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     [bookmark: pgfId-426409][bookmark: 170219][bookmark: preface_abstract]Preface
      
      
 
     
 
 
     
      [bookmark: pgfId-426795][bookmark: 170588][bookmark: welDocConv][bookmark: marker-426793]Conventions
 
     [bookmark: pgfId-426800][bookmark: marker-426797]This document uses the following conventions:
 
      
       
       
         
         	 
           
           [bookmark: pgfId-425817]Item
          
  
         	 
           
           [bookmark: pgfId-425819]Convention
          
  
        
 
         
         	[bookmark: pgfId-425825]Commands, keywords, special terminology, and options that should be selected during procedures
  
         	[bookmark: pgfId-425827]boldface font
  
        
 
         
         	[bookmark: pgfId-425833]Variables for which you supply values and new or important terminology
  
         	[bookmark: pgfId-425835]italic font
  
        
 
         
         	[bookmark: pgfId-425841]Displayed session and system information, paths and file names
  
         	[bookmark: pgfId-425843]screen font
  
        
 
         
         	[bookmark: pgfId-425849]Information you enter
  
         	[bookmark: pgfId-425851]boldface screen font
  
        
 
         
         	[bookmark: pgfId-425857]Variables you enter
  
         	[bookmark: pgfId-425859]italic screen font
  
        
 
         
         	[bookmark: pgfId-425865]Menu items and button names
  
         	[bookmark: pgfId-425867]boldface font
  
        
 
         
         	[bookmark: pgfId-425873]Indicates menu items to select, in the order you select them.
  
         	[bookmark: pgfId-425875]Option > Network Preferences
  
        
 
       
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-426802]Tip Identifies information to help you get the most benefit from your product.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-426804]Note Means reader take note. Notes identify important information that you should reflect upon before continuing, contain helpful suggestions, or provide references to materials not contained in the document.

     
      

     

     
 
      
       
     
 
     
 
     
      [bookmark: pgfId-426808]
      Caution 
      [bookmark: marker-426806]Means 
      reader be careful. In this situation, you might do something that could result in equipment damage, loss of data, or a potential breach in your network security.
       
       
 
      

     
 
      
       
     
 
     
 
     [bookmark: pgfId-426812]Warning [bookmark: marker-426810]Identifies information that you must heed to prevent damaging yourself, the state of software, or equipment. Warnings identify definite security breaches that will result if the information presented is not followed carefully.

     
      

     

     
 
    
 
     
      [bookmark: pgfId-1011770][bookmark: 74565]Obtaining Documentation and Submitting a Service Request
 
     [bookmark: pgfId-1011771]For information on obtaining documentation, using the Cisco Bug Search Tool (BST), submitting a service request, and gathering additional information, see What’s New in Cisco Product Documentation.
 
     [bookmark: pgfId-1011773]Toreceivenew and revised Ciscotechnical content directly to your desktop, you can subscribeto theWhat’s New in Cisco Product DocumentationRSS feed. The RSS feeds are a free service.
 
    
 
     
    
 
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-1052512][bookmark: 9][bookmark: wfplan_cncpt_GettingtoKnowSecurityManager]Getting Started with Security Manager[bookmark: marker-1052511]
      
      
 
     
 
 
    [bookmark: pgfId-798406]The following topics describe Cisco Security Manager, how to get started with the application, and how to complete its configuration.
 
     
     	 [bookmark: pgfId-798411]Product Overview
 
     	 [bookmark: pgfId-798416]Logging In to and Exiting Security Manager
 
     	 [bookmark: pgfId-798421]Using Configuration Manager - Overview
 
     	 [bookmark: pgfId-798426]Using the JumpStart to Learn About Security Manager
 
     	 [bookmark: pgfId-798431]Completing the Initial Security Manager Configuration
 
     	 [bookmark: pgfId-798436]Understanding Basic Security Manager Interface Features
 
     	 [bookmark: pgfId-798441]Accessing Online Help
 
    
 
   
 
    
     [bookmark: pgfId-798459][bookmark: 37][bookmark: wfplan_cncpt_ProductOverview]Product Overview [bookmark: marker-798457]
 
    [bookmark: pgfId-798461]Cisco Security Manager (Security Manager) enables you to manage security policies on Cisco security devices. Security Manager supports integrated provisioning of firewall, IPS, and VPN (site-to-site, remote access, and SSL) services across:
 
     
     	 [bookmark: pgfId-798463]ASA and PIX security appliances.
 
     	 [bookmark: pgfId-798465]IPS appliances and various service modules for routers and ASA devices.
 
     	 [bookmark: pgfId-798467]IOS routers.
 
     	 [bookmark: pgfId-798469]Catalyst switches.
 
     	 [bookmark: pgfId-798471]Catalyst services modules related to firewall, VPN, and IPS.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-798475]Note For a complete list of devices and OS versions supported by Security Manager, please refer to Supported Devices and Software Versions for Cisco Security Manager on Cisco.com.

    
     

    

    
 
    [bookmark: pgfId-798477]Security Manager also supports provisioning of many platform-specific settings, for example, interfaces, routing, identity, QoS, logging, and so on.
 
    [bookmark: pgfId-798479]Security Manager efficiently manages a wide range of networks, from small networks consisting of a few devices to large networks with thousands of devices. Scalability is achieved through a rich feature set of shareable objects and policies and device grouping capabilities.
 
    [bookmark: pgfId-798481]Security Manager supports multiple configuration views optimized around different task flows and use cases.
 
    [bookmark: pgfId-798483]The following topics provide an overview of Security Manager:
 
     
     	 [bookmark: pgfId-798488]Primary Benefits of Cisco Security Manager
 
     	 [bookmark: pgfId-798493]Security Manager Policy Feature Sets
 
     	 [bookmark: pgfId-798498]Security Manager Applications Overview
 
     	 [bookmark: pgfId-798503]Device Monitoring Overview
 
     	 [bookmark: pgfId-798508]IPv6 Support in Security Manager
 
    
 
     
      [bookmark: pgfId-798516][bookmark: 82][bookmark: wfplan_cncpt_PrimaryBenefitsofCiscoSecurityManager]Primary Benefits of Cisco Security Manager [bookmark: marker-798514]
 
     [bookmark: pgfId-798518]These are the primary benefits of working with Security Manager:
 
      
      	 [bookmark: pgfId-798520] Scalable network management —Centrally administer security policies and device settings for either small networks or large scale networks consisting of thousands of devices. Define policies and settings once and then optionally assign them to individual devices, groups of devices or all the devices in the enterprise.
 
      	 [bookmark: pgfId-798522] Provisioning of multiple security technologies across different platforms —Manage VPN, firewall, and IPS technologies on routers, security appliances, Catalyst devices and service modules, and IPS devices.
 
      	 [bookmark: pgfId-798524] Provisioning of platform-specific settings and policies —Manage platform-specific settings on specific device types. For example: routing, 802.1x, EzSDD, and Network Admission Control on routers, and device access security, DHCP, AAA, and multicast on firewall devices.
 
      	 [bookmark: pgfId-798526] VPN wizards —Quickly and easily configure point-to-point, hub-and-spoke, full-mesh, and Extranet site-to-site VPNs across different VPN device types. Quickly and easily configure remote access IPsec and SSL VPNs on ASA, IOS, and PIX devices.
 
      	 [bookmark: pgfId-798528] Multiple management views —Device, policy, and map views enable you to manage your security in the environment that best suits your needs.
 
      	 [bookmark: pgfId-798530] Reusable policy objects —Create reusable objects to represent network addresses, device settings, VPN parameters, and so on, then use them instead of manually entering values.
 
      	 [bookmark: pgfId-798532] Device grouping capabilities —Create device groups to represent your organizational structure. Manage all devices in the groups concurrently.
 
      	 [bookmark: pgfId-798534] Policy inheritance —Centrally specify which policies are mandatory and enforced lower in the organization.
 
      	 [bookmark: pgfId-798536] Role-based administration —Enable appropriate access controls for different operators.
 
      	 [bookmark: pgfId-798538] Workflow —Optionally allow division of responsibility and workload between network operators and security operators and provide a change management approval and tracking mechanism.
 
      	 [bookmark: pgfId-798540] Ticket Management —Associate a ticket ID with policy changes, easily add and update comments pertaining to those changes, and quickly navigate to an external change management system from Security Manager.
 
      	 [bookmark: pgfId-798542] Single, consistent user interface for managing common firewall features —Single rule table for all platforms (router, PIX, ASA, and FWSM).
 
      	 [bookmark: pgfId-798544] Image management —Complete image management for ASA devices. Facilitates at every stage of image upgrade of devices by: downloading and maintaining image repository, evaluating images, analyzing impact of upgrades, preparing and planning reliable and stable device upgrades, and ensuring sufficient fallback and recovery mechanisms.
 
      	 [bookmark: pgfId-798546] Intelligent analysis of firewall policies —The conflict detection feature analyzes and reports rules that overlap or conflict with other rules. The ACL hit count feature checks in real-time whether specific rules are being hit or triggered by packets.
 
      	 [bookmark: pgfId-798548] Sophisticated rule table editing —In-line editing, ability to cut, copy, and paste rules and to change their order in the rule table.
 
      	 [bookmark: pgfId-798550] Discover firewall policies from device —Policies that exist on the device can be imported into Security Manager for future management.
 
      	 [bookmark: pgfId-798552] Flexible deployment options —Support for deployment of configurations directly to a device or to a configuration file. You can also use Auto-Update Server (AUS), Configuration Engine, or Token Management Server (TMS) for deployment.
 
      	 [bookmark: pgfId-798554] Rollback —Ability to roll back to a previous configuration if necessary.
 
      	 [bookmark: pgfId-798556] FlexConfig (template manager) —Intelligent CLI configlet editor to manage features available on a device but not natively supported by Security Manager.
 
      	 [bookmark: pgfId-798558] Integrated device monitoring and reporting —Features for monitoring events on IPS, ASA, and FWSM devices and correlating them to the related configuration policies, and for creating security and usage reports. These features include the following stand-alone Security Manager applications:
 
     
 
     [bookmark: pgfId-798560] – Event Viewer—Event Viewer monitors your network for system log (syslog) events from ASA and FWSM devices, as well as security contexts and SDEE events from IPS devices and virtual sensors. Event Viewer collects these events and provides an interface by which you can view them, group them, and examine their details in near real time.
 
     [bookmark: pgfId-798562] – Report Manager—Report Manager lets you collect, display and export a wide variety of network usage and security information for ASA and IPS devices, and for ASA-hosted remote-access IPsec and SSL VPNs. These reports aggregate security data such as top sources, destinations, attackers, victims, as well as security information such as top bandwidth, duration, and throughput users. Data is available for hourly, daily, and monthly periods. (Report Manager aggregates information collected from devices monitored by the Event Manager service. Thus, to view reports about a device, you must be monitoring that device in Event Viewer.)
 
      
       
     
 
     
 
     [bookmark: pgfId-798564]Note Report Manager does not report FWSM events even though Event Viewer works with FWSM.

     
      

     

     
 
     [bookmark: pgfId-798566] – Health and Performance Monitor—Health and Performance Monitor (HPM) periodically polls monitored ASA devices, IPS devices, and ASA-hosted VPN services for key health and performance data, including critical and non-critical issues, such as memory usage, interface status, dropped packets, tunnel status, and so on. This information is used for alert generation and email notification, and to display trends based on aggregated data, which is available for hourly, daily, and weekly periods.
 
      
       
     
 
     
 
     [bookmark: pgfId-798568]Note Health and Performance Monitor does not monitor FWSM devices.

     
      

     

     
 
     [bookmark: pgfId-798573] – Dashboard—The Dashboard is a configurable launch point for Security Manager that makes IPS and FW tasks more convenient for you. In addition to the original dashboard, you can create new, additional dashboards, and you can customize all dashboards. By using the dashboard, you can accomplish in one place many tasks that are found in several other areas of Security Manager, such as the IPS Health Monitor page, Report Manager, Health and Performance Monitor, and IP Intelligence Settings. For detailed information on the dashboard, see Dashboard Overview.
 
     [bookmark: pgfId-798575]Additional features let you monitor devices from Security Manager using other closely related applications, including Cisco Security Monitoring, Analysis and Response System (CS-MARS), Cisco Performance Monitor, and device managers such as ASDM (read-only versions of which are included with Security Manager).
 
    
 
     
      [bookmark: pgfId-798583][bookmark: 166][bookmark: wfplan_cncpt_SecurityManagerFeatureSets]Security Manager Policy Feature Sets[bookmark: marker-798581]
 
     [bookmark: pgfId-798585]Security Manager provides the following primary feature sets for configuration policies:
 
      
      	 [bookmark: pgfId-798587] Firewall Services 
 
     
 
     [bookmark: pgfId-798589]Configuration and management of firewall policies across multiple platforms, including IOS routers, ASA/PIX devices, and Catalyst Firewall Service Modules (FWSMs). Features include:
 
     [bookmark: pgfId-798591] – Access control rules—Permit or deny traffic on interfaces through the use of access control lists for both IPv4 and IPv6 traffic.
 
     [bookmark: pgfId-798593] – Botnet Traffic Filter rules—(ASA only.) Filter traffic based on known malware sites and optionally drop traffic based on threat level.
 
     [bookmark: pgfId-798595] – Inspection rules—Filter TCP and UDP packets based on application-layer protocol session information.
 
     [bookmark: pgfId-798597] – AAA/Authentication Proxy rules—Filter traffic based on authentication and authorization for users who log into the network or access the Internet through HTTP, HTTPS, FTP, or Telnet sessions.
 
     [bookmark: pgfId-798599] – Web filtering rules—Use URL filtering software, such as Websense, to deny access to specific web sites.
 
     [bookmark: pgfId-798601] – ScanSafe Web Security—(Routers only.) Redirect HTTP/HTTPS traffic to the ScanSafe web security center for content scanning and malware protection services.
 
     [bookmark: pgfId-798603] – Transparent firewall rules—Filter layer-2 traffic on transparent or bridged interfaces.
 
     [bookmark: pgfId-798605] – Zone-based firewall rules—Configure access, inspection, and web filtering rules based on zones rather than on individual interfaces.
 
     [bookmark: pgfId-798610]For more information, see Chapter 12, “Introduction to Firewall Services”.
 
      
      	 [bookmark: pgfId-798612] Site-to-Site VPN 
 
     
 
     [bookmark: pgfId-798614]Setup and configuration of IPsec site-to-site VPNs. Multiple device types can participate in a single VPN, including IOS routers, PIX/ASA devices, and Catalyst VPN Service Modules. Supported VPN topologies are:
 
     [bookmark: pgfId-798616] – Point to point
 
     [bookmark: pgfId-798618] – Hub and spoke
 
     [bookmark: pgfId-798620] – Full mesh
 
     [bookmark: pgfId-798622] – Extranet (a point-to-point connection to an unmanaged device)
 
     [bookmark: pgfId-798624]Supported IPsec technologies are:
 
     [bookmark: pgfId-798626] – Regular IPsec
 
     [bookmark: pgfId-798628] – GRE
 
     [bookmark: pgfId-798630] – GRE Dynamic IP
 
     [bookmark: pgfId-798632] – DMVPN
 
     [bookmark: pgfId-798634] – Easy VPN
 
     [bookmark: pgfId-798636] – GET VPN
 
     [bookmark: pgfId-798641]For more information, see Chapter 25, “Managing Site-to-Site VPNs: The Basics”.
 
      
      	 [bookmark: pgfId-798643] Remote Access VPN 
 
     
 
     [bookmark: pgfId-798648]Setup and configuration of IPsec and SSL VPNs between servers and mobile remote workstations running Cisco VPN client or AnyConnect client software. For more information, see Chapter 30, “Managing Remote Access VPNs: The Basics”.
 
      
      	 [bookmark: pgfId-798650] Intrusion Prevention System (IPS) Management 
 
     
 
     [bookmark: pgfId-798652]Management and configuration of Cisco IPS sensors (appliances and service modules) and IOS IPS devices (Cisco IOS routers with IPS-enabled images and Cisco Integrated Services Routers).
 
     [bookmark: pgfId-798660]For more information, see Overview of IPS Configuration and Overview of Cisco IOS IPS Configuration.
 
      
      	 [bookmark: pgfId-798662] Features Specific to Firewall Devices (PIX/ASA/FWSM) 
 
     
 
     [bookmark: pgfId-798664]Configuration of advanced platform-specific features and settings on PIX/ASA devices and Catalyst FWSMs. These features provide added value when managing security profiles and include:
 
     [bookmark: pgfId-798666] – Interface configuration
 
     [bookmark: pgfId-798668] – Identity-aware firewall settings
 
     [bookmark: pgfId-798670] – Device administration settings
 
     [bookmark: pgfId-798672] – Security
 
     [bookmark: pgfId-798674] – Routing
 
     [bookmark: pgfId-798676] – Multicast
 
     [bookmark: pgfId-798678] – Logging
 
     [bookmark: pgfId-798680] – NAT
 
     [bookmark: pgfId-798682] – Bridging
 
     [bookmark: pgfId-798684] – Failover
 
     [bookmark: pgfId-798686] – Security contexts
 
     [bookmark: pgfId-798691]For more information, see Chapter 46, “Managing Firewall Devices”.
 
      
      	 [bookmark: pgfId-798693] Features Specific to IOS Routers 
 
     
 
     [bookmark: pgfId-798695]Configuration of advanced platform-specific features and settings on IOS routers. These features provide added value when managing security profiles and include:
 
     [bookmark: pgfId-798697] – Interface configuration
 
     [bookmark: pgfId-798699] – Routing
 
     [bookmark: pgfId-798701] – NAT
 
     [bookmark: pgfId-798703] – 802.1x
 
     [bookmark: pgfId-798705] – NAC
 
     [bookmark: pgfId-798707] – QoS
 
     [bookmark: pgfId-798709] – Dialer interfaces
 
     [bookmark: pgfId-798711] – Secure device provisioning
 
     [bookmark: pgfId-798716]For more information, see Chapter 60, “Managing Routers”.
 
      
      	 [bookmark: pgfId-798718] Features Specific to Catalyst 6500/7600 Devices and Catalyst Switches 
 
     
 
     [bookmark: pgfId-798720]Configuration of VLAN, network connectivity, and service module features and settings on Catalyst 6500/7600 devices and on other Catalyst switches.
 
     [bookmark: pgfId-798725]For more information, Chapter 67, “Managing Cisco Catalyst Switches and Cisco 7600 Series Routers”.
 
      
      	 [bookmark: pgfId-798727] FlexConfigs 
 
     
 
     [bookmark: pgfId-798729]Flexconfig policies and policy objects enable you to provision features that are available on the device but not natively supported by Security Manager. They enable you to manually specify a set of CLI commands and to deploy them to devices using Security Manager’s provisioning mechanisms. These commands can be either prepended or appended to the commands generated by Security Manager to provision security policies.
 
     [bookmark: pgfId-798734]For more information, see Chapter 7, “Managing FlexConfigs”.
 
    
 
     
      [bookmark: pgfId-798744][bookmark: 301][bookmark: wfplan_cncpt_SecurityManagerApplicationsOverview]Security Manager Applications Overview[bookmark: marker-798740][bookmark: marker-798742]
 
     [bookmark: pgfId-798746]The Security Manager client has six main applications and one application designed for mobile devices:
 
      
      	 [bookmark: pgfId-798751] Configuration Manager —This is the primary application. You use Configuration Manager to manage the device inventory, create and edit local and shared policies, manage VPN configurations, and deploy policies to devices. Configuration Manager is the largest of the applications and most of the documentation addresses this application. If a procedure does not specifically mention an application, the procedure is using Configuration Manager. For an introduction to Configuration Manager, see Using Configuration Manager - Overview.
 
      	 [bookmark: pgfId-798756] Event Viewer —This is an event monitoring application, where you can view and analyze events generated from IPS, ASA, and FWSM devices that you have configured to send events to Security Manager. For information about using Event Viewer, see Chapter 68, “Viewing Events”.
 
      	 [bookmark: pgfId-798761] Report Manager —This is a reporting application, where you can view and create reports of aggregated information on device and VPN statistics. Much of the information is derived from events available through Event Viewer, but some of the VPN statistics are obtained by communicating directly with the device. For information about using Report Manager, see Chapter 69, “Managing Reports”.
 
      	 [bookmark: pgfId-798766] Health & Performance Monitor —The HPM application lets you monitor key health and performance data for ASA (including ASA-SM) devices, IPS devices, and VPN services by providing network-level visibility into device status and traffic information. This ability to monitor key network and device metrics lets you quickly detect and resolve device malfunctions and bottlenecks in the network. See Chapter 70, “Health and Performance Monitoring” for more information about this application.
 
      	 [bookmark: pgfId-798771] Image Manager —The Image Manager application provides complete image management of ASA devices. It facilitates downloading, evaluating, analyzing, preparing, and planning image updates. It assesses image availability, compatibility, and impact on devices and provides scheduling, grouping, and change management of device updates. In addition, Image Manager includes capabilities for maintaining an image repository as well as for ensuring stable fallback and recovery mechanisms for image updates on ASA devices. For information about using Image Manager, see Chapter 72, “Using Image Manager”.
 
      	 [bookmark: pgfId-798776] Dashboard —The Dashboard is a configurable launch point for Security Manager that makes IPS and FW tasks more convenient for you. In addition to the original dashboard, you can create new, additional dashboards, and you can customize all dashboards. By using the dashboard, you can accomplish in one place many tasks that are found in several other areas of Security Manager, such as the IPS Health Monitor page, Report Manager, Health and Performance Monitor, and IP Intelligence Settings. For detailed information on the dashboard, see Dashboard Overview.
 
     
 
     [bookmark: pgfId-798781]You can open any of these applications directly from the Windows Start menu or a desktop icon, or you can open them from within any of these applications through the application’s Launch menu. For information on opening applications, see Logging In to and Exiting the Security Manager Client.
 
     [bookmark: pgfId-798783]The Security Manager client has an additional application, CSM Mobile, which is designed specifically for mobile devices:
 
      
      	 [bookmark: pgfId-798794] CSM Mobile —CSM Mobile allows you to access device health summary information from mobile devices. The information available to you in this way is the same as that available in the Device Health Summary widget in the Dashboard: current high or medium severity active alerts generated by HPM. Alerts can be grouped by Alert-Description, Predefined-Category, Device, or Alert Technology. For more information on CSM Mobile, see CSM Mobile. For more details on device health summary information, see Dashboard Overview. For information on enabling or disabling CSM Mobile, see CSM Mobile Page
 
     
 
    
 
     
      [bookmark: pgfId-798804][bookmark: 346][bookmark: wfplan_cncpt_DeviceMonitoringOverview]Device Monitoring Overview[bookmark: marker-798800][bookmark: marker-798802]
 
     [bookmark: pgfId-798806]Security Manager includes several facilities for monitoring devices:
 
      
      	 [bookmark: pgfId-798811] Event Viewer —This integrated tool allows you to view events on ASA, FWSM, and IPS devices and correlate them to the related configuration policies. This helps you identify problems, troubleshoot configurations, and then fix the configurations and redeploy them. For more information, see Chapter 68, “Viewing Events”.
 
      	 [bookmark: pgfId-798816] Report Manager —This is a reporting application, where you can view and create reports of aggregated information on device and VPN statistics. Much of the information is derived from events available through Event Viewer, but some of the VPN statistics are obtained by communicating directly with the device. For information about using Report Manager, see Chapter 69, “Managing Reports”.
 
     
 
     [bookmark: pgfId-798821]For information on all of the types of reports available in Security Manager, see Understanding the Types of Reports Available in Security Manager.
 
      
      	 [bookmark: pgfId-798826] Health & Performance Monitor —The HPM application lets you monitor key health and performance data for ASA (including ASA-SM) devices, IPS devices, and VPN services by providing network-level visibility into device status and traffic information. See Chapter 70, “Health and Performance Monitoring” for more information about this application.
 
      	 [bookmark: pgfId-798831] Dashboard —The Dashboard is a configurable launch point for Security Manager that makes IPS and FW tasks more convenient for you. In addition to the original dashboard, you can create new, additional dashboards, and you can customize all dashboards. By using the dashboard, you can accomplish in one place many tasks that are found in several other areas of Security Manager, such as the IPS Health Monitor page, Report Manager, Health and Performance Monitor, and IP Intelligence Settings. For detailed information on the dashboard, see Dashboard Overview.
 
      	 [bookmark: pgfId-798836] Packet Tracer —You can use this tool to test whether certain types of packets will be allowed to go through an ASA device. For more information, see Analyzing an ASA or PIX Configuration Using Packet Tracer.
 
      	 [bookmark: pgfId-798841] Ping, Trace route, and NS Lookup —You can use ping and traceroute on a managed device to check whether there is a route between the device and a specific destination. You can use NS lookup to resolve addresses to DNS names. For more information, see Analyzing Connectivity Issues Using the Ping, Trace Route, or NS Lookup Tools.
 
      	 [bookmark: pgfId-798846] Cisco Prime Security Manager (PRSM) Integration —You can “cross launch” PRSM from the Configuration Manager application. The PRSM application is used to configure and manage ASA CX devices. For more information, see Launching Cisco Prime Security Manager or FireSIGHT Management Center.
 
      	 [bookmark: pgfId-798851] Device Manager Integration —Security Manager includes read-only copies of the various device managers, such as Adaptive Security Device Manager (ASDM). You can use these tools to view device status, but not to change the device configuration. For more information, see Starting Device Managers.
 
      	 [bookmark: pgfId-798856] Cisco Security Monitoring, Analysis and Response System (CS-MARS) Integration —If you use the CS-MARS application, you can integrate it with Security Manager and view events in CS-MARS from Security Manager, and conversely, Security Manager policies related to events from CS-MARS. For more information, see Integrating CS-MARS and Security Manager.
 
     
 
    
 
     
      [bookmark: pgfId-798870][bookmark: 395][bookmark: wfplan_cncpt_IPv6SupportInSecurityManager]IPv6 Support in Security Manager [bookmark: marker-798862][bookmark: marker-798864][bookmark: marker-798866][bookmark: marker-798868]
 
     [bookmark: pgfId-798872]Security Manager provides increasing support for IPv6 configuration, monitoring, and reporting.
 
      
       
     
 
     
 
     [bookmark: pgfId-798874]Note To manage a device that supports IPv6 addressing with Security Manager, you must configure the device’s management address as an IPv4 address. All communications between the device and Security Manager, such as policy discovery and deployment, use IPv4 transport. Also, if the IPv6 policies are not appearing for a supported device, rediscover the device policies; if necessary, delete the device from the inventory and add it again.

     
      

     

     
 
     [bookmark: pgfId-798878]In general, you can configure IPv6 policies on the following types of device. In addition, you can monitor IPv6 alerts generated by IPS, ASA, and FWSM devices. For other types of devices, use FlexConfig policies to configure IPv6 settings. For more specific information on IPv6 device support, see the Supported Devices and Software Versions for Cisco Security Manager document on Cisco.com.
 
      
      	 [bookmark: pgfId-798880] ASA —Release 7.0+ when running in router mode; release 8.2+ when running in transparent mode. Both single and multiple security context devices are supported.
 
      	 [bookmark: pgfId-798882] FWSM —Release 3.1+ when running in router mode. Not supported in transparent mode. Both single and multiple security context devices are supported.
 
      	 [bookmark: pgfId-798884] IPS —Release 6.1+.
 
     
 
     [bookmark: pgfId-798886]Following is a summary of the Security Manager features that support IPv6 addressing:
 
      
      	 [bookmark: pgfId-798888] Policy Objects —The following policy objects support IPv6 addresses:
 
     
 
     [bookmark: pgfId-798893] – Networks/Hosts. See Understanding Networks/Hosts Objects.
 
     [bookmark: pgfId-798898] – Services. This object includes predefined services for ICMP6 and DHCPv6, which you can use only with IPv6 policies. The other services apply to both IPv4 and IPv6. For more information on service objects, see Understanding and Specifying Services and Service and Port List Objects.
 
      
      	 [bookmark: pgfId-798900] Firewall Services Policies —The following Firewall Services policies and tools support IPv6 configurations:
 
     
 
     [bookmark: pgfId-798905] – AAA Rules. See Chapter 15, “Managing Firewall AAA Rules”.
 
     [bookmark: pgfId-798910] – Access Rules. See Configuring Access Rules.
 
     [bookmark: pgfId-798915] – Inspection Rules. See Chapter 17, “Managing Firewall Inspection Rules”.
 
     [bookmark: pgfId-798920] – Settings > Access Control. See Configuring Settings for Access Control.
 
     [bookmark: pgfId-798922] – Tools:
 
     [bookmark: pgfId-798927]Hit Count. See Viewing Hit Count Details.
 
     [bookmark: pgfId-798932]Find and Replace. See Finding and Replacing Items in Rules Tables.
 
      
      	 [bookmark: pgfId-798934] ASA and FWSM Policies —The following ASA and FWSM policies support IPv6 configurations:
 
     
 
     [bookmark: pgfId-798939] – (ASA 7.0+ routed mode; ASA 8.2+ transparent mode; FWSM 3.1+ routed mode.) Interfaces: IPv6 tab of the Add Interface and Edit Interface dialog boxes. See Configuring IPv6 Interfaces (ASA/FWSM).
 
     [bookmark: pgfId-798944] – (ASA only.) Platform > Bridging > IPv6 Neighbor Cache. See Managing the IPv6 Neighbor Cache.
 
     [bookmark: pgfId-798949] – (ASA 5505 8.2/8.3 only.) Platform > Bridging > Management IPv6. See Management IPv6 Page (ASA 5505).
 
     [bookmark: pgfId-798954] – (ASA 8.4.2+ only.) Platform > Device Admin > Server Access > DNS. See DNS Page.
 
      
      	 [bookmark: pgfId-798959] FlexConfig Policies —There are two Firewall system variables that you can use to identify IPv6 ACLs on a device. For more information, see FlexConfig System Variables.
 
     
 
     [bookmark: pgfId-798961]There is also a predefined FlexConfig policy object that uses these variables, ASA_add_IPv6_ACEs.
 
      
      	 [bookmark: pgfId-798966] Event Viewer —Events that include IPv6 addresses are supported, and the addresses are displayed in the same columns as IPv4 addresses: Source, Destination, and IPLog Address (for IPS alerts). However, you must configure the device to use IPv4 for sending events to the Security Manager server. All event communications use IPv4 transport. For more information on Event Viewer, see Chapter 68, “Viewing Events”.
 
      	 [bookmark: pgfId-798971] Dashboard —On the Dashboard, all the widgets that use IP addressing support IPv6 addresses. However, as is true elsewhere in Security Manager, you must configure the device to use IPv4 for sending events to the Security Manager server. All event communications use IPv4 transport. For more information on the Dashboard, see Dashboard Overview
 
      	 [bookmark: pgfId-798976] Report Manager —Reports include statistics for IPv6 events collected by Event Management. For more information on Report Manager, see Chapter 69, “Managing Reports”.
 
     
 
    
 
     
      [bookmark: pgfId-798986][bookmark: 491][bookmark: wfplan_cncpt_PolicyObjectChanges]Policy Object Changes in Security Manager 4.4 [bookmark: marker-798982][bookmark: marker-798984]
 
     [bookmark: pgfId-798988]Certain changes were made to a few policies and policy objects in Security Manager 4.4, in order to unify previously separate IPv4 and IPv6 elements. The most important of these changes are to the Networks/Hosts object (which itself represents a unification of the Networks/Hosts and the Networks/Hosts-IPv6 objects):
 
      
      	 [bookmark: pgfId-798990]The new Networks/Hosts object “All-IPv4-Addresses” replaces the IPv4 “any” network policy object. If you upgrade to Security Manager 4.4 from a previous version, all references to the IPv4 “any” network policy object will be changed to “All-IPv4-Addresses.”
 
      	 [bookmark: pgfId-798992]The new Networks/Hosts object “All-IPv6-Addresses” replaces the IPv6 “any” network policy object. If you upgrade to Security Manager 4.4 from a previous version, all references to the IPv6 “any” network policy object will be changed to “All-IPv6-Addresses.”
 
      	 [bookmark: pgfId-798994]The new Networks/Hosts object “All-Addresses” does not have a corresponding policy object in earlier versions of Security Manager. It is a new global “any” policy object, and it encompasses all IPv4 and IPv6 address ranges.
 
     
 
     [bookmark: pgfId-798996]Other related changes include unification of IPv4 and IPv6 versions of device-specific policies such as Access Rules, Inspection Rules, and so on.
 
     [bookmark: pgfId-798998]Further, when editing policies and objects, IPv4, IPv6, or mixed-mode (both IPv4 and IPv6) entries are automatically filtered in elements, such as dialog boxes, in which one or more of those entries is not appropriate to that element.
 
     [bookmark: pgfId-799000]Related Topics
 
      
      	 [bookmark: pgfId-799005]Policy Object Manager
 
      	 [bookmark: pgfId-799010]Understanding Networks/Hosts Objects
 
     
 
    
 
   
 
    
     [bookmark: pgfId-799022][bookmark: 521][bookmark: dtchap_cncpt_LoggingIntoandExitingSecurityManager]Logging In to and Exiting Security Manager[bookmark: marker-799018][bookmark: marker-799020]
 
    [bookmark: pgfId-799024]Security Manager has two main interfaces:
 
     
     	 [bookmark: pgfId-799026]Cisco Security Management Suite home page—Use this interface to install the Security Manager client and to manage the server. You can also access other CiscoWorks applications you installed, such as Resource Manager Essentials (RME).
 
     	 [bookmark: pgfId-799028]Security Manager clients—Use these interfaces to perform most Security Manager tasks. You can log directly into any of six client applications: Configuration Manager, Event Viewer, Report Manager, Health & Performance Monitor, Image Manager, and Dashboard.
 
    
 
    [bookmark: pgfId-799030]These topics describe how to log in to and exit these interfaces:
 
     
     	 [bookmark: pgfId-799035]Understanding User Permissions
 
     	 [bookmark: pgfId-799040]Logging In to the Cisco Security Management Suite Server
 
     	 [bookmark: pgfId-799045]Logging In to and Exiting the Security Manager Client
 
    
 
     
      [bookmark: pgfId-799063][bookmark: 547][bookmark: wfplan_cncpt_UnderstandingUserPermissions]Understanding User Permissions [bookmark: marker-799051][bookmark: marker-799053][bookmark: marker-799055][bookmark: marker-799057][bookmark: marker-799059][bookmark: marker-799061]
 
     [bookmark: pgfId-799065]Cisco Security Manager authenticates your username and password before you can log in. After you are authenticated, Security Manager establishes your role within the application. This role defines your permissions (also called privileges), which are the set of tasks or operations that you are authorized to perform. If you are not authorized for certain tasks or devices, the related menu items, items in tables of contents, and buttons are hidden or disabled. In addition, a message tells you that you do not have permission to view the selected information or perform the selected operation.
 
     [bookmark: pgfId-799067]Authentication and authorization for Security Manager is managed either by the CiscoWorks server or the Cisco Secure Access Control Server (ACS). By default, CiscoWorks manages authentication and authorization, but you can configure Security Manager to use your Cisco Secure ACS setup.
 
     [bookmark: pgfId-799069]When using ACS, if all of the ACS servers become unavailable, you cannot perform tasks in Security Manager. If you are logged in, you might be abruptly logged out of the system (without an opportunity to save changes) if you try to perform a task that requires ACS authorization. If this happens, you get a message stating this is the reason you are getting logged off.
 
     [bookmark: pgfId-799073]For more information about user permissions and AAA configuration, see the Installation Guide for Cisco Security Manager.
 
     [bookmark: pgfId-799075]For more information about authorization control in the Event Viewer and Report Manager applications, see the following topics:
 
      
      	 [bookmark: pgfId-799080]Understanding Event Viewer Access Control
 
      	 [bookmark: pgfId-799085]Understanding Report Manager Access Control
 
     
 
    
 
     
      [bookmark: pgfId-799103][bookmark: 581][bookmark: dtchap_proc_LoggingIntotheCiscoSecurityManagementSuiteServer]Logging In to the Cisco Security Management Suite Server[bookmark: marker-799091][bookmark: marker-799093][bookmark: marker-799095][bookmark: marker-799097][bookmark: marker-799099][bookmark: marker-799101]
 
     [bookmark: pgfId-799105]Use the Cisco Security Management Suite home page, and CiscoWorks Common Services, to install the Security Manager client and to manage the server. You can also access other CiscoWorks applications you installed, such as RME.
 
      
       
     
 
     
 
     [bookmark: pgfId-799107]Note The Software Center > Software Update feature in Common Services is not supported by Cisco Security Manager.

     
      

     

     
 
     
 
     [bookmark: pgfId-799109]Step 1 In your web browser, open one of these URLs, where SecManServer is the name of the computer where Security Manager is installed. Click Yes on any Security Alert windows.
 
      
      	 [bookmark: pgfId-799111]If you are not using SSL, open http:// SecManServer :1741
 
      	 [bookmark: pgfId-799113]If you are using SSL, open https:// SecManServer :443
 
     
 
     [bookmark: pgfId-799117]The Cisco Security Management Suite login screen is displayed. Verify on the page that JavaScript and cookies are enabled and that you are running a supported version of the web browser. For information on configuring the browser to run Security Manager, see Installation Guide for Cisco Security Manager.
 
     [bookmark: pgfId-799119]Step 2 Log in to the Cisco Security Management Suite server with your username and password. When you initially install the server, you can log in using the username admin and the password defined during product installation.
 
     [bookmark: pgfId-799121]Step 3 On the Cisco Security Management Suite home page, you can access at least the following features. Other features might be available depending on how you installed the product.
 
      
      	 [bookmark: pgfId-799123]Cisco Security Manager Client Installer—Click this item to install the Security Manager client. The client is the main interface for using the product.
 
      	 [bookmark: pgfId-799125]Server Administration—Click this item to open the CiscoWorks Common Services Server page. CiscoWorks Common Services is the foundation software that manages the server. Use it to configure and manage back-end server features such as server maintenance and troubleshooting, local user definition, and so on.
 
      	 [bookmark: pgfId-799127]CiscoWorks link (in the upper right of the page)—Click this link to open the CiscoWorks Common Services home page.
 
     
 
     [bookmark: pgfId-799129]Step 4 To exit the application, click Logout in the upper right corner of the screen. If you have both the home page and the Security Manager client open at the same time, exiting the browser connection does not exit the Security Manager client.
 
     [bookmark: pgfId-799131]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-799147][bookmark: 637][bookmark: dtchap_proc_LoggingIntoandExitingtheSecurityManagerClient]Logging In to and Exiting the Security Manager Client[bookmark: marker-799137][bookmark: marker-799139][bookmark: marker-799141][bookmark: marker-799143][bookmark: marker-799145]
 
     [bookmark: pgfId-799149]Use the Security Manager client to perform most Security Manager tasks.
 
      
       
     
 
     
 
     [bookmark: pgfId-799151]Tip You must log into the workstation using a Windows user account that has Administrator privileges to fully use the Security Manager client applications. If you try to operate the applications with lesser privileges, you might find that some features do not work correctly.

     
      

     

     
 
     [bookmark: pgfId-799153]Before You Begin
 
     [bookmark: pgfId-799158]Install the client on your computer. To install the client, log into the Security Manager server as described in Logging In to the Cisco Security Management Suite Server, and then click Cisco Security Manager Client Installer and follow the instructions in the installation wizard.
 
     
 
     [bookmark: pgfId-799160]Step 1 Select one of the following applications from the Start > All Programs > Cisco Security Manager Client menu:
 
      
      	 [bookmark: pgfId-799162]Configuration Manager
 
      	 [bookmark: pgfId-799164]Event Viewer
 
      	 [bookmark: pgfId-799166]Report Manager
 
      	 [bookmark: pgfId-799168]Health & Performance Monitor
 
      	 [bookmark: pgfId-799170]Image Manager
 
      	 [bookmark: pgfId-799172]Dashboard
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-799174]Tip If the client was installed on the workstation, but it does not appear in your Start menu, it probably was installed by another user. To make Security Manager Client visible in the Start menu for every user of the client station, copy the Cisco Security Manager Client folder from Documents and Settings\<user>\Start Menu\Programs\Cisco Security Manager to Documents and Settings\All Users\Start Menu\Programs\Cisco Security Manager.

     
      

     

     
 
     [bookmark: pgfId-799176]Step 2 In the application’s login window, select the server to which you want to log in, and enter your Security Manager username and password. Click Login.
 
     [bookmark: pgfId-799178]The client logs in to the server and opens the application you selected based on the following conditions. Note that these conditions are per application, for example, if you have Configuration Manager open on one workstation, opening Event Viewer from a different workstation has no implications for your Configuration Manager session unless or until you start Configuration Manager from Event Viewer.
 
      
      	 [bookmark: pgfId-799180]In both Workflow and non-Workflow mode, you cannot log into the same server from a single workstation and have more than one active session using the same user account. You are reminded that you are already logged in and asked to reuse the existing open application.
 
      	 [bookmark: pgfId-799182]In both workflow modes, you can log into different servers using the same (or different) user name from the same workstation.
 
      	 [bookmark: pgfId-799184]In non-Workflow mode, for a given server, if the user name is logged in on a different workstation, the client on the other workstation is automatically logged out, and any unsaved changes are lost. Thus, do not share user accounts, and if you must log in from different workstations to the same server, be sure to save your changes before leaving an active client.
 
      	 [bookmark: pgfId-799186]In Workflow mode, you can log in using the same user account multiple times but only from different workstations. However, you cannot open the same activity in Configuration Manager at the same time in more than one client; you must open different activities. Activities do not apply when using Event Viewer or Report Manager.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-799188]Tip The client automatically closes if it is idle for 120 minutes. To change the idle timeout, in Configuration Manager, select Tools > Security Manager Administration, select Customize Desktop from the table of contents, and enter the desired timeout period. You can also disable the feature so that the client does not close automatically. All applications use the same timeout setting, and working in one application resets the timer for all other applications.

     
      

     

     
 
     [bookmark: pgfId-799190]Step 3 To exit the application, select File > Exit.
 
     [bookmark: pgfId-799192]

     
      

     

     
 
    
 
   
 
    
     [bookmark: pgfId-799202][bookmark: 702][bookmark: wfplan_cncpt_UsingSecurityManagerOverview]Using Configuration Manager - Overview [bookmark: marker-799198][bookmark: marker-799200]
 
    [bookmark: pgfId-799204]These topics provide an overview of the different views in which you can work in Configuration Manager, the basic task flow for defining and deploying policies to devices, and some basic concepts:
 
     
     	 [bookmark: pgfId-799209]Configuration Manager Overview
 
     	 [bookmark: pgfId-799214]Task Flow for Configuring Security Policies
 
     	 [bookmark: pgfId-799219]Policy and Policy Object Overview
 
     	 [bookmark: pgfId-799224]Workflow and Activities Overview
 
    
 
     
      [bookmark: pgfId-799240][bookmark: 724][bookmark: wfplan_cncpt_SecurityManagerUserInterfaceOverview]Configuration Manager Overview[bookmark: marker-799230][bookmark: marker-799232][bookmark: marker-799234][bookmark: marker-799236][bookmark: marker-799238]
 
     [bookmark: pgfId-799242]The Configuration Manager application provides three views in which you can manage devices and policies: Device view, Policy view, and Map view. You can switch between these views according to your needs using toolbar buttons or the View menu.
 
      
      	 [bookmark: pgfId-799247]Device view—Provides a device-centric view, where you configure policies on specific devices. For more information, see Device View Overview.
 
      	 [bookmark: pgfId-799252]Policy view—Provides a policy-centric view, where you can create device-independent shared policies that you can assign to one or more devices. For more information, see Policy View Overview.
 
      	 [bookmark: pgfId-799257]Map view—Provides a visual representation of your network, which is primarily useful for visualizing and configuring site-to-site VPNs. For more information, see Map View Overview.
 
     
 
     [bookmark: pgfId-799259]Each view presents a different way to access Configuration Manager functionality. What you can do, and how you do it, are determined by the view you select. In the Device and Policy views you see two selectors on the left and a work area on the right. In each of these, your selection in the upper selector determines what you can select in the lower selector. Your selection in the lower selector determines what you view in the work area. This design enables you to quickly and easily drill down to the network details that you want to view or edit.
 
     [bookmark: pgfId-799261]Besides the main views, there are several additional tools used for configuring other items such as site-to-site VPNs and policy objects, or for monitoring devices. These tools are typically available from the Manage menu, although some are available on the Policy, Activities, Tools, or Launch menus. Some tools have related buttons in the toolbar. These tools open in a separate window so that you do not loose your place in the main view that you are currently using.
 
     [bookmark: pgfId-799263]The following topics provide reference information about the basic features of the user interface:
 
      
      	 [bookmark: pgfId-799268]Menu Bar Reference for Configuration Manager
 
      	 [bookmark: pgfId-799273]Toolbar Reference (Configuration Manager)
 
      	 [bookmark: pgfId-799278]Using Selectors
 
      	 [bookmark: pgfId-799283]Using Wizards
 
      	 [bookmark: pgfId-799288]Using Rules Tables
 
      	 [bookmark: pgfId-799293]Using Text Fields
 
      	 [bookmark: pgfId-799298]Accessing Online Help
 
     
 
    
 
     
      [bookmark: pgfId-799308][bookmark: 776][bookmark: dtchap_cncpt_DeviceViewInterfaceOverview]Device View Overview [bookmark: marker-799304][bookmark: marker-799306]
 
     [bookmark: pgfId-799310]Device view in Configuration Manager enables you to add devices to the Security Manager inventory and to centrally manage device policies, properties, interfaces, and so on. The following figure identifies the functional areas of the Device view.
 
     [bookmark: pgfId-799312]This is a device-centric view in which you can see all devices that you are managing and you can select specific devices to view their properties and define their settings and policies.
 
      
       
     
 
     
 
     [bookmark: pgfId-799317]Note Security Manager also provides the ability to see the status of the devices in the Security Manager inventory. To access the Device Status View, select View > Device Status View or select one of the folder nodes in the Device selector. For more information, see Working with Device Status View.

     
      

     

     
 
     [bookmark: pgfId-799319]In Device View, you can define security policies locally on specific devices. You can then share these policies to make them globally available to be assigned to other devices.
 
     [bookmark: pgfId-799324]For more information, see Understanding the Device View.
 
     [bookmark: pgfId-799328]Figure 1-1 [bookmark: 792]Device View Overview
 
     [bookmark: pgfId-799332]
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     [bookmark: pgfId-799334]The title bar displays the following information about Security Manager:
 
      
      	 [bookmark: pgfId-799336]Your login name.
 
      	 [bookmark: pgfId-799338]The name of the Security Manager server to which you are connected.
 
      	 [bookmark: pgfId-799340]If Workflow mode is enabled, the name of the open activity.
 
     
 
    
 
     
      [bookmark: pgfId-799350][bookmark: 846][bookmark: dtchap_cncpt_PolicyViewInterfaceOverview]Policy View Overview [bookmark: marker-799346][bookmark: marker-799348]
 
     [bookmark: pgfId-799352]Policy view in Configuration Manager enables you to create and manage reusable policies that can be shared among multiple devices. The following figure identifies the functional areas of the Policy view.
 
     [bookmark: pgfId-799354]This is a policy-centric view in which you can see all the shareable policy types supported by Security Manager. You can select a specific policy type and create, view, or modify shared policies of that type. You can also see the devices to which each shared policy is assigned and change the assignments as required.
 
     [bookmark: pgfId-799359]For more information, see Managing Shared Policies in Policy View.
 
     [bookmark: pgfId-799363]Figure 1-2 [bookmark: 858]Policy View Overview
 
     [bookmark: pgfId-799367]
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         	[bookmark: pgfId-795157]Title bar
  
         	
           
           [bookmark: pgfId-795159]2
          
  
         	[bookmark: pgfId-795164]Menu bar (see Menu Bar Reference for Configuration Manager)
  
        
 
         
         	
           
           [bookmark: pgfId-795174]3
          
  
         	[bookmark: pgfId-795179]Toolbar (see Toolbar Reference (Configuration Manager))
  
         	
           
           [bookmark: pgfId-795181]4
          
  
         	[bookmark: pgfId-795186]Policy type selector (see Using Selectors)
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         	[bookmark: pgfId-795198]Work area
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         	[bookmark: pgfId-795202]Shared policy selector
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         	[bookmark: pgfId-795214]Policy filter
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      [bookmark: pgfId-799377][bookmark: 916][bookmark: dtchap_cncpt_MapViewInterfaceOverview]Map View Overview [bookmark: marker-799373][bookmark: marker-799375]
 
     [bookmark: pgfId-799379]Map view in Configuration Manager enables you to create customized, visual topology maps of your network, within which you can view connections between your devices and easily configure VPNs and access control settings. The following figure identifies the functional areas of the Map view.
 
     [bookmark: pgfId-799384]For more information, see Chapter 35, “Using Map View”.
 
     [bookmark: pgfId-799388]Figure 1-3 [bookmark: 927]Map View Overview
 
     [bookmark: pgfId-799392]
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         	[bookmark: pgfId-795231]Title bar
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         	[bookmark: pgfId-795235]Navigation window
  
        
 
         
         	
           
           [bookmark: pgfId-795245]3
          
  
         	[bookmark: pgfId-795250]Menu bar (see Map Menu (Configuration Manager))
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         	[bookmark: pgfId-795257]Toolbar (see Toolbar Reference (Configuration Manager))
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         	[bookmark: pgfId-795272]Map toolbar (see Map Toolbar)
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      [bookmark: pgfId-799402][bookmark: 974][bookmark: wfplan_proc_UserTaskflow]Task Flow for Configuring Security Policies [bookmark: marker-799398][bookmark: marker-799400]
 
     [bookmark: pgfId-799404]The basic user task flow for configuring security policies on devices involves adding devices to the Security Manager inventory, defining the policies, and then deploying them to the devices. You perform these tasks in Configuration Manager. The following briefly describes the steps in a typical user task flow:
 
     
 
     [bookmark: pgfId-799406]Step 1 Prepare devices for management.
 
     [bookmark: pgfId-799411]Before you can add a device to the Security Manager device inventory and manage it, you must configure some minimal settings on the device to enable Security Manager to contact it. For more information, see Chapter 2, “Preparing Devices for Management”.
 
     [bookmark: pgfId-799413]Step 2 Add devices to the Security Manager device inventory.
 
     [bookmark: pgfId-799415]To manage a device with Security Manager, you must first add it to the Security Manager inventory. Security Manager provides multiple methods to add devices: from the network (live devices), from an inventory file exported from another Security Manager server or CiscoWorks Common Services Device Credential Repository (DCR), or in Cisco Security Monitoring, Analysis and Response System (CS-MARS) format, or from a device configuration file. You can also add a device that does not yet exist in the network but which will be deployed in the future, by creating it in Security Manager.
 
     [bookmark: pgfId-799417]When you add a device, you can also discover its interfaces and certain policies that were already configured on the device. Discovery brings the information into the Security Manager database for continued management with Security Manager in the future.
 
     [bookmark: pgfId-799422]For more information, see Chapter 3, “Managing the Device Inventory”.
 
     [bookmark: pgfId-799424]Step 3 Define security policies.
 
     [bookmark: pgfId-799426]After you have added your devices, you can define the security policies you require. You can use Device view to define policies on specific devices. You can use Policy view to create and manage reusable policies that can be shared by any number of devices. When you make a change to a shared policy, the change is applied to all devices to which that policy is assigned.
 
     [bookmark: pgfId-799428]To simplify and speed up policy definition, you can use policy objects, which are named, reusable representations of specific values. You can define an object once and then reference it in multiple policies instead of having to define the values individually in each policy.
 
      
       
     
 
     
 
     [bookmark: pgfId-799433]Note If you are using Workflow mode, you must create an activity before you start defining policies. For more information, see Workflow and Activities Overview.

     
      

     

     
 
     [bookmark: pgfId-799435]For more information, see these topics:
 
      
      	 [bookmark: pgfId-799440]Chapter 5, “Managing Policies”
 
      	 [bookmark: pgfId-799445]Chapter 6, “Managing Policy Objects”
 
     
 
     [bookmark: pgfId-799447]Step 4 Submit and deploy your policy definitions.
 
     [bookmark: pgfId-799449]Policy definition is done within your private view. Your definitions are not committed to the database and cannot be seen by other Security Manager users until you submit them. When you submit your policy definitions, the system validates their integrity. Errors or warnings are displayed to inform you of any problems that need to be addressed before the policies can be deployed to the devices.
 
     [bookmark: pgfId-799451]Security Manager generates CLI commands according to your policy definitions and enables you to quickly and easily deploy them to your devices. You can deploy directly to live devices in the network (including dynamically addressed devices) through a secure connection, or to files that can be transferred to your devices at any time.
 
     [bookmark: pgfId-799453]In non-Workflow mode, submitting and deploying your changes can be done in a single action. In Workflow mode, you first submit your activity and then you create a deployment job to deploy your changes.
 
     [bookmark: pgfId-799458]For more information, see Chapter 8, “Managing Deployment”.
 
     [bookmark: pgfId-799460]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-799482][bookmark: 1020][bookmark: wfplan_cncpt_PolicyOverview]Policy and Policy Object Overview[bookmark: marker-799466][bookmark: marker-799468][bookmark: marker-799470][bookmark: marker-799472][bookmark: marker-799474][bookmark: marker-799476][bookmark: marker-799478][bookmark: marker-799480]
 
     [bookmark: pgfId-799484]A policy is a set of rules or parameters that define a particular aspect of network configuration. In Configuration Manager, you define policies that specify the security functionality you want on your devices. Security Manager translates your policies into CLI commands that can be deployed to the relevant devices.
 
     [bookmark: pgfId-799486]Security Manager enables you to configure local policies and shared policies.
 
      
      	 [bookmark: pgfId-799488] Local policies are confined to the device on which they are configured; they are automatically assigned (applied) to the device when you configure them. Unconfigured policies (those whose default settings you do not change) are not considered to be assigned or configured. To remove a policy, you unassign it.
 
      	 [bookmark: pgfId-799490] Shared policies are named, reusable policies that can be assigned to multiple devices at once. Any changes you make to a shared policy are reflected on all devices to which that policy is assigned, so you do not have to make the change on each device.
 
     
 
     [bookmark: pgfId-799492]When you add a device to the inventory, you can discover the existing policies configured on the device. Security Manager translates your device configuration into Security Manager policies, populates the relevant local policies, and assigns them to the device. Policy discovery ensures that you do not need to recreate your existing configurations in Security Manager terms. You can also rediscover policies on devices after you add them to the inventory if you change their configuration through the CLI.
 
     [bookmark: pgfId-799494]When you create policies, you often have the option to use policy objects, which are reusable definitions of related sets of values. (Sometimes, you are required to use policy objects.) For example, you can define a network object called MyNetwork that contains a set of IP addresses in your network. Whenever you configure a policy requiring these addresses, you can simply refer to the MyNetwork network object rather than manually entering the addresses each time. Furthermore, you can make changes to policy objects in a central location and these changes will be reflected in all the policies that reference those objects.
 
     [bookmark: pgfId-799502]For more detailed information, see Understanding Policies and Chapter 6, “Managing Policy Objects”.
 
    
 
     
      [bookmark: pgfId-799520][bookmark: 1063][bookmark: wfplan_cncpt_WorkflowOverview]Workflow and Activities Overview[bookmark: marker-799508][bookmark: marker-799510][bookmark: marker-799512][bookmark: marker-799514][bookmark: marker-799516][bookmark: marker-799518]
 
     [bookmark: pgfId-799522]To provide flexible, secure policy management while allowing your organization to implement change control processes, Security Manager provides three closely-related features in Configuration Manager:
 
      
      	 [bookmark: pgfId-799524] Workflow/Non-Workflow modes —Configuration Manager provides two modes of operation that scale to different organizational working environments: Workflow mode and non-Workflow mode (the default).
 
     
 
     [bookmark: pgfId-799529] – Workflow Mode—Workflow mode is for organizations that have division of responsibility between users who define security policies and those who administer security policies. It imposes a formal change-tracking and management system by requiring all policy configuration to be done within the context of an explicitly-created activity. A user can create multiple activities so that a single activity contains only logically-related policy changes. You can configure Workflow mode to require a separate approver, so that configuration changes cannot be made without oversight. After approval, the user defines a separate deployment job to push the policy changes to the devices. For more information, see Working in Workflow Mode.
 
     [bookmark: pgfId-799534] – Non-Workflow Mode—In non-Workflow mode, you do not explicitly create activities. When you log in, Configuration Manager creates an activity for you or opens the one you were previously using if it was not submitted. You can define and save your policies, and then submit and deploy them in one step. For more information, see Working in Non-Workflow Mode.
 
     [bookmark: pgfId-799539]For information on selecting a mode, see Changing Workflow Modes.
 
      
      	 [bookmark: pgfId-799547] Activities or Configuration Sessions —An activity (in non-Workflow mode, a configuration session), is essentially a private view of the Security Manager database. In Configuration Manager, you use activities to control changes made to policies and policy assignments. Adding devices to the inventory does not involve an activity, however, unless you discover policies that define security contexts (on multi-context firewall devices) or virtual sensors (on IPS devices). Isolating policy changes in activities helps prevent “work in progress” from accidentally making it into active device configurations. For more information about activities and configuration sessions, see Understanding Activities and Working with Activities/Tickets.
 
      	 [bookmark: pgfId-799549] Ticket Management —Ticket management allows you to associate a Ticket ID with policy configuration changes made in Security Manager. Ticket management works in coordination with activities or configuration sessions depending on whether you have workflow mode enabled or not. If workflow mode is enabled, you can also enable ticket management so that a Ticket ID can optionally be associated with a specific activity. If workflow mode is not enabled, using ticket management makes it so that all changes must be done as part of a ticket and the ticket must be submitted before those changes can be deployed. In this respect, ticket management with workflow disabled is very similar to how activities function when workflow is enabled; however, no approval of submitted tickets is required.
 
     
 
     [bookmark: pgfId-799554]For a comparison of the various modes of operation, see Comparing Workflow Modes.
 
    
 
     
      [bookmark: pgfId-799562][bookmark: 1109][bookmark: defapset_cncpt_WorkinginWorkflowMode]Working in Workflow Mode[bookmark: marker-799560]
 
     [bookmark: pgfId-799564]Workflow mode is an advanced mode of operation that imposes a formal change-tracking and change-management system. Workflow mode is suitable for organizations in which there is division of responsibility among security and network operators for defining policies and deploying those policies to devices. For example, a security operator might be responsible for defining security policies on devices, another security operator might be responsible for approving the policy definitions, and a network operator might be responsible for deploying the resulting configurations to a device. This separation of responsibility helps maintain the integrity of deployed device configurations.
 
     [bookmark: pgfId-799566]You can use Workflow mode with or without an approver. When using Workflow mode with an approver, device management and policy configuration changes performed by one user are reviewed and approved by another user before being deployed to the relevant devices. When using Workflow mode without an approver, device and policy configuration changes can be created and approved by a single user, thus simplifying the change process.
 
      
       
     
 
     
 
     [bookmark: pgfId-799568]Note Workflow mode works in the same manner whether Ticket Management is enabled or not. Enabling Ticket Management in Workflow mode simply enables the Ticket field for use with Activities. Entering a ticket ID is not required, but if one is used, the Ticket field can be configured to link to an external change management system. For more information, see Ticket Management.

     
      

     

     
 
     [bookmark: pgfId-799573]For information about enabling or disabling Workflow mode or enabling or disabling Ticket Management, see Changing Workflow Modes.
 
     [bookmark: pgfId-799575]In Workflow mode:
 
      
      	 [bookmark: pgfId-799580]A user must create an activity before defining or changing policy configurations in Configuration Manager. The activity is essentially a proposal to make configuration changes. The changes made within the activity are applied only after the activity is approved by a user with the appropriate permissions. An activity can either be submitted to another user for review and approval (Workflow mode with an activity approver), or it can be approved by the current user (Workflow mode without an activity approver). For detailed information about the process of creating, submitting, and approving activities, see Chapter 4, “Managing Activities”.
 
      	 [bookmark: pgfId-799585]After the activity is approved, the configuration changes need to be deployed to the relevant devices. To do this, a user must create a  deployment job . A deployment job defines the devices to which configurations will be deployed, and the deployment method to be used. A deployment job can either be submitted to another user for review and approval (Workflow mode with a deployment job approver), or it can be approved by the current user (Workflow mode without a job approver). Deployment preferences can be configured with or without job approval. For more information, see Chapter 8, “Managing Deployment”
 
     
 
    
 
     
      [bookmark: pgfId-799593][bookmark: 1129][bookmark: defapset_cncpt_WorkinginNonWorkflowMode]Working in Non-Workflow Mode[bookmark: marker-799591]
 
     [bookmark: pgfId-799595]Some organizations have no division of responsibility between users when defining and administering their VPN and firewall policies. These organizations can work in non-Workflow mode. When using non-Workflow mode, you do not explicitly create activities. When you log in, Configuration Manager creates an activity for you, also called a configuration session, or opens the activity you were using when previously logged in (the configuration session is automatically closed when you log out of Security Manager). This activity is transparent to the user and does not need to be managed in any way. When you submit your configuration changes to the database, this is equivalent to submitting and approving the activity in Workflow mode. In addition, when you submit and deploy configuration changes, Security Manager creates a deployment job for you as well. Like activities, deployment jobs are transparent and do not need to be managed.
 
     [bookmark: pgfId-799597]When using non-Workflow mode, multiple users with the same username and password cannot be logged into Security Manager at the same time. If another user logs in with the same username and password while you are working, your session will be terminated and you will have to log in again.
 
     [bookmark: pgfId-799599]Ticket Management in Non-Workflow Mode
 
     [bookmark: pgfId-799601]If your organization uses a change management system, Security Manager can associate the changes made to configurations with a ticket ID. Before making any configuration changes, you must open a ticket and the ticket must be submitted before the changes associated with that ticket are available to be deployed. Tickets can be opened and closed as needed, and you can discard a ticket if the changes associated with that ticket are no longer desired. Entering a ticket ID is not required, but if one is used, the Ticket field can be configured to link to an external change management system. For more information, see Ticket Management.
 
     [bookmark: pgfId-799606]Non-Workflow mode with Ticket Management enabled is the default mode for Security Manager. For information about enabling or disabling Workflow mode or enabling or disabling Ticket Management, see Changing Workflow Modes.
 
    
 
     
      [bookmark: pgfId-799620][bookmark: 1142][bookmark: defapset_cncpt_ComparingtheTwoWorkflowModes]Comparing Workflow Modes[bookmark: marker-799612][bookmark: marker-799614][bookmark: marker-799616][bookmark: marker-799618]
 
     [bookmark: pgfId-799622]The following table highlights the differences between the workflow modes.
 
      
       
     
 
     
 
     [bookmark: pgfId-799624]Note Workflow mode works in the same manner whether Ticket Management is enabled or not. Enabling Ticket Management in Workflow mode simply enables the Ticket field for use with Activities. Entering a ticket ID is not required, but if one is used, the Ticket field can be configured to link to an external change management system. For more information, see Ticket Management.

     
      

     

     
 
     [bookmark: pgfId-799627]
 
      
       
        
        [bookmark: pgfId-795293]Table 1-1 [bookmark: 1161]Comparison Between Workflow Mode and Non-Workflow Mode in Configuration Manager 
 
        
       
         
         	
           
           [bookmark: pgfId-795303]Question
          
  
         	
           
           [bookmark: pgfId-795305]Non-Workflow Mode with Ticket Management Enabled
          
  
         	
           
           [bookmark: pgfId-795307]Non-Workflow Mode with Ticket Management Disabled
          
  
         	
           
           [bookmark: pgfId-795309]Workflow Mode
          
  
        
 
         
         	[bookmark: pgfId-795319]What is the default mode for Security Manager?
  
         	[bookmark: pgfId-795321]Default
  
         	[bookmark: pgfId-795323]Not Default
  
         	[bookmark: pgfId-795325]Not default
  
        
 
         
         	[bookmark: pgfId-795335]How do I know which mode is currently selected?
  
         	 [bookmark: pgfId-795337]Select Tools > Security Manager Administration > Workflow. If the Enable Workflow check box is selected, you are in Workflow mode.
 [bookmark: pgfId-795339]Select Tools > Security Manager Administration > Ticket Management. If the Enable Ticketing check box is selected, ticket management is enabled.
  
        
 
         
         	[bookmark: pgfId-795353]Must I explicitly create activities to make configuration changes?
  
         	[bookmark: pgfId-795355]You must explicitly create a Ticket before you can make configuration changes. Configuration Manager automatically creates an activity that is associated with that ticket.
  
         	[bookmark: pgfId-795357]No. Configuration Manager automatically creates an activity when you log in, or opens the previous session if you did not submit it before logging out.
  
         	[bookmark: pgfId-795359]Yes.
  
        
 
         
         	[bookmark: pgfId-795369]Must I explicitly create deployment jobs to deploy configurations to devices?
  
         	[bookmark: pgfId-795371]No. Configuration Manager creates a deployment job for you when you deploy configuration changes.
  
         	[bookmark: pgfId-795373]No. Configuration Manager creates a deployment job for you when you deploy configuration changes.
  
         	[bookmark: pgfId-795375]Yes.
  
        
 
         
         	[bookmark: pgfId-795385]How do I deploy my configuration changes to the devices?
  
         	[bookmark: pgfId-795387]Do one of the following:
 
           
           	 [bookmark: pgfId-795389]Select  File > Deploy .
 
           	 [bookmark: pgfId-795391]Select  Manage > Deployments and click  Deploy on the Deployment Jobs tab.
 
          
  
         	[bookmark: pgfId-795393]Do one of the following:
 
           
           	 [bookmark: pgfId-795395]Click the  Submit and Deploy Changes button in the Main toolbar.
 
           	 [bookmark: pgfId-795397]Select  File > Submit and Deploy .
 
           	 [bookmark: pgfId-795399]Select  Manage > Deployments and click  Deploy on the Deployment Jobs tab.
 
          
  
         	[bookmark: pgfId-795401]Select Manage > Deployments and create a deployment job.
  
        
 
         
         	[bookmark: pgfId-795411]At what stage are the CLI commands for my configuration changes generated?
  
         	[bookmark: pgfId-795413]When initiating deployment.
  
         	[bookmark: pgfId-795415]When initiating deployment.
  
         	[bookmark: pgfId-795417]When creating a deployment job.
  
        
 
         
         	[bookmark: pgfId-795427]How do I delete my current changes?
  
         	[bookmark: pgfId-795429]Select Tickets > Discard Ticket to discard the currently-open ticket, or select the ticket in the Ticket Manager and click Discard.
 [bookmark: pgfId-795431]If you have already started deploying devices, abort the deployment by selecting the job in the Deployment Manager and clicking Abort.
  
         	[bookmark: pgfId-795433]Select File > Discard.
 [bookmark: pgfId-795435]If you have already started deploying devices, abort the deployment by selecting the job in the Deployment Manager and clicking Abort.
  
         	[bookmark: pgfId-795437]Select Activities > Discard Activity to discard the currently-open activity, or select the activity in the Activity Manager and click Discard.
 [bookmark: pgfId-795439]If you already created a deployment job, select the job in the Deployment Manager and click Discard. If the job has already been deployed, you can abort the job by selecting Abort.
  
        
 
         
         	[bookmark: pgfId-795449]Can multiple users log into Security Manager at the same time?
  
         	[bookmark: pgfId-795451]Yes. Each user can open a different ticket and make configuration changes. A single user can log in multiple times, but the user must open separate tickets.
  
         	[bookmark: pgfId-795453]Yes, but only if each one has a different username. If a user with the same username logs into Security Manager, the first user is automatically logged out.
  
         	[bookmark: pgfId-795455]Yes. Each user can open a different activity and make configuration changes. A single user can log in multiple times, but the user must open separate activities.
  
        
 
         
         	[bookmark: pgfId-795465]What if another user is configuring the devices I want to configure?
  
         	 [bookmark: pgfId-795470]You will receive a message indicating that the devices are locked. See Activities and Locking.
  
        
 
       
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-799635][bookmark: 1293][bookmark: wfplan_cncpt_UsingtheJumpStart]Using the JumpStart to Learn About Security Manager[bookmark: marker-799633]
 
    [bookmark: pgfId-799637]The JumpStart is an introduction to Security Manager. It describes and illustrates the major concepts of using the product. Use the jumpstart to explore Security Manager features and capabilities.
 
    [bookmark: pgfId-799639]The JumpStart opens automatically when you first launch Security Manager. To get to the JumpStart while you are working with Security Manager, select Help > JumpStart from the main menu in Configuration Manager.
 
    [bookmark: pgfId-799641]The JumpStart contains the following navigation features:
 
     
     	 [bookmark: pgfId-799643]A table of contents, which is always visible in the upper right corner. Click an entry to open its page.
 
     	 [bookmark: pgfId-799645]Links in the page enable you to drill down to more detailed information in the JumpStart or to relevant information in the online help.
 
    
 
   
 
    
     [bookmark: pgfId-799655][bookmark: 1307][bookmark: wfplan_cncpt_CompletingtheInitialSecurityManagerConfiguration]Completing the Initial Security Manager Configuration[bookmark: marker-799651][bookmark: marker-799653]
 
    [bookmark: pgfId-799657]After you install Security Manager, there are several configuration steps you might want to perform to complete the installation. Although most of the features you initially configure have default settings, you should familiarize yourself with the features and decide if the default settings are the best settings for your organization.
 
    [bookmark: pgfId-799659]The following list explains the features you might want to initially configure, with pointers to topics that provide more detailed information where appropriate. You can configure these features in any order, or delay configuring those that you do not yet need to use.
 
     
     	 [bookmark: pgfId-799661]Configure an SMTP server and default e-mail addresses. Security Manager can send e-mail notifications for several actions that occur in the system. For example, you can get an e-mail when your deployment job finishes reconfiguring network devices. For e-mail notifications to work, you must configure an SMTP server.
 
    
 
    [bookmark: pgfId-799666]For information on configuring an SMTP server and setting the default e-mail addresses, see Configuring an SMTP Server and Default Addresses for E-Mail Notifications
 
     
     	 [bookmark: pgfId-799670]Create user accounts. Users must log into Security Manager to use the product. However, if a user logs in with an account another user is already using, the first user is automatically disconnected. Thus, each user should have a unique account. You can create accounts local to the Security Manager server, or you can use your ACS system to manage user authentication. For more information, see the  Installation Guide for Cisco Security Manager 
 
     	 [bookmark: pgfId-799675]Configure default deployment settings. When users deploy configurations to devices, they can select how the configurations should be deployed and how Security Manager should handle anomalies. However, you can select system-default settings that make it easier for users to follow your organization’s recommendations. To set deployment defaults, in Configuration Manager, select  Tools > Security Manager Administration , and then select  Deployment from the table of contents to open the Deployment settings page (see Deployment Page).
 
    
 
    [bookmark: pgfId-799677]The following deployment settings are of particular interest:
 
    [bookmark: pgfId-799682] – Default Deployment Method—Whether configuration deployments should be written directly to the device or to a transport server, or if configuration files should be written to a specified directory on the Security Manager server. The default is to deploy configurations directly to the device or transport server, if one is configured for the device. However, if you have your own methods for deploying configuration files, you might want to select File as the default deployment method. For more information on deployment methods, see Understanding Deployment Methods
 
    [bookmark: pgfId-799687] – When Out-of-Band Changes Detected—How to respond when Security Manager detects that configuration changes were made on the device through the CLI rather than through Security Manager. The default is to issue a warning and proceed with the deployment, overwriting the changes that were made through the CLI. However, you can change this behavior to simply skip the check for changes (which means Security Manager overwrites the changes but does not warn you), or to cancel the deployment, thus leaving the device in its current state. For more information about handling out-of-bound changes, see Understanding How Out-of-Band Changes are Handled.
 
    [bookmark: pgfId-799689] – Allow Download on Error—Whether to allow deployment to continue if minor configuration errors are found. The default is to not allow deployment when minor errors are found.
 
     
     	 [bookmark: pgfId-799697]Select a workflow mode. The default mode is non-Workflow mode with Ticket Management enabled. In non-Workflow mode, users have more freedom to create and deploy configurations. However, if your organization requires a more transaction-oriented approach to network management, where separate individuals perform policy creation, approval, and deployment, you can enable Workflow mode to enforce your procedures. If you are using Workflow mode, ensure that you configure user permissions appropriately when you define user accounts to enforce your required division of labor. For information on the types of workflow you can use, see Workflow and Activities Overview. For information on how to change workflow modes, see Changing Workflow Modes.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-799699]Tip You can disable Ticket Management in non-Workflow mode to make most activity management tasks automatic.

    
     

    

    
 
     
     	 [bookmark: pgfId-799704]Configure default device communication settings. Security Manager uses the most commonly used methods for accessing devices based on the type of device. For example, Security Manager uses SSH by default when contacting Catalyst switches. If the default protocols work for the majority of your devices, you do not need to change them. For devices that should use a non-default protocol, you can change the protocol in the device properties for the specific devices. However, if you typically use a protocol that is not the Security Manager default (for example, if you use a token management server (TMS) for your routers), you should change the default setting. To change the default communication settings, in Configuration Manager, select  Tools > Security Manager Administration , and select  Device Communication from the table of contents. In the Device Connection Settings group, select the most appropriate protocols for each type of device. You can also change the default connection time out and retry settings. For more information about device communication settings, see Device Communication Page
 
     	 [bookmark: pgfId-799709]Select the types of router and firewall policies you will manage with Security Manager. When you manage IPS devices in Security Manager, you automatically manage the entire configuration. However, with routers and firewall devices (ASA, PIX, and FWSM), you can select which types of policies are managed by Security Manager. You can manage other parts of the device configuration using other tools (including the devices’s CLI). By default, all security-related policies are managed. To change which policies are managed, in Configuration Manager, select  Tools > Security Manager Administration > Policy Management . For detailed information about changing these settings and what you should do before and after making the change, see Customizing Policy Management for Routers and Firewall Devices.
 
     	 [bookmark: pgfId-799714]Decide whether you want to use the Event Viewer to manage firewall and IPS events. You can configure the disk and location for collecting syslog events from devices, and the port number to use for syslog communication. If you do not want to use Security Manager for event management, you can turn off the feature, which is enabled by default. For more information on the configuration options, see Event Management Page.
 
     	 [bookmark: pgfId-799719]Configure Security Manager for communication with Cisco Security Monitoring, Analysis and Response System (CS-MARS). If you use CS-MARS for monitoring your network, you can identify the servers to Security Manager and then access CS-MARS event information from within Security Manager. For information on configuring this cross-communication, see Checklist for Integrating CS-MARS with Security Manager.
 
    
 
     
      [bookmark: pgfId-799733][bookmark: 1361][bookmark: wfplan_proc_ConfiguringanSMTPServerforEmailNotifications]Configuring an SMTP Server and Default Addresses for E-Mail Notifications [bookmark: marker-799725][bookmark: marker-799727][bookmark: marker-799729][bookmark: marker-799731]
 
     [bookmark: pgfId-799735]Security Manager can send e-mail notifications for several types of events such as deployment job completion, activity approval, or ACL rule expiration. To enable e-mail notifications, you must configure an SMTP server that Security Manager can use for sending the e-mails. Then, you can configure e-mail addresses and notification settings on these settings pages (in Configuration Manager, select Tools > Security Manager Administration and select the page from the table of contents):
 
      
      	 [bookmark: pgfId-799737]Workflow page—For default e-mail addresses and notification settings for deployment jobs and activities. Users can override the defaults when managing deployment jobs and activities.
 
      	 [bookmark: pgfId-799739]Rules Expiration page—For default e-mail addresses and notification settings for ACL rule expiration. Rules expire only if you configure them with expiration dates.
 
      	 [bookmark: pgfId-799741]IPS Updates page—For the e-mail address that should be notified of IPS update availability.
 
      	 [bookmark: pgfId-799743]Server Security page—When you configure local user accounts (click  Local User Setup ), specify the user’s e-mail address. This address is used as the default target for some notifications such as deployment job completion.
 
      	 [bookmark: pgfId-799745]Event Management page—When you configure an extended data storage location, you must specify at least one e-mail address. The email addresses receive notifications if problems arise with the use of the extended storage location. Also, if you are using the Syslog Relay Service, you can configure e-mail addresses that should be notified when the syslog relay service enters or exits CPU throttling.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-799749]Tip If you are using ACS for user authorization, you might have already configured an SMTP server and system administrator e-mail address in the ACS integration procedure as described in the Installation Guide for Cisco Security Manager. Security Manager sends a notification to this address if all ACS servers become unavailable.

     
      

     

     
 
     
 
     [bookmark: pgfId-799751]Step 1 Access CiscoWorks Common Services on the Security Manager server:
 
      
      	 [bookmark: pgfId-799753]If you are currently using the Security Manager client, the easiest way to do this is to select  Tools > Security Manager Administration , select  Server Security from the table of contents, and click any button on that page (for example,  Local User Setup ).
 
      	 [bookmark: pgfId-799755]You can use your web browser to log into the home page on the Security Manager server (https:// servername /CSCOnm/servlet/login/login.jsp) and click  Server Administration .
 
     
 
     [bookmark: pgfId-799757]Step 2 Click Server > Admin and select System Preferences from the table of contents.
 
     [bookmark: pgfId-799759]Step 3 On the System Preferences page, enter the host name or IP address of an SMTP server that Security Manager can use. The SMTP server cannot require user authentication for sending e-mail messages.
 
     [bookmark: pgfId-799761]Also, enter an e-mail address that CiscoWorks can use for sending e-mails. This does not have to be the same e-mail address that you configure for Security Manager to use when sending notifications. If you are using ACS for authorization, Security Manager sends an e-mail message to this address if all ACS servers become unavailable. This can alert you to a problem that needs immediate attention. The administrator might also receive e-mail messages from Common Services for non-ACS-related events.
 
     [bookmark: pgfId-799763]Step 4 Click Apply to save your changes.
 
     [bookmark: pgfId-799765]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-799777][bookmark: 1418][bookmark: defapset_proc_EnablingandDisablingWorkflowModes]Changing Workflow Modes [bookmark: marker-799771][bookmark: marker-799773][bookmark: marker-799775]
 
     [bookmark: pgfId-799779]You can change the workflow mode that Security Manager enforces if you have the appropriate administrator permissions. Changing the workflow mode has significant effects on users. Before making a change, be sure to understand the following:
 
      
      	 [bookmark: pgfId-799781]When you change the workflow mode, the change will take effect for all Security Manager users working from the same server.
 
      	 [bookmark: pgfId-799783]Before you can change from Workflow mode to non-Workflow mode, all activities in editable states (Edit, Edit Open, Submit, or Submit Open) must be approved or discarded, and all generated jobs must be deployed, rejected, discarded, or aborted so that the locks on the devices can be released. You do not have to do anything to jobs that are in the failed state.
 
      	 [bookmark: pgfId-799785]Before you can disable Ticket Management in non-Workflow mode, all tickets in editable states (Edit or Edit Open) must be submitted or discarded.
 
      	 [bookmark: pgfId-799787]If you change from Workflow mode to non-Workflow mode and then restore an earlier version of the database, Security Manager automatically changes to Workflow mode if the restored database has any activities in an editable state (Edit, Edit Open, Submit, or Submit Open). Approve or delete the editable activities, and then turn Workflow mode off again.
 
      	 [bookmark: pgfId-799789]When changing from non-Workflow mode to Workflow mode or enabling Ticket Management in non-Workflow mode, current configuration sessions are listed as activities/tickets in the Edit_Open state, and these activities/tickets must now be explicitly managed.
 
      	 [bookmark: pgfId-799791]When Ticket Management is enabled or disabled, any other users logged into Security Manager are logged out.
 
     
 
     [bookmark: pgfId-799796]For an explanation of workflow modes, see Workflow and Activities Overview.
 
     
 
     [bookmark: pgfId-799801]Step 1 In Configuration Manager, select Tools > Security Manager Administration and select Workflow from the table of contents to open the Workflow page (see Workflow Page).
 
     [bookmark: pgfId-799803]Step 2 Configure the workflow mode settings in the Workflow Control group. If you select Enable Workflow (to use Workflow mode), you can also select these options:
 
      
      	 [bookmark: pgfId-799805]Require Activity Approval—To enforce explicit approval of activities before policy changes are committed to the database.
 
      	 [bookmark: pgfId-799807]Require Deployment Approval—To enforce explicit approval of deployment jobs before they can be run.
 
     
 
     [bookmark: pgfId-799809]Step 3 Configure the e-mail notification settings. These are the default e-mail addresses for the e-mail sender (that is, Security Manager), the approvers, and another person or e-mail alias who should be notified when deployment jobs are complete.
 
     [bookmark: pgfId-799811]You also have the options to include the job deployer when sending notifications of job status, and to require that e-mail notifications are sent for deployment job status changes.
 
     [bookmark: pgfId-799813]Step 4 Click Save to save and apply changes.
 
     [bookmark: pgfId-799818]Step 5 Select Workflow from the table of contents to open the Ticket Management page (see Ticket Management Page).
 
     [bookmark: pgfId-799820]Step 6 Configure the Ticket Management settings. If you select Enable Ticketing, you can also select these options:
 
      
       
     
 
     
 
     [bookmark: pgfId-799825]Note See Ticket Management Page for detailed information on these fields.

     
      

     

     
 
      
      	 [bookmark: pgfId-799827]Ticket System URL—To provide linking between a Ticket ID and an external ticket management system.
 
      	 [bookmark: pgfId-799829]Ticket History—Specify how long to keep information related to tickets.
 
     
 
     [bookmark: pgfId-799831]Step 7 Click Save to save and apply changes.
 
     [bookmark: pgfId-799833]

     
      

     

     
 
    
 
   
 
    
     [bookmark: pgfId-799841][bookmark: 1484][bookmark: wfplan_cncpt_UnderstandingBasicSecurityManagerInterfaceFeatures]Understanding Basic Security Manager Interface Features[bookmark: marker-799839]
 
    [bookmark: pgfId-799843]The following topics provide information about some basic interface features such as descriptions of the menu commands, toolbar buttons, and how to use common user interface elements. Many of the features described are used only in Configuration Manager.
 
     
     	 [bookmark: pgfId-799848]Menu Bar Reference for Configuration Manager
 
     	 [bookmark: pgfId-799853]Toolbar Reference (Configuration Manager)
 
     	 [bookmark: pgfId-799858]Using Selectors
 
     	 [bookmark: pgfId-799863]Using Wizards
 
     	 [bookmark: pgfId-799868]Using Tables
 
     	 [bookmark: pgfId-799873]Using Text Fields
 
     	 [bookmark: pgfId-799878]Selecting or Specifying a File or Directory in Security Manager
 
     	 [bookmark: pgfId-799883]Troubleshooting User Interface Problems
 
    
 
     
      [bookmark: pgfId-799893][bookmark: 1515][bookmark: dtchap_cncpt_MenuBarReference]Menu Bar Reference for Configuration Manager[bookmark: marker-799889][bookmark: marker-799891]
 
     [bookmark: pgfId-799895]The menu bar in Configuration Manager contains menus with commands for using Security Manager. Commands may become unavailable depending on the task you are performing.
 
     [bookmark: pgfId-799897]The menus in the menu bar are described in the following topics:
 
      
      	 [bookmark: pgfId-799902]File Menu (Configuration Manager)
 
      	 [bookmark: pgfId-799907]Edit Menu (Configuration Manager)
 
      	 [bookmark: pgfId-799912]View Menu (Configuration Manager)
 
      	 [bookmark: pgfId-799917]Policy Menu (Configuration Manager)
 
      	 [bookmark: pgfId-799922]Map Menu (Configuration Manager)
 
      	 [bookmark: pgfId-799927]Manage Menu (Configuration Manager)
 
      	 [bookmark: pgfId-799932]Tools Menu (Configuration Manager)
 
      	 [bookmark: pgfId-799937]Launch Menu (Configuration Manager)
 
      	 [bookmark: pgfId-799942]Activities Menu (Configuration Manager)
 
      	 [bookmark: pgfId-799947]Tickets Menu (Configuration Manager)
 
      	 [bookmark: pgfId-799952]Help Menu (Configuration Manager)
 
     
 
    
 
     
      [bookmark: pgfId-799964][bookmark: 1559][bookmark: dtchap_cncpt_FileMenu]File Menu (Configuration Manager)[bookmark: marker-799958][bookmark: marker-799960][bookmark: marker-799962]
 
     [bookmark: pgfId-799966]The following table describes the commands on the File menu in Configuration Manager. The menu items differ depending on the workflow mode.
 
     [bookmark: pgfId-799969]
 
      
       
        
        [bookmark: pgfId-795487]Table 1-2 [bookmark: 1572]File Menu (Configuration Manager) 
 
        
       
         
         	
           
           [bookmark: pgfId-795493]Command
          
  
         	
           
           [bookmark: pgfId-795495]Description
          
  
        
 
         
         	[bookmark: pgfId-795503]New Device[bookmark: marker-795501]
  
         	[bookmark: pgfId-795508]Initiates the wizard to add a new device. See Adding Devices to the Device Inventory.
  
        
 
         
         	[bookmark: pgfId-795516]Clone Device[bookmark: marker-795514]
  
         	[bookmark: pgfId-795521]Creates a device by duplicating an existing device. See Cloning a Device
  
        
 
         
         	[bookmark: pgfId-795529]Delete Device[bookmark: marker-795527]
  
         	[bookmark: pgfId-795534]Deletes a device. See Deleting Devices from the Security Manager Inventory.
  
        
 
         
         	[bookmark: pgfId-795542]Save[bookmark: marker-795540]
  
         	[bookmark: pgfId-795544]Saves any changes made on the active page, but does not submit them to the Security Manager database.
  
        
 
         
         	[bookmark: pgfId-795550]Import
  
         	[bookmark: pgfId-795555]Import policies and devices exported from another Security Manager server. See Importing Policies or Devices.
  
        
 
         
         	[bookmark: pgfId-795563]Export[bookmark: marker-795561]
  
         	[bookmark: pgfId-795571]Export policies or devices so that they can be imported into another Security Manager server. A device export can include policy information, or it can be a simple CSV file that you can import into CiscoWorks Common Services Device Credential Repository (DCR) or Cisco Security Monitoring, Analysis and Response System (CS-MARS). See Exporting the Device Inventory from the Security Manager Client and Exporting Shared Policies.
  
        
 
         
         	[bookmark: pgfId-795579]View Changes[bookmark: marker-795577]
 [bookmark: pgfId-795581](non-Workflow mode only)
  
         	[bookmark: pgfId-795583]Opens the Activity Change Report (in PDF format) for the current configuration session.
 [bookmark: pgfId-795585]To see changes for the current activity in Workflow mode, select Activities > View Changes.
  
        
 
         
         	[bookmark: pgfId-795593]Validate[bookmark: marker-795591]
 [bookmark: pgfId-795595](non-Workflow mode only)
  
         	[bookmark: pgfId-795600]Validates the changes you have saved. See Validating an Activity/Ticket.
 [bookmark: pgfId-795602]To validate the current activity in Workflow mode, select Activities > Validate Activity.
  
        
 
         
         	[bookmark: pgfId-795610]Submit[bookmark: marker-795608]
 [bookmark: pgfId-795612](non-Workflow mode only)
  
         	[bookmark: pgfId-795614]Submits all changes made since the last submission to the Security Manager database.
 [bookmark: pgfId-795616]To validate the current activity in Workflow mode, select Activities > Submit Activity.
  
        
 
         
         	[bookmark: pgfId-795624]Submit and Deploy[bookmark: marker-795622]
 [bookmark: pgfId-795626](non-Workflow mode only)
  
         	[bookmark: pgfId-795631]Submits all changes made since the last submission to the Security Manager database and deploys all changes made since the last deployment. See Understanding Deployment.
 [bookmark: pgfId-795633]In Workflow mode, you must have your activity approved and then create a deployment job to deploy changes to devices.
  
        
 
         
         	[bookmark: pgfId-795641]Deploy[bookmark: marker-795639]
 [bookmark: pgfId-795643](non-Workflow mode only)
  
         	[bookmark: pgfId-795648]Deploys all changes made since the last deployment. See Understanding Deployment.
 [bookmark: pgfId-795650]In Workflow mode, you must have your activity approved and then create a deployment job to deploy changes to devices.
  
        
 
         
         	[bookmark: pgfId-795658]Discard[bookmark: marker-795656]
 [bookmark: pgfId-795660](non-Workflow mode only)
  
         	[bookmark: pgfId-795662]Discards all configuration changes since the last submission.
 [bookmark: pgfId-795664]To validate the current activity in Workflow mode, select Activities > Discard Activity.
  
        
 
         
         	[bookmark: pgfId-795672]Edit Device Groups[bookmark: marker-795670]
  
         	[bookmark: pgfId-795677]Edits device groups. See Working with Device Groups.
  
        
 
         
         	[bookmark: pgfId-795685]New Device Group[bookmark: marker-795683]
  
         	[bookmark: pgfId-795690]Adds a device group. See Creating Device Groups.
  
        
 
         
         	[bookmark: pgfId-795698]Add Devices to Group[bookmark: marker-795696]
  
         	[bookmark: pgfId-795703]Adds a device to a group. See Adding Devices to or Removing Them From Device Groups.
  
        
 
         
         	[bookmark: pgfId-795711]Print[bookmark: marker-795709]
  
         	[bookmark: pgfId-795713]Prints the active page.
 [bookmark: pgfId-795715]Not all pages can be printed. If the Print command is not available, you cannot print the active page.
  
        
 
         
         	[bookmark: pgfId-795723]Exit[bookmark: marker-795721]
  
         	[bookmark: pgfId-795725]Exits Security Manager.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-799985][bookmark: 1729][bookmark: dtchap_cncpt_EditMenu]Edit Menu (Configuration Manager)[bookmark: marker-799975][bookmark: marker-799977][bookmark: marker-799979][bookmark: marker-799981][bookmark: marker-799983]
 
      
       
        
        [bookmark: pgfId-795738]Table 1-3 [bookmark: 1749]Edit Menu (Configuration Manager) 
 
        
       
         
         	
           
           [bookmark: pgfId-795744]Command
          
  
         	
           
           [bookmark: pgfId-795746]Description
          
  
        
 
         
         	[bookmark: pgfId-795754]Cut[bookmark: marker-795752]
  
         	[bookmark: pgfId-795756]Cuts the selected row in a rules table and saves it on the clipboard.
  
        
 
         
         	[bookmark: pgfId-795764]Copy[bookmark: marker-795762]
  
         	[bookmark: pgfId-795766]Copies the selected row in a rules table and saves it on the clipboard.
  
        
 
         
         	[bookmark: pgfId-795774]Paste[bookmark: marker-795772]
  
         	[bookmark: pgfId-795776]Pastes the rules table row from the clipboard to the into the rules table after the selected row.
  
        
 
         
         	[bookmark: pgfId-795784]Add Row[bookmark: marker-795782]
  
         	[bookmark: pgfId-795786]Adds a row into the active table.
  
        
 
         
         	[bookmark: pgfId-795794]Edit Row[bookmark: marker-795792]
  
         	[bookmark: pgfId-795796]Edits the selected table row.
  
        
 
         
         	[bookmark: pgfId-795804]Delete Row[bookmark: marker-795802]
  
         	[bookmark: pgfId-795806]Deletes the selected table row.
  
        
 
         
         	[bookmark: pgfId-795814]Move Row Up[bookmark: marker-795812]
 [bookmark: pgfId-795818]Move Row Down[bookmark: marker-795816]
  
         	[bookmark: pgfId-795823]Moves the selected row up or down in the rules table. For more information, see Moving Rules and the Importance of Rule Order.
  
        
 
         
         	[bookmark: pgfId-795831]Global Search[bookmark: marker-795829]
  
         	[bookmark: pgfId-795836]Opens the Global Search window. For more information, see Using Global Search.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-800005][bookmark: 1821][bookmark: dtchap_cncpt_ViewMenu]View Menu (Configuration Manager)[bookmark: marker-799999][bookmark: marker-800001][bookmark: marker-800003]
 
      
       
        
        [bookmark: pgfId-795849]Table 1-4 [bookmark: 1834]View Menu 
 
        
       
         
         	
           
           [bookmark: pgfId-795855]Menu Command
          
  
         	
           
           [bookmark: pgfId-795857]Description
          
  
        
 
         
         	[bookmark: pgfId-795865]Device View[bookmark: marker-795863]
  
         	[bookmark: pgfId-795870]Opens Device view. See Device View Overview.
  
        
 
         
         	[bookmark: pgfId-795878]Device Status View[bookmark: marker-795876]
  
         	[bookmark: pgfId-795883]Opens the Device Status View window. See Working with Device Status View.
  
        
 
         
         	[bookmark: pgfId-795891]Map View[bookmark: marker-795889]
  
         	[bookmark: pgfId-795896]Opens Map view. See Map View Overview.
  
        
 
         
         	[bookmark: pgfId-795904]Policy View[bookmark: marker-795902]
  
         	[bookmark: pgfId-795909]Opens Policy view. See Policy View Overview.
  
        
 
         
         	[bookmark: pgfId-795917]Policy Bundle View[bookmark: marker-795915]
  
         	[bookmark: pgfId-795922]Opens Policy Bundle view. See Managing Policy Bundles.
  
        
 
         
         	[bookmark: pgfId-795930]Customized Toolbar[bookmark: marker-795928]
  
         	[bookmark: pgfId-795935]Allows you to add or remove some optional buttons on the toolbar. For information on all the buttons that can appear on the toolbar, see Toolbar Reference (Configuration Manager).
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-800022][bookmark: 1893][bookmark: dtchap_cncpt_PolicyMenu]Policy Menu (Configuration Manager)[bookmark: marker-800016][bookmark: marker-800018][bookmark: marker-800020]
 
     [bookmark: pgfId-800024]The Policy menu in Configuration Manager contains commands for managing policies.
 
     [bookmark: pgfId-800027]
 
      
       
        
        [bookmark: pgfId-795948]Table 1-5 [bookmark: 1906]Policy Menu (Configuration Manager) 
 
        
       
         
         	
           
           [bookmark: pgfId-795954]Menu Command
          
  
         	
           
           [bookmark: pgfId-795956]Description
          
  
        
 
         
         	[bookmark: pgfId-795964]Share Policy[bookmark: marker-795962]
  
         	[bookmark: pgfId-795969]Saves the active local policy as a shared policy. See Sharing a Local Policy.
  
        
 
         
         	[bookmark: pgfId-795977]Unshare Policy[bookmark: marker-795975]
  
         	[bookmark: pgfId-795982]Saves the active shared policy as a local policy. See Unsharing a Policy.
  
        
 
         
         	[bookmark: pgfId-795990]Assign Shared Policy[bookmark: marker-795988]
  
         	[bookmark: pgfId-795995]Assigns shared policies to devices. See Assigning a Shared Policy to a Device or VPN Topology.
  
        
 
         
         	[bookmark: pgfId-796003]Unassign Policy[bookmark: marker-796001]
  
         	[bookmark: pgfId-796008]Unassigns the current policy from the selected device. See Unassigning a Policy.
  
        
 
         
         	[bookmark: pgfId-796016]Copy Policies Between Devices[bookmark: marker-796014]
  
         	[bookmark: pgfId-796021]Copies policies between devices. See Copying Policies Between Devices
  
        
 
         
         	[bookmark: pgfId-796029]Share Device Polices[bookmark: marker-796027]
  
         	[bookmark: pgfId-796034]Enables you to share local device policies. See Sharing a Local Policy.
  
        
 
         
         	[bookmark: pgfId-796042]Edit Policy Assignments[bookmark: marker-796040]
  
         	[bookmark: pgfId-796047]Edits assignment of shared policies to devices. See Modifying Policy Assignments in Policy View.
  
        
 
         
         	[bookmark: pgfId-796055]Clone Policy[bookmark: marker-796053]
  
         	[bookmark: pgfId-796060]Creates a copy of a policy with a new name. See Cloning (Copying) a Shared Policy.
  
        
 
         
         	[bookmark: pgfId-796068]Rename Policy[bookmark: marker-796066]
  
         	[bookmark: pgfId-796073]Renames a policy. See Renaming a Shared Policy.
  
        
 
         
         	[bookmark: pgfId-796081]Add Local Rules[bookmark: marker-796079]
  
         	[bookmark: pgfId-796083]Adds local rules to a shared policy on a device. You must select a rule-based shared policy to use this command.
  
        
 
         
         	[bookmark: pgfId-796091]Inherit Rules[bookmark: marker-796089]
  
         	[bookmark: pgfId-796096]Edits policy inheritance. See Inheriting or Uninheriting Rules
  
        
 
         
         	[bookmark: pgfId-796104]Discover Policies on Device[bookmark: marker-796102]
  
         	[bookmark: pgfId-796109]Discovers policies on a device. See Discovering Policies
  
        
 
         
         	[bookmark: pgfId-796117]Discover VPN Policies[bookmark: marker-796115]
  
         	[bookmark: pgfId-796122]Opens the Discover VPN Policies wizard. See Site-To-Site VPN Discovery.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-800039][bookmark: 2020][bookmark: dtchap_cncpt_MapMenu]Map Menu (Configuration Manager)[bookmark: marker-800033][bookmark: marker-800035][bookmark: marker-800037]
 
     [bookmark: pgfId-800044]The Map menu in Configuration Manager contains commands for using the Map view. The commands in this menu are available only when the Map view is open. For more information, see Chapter 35, “Using Map View”.
 
     [bookmark: pgfId-800047]
 
      
       
        
        [bookmark: pgfId-796135]Table 1-6 [bookmark: 2033]Map Menu (Configuration Manager) 
 
        
       
         
         	
           
           [bookmark: pgfId-796141]Menu Command
          
  
         	
           
           [bookmark: pgfId-796143]Description
          
  
        
 
         
         	[bookmark: pgfId-796151]New Map[bookmark: marker-796149]
  
         	[bookmark: pgfId-796156]Creates a map. See Creating New or Default Maps.
  
        
 
         
         	[bookmark: pgfId-796164]Open Map[bookmark: marker-796162]
  
         	[bookmark: pgfId-796169]Opens a saved map or the default map. See Opening Maps.
  
        
 
         
         	[bookmark: pgfId-796177]Show Devices On Map[bookmark: marker-796175]
  
         	[bookmark: pgfId-796182]Selects the managed devices to show on the active map. See Displaying Managed Devices on the Map.
  
        
 
         
         	[bookmark: pgfId-796190]Show VPNs On Map[bookmark: marker-796188]
  
         	[bookmark: pgfId-796195]Selects the VPNs to show on the active map. See Displaying Existing VPNs on the Map.
  
        
 
         
         	[bookmark: pgfId-796203]Add Map Object[bookmark: marker-796201]
  
         	[bookmark: pgfId-796208]Creates a map object on the open map. See Using Map Objects To Represent Network Topology.
  
        
 
         
         	[bookmark: pgfId-796216]Add Link[bookmark: marker-796214]
  
         	[bookmark: pgfId-796221]Creates a Layer 3 link on the open map. See Creating and Managing Layer 3 Links on the Map.
  
        
 
         
         	[bookmark: pgfId-796229]Find Map Node[bookmark: marker-796227]
  
         	[bookmark: pgfId-796234]Finds nodes on the open map. See Searching for Map Nodes.
  
        
 
         
         	[bookmark: pgfId-796242]Save Map[bookmark: marker-796240]
  
         	[bookmark: pgfId-796247]Saves the open map. See Saving Maps.
  
        
 
         
         	[bookmark: pgfId-796255]Save Map As[bookmark: marker-796253]
  
         	[bookmark: pgfId-796260]Saves the open map with a new name. See Saving Maps.
  
        
 
         
         	[bookmark: pgfId-796268]Zoom In[bookmark: marker-796266]
  
         	[bookmark: pgfId-796273]Zooms in on the map. See Panning, Centering, and Zooming Maps.
  
        
 
         
         	[bookmark: pgfId-796281]Zoom Out[bookmark: marker-796279]
  
         	[bookmark: pgfId-796286]Zooms out from the map. See Panning, Centering, and Zooming Maps.
  
        
 
         
         	[bookmark: pgfId-796294]Fit to Window[bookmark: marker-796292]
  
         	[bookmark: pgfId-796299]Zooms the open map to display the entire map. See Panning, Centering, and Zooming Maps.
  
        
 
         
         	[bookmark: pgfId-796307]Display Actual Size[bookmark: marker-796305]
  
         	[bookmark: pgfId-796312]Zooms the open map to display at actual size. See Panning, Centering, and Zooming Maps.
  
        
 
         
         	[bookmark: pgfId-796320]Refresh Map[bookmark: marker-796318]
  
         	[bookmark: pgfId-796325]Refreshes the open map with updated network data. See Creating New or Default Maps.
  
        
 
         
         	[bookmark: pgfId-796333]Export Map[bookmark: marker-796331]
  
         	[bookmark: pgfId-796338]Exports the open map to a file. See Exporting Maps.
  
        
 
         
         	[bookmark: pgfId-796346]Delete Map[bookmark: marker-796344]
  
         	[bookmark: pgfId-796351]Deletes the map you select from a list. See Deleting Maps.
  
        
 
         
         	[bookmark: pgfId-796359]Map Properties[bookmark: marker-796357]
  
         	[bookmark: pgfId-796364]Displays or edits properties for the open map. See Setting the Map Background Properties.
  
        
 
         
         	[bookmark: pgfId-796374]Show/Hide Navigation Window[bookmark: marker-796370][bookmark: marker-796372]
  
         	[bookmark: pgfId-796379]Displays or hides the navigation window on the open map. See Using the Navigation Window.
  
        
 
         
         	[bookmark: pgfId-796389]Undock/Dock Map View[bookmark: marker-796385][bookmark: marker-796387]
  
         	[bookmark: pgfId-796394]Undocks the maps window, allowing you to use other features while keeping the map open. If the window is already undocked, the Dock Map View command reattaches the window to the primary Security Manager window. See Understanding the Map View Main Page.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-800059][bookmark: 2200][bookmark: dtchap_cncpt_ManageMenu]Manage Menu (Configuration Manager)[bookmark: marker-800053][bookmark: marker-800055][bookmark: marker-800057]
 
     [bookmark: pgfId-800061]The Manage menu in Configuration Manager contains commands that start tools that run in a window separate from the Security Manager main interface. This enables you to access features without closing the page from which you are currently working.
 
     [bookmark: pgfId-800064]
 
      
       
        
        [bookmark: pgfId-796407]Table 1-7 [bookmark: 2212]Manage Menu (Configuration Manager) 
 
        
       
         
         	
           
           [bookmark: pgfId-796413]Menu Command
          
  
         	
           
           [bookmark: pgfId-796415]Description
          
  
        
 
         
         	[bookmark: pgfId-796423]Policy Objects[bookmark: marker-796421]
  
         	[bookmark: pgfId-796428]Opens the Policy Object Manager, where you can view all available objects grouped according to object type; create, copy, edit, and delete objects; and generate usage reports, which describe how selected objects are being used by other Security Manager objects and policies. For information see Policy Object Manager.
  
        
 
         
         	[bookmark: pgfId-796436]Site-to-Site VPNs[bookmark: marker-796434]
  
         	[bookmark: pgfId-796441]Opens the Site-to-Site VPN Manager, where you can configure site-to-site VPNs. See Chapter 25, “Managing Site-to-Site VPNs: The Basics”
  
        
 
         
         	[bookmark: pgfId-796449]Activities[bookmark: marker-796447]
 [bookmark: pgfId-796451](Workflow mode only)
  
         	[bookmark: pgfId-796456]Opens the Activity Manager, where you can create and manage activities. See Activity/Ticket Manager Window.
  
        
 
         
         	[bookmark: pgfId-796464]Deployments[bookmark: marker-796462]
  
         	[bookmark: pgfId-796469]Opens the Deployment Manager, where you can deploy configurations and manage deployment jobs. See Chapter 8, “Managing Deployment”
  
        
 
         
         	[bookmark: pgfId-796477]Configuration Archive[bookmark: marker-796475]
  
         	[bookmark: pgfId-796482]Stores archived device configuration versions and allows you to view, compare, and roll back from one configuration to another. See Configuration Archive Window.
  
        
 
         
         	[bookmark: pgfId-796490]Policy Discovery Status[bookmark: marker-796488]
  
         	[bookmark: pgfId-796495]Opens the Policy Discovery Status window, where you can see the status of policy discovery and device import. See Viewing Policy Discovery Task Status.
  
        
 
         
         	[bookmark: pgfId-796503]IPS[bookmark: marker-796501]
  
         	[bookmark: pgfId-796505]Manage IPS device certificates, which are required for device communications.
  
        
 
         
         	[bookmark: pgfId-796513]Audit Report[bookmark: marker-796511]
  
         	[bookmark: pgfId-796518]Generates an audit report according to parameters set in the audit report page. See Using the Audit Report Window.
  
        
 
         
         	[bookmark: pgfId-796526]Change Reports[bookmark: marker-796524]
 [bookmark: pgfId-796528](non-Workflow mode only)
  
         	[bookmark: pgfId-796533]Allows you to generate a report of changes to devices, shared policies, and policy objects for a previous configuration session. See Viewing Change Reports.
 [bookmark: pgfId-796535]To view changes for the current configuration session, select File > View Changes.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-800076][bookmark: 2298][bookmark: dtchap_cncpt_ToolsMenu]Tools Menu (Configuration Manager)[bookmark: marker-800070][bookmark: marker-800072][bookmark: marker-800074]
 
      
       
        
        [bookmark: pgfId-796548]Table 1-8 [bookmark: 2311]Tools Menu (Configuration Manager) 
 
        
       
         
         	
           
           [bookmark: pgfId-796554]Menu Command
          
  
         	
           
           [bookmark: pgfId-796556]Description
          
  
        
 
         
         	[bookmark: pgfId-796564]Device Properties[bookmark: marker-796562]
  
         	[bookmark: pgfId-796569]Opens the Device Properties window, which provides general information about the device, including credentials, the group the device is assigned to, and policy object overrides. For more information, see Understanding Device Properties.
  
        
 
         
         	[bookmark: pgfId-796577]Detect Out of Band Changes[bookmark: marker-796575]
  
         	[bookmark: pgfId-796582]Analyzes devices to determine if their configurations have changed since the last time Security Manager deployed configurations. You can use this information to ensure that you do not loose important configuration changes. See Detecting and Analyzing Out of Band Changes.
  
        
 
         
         	[bookmark: pgfId-796590]Packet Capture Wizard[bookmark: marker-796588]
  
         	[bookmark: pgfId-796592]Opens the Packet Capture wizard, where you can set up a packet capture on an ASA device.
  
        
 
         
         	[bookmark: pgfId-796600]Ping, TraceRoute and NSLookup[bookmark: marker-796598]
  
         	[bookmark: pgfId-796605]Opens the Ping, TraceRoute, and NSLookup tool, where you can use these troubleshooting commands. Ping and traceroute run on managed devices, whereas NSLookup runs on your client workstation. See Analyzing Connectivity Issues Using the Ping, Trace Route, or NS Lookup Tools.
  
        
 
         
         	[bookmark: pgfId-796611]IP Intelligence
  
         	[bookmark: pgfId-796616]Opens the IP Intelligence tool, where you can access various pieces of information about an IPv4 address, such as the fully qualified domain name (FQDN), geographic location information, and WHOIS information. For more information on the IP Intelligence tool, see IP Intelligence.
 [bookmark: pgfId-796621]Before you can use any of the IP Intelligence features, you must enable and configure those features on the IP Intelligence Settings page (see IP Intelligence Settings Page).
  
        
 
         
         	[bookmark: pgfId-796627]Wall
  
         	[bookmark: pgfId-796632]Opens the Wall window, where you can send messages to all users who are logged in on the same Security Manager server. First, however, it must be enabled on the Wall Settings page. See Wall Settings Page.
  
        
 
         
         	[bookmark: pgfId-796640]Show Containment[bookmark: marker-796638]
  
         	[bookmark: pgfId-796645]Shows security contexts or service modules for a device. See Showing Device Containment.
  
        
 
         
         	[bookmark: pgfId-796653]Inventory Status[bookmark: marker-796651]
  
         	[bookmark: pgfId-796658]Shows device summary information for all devices. See Viewing Inventory Status.
  
        
 
         
         	[bookmark: pgfId-796666]Catalyst Summary Info[bookmark: marker-796664]
  
         	[bookmark: pgfId-796671]Shows high-level system information, including any service modules, ports, and VLANs that Security Manager has discovered on the selected Catalyst switch. See Viewing Catalyst Summary Information.
  
        
 
         
         	[bookmark: pgfId-796679]Apply IPS Update[bookmark: marker-796677]
  
         	[bookmark: pgfId-796684]Manually applies IPS image and signature updates. See Manually Applying IPS Updates.
  
        
 
         
         	[bookmark: pgfId-796692]Preview Configuration[bookmark: marker-796690]
  
         	[bookmark: pgfId-796697]Displays the proposed changes, last deployed configuration, or current running configuration for specific devices. See Previewing Configurations.
  
        
 
         
         	[bookmark: pgfId-796705]Backup[bookmark: marker-796703]
  
         	[bookmark: pgfId-796710]Backs up the Security Manager database using CiscoWorks Common Services. See Backing up and Restoring the Security Manager Database.
  
        
 
         
         	[bookmark: pgfId-796718]Security Manager Diagnostics[bookmark: marker-796716]
  
         	[bookmark: pgfId-796723]Gathers troubleshooting information to send to the Technical Assistance Center (TAC) if they request it. See Creating Diagnostics Files for the Cisco Technical Assistance Center.
 [bookmark: pgfId-796725]Tip Beginning with Version 4.7 of Cisco Security Manager, you can select "Light Diagnostics" instead of the existing "General Diagnostics."  
        
 
         
         	[bookmark: pgfId-796733]Security Manager Administration[bookmark: marker-796731]
  
         	[bookmark: pgfId-796738]Configures system-wide settings that control the functioning of Security Manager. For information, see Chapter 11, “Configuring Security Manager Administrative Settings”.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-800093][bookmark: 2432][bookmark: dtchap_cncpt_ActivitiesMenu]Activities Menu (Configuration Manager)[bookmark: marker-800087][bookmark: marker-800089][bookmark: marker-800091]
 
      
       
        
        [bookmark: pgfId-796751]Table 1-9 [bookmark: 2445]Activities Menu (Configuration Manager) 
 
        
       
         
         	
           
           [bookmark: pgfId-796757]Menu Command
          
  
         	
           
           [bookmark: pgfId-796759]Description
          
  
        
 
         
         	[bookmark: pgfId-796767]New Activity[bookmark: marker-796765]
  
         	[bookmark: pgfId-796772]Creates a new activity. See Creating an Activity/Ticket.
  
        
 
         
         	[bookmark: pgfId-796780]Open Activity[bookmark: marker-796778]
  
         	[bookmark: pgfId-796785]Opens an activity. See Opening an Activity/Ticket.
  
        
 
         
         	[bookmark: pgfId-796793]Close Activity[bookmark: marker-796791]
  
         	[bookmark: pgfId-796798]Closes the open activity. See Closing an Activity/Ticket.
  
        
 
         
         	[bookmark: pgfId-796806]View Changes[bookmark: marker-796804]
  
         	[bookmark: pgfId-796811]Opens the Activity Change Report (in PDF format). See Viewing Change Reports.
  
        
 
         
         	[bookmark: pgfId-796819]Validate Activity[bookmark: marker-796817]
  
         	[bookmark: pgfId-796824]Validates the open activity. See Validating an Activity/Ticket.
  
        
 
         
         	[bookmark: pgfId-796832]Submit Activity[bookmark: marker-796830]
  
         	[bookmark: pgfId-796837]Submits the open activity. See Submitting an Activity for Approval (Workflow Mode with Activity Approver).
  
        
 
         
         	[bookmark: pgfId-796845]Approve Activity[bookmark: marker-796843]
  
         	[bookmark: pgfId-796850]Approves the open activity. See Approving or Rejecting an Activity (Workflow Mode).
  
        
 
         
         	[bookmark: pgfId-796858]Reject Activity[bookmark: marker-796856]
  
         	[bookmark: pgfId-796863]Rejects the open activity. See Approving or Rejecting an Activity (Workflow Mode).
  
        
 
         
         	[bookmark: pgfId-796871]Discard Activity[bookmark: marker-796869]
  
         	[bookmark: pgfId-796876]Discards the open activity. See Discarding an Activity/Ticket.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-800113][bookmark: 2528][bookmark: dtchap_cncpt_TicketsMenu]Tickets Menu (Configuration Manager)[bookmark: marker-800107][bookmark: marker-800109][bookmark: marker-800111]
 
     [bookmark: pgfId-800118]The Tickets menu in Configuration Manager contains commands for managing tickets. It appears only when Ticket Management is enabled in non-Workflow mode. For more detailed information about these commands, see Accessing Ticket Functions in Non-Workflow Mode.
 
     [bookmark: pgfId-800121]
 
      
       
        
        [bookmark: pgfId-796889]Table 1-10 [bookmark: 2541]Tickets Menu (Configuration Manager) 
 
        
       
         
         	
           
           [bookmark: pgfId-796895]Menu Command
          
  
         	
           
           [bookmark: pgfId-796897]Description
          
  
        
 
         
         	[bookmark: pgfId-796905]New Ticket[bookmark: marker-796903]
  
         	[bookmark: pgfId-796910]Creates a new ticket. See Creating an Activity/Ticket.
  
        
 
         
         	[bookmark: pgfId-796918]Open Ticket[bookmark: marker-796916]
  
         	[bookmark: pgfId-796923]Opens an ticket. See Opening an Activity/Ticket.
  
        
 
         
         	[bookmark: pgfId-796931]Close Ticket[bookmark: marker-796929]
  
         	[bookmark: pgfId-796936]Closes the open ticket. See Closing an Activity/Ticket.
  
        
 
         
         	[bookmark: pgfId-796944]View Changes[bookmark: marker-796942]
  
         	[bookmark: pgfId-796949]Opens the Ticket Change Report (in PDF format). See Viewing Change Reports.
  
        
 
         
         	[bookmark: pgfId-796957]Validate Ticket[bookmark: marker-796955]
  
         	[bookmark: pgfId-796962]Validates the open ticket. See Validating an Activity/Ticket.
  
        
 
         
         	[bookmark: pgfId-796970]Submit Ticket[bookmark: marker-796968]
  
         	[bookmark: pgfId-796975]Submits the open ticket. See Understanding Activity/Ticket States.
  
        
 
         
         	[bookmark: pgfId-796983]Discard Ticket[bookmark: marker-796981]
  
         	[bookmark: pgfId-796988]Discards the open ticket. See Discarding an Activity/Ticket.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-800133][bookmark: 2608][bookmark: dtchap_cncpt_LaunchMenu]Launch Menu (Configuration Manager)[bookmark: marker-800127][bookmark: marker-800129][bookmark: marker-800131]
 
     [bookmark: pgfId-800135]The Launch menu contains commands that start other applications.
 
     [bookmark: pgfId-800138]
 
      
       
        
        [bookmark: pgfId-797001]Table 1-11 [bookmark: 2620]Launch Menu (Configuration Manager) 
 
        
       
         
         	
           
           [bookmark: pgfId-797007]Menu Command
          
  
         	
           
           [bookmark: pgfId-797009]Description
          
  
        
 
         
         	[bookmark: pgfId-797017]Device Manager[bookmark: marker-797015]
  
         	[bookmark: pgfId-797022]Starts device managers for all supported devices, such as PIX security appliances, Firewall Services Modules (FWSM), IPS sensors, IOS routers, and Adaptive Security Appliance (ASA) devices. Device managers provide several monitoring and diagnostic features that enable you to get information regarding the services running on the device and a snapshot of the overall health of the system. See Starting Device Managers.
  
        
 
         
         	[bookmark: pgfId-797030]Prime Security Manager[bookmark: marker-797028]
  
         	[bookmark: pgfId-797035]Launches the Cisco Prime Security Manager (PRSM) application, used to manage ASA CX devices. See Launching Cisco Prime Security Manager or FireSIGHT Management Center for more information.
  
        
 
         
         	[bookmark: pgfId-797043]FireSIGHT Management Center[bookmark: marker-797041]
  
         	[bookmark: pgfId-797048]Launches the FireSIGHT Management Center application, used to manage FirePOWER modules. See Launching Cisco Prime Security Manager or FireSIGHT Management Center for more information.
  
        
 
         
         	[bookmark: pgfId-797054]Dashboard
  
         	[bookmark: pgfId-797059]Opens the Dashboard, which is a configurable launch point for Security Manager that makes IPS and FW tasks more convenient for you. In addition to the original dashboard, you can create new, additional dashboards, and you can customize all dashboards. By using the dashboard, you can accomplish in one place many tasks that are found in several other areas of Security Manager, such as the IPS Health Monitor page, Report Manager, Health and Performance Monitor, and IP Intelligence Settings. For detailed information on the dashboard, see Dashboard Overview.
  
        
 
         
         	[bookmark: pgfId-797067]Event Viewer[bookmark: marker-797065]
  
         	[bookmark: pgfId-797072]Opens the Event Viewer, where you can view and analyze device events. See Chapter 68, “Viewing Events” for more information.
 [bookmark: pgfId-797074]If you have already logged into another Security Manager application, Event Viewer is opened using the same user account; you are not prompted to log in. To open Event Viewer using a different user account, open the application from the Windows Start menu or desktop icon.
  
        
 
         
         	[bookmark: pgfId-797082]Report Manager[bookmark: marker-797080]
  
         	[bookmark: pgfId-797087]Opens the Report Manager, where you can generate and analyze security and usage reports. See Chapter 69, “Managing Reports” for more information.
 [bookmark: pgfId-797089]If you have already logged into another Security Manager application, Report Manager is opened using the same user account; you are not prompted to log in. To open Report Manager using a different user account, open the application from the Windows Start menu or desktop icon.
  
        
 
         
         	[bookmark: pgfId-797097]Image Manager[bookmark: marker-797095]
  
         	[bookmark: pgfId-797102]Opens the Image Manager, where you can manage the images on ASA devices. See Chapter 72, “Using Image Manager” for more information.
 [bookmark: pgfId-797104]If you have already logged into another Security Manager application, Image Manager is opened using the same user account; you are not prompted to log in. To open Image Manager using a different user account, open the application from the Windows Start menu or desktop icon.
  
        
 
         
         	[bookmark: pgfId-797112]Health & Performance Monitor[bookmark: marker-797110]
  
         	[bookmark: pgfId-797117]Opens the Health & Performance Monitor (HPM), where you can view device status and traffic information across your network, and view and acknowledge device-specific alerts. See Chapter 70, “Health and Performance Monitoring” for more information.
 [bookmark: pgfId-797119]If you have already logged into another Security Manager application, HPM is opened using the same user account; you are not prompted to log in. To open HPM using a different user account, open the application from the Windows Start menu or desktop icon.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-800150][bookmark: 2697][bookmark: dtchap_cncpt_HelpMenu]Help Menu (Configuration Manager)[bookmark: marker-800144][bookmark: marker-800146][bookmark: marker-800148]
 
     [bookmark: pgfId-800155]The Help menu in Configuration Manager contains commands for accessing product documentation and training. For more information, see Accessing Online Help.
 
     [bookmark: pgfId-800158]
 
      
       
        
        [bookmark: pgfId-797132]Table 1-12 [bookmark: 2711]Help Menu (Configuration Manager) 
 
        
       
         
         	
           
           [bookmark: pgfId-797138]Menu Command
          
  
         	
           
           [bookmark: pgfId-797140]Description
          
  
        
 
         
         	[bookmark: pgfId-797148]Help Topics[bookmark: marker-797146]
  
         	[bookmark: pgfId-797150]Opens the online help system.
  
        
 
         
         	[bookmark: pgfId-797158]Help About This Page[bookmark: marker-797156]
  
         	[bookmark: pgfId-797160]Open online help for the active page.
  
        
 
         
         	[bookmark: pgfId-797168]JumpStart[bookmark: marker-797166]
  
         	[bookmark: pgfId-797170]Opens the JumpStart.
  
        
 
         
         	[bookmark: pgfId-797178]Security Manager Online[bookmark: marker-797176]
  
         	[bookmark: pgfId-797180]Opens the Security Manager web page on Cisco.com.
  
        
 
         
         	[bookmark: pgfId-797188]About Configuration Manager[bookmark: marker-797186]
  
         	[bookmark: pgfId-797190]Displays information about Configuration Manager.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-800170][bookmark: 2758][bookmark: dtchap_cncpt_ToolbarReference]Toolbar Reference (Configuration Manager)[bookmark: marker-800164][bookmark: marker-800166][bookmark: marker-800168]
 
     [bookmark: pgfId-800175]The main toolbar (see the illustration Figure 1-1) contains buttons that perform actions in Configuration Manager.
 
     [bookmark: pgfId-800177]The buttons that appear on the main toolbar vary depending on whether Workflow/Ticket Management mode is enabled and how you have customized the toolbar. By selecting View > Customized Toolbar, you can select some of the buttons included in the toolbar. Many buttons are on the toolbar permanently; you cannot remove them.
 
     [bookmark: pgfId-800179]The following table presents all buttons.
 
     [bookmark: pgfId-800182]
 
      
      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

      

       
        
        [bookmark: pgfId-797203]Table 1-13 [bookmark: 2776]Configuration Manager Toolbar 
 
        
       
         
         	
           
           [bookmark: pgfId-797209]Button
          
  
         	
           
           [bookmark: pgfId-797211]Description
          
  
        
 
        
            
         	[bookmark: pgfId-797220]Opens the Device view.
 [bookmark: pgfId-797225]For more information, see Understanding the Device View.
  
        
 
        
            
         	[bookmark: pgfId-797234]Opens the Map view.
 [bookmark: pgfId-797239]For more information, see Chapter 35, “Using Map View”.
  
        
 
        
            
         	[bookmark: pgfId-797248]Opens the Policy view.
 [bookmark: pgfId-797253]For more information, see Managing Shared Policies in Policy View.
  
        
 
        
            
         	[bookmark: pgfId-797262]Opens the Policy Bundle view.
 [bookmark: pgfId-797267]For more information, see Managing Policy Bundles.
  
        
 
        
            
         	[bookmark: pgfId-797276]Opens the Policy Object Manager.
 [bookmark: pgfId-797281]For more information, see Chapter 6, “Managing Policy Objects”.
  
        
 
        
            
         	[bookmark: pgfId-797290]Opens the Site-to-Site VPN Manager.
 [bookmark: pgfId-797295]For more information, see Chapter 25, “Managing Site-to-Site VPNs: The Basics”.
  
        
 
        
            
         	[bookmark: pgfId-797304]Opens the Deployment Manager.
 [bookmark: pgfId-797309]For more information, see Chapter 8, “Managing Deployment”.
  
        
 
        
            
         	[bookmark: pgfId-797318]Opens the Audit Report.
 [bookmark: pgfId-797323]For more information, see Understanding Audit Reports.
  
        
 
        
            
         	[bookmark: pgfId-797332](Non-Workflow mode with Ticket Management disabled only.) Submits and deploys changes.
 [bookmark: pgfId-797337]For more information, see Chapter 8, “Managing Deployment”.
  
        
 
        
            
         	[bookmark: pgfId-797346]Discovers configuration policies defined on the currently selected device.
 [bookmark: pgfId-797351]For more information, see Discovering Policies.
  
        
 
        
            
         	[bookmark: pgfId-797360]Detects out-of-band changes, those made to the device outside of Security Manager, for the currently selected devices.
 [bookmark: pgfId-797365]For more information, see Detecting and Analyzing Out of Band Changes.
  
        
 
        
            
         	[bookmark: pgfId-797377]Opens the IP Intelligence tool, where you can access various pieces of information about an IPv4 address, such as the fully qualified domain name (FQDN), geographic location information, and WHOIS information. For more information on the IP Intelligence tool, see IP Intelligence.
 [bookmark: pgfId-797382]Before you can use any of the IP Intelligence features, you must enable and configure those features on the IP Intelligence Settings page (see IP Intelligence Settings Page).
  
        
 
        
            
         	[bookmark: pgfId-797391]Opens the Wall window, where you can send messages to all users who are logged in on the same Security Manager server. First, however, it must be enabled on the Wall Settings page.
 [bookmark: pgfId-797396]For more information, see Workflow Page.
  
        
 
        
            
         	[bookmark: pgfId-797405]Shows high-level system information, including any service modules, ports, and VLANs that Security Manager has discovered on the selected Catalyst switch.
 [bookmark: pgfId-797410]For more information, see Viewing Catalyst Summary Information.
  
        
 
        
            
         	[bookmark: pgfId-797419]Previews the configuration for the currently selected device.
 [bookmark: pgfId-797424]For more information, see Previewing Configurations.
  
        
 
        
            
         	[bookmark: pgfId-797436]Configures system-wide settings that control the functioning of Security Manager. For information, see Chapter 11, “Configuring Security Manager Administrative Settings”.
  
        
 
        
            
         	[bookmark: pgfId-797445]Opens the device manager for the currently selected device.
 [bookmark: pgfId-797450]For more information, see Starting Device Managers.
  
        
 
        
            
         	[bookmark: pgfId-797462]Launches the Cisco Prime Security Manager (PRSM) application, used to manage ASA CX devices. See Launching Cisco Prime Security Manager or FireSIGHT Management Center for more information.
  
        
 
        
            
         	[bookmark: pgfId-797474]Launches the FireSIGHT Management Center application, used to manage FirePOWER modules. See Launching Cisco Prime Security Manager or FireSIGHT Management Center for more information.
  
        
 
        
            
         	[bookmark: pgfId-797483]Opens the Dashboard application.
 [bookmark: pgfId-797488]For more information, see Dashboard Overview.
  
        
 
        
            
         	[bookmark: pgfId-797497]Opens the Event Viewer application.
 [bookmark: pgfId-797502]For more information, see Chapter 68, “Viewing Events”.
  
        
 
        
            
         	[bookmark: pgfId-797511]Opens the Report Manager application.
 [bookmark: pgfId-797516]For more information, see Chapter 69, “Managing Reports”.
  
        
 
        
            
         	[bookmark: pgfId-797525]Opens the Image Manager application.
 [bookmark: pgfId-797530]For more information, see Chapter 72, “Using Image Manager”.
  
        
 
        
            
         	[bookmark: pgfId-797539]Opens the Health & Performance Monitor application.
 [bookmark: pgfId-797544]For more information, see Chapter 70, “Health and Performance Monitoring”.
  
        
 
        
            
         	[bookmark: pgfId-797553]Opens online help for the current page.
 [bookmark: pgfId-797558]For more information, see Accessing Online Help.
  
        
 
         
         	 [bookmark: pgfId-797564]Note The following buttons are not available in non-Workflow mode when Ticket Management is disabled.
  
        
 
        
            
         	[bookmark: pgfId-797578]Opens the Activity Manager window in Workflow mode or the Ticket Manager window when Ticket Management is enabled in non-Workflow mode. You can use these windows to create and manage activities/tickets. For more information, see Activity/Ticket Manager Window.
 [bookmark: pgfId-797583]For more information on the activity buttons, and the conditions under which they are enabled, see Accessing Activity Functions in Workflow Mode.
 [bookmark: pgfId-797588]For more information on the ticket buttons, and the conditions under which they are enabled, see Accessing Ticket Functions in Non-Workflow Mode.
  
        
 
        
            
         	[bookmark: pgfId-797597]Creates a new activity/ticket.
  
        
 
        
            
         	[bookmark: pgfId-797606]Opens an activity/ticket.
  
        
 
        
            
         	[bookmark: pgfId-797615]Saves all changes made while the activity/ticket was open and closes it.
  
        
 
        
            
         	[bookmark: pgfId-797627]Evaluates all changes made in the activity/ticket and produces a Change Report in PDF format in a separate window. For more information, see Viewing Change Reports
  
        
 
        
            
         	[bookmark: pgfId-797636]Validates the integrity of changed policies within the current activity/ticket.
  
        
 
        
            
         	[bookmark: pgfId-797645](Workflow mode with an approver only.) Submits the activity for approval when using Workflow mode with an activity approver.
 [bookmark: pgfId-797647](Non-Workflow mode with Ticket Management enabled only.) Submits the ticket. Submitting the ticket saves the proposed changes to the database. Devices associated with the ticket are unlocked, meaning they can be included in policy definitions and changes in other tickets. You can submit a ticket when it is in the Edit or the Edit Open state.
  
        
 
        
            
         	[bookmark: pgfId-797656](Workflow mode only.) Approves the changes proposed in an activity.
  
        
 
        
            
         	[bookmark: pgfId-797665](Workflow mode only.) Rejects the changes proposed in an activity.
  
        
 
        
            
         	[bookmark: pgfId-797674]Discards the selected activity/ticket.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-800204][bookmark: 3056][bookmark: dtchap_cncpt_UsingGlobalSearch]Using Global Search[bookmark: marker-800190][bookmark: marker-800192][bookmark: marker-800194][bookmark: marker-800196][bookmark: marker-800198][bookmark: marker-800200][bookmark: marker-800202]
 
     [bookmark: pgfId-800206]Security Manager provides a global search feature to make finding and working with information that you are interested in easier. The Global Search feature allows you to search for devices, policy objects, policies, and tickets that contain a particular search string. The scope of the search can be limited to just devices, policy objects, policies, or tickets.
 
      
       
     
 
     
 
     [bookmark: pgfId-800208]Note Search is only performed using data that has been committed. Changes that have not yet been submitted to the database will not be included in search results.

     
      

     

     
 
     [bookmark: pgfId-800210]Wildcard Matching
 
     [bookmark: pgfId-800212]The search string supports the use of the following wildcard characters:
 
      
      	 [bookmark: pgfId-800214] Asterisk (*) —matches zero or more characters
 
      	 [bookmark: pgfId-800216] Question Mark (?) —matches a single character
 
     
 
     [bookmark: pgfId-800218]Semantic Searching
 
     [bookmark: pgfId-800220]If the search string that is entered is an IP address, Security Manager will perform a semantic search. For example, entering "192.168.0.0/16" in the search string will return items matching that subnet as well as any specific hosts or other subnets belonging to that subnet or to which that subnet belongs.
 
     [bookmark: pgfId-800222]Global Search Scope
 
     [bookmark: pgfId-800224]Global search is supported only within a set of policies and policy objects, not all. The supported policies and the policy objects are the most frequently used policies and objects in the customer deployments. The policies and policy objects supported are:
 
      
      	 [bookmark: pgfId-800226]Devices: All Devices
 
      	 [bookmark: pgfId-800228]Policy Objects:
 
     
 
     [bookmark: pgfId-800230] – AAA Server Groups
 
     [bookmark: pgfId-800232] – AAA Servers
 
     [bookmark: pgfId-800234] – Access Control Lists
 
     [bookmark: pgfId-800236] – As Path Policies
 
     [bookmark: pgfId-800238] – ASA Group Policies
 
     [bookmark: pgfId-800240] – Categories
 
     [bookmark: pgfId-800242] – Cisco Secure Desktop (Router)
 
     [bookmark: pgfId-800244] – Community List Policies
 
     [bookmark: pgfId-800246] – Credentials
 
     [bookmark: pgfId-800248] – File Objects
 
     [bookmark: pgfId-800250] – FlexConfigs
 
     [bookmark: pgfId-800252] – Identity User Group
 
     [bookmark: pgfId-800254] – IKE Proposals
 
     [bookmark: pgfId-800256] – Interface Roles
 
     [bookmark: pgfId-800258] – IPSec Transform Sets
 
     [bookmark: pgfId-800260] – LDAP Attribute Maps
 
     [bookmark: pgfId-800262] – Networks/Hosts (IPv4 and IPv6)
 
     [bookmark: pgfId-800264] – PKI Enrollments
 
     [bookmark: pgfId-800266] – Policy List Policies
 
     [bookmark: pgfId-800268] – Port Forwarding List
 
     [bookmark: pgfId-800270] – Prefix List Policies
 
     [bookmark: pgfId-800272] – Route List Policies
 
     [bookmark: pgfId-800274] – Services
 
     [bookmark: pgfId-800276] – Single Sign On Servers
 
     [bookmark: pgfId-800278] – SLA Monitors
 
     [bookmark: pgfId-800280] – SSL VPN Bookmarks
 
     [bookmark: pgfId-800282] – SSL VPN Customizations
 
     [bookmark: pgfId-800284] – SSL VPN Gateways
 
     [bookmark: pgfId-800286] – SSL VPN Smart Tunnel Auto Signon Lists
 
     [bookmark: pgfId-800288] – SSL VPN Smart Tunnels
 
     [bookmark: pgfId-800290] – Text Objects
 
     [bookmark: pgfId-800292] – Time Ranges
 
     [bookmark: pgfId-800294] – Traffic Flows
 
     [bookmark: pgfId-800296] – User Groups
 
     [bookmark: pgfId-800298] – WINS Server Lists
 
      
      	 [bookmark: pgfId-800300]Policies:
 
     
 
     [bookmark: pgfId-800302] – AAA Rules
 
     [bookmark: pgfId-800304] – Access Rules
 
     [bookmark: pgfId-800306] – IPv6 Access Rules
 
     [bookmark: pgfId-800308] – Inspection Rules
 
     [bookmark: pgfId-800310] – Translation Rules
 
     [bookmark: pgfId-800312] – Web Filter Rules
 
     [bookmark: pgfId-800314] – Zone Based Firewall Rules
 
      
      	 [bookmark: pgfId-800316]Tickets
 
     
 
     [bookmark: pgfId-800318] – Configuration Manager
 
     [bookmark: pgfId-800320] – Image Manager
 
     [bookmark: pgfId-800322]Performing a Global Search
 
     [bookmark: pgfId-800324]To perform a global search, do one of the following:
 
      
      	 [bookmark: pgfId-800326]Select  Edit > Global Search or press  Ctrl+F to open the Global Search window. Select the scope for the search in the drop-down list to the left of the search field, enter your search string in the search field, and then click  Search .
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-800328]Note If you are currently viewing a rule table, pressing Ctrl+F will open the Find and Replace dialog box instead of the Global Search window. Use one of the other methods to access the Global Search feature instead of the Find and Replace feature.

     
      

     

     
 
      
      	 [bookmark: pgfId-800330]Using the search field in the upper-right corner of the Configuration Manager window, select the scope for the search by clicking on the Search icon, enter your search string in the search field, and then press  Enter .
 
     
 
     [bookmark: pgfId-800332]The Global Search window displays the results matching your search criteria. Select the desired data type from the Category selector tree to see results for that category.
 
     [bookmark: pgfId-800334]Acting on Search Results
 
     [bookmark: pgfId-800336]You can perform the following actions on the items returned from your search:
 
      
      	 [bookmark: pgfId-800338] Export Data (All) —Allows you to export the search results for the selected category in CSV format. Select the desired data type from the Category selector tree in the Global Search window to see results for that category, then click  Export in the toolbar above the search results to export that table of data in CSV format.
 
      	 [bookmark: pgfId-800340] Print (All) —Allows you to print the search results for the selected category. Select the desired data type from the Category selector tree in the Global Search window to see results for that category, then click  Print in the toolbar above the search results to print the table of data.
 
      	 [bookmark: pgfId-800345] Device Properties (Devices) —Allows you to view the device properties for devices returned in search results. Select the desired device group from the Category selector tree in the Global Search window to see results for that category. Select a device in the results table to highlight it, right-click the device, and then select  Device Properties . The Device Properties dialog box for the selected device is displayed. For more information, see Viewing or Changing Device Properties.
 
      	 [bookmark: pgfId-800347] Go To (Policies) —Allows you to navigate to a policy from the search results. Select the desired policy type from the Category selector tree in the Global Search window to see results for that policy type. Select an item in the results table to highlight it, right-click the item, and then select  Go To . The relevant policy for the selected item is displayed.
 
      	 [bookmark: pgfId-800352] Filter (Policies) —Allows you to filter the search results using the standard table filter. For more information, see Filtering Tables.
 
      	 [bookmark: pgfId-800354] View (Policy Objects) —Allows you to view the policy object details for an object in the search results. Select the desired policy object type from the Category selector tree in the Global Search window to see results for that object type. Select an object in the results table to highlight it, then click  View in the toolbar above the search results (or right-click the object and select  View ). The relevant Edit dialog box for the selected policy object is displayed in read-only mode.
 
      	 [bookmark: pgfId-800356] Edit (Policy Objects) —Allows you to edit a policy object from the search results. Select the desired policy object type from the Category selector tree in the Global Search window to see results for that object type. Select an object in the results table to highlight it, then click  Edit in the toolbar above the search results (or right-click the object and select  Edit ). The relevant Edit dialog box for the selected policy object is displayed.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-800358]Note If a ticket or activity is not currently open, you will be prompted to create one or open an existing one before you can edit the policy object.

     
      

     

     
 
      
      	 [bookmark: pgfId-800363] Find Usage (Policy Objects) —Allows you to find which policies, objects, VPNs, and devices are using an object in the search results. Select the desired policy object type from the Category selector tree in the Global Search window to see results for that object type. Select an object in the results table to highlight it, then click  Find Usage in the toolbar above the search results (or right-click the object and select  Find Usage ). The Object Usage dialog box for the selected policy object is displayed. For more information, see Generating Object Usage Reports.
 
      	 [bookmark: pgfId-800368] Show Ticket (Tickets) —Allows you to navigate to the Ticket Manager window for a ticket returned in the search results. Select the desired ticket group from the Category selector tree in the Global Search window to see results for that category. Click the Ticket column in the results table for the ticket you want to view. The Ticket Manager window is displayed with the selected ticket highlighted. For more information, see Activity/Ticket Manager Window.
 
     
 
    
 
     
      [bookmark: pgfId-800386][bookmark: 3270][bookmark: dtchap_cncpt_UsingSelectors]Using Selectors[bookmark: marker-800374][bookmark: marker-800376][bookmark: marker-800378][bookmark: marker-800380][bookmark: marker-800382][bookmark: marker-800384]
 
     [bookmark: pgfId-800391]Selectors appear in several places in the user interface; for example, the Device selector in Device view (see Figure 1-1). These tree structures enable you to select items (like devices) on which to perform actions. Several types of items can appear in a selector, depending on the task you are performing.
 
     [bookmark: pgfId-800393]Items in selectors are presented in a hierarchy of folders. You can browse for items in a selector by expanding and collapsing folders, which can contain other folders, items, or a combination of folders and items. To expand and collapse a folder, click the +/- next to it.
 
     [bookmark: pgfId-800395]To select an item, click it. If it is possible to perform actions on multiple items (for example, in a device selector), you can use Ctrl+click to select each item, or Shift+click on the first and last item to select all items between them. Many selectors support auto select, that is, when you type a single letter, the next folder or item in the selector that begins with that letter is selected.
 
     [bookmark: pgfId-800397]You can right-click an item to see commands that you can use with the item. Some commands on the right-click menus are unique and not repeated on the regular menus.
 
     [bookmark: pgfId-800399]Many times a device selector appears in a dialog box divided into two panes, Available Devices and Selected Devices. In these dialog boxes, you must select the devices in the available devices list and click >> to move them to the selected list to actually select the devices. To deselect the devices, you select them in the selected devices list and click <<.
 
     [bookmark: pgfId-800404]If a selector contains a large number of items, you can filter it to view a subset of those items. For more information, see Filtering Items in Selectors.
 
    
 
     
      [bookmark: pgfId-800418][bookmark: 3299][bookmark: dtchap_cncpt_FilteringItemsinSelectors]Filtering Items in Selectors[bookmark: marker-800410][bookmark: marker-800412][bookmark: marker-800414][bookmark: marker-800416]
 
     [bookmark: pgfId-800420]To view a subset of the items in a selector, you can create filters to display only those items that match the criteria you specify. You can have a maximum of 10 filters per user for each selector. After that, when you create another filter, that new filter replaces the oldest filter. There is no duplication check for filters that are created. You cannot delete filters manually.
 
     [bookmark: pgfId-800422]A filter list appears above all selectors that can be filtered. From this list, you can do the following:
 
      
      	 [bookmark: pgfId-800424]Select a filter that you created previously.
 
      	 [bookmark: pgfId-800426]Select  None to see the tree without any filters applied to it.
 
      	 [bookmark: pgfId-800428]Select  Create Filter to create a filter.
 
     
 
     [bookmark: pgfId-800430]Each filter can contain several filter rules. Each filter rule specifies a rule type, criteria, and values. You select whether items must match any or all filter rules before they can be displayed in the selector.
 
     [bookmark: pgfId-800432]When you create a filter, the fields that you can filter on depend on the types of items displayed in the filter. However, the general procedure is the same for all selectors.
 
     [bookmark: pgfId-800437]For information on filtering tables, see Filtering Tables.
 
      
       
     
 
     
 
     [bookmark: pgfId-800439]Tip When you filter a selector, that filter might remain applied to the selector when you open another window that includes the selector. For example, when you apply a filter to the Device selector in Device view, that filter is applied to the selector if you open the New Device wizard. If you have problems finding an item in a selector, check the Filter field to see if a filter is being applied.

     
      

     

     
 
     
 
     [bookmark: pgfId-800441]Step 1 Select Create Filter from the selector filter field to open the Create Filter dialog box.
 
     [bookmark: pgfId-800443]Step 2 Select one of the radio buttons to determine the matching criteria. The choices are:
 
      
      	 [bookmark: pgfId-800445]Match Any of the Following—Creates an OR relationship among the filter criteria. Policies matching any of your criteria are included in the filter.
 
      	 [bookmark: pgfId-800447]Match All of the Following—Creates an AND relationship among the filter criteria. Only those policies matching all your criteria are included in the filter.
 
     
 
     [bookmark: pgfId-800449]Step 3 Establish a filter rule by entering three criteria, as follows:
 
      
      	 [bookmark: pgfId-800451]From the first list, select the type to be filtered; for example,  Name .
 
      	 [bookmark: pgfId-800453]From the next list, select the operating criteria for the filter; for example,  contains .
 
      	 [bookmark: pgfId-800455]In the final field, enter or select a value on which to filter; for example  Cisco .
 
     
 
     [bookmark: pgfId-800457]Step 4 Click Add.
 
      
       
     
 
     
 
     [bookmark: pgfId-800459]Tip If you make a mistake in forming the filter rule, select the rule and click Remove to delete it.

     
      

     

     
 
     [bookmark: pgfId-800461]Step 5 Add any additional filter rules that you require. Click OK when you are finished.
 
     [bookmark: pgfId-800463]The selector is filtered according to the new filter criteria, and the new filter is added to the filter list.
 
     [bookmark: pgfId-800465]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-800481][bookmark: 3364][bookmark: ivpage_cncpt_CreateFilterDialogBox]Create Filter Dialog Box[bookmark: marker-800479]
 
     [bookmark: pgfId-800483]Use the Create Filter dialog box to filter and display a subset items in a selector or a table. Creating filters helps you find items more easily when viewing large lists.
 
     [bookmark: pgfId-800485]For more information on filtering, see these topics:
 
      
      	 [bookmark: pgfId-800490]Filtering Items in Selectors
 
      	 [bookmark: pgfId-800495]Filtering Tables
 
     
 
     [bookmark: pgfId-800497]Navigation Path
 
     [bookmark: pgfId-800499]Do one of the following:
 
      
      	 [bookmark: pgfId-800501]Select  Create Filter from the Filter field in a selector tree.
 
      	 [bookmark: pgfId-800503]Select  Advanced Filter from the Filter field above a table.
 
     
 
     [bookmark: pgfId-800505]Field Reference
 
     [bookmark: pgfId-800508]
 
      
       
        
        [bookmark: pgfId-797687]Table 1-14 [bookmark: 3395]Create Filter Dialog Box 
 
        
       
         
         	
           
           [bookmark: pgfId-797693]Element
          
  
         	
           
           [bookmark: pgfId-797695]Description
          
  
        
 
         
         	[bookmark: pgfId-797701]Match All of the Following
  
         	[bookmark: pgfId-797703]When you select this option an AND relationship is created among the filtering criteria you define. An item must satisfy every rule in the filter to be displayed in the list.
 [bookmark: pgfId-797705]For example, if you define the following criteria:
 
           
           	 [bookmark: pgfId-797707]Name contains OSPF
 
           	 [bookmark: pgfId-797709]Name contains West
 
          
 [bookmark: pgfId-797711]When you click OK, the filter is defined as: Name contains OSPF and Name contains West.
  
        
 
         
         	[bookmark: pgfId-797717]Match Any of the Following
  
         	[bookmark: pgfId-797719]When you select this option an OR relationship is created among the filtering criteria you define. An item must satisfy only one of the rules in the filter to be displayed in the list.
 [bookmark: pgfId-797721]For example, if you define the following criteria:
 
           
           	 [bookmark: pgfId-797723]Name contains OSPF
 
           	 [bookmark: pgfId-797725]Name contains RIP
 
          
 [bookmark: pgfId-797727]When you click OK, the filter is defined as: Name contains OSPF or Name contains RIP.
  
        
 
         
         	[bookmark: pgfId-797733]Filter Type
 [bookmark: pgfId-797735](First field.)
  
         	[bookmark: pgfId-797737]The type of property on which you are filtering. For tables, this is the column heading. You might have only one option for filtering certain lists (for example, you might only be able to filter by the name of the item).
  
        
 
         
         	[bookmark: pgfId-797743]Filter Operator
 [bookmark: pgfId-797745](Second field.)
  
         	[bookmark: pgfId-797747]The relationship between the filter type and the filter value. The available options depend on the selected type.
  
        
 
         
         	[bookmark: pgfId-797753]Filter Value
 [bookmark: pgfId-797755](Third field.)
  
         	[bookmark: pgfId-797757]The value on which you want to filter. Depending on the selected type, you either enter a text string in this field, or you select a value from the list.
  
        
 
         
         	[bookmark: pgfId-797763]Filter Content Area
 [bookmark: pgfId-797765]Add button
 [bookmark: pgfId-797767]Remove button
  
         	[bookmark: pgfId-797769]The filter type, operator, and value that you have selected for each criterion.
 
           
           	 [bookmark: pgfId-797771]To add a criterion, create it in the fields above this area and click  Add .
 
           	 [bookmark: pgfId-797773]To remove a criterion, select it and click  Remove .
 
          
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-800518][bookmark: 3465][bookmark: dtchap_cncpt_UsingWizards]Using Wizards[bookmark: marker-800514][bookmark: marker-800516]
 
     [bookmark: pgfId-800520]Some tasks that you can perform with Security Manager are presented as wizards. A wizard is a series of dialog boxes (or steps) that enables you to perform a task. The current step number and the total number of steps in the wizard are displayed in the wizard title bar.
 
     [bookmark: pgfId-800522]Wizards share the following buttons:
 
      
      	 [bookmark: pgfId-800524] Back —Returns to the previous dialog box. Enables you to review and modify settings that you defined in previous wizard steps.
 
      	 [bookmark: pgfId-800526] Next —Continues to the next dialog box. If this button is unavailable, you must define some required settings in the current dialog box before you can continue. Required settings are marked with an asterisk (*).
 
      	 [bookmark: pgfId-800528] Finish —Finishes the wizard, saving the settings you defined. You can finish the wizard whenever this button is available. If this button is not available, you must define more settings.
 
      	 [bookmark: pgfId-800530] Cancel —Closes the wizard without saving any settings.
 
      	 [bookmark: pgfId-800532] Help —Opens online help for the wizard.
 
     
 
    
 
     
      [bookmark: pgfId-800542][bookmark: 3491][bookmark: dtchap_cncpt_UsingTables]Using Tables [bookmark: marker-800538][bookmark: marker-800540]
 
     [bookmark: pgfId-800547]Many policies in Security Manager use tables. A small number of policies use a specialized type of table called a rules table. Rules tables have extra features compared to standard tables; for more information, see Using Rules Tables.
 
     [bookmark: pgfId-800549]Standard tables include these basic features:
 
      
      	 [bookmark: pgfId-800554]Table filter—You can filter the rows displayed to help you find items in a large table. For more information, see Filtering Tables.
 
      	 [bookmark: pgfId-800559]Table column headings—You can sort by column and move, show, and hide columns. For more information, see Table Columns and Column Heading Features.
 
      	 [bookmark: pgfId-800561]Table buttons—Use the buttons below the table to do the following:
 
     
 
     [bookmark: pgfId-800563] – Add Row button (+ icon)—Click this button to add an item to the table.
 
     [bookmark: pgfId-800565] – Edit Row button (pencil icon)—Select a row and click this button to edit its properties.
 
     [bookmark: pgfId-800567] – Delete Row button (trash can icon)—Select a row and click this button to delete it from the table.
 
    
 
     
      [bookmark: pgfId-800579][bookmark: 3518][bookmark: dtchap_proc_FilteringTables]Filtering Tables[bookmark: marker-800573][bookmark: marker-800575][bookmark: marker-800577]
 
     [bookmark: pgfId-800581]You can filter the items in a table to view a subset that satisfies specific criteria. Filtering a table does not change the contents of the table, but allows you to focus on just those entries that currently interest you. This is helpful for tables that have hundreds of entries.
 
     [bookmark: pgfId-800583]To filter a table, use the Filter fields above the table. With these controls, you can do the following:
 
      
      	 [bookmark: pgfId-800585]To do simple filtering, select the column name on which you want to filter, select the relationship you are looking for (such as “begins with”), enter the desired text string (or in some cases, select one of the pre-defined options), and click  Apply .
 
     
 
     [bookmark: pgfId-800587]You can filter the results by selecting another criteria and clicking Apply. Your filters are added together, showing the results that satisfy all criteria. For example, you could first enter “Service begins with IP,” click Apply, then enter “Source contains 10.100.10.10,” and click Apply. The result would be a table that shows all rows where the service is IP AND the source includes 10.100.10.10 (it might include other IP addresses as well).
 
      
      	 [bookmark: pgfId-800589]To do advanced filtering, select  Advanced Filter from the left most menu (the one that contains the column headings). This opens the Create Filter dialog box. Using this dialog box, you can create multiple filter criteria just as you can with the regular filter controls. However, you also have the option to create a list of disjoined, OR’ed criteria, by selecting  Match Any of the Following , where you can say “show me all rows that have IP for service or 10.100.10.10 for source address.”
 
     
 
     [bookmark: pgfId-800591] – To add criteria, enter the criteria and click Add.
 
     [bookmark: pgfId-800593] – To remove criteria, select the undesired criteria and click Remove.
 
     [bookmark: pgfId-800595]If you filter a table using the simple method, you can select Advanced Filter to alter your existing filter, adding or removing criteria as desired. The dialog box is filled with whatever filter criteria are currently applied to the table.
 
      
      	 [bookmark: pgfId-800597]The current filter is shown next to the Filter label in the filter control area. You can click  Clear to remove the filter and show all rows.
 
      	 [bookmark: pgfId-800599]Any filter you apply is kept in the left most menu below the Advanced Filter entry. You can apply the filter by selecting it from the list. However, this list can have at most 10 entries. When you create your eleventh filter, your oldest filter is removed from the list. If you select a filter and add criteria, you are modifying that filter rather than creating a new one. You cannot delete the listed filters.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-800601]Tip Your filter is maintained for a given type of table even if you select another device or log out and subsequently log back in. For example, if you filter the Access Rules table for one device, it will be filtered the same way for other devices. When you clear the filter, it is cleared for the same type of table for all devices. Your filters do not affect what any other user sees.

     
      

     

     
 
    
 
     
      [bookmark: pgfId-800613][bookmark: 3555][bookmark: dtchap_cncpt_TableColumnsandColumnHeadingFeatures]Table Columns and Column Heading Features[bookmark: marker-800607][bookmark: marker-800609][bookmark: marker-800611]
 
     [bookmark: pgfId-800615]Tables contain columns, each of which has a column heading in the heading row. These columns and their headings include the following features:
 
      
      	 [bookmark: pgfId-800617]Show/hide Columns—Right-click the table heading row to open the context menu and then select Show Columns. This menu enables you to select which columns appear. Showing or hiding columns does not affect the content of items defined in the table; it affects only your view.
 
     
 
     [bookmark: pgfId-800619]By default, the tables for some policies do not display all available columns.
 
      
      	 [bookmark: pgfId-800621]Show Details/Show Summary—Right-click the table heading row to open the context menu and then select either  Show Details or  Show Summary . This toggling menu enables you to select whether to view detailed or summarized information in the table.
 
      	 [bookmark: pgfId-800623]Move columns—Click and drag a column heading to move the column to a new position.
 
      	 [bookmark: pgfId-800625]Resize columns—Click a column heading divider (when the cursor turns into an arrow) and drag it to resize the column.
 
      	 [bookmark: pgfId-800627]Sort by column headings—Click a column heading to sort the table by that column’s contents. Click the same column heading again to reverse the sort order. The sorted column has an arrow next to its heading.
 
     
 
    
 
     
      [bookmark: pgfId-800637][bookmark: 3584][bookmark: dtchap_cncpt_UsingTextBoxes]Using Text Fields[bookmark: marker-800633][bookmark: marker-800635]
 
     [bookmark: pgfId-800639]Text fields can be single- or multiple-line, depending on the purpose of the field. Text fields that can contain multiple text lines include several features to make them easier to use. The following topics describe limitations and features of text fields:
 
      
      	 [bookmark: pgfId-800644]Understanding ASCII Limitations for Text
 
      	 [bookmark: pgfId-800649]Finding Text in Text Boxes
 
      	 [bookmark: pgfId-800654]Navigating Within Text Boxes
 
     
 
    
 
     
      [bookmark: pgfId-800666][bookmark: 3604][bookmark: dtchap_cncpt_UnderstandingASCIILimitationsforText]Understanding ASCII Limitations for Text[bookmark: marker-800660][bookmark: marker-800662][bookmark: marker-800664]
 
     [bookmark: pgfId-800668]Devices typically restrict text to ASCII characters. If you include non-ASCII characters in Security Manager text fields that are used to generate commands in a device configuration file, the presence of those characters can prevent the configuration file from loading on the device. For example, a non-ASCII character in an interface description for an FWSM can prevent the device from loading the startup configuration when you restart the device.
 
     [bookmark: pgfId-800673]The only places where you can include non-ASCII, non-English languages in device configurations is in the SSL VPN Bookmarks and SSL VPN Customization policy objects, which are used in configuring browser-based clientless SSL VPNs on ASA devices. For information on how you can support local languages for these objects, see Localizing SSL VPN Web Pages for ASA Devices.
 
    
 
     
      [bookmark: pgfId-800685][bookmark: 3619][bookmark: dtchap_proc_FindingTextinTextBoxes]Finding Text in Text Boxes[bookmark: marker-800681][bookmark: marker-800683]
 
     [bookmark: pgfId-800687]Use the Find dialog box to find text within a multiple line text field.
 
     
 
     [bookmark: pgfId-800689]Step 1 Click in a multiple line text field.
 
     [bookmark: pgfId-800691]Step 2 Press Ctrl+F. The Find dialog box opens.
 
     [bookmark: pgfId-800693]Step 3 Enter text to search for in the Find what field.
 
     [bookmark: pgfId-800695]Step 4 To specify the direction of the search, select either Up or Down in the Direction field.
 
     [bookmark: pgfId-800697]Step 5 To match the case of the text you entered, select the Match Case check box.
 
     [bookmark: pgfId-800699]Step 6 Click Find. The next occurrence of your search text is highlighted in the text field.
 
     [bookmark: pgfId-800701]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-800713][bookmark: 3652][bookmark: dtchap_proc_NavigatingWithinTextBoxes]Navigating Within Text Boxes[bookmark: marker-800709][bookmark: marker-800711]
 
     [bookmark: pgfId-800715]Use the Goto line dialog box to navigate to a specific line in a multiple line text field.
 
     
 
     [bookmark: pgfId-800717]Step 1 Click in a multiple line text field.
 
     [bookmark: pgfId-800719]Step 2 Press Ctrl+G. The Goto line dialog box opens.
 
     [bookmark: pgfId-800721]Step 3 Enter a line number in the Line number field.
 
     [bookmark: pgfId-800723]Step 4 Click OK. The text field scrolls to the line number you entered.
 
     [bookmark: pgfId-800725]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-800743][bookmark: 3679][bookmark: dtchap_cncpt_SelectingaFileorDirectoryontheServerFileSystem]Selecting or Specifying a File or Directory in Security Manager[bookmark: marker-800735][bookmark: marker-800737][bookmark: marker-800739][bookmark: marker-800741]
 
     [bookmark: pgfId-800745]Cisco Security Manager uses a standard file system browser to let you select a directory or file or to specify a file.
 
     [bookmark: pgfId-800747]You will be able to choose between client and server file systems when performing the following file operations:
 
      
      	 [bookmark: pgfId-800749]Installing Security Manager license files
 
      	 [bookmark: pgfId-800751]Importing/exporting device inventory files
 
      	 [bookmark: pgfId-800753]Importing/exporting shared policies
 
      	 [bookmark: pgfId-800755]Creating the following file objects:
 
     
 
     [bookmark: pgfId-800757] – Cisco Secure Desktop Package
 
     [bookmark: pgfId-800759] – Plug-In—For browser plug-in files.
 
     [bookmark: pgfId-800761] – AnyConnect Profile
 
     [bookmark: pgfId-800763] – AnyConnect Image
 
     [bookmark: pgfId-800765] – Hostscan Image
 
     [bookmark: pgfId-800767]For all other file operations, you can create or select files only on the Security Manager server--you cannot use a drive mounted on the server, and you cannot use your client system.
 
      
       
     
 
     
 
     [bookmark: pgfId-800772]Tip You can control whether file operations are allowed on the Security Manager client from Tools > Security Manager Administration > Customize Desktop. For more information, see Customize Desktop Page.

     
      

     

     
 
     [bookmark: pgfId-800774]Typically, to create or select a file, you click a Browse button to open a dialog box that has a title related to the action you are performing (for example, Choose Files when selecting configuration files). The Browse button appears on various dialog boxes throughout the product.
 
     [bookmark: pgfId-800776]In the dialog box, use the folder tree on the left to navigate to the folder you want:
 
      
      	 [bookmark: pgfId-800778]If client-side file browsing is enabled and you are performing a function that supports client-side browsing (see above), select the tab that corresponds to the system you want to import from or export to.
 
      	 [bookmark: pgfId-800780]If you are selecting a file, find it in the folder tree and select it in the right pane. If the action you are taking allows you to select multiple files, use Ctrl+click to select files individually, or Shift+click to select a range of files. You might also need to select a file type to view only those files that apply to your action.
 
      	 [bookmark: pgfId-800782]If you are specifying (creating) a file, navigate to the folder in which you want to create the file, enter a file name, and select the appropriate file type.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-800784]Note The path and file name are restricted to characters in the English alphabet. Japanese characters are not supported. When selecting files on a Windows Japanese OS system, the usual file separator character \ is supported, although you should be aware that it might appear as the Yen symbol (U+00A5).

     
      

     

     
 
    
 
     
      [bookmark: pgfId-800794][bookmark: 3734][bookmark: wfplan_cncpt_TroubleshootingUserInterfaceProblems]Troubleshooting User Interface Problems [bookmark: marker-800790][bookmark: marker-800792]
 
     [bookmark: pgfId-800796]The following tips might help you resolve general user interface problems that you might encounter:
 
      
      	 [bookmark: pgfId-800800] Interface appears to freeze [bookmark: marker-800798]—Occasionally, when you go from a Security Manager dialog box to some other application (for example, to check your e-mail), when you come back to Security Manager, nothing you click on responds. It appears the interface is frozen.
 
     
 
     [bookmark: pgfId-800802]This might be caused by an open dialog box that is covered by another Security Manager window. Until you close the dialog box, you will not be able to use any other window in the application. To find the hidden dialog box, press Alt+Tab, which opens a Windows panel that has icons for all currently open windows. Keep holding Alt, then press Tab repeatedly to cycle through the icons until you find the right one (the icon might be a generic Java icon rather than the Security Manager icon). You can also use your mouse to click the desired icon rather than using Tab to cycle through them.
 
      
      	 [bookmark: pgfId-800808] Text and list elements missing, Java errors when clicking buttons [bookmark: marker-800804][bookmark: marker-800806]—If you change your Windows color scheme while running the Security Manager client, you must close and then restart the client. Otherwise, the behavior of the client can be unpredictable.
 
     
 
     [bookmark: pgfId-800810]If you are experiencing these problems and you did not change the color scheme, try closing and restarting the application.
 
      
      	 [bookmark: pgfId-800816] Dialog Box is too big for the screen [bookmark: marker-800812]—The minimum screen resolution for the Security Manager client is actually bigger than the best screen resolution available on many laptops (for screen resolution requirements, see the client system requirements in the  Installation Guide for Cisco Security Manager ). Because some dialog boxes are quite large, if you run the client on a laptop, you might find the occasional dialog box that is too big to fit on your screen.
 
     
 
     [bookmark: pgfId-800818]Usually, you can reposition the dialog box to get access to the OK, Cancel, and Help buttons. However, if you cannot get those buttons on the screen, you can use the following techniques to perform the same actions:
 
     [bookmark: pgfId-800820] – OK—Put your cursor in a field near the bottom of the dialog box, then press Tab to move from field to field. Typically, the first off-screen field is the OK button. When the cursor highlight moves off screen, press Enter.
 
     [bookmark: pgfId-800822]You can also put the cursor in a field that does not allow carriage returns (for example, the typical Name field) and press Enter. In many cases, this is the equivalent of clicking OK.
 
     [bookmark: pgfId-800824] – Cancel—Click the X on the right side of the window’s title bar.
 
     [bookmark: pgfId-800826] – Help—Press F1.
 
    
 
   
 
    
     [bookmark: pgfId-800836][bookmark: 3783][bookmark: dtchap_cncpt_AccessingOnlineHelp]Accessing Online Help[bookmark: marker-800832][bookmark: marker-800834]
 
    [bookmark: pgfId-800838]To access online help for Security Manager, do one of the following:
 
     
     	 [bookmark: pgfId-800840]To open the main Security Manager online help page, select  Help > Help Topics .
 
     	 [bookmark: pgfId-800842]To open context-sensitive online help for the active page, select  Help > Help About This Page or click the  ? button in the toolbar.
 
     	 [bookmark: pgfId-800844]To open context-sensitive online help for a dialog box, click  Help in the dialog box.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-800848]Tip You must configure Internet Explorer to allow active content to run on your computer for the online help to open unblocked. In Internet Explorer, select Tools > Internet Options and click the Advanced tab. Scroll to the Security section, and select Allow active content to run in files on My Computer. Click OK to save the change. For a complete list of configuration requirements for Internet Explorer and Firefox browsers, see the Installation Guide for Cisco Security Manager.

    
     

    

    
 
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-996283][bookmark: 36179][bookmark: porules_cncpt_ManagingFirewallServices]Introduction to Firewall Services[bookmark: marker-996281]
      
      
 
     
 
 
    [bookmark: pgfId-996285]The Firewall policy folder (in either Device or Policy view) includes firewall-related policies that you can deploy to the Adaptive Security Appliance (ASA), PIX Firewall (PIX), Catalyst Firewall Services Module (FWSM), and security routers running Cisco IOS Software. These policies allow you to control network access through a device.
 
    [bookmark: pgfId-996287]This chapter contains the following topics:
 
     
     	 [bookmark: pgfId-996292]Overview of Firewall Services
 
     	 [bookmark: pgfId-996297]Managing Your Rules Tables
 
    
 
   
 
    
     [bookmark: pgfId-996309][bookmark: 36185][bookmark: porules_cncpt_OverviewofFirewallServices]Overview of Firewall Services[bookmark: marker-996307]
 
    [bookmark: pgfId-996311]The Firewall policy folder (in either Device or Policy view) includes firewall-related policies that you can deploy to the Adaptive Security Appliance (ASA), PIX Firewall (PIX), Catalyst Firewall Services Module (FWSM), and security routers running Cisco IOS Software, including Aggregation Services Routers (ASR) and Integrated Services Routers (ISR).
 
    [bookmark: pgfId-996313]These policies are focused on controlling access through the device, rather than access to the device (that is, logging into the device so that you can change its configuration or use show commands). Following is a general overview of the available firewall policies with pointers to topics that provide more detailed information:
 
     
     	 [bookmark: pgfId-996318]AAA rules—These are AAA firewall or authentication proxy rules that can require a user to authenticate (with a username and password) and optionally be authorized before the device allows the user to make network connections through it. You can also create accounting rules to collect billing, security, or resource allocation information. For more information, see Understanding AAA Rules.
 
     	 [bookmark: pgfId-996323]Access rules—These are traditional interface-based extended access control rules. They permit or deny a packet based on source address, destination address, source interface, and service, and you can apply them in both the in and out directions. For more information, see Understanding Access Rules.
 
     	 [bookmark: pgfId-996328]Inspection rules—These are traditional Context-Based Access Control (CBAC) inspection rules that filter out bad TCP/UDP packets based on application-layer protocol session information and that enable return traffic for the selected services. For more information, see Understanding Inspection Rules.
 
     	 [bookmark: pgfId-996333]Web filter rules—These are a type of inspection rule that filters web traffic based on the requested URL, allowing you to prevent connections to undesirable web sites. For more information, see Understanding Web Filter Rules.
 
     	 [bookmark: pgfId-996338]Zone-based firewall rules—These rules replace access rules, inspection rules, and web filter rules on IOS devices if you want to configure your rules based on zones instead of interfaces. A zone is a defined group of interfaces that perform the same security role (such as Inside or Outside). By using zone rules, you can create more compact device configurations than you can by using the other types of rules. For more information, see Understanding the Zone-based Firewall Rules.
 
     	 [bookmark: pgfId-996343]Botnet Traffic Filter Rules—These rules help you to spot botnet traffic when it is sent to known bad addresses. Botnets install malware on unsuspecting computers and use those computers as proxies to perform malicious actions. For more information, see Chapter 19, “Managing Firewall Botnet Traffic Filter Rules”.
 
     	 [bookmark: pgfId-996348]Transparent rules—These are Ethertype access control rules that apply to non-IP layer-2 traffic on transparent or bridged interfaces. For more information, see Configuring Transparent Firewall Rules.
 
    
 
    [bookmark: pgfId-996353]Most firewall rules policies are configured in rules tables. These tables allow in-line editing for most cells, rule organization using sections, and the ability to change the order of rules. If you create shared rules policies, you can apply them to a number of devices, even to devices running different operating systems, and Security Manager automatically creates the appropriate device commands to configure the policies based on the characteristics of each individual device, filtering out settings that do not apply to a device. For more information on using rule tables, see Managing Your Rules Tables.
 
    [bookmark: pgfId-996355]Another powerful feature used by most firewall rules policies is the idea of inheritance. When you create shared policies, one of your options is to have a device inherit the policy rather than be assigned the policy. This allows you to have a set of shared rules that apply to all devices, while having unique rules that apply to only those devices that require them. For more information about inheritance, see the following topics:
 
     
     	 [bookmark: pgfId-996360]Understanding Rule Inheritance
 
     	 [bookmark: pgfId-996365]Working with Shared Policies in Device View or the Site-to-Site VPN Manager.
 
    
 
    [bookmark: pgfId-996367]The following topics provide additional overview information about firewall services policies:
 
     
     	 [bookmark: pgfId-996372]Understanding the Processing Order of Firewall Rules
 
     	 [bookmark: pgfId-996377]Understanding How NAT Affects Firewall Rules
 
     	 [bookmark: pgfId-996382]ACL Names Preserved by Security Manager
 
    
 
     
      [bookmark: pgfId-996406][bookmark: 36238][bookmark: porules_cncpt_UnderstandingtheProcessingOrderofFirewallRules]Understanding the Processing Order of Firewall Rules [bookmark: marker-996388][bookmark: marker-996390][bookmark: marker-996392][bookmark: marker-996394][bookmark: marker-996396][bookmark: marker-996398][bookmark: marker-996400][bookmark: marker-996402][bookmark: marker-996404]
 
     [bookmark: pgfId-996408]When you configure firewall rules policies, you should keep in mind the logical order in which the rules are processed. For example, if you plan to drop all traffic of a certain type in an access rule, there is no reason to create rules in other firewall policies that apply to that type of traffic, because they will never be triggered. Conversely, if you want to apply certain types of inspection or web filtering on traffic, you must ensure that your access rules first allow that traffic to enter the device.
 
     [bookmark: pgfId-996410]Following is the general logical processing order of firewall rules:
 
      
      	 [bookmark: pgfId-996412]AAA rules—If you require authentication, with or without authorization, the user must successfully pass the test or the traffic is dropped.
 
      	 [bookmark: pgfId-996414]Access rules (In direction)—The traffic must then get through your access rules. If you used AAA rules, you might have allowed temporary per-user access rules to be configured for the user’s session. These per-user rules are configured in your AAA server, not in Security Manager.
 
     
 
     [bookmark: pgfId-996419]On ASA 8.3+ devices, global access rules are then processed after any interface-specific access rules. For more information, see Understanding Global Access Rules.
 
      
      	 [bookmark: pgfId-996421]One of the following:
 
     
 
     [bookmark: pgfId-996423] – Inspection rules (In direction), web filter rules (In direction), botnet rules, service policy rules (IPS, QoS, Connection)—All of these are applied to the traffic. For devices that do not allow you to configure the direction, all rules are considered to be in the In direction.
 
     [bookmark: pgfId-996425] – Zone-based firewall rules—If you configured zone-based rules for an IOS device, these rules replace inspection and web filter rules (botnet rules do not apply to IOS devices).
 
      
      	 [bookmark: pgfId-996427]Routing protocols are then applied to the traffic. The traffic is dropped if it cannot be routed. (Routing policies are in the Platform folders for the various device types and are not considered firewall policies.)
 
      	 [bookmark: pgfId-996429]ScanSafe Web Security policies, Inspection rules (Out direction), web filter rules (Out direction)—For IOS devices only, if you created ScanSafe policies, or inspection or web filter rules in the Out direction, they are now applied.
 
      	 [bookmark: pgfId-996431]Access rules (Out direction)—Finally, the traffic must pass through any Out direction access rules.
 
     
 
     [bookmark: pgfId-996433]Transparent rules do not fit into this picture. Because transparent rules apply to non-IP layer-2 traffic only, if a transparent rule applies to a packet, no other firewall rule applies to it; and conversely, if other rules apply, the transparent rule never applies.
 
     [bookmark: pgfId-996435]Related Topics
 
      
      	 [bookmark: pgfId-996440]Understanding AAA Rules
 
      	 [bookmark: pgfId-996445]Understanding Access Rules
 
      	 [bookmark: pgfId-996450]Understanding Inspection Rules
 
      	 [bookmark: pgfId-996455]Understanding Web Filter Rules
 
      	 [bookmark: pgfId-996460]Understanding the Zone-based Firewall Rules
 
      	 [bookmark: pgfId-996465]Chapter 19, “Managing Firewall Botnet Traffic Filter Rules”
 
      	 [bookmark: pgfId-996470]Configuring Transparent Firewall Rules
 
     
 
    
 
     
      [bookmark: pgfId-996492][bookmark: 36315][bookmark: porules_cncpt_UnderstandingHowNATAffectsFirewallRules]Understanding How NAT Affects Firewall Rules [bookmark: marker-996476][bookmark: marker-996478][bookmark: marker-996480][bookmark: marker-996482][bookmark: marker-996484][bookmark: marker-996486][bookmark: marker-996488][bookmark: marker-996490]
 
     [bookmark: pgfId-996494]Devices that support firewall rules also allow you to configure network address translation (NAT). NAT substitutes the real address in a packet with a mapped address that is routable on the destination network.
 
     [bookmark: pgfId-996496]If you configure NAT to occur on an interface, the firewall rules that are also configured on that interface should assess traffic based on the translated address rather than on the original (pre-NAT) address, with the exception of ASA 8.3+ devices.
 
     [bookmark: pgfId-996498]Devices running ASA software release 8.3 and higher use the original, or real, IP address when evaluating traffic with the exception of IPSec VPN traffic policies. Thus, when you configure firewall rules, ACL policy objects, or the IOS, QoS, and connection rules platform service policy, ensure that you use the original addresses.
 
     [bookmark: pgfId-996500]For more information about NAT, see the following topics:
 
      
      	 [bookmark: pgfId-996505]ASA, PIX, FWSM devices—Understanding Network Address Translation.
 
      	 [bookmark: pgfId-996510]IOS devices—NAT Policies on Cisco IOS Routers.
 
     
 
    
 
     
      [bookmark: pgfId-996536][bookmark: 36353][bookmark: porules_cncpt_ACLNamesPreservedbySecurityManager]ACL Names Preserved by Security Manager [bookmark: marker-996516][bookmark: marker-996518][bookmark: marker-996520][bookmark: marker-996522][bookmark: marker-996524][bookmark: marker-996526][bookmark: marker-996528][bookmark: marker-996530][bookmark: marker-996532][bookmark: marker-996534]
 
     [bookmark: pgfId-996538]Security Manager tries to preserve user-defined access control list (ACL) names as they appear in device configurations. Security Manager can preserve the ACL names configured on a device in the following circumstances:
 
      
      	 [bookmark: pgfId-996540]If the ACL name is specified in Security Manager.
 
     
 
     [bookmark: pgfId-996542]For access rules policies, you can specify ACL names in Firewall > Settings > Access Control or Firewall > Settings > IPv6 Access Control. You can specify a given name for a single interface and direction, but the name is used for any other interfaces and directions that use the same ACL. Keep in mind that you cannot use the same name as an ACL policy object that you assign to other policies on the device, and you cannot use the same name for IPv4 and IPv6 ACLs.
 
      
       
     
 
     
 
     [bookmark: pgfId-996544]Note Prior to the release of Security Manager 4.4 and versions 9.0 and higher of the ASA, separate pages, policies and policy objects were provided for configuring IPv4 and IPv6 firewall rules and policies. With Security Manager 4.4 and ASA 9.0+, these policies and policy objects were combined or unified. However, for the earlier ASA versions, a separate page for IPv6 access rules is still provided in Device view, while in Policy view, IPv4 and unified versions of the AAA-, access- and inspection-rule policy types are provided.

     
      

     

     
 
      
      	 [bookmark: pgfId-996546]If a policy uses an ACL policy object, the name of the policy object is used for the ACL name. ACL policy objects created during discovery use the name of the ACL defined on the device whenever possible. Behavior depends on an administrative setting:
 
     
 
     [bookmark: pgfId-996548] – If you select Allow Device Override for Policy Objects in Tools > Security Manager Administration > Discovery, if a policy object with the same name exists in Security Manager, but it has different content, the name is reused and a device-level override is created.
 
     [bookmark: pgfId-996550] – If you do not select that option, a new policy object is created with the same name but with a number appended to it, for example, ACLobject_1. This is the default behavior.
 
      
      	 [bookmark: pgfId-996552]If you select  Reuse Existing Names for the  Firewall Access List Names setting in  Tools > Security Manager Administration > Deployment , names defined on the device are reused for firewall rules that generate ACLs.
 
      	 [bookmark: pgfId-996554]If the ACL is unshared, even if you change the content of the ACL in Security Manager.
 
      	 [bookmark: pgfId-996556]If the ACL is shared, but the policies that share the ACL are defined identically in Security Manager. If you change the content of the ACL, one ACL retains the name and the others are assigned generated names.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-996558]Note On ASA devices and on PIX devices not running version 6.3(x), Security Manager does not reuse the ACL name if it is used by a NAT policy static rule and contains an object-group. The ACL is deployed with the contents of the object-group defined as the source. This is because the device requires that all ACEs in the ACL have the same source.

     
      

     

     
 
     [bookmark: pgfId-996560]Tips
 
      
      	 [bookmark: pgfId-996562]If you use an ACL policy object that uses a name also used by an ACL already defined on the device, and the existing ACL is for a command that Security Manager does not support, you will get a deployment error asking you to choose a different name. If this happens, rename the policy object.
 
      	 [bookmark: pgfId-996564]ACLs named <number>_<number> are not valid on IOS devices. Security Manager strips off the suffix prior to deployment. This also means that you cannot assign an IOS device more than one ACL object with the same numbered prefix. However, named ACLs that have a numbered suffix are allowed, for example, ACLname_1.
 
      	 [bookmark: pgfId-996566]Numbered ACLs must use the correct number ranges for IOS devices. Standard ACLs must be in the range 1-99 or 1300-1999. Extended ACLs must be in the range 100-199 or 2000-2699.
 
      	 [bookmark: pgfId-996568]ACL names for IOS devices cannot begin with an underscore (_).
 
      	 [bookmark: pgfId-996570]Policies that do not preserve user-defined names include SSL VPN policies, transparent firewall rules, and AAA rules (for IOS devices).
 
     
 
     [bookmark: pgfId-996572]The following topics provide additional information about ACL naming:
 
      
      	 [bookmark: pgfId-996577]ACL Naming Conventions
 
      	 [bookmark: pgfId-996582]Resolving ACL Name Conflicts Between Policies
 
     
 
    
 
     
      [bookmark: pgfId-996604][bookmark: 36433][bookmark: porules_cncpt_ACLNamingConventions]ACL Naming Conventions [bookmark: marker-996588][bookmark: marker-996590][bookmark: marker-996592][bookmark: marker-996594][bookmark: marker-996596][bookmark: marker-996598][bookmark: marker-996600][bookmark: marker-996602]
 
     [bookmark: pgfId-996606]When the name for the ACL is generated by Security Manager, the name is derived from the type of rule or platform being defined and certain configuration settings that make it unique. All newly created ACLs are given a name based on the naming conventions shown in the following table.
 
      
       
     
 
     
 
     [bookmark: pgfId-996608]Tip During deployment, sometimes a suffix .n (where n is an integer) might get added to an ACL name if the existing ACL cannot be edited in place. For example, if an ACL named acl_mdc_outside_10 already exists on the device, a new ACL with the name acl_mdc_outside_10.1 is created if you do not remove the old ACL before you deploy the new ACL.

     
      

     

     
 
     [bookmark: pgfId-996611]
 
      
       
        
        [bookmark: pgfId-994977]Table 12-1 [bookmark: 36463]ACL Naming Conventions 
 
        
       
         
         	
           
           [bookmark: pgfId-994983]Policy Type
          
  
         	
           
           [bookmark: pgfId-994985]Naming Convention
          
  
        
 
         
         	[bookmark: pgfId-994991]Access ACLs
  
         	
           
           	 [bookmark: pgfId-994993]Inbound: CSM_FW_ACL_InterfaceName
 
           	 [bookmark: pgfId-994995]Outbound: CSM_FW_ACL_OUT_InterfaceName
 
          
  
        
 
         
         	[bookmark: pgfId-995001]IPv6 Access ACLs
  
         	
           
           	 [bookmark: pgfId-995003]Inbound: CSM_IPV6_FW_ACL_InterfaceName
 
           	 [bookmark: pgfId-995005]Outbound: CSM_IPV6_FW_ACL_OUT_InterfaceName
 
          
 [bookmark: pgfId-995007]Note Prior to the release of Security Manager 4.4 and versions 9.0 and higher of the ASA, separate pages, policies and policy objects were provided for configuring IPv4 and IPv6 firewall rules and policies. With Security Manager 4.4 and ASA 9.0+, these policies and policy objects were combined or unified. However, for the earlier ASA versions, a separate page for IPv6 access rules is still provided in Device view, while in Policy view, IPv4 and unified versions of the AAA-, access- and inspection-rule policy types are provided.
  
        
 
         
         	[bookmark: pgfId-995013]Inspection Rules
  
         	
           
           	 [bookmark: pgfId-995015]For ASA 7.0+/PIX 7.0+: CSM_CMAP_ACL_n where n is an integer beginning with 1.
 
           	 [bookmark: pgfId-995017]For IOS devices, a numbered ACL.
 
          
  
        
 
         
         	[bookmark: pgfId-995023]NAT0 ACLs
  
         	
           
           	 [bookmark: pgfId-995025]Inbound: CSM_nat0_InterfaceName_in
 
           	 [bookmark: pgfId-995027]Outbound: CSM_nat0_InterfaceName
 
          
  
        
 
         
         	[bookmark: pgfId-995033]NAT ACLs
  
         	
           
           	 [bookmark: pgfId-995035]Inbound: CSM_nat_InterfaceName_poolID_in
 
           	 [bookmark: pgfId-995037]Outbound: CSM_nat_InterfaceName_poolID
 
          
 [bookmark: pgfId-995039]Note For PIX 6.3(x) devices, the following is added to the ACL name: add _dns for dns, _nrseq for norandomseq, _emb## for embryonic limit and _tcp## and _udp## for tcp and udp max connection limits.
  
        
 
         
         	[bookmark: pgfId-995045]NAT Policy Static Translation Rules ACLs
  
         	
           
           	 [bookmark: pgfId-995047]For PIX 6.3(x) devices:
 
          
 [bookmark: pgfId-995049] – For IP: CSM_static_globalIP_LocalInterfaceName_globalInterfaceName
 [bookmark: pgfId-995051] – For other protocols: CSM_static_globalIP_LocalInterfaceName_globalInterfaceName_ protocol _globalPort
 
           
           	 [bookmark: pgfId-995053]For devices running other OS versions, the localIP string is added:
 
          
 [bookmark: pgfId-995055] – For IP: CSM_static_localIP_globalIP_LocalInterfaceName_globalInterfaceName
 [bookmark: pgfId-995057] – For other protocols: CSM_static_localIP_globalIP_LocalInterfaceName_globalInterfaceName_ protocol _globalPort
  
        
 
         
         	[bookmark: pgfId-995063]AAA ACLs
  
         	[bookmark: pgfId-995065]For PIX/ASA/FWSM: CSM_AAA_{AUTHO | ATHEN | ACCT}_InterfaceName _ServerGroupName
 [bookmark: pgfId-995067]Authentication Proxy for IOS devices:
 
           
           	 [bookmark: pgfId-995069]On an interface without NAC: CSM_AUTH-PROXY_InterfaceName_traffic type_ACL, where InterfaceName is the interface in which the rule is applied and traffic type is HTTP, Telnet, or FTP.
 
           	 [bookmark: pgfId-995071]AuthProxy and NAC on the same interface: CSM_ADMISSION_ID_ACL, where ID is an internal identifier of the interface role within Security Manager to which NAC is applied.
 
          
  
        
 
         
         	[bookmark: pgfId-995077]Web Filter Rules ACLs
  
         	[bookmark: pgfId-995079]For ASA 7.0+/PIX 7.0+: devices correspond to a filter command.
 [bookmark: pgfId-995081]For IOS devices, a numbered ACL.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-996623][bookmark: 36557][bookmark: porules_cncpt_ResolvingACLNameConflictsBetweenPolicies]Resolving ACL Name Conflicts Between Policies [bookmark: marker-996617][bookmark: marker-996619][bookmark: marker-996621]
 
     [bookmark: pgfId-996625]If an ACL is shared, but the policies that share the ACL are not defined identically in Security Manager, one policy uses the original name of the ACL and the other policies use a new name generated by Security Manager. The order of preference for determining which policy uses the original name is as follows:
 
      
      	 [bookmark: pgfId-996627]Access list ACLs
 
      	 [bookmark: pgfId-996629]AAA ACLs
 
      	 [bookmark: pgfId-996631]Static ACLs
 
      	 [bookmark: pgfId-996633]NAT0 ACLs
 
      	 [bookmark: pgfId-996635]NAT ACLs
 
     
 
     [bookmark: pgfId-996637]For example, if an access ACL and a NAT0 ACL try to reuse the same ACL, the access ACL uses the original name as configured on the device and the NAT0 ACL is renamed by Security Manager.
 
    
 
   
 
    
     [bookmark: pgfId-996645][bookmark: 36584][bookmark: porules_cncpt_ManagingYourRulesTables]Managing Your Rules Tables [bookmark: marker-996643]
 
    [bookmark: pgfId-996647]The following sections explain some of the basics of using rules tables, which appear in many of the firewall rules, NAT, and select other policies:
 
     
     	 [bookmark: pgfId-996652]Using Rules Tables
 
     	 [bookmark: pgfId-996657]Adding and Removing Rules
 
     	 [bookmark: pgfId-996662]Editing Rules
 
     	 [bookmark: pgfId-996667]Finding and Replacing Items in Rules Tables
 
     	 [bookmark: pgfId-996672]Moving Rules and the Importance of Rule Order
 
     	 [bookmark: pgfId-996677]Enabling and Disabling Rules
 
     	 [bookmark: pgfId-996682]Using Sections to Organize Rules Tables
 
     	 [bookmark: pgfId-996687]Combining Rules
 
     	 [bookmark: pgfId-996692]Generating Policy Query Reports
 
     	 [bookmark: pgfId-996697]Optimizing Network Object Groups When Deploying Firewall Rules
 
     	 [bookmark: pgfId-996702]Expanding Object Groups During Discovery
 
    
 
     
      [bookmark: pgfId-996716][bookmark: 36624][bookmark: dtchap_cncpt_UsingRulesTables]Using Rules Tables[bookmark: marker-996708][bookmark: marker-996710][bookmark: marker-996712][bookmark: marker-996714]
 
     [bookmark: pgfId-996718]Rules tables in Security Manager display sets of rules (for example, access rules) that make up a policy. These types of tables are used in only a select group of policies, but many of the firewall services rules policies use them. Rules tables are used when the order of the rules within the policy matter.
 
     [bookmark: pgfId-996723]Figure 12-1 details the features in rules tables.
 
     [bookmark: pgfId-996727]Figure 12-1 [bookmark: 36641]Rules Table Example
 
     [bookmark: pgfId-996730]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-996732]Following is an explanation of the numbered call-outs of the rules table features:
 
      
      	 [bookmark: pgfId-996737] Device and policy identification banner (1) —The banner provides information about policy sharing and inheritance and includes the ability to perform some actions. For detailed information, see Using the Policy Banner.
 
      	 [bookmark: pgfId-996742] Table filter (2) —You can filter the rules displayed to help you find rules in a large table. For more information, see Filtering Tables.
 
      	 [bookmark: pgfId-996747] Table column headings (3) —You can sort by column and move, show, and hide columns. For more information, see Table Columns and Column Heading Features.
 
      	 [bookmark: pgfId-996749] Rules, Workarea (4) —The body of the table shows the rules that are included in the policy.
 
      	 [bookmark: pgfId-996754] User-defined sections (5) —You can group rules into sections for your convenience. For more information, see Using Sections to Organize Rules Tables.
 
      	 [bookmark: pgfId-996756] Table buttons (6) —Use the buttons below the table to do the following:
 
     
 
     [bookmark: pgfId-996761] – Enable automatic conflict detection (Access Rules only). For more information, see Using Automatic Conflict Detection.
 
     [bookmark: pgfId-996763]If conflict detection is enabled, you can click the Generate Report button to create an HTML report of the conflicts that can be printed or exported to another tool.
 
     [bookmark: pgfId-996765]When you first open the Access Rules page, the Generate Report button is replaced with a progress bar. After conflict analysis has completed, the Generate Report button becomes available along with the other conflict detection features.
 
     [bookmark: pgfId-996773] – Update the hit count information displayed in the table. For more information, see Viewing Hit Count Details and Hit Count Selection Summary Dialog Box.
 
     [bookmark: pgfId-996778] – Run a policy query, which can help you evaluate your rules and identify ineffective rules. See Generating Policy Query Reports
 
     [bookmark: pgfId-996783] – Find and replace items within rules (button with the binoculars icon)—For more information, see Finding and Replacing Items in Rules Tables.
 
     [bookmark: pgfId-996788] – Move and rearrange rules (up and down arrows)—For more information, see Moving Rules and the Importance of Rule Order.
 
     [bookmark: pgfId-996793] – Add rules to the table (+ icon)—For more information, see Adding and Removing Rules.
 
     [bookmark: pgfId-996798] – Edit the selected rule (pencil icon)—For more information, see Editing Rules.
 
     [bookmark: pgfId-996803] – Delete the selected rule (trash can icon)—For more information, see Adding and Removing Rules.
 
      
      	 [bookmark: pgfId-996808] Conflict Navigation Bar (7) —Use the Conflict navigation bar to navigate to conflicting rules in the rules table. For more information, see Using Automatic Conflict Detection.
 
     
 
    
 
     
      [bookmark: pgfId-996850][bookmark: 36702][bookmark: porules_cncpt_AddingandRemovingRules]Adding and Removing Rules [bookmark: marker-996814][bookmark: marker-996816][bookmark: marker-996818][bookmark: marker-996820][bookmark: marker-996822][bookmark: marker-996824][bookmark: marker-996826][bookmark: marker-996828][bookmark: marker-996830][bookmark: marker-996832][bookmark: marker-996834][bookmark: marker-996836][bookmark: marker-996838][bookmark: marker-996840][bookmark: marker-996842][bookmark: marker-996844][bookmark: marker-996846][bookmark: marker-996848]
 
     [bookmark: pgfId-996852]When you work with policies that use rules tables, like many of the firewall rules policies, you can add rules to the policy using several methods:
 
      
      	 [bookmark: pgfId-996854] Add Row button (+ icon)—Clicking the Add Row button beneath the table is the standard method to add a new rule. Clicking this button opens the dialog box for adding rules that is specific to that type of policy. If you select a row or section heading, the new rule is added after the selected row. Otherwise, it is added at the end of the appropriate scope (typically, the local scope).
 
      	 [bookmark: pgfId-996856]Right-click a row and select  Add Row —This is equivalent to selecting a row and clicking the Add Row button.
 
      	 [bookmark: pgfId-996861]Copy and paste—If you want to create a new rule that is similar to an existing rule, you can select the rule, right-click and select  Copy , then select the row after which you want to place the rule, right-click and select  Paste . This creates a duplicate rule, which you can select and edit (see Editing Rules).
 
      	 [bookmark: pgfId-996866]Cut and paste—Cut and paste is similar to copy and paste, except you are deleting the existing rule when you select the  Cut command. Instead of cut and paste, consider moving the rule (see Moving Rules and the Importance of Rule Order).
 
     
 
     [bookmark: pgfId-996868]When you no longer need a rule, you can remove it by selecting the rule and clicking the Delete Row button (trash can icon).
 
      
       
     
 
     
 
     [bookmark: pgfId-996873]Tip Rather than deleting a rule, consider first disabling the rule. By disabling a rule, you remove it from the device (when you redeploy the configuration) without removing it from Security Manager. Then, if you discover that you really needed that rule after all, you can simply enable it and redeploy the configuration. If you delete the rule, you would have to recreate it (there is no undo function). Thus, you might want to develop a policy of deleting rules only after they have been disabled for a certain amount of time. For more information, see Enabling and Disabling Rules.

     
      

     

     
 
     [bookmark: pgfId-996875]Related Topics
 
      
      	 [bookmark: pgfId-996880]Using Rules Tables
 
      	 [bookmark: pgfId-996885]Using Sections to Organize Rules Tables
 
     
 
    
 
     
      [bookmark: pgfId-996907][bookmark: 36787][bookmark: porules_cncpt_EditingFirewallRules]Editing Rules[bookmark: marker-996891][bookmark: marker-996893][bookmark: marker-996895][bookmark: marker-996897][bookmark: marker-996899][bookmark: marker-996901][bookmark: marker-996903][bookmark: marker-996905]
 
     [bookmark: pgfId-996909]To edit an existing rule in any of the rules policies that use rules tables, select the rule and click the Edit Row button, or right-click and select Edit Row. This allows you to edit all aspects of the selected rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-996911]Tip You cannot edit any aspect of an inherited rule from a local device rule policy. Edit inherited rules in Policy view.

     
      

     

     
 
     [bookmark: pgfId-996913]For most rule tables, you can also edit specific attributes, or table cells, instead of editing the entire rule, using commands in the right-click menu.
 
     [bookmark: pgfId-996915]The ability to edit a cell is limited by whether it makes sense to edit the content. For example, Inspection Rules have many limitations based on how the rule is configured:
 
      
      	 [bookmark: pgfId-996917]If you applied the rule to All Interfaces, you cannot edit source or destination addresses, the interface, or the direction of the rule.
 
      	 [bookmark: pgfId-996919]If you selected Default Inspection Traffic for the traffic match criteria (without selecting the option to limit inspection between source and destination), or Custom Destination Ports, you cannot edit source or destination addresses.
 
      	 [bookmark: pgfId-996921]If you selected Destination Address and Port (IOS), you cannot edit source addresses.
 
     
 
     [bookmark: pgfId-996923]The following cell-level commands are available, although the ability to edit multiple rows is not supported in all policies that use rule tables:
 
      
      	 [bookmark: pgfId-996925] Add <Attribute Type> —When you select multiple rows and right-click a Source, User, Destination, Services, or Interface cell, you can select the Add command to append entries to the data currently in the selected cells. The Add command’s full name includes the name of the attribute, for example, Add Source.
 
      	 [bookmark: pgfId-996927] Edit <Attribute Type> —Most attributes allow you to edit the content. Editing replaces the content of the cell. You can edit a single cell, or select multiple rows and edit the contents of the same type of cell in all rows at once. The Edit command’s full name includes the name of the attribute, for example, Edit Interfaces.
 
      	 [bookmark: pgfId-996929] Edit <Entry> —In some cases, when you edit Source, User, Destination, Services, or Interfaces, you can select an entry in the cell and edit just that entry. For example, if the Sources cell contains three network/host objects and an IP address, you can select any of them and edit the entry. The edit command includes the name of the entry, for example, Edit HostObject.
 
      	 [bookmark: pgfId-996931] Remove <Entry> —In some cases, when you edit Source, User, Destination, Services, or Interfaces, you can select an entry in the cell and remove the entry. You cannot remove the last entry in the cell, because the rule would become invalid. The remove command includes the name of the entry, for example, Remove IP.
 
      	 [bookmark: pgfId-996933] Create <Object Type> Object from Cell Contents —In the Sources, User, Destinations, and Services cells, you can select the Create command to create a policy object of the appropriate type. You can also select an entry in the cell and create a policy object from just the selected item. The create command includes the policy object type you can create, and the name of the item that is the source for the object, either cell contents for everything in the cell, or the name of an entry if you selected one. When creating network/host objects, you are always creating network/host group objects.
 
      	 [bookmark: pgfId-996935] Show <Attribute Type> Contents; Show <Entry> Contents —The show commands let you view the actual data defined in the cell. The results depend on the view you are in:
 
     
 
     [bookmark: pgfId-996937] – Device View, Map View, or Import Rules—You are shown the actual IP addresses, fully-qualified domain names (FQDNs), services, or interfaces to which the rule will apply for the specific device. For example, if the rule uses network/host objects, you will see the specific IP addresses or FQDNs defined by the objects. If the rule uses interface objects, you will see the specific interfaces defined on the device that the object identifies, if any.
 
     [bookmark: pgfId-996939]The IP addresses for network/host objects are sorted in ascending order on the IP address, and then descending order on the subnet mask.
 
     [bookmark: pgfId-996941]Service objects are sorted on protocol, source port, and destination port.
 
     [bookmark: pgfId-996943]Interface objects are listed in alphabetical order. If the interface is selected because it matches a pattern in an interface object, the pattern is listed first, and the matching interface is shown in parentheses. For example, “* (Ethernet1)” indicates that the Ethernet1 interface on the device is selected because it matches the * pattern (which matches all interfaces).
 
      
      	 [bookmark: pgfId-996945]Policy View—You are shown the patterns defined in the policy objects and entries defined for the policy. Entries are sorted alphabetically, with numbers and special characters coming first.
 
     
 
     [bookmark: pgfId-996947]Related Topics
 
      
      	 [bookmark: pgfId-996952]Using Rules Tables
 
      	 [bookmark: pgfId-996957]Adding and Removing Rules
 
      	 [bookmark: pgfId-996962]Moving Rules and the Importance of Rule Order
 
      	 [bookmark: pgfId-996967]Enabling and Disabling Rules
 
      	 [bookmark: pgfId-996972]Using Sections to Organize Rules Tables
 
     
 
    
 
     
      [bookmark: pgfId-997004][bookmark: 36873][bookmark: fwlsvcpg_cncpt_AddorEditSourcesorDestinations]Adding or Editing Address Cells in Rules Tables[bookmark: marker-996996][bookmark: marker-996998][bookmark: marker-997000][bookmark: marker-997002]
 
     [bookmark: pgfId-997009]Use the Add or Edit Sources or Destinations dialog boxes, or Address dialog boxes for NAT tables, to edit the source or destination entry in a rules table that includes sources or destinations. For detailed information on editing firewall rules cells, see Editing Rules.
 
     [bookmark: pgfId-997014]You can enter any combination of the following address types to define the source or destination of the traffic. The type of policy determines whether an IPv4 or IPv6 address is required; you cannot mix address types. You can enter more than one value by separating the items with commas. For more information, see Specifying IP Addresses During Policy Definition.
 
      
      	 [bookmark: pgfId-997016]Network/host object. Enter the name of the object or click  Select to select it from a list. You can also create new objects from the selection list.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-997018]Note The only way to specify a fully-qualified domain name (FQDN) is to use an FQDN network/host object or a group object that includes an FQDN object. You cannot directly type in an FQDN. Not all policy types allow FQDN; you are prevented from specifying an object that contains an FQDN object if the policy does not allow it.

     
      

     

     
 
      
      	 [bookmark: pgfId-997020]Host IP address, for example, 10.10.10.100 (IPv4) or 2001:DB8::200C:417A (IPv6).
 
      	 [bookmark: pgfId-997022]IPv4 network address, including subnet mask, in either the format 10.10.10.0/24 or 10.10.10.0/255.255.255.0.
 
      	 [bookmark: pgfId-997024]IPv6 network address and prefix length in the format 2001:DB8::/32.
 
      	 [bookmark: pgfId-997026]A range of IP addresses, for example, 10.10.10.100-10.10.10.200 (IPv4) or 2001:DB8::1-2001:DB8::100 (IPv6).
 
      	 [bookmark: pgfId-997031](IPv4 only.) An IP address pattern in the format 10.10.0.10/255.255.0.255, where the mask is a discontiguous bit mask (see Contiguous and Discontiguous Network Masks for IPv4 Addresses).
 
      	 [bookmark: pgfId-997036]Interface roles object. Enter the name of the object or click  Select to select it from a list (you must select Interface Role as the object type). When you use an interface role, the rule behaves as if you supplied the IPv4 or IPv6 address of the selected interface. This is useful for interfaces that get their address through DHCP, because you do not know what IP address will be assigned to the device. For more information, see Understanding Interface Role Objects.
 
     
 
     [bookmark: pgfId-997038]If you select an interface role as a source, the dialog box displays tabs to differentiate between hosts or networks and interface roles.
 
     [bookmark: pgfId-997040]Navigation Path
 
     [bookmark: pgfId-997042]Do any of the following in a rules policy that includes sources, destinations, or other address cells:
 
      
      	 [bookmark: pgfId-997044]Right-click an address cell in a rules table and select  Edit Sources or  Edit Destinations or a similar command. The data replaces the content of the selected cells.
 
      	 [bookmark: pgfId-997046]Select an entry in an address cell and select  Edit <Entry> . The data replaces the selected entry.
 
      	 [bookmark: pgfId-997048]Select multiple rules, right-click a Sources or Destination cell, and select  Add Sources or  Add Destinations . The data is appended to the data already in the cell.
 
     
 
    
 
     
      [bookmark: pgfId-997064][bookmark: 36934][bookmark: fwlsvcpg_cncpt_AddorEditUser]Adding or Editing User Cells in Rules Tables[bookmark: marker-997060][bookmark: marker-997062]
 
      
       
     
 
     
 
     [bookmark: pgfId-997066]Tip The user cell applies to ASA 8.4(2+) only. Anything configured in the cell is ignored for other device types or OS versions.

     
      

     

     
 
     [bookmark: pgfId-997071]Use the Add or Edit Users dialog boxes to edit the user entry in a rules table that includes user identity groups. For detailed information on editing firewall rules cells, see Editing Rules.
 
     [bookmark: pgfId-997076]You can enter any combination of the following to identify traffic based on Active Directory (AD) user or user group names. If you configure identity user groups, they apply to source traffic only. For traffic to match the rule, both the source addresses and identity user groups must match. That is, the rule applies to traffic sent from users on the specific networks or hosts defined in the source field when directed at the destination. For more information, see Configuring Identity-Based Firewall Rules.
 
     [bookmark: pgfId-997078]To make the rule apply to a user without regard for the source address, specify any in the source cell.
 
     [bookmark: pgfId-997080]You can enter more than one value by separating the items with commas. Following are the supported formats:
 
      
      	 [bookmark: pgfId-997082]Identity user group objects.
 
      	 [bookmark: pgfId-997084]Individual users: NETBIOS_DOMAIN\user
 
      	 [bookmark: pgfId-997086]User groups (note the double \): NETBIOS_DOMAIN\\user_group
 
     
 
     [bookmark: pgfId-997094]Click Select to select objects, users, or user groups from a list or to create new objects. For more information, see Selecting Identity Users in Policies and Creating Identity User Group Objects.
 
     [bookmark: pgfId-997096]Navigation Path
 
     [bookmark: pgfId-997098]Do any of the following in a rules policy that includes user cells:
 
      
      	 [bookmark: pgfId-997100]Right-click a user cell in a rules table and select  Edit Users . The data replaces the content of the selected cells.
 
      	 [bookmark: pgfId-997102]Select an entry in a user cell and select  Edit <Entry> . The data replaces the selected entry.
 
      	 [bookmark: pgfId-997104]Select multiple rules, right-click a user cell, and select  Add Users . The data is appended to the data already in the cell.
 
     
 
    
 
     
      [bookmark: pgfId-997124][bookmark: 36977][bookmark: fwlsvcpg_cncpt_EditServices]Adding or Editing Services Cells in Rules Tables[bookmark: marker-997120][bookmark: marker-997122]
 
     [bookmark: pgfId-997126]Use the Edit Services dialog box to edit the services that define the type of traffic to act on. You can enter more than one value by separating the items with commas.
 
     [bookmark: pgfId-997128]You can enter any combination of service objects and service types (which are typically a protocol and port combination). If you type in a service, you are prompted as you type with valid values. You can select a value from the list and press Enter or Tab. You can also click Select to select the service from a list, or to create a new service.
 
     [bookmark: pgfId-997133]For complete information on how to specify services, see Understanding and Specifying Services and Service and Port List Objects.
 
     [bookmark: pgfId-997138]For detailed information on editing firewall rules cells, see Editing Rules.
 
     [bookmark: pgfId-997140]Navigation Path
 
     [bookmark: pgfId-997142]Do any of the following in a rules policy that includes services:
 
      
      	 [bookmark: pgfId-997144]Right-click a Services cell in a rules table and select  Edit Services . The data replaces the content of the selected cells.
 
      	 [bookmark: pgfId-997146]Select an entry in a Services cell and select  Edit <Entry> . The data replaces the selected entry.
 
      	 [bookmark: pgfId-997148]Select multiple rules, right-click a Services cell, and select  Add Services . The data is appended to the data already in the cell.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-997150]Tip For inspection rules, services appear in the Traffic Match column and only for rules where the traffic matches source, destination, and port.

     
      

     

     
 
    
 
     
      [bookmark: pgfId-997174][bookmark: 37011][bookmark: fwlsvcpg_cncpt_EditIF]Adding or Editing Interfaces or Zones Cells in Rules Tables[bookmark: marker-997166][bookmark: marker-997168][bookmark: marker-997170][bookmark: marker-997172]
 
     [bookmark: pgfId-997179]Use the Add or Edit Interfaces (or Zones) dialog box to edit the interfaces or zones for which the rule is defined. For detailed information on editing firewall rules cells, see Editing Rules.
 
      
      	 [bookmark: pgfId-997181]When editing interfaces, you can enter any combination of specific interface names or interface roles. You can enter more than one value by separating the items with commas. Enter the names or click  Select to select the interfaces and roles from a list, or to create new roles. An interface must already be defined to appear on the list.
 
     
 
     [bookmark: pgfId-997183]When you deploy the policy to the device, interface roles are replaced by actual interface names, and only to interfaces that are actually configured on the device. To see which interfaces will actually be selected by a rule, right-click the Interfaces cell and select Show Interfaces.
 
      
      	 [bookmark: pgfId-997185]When editing zones, you can select only one interface role, and you cannot select individual interfaces. The interface roles are used to create zones for zone based firewall rules. To see the interfaces that will belong to the zone, right-click the Zones cell and select  Show Zone Contents .
 
     
 
     [bookmark: pgfId-997187]For more information about interface roles and selecting interfaces, see the following topics:
 
      
      	 [bookmark: pgfId-997192]Understanding Interface Role Objects
 
      	 [bookmark: pgfId-997197]Specifying Interfaces During Policy Definition
 
     
 
     [bookmark: pgfId-997199]Navigation Path
 
     [bookmark: pgfId-997201]Do any of the following in a rules policy that includes interfaces or zones:
 
      
      	 [bookmark: pgfId-997203]Right-click an Interfaces or Zones cell in a rules table and select  Edit Interfaces ,  Edit Zones , or similar command. The data replaces the content of the selected cells.
 
      	 [bookmark: pgfId-997205]Select an entry in an Interfaces cell and select  Edit <Entry> . The data replaces the selected entry. You cannot edit an entry in a zone.
 
      	 [bookmark: pgfId-997207]Select multiple rules, right-click an Interfaces cell, and select  Add Interfaces . The data is appended to the data already in the cell. You cannot add entries to a zone.
 
     
 
    
 
     
      [bookmark: pgfId-997227][bookmark: 37061][bookmark: fwlsvcpg_cncpt_EditCategory]Editing Category Cells in Rules Tables[bookmark: marker-997225]
 
     [bookmark: pgfId-997235]Use the Edit Category dialog box to change the category assigned to a rule. Categories help you organize and identify rules and objects. See Using Category Objects. For detailed information on editing firewall rules cells, see Editing Rules.
 
     [bookmark: pgfId-997237]Navigation Path
 
     [bookmark: pgfId-997239]Right-click a Category cell in a rules policy that includes categories and select Edit Category.
 
    
 
     
      [bookmark: pgfId-997259][bookmark: 37080][bookmark: fwlsvcpg_cncpt_EditDescription]Editing Description Cells in Rules Tables[bookmark: marker-997257]
 
     [bookmark: pgfId-997264]Use the Edit Description dialog box to edit the description of the rule. The description helps you identify the purpose of a rule and can be up to 1024 characters. For detailed information on editing rules cells, see Editing Rules.
 
     [bookmark: pgfId-997266]Navigation Path
 
     [bookmark: pgfId-997268]Right-click a Description cell in a rules policy that includes descriptions and select Edit Description.
 
    
 
     
      [bookmark: pgfId-997338][bookmark: 37098][bookmark: fwlsvcpg_cncpt_ShowContentsDialogBoxes]Showing the Contents of Cells in Rules Tables[bookmark: marker-997328][bookmark: marker-997330][bookmark: marker-997332][bookmark: marker-997334][bookmark: marker-997336]
 
     [bookmark: pgfId-997343]Use the Show Contents dialog boxes to display the actual, translated data defined in a source, user, destination, services, interfaces, zones, or other cell in a rules table that includes addresses, identity user groups, interfaces, services, or policy objects that define those things. The title of the dialog box indicates which cell or entry you are examining. Use this information to determine to which addresses, services, or interfaces the rule will actually apply when deployed to the device. For detailed information about editing or viewing cell contents, see Editing Rules.
 
     [bookmark: pgfId-997345]What you see in the dialog box depends on the view you are in:
 
      
      	 [bookmark: pgfId-997347]Device View, Map View—You are shown the actual IP addresses, users, services, or interfaces to which the rule will apply for the specific device. For example, if the rule uses network/host objects, you will see the specific IP addresses or fully-qualified domain names (FQDN) defined by the objects. If the rule uses interface objects, you will see the specific interfaces defined on the device that the object identifies, if any.
 
     
 
     [bookmark: pgfId-997349] – The IP addresses for network/host objects are sorted in ascending order on the IP address, and then descending order on the subnet mask.
 
     [bookmark: pgfId-997351] – Service objects are sorted on protocol, source port, and destination port.
 
     [bookmark: pgfId-997353] – Interface objects are listed in alphabetical order. If the interface is selected because it matches a pattern in an interface object, the pattern is listed first, and the matching interface is shown in parentheses. For example, “* (Ethernet1)” indicates that the Ethernet1 interface on the device is selected because it matches the * pattern (which matches all interfaces).
 
      
      	 [bookmark: pgfId-997355]Policy View—You are shown the patterns defined in the policy objects and entries defined for the policy. Entries are sorted alphabetically, with numbers and special characters coming first.
 
     
 
     [bookmark: pgfId-997357]Filtering Contents
 
     [bookmark: pgfId-997359]A List Filter field is provided above the results in the Show Contents dialog box. You can use the List Filter field to quickly locate any entries that contain a specified text string.
 
     [bookmark: pgfId-997363]Figure 12-2 [bookmark: 37156]List Filter Field
 
     [bookmark: pgfId-997367]
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     [bookmark: pgfId-997369]To search for a specific text string in the Show Contents list:
 
      
      	 [bookmark: pgfId-997371]Click in the List Filter field to place the text cursor, and then begin typing.
 
     
 
     [bookmark: pgfId-997373]These are “live filter” fields. That is, as you type each character, entries that do not include your current text string are removed from the list or table.
 
     [bookmark: pgfId-997375]To clear a List Filter field:
 
      
      	 [bookmark: pgfId-997377]Click the clear button at the right side of the field.
 
     
 
     [bookmark: pgfId-997379]This button appears when you begin typing in the field. (You also can highlight the characters and press the Delete or Backspace key on your keyboard.)
 
     [bookmark: pgfId-997381]When you clear the List Filter field, all entries in the list are again displayed.
 
     [bookmark: pgfId-997383]You can tune the filter results by selecting case sensitivity or insensitivity, by allowing wildcards or regular expressions, and by specifying where in a returned string your characters must be located.
 
     [bookmark: pgfId-997385]To change the List Filter criteria:
 
     [bookmark: pgfId-997387] 1. Click the filter-parameters button (magnifying glass) at the left side of the List Filter field to open the parameters menu.
 
     [bookmark: pgfId-997389] 2. Choose an option.
 
     [bookmark: pgfId-997391]The menu consists of three sections:
 
     [bookmark: pgfId-997393] – Case sensitive and Case insensitive – Choose one or the other. If you choose Case sensitive, found text must match not only the characters you enter, but also their as-typed case.
 
     [bookmark: pgfId-997395] – Use wildcards and Use regular expression – Choose one or the other. The following wildcards are recognized:
 
     [bookmark: pgfId-997397] – * (asterisk) – Match zero or more characters at that location in the string.
 
     [bookmark: pgfId-997399] – + (plus sign)– Match one or more characters at that location in the string.
 
     [bookmark: pgfId-997401] – ? (question mark) – Match one character at that location in the string.
 
     [bookmark: pgfId-997403] – Match from start, Match exactly, and Match anywhere – Choose one. Match from start means that the string you enter must be found at the beginning of an entry, although it can be part of a larger set of characters. Match exactly requires that the string you enter exactly match the entire column entry. Match anywhere means the string can be found anywhere within an entry, and it can be part of a larger set of characters.
 
     [bookmark: pgfId-997405] 3. Repeat Steps 1 and 2 to change another parameter.
 
     [bookmark: pgfId-997407]Navigation Path
 
     [bookmark: pgfId-997409]Do any of the following in a rules policy that includes sources, user, destinations, services, interfaces, zones, or other fields that specify networks, identity user groups, interfaces, or services. You can also show contents when using tools that work with rules, such as importing rules.
 
      
      	 [bookmark: pgfId-997411]Right-click one of those cells and select  Show <Attribute Type> Contents , where the attribute type is the name of the cell. The data includes all entries defined in the cell.
 
      	 [bookmark: pgfId-997413]Right-click an entry in one of those cells and select  Show <Entry> Contents , where the name of the selected entry is included in the command name. The data displayed is only for the selected entry.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-997415]Tip For inspection rules, services appear in the Traffic Match column and only for rules where the traffic matches source, destination, and port.

     
      

     

     
 
    
 
     
      [bookmark: pgfId-997429][bookmark: 37238][bookmark: porules_cncpt_UsingFindandReplace]Finding and Replacing Items in Rules Tables [bookmark: marker-997421][bookmark: marker-997423][bookmark: marker-997425][bookmark: marker-997427]
 
     [bookmark: pgfId-997431]In policies that use rules tables, you can search for items in some cells and selectively replace them. The cells that you can search depend on the policy. You can use wildcard characters to find items based on pattern matching, for example, so that you can replace several related networks with a new network/host policy object defined for them.
 
     [bookmark: pgfId-997436]To use find and replace, click the Find and Replace (binoculars icon) button at the bottom of any policy that uses rules tables to open the Find and Replace Dialog Box. In the Firewall folder, this includes AAA rules, access rules, IPv6 access rules, inspection rules, zone based firewall rules, and web filter rules (for ASA/PIX/FWSM devices only). For ASA/PIX/FWSM devices, it also includes the NAT translation rules policy (but not for every combination of context and operational mode) and the IOS, QoS, and connection rules platform service policy.
 
     [bookmark: pgfId-997438]When searching for items, you select the type of item, the columns you want to search, and enter the string that you want to find and optionally, the string you want to use to replace it. You can find and replace the following types of items:
 
      
      	 [bookmark: pgfId-997440]Network—A network/host object name, or the IP address of a host or network.
 
      	 [bookmark: pgfId-997442]User—An Active Directory (AD) username (NetBIOS_DOMAIN\user), user group name (NetBIOS_DOMAIN\\user_group), or identity user group object name.
 
      	 [bookmark: pgfId-997444]Service—A service object name or protocol and port, for example TCP/80. The search is syntactic, not semantic, that is, if you are searching for TCP/80 and a rule uses HTTP, the search results will not find it.
 
      	 [bookmark: pgfId-997446]Interface Role—An interface name or interface role object name.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-997448]Note In access rules, you can search for global rules by using the Global interface name. However, there is no way to convert between global and interface-specific rules. Although you can find global rules using the Global interface name, if you try to replace an interface name with the name “Global,” you are actually creating an interface-specific access rule that uses a policy object named Global.

     
      

     

     
 
      
      	 [bookmark: pgfId-997450]Text—A text string in a Description field.
 
     
 
     [bookmark: pgfId-997452]The following are some examples of what you might do with find and replace:
 
      
      	 [bookmark: pgfId-997454]If you create a new network/host object named network10.100 for all networks in the 10.100.0.0/16 range, you can search and replace all subordinate network specifications. For example, you can search for ^10.100* to find all addresses like 10.100.10.0/24. Select the  Find Whole Words Only and  Allow Wildcard options, and enter network10.100 as the replacement string. Because you selected Find Whole Words Only, the string that is replaced is the entire 10.100.10.0/24 string, not just the 10.100 portion.
 
      	 [bookmark: pgfId-997456]If you want to find all rules that use IP addresses (instead of network/host objects), you can search for *.*.*.* to find all host or network IP addresses. You can then selectively edit the cell while the Find and Replace dialog box is open.
 
      	 [bookmark: pgfId-997458]If you want to replace all interface role objects that include “side” in the name (such as inside and outside) with the interface role object named External, search for *side with the  Find Whole Words Only and  Allow Wildcard options selected, and enter External in the Replace field.
 
     
 
     [bookmark: pgfId-997460]Related Topics
 
      
      	 [bookmark: pgfId-997465]Editing Rules
 
     
 
    
 
     
      [bookmark: pgfId-997475][bookmark: 37286][bookmark: fwlsvcpg_cncpt_FindandReplacePage]Find and Replace Dialog Box [bookmark: marker-997473]
 
     [bookmark: pgfId-997477]Use the Find and Replace dialog box to locate and optionally replace items in rule table cells. The types of items you can search for differ based on the policy you are viewing.
 
     [bookmark: pgfId-997479]Navigation Path
 
     [bookmark: pgfId-997481]Click the Find and Replace (binoculars icon) button at the bottom of any policy that uses rules tables. In the Firewall folder, this includes AAA rules, access rules, IPv6 access rules, inspection rules, zone based firewall rules, and web filter rules (for ASA/PIX/FWSM devices only). For ASA/PIX/FWSM devices, it also includes the NAT translation rules policy (but not for every combination of context and operational mode) and the IOS, QoS, and connection rules platform service policy.
 
     [bookmark: pgfId-997483]Related Topics
 
      
      	 [bookmark: pgfId-997488]Finding and Replacing Items in Rules Tables
 
      	 [bookmark: pgfId-997493]Editing Rules
 
     
 
     [bookmark: pgfId-997495]Field Reference
 
     [bookmark: pgfId-997498]
 
      
       
        
        [bookmark: pgfId-995111]Table 12-2 [bookmark: 37309]Find and Replace Page 
 
        
       
         
         	
           
           [bookmark: pgfId-995117]Element
          
  
         	
           
           [bookmark: pgfId-995119]Description
          
  
        
 
         
         	[bookmark: pgfId-995125]Type
  
         	[bookmark: pgfId-995127]The type of item you are trying to find. Select the type, then select which columns you want to search. If you select All Columns, the columns searched are those also listed with the All Columns item (the search does not consider every column in the table).
 
           
           	 [bookmark: pgfId-995129]Network—A network/host object name, or the IP address of a host or network.
 
           	 [bookmark: pgfId-995131]User—An Active Directory (AD) username (NetBIOS_DOMAIN\user), user group name (NetBIOS_DOMAIN\\user_group), or identity user group object name.
 
           	 [bookmark: pgfId-995133]Service—A service object name or protocol and port, for example TCP/80. The search is syntactic, not semantic, that is, if you are searching for TCP/80 and a rule uses HTTP, the search results will not find it.
 
           	 [bookmark: pgfId-995135]Interface Role—An interface name or interface role object name.
 
          
 [bookmark: pgfId-995137]Note In access rules, you can search for global rules by using the Global interface name. However, there is no way to convert between global and interface-specific rules. Although you can find global rules using the Global interface name, if you try to replace an interface name with the name “Global,” you are actually creating an interface-specific access rule that uses a policy object named Global.
 
           
           	 [bookmark: pgfId-995139]Text—A text string in a Description field.
 
          
  
        
 
         
         	[bookmark: pgfId-995145]Find
  
         	[bookmark: pgfId-995147]The string you are trying to locate. If you are searching for a policy object, click Select to choose the object from a list.
  
        
 
         
         	[bookmark: pgfId-995153]Replace
  
         	[bookmark: pgfId-995155](Optional) The string you want to use to replace the search string. What gets replaced is controlled by the search options. If you want to replace the search string with the name of a policy object, click Select to choose the object from a list.
 [bookmark: pgfId-995157]You can replace search strings with multiple items. Separate the items with commas. For example, you can search for the TCP service and replace it with TCP, UDP.
 [bookmark: pgfId-995159]You can remove items by not entering anything in the Replace field and clicking the Replace button.
 [bookmark: pgfId-995161]This field is greyed out if the table does not allow editing.
  
        
 
         
         	[bookmark: pgfId-995167]Direction
  
         	[bookmark: pgfId-995169]The direction in which you want to search relative to the currently selected row or cell, either up or down. When the end of the table is reach, the search continues to the top of the table.
  
        
 
         
         	[bookmark: pgfId-995175]Match Case
  
         	[bookmark: pgfId-995177]For text searches, whether you want to match the capitalization you used in the Find field.
  
        
 
         
         	[bookmark: pgfId-995183]Find Whole Words Only
  
         	[bookmark: pgfId-995185]Whether the search should find and select only whole words, which are strings delimited by spaces or punctuation. For example, a whole word search for SanJose will find SanJose but not SanJose1.
 [bookmark: pgfId-995187]If you use this option with the Allow Wildcard option, you can search for partial strings but if you replace the located string, you replace the whole word and not the partial string. For example, you can search for ^10.100* to find all addresses like 10.100.10.0/24, and replace with them with the network10.100 policy object. By selecting Whole Words, the network/host object replaces the entire address, not just the portion you searched for.
 [bookmark: pgfId-995189]For text searches, this option and the Allow Wildcards option are mutually exclusive.
  
        
 
         
         	[bookmark: pgfId-995195]Allow Wildcards
  
         	[bookmark: pgfId-995197]Whether the search or replacement strings use wildcard characters. If you do not select this option, all characters are treated literally.
 [bookmark: pgfId-995199]You can use the Java regular expression syntax to create your expression with the following exceptions:
 
           
           	 [bookmark: pgfId-995201]Period (.)—The period is a literal period and it is implicitly escaped.
 
           	 [bookmark: pgfId-995203]Question mark (?)—The question mark indicates a single character.
 
           	 [bookmark: pgfId-995205]Asterisk (*)—The asterisk matches one or more characters. It does not match zero characters.
 
           	 [bookmark: pgfId-995207]Plus sign (+)—The plus sign means the same as the asterisk; it matches one or more characters.
 
          
  
        
 
         
         	[bookmark: pgfId-995213]Find Next button
  
         	[bookmark: pgfId-995215]Click this button to find the next occurrence of the search string.
  
        
 
         
         	[bookmark: pgfId-995221]Replace button
  
         	[bookmark: pgfId-995223]Click this button to replace the found string with the replacement string.
  
        
 
         
         	[bookmark: pgfId-995229]Replace All button
  
         	[bookmark: pgfId-995231]Click this button to automatically find the search string and replace it throughout the table.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-997524][bookmark: 37401][bookmark: porules_proc_MovingRules]Moving Rules and the Importance of Rule Order [bookmark: marker-997504][bookmark: marker-997506][bookmark: marker-997508][bookmark: marker-997510][bookmark: marker-997512][bookmark: marker-997514][bookmark: marker-997516][bookmark: marker-997518][bookmark: marker-997520][bookmark: marker-997522]
 
     [bookmark: pgfId-997526]Rules policies that use rules tables are ordered lists. That is, the top to bottom order of the rules matters and has an effect on the policy.
 
     [bookmark: pgfId-997528]When the device analyzes a packet against a rules policy, the device searches the rules in order from top to bottom. The first rule that matches the packet is the rule that is applied to the packet, and all subsequent rules are ignored. Thus, if you place a general rule pertaining to IP traffic before a more specific rule pertaining to HTML traffic for a given source or destination, the more specific rule might never be applied.
 
     [bookmark: pgfId-997533]For access control rules, you can use the automatic conflict detection tool to help identify when rule order will prevent a rule from ever being applied to traffic (for more information, see Using Automatic Conflict Detection). For other rules policies, carefully inspect the table to spot problems with rule order.
 
     [bookmark: pgfId-997535]When you find that you need to rearrange the order of a rule, select the rule that needs to be moved and click the Up Row (up arrow) or Down Row (down arrow) buttons as appropriate. If these buttons do not appear beneath the rules table, rule order does not matter and you cannot rearrange them.
 
     [bookmark: pgfId-997540]If you use sections to organize your rules, you can move rules only within the section. When you move rules that are outside the sections, you can move them above or below the section. For more information about working with sections, see Using Sections to Organize Rules Tables.
 
      
       
     
 
     
 
     [bookmark: pgfId-997545]Tip Special rules apply to moving access rules when you mix interface-specific and global rules in a policy. For more information, see Understanding Global Access Rules.

     
      

     

     
 
     [bookmark: pgfId-997547]Related Topics
 
      
      	 [bookmark: pgfId-997552]Using Rules Tables
 
      	 [bookmark: pgfId-997557]Adding and Removing Rules
 
      	 [bookmark: pgfId-997562]Editing Rules
 
      	 [bookmark: pgfId-997567]Enabling and Disabling Rules
 
      	 [bookmark: pgfId-997572]Using Sections to Organize Rules Tables
 
     
 
    
 
     
      [bookmark: pgfId-997618][bookmark: 37464][bookmark: porules_proc_EnablingandDisablingRules]Enabling and Disabling Rules[bookmark: marker-997578][bookmark: marker-997580][bookmark: marker-997582][bookmark: marker-997584][bookmark: marker-997586][bookmark: marker-997588][bookmark: marker-997590][bookmark: marker-997592][bookmark: marker-997594][bookmark: marker-997596][bookmark: marker-997598][bookmark: marker-997600][bookmark: marker-997602][bookmark: marker-997604][bookmark: marker-997606][bookmark: marker-997608][bookmark: marker-997610][bookmark: marker-997612][bookmark: marker-997614][bookmark: marker-997616]
 
     [bookmark: pgfId-997620]You can enable and disable individual rules in a policy that uses rules tables, such as most firewall services rules policies. Your change takes effect when you redeploy the configuration to the device.
 
     [bookmark: pgfId-997622]If a rule is disabled, it appears in the table overlain with hash marks. When you deploy the configuration, disabled rules are removed from the device.
 
     [bookmark: pgfId-997624]Disabled rules are kept in the rules policy in Security Manager as a convenience so that you can easily enable needed rules without recreating them. Thus, it is often wise to disable a rule that you believe you no longer need instead of immediately deleting it.
 
     [bookmark: pgfId-997626]To change whether a rule is enabled or disabled, select the rule, right-click and select Enable or Disable, as appropriate.
 
     [bookmark: pgfId-997628]Related Topics
 
      
      	 [bookmark: pgfId-997633]Using Rules Tables
 
      	 [bookmark: pgfId-997638]Adding and Removing Rules
 
      	 [bookmark: pgfId-997643]Editing Rules
 
      	 [bookmark: pgfId-997648]Moving Rules and the Importance of Rule Order
 
      	 [bookmark: pgfId-997653]Using Sections to Organize Rules Tables
 
     
 
    
 
     
      [bookmark: pgfId-997667][bookmark: 37551][bookmark: porules_cncpt_UnderstandingRuleTableSections]Using Sections to Organize Rules Tables[bookmark: marker-997659][bookmark: marker-997661][bookmark: marker-997663][bookmark: marker-997665]
 
     [bookmark: pgfId-997669]You can organize policies that use rules tables into sections. There are two types of sections:
 
      
      	 [bookmark: pgfId-997674]Scopes, which define inheritance relationships between a policy and an inherited policy. These sections are automatically created when you inherit policies. For more information, see Understanding Rule Inheritance.
 
      	 [bookmark: pgfId-997676]User-defined sections, which are convenient groupings that help you organize rules so that you can evaluate and edit the policy more easily. These types of sections are most useful for policies that contain a large number of rules.
 
     
 
     [bookmark: pgfId-997678]All rules within a section must be sequential; you cannot group rules randomly. If you want to identify non-contiguous rules as being related, you can assign the same category to the rules.
 
     [bookmark: pgfId-997680]User-defined sections are set off visually from the other rules in the table by an indented section heading. The heading contains, left to right, a +/- icon for opening and closing the section, a band of color identifying the category you assigned the section (if any), the section name, the first and last rule number contained in the section (for example, 4-8), and the description, if any, you gave the section.
 
      
       
     
 
     
 
     [bookmark: pgfId-997682]Note You might need to resize the rule number column to see the numbering of rules in sections.

     
      

     

     
 
     [bookmark: pgfId-997684]Whether you create user-defined sections is completely up to you. If you decide creating these types of sections is worthwhile, the following information explains how to create and use them:
 
      
      	 [bookmark: pgfId-997686]To create a new section, right-click a row that you want to place the section and select  Include in New Section . (You can also use Shift+click to select a block of rules.) You are prompted for a name, description, and category for the section (the name is the only required element).
 
      	 [bookmark: pgfId-997688]To move existing rules into a section, select one or more contiguous rules, right-click and select  Include in Section <name of section> . This command appears only if the selected rows are next to an existing section. If the rows you want to add to a section are not currently next to the section, you can do one of two things: move the rules until they are next to the section; cut the rules and paste them into the section.
 
      	 [bookmark: pgfId-997690]You cannot move a section. Instead, you need to move the rules that are outside of the section around it. When you move a rule that is next to, but not within, a section, the rule jumps over the section.
 
      	 [bookmark: pgfId-997692]You cannot move a rule outside of or through a section. A section defines the borders within which you can move rules. If you want to move rules out of a section and back into the Local scope section, select one or more contiguous rules, right-click and select  Remove from Section <name of section> . The rules must be at the beginning or end of the section to use this command. If they are not, you can either move the rules until they are, or use cut and paste to move them out of the section.
 
      	 [bookmark: pgfId-997694]To add a new rule to a section, select the rule after which you want to create the rule before clicking the Add Row button. To place it at the beginning of the section, select the section heading.
 
     
 
     [bookmark: pgfId-997696]If you want to create a rule after, but outside of, a section, you can either create it as the last rule in the section and then remove it from the section, or create it just above the section and click the down arrow button.
 
      
      	 [bookmark: pgfId-997698]You can change the name, description, or category of a section by right-clicking the section heading and selecting  Edit Section .
 
      	 [bookmark: pgfId-997700]When you delete a section, all rules contained in the section are retained and moved back into the Local scope section. No rules are deleted. To delete a section, right-click the section heading and select  Delete Section .
 
      	 [bookmark: pgfId-997702]If you use the Combine Rules tool, the resulting combined rules respect your sections. Rules that are in a section can be combined only with other rules in that section.
 
     
 
     [bookmark: pgfId-997704]Related Topics
 
      
      	 [bookmark: pgfId-997709]Using Rules Tables
 
      	 [bookmark: pgfId-997714]Adding and Removing Rules
 
      	 [bookmark: pgfId-997719]Editing Rules
 
      	 [bookmark: pgfId-997724]Moving Rules and the Importance of Rule Order
 
      	 [bookmark: pgfId-997729]Enabling and Disabling Rules
 
     
 
    
 
     
      [bookmark: pgfId-997759][bookmark: 37618][bookmark: fwlsvcpg_cncpt_AddandEditRuleSectionDialogBoxes]Add and Edit Rule Section Dialog Boxes[bookmark: marker-997755][bookmark: marker-997757]
 
     [bookmark: pgfId-997764]Use the Add and Edit Rule Section dialog boxes to add or edit a user-defined section heading in a rules table. For detailed information about how to use sections to organize a rules table, see Using Sections to Organize Rules Tables.
 
     [bookmark: pgfId-997766]Navigation Path
 
     [bookmark: pgfId-997768]Do one of the following:
 
      
      	 [bookmark: pgfId-997770]Select one or more rules in a rules table, right-click and select  Include in New Section .
 
      	 [bookmark: pgfId-997772]Right-click a section heading and select  Edit Section .
 
     
 
     [bookmark: pgfId-997774]Field Reference
 
     [bookmark: pgfId-997777]
 
      
       
        
        [bookmark: pgfId-995244]Table 12-3 [bookmark: 37650]Add and Edit Rule Section Dialog Boxes 
 
        
       
         
         	
           
           [bookmark: pgfId-995250]Element
          
  
         	
           
           [bookmark: pgfId-995252]Description
          
  
        
 
         
         	[bookmark: pgfId-995258]Name
  
         	[bookmark: pgfId-995260]The name of the section.
  
        
 
         
         	[bookmark: pgfId-995266]Description
  
         	[bookmark: pgfId-995268]A description for the section, up to 1024 characters.
  
        
 
         
         	[bookmark: pgfId-995274]Category
  
         	[bookmark: pgfId-995279]The category assigned to the section. Categories help you organize and identify rules and objects. See Using Category Objects.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-997789][bookmark: 37678][bookmark: porules_cncpt_CombiningRules]Combining Rules[bookmark: marker-997783][bookmark: marker-997785][bookmark: marker-997787]
 
     [bookmark: pgfId-997791]Access rules and AAA rules policies can grow over time to include a large number of rules. The size of these policies can make it difficult to manage them. To alleviate this problem, you can use the rule combiner tool to reduce the number of rules in a policy without changing how the policy handles traffic.
 
      
       
     
 
     
 
     [bookmark: pgfId-997793]Tip Combining rules can dramatically compress the number of access rules required to implement a particular security policy. For example, a policy that required 3,300 access rules might only require 40 rules after hosts and services are efficiently grouped. However, you cannot use the rule combiner with IPv6 access rules or with rules that specify users or user groups, either directly or with identity user group objects. You can use the tool with rules that use FQDN network/host objects.

     
      

     

     
 
     [bookmark: pgfId-997795]You might have several rules that allow a specific range of services to various trusted hosts (as sources) to various public servers (as destinations). If you have 10 rules applying to this situation, it is possible that those 10 rules can be combined into a single rule. You could then create new policy objects for the collection of services (for example, AllowedServices), hosts (for example, TrustedHosts), and servers (for example, PublicServers). To create the new objects during rule combination, you can right-click the newly-combined cells and select Create Network (or Service) Object from Cell Contents.
 
     [bookmark: pgfId-997797]For example, you might have two rules for interface FastEthernet0:
 
      
      	 [bookmark: pgfId-997799]Permit TCP for source 10.100.10.1 to destination 10.100.12.1
 
      	 [bookmark: pgfId-997801]Permit TCP for source 10.100.10.1 to destination 10.100.13.1
 
     
 
     [bookmark: pgfId-997803]These can be combined into a single rule: permit TCP for source 10.100.10.1 to destination 10.100.12.1, 10.100.13.1.
 
     [bookmark: pgfId-997805]Multidimensional sorting is used to combine rules. For example, for access rules:
 
     [bookmark: pgfId-997807] 1. Rules are sorted by their sources, so rules with the same source are placed together.
 
     [bookmark: pgfId-997809] 2. Same-source rules are sorted by destination, so rules with the same source and destination are placed together.
 
     [bookmark: pgfId-997811] 3. Same-source and same-destination rules are combined into a single rule, and the services are concatenated.
 
     [bookmark: pgfId-997813] 4. Adjacent rules are checked to see if they have the same source and service. If so, they are combined into a single rule, and the destinations are concatenated.
 
     [bookmark: pgfId-997815] 5. Adjacent rules are checked to see if they have the same destination and service. If so, they are combined into a single rule, and the sources are concatenated.
 
     [bookmark: pgfId-997817]Sorting is repeated based on destination and service in place of source.
 
      
       
     
 
     
 
     [bookmark: pgfId-997822]Tip Rules from different sections are never combined. Any sections you create to organize rules limit the scope of the possible combinations. Also, interface-specific and global access rules are never combined. For more information about global rules, see Understanding Global Access Rules.

     
      

     

     
 
     [bookmark: pgfId-997824]Related Topics
 
      
      	 [bookmark: pgfId-997829]Chapter 15, “Managing Firewall AAA Rules”
 
      	 [bookmark: pgfId-997834]Chapter 16, “Managing Firewall Access Rules”
 
     
 
     
 
     [bookmark: pgfId-997836]Step 1 Select the policy whose rules you want to combine from the Firewall folder. You can combine rules for the following types of policy:
 
      
      	 [bookmark: pgfId-997838]AAA rules
 
      	 [bookmark: pgfId-997840]Access rules
 
     
 
     [bookmark: pgfId-997842]Step 2 If you want the tool to limit possible combinations to a specific group of rules, select them. You can select rules using Shift+click and Ctrl+click, select all rules in a section by selecting the section heading, or all rules within a scope by selecting the scope heading (for example, Local). To not limit the tool, do not select anything in the table. Keep the following in mind:
 
      
      	 [bookmark: pgfId-997844]In Device view, you can save combinations only for local rules. The tool will allow you to run it on shared and inherited rules, but you cannot save the results. If you do not select any rules, the default is to consider all local scope rules.
 
      	 [bookmark: pgfId-997846]To combine rules in shared policies, you must run the tool in Policy view. If you do not select any rules, the default is to consider all mandatory rules.
 
     
 
     [bookmark: pgfId-997848]You are warned if you try to run the tool when you cannot save the results.
 
     [bookmark: pgfId-997853]Step 3 Right-click anywhere in the rules table and choose Combine Rules to open the Combine Rules Selection Summary Dialog Box. If you have selected specific rules for which to limit combining, make sure you right-click on one of the selected rules or the rules will be deselected.
 
     [bookmark: pgfId-997855]Step 4 Select the columns you want the rule to consider combining. If you do not select certain columns, the combined rules must have the identical settings in those columns to be combined.
 
     [bookmark: pgfId-997857]You can also elect to consider combining the rules you selected or all rules within the policy.
 
      
       
     
 
     
 
     [bookmark: pgfId-997859]Tip If a column type is not listed, then combined rules must have the identical content in those cells except for the Description cell. Rules that have different content for the cells are not combined.

     
      

     

     
 
     [bookmark: pgfId-997861]Step 5 Click OK to generate the combination and display the results in the Rule Combiner Results Dialog Box.
 
     [bookmark: pgfId-997863]Analyze the results and evaluate whether you want to save the combinations. You must save all or none, you cannot pick and choose which combinations to save.
 
     [bookmark: pgfId-997871]For more information on evaluating the results, see Interpreting Rule Combiner Results. For an example, see Example Rule Combiner Results.
 
     [bookmark: pgfId-997873]Step 6 Click OK to replace the original rules in the rules tables with the combined rules.
 
     [bookmark: pgfId-997875]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-997887][bookmark: 37764][bookmark: fwlsvcpg_cncpt_CombineRulesSelectionSummaryDialogBox]Combine Rules Selection Summary Dialog Box[bookmark: marker-997885]
 
     [bookmark: pgfId-997892]Use the Combine Rules Selection Summary dialog box to define the parameters used for combining rules in firewall rules policies. When you click OK, the combination results are displayed in the Rule Combiner Results Dialog Box, where you can choose to save or discard the results as explained in Interpreting Rule Combiner Results.
 
     [bookmark: pgfId-997894]Navigation Path
 
     [bookmark: pgfId-997902]You can combine rules from the AAA Rules Page and the Access Rules Page. Click Tools located at the bottom of the tables and select Combine Rules.
 
     [bookmark: pgfId-997904]Field Reference
 
     [bookmark: pgfId-997907]
 
      
       
        
        [bookmark: pgfId-995292]Table 12-4 [bookmark: 37784]Combine Rules Selection Summary Dialog Box 
 
        
       
         
         	
           
           [bookmark: pgfId-995298]Element
          
  
         	
           
           [bookmark: pgfId-995300]Description
          
  
        
 
         
         	[bookmark: pgfId-995306]Policy Selected
  
         	[bookmark: pgfId-995308]Shows the policy selected and the scope. Local indicates the local device rules. Otherwise, the field indicates the name of the shared policy and the scope selected within the policy, if any.
  
        
 
         
         	[bookmark: pgfId-995314]Rules to be combined
  
         	[bookmark: pgfId-995316]The rules you want the tool to consider combining:
 
           
           	 [bookmark: pgfId-995318]All Rules—Consider combining all rules within the selected policy.
 
           	 [bookmark: pgfId-995320]Selected Rules—Consider combining only those rules you selected in the policy before starting the tool.
 
          
 [bookmark: pgfId-995325]For detailed information on selecting rules before running the tool, see Combining Rules.
  
        
 
         
         	[bookmark: pgfId-995331]Choose which columns to combine
  
         	[bookmark: pgfId-995333]The columns in the rules table that can be combined. Any columns that you do not select must have the identical content for two rules to be combined (even those not listed as combinable, except for the Description column). The columns you can combine are:
 
           
           	 [bookmark: pgfId-995335]Source
 
           	 [bookmark: pgfId-995337]User
 
           	 [bookmark: pgfId-995339]Destination
 
           	 [bookmark: pgfId-995341]Service
 
           	 [bookmark: pgfId-995343]Interface
 
           	 [bookmark: pgfId-995345]Security Sources
 
           	 [bookmark: pgfId-995347]Security Destinations
 
           	 [bookmark: pgfId-995349]For AAA rules, these additional columns:
 
          
 [bookmark: pgfId-995351] – Action
 [bookmark: pgfId-995353] – Auth Proxy
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-997925][bookmark: 37839][bookmark: fwlsvcpg_cncpt_CombinedRulesResultsSummary]Interpreting Rule Combiner Results[bookmark: marker-997917][bookmark: marker-997919][bookmark: marker-997921][bookmark: marker-997923]
 
     [bookmark: pgfId-997930]Use the Rule Combiner Results dialog box to evaluate the results of a rule combination (see Combining Rules). The dialog box includes a summary of the results, and shows the new rules that will be created if you click OK.
 
     [bookmark: pgfId-997932]Changed rule cells are outlined in red. Select a combined rule in the upper table to see the rules in the lower table that were combined to create the rule.
 
     [bookmark: pgfId-997934]You can refine some elements of the results in this window:
 
      
      	 [bookmark: pgfId-997936]You can right-click on the Source, Destination, and Service cells with multiple elements and select  Create Network (or Service) Object from Cell Contents to create a new policy object that contains the contents of the combined cell. The new object replaces the contents of the cell.
 
     
 
     [bookmark: pgfId-997941]You can also automatically create network object groups in the deployed configuration to replace the comma-separated values in a rule table cell. The network objects are created during deployment, and they do not affect the content of your rules policy. To enable this option, select Tools > Security Manager Administration > Deployment to open the Deployment Page and select Create Object Groups for Multiple Sources, Destinations, or Services in a Rule.
 
      
      	 [bookmark: pgfId-997943]You can right-click on Description and select  Edit Description to change the description. The descriptions of combined rules are a concatenation of the descriptions of the old rules separated by new lines.
 
     
 
     [bookmark: pgfId-997948]For an example, see Example Rule Combiner Results.
 
     [bookmark: pgfId-997950]Tips
 
      
      	 [bookmark: pgfId-997952]The combined results are not applied to the policy until you click  OK . If you do not like the results of the combination, click  Cancel and consider selecting smaller groups of rules to limit the scope of the Combine Rules tool.
 
     
 
     [bookmark: pgfId-997954]If you click OK but then decide you do not want to accept the changes, you have two options. First, make sure you do not click Save on the policy page, select a different policy, and click No when prompted to save your changes to the policy. If you already clicked Save, you can still back out the changes by discarding your activity or configuration session (for example, File > Discard in non-Workflow mode), but this also discards any other changes you have made to other policies. Once you submit your changes or your activity is approved, you cannot undo your changes.
 
      
      	 [bookmark: pgfId-997956]You are allowed to run the Combine Rules tool even if you are combining rules for a policy that you are not allowed to save. For example, you cannot save combined rules for a shared or inherited policy in Device view. You are warned before running the tool if you will not be allowed to save the results.
 
      	 [bookmark: pgfId-997961]Rules from different sections are never combined. Any sections you create to organize rules limit the scope of the possible combinations. Also, interface-specific and global access rules are never combined. For more information about global rules, see Understanding Global Access Rules.
 
     
 
     [bookmark: pgfId-997963]Navigation Path
 
     [bookmark: pgfId-997974]You can combine rules from the AAA Rules Page and the Access Rules Page. Click Tools located at the bottom of the tables and select Combine Rules, fill in the Combine Rules Selection Summary Dialog Box and click OK.
 
     [bookmark: pgfId-997976]Field Reference
 
     [bookmark: pgfId-997979]
 
      
       
        
        [bookmark: pgfId-995366]Table 12-5 [bookmark: 37906]Combined Rules Results Summary 
 
        
       
         
         	
           
           [bookmark: pgfId-995372]Element
          
  
         	
           
           [bookmark: pgfId-995374]Description
          
  
        
 
         
         	[bookmark: pgfId-995380]Result Summary
  
         	[bookmark: pgfId-995382]Provides a summary of the results of the combination and indicates the number of original rules, the number of rules remaining after the combination, and the number of changed and unchanged rules, if any combinations could be made.
  
        
 
         
         	[bookmark: pgfId-995388]Resulting Rules table
  
         	[bookmark: pgfId-995396]The rules that will replace the rules currently in the policy. If you click OK, these rules become part of your policy. The columns are the same as those in the associated policy (see AAA Rules Page or Access Rules Page), with the addition of the Rule State column.
 [bookmark: pgfId-995398]The Rule State column shows the status of the rule:
 
           
           	 [bookmark: pgfId-995400]Modified, Combined—The new rule is the result of combining one or more rules or modifying an existing rule. A red box around a cell indicates cells that have combined contents.
 
           	 [bookmark: pgfId-995402]Unchanged—The rule remains unchanged, as it could not be combined with any other rule.
 
           	 [bookmark: pgfId-995404]Not Selected—You did not select the rule for possible combination.
 
          
 [bookmark: pgfId-995406]If there are a large number of rules, you can use the buttons beneath the table to scroll through the rules that have changes. Unchanged and unselected rules are skipped.
  
        
 
         
         	[bookmark: pgfId-995412]Original rules table (lower table)
  
         	[bookmark: pgfId-995414]The table in the lower half of the dialog box shows the original rules that were combined to create the rule you select in the upper table.
  
        
 
         
         	[bookmark: pgfId-995420]Detail Report button
  
         	[bookmark: pgfId-995422]Click this button to create an HTML report of the results. The report summarizes the results and also provides the details about the resulting rules and the rules that were combined to create the new rule.
 [bookmark: pgfId-995424]For combined rules that have a lot of entries in cells, this report makes it easier to read the results. You can also print or save the report for later use.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-997991][bookmark: 37950][bookmark: porules_cncpt_UnderstandingCombinedRulesSummaryResults]Example Rule Combiner Results[bookmark: marker-997985][bookmark: marker-997987][bookmark: marker-997989]
 
     [bookmark: pgfId-997999]When you run the Combine Rules tool as described in Combining Rules, the results of the combination are displayed in the Rule Combiner Results Dialog Box (see Interpreting Rule Combiner Results).
 
     [bookmark: pgfId-998004]Figure 12-3 shows an example of a rule combination.
 
     [bookmark: pgfId-998006]The new rules are shown in the upper table. Any new rules are indicated as modified or combined rules, and the changed cells are outlined in red. When you select a new rule in the upper table, the lower table shows the old rules that were combined to create the new rule. In this example, the two old rules had the same destination, service, and interface, and the two distinct sources were concatenated to form the new rule.
 
     [bookmark: pgfId-998008]The top of the report summarizes the results. In this example, 5700 rules were reduced to 96 rules.
 
     [bookmark: pgfId-998012]Figure 12-3 [bookmark: 37971]Example of Rule Combiner Results
 
     [bookmark: pgfId-998016]
 
      
      [image: ] 
     
 
      
       
       
         
         	
           
           [bookmark: pgfId-995435]1
          
  
         	[bookmark: pgfId-995437]Combined cell
  
         	
           
           [bookmark: pgfId-995439]3
          
  
         	[bookmark: pgfId-995441]Original rules
  
        
 
         
         	
           
           [bookmark: pgfId-995451]2
          
  
         	[bookmark: pgfId-995453]Newly combined rule
  
         	[bookmark: pgfId-995455] 
  
         	[bookmark: pgfId-995457] 
  
        
 
       
      
 
     
 
     [bookmark: pgfId-998018]Related Topics
 
      
      	 [bookmark: pgfId-998023]Chapter 15, “Managing Firewall AAA Rules”
 
      	 [bookmark: pgfId-998028]Chapter 16, “Managing Firewall Access Rules”
 
     
 
    
 
     
      [bookmark: pgfId-998046][bookmark: 38014][bookmark: porules_proc_ConvertingIPv4Rules]Converting IPv4 Rules to Unified Rules [bookmark: marker-998036][bookmark: marker-998038][bookmark: marker-998040][bookmark: marker-998042][bookmark: marker-998044]
 
     [bookmark: pgfId-998048]Prior to the release of Security Manager 4.4 and versions 9.0 and higher of the ASA, separate pages, policies and policy objects were provided for configuring IPv4 and IPv6 firewall rules and policies. With Security Manager 4.4 and ASA 9.0+, these policies and policy objects were combined or unified. However, for the earlier ASA versions, a separate page for IPv6 access rules is still provided in Device view, while in Policy view, IPv4 and unified versions of the AAA-, access- and inspection-rule policy types are provided.
 
     [bookmark: pgfId-998050]A utility to convert separate IPv4 and IPv6 firewall rules to “unified” rules is provided with Security Manager 4.4 for use when you upgrade an ASA from an earlier version to 9.0 or later.
 
     [bookmark: pgfId-998052]Navigation Path
 
     [bookmark: pgfId-998054]To access the firewall-rule unification utility:
 
      
      	 [bookmark: pgfId-998056](Policy view) Select the firewall IPv4 rule type from the Policy Type selector and then right-click the desired policy in the Policies pane; choose  Convert to <  rule-type > Rules (Unified).
 
     
 
     [bookmark: pgfId-998058]Related Topics
 
      
      	 [bookmark: pgfId-998063]AAA Rules Page
 
      	 [bookmark: pgfId-998068]Access Rules Page
 
      	 [bookmark: pgfId-998073]Inspection Rules Page
 
     
 
     
 
     [bookmark: pgfId-998075]Step 1 Open the utility as described above; in the Convert Policy dialog box, provide a name for the new unified policy and click OK.
 
     [bookmark: pgfId-998077]Following processing, the new unified rules policy is displayed. You can now assign this policy to ASA 9.0+ devices.
 
     [bookmark: pgfId-998079]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-998091][bookmark: 38062][bookmark: porules_proc_GeneratingPolicyQueryReports]Generating Policy Query Reports[bookmark: marker-998085][bookmark: marker-998087][bookmark: marker-998089]
 
     [bookmark: pgfId-998093]For most of the firewall rules policies, you can generate policy query reports that can help you evaluate your rules. With policy query reports, you can determine what rules already exist for a particular source, user, destination, interface, service, or zone before creating new rules to apply to those items.
 
     [bookmark: pgfId-998095]To a limited degree, you can also determine if there are some blocking rules that prevent a rule from being used, or redundant rules that you can delete. If you are evaluating access rules, however, it is better to use the more powerful rule analysis tool to determine these problems.
 
     [bookmark: pgfId-998097]When you create a policy query, you describe the traffic that interests you, much the same way you describe traffic when creating a rule. Creating a query is essentially the same as creating a rule, but you might want to describe the rule more broadly to capture a wider set of traffic so you can see a set of related rules rather than a single rule or a limited number of rules. The query you create depends on the information you are trying to discover.
 
     [bookmark: pgfId-998099]The possible extent of a query depends on the view you are in:
 
      
      	 [bookmark: pgfId-998101]Device or Map view—The query is limited to the selected device. However, you can query across all supported rule types. This allows you to compare different types of rules that apply to the same traffic.
 
      	 [bookmark: pgfId-998103]Policy view—The query is limited to the selected policy. You see only rules that are defined in that policy, and you cannot query other types of policies. If you want to query a shared policy while examining other policies, select a device that is assigned to the shared policy, and query the policy from the device in Device view.
 
     
 
     [bookmark: pgfId-998105]Related Topics
 
      
      	 [bookmark: pgfId-998110]AAA Rules Page
 
      	 [bookmark: pgfId-998115]Access Rules Page
 
      	 [bookmark: pgfId-998120]Inspection Rules Page
 
      	 [bookmark: pgfId-998125]Web Filter Rules Page (ASA/PIX/FWSM)
 
      	 [bookmark: pgfId-998130]Zone-based Firewall Rules Page
 
     
 
     
 
     [bookmark: pgfId-998132]Step 1 Select the policy that you want to query from the Firewall folder. You can query any of the following types of policy:
 
      
      	 [bookmark: pgfId-998134]AAA Rules
 
      	 [bookmark: pgfId-998136]Access Rules
 
      	 [bookmark: pgfId-998138]Inspection Rules
 
      	 [bookmark: pgfId-998140]Web Filter Rules (PIX/ASA/FWSM)
 
      	 [bookmark: pgfId-998142]Zone Based Rules
 
     
 
     [bookmark: pgfId-998144]Step 2 Click the Query button located below the table to open the Querying Device or Policy dialog box.
 
     [bookmark: pgfId-998149]Step 3 Enter the parameters that define the rules you want to query. When setting up your query, you must select at least one rule type; enabled, disabled or both; permitted, denied, or both; and mandatory, default, or both. For detailed information about the query parameters, see Querying Device or Policy Dialog Box.
 
     [bookmark: pgfId-998151]In Policy view, you cannot change the type of rule you are querying. In Device view, you can query any combination of rule types.
 
     [bookmark: pgfId-998156]Step 4 Click OK to view the rules that match the criteria in the Policy Query Results dialog box. For information on reading the report, see Interpreting Policy Query Results.
 
     [bookmark: pgfId-998161]For an example of a policy query report, see Example Policy Query Result.
 
     [bookmark: pgfId-998163]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-998175][bookmark: 38131][bookmark: fwlsvcpg_cncpt_PolicyQueryPage]Querying Device or Policy Dialog Box [bookmark: marker-998171][bookmark: marker-998173]
 
     [bookmark: pgfId-998177]Use the Querying Device or Querying Policy dialog box to set up the parameters for a query. The query results show the rules that match your parameters. The title of the dialog box indicates what you are querying:
 
      
      	 [bookmark: pgfId-998179]In Device or Map view, you are querying rules defined for the selected device.
 
      	 [bookmark: pgfId-998181]In Policy view, you are querying rules within the selected policy only.
 
     
 
     [bookmark: pgfId-998183]You can query rules from these types of policies: AAA rules, access rules, inspection rules, web filter rules for ASA/PIX/FWSM, and zone based firewall rules.
 
     [bookmark: pgfId-998185]When setting up your query, you must select at least one rule type; enabled, disabled or both; permitted, denied, or both; and mandatory, default, or both.
 
      
       
     
 
     
 
     [bookmark: pgfId-998187]Note For inspection rules, if you enter Global as the interface value, the match status results will be shown as a partial match even if the match is complete.

     
      

     

     
 
     [bookmark: pgfId-998192]Results are displayed in the Policy Query Results dialog box (see Interpreting Policy Query Results).
 
     [bookmark: pgfId-998194]Navigation Path
 
     [bookmark: pgfId-998196]To generate Policy Query reports, do one of the following:
 
      
      	 [bookmark: pgfId-998198](Device view) Select a device, then select one of the supported firewall rules policies from the Firewall folder, and then click the  Query button located below the table.
 
      	 [bookmark: pgfId-998200](Policy view) Select any of the supported firewall rules policies from the Firewall folder, then select a specific policy from the Shared Policy selector, and then click the  Query button located below the table.
 
      	 [bookmark: pgfId-998202](Map view) Right-click a device and select a supported firewall rules policy from the Edit Firewall Policies menu. Click the  Query button.
 
     
 
     [bookmark: pgfId-998204]Related Topics
 
      
      	 [bookmark: pgfId-998209]Generating Policy Query Reports
 
      	 [bookmark: pgfId-998214]Example Policy Query Result
 
     
 
     [bookmark: pgfId-998216]Field Reference
 
     [bookmark: pgfId-998219]
 
      
       
        
        [bookmark: pgfId-995470]Table 12-6 [bookmark: 38176]Querying Device or Policy Dialog Box 
 
        
       
         
         	
           
           [bookmark: pgfId-995476]Element
          
  
         	
           
           [bookmark: pgfId-995478]Description
          
  
        
 
         
         	[bookmark: pgfId-995484]Rule Types
  
         	[bookmark: pgfId-995486]The type of rules you want to query. When querying in Policy view, you cannot change the selection. When querying in Device view, you can select any of the following types of rules; the scope of the query is limited to the selected device:
 
           
           	 [bookmark: pgfId-995488]AAA Rules
 
           	 [bookmark: pgfId-995490]Access Rules
 
           	 [bookmark: pgfId-995492]Inspection Rules
 
           	 [bookmark: pgfId-995494]Web Filter Rules
 
           	 [bookmark: pgfId-995496]Zone Based Rules
 
          
  
        
 
         
         	[bookmark: pgfId-995502]Enabled and/or Disabled Rules
  
         	[bookmark: pgfId-995504]Whether you want to query enabled or disabled rules, or both.
  
        
 
         
         	[bookmark: pgfId-995510]Mandatory and/or Default Rules
  
         	[bookmark: pgfId-995512]Whether you want to query rules that are in the mandatory or default sections, or both.
  
        
 
         
         	[bookmark: pgfId-995518]Match
  
         	[bookmark: pgfId-995520]Whether you want to query rules that permit or deny traffic, or both.
  
        
 
         
         	[bookmark: pgfId-995526]Sources
 [bookmark: pgfId-995528]Destinations
  
         	[bookmark: pgfId-995530]The source or destination of the traffic. You can enter more than one value by separating the items with commas.
 [bookmark: pgfId-995532]Note If you leave a field blank, the query matches any address for that field.
 [bookmark: pgfId-995537]You can enter any combination of the following address types to define the source or destination of the traffic. For more information, see Specifying IP Addresses During Policy Definition.
 
           
           	 [bookmark: pgfId-995539]Network/host object. Enter the name of the object or click  Select to select it from a list. You can also create new network/host objects from the selection list.
 
           	 [bookmark: pgfId-995541]Host IP address, for example, 10.10.10.100.
 
           	 [bookmark: pgfId-995543]Network address, including subnet mask, in either the format 10.10.10.0/24 or 10.10.10.0/255.255.255.0.
 
           	 [bookmark: pgfId-995545]A range of IP addresses, for example, 10.10.10.100-10.10.10.200.
 
           	 [bookmark: pgfId-995550]An IP address pattern in the format 10.10.0.10/255.255.0.255, where the mask is a discontiguous bit mask (see Contiguous and Discontiguous Network Masks for IPv4 Addresses).
 
          
 [bookmark: pgfId-995552]Tip You can create an object with a list of the IP addresses to facilitate future policy query requests.  
        
 
         
         	[bookmark: pgfId-995558]User
  
         	[bookmark: pgfId-995560](ASA 8.4(2+) only.) The Active Directory (AD) usernames, user groups, or identity user group objects for the rule, if any. You can enter more than one value by separating the items with commas.
 [bookmark: pgfId-995562]Note If you leave a field blank, the query matches only those rules that have nothing in the User field.
 [bookmark: pgfId-995564]You can enter any combination of the following values.
 
           
           	 [bookmark: pgfId-995566]Individual user names: NetBIOS_DOMAIN\username
 
           	 [bookmark: pgfId-995568]User groups (note the double \): NetBIOS_DOMAIN\\user_group
 
           	 [bookmark: pgfId-995570]Identity user group object names.
 
          
 [bookmark: pgfId-995572]Click Select to select objects, users, or user groups from a list or to create new objects.
 [bookmark: pgfId-995574]For more information, see:
 
           
           	 [bookmark: pgfId-995579]Selecting Identity Users in Policies
 
           	 [bookmark: pgfId-995584]Configuring Identity-Based Firewall Rules
 
           	 [bookmark: pgfId-995589]Creating Identity User Group Objects
 
          
  
        
 
         
         	[bookmark: pgfId-995595]Services
  
         	[bookmark: pgfId-995597]The services that define the type of traffic that is acted on. You can enter more than one value by separating the items with commas.
 [bookmark: pgfId-995599]Note If you leave the field blank, the query matches any service.
 [bookmark: pgfId-995601]You can enter any combination of service objects and service types (which are typically a protocol and port combination). If you type in a service, you are prompted as you type with valid values. You can select a value from the list and press Enter or Tab.
 [bookmark: pgfId-995606]For complete information on how to specify services, see Understanding and Specifying Services and Service and Port List Objects.
 [bookmark: pgfId-995608]Tip You can create an object with a list of the services to facilitate future policy query requests.  
        
 
         
         	[bookmark: pgfId-995614]Interfaces
  
         	[bookmark: pgfId-995616]The interfaces for which the rule is defined. You can enter any combination of interface or interface role names, separated by commas. Enter the name or click Select to select the interface or interface role.
 [bookmark: pgfId-995618]Note If you leave the field blank, the query matches any interface or interface role.
  
        
 
         
         	[bookmark: pgfId-995624]Query for Global Rules
  
         	[bookmark: pgfId-995626]Whether the query should also consider global rules when querying access rules or inspection rules.
  
        
 
         
         	[bookmark: pgfId-995632]From Zone
 [bookmark: pgfId-995634]To Zone
  
         	[bookmark: pgfId-995636]For zone based firewall rules, the zones defined for the rule. Enter the zone names (which are interface roles), or click Select to select them from a list.
  
        
 
         
         	[bookmark: pgfId-995642]Actions
  
         	[bookmark: pgfId-995644]For zone based firewall rules, the actions defined for the rule.
  
        
 
         
         	[bookmark: pgfId-995650]Check if Matching Rules Are Shadowed by Rules Above
  
         	[bookmark: pgfId-995652]Whether to have the policy query results include rule conflict detection information. Selecting this option might have an impact on performance and cost results.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-998235][bookmark: 38307][bookmark: fwlsvcpg_cncpt_PolicyQueryResultsPage]Interpreting Policy Query Results[bookmark: marker-998227][bookmark: marker-998229][bookmark: marker-998231][bookmark: marker-998233]
 
     [bookmark: pgfId-998246]Use the Policy Query Results dialog box to view the results of a policy query that you defined on the Query Device or Policy dialog box. The results report opens after you define your query parameters on the Querying Device or Policy Dialog Box and click OK. For the procedure, see Generating Policy Query Reports. To see an example report, see Example Policy Query Result.
 
      
       
     
 
     
 
     [bookmark: pgfId-998248]Tip In the query results table, you can double-click a row, or right-click and select Go to Rule, to select the rule in the rules policy page, where you can edit the rule. If the appropriate rules policy is not already selected in the policy selector, you might have to do this twice to actually select the rule.

     
      

     

     
 
     [bookmark: pgfId-998250]To read the report, consider the following report sections:
 
      
      	 [bookmark: pgfId-998255] Query Parameters —The top portion of the report specifies the parameters you entered for the query. If you want to change them, click  Edit Query to open the Querying Device or Policy Dialog Box, where you can make your changes and regenerate the report.
 
      	 [bookmark: pgfId-998257] Results Table —This table lists all rules that match your query. If you queried more than one type of rule, select the rule type you want to examine in the  Display field. The columns in the table are the same as those for that type of rule, except for the following:
 
     
 
     [bookmark: pgfId-998259] – Match Status—Indicates how the rule matches your query:
 
     [bookmark: pgfId-998261]Complete Match—The rule matches all query parameters.
 
     [bookmark: pgfId-998263]Partial Match—All of the search criteria overlap or are a superset of the matched rule. For example, if you have a rule defined with a source address of 10.100.20.0/24, a destination address of 10.200.100.0/24 and a service of IP, and your query is to search for a source of 10.100.20.0/24, the match status is shown as a partial match because the query results represent only a portion of the rule’s definition.
 
     [bookmark: pgfId-998265]No Effect—Rules are blocked by other matching rules, or a conflict exists that has no effect. For example, you might have two matching rules, A and B. If rule A’s source address, destination address, and services are equivalent to, or contain, those of rule B, rule B is blocked by rule A. Thus, rule B will have no effect on traffic.
 
     [bookmark: pgfId-998267]In another example, you might have a global mandatory rule that permits a service, but a rule at the device (local) level denies the service. Because rules are recognized on a first-match basis, after discovering a match at the mandatory global scope, no other rules are checked. The local rule has no effect; the service is permitted, not denied. You should edit your policies to ensure you get the desired results.
 
     [bookmark: pgfId-998269] – Scope—Identifies whether a rule is shared or local, mandatory or default.
 
      
      	 [bookmark: pgfId-998271] Details Table —The details table shows the detailed query match information for the rule selected in the results table. The folders on the left represent the attributes for which you can see detailed information. Select a folder to view the details.
 
     
 
     [bookmark: pgfId-998273]The details show the query value, which is the parameter you defined, and the item in the rule that matches the parameter. The matching relationship is one of the following:
 
     [bookmark: pgfId-998275] – Identical—The parameter is identical to the value in the rule.
 
     [bookmark: pgfId-998277] – Contains—The parameter is a superset that contains the value in the rule. For example, the query parameter might have been a network/host object, and the rule used an IP address that was part of the object definition.
 
     [bookmark: pgfId-998279] – Is contained by—The parameter is a subset nested within the value of the rule.
 
     [bookmark: pgfId-998281] – Overlaps—The query parameter shows results that overlap between more than one policy object used in the rule. For example, the service query parameter was tcp/70-90 and the results show a service defined as tcp/80-100.
 
     [bookmark: pgfId-998283]Related Topics
 
      
      	 [bookmark: pgfId-998288]AAA Rules Page
 
      	 [bookmark: pgfId-998293]Access Rules Page
 
      	 [bookmark: pgfId-998298]Inspection Rules Page
 
      	 [bookmark: pgfId-998303]Web Filter Rules Page (ASA/PIX/FWSM)
 
      	 [bookmark: pgfId-998308]Zone-based Firewall Rules Page
 
     
 
    
 
     
      [bookmark: pgfId-998320][bookmark: 38385][bookmark: porules_cncpt_UnderstandingPolicyQueryResults]Example Policy Query Result[bookmark: marker-998314][bookmark: marker-998316][bookmark: marker-998318]
 
     [bookmark: pgfId-998325]Figure 12-4 shows an example of a policy query report on access rules. The criteria does not limit source, destination, service, and interface parameters, but limits the query to enabled rules. Both shared and local rules are included.
 
     [bookmark: pgfId-998327]The Query Parameters section shows the query criteria for the report. In this example, the first row in the results table is selected, and the detailed information for that rule is shown in the details table in the bottom half of the window. In this example, the source folder is selected in the details table, and the result shows that the rule value, any, is an identical match to the query parameter *, which is equivalent to any source address.
 
     [bookmark: pgfId-998332]For detailed information on reading the report, see Interpreting Policy Query Results.
 
     [bookmark: pgfId-998336]Figure 12-4 [bookmark: 38404]Policy Query Results
 
     [bookmark: pgfId-998339]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-998341]Related Topics
 
      
      	 [bookmark: pgfId-998346]Generating Policy Query Reports
 
      	 [bookmark: pgfId-998351]AAA Rules Page
 
      	 [bookmark: pgfId-998356]Access Rules Page
 
      	 [bookmark: pgfId-998361]Inspection Rules Page
 
      	 [bookmark: pgfId-998366]Web Filter Rules Page (ASA/PIX/FWSM)
 
      	 [bookmark: pgfId-998371]Zone-based Firewall Rules Page
 
     
 
    
 
     
      [bookmark: pgfId-998385][bookmark: 38430][bookmark: porules_cncpt_OptimizingPolicyObjectsinRules]Optimizing Network Object Groups When Deploying Firewall Rules [bookmark: marker-998377][bookmark: marker-998379][bookmark: marker-998381][bookmark: marker-998383]
 
     [bookmark: pgfId-998387]When you deploy firewall rules policies to an ASA, PIX, FWSM, or IOS 12.4(20)T+ device, you can configure Security Manager to evaluate and optimize the network/host policy objects that you use in the rules when it creates the associated network object groups on the device. Optimization merges adjacent networks and removes redundant network entries. This reduces the runtime access list data structures and the size of the configuration, which can be beneficial to some FWSM and PIX devices that are memory-constrained.
 
     [bookmark: pgfId-998389]For example, consider a network/host object named test that contains the following entries and that is used in an access rule:
 
     
      [bookmark: pgfId-998391]192.168.1.0/24
     

     
      [bookmark: pgfId-998393]192.168.1.23
     

     
      [bookmark: pgfId-998395]10.1.1.0
     

     
      [bookmark: pgfId-998397]10.1.1.1
     

     
      [bookmark: pgfId-998399]10.1.1.2/31
     

     
      [bookmark: pgfId-998401]
     

     
      [bookmark: pgfId-998403]
     

     [bookmark: pgfId-998405]If you enable optimization, when you deploy the policy, the resulting object group configuration is generated. Note that the description indicates the group was optimized:
 
     
      [bookmark: pgfId-998407]object-group network test
     

     
      [bookmark: pgfId-998409] description (Optimized by CS-Manager)
     

     
      [bookmark: pgfId-998411] network-object 10.1.1.0 255.255.255.252
     

     
      [bookmark: pgfId-998413] network-object 192.168.1.0 255.255.255.0
     

     
      [bookmark: pgfId-998415]
     

     
      [bookmark: pgfId-998417]
     

     [bookmark: pgfId-998419]If you do not enable optimization, the group configuration would be as follows:
 
     
      [bookmark: pgfId-998421]object-group network test
     

     
      [bookmark: pgfId-998423] network-object 192.168.1.0 255.255.255.0
     

     
      [bookmark: pgfId-998425] network-object 192.168.1.23 255.255.255.255
     

     
      [bookmark: pgfId-998427] network-object 10.1.1.0 255.255.255.255
     

     
      [bookmark: pgfId-998429] network-object 10.1.1.1 255.255.255.255
     

     
      [bookmark: pgfId-998431] network-object 10.1.1.2 255.255.255.254
     

     
      [bookmark: pgfId-998433]
     

     
      [bookmark: pgfId-998435]
     

     [bookmark: pgfId-998437]This optimization does not change the definition of the network/host object, nor does it create a new network/host policy object. If you rediscover policies on the device, the existing unchanged policy object is used.
 
      
       
     
 
     
 
     [bookmark: pgfId-998439]Note If a network/host object contains another network/host object, the objects are not combined. Instead, each network/host object is optimized separately. Also, Security Manager cannot optimize network/host objects that use discontiguous subnet masks.

     
      

     

     
 
     [bookmark: pgfId-998444]To configure optimization, select the Optimize Network Object-Groups During Deployment option on the Deployment Page (select Tools > Security Manager Administration and select Deployment from the table of contents). The default is to not optimize network object groups during deployment.
 
    
 
     
      [bookmark: pgfId-998452][bookmark: 38477][bookmark: porules_cncpt_ExpandingObjectGroupsDuringDiscovery]Expanding Object Groups During Discovery[bookmark: marker-998450]
 
     [bookmark: pgfId-998454]When you discover policies from a device that uses object groups, you can elect to have those object groups expanded into the items they contain rather than create policy objects from the group.
 
     [bookmark: pgfId-998456]For example, if an object group named CSM_INLINE_55 contains the hosts 10.100.10.15, 10.100.10.18, and 10.100.10.25, importing an access control list by expanding the objects will create a rule that includes all three addresses in the source (or destination, as appropriate) cell rather than a network/host policy object named CSM_INLINE_55.
 
     [bookmark: pgfId-998461]To configure expansion, you must have a naming scheme for your object groups that allows you to identify the prefix of groups that you want to expand. The default is to expand any object group that starts with the prefix CSM_INLINE. Configure these prefixes in the Auto-Expand Object Groups with These Prefixes field on the Discovery Page by selecting Tools > Security Manager Administration and selecting Discovery from the table of contents.
 
    
 
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-490022][bookmark: 64075][bookmark: vpchap_cncpt_ManagingSitetoSiteVPNs]Managing Site-to-Site VPNs: The Basics[bookmark: marker-490018][bookmark: marker-490020]
      
      
 
     
 
 
    [bookmark: pgfId-490024]A virtual private network (VPN) consists of multiple remote peers transmitting private data securely to one another over an unsecured network, such as the Internet. Site-to-site VPNs use tunnels to encapsulate data packets within normal IP packets for forwarding over IP-based networks, using encryption to ensure privacy and authentication to ensure integrity of data.
 
    [bookmark: pgfId-490026]In Cisco Security Manager, site-to-site VPNs are implemented based on IPsec policies that are assigned to VPN topologies. An IPsec policy is a set of parameters that define the characteristics of the site-to-site VPN, such as the security protocols and algorithms that will be used to secure traffic in an IPsec tunnel. Security Manager translates IPsec policies into CLI commands that can be deployed to the devices in the VPN topology. Several policy types might be required to define a full configuration image that can be assigned to a VPN topology, depending on the IPsec technology type.
 
    [bookmark: pgfId-490028]The Site-to-Site VPN Manager defines and configures site-to-site VPN topologies and policies on Cisco IOS security routers, PIX Firewalls, Catalyst VPN Service Modules, and Adaptive Security Appliance (ASA) firewall devices.
 
     
      
    
 
    
 
    [bookmark: pgfId-490030]Tip In ASA documentation, site-to-site VPNs are called LAN-to-LAN VPNs. These phrases are equivalent, and we use “site-to-site VPN” in this documentation.

    
     

    

    
 
    [bookmark: pgfId-490032]You can access the Site-to-Site VPN Manager by selecting Manage > Site-To-Site VPNs or clicking the Site-To-Site VPN Manager button on the toolbar.
 
    [bookmark: pgfId-490034]You can also configure shared policies in Policy view and view and configure topologies in Device view. In Policy View, you can assign IPsec policies to VPN topologies.
 
    [bookmark: pgfId-490036]This chapter contains the following topics:
 
     
     	 [bookmark: pgfId-490041]Understanding VPN Topologies
 
     	 [bookmark: pgfId-490046]Understanding IPsec Technologies and Policies
 
     	 [bookmark: pgfId-490051]Accessing Site-to-Site VPN Topologies and Policies
 
     	 [bookmark: pgfId-490056]Site-To-Site VPN Discovery
 
     	 [bookmark: pgfId-490061]Creating or Editing VPN Topologies
 
     	 [bookmark: pgfId-490066]Creating or Editing Extranet VPNs
 
     	 [bookmark: pgfId-490071]Deleting a VPN Topology
 
    
 
   
 
    
     [bookmark: pgfId-490081][bookmark: 64091][bookmark: vpchap_cncpt_UnderstandingVPNTopologies]Understanding VPN Topologies[bookmark: marker-490077][bookmark: marker-490079]
 
    [bookmark: pgfId-490083]A VPN topology specifies the peers and the networks that are part of the VPN and how they connect to one another. After you create a VPN topology, the policies that can be applied to your VPN topology become available for configuration, depending on the assigned IPsec technology.
 
    [bookmark: pgfId-490085]Security Manager supports three main types of topologies—hub and spoke, point to point, and full mesh, with which you can create a site-to-site VPN. Not all policies can be applied to all VPN topologies. The policies that can be applied depend on the IPsec technology that is assigned to the VPN topology. In addition, the IPsec technology that is assigned to a VPN depends on the topology type. For example, the DMVPN and Easy VPN technologies can only be applied in a hub-and-spoke topology.
 
    [bookmark: pgfId-490090]For more information, see Understanding IPsec Technologies and Policies.
 
    [bookmark: pgfId-490092]The following topics describe:
 
     
     	 [bookmark: pgfId-490097]Hub-and-Spoke VPN Topologies
 
     	 [bookmark: pgfId-490102]Point-to-Point VPN Topologies
 
     	 [bookmark: pgfId-490107]Full Mesh VPN Topologies
 
     	 [bookmark: pgfId-490112]Implicitly Supported Topologies
 
    
 
     
      [bookmark: pgfId-490122][bookmark: 64117][bookmark: vpchap_cncpt_HubandSpokeVPNTopologies]Hub-and-Spoke VPN Topologies [bookmark: marker-490118][bookmark: marker-490120]
 
     [bookmark: pgfId-490124]In a hub-and-spoke VPN topology, multiple remote devices (spokes) communicate securely with a central device (hub). A separate, secured tunnel extends between the hub and each individual spoke.
 
     [bookmark: pgfId-490126]The following illustration shows a typical hub-and-spoke VPN topology.
 
     [bookmark: pgfId-490130]Figure 25-1 [bookmark: 64127]Hub-and-Spoke VPN Topology
 
     [bookmark: pgfId-490133]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-490135]This topology usually represents an intranet VPN that connects an enterprise’s main office with branch offices using persistent connections to a third-party network or the Internet. VPNs in a hub-and-spoke topology provide all employees with full access to the enterprise network, regardless of the size, number, or location of its remote operations.
 
     [bookmark: pgfId-490137]A hub is generally located at an enterprise’s main office. Spoke devices are generally located at an enterprise’s branch offices. In a hub-and-spoke topology, most traffic is initiated by hosts at the spoke site, but some traffic might be initiated from the central site to the spokes.
 
     [bookmark: pgfId-490139]If the hub in a hub-and-spoke configuration becomes unavailable for any reason, IPsec failover transfers tunnel connections seamlessly to a failover (backup) hub, which is used by all spokes. You can configure multiple failover hubs for a single primary hub.
 
     [bookmark: pgfId-490141]In a hub-and-spoke VPN topology, all IPsec technology types can be assigned except GET VPN.
 
     [bookmark: pgfId-490143]Related Topics
 
      
      	 [bookmark: pgfId-490148]Understanding IPsec Technologies and Policies
 
      	 [bookmark: pgfId-490153]Implicitly Supported Topologies
 
      	 [bookmark: pgfId-490158]Creating or Editing VPN Topologies
 
      	 [bookmark: pgfId-490163]Chapter 26, “Configuring IKE and IPsec Policies”
 
     
 
    
 
     
      [bookmark: pgfId-490173][bookmark: 64150][bookmark: vpchap_cncpt_PointtoPointVPNTopologies]Point-to-Point VPN Topologies[bookmark: marker-490169][bookmark: marker-490171]
 
     [bookmark: pgfId-490175]In a point-to-point VPN topology, two devices communicate directly with each other, without the option of IPsec failover as in a hub-and-spoke configuration. To establish a point-to-point VPN topology, you specify two endpoints as peer devices. Because either of the two devices can initiate the connection, the assigned IPsec technology type can be only regular IPsec or IPsec/GRE.
 
     [bookmark: pgfId-490177]In Security Manager, you can configure a special type of regular IPsec point-to-point VPN called an Extranet. An Extranet VPN is a connection between a device in your managed network and an unmanaged device, such as a router in your service provider’s network, a non-Cisco device, or simply a device in your network that is being managed by a different group (that is, one that does not appear in the Security Manager inventory).
 
     [bookmark: pgfId-490179]The following illustration shows a typical point-to-point VPN topology.
 
     [bookmark: pgfId-490183]Figure 25-2 [bookmark: 64161]Point-to-Point VPN Topology
 
     [bookmark: pgfId-490186]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-490188]Related Topics
 
      
      	 [bookmark: pgfId-490193]Understanding IPsec Technologies and Policies
 
      	 [bookmark: pgfId-490198]Implicitly Supported Topologies
 
      	 [bookmark: pgfId-490203]Creating or Editing VPN Topologies
 
      	 [bookmark: pgfId-490208]Creating or Editing Extranet VPNs
 
      	 [bookmark: pgfId-490213]Chapter 26, “Configuring IKE and IPsec Policies”
 
     
 
    
 
     
      [bookmark: pgfId-490223][bookmark: 64183][bookmark: vpchap_cncpt_FullMeshVPNTopologies]Full Mesh VPN Topologies[bookmark: marker-490219][bookmark: marker-490221]
 
     [bookmark: pgfId-490225]A full mesh topology works well in a complicated network where all peers need to communicate with each other. In this topology type, every device in the network communicates with every other device through a unique IPsec tunnel. All devices have direct peer relationships with one another, preventing a bottleneck at the VPN gateway device, and saving the overhead of encryption and decryption on the device.
 
     [bookmark: pgfId-490227]You can assign only Regular IPsec, IPsec/GRE, and GET VPN technologies to a full mesh VPN topology.
 
     [bookmark: pgfId-490229]The following illustration shows a typical full mesh VPN topology.
 
     [bookmark: pgfId-490233]Figure 25-3 [bookmark: 64194]Full Mesh VPN Topology
 
     [bookmark: pgfId-490236]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-490238]A full mesh network is reliable and offers redundancy. When the assigned technology is GRE and one device (or node) can no longer operate, all the rest can still communicate with one another, directly or through one or more intermediate nodes. With regular IPsec, if one device can no longer operate, a crypto access control list (ACL) that specifies the protected networks, is created per two peers.
 
     [bookmark: pgfId-490240]GET VPN is based on the group trust model. In this model, group members register with a key server. The key server uses the Group Domain of Interpretation (GDOI) protocol for distributing the security policy and keys for encrypting traffic between the group members. Because you can configure a primary key server and secondary key servers that synchronize their policies with the primary one, if the primary key server becomes unavailable, a secondary key server can take over.
 
      
       
     
 
     
 
     [bookmark: pgfId-490242]Note When the number of nodes in a full mesh topology increases, scalability may become an issue—the limiting factor being the number of tunnels that the devices can support at a reasonable CPU utilization.

     
      

     

     
 
     [bookmark: pgfId-490244]Related Topics
 
      
      	 [bookmark: pgfId-490249]Understanding IPsec Technologies and Policies
 
      	 [bookmark: pgfId-490254]Implicitly Supported Topologies
 
      	 [bookmark: pgfId-490259]Creating or Editing VPN Topologies
 
      	 [bookmark: pgfId-490264]Chapter 26, “Configuring IKE and IPsec Policies”
 
     
 
    
 
     
      [bookmark: pgfId-490288][bookmark: 64216][bookmark: vpchap_cncpt_ImplicitlySupportedTopologies]Implicitly Supported Topologies[bookmark: marker-490270][bookmark: marker-490272][bookmark: marker-490274][bookmark: marker-490276][bookmark: marker-490278][bookmark: marker-490280][bookmark: marker-490282][bookmark: marker-490284][bookmark: marker-490286]
 
     [bookmark: pgfId-490290]In addition to the three main VPN topologies, other more complex topologies can be created as combinations of these topologies. They include:
 
      
      	 [bookmark: pgfId-490292]Partial mesh—A network in which some devices are organized in a full mesh topology, and other devices form either a hub-and-spoke or a point-to-point connection to some of the fully meshed devices. A partial mesh does not provide the level of redundancy of a full mesh topology, but it is less expensive to implement. Partial mesh topologies are generally used in peripheral networks that connect to a fully meshed backbone.
 
      	 [bookmark: pgfId-490294]Tiered hub-and-spoke—A network of hub-and-spoke topologies in which a device can behave as a hub in one or more topologies and a spoke in other topologies. Traffic is permitted from spoke groups to their most immediate hub.
 
      	 [bookmark: pgfId-490296]Joined hub-and-spoke—A combination of two topologies (hub-and-spoke, point-to-point, or full mesh) that connect to form a point-to-point tunnel. For example, a joined hub-and-spoke topology could comprise two hub-and-spoke topologies, with the hubs acting as peer devices in a point-to-point topology.
 
     
 
     [bookmark: pgfId-490298]Related Topics
 
      
      	 [bookmark: pgfId-490303]Creating or Editing VPN Topologies
 
      	 [bookmark: pgfId-490308]Hub-and-Spoke VPN Topologies
 
      	 [bookmark: pgfId-490313]Point-to-Point VPN Topologies
 
      	 [bookmark: pgfId-490318]Full Mesh VPN Topologies
 
     
 
    
 
   
 
    
     [bookmark: pgfId-490328][bookmark: 64267][bookmark: vpchap_cncpt_UnderstandingIPsecTechnologiesandPolicies]Understanding IPsec Technologies and Policies[bookmark: marker-490324][bookmark: marker-490326]
 
    [bookmark: pgfId-490330]Security Manager provides seven types of IPsec technologies that you can configure on the devices in your site-to-site VPN topology—Regular IPsec, IPsec/GRE, GRE Dynamic IP, standard and large scale DMVPN, Easy VPN, and GET VPN. The assigned technology determines which policies you can configure for the VPN.
 
    [bookmark: pgfId-490335]You assign an IPsec technology to a VPN topology during its creation. After an IPsec technology is assigned to a VPN topology, you cannot change the technology, other than by deleting the VPN topology and creating a new one. See Defining the Name and IPsec Technology of a VPN Topology.
 
    [bookmark: pgfId-490337]The following topics explain some basic concepts about IPsec technologies and site-to-site VPN policies:
 
     
     	 [bookmark: pgfId-490342]Understanding Mandatory and Optional Policies for Site-to-Site VPNs
 
     	 [bookmark: pgfId-490347]Overview of Site-to-Site VPN Policies
 
     	 [bookmark: pgfId-490352]Understanding Devices Supported by Each IPsec Technology
 
     	 [bookmark: pgfId-490357]Including Unmanaged or Non-Cisco Devices in a VPN
 
     	 [bookmark: pgfId-490362]Understanding and Configuring VPN Default Policies
 
     	 [bookmark: pgfId-490367]Using Device Overrides to Customize VPN Policies
 
     	 [bookmark: pgfId-490372]Understanding VRF-Aware IPsec
 
    
 
     
      [bookmark: pgfId-490392][bookmark: 64301][bookmark: vpchap_cncpt_UnderstandingMandatoryandOptionalPoliciesforSitetoSiteVPNs]Understanding Mandatory and Optional Policies for Site-to-Site VPNs[bookmark: marker-490378][bookmark: marker-490380][bookmark: marker-490382][bookmark: marker-490384][bookmark: marker-490386][bookmark: marker-490388][bookmark: marker-490390]
 
     [bookmark: pgfId-490394]Some site-to-site VPN policies are mandatory, which means that you must configure them to create a VPN topology or to save your changes when editing them. Most mandatory policies have predefined defaults, which you can use to complete the definition of a VPN topology, but you typically must edit the policies to ensure their settings work for your network.
 
     [bookmark: pgfId-490396]Optional policies, which you need to configure only if you desire the services defined by the policy, do not come with predefined defaults.
 
      
       
     
 
     
 
     [bookmark: pgfId-490401]Tip You can configure your own mandatory policy defaults by creating shared policies that specify the desired settings, and then by selecting these shared policies when creating a VPN. You can even make the shared policies the defaults for the Create VPN wizard. However, these default policies do not apply when you create Extranet VPNs; with Extranet VPNs, you must always configure the settings for mandatory policies as part of the normal wizard flow. In addition, you cannot create a default policy for IKEv2 Authentication. For more information, see Understanding and Configuring VPN Default Policies.

     
      

     

     
 
     [bookmark: pgfId-490406]Some mandatory policies are mandatory only under certain conditions. For example, an IKEv1 preshared key policy is mandatory only if the default (mandatory) IKEv1 proposal uses preshared key authentication. If the selected IKE authentication method is Certificate (RSA Signature), an IKEv1 Public Key Infrastructure policy is mandatory (see Deciding Which Authentication Method to Use). If you allow IKEv2 negotiations in the topology, an IKEv2 Authentication policy is mandatory.
 
     [bookmark: pgfId-490408]The following table lists the mandatory and optional policies for each predefined technology that you can assign to the devices in your site-to-site VPN topology.
 
     [bookmark: pgfId-490411]
 
      
       
        
        [bookmark: pgfId-487201]Table 25-1 [bookmark: 64333]Site-to-Site VPN IPsec Technologies and Policies 
 
        
       
         
         	
           
           [bookmark: pgfId-487209]Technology
          
  
         	
           
           [bookmark: pgfId-487211]Mandatory Policies
          
  
         	
           
           [bookmark: pgfId-487213]Optional Policies
          
  
        
 
         
         	[bookmark: pgfId-487221]Regular IPsec
 [bookmark: pgfId-487226]See Understanding IPsec Proposals for Site-to-Site VPNs.
  
         	
           
           	 [bookmark: pgfId-487228]IKE Proposal
 
           	 [bookmark: pgfId-487230]IPsec Proposal
 
           	 [bookmark: pgfId-487232]When allowing IKEv1, one of: IKEv1 Preshared Key or IKEv1 Public Key Infrastructure
 
           	 [bookmark: pgfId-487234]When allowing IKEv2, IKEv2 Authentication
 
          
  
         	
           
           	 [bookmark: pgfId-487236]VPN Global Settings
 
          
  
        
 
         
         	[bookmark: pgfId-487244]IPsec/GRE (Generic Routing Encapsulation)
 [bookmark: pgfId-487249]See Understanding GRE.
  
         	
           
           	 [bookmark: pgfId-487251]IKE Proposal
 
           	 [bookmark: pgfId-487253]IPsec Proposal
 
           	 [bookmark: pgfId-487255]One of: IKEv1 Preshared Key or IKEv1 Public Key Infrastructure
 
           	 [bookmark: pgfId-487257]GRE Modes
 
          
  
         	
           
           	 [bookmark: pgfId-487259]VPN Global Settings
 
          
  
        
 
         
         	[bookmark: pgfId-487267]GRE Dynamic IP
 [bookmark: pgfId-487272]See Understanding GRE Configuration for Dynamically Addressed Spokes.
  
         	
           
           	 [bookmark: pgfId-487274]IKE Proposal
 
           	 [bookmark: pgfId-487276]IPsec Proposal
 
           	 [bookmark: pgfId-487278]One of: IKEv1 Preshared Key or IKEv1 Public Key Infrastructure
 
           	 [bookmark: pgfId-487280]GRE Modes
 
          
  
         	
           
           	 [bookmark: pgfId-487282]VPN Global Settings
 
          
  
        
 
         
         	[bookmark: pgfId-487290]Dynamic Multipoint VPN (DMVPN).
 [bookmark: pgfId-487295]See Understanding DMVPN.
  
         	
           
           	 [bookmark: pgfId-487297]IKE Proposal
 
           	 [bookmark: pgfId-487299]IPsec Proposal
 
           	 [bookmark: pgfId-487301]One of: IKEv1 Preshared Key or IKEv1 Public Key Infrastructure
 
           	 [bookmark: pgfId-487303]GRE Modes
 
          
  
         	
           
           	 [bookmark: pgfId-487305]VPN Global Settings
 
          
  
        
 
         
         	[bookmark: pgfId-487313]Large Scale DMVPN
 [bookmark: pgfId-487318]See Configuring Large Scale DMVPNs.
  
         	
           
           	 [bookmark: pgfId-487320]IKE Proposal
 
           	 [bookmark: pgfId-487322]IPsec Proposal
 
           	 [bookmark: pgfId-487324]One of: IKEv1 Preshared Key or IKEv1 Public Key Infrastructure
 
           	 [bookmark: pgfId-487326]GRE Modes
 
           	 [bookmark: pgfId-487328]Server Load Balance
 
          
  
         	
           
           	 [bookmark: pgfId-487330]VPN Global Settings
 
          
  
        
 
         
         	[bookmark: pgfId-487338]Easy VPN
 [bookmark: pgfId-487343]See Understanding Easy VPN.
  
         	
           
           	 [bookmark: pgfId-487345]IKE Proposal
 
           	 [bookmark: pgfId-487347]Easy VPN IPsec Proposal
 
           	 [bookmark: pgfId-487349]Client Connection Characteristics
 
           	 [bookmark: pgfId-487351]If any servers are IOS or PIX 6.3 devices: User Group
 
           	 [bookmark: pgfId-487353]If any servers are ASA or PIX 7.0+ devices: Connection Profiles
 
          
  
         	
           
           	 [bookmark: pgfId-487355]IKEv1 Public Key Infrastructure (mandatory if using certificates)
 
           	 [bookmark: pgfId-487357]VPN Global Settings
 
          
  
        
 
         
         	[bookmark: pgfId-487365]GET VPN
 [bookmark: pgfId-487370]See Understanding Group Encrypted Transport (GET) VPNs.
  
         	
           
           	 [bookmark: pgfId-487372]Group Encryption
 
           	 [bookmark: pgfId-487374]IKE Proposal for GET VPN
 
           	 [bookmark: pgfId-487376]One of: IKEv1 Preshared Key or IKEv1 Public Key Infrastructure
 
          
  
         	
           
           	 [bookmark: pgfId-487378]Global Settings for GET VPN
 
          
  
        
 
       
      
 
     
 
     [bookmark: pgfId-490413]Related Topics
 
      
      	 [bookmark: pgfId-490418]Creating or Editing VPN Topologies
 
      	 [bookmark: pgfId-490423]Understanding Devices Supported by Each IPsec Technology
 
      	 [bookmark: pgfId-490428]Understanding and Configuring VPN Default Policies
 
      	 [bookmark: pgfId-490433]Understanding VPN Topologies
 
      	 [bookmark: pgfId-490438]Chapter 26, “Configuring IKE and IPsec Policies”
 
      	 [bookmark: pgfId-490443]Understanding Policies
 
     
 
    
 
     
      [bookmark: pgfId-490453][bookmark: 64504][bookmark: vpnpage_cncpt_SitetoSiteVPNPolicies]Overview of Site-to-Site VPN Policies[bookmark: marker-490449][bookmark: marker-490451]
 
     [bookmark: pgfId-490458]You can access site-to-site VPN policies by selecting Manage > Site-To-Site VPNs, or by clicking the Site-To-Site VPN Manager button on the toolbar, and then selecting the required policy in the Policies selector of the Site-to-Site VPN window. You can also access site-to-site VPN policies from Device view or Policy view. For more information, see Accessing Site-to-Site VPN Topologies and Policies.
 
     [bookmark: pgfId-490460]The following is a summary of all of the site-to-site VPN policies, some of which you cannot create as shared policies. Note that some of these policies are documented in the sections that explain remote access VPNs, because the policies are used for both remote access and site-to-site VPNs. However, you must configure these policies separately for each type of VPN.
 
      
      	 [bookmark: pgfId-490465]Client Connection Characteristics. See Configuring Client Connection Characteristics for Easy VPN.
 
      	 [bookmark: pgfId-490470]Connection Profiles. See Connection Profiles Page.
 
      	 [bookmark: pgfId-490475]Easy VPN IPsec Proposal. See Configuring an IPsec Proposal for Easy VPN.
 
      	 [bookmark: pgfId-490480]GRE Modes. See Understanding the GRE Modes Page.
 
      	 [bookmark: pgfId-490485]Group Encryption Policy. See Defining GET VPN Group Encryption.
 
      	 [bookmark: pgfId-490490]Group Members. See Configuring GET VPN Group Members.
 
      	 [bookmark: pgfId-490495]IKE Proposal. See Configuring an IKE Proposal.
 
      	 [bookmark: pgfId-490500]IKE Proposal for GET VPN. See Configuring the IKE Proposal for GET VPN.
 
      	 [bookmark: pgfId-490505]IKEv2 Authentication. See Configuring IKEv2 Authentication in Site-to-Site VPNs.
 
      	 [bookmark: pgfId-490510]IPsec Proposal. See Configuring IPsec Proposals in Site-to-Site VPNs
 
      	 [bookmark: pgfId-490515]Key Servers. See Configuring GET VPN Key Servers.
 
      	 [bookmark: pgfId-490520]Peers. See Defining the Endpoints and Protected Networks.
 
      	 [bookmark: pgfId-490525]IKEv1 Preshared Key. See Configuring IKEv1 Preshared Key Policies.
 
      	 [bookmark: pgfId-490530]IKEv1 Public Key Infrastructure. See Configuring IKEv1 Public Key Infrastructure Policies in Site-to-Site VPNs.
 
      	 [bookmark: pgfId-490535]Server Load Balance. See Configuring Server Load Balancing in Large Scale DMVPN.
 
      	 [bookmark: pgfId-490540]User Group Policy. See Configuring a User Group Policy for Easy VPN.
 
      	 [bookmark: pgfId-490545]VPN Global Settings. See Configuring VPN Global Settings.
 
      	 [bookmark: pgfId-490550]Global Settings for GET VPN. See Configuring Global Settings for GET VPN.
 
     
 
    
 
     
      [bookmark: pgfId-490570][bookmark: 64574][bookmark: vpchap_cncpt_UnderstandingDevicesSupportedbyEachIPsecTechnology]Understanding Devices Supported by Each IPsec Technology[bookmark: marker-490556][bookmark: marker-490558][bookmark: marker-490560][bookmark: marker-490562][bookmark: marker-490564][bookmark: marker-490566][bookmark: marker-490568]
 
     [bookmark: pgfId-490572]Each IPsec technology supports different devices as members of their topology. The following table describes the basic device support. These requirements are enforced when you select devices for a VPN; in some cases, the device lists are filtered to show only supported devices. In other cases, a device might be supported in one role (for example, as a spoke), but not supported in another role; in these cases, you can select the wrong device type, but you are prevented from saving the change (a message will explain the specific problem).
 
      
       
     
 
     
 
     [bookmark: pgfId-490574]Tip Some device models have NO-VPN versions, which do not support VPN configuration. Thus, although the 3845 model might be supported for a type of VPN, the 3845 NOVPN model is not supported. In addition, the Cisco Catalyst 6500 series ASA Services Module (running software release 8.5(x)) does not support any type of VPN.

     
      

     

     
 
     [bookmark: pgfId-490577]
 
      
       
        
        [bookmark: pgfId-487391]Table 25-2 [bookmark: 64600]Devices Supported by Each IPsec Technology 
 
        
       
         
         	
           
           [bookmark: pgfId-487397]Technology
          
  
         	
           
           [bookmark: pgfId-487399]Supported Platforms
          
  
        
 
         
         	[bookmark: pgfId-487405]Regular IPsec
 [bookmark: pgfId-487410]See Chapter 26, “Configuring IKE and IPsec Policies”.
  
         	[bookmark: pgfId-487412]Regular IPsec policies can be configured on Cisco IOS security routers (including Aggregation Service Routers, or ASRs), PIX Firewalls, and ASA 5500 series devices. Except for Extranet VPNs, Catalyst VPN service modules are also supported.
 [bookmark: pgfId-487414]IKEv2 is supported on ASA release 8.4(x) only. If you limit the topology to IKEv2 only, all devices must support IKEv2. If you allow both IKEv1 and IKEv2, devices that do not support IKEv2 automatically use IKEv1.
  
        
 
         
         	[bookmark: pgfId-487420]IPsec/GRE (Generic Routing Encapsulation).
 [bookmark: pgfId-487425]See Understanding GRE.
  
         	[bookmark: pgfId-487427]GRE policies can be configured on Cisco IOS security routers (including ASRs) and Catalyst 6500/7600 devices.
  
        
 
         
         	[bookmark: pgfId-487433]GRE Dynamic IP.
 [bookmark: pgfId-487438]See Understanding GRE Configuration for Dynamically Addressed Spokes.
  
         	[bookmark: pgfId-487440]GRE Dynamic IP can be configured on Cisco IOS security routers (including ASRs) and Catalyst 6500/7600 devices.
  
        
 
         
         	[bookmark: pgfId-487446]Dynamic Multipoint VPN (DMVPN), Large Scale DMVPN.
 [bookmark: pgfId-487454]See Dynamic Multipoint VPNs (DMVPN) and Configuring Large Scale DMVPNs.
  
         	[bookmark: pgfId-487456]DMVPN configuration is supported on Cisco IOS 12.3T devices and later, and on ASRs running Cisco IOS XE Software 2.x or later (known as 12.2(33)XNA+ in Security Manager). Large Scale DMVPN configuration also supports Catalyst 6500/7600 devices as IPsec Terminators.
 [bookmark: pgfId-487458]To use DMVPN phase 3 connections between spokes, devices must run IOS Software release 12.4(6)T or higher; ASRs must run IOS XE Software release 2.4 (called 12.2(33)XND) or higher.
  
        
 
         
         	[bookmark: pgfId-487464]Easy VPN.
 [bookmark: pgfId-487469]See Chapter 28, “Easy VPN”.
  
         	[bookmark: pgfId-487471]The Easy VPN Server can be a Cisco IOS security router (including ASRs), a Catalyst 6500/7600 (with supported VPN service modules or port adapters), a PIX Firewall, or an ASA 5500 series device.
 [bookmark: pgfId-487473]The Easy VPN client is supported on PIX 501, 506, 506E Firewalls running PIX 6.3, Cisco 800-3900 Series routers, and ASA 5505 devices running OS version 7.2 or later.
  
        
 
         
         	[bookmark: pgfId-487479]GET VPN.
 [bookmark: pgfId-487484]See Chapter 29, “Group Encrypted Transport (GET) VPNs”.
  
         	[bookmark: pgfId-487486]Key servers can be configured on:
 
           
           	 [bookmark: pgfId-487488]Cisco 1800, 2800, 3800 Series ISR, Cisco 7200 Series Routers, and Cisco 7301 Routers running Cisco IOS Software release 12.4(15)T or later.
 
           	 [bookmark: pgfId-487490]Cisco 1900, 2900, 3900 Series ISR running release 15.0 or later.
 
          
 [bookmark: pgfId-487492]Group members can be configured on Cisco 1800, 1900, 2800, 2900, 3800, 3900 Series ISR, Cisco 7200 Series Routers, and Cisco 7301 Routers with the same minimum software releases. The Cisco 871 ISR can also be used as a group member if GET VPN is deployed with very few (1-3) IPSec SAs. In addition, you can configure Cisco ASR Routers using Cisco IOS XE Software Release 2.3 (12.2(33)XNC) and above as group members.
  
        
 
       
      
 
     
 
     [bookmark: pgfId-490579]Related Topics
 
      
      	 [bookmark: pgfId-490584]Creating or Editing VPN Topologies
 
      	 [bookmark: pgfId-490589]Understanding Mandatory and Optional Policies for Site-to-Site VPNs
 
      	 [bookmark: pgfId-490594]Including Unmanaged or Non-Cisco Devices in a VPN
 
      	 [bookmark: pgfId-490599]Understanding and Configuring VPN Default Policies
 
      	 [bookmark: pgfId-490604]Understanding VPN Topologies
 
      	 [bookmark: pgfId-490609]Chapter 26, “Configuring IKE and IPsec Policies”
 
      	 [bookmark: pgfId-490614]Understanding Policies
 
     
 
    
 
     
      [bookmark: pgfId-490624][bookmark: 64687][bookmark: vpchap_cncpt_IncludingUnmanagedorNonCiscoDevicesinaVPN]Including Unmanaged or Non-Cisco Devices in a VPN[bookmark: marker-490620][bookmark: marker-490622]
 
     [bookmark: pgfId-490626]Your VPN might include devices that you cannot, or should not, manage in Security Manager. These include:
 
      
      	 [bookmark: pgfId-490628]Cisco devices that Security Manager supports, but for which your organization is not responsible. For example, you might have a VPN that includes spokes in networks managed by other organizations within your company, or a connection to a service provider or partner network.
 
      	 [bookmark: pgfId-490630]Non-Cisco devices. You cannot use Security Manager to create and deploy configurations to non-Cisco devices.
 
     
 
     [bookmark: pgfId-490632]You have two options for handling these kinds of devices:
 
      
      	 [bookmark: pgfId-490637]If the connection is a regular IPsec point-to-point connection, you can configure the connection as an Extranet VPN as described in Creating or Editing Extranet VPNs.
 
      	 [bookmark: pgfId-490639]For other types of connections, you can include these devices in the Security Manager inventory as “unmanaged” devices. These devices can serve as endpoints in a VPN topology, but Security Manager does not discover any configurations from the device, nor does it deploy configurations to them.
 
     
 
     [bookmark: pgfId-490641]When the Extranet VPN option will not work, you must do the following before you can add an unmanaged device to a VPN topology:
 
      
      	 [bookmark: pgfId-490646]Manually add the device as an unmanaged device to the device inventory using the procedure described in Adding Devices by Manual Definition. Ensure that you make the following selections:
 
     
 
     [bookmark: pgfId-490648] – Select a Cisco device type that is comparable to the device you are adding in terms of VPN-supported technologies. The device type controls the types of VPN topologies to which you can add the device. For example, for GRE/DMVPN, you might select an integrated services router such as an 1800 or 2800 series, whereas in Easy VPN you could also select an ASA or PIX device if appropriate.
 
     [bookmark: pgfId-490650] – Deselect the Manage in Cisco Security Manager option. This is very important, because the default is to make all new devices managed devices. If you forget to do this while adding the device, you can deselect the option later on the General tab in the device properties (right-click the device and select Device Properties).
 
      
      	 [bookmark: pgfId-490652]Using the interface policy for the device, define the external VPN interface to which managed devices will point. Because the device is unmanaged, your definitions in this policy are never configured on the device; the policy simply represents what you have configured on the device outside of Security Manager.
 
     
 
     [bookmark: pgfId-490654]Related Topics
 
      
      	 [bookmark: pgfId-490659]Understanding Devices Supported by Each IPsec Technology
 
      	 [bookmark: pgfId-490664]Selecting Devices for Your VPN Topology
 
      	 [bookmark: pgfId-490669]Creating or Editing VPN Topologies
 
     
 
    
 
     
      [bookmark: pgfId-490683][bookmark: 64735][bookmark: vpchap_cncpt_UnderstandingVPNDefaultPolicies]Understanding and Configuring VPN Default Policies[bookmark: marker-490675][bookmark: marker-490677][bookmark: marker-490679][bookmark: marker-490681]
 
     [bookmark: pgfId-490685]For most VPN policies that are mandatory, Security Manager includes “factory default” settings for the policies. These defaults are generic, and might not be appropriate for your network, but they do allow you to complete the creation of a VPN without having to stop and start over when you do not have the needed shared policy configured. Therefore, you can, and should, create your own default VPN policies for mandatory policies. You can also create defaults for certain optional policies.
 
     [bookmark: pgfId-490687]Before configuring new defaults, consider the types of VPNs you are likely to configure, then review the types of policies for which you can create defaults. Select Tools > Security Manager Administration, then select VPN Policy Defaults from the table of contents. Select the tabs for the desired IPsec technologies to see which policies are available. If a policy is assigned Factory Default, or if this option is available from the drop-down list, the policy is mandatory; other policies are optional. You can also create default policies for remote access VPNs, and for site-to-site endpoint configurations. Click the View Content button next to a selected policy to see the policy definition.
 
     [bookmark: pgfId-490689]The following procedure explains how to create and use VPN policy defaults.
 
     [bookmark: pgfId-490691]Tips
 
      
      	 [bookmark: pgfId-490696]When you configure VPN default policies, you are selecting shared policies. Although you can configure only one default per policy per IPsec technology, users can select different shared policies when configuring VPNs. Thus, you might want to configure more than one shared policy that users can select, and configure the most commonly-used policy as the default policy. For more information about how users can select different policies when configuring a VPN, see Assigning Initial Policies (Defaults) to a New VPN Topology.
 
      	 [bookmark: pgfId-490698]Although the IKEv2 Authentication policy is a mandatory policy for topologies that allow IKEv2 negotiations, there are no IKEv2 Authentication factory default settings, and you cannot create IKEv2 Authentication shared policies. Therefore, whenever you allow IKEv2 in a topology, you must manually configure the IKEv2 Authentication policy before the topology is valid.
 
      	 [bookmark: pgfId-490700]The Public Key Infrastructure policy is required for IKEv1 if you configure the IKE Proposal policy to use certificate authentication. However, there are no factory default settings for this policy, so if you intend to use certificate authentication for IKEv1, consider creating default Public Key Infrastructure policies.
 
      	 [bookmark: pgfId-490705]Keep in mind that any change to a shared policy affects all VPNs that are using the policy. This can make it easy to implement across-the-board changes that are required for every VPN. However, after creating the VPN, the user can switch from a shared policy to a local policy, so that any changes to the configuration must be done specifically for the VPN topology. For more information about shared policies, see Managing Shared Policies in Policy View.
 
      	 [bookmark: pgfId-490707]These default policies do not apply when you create Extranet VPNs. With Extranet VPNs, you must always configure the settings for mandatory policies as part of the normal wizard flow.
 
     
 
     
 
     [bookmark: pgfId-490709]Step 1 Create the default policies. All default policies are shared policies.
 
     [bookmark: pgfId-490711] a. In Policy view (select View > Policy View), select the policy for which you want to configure defaults. The policies are in the Site-to-Site VPN or Remote Access VPN folders.
 
     [bookmark: pgfId-490713] b. Click the Create a Policy (+) button at the bottom of the shared policy selector, enter a name for the policy, and click OK.
 
     [bookmark: pgfId-490715] c. Configure the desired settings. Click the Help (?) button in the toolbar to get reference information about the settings available in the selected policy.
 
     [bookmark: pgfId-490717] d. Repeat the process until you have created at least one shared policy for each policy for which you want to define a default policy.
 
     [bookmark: pgfId-490719]Step 2 If desired, create defaults for the VPN endpoints. These defaults are interface role objects, which identify the interface names used for VPN connections (for example, GigabitEthernet0/1). Create separate roles for internal and external VPN interfaces.
 
     [bookmark: pgfId-490724] a. Select Manage > Policy Objects to open the Policy Object Manager.
 
     [bookmark: pgfId-490726] b. Select Interface Roles from the table of contents.
 
     [bookmark: pgfId-490728] c. Click the New Object (+) button, enter the interface name patterns that identify the most commonly used interfaces for VPN internal or external interfaces in your network, and click OK.
 
     [bookmark: pgfId-490736]For more information about interface roles and the wildcards you can use to configure them, see Understanding Interface Role Objects and Creating Interface Role Objects.
 
     [bookmark: pgfId-490738]Step 3 Submit the policies and policy objects to the database. You will have to resolve any validation errors.
 
      
      	 [bookmark: pgfId-490740]In non-Workflow mode, select  File > Submit .
 
      	 [bookmark: pgfId-490742]In Workflow mode without an activity approver, select  Activities > Approve Activity .
 
      	 [bookmark: pgfId-490744]In Workflow mode with an activity approver, select  Activities > Submit Activity . You will have to wait for the activity to be approved before you can select the policies and objects as defaults.
 
     
 
     [bookmark: pgfId-490746]Step 4 Select your newly-configured policies and policy objects as VPN policy defaults.
 
     [bookmark: pgfId-490751] a. Select Tools > Security Manager Administration, and then select VPN Policy Defaults from the table of contents (see VPN Policy Defaults Page).
 
     [bookmark: pgfId-490753] b. Select the desired tabs, then select the policies you configured from the drop-down lists for each of the mandatory or optional policies for which you configured defaults.
 
     [bookmark: pgfId-490755]On the S2S Endpoints tab, select the appropriate interface role objects.
 
     [bookmark: pgfId-490757] c. Click Save to save your defaults.
 
     [bookmark: pgfId-490759]The next time a user runs the Create VPN wizard, the defaults you selected will be used as the wizard’s defaults. Users can select any other shared policy or interface role to override the default.
 
     [bookmark: pgfId-490761]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-490773][bookmark: 64835][bookmark: vpchap_cncpt_UsingDeviceOverridestoCustomizeVPNPolicies]Using Device Overrides to Customize VPN Policies [bookmark: marker-490767][bookmark: marker-490769][bookmark: marker-490771]
 
     [bookmark: pgfId-490775]Many VPN policies use Security Manager policy objects in their configuration. Policy objects are containers that allow you to create reusable configurations.
 
     [bookmark: pgfId-490777]Because a VPN policy applies to every device in a VPN topology, you might need to make modifications to a policy object used in a policy for certain devices within the VPN topology. There might even be situations where you need to make modifications for all devices within a topology. You accomplish these modifications with device-level overrides on the policy objects.
 
     [bookmark: pgfId-490779]For example, when defining a PKI policy, you need to select a PKI enrollment object. If the hub of your VPN uses a different CA server than the spokes, you must use device-level overrides to specify the CA server used by the hub. Although the PKI policy references a single PKI enrollment object, the actual CA server represented by this object differs for the hub, based on the device-level override you define.
 
     [bookmark: pgfId-490781]To enable a policy object to be overridden, you must select the Allow Override per Device option in the policy object definition. You can then create device-level overrides. For more information about overriding a VPN policy object at the device level, see the following topics:
 
      
      	 [bookmark: pgfId-490786]Understanding Policy Object Overrides for Individual Devices
 
      	 [bookmark: pgfId-490791]Allowing a Policy Object to Be Overridden
 
      	 [bookmark: pgfId-490796]Creating or Editing Object Overrides for a Single Device
 
      	 [bookmark: pgfId-490801]Creating or Editing Object Overrides for Multiple Devices At A Time
 
     
 
    
 
     
      [bookmark: pgfId-490811][bookmark: 64865][bookmark: vpchap_cncpt_UnderstandingVRFAwareIPsec]Understanding VRF-Aware IPsec[bookmark: marker-490807][bookmark: marker-490809]
 
     [bookmark: pgfId-490813]One obstacle to successfully deploying peer-to-peer VPNs is the separation of routing tables, and the use of overlapping addresses, which usually results from using private IP addresses in customer networks. The VRF-Aware IPsec feature, which introduces IPsec tunnel mapping to Multiprotocol Label Switching (MPLS) VPNs, solves this problem.
 
     [bookmark: pgfId-490815]The VRF-Aware IPsec feature enables you to map IPsec tunnels to Virtual Routing Forwarding (VRF) instances, using a single public-facing address. A VRF instance defines the VPN membership of a customer site attached to the Provider Edge (PE) router. A VRF comprises an IP routing table, a derived Cisco Express Forwarding (CEF) table, a set of interfaces that use the forwarding table, and a set of rules and routing protocol parameters that control the information that is included in the routing table. A set of routing and CEF tables is maintained for each VPN customer across the MPLS/VPN network.
 
     [bookmark: pgfId-490817]Since each VPN has its own routing and forwarding table in the router, any customer or site that belongs to a VPN is provided access only to the set of routes contained within that table. Any PE router maintains a number of routing tables and a global routing table per VPN, which can be used to reach other routers in the provider network. Effectively, a number of virtual routers are created in a single physical router. Across the MPLS core to the other PE routers, this routing separation is maintained by adding unique VPN identifiers, such as the route distinguisher (RD).
 
      
       
     
 
     
 
     [bookmark: pgfId-490822]Note VRF-Aware IPsec can also be configured on devices in a remote access VPN. For more information, see Configuring Dynamic VTI/VRF Aware IPsec in Remote Access VPNs (IOS Devices).

     
      

     

     
 
     [bookmark: pgfId-490824]In Security Manager, you can configure VRF-Aware IPsec in your hub-and spoke VPN topology, with either a single device providing all functionality (“one-box” solution) or with multiple devices, each providing a part of the functionality (“two-box” solution). The solution of one device providing all the functionality can affect performance by overloading the system, whereas separating the functionality in a two-box solution provides better scaling for each function.
 
     [bookmark: pgfId-490826]The following topics describe:
 
      
      	 [bookmark: pgfId-490831]VRF-Aware IPsec One-Box Solution
 
      	 [bookmark: pgfId-490836]VRF-Aware IPsec Two-Box Solution
 
      	 [bookmark: pgfId-490841]Enabling and Disabling VRF on Catalyst Switches and 7600 Devices
 
     
 
     [bookmark: pgfId-490846]For information on configuring VRF-aware IPsec, see Configuring VRF Aware IPsec Settings.
 
    
 
     
      [bookmark: pgfId-490854][bookmark: 64892][bookmark: vpchap_cncpt_VRFAwareIPsecOneBoxSolution]VRF-Aware IPsec One-Box Solution [bookmark: marker-490852]
 
     [bookmark: pgfId-490856]In the one-box solution, IPsec tunnels terminate on a Cisco IOS router, which serves as the Provider Edge (PE) device. The PE device maps these tunnels to the appropriate MPLS/VPN network and serves as the IPsec Aggregator, by performing IPsec encryption and decryption from the Customer Edge (CE) devices.
 
      
       
     
 
     
 
     [bookmark: pgfId-490860]Note The configuration of routing between the PE device and the MPLS cloud is done by Cisco IP Solution Center. See the Cisco IP Solution Center MPLS VPN User Guide.

     
      

     

     
 
     [bookmark: pgfId-490862]The following illustration shows the topology of a one-box solution.
 
     [bookmark: pgfId-490866]Figure 25-4 [bookmark: 64902]VRF-Aware IPsec One-Box Solution
 
     [bookmark: pgfId-490869]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-490871]Related Topics
 
      
      	 [bookmark: pgfId-490876]Understanding VRF-Aware IPsec
 
      	 [bookmark: pgfId-490881]Configuring VRF Aware IPsec Settings
 
      	 [bookmark: pgfId-490886]Defining the Endpoints and Protected Networks
 
     
 
    
 
     
      [bookmark: pgfId-490894][bookmark: 64918][bookmark: vpchap_cncpt_VRFAwareIPsecTwoBoxSolution]VRF-Aware IPsec Two-Box Solution [bookmark: marker-490892]
 
     [bookmark: pgfId-490896]In the two-box solution, the PE device does just the MPLS mapping, while a separate IPsec Aggregator device does the IPsec encryption and decryption from the CEs.
 
      
       
     
 
     
 
     [bookmark: pgfId-490900]Note Security Manager fully manages the IPsec Aggregator, including routing to the PE device. The PE device is fully managed by Cisco IP Solution Center. This includes routing between the PE device and the MPLS cloud, and routing from the PE to the IPsec Aggregator. For more information, see the Cisco IP Solution Center MPLS VPN User Guide.

     
      

     

     
 
     [bookmark: pgfId-490902]The following illustration shows the topology of a two-box solution.
 
     [bookmark: pgfId-490906]Figure 25-5 [bookmark: 64928]VRF-Aware IPsec Two-Box Solution
 
     [bookmark: pgfId-490909]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-490911]Using the two-box solution, you configure VRF-Aware IPsec on devices in your VPN topology, as follows:
 
     [bookmark: pgfId-490913] 1. Configure the connection between the IPsec Aggregator and the PE device.
 
     [bookmark: pgfId-490915]Create a hub-and-spoke VPN topology and assign an IPsec technology to it. In this topology, the hub is the IPsec Aggregator, and the spokes may be Cisco IOS routers, PIX Firewalls, Catalyst VPN service modules, or Adaptive Security Appliance (ASA) devices. The IPsec Aggregator may be a security router or a Catalyst VPN service module. You then define the VRF parameters (VRF name and unique routing identifier) on the hub.
 
      
       
     
 
     
 
     [bookmark: pgfId-490917]Note VRF-Aware IPsec supports the configuration of IPsec, GRE, or Easy VPN technologies on Cisco IOS routers and Catalyst VPN service modules. DMVPN is also supported, but only on Cisco IOS routers.

     
      

     

     
 
     [bookmark: pgfId-490919] 2. Specify the VRF forwarding interface (or VLAN for a Catalyst VPN service module) between the IPsec Aggregator and the PE device.
 
     [bookmark: pgfId-490921] 3. Define the routing protocol and autonomous system (AS) number to be used between the IPsec Aggregator and the PE. Available routing protocols include BGP, EIGRP, OSPF, RIPv2, and Static Route.
 
     [bookmark: pgfId-490923]If the routing protocol defined between the IPsec Aggregator and the PE differs from the routing protocol used for the secured IGP, routing is redistributed to the secured IGP, using this routing protocol and AS number. Routing is also redistributed from the secured IGP to the PE.
 
      
       
     
 
     
 
     [bookmark: pgfId-490925]Note Redistributing the routing is only relevant when IPsec/GRE or DMVPN is the selected technology.

     
      

     

     
 
     [bookmark: pgfId-490927]Related Topics
 
      
      	 [bookmark: pgfId-490932]Understanding VRF-Aware IPsec
 
      	 [bookmark: pgfId-490937]Configuring VRF Aware IPsec Settings
 
      	 [bookmark: pgfId-490942]Defining the Endpoints and Protected Networks
 
     
 
    
 
     
      [bookmark: pgfId-490954][bookmark: 64956][bookmark: vpchap_proc_EnablingandDisablingVRFonCatalystSwitchesand7600Devices]Enabling and Disabling VRF on Catalyst Switches and 7600 Devices [bookmark: marker-490948][bookmark: marker-490950][bookmark: marker-490952]
 
     [bookmark: pgfId-490959]Deployment fails when you change the virtual routing and forwarding (VRF) mode on the Catalyst switches and 7600 hub of an existing site-to-site VPN. For example, if you initially configured VRF in the Create VPN wizard and deployed, but later return to the Peers policy and deselect the Enable VRF Settings check box, deployment fails. (This setting is found in the VRF Aware IPSec tab of the Edit Endpoints dialog box; see Configuring VRF Aware IPsec Settings.) Deployment likewise fails if you try to enable VRF on a VPN that was not initially configured with it.
 
     [bookmark: pgfId-490961]You cannot change the VRF mode on a Catalyst 6500/7600 during VPN operation. This restriction applies only to Catalyst 6500/7600 hubs, not to any other device type.
 
     [bookmark: pgfId-490963]This restriction does not apply to changes made to the VRF settings themselves. For example, if VRF is configured on the VPN topology, you can return to the Peers policy and change the VRF name or route distinguisher.
 
     [bookmark: pgfId-490965]If you need to change the VRF mode of a VPN, and you are using Catalyst 6500/7600 devices as hubs, use the following procedure.
 
     [bookmark: pgfId-490967]Related topics
 
      
      	 [bookmark: pgfId-490972]Understanding VRF-Aware IPsec
 
      	 [bookmark: pgfId-490977]VRF-Aware IPsec One-Box Solution
 
      	 [bookmark: pgfId-490982]VRF-Aware IPsec Two-Box Solution
 
     
 
     
 
     [bookmark: pgfId-490984]Step 1 Delete the VPN topology from Security Manager.
 
     [bookmark: pgfId-490986]Step 2 Deploy your changes.
 
     [bookmark: pgfId-490988]Step 3 Reload (restart) the Catalyst 6500/7600 device.
 
     [bookmark: pgfId-490990]Step 4 Right-click the device in Security Manager and select Discover Policies on Device. Perform a complete policy rediscovery.
 
     [bookmark: pgfId-490998]Step 5 Open the Create VPN wizard and redefine the VPN topology. At this point, you can select a different VRF mode. See Configuring VRF Aware IPsec Settings and Creating or Editing VPN Topologies.
 
     [bookmark: pgfId-491000]

     
      

     

     
 
    
 
   
 
    
     [bookmark: pgfId-491010][bookmark: 65003][bookmark: vpchap_cncpt_AccessingSitetoSiteVPNTopologiesandPolicies]Accessing Site-to-Site VPN Topologies and Policies[bookmark: marker-491006][bookmark: marker-491008]
 
    [bookmark: pgfId-491012]You can use the following methods to access and configure site-to-site VPN topologies and policies:
 
     
     	 [bookmark: pgfId-491017] Site-to-Site VPN Manager —This is the main tool for configuring VPN topologies. You can view a list of all site-to-site VPNs configured in Security Manager and edit their configurations and policies, including device membership. For information on using this tool, see Site-to-Site VPN Manager Window.
 
     	 [bookmark: pgfId-491022] Site-to-Site VPN policy in Device view —When you select a device in device view, you can select the Site-to-Site VPN policy in the Policies selector to see a list of all site-to-site VPNs in which the device participates and edit those topologies. You can also create new VPNs, or select a VPN and open the Site-to-Site VPN Manager to edit the policies for the selected VPN. This device view policy is essentially a short-cut into the Site-to-Site VPN Manager. For more information about using this policy, see Configuring VPN Topologies in Device View.
 
     	 [bookmark: pgfId-491027] Site-to-Site VPN folder in Policy view —Policy view is used to create shared policies. Many of the site-to-site VPN policies are shareable. Thus, you can configure shared policies that you can assign to more than one VPN topology while configuring the topology in the Site-to-Site VPN Manager. You can configure shared policies as defaults for the Create VPN wizard, as described in Understanding and Configuring VPN Default Policies.
 
    
 
    [bookmark: pgfId-491029]You can also create shared policies from the Site-to-Site VPN Manager window in much the same way you can create them from local policies in Device view, although all sharing commands in the Site-to-Site VPN Manager window are available only on the right-click context menu (when right-clicking a shareable policy).
 
    [bookmark: pgfId-491034]For more information on creating shared policies in Policy view, see Managing Shared Policies in Policy View.
 
     
      [bookmark: pgfId-491044][bookmark: 65028][bookmark: vpnpage_cncpt_SitetoSiteVPNManagerWindow]Site-to-Site VPN Manager Window[bookmark: marker-491042]
 
     [bookmark: pgfId-491049]The Site-to-Site VPN Manager lists all site-to-site VPNs configured in Security Manager. The VPNs selector, in the upper left pane of the window, lists all existing VPN topologies (see Understanding VPN Topologies). An icon indicates the type of VPN (hub and spoke, point to point, or full mesh).To view or edit a topology, select it, and its policies are loaded into the policy selector in the lower left pane. Select a policy to see its definition in the right pane.
 
     [bookmark: pgfId-491051]To open the Site-to-Site VPN Manager, click the Site-To-Site VPN Manager button on the toolbar or select Manage > Site-To-Site VPNs.
 
     [bookmark: pgfId-491053]Use the Site-to-Site VPN Manager window to:
 
      
      	 [bookmark: pgfId-491055]Create, edit, and delete VPN topologies.
 
     
 
     [bookmark: pgfId-491063] – To create a VPN topology, click the Create VPN Topology (+) button above the VPN selector and select the type of topology you want to create from the options that are displayed. This action opens the Create VPN Wizard or the Create Extranet VPN wizard. For more information, see Creating or Editing VPN Topologies or Creating or Editing Extranet VPNs.
 
     [bookmark: pgfId-491065] – To edit a VPN topology, select it and click the Edit VPN Topology (pencil) button, or right-click it and select Edit. This opens the Edit VPN or Edit Extranet VPN dialog box, which contains the most of the same pages as the Create VPN wizard in a tabbed layout.
 
     [bookmark: pgfId-491070] – To delete a VPN topology, select it and click the Delete VPN Topology (trash can) icon, or right-click it and select Delete. You are asked to confirm the deletion. See Deleting a VPN Topology.
 
      
      	 [bookmark: pgfId-491075]View detailed information about each VPN topology; select the topology, then select the VPN Summary policy. See Viewing a Summary of a VPN Topology’s Configuration.
 
      	 [bookmark: pgfId-491077]View and configure the endpoints defined for a VPN topology. You can see endpoints on the Endpoints tab or when editing a VPN topology, or by selecting the  Peers policy. For GET VPN topologies, there is no Peers policy; instead, use the  Key Servers and  Group Members policies to view and configure endpoints. For Extranet VPNs, the endpoints are on the Device Selection tab when editing the VPN, or also in the Peers policy.
 
      	 [bookmark: pgfId-491082]View and edit the policies assigned to a VPN topology, assign shared policies, or create shared policies from existing policies. For information on individual policies, see Overview of Site-to-Site VPN Policies.
 
     
 
     [bookmark: pgfId-491090]The options and methods for configuring shared policies from the Site-to-Site VPN Manager are the same as those from Device view, as explained in the sections under Working with Shared Policies in Device View or the Site-to-Site VPN Manager and Using the Policy Banner. You can share, assign, unassign, edit assignments, and rename policies, but no VPN policies allow inheritance. To perform these tasks, select the VPN topology, then right-click the desired policy and select the desired command.
 
     [bookmark: pgfId-491092]You can also use Policy view to configure shared VPN policies.
 
    
 
     
      [bookmark: pgfId-491106][bookmark: 65074][bookmark: vpchap_proc_ManagingVPNDevicesinDeviceView]Configuring VPN Topologies in Device View[bookmark: marker-491100][bookmark: marker-491102][bookmark: marker-491104]
 
     [bookmark: pgfId-491108]Use the Site-to-Site VPN Device view policy to view and edit the site-to-site VPN topologies to which a device belongs, if any. You can edit the VPN policies and change whether the device participates in the topology. You can also create new VPN topologies.
 
     [bookmark: pgfId-491113]This policy is essentially an access point for the Site-to-Site VPN Manager (see Site-to-Site VPN Manager Window).
 
     [bookmark: pgfId-491115]To open this policy, in Device view, select the desired device and then select Site-to-Site VPN from the Policy selector.
 
     [bookmark: pgfId-491117]The VPN topologies table lists all of the site-to-site VPNs to which this device belongs. Information includes the type of VPN, its name, IPSec technology, and description. Beginning with version 4.9, Security Manager also displays the Last Modified Ticket information for the VPN topologies. The VPN topologies that have been created or edited using the Ticket Management system will have the last Modified Ticket ID information available on this page. You can also filter the VPN topologies by the Last Modified Ticket ID.
 
      
      	 [bookmark: pgfId-491125]To add a VPN, click the  Create VPN Topology button, or right-click in the table and select  Create VPN Topology and select the type of topology you want to create from the options that are displayed. This action opens the Create VPN Wizard or the Create Extranet VPN wizard. For more information, see Creating or Editing VPN Topologies or Creating or Editing Extranet VPNs.
 
      	 [bookmark: pgfId-491133]To edit a VPN, select it and click the  Edit VPN Topology button, right-click the VPN and select  Edit VPN Topology , or simply double-click the entry. This opens the Edit VPN or Edit Extranet VPN dialog box, which is a tabbed version of the Create VPN wizard (see Creating or Editing VPN Topologies or Creating or Editing Extranet VPNs).
 
      	 [bookmark: pgfId-491135]To edit the policies for a VPN, select it and click the  Edit VPN Policies button. The Site-to-Site VPN Window opens displaying information about the VPN topology; select the desired policy from the Policies selector to edit it.
 
      	 [bookmark: pgfId-491140]To delete a VPN, select it and click the  Delete VPN Topology button, or right-click the VPN and select  Delete VPN Topology . You are asked to confirm the deletion. For more information, see Deleting a VPN Topology.
 
     
 
    
 
   
 
    
     [bookmark: pgfId-491152][bookmark: 65115][bookmark: vpchap_cncpt_SiteToSiteVPNDiscovery]Site-To-Site VPN Discovery[bookmark: marker-491146][bookmark: marker-491148][bookmark: marker-491150]
 
    [bookmark: pgfId-491154]You can discover the VPN topologies that are already deployed in your network so that you can use Security Manager to manage them. Your VPN configurations are brought into Security Manager and displayed as site-to-site VPN policies.
 
    [bookmark: pgfId-491159]Except for Extranet VPNs, you can also rediscover the configurations of existing VPN topologies that are already managed with Security Manager. For information about Site-to-Site VPN rediscovery, see Rediscovering Site-to-Site VPNs.
 
     
      
    
 
    
 
    [bookmark: pgfId-491164]Note You can also discover configurations on devices in remote access VPNs that are already deployed in your network. See Discovering Remote Access VPN Policies.

    
     

    

    
 
    [bookmark: pgfId-491166]These topics provide information about Site-to-Site VPN discovery:
 
     
     	 [bookmark: pgfId-491171]Supported and Unsupported Technologies and Topologies for VPN Discovery
 
     	 [bookmark: pgfId-491176]Prerequisites for VPN Discovery
 
     	 [bookmark: pgfId-491181]VPN Discovery Rules
 
     	 [bookmark: pgfId-491186]Discovering Site-to-Site VPNs
 
     	 [bookmark: pgfId-491191]Defining or Repairing Discovered VPNs with Multiple Spoke Definitions
 
     	 [bookmark: pgfId-491196]Rediscovering Site-to-Site VPNs
 
    
 
     
      [bookmark: pgfId-491204][bookmark: 65151][bookmark: vpchap_cncpt_SupportedTechnologiesandTopologiesforVPNDiscovery]Supported and Unsupported Technologies and Topologies for VPN Discovery[bookmark: marker-491202]
 
     [bookmark: pgfId-491206]This topic lists the technologies and topologies that Security Manager can discover, as well as the VPN features that are provisioned by Security Manager but cannot be discovered.
 
     [bookmark: pgfId-491208]Supported Technologies for VPN Discovery
 
      
      	 [bookmark: pgfId-491210]IPsec, including LAN-to-LAN configurations on ASA devices.
 
      	 [bookmark: pgfId-491212]IPsec + GRE
 
      	 [bookmark: pgfId-491214]IPsec + GRE dynamic IP
 
      	 [bookmark: pgfId-491216]DMVPN
 
      	 [bookmark: pgfId-491218]Easy VPN
 
      	 [bookmark: pgfId-491220]GET VPN
 
     
 
     [bookmark: pgfId-491222]Supported Topologies for VPN Discovery
 
      
      	 [bookmark: pgfId-491224]Point to point
 
      	 [bookmark: pgfId-491226]Hub and spoke
 
      	 [bookmark: pgfId-491228]Full mesh
 
      	 [bookmark: pgfId-491230]Extranet VPN (point-to-point to an unmanaged device)
 
     
 
     [bookmark: pgfId-491232]VPN Features Provisioned by Security Manager but Unsupported for VPN Discovery
 
      
      	 [bookmark: pgfId-491234]Large Scale DMVPN with IPsec Terminator (high-concentration hub)
 
      	 [bookmark: pgfId-491236]VRF-Aware IPsec
 
      	 [bookmark: pgfId-491238]Dial backup
 
      	 [bookmark: pgfId-491240]IPsec and ISAKMP profiles for Easy VPN
 
      	 [bookmark: pgfId-491242]Easy VPN with High Availability
 
     
 
     [bookmark: pgfId-491244]If you define and deploy policies of these types using Security Manager, your policies overwrite the device configurations that were not discovered. Therefore, if you want Security Manager to manage existing configurations, you should define policies that match the existing configurations as closely as possible. (Use Tools > Preview Configuration to examine the results before deploying.) The VPN provisioning mechanism leverages the content of the existing configuration as much as possible (assuming the content matches the policies configured in Security Manager), but does not retain the naming conventions used in the CLI commands.
 
     [bookmark: pgfId-491246]Related Topics
 
      
      	 [bookmark: pgfId-491251]Prerequisites for VPN Discovery
 
      	 [bookmark: pgfId-491256]VPN Discovery Rules
 
      	 [bookmark: pgfId-491261]Discovering Site-to-Site VPNs
 
     
 
    
 
     
      [bookmark: pgfId-491269][bookmark: 65211][bookmark: vpchap_cncpt_PrerequisitesforVPNDiscovery]Prerequisites for VPN Discovery[bookmark: marker-491267]
 
     [bookmark: pgfId-491271]For successful VPN discovery, the following prerequisites must be met:
 
      
      	 [bookmark: pgfId-491273]Except for Extranet VPNs, all devices participating in the VPN must be added to the Security Manager inventory.
 
      	 [bookmark: pgfId-491275]You must provide Security Manager with some basic information about the VPN. The VPN discovery wizard prompts you for the following information:
 
     
 
     [bookmark: pgfId-491277] – VPN topology (hub and spoke, point to point, full mesh, Extranet).
 
     [bookmark: pgfId-491279] – VPN technology (Regular IPsec, IPsec/GRE, GRE dynamic IP, DMVPN, Easy VPN, GET VPN).
 
     [bookmark: pgfId-491281] – Devices in the VPN and their roles (hub/spoke). For Extranet VPNs, you specify the managed device only.
 
     [bookmark: pgfId-491283] – Source of the VPN configuration. The VPN can be discovered directly from the live network or from Security Manager’s Configuration Archive.
 
      
      	 [bookmark: pgfId-491285]Each device in the VPN must have a crypto map associated with a physical interface. This rule does not apply to the remote (unmanaged) devices in an Extranet VPN.
 
      	 [bookmark: pgfId-491287]If you use OSPF as your routing protocol in a VPN topology, all devices in the VPN must use the same OSPF process number.
 
      	 [bookmark: pgfId-491289]Each PIX 6.3 or ASA 5505 client device in an Easy VPN topology must have a vpnclient configuration.
 
     
 
     [bookmark: pgfId-491291]Related Topics
 
      
      	 [bookmark: pgfId-491296]Supported and Unsupported Technologies and Topologies for VPN Discovery
 
      	 [bookmark: pgfId-491301]VPN Discovery Rules
 
      	 [bookmark: pgfId-491306]Discovering Site-to-Site VPNs
 
     
 
    
 
     
      [bookmark: pgfId-491314][bookmark: 65250][bookmark: vpchap_cncpt_VPNDiscoveryRules]VPN Discovery Rules[bookmark: marker-491312]
 
     [bookmark: pgfId-491316]The following table describes the rules by which Security Manager translates and discovers your VPN configurations, and how it handles instances where your configuration on the device does not match what is supported by Security Manager.
 
      
       
     
 
     
 
     [bookmark: pgfId-491318]Tip Because Extranet VPN discovery involves the analysis of a single device (the managed device), most of these rules do not apply to Extranet VPN discovery. Any rule that involves consistency of values among devices in the VPN is not applicable.

     
      

     

     
 
     [bookmark: pgfId-491321]
 
      
       
        
        [bookmark: pgfId-487505]Table 25-3 [bookmark: 65258]VPN Discovery Rules 
 
        
       
         
         	
           
           [bookmark: pgfId-487511]If this condition exists:
          
  
         	
           
           [bookmark: pgfId-487513]The VPN discovery is handled as follows:
          
  
        
 
         
         	[bookmark: pgfId-487519]Security Manager cannot contact a device in the VPN for live device discovery.
  
         	
           
           	 [bookmark: pgfId-487521]If the device is the only hub or spoke in the VPN, discovery fails.
 
           	 [bookmark: pgfId-487523]If there are other hubs or spokes in the VPN, discovery proceeds but the unavailable device is not discovered.
 
           	 [bookmark: pgfId-487525]Except for Extranet VPNs, if the device is a peer in a point-to-point topology, discovery fails. For Extranet VPNs, only the managed device is contacted, and discovery fails if it cannot be contacted.
 
           	 [bookmark: pgfId-487527]If the device is a peer in a full mesh topology and there are only two devices, including the unavailable one, in the topology, discovery fails. If there are more than two devices, discovery proceeds but the unavailable device is not discovered.
 
          
  
        
 
         
         	[bookmark: pgfId-487533]The VPN is a LAN-to-LAN VPN on an ASA.
  
         	[bookmark: pgfId-487535]The ASA documentation uses “LAN-to-LAN” as a synonym for “site-to-site.” In a LAN-to-LAN VPN configuration, the ASA uses tunnel groups, which when used in a remote access VPN configuration, Security Manager discovers as connection profiles.
 [bookmark: pgfId-487537]When discovering site-to-site VPNs on an ASA that uses LAN-to-LAN (L2L) tunnel groups, Security Manager creates a site-to-site VPN topology, and the L2L tunnel groups are not presented to you as connection profiles. Instead, you edit the properties of the VPN topology, and during deployment, Security Manager will translate the configuration into the appropriate L2L tunnel group commands.
  
        
 
         
         	[bookmark: pgfId-487543]There are inconsistencies in the policies or values in the VPN configurations across the devices in the VPN.
  
         	
           
           	 [bookmark: pgfId-487545]If the values on the hub and the spokes differ, preference is given to the values on the hub.
 
           	 [bookmark: pgfId-487547]If a simple selection of one policy or value from several eligible policies or values is required and does not put functionality at risk, Security Manager selects a single policy/value that is common to all devices. For example, a VPN can have a single IKE policy only, whereas there can be more than one IKE policy on the devices.
 
           	 [bookmark: pgfId-487549]If selecting one value puts the functionality at risk, no value is discovered for the policy and a validation message is received upon deployment.
 
           	 [bookmark: pgfId-487551]If numeric values differ, a message is generated during discovery, and the lower value is discovered. For example, the lowest SA lifetime value in an IPsec policy.
 
           	 [bookmark: pgfId-487553]If none of the above options are possible, VPN discovery fails.
 
          
  
        
 
         
         	[bookmark: pgfId-487559]Preshared key configuration—there is a different key per set of peers.
  
         	[bookmark: pgfId-487563]The preshared key policy is not discovered; you will have to configure it after discovery is completed. Security Manager discovers preshared key policies only when the preshared key has the same value on all devices. [bookmark: marker-487561]
  
        
 
         
         	[bookmark: pgfId-487569]There is more than one eligible crypto map on the device.
  
         	[bookmark: pgfId-487571]The crypto map that is associated with all or the majority of the devices selected for VPN discovery is used.
  
        
 
         
         	[bookmark: pgfId-487577]A spoke does not have a crypto map associated with the hub.
  
         	[bookmark: pgfId-487579]VPN discovery proceeds but the spoke is not discovered and an error message is generated.
  
        
 
         
         	[bookmark: pgfId-487585]A device does not have the selected transform set value.
  
         	[bookmark: pgfId-487587]VPN discovery proceeds but the device might removed from the VPN topology.
  
        
 
         
         	[bookmark: pgfId-487593]A device does not have the selected IKE proposal.
  
         	[bookmark: pgfId-487595]VPN discovery proceeds but the device might removed from the VPN topology.
  
        
 
         
         	[bookmark: pgfId-487601]A device supports DVTI, but does not have DVTI or a crypto map configured.
  
         	[bookmark: pgfId-487603]VPN discovery fails.
  
        
 
         
         	[bookmark: pgfId-487609]A server supports DVTI, but does not have an IP address configured in the DVTI configuration.
  
         	[bookmark: pgfId-487611]VPN discovery proceeds but with a warning.
  
        
 
         
         	[bookmark: pgfId-487617]A client does not support DVTI.
  
         	[bookmark: pgfId-487619]If the hub is configured with DVTI, discovery proceeds without any warning or Error.
  
        
 
         
         	[bookmark: pgfId-487625]A Hub and Spoke topology where the spokes are not using the same VPNSPA/VSPA slot on the hub (Catalyst 6500/7600).
  
         	[bookmark: pgfId-487627]VPN discovery fails.
  
        
 
         
         	[bookmark: pgfId-487633]The same set of key servers and group members are participating in more than one GET VPN.
  
         	[bookmark: pgfId-487635]Security Manager discovers only one of the topologies.
  
        
 
         
         	[bookmark: pgfId-487641]A User Group policy is configured with backup servers using hostnames instead of an IP addresses.
  
         	[bookmark: pgfId-487643]VPN policy discovery fails with the following error:
 [bookmark: pgfId-487645]Policy Discovery Failed: com.cisco.nm.vms.discovery.DiscoveryException: Internal Error
 [bookmark: pgfId-487647]In order for discovery to be successful, you need to reconfigure the user group policy on the device with backup servers using IP address, not hostnames.
  
        
 
       
      
 
     
 
     [bookmark: pgfId-491323]Related Topics
 
      
      	 [bookmark: pgfId-491328]Supported and Unsupported Technologies and Topologies for VPN Discovery
 
      	 [bookmark: pgfId-491333]Prerequisites for VPN Discovery
 
      	 [bookmark: pgfId-491338]Discovering Site-to-Site VPNs
 
      	 [bookmark: pgfId-491343]Rediscovering Site-to-Site VPNs
 
     
 
    
 
     
      [bookmark: pgfId-491365][bookmark: 65378][bookmark: vpchap_proc_DiscoveringSitetoSiteVPNs]Discovering Site-to-Site VPNs[bookmark: marker-491353][bookmark: marker-491355][bookmark: marker-491357][bookmark: marker-491359][bookmark: marker-491361][bookmark: marker-491363]
 
     [bookmark: pgfId-491367]This procedure describes how to discover a Site-to-Site VPN that is already working in your network but that has not yet been defined in Security Manager.
 
     [bookmark: pgfId-491369]Related Topics
 
      
      	 [bookmark: pgfId-491374]Discovering Site-to-Site VPNs
 
      	 [bookmark: pgfId-491379]Discovering Policies
 
      	 [bookmark: pgfId-491384]Supported and Unsupported Technologies and Topologies for VPN Discovery
 
      	 [bookmark: pgfId-491389]Prerequisites for VPN Discovery
 
      	 [bookmark: pgfId-491394]VPN Discovery Rules
 
      	 [bookmark: pgfId-491399]Understanding Devices Supported by Each IPsec Technology
 
      	 [bookmark: pgfId-491404]Including Unmanaged or Non-Cisco Devices in a VPN
 
     
 
     
 
     [bookmark: pgfId-491406]Step 1 In Device view, select Policy > Discover VPN Polices to open the Discover VPN Policies Wizard—Name and Technology page.
 
     [bookmark: pgfId-491408]Step 2 Specify the following information:
 
      
      	 [bookmark: pgfId-491410] VPN Name —The name of the VPN being discovered.
 
     
 
     [bookmark: pgfId-491412]You cannot specify the name when discovering Extranet VPNs. Instead, Security Manager discovers all Extranets defined on the device, and for each Extranet, the VPN name is a hyphenation of the local and remote IP addresses. For example, if the local address is 10.100.10.1 and the remote address is 10.100.11.1, the Extranet VPN is named 10.100.10.1-10.100.11.1.
 
      
      	 [bookmark: pgfId-491414] Description —An optional description of the VPN. You cannot add a description to Extranet VPN discovery.
 
      	 [bookmark: pgfId-491416] Topology —The type of VPN that you are discovering—Hub and Spoke, Point to Point, Full Mesh, or Extranet.
 
      	 [bookmark: pgfId-491418] IPsec Technology —The IPsec technology assigned to the VPN—Regular IPsec, IPsec/GRE, GRE Dynamic IP (sub-technology), DMVPN, Easy VPN, or GET VPN. The topology you select controls what is available in this list.
 
     
 
     [bookmark: pgfId-491420]If you selected IPsec/GRE, you must also specify the type which may be Standard (for IPsec/GRE) or Spokes with Dynamic IP (to configure GRE Dynamic IP).
 
      
      	 [bookmark: pgfId-491422] Discover From —You can either discover the VPN directly from the network or from Configuration Archive.
 
     
 
     [bookmark: pgfId-491424] – Network—Security Manager connects to all live devices to obtain the device configuration. For Extranet VPN discovery, Security Manager connects to the single managed device that you specify.
 
     [bookmark: pgfId-491426] – Config Archive—Discovery from Configuration Archive is recommended if you deploy to configuration files instead of live devices. The most recent version of the device configuration in Configuration Archive is used for all devices.
 
     [bookmark: pgfId-491428]Step 3 Click Next to open the Discover VPN Policies Wizard—Device Selection Page.
 
     [bookmark: pgfId-491430]Step 4 Select the devices participating in the VPN and their role in the VPN (hub, spoke, peer one, peer two, local device, key server, group member, or simply selected devices for full-mesh VPNs) depending on the topology type. For Easy VPN topologies, servers are hubs and clients are spokes.
 
     [bookmark: pgfId-491432]If there are two or more IPsec terminators in a hub-and-spoke VPN, use the Up and Down arrow buttons to ensure the primary hub is listed first. When there is only one IPsec terminator, regardless of how many hubs are connected to the same IPsec terminator, it is not possible to designate one hub as the primary hub.
 
     [bookmark: pgfId-491437]For more detailed information on selecting devices for a VPN, see Selecting Devices for Your VPN Topology.
 
     [bookmark: pgfId-491442]Step 5 Click Finish to close the wizard and start the discovery process. The Discovery Status window opens and displays the status of the discovery and indicates whether the discovery of each device has been successful or has failed (see Viewing Policy Discovery Task Status). Error or warning messages are provided to indicate the source of any problems, which may be VPN specific or device specific.
 
     [bookmark: pgfId-491444]Except for Extranet discovery, when the discovery process completes successfully, and you close the Discovery Status dialog box, the Site-to-Site VPN Manager window opens, displaying summary information for the VPN that was discovered. For Extranet discovery, you must either manually open the Site-to-Site VPN Manager, or select the Site-to-Site VPN policy in Device view, to see the list of discovered Extranet VPNs.
 
     [bookmark: pgfId-491446]Step 6 Verify that the VPN polices are as required. Edit the policies as necessary.
 
      
       
     
 
     
 
     [bookmark: pgfId-491448]Tip When discovering Extranet VPNs, all Extranet VPNs defined on the selected device are discovered. Delete the ones that you do not want to manage in Security Manager.

     
      

     

     
 
     [bookmark: pgfId-491450]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-491460][bookmark: 65476][bookmark: vpchap_proc_DefiningorRepairingDiscoveredVPNswithMultipleSpokeDefinitions]Defining or Repairing Discovered VPNs with Multiple Spoke Definitions [bookmark: marker-491456][bookmark: marker-491458]
 
     [bookmark: pgfId-491462]If you discover a VPN whose spokes contain different definitions (for example, different client modes for Easy VPN spokes), Security Manager changes the definitions during discovery to create a uniform definition for all spokes. This behavior occurs because VPN topologies in Security Manager can contain only one set of spoke definitions.
 
     [bookmark: pgfId-491464]If you want to maintain your original definitions, or create a new VPN that has spokes with different definitions, you can choose one of two approaches:
 
      
      	 [bookmark: pgfId-491466]Define multiple VPN topologies in Security Manager, where each topology includes spokes containing matching spoke definitions.
 
      	 [bookmark: pgfId-491468]Define a FlexConfig policy that contains the specialized definition, then assign the policy to the spokes that require this definition, as described in the following procedure.
 
     
 
     [bookmark: pgfId-491470]Related Topics
 
      
      	 [bookmark: pgfId-491475]Creating a New Shared Policy
 
      	 [bookmark: pgfId-491480]Creating FlexConfig Policy Objects
 
      	 [bookmark: pgfId-491485]Modifying Policy Assignments in Policy View
 
      	 [bookmark: pgfId-491490]Site-To-Site VPN Discovery
 
      	 [bookmark: pgfId-491495]Discovering Site-to-Site VPNs
 
      	 [bookmark: pgfId-491500]VPN Discovery Rules
 
     
 
     
 
     [bookmark: pgfId-491502]Step 1 Create a shared FlexConfig policy in Policy view:
 
     [bookmark: pgfId-491504] a. Select View > Policy View.
 
     [bookmark: pgfId-491506] b. Right-click FlexConfigs in the Policy Type selector, then select New FlexConfigs Policy.
 
     [bookmark: pgfId-491508] c. Enter a name for the policy and click OK.
 
     [bookmark: pgfId-491510]Step 2 Define the FlexConfig policy by creating and selecting a FlexConfig object:
 
     [bookmark: pgfId-491512] a. In the work area of Policy view, click the Add button on the Details tab.
 
     [bookmark: pgfId-491517] b. In the FlexConfigs Selector, click the Create button in the lower-left corner of the window to open Add or Edit FlexConfig Dialog Box.
 
     [bookmark: pgfId-491519] c. Define an appended FlexConfig object that contains the required client definition. For example, to define the client mode on an Easy VPN spoke, enter the following commands:
 
     [bookmark: pgfId-491521]crypto ipsec client ezvpn CSM_EASY_VPN_CLIENT_1
 
     [bookmark: pgfId-491523]mode client
 
     [bookmark: pgfId-491525]exit
 
     [bookmark: pgfId-491527] d. After you create the FlexConfig object, add it to the FlexConfig policy using the selector.
 
     [bookmark: pgfId-491529]Step 3 In the work area of Policy view, use the Assignments tab to select the spokes to which this policy should be assigned, then click Save.
 
     [bookmark: pgfId-491531]Step 4 Deploy the policy.
 
     [bookmark: pgfId-491533]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-491555][bookmark: 65554][bookmark: vpchap_proc_RediscoveringSitetoSiteVPNs]Rediscovering Site-to-Site VPNs[bookmark: marker-491543][bookmark: marker-491545][bookmark: marker-491547][bookmark: marker-491549][bookmark: marker-491551][bookmark: marker-491553]
 
     [bookmark: pgfId-491557]You can rediscover the configurations of existing VPN topologies that are already managed with Security Manager so that you do not have to recreate policies changes in the application.
 
     [bookmark: pgfId-491559]The same rules by which Security Manager translates and discovers VPN configurations apply also to rediscovery. However, you can perform rediscovery only on devices that participate in a VPN topology, and you cannot make any changes to the IPsec technology or topology type. Only the configurations of device specific policies, such as VPN interfaces and protected networks, and any High Availability (HA) policies that are configured on hubs, can be rediscovered. VPN global policies, such as IKE proposals or PKI enrollments, cannot be rediscovered. In addition, you cannot rediscover the following topologies:
 
      
      	 [bookmark: pgfId-491561]Easy VPN topologies with Dynamic VTI
 
      	 [bookmark: pgfId-491563]Extranet VPNs
 
     
 
     [bookmark: pgfId-491565]This procedure describes how to rediscover the configurations of a Site-to-Site VPN topology that already exists in Security Manager.
 
     [bookmark: pgfId-491567]Related Topics
 
      
      	 [bookmark: pgfId-491572]Discovering Site-to-Site VPNs
 
      	 [bookmark: pgfId-491577]Discovering Policies
 
      	 [bookmark: pgfId-491582]Prerequisites for VPN Discovery
 
      	 [bookmark: pgfId-491587]VPN Discovery Rules
 
      	 [bookmark: pgfId-491592]Understanding Devices Supported by Each IPsec Technology
 
      	 [bookmark: pgfId-491597]Including Unmanaged or Non-Cisco Devices in a VPN
 
     
 
     
 
     [bookmark: pgfId-491599]Step 1 In the Site-to-Site VPN Manager window, right-click the VPN topology whose configurations you want to rediscover and select Rediscover Peers. This opens the Rediscover VPN Policies Wizard—Name and Technology page.
 
     [bookmark: pgfId-491601]This page displays the type of topology and IPsec technology used in the VPN, which you cannot change.
 
     [bookmark: pgfId-491603]Step 2 Specify the following information:
 
      
      	 [bookmark: pgfId-491605] VPN Discovery Name —The name of the rediscover VPN job.
 
      	 [bookmark: pgfId-491607] Description —An optional description of the VPN.
 
      	 [bookmark: pgfId-491609] Discover From —You can either rediscover the VPN directly from the network or from Configuration Archive.
 
     
 
     [bookmark: pgfId-491611] – Network—Security Manager connects to all live devices to obtain the device configuration.
 
     [bookmark: pgfId-491613] – Config Archive—Rediscovery from Configuration Archive is recommended if you deploy to configuration files instead of live devices. The most recent version of the device configuration in Configuration Archive is used for all devices.
 
     [bookmark: pgfId-491615]Step 3 Click Next to open the Rediscover VPN Policies Wizard—Device Selection page.
 
     [bookmark: pgfId-491617]Step 4 Select the devices whose peer level policies need to be rediscovered and their role in the VPN (hub, spoke, peer one, peer two, key server, group member, or simply selected devices for full-mesh VPNs) depending on the topology type. For Easy VPN topologies, servers are hubs and clients are spokes.
 
     [bookmark: pgfId-491619]If there are two or more IPsec terminators in a hub-and-spoke VPN, use the Up and Down arrow buttons to ensure the primary hub is listed first. When there is only one IPsec terminator, regardless of how many hubs are connected to the same IPsec terminator, it is not possible to designate one hub as the primary hub.
 
     [bookmark: pgfId-491624]For more detailed information on selecting devices for a VPN, see Selecting Devices for Your VPN Topology.
 
     [bookmark: pgfId-491629]Step 5 Click Finish to close the wizard and start the rediscovery process. The Discovery Status window opens and displays the status of the rediscovery and indicates whether the rediscovery of each device has been successful or has failed (see Viewing Policy Discovery Task Status). Error or warning messages are provided to indicate the source of any problems, which may be VPN specific or device specific.
 
     [bookmark: pgfId-491631]When the rediscovery process completes successfully, and you close the Discovery Status dialog box, the Site-to-Site VPN Manager window opens, displaying summary information for the VPN that was rediscovered.
 
     [bookmark: pgfId-491633]

     
      

     

     
 
    
 
   
 
    
     [bookmark: pgfId-491649][bookmark: 65642][bookmark: vpchap_cncpt_CreatingaVPNTopology]Creating or Editing VPN Topologies[bookmark: marker-491639][bookmark: marker-491641][bookmark: marker-491643][bookmark: marker-491645][bookmark: marker-491647]
 
    [bookmark: pgfId-491654]Security Manager supports three basic types of topologies with which you can create a site-to-site VPN. Use the Create VPN wizard to create a hub-and-spoke, point-to-point, or full mesh VPN topology across multiple device types. For more information about these topologies, see Understanding VPN Topologies.
 
     
      
    
 
    
 
    [bookmark: pgfId-491659]Tip If you want to create an Extranet point-to-point VPN, read Creating or Editing Extranet VPNs instead of this topic.

    
     

    

    
 
    [bookmark: pgfId-491664]Creating a VPN topology involves specifying the devices and the networks that make up the site-to-site VPN. You define the devices and their roles (such as hub, spoke, peer, key server, group member), the VPN interfaces that are the source and destination endpoints of the VPN tunnel, and the protected networks that will be secured by the tunnel. When you create a VPN topology, you assign to it the IPsec technology (such as Regular IPSec, IPSec/GRE, GRE Dynamic IP, DMVPN, Large Scale DMVPN, Easy VPN, GET VPN) with which a predefined set of policies is associated. See Understanding Mandatory and Optional Policies for Site-to-Site VPNs.
 
     
      
    
 
    
 
    [bookmark: pgfId-491669]Note When you complete the Create VPN wizard, your topology might be immediately deployable, because Security Manager provides defaults for mandatory policies. However, if you use Security Manager defaults, be sure to verify that the settings will work properly in your network. For more information, see Understanding and Configuring VPN Default Policies.

    
     

    

    
 
    [bookmark: pgfId-491674]When you edit a VPN topology, the Edit VPN dialog box contains the same pages as the Create VPN wizard (except for the VPN defaults page), but the pages are laid out in a tabbed format rather than being presented as a wizard. The only exception is for GET VPN topologies, where you can edit only the name and description of the topology (you must edit GET VPN policies to change topology attributes, see Configuring GET VPN). Clicking OK on any tab in the dialog box saves your definitions on all the tabs. For all topologies, you must edit mandatory and optional policies originally presented on the VPN defaults page directly.
 
    [bookmark: pgfId-491676]By editing a VPN topology, you can change its device structure (adding or removing devices), change the VPN interfaces and protected networks defined for a device, or modify the policies that are assigned to the VPN. For example, if your organization frequently opens new sites, you might need to add spokes to an existing hub-and-spoke VPN while applying all policies of the VPN to the new spokes. Or, you might want to increase resiliency by adding a secondary hub to a VPN that has only one hub. While editing a VPN topology, you might also need to modify the policies assigned to it, for example, to change an IKE algorithm to a more secured one, or to change the DES encryption algorithm for a VPN to make it more secure.
 
     
      
    
 
    
 
    [bookmark: pgfId-491678]Tip After you create a topology, you cannot change the technology used in the VPN. Instead, you must delete the old VPN and create a new one using the desired technology.

    
     

    

    
 
    [bookmark: pgfId-491680]To start the Create VPN wizard, or to edit an existing VPN topology:
 
     
     	 [bookmark: pgfId-491685]To open the Create VPN wizard, in the Site-to-Site VPN Manager Window or the Site-to-Site VPN policy page (Device View), click the  Create VPN Topology (+) button and select the type of VPN topology you want to create from the options that are displayed—Hub and Spoke, Point to Point, or Full Mesh. Use the Back and Next buttons to move through the pages; when finished, click Finish to create the topology.
 
     	 [bookmark: pgfId-491687]To open the Edit VPN dialog box, select the VPN topology in the Site-to-Site VPN Manager window or the Site-to-Site VPN policy page (Device View) and click the  Edit VPN Topology (pencil) button.
 
    
 
    [bookmark: pgfId-491689]The pages or tabs that appear and their sequence depend on the type of VPN topology you are creating, as explained in the following table.
 
    [bookmark: pgfId-491692]
 
     
      
       
       [bookmark: pgfId-487666]Table 25-4 [bookmark: 65686]Create/Edit VPN Wizard Pages 
 
       
      
        
        	
          
          [bookmark: pgfId-487678]Page
         
  
        	 
          
          [bookmark: pgfId-487680]Hub and Spoke VPN
         
  
        	
          
          [bookmark: pgfId-487684]Point to Point VPN
         
  
        	
          
          [bookmark: pgfId-487686]Full Mesh VPN
         
  
       
 
        
        	[bookmark: pgfId-487698]Name and Technology Page.
 [bookmark: pgfId-487703]See Defining the Name and IPsec Technology of a VPN Topology.
  
        	 [bookmark: pgfId-487705]Step 1
  
        	[bookmark: pgfId-487709]Step 1
  
        	[bookmark: pgfId-487711]Step 1
  
       
 
        
        	[bookmark: pgfId-487723]Device Selection Page.
 [bookmark: pgfId-487728]See Selecting Devices for Your VPN Topology.
  
        	 [bookmark: pgfId-487730]Step 2
  
        	[bookmark: pgfId-487734]Step 2
  
        	[bookmark: pgfId-487736]Step 2
  
       
 
        
        	[bookmark: pgfId-487748]Endpoints Page.
 [bookmark: pgfId-487753]See Defining the Endpoints and Protected Networks.
 [bookmark: pgfId-487755]From this page, you can also create several advanced configurations; see the information following the table for further explanation.
  
        	 [bookmark: pgfId-487757]Step 3
  
        	[bookmark: pgfId-487761]Step 3
  
        	[bookmark: pgfId-487763]Step 3 (Regular IPSec, IPSec GRE only)
  
       
 
        
        	[bookmark: pgfId-487775]High Availability Page.
 [bookmark: pgfId-487780]See Configuring High Availability in Your VPN Topology.
  
        	 [bookmark: pgfId-487782]Step 4
  
        	[bookmark: pgfId-487786]—
  
        	[bookmark: pgfId-487788]—
  
       
 
        
        	[bookmark: pgfId-487800]GET VPN Group Encryption Policy Page.
 [bookmark: pgfId-487805]See Defining GET VPN Group Encryption.
  
        	 [bookmark: pgfId-487807]—
  
        	[bookmark: pgfId-487811]—
  
        	[bookmark: pgfId-487813]Step 3 (GET VPN only.)
  
       
 
        
        	[bookmark: pgfId-487825]GET VPN Peers Page.
 [bookmark: pgfId-487830]See Defining GET VPN Peers.
  
        	 [bookmark: pgfId-487832]—
  
        	[bookmark: pgfId-487836]—
  
        	[bookmark: pgfId-487838]Step 4 (GET VPN only.)
  
       
 
        
        	[bookmark: pgfId-487850]VPN Defaults Page.
 [bookmark: pgfId-487855]See Assigning Initial Policies (Defaults) to a New VPN Topology.
  
        	 [bookmark: pgfId-487857]Step 5
  
        	[bookmark: pgfId-487861]Step 4
  
        	[bookmark: pgfId-487863]Step 4 (Step 5 for GET VPN.)
  
       
 
        
        	[bookmark: pgfId-487875]Synchronize Keys dialog box. When completing the Create VPN wizard for a GET VPN, you are asked if you want to synchronize keys. Clicking Yes initiates the process.
 [bookmark: pgfId-487880]See Generating and Synchronizing RSA Keys.
  
        	 [bookmark: pgfId-487882]—
  
        	[bookmark: pgfId-487886]—
  
        	[bookmark: pgfId-487888]Step 6 (GET VPN only.)
  
       
 
      
     
 
    
 
    [bookmark: pgfId-491694]Either during or after you create a VPN topology, you can also create the following advanced configurations when editing endpoints:
 
     
     	 [bookmark: pgfId-491699]VRF-Aware IPsec on a hub in a hub-and-spoke topology (see Configuring VRF Aware IPsec Settings).
 
     	 [bookmark: pgfId-491704]A VPNSM or VPNSPA/VSPA on a Catalyst 6500/7600 in a hub-and-spoke, point-to-point, or full mesh VPN topology (see Configuring VPNSM or VPN SPA/VSPA Endpoint Settings).
 
     	 [bookmark: pgfId-491709]A Firewall Services Module together with a VPN Services Module or VPN SPA on a Catalyst 6500/7600 device in a hub-and-spoke, point-to-point, or full mesh VPN topology (see Configuring a Firewall Services Module (FWSM) Interface with VPNSM or VPNSPA/VSPA).
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-491714]Note You can create a visual representation of your VPN topology with all its elements in the Map view. For more information, see Creating VPN Topologies in Map View.

    
     

    

    
 
    [bookmark: pgfId-491716]Related Topics
 
     
     	 [bookmark: pgfId-491721]Configuring VPN Topologies in Device View
 
     	 [bookmark: pgfId-491726]Understanding IPsec Technologies and Policies
 
     	 [bookmark: pgfId-491731]Using Wizards
 
    
 
     
      [bookmark: pgfId-491747][bookmark: 65824][bookmark: vpchap_proc_DefiningaNameandIPsecTechnology]Defining the Name and IPsec Technology of a VPN Topology[bookmark: marker-491739][bookmark: marker-491741][bookmark: marker-491743][bookmark: marker-491745]
 
      
       
     
 
     
 
     [bookmark: pgfId-491752]Note This topic does not apply to Extranet VPNs. For information about configuring the name of an Extranet VPN, see Creating or Editing Extranet VPNs.

     
      

     

     
 
     [bookmark: pgfId-491754]Use the Name and Technology page (or tab) of the Create VPN wizard and Edit VPN dialog box to define a name and description for the VPN topology. When creating a new topology, you must select the IPsec technology that will be assigned to it, but you cannot change the technology when editing an existing topology.
 
     [bookmark: pgfId-491759]For information on opening the Create VPN wizard or Edit VPN dialog box, see Creating or Editing VPN Topologies.
 
      
       
     
 
     
 
     [bookmark: pgfId-491761]Note If you are editing an existing VPN, the assigned IPsec technology and type is displayed, but you cannot change them. To change the technology or type, you must delete the topology and create a new one.

     
      

     

     
 
      
       
        
        [bookmark: pgfId-487901]Table 25-5 [bookmark: 65848]Name and Technology Page 
 
        
       
         
         	
           
           [bookmark: pgfId-487907]Element
          
  
         	
           
           [bookmark: pgfId-487909]Description
          
  
        
 
         
         	[bookmark: pgfId-487915]Name
  
         	[bookmark: pgfId-487917]A unique name that identifies the VPN topology.
  
        
 
         
         	[bookmark: pgfId-487923]Description
  
         	[bookmark: pgfId-487925]Information about the VPN topology.
  
        
 
         
         	[bookmark: pgfId-487931]IPsec Technology
  
         	[bookmark: pgfId-487933]The IPsec technology used in the VPN topology:
 
           
           	 [bookmark: pgfId-487935]Regular IPsec
 
           	 [bookmark: pgfId-487937]IPsec/GRE
 
           	 [bookmark: pgfId-487939]DMVPN (Hub and Spoke VPN only)
 
           	 [bookmark: pgfId-487941]Easy VPN (Hub and Spoke VPN only)
 
           	 [bookmark: pgfId-487943]GET VPN (Full Mesh VPN only)
 
          
  
        
 
         
         	[bookmark: pgfId-487949]Type
  
         	[bookmark: pgfId-487951]The technology type if the selected IPsec technology is IPsec/GRE or DMVPN for a hub-and-spoke topology:
 
           
           	 [bookmark: pgfId-487956]IPsec/GRE—Select either  Standard (for IPsec/GRE) or  Spokes with Dynamic IP (for GRE Dynamic IP). For more information, see Understanding GRE Configuration for Dynamically Addressed Spokes.
 
           	 [bookmark: pgfId-487961]DMVPN—Select either  Standard (for regular DMVPN) or  Large Scale with IPsec Terminator (for a large scale DMVPN). For more information, see Configuring Large Scale DMVPNs.
 
          
  
        
 
         
         	[bookmark: pgfId-487967]IKE version
  
         	[bookmark: pgfId-487969]When configuring regular IPsec topologies, the Internet Key Exchange (IKE) version to allow in IKE negotiations. You can allow version 1 (IKEv1), version 2 (IKEv2), or both IKEv1 & IKEv2.
 [bookmark: pgfId-487971]If you select IKEv1 & IKEv2, IKEv1 is automatically used by any device that does not support IKEv2. However, if you select IKEv2 only, you must ensure that you do not select any devices that do not support IKEv2 (the wizard does not prevent an invalid selection). You can edit the IKE Proposal and IPsec Proposal policies to change which IKE versions are supported after creating the VPN if you select the wrong option.
 [bookmark: pgfId-487979]For information on IKE and how these versions differ, see Overview of IKE and IPsec Configurations. For information on devices that support IKEv2, see Understanding Devices Supported by Each IPsec Technology.
 [bookmark: pgfId-487981]Tip When using the Create VPN wizard, if you select an option that allows IKEv2, the wizard never creates a valid topology. After completing the wizard, you must manually configure the IKEv2 Authentication policy to complete the configuration.  
        
 
       
      
 
     
 
     [bookmark: pgfId-491768]Related Topics
 
      
      	 [bookmark: pgfId-491773]Understanding IPsec Technologies and Policies
 
     
 
    
 
     
      [bookmark: pgfId-491791][bookmark: 65921][bookmark: vpchap_proc_SelectingDevicesforYourVPNTopology]Selecting Devices for Your VPN Topology[bookmark: marker-491781][bookmark: marker-491783][bookmark: marker-491785][bookmark: marker-491787][bookmark: marker-491789]
 
      
       
     
 
     
 
     [bookmark: pgfId-491796]Note This topic does not apply to Extranet VPNs. For information about selecting devices in an Extranet VPN, see Creating or Editing Extranet VPNs.

     
      

     

     
 
     [bookmark: pgfId-491804]Use the Device Selection page (or tab) of the Create VPN wizard and Edit VPN dialog box to select the devices to include in the VPN topology. The contents of this page differ depending on whether you are creating or editing a hub-and-spoke, large scale DMVPN, point-to-point, or full mesh VPN topology. Also, you cannot use this page to edit the membership in a GET VPN (instead, see Configuring GET VPN Group Members and Configuring GET VPN Key Servers when working with an existing GET VPN).
 
     [bookmark: pgfId-491809]For information on opening the Create VPN wizard or Edit VPN dialog box, see Creating or Editing VPN Topologies.
 
     [bookmark: pgfId-491814]In most cases, the devices that are listed in the Available Devices list include only those that can be used for the selected VPN topology type, that support the IPsec technology type, and which you are authorized to view. In addition, the available devices depend on the selected IPsec technology—for example, if the IPsec technology is IPsec/GRE, GRE Dynamic IP, or DMVPN, PIX Firewalls and ASA devices are not displayed. However, the lists are not adjusted to account for the IKE versions you are supporting in the topology. For more information, see the supported platforms described in Understanding Devices Supported by Each IPsec Technology.
 
      
       
     
 
     
 
     [bookmark: pgfId-491816]Tip When selecting devices, you can select a device group to select all of the eligible devices in the group.

     
      

     

     
 
     [bookmark: pgfId-491818]The following list explains how to add or remove devices based on the type of topology:
 
      
      	 [bookmark: pgfId-491820] To select devices for a full mesh VPN topology with Regular IPSec or IPSec/GRE technology , select them in the Available Devices list and click  >> .
 
      	 [bookmark: pgfId-491822] To select devices for a full mesh VPN topology that uses the GET VPN technology: 
 
     
 
     [bookmark: pgfId-491824] – Select the devices that you want to define as key servers and click >> next to the Key Servers field.
 
     [bookmark: pgfId-491826]If you have more than one key server, use the Up and Down arrow buttons to ensure the primary key server is listed first. Group members register with the first key server in the list. If the first key server cannot be reached, they try to register with the second key server, and so on.
 
     [bookmark: pgfId-491828] – Select the devices that you want to define as group members and click >> next to the Group Members field.
 
      
      	 [bookmark: pgfId-491830] To select devices for a hub-and-spoke VPN topology :
 
     
 
     [bookmark: pgfId-491832] – Select the devices that you want to define as hubs (or servers in an Easy VPN configuration) and click >> next to the Hubs list.
 
     [bookmark: pgfId-491834]If you have more than one hub, ensure the hubs list is in priority order with the primary hub listed first. To change the order, select a hub and click the Up and Down arrow buttons until the device is ordered as desired.
 
      
       
     
 
     
 
     [bookmark: pgfId-491836]Note You need to select the primary hub only when there are two or more IPsec terminators. When there is only one IPsec terminator, regardless of how many hubs are connected to the same IPsec terminator, it is not possible to designate one hub as the primary hub.

     
      

     

     
 
     [bookmark: pgfId-491838] – Select the devices that you want to define as spokes (or clients in an Easy VPN configuration) and click >> next to the Spokes list.
 
     [bookmark: pgfId-491843] – If you are configuring a Large Scale DMVPN with IPsec Terminator topology, you must also select the Catalyst 6500/7600 devices you want to be IPsec Terminators in your Large Scale DMVPN configuration. If you select more than one IPsec Terminator, use the Up and Down arrow buttons to put them in priority order. For more information, see Configuring Large Scale DMVPNs.
 
      
      	 [bookmark: pgfId-491845] To select devices for a point-to-point VPN topology: 
 
     
 
     [bookmark: pgfId-491847] – From the Devices list, select a device to be Peer One and click >>.
 
     [bookmark: pgfId-491849] – Select another device to be Peer Two and click >>.
 
      
      	 [bookmark: pgfId-491851] To remove devices (any topology or technology combination) , select them from one of the selected devices lists and click  << to move them back to the Available Devices list.
 
     
 
     [bookmark: pgfId-491853]If you are editing an existing VPN topology, you can remove devices from the VPN topology, but you cannot save your changes if your device selections result in an invalid VPN configuration. When removing devices, you should be aware of the following:
 
     [bookmark: pgfId-491855] – You cannot remove a device if it is the only hub in a hub-and-spoke VPN topology, unless you replace it with a different hub.
 
     [bookmark: pgfId-491857] – You cannot remove a device that is one of the two devices in a point-to-point VPN topology, unless you replace it with a different device.
 
     [bookmark: pgfId-491859] – In a VPN topology with multiple hub devices, deleting a hub causes the appropriate tunnels to be removed.
 
     [bookmark: pgfId-491861] – If some, but not all, spokes in a VPN topology are deleted, the hub side crypto statements change to reflect the removal.
 
     [bookmark: pgfId-491863] – GET VPNs must have at least one key server and one group member.
 
     [bookmark: pgfId-491865]Related Topics
 
      
      	 [bookmark: pgfId-491870]Including Unmanaged or Non-Cisco Devices in a VPN
 
     
 
    
 
     
      [bookmark: pgfId-491898][bookmark: 66030][bookmark: vpchap_proc_DefiningtheEndpointsandProtectedNetworks]Defining the Endpoints and Protected Networks[bookmark: marker-491880][bookmark: marker-491882][bookmark: marker-491884][bookmark: marker-491886][bookmark: marker-491888][bookmark: marker-491890][bookmark: marker-491892][bookmark: marker-491894][bookmark: marker-491896]
 
     [bookmark: pgfId-491900]Use the Endpoints page of the Create VPN wizard and Edit VPN dialog box, or the Peers policy, to view the devices in your VPN topology and to define or edit their VPN characteristics and features. You are primarily defining the external or internal VPN interfaces and the protected networks for the devices in the VPN topology. The VPN interfaces are the interfaces that encrypt the data. The protected networks are the networks that are encrypted.
 
     [bookmark: pgfId-491902]To get to the Endpoints page, do any of the following:
 
      
      	 [bookmark: pgfId-491907]Open the Create VPN wizard or the Edit VPN dialog box; for the procedure, see Creating or Editing VPN Topologies.
 
      	 [bookmark: pgfId-491909]In the Site-to-Site VPN Manager, select the desired VPN topology (excepting GET VPN topologies) and select the  Peers policy.
 
     
 
     [bookmark: pgfId-491911]Tips:
 
      
      	 [bookmark: pgfId-491922]This configuration applies to all IPsec technology types except GET VPN. To configure GET VPN endpoints when creating the VPN, see Defining GET VPN Peers. For existing GET VPNs, configure endpoints using the Key Servers and Group Members policies; see Configuring GET VPN Key Servers and Configuring GET VPN Group Members.
 
      	 [bookmark: pgfId-491927]The devices listed on this page are selected in the Device Selection Page (see Selecting Devices for Your VPN Topology). You can change the list only when editing the Peers policy, where you can select a device and click the  Delete (trash can) button to remove it. To add devices, you must edit the VPN topology itself.
 
      	 [bookmark: pgfId-491929]Although you can edit the endpoints for an Extranet VPN using the Peers policy, you should instead edit the endpoints through the Edit Extranet VPN dialog box by editing the VPN topology. The Endpoints page does not appear in the Create Extranet VPN wizard.
 
     
 
     [bookmark: pgfId-491934]The table shows the role each device plays in the VPN (hub, spoke, peer, or IPsec Terminator), the device name, and the VPN interface and protected networks. Initially, the VPN interface and protected network is set to the default interface roles defined in the Security Manager Administrative settings for external and internal interfaces (see VPN Policy Defaults Page). The endpoint configuration might include configurations not shown in this table, but the VPN interface and protected network are the only required settings.
 
      
      	 [bookmark: pgfId-491936]To change the endpoint configuration for a device, select it and click the  Edit Row button beneath the table. You can select more than one device to edit at a time, but the devices must serve the same role, and you cannot include Catalyst 6500/7600 devices or VPN service modules when selecting multiple devices. You perform endpoint editing in the Edit Endpoints Dialog Box, whose content differs depending on the selected device type and IPsec technology.
 
     
 
     [bookmark: pgfId-491938]See the following topics for detailed information about the options you can configure in the Edit Endpoints dialog box:
 
     [bookmark: pgfId-491946] – VPN Interface tab—To configure the VPN interface and other required interface settings (see Configuring VPN Interface Endpoint Settings). In some cases, you can also configure dial backup (for more information about dial backup, see Configuring Dial Backup).
 
     [bookmark: pgfId-491951]For Catalyst 6500/7600 devices, the VPN Interface tab provides settings that enable you to configure a VPN Services Module (VPNSM) or a VPNSPA/VSPA blade on the device (which might be an IPsec Terminator in a large scale DMVPN), and are described in Configuring VPNSM or VPN SPA/VSPA Endpoint Settings.
 
     [bookmark: pgfId-491956] – Extranet Device Details—To configure the endpoint settings for the remote (unmanaged) device in an Extranet VPN. The tab appears in the Peers policy only. Instead of editing the information on this tab, the preferred method is to edit the VPN topology and change the settings there. For more information, see Creating or Editing Extranet VPNs.
 
     [bookmark: pgfId-491961] – Hub Interface tab—If the selected device is a hub in a large scale DMVPN, specify the interface that is connected to the IPsec Terminator. See Configuring Large Scale DMVPNs.
 
     [bookmark: pgfId-491966] – Protected Networks tab—To define the networks that are encrypted (see Identifying the Protected Networks for Endpoints). The protected network can be an interface role, network/host group object, or in the case of regular IPsec, an ACL policy object.
 
     [bookmark: pgfId-491971] – FWSM tab—To define the settings that enable you to connect between a Firewall Services Module (FWSM) and an IPsec VPN Services Module (VPNSM) or VPNSPA/VSPA that is already configured on a Catalyst 6500/7600 device. This is possible only in a hub-and-spoke topology where the hub is a Catalyst 6500/7600 device that has these modules installed. For more information, see Configuring a Firewall Services Module (FWSM) Interface with VPNSM or VPNSPA/VSPA.
 
     [bookmark: pgfId-491979] – VRF Aware IPsec tab—To configure a VRF-Aware IPsec policy on a hub (IPsec Aggregator) in a hub-and-spoke VPN topology. For more information, see Configuring VRF Aware IPsec Settings and Understanding VRF-Aware IPsec.
 
     [bookmark: pgfId-491984] – Crypto Map tab—To manually configure the Crypto Map name and Crypto ACL name for each peer, which is supported by Security Manager starting with version 4.7. Crypto Map and Crypto ACL are supported in regular IPSec technology. Therefore, this configuration is applicable only for the topologies with regular IPSec technology. For more information see, Configuring Crypto Map
 
      
      	 [bookmark: pgfId-491986]To view the actual interfaces associated with an interface role for each device, select  Matching Interfaces in the  Show list beneath the table. If there are no matching interfaces, “No Match” is displayed. The default is to show the interface role policy object names. To create a valid VPN, these roles must match to actual interfaces defined on the device.
 
     
 
     [bookmark: pgfId-491988]Related Topics
 
      
      	 [bookmark: pgfId-491993]Table Columns and Column Heading Features
 
      	 [bookmark: pgfId-491998]Filtering Tables
 
     
 
    
 
     
      [bookmark: pgfId-492010][bookmark: 66138][bookmark: vpnpage_cncpt_VPNInterfaceTab]Configuring VPN Interface Endpoint Settings[bookmark: marker-492006][bookmark: marker-492008]
 
     [bookmark: pgfId-492015]Use the VPN Interface tab in the Edit Endpoints dialog box to edit the VPN interfaces defined for devices in the Endpoints table. When defining a primary VPN interface for a router device, you can also configure a backup interface to use as a fallback link for the primary route VPN interface, if its connection link becomes unavailable. You can configure a backup interface on a Cisco IOS security router, that is in a point-to-point or full mesh topology, or that is a spoke in a hub-and-spoke topology, or is a remote client in an Easy VPN topology. For more information, see Configuring Dial Backup.
 
     [bookmark: pgfId-492017]Tips
 
      
      	 [bookmark: pgfId-492022]If the device is a hub in a large scale DMVPN, this tab is called  Hub Interface . Specify the interface that is connected to the IPsec Terminator in the  Hub Interface Toward the IPsec Terminator field. Enter the name of the interface or interface role, or click  Select to select it from a list. For more information, see Configuring Large Scale DMVPNs.
 
      	 [bookmark: pgfId-492027]If the device is a Catalyst 6500/7600 device, the VPN Interface tab provides settings that enable you to configure a VPN Services Module (VPNSM) or a VPNSPA/VSPA blade on the device. For a description of the elements that appear on the VPN Interface tab for a Catalyst 6500/7600 device, see Configuring VPNSM or VPN SPA/VSPA Endpoint Settings. The table below assumes the device is not a Catalyst 6500/7600 device.
 
     
 
     [bookmark: pgfId-492029]Navigation Path
 
     [bookmark: pgfId-492034]On the Endpoints Page of the Create VPN wizard or Edit VPN dialog box, or on the VPN Peers policy, select a device and click Edit to open the Edit Endpoints Dialog Box. Select the VPN Interfaces tab in the Edit Endpoints dialog box. For information on how to access these pages and dialog boxes, see Defining the Endpoints and Protected Networks.
 
     [bookmark: pgfId-492036]Field Reference
 
     [bookmark: pgfId-492039]
 
      
       
        
        [bookmark: pgfId-487994]Table 25-6 [bookmark: 66171]Edit Endpoints Dialog Box, VPN Interface Tab 
 
        
       
         
         	
           
           [bookmark: pgfId-488000]Element
          
  
         	
           
           [bookmark: pgfId-488002]Description
          
  
        
 
         
         	[bookmark: pgfId-488008]Enable the VPN Interface Changes on All Selected Peers
  
         	[bookmark: pgfId-488010]Available if you selected more than one device on the Endpoints page for editing.
 [bookmark: pgfId-488012]When selected, applies any changes you make in the VPN interface tab to all the selected devices.
  
        
 
         
         	[bookmark: pgfId-488018]VPN Interface
  
         	[bookmark: pgfId-488023]The VPN interface defined for the selected device. Enter the name of the interface role policy object that defines identifies the interface, or click Select to select it from a list or to create a new interface role object. (See Creating Interface Role Objects.)
 [bookmark: pgfId-488028]If the device is an ASA 5505 version 7.2(1) or later, it must have two interfaces defined with different security levels. For more information, see Managing Device Interfaces, Hardware Ports, and Bridge Groups.
  
        
 
         
         	[bookmark: pgfId-488034]Connection Type
  
         	[bookmark: pgfId-488036]Only available in a hub-and-spoke VPN topology, if the selected device is an ASA or PIX 7.0+ device, and the selected technology is Regular IPsec.
 [bookmark: pgfId-488038]Select the type of connection that the hub or spoke will use during an SA negotiation:
 
           
           	 [bookmark: pgfId-488040] Answer Only —To configure the hub to only respond to an SA negotiation, but not initiate it. This is the default for hubs.
 
           	 [bookmark: pgfId-488042] Originate Only —To configure the device to only initiate an SA negotiation, but not respond to one. This is the default for spokes.
 
           	 [bookmark: pgfId-488044] Bidirectional —To configure the hub or spoke to both initiate and respond to an SA negotiation.
 
          
  
        
 
         
         	[bookmark: pgfId-488050]Local Peer IPSec Termination
  
         	[bookmark: pgfId-488052]Unavailable if the selected technology is Easy VPN.
 [bookmark: pgfId-488054]Specifies the IP address of the VPN interface of the local router. You can select one of the following options:
 
           
           	 [bookmark: pgfId-488056] Tunnel Source IP Address —Use the IP address of the tunnel source.
 
           	 [bookmark: pgfId-488058] VPN Interface IP Address —Uses the configured IP address on the selected VPN interface. Only one VPN interface can match the interface role. This option is available only if you select  Configure Unique Tunnel Source for each Tunnel in the GRE Modes policy.
 
          
 [bookmark: pgfId-488060]Note Beginning with version 4.9, Security Manager enables you to select IPv6 addresses. This feature is supported for interfaces that have IPv6 addresses and is applicable for devices running the ASA software version 9.0 or higher. Also, the option of IPv6 address is available only with Regular IPSec technology.
 
           
           	 [bookmark: pgfId-488062] IP Address —Explicitly specify the IP address of the VPN interface of the local router. Use this option when the device is behind a NAT boundary to specify the NAT IP Address. Beginning with version 4.9, Security Manager enables you to specify IPv6 addresses.
 
          
 [bookmark: pgfId-488064]Note If you select a tunnel source as the VPN interface, it is likely that the VPN interface has a dynamically assigned IP address.
 
           
           	 [bookmark: pgfId-488066] IP Address of Another Existing Interface to be Used as Local Address (unavailable if IPsec technology is DMVPN)—To use the configured IP address on any interface as a local address, not necessarily a VPN interface. Enter the interface in the field provided.
 
          
 [bookmark: pgfId-488068]You can choose the required interface by clicking Select. A dialog box opens that lists all available predefined interface roles, and in which you can create an interface role object.
  
        
 
         
         	[bookmark: pgfId-488074]Tunnel Source
  
         	[bookmark: pgfId-488076]Available only for IPsec/GRE or DMVPN.
 [bookmark: pgfId-488078]If you have enabled the setting to use a unique tunnel source per tunnel interface in the GRE Modes > Tunnel Parameters tab, the Override Unique Tunnel Source per Tunnel Interface check box is available. Select this option to specify a different tunnel source for the selected device.
 [bookmark: pgfId-488080]Specifies the tunnel source address to be used by the GRE or DMVPN tunnel on the spoke side. You can select one of the following options:
 
           
           	 [bookmark: pgfId-488082] VPN Interface —Uses the VPN interface as the tunnel source address.
 
           	 [bookmark: pgfId-488084] Interface —To use any interface as the tunnel source address, not necessarily a VPN interface. Enter the interface name or click  Select to select an interface role that identifies the interface (you can also create a role from the selection dialog box).
 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-488090]Dial Backup Settings
          
  
        
 
         
         	[bookmark: pgfId-488098]Enable Backup
  
         	[bookmark: pgfId-488100]Available if the selected device is an IOS router that is in a point-to-point or full mesh topology, or that is a spoke in a hub-and-spoke topology, or that is a remote client in an Easy VPN topology.
 [bookmark: pgfId-488102]Whether to configure a backup interface to use as a fallback link for the primary route VPN interface, if its connection link becomes unavailable.
 [bookmark: pgfId-488107]Tip Before configuring a backup interface, you must first configure the dialer interface settings on the device. For more information, see Dialer Interfaces on Cisco IOS Routers.  
        
 
         
         	[bookmark: pgfId-488113]Dialer Interface
  
         	[bookmark: pgfId-488115]The logical interface through which the secondary route traffic is directed when the dialer interface is activated. This can be a Serial, Async, or BRI interface.
 [bookmark: pgfId-488117]Enter the name of the interface or interface role object, or click Select to select it from a list.
  
        
 
         
         	[bookmark: pgfId-488123]Primary Next Hop IP Address
  
         	[bookmark: pgfId-488125]Available only if the selected technology is Regular IPsec, IPsec/GRE, GRE Dynamic IP, or Easy VPN.
 [bookmark: pgfId-488127]The IP address to which the primary interface connects when it is active. This is known as the next hop IP address.
 [bookmark: pgfId-488129]If you do not specify the next hop IP address, Security Manager configures a static route using the VPN interface name. The VPN interface must be point-to-point or deployment fails.
 [bookmark: pgfId-488131]You can choose the required IP address by clicking Select. The Network/Hosts selector opens, in which you can select a network from which the IP address will be allocated.
  
        
 
         
         	[bookmark: pgfId-488137]Tracking IP Address
  
         	[bookmark: pgfId-488139]The IP address of the destination device to which connectivity must be maintained from the primary VPN interface connection. This is the device that is pinged by the Service Assurance agent through the primary route to track connectivity. The backup connection is triggered if connectivity to this device is lost.
 [bookmark: pgfId-488141]If you do not specify an IP address, the primary hub VPN interface is used in a hub-and-spoke or Easy VPN topology. In a point-to-point or full mesh VPN topology, the peer VPN interface is used.
 [bookmark: pgfId-488143]You can choose the required IP address by clicking Select. The Network/Hosts selector opens, in which you can select a network from which the IP address will be allocated.
  
        
 
         
         	[bookmark: pgfId-488149]Advanced button
  
         	[bookmark: pgfId-488151]Available if the selected technology is Regular IPsec, IPsec/GRE, GRE Dynamic IP, or Easy VPN.
 [bookmark: pgfId-488156]Click this button to configure additional optional settings using the Dial Backup Settings Dialog Box.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-492051][bookmark: 66297][bookmark: vpchap_proc_ConfiguringDialBackup]Configuring Dial Backup[bookmark: marker-492045][bookmark: marker-492047][bookmark: marker-492049]
 
     [bookmark: pgfId-492053]You can use dial backup to provide a fallback link for a primary, direct connection when the primary link becomes unavailable. You can configure dial backup on Cisco IOS security routers that participate in a point-to-point, Extranet, or full mesh VPN topology, or that are spokes in a hub-and-spoke topology. You can also configure it on a remote client router running IOS version 12.3(14)T+ in an Easy VPN topology.
 
     [bookmark: pgfId-492055]Implementation of the dial backup feature is based on the assumption that two static routes exist:
 
      
      	 [bookmark: pgfId-492057]A primary route through a primary gateway, which has highest priority.
 
      	 [bookmark: pgfId-492059]A secondary route through a secondary gateway, which has lower priority and only appears in the routing table when the primary gateway is down.
 
     
 
     [bookmark: pgfId-492061]Security Manager configures a logical dialer interface on the spoke. The dialer interface is associated with a physical backup interface. When the primary route is down, the dialer interface is activated and traffic is redirected through this backup interface along the secondary route. To ensure that the spoke-hub traffic is encrypted, Security Manager applies a crypto map to the dialer interface. This crypto map is identical to the crypto map on the VPN interface (the primary route interface). In Easy VPN, the backup configuration is attached to the dialer interface.
 
     [bookmark: pgfId-492063]Depending on the IOS version, Response Time Reporter (RTR) or Service Level Agreement (SLA) IOS technology is used to detect loss of network performance on the primary route. If the assigned IPsec technology is DMVPN, Dialer Watch-List (DWL) is used.
 
     [bookmark: pgfId-492065]ISDN Basic Rate Interface (BRI) and analog modem interfaces can be configured as backup interfaces to other primary interfaces. In such a case, an ISDN or analog modem connection is made if the primary interface goes down. Should the primary interface and connection go down, the ISDN or analog modem interface immediately dials out to establish a connection so that network services are not lost.
 
     [bookmark: pgfId-492067]Before You Begin
 
      
      	 [bookmark: pgfId-492072]Configure the dialer interface settings on the Cisco IOS routers. This requires defining the relationship between the physical BRI and Async interfaces, and the virtual dialer interfaces used when configuring dial backup. For more information, see Dialer Interfaces on Cisco IOS Routers.
 
      	 [bookmark: pgfId-492074]Make sure that the primary route is functioning.
 
      	 [bookmark: pgfId-492076]For Extranet VPNs, you can configure dial backup on the local (managed) device only.
 
     
 
     
 
     [bookmark: pgfId-492078]Step 1 For most VPN topologies, you configure dial backup when creating or editing a site-to-site VPN. You can also edit the Peers policy for existing VPN topologies. For Extranet VPNs, you configure dial backup through the Peers policy only.
 
     [bookmark: pgfId-492080]Do one of the following:
 
      
      	 [bookmark: pgfId-492088]In the Create VPN wizard, proceed to the Endpoints page (see Creating or Editing VPN Topologies and Defining the Endpoints and Protected Networks).
 
      	 [bookmark: pgfId-492096]In the Edit VPN dialog box, click the  Endpoints tab (see Creating or Editing VPN Topologies and Defining the Endpoints and Protected Networks).
 
      	 [bookmark: pgfId-492101]For Extranet VPNs, or for editing any other VPN topology, select the Peers policy. For general information on editing endpoints, see Defining the Endpoints and Protected Networks.
 
     
 
     [bookmark: pgfId-492103]Step 2 Select the router on which you want to configure dial backup and click the Edit (pencil) button. If there is more than one router that will have the same dialer configuration, you can select and edit them all at once.
 
     [bookmark: pgfId-492105]This action opens the Edit Endpoints dialog box. Select the VPN Interface tab if it is not already selected.
 
     [bookmark: pgfId-492110]Step 3 On the VPN Interface tab, configure the following options related to dial backup. If you are creating a new VPN, you need to configure the other settings (such as VPN interface) as well. For detailed reference information for these options, see Configuring VPN Interface Endpoint Settings.
 
      
      	 [bookmark: pgfId-492112] Enable Backup —Select this option.
 
      	 [bookmark: pgfId-492114] Dialer Interface —Specify the physical interface through which the secondary route traffic will be directed when the logical dialer interface is activated.
 
      	 [bookmark: pgfId-492116] Primary Next Hop IP Address —If the selected IPsec technology is Regular IPsec, IPsec/GRE, GRE Dynamic IP, or Easy VPN, enter the next hop IP address. If you do not enter the next hop IP address, Security Manager configures a static route using the interface name.
 
      	 [bookmark: pgfId-492118] Tracking IP Address —Specify the IP address of the destination device to which connectivity must be maintained from the primary VPN interface connection. This is the device that is pinged through the primary route to track connectivity. The backup connection is triggered if connectivity to this device is lost.
 
     
 
     [bookmark: pgfId-492120]If you do not specify an IP address, the primary hub VPN interface is used in a hub-and-spoke or Easy VPN topology. In a point-to-point or full mesh VPN topology, the peer VPN interface is used.
 
     [bookmark: pgfId-492125]Step 4 If the selected IPsec technology is Regular IPsec, IPsec/GRE, GRE Dynamic IP, or Easy VPN, click Advanced to configure additional (optional) settings in the Dial Backup Settings dialog box. These settings are explained in Dial Backup Settings Dialog Box. Click OK to save your changes.
 
     [bookmark: pgfId-492127]Step 5 Click OK in the Edit Endpoints dialog box.
 
     [bookmark: pgfId-492129]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-492141][bookmark: 66378][bookmark: vpnpage_cncpt_DialBackupSettingsDialogBox]Dial Backup Settings Dialog Box[bookmark: marker-492137][bookmark: marker-492139]
 
     [bookmark: pgfId-492143]Use the Dial Backup Settings dialog box to define optional settings for configuring a dial backup policy for your site-to-site VPN. These settings are available for Regular IPsec, IPsec/GRE, GRE Dynamic IP, or Easy VPN technologies.
 
     [bookmark: pgfId-492148]Mandatory settings for dial backup are configured in the VPN Interface tab on the Edit Endpoints dialog box. See Configuring VPN Interface Endpoint Settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-492153]Note You must configure the dialer interface settings before dial backup can work properly. For more information, see Dialer Interfaces on Cisco IOS Routers.

     
      

     

     
 
     [bookmark: pgfId-492155]Navigation Path
 
     [bookmark: pgfId-492160]To open the Dial Backup Settings dialog box, enable dial backup and click Advanced on the VPN Interface tab of the Edit Endpoints dialog box. For information on opening the Edit Endpoints dialog box, see Defining the Endpoints and Protected Networks.
 
     [bookmark: pgfId-492162]Related Topics
 
      
      	 [bookmark: pgfId-492167]Configuring Dial Backup
 
      	 [bookmark: pgfId-492172]Understanding Easy VPN
 
     
 
     [bookmark: pgfId-492174]Field Reference
 
     [bookmark: pgfId-492177]
 
      
       
        
        [bookmark: pgfId-488169]Table 25-7 [bookmark: 66410]Dial Backup Settings Dialog Box 
 
        
       
         
         	
           
           [bookmark: pgfId-488175]Element
          
  
         	
           
           [bookmark: pgfId-488177]Description
          
  
        
 
         
         	[bookmark: pgfId-488183]Next Hop Forwarding
 [bookmark: pgfId-488185]Backup Next Hop IP Address
  
         	[bookmark: pgfId-488187]If required, enter the next hop IP address of the ISDN BRI or analog modem backup interface (that is, the IP address to which the backup interface will connect when it is active). You can enter an IP address or the name of a network/host object, or click Select to select a network/host object that specifies the IP address.
 [bookmark: pgfId-488189]If you do not enter the next hop IP address, Security Manager configures a static route using the interface name.
  
        
 
         
         	 
           
           [bookmark: pgfId-488195]Tracking Object Settings
          
  
        
 
         
         	[bookmark: pgfId-488203]Timeout
  
         	[bookmark: pgfId-488205]The number of milliseconds the Service Assurance Agent operation waits to receive a response from the destination device. The default is 5000 ms.
  
        
 
         
         	[bookmark: pgfId-488211]Frequency
  
         	[bookmark: pgfId-488213]How often Response Time Reporter (RTR) should be used to detect loss of performance on the primary route. The default is every 60 seconds.
  
        
 
         
         	[bookmark: pgfId-488219]Threshold
  
         	[bookmark: pgfId-488221]The rising threshold in milliseconds that generates a reaction event and stores history information for the RTR operation. The default is 5000 ms.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-492197][bookmark: 66448][bookmark: vpchap_proc_ProcedureforConfiguringaVPNSMorVPNSPABlade]Configuring VPNSM or VPN SPA/VSPA Endpoint Settings[bookmark: marker-492183][bookmark: marker-492185][bookmark: marker-492187][bookmark: marker-492189][bookmark: marker-492191][bookmark: marker-492193][bookmark: marker-492195]
 
     [bookmark: pgfId-492199]When you select a Catalyst 6500/7600 device in the Endpoints table for editing, the VPN Interface tab of the Edit Endpoints dialog box provides settings for configuring Cisco VPN Services Modules (VPNSM), Cisco VPN Shared Port Adapters (VPN SPAs), and Cisco VPN Service Port Adapters (VSPAs) on the device. You can select more than one Catalyst 6500/7600 device at the same time. Your changes are applied to all the selected devices.
 
     [bookmark: pgfId-492204]The device can be in a point-to-point or full mesh VPN topology, or a hub or spoke in a hub-and-spoke VPN topology managed by Security Manager (except in an Easy VPN configuration, where the device cannot be a spoke). These settings must also be configured if the selected device is an IPsec Terminator in a large scale DMVPN, although not all settings described below are available. See Configuring Large Scale DMVPNs.
 
     [bookmark: pgfId-492206]General Notes
 
      
      	 [bookmark: pgfId-492208]A Catalyst 6500/7600 device can contain from 3 to 13 chassis slots. Due to the design of the blades, you can install one VPNSM or two VPNSPA/VSPA per slot. The location of a VPNSPA/VSPA is identified with a slot and subslot number. Security Manager stores this information in its inventory, so that Security Manager can manage the VPN topologies.
 
      	 [bookmark: pgfId-492210]If you are configuring intra-chassis high availability, you cannot use a VPNSM blade and a VPNSPA/VSPA blade on the same device as primary and failover blades.
 
      	 [bookmark: pgfId-492215]In a remote access VPN, you can configure only one failover unit for each IPsec proposal. See VPNSM/VPN SPA/VSPA Settings Dialog Box.
 
      	 [bookmark: pgfId-492220]If the Catalyst 6500/7600 has a Firewall Services Module (FWSM), you can configure it to work with these modules. For more information, see Configuring a Firewall Services Module (FWSM) Interface with VPNSM or VPNSPA/VSPA.
 
      	 [bookmark: pgfId-492225]If you are configuring a VPNSM or VPNSPA/VSPA with VRF-Aware IPsec on a device, the device cannot belong to a different VPN topology in which VRF-Aware IPsec is not configured. For more information, see Configuring VRF Aware IPsec Settings.
 
      	 [bookmark: pgfId-492227]Create an inside VLAN on the Catalyst 6500/7600 device, or edit an existing port or VLAN configuration. If the device is configured with VRF-Aware IPsec, you must create a forwarding VLAN.
 
     
 
     [bookmark: pgfId-492229]Notes for VPNSMs
 
      
      	 [bookmark: pgfId-492231]Security Manager supports the configuration of multiple VPNSMs on a Catalyst 6500/7600 device, but only one module (or two if you are configuring intra chassis high availability) can be configured per VPN topology.
 
      	 [bookmark: pgfId-492233]VPNSM configuration requires that its parent Catalyst 6500/7600 device is running Cisco IOS Software release 12.2(18)SXD1 and later.
 
      	 [bookmark: pgfId-492235]You can use only Layer 3 VLANs for VPNSM configuration.
 
     
 
     [bookmark: pgfId-492237]Notes for VPNSPA/VSPAs
 
      
      	 [bookmark: pgfId-492242]This configuration also applies if you are configuring an IPsec Terminator in a large scale DMVPN configuration. For more information, see Configuring Large Scale DMVPNs.
 
      	 [bookmark: pgfId-492247]The VPN SPA supports the AES encryption algorithm for all key sizes (128-, 192-, and 256-bit), as well as the DES and 3DES encryption algorithms. For more information, see Deciding Which Encryption Algorithm to Use.
 
     
 
     [bookmark: pgfId-492249]In VRF mode, the crypto engine slot slot/subslot {inside | outside} command is deployed on the inside and outside VPN interfaces.
 
      
      	 [bookmark: pgfId-492251]Make sure that the Catalyst 6500/7600 device is running Cisco IOS Software release 12.2(18)SXE2 or later.
 
      	 [bookmark: pgfId-492253]If you plan to use Crypto Connect Alternate mode (whereby encrypted traffic entering the VPNSM/VPN SPA is passed through and clear text traffic is bypassed), the Catalyst 6500 device must be running Cisco IOS Software version 12.2(33)SXH or later, and the 7600 router must be running 12.2(33)SRA or later.
 
      	 [bookmark: pgfId-492255]In the case of a DMVPN topology in which multiple hubs participate, if one hub is configured with a VPN SPA blade, a tunnel key must not be configured on  any of the devices, whether they are spokes or hubs. Devices that participate in such a topology must be running Cisco IOS Software version 12.3T and later in order to support tunnels without keys.
 
     
 
     [bookmark: pgfId-492257]Navigation Path
 
     [bookmark: pgfId-492262]On the Endpoints Page of the Create VPN wizard or Edit VPN dialog box, or on the VPN Peers policy, select a Catalyst 6500/7600 device, then click Edit to open the Edit Endpoints Dialog Box. Select the FWSM tab in the Edit Endpoints dialog box. For information on how to access these pages and dialog boxes, see Defining the Endpoints and Protected Networks.
 
     [bookmark: pgfId-492264]Field Reference
 
     [bookmark: pgfId-492267]
 
      
       
        
        [bookmark: pgfId-488234]Table 25-8 [bookmark: 66531]Edit Endpoints Dialog Box, VPN Interface Tab’s VPNSM/VPN SPA/VSPA Settings 
 
        
       
         
         	
           
           [bookmark: pgfId-488240]Element
          
  
         	
           
           [bookmark: pgfId-488242]Description
          
  
        
 
         
         	[bookmark: pgfId-488248]Enable the VPN Interface Changes on All Selected Peers
  
         	[bookmark: pgfId-488250]Note Available if you selected more than one Catalyst 6500/7600 device for editing in the Endpoints page.
 [bookmark: pgfId-488252]When selected, applies any changes you make in the VPN interface tab to all the selected devices.
  
        
 
         
         	[bookmark: pgfId-488258]VPNSM/VPN SPA/VSPA Settings
  
         	
           
           	 [bookmark: pgfId-488260] Use Crypto Connect Alternate —When selected, only encrypted traffic entering the VPNSM/VPN SPA on the Catalyst 6500/7600 is passed through. Clear text traffic does not go through (bypasses) the adapters. To use this option, the Catalyst 6500 must be running version 12.2(33)SXH or later, and the 7600 router must be running 12.2(33)SRA or later.
 
          
 [bookmark: pgfId-488262]This mode is recommended as an alternate to Crypto connect mode for enterprise customers who have a need to support large VPN topologies (financial institutions, for example) or need to pass large amounts of data over an encrypted channel (remote disaster recovery or backup over the Internet).
 
           
           	 [bookmark: pgfId-488264] Inside VLAN —The VLAN that serves as the inside interface to the service module or adapter. It is also the hub endpoint of the VPN tunnel (unless VRF-Aware IPsec is configured on the device). Enter the name of the VLAN or interface role object, or click  Select to select it from a list.
 
           	 [bookmark: pgfId-488266] Slot and Subslot —The number designating the slot location of the VPNSM or VPNSPA/VSPA. If you are configuring a VPNSPA/VSPA, the subslot number is also required.
 
           	 [bookmark: pgfId-488268] Outside VLAN/External port —The external port or VLAN that connects to the inside VLAN. Enter the name of the VLAN or interface role object, or click  Select to select it from a list. You must select an interface or interface role that differs from the one selected for the inside VLAN.
 
          
 [bookmark: pgfId-488270]Note If VRF-Aware IPsec is configured on the device, the external port or VLAN must have an IP address.
  
        
 
         
         	[bookmark: pgfId-488276]Tunnel Source
  
         	[bookmark: pgfId-488278]Note Available only for a hub when the selected technology is IPsec/GRE or DMVPN.
 [bookmark: pgfId-488280]Specifies the tunnel source address to be used by the GRE or DMVPN tunnel on the spoke side. You can select one of the following options:
 
           
           	 [bookmark: pgfId-488282] Override Unique Tunnel Source per Tunnel Interface —If you have enabled the setting to use a unique tunnel source per tunnel interface in the GRE Modes > Tunnel Parameters tab, this option is available. Select this option to specify a different tunnel source for the selected device.
 
           	 [bookmark: pgfId-488284] Outside VLAN/External Port (When CCA/VRF is Enabled) —When the  Use Crypto Connect Alternate check box is selected, this radio button is available. When selected, specifies the outside VLAN/external port as the tunnel source.
 
           	 [bookmark: pgfId-488286] Inside VLAN —When selected, uses the interface configured for the inside VLAN as the tunnel source.
 
           	 [bookmark: pgfId-488288] Interface —To use any interface as the tunnel source address, not necessarily a VPN interface, enter the interface name or click  Select to select an interface role that identifies the interface. You can create new roles from the selection list.
 
          
  
        
 
         
         	[bookmark: pgfId-488294]Local Peer IPSec Termination
  
         	[bookmark: pgfId-488296]Define the IPSec termination point of the VPN interface on the local router:
 
           
           	 [bookmark: pgfId-488298] Inside VLAN —Use the interface configured as the inside VLAN.
 
           	 [bookmark: pgfId-488300] IP Address —Use the IP address of the VPN interface on the local router. Enter the IP address.
 
          
 [bookmark: pgfId-488302]Note If you select a tunnel source as the VPN interface, it is likely that the VPN interface has a dynamically assigned IP address.
  
        
 
         
         	[bookmark: pgfId-488308]Enable Failover Blade
  
         	[bookmark: pgfId-488310]Whether to configure a failover VPNSM or VPNSPA/VSPA blade for intra-chassis high availability.
 [bookmark: pgfId-488312]Note A VPNSM and VPNSPA/VSPA blade cannot be used on the same device as primary and failover blades.
 [bookmark: pgfId-488314]Specify the failover blade, as follows:
 
           
           	 [bookmark: pgfId-488316] Slot —The slot number that identifies where the VPNSM blade or VPNSPA/VSPA blade is located.
 
           	 [bookmark: pgfId-488318] Subslot —If you are configuring a VPNSPA/VSPA, select the number of the subslot (0 or 1) on which the failover VPN SPA blade is installed.
 
          
 [bookmark: pgfId-488320]Note If you are configuring a VPNSM, select the blank option.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-492279][bookmark: 66618][bookmark: vpnpage_cncpt_ProtectedNetworksTab]Identifying the Protected Networks for Endpoints[bookmark: marker-492275][bookmark: marker-492277]
 
     [bookmark: pgfId-492284]Use the Protected Networks tab on the Edit Endpoints dialog box to edit the protected networks that are defined on devices in the Endpoints table. (See Defining the Endpoints and Protected Networks.)
 
     [bookmark: pgfId-492286]You can specify the protected networks as interface roles whose naming patterns match the internal VPN interface of the device, as network/host group objects containing one or more network or host IP addresses, interfaces, or other network objects, or as access control list objects (if Regular IPsec is the assigned technology).
 
      
      	 [bookmark: pgfId-492288]If you are editing more than one device at a time, select  Enable the Protected Networks Changes on All Selected Peers to apply any changes you make in the Protected Networks tab to all the selected devices.
 
      	 [bookmark: pgfId-492290]To add a protected network, select it from the Available Protected Networks list and click  >> to move it to the Selected Protected Networks list. You can use any combination of interface role objects, network/host group objects (listed in the Protected Networks folder), or Access Control List objects to define the protected network for the device. (ACL objects are available only if Regular IPsec is the assigned technology.)
 
     
 
     [bookmark: pgfId-492292]Beginning with version 4.9, Security Manager supports IPv6 addresses.
 
     [bookmark: pgfId-492294] – The Protected Networks folder now supports IPv6 objects.
 
     [bookmark: pgfId-492296] – Access Control Lists folder now supports Extended and Unified ACLs.
 
     [bookmark: pgfId-492298] – For Interface Roles, if you select an IPv6 enabled interface and click >>, a popup window appears with a list of all the IPv6 addresses that are configured. You can select an address from the list and then click OK to move the address to the Selected Protected Networks list. To edit an address, select it in the Selected Protected Networks list and click the Edit Selection link.
 
     [bookmark: pgfId-492300] – For Extranet VPNs, remote backup peer supports IPv6 addresses.
 
      
       
     
 
     
 
     [bookmark: pgfId-492302]Note In a hub-and-spoke VPN topology in which Regular IPsec is the assigned technology, when an ACL object is used to define the protected network on a spoke, Security Manager mirrors the spoke’s ACL object on the hub to the matching crypto map entry.

     
      

     

     
 
     [bookmark: pgfId-492304]If you do not provide a crypto map entry, then during deployment Security Manager generates the crypto ACL name on the hub device as the ACL object name on the spoke device appended with an “_1”. For example, if the ACL object name of a spoke is, say, “spokeACL”, Security Manager generates the Crypto ACL name on the hub device as “spokeACL_1”. If there are multiple spoke devices with the same ACL object name, Security Manager generates the crypto ACL name on the hub device as “ACLobjectName_spokeDisplayName_1”.
 
     [bookmark: pgfId-492306]where, "ACLobjectName" is the ACL object name for all the spoke devices in the topology, and,
 
     [bookmark: pgfId-492308]"spokeDisplayName" is the display name of the spoke devices, which is different for each spoke.
 
      
      	 [bookmark: pgfId-492310]To remove a selected protected network, select it and click the  << button.
 
      	 [bookmark: pgfId-492312]If the order of the objects matters, you can adjust the priority order of the selected objects using the Move Up, Move Down buttons to position the objects in the selected list as desired. These buttons are not available if order does not matter.
 
      	 [bookmark: pgfId-492314]If an object that you need to define the protected network is not listed, click the  Create (+) button to add the object; you are prompted to select the type of object you want to add. You can also modify the definition of an existing object by selecting it and clicking the  Edit (pencil) button. For more information, see the following topics:
 
     
 
     [bookmark: pgfId-492322] – Understanding Interface Role Objects and Creating Interface Role Objects.
 
     [bookmark: pgfId-492330] – Understanding Networks/Hosts Objects and Creating Networks/Hosts Objects.
 
     [bookmark: pgfId-492335] – Creating Access Control List Objects.
 
     [bookmark: pgfId-492337]Navigation Path
 
     [bookmark: pgfId-492342]On the Endpoints Page of the Create VPN wizard or Edit VPN dialog box, or on the Peers policy, select a device and click Edit to open the Edit Endpoints Dialog Box. Select the Protected Networks tab in the Edit Endpoints dialog box. For information on how to access these pages and dialog boxes, see Defining the Endpoints and Protected Networks.
 
    
 
     
      [bookmark: pgfId-492356][bookmark: 66684][bookmark: vpchap_proc_ConfiguringaFirewallServicesModuleFWSMInterfacewithVPNSMorVPNSPA]Configuring a Firewall Services Module (FWSM) Interface with VPNSM or VPNSPA/VSPA[bookmark: marker-492350][bookmark: marker-492352][bookmark: marker-492354]
 
     [bookmark: pgfId-492358]Security Manager supports the configuration of a Firewall Services Module (FWSM) with an IPsec VPN Services Module (VPNSM) or VPNSPA/VSPA on a Catalyst 6500/7600 device. This feature enables a FWSM to apply firewall policies to untrusted clients, while the VPNSM or VPN SPA/VSPA provides secure access to the internal network.
 
     [bookmark: pgfId-492360]Use the FWSM tab on the Edit Endpoints dialog box to define the settings that enable you to connect between the FWSM and a VPNSM or VPNSPA/VSPA that is already configured on a Catalyst 6500/7600 device. The FWSM tab is available only in a hub-and-spoke VPN topology when the selected hub is a Catalyst 6500/7600 device.
 
     [bookmark: pgfId-492362]Tips
 
      
      	 [bookmark: pgfId-492370]Before you can define the FWSM settings, you must add the hosting Catalyst 6500/7600 device to the Security Manager inventory and discover its FWSM and its policies and security contexts. See Adding Devices from the Network and Managing Security Contexts.
 
      	 [bookmark: pgfId-492375]If an inside interface is not already created on the Catalyst 6500/7600 device, you must create it (see Creating or Editing VLANs). Then, you must assign the FWSM inside interface (VLAN) to the appropriate security context, or directly to the FWSM blade.
 
      	 [bookmark: pgfId-492380]You also must configure the settings on the VPN Interfaces tab related to IPsec VPN Services Module (VPNSM) or VPNSPA/VSPA. For more information, see Configuring VPNSM or VPN SPA/VSPA Endpoint Settings.
 
     
 
     [bookmark: pgfId-492382]Navigation Path
 
     [bookmark: pgfId-492387]On the Endpoints Page of the Create VPN wizard or Edit VPN dialog box, or on the VPN Peers policy, select a Catalyst 6500/7600 device that contains an FWSM, then click Edit to open the Edit Endpoints Dialog Box. Select the FWSM tab in the Edit Endpoints dialog box. For information on how to access these pages and dialog boxes, see Defining the Endpoints and Protected Networks.
 
     [bookmark: pgfId-492389]Field Reference
 
     [bookmark: pgfId-492392]
 
      
       
        
        [bookmark: pgfId-488333]Table 25-9 [bookmark: 66722]Edit Endpoints Dialog Box, FWSM Tab 
 
        
       
         
         	
           
           [bookmark: pgfId-488339]Element
          
  
         	
           
           [bookmark: pgfId-488341]Description
          
  
        
 
         
         	[bookmark: pgfId-488347]Enable FWSM Settings
  
         	[bookmark: pgfId-488349]Whether you want to configure the connection between the Firewall Services Module (FWSM) and the VPN Services Module (VPNSM) or VPN SPA on the Catalyst 6500/7600 device.
  
        
 
         
         	[bookmark: pgfId-488355]FWSM Inside VLAN
  
         	[bookmark: pgfId-488357]The VLAN that serves as the inside interface to the Firewall Services Module (FWSM). Enter the name of the interface or interface role, or click Select to select it from a list or to create a new interface role object.
  
        
 
         
         	[bookmark: pgfId-488363]FWSM Blade
  
         	[bookmark: pgfId-488365]From the list of available blades, select the blade number to which the selected FWSM inside VLAN interface is connected.
  
        
 
         
         	[bookmark: pgfId-488371]Security Context
  
         	[bookmark: pgfId-488373]If the FWSM inside VLAN is part of a security context (that is, the FWSM is running in multiple-context mode), specify the security context name in this field. The name is case-sensitive.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-492406][bookmark: 66754][bookmark: vpchap_proc_ConfiguringVRFAwareIPsecSettings]Configuring VRF Aware IPsec Settings[bookmark: marker-492400][bookmark: marker-492402][bookmark: marker-492404]
 
     [bookmark: pgfId-492411]Use the VRF-Aware IPsec tab on the Edit Endpoints dialog box to configure a VRF-Aware IPsec policy on a hub in your hub-and-spoke VPN topology. You can configure VRF-Aware IPsec as a one-box or two-box solution. For more information about VRF-Aware IPsec, see Understanding VRF-Aware IPsec.
 
     [bookmark: pgfId-492413]Tips
 
      
      	 [bookmark: pgfId-492415]VRF-Aware IPsec can be configured only on hubs in a hub-and-spoke VPN topology.
 
      	 [bookmark: pgfId-492417]In a VPN topology with two hubs, you must configure VRF-Aware IPsec on both devices.
 
      	 [bookmark: pgfId-492419]You cannot configure VRF-Aware IPsec on a device that belongs to another VPN topology in which VRF-Aware IPsec is not configured.
 
      	 [bookmark: pgfId-492424]You cannot configure VRF-Aware IPsec on hubs that have been configured with high availability. See Configuring High Availability in Your VPN Topology.
 
      	 [bookmark: pgfId-492426]Deployment might fail if the IPsec Aggregator is configured with the same  keyring CLI command as the existing preshared key (keyring) command, and is not referenced by any other command. In this case, Security Manager does not use the VRF keyring CLI, but generates the keyring with a different name, causing deployment to fail. You must manually remove the preshared key keyring command through the CLI before you can deploy the configuration.
 
     
 
     [bookmark: pgfId-492428]Navigation Path
 
     [bookmark: pgfId-492436]On the Endpoints Page of the Create VPN wizard or Edit VPN dialog box, or on the VPN Peers policy, select a device that supports VRF-Aware IPsec configuration in a hub-and-spoke topology, and click Edit to open the Edit Endpoints Dialog Box. Select the VRF-Aware IPsec tab in the Edit Endpoints dialog box. For information on how to access these pages and dialog boxes, see Defining the Endpoints and Protected Networks and Creating or Editing VPN Topologies.
 
     [bookmark: pgfId-492438]Field Reference
 
     [bookmark: pgfId-492441]
 
      
       
        
        [bookmark: pgfId-488386]Table 25-10 [bookmark: 66794]Edit Endpoints Dialog Box, VRF Aware IPsec Tab 
 
        
       
         
         	
           
           [bookmark: pgfId-488392]Element
          
  
         	
           
           [bookmark: pgfId-488394]Description
          
  
        
 
         
         	[bookmark: pgfId-488400]Enable the VRF Settings Changes on All Selected Peers
  
         	[bookmark: pgfId-488402]Available if you selected more than one device for editing in the Endpoints page.
 [bookmark: pgfId-488404]When selected, applies any changes you make in the VRF Settings tab to all the selected devices.
  
        
 
         
         	[bookmark: pgfId-488410]Enable VRF Settings
  
         	[bookmark: pgfId-488412]Whether to enable the configuration of VRF settings on the device.
 [bookmark: pgfId-488417]Note You can remove VRF settings that were defined for the VPN topology by deselect this check box. However, if VRF-Aware IPsec is configured on a Catalyst 6500/7600 device, disabling it requires additional steps, as explained in Enabling and Disabling VRF on Catalyst Switches and 7600 Devices.
  
        
 
         
         	[bookmark: pgfId-488423]VRF Solution
  
         	[bookmark: pgfId-488425]The type of VRF solution you want to configure:
 
           
           	 [bookmark: pgfId-488430]1-Box (IPsec Aggregator + MPLS PE)—In the one-box solution, one device serves as the Provider Edge (PE) router that does the MPLS tagging of the packets in addition to IPsec encryption and decryption from the Customer Edge (CE) devices. For more information, see VRF-Aware IPsec One-Box Solution.
 
           	 [bookmark: pgfId-488435]2-Box (IPsec Aggregator Only)—In the two-box solution, the PE device does just the MPLS tagging, while the IPsec Aggregator device does the IPsec encryption and decryption from the CEs. For more information, see VRF-Aware IPsec Two-Box Solution.
 
          
  
        
 
         
         	[bookmark: pgfId-488441]VRF Name
  
         	[bookmark: pgfId-488443]The name of the VRF routing table on the IPsec Aggregator. The VRF name is case-sensitive.
  
        
 
         
         	[bookmark: pgfId-488449]Route Distinguisher
  
         	[bookmark: pgfId-488451]The unique identifier of the VRF routing table on the IPsec Aggregator. This unique route distinguisher maintains the routing separation for each VPN across the MPLS core to the other PE routers.
 [bookmark: pgfId-488453]The identifier can be in either of the following formats:
 
           
           	 [bookmark: pgfId-488455] IP address:X (where  X is in the range 0- 2147483647).
 
           	 [bookmark: pgfId-488457] N:X (where  N is in the range 0-65535, and X is in the range 0- 2147483647).
 
          
 [bookmark: pgfId-488459]Note You cannot override the RD identifier after deploying the VRF configuration to your device. To modify the RD identifier after deployment, you must manually remove it using the device CLI, and then deploy again.
  
        
 
         
         	[bookmark: pgfId-488465]Interface Towards Provider Edge
 [bookmark: pgfId-488467](2-Box solution only.)
  
         	[bookmark: pgfId-488469]The VRF forwarding interface on the IPsec Aggregator towards the PE device. If the IPsec Aggregator (hub) is a Catalyst VPN service module, you must specify a VLAN.
 [bookmark: pgfId-488471]Enter the name of the interface or interface role object, or click Select to select it from a list or to create a new interface role object.
  
        
 
         
         	[bookmark: pgfId-488477]Routing Protocol
 [bookmark: pgfId-488479](2-Box solution only.)
  
         	[bookmark: pgfId-488481]The routing protocol to be used between the IPsec Aggregator and the PE. The options are BGP, EIGRP, OSPF, RIPv2, or Static route. The default is BGP.
 [bookmark: pgfId-488483]If the routing protocol used for the secured IGP differs from the routing protocol between the IPsec Aggregator and the PE, select the routing protocol to use for redistributing the routing to the secured IGP.
 [bookmark: pgfId-488488]For information about protocols, see Chapter 60, “Managing Routers”.
 [bookmark: pgfId-488490]Note In a one-box solution, these fields are unavailable as you do not need to specify the routing protocol and AS number. In the one-box solution, only the BGP protocol is supported.
  
        
 
         
         	[bookmark: pgfId-488496]AS Number
 [bookmark: pgfId-488498](2-Box solution, BGP or EIGRP routing only.)
  
         	[bookmark: pgfId-488500]The number that will be used to identify the autonomous system (AS) area between the IPsec Aggregator and the PE. The AS number must be within the range 1-65535.
 [bookmark: pgfId-488502]If the routing protocol used for the secured IGP differs from the routing protocol between the IPsec Aggregator and the PE, enter an AS number that will be used to identify the secured IGP into which the routing will be redistributed from the IPsec Aggregator and the PE. This is relevant only when IPsec/GRE or DMVPN are applied.
  
        
 
         
         	[bookmark: pgfId-488508]Process Number
 [bookmark: pgfId-488510](2-Box solution, OSPF routing only.)
  
         	[bookmark: pgfId-488512]The routing process ID number that will be used to identify the secured IGP if you are using OSPF routing.
 [bookmark: pgfId-488514]The range is 1-65535.
  
        
 
         
         	[bookmark: pgfId-488520]OSPF Area ID
 [bookmark: pgfId-488522](2-Box solution, OSPF routing only.)
  
         	[bookmark: pgfId-488524]The ID number of the area in which the packet belongs. You can enter any number from 0-4294967295.
 [bookmark: pgfId-488526]Note All OSPF packets are associated with a single area, so all devices must have the same area ID number.
  
        
 
         
         	[bookmark: pgfId-488532]Next Hop IP Address
 [bookmark: pgfId-488534](2-Box solution, static routing only.)
  
         	[bookmark: pgfId-488536]The IP address of the Provider Edge (PE) or the interface that is connected to the IPsec Aggregator, if you are using static routing.
  
        
 
         
         	[bookmark: pgfId-488542]Redistribute Static Route
 [bookmark: pgfId-488544](2-Box solution, non-static routing only.)
  
         	[bookmark: pgfId-488546]Whether to have static routes advertised in the routing protocol configured on the IPsec Aggregator towards the PE device.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-492453][bookmark: 66902][bookmark: vpnpage_cncpt_CryptoMapTab]Configuring Crypto Map [bookmark: marker-492449][bookmark: marker-492451]
 
     [bookmark: pgfId-492455]Beginning with version 4.7, Security Manager enables you to manually configure the Crypto Map name and Crypto ACL name for each peer device in a VPN topology. This feature is supported only in Regular IPsec topologies.
 
     [bookmark: pgfId-492457]Use the Crypto Map tab in the Edit Endpoints dialog box to list the peer devices along with the Crypto Map Name and Crypto ACL Name configured for the peers. Selecting any peer device in the list and clicking the Edit (pencil)button opens the Edit Crypto Map Entry dialog box.
 
      
       
     
 
     
 
     [bookmark: pgfId-492459]Note If the topology supports dynamic Crypto Map, the dialog box that opens on clicking the Edit button enables you to enter the Dynamic Crypto Map Name.

     
      

     

     
 
     [bookmark: pgfId-492461]Navigation Path
 
     [bookmark: pgfId-492466]On the Edit Endpoints Page of the Create VPN wizard or Edit VPN dialog box, select a device and click Edit to open the Edit Endpoints Dialog Box. Select the Crypto Map tab in the Edit Endpoints dialog box. For information on how to access these pages and dialog boxes, see Defining the Endpoints and Protected Networks.
 
     [bookmark: pgfId-492468]Field Reference
 
     [bookmark: pgfId-492471]
 
      
       
        
        [bookmark: pgfId-488559]Table 25-11 [bookmark: 66926]Edit Endpoints Dialog Box, Crypto Map Tab 
 
        
       
         
         	
           
           [bookmark: pgfId-488565]Element
          
  
         	
           
           [bookmark: pgfId-488567]Default Value
          
  
        
 
         
         	[bookmark: pgfId-488573]Crypto Map Name
  
         	[bookmark: pgfId-488575]There is no default value. If you do not enter any value, Security Manager uses the Crypto Map Name of the device or generates a new Crypto Map Name. If a Crypto Map already exists on the VPN interface, Security Manager will reuse the same name.
  
        
 
         
         	[bookmark: pgfId-488581]Crypto Map Sequence
  
         	[bookmark: pgfId-488583]Security Manager displays the sequence number of the device in this field after it has discovered the device in the managed network. You cannot edit this value.
 [bookmark: pgfId-488585]If you are adding a new VPN topology, Security Manager populates the Sequence Number field with a value of #. You cannot edit this value.
  
        
 
         
         	[bookmark: pgfId-488591]Crypto ACL Name
  
         	[bookmark: pgfId-488593]There is no default value. If you do not enter any value, Security Manager generates a new Crypto ACL name.
  
        
 
         
         	[bookmark: pgfId-488599]Dynamic Crypto Map Name
  
         	[bookmark: pgfId-488601]There is no default value. If you do not enter any value, Security Manager uses the Crypto Map Name of the device or generates a new Crypto Map Name.
  
        
 
       
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-492473]Warning 

     
      

     

     
 
      
      	 [bookmark: pgfId-492475]You can apply only one crypto map to an interface.
 
      	 [bookmark: pgfId-492477]You cannot assign the same Crypto Map Name on multiple interfaces of a device.
 
      	 [bookmark: pgfId-492479]You cannot assign different Crypto Map names on the same interface of a device.
 
     
 
    
 
     
      [bookmark: pgfId-492495][bookmark: 66967][bookmark: vpchap_proc_ConfiguringHighAvailabilityinYourVPNTopology]Configuring High Availability in Your VPN Topology[bookmark: marker-492487][bookmark: marker-492489][bookmark: marker-492491][bookmark: marker-492493]
 
     [bookmark: pgfId-492497]Use the High Availability page of the Create VPN wizard and Edit VPN dialog box to define a group of hubs as a high availability (HA) group. Configuring high availability is optional.
 
     [bookmark: pgfId-492502]For information on opening the Create VPN wizard or Edit VPN dialog box, see Creating or Editing VPN Topologies.
 
     [bookmark: pgfId-492504]High Availability (HA) policies provide automatic device backup when configured on Cisco IOS routers or Catalyst 6500/7600 devices that run IP over LANs. You can configure high availability in a hub-and-spoke VPN topology that uses Regular IPsec or Easy VPN technologies.
 
     [bookmark: pgfId-492506]In Security Manager, HA is supported by an HA group made up of two or more hub devices that use Hot Standby Routing Protocol (HSRP) to provide transparent, automatic device failover. By sharing a virtual IP address, the hubs in the HA group present the appearance of a single virtual device or default gateway to the hosts on a LAN. One hub in the HA group is always active and assumes the virtual IP address, while the others are standby hubs. The hubs in the group watch for hello packets from active and standby devices. If the active device becomes unavailable for any reason, a standby hub takes ownership of the virtual IP address and takes over the hub functionality. This transfer is seamless and transparent to hosts on the LAN and to the peering devices.
 
     [bookmark: pgfId-492508]Keep the following points in mind when working with HA groups:
 
      
      	 [bookmark: pgfId-492510]You can configure High Availability only on hubs in a hub-and-spoke VPN topology that uses Regular IPsec or Easy VPN technologies.
 
      	 [bookmark: pgfId-492512]You can configure high availability only on Cisco IOS routers or Catalyst 6500/7600 devices; however, an HA group cannot contain both Cisco IOS routers and Catalyst 6500/7600 devices.
 
      	 [bookmark: pgfId-492514]If you want to configure stateful failover, the HA group can contain only two hubs, and they must be Cisco IOS routers. You cannot use Catalyst 6500/7600 devices.
 
      	 [bookmark: pgfId-492519]You cannot configure High Availability on hubs that have been configured with VRF-Aware IPsec. See Understanding VRF-Aware IPsec.
 
      	 [bookmark: pgfId-492521]You cannot configure GRE on an HA group.
 
      	 [bookmark: pgfId-492523]A device in an HA group can belong to more than one hub-and-spoke topology.
 
      	 [bookmark: pgfId-492525]A device configured as a hub in a site-to-site VPN with an HA configuration cannot be configured as a hub in a different site-to-site VPN with an HA configuration using the same outside interface. Similarly, such a device cannot be configured as a remote access VPN server on which HA is configured using the same outside interface.
 
      	 [bookmark: pgfId-492530]The same auto-generated preshared key must be used for authentication on all peers. If you specified not to use this option when configuring a preshared key policy, this is overridden during configuration of High Availability. For more information, see Configuring IKEv1 Preshared Key Policies.
 
      	 [bookmark: pgfId-492532]During generation of configurations, all hubs in the HA group receive the same commands, which must be deployed to the HA group as a unit. You cannot deploy to individual hubs in the group.
 
     
 
     [bookmark: pgfId-492534]The following table describes the options for configuring high availability.
 
     [bookmark: pgfId-492537]
 
      
       
        
        [bookmark: pgfId-488614]Table 25-12 [bookmark: 67012]High Availability Page 
 
        
       
         
         	
           
           [bookmark: pgfId-488620]Element
          
  
         	
           
           [bookmark: pgfId-488622]Description
          
  
        
 
         
         	[bookmark: pgfId-488628]Enable
  
         	[bookmark: pgfId-488630]Whether to enable high availability configuration on a group of hubs. If you already configured high availability, you can remove the configuration by deselecting this option.
  
        
 
         
         	[bookmark: pgfId-488636]Inside Virtual IP
  
         	[bookmark: pgfId-488638]The IP address that is shared by the hubs in the HA group and that represents the inside interface of the HA group. The virtual IP address must be on the same subnet as the inside interfaces of the hubs in the HA group, but must not be identical to the IP address of any of these interfaces.
 [bookmark: pgfId-488640]Note If there is an existing standby group on the device, make sure that the IP address you provide is different from the virtual IP address already configured on the device.
  
        
 
         
         	[bookmark: pgfId-488646]Inside Mask
  
         	[bookmark: pgfId-488648]The subnet mask for the inside virtual IP address.
  
        
 
         
         	[bookmark: pgfId-488654]VPN Virtual IP
  
         	[bookmark: pgfId-488656]The IP address that is shared by the hubs in the HA group and represents the VPN interface of the HA group. This IP address serves as the hub endpoint of the VPN tunnel.
 [bookmark: pgfId-488658]Note If there is an existing standby group on the device, make sure that the IP address you provide is different from the virtual IP address already configured on the device.
  
        
 
         
         	[bookmark: pgfId-488664]VPN Mask
  
         	[bookmark: pgfId-488666]The subnet mask for the VPN virtual IP address.
  
        
 
         
         	[bookmark: pgfId-488672]Hello Interval
  
         	[bookmark: pgfId-488674]The duration in seconds (within the range of 1-254) between each hello message sent by a hub to the other hubs in the group to indicate status and priority. The default is 5 seconds.
  
        
 
         
         	[bookmark: pgfId-488680]Hold Time
  
         	[bookmark: pgfId-488682]The duration in seconds (within the range of 2-255) that a standby hub will wait to receive a hello message from the active hub before concluding that the hub is down. The default is 15 seconds.
  
        
 
         
         	[bookmark: pgfId-488688]Standby Group Number (Inside)
  
         	[bookmark: pgfId-488690]The standby number of the inside hub interface that matches the internal virtual IP subnet for the hubs in the HA group. The number must be within the range of 0-255. The default is 1.
  
        
 
         
         	[bookmark: pgfId-488696]Standby Group Number (Outside)
  
         	[bookmark: pgfId-488698]The standby number of the outside hub interface that matches the external virtual IP subnet for the hubs in the HA group. The number must be within the range of 0-255. The default is 2.
 [bookmark: pgfId-488700]Note The outside standby group number must be different from the inside standby group number.
  
        
 
         
         	[bookmark: pgfId-488706]Enable Stateful Failover
  
         	[bookmark: pgfId-488714]Whether to enable stateful failover, which uses Stateful SwitchOver (SSO) to ensure that state information is shared between the HSRP devices in the HA group. If a device fails, the shared state information enables the standby device to maintain IPsec sessions without having to re-establish the tunnel or renegotiate the security associations.[bookmark: marker-488708][bookmark: marker-488710][bookmark: marker-488712]
 [bookmark: pgfId-488716]You can configure stateful failover only on an HA group that contains two hubs that are Cisco IOS routers. This check box is disabled if the HA group contains more than two hubs.
 [bookmark: pgfId-488718]In an Easy VPN topology, this check box appears selected and disabled, as stateful failover must always be configured.
 [bookmark: pgfId-488720]Tips:
 
           
           	 [bookmark: pgfId-488722]When deselected in a Regular IPsec topology, stateless failover is configured on the HA group. Stateless failover will also be configured if the HA group contains more than two hubs. You can configure stateless failover on Cisco IOS routers or Catalyst 6500/7600 devices.
 
           	 [bookmark: pgfId-488724]Stateful failover cannot be used when RSA Signature is the IKE authentication method.
 
           	 [bookmark: pgfId-488726]Stateful failover can be configured together with PKI configuration, but only on devices with Cisco IOS version 12.3(14)T and later.
 
          
  
        
 
       
      
 
     
 
     [bookmark: pgfId-492539]Related Topics
 
      
      	 [bookmark: pgfId-492544]Hub-and-Spoke VPN Topologies
 
      	 [bookmark: pgfId-492549]Understanding Easy VPN
 
     
 
    
 
     
      [bookmark: pgfId-492569][bookmark: 67105][bookmark: vpchap_proc_DefiningtGETVPNGroupEncryption]Defining GET VPN Group Encryption[bookmark: marker-492559][bookmark: marker-492561][bookmark: marker-492563][bookmark: marker-492565][bookmark: marker-492567]
 
     [bookmark: pgfId-492571]Use the GET VPN Group Encryption page to define the group settings and security associations for a GET VPN topology.
 
     [bookmark: pgfId-492573]The contents of this page differ depending on whether you are using the Create VPN wizard or you are editing the Group Encryption Policy. The wizard page is not tabbed, whereas the policy is tabbed. There is an extra field on the wizard page to allow the security association configuration.
 
     [bookmark: pgfId-492575]To open the GET VPN Group Encryption page:
 
      
      	 [bookmark: pgfId-492580]When creating a new GET VPN, use the Create VPN wizard. For information on starting the wizard, see Creating or Editing VPN Topologies.
 
      	 [bookmark: pgfId-492585](Site-to-Site VPN Manager Window) Select an existing GET VPN topology and then select  Group Encryption Policy in the Policies selector.
 
      	 [bookmark: pgfId-492587](Policy view) Select  Site-to-Site VPN > Group Encryption Policy , and then select an existing policy or create a new one.
 
     
 
     [bookmark: pgfId-492589]The following table describes the options you can configure when defining the GET VPN group encryption settings.
 
     [bookmark: pgfId-492592]
 
      
       
        
        [bookmark: pgfId-488739]Table 25-13 [bookmark: 67140]GET VPN Group Encryption Policy Page 
 
        
       
         
         	
           
           [bookmark: pgfId-488745]Element
          
  
         	
           
           [bookmark: pgfId-488747]Description
          
  
        
 
         
         	 
           
           [bookmark: pgfId-488753]Group Settings Tab
          
  
        
 
         
         	[bookmark: pgfId-488761]Group Name
  
         	[bookmark: pgfId-488763]The name of the Group Name of Interpretation (GDOI) group. This name is the same as a VPN name.
  
        
 
         
         	[bookmark: pgfId-488769]Group Identity
  
         	[bookmark: pgfId-488771]A parameter that is used to identify the group. All key servers and group members use this parameter to identify with the group.
 [bookmark: pgfId-488773]The identity can be either a number (such as 3333) or any IP address (such as the multicast address used for rekey).
  
        
 
         
         	[bookmark: pgfId-488779]Receive Only
  
         	[bookmark: pgfId-488784]If enabled, group members decrypt traffic and forward it in clear text. This feature is useful for testing the VPN. In normal operation, ensure that this option is not selected. For detailed information, see Using Passive Mode to Migrate to GET VPN.
  
        
 
         
         	[bookmark: pgfId-488790]Security Policy
 [bookmark: pgfId-488792](Create VPN wizard only.)
  
         	[bookmark: pgfId-488797]An ACL policy object to be used as the security policy. For a detailed explanation of the contents of this object and how it relates to the group member security policy, see Understanding the GET VPN Security Policy and Security Associations.
 [bookmark: pgfId-488799]This field appears only if you are using the Create VPN wizard. In the Group Encryption Policy, you configure the security policy on the Security Associations tab (described below).
 [bookmark: pgfId-488801]Note If you are using multicast as the method to distribute the keys, then the ACL policy object must contain a deny rule (ACE) for the multicast address. In this way, the rekey packets sent using multicast will not be encrypted by the TEK. This statement allows the group members to receive rekey packets sent using the multicast protocol.
  
        
 
         
         	[bookmark: pgfId-488807]Authorization Type
  
         	[bookmark: pgfId-488809]The type of authorization mechanism used by the group: None, Certificates, or Preshared Key. Selecting Certificates or Preshared Key provides additional security in allowing only authorized group members to register with the key server. This type of additional security is required when a key server serves multiple GDOI groups.
 [bookmark: pgfId-488814]If you select Certificates, you must create a list of certificate filters (using some combination of distinguished name or full-qualified domain name attributes). This filter, located on the key server, specifies the attributes and values used to validate whether the group member is authorized to join the GDOI group. Enter a name for the certificate filter, click the Add Row (+) button, and fill in the Add Certificate Filter Dialog Box.
 [bookmark: pgfId-488816]Note To configure certificate authorization, you must also configure a Public Key Infrastructure (PKI) policy for the GET VPN. The PKI enrollment object that you use should define the same distinguished names, or include the device’s fully-qualified domain name, as appropriate.
 [bookmark: pgfId-488818]If you select Preshared Key, also select an ACL policy object to identify the authorized group members. Use permit rules to identify the host or network addresses of group members.
  
        
 
         
         	[bookmark: pgfId-488824]Key Distribution
  
         	[bookmark: pgfId-488829]The transport method to be used to distribute keys to each group member, either unicast or multicast. For help deciding which to use, see Choosing the Rekey Transport Mechanism.
 [bookmark: pgfId-488831]If you select unicast, the key server sends a rekey message to each registered group member and waits for an acknowledgment. If you select multicast, the key server sends a rekey message to all group members at once and does not wait for acknowledgment. Rekey messages are retransmitted after the retransmit interval configured in this policy.
 [bookmark: pgfId-488833]If you select multicast, make sure that the router used as the key server is multicast enabled, and also configure the following options:
 
           
           	 [bookmark: pgfId-488835] Group IP Address —The IP address of the multicast group to be used for key distribution.
 
           	 [bookmark: pgfId-488837] Use Static IGMP Joins on Group Members —If you select this option, the static Source Specific Multicast (SSM) mappings are enabled, which reveal the source of multicast traffic to the group member. In the case of GET VPN, the group member learns the key server address.
 
          
  
        
 
         
         	[bookmark: pgfId-488843]RSA Key Label
  
         	[bookmark: pgfId-488845]The label for the RSA key, which is used to encrypt a variety of messages. This key can either already exist on the device, or it can be an unused new label.
 [bookmark: pgfId-488850]If you are creating a new VPN, you are asked at the end of the Create VPN wizard whether you want this key synchronized among the key servers; if you click Yes, Security Manager generates the key if it does not already exist. If you change this value for an existing GET VPN, you need to synchronize keys from the Key Servers policy. For more detailed information about how this key is used, and the key generation and synchronization process, see Generating and Synchronizing RSA Keys.
  
        
 
         
         	[bookmark: pgfId-488856]Lifetime (KEK)
  
         	[bookmark: pgfId-488858]The number of seconds that the key encryption key (KEK) is valid. This key is used for encrypting rekey messages. Before the end of this lifetime, the key server sends rekey messages to the group, which includes a new KEK encryption key and transforms and new TEK encryption keys and transforms.
 [bookmark: pgfId-488863]The KEK lifetime value should be greater than the TEK lifetime value (it is recommended that the KEK lifetime value be at least three times greater than the TEK lifetime value). The default value of 86,400 seconds is usually appropriate. The TEK lifetime value is configured for each security association (see Add New or Edit Security Association Dialog Box).
  
        
 
         
         	[bookmark: pgfId-488869]Encryption Algorithm
  
         	[bookmark: pgfId-488871]The algorithm used to encrypt the rekey message from the key server to the group member.
  
        
 
         
         	[bookmark: pgfId-488877]Retransmits
  
         	[bookmark: pgfId-488879]The number of times the rekey message can be sent if one or more group members do not receive it.
  
        
 
         
         	[bookmark: pgfId-488885]Interval
  
         	[bookmark: pgfId-488887]The number of seconds between retries.
  
        
 
         
         	 
           
           [bookmark: pgfId-488893]Security Associations Tab
          
  
        
 
         
         	[bookmark: pgfId-488901]Security Associations table
  
         	[bookmark: pgfId-488906]Use the Security Associations table to define security associations for the VPN. The columns in the table summarize the settings for an entry and are explained in Add New or Edit Security Association Dialog Box. When creating a new VPN, the Security Policy field (explained above) is used instead of this tab, which does not appear in the wizard.
 [bookmark: pgfId-488908]To configure security associations:
 
           
           	 [bookmark: pgfId-488910]Click the  Add button to add an entry to the table, and fill in the Add New Security Association dialog box.
 
           	 [bookmark: pgfId-488912]Select an entry and click the  Edit button to edit an existing entry.
 
           	 [bookmark: pgfId-488914]Select an entry and click the  Delete button to delete it.
 
          
  
        
 
       
      
 
     
 
     [bookmark: pgfId-492594]Related Topics
 
      
      	 [bookmark: pgfId-492599]Understanding the GET VPN Registration Process
 
      	 [bookmark: pgfId-492604]Understanding Group Encrypted Transport (GET) VPNs
 
      	 [bookmark: pgfId-492609]Configuring GET VPN
 
     
 
    
 
     
      [bookmark: pgfId-492621][bookmark: 67274][bookmark: vpnpage_cncpt_GETVPNGroupEncryptionPage_AddCertificateFilter]Add Certificate Filter Dialog Box[bookmark: marker-492617][bookmark: marker-492619]
 
     [bookmark: pgfId-492623]Use the Add Certificate Filter dialog box to define a certificate filter for the group encryption policy for GET VPNs. This filter, located on the key server, specifies the attributes and values used to validate whether the group member is authorized to join the group.
 
     [bookmark: pgfId-492625]Select one of the following filter types:
 
      
      	 [bookmark: pgfId-492630] dn —(Distinguished name.) Specify a comma separated list of  name=value pairs in the  Subject field. For example, OU=Cisco, C=US. When you configure the Public Key Infrastructure policy, the PKI enrollment object you select should define the same values on the Certificate Subject Name tab (see PKI Enrollment Dialog Box—Certificate Subject Name Tab). Using a distinguished name can let you match multiple devices with a single filter.
 
      	 [bookmark: pgfId-492632] fqdn —(Fully-qualified domain name.) Specify the fully qualified domain name of a single device (for example, router1.example.com) in the  Domain Name field. When you configure the Public Key Infrastructure policy, the PKI enrollment object you select should have the  Include Device’s FQDN option selected. Because each device has a unique name, an FQDN filter matches a single device only.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-492634]Tip To configure certificate authorization, you must also configure a Public Key Infrastructure (PKI) policy for the GET VPN. The PKI policy is configured on all devices in the VPN.

     
      

     

     
 
     [bookmark: pgfId-492636]Navigation Path
 
     [bookmark: pgfId-492641]From the Group Settings tab on the GET VPN Group Encryption page, select Certificates as the authorization type and click the Add Row button under the Authorization Filter table, or select a filter and click the Edit Row button. For information on opening the Group Encryption page, see Defining GET VPN Group Encryption.
 
     [bookmark: pgfId-492643]Related Topics
 
      
      	 [bookmark: pgfId-492648]Understanding the GET VPN Registration Process
 
      	 [bookmark: pgfId-492653]Understanding Group Encrypted Transport (GET) VPNs
 
      	 [bookmark: pgfId-492658]Configuring GET VPN
 
     
 
    
 
     
      [bookmark: pgfId-492672][bookmark: 67318][bookmark: vpnpage_cncpt_GroupEncryptionPolicy_AddNewSecurityAssociationDialogBox]Add New or Edit Security Association Dialog Box[bookmark: marker-492666][bookmark: marker-492668][bookmark: marker-492670]
 
     [bookmark: pgfId-492674]Use the Add New or Edit Security Association dialog boxes to define an IPSec profile (name and transform set only) and security policy used by the selected GET VPN topology.
 
     [bookmark: pgfId-492676]Navigation Path
 
     [bookmark: pgfId-492681]To open the Add New Security Association dialog box, from the Security Associations tab on the GET VPN Group Encryption page, click the Add Row (+) button or select an existing association and click the Edit Row (pencil) button. For information on opening the Group Encryption page, see Defining GET VPN Group Encryption.
 
     [bookmark: pgfId-492683]Related Topics
 
      
      	 [bookmark: pgfId-492688]Understanding the GET VPN Registration Process
 
      	 [bookmark: pgfId-492693]Understanding Group Encrypted Transport (GET) VPNs
 
      	 [bookmark: pgfId-492698]Configuring GET VPN
 
     
 
     [bookmark: pgfId-492700]Field Reference
 
     [bookmark: pgfId-492703]
 
      
       
        
        [bookmark: pgfId-488927]Table 25-14 [bookmark: 67352]Add New Security Association Dialog Box 
 
        
       
         
         	
           
           [bookmark: pgfId-488933]Element
          
  
         	
           
           [bookmark: pgfId-488935]Description
          
  
        
 
         
         	[bookmark: pgfId-488941]ID
  
         	[bookmark: pgfId-488943]The sequence number of the profile. This number defines the relative priority of the security association (1 being the highest). If you have more than one security association, the ACLs for each are concatenated (and merged) in the order represented by this number, and the group members process the collected ACL as a single ACL.
 [bookmark: pgfId-488945]Keep the default number or enter a new one.
  
        
 
         
         	[bookmark: pgfId-488951]IPSec Profile Name
  
         	[bookmark: pgfId-488953]The name of the IPSec profile.
  
        
 
         
         	[bookmark: pgfId-488959]Transform Sets
  
         	[bookmark: pgfId-488961]The transform set policy objects (security protocols, algorithms, and other settings) defined for the IPSec profile. Separate multiple entries with commas, and place them in priority order. Click Select to choose from a list of predefined transform sets or to create a new one.
  
        
 
         
         	[bookmark: pgfId-488967]Security Policy
  
         	[bookmark: pgfId-488972]The access control list policy object defined for the security association. Click Select to choose from a list of predefined ACL objects or to create a new one. For a detailed explanation of the contents of this object and how it relates to the group member security policy, see Understanding the GET VPN Security Policy and Security Associations.
 [bookmark: pgfId-488974]Note If you are using multicast as the method to distribute the keys, then the ACL policy object must contain a deny rule (ACE) for the multicast address. In this way, the rekey packets sent using multicast will not be encrypted by the TEK. This statement allows the group members to receive rekey packets sent using the multicast protocol.
  
        
 
         
         	[bookmark: pgfId-488980]Enable Anti-Replay
  
         	[bookmark: pgfId-488982]Whether to enable the anti-replay feature, which helps prevent eavesdroppers from inserting packets into the data stream. You can configure anti-replay based on traffic counters or time:
 
           
           	 [bookmark: pgfId-488984] Counter Window Size —Although this is the default, it is not recommended. Counter-based anti-replay is useful only if there are two group members (essentially a point-to-point VPN). Select a window size.
 
           	 [bookmark: pgfId-488989] Time Window Size —This is the preferred method, but it requires that there are more than two group members. Enter the number of seconds of the interval duration of the Synchronous Anti-Replay (SAR) clock. The value range is 1 through 100. The default value is 100. For more information on time-based anti-replay, see Understanding Time-Based Anti-Replay.
 
          
 [bookmark: pgfId-488991]Note If you are encrypting high packet rates for count-based anti-replay, ensure that you do not make the KEK or TEK lifetime too long or it can take several hours for the sequence number to wrap. For example, if the packet rate is 100 kilopackets per second, the lifetime should be configured as less than 11.93 hours so that the SA is used before the sequence number wraps.
  
        
 
         
         	[bookmark: pgfId-488997]Enable IPSec Lifetime
  
         	[bookmark: pgfId-489002]Whether to configure an IPsec security association lifetime that overrides the global setting, which is configured in the Global Settings for GET VPN policy (see Configuring Global Settings for GET VPN). This lifetime value controls how long the traffic encryption key (TEK) can be used before a rekey is required.
 [bookmark: pgfId-489004]Configure a value based on the volume of traffic (in kilobytes) between group members, seconds, or both. The key expires when either of the values is reached. Use the following recommendations:
 
           
           	 [bookmark: pgfId-489009]The lifetime should be significantly shorter than the one used for the key encryption key (KEK) (see Defining GET VPN Group Encryption), perhaps a third of the length.
 
           	 [bookmark: pgfId-489011]The timed lifetime is the recommended approach, because high traffic volumes can cause excessive rekeys (with potential data loss).
 
           	 [bookmark: pgfId-489013]Leave a field blank to not override that global setting.
 
          
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-492719][bookmark: 67418][bookmark: vpchap_proc_DefiningtGETVPNPeers]Defining GET VPN Peers[bookmark: marker-492711][bookmark: marker-492713][bookmark: marker-492715][bookmark: marker-492717]
 
     [bookmark: pgfId-492721]Use the GET VPN Peers page of the Create VPN wizard to configure peer properties for the key servers and group members in a GET VPN topology. After creating the topology, use the Key Servers and Group Members policies to modify these settings. The policies are the same as the wizard page, except that the key server and group member tables are split into separate policies.
 
      
       
     
 
     
 
     [bookmark: pgfId-492726]Tip The list of key servers and group members includes those devices you selected on the Device Selection page of the wizard (see Selecting Devices for Your VPN Topology), however, you can use the Add (+) and Delete (trash can) buttons to add or remove devices from this page.

     
      

     

     
 
     [bookmark: pgfId-492728]Examine the list of key servers and group members to determine if the default settings are appropriate for your VPN. You can select Matching Interfaces from the Show field below each table to display the actual interfaces that will be selected by the default interface roles. The interface roles must resolve to actual interfaces on the device for the GET VPN configuration to be valid.
 
     [bookmark: pgfId-492730]Before You Begin
 
     [bookmark: pgfId-492735]This procedure describes how to define peers for GET VPN when creating a new VPN, and explains just the GET VPN peers configuration. For information on opening the Create VPN wizard, see Creating or Editing VPN Topologies.
 
     [bookmark: pgfId-492737]Related Topics
 
      
      	 [bookmark: pgfId-492742]Configuring Fail-Close to Protect Registration Failures
 
      	 [bookmark: pgfId-492747]Using Passive Mode to Migrate to GET VPN
 
      	 [bookmark: pgfId-492752]Configuring GET VPN Key Servers
 
      	 [bookmark: pgfId-492757]Configuring GET VPN Group Members
 
     
 
     
 
     [bookmark: pgfId-492759]Step 1 Configure the key servers if the default settings are not appropriate.
 
     [bookmark: pgfId-492764]For each key server you want to modify, select it, click the Edit (pencil) button beneath the table, and configure at least following settings. For information on all available settings, see Edit Key Server Dialog Box.
 
      
      	 [bookmark: pgfId-492766] Identity Interface —Select the interface that group members use to identify the key server and register with it. The default is the Loopback interface role, which identifies all Loopback interfaces defined on the key server.
 
      	 [bookmark: pgfId-492768] Priority —Define the role of the key server as primary or secondary by entering a priority value between 1-100. The key server with the highest priority becomes the primary key server. If two or more key servers are assigned the same priority value, the device with the highest IP address is used. The default priority is 100 for the first key server, 95 for the second, and so on.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-492770]Note There can be more than one primary key server if the network is partitioned.

     
      

     

     
 
     [bookmark: pgfId-492772]Step 2 Move key servers up or down in the table to specify the order that group members use to register with key servers. Group members register with the first key server in the list. If the first key server cannot be reached, they will register with the second key server, and so on. Note that this order does not define the overall key server priority, which is used to determine which key server is the primary key server.
 
     [bookmark: pgfId-492774]Step 3 Configure the group members if the default settings are not appropriate.
 
     [bookmark: pgfId-492776]For each group member you want to modify, select it, click the Edit (pencil) button beneath the table, and configure at least the following settings:
 
      
      	 [bookmark: pgfId-492778] GET-Enabled Interface —This is the VPN-enabled outside interface to the provider edge (PE). Traffic originating or terminating on this interface is evaluated for encryption or decryption, as appropriate. You can configure multiple interfaces by selecting an interface role object that resolves to more than one interface. Click  Select to select an interface role object or to create a new object.
 
      	 [bookmark: pgfId-492780] Interface To Be Used As Local Address —The interface whose IP address is used to identify the group member to the key server for sending data, such as rekey information. If GET is enabled on only one interface, you do not need to specify the interface to be used as the local address. If GET is enabled on more than one interface, you must specify the interface to be used as the local address. Enter the name of the interface or interface role, or click  Select to select an interface role.
 
     
 
     [bookmark: pgfId-492785]For information on the other available settings, see Edit Group Member Dialog Box.
 
     [bookmark: pgfId-492787]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-492799][bookmark: 67497][bookmark: vpchap_proc_AssigningDefaultPoliciestoYourVPNTopology]Assigning Initial Policies (Defaults) to a New VPN Topology[bookmark: marker-492795][bookmark: marker-492797]
 
     [bookmark: pgfId-492804]Use the VPN Defaults page of the Create VPN wizard to view and select the shared site-to-site VPN policies that will be assigned to the VPN topology you are creating. The page displays all the available mandatory and optional policies that can be assigned to your VPN topology, according to the selected IPsec technology. (For more information, see Understanding Mandatory and Optional Policies for Site-to-Site VPNs.)
 
     [bookmark: pgfId-492809]For information on opening the Create VPN wizard, see Creating or Editing VPN Topologies. After you create the topology, you edit these policies directly.
 
     [bookmark: pgfId-492811]For each policy type, select the shared VPN policy you want to assign to your VPN topology. Only shared policies are available for selection. Use the following tips to guide your selection:
 
      
      	 [bookmark: pgfId-492819]The initial defaults listed in this page are configured in the Security Manager Administration VPN Policy Defaults Page. If no specific default was configured for a mandatory policy, the Factory Default policy is selected. For more information about configuring default policies, see Understanding and Configuring VPN Default Policies.
 
      	 [bookmark: pgfId-492821]The shared policies listed are only those that have been committed to the database. For example, if you create a new shared IPsec Proposal policy before using the Create VPN wizard, but you do not submit (and have approved, if necessary) the policy beforehand, the new policy does not appear in the list. Ensure that you submit policies before creating a VPN if you need to use the new policies.
 
      	 [bookmark: pgfId-492823]If a policy is mandatory, you must make a selection. If there are no shared policies, Factory Default is your only option. You can always edit the policy after you create the topology.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-492828]Note If you try to select a shared policy that is currently locked by another user, a message is displayed warning you of a lock problem. To bypass the lock, select a different policy or cancel the VPN topology creation until the lock is removed. For more information, see Understanding Policy Locking.

     
      

     

     
 
      
      	 [bookmark: pgfId-492830]If a policy is optional, and there are no shared policies, you cannot select anything. If you want the features provided by that policy, configure it after you finish creating the topology.
 
      	 [bookmark: pgfId-492832]To view the contents of the policy in a read-only dialog box, select the policy and click the  View Contents button beside the policy list.
 
      	 [bookmark: pgfId-492834]If you are creating a topology that supports IKEv2 only, the Create VPN wizard will still create either an IKEv1 Preshared Key or IKEv1 Public Key Infrastructure policy according to your selection. There are no default configurations for IKEv2 Authentication policies. Whenever you choose to support IKEv2, you must manually edit the IKEv2 Authentication policy after creating the VPN to define at least the global IKEv2 settings. You can also create peer-specific IKEv2 overrides. When supporting IKEv2 only, you can unassign the IKEv1-specific policies created by the wizard.
 
     
 
     [bookmark: pgfId-492839]When you are done, click Finish to create the new VPN topology. The new VPN topology appears in the VPNs selector in the Site-to-Site VPN window, with the VPN Summary page displayed. See Viewing a Summary of a VPN Topology’s Configuration.
 
    
 
     
      [bookmark: pgfId-492853][bookmark: 67534][bookmark: vpnpage_cncpt_VPNSummaryPage]Viewing a Summary of a VPN Topology’s Configuration[bookmark: marker-492847][bookmark: marker-492849][bookmark: marker-492851]
 
     [bookmark: pgfId-492855]Use the VPN Summary page to view a summary of the configuration of a selected VPN topology. This includes information about the type of VPN topology, its devices, the assigned technology, and specific policies that are configured in it. The summary page is opened automatically after you create a VPN topology. When creating an Extranet VPN, it is also shown as the final step of the Create Extranet VPN wizard.
 
     [bookmark: pgfId-492857]To open the VPN Summary page for a VPN topology:
 
      
      	 [bookmark: pgfId-492862](Site-to-Site VPN Manager Window) Select the VPN topology, then select  VPN Summary from the Policies list.
 
      	 [bookmark: pgfId-492864](Device view) Select a device that participates in the VPN and select the  Site-to-Site VPN policy from the Policies list. Select the VPN topology, then click the  Edit VPN Policies button. This opens the Site-to-Site VPN Manager window with the topology selected, where you can select  VPN Summary from the Policies list.
 
     
 
     [bookmark: pgfId-492866]The following table describes the information shown on this page.
 
      
       
     
 
     
 
     [bookmark: pgfId-492868]Note The summary for standard VPNs is significantly different from the summary for Extranet VPNs. This table is divided in two, with the top half explaining summaries for standard VPNs, and the bottom half explaining summaries for Extranet VPNs.

     
      

     

     
 
     [bookmark: pgfId-492871]
 
      
       
        
        [bookmark: pgfId-489026]Table 25-15 [bookmark: 67561]VPN Summary Page 
 
        
       
         
         	
           
           [bookmark: pgfId-489032]Element
          
  
         	
           
           [bookmark: pgfId-489034]Description
          
  
        
 
         
         	 
           
           [bookmark: pgfId-489040]Summary Information for Standard VPNs
          
  
        
 
         
         	[bookmark: pgfId-489048]Name
  
         	[bookmark: pgfId-489050]The name of the VPN topology.
  
        
 
         
         	[bookmark: pgfId-489056]Technology
  
         	[bookmark: pgfId-489061]The IPsec technology assigned to the VPN topology. See Understanding IPsec Technologies and Policies.
  
        
 
         
         	[bookmark: pgfId-489067]Type
  
         	[bookmark: pgfId-489069]The VPN topology type: Hub-and-Spoke, Point-to-Point, or Full Mesh.
  
        
 
         
         	[bookmark: pgfId-489075]Description
  
         	[bookmark: pgfId-489077]A description of the VPN topology.
  
        
 
         
         	[bookmark: pgfId-489083]IPsec Terminator
  
         	[bookmark: pgfId-489085]Available if the VPN topology is large scale DMVPN.
 [bookmark: pgfId-489087]The name of the IPsec Terminators used to load balance GRE traffic to the hubs in the large scale DMVPN.
  
        
 
         
         	[bookmark: pgfId-489093]Primary Hub
  
         	[bookmark: pgfId-489095]Available if the VPN topology type is hub-and-spoke.
 [bookmark: pgfId-489097]The name of the primary hub in the hub-and-spoke topology.
  
        
 
         
         	[bookmark: pgfId-489103]Failover Hubs
  
         	[bookmark: pgfId-489105]Available if the VPN topology type is hub-and-spoke.
 [bookmark: pgfId-489107]The name of any secondary backup hubs that are configured in the hub-and-spoke topology.
  
        
 
         
         	[bookmark: pgfId-489113]Number of Spokes
  
         	[bookmark: pgfId-489115]Available if the VPN topology type is hub-and-spoke.
 [bookmark: pgfId-489117]The number of spokes that are included in the hub-and-spoke topology.
  
        
 
         
         	[bookmark: pgfId-489123]Peer 1
  
         	[bookmark: pgfId-489125]Available if the VPN topology type is point-to-point.
 [bookmark: pgfId-489127]The name of the device that is defined as Peer One in the point-to-point VPN topology.
  
        
 
         
         	[bookmark: pgfId-489133]Peer 2
  
         	[bookmark: pgfId-489135]Available if the VPN topology type is point-to-point.
 [bookmark: pgfId-489137]The name of the device that is defined as Peer Two in the point-to-point VPN topology.
  
        
 
         
         	[bookmark: pgfId-489143]Number of Peers
  
         	[bookmark: pgfId-489145]Available if the VPN topology type is full mesh.
 [bookmark: pgfId-489147]The number of devices included in the full mesh VPN topology.
  
        
 
         
         	[bookmark: pgfId-489153]IKE Proposal
  
         	[bookmark: pgfId-489158]The security parameters of the IKEv1 proposal configured in the VPN topology. See Configuring an IKE Proposal.
 [bookmark: pgfId-489160]Note IKEv2 proposals are not displayed in the summary.
  
        
 
         
         	[bookmark: pgfId-489166]Dynamic VTI
  
         	[bookmark: pgfId-489168]Available in an Easy VPN topology.
 [bookmark: pgfId-489173]Displays if a dynamic virtual template interface is configured on a device in an Easy VPN topology. See Configuring Dynamic VTI for Easy VPN.
  
        
 
         
         	[bookmark: pgfId-489179]Transform Sets
  
         	[bookmark: pgfId-489184]The IPsec IKEv1 transform sets that specify the authentication and encryption algorithms that will be used to secure the traffic in the VPN tunnel. See Configuring IPsec Proposals in Site-to-Site VPNs.
 [bookmark: pgfId-489186]Note IPsec IKEv2 transform sets are not displayed in the summary.
  
        
 
         
         	[bookmark: pgfId-489192]Preshared Key
  
         	[bookmark: pgfId-489194]Unavailable if the selected technology is Easy VPN.
 [bookmark: pgfId-489199]Specifies whether the shared key to use in the IKEv1 preshared key policy is user defined or auto-generated. See Configuring IKEv1 Preshared Key Policies.
 [bookmark: pgfId-489201]Note IKEv2 preshared key settings are not displayed in the summary.
  
        
 
         
         	[bookmark: pgfId-489207]Public Key Infrastructure
  
         	[bookmark: pgfId-489212]If an IKEv1 Public Key Infrastructure policy is configured in the VPN topology, specifies the certificate authority (CA) server. See Configuring IKEv1 Public Key Infrastructure Policies in Site-to-Site VPNs.
 [bookmark: pgfId-489214]Note IKEv2 PKI configurations are not displayed in the summary.
  
        
 
         
         	[bookmark: pgfId-489220]Routing Protocol
  
         	[bookmark: pgfId-489222]Available only if the selected technology is IPsec/GRE, GRE Dynamic IP, or DMVPN.
 [bookmark: pgfId-489224]The routing protocol and autonomous system (or process ID) number used in the secured IGP for configuring a GRE, GRE Dynamic IP, or DMVPN routing policy.
 [bookmark: pgfId-489226]Note Security Manager adds a routing protocol to all the devices in the secured IGP on deployment. If you want to maintain this secured IGP, you must create a router platform policy using this routing protocol and autonomous system (or process ID) number.
 [bookmark: pgfId-489231]See Understanding the GRE Modes Page.
  
        
 
         
         	[bookmark: pgfId-489237]Tunnel Subnet IP
  
         	[bookmark: pgfId-489239]Available only if the selected technology is IPsec/GRE, GRE Dynamic IP, or DMVPN.
 [bookmark: pgfId-489241]If a tunnel subnet is defined, displays the inside tunnel interface IP address, including the unique subnet mask.
 [bookmark: pgfId-489246]See Understanding the GRE Modes Page.
  
        
 
         
         	[bookmark: pgfId-489252]User Group
  
         	[bookmark: pgfId-489254]Available for an Easy VPN topology.
 [bookmark: pgfId-489259]If a User Group policy is configured on a device in the Easy VPN topology, displays the details of the policy. See Configuring a User Group Policy for Easy VPN.
  
        
 
         
         	[bookmark: pgfId-489265]PIX7.0/ASA Tunnel Group
  
         	[bookmark: pgfId-489267]Available for an Easy VPN topology.
 [bookmark: pgfId-489272]If a Connection Profile policy is configured on a PIX Firewall version 7.0+ or ASA appliance in the Easy VPN topology, displays the details of the policy. See Connection Profiles Page.
  
        
 
         
         	[bookmark: pgfId-489278]High Availability
  
         	[bookmark: pgfId-489280]Available if the VPN topology type is hub-and-spoke.
 [bookmark: pgfId-489285]If a High Availability policy is configured on a device in your hub-and-spoke VPN topology, displays the details of the policy. See Configuring High Availability in Your VPN Topology.
  
        
 
         
         	[bookmark: pgfId-489291]VRF-Aware IPsec
  
         	[bookmark: pgfId-489293]Available if the VPN topology type is hub-and-spoke.
 [bookmark: pgfId-489298]If a VRF-Aware IPsec policy is configured on a hub in your hub-and-spoke VPN topology, displays the type of VRF solution (1-Box or 2-Box) and the name of the VRF policy. See Configuring VRF Aware IPsec Settings.
  
        
 
         
         	 
           
           [bookmark: pgfId-489304]Summary Information for Extranet VPNs
          
  
        
 
         
         	[bookmark: pgfId-489312]IKE Phase 1 Proposal section
  
         	[bookmark: pgfId-489314]The parameters for the IKE Phase 1 proposal, which are defined in the IKE Proposal policy object that is assigned to the Extranet. For information about the settings, see the following topics:
 
           
           	 [bookmark: pgfId-489319]Configuring IKEv1 Proposal Policy Objects
 
           	 [bookmark: pgfId-489324]Configuring IKEv2 Proposal Policy Objects
 
          
  
        
 
         
         	[bookmark: pgfId-489330]IKE Phase 2 Proposal section
  
         	[bookmark: pgfId-489335]The parameters of the IKE Phase 2 proposal. Most of these parameters are configured in the IPsec transform set policy object assigned to the Extranet. For explanations, see Configuring IPSec IKEv1 or IKEv2 Transform Set Policy Objects.
 [bookmark: pgfId-489343]The Lifetime attribute parameter is defined in the VPN Global Settings policy, see Configuring VPN Global Settings. The Perfect Forward Secrecy parameter is defined in the IPsec Proposal policy, see Configuring IPsec Proposals in Site-to-Site VPNs.
  
        
 
         
         	[bookmark: pgfId-489349]Authentication section
  
         	[bookmark: pgfId-489351]The preshared key or the PKI enrollment policy object that defines the certificate used to authenticate the connection.
 [bookmark: pgfId-489353]When using preshared keys, you can click the Show/Hide Key button to toggle between showing and masking the key. If you print the summary or generate a PDF, the key is shown or hidden based on your selection here.
  
        
 
         
         	[bookmark: pgfId-489359]Local
  
         	[bookmark: pgfId-489361]The device at the local (managed) end of the Extranet VPN, including the display name, VPN interface name and IP address, and the protected networks.
  
        
 
         
         	[bookmark: pgfId-489367]Remote
  
         	[bookmark: pgfId-489369]The device at the remote (unmanaged) end of the Extranet VPN, including the device name, the IP address of the VPN interface, and the protected networks.
  
        
 
         
         	[bookmark: pgfId-489375]Print button
  
         	[bookmark: pgfId-489377]Click this button to print the summary. The preshared key is shown or hidden based on what is currently displayed in the page.
 [bookmark: pgfId-489379]To print the summary, you must have Adobe Acrobat Reader installed. Security Manager generates a PDF of the summary and then prints it using Acrobat’s printing capability.
  
        
 
         
         	[bookmark: pgfId-489385]Generate PDF button
  
         	[bookmark: pgfId-489387]Click this button to create a PDF of the summary. The preshared key is shown or hidden based on what is currently displayed in the page. You are prompted for a file name and a location to save the PDF.
  
        
 
       
      
 
     
 
     [bookmark: pgfId-492873]Related Topics
 
      
      	 [bookmark: pgfId-492878]Configuring an IKE Proposal
 
      	 [bookmark: pgfId-492883]Configuring IPsec Proposals in Site-to-Site VPNs
 
      	 [bookmark: pgfId-492888]Configuring IKEv1 Preshared Key Policies
 
      	 [bookmark: pgfId-492893]Configuring IKEv1 Public Key Infrastructure Policies in Site-to-Site VPNs
 
      	 [bookmark: pgfId-492898]Configuring GRE Modes for GRE or GRE Dynamic IP VPNs
 
      	 [bookmark: pgfId-492903]Configuring GRE Modes for DMVPN
 
      	 [bookmark: pgfId-492908]Configuring Large Scale DMVPNs
 
      	 [bookmark: pgfId-492913]Configuring an IPsec Proposal for Easy VPN
 
      	 [bookmark: pgfId-492918]Configuring a User Group Policy for Easy VPN
 
      	 [bookmark: pgfId-492923]Configuring a Connection Profile Policy for Easy VPN
 
      	 [bookmark: pgfId-492928]Creating or Editing Extranet VPNs
 
     
 
    
 
   
 
    
     [bookmark: pgfId-492954][bookmark: 67812][bookmark: vpchap_cncpt_CreatingorEditingExtranetVPNs]Creating or Editing Extranet VPNs[bookmark: marker-492944][bookmark: marker-492946][bookmark: marker-492948][bookmark: marker-492950][bookmark: marker-492952]
 
    [bookmark: pgfId-492956]Security Manager provides a simplified method of creating a regular IPsec point-to-point VPN between a device that you are managing in Security Manager and one that is not managed. This type of VPN is called an Extranet.
 
    [bookmark: pgfId-492958]Typically, an Extranet is a site-to-site VPN connection between your network and the network of a partner or a service provider. However, it can also be a VPN connection within your organization’s network, but between devices managed by different groups, or between a Cisco device and a non-Cisco device (which Security Manager cannot manage).
 
    [bookmark: pgfId-492960]Use the Create Extranet VPN wizard to create this type of point-to-point VPN topology. Creating an Extranet VPN involves specifying the devices, the VPN interfaces that are the source and destination endpoints of the VPN tunnel, and the protected networks that will be secured by the tunnel. You also specify the IKE and IPsec proposals and preshared key or certificates required to complete a secure connection.
 
    [bookmark: pgfId-492962]When you edit an Extranet VPN topology, the Edit Extranet VPN dialog box contains the same pages as the Create Extranet VPN wizard, with the exception of the IKE proposal page, but the pages are laid out in a tabbed format rather than being presented as a wizard. Clicking OK on any tab in the dialog box saves your definitions on all the tabs. For IKE proposals, IPsec proposals, preshared keys, and Public Key Infrastructure certificates, you must edit the policies directly.
 
    [bookmark: pgfId-492964]Tips
 
     
     	 [bookmark: pgfId-492966]VPN default policies do not apply to Extranet VPNs. The settings defined on the Security Manager Administration VPN Defaults page are ignored. If you have shared policies that you want to use in the Extranet VPN configuration, you can assign them to the VPN after you create it with the Create Extranet VPN wizard. Assigning the shared policy replaces the policy created by the wizard.
 
     	 [bookmark: pgfId-492968]You cannot select your pre-defined IKE proposal or IPsec transform set policy objects when creating an Extranet VPN. If you have existing objects that you want to use, you can edit the relevant policies after creating the VPN and select the objects. You can then delete the objects created by the Create Extranet VPN wizard, if desired.
 
     	 [bookmark: pgfId-492970]After creating an Extranet VPN, you cannot convert it to a standard point-to-point VPN, where you are managing both ends of the VPN in Security Manager. Instead, you must delete and recreate the VPN.
 
     	 [bookmark: pgfId-492975]You can configure Extranet VPN connections for regular IPsec point-to-point connections only. For example, you cannot use this method to identify a GET VPN key server that exists in your service provider’s network. To configure all other types of Extranet connections, you must add dummy unmanaged devices to the Security Manager inventory as described in Including Unmanaged or Non-Cisco Devices in a VPN.
 
    
 
    [bookmark: pgfId-492977]Related Topics
 
     
     	 [bookmark: pgfId-492982]Understanding VPN Topologies
 
     	 [bookmark: pgfId-492987]Configuring VPN Topologies in Device View
 
     	 [bookmark: pgfId-492992]Understanding IPsec Technologies and Policies
 
     	 [bookmark: pgfId-492997]Using Wizards
 
    
 
    
 
    [bookmark: pgfId-492999]Step 1 Do one of the following
 
     
     	 [bookmark: pgfId-493004]To create a new Extranet VPN, in the Site-to-Site VPN Manager Window or the Site-to-Site VPN policy page (Device View), click the  Create VPN Topology (+) button and select  Extranet VPN . The Create Extranet VPN wizard starts with the Name and Technology page.
 
     	 [bookmark: pgfId-493006]To edit an existing Extranet VPN, select the VPN topology in the Site-to-Site VPN Manager window or the Site-to-Site VPN policy page (Device View) and click the  Edit VPN Topology (pencil) button. The Edit Extranet VPN dialog box opens to the Device Selection tab.
 
    
 
    [bookmark: pgfId-493008]Step 2 On the Name and Technology page or tab, configure the following; only the name is required:
 
     
     	 [bookmark: pgfId-493010] Name —A unique name that identifies the VPN topology.
 
     	 [bookmark: pgfId-493012] Description —A description of the VPN, up to 1024 characters.
 
     	 [bookmark: pgfId-493014] Creation Date —The date on which the VPN was created. When creating the VPN, today’s date is the default. However, you can click the calendar icon beside the edit box and select the desired date.
 
     	 [bookmark: pgfId-493016] Ticket Number —If you use a ticket system, and the action you are taking relates to a tracked requirement, enter the number in this field. Security Manager does not use this number; it is for your internal tracking purposes only.
 
     	 [bookmark: pgfId-493018] Last Modified By —The name, user ID, email address, or other indicator of the person who last changed the settings for the VPN. Security Manager does not use this field; it is for your internal tracking purposes only.
 
    
 
    [bookmark: pgfId-493020]In the wizard, click Next; in the Edit Extranet VPN dialog box, click the Device Selection tab.
 
    [bookmark: pgfId-493022]Step 3 On the Device Selection page or tab, configure the devices, interfaces, and protected networks for each end of the connection:
 
     
     	 [bookmark: pgfId-493024] Local —This is the device in your managed network. The device must be in the Security Manager inventory. Configure all of these properties:
 
    
 
    [bookmark: pgfId-493026] – Device—Enter the display name of the device or click Select to select it from the list of devices in the inventory. You can select ASA 5500 series devices, PIX firewalls, or Cisco IOS routers (including ASRs).
 
    [bookmark: pgfId-493028] – VPN Tunnel Interface—The name of the interface or interface role that identifies the external interface for the VPN connection. Click Select to select an existing interface or interface role, or to create a new interface role.
 
    [bookmark: pgfId-493030]When you select an interface or role, the IP address for the matching interface are listed in the drop-down list next to the IP Address field. Beginning with version 4.9, Security Manager supports IPv6 addresses in Extranet VPN. You can see a list of IPv4 and IPv6 addresses, by default the IPv4 address will be displayed. If no address appears, Security Manager could not determine the IP address. Check your configuration or object selection.
 
    [bookmark: pgfId-493032] – Protected Networks—The networks that the device is protecting for this VPN. Click Select to display the Protected Network Selection dialog box in which you can specify the protected networks using an interface name, interface role object, network/host group object, or ACL object. You can also use the Protected Network Selection dialog box to define new network/host group or ACL objects.
 
     
      
    
 
    
 
    [bookmark: pgfId-493037]Note You can also edit the local device endpoint settings as described in Defining the Endpoints and Protected Networks. The settings are similar to these, with the added ability to define interface role objects.

    
     

    

    
 
    [bookmark: pgfId-493039] – Crypto Map name—You can manually enter the Crypto Map name for the device. There is no default value. If you do not enter any value, Security Manager uses the Crypto Map Name of the device or generates a new Crypto Map Name. If a Crypto Map already exists on the VPN interface, Security Manager will reuse the same name.
 
    [bookmark: pgfId-493041] – Crypto ACL name—You can manually enter the Crypto ACL name for the device. There is no default value. If you do not enter any value, Security Manager generates a new Crypto ACL name.
 
    [bookmark: pgfId-493043] – Crypto Map Sequence—Security Manager displays the sequence number of the device in this field after it has discovered the device in the managed network. You cannot edit this value. If you are adding a new VPN topology, Security Manager populates the Sequence Number field with a value of #. You cannot edit this value.
 
    [bookmark: pgfId-493048]For more information see, Configuring Crypto Map
 
     
     	 [bookmark: pgfId-493050] Remote —This is the device that you are not managing in Security Manager. Configure all of these properties:
 
    
 
    [bookmark: pgfId-493052] – Name—The name of the device, equivalent to the display name used in the Security Manager inventory.
 
    [bookmark: pgfId-493054] – IP Address—The IP address of the VPN interface on the device. You can enter a maximum of 10 IP addresses using space as the delimiter. Beginning with version 4.9, Security Manager supports IPv6 addresses in addition to IPv4 addresses.
 
     
      
    
 
    
 
    [bookmark: pgfId-493056]Note Beginning from version 4.8, Security Manager enables you to configure multiple peer IP addresses for the same extranet VPN configuration. This allows the next peer device in the list to act as a failover when the first device is not available for VPN services. This backup peer support is available for Cisco Adaptive Security Appliance (ASA) devices and Cisco IOS routers.

    
     

    

    
 
    [bookmark: pgfId-493058] – Protected Networks—The networks that the device is protecting for this VPN. Click Select to display the Protected Network Selection dialog box in which you can specify the protected networks using a network/host group object or ACL object. You can also use the Protected Network Selection dialog box to define new network/host group or ACL objects.
 
     
      
    
 
    
 
    [bookmark: pgfId-493063]Note You can also edit the remote device endpoint settings as described in Defining the Endpoints and Protected Networks. However, the settings are identical to these, and you cannot specify the protected networks using an interface name or interface role object.

    
     

    

    
 
    [bookmark: pgfId-493065]In the wizard, click Next. In the Edit VPN dialog box, you are finished; to edit the remaining characteristics, you must edit the IKE Proposal, IPsec Proposal, IKEv1 Preshared Key, IKEv1 Public Key Infrastructure, IKEv2 Authentication, and VPN Global Settings policies to change the settings described in the next step.
 
    [bookmark: pgfId-493067]Step 4 On the IKE Proposal page of the Create Extranet VPN wizard, define the IKE proposal, the IPsec proposal, and either the preshared key or the certificate:
 
     
     	 [bookmark: pgfId-493069]Select  IKEv1 or  IKEv2 . You can use IKEv2 on ASA 5500 series devices running release 8.4(x) only.
 
    
 
    [bookmark: pgfId-493074]If you want to change IKE versions after creating the Extranet VPN, you must edit all of these policies to unassign or replace the old configuration while configuring options for the desired version: IKE Proposal, IPsec Proposal, IKEv1 Preshared Key, IKEv1 Public Key Infrastructure, IKEv2 Authentication, VPN Global Settings. For information on how IKEv1 and IKEv2 differ, see Comparing IKE Version 1 and 2.
 
     
     	 [bookmark: pgfId-493082]Configure the IKE Phase 1 Proposal parameters. These parameters will be used to create an IKE proposal policy object with the name  ExtranetName  _ikeBB . For an explanation of the parameters, see Configuring IKEv1 Proposal Policy Objects or Configuring IKEv2 Proposal Policy Objects.
 
    
 
    [bookmark: pgfId-493084]To edit these values after creating the VPN, you simply need to edit the object. You can edit the object in the Policy Object Manager or directly through the IKE Proposal policy for the VPN.
 
     
      
    
 
    
 
    [bookmark: pgfId-493086]Note The DH Group attribute (for Diffie-Hellman modulus group) is called Modulus Group in other policies and policy objects.

    
     

    

    
 
     
     	 [bookmark: pgfId-493091]Configure the IKE Phase 2 (IPsec) Proposal parameters. Most of these parameters will be used to create an IPsec transform set policy object with the name  ExtranetName  _transformSet . For an explanation of the parameters, see Configuring IPSec IKEv1 or IKEv2 Transform Set Policy Objects. Note that the AH Hash Algorithm setting is available only if the local device is a router.
 
    
 
    [bookmark: pgfId-493093]To edit these values after creating the VPN, you simply need to edit the object. You can edit the object in the Policy Object Manager or directly through the IPsec Proposal policy for the VPN.
 
    [bookmark: pgfId-493095]The following settings are not part of the IPsec transform set object:
 
    [bookmark: pgfId-493100] – Enable Perfect Forward Secrecy, DH Group—Whether to use a unique session key for each encrypted exchange, which prevents an attacker from decrypting a captured exchange even if the attacker knows the preshared or private keys used by both ends of the tunnel. If you select this option, also select the Diffie-Hellman (DH) modulus group to use for deriving the key. For more information on the modulus group, see Deciding Which Diffie-Hellman Modulus Group to Use.
 
    [bookmark: pgfId-493102]To change this option after creating the VPN, edit the IPsec Proposal policy.
 
    [bookmark: pgfId-493104] – Lifetime—The number of seconds a security association will exist before expiring. The default is 3,600 seconds (one hour).
 
    [bookmark: pgfId-493106]To change this option after creating the VPN, edit the VPN Global Settings policy.
 
     
     	 [bookmark: pgfId-493108]If you select  Preshared Key for authentication, enter the key used to authenticate connections with the remote host.
 
    
 
    [bookmark: pgfId-493110]To edit the key after creating the VPN, you must edit either the IKEv1 Preshared Key or IKEv2 Authentication policy depending on the IKE version you are using. The key is masked in these policies, but you can display the key by selecting the VPN Summary policy and clicking the Show Key button beside the preshared key.
 
     
     	 [bookmark: pgfId-493115]If you select  Certificate , select the PKI enrollment object that defines the certificate name. If the required object is not yet defined, select  <Add New> to open the Add PKI selector, from which you can add new, or edit existing, PKI enrollment objects. For more information about PKI enrollment objects, see PKI Enrollment Dialog Box.
 
    
 
    [bookmark: pgfId-493117]To edit the certificate settings after creating the VPN, you can edit the object in the Policy Object Manager or directly through either the IKEv1 Public Key Infrastructure or IKEv2 Authentication policy depending on the IKE version you are using.
 
    [bookmark: pgfId-493119]In the wizard, click Next.
 
    [bookmark: pgfId-493121]Step 5 (Create Extranet VPN wizard only.) On the Summary page, verify that the settings are correct and click Finish.
 
    [bookmark: pgfId-493123]Security Manager creates the topology and the required policy objects, and adds the VPN to the list of VPNs in the Site-to-Site VPN Manager.
 
    [bookmark: pgfId-493128]Step 6 If you want to configure dial backup, select the Peers policy and follow the instructions in Configuring Dial Backup.
 
    [bookmark: pgfId-493130]

    
     

    

    
 
   
 
    
     [bookmark: pgfId-493138][bookmark: 68012][bookmark: vpchap_proc_DeletingaVPNTopology]Deleting a VPN Topology[bookmark: marker-493136]
 
    [bookmark: pgfId-493140]Deleting a VPN topology removes IPsec tunnels between peers and all configurations associated with the VPN topology from the devices and networks assigned to the site-to-site VPN. The actual VPN is not removed from the network until you deploy configurations.
 
    
 
    [bookmark: pgfId-493142]Step 1 Do one of the following:
 
     
     	 [bookmark: pgfId-493147]Select  Manage > Site-To-Site VPNs to open the Site-to-Site VPN Manager Window.
 
     	 [bookmark: pgfId-493152]In Device view, select a device that participates in the VPN you want to delete, then select the  Site to Site VPN policy from the policy selector (see Configuring VPN Topologies in Device View).
 
    
 
    [bookmark: pgfId-493154]Step 2 Select the VPN topology you want to delete and click the Delete VPN Topology (trash can) button. You are asked to confirm the deletion.
 
    [bookmark: pgfId-493156]

    
     

    

    
 
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-536791][bookmark: 94768][bookmark: ipdvchap_cncpt_GettingStartedwithIPSConfiguration]Getting Started with IPS Configuration[bookmark: marker-536783][bookmark: marker-536785][bookmark: marker-536787][bookmark: marker-536789]
      
      
 
     
 
 
    [bookmark: pgfId-536793]Cisco Intrusion Prevention System (IPS) Sensors are network devices that perform real-time monitoring of network traffic for suspicious activities and active network attacks. The IPS sensor analyzes network packets and flows to determine whether their contents appear to indicate an attack against your network.
 
    [bookmark: pgfId-536797]Using Cisco Security Manager, you can configure and manage sensors, which can be dedicated stand-alone network appliances, Catalyst 6500 switch modules, service modules running in supported ASA devices or routers, and IPS-enabled Cisco IOS Software images running on integrated services routers. For a full list of supported IPS devices and software versions, see the Supported Devices and Software Versions for Cisco Security Manager document for this version of the product.
 
    [bookmark: pgfId-536799]This chapter contains the following topics:
 
     
     	 [bookmark: pgfId-536804]Understanding IPS Network Sensing
 
     	 [bookmark: pgfId-536809]Overview of IPS Configuration
 
     	 [bookmark: pgfId-536814]Identifying Allowed Hosts
 
     	 [bookmark: pgfId-536819]Configuring SNMP
 
     	 [bookmark: pgfId-536824]Managing User Accounts and Password Requirements
 
     	 [bookmark: pgfId-536829]Identifying an NTP Server
 
     	 [bookmark: pgfId-536834]Identifying DNS Servers
 
     	 [bookmark: pgfId-536839]Identifying an HTTP Proxy Server
 
     	 [bookmark: pgfId-536844]IPS SSHv2 Known Host Keys
 
     	 [bookmark: pgfId-536849]Configuring IPS SSHv1 Fallback Settings
 
     	 [bookmark: pgfId-536854]Configuring the External Product Interface
 
     	 [bookmark: pgfId-536859]Configuring IPS Logging Policies
 
     	 [bookmark: pgfId-536864]IPS Health Monitor
 
     	 [bookmark: pgfId-536869]Configuring IPS Security Settings
 
    
 
   
 
    
     [bookmark: pgfId-536883][bookmark: 94785][bookmark: ipsvchap_cncpt_UnderstandingNetworkSensing]Understanding IPS Network Sensing[bookmark: marker-536875][bookmark: marker-536877][bookmark: marker-536879][bookmark: marker-536881]
 
    [bookmark: pgfId-536885]Network sensing can be accomplished using Cisco IPS sensors (appliances, switch modules, network modules, and SSMs) and Cisco IOS IPS devices (Cisco IOS routers with IPS-enabled images and Cisco ISRs). These sensing platforms are components of the Cisco Intrusion Prevention System and can be managed and configured through Cisco Security Manager. These sensing platforms monitor and analyze network traffic in real time. They do this by looking for anomalies and misuse on the basis of network flow validation, an extensive embedded signature library, and anomaly detection engines. However, these platforms differ in how they can respond to perceived intrusions.
 
     
      
    
 
    
 
    [bookmark: pgfId-536894]Tip Cisco IPS sensors and Cisco IOS IPS devices are often referred to collectively as IPS devices or simply sensors. However, Cisco IOS IPS does not run the full dedicated IPS software, and its configuration does not include IPS device-specific policies. Additionally, the amount of sensing that you can perform with Cisco IOS IPS is more limited. The following sections focus on using dedicated IPS devices, including service modules installed in IOS routers, rather than Cisco IOS IPS. For a discussion focused on Cisco IOS IPS, see Intrusion Prevention System (IPS) Cisco IOS Intrusion Prevention System Deployment Guide on Cisco.com and Chapter 45, “Configuring IOS IPS Routers”. Also, see http://www.cisco.com/go/iosips.

    
     

    

    
 
    [bookmark: pgfId-536896]When an IPS device detects unauthorized network activity, it can terminate the connection, permanently block the associated host, and take other actions.
 
     
      
    
 
    
 
    [bookmark: pgfId-536902]Note For more overview information on IPS sensors, including a comparison of the available appliances and service modules and details about device interfaces, see Introducing the Sensor in Installing Cisco Intrusion Prevention System Appliances and Modules. A list of these documents for each IPS release is available at http://www.cisco.com/en/US/products/hw/vpndevc/ps4077/prod_installation_guides_list.html.

    
     

    

    
 
    [bookmark: pgfId-536904]This section contains the following topics:
 
     
     	 [bookmark: pgfId-536909]Capturing Network Traffic
 
     	 [bookmark: pgfId-536914]Correctly Deploying the Sensor
 
     	 [bookmark: pgfId-536919]Tuning the IPS
 
    
 
     
      [bookmark: pgfId-536931][bookmark: 94809][bookmark: ipdvchap_cncpt_CapturingNetworkTraffic]Capturing Network Traffic[bookmark: marker-536925][bookmark: marker-536927][bookmark: marker-536929]
 
     [bookmark: pgfId-536933]The sensor can operate in either promiscuous or inline mode. The following illustration shows how you can deploy a combination of sensors operating in both inline (IPS) and promiscuous (IDS) modes to protect your network.
 
     [bookmark: pgfId-536937]Figure 36-1 [bookmark: 94821]Comprehensive IPS Deployment Solutions
 
     [bookmark: pgfId-536940]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-536942]The command and control interface is always Ethernet. This interface has an assigned IP address, which allows it to communicate with the manager workstation or network devices (Cisco switches, routers, and firewalls). Because this interface is visible on the network, you should use encryption to maintain data privacy. SSH is used to protect the CLI and TLS/SSL is used to protect the manager workstation. SSH and TLS/SSL are enabled by default on the manager workstations.
 
     [bookmark: pgfId-536944]When responding to attacks, the sensor can do the following:
 
      
      	 [bookmark: pgfId-536946]Insert TCP resets via the sensing interface.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-536948]Note You should select the TCP reset action only on signatures associated with a TCP-based service. If selected as an action on non-TCP-based services, no action is taken. Additionally, TCP resets are not guaranteed to tear down an offending session because of limitations in the TCP protocol.

     
      

     

     
 
      
      	 [bookmark: pgfId-536950]Make ACL changes on switches, routers, and firewalls that the sensor manages.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-536952]Note ACLs may block only future traffic, not current traffic.

     
      

     

     
 
      
      	 [bookmark: pgfId-536954]Generate IP session logs, session replay, and trigger packets display.
 
     
 
     [bookmark: pgfId-536956]IP session logs are used to gather information about unauthorized use. IP log files are written when events occur that you have configured the appliance to look for.
 
      
      	 [bookmark: pgfId-536958]Implement multiple packet drop actions to stop worms and viruses.
 
     
 
    
 
     
      [bookmark: pgfId-536970][bookmark: 94839][bookmark: ipdvchap_cncpt_CorrectlyDeployingtheSensor]Correctly Deploying the Sensor[bookmark: marker-536964][bookmark: marker-536966][bookmark: marker-536968]
 
     [bookmark: pgfId-536972]Before you deploy and configure your sensors, you should understand the following about your network:
 
      
      	 [bookmark: pgfId-536974]The size and complexity of your network.
 
      	 [bookmark: pgfId-536976]Connections between your network and other networks, including the Internet.
 
      	 [bookmark: pgfId-536978]The amount and type of traffic on your network.
 
     
 
     [bookmark: pgfId-536980]This knowledge will help you determine how many sensors are required, the hardware configuration for each sensor (for example, the size and type of network interface cards), and how many managers are needed.
 
     [bookmark: pgfId-536982]You should always position the IPS sensor behind a perimeter-filtering device, such as a firewall or adaptive security appliance. The perimeter device filters traffic to match your security policy thus allowing acceptable traffic in to your network. Correct placement significantly reduces the number of alerts, which increases the amount of actionable data you can use to investigate security violations. If you position the IPS sensor on the edge of your network in front of a firewall, your sensor will produce alerts on every single scan and attempted attack even if they have no significance to your network implementation. You will receive hundreds, thousands, or even millions of alerts (in a large enterprise environment) that are not really critical or actionable in your environment. Analyzing this type of data is time consuming and costly.
 
    
 
     
      [bookmark: pgfId-536996][bookmark: 94861][bookmark: ipdvchap_cncpt_TuningtheIPS]Tuning the IPS[bookmark: marker-536988][bookmark: marker-536990][bookmark: marker-536992][bookmark: marker-536994]
 
     [bookmark: pgfId-536998]Tuning the IPS ensures that the alerts you see reflect true actionable information. Without tuning the IPS, it is difficult to do security research or forensics on your network because you will have thousands of benign events, also known as false positives. False positives are a by-product of all IPS devices, but they occur much less frequently in Cisco IPS devices because Cisco IPS devices are stateful, normalized, and use vulnerability signatures for attack evaluation. Cisco IPS devices also provide risk rating, which identifies high risk events, and policy-based management, which lets you deploy rules to enforce IPS signature actions based on risk rating.
 
     [bookmark: pgfId-537000]Follow these tips when tuning your IPS sensors:
 
      
      	 [bookmark: pgfId-537002]Place your sensor on your network behind a perimeter-filtering device.
 
     
 
     [bookmark: pgfId-537004]Proper sensor placement can reduce the number of alerts you need to examine by several thousands a day.
 
      
      	 [bookmark: pgfId-537006]Deploy the sensor with the default signatures in place.
 
     
 
     [bookmark: pgfId-537008]The default signature set provides you with a very high security protection posture. The Cisco signature team has spent many hours on testing the defaults to give your sensor the highest protection. If you think that you have lost these defaults, you can restore them.
 
      
      	 [bookmark: pgfId-537010]Make sure that the event action override is set to drop packets with a risk rating greater than 90.
 
     
 
     [bookmark: pgfId-537012]This is the default and ensures that high risk alerts are stopped immediately.
 
      
      	 [bookmark: pgfId-537014]Filter out known false positives caused by specialized software, such as vulnerability scanner and load balancers by one of the following methods:
 
     
 
     [bookmark: pgfId-537016] – You can configure the sensor to ignore the alerts from the IP addresses of the scanner and load balancer.
 
     [bookmark: pgfId-537018] – You can configure the sensor to allow these alerts and then use Event Viewer to filter out the false positives.
 
      
      	 [bookmark: pgfId-537020]Filter the Informational alerts.
 
     
 
     [bookmark: pgfId-537022]These low priority events notifications could indicate that another device is doing reconnaissance on a device protected by the IPS. Research the source IP addresses from these Informational alerts to determine what the source is.
 
      
      	 [bookmark: pgfId-537024]Analyze the remaining actionable alerts:
 
     
 
     [bookmark: pgfId-537026] – Research the alert.
 
     [bookmark: pgfId-537028] – Fix the attack source.
 
     [bookmark: pgfId-537030] – Fix the destination host.
 
     [bookmark: pgfId-537032] – Modify the IPS policy to provide more information.
 
    
 
   
 
    
     [bookmark: pgfId-537042][bookmark: 94910][bookmark: ipdvchap_proc_OverviewofIPSConfiguration]Overview of IPS Configuration[bookmark: marker-537038][bookmark: marker-537040]
 
    [bookmark: pgfId-537044]There are a wide variety of devices on which you can configure the Intrusion Prevention System. From a configuration point-of-view, you can separate the devices into two groups: dedicated appliances and service modules (for routers, switches, and ASA devices) that run the full IPS software; and IPS-enabled routers running Cisco IOS Software 12.4(11)T and later (Cisco IOS IPS).
 
    [bookmark: pgfId-537049]The following procedure is an overview of IPS configuration on dedicated appliances and service modules. For Cisco IOS IPS devices (which does not include IPS service modules installed in a router), see Overview of Cisco IOS IPS Configuration.
 
    
 
    [bookmark: pgfId-537051]Step 1 Install and connect the device to your network. Install the device software and perform basic device configuration. Install the licenses required for all of the services running on the device. The amount of initial configuration that you perform influences what you will need to configure in Security Manager.
 
    [bookmark: pgfId-537055]Follow the instructions in the Installing Cisco Intrusion Prevention System Appliances and Modules document for the IPS version you are using.
 
    [bookmark: pgfId-537060]Step 2 Add the device to the Security Manager device inventory (see Adding Devices to the Device Inventory).
 
     
      
    
 
    
 
    [bookmark: pgfId-537062]Tip You can discover router and Catalyst switch modules when adding the device in which the module is installed. For ASA devices, you must add the service module separately.

    
     

    

    
 
    [bookmark: pgfId-537067]Step 3 Configure the interfaces as described in Configuring Interfaces. You must enable the interfaces connected to your network for the device to function.
 
    [bookmark: pgfId-537069]For certain types of service module, there are additional policies to configure:
 
     
     	 [bookmark: pgfId-537074]Router-hosted service modules—Configure the  IPS Module interface settings policy on the router. For more information, see IPS Module Interface Settings on Cisco IOS Routers.
 
     	 [bookmark: pgfId-537079]IDSM—Configure the  IDSM Settings Catalyst platform policy. For more information, see IDSM Settings.
 
     	 [bookmark: pgfId-537087]IPS modules on ASA devices—Configure the  Platform > Service Policy Rules > IPS, QoS, and Connection Rules policy on the host ASA to specify the traffic that should be inspected. For more information, see About IPS Modules on ASA Devices and Service Policy Rules Page.
 
    
 
    [bookmark: pgfId-537092]Step 4 Use the Virtual Sensors policy to assign interfaces to the virtual sensors, including the base vs0 virtual sensor that exists for all IPS devices. For information about virtual sensor settings and assigning interfaces to a virtual sensor, see Defining A Virtual Sensor.
 
    [bookmark: pgfId-537097]If the device supports it, and you have a need for it, you can also create user-defined virtual sensors so that a single device acts like multiple sensors. Most of the IPS configuration is done on the parent device, but you can configure unique settings per virtual sensor for signatures, anomaly detection, and event actions. For more information, see Chapter 38, “Configuring Virtual Sensors”.
 
    [bookmark: pgfId-537099]Step 5 Configure basic device access platform policies. These policies determine who can log into the device:
 
     
     	 [bookmark: pgfId-537104] AAA —Configure this policy if you want to use a RADIUS server to control access to the device. You can use AAA control in conjunction with local user accounts defined in the User Accounts policy. See Configuring AAA Access Control for IPS Devices.
 
     	 [bookmark: pgfId-537109] Allowed Hosts —The addresses of hosts who are allowed access. Ensure that the Security Manager server is included as an allowed host, or you cannot configure the device using Security Manager. See Identifying Allowed Hosts.
 
     	 [bookmark: pgfId-537114] SNMP —Configure this policy if you want to use an SNMP application to manage the device. See Configuring SNMP.
 
     	 [bookmark: pgfId-537119] Password Requirements —You can define the acceptable characteristics of a user password. See Configuring User Password Requirements.
 
     	 [bookmark: pgfId-537124] User Accounts —The user accounts defined on the device. See Configuring IPS User Accounts.
 
    
 
    [bookmark: pgfId-537126]Step 6 Configure basic server access platform policies. These policies identify the servers to which the device can connect:
 
     
     	 [bookmark: pgfId-537131] External Product Interface —If you use Management Center for Cisco Security Agents, configure this policy to allow the sensor to download host postures from the application. See Configuring the External Product Interface.
 
     	 [bookmark: pgfId-537136] NTP —Configure this policy if you want to use a Network Time Protocol server to control the device time. See Identifying an NTP Server.
 
     	 [bookmark: pgfId-537144] DNS, HTTP Proxy —The DNS and HTTP Proxy policies are required only if you configure global correlation. They identify a server that can resolve DNS names to IP addresses. Use the HTTP Proxy policy if your network requires the use of a proxy to make Internet connections; otherwise, use the DNS policy. See Identifying DNS Servers or Identifying an HTTP Proxy Server.
 
    
 
    [bookmark: pgfId-537149]Step 7 Configure the Logging policy if you want non-default logging. See Configuring IPS Logging Policies.
 
    [bookmark: pgfId-537151]Step 8 Configure IPS signatures and event actions. Event action policies are easier to configure than creating custom signatures, so try to use event action filters and overrides to modify signature behavior before trying to edit specific signatures. For more information, see the following topics:
 
     
     	 [bookmark: pgfId-537156]Chapter 40, “Configuring Event Action Rules”
 
     	 [bookmark: pgfId-537161]Configuring Signatures
 
    
 
    [bookmark: pgfId-537166]Step 9 If you use any of the Request Block or Request Rate Limit event actions, configure blocking or rate limiting hosts. See Configuring IPS Blocking and Rate Limiting.
 
    [bookmark: pgfId-537168]Step 10 Configure other desired advanced IPS services. See the following topics:
 
     
     	 [bookmark: pgfId-537173]Chapter 42, “Configuring Global Correlation”
 
     	 [bookmark: pgfId-537178]Configuring Anomaly Detection
 
    
 
    [bookmark: pgfId-537180]Step 11 Maintain the device:
 
     
     	 [bookmark: pgfId-537182]Update and redeploy configurations as necessary.
 
     	 [bookmark: pgfId-537187]Apply updated signature and engine packages. For information about checking for updates, applying them, and setting up regular automated updates, see Managing IPS Updates.
 
     	 [bookmark: pgfId-537189]Manage the device licenses. You can update and redeploy licenses, or automate license updates. For more information, see the following topics:
 
    
 
    [bookmark: pgfId-537194] – Updating IPS License Files
 
    [bookmark: pgfId-537199] – Redeploying IPS License Files
 
    [bookmark: pgfId-537204] – Automating IPS License File Updates
 
     
     	 [bookmark: pgfId-537209]Manage the certificates required for SSL (HTTPS) communication. These certificates expire, so you need to regenerate them approximately every 2 years. For information on regenerating certificates and ensuring that the certificates defined on the device are synchronized with those stored in the Security Manager certificate store, see Managing IPS Certificates.
 
    
 
    [bookmark: pgfId-537211]Step 12 Monitor the device:
 
     
     	 [bookmark: pgfId-537213]Use the Event Viewer application to view alerts generated from the device. You can open Event Viewer from the Launch menu in Configuration Manager or Report Manager, or from the Windows Start menu.
 
    
 
    [bookmark: pgfId-537218] – For information on using Event Viewer, see Chapter 68, “Viewing Events”.
 
    [bookmark: pgfId-537223] – For an example of how to filter IPS alerts, see Removing False Positive IPS Events from the Event Table.
 
     
     	 [bookmark: pgfId-537225]Use the Report Manager application to generate reports on IPS usage, including comparisons of inline vs. promiscuous mode, and global correlation vs. traditional inspection. You can also analyze top attackers, victims, signatures, blocked signatures, and perform target analysis. The following topics explain Report Manager and the IPS reports in more detail:
 
    
 
    [bookmark: pgfId-537230] – Chapter 69, “Managing Reports”
 
    [bookmark: pgfId-537235] – Understanding General IPS Reports
 
    [bookmark: pgfId-537240] – Understanding IPS Top Reports
 
    [bookmark: pgfId-537245] – Opening and Generating Reports
 
    [bookmark: pgfId-537247]

    
     

    

    
 
   
 
    
     [bookmark: pgfId-537269][bookmark: 95071][bookmark: ipdvchap_proc_IdentifyingAllowedHosts]Identifying Allowed Hosts[bookmark: marker-537257][bookmark: marker-537259][bookmark: marker-537261][bookmark: marker-537263][bookmark: marker-537265][bookmark: marker-537267]
 
    [bookmark: pgfId-537271]Use the Allowed Hosts policy to identify which hosts or networks have permission to access the IPS sensor. By default, no hosts are permitted to access a sensor, so you must add hosts or networks to this policy.
 
    [bookmark: pgfId-537273]Specifically, you must add either the IP address of the Security Manager server, or its network address, or Security Manager cannot configure the device. Also add the addresses of all other management hosts that you use, such as CS-MARS.
 
     
      
    
 
    
 
    [bookmark: pgfId-537275]Tip If you add host addresses only, you will be limited to using those workstations to access the device. Instead, you can specify network addresses to allow all hosts connected to specific “safe” networks access.

    
     

    

    
 
    
 
    [bookmark: pgfId-537277]Step 1 Do one of the following to open the Allowed Hosts policy:
 
     
     	 [bookmark: pgfId-537279](Device view) Select  Platform > Device Admin > Device Access > Allowed Hosts from the Policy selector.
 
     	 [bookmark: pgfId-537281](Policy view) Select  IPS > Platform > Device Admin > Allowed Hosts , then select an existing policy or create a new one.
 
    
 
    [bookmark: pgfId-537283]Step 2 Do one of the following:
 
     
     	 [bookmark: pgfId-537285]To add an entry, click the  Add Row button and fill in the Access List dialog box.
 
    
 
    [bookmark: pgfId-537287]You can add up to 512 entries.
 
     
     	 [bookmark: pgfId-537289]To edit an entry, select it and click the  Edit Row button.
 
     	 [bookmark: pgfId-537291]To delete an entry, select it and click the  Delete Row button.
 
    
 
    [bookmark: pgfId-537293]Step 3 When adding or editing an entry, specify the host or network address in the Add or Modify Access List dialog box, then click OK. You can enter addresses using the following formats:
 
     
     	 [bookmark: pgfId-537295]Host address—A simple IP address, such as 10.100.10.10.
 
     	 [bookmark: pgfId-537297]Network address—A network address and mask, such as 10.100.10.0/24 or 10.100.10.0/255.255.255.0.
 
     	 [bookmark: pgfId-537299]A network/host policy object—Click  Select to select an existing object or to create a new one. To use the object in this policy, it must have a single value, either a single network or a single host.
 
    
 
    [bookmark: pgfId-537301]

    
     

    

    
 
   
 
    
     [bookmark: pgfId-537317][bookmark: 95130][bookmark: ipdvchap_proc_ConfiguringSNMP-2]Configuring SNMP[bookmark: marker-537309][bookmark: marker-537311][bookmark: marker-537313][bookmark: marker-537315]
 
    [bookmark: pgfId-537319]SNMP is an application layer protocol that facilitates the exchange of management information between network devices. SNMP enables network administrators to manage network performance, find and solve network problems, and plan for network growth.
 
    [bookmark: pgfId-537321]SNMP is a simple request/response protocol. The network-management system issues a request, and managed devices return responses. This behavior is implemented by using one of four protocol operations: Get, GetNext, Set, and Trap.
 
    [bookmark: pgfId-537323]You can configure the sensor for monitoring by SNMP. SNMP defines a standard way for network management stations to monitor the health and status of many types of devices, including switches, routers, and sensors.
 
    [bookmark: pgfId-537325]You can configure the sensor to send SNMP traps. SNMP traps enable an agent to notify the management station of significant events by way of an unsolicited SNMP message.
 
    [bookmark: pgfId-537327]Trap-directed notification has the following advantage—if a manager is responsible for a large number of devices, and each device has a large number of objects, it is impractical to poll or request information from every object on every device. The solution is for each agent on the managed device to notify the manager without solicitation. It does this by sending a message known as a trap of the event.
 
    [bookmark: pgfId-537329]After receiving the event, the manager displays it and can take an action based on the event. For example, the manager can poll the agent directly, or poll other associated device agents to get a better understanding of the event.
 
     
      
    
 
    
 
    [bookmark: pgfId-537331]Tip Trap-directed notification results in substantial savings of network and agent resources by eliminating frivolous SNMP requests. However, it is not possible to totally eliminate SNMP polling. SNMP requests are required for discovery and topology changes. In addition, a managed device agent cannot send a trap if the device has had a catastrophic outage.

    
     

    

    
 
    [bookmark: pgfId-537333]This procedure describes how to configure SNMP on an IPS sensor so that you can manage the sensor with an SNMP management station, including the configuration of traps.
 
    
 
    [bookmark: pgfId-537335]Step 1 Do one of the following to open the SNMP policy:
 
     
     	 [bookmark: pgfId-537337](Device view) Select  Platform > Device Admin > Device Access > SNMP from the Policy selector.
 
     	 [bookmark: pgfId-537339](Policy view) Select  IPS > Platform > Device Admin > Device Access > SNMP , then select an existing policy or create a new one.
 
    
 
    [bookmark: pgfId-537344]Step 2 On the General Configuration tab, configure at least the following options. For a complete description of all available options, see General SNMP Configuration Options.
 
     
     	 [bookmark: pgfId-537346] Enable SNMP Gets/Sets —Select this option to enable the SNMP management workstation to obtain (get) information, and to modify (set) values on the IPS sensor. If you do not enable this option, the management workstation cannot manage this sensor.
 
     	 [bookmark: pgfId-537348] Read-Only Community String —The community string required for read-only access to the sensor. SNMP get requests from the management station must supply this string to get responses from the sensor. This string gives access to all SNMP get requests.
 
     	 [bookmark: pgfId-537350] Read-Write Community String —The community string required for read-write access to the sensor. SNMP set requests from the management station must supply this string to get responses from the sensor; it can also be used on get requests. This string gives access to all SNMP get and set requests.
 
    
 
    [bookmark: pgfId-537355]Step 3 On the SNMPv3 Users tab, add one or more SNMPv3 users to configure SNMPv3 settings on the managed IPS devices. Beginning with version 4.6, Security Manager enables you to configure SNMPv3 settings on the IPS devices it manages. For more information, see SNMPv3 Users Tab.
 
     
      
    
 
    
 
    [bookmark: pgfId-537357]Note SNMPv3 is supported in IPS version 7.2.2 and later, but not in the IPS version 7.3.1. Security Manager can however manage IPS 7.3.1 devices. If you try to use Security Manager to upgrade an IPS device from version 7.2.2, with SNMP policy configured, to version 7.3.1, a mouse-over tooltip displays the message "Selected upgrade is not recommended. Unassign the SNMP policy on the device and deploy it to continue with the upgrade to 7.3.1". For information about managing SNMPv3 policies on IPS devices with version 7.2.2 and later, see the Release Notes for Cisco Intrusion Prevention System 7.2(2).

    
     

    

    
 
    [bookmark: pgfId-537362]Step 4 If you want to configure SNMP traps, click the SNMP Trap Configuration tab and configure at least the following options. For a complete description of all available options, see SNMP Trap Configuration Tab.
 
     
     	 [bookmark: pgfId-537364] Enable Notifications —Select this option to allow the sensor to send SNMP traps.
 
     	 [bookmark: pgfId-537366] Trap Destinations —Add the SNMP management stations that should be trap destinations. Click the  Add Row (+) button to add a new destination, or select a destination and click the  Edit Row (pencil) button to change its configuration.
 
    
 
    [bookmark: pgfId-537368]When adding or editing a trap destination, the trap community string that you enter overrides the default community string entered on the SNMP Trap Configuration tab. The community string appears in the traps sent to this destination and is useful if you are receiving multiple types of traps from multiple agents. For example, a router or sensor could be sending the traps, and if you put something that identifies the router or sensor specifically in your community string, you can filter the traps based on the community string.
 
    [bookmark: pgfId-537370]To remove a destination, select it and click the Delete Row (trash can) button.
 
    [bookmark: pgfId-537372]Step 5 If you configure trap destinations, you must also ensure that the desired alerts include the Request SNMP Trap action. You have the following options for adding this action:
 
     
     	 [bookmark: pgfId-537377](Easy way.) Create an event action override to add the Request SNMP Trap action to all alerts of a specified risk rating ( IPS > Event Actions > Event Action Overrides policy). For example, you could generate traps for all alerts with a risk rating between 85-100. Event action overrides let you add an action without individually editing each signature. For more information, see Configuring Event Action Overrides.
 
     	 [bookmark: pgfId-537379](Precise way.) Edit the Signatures policy ( IPS > Signatures > Signatures ) to add the Request SNMP Trap action to the signatures for which you want to send trap notifications. Traps are sent only for signatures that you configure to send traps.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-537381]Note If the signature has Default for the source, you have to change the source to the Local source before you can change the action. However, if you right-click the Action cell in the signatures table and select Edit Actions, then select Request SNMP Trap (along with any other desired action) and click OK, the source is automatically changed to Local.

    
     

    

    
 
    [bookmark: pgfId-537386]Step 6 Add the SNMP management stations to the Allowed Hosts policy. The management stations must be allowed hosts to access the sensor. See Identifying Allowed Hosts.
 
    [bookmark: pgfId-537388]

    
     

    

    
 
     
      [bookmark: pgfId-537398][bookmark: 95218][bookmark: ipspage_cncpt_GeneralConfigurationTab]General SNMP Configuration Options[bookmark: marker-537394][bookmark: marker-537396]
 
     [bookmark: pgfId-537403]Use the General Configuration tab on the SNMP page to configure general SNMP parameters and apply them to IPS sensors. For the procedure, see Configuring SNMP.
 
     [bookmark: pgfId-537405]Navigation Path
 
      
      	 [bookmark: pgfId-537407](Device view) Select  Platform > Device Admin > Device Access > SNMP from the Policy selector. Select the General Configuration tab.
 
      	 [bookmark: pgfId-537409](Policy view) Select  IPS > Platform > Device Admin > Device Access > SNMP , then select an existing policy or create a new one. Select the General Configuration tab.
 
     
 
     [bookmark: pgfId-537411]Field Reference
 
     [bookmark: pgfId-537414]
 
      
       
        
        [bookmark: pgfId-535210]Table 36-1 [bookmark: 95239]General Configuration Tab, SNMP Policy for IPS Sensors 
 
        
       
         
         	
           
           [bookmark: pgfId-535216]Element
          
  
         	
           
           [bookmark: pgfId-535218]Description
          
  
        
 
         
         	[bookmark: pgfId-535224]Enable SNMP Gets/Sets
  
         	[bookmark: pgfId-535226]Whether to enable the SNMP management workstation to obtain (get) information, and modify (set) values on the IPS sensor. If you do not enable this option, the management workstation cannot manage this sensor; the sensor will not respond to SNMP requests.
  
        
 
         
         	[bookmark: pgfId-535232]Read-Only Community String
  
         	[bookmark: pgfId-535234]The community string required for read-only access to the sensor. SNMP get requests from the management station must supply this string to get responses from the sensor. This string gives access to all SNMP get requests. Use the string to help identify the sensor.
  
        
 
         
         	[bookmark: pgfId-535240]Read-Write Community String
  
         	[bookmark: pgfId-535242]The community string required for read-write access to the sensor. SNMP set requests from the management station must supply this string to get responses from the sensor; it can also be used on get requests. This string gives access to all SNMP get and set requests. Use the string to help identify the sensor.
  
        
 
         
         	[bookmark: pgfId-535248]Sensor Contact
  
         	[bookmark: pgfId-535250]The network administrator or contact point who is responsible for this sensor.
  
        
 
         
         	[bookmark: pgfId-535256]Sensor Location
  
         	[bookmark: pgfId-535258]The physical location of the sensor, such as building address, name, and room number.
  
        
 
         
         	[bookmark: pgfId-535264]Sensor Agent Port
  
         	[bookmark: pgfId-535266]The port to use for SNMP get/set communication with the sensor. The default is 161. The valid range is 1 to 65535.
 [bookmark: pgfId-535268]Enter a port number or the name of a port list object, or click Select to select a port list object from a list or to create a new object. The port list object must identify a single port.
  
        
 
         
         	[bookmark: pgfId-535274]SNMP Agent Protocol
  
         	[bookmark: pgfId-535276]The protocol you are using for SNMP, either UDP (the default) or TCP. Select the protocol used by your SNMP management station.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-537426][bookmark: 95287][bookmark: ipspage_cncpt_SNMPVUsersTab]SNMPv3 Users Tab[bookmark: marker-537420][bookmark: marker-537422][bookmark: marker-537424]
 
     [bookmark: pgfId-537428]Beginning with version 4.6, Security Manager enables you to configure SNMPv3 settings on the IPS devices it manages. You must add SNMPv3 users to configure SNMPv3 settings on the managed IPS devices.
 
     [bookmark: pgfId-537430]You can use the SNMPv3 Users tab on the SNMP page to view, add, edit, or delete SNMPv3 users.
 
     [bookmark: pgfId-537432]Navigation Path
 
      
      	 [bookmark: pgfId-537434](Device view) Select  Platform > Device Admin > Device Access > SNMP from the Policy selector. Select the SNMPv3 Users tab.
 
      	 [bookmark: pgfId-537436](Policy view) Select  IPS > Platform > Device Admin > SNMP , then select an existing policy or create a new one. Select the SNMPv3 Users tab.
 
     
 
     [bookmark: pgfId-537438]Do one of the following:
 
      
      	 [bookmark: pgfId-537443]To add an SNMPv3 user, click the  Add Row (+) button. This opens the Add SNMPv3 User dialog box. Enter the information required to create the user. For detailed information on the settings, see Add SNMPv3 User Dialog Box
 
      	 [bookmark: pgfId-537445]To edit an SNMPv3 user, select it and click the  Edit Row (pencil) button and make the required changes in the Edit SNMPv3 User dialog box.
 
      	 [bookmark: pgfId-537447]To delete an existing SNMPv3 user, select it and click the  Delete Row (trash can) button.
 
     
 
     [bookmark: pgfId-537449]Field Reference
 
     [bookmark: pgfId-537452]
 
      
       
        
        [bookmark: pgfId-535289]Table 36-2 [bookmark: 95324]SNMPv3 Users 
 
        
       
         
         	
           
           [bookmark: pgfId-535295]Element
          
  
         	
           
           [bookmark: pgfId-535297]Description
          
  
        
 
         
         	[bookmark: pgfId-535303]User Name
  
         	[bookmark: pgfId-535305]Name of the user on the host that belongs to the SNMP agent.
  
        
 
         
         	[bookmark: pgfId-535311]Access Control
  
         	[bookmark: pgfId-535313]Access privilege for the SNMPv3 user.
  
        
 
         
         	[bookmark: pgfId-535319]Security Level
  
         	[bookmark: pgfId-535321]Security level for the SNMPv3 user.
  
        
 
         
         	[bookmark: pgfId-535327]Authentication Protocol
  
         	[bookmark: pgfId-535329]The authentication protocol keyword is the authentication level used to configure the SNMPv3 user.
  
        
 
         
         	[bookmark: pgfId-535335]Privacy Protocol
  
         	[bookmark: pgfId-535337]The privacy protocol keyword is the privacy or encryption algorithm used to configure the SNMPv3 user.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-537462][bookmark: 95359][bookmark: ipspage_cncpt_SnmpvAddUsersDialogBox]Add SNMPv3 User Dialog Box[bookmark: marker-537460]
 
     [bookmark: pgfId-537464]Use the Add SNMPv3 User dialog box to configure a new SNMPv3 user for the managed IPS device.
 
     [bookmark: pgfId-537466]Navigation Path
 
      
      	 [bookmark: pgfId-537468](Device view) Select  Platform > Device Admin > Device Access > SNMP from the Policy selector. Select the SNMPv3 Users tab and click the  Add Row (+) button.
 
      	 [bookmark: pgfId-537470](Policy view) Select  IPS > Platform > Device Admin > SNMP , then select an existing policy or create a new one. Select the SNMPv3 Users tab and click the  Add Row (+) button.
 
     
 
     [bookmark: pgfId-537472]Field Reference
 
     [bookmark: pgfId-537475]
 
      
       
        
        [bookmark: pgfId-535350]Table 36-3 [bookmark: 95379]Add SNMPv3 Users Dialog Box 
 
        
       
         
         	
           
           [bookmark: pgfId-535356]Element
          
  
         	
           
           [bookmark: pgfId-535358]Description
          
  
        
 
         
         	[bookmark: pgfId-535364]User Name
  
         	[bookmark: pgfId-535366]Enter a name for the new SNMPv3 user.
  
        
 
         
         	[bookmark: pgfId-535372]Access Control
  
         	[bookmark: pgfId-535374]Select the access privilege for the new SNMPv3 user.
  
        
 
         
         	[bookmark: pgfId-535380]Security Level
  
         	[bookmark: pgfId-535382]Select one of the following security levels for the SNMPv3 user:
 
           
           	 [bookmark: pgfId-535384] NoAuthNoPriv —There is no authentication and no privacy, which means that no security is applied to the messages.
 
           	 [bookmark: pgfId-535386] AuthNoPriv —There is authentication but there is no privacy, which means that messages are authenticated.
 
           	 [bookmark: pgfId-535388] AuthPriv —Authentication and privacy are configured, which means that messages are authenticated and encrypted.
 
          
  
        
 
         
         	[bookmark: pgfId-535394]Authentication Protocol
  
         	[bookmark: pgfId-535396]Select the authentication protocol keyword that specifies which authentication level should be used. There is no default value.
  
        
 
         
         	[bookmark: pgfId-535402]Privacy Protocol
  
         	[bookmark: pgfId-535404]Select the privacy protocol keyword that specifies which privacy or encryption algorithm should be used. For the encryption algorithm, you can specify the AES keyword. There is no default value.
  
        
 
         
         	[bookmark: pgfId-535410]Authentication Passphrase
  
         	[bookmark: pgfId-535412]Enter the authentication passphrase argument that specifies the authentication user password. This password must not be less than eight characters. There is no default value.
  
        
 
         
         	[bookmark: pgfId-535418]Privacy Passphrase
  
         	[bookmark: pgfId-535420]Enter the privacy passphrase argument that specifies the encryption user password. This password must not be less than eight characters. There is no default value.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-537487][bookmark: 95436][bookmark: ipspage_cncpt_SNMPTrapConfigurationTab]SNMP Trap Configuration Tab[bookmark: marker-537481][bookmark: marker-537483][bookmark: marker-537485]
 
     [bookmark: pgfId-537492]Use the SNMP Trap Communication tab on the SNMP page to configure traps and apply them to sensors and to identify recipients that the traps should be sent to. For the procedure, see Configuring SNMP.
 
     [bookmark: pgfId-537494]Navigation Path
 
      
      	 [bookmark: pgfId-537496](Device view) Select  Platform > Device Admin > Device Access > SNMP from the Policy selector. Select the SNMP Trap Configuration tab.
 
      	 [bookmark: pgfId-537498](Policy view) Select  IPS > Platform > Device Admin > Device Access > SNMP , then select an existing policy or create a new one. Select the SNMP Trap Configuration tab.
 
     
 
     [bookmark: pgfId-537500]Field Reference
 
     [bookmark: pgfId-537503]
 
      
       
        
        [bookmark: pgfId-535433]Table 36-4 [bookmark: 95460]SNMP Trap Configuration Tab, SNMP Policy for IPS Sensors 
 
        
       
         
         	
           
           [bookmark: pgfId-535439]Element
          
  
         	
           
           [bookmark: pgfId-535441]Description
          
  
        
 
         
         	[bookmark: pgfId-535447]Enable Notifications
  
         	[bookmark: pgfId-535449]Whether to enable the sensor to send trap notifications to the trap destinations whenever a specific type of event occurs in a sensor. If you do not select this option, the sensor does not send traps.
 as the event action when you configure signatures. Traps are sent only for signatures that you configure to send traps.  
        
 
         
         	[bookmark: pgfId-535457]Error Filter
  
         	[bookmark: pgfId-535459]The type of events that will generate SNMP traps based on the severity of the event: fatal, error, or warning. Select all severities that you want; use Ctrl+click to select multiple values.
 [bookmark: pgfId-535461]The sensor sends notifications of events of the selected severities only.
  
        
 
         
         	[bookmark: pgfId-535467]Enable Detail Traps
  
         	[bookmark: pgfId-535469]Whether to include the full text of the alert in the trap. If you do not select this option, sparse mode is used. Sparse mode includes less than 484 bytes of text for the alert.
  
        
 
         
         	[bookmark: pgfId-535475]Default Trap Community String
  
         	[bookmark: pgfId-535477]The community string used for the traps if no specific string has been set for the trap destination in the Trap Destinations table.
 [bookmark: pgfId-535479]Tip All traps carry a community string. By default, all traps that have a community string identical to that of the destination are taken by the destination. All other traps are discarded by the destination. However, you can configure the destination to determine which trap strings to accept.  
        
 
         
         	[bookmark: pgfId-535485]Trap Destinations table
  
         	[bookmark: pgfId-535487]The SNMP management stations that will be sent trap notifications. The table shows the IP address of the management station, the community string added to traps from this sensor, and the port to which traps are sent.
 
           
           	 [bookmark: pgfId-535492]To add a destination, click the  Add Row button and fill in the Add SNMP Trap Communication dialog box (see SNMP Trap Communication Dialog Box).
 
           	 [bookmark: pgfId-535494]To edit a destination, select it, click the  Edit Row button and make your changes.
 
           	 [bookmark: pgfId-535496]To delete a destination, select it and click the  Delete Row button.
 
          
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-537513][bookmark: 95510][bookmark: ipspage_cncpt_SnmpTrapCommunicationDialogBox]SNMP Trap Communication Dialog Box[bookmark: marker-537511]
 
     [bookmark: pgfId-537515]Use the Add or Modify SNMP Trap Communication dialog box to configure SNMP trap destinations. These are the SNMP management stations that should receive traps from the IPS sensor.
 
     [bookmark: pgfId-537517]Navigation Path
 
     [bookmark: pgfId-537522]Go to the IPS Platform > Device Admin > Device Access > SNMP policy, select the SNMP Trap Configuration tab, and click the Add Row button beneath the Trap Destinations table, or select a destination in the table and click the Edit Row button. For more information, see SNMP Trap Configuration Tab.
 
     [bookmark: pgfId-537524]Field Reference
 
     [bookmark: pgfId-537527]
 
      
       
        
        [bookmark: pgfId-535509]Table 36-5 [bookmark: 95528]SNMP Trap Communication Dialog Box 
 
        
       
         
         	
           
           [bookmark: pgfId-535515]Element
          
  
         	
           
           [bookmark: pgfId-535517]Description
          
  
        
 
         
         	[bookmark: pgfId-535523]IP Address
  
         	[bookmark: pgfId-535525]The IP address of the SNMP management station that should receive trap notifications. Enter the IP address or the name of a network/host object, or click Select to select the object from a list or to create a new object. The network/host object must specify a single host IP address.
  
        
 
         
         	[bookmark: pgfId-535531]Trap Community String
  
         	[bookmark: pgfId-535533]The community string of the trap. If you do not enter a trap string, the default trap string defined on the SNMP Trap Communication tab is used for traps sent to this destination.
  
        
 
         
         	[bookmark: pgfId-535539]Trap Port
  
         	[bookmark: pgfId-535541]The port used by the SNMP management station to receive traps. Enter the port number or the name of a port list object, or click Select to select the object from a list or to create a new one. The port list object must identify a single port.
  
        
 
         
         	[bookmark: pgfId-535547]SNMPv3 User
  
         	[bookmark: pgfId-535552]Enter the username of the SNMPv3 user that you configured by using the Add SNMPv3 User Dialog Box. Leave this field blank if you do not want to associate any SNMPv3 user.
 [bookmark: pgfId-535554]Note If you enter a username that is not a configured SNMPv3 user, you will receive an error message while trying to save the SNMP trap communication settings. () Also, note that you can add up to a maximum of 23 SNMPv3 users.
  
        
 
       
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-537541][bookmark: 95567][bookmark: ipdvchap_cncpt_ManagingUserAccountsandPasswordRequirements]Managing User Accounts and Password Requirements[bookmark: marker-537533][bookmark: marker-537535][bookmark: marker-537537][bookmark: marker-537539]
 
    [bookmark: pgfId-537543]You can configure user accounts and passwords, and general password requirements, for your IPS devices. You can configure local users (defined directly on the device), use a RADIUS AAA server, or use them both in conjunction. The policies used are the AAA, User Accounts, and Password Requirements policies in the Platform > Device Admin > Device Access folder.
 
    [bookmark: pgfId-537545]When you create or edit a local user account in Security Manager, the password you enter must satisfy the requirements defined in the Password Requirements policy. This ensures that new passwords meet your security requirements.
 
     
      
    
 
    
 
    [bookmark: pgfId-537547]Tip If you change the password requirements, and then make changes to any local user account, the new requirements must be met by all user accounts that have passwords managed by Security Manager. This is because Security Manager reconfigures the passwords for all managed accounts if any single account needs to be reconfigured.

    
     

    

    
 
    [bookmark: pgfId-537549]The User Accounts policy allows you to centrally manage the local user accounts for your IPS devices. Using a shared policy can help you ensure that all IPS devices contain the same accounts with the same passwords. However, it is important to understand that passwords are encrypted, so Security Manager cannot discover the actual passwords defined on the device. Security Manager manages the passwords for an account only if you define that password in Security Manager. Security Manager does not manage any user accounts defined in a RADIUS AAA server.
 
    [bookmark: pgfId-537551]The following topics describe IPS user accounts, and Security Manager discovery and deployment considerations, in more detail:
 
     
     	 [bookmark: pgfId-537556]Understanding IPS User Roles
 
     	 [bookmark: pgfId-537561]Understanding Managed and Unmanaged IPS Passwords
 
     	 [bookmark: pgfId-537566]Understanding How IPS Passwords are Discovered and Deployed
 
     	 [bookmark: pgfId-537571]Configuring IPS User Accounts
 
     	 [bookmark: pgfId-537576]Configuring User Password Requirements
 
     	 [bookmark: pgfId-537581]Configuring AAA Access Control for IPS Devices
 
    
 
     
      [bookmark: pgfId-537597][bookmark: 95609][bookmark: ipdvchap_cncpt_UnderstandingUserRoles]Understanding IPS User Roles[bookmark: marker-537587][bookmark: marker-537589][bookmark: marker-537591][bookmark: marker-537593][bookmark: marker-537595]
 
     [bookmark: pgfId-537599]There are four user roles for IPS user accounts:
 
      
      	 [bookmark: pgfId-537601] Viewer —Users can view the device configuration and events, but they cannot modify any configuration data except their user passwords.
 
      	 [bookmark: pgfId-537603] Operator —Users can view everything and they can modify the following options:
 
     
 
     [bookmark: pgfId-537605] – Signature tuning (priority, disable or enable).
 
     [bookmark: pgfId-537607] – Virtual sensor definition.
 
     [bookmark: pgfId-537609] – Managed routers.
 
     [bookmark: pgfId-537611] – Their user passwords.
 
      
      	 [bookmark: pgfId-537613] Administrator —Users can view everything and they can modify all options that Operators can modify in addition to the following:
 
     
 
     [bookmark: pgfId-537615] – Sensor addressing configuration.
 
     [bookmark: pgfId-537617] – List of hosts allowed to connect as configuration or viewing agents.
 
     [bookmark: pgfId-537619] – Assignment of physical sensing interfaces.
 
     [bookmark: pgfId-537621] – Enable or disable control of physical interfaces.
 
     [bookmark: pgfId-537623] – Add and delete users and passwords.
 
     [bookmark: pgfId-537625] – Generate new SSH host keys and server certificates.
 
      
      	 [bookmark: pgfId-537627] Service —Only one user with service privileges can exist on a sensor. The service user cannot log in to IDM or IME. The service user logs in to a bash shell rather than the CLI. The service role is a special role that allows you to bypass the CLI if needed.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-537629]Note The purpose of the Service account is to provide Cisco Technical Support access to troubleshoot unique and unusual problems. It is not needed for normal system configuration and troubleshooting. You should carefully consider whether you want to create a service account. The service account provides shell access to the system, which makes the system vulnerable. However, you can use the service account to create a password if the administrator password is lost. Analyze your situation to decide if you want a service account existing on the system.

     
      

     

     
 
    
 
     
      [bookmark: pgfId-537643][bookmark: 95662][bookmark: ipdvchap_cncpt_UnderstandingManagedandUnmanagedIPSPasswords]Understanding Managed and Unmanaged IPS Passwords[bookmark: marker-537635][bookmark: marker-537637][bookmark: marker-537639][bookmark: marker-537641]
 
     [bookmark: pgfId-537645]Every IPS local user account has a password, which allows secure user login to the device. These user passwords are encrypted on the IPS device. Thus, when you add an IPS device to the Security Manager inventory, Security Manager cannot read the actual user passwords.
 
     [bookmark: pgfId-537647]Because Security Manager cannot read the password, it is unable to deploy newly-discovered user account passwords to the device. To avoid putting user accounts into a state where the passwords are unknown and unusable, Security Manager marks discovered user account passwords as unmanaged. The status of a password is indicated in the Is Password Managed? column of the Platform > Device Admin > Device Access > User Accounts policy:
 
      
      	 [bookmark: pgfId-537649]If  No is indicated, the password for this account is not configured in Security Manager. When you deploy this policy, Security Manager will not attempt to configure the password for this user account.
 
      	 [bookmark: pgfId-537651]If  Yes is indicated, the password for this account was configured or updated in Security Manager. When you deploy this policy, Security Manager reconfigures the passwords for all managed accounts, not just the passwords that changed since the last deployment.
 
     
 
     [bookmark: pgfId-537653]Because Security Manager configures even unchanged passwords, all managed passwords must satisfy the password requirements defined in the Password Requirements policy.
 
     [bookmark: pgfId-537655]Thus, you can have a mix of managed and unmanaged account passwords. For example, you can have a set of shared user accounts that are centrally managed, and manage these account passwords in Security Manager. Other accounts might be unique to individuals; if you never edit these account passwords in Security Manager, the user can manage these passwords individually on the device.
 
      
       
     
 
     
 
     [bookmark: pgfId-537657]Tip If you do not want to manage any user accounts in Security Manager, ensure that the User Accounts policy is empty, or simply unassign the policy (right-click the policy and select Unassign Policy). Security Manager will not modify user account configurations.

     
      

     

     
 
    
 
     
      [bookmark: pgfId-537675][bookmark: 95693][bookmark: ipdvchap_cncpt_UnderstandingHowIPSPasswordsareDiscoveredandDeployed]Understanding How IPS Passwords are Discovered and Deployed[bookmark: marker-537663][bookmark: marker-537665][bookmark: marker-537667][bookmark: marker-537669][bookmark: marker-537671][bookmark: marker-537673]
 
     [bookmark: pgfId-537677]Because user passwords are encrypted on IPS devices, Security Manager has to handle them with special care when discovering policies on the device or deploying configurations. When discovering or deploying user accounts on IPS devices, Security Manager does the following:
 
      
      	 [bookmark: pgfId-537682] Discovery —When you add an IPS device to the inventory, or rediscover policies on it, Security Manager determines the current status of each user account, updates the User Account policy with each discovered username and associated role, and marks the user password as unmanaged (as described in Understanding Managed and Unmanaged IPS Passwords).
 
     
 
     [bookmark: pgfId-537684]You cannot view the account status through Security Manager, because it is dynamic and can change. However, the Discovery Status window displays the status at discovery. Accounts can have these statuses:
 
     [bookmark: pgfId-537686] – Active—This state indicates that the account is available for use. Active accounts can be accessed using an authentication token if one has been assigned to the account.
 
     [bookmark: pgfId-537688] – Expired—This state indicates that the account’s authentication token has expired and the account can not be accessed using a token until the token has been updated.
 
     [bookmark: pgfId-537690] – Locked—This state indicates that logins to the account have been disabled due to too many failed authentication attempts. You should update the password for these accounts.
 
      
      	 [bookmark: pgfId-537692] Deployment —You are warned if any deployed user accounts are in the Expired or Locked state. Any unmanaged passwords are not deployed to the device. Also, keep in mind the following points:
 
     
 
     [bookmark: pgfId-537694] – If you make changes to any user account on the device, all user accounts with managed passwords are reconfigured. If you also changed the Password Requirements policy, all passwords are compared to the new policy and must meet the new requirements.
 
     [bookmark: pgfId-537696] – If you change the password of the user account you defined in the device’s properties for Security Manager to use when configuring the device, after successful deployment, Security Manager updates the password in the device properties to the new password. You do not need to manually update the password. To see device properties, select Tools > Device Properties.
 
     [bookmark: pgfId-537701]This behavior assumes that you selected Security Manager Device Credentials for the Connect to Device Using option on the Tools > Security Manager Administration > Device Communication page. If you are using the logged-in users credentials for deployment, after successful deployment, the overall deployment is marked as failed, and a message explains how to reestablish connection. See Device Communication Page.
 
     [bookmark: pgfId-537706] – If you use out-of-band change detection, changes to passwords are not detected. However, changes to usernames and roles are detected. For more information about out-of-band change detection, see Detecting and Analyzing Out of Band Changes.
 
     [bookmark: pgfId-537711] – When previewing configurations, you can see changes to the user accounts by selecting to IPS(Delta – User Passwords). However, passwords are masked. For more information, see Previewing Configurations.
 
     [bookmark: pgfId-537713] – If you are rolling back configurations, the user accounts are never rolled back. The current status and configuration of user accounts does not change.
 
      
       
     
 
     
 
     [bookmark: pgfId-537715]Tip The IPS sensor can accept public keys for RSA authentication when logging into the device through an SSH client. Each user has an associated list of authorized keys. Users can use these keys instead of passwords. Security Manager ignores these keys during discovery and deployment. Thus, if keys are configured, Security Manager does not remove the configuration.

     
      

     

     
 
     [bookmark: pgfId-537717]Related Topics
 
      
      	 [bookmark: pgfId-537722]Discovering Policies
 
      	 [bookmark: pgfId-537727]Deploying Configurations in Non-Workflow Mode
 
      	 [bookmark: pgfId-537732]Deploying Configurations in Workflow Mode
 
      	 [bookmark: pgfId-537737]Understanding Configuration Rollback
 
      	 [bookmark: pgfId-537742]Understanding Rollback for IPS and IOS IPS
 
     
 
    
 
     
      [bookmark: pgfId-537760][bookmark: 95771][bookmark: ipdvchap_proc_ConfiguringUserAccounts]Configuring IPS User Accounts[bookmark: marker-537750][bookmark: marker-537752][bookmark: marker-537754][bookmark: marker-537756][bookmark: marker-537758]
 
     [bookmark: pgfId-537762]Use the User Accounts policy to configure local user accounts for IPS devices. Users can use these accounts to log into the device. You can create new users, modify user privileges and passwords, and delete users.
 
     [bookmark: pgfId-537764]The user accounts policy should have at least these accounts:
 
      
      	 [bookmark: pgfId-537766]cisco—An account named “cisco” must exist on the device and you cannot delete it.
 
      	 [bookmark: pgfId-537771]An administrator account that Security Manager can use—Security Manager must be able to log into the device to configure it. Typically, you create an account for this purpose. However, you have the option of having Security Manager use the user account of the person deploying configurations to log into the device. You can configure this using the  Connect to Device Using option on the  Tools > Security Manager Administration > Device Communication page. See Device Communication Page.
 
     
 
     [bookmark: pgfId-537773]IPS user account configuration is more complicated than it seems. Before you configure IPS user accounts, read the following topics:
 
      
      	 [bookmark: pgfId-537778]Managing User Accounts and Password Requirements
 
      	 [bookmark: pgfId-537783]Understanding IPS User Roles
 
      	 [bookmark: pgfId-537788]Understanding Managed and Unmanaged IPS Passwords
 
      	 [bookmark: pgfId-537793]Understanding How IPS Passwords are Discovered and Deployed
 
      	 [bookmark: pgfId-537798]Configuring User Password Requirements
 
      	 [bookmark: pgfId-537803]Configuring AAA Access Control for IPS Devices
 
     
 
     [bookmark: pgfId-537805]Tips
 
      
      	 [bookmark: pgfId-537807]Cisco IOS IPS devices use the same user accounts that are defined for the router. This procedure does not apply to Cisco IOS IPS configurations.
 
      	 [bookmark: pgfId-537812]If you change the password for the user defined in the device properties, which Security Manager uses to deploy configurations to the device, Security Manager uses the existing credentials defined in the device properties to log into the device and deploy changes. After successful deployment, the device properties are then changed to use your new settings. For more information on credentials in device properties, see Device Credentials Page.
 
     
 
     [bookmark: pgfId-537814]Related Topics
 
      
      	 [bookmark: pgfId-537819]Filtering Tables
 
      	 [bookmark: pgfId-537824]Table Columns and Column Heading Features
 
     
 
     
 
     [bookmark: pgfId-537826]Step 1 Do one of the following to open the User Accounts policy:
 
      
      	 [bookmark: pgfId-537828](Device view) Select  Platform > Device Admin > Device Access > User Accounts from the Policy selector.
 
      	 [bookmark: pgfId-537830](Policy view) Select  IPS > Platform > Device Admin > Device Access > User Accounts , then select an existing policy or create a new one.
 
     
 
     [bookmark: pgfId-537835]The policy shows existing user accounts, including the username, role, and whether the password is managed by Security Manager (as explained in Understanding Managed and Unmanaged IPS Passwords).
 
     [bookmark: pgfId-537837]Step 2 Do one of the following:
 
      
      	 [bookmark: pgfId-537842]To add a user account, click the  Add Row (+) button. This opens the Add User dialog box. Enter the information required to define the account. For detailed information on the settings, see Add User and Edit User Credentials Dialog Boxes.
 
      	 [bookmark: pgfId-537844]To edit a user account, select it and click the  Edit Row (pencil) button and make the required changes in the Edit User dialog box.
 
     
 
     [bookmark: pgfId-537846]You cannot change a user role to or from the Service role.
 
      
      	 [bookmark: pgfId-537848]To delete a user account, select it and click the  Delete Row (trash can) button. You cannot delete the account named cisco.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-537853]Tip All password changes must meet the requirements of the Password Requirements policy. If you change the requirements policy, all new user accounts, or edited accounts, are tested against the new requirements. Although the passwords for existing unedited user accounts are not tested, they too must meet the password requirements if you change any user account defined in this policy, because Security Manager will deploy all of the accounts during the next configuration deployment. Passwords are checked for conformity when you validate policies, which typically happens when you submit changes to the database. For more information, see Understanding How IPS Passwords are Discovered and Deployed.

     
      

     

     
 
     [bookmark: pgfId-537855]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-537875][bookmark: 95866][bookmark: ipspage_cncpt_AddUserDialogBox]Add User and Edit User Credentials Dialog Boxes[bookmark: marker-537865][bookmark: marker-537867][bookmark: marker-537869][bookmark: marker-537871][bookmark: marker-537873]
 
     [bookmark: pgfId-537877]Use the Add User or Edit User Credentials dialog boxes to add or edit IPS device user accounts.
 
     [bookmark: pgfId-537879]Navigation Path
 
     [bookmark: pgfId-537884]From the IPS platform User Accounts policy, click the Add Row (+) button to create a new account, or select an existing account and click the Edit Row (pencil) button. For information on accessing the User Accounts policy, see Configuring IPS User Accounts.
 
     [bookmark: pgfId-537886]Field Reference
 
     [bookmark: pgfId-537889]
 
      
       
        
        [bookmark: pgfId-535567]Table 36-6 [bookmark: 95894]Add or Edit User Dialog Box 
 
        
       
         
         	
           
           [bookmark: pgfId-535573]Element
          
  
         	
           
           [bookmark: pgfId-535575]Description
          
  
        
 
         
         	[bookmark: pgfId-535581]User Name
  
         	[bookmark: pgfId-535583]The username for the account. The name can be 1 to 64 characters, including uppercase and lowercase letters and numbers, plus the special characters ( ) + : , _ / - ] + $.
 [bookmark: pgfId-535585]You cannot change the username when editing an account.
  
        
 
         
         	[bookmark: pgfId-535591]Password
 [bookmark: pgfId-535593]Confirm
  
         	[bookmark: pgfId-535595]The password for this user account. Enter the password in both fields.
 [bookmark: pgfId-535600]The password must conform to the Password Requirements policy for IPS devices; see Configuring User Password Requirements.
  
        
 
         
         	[bookmark: pgfId-535606]Role
  
         	[bookmark: pgfId-535611]The role for this user. For an explanation of these roles, see Understanding IPS User Roles.
 [bookmark: pgfId-535613]Tip When editing a user account, you cannot select the Service role. When editing an account assigned to the Service role, you cannot change the role.  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-537907][bookmark: 95927][bookmark: ipsvchap_cncpt_ConfiguringPasswordSettings]Configuring User Password Requirements[bookmark: marker-537897][bookmark: marker-537899][bookmark: marker-537901][bookmark: marker-537903][bookmark: marker-537905]
 
     [bookmark: pgfId-537909]Use the IPS platform Password Requirements policy to configure the rules for passwords for local IPS device user accounts. All user-created sensor passwords must conform to the requirements defined in this policy. You can configure password requirements for sensor running IPS software version 6.0 or higher.
 
      
       
     
 
     
 
     [bookmark: pgfId-537917]Tip The requirements you define here determine what is considered an acceptable password in the User Accounts policy (see Configuring IPS User Accounts). If you change this policy, it can be applied even to unchanged user accounts. For more information about the implications of deploying changes to this policy, see Understanding How IPS Passwords are Discovered and Deployed.

     
      

     

     
 
     [bookmark: pgfId-537919]To configure IPS password requirements, select one of the following policies:
 
      
      	 [bookmark: pgfId-537921](Device view) Select  Platform > Device Admin > Device Access > Password Requirements from the Policy selector.
 
      	 [bookmark: pgfId-537923](Policy view) Select  IPS > Platform > Device Admin > Password Requirements from the Policy Type selector, then select an existing policy or create a new one.
 
     
 
     [bookmark: pgfId-537925]The following table explains the password requirement options that you can configure.
 
     [bookmark: pgfId-537928]
 
      
       
        
        [bookmark: pgfId-535626]Table 36-7 [bookmark: 95959]Password Requirements Policy 
 
        
       
         
         	
           
           [bookmark: pgfId-535632]Element
          
  
         	
           
           [bookmark: pgfId-535634]Description
          
  
        
 
         
         	[bookmark: pgfId-535640]Attempt Limit
  
         	[bookmark: pgfId-535642]How many times a user is allowed to try to log into the device before you lock the user account due to excessive failed attempts.
 [bookmark: pgfId-535644]The default is 0, which indicates unlimited authentication attempts. For security purposes, you should change this number.
  
        
 
         
         	[bookmark: pgfId-535650]Size Range
  
         	[bookmark: pgfId-535652]The minimum and maximum size allowed for user passwords; separate the minimum and maximum with a hyphen. The range is 6 to 64 characters; the default is 8-64.
 [bookmark: pgfId-535654]Tip If you configure non-zero values for any of the minimum characters options, the minimum size you enter in the Size Range field must be equal to or greater than the sum of those values. For example, you cannot set a minimum password size of eight and also require that passwords must contain at least five lowercase and five uppercase characters.  
        
 
         
         	[bookmark: pgfId-535660]Minimum Digit Characters
  
         	[bookmark: pgfId-535662]The minimum number of numeric digits that must be in a password.
  
        
 
         
         	[bookmark: pgfId-535668]Minimum Uppercase Characters
  
         	[bookmark: pgfId-535670]The minimum number of uppercase alphabet characters that must be in a password.
  
        
 
         
         	[bookmark: pgfId-535676]Minimum Lowercase Characters
  
         	[bookmark: pgfId-535678]The minimum number of lowercase alphabet characters that must be in a password.
  
        
 
         
         	[bookmark: pgfId-535684]Minimum Other Characters
  
         	[bookmark: pgfId-535686]The minimum number of non-alphanumeric printable characters that must be in a password.
  
        
 
         
         	[bookmark: pgfId-535692]Number of Historical Passwords
  
         	[bookmark: pgfId-535694]The number of historical passwords that you want the sensor to remember for each account. Any attempt to change the password of an account fails if the new password matches any of the remembered passwords. If you specify 0, no previous passwords are remembered.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-537942][bookmark: 96007][bookmark: ipdvchap_proc_ConfiguringAAAAccessControlforIPSDevices]Configuring AAA Access Control for IPS Devices[bookmark: marker-537936][bookmark: marker-537938][bookmark: marker-537940]
 
     [bookmark: pgfId-537944]Use the AAA policy to configure AAA access control for your IPS devices. The device must use IPS Software release 7.0(4) or above or 7.1.3 or above to configure AAA; for example, neither 7.1.1 nor 7.1.2 supports AAA.
 
     [bookmark: pgfId-537946]You can configure the IPS device to use a RADIUS AAA server to authenticate user access to the device. By configuring AAA, you can reduce the number of local users defined on the device and take advantage of your existing RADIUS setup. If you configure a AAA server, you can configure the device to allow local user accounts as a fallback mechanism if the RADIUS servers are unavailable.
 
     [bookmark: pgfId-537948]When configuring AAA, you identify the RADIUS server using a AAA server policy object. You can create the object while configuring the policy, or you can create it in the Policy Object Manager. When you configure the AAA server object, you must adhere to the following restrictions:
 
      
      	 [bookmark: pgfId-537950] Host —You must specify the IP address; you cannot use a DNS name.
 
      	 [bookmark: pgfId-537952] Timeout —If you enter a timeout value, it must be from 1 to 512 seconds. The generic AAA server object allows higher numbers, but IPS has a more limited timeout range. The default is 3.
 
      	 [bookmark: pgfId-537954] Protocol —RADIUS is the only supported protocol.
 
      	 [bookmark: pgfId-537956] Key — You must specify the shared secret key that is defined on the RADIUS server. Although this field is optional for a generic AAA server object, IPS requires a key.
 
      	 [bookmark: pgfId-537958] Port —Ensure that the RADIUS Authentication/Authorization port is correct. Note that the default port in the AAA server object is different from the IPS default, which is 1812. You will need to change the port if you want to use the IPS default.
 
     
 
     [bookmark: pgfId-537963]For more information about configuring AAA server objects, see Creating AAA Server Objects.
 
      
       
     
 
     
 
     [bookmark: pgfId-537965]Tip You must ensure that the user account configured in the device properties exists in the RADIUS server or as a local user account, depending on the authorization method that you use. If you switch between local and AAA modes, or change AAA servers, you must ensure that the account is defined in whatever user account database you are using. If you are using AAA with local fallback, the account should be defined in all databases. This account must exist, with the same password defined in the Security Manager device properties for the device, or deployment to the device will fail. The user account used for discovery and deployment must have administrator privileges.

     
      

     

     
 
     [bookmark: pgfId-537967]Related Topics
 
      
      	 [bookmark: pgfId-537972]Managing User Accounts and Password Requirements
 
      	 [bookmark: pgfId-537977]Configuring IPS User Accounts
 
     
 
     
 
     [bookmark: pgfId-537979]Step 1 Do one of the following:
 
      
      	 [bookmark: pgfId-537981](Device view) Select  Platform > Device Admin > Device Access > AAA from the Policy selector.
 
      	 [bookmark: pgfId-537983](Policy view) Select  IPS > Platform > Device Admin > AAA , then select an existing policy or create a new one.
 
     
 
     [bookmark: pgfId-537985]Step 2 Configure the following basic properties:
 
      
      	 [bookmark: pgfId-537987] Authentication Mode —Whether to use Local or AAA mode. Local mode uses user accounts defined on the IPS device only. With AAA mode, the RADIUS servers are the primary means of user authentication, and you can configure local user accounts as a fallback mechanism. The default is Local. You must select AAA to configure any other options in this policy.
 
      	 [bookmark: pgfId-537989] Primary RADIUS Server, Secondary RADIUS Server —The main (primary) AAA server and a backup server, if any. Enter the name of the AAA server policy object that identifies the RADIUS server, or click  Select to select it from a list of objects or to create a new object.
 
     
 
     [bookmark: pgfId-537991]When authenticating users, the IPS device sends the user authentication attempt to the primary server. The secondary server is contacted only if the request to the primary server times out.
 
     [bookmark: pgfId-537993]Step 3 Configure the following optional properties if you want non-default values:
 
      
      	 [bookmark: pgfId-537995] Console Authentication —How you want to authenticate users who access the IPS device through the console:
 
     
 
     [bookmark: pgfId-537997] – Local—Users connected through the console port are authenticated through local user accounts.
 
     [bookmark: pgfId-537999] – Local and RADIUS—Users connected through the console port are authenticated through RADIUS first. If RADIUS fails, local authentication is attempted.
 
     [bookmark: pgfId-538001] – RADIUS—Users connected through the console port are authenticated by RADIUS. If you also select Enable Local Fallback, then users can also be authenticated through the local user accounts.
 
      
      	 [bookmark: pgfId-538003] RADIUS NAS ID —The Network Access ID, which identifies the service requesting authentication. The value can be no NAS-ID, cisco-ips, or a NAS-ID already configured on the RADIUS server. The default is cisco-ips.
 
      	 [bookmark: pgfId-538005] Enable Local Fallback —Whether you want to fall back to local user account authentication if all RADIUS servers are unavailable. This option is selected by default. Note that local authentication is not attempted if the RADIUS server responds negatively to the logon attempt; local authentication is tried only if no response is received from the RADIUS server.
 
      	 [bookmark: pgfId-538010] Default User Role —The role to assign to users who do not have a role assigned in the RADIUS server. You can make Viewer, Operator, or Administrator the default roles, but not Service; select Unspecified to assign no default role (this is the default). For an explanation of user roles, see Understanding IPS User Roles.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-538012]Note User role configuration is very important. If you do not assign a role to the user, either through the default user role or in the RADIUS server, the sensor prevents user login even if the RADIUS server accepted the username and password.

     
      

     

     
 
     [bookmark: pgfId-538014]To assign roles specifically to users on the RADIUS server, you configure the Accept Message for those accounts as either ips-role=administrator, ips-role=operator, ips-role=viewer, or ips-role=service. You configure the Accept Message individually for each user account. An example of a Reply attribute for a given user could be configured to return “Hello <user> your ips-role=operator.”
 
     [bookmark: pgfId-538016]If you configure a service account in the RADIUS server, you must also configure an identical service account locally on the device. For service accounts, both the RADIUS and Local accounts are checked during login.
 
     [bookmark: pgfId-538018]

     
      

     

     
 
    
 
   
 
    
     [bookmark: pgfId-538034][bookmark: 96102][bookmark: ipdvchap_proc_IdentifyinganNTPServer]Identifying an NTP Server[bookmark: marker-538026][bookmark: marker-538028][bookmark: marker-538030][bookmark: marker-538032]
 
    [bookmark: pgfId-538036]Use the NTP policy to configure a Network Time Protocol (NTP) server as the time source for the IPS device. Using NTP helps ensure synchronized time among your network devices, which can aid event analysis. NTP is the recommended way to configure time settings on an IPS device.
 
    [bookmark: pgfId-538040]For detailed information on how to set the time on a sensor, including how to set up a Cisco IOS router as an NTP server, refer to Configuring Time in Configuring the Cisco Intrusion Prevention System Sensor Using the Command Line Interface Version 7.0.
 
     
      
    
 
    
 
    [bookmark: pgfId-538042]Tip Check the time on your IPS sensor if you are having trouble updating your IPS software. If the time on the sensor is ahead of the time on the associated certificate, the certificate is rejected, and the sensor software update fails.

    
     

    

    
 
    
 
    [bookmark: pgfId-538044]Step 1 Do one of the following to open the NTP policy:
 
     
     	 [bookmark: pgfId-538046](Device view) Select  Platform > Device Admin > Server Access > NTP from the Policy selector.
 
     	 [bookmark: pgfId-538048](Policy view) Select  IPS > Platform > Device Admin > Server Access > NTP , then select an existing policy or create a new one.
 
    
 
    [bookmark: pgfId-538050]Step 2 In the NTP Server IP Address field, enter the IP address of the NTP server. You can also enter the name of a network/host object that identifies the single host address of the server, or click Select to select the object from a list or to create a new one.
 
    [bookmark: pgfId-538052]Step 3 If the NTP server does not require authentication, deselect the Authenticated NTP checkbox.
 
    [bookmark: pgfId-538054]If the NTP server requires authentication, configure the following options:
 
     
     	 [bookmark: pgfId-538056] Authenticated NTP —Select this option to enable authenticated connections.
 
     	 [bookmark: pgfId-538058] Key, Confirm —The key value of the NTP server. The key is an MD5 type of key (either numeric or character); it is the key that was used to set up the NTP server.
 
     	 [bookmark: pgfId-538060] Key ID —The key ID value of the NTP server, a numeric value between 1 and 65535.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-538062]Tip The key and key ID are configured on the NTP server; you must obtain them from the NTP server configuration.

    
     

    

    
 
    [bookmark: pgfId-538064]

    
     

    

    
 
   
 
    
     [bookmark: pgfId-538080][bookmark: 96154][bookmark: ipdvchap_proc_IdentifyingDNSServers]Identifying DNS Servers[bookmark: marker-538072][bookmark: marker-538074][bookmark: marker-538076][bookmark: marker-538078]
 
    [bookmark: pgfId-538082]If you configure global correlation on an IPS 7.0+ sensor, the sensor must be able to resolve domain names to successfully connect to the update server when downloading global correlation updates. Use the DNS policy to identify the Domain Name System (DNS) servers that the sensor can use to resolve domain names to IP addresses.
 
     
      
    
 
    
 
    [bookmark: pgfId-538087]Tip If your network requires HTTP proxies when making Internet connections, configure the HTTP Proxy policy instead of the DNS policy. See Identifying an HTTP Proxy Server.

    
     

    

    
 
     
      
    
 
    
 
    [bookmark: pgfId-538089]Note The AIP-SSC-5 service module does not support DNS servers.

    
     

    

    
 
    
 
    [bookmark: pgfId-538091]Step 1 Do one of the following to open the HTTP Proxy policy:
 
     
     	 [bookmark: pgfId-538093](Device view) Select  Platform > Device Admin > Server Access > DNS from the Policy selector.
 
     	 [bookmark: pgfId-538095](Policy view) Select  IPS > Platform > Device Admin > Server Access > DNS , then select an existing policy or create a new one.
 
    
 
    [bookmark: pgfId-538097]Step 2 Specify the IP addresses of up to three DNS servers in the Primary, Secondary, and Tertiary Address fields. The sensor uses the servers in the order listed; if one server does not respond, the next server is contacted.
 
    [bookmark: pgfId-538099]You can enter an IP address or the name of a network/host object that contains a server address. Click Select to select a network/host object from a list or to create a new one. The network/host object must specify a single host address.
 
    [bookmark: pgfId-538101]

    
     

    

    
 
   
 
    
     [bookmark: pgfId-538119][bookmark: 96192][bookmark: ipdvchap_proc_IdentifyinganHTTP-HTTPSProxy]Identifying an HTTP Proxy Server[bookmark: marker-538109][bookmark: marker-538111][bookmark: marker-538113][bookmark: marker-538115][bookmark: marker-538117]
 
    [bookmark: pgfId-538121]If you configure global correlation on an IPS 7.0+ sensor, and your network requires the use of HTTP proxies to connect to the Internet, you need to configure the HTTP Proxy policy to identify a proxy that the IPS sensor can use. When downloading global correlation updates, the IPS sensor connects to the update server using this proxy. The proxy must be able to resolve DNS names.
 
     
      
    
 
    
 
    [bookmark: pgfId-538126]Tip If you do not use HTTP proxies, configure DNS servers so that the IPS sensor can resolve the address of the update server. See Identifying DNS Servers.

    
     

    

    
 
     
      
    
 
    
 
    [bookmark: pgfId-538128]Note The AIP-SSC-5 service module does not support HTTP proxy servers.

    
     

    

    
 
    
 
    [bookmark: pgfId-538130]Step 1 Do one of the following to open the HTTP Proxy policy:
 
     
     	 [bookmark: pgfId-538132](Device view) Select  Platform > Device Admin > Server Access > HTTP Proxy from the Policy selector.
 
     	 [bookmark: pgfId-538134](Policy view) Select  IPS > Platform > Device Admin > Server Access > HTTP Proxy , then select an existing policy or create a new one.
 
    
 
    [bookmark: pgfId-538136]Step 2 Configure the following options:
 
     
     	 [bookmark: pgfId-538138] Enable Proxy —Select this option to tell the device to connect through the configured proxy server.
 
     	 [bookmark: pgfId-538140] IP Address —Enter the IP address of the proxy server, or the name of the network/host object that contains the server’s IP address. Click  Select to select a network/host object from a list or to create a new one. The network/host object must contain a single host IP address.
 
     	 [bookmark: pgfId-538142] Port —Enter the port number used for HTTP connections to the proxy server. The default is 80.
 
    
 
    [bookmark: pgfId-538144]

    
     

    

    
 
   
 
    
     [bookmark: pgfId-538150][bookmark: 96241][bookmark: ipdvchap_proc_IPS_SSHv2_KnownHostKeys]IPS SSHv2 Known Host Keys
 
    [bookmark: pgfId-538152]The IPS SSHv2 Known Host Keys policy enables you to configure SSHv2 server host keys (outgoing SSHv2 connections from an IPS sensor to an SSH server). This feature is available on IPS sensors running 7.1(8) and later versions of Cisco IPS.
 
    [bookmark: pgfId-538154]The host key can be retrieved from an IPS sensor using valid IP addresses; alternatively, it can be entered manually if you know it. The host key retrieval may take few seconds.
 
    
 
    [bookmark: pgfId-538156]Step 1 Do one of the following to open the IPS SSHv2 Known Host Keys policy:
 
     
     	 [bookmark: pgfId-538158](Device view) Select  Platform > Device Admin > Server Access > SSHv2 Known Host Keys from the Policy selector.
 
     	 [bookmark: pgfId-538160](Policy view) Select  IPS > Platform > Device Admin > Server Access > SSHv2 Known Host Keys , then select an existing policy or create a new one.
 
    
 
    [bookmark: pgfId-538165]Step 2 Click the Add button to open the Add or Edit Known Host RSA Key Dialog Box.
 
    [bookmark: pgfId-538170]Step 3 Select a row and then click the Edit button to open the Add or Edit Known Host RSA Key Dialog Box.
 
    [bookmark: pgfId-538172]

    
     

    

    
 
     
      [bookmark: pgfId-538180][bookmark: 96265][bookmark: ipdvchap_cncpt_AddEditKnownHostRSAKey]Add or Edit Known Host RSA Key Dialog Box
 
     [bookmark: pgfId-538182]Use the Add or Edit Known Host RSA Key dialog box to retrieve an SSHv2 key from an IPS sensor or to enter the key manually if you know it.
 
     [bookmark: pgfId-538184]Navigation Path
 
     [bookmark: pgfId-538189]From the SSHv2 Known Host Keys policy, click the Add button beneath the IP Address/Public Key table, or select a row in the table and click the Edit button. For information on the SSHv2Known Host Keys policy, see IPS SSHv2 Known Host Keys.
 
     [bookmark: pgfId-538191]Field Reference
 
     [bookmark: pgfId-538194]
 
      
       
        
        [bookmark: pgfId-535707]Table 36-8 [bookmark: 96278]Add or Edit Known Host RSA Key Dialog Box 
 
        
       
         
         	
           
           [bookmark: pgfId-535713]Element
          
  
         	
           
           [bookmark: pgfId-535715]Description
          
  
        
 
         
         	[bookmark: pgfId-535721]IP Address
  
         	[bookmark: pgfId-535723]The IP address of the IPS sensor from which you want to retrieve the public key.
  
        
 
         
         	[bookmark: pgfId-535729]Retrieve Public Key
  
         	[bookmark: pgfId-535731]Initiates retrieval of the public key from the device identified in the IP Address field.
 [bookmark: pgfId-535733]The Retrieve Public Key option is available in device view (it is not shown in shared policy view). However, you can enter inline values for the public key in shared policies or retrieve the public key in device view and share it using the "share policy" option.
  
        
 
         
         	[bookmark: pgfId-535739]Public Key
  
         	[bookmark: pgfId-535741]The public key that you know and are able to enter manually.
 [bookmark: pgfId-535743]For shared policies, you will be able to enter inline values for the host key.
  
        
 
       
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-538200][bookmark: 96307][bookmark: ipdvchap_proc_Configuring_IPS_SSHv1_FallbackSettings]Configuring IPS SSHv1 Fallback Settings
 
    [bookmark: pgfId-538202]The IPS SSHv1 Fallback policy is available on IPS sensors running 7.1(8) and later versions of Cisco IPS.
 
    
 
    [bookmark: pgfId-538204]Step 1 Do one of the following to enable or disable SSHv1 Fallback:
 
     
     	 [bookmark: pgfId-538206](Device view) Select  Platform > Device Admin > Server Access >Settings from the Policy selector.
 
     	 [bookmark: pgfId-538208](Policy view) Select  IPS > Platform > Device Admin > Server Access > Settings , then select an existing policy or create a new one.
 
    
 
    [bookmark: pgfId-538210]Step 2 To enable SSHv1 fallback, click the checkbox.
 
    [bookmark: pgfId-538212]Step 3 To disable SSHv1 fallback, clear the checkbox.
 
    [bookmark: pgfId-538214]

    
     

    

    
 
   
 
    
     [bookmark: pgfId-538232][bookmark: 96327][bookmark: ipdvchap_proc_ConfiguringtheExternalProductInterface]Configuring the External Product Interface[bookmark: marker-538224][bookmark: marker-538226][bookmark: marker-538228][bookmark: marker-538230]
 
    [bookmark: pgfId-538234]Use the External Product Interface policy to configure the way that Security Manager works with Management Center for Cisco Security Agents (CSA MC).
 
    [bookmark: pgfId-538236]In general, the external product interface is designed to receive and process information from external security and management products. These external security and management products collect information that can be used to automatically enhance the sensor configuration information. Management Center for Cisco Security Agents is the only external product that can be configured to communicate with the IPS. At most two Management Center for Cisco Security Agents servers can be configured per IPS device.
 
     
      
    
 
    
 
    [bookmark: pgfId-538242]Tip Management Center for Cisco Security Agents is no longer an active product. Configure this policy only if you are still using that application. For more information, see About CSA MC in Installing and Using Cisco Intrusion Prevention System Device Manager 6.0 and http://www.cisco.com/en/US/products/sw/cscowork/ps5212/index.html.

    
     

    

    
 
    [bookmark: pgfId-538244]Management Center for Cisco Security Agents enforces a security policy on network hosts. It has two components:
 
     
     	 [bookmark: pgfId-538246]Agents that reside on and protect network hosts.
 
     	 [bookmark: pgfId-538248]A management console, which is an application that manages agents. It downloads security policy updates to agents and uploads operational information from agents.
 
    
 
    [bookmark: pgfId-538250]Before You Begin
 
    [bookmark: pgfId-538255]Add the external product as an allowed host so that Security Manager allows the sensor to communicate with the external product. For more information, see Identifying Allowed Hosts.
 
    
 
    [bookmark: pgfId-538257]Step 1 Do one of the following to open the External Product Interface policy:
 
     
     	 [bookmark: pgfId-538259](Device view) Select  Platform > Device Admin > Server Access > External Product Interface from the Policy selector.
 
     	 [bookmark: pgfId-538261](Policy view) Select  IPS > Platform > Device Admin > Server Access > External Product Interface , then select an existing policy or create a new one.
 
    
 
    [bookmark: pgfId-538263]The Management Center for Cisco Security Agents tab shows any existing definitions, including the IP address (or network/host object), URL, and port of the external application, the username and password used to log into it, and whether the connection is enabled. The interface type is always Extended SDEE.
 
    [bookmark: pgfId-538265]Step 2 Do one of the following:
 
     
     	 [bookmark: pgfId-538270]To add a server, click the  Add Row (+) button. This opens the External Product Interface dialog box. Enter the information required to identify the server and configure the posture ACLs. For detailed information on the settings, see External Product Interface Dialog Box.
 
    
 
    [bookmark: pgfId-538272]You can add at most two servers.
 
     
     	 [bookmark: pgfId-538274]To edit a server, select it and click the  Edit Row (pencil) button and make the required changes in the External Product Interface dialog box.
 
     	 [bookmark: pgfId-538276]To delete a server, select it and click the  Delete Row (trash can) button.
 
    
 
    [bookmark: pgfId-538278]

    
     

    

    
 
     
      [bookmark: pgfId-538290][bookmark: 96387][bookmark: ipspage_cncpt_ExternalProductInterfaceDialogBox]External Product Interface Dialog Box[bookmark: marker-538286][bookmark: marker-538288]
 
     [bookmark: pgfId-538292]Use the Add or Edit External Product Interface dialog box to add or modify interfaces between Management Center for Cisco Security Agents (CSA MC) and the IPS device and the related posture ACLs.
 
     [bookmark: pgfId-538294]Navigation Path
 
     [bookmark: pgfId-538299]From the External Product Interface IPS platform policy, click Add Row or select an entry and click Edit Row. For information on opening the External Product Interface policy, see Configuring the External Product Interface.
 
     [bookmark: pgfId-538301]Field Reference
 
     [bookmark: pgfId-538304]
 
      
       
        
        [bookmark: pgfId-535756]Table 36-9 [bookmark: 96406]External Product Interface Dialog Box 
 
        
       
         
         	
           
           [bookmark: pgfId-535762]Element
          
  
         	
           
           [bookmark: pgfId-535764]Description
          
  
        
 
         
         	[bookmark: pgfId-535770]External Product’s IP Address
  
         	[bookmark: pgfId-535772]The IP address, or the network/host policy object that contains the address, of the external product. Enter the IP address or object name, or click Select to select an object from a list or to create a new one.
  
        
 
         
         	[bookmark: pgfId-535778]Interface Type
  
         	[bookmark: pgfId-535780]Identifies the physical interface type, which is always Extended SDEE.
  
        
 
         
         	[bookmark: pgfId-535786]Enable receipt of information
  
         	[bookmark: pgfId-535788]Whether information is allowed to be passed from the external product to the sensor.
  
        
 
         
         	[bookmark: pgfId-535794]SDEE URL
  
         	[bookmark: pgfId-535796]The URL on the CSA MC the IPS uses to retrieve information using SDEE communication. You must configure the URL based on the software version of the CSA MC that the IPS is communicating with as follows:
 
           
           	 [bookmark: pgfId-535798]For CSA MC version 5.0—/csamc50/sdee-server.
 
           	 [bookmark: pgfId-535800]For CSA MC version 5.1—/csamc51/sdee-server.
 
           	 [bookmark: pgfId-535802]For CSA MC version 5.2 and higher—/csamc/sdee-server (the default value).
 
          
  
        
 
         
         	[bookmark: pgfId-535808]Port
  
         	[bookmark: pgfId-535810]The port, or the port list object that identifies the port, being used for communications. Enter the port or port list name, or click Select to select the object from a list or to create a new object.
  
        
 
         
         	[bookmark: pgfId-535816]User name
 [bookmark: pgfId-535818]Password
  
         	[bookmark: pgfId-535820]A username and password that can log into the external product.
  
        
 
         
         	[bookmark: pgfId-535826]Enable receipt of host postures
  
         	[bookmark: pgfId-535828]Whether to allow the receipt of host posture information from CSA MC. The host posture information received from a CSA MC is deleted if you disable this option.
  
        
 
         
         	[bookmark: pgfId-535834]Allow unreachable hosts’ postures
  
         	[bookmark: pgfId-535836]Whether to allow the receipt of host posture information for hosts that are not reachable by the CSA MC.
 [bookmark: pgfId-535838]A host is not reachable if the CSA MC cannot establish a connection with the host on any IP addresses in the host’s posture. This option is useful in filtering the postures whose IP addresses may not be visible to the IPS sensor or that might be duplicated across the network. This filter is most applicable in network topologies where hosts that are not reachable by the CSA MC are also not reachable by the IPS, for example if the IPS and CSA MC are on the same network segment.
  
        
 
         
         	[bookmark: pgfId-535844]Posture ACL table
  
         	[bookmark: pgfId-535846]Posture ACLs are network addresses for which host postures are allowed or denied. Use posture ACLs to filter postures that have IP addresses that might not be visible to the IPS or that might be duplicated across the network.
 
           
           	 [bookmark: pgfId-535851]To add a posture ACL, click the  Add Row (+) button. This opens the Add Posture ACL dialog box. For information on configuring the Posture ACL, see Posture ACL Dialog Box.
 
           	 [bookmark: pgfId-535853]To edit a posture ACL, select it and click the  Edit Row (pencil) button.
 
           	 [bookmark: pgfId-535855]To delete a posture ACL, select it and click the  Delete Row (trash can) button.
 
           	 [bookmark: pgfId-535857]To change the priority of an ACL, select it and click the Up or Down button. ACLs are processed in order, and the action associated with the first match is applied.
 
          
  
        
 
         
         	[bookmark: pgfId-535863]Enable receipt of watch listed addresses
  
         	[bookmark: pgfId-535865]Whether to allow the receipt of the watch list information from CSA MC. The watch list information received from a CSA MC is deleted if you disable this option.
  
        
 
         
         	[bookmark: pgfId-535871]Manual Watch List RR increase
  
         	[bookmark: pgfId-535873]The percentage of the manual watch list risk rating (RR). The default is 25, and the valid range is 0 to 35.
  
        
 
         
         	[bookmark: pgfId-535879]Session-based Watch List RR Increase
  
         	[bookmark: pgfId-535881]The percentage of the session-based watch list risk rating. The default is 25, and the valid range is 0 to 35.
  
        
 
         
         	[bookmark: pgfId-535887]Packed-based Watch List RR Increase
  
         	[bookmark: pgfId-535889]The percentage of the packet-based watch list risk rating. The default is 10, and the valid range is 0 to 35.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-538316][bookmark: 96506][bookmark: ipspage_cncpt_PostureAclDialogBox]Posture ACL Dialog Box[bookmark: marker-538312][bookmark: marker-538314]
 
     [bookmark: pgfId-538318]Use the Add or Modify Posture ACL dialog box to configure posture ACLs for Management Center for Security Agents. Posture ACLs are network addresses for which host postures are allowed or denied. Use posture ACLs to filter postures that have IP addresses that might not be visible to the IPS or that might be duplicated across the network.
 
     [bookmark: pgfId-538320]Configure the following fields to define a posture ACL:
 
      
      	 [bookmark: pgfId-538322] Network Address —Enter the IP address of a host or network, or the name of a network/host object that specifies one. You can click  Select to select the object from a list or to create a new object.
 
      	 [bookmark: pgfId-538324] Action —Whether host postures will be permitted or denied from the hosts on the network address.
 
     
 
     [bookmark: pgfId-538326]Navigation Path
 
     [bookmark: pgfId-538331]From the External Product Interface dialog box (see External Product Interface Dialog Box), click the Add Row (+) button underneath the Posture ACL table, or select a posture ACL and click the Edit Row (pencil) button.
 
    
 
   
 
    
     [bookmark: pgfId-538353][bookmark: 96533][bookmark: ipdvchap_proc_ConfiguringLogging]Configuring IPS Logging Policies[bookmark: marker-538339][bookmark: marker-538341][bookmark: marker-538343][bookmark: marker-538345][bookmark: marker-538347][bookmark: marker-538349][bookmark: marker-538351]
 
    [bookmark: pgfId-538355]Use the IPS platform Logging policy to configure traffic flow notifications and Analysis Engine global variables. These settings apply to the general operation of the IPS sensor.
 
    [bookmark: pgfId-538357]Traffic flow notifications have to do with the flow of traffic across the interface of a sensor. You can configure the sensor to monitor the flow of packets across an interface and send notification if that flow changes (starts and stops) during a specified interval. You can configure the missed packet threshold within a specific notification interval and also configure the interface idle delay before a status event is reported.
 
    [bookmark: pgfId-538359]The Analysis Engine performs packet analysis and alert detection. It monitors traffic that flows through specified interfaces. For the Analysis Engine, there is only one global variable: Maximum Open IP Log Files.
 
    [bookmark: pgfId-538361]Navigation Path
 
     
     	 [bookmark: pgfId-538363](Device view) Select  Platform > Logging from the Policy selector.
 
     	 [bookmark: pgfId-538365](Policy view) Select  IPS > Platform > Logging , then select an existing policy or create a new one.
 
    
 
    [bookmark: pgfId-538367]Field Reference
 
    [bookmark: pgfId-538370]
 
     
      
       
       [bookmark: pgfId-535902]Table 36-10 [bookmark: 96572]IPS Logging Page 
 
       
      
        
        	
          
          [bookmark: pgfId-535908]Element
         
  
        	
          
          [bookmark: pgfId-535910]Description
         
  
       
 
        
        	 
          
          [bookmark: pgfId-535916]Interface Notifications Tab
         
  
       
 
        
        	[bookmark: pgfId-535924]Missed Packets Threshold
  
        	[bookmark: pgfId-535926]The percent of missed packets that has to occur before you want to receive notification. The default is 0, and the range is 0 to 100.
  
       
 
        
        	[bookmark: pgfId-535932]Notification Interval
  
        	[bookmark: pgfId-535934]The length of time, in seconds, that you want to check for the percentage of missed packets. The default is 30, and the range is 5 to 3600.
  
       
 
        
        	[bookmark: pgfId-535940]Interface Idle Threshold
  
        	[bookmark: pgfId-535942]The length of time, in seconds, that you will allow an interface to be idle and not receiving packets before you want to be notified. The default is 30, and the range is 5 to 3600.
  
       
 
        
        	 
          
          [bookmark: pgfId-535948]Analysis Engine Tab
         
  
       
 
        
        	[bookmark: pgfId-535956]Specify-Flow-Depth
  
        	[bookmark: pgfId-535958]Lets you specify the inspection depth of the flow. Flow depth is the number of bytes inspected in a flow. The new value applies for new flows only. The valid range is from 0 to 429496296. The default is 0.
  
       
 
        
        	[bookmark: pgfId-535964]Enable Service Activity
  
        	[bookmark: pgfId-535966]Service activity lets you gather information about service activities for diagnostic purposes. The details are more granular and have port level details. Enabling service activity impacts system performance. Enable service activity collection temporarily for diagnostic purposes only. You must reboot the sensor after you enable service activity for the change to take effect.
  
       
 
        
        	[bookmark: pgfId-535972]Service Activity Limit
  
        	[bookmark: pgfId-535974]Sets the limit for how many services you want to enable. The valid range is from 10 to 65536. The default is 15.
  
       
 
        
        	 [bookmark: pgfId-535980]Note The Specify-Flow-Depth, Enable Service Activity, and Service Activity Limit fields are applicable to IPS devices of version 7.2(2) or higher.
  
       
 
        
        	[bookmark: pgfId-535988]Maximum Open IP Log Files
  
        	[bookmark: pgfId-535990]The maximum number of open IP log files that you want to allow on the sensor. The default is 20, and the range is 20 to 100.
  
       
 
      
     
 
    
 
   
 
    
     [bookmark: pgfId-538378][bookmark: 96632][bookmark: ipsvchap_cncpt_IPSHealthMonitor]IPS Health Monitor
 
    [bookmark: pgfId-538380]Use the IPS Health Monitor page to configure the metrics, or parameters, that are used to determine the health and network security status of your IPS devices. Your IPS devices use these metrics to assign appropriate severity when sending IPS events. The results appear in the Health and Performance Monitor of Security Manager (Launch > Health and Performance Monitor).
 
    [bookmark: pgfId-538382]IPS Health Monitor is supported in IPS devices beginning with IPS version 6.1 and in Security Manager beginning with version 4.4. Please note the following special cases:
 
    [bookmark: pgfId-538384] 1. For IPS devices running 7.x, all 11 configuration items in the IPS Security Settings Policy are displayed and monitored properly in the Security Manager GUI.
 
    [bookmark: pgfId-538386] 2. For IPS devices running less than 6.1, the Network Participation and Global Correlation entries are hidden in the device view of Security Manager.
 
    [bookmark: pgfId-538388] 3. Some IPS Health Monitor configuration items are protected entries on the device side itself and cannot be edited. Security Manager informs you in such cases.
 
    [bookmark: pgfId-538390]If you do not select a metric by checking the check box, it does not appear in the Health and Performance Monitor. You can accept the default configuration or edit the values. Items will be disabled and will not be editable if you do not select a metric.
 
    [bookmark: pgfId-538392]The overall health is set to the most critical settings of any of the metrics. For instance, if all the selected metrics are normal except for one that is critical, the overall health becomes critical. The IPS sensor sends a health and security status event when the overall health status of the IPS sensor changes.
 
    [bookmark: pgfId-538394]The security status of the IPS sensor is determined for each virtual sensor using the threat ratings of events detected by the virtual sensors. The security status of the virtual sensor is raised when the virtual sensor detects an event with a threat rating that exceeds the threshold for that virtual sensor. After a threshold has been exceeded, the security status remains at a critical level until the configured amount of time has passed with no more events being detected at the higher level.
 
    [bookmark: pgfId-538396]To configure the metrics on the IPS Health Monitor page, select one of the following policies:
 
     
     	 [bookmark: pgfId-538398](Device view) Select  Platform > Device Admin > Health Monitor from the Policy selector.
 
     	 [bookmark: pgfId-538400](Policy view) Select  IPS > Platform > Device Admin > Health Monitor from the Policy Type selector, then select an existing policy or create a new one.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-538402]Note In policy view, no validation is performed if a shared IPS Health Monitor policy is applied to an IPS device running less than 6.1. Security Manager ignores such policies during deployment to device and captures them in deployment logs also.

    
     

    

    
 
    [bookmark: pgfId-538404]The following table explains the IPS Health Monitor Metrics that you can configure.
 
    [bookmark: pgfId-538407]
 
     
      
       
       [bookmark: pgfId-536003]Table 36-11 [bookmark: 96658]IPS Security Settings Policy 
 
       
      
        
        	
          
          [bookmark: pgfId-536009]Element
         
  
        	
          
          [bookmark: pgfId-536011]Description
         
  
       
 
        
        	[bookmark: pgfId-536017]Inspection Load
  
        	[bookmark: pgfId-536019]Lets you set a threshold for inspection load and whether this metric is applied to the overall sensor health rating.
  
       
 
        
        	[bookmark: pgfId-536025]Missed Packet
  
        	[bookmark: pgfId-536027]Lets you set a threshold percentage for missed packets and whether this metric is applied to the overall sensor health rating.
  
       
 
        
        	[bookmark: pgfId-536033]Memory Usage
  
        	[bookmark: pgfId-536035]Lets you set a threshold percentage for memory usage and whether this metric is applied to the overall sensor health rating.
  
       
 
        
        	[bookmark: pgfId-536041]Signature Update
  
        	[bookmark: pgfId-536043]Lets you set a threshold for when the last signature update was applied and whether this metric is applied to the overall sensor health rating.
  
       
 
        
        	[bookmark: pgfId-536049]License Expiration
  
        	[bookmark: pgfId-536051]Lets you set a threshold for when the license expires and whether this metric is applied to the overall sensor health rating.
  
       
 
        
        	[bookmark: pgfId-536057]Event Retrieval
  
        	[bookmark: pgfId-536059]Lets you set a threshold for when the last event was retrieved and whether this metric is applied to the overall sensor health rating.
 [bookmark: pgfId-536061]Note The event retrieval metric keeps track of when the last event was retrieved by an external monitoring application such as IME. Disable Event Retrieval if you are not doing external event monitoring.
  
       
 
        
        	[bookmark: pgfId-536067]Network Participation
  
        	[bookmark: pgfId-536069]Lets you choose whether the Network Participation health metrics contribute to the overall sensor health rating.
  
       
 
        
        	[bookmark: pgfId-536075]Global Correlation
  
        	[bookmark: pgfId-536077]Let you choose whether the Global Correlation health metrics contribute to the overall sensor health rating.
  
       
 
        
        	[bookmark: pgfId-536083]Application Failure
  
        	[bookmark: pgfId-536085]Lets you choose to have an application failure applied to the overall sensor health rating.
  
       
 
        
        	[bookmark: pgfId-536091]IPS in Bypass Mode
  
        	[bookmark: pgfId-536093]Let you choose to know if bypass mode is active and have that apply to the overall sensor health rating.
  
       
 
        
        	[bookmark: pgfId-536099]One or More Active Interfaces Down
  
        	[bookmark: pgfId-536101]Lets you choose to know if one or more enabled interfaces are down and have that apply to the overall sensor health rating.
  
       
 
        
        	[bookmark: pgfId-536107]Warning
  
        	[bookmark: pgfId-536109]Lets you set the lowest threshold in percentage, days, seconds, or failures for the warning threshold.
  
       
 
        
        	[bookmark: pgfId-536115]Critical
  
        	[bookmark: pgfId-536117]Lets you set the lowest threshold in percentage, days, seconds, or failures for the critical threshold.
  
       
 
      
     
 
    
 
   
 
    
     [bookmark: pgfId-538415][bookmark: 96735][bookmark: ipsvchap_cncpt_ConfiguringIPSSecuritySettings]Configuring IPS Security Settings
 
    [bookmark: pgfId-538417]Use the IPS Security Settings policy to configure two items that are important to the security of your IPS devices:
 
     
     	 [bookmark: pgfId-538419] Permit packet capture logging —With this feature, IPS devices can prevent users from arbitrarily executing packet capture/display/iplog commands. In previous versions of Security Manager, such actions leave no trace of who executed the command.
 
     	 [bookmark: pgfId-538421] Configurable idle timeout —When configured, this feature terminates the connection to an IPS device after a period of time that you specify. Its purpose is to increase the security of a CLI session.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-538423]Note These settings are available for devices operating with IPS 7.1.3 and later.

    
     

    

    
 
    [bookmark: pgfId-538425]To configure IPS security settings, select one of the following policies:
 
     
     	 [bookmark: pgfId-538427](Device view) Select  Platform > Security >Settings from the Policy selector.
 
     	 [bookmark: pgfId-538429](Policy view) Select  IPS > Platform > Security > Settings from the Policy Type selector, then select an existing policy or create a new one.
 
    
 
    [bookmark: pgfId-538431]The following table explains the IPS security settings that you can configure.
 
    [bookmark: pgfId-538434]
 
     
      
       
       [bookmark: pgfId-536130]Table 36-12 [bookmark: 96759]IPS Security Settings Policy 
 
       
      
        
        	
          
          [bookmark: pgfId-536136]Element
         
  
        	
          
          [bookmark: pgfId-536138]Description
         
  
       
 
        
        	[bookmark: pgfId-536144]Permit packet logging
  
        	[bookmark: pgfId-536146]Whether to enable packet logging; applies to packet capture/display/iplog commands.
  
       
 
        
        	[bookmark: pgfId-536152]CLI Inactivity Timeout (In Minutes)
  
        	[bookmark: pgfId-536154]Terminates the connection to an IPS device after the specified period of time.
  
       
 
      
     
 
    
 
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-609004][bookmark: 105691][bookmark: pxchap_cncpt_ManagingFirewallDevices]Managing Firewall Devices[bookmark: marker-609002]
      
      
 
     
 
 
    [bookmark: pgfId-609006]The following topics describe configuration and management of security services and policies on Cisco security devices: Adaptive Security Appliances (ASAs), PIX Firewalls, and the Catalyst 6500 series switch Services Modules—that is, Firewall Services Modules (FWSMs) and ASA-SMs.
 
    [bookmark: pgfId-609008]This chapter contains the following topics:
 
     
     	 [bookmark: pgfId-609013]Firewall Device Types
 
     	 [bookmark: pgfId-609018]Default Firewall Configurations
 
     	 [bookmark: pgfId-609023]Configuring Firewall Device Interfaces
 
     	 [bookmark: pgfId-609028]VXLAN
 
    
 
   
 
    
     [bookmark: pgfId-609054][bookmark: 105698][bookmark: pxchap_cncpt_TypesofFirewallDevices]Firewall Device Types[bookmark: marker-609034][bookmark: marker-609036][bookmark: marker-609038][bookmark: marker-609040][bookmark: marker-609042][bookmark: marker-609044][bookmark: marker-609046][bookmark: marker-609048][bookmark: marker-609050][bookmark: marker-609052]
 
    [bookmark: pgfId-609056]Security Manager can discover and manage a variety of Cisco security appliances or firewall devices, most notably the following:
 
     
     	 [bookmark: pgfId-609058]PIX 500 Series firewall devices
 
     	 [bookmark: pgfId-609060]ASA 5500 Series security appliances including the Cisco Virtual Security Appliance (ASAv)
 
     	 [bookmark: pgfId-609062]Security-specific Catalyst Services Modules
 
    
 
    [bookmark: pgfId-609064]PIX 500 Series
 
    [bookmark: pgfId-609066]The Private Internet eXchange (PIX) 500 Series firewall appliances are no longer sold, however they are still supported and a great many are still in use world-wide.
 
    [bookmark: pgfId-609068]ASA 5500 Series
 
    [bookmark: pgfId-609072]The Adaptive Security Appliance (ASA) 5500 Series devices provide comprehensive security services, including context-aware firewall capabilities and real-time threat defense. The ASA 5500 has replaced the PIX 500 as Cisco’s primary security appliance. Visit the Cisco ASA 5500 Series Adaptive Security Appliance page on cisco.com for more information.
 
    [bookmark: pgfId-609076]The Cisco ASAv Virtual Appliance, introduced in ASA 9.2(1), brings full firewall functionality to virtualized environments to secure data center traffic and multi-tenant environments. The ASAv runs on VMware vSphere. Although the ASAv is a virtual device, it is managed like other ASA devices in Security Manager. For more information about the ASAv, see http://www.cisco.com/c/en/us/support/security/virtual-adaptive-security-appliance-firewall/tsd-products-support-series-home.html.
 
     
      
    
 
    
 
    [bookmark: pgfId-609078]Note The ASAv does not support the following ASA features: Clustering, Multiple context mode, Active/Active failover, Ether channels, and Shared AnyConnect Premium Licenses.

    
     

    

    
 
    [bookmark: pgfId-609080]Catalyst Services Modules
 
    [bookmark: pgfId-609082]A variety of Services Modules (SMs) are available for the Catalyst 6500 switch, including two that provide firewall and security services. These are blade-type modules that are installed directly into the switch chassis.
 
    [bookmark: pgfId-609086]The Firewall Services module (FWSM) allows any port on the switch to operate as a firewall port, integrating firewall security inside the network structure. See Cisco Catalyst 6500 Series Firewall Services Module for more information.
 
    [bookmark: pgfId-609090]The Adaptive Security Appliance service module (ASA-SM) provides high-speed security services across Layers 2 through 7, and you can install up to four ASA-SM blades in a single switch, providing scalability to 64 Gbps. See Cisco Catalyst 6500 Series ASA Services Module for more information.
 
     
      
    
 
    
 
    [bookmark: pgfId-609092]Note While the ASA-SM is a blade installed in a Catalyst 6500 switch—much like the FWSM physically—it is an ASA device, and it is documented as such. That is, refer to ASA-related topics for information about the ASA-SM. Where necessary, caveats and differences between the Service Module and the ASA appliance are noted.

    
     

    

    
 
   
 
    
     [bookmark: pgfId-609102][bookmark: 105758][bookmark: pxchap_cncpt_DefaultFirewallConfigurations]Default Firewall Configurations[bookmark: marker-609098][bookmark: marker-609100]
 
    [bookmark: pgfId-609107]Firewall devices are shipped with certain settings already configured. When you manually add a newly installed firewall device to Cisco Security Manager, you should discover (import) the pre-set or default policies for that device. Importing these policies into Security Manager prevents them being unintentionally removed the first time you deploy a configuration to that device. For more information about importing policies, see Discovering Policies.
 
    [bookmark: pgfId-609109]Cisco Security Manager provides a set of configuration files that contain default policies for a number of device types and versions. These configuration files are located in the directory: <install_dir>\CSCOpx\MDC\fwtools\pixplatform\ (for example, C:\Program Files\CSCOpx\MDC\fwtools\pixplatform\).
 
    [bookmark: pgfId-609111]The file name indicates device type, operating system version, context support, and operation type. For example, “FactoryDefault_FWSM2_2_MR.cfg” is the configuration file for an FWSM, version 2.2, with support for Multiple contexts, operating in Routed mode. Similarly, “FactoryDefault_ASA7_0_1_ST.cfg” is the configuration file for an ASA, version 7.0.1, in Single-context, Transparent mode.
 
    [bookmark: pgfId-609119]Refer to Interfaces in Single and Multiple Contexts for more about security contexts, and Interfaces in Routed and Transparent Modes for more about routed and transparent operation.
 
    [bookmark: pgfId-609124]See Adding Devices from Configuration Files for information about adding new devices from the supplied configuration files.
 
   
 
    
     [bookmark: pgfId-609138][bookmark: 105778][bookmark: pxchap_cncpt_ConfiguringFirewallDeviceInterfaces]Configuring Firewall Device Interfaces[bookmark: marker-609130][bookmark: marker-609132][bookmark: marker-609134][bookmark: marker-609136]
 
    [bookmark: pgfId-609140]The Interfaces page displays configured physical interfaces, logical interfaces, and redundant interfaces, as well as hardware ports and bridge groups, for the selected device. From this page, you can add, edit and delete interfaces; enable communication between interfaces on the same security level; and manage VPDN groups and PPPoE users.
 
     
      
    
 
    
 
    [bookmark: pgfId-609142]Note The Interfaces page displayed for ASA 5505 devices presents two tabbed panels: Hardware Ports and Interfaces. Similarly, the Interfaces page displayed for the Catalyst 6500 services modules (ASA-SMs and FWSMs) operating in transparent mode also presents two tabbed panels: Interfaces and Bridge Groups.

    
     

    

    
 
    [bookmark: pgfId-609144]Navigation Path
 
    [bookmark: pgfId-609146]To access the Interfaces page, select a security device in Device View and then select Interfaces from the Device Policy selector.
 
    [bookmark: pgfId-609148]This section contains the following topics:
 
     
     	 [bookmark: pgfId-609153]Understanding Device Interfaces
 
     	 [bookmark: pgfId-609158]Managing Device Interfaces, Hardware Ports, and Bridge Groups
 
     	 [bookmark: pgfId-609163]Advanced Interface Settings (PIX/ASA/FWSM)
 
    
 
     
      [bookmark: pgfId-609173][bookmark: 105802][bookmark: pxchap_cncpt_UnderstandingDeviceInterfaces]Understanding Device Interfaces[bookmark: marker-609169][bookmark: marker-609171]
 
     [bookmark: pgfId-609175]An interface is a point of connection between a security device and some other network device. Interfaces are initially disabled; thus, as an essential part of firewall configuration, interfaces must be enabled and configured to allow appropriate packet inspection and forwarding.
 
     [bookmark: pgfId-609177]There are two types of interface: physical and logical, where a physical interface is the actual slot on the device into which a network cable is plugged, and a logical interface is a virtual port assigned to a specific physical port. Generally, physical ports are referred to as interfaces, while logical ports are referred to as subinterfaces, virtual interfaces, VLANs, or EtherChannels, depending on their function. The number and type of interfaces you can define varies with appliance model and type of license purchased.
 
      
       
     
 
     
 
     [bookmark: pgfId-609179]Note On devices running version 6.3 of the PIX operating system, the labels “physical” and “logical” are used, rather than “interface” and “subinterface.” Also, transparent mode and multiple contexts are not supported on these devices.

     
      

     

     
 
     [bookmark: pgfId-609181]Subinterfaces let you divide a physical interface into multiple logical interfaces that are tagged with different VLAN IDs. Because VLANs keep traffic separate on a given physical interface, you can increase the number of interfaces available to your network without adding additional physical interfaces or security appliances. This feature is particularly useful in multiple-context mode, allowing you to assign unique interfaces to each context.
 
     [bookmark: pgfId-609183]As a general rule, interfaces attach to router-based networks, and subinterfaces attach to switch-based networks. All subinterfaces must be associated with a physical interface that is responsible for routing allowed traffic correctly.
 
     [bookmark: pgfId-609188]If you use subinterfaces, you typically do not also want the physical interface to pass traffic, because the physical interface passes untagged packets. The physical interface must be enabled for the subinterface to pass traffic, but do not name the physical interface to ensure it does not pass traffic. However, if you do want to let the physical interface pass untagged packets, you can name the interface as usual. See Managing Device Interfaces, Hardware Ports, and Bridge Groups for information about naming an interface.
 
      
       
     
 
     
 
     [bookmark: pgfId-609193]Note The ASA 5505, combining switch and security appliance features, is a special case in that you configure both physical switch ports and logical VLAN interfaces. See Understanding ASA 5505 Ports and Interfaces for more information.

     
      

     

     
 
     [bookmark: pgfId-609195]The Catalyst 6500 services modules (ASA-SMs and FWSMs) do not include any external physical interfaces—instead, they use internal VLAN interfaces. For example, assume you assign VLAN 201 to an FWSM inside interface, and VLAN 200 to the outside interface. You assign these VLANs to physical switch ports, and hosts connect to those ports. When communication occurs between VLANs 201 and 200, the FWSM is the only available path between the VLANs, forcing traffic to be statefully inspected.
 
     [bookmark: pgfId-609197]See the following sections for additional information about device interfaces:
 
      
      	 [bookmark: pgfId-609202]Interfaces in Routed and Transparent Modes
 
      	 [bookmark: pgfId-609207]Interfaces in Single and Multiple Contexts
 
      	 [bookmark: pgfId-609212]Understanding ASA 5505 Ports and Interfaces
 
      	 [bookmark: pgfId-609217]Configuring Subinterfaces (PIX/ASA)
 
      	 [bookmark: pgfId-609222]Configuring Redundant Interfaces
 
      	 [bookmark: pgfId-609227]Configuring EtherChannels
 
     
 
     [bookmark: pgfId-609229]Security Appliance Configurations
 
      
       
        
        [bookmark: pgfId-606366]Table 46-1 [bookmark: 105847]Security Appliance Configurations 
 
        
       
         
         	
           
           [bookmark: pgfId-606374]Device Type
          
  
         	
           
           [bookmark: pgfId-606376]Operational Mode (Router or Transparent)
          
  
         	
           
           [bookmark: pgfId-606378]Context Support (Single or Multiple)
          
  
        
 
         
         	[bookmark: pgfId-606386]PIX 6.3.x
  
         	[bookmark: pgfId-606388]N/A
  
         	[bookmark: pgfId-606390]N/A
  
        
 
         
         	[bookmark: pgfId-606398]PIX 7.0+/ASA
  
         	[bookmark: pgfId-606400]Router or Transparent
  
         	[bookmark: pgfId-606402]Single
  
        
 
         
         	[bookmark: pgfId-606410]PIX 7.0+/ASA, or security context of unmanaged PIX 7.0+/ASA
  
         	[bookmark: pgfId-606412]Router or Transparent
  
         	[bookmark: pgfId-606417]Multiple (see Checklist for Configuring Multiple Security Contexts)
  
        
 
         
         	[bookmark: pgfId-606425]FWSM, or security context of unmanaged switch (multiple mode)
  
         	[bookmark: pgfId-606427]Router or Transparent
  
         	[bookmark: pgfId-606429]Single or Multiple
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-609244][bookmark: 105888][bookmark: pxchap_cncpt_Interfaces_AboutTranparentMode]Interfaces in Routed and Transparent Modes[bookmark: marker-609240][bookmark: marker-609242]
 
     [bookmark: pgfId-609246]Beginning with ASA/PIX 7.0 and FWSM 2.2.1, you can configure a security device to operate in one of two modes: routed or transparent. (The PIX 6.3 operates only in routed mode.)
 
     [bookmark: pgfId-609248]In routed mode, the security appliance acts as a gateway or router for connected networks: it maintains IP addresses for its interfaces, and inspects and filters traffic traversing these interfaces based on IP address (Layer 3) information. In this mode, each device interface is connected to a different IP subnet, and has its own IP address on that subnet. Routed mode supports up to 256 interfaces in single mode or per context, with a maximum of 1000 interfaces divided between all contexts.
 
     [bookmark: pgfId-609250]In transparent mode, the security appliance operates as a Layer 2 (data link) device, or transparent bridge, and is often referred to as a “bump in the wire,” or a “stealth firewall.” In this mode, you can define only two interfaces: inside and outside. The interfaces do not require IP addresses; they use VLAN IDs to forward inspected traffic. However, if the device includes a dedicated management interface, you can use it—either the physical interface or a subinterface—as a third interface for device-management traffic.
 
      
       
     
 
     
 
     [bookmark: pgfId-609252]Note Cisco Security Manager does not populate the interface information for FWSM 2.x devices during discovery.

     
      

     

     
 
     [bookmark: pgfId-609254]Bridge Groups
 
     [bookmark: pgfId-609259]Beginning with the ASA 8.4.1 and FWSM 3.1, in transparent mode, you can increase the number of interfaces available to a device or context through use of bridge groups. You can configure up to eight bridge groups; on an FWSM each group can contain two interfaces; on an ASA each group can contain four interfaces. See Add/Edit Bridge Group Dialog Box for more information.
 
     [bookmark: pgfId-609261]Related Topics
 
      
      	 [bookmark: pgfId-609266]Chapter 47, “Configuring Bridging Policies on Firewall Devices”
 
     
 
    
 
     
      [bookmark: pgfId-609276][bookmark: 105914][bookmark: pxchap_cncpt_Interfaces_AboutMultiMode]Interfaces in Single and Multiple Contexts[bookmark: marker-609272][bookmark: marker-609274]
 
     [bookmark: pgfId-609278]Security “contexts” allow a single physical device to operate as multiple, independent firewalls. In multiple-context mode, each context defines a single virtual firewall, complete with its own configuration. Each context acts as a unique virtual firewall that inspects and filters traffic traversing the interfaces allocated to that context. Each context is “unaware” of other contexts defined on the same security appliance.
 
     [bookmark: pgfId-609280]As with a single-context, routed-mode device, interfaces on a multiple-context device connect to router-based networks, subinterfaces connect to switch-based networks, and each subinterface must be associated with an interface that routes allowed traffic correctly.
 
     [bookmark: pgfId-609282]However, you cannot define IP addresses, the routed-mode portion of the configuration, or identify the management interface until you have defined and deployed the contexts. But you cannot define a security context until you have defined the necessary interfaces and subinterfaces.
 
     [bookmark: pgfId-609284]In other words, you must enable and configure the interfaces and subinterfaces on a device that will provide multiple security contexts (in either routed or transparent mode) before you can define and configure the security contexts themselves.
 
     [bookmark: pgfId-609289]Refer to Chapter 58, “Configuring Security Contexts on Firewall Devices” for more information.
 
    
 
     
      [bookmark: pgfId-609299][bookmark: 105931][bookmark: pxchap_cncpt_Interfaces_AboutAsymmetricRouting]About Asymmetric Routing Groups[bookmark: marker-609295][bookmark: marker-609297]
 
     [bookmark: pgfId-609301]In some situations, return traffic for a session may be routed through a different interface than the one from which it originated. Similarly, in failover configurations, return traffic for a connection that originated on one unit may return through the peer unit. This most commonly occurs when two interfaces on a single FWSM, or two FWSMs in a failover pair, are connected to different service providers and the outbound connection does not use a NAT address. By default, the FWSM drops the return traffic because there is no connection information for that traffic.
 
     [bookmark: pgfId-609303]You can prevent return traffic being dropped by assigning the VLAN interfaces on which this is likely to occur to an asymmetric routing (ASR) group. When a member interface receives a packet for which it has no session information, it checks the session information for other interfaces that are members of the same group.
 
     [bookmark: pgfId-609305]If a match is not found, the packet is dropped. If a match is found, one of the following actions occurs:
 
      
      	 [bookmark: pgfId-609307]If the incoming traffic originated on a different interface on the same FWSM, some or all of the Layer 2 header is rewritten and the packet is re-injected into the stream.
 
      	 [bookmark: pgfId-609309]If the incoming traffic originated on a peer unit in a failover configuration, some or all of the Layer 2 header is rewritten and the packet is redirected to the other unit. This redirection continues as long as the session is active.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-609311]Note In failover configurations, you must enable Stateful Failover for session information to be passed from the standby unit or failover group to the active unit or failover group.

     
      

     

     
 
     [bookmark: pgfId-609316]To assign an FWSM virtual interface to an asymmetric routing group, simply specify an ASR Group ID in the Add/Edit Interface Dialog Box: Advanced Tab (ASA/PIX 7.0+). If the group does not exist, it is created and the interface assigned to it.
 
     [bookmark: pgfId-609318]You must repeat the assignment for each interface that will participate in this ASR group. You can create up to 32 ASR groups and assign a maximum of eight interfaces to each group.
 
      
       
     
 
     
 
     [bookmark: pgfId-609320]Note The upstream and downstream routers must use one MAC address per VLAN, and have different MAC addresses for different VLANs, to allow the redirection of packets from a standby unit to an active unit in failover configurations.

     
      

     

     
 
    
 
     
      [bookmark: pgfId-609332][bookmark: 105952][bookmark: pxchap_cncpt_UnderstandingASAPortsandInterfaces]Understanding ASA 5505 Ports and Interfaces[bookmark: marker-609328][bookmark: marker-609330]
 
     [bookmark: pgfId-609334]The ASA 5505 is unique in that it includes a built-in switch, and there are two kinds of ports and interfaces that you need to configure:
 
      
      	 [bookmark: pgfId-609336]Physical switch ports – The ASA 5505 has eight Fast Ethernet switch ports that forward traffic at Layer 2, using the switching function in hardware. Two of these ports are power-over-Ethernet (PoE) ports. You can connect these ports directly to user equipment such as PCs, IP phones, or DSL modems. Or you can connect to another switch.
 
      	 [bookmark: pgfId-609338]Logical VLAN interfaces – In routed mode, these interfaces forward traffic between VLAN networks at Layer 3, using the configured security policy to apply firewall and VPN services. In transparent mode, these interfaces forward traffic between the VLANs on the same network at Layer 2, using the configured security policy to apply firewall services.
 
     
 
     [bookmark: pgfId-609340]To segregate the switch ports into separate VLANs, you assign each switch port to a VLAN interface. Switch ports on the same VLAN can communicate with each other using hardware switching. But when a switch port on one VLAN attempts to communicate with a switch port on another VLAN, the ASA 5505 applies the security policy to the traffic, and routes or bridges between the two VLANs.
 
      
       
     
 
     
 
     [bookmark: pgfId-609342]Note Subinterfaces and redundant interfaces are not available on the ASA 5505.

     
      

     

     
 
     [bookmark: pgfId-609344]Navigation Path
 
     [bookmark: pgfId-609346]The Interfaces page displayed for ASA 5505 devices presents two tabbed panels: Hardware Ports and Interfaces. To access these panels, select an ASA 5505 in Device View and then select Interfaces from the Device Policy selector.
 
     [bookmark: pgfId-609348]Configuring ASA 5505 Switch Ports and Interfaces
 
     [bookmark: pgfId-609353]Refer to Configuring Hardware Ports on an ASA 5505 for information about configuring the switch ports.
 
     [bookmark: pgfId-609358]Refer to Add/Edit Interface Dialog Box (PIX 7.0+/ASA/FWSM) for information about configuring the interfaces.
 
     [bookmark: pgfId-609360]Related Topics
 
      
      	 [bookmark: pgfId-609365]Managing Device Interfaces, Hardware Ports, and Bridge Groups
 
     
 
    
 
     
      [bookmark: pgfId-609377][bookmark: 105988][bookmark: pxchap_cncpt_Interfaces_ConfiguringSubinterfaces]Configuring Subinterfaces (PIX/ASA)[bookmark: marker-609371][bookmark: marker-609373][bookmark: marker-609375]
 
     [bookmark: pgfId-609379]Subinterfaces let you divide a physical interface into multiple logical interfaces that are tagged with different VLAN IDs. Because VLANs keep traffic separate on a given physical interface, you can increase the number of interfaces available to your network without adding additional physical interfaces or security appliances. This feature is particularly useful in multiple-context mode, letting you assign unique interfaces to each context.
 
      
       
     
 
     
 
     [bookmark: pgfId-609381]Note If you use subinterfaces, you typically do not also want the physical interface to pass traffic, as the physical interface passes untagged packets. Because the physical interface must be enabled for the subinterface to pass traffic, do not name the physical interface to ensure it does not pass traffic. However, if you do want to let the physical interface pass untagged packets, you can name the interface as usual.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-609383]Note This option is available only on PIX 7.0+ and non-5505 ASA devices.

     
      

     

     
 
     [bookmark: pgfId-609385]Defining Subinterfaces
 
     [bookmark: pgfId-609390]Follow these steps to configure a subinterface in the Add/Edit Interface (ASA/PIX 7.0+) dialog box, which is accessed from the device Interfaces page (see Managing Device Interfaces, Hardware Ports, and Bridge Groups).
 
     [bookmark: pgfId-609392] 1. Choose Subinterface as the interface Type in the Add/Edit Interface dialog box.
 
     [bookmark: pgfId-609394]The VLAN ID and Subinterface ID fields appear below the Hardware Port, Name and Security Level fields.
 
     [bookmark: pgfId-609396] 2. Choose the desired Hardware Port from the list of previously defined interface ports. If you do not see a desired interface ID, be sure that Interface is defined and enabled.
 
     [bookmark: pgfId-609398] 3. VLAN ID – Provide a VLAN ID for this subinterface: enter a value between 1 and 4094. The specified VLAN ID must not be in use on any connected device.
 
     [bookmark: pgfId-609400]Some VLAN IDs might be reserved on connected switches; see the switch documentation for more information. In multiple-context mode, you can only set the VLAN ID in the system configuration.
 
     [bookmark: pgfId-609402] 4. Subinterface ID – Provide an integer between 1 and 4294967293 as the Subinterface ID. The number of subinterfaces allowed depends on your platform.
 
     [bookmark: pgfId-609404]For subinterface port identification, this ID is appended to the chosen Hardware Port. For example, GigabitEthernet0.4 represents the subinterface assigned an ID of 4, operating on the port GigabitEthernet0.
 
      
       
     
 
     
 
     [bookmark: pgfId-609406]Note You cannot change the Subinterface ID after you set it.

     
      

     

     
 
     [bookmark: pgfId-609411] 5. Continue configuring this interface, as described in Add/Edit Interface Dialog Box (PIX 7.0+/ASA/FWSM).
 
    
 
     
      [bookmark: pgfId-609423][bookmark: 106030][bookmark: pxchap_cncpt_Interfaces_AboutRedundantPairs]Configuring Redundant Interfaces[bookmark: marker-609417][bookmark: marker-609419][bookmark: marker-609421]
 
     [bookmark: pgfId-609425]Beginning with Security Manager 3.2.2, you can define logical “redundant” interfaces to increase security appliance reliability. A redundant interface is a specific pair of physical interfaces, with one designated as active (or primary) and the other as standby (or secondary). If the active interface fails, the standby interface becomes active and starts passing traffic. This feature is separate from device-level failover, but you can configure redundant interfaces as well as failover, if desired. You can configure up to eight redundant interface pairs.
 
     [bookmark: pgfId-609427]A redundant interface functions as a single interface (inside, outside, etc.), with only one of the member pair active at any one time. This redundant interface is configured normally, with a unique interface name, security level and IP address. Note that each member interface must be of the same type (e.g., GigabitEthernet), and cannot have a name, security level, or IP address assigned. In fact, do not configure any options other than Duplex and Speed on the member interfaces.
 
     [bookmark: pgfId-609429]The redundant interface uses the MAC address of the first physical interface that you specify. If you change the order of the member interfaces in the configuration, then the MAC address changes to match the MAC address of the interface that is now listed first. Alternatively, you can explicitly assign a MAC address to the redundant interface; this address is then used regardless of the member interface MAC addresses. In either case, when the active interface fails over to the standby, the same MAC address is maintained so that traffic is not disrupted.
 
      
       
     
 
     
 
     [bookmark: pgfId-609431]Note This option is available only on PIX 8.0+ and non-5505 ASA devices.

     
      

     

     
 
     [bookmark: pgfId-609433]Defining Redundant Interfaces
 
     [bookmark: pgfId-609438]Follow these steps to configure two physical interfaces as a single logical “redundant interface” in the Add/Edit Interface (ASA/PIX 7.0+) dialog box, which is accessed from the device Interfaces page (see Managing Device Interfaces, Hardware Ports, and Bridge Groups).
 
     [bookmark: pgfId-609440] 1. Choose Redundant as the interface Type in the Add/Edit Interface dialog box.
 
     [bookmark: pgfId-609442]The Redundant ID, Primary Interface and Secondary Interface options appear.
 
     [bookmark: pgfId-609444] 2. Provide an identifier for this redundant interface in the Redundant ID field; valid IDs are the integers from 1 to 8.
 
     [bookmark: pgfId-609446] 3. Primary Interface – Choose the primary member of the redundant interface pair from this list of available interfaces. Available interfaces are presented by Hardware Port IDs, as named interfaces cannot be used for a redundant interface pair.
 
     [bookmark: pgfId-609448] 4. Secondary Interface – Choose the secondary member of the redundant interface pair from this list of available interfaces. Available interfaces are presented by Hardware Port IDs, as named interfaces cannot be used for a redundant interface pair.
 
      
       
     
 
     
 
     [bookmark: pgfId-609450]Note Member interfaces must be enabled and of the same type (e.g., GigabitEthernet), and cannot have a Name, IP Address, or Security Level assigned. In fact, do not configure any options other than Duplex and Speed on the member interfaces.

     
      

     

     
 
     [bookmark: pgfId-609455] 5. Continue configuring this interface, as described in Add/Edit Interface Dialog Box (PIX 7.0+/ASA/FWSM).
 
    
 
     
      [bookmark: pgfId-609467][bookmark: 106070][bookmark: pxchap_cncpt_Interfaces_ConfiguringEtherChannels]Configuring EtherChannels[bookmark: marker-609461][bookmark: marker-609463][bookmark: marker-609465]
 
     [bookmark: pgfId-609469]Beginning with ASA 8.4.1, you can define logical EtherChannel interfaces. An EtherChannel, also called a port-channel interface, is a logical interface consisting of a bundle of individual Ethernet links (a channel group). This provides increased bandwidth and fault tolerance compared to the individual links.
 
     [bookmark: pgfId-609471]An EtherChannel interface is configured and used in the same manner as a single physical interface. You can configure up to 48 EtherChannels, each of which consists of between one and eight active Fast Ethernet, Gigabit Ethernet, or Ten-Gigabit Ethernet ports. For ASA 9.2(1), the number of active interfaces increased to 16.
 
      
       
     
 
     
 
     [bookmark: pgfId-609473]Note You cannot use a redundant interface as part of an EtherChannel, nor can you use an EtherChannel as part of a redundant interface. You cannot use the same physical interfaces in a redundant interface and an EtherChannel interface. You can, however, configure both types on the ASA if they do not use the same physical interfaces.

     
      

     

     
 
     [bookmark: pgfId-609475]EtherChannel MAC Addressing
 
     [bookmark: pgfId-609477]All interfaces that are part of a channel group share the same MAC address. This makes the EtherChannel transparent to network applications and users, because they only see the one logical connection; they have no knowledge of the individual links. By default, the EtherChannel uses the MAC address of the lowest-numbered member interface as its MAC address.
 
     [bookmark: pgfId-609479]Alternatively, you can manually configure a MAC address for the port-channel interface. We recommend doing so in case the channel interface membership changes. For example, if you remove the interface that provides the port-channel MAC address, the port-channel is assigned the MAC address of the next lowest numbered interface, causing traffic disruption. Manually assigning a unique MAC address to the EtherChannel interface prevents this disruption. (Note that in multiple-context mode, you can assign unique MAC addresses to interfaces assigned to an individual context, including EtherChannel interfaces.)
 
     [bookmark: pgfId-609481]About Management Only EtherChannel Interfaces
 
     [bookmark: pgfId-609483]You can specify an EtherChannel group as a management-only interface, but note the following caveats:
 
      
      	 [bookmark: pgfId-609488]Routed mode – You must explicitly configure the EtherChannel to be Management Only in the Add/Edit Interface Dialog Box (PIX 7.0+/ASA/FWSM). Any non-management interface added to the management-only port-channel is treated as a management port. If you add an interface already defined as management-only to the management-only group, that attribute is ignored on the physical interface. Similarly, you cannot designate an interface as management-only if it is already a member of a management-only port-channel.
 
      	 [bookmark: pgfId-609490]Transparent mode – In this mode, members of a management-only EtherChannel can themselves only be management-only ports. Thus, when a management-only member is added to a transparent-mode EtherChannel, the channel inherits the management-only designation, while the designation is removed from the member interface. Conversely, when such an interface is removed from the EtherChannel, the designation is restored on the individual interface.
 
     
 
     [bookmark: pgfId-609492]Using an EtherChannel Interface as a Failover Link
 
     [bookmark: pgfId-609494]If an EtherChannel interface is specified as a failover link, all state-sync traffic for that link will travel over a single physical interface. Should that physical interface fail, the state-sync traffic will then traverse another physical interface that is part of the EtherChannel aggregated link. If there are no remaining available physical interfaces in the EtherChannel link specified for failover, the ASA falls back to the redundant interface, if one is specified.
 
     [bookmark: pgfId-609496]While an EtherChannel interface is being used as an active failover link, changes to that EtherChannel configuration are not allowed. You can change the EtherChannel configuration of that link only by disabling either the link or failover, as follows:
 
      
      	 [bookmark: pgfId-609498]Disable the EtherChannel link while the configuration changes are being made, and then reactivate it (failover will not occur while the link is disabled).
 
      	 [bookmark: pgfId-609500]Disable failover while the configuration changes are being made, and then re-enable it (failover will not occur in the interim).
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-609502]Note As with any other type of interface assigned as a failover link, the EtherChannel interface cannot be named. Further, none of the EtherChannel’s member interfaces can be named.

     
      

     

     
 
     [bookmark: pgfId-609504]Defining EtherChannels on an ASA
 
     [bookmark: pgfId-609509]Follow these steps to configure multiple physical interfaces as a single logical EtherChannel interface in the ASA Add Interface or Edit Interface dialog boxes, which are accessed from the device Interfaces page (see Managing Device Interfaces, Hardware Ports, and Bridge Groups).
 
     
 
     [bookmark: pgfId-609511]Step 1 Choose EtherChannel as the interface Type.
 
     [bookmark: pgfId-609513]The EtherChannel ID and interface-selection options appear on the General panel of the dialog box; the Load Balancing, LACP Mode, and Active Physical Interfaces: Minimum and Maximum fields appear on the Advanced panel.
 
     [bookmark: pgfId-609515]Step 2 Provide an identifier for this EtherChannel in the EtherChannel ID field; valid IDs are the integers from 1 to 48. This number is appended to “Port-channel” to identify the EtherChannel in the Interface column of the table on the device’s Interfaces page.
 
     [bookmark: pgfId-609517]Step 3 Available Interfaces – Specify the members of this port-channel group by select one or more interfaces in this list of available interfaces, and then click the >> button to add them to the member list on the right.
 
      
       
     
 
     
 
     [bookmark: pgfId-609519]Note All interfaces in the channel group must be the same type and speed. The first interface added to the channel group determines the correct type and speed.

     
      

     

     
 
     [bookmark: pgfId-609521]You can assign up to 16 interfaces to a channel group. For ASA 9.2(1) and later, each channel group can have up to 16 active interfaces. For switches that support only 8 active interfaces and ASA versions earlier than 9.2(1), only eight interfaces can be active, the remaining interfaces can act as standby links in case of interface failure. Alternatively, you can create a static EtherChannel by setting LACP Mode to On (on the Advanced panel, as described below), which means all interfaces in the group can pass traffic.
 
      
       
     
 
     
 
     [bookmark: pgfId-609526]Note After assigning interfaces to this EtherChannel group, you can edit the LACP Port parameters for each member interface, as described in Editing LACP Parameters for an Interface Assigned to an EtherChannel.

     
      

     

     
 
     [bookmark: pgfId-609528]Step 4 Click the Advanced tab to display that panel.
 
     [bookmark: pgfId-609533]Step 5 Choose a Load Balancing option in the EtherChannel section. See About EtherChannel Load Balancing, for more information about this option.
 
     [bookmark: pgfId-609535]Step 6 Select the desired LACP Mode; the default is Active, which means up to eight interfaces are active, while up to eight are in stand-by mode, as determined by the Minimum and Maximum values under Active Physical Interfaces.
 
     [bookmark: pgfId-609540]If you select On, a static port-channel is created in which all member interfaces are all “on,” meaning you can have up to 16 ports passing traffic, with no stand-by ports. When you select this option, the Mode for all interfaces assigned to this EtherChannel group is switched to On (if the Mode for each is not already On). See Editing LACP Parameters for an Interface Assigned to an EtherChannel, for more information about this mode.
 
     [bookmark: pgfId-609542]Step 7 Specify the Minimum and Maximum number of Active Physical Interfaces for this EtherChannel.
 
     [bookmark: pgfId-609544]As mentioned, an EtherChannel can consist of between 1 and 8 active links for ASA devices earlier than 9.2(1) or between 1 and 16 active links for ASA 9.2(1)+. Use these fields to indicate the minimum and maximum number of interfaces that can be active in this channel group at any given time. If your switch does not support 16 active interfaces, be sure to set the maximum to 8 or fewer.
 
     [bookmark: pgfId-609549]Step 8 Continue configuring this interface, as described in Add/Edit Interface Dialog Box (PIX 7.0+/ASA/FWSM).
 
      
       
     
 
     
 
     [bookmark: pgfId-609554]Note The EtherChannel LACP System Priority for this device is specified in the Advanced Interface Settings (PIX/ASA/FWSM) dialog box.

     
      

     

     
 
     [bookmark: pgfId-609556]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-609578][bookmark: 106151][bookmark: pxchap_cncpt_Interfaces_AddEditEtherChannels]Editing LACP Parameters for an Interface Assigned to an EtherChannel [bookmark: marker-609562][bookmark: marker-609564][bookmark: marker-609566][bookmark: marker-609568][bookmark: marker-609570][bookmark: marker-609572][bookmark: marker-609574][bookmark: marker-609576]
 
     [bookmark: pgfId-609580]After assigning interfaces to an EtherChannel (port-channel) group, you can edit the LACP Port parameters for each member interface, as described here.
 
      
       
     
 
     
 
     [bookmark: pgfId-609582]Note This feature is available only on ASA 8.4.1+ devices.

     
      

     

     
 
     [bookmark: pgfId-609584]The Link Aggregation Control Protocol (LACP) directs aggregation of physical Fast Ethernet, Gigabit Ethernet, or Ten-Gigabit Ethernet interfaces into an EtherChannel group, and updating the remote partner device with current information after it finds a compatible set of ports and assigns a unique value called an “operational key” to the group. Note that operational key assignment is automatic; you cannot configure it.
 
      
       
     
 
     
 
     
      [bookmark: pgfId-609586]
      Caution These LACP parameters are not available when the EtherChannel is assigned as a failover link.
       
       
 
      

     
 
     [bookmark: pgfId-609588]LACP System Priority
 
     [bookmark: pgfId-609593]Every LACP-enabled device has a unique system ID that is formed by combining a System Priority identifier and the system’s MAC address. In certain situations, two EtherChannel-linked systems may need to change the operational key assigned to a set of ports to allow optimal aggregation. In such a situation, the system with higher priority is allowed to dynamically modify the operational key value assigned to the ports to achieve better aggregation. The system with the lower priority is not allowed to change the operational keys. The System Priority identifier is user-configurable, as described in Advanced Interface Settings (PIX/ASA/FWSM).
 
     [bookmark: pgfId-609595]LACP Port Parameters
 
     [bookmark: pgfId-609597]Port identification is provided by a unique number assigned to every group interface; this identifier is formed by combining a configurable Port Priority number and the port number assigned to the interface.
 
     [bookmark: pgfId-609599]The port identifier provides port aggregation priority. Ports are considered for active use in an aggregation starting with the port that has highest aggregation priority in the system, and working down through an ordered list of port identifiers. The use of this port aggregation priority makes aggregation predictable and reproducible by selecting the links for aggregation in the same manner when all links are running LACP concurrently.
 
     [bookmark: pgfId-609601]In addition, you can configure the priority of each port to administratively control the set of stand-by ports. For example, the port with the lowest priority will be considered last for group aggregation and will be become a stand-by port (assuming enough members are assigned to the group to allow stand-by ports).
 
     [bookmark: pgfId-609603]Related Topics
 
      
      	 [bookmark: pgfId-609608]Configuring EtherChannels
 
     
 
     [bookmark: pgfId-609610]Editing LACP Port Parameters for an Existing EtherChannel Interface
 
     [bookmark: pgfId-609612]Follow these steps to edit an existing EtherChannel-assigned interface:
 
     
 
     [bookmark: pgfId-609617]Step 1 In the table on the device’s Interfaces page, select an interface that is a Member of a Port-channel group. (See Managing Device Interfaces, Hardware Ports, and Bridge Groups for information about accessing and using this table.)
 
     [bookmark: pgfId-609619]Step 2 Click Edit Row to open the Edit Interface dialog box for that interface.
 
     [bookmark: pgfId-609621]Only the Enable Interface check box, the LACP Port parameters, and the Description field can be altered.
 
     [bookmark: pgfId-609623]Step 3 Edit the LACP Port parameters as necessary:
 
      
      	 [bookmark: pgfId-609625] Priority – This number is combined with the port number assigned to the interface to produce a unique port identification number. This value can be 1 to 65535, with higher numbers signifying lower priorities. The default is 32768. This parameter applies only when the port is in Active or Passive mode.
 
      	 [bookmark: pgfId-609627] Mode – Choose one of these LACP modes:
 
     
 
     [bookmark: pgfId-609629] – Active – In Active mode, a port initiates LACP exchanges with the partner device and periodically sends updates to the partner. Active LACP reflects the port’s preference to participate in the protocol regardless of the partner’s control mode.
 
     [bookmark: pgfId-609631] – Passive – A Passive-mode port does not initiate LACP exchanges, but upon receiving a request from the partner, the port will start exchanging LACP information with the partner. Passive mode is useful when it is not clear if the remote port supports LACP.
 
     [bookmark: pgfId-609633]Some devices may show undesired behavior when they do not have LACP enabled and they receive periodic LACP updates. However, for channeling to operate correctly, at least one port must be configured in Active mode.
 
     [bookmark: pgfId-609635] – On – Use this mode to configure a static port-channel in which all member interfaces are “on,” with no stand-by ports. No negotiation takes place and most restrictions associated with the other two modes do not apply; for example, the speed and duplex settings do not have to be the same for all member ports, and all member ports remain Active. Note that the remote ports also must be On. An “on” EtherChannel can only establish a connection with another “on” EtherChannel.
 
      
      	 [bookmark: pgfId-609637] VSS or vPC Switch ID – Identifies the Virtual Switching System (VSS) or Virtual Port Channel (vPC) switch ID to which the interface is connected.
 
     
 
     [bookmark: pgfId-609642]Step 4 Continue editing this interface, as described in Add/Edit Interface Dialog Box (PIX 7.0+/ASA/FWSM).
 
     [bookmark: pgfId-609644]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-609656][bookmark: 106242][bookmark: pxchap_cncpt_AboutEtherChannelLoadBalancing]About EtherChannel Load Balancing[bookmark: marker-609650][bookmark: marker-609652][bookmark: marker-609654]
 
     [bookmark: pgfId-609658]Traffic in an EtherChannel is distributed across the individual bundled links in a deterministic fashion; however, the load is not necessarily balanced equally across all the links. Instead, frames are forwarded on a specific link as a result of a hashing algorithm. This algorithm uses a specific field or combination of fields in the packet header to produce a fixed Result Bundle Hash (RBH) value that indicates which link to use.
 
     [bookmark: pgfId-609663]The algorithm can use one or a combination of the following packet-header fields to determine link assignment: source IP address, destination IP address, source MAC address, destination MAC address, TCP/UDP port numbers, or VLAN IDs. The field combination used by the algorithm is chosen from the Load Balancing list (on the Advanced tab of the ASA’s Add Interface and Edit Interface dialog boxes); these options are described in the following section. For additional information, see Configuring EtherChannels.
 
     [bookmark: pgfId-609665]For example, suppose source MAC address (src-mac) is the chosen field: when packets are forwarded to an EtherChannel, they are distributed across the ports in the channel based on the source MAC address of each incoming packet. Therefore, to provide load balancing, packets from different hosts use different ports in the channel, but packets from the same host use the same port in the channel (and the MAC addresses learned by the device do not change).
 
     [bookmark: pgfId-609667]Similarly, with destination MAC address forwarding, when packets are forwarded to an EtherChannel, each packet is distributed across the ports in the channel based on the packet’s destination host MAC address. Thus, packets to the same destination are forwarded over the same port, and packets to a different destination are sent on a different port in the channel.
 
     [bookmark: pgfId-609669]Therefore, when choosing a load-balancing option, use the option that provides the greatest variety in your configuration. For example, if most of the traffic on a channel is going only to a single MAC address, choosing the destination MAC address results in most of the traffic always using the same link in the channel. Alternatively, using source addresses or IP addresses might result in better load balancing, while a method that uses the source and destination addresses along with UDP or TCP port numbers can distribute traffic much differently.
 
      
       
     
 
     
 
     [bookmark: pgfId-609671]Note This option is available only on ASA 8.4.1+ devices.

     
      

     

     
 
     [bookmark: pgfId-609673]Load Balancing Options
 
     [bookmark: pgfId-609678]When defining a single logical EtherChannel interface in the ASA Add/Edit Interface dialog box, choose one of the following Load Balancing options (on the Add/Edit Interface Dialog Box: Advanced Tab (ASA/PIX 7.0+)) to specify the basis of load distribution:
 
      
      	 [bookmark: pgfId-609680] dst-ip – Load distribution is based on the destination-host IP address only; the source of the packets is not considered. Each packet with the same destination IP address is forwarded over the same link.
 
      	 [bookmark: pgfId-609682] dst-ip-port – Load distribution is based on the destination-host IP address and TCP/ UDP port. This option offers more granularity and a little more complexity than destination IP address alone.
 
      	 [bookmark: pgfId-609684] dst-mac – Load distribution is based on the destination host MAC address of incoming packets.
 
      	 [bookmark: pgfId-609686] dst-port – Distribution is based on the destination port; that is, a TCP or UDP port and not a physical interface.
 
      	 [bookmark: pgfId-609688] src-dst-ip – Distribution is based on source and destination IP addresses—source and destination IP addresses are paired for hash calculations. This method provides more granularity than destination IP address, for example: packets to the same destination can be forwarded over different links in a port-channel if they are coming from a different IP source.
 
      	 [bookmark: pgfId-609690] src-dst-ip-port – Distribution calculation considers source and destination IP addresses, and TCP/ UDP ports. Provides even greater granularity and distribution.
 
      	 [bookmark: pgfId-609692] src-dst-mac – Calculation is based on source and destination MAC address pairing.
 
      	 [bookmark: pgfId-609694] src-dst-port – Load distribution is based on source and destination TCP/UDP port.
 
      	 [bookmark: pgfId-609696] src-ip – Based on source host IP address only.
 
      	 [bookmark: pgfId-609698] src-ip-port – Source IP address and TCP/UDP port.
 
      	 [bookmark: pgfId-609700] src-mac – Source MAC address only.
 
      	 [bookmark: pgfId-609702] src-port – Source TCP/UDP port only.
 
      	 [bookmark: pgfId-609704] vlan-dst-ip – Destination IP address and VLAN ID pairing.
 
      	 [bookmark: pgfId-609706] vlan-dst-ip-port – Combination of destination IP address, TCP/UDP port, and VLAN ID.
 
      	 [bookmark: pgfId-609708] vlan-only – VLAN ID only.
 
      	 [bookmark: pgfId-609710] vlan-src-dst-ip – Source and destination IP address, and VLAN ID.
 
      	 [bookmark: pgfId-609712] vlan-src-dst-ip-port – Source and destination IP address, TCP/UDP port, and VLAN ID.
 
      	 [bookmark: pgfId-609714] vlan-src-ip – Source IP address and VLAN ID.
 
      	 [bookmark: pgfId-609716] vlan-src-ip-port – Source IP address, TCP/UDP port, and VLAN ID.
 
     
 
    
 
     
      [bookmark: pgfId-609730][bookmark: 106330][bookmark: pxchap_cncpt_VNI_Interfaces]Configuring VNI Interfaces[bookmark: marker-609724][bookmark: marker-609726][bookmark: marker-609728]
 
     [bookmark: pgfId-609732]VNI interfaces are similar to VLAN interfaces: they are virtual interfaces that keep network traffic separated on a given physical interface by using tagging. You apply your security policy directly to each VNI interface. All VNI interfaces are associated with the same VTEP interface.
 
     [bookmark: pgfId-609737]To configure VXLAN, you must first Configuring VXLAN Policy and then create a VNI interface and associate the configured VXLAN policy to the VNI interface.
 
     [bookmark: pgfId-609739]When VNI Interface is the chosen Type in the Add Interface or Edit Interface dialog box, the dialog box presents three tabbed panels of options: General, Advanced and IPv6.The following sections describe how to configure VNI interfaces using the three tabbed panels:
 
      
      	 [bookmark: pgfId-609744]VXLAN
 
      	 [bookmark: pgfId-609749]VNI Interfaces—General Tab
 
      	 [bookmark: pgfId-609754]VNI Interfaces—Advanced Tab
 
      	 [bookmark: pgfId-609759]VNI Interfaces—IPv6 Tab
 
     
 
    
 
     
      [bookmark: pgfId-609767][bookmark: 106360][bookmark: pxchap_cncpt_VNI_Interfaces_General]VNI Interfaces—General Tab
 
     [bookmark: pgfId-609769]When VNI Interface is the chosen Type in the Add Interface or Edit Interface dialog box, the dialog box presents three tabbed panels of options: General, Advanced and IPv6. The options provided by the General panel are described in this section.
 
     [bookmark: pgfId-609771]Navigation Path
 
     [bookmark: pgfId-609776]You can access the General panel in the Add Interface and Edit Interface dialog boxes, which are accessed from the ASA Interfaces page, as described in Managing Device Interfaces, Hardware Ports, and Bridge Groups.
 
     [bookmark: pgfId-609778]Related Topics
 
      
      	 [bookmark: pgfId-609783]Configuring VNI Interfaces
 
      	 [bookmark: pgfId-609788]VNI Interfaces—Advanced Tab
 
      	 [bookmark: pgfId-609793]VNI Interfaces—IPv6 Tab
 
     
 
     [bookmark: pgfId-609795]Field Reference
 
     [bookmark: pgfId-609798]
 
      
       
        
        [bookmark: pgfId-606442]Table 46-2 [bookmark: 106384]General tab: Add/Edit Interface Dialog Box (ASA) 
 
        
       
         
         	
           
           [bookmark: pgfId-606448]Element
          
  
         	
           
           [bookmark: pgfId-606450]Description
          
  
        
 
         
         	[bookmark: pgfId-606456]Enable Interface
  
         	[bookmark: pgfId-606458]Check this box to enable the VNI interface if not already enabled.
  
        
 
         
         	[bookmark: pgfId-606464]Name
  
         	[bookmark: pgfId-606466]Enter the Interface Name. The name is a text string up to 48 characters, and is not case-sensitive. You can change the name by reentering this command with a new value.
  
        
 
         
         	[bookmark: pgfId-606472]Security Level
  
         	[bookmark: pgfId-606474]Enter the Security Level, between 0 (lowest) and 100 (highest).
  
        
 
         
         	 
           
           [bookmark: pgfId-606480]VXLAN
          
  
        
 
         
         	[bookmark: pgfId-606488]VNI ID
  
         	[bookmark: pgfId-606490]Enter the VNI ID, between 1 and 10000. This ID is just an internal interface identifier.
  
        
 
         
         	[bookmark: pgfId-606496]VNI Segment ID
  
         	[bookmark: pgfId-606498]Enter the VNI Segment ID, between 1 and 16777215. The segment ID is used for VXLAN tagging.
  
        
 
         
         	[bookmark: pgfId-606504]Multicast Group IP Address
  
         	[bookmark: pgfId-606506](Single Mode) Enter the Multicast Group IP Address.
 [bookmark: pgfId-606508]If you do not set the multicast group for the VNI interface, the default group from the VTEP source interface configuration is used, if available. If you manually set a VTEP peer IP for the VTEP source interface, you cannot specify a multicast group for the VNI interface. Multicast is not supported in multiple context mode.
  
        
 
         
         	[bookmark: pgfId-606514]NVE Mapped to VTEP Interface
  
         	[bookmark: pgfId-606516]Check the NVE Mapped to VTEP Interface check box. This setting associates the VNI interface with the VTEP source interface.
  
        
 
         
         	[bookmark: pgfId-606522]IP Type
  
         	[bookmark: pgfId-606524]Select the IP Type from the available options.
  
        
 
         
         	[bookmark: pgfId-606530]Static IP
  
         	[bookmark: pgfId-606532]IP Address—(Routed Mode) In the IP Address area, configure an IPv4 address. To configure IPv6, click the IPv6 tab.
 [bookmark: pgfId-606534]Subnet Mask—Specify the Subnet Mask.
  
        
 
         
         	[bookmark: pgfId-606540]Use DHCP
  
         	[bookmark: pgfId-606542]DHCP Learned Route Metric—(Required)To assign an administrative distance to the learned route, enter a value between 1 and 255 in the DHCP Learned Route Metric field. If this field is left blank, the administrative distance for the learned routes is 1.
 [bookmark: pgfId-606544]Obtain Default Route using DHCP—(Optional) Select this option to obtain a default route from the DHCP server so that you do not need to configure a default static route.
 [bookmark: pgfId-606546]Enable Tracking for DHCP Learned Route—(Optional) If Obtain Default Route using DHCP is selected, you can select this option to enable route tracking via a specific Service Level Agreement (SLA) monitor. The following option becomes available:
 [bookmark: pgfId-606548]Tracked SLA Monitor—Required if Enable Tracking for DHCP Learned Route is selected. Enter or Select the name of the SLA monitor object that defines the route tracking (connectivity monitoring) to be applied to this interface.
  
        
 
         
         	[bookmark: pgfId-606554]Description
  
         	[bookmark: pgfId-606556](Optional) Specify a description for the interface.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-609806][bookmark: 106460][bookmark: pxchap_cncpt_VNI_Interfaces_Advanced]VNI Interfaces—Advanced Tab
 
     [bookmark: pgfId-609808]When VNI Interface is the chosen Type in the Add Interface or Edit Interface dialog box, the dialog box presents three tabbed panels of options: General, Advanced and IPv6. The options provided by the Advanced panel are described in this section.
 
     [bookmark: pgfId-609810]Navigation Path
 
     [bookmark: pgfId-609815]You can access the Advanced tab in the Add Interface and Edit Interface dialog boxes, which are accessed from the ASA Interfaces page, as described in Managing Device Interfaces, Hardware Ports, and Bridge Groups.
 
     [bookmark: pgfId-609817]Related Topics
 
      
      	 [bookmark: pgfId-609822]Configuring VNI Interfaces
 
      	 [bookmark: pgfId-609827]VNI Interfaces—General Tab
 
      	 [bookmark: pgfId-609832]VNI Interfaces—IPv6 Tab
 
     
 
     [bookmark: pgfId-609834]Field Reference
 
     [bookmark: pgfId-609837]
 
      
       
        
        [bookmark: pgfId-606569]Table 46-3 [bookmark: 106484]Advanced tab: Add/Edit Interface Dialog Box (ASA) 
 
        
       
         
         	
           
           [bookmark: pgfId-606575]Element
          
  
         	
           
           [bookmark: pgfId-606577]Description
          
  
        
 
         
         	[bookmark: pgfId-606583]Active MAC Address
  
         	[bookmark: pgfId-606585]Use the Active MAC Address field to manually assign a private MAC address to the interface
  
        
 
         
         	[bookmark: pgfId-606591]Standby MAC Address
  
         	[bookmark: pgfId-606593]The Standby MAC Address field can be used to set a standby MAC address for use with device-level failover.
  
        
 
         
         	[bookmark: pgfId-606599]Roles
  
         	[bookmark: pgfId-606601]All interface roles assigned to this interface are listed in this field. Role assignments are based on pattern matching between the Name given to this interface and all currently defined Interface Role objects in Cisco Security Manager. Interface role objects are replaced with the actual interface IP addresses when the configuration is generated for each device. They allow you to define generic rules—ones that can apply to multiple interfaces.
  
        
 
         
         	[bookmark: pgfId-606607]DHCP Relay Servers
  
         	[bookmark: pgfId-606609]Enter the IP address or select a Networks/Hosts object representing the interface-specific DHCP server to which DHCP requests on this interface are relayed. Use a comma to separate multiple values. You can configure a maximum of 4 interface-specific DHCP relay servers and a maximum of 10 global and interface-specific DHCP relay servers combined.
  
        
 
         
         	[bookmark: pgfId-606615]DHCP Relay Trust Info (Option 82)
  
         	[bookmark: pgfId-606617]Specifies that you want to trust this DHCP client interface. You can configure interfaces as trusted interfaces to preserve DHCP Option 82.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-609845][bookmark: 106520][bookmark: pxchap_cncpt_VNI_Interfaces_IPv6]VNI Interfaces—IPv6 Tab
 
     [bookmark: pgfId-609847]When VNI Interface is the chosen Type in the Add Interface or Edit Interface dialog box, the dialog box presents three tabbed panels of options: General, Advanced and IPv6. The options provided by the IPv6 panel are described in this section.
 
     [bookmark: pgfId-609849]Navigation Path
 
     [bookmark: pgfId-609854]You can access the IPv6 panel in the Add Interface and Edit Interface dialog boxes, which are accessed from the ASA Interfaces page, as described in Managing Device Interfaces, Hardware Ports, and Bridge Groups.
 
     [bookmark: pgfId-609856]Related Topics
 
      
      	 [bookmark: pgfId-609861]Configuring VNI Interfaces
 
      	 [bookmark: pgfId-609866]VNI Interfaces—General Tab
 
      	 [bookmark: pgfId-609871]VNI Interfaces—IPv6 Tab
 
     
 
     [bookmark: pgfId-609873]Field Reference
 
     [bookmark: pgfId-609876]
 
      
       
        
        [bookmark: pgfId-606630]Table 46-4 [bookmark: 106544]IPv6 tab: Add/Edit Interface Dialog Box (ASA) 
 
        
       
         
         	
           
           [bookmark: pgfId-606636]Element
          
  
         	
           
           [bookmark: pgfId-606638]Description
          
  
        
 
         
         	[bookmark: pgfId-606644]Enable IPv6
  
         	[bookmark: pgfId-606646]Check this box to enable IPv6 and configure IPv6 addresses on this interface. You can deselect this option to disable IPv6 on the interface, but retain the configuration information.
  
        
 
         
         	[bookmark: pgfId-606652]Enforce EUI-64
  
         	[bookmark: pgfId-606654]When selected, use of Modified EUI-64 format interface identifiers in IPv6 addresses on a local link is enforced.
 [bookmark: pgfId-606656]When this option is enabled on an interface, the source addresses of IPv6 packets received on the interface are verified against the source MAC addresses to ensure that the interface identifiers use the Modified EUI-64 format. If the interface identifier in an IPv6 packet is not in the Modified EUI-64 format, the packet is dropped and the following system log message is generated:
 [bookmark: pgfId-606658]%PIX|ASA-3-325003: EUI-64 source address check failed.
 [bookmark: pgfId-606660]Address format verification is performed only when a flow is created. Packets from an existing flow are not checked. Additionally, address verification can be performed only for hosts on the local link. Packets received from hosts behind a router will fail the address format verification, and be dropped, because their source MAC address will be the router MAC address and not the host MAC address.
 [bookmark: pgfId-606662]The Modified EUI-64 format interface identifier is derived from the 48-bit link-layer (MAC) address by inserting the hex number FFFE between the upper three bytes (OUI field) and the lower 3 bytes (serial number) of the link-layer address. To ensure the chosen address is from a unique Ethernet MAC address, the next-to-lowest order bit in the high-order byte is inverted (universal/local bit) to indicate the uniqueness of the 48-bit address. For example, an interface with a MAC address of 00E0.B601.3B7A would have a 64-bit interface ID of 02E0:B6FF:FE01:3B7A.
  
        
 
         
         	[bookmark: pgfId-606668]DAD Attempts
  
         	[bookmark: pgfId-606670]To specify the number of consecutive neighbor solicitation messages that are sent on an interface during duplicate address detection (DAD), enter a number from 0 to 600 in this field. Entering 0 disables duplicate address detection on the interface. Entering 1 configures a single transmission without follow-up transmissions; this is the default.
 [bookmark: pgfId-606672]Duplicate address detection verifies the uniqueness of new unicast IPv6 addresses before the addresses are assigned to interfaces (the new addresses remain in a tentative state while duplicate address detection is performed). Duplicate address detection uses neighbor solicitation messages to verify the uniqueness of unicast IPv6 addresses.
 [bookmark: pgfId-606674]When duplicate address detection identifies a duplicate address, the state of the address is set to DUPLICATE and the address is not used. If the duplicate address is the link-local address of the interface, the processing of IPv6 packets is disabled on the interface and an error message similar to the following is issued:
 [bookmark: pgfId-606676]%PIX-4-DUPLICATE: Duplicate address FE80::1 on outside
 [bookmark: pgfId-606678]If the duplicate address is a global address of the interface, the address is not used and an error message is issued, similar to that shown previously for a duplicate link-local address.
 [bookmark: pgfId-606680]All configuration commands associated with the duplicate address remain as-configured while the state of the address is set to DUPLICATE. If the link-local address for an interface changes, duplicate address detection is performed on the new link-local address, and all other IPv6 address associated with the interface are regenerated (that is, duplicate address detection is performed only on the new link-local address).
  
        
 
         
         	[bookmark: pgfId-606686]NS Interval
  
         	[bookmark: pgfId-606688]The interval between IPv6 neighbor solicitation retransmissions, in milliseconds. Valid values range from 1000 to 3600000 milliseconds; the default value is 1000 milliseconds.
 [bookmark: pgfId-606690]Note This value is included in all IPv6 router advertisements sent out on this interface.
  
        
 
         
         	[bookmark: pgfId-606696]Reachable Time
  
         	[bookmark: pgfId-606698]The amount of time, in milliseconds, within which a remote IPv6 node is considered still reachable, after initial reachability was confirmed. Valid values range from 0 to 3600000 milliseconds, the default value is 0. When 0 is used for the value, the reachable time is set as undetermined—it is up to the receiving devices to set and track reachable time.
 [bookmark: pgfId-606700]A configured time enables detection of unavailable neighbors. A shorter time allows detecting unavailable neighbors more quickly; however, shorter times consume more IPv6 network bandwidth and processing resources in all IPv6 network devices. Very short configured times are not recommended in normal IPv6 operation.
  
        
 
         
         	[bookmark: pgfId-606706]Managed Config Flag
  
         	[bookmark: pgfId-606708]Whether or not to set the flag "managed-config-flag" in the IPv6 router advertisement packet.
  
        
 
         
         	[bookmark: pgfId-606714]Other Config Flag
  
         	[bookmark: pgfId-606716]Whether or not to set the flag "other-config-flag" in the IPv6 router advertisement packet.
  
        
 
         
         	[bookmark: pgfId-606722]Enable RA
  
         	[bookmark: pgfId-606724]When checked, IPv6 router advertisement transmissions are enabled on the interface. The following options are enabled:
 
           
           	 [bookmark: pgfId-606726] RA Lifetime – The “router lifetime” value specifies how long nodes on the local link should consider the security appliance as the default router on the link. Valid values range from 0 to 9000 seconds; the default is 1800 seconds. Entering 0 indicates that the security appliance should not be considered a default router on the selected interface.
 
          
 [bookmark: pgfId-606728]Any non-zero value should not be less than the following RA Interval value.
 [bookmark: pgfId-606730]Note This value is included in all IPv6 router advertisements sent out on this interface.
 
           
           	 [bookmark: pgfId-606732] RA Interval – The interval between IPv6 router advertisement transmissions on this interface. Valid values range from 3 to 1800 seconds, (or from 500 to 1800000 milliseconds if the following RA Interval in Milliseconds option is checked); the default is 200 seconds.
 
          
 [bookmark: pgfId-606734]The interval between transmissions should be less than or equal to the RA Lifetime value if it is non-zero. To prevent synchronization with other IPv6 nodes, randomly adjust the actual value used to within 20 percent of the desired value.
 
           
           	 [bookmark: pgfId-606736] RA Interval in Milliseconds – Checking this option indicates that the provided RA Interval value is in milliseconds, rather than seconds.
 
          
  
        
 
         
         	[bookmark: pgfId-606742]Interface IPv6 Addresses
  
         	[bookmark: pgfId-606744]The IPv6 addresses assigned to the interface are specified in this section of the dialog box.
 
           
           	 [bookmark: pgfId-606746] Link-Local Address – To override the link-local address that is automatically generated for the interface, enter the desired IPv6 link-local address in this field.
 
          
 [bookmark: pgfId-606748]The link-local address is composed of the link-local prefix FE80::/64 and the interface ID in Modified EUI-64 format. For example, an interface with a MAC address of 00E0.B601.3B7A would have a link-local address of FE80::2E0:B6FF:FE01:3B7A. An error will occur if another host is using the specified address.
 
           
           	 [bookmark: pgfId-606750] Enable Address Auto-Configuration – Select this option to enable automatic configuration of IPv6 addresses on the interface using stateless autoconfiguration. The addresses are configured based on the prefixes received in Router Advertisement (RA) messages. If a link-local address has not been configured, then one is automatically generated for this interface. An error occurs if another host is already using the generated link-local address.
 
           	 [bookmark: pgfId-606755]The table in this section displays the IPv6 addresses assigned to this interface. Use the Add Row, Edit Row, and Delete Row buttons below this table to manage these entries. (These are standard buttons, as described in Using Tables.)
 
          
 [bookmark: pgfId-606760]Add Row and Edit Row open the IPv6 Address for Interface Dialog Box.
  
        
 
         
         	[bookmark: pgfId-606766]Interface IPv6 Prefixes
  
         	[bookmark: pgfId-606771]Use the table in this section to configure which IPv6 prefixes (that is, the network portion of the IPv6 addresses) are included in IPv6 router advertisements. Use the Add Row, Edit Row, and Delete Row buttons below this table to manage these entries. (These are standard buttons, as described in Using Tables.)
 [bookmark: pgfId-606776]Add Row and Edit Row open the IPv6 Prefix Editor Dialog Box.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-609898][bookmark: 106649][bookmark: pxchap_proc_Interfaces_Managing]Managing Device Interfaces, Hardware Ports, and Bridge Groups [bookmark: marker-609890][bookmark: marker-609892][bookmark: marker-609894][bookmark: marker-609896]
 
     [bookmark: pgfId-609900]The Interfaces page displays the interfaces, subinterfaces, redundant interfaces, virtual interfaces (VLANs), and EtherChannel interfaces, as well as the hardware ports and bridge groups, configured on the selected device, and lets you add, edit and delete them.
 
     [bookmark: pgfId-609905]The types of interface available depend on device type, operating system version, and mode (routed or transparent). For example, EtherChannel interfaces are available only on ASA 8.4.1 and later devices, in both routed and transparent mode. See Understanding Device Interfaces for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-609907]Note The Interfaces page displayed for ASA 5505 devices presents two tabbed panels: Interfaces and Hardware Ports. Similarly, the Interfaces page displayed for both Firewall Services Modules (FWSMs), version 3.1 and later, and ASAs version 8.4.1 and later, operating in transparent mode also present two tabbed panels: Interfaces and Bridge Groups. Links to configuration information for these features are included in the following procedure.

     
      

     

     
 
     [bookmark: pgfId-609909]Each security device must be configured, and each active interface must be enabled. Inactive interfaces can be disabled. When disabled, the interface does not transmit or receive data, but its configuration information is retained.
 
     [bookmark: pgfId-609911]If you bootstrapped a new security device, the set-up feature configures only the addresses and names associated with the inside interface. You must define the remaining interfaces on that device before you can specify access and translation rules for traffic traversing that security device.
 
     [bookmark: pgfId-609913]Transparent firewall mode allows only two interfaces to pass traffic; however, if your platform includes a dedicated management interface, you can use it (either the physical interface or a subinterface) as a third interface for management traffic.
 
     [bookmark: pgfId-609915]Follow these general steps to manage security-device interfaces and related options. You can add, edit and delete configured interfaces, subinterfaces, redundant interfaces, virtual interfaces (VLANs), EtherChannel interfaces, hardware ports, and bridge groups, according to the type of device selected.
 
     
 
     [bookmark: pgfId-609917]Step 1 Ensure Device View is your present application view; if necessary, click the Device View button on the toolbar.
 
      
       
     
 
     
 
     [bookmark: pgfId-609922]Note For more information on using the Device View to configure device policies, see Managing Policies in Device View and the Site-to-Site VPN Manager).

     
      

     

     
 
     [bookmark: pgfId-609924]Step 2 Select the security device you want to configure.
 
     [bookmark: pgfId-609926]Step 3 Select Interfaces in the Device Policy selector.
 
     [bookmark: pgfId-609928]The Interfaces page is displayed. The information displayed, and the page itself, varies based on the selected device type and version, the operational mode (routed versus transparent), and whether the device hosts single or multiple contexts.
 
     [bookmark: pgfId-609930]Note that the Interfaces page for ASA 5505 devices presents two tabbed panels: Hardware Ports and Interfaces. Similarly, the Interfaces page displayed for both FWSMs (version 3.1 and later) and ASAs (version 8.4.1 and later), operating in transparent mode also presents two tabbed panels: Interfaces and Bridge Groups.
 
     [bookmark: pgfId-609932]Step 4 Add, edit and delete interfaces and related options, as necessary.
 
     [bookmark: pgfId-609937]The Interfaces pages/panels and the Bridge Groups and Hardware Ports panels present standard Security Manager tables, with Add Row, Edit Row and Delete Row buttons, which are described in Using Tables.
 
     [bookmark: pgfId-609939]The actual dialog box presented when you click the Add Row or Edit Row button depends on the type of device (and panel) you have selected. Refer to the following topics for device-specific dialog box information:
 
      
      	 [bookmark: pgfId-609944]Add/Edit Interface Dialog Box (PIX 6.3)
 
      	 [bookmark: pgfId-609949]Add/Edit Interface Dialog Box (PIX 7.0+/ASA/FWSM)
 
      	 [bookmark: pgfId-609954]Configuring Hardware Ports on an ASA 5505
 
      	 [bookmark: pgfId-609959]Add/Edit Bridge Group Dialog Box
 
     
 
     [bookmark: pgfId-609964]Step 5 To manage Advanced Interface settings, including enabling communication between interfaces with the same security level, click the Advanced button at the bottom of the Interfaces page to open the Advanced Interface Settings dialog box. See Advanced Interface Settings (PIX/ASA/FWSM) for more information.
 
     [bookmark: pgfId-609966]Step 6 When you are finished adding, editing and deleting interfaces, click Save at the bottom of the window to save your interface definitions to the Cisco Security Manager server.
 
     [bookmark: pgfId-609968]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-609980][bookmark: 106719][bookmark: pxpage_cncpt_AddEditInterfaceDialogBoxPIX]Add/Edit Interface Dialog Box (PIX 6.3)[bookmark: marker-609976][bookmark: marker-609978]
 
     [bookmark: pgfId-609983]
 
      
       
        
        [bookmark: pgfId-606789]Table 46-5 [bookmark: 106731]Add/Edit Interface Dialog Box (PIX 6.3) 
 
        
       
         
         	
           
           [bookmark: pgfId-606795]Element
          
  
         	
           
           [bookmark: pgfId-606797]Description
          
  
        
 
         
         	[bookmark: pgfId-606803]Enable Interface
  
         	[bookmark: pgfId-606805]Enables this interface to pass traffic. In addition to this setting, you must specify an IP Type and a Name before traffic can pass according to your security policy.
 [bookmark: pgfId-606807]You must enable a physical interface before traffic can pass through any enabled subinterfaces.
  
        
 
         
         	[bookmark: pgfId-606813]Type
  
         	[bookmark: pgfId-606815]Choose the type of interface:
 
           
           	 [bookmark: pgfId-606817] Physical – VLAN is on the same network as its underlying hardware interface.
 
           	 [bookmark: pgfId-606819] Logical – VLAN is associated with a logical interface.
 
          
  
        
 
         
         	[bookmark: pgfId-606825]Name
  
         	[bookmark: pgfId-606827]Provide an interface name up to 48 characters in length. The Name should be a memorable name for the interface that relates to its use. Supported interface names are:
 
           
           	 [bookmark: pgfId-606829]Inside—Connects to your internal network. Must be most secure interface.
 
           	 [bookmark: pgfId-606831]DMZ—Demilitarized zone (Intermediate interface). Also known as a perimeter network.
 
           	 [bookmark: pgfId-606833]Outside—Connects to an external network or the Internet. Must be least secure interface.
 
          
  
        
 
         
         	[bookmark: pgfId-606839]Hardware Port
  
         	[bookmark: pgfId-606841]When defining a physical network interface, this value represents the name identifies the interface type and its slot or port in the device.
 [bookmark: pgfId-606843]When you add a logical network interface, you can choose any enabled physical interface to which you want to add a logical interface. If you do not see the desired hardware port, verify that the interface is enabled.
 [bookmark: pgfId-606845]Valid values are:
 
           
           	 [bookmark: pgfId-606847]ethernet0 to ethernet n .
 
           	 [bookmark: pgfId-606849]gb-ethernet n .
 
          
 [bookmark: pgfId-606851]where n represents the number of network interfaces in the device.
  
        
 
         
         	[bookmark: pgfId-606857]IP Type
  
         	[bookmark: pgfId-606862]The IP Type defines the type of IP addressing used for the interface; choose Static IP or Use DHCP, as described in Device Interface: IP Type (PIX 6.3). (The PPPoE option is not applicable to PIX 6.3 devices.)
 [bookmark: pgfId-606864]Note You can configure DHCP only on the outside interface of a security appliance.
  
        
 
         
         	[bookmark: pgfId-606870]Speed and Duplex
  
         	[bookmark: pgfId-606872]Lists the speed options for a physical interface; not applicable to logical interfaces. Choose one of the following options:
 
           
           	 [bookmark: pgfId-606874]auto – Sets Ethernet speed automatically. The auto keyword can be used only with the Intel 10/100 automatic speed-sensing network interface card.
 
           	 [bookmark: pgfId-606876]10baset – 10-Mbps Ethernet half-duplex.
 
           	 [bookmark: pgfId-606878]10full – 10-Mbps Ethernet full-duplex.
 
           	 [bookmark: pgfId-606880]100basetx – 100-Mbps Ethernet half-duplex.
 
           	 [bookmark: pgfId-606882]100full – 100-Mbps Ethernet full-duplex.
 
           	 [bookmark: pgfId-606884]1000auto – 1000-Mbps Ethernet to auto-negotiate full- or half -duplex.
 
          
 [bookmark: pgfId-606886]Tip We recommend that you do not use this option to maintain compatibility with switches and other devices in your network. 
           
           	 [bookmark: pgfId-606888]1000full – Auto-negotiate, advertising 1000-Mbps Ethernet full-duplex.
 
           	 [bookmark: pgfId-606890]1000full nonnegotiate – 1000-Mbps Ethernet full-duplex.
 
           	 [bookmark: pgfId-606892]aui – 10-Mbps Ethernet half-duplex communication with an AUI cable interface.
 
           	 [bookmark: pgfId-606894]bnc – 10-Mbps Ethernet half-duplex communication with a BNC cable interface.
 
          
 [bookmark: pgfId-606896]Note We recommend that you specify the speed of the network interfaces in case your network environment includes switches or other devices that do not handle autosensing correctly.
  
        
 
         
         	[bookmark: pgfId-606902]MTU
  
         	[bookmark: pgfId-606904]Specify the maximum packet size in bytes; that is, the maximum transmission unit (MTU). The value depends on the type of network connected to the interface. Valid values are 300 to 65535 bytes. Default is 1500.
  
        
 
         
         	[bookmark: pgfId-606910]Physical VLAN ID
  
         	[bookmark: pgfId-606912]For a physical interface, enter the VLAN ID, between 1 and 4094. This VLAN ID must not be in use on connected devices.
  
        
 
         
         	[bookmark: pgfId-606918]Logical VLAN ID
  
         	[bookmark: pgfId-606920]Provide the alias, a value between 1 and 4094, for the VLAN associated with this logical interface. This value is required if the logical interface Type is selected.
  
        
 
         
         	[bookmark: pgfId-606926]Security Level
  
         	[bookmark: pgfId-606928]Specify the security level of the interface: enter a value between 0 (least secure) and 100 (most secure). The security appliance lets traffic flow freely from an inside network to an outside network (lower security level). Many other security features are affected by the relative security level of two interfaces.
 
           
           	 [bookmark: pgfId-606930]The  outside interface is always 0.
 
           	 [bookmark: pgfId-606932]The  inside interface is always 100.
 
           	 [bookmark: pgfId-606934]DMZ interfaces are between 1 and 99.
 
          
  
        
 
         
         	[bookmark: pgfId-606940]Roles
  
         	[bookmark: pgfId-606945]For more information on roles and how to define and use them, see Understanding Interface Role Objects.
 [bookmark: pgfId-606947]All interface roles assigned to this interface are listed in this field. Role assignments are based on pattern matching between the Name given to this interface and all currently defined Interface Role objects in Cisco Security Manager.
 [bookmark: pgfId-606949]Interface role objects are replaced with the actual interface IP addresses when the configuration is generated for each device. They allow you to define generic rules—ones that can apply to multiple interfaces.
 [bookmark: pgfId-606954]For more information on roles and how to define and use them, see Understanding Interface Role Objects.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-609995][bookmark: 106863][bookmark: pxchap_proc_Interfaces_IPType_PIX63]Device Interface: IP Type (PIX 6.3)[bookmark: marker-609989][bookmark: marker-609991][bookmark: marker-609993]
 
     [bookmark: pgfId-609997]A PIX 6.3 security device requires IP addressing for its interfaces; however, firewall interfaces do not have IP addresses until you assign them.
 
     [bookmark: pgfId-610002]The Add/Edit Interface dialog box presented for a PIX 6.3 security device includes the section IP Type, where you specify the type of IP addressing for the interface and provide related parameters, as described here. See Add/Edit Interface Dialog Box (PIX 6.3) for information about the other sections of the dialog box.
 
      
       
     
 
     
 
     [bookmark: pgfId-610007]Note The IP Type options presented for other security appliances are described in Device Interface: IP Type (PIX/ASA 7.0+).

     
      

     

     
 
     
 
     [bookmark: pgfId-610009]Step 1 In the Add/Edit Interface dialog box, choose a method for address assignment from the IP Type list, and then provide related parameters, as follows:
 
      
      	 [bookmark: pgfId-610011] Static IP – Provide a static  IP Address and  Subnet Mask that represents the security device on this interface’s connected network. The IP address must be unique for each interface.
 
     
 
     [bookmark: pgfId-610013]The Subnet mask can be expressed in dotted decimal format (for example, 255.255.255.0), or by entering the number of bits in the network mask (for example, 24). Do not use 255.255.255.254 or 255.255.255.255 for an interface connected to the network because this will stop traffic on that interface. If you omit the Subnet Mask value, a “classful” network is assumed, as follows:
 
     [bookmark: pgfId-610015] – The Class A netmask (255.0.0.0) is assumed if the first octet of the IP Address is 1 through 126 (i.e., addresses 1.0.0.0 through 126.255.255.255).
 
     [bookmark: pgfId-610017] – The Class B netmask (255.255.0.0) is assumed if the first octet of the IP Address is 128 through 191 (i.e., addresses 128.0.0.0 through 191.255.255.255).
 
     [bookmark: pgfId-610019] – The Class C netmask (255.255.255.0) is assumed if the first octet of the IP Address is 192 through 223 (i.e., addresses 192.0.0.0 through 223.255.255.255).
 
      
       
     
 
     
 
     [bookmark: pgfId-610021]Note Do not use addresses previously used for routers, hosts, or any other firewall device commands, such as an IP address in the global pool or a static NAT entry.

     
      

     

     
 
      
      	 [bookmark: pgfId-610023] Use DHCP – Enables Dynamic Host Configuration Protocol (DHCP) for automatic assignment of an IP address from a DHCP server on the connected network. The following options become available:
 
     
 
     [bookmark: pgfId-610025] – Obtain Default Route using DHCP – Check this box to obtain a default route from the DHCP server so that you do not need to configure a default static route.
 
     [bookmark: pgfId-610027] – Retry Count – The number of times the PIX will resend the DHCP request. Valid values are 4 to 16; the default is 2
 
      
      	 [bookmark: pgfId-610029] PPPoE (PIX and ASA 7.2+) – This option does not apply to PIX 6.3 devices.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-610031]Note You can configure DHCP only on the outside interface of a firewall device.

     
      

     

     
 
     [bookmark: pgfId-610033]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-610057][bookmark: 106920][bookmark: pxpage_cncpt_AddEditInterfaceDialogBoxPIXASA]Add/Edit Interface Dialog Box (PIX 7.0+/ASA/FWSM)[bookmark: marker-610049][bookmark: marker-610051][bookmark: marker-610053][bookmark: marker-610055]
 
     [bookmark: pgfId-610062]These Add Interface and Edit Interface dialog boxes are used to define and configure interfaces, subinterfaces, redundant, and EtherChannel interfaces on PIX 7.0+, ASA, and FWSM devices. You can access the Add/Edit Interface dialog boxes from the Interfaces page. See Managing Device Interfaces, Hardware Ports, and Bridge Groups for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-610070]Note The ASA 5505, combining switch and security appliance features, is a special case in that you configure both physical switch ports and logical VLAN interfaces. Thus, the Interfaces page displayed for ASA 5505 devices presents two tabbed panels: Hardware Ports and Interfaces. See Understanding ASA 5505 Ports and Interfaces for more information.

ASA 8.4.1+ and FWSM 3.1+ devices operating in transparent mode also present two tabbed panels: Interfaces and Bridge Groups. See Add/Edit Bridge Group Dialog Box for information about configuring bridge groups.

     
      

     

     
 
     [bookmark: pgfId-610072]Many of the parameters presented in these dialog boxes vary according to device type and version, operational mode (routed versus transparent), and whether the device hosts a single or multiple contexts.
 
      
       
     
 
     
 
     [bookmark: pgfId-610077]Note If you intend to use an interface for failover, you can define that interface in the Add Interface dialog box but do not configure it; instead, use the Failover page (see Chapter 50, “Configuring Failover”). In particular, do not specify an interface Name, as this parameter disqualifies the interface from being used as the failover link.

     
      

     

     
 
     [bookmark: pgfId-610079]Using the Add Interface and Edit Interface Dialog Boxes
 
     [bookmark: pgfId-610081]The following steps outline the general use of these dialog boxes:
 
     [bookmark: pgfId-610083] 1. An interface Type drop-down list appears at the top of the Add Interface and Edit Interface dialog boxes.
 
      
       
     
 
     
 
     [bookmark: pgfId-610085]Note Catalyst 6500 services modules (ASA-SMs and FWSMs) and the ASA 5505 do not present the Type list.

     
      

     

     
 
     [bookmark: pgfId-610087]Depending on device type, operating-system version and operating mode (router or transparent), the Type options presented will be two, three or all of the following:
 
     [bookmark: pgfId-610089] – Physical Interface – Choose this option to configure a physical interface on the device.
 
     [bookmark: pgfId-610094] – Sub-Interface – Choose this option to configure a logical interface (or VLAN connection) associated with a previously defined physical interface. Refer to Configuring Subinterfaces (PIX/ASA) for more information.
 
     [bookmark: pgfId-610099] – Redundant – Choose this option to configure two physical interfaces as a single logical “redundant interface.” Refer to Configuring Redundant Interfaces for more information.
 
     [bookmark: pgfId-610104] – EtherChannel – Choose this option to configure a logical interface consisting of a bundle of up to eight individual Ethernet links; this bundle is known as an EtherChannel, or a port-channel interface. (This option is available only on ASA 8.4+ devices.) Refer to Configuring EtherChannels, for more information.
 
     [bookmark: pgfId-610106] 2. Below the Type option, the dialog boxes present up to three tabbed panels. Again, this depends on device type, operating-system version and operating mode.
 
     [bookmark: pgfId-610108]The PIX 7.0+ Add Interface and Edit Interface dialog boxes present two tabbed panels: General and Advanced. The ASA 7.0+ Add Interface and Edit Interface dialog boxes present three tabbed panels: General, Advanced and IPv6.
 
     [bookmark: pgfId-610113] – Configure the General options, as appropriate. This panel is described in Add/Edit Interface Dialog Box: General Tab (PIX 7.0+/ASA/FWSM).
 
     [bookmark: pgfId-610118] – Configure the Advanced-panel options, as appropriate. This panel is described in Add/Edit Interface Dialog Box: Advanced Tab (ASA/PIX 7.0+).
 
     [bookmark: pgfId-610123] – Configure the IPv6 options, as appropriate. This panel is described in Configuring IPv6 Interfaces (ASA/FWSM).
 
     [bookmark: pgfId-610125] 3. When you have finished configuring this interface, click OK to close the dialog box and return to the device Interfaces page.
 
    
 
     
      [bookmark: pgfId-610139][bookmark: 106997][bookmark: pxpage_cncpt_AddEditInterfacePIXASA_GeneralTab]Add/Edit Interface Dialog Box: General Tab (PIX 7.0+/ASA/FWSM) [bookmark: marker-610131][bookmark: marker-610133][bookmark: marker-610135][bookmark: marker-610137]
 
     [bookmark: pgfId-610147]The Add/Edit Interface Dialog Box (PIX 7.0+/ASA/FWSM), is used to define and configure interfaces, subinterfaces, VLAN interfaces, and redundant, and EtherChannel interfaces on firewall devices. You can access the Add/Edit Interface dialog box from the Interfaces page. See Managing Device Interfaces, Hardware Ports, and Bridge Groups for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-610149]Note In the following descriptions, the term “interface” may be used generically to refer to any of these types of interface.

     
      

     

     
 
     [bookmark: pgfId-610151]The General panel of this dialog box is used to configure general interface settings, including Name, Security Level and IP Type parameters. Note that many of the parameters presented in this panel vary according to device type and version, operational mode (routed versus transparent), and whether the device hosts a single or multiple contexts. Thus, some of the options in the following table may not appear for the device you are configuring.
 
     [bookmark: pgfId-610153]Related Topics
 
      
      	 [bookmark: pgfId-610158]Configuring Subinterfaces (PIX/ASA)
 
      	 [bookmark: pgfId-610163]Configuring Redundant Interfaces
 
      	 [bookmark: pgfId-610168]Configuring EtherChannels
 
      	 [bookmark: pgfId-610173]Add/Edit Interface Dialog Box: Advanced Tab (ASA/PIX 7.0+)
 
      	 [bookmark: pgfId-610178]Configuring IPv6 Interfaces (ASA/FWSM)
 
      	 [bookmark: pgfId-610183]Understanding ASA 5505 Ports and Interfaces
 
      	 [bookmark: pgfId-610188]Configuring Hardware Ports on an ASA 5505
 
     
 
     [bookmark: pgfId-610191]
 
      
       
        
        [bookmark: pgfId-606967]Table 46-6 [bookmark: 107045]General tab: Add/Edit Interface Dialog Box 
 
        
       
         
         	
           
           [bookmark: pgfId-606973]Element
          
  
         	
           
           [bookmark: pgfId-606975]Description
          
  
        
 
         
         	[bookmark: pgfId-606981]Enable Interface
  
         	[bookmark: pgfId-606983]Enables this interface to pass traffic.
 [bookmark: pgfId-606985]By default, all physical interfaces are shut down. Traffic cannot traverse an interface of any type if the interface is not enabled. If you are defining a logical interface such as a subinterface, enable the physical interface it will be associated with before defining the subinterface. If you are defining a redundant interface or an EtherChannel interface, enable the member interfaces before defining the group interface.
 [bookmark: pgfId-606987]When you check this option, you must also specify a Name and, in routed mode, an IP Type (or IP Address and Subnet Mask on an FWSM or ASA-SM) before traffic can pass according to your security policy.
 [bookmark: pgfId-606989]In multiple-context mode, if you allocate a physical or logical interface to a context, the interface is enabled by default in the context. However, before traffic can pass through the context interface, you must also enable the interface in the system configuration. If you shut down an interface in the system execution space, that interface is shut down in all contexts in which it shared.
  
        
 
         
         	[bookmark: pgfId-606995]Management Only
  
         	[bookmark: pgfId-606997]Reserves this interface for device administration. Only traffic for management of this device is accepted; pass-through traffic for other interfaces and devices is rejected.
 [bookmark: pgfId-606999]You cannot set a Primary or Secondary ISP interface to be Management Only.
 [bookmark: pgfId-607004]Defining a management-only EtherChannel interface has certain member-interface restrictions. See Configuring EtherChannels, for more information.
 [bookmark: pgfId-607006]Note This is not available on devices in transparent mode. If an interface is assigned as Management Only, then Route Map cannot be assigned to that interface. In other words, either Management Only or Route Map can be assigned to an interface but not both.
  
        
 
         
         	[bookmark: pgfId-607012]Interface
  
         	[bookmark: pgfId-607017]On the ASA 5505, the Hardware Port is specified on the Hardware Ports panel (see Configuring Hardware Ports on an ASA 5505). Also, this option is not part of Catalyst 6500 services module (ASA-SM and FWSM) configuration.
 [bookmark: pgfId-607019]For a physical interface, provide the specific hardware port assigned to the interface: enter a physical port ID, which includes network type, slot and port number, in the form: type[slot/]port. This is also the name by which subinterfaces can be associated with the interface.
 [bookmark: pgfId-607021]The network type specified for the physical interface can be either Ethernet or GigabitEthernet; on the ASA 5580, TenGigabitEthernet is also available. This field provides automatic pattern matching: if you begin typing with the letter e, “Ethernet” is inserted into the field. Similarly, typing the letter g produces “GigabitEthernet.” Therefore, valid values are:
 
           
           	 [bookmark: pgfId-607023]Ethernet0 to Ethernet n 
 
           	 [bookmark: pgfId-607025]GigabitEthernet0 to GigabitEthernet n 
 
           	 [bookmark: pgfId-607027]GigabitEthernet s / n 
 
           	 [bookmark: pgfId-607029]TenGigabitEthernet s / n (ASA 5580 only)
 
          
 [bookmark: pgfId-607031]where s represents a slot number, and n represents a port number, up to the maximum number of network ports in the slot or device.
 [bookmark: pgfId-607033]For an ASA 5500 series appliance, enter the type and a slot/port pair; for example, gigabitethernet0/1. Ports that are built into the chassis are assigned to slot 0, while ports on the 4-Port Gigabit Ethernet Security Services Module (4GE SSM) are assigned to slot 1. When you enter a slot/port pair, the Media Type options are enabled.
 [bookmark: pgfId-607035]The ASA 5500 series appliances also include a management interface type. The management interface is a Fast Ethernet interface designed for device-management traffic only, and is specified as management0/0. You can, however, use this physical interface for through traffic if desired (be sure the Management Only option is not selected). Thus, in transparent firewall mode, you can use the management interface in addition to the two interfaces allowed for through traffic. You can also add subinterfaces to the management interface to provide management in each security context in multiple-context mode.
 [bookmark: pgfId-607037]If you are defining a subinterface, you can simply choose the desired Hardware Port from a list of previously defined ports (you must also supply a VLAN ID). If you do not see a desired interface ID, be sure that Interface is defined and enabled.
  
        
 
         
         	[bookmark: pgfId-607043]Name
  
         	[bookmark: pgfId-607045]Provide an identifier for this interface of up to 48 characters in length. The name should be a memorable name for the interface that relates to its use. However, if you are using failover, do not name interfaces that you are reserving for failover communications; this includes an EtherChannel intended for failover, as well as its member interfaces. Also, do not name interfaces intended for use as a member of a redundant-interface pair.
 [bookmark: pgfId-607047]Certain names are reserved for specific interfaces, in accordance with the interface naming conventions of the security appliance. As such, these reserved names enforce default, reserved security levels, as follows:
 
           
           	 [bookmark: pgfId-607049]Inside – Connects to your internal network. Must be the most secure interface.
 
           	 [bookmark: pgfId-607051]DMZ – “Demilitarized zone” attached to an intermediate interface. DMZ is also known as a perimeter network. You can name a DMZ interface any name you choose. Typically, DMZ interfaces are prefixed with “ DMZ ” to identify the interface type.
 
           	 [bookmark: pgfId-607053]Outside – Connects to an external network or the Internet. Must be the least secure interface.
 
          
 [bookmark: pgfId-607055]Similarly, a subinterface name typically identifies its associated interface, in addition to its own unique identifier. For example, DMZoobmgmt could represent an out-of-band management network attached to the DMZ interface.
 . See Chapter 50, “Configuring Failover” and Configuring Redundant Interfaces for more information.
  
        
 
         
         	[bookmark: pgfId-607069]Security Level
  
         	[bookmark: pgfId-607071]Specify the security level of the interface: enter a value between 0 (least secure) and 100 (most secure). The security appliance lets traffic flow freely from an inside network to an outside network (lower security level). Many other security features are affected by the relative security level of two interfaces.
 
           
           	 [bookmark: pgfId-607073]The  outside interface is always 0.
 
           	 [bookmark: pgfId-607075]The  inside interface is always 100.
 
           	 [bookmark: pgfId-607077]DMZ interfaces are between 1 and 99.
 
          
  
        
 
         
         	[bookmark: pgfId-607083]Media Type
  
         	[bookmark: pgfId-607085]When Interface is the chosen Type and you enter a hardware port ID with slot/port numbers in the Hardware Port field, these options are enabled. (These options apply to ASA slot/port interfaces only.)
 [bookmark: pgfId-607087]For all ASA 5500 series appliances, except the 5505, ports that are built into the chassis are assigned to slot 0, while ports on the 4GE SSM are assigned to slot 1. By default, all connectors used on an ASA are RJ-45 connectors. However, the ports on the 4GE SSM can include fiber SFP connectors. As part of the interface configuration for one of these fiber-based connections, you must change the Media Type setting from the default (RJ45) to the fiber-connector setting (SFP).
 [bookmark: pgfId-607089]Fiber-based interfaces do not support duplexing and have a fixed speed, so the Duplex option is disabled, and the Speed options are limited to auto and nonegotiate.
 [bookmark: pgfId-607091]Select the connector type used by this slot-1 interface:
 
           
           	 [bookmark: pgfId-607093] RJ45 – The port uses RJ-45 (copper) connectors.
 
           	 [bookmark: pgfId-607095] SFP – The port uses fiber SFP connectors. Required for 10-Gigabit Ethernet cards.
 
          
  
        
 
         
         	[bookmark: pgfId-607101]VLAN ID
  
         	[bookmark: pgfId-607103]When Subinterface is the chosen interface Type, or when you are defining a logical interface on a device operating in transparent mode, on an ASA 5505, or on a Catalyst 6500 services module (ASA-SM or FWSM), provide a VLAN ID for this interface.
 [bookmark: pgfId-607105]For PIX/ASA devices running operating system 7.2(2)18 or earlier, valid VLAN IDs are 1 to 1001; with version 7.2(2)19 or later, valid IDs are 1 to 4090. For Catalyst 6500 services modules, valid IDs are 1 to 4096. The specified VLAN ID must not be in use on any connected device.
 [bookmark: pgfId-607107]Some VLAN IDs might be reserved on connected switches; see the switch documentation for more information. In multiple-context mode, you can only set the VLAN ID in the system configuration.
 [bookmark: pgfId-607112]See Configuring Subinterfaces (PIX/ASA) for more information.
  
        
 
         
         	[bookmark: pgfId-607118]Subinterface ID
  
         	[bookmark: pgfId-607120]When Subinterface is the chosen interface Type, or when defining an interface on a device operating in transparent mode, provide an integer between 1 and 4294967293 as the Subinterface ID.
 [bookmark: pgfId-607122]For subinterface port identification, this ID is appended to the chosen Hardware Port. For example, GigabitEthernet0.4 represents the subinterface assigned an ID of 4, operating on the port GigabitEthernet0.
 [bookmark: pgfId-607124]Note You cannot change the Subinterface ID after you set it.
  
        
 
         
         	[bookmark: pgfId-607130]Route Map
  
         	[bookmark: pgfId-607132]Select the Route Map from the Route Map Object Selector dialog box.
 [bookmark: pgfId-607134]Note Except VNI Interface, all other interface types support Policy Based Routing for ASA devices running the software version 9.4(1) or higher. VNI Interface supports Policy Based Routing for ASA devices running the software version 9.5(1) or higher.
  
        
 
         
         	[bookmark: pgfId-607140]IP Type
  
         	[bookmark: pgfId-607142]PIX 7.0+ and ASA (except the 5505 in transparent mode) only.
 [bookmark: pgfId-607147]The IP Type defines the type of IP addressing used for the interface; choose Static IP, Use DHCP, or PPPoE (as described in Device Interface: IP Type (PIX/ASA 7.0+)).
 [bookmark: pgfId-607149]Note You can configure DHCP and PPPoE only on the outside interface of a security appliance.
  
        
 
         
         	[bookmark: pgfId-607155]IP Address
 [bookmark: pgfId-607157]Subnet Mask
  
         	[bookmark: pgfId-607159]Catalyst 6500 services modules (ASA-SMs and FWSMs) in routed mode only.
 [bookmark: pgfId-607161]Use these two fields to assign an IP address and subnet mask to the VLAN interface. The IP address must be unique for each interface.
 [bookmark: pgfId-607163]The Subnet Mask can be expressed in dotted decimal format (for example, 255.255.255.0), or by entering the number of bits in the network mask (for example, 24). Do not use 255.255.255.254 or 255.255.255.255 for an interface connected to the network because this will stop traffic on that interface. If you omit the Subnet Mask value, a “classful” network is assumed, as follows:
 
           
           	 [bookmark: pgfId-607165]The Class A netmask (255.0.0.0) is assumed if the first octet of the IP Address is 1 through 126 (that is, addresses 1.0.0.0 through 126.255.255.255).
 
           	 [bookmark: pgfId-607167]Subnet Mask
 
          
 [bookmark: pgfId-607169]The Class B netmask (255.255.0.0) is assumed if the first octet of the IP Address is 128 through 191 (that is, addresses 128.0.0.0 through 191.255.255.255).
 
           
           	 [bookmark: pgfId-607171]The Class C netmask (255.255.255.0) is assumed if the first octet of the IP Address is 192 through 223 (that is, addresses 192.0.0.0 through 223.255.255.255).
 
          
 [bookmark: pgfId-607173]Note Do not use addresses previously used for routers, hosts, or any other firewall device commands, such as an IP address in the global pool or a static NAT entry.
  
        
 
         
         	[bookmark: pgfId-607179]Description
  
         	[bookmark: pgfId-607181]You can enter an optional description of up to 240 characters on a single line, without carriage returns. In multiple-context mode, the system description is independent of the context description.
 [bookmark: pgfId-607183]For a failover or state link, the description is fixed as “LAN Failover Interface,” “STATE Failover Interface,” or “LAN/STATE Failover Interface,” for example. You cannot edit this description. The fixed description overwrites any description you enter here if you make this interface a failover or state link.
  
        
 
         
         	 
           
           [bookmark: pgfId-607189]Redundant Interface; these options not available on ASA 5505 devices or Catalyst 6500 services modules (ASA-SMs and FWSMs).
          
  
        
 
         
         	[bookmark: pgfId-607197]Redundant ID
  
         	[bookmark: pgfId-607199]When Redundant Interface is the chosen interface Type, provide an identifier for this redundant interface; valid IDs are the integers from 1 to 8.
 [bookmark: pgfId-607204]See Configuring Redundant Interfaces for more information.
  
        
 
         
         	[bookmark: pgfId-607210]Primary Interface
 [bookmark: pgfId-607212]Secondary Interface
  
         	[bookmark: pgfId-607214]When Redundant Interface is the chosen interface Type, choose the primary member of the redundant interface pair from the Primary Interface list of available interfaces. Available interfaces are presented by Hardware Port IDs, as named interfaces cannot be used for a redundant interface pair.
 [bookmark: pgfId-607216]Similarly, choose the secondary member of the redundant interface pair from the Secondary Interface list of available interfaces.
 [bookmark: pgfId-607218]Note Member interfaces must be enabled and of the same type (e.g., GigabitEthernet), and cannot have a Name, IP Address, or Security Level assigned. In fact, do not configure any options other than Duplex and Speed on the member interfaces.
  
        
 
         
         	 
           
           [bookmark: pgfId-607224]These options available on ASA 5505 devices only.
          
  
        
 
         
         	[bookmark: pgfId-607232]Block Traffic To
  
         	[bookmark: pgfId-607234]Restricts this VLAN interface from initiating contact with the VLAN chosen here.
  
        
 
         
         	[bookmark: pgfId-607240]Backup Interface
  
         	[bookmark: pgfId-607242]Choose a VLAN interface as a backup interface, for example, to an ISP. The backup interface does not pass traffic unless the default route through the primary interface fails. To ensure that traffic can pass over the backup interface, be sure to configure default routes on both the primary and backup interfaces so that the backup interface can be used when the primary fails.
  
        
 
         
         	[bookmark: pgfId-607248]Active MAC Address
 [bookmark: pgfId-607250]Standby MAC Address
  
         	[bookmark: pgfId-607252]Use the Active MAC Address field to manually assign a private MAC address to the interface; the Standby MAC Address field can be used to set a standby MAC address for use with device-level failover.
 [bookmark: pgfId-607257]Refer to Device Interface: MAC Address for more information about these fields.
  
        
 
         
         	 
           
           [bookmark: pgfId-607263]EtherChannel Interface options; available on ASA 8.4.1+ devices only.
          
  
        
 
         
         	[bookmark: pgfId-607271]EtherChannel ID
  
         	[bookmark: pgfId-607276]When EtherChannel is the chosen interface Type, enter an identifier for this EtherChannel (also referred to as a “port-channel”). Valid values are 1 to 48—you can define up to 48 port-channel groups. See Configuring EtherChannels, for more information.
  
        
 
         
         	[bookmark: pgfId-607282]Available Interfaces/Members in Group
  
         	[bookmark: pgfId-607284]When EtherChannel is the chosen interface Type, you can assign interfaces to this EtherChannel group by selecting them in the Available Interfaces list and then clicking the >> button to add them to the members list to the right.
 [bookmark: pgfId-607289]You can assign up to 16 interfaces to a channel group. For ASA 9.2(1) and later, each channel group can have up to 16 active interfaces. For switches that support only eight active interfaces and for ASA versions earlier than 9.2(1), only eight interfaces can be active, the remaining interfaces can act as standby links in case of interface failure. Alternatively, you can create a static EtherChannel by setting LACP Mode to On (on the Advanced tab, see Add/Edit Interface Dialog Box: Advanced Tab (ASA/PIX 7.0+)), which means all interfaces in the group can pass traffic.
 [bookmark: pgfId-607291]Note All interfaces in the channel group must be the same type and speed. The first interface added to the channel group determines the type and speed for the group.
 [bookmark: pgfId-607296]See Configuring EtherChannels, for more information.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-610211][bookmark: 107278][bookmark: pxpage_cncpt_AddEditInterfacePIXASA_AdvancedTab]Add/Edit Interface Dialog Box: Advanced Tab (ASA/PIX 7.0+)[bookmark: marker-610199][bookmark: marker-610201][bookmark: marker-610203][bookmark: marker-610205][bookmark: marker-610207][bookmark: marker-610209]
 
     [bookmark: pgfId-610219]The Add/Edit Interface Dialog Box (PIX 7.0+/ASA/FWSM), is used to define and configure interfaces, subinterfaces, redundant, and EtherChannel interfaces on ASA and PIX 7.0+ devices. You can access the Add/Edit Interface dialog box from the Interfaces page. See Managing Device Interfaces, Hardware Ports, and Bridge Groups for more information.
 
     [bookmark: pgfId-610221]The Advanced panel of this dialog box is used to configure basic interface settings, including Duplex, Speed, and maximum transmission unit (MTU) parameters, as described in the following table.
 
     [bookmark: pgfId-610223]Related Topics
 
      
      	 [bookmark: pgfId-610228]Add/Edit Interface Dialog Box: General Tab (PIX 7.0+/ASA/FWSM)
 
      	 [bookmark: pgfId-610233]Configuring IPv6 Interfaces (ASA/FWSM)
 
     
 
     [bookmark: pgfId-610236]
 
      
       
        
        [bookmark: pgfId-607309]Table 46-7 [bookmark: 107316]Advanced tab: Add/Edit Interface Dialog Box (ASA/PIX 7.0+) 
 
        
       
         
         	
           
           [bookmark: pgfId-607315]Element
          
  
         	
           
           [bookmark: pgfId-607317]Description
          
  
        
 
         
         	[bookmark: pgfId-607323]Duplex
  
         	[bookmark: pgfId-607325]Lists the duplex options for the interface, including Auto, Full, Half, or N/A, depending on the interface type.
 [bookmark: pgfId-607327]For TenGigabitEthernet (ASA 5580 only), Duplex is automatically set to Full.
 [bookmark: pgfId-607329]Note This option is not available when Subinterface or Redundant is the chosen Interface type.
  
        
 
         
         	[bookmark: pgfId-607335]Speed
  
         	[bookmark: pgfId-607337]Lists the speed options (in bits per second) for a physical interface; not applicable to logical interfaces. The speeds available depend on the interface type.
 
           
           	 [bookmark: pgfId-607339]auto
 
           	 [bookmark: pgfId-607341]10
 
           	 [bookmark: pgfId-607343]100
 
           	 [bookmark: pgfId-607345]1000
 
           	 [bookmark: pgfId-607347]10000 (set automatically for a TenGigabitEthernet interface; available only on ASA 5580)
 
           	 [bookmark: pgfId-607349]nonegotiate
 
          
 [bookmark: pgfId-607351]Note This option is not available when Subinterface or Redundant is the chosen Interface type.
  
        
 
         
         	[bookmark: pgfId-607357]MTU
  
         	[bookmark: pgfId-607359]Specify the maximum packet size in bytes; that is, the maximum transmission unit (MTU). The value depends on the type of network connected to the interface. Valid values are 300 to 65535 bytes. Default is 1500 for all types except PPPoE, for which the default is 1492. In multiple-context mode, set the MTU in the context configuration.
  
        
 
         
         	[bookmark: pgfId-607365]Active MAC Address
 [bookmark: pgfId-607367]Standby MAC Address
  
         	[bookmark: pgfId-607369]Available only on PIX 7.2+ and ASA 7.2+ devices.
 [bookmark: pgfId-607371]Use the Active MAC Address field to manually assign a private MAC address to the interface; the Standby MAC Address field can be used to set a standby MAC address for use with device-level failover.
 [bookmark: pgfId-607376]Refer to Device Interface: MAC Address for more information about these fields.
  
        
 
         
         	[bookmark: pgfId-607382]Roles
  
         	[bookmark: pgfId-607384]All interface roles assigned to this interface are listed in this field. Role assignments are based on pattern matching between the Name given to this interface and all currently defined Interface Role objects in Cisco Security Manager.
 [bookmark: pgfId-607386]Interface role objects are replaced with the actual interface IP addresses when the configuration is generated for each device. They allow you to define generic rules—ones that can apply to multiple interfaces.
 [bookmark: pgfId-607391]For more information on roles and how to define and use them, see Understanding Interface Role Objects.
  
        
 
         
         	[bookmark: pgfId-607397]MAC Address
  
         	[bookmark: pgfId-607399]Site specific MAC address.
  
        
 
         
         	[bookmark: pgfId-607405]Site ID
  
         	[bookmark: pgfId-607407]Site ID to specify the site the current unit belongs to.
  
        
 
         
         	 [bookmark: pgfId-607413]Beginning with Security Manager version 4.9 for ASA devices running the software version 9.5(1) or higher, you can use inter-site clustering for Spanned EtherChannels in routed mode. To avoid MAC address flapping, configure a site ID for each cluster member so that a site-specific MAC address for each interface can be shared among a site’s units.
  
        
 
         
         	 [bookmark: pgfId-607421]EtherChannel Interface options; available on ASA 8.4.1+ devices only.
 [bookmark: pgfId-607423] 
  
        
 
         
         	[bookmark: pgfId-607431]Load Balancing
  
         	[bookmark: pgfId-607436]When EtherChannel is the chosen interface Type (on the General panel), choose a load-balancing method for the channel links. See About EtherChannel Load Balancing, for more information about this option.
  
        
 
         
         	[bookmark: pgfId-607442]LACP Mode
  
         	[bookmark: pgfId-607444]Select the desired LACP Mode; the default is Active, which means up to eight interfaces are active, while up to eight are in stand-by mode, as determined by the Minimum and Maximum values under Active Physical Interfaces.
 [bookmark: pgfId-607449]If you select On, a static port-channel is created in which all member interfaces are all “on,” meaning you can have up to 16 ports passing traffic, with no stand-by ports. When you select this option, the Mode for all interfaces assigned to this EtherChannel group is switched to On (if the Mode for each is not already On). See Editing LACP Parameters for an Interface Assigned to an EtherChannel, for more information about this mode.
  
        
 
         
         	[bookmark: pgfId-607455]Active Physical Interfaces
  
         	[bookmark: pgfId-607457]When EtherChannel is the chosen interface Type (on the General panel), specify the minimum and maximum number of interfaces that can be active for this EtherChannel group:
 
           
           	 [bookmark: pgfId-607459] Minimum – Specify the minimum number of active interfaces for this group. For ASA 9.2(1)+, you can specify a value from 1 to 16; for earlier versions, enter a value from 1 to 8.
 
          
 [bookmark: pgfId-607461]If the active interfaces in the channel group falls below this value, then the port-channel interface goes down, and could trigger a device-level failover.
 
           
           	 [bookmark: pgfId-607463] Maximum – Specify the maximum number of interfaces that can be active. For ASA 9.2(1)+, you can specify a value from 1 to 16; for earlier versions, enter a value from 1 to 8.
 
          
 [bookmark: pgfId-607465]For 16 active interfaces, be sure that your switch supports the feature (for example, the Cisco Nexus 7000 with F2-Series 10 Gigabit Ethernet Module). If your switch does not support 16 active interfaces, be sure to set this command to 8 or fewer.
 [bookmark: pgfId-607470]Interfaces available to the channel are selected on the General tab of this dialog box (Add/Edit Interface Dialog Box: General Tab (PIX 7.0+/ASA/FWSM)).
 [bookmark: pgfId-607472]Specifying 3, 5, 6, or 7 active ports in an EtherChannel bundle provides poor load balancing, because some ports get up to twice the load of others. We recommend specifying 2, 4, or 8 active ports per EtherChannel to achieve effective load balancing. (A value of 1 provides no load balancing at all.)
  
        
 
         
         	 [bookmark: pgfId-607478]DHCP Relay options; available on ASA-SM 9.1.2+ devices only.
 [bookmark: pgfId-607480] 
  
        
 
         
         	[bookmark: pgfId-607488]DHCP Relay Servers
  
         	[bookmark: pgfId-607490]Enter the IP address or select a Networks/Hosts object representing the interface-specific DHCP server to which DHCP requests on this interface are relayed. Use a comma to separate multiple values. You can configure a maximum of 4 interface-specific DHCP relay servers and a maximum of 10 global and interface-specific DHCP relay servers combined.
 [bookmark: pgfId-607492]Note IPv6 is not supported for interface-specific servers.
 [bookmark: pgfId-607494]When a DHCP request enters an interface, the DHCP servers to which the ASA relays the request depends on your configuration. You can configure the following types of servers:
 
           
           	 [bookmark: pgfId-607496]Interface-specific DHCP servers—When a DHCP request enters a particular interface, then the ASA relays the request only to the interface-specific servers.
 
           	 [bookmark: pgfId-607501]Global DHCP servers—When a DHCP request enters an interface that does not have interface-specific servers configured, the ASA relays the request to all global servers. If the interface has interface-specific servers, then the global servers are not used. For more information, see DHCP Relay Page.
 
          
  
        
 
         
         	[bookmark: pgfId-607507]DHCP Relay Trust Info (Option 82)
  
         	[bookmark: pgfId-607509]Specifies that you want to trust this DHCP client interface. You can configure interfaces as trusted interfaces to preserve DHCP Option 82.
 [bookmark: pgfId-607514]Note You can also trust all DHCP client interfaces. For more information, see DHCP Relay Page.
 [bookmark: pgfId-607516]DHCP Option 82 is used by downstream switches and routers for DHCP snooping and IP Source Guard. Normally, if the ASA DHCP relay agent receives a DHCP packet with Option 82 already set, but the giaddr field (which specifies the DHCP relay agent address that is set by the relay agent before it forwards the packet to the server) is set to 0, then the ASA will drop that packet by default. You can now preserve Option 82 and forward the packet by identifying an interface as a trusted interface.
  
        
 
         
         	 [bookmark: pgfId-607530]Secure Group Tagging options; available on ASA 9.3.1+ devices only.[bookmark: marker-607522][bookmark: marker-607524][bookmark: marker-607526][bookmark: marker-607528]
 [bookmark: pgfId-607532]SGT plus Ethernet Tagging, also called Layer 2 SGT Imposition, enables the ASA to send and receive security group tags on Ethernet interfaces using Cisco proprietary Ethernet framing (EtherType 0x8909), which allows the insertion of source security group tags into plain-text Ethernet frames. The ASA inserts security group tags on the outgoing packet and processes security group tags on the incoming packet, based on a manual per-interface configuration. This feature allows inline hop-by-hop propagation of endpoint identity across network devices and provides seamless Layer 2 SGT Imposition between each hop.
 Does not support failover links or cluster control links.
  
        
 
         
         	[bookmark: pgfId-607542]Enable secure group tagging for Cisco TrustSec
  
         	[bookmark: pgfId-607544]Enables SGT plus Ethernet Tagging (also called Layer 2 SGT Imposition).
  
        
 
         
         	[bookmark: pgfId-607550]Tag egress packets with secure group tags
  
         	[bookmark: pgfId-607552]Enables propagation of a security group tag (called sgt) on an interface.
  
        
 
         
         	[bookmark: pgfId-607558]Assign a static secure group tag to all ingress packets
  
         	[bookmark: pgfId-607560]Applies a static security group tag to incoming traffic from the peer. If enabled, you must specify the SGT number to use in the Secure Group Tag field.
  
        
 
         
         	[bookmark: pgfId-607566]Secure Group Tag
  
         	[bookmark: pgfId-607568]Specifies the SGT number to apply to incoming traffic from the peer. Valid values are from 2-65519.
  
        
 
         
         	[bookmark: pgfId-607574]Trusted Interface
  
         	[bookmark: pgfId-607576]Indicates that ingress traffic on the interface should not have its existing SGT overwritten with the static SGT specified.
  
        
 
         
         	 [bookmark: pgfId-607582]ASA Cluster (Layer 3); available on ASA 5580 and 5585 devices in cluster mode only.
 [bookmark: pgfId-607584]Supported by all interfaces when ASA cluster is in Router mode and supported by management interface when ASA cluster is in Transparent mode.
  
        
 
         
         	[bookmark: pgfId-607592]IPv4 Address Pool
  
         	[bookmark: pgfId-607594]Enter or select the IPv4 Pool object that represents the pool of addresses to use.
  
        
 
         
         	[bookmark: pgfId-607600]MAC Address Pool
  
         	[bookmark: pgfId-607602]Enter or select the MAC Pool object that represents the pool of MAC addresses to use.
  
        
 
         
         	 [bookmark: pgfId-607608]ASA Cluster (Layer 2); available on ASA 5580 and 5585 devices in cluster mode only.
 [bookmark: pgfId-607610]Supported on EtherChannel interfaces for ASA clusters. Not supported on Management interface when ASA cluster is in Transparent mode.
  
        
 
         
         	[bookmark: pgfId-607618]Span EtherChannel across the ASA Cluster
  
         	[bookmark: pgfId-607620]Select to configure an EtherChannel that spans all ASAs in the cluster, and provides load balancing as part of the EtherChannel operation.
  
        
 
         
         	[bookmark: pgfId-607626]Enable load balancing between switch pairs in VSS or vPC mode
  
         	[bookmark: pgfId-607628](Optional) If you are connecting the ASA to two switches in a Virtual Switching System (VSS) or Virtual Port Channel (vPC), then you should enable load balancing by checking the Enable load balancing between switch pairs in VSS or vPC mode check box. This feature ensures that the physical link connections between the ASAs to the VSS (or vPC) pair are balanced.
  
        
 
         
         	[bookmark: pgfId-607634]Member Interface Configuration
  
         	[bookmark: pgfId-607636]Identifies the LACP mode for the interface and the Virtual Switching System (VSS) or Virtual Port Channel (vPC) switch to which a given interface is connected, 1 or 2.
  
        
 
         
         	 
           
           [bookmark: pgfId-607642]Advanced tab options specific to ASA 5505 devices (routed mode only)
          
  
        
 
         
         	[bookmark: pgfId-607650]Block Traffic To
  
         	[bookmark: pgfId-607652]Restricts this VLAN interface from initiating contact with the VLAN chosen here.
  
        
 
         
         	[bookmark: pgfId-607658]Backup Interface
  
         	[bookmark: pgfId-607660]Choose a VLAN interface as a backup interface, for example, to an ISP. The backup interface does not pass traffic unless the default route through the primary interface fails. To ensure that traffic can pass over the backup interface, be sure to configure default routes on both the primary and backup interfaces so that the backup interface can be used when the primary fails.
  
        
 
         
         	 
           
           [bookmark: pgfId-607666]Advanced tab options specific to FWSM 3.1+ devices
          
  
        
 
         
         	[bookmark: pgfId-607674]Bridge Group
  
         	[bookmark: pgfId-607679]For an FWSM 3.1+ operating in transparent mode, this read-only field indicates the Bridge group to which this interface is assigned. See Add/Edit Bridge Group Dialog Box for more information.
  
        
 
         
         	[bookmark: pgfId-607685]ASR Group
  
         	[bookmark: pgfId-607690]To add this interface to an asymmetric routing group, enter the ASR group number in this field. Stateful failover must be enabled for asymmetric routing support to function properly between units in failover configurations. Valid values for ASR group range from 1 to 32. See About Asymmetric Routing Groups for more information.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-610252][bookmark: 107570][bookmark: pxchap_cncpt_Interfaces_IPv6]Configuring IPv6 Interfaces (ASA/FWSM)[bookmark: marker-610244][bookmark: marker-610246][bookmark: marker-610248][bookmark: marker-610250]
 
     [bookmark: pgfId-610254]When Interface, Subinterface, Redundant, or EtherChannel is the chosen Type in the Add Interface or Edit Interface dialog box, the dialog box presents three tabbed panels of options: General, Advanced and IPv6. The options provided by the IPv6 panel are described in this section.
 
      
       
     
 
     
 
     [bookmark: pgfId-610256]Note These options are available only on ASA 7.0+ devices in routed mode; ASA 8.2+ devices in transparent mode; and FWSM 3.1+ devices in routed mode.

     
      

     

     
 
     [bookmark: pgfId-610258]Navigation Path
 
     [bookmark: pgfId-610263]You can access the IPv6 panel in the Add Interface and Edit Interface dialog boxes, which are accessed from the ASA or FWSM Interfaces page, as described in Managing Device Interfaces, Hardware Ports, and Bridge Groups.
 
     [bookmark: pgfId-610265]Related Topics
 
      
      	 [bookmark: pgfId-610270]IPv6 Support in Security Manager
 
      	 [bookmark: pgfId-610275]Add/Edit Interface Dialog Box: General Tab (PIX 7.0+/ASA/FWSM)
 
      	 [bookmark: pgfId-610280]Add/Edit Interface Dialog Box: Advanced Tab (ASA/PIX 7.0+)
 
     
 
     [bookmark: pgfId-610282]Field Reference
 
     [bookmark: pgfId-610285]
 
      
       
        
        [bookmark: pgfId-607703]Table 46-8 [bookmark: 107611]IPv6 tab: Add/Edit Interface Dialog Box (ASA/FWSM) 
 
        
       
         
         	
           
           [bookmark: pgfId-607709]Element
          
  
         	
           
           [bookmark: pgfId-607711]Description
          
  
        
 
         
         	[bookmark: pgfId-607717]Enable IPv6
  
         	[bookmark: pgfId-607719]Check this box to enable IPv6 and configure IPv6 addresses on this interface. You can deselect this option to disable IPv6 on the interface, but retain the configuration information.
  
        
 
         
         	[bookmark: pgfId-607725]Enforce EUI-64
  
         	[bookmark: pgfId-607727]When selected, use of Modified EUI-64 format interface identifiers in IPv6 addresses on a local link is enforced.
 [bookmark: pgfId-607729]When this option is enabled on an interface, the source addresses of IPv6 packets received on the interface are verified against the source MAC addresses to ensure that the interface identifiers use the Modified EUI-64 format. If the interface identifier in an IPv6 packet is not in the Modified EUI-64 format, the packet is dropped and the following system log message is generated:
 [bookmark: pgfId-607731]%PIX|ASA-3-325003: EUI-64 source address check failed.
 [bookmark: pgfId-607733]Address format verification is performed only when a flow is created. Packets from an existing flow are not checked. Additionally, address verification can be performed only for hosts on the local link. Packets received from hosts behind a router will fail the address format verification, and be dropped, because their source MAC address will be the router MAC address and not the host MAC address.
 [bookmark: pgfId-607735]The Modified EUI-64 format interface identifier is derived from the 48-bit link-layer (MAC) address by inserting the hex number FFFE between the upper three bytes (OUI field) and the lower 3 bytes (serial number) of the link-layer address. To ensure the chosen address is from a unique Ethernet MAC address, the next-to-lowest order bit in the high-order byte is inverted (universal/local bit) to indicate the uniqueness of the 48-bit address. For example, an interface with a MAC address of 00E0.B601.3B7A would have a 64-bit interface ID of 02E0:B6FF:FE01:3B7A.
  
        
 
         
         	[bookmark: pgfId-607741]DAD Attempts
  
         	[bookmark: pgfId-607743]To specify the number of consecutive neighbor solicitation messages that are sent on an interface during duplicate address detection (DAD), enter a number from 0 to 600 in this field. Entering 0 disables duplicate address detection on the interface. Entering 1 configures a single transmission without follow-up transmissions; this is the default.
 [bookmark: pgfId-607745]Duplicate address detection verifies the uniqueness of new unicast IPv6 addresses before the addresses are assigned to interfaces (the new addresses remain in a tentative state while duplicate address detection is performed). Duplicate address detection uses neighbor solicitation messages to verify the uniqueness of unicast IPv6 addresses.
 [bookmark: pgfId-607747]When duplicate address detection identifies a duplicate address, the state of the address is set to DUPLICATE and the address is not used. If the duplicate address is the link-local address of the interface, the processing of IPv6 packets is disabled on the interface and an error message similar to the following is issued:
 [bookmark: pgfId-607749]%PIX-4-DUPLICATE: Duplicate address FE80::1 on outside
 [bookmark: pgfId-607751]If the duplicate address is a global address of the interface, the address is not used and an error message is issued, similar to that shown previously for a duplicate link-local address.
 [bookmark: pgfId-607753]All configuration commands associated with the duplicate address remain as-configured while the state of the address is set to DUPLICATE. If the link-local address for an interface changes, duplicate address detection is performed on the new link-local address, and all other IPv6 address associated with the interface are regenerated (that is, duplicate address detection is performed only on the new link-local address).
  
        
 
         
         	[bookmark: pgfId-607759]NS Interval
  
         	[bookmark: pgfId-607761]The interval between IPv6 neighbor solicitation retransmissions, in milliseconds. Valid values range from 1000 to 3600000 milliseconds; the default value is 1000 milliseconds.
 [bookmark: pgfId-607763]Note This value is included in all IPv6 router advertisements sent out on this interface.
  
        
 
         
         	[bookmark: pgfId-607769]Reachable Time
  
         	[bookmark: pgfId-607771]The amount of time, in milliseconds, within which a remote IPv6 node is considered still reachable, after initial reachability was confirmed. Valid values range from 0 to 3600000 milliseconds, the default value is 0. When 0 is used for the value, the reachable time is set as undetermined—it is up to the receiving devices to set and track reachable time.
 [bookmark: pgfId-607773]A configured time enables detection of unavailable neighbors. A shorter time allows detecting unavailable neighbors more quickly; however, shorter times consume more IPv6 network bandwidth and processing resources in all IPv6 network devices. Very short configured times are not recommended in normal IPv6 operation.
  
        
 
         
         	[bookmark: pgfId-607779]Managed Config Flag
  
         	[bookmark: pgfId-607781]Whether or not to set the flag "managed-config-flag" in the IPv6 router advertisement packet.
  
        
 
         
         	[bookmark: pgfId-607787]Other Config Flag
  
         	[bookmark: pgfId-607789]Whether or not to set the flag "other-config-flag" in the IPv6 router advertisement packet.
  
        
 
         
         	[bookmark: pgfId-607795]Enable RA
  
         	[bookmark: pgfId-607797]When checked, IPv6 router advertisement transmissions are enabled on the interface. The following options are enabled:
 
           
           	 [bookmark: pgfId-607799] RA Lifetime – The “router lifetime” value specifies how long nodes on the local link should consider the security appliance as the default router on the link. Valid values range from 0 to 9000 seconds; the default is 1800 seconds. Entering 0 indicates that the security appliance should not be considered a default router on the selected interface.
 
          
 [bookmark: pgfId-607801]Any non-zero value should not be less than the following RA Interval value.
 [bookmark: pgfId-607803]Note This value is included in all IPv6 router advertisements sent out on this interface.
 
           
           	 [bookmark: pgfId-607805] RA Interval – The interval between IPv6 router advertisement transmissions on this interface. Valid values range from 3 to 1800 seconds, (or from 500 to 1800000 milliseconds if the following RA Interval in Milliseconds option is checked); the default is 200 seconds.
 
          
 [bookmark: pgfId-607807]The interval between transmissions should be less than or equal to the RA Lifetime value if it is non-zero. To prevent synchronization with other IPv6 nodes, randomly adjust the actual value used to within 20 percent of the desired value.
 
           
           	 [bookmark: pgfId-607809] RA Interval in Milliseconds – Checking this option indicates that the provided RA Interval value is in milliseconds, rather than seconds.
 
          
  
        
 
         
         	[bookmark: pgfId-607815]Interface IPv6 Addresses
  
         	[bookmark: pgfId-607817]The IPv6 addresses assigned to the interface are specified in this section of the dialog box.
 
           
           	 [bookmark: pgfId-607819] Link-Local Address – To override the link-local address that is automatically generated for the interface, enter the desired IPv6 link-local address in this field.
 
          
 [bookmark: pgfId-607821]The link-local address is composed of the link-local prefix FE80::/64 and the interface ID in Modified EUI-64 format. For example, an interface with a MAC address of 00E0.B601.3B7A would have a link-local address of FE80::2E0:B6FF:FE01:3B7A. An error will occur if another host is using the specified address.
 
           
           	 [bookmark: pgfId-607823] Enable Address Auto-Configuration – Select this option to enable automatic configuration of IPv6 addresses on the interface using stateless autoconfiguration. The addresses are configured based on the prefixes received in Router Advertisement (RA) messages. If a link-local address has not been configured, then one is automatically generated for this interface. An error occurs if another host is already using the generated link-local address.
 
           	 [bookmark: pgfId-607828]The table in this section displays the IPv6 addresses assigned to this interface. Use the Add Row, Edit Row, and Delete Row buttons below this table to manage these entries. (These are standard buttons, as described in Using Tables.)
 
          
 [bookmark: pgfId-607833]Add Row and Edit Row open the IPv6 Address for Interface Dialog Box.
  
        
 
         
         	[bookmark: pgfId-607839]Interface IPv6 Prefixes
  
         	[bookmark: pgfId-607844]Use the table in this section to configure which IPv6 prefixes (that is, the network portion of the IPv6 addresses) are included in IPv6 router advertisements. Use the Add Row, Edit Row, and Delete Row buttons below this table to manage these entries. (These are standard buttons, as described in Using Tables.)
 [bookmark: pgfId-607849]Add Row and Edit Row open the IPv6 Prefix Editor Dialog Box.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-610301][bookmark: 107714][bookmark: pxpage_cncpt_IPv6AddressforInterface]IPv6 Address for Interface Dialog Box [bookmark: marker-610293][bookmark: marker-610295][bookmark: marker-610297][bookmark: marker-610299]
 
     [bookmark: pgfId-610303]This dialog box is used to add or edit an IPv6 address assigned to an ASA or FWSM interface. Multiple IPv6 addresses can be assigned to the interface in the IPv6 panel of the Add Interface or Edit Interface dialog box.
 
      
       
     
 
     
 
     [bookmark: pgfId-610305]Note This dialog box is available only on ASA 7.0+ devices in routed mode; ASA 8.2+ devices in transparent mode; and FWSM 3.1+ devices in routed mode.

     
      

     

     
 
     [bookmark: pgfId-610307]Navigation Path
 
     [bookmark: pgfId-610309]You can access the IPv6 Address for Interface dialog box:
 
      
      	 [bookmark: pgfId-610311]From the IPv6 panel of the ASA or FWSM Add Interface and Edit Interface dialog boxes.
 
      	 [bookmark: pgfId-610313]From the Management IPv6 page of an ASA 5505 in transparent firewall mode (version 8.2 and 8.3 devices only).
 
     
 
     [bookmark: pgfId-610315]Click the Add Row or Edit Row buttons beneath the table in the Interfaces IPv6 Addresses section to open the dialog box.
 
     [bookmark: pgfId-610317]Related Topics
 
      
      	 [bookmark: pgfId-610322]IPv6 Prefix Editor Dialog Box
 
      	 [bookmark: pgfId-610327]Add/Edit Interface Dialog Box (PIX 7.0+/ASA/FWSM)
 
      	 [bookmark: pgfId-610332]Managing Device Interfaces, Hardware Ports, and Bridge Groups
 
      	 [bookmark: pgfId-610337]Management IPv6 Page (ASA 5505)
 
     
 
     [bookmark: pgfId-610339]Field Reference
 
     [bookmark: pgfId-610342]
 
      
       
        
        [bookmark: pgfId-607862]Table 46-9 [bookmark: 107762]IPv6 Address for Interface Dialog Box 
 
        
       
         
         	
           
           [bookmark: pgfId-607868]Element
          
  
         	
           
           [bookmark: pgfId-607870]Description
          
  
        
 
         
         	[bookmark: pgfId-607876]Address/Prefix Length
  
         	[bookmark: pgfId-607878]Enter an IPv6 network address to be assigned to the interface, with its Prefix Length appended, where the Prefix Length integer indicates how many of the high-order, contiguous bits of the address comprise network portion of the address. A slash (/) must precede the Prefix Length. For example, 3FFE:C00:0:1::/64.
  
        
 
         
         	[bookmark: pgfId-607884]EUI-64
  
         	[bookmark: pgfId-607886]If this box is checked, the EUI-64 interface ID will be used in the low-order 64 bits of the IPv6 address. If the value specified for the Prefix Length is greater than 64 bits, the prefix bits have precedence over the interface ID. An error occurs if another host is using the specified address.
 [bookmark: pgfId-607888]The Modified EUI-64 format interface ID is derived from the 48-bit link-layer (MAC) address by inserting the hex number FFFE between the upper three bytes (OUI field) and the lower 3 bytes (serial number) of the link layer address. To ensure the chosen address is from a unique Ethernet MAC address, the next-to-lowest order bit in the high-order byte is inverted (universal/local bit) to indicate the uniqueness of the 48-bit address. For example, an interface with a MAC address of 00E0.B601.3B7A would have a 64 bit interface ID of 02E0:B6FF:FE01:3B7A.
  
        
 
         
         	[bookmark: pgfId-607894]IPv6 Address Pool
  
         	[bookmark: pgfId-607896]Enter or select the IPv6 Pool object that represents the pool of addresses to use.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-610358][bookmark: 107789][bookmark: pxpage_cncpt_IPv6PrefixEditor]IPv6 Prefix Editor Dialog Box [bookmark: marker-610350][bookmark: marker-610352][bookmark: marker-610354][bookmark: marker-610356]
 
     [bookmark: pgfId-610360]This dialog box is used to add or edit an IPv6 prefix (that is, the network portion of an IPv6 address), providing control over individual parameters, including whether the prefix should be included in IPv6 router advertisements. Multiple prefixes can be configured in the IPv6 panel of the ASA or FWSM Add Interface or Edit Interface dialog box.
 
      
       
     
 
     
 
     [bookmark: pgfId-610362]Note This dialog box is available only on ASA 7.0+ devices in routed mode; ASA 8.2+ devices in transparent mode; and FWSM 3.1+ devices in routed mode.

     
      

     

     
 
     [bookmark: pgfId-610364]By default, prefixes configured as addresses on an interface are advertised in router advertisements. If you configure specific prefixes for advertisement, then only those prefixes are advertised. The valid and preferred lifetimes are counted down in real time. Alternately, a date can be set to specify the expiration of a prefix. When the expiration is reached, the prefix is no longer advertised.
 
     [bookmark: pgfId-610366]Navigation Path
 
     [bookmark: pgfId-610368]You can access the IPv6 Prefix Editor dialog box from the IPv6 panel of the Add Interface and Edit Interface dialog boxes: click the Add Row or Edit Row buttons beneath the table in the Interfaces IPv6 Prefixes section in either of those dialog boxes.
 
     [bookmark: pgfId-610370]Related Topics
 
      
      	 [bookmark: pgfId-610375]IPv6 Address for Interface Dialog Box
 
      	 [bookmark: pgfId-610380]Add/Edit Interface Dialog Box (PIX 7.0+/ASA/FWSM)
 
      	 [bookmark: pgfId-610385]Managing Device Interfaces, Hardware Ports, and Bridge Groups
 
     
 
     [bookmark: pgfId-610387]Field Reference
 
     [bookmark: pgfId-610390]
 
      
       
        
        [bookmark: pgfId-607909]Table 46-10 [bookmark: 107829]IPv6 Prefix Editor Dialog Box 
 
        
       
         
         	
           
           [bookmark: pgfId-607915]Element
          
  
         	
           
           [bookmark: pgfId-607917]Description
          
  
        
 
         
         	[bookmark: pgfId-607923]Address/Prefix Length
  
         	[bookmark: pgfId-607925]Enter an IPv6 network address, with its Prefix Length appended, where the Prefix Length integer indicates how many of the high-order, contiguous bits of the address represent the network portion of the address. A slash (/) must precede the Prefix Length. For example, 3FFE:C00:0:1::/64.
  
        
 
         
         	[bookmark: pgfId-607931]Default
  
         	[bookmark: pgfId-607933]If this box is checked, the settings in this dialog box will apply to all prefixes, rather than a single address. (When checked, the Address/Prefix Length field is disabled.)
  
        
 
         
         	[bookmark: pgfId-607939]No Advertisements
  
         	[bookmark: pgfId-607941]When checked, hosts on the local link cannot use the specified prefix in advertisements.
  
        
 
         
         	[bookmark: pgfId-607947]Off Link
  
         	[bookmark: pgfId-607949]When checked, the specified prefix is “off-link”; that is, not locally reachable on the link.
 [bookmark: pgfId-607951]When on-link (the default), the specified prefix is assigned to the link. Nodes sending traffic to addresses that contain the specified prefix consider the destination to be locally reachable on the link.
  
        
 
         
         	[bookmark: pgfId-607957]No Auto-Configuration
  
         	[bookmark: pgfId-607959]When checked, hosts on the local link cannot use the specified prefix for IPv6 autoconfiguration.
 [bookmark: pgfId-607961]When auto-configuration is on (the default), hosts on the local link can use the specified prefix for IPv6 autoconfiguration.
  
        
 
         
         	[bookmark: pgfId-607967]Prefix Lifetime
  
         	[bookmark: pgfId-607969]You can expand this section of the dialog box to display the following expiration options:
 
           
           	 [bookmark: pgfId-607971] Lifetime Duration – Select this option to define prefix expiration as a length of time; the following options are enabled:
 
          
 [bookmark: pgfId-607973] – Valid Lifetime – The amount of time (in seconds) that the specified IPv6 prefix is advertised as being valid. Enter a value from 0 to 4294967295 seconds. The maximum value represents infinity (that is, the lifetime does not expire), which can also be specified by the checking the Infinite box. The default is 2592000 (30 days).
 [bookmark: pgfId-607975] – Preferred Lifetime – The amount of time (in seconds) that the specified IPv6 prefix is advertised as being preferred. Enter a value from 0 to 4294967295 seconds. The maximum value represents infinity (that is, the lifetime does not expire), which can also be specified by the checking the Infinite box. The default is 604800 (7 days). The Preferred Lifetime must less than or equal to the Valid Lifetime.
 
           
           	 [bookmark: pgfId-607977] Lifetime Expiration Date – Select this option to define prefix expiration as a specific date. Note that acceptable values for this date can range from today’s date to one year from today’s date. The following options are enabled:
 
          
 [bookmark: pgfId-607979] – Valid – The prefix is advertised as being valid until this date and time are reached. Enter a date in the form Mmm dd yyyy (that is, three-letter month abbreviation, two-digit date, and four-digit year), or click the calendar icon to select a date from a scrolling calendar. Also, enter the time of expiration on the specified date, in the form hh:mm, based on a 24-hour clock.
 [bookmark: pgfId-607981] – Preferred – The prefix is advertised as being preferred until this date and time are reached. Enter a date in the form Mmm dd yyyy (that is, three-letter month abbreviation, two-digit date, and four-digit year), or click the calendar icon to select a date from a scrolling calendar. Also, enter the time of expiration on the specified date, in the form hh:mm, based on a 24-hour clock. The Preferred date and time must be earlier than or equal to the Valid date and time.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-610406][bookmark: 107899][bookmark: pxchap_proc_Interfaces_IPType_ASAPIX]Device Interface: IP Type (PIX/ASA 7.0+)[bookmark: marker-610396][bookmark: marker-610398][bookmark: marker-610400][bookmark: marker-610402][bookmark: marker-610404]
 
     [bookmark: pgfId-610408]A security device operating in single-context, routed mode requires IP addressing for its interfaces; however, firewall interfaces do not have IP addresses until you assign them. Note that in transparent mode, the device acts as an access-control bridge (a “bump in the wire”)—you assign different VLANs to each interface, but IP addressing is not necessary.
 
     [bookmark: pgfId-610413]The Add/Edit Interface dialog box presented for an independent ASA or PIX 7.0+ device in single-context, routed mode includes the section IP Type, where you specify the type of IP addressing for the interface and provide related parameters, as described here. (The IP Type section of the Add/Edit Interface dialog box for PIX 6.3 devices is described in Device Interface: IP Type (PIX 6.3).)
 
     [bookmark: pgfId-610415]In multiple-context mode, interface IP addresses are set in the context configuration.
 
      
       
     
 
     
 
     [bookmark: pgfId-610417]Note Do not use addresses previously used for routers, hosts, or any other firewall device commands, such as an IP address in the global pool or a static NAT entry.

Also, do not specify IP Type information for an interface you intend to use as a redundant interface.

     
      

     

     
 
     
 
     [bookmark: pgfId-610419]Step 1 In the Add/Edit Interface dialog box, choose a method for address assignment (Static IP, Use DHCP, or PPPoE (PIX and ASA 7.2+)) from the IP Type list, and then provide related parameters, as follows:
 
      
      	 [bookmark: pgfId-610421] Static IP – Provide a static  IP Address and  Subnet Mask that represents the security device on this interface’s connected network. The IP address must be unique for each interface.
 
     
 
     [bookmark: pgfId-610423]The Subnet mask can be expressed in dotted decimal format (for example, 255.255.255.0), or by entering the number of bits in the network mask (for example, 24). Do not use 255.255.255.254 or 255.255.255.255 for an interface connected to the network because this will stop traffic on that interface. If you omit the Subnet Mask value, a “classful” network is assumed, as follows:
 
     [bookmark: pgfId-610425] – The Class A netmask (255.0.0.0) is assumed if the first octet of the IP Address is 1 through 126 (i.e., addresses 1.0.0.0 through 126.255.255.255).
 
     [bookmark: pgfId-610427] – The Class B netmask (255.255.0.0) is assumed if the first octet of the IP Address is 128 through 191 (i.e., addresses 128.0.0.0 through 191.255.255.255).
 
     [bookmark: pgfId-610429] – The Class C netmask (255.255.255.0) is assumed if the first octet of the IP Address is 192 through 223 (i.e., addresses 192.0.0.0 through 223.255.255.255).
 
      
       
     
 
     
 
     [bookmark: pgfId-610431]Note Do not use addresses previously used for routers, hosts, or any other firewall device commands, such as an IP address in the global pool or a static NAT entry.

     
      

     

     
 
      
      	 [bookmark: pgfId-610433] Use DHCP – Enables Dynamic Host Configuration Protocol (DHCP) for automatic assignment of an IP address from a DHCP server on the connected network. The following options become available:
 
     
 
     [bookmark: pgfId-610435] – DHCP Learned Route Metric (required) – Assign an administrative distance to the learned route. Valid values are 1 to 255. The administrative distance for learned routes defaults to 1.
 
     [bookmark: pgfId-610437]All routes have a value or “metric” that represents its priority of use. (This metric is also referred to as “administrative distance.”) When two or more routes to the same destination are available, devices use administrative distance to decide which route to use.
 
     [bookmark: pgfId-610442] – Obtain Default Route using DHCP – Select this option to obtain a default route from the DHCP server so that you do not need to configure a default static route. See also Configuring Static Routes.
 
     [bookmark: pgfId-610444] – Enable Tracking for DHCP Learned Route – If Obtain Default Route using DHCP is selected, you can select this option to enable route tracking via a specific Service Level Agreement (SLA) monitor. The following option becomes available:
 
     [bookmark: pgfId-610449] – Tracked SLA Monitor – Required if Enable Tracking for DHCP Learned Route is selected. Enter or Select the name of the SLA monitor object that defines the route tracking (connectivity monitoring) to be applied to this interface. See Monitoring Service Level Agreements (SLAs) To Maintain Connectivity for more information.
 
      
      	 [bookmark: pgfId-610451] PPPoE (PIX and ASA 7.2+) – Enables Point-to-Point Protocol over Ethernet (PPPoE) for automatic assignment of an IP address from a PPPoE server on the connected network; this option is not supported with failover. The following options become available:
 
     
 
     [bookmark: pgfId-610456] – VPDN Group Name (required) – Choose the Virtual Private Dialup Network (VPDN) group that contains the authentication method and user name/password to use for network connection, negotiation and authentication. See Managing VPDN Groups for more information.
 
     [bookmark: pgfId-610458] – IP Address – If provided, this static IP address is used for connection and authentication, instead of a negotiated address.
 
     [bookmark: pgfId-610460] – Subnet Mask – The subnet mask to be used in conjunction with the provided IP Address.
 
     [bookmark: pgfId-610462] – PPPoE Learned Route Metric (required) – Assign an administrative distance to the learned route. Valid values are 1 to 255; defaults to 1.
 
     [bookmark: pgfId-610464]All routes have a value or “metric” that represents its priority of use. (This metric is also referred to as “administrative distance.”) When two or more routes to the same destination are available, devices use administrative distance to decide which route to use.
 
     [bookmark: pgfId-610466] – Obtain Default Route using PPPoE – Select this option to obtain a default route from the PPPoE server; sets the default routes when the PPPoE client has not yet established a connection. When using this option, you cannot have a statically defined route in the configuration.
 
     [bookmark: pgfId-610468] – Enable Tracking for PPPoE Learned Route – If Obtain Default Route using PPPoE is selected, you can select this option to enable route tracking for PPPoE-learned routes. The following options become available:
 
     [bookmark: pgfId-610470] – Dual ISP Interface – If you are defining interfaces for dual ISP support, choose Primary or Secondary to indicate which connection you are configuring.
 
     [bookmark: pgfId-610475] – Tracked SLA Monitor – Required if Enable Tracking for DHCP Learned Route is selected. Enter or Select the name of the SLA monitor object that defines the route tracking (connectivity monitoring) to be applied to this interface. See Monitoring Service Level Agreements (SLAs) To Maintain Connectivity for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-610477]Note You can configure DHCP and PPPoE only on the outside interface of a firewall device. If you have already configured PPPoE on the outside interface, it is no longer available as an option.

     
      

     

     
 
     [bookmark: pgfId-610482]Step 2 Continue configuring the device interface in the Add/Edit Interface Dialog Box (PIX 7.0+/ASA/FWSM).
 
     [bookmark: pgfId-610484]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-610498][bookmark: 108010][bookmark: pxchap_proc_Interfaces_MACAddress]Device Interface: MAC Address[bookmark: marker-610490][bookmark: marker-610492][bookmark: marker-610494][bookmark: marker-610496]
 
     [bookmark: pgfId-610500]By default, a physical interface uses its “burned-in” MAC address, and all subinterfaces of a physical interface use the same burned-in MAC address.
 
     [bookmark: pgfId-610502]A redundant interface uses the MAC address of the first physical interface that you add. If you change the order of the member interfaces in the configuration, then its MAC address changes to match the MAC address of the interface that is now listed first. If you manually assign a MAC address to the redundant interface, that is used regardless of the physical-interface MAC addresses.
 
     [bookmark: pgfId-610504]Similarly, all interfaces assigned to an EtherChannel group share the same MAC address. By default, the EtherChannel uses the MAC address of the lowest-numbered member interface. However, you can manually configure a MAC address for the EtherChannel to prevent traffic disruption should the low-numbered interface be removed from the group.
 
     [bookmark: pgfId-610506]You also might want to assign unique MAC addresses to subinterfaces. For example, your service provider might control access based on MAC addresses.
 
     [bookmark: pgfId-610508]Further, if you use failover, you can provide a standby MAC address. If the active unit fails over and the standby unit becomes active, the new active unit starts using the active MAC addresses to minimize network disruption, while the old active unit uses the standby address.
 
      
       
     
 
     
 
     [bookmark: pgfId-610510]Note The following options appear only on the Advanced tab of the Add Interface and Edit Interface dialog boxes presented by PIX 7.2+ and ASA 7.2+ devices.

     
      

     

     
 
     [bookmark: pgfId-610512](Optional) To manually assign a private MAC address to the current interface:
 
     
 
     [bookmark: pgfId-610514]Step 1 In the Add/Edit Interface dialog box, provide the desired MAC address in the Active MAC Address field.
 
     [bookmark: pgfId-610516]MAC addresses are provided in H.H.H format, where H is a 16-bit hexadecimal digit. For example, the MAC address 00-0C-F1-42-4C-DE would be entered as 000C.F142.4CDE.
 
      
       
     
 
     
 
     [bookmark: pgfId-610518]Note In some cases, you may have to press the Tab key after entering the Active MAC Address to activate the Standby MAC Address field.

     
      

     

     
 
     [bookmark: pgfId-610520]Step 2 If desired, provide a Standby MAC Address for use with device-level failover.
 
     [bookmark: pgfId-610522]If the active unit fails over and the standby unit becomes active, the new active unit begins using the active MAC addresses to minimize network disruption, while the old active unit uses the standby address.
 
     [bookmark: pgfId-610527]Step 3 Continue configuring the device interface in the Add/Edit Interface Dialog Box (PIX 7.0+/ASA/FWSM).
 
     [bookmark: pgfId-610529]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-610543][bookmark: 108054][bookmark: pxpage_cncpt_ConfigureHardwarePortsDialogBox]Configuring Hardware Ports on an ASA 5505[bookmark: marker-610537][bookmark: marker-610539][bookmark: marker-610541]
 
     [bookmark: pgfId-610545]The Interfaces page displayed for ASA 5505 devices presents two tabbed panels: Hardware Ports and Interfaces. The table on the Hardware Ports panel displays currently configured switch ports for the selected ASA 5505.
 
     [bookmark: pgfId-610547]Use the Configure Hardware Ports dialog box to configure the switch ports on an ASA 5505, including setting the mode, assigning a switch port to a VLAN, and setting the Protected option. (The following dialog-box parameter descriptions also describe the fields in the Hardware Ports table.)
 
      
       
     
 
     
 
     
      [bookmark: pgfId-610549]
      Caution The ASA 5505 does not support Spanning Tree Protocol for loop detection in the network. Therefore, you must ensure that any connection with the appliance does not end up in a network loop.
       
       
 
      

     
 
     [bookmark: pgfId-610551]Navigation Path
 
     [bookmark: pgfId-610556]You can access the Configure Hardware Ports dialog box by clicking Add Row or Edit Row on the Hardware Ports panel of the ASA 5505 Interfaces page. See Managing Device Interfaces, Hardware Ports, and Bridge Groups for more information.
 
     [bookmark: pgfId-610558]Related Topics
 
      
      	 [bookmark: pgfId-610563]Understanding ASA 5505 Ports and Interfaces
 
      	 [bookmark: pgfId-610568]Add/Edit Interface Dialog Box (PIX 7.0+/ASA/FWSM)
 
     
 
     [bookmark: pgfId-610570]Field Reference
 
     [bookmark: pgfId-610573]
 
      
       
        
        [bookmark: pgfId-607994]Table 46-11 [bookmark: 108089]Configure Hardware Ports Dialog Box 
 
        
       
         
         	
           
           [bookmark: pgfId-608000]Element
          
  
         	
           
           [bookmark: pgfId-608002]Description
          
  
        
 
         
         	[bookmark: pgfId-608008]Enable Interface
  
         	[bookmark: pgfId-608010]Select this option to enable this switch port. You can deselect this option to disable the port, but retain its configuration information.
  
        
 
         
         	[bookmark: pgfId-608016]Isolated
  
         	[bookmark: pgfId-608018]Select this option to prevent this port from communicating with other isolated or “protected” switch ports on the same VLAN.
 [bookmark: pgfId-608020]You might want to prevent switch ports from communicating with each other if the devices on those ports are primarily accessed from other VLANs, if you do not need to allow intra-VLAN access, and you want to isolate the devices from each other in case of infection or other security breach. For example, if you have a DMZ that hosts three Web servers, you can isolate the Web servers from each other if you apply the Isolated option to each switch port. The inside and outside networks can both communicate with all three Web servers, and vice versa, but the Web servers cannot communicate with each other.
  
        
 
         
         	[bookmark: pgfId-608026]Hardware Port
  
         	[bookmark: pgfId-608028]Choose the switch port that you are configuring; all device ports are listed.
  
        
 
         
         	[bookmark: pgfId-608034]Mode
  
         	[bookmark: pgfId-608036]Choose a mode for this port:
 
           
           	 [bookmark: pgfId-608038] Access Port – Sets the port to access mode. Each access port can be assigned to one VLAN.
 
           	 [bookmark: pgfId-608040] Trunk Port – Sets the port to trunk mode using 802.1Q tagging. Trunk ports can carry multiple VLANs using 802.1Q tagging.
 
          
 [bookmark: pgfId-608042]Trunk mode is available only with the Security Plus license. Trunk ports do not support untagged packets, there is no native VLAN support, and the appliance drops all packets that do not contain a tag.
  
        
 
         
         	[bookmark: pgfId-608048]VLAN ID
  
         	[bookmark: pgfId-608050]Enter VLAN ID(s) for this port, according to the chosen Mode:
 
           
           	 [bookmark: pgfId-608052]For Access Port mode, enter the ID of the VLAN to which this switch port is to be assigned.
 
           	 [bookmark: pgfId-608054]For Trunk Port mode, you can enter multiple VLAN IDs, and multiple ID ranges (such as 4-8), separated by commas.
 
          
 [bookmark: pgfId-608056]Note For devices running operating system 7.2(2)18 or earlier, valid VLAN IDs are 1 to 1001; with version 7.2(2)19 or later, valid IDs are 1 to 4090.
  
        
 
         
         	[bookmark: pgfId-608062]Duplex
  
         	[bookmark: pgfId-608064]Choose a duplex option for the port: Full, Half, or Auto. The Auto setting is recommended, and the default.
 [bookmark: pgfId-608066]If you set Duplex to anything other than Auto for PoE ports Ethernet 0/6 or 0/7, then Cisco IP phones and Cisco wireless access points that do not support IEEE 802.3af will not be detected and supplied with power.
  
        
 
         
         	[bookmark: pgfId-608072]Speed
  
         	[bookmark: pgfId-608074]Choose a speed for the port: 10, 100, or Auto. The Auto setting is recommended, and the default.
 [bookmark: pgfId-608076]If you set Speed to anything other than Auto for PoE ports Ethernet 0/6 or 0/7, then Cisco IP phones and Cisco wireless access points that do not support IEEE 802.3af will not be detected and supplied with power.
 [bookmark: pgfId-608078]The default Auto setting also includes the Auto-MDI/MDIX feature. Auto-MDI/MDIX eliminates the need for crossover cabling by performing an internal crossover when a straight cable is detected during the auto-negotiation phase. Either Speed or Duplex must be set to Auto to enable Auto-MDI/MDIX for the interface. If you explicitly set both Speed and Duplex to a fixed value, thus disabling auto-negotiation for both settings, then Auto-MDI/MDIX is also disabled.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-610587][bookmark: 108159][bookmark: pxpage_cncpt_AddEditBridgeGroupDialogBox]Add/Edit Bridge Group Dialog Box [bookmark: marker-610581][bookmark: marker-610583][bookmark: marker-610585]
 
     [bookmark: pgfId-610589]A transparent firewall connects the same network on its inside and outside interfaces, and supports only the two interfaces per context. However, you can increase the number of interfaces available to a context through use of bridge groups. You can configure up to eight bridge groups; on an FWSM each group can contain two interfaces; on an ASA each group can contain four interfaces.
 
     [bookmark: pgfId-610591]Each bridge group connects to a separate network. Bridge group traffic is isolated from other bridge groups; traffic is not routed to another bridge group within the security appliance—traffic must exit the security appliance to be routed by an external router back to another bridge group in the security appliance.
 
     [bookmark: pgfId-610593]You might want to use more than one bridge group if you do not want the overhead of security contexts, or want to maximize your use of security contexts. Although the bridging functions are separate for each bridge group, many other functions are shared between all bridge groups. For example, all bridge groups share a syslog server or AAA server configuration. For complete security policy separation, use security contexts with one bridge group in each context.
 
     [bookmark: pgfId-610598]For FWSM 3.1+ and ASA 8.4.1+ devices in transparent mode, the Interfaces page displays two tabbed panels: Interfaces and Bridge Groups. The following information applies to the Bridge Groups panel and the Add/Edit Bridge Group dialog box; refer to Add/Edit Interface Dialog Box (PIX 7.0+/ASA/FWSM) for information about the Interfaces panel.
 
     [bookmark: pgfId-610600]Navigation Path
 
     [bookmark: pgfId-610602]You can access the Add/Edit Bridge Group dialog box from the Bridge Groups panel of the Interfaces page.
 
     [bookmark: pgfId-610604]Related Topics
 
      
      	 [bookmark: pgfId-610609]Interfaces in Routed and Transparent Modes
 
      	 [bookmark: pgfId-610614]Bridging Support for FWSM 3.1
 
      	 [bookmark: pgfId-610619]Managing Device Interfaces, Hardware Ports, and Bridge Groups
 
     
 
     [bookmark: pgfId-610621]Field Reference
 
     [bookmark: pgfId-610624]
 
      
       
        
        [bookmark: pgfId-608091]Table 46-12 [bookmark: 108197]Add/Edit Bridge Group Dialog Box 
 
        
       
         
         	
           
           [bookmark: pgfId-608097]Element
          
  
         	
           
           [bookmark: pgfId-608099]Description
          
  
        
 
         
         	[bookmark: pgfId-608105]Name
  
         	[bookmark: pgfId-608107]Enter a name for this bridge group.
  
        
 
         
         	[bookmark: pgfId-608113]ID
  
         	[bookmark: pgfId-608115]Enter an identifier for this bridge group; can be an integer between 1 and 100.
  
        
 
         
         	[bookmark: pgfId-608121]Interface A
  
         	[bookmark: pgfId-608123]Choose the first interface or VLAN to assign to this bridge group; all interfaces defined on the Interfaces panel are listed.
  
        
 
         
         	[bookmark: pgfId-608129]Interface B
  
         	[bookmark: pgfId-608131]Choose the second interface or VLAN to assign to this bridge group; all interfaces defined on the Interfaces panel are listed.
  
        
 
         
         	[bookmark: pgfId-608137]Interface C
 [bookmark: pgfId-608139]Interface D
  
         	[bookmark: pgfId-608141]Choose the third and fourth interfaces or VLANs to assign to this bridge group; all interfaces defined on the Interfaces panel are listed.
 [bookmark: pgfId-608143]Note These two options are available only on ASA 8.4.1 and later devices operating in transparent mode.
  
        
 
         
         	[bookmark: pgfId-608149]IP Address
  
         	[bookmark: pgfId-608151]Enter or Select a management IP address for the bridge group. A transparent firewall does not participate in IP routing. Thus, the only IP configuration required for a bridge group is this management IP address. This address is the source address for traffic originating on the security appliance, such as system messages or communications with AAA servers. You can also use this address for remote management access.
 [bookmark: pgfId-608153]Note IPv6 addresses are not supported for bridge groups.
  
        
 
         
         	[bookmark: pgfId-608159]Netmask
  
         	[bookmark: pgfId-608161]Network mask for the specified IP address. You can express the value in dotted decimal format (for example, 255.255.255.0) or by entering the number of bits in the network mask (for example, 24).
 [bookmark: pgfId-608163]Note Do not use 255.255.255.254 or 255.255.255.255 for an interface connected to the network because this will stop traffic on that interface.
  
        
 
         
         	[bookmark: pgfId-608169]Description
  
         	[bookmark: pgfId-608171]You can enter an optional description for this bridge group.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-610638][bookmark: 108254][bookmark: pxpage_cncpt_AdvancedInterfaceSettingsDialogBox-2]Advanced Interface Settings (PIX/ASA/FWSM)[bookmark: marker-610632][bookmark: marker-610634][bookmark: marker-610636]
 
     [bookmark: pgfId-610640]Advanced configuration options are available for interfaces on FWSMs and ASA/PIX 7.0+ devices operating in single-context mode and for ASA 9.0+ devices operating in single-context mode or multi-context mode.
 
     [bookmark: pgfId-610642]These are general device-related settings; that is, they are not applied to individual interfaces.
 
      
       
     
 
     
 
     [bookmark: pgfId-610644]Note The information in this section does not apply to PIX 6.3 devices, nor to security devices in multiple-context mode.

     
      

     

     
 
     [bookmark: pgfId-610646]The Advanced Interface Settings dialog box includes the following elements:
 
      
      	 [bookmark: pgfId-610648] MAC Address Auto - Enable this option to automatically assign private MAC addresses to each shared context interface. You can also, optionally, set a user-defined prefix as part of the MAC address. The prefix is a decimal value between 0 and 65535. If you do not enter a prefix, then the ASA generates a default prefix. This prefix is converted to a 4-digit hexadecimal number. The prefix ensures that each ASA uses unique MAC addresses (using different prefix values), so you can have multiple ASAs on a network segment, for example.
 
      	 [bookmark: pgfId-610653] Traffic between interfaces with same security levels – This parameter controls communication between interfaces and subinterfaces on the same security level. If you enable same security interface communication, you can still configure interfaces at different security levels as usual. Refer to Enabling Traffic between Interfaces with the Same Security Level for more information.
 
      	 [bookmark: pgfId-610658] PPPoE Users button – Click this button to open the PPPoE Users dialog box, where you can add, edit and delete PPPoE users, as described in Managing the PPPoE Users List. This option is available only for ASA and PIX 7.0+ devices.
 
      	 [bookmark: pgfId-610663] VPDN Groups (PIX and ASA 7.2+) – This table lists currently defined VPDN Groups. The buttons below the table are used to add, edit and delete VPDN group entries, as described in Managing VPDN Groups.
 
      	 [bookmark: pgfId-610665] LACP System Priority (ASA 8.4.1+) – All systems participating in EtherChannel link aggregation require a Link Aggregation Control Protocol (LACP) System Priority. The value can be 1 to 65535, with the higher number signifying lower priority. The default is 32768.
 
     
 
     [bookmark: pgfId-610670]This value is combined with the system MAC address to form the system’s LACP identifier, and thus is applicable only for EtherChannel interfaces. See Configuring EtherChannels, for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-610675]Note Additional LACP parameters are available in the Edit Interface dialog box for individual interfaces assigned to an EtherChannel; see Editing LACP Parameters for an Interface Assigned to an EtherChannel, for more information.

     
      

     

     
 
      
      	 [bookmark: pgfId-610677] Static Port Priority (ASA 9.2.1+ Cluster in Spanned mode) – Disables dynamic port priority in LACP. Some switches do not support dynamic port priority, so this parameter improves switch compatibility. Enabling static port priority enables support of 16 active spanned EtherChannel members. Without this parameter, only 8 active members and 8 standby members are supported. If you enable this parameter, then you cannot use any standby members; all members are active. This parameter is not part of the bootstrap configuration, and is replicated from the master unit to the slave units.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-610679]Note If you enable Static Port Priority, 16 nodes can be part of a cluster instead of 8 nodes.

     
      

     

     
 
     [bookmark: pgfId-610681]Navigation Path
 
     [bookmark: pgfId-610683]You can open the Advanced Interface Settings dialog box by clicking the Advanced button at the bottom of the Interfaces page (for non-5505 ASAs, PIX 7.0+ devices, and FWSMs), or at the bottom of the Interfaces tab on the ASA 5505 Ports and Interfaces page.
 
     [bookmark: pgfId-610685]Related Topics
 
      
      	 [bookmark: pgfId-610690]Managing Device Interfaces, Hardware Ports, and Bridge Groups
 
     
 
    
 
     
      [bookmark: pgfId-610698][bookmark: 108309][bookmark: pxchap_proc_EnablingTrafficbetweenInterfaceswiththeSameSecurityLevel]Enabling Traffic between Interfaces with the Same Security Level[bookmark: marker-610696]
 
     [bookmark: pgfId-610703]The Advanced Interface Settings (PIX/ASA/FWSM) dialog box presented for a single-context security device includes the “Traffic between interfaces with the same security level” drop-down list, as described in this section.
 
     [bookmark: pgfId-610705]By default, interfaces or subinterfaces on the same security level cannot communicate with each other. Allowing communication between same-security interfaces provides the following benefits:
 
      
      	 [bookmark: pgfId-610707]You can configure more than 101 communicating interfaces.
 
     
 
     [bookmark: pgfId-610709]If you use different levels for each interface and do not assign any interfaces to the same security level, you can configure only one interface per level (0 to 100).
 
      
      	 [bookmark: pgfId-610711]You can allow traffic to flow freely between all same-security interfaces without access lists.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-610713]Note If you enable NAT control, you do not need to configure NAT between same-security-level interfaces.

     
      

     

     
 
     
 
     [bookmark: pgfId-610715]Step 1 In the Advanced Interface Settings dialog box, choose the option that identifies how you want this device to handle Traffic between interfaces with the same security levels:
 
      
      	 [bookmark: pgfId-610717] Disabled —Communication between interfaces on the same security level is not allowed.
 
      	 [bookmark: pgfId-610719] Inter-interface —Enables traffic flows between interfaces with the same security level setting. When this option is enabled, you are not required to define translation rules to enable traffic flow between interfaces in the firewall device.
 
      	 [bookmark: pgfId-610721] Intra-interface —Enables traffic flows between subinterfaces with the same security level setting. When this option is enabled, you are not required to define translation rules to enable traffic flow between subinterfaces assigned to an interface.
 
      	 [bookmark: pgfId-610723] Both —Allows both intra- and inter-interface communications among interfaces and subinterfaces with the same security level.
 
     
 
     [bookmark: pgfId-610728]Step 2 Continue with Advanced Interface Settings (PIX/ASA/FWSM) configuration, or click OK to close the Advanced Interface Settings dialog box.
 
     [bookmark: pgfId-610730]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-610748][bookmark: 108352][bookmark: pxchap_proc_AddEditPPPoEUsers]Managing the PPPoE Users List[bookmark: marker-610740][bookmark: marker-610742][bookmark: marker-610744][bookmark: marker-610746]
 
     [bookmark: pgfId-610753]Point-to-Point Protocol over Ethernet (PPPoE) allows standard PPP communication between a security device and an external ISP, via an Ethernet interface on the device. To establish a communication link, the device must provide authentication credentials and obtain network parameters. This is accomplished using a Virtual Private Dialup Network (VPDN) group, which basically consists of established PPPoE user credentials (i.e., a user name and password) and an authentication protocol. See Managing VPDN Groups for more information about VPDN groups.
 
     [bookmark: pgfId-610758]The PPPoE user credentials available for use with VPDN groups are maintained in the PPPoE Users dialog box, which you can access from the Advanced Interface Settings (PIX/ASA/FWSM) dialog box, and from the Add/Edit VPND Group dialog boxes.
 
     [bookmark: pgfId-610760]Adding and Editing PPPoE Users
 
     [bookmark: pgfId-610762]The PPPoE Users dialog box presents a table of currently defined PPPoE users, along with standard Add Row, Edit Row, and Delete Row buttons. The Add Row button opens the Add PPPoE User dialog box; the Edit Row button opens the virtually identical Edit PPPoE User dialog box.
 
     [bookmark: pgfId-610764]Enter or edit the following PPPoE user parameters, and then click OK to close the Add (Edit) PPPoE User dialog box and return to the Advanced Interface Settings dialog box.
 
      
       
     
 
     
 
     [bookmark: pgfId-610766]Note PPPoE user options are not available on Firewall Service Modules (FWSMs).

     
      

     

     
 
     [bookmark: pgfId-610768]Field Reference
 
     [bookmark: pgfId-610771]
 
      
       
        
        [bookmark: pgfId-608184]Table 46-13 [bookmark: 108382]Add and Edit PPPoE User Dialog Boxes 
 
        
       
         
         	
           
           [bookmark: pgfId-608190]Element
          
  
         	
           
           [bookmark: pgfId-608192]Description
          
  
        
 
         
         	[bookmark: pgfId-608198]Username
  
         	[bookmark: pgfId-608200]The name assigned to this user account; generally provided by the external ISP.
  
        
 
         
         	[bookmark: pgfId-608206]Password
  
         	[bookmark: pgfId-608208]The password assigned to this user account; also generally provided by the external ISP.
  
        
 
         
         	[bookmark: pgfId-608214]Confirm
  
         	[bookmark: pgfId-608216]Re-enter the password.
  
        
 
         
         	[bookmark: pgfId-608222]Store Username and Password in Local Flash
  
         	[bookmark: pgfId-608224]If checked, this PPPoE user information will be stored in the device’s local flash memory, ensuring it cannot be inadvertently overwritten.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-610787][bookmark: 108413][bookmark: pxchap_proc_AddEditVPDNGroups]Managing VPDN Groups[bookmark: marker-610779][bookmark: marker-610781][bookmark: marker-610783][bookmark: marker-610785]
 
     [bookmark: pgfId-610792]A Virtual Private Dialup Network (VPDN) group—basically an established PPPoE user and an authentication protocol—is used by a security device to contact an external ISP and authenticate itself, in order to establish a PPPoE communications link and obtain network parameters. (See Managing the PPPoE Users List for information about establishing PPPoE users.)
 
     [bookmark: pgfId-610797]Available VPDN groups are maintained in the Advanced Interface Settings dialog box, which opens when you click the Advanced button at the bottom of the Interfaces page, as described in Advanced Interface Settings (PIX/ASA/FWSM).
 
     [bookmark: pgfId-610799]Adding and Editing VPND Groups
 
     [bookmark: pgfId-610801]The Advanced Interface Settings dialog box includes a table of currently defined VPDN groups, and standard Add Row, Edit Row, and Delete Row buttons. The Add Row button opens the Add VPDN Group dialog box; the Edit Row button opens the virtually identical Edit VPDN Group dialog box.
 
     [bookmark: pgfId-610803]Enter or edit the following VPDN group parameters, and then click OK to close the Add (Edit) VPDN Group dialog box and return to the Advanced Interface Settings dialog box.
 
      
       
     
 
     
 
     [bookmark: pgfId-610805]Note VPDN group options are not available on Firewall Service Modules (FWSMs).

     
      

     

     
 
     [bookmark: pgfId-610807]Field Reference
 
     [bookmark: pgfId-610810]
 
      
       
        
        [bookmark: pgfId-608237]Table 46-14 [bookmark: 108442]Add and Edit VPND Group Dialog Boxes 
 
        
       
         
         	
           
           [bookmark: pgfId-608243]Element
          
  
         	
           
           [bookmark: pgfId-608245]Description
          
  
        
 
         
         	[bookmark: pgfId-608251]Group Name
  
         	[bookmark: pgfId-608253]A name to identify this group in Security Manager; up to 63 characters.
  
        
 
         
         	[bookmark: pgfId-608259]PPPoE Username
  
         	[bookmark: pgfId-608261]The name identifying the PPPoE credentials to be used by this group for authentication with an ISP; choose from the list of available PPPoE users.
 [bookmark: pgfId-608266]Choose Edit User from this list to open the PPPoE Users dialog box, where you can add or edit a user for this option. Refer to Managing the PPPoE Users List for information about creating and editing users.
  
        
 
         
         	[bookmark: pgfId-608272]PPP Authentication
  
         	[bookmark: pgfId-608274]Select the PPP Authentication method:
 
           
           	 [bookmark: pgfId-608276] PAP – Password Authentication Protocol, with exchange of credentials in clear text.
 
           	 [bookmark: pgfId-608278] CHAP – Challenge Handshake Authentication Protocol, with encrypted credential exchange.
 
           	 [bookmark: pgfId-608280] MSCHAP – Microsoft’s CHAP, version 1 only.
 
          
  
        
 
       
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-610826][bookmark: 108483][bookmark: pxchap_cncpt_VXLAN]VXLAN[bookmark: marker-610818][bookmark: marker-610820][bookmark: marker-610822][bookmark: marker-610824]
 
    [bookmark: pgfId-610828]Virtual eXtensible LANs (VXLAN) act as Layer 2 virtual networks over Layer 3 physical networks to stretch Layer 2 networks. VXLAN provides the same Ethernet Layer 2 network services as VLAN does, but with greater extensibility and flexibility. Compared to VLAN, VXLAN offers the following benefits:
 
     
     	 [bookmark: pgfId-610830]Flexible placement of multitenant segments throughout the data center.
 
     	 [bookmark: pgfId-610832]Higher scalability to address more Layer 2 segments—up to 16 million VXLAN segments.
 
    
 
    [bookmark: pgfId-610834]Beginning with version 4.9, Security Manager supports VXLAN for ASA, ASAv, and ASASM devices on version 9.4(1) and higher.
 
     
      
    
 
    
 
    [bookmark: pgfId-610836]Note VxLAN is not supported on IOS, FWSM, ASR, or ISR devices.

    
     

    

    
 
    [bookmark: pgfId-610838]To configure VXLAN, follow these steps:
 
    [bookmark: pgfId-610843] 1. Configuring VXLAN Policy
 
    [bookmark: pgfId-610848] 2. Create a Configuring VNI Interfaces and associate the configured VXLAN policy to the VNI interface.
 
     
      [bookmark: pgfId-610862][bookmark: 108518][bookmark: pxchap_cncpt_Configuring_vxlan_policy]Configuring VXLAN Policy[bookmark: marker-610854][bookmark: marker-610856][bookmark: marker-610858][bookmark: marker-610860]
 
     [bookmark: pgfId-610864]To configure VXLAN you must first configure VXLAN policy and then create a VNI interface and associate the configured VXLAN policy to the VNI interface. This section describes how to configure VXLAN policy.
 
     [bookmark: pgfId-610866]Navigation Path
 
     [bookmark: pgfId-610868]To access the VXLAN page, go to Device View, select an ASA, ASAv, or ASASM device and then click VxLAN from Policies.
 
     [bookmark: pgfId-610870]Related Topics
 
      
      	 [bookmark: pgfId-610875]VXLAN
 
      	 [bookmark: pgfId-610880]Configuring VNI Interfaces
 
     
 
     [bookmark: pgfId-610882]Field Reference
 
     [bookmark: pgfId-610885]
 
      
       
        
        [bookmark: pgfId-608293]Table 46-15 [bookmark: 108555]VxLAN 
 
        
       
         
         	
           
           [bookmark: pgfId-608299]Element
          
  
         	
           
           [bookmark: pgfId-608301]Description
          
  
        
 
         
         	[bookmark: pgfId-608307]Enable VXLAN Port Number
 [bookmark: pgfId-608309]VXLAN Destination Port
  
         	[bookmark: pgfId-608311]Check this box if you want to change the value of the VXLAN Destination Port from the default 4789. If checked, enter a numeric value in the range from 1024 to 65535.
  
        
 
         
         	 
           
           [bookmark: pgfId-608317]Network Virtualization Endpoint (NVE)
          
  
        
 
         
         	[bookmark: pgfId-608325]Enable NVE
  
         	[bookmark: pgfId-608327]When selected, it enables you to select the VTEP Tunnel Interface.
  
        
 
         
         	[bookmark: pgfId-608333]VXLAN NVE No
  
         	[bookmark: pgfId-608335]The value of VXLAN NVE Number is "1". You cannot edit this value.
  
        
 
         
         	[bookmark: pgfId-608341]Enable NVE Encapsulation
  
         	[bookmark: pgfId-608343]Select this checkbox to enable NVE Encapsulation using VXLAN.
  
        
 
         
         	[bookmark: pgfId-608349]VTEP Tunnel Interface
  
         	[bookmark: pgfId-608351]Click Select and choose the VTEP Tunnel Interface.
  
        
 
         
         	[bookmark: pgfId-608357]Enable VTEP IP Address Or Multicast Traffic Address
  
         	[bookmark: pgfId-608359]Select one of the following:
 
           
           	 [bookmark: pgfId-608361]Peer VTEP IP Address—Manually specify the peer VTEP IP address. If you specify the peer IP address, you cannot use multicast group discovery. Multicast is not supported in multiple context mode. You can only specify one peer for the VTEP. Note that the peer VTEP IP address must be reachable from the VTEP Tunnel Interface, else deployment will fail. If you have used peer IP address in VXLAN policy, you cannot configure multicast IP address on the Interface page, including the VNI interface.
 
           	 [bookmark: pgfId-608363]Default Multicast IP Address—Specify a default multicast group for all associated VNI interfaces. The range of IP addresses is from 224.0.0.0 to 239.255.255.255. If you do not configure the multicast group per VNI interface, then this group is used. If you configure a group at the VNI interface level, then that group overrides this setting.
 
          
  
        
 
         
         	[bookmark: pgfId-608369]Save
  
         	[bookmark: pgfId-608371]Click Save to save the VXLAN settings.
  
        
 
       
      
 
     
 
    
 
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-665063][bookmark: 132365][bookmark: rtchap_cncpt_ManagingIPSServices]Managing Routers[bookmark: marker-665057][bookmark: marker-665059][bookmark: marker-665061]
      
      
 
     
 
 
    [bookmark: pgfId-665068]Cisco Security Manager supports the management and configuration of security features and other platform-specific features on Cisco IOS access security routers. You configure these features in the form of policies, each of which defines a different aspect of the configuration of the router. For a detailed explanation of the policy paradigm used by Security Manager, see Chapter 5, “Managing Policies”.
 
    [bookmark: pgfId-665073]You can discover the configurations that are already defined on Cisco IOS routers. The discovery process imports the device configuration into Security Manager as policies and policy objects that you can then manage as required. For more information, see Discovering Router Policies.
 
     
      
    
 
    
 
    [bookmark: pgfId-665078]Note Security Manager supports Cisco IOS Software Releases 12.3 and higher. However, a limited number of policies are supported for routers running Cisco IOS Software Release 12.1 or 12.2. See Configuring Routers Running IOS Software Releases 12.1 and 12.2.

    
     

    

    
 
    [bookmark: pgfId-665080]By right-clicking a policy type in one of the policy selectors, you can assign a policy to a single router, share the policy among multiple routers, or unassign the policy from the device.
 
    [bookmark: pgfId-665082]The following topics describe how to configure platform policies and interface policies on Cisco IOS routers:
 
     
     	 [bookmark: pgfId-665084]Interface polices:
 
    
 
    [bookmark: pgfId-665089] – Basic Interface Settings on Cisco IOS Routers
 
    [bookmark: pgfId-665094] – Advanced Interface Settings on Cisco IOS Routers
 
    [bookmark: pgfId-665099] – IPS Module Interface Settings on Cisco IOS Routers
 
    [bookmark: pgfId-665104] – CEF Interface Settings on Cisco IOS Routers
 
    [bookmark: pgfId-665109] – Dialer Interfaces on Cisco IOS Routers
 
    [bookmark: pgfId-665114] – ADSL on Cisco IOS Routers
 
    [bookmark: pgfId-665119] – SHDSL on Cisco IOS Routers
 
    [bookmark: pgfId-665124] – PVCs on Cisco IOS Routers
 
    [bookmark: pgfId-665129] – PPP on Cisco IOS Routers
 
     
     	 [bookmark: pgfId-665131]Device administration policies:
 
    
 
    [bookmark: pgfId-665136] – AAA on Cisco IOS Routers
 
    [bookmark: pgfId-665141] – User Accounts and Device Credentials on Cisco IOS Routers
 
    [bookmark: pgfId-665146] – Bridging on Cisco IOS Routers
 
    [bookmark: pgfId-665151] – Time Zone Settings on Cisco IOS Routers
 
    [bookmark: pgfId-665156] – CPU Utilization Settings on Cisco IOS Routers
 
    [bookmark: pgfId-665161] – HTTP and HTTPS on Cisco IOS Routers
 
    [bookmark: pgfId-665166] – Line Access on Cisco IOS Routers
 
    [bookmark: pgfId-665171] – Optional SSH Settings on Cisco IOS Routers
 
    [bookmark: pgfId-665176] – SNMP on Cisco IOS Routers
 
    [bookmark: pgfId-665181] – DNS on Cisco IOS Routers
 
    [bookmark: pgfId-665186] – Hostnames and Domain Names on Cisco IOS Routers
 
    [bookmark: pgfId-665191] – Memory Settings on Cisco IOS Routers
 
    [bookmark: pgfId-665196] – Secure Device Provisioning on Cisco IOS Routers
 
    [bookmark: pgfId-665201] – DHCP on Cisco IOS Routers
 
    [bookmark: pgfId-665206] – NTP on Cisco IOS Routers
 
     
     	 [bookmark: pgfId-665208]Identity policies:
 
    
 
    [bookmark: pgfId-665213] – 802.1x on Cisco IOS Routers
 
    [bookmark: pgfId-665218] – Network Admission Control on Cisco IOS Routers
 
     
     	 [bookmark: pgfId-665220]Logging policies:
 
    
 
    [bookmark: pgfId-665225] – Logging on Cisco IOS Routers
 
     
     	 [bookmark: pgfId-665227]Quality of Service:
 
    
 
    [bookmark: pgfId-665232] – Quality of Service on Cisco IOS Routers
 
     
     	 [bookmark: pgfId-665234]Routing policies:
 
    
 
    [bookmark: pgfId-665239] – BGP Routing on Cisco IOS Routers
 
    [bookmark: pgfId-665244] – EIGRP Routing on Cisco IOS Routers
 
    [bookmark: pgfId-665249] – OSPF Routing on Cisco IOS Routers
 
    [bookmark: pgfId-665254] – RIP Routing on Cisco IOS Routers
 
    [bookmark: pgfId-665259] – Static Routing on Cisco IOS Routers
 
     
      
    
 
    
 
    [bookmark: pgfId-665261]Note The settings on the Policy Management page of the Security Manager Administration window determine which router platform policies can be managed with Security Manager. Any policy type that you do not select in this window does not appear on the configuration pages of Security Manager.

    
     

    

    
 
   
 
    
     [bookmark: pgfId-665273][bookmark: 132504][bookmark: rtchap_cncpt_ConfiguringRoutersRunningIOSSoftwareReleasesand]Configuring Routers Running IOS Software Releases 12.1 and 12.2[bookmark: marker-665267][bookmark: marker-665269][bookmark: marker-665271]
 
    [bookmark: pgfId-665275]Security Manager provides limited support for routers running Cisco IOS Software Releases 12.1 and 12.2 (with the exception of the ASR 1000 Series, which supports more features). You can configure the following policies on these routers:
 
     
     	 [bookmark: pgfId-665280]Access Rules (Layer 3 only). See Chapter 16, “Managing Firewall Access Rules”.
 
     	 [bookmark: pgfId-665285]Access Rule Settings. See Chapter 16, “Managing Firewall Access Rules”.
 
     	 [bookmark: pgfId-665290]Interfaces. See Basic Interface Settings on Cisco IOS Routers.
 
     	 [bookmark: pgfId-665295]FlexConfigs. See Chapter 7, “Managing FlexConfigs”.
 
    
 
    [bookmark: pgfId-665299]All other policies require Cisco IOS Software Release 12.3 or higher. For more information about supported devices, see Supported Devices and Software Versions for Cisco Security Manager.
 
   
 
    
     [bookmark: pgfId-665309][bookmark: 132533][bookmark: rtchap_cncpt_DiscoveringRouterPolicies]Discovering Router Policies[bookmark: marker-665305][bookmark: marker-665307]
 
    [bookmark: pgfId-665314]You can discover the configurations of your Cisco IOS routers and import these configurations as policies into Security Manager. This makes it possible to add existing devices and manage them with Security Manager without having to manually configure each device policy by policy. For more information, see Adding Devices to the Device Inventory.
 
    [bookmark: pgfId-665316]You can discover all Cisco IOS commands that can be configured with Security Manager. Discovery ignores unsupported commands, which means that they are left intact on the device even after subsequent deployments. Additionally, in cases where Security Manager can discover the command, but not all the subcommands and keywords related to that command, the unsupported elements are ignored and left intact on the device.
 
    [bookmark: pgfId-665321]You can also rediscover the configurations of devices that you are already managing with Security Manager at any time. Be aware, however, that performing rediscovery overwrites the policies that you have defined in Security Manager, and is therefore not generally recommended. For more information, see Discovering Policies on Devices Already in Security Manager.
 
     
      
    
 
    
 
    [bookmark: pgfId-665323]Note We recommend that you perform deployment immediately after you discover the policies on a Cisco IOS router, before you make any changes to policies or unassign policies from the device. Otherwise, the changes that you configure in Security Manager might not be deployed to the device.

    
     

    

    
 
     
      
    
 
    
 
    [bookmark: pgfId-665325]Note If a policy that is not configured in Security Manager was configured on the device using an out-of-band method (such as the CLI) between the time of the first discovery and rediscovery, we recommend that you perform deployment immediately after rediscovery.

    
     

    

    
 
    [bookmark: pgfId-665327]Related Topics
 
     
     	 [bookmark: pgfId-665332]Understanding Policies
 
     	 [bookmark: pgfId-665337]Discovering Policies
 
     	 [bookmark: pgfId-665342]Working with Deployment and the Configuration Archive
 
    
 
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-435059][bookmark: 156361][bookmark: evntchap_intro_ViewingEvents]Viewing Events[bookmark: marker-435057]
      
      
 
     
 
 
    [bookmark: pgfId-435061]Event Viewer enables you to selectively monitor, view, and examine events from ASA (including ASA-SM), FWSM and IPS devices. Events are organized into views that you can filter or search to find events that interest you. You can create customized views and filters to fit your needs, or use the predefined views included in the application.
 
    [bookmark: pgfId-435063]This chapter contains the following topics:
 
     
     	 [bookmark: pgfId-435068]Introduction to Event Viewer Capabilities
 
     	 [bookmark: pgfId-435073]Overview of Event Viewer
 
     	 [bookmark: pgfId-435078]Preparing for Event Management
 
     	 [bookmark: pgfId-435083]Managing the Event Manager Service
 
     	 [bookmark: pgfId-435088]Using Event Viewer
 
     	 [bookmark: pgfId-435093]Examples of Event Analysis
 
    
 
   
 
    
     [bookmark: pgfId-435101][bookmark: 156367][bookmark: evntchap_intro_IntroductiontoEventViewerCapabilities]Introduction to Event Viewer Capabilities[bookmark: marker-435099]
 
    [bookmark: pgfId-435103]Event Viewer monitors your network for syslog (system log) events from ASA and FWSM devices and security contexts and SDEE (Secure Device Event Exchange) events from IPS devices and virtual sensors. Event Viewer collects these events and provides an interface by which you can view them, group them, and examine their details.
 
     
      
    
 
    
 
    [bookmark: pgfId-435108]Note Beginning with version 4.5, Security Manager enables you to forward syslogs to one local collector and two remote collectors. For more information, see Event Management Page.

    
     

    

    
 
     
      
    
 
    
 
    [bookmark: pgfId-435110]Tip Event Viewer and its related applications, Report Manager and Health and Performance Monitor, are useful for operational monitoring and troubleshooting of certain types of Cisco devices in your network. These applications do not provide extensive event correlation, compliance reporting, long-term forensics, or the integrated monitoring of both Cisco and non-Cisco devices.

    
     

    

    
 
    [bookmark: pgfId-435112]When working with IPS events, the Report Manager component of Cisco Security Manager reports events individually; the Event Viewer component of Cisco Security Manager displays alerts. In the Event Viewer component, the IPS Summarizer groups events into a single alert, thus decreasing the number of alerts that the IPS sensor sends out.
 
     
      
    
 
    
 
    [bookmark: pgfId-435114]Tip Cisco IPS Manager Express (IME) and Cisco Security Manager do not summarize events in precisely the same way.

    
     

    

    
 
    [bookmark: pgfId-435116]This section briefly describes some key activities that Event Viewer can facilitate.
 
    [bookmark: pgfId-435118]This section contains the following topics:
 
     
     	 [bookmark: pgfId-435123]Historical View
 
     	 [bookmark: pgfId-435128]Real-Time View
 
     	 [bookmark: pgfId-435133]Views and Filters
 
     	 [bookmark: pgfId-435138]Policy Navigation
 
     	 [bookmark: pgfId-435143]Understanding Event Viewer Access Control
 
     	 [bookmark: pgfId-435148]Scope and Limits of Event Viewer
 
     	 [bookmark: pgfId-435153]Deeply Parsed Syslogs
 
    
 
     
      [bookmark: pgfId-435161][bookmark: 156381][bookmark: evntchap_cncpt_HistoricalView]Historical View[bookmark: marker-435159]
 
     [bookmark: pgfId-435163]An historical view is one that displays events from a selected period of time (for example, the last 10 minutes) and does not automatically update as new events are collected. You must refresh the view to see newer events.
 
     [bookmark: pgfId-435165]Consider the following activities among the many possibilities for employing Event Viewer with an historical view:
 
      
      	 [bookmark: pgfId-435167] Troubleshoot Connectivity —When a report comes in that a user cannot reach a particular server, you can set an historical view (for example, the last 10 minutes) that displays all events that affect that user’s IP address as a source or destination. Then, you can go from a particular displayed event to the policy denying that user’s access to the resource.
 
      	 [bookmark: pgfId-435169] Tune Signatures —After setting a view of all IPS messages, or all IPS messages of a given category, you might decide that an event is actually a false positive. You can then cross launch into the associated policy and either tune the signature to exclude the host or lessen the reported severity of the particular event.
 
     
 
     [bookmark: pgfId-435174]Also consider creating an event action filter to modify how the alert is handled. Frequently, event action filters are a better way of dealing with false positives than editing the actual signature. For more information, see Configuring Event Action Filters.
 
      
      	 [bookmark: pgfId-435176] Validate Policy Deployment —After deploying a new or changed policy, you might want to confirm that it is operating effectively by selecting events corresponding to the given policy. For example, you could identify firewall-deny messages triggered by the new policy.
 
     
 
    
 
     
      [bookmark: pgfId-435184][bookmark: 156405][bookmark: evntchap_cncpt_RealTimeView]Real-Time View[bookmark: marker-435182]
 
     [bookmark: pgfId-435186]A real-time view displays events as they are received and automatically updates the Event Table in waterfall fashion. Keep in mind that the term “real-time” is not precise. System latency and other factors prevent true real-time system response.
 
     [bookmark: pgfId-435188]Consider the following activities among the many possibilities for employing Event Viewer with a real-time view:
 
      
      	 [bookmark: pgfId-435190] Investigate Attacks in Near Real-time —By isolating details of a particular source IP address, or a source/destination pair, Event Viewer can provide details about attacks on your monitored devices, or attacks that are going through those devices.
 
      	 [bookmark: pgfId-435192] Validate Device Activity —You can examine a device in your network and determine whether it is present and whether it is sending events.
 
      	 [bookmark: pgfId-435194] View High Threat IPS Events —You can filter a view to display all events that exceed a certain threat level. On a properly tuned IPS sensor, this should be a manageable flow of events to watch in a real-time view.
 
     
 
    
 
     
      [bookmark: pgfId-435206][bookmark: 156427][bookmark: evntchap_cncpt_ViewsandFilters]Views and Filters[bookmark: marker-435200][bookmark: marker-435202][bookmark: marker-435204]
 
     [bookmark: pgfId-435208]When you view events in Event Viewer, you open a view. A view is a set of filters and other properties, including color rules, selected columns and their positions and widths, and the default time window, that let you define a subset of events. Views help to limit the scope of the events list so that you can more easily find what you are looking for.
 
     [bookmark: pgfId-435213]Event Viewer includes a number of predefined views. Although you cannot change the filter rules for these views, you can create copies of the views and change the filter rules in your copy. Views you create are called custom views. For more information, see Creating Custom Views.
 
     [bookmark: pgfId-435218]Using filters is key to getting the most from Event Viewer. You can distill from all the events being received a view of only the information that you need or want. You can use the various methods of filtering to reduce the events list, filtering lists that have already been filtered. The following list explains the general filtering features; for more information, see Filtering and Querying Events.
 
      
      	 [bookmark: pgfId-435223] Time filters —You can use time filters to limit the events that are loaded into your client as well as to limit the events displayed in the Event Table. With time filtering you can select predefined values, such as  the last hour , or specify a particular time range by dates and times. For more information, see Selecting the Time Range for Events.
 
      	 [bookmark: pgfId-435228] Column filters —You can use column filters to filter events based on a particular value of an event. For example, you could filter on a particular source or destination, or both. For certain columns you can also filter on a range of values or on a policy object. Column filters are part of the view settings for a view. For more information, see Creating Column-Based Filters.
 
      	 [bookmark: pgfId-435233] Quick filters —You can use quick filters to execute a text-based filter on events listed in the event table. The search is not column-sensitive, showing all events in which the string appears in any column. You can use the Quick Filter drop-down list (shown as a magnifier) to modify the scope of the filter. For more information, see Filtering on a Text String.
 
      	 [bookmark: pgfId-435235] Drilling down with filters —Aggregating additional filters allows you to become more and more selective, to “drill down” until you can view a particular event or set of events that meet your requirements. The View Settings pane at the top of the Event Monitoring window updates with each additional filter choice you make to show the current aggregate filter definition of the view selected.
 
     
 
    
 
     
      [bookmark: pgfId-435243][bookmark: 156463][bookmark: evntchap_cncpt_PolicyNavigation]Policy Navigation[bookmark: marker-435241]
 
     [bookmark: pgfId-435251]You can navigate from a particular event to the policy within Security Manager that governs that event. You can also navigate from certain policies to events associated with those policies. For more information, see Looking Up a Security Manager Policy from Event Viewer and Looking Up Events for a Security Manager Policy.
 
    
 
     
      [bookmark: pgfId-435265][bookmark: 156473][bookmark: evntchap_cncpt_UnderstandingEventViewerAccessControl]Understanding Event Viewer Access Control[bookmark: marker-435257][bookmark: marker-435259][bookmark: marker-435261][bookmark: marker-435263]
 
     [bookmark: pgfId-435267]The user privileges assigned to your username control what you can do in Event Viewer. If you use local users, or other types of non-ACS access control, then all users have access to Event Viewer. However, the following access limits are imposed:
 
      
      	 [bookmark: pgfId-435272]You must have system administrator, network administrator, or approver privileges to select or deselect devices for monitoring. See Selecting Devices to Monitor.
 
      	 [bookmark: pgfId-435280]You must have system administrator privileges to change the Event Management administrative settings page, where you enable or disable the service and configure storage location and other settings, as described in Starting, Stopping, and Configuring the Event Manager Service and Event Management Page
 
     
 
     [bookmark: pgfId-435282]If you use ACS to control access to Security Manager, you can also control the following:
 
      
      	 [bookmark: pgfId-435284]You can control access to the Event Viewer application using the View Event Viewer privilege. Using this privilege, you could prevent certain users from accessing Event Viewer, or create roles that allow access to Event Viewer without allowing access to Report Manager. All default ACS roles are permitted to use Event Viewer.
 
      	 [bookmark: pgfId-435289]You can control which users can enable or disable monitoring for devices using the Modify > Manage Event Monitoring privilege. A user must have this privilege to select devices for monitoring as described in Selecting Devices to Monitor. The default ACS roles that have this permission are system administrator, network administrator, approver, security administrator, and security approver.
 
      	 [bookmark: pgfId-435294]You can control the use of the policy lookup feature. Users must have View Device privileges to the device, and also View privileges to the firewall or IPS policy, to perform policy lookup. If users do not have all permissions, they will get an “Unable to Find Matching Rule” error if they try to look up a matching rule. For more information about policy lookup, see Looking Up a Security Manager Policy from Event Viewer.
 
      	 [bookmark: pgfId-435296]Users can view events on devices only if they have at least View privileges to the device.
 
      	 [bookmark: pgfId-435304]You can control access to the Event Management administrative settings page, where you enable or disable the service and configure storage location and other settings, as described in Starting, Stopping, and Configuring the Event Manager Service and Event Management Page. The user must have Admin privileges to access this page (or any other administrative settings page). All default ACS roles except help desk can view the page, but only system administrators can change settings.
 
      	 [bookmark: pgfId-435309]You can control the use of network/host and service policy objects for column filters (such as the Device, Source, Destination, Source Service, and Destination Service columns). Users must have the appropriate View Object permissions for network/host, network/host-IPv6, and service objects to use them in filters. For more information on creating column filters, see Creating Column-Based Filters.
 
     
 
     [bookmark: pgfId-435313]For information on integrating Security Manager with Cisco Secure ACS, see the Installation Guide for Cisco Security Manager.
 
    
 
     
      [bookmark: pgfId-435327][bookmark: 156519][bookmark: evntchap_cncpt_ScopeandLimitsofEventViewer]Scope and Limits of Event Viewer[bookmark: marker-435319][bookmark: marker-435321][bookmark: marker-435323][bookmark: marker-435325]
 
      
       
        
        [bookmark: pgfId-432115]Table 68-1 [bookmark: 156535]Event Viewer Scope and Limits 
 
        
       
         
         	
           
           [bookmark: pgfId-432121]Item
          
  
         	
           
           [bookmark: pgfId-432123]Description
          
  
        
 
         
         	[bookmark: pgfId-432129]Device Support
  
         	[bookmark: pgfId-432131]You can view events collected from the following types of devices. Although Event Viewer has been tested with the indicated software releases, you might be able to use it with older software releases.
 
           
           	 [bookmark: pgfId-432133] ASA devices (including ASA-SM) and security contexts —All 8.x releases.
 
           	 [bookmark: pgfId-432135] FWSM devices and security contexts —Releases 3.1.17, 3.2.17, 4.0.10, and 4.1.1 and higher.
 
           	 [bookmark: pgfId-432137] IPS devices and virtual sensors —Releases 6.1 and higher.
 
          
 [bookmark: pgfId-432139]IPS support does not include IOS IPS.
  
        
 
         
         	[bookmark: pgfId-432145]Event Data Store Size and Location
  
         	[bookmark: pgfId-432147]You can control the location and disk space allocated to holding events collected from monitored devices. After the Event Data Store is 90 percent filled, newest events replace oldest events.
 [bookmark: pgfId-432149]You can also configure an extended storage, or archive, location on attached storage devices. Security Manager automatically copies events into the extended storage; when you view historical events, they are automatically retrieved from extended storage if they no longer reside on the local disk.
 [bookmark: pgfId-432154]For more information on configuring these settings, see the Event Management Page
  
        
 
         
         	[bookmark: pgfId-432160]Event Limit
  
         	[bookmark: pgfId-432165]You can control the maximum number of events that can be viewed at one time in the events table using the Event Data Pagination Size option. For information on configuring the option, see Event Management Page.
  
        
 
         
         	[bookmark: pgfId-432171]Policy Objects
  
         	[bookmark: pgfId-432173]You can use some types of policy objects, such as network/host and services objects, when creating column filters.
 [bookmark: pgfId-432175]You can also view host object names instead of IP addresses in the source and destination columns by selecting View > Show Network Host Objects. This option is selected by default.
 [bookmark: pgfId-432177]IP address to host name mapping is supported only for the source and destination of events. Also, the mapping applies to Host objects only; Event Viewer will not show an object name when the source or destination of an event matches a Network object, Group object, or Address Range object.
 [bookmark: pgfId-432179]Tip Hover over a host object name to view the IP address associated with that object.  
        
 
         
         	[bookmark: pgfId-432185]Views
  
         	[bookmark: pgfId-432187]A single Event Viewer client can open at most four historical views and one real-time view at a time.
  
        
 
         
         	[bookmark: pgfId-432193]Clients
  
         	[bookmark: pgfId-432195]For a single Security Manager server, a maximum of 5 Security Manager clients can open Event Viewer at one time, and a Security Manager client can open one copy of Event Viewer.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-435342][bookmark: 156595][bookmark: evntchap_cncpt_DeeplyParsedSyslogs]Deeply Parsed Syslogs[bookmark: marker-435338][bookmark: marker-435340]
 
     [bookmark: pgfId-435344]The structure and contents of standard syslogs and the elements comprised by each are detailed in the System Logs documentation for the device and software version you are using. You can find the documentation on Cisco.com at these locations:
 
      
      	 [bookmark: pgfId-435348]ASA Devices:  http://www.cisco.com/en/US/products/ps6120/products_system_message_guides_list.html 
 
      	 [bookmark: pgfId-435352]FWSM Devices:  http://www.cisco.com/en/US/products/hw/modules/ps2706/products_system_message_guides_list.html 
 
     
 
     [bookmark: pgfId-435354]Syslogs other than those listed here are presented as raw syslogs. Only deeply parsed syslogs present the full content carried by the syslog.
 
      
       
        
        [bookmark: pgfId-432210]Table 68-2 [bookmark: 156615]Deeply Parsed Syslogs 
 
        
       
         
         	
           
           [bookmark: pgfId-432218]Syslog Category
          
  
         	
           
           [bookmark: pgfId-432220]Syslog ID
          
  
         	
           
           [bookmark: pgfId-432222]Total Number of Syslogs
          
  
        
 
         
         	[bookmark: pgfId-432230]Flow, Session Syslogs
  
         	[bookmark: pgfId-432232]110002-110003, 209003-209005, 302003-302004, 302009-302010, 302012-302018, 302020-302021,302303-302304, 302033-302034, 303002-302005, 313001, 313004, 313005, 313008, 324000-324006, 337001-337009, 431001-431002, 407001-407002, 416001, 418001-418002, 419001-419003, 424001-424002, 450001, 448001, 609001-609002
  
         	[bookmark: pgfId-432234]47
  
        
 
         
         	[bookmark: pgfId-432242]Botnet
  
         	[bookmark: pgfId-432244]338001-338004, 338101-338104, 338201-338202, 338301
  
         	[bookmark: pgfId-432246]11
  
        
 
         
         	[bookmark: pgfId-432254]ACL
  
         	[bookmark: pgfId-432256]106100, 106023, 106002, 106006, 106018
  
         	[bookmark: pgfId-432258]5
  
        
 
         
         	[bookmark: pgfId-432266]Denied Firewall
  
         	[bookmark: pgfId-432268]106001, 106007, 106008, 106010-106017, 106020-106022, 106025-106027
  
         	[bookmark: pgfId-432270]12
  
        
 
         
         	[bookmark: pgfId-432278]Identity Firewall
  
         	[bookmark: pgfId-432280]746003, 746005, 746010, 746016
  
         	[bookmark: pgfId-432282]4
  
        
 
         
         	[bookmark: pgfId-432290]AAA
  
         	[bookmark: pgfId-432292]109001-109010, 109012, 109016-109020, 109023-109029, 109031-109035, 113001-113025
  
         	[bookmark: pgfId-432294]44
  
        
 
         
         	[bookmark: pgfId-432302]Inspect
  
         	[bookmark: pgfId-432304]108002-108007, 303004-303005, 400000-400050, 406001-406002, 415001-415020, 500001-500005, 508001-508002, 608001-608005, 607001- 607003, 703001-703002, 726001
  
         	[bookmark: pgfId-432306]99
  
        
 
         
         	[bookmark: pgfId-432314]NAT
  
         	[bookmark: pgfId-432316]201002-201006, 201009-201013, 202005, 202011, 305005-305012
  
         	[bookmark: pgfId-432318]21
  
        
 
         
         	[bookmark: pgfId-432326]IPSec VPN
  
         	[bookmark: pgfId-432328]402114-402122, 602103-602104, 602303-602304, 702305, 702307
  
         	[bookmark: pgfId-432330]15
  
        
 
         
         	[bookmark: pgfId-432338]Failover (HA)
  
         	[bookmark: pgfId-432340]101001-101005, 102001, 103001-103007, 104001-104004, 311001-311004, 709001-709007, 210001-210022 (except 210008, 210010)
  
         	[bookmark: pgfId-432342]49
  
        
 
         
         	[bookmark: pgfId-432350]SSL VPN
  
         	[bookmark: pgfId-432352]725001-725009, 725012-725013, 716001-716020, 716023 -716039, 716041-716060, 722001-722023, 722026-722044, 722046-722051, 723001-723002, 723009-723012, 723014, 724001-724004
  
         	[bookmark: pgfId-432354]8
  
        
 
         
         	[bookmark: pgfId-432362]Etherchannel
  
         	[bookmark: pgfId-432364]426001-426003
  
         	[bookmark: pgfId-432366]3
  
        
 
         
         	[bookmark: pgfId-432374]Cluster
  
         	[bookmark: pgfId-432376]302022- 302027
  
         	[bookmark: pgfId-432378]6
  
        
 
       
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-435371][bookmark: 156720][bookmark: evntchap_cncpt_OverviewofEventViewer]Overview of Event Viewer[bookmark: marker-435367][bookmark: marker-435369]
 
    [bookmark: pgfId-435376]Use Event Viewer to view events and alerts collected from monitored firewall and IPS devices. For more information about selecting devices for monitoring, see Selecting Devices to Monitor.
 
    [bookmark: pgfId-435378]To open Event Viewer, do any of the following:
 
     
     	 [bookmark: pgfId-435383]Select  Start > All Programs > Cisco Security Manager Client > Event Viewer from the Windows Start menu (your exact command path might differ), or double-click the Event Viewer icon on the desktop. You are prompted to log in. For more information about starting a Security Manager client application, see Logging In to and Exiting the Security Manager Client.
 
     	 [bookmark: pgfId-435385]Select  Launch > Event Viewer from the Configuration Manager or Report Manager applications, or click the Event Viewer button on the Configuration Manager toolbar. Event Viewer is opened using the same user account that you used to log into the other application.
 
    
 
    [bookmark: pgfId-435387]The following illustration and subsequent list explain the basics of Event Viewer.
 
    [bookmark: pgfId-435391]Figure 68-1 [bookmark: 156742]Event Viewer Main Window
 
    [bookmark: pgfId-435394]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-435396]The following list explains the main Event Viewer window in more detail.
 
     
     	 [bookmark: pgfId-435398] (1) Menu Bar —General commands for performing actions in Event Viewer, including the following menus:
 
    
 
    [bookmark: pgfId-435403] – File, for operations on views. For information on the commands, see Event Viewer File Menu.
 
    [bookmark: pgfId-435408] – View, for operations within a view and general system management. For information on the commands, see Event Viewer View Menu.
 
    [bookmark: pgfId-435410] – Launch, for opening the Configuration Manager or Report Manager applications.
 
    [bookmark: pgfId-435412] – Help, for opening the online help or for viewing copyright and licensing information.
 
     
     	 [bookmark: pgfId-435417] (2) Event Monitoring Window —The right pane shows the open views. Each open view is represented on separate tabs (you can have up to four open historical views and one real-time view). Note that you can arrange views horizontally or vertically in this space, or even make a view float to a separate window. For more information about how you can arrange or float views, see Floating and Arranging Views.
 
    
 
    [bookmark: pgfId-435422]For detailed information about the many parts of the event monitoring window, see Event Monitoring Window.
 
     
     	 [bookmark: pgfId-435427] (3) View List —The left pane is a list of views. The list is organized into folders that separate the predefined views from the custom views, which are listed in the My Views folder. The simplest way to open a view is to double-click it, which replaces the currently open view. To open a view without replacing the currently open view, right-click the view and select  Open in New Tab . For more information on opening views, see Opening Views.
 
    
 
    [bookmark: pgfId-435432]For information about other things you can do with the view list pane, see View List.
 
     
     	 [bookmark: pgfId-435437] (4) Status Information —The lower right portion of the status bar shows the current events per second (EPS) rate and an icon that indicates the current health of the monitoring system. Click the alert status icon to open a bubble that shows statistics for the past five minutes and any current system alerts. From this view, you can click the Details link to see more detailed information; click the alert status icon again to close the bubble. For more information, see Monitoring the Event Manager Service.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-435439]Note The Events per Second (EPS) information that is displayed on the Status Bar is calculated based on the number of events received every two seconds. Whereas, the EPS information that is displayed on the Time Slider graph is calculated by performing an aggregation of all the events that are available in a selected time range. Therefore, the numbers displayed on the Status Bar and the Time Slider graph might differ.

    
     

    

    
 
    [bookmark: pgfId-435441]See an example below:
 
    [bookmark: pgfId-435443]Example of EPS information display on the Status Bar
 
    [bookmark: pgfId-435445]Assume at time T1, the Event Viewer application received 192 events. The Events per second (EPS) that will be displayed on the Status Bar is 192 / 2 = 96. This is because Security Manager collects events every 2 seconds and displays the Events per Second on the Status Bar. Let us say at T1 + 2 seconds, the Event Viewer application received 384 events. The EPS that will be displayed on the Status Bar is equal to (384 - 192)/2 = 96. This is the difference between current and previous value divided by 2.
 
    [bookmark: pgfId-435447]Example of EPS information display on the Time Slider graph
 
    [bookmark: pgfId-435449]Security Manager persists the events per second at an interval of 10 seconds. For example, if the Event Viewer application received 352 events in 10 seconds interval, the EPS is equal to 352 / 10 = 35. This value is persisted by Security Manager. For the next 10 seconds interval, if the Event Viewer receives 1056 events, the EPS will be equal to (1056 – 352)/ 10 = 70, which is persisted by Security Manager.
 
    [bookmark: pgfId-435451]Displaying values on the Time Slider graph
 
    [bookmark: pgfId-435453]The Time Slider graph displays the information for a period of time which has a Start Time and an End Time. All events per second that were collected in the given time interval are aggregated and plotted on the graph. In the given example, 35 and 70 are the values stored every 10 seconds. Therefore the Time Slider graph displays EPS as 35 and 70, which are different from the values displayed in the Status Bar.
 
     
      [bookmark: pgfId-435467][bookmark: 156790][bookmark: evntchap_cncpt_EventViewerFileMenu]Event Viewer File Menu[bookmark: marker-435459][bookmark: marker-435461][bookmark: marker-435463][bookmark: marker-435465]
 
     [bookmark: pgfId-435469]The following table describes the commands on the File menu in Event Viewer.
 
     [bookmark: pgfId-435472]
 
      
       
        
        [bookmark: pgfId-432391]Table 68-3 [bookmark: 156806]File Menu in Event Viewer 
 
        
       
         
         	
           
           [bookmark: pgfId-432397]Command
          
  
         	
           
           [bookmark: pgfId-432399]Description
          
  
        
 
         
         	[bookmark: pgfId-432405]New View
  
         	[bookmark: pgfId-432410]Creates a new custom view. You are prompted for a name and description. See Creating Custom Views.
 [bookmark: pgfId-432412]Alternatively, click the New (+) button in the view list.
  
        
 
         
         	[bookmark: pgfId-432418]Open View
  
         	[bookmark: pgfId-432423]Opens a view on a new tab. You are prompted to select the view to open. You can open at most four historical views and one real-time view. See Opening Views.
 [bookmark: pgfId-432425]Tip You can double-click in the view list to open the view and replace the view that is displayed.  
        
 
         
         	[bookmark: pgfId-432431]Save
  
         	[bookmark: pgfId-432436]Saves changes made to the active view, including filters (for custom views only), table preferences such as selected columns, column width, and sort order, the time range, and color rules. See Saving Views.
 [bookmark: pgfId-432438]If you want to save filter changes for a predefined view, you must use Save As to create a new custom view.
  
        
 
         
         	[bookmark: pgfId-432444]Save As
  
         	[bookmark: pgfId-432449]Saves as a custom view the changes you have made to the displayed view. See Saving Views.
  
        
 
         
         	[bookmark: pgfId-432455]Close View
  
         	[bookmark: pgfId-432457]Closes the displayed view.
  
        
 
         
         	[bookmark: pgfId-432463]Close All Views
  
         	[bookmark: pgfId-432465]Closes all open views.
  
        
 
         
         	[bookmark: pgfId-432471]Exit
  
         	[bookmark: pgfId-432473]Closes Event Viewer. Exiting the application closes any floating Event Viewer window that is open.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-435486][bookmark: 156860][bookmark: evntchap_cncpt_EventViewerViewMenu]Event Viewer View Menu[bookmark: marker-435478][bookmark: marker-435480][bookmark: marker-435482][bookmark: marker-435484]
 
     [bookmark: pgfId-435488]The following table describes the commands on the View menu in Event Viewer.
 
     [bookmark: pgfId-435491]
 
      
       
        
        [bookmark: pgfId-432486]Table 68-4 [bookmark: 156876]View Menu in Event Viewer 
 
        
       
         
         	
           
           [bookmark: pgfId-432492]Command
          
  
         	
           
           [bookmark: pgfId-432494]Description
          
  
        
 
         
         	[bookmark: pgfId-432500]Mode
  
         	[bookmark: pgfId-432502]Specifies the time interval for selecting the events to display in the event table. From the submenu, select one of the following options:
 
           
           	 [bookmark: pgfId-432504] last 10 minutes 
 
           	 [bookmark: pgfId-432506] last 1 hour 
 
           	 [bookmark: pgfId-432508] last 12 hours 
 
           	 [bookmark: pgfId-432510] last 1 day 
 
           	 [bookmark: pgfId-432512] last 1 week 
 
           	 [bookmark: pgfId-432514] is today 
 
           	 [bookmark: pgfId-432516] is yesterday 
 
           	 [bookmark: pgfId-432518] is on . . . (Opens a calendar on which you click to specify a single date.)
 
           	 [bookmark: pgfId-432520] is between (Opens two calendars on which to specify a beginning and ending date and time.)
 
           	 [bookmark: pgfId-432522] Real Time (Sets the mode to display events as they are received.)
 
          
 [bookmark: pgfId-432527]Alternatively, click the Time Selector control on the toolbar and select from the same options. See Event Table Toolbar.
  
        
 
         
         	[bookmark: pgfId-432533]Customize Column
  
         	[bookmark: pgfId-432538]Changes the columns shown in the event table. The Choose Columns to Display dialog box opens, where you can select the columns that you want to display. For details on the columns available, see Columns in Event Table.
  
        
 
         
         	[bookmark: pgfId-432544]Start
  
         	[bookmark: pgfId-432546]Initiates retrieving events to update the current view’s event table. The event table then displays events received from the moment you clicked Start back to either the limit of the time mode or the event table pagination limit.
 [bookmark: pgfId-432548]Alternatively, click the Start button on the event table toolbar.
  
        
 
         
         	[bookmark: pgfId-432554]Stop
  
         	[bookmark: pgfId-432556]Stops event retrieval. The event table then displays the events received until the moment you clicked Stop.
 [bookmark: pgfId-432558]Alternatively, click the Stop button on the event table toolbar.
  
        
 
         
         	[bookmark: pgfId-432564]Show View Settings
  
         	[bookmark: pgfId-432566]Opens the View Settings pane, which displays the filters and color settings for the current view. You can alter these settings using the View Settings pane.
 [bookmark: pgfId-432568]Alternatively, click anywhere in the View Settings pane title bar, such as on the icon, on the text, or on the double arrow on the right side of the title bar. Clicking the heading opens and closes the pane.
  
        
 
         
         	[bookmark: pgfId-432574]Show Event Details
  
         	[bookmark: pgfId-432576]Opens the Event Details pane and displays the selected event’s details.
 [bookmark: pgfId-432578]Alternatively:
 
           
           	 [bookmark: pgfId-432580]Click the expand icon (+) on the left of the Event Details pane title bar.
 
           	 [bookmark: pgfId-432582]Double-click an event in the event table to display the event details data in a pop-up window.
 
          
 [bookmark: pgfId-432584]Tip From the Event Details dialog box you can print the event details or you can copy one or more of the detail rows to your clipboard. You can also scroll through the events list using the Next and Previous buttons.  
        
 
         
         	[bookmark: pgfId-432590]Manage Monitored Devices
  
         	[bookmark: pgfId-432595]Allows you to select which devices, or groups of devices, can have events displayed in Event Viewer. For more information, see Selecting Devices to Monitor.
 [bookmark: pgfId-432597]Note By default, any ASA, FWSM, or IPS device added to the Security Manager inventory is monitored.
  
        
 
         
         	[bookmark: pgfId-432603]Show Event Store Disk Usage
  
         	[bookmark: pgfId-432608]Opens a window that displays the amount of disk space used as well as the age of the oldest event stored. See Monitoring Event Data Store Disk Space Usage.
  
        
 
         
         	[bookmark: pgfId-432614]Show Network Host Objects
  
         	[bookmark: pgfId-432616]When selected, the host object name is displayed, if available, instead of the Source or Destination IP address. This option is selected by default.
 [bookmark: pgfId-432618]Tip Hover over a host object name to view the IP address associated with that object.  
        
 
         
         	[bookmark: pgfId-432624]Reset Layout
  
         	[bookmark: pgfId-432626]Re-establishes the width of the view list pane to its original setting after it has been hidden or manually narrowed or widened
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-435501][bookmark: 156990][bookmark: evntchap_cncpt_ViewList]View List[bookmark: marker-435497][bookmark: marker-435499]
 
     [bookmark: pgfId-435503]The left pane of the Event Viewer main window displays a list of available views as shown in the following illustration. A view is a set of filters and other properties, including color rules, selected columns and their positions and widths, and the default time window, that let you define a subset of events.
 
     [bookmark: pgfId-435507]Figure 68-2 [bookmark: 157000]Event Viewer View List
 
     [bookmark: pgfId-435510]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-435512]The view list includes the following controls:
 
      
      	 [bookmark: pgfId-435514] (1) Push Pin button —Click the Push Pin icon to control whether the view list pane is opened or closed. If the pin is vertical, the view list remains open unless you maximize the event monitoring window (the right pane). If the pin is horizontal, the view list collapses to the left margin, and you must click the Views heading in the left margin to open the list.
 
      	 [bookmark: pgfId-435516] (2) Toolbar —The toolbar contains these buttons:
 
     
 
     [bookmark: pgfId-435521] – New button—Click the New button to create a new custom view. You are prompted for a view name and description. For more information, see Creating Custom Views.
 
     [bookmark: pgfId-435526] – Edit button—Click the Edit button to change the name or description of the selected custom view. You can edit custom views only. For more information, see Editing a Custom View Name or Description.
 
     [bookmark: pgfId-435531] – Delete button—Click the Delete button to delete the selected custom view. You can delete custom views only. For more information, see Deleting Custom Views
 
      
      	 [bookmark: pgfId-435536] (3) List of views —The list is organized into folders that separate the predefined views from the custom views, which are listed in the My Views folder. The simplest way to open a view is to double-click it, which replaces the currently open view. To open a view without replacing the currently open view, right-click the view and select  Open in New Tab . For more information on opening views, see Opening Views.
 
      	 [bookmark: pgfId-435538] Right-click shortcut menu —If you right-click on a view, you get a list of additional commands that you can perform:
 
     
 
     [bookmark: pgfId-435543] – Open—Opens the view and uses it to replace the currently active view. If the currently active view contains unsaved changes, you are prompted to save them. If the view is already open, it is brought to the foreground. See Opening Views.
 
     [bookmark: pgfId-435548] – Open in New Tab—Opens the view in a new tab, so that no existing open views are closed. See Opening Views.
 
     [bookmark: pgfId-435553] – Save As—Saves the view as a new custom view. See Saving Views.
 
     [bookmark: pgfId-435558] – Edit—Edits the custom view name and description. See Editing a Custom View Name or Description.
 
     [bookmark: pgfId-435563] – Delete—Deletes the custom view. See Deleting Custom Views.
 
     [bookmark: pgfId-435565] – View Description—Displays the description for the view.
 
     [bookmark: pgfId-435567]Related Topics
 
      
      	 [bookmark: pgfId-435572]Views and Filters
 
      	 [bookmark: pgfId-435577]Overview of Event Viewer
 
      	 [bookmark: pgfId-435582]Floating and Arranging Views
 
     
 
    
 
     
      [bookmark: pgfId-435592][bookmark: 157063][bookmark: evntchap_cncpt_EventMonitoringWindow]Event Monitoring Window[bookmark: marker-435588][bookmark: marker-435590]
 
     [bookmark: pgfId-435594]The Event Monitoring window shows the event views that you have opened. From this window, you can configure views and analyze and filter events.
 
     [bookmark: pgfId-435598]Figure 68-3 [bookmark: 157072]Event Monitoring Window
 
     [bookmark: pgfId-435602]
 
      
      [image: ] 
     
 
      
       
       
         
         	
           
           [bookmark: pgfId-432637]1
          
  
         	[bookmark: pgfId-432639]View tabs.
  
         	
           
           [bookmark: pgfId-432641]6
          
  
         	[bookmark: pgfId-432643]Time slider.
  
        
 
         
         	
           
           [bookmark: pgfId-432653]2
          
  
         	[bookmark: pgfId-432655]View Settings pane.
  
         	
           
           [bookmark: pgfId-432657]7
          
  
         	[bookmark: pgfId-432659]Event Details pane.
  
        
 
         
         	
           
           [bookmark: pgfId-432669]3
          
  
         	[bookmark: pgfId-432671]Event table toolbar.
  
         	
           
           [bookmark: pgfId-432673]8
          
  
         	[bookmark: pgfId-432675]Column selector button.
  
        
 
         
         	
           
           [bookmark: pgfId-432685]4
          
  
         	[bookmark: pgfId-432687]Filtered column icon.
  
         	
           
           [bookmark: pgfId-432689]9
          
  
         	[bookmark: pgfId-432691]Open view scroll buttons and list.
  
        
 
         
         	
           
           [bookmark: pgfId-432701]5
          
  
         	[bookmark: pgfId-432703]Event table.
  
         	[bookmark: pgfId-432705] 
  
         	[bookmark: pgfId-432707] 
  
        
 
       
      
 
     
 
     [bookmark: pgfId-435604]The Event Monitoring window contains these main elements:
 
      
      	 [bookmark: pgfId-435609] View tabs (1, 9) —When you open a view, it is represented as a tab in the window. To change views, click the tab, click the left or right arrow buttons to scroll through the tabs, or click the Open View List button and select the desired view. You can arrange views to be side by side or to float to separate windows by right-clicking the tab name and selecting an appropriate command; for more details, see Floating and Arranging Views.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-435611]Note You can open at most four historical views and one real-time view.

     
      

     

     
 
      
      	 [bookmark: pgfId-435613] View Settings pane (2) —Use the View Settings pane to define the column filters and color rules to use in a view. You can open and close the pane by clicking anywhere in the heading or by toggling the  View > Show View Settings command.
 
     
 
     [bookmark: pgfId-435615]The View Settings pane contains two tabs: Filter and Color Rules. These tabs are shown along the bottom of the pane. On each tab, the body of the tab shows the current filter or rules; to change a rule, you select it and click the Edit or Delete buttons along the top of the pane, as appropriate. To create new rules, click the Add button.
 
     [bookmark: pgfId-435623]You can also add filters using the column filtering controls in the events table, as described in Creating Column-Based Filters. For more information on color rules, see Configuring Color Rules for a View.
 
      
      	 [bookmark: pgfId-435628] Event Table Toolbar (3) —The toolbar above the event table includes shortcut buttons and other controls that relate specifically to the events listed in the table. For a description of the toolbar controls, see Event Table Toolbar.
 
      	 [bookmark: pgfId-435630] Event Table (4, 5, 8) —The event table shows the events that match your filter criteria, one event per row. These events might be retrieved from the primary or the extended data store; you do not have to explicitly request data from the extended data store. To see events from a device, you must have View Device privileges to the device.
 
     
 
     [bookmark: pgfId-435638]The columns that make up the event table can be hidden, resized, reordered, and sorted upon as described in Customizing the Event Table Appearance. For a description of the columns, and how to use the column selector button to choose which columns are shown, see Columns in Event Table.
 
     [bookmark: pgfId-435640]If a column has a filter applied to it, an icon appears in the column heading.
 
      
      	 [bookmark: pgfId-435645] Time Slider (6) —For historical views, the time slider shows the current slice of time displayed in the table and the events per second rate as a linear graph. For more information about using the time slider, see Time Slider.
 
      	 [bookmark: pgfId-435650] Event Details Pane (7) —The event details pane shows detailed information about the currently selected event. You can open and close the pane by clicking anywhere in the heading or by toggling the  View > Show Event Details command. For more information, see Event Details Pane.
 
     
 
    
 
     
      [bookmark: pgfId-435664][bookmark: 157172][bookmark: evntchap_cncpt_EventTableToolbar]Event Table Toolbar[bookmark: marker-435656][bookmark: marker-435658][bookmark: marker-435660][bookmark: marker-435662]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-435672]
 
      
       
        
        [bookmark: pgfId-432722]Table 68-5 [bookmark: 157193]Event Table Toolbar Elements 
 
        
       
         
         	
           
           [bookmark: pgfId-432730]Callout
          
  
         	
           
           [bookmark: pgfId-432732]Name
          
  
         	
           
           [bookmark: pgfId-432734]Description
          
  
        
 
         
         	[bookmark: pgfId-432742]1
  
         	[bookmark: pgfId-432744]Search Within Results Field
 [bookmark: pgfId-432746](Quick Filter)
  
         	[bookmark: pgfId-432751]This tool is also known as the Quick Filter. Use it to search for a word or phrase as well as to limit the scope of the search to certain columns. Further, you can select whether the search term used should be considered case sensitive, whether wildcards may be used, and whether a match may be partial, case sensitive, exact, or anywhere within a string. This search operates only on the selected view and within the data loaded. For more information, see Filtering on a Text String.
  
        
 
         
         	[bookmark: pgfId-432759]2
  
         	[bookmark: pgfId-432761]Time Selector (Mode)
 [bookmark: pgfId-432763](Equivalent to View > Mode.)
  
         	[bookmark: pgfId-432765]You use the time selector to do the following:
 
           
           	 [bookmark: pgfId-432770]Filter the events shown in the event table pane according to the time they were received. See Selecting the Time Range for Events.
 
           	 [bookmark: pgfId-432775]Select between a real-time view or historical views. See Switching Between Real-Time and Historical Views.
 
           	 [bookmark: pgfId-432777]Determine the time interval loaded in the client. If you are using one of the modes that shows events from the current time into the past, hovering the pointer over the field shows the start and end times for the displayed events. If you are using a specific time interval, the interval is shown in the toolbar.
 
          
  
        
 
         
         	[bookmark: pgfId-432785]3
  
         	[bookmark: pgfId-432787]Events by IP Address Type Selector
  
         	[bookmark: pgfId-432789]You use the events by IP address type selector to filter the list based on the type of IP address included in the events. Options are:
 
           
           	 [bookmark: pgfId-432791] All Events (Default) —Show all events regardless of the address type. This is the default option.
 
           	 [bookmark: pgfId-432793] IPv4 Events Only —Show events only if all addresses in the event are in IPv4 format.
 
           	 [bookmark: pgfId-432795] IPv6 Events Only —Show events only if at least one address in the event is in IPv6 format.
 
          
 [bookmark: pgfId-432797]Tip You cannot save your selection. The next time you open the view, you need to reselect your option if you want something other than the default.  
        
 
         
         	[bookmark: pgfId-432805]4
  
         	[bookmark: pgfId-432807]Save
 [bookmark: pgfId-432809](Equivalent to File > Save or File > Save As.)
  
         	[bookmark: pgfId-432811]Click Save to save changes to the current view, including filters (for custom views only), table preferences such as selected columns, column width, and sort order, the time range, and color rules.
 [bookmark: pgfId-432816]Alternatively, click the down arrow and select Save As to save changes as a new custom view. If you want to save filter changes for a predefined view, you must use Save As to create a new custom view. For more information, see Creating Custom Views.
  
        
 
         
         	[bookmark: pgfId-432824]5
  
         	[bookmark: pgfId-432826]Start
 [bookmark: pgfId-432828](Equivalent to View > Start.)
  
         	[bookmark: pgfId-432830]Click Start to reload or restart the listing of events in the Event Table. Clicking Start retrieves any events that have occurred since you originally loaded the table.
  
        
 
         
         	[bookmark: pgfId-432838]6
  
         	[bookmark: pgfId-432840]Stop
 [bookmark: pgfId-432842](Equivalent to View > Stop.)
  
         	[bookmark: pgfId-432844]Click Stop to halt the listing of events in the Event Table. If you are in a real-time view, the Time Selector indicates the time stopped as well as the time interval that is loaded. Clicking on stop can also halt a query and display the set of events currently loaded in event viewer.
  
        
 
         
         	[bookmark: pgfId-432852]7
  
         	[bookmark: pgfId-432854]Clear
  
         	[bookmark: pgfId-432856]Click Clear to empty the event table.
  
        
 
         
         	[bookmark: pgfId-432864]8
  
         	[bookmark: pgfId-432866]Event Enumerator and messages
  
         	[bookmark: pgfId-432871]The number shown on the right of the toolbar indicates how many events are loaded onto the Event Viewer client. The number grows as events are loaded until either all events matching the filter criteria are displayed, or the pagination limit is reached, whichever is lowest. If you change the pagination limit (see Event Management Page), you must exit Event Viewer and open it again for the new limit to be in effect.
 [bookmark: pgfId-432873]If your query requires that events be retrieved from the extended event storage area, a message such as “Data being fetched from extended store” appears. Fetching events from the extended storage area typically takes longer than fetching them from the primary storage area.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-435688][bookmark: 157303][bookmark: evntchap_cncpt_ColumnsinEventViewer]Columns in Event Table[bookmark: marker-435680][bookmark: marker-435682][bookmark: marker-435684][bookmark: marker-435686]
 
     [bookmark: pgfId-435690]The following table lists alphabetically, and describes, all the columns that you can display in a view in Event Viewer. The columns applicable to a particular device vary, as does the presence or absence of event data for a particular event type.
 
     [bookmark: pgfId-435692]When you save a view, the columns you selected, and their order, are preserved and displayed the next time you open the view. To select which columns to display in the open (and active) view, do one of the following:
 
      
      	 [bookmark: pgfId-435697](Preferred method.) Click the  Column Chooser icon in the far right of the event table header row (see Event Monitoring Window). The Choose Columns to Display dialog box that opens lists the columns in alphabetical order. You can select or deselect the columns either individually or by using the  Select/Unselect All check box. Also, you can click Revert to return to the default column selection for the view.
 
      	 [bookmark: pgfId-435699]Select  View > Customize Columns .
 
      	 [bookmark: pgfId-435701]Right-click any column heading and select or deselect a column individually, or select More to open the same dialog box that is used by the View > Customize Columns command.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-435706]Note Most columns other than Description, Event Name, and Receive Time include a filtering function. For more information, see Creating Column-Based Filters.

     
      

     

     
 
     [bookmark: pgfId-435709]
 
      
       
        
        [bookmark: pgfId-432886]Table 68-6 [bookmark: 157335]Event Viewer Column Descriptions 
 
        
       
         
         	
           
           [bookmark: pgfId-432892]Column Label
          
  
         	
           
           [bookmark: pgfId-432894]Description
          
  
        
 
         
         	[bookmark: pgfId-432900]AAA Group
  
         	[bookmark: pgfId-432902]The AAA group policy.
  
        
 
         
         	[bookmark: pgfId-432908]AAA Server
  
         	[bookmark: pgfId-432910]The server that handles user requests for access; it performs authentication, authorization, and accounting.
  
        
 
         
         	[bookmark: pgfId-432916]AAA User
  
         	[bookmark: pgfId-432918]The AAA username.
  
        
 
         
         	[bookmark: pgfId-432924]ACE Hash1
 [bookmark: pgfId-432926]ACE Hash2
  
         	[bookmark: pgfId-432928]The hashcode1 and hashcode2 of the access control list entry (ACE).
 [bookmark: pgfId-432930]Hash codes are required for successful policy lookups from syslog 106023 and 106100 events. These hash codes are available only if you deployed the configuration using Security Manager.
  
        
 
         
         	[bookmark: pgfId-432936]ACL Name
  
         	[bookmark: pgfId-432938]The name or ID of the access control list (ACL).
  
        
 
         
         	[bookmark: pgfId-432944]Action
  
         	[bookmark: pgfId-432946]The action performed on the flow. For example: Terminated or denied.
  
        
 
         
         	[bookmark: pgfId-432952]Alert Details
  
         	[bookmark: pgfId-432954]The details regarding the alerts.
  
        
 
         
         	[bookmark: pgfId-432960]App Name
  
         	[bookmark: pgfId-432962]The name of the application originating the event.
  
        
 
         
         	[bookmark: pgfId-432968]App Stop Reason
  
         	[bookmark: pgfId-432970]An explanation of how or why the application was shut down.
  
        
 
         
         	[bookmark: pgfId-432976]App Version
  
         	[bookmark: pgfId-432978]The version of the application originating the event.
  
        
 
         
         	[bookmark: pgfId-432984]Attack Relevance Rating
  
         	[bookmark: pgfId-432986]A numerical value used to indicate an attack’s relevance to its destination target or targets.
  
        
 
         
         	[bookmark: pgfId-432992]Backplane Interface
  
         	[bookmark: pgfId-432994]The backplane interface, which is identified only when the backplane interface differs from the physical interface.
  
        
 
         
         	[bookmark: pgfId-433000]Botnet Category
  
         	[bookmark: pgfId-433002]The category showing the reason a domain name is blacklisted, for example, botnet, Trojan, spyware, and so on.
  
        
 
         
         	[bookmark: pgfId-433008]Botnet Domain
  
         	[bookmark: pgfId-433010]The domain name or IP address in the dynamic filter database to which the traffic was initiated. It can be black listed, white listed, or grey listed.
  
        
 
         
         	[bookmark: pgfId-433016]Build Time
  
         	[bookmark: pgfId-433018]The date and time of the software build.
  
        
 
         
         	[bookmark: pgfId-433024]Build Type
  
         	[bookmark: pgfId-433026]The type of build. Typically this is a word such as “release” or “debug.” In some cases, it is the ID of the builder of the application.
  
        
 
         
         	[bookmark: pgfId-433032]Byte Count
  
         	[bookmark: pgfId-433034]The number of bytes in the data transfer of the connection.
  
        
 
         
         	[bookmark: pgfId-433040]Call Id
  
         	[bookmark: pgfId-433042]The peer’s Call ID for the session to which this packet belongs.
  
        
 
         
         	[bookmark: pgfId-433048]Class Map
  
         	[bookmark: pgfId-433050]The class map name.
  
        
 
         
         	[bookmark: pgfId-433056]Connection Duration
  
         	[bookmark: pgfId-433058]The lifetime of the connection.
  
        
 
         
         	[bookmark: pgfId-433064]Connection ID
  
         	[bookmark: pgfId-433066]A unique identifier for the connection.
  
        
 
         
         	[bookmark: pgfId-433072]Connection Limit
  
         	[bookmark: pgfId-433074]The maximum number of connections or sessions.
  
        
 
         
         	[bookmark: pgfId-433080]Connection Termination Value
  
         	[bookmark: pgfId-433082]A factor for which the connection is terminated, for example, incorrect version or invalid payload-type.
  
        
 
         
         	[bookmark: pgfId-433088]Current Connection Count
  
         	[bookmark: pgfId-433090]The number of current connections.
  
        
 
         
         	[bookmark: pgfId-433096]Description
  
         	[bookmark: pgfId-433098]For syslogs this shows the raw message, for IPS it shows a description of the event.
  
        
 
         
         	[bookmark: pgfId-433104]Destination
  
         	[bookmark: pgfId-433106]The IP Address or hostname of the traffic destination (for ASA and FWSM) or the attack target (for IPS). It can be multi-valued and contain IPv4 or IPv6 addresses.
 [bookmark: pgfId-433108]If View > Show Network Host Objects is selected and a host object is defined that matches the destination IP address, the host object name is displayed.
 [bookmark: pgfId-433110]Tip Hover over a host object name to view the IP address associated with that object.  
        
 
         
         	[bookmark: pgfId-433116]Destination Context Data
  
         	[bookmark: pgfId-433118]Context buffer indicating the data that was sent just prior to, and immediately after, the alert was triggered. A Base64-encoded representation of the stream data that was sourced by the target.
  
        
 
         
         	[bookmark: pgfId-433124]Destination FQDN
  
         	[bookmark: pgfId-433126]The fully-qualified domain name of the destination IP address, if any.
  
        
 
         
         	[bookmark: pgfId-433132]Destination Interface
  
         	[bookmark: pgfId-433134]The destination interface.
 [bookmark: pgfId-433136]For Etherchannel alerts (426001-426003), this is the name of the Etherchannel interface for which this event occurred. The member interface is identified in the Source Interface column.
  
        
 
         
         	[bookmark: pgfId-433142]Destination Locality
  
         	[bookmark: pgfId-433144]Whether the target address is located inside or outside of a given network as specified by the intrusion.
  
        
 
         
         	[bookmark: pgfId-433150]Destination OS
  
         	[bookmark: pgfId-433152]The target’s operating system information.
  
        
 
         
         	[bookmark: pgfId-433158]Destination OS Relevance
  
         	[bookmark: pgfId-433160]A numerical value indicating the relevance of the destination target OS value.
  
        
 
         
         	[bookmark: pgfId-433166]Destination OS Source
  
         	[bookmark: pgfId-433168]The source of the Target OS data. Possible values are: learned, imported, or configured.
  
        
 
         
         	[bookmark: pgfId-433174]Destination Service
  
         	[bookmark: pgfId-433176]The destination port. It can be multi-valued.
  
        
 
         
         	[bookmark: pgfId-433182]Destination User Identity
  
         	[bookmark: pgfId-433184]The user name for the traffic destination, if any.
  
        
 
         
         	[bookmark: pgfId-433190]Device
  
         	[bookmark: pgfId-433192]The source of the event; usually the device ID.
 [bookmark: pgfId-433194]A device identified as Not Available has been deleted from the Security Manager inventory.
  
        
 
         
         	[bookmark: pgfId-433200]Device Identifier
  
         	[bookmark: pgfId-433205]For a cluster of ASA devices, the ID of the event’s source node, which is based on the "Enable Syslog Device ID" configuration on the Server Setup Page.
 [bookmark: pgfId-433207]A cluster is managed by Security Manager as a single device with multiple nodes. Thus, all the node’s events are mapped to the cluster virtual IP and are displayed with the cluster virtual IP in Event Viewer. You can use “Device Identifier” to filter the syslogs generated by a specific cluster member of a node.
  
        
 
         
         	[bookmark: pgfId-433213]Direction
  
         	[bookmark: pgfId-433215]The direction of the traffic: inbound or outbound.
  
        
 
         
         	[bookmark: pgfId-433221]Event ID
  
         	[bookmark: pgfId-433223]A unique sequential number for each event, assigned internally.
  
        
 
         
         	[bookmark: pgfId-433229]Event Name
  
         	[bookmark: pgfId-433231]A user-friendly name given to the event.
  
        
 
         
         	[bookmark: pgfId-433237]Event Summary
  
         	[bookmark: pgfId-433239]Specifies that this is a summary alert, representing one or more alerts with common characteristics. The numeric value indicates the number of times the signature fired since the last summary alert with a matching initialAlert attribute value.
  
        
 
         
         	[bookmark: pgfId-433245]Event Type ID
  
         	[bookmark: pgfId-433247]For ASA or FWSM, the syslog ID.
 [bookmark: pgfId-433249]For IPS, this value could be:
 
           
           	 [bookmark: pgfId-433251]A combination of Sig Id & Sub-Sig ID (for IPS Alert Events)
 
           	 [bookmark: pgfId-433253]IPS Status (for IPS Status Events)
 
           	 [bookmark: pgfId-433255]IPS Error (for IPS Error Events).
 
          
  
        
 
         
         	[bookmark: pgfId-433261]Execution State
  
         	[bookmark: pgfId-433263]The execution status of the application.
  
        
 
         
         	[bookmark: pgfId-433269]Final Alert
  
         	[bookmark: pgfId-433271]Applies to a summary alert, representing one or more alerts with common characteristics. It indicates whether this is the last event alert containing the same value in the initialAlert attribute.
  
        
 
         
         	[bookmark: pgfId-433277]Generation Time
  
         	[bookmark: pgfId-433279]Represents device local event generation time (available only for IPS events).
  
        
 
         
         	[bookmark: pgfId-433285]Global Correlation Audit Mode
  
         	[bookmark: pgfId-433287]Whether the alert was handled with audit mode processing: true or false.
  
        
 
         
         	[bookmark: pgfId-433293]Global Correlation Deny Attacker
  
         	[bookmark: pgfId-433295]Whether a deny-attacker action occurred (or would have occurred) because an internal override was exceeded due to the calculated risk rating: true or false.
  
        
 
         
         	[bookmark: pgfId-433301]Global Correlation Deny Packet
  
         	[bookmark: pgfId-433303]Whether a deny-packet action occurred (or would have occurred) because an internal override was exceeded due to the calculated risk rating: true or false.
  
        
 
         
         	[bookmark: pgfId-433309]Global Correlation Modified Risk Rating
  
         	[bookmark: pgfId-433311]Whether the risk rating was adjusted by adding the reputation risk delta due to the risk rating: true or false.
  
        
 
         
         	[bookmark: pgfId-433317]Global Correlation Other Overrides
  
         	[bookmark: pgfId-433319]Whether any other defensive actions were taken because an override threshold was exceeded due to the calculated risk rating: true or false.
  
        
 
         
         	[bookmark: pgfId-433325]Global Correlation Risk Delta
  
         	[bookmark: pgfId-433327]A value from 0 to 99 that indicates how much the risk rating was increased due to the reputation score. If audit-mode is enabled, then it indicates how much the risk rating would have been adjusted had audit-mode not been enabled.
  
        
 
         
         	[bookmark: pgfId-433333]Hit Count
  
         	[bookmark: pgfId-433335]The number of times the flow was permitted or denied by the ACL entry in the configured time interval. The value is 1 when the ASA or FWSM generates the first syslog message for a particular flow.
  
        
 
         
         	[bookmark: pgfId-433341]Hit Count Info
  
         	[bookmark: pgfId-433343]ACL Hit Count information, for example, First hit.
  
        
 
         
         	[bookmark: pgfId-433349]Host ID
  
         	[bookmark: pgfId-433351]The globally unique identifier for the host that originated the event.
  
        
 
         
         	[bookmark: pgfId-433357]ICMP Code
  
         	[bookmark: pgfId-433359]The code of the ICMP type. For example, ICMP Type 3 and Code 0 is Net Unreachable or Code 1 is Host Unreachable.
  
        
 
         
         	[bookmark: pgfId-433365]ICMP Type
  
         	[bookmark: pgfId-433367]The type of ICMP message. For example, 3 for Destination unreachable, 8 for Echo.
  
        
 
         
         	[bookmark: pgfId-433373]Initial Alert
  
         	[bookmark: pgfId-433375]This field applies to a summary alert, representing one or more alerts with common characteristics. The value of InitialAlert provides the event ID of the last non-summary evIdsAlert with the same characteristic (sigid/subsigid).
  
        
 
         
         	[bookmark: pgfId-433381]Ip Log ID
  
         	[bookmark: pgfId-433383]The IP Log Identifier that uniquely identifies (with host-scope) an iplog document.
  
        
 
         
         	[bookmark: pgfId-433389]IpLog Address
  
         	[bookmark: pgfId-433391]The IPv4 or IPv6 address associated with the IP log.
  
        
 
         
         	[bookmark: pgfId-433397]IpLog Alert Reference
  
         	[bookmark: pgfId-433399]The global event ID of the evAlert event that triggered the log to be initiated.
  
        
 
         
         	[bookmark: pgfId-433405]IpLog Begin Time
  
         	[bookmark: pgfId-433407]The start of the time range that is currently available in the log document.
  
        
 
         
         	[bookmark: pgfId-433413]IpLog Bytes Captured
  
         	[bookmark: pgfId-433415]The total bytes captured. Note that some packets that were captured may have already been deleted from the log due to memory limitations.
  
        
 
         
         	[bookmark: pgfId-433421]IpLog Bytes Remaining
  
         	[bookmark: pgfId-433423]The number of bytes remaining until the log will be terminated.
  
        
 
         
         	[bookmark: pgfId-433429]IpLog End Time
  
         	[bookmark: pgfId-433431]The end of the time range that is currently available in the log document.
  
        
 
         
         	[bookmark: pgfId-433437]IpLog Minutes Remaining
  
         	[bookmark: pgfId-433439]The minutes remaining until the log will be terminated.
  
        
 
         
         	[bookmark: pgfId-433445]IpLog Packets Captured
  
         	[bookmark: pgfId-433447]The total number of packets captured and logged.
  
        
 
         
         	[bookmark: pgfId-433453]IpLog Packets Remaining
  
         	[bookmark: pgfId-433455]The packets remaining until the log will be terminated.
  
        
 
         
         	[bookmark: pgfId-433461]IpLog Status
  
         	[bookmark: pgfId-433463]A string that represents the log status.
  
        
 
         
         	[bookmark: pgfId-433469]IPS Category
  
         	[bookmark: pgfId-433471]The SEE event category.
  
        
 
         
         	[bookmark: pgfId-433477]IPS User
  
         	[bookmark: pgfId-433479]The username of the user initiating the operation.
  
        
 
         
         	[bookmark: pgfId-433485]License Limit
  
         	[bookmark: pgfId-433487]The maximum number of licenses.
  
        
 
         
         	[bookmark: pgfId-433493]List Name
  
         	[bookmark: pgfId-433495]The list that includes the domain name, administrator whitelist, blacklist, or IronPort list.
  
        
 
         
         	[bookmark: pgfId-433501]Login Action
  
         	[bookmark: pgfId-433503]The login action that occurred: loggedIn, loggedOut, or loginFailed.
  
        
 
         
         	[bookmark: pgfId-433509]Malicious Host
  
         	[bookmark: pgfId-433511]The hostname of the malicious host.
  
        
 
         
         	[bookmark: pgfId-433517]Malicious IP
  
         	[bookmark: pgfId-433519]The IP address of malicious device.
  
        
 
         
         	[bookmark: pgfId-433525]Max Connection
  
         	[bookmark: pgfId-433527]The maximum number of NAT connections.
  
        
 
         
         	[bookmark: pgfId-433533]MaxEmbryonic Connection
  
         	[bookmark: pgfId-433535]The maximum number of embryonic connections.
  
        
 
         
         	[bookmark: pgfId-433541]NAT Destination
  
         	[bookmark: pgfId-433543]The translated (also called natted) destination IP address.
 [bookmark: pgfId-433545]The host name of the translated destination.
  
        
 
         
         	[bookmark: pgfId-433551]NAT Destination Service
  
         	[bookmark: pgfId-433553]The translated (or natted) destination port.
  
        
 
         
         	[bookmark: pgfId-433559]NAT Global IP
  
         	[bookmark: pgfId-433561]The global address. It can contain IPv4 or IPv6 addresses.
  
        
 
         
         	[bookmark: pgfId-433567]NAT Source
  
         	[bookmark: pgfId-433569]The translated (or natted) source IP address. It can contain IPv4 or IPv6 addresses.
 [bookmark: pgfId-433571]The host name of the translated source.
  
        
 
         
         	[bookmark: pgfId-433577]NAT Source Service
  
         	[bookmark: pgfId-433579]The translated (or natted) source port.
  
        
 
         
         	[bookmark: pgfId-433585]NAT Type
  
         	[bookmark: pgfId-433587]The type of network address translation, for example Static or Dynamic.
  
        
 
         
         	[bookmark: pgfId-433593]New Time
  
         	[bookmark: pgfId-433595]The time to which the device clock was changed.
  
        
 
         
         	[bookmark: pgfId-433601]New Version
  
         	[bookmark: pgfId-433603]The system software version after an upgrade installation.
  
        
 
         
         	[bookmark: pgfId-433609]No.
  
         	[bookmark: pgfId-433611]The number of the event (row) in the current display. This is a simple sequential number and is not related to the content of the event. See the Event ID and Event Name fields for information about the type of event.
  
        
 
         
         	[bookmark: pgfId-433617]Old Time
  
         	[bookmark: pgfId-433619]The device clock time prior to a change.
  
        
 
         
         	[bookmark: pgfId-433625]Old Version
  
         	[bookmark: pgfId-433627]The system software version before an upgrade was uninstalled.
  
        
 
         
         	[bookmark: pgfId-433633]Operation Successful
  
         	[bookmark: pgfId-433635]Indicates whether an operation was successfully performed.
  
        
 
         
         	[bookmark: pgfId-433641]Package File
  
         	[bookmark: pgfId-433643]The name of package file to be auto-downloaded and installed.
  
        
 
         
         	[bookmark: pgfId-433649]Physical Interface
  
         	[bookmark: pgfId-433651]The physical interface, which is identified only if physical interface is different from the respective value in the Interface column.
  
        
 
         
         	[bookmark: pgfId-433657]Policy Map
  
         	[bookmark: pgfId-433659]The policy map name.
  
        
 
         
         	[bookmark: pgfId-433665]Protocol
  
         	[bookmark: pgfId-433667]The Level-3 or Level-4 protocol.
  
        
 
         
         	[bookmark: pgfId-433673]Protocol Version
  
         	[bookmark: pgfId-433675]The protocol version.
  
        
 
         
         	[bookmark: pgfId-433681]Protocol (Non L3)
  
         	[bookmark: pgfId-433683]Some non-Level-3 or -4 protocol seen in the event, for example, TACACS, RADIUS, FTP, or H245.
  
        
 
         
         	[bookmark: pgfId-433689]Reason
  
         	[bookmark: pgfId-433691]A rationale associated with certain events. For example, a connection tear down may have an associated reason.
  
        
 
         
         	[bookmark: pgfId-433697]Receive Time
  
         	[bookmark: pgfId-433699]The time the event was received by Security Manager.
  
        
 
         
         	[bookmark: pgfId-433705]Reputation
  
         	[bookmark: pgfId-433707]The attacker’s reputation score in the range -10.0 to +10.0. A lower (more negative) score indicates a greater likelihood that the host is malicious.
  
        
 
         
         	[bookmark: pgfId-433713]Result Status
  
         	[bookmark: pgfId-433715]The status of an operation, which indicates whether the operation successfully completed.
  
        
 
         
         	[bookmark: pgfId-433721]Risk Rating
  
         	[bookmark: pgfId-433723]A value that represents the calculated risk associated with the event.
  
        
 
         
         	[bookmark: pgfId-433729]Role in Cluster
  
         	[bookmark: pgfId-433731]The role of this member of an ASA load-balancing cluster: Cluster, Master, or Slave.
  
        
 
         
         	[bookmark: pgfId-433737]Security Context
  
         	[bookmark: pgfId-433739]The security context with which the named interface, specified in the corresponding Interface column, is associated.
  
        
 
         
         	[bookmark: pgfId-433745]Sensor Event ID
  
         	[bookmark: pgfId-433747]The serial number for an event, which is guaranteed unique within the scope of the originating host.
  
        
 
         
         	[bookmark: pgfId-433753]Severity
  
         	[bookmark: pgfId-433755]The firewall or IPS severity values.
  
        
 
         
         	[bookmark: pgfId-433761]SIA Event Name
  
         	[bookmark: pgfId-433763]The event that occurred for the service identified in the SIA Service Name field.
  
        
 
         
         	[bookmark: pgfId-433769]SIA Service Name
  
         	[bookmark: pgfId-433771]The name of the Service Insertion Architecture (SIA) service for which this event occurred.
  
        
 
         
         	[bookmark: pgfId-433777]Sig Details
  
         	[bookmark: pgfId-433779]The details of the reported signature that was triggered and resulted in the generation of the alert.
  
        
 
         
         	[bookmark: pgfId-433785]Sig ID
  
         	[bookmark: pgfId-433787]The Sig ID value is used by the alert originator to identify the activity. It identifies the pre-defined signature defined for this activity.
  
        
 
         
         	[bookmark: pgfId-433793]Signature Version
  
         	[bookmark: pgfId-433795]The version of the signature definition used to generate an alert.
  
        
 
         
         	[bookmark: pgfId-433801]Source
  
         	[bookmark: pgfId-433803]The IP Address or hostname of the traffic source (for ASA and FWSM) or the attacker (for IPS). It can be multi-valued and contain IPv4 or IPv6 addresses.
 [bookmark: pgfId-433805]If View > Show Network Host Objects is selected and a host object is defined that matches the source IP address, the host object name is displayed.
 [bookmark: pgfId-433807]Tip Hover over a host object name to view the IP address associated with that object.  
        
 
         
         	[bookmark: pgfId-433813]Source Context Data
  
         	[bookmark: pgfId-433815]The context buffer indicating the data that was sent just prior to and immediately after the alert was triggered. A Base64-encoded representation of the data stream that was sourced by the attacker.
  
        
 
         
         	[bookmark: pgfId-433821]Source FQDN
  
         	[bookmark: pgfId-433823]The fully-qualified domain name of the source IP address, if any.
  
        
 
         
         	[bookmark: pgfId-433829]Source Interface
  
         	[bookmark: pgfId-433831]The source interface.
 [bookmark: pgfId-433833]For Etherchannel alerts (426001-426003), this is the name of the interface that is part of the Etherchannel bundle for which this event occurred. The Etherchannel interface is identified in the Destination Interface column.
  
        
 
         
         	[bookmark: pgfId-433839]Source Locality
  
         	[bookmark: pgfId-433841]Identifies whether the attacker address is located inside or outside of a given network, as specified by the intrusion detection device’s configuration.
  
        
 
         
         	[bookmark: pgfId-433847]Source Service
  
         	[bookmark: pgfId-433849]The source port.
  
        
 
         
         	[bookmark: pgfId-433855]Source User Identity
  
         	[bookmark: pgfId-433857]The username associated with the traffic source, if any.
  
        
 
         
         	[bookmark: pgfId-433863]SSO Server
  
         	[bookmark: pgfId-433865]The single sign-on (SSO) server name.
  
        
 
         
         	[bookmark: pgfId-433871]SSO Server Type
  
         	[bookmark: pgfId-433873]The single sign-on (SSO) server type, for example, SiteMinder.
  
        
 
         
         	[bookmark: pgfId-433879]Sub SigId
  
         	[bookmark: pgfId-433881]The sub-sig ID value, which is used by the alert originator in combination with the signature ID (sigId) to identify the activity.
  
        
 
         
         	[bookmark: pgfId-433887]Summary Type
  
         	[bookmark: pgfId-433889]Defines the common characteristics of all alerts in a summary alert.
  
        
 
         
         	[bookmark: pgfId-433895]Target Value Rating
  
         	[bookmark: pgfId-433897]The asset values associated with targets identified in alerts.
  
        
 
         
         	[bookmark: pgfId-433903]Threat Level
  
         	[bookmark: pgfId-433905]Shows one of the following values, if any threat level pertains: none, very-low, low, moderate, high, or very-high.
  
        
 
         
         	[bookmark: pgfId-433911]Threat Rating
  
         	[bookmark: pgfId-433913]The threat rating of the event, if any.
  
        
 
         
         	[bookmark: pgfId-433919]Time Zone
  
         	[bookmark: pgfId-433921]The local time zone at the originating host’s location.
  
        
 
         
         	[bookmark: pgfId-433927]Translated Call ID
  
         	[bookmark: pgfId-433929]The peer’s Translated Call ID for the session to which this packet belongs.
  
        
 
         
         	[bookmark: pgfId-433935]Trigger Packet
  
         	[bookmark: pgfId-433937]The single, complete packet (in base64 binary format) that triggered the alert.
  
        
 
         
         	[bookmark: pgfId-433943]Truncated
  
         	[bookmark: pgfId-433945]Whether the trigger packet contained in the event is truncated.
  
        
 
         
         	[bookmark: pgfId-433951]Tunnel Type
  
         	[bookmark: pgfId-433953]The VPN tunnel type.
  
        
 
         
         	[bookmark: pgfId-433959]Type
  
         	[bookmark: pgfId-433961]The AAA type, for example authentication, authorization, or accounting.
  
        
 
         
         	[bookmark: pgfId-433967]Upgrade Name
  
         	[bookmark: pgfId-433969]The name of the upgrade package that was uninstalled.
  
        
 
         
         	[bookmark: pgfId-433975]URI
  
         	[bookmark: pgfId-433977]The URI of the auto-upgrade server directory.
  
        
 
         
         	[bookmark: pgfId-433983]UTC Offset
  
         	[bookmark: pgfId-433985]The offset attribute of sensor local time indicates the number of minutes that must be added to the UTC time to convert to local time at the originating host.
  
        
 
         
         	[bookmark: pgfId-433991]Virtual Sensor
  
         	[bookmark: pgfId-433993]The name of the virtual sensor associated with the event.
  
        
 
         
         	[bookmark: pgfId-433999]VLAN Id
  
         	[bookmark: pgfId-434001]The VLAN number associated with packets involved in the activity that triggered the alert.
  
        
 
         
         	[bookmark: pgfId-434007]VPN Group
  
         	[bookmark: pgfId-434009]The VPN group policy.
  
        
 
         
         	[bookmark: pgfId-434015]VPN IPSec SPI
  
         	[bookmark: pgfId-434017]The IPSec Security Parameter Index.
  
        
 
         
         	[bookmark: pgfId-434023]VPN User
  
         	[bookmark: pgfId-434025]The VPN username.
  
        
 
         
         	[bookmark: pgfId-434031]Watchlist Delta
  
         	[bookmark: pgfId-434033]The amount that the risk rating value was increase due to the source of the activity associated with the alert being on a watchlist.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-435719][bookmark: 158060][bookmark: evntchap_cncpt_TimeSlider]Time Slider[bookmark: marker-435715][bookmark: marker-435717]
 
     [bookmark: pgfId-435724]The time slider resides below the events table when you are using an historical view; it is not used with real-time views. The following illustration explains the time slider; the pagination controls on the right are explained in Table 68-7.
 
     [bookmark: pgfId-435728]Figure 68-4 [bookmark: 158071]Time Slider Elements
 
     [bookmark: pgfId-435731]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-435733]You can use the time slider to do the following:
 
      
      	 [bookmark: pgfId-435735]View the EPS (events per second) trends for the server. You can use the controls on the right to zoom in or out to get a better view of the EPS trends over the time frame that concerns you.
 
     
 
     [bookmark: pgfId-435737]You can also click and drag the background of the time slider to position the time ranges within the window. Moving the background does not affect the selected time range.
 
      
      	 [bookmark: pgfId-435739]Select a slice of time for displaying events in the table, either by moving the vertical slider or by using the pagination controls. The position of the vertical slider determines the most recent event displayed in the event table. Whenever you alter the time slice, the event table is reloaded with the events that match the time period.
 
     
 
     [bookmark: pgfId-435744]The time range of the events displayed in the event table is determined by the selected time interval. For more information, see Selecting the Time Range for Events.
 
     [bookmark: pgfId-435746]The following table explains the pagination controls to the right of the time slider.
 
     [bookmark: pgfId-435749]
 
      
      

      

      

       
        
        [bookmark: pgfId-434046]Table 68-7 [bookmark: 158085]Time Slider Paging Controls 
 
        
       
         
         	
           
           [bookmark: pgfId-434052]Element
          
  
         	
           
           [bookmark: pgfId-434054]Description
          
  
        
 
        
            
         	[bookmark: pgfId-434063]Previous page (earlier) and next page (later). The size of page varies according to the selected time mode.
 [bookmark: pgfId-434065]Note Using the page controls alternately, for example forward and then back, causes the sort order in the event table to reverse. That is, the latest events go from the top of the table to the bottom, or from the bottom to the top.
  
        
 
        
            
         	[bookmark: pgfId-434074]First page (earliest) and last page (most recent).
  
        
 
        
            
         	[bookmark: pgfId-434083]Zoom in (smaller total time interval shown) and zoom out (greater time interval shown).
 [bookmark: pgfId-434085]Zooming does not change the content of the event table. A shaded blue area indicates the time interval currently displayed in the event table.
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-435757][bookmark: 158116][bookmark: evntchap_cncpt_EventDetailsPane]Event Details Pane[bookmark: marker-435755]
 
     [bookmark: pgfId-435762]The Event Details pane (illustrated in Event Monitoring Window) presents information contained within a single event. The information, which is displayed in multiple tabs within the pane, varies according to the richness of the event and the capability of Event Viewer to parse the data. Components include:
 
      
      	 [bookmark: pgfId-435764] Displayed Fields Tab —Displays the fields shown in the Event Table.
 
      	 [bookmark: pgfId-435766] Details Tab —Displays all available fields for the selected event. The fields are presented in alphabetical order.
 
      	 [bookmark: pgfId-435768] Explanation Tab —Displays a generic explanation for this event type.
 
      	 [bookmark: pgfId-435770] Related Threats Tab —Displays threats correlated to the event. (IPS Events only.)
 
      	 [bookmark: pgfId-435772] Recommended Action Tab —Displays a generic recommendation for an event of this type. (Syslogs only.)
 
      	 [bookmark: pgfId-435774] Trigger Packet Tab —Displays trigger packet data. (IPS Events only.)
 
      	 [bookmark: pgfId-435776] Context Packet Tab —Displays context packet data from the Source (Attacker) and Destination (Target). (IPS events only.)
 
      	 [bookmark: pgfId-435781] Notes —Enables you to add a note so that you can revisit particular signatures later to see what you or other users have added for a signature or an event. For more detailed information, refer to Signatures Page
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-435783]Note The notes added here will be persistent when you cross-launch to Configuration Manager.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-435785]Note If you have more than one event for a particular signature, then annotating one event will annotate all the events related to that signature.

     
      

     

     
 
    
 
   
 
    
     [bookmark: pgfId-435793][bookmark: 158164][bookmark: evntchap_intro_PreparingforEventManagement]Preparing for Event Management[bookmark: marker-435791]
 
    [bookmark: pgfId-435795]Before you can view events generated from a device, you must configure the device to work with Event Viewer.
 
     
      [bookmark: pgfId-435805][bookmark: 158170][bookmark: evntchap_cncpt_EnsuringTimeSyncronization]Ensuring Time Synchronization[bookmark: marker-435801][bookmark: marker-435803]
 
     [bookmark: pgfId-435807]Standard network management practice includes consideration of time differences and network device synchronization. Typically, this includes the use of a Network Time Protocol (NTP) server. Event Viewer is most easily used with a common time standard. However, it is worth noting that you can view the time an event is received by Security Manager (Receive Time), and for IPS devices, the time the event was generated by a device (Generation Time).
 
     [bookmark: pgfId-435809]Whenever possible, configure the Security Manager server and the devices it is monitoring with the same NTP server.
 
     [bookmark: pgfId-435811]Differences between the clock on the Security Manager server and the clock on a Security Manager client at the time the client is opened are taken into account while translating/mapping event data from the server time to the client time. If the time difference changes dynamically due to the Security Manager server time moving ahead, for example, the data retrieved from the server will show an updated timestamp, but the client will continue to map the time difference based on the times on the server and the client when the client was opened. In such a situation, no data will be seen on Event Viewer for a brief interval that corresponds to the time change on the server. For this reason, we recommend that Security Manager server clock changes are done less frequently and at a time that would be the least impacting.
 
    
 
     
      [bookmark: pgfId-435827][bookmark: 158182][bookmark: evntchap_proc_ConfiguringASADevicesforEventManagement]Configuring ASA and FWSM Devices for Event Management[bookmark: marker-435817][bookmark: marker-435819][bookmark: marker-435821][bookmark: marker-435823][bookmark: marker-435825]
 
     [bookmark: pgfId-435829]Before you can use Event Viewer, or any other application that analyzes syslog events, to view events generated from an ASA (including ASA-SM) or FWSM device, you must configure the logging policies on the device to generate and transmit syslog messages.
 
      
       
     
 
     
 
     [bookmark: pgfId-435831]Note A cluster device with a Virtual IP address (beginning with Security Manager version 4.4) can be added if configured in both Security Manager and on the virtual device.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-435839]Tip Although you can configure devices individually to specify the appropriate logging configuration, it is likely that more than one ASA or FWSM device in your network would use the same logging configuration. Although this topic describes how to configure an individual device, you can also create shared policies and assign them to multiple devices. For more information about configuring and assigning shared policies, see Creating a New Shared Policy and Modifying Policy Assignments in Policy View.

     
      

     

     
 
     [bookmark: pgfId-435841]Besides the logging configuration described here, you can also configure logging for individual access control entries when you configure them either in firewall policies or ACL policy objects. The default is to log denied access only, but you can configuring ACL logging options to provide increased logging.
 
      
       
     
 
     
 
     [bookmark: pgfId-435843]Note To reliably report events from contexts in multiple-context mode, Cisco Event Viewer requires an IP address for the management interface of each context.

     
      

     

     
 
     
 
     [bookmark: pgfId-435845]Step 1 (Device view) Select the ASA or FWSM device or security context, then select Platform > Logging > Syslog > Logging Setup from the Policies selector.
 
     [bookmark: pgfId-435850]In the policy, select Enable Logging. You can configure other options as needed. For detailed information about the options, see Logging Setup Page.
 
     [bookmark: pgfId-435852]Step 2 Select Platform > Logging > Syslog > Syslog Servers.
 
     [bookmark: pgfId-435857]Add the Security Manager server’s IP address to the syslog servers table. Configure the server to use the UDP protocol. The default port, 514, is correct unless you configure a different port on the Security Manager Administration Event Management Page.
 
     [bookmark: pgfId-435859]If you are using other event management applications, such as CS-MARS, also add those servers to this policy.
 
      
       
     
 
     
 
     [bookmark: pgfId-435861]Note You can use EMBLEM message format if you desire; both traditional and EMBLEM formats are supported. Keep in mind that EMBLEM is not supported by CS-MARS, so do not send EMBLEM-formatted messages to a CS-MARS server.

     
      

     

     
 
     [bookmark: pgfId-435866]For detailed information about the options in the Syslog Servers policy, see Syslog Servers Page.
 
     [bookmark: pgfId-435871]Step 3 If you want to configure non-default syslog server settings, such as adding time stamps to syslog messages, changing the severity level of messages, or suppressing the generation of specific messages altogether, configure the Platform > Logging > Syslog > Server Setup policy. For detailed information, see Server Setup Page
 
     [bookmark: pgfId-435879]Step 4 (Optional)You can configure the Platform > Logging > Syslog > Logging Filters policy to fine-tune the kinds of messages sent to syslog servers. For detailed information about this policy, see Logging Filters Page and Edit Logging Filters Dialog Box.
 
     [bookmark: pgfId-435881]Following are some tips for configuring this policy:
 
      
      	 [bookmark: pgfId-435883]When adding the logging filter, select  Syslog Servers for Logging Destination.
 
      	 [bookmark: pgfId-435888]You can create a simple filter based on message severity, or you can configure a much more complex filter based on event classes. If you elect to use event classes, you can do the configuration directly in the Logging Filters policy, or you can configure event lists separately in the  Event Lists policy (see Event Lists Page).
 
     
 
     [bookmark: pgfId-435893]Step 5 (Optional) You can configure the Platform > Logging > Syslog > Rate Limit policy to limit the quantity of messages generated per time interval, either by message severity or message number. This can help you avoid flooding the syslog server. See Rate Limit Page.
 
     [bookmark: pgfId-435898]Step 6 (Optional, but recommended) You can configure the Platform > Device Admin > Server Access > NTP policy to specify a network time protocol server for ASA devices. Using NTP ensures consistent date and time information for easy event correlation. Specify the same NTP server you use for the Security Manager server. If you use different servers, ensure the servers are synchronized. See NTP Page.
 
     [bookmark: pgfId-435900]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-435912][bookmark: 158251][bookmark: evntchap_cncpt_ConfiguringIPSDevicesforEventManagement]Configuring IPS Devices for Event Management[bookmark: marker-435906][bookmark: marker-435908][bookmark: marker-435910]
 
     [bookmark: pgfId-435914]Before you can use Event Viewer to view events generated from an IPS device, you must configure the Allowed Hosts policy on the device to allow the Security Manager server access to the device. Because Security Manager also needs to be configured in the Allowed Hosts policy to allow configuration access, your IPS devices might already be configured correctly. You should also configure the network time protocol (NTP).
 
     [bookmark: pgfId-435916]Configure the following policies for IPS devices in Device view to enable effective event management on those devices:
 
      
      	 [bookmark: pgfId-435918] Platform > Device Admin > Device Access > Allowed Hosts —(Required) Add the Security Manager server to the table. You can either identify the Security Manager server by its host IP address (for example, 10.100.10.10), or you can specify the network that it is on (for example, 10.100.10.0/24).
 
     
 
     [bookmark: pgfId-435920]If you are using other event management applications with the device, such as CS-MARS, ensure that you also add those servers to the policy.
 
     [bookmark: pgfId-435925]For more information about configuring the Allowed Hosts policy, see Identifying Allowed Hosts.
 
      
      	 [bookmark: pgfId-435930] Platform > Device Admin > Server Access > NTP —(Recommended) Configure the same NTP server that you use for the Security Manager server to ensure consistent date and time information for easy event correlation. If you use different servers, ensure the servers are synchronized. For more information, see Identifying an NTP Server.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-435938]Tip Although you can configure devices individually to specify the appropriate allowed hosts and NTP configuration, it is likely that more than one IPS device in your network would use the same configuration. Although this topic describes how to configure an individual device, you can also create shared versions of these policies and assign them to multiple devices. For more information about configuring and assigning shared policies, see Creating a New Shared Policy and Modifying Policy Assignments in Policy View.

     
      

     

     
 
    
 
   
 
    
     [bookmark: pgfId-435950][bookmark: 158280][bookmark: evntchap_intro_ManagingtheEventManagerService]Managing the Event Manager Service[bookmark: marker-435944][bookmark: marker-435946][bookmark: marker-435948]
 
    [bookmark: pgfId-435952]The Event Manager service enables the use of the Event Viewer application. For Event Viewer to function, the service must be started. There are several tasks that you can perform to configure and manage the overall functioning of the service.
 
    [bookmark: pgfId-435954]This section contains the following topics:
 
     
     	 [bookmark: pgfId-435959]Starting, Stopping, and Configuring the Event Manager Service
 
     	 [bookmark: pgfId-435964]Monitoring the Event Manager Service
 
     	 [bookmark: pgfId-435969]Selecting Devices to Monitor
 
     	 [bookmark: pgfId-435974]Monitoring Event Data Store Disk Space Usage
 
     	 [bookmark: pgfId-435979]Archiving or Backing Up and Restoring the Event Data Store
 
    
 
     
      [bookmark: pgfId-435999][bookmark: 158292][bookmark: evntchap_proc_StartingandConfiguringtheEventManagerService]Starting, Stopping, and Configuring the Event Manager Service[bookmark: marker-435985][bookmark: marker-435987][bookmark: marker-435989][bookmark: marker-435991][bookmark: marker-435993][bookmark: marker-435995][bookmark: marker-435997]
 
     [bookmark: pgfId-436001]The Event Manager service must be running for you to use Event Viewer or Report Manager.
 
     [bookmark: pgfId-436005]When you install Security Manager, the Event Manager service is automatically enabled unless the server does not meet the minimum memory requirements that are documented in the Installation Guide for Cisco Security Manager. Although you can manually start the service on a system that does not meet the minimum memory requirements, you might find the performance to be dissatisfactory. The key factors are the number of devices managed and their rate of event generation.
 
      
       
     
 
     
 
     [bookmark: pgfId-436011]Tip If you get a message that Event Viewer is unavailable when you select Launch > Event Viewer, but the Enable Event Management option is selected in the Tools > Security Manager Administration > Event Management page, try restarting the Event Manager Service. First, deselect the Enable option and click Save. Wait for the service to stop. Then, select the Enable option, click Save, and wait for the service to finish restarting. You can then try opening Event Viewer again.[bookmark: marker-436007][bookmark: marker-436009]

     
      

     

     
 
     [bookmark: pgfId-436013]The following procedure explains how to start, stop, and configure the Event Manager service.
 
     [bookmark: pgfId-436015]Related Topics
 
      
      	 [bookmark: pgfId-436020]Monitoring Event Data Store Disk Space Usage
 
     
 
     
 
     [bookmark: pgfId-436022]Step 1 In the main Security Manager window (not Event Viewer), select Tools > Security Manager Administration and select Event Management from the table of contents.
 
     [bookmark: pgfId-436024]Step 2 Do one of the following:
 
      
      	 [bookmark: pgfId-436026]To enable, or start, the Event Manager service, select  Enable Event Management .
 
      	 [bookmark: pgfId-436028]To disable, or stop, the Event Manager service, deselect  Enable Event Management .
 
     
 
     [bookmark: pgfId-436033]You can also change the other settings, such as the event data store location and maximum size, the syslog port to which devices should send events, and the pagination size (which determines the maximum number of events loaded into the event table). You can also configure an extended event storage location to augment your primary storage location. For detailed information about these settings, see Event Management Page.
 
      
       
     
 
     
 
     [bookmark: pgfId-436038]Note Beginning with version 4.5, Security Manager enables you to forward syslogs to one local collector and two remote collectors. For more information, see Event Management Page.

     
      

     

     
 
     [bookmark: pgfId-436040]Step 3 Click Save to save your changes.
 
     [bookmark: pgfId-436042]If you changed the Enable Event Management option, you are prompted to confirm that you want to start or stop the Event Manager Service. If you click Yes, the service is started or stopped immediately, and you are shown a progress indicator and told when the change is completed. Wait until the status change is completed before continuing.
 
     [bookmark: pgfId-436044]If you change other settings, with the exception of the pagination size, the Event Manager service must be briefly stopped and restarted. You are shown a progress indicator.
 
     [bookmark: pgfId-436046]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-436062][bookmark: 158362][bookmark: evntchap_cncpt_MonitoringtheEventManagerService]Monitoring the Event Manager Service[bookmark: marker-436054][bookmark: marker-436056][bookmark: marker-436058][bookmark: marker-436060]
 
     [bookmark: pgfId-436064]The Event Manager service processes incoming syslog messages and retrieves SDEE alerts from monitored IPS devices. The amount of data processed varies depending on network activity. There can be times when the events per second (EPS) generated in the network is higher than the service can handle, in which case the service goes into throttle mode, selectively dropping events.
 
     [bookmark: pgfId-436069]You can monitor the status of the service to identify congestion and address problems that arise. The status of the service is shown in an icon in the lower right corner of the status bar in Event Viewer, as shown in Overview of Event Viewer. The Total EPS indicates the current events per second rate that the service is experiencing. The alert status icon color indicates the following:
 
      
      	 [bookmark: pgfId-436079]Green dot—There are no problems. All events are being processed normally.[bookmark: marker-436071][bookmark: marker-436073][bookmark: marker-436075][bookmark: marker-436077]
 
      	 [bookmark: pgfId-436081]Yellow dot—There are some warnings, for example, low severity events are being dropped.
 
      	 [bookmark: pgfId-436083]Orange dot—There are more serious issues, for example, low and medium severity events are being dropped.
 
      	 [bookmark: pgfId-436085]Red dot—There is a critical situation, for example, high severity events are being dropped or there is a significant problem with the system, such as problems with the syslog port or with the event data store location.
 
      	 [bookmark: pgfId-436090]Disconnected network wire—The Event Manager service is disabled, either intentionally or due to some server problem; no events are being stored or retrieved. If this is not intentional, restart the Event Manager service as described in Starting, Stopping, and Configuring the Event Manager Service.
 
     
 
     [bookmark: pgfId-436092]To view detailed information, click on the alert status icon. A bubble opens that shows summary statistics for the past five minutes, including the number of events received and dropped and event server alert messages, if any. Click the alert status icon again to close the bubble.
 
     [bookmark: pgfId-436094]When the bubble is open, you can click the Details link in the bubble to view more detailed information. Clicking the Details link opens the Event Statistics Details dialog box, which shows the following information:
 
      
      	 [bookmark: pgfId-436096] Last 5 Minutes Statistics: 
 
     
 
     [bookmark: pgfId-436098] – Events Received—The total number of syslog events Received and SDEE alerts retrieved in the past five minutes by the service.
 
     [bookmark: pgfId-436100] – Events Dropped—The total number of events or alerts that the service had to drop due to congestion. This number indicates drops from monitored devices only, so the number should be zero in normal circumstances. A non-zero number indicates that the service is in throttle mode; look for messages in the Event Server Alerts section.
 
     [bookmark: pgfId-436105] – Events from Unmonitored Devices—The number of syslog messages sent to the server that came from devices that are not selected for monitoring (as described in Selecting Devices to Monitor).
 
     [bookmark: pgfId-436107]Events from unmonitored devices are always dropped, but they do place a load on the service. The IP address of the last unmonitored device detected is shown; use the IP address to determine the source of the messages. You can then determine if the device should be added to the monitored devices list, or if you need to alter the device’s configuration to remove the Security Manager server from its list of syslog servers.
 
     [bookmark: pgfId-436109]If the device that is sending messages is outside of your network, adjust the firewall configuration to prevent this syslog traffic from entering your network.
 
      
      	 [bookmark: pgfId-436111] Status Information: 
 
     
 
     [bookmark: pgfId-436113] – Total Events Per Second (EPS)—The rate at which events are currently being processed. This measure does not include dropped events.
 
     [bookmark: pgfId-436115] – Event Buffer Used—The percentage of the shared event buffer that is currently being used to process events. The bar is color-coded to indicate the throttle level:
 
     [bookmark: pgfId-436117]Green—Not in throttle mode.
 
     [bookmark: pgfId-436119]Yellow—Low severity events are being dropped.
 
     [bookmark: pgfId-436121]Orange—Low and medium severity events are being dropped.
 
     [bookmark: pgfId-436123]Red—High severity events are being dropped.
 
      
      	 [bookmark: pgfId-436128] Event Server Alerts —These messages indicate specific status problems that you might need to address.  Table 68-8  explains the messages that you might see with possible solutions.
 
      	 [bookmark: pgfId-436130] Copy button —Click the Copy button to copy the information to the clipboard. The copied information includes HTML markup. You can paste the information into an HTML file.
 
     
 
     [bookmark: pgfId-436133]
 
      
       
        
        [bookmark: pgfId-434100]Table 68-8 [bookmark: 158448]Event Manager Status Messages 
 
        
       
         
         	
           
           [bookmark: pgfId-434108]Alert Message
          
  
         	
           
           [bookmark: pgfId-434110]Alert Level
          
  
         	
           
           [bookmark: pgfId-434112]Possible Action
          
  
        
 
         
         	[bookmark: pgfId-434120]UDP port <514> could not be acquired, therefore syslog events cannot be collected.
  
         	[bookmark: pgfId-434122]High
  
         	[bookmark: pgfId-434124]Some external application might already be using the indicated port (the default syslog port is 514). You might need to stop that external application. You can use the netstat command to identify the PID of the process, for example, netstat -ao | findstr 514.
  
        
 
         
         	[bookmark: pgfId-434132]The event data store location does not exist, therefore events cannot be stored.
  
         	[bookmark: pgfId-434134]High
  
         	[bookmark: pgfId-434139]The event data store location as configured in the Security Manager Administrative Settings does not exist or the Security Manager server does not have the required read/write permissions to the location. For more information about configuring the location, see Event Management Page.
  
        
 
         
         	[bookmark: pgfId-434147]Low severity events are being dropped.
  
         	[bookmark: pgfId-434149]Low
  
         	 [bookmark: pgfId-434151]Either events are being received at a very high rate or the system is under a heavy load.
 [bookmark: pgfId-434156]To identify if a device is sending events too frequently, you can open the All Device Events view and switch to real-time mode, as described in Switching Between Real-Time and Historical Views.
 [bookmark: pgfId-434158]To identify if the server is under a heavy load, log into Windows on the server and use Task Manager or another tool to see if there is an application other than Security Manager that is taxing the system. If possible, disable or stop the application. If the problem occurs frequently, consider uninstalling the other application from the server.
  
        
 
         
         	[bookmark: pgfId-434166]Low and medium severity events are being dropped.
  
         	[bookmark: pgfId-434168]Medium
  
        
 
         
         	[bookmark: pgfId-434178]All events are being dropped.
  
         	[bookmark: pgfId-434180]High
  
        
 
         
         	[bookmark: pgfId-434190]Events from unknown devices are being received.
  
         	[bookmark: pgfId-434192]Low
  
         	 [bookmark: pgfId-434197]Syslog events are being sent to the Security Manager server from devices that are not selected for monitoring as described in Selecting Devices to Monitor. These devices might not be supported device types for monitoring and they might not even be in the Security Manager inventory.
 [bookmark: pgfId-434199]The message varies based on the EPS rate for these devices. A low severity message indicates the EPS rate is between 500 and 5,000; a medium indicates an EPS rate between 5,000 and 10,000; a high indicates an EPS rate greater than 10,000.
 [bookmark: pgfId-434201]The Events from Unmonitored Devices statistic in the Last 5 Minutes Statistics shows the number of these events and the IP address of the last unsupported device. Either select the device for monitoring or change the syslog policy for the device to remove the address of the Security Manager server. You will need to repeat the process if more than one unmonitored device is sending messages.
  
        
 
         
         	[bookmark: pgfId-434209]Events from unknown devices are being received at a high rate.
  
         	[bookmark: pgfId-434211]Medium
  
        
 
         
         	[bookmark: pgfId-434221]Events from unknown devices are being received at a very high rate.
  
         	[bookmark: pgfId-434223]High
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-436151][bookmark: 158522][bookmark: evntchap_proc_SelectingDevicestoMonitor]Selecting Devices to Monitor[bookmark: marker-436141][bookmark: marker-436143][bookmark: marker-436145][bookmark: marker-436147][bookmark: marker-436149]
 
     [bookmark: pgfId-436153]All ASA and FWSM devices and security contexts, and IPS devices and virtual sensors, that are added to the Security Manager database are automatically selected for monitoring in Event Viewer.
 
      
       
     
 
     
 
     [bookmark: pgfId-436155]Note To reliably report events from contexts in multiple-context mode, Cisco Event Viewer requires an IP address for the management interface of each context.

     
      

     

     
 
     [bookmark: pgfId-436157]If you do not want to use Event Viewer with a device, you can deselect the device for monitoring. Note that if an ASA or FWSM device or security context is not configured to use the Security Manager server as a syslog server, you will not get events from the device or security context anyway, so you might not need to deselect an ASA or FWSM that you do not want to monitor.
 
      
       
     
 
     
 
     [bookmark: pgfId-436159]Tip You cannot monitor Cisco IOS IPS devices in Event Viewer.

     
      

     

     
 
     [bookmark: pgfId-436161]Related Topics
 
      
      	 [bookmark: pgfId-436166]Adding Devices to the Device Inventory
 
      	 [bookmark: pgfId-436171]Configuring ASA and FWSM Devices for Event Management
 
      	 [bookmark: pgfId-436176]Configuring IPS Devices for Event Management
 
     
 
     
 
     [bookmark: pgfId-436178]Step 1 In Event Viewer, select View > Manage Monitored Device to open the Manage Monitored Devices dialog box.
 
     [bookmark: pgfId-436183]The device list shows all devices in the Security Manager inventory to which you have view permissions. You cannot see any devices for which you have no permissions. Any selections you make are limited to the displayed devices. If you do not have permission to select or deselect any devices, the list is read-only and you cannot select devices for monitoring. For more information on access permissions, see Understanding Event Viewer Access Control.
 
     [bookmark: pgfId-436185]Step 2 Ensure that only those devices whose events you want to monitor in Event Viewer are selected. Deselect any undesired devices.
 
     [bookmark: pgfId-436187]You can change the selection status for all devices in a device group by selecting or deselecting the group.
 
     [bookmark: pgfId-436189]Step 3 Click OK.
 
     [bookmark: pgfId-436191]You might need to wait for the changes take effect in Event Viewer.
 
     [bookmark: pgfId-436193]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-436207][bookmark: 158573][bookmark: evntchap_cncpt_MonitoringEventStoreDiskUsage]Monitoring Event Data Store Disk Space Usage[bookmark: marker-436199][bookmark: marker-436201][bookmark: marker-436203][bookmark: marker-436205]
 
     [bookmark: pgfId-436212]The Event Manager service uses a specified amount of disk space for the primary and extended event data stores. This ensures that the service does not overwhelm the server computer or the extended storage location. You configure the size of the primary and extended event data stores on the Tools > Security Manager Administration > Event Management page as described in Event Management Page.
 
     [bookmark: pgfId-436214]For both the primary and extended locations, when the allocated space is 90% full, the oldest event data is deleted from storage to make room for new data. Data is copied from the primary store to the extended store, if you configure one, so in most cases events deleted from the primary storage continue to be available for querying from the extended storage location, until they are rotated out of the extended storage. (The timing of the copy from the primary to extended data store depends on a number of factors, including the events per second (EPS) rate, the relative size of the primary store to the extended store, and the percentage of the primary data that has already been copied to the extended store.)
 
     [bookmark: pgfId-436216]You can monitor how much of the allocated space is currently being used, and the age of the oldest event, by selecting View > Show Event Store Disk Usage in Event Viewer. The information is displayed as a pie chart that shows the used and unused space in gigabytes (GB) for each location. There is also an indication of the oldest event currently stored in each location.
 
     [bookmark: pgfId-436218]You can use this information to help you decide whether to increase or decrease the space allocated to each location.
 
      
       
     
 
     
 
     [bookmark: pgfId-436220]Tip If you decrease the size of either location, and your new size is less than the amount of space currently being used, the oldest events are immediately deleted until your new target size is reached.

     
      

     

     
 
    
 
     
      [bookmark: pgfId-436242][bookmark: 158595][bookmark: evntchap_proc_ArchivingorBackingUpandRestoringtheEventDataStore]Archiving or Backing Up and Restoring the Event Data Store[bookmark: marker-436226][bookmark: marker-436228][bookmark: marker-436230][bookmark: marker-436232][bookmark: marker-436234][bookmark: marker-436236][bookmark: marker-436238][bookmark: marker-436240]
 
     [bookmark: pgfId-436244]The event data store is not included with the regular Security Manager database backup. If you want to archive or back up the event data store, whether the primary or extended location, you must do so separately. You can restore the backups if necessary.
 
     [bookmark: pgfId-436246]This procedure explains the steps required for backup and restore for the event data store.
 
      
       
     
 
     
 
     [bookmark: pgfId-436248]Tip When you disable the Event Manager service, events are not written to the data store, so you will miss any events generated during the backup or restore process.

     
      

     

     
 
     
 
     [bookmark: pgfId-436250]Step 1 To back up the event data store:
 
     [bookmark: pgfId-436252] a. Using the Security Manager client, select Tools > Security Manager Administration, and select Event Management from the table of contents.
 
     [bookmark: pgfId-436254] b. Determine the name of the event data store folder. The folder is shown in the Event Data Store Location field; the default is NMSROOT\MDC\eventing\database, where NMSROOT is the installation directory (usually C:\Program Files\CSCOpx).
 
     [bookmark: pgfId-436256]If you are backing up the extended data store, the location is identified in the Extended Data Store Location field.
 
     [bookmark: pgfId-436258] c. Deselect the Enable Event Management check box to stop the Event Manager service. Click Save to save your changes. You are prompted to verify that you want to stop the service; click Yes and wait until you are notified that the service has stopped.
 
     [bookmark: pgfId-436260] d. Outside of Security Manager, make a copy of the NMSROOT\MDC\eventing\config\collector.properties file and the event data store folder. Place the copy on a separate server so that the backup is available in case of hardware failure.
 
     [bookmark: pgfId-436262]If you are also backing up the extended data store, make a copy of that folder as well.
 
     [bookmark: pgfId-436264] e. In the Security Manager client’s Tools > Security Manager Administration > Event Management page, select the Enable Event Management check box and click Save. You are prompted to verify that you want to start the service; click Yes and wait until you are notified that the service has started.
 
     [bookmark: pgfId-436266]Step 2 To restore the event data store, use the same process you used to back up the data with the following exceptions:
 
      
      	 [bookmark: pgfId-436268]Instead of making a copy of the existing event data store, copy the backup into the event data store location. You can optionally delete the existing data before copying in the backup data. However, as long as you do not exceed the data store size limit, you can mix the backup and existing data. (The data store limit is configured in the  Tools > Security Manager Administration > Event Management page.)
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-436270]Note Mixing old and new data works only if you are preserving the existing copy of collector.properties (that is, you are not restoring the file), and the new and old data are from the same server. You cannot merge the data store from two or more separate servers.

     
      

     

     
 
      
      	 [bookmark: pgfId-436272]Do not restore collector.properties unless you are recovering from a hardware failure or some other event that required you to reinstall Security Manager.
 
     
 
     [bookmark: pgfId-436274]

     
      

     

     
 
    
 
   
 
    
     [bookmark: pgfId-436282][bookmark: 158665][bookmark: evntchap_cncpt_UsingEventViewer]Using Event Viewer[bookmark: marker-436280]
 
    [bookmark: pgfId-436284]Use Event Viewer to help troubleshoot network problems involving monitored devices. Using views and filtering, you can analyze problems to help identify the cause and possible remedies.
 
    [bookmark: pgfId-436286]This section contains the following topics:
 
     
     	 [bookmark: pgfId-436291]Using Event Views
 
     	 [bookmark: pgfId-436296]Filtering and Querying Events
 
     	 [bookmark: pgfId-436301]Performing Operations on Specific Events
 
     	 [bookmark: pgfId-436306]Looking Up a Security Manager Policy from Event Viewer
 
     	 [bookmark: pgfId-436311]Looking Up Events for a Security Manager Policy
 
    
 
     
      [bookmark: pgfId-436321][bookmark: 158671][bookmark: evntchap_cncpt_UsingEventViews]Using Event Views[bookmark: marker-436317][bookmark: marker-436319]
 
     [bookmark: pgfId-436323]When you view events in Event Viewer, you open a view. A view is a set of filters and other properties, including color rules, selected columns and their positions and widths, and the default time window, that let you define a subset of events. Views help to limit the scope of the events list so that you can more easily find what you are looking for.
 
     [bookmark: pgfId-436325]This section contains the following topics:
 
      
      	 [bookmark: pgfId-436330]Opening Views
 
      	 [bookmark: pgfId-436335]Floating and Arranging Views
 
      	 [bookmark: pgfId-436340]Customizing the Event Table Appearance
 
      	 [bookmark: pgfId-436345]Switching Between Source/Destination IP Addresses and Host Object Names
 
      	 [bookmark: pgfId-436350]Configuring Color Rules for a View
 
      	 [bookmark: pgfId-436355]Creating Custom Views
 
      	 [bookmark: pgfId-436360]Editing a Custom View Name or Description
 
      	 [bookmark: pgfId-436365]Switching Between Real-Time and Historical Views
 
      	 [bookmark: pgfId-436370]Saving Views
 
      	 [bookmark: pgfId-436375]Deleting Custom Views
 
     
 
    
 
     
      [bookmark: pgfId-436387][bookmark: 158681][bookmark: evntchap_proc_OpeningViews]Opening Views[bookmark: marker-436383][bookmark: marker-436385]
 
     [bookmark: pgfId-436389]You can open up to four historical views and one real-time view in Event Viewer. When you open a view, Event Viewer uses the view settings and time range to retrieve events from the event data store and display them in the event table.
 
      
      	 [bookmark: pgfId-436391]To open a view so that it replaces the currently active open view, do one of the following in Event Viewer:
 
     
 
     [bookmark: pgfId-436393] – Double-click the view in the views list.
 
     [bookmark: pgfId-436395] – Right-click the view in the view list and select Open.
 
      
      	 [bookmark: pgfId-436397]To open a view in a new tab, do one of the following:
 
     
 
     [bookmark: pgfId-436399] – Select File > Open View from the menu bar. The Open a View dialog box opens, which is essentially the same as the view list. Select the view and click OK.
 
     [bookmark: pgfId-436401] – Right-click the view in the views list and select Open In New Tab.
 
    
 
     
      [bookmark: pgfId-436421][bookmark: 158712][bookmark: evntchap_proc_FloatingandArrangingViews]Floating and Arranging Views[bookmark: marker-436407][bookmark: marker-436409][bookmark: marker-436411][bookmark: marker-436413][bookmark: marker-436415][bookmark: marker-436417][bookmark: marker-436419]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-436428]You have many options for arranging view windows based on your requirements. For example, you might want to compare two views side-by-side, or remove a view from the main window without closing it.
 
     [bookmark: pgfId-436430]You can use the following techniques to arrange the view windows to get the display that you desire:
 
      
      	 [bookmark: pgfId-436432]Floating a view—To remove a view from the main Event Viewer window without closing it, right-click the view tab and select  Floating . The view is moved to its own window.
 
     
 
     [bookmark: pgfId-436434]If you have already floated a view, you can select Floating to and choose one of the already-floated windows. The view becomes a new tab in that window.
 
      
      	 [bookmark: pgfId-436436]Docking a view—To move a floating view back to the main Event Viewer window, right-click the view tab and select  Docking .
 
      	 [bookmark: pgfId-436438]Arranging views horizontally or vertically for side-to-side comparison—To create a vertical or horizontal arrangement of views to allow for easy comparison, without floating the views, right-click the view tab and select  New Horizontal Group or  New Vertical Group . These commands split the current tabbed group into the selected layout. You must have at least two views open to use these commands. If you have more than two open views, and you want all of them in separate windows, you need to use the command multiple times.
 
      	 [bookmark: pgfId-436440]Move views to different tabbed groups—If you have several open views, and you have arranged them into horizontal or vertical groups, you can move views among the groups by right-clicking the view tab and selecting  Move to Next Tab Group or  Move to Previous Tab Group . The commands appear only if views are arranged in a manner where such movement is possible:
 
      	 [bookmark: pgfId-436442]Change the orientation of groups—You can switch between horizontal and vertical layouts by right-clicking the view tab and selecting  Change Tab Groups Orientation .
 
     
 
    
 
     
      [bookmark: pgfId-436452][bookmark: 158761][bookmark: evntchap_proc_CustomizingtheEventTableAppearance]Customizing the Event Table Appearance[bookmark: marker-436448][bookmark: marker-436450]
 
     [bookmark: pgfId-436454]You can customize the appearance of predefined or custom views in the event table to meet your requirements. You can save these changes even in the predefined views.
 
     [bookmark: pgfId-436456]You can do the following to customize the event table:
 
      
      	 [bookmark: pgfId-436461]Create column filters to limit the type of events listed. Use the down arrows in the column heading to define the filter as described in Creating Column-Based Filters.
 
      	 [bookmark: pgfId-436466]Create color rules to highlight events based on severity, as described in Configuring Color Rules for a View.
 
      	 [bookmark: pgfId-436471]Change which columns appear in the table by clicking the Column Selector icon to the right of the table heading row, as described in Columns in Event Table.
 
      	 [bookmark: pgfId-436473]Change the width of a column by clicking the right edge of the column heading and dragging it to the desired size.
 
      	 [bookmark: pgfId-436475]Change the order of the columns by clicking the column heading and dragging the column to the position you want.
 
      	 [bookmark: pgfId-436477]Sort the events list by a column by clicking the column heading. The column sorts based on a three-click cycle: ascending, descending, and default order (which is by event reception time).
 
      	 [bookmark: pgfId-436479]Reset the width of the View Selector and Event Monitoring window to their default values by selecting  View > Reset Layout .
 
      	 [bookmark: pgfId-436484]Change whether the source and destination columns show IP addresses or host object names, as described in Switching Between Source/Destination IP Addresses and Host Object Names.
 
     
 
     [bookmark: pgfId-436486]Related Topics:
 
      
      	 [bookmark: pgfId-436491]Creating Custom Views
 
      	 [bookmark: pgfId-436496]Saving Views
 
     
 
    
 
     
      [bookmark: pgfId-436504][bookmark: 158804][bookmark: evntchap_cncpt_SwitchingBetweenIPaddressandHostObjectName]Switching Between Source/Destination IP Addresses and Host Object Names[bookmark: marker-436502]
 
     [bookmark: pgfId-436506]You can view source and destination IP addresses or you can view the host object name of objects that match a source or destination IP address. By default, the Event Viewer shows host object names when available.
 
     [bookmark: pgfId-436508]IP address to host name mapping is supported only for the source and destination of events. Also, the mapping applies to Host objects only; Event Viewer will not show an object name when the source or destination of an event matches a Network object, Group object, or Address Range object.
 
     [bookmark: pgfId-436510]Please clarify the type and content of the object. E.g. is this feature for host type network/host objects only, that is, the single-value host version of the object? does it work for single-value group objects, or for network or range objects?
 
     [bookmark: pgfId-436512]To switch between source/destination IP addresses and host object names, do the following:
 
      
      	 [bookmark: pgfId-436514]To see host objects names for any objects that match a source or destination IP address, select  View > Show Network Host Objects . This option is selected by default.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-436516]Tip Hover over a host object name to view the IP address associated with that object.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-436518]Note An IP address to host object name cache is created when Event Viewer is launched. If you define new host objects, you must submit those changes to the database and then close and relaunch Event Viewer for those mappings to be used.

     
      

     

     
 
      
      	 [bookmark: pgfId-436520]To see IP addresses in the source and destination columns, deselect  View > Show Network Host Objects .
 
     
 
    
 
     
      [bookmark: pgfId-436536][bookmark: 158823][bookmark: evntchap_proc_ConfiguringColorRulesforaView]Configuring Color Rules for a View[bookmark: marker-436530][bookmark: marker-436532][bookmark: marker-436534]
 
     [bookmark: pgfId-436538]You can use color rules to color-code events shown in the event table based on the severity of the event. Color-coding can help you quickly identify the events that you most want to know about.
 
     [bookmark: pgfId-436540]You can selectively enable and disable color rules by editing them. This allows you to turn them on and off without deleting them.
 
      
       
     
 
     
 
     [bookmark: pgfId-436542]Tip You can configure color rules for both predefined and custom views. However, you cannot share color rules between views: all color rules are unique to a view. If you want to apply the same rules to multiple views, you must recreate the rules in each view.

     
      

     

     
 
     [bookmark: pgfId-436544]To define and enable a color rule, follow these steps:
 
     
 
     [bookmark: pgfId-436549]Step 1 Open the view in which you want to define the color rule (see Opening Views).
 
     [bookmark: pgfId-436554]Step 2 Click the Color Rules tab in the View Settings pane (see Event Monitoring Window).
 
     [bookmark: pgfId-436556]Step 3 Do any of the following:
 
      
      	 [bookmark: pgfId-436558]To add a new rule, click the  Add button. In the Add Color Rule dialog box, configure the rule as follows:
 
     
 
     [bookmark: pgfId-436560] – Select Enable to make the rule active.
 
     [bookmark: pgfId-436562] – Select the severity level for which the rule applies from the Severity list.
 
     [bookmark: pgfId-436564] – Use the Foreground (which is the text color), Background, and Font Type (either Bold or Italics) controls to define how the severity should be presented in the table. The Preview Text area shows how your rule will look.
 
      
      	 [bookmark: pgfId-436566]To edit a rule, select it and click the  Edit button.
 
      	 [bookmark: pgfId-436568]To delete a rule, select it and click the  Delete button.
 
     
 
     [bookmark: pgfId-436570]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-436582][bookmark: 158874][bookmark: evntchap_proc_CreatingCustomViews]Creating Custom Views[bookmark: marker-436578][bookmark: marker-436580]
 
     [bookmark: pgfId-436584]A custom view is one in which you define the filters in the view settings. Using custom views, you can configure filter rules to pin-point specific areas for monitoring and analysis. Custom views are private and cannot be shared between users.
 
     [bookmark: pgfId-436586]You basically have two options for creating custom views, creating a view from scratch or from an existing view:
 
      
      	 [bookmark: pgfId-436588]To create a custom view that has no predefined column filters, do one of the following:
 
     
 
     [bookmark: pgfId-436590] – Select File > New View from the menu bar.
 
     [bookmark: pgfId-436592] – Click the New button above the view list.
 
     [bookmark: pgfId-436594]Then, enter a name for the view and optionally a description of the view and click OK. The view is added to the My Views folder in the views list.
 
      
      	 [bookmark: pgfId-436596]To create a custom view based on an existing view, do one of the following:
 
     
 
     [bookmark: pgfId-436598] – With the desired base view open, click the down arrow on the Save button in the event table toolbar and select Save As, or select File > Save As from the menu bar.
 
     [bookmark: pgfId-436600] – Right-click the desired base view in the views list and select Save As.
 
     [bookmark: pgfId-436602]Then, enter a name for the view and optionally a description of the view and click OK. The view is added to the My Views folder in the views list. The new view has the same filters as the base view.
 
      
       
     
 
     
 
     [bookmark: pgfId-436604]Note View names can be up to 128 characters and contain alphanumeric characters, spaces, hyphens (-), underscore characters (_), plus signs (+), periods, and ampersands (&). The description can be up to 1024 characters.

     
      

     

     
 
     [bookmark: pgfId-436606]After you create the new view, you can customize it the same way that you can an existing view:
 
      
      	 [bookmark: pgfId-436611]Define filters in the view settings. See Creating Column-Based Filters.
 
      	 [bookmark: pgfId-436616]Define color rules in the view settings. See Configuring Color Rules for a View.
 
      	 [bookmark: pgfId-436621]Select the columns to display in the event table. See Columns in Event Table.
 
      	 [bookmark: pgfId-436626]Customize the event table appearance. See Customizing the Event Table Appearance.
 
     
 
     [bookmark: pgfId-436628]Related Topics
 
      
      	 [bookmark: pgfId-436633]Views and Filters
 
      	 [bookmark: pgfId-436638]Event Table Toolbar
 
      	 [bookmark: pgfId-436643]Editing a Custom View Name or Description
 
      	 [bookmark: pgfId-436648]Deleting Custom Views
 
     
 
    
 
     
      [bookmark: pgfId-436662][bookmark: 158941][bookmark: evntchap_proc_EditingaCustomViewNameorDescription]Editing a Custom View Name or Description[bookmark: marker-436656][bookmark: marker-436658][bookmark: marker-436660]
 
     [bookmark: pgfId-436664]To change the name of a custom view, or the custom view’s description, do one of the following:
 
      
      	 [bookmark: pgfId-436666]Select the custom view in the view list and click the  Edit button above the list.
 
      	 [bookmark: pgfId-436668]Right-click the custom view in the view list and select  Edit .
 
     
 
     [bookmark: pgfId-436670]Then, make the desired changes to the custom view name or description and click OK.
 
      
       
     
 
     
 
     [bookmark: pgfId-436672]Note View names can be up to 128 characters and contain alphanumeric characters, spaces, hyphens (-), underscore characters (_), plus signs (+), periods, and ampersands (&). The description can be up to 1024 characters.

     
      

     

     
 
     [bookmark: pgfId-436674]You cannot change the name or description of a predefined view.
 
    
 
     
      [bookmark: pgfId-436684][bookmark: 158967][bookmark: evntchap_cncpt_SwitchingBetweenRealTimeandHistoricalViews]Switching Between Real-Time and Historical Views[bookmark: marker-436680][bookmark: marker-436682]
 
     [bookmark: pgfId-436686]You can update the events table for any view using either real-time or historical time periods. A real-time view shows events as they are received, whereas an historical view shows a static list of events that is not updated until you click the Start button in the event table toolbar.
 
     [bookmark: pgfId-436688]To switch between real-time and historical time periods in an open view, do the following:
 
      
      	 [bookmark: pgfId-436693]To see events in real-time, select  View > Mode > Real Time , or click the Time Selector control in the event table toolbar and select  Real Time . For help in locating the control on the toolbar, see Event Table Toolbar.
 
      	 [bookmark: pgfId-436698]To see events in an historical period, select the desired time frame from the  View > Mode menu or from the Time Selector control on the event table toolbar. All options other than Real Time are historical views. For more information, see Selecting the Time Range for Events.
 
     
 
    
 
     
      [bookmark: pgfId-436710][bookmark: 158990][bookmark: evntchap_proc_SavingViews]Saving Views[bookmark: marker-436706][bookmark: marker-436708]
 
     [bookmark: pgfId-436712]If you edit the settings for a view, you must save it to make those changes permanent. Saving a view saves changes to filters (for custom views only), table preferences such as selected columns, column width, and sort order, the time range, and color rules. If you make filter changes to a predefined view, you must use Save As to create a new custom view.
 
      
      	 [bookmark: pgfId-436714]To save changes to a view, do one of the following in Event Viewer:
 
     
 
     [bookmark: pgfId-436716] – Select File > Save from the menu bar.
 
     [bookmark: pgfId-436718] – Click the Save button in the event table toolbar.
 
     [bookmark: pgfId-436720]You are asked to confirm that you want to save your changes.
 
      
      	 [bookmark: pgfId-436722]To save your changes as a new custom view, do one of the following to open the Save View As dialog box:
 
     
 
     [bookmark: pgfId-436724] – Select File > Save As from the menu bar.
 
     [bookmark: pgfId-436726] – Click the down arrow on the Save button in the event table toolbar and select Save As.
 
     [bookmark: pgfId-436728] – Right-click the view in the views list and select Save As.
 
     [bookmark: pgfId-436730]Then, enter a name for the view and optionally a description of the view and click OK. The view is added to the My Views folder in the views list.
 
      
       
     
 
     
 
     [bookmark: pgfId-436732]Note View names can be up to 128 characters and contain alphanumeric characters, spaces, hyphens (-), underscore characters (_), plus signs (+), periods, and ampersands (&). The description can be up to 1024 characters.

     
      

     

     
 
    
 
     
      [bookmark: pgfId-436742][bookmark: 159028][bookmark: evntchap_proc_DeletingCustomViews]Deleting Custom Views[bookmark: marker-436738][bookmark: marker-436740]
 
     [bookmark: pgfId-436744]You can delete custom views, but you cannot delete predefined views. To delete a custom view, do one of the following:
 
      
      	 [bookmark: pgfId-436746]Select it in the view list and click the  Delete (trash can) button above the list.
 
      	 [bookmark: pgfId-436748]Right-click it in the view list and select  Delete .
 
     
 
     [bookmark: pgfId-436750]You are asked to confirm your deletion.
 
    
 
     
      [bookmark: pgfId-436764][bookmark: 159047][bookmark: evntchap_cncpt_FilteringandQueryingEvents]Filtering and Querying Events[bookmark: marker-436756][bookmark: marker-436758][bookmark: marker-436760][bookmark: marker-436762]
 
     [bookmark: pgfId-436766]There are many options for filtering the events that appear in the event table. You can reduce the list of events by selecting the appropriate time range, by filtering on elements in specific columns, or even by searching on a text string.
 
     [bookmark: pgfId-436768]This section contains the following topics:
 
      
      	 [bookmark: pgfId-436773]Selecting the Time Range for Events
 
      	 [bookmark: pgfId-436778]Using the Time Slider with Filtering
 
      	 [bookmark: pgfId-436783]Refreshing the Event Table
 
      	 [bookmark: pgfId-436788]Creating Column-Based Filters
 
      	 [bookmark: pgfId-436793]Filtering Based on a Specific Event’s Values
 
      	 [bookmark: pgfId-436798]Filtering on a Text String
 
      	 [bookmark: pgfId-436803]Clearing Filters
 
     
 
    
 
     
      [bookmark: pgfId-436817][bookmark: 159066][bookmark: evntchap_cncpt_SelectingtheTimeRangeforEvents]Selecting the Time Range for Events[bookmark: marker-436809][bookmark: marker-436811][bookmark: marker-436813][bookmark: marker-436815]
 
     [bookmark: pgfId-436822]Use the Time Selector control in the event table toolbar, or the equivalent View > Mode command, to select the time range for displaying events. The event table lists only those events that occur within the selected time range. For help in locating the Time Selector control on the toolbar, see Event Table Toolbar.
 
      
       
     
 
     
 
     [bookmark: pgfId-436824]Tip For historical views, the time is based on server time, not the time configured on your workstation.

     
      

     

     
 
     [bookmark: pgfId-436829]When you change the time range, the table reloads to show events in the selected range. For historical views, you can refresh the events list by clicking Start or by doing the other actions described in Refreshing the Event Table.
 
     [bookmark: pgfId-436831]The following are your options for the time range:
 
      
      	 [bookmark: pgfId-436833]To view events from the present time into the past, select one of the following time periods:  last 10 minutes ,  last 1 hour ,  last 12 hours ,  last 1 day , or  last 1 week .
 
      	 [bookmark: pgfId-436835]To view events from today or yesterday, select  today or  yesterday , as desired.
 
      	 [bookmark: pgfId-436837]To view events from a specific day, select  is on and then select the date from the displayed calendar.
 
      	 [bookmark: pgfId-436839]To view events from a specific date and time range, select  is between and select the first and last days and times from the displayed calendars.
 
      	 [bookmark: pgfId-436841]To view real-time events, select Real Time.
 
     
 
    
 
     
      [bookmark: pgfId-436857][bookmark: 159113][bookmark: evntchap_proc_UsingtheTimeSliderwithFiltering]Using the Time Slider with Filtering[bookmark: marker-436847][bookmark: marker-436849][bookmark: marker-436851][bookmark: marker-436853][bookmark: marker-436855]
 
     [bookmark: pgfId-436859]You can use the vertical slider control in the time slider to change the start time for the events shown in the event table. This is particularly useful when you want to locate events and you know the approximate time they occurred.
 
     [bookmark: pgfId-436864]For details on the operation of the time slider, see Time Slider.
 
     [bookmark: pgfId-436866]To use the time slider to aid filtering, follow these steps:
 
     
 
     [bookmark: pgfId-436871]Step 1 Open an historical view, or use the Time Selector in the toolbar, or the View > Mode command, to select an appropriate time range, such as Last 10 Minutes. For more information, see Selecting the Time Range for Events.
 
     [bookmark: pgfId-436873]Step 2 Move the vertical slider to the approximate time of the events you want to examine.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-436880]Step 3 To locate the events, you can now do any of the following:
 
      
      	 [bookmark: pgfId-436885]Apply custom column filters. See Creating Column-Based Filters.
 
      	 [bookmark: pgfId-436890]Use the quick filter to search on a text string. See Filtering on a Text String.
 
      	 [bookmark: pgfId-436892]Scroll or page through the event table.
 
      	 [bookmark: pgfId-436897]Use the time slider paging controls to reset the time range forward or back. For more information, see Time Slider.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-436899]Note The distance moved forward or back when paging in the time slider depends either on the mode (time range) that is set or the number of events the event table can hold. The position of the vertical slider denotes the most recent event loaded in the event table.

     
      

     

     
 
     [bookmark: pgfId-436901]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-436915][bookmark: 159165][bookmark: evntchap_cncpt_RefreshingtheEventTable]Refreshing the Event Table[bookmark: marker-436907][bookmark: marker-436909][bookmark: marker-436911][bookmark: marker-436913]
 
     [bookmark: pgfId-436917]When you are using an historical mode, such as “last 10 minutes,” the latest events displayed correspond to the time you selected the time range or opened the view. Similarly, if you are in real-time mode and have clicked Stop, the event table does not include events that arrived after you stopped the event stream.
 
     [bookmark: pgfId-436919]To refresh the events listed in the event table, so that they are current with your selected time range, do any of the following:
 
      
      	 [bookmark: pgfId-436921]Click  Start in the toolbar, or select  View > Start . The table is refreshed based on your currently selected time range. For real-time views, the event stream restarts.
 
      	 [bookmark: pgfId-436923]Select a different time range using the Time Selector in the toolbar or the  View > Mode command.
 
      	 [bookmark: pgfId-436928]Select a different time slice using the vertical slider or the pagination controls in the time slider below the event table. For more information on using these controls, see Time Slider.
 
     
 
    
 
     
      [bookmark: pgfId-436946][bookmark: 159197][bookmark: evntchap_proc_CreatingColumnBasedFilters]Creating Column-Based Filters[bookmark: marker-436938][bookmark: marker-436940][bookmark: marker-436942][bookmark: marker-436944]
 
     [bookmark: pgfId-436948]You can filter the event table in Event Viewer based on the contents of specific columns. Column filters are the type of filter contained in the view settings; they define the basic content of the view. Whenever you apply a column filter, the view settings for the view are updated to include the newly selected filter: you must save the view before closing it if you want the new filter to become a permanent part of the view’s definition.
 
     [bookmark: pgfId-436950]There are many ways in which to define a column filter:
 
      
      	 [bookmark: pgfId-436952]In the View Settings pane, click the  Add button. You are first prompted to select the column on which to base the filter. When you click  OK , you are prompted to create the filter.
 
      	 [bookmark: pgfId-436954]In the View Settings pane, select a filter and click the  Edit button to change it.
 
      	 [bookmark: pgfId-436956]In the event table, click the down arrow button in the heading of a column and select any of the following from the drop-down list:
 
     
 
     [bookmark: pgfId-436958] – A specific entry. The drop-down list contains all values currently displayed in the events listed in the table.
 
     [bookmark: pgfId-436960] – (All). Select (All) to remove a filter from this column. The event table is updated to show the events that meet your other filter criteria.
 
     [bookmark: pgfId-436962] – (Custom). Select (Custom) to create a filter that might have multiple values, negative values, or be based on data not currently contained in the column in the current event table. Selecting (Custom) is essentially the same as creating a filter directly in the View Settings pane.
 
      
      	 [bookmark: pgfId-436964]In the event table, you can right-click a value and select  Filter This Value . This action has the same effect as selecting the value from the drop-down list for the column.
 
     
 
     [bookmark: pgfId-436966]You can alternatively select Filter Not This Value to create a filter that excludes a value,
 
      
      	 [bookmark: pgfId-436968]In the event table, you can right-click a value and select  Create Filter from Event . You are prompted to select the specific columns to include; the column on which you right-clicked is initially selected, but you can deselect it.
 
     
 
     [bookmark: pgfId-436970]The following procedure explains how to build a custom column-based filter, one in which you are not simply selecting a value from the column’s drop-down list.
 
     [bookmark: pgfId-436972]Tips
 
      
      	 [bookmark: pgfId-436974]Column filters are cumulative: for an event to appear in the event table for a view, the event must meet all column filter criteria. You cannot create a set of OR’ed column filters.
 
      	 [bookmark: pgfId-436976]Some columns allow you to select network/host or service policy objects to define the filter criteria. Selecting policy objects can simplify your filters. However, for a policy object to be selectable in a filter, the object must be committed to the database. If you create a new object for filtering purposes, ensure that you submit your changes in Configuration Manager (and if using Workflow mode with an approver, get the changes approved) before attempting to create the filter in Event Viewer.
 
     
 
     [bookmark: pgfId-436978]When using policy objects, the filtering recognizes whether a device-level override is defined for the object. For example, if you use a network/host object that contains 10.10.10.10, and Device A has an override to change the address to 10.10.10.12, events from Device A appear in the list only if the event matches 10.10.10.12. For devices that do not have overrides, the events must match 10.10.10.10. Furthermore, if Device A has an event that matches 10.10.10.10, that event is not listed because it does not match the device-level override. Thus, using policy objects can provide results that vary by device and therefore match more closely to your policy definitions.
 
     [bookmark: pgfId-436980]If your organization is using ACS to control user access, you must have the appropriate View Object privileges for network/host, network/host-IPv6, and service objects to use them in filters.
 
      
      	 [bookmark: pgfId-436982]You can filter on the contents of most but not all columns. If a column does not have a down arrow, you cannot filter on it. For example, you cannot filter on Description, Event Name, Generation Time, or Receive Time.
 
      	 [bookmark: pgfId-436984]The filter icon (a funnel) appears in the heading of a filtered column.
 
      	 [bookmark: pgfId-436989]For a description of the available columns, see Columns in Event Table.
 
     
 
     
 
     [bookmark: pgfId-436991]Step 1 Do one of the following:
 
      
      	 [bookmark: pgfId-436993]In the View Settings pane, click the  Add button. The Add Custom Filter to a Column dialog box opens. Select the column on which to base the filter and click  OK .
 
      	 [bookmark: pgfId-436995]In the View Settings pane, select a filter you want to change and click the  Edit button.
 
      	 [bookmark: pgfId-436997]From the drop-down list for a column, select  (Custom) .
 
      	 [bookmark: pgfId-436999]Right-click any cell in the desired column and select  Custom Filter .
 
     
 
     [bookmark: pgfId-437001]The Custom Filter dialog box opens for the selected column.
 
     [bookmark: pgfId-437003]Step 2 In the Custom Filter dialog box, select the desired values. The following illustration shows a typical example of this dialog box, for the Source column.
 
     [bookmark: pgfId-437006]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-437008]Following is a description of the controls you might find in the Custom Filter dialog box. Not all controls appear for every column:
 
      
      	 [bookmark: pgfId-437010] Available and Selected Items lists —In most cases, to select an item you highlight it in the left list, which contains the available values, and click the right arrow to move it to the list of selected values. You can select multiple values. The right list defines the filtered values.
 
     
 
     [bookmark: pgfId-437012]The items listed in the available values column are determined by the values currently present in the events listed in the events table. For address and service fields, the list also includes policy objects. If there are a lot of available values, you can search for the desired value by typing into the edit box above the list; the list is filtered as you type. Click the down arrow next to the Q to change how your search string is evaluated for matches.
 
     [bookmark: pgfId-437014]You can also select, or deselect, values using the following techniques:
 
     [bookmark: pgfId-437016] – Type the item into the edit box above the selected values list and click the + button. This technique is useful if there is a large number of available values, or if you want to filter on a value that is not present in the current events list.
 
     [bookmark: pgfId-437018] – Double-click an item in either list to move it to the other list.
 
     [bookmark: pgfId-437020] – Click the double-arrow buttons to move all items, regardless of your selection.
 
      
       
     
 
     
 
     [bookmark: pgfId-437022]Note In a limited number of cases, the Custom Filter dialog box contains a single list. For example, the dialog boxes for the Event Type ID and Device columns contain single selectors. In these cases, make your selection using the check boxes next to the items; selecting a folder selects all items in the folder.

     
      

     

     
 
      
      	 [bookmark: pgfId-437024] Filter on IPv6 Addresses —For columns that contain addresses, use this option to toggle between listing IPv4 and IPv6 addresses and network/host objects in the available values column. You can filter on either IPv4 addresses or IPv6 addresses, but not both, in a single view.
 
      	 [bookmark: pgfId-437026] Condition, Not —Defines the condition applied to the selected items, typically “is in.”
 
     
 
     [bookmark: pgfId-437028]To create a negative condition, so that selected values define the events to not include in the events table, select the Not option.
 
     [bookmark: pgfId-437030]Step 3 Click OK.
 
     [bookmark: pgfId-437032]The view settings are updated to include the new filter, and the events table is updated to show only those events that satisfy all filters.
 
     [bookmark: pgfId-437034]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-437050][bookmark: 159313][bookmark: evntchap_proc_FilteringBasedonaSpecificEventsValues]Filtering Based on a Specific Event’s Values[bookmark: marker-437042][bookmark: marker-437044][bookmark: marker-437046][bookmark: marker-437048]
 
     [bookmark: pgfId-437052]You can base a new filter on information contained within an event, or a single cell within an event, by right-clicking and choosing a filter command. When you filter using these commands, a column filter is added to the view settings. You can do the following:
 
      
      	 [bookmark: pgfId-437057]To create a filter based on multiple values in the selected event, select  Create Filter from Event , then select from the dialog box the values on which to filter. The dialog box lists only those columns that are displayed in the table; the current values are shown in parentheses. For an explanation of the columns, see Columns in Event Table.
 
      	 [bookmark: pgfId-437059]To filter on only the value in the cell on which you right-click, select  Filter This Value .
 
      	 [bookmark: pgfId-437061]To filter to exclude the value in the cell on which you right-click, select  Filter Not this Value . All events that do not contain the selected value in this column, including all empty cells, are shown in the table.
 
      	 [bookmark: pgfId-437063]To filter on the flow of the selected event, based on source, source service, destination, and destination service, select  Filter This Flow .
 
     
 
    
 
     
      [bookmark: pgfId-437079][bookmark: 159349][bookmark: evntchap_cncpt_FilteringonaTextString]Filtering on a Text String[bookmark: marker-437069][bookmark: marker-437071][bookmark: marker-437073][bookmark: marker-437075][bookmark: marker-437077]
 
     [bookmark: pgfId-437081]Use the quick filter to search for text strings in events. As you type a search keyword, the events table automatically excludes non-matching events as you type. You can search on all columns (the default), or you can select a specific column in which to search.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-437091]To perform a search, simply type in the search string. To change how the string is evaluated, click the down arrow next to the Q (magnifying glass) in the left of the edit box. You can limit the search scope using these controls:
 
      
      	 [bookmark: pgfId-437093]Column name—Select a specific column to search only within that column. The list includes all columns currently displayed in the table. The default is to search all columns.
 
      	 [bookmark: pgfId-437095]Case sensitivity—Select  Case sensitive or  Case insensitive to control whether capitalization is considered when selecting matches. The default is case insensitive.
 
      	 [bookmark: pgfId-437097]Wild card usage—Select  Use Wild Cards to have the following characters evaluated as wild cards:
 
     
 
     [bookmark: pgfId-437099] – * (asterisk)—matches 0 or more characters.
 
     [bookmark: pgfId-437101] – ? (question mark)—matches one character.
 
      
      	 [bookmark: pgfId-437103]Match method—Select one of the following to determine the location within a cell that the search string should reside:
 
     
 
     [bookmark: pgfId-437105] – Match from start—The string must be at the beginning of the cell.
 
     [bookmark: pgfId-437107] – Match exactly—The cell must contain all and only the search string.
 
     [bookmark: pgfId-437109] – Match anywhere—The string can appear anywhere within the cell.
 
     [bookmark: pgfId-437111]To remove the search string, simply delete it from the quick filter edit box.
 
     [bookmark: pgfId-437113]For example, if you want to find events that relate to ports that start with tcp/48, type tcp/48 into the quick filter. In the following illustration, note that all but six events are filtered out of the table. In this example, the search string is found in the Source Service column for the first five events, but in the Destination Service column for the sixth event. If you know beforehand that you are interested in destination services only, you could select Destination Service from the quick filter drop-down list and the table would show the last event only.
 
     [bookmark: pgfId-437116]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-437130][bookmark: 159407][bookmark: evntchap_cncpt_ClearingFilters]Clearing Filters[bookmark: marker-437122][bookmark: marker-437124][bookmark: marker-437126][bookmark: marker-437128]
 
     [bookmark: pgfId-437132]When you apply filters to the event table, non-matching events are not displayed. You might find that you need to see the non-matching events. You can either open a different view that applies different (or no) filters, or you can clear filters from the current view.
 
     [bookmark: pgfId-437134]When clearing filters, the filter definition is removed from the view settings, but the change is not permanent until you click Save. Thus, you can remove filters temporarily without redefining the view settings.
 
     [bookmark: pgfId-437136]You can clear filters one at a time or clear all filters:
 
      
      	 [bookmark: pgfId-437138]To clear a single filter, so any of the following:
 
     
 
     [bookmark: pgfId-437140] – Select the filter in the View Settings pane and click Delete.
 
     [bookmark: pgfId-437142] – Select (All) from the drop-down list of a filtered column.
 
     [bookmark: pgfId-437144] – Right-click in the filtered column and select Clear This Filter.
 
      
      	 [bookmark: pgfId-437146]To clear all filters, right click in the events table and select  Clear all filters .
 
     
 
    
 
     
      [bookmark: pgfId-437156][bookmark: 159447][bookmark: evntchap_cncpt_PerformingOperationsonSpecificEvents]Performing Operations on Specific Events[bookmark: marker-437152][bookmark: marker-437154]
 
     [bookmark: pgfId-437158]You can operate upon a single event in the event table in a variety of ways, which include the following:
 
      
      	 [bookmark: pgfId-437160] Right-click —Right-clicking a single event in the event table opens a context menu with commands that you can use on the event. For more information about what you can do from the right-click menu, see the following topics:
 
     
 
     [bookmark: pgfId-437165] – Event Context (Right-Click) Menu
 
     [bookmark: pgfId-437170] – Examining Details of a Single Event
 
     [bookmark: pgfId-437175] – Copying Event Records
 
     [bookmark: pgfId-437180] – Saving Events to a File
 
     [bookmark: pgfId-437185] – Filtering Based on a Specific Event’s Values
 
      
       
     
 
     
 
     [bookmark: pgfId-437190]Note You can hover your mouse over a valid IPv4 address in Event Viewer to launch the IP Intelligence tool for that IP address. The IP Intelligence tool provides various pieces of information about an IPv4 address, such as the fully qualified domain name (FQDN), geographic location information, and WHOIS information. For more information on the IP Intelligence tool, see IP Intelligence.

     
      

     

     
 
      
      	 [bookmark: pgfId-437192] Select an event —When you click a single event in the event table it is highlighted and the Event Details pane displays details for that particular event. Hold the  Ctrl key to select additional events, or hold the  Shift key to select a range of events.
 
      	 [bookmark: pgfId-437197] Double-click an event —Double-clicking a single event in the event table opens the Event Details dialog box, which shows the event information in an easier-to-read format. From the Event Details dialog box, you can print the displayed details or copy some, or all, of the details to the clipboard for pasting into another program. You can use the Next and Previous buttons to scroll through the events listed in the event table. For information on the meaning of the attributes, see Columns in Event Table.
 
     
 
     [bookmark: pgfId-437199]Alternatively, you can right-click on an event and select Show All Details to open the Event Details dialog box.
 
    
 
     
      [bookmark: pgfId-437211][bookmark: 159489][bookmark: evntchap_cncpt_EventContextRightClickMenu]Event Context (Right-Click) Menu[bookmark: marker-437205][bookmark: marker-437207][bookmark: marker-437209]
 
     [bookmark: pgfId-437213]When you right-click an event in the Event Table, a context menu appears that provides commands that you can use with the selected event. The specific list of available commands depends on the type of event and also the specific cell on which you right-click. The following table explains all of the available commands.
 
      
       
     
 
     
 
     [bookmark: pgfId-437218]Note In addition to the right-click options listed below, you can also hover your mouse over a valid IPv4 address in Event Viewer to launch the IP Intelligence tool for that IP address. The IP Intelligence tool provides various pieces of information about an IPv4 address, such as the fully qualified domain name (FQDN), geographic location information, and WHOIS information. For more information on the IP Intelligence tool, see IP Intelligence.

     
      

     

     
 
     [bookmark: pgfId-437221]
 
      
       
        
        [bookmark: pgfId-434238]Table 68-9 [bookmark: 159507]Event Context Menu 
 
        
       
         
         	
           
           [bookmark: pgfId-434244]Command
          
  
         	
           
           [bookmark: pgfId-434246]Description
          
  
        
 
         
         	[bookmark: pgfId-434252]Clear This Filter
  
         	[bookmark: pgfId-434254]Removes the filter defined for this column. The command is available only if you right-click on a cell that is in a filtered column.
 [bookmark: pgfId-434256]The filter is removed from the view settings. You must save the view to make your change permanent.
  
        
 
         
         	[bookmark: pgfId-434262]Clear All Filters
  
         	[bookmark: pgfId-434264]Removes all filters from the view settings. This command is available only if there is at least one column filter.
 [bookmark: pgfId-434266]You must save the view to make your change permanent.
  
        
 
         
         	[bookmark: pgfId-434272]Filter This Value
 [bookmark: pgfId-434274]Filter Not This Value
  
         	[bookmark: pgfId-434276]Creates a column filter based on the value in the cell that you right click. You can create either a positive or negative filter based on the value.
 [bookmark: pgfId-434278]The view settings are updated with the new filter and replace any existing filter for this column. You must save the view to make your change permanent.
  
        
 
         
         	[bookmark: pgfId-434284]Create Filter from Event
  
         	[bookmark: pgfId-434286]Creates a set of column filters based on the values in the selected event. You are prompted to select the specific columns to include; the column on which you right-clicked is initially selected, but you can deselect it.
 [bookmark: pgfId-434288]The view settings are updated with the new filters and any existing column filters for the selected columns are replaced. You must save the view to make your changes permanent.
  
        
 
         
         	[bookmark: pgfId-434294]Custom Filter
  
         	[bookmark: pgfId-434299]Creates a custom column filter, as described in Creating Column-Based Filters.
 [bookmark: pgfId-434301]The view settings are updated with the new filter and any existing filters for the selected columns are replaced. You must save the view to make your changes permanent.
  
        
 
         
         	[bookmark: pgfId-434307]Filter This Flow
  
         	[bookmark: pgfId-434309]Creates a set of column-based filters that present the events related to a specific traffic flow. Filtered columns are source and source service and destination and destination service.
 [bookmark: pgfId-434311]The view settings are updated with the new filter and any existing filters for the selected columns are replaced. You must save the view to make your changes permanent.
  
        
 
         
         	[bookmark: pgfId-434317]Show IPLogs
  
         	[bookmark: pgfId-434319]Opens the IP log for an IPS Alert event using an external packet analyzer tool. You must have a packet analyzer installed and associated with *.pcap file extension.
  
        
 
         
         	[bookmark: pgfId-434325]Show All Details
  
         	[bookmark: pgfId-434327]Opens the Event Details dialog box for the event, which shows all event information in an easier-to-read format. You can also print the details or copy them to the clipboard.
 [bookmark: pgfId-434329]The details are the same as those shown in the Event Details pane below the event table.
  
        
 
         
         	[bookmark: pgfId-434335]Copy commands
  
         	[bookmark: pgfId-434340]You can use the following commands to copy event data to the clipboard. You can then paste the data into a spreadsheet or other program for your use. For more information, see Copying Event Records.
 
           
           	 [bookmark: pgfId-434342] Copy Cell —Copies the contents of the cell you right-click to the clipboard.
 
           	 [bookmark: pgfId-434344] Copy Selected Events —Copies the contents of all selected (high-lighted) events to the clipboard.
 
           	 [bookmark: pgfId-434346] Copy All Events —Copies the contents of all listed events to the clipboard.
 
          
 [bookmark: pgfId-434348]This command is useful only if you have filtered the event table to a manageable number of events.
  
        
 
         
         	[bookmark: pgfId-434354]Save Selected Events as HTML
 [bookmark: pgfId-434356]Save All Events as HTML
 [bookmark: pgfId-434358]Save Selected Events as CSV
 [bookmark: pgfId-434360]Save All Events as CSV
  
         	[bookmark: pgfId-434362]Saves either all events listed in the event table, or all selected (high-lighted) events, to an HTML or comma-separate values (CSV) file on your workstation. You are prompted to select the folder and enter the file name for the export file.
 [bookmark: pgfId-434367]For more information, see Saving Events to a File.
  
        
 
         
         	[bookmark: pgfId-434373]Go To Policy
  
         	[bookmark: pgfId-434378]Finds the policy that generated this event in the device’s policy configuration in Configuration Manager. This command is available only for events where a binoculars icon appears in the Event Name cell. For detailed information, see Looking Up a Security Manager Policy from Event Viewer.
  
        
 
         
         	[bookmark: pgfId-434384]Packet Capture
  
         	[bookmark: pgfId-434386]Opens the packet capture tool, where you can define criteria for capturing packets on the device.
  
        
 
         
         	[bookmark: pgfId-434392]Ping and TraceRoute
  
         	[bookmark: pgfId-434394]Opens the Ping, TraceRoute, and NS Lookup tool, where you can use these applications with the device from which the event was sent.
  
        
 
         
         	[bookmark: pgfId-434400]Tune Signature
  
         	[bookmark: pgfId-434402]Opens the IPS Signature Quick Tune dialog box where you can enable or disable the signature associated with the selected event, and modify the Base Risk Rating of the signature that is assigned to the device or shared policy.
 [bookmark: pgfId-434407]To tune a signature you must create or open a ticket. For more information see Working with Activities/Tickets.
 [bookmark: pgfId-434409]The Base Risk Rating value of the signature is calculated by multiplying the fidelity rating and the severity factor and dividing them by 100 (Fidelity Rating x Severity Factor /100). This value is read only; you cannot directly change it. To change the Base Risk Rating, you must alter the Severity and Fidelity values.
 
           
           	 [bookmark: pgfId-434411]Severity: The severity level that the signature will report: High, Medium, Low, or Informational, where,
 
          
 [bookmark: pgfId-434413] – High = 100
 [bookmark: pgfId-434415] – Medium = 75
 [bookmark: pgfId-434417] – Low = 50
 [bookmark: pgfId-434419] – Informational = 25
 
           
           	 [bookmark: pgfId-434421]Fidelity: The Fidelity Rating, or Signature Fidelity Rating (SFR), identifies the weight associated with how well this signature might perform in the absence of specific knowledge of the target. This rating can be any number from 0 to 100, with 100 indicating the most confidence in the signature.
 
          
  
        
 
       
      
 
     
 
    
 
     
      [bookmark: pgfId-437229][bookmark: 159635][bookmark: evntchap_cncpt_QuickTune]IPS Signature Quick Tune Dialog Box
 
     [bookmark: pgfId-437231]Use the IPS Signature Quick Tune dialog box to enable or disable the signature associated with the selected event, and modify the Base Risk Rating of the signature that is assigned to the device or shared policy.
 
     [bookmark: pgfId-437233]Navigation Path
 
     [bookmark: pgfId-437238]In Event Viewer, right-click a row (an event) and click Tune Signature. For more information, see Event Context (Right-Click) Menu.
 
    
 
     
      [bookmark: pgfId-437248][bookmark: 159645][bookmark: evntchap_cncpt_ExaminingDetailsofaSingleEvent]Examining Details of a Single Event[bookmark: marker-437244][bookmark: marker-437246]
 
     [bookmark: pgfId-437250]Each event contains a lot of specific information in many separate fields. Typically, you display a subset of these fields in the event table. When you want to see the complete details of an event, you can use either of the following:
 
      
      	 [bookmark: pgfId-437255] Event Details pane —Select the event and open the Event Details pane below the event table. You can open the pane by clicking anywhere in the “Event Details” title row, or you can select  View > Show Event Details from the menu. The Event Details pane organizes the information in tabs. For more information about this pane, see Event Details Pane.
 
      	 [bookmark: pgfId-437260] Event Details dialog box —You can open this dialog box by double-clicking the event, or by right-clicking the event and selecting  Show All Details . The information is presented as a flat list and shows the information that would be shown on the Details tab in the Event Details pane. For information on the meaning of the attributes, see Columns in Event Table.
 
     
 
     [bookmark: pgfId-437262]The Event Details dialog box includes the following controls:
 
     [bookmark: pgfId-437264] – Print button—Click this button to print the information. You are prompted to select a printer.
 
     [bookmark: pgfId-437266] – Copy button—Click the down arrow on this button and select All Rows or Selected Rows. The information is copied to the clipboard, and you can paste it into another application. Note that the Selected Rows command works only if you select at least one row in the table.
 
      
      	 [bookmark: pgfId-437268]Next, Previous buttons—Click these buttons to scroll through the events currently displayed in the event table. Next moves up and Previous moves down in the table.
 
     
 
    
 
     
      [bookmark: pgfId-437278][bookmark: 159676][bookmark: evntchap_cncpt_CopyingEventRecords]Copying Event Records[bookmark: marker-437274][bookmark: marker-437276]
 
     [bookmark: pgfId-437280]You can copy single events, multiple events, all events, or even the contents of a single cell to the clipboard. You can then paste the information into another application, such as a spreadsheet or an e-mail message.
 
     [bookmark: pgfId-437282]You can do the following from the event table:
 
      
      	 [bookmark: pgfId-437284] Copy selected events —To copy one or more selected events, right-click in the event table and select  Copy Selected Events . The event you right-click does not matter, the copied events are those that are selected (highlighted) in the table.
 
     
 
     [bookmark: pgfId-437286]Click an event to select it. Hold Ctrl key to select additional events, or hold the Shift key to select a range of events.
 
      
      	 [bookmark: pgfId-437288] Copy the contents of a single cell —To copy the contents of a single cell in one event, right-click the cell and select  Copy Cell . You cannot copy cell contents if there is more than one event selected in the table.
 
      	 [bookmark: pgfId-437290] Copy all events —To copy all the events shown in the event table, right-click anywhere in the table and select  Copy All Events .
 
     
 
    
 
     
      [bookmark: pgfId-437300][bookmark: 159703][bookmark: evntchap_cncpt_SavingEventstoaFile]Saving Events to a File[bookmark: marker-437296][bookmark: marker-437298]
 
     [bookmark: pgfId-437302]Rather than copying events to the clipboard and pasting them into another application, you can directly save events to an HTML or comma-separated values (CSV) file. HTML files are useful for viewing information, whereas you can open a CSV file in a spreadsheet application for further analysis and report generation.
 
     [bookmark: pgfId-437304]When saving event data, you are prompted to select a folder and enter a file name.
 
     [bookmark: pgfId-437306]You can do the following from the event table:
 
      
      	 [bookmark: pgfId-437308] Save selected events —To save one or more selected events, right-click in the event table and select either  Save Selected Events as HTML or  Save Selected Events as CSV . The event you right-click does not matter, the saved events are those that are selected (highlighted) in the table.
 
     
 
     [bookmark: pgfId-437310]Click an event to select it. Hold Ctrl key to select additional events, or hold the Shift key to select a range of events.
 
      
      	 [bookmark: pgfId-437312] Save all events —To save all the events shown in the event table, right-click anywhere in the table and select either  Save All Events as HTML or  Save All Events as CSV .
 
     
 
    
 
     
      [bookmark: pgfId-437334][bookmark: 159730][bookmark: evntchap_proc_LookingUpaSecurityManagerPolicyfromEventViewer]Looking Up a Security Manager Policy from Event Viewer[bookmark: marker-437318][bookmark: marker-437320][bookmark: marker-437322][bookmark: marker-437324][bookmark: marker-437326][bookmark: marker-437328][bookmark: marker-437330][bookmark: marker-437332]
 
     [bookmark: pgfId-437336]In Event Viewer, if an event was generated from an IPS signature policy, or from certain actions related to explicit access rules (such as denied access), you can quickly locate the related signature or access rule from the event itself.
 
     [bookmark: pgfId-437338]The main reason you would want to perform policy lookup is to adjust a policy based on the events that it is generating. For example, an access rule might be dropping traffic that you actually want to allow. Because you are looking at the event, you know there is a policy that is causing the event, so with a few clicks, you can get from that event to the policy that you need to reconfigure.
 
     [bookmark: pgfId-437340]You can look up policies from the following types of events:
 
      
      	 [bookmark: pgfId-437342]Firewall events—You can look up policies for the following syslog messages:
 
     
 
     [bookmark: pgfId-437344] – 106023—Denied IP packet.
 
     [bookmark: pgfId-437346] – 106100—Permit/Denied by ACL.
 
     [bookmark: pgfId-437348] – 302013—Built TCP (started a TCP session).
 
     [bookmark: pgfId-437350] – 302015—Built UDP (started a UDP session).
 
      
      	 [bookmark: pgfId-437352]IPS alert events—All IPS events that have valid signature and sub-signature identifiers.
 
     
 
     [bookmark: pgfId-437354]Tips and Caveats
 
      
      	 [bookmark: pgfId-437356]You cannot look up firewall policies for events that contain IPv6 addresses. You can look up IPS policies for IPv6 addresses, however.
 
      	 [bookmark: pgfId-437358]When a policy that is based on IP address alone and not on a user name triggers an event, the device looks up the IP address in the Active Directory and if a user name is associated with that IP address, the user name is added to the syslog. Hence, even if a policy does not contain a user name, the resulting syslog might contain it. Policies cannot be created with a destination user and, as a result, this field will not be used during policy lookup.
 
      	 [bookmark: pgfId-437360]If an event is generated for a policy that is configured based on source/destination FQDN, the resulting syslog will not contain the FQDN because of a device defect. In such cases, policy lookup will not work.
 
      	 [bookmark: pgfId-437362]If an event is generated for a policy that is based on user groups, the syslog will contain the specific user name that triggered the event and not the user group. In such cases, policy lookup will not work.
 
      	 [bookmark: pgfId-437364]Hash codes are required for successful policy lookups from syslog 106023 and 106100 events. These hash codes are available only if you deployed the configuration using Security Manager. If policy lookup fails, try deploying the configuration (either to the device or to a file), then try the policy lookup again.
 
      	 [bookmark: pgfId-437366]If you had applied a filter to the device’s policy table, and the rule or signature that generated an event is filtered from the current view, Security Manager cannot highlight it. Clear the filter and try again.
 
      	 [bookmark: pgfId-437368]If the event is caused by an implicit rule, such as the implicit  deny any at the end of access rules, Security Manager cannot highlight the rule. It is considered good practice to create an explicit deny any rule at the end of access lists.
 
      	 [bookmark: pgfId-437370]The target policy is always found in Device view, even if the device uses a shared policy. Device view is opened if necessary to highlight the policy.
 
      	 [bookmark: pgfId-437372]For IPS signatures, you might not be able to edit the signature if it is a default signature.
 
      	 [bookmark: pgfId-437374]For access rules, the selected rule is the best match for the event. It is possible that more than one rule would generate the same event if you have overlapping or redundant rules. In these cases, editing the selected rule might not completely eliminate the event, because a subsequent rule might perform the same action. Use the access rules tools to analyze and combine overlapping rules.
 
      	 [bookmark: pgfId-437376]For access rules, multiple rules might permit a packet during session creation, but the first rule only is highlighted.
 
      	 [bookmark: pgfId-437378]If your organization is using ACS to control access, you must have View Device privileges to the device, and also View privileges to the firewall or IPS policy, to perform policy lookup. If you do not have all permissions, you will get an “Unable to Find Matching Rule” error if you try to look up a matching rule.
 
     
 
     
 
     [bookmark: pgfId-437380]Step 1 Right-click the event in Event Viewer and select Go To Policy.
 
      
       
     
 
     
 
     [bookmark: pgfId-437382]Tip You can identify whether you can look up policies from the event by looking at the Event Name cell in the table. If there is a binoculars icon before the event name, policy lookup is available. Also, if the Go To Policy command is greyed out, you cannot look up policies for that type of event.

     
      

     

     
 
     [bookmark: pgfId-437390]Step 2 Security Manager finds the related access rule or IPS signature for the device and highlights it in the policy table. From here, you can edit the policy to view or change it; for detailed instructions, see Configuring Access Rules and Configuring Signatures.
 
     [bookmark: pgfId-437392]Your changes do not take effect until you submit and deploy the updated configurations.
 
     [bookmark: pgfId-437394]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-437408][bookmark: 159817][bookmark: evntchap_cncpt_LookingUpEventsforaSecurityManagerPolicy]Looking Up Events for a Security Manager Policy[bookmark: marker-437400][bookmark: marker-437402][bookmark: marker-437404][bookmark: marker-437406]
 
     [bookmark: pgfId-437410]You can look up events in Event Viewer that relate to specific firewall access rules or IPS signatures. You can also look up events that relate to specific devices or site-to-site tunnels in Health and Performance Monitor.
 
     [bookmark: pgfId-437412]When Event Viewer receives events, they are parsed, “sessionized,” written to an event buffer, and then written to the database. Sessionizing takes two forms: with a session-oriented protocol, such as TCP, the session encompasses the initial handshake to the connection tear-down; with a sessionless protocol, such as UDP, the session start and end times are based more on first and last packets tracked within a restricted time period—packets that fall outside of the time period are considered parts of other sessions.
 
     [bookmark: pgfId-437414]Because there is a difference between newly-received and fully processed data, you can look up either real-time or historical events:
 
      
      	 [bookmark: pgfId-437416] Real-time —Because sessionization takes time, keeping an event in cache for up to two minutes, you can use the real-time event query to view events right after parsing, providing access to the most current data received.
 
      	 [bookmark: pgfId-437418] Historical —Historical event reports help you identify trends over longer periods of time than is possible with real-time monitoring. For historical events, the Result Format is the All Matching Events option, and the Filter By Time value is set to the previous 10 minutes.
 
     
 
     [bookmark: pgfId-437420]The following topics explain event lookup in more detail:
 
      
      	 [bookmark: pgfId-437425]Viewing Events for an Access Rule
 
      	 [bookmark: pgfId-437430]Viewing Events for an IPS Signature
 
      	 [bookmark: pgfId-437435]Viewing Events for HPM Devices and Site-to-Site VPNs
 
     
 
    
 
     
      [bookmark: pgfId-437451][bookmark: 159856][bookmark: evntchap_proc_NavigatingtoEventsfromanAccessRulePolicy]Viewing Events for an Access Rule[bookmark: marker-437441][bookmark: marker-437443][bookmark: marker-437445][bookmark: marker-437447][bookmark: marker-437449]
 
     [bookmark: pgfId-437453]From the Firewall > Access Rules policy in Security Manager, you can select an access rule and view related event information in Event Viewer. You can view real-time or historical events matching the rule. You can view events for ASA (including ASA-SM) and FWSM devices.
 
     [bookmark: pgfId-437458]Firewall access rules are presented in the form of an ordered list or table. When deployed, this policy becomes an access-control list (ACL), with each entry in the list known as an access-control entry (ACE). (For more detailed information, see Understanding Access Rules.)
 
     [bookmark: pgfId-437463]When deciding whether to forward or drop a packet, a device tests the packet against each access rule in the ordered listed. If you enable logging for an access rule, the results of the test are recording according to your per-rule log settings. Some devices, such as ASA, generate log entries for denied access even if you do not configure logging explicitly. For information on creating access rules, including logging options, see Configuring Access Rules.
 
     [bookmark: pgfId-437468]If logging is enabled for the rule (in the Advanced and Edit Options Dialog Boxes), the device sends syslog messages to Event Viewer to record the logged events. This query includes the access-rule parameters, including available keyword information. Reported events do not include connection set-up and tear-down.
 
     [bookmark: pgfId-437470]To view rule-related events, use the following right-click commands:
 
      
      	 [bookmark: pgfId-437472] Show Events > Realtime —To view real-time query results in Event Viewer for events matching this rule. You can change the query criteria in the Event Monitoring window at any time, applying new parameters to alter the real-time results.
 
      	 [bookmark: pgfId-437474] Show Events > Historical —To view historical query results in Event Viewer for events matching this rule. You can change the query criteria in the Event Monitoring window at any time, applying new parameters to alter the historical results.
 
     
 
     [bookmark: pgfId-437476]Security Manager provides the following information to Event Viewer as criteria for access-rule event queries:
 
      
      	 [bookmark: pgfId-437478]Device details—General information about the device, such as host name, domain name, management IP address, and display name.
 
      	 [bookmark: pgfId-437480]Source addresses—Source addresses of hosts and the network/host objects expanded to display the networks or collections of IP addresses.
 
      	 [bookmark: pgfId-437482]Destination addresses—Destination addresses of hosts and the network/host objects expanded to display the networks or collections of IP addresses.
 
      	 [bookmark: pgfId-437484]Service—Protocol and port information.
 
      	 [bookmark: pgfId-437486]Event Type—“Built/teardown/permitted IP connection” for permit rules and “Deny packet due to security policy” for deny rules.
 
     
 
     [bookmark: pgfId-437488]Notes:
 
      
      	 [bookmark: pgfId-437490]You can query on only one access rule at a time.
 
      	 [bookmark: pgfId-437492]When NAT or PAT is configured on a security device, the source and destination addresses are mapped to pre-translation and post-translation addresses, respectively, and the translated addresses are used when Security Manager sends a query to Event Viewer. For inbound access rules, the destination address is considered the pre-translation address, and for outbound access rules, the source address is considered the post-translation address.
 
      	 [bookmark: pgfId-437494]Filtering with multiple services (like UDP, TCP, and ICMP) might not give accurate results. To work around this problem, you can remove some of the filters after Event Viewer is launched.
 
      	 [bookmark: pgfId-437496]Filtering based on ICMP sub types is not supported. For example, if an ACE has ’ICMP Echo’ in service, the filter is applied only for the protocol (ICMP), but not for type column (Echo) in Event Viewer.
 
      	 [bookmark: pgfId-437498]Service ports with ’eq’, ’neq’, ’gt’, and ’lt’ are not supported in cross launch to Event Viewer.
 
     
 
     [bookmark: pgfId-437500]Related Topics
 
      
      	 [bookmark: pgfId-437505]Access Rules Page
 
      	 [bookmark: pgfId-437510]Looking Up Events for a Security Manager Policy
 
      	 [bookmark: pgfId-437515]Viewing Events for an IPS Signature
 
      	 [bookmark: pgfId-437520]Viewing Events for HPM Devices and Site-to-Site VPNs
 
     
 
    
 
     
      [bookmark: pgfId-437538][bookmark: 159933][bookmark: evntchap_proc_NavigatingtoEventsfromanIPSSignaturePolicy]Viewing Events for an IPS Signature[bookmark: marker-437526][bookmark: marker-437528][bookmark: marker-437530][bookmark: marker-437532][bookmark: marker-437534][bookmark: marker-437536]
 
     [bookmark: pgfId-437540]When an IPS device detects and reports a network intrusion by comparing incoming traffic to a configured signature, a syslog message is generated on the device. If the device is monitored by Security Manager, an incident is generated in Event Viewer after the log associated with the signature is obtained from the device. Looking up the events associated with a specific signature lets you quickly identify attacks and tune your device configuration to minimize or prevent intrusions.
 
     [bookmark: pgfId-437542]To view reported network intrusion events in Event Viewer, you can select one or more entries in the Signatures policy for a device in Security Manager and navigate to the Event Viewer to view real-time and historical events.
 
     [bookmark: pgfId-437544]Related Topics
 
      
      	 [bookmark: pgfId-437549]Looking Up Events for a Security Manager Policy
 
      	 [bookmark: pgfId-437554]Viewing Events for an Access Rule
 
      	 [bookmark: pgfId-437559]Viewing Events for HPM Devices and Site-to-Site VPNs
 
     
 
     
 
     [bookmark: pgfId-437564]Step 1 (Device view) With an IPS device selected, select IPS > Signatures > Signatures to display the Signatures Page.
 
     [bookmark: pgfId-437566]Step 2 Right-click the desired entry in the signatures table, or select multiple entries before right-clicking one of them, and choose one of the following commands from the Show Events menu:
 
      
      	 [bookmark: pgfId-437568] Realtime —To view real-time query results in Event Viewer for events matching this signature. Use this option to view raw events as they stream to Event Viewer.
 
     
 
     [bookmark: pgfId-437570]You can change the query criteria in the Event Monitoring window at any time, applying new parameters to alter the real-time results.
 
      
      	 [bookmark: pgfId-437572] Historical —To view historical query results in Event Viewer for events matching this signature.
 
     
 
     [bookmark: pgfId-437574]You can change the query criteria in the Event Monitoring window at any time, applying new parameters to alter the results.
 
     [bookmark: pgfId-437576]Tips:
 
      
      	 [bookmark: pgfId-437578]If a signature is disabled, you are warned and asked if you want to proceed to event lookup.
 
      	 [bookmark: pgfId-437580]Events of type Packet Data and Context Data are not displayed in the query results because these events are not triggered by signature rules.
 
     
 
     [bookmark: pgfId-437582]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-437596][bookmark: 159996][bookmark: evntchap_proc_NavigatingtoEventsfromHPM]Viewing Events for HPM Devices and Site-to-Site VPNs[bookmark: marker-437588][bookmark: marker-437590][bookmark: marker-437592][bookmark: marker-437594]
 
     [bookmark: pgfId-437598]From Health and Performance Monitor, you can quickly access events for a monitored device or for site-to-site VPNs that have had a tunnel up/down event.
 
     [bookmark: pgfId-437600]To view events for a monitored device, select a device from the All Devices, Firewall Devices, IPS Devices, Priority Devices, or custom device-related view, and with the Summary tab selected in the device details area, click the View Events button. Event Viewer opens and the Event Monitoring window lists events filtered by the selected device and the time period specified by the slider bar.
 
     [bookmark: pgfId-437602]To view related events for a site-to-site VPN that has had a tunnel up/down event, do one of the following:
 
      
      	 [bookmark: pgfId-437604]From the Site-to-Site Tunnels view, click on the Down notification hyperlink in the Status column.
 
      	 [bookmark: pgfId-437606]From the Alerts view, click on the hyperlink in the Description column for tunnel up/down alerts.
 
     
 
     [bookmark: pgfId-437608]Event Viewer will show IPSec VPN Events for the device within a time range depending on the polling interval for that device. If it is a priority device, the time range will be 5 minutes before until 5 minutes after the first up/down notification was received. For non-priority devices, the time range will be +/- 10 minutes instead of 5 minutes.
 
     [bookmark: pgfId-437610]Related Topics
 
      
      	 [bookmark: pgfId-437615]Chapter 70, “Health and Performance Monitoring”
 
      	 [bookmark: pgfId-437620]Looking Up Events for a Security Manager Policy
 
      	 [bookmark: pgfId-437625]Viewing Events for an Access Rule
 
      	 [bookmark: pgfId-437630]Viewing Events for an IPS Signature
 
     
 
    
 
   
 
    
     [bookmark: pgfId-437640][bookmark: 160039][bookmark: evntchap_intro_ExamplesofEventAnalysis]Examples of Event Analysis[bookmark: marker-437636][bookmark: marker-437638]
 
    [bookmark: pgfId-437642]There are many different techniques you can use to analyze and respond to events generated by your network devices. The examples in this section can help you understand some of the things you can do with the Security Manager Event Viewer.
 
    [bookmark: pgfId-437644]This section contains the following topics:
 
     
     	 [bookmark: pgfId-437649]Help Desk: User Access To a Server Is Blocked By the Firewall
 
     	 [bookmark: pgfId-437654]Monitoring and Mitigating Botnet Activity
 
     	 [bookmark: pgfId-437659]Removing False Positive IPS Events from the Event Table
 
    
 
     
      [bookmark: pgfId-437673][bookmark: 160050][bookmark: evntchap_proc_HelpDeskUserAccesstoServerBlockedbyFirewall]Help Desk: User Access To a Server Is Blocked By the Firewall[bookmark: marker-437665][bookmark: marker-437667][bookmark: marker-437669][bookmark: marker-437671]
 
     [bookmark: pgfId-437675]In this example, the help desk gets a call from a user who cannot access a server.
 
     [bookmark: pgfId-437677]There are many reasons that a user might not be able to access a server, such as:
 
      
      	 [bookmark: pgfId-437679]Problems at the server’s end of the network, including server down, no network connection, or the server’s firewall is actively preventing access by policy.
 
      	 [bookmark: pgfId-437681]Problems in the network cloud between the user and the server, such as routing problems.
 
      	 [bookmark: pgfId-437683]Problems in the user’s network, which could include workstation problems, physical problems with a network connection (for example, broken wires), problems with the switch port or wireless access point, DNS lookup failures, and so forth.
 
     
 
     [bookmark: pgfId-437685]The Security Manager Event Viewer cannot identify or resolve these problems. However, it can identify whether a firewall that you control is blocking access to the server. This can help you either to rule out the firewall as being the source of the problem, or if it is blocking access, to fix the problem or to inform the user that the server is blocked by policy.
 
     [bookmark: pgfId-437687]This procedure assumes that you have first determined that access to the server is not being denied by policy and that the firewall should allow access to the server.
 
     
 
     [bookmark: pgfId-437689]Step 1 Ask the user for the IP address of the workstation and server.
 
     [bookmark: pgfId-437691]Step 2 Open Event Viewer, for example, by selecting Launch > Event Viewer in Configuration Manager.
 
     [bookmark: pgfId-437693]Step 3 Double-click the Firewall Traffic Events view to open it. Optionally, you can use the All Device Events view if you also want to see if there are any IPS events related to the workstation.
 
      
       
     
 
     
 
     [bookmark: pgfId-437695]Tip You can also select the Firewall Denied Events view to see just denial events. However, you might want to see other events related to the user’s workstation.

     
      

     

     
 
     [bookmark: pgfId-437697]Step 4 Ask the user to retry the server access.
 
     [bookmark: pgfId-437699]Step 5 Click the Start button, or select View > Start, to refresh the event table with the latest events.
 
     [bookmark: pgfId-437701]Step 6 Type the user’s IP address into the Search within Results box. The list of events is filtered as you type, and presents events in which the search string appears in any column. In the following illustration, the event list shows all events in the past 10 minutes for the IP address 10.52.150.50.
 
     [bookmark: pgfId-437705]Figure 68-5 [bookmark: 160100]Restricting the Events List to One IP Address
 
     [bookmark: pgfId-437708]
 
      
      [image: ] 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-437710]Tip You can also select the IP address from the Source column’s drop-down list, and the server’s IP address from the Destination column’s drop-down list (or the reverse), to show only events with both the source and destination that interests you. Use the column filters if the search string does not sufficiently reduce the event list for easy analysis.

     
      

     

     
 
     [bookmark: pgfId-437712]Step 7 Look for an event that indicates that traffic from the user’s workstation to the server, or from the server to the workstation, was denied. Syslog 106xxx messages indicate denial actions.
 
     [bookmark: pgfId-437714]Select the event in the table and open the Event Details pane at the bottom of the window. The tabs in this pane show the complete message information and include plain-language explanations and recommended actions.
 
     [bookmark: pgfId-437716]Step 8 If the event is message 106023 or 106100, you can quickly locate the access rule that is denying the connection and fix it. You can identify whether you can look up policies from the event by looking at the Event Name cell in the table. If there is a binoculars icon before the event name, policy lookup is available. Also, if the Go To Policy command is greyed out, you cannot look up policies for that type of event.
 
      
       
     
 
     
 
     [bookmark: pgfId-437721]Tip If the traffic is denied because of the implicit deny any rule at the end of the access list, the Go To Policy command cannot take you to the rule. For tips about rule lookup, see Looking Up a Security Manager Policy from Event Viewer.

     
      

     

     
 
     [bookmark: pgfId-437723] a. Right-click the event and select Go To Policy. You are taken to Device view with the rule selected. You are notified if a matching rule cannot be found.
 
     [bookmark: pgfId-437728] b. Modify the rule so that it allows the desired access. This might be as simple as deleting the rule, or you might have to add a new rule that specifically allows traffic to or from the destination server (place the permit rule above the deny rule). Your organization’s security policy determines the allowable changes. For more information about configuring the access rules policy, see Configuring Access Rules.
 
     [bookmark: pgfId-437736] c. Submit and deploy the updated configuration to the device. For more information on the deployment process, see Deploying Configurations in Non-Workflow Mode or Deploying Configurations in Workflow Mode.
 
     [bookmark: pgfId-437738]Wait for deployment to complete successfully.
 
     [bookmark: pgfId-437740]Step 9 Ask the user to try to access the server again. If access is again denied, click Start in Event Viewer to refresh the events list and find the latest denial event.
 
      
       
     
 
     
 
     [bookmark: pgfId-437745]Tip There might be more than one access rule that can deny communications with the server. The access rule policy is processed in order, top to bottom, so deleting a rule that prevents access can result in a rule that previously was not being hit suddenly becoming active. If you have a very long access rule policy, you could have several rules that you will have to remove one after the other. Alternatively, you could use the Rule Combiner tool to consolidate and simplify your access rules policy; for more information, see Combining Rules.

     
      

     

     
 
     [bookmark: pgfId-437747]Step 10 Continue to resolve access denial events until the firewall is no longer blocking access.
 
      
       
     
 
     
 
     [bookmark: pgfId-437752]Tip You can also use the Packet Tracer tool to simulate traffic going through the ASA device from the workstation to the server. In Device view, right-click the device that is denying access and select Packet Tracer. For more information, see Analyzing an ASA or PIX Configuration Using Packet Tracer.

     
      

     

     
 
     [bookmark: pgfId-437754]After resolving all events, if the user still cannot reach the server, you know that the firewall is no longer one of the network elements that is blocking access. Consider other intervening network devices; perhaps a router includes an access rule that blocks the traffic.
 
     [bookmark: pgfId-437756]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-437768][bookmark: 160141][bookmark: evntchap_cncpt_MonitoringandMitigatingBotnetActivity]Monitoring and Mitigating Botnet Activity[bookmark: marker-437762][bookmark: marker-437764][bookmark: marker-437766]
 
     [bookmark: pgfId-437773]After you configure Botnet Traffic Filtering as described in Chapter 19, “Managing Firewall Botnet Traffic Filter Rules”, you want to monitor it and resolve any problems identified in your network. You can use Security Manager and ASDM to monitor Botnet activity, and mitigate identified problems, as explained in the following sections:
 
      
      	 [bookmark: pgfId-437778]Understanding the Syslog Messages That Indicate Actionable Events
 
      	 [bookmark: pgfId-437783]Monitoring Botnet Using the Security Manager Event Viewer
 
      	 [bookmark: pgfId-437788]Monitoring Botnet Using the Security Manager Report Manager
 
      	 [bookmark: pgfId-437793]Monitoring Botnet Activity Using the Adaptive Security Device Manager (ASDM)
 
      	 [bookmark: pgfId-437798]Mitigating Botnet Traffic
 
     
 
    
 
     
      [bookmark: pgfId-437810][bookmark: 160173][bookmark: evntchap_cncpt_UnderstandingtheSyslogMessagesThatIndicateActionableEvents]Understanding the Syslog Messages That Indicate Actionable Events[bookmark: marker-437804][bookmark: marker-437806][bookmark: marker-437808]
 
     [bookmark: pgfId-437812]Botnet Traffic Filter events use syslog message numbers 338xxx. However, some messages are informational and require no action on your part.
 
     [bookmark: pgfId-437819]When viewing syslogs for botnet events, you should be most concerned with the following message numbers. For information on dealing with messages that indicate blacklisted or whitelisted traffic, see Mitigating Botnet Traffic. For detailed descriptions of syslog messages, see the Syslog Message document for your ASA software version at http://www.cisco.com/en/US/products/ps6120/products_system_message_guides_list.html.
 
      
      	 [bookmark: pgfId-437821] 338001 to 338004 —Indicate blacklisted traffic that the ASA is logging, but the ASA is not stopping the traffic. These messages require immediate attention if you want to stop botnet activity that is in progress.
 
      	 [bookmark: pgfId-437823] 338005 to 338008 —Indicate blacklisted traffic that the ASA is logging and dropping. This indicates that the traffic was covered by a drop rule. Thus, your network is being protected, although you still need to disinfect the victim computer.
 
      	 [bookmark: pgfId-437825] 338201, 338202 —Indicate greylisted traffic that the ASA is logging but not dropping. These messages can indicate an active botnet connection that needs to be handled immediately.
 
      	 [bookmark: pgfId-437830] 338203, 338204 —Indicate greylisted traffic that the ASA is logging and dropping. Your network is protected from this traffic. However, if the greylisted site is legitimate, the fact that the traffic is being dropped might be a problem that requires immediate attention. You can whitelist the greylisted address if you determine it is legitimate and redeploy the configuration, as described in Adding Entries to the Static Database.
 
      	 [bookmark: pgfId-437832] 338305 to 338307, 338310 —The ASA could not download the dynamic filter database. Ensure that you configured DNS lookup on the device, and that there is a routable network path to the Cisco Intelligence Security Operations Center. You might need to contact Cisco Technical Support.
 
      	 [bookmark: pgfId-437834] 338309 —The Botnet Traffic Filter license is not current, and you cannot download the dynamic database. Purchase and install the appropriate license. The Botnet Traffic Filter license is time-based, so you might have had a valid license that expired.
 
     
 
    
 
     
      [bookmark: pgfId-437846][bookmark: 160212][bookmark: evntchap_proc_MonitoringBotnetUsingtheSecurityManagerEventViewer]Monitoring Botnet Using the Security Manager Event Viewer[bookmark: marker-437840][bookmark: marker-437842][bookmark: marker-437844]
 
     [bookmark: pgfId-437848]You can use the Event Viewer application to monitor syslog events generated by an ASA device. The Event Viewer has a predefined view that shows just botnet events.
 
     [bookmark: pgfId-437850]Botnet messages are in the informational to debug severity levels and are numbered 338xxx.
 
      
       
     
 
     
 
     [bookmark: pgfId-437852]Tip This procedure assumes the Event Manager service is enabled. If it is not, enable it using the Tools > Security Manager Administration > Event Management page.

     
      

     

     
 
     
 
     [bookmark: pgfId-437854]Step 1 Open Event Viewer, for example, by selecting Launch > Event Viewer in Configuration Manager.
 
     [bookmark: pgfId-437856]Step 2 Double-click Botnet Events from the list of predefined views in the left pane. You must double-click to activate the view and load it into the right pane. To verify the view has been opened, ensure that the tab name for the view in the right pane says “Botnet Events.” The following illustration shows an example of the botnet events view.
 
     [bookmark: pgfId-437860]Figure 68-6 [bookmark: 160237]Botnet Events View in the Security Manager Event Viewer
 
     [bookmark: pgfId-437863]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-437865]Step 3 To see the details of a specific event, select it in the table. You can then do the following:
 
      
      	 [bookmark: pgfId-437867]Double-click the event to see the tabular information presented in a more readable format.
 
      	 [bookmark: pgfId-437869]Open the  Event Details section at the bottom of the window. The details pane shows information about the event organized on tabs. The Explanation and Recommended Action tabs include plain-language information about the event and what you might want to do about it.
 
     
 
     [bookmark: pgfId-437874]The following illustration shows the Event Details pane for the Botnet Destination Blacklist message 338004. In this example, the recommended action is shown. The explanation for this message is “This syslog message is generated when traffic to a blacklisted IP address in the dynamic filter database appears.” For information on dealing with this type of event, see Mitigating Botnet Traffic.
 
     [bookmark: pgfId-437878]Figure 68-7 [bookmark: 160250]Botnet Event Details for Message 338004, Botnet Destination Blacklist
 
     [bookmark: pgfId-437881]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-437883]Step 4 To narrow the list of events to those generated by a single ASA, click the drop-down arrow in the Device column and select the desired device from the list. If you want to narrow the list to multiple ASAs, select Custom from the drop-down list and select the desired devices in the dialog box that appears.
 
     [bookmark: pgfId-437885]You can also narrow the list using filters for any of the other columns. Filtering works the same way for all columns: either select the desired value from the drop-down list, or select Custom to create a more complex column filter.
 
     [bookmark: pgfId-437887]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-437899][bookmark: 160259][bookmark: evntchap_proc_MonitoringBotnetUsingtheSecurityManagerReportManager]Monitoring Botnet Using the Security Manager Report Manager[bookmark: marker-437893][bookmark: marker-437895][bookmark: marker-437897]
 
     [bookmark: pgfId-437904]You can use the Report Manager application to generate reports on botnet activity. There are predefined reports that show the top infected hosts, the top malware ports, and the top malware sites. For a description of these reports, see Understanding Firewall Summary Botnet Reports.
 
      
       
     
 
     
 
     [bookmark: pgfId-437906]Tip This procedure assumes the Event Manager service is enabled. If it is not, enable it using the Tools > Security Manager Administration > Event Management page.

     
      

     

     
 
     
 
     [bookmark: pgfId-437908]Step 1 Open Report Manager, for example, by selecting Launch > Report Manager in Configuration Manager.
 
     [bookmark: pgfId-437910]Step 2 Open the desired report from the System > FW > Summary Botnet folder. You can open the report by double-clicking it or by right-clicking and selecting Open Report.
 
     [bookmark: pgfId-437915]Step 3 (Optional) Customize the report to select the desired time range and devices to include in the report. For more information, see Editing Report Settings.
 
     [bookmark: pgfId-437920]If you want to save your custom settings to generate the report again in the future, click Save As to create a custom report. For more information, see Creating Custom Reports.
 
     [bookmark: pgfId-437925]Step 4 Click Generate Report to retrieve the collected information and display the graphs and tabular data. For more information, see Opening and Generating Reports.
 
     [bookmark: pgfId-437930]If you want to generate the report on a regular basis, you can configure a schedule as described in Configuring Report Schedules.
 
     [bookmark: pgfId-437932]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-437942][bookmark: 160300][bookmark: evntchap_proc_MonitoringBotnetActivityUsingASDM]Monitoring Botnet Activity Using the Adaptive Security Device Manager (ASDM)[bookmark: marker-437938][bookmark: marker-437940]
 
     [bookmark: pgfId-437944]The Adaptive Security Device Manager (ASDM) includes botnet reporting features. A read-only version of ASDM is installed with the Security Manager client as a device manager, and you can start ASDM from within Security Manager.
 
      
       
     
 
     
 
     [bookmark: pgfId-437946]Tip You can also install the full ASDM application separately. However, any configuration changes that you perform in ASDM are considered out-of-band changes by Security Manager and are overwritten the next time you deploy configurations from Security Manager. If you ever find a need to make configuration changes using ASDM, be sure to rediscover policies on the device in Security Manager so that Security Manager’s view of the configuration is up-to-date.

     
      

     

     
 
     
 
     [bookmark: pgfId-437948]Step 1 In Device view in Configuration Manager, select the ASA device.
 
     [bookmark: pgfId-437950]Step 2 Select Launch > Device Manager to open an ASDM connection to the ASA. You are warned that you cannot make configuration changes. Click Yes to continue.
 
     [bookmark: pgfId-437952]Step 3 In ASDM, view Botnet Traffic Filter monitoring information in the following areas:
 
      
      	 [bookmark: pgfId-437954] Home > Firewall Dashboard includes a Botnet Traffic Filter summary.
 
      	 [bookmark: pgfId-437956] Monitoring > Botnet Traffic Filter > Reports includes charts on the top botnet sites, ports, and infected hosts.
 
      	 [bookmark: pgfId-437958] Monitoring > Logging > Log Buffer shows historical syslog messages.
 
      	 [bookmark: pgfId-437960] Monitoring > Logging > Real-Time Log Viewer shows syslog messages as they are generated.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-437962]Tip You can also search the dynamic database on the Configure > Botnet Traffic Filter > Botnet Database page. This page also allows you to manually start a database download or to purge the dynamic database. These actions do not change the device’s configuration and do not require policy rediscovery in Security Manager.

     
      

     

     
 
     [bookmark: pgfId-437964]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-437976][bookmark: 160339][bookmark: evntchap_proc_MitigatingBotnetTraffic]Mitigating Botnet Traffic[bookmark: marker-437970][bookmark: marker-437972][bookmark: marker-437974]
 
     [bookmark: pgfId-437978]Botnet traffic mitigation is a two step process:
 
     [bookmark: pgfId-437980] 1. Stop traffic from your network to the botnet control site.
 
     [bookmark: pgfId-437982] 2. Disinfect the victim computers.
 
     [bookmark: pgfId-437984]The following procedure explains the process in more detail.
 
     
 
     [bookmark: pgfId-437989]Step 1 You see syslog events that indicate that packets are traveling to or from an objectionable address, typically message numbers 338001-338008 or 338201-3382004. For detailed information about these messages, see Understanding the Syslog Messages That Indicate Actionable Events.
 
      
       
     
 
     
 
     [bookmark: pgfId-437991]Tip Messages 338201-3382004 are for greylisted traffic. You might want to first determine if the greylisted traffic is truly objectionable before stopping the traffic.

     
      

     

     
 
     [bookmark: pgfId-437993]Step 2 Stop the botnet traffic:
 
      
      	 [bookmark: pgfId-437998]Messages 338005-338008 and 338203-338204 indicate that the ASA is already dropping the traffic for you. Traffic classification drop rules cover the blacklisted or greylisted addresses. See Enabling Traffic Classification and Actions for the Botnet Traffic Filter.
 
      	 [bookmark: pgfId-438000]Messages 338001-338004 and 338201-338202 indicate that the ASA is logging the event but not dropping the traffic. The first order of business is to stop this traffic.
 
     
 
     [bookmark: pgfId-438002]You have these options for stopping the botnet traffic if the ASA is not already dropping it because of a drop rule:
 
      
      	 [bookmark: pgfId-438007](Preferred method.) Configure a drop rule for the botnet site and redeploy the configuration. See Enabling Traffic Classification and Actions for the Botnet Traffic Filter.
 
      	 [bookmark: pgfId-438009](Second best method.) Log into the ASA using an SSH client, enter privileged EXEC mode, and use the  shun command to prevent traffic to or from the botnet site. You can also issue this command through ASDM in a CLI window, but you cannot do it from Security Manager. The shun command does not create a permanent rule blocking traffic.
 
     
 
     [bookmark: pgfId-438011]For example, if the botnet site is 10.1.14.14, and the internal infected computer is 10.100.10.10, issue the following commands. The first command blocks all incoming traffic from the botnet command center, the second blocks traffic from the infected computer just to the botnet site.
 
     [bookmark: pgfId-438013]shun 10.1.14.14
 
     [bookmark: pgfId-438015]shun 10.100.10.10 10.1.14.14
 
      
      	 [bookmark: pgfId-438017](Not recommended.) Although the shun command is preferred, you can also create a permanent rule in the interface’s access control list (ACL) that denies traffic to or from the botnet site. With the device selected in Security Manager, select  Firewall > Access Rule , and create two rules: one that denies the botnet site as the source address, with any destination address; one that denies any source address with the botnet site as the destination address. For service, select IP so that all traffic is blocked. You must deploy the configuration for the rule to take effect.
 
     
 
     [bookmark: pgfId-438019]Creating an access rule is not the preferred method because it creates a permanent rule, whereas botnet sites are transient. Using the Botnet Traffic Filter to dynamically block botnet traffic is a better fit for this type of network attack compared to traditional access rules.
 
     [bookmark: pgfId-438021]Step 3 Shut down network access for the infected computer. For example, find the switch port to which the computer is attached, and shut down the port using the switch’s CLI. There might also be wireless access for the computer, so completely shutting down network access might not be a simple task.
 
     [bookmark: pgfId-438023]Step 4 Inform the owner of the victim computer that it is infected and dispatch IT personnel to disinfect the computer. Tools and techniques for disinfecting a computer are outside the scope of this document.
 
     [bookmark: pgfId-438025]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-438043][bookmark: 160397][bookmark: evntchap_proc_RemovingFalsePositiveIPSEventsfromtheEventTable]Removing False Positive IPS Events from the Event Table[bookmark: marker-438031][bookmark: marker-438033][bookmark: marker-438035][bookmark: marker-438037][bookmark: marker-438039][bookmark: marker-438041]
 
     [bookmark: pgfId-438045]An IPS appliance or service module (IPS device) triggers an alarm when a given packet or sequence of packets matches the characteristics of known attack profiles defined in the IPS signatures. False positives (benign triggers) occur when the IPS reports certain benign activity as malicious. Because each event requires human intervention to diagnose, spending your time analyzing false-positive events can significantly drain resources.
 
     [bookmark: pgfId-438047]Due to the nature of the IPS signatures that are used to detect malicious activity, it is almost impossible to completely eliminate false positives without severely degrading the effectiveness of the IPS or severely disrupting the computing infrastructure of an organization (such as hosts and networks). Customized tuning when an IPS is deployed minimizes false positives. Periodic re-tuning is required when the computing environment changes (for example, when new systems and applications are deployed). IPS devices provide a flexible tuning capability that can minimize false positives during steady-state operations.
 
     [bookmark: pgfId-438049]An example of a false-positive is a network management station that periodically builds a network discovery map by running ping sweeps. A ping sweep triggers the ICMP Network Sweep with Echo signature (signature ID 2100). Thus, ICMP Network Sweep with Echo events that have the IP address of the network management station as the source address are actually expected and desired events.
 
     [bookmark: pgfId-438051]You have the following options to remove false-positive IPS events from the event table in Event Viewer:
 
      
      	 [bookmark: pgfId-438053] Filter out events from known “clean” sources. 
 
     
 
     [bookmark: pgfId-438055]By filtering out the events, you do not stop their generation, but you also do not see them in the table. Because they are still available (you can remove the filter), you can see the events if some particular network behavior requires that you examine activity from the excluded host.
 
     [bookmark: pgfId-438057]There are two main drawbacks to using this technique:
 
     [bookmark: pgfId-438059] – The events are still generated, adding events to the event store.
 
     [bookmark: pgfId-438061] – The filter excludes all events from a host. You cannot create a complex filter that excludes a host/signature ID pair.
 
     [bookmark: pgfId-438063]The procedure below shows how to filter out events from sources that you identify as clean.
 
      
      	 [bookmark: pgfId-438073] Create event action filter rules to stop the generation of the false-positive events. [bookmark: marker-438065][bookmark: marker-438067][bookmark: marker-438069][bookmark: marker-438071]
 
     
 
     [bookmark: pgfId-438075]Event action filter rules are the easiest way to stop generating events, and are thus preferable to editing signatures or creating custom signatures, which is a more difficult task. If you exclude a host in an event action filter rule, the IPS device does not generate alarms or log records when the host triggers the event.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-438085]For more information about configuring event action filter rules, see Configuring Event Action Filters.
 
     [bookmark: pgfId-438087]The following procedure shows how to use filtering in Event Viewer to remove false positives from the events list. It uses network/host policy objects to accomplish the filtering.
 
      
       
     
 
     
 
     [bookmark: pgfId-438099]Tip By creating source or destination address filters using network/host objects, you can update the filters simply by changing the contents of the object. You do not need to add or remove filters from your views. Another advantage is that you can proactively create filters for addresses that do not currently appear in the events table; the source/destination column filter controls in Event Viewer list only those addresses that currently appear in listed events.[bookmark: marker-438089][bookmark: marker-438091][bookmark: marker-438093][bookmark: marker-438095][bookmark: marker-438097]

     
      

     

     
 
     
 
     [bookmark: pgfId-438101]Step 1 Create a network/host policy object that includes the IP address of the clean hosts or networks.
 
     [bookmark: pgfId-438106] a. Select Manage > Policy Objects to open the Policy Object Manager window (see Policy Object Manager).
 
     [bookmark: pgfId-438108] b. Select Networks/Hosts from the table of contents.
 
     [bookmark: pgfId-438110] c. Click the Add Row (+) button beneath the table of network/host policy objects, and select Group as the object type.
 
     [bookmark: pgfId-438112] d. In the Add Network/Host Group dialog box, enter a name for the object, for example, IPS_Safe_Hosts.
 
     [bookmark: pgfId-438114] e. Select Enter IPv4 Address Information and enter the IP address, for example, 10.100.15.75.
 
     [bookmark: pgfId-438116] f. Click Add >> to add the IP address to the Members in Group list.
 
     [bookmark: pgfId-438118] g. Click OK to create the object.
 
     [bookmark: pgfId-438120] h. Click Close to close the Policy Object Manager window.
 
     [bookmark: pgfId-438122]Step 2 Select File > Submit to submit your changes to the database (non-Workflow mode). Keep in mind that all of your configuration changes are submitted, not just the new policy object.
 
     [bookmark: pgfId-438124]If you are using Workflow mode, you must submit your activity and have it approved, if necessary.
 
      
       
     
 
     
 
     [bookmark: pgfId-438134]Tip Event Viewer can see only those policy objects that have been submitted to the database, so you must submit your changes before you can create a filter using the object. If you later change the object, you must also submit your changes for the filter to use the new definition of the policy object.[bookmark: marker-438126][bookmark: marker-438128][bookmark: marker-438130][bookmark: marker-438132]

     
      

     

     
 
     [bookmark: pgfId-438136]Step 3 Select Launch > Event Viewer to open the Event Viewer application.
 
     [bookmark: pgfId-438138]Step 4 Create a custom view that filters out the network management station:
 
     [bookmark: pgfId-438140] a. Double-click the predefined view that you want to use as the basis of your custom view, for example, All IPS Events. Double-clicking the view in the Views list opens the view. If you already have a custom view that you want to update, open it.
 
     [bookmark: pgfId-438142] b. Click the down arrow button in the title of the Source column in the events table and select Custom to open the Custom Filter for Source dialog box.
 
     [bookmark: pgfId-438144]Tip: You can also get to this dialog box through the View Settings pane by clicking the Add button, then selecting Source in the Add Custom Filter to a Column dialog box and clicking OK.
 
     [bookmark: pgfId-438146] c. In the Custom Filter for Source dialog box, select the policy object you created and click the right-arrow button to move it to the selected list. Also, select the Not option next to the Condition option. The following illustration shows how the dialog box should look.
 
     [bookmark: pgfId-438149]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-438151] d. Click OK. The filter is added to the view settings and is used to remove events from the table.
 
     [bookmark: pgfId-438153] e. Select File > Save As to save the changes as a new custom view. You are prompted for a view name and description; enter the information and click OK.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-438160]

     
      

     

     
 
    
 
   
 
  
 
  
   
   
   
    
     [bookmark: pgfId-919445][bookmark: 168293][bookmark: nuuimmgt]Using Image Manager[bookmark: marker-919443]
      
      
 
     
 
 
    [bookmark: pgfId-919447]Image Manager is a tool to simplify the distribution and management of images on internal and edge firewall devices in your network. It enables you to:
 
     
     	 [bookmark: pgfId-919449]Download and maintain a repository of different types and versions of images
 
     	 [bookmark: pgfId-919451]Evaluate images
 
     	 [bookmark: pgfId-919453]Analyze impact of upgrading images to the devices in the network
 
     	 [bookmark: pgfId-919455]Prepare for and plan an upgrade
 
     	 [bookmark: pgfId-919457]Reliably upgrade devices, with sufficient fallback and recovery mechanisms built in to ensure minimal network downtime
 
    
 
    [bookmark: pgfId-919459]This chapter contains the following topics:
 
     
     	 [bookmark: pgfId-919464]Getting Started with Image Manager
 
     	 [bookmark: pgfId-919469]Working with Images
 
     	 [bookmark: pgfId-919474]Working with Bundles
 
     	 [bookmark: pgfId-919479]Working with Devices
 
     	 [bookmark: pgfId-919484]About Image Updates on Devices Using Image Manager
 
     	 [bookmark: pgfId-919489]Working with Jobs
 
     	 [bookmark: pgfId-919494]Troubleshooting Image Management
 
    
 
   
 
    
     [bookmark: pgfId-919504][bookmark: 168310][bookmark: immgt_intro_GettingStarted]Getting Started with Image Manager[bookmark: marker-919500][bookmark: marker-919502]
 
    [bookmark: pgfId-919506]Image Manager contains sections that are used for managing your images, working with the devices that you will need to update, and performing image installations on those devices.
 
    [bookmark: pgfId-919508]For more information on these areas of Image Manager, see the following topics:
 
     
     	 [bookmark: pgfId-919513]Working with Images
 
     	 [bookmark: pgfId-919518]Working with Bundles
 
     	 [bookmark: pgfId-919523]Working with Devices
 
     	 [bookmark: pgfId-919528]Working with Jobs
 
    
 
    [bookmark: pgfId-919530]Before working with Image Manager, you should review the sections that follow:
 
     
     	 [bookmark: pgfId-919532]the platforms that are supported by this feature,
 
     	 [bookmark: pgfId-919534]the configuration settings you can change to control how the feature works, and
 
     	 [bookmark: pgfId-919536]the steps that are necessary to ensure your devices are configured to work with Image Manager.
 
    
 
    [bookmark: pgfId-919538]This section contains the following topics:
 
     
     	 [bookmark: pgfId-919543]Image Manager Supported Platforms and Versions
 
     	 [bookmark: pgfId-919548]Device Configurations supported by Image Manager
 
     	 [bookmark: pgfId-919553]Image Manager Supported Image Types
 
     	 [bookmark: pgfId-919558]Administrative Settings for Image Manager
 
     	 [bookmark: pgfId-919563]Bootstrapping Devices for Image Manager
 
    
 
     
      [bookmark: pgfId-919573][bookmark: 168340][bookmark: immgt_cncpt_SupportedPlatforms]Image Manager Supported Platforms and Versions[bookmark: marker-919569][bookmark: marker-919571]
 
     [bookmark: pgfId-919575]Image Manager is available only for ASA devices. The following devices support Image Manager:
 
      
      	 [bookmark: pgfId-919577]All legacy ASA models—ASA 5505/10/20/40/50/80
 
      	 [bookmark: pgfId-919579]ASA 5585
 
      	 [bookmark: pgfId-919581]ASA 5512/15/25/35/45/55
 
      	 [bookmark: pgfId-919583]ASA-SM module for Catalyst 6K
 
      	 [bookmark: pgfId-919585]5506-X,5506H-X,5506W-X,5516-X
 
      	 [bookmark: pgfId-919587]Adaptive Security Virtual Appliance (ASAv)
 
     
 
     [bookmark: pgfId-919589]The following devices are not supported and are filtered out in the devices tab of the Image Manager unified view:
 
      
      	 [bookmark: pgfId-919591]PIX firewall
 
      	 [bookmark: pgfId-919593]FWSM blade
 
      	 [bookmark: pgfId-919595]ASA device managed by AUS
 
      	 [bookmark: pgfId-919597]Devices unmanaged in Security Manager
 
      	 [bookmark: pgfId-919599]Other device types—IPS and Routers
 
     
 
     [bookmark: pgfId-919601]Image Manager supports image upgrade for ASA device version from 7.x onwards. The target image version that can be used to upgrade is not restricted. Image upgrade to the highest ASA version supported in Security Manager 4.4, that is ASA version 9.0(1) and 9.1(1), has been tested.
 
     [bookmark: pgfId-919603]Prior to version 4.9, the Image Manager application listed all the images of the supported device type. You could select and download any image that you required. Beginning with version 4.9, the Image Manager application lists only the specific versions of images.
 
     [bookmark: pgfId-919605]The latest images of ASDM, †Remote Access Plugin and Host scan are listed in Image Manager. For AnyConnect version 3.x and 4.x, the latest images are listed.
 
     [bookmark: pgfId-919608]For ASA devices, the following images are listed:
 
      
       
       
         
         	
           
           [bookmark: pgfId-918680]ASA Device Model
          
  
         	
           
           [bookmark: pgfId-918682]ASA Images listed in Image Manager
          
  
        
 
         
         	[bookmark: pgfId-918688]5512-x,5515-x,5525-x,5545-x,5585x
  
         	[bookmark: pgfId-918690]9.4.1
 [bookmark: pgfId-918692]9.3.3
 [bookmark: pgfId-918694]9.3.2
 [bookmark: pgfId-918696]9.3.1.SMP
 [bookmark: pgfId-918698]9.2.3.SMP
 [bookmark: pgfId-918700]9.2.2.4.SMP
 [bookmark: pgfId-918702]9.2.1.SMP.ED
 [bookmark: pgfId-918704]9.1.4.SMP.ED
 [bookmark: pgfId-918706]9.1.5.SMP.ED
 [bookmark: pgfId-918708]9.1.6.SMP.ED
 [bookmark: pgfId-918710]9.1.2.SMP.ED
 [bookmark: pgfId-918712]9.0.4.SMP.ED
 [bookmark: pgfId-918714]8.4.6.SMP.ED
  
        
 
         
         	[bookmark: pgfId-918720]5580-x
  
         	[bookmark: pgfId-918722]9.1.6.SMP
 [bookmark: pgfId-918724]9.1.5.SMP.ED
 [bookmark: pgfId-918726]9.1.4.SMP.ED
 [bookmark: pgfId-918728]9.1.2.SMP.ED
 [bookmark: pgfId-918730]9.0.4.SMP.ED
 [bookmark: pgfId-918732]8.4.6.SMP.ED
  
        
 
         
         	[bookmark: pgfId-918738]5555-x
  
         	[bookmark: pgfId-918740]9.4.1
 [bookmark: pgfId-918742]9.3.3
 [bookmark: pgfId-918744]9.3.2
 [bookmark: pgfId-918746]9.3.1.SMP
 [bookmark: pgfId-918748]9.2.3.SMP
 [bookmark: pgfId-918750]9.2.2.4.SMP
 [bookmark: pgfId-918752]9.2.1.SMP.ED
 [bookmark: pgfId-918754]9.1.2.SMP.ED
 [bookmark: pgfId-918756]9.0.4.SMP.ED
  
        
 
         
         	[bookmark: pgfId-918762]5505,5510,5520,5540,5550
  
         	[bookmark: pgfId-918764]9.1.6
 [bookmark: pgfId-918766]9.1.5.ED
 [bookmark: pgfId-918768]9.1.4.ED
 [bookmark: pgfId-918770]9.1.2.ED
 [bookmark: pgfId-918772]9.0.4.ED
 [bookmark: pgfId-918774]8.4.6.ED
  
        
 
         
         	[bookmark: pgfId-918780]5506-X
  
         	[bookmark: pgfId-918782]9.4.1, 9.3.3, 9.3.2
  
        
 
         
         	[bookmark: pgfId-918788]5506H-X
  
         	[bookmark: pgfId-918790]9.4.1
  
        
 
         
         	[bookmark: pgfId-918796]5506W-X
  
         	[bookmark: pgfId-918798]9.4.1
  
        
 
         
         	[bookmark: pgfId-918804]5516-X
  
         	[bookmark: pgfId-918806]9.4.1
  
        
 
         
         	[bookmark: pgfId-918812]Adaptive Security Virtual Appliance (ASAv)
  
         	[bookmark: pgfId-918814]9.3.1, 9.3.2, 9.4.1
  
        
 
       
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-919610]Warning Image downgrade is not restricted, but is done at your own risk. Image Manager does not validate downgrade cases.

     
      

     

     
 
    
 
     
      [bookmark: pgfId-919616][bookmark: 168468][bookmark: immgt_intro_devConfig]Device Configurations supported by Image Manager
 
     [bookmark: pgfId-919618]In addition to supporting image updates on standalone ASA devices, Image Manager manages the filesystem and supports seamless image update for ASA devices specially configured for high availability and scalability. Following configurations are supported:
 
      
      	 [bookmark: pgfId-919620] Multiple context mode —ASA in multiple context mode where a single ASA can be partitioned into multiple virtual devices/firewalls. Refer to  http://www.cisco.com/en/US/docs/security/asa/asa91/configuration/general/ha_contexts.html . Each of these virtual firewalls are represented in Security Manager as independent devices. When Image Manager updates the image on the physical unit hosting these virtual devices, it updates device properties of all virtual devices with the new image information.
 
      	 [bookmark: pgfId-919622] Failover configuration —Two identical ASA devices configured to failover for high availability. They can be configured to be in Active/Active or Active/Standby failover. Refer to  http://www.cisco.com/en/US/docs/security/asa/asa91/configuration/general/ha_overview.html . Image update on an Active/Active failover pair is not supported in Image Manager. In order to use Image Manager to update the images on an Active/Active failover pair, the Active/Active failover pair has to temporarily be converted to Active/Standby by making all the failover groups active on one unit, and the corresponding failover groups standby on the other unit. After upgrade, you can convert the failover pair back to Active/Active.
 
      	 [bookmark: pgfId-919624] Cluster configuration —Multiple ASAs (up to 8 ASAs) can be grouped together as a single logical unit called a  cluster for achieving increased throughput and redundancy. The purpose of clustering devices is to simplify manageability and to increase processing speed. By using clusters you are able to scale to a multitude of simultaneous connections that work together to load balance the connections. Clustering feature has been introduced starting from ASA version 9.0(1). For more information see  http://www.cisco.com/en/US/docs/security/asa/asa91/configuration/general/ha_cluster.html .
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-919626]Note Clustering is only supported on ASA 5580 and ASA 5585.

     
      

     

     
 
     [bookmark: pgfId-919628]Starting from release 4.4, Security Manager supports Clustering. In Configuration manager and Image Manager, all the devices/members in a cluster or a failover pair are managed as a single device. That is, when you change the configuration on a cluster’s master device, the change is automatically made to all the devices in the cluster. Similarly, Image Manager updates image on each of the physical unit that is part of failover or cluster in a single operation.
 
    
 
     
      [bookmark: pgfId-919636][bookmark: 168491][bookmark: immgt_cncpt_SupportedImageTypes]Image Manager Supported Image Types[bookmark: marker-919634]
 
     [bookmark: pgfId-919638]Image Manager supports the following types of images:
 
      
      	 [bookmark: pgfId-919640]ASA System software
 
      	 [bookmark: pgfId-919642]ASDM image
 
      	 [bookmark: pgfId-919644]VPN images [includes Cisco Secure Desktop (CSD), AnyConnect, and Hostscan]
 
      	 [bookmark: pgfId-919646]SSLVPN Plug-in images (For example: RDP, SSH, ICA, and others)
 
     
 
     [bookmark: pgfId-919648]Image Manager completely manages the ASA system software and the ASDM images on the ASA devices, i.e., it performs loading of the image, activating the image by modifying configuration, and even reloading the device if required to complete the image upgrade process.
 
     [bookmark: pgfId-919650]Image Manager does not support the ASA–CX images. This includes both the system images, for example asacx-sys-9.1.1-1.pkg, and also the boot images, for example asacx-5500x-boot-9.1.1-1.img. Using Image Manager, you cannot add any CX images to the Image Manager repository and cannot push any CX images to the device .
 
     [bookmark: pgfId-919652]Handling of SSL VPN Images
 
     [bookmark: pgfId-919654]Image Manager only reliably copies SSL VPN images to the ASA device. No configuration or activation commands are added for SSL VPN images by Image Manager. The configuration of the images must still be done using Configuration Manager.
 
     [bookmark: pgfId-919656]The following files are not managed in Image Manager and have to be configured and deployed from Configuration Manager as in earlier versions of Security Manager:
 
      
      	 [bookmark: pgfId-919658]CSD Configuration XML
 
      	 [bookmark: pgfId-919660]AnyConnect Client Profile files
 
      	 [bookmark: pgfId-919662]DAP Configuration XML
 
      	 [bookmark: pgfId-919664]Full Customization XML files
 
     
 
     [bookmark: pgfId-919666]After the SSL VPN images have been copied to the device using Image Manager, the remote access VPN policies must be configured in Configuration Manager to make use of these images. The Remote Access VPN policies that must be configured are located at the following paths in Configuration Manager:
 
      
      	 [bookmark: pgfId-919668] CSD Package —Remote Access VPN > Dynamic Access > Cisco Secure Desktop group box
 
      	 [bookmark: pgfId-919670] HostScan Package —Remote Access VPN > Dynamic Access > Cisco Secure Desktop group box
 
      	 [bookmark: pgfId-919672] Anyconnect Image —Remote Access VPN > SSL VPN > Other Settings > Client Settings tab
 
      	 [bookmark: pgfId-919674] Plug-ins —Remote Access VPN > SSL VPN > Other Settings > Plug-in tab
 
     
 
     [bookmark: pgfId-919676]The SSL VPN binary files must be present on the device flash before you reference them in VPN policy. If not, Security Manager will present an activity validation warning informing the user of the preference to use Image Manager to push these files reliably to the device before deploying the configuration. If the user ignores the activation warning and goes ahead, Configuration Manager defaults to the old behavior and pushes the images or files as was done in the earlier versions of Security Manager before deploying the configuration referring to these files. But the user cannot leverage the following advantages of using Image Manager for copying these files:
 
     [bookmark: pgfId-919678] 1. Capability to use external disks like disk1 to copy the files. Configuration Manager only copies the files to disk0 and does not recognize or support external disks.
 
     [bookmark: pgfId-919680] 2. Image Manager preempts errors during the image copy by validating that there is enough free space on the disk to copy the selected images and does not allow creation of a job unless there is sufficient space is to copy the images. User can make space by using the Image Manager to delete unwanted images.
 
      
       
     
 
     
 
     [bookmark: pgfId-919682]Note Image Manager does not validate the compatibility of the SSL VPN files that are pushed to the ASA. But Configuration Manager will complain when incompatible files are referenced in the Remote Access VPN policies.

     
      

     

     
 
    
 
     
      [bookmark: pgfId-919690][bookmark: 168547][bookmark: immgt_proc_adminstgs]Administrative Settings for Image Manager[bookmark: marker-919688]
 
     [bookmark: pgfId-919692]Image Manager introduces new administrative settings. These administrative settings must be configured as part of Configuration Manager.
 
     [bookmark: pgfId-919694]Configuring Cisco.com Certificates
 
     [bookmark: pgfId-919699]Beginning with version 4.4, Security Manager has a certificate trust management feature. This feature helps you with improved handling of Cisco.com certificates. For detailed documentation of this feature, refer to Certificate Trust Management.
 
     [bookmark: pgfId-919701]To configure administrative settings for Image Manager, do the following:
 
     
 
     [bookmark: pgfId-919703]Step 1 Go to Configuration Manager > Tools > Security Manager Administration.
 
     [bookmark: pgfId-919705]The Cisco Security Manager - Administration page appears.
 
     [bookmark: pgfId-919707]Step 2 Configure workflow settings:
 
      
       
     
 
     
 
     [bookmark: pgfId-919709]Tip Refer to the Configuration Manager documentation for workflow control setting information.

     
      

     

     
 
     [bookmark: pgfId-919711] a. Select Workflow.
 
     [bookmark: pgfId-919716] b. To require that Install Jobs be approved explicitly by an assigned approver before they are installed on devices, select Require Deployment & Install Image Approval. If you select this option, make sure you configure appropriate email notification settings. For more information, see the Workflow Page.
 
     [bookmark: pgfId-919718] c. Click Save.
 
     [bookmark: pgfId-919720]Step 3 Configure debug settings:
 
     [bookmark: pgfId-919722] a. Select Debug Options and from the drop-down list for Image Manager Debug Level, select the debug level you want.
 
      
       
     
 
     
 
     [bookmark: pgfId-919724]Tip The levels include: Severe, Error, Warning, Info and Debug. The default log level is Error.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-919726]Note The log files are stored as follows:

     
      

     

     
 
      
      	 [bookmark: pgfId-919728]The server logs are located at:  %NMSROOT%\MDC\log\operation\vmssharedsvcs.log and  %NMSROOT%\MDC\tomcat\logs\stdout.log 
 
      	 [bookmark: pgfId-919730]The client logs are located at:  <Client Install Dir>\logs\*.log 
 
     
 
     [bookmark: pgfId-919732] b. Click Save.
 
     [bookmark: pgfId-919734]Step 4 Configure Cisco.com credentials:
 
     [bookmark: pgfId-919736] a. Select Image Manager.
 
     [bookmark: pgfId-919738]The Image Manager page appears.
 
     [bookmark: pgfId-919740] b. If you have credentials to connect to Cisco.com configured already at Tools > Security Manager Administration > IPS Updates > Update Server and wish to reuse the same for Image Manager, then check the Use IPS Updates Settings check box. This is also the default behavior.
 
      
       
     
 
     
 
     [bookmark: pgfId-919742]Note Only Cisco.com is supported, not Local Server.

     
      

     

     
 
     [bookmark: pgfId-919744] c. On the Image Manager page, deselect the Use IPS Updates Settings check box if you want to specify a set of credentials for Image Manager explicitly.
 
     [bookmark: pgfId-919746]The fields on the Image Manager page become operable.
 
     [bookmark: pgfId-919748] d. Complete the following fields:
 
      
      	 [bookmark: pgfId-919750]Username
 
      	 [bookmark: pgfId-919752]Password
 
      	 [bookmark: pgfId-919754]Confirmation
 
     
 
     [bookmark: pgfId-919756] e. Optionally, complete the Proxy Server Settings to configure a proxy, if required.
 
     [bookmark: pgfId-919758] 1. Select the Enable Proxy check box.
 
     [bookmark: pgfId-919760] 2. Complete the following fields to define the proxy:
 
      
      	 [bookmark: pgfId-919762]IP or Hostname
 
      	 [bookmark: pgfId-919764]Port
 
      	 [bookmark: pgfId-919766]Username
 
      	 [bookmark: pgfId-919768]Password
 
      	 [bookmark: pgfId-919770]Confirmation (of Password)
 
     
 
     [bookmark: pgfId-919772] f. Click Test Connection test connectivity to Cisco.com with the configured settings.
 
     [bookmark: pgfId-919774] g. Click Save.
 
     [bookmark: pgfId-919776]Step 5 Configure Purge Interval for Image Install Jobs
 
     [bookmark: pgfId-919778] a. Select Image Manager.
 
     [bookmark: pgfId-919780] b. Enter a purge value to specify how many days should pass between purges, in the Purge Jobs Older Than field.
 
      
       
     
 
     
 
     [bookmark: pgfId-919782]Note Pressing the Purge Now button immediately purges the Image Installation jobs satisfying the Purge Interval criteria.

     
      

     

     
 
     [bookmark: pgfId-919784]Step 6 Configure Image Backup Settings
 
     [bookmark: pgfId-919786] a. Select Image Manager.
 
     [bookmark: pgfId-919788] b. To include the repository as part of the standard backup, select Include Repository.
 
      
       
     
 
     
 
     
      [bookmark: pgfId-919790]
      Caution Ensure that you have sufficient hard disk space on the Security Manager server as the image files consume a lot of space.
       
       
 
      

     
 
      
       
     
 
     
 
     [bookmark: pgfId-919792]Note You can click the Reset button to reset the values to the last saved values before the current change.

     
      

     

     
 
     [bookmark: pgfId-919794] c. Click Save.
 
     [bookmark: pgfId-919796]Step 7 Click Close to close the Administration window.
 
     [bookmark: pgfId-919798]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-919806][bookmark: 168675][bookmark: immgt_proc_BootstrapDevices]Bootstrapping Devices for Image Manager[bookmark: marker-919804]
 
     [bookmark: pgfId-919808]The bootstrapping in Image Manager is essentially the same as that which you perform in Configuration Manager for ASA devices.
 
     [bookmark: pgfId-919810]To bootstrap a device for Image Management, do the following:
 
     
 
     [bookmark: pgfId-919812]Step 1 Configure HTTPS on the device(s) to manage ASA in Security Manager.
 
     [bookmark: pgfId-919814] a. Ensure that the HTTP server is enabled.
 
     [bookmark: pgfId-919816] b. Add the Security Manager server IP address as an allowed host for HTTP management on the device.
 
     [bookmark: pgfId-919818]Step 2 Ensure that the configuration register setting is set to boot with the image list in the running configuration.
 
     [bookmark: pgfId-919820] a. Register value: 0x1,0x3,0x5, 0x7, 0x9
 
      
       
     
 
     
 
     [bookmark: pgfId-919822]Note Register value: 0x1 is the recommended setting.

     
      

     

     
 
     [bookmark: pgfId-919824] b. Do not set to boot to rommon mode. (Otherwise device will not be rebooted and the image upgrade will be aborted.)
 
     [bookmark: pgfId-919826]Step 3 In Security Manager, go to Tools > Security Manager Administration > Device Communication > SSL Certificate Parameters. In the SSL Certificate Parameters area, set PIX/ASA/FWSM Device Authentication Certificates to Do not use certificate authentication.
 
     [bookmark: pgfId-919828]Step 4 Ensure that there is sufficient space in the flash memory of the device(s) to hold the images you intend to load.
 
      
       
     
 
     
 
     [bookmark: pgfId-919830]Tip If necessary, you can delete other images you do not intend to use from the device(s).

     
      

     

     
 
     [bookmark: pgfId-919832]Step 5 We recommend that you unmanage the Boot-Image/Configuration policy for ASA, as follows:
 
     [bookmark: pgfId-919834] a. In Security Manager, navigate to Tools > Administration > Policy Management.
 
     [bookmark: pgfId-919836] b. Uncheck the Boot Image/Configuration policy selection.
 
      
       
     
 
     
 
     [bookmark: pgfId-919838]Note Image Manager configures boot image and ASDM image as part of the image installation job. So, if the Boot Image/Configuration policy is not unmanaged, then any configuration deployment after the image installation will remove these boot commands added by Image Manager. To prevent this, the Boot Image/Configuration policy should be unmanaged in Security Manager. This can be done from Security Manager administration settings -> Device Exception Settings -> Firewall Policies node.

     
      

     

     
 
     [bookmark: pgfId-919840]Step 6 We recommend that the device not be set as a priority monitored device in HPM.
 
     [bookmark: pgfId-919842]Step 7 Ensure that all configuration changes on the device are submitted and deployed.
 
     [bookmark: pgfId-919844]

     
      

     

     
 
    
 
   
 
    
     [bookmark: pgfId-919858][bookmark: 168719][bookmark: immgt_intro_Repostry]Working with Images[bookmark: marker-919854][bookmark: marker-919856]
 
    [bookmark: pgfId-919860]Image Manager provides access to images on Cisco.com as well as images on your network. When an image shows a location of Repository, it means that image has already been downloaded (either from Cisco.com or from a local file system). Conversely, an image that shows location as Cisco.com has not been downloaded into the repository. Navigating to the Repository Images in the Images section of the selector enables you to examine a list of all the images. You can also filter, sort, and search the images available. Filtering, in particular, is a good way to navigate within Image Manager. Beginning with all images, you can use the headings in the main repository view to locate images by a variety of attributes including name, version, and type.
 
    [bookmark: pgfId-919862]Image Manager does not manage ASA-CX images. Any CX images available on Cisco.com will not be shown in Image Manager for download. You also cannot add any CX images from the file-system.
 
     
      
    
 
    
 
    [bookmark: pgfId-919864]Note Only images that are downloaded to the Image Repository can be used for image upgrade jobs.

    
     

    

    
 
     
      
    
 
    
 
    [bookmark: pgfId-919869]Note Beginning with Security Manager release 4.4, when Security Manager contacts Cisco.com to update images or to check on the availability of image updates, an additional certificate validation is performed. The update or download fails if you have not accepted the most recent certificate. You must retrieve, view, and accept the most recent certificate before you can proceed with other operations. For more information on the certificates, see Managing Device Communication Settings and Certificates.

    
     

    

    
 
    [bookmark: pgfId-919871]This section contains the following topics:
 
     
     	 [bookmark: pgfId-919876]View All Images
 
     	 [bookmark: pgfId-919881]Download Images to the Repository
 
    
 
     
      [bookmark: pgfId-919891][bookmark: 168733][bookmark: immgt_proc_ViewAllImages]View All Images[bookmark: marker-919887][bookmark: marker-919889]
 
     [bookmark: pgfId-919893]When you first open Image Manager, or when you select All Images from the selector, the system displays a complete list of images. This list includes both those images in the repository as well as those on Cisco.com (which have not yet been downloaded). Some of the VPN image files are bundled with the Security Manager installation and are shown in the repository from the first time onwards. Image Manager will display a warning about credentials not being configured when the Image Manager client is launched for the first time, or until the credentials are configured under Security Manager administration settings for Image Manager.
 
      
       
     
 
     
 
     [bookmark: pgfId-919895]Note In earlier releases of Security manager, only the prepackaged SSL-VPN images already existing in the Image Manager repository could be seen. If you do not have a repository connection, beginning with Security Manager release 4.4, on a freshly installed Security Manager, Image Manager shows not only the prepackaged SSL-VPN images in the repository, but also lists supported ASA images available on Cisco.com. The prepackaged files are available at: CSMRoot>\MDC\athena\ccometadata. Thus, even if you do not have initial connectivity to Cisco.com, you can view the latest images that are available at the time of release of the Security Manager. You have to have Cisco.com connectivity and should configure credentials to Cisco.com to either check for the latest updates on Cisco.com or to download the images from Cisco.com, or both. This prepackaged information about image availability enables users not having Cisco.com connectivity to still view the latest images available on Cisco.com (at least the ones published on Cisco.com by the Security Manager release). This also lets you view compatible images for a particular device type/platform.

     
      

     

     
 
     [bookmark: pgfId-919897]This view can be re-ordered by any of the listed image attributes. For example, you can list the images by size. The attributes that you can sort on include:
 
      
      	 [bookmark: pgfId-919899]Download State - This is the first column and is shown as icons. The icons are actionable, and you can double-click the icon in this column to start the download of an image from Cisco.com, or to abort an ongoing image download, or to delete an image from the repository. Note that the icons change during each of these actions. (A green arrow indicates an image on Cisco.com, a red cross indicates an image that has already been downloaded, and another icon indicates that a download is in progress.)
 
      	 [bookmark: pgfId-919901]Image (name)
 
      	 [bookmark: pgfId-919903]Type
 
      	 [bookmark: pgfId-919905]Version
 
      	 [bookmark: pgfId-919907]Location
 
      	 [bookmark: pgfId-919909]Size
 
      	 [bookmark: pgfId-919911]Description
 
      	 [bookmark: pgfId-919913]Comments (you can add and edit comments for an image).
 
     
 
     [bookmark: pgfId-919915]To view all images, do the following:
 
     
 
     [bookmark: pgfId-919917]Step 1 Check for new images available on Cisco.com
 
     [bookmark: pgfId-919919] a. Configure the credentials for reaching Cisco.com by navigating to Tools > Security Manager Administration > Image Manager.
 
     [bookmark: pgfId-919921] b. In the upper right corner, click the double arrow Check for Updates icon.
 
     [bookmark: pgfId-919923] c. Ensure that the CCO account has permissions to download crypto images. Otherwise, navigate to the link and accept the agreement, and then retry the operation.
 
     [bookmark: pgfId-919925]The system displays “Updating” while it checks for updates. When finished, it reads: Last updated at: <timestamp>, and you can view the new images available in the All Images view.
 
     [bookmark: pgfId-919927]Step 2 If you have not already accepted the most recently issued Cisco.com certification, the system notifies you that you must retieve, view, and accept the latest certificate before any communication with Cisco.com by Image Manager can occur.
 
     [bookmark: pgfId-919929]Step 3 Click All Images in the selector.
 
     [bookmark: pgfId-919931]The system displays the image list.
 
     [bookmark: pgfId-919933]Step 4 To re-order the list, click on any of the column headings.
 
     [bookmark: pgfId-919935]The list of images is reordered according to the selected attribute.
 
     [bookmark: pgfId-919937]Step 5 To filter the list, use the Image Manager’s search window to enter a key string. For example, you could enter the digits of a version number.
 
      
       
     
 
     
 
     [bookmark: pgfId-919939]Note Also, you can use the filter settings in some of the column headings to filter the list shown.

     
      

     

     
 
     [bookmark: pgfId-919941]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-919951][bookmark: 168794][bookmark: immgt_proc_AddImagetoRepository]Download Images to the Repository[bookmark: marker-919949]
 
     [bookmark: pgfId-919953]You can download images to the repository either from Cisco.com or from a local file system.
 
      
       
     
 
     
 
     [bookmark: pgfId-919958]Note Beginning with version 4.4, Security Manager has a certificate trust management feature. This feature helps you with improved handling of Cisco.com certificates. For detailed documentation of this feature, refer to Certificate Trust Management. You must have accepted the latest certificate from the image download site on Cisco.com to proceed. The certificate of the site from which the image is to be downloaded may be different from the site that is contacted for "Check for updates" to obtain the latest meta-data information about images. Thus, even if you have accepted the certificate from the "Image Meta-data Locator" URL, the image download may fail with an error to accept the certificate of the image download URL. You must retrieve and accept the certificate from the download URL given in the error message to proceed with the image download.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-919960]Note Beginning with version 4.9, Security Manager mandates you to read and accept the End User License Agreement (EULA) before you can proceed to downloading images from cisco.com.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-919965]Tip Images can also be downloaded from the Compatible Images tab. For details see Manage Images on a Device.

     
      

     

     
 
     [bookmark: pgfId-919967]To add an image file to your Security Manager repository, do the following:
 
     
 
     [bookmark: pgfId-919969]Step 1 To download images from Cisco.com, do the following:
 
     [bookmark: pgfId-919971] a. From the All Images view double-click the Start Download icon in the first column.
 
      
       
     
 
     
 
     [bookmark: pgfId-919973]Tip Ensure that the credentials to Cisco.com are configured and you have authorization to download the images.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-919975]Note Image Manager displays an error message if the image to be downloaded already exists in the repository. The system skips the download when the file name and checksum are identical.

     
      

     

     
 
     [bookmark: pgfId-919977]The Downloads window appears showing the progress of the download.
 
      
       
     
 
     
 
     [bookmark: pgfId-919979]Tip The progress icons may change as the download progresses. A green check icon with the word Deployed indicates success. A red X icon indicates failure. In case of failures, you can view the cause of the failure for that image in the Downloads window. You can double click the message to view the complete details of the error.

     
      

     

     
 
     [bookmark: pgfId-919981] b. When completed, select Repository Images and view the image in the listing.
 
      
       
     
 
     
 
     [bookmark: pgfId-919983]Tip You can also select multiple images and download them all at once by right-clicking them and using the context-sensitive menu.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-919985]Tip By sorting the list on Update Time, you can easily view the most recent image.

     
      

     

     
 
     [bookmark: pgfId-919987]Step 2 To download images from a local file system, do the following:
 
     [bookmark: pgfId-919989] a. From the toolbar in the Repository Images view, click the Download image from file system icon (found on the far left).
 
     [bookmark: pgfId-919991]The Download from File System dialog box appears.
 
     [bookmark: pgfId-919993] b. Use the Browse feature to select the Import location and to select the image to be imported.
 
     [bookmark: pgfId-919995] c. Click OK.
 
     [bookmark: pgfId-919997] d. Click OK in the Download image from file system dialog box.
 
     [bookmark: pgfId-919999] e. Observe the progress of the download.
 
      
       
     
 
     
 
     [bookmark: pgfId-920001]Note If the image to be downloaded already exists in the repository, the system displays an error.

     
      

     

     
 
     [bookmark: pgfId-920003] f. When completed, select a device group in Security Manager and view the image in the listing.
 
      
       
     
 
     
 
     [bookmark: pgfId-920005]Tip By sorting the list on Update Time, you can easily view the most recent image.

     
      

     

     
 
     [bookmark: pgfId-920007] g. Alternatively, you can download an image file using the drag-and-drop method. For example, you can drag one or more files from your desktop and simply drop it on the Image Manager application.
 
     [bookmark: pgfId-920009]

     
      

     

     
 
    
 
   
 
    
     [bookmark: pgfId-920023][bookmark: 168850][bookmark: immgt_intro_UsingBundles]Working with Bundles[bookmark: marker-920019][bookmark: marker-920021]
 
    [bookmark: pgfId-920025]Bundles are groups of compatible images that you define. You can use bundles to simplify repetitive operations, by grouping images that are pre-validated to work together as a logical group. For example, you might define bundles that reflect ASA and ASDM pairs to ensure that you deploy both types in a single operation. The following types of images can be part of a bundle:
 
     
     	 [bookmark: pgfId-920027]ASA system software
 
     	 [bookmark: pgfId-920029]ASDM image
 
     	 [bookmark: pgfId-920031]VPN images (including csd, AnyConnect, Hostscan)
 
     	 [bookmark: pgfId-920033]Plug-ins (including rdp, ssh, ica, owa, and others)
 
    
 
    [bookmark: pgfId-920035]Multiple system software images cannot be included in the same bundle.
 
     
      
    
 
    
 
    
     [bookmark: pgfId-920039]
     Caution The Image Manager does not stop you from adding incompatible images as part of a bundle. You must determine this compatibility. The ASA and ASDM Compatibility matrix is located at: 
     http://www.cisco.com/en/US/docs/security/asa/compatibility/asamatrx.html#wp42231.
      
      
 
     

    
 
     
      
    
 
    
 
    [bookmark: pgfId-920041]Tip Throughout Image Manager there are operations where you can choose to apply an image, multiple images, or a (predefined) bundle of images.

    
     

    

    
 
    [bookmark: pgfId-920043]This section contains the following topics:
 
     
     	 [bookmark: pgfId-920048]Creating Bundles
 
     	 [bookmark: pgfId-920053]View Images by Bundle
 
     	 [bookmark: pgfId-920058]Renaming Bundles
 
     	 [bookmark: pgfId-920063]Deleting Bundles
 
     	 [bookmark: pgfId-920068]Deleting Images from Bundles
 
    
 
     
      [bookmark: pgfId-920076][bookmark: 168873][bookmark: immgt_proc_CreateBundle]Creating Bundles[bookmark: marker-920074]
 
     [bookmark: pgfId-920078]You can define bundles of images to simplify your Image Manager. Bundles are particularly useful when you have a group of images upon which you regularly operate.
 
     [bookmark: pgfId-920080]To create a bundle, do the following:
 
     
 
     [bookmark: pgfId-920082]Step 1 From the Bundles heading in the selector, click the Add Bundle (plus sign) icon.
 
     [bookmark: pgfId-920084]Step 2 In the Create Bundle dialog box that opens, enter the name for the new bundle.
 
     [bookmark: pgfId-920086]Step 3 Click OK.
 
     [bookmark: pgfId-920088]The bundle is listed under the Bundles heading in the selector.
 
     [bookmark: pgfId-920090]Step 4 From the Images section of the selector, select an image to be bundled. Then click on the Release Notes tab. Finally, examine the compatibility table in the applicable release notes to ensure there are no conflicts with the other images to be bundled.
 
      
       
     
 
     
 
     
      [bookmark: pgfId-920094]
      Caution The Image Manager does not stop you from adding incompatible images as part of a bundle. It is the responsibility of the user to determine this compatibility. The ASA and ASDM Compatibility matrix is located at: 
      http://www.cisco.com/en/US/docs/security/asa/compatibility/asamatrx.html#wp42231.
       
       
 
      

     
 
     [bookmark: pgfId-920096]Step 5 With compatibility determined, drag and drop each image onto the bundle.
 
      
       
     
 
     
 
     [bookmark: pgfId-920098]Note Multiple system software images cannot be included in the same bundle.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-920100]Tip You can select a range of images to drag and drop by selecting the first image in the range and then, with the Shift key pressed, selecting the last image in the range. You can select multiple images by clicking those images while keeping the Ctrl key pressed. You can also select a range of images and then add additional images to your selection by using the Ctrl key method. To move multiple images to a bundle, drag using the right mouse button.

     
      

     

     
 
     [bookmark: pgfId-920102]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-920110][bookmark: 168902][bookmark: immgt_proc_ViewImagesbyBundle]View Images by Bundle[bookmark: marker-920108]
 
     [bookmark: pgfId-920112]You can view the images that have been added to a bundle.
 
     [bookmark: pgfId-920114]To view the images in a bundle, do one of the following:
 
     
 
     [bookmark: pgfId-920116]Step 1 To view the images contained within all bundles:
 
     [bookmark: pgfId-920118] a. Under the Bundles heading in the selector, click the top-level Bundles folder.
 
     [bookmark: pgfId-920120]All the bundles are listed, together with the images contained within each.
 
     [bookmark: pgfId-920122] b. You can expand or collapse any of the bundles to make viewing easier. To expand all bundles or collapse all bundles, use the Expand All and Collapse All buttons at the top of the main window.
 
     [bookmark: pgfId-920124]Step 2 To view the images for a specific bundle:
 
     [bookmark: pgfId-920126] a. Under the Bundles heading in the selector, select a bundle.
 
     [bookmark: pgfId-920128]The list of images for the selected bundle is displayed in the main window.
 
     [bookmark: pgfId-920130]Step 3 To view a particular bundle:
 
     [bookmark: pgfId-920132] a. In the Bundles section of the selector, click Search (the magnifier icon).
 
     [bookmark: pgfId-920134] b. Enter the bundle name in the search field under the Bundles banner.
 
     [bookmark: pgfId-920136]The list of bundles displays only the specified bundle.
 
     [bookmark: pgfId-920138]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-920146][bookmark: 168939][bookmark: immgt_proc_RenamingBundles]Renaming Bundles[bookmark: marker-920144]
 
     [bookmark: pgfId-920148]Bundles can easily be renamed to provide better organization or to more accurately reflect the contents of the bundle.
 
     [bookmark: pgfId-920150]To rename a bundle, do the following:
 
     
 
     [bookmark: pgfId-920152]Step 1 From the Bundles heading in the selector, select a bundle.
 
     [bookmark: pgfId-920154]Step 2 Right-click the bundle name and, from the drop-down list, select Rename Bundle.
 
     [bookmark: pgfId-920156]The Rename Bundle dialog box appears.
 
     [bookmark: pgfId-920158]Step 3 Type the new bundle name.
 
     [bookmark: pgfId-920160]Step 4 Click OK.
 
     [bookmark: pgfId-920162]The new bundle name appears in the selector under Bundles.
 
     [bookmark: pgfId-920164]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-920172][bookmark: 168964][bookmark: immgt_proc_DeleteBundle]Deleting Bundles[bookmark: marker-920170]
 
     [bookmark: pgfId-920174]Bundles that are no longer needed can be deleted.
 
     [bookmark: pgfId-920176]To delete a bundle, do the following:
 
     
 
     [bookmark: pgfId-920178]Step 1 Select the bundle.
 
     [bookmark: pgfId-920180]Step 2 From the Bundles heading in the selector, click Delete (the red X icon). Alternatively, right click on the selected bundle and select Delete Bundle.
 
     [bookmark: pgfId-920182]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-920190][bookmark: 168981][bookmark: immgt_proc_DeletingImagesfromBundles]Deleting Images from Bundles[bookmark: marker-920188]
 
     [bookmark: pgfId-920192]If you wish to change the contents of a bundle, you can delete any of the images that are defined as part of a bundle.
 
     [bookmark: pgfId-920194]To delete images from bundle, do the following:
 
     
 
     [bookmark: pgfId-920196]Step 1 Select the bundle.
 
     [bookmark: pgfId-920198]Step 2 Right-click on the image(s) to be removed.
 
     [bookmark: pgfId-920200]Step 3 Select Delete Image from Bundle. Alternatively, click the Delete button at the top of the table.
 
     [bookmark: pgfId-920202]

     
      

     

     
 
    
 
   
 
    
     [bookmark: pgfId-920218][bookmark: 169000][bookmark: immgt_cncpt_Invntry]Working with Devices[bookmark: marker-920212][bookmark: marker-920214][bookmark: marker-920216]
 
    [bookmark: pgfId-920220]The following topics explain how to work with devices in Image Manager.
 
     
      
    
 
    
 
    [bookmark: pgfId-920222]Note For a cluster, only the master node supports the download of files from storage.

    
     

    

    
 
    [bookmark: pgfId-920224]This section contains the following topics:
 
     
     	 [bookmark: pgfId-920229]Viewing Device Inventory
 
     	 [bookmark: pgfId-920234]Manage Images on a Device
 
     	 [bookmark: pgfId-920239]View Device Memory
 
     	 [bookmark: pgfId-920244]Configuring the Image Install Location
 
    
 
     
      [bookmark: pgfId-920252][bookmark: 169013][bookmark: immgt_cncpt_ViewDeviceInventory]Viewing Device Inventory[bookmark: marker-920250]
 
     [bookmark: pgfId-920254]You can use the Device Summary page to quickly view the devices on your network and their attributes.
 
     [bookmark: pgfId-920256]Within the selector panel on the left is an area called Devices. From that area you can display all devices by selecting All (or you could select a location or group of devices you have defined). After you have chosen the scope of device selection, the corresponding devices are displayed in the upper panel of the Device Summary page. The upper window of the Device Summary page displays the following attributes, as applicable, for each device:
 
      
      	 [bookmark: pgfId-920258]Device Display name
 
      	 [bookmark: pgfId-920260]Mode (for example, Standalone, Active-Active. Active-Standby, Cluster)
 
      	 [bookmark: pgfId-920262]System SW Version
 
      	 [bookmark: pgfId-920264]ASDM Version
 
      	 [bookmark: pgfId-920266]AnyConnect Version
 
      	 [bookmark: pgfId-920268]Secure Desktop Version
 
      	 [bookmark: pgfId-920270]Hostscan Version
 
     
 
     [bookmark: pgfId-920272]The Device Summary table includes a Mode column. This column specifies such modes as Cluster, Standalone, Active-Active, and Active-Standby.
 
     [bookmark: pgfId-920274]For configurations in which multiple physical devices are grouped together, as in failover and cluster configuration, each physical unit/ member has its own file system. And these file systems can be different. The details of the file systems of each physical device/ member are viewable within Image Manager.
 
     [bookmark: pgfId-920276]Details of individual cluster members, including storage and image status, are shown in the Security Manager user interface. During discovery of image management inventory data, details are discovered regarding each cluster member’s storage and running image details.
 
     [bookmark: pgfId-920278]When a Failover or Cluster device is selected in the Device Summary page, the individual physical members in the group are displayed in the middle Device View table. The Device View table for Cluster device displays the following information about the cluster members:
 
      
      	 [bookmark: pgfId-920280] Name —Device or cluster member name.
 
      	 [bookmark: pgfId-920282] ID —Cluster Member ID.
 
      	 [bookmark: pgfId-920284] Status —Role of the member in the cluster. For example, Cluster Master or Cluster Slave.
 
      	 [bookmark: pgfId-920286] Serial Number —Serial number of the cluster device.
 
      	 [bookmark: pgfId-920288] Running OS Version —Version of OS on the particular member.
 
      	 [bookmark: pgfId-920290] CCL IP —Cluster Link IP address.
 
      	 [bookmark: pgfId-920292] CCL MAC —Cluster Link MAC address.
 
      	 [bookmark: pgfId-920294] Site ID —Site ID of the Cluster device.
 
     
 
     [bookmark: pgfId-920296]The Device View table for a Failover device has columns that include Name, Status (for example Standby or Active), Serial Number, RAM size, and Running OS Version. The Failover Device table lists these elements by Primary and Secondary devices for the failover pair nodes.
 
     [bookmark: pgfId-920298]When you select a particular device in the device summary page, then the lower window displays the following tabbed pages for the details of that device.
 
      
      	 [bookmark: pgfId-920300] Summary —Display Name, Device Type, IP Address, Hostname, Domain Name, Serial Number, Running OS Version, Target OS Version, RAM, Failover Mode, Image Install Location
 
      	 [bookmark: pgfId-920302] Compatible Images —Images compatible to the device—Image, Type, Version, Location, Size, Description, Comment.
 
      	 [bookmark: pgfId-920304] History —Chronological view of Image Installation Jobs and Configuration Deployment Jobs that have been executed on the device—Job Name, Changed By, State, Last Action, Tickets
 
     
 
     [bookmark: pgfId-920306]When you select a particular member of a failover or cluster device in the middle Device View, the lower window displays the following tabbed details for that physical device.
 
      
      	 [bookmark: pgfId-920308] Summary —Running OS Version, Target OS Version, RAM
 
      	 [bookmark: pgfId-920310] Storage —The number and capacity of flash memory units. Name, Size, Path, Type, Disk Usage
 
      	 [bookmark: pgfId-920312] Running Images —The images presently operating. Name, Type, Version, Path, Size
 
     
 
    
 
     
      [bookmark: pgfId-920324][bookmark: 169103][bookmark: immgt_proc__I_DvcImg]Manage Images on a Device[bookmark: marker-920318][bookmark: marker-920320][bookmark: marker-920322]
 
     [bookmark: pgfId-920326]You can use the Image Management tool to review, download, and remove the images on the ASA device(s) you select.
 
     [bookmark: pgfId-920328]To review, download, or remove ASA images on a device, do the following:
 
     
 
     [bookmark: pgfId-920330]Step 1 Select a device group from the Devices area of the selector panel.
 
     [bookmark: pgfId-920332]The main window displays the Device Summary. The Device summary lists the devices and the associated system software versions.
 
      
       
     
 
     
 
     [bookmark: pgfId-920334]Tip Alternatively, you can select the search function (magnifier icon) from the Devices banner and then enter the device name in the search field that appears.

     
      

     

     
 
     [bookmark: pgfId-920336]Step 2 From the upper pane of the Device Summary page, select a device.
 
      
       
     
 
     
 
     [bookmark: pgfId-920338]Note If a particular device is part of a cluster, you can navigate through the cluster to view device details.

     
      

     

     
 
     [bookmark: pgfId-920340]The lower pane displays details of the selected device.
 
     [bookmark: pgfId-920342]Step 3 Select the Storage tab in the lower pane and then check the amount of free space listed under Disk Usage.
 
      
       
     
 
     
 
     [bookmark: pgfId-920344]Note If a particular device is part of a cluster, you can navigate through the cluster to view device storage details.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-920346]Tip The device may have more than one storage area, for example, disk1. Be sure to scroll down to see secondary (flash) storage capacity.

     
      

     

     
 
     [bookmark: pgfId-920348]Step 4 Note the available disk space on the device.
 
     [bookmark: pgfId-920350]Step 5 To remove one or more images from the device to free up space, select one or more images in the Storage Tab and click Delete at the top of the Storage Tab.
 
      
       
     
 
     
 
     [bookmark: pgfId-920352]Tip Alternatively, you can select one or more images, right-click and click Delete.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-920354]Tip If you delete an image that is currently active and is being referenced, Image Manager displays a warning message.

     
      

     

     
 
     [bookmark: pgfId-920356]Step 6 To download an image from the device, select the image and click Download at the top of the Storage tab. Select the location on the local file system to which to download the image and click OK.
 
      
       
     
 
     
 
     [bookmark: pgfId-920358]Note For a cluster device, download of images is only supported on the Cluster master. Similarly, for a failover device, download of images is only supported on the active device in the pair.

     
      

     

     
 
     [bookmark: pgfId-920360]A dialog appears showing the progress of the download from the device. After the download is completed, the downloaded image is shown in Explorer.
 
     [bookmark: pgfId-920362]Step 7 Select the Compatible Images tab in the lower pane.
 
     [bookmark: pgfId-920364]The system displays images that are compatible to the device.
 
     [bookmark: pgfId-920366]Step 8 To install the compatible image(s) onto the device do the following:
 
     [bookmark: pgfId-920368] a. Select the image to be added to the device.
 
     [bookmark: pgfId-920370] b. Double-click the download icon.
 
     [bookmark: pgfId-920372]The image is downloaded to the repository.
 
     [bookmark: pgfId-920374] c. Select the image and then select Install from the context menu.
 
     [bookmark: pgfId-920379]The Install wizard appears and the system installs the image. Please see Install Compatible Images on Devices for details.
 
     [bookmark: pgfId-920381]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-920389][bookmark: 169166][bookmark: immgt_proc__I_DvcMem]View Device Memory[bookmark: marker-920387]
 
     [bookmark: pgfId-920391]You can use Image Manager to determine the memory capacity and application of a device in your network.
 
      
       
     
 
     
 
     [bookmark: pgfId-920393]Note Only physical devices can display memory capacity, clusters do not.

     
      

     

     
 
     [bookmark: pgfId-920395]To view the details of the memory on a device, do the following:
 
     
 
     [bookmark: pgfId-920397]Step 1 From the Devices area of the selector panel, choose the device to examine.
 
     [bookmark: pgfId-920399]Details of the selected device appear in upper window of the Device Summary page.
 
     [bookmark: pgfId-920401]Step 2 In the upper panel, examine the RAM listing.
 
      
       
     
 
     
 
     
      [bookmark: pgfId-920403]
      Caution Image Manager warns you if there is insufficient RAM on a device to load the new image. However, the system does not stop you from performing such an image upgrade. (This is in contrast with Configuration deployment, where the deployment job stops if there is insufficient RAM.)
       
       
 
      

     
 
     [bookmark: pgfId-920405]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-920413][bookmark: 169184][bookmark: immgt_proc_ConfigureInstallLocation]Configuring the Image Install Location[bookmark: marker-920411]
 
     [bookmark: pgfId-920415]ASA devices have a default flash (disk0) where all the images reside. By default, Image Manager copies images to disk0 of the ASA device. When the ASA device is configured with an external disk (that is, disk1), Image Manager allows you to choose between the two disks, disk0 or disk1, when loading images on the ASA device.
 
      
       
     
 
     
 
     [bookmark: pgfId-920417]Note The capability to load images on an external disk is very useful for storing large images such as those for AnyConnect and CSD, as disk0 can run out of space quickly with even a few of these larger images.

     
      

     

     
 
     [bookmark: pgfId-920419]For configuring Image Manager to use the external disk, do the following:
 
     
 
     [bookmark: pgfId-920421]Step 1 Select the device from the Devices area of the selector.
 
     [bookmark: pgfId-920423]Step 2 View the Summary information on the right pane.
 
     [bookmark: pgfId-920425]The available disks on the device are listed in the Image Install Location drop-down list. For a device with external disk, disk0 and disk1 would be listed.
 
     [bookmark: pgfId-920427]Step 3 Select the external disk, disk1, from the Image Install Location drop-down list and click Apply.
 
     [bookmark: pgfId-920429]All future image installation jobs for the device will load the images to disk1.
 
      
       
     
 
     
 
     [bookmark: pgfId-920431]Tip The configuration of the external disk can be verified by performing an image install operation. After the job is complete, view the contents of disk1 in the Storage tab of the device in Image Manager. It should list the newly installed images.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-920433]Note For cluster and failover devices, if all the physical member devices do not have the disk that is selected as the Image Install location, then there will be a validation error when you try to install images on the cluster or failover device. You need to select the Image Install location to be a disk that is present on every member device in the cluster or the failover to proceed with installing images.

     
      

     

     
 
     [bookmark: pgfId-920435]

     
      

     

     
 
    
 
   
 
    
     [bookmark: pgfId-920447][bookmark: 169209][bookmark: immgt_intro_UpdatingImages]About Image Updates on Devices Using Image Manager[bookmark: marker-920441][bookmark: marker-920443][bookmark: marker-920445]
 
    [bookmark: pgfId-920449]How does Image Manager update images on an ASA device?
 
    [bookmark: pgfId-920453]Image Manager follows the standard documented procedure to upgrade the stand-alone ASA devices with several built-in checks to ensure reliable image upgrade. Please refer to: http://www.cisco.com/en/US/products/ps6120/products_configuration_example09186a008067e9f9.shtml#maintask2 for the procedure for image upgrade.
 
     
      
    
 
    
 
    [bookmark: pgfId-920458]Note You must have accepted the latest Cisco.com certificate to enable Image Manager to interface with cisco.com. You must accept the certificate from both the "Image Meta-data locator" site and the download site of the images to start downloading images successfully (see Image Manager Page).

    
     

    

    
 
    [bookmark: pgfId-920460]Image Manager uses the HTTPS protocol to copy images to the ASA device, performs configuration changes to activate the new image (ensuring fallback to the older image in case of any error), and finally reloads the device if required, with the new image.
 
    [bookmark: pgfId-920462]How does Image Manager update images on an ASA configured for failover?
 
    [bookmark: pgfId-920464]Updating the images in an Active/Standby failover pair is accomplished by creating an image upgrade job on the active device of the pair, and then running the image upgrade job.
 
    [bookmark: pgfId-920466]Image update on an Active/Active failover pair is not supported in Image Manager. The Active/Active failover pair has to be converted to Active/Standby by making all the failover groups active on one unit, and the corresponding failover groups standby on the other unit. Only then can Image Manager update the image on the pair of devices.
 
    [bookmark: pgfId-920468]To upgrade devices in an Active/Active failover pair:
 
    [bookmark: pgfId-920470] 1. Manually convert the pair to active/standby by forcing all the failover groups on one device to be active and on the other device to be standby.
 
     
      
    
 
    
 
    [bookmark: pgfId-920472]Note Do not discover the devices in Security Manager.

    
     

    

    
 
     
      
    
 
    
 
    [bookmark: pgfId-920476]Note For additional details on how to convert an active/active failover pair to active/standby, see http://www.cisco.com/en/US/products/ps6120/products_configuration_example09186a0080b20f35.shtml#Actact.

    
     

    

    
 
    [bookmark: pgfId-920478] 2. Create an image upgrade job on the active device of the pair, and run the image upgrade job.
 
    [bookmark: pgfId-920480] 3. After the upgrade has occurred, manually convert the pair back to active/active configuration, as existed before the upgrade, by making the required failover groups active on one unit and the remaining failover groups to be active on the other physical unit.
 
    [bookmark: pgfId-920482] 4. Rediscover in Security Manager only the device inventory for the unit that was converted to standby.
 
    [bookmark: pgfId-920486]Image Manager follows the upgrade procedure as detailed at: http://www.cisco.com/en/US/products/ps6120/products_configuration_example09186a0080b20f35.shtml. The image is copied to both the units and then configuration change is done to activate the image that is synced to both units. First the standby is reloaded via the active unit and after ensuring that the standby has been upgraded successfully to the new version, the current active is reloaded. After both the units are upgraded to the new version, the failover pair or cluster upgrade is marked successful.
 
     
      
    
 
    
 
    [bookmark: pgfId-920488]Note During the current active reload and until the standby ASA takes over, the traffic going through the failover pair will be impacted.

    
     

    

    
 
    [bookmark: pgfId-920490]There are restrictions for image upgrade in failover ASA pair. We recommend that, while performing image upgrades on a failover ASA pair or cluster using Image Manager, you ensure the following restrictions are satisfied:
 
     
     	 [bookmark: pgfId-920492]The two units in a failover configuration should have the same major (first number) and minor (second number) software version.
 
     	 [bookmark: pgfId-920494] Maintenance Release : You can upgrade from any maintenance release to any other maintenance release within a minor release. For example, you can upgrade from 7.0(1) to 7.0(4) without first installing the maintenance releases in between.
 
     	 [bookmark: pgfId-920496] Minor Release : You can upgrade from a minor release to the next minor release.  You cannot skip a minor release. For example, you can upgrade from 7.0 to 7.1. Upgrading from 7.0 directly to 7.2 is not supported for zero-downtime upgrades; you must first upgrade to 7.1
 
     	 [bookmark: pgfId-920498] Major Release : You can upgrade from the last minor release of the previous version to the next major release. For example, you can upgrade from 7.9 to 8.0, assuming that 7.9 is the last minor version in the 7.x release.
 
    
 
    [bookmark: pgfId-920500]How does Image Manager update images on an ASA cluster?
 
    [bookmark: pgfId-920502]Image updates follow the procedure previously established for hitless upgrades that ensures that all members of a cluster are upgraded to a new version in a single user operation without affecting traffic flow. During an image upgrade:
 
     
     	 [bookmark: pgfId-920504]Slave cluster members are first loaded with the new image from the master. Images are copied to all members of a cluster while being connected only to the master. Such propagation through a cluster does not require switchovers of each device to master status and, thereby, minimizes traffic disruption.
 
     	 [bookmark: pgfId-920506]Configuration is changed on the master to add the boot command to load with the new image. The configuration, once changed on the master, automatically gets synced on all the slave units.
 
     	 [bookmark: pgfId-920508]All the slave cluster members reboot with the new image sequentially via the cluster master.
 
     	 [bookmark: pgfId-920510]All the slave cluster members come online and rejoin the cluster.
 
     	 [bookmark: pgfId-920512]The cluster master is then made into a slave (with the next slave member taking over the cluster master role).
 
     	 [bookmark: pgfId-920514]Via the new master, the old master is reloaded with the new image.
 
    
 
    [bookmark: pgfId-920516]This procedure for image update followed by Image Manager ensures minimal switchovers and minimal disruption of traffic.
 
    [bookmark: pgfId-920518]Device State Changes During and After Image Update
 
    [bookmark: pgfId-920520]Image upgrade is a critical operation and hence there is a need to depict visually, and inform users of, all image update operations. Thus, three new device states have been introduced:
 
     
     	 [bookmark: pgfId-920522] Upgrade In Progress —The device is put into this state whenever an image install job starts on the device. This state is automatically reset by the system after the image update operation is completed on the device.
 
     	 [bookmark: pgfId-920524] Maintenance —The device is put into Maintenance state when the image install job fails on the device and the device becomes unreachable after the image install operation. You need to manually reset this state to normal/operational state after taking necessary steps to bring back the device online by manually correcting issues due to upgrade or by rolling back the image.
 
     	 [bookmark: pgfId-920526] Configuration Required —For certain cases of image upgrade (like from ASA 8.2 to ASA 8.3), there are significant changes in the device configuration as part of the image upgrade which renders the policy configuration model in Security Manager incompatible with the device configuration. In such cases, even if the image upgrade operation may be successful, you must perform some operations, like rediscovery of device, to ensure that after upgrade, Security Manager’s configuration policy model and the device configuration are in tandem. Thus, after an image upgrade, if some additional configuration is required to be made in Configuration Manager to make the device operational, the device is put into  Configuration Required state. Even in the case where VPN images are deployed using Image Manager, the device is put into  Configuration Required state since this requires the user to configure these images in the VPN policies using Configuration Manager. The  Configuration Required state indicates that there are changes to be done in Configuration Manager to make the device functional in Security Manager after the image update operation. You can make the suggested changes and, after you are satisfied with your configuration changes, you can manually bring the device back to  Operational state.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-920531]Note Refer to the Troubleshooting Image Management for more scenarios that can put the device in the Configuration Required mode.

    
     

    

    
 
    [bookmark: pgfId-920533]Whenever the device state is changed to any of these three states, the state is indicated in the device selector with an explicit icon. This change in device state can be seen in both Configuration Manager and Image Manager. The normal state of the device when there is no image update operation on the device is the Operational state.
 
     
      
    
 
    
 
    [bookmark: pgfId-920535]Tip To manually reset the device state to normal or Operational status, select the device(s) in the device selector in Configuration Manager or Image Manager, right click, and select Make Device Operational.

    
     

    

    
 
    [bookmark: pgfId-920537]This section contains the following topics:
 
     
     	 [bookmark: pgfId-920542]Validating a Proposed Image Update on a Device
 
     	 [bookmark: pgfId-920547]Using the Image Installation Wizard to Install Images on Devices
 
     	 [bookmark: pgfId-920552]Install Bundled Images on Devices
 
     	 [bookmark: pgfId-920557]Install Compatible Images on Devices
 
     	 [bookmark: pgfId-920562]Install Images on Selected Devices
 
    
 
     
      [bookmark: pgfId-920572][bookmark: 169304][bookmark: immgt_proc_ValidatingUpdates]Validating a Proposed Image Update on a Device [bookmark: marker-920570]
 
     [bookmark: pgfId-920574]You can validate the image update job on one or more devices prior to actually performing it. The following list details the various validations that are performed:
 
      
      	 [bookmark: pgfId-920576]Insufficient disk space on the ASA device to accommodate the selected images.
 
     
 
     [bookmark: pgfId-920578]An error is displayed in this case. You must navigate to the Storage tab for that device and delete one or more images to make space. Then retry the upgrade validation operation.
 
      
       
     
 
     
 
     [bookmark: pgfId-920580]Note The disk space on each of the members in the Cluster and both active and standby units in a Failover are evaluated for sufficient space to accommodate the selected images. When a single member or device does not have sufficient space, an error is displayed and you cannot proceed to creating a job on the device. You must navigate to the Storage tab for that particular member and make space by deleting one or more unwanted images.

     
      

     

     
 
      
      	 [bookmark: pgfId-920584]Insufficient RAM on the device to run the new image as recommended in:  Release Notes for the Cisco ASA 5500 Series, 8.4(x). 
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-920586]Note Image Manager will warn you if there is insufficient RAM on the device to load the new image. However, this will not stop you from performing an image upgrade. This is in contrast with Configuration deployment, wherein the deployment job stops if there is insufficient RAM.

     
      

     

     
 
      
      	 [bookmark: pgfId-920588]If the flash device (disk0 or disk1) that is selected for Image Install Location is not present on any of the devices/members in cluster/failover setup, then and error is displayed and the job is aborted.
 
      	 [bookmark: pgfId-920590]Configuration changes that have been submitted but not yet deployed to the device. These changes need to be deployed before starting the image update job. Otherwise, the configuration changes may become incompatible with the upgraded image version on the device.
 
      	 [bookmark: pgfId-920592]Warn if the selected image(s) is (are) incompatible with the device type, for example, if non-SMP images are selected for ASA 5585 device types.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-920594]Note This warning only occurs when you are using the drag-and-drop method. For other flows, the incompatible images/devices are filtered out in step 2 of the Image Install Wizard.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-920596]Note This validation was skipped in CSM 4.3 if Check for updates is not performed due to the unavailability of meta-data information about images on Cisco.com compatible with MDF IDs. In CSM 4.4, the meta-data information are prepackaged with CSM install and hence even if Check for updates is not performed, Image manager will validate the compatibility of images for device types and warn the user when an incompatible image-device combination is chosen.

     
      

     

     
 
      
      	 [bookmark: pgfId-920598]Warn if the device is being updated to a version that is unsupported on Security Manager.
 
      	 [bookmark: pgfId-920600]Warn if the new image version is the same as or lower than the version running on the device.
 
      	 [bookmark: pgfId-920602]An image upgrade to ASA Version 8.3 from any lower version would require the device to be re-discovered in Security Manager. There were major changes in the NAT configuration introduced in ASA version 8.3 that are incompatible with previous ASA versions. Likewise, there were major changes to the NAT policy model in Security Manager for Version 8.3. Hence, when a device is upgraded to ASA 8.3, that device is put into the Configuration Required state to indicate to the Configuration user that some changes are required in Configuration Manager to make the device operational. After rediscovering the device in Security Manager, the user can right-click the device in the device tree and select Make Device Operational to bring it back to normal state.
 
      	 [bookmark: pgfId-920604]An image upgrade from ASA Version 8.3.x to 8.4.2 or higher also requires rediscovery of the device in Security Manager because of incompatible changes in PAT configuration in ASA Version 8.4.2. In this case also, the device state is changed to the Configuration Required state after the image upgrade.
 
      	 [bookmark: pgfId-920606]An image upgrade from ASA Version 8.x to 9.0.1 or higher requires rediscovery of the device in Security Manager because of incompatible changes in Unified access rules, inspection, and NAT rules.
 
      	 [bookmark: pgfId-920608]An image upgrade from ASA Version 7.x to 8.x introduces major changes in the SSLVPN configuration both on the device and in Security Manager. Because of these incompatible changes, the device must be deleted from Security Manager after the image upgrade and then added again. The device is put into the Configuration Required state to notify the user to act upon these warnings.
 
      	 [bookmark: pgfId-920610]Any VPN image, such as an AnyConnect, CSD, or Hostscan image, being loaded using Image Manager warns the user if the existing VPN image was part of a shared policy being assigned to the current device or other devices. A warning is issued to also copy the new image to all the devices to which the shared policy is assigned so that the shared policy can be updated for all the devices seamlessly without the loss of policy sharing.
 
      	 [bookmark: pgfId-920612]Warn when the standby unit in a failover pair in not reachable. This is an error that will cause the job to be aborted.
 
      	 [bookmark: pgfId-920616]Warning for upgrade of Active/Standby failover pair. The version being upgraded should comply with the recommendations listed at:  ASA/PIX: How to Use the CLI to Upgrade the Software Image on a Failover Pair .
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-920618]Note The same warnings are also applicable for an ASA in cluster configuration.

     
      

     

     
 
      
      	 [bookmark: pgfId-920620]Warning for upgrade of Active/Active failover pair that the image update job will be aborted unless the pair is converted to Active/Standby (that is, if all the failover groups are active on one physical unit).
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-920622]Note Additional validations are required for a "device" that is a designated cluster master. In addition to a check that is similar to that for Active/Standby Failover, there is also a check that the cluster image is compatible with supported platforms. A cluster cannot be downgraded to a version less than 9.x.

     
      

     

     
 
     [bookmark: pgfId-920624]To validate an image installation, do the following:
 
     
 
     [bookmark: pgfId-920626]Step 1 From the File menu, select Validate.
 
     [bookmark: pgfId-920628]The Validate Image Assignments window opens.
 
     [bookmark: pgfId-920630]Step 2 Click Add Assignment.
 
     [bookmark: pgfId-920632]The Image Assignment window opens.
 
     [bookmark: pgfId-920634]Step 3 In the Image Assignment window, from the drop-down list, select either:
 
      
      	 [bookmark: pgfId-920636]Select Images and Assign to Devices
 
      	 [bookmark: pgfId-920638]Select Devices and Assign to Images
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-920640]Tip The same result is obtained by assigning images to devices or by assigning devices to images.

     
      

     

     
 
     [bookmark: pgfId-920642]Step 4 Select one or more items (images or devices) by moving them to the window on the right.
 
      
       
     
 
     
 
     [bookmark: pgfId-920644]Tip You can use pre-defined bundles rather than images by clicking Bundles and selecting the bundle.

     
      

     

     
 
     [bookmark: pgfId-920646]Step 5 Click Next and assign the other item (images or devices).
 
     [bookmark: pgfId-920648]The Confirm Assignments window appears.
 
     [bookmark: pgfId-920650]Step 6 Examine and confirm the assignments that you have specified.
 
      
       
     
 
     
 
     [bookmark: pgfId-920652]Tip You can continue to add or remove assignments, as required.

     
      

     

     
 
     [bookmark: pgfId-920654]Step 7 Click Finish.
 
     [bookmark: pgfId-920656]The Validate Assignments window appears.
 
     [bookmark: pgfId-920658]Step 8 Click Start Validation.
 
     [bookmark: pgfId-920660]The validation status of the assignment is shown in the Validation column. It shows either Warning or Successful or Error.
 
     [bookmark: pgfId-920662]Step 9 Click on the display of Warning or Successful or Error.
 
     [bookmark: pgfId-920664]A lower pane window opens.
 
     [bookmark: pgfId-920666]Step 10 According to the validation status, do one of the following:
 
      
      	 [bookmark: pgfId-920668] Error —Examine the potential reasons for the error and correct as necessary.
 
      	 [bookmark: pgfId-920670] Warning —Examine the potential reasons for the warning and correct as necessary.
 
      	 [bookmark: pgfId-920672] Successful —No action required.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-920674]Tip Be sure to display and examine all the errors or warnings by using the window slider bar on the right.

     
      

     

     
 
     [bookmark: pgfId-920676]Step 11 After addressing the warnings or errors shown, you can proceed to create the job using the Image Install wizard.
 
     [bookmark: pgfId-920678]Step 12 Optionally, you can right-click on an assignment element in the Validate Image Assignments window and modify or delete it before proceeding.
 
     [bookmark: pgfId-920680]Step 13 You can also right-click on an assignment and select Copy Table. This copies the assignment details and the validation status and notes. You can then paste the contents to Notepad or another program as a CSV file to be used as reference.
 
     [bookmark: pgfId-920682]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-920696][bookmark: 169422][bookmark: immgt_proc_CreateJob]Using the Image Installation Wizard to Install Images on Devices[bookmark: marker-920692][bookmark: marker-920694]
 
     [bookmark: pgfId-920698]You can use this feature to create a job to assign and install images on devices. An assignment is simply an association of an image and a device that defines an installation job.
 
      
       
     
 
     
 
     [bookmark: pgfId-920700]Note If you have the workflow function enabled, you must perform the additional steps described for obtaining authorization before you can accomplish installation.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-920702]Note You can choose to operate upon any arbitrary set of devices.

     
      

     

     
 
     [bookmark: pgfId-920704]To create a job to install images on devices, do the following:
 
     
 
     [bookmark: pgfId-920706]Step 1 Go to Files > Open Image Installation Wizard.
 
     [bookmark: pgfId-920708]The Image Installation Wizard dialog box appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-920710]Tip The Image Installation Wizard can be invoked in several ways. In addition to invoking the Wizard from the menu, as described here, you can invoke it when you do any one of the following things: (1) install images by the drag-and-drop method; (2) right-click on a device or bundle; or (3) select a device, navigate to the Compatible Image tab, select one or more images from the table, right-click, and select the Install option.

     
      

     

     
 
     [bookmark: pgfId-920712]Step 2 On the lower left, click Add Assignment.
 
     [bookmark: pgfId-920714]The Image Assignments dialog box appears.
 
     [bookmark: pgfId-920716]Step 3 From the drop-down list on the top, select whether you want to assign images to devices, or devices to images.
 
     [bookmark: pgfId-920718]Step 4 Move items (devices or images) from the list on the left to the selected items list on the right. Then click Next. You can also select bundles, instead of images, by clicking the Bundles tab.
 
      
       
     
 
     
 
     [bookmark: pgfId-920720]Tip When pairing images and devices to define assignments, you can proceed with images and then devices, or devices and then images. The order of this selection does not matter.

     
      

     

     
 
     [bookmark: pgfId-920722]Step 5 Review the assignment definition in the Confirm Assignments dialog box and click Finish.
 
      
       
     
 
     
 
     [bookmark: pgfId-920724]Tip At this point you can choose to add additional assignment pairs, as desired, by clicking Add Assignment.

     
      

     

     
 
     [bookmark: pgfId-920726]Step 6 When you are finished defining assignments, click Start Validation. Wait until the system displays Validation Complete.
 
     [bookmark: pgfId-920728]Step 7 Examine the status in the Validation column on the Assignments tab of the Wizard dialog box. It shows either Warning or Successful or Error.
 
     [bookmark: pgfId-920730]Step 8 Determine what steps are necessary according to the status:
 
      
      	 [bookmark: pgfId-920732] Error —Examine the potential reasons for the error and correct as necessary.
 
      	 [bookmark: pgfId-920734] Warning —Examine the potential reasons for the warning and correct as necessary.
 
      	 [bookmark: pgfId-920736] Successful —No action required.
 
     
 
     [bookmark: pgfId-920738]Step 9 Right-click on the assignment for more options:
 
      
      	 [bookmark: pgfId-920740] Move Up/Move Down —Select these options for a multi-device job when you want to change the order in which the devices will get updated. This feature can be used to order or sequence the devices when the Install Images to Devices job option is set to Sequential.
 
      	 [bookmark: pgfId-920742] Delete/Delete All —You choose these options to remove one or all devices from the image upgrade job.
 
      	 [bookmark: pgfId-920744] Copy Table —Use this to copy the warning messages to some text editor or spreadsheet program for reference.
 
      	 [bookmark: pgfId-920746] Test File copy —Use this option to check whether files can be copied between Security Manager Image repository and ASA device flash using https protocol.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-920748]Tip Be sure to display and examine all the errors or warnings by using the windows slider bar on the right.

     
      

     

     
 
     [bookmark: pgfId-920750]Step 10 If you want the installation job scheduled for a particular time, select the Schedule tab and specify the date and time.
 
     [bookmark: pgfId-920752]Step 11 To set properties of the installation job, select the Properties tab.
 
     [bookmark: pgfId-920754] a. Edit the Name, if desired. (The default is Image install Job—<timestamp>)
 
     [bookmark: pgfId-920756] b. Edit the Description, if desired.
 
     [bookmark: pgfId-920758] c. Select a Ticket ID, if desired.
 
      
       
     
 
     
 
     [bookmark: pgfId-920760]Tip Starting from release 4.4, Ticket ID field in Image Manager has been decoupled from Config Manager. It is now just a ‘tag’ and can be any arbitrary string. Ticket ID field is an editable combo box with auto completion that shows tickets created earlier both in Image Manager and Configuration Manager. Also, there is no dependency on Ticketing mode in Configuration Manager for Ticket ID field. Ticket ID is an optional field and can be left blank. Global search in Configuration Manager also supports tickets used in Image Manager and lists the Image Installation jobs with which the ticket is associated.

     
      

     

     
 
     [bookmark: pgfId-920762] d. Set the On Error option. (Default is Stop Installation, alternative is Continue Operation.)
 
     [bookmark: pgfId-920764] e. Set the Backup Current Image option. (Default is Yes, alternative is No.)
 
      
       
     
 
     
 
     [bookmark: pgfId-920766]Tip This is only applicable for system software images

     
      

     

     
 
     [bookmark: pgfId-920768] f. Set the Install images to devices in option. (Default is parallel, alternative is Sequential.)
 
     [bookmark: pgfId-920770] g. Select one of three operations:
 
      
      	 [bookmark: pgfId-920772]Install image and reboot device
 
      	 [bookmark: pgfId-920774]Install image but do not reboot device
 
      	 [bookmark: pgfId-920776]Only copy image onto devices
 
     
 
     [bookmark: pgfId-920778] h. If you are using Workflow, you can optionally configure the following approval options:
 
      
       
     
 
     
 
     [bookmark: pgfId-920780]Tip These are located in the top frame in Job properties for the job.

     
      

     

     
 
      
      	 [bookmark: pgfId-920782] Action — 
 
      	 [bookmark: pgfId-920784]Approve
 
      	 [bookmark: pgfId-920786]Reject
 
      	 [bookmark: pgfId-920788]Deploy
 
      	 [bookmark: pgfId-920790]Submit
 
     
 
     [bookmark: pgfId-920792]If you reject a job, the status is set to Rejected, after which you discard the job. When you discard a job the status is shown as Discarded and all the job’s action buttons are disabled.
 
     [bookmark: pgfId-920794]If you approve a job, the status is set to Approved. Then, you must click Deploy to start the image upgrade job.
 
      
       
     
 
     
 
     [bookmark: pgfId-920796]Tip You can the check running commentary by selecting the Details tab. and clicking Show Progress.

     
      

     

     
 
     [bookmark: pgfId-920798]After you deploy a job, the job status is shown as either Deployed or Failed. The History tab in the bottom pane (for the selected job) only is activated in WF mode and displays one of two job action flows:
 
      
      	 [bookmark: pgfId-920800]Creating/ Edit-In-use/ Submitted/ Rejected/ Discarded
 
      	 [bookmark: pgfId-920802]Creating/Edit-In-use/ Submitted/ Approved/ Deploying/ Deployed (or Failed)
 
      	 [bookmark: pgfId-920804] Submit the job —This is checked by default
 
      	 [bookmark: pgfId-920806] Approver email —The email address list of approvers
 
      	 [bookmark: pgfId-920808] Submitter email —The email address of the person submitting the job
 
     
 
     [bookmark: pgfId-920810] i. You can change job properties by clicking Edit.
 
     [bookmark: pgfId-920815] j. Refer to Viewing Install Jobs for additional job viewing options.
 
     [bookmark: pgfId-920817]Step 12 Click Install.
 
     [bookmark: pgfId-920819]The Jobs page appears and the install job is shown with its status as Deploying.
 
      
       
     
 
     
 
     [bookmark: pgfId-920821]Note If a schedule was selected for the job, the job state is shown as Scheduled. The job will start deploying at the scheduled time and, at that time, the job state changes to Deploying.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-920826]Note If workflow is enabled for Image Install Jobs, then the job state is changed to either Submitted or Edit-in-Use. In this mode, the job can be deployed only after it has been approved. Please refer to Image Installation Job Approval Workflow for details on the job states in the workflow mode.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-920831]Tip You can halt the job by clicking Abort. Please see Aborting an Image Installation Job for important information about aborting an installation job.

You can discard a job before the scheduled run time by clicking Discard.

     
      

     

     
 
     [bookmark: pgfId-920833]Step 13 When the job starts deploying, notice the change in the state of the devices to Update in progress state in the device tree in Configuration Manager and Image Manager. A green progress icon appears beside the device in the device tree.
 
     [bookmark: pgfId-920838]Step 14 View the details of the job and its progress while it is in deploying state. Please see Viewing Install Jobs for details.
 
     [bookmark: pgfId-920840]Step 15 Wait for the job to complete.
 
     [bookmark: pgfId-920842]The job state is changed to Deployed if all the devices are successfully updated. The job state is changed to Failed if one or more devices failed in the job.
 
     [bookmark: pgfId-920844]Step 16 Notice the change in state of the device(s) in the device tree after the job is complete.
 
     [bookmark: pgfId-920846]If the image update is successful and there are no further configuration changes required in Configuration Manager, the device will be moved back to Operational state. If there are configuration changes required on the device after the update, then device is moved to Configuration Required state. Clicking on the device in the device tree brings up a balloon tip with details of the state and actions to be taken to move the device state back to Operational.

If the image update fails on the device and the device is rendered unreachable during the image update operation, the device is put to Maintenance state.
 
     [bookmark: pgfId-920848]Step 17 Verifying the image update:
 
     [bookmark: pgfId-920850] a. Click on the device in the device tree in Image Manager.
 
     [bookmark: pgfId-920852] b. Go to the Summary tab to view the updated Running OS version.
 
     [bookmark: pgfId-920854] c. Go to the Running Images tab to view the new running images after the image update.
 
     [bookmark: pgfId-920856] d. Select the device in Configuration Manager.
 
     [bookmark: pgfId-920858] e. Right-click the device and select Device Properties.
 
     [bookmark: pgfId-920860] f. Notice the new image version updated in Running OS Version field.
 
     [bookmark: pgfId-920862] g. Go to Configuration Manager > Manage > Configuration Archive.
 
     [bookmark: pgfId-920864] h. From the device CLI, enter sh ver
 
     [bookmark: pgfId-920866]The updated OS version should be displayed.
 
     [bookmark: pgfId-920868] i. Select the device in the left device tree.
 
     [bookmark: pgfId-920870] j. View the Configuration Archive versions in the right pane and notice the latest entry with the Archival Source as Image Manager.
 
     [bookmark: pgfId-920872] k. Select the archived entry and click View.
 
     [bookmark: pgfId-920874] l. Compare this entry with the previous archived version to view the configuration changes made by Image Manager during image update. You can view the boot commands being prepended for the new ASA system software image and/or ASDM image command being added for the new ASDM image.
 
     [bookmark: pgfId-920876] m. Email notification will be sent to configured recipients with the status of the Image Upgrade job if email notification is configured in Image Manager administration settings.
 
     [bookmark: pgfId-920878]Step 18 If the device is set to Configuration Required or Maintenance state after the image update operation, follow the steps below to complete the post-image update requirements to make the device functional from Configuration Manager:
 
     [bookmark: pgfId-920880] a. Click on the device in the device tree in Configuration Manager or Image Manager.
 
     [bookmark: pgfId-920882]A balloon tip appears showing the device information.
 
     [bookmark: pgfId-920884] b. View the contents of the balloon tip. Review the reason for the device being set to the Configuration Required or Maintenance state. Review also the recommended actions to be taken.
 
     [bookmark: pgfId-920886] c. Perform the recommended actions.
 
     [bookmark: pgfId-920888] d. Right-click the device in the device tree and select Make Device(s) Operational.
 
     [bookmark: pgfId-920890]The device is moved to Operational state and the icon beside the device in the device tree is removed.
 
     [bookmark: pgfId-920892]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-920900][bookmark: 169678][bookmark: immgt_proc_InstallBundle]Install Bundled Images on Devices [bookmark: marker-920898]
 
     [bookmark: pgfId-920902]You can use the Image Manager tool to assign and install compatible images that are grouped as bundles. Bundles simplify repetitive operations and can ensure consistent actions are taken on a group of devices.
 
     [bookmark: pgfId-920904]To selectively install an image bundle on a device or device group, do the following:
 
     
 
     [bookmark: pgfId-920906]Step 1 Drag and drop the bundle onto a device or device group.
 
     [bookmark: pgfId-920908]The Install images on devices dialog box appears with device and images in the bundle pre-assigned. If the bundle is dropped onto a device group, all the devices in the group are automatically selected and assigned to the images in the bundle.
 
     [bookmark: pgfId-920910]Step 2 Investigate any assignment validation errors or warnings listed in the Install images on devices dialog box.
 
      
       
     
 
     
 
     [bookmark: pgfId-920915]Tip You can choose to schedule the job and also modify the default properties for the job. Please see Using the Image Installation Wizard to Install Images on Devices for details on scheduling a job and configuring job properties.

     
      

     

     
 
     [bookmark: pgfId-920917]Step 3 When your warnings are corrected (or you determine them to be insignificant), click Install.
 
      
       
     
 
     
 
     [bookmark: pgfId-920919]Note Alternatively, you can right-click a bundle and select Install to launch the Image Installation wizard with the bundle pre-selected. You can then choose the devices and click Install to install the bundle on the selected devices.

     
      

     

     
 
     [bookmark: pgfId-920921]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-920929][bookmark: 169702][bookmark: immgt_proc_InstallCompatibleImages]Install Compatible Images on Devices[bookmark: marker-920927]
 
     [bookmark: pgfId-920931]You can use Image Manager to install compatible images on devices.
 
     [bookmark: pgfId-920933]To selectively install one or more compatible images on a device or device group, do the following:
 
     
 
     [bookmark: pgfId-920935]Step 1 Select a device in the Devices area of the selector and navigate to the Compatible Images tab.
 
     [bookmark: pgfId-920937]Step 2 Select one or more Repository images in the Compatible Images tab.
 
     [bookmark: pgfId-920939]Step 3 Right-click a selected image and click Install.
 
     [bookmark: pgfId-920941]The Image Installation wizard appears with the selected images pre-assigned or moved to the right pane in the Select Image page.
 
     [bookmark: pgfId-920943]Step 4 Click Next.
 
     [bookmark: pgfId-920945]The Select Devices page of the wizard is displayed.
 
     [bookmark: pgfId-920947]Step 5 Select the devices to which you want to install, and then click Next.
 
     [bookmark: pgfId-920949]The Confirm Assignments page of the wizard is displayed.
 
     [bookmark: pgfId-920951]Step 6 Confirm the devices and images assignments, and then click Finish.
 
     [bookmark: pgfId-920953]The Install images on selected devices dialog box appears with the devices and image(s) assigned.
 
     [bookmark: pgfId-920955]Step 7 Click Start Validation in the upper-right corner of the Assignments tab. Investigate any assignment validation errors or warnings listed in the Install images on devices dialog box.
 
     [bookmark: pgfId-920957]Beginning with version 4.9, Security Manager provides an enhanced validation procedure for installing images on devices:
 
      
      	 [bookmark: pgfId-920959]If you have downloaded the images from CCO using the Image Manager, before installing the images to the device, the serial number of the device is verified for the service contract. If the device has a valid service contract, the image will proceed with the installation or upgrade process. If the device does not have a valid service contract, the image will not proceed with the installation or upgrade process.
 
      	 [bookmark: pgfId-920961]If you have copied the images from the local file system to Image Manager, the service contract validation will not be performed for the device and you can proceed to install the image on the device.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-920966]Tip You can choose to schedule the job and also modify the default properties for the job. Please see Using the Image Installation Wizard to Install Images on Devices for details on scheduling a job and configuring job properties.

     
      

     

     
 
     [bookmark: pgfId-920968]Step 8 When your warnings are corrected (or you determine them to be insignificant), click Install.
 
     [bookmark: pgfId-920973]The image installation job is created. Please see Using the Image Installation Wizard to Install Images on Devices for the remaining steps to monitor the job progress and verify the image update.
 
      
       
     
 
     
 
     [bookmark: pgfId-920975]Note Alternatively, to install one or more images on a device or device group, you can drag multiple images from the Repository view and drop them onto a device or device group. Then, click Install to install the selected image(s) on the selected device(s).

     
      

     

     
 
     [bookmark: pgfId-920977]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-920985][bookmark: 169755][bookmark: immgt_proc_UpgradeASAImages]Install Images on Selected Devices[bookmark: marker-920983]
 
     [bookmark: pgfId-920987]You can use Image Manager to upgrade the images on a set of devices that you select.
 
     [bookmark: pgfId-920989]To install images on a selected set of devices, do the following:
 
     
 
     [bookmark: pgfId-920991]Step 1 Select a device group in the Devices area of the selector.
 
     [bookmark: pgfId-920993]Step 2 View the listing of devices in the group in the right pane.
 
     [bookmark: pgfId-920995]Step 3 Select one or more devices from the list.
 
      
       
     
 
     
 
     [bookmark: pgfId-920997]Tip Use the Shift and Control keys to select multiple devices.

     
      

     

     
 
     [bookmark: pgfId-920999]Step 4 Right-click a selected device and click Install.
 
     [bookmark: pgfId-921001]The Image Installation wizard appears with the selected devices pre-assigned or moved to the right pane in the Select Devices page.
 
     [bookmark: pgfId-921003]Step 5 Click Next.
 
     [bookmark: pgfId-921005]The Select Images page of the wizard is displayed.
 
     [bookmark: pgfId-921007]Step 6 Select the images you want to install, and then click Next.
 
      
       
     
 
     
 
     [bookmark: pgfId-921009]Tip You can also select a bundle in the Bundles tab.

     
      

     

     
 
     [bookmark: pgfId-921011]The Confirm Assignments page of the wizard is displayed.
 
     [bookmark: pgfId-921013]Step 7 Confirm the devices and images assignments, and then click Finish.
 
     [bookmark: pgfId-921015]The Install Images on selected devices dialog box appears with the devices and image(s) assigned.
 
     [bookmark: pgfId-921017]Step 8 Click Start Validation in the upper-right corner of the Assignments tab. Investigate any assignment validation errors or warnings listed in the Install images on devices dialog box.
 
      
       
     
 
     
 
     [bookmark: pgfId-921022]Tip You can choose to schedule the job and also modify the default properties for the job. Please see Using the Image Installation Wizard to Install Images on Devices for details on scheduling a job and configuring job properties.

     
      

     

     
 
     [bookmark: pgfId-921024]Step 9 When your warnings are corrected (or you determine them to be insignificant), click Install.
 
     [bookmark: pgfId-921029]The image installation job is created. Please see Using the Image Installation Wizard to Install Images on Devices for the remaining steps to monitor the job progress and verify the image update.
 
     [bookmark: pgfId-921031]

     
      

     

     
 
    
 
   
 
    
     [bookmark: pgfId-921043][bookmark: 169805][bookmark: immgt_intro_Jobs]Working with Jobs[bookmark: marker-921039][bookmark: marker-921041]
 
    [bookmark: pgfId-921045]This section details the set of functions that assists in the performance of the image installation jobs. An image installation job may be immediately run, or it may be scheduled to run at a specified time and date. As Image Manager jobs tend to be time-consuming, the job management functions enable you to perform these operations in the background. Image Manager incorporates an optional ticketing system that enables you to easily locate a job or jobs by means of a unique Ticket ID.
 
    [bookmark: pgfId-921047]You should understand that the details of a particular job are defined and validated before being run.
 
    [bookmark: pgfId-921049]This section contains the following topics:
 
     
     	 [bookmark: pgfId-921054]Viewing Image Installation Job Summary
 
     	 [bookmark: pgfId-921059]Viewing Install Jobs
 
     	 [bookmark: pgfId-921064]Aborting an Image Installation Job
 
     	 [bookmark: pgfId-921069]Retry a Failed Image Install Job
 
     	 [bookmark: pgfId-921074]Roll Back a Deployed Job
 
     	 [bookmark: pgfId-921079]Image Installation Job Approval Workflow
 
    
 
     
      [bookmark: pgfId-921087][bookmark: 169815][bookmark: immgt_proc_ViewJobSummary]Viewing Image Installation Job Summary[bookmark: marker-921085]
 
     [bookmark: pgfId-921089]You can use the Image Manager tool to monitor image installation and deployment jobs. You can view the history and status of jobs that Image Manager has performed, as well as the summary, details, or history of any particular job.
 
      
       
     
 
     
 
     [bookmark: pgfId-921097]Note Comprehensive details of job state changes are available in Configuration Manager (see Job States in Non-Workflow Mode or Job States in Workflow Mode). For an Audit Report navigate to Configuration Manager > Manage > Audit Report.

     
      

     

     
 
     [bookmark: pgfId-921099]To view a summary of image installation jobs, do the following:
 
     
 
     [bookmark: pgfId-921101]Step 1 In the selector, under Jobs, click Install Jobs.
 
     [bookmark: pgfId-921103]The main window displays the Jobs list in the upper pane.
 
     [bookmark: pgfId-921105]Step 2 Examine the details of the Jobs list, which may include:
 
      
      	 [bookmark: pgfId-921107] Name —The name of the job. By default the name includes a time stamp.
 
      	 [bookmark: pgfId-921109] Last Action —Date of the last action.
 
      	 [bookmark: pgfId-921111] Status —Whether the job has deployed, failed, or is underway.
 
      	 [bookmark: pgfId-921113] Changed By —Who started the job.
 
      	 [bookmark: pgfId-921115] Description —Job description.
 
      	 [bookmark: pgfId-921117] Schedule —Job schedule.
 
      	 [bookmark: pgfId-921119] Ticket ID(s) —Tickets are just tags attached to Image Manager job to track changes. These tickets may be tickets created in Configuration Manager, but are not mandated to be so.
 
     
 
     [bookmark: pgfId-921121]Step 3 Optionally, you can find and select a single job about which more information is then displayed in the lower pane. This includes:
 
      
      	 [bookmark: pgfId-921123]Summary
 
      	 [bookmark: pgfId-921125]Details
 
      	 [bookmark: pgfId-921127]History
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-921129]Tip While viewing the lower pane Details tab, you can select a device and then view a log of the job in the lower right pane.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-921131]Note These are dockable windows. You can customize the default view.

     
      

     

     
 
     [bookmark: pgfId-921133]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-921141][bookmark: 169875][bookmark: immgt_proc_ViewJobDetails]Viewing Install Jobs[bookmark: marker-921139]
 
     [bookmark: pgfId-921143]You can view the details associated with a particular Image Management job.
 
     [bookmark: pgfId-921145]To view the details associated with a job, do the following:
 
     
 
     [bookmark: pgfId-921147]Step 1 In the selector, under Jobs, click Install Jobs.
 
      
       
     
 
     
 
     [bookmark: pgfId-921149]Tip The Status column in the Jobs selector indicates whether a job is Submitted, Approved, Deployed, In Progress, or Failed.

     
      

     

     
 
     [bookmark: pgfId-921151]The main window displays the Jobs list in the upper pane.
 
     [bookmark: pgfId-921153]Step 2 Select a job to examine.
 
      
       
     
 
     
 
     [bookmark: pgfId-921155]Tip To find a particular job, you can sort the Jobs list by any of the column headings, including Name, Last Action (chronology), Status (e.g., Deployed, Failed), Description, and so forth. You can also find a particular job by using the search window to enter a filtering string.

     
      

     

     
 
      
       
     
 
     
 
     [bookmark: pgfId-921157]Note The location of the jobs folder is CSM-ROOT\files\vms\jobs directory.

     
      

     

     
 
     [bookmark: pgfId-921159]Step 3 Examine job summary information by clicking Summary in the lower pane.
 
     [bookmark: pgfId-921161]The lower pane displays job summary information including Image Management Job Name, Devices to be Deployed, Devices Deployed Successfully, and Devices Deployed with Errors.
 
     [bookmark: pgfId-921163]Step 4 Examine job summary details by clicking Details in the lower pane.
 
     [bookmark: pgfId-921165]Details of the Devices, New Image, Old Image, and the device status are displayed.
 
     [bookmark: pgfId-921167]Step 5 Examine the Commentary on the devices in the job by clicking on the vertical Commentary tab on the far right. This shows the progress of the image install operation on the device.
 
     [bookmark: pgfId-921169]Step 6 Examine the Transcript of the devices in the job by clicking on the vertical Transcript tab on the far right. This shows the chronology of the commands executed on the device and their responses.
 
     [bookmark: pgfId-921171]Step 7 Examine job history details by clicking History in the lower pane. This shows the history of the transition in the job state.
 
      
       
     
 
     
 
     [bookmark: pgfId-921173]Note This information is visible only in the workflow mode.

     
      

     

     
 
     [bookmark: pgfId-921175]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-921183][bookmark: 169915][bookmark: immgt_proc_AbortJob]Aborting an Image Installation Job[bookmark: marker-921181]
 
     [bookmark: pgfId-921185]You can abort an image installation job by clicking Abort from the Jobs page. This option is effective only for multi-device jobs:
 
      
       
     
 
     
 
     [bookmark: pgfId-921187]Note If the job involves a single device, then Abort will have no effect after the job begins and the job will always run to completion.

     
      

     

     
 
      
      	 [bookmark: pgfId-921189]If the Sequential option is selected, then all the devices on which the job has not yet started will be aborted.
 
      	 [bookmark: pgfId-921191]If Parallel is selected, then all the devices till that batch will undergo image upgrade. All devices from the next batch onwards will be aborted.
 
     
 
    
 
     
      [bookmark: pgfId-921199][bookmark: 169929][bookmark: immgt_proc_RetryFailedJob]Retry a Failed Image Install Job[bookmark: marker-921197]
 
     [bookmark: pgfId-921201]If your attempts to deploy an image to one or more devices fails, you can retry the job. However, you should retry the entire job and not attempt to simply continue from a failed step.
 
     [bookmark: pgfId-921203]To retry a failed job, do the following:
 
     
 
     [bookmark: pgfId-921205]Step 1 To determine that an installation job has failed, go to the Jobs section in the selector and click Install Jobs.
 
     [bookmark: pgfId-921207]The Jobs page appears.
 
     [bookmark: pgfId-921209]Step 2 Determine the status of the job in question by examining the Status column.
 
      
       
     
 
     
 
     [bookmark: pgfId-921211]Tip A green check icon with the word Deployed indicates success. A red X icon indicates failure.

     
      

     

     
 
     [bookmark: pgfId-921213]Step 3 Investigate possible reasons for job failure.
 
     [bookmark: pgfId-921215]Step 4 Select the failed image install job from the job list and click Retry from the toolbar atop the upper pane.
 
     [bookmark: pgfId-921217]The Install Images on Devices window appears. You can observe the validation warnings as you would in a normal install job.
 
     [bookmark: pgfId-921219]Step 5 As required, you can change the images, devices, schedule, or job properties to be used.
 
     [bookmark: pgfId-921221]Step 6 From within the Install Images on Devices window click Install.
 
     [bookmark: pgfId-921223]Step 7 Determine that the retried attempt is successful by observing the newly created job.
 
     [bookmark: pgfId-921225]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-921233][bookmark: 169961][bookmark: immgt_proc_RollbackJob]Roll Back a Deployed Job[bookmark: marker-921231]
 
     [bookmark: pgfId-921235]You can roll back the changes from a deployed image installation job.
 
     [bookmark: pgfId-921237]To roll back a Deployed job, do the following:
 
     
 
     [bookmark: pgfId-921239]Step 1 From the job list, select the image install job to be rolled back and click Rollback from the toolbar atop the upper pane.
 
     [bookmark: pgfId-921241]The Install Images on Devices window appears. You can observe the validation warnings as you would in a normal install job.
 
     [bookmark: pgfId-921243]Step 2 As required, you can change the images, devices, schedule, or job properties to be used in the rollback.
 
     [bookmark: pgfId-921245]Step 3 From within the Install Images on Devices window click Install.
 
     [bookmark: pgfId-921247]Step 4 Determine that the rollback attempt is successful by monitoring the newly created job.
 
     [bookmark: pgfId-921249]

     
      

     

     
 
    
 
     
      [bookmark: pgfId-921257][bookmark: 169983][bookmark: immgt_proc_JobApprovalWorkflow]Image Installation Job Approval Workflow[bookmark: marker-921255]
 
     [bookmark: pgfId-921259]Image update is a critical operation that has the potential to cause downtime for devices and your network. Hence, change control and management for image install operations is crucial. Change management for image installation jobs is done using the Deployment Workflow framework of Configuration Manager. This ensures that all image installation jobs need to be approved before getting executed or deployed.
 
     [bookmark: pgfId-921261]To use workflow with image installation jobs, do the following:
 
     
 
     [bookmark: pgfId-921263]Step 1 Enable workflow for image installation jobs:
 
     [bookmark: pgfId-921265] a. In Configuration Manager, select Tools > Security Manager Administration > Workflow.
 
     [bookmark: pgfId-921267] b. If workflow is not already enabled, select Enable Workflow.
 
     [bookmark: pgfId-921269] c. Select Require Deployment & Install Image Approval.
 
     [bookmark: pgfId-921274] d. Configure the email address of the person responsible for approving the image installation job in the Job/Schedule Approver field. For more information, see Workflow Page.
 
     [bookmark: pgfId-921276] e. Click Save and then Close.
 
     [bookmark: pgfId-921278] f. Launch Image Manager and navigate to Install Jobs. Notice the new buttons available in the Menu bar for job state transitions in workflow mode: Submit, Approve, Reject, and Deploy.
 
     [bookmark: pgfId-921280]Step 2 To create and execute an image installation job with workflow enabled:
 
     [bookmark: pgfId-921285] a. Use any of the previously documented procedures to create an image installation job. See About Image Updates on Devices Using Image Manager.
 
      
       
     
 
     
 
     [bookmark: pgfId-921287]Note There is an additional option in the Properties tab to Submit the Job. Check this option to automatically submit the job for approval after creation of the job.

     
      

     

     
 
     [bookmark: pgfId-921289] b. Once the image installation job is created, note the state of the job in the Image Install Jobs View.
 
     [bookmark: pgfId-921291] c. Select the job and click Submit to submit the job for approval if automatic submit option was not selected while creating the job.
 
     [bookmark: pgfId-921293]The job Approver (user with Approver role/privileges) receives an email notification to approve the job.
 
     [bookmark: pgfId-921295] d. The Approver can log in to Security Manager, launch Image Manager, and navigate to the job.
 
     [bookmark: pgfId-921297] e. The Approver clicks Approve to approve the job after reviewing the details of the upgrade, that is, image being upgraded to, job properties, schedule, and so on.
 
     [bookmark: pgfId-921299]Job state is changed to Approved. The creator of the job receives an email that the job has been approved. Now the job can be deployed.
 
     [bookmark: pgfId-921301] f. If the Approver is not convinced after reviewing the job details, he can choose to reject the job by clicking Reject.
 
     [bookmark: pgfId-921303]The job state is moved to Rejected. The creator of the job receives an email that job has been rejected. A rejected job will not be deployed.
 
      
       
     
 
     
 
     [bookmark: pgfId-921305]Note A rejected job will not be deployed. It can be edited and resubmitted for approval or it has to be discarded.

     
      

     

     
 
     [bookmark: pgfId-921307] g. Once the job is approved, the job can be deployed by clicking Deploy.
 
     [bookmark: pgfId-921309]The job state is changed to Deploying and image install job execution is started.
 
     [bookmark: pgfId-921311] h. If the job is rejected or any other changes are required to be made for a job, the job can be edited by clicking Edit.
 
     [bookmark: pgfId-921313]The Image Assignments page of the wizard showing all the devices and images is displayed. The user can modify the Job Properties, schedule and even delete some device-to-image assignments and submit the job for approval again by clicking Submit.
 
     [bookmark: pgfId-921315] i. If a job has not started executing, then the user can dismiss the job by clicking Discard.
 
     [bookmark: pgfId-921317]The job is moved to Discarded state. A discarded job does not execute and cannot be edited or moved to any other state.
 
     [bookmark: pgfId-921319] j. If the changed job is acceptable to the approver, he can approve the job this time and the job can be deployed as mentioned above.
 
     [bookmark: pgfId-921321] k. Once the deploying job completes execution it will be moved to Deployed state if the image installation is successful or it will be moved to Failed state if the image installation operation fails.
 
     [bookmark: pgfId-921323]

     
      

     

     
 
    
 
   
 
    
     [bookmark: pgfId-921331][bookmark: 170069][bookmark: immgt_cncpt_troubleshooting]Troubleshooting Image Management[bookmark: marker-921329]
 
    [bookmark: pgfId-921333]This section addresses steps you can take to troubleshoot Image Management in response to particular symptoms.
 
    [bookmark: pgfId-921335]No data for devices in Image Manager, after Security Manager upgrade. Any one of the following operations that first contacts the device will collect the image inventory for the device:
 
     
     	 [bookmark: pgfId-921337]Rediscover the device choosing to discover only Device Inventory
 
     	 [bookmark: pgfId-921339]Perform a live deployment to device
 
     	 [bookmark: pgfId-921341]Perform an Image Install operation to the device
 
    
 
    [bookmark: pgfId-921343]Image Download from Cisco.com Fails
 
     
     	 [bookmark: pgfId-921345]Go to Configuration Manager > Tools > Security Manager Administration.
 
     	 [bookmark: pgfId-921347]Select Image Manager.
 
     	 [bookmark: pgfId-921349]Click  Test Connection to ensure the server is reachable.
 
     	 [bookmark: pgfId-921351]Check  %NMSROOT%/MDC/athena/config/****-CCOMetaData.xml for error in downloading metadata information for particular MDF IDs.
 
    
 
    [bookmark: pgfId-921353]Update or Image Download fails due to certificate mismatch, unavailability, expiration, or other cause.
 
     
     	 [bookmark: pgfId-921355]Employ the recommended actions cited by the error message. Use the failed download URL from the error message to retrieve the certificate.
 
     	 [bookmark: pgfId-921357]View the stored certificate at  %NMSROOT%/MDC/certificates/*.ser (Serialized object--file contents are unintelligible and cannot be viewed in any editor.)
 
    
 
    [bookmark: pgfId-921359]Image Download from Cisco.com Fails with Message: "User not authorized to download file"
 
     
     	 [bookmark: pgfId-921361]Go to Configuration Manager > Tools > Security Manager Administration.
 
     	 [bookmark: pgfId-921363]Select Image Manager.
 
     	 [bookmark: pgfId-921365]Click  Test Connection to ensure the server is reachable.
 
     	 [bookmark: pgfId-921367]Register your acceptance of the Cisco Encryption Software Usage Handling and Distribution Policy.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-921371]Tip The policy is found at: http://tools.cisco.com/legal/k9/controller/do/k9Check.x?eind=Y.

    
     

    

    
 
    [bookmark: pgfId-921373]Image Download from Cisco.com is Slow
 
     
     	 [bookmark: pgfId-921375]Ensure proxy is configured
 
     	 [bookmark: pgfId-921377]Trace route from Security Manger to Cisco.com
 
    
 
    [bookmark: pgfId-921379]Check for Updates Fails
 
    [bookmark: pgfId-921381]Go to the Security Manager administrative settings page and test connectivity to Cisco.com. Check %NMSROOT%/MDC/athena/config/****-CCOMetaData.xml for an error in downloading metadata information for particular MDF IDs.
 
    [bookmark: pgfId-921383]Message: "User not authorized to download file." Go to the Security Manager administrative settings page and test connectivity to Cisco.com. Accept the crypto agreement at http://tools.cisco.com/legal/k9/controller/do/k9Check.x?eind=Y
 
    [bookmark: pgfId-921385]Image Download from External File System or Network Fileshare Fails
 
     
     	 [bookmark: pgfId-921387]Check that you have proper permissions/credentials for the external file system or fileshare.
 
     	 [bookmark: pgfId-921389]Open the fileshare on the client, drag the image and drop it on Image Manager.
 
    
 
    [bookmark: pgfId-921391]Image Install Wizard does not Show Compatible Images
 
     
     	 [bookmark: pgfId-921393]Image Manager uses the information on Cisco.com to determine the compatibility of the images for the MDF IDs. Please download the latest images available on cisco.com by performing ’Check for Updates’. If the image is available on Cisco.com and listed as compatible for the platform, you should now be able to view these images for the device in the Image Install Wizard and also in the Compatible Images tab for the device.
 
     	 [bookmark: pgfId-921395]Even the Compatible Images tab for the device may not show some images that are actually compatible to the device.
 
     	 [bookmark: pgfId-921397]If you still don’t see the images in the Install Wizard, either because you do not have Cisco.com connectivity or images are not updated on Cisco.com for that platform, you can use the drag and drop procedure to install the images on the device. You would be warned that the image is not compatible, but you can still go ahead and install the image by dragging the image and dropping it on to the device and creating a job.
 
    
 
    [bookmark: pgfId-921399]Image Copy Failure –"HTTP 413 Error"
 
     
     	 [bookmark: pgfId-921401]Right-click  Device in Image Manager > Test File Copy To Device
 
     	 [bookmark: pgfId-921403]Check Error Message in vmssharedsvcs.log
 
     	 [bookmark: pgfId-921405]If you encounter an HTTP 413 error, split the job to contain a smaller number of images in one job
 
    
 
    [bookmark: pgfId-921407]Image Copy Failure –"Not enough space on disk"
 
     
     	 [bookmark: pgfId-921409]Check Device > Storage View for files on device and free space in the Image Install Location.
 
     	 [bookmark: pgfId-921411]If Device > Storage View shows files, then delete files from Storage to make space and retry.
 
     	 [bookmark: pgfId-921413]If Device > Storage View does not show files, either because it is a greenfield device or it is a Security Manager upgrade setup, rediscover only the device inventory on the device and then delete files from Storage view to make space.
 
    
 
    [bookmark: pgfId-921415]Image Install Job failure –Error: "Invalid flash device"
 
     
     	 [bookmark: pgfId-921417]Check if flash exists on the device:
 
    
 
    [bookmark: pgfId-921419] – Right-click on device in IM > Test File Copy to Device
 
    [bookmark: pgfId-921421] – Connect to device, and check whether it is a multiple-context device that is being managed as a single context device in Security Manager
 
    [bookmark: pgfId-921423] – Rediscover the device selecting to discover System Context. Then, retry the image install job.
 
    [bookmark: pgfId-921425]Image Upgrade Job on Active/Standby pair fails
 
     
     	 [bookmark: pgfId-921427]Error:  "This host is not the ’active’ device in the failover pair" - Ensure that the failover pair is managed in Security Manager via the IP address of the active device in the failover pair and not the IP address of the standby device.
 
     	 [bookmark: pgfId-921429]Error:  "Secondary device is not in standby-ready state" - Ensure that the devices in the failover pair are up and the standby device is in standby-ready state. Job will abort if standby device is in failed state
 
    
 
    [bookmark: pgfId-921431]Image Install Job failure –Error: "SWIM1114: Device could not be reached after upgrade"
 
     
     	 [bookmark: pgfId-921433]Manually check if device is reachable. Solution: After image upgrade, device has to be re-added in Security Manager or change the Admin option to "Do not check certificate authentication"
 
     	 [bookmark: pgfId-921435]Check whether Tools > Admin > Device Communication > SSL Certificate Parameters > PIX/ASA/FWSM Device Authentication Certificates is set to "Retrieve while adding devices."
 
     	 [bookmark: pgfId-921437]After image upgrade, ensure the device has been re-added in Security Manager. Otherwise, change the Admin option to "Do not check certificate authentication."
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     [bookmark: pgfId-98821][bookmark: 76999][bookmark: ravpnch_cncpt_ManagingRemoteAccessVPNsASAPIX70]Managing Remote Access VPNs on ASA and PIX 7.0+ Devices[bookmark: marker-98815][bookmark: marker-98817][bookmark: marker-98819]
      
      
 
     
 

 
    [bookmark: pgfId-98823]You can configure and manage remote access IPsec on devices running Cisco ASA Software or PIX 7.0+, and SSL VPNs on ASA 8.0+ devices (but not on PIX devices). Additionally, you can use IKE version 2 (IKEv2) negotiations in remote access IPsec VPNs on ASA 8.4(x) devices.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-98825]Tip No VPN configuration is supported on Cisco Catalyst 6500 Series ASA Service Modules and the ASA Software Release 8.5(x) used on the module.


    
     

    

    

 
    [bookmark: pgfId-98830]The configuration of these remote access VPNs are the same for these device types. IOS and PIX 6.3+ devices use different configurations for remote access VPNs (as explained in Chapter 33, “Managing Remote Access VPNs on IOS and PIX 6.3 Devices”).

 
    [bookmark: pgfId-98832]The topics in this chapter explain how to configure policies that are specific to ASA and PIX 7.0+ devices. Additionally, review the following topics for more information about remote access VPNs:

 
     
     		 [bookmark: pgfId-98837]Understanding Remote Access VPNs

 
     		 [bookmark: pgfId-98842]Understanding Devices Supported by Each Remote Access VPN Technology

 
     		 [bookmark: pgfId-98847]Discovering Remote Access VPN Policies

 
     		 [bookmark: pgfId-98852]Using the Remote Access VPN Configuration Wizard

 
    

 
    [bookmark: pgfId-98857] – Creating IPSec VPNs Using the Remote Access VPN Configuration Wizard (ASA and PIX 7.0+ Devices)

 
    [bookmark: pgfId-98862] – Creating SSL VPNs Using the Remote Access VPN Configuration Wizard (ASA Devices)

 
     
     		 [bookmark: pgfId-98867]Chapter 32, “Managing Dynamic Access Policies for Remote Access VPNs (ASA 8.0+ Devices)”

 
    

 
    [bookmark: pgfId-98869]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-98874]Overview of Remote Access VPN Policies for ASA and PIX 7.0+ Devices

 
     		 [bookmark: pgfId-98879]Understanding Cluster Load Balancing (ASA)

 
     		 [bookmark: pgfId-98884]Configuring Connection Profiles (ASA, PIX 7.0+)

 
     		 [bookmark: pgfId-98889]Configuring Group Policies for Remote Access VPNs

 
     		 [bookmark: pgfId-98894]Understanding SSL VPN Server Verification (ASA)

 
     		 [bookmark: pgfId-98899]Add/Edit Scripts Dialog Box

 
     		 [bookmark: pgfId-98904]Working with IPSec VPN Policies

 
     		 [bookmark: pgfId-98909]Working with SSL and IKEv2 IPSec VPN Policies

 
     		 [bookmark: pgfId-98914]Customizing Clientless SSL VPN Portals

 
    

 
   
 
    
     [bookmark: pgfId-98926][bookmark: 77040][bookmark: ravpnch_cncpt_OverviewofRemoteAccessVPNPoliciesforASAandPIX70Devices]Overview of Remote Access VPN Policies for ASA and PIX 7.0+ Devices[bookmark: marker-98920][bookmark: marker-98922][bookmark: marker-98924]

 
    [bookmark: pgfId-98931]When you configure remote access VPNs on ASA or PIX 7.0+ devices, you use the following policies based on the type of VPN you are configuring. Possible remote access VPN types are: IKE version 1 (IKEv1) IPsec, IKE version 2 (IKEv2) IPsec, and SSL. IKEv2 is supported on ASA devices running the software version 8.4(x) and higher. Table 31-1 explains the conditions under which these policies are required or optional.
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    [bookmark: pgfId-98933]Note You cannot configure SSL VPNs on PIX devices; PIX devices support remote access IKEv1 IPsec VPNs only.


    
     

    

    

 
     
     		 [bookmark: pgfId-98935] Policies used with remote access IKEv1 and IKEv2 IPsec and SSL VPNs: 

 
    

 
    [bookmark: pgfId-98940] – ASA Cluster Load Balancing—In a remote client configuration in which you are using two or more devices connected to the same network to handle remote sessions, you can configure these devices to share their session load. This feature is called load balancing. Load balancing directs session traffic to the least loaded device, thus distributing the load among all devices. Load balancing is effective only on remote sessions initiated with an ASA device. For more information, see Understanding Cluster Load Balancing (ASA).

 
    [bookmark: pgfId-98945] – Connection Profiles—A connection profile is a set of records that contain VPN tunnel connection policies, including the attributes that pertain to creating the tunnel itself. Connection profiles identify the group policies for a specific connection, which includes user-oriented attributes. For more information, see Configuring Connection Profiles (ASA, PIX 7.0+).

 
    [bookmark: pgfId-98950] – Dynamic Access—Multiple variables can affect each VPN connection, for example, intranet configurations that frequently change, the various roles that each user might inhabit within an organization, and logins from remote access sites with different configurations and levels of security. Dynamic access policies (DAP) let you configure authorization that addresses these many variables. You create a dynamic access policy by setting a collection of access control attributes that you associate with a specific user tunnel or session. For more information, see Chapter 32, “Managing Dynamic Access Policies for Remote Access VPNs (ASA 8.0+ Devices)”.

 
    [bookmark: pgfId-98955] – Global Settings—You can define global settings that apply to all devices in your remote access VPNs. These settings include Internet Key Exchange (IKE), IKEv2, IPsec, NAT, and fragmentation definitions. The global settings typically have defaults that work in most situations, so configuring the Global Settings policy is optional in most cases; configure it only if you need non-default behavior or if you are supporting IKEv2 negotiations. For more information, see Configuring VPN Global Settings.

 
    [bookmark: pgfId-98960] – Group Policies—You can view the user group policies defined for your remote access VPN connection profiles. From this page, you can specify new ASA user groups and edit existing ones. When you create a connection profile, if you specify a group policy that has not been used on the device, the group policy is automatically added to the Group Policies page; you do not need to add it to this policy before you create the connection profile. For more information, see Configuring Group Policies for Remote Access VPNs.

 
    [bookmark: pgfId-98968] – Public Key Infrastructure—You can create a Public Key Infrastructure (PKI) policy to generate enrollment requests for CA certificates and RSA keys, and to manage keys and certificates. Certification Authority (CA) servers are used to manage these certificate requests and issue certificates to users who connect to your IPsec or SSL remote access VPN. For more information, see Understanding Public Key Infrastructure Policies and Configuring Public Key Infrastructure Policies for Remote Access VPNs.

 
    [bookmark: pgfId-98973] – Username from Cert Scripts—You can use this policy to define a script to use in mapping the username from the certificate. For more information, see Add/Edit Scripts Dialog Box.

 
     
     		 [bookmark: pgfId-98975] Policies used in remote access IPsec VPNs only: 

 
    

 
    [bookmark: pgfId-98980] – Certificate To Connection Profile Maps, Policy and Rules (IKEv1 IPSec only.)—Certificate to connection profile map policies let you define rules to match a user’s certificate to a permission group based on specified fields. To establish authentication, you can use any field of the certificate, or you can have all certificate users share a permission group. You can match the group from the DN rules, the Organization Unit (OU) field, the IKE identity, or the peer IP address. You can use any or all of these methods. For more information, see Configuring Certificate to Connection Profile Map Policies (ASA).

 
    [bookmark: pgfId-98985] – IKE Proposal—Internet Key Exchange (IKE), also called ISAKMP, is the negotiation protocol that enables two hosts to agree on how to build an IPsec security association. IKE is used to authenticate IPsec peers, negotiate and distribute IPsec encryption keys, and to automatically establish IPsec security associations (SAs). Use the IKE Proposal policy to define the requirements for phase 1 of the IKE negotiation. For more information, see Configuring an IKE Proposal.

 
    [bookmark: pgfId-98990] – IPsec Proposal (ASA/PIX 7.x)—An IPsec proposal is a collection of one or more crypto maps. A crypto map combines all the components required to set up IPsec security associations (SAs), including IPsec rules, transform sets, remote peers, and other parameters that might be necessary to define an IPsec SA. The policy is used for IKE phase 2 negotiations. For more information, see Configuring an IPsec Proposal on a Remote Access VPN Server (ASA, PIX 7.0+ Devices).

 
     
     		 [bookmark: pgfId-98992] Policies used in remote access IKEv2 IPSec and SSL VPNs only: 

 
    

 
    [bookmark: pgfId-98997] – Access—An Access policy specifies the security appliance interfaces on which a remote access SSL or IKEv2 IPsec VPN connection profile can be enabled, the port to be used for the connection profile, Datagram Transport Layer Security (DTLS) settings, the SSL VPN session timeout and maximum number of sessions. You can also specify whether to use the AnyConnect VPN Client or AnyConnect Essentials Client. For more information, see Understanding SSL VPN Access Policies (ASA).

 
    [bookmark: pgfId-99002] – Other Settings—The SSL VPN Other Settings policy defines settings that include caching, content rewriting, character encoding, proxy and proxy bypass definitions, browser plug-ins, AnyConnect client images and profiles, Kerberos Constrained Delegation, and some other advanced settings. For more information, see Configuring Other SSL VPN Settings (ASA).

 
    [bookmark: pgfId-99007] – Shared License—Use the SSL VPN Shared License page to configure your SSL VPN Shared License. For more information, see Configuring SSL VPN Shared Licenses (ASA 8.2+).

 
     
      
       
       [bookmark: pgfId-95780]Table 31-1 [bookmark: 77126]Remote Access VPN Policy Requirements for ASA Devices 

 
       
      
        
        		
          
          [bookmark: pgfId-95786]Policy
         
  
        		
          
          [bookmark: pgfId-95788]Required, Optional
         
  
       

 
        
        		[bookmark: pgfId-95794]ASA Cluster Load Balancing

  
        		[bookmark: pgfId-95796]Optional for all VPN types.

  
       

 
        
        		[bookmark: pgfId-95802]Connection Profiles

  
        		[bookmark: pgfId-95804]Required for all VPN types.

  
       

 
        
        		[bookmark: pgfId-95810]Dynamic Access

  
        		[bookmark: pgfId-95812]Optional for all VPN types.

  
       

 
        
        		[bookmark: pgfId-95818]Global Settings

  
        		[bookmark: pgfId-95820]Required: IKEv2 IPsec.

 [bookmark: pgfId-95822]Optional: IKEv1 IPsec, SSL.

  
       

 
        
        		[bookmark: pgfId-95828]Group Policies

  
        		[bookmark: pgfId-95830]Required for all VPN types.

  
       

 
        
        		[bookmark: pgfId-95836]Public Key Infrastructure

  
        		[bookmark: pgfId-95838]Required: IKEv2 IPsec.

 [bookmark: pgfId-95840]Also required if you configure any trustpoints for IKEv1 IPsec or SSL VPNs. Otherwise, it is optional.

  
       

 
        
        		[bookmark: pgfId-95846]Certificate To Connection Profile Maps, Policy and Rules

  
        		[bookmark: pgfId-95848]Optional: IKEv1 IPsec.

 [bookmark: pgfId-95850]Not used in: IKEv2 IPsec, SSL.

  
       

 
        
        		[bookmark: pgfId-95856]IKE Proposal

  
        		[bookmark: pgfId-95858]Required: IKEv1 IPsec, IKEv2 IPsec.

 [bookmark: pgfId-95860]Not used in: SSL.

  
       

 
        
        		[bookmark: pgfId-95866]IPsec Proposal (ASA/PIX 7.x)

  
        		[bookmark: pgfId-95868]Required: IKEv1 IPsec, IKEv2 IPsec.

 [bookmark: pgfId-95870]Not used in: SSL.

  
       

 
        
        		[bookmark: pgfId-95876]Access

  
        		[bookmark: pgfId-95878]Required: IKEv2 IPsec, SSL.

 [bookmark: pgfId-95880]Not used in: IKEv1 IPsec.

  
       

 
        
        		[bookmark: pgfId-95886]Other Settings

  
        		[bookmark: pgfId-95888]Required: IKEv2 IPsec, SSL.

 [bookmark: pgfId-95890]Not used in: IKEv1 IPsec.

  
       

 
        
        		[bookmark: pgfId-95896]Shared License

  
        		[bookmark: pgfId-95898]Optional: IKEv2 IPsec, SSL.

 [bookmark: pgfId-95900]Not used in: IKEv1 IPsec.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-99034][bookmark: 77224][bookmark: ravpnch_cncpt_ClusterLoadBalancing]Understanding Cluster Load Balancing (ASA)[bookmark: marker-99018][bookmark: marker-99020][bookmark: marker-99022][bookmark: marker-99024][bookmark: marker-99026][bookmark: marker-99028][bookmark: marker-99030][bookmark: marker-99032]

 
    [bookmark: pgfId-99036]In a remote client configuration in which you are using two or more devices connected to the same network to handle remote sessions, you can configure these devices to share their session load. This feature is called load balancing. Load balancing directs session traffic to the least loaded device, thus distributing the load among all devices. Load balancing is effective only on remote sessions initiated with an ASA device.

 
    [bookmark: pgfId-99038]To implement load balancing, you must group two or more devices on the same private LAN-to-LAN network into a virtual cluster. All devices in the virtual cluster carry session loads. One device in the virtual cluster, called the virtual cluster master, directs incoming calls to the other devices, called secondary devices. The virtual cluster master monitors all devices in the cluster, keeps track of how busy each is, and distributes the session load accordingly.

 
    [bookmark: pgfId-99040]The virtual cluster appears to outside clients as a single virtual cluster IP address. This IP address is not tied to a specific physical device—it belongs to the current virtual cluster master. A VPN client trying to establish a connection connects first to this virtual cluster IP address. The virtual cluster master then sends back to the client the public IP address of the least-loaded available host in the cluster. In a second transaction (transparent to the user), the client connects directly to that host. In this way, the virtual cluster master directs traffic evenly and efficiently across resources.

 
    [bookmark: pgfId-99042]The role of virtual cluster master is not tied to a physical device—it can shift among devices. If a machine in the cluster fails, the terminated sessions can immediately reconnect to the virtual cluster IP address. The virtual cluster master then directs these connections to another active device in the cluster. Should the virtual cluster master itself fail, a secondary device in the cluster immediately takes over as the new virtual session master. Even if several devices in the cluster fail, users can continue to connect to the cluster as long as any one device in the cluster is available.

 
    [bookmark: pgfId-99046]Understanding Redirection Using a Fully Qualified Domain Name (FQDN)[bookmark: marker-99044]

 
    [bookmark: pgfId-99048]By default, the ASA sends only IP addresses in load-balancing redirection to a client. If certificates are in use that are based on DNS names, the certificates will be invalid when redirected to a secondary device. As a VPN cluster master, this security appliance can send a fully qualified domain name (FQDN) of a cluster device (another security appliance in the cluster) when redirecting VPN client connections to that cluster device. The security appliance uses reverse DNS lookup to resolve the FQDN of the device to its outside IP address to redirect connections and perform VPN load balancing. All outside and inside network interfaces on the load-balancing devices in a cluster must be on the same IP network.

 
    [bookmark: pgfId-99050]After you enable load balancing using FQDNs, add an entry for each of your ASA outside interfaces into your DNS server, if such entries are not already present. Each ASA outside IP address should have a DNS entry associated with it for lookups. These DNS entries must also be enabled for Reverse Lookup. Enable DNS lookups on your ASA and define your DNS server IP address on the ASA.

 
    [bookmark: pgfId-99055]For the procedure to configure cluster load balancing, see Configuring Cluster Load Balance Policies (ASA).

 
     
      [bookmark: pgfId-99081][bookmark: 77270][bookmark: ravpnch_proc_ConfiguringaClusterLoadBalancePolicy]Configuring Cluster Load Balance Policies (ASA)[bookmark: marker-99063][bookmark: marker-99065][bookmark: marker-99067][bookmark: marker-99069][bookmark: marker-99071][bookmark: marker-99073][bookmark: marker-99075][bookmark: marker-99077][bookmark: marker-99079]

 
     [bookmark: pgfId-99086]Use the ASA Cluster Load Balance page to enable load balancing for an ASA device in your remote access VPN. You must explicitly enable load balancing, as it is disabled by default. All devices that participate in a cluster must share the same cluster-specific values: IP address, encryption settings, encryption key, and port. For more information on cluster load balancing, see Understanding Cluster Load Balancing (ASA).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-99088]Note Load balancing requires an active 3DES/AES license and an ASA Model 5510 with a Plus license or an ASA Model 5520 or higher. The ASA device checks for the existence of this crypto license before enabling load balancing. If it does not detect an active 3DES or AES license, the device prevents load balancing, and also prevents internal configuration of 3DES by the load balancing system unless the license permits this usage.


     
      

     

     

 
     
 
     [bookmark: pgfId-99090]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-99092](Device View) Select an ASA device; then select  Remote Access VPN > ASA Cluster Load Balance from the Policy selector.

 
      		 [bookmark: pgfId-99094](Policy View) Select  Remote Access VPN > ASA Cluster Load Balance from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-99096]The ASA Cluster Load Balance page opens.

 
     [bookmark: pgfId-99098]Step 2 Select Participate in Load Balancing Cluster to indicate that the device belongs to a load-balancing cluster.

 
     [bookmark: pgfId-99100]Step 3 Configure the VPN Cluster Configuration options:

 
      
      		 [bookmark: pgfId-99102] Cluster IP Address —Specify the single IP address that represents the entire virtual cluster. Choose an IP address that is in the same subnet as the external interface.

 
      		 [bookmark: pgfId-99104] UDP Port —Specify the UDP destination port for the virtual cluster to which the device belongs. The port is typically 9023, but if that port is in use by another application, enter the UDP destination port number that you want to use for load balancing.

 
      		 [bookmark: pgfId-99106] Enable IPSec Encryption ,  IPSec Shared Secret —If required, select  Enable IPsec Encryption to ensure that all load-balancing information communicated between the devices is encrypted. If you select this option, also enter (and confirm) the shared secret password. This can be a case-sensitive value between 4 and 16 characters, without spaces. The security appliances in the virtual cluster communicate through LAN-to-LAN tunnels using IPsec. This password must match the passwords passed on by the client.

 
     

 
     [bookmark: pgfId-99108]Step 4 Configure the priority of the server in the cluster. Select one of the following options:

 
      
      		 [bookmark: pgfId-99110] Accept default device value —To accept the default priority value assigned to the device.

 
      		 [bookmark: pgfId-99112] Configure same priority on all devices in the cluster —To configure the same priority value to all the devices in the cluster. Then enter the priority number (1-10) to indicate the likelihood of the device becoming the virtual cluster master, either at startup or when the existing master fails.

 
     

 
     [bookmark: pgfId-99114]Step 5 Specify the public and private interfaces to be used on the server:

 
      
      		 [bookmark: pgfId-99116] Public Interfaces —The public interfaces to be used on the server. Enter the name of an interface or interface role object, or click  Select to select the interface or role or to create a new role.

 
      		 [bookmark: pgfId-99118] Private Interfaces —The private interfaces to be used on the server. Enter the name of an interface or interface role object, or click  Select to select the interface or role or to create a new role.

 
     

 
     [bookmark: pgfId-99123]Step 6 If required, select Send FQDN to client instead of an IP address when redirecting to enable redirection using fully-qualified domain names. This option is available only for ASA devices running 8.0(2) or later. For more information, see Understanding Cluster Load Balancing (ASA).

 
     [bookmark: pgfId-99125]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-99147][bookmark: 77366][bookmark: ravpnch_proc_ConfiguringConnectionProfilesASA]Configuring Connection Profiles (ASA, PIX 7.0+) [bookmark: marker-99131][bookmark: marker-99133][bookmark: marker-99135][bookmark: marker-99137][bookmark: marker-99139][bookmark: marker-99141][bookmark: marker-99143][bookmark: marker-99145]

 
    [bookmark: pgfId-99149]A connection profile is a set of records that contain VPN tunnel connection policies, including the attributes that pertain to creating the tunnel itself. Connection profiles identify the group policies for a specific connection, which includes user-oriented attributes. If you do not assign a group policy to a user, the default connection profile for the connection applies. You can create one or more connection profiles specific to your environment. You can configure connection profiles on the local remote access VPN server or on external AAA servers.

 
    [bookmark: pgfId-99151]When you discover remote access VPN policies on a device, Security Manager adds the default connection profiles to the policy. You can edit these profiles, and the associated DlftGrpPolicy (renamed in Security Manager as <device_display_name>DfltGrpPolicy), but you cannot delete them. The following default connection profiles are supported in Security Manager:

 
     
     		 [bookmark: pgfId-99153]DefaultRAGroup—The default connection profile for remote access IPsec VPNs.

 
     		 [bookmark: pgfId-99155]DefaultWEBVPNGroup—The default connection profile for SSL VPNs. This connection profile is discovered only for ASA 8.0+ devices.

 
    

 
    [bookmark: pgfId-99157]If you are configuring a connection profile on an ASA device, you have the option of configuring double authentication. The double authentication feature implements two-factor authentication for remote access to the network, in accordance with the Payment Card Industry Standards Council Data Security Standard. This feature requires that the user enter two separate sets of login credentials at the login page. For example, the primary authentication might be a one-time password, and the secondary authentication might be a domain (Active Directory) credential. If the primary credential authentication fails, the security appliance does not attempt to validate the secondary credentials. If either authentication fails, the connection is denied. Both the AnyConnect VPN client (SSL VPN or IKEv2 IPSec VPN) and Clientless SSL VPN support double authentication. The AnyConnect client supports double authentication on Windows computers (including supported Windows Mobile devices and Start Before Login), Mac computers, and Linux computers.

 
    [bookmark: pgfId-99159]This procedure describes how to create or edit connection profiles on your remote access VPN server using the Connection Profile policy.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-99167]Note You can also create connection profiles from the Remote Access VPN Configuration wizard; see Using the Remote Access VPN Configuration Wizard. For information on connection profiles in Easy VPN site-to-site topologies, see Configuring a Connection Profile Policy for Easy VPN.


    
     

    

    

 
    [bookmark: pgfId-99169]Related Topics

 
     
     		 [bookmark: pgfId-99174]Discovering Remote Access VPN Policies

 
    

 
    
 
    [bookmark: pgfId-99176]Step 1 Do one of the following:

 
     
     		 [bookmark: pgfId-99178](Device view) With an ASA or PIX 7.0+ device selected, select  Remote Access VPN > Connection Profiles from the Policy selector.

 
     		 [bookmark: pgfId-99180](Policy view) Select  Remote Access VPN > Connection Profiles (ASA) from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-99185]The Connection Profiles page opens. The policy lists all connection profiles and shows the group policy used in the profile. For more information, see Connection Profiles Page.

 
    [bookmark: pgfId-99187]Step 2 Click Add Row (+) beneath the table, or select a profile and click Edit Row (pencil). The Connection Profiles dialog box opens.

 
    [bookmark: pgfId-99192]Step 3 (All remote access VPN types.) On the General tab, specify the connection profile name and group policies and select which method (or methods) of address assignment to use. For a detailed explanation of the configuration, see General Tab (Connection Profiles).

 
    [bookmark: pgfId-99197]Step 4 (All remote access VPN types.) Click the AAA tab to specify the AAA authentication parameters for the connection profile. For a detailed explanation of the configuration, see AAA Tab (Connection Profiles).

 
    [bookmark: pgfId-99202]Step 5 (Remote access IKEv2 IPsec and SSL VPN only.) If you are setting up a connection profile on an ASA device, you can configure secondary authentication. To do so, click the Secondary AAA tab. For a detailed explanation of the configuration, see Secondary AAA Tab (Connection Profiles).

 
    [bookmark: pgfId-99207]Step 6 (Remote access IPsec VPN only.) Click the IPsec tab to specify IPsec and IKE parameters for the connection profile. Some of these settings apply to IKEv1 but not to IKEv2 connections. For a detailed explanation of the configuration, see IPSec Tab (Connection Profiles).

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-99212]Note To configure IKEv2 settings, use the IKEv2 Settings tab of the Global Settings policy; see Configuring VPN Global IKEv2 Settings.


    
     

    

    

 
    [bookmark: pgfId-99217]Step 7 (Remote access SSL VPN only.) Click the SSL tab to specify the WINS servers for the connection profile policy, select a customized look and feel for the SSL VPN end-user logon web page, specify DHCP servers to be used for client address assignment, and establish an association between an interface and client IP address pools. For a detailed explanation of the configuration, see SSL Tab (Connection Profiles).

 
    [bookmark: pgfId-99219]Step 8 Click OK.

 
    [bookmark: pgfId-99221]


    
     

    
 
    

 
     
      [bookmark: pgfId-99251][bookmark: 77460][bookmark: ravpnpg_cncpt_SSLVPNConnectionProfilesPolicyPage]Connection Profiles Page [bookmark: marker-99229][bookmark: marker-99231][bookmark: marker-99233][bookmark: marker-99235][bookmark: marker-99237][bookmark: marker-99239][bookmark: marker-99241][bookmark: marker-99243][bookmark: marker-99245][bookmark: marker-99247][bookmark: marker-99249]

 
     [bookmark: pgfId-99253]Use the Connection Profiles page to manage connection profile policies for remote access VPN or Easy VPN topologies. The Connection Profiles page lists the connection profiles that are configured, shows the group policy associated with those connection profiles, and indicates whether a connection profile is the default connection profile to use for Citrix clients when no specific tunnel group is identified during tunnel negotiation.

 
     [bookmark: pgfId-99255]Use of this policy differs depending on the type of VPN you are configuring:

 
      
      		 [bookmark: pgfId-99257]Remote access SSL VPN—The policy is used only for ASA devices. You can create multiple profiles, and configure settings on all tabs of the Connection Profiles dialog box.

 
      		 [bookmark: pgfId-99259]Remote access IPSec VPN—The policy is used for ASA devices and PIX Firewalls running PIX 7.0+ software. You can create multiple profiles, but only the General, AAA, and IPSec tabs on the Connection Profiles dialog box apply to this configuration (in some cases, you will see only these tabs).

 
      		 [bookmark: pgfId-99261]Easy VPN topologies—The policy is used for Easy VPN servers (hubs) that are ASA devices or PIX Firewalls running PIX 7.0+ software. You can create a single profile, so the policy page actually imbeds the Connection Profiles dialog box, so that you have direct access to the tabs that define the profile. Only the General, AAA, and IPSec tabs apply.

 
     

 
     [bookmark: pgfId-99263]For remote access IPSec and SSL VPNs:

 
      
      		 [bookmark: pgfId-99265]To add a profile, click the  Add Row button and fill in the Connection Profiles dialog box.

 
      		 [bookmark: pgfId-99267]To edit an existing profile, select it and click the  Edit Row button.

 
      		 [bookmark: pgfId-99269]To delete a profile, select it and click the  Delete Row button.

 
     

 
     [bookmark: pgfId-99271]The connection profile consists of the following tabs. Configure them as appropriate for the type of VPN you are configuring.

 
      
      		 [bookmark: pgfId-99276]General Tab (Connection Profiles)

 
      		 [bookmark: pgfId-99281]AAA Tab (Connection Profiles)

 
      		 [bookmark: pgfId-99286]Secondary AAA Tab (Connection Profiles) (SSL VPN and IKEv2 IPsec VPN only.)

 
      		 [bookmark: pgfId-99291]IPSec Tab (Connection Profiles) (IKEv1 IPsec VPN only, does not apply to SSL or IKEv2 IPsec VPNs.)

 
      		 [bookmark: pgfId-99296]SSL Tab (Connection Profiles) (SSL VPN only)

 
     

 
     [bookmark: pgfId-99298]Navigation Path

 
     [bookmark: pgfId-99300]Remote access VPNs:

 
      
      		 [bookmark: pgfId-99302](Device View) Select an ASA or PIX 7+ device and select  Remote Access VPN > Connection Profiles from the Policy selector.

 
      		 [bookmark: pgfId-99304](Policy View) Select  Remote Access VPN > Connection Profiles (ASA) from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-99306]Easy VPN:

 
      
      		 [bookmark: pgfId-99311]From the Site-to-Site VPN Manager Window, select the Easy VPN topology and then select  Connection Profiles (PIX7.0/ASA) .

 
      		 [bookmark: pgfId-99316](Device view) Select a device that participates in the Easy VPN topology and select  Site to Site VPN from the Policy selector. Select the Easy VPN topology and click  Edit VPN Policies to open the Site-to-Site VPN Manager Window, where you can select the policy.

 
      		 [bookmark: pgfId-99318](Policy view) Select  Site-to-Site VPN > Connection Profiles (PIX7.0/ASA) . Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-99320]This section contains the following topics:

 
      
      		 [bookmark: pgfId-99325]General Tab (Connection Profiles)

 
      		 [bookmark: pgfId-99330]AAA Tab (Connection Profiles)

 
      		 [bookmark: pgfId-99335]Secondary AAA Tab (Connection Profiles)

 
      		 [bookmark: pgfId-99340]IPSec Tab (Connection Profiles)

 
      		 [bookmark: pgfId-99345]SSL Tab (Connection Profiles)

 
     

 
    
 
     
      [bookmark: pgfId-99359][bookmark: 77566][bookmark: ravpnpg_cncpt_GeneralTabASA]General Tab (Connection Profiles)[bookmark: marker-99355][bookmark: marker-99357]

 
     [bookmark: pgfId-99361]Use the General tab of the Connection Profiles dialog box to configure the basic properties for a VPN Connection Profile policy. These properties are used in remote access IPsec and SSL VPNs and site-to-site Easy VPN topologies.

 
     [bookmark: pgfId-99363]Navigation Path

 
      
      		 [bookmark: pgfId-99368]Remote Access VPNs—From the Connection Profiles page (see Connection Profiles Page), click the  Add Row (+) button, or select a profile and click the  Edit Row (pencil) button, to open the Connection Profiles dialog box. Click the  General tab if necessary.

 
      		 [bookmark: pgfId-99373]Easy VPN topologies—Select the site-to-site VPN Connection Profiles policy in either Policy view or in the Site-to-Site VPN Manager with an Easy VPN topology selected (see Connection Profiles Page). Click the  General tab if necessary.

 
     

 
     [bookmark: pgfId-99375]Related Topics

 
      
      		 [bookmark: pgfId-99380]Configuring Connection Profiles (ASA, PIX 7.0+)

 
      		 [bookmark: pgfId-99385]ASA Group Policies Dialog Box

 
      		 [bookmark: pgfId-99390]Understanding Networks/Hosts Objects

 
      		 [bookmark: pgfId-99395]Configuring a Connection Profile Policy for Easy VPN

 
      		 [bookmark: pgfId-99400]Understanding Easy VPN

 
     

 
     [bookmark: pgfId-99402]Field Reference

 
     [bookmark: pgfId-99405] 

 
      
       
        
        [bookmark: pgfId-95913]Table 31-2 [bookmark: 77613]Connection Profile General Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-95919]Element
          
  
         		
           
           [bookmark: pgfId-95921]Description
          
  
        

 
         
         		[bookmark: pgfId-95927]Connection Profile Name

  
         		[bookmark: pgfId-95929]The name of the connection profile (tunnel group).

  
        

 
         
         		[bookmark: pgfId-95935]Group Policy

  
         		[bookmark: pgfId-95937]If required, the name of the ASA group policy object that defines the default user group associated with the connection profile. A group policy is a collection of user-oriented attribute/value pairs stored either internally on the device or externally on a RADIUS/LDAP server.

 [bookmark: pgfId-95939]Click Select to select an existing object or to create a new one.

  
        

 
         
         		 
           
           [bookmark: pgfId-95945]Client Address Assignment
          
  
        

 
         
         		[bookmark: pgfId-95953]DHCP Servers

  
         		[bookmark: pgfId-95955]The DHCP servers to be used for client address assignments. The servers are used in the order listed.

 [bookmark: pgfId-95957]Enter the IP addresses of the DHCP servers or the names of network/host policy objects that define the DHCP server addresses. Click Select to select existing network/host objects or to create new ones. Separate multiple entries with commas.

  
        

 
         
         		[bookmark: pgfId-95963]Global IP Address Pool

  
         		[bookmark: pgfId-95965]The address pools from which IP addresses will be assigned to clients if no pool is specified for the interface to which the client connects. Address pools are entered as a range of addresses, such as 10.100.12.2-10.100.12.254. The server uses these pools in the order listed. If all addresses in the first pool have been assigned, it uses the next pool, and so on. You can specify up to 6 pools.

 [bookmark: pgfId-95967]Enter the address pool ranges or the names of network/host objects that define these pools. Click Select to select existing network/host objects or to create new ones. Separate multiple entries with commas.

  
        

 
         
         		[bookmark: pgfId-95973]Interface-Specific Address Pools table

  
         		[bookmark: pgfId-95975]If you want to configure separate IP address pools for specific interfaces, so that clients connecting through that interface use a pool different from the global pool, add the interface to this table and configure the separate pool. Any interface not listed here uses the global pool.

 
           
           		 [bookmark: pgfId-95980]To add an interface-specific address pool, click the  Add Row button and fill in the Add/Edit Interface Specific Client Address Pools Dialog Box

 
           		 [bookmark: pgfId-95982]To edit an interface pool, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-95984]To delete an interface, select it and click the  Delete Row button.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-99415][bookmark: 77670][bookmark: ravpnpg_cncpt_AddEditSSLVPNInterfaceSpecificClientAddressPools]Add/Edit Interface Specific Client Address Pools Dialog Box[bookmark: marker-99413]

 
     [bookmark: pgfId-99417]Use the Add/Edit Interface Specific Client Address Pools dialog box to configure interface-specific client address pools for your connection profile policy.

 
     [bookmark: pgfId-99419]Navigation Path

 
     [bookmark: pgfId-99424]Open the General tab in the Connection Profiles dialog box (see General Tab (Connection Profiles)), then click Add Row below the Interface-Specific Address Pools table, or select a row in the table and click Edit Row.

 
     [bookmark: pgfId-99426]Related Topics

 
      
      		 [bookmark: pgfId-99431]Creating Interface Role Objects

 
      		 [bookmark: pgfId-99436]Creating Networks/Hosts Objects

 
     

 
     [bookmark: pgfId-99438]Field Reference

 
     [bookmark: pgfId-99441] 

 
      
       
        
        [bookmark: pgfId-95997]Table 31-3 [bookmark: 77695]Add/Edit Interface Specific Client Address Pools Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-96003]Element
          
  
         		
           
           [bookmark: pgfId-96005]Description
          
  
        

 
         
         		[bookmark: pgfId-96011]Interface

  
         		[bookmark: pgfId-96013]The interface to which you are assigning an address pool. Enter the interface name or the name of an interface role object, or click Select to select an interface or object or to create a new object.

  
        

 
         
         		[bookmark: pgfId-96019]Address Pool

  
         		[bookmark: pgfId-96021]The address pool to assign to the interface. Address pools are specified using the starting and ending IP addresses of the pool, for example, 10.100.10.2-10.100.10.254. You can either type in the IP address range, or use a network/host object that specifies an address range. Click Select to select a network/host object or to create a new object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-99455][bookmark: 77719][bookmark: ravpnpg_cncpt_AAATabASA]AAA Tab (Connection Profiles)[bookmark: marker-99451][bookmark: marker-99453]

 
     [bookmark: pgfId-99457]Use the AAA tab of the Connection Profile dialog box to configure the AAA authentication parameters for a connection profile policy.

 
     [bookmark: pgfId-99459]Navigation Path

 
      
      		 [bookmark: pgfId-99464]Remote Access VPNs—From the Connection Profiles page (see Connection Profiles Page), click the  Add Row (+) button, or select a profile and click the  Edit Row (pencil) button, to open the Connection Profiles dialog box. Click the  AAA tab.

 
      		 [bookmark: pgfId-99469]Easy VPN topologies—Select the site-to-site VPN Connection Profiles policy in either Policy view or in the Site-to-Site VPN Manager with an Easy VPN topology selected (see Connection Profiles Page). Click the  AAA tab.

 
     

 
     [bookmark: pgfId-99471]Related Topics

 
      
      		 [bookmark: pgfId-99476]Configuring Connection Profiles (ASA, PIX 7.0+)

 
      		 [bookmark: pgfId-99481]Understanding AAA Server and Server Group Objects

 
      		 [bookmark: pgfId-99486]Configuring a Connection Profile Policy for Easy VPN

 
      		 [bookmark: pgfId-99491]Understanding Easy VPN

 
     

 
     [bookmark: pgfId-99493]Field Reference

 
     [bookmark: pgfId-99496] 

 
      
       
        
        [bookmark: pgfId-96034]Table 31-4 [bookmark: 77763]Connection Profile AAA Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-96040]Element
          
  
         		
           
           [bookmark: pgfId-96042]Description
          
  
        

 
         
         		[bookmark: pgfId-96048]Authentication Method

  
         		[bookmark: pgfId-96050]Whether to authenticate connections using AAA, certificates, or both. If you select Certificate, many of the options on the dialog box are greyed out and do not apply.

  
        

 
         
         		[bookmark: pgfId-96056]Authentication Server Group

  
         		[bookmark: pgfId-96058]The name of the authentication server group (LOCAL if the tunnel group is configured on the local device). Enter the name of a AAA server group object or click Select to select it from a list or to create a new object.

 [bookmark: pgfId-96060]If you want to use different authentication server groups based on the interface to which the client connects, configure the server groups in the Interface-Specific Authentication Server Groups table at the bottom of this tab (described below).

  
        

 
         
         		[bookmark: pgfId-96066]Use LOCAL if Server Group Fails

  
         		[bookmark: pgfId-96068]Whether to fall back to the local database for authentication if the selected authentication server group fails.

  
        

 
         
         		[bookmark: pgfId-96074]Authorization Server Group

  
         		[bookmark: pgfId-96076]The name of the authorization server group (LOCAL if the tunnel group is configured on the local device). Enter the name of a AAA server group object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-96082]Users must exist in the authorization database to connect

  
         		[bookmark: pgfId-96084]Whether to require that the username of the client must exist in the authorization database to allow a successful connection. If the username does not exist in the authorization database, then the connection is denied.

  
        

 
         
         		[bookmark: pgfId-96090]Accounting Server Group

  
         		[bookmark: pgfId-96092]The name of the accounting server group. Enter the name of a AAA server group object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-96098]Strip Realm from Username

 [bookmark: pgfId-96100]Strip Group from Username

  
         		[bookmark: pgfId-96102]Whether to remove the realm or group name from the username before passing the username on to the AAA server. A realm is an administrative domain. Enabling these options allows the authentication to be based on the username alone.

 [bookmark: pgfId-96104]You can enable any combination of these options. However, you must select both check boxes if your server cannot parse delimiters.

  
        

 
         
         		[bookmark: pgfId-96110]Override Account-Disabled Indication from AAA Server

  
         		[bookmark: pgfId-96112]Whether to override the “account-disabled” indicator from a AAA server. This configuration is valid for servers, such as RADIUS with NT LDAP, and Kerberos, that return an “account-disabled” indication.

 [bookmark: pgfId-96114]If you are using an LDAP directory server for authentication, password management is supported with the Sun Microsystems JAVA System Directory Server (formerly named the Sun ONE Directory Server) and the Microsoft Active Directory.

 
           
           		 [bookmark: pgfId-96116] Sun —The DN configured on the security appliance to access a Sun directory server must be able to access the default password policy on that server. We recommend using the directory administrator, or a user with directory administrator privileges, as the DN. Alternatively, you can place an ACI on the default password policy.

 
           		 [bookmark: pgfId-96118] Microsoft —You must configure LDAP over SSL to enable password management with Microsoft Active Directory.

 
          

  
        

 
         
         		[bookmark: pgfId-96124]Enable Notification Upon Password Expiration to Allow User to Change Password

 [bookmark: pgfId-96126]Enable Notification Prior to Expiration

 [bookmark: pgfId-96128]Notify Prior to Expiration

  
         		[bookmark: pgfId-96130]Whether to have the security appliance notify the remote user at login that the current password is about to expire or has expired, and to then offer the user the opportunity to change the password.

 [bookmark: pgfId-96132]If you want to give the user prior warning of an impending password expiration, select Enable Notification Prior to Expiration and specify the number of days prior to expiration that you want to start notifications (1 to 180 days). You can use this option with AAA servers that support such notification—RADIUS, RADIUS with an NT server, and LDAP servers. There is no prior notification for other types of servers.

  
        

 
         
         		[bookmark: pgfId-96138]Distinguished Name (DN) Authorization Settings

  
         		[bookmark: pgfId-96140]How you want to use the distinguished name for authorization. A distinguished name (DN) is a unique identification, made up of individual fields, that can be used as the identifier when matching users to a tunnel group. DN rules are used for enhanced certificate authentication. Select from the following options to determine how the DN is used during authorization:

 
           
           		 [bookmark: pgfId-96142] Use Entire DN as the Username —Use the entire DN; do not focus on any one field.

 
           		 [bookmark: pgfId-96144] Specify Individual DN fields as the Username —Focus on specific fields. Select a primary field, and optionally, a secondary field. The default is to use the common name (CN) as primary and the organization unit (OU) as secondary.

 
           		 [bookmark: pgfId-96149] Use Script to Select Username —Beginning with version 4.7, Security Manager enables you to define a script to use in mapping the username from the certificate. Select the script that you have defined from the drop-down list. For more information, see Add/Edit Scripts Dialog Box.

 
          

  
        

 
         
         		[bookmark: pgfId-96155]Interface-Specific Authentication Server Groups table

  
         		[bookmark: pgfId-96157]If you want to configure separate authentication server groups for specific interfaces, so that clients connecting through that interface use a server group different from the global group, add the interface to this table and configure the separate group. Any interface not listed here uses the global authentication server group. The table shows the server group and whether you are falling back to local authentication if the server group is not available.

 
           
           		 [bookmark: pgfId-96162]To add an interface-specific authentication group to the list, click the  Add Row button and fill in the Add/Edit Interface Specific Authentication Server Groups Dialog Box.

 
           		 [bookmark: pgfId-96164]To edit an interface setting, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-96166]To delete an interface setting, select it and click the  Delete Row button.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-99510][bookmark: 77868][bookmark: ravpnpg_cncpt_AddEditSSLVPNInterfaceSpecificAuthenticationServerGroups]Add/Edit Interface Specific Authentication Server Groups Dialog Box[bookmark: marker-99506][bookmark: marker-99508]

 
     [bookmark: pgfId-99512]Use the Add/Edit Interface Specific Authentication Server Groups dialog boxes to configure interface-specific authentication for your connection profile policy. This setting overrides the global authentication server group settings if the client connects to the specified interface.

 
     [bookmark: pgfId-99514]If you are configuring the secondary AAA server for an SSL VPN on an ASA device, the settings are specifically used for the secondary set of credentials that the user enters; this is reflected in the name of the dialog box.

 
     [bookmark: pgfId-99516]Navigation Path

 
     [bookmark: pgfId-99524]Open the AAA or Secondary AAA tabs in the Connection Profiles dialog box (see AAA Tab (Connection Profiles) or Secondary AAA Tab (Connection Profiles)), then click Add Row below the Interface-Specific Address Pools table, or select a row in the table and click Edit Row.

 
     [bookmark: pgfId-99526]Related Topics

 
      
      		 [bookmark: pgfId-99531]Understanding Interface Role Objects

 
      		 [bookmark: pgfId-99536]Understanding AAA Server and Server Group Objects

 
     

 
     [bookmark: pgfId-99538]Field Reference

 
     [bookmark: pgfId-99541] 

 
      
       
        
        [bookmark: pgfId-96179]Table 31-5 [bookmark: 77898]Add/Edit (Secondary) Interface Specific Authentication Server Groups 

 
        
       
         
         		
           
           [bookmark: pgfId-96185]Element
          
  
         		
           
           [bookmark: pgfId-96187]Description
          
  
        

 
         
         		[bookmark: pgfId-96193]Interface

  
         		[bookmark: pgfId-96195]The name of the interface or interface role (that identifies the interfaces) for which you are configuring an authentication server group. Click Select to select an interface or interface role or to create a new interface role.

  
        

 
         
         		[bookmark: pgfId-96201]Server Group

  
         		[bookmark: pgfId-96203]The name of the authentication server group (LOCAL if the tunnel group is configured on the local device). Enter the name of a AAA server group object or click Select to select it from a list or to create a new object.

 [bookmark: pgfId-96205]When you are configuring secondary AAA, this group is used specifically for the second credentials. You can specify different server groups for primary and secondary credentials.

  
        

 
         
         		[bookmark: pgfId-96211]Use LOCAL if Server Group Fails

  
         		[bookmark: pgfId-96213]Whether to fall back to the local database for authentication if the selected authentication server group fails.

  
        

 
         
         		[bookmark: pgfId-96219]Use Primary Username

 [bookmark: pgfId-96221](Secondary authentication only; remote access SSL or IKEv2 IPSec VPN on ASA 8.2+ only.)

  
         		[bookmark: pgfId-96223]Whether to use the same username for the secondary credentials that was used for the primary credentials. If you select this option, after users authenticate with their primary credentials, they are prompted for the secondary password only. If you do not select this option, the secondary prompt requires both a username and password.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-99553][bookmark: 77934][bookmark: ravpnpg_cncpt_SecondaryAAATabASA]Secondary AAA Tab (Connection Profiles)[bookmark: marker-99549][bookmark: marker-99551]

 
     [bookmark: pgfId-99555]Use the Secondary AAA tab to configure the secondary AAA authentication parameters for a remote access SSL VPN connection profile policy for use with ASA 8.2+ devices, or a remote access IKEv2 IPSec VPN connection profile policy for use with an ASA 8.4(1)+ device. These settings do not apply to remote access IKEv1 IPSec VPNs or Easy VPN topologies or to other device types.

 
     [bookmark: pgfId-99557]Navigation Path

 
     [bookmark: pgfId-99562]Remote Access VPNs only—From the Connection Profiles page (see Connection Profiles Page), click the Add Row (+) button, or select a profile and click the Edit Row (pencil) button, to open the Connection Profiles dialog box. Click the Secondary AAA tab.

 
     [bookmark: pgfId-99564]Related Topics

 
      
      		 [bookmark: pgfId-99569]Configuring Connection Profiles (ASA, PIX 7.0+)

 
     

 
     [bookmark: pgfId-99571]Field Reference

 
     [bookmark: pgfId-99574] 

 
      
       
        
        [bookmark: pgfId-96236]Table 31-6 [bookmark: 77962]Connection Profile Secondary AAA Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-96242]Element
          
  
         		
           
           [bookmark: pgfId-96244]Description
          
  
        

 
         
         		[bookmark: pgfId-96250]Enable Double Authentication

  
         		[bookmark: pgfId-96252]Whether to enable double authentication, which prompts the user for two sets of credentials (username and password) before completing the remote access VPN connection.

  
        

 
         
         		[bookmark: pgfId-96258]Secondary Authentication Server Group

  
         		[bookmark: pgfId-96260]The name of the authentication server group (LOCAL if the tunnel group is configured on the local device) to be used with the second set of credentials. Enter the name of a AAA server group object or click Select to select it from a list or to create a new object.

 [bookmark: pgfId-96262]If you want to use different authentication server groups based on the interface to which the client connects, configure the server groups in the Secondary Interface-Specific Authentication Server Groups table at the bottom of this tab (described below).

  
        

 
         
         		[bookmark: pgfId-96268]Use LOCAL if Server Group Fails

  
         		[bookmark: pgfId-96270]Whether to fall back to the local database for authentication if the selected authentication server group fails.

  
        

 
         
         		[bookmark: pgfId-96276]Use Primary Username for Secondary Authentication

  
         		[bookmark: pgfId-96278]Whether to use the same username for the secondary credentials that was used for the primary credentials. If you select this option, after users authenticate with their primary credentials, they are prompted for the secondary password only. If you do not select this option, the secondary prompt requires both a username and password.

  
        

 
         
         		[bookmark: pgfId-96284]Username for Session

  
         		[bookmark: pgfId-96286]The username that the software will use for the user session, either the primary or secondary name. If you prompt for the primary name only, select primary.

 [bookmark: pgfId-96288]Note By default, if there is more than one username, AnyConnect remembers both usernames between sessions. In addition, the head-end device might offer a feature to allow for administrative control over whether the client remembers both or neither usernames.

  
        

 
         
         		[bookmark: pgfId-96294]Authorization Authentication Server

  
         		[bookmark: pgfId-96296]The server to use for authorization, either the primary authentication server (defined on the AAA tab) or the secondary authentication server configured on this tab.

  
        

 
         
         		[bookmark: pgfId-96302]Distinguished Name (DN) Secondary Authorization Setting

  
         		[bookmark: pgfId-96304]How you want to use the distinguished name for authorization. A distinguished name (DN) is a unique identification, made up of individual fields, that can be used as the identifier when matching users to a tunnel group. DN rules are used for enhanced certificate authentication. Select from the following options to determine how the DN is used during authorization:

 
           
           		 [bookmark: pgfId-96306] Use Entire DN as the Username —Use the entire DN; do not focus on any one field.

 
           		 [bookmark: pgfId-96308] Specify Individual DN fields as the Username —Focus on specific fields. Select a primary field, and optionally, a secondary field. The default is to use only the user identification (UID) field.

 
           		 [bookmark: pgfId-96313] Use Script to Select Username —Beginning with version 4.7, Security Manager enables you to define a script to use in mapping the username from the certificate. Select the script that you have defined from the drop-down list. For more information, see Add/Edit Scripts Dialog Box.

 
          

  
        

 
         
         		[bookmark: pgfId-96319]Secondary Interface-Specific Authentication Server Groups table

  
         		[bookmark: pgfId-96321]If you want to configure separate secondary authentication server groups for specific interfaces, so that clients connecting through that interface use a server group different from the global group, add the interface to this table and configure the separate group. Any interface not listed here uses the global authentication server group. The table shows the server group and whether you are falling back to local authentication if the server group is not available.

 
           
           		 [bookmark: pgfId-96326]To add a secondary interface-specific authentication group to the list, click the  Add Row button and fill in the Add/Edit Interface Specific Authentication Server Groups Dialog Box.

 
           		 [bookmark: pgfId-96328]To edit an interface setting, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-96330]To delete an interface setting, select it and click the  Delete Row button.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-99588][bookmark: 78038][bookmark: ravpnpag_cncpt_IPsecTab]IPSec Tab (Connection Profiles)[bookmark: marker-99584][bookmark: marker-99586]

 
     [bookmark: pgfId-99590]Use the IPsec tab of the Connection Profiles page to specify IPsec and IKE parameters for the connection policy.

 
     [bookmark: pgfId-99592]Beginning with version 4.8, Security Manager supports VPN connectivity via standards-based, third-party, IKEv2 remote-access clients (in addition to AnyConnect). Authentication support includes preshared keys, certificates, and user authentication via the Extensible Authentication Protocol (EAP).

 
     [bookmark: pgfId-99594]Navigation Path

 
      
      		 [bookmark: pgfId-99599]Remote Access VPNs—From the Connection Profiles page (see Connection Profiles Page), click the  Add Row (+) button, or select a profile and click the  Edit Row (pencil) button, to open the Connection Profiles dialog box. Click the  IPSec tab.

 
      		 [bookmark: pgfId-99604]Easy VPN topologies—Select the site-to-site VPN Connection Profiles policy in either Policy view or in the Site-to-Site VPN Manager with an Easy VPN topology selected (see Connection Profiles Page). Click the  IPSec tab.

 
     

 
     [bookmark: pgfId-99606]Related Topics

 
      
      		 [bookmark: pgfId-99611]Configuring Connection Profiles (ASA, PIX 7.0+)

 
      		 [bookmark: pgfId-99616]Configuring a Connection Profile Policy for Easy VPN

 
      		 [bookmark: pgfId-99621]Understanding Easy VPN

 
     

 
     [bookmark: pgfId-99623]Field Reference

 
     [bookmark: pgfId-99626] 

 
      
       
        
        [bookmark: pgfId-96343]Table 31-7 [bookmark: 78080]Connection Profiles IPsec Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-96349]Element
          
  
         		
           
           [bookmark: pgfId-96351]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-96357]IKEv1 Peer Authentication
          
  
        

 
         
         		[bookmark: pgfId-96365]Preshared Key

  
         		[bookmark: pgfId-96367]The preshared key for the connection profile. The maximum length of a preshared key is 127 characters. Enter the key again in the Confirm field.

  
        

 
         
         		[bookmark: pgfId-96373]Trustpoint Name

 [bookmark: pgfId-96379]Click Select to select the object from a list or to create a new object.

 [bookmark: pgfId-96381]Tips

 [bookmark: pgfId-96386]If you specify a trustpoint, you must also select the same PKI enrollment object in the Public Key Infrastructure policy. For more information, see Configuring Public Key Infrastructure Policies for Remote Access VPNs.

  
        

 
         
         		 [bookmark: pgfId-96392]IKEv2 Peer Authentication

 [bookmark: pgfId-96394]You can configure one or more authentication options such as preshared key, certificate, and EAP for remote authentication.

  
        

 
         
         		[bookmark: pgfId-96402]Preshared Key

  
         		[bookmark: pgfId-96404]The preshared key for the connection profile. The maximum length of a preshared key is 127 characters. Enter the key again in the Confirm field.

  
        

 
         
         		[bookmark: pgfId-96410]Enable Certificate Authentication

  
         		[bookmark: pgfId-96412]Allows you to use certificates for authentication if checked.

  
        

 
         
         		[bookmark: pgfId-96418]Enable EAP Authentication

  
         		[bookmark: pgfId-96420]Allows you to use EAP for authentication if checked.

 [bookmark: pgfId-96422]Note You must use certificates for local authentication if you check this check box since EAP authentication requires the server to authenticate via a certificate.

  
        

 
         
         		[bookmark: pgfId-96428]Send EAP identity request to the client

  
         		[bookmark: pgfId-96430]Enables you to send an EAP request for authentication to the remote access VPN client.

  
        

 
         
         		 [bookmark: pgfId-96436]IKEv2 Local Authentication

 [bookmark: pgfId-96438]You can configure either a preshared key or a trustpoint name for local authentication.

  
        

 
         
         		[bookmark: pgfId-96446]Preshared key

  
         		[bookmark: pgfId-96448]The preshared key for the connection profile. The maximum length of a preshared key is 127 characters. Enter the key again in the Confirm field.

  
        

 
         
         		[bookmark: pgfId-96454]Trustpoint Name

  
         		[bookmark: pgfId-96456]The name of the PKI enrollment policy object that defines the trustpoint name if any trustpoints are configured for IKEv2 connections. A trustpoint represents a Certificate Authority (CA)/identity pair and contains the identity of the CA, CA-specific configuration parameters, and an association with one enrolled identity certificate.

 [bookmark: pgfId-96458]Click Select to select the object from a list or to create a new object.

 [bookmark: pgfId-96460]Note Local authentication must be using certificate if you select EAP for remote authentication.

  
        

 
         
         		[bookmark: pgfId-96466]IKE Peer ID Validation

  
         		[bookmark: pgfId-96468]Select whether IKE peer ID validation is ignored (Do not check), required, or checked only if supported by a certificate. During IKE negotiations, peers must identify themselves to one another.

  
        

 
         
         		[bookmark: pgfId-96474]Enable Sending Certificate Chain

  
         		[bookmark: pgfId-96476]Whether to enable the sending of the certificate chain for authorization. A certificate chain includes the root CA certificate, identity certificate, and key pair.

  
        

 
         
         		[bookmark: pgfId-96482]Enable Password Update with RADIUS Authentication

  
         		[bookmark: pgfId-96487]Whether to enable passwords to be updated with the RADIUS authentication protocol. For more information, see Supported AAA Server Types.

  
        

 
         
         		[bookmark: pgfId-96493]ISAKMP Keepalive

  
         		[bookmark: pgfId-96495]Whether to monitor ISAKMP keepalive. If you select the Monitor Keepalive option, you can configure IKE keepalive as the default failover and routing mechanism. Enter the following parameters:

 
           
           		 [bookmark: pgfId-96497] Confidence Interval —The number of seconds that a device waits between sending IKE keepalive packets.

 
           		 [bookmark: pgfId-96499] Retry Interval —The number of seconds a device waits between attempts to establish an IKE connection with the remote peer. The default is 2 seconds.

 
          

 [bookmark: pgfId-96504]For more information, see Configuring VPN Global ISAKMP/IPsec Settings.

  
        

 
         
         		[bookmark: pgfId-96510]Client Software Update table

 [bookmark: pgfId-96519]To configure the client for a platform, select it, click the Edit Row button, and fill in the IPSec Client Software Update Dialog Box.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-99638][bookmark: 78198][bookmark: ravpnpag_cncpt_IPsecClientSoftwareUpdate]IPSec Client Software Update Dialog Box[bookmark: marker-99636]

 
     [bookmark: pgfId-99640]Use the IPsec Client Software Update dialog box to configure the specific revision level and image URL of a VPN client.

 
     [bookmark: pgfId-99642]Navigation Path

 
     [bookmark: pgfId-99647]Open the IPSec tab in the Connection Profiles dialog box (see IPSec Tab (Connection Profiles)), select a client type from the Client Software Update table, then click Edit Row.

 
     [bookmark: pgfId-99649]Field Reference

 
     [bookmark: pgfId-99652] 

 
      
       
        
        [bookmark: pgfId-96532]Table 31-8 [bookmark: 78214]IPSec Client Software Update Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-96538]Element
          
  
         		
           
           [bookmark: pgfId-96540]Description
          
  
        

 
         
         		[bookmark: pgfId-96546]Client Type

  
         		[bookmark: pgfId-96548]Type of client being modified.

  
        

 
         
         		[bookmark: pgfId-96554]Client Revisions

  
         		[bookmark: pgfId-96556]Revision level of the client.

  
        

 
         
         		[bookmark: pgfId-96562]Image URL

  
         		[bookmark: pgfId-96564]URL of the client software image.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-99664][bookmark: 78241][bookmark: ravpnpg_cncpt_SSLTabASA]SSL Tab (Connection Profiles)[bookmark: marker-99660][bookmark: marker-99662]

 
     [bookmark: pgfId-99666]Use the SSL tab of the Connection Profile dialog box to configure the WINS servers for the connection profile policy, select a customized look and feel for the SSL VPN end-user logon web page, DHCP servers to be used for client address assignment, and to establish an association between an interface and client IP address pools. Some items, such as connection profile aliases, apply to remote access IKEv2 IPsec VPNs, but otherwise these settings do not apply to remote access IKEv1 IPSec VPNs or Easy VPN topologies.

 
     [bookmark: pgfId-99668]Navigation Path

 
     [bookmark: pgfId-99673]Remote Access VPNs only—From the Connection Profiles page (see Connection Profiles Page), click the Add Row (+) button, or select a profile and click the Edit Row (pencil) button, to open the Connection Profiles dialog box. Click the SSL tab.

 
     [bookmark: pgfId-99675]Related Topics

 
      
      		 [bookmark: pgfId-99680]Configuring Connection Profiles (ASA, PIX 7.0+)

 
      		 [bookmark: pgfId-99685]Configuring WINS/NetBIOS Name Service (NBNS) Servers To Enable File System Access in SSL VPNs

 
      		 [bookmark: pgfId-99690]Understanding Networks/Hosts Objects

 
      		 [bookmark: pgfId-99695]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
     

 
     [bookmark: pgfId-99697]Field Reference

 
     [bookmark: pgfId-99700] 

 
      
       
        
        [bookmark: pgfId-96577]Table 31-9 [bookmark: 78278]Connection Profile SSL Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-96583]Element
          
  
         		
           
           [bookmark: pgfId-96585]Description
          
  
        

 
         
         		[bookmark: pgfId-96591]WINS Servers List

  
         		[bookmark: pgfId-96593]The name of the WINS (Windows Internet Naming Server) servers list to use for CIFS name resolution. Click Select to select the WINS servers list policy object or to create a new object.

 [bookmark: pgfId-96595]SSL VPN uses the CIFS protocol to access or share files on remote systems. When you attempt a file-sharing connection to a Windows computer by using its computer name, the file server you specify corresponds to a specific WINS server name that identifies a resource on the network.

 [bookmark: pgfId-96597]A WINS servers list defines a list of WINS servers, which are used to translate Windows file server names to IP addresses. The security appliance queries the WINS servers to map WINS names to IP addresses. You must configure at least one, and up to three WINS servers for redundancy. The security appliance uses the first server on the list for WINS/CIFS name resolution. If the query fails, it uses the next server.

  
        

 
         
         		[bookmark: pgfId-96603]DNS Group

  
         		[bookmark: pgfId-96605]The DNS group to use for the SSL VPN tunnel group. The DNS group resolves the hostname to the appropriate DNS server for the tunnel group. Select the desired group from the list; the DefaultDNS group is the default group that is always available on the device.

 policy. Use the DNS policy to change the servers defined in a group or to add or remove groups. See DNS Page.  
        

 
         
         		[bookmark: pgfId-96616]Portal Page Customization

  
         		[bookmark: pgfId-96618]The name of the SSL VPN Customization policy object that defines the default portal page for the VPN. This profile defines the appearance of the portal page that allows the remote user access to all resources available on the SSL VPN. Click Select to select the object or to create a new object.

 [bookmark: pgfId-96623]Note You can set up different login windows for different groups by using a combination of customization profiles and groups. For example, assuming that you had created a customization profile called salesgui, you can create an SSL VPN group called sales that uses that customization profile. You would then specify the SSL VPN customization object in the group policy object on the SSL VPN > Settings tab; see ASA Group Policies SSL VPN Settings.

  
        

 
         
         		[bookmark: pgfId-96629]Override SVC Download

 [bookmark: pgfId-96631](ASA 8.0(2)+ only)

  
         		[bookmark: pgfId-96633]Whether you want clientless users logging in under specific tunnel groups to not have to wait for the download prompt to expire before being presented with the clientless SSL VPN home page. Instead, these users are immediately presented with the clientless SSL VPN home page.

  
        

 
         
         		[bookmark: pgfId-96639]Reject Radius Message

 [bookmark: pgfId-96641](ASA 8.0(2)+ only)

  
         		[bookmark: pgfId-96643]Whether you want to display to remote users a RADIUS message about their authentication failure.

  
        

 
         
         		[bookmark: pgfId-96649]Connection Aliases table

  
         		[bookmark: pgfId-96651]A list of alternate names by which the tunnel group can be referred to. The status indicates whether the name is enabled for use or disabled (cannot be used).

 [bookmark: pgfId-96653]A group alias creates one or more alternate names by which a user can refer to a tunnel group. This feature is useful when the same group is known by several common names (such as “Devtest” and “QA”). If you want the actual name of the tunnel group to appear on this list, you must specify it as an alias. The group alias that you specify here appears on the login page. Each tunnel group can have multiple aliases or no alias.

 
           
           		 [bookmark: pgfId-96658]To add an alias, click the  Add Row (+) button beneath the table and fill in the Add/Edit Connection Alias Dialog Box.

 
           		 [bookmark: pgfId-96660]To edit an alias, select it and click the  Edit Row (pencil) button.

 
           		 [bookmark: pgfId-96662]To delete an alias, select it and click the  Delete Row (trash can) button.

 
          

  
        

 
         
         		[bookmark: pgfId-96668]Group URLs table

  
         		[bookmark: pgfId-96670]A list of URLs associated with the tunnel group connection profile. The status indicates whether the URL is enabled for use. When enabled, the user can use the URL, which eliminates the need to select a group during login.

 [bookmark: pgfId-96672]You can configure multiple URLs (or no URLs) for a tunnel group. Each URL can be enabled or disabled individually. You must use a separate specification for each URL, specifying the entire URL using either the HTTP or HTTPS protocol.

 
           
           		 [bookmark: pgfId-96677]To add a URL, click the  Add Row (+) button beneath the table and fill in the Add/Edit Connection URL Dialog Box.

 
           		 [bookmark: pgfId-96679]To edit a URL, select it and click the  Edit Row (pencil) button.

 
           		 [bookmark: pgfId-96681]To delete a URL, select it and click the  Delete Row (trash can) button.

 
          

  
        

 
         
         		[bookmark: pgfId-96687]Default Citrix Client Profile

 [bookmark: pgfId-96689](ASA 9.1(4)+ only)

  
         		[bookmark: pgfId-96691]Whether this connection profile should be the default connection profile to use for Citrix clients when no specific tunnel group is identified during tunnel negotiation.

 [bookmark: pgfId-96693]Note Only one connection profile can be configured as the Default Citrix Client Profile. If you try to configure a connection profile as the Default Citrix Client Profile when another profile is already configured as such, you will receive a warning message. If you continue with the operation, the selected connection profile will be made the Default Citrix Client Profile and the other connection profile will be deselected as the Default Citrix Client Profile.

  
        

 
         
         		[bookmark: pgfId-96699]Disable CSD

 [bookmark: pgfId-96701](ASA 8.2(0)+ only)

 [bookmark: pgfId-96703]Both Clientless and AnyConnect

 [bookmark: pgfId-96705]AnyConnect only

  
         		[bookmark: pgfId-96707]Whether to disable Cisco Secure Desktop (CSD) for this connection profile. Security Manager supports this feature on all devices that are running ASA software version 8.2(0) and higher.

 [bookmark: pgfId-96709]Note If you choose to disable CSD, by default Security Manager selects the option for both SSL Clientless VPN and AnyConnect.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-99710][bookmark: 78374][bookmark: ravpnpg_cncpt_AddEditConnectionAliasDialogBox]Add/Edit Connection Alias Dialog Box[bookmark: marker-99708]

 
     [bookmark: pgfId-99712]Use the Add/Edit Connection Alias dialog box to create or edit a connection alias for an SSL or IKEv2 IPsec VPN connection profile. Specifying the connection alias creates one or more alternate names by which the user can refer to a tunnel group.

 
     [bookmark: pgfId-99714]Navigation Path

 
     [bookmark: pgfId-99719]Open the SSL tab in the Connection Profiles dialog box (see SSL Tab (Connection Profiles)), and click Add Row beneath the Connection Alias table, or select an alias from the table and click Edit Row.

 
     [bookmark: pgfId-99721]Field Reference

 
     [bookmark: pgfId-99724] 

 
      
       
        
        [bookmark: pgfId-96722]Table 31-10 [bookmark: 78390]Add/Edit Connection Alias Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-96728]Element
          
  
         		
           
           [bookmark: pgfId-96730]Description
          
  
        

 
         
         		[bookmark: pgfId-96736]Enabled

  
         		[bookmark: pgfId-96738]Whether to enable the connection alias. You must enable the alias for users to use it.

  
        

 
         
         		[bookmark: pgfId-96744]Connection Alias

  
         		[bookmark: pgfId-96746]The alternative name for the connection profile.

 [bookmark: pgfId-96748]The connection alias that you specify here appears in a list on the user’s login page.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-99734][bookmark: 78412][bookmark: ravpnpg_cncpt_AddEditConnectionURLDialogBox]Add/Edit Connection URL Dialog Box[bookmark: marker-99732]

 
     [bookmark: pgfId-99736]Use this dialog box to specify incoming URLs for the tunnel group. If a connection URL is enabled in a tunnel group, when the user connects using that URL, the security appliance selects the associated tunnel group and presents the user with only the username and password fields in the login window.

 
     [bookmark: pgfId-99738]Tips

 
      
      		 [bookmark: pgfId-99740]You can configure multiple URLs or addresses (or none) for a group. Each URL or address can be enabled or disabled individually.

 
      		 [bookmark: pgfId-99742]You cannot associate the same URL or address with multiple groups. The security appliance verifies the uniqueness of the URL or address before accepting the URL or address for a tunnel group.

 
     

 
     [bookmark: pgfId-99744]Navigation Path

 
     [bookmark: pgfId-99749]Open the SSL tab in the Connection Profiles dialog box (see SSL Tab (Connection Profiles)), and click Add Row beneath the Group URLs table, or select a URL from the table and click Edit Row.

 
     [bookmark: pgfId-99751]Field Reference

 
     [bookmark: pgfId-99754] 

 
      
       
        
        [bookmark: pgfId-96761]Table 31-11 [bookmark: 78435]Add/Edit Connection URL Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-96767]Element
          
  
         		
           
           [bookmark: pgfId-96769]Description
          
  
        

 
         
         		[bookmark: pgfId-96775]Enabled

  
         		[bookmark: pgfId-96777]Whether to enable the connection alias. You must enable the alias for users to use it.

  
        

 
         
         		[bookmark: pgfId-96783]Connection URL

  
         		[bookmark: pgfId-96785]Select a protocol (http or https) from the list, and specify the incoming URL for the connection.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-99780][bookmark: 78461][bookmark: ravpnpag_cncpt_GroupPoliciesPage]Configuring Group Policies for Remote Access VPNs[bookmark: marker-99762][bookmark: marker-99764][bookmark: marker-99766][bookmark: marker-99768][bookmark: marker-99770][bookmark: marker-99772][bookmark: marker-99774][bookmark: marker-99776][bookmark: marker-99778]

 
    [bookmark: pgfId-99785]In the Group Policies page, you can view the user group policies defined for your ASA remote access VPN connection profiles. From this page, you can specify new ASA user groups and edit existing ones. When you create a connection profile, if you specify a group policy that has not been used on the device, the group policy is automatically added to the Group Policies page; you do not need to add it to this policy before you create the connection profile. For information on creating connection profiles, see Configuring Connection Profiles (ASA, PIX 7.0+).

 
    [bookmark: pgfId-99790]For more information about group policies, see Understanding Group Policies (ASA).

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-99792]Tip Dynamic Access policies take precedence over Group policies. If a setting is not specified in a Dynamic Access policy, an ASA device checks for Group policies that specify the setting.


    
     

    

    

 
    [bookmark: pgfId-99794]Each row in the table represents an ASA group policy object, displaying the name of the policy object assigned to the remote access VPN connection profile, whether it is stored on the ASA device itself (Internal) or on a AAA server (External), and whether the group is for IKEv1 (IPsec), IKEv2 (IPsec), SSL, or all types of VPN. For external groups, the protocol is unknown and listed as N/A.

 
     
     		 [bookmark: pgfId-99799]To add an ASA group policy object, click the  Add Row button. This opens an object selector, from which you can select an existing policy object or click the  Create button to create a new object. For more information about creating group policies, see Creating Group Policies (ASA, PIX 7.0+).

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-99804]Note You cannot create more than one group policy that includes DfltGrpPolicy in its name. DfltGrpPolicy is the default policy defined on the device; if Security Manager discovers the group during remote access policy discovery, the group appears in the list under the name <device_display_name>DfltGrpPolicy. When you deploy the configuration to the device, the display name prefix is removed so that DfltGrpPolicy is updated correctly. For more information, see Discovering Remote Access VPN Policies.


    
     

    

    

 
     
     		 [bookmark: pgfId-99809]To edit an object, select it and click the  Edit Row button to open the ASA Group Policies Dialog Box.

 
     		 [bookmark: pgfId-99811]To delete an object from the policy, select it and click the  Delete Row button. The associated policy objects are not deleted, they are only removed from this policy.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-99813]Note You cannot delete the default group policy.


    
     

    

    

 
    [bookmark: pgfId-99815]Navigation Path

 
     
     		 [bookmark: pgfId-99817](Device view) Select an ASA device, then select  Remote Access VPN > Group Policies from the Policy selector.

 
     		 [bookmark: pgfId-99819](Policy view) Select  Remote Access VPN > Group Policies (ASA) from the Policy selector. Select an existing policy or create a new one.

 
    

 
     
      [bookmark: pgfId-99841][bookmark: 78530][bookmark: ravpnch_cncpt_UnderstandingASAUserGroupObjects]Understanding Group Policies (ASA)[bookmark: marker-99825][bookmark: marker-99827][bookmark: marker-99829][bookmark: marker-99831][bookmark: marker-99833][bookmark: marker-99835][bookmark: marker-99837][bookmark: marker-99839]

 
     [bookmark: pgfId-99843]When you configure a remote access IPSec or SSL VPN connection, you must create user groups to which remote clients will belong. A user group policy is a set of user-oriented attribute/value pairs for remote access VPN connections that are stored either internally (locally) on the device or externally on an AAA server. The connection profile uses a user group policy that sets terms for user connections after the connection is established. Group policies let you apply whole sets of attributes to a user or a group of users, rather than having to specify each attribute individually for each user.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-99845]Tip Dynamic Access policies take precedence over Group policies. If a setting is not specified in a Dynamic Access policy, an ASA device checks for Group policies that specify the setting.


     
      

     

     

 
     [bookmark: pgfId-99847]An ASA user group comprises the following attributes:

 
      
      		 [bookmark: pgfId-99852]Group policy source—Identifies whether the user group’s attributes and values are stored internally (locally) on the security appliance or externally on an AAA server. If the user group is an external type, no other settings need to be configured for it. For more information, see ASA Group Policies Dialog Box.

 
      		 [bookmark: pgfId-99857]Client Configuration settings, which specify the Cisco client parameters for the user group in an Easy VPN or remote access VPN. For more information, see ASA Group Policies Client Configuration Settings.

 
      		 [bookmark: pgfId-99862]Client Firewall Attributes, which configure the firewall settings for VPN clients in an Easy VPN or remote access VPN. For more information, see ASA Group Policies Client Firewall Attributes.

 
      		 [bookmark: pgfId-99867]Hardware Client Attributes, which configure the VPN 3002 Hardware Client settings in an Easy VPN or remote access VPN. For more information, see ASA Group Policies Hardware Client Attributes.

 
      		 [bookmark: pgfId-99872]IPsec settings, which specify tunneling protocols, filters, connection settings, and servers for the user group in an Easy VPN or remote access VPN. For more information, see ASA Group Policies IPSec Settings.

 
      		 [bookmark: pgfId-99877]Clientless settings, which configure the Clientless mode of access to the corporate network in an SSL VPN, for the ASA user group. For more information, see ASA Group Policies SSL VPN Clientless Settings.

 
      		 [bookmark: pgfId-99882]Full Client settings, which configure the Full Client mode of access to the corporate network in an SSL VPN, for the ASA user group. For more information, see ASA Group Policies SSL VPN Full Client Settings.

 
      		 [bookmark: pgfId-99887]General settings that are required for Clientless/Port Forwarding in an SSL VPN. For more information, see ASA Group Policies SSL VPN Settings.

 
      		 [bookmark: pgfId-99892]DNS/WINS settings that define the DNS and WINS servers and the domain name that should be pushed to remote clients associated with the ASA user group. For more information, see ASA Group Policies DNS/WINS Settings.

 
      		 [bookmark: pgfId-99897]Split tunneling that lets a remote client conditionally direct packets over an IPsec or SSL VPN tunnel in encrypted form or to a network interface in clear text form. For more information, see ASA Group Policies Split Tunneling Settings.

 
      		 [bookmark: pgfId-99902]Remote access or SSL VPN session connection settings for the ASA user group. For more information, see ASA Group Policies Connection Settings.

 
     

 
     [bookmark: pgfId-99904]Related Topics

 
      
      		 [bookmark: pgfId-99909]Creating Group Policies (ASA, PIX 7.0+)

 
      		 [bookmark: pgfId-99914]Configuring Group Policies for Remote Access VPNs

 
     

 
    
 
     
      [bookmark: pgfId-99936][bookmark: 78610][bookmark: ravpnch_proc_CreatingGroupPolicies]Creating Group Policies (ASA, PIX 7.0+)[bookmark: marker-99920][bookmark: marker-99922][bookmark: marker-99924][bookmark: marker-99926][bookmark: marker-99928][bookmark: marker-99930][bookmark: marker-99932][bookmark: marker-99934]

 
     [bookmark: pgfId-99938]Use the Group Policies page to create group policies for ASA or PIX 7.0+ devices used in remote access IPSec VPNs, or ASA devices used in remote access SSL VPNs. For information about group policies, see:

 
      
      		 [bookmark: pgfId-99943]Understanding Group Policies (ASA)

 
      		 [bookmark: pgfId-99948]Configuring Group Policies for Remote Access VPNs

 
     

 
     
 
     [bookmark: pgfId-99950]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-99952](Device view) With an ASA or PIX 7.0+ device selected, select  Remote Access VPN > Group Policies from the Policy selector.

 
      		 [bookmark: pgfId-99954](Policy view) Select  Remote Access VPN > Group Policies (ASA) from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-99956]The Group Policies page opens. The table lists the existing group policies, whether they are defined internally on the device or externally on a AAA server, and the protocol for the group: IKEv1 (IPsec), IKEv2 (IPsec), or SSL.

 
     [bookmark: pgfId-99958]Step 2 Click Add Row (+) to open a dialog box from which you can select a user group from a list of predefined ASA user group objects, or create new ones if necessary. To create a new group, click the Create (+) button in the dialog box.

 
     [bookmark: pgfId-99960]Step 3 Select the required ASA user group from the list and click OK. If the required group already exists, you are finished.

 
     [bookmark: pgfId-99965]If the required ASA user group does not exist, create it by clicking Create (+). The Add ASA User Group dialog box appears, displaying a list of settings that you can configure for the ASA user group object. For a description of the elements on this dialog box, see ASA Group Policies Dialog Box.

 
     [bookmark: pgfId-99967]Step 4 Enter a name for the object and optionally a description of the object.

 
     [bookmark: pgfId-99969]Step 5 Select whether to store the ASA user group’s attributes and values locally on the device, or on an external server.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-99971]Note If you selected to store the ASA user group’s attributes on an external server, you do not need to configure any Technology settings. After you specify the AAA server group that will be used for authentication and a password to the AAA server, click OK and then select the group in the object selector and click OK to add it to the policy.


     
      

     

     

 
     [bookmark: pgfId-99973]Step 6 If you selected to store the ASA user group’s attributes locally on the device, select the type of VPN for which you are creating the ASA user group from the Technology list:

 
      
      		 [bookmark: pgfId-99975]Easy VPN/IPSec IKEv1—For remote access IPsec VPNs that use IKE version 1 negotiations.

 
      		 [bookmark: pgfId-99977]Easy VPN/IPSec IKEv2—(ASA only.) For remote access IPsec VPNs that use IKE version 2 negotiations.

 
      		 [bookmark: pgfId-99979]SSL Clientless—(ASA only.) For SSL VPNs, all access modes (not just clientless).

 
     

 
     [bookmark: pgfId-99981]Step 7 To configure the user group for Easy VPN/IPSec IKEv1 and Easy VPN/IPSec IKEv2, from the Easy VPN/IPSec VPN folder in the Settings pane:

 
     [bookmark: pgfId-99986] a. Select Client Configuration to configure the Cisco client parameters. For a description of these settings, see ASA Group Policies Client Configuration Settings.

 
     [bookmark: pgfId-99991] b. Select Client Firewall Attributes to configure the firewall settings for VPN clients. For a description of these settings, see ASA Group Policies Client Firewall Attributes.

 
     [bookmark: pgfId-99996] c. Select Hardware Client Attributes to configure the VPN 3002 Hardware Client settings. For a description of these settings, see ASA Group Policies Hardware Client Attributes.

 
     [bookmark: pgfId-100001] d. Select IPsec to specify tunneling protocols, filters, connection settings, and servers. For a description of these settings, see ASA Group Policies IPSec Settings.

 
     [bookmark: pgfId-100003]Step 8 To configure the user group for an SSL VPN, from the SSL VPN folder in the Settings pane:

 
     [bookmark: pgfId-100008] a. Select Clientless to configure the Clientless mode of access to the corporate network in an SSL VPN. For a description of these settings, see ASA Group Policies SSL VPN Clientless Settings.

 
     [bookmark: pgfId-100013] b. Select Full Client to configure the Full Client mode of access to the corporate network in an SSL VPN. For a description of these settings, see ASA Group Policies SSL VPN Full Client Settings.

 
     [bookmark: pgfId-100018] c. Select Settings to configure the general settings that are required for clientless and thin client (port forwarding) access modes in an SSL VPN. For a description of these settings, see ASA Group Policies SSL VPN Settings.

 
     [bookmark: pgfId-100020]Step 9 Specify the following settings for an ASA user group in an Easy VPN/IPSec IKEv1 or IKEv2 VPN and SSL VPN configuration, in the Settings pane:

 
     [bookmark: pgfId-100025] a. Select DNS/WINS to define the DNS and WINS servers and the domain name that should be pushed to clients associated with the ASA user group. For a description of these settings, see ASA Group Policies DNS/WINS Settings.

 
     [bookmark: pgfId-100030] b. Select Split Tunneling to allow a remote client to conditionally direct encrypted packets through a secure tunnel to the central site and simultaneously allow clear text tunnels to the Internet through a network interface. For a description of these settings, see ASA Group Policies Split Tunneling Settings.

 
     [bookmark: pgfId-100035] c. Select Connection Settings to configure the SSL VPN connection settings for the ASA user group, such as the session and idle timeouts, including the banner text. For a description of these settings, see ASA Group Policies Connection Settings.

 
     [bookmark: pgfId-100037]Step 10 Click OK.

 
     [bookmark: pgfId-100039]Step 11 Select the ASA user group from the list and click OK.

 
     [bookmark: pgfId-100041]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-100057][bookmark: 78748][bookmark: ravpnch_cncpt_UnderstandingSSLServerVerification]Understanding SSL VPN Server Verification (ASA)[bookmark: marker-100047][bookmark: marker-100049][bookmark: marker-100051][bookmark: marker-100053][bookmark: marker-100055]

 
    [bookmark: pgfId-100059]When connecting to a remote SSL-enabled server through clientless SSL VPN, it is important to know that you can trust the remote server, and that it is in fact the server you are trying to connect to. ASA 9.0 introduces support for SSL server certificate verification against a list of trusted certificate authority (CA) certificates for clientless SSL VPN.

 
    [bookmark: pgfId-100061]When you connect to a remote server via a web browser using the HTTPS protocol, the server will provide a digital certificate signed by a CA to identify itself. Web browsers ship with a collection of CA certificates which are used to verify the validity of the server certificate. This is a form of public key infrastructure (PKI).

 
    [bookmark: pgfId-100063]Just as browsers provide certificate management facilities, so does the ASA in the form of trusted certificate pool management facility: trustpools. This can be thought of as a special case of trustpoint representing multiple known CA certificates. The ASA includes a default bundle of certificates, similar to that provided with web browsers, but it is inactive until activated by the administrator.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-100065]Note If you are already familiar with trustpools from Cisco IOS then you should be aware that the ASA version is similar, but not identical.


    
     

    

    

 
    [bookmark: pgfId-100067]For more information on managing trusted certificates, see the following topics:

 
     
     		 [bookmark: pgfId-100072]Configuring SSL VPN Server Verification (ASA)

 
     		 [bookmark: pgfId-100077]Configuring Trusted Pool Settings (ASA)

 
     		 [bookmark: pgfId-100082]Using the Trustpool Manager

 
    

 
     
      [bookmark: pgfId-100098][bookmark: 78784][bookmark: ravpnch_cncpt_TrustedPoolSettings]Configuring Trusted Pool Settings (ASA)[bookmark: marker-100088][bookmark: marker-100090][bookmark: marker-100092][bookmark: marker-100094][bookmark: marker-100096]

 
     [bookmark: pgfId-100100]Use the Trusted Pool Settings page to configure options for certificate revocation. You can also launch the Trustpool Manager.

 
     [bookmark: pgfId-100102]Navigation Path

 
     [bookmark: pgfId-100104](Device View only) Select an ASA device; then select Remote Access VPN > Trusted Pool from the Policy selector.

 
     [bookmark: pgfId-100106]Related Topics

 
      
      		 [bookmark: pgfId-100111]Configuring SSL VPN Server Verification (ASA)

 
      		 [bookmark: pgfId-100116]Using the Trustpool Manager

 
     

 
     [bookmark: pgfId-100118]Field Reference

 
     [bookmark: pgfId-100121] 

 
      
       
        
        [bookmark: pgfId-96798]Table 31-12 [bookmark: 78822]Trusted Pool Page 

 
        
       
         
         		
           
           [bookmark: pgfId-96804]Element
          
  
         		
           
           [bookmark: pgfId-96806]Description
          
  
        

 
         
         		[bookmark: pgfId-96812]Revocation Check

  
         		[bookmark: pgfId-96814]Whether to check certificates for revocation. Select the appropriate option:

 
           
           		 [bookmark: pgfId-96816] Check Certificates 

 
          

 [bookmark: pgfId-96818]If you select this option, also specify the method or methods to use for revocation by selecting the appropriate method (CRL or OCSP) and moving it to the box on the right by clicking >>.

 [bookmark: pgfId-96820]Note You can choose either or both methods. If choosing both methods, add the methods in the order in which you want them used.

 
           
           		 [bookmark: pgfId-96822] Do not check Certificates 

 
          

  
        

 
         
         		[bookmark: pgfId-96828]Certificate Map Settings

  
         		[bookmark: pgfId-96830]Optionally, specify override options for a certificate map by selecting the map from the following lists. Each list will include all certificate maps that are configured on the device.

 
           
           		 [bookmark: pgfId-96832] Allow Expired Certificates —Select the certificate map for which you want to allow expired certificates.

 
           		 [bookmark: pgfId-96834] Skip Revocation Check —Select the certificate map for which you want to skip revocation check.

 
          

  
        

 
         
         		[bookmark: pgfId-96840]CRL Options

  
         		[bookmark: pgfId-96842]Specifies options for managing the Certificate Revocation List:

 
           
           		 [bookmark: pgfId-96844] Cache Refresh Time —The number of minutes (1-1440) before the ASA considers a CRL too old to be reliable. The default value is 60 minutes.

 
           		 [bookmark: pgfId-96846] Enforce next CRL update —Whether the ASA should enforce the next CRL update.

 
          

  
        

 
         
         		[bookmark: pgfId-96852]Certificate Expiration Alerts

  
         		[bookmark: pgfId-96854]Beginning with version 4.9, Security Manager enables checking all CA and ID certificates in the trust points for expiration once every 24 hours. If a certificate is nearing expiration, a syslog will be issued as an alert. You can configure the reminder and recurrence intervals. This feature is supported only in devices running ASA software version 9.4(1) or higher.

 [bookmark: pgfId-96856]Begin—Enter the number of days before the expiration in which the first alert will be sent. The range is 1 to 90 days. By default, reminders will start at 60 days prior to expiration.

 [bookmark: pgfId-96858]Repeat—Enter the frequency, in number of days, at which the alert will be repeated if the certificate is not renewed. The range is 1 to 14 days. By default reminders will be sent every 7 days.

  
        

 
         
         		[bookmark: pgfId-96864]Launch Trustpool Manager

  
         		[bookmark: pgfId-96866]Launches the Trustpool Manager, which is used to manage Trustpool certificates. You can use the Trustpool Manager to perform the following:

 [bookmark: pgfId-96871]For more information, see Using the Trustpool Manager.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-100143][bookmark: 78888][bookmark: ravpnch_cncpt_TrustPoolManager]Using the Trustpool Manager[bookmark: marker-100133][bookmark: marker-100135][bookmark: marker-100137][bookmark: marker-100139][bookmark: marker-100141]

 
     [bookmark: pgfId-100145]Use the Trustpool Manager to manage the certificates that are included in the trustpool. The Trustpool Manager provides the following functions:

 
      
      		 [bookmark: pgfId-100147]Updating the trustpool

 
      		 [bookmark: pgfId-100149]Importing a certificate bundle

 
      		 [bookmark: pgfId-100151]Exporting a certificate bundle

 
      		 [bookmark: pgfId-100153]Removing certificates from the trustpool

 
     

 
     [bookmark: pgfId-100155]Navigation Path

 
     [bookmark: pgfId-100157](Device View only) Select an ASA device, select Remote Access VPN > Trusted Pool from the Policy selector, and then click Launch Trustpool Manager.

 
     [bookmark: pgfId-100159]Updating the Trustpool

 
     [bookmark: pgfId-100161]The trustpool should be updated if either of the following conditions exists:

 
      
      		 [bookmark: pgfId-100163]Any certificate in the trustpool is due to expire or has been re-issued.

 
      		 [bookmark: pgfId-100165]The published CA certificate bundle contains additional certificates that are required by a specific application.

 
     

 
     [bookmark: pgfId-100167]To update the certificates in the trustpool, click Refresh Certificates.

 
     [bookmark: pgfId-100169]Importing a Certificate Bundle

 
     [bookmark: pgfId-100171]You can import individual certificates or bundles of certificates from a variety of locations in one of the following formats:

 
      
      		 [bookmark: pgfId-100173]x509 certificates in DER format wrapped in a pkcs7 structure

 
      		 [bookmark: pgfId-100175]a file of concatenated x509 certificates in PEM format (complete with PEM header)

 
     

 
     [bookmark: pgfId-100177]To import a certificate or bundle:

 
     [bookmark: pgfId-100179] 1. Click Import Bundle.

 
     [bookmark: pgfId-100181] 2. Select the location of the bundle:

 
     [bookmark: pgfId-100183] – Import from Cisco published signed root file distribution—Select this option to import from the published distribution site.

 
     [bookmark: pgfId-100185] – Import from a URL—If the bundle is hosted on a server, select this option, select the protocol from the list, and enter the URL in the box.

 
     [bookmark: pgfId-100187] – Bundle file on device—If the bundle is stored on the ASA flash file system, select this option and then enter the path to the bundle.

 
     [bookmark: pgfId-100189] – Select bundle file—If the bundle is stored on your machine, click Import from a file, then click Browse Local Files and navigate to the bundle.

 
     [bookmark: pgfId-100191] – Import default bundle—Select this option to import the default bundle.

 
     [bookmark: pgfId-100193] 3. Specify the following import options:

 
     [bookmark: pgfId-100195] – Clear all certificates before import—Whether to clear the trustpool before importing the bundle.

 
     [bookmark: pgfId-100197] – Continue to import the bundle if signature validation fails or can’t be performed—Whether to continue import if the signature can not be validated.

 
     [bookmark: pgfId-100199] 4. Click Import.

 
     [bookmark: pgfId-100201]Exporting a Certificate Bundle

 
     [bookmark: pgfId-100203]When you have correctly configured the Trustpool you should export the pool. This will enable you to restore the Trustpool to this point, for example if you wish to remove a certificate that was added to the trustpool after the export. You can export the pool to the Security Manager server file system or your local file system.

 
     [bookmark: pgfId-100205]To export the certificate bundle:

 
     [bookmark: pgfId-100207] 1. Click Export Bundle.

 
     [bookmark: pgfId-100209] 2. Click Browse.

 
     [bookmark: pgfId-100211] 3. Select the tab that corresponds to the file system you want to export to (local machine or Security Manager server).

 
     [bookmark: pgfId-100213] 4. Navigate to the folder where you want to save the trustpool.

 
     [bookmark: pgfId-100215] 5. Enter a unique memorable name for the trustpool in the File name box.

 
     [bookmark: pgfId-100217] 6. Click Save.

 
     [bookmark: pgfId-100219]Removing Certificates from the Trustpool

 
     [bookmark: pgfId-100221]You can remove certificates from the trustpool using the following methods:

 
      
      		 [bookmark: pgfId-100223]To remove an individual certificate, select the certificate and click  Delete .

 
      		 [bookmark: pgfId-100225]To remove all certificates that are not part of the default bundle, click  Clear Trustpool .

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-100227]Note Before clearing the trustpool you should export the current trustpool so that you can restore your current settings if needed.


     
      

     

     

 
     [bookmark: pgfId-100229]Related Topics

 
      
      		 [bookmark: pgfId-100234]Configuring SSL VPN Server Verification (ASA)

 
      		 [bookmark: pgfId-100239]Configuring Trusted Pool Settings (ASA)

 
     

 
    
 
   
 
    
     [bookmark: pgfId-100251][bookmark: 79022][bookmark: ravpnpg_cncpt_AddEditUsernameCertScripts]Add/Edit Scripts Dialog Box[bookmark: marker-100249]

 
    [bookmark: pgfId-100253]Use the Add/Edit Scripts dialog box to define a script to use in mapping the username from the certificate.

 
    [bookmark: pgfId-100255]Navigation Path

 
     
     		 [bookmark: pgfId-100257](Device view) Select an ASA device, then select  Remote Access VPN > Username from Cert Scripts from the Policy selector.

 
     		 [bookmark: pgfId-100259](Policy view) Select  Remote Access VPN > Username from Cert Scripts (ASA) from the Policy selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-100261]Field Reference

 
    [bookmark: pgfId-100264] 

 
     
      
       
       [bookmark: pgfId-96884]Table 31-13 [bookmark: 79042]Add/Edit Scripts Dialog Box 

 
       
      
        
        		
          
          [bookmark: pgfId-96890]Element
         
  
        		
          
          [bookmark: pgfId-96892]Description
         
  
       

 
        
        		[bookmark: pgfId-96898]Script Name

  
        		[bookmark: pgfId-96900]Specify the name of the script and use the script in the tunnel group AAA authentication and authorization. The script name may be different for authentication and authorization. You define the script here, and CLI uses the same script to perform this function.

  
       

 
        
        		[bookmark: pgfId-96906]Select Script Parameters

  
        		[bookmark: pgfId-96908]Specify the attributes and content of the script.

  
       

 
        
        		[bookmark: pgfId-96914]Value for Username

  
        		[bookmark: pgfId-96916]Select an attribute from the drop-down list of standard DN attributes to use as the username (Subject DN).

  
       

 
        
        		[bookmark: pgfId-96922]No Filtering

  
        		[bookmark: pgfId-96924]Specify that you want to use the entire specified DN name.

  
       

 
        
        		[bookmark: pgfId-96930]Filter by Substring

  
        		[bookmark: pgfId-96932]Specify the Starting Index (the position in the string of the first character to match) and Ending Index (number of characters to search). If you choose this option, the starting index cannot be blank. If you leave the ending index blank, it defaults to -1, indicating that the entire string is searched for a match.

  
       

 
        
        		[bookmark: pgfId-96938]Filter by Regular Expression

  
        		[bookmark: pgfId-96940]Enter a regular expression to apply to the search in the Regular Expression field. Standard regular expression operators apply.

  
       

 
        
        		[bookmark: pgfId-96946]Use Custom Script in LUA format

  
        		[bookmark: pgfId-96948]Specify a custom script written in the LUA programming language to parse the search fields. Selecting this option makes available a field in which you can enter your custom LUA script.

 [bookmark: pgfId-96950]The following are examples of custom scripts in LUA format:

 
          
          		 [bookmark: pgfId-96952]"return findpattern(cert.subject.cn,"%a+")"

 
          		 [bookmark: pgfId-96954]local a,b,c;

 
         

 [bookmark: pgfId-96956]a,b,c = string.find( cert.subject.fulldn, ’,cn=(.+),cn=Users’);

 [bookmark: pgfId-96958]return c;

 [bookmark: pgfId-96960]Note LUA is case-sensitive.

 
          
           
            
            [bookmark: pgfId-96975]Table 31-14 [bookmark: 79098]Attributes in an LUA script 

 
            
           
             
             		
               
               [bookmark: pgfId-96981]Attribute
              
  
             		
               
               [bookmark: pgfId-96983]Description
              
  
            

 
             
             		[bookmark: pgfId-96989]cert.subject.c

  
             		[bookmark: pgfId-96991]Country

  
            

 
             
             		[bookmark: pgfId-96997]cert.subject.cn

  
             		[bookmark: pgfId-96999]Common Name

  
            

 
             
             		[bookmark: pgfId-97005]cert.subject.dnq

  
             		[bookmark: pgfId-97007]DN qualifier

  
            

 
             
             		[bookmark: pgfId-97013]cert.subject.ea

  
             		[bookmark: pgfId-97015]E-mail Address

  
            

 
             
             		[bookmark: pgfId-97021]cert.subject.genq

  
             		[bookmark: pgfId-97023]Generational qualified

  
            

 
             
             		[bookmark: pgfId-97029]cert.subject.gn

  
             		[bookmark: pgfId-97031]Given Name

  
            

 
             
             		[bookmark: pgfId-97037]cert.subject.i

  
             		[bookmark: pgfId-97039]Initials

  
            

 
             
             		[bookmark: pgfId-97045]cert.subject.l

  
             		[bookmark: pgfId-97047]Locality

  
            

 
             
             		[bookmark: pgfId-97053]cert.subject.n

  
             		[bookmark: pgfId-97055]Name

  
            

 
             
             		[bookmark: pgfId-97061]cert.subject.o

  
             		[bookmark: pgfId-97063]Organization

  
            

 
             
             		[bookmark: pgfId-97069]cert.subject.ou

  
             		[bookmark: pgfId-97071]Organization Unit

  
            

 
             
             		[bookmark: pgfId-97077]cert.subject.ser

  
             		[bookmark: pgfId-97079]Subject Serial Number

  
            

 
             
             		[bookmark: pgfId-97085]cert.subject.sn

  
             		[bookmark: pgfId-97087]Surname

  
            

 
             
             		[bookmark: pgfId-97093]cert.subject.sp

  
             		[bookmark: pgfId-97095]State/Province

  
            

 
             
             		[bookmark: pgfId-97101]cert.subject.t

  
             		[bookmark: pgfId-97103]Title

  
            

 
             
             		[bookmark: pgfId-97109]cert.subject.uid

  
             		[bookmark: pgfId-97111]User ID

  
            

 
             
             		[bookmark: pgfId-97117]cert.issuer.c

  
             		[bookmark: pgfId-97119]Country

  
            

 
             
             		[bookmark: pgfId-97125]cert.issuer.cn

  
             		[bookmark: pgfId-97127]Common Name

  
            

 
             
             		[bookmark: pgfId-97133]cert.issuer.dnq

  
             		[bookmark: pgfId-97135]DN qualifier

  
            

 
             
             		[bookmark: pgfId-97141]cert.issuer.ea

  
             		[bookmark: pgfId-97143]E-mail Address

  
            

 
             
             		[bookmark: pgfId-97149]cert.issuer.genq

  
             		[bookmark: pgfId-97151]Generational qualified

  
            

 
             
             		[bookmark: pgfId-97157]cert.issuer.gn

  
             		[bookmark: pgfId-97159]Given Name

  
            

 
             
             		[bookmark: pgfId-97165]cert.issuer.i

  
             		[bookmark: pgfId-97167]Initials

  
            

 
             
             		[bookmark: pgfId-97173]cert.issuer.l

  
             		[bookmark: pgfId-97175]Locality

  
            

 
             
             		[bookmark: pgfId-97181]cert.issuer.n

  
             		[bookmark: pgfId-97183]Name

  
            

 
             
             		[bookmark: pgfId-97189]cert.issuer.o

  
             		[bookmark: pgfId-97191]Organization

  
            

 
             
             		[bookmark: pgfId-97197]cert.issuer.ou

  
             		[bookmark: pgfId-97199]Organization Unit

  
            

 
             
             		[bookmark: pgfId-97205]cert.issuer.ser

  
             		[bookmark: pgfId-97207]Issuer Serial Number

  
            

 
             
             		[bookmark: pgfId-97213]cert.issuer.sn

  
             		[bookmark: pgfId-97215]Surname

  
            

 
             
             		[bookmark: pgfId-97221]cert.issuer.sp

  
             		[bookmark: pgfId-97223]State/Province

  
            

 
             
             		[bookmark: pgfId-97229]cert.issuer.t

  
             		[bookmark: pgfId-97231]Title

  
            

 
             
             		[bookmark: pgfId-97237]cert.issuer.uid

  
             		[bookmark: pgfId-97239]User ID

  
            

 
             
             		[bookmark: pgfId-97245]cert.serialnumber

  
             		[bookmark: pgfId-97247]Certificate Serial Number

  
            

 
             
             		[bookmark: pgfId-97253]cert.subjectaltname.upn

  
             		[bookmark: pgfId-97255]User Principal Name

  
            

 
           
          

 
         
  
          
           [bookmark: pgfId-100275][bookmark: 79279][bookmark: ravpnch_cncpt_WorkingWithPoliciesIPSecVPNPolicies]Working with IPSec VPN Policies[bookmark: marker-100273]

 
          [bookmark: pgfId-100280]Certain policies need to be configured for IPSec VPNs. The topics listed below explain these remote access IPsec VPN policies, with the exception of the IKE Proposal policy, which is explained in Configuring an IKE Proposal.

 
          [bookmark: pgfId-100282]This section contains the following topics:

 
           
           		 [bookmark: pgfId-100287]Configuring Certificate to Connection Profile Map Policies (ASA)

 
           		 [bookmark: pgfId-100292]Configuring an IPsec Proposal on a Remote Access VPN Server (ASA, PIX 7.0+ Devices)

 
          

 
           
            [bookmark: pgfId-100310][bookmark: 79286][bookmark: ravpnch_proc_ConfiguringaCertificateToConnectionProfileMapPolicyASA]Configuring Certificate to Connection Profile Map Policies (ASA)[bookmark: marker-100300][bookmark: marker-100302][bookmark: marker-100304][bookmark: marker-100306][bookmark: marker-100308]

 
           [bookmark: pgfId-100312]Certificate to connection profile map policies are used for enhanced certificate authentication on ASA devices in remote access IKEv1 IPSec VPNs. They are not used in remote access IKEv2 IPSec or SSL VPNs.

 
           [bookmark: pgfId-100314]Certificate to connection profile map policies let you define rules to match a user’s certificate to a permission group based on specified fields. To establish authentication, you can use any field of the certificate, or you can have all certificate users share a permission group. You can match the group from the DN rules, the Organization Unit (OU) field, the IKE identity, or the peer IP address. You can use any or all of these methods.

 
           [bookmark: pgfId-100316]To match user permission groups based on DN fields of the certificate, you define rules that specify the fields to match for a group and then enable each rule for that selected group. A connection profile must already exist in the configuration before you can create a rule for it.

 
           [bookmark: pgfId-100318]This procedure describes how to configure a Certificate to Connection Profile Map policy for a remote client trying to connect to an ASA server device.

 
           
 
           [bookmark: pgfId-100320]Step 1 Do one of the following:

 
            
            		 [bookmark: pgfId-100322](Device View) Select an ASA device; then select  Remote Access VPN > IPSec VPN > Certificate to Connection Profile Maps > Policies from the Policy selector.

 
            		 [bookmark: pgfId-100324](Policy View) Select  Remote Access VPN > IPSec VPN > Certificate to Connection Profile Maps > Policies from the Policy Type selector. Select an existing policy or create a new one.

 
           

 
           [bookmark: pgfId-100326]The Certificate to Connection Profile Map Policies page opens.

 
           [bookmark: pgfId-100328]Step 2 Select any, or all, of the following options to establish authentication and to determine to which connection profile (tunnel group) to map the client:

 
            
            		 [bookmark: pgfId-100333] Use Configured Rules to Match a Certificate to a Group —To use the rules defined in the Certificate to Connection Profile Maps > Rules policy. For information on configuring the rules, see Configuring Certificate to Connection Profile Map Rules (ASA).

 
            		 [bookmark: pgfId-100335] Use Certificate Organization Unit (OU) Field to Determine the Group —To use the organizational unit (OU) field of the client certificate.

 
            		 [bookmark: pgfId-100337] Use IKE Identify to Determine the Group —To use the IKE identity.

 
            		 [bookmark: pgfId-100339] Use Peer IP address to Determine the Group —To use the peer’s IP address.

 
           

 
           [bookmark: pgfId-100341]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-100359][bookmark: 79342][bookmark: ravpnch_proc_ConfiguringaCertificateToConnectionProfileMapRuleASA]Configuring Certificate to Connection Profile Map Rules (ASA)[bookmark: marker-100349][bookmark: marker-100351][bookmark: marker-100353][bookmark: marker-100355][bookmark: marker-100357]

 
           [bookmark: pgfId-100364]If you configure certificate to connection profile maps, and select the option to Use Configured Rules to Match a Certificate to a Group (as explained in Configuring Certificate to Connection Profile Map Policies (ASA)), you need to configure the rules required to match a user to a connection profile based on the user certificate.

 
           [bookmark: pgfId-100366]To match user permission groups based on fields of the certificate, you define rules that specify the fields to match for a group and then enable each rule for that selected group. You must first define a connection profile (tunnel group) before you can create and map a rule to it.

 
           [bookmark: pgfId-100368]This procedure describes how to configure the Certificate to Connection Profile Map rules and parameters for any remote client trying to connect to an ASA server device.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-100370]Tip Certificate to connection profile map policies apply to remote access IKEv1 IPSec VPNs only. They do not apply to IKEv2 or SSL VPNs.


           
            

           

           

 
           [bookmark: pgfId-100372]Before You Begin

 
            
            		 [bookmark: pgfId-100377]Make sure the connection profiles for which you are creating mapping rules has been configured on the device. See Configuring Connection Profiles (ASA, PIX 7.0+).

 
            		 [bookmark: pgfId-100382]Make sure that you select  Use Configured Rules to Match a Certificate to a Group in the Certificate to Connection Profile Maps Policies policy. See Configuring Certificate to Connection Profile Map Policies (ASA).

 
           

 
           
 
           [bookmark: pgfId-100384]Step 1 (Device view only) With an ASA device selected, select Remote Access VPN > IPSec VPN > Certificate to Connection Profile Maps > Rules from the Policy selector.

 
           [bookmark: pgfId-100386]The Certificate to Connection Profile Map Rules page is displayed. The policy has two tables:

 
            
            		 [bookmark: pgfId-100388] Maps table (upper table) —The upper table lists all connection profiles for which you are defining certificate to connection map rules. Each row is a profile map, which includes the name of the connection profile that is being mapped, the priority of the map (lower numbers have higher priority), and the map name. You can configure more than one map for the same connection profile.

 
           

 
           [bookmark: pgfId-100390] – To configure rules for a map, select it and then use the rules table to create, edit, and delete the rules.

 
           [bookmark: pgfId-100395] – To add a map, click the Add Row button and fill in the Map Rule Dialog Box (Upper Table).

 
           [bookmark: pgfId-100397] – To edit map properties (not rules), select it and click the Edit Row button.

 
           [bookmark: pgfId-100399] – To delete an entire map, select it and click the Delete Row button.

 
            
            		 [bookmark: pgfId-100401] Rules table (lower table) —The rules for the map selected in the upper table. You must ensure that the map is actually selected in the upper table: the group title above the rules table should say “ Details for (Connection Profile Name) .”

 
           

 
           [bookmark: pgfId-100403]When you select a map, the table shows all rules configured for the map, including the field (subject or issuer), certificate component, matching operator, and the value that the rule is looking for. The remote user must match all configured rules in a map for the device to use the mapped connection profile.

 
           [bookmark: pgfId-100408] – To add a rule, click the Add Row button and fill in the Map Rule Dialog Box (Lower Table).

 
           [bookmark: pgfId-100410] – To edit a rule, select it and click the Edit Row button.

 
           [bookmark: pgfId-100412] – To delete a rule, select it and click the Delete Row button.

 
           [bookmark: pgfId-100414]Step 2 To add a rule to a map:

 
           [bookmark: pgfId-100416] a. Select the map in the upper table.

 
           [bookmark: pgfId-100418]If the map does not already exist, create it by clicking the Add Row (+) button beneath the upper table and fill in the Map Rule dialog box for creating maps. In the dialog box, you must select the connection profile for the map, assign a relative priority between 1 and 65535 (lower numbers have higher priority), and a unique map name.

 
           [bookmark: pgfId-100420] b. Ensure that the map is actually selected. Highlighting the map in the table is not sufficient. The heading above the lower table should be “Details for (Connection Profile Name),” and unless the map is new, the table should show some rules.

 
           [bookmark: pgfId-100422] c. To add a new certificate to connection profile matching rule that must be satisfied in order for a remote client to connect to the device using the profile in this map, click the Add Row (+) button beneath the lower table. This opens the Map Rule dialog box with different fields.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-100424]Note If you get the error message “Missing Settings, A value ID required for Mapping field, Please select a Mapping,” it means that you have not successfully selected a map in the upper table. Click on the desired map again.


           
            

           

           

 
           [bookmark: pgfId-100426] d. From the Field list, select whether the rule should examine the Subject or Issuer field of the client certificate.

 
           [bookmark: pgfId-100428] e. From the Component list, select the component of the client certificate to use for the matching rule.

 
           [bookmark: pgfId-100430] f. From the Operator field, select how the component should be compared to the Value field: Equals (exact match is required), Contains (the entire value must appear), Does Not Equal, Does Not Contain.

 
           [bookmark: pgfId-100432] g. In the Value field, specify the value to match, then click OK to save the rule.

 
           [bookmark: pgfId-100434] h. Add additional rules to the map as desired.

 
           [bookmark: pgfId-100436]Step 3 In the Default Connection Profile field, select the connection profile that should be used for users who do not meet any of the map rules.

 
           [bookmark: pgfId-100438]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-100448][bookmark: 79454][bookmark: ravpnpag_cncpt_CertificatetoConnectionProfileMaps_RulesPageUpperPane]Map Rule Dialog Box (Upper Table)[bookmark: marker-100446]

 
           [bookmark: pgfId-100453]Use the Map Rule dialog box, when opened for the maps table in the upper part of the Certificate to Connection Profile Maps > Rules policy, to configure maps for which you can then configure rules in the lower table of the Rules policy. For a detailed explanation of configuring these maps and their associated rules, see Configuring Certificate to Connection Profile Map Rules (ASA).

 
           [bookmark: pgfId-100455]Navigation Path

 
           [bookmark: pgfId-100457](Device View only) Select an ASA device; then select Remote Access VPN > Certificate to Connection Profile Maps > Rules from the Policy selector. Click the Add Row button beneath the upper table, or select a map in the upper table and click Edit Row.

 
           [bookmark: pgfId-100459]Field Reference

 
           [bookmark: pgfId-100462] 

 
            
             
              
              [bookmark: pgfId-97268]Table 31-15 [bookmark: 79472]Map Rule Dialog Box (Upper Table) 

 
              
             
               
               		
                 
                 [bookmark: pgfId-97274]Element
                
  
               		
                 
                 [bookmark: pgfId-97276]Description
                
  
              

 
               
               		[bookmark: pgfId-97282]Map Name

  
               		[bookmark: pgfId-97284]The name of the connection profile map.

  
              

 
               
               		[bookmark: pgfId-97290]Priority

  
               		[bookmark: pgfId-97292]The priority number of the matching rule, between 1 and 65535. A lower number has a higher priority. For example, a matching rule with a priority number of 2, has a higher priority than a matching rule with a priority number of 5.

 [bookmark: pgfId-97294]If you create multiple maps, they are processed in priority order, and the first matching rule determines to which profile the user is mapped.

  
              

 
               
               		[bookmark: pgfId-97300]Connection Profile

  
               		[bookmark: pgfId-97302]Select the connection profile for IPSec and for SSL for which you are creating matching rules. You must select either or both connection profiles. Clients attempting to connect to the connection profiles must satisfy the associated matching rule conditions to connect to the device.

  
              

 
             
            

 
           
 
          
 
           
            [bookmark: pgfId-100472][bookmark: 79499][bookmark: ravpnpag_cncpt_CertificatetoConnectionProfileMaps_RulesPageLowerPane]Map Rule Dialog Box (Lower Table)[bookmark: marker-100470]

 
           [bookmark: pgfId-100477]Use the Map Rule dialog box, when opened for the rules table in the lower part of the Certificate to Connection Profile Maps > Rules policy, to configure rules for the map selected in the maps table (upper table of the Rules policy). For a detailed explanation of configuring these rules, see Configuring Certificate to Connection Profile Map Rules (ASA).

 
           [bookmark: pgfId-100479]Navigation Path

 
           [bookmark: pgfId-100481](Device View only) Select an ASA device; then select Remote Access VPN > IPSec VPN > Certificate to Connection Profile Maps > Rules from the Policy selector. Click the Add Row button beneath the lower table, or select a rule in the lower table and click Edit Row.

 
           [bookmark: pgfId-100483]Field Reference

 
           [bookmark: pgfId-100486] 

 
            
             
              
              [bookmark: pgfId-97315]Table 31-16 [bookmark: 79517]Map Rule Dialog Box (Lower Table) 

 
              
             
               
               		
                 
                 [bookmark: pgfId-97321]Element
                
  
               		
                 
                 [bookmark: pgfId-97323]Description
                
  
              

 
               
               		[bookmark: pgfId-97329]Field

  
               		[bookmark: pgfId-97331]Select the field for the matching rule according to the Subject or the Issuer of the client certificate.

  
              

 
               
               		[bookmark: pgfId-97337]Component

  
               		[bookmark: pgfId-97339]Select the component of the client certificate to use for the matching rule.

  
              

 
               
               		[bookmark: pgfId-97345]Operator

  
               		[bookmark: pgfId-97347]Select the operator for the matching rule as follows:

 
                 
                 		 [bookmark: pgfId-97349]Equals—The certificate component must match the entered value. If they do not match exactly, the connection is denied.

 
                 		 [bookmark: pgfId-97351]Contains—The certificate component must contain the entered value. If the component does not contain the value, the connection is denied.

 
                 		 [bookmark: pgfId-97353]Does Not Equal—The certificate component  cannot equal the entered value. For example, for a selected certificate component of Country, and an entered value of US, if the client county value equals US, then the connection is denied.

 
                 		 [bookmark: pgfId-97355]Does Not Contain—The certificate component  cannot contain the entered value. For example, for a selected certificate component of Country, and an entered value of US, if the client county value contains US, the connection is denied.

 
                

  
              

 
               
               		[bookmark: pgfId-97361]Value

  
               		[bookmark: pgfId-97363]The value of the matching rule. The value entered is associated with the selected component and operator.

  
              

 
             
            

 
           
 
          
 
           
            [bookmark: pgfId-100500][bookmark: 79562][bookmark: ravpnch_proc_ConfiguringanIPsecProposalonaRemoteAccessVPNServer]Configuring an IPsec Proposal on a Remote Access VPN Server (ASA, PIX 7.0+ Devices)[bookmark: marker-100494][bookmark: marker-100496][bookmark: marker-100498]

 
           [bookmark: pgfId-100505]This procedure describes how to create or edit an IPsec proposal for your remote access VPN server when the server is an ASA or PIX 7.0+ device. If you are configuring an IPsec proposal for IOS or PIX 6.3 devices, including Catalyst 6500/7600 devices, see Configuring an IPsec Proposal on a Remote Access VPN Server (IOS, PIX 6.3 Devices)

 
           [bookmark: pgfId-100507]An IPsec proposal is a collection of one or more crypto maps. A crypto map combines all the components required to set up IPsec security associations (SAs), including IPsec rules, transform sets, remote peers, and other parameters that might be necessary to define an IPsec SA.

 
           [bookmark: pgfId-100509]When configuring an IPsec proposal, you must define the external interface through which the remote access clients connect to the server, the IKE version to use during IKE negotiation, and the encryption and authentication algorithms that protect the data in the VPN tunnel. You can also enable reverse route injection and NAT traversal.

 
           [bookmark: pgfId-100514]For more information on IPsec tunnel concepts, see Understanding IPsec Proposals.

 
           [bookmark: pgfId-100516]Related Topics

 
            
            		 [bookmark: pgfId-100521]Table Columns and Column Heading Features

 
           

 
           
 
           [bookmark: pgfId-100523]Step 1 Do one of the following:

 
            
            		 [bookmark: pgfId-100525](Device view) Select  Remote Access VPN > IPSec VPN > IPsec Proposal (ASA/PIX 7.x) from the Policy selector.

 
            		 [bookmark: pgfId-100527](Policy view) Select  Remote Access VPN > IPSec VPN > IPsec Proposal (ASA/PIX 7.x) from the Policy Type selector. Select an existing policy or create a new one.

 
           

 
           [bookmark: pgfId-100529]The IPsec Proposal page opens and lists the configured proposals, including the VPN endpoint, IPsec transform set, and whether reverse route injection is configured for the proposal.

 
           [bookmark: pgfId-100531]Step 2 Do any of the following:

 
            
            		 [bookmark: pgfId-100536]To add a new IPsec proposal, click the  Add Row (+) button and fill in the IPsec Proposal Editor dialog box. For detailed information on the available options, see IPsec Proposal Editor (ASA, PIX 7.0+ Devices).

 
            		 [bookmark: pgfId-100538]To edit an existing proposal, select it and click the  Edit Row (pencil) button.

 
            		 [bookmark: pgfId-100540]To delete a proposal, select it and click the  Delete Row (trash can) button.

 
           

 
           [bookmark: pgfId-100542]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-100564][bookmark: 79616][bookmark: ravpnpag_cncpt_IPsecProposalEditorDialogBoxforPIXandASADevices]IPsec Proposal Editor (ASA, PIX 7.0+ Devices)[bookmark: marker-100550][bookmark: marker-100552][bookmark: marker-100554][bookmark: marker-100556][bookmark: marker-100558][bookmark: marker-100560][bookmark: marker-100562]

 
           [bookmark: pgfId-100566]Use the IPsec Proposal Editor to create or edit an IPsec proposal for an ASA or PIX 7.0+ device.

 
           [bookmark: pgfId-100568]The elements in this dialog box differ according to the selected device. The table below describes the elements on the General tab in the IPsec Proposal Editor dialog box when an ASA or PIX 7.0+ device is selected.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-100573]Note For a description of the elements in the dialog box when a PIX 7.0+ or ASA device is selected is selected, see IPsec Proposal Editor (IOS, PIX 6.3 Devices).


           
            

           

           

 
           [bookmark: pgfId-100575]Navigation Path

 
            
            		 [bookmark: pgfId-100577](Device view) Select  Remote Access VPN > IPSec VPN > IPsec Proposal (ASA/PIX 7.x) from the Policy selector. Click the Add Row (+) or Edit Row (pencil) buttons.

 
            		 [bookmark: pgfId-100579](Policy view) Select  Remote Access VPN > IPSec VPN > IPsec Proposal (ASA/PIX 7.x) from the Policy Type selector. Select an existing policy or create a new one. Click the Add Row (+) or Edit Row (pencil) buttons.

 
           

 
           [bookmark: pgfId-100581]Related Topics

 
            
            		 [bookmark: pgfId-100586]Configuring an IPsec Proposal on a Remote Access VPN Server (ASA, PIX 7.0+ Devices)

 
            		 [bookmark: pgfId-100591]Understanding IPsec Proposals

 
            		 [bookmark: pgfId-100596]Creating Interface Role Objects

 
            		 [bookmark: pgfId-100601]Creating AAA Server Group Objects

 
           

 
           [bookmark: pgfId-100603]Field Reference

 
           [bookmark: pgfId-100606] 

 
            
             
              
              [bookmark: pgfId-97376]Table 31-17 [bookmark: 79678]IPsec Proposal Editor, ASA and PIX 7.0+ Devices) 

 
              
             
               
               		
                 
                 [bookmark: pgfId-97382]Element
                
  
               		
                 
                 [bookmark: pgfId-97384]Description
                
  
              

 
               
               		[bookmark: pgfId-97390]External Interface

  
               		[bookmark: pgfId-97392]The external interface through which remote access clients will connect to the server. Enter the name of the interface or interface role object, or click Select to select it or to create a new object.

  
              

 
               
               		[bookmark: pgfId-97398]Enable IKEv1

 [bookmark: pgfId-97400]Enable IKEv2

  
               		[bookmark: pgfId-97402]The IKE versions to use during IKE negotiations. IKEv2 is supported on ASA Software release 8.4(1)+ only with Anyconnect 3.0+ clients. Select either or both options as appropriate.

  
              

 
               
               		[bookmark: pgfId-97408]Enable Client Services

 [bookmark: pgfId-97410]Client Services Port Number

  
               		[bookmark: pgfId-97412]Available only if you enable IKEv2.

 [bookmark: pgfId-97414]Whether to enable the Client Services Server on the ASA for this connection. The Client Services Server provides HTTPS (SSL) access to allow the AnyConnect Downloader to receive software upgrades, profiles, localization and customization files, CSD, SCEP, and other file downloads required by the AnyConnect client. If you select this option, specify the client services port number, which is 443 by default.

 [bookmark: pgfId-97416]If you do not enable the Client Services Server, users will not be able to download any of these files that the AnyConnect client might need.

 [bookmark: pgfId-97418]Tip You can use the same port that you use for SSL VPN running on the same device. Even if you have an SSL VPN configured, you must select this option to enable file downloads over SSL for IKEv2 IPsec clients.  
              

 
               
               		[bookmark: pgfId-97424]IKEv1 Transform Sets

 [bookmark: pgfId-97426]IKEv2 Transform Sets

  
               		[bookmark: pgfId-97431]The transform sets to use for your tunnel policy. Transform sets specify which authentication and encryption algorithms will be used to secure the traffic in the tunnel. The transform sets are different for each IKE version; select objects for each supported version. You can select up to 11 transform sets for each. For more information, see Understanding Transform Sets.

 [bookmark: pgfId-97433]If more than one of your selected transform sets is supported by both peers, the transform set that provides the highest security will be used.

 [bookmark: pgfId-97438]Click Select to select the IPsec transform set policy objects to use in the topology. If the required object is not yet defined, you can click the Create (+) button beneath the available objects list in the selection dialog box to create a new one. For more information, see Configuring IPSec IKEv1 or IKEv2 Transform Set Policy Objects.

  
              

 
               
               		[bookmark: pgfId-97444]Reverse Route Injection

  
               		[bookmark: pgfId-97449]Reverse Route Injection (RRI) enables static routes to be automatically inserted into the routing process for those networks and hosts protected by a remote tunnel endpoint. For more information, see Understanding Reverse Route Injection.

 [bookmark: pgfId-97451]Select one of the following options to configure RRI on the crypto map:

 
                 
                 		 [bookmark: pgfId-97453] None —Disables the configuration of RRI on the crypto map.

 
                 		 [bookmark: pgfId-97455] Standard —Creates routes based on the destination information defined in the crypto map access control list (ACL). This is the default option.

 
                

  
              

 
               
               		[bookmark: pgfId-97461]Enable Network Address Translation Traversal

  
               		[bookmark: pgfId-97463]Whether to allow Network Address Translation traversal (NAT-T).

 [bookmark: pgfId-97468]Use NAT traversal when there is a device between a VPN-connected hub and spoke that performs Network Address Translation (NAT) on the IPsec traffic. For information about NAT traversal, see Understanding NAT in VPNs

  
              

 
               
               		 [bookmark: pgfId-97474]ESPv3 Settings (ASA 9.0.1+ only)

 [bookmark: pgfId-97476]Specify whether incoming ICMP error messages are validated for cryptography and dynamic cryptography maps, set the per-security association policy, or enable traffic flow packets:

  
              

 
               
               		[bookmark: pgfId-97484]Validate Incoming ICMP error messages

  
               		[bookmark: pgfId-97486]Whether to validate those ICMP error messages received through an IPsec tunnel and destined for an interior host on the private network.

  
              

 
               
               		[bookmark: pgfId-97492]Enable Do Not Fragment (DF) Policy

  
               		[bookmark: pgfId-97494]Define how the IPsec subsystem handles large packets that have the do-not-fragment (DF) bit set in the IP header. Choose one of the following:

 
                 
                 		 [bookmark: pgfId-97496]Set—Sets and uses the DF bit.

 
                 		 [bookmark: pgfId-97498]Copy—Maintains the DF bit.

 
                 		 [bookmark: pgfId-97500]Clear—Ignores the DF bit.

 
                

  
              

 
               
               		[bookmark: pgfId-97506]Enable Traffic Flow Confidentiality (TFC) Packets

  
               		[bookmark: pgfId-97508]Enable dummy TFC packets that mask the traffic profile which traverses the tunnel.

 [bookmark: pgfId-97510]Note You must have an IKEv2 IPsec proposal set on the Tunnel Policy (Crypto Map) Basic tab before enabling TFC. Traffic Flow Confidentiality is not available when IKEv1 is enabled.

 [bookmark: pgfId-97512]Use the Burst, Payload Size, and Timeout parameters to generate random length packets at random intervals across the specified SA.

  
              

 
             
            

 
           
 
          
 
         
 
          
           [bookmark: pgfId-100618][bookmark: 79775][bookmark: ravpnch_cncpt_WorkingWithSSLVPNPolicies]Working with SSL and IKEv2 IPSec VPN Policies[bookmark: marker-100612][bookmark: marker-100614][bookmark: marker-100616]

 
          [bookmark: pgfId-100620]Certain policies need to be configured for SSL VPNs. These policies are also used with remote access IKEv2 IPSec VPNs. The topics listed below explain these remote access VPN policies.

 
          [bookmark: pgfId-100622]This section contains the following topics:

 
           
           		 [bookmark: pgfId-100627]Understanding SSL VPN Access Policies (ASA)

 
           		 [bookmark: pgfId-100632]Configuring Other SSL VPN Settings (ASA)

 
           		 [bookmark: pgfId-100637]Configuring SSL VPN Shared Licenses (ASA 8.2+)

 
          

 
           
            [bookmark: pgfId-100659][bookmark: 79788][bookmark: ravpnch_cncpt_UnderstandingSSLVPNAccessASA]Understanding SSL VPN Access Policies (ASA)[bookmark: marker-100643][bookmark: marker-100645][bookmark: marker-100647][bookmark: marker-100649][bookmark: marker-100651][bookmark: marker-100653][bookmark: marker-100655][bookmark: marker-100657]

 
           [bookmark: pgfId-100661]An Access policy specifies the security appliance interfaces on which a remote access SSL or IKEv2 IPsec VPN connection profile can be enabled, the port to be used for the connection profile, Datagram Transport Layer Security (DTLS) settings, the SSL VPN session timeout and maximum number of sessions. You can also specify whether to use the AnyConnect VPN Client or AnyConnect Essentials Client.

 
           [bookmark: pgfId-100666]For more information about the Anyconnect VPN Client, see Understanding SSL VPN AnyConnect Client Settings. The remainder of this topic explains DTLS and AnyConnect Essentials in more detail.

 
           [bookmark: pgfId-100668]Datagram Transport Layer Security (DTLS)

 
           [bookmark: pgfId-100670]Enabling Datagram Transport Layer Security (DTLS) allows the AnyConnect client establishing an SSL VPN connection to use two simultaneous tunnels—an SSL tunnel and a DTLS tunnel. Using DTLS avoids latency and bandwidth problems associated with SSL connections and improves the performance of real-time applications that are sensitive to packet delays. By default, DTLS is enabled when SSL VPN access is enabled on an interface. If you disable DTLS, SSL VPN connections connect with an SSL VPN tunnel only.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-100672]Note In order for DTLS to fall back to a TLS connection, you must specify a fallback trustpoint. If you do not specify a fallback trustpoint and the DTLS connection experiences a problem, the connection terminates instead of falling back to the specified trustpoint.


           
            

           

           

 
           [bookmark: pgfId-100674]AnyConnect Essentials VPN Client

 
           [bookmark: pgfId-100676]AnyConnect Essentials is a separately licensed VPN client for SSL or IKEv2 IPsec, entirely configured on the adaptive security appliance, that provides the full AnyConnect capability, with the following exceptions:

 
            
            		 [bookmark: pgfId-100678]No CSD (including HostScan/Vault/Cache Cleaner)

 
            		 [bookmark: pgfId-100680]No clientless SSL VPN

 
            		 [bookmark: pgfId-100682]Optional Windows Mobile Support

 
           

 
           [bookmark: pgfId-100684]The AnyConnect Essentials client provides remote end users running Microsoft Windows Vista, Windows Mobile, Windows XP or Windows 2000, Linux, or Macintosh OS X, with the benefits of a Cisco VPN client. If this feature is disabled, the full AnyConnect VPN client is used. This feature is disabled by default.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-100686]Note This license cannot be used at the same time as the shared license for SSL VPN.


           
            

           

           

 
           [bookmark: pgfId-100688]This section contains the following topics:

 
            
            		 [bookmark: pgfId-100693]SSL VPN Access Policy Page

 
            		 [bookmark: pgfId-100698]Configuring an Access Policy

 
           

 
          
 
           
            [bookmark: pgfId-100724][bookmark: 79840][bookmark: ravpnpg_cncpt_SSLVPNAccessPolicyPage]SSL VPN Access Policy Page[bookmark: marker-100706][bookmark: marker-100708][bookmark: marker-100710][bookmark: marker-100712][bookmark: marker-100714][bookmark: marker-100716][bookmark: marker-100718][bookmark: marker-100720][bookmark: marker-100722]

 
           [bookmark: pgfId-100729]Use the SSL VPN Access Policy page to configure access parameters for your remote access SSL or IKEv2 IPsec VPN. For more information about configuring an Access policy, see Configuring an Access Policy.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-100734]Tip Any trustpoints that you specify in this policy must also be selected in the Public Key Infrastructure policy. For more information, see Configuring Public Key Infrastructure Policies for Remote Access VPNs.


           
            

           

           

 
           [bookmark: pgfId-100736]Navigation Path

 
            
            		 [bookmark: pgfId-100738](Device View) Select  Remote Access VPN > SSL VPN > Access from the Policy selector.

 
            		 [bookmark: pgfId-100740](Policy View) Select  Remote Access VPN > SSL VPN > Access (ASA) from the Policy Type selector. Select an existing policy or create a new one.

 
           

 
           [bookmark: pgfId-100742]Related Topics

 
            
            		 [bookmark: pgfId-100747]Understanding SSL VPN Access Policies (ASA)

 
            		 [bookmark: pgfId-100752]Understanding Interface Role Objects

 
           

 
           [bookmark: pgfId-100754]Field Reference

 
           [bookmark: pgfId-100757] 

 
            
             
              
              [bookmark: pgfId-97525]Table 31-18 [bookmark: 79903]SSL VPN Access Policy Page 

 
              
             
               
               		
                 
                 [bookmark: pgfId-97531]Element
                
  
               		
                 
                 [bookmark: pgfId-97533]Description
                
  
              

 
               
               		[bookmark: pgfId-97539]Access Interface Table

  
               		[bookmark: pgfId-97541]The Access Interface table lists the interfaces that are configured for remote access SSL or IKEv2 IPSec VPN connections. The table displays the access settings for each interface: whether the interface is enabled to allow VPN access, whether DTLS is enabled, whether client certificates are required, and the trustpoints used by the interface.

 
                 
                 		 [bookmark: pgfId-97546]To configure access on an interface, click the  Add row (+) button (see Access Interface Configuration Dialog Box).

 
                 		 [bookmark: pgfId-97551]To edit access settings for an interface, select the interface and click the  Edit Row (pencil) button (see Access Interface Configuration Dialog Box).

 
                 		 [bookmark: pgfId-97553]To delete access settings for an interface, select the interface and click the  Delete Row (trash can) button.

 
                

  
              

 
               
               		[bookmark: pgfId-97559]Server Name Indication Table

  
               		[bookmark: pgfId-97561]The Server Name Indication table lists the Server Name Indication mappings that have been defined.

 
                 
                 		 [bookmark: pgfId-97566]To define a Server Name Indication mapping, click the  Add row (+) button (see Server Name Indication Dialog Box).

 
                 		 [bookmark: pgfId-97571]To edit an existing mapping, select the mapping and click the  Edit Row (pencil) button (see Server Name Indication Dialog Box).

 
                 		 [bookmark: pgfId-97573]To delete a Server Name Indication mapping, select the mapping and click the  Delete Row (trash can) button.

 
                

  
              

 
               
               		[bookmark: pgfId-97579]Port Number

  
               		[bookmark: pgfId-97581]The port to use for VPN sessions. The default port is 443, for HTTPS traffic. If HTTP port redirection is enabled, the default HTTP port number is 80. To specify a non-default port, the range is 1024 through 65535.

 [bookmark: pgfId-97583]Enter the port number or the name of a port list object, or click Select to select a port list object or to create a new object.

 [bookmark: pgfId-97585]Note If you change the port number, all current SSL VPN connections terminate (upon configuration deployment), and current users must reconnect.

  
              

 
               
               		[bookmark: pgfId-97591]DTLS Port Number

  
               		[bookmark: pgfId-97596]The UDP port to use for DTLS connections. The default port is 443. For details about DTLS, see Understanding SSL VPN Access Policies (ASA).

 [bookmark: pgfId-97598]Enter the port number or the name of a port list object, or click Select to select a port list object or to create a new object.

  
              

 
               
               		[bookmark: pgfId-97604]Fallback Trustpoint

  
               		[bookmark: pgfId-97606]The trustpoint (Certificate Authority, or CA server) to use for interfaces that do not have an assigned trustpoint. Enter the name of a PKI enrollment object, or click Select to select the object from a list or to create a new object.

  
              

 
               
               		[bookmark: pgfId-97612]Default Idle Timeout

  
               		[bookmark: pgfId-97614]The amount of time, in seconds, that an SSL or IKEv2 IPSec VPN session can be idle before the security appliance terminates it.

 [bookmark: pgfId-97616]This value applies only if the Idle Timeout value in the group policy for the user is set to zero (0), which means there is no timeout value; otherwise the group policy Idle Timeout value takes precedence over the timeout you configure here. The minimum value you can enter is 60 seconds (1 minute). The default is 30 minutes (1800 seconds). The maximum is 24 hours (86400 seconds).

 [bookmark: pgfId-97618]We recommend that you set this attribute to a short time period. This is because a browser set to disable cookies (or one that prompts for cookies and then denies them) can result in a user not connecting but nevertheless appearing in the sessions database. If the Simultaneous Logins attribute for the group policy is set to one, the user cannot log back in because the database indicates that the maximum number of connections already exists. Setting a low idle timeout removes such phantom sessions quickly, and lets a user log in again.

  
              

 
               
               		[bookmark: pgfId-97624]Max Session Limit

  
               		[bookmark: pgfId-97626]The maximum number of SSL or IKEv2 IPSec VPN sessions allowed. Be aware that the different ASA models have different maximum session limits:

 
                 
                 		 [bookmark: pgfId-97628]ASA 5505—25.

 
                 		 [bookmark: pgfId-97630]ASA 5510—250.

 
                 		 [bookmark: pgfId-97632]ASA 5520—750.

 
                 		 [bookmark: pgfId-97634]ASA 5540—2500.

 
                 		 [bookmark: pgfId-97636]ASA 5550, 5585-X with SSP-10—5000.

 
                 		 [bookmark: pgfId-97638]ASA 5580, 5585-X (other models)—10,000.

 
                

  
              

 
               
               		[bookmark: pgfId-97644]Certificate Authentication Timeout

 [bookmark: pgfId-97646](ASA 8.4(5) or ASA 9.1(2)+)

  
               		[bookmark: pgfId-97648]The amount of time, in minutes, to wait before timing out certificate authentication. Valid values are from 1 to 120 minutes.

  
              

 
               
               		[bookmark: pgfId-97654]Allow Users to Select Connection Profile in Portal Page

  
               		[bookmark: pgfId-97656]Whether to present a list of configured connection profiles (tunnel groups) from which the user can select the appropriate profile when the user logs in (for example, in the SSL VPN portal page). If you do not select this option, the user cannot select a profile and must use the default profile for the connection.

 [bookmark: pgfId-97658]Tip You must select this option for remote access IKEv2 IPSec VPNs. It is optional for SSL VPNs.  
              

 
               
               		[bookmark: pgfId-97664]Enable AnyConnect Access

  
               		[bookmark: pgfId-97669]Whether to allow the user to use the AnyConnect VPN client to make an SSL or IKEv2 IPSec VPN connection. The option is selected by default. For details about AnyConnect VPN clients, see Understanding SSL VPN AnyConnect Client Settings.

 [bookmark: pgfId-97671]Tip You must select this option for remote access IKEv2 IPSec VPNs. For SSL VPN, select this option if you want to enable full client access.  
              

 
               
               		[bookmark: pgfId-97677]Enable AnyConnect Essentials

  
               		[bookmark: pgfId-97682]Whether to enable the AnyConnect Essentials feature, which can be used with both SSL and IKEv2 IPSec VPNs. For details about AnyConnect Essentials VPN clients, see Understanding SSL VPN Access Policies (ASA).

  
              

 
             
            

 
           
 
          
 
           
            [bookmark: pgfId-100767][bookmark: 80019][bookmark: ravpnpg_cncpt_AccessInterfaceConfigurationDialogBox]Access Interface Configuration Dialog Box[bookmark: marker-100765]

 
           [bookmark: pgfId-100769]Use the Access Interface Configuration dialog box to configure an interface on an ASA device for remote access SSL or IKEv2 IPSec VPN connections.

 
           [bookmark: pgfId-100771]Navigation Path

 
           [bookmark: pgfId-100776]Open the SSL VPN Access policy (see SSL VPN Access Policy Page), then click Add Row below the interface table, or select a row in the table and click Edit Row.

 
           [bookmark: pgfId-100778]Related Topics

 
            
            		 [bookmark: pgfId-100783]Configuring an Access Policy

 
            		 [bookmark: pgfId-100788]Understanding Interface Role Objects

 
           

 
           [bookmark: pgfId-100790]Field Reference

 
           [bookmark: pgfId-100793] 

 
            
             
              
              [bookmark: pgfId-97695]Table 31-19 [bookmark: 80044]Access Interface Configuration Dialog Box 

 
              
             
               
               		
                 
                 [bookmark: pgfId-97701]Element
                
  
               		
                 
                 [bookmark: pgfId-97703]Description
                
  
              

 
               
               		[bookmark: pgfId-97709]Access Interface

  
               		[bookmark: pgfId-97711]The interface or interface role object on which you want to configure SSL or IKEv2 IPSec VPN access. Enter the name of the interface or interface role, or click Select to select one from a list or to create new interface role objects.

  
              

 
               
               		[bookmark: pgfId-97717]Trustpoint

 [bookmark: pgfId-97719]Load Balancing Trustpoint

  
               		[bookmark: pgfId-97721]The trustpoint (Certificate Authority, or CA server) to use for authenticating users on the interface. Enter the name of a PKI enrollment object, or click Select to select one or to create a new object.

 [bookmark: pgfId-97723]If load balancing is configured, you can also select a separate PKI enrollment object for the load balancing trustpoint.

  
              

 
               
               		[bookmark: pgfId-97729]Allow Access

  
               		[bookmark: pgfId-97731]Select this option to enable VPN access via this interface. If the option is not selected, access is configured on the interface, but it is disabled.

  
              

 
               
               		[bookmark: pgfId-97737]Enable DTLS

  
               		[bookmark: pgfId-97739]When selected, enables Datagram Transport Layer Security (DTLS) on the interface and allows an AnyConnect VPN Client to establish an SSL VPN connection using two simultaneous tunnels—an SSL tunnel and a DTLS tunnel.

  
              

 
             
            

 
           
 
          
 
           
            [bookmark: pgfId-100801][bookmark: 80079][bookmark: ravpnpg_cncpt_ServerNameIndicationDialogBox]Server Name Indication Dialog Box

 
           [bookmark: pgfId-100803]Beginning from version 4.8, Security Manager enables you to configure Server Name Indication mappings used by the enabled VPN interface for authentication. This capability includes the mapping of domain names to trustpoints.

 
           [bookmark: pgfId-100805]Use the Server Name Indication dialog box to define or modify a domain and trustpoint for each interface.

 
           [bookmark: pgfId-100807]NOTES:

 
            
            		 [bookmark: pgfId-100809]You can configure a unique domain name to a trustpoint. However, you can map a trustpoint to multiple domain names. You can configure a maximum of 16 unique trustpoints.

 
            		 [bookmark: pgfId-100811]Server Name Indication mapping of domain names to trustpoints is supported for devices that are running the ASA software version 9.3(2) or higher.

 
           

 
           [bookmark: pgfId-100813]Navigation Path

 
           [bookmark: pgfId-100818]Open the SSL VPN Access policy (see SSL VPN Access Policy Page), then click Add Row below the ServerNameIndication table, or select a row in the table and click Edit Row.

 
           [bookmark: pgfId-100820]Field Reference

 
           [bookmark: pgfId-100823] 

 
            
             
              
              [bookmark: pgfId-97752]Table 31-20 [bookmark: 80101]Server Name Indication Dialog Box 

 
              
             
               
               		
                 
                 [bookmark: pgfId-97758]Element
                
  
               		
                 
                 [bookmark: pgfId-97760]Description
                
  
              

 
               
               		[bookmark: pgfId-97766]Domain Mask

  
               		[bookmark: pgfId-97768]Enter the domain name that the trustpoint will be configured with. This domain will not be associated with any particular interface. A certificate with an associated domain may be used by any interface.

  
              

 
               
               		[bookmark: pgfId-97774]Trustpoint

  
               		[bookmark: pgfId-97776]The trustpoint (Certificate Authority, or CA server) to use for authenticating users on the interface. Enter the name of a PKI enrollment object, or click Select to select one or to create a new object.

  
              

 
             
            

 
           
 
          
 
           
            [bookmark: pgfId-100845][bookmark: 80124][bookmark: ravpnch_proc_ConfiguringanAccessPolicy]Configuring an Access Policy[bookmark: marker-100829][bookmark: marker-100831][bookmark: marker-100833][bookmark: marker-100835][bookmark: marker-100837][bookmark: marker-100839][bookmark: marker-100841][bookmark: marker-100843]

 
           [bookmark: pgfId-100850]This procedure describes how to configure an Access policy on an ASA device. Access policies are required for remote access SSL and IKEv2 IPSec VPN connections. For more information about access policies, see Understanding SSL VPN Access Policies (ASA).

 
           
 
           [bookmark: pgfId-100852]Step 1 Do one of the following:

 
            
            		 [bookmark: pgfId-100854](Device view) With an ASA device selected, select  Remote Access VPN > SSL VPN > Access from the Policy selector.

 
            		 [bookmark: pgfId-100856](Policy view) Select  Remote Access VPN > SSL VPN > Access (ASA) from the Policy Type selector. Select an existing policy or create a new one.

 
           

 
           [bookmark: pgfId-100861]The Access page opens. For a description of the elements on this page, see SSL VPN Access Policy Page.

 
           [bookmark: pgfId-100863]Step 2 In the interface table at the top of the policy, configure all of the interfaces on which you will allow remote access SSL or IKEv2 IPSec VPN connections:

 
            
            		 [bookmark: pgfId-100865]To add an interface, click the  Add Row (+) button beneath the table and fill in the Add Access Interface Configuration dialog box. You must specify the interface name (or an interface role object that identifies the desired interfaces) and whether to allow access on the interface.

 
           

 
           [bookmark: pgfId-100870]You can also specify the PKI enrollment object that identifies the Certificate Authority (CA) server trustpoint for the interface (and a load balancing trustpoint if you use load balancing), whether to enable DTLS connections, and whether to require that the client have a valid certificate to complete a connection. For details about the options, see Access Interface Configuration Dialog Box.

 
            
            		 [bookmark: pgfId-100872]To edit the settings for an interface, select it and click the  Edit Row (pencil) button.

 
            		 [bookmark: pgfId-100874]To delete an interface, select it and click the  Delete Row button. Keep in mind that you can edit the interface settings to disable access, so you should delete an interface only if you want to permanently remove it from VPN use.

 
           

 
           [bookmark: pgfId-100879]Step 3 Configure the remaining settings. The settings are described in detail in SSL VPN Access Policy Page. The following are the settings that are of particular interest:

 
            
            		 [bookmark: pgfId-100881] Fallback Trustpoint —The Certificate Authority (CA) server trustpoint to use if an interface does not have a trustpoint configured in the table. Enter the name of a PKI enrollment object, or click  Select to select one or to create a new object.

 
            		 [bookmark: pgfId-100883] Allow Users to Select Connection Profile in Portal Page —If you have multiple tunnel groups, selecting this option allows the user to select the correct tunnel group during login. You must select this option for IKEv2 IPSec VPNs.

 
            		 [bookmark: pgfId-100885] Enable AnyConnect Access —The AnyConnect VPN client is a full client; you must enable AnyConnect access if you want to allow full client access to the VPN. You must select this option for IKEv2 IPSec VPNs.

 
           

 
           [bookmark: pgfId-100890]For more information about AnyConnect, including AnyConnect Essentials, see Understanding SSL VPN AnyConnect Client Settings.

 
            
            		 [bookmark: pgfId-100892] Enable AnyConnect Essentials —Select this option if you are using AnyConnect Essentials clients, which you can use with remote access SSL or IKEv2 IPSec VPNs.

 
           

 
           [bookmark: pgfId-100897]Step 4 Any trustpoints that you specify in this policy must also be selected in the Public Key Infrastructure policy. For more information, see Configuring Public Key Infrastructure Policies for Remote Access VPNs.

 
           [bookmark: pgfId-100899]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-100919][bookmark: 80212][bookmark: ravpnch_cncpt_ConfiguringOtherSettings]Configuring Other SSL VPN Settings (ASA)[bookmark: marker-100907][bookmark: marker-100909][bookmark: marker-100911][bookmark: marker-100913][bookmark: marker-100915][bookmark: marker-100917]

 
           [bookmark: pgfId-100921]The SSL VPN Other Settings policy for ASA devices defines settings that include caching, content rewriting, character encoding, proxy and proxy bypass definitions, browser plug-ins, AnyConnect client images and profiles, Kerberos Constrained Delegation, and some other advanced settings.

 
           [bookmark: pgfId-100923]To configure the Other Settings policy, do one of the following:

 
            
            		 [bookmark: pgfId-100925](Device View) Select  Remote Access VPN > SSL VPN > Other Settings from the Policy selector.

 
            		 [bookmark: pgfId-100927](Policy View) Select  Remote Access VPN > SSL VPN > Other Settings (ASA) from the Policy Type selector. Select an existing policy or create a new one.

 
           

 
           [bookmark: pgfId-100929]You can then configure the settings on the following tabs:

 
            
            		 [bookmark: pgfId-100934]Performance tab—To configure caching to improve SSL VPN performance. See Configuring SSL VPN Performance Settings (ASA).

 
            		 [bookmark: pgfId-100939]Content Rewrite tab—To create rules that permit users to browse certain sites and applications without going through the security appliance itself. See Configuring SSL VPN Content Rewrite Rules (ASA).

 
            		 [bookmark: pgfId-100944]Encoding tab—To configure non-default encoding for web pages delivered from CIFS servers. Encoding is normally determined by the remote user’s browser. See Configuring SSL VPN Encoding Rules (ASA).

 
            		 [bookmark: pgfId-100949]Proxy tab—To define HTTP or HTTPS proxy servers, if your network requires them, and proxy bypass rules. See Configuring SSL VPN Proxies and Proxy Bypass (ASA).

 
            		 [bookmark: pgfId-100954]Plug In tab—To define browser plug-ins, which are separate programs that a web browser invokes to perform a dedicated function. See Configuring SSL VPN Browser Plug-ins (ASA).

 
            		 [bookmark: pgfId-100956]Client Settings tab—To configure AnyConnect client images and profiles for downloading to clients. See the following topics:

 
           

 
           [bookmark: pgfId-100961] – Understanding SSL VPN AnyConnect Client Settings

 
           [bookmark: pgfId-100966] – Configuring SSL VPN AnyConnect Client Settings (ASA)

 
            
            		 [bookmark: pgfId-100968]Microsoft KCD Server—To configure Kerberos Constrained Delegation (KCD) for use with clientless SSL VPN connections. See the following topics:

 
           

 
           [bookmark: pgfId-100973] – Understanding Kerberos Constrained Delegation (KCD) for SSL VPN (ASA)

 
           [bookmark: pgfId-100978] – Configuring Kerberos Constrained Delegation (KCD) for SSL VPN (ASA)

 
            
            		 [bookmark: pgfId-100983]AnyConnect Custom Attributes tab—To configure AnyConnect custom attributes. See Configuring AnyConnect Custom Attributes (ASA).

 
            		 [bookmark: pgfId-100988]Advanced tab—To configure the memory, on-screen keyboard, and internal password features. See Configuring SSL VPN Advanced Settings (ASA).

 
            		 [bookmark: pgfId-100993]SSL Server Verification tab—To enable HTTPS server verification for clientless SSL VPN users. See Configuring SSL VPN Server Verification (ASA).

 
           

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-100998]Tip You must also configure a connection profile policy on the device. See Configuring Connection Profiles (ASA, PIX 7.0+).


           
            

           

           

 
          
 
           
            [bookmark: pgfId-101018][bookmark: 80293][bookmark: ravpnch_proc_ConfiguringOtherSettings_PerformanceTab]Configuring SSL VPN Performance Settings (ASA)[bookmark: marker-101006][bookmark: marker-101008][bookmark: marker-101010][bookmark: marker-101012][bookmark: marker-101014][bookmark: marker-101016]

 
           [bookmark: pgfId-101020]Caching enhances SSL VPN performance. It stores frequently reused objects in the system cache, which reduces the need to perform repeated rewriting and compressing of content. It reduces traffic between SSL VPN and both the remote servers and end-user browsers, with the result that many applications run much more efficiently.

 
           [bookmark: pgfId-101022]This procedure describes how to enable caching on your ASA security appliance.

 
           [bookmark: pgfId-101024]Related Topics

 
            
            		 [bookmark: pgfId-101029]Configuring Other SSL VPN Settings (ASA)

 
           

 
           
 
           [bookmark: pgfId-101031]Step 1 Do one of the following:

 
            
            		 [bookmark: pgfId-101033](Device view) With an ASA device selected, select  Remote Access VPN > SSL VPN > Other Settings from the Policy selector. Click the  Performance tab if it is not already selected.

 
            		 [bookmark: pgfId-101035](Policy view) Select  Remote Access VPN > SSL VPN > Other Settings (ASA) from the Policy Type selector. Select an existing policy or create a new one. Click the  Performance tab if it is not already selected.

 
           

 
           [bookmark: pgfId-101037]Step 2 Select Enable to enable caching on the security appliance.

 
           [bookmark: pgfId-101039]If you deselect this option, the cache settings configured on the security appliance do not take effect.

 
           [bookmark: pgfId-101041]Step 3 Configure the following options:

 
            
            		 [bookmark: pgfId-101043] Minimum Object Size —The minimum size of an HTTP object that can be stored in the cache on the security appliance, in kilobytes. The range is 0-10,000 KB. The default is 0 KB.

 
            		 [bookmark: pgfId-101045] Maximum Object Size —The maximum size of an HTTP object that can be stored in the cache on the security appliance, in kilobytes. The range is 0-10,000 KB. The default is 1000 KB. The maximum size must be larger than the minimum size.

 
            		 [bookmark: pgfId-101047] Last Modified Factor —An integer to set a revalidation policy for caching objects that have only the last-modified timestamp, and no other server-set expiration values. The range is 1-100. The default is 20.

 
           

 
           [bookmark: pgfId-101049]The Expires response from the origin web server to the security appliance request, which indicates the time that the response expires, also affects caching. This response header indicates the time that the response becomes stale and should not be sent to the client without an up-to-date check (using a conditional GET operation).

 
           [bookmark: pgfId-101051]The security appliance can also calculate an expiration time for each web object before it is written to disk. The algorithm to calculate an object’s cache expiration date is as follows:

 
           [bookmark: pgfId-101053]Expiration date = (Today’s date - Object’s last modified date) * Freshness factor

 
           [bookmark: pgfId-101055]After the expiration date has passed, the object is considered stale and subsequent requests causes a fresh retrieval of the content by the security appliance. Setting the last modified factor to zero is equivalent to forcing an immediate revalidation, while setting it to 100 results in the longest allowable time until revalidation.

 
            
            		 [bookmark: pgfId-101057] Expiration Time —The amount of time (in minutes) that the security appliance caches objects without revalidating them. The range is 0-900 minutes. The default is one minute.

 
           

 
           [bookmark: pgfId-101059]Revalidation consists of rejecting the objects from the origin server before serving the requested content to the client browser when the age of the cached object has exceeded its freshness lifetime. The age of a cached object is the time that the object has been stored in the security appliance’s cache without the security appliance explicitly contacting the origin server to check if the object is still fresh.

 
            
            		 [bookmark: pgfId-101061] Cache Static Content —Whether to cache static content on the security appliance. Each web page can include static and dynamic objects. The security appliance caches individual static objects, such as image files (*.gif, *.jpeg), java applets (.js), and cascading style sheets (*.css).

 
           

 
           [bookmark: pgfId-101063]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-101083][bookmark: 80369][bookmark: ravpnch_proc_ConfiguringOtherSettings_ContentRewriteTab]Configuring SSL VPN Content Rewrite Rules (ASA)[bookmark: marker-101071][bookmark: marker-101073][bookmark: marker-101075][bookmark: marker-101077][bookmark: marker-101079][bookmark: marker-101081]

 
           [bookmark: pgfId-101085]SSL VPN processes application traffic through a content transformation/rewriting engine that includes advanced elements (such as, JavaScript, VBScript, Java, and multi-byte characters) to proxy HTTP traffic depending on whether the user is using an application within or independently of an SSL VPN device.

 
           [bookmark: pgfId-101087]If you do not want some applications and web resources, such as public web sites, to go through the security appliance, you can create rewrite rules that permit users to browse certain sites and applications without going through the security appliance itself. This is similar to split tunneling in an IPsec VPN connection.

 
           [bookmark: pgfId-101089]In the Content Rewrite tab of the SSL VPN Other Settings page, you can configure multiple content rewrite rules. The Content Rewrite tab lists all applications for which content rewrite is enabled or disabled.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-101091]Tip The security appliance searches rewrite rules by order number, starting with the lowest, and applies the first rule that matches.


           
            

           

           

 
           [bookmark: pgfId-101093]This procedure shows you how to create or edit content rewrite rules.

 
           [bookmark: pgfId-101095]Related Topics

 
            
            		 [bookmark: pgfId-101100]Configuring Other SSL VPN Settings (ASA)

 
           

 
           
 
           [bookmark: pgfId-101102]Step 1 Do one of the following:

 
            
            		 [bookmark: pgfId-101104](Device view) With an ASA device selected, select  Remote Access VPN > SSL VPN > Other Settings from the Policy selector.

 
            		 [bookmark: pgfId-101106](Policy view) Select  Remote Access VPN > SSL VPN > Other Settings (ASA) from the Policy Type selector. Select an existing policy or create a new one.

 
           

 
           [bookmark: pgfId-101108]Step 2 On the Other Settings page, click the Content Rewrite tab. The Content Rewrite tab displays all applications for which content rewrite is enabled or disabled.

 
           [bookmark: pgfId-101110]The security appliance searches rewrite rules by order number, starting with the lowest, and applies the first rule that matches. The resource mask defines the application string to which the rule is matched.

 
           [bookmark: pgfId-101112]If a rule does not have a number, it is evaluated after all of the numbered rules.

 
           [bookmark: pgfId-101114]Step 3 Do any of the following:

 
            
            		 [bookmark: pgfId-101119]To add a rule, click the  Add Row button beneath the table and fill in the Add Content Rewrite dialog box. The options are described in detail in Add/Edit Content Rewrite Dialog Box.

 
            		 [bookmark: pgfId-101121]To edit a rule, select it, click the  Edit Row button, and make your changes in the Edit Content Rewrite dialog box.

 
            		 [bookmark: pgfId-101123]To delete a rule, select it and click the  Delete Row button. You are asked to confirm the deletion.

 
           

 
           [bookmark: pgfId-101125]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-101135][bookmark: 80436][bookmark: ravpnpg_cncpt_AddEditContentRewriteDialogBox]Add/Edit Content Rewrite Dialog Box[bookmark: marker-101133]

 
           [bookmark: pgfId-101140]Use the Add or Edit Content Rewrite dialog box to configure the rewriting engine that includes advanced elements such as JavaScript, VBScript, Java, and multi-byte characters to proxy HTTP traffic over a SSL VPN connection. For more information about content rewrite rules, see Configuring SSL VPN Content Rewrite Rules (ASA).

 
           [bookmark: pgfId-101142]Navigation Path

 
           [bookmark: pgfId-101147]From the Content Rewrite tab of the SSL VPN Other Settings policy for ASA devices, click the Add Row button, or select a rule and click the Edit Row button. For detailed information on opening the tab, see Configuring SSL VPN Content Rewrite Rules (ASA).

 
           [bookmark: pgfId-101149]Related Topics

 
            
            		 [bookmark: pgfId-101154]Configuring Other SSL VPN Settings (ASA)

 
           

 
           [bookmark: pgfId-101156]Field Reference

 
           [bookmark: pgfId-101159] 

 
            
             
              
              [bookmark: pgfId-97789]Table 31-21 [bookmark: 80459]Add or Edit Content Rewrite Dialog Box 

 
              
             
               
               		
                 
                 [bookmark: pgfId-97795]Element
                
  
               		
                 
                 [bookmark: pgfId-97797]Description
                
  
              

 
               
               		[bookmark: pgfId-97803]Enable

  
               		[bookmark: pgfId-97805]When selected, enables content rewriting on the security appliance for the rewrite rule.

 [bookmark: pgfId-97807]Some applications do not require this processing, such as external public web sites. For these applications, you might choose to turn off content rewriting.

  
              

 
               
               		[bookmark: pgfId-97813]Rule Number

  
               		[bookmark: pgfId-97815]The number for this rule. This number specifies the position of the rule in the list. Rules without a number are at the end of the list. The range is from 1 to 65534.

 [bookmark: pgfId-97817]Rules are processed from the lowest to the highest number, and the first match is applied to the traffic.

  
              

 
               
               		[bookmark: pgfId-97823]Rule Name

  
               		[bookmark: pgfId-97825]An alphanumeric string that describes the content rewrite rule. The maximum length is 128 characters.

  
              

 
               
               		[bookmark: pgfId-97831]Resource Mask

  
               		[bookmark: pgfId-97833]The name of the application or resource to which the rule applies. The maximum length is 300 characters.

 [bookmark: pgfId-97835]You can use the following wildcards:

 
                 
                 		 [bookmark: pgfId-97837]*—Matches everything. You cannot use this wildcard by itself. It must accompany an alphanumeric string.

 
                 		 [bookmark: pgfId-97839]?—Matches any single character.

 
                 		 [bookmark: pgfId-97841][!x-y]—Matches any character not in the sequence.

 
                 		 [bookmark: pgfId-97843][x-y]—Matches any character in the sequence.

 
                

  
              

 
             
            

 
           
 
          
 
           
            [bookmark: pgfId-101183][bookmark: 80503][bookmark: ravpnch_proc_ConfiguringOtherSettings_EncodingTab]Configuring SSL VPN Encoding Rules (ASA)[bookmark: marker-101169][bookmark: marker-101171][bookmark: marker-101173][bookmark: marker-101175][bookmark: marker-101177][bookmark: marker-101179][bookmark: marker-101181]

 
           [bookmark: pgfId-101185]Use the Encoding tab of the SSL VPN Other Settings page to specify the character set to encode in SSL VPN portal pages to be delivered to remote users. By default, the encoding type set on the remote browser determines the character set for SSL VPN portal pages, so you need to set the character encoding only if it is necessary to ensure proper encoding on the browser.

 
           [bookmark: pgfId-101187]Character encoding is the pairing of raw data (such as 0’s and 1’s) with characters to represent the data. The language determines the character encoding method to use. Some languages use the same method, while others do not. Usually, the geographic region determines the default encoding method used by the browser, but the remote user can change this. The browser can also detect the encoding specified on the page, and render the document accordingly.

 
           [bookmark: pgfId-101189]The encoding attribute lets you specify the value of the character encoding method in the SSL VPN portal page to ensure that the browser renders it properly, regardless of the region in which the user is using the browser, or any changes made to the browser.

 
           [bookmark: pgfId-101191]The character encoding attribute is a global setting that, by default, all SSL VPN portal pages inherit. However, you can override the file-encoding attribute for Common Internet File System (CIFS) servers that use character encoding that differs from the value of the character-encoding attribute. You can use different file-encoding values for CIFS servers that require different character encodings.

 
           [bookmark: pgfId-101193]The SSL VPN portal pages downloaded from the CIFS server to the SSL VPN user encode the value of the SSL VPN file-encoding attribute identifying the server, or if one does not, they inherit the value of the character encoding attribute. The remote user’s browser maps this value to an entry in its character encoding set to determine the proper character set to use. The SSL VPN portal pages do not specify a value if SSL VPN configuration does not specify a file encoding entry for the CIFS server and the character encoding attribute is not set. The remote browser uses its own default encoding if the SSL VPN portal page does not specify the character encoding, or if it specifies a character encoding value that the browser does not support.

 
           [bookmark: pgfId-101195]In the Encoding tab of the SSL VPN Global Settings page, you can view the currently configured character sets associated with the CIFS server to be encoded in the portal pages. From this tab, you can create or edit the character sets, as described in the following procedure.

 
           [bookmark: pgfId-101197]Related Topics

 
            
            		 [bookmark: pgfId-101202]Configuring Other SSL VPN Settings (ASA)

 
           

 
           
 
           [bookmark: pgfId-101204]Step 1 Do one of the following:

 
            
            		 [bookmark: pgfId-101206](Device view) With an ASA device selected, select  Remote Access VPN > SSL VPN > Other Settings from the Policy selector.

 
            		 [bookmark: pgfId-101208](Policy view) Select  Remote Access VPN > SSL VPN > Other Settings (ASA) from the Policy Type selector. Select an existing policy or create a new one.

 
           

 
           [bookmark: pgfId-101210]Step 2 On the Other Settings page, click the Encoding tab. The Encoding tab displays the default encoding and a list of CIFS servers for which encoding rules are configured.

 
           [bookmark: pgfId-101212]Step 3 From the Global SSL VPN Encoding Type list, select the attribute that determines the character encoding that all SSL VPN portal pages inherit, except for those from the CIFS servers listed in the table.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-101214]Note If you choose none or specify a value that the browser on the SSL VPN client does not support, the browser uses its own default encoding. The default global encoding is none.


           
            

           

           

 
           [bookmark: pgfId-101216]You can select from the following encoding types:

 
            
            		 [bookmark: pgfId-101218]big5

 
            		 [bookmark: pgfId-101220]gb2312

 
            		 [bookmark: pgfId-101222]ibm-850

 
            		 [bookmark: pgfId-101224]iso-8859-1

 
            		 [bookmark: pgfId-101226]shift_jis

 
           

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-101228]Note If you are using Japanese Shift_jis Character encoding, click Do not specify in the Font Family area of the associated Select Page Font pane to remove the font family.


           
            

           

           

 
            
            		 [bookmark: pgfId-101230]unicode

 
            		 [bookmark: pgfId-101232]windows-1252

 
            		 [bookmark: pgfId-101234]none

 
           

 
           [bookmark: pgfId-101236]Step 4 Do any of the following:

 
            
            		 [bookmark: pgfId-101238]To add a rule, click the  Add Row button beneath the table and configure the following settings in the Add File Encoding dialog box:

 
           

 
           [bookmark: pgfId-101240] – CIFS Server IP, CIFS Server Host—Select one of these options to specify the CIFS server either by IP address or hostname. If you select IP address, you can either enter the IP address or the name of a network/host object that specifies one or more individual IP addresses.

 
           [bookmark: pgfId-101242]If you specify a hostname, the security appliance retains the case you specify, although it ignores the case when matching the name to a server.

 
           [bookmark: pgfId-101244] – Encoding Type—Select the encoding type. The options are the same as for the global setting described above.

 
            
            		 [bookmark: pgfId-101246]To edit a rule, select it, click the  Edit Row button, and make your changes in the Edit File Encoding dialog box.

 
            		 [bookmark: pgfId-101248]To delete a rule, select it and click the  Delete Row button. You are asked to confirm the deletion.

 
           

 
           [bookmark: pgfId-101250]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-101272][bookmark: 80605][bookmark: ravpnch_proc_ConfiguringOtherSettings_ProxyTab]Configuring SSL VPN Proxies and Proxy Bypass (ASA)[bookmark: marker-101258][bookmark: marker-101260][bookmark: marker-101262][bookmark: marker-101264][bookmark: marker-101266][bookmark: marker-101268][bookmark: marker-101270]

 
           [bookmark: pgfId-101274]Use the Proxy tab of the SSL VPN Other Settings page to configure the security appliance to terminate HTTPS connections and forward HTTP/HTTPS requests to HTTP and HTTPS proxy servers. On this tab, you can also configure the security appliance to perform minimal content rewriting and to specify the types of content to rewrite—external links, XML, or neither.

 
           [bookmark: pgfId-101276]The security appliance can terminate HTTPS connections and forward HTTP/HTTPS requests to HTTP and HTTPS proxy servers. These servers act as intermediaries between users and the Internet. Requiring all Internet access through a server you control provides another opportunity for filtering to assure secure Internet access and administrative control.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-101278]Note The HTTP/HTTPS proxy does not support connections to personal digital assistants.


           
            

           

           

 
           [bookmark: pgfId-101280]You can specify a proxy auto-configuration (PAC) file to download from an HTTP proxy server; however, you cannot use proxy authentication when specifying the PAC file.

 
           [bookmark: pgfId-101282]You can configure the security appliance to use proxy bypass when applications and web resources work better with the content rewriting this feature provides. Proxy bypass is an alternative method of content rewriting that makes minimal changes to the original content. It is useful with custom web applications.

 
           [bookmark: pgfId-101284]You can configure multiple proxy bypass entries. The order in which you configure them is unimportant. The interface and path mask or interface and port uniquely identify a proxy bypass rule.

 
           [bookmark: pgfId-101286]If you configure proxy bypass using ports rather than path masks, depending on your network configuration, you might need to change your firewall configuration to allow these ports access to the security appliance. Use path masks to avoid this restriction. Be aware, however, that path masks can change, so you might need to use multiple path mask statements to exhaust the possibilities.

 
           [bookmark: pgfId-101288]This procedure shows you how to define proxies and proxy bypass rules for your SSL VPN.

 
           [bookmark: pgfId-101290]Related Topics

 
            
            		 [bookmark: pgfId-101295]Configuring Other SSL VPN Settings (ASA)

 
           

 
           
 
           [bookmark: pgfId-101297]Step 1 Do one of the following:

 
            
            		 [bookmark: pgfId-101299](Device view) With an ASA device selected, select  Remote Access VPN > SSL VPN > Other Settings from the Policy selector.

 
            		 [bookmark: pgfId-101301](Policy view) Select  Remote Access VPN > SSL VPN > Other Settings (ASA) from the Policy Type selector. Select an existing policy or create a new one.

 
           

 
           [bookmark: pgfId-101303]Step 2 On the Other Settings page, click the Proxy tab. The Proxy tab displays any currently defined proxies and proxy rules.

 
           [bookmark: pgfId-101305]Step 3 From the Proxy Type field, select the type of external proxy server to use for SSL VPN connections:

 
            
            		 [bookmark: pgfId-101307] HTTP/HTTPS Proxy Server —To specify proxy servers to handle HTTP or HTTPS requests.

 
            		 [bookmark: pgfId-101309] Proxy Using PAC —To specify a proxy auto-configuration (PAC) file to download from an HTTP proxy server to the user’s browser. Once downloaded, the PAC file uses a JavaScript function to identify a proxy for each URL.

 
           

 
           [bookmark: pgfId-101311]If you select this option, enter the URL for the PAC file in the Specify Proxy Auto Config file URL field. The URL must begin with http:// or the security appliance will not use the PAC file.

 
           [bookmark: pgfId-101313]Step 4 If you select HTTP/HTTPS Proxy Server for the proxy type, configure the settings for the HTTP and HTTPS proxy servers. There are separate settings for the HTTP and HTTPS server, allowing you to use different servers, or to specify only one type of proxy. Configure the following options:

 
            
            		 [bookmark: pgfId-101315] Enable HTTP Proxy Server, Enable HTTPS Proxy Server —Select either or both of these options to configure the proxy server.

 
            		 [bookmark: pgfId-101317] HTTP Proxy Server, HTTPS Proxy Server —Enter the IP address, or the name of a network/host object that contains the single proxy server’s IP address, for each type of proxy server you are configuring. You can click  Select to select the object from a list or to create a new object.

 
           

 
           [bookmark: pgfId-101319]The default ports are 80 for HTTP and 443 for HTTPS.

 
            
            		 [bookmark: pgfId-101321] HTTP Proxy Port, HTTPS Proxy Port —Enter the port on the proxy server to which HTTP or HTTPS requests will be forwarded. You can also enter the name of a port list object that defines the port, or click  Select to select an object or to create a new one.

 
            		 [bookmark: pgfId-101323] Exception Address List —A URL or a comma-delimited list of several URLs to exclude from those that should be sent to the HTTP or HTTPS proxy servers. The string does not have a character limit, but the entire command cannot exceed 512 characters. You can specify literal URLs or use the following wildcards:

 
           

 
           [bookmark: pgfId-101325] – * to match any string, including slashes (/) and periods (.). You must accompany this wildcard with an alphanumeric string.

 
           [bookmark: pgfId-101327] – ? to match any single character, including slashes and periods.

 
           [bookmark: pgfId-101329] – [x-y] to match any single character in the range of x and y, where x represents one character and y represents another character in the ANSI character set.

 
           [bookmark: pgfId-101331] – [!x-y] to match any single character that is not in the range.

 
            
            		 [bookmark: pgfId-101333] Authentication User Name, Authentication Password, Confirm —If the proxy server requires user authentication, enter a valid user name and password.

 
           

 
           [bookmark: pgfId-101335]Step 5 If necessary, configure proxy bypass rules in the Proxy Bypass table at the bottom of the tab. Proxy bypass rules specify the ASA interface, port, and target URL configured for proxy bypass. Do any of the following:

 
            
            		 [bookmark: pgfId-101340]To create a proxy bypass rule, click the  Add Row button and fill in the Add Proxy Bypass dialog box. For specific information on the attributes of a proxy bypass rule, see Add or Edit Proxy Bypass Dialog Box.

 
            		 [bookmark: pgfId-101342]To edit a proxy bypass rule, select the rule and click the  Edit Row button.

 
            		 [bookmark: pgfId-101344]To delete a rule, select it and click the  Delete Row button. You are asked to confirm the deletion.

 
           

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-101349]Tip If you configure proxy bypass rules, you must also configure the SSL VPN Access policy. For more information, see Configuring an Access Policy.


           
            

           

           

 
           [bookmark: pgfId-101351]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-101369][bookmark: 80725][bookmark: ravpnpg_cncpt_AddEditProxyBypassDialogBox]Add or Edit Proxy Bypass Dialog Box[bookmark: marker-101359][bookmark: marker-101361][bookmark: marker-101363][bookmark: marker-101365][bookmark: marker-101367]

 
           [bookmark: pgfId-101371]Use the Add or Edit Proxy Bypass dialog box to set proxy bypass rules when the security appliance should perform little or no content rewriting.

 
           [bookmark: pgfId-101373]Navigation Path

 
           [bookmark: pgfId-101378]From the Proxy tab of the SSL VPN Other Settings policy for ASA devices, click the Add Row button, or select a rule and click the Edit Row button. For detailed information on opening the tab, see Configuring SSL VPN Encoding Rules (ASA).

 
           [bookmark: pgfId-101380]Field Reference

 
           [bookmark: pgfId-101383] 

 
            
             
              
              [bookmark: pgfId-97856]Table 31-22 [bookmark: 80757]Add or Edit Proxy Bypass Dialog Box 

 
              
             
               
               		
                 
                 [bookmark: pgfId-97862]Element
                
  
               		
                 
                 [bookmark: pgfId-97864]Description
                
  
              

 
               
               		[bookmark: pgfId-97870]Interface

  
               		[bookmark: pgfId-97872]The interface on the security appliance that is used for proxy bypass. Enter the name of the interface or the interface role object, or click Select to select it from a list or to create a new object.

  
              

 
               
               		[bookmark: pgfId-97878]Bypass On Port

  
               		[bookmark: pgfId-97880]Select this option to use a port number for proxy bypass. Valid port numbers are 20000-21000. Enter the ports or the name of a port list object, or click Select to select an object or to create a new one.

 [bookmark: pgfId-97882]Note If you configure proxy bypass using ports rather than path masks, depending on your network configuration, you might need to change your firewall configuration to allow these ports access to the security appliance. Use path masks to avoid this restriction.

  
              

 
               
               		[bookmark: pgfId-97888]Bypass Matching Specific Pattern

  
               		[bookmark: pgfId-97890]Select this option to use a URL path mask to match for proxy bypass. A path is the text in a URL that follows the domain name. For example, in the URL www.mycompany.com/hrbenefits, hrbenefits is the path.

 [bookmark: pgfId-97892]You can use the following wildcards:

 
                 
                 		 [bookmark: pgfId-97894] * —Matches everything. You cannot use this wildcard by itself. It must accompany an alphanumeric string.

 
                 		 [bookmark: pgfId-97896] ? —Matches any single character.

 
                 		 [bookmark: pgfId-97898] [x-y] —Matches any character in the sequence.

 
                 		 [bookmark: pgfId-97900] [!x-y] —Matches any character not in the sequence.

 
                

 [bookmark: pgfId-97902]The maximum is 128 bytes.

 [bookmark: pgfId-97904]Note Path masks can change, so you might need to use multiple path mask statements to exhaust the possibilities.

  
              

 
               
               		[bookmark: pgfId-97910]URL

  
               		[bookmark: pgfId-97912]Select the http or https protocol, then enter a URL to which you want to apply proxy bypass.

 [bookmark: pgfId-97914]URLs used for proxy bypass allow a maximum of 128 bytes. The port for HTTP is 80 and for HTTPS it is 443, unless you specify another port.

  
              

 
               
               		[bookmark: pgfId-97920]Rewrite XML

  
               		[bookmark: pgfId-97922]Whether to rewrite XML sites and applications to be bypassed by the security appliance.

  
              

 
               
               		[bookmark: pgfId-97928]Rewrite Hostname

  
               		[bookmark: pgfId-97930]Whether to rewrite external links to be bypassed by the security appliance.

  
              

 
             
            

 
           
 
          
 
           
            [bookmark: pgfId-101405][bookmark: 80822][bookmark: ravpnch_proc_ConfiguringOtherSettings_PluginTab]Configuring SSL VPN Browser Plug-ins (ASA)[bookmark: marker-101391][bookmark: marker-101393][bookmark: marker-101395][bookmark: marker-101397][bookmark: marker-101399][bookmark: marker-101401][bookmark: marker-101403]

 
           [bookmark: pgfId-101407]A browser plug-in is a separate program that a web browser invokes to perform a dedicated function, such as connect a client to a server within the browser window. The security appliance lets you import plug-ins for download to remote browsers in clientless SSL VPN sessions.

 
           [bookmark: pgfId-101409]Cisco redistributes the following open-source, Java-based components to be accessed as plug-ins for web browsers in Clientless SSL VPN sessions. Cisco tests the plug-ins it redistributes, and in some cases, tests the connectivity of plug-ins we cannot redistribute. These files are available in the \files\vms\repository folder in the product installation folder (usually C:\Program Files\CSCOpx) on the Security Manager server. The actual file names include release numbers:

 
            
            		 [bookmark: pgfId-101413]rdp-plugin.jar—The Remote Desktop Protocol plug-in lets the remote user connect to a computer running Microsoft Terminal Services. The web site containing the source of the redistributed plug-in is  http://properjavardp.sourceforge.net/ .

 
            		 [bookmark: pgfId-101417]ssh-plugin.jar—The Secure Shell-Telnet plug-in lets the remote user establish a Secure Shell or Telnet connection to a remote computer. The web site containing the source of the redistributed plug-in is  http://javassh.org/ .

 
           

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-101419]Note The ssh-plugin.jar provides support for both SSH and Telnet protocols. The SSH client supports SSH Version 1.0.


           
            

           

           

 
            
            		 [bookmark: pgfId-101423]vnc-plugin.jar—The Virtual Network Computing plug-in lets the remote user use a monitor, keyboard, and mouse to view and control a computer with remote desktop sharing turned on. The web site containing the source of the redistributed plug-in is  http://www.tightvnc.com .

 
           

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-101425]Note Per the GNU General Public License (GPL), Cisco redistributes plug-ins without having made any changes to them. Per the GPL, Cisco cannot directly enhance these plug-ins.


           
            

           

           

 
           [bookmark: pgfId-101427]The security appliance does the following when you install a plug-in onto the flash device:

 
            
            		 [bookmark: pgfId-101429](Cisco-distributed plug-ins only) Unpacks the jar file specified in the URL.

 
            		 [bookmark: pgfId-101431]Writes the file to the csco-config/97/plugin directory on the security appliance file system.

 
            		 [bookmark: pgfId-101433]Enables the plug-in for all future clientless SSL VPN sessions, and adds a main menu option and an option to the drop-down menu next to the Address field of the portal page.

 
           

 
           [bookmark: pgfId-101435]When the user in a clientless SSL VPN session clicks the associated menu option on the portal page, the portal page displays a window to the interface and displays a help pane. The user can select the protocol displayed in the drop-down menu and enter the URL in the Address field to establish a connection.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-101437]Note Some Java plug-ins might report a status of connected or online even when a session to the destination service is not set up. The open-source plug-in reports the status, not the security appliance.


           
            

           

           

 
           [bookmark: pgfId-101439]In the Plug-in tab of the SSL VPN Global Settings page, you can view the currently configured browser plug-ins for clientless SSL VPN browser access. From this tab, you can create or edit the plug-in files, as described in the following procedure.

 
           [bookmark: pgfId-101441]Plug-in Requirements and Restrictions

 
           [bookmark: pgfId-101443]Clientless SSL VPN must be enabled on the security appliance to provide remote access to the plug-ins. The minimum access rights required for remote use belong to the guest privilege mode. The plug-ins automatically install or update the Java version required on the remote computer. A stateful failover does not retain sessions established using plug-ins. Users must reconnect following a failover.

 
           [bookmark: pgfId-101445]Before installing a plug-in, prepare the security appliance as follows:

 
            
            		 [bookmark: pgfId-101447]Make sure clientless SSL VPN is enabled on an interface on the security appliance.

 
            		 [bookmark: pgfId-101449]Install an SSL certificate onto the security appliance interface to which remote users use a fully-qualified domain name (FQDN) to connect.

 
           

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-101451]Note Do not specify an IP address as the common name (CN) for the SSL certificate. The remote user attempts to use the FQDN to communicate with the security appliance. The remote PC must be able to use DNS or an entry in the System32\drivers\etc\hosts file to resolve the FQDN.


           
            

           

           

 
           [bookmark: pgfId-101453]Related Topics

 
            
            		 [bookmark: pgfId-101458]Understanding and Managing SSL VPN Support Files

 
            		 [bookmark: pgfId-101463]Configuring Other SSL VPN Settings (ASA)

 
           

 
           
 
           [bookmark: pgfId-101465]Step 1 Do one of the following:

 
            
            		 [bookmark: pgfId-101467](Device view) With an ASA device selected, select  Remote Access VPN > SSL VPN > Other Settings from the Policy selector.

 
            		 [bookmark: pgfId-101469](Policy view) Select  Remote Access VPN > SSL VPN > Other Settings (ASA) from the Policy Type selector. Select an existing policy or create a new one.

 
           

 
           [bookmark: pgfId-101471]Step 2 On the Other Settings page, click the Plug-in tab. The Plug-in tab lists all configured plug-ins, including the type of plug-in and the name of the File policy object that defines the actual plug-in file.

 
           [bookmark: pgfId-101473]Step 3 Do any of the following:

 
            
            		 [bookmark: pgfId-101475]To add a plug-in, click the  Add Row button beneath the table and fill in the Add Plug-In Entry dialog box as follows:

 
           

 
           [bookmark: pgfId-101477] – Plug-in—Select the type of plug-in that you are adding:

 
           [bookmark: pgfId-101479] – Remote Desktop (RDP) or RDP2—For Remote Desktop Protocol services.

 
           [bookmark: pgfId-101481] – Secure Shell (SSH), Telnet—For Secure Shell and Telnet services.

 
           [bookmark: pgfId-101483] – VNC—For Virtual Network Computing services.

 
           [bookmark: pgfId-101485] – Citrix (ICA)—For Citrix MetaFrame services.

 
           [bookmark: pgfId-101487] – Post—For post services.

 
           [bookmark: pgfId-101492] – Plug-in File—The name of the File policy object that defines the plug-in file. Enter the name of the File object or click Select to select an object or to create a new one. For more information on creating File Objects, see Add and Edit File Object Dialog Boxes.

 
            
            		 [bookmark: pgfId-101494]To edit a plug-in, select it, click the  Edit Row button, and make your changes in the Edit Plug-In Entry dialog box.

 
            		 [bookmark: pgfId-101496]To delete a plug-in, select it and click the  Delete Row button. You are asked to confirm the deletion.

 
           

 
           [bookmark: pgfId-101498]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-101518][bookmark: 80942][bookmark: ravpnch_cncpt_UnderstandingSSLVPNClientSettings]Understanding SSL VPN AnyConnect Client Settings[bookmark: marker-101504][bookmark: marker-101506][bookmark: marker-101508][bookmark: marker-101510][bookmark: marker-101512][bookmark: marker-101514][bookmark: marker-101516]

 
           [bookmark: pgfId-101520]The Cisco AnyConnect VPN Client provides secure SSL and IKEv2 IPsec connections to the security appliance for remote users. The client gives remote users the benefits of an SSL or IKEv2 IPsec VPN client without the need for network administrators to install and configure clients on remote computers.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-101522]Tip IKEv2 IPsec connections require AnyConnect 3.0 or higher clients.


           
            

           

           

 
           [bookmark: pgfId-101524]Without a previously installed client, remote users enter the IP address in their browser of an interface configured to accept SSL or IKEv2 IPsec VPN connections. Unless the security appliance is configured to redirect http:// requests to https://, users must enter the URL in the form https://<address>.

 
           [bookmark: pgfId-101526]After the user enters the URL, the browser connects to that interface and displays the login screen. If the user satisfies the login authentication, and the security appliance identifies the user as requiring the client, it downloads the client that matches the operating system of the remote computer. After downloading, the client installs and configures itself, establishes a secure connection and either remains or uninstalls itself (depending on the security appliance configuration) when the connection terminates.

 
           [bookmark: pgfId-101528]In the case of a previously installed client, when the user authenticates, the security appliance examines the revision of the client and upgrades the client as necessary.

 
           [bookmark: pgfId-101530]When the client negotiates a connection with the security appliance, it connects using Transport Layer Security (TLS), and optionally, Datagram Transport Layer Security (DTLS). DTLS avoids latency and bandwidth problems associated with some SSL connections and improves the performance of real-time applications that are sensitive to packet delays.

 
           [bookmark: pgfId-101536]The AnyConnect client can be downloaded from the security appliance, or it can be installed manually on the remote workstation by the system administrator. For more information about installing the client manually, see the Cisco AnyConnect Secure Mobility Client Administrator Guide. AnyConnect documentation is available at http://www.cisco.com/en/US/products/ps10884/tsd_products_support_series_home.html. You can find general information about AnyConnect at http://www.cisco.com/go/anyconnect.

 
           [bookmark: pgfId-101538]The security appliance downloads the client based on the group policy or username attributes of the user establishing the connection. You can configure the security appliance to automatically download the client, or you can configure it to prompt the remote user about whether to download the client. In the latter case, if the user does not respond, you can configure the security appliance to either download the client after a timeout period or present the login page.

 
           [bookmark: pgfId-101540]AnyConnect Client Profiles

 
           [bookmark: pgfId-101542]An AnyConnect client profile is a group of configuration parameters, stored in an XML file, that the client uses to configure the connection entries that appear in the client user interface. These parameters (XML tags) include the names and addresses of host computers and settings to enable additional client features.

 
           [bookmark: pgfId-101544]The AnyConnect client installation includes a profile template, named AnyConnectProfile.tmpl, that you can edit with a text editor and use as a basis to create other profile files. You can also set advanced parameters that are not available through the user interface. The installation also includes a complete XML schema file, named AnyConnectProfile.xsd.

 
           [bookmark: pgfId-101546]You can add the profile to the Client Settings tab in the Other Settings policy to have it loaded onto the security appliance and subsequently downloaded to the client workstations based on group policies and username attributes.

 
           [bookmark: pgfId-101548]Related Topics

 
            
            		 [bookmark: pgfId-101553]Understanding and Managing SSL VPN Support Files

 
            		 [bookmark: pgfId-101558]Configuring SSL VPN AnyConnect Client Settings (ASA)

 
            		 [bookmark: pgfId-101563]Cisco AnyConnect Profile Editor

 
           

 
          
 
           
            [bookmark: pgfId-101577][bookmark: 81000][bookmark: ravpnpg_cncpt_AnyConnectProfileEditorDialogBox]Cisco AnyConnect Profile Editor[bookmark: marker-101571][bookmark: marker-101573][bookmark: marker-101575]

 
           [bookmark: pgfId-101579]You can configure a profile using the AnyConnect profile editor, a convenient GUI-based configuration tool launched from Cisco Security Manager. The AnyConnect software package for Windows, version 2.5 and later, includes the editor, which activates when you launch the editor from the Add/Edit AnyConnect Client Profile dialog box as long as you have added an appropriate AnyConnect package to the AnyConnect Client Image list.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-101583]Note The Cisco AnyConnect Profile Editor is an independent program. For information about configuring AnyConnect profiles, and what AnyConnect Profile Editor can do for you, see the materials available online at http://www.cisco.com/en/US/products/ps10884/products_installation_and_configuration_guides_list.html.


           
            

           

           

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-101585]Note Beginning with version 4.7, Security Manager provides support for AnyConnect version 3.2.


           
            

           

           

 
           [bookmark: pgfId-101587]Navigation Path

 
           [bookmark: pgfId-101591]Open the Add/Edit AnyConnect Client Profile dialog box, then click Launch Editor (you must first add an appropriate AnyConnect package to the AnyConnect Client Image list before accessing the Add/Edit AnyConnect Client Profile dialog box). The AnyConnect Profile Editor is displayed.

 
           [bookmark: pgfId-101593]Related Topics

 
            
            		 [bookmark: pgfId-101598]Understanding SSL VPN AnyConnect Client Settings

 
            		 [bookmark: pgfId-101603]Configuring SSL VPN AnyConnect Client Settings (ASA)

 
            		 [bookmark: pgfId-101608]Understanding and Managing SSL VPN Support Files

 
           

 
          
 
           
            [bookmark: pgfId-101634][bookmark: 81034][bookmark: ravpnch_proc_ConfiguringOtherSettings_ClientSettingsTab]Configuring SSL VPN AnyConnect Client Settings (ASA)[bookmark: marker-101616][bookmark: marker-101618][bookmark: marker-101620][bookmark: marker-101622][bookmark: marker-101624][bookmark: marker-101626][bookmark: marker-101628][bookmark: marker-101630][bookmark: marker-101632]

 
           [bookmark: pgfId-101639]This procedure shows you how to define SSL and IKEv2 IPsec VPN client images and profiles. For a detailed explanation of AnyConnect images and profiles, see Understanding SSL VPN AnyConnect Client Settings.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-101641]Tip Ensure that you add AnyConnect images of the required releases. For example, if you are configuring an IKEv2 IPsec VPN, you must include an AnyConnect 3.0 or higher image. In general, the image versions must support the features you are deploying in the remote access VPN.


           
            

           

           

 
           [bookmark: pgfId-101643]Related Topics

 
            
            		 [bookmark: pgfId-101648]Understanding SSL VPN AnyConnect Client Settings

 
            		 [bookmark: pgfId-101653]Cisco AnyConnect Profile Editor

 
            		 [bookmark: pgfId-101658]Understanding and Managing SSL VPN Support Files

 
            		 [bookmark: pgfId-101663]Configuring Other SSL VPN Settings (ASA)

 
           

 
           
 
           [bookmark: pgfId-101665]Step 1 Do one of the following:

 
            
            		 [bookmark: pgfId-101667](Device view) With an ASA device selected, select  Remote Access VPN > SSL VPN > Other Settings from the Policy selector.

 
            		 [bookmark: pgfId-101669](Policy view) Select  Remote Access VPN > SSL VPN > Other Settings (ASA) from the Policy Type selector. Select an existing policy or create a new one.

 
           

 
           [bookmark: pgfId-101671]Step 2 On the Other Settings page, click the Client Settings tab. The tab has two tables listing the configured AnyConnect clients and profiles separately.

 
           [bookmark: pgfId-101673]The AnyConnect images include an order number. The security appliance downloads portions of the AnyConnect images to the remote computer until it achieves a match with the operating system, starting with the highest order number. Therefore, you should give the highest number to the image used by the most commonly-encountered operating system.

 
           [bookmark: pgfId-101675]Because mobile users have slower connection speeds, you should load the AnyConnect image for Windows Mobile at the top of the list. Alternatively, you can decrease the connection time by specifying the regular expression Windows CE to match the user agent on Windows Mobile devices. When the browser on the mobile device connects to the ASA, it includes the User-Agent string in the HTTP header. The ASA, receiving the string, immediately downloads AnyConnect for Windows Mobile without ascertaining whether the other AnyConnect images are appropriate.

 
           [bookmark: pgfId-101677]Step 3 To add an AnyConnect client image or make changes to the existing list, do any of the following:

 
            
            		 [bookmark: pgfId-101682]To add an AnyConnect image, click the  Add Row button beneath the table and fill in the Add AnyConnect Client Image dialog box. You need to specify the name of the File object that defines the image and the priority order of the image. You can also specify a regular expression for the connecting client to speed up the download. For detailed information about the options, see Add/Edit AnyConnect Client Image Dialog Box.

 
            		 [bookmark: pgfId-101684]To edit an image, select it, click the  Edit Row button, and make your modifications in the Edit AnyConnect Client Image dialog box.

 
            		 [bookmark: pgfId-101686]To delete an image, select it and click the  Delete Row button. You are asked to confirm the deletion.

 
           

 
           [bookmark: pgfId-101688]Step 4 To add an AnyConnect profile or make changes to the existing list, do any of the following:

 
            
            		 [bookmark: pgfId-101690]To add an AnyConnect profile, click the  Add Row button beneath the table and configure these options in the Add AnyConnect Client Profile dialog box:

 
           

 
           [bookmark: pgfId-101692] – AnyConnect Profile Name—The name of the profile.

 
           [bookmark: pgfId-101700]To use this profile, ensure that you specify the profile name in an ASA Group Policy object assigned to the security appliance (in the Full Client settings page as described in ASA Group Policies SSL VPN Full Client Settings). Configure the ASA Group Policy object through the remote access Connection Profiles policy for the device as described in Configuring Connection Profiles (ASA, PIX 7.0+).

 
           [bookmark: pgfId-101702] – AnyConnect Profile Type—Select the type of AnyConnect Profile you are adding or editing: VPN, Network Access Manager, Telemetry, Web Security, ISE Posture, or Customer Experience Feedback.

 
           [bookmark: pgfId-101707] – AnyConnect Profile File—The name of the File object that identifies the Anyconnect client profile XML file. Click Select to select the object or to create a new one. For more information about File objects, see Add and Edit File Object Dialog Boxes.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-101709]Note Beginning with version 4.7, Security Manager provides support for AnyConnect version 3.2. If you select ISE Posture as the AnyConnect Profile Type, the AnyConnect Profile File will have a filename extension of .isp.


           
            

           

           

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-101711]Note If you are going to create a new profile using the AnyConnect Profile Editor, do not specify an AnyConnect Profile File.


           
            

           

           

 
           [bookmark: pgfId-101716] – Launch Editor—Click Launch Editor to use the AnyConnect Profile Editor to edit the profile specified in AnyConnect Profile File or to create a new profile if no profile file is specified. For more information about File objects, see Cisco AnyConnect Profile Editor.

 
            
            		 [bookmark: pgfId-101718]To edit a profile, select it, click the  Edit Row button, and make your modifications in the Edit AnyConnect Client Profile dialog box.

 
            		 [bookmark: pgfId-101720]To delete a profile, select it and click the  Delete Row button. You are asked to confirm the deletion.

 
           

 
           [bookmark: pgfId-101722]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-101740][bookmark: 81151][bookmark: ravpnpg_cncpt_AddEditSSLVPNClientImageDialogBox]Add/Edit AnyConnect Client Image Dialog Box[bookmark: marker-101730][bookmark: marker-101732][bookmark: marker-101734][bookmark: marker-101736][bookmark: marker-101738]

 
           [bookmark: pgfId-101742]Use the Add or Edit AnyConnect Client Image dialog box to create or edit a package file as the client image, and establish the order that the security appliance downloads the image to the remote workstation.

 
           [bookmark: pgfId-101744]Navigation Path

 
           [bookmark: pgfId-101749]From the Client Settings tab of the SSL VPN Other Settings policy for ASA devices, click the Add Row button for the AnyConnect Client Image table, or select an image and click the Edit Row button. For detailed information on opening the tab, see Configuring SSL VPN AnyConnect Client Settings (ASA).

 
           [bookmark: pgfId-101751]Related Topics

 
            
            		 [bookmark: pgfId-101756]Understanding SSL VPN AnyConnect Client Settings

 
            		 [bookmark: pgfId-101761]Configuring SSL VPN AnyConnect Client Settings (ASA)

 
            		 [bookmark: pgfId-101766]Understanding and Managing SSL VPN Support Files

 
           

 
           [bookmark: pgfId-101768]Field Reference

 
           [bookmark: pgfId-101771] 

 
            
             
              
              [bookmark: pgfId-97943]Table 31-23 [bookmark: 81195]Add or Edit AnyConnect Client Image Dialog Box 

 
              
             
               
               		
                 
                 [bookmark: pgfId-97949]Element
                
  
               		
                 
                 [bookmark: pgfId-97951]Description
                
  
              

 
               
               		[bookmark: pgfId-97957]AnyConnect Client Image

  
               		[bookmark: pgfId-97962]The name of the File object that identifies the Anyconnect client. Click Select to select an object or to create a new one. For more information about File objects, see Add and Edit File Object Dialog Boxes.

  
              

 
               
               		[bookmark: pgfId-97968]Image Order

  
               		[bookmark: pgfId-97970]The order in which the security appliance downloads the client images to the remote workstation. It downloads the image in priority order. Therefore, you should enter a lower value for the image used by the most commonly-encountered operating system.

  
              

 
               
               		[bookmark: pgfId-97976]Regular Expression

  
               		[bookmark: pgfId-97981]A regular expression to match the user agent. Enter a name of an existing regular expression policy object or click Select to select an entry from the Regular Expressions Selector dialog box. To add a new regular expression, click the Add (+) button on the Regular Expressions Selector dialog box. For more information see Add/Edit Regular Expressions.

 [bookmark: pgfId-97983]If you are adding an AnyConnect package for Windows Mobile, specify the regular expression Windows CE to match the user agent on Windows Mobile devices. This decreases the connection time of the mobile device. When the browser on the mobile device connects to the adaptive security appliance, it includes the User-Agent string in the HTTP header. The adaptive security appliance, receiving the string, immediately downloads AnyConnect for Windows Mobile without ascertaining whether the other AnyConnect images are appropriate.

  
              

 
             
            

 
           
 
          
 
           
            [bookmark: pgfId-101789][bookmark: 81229][bookmark: ravpnch_cncpt_UnderstandingSSLVPNKerberosConstrainedDelegationASA]Understanding Kerberos Constrained Delegation (KCD) for SSL VPN (ASA)[bookmark: marker-101777][bookmark: marker-101779][bookmark: marker-101781][bookmark: marker-101783][bookmark: marker-101785][bookmark: marker-101787]

 
           [bookmark: pgfId-101791]There are many ways to protect network resources through the use of authentication. Many organizations want to use Kerberos to protect certain web applications while using other authentication techniques, such as username and password, digital certificates, RSA SecureID, or SmartCards, to control access to an SSL VPN. However, a restriction in the Kerberos protocol prevents Kerberos authentication if the user has already used another technique to authenticate to the VPN.

 
           [bookmark: pgfId-101793]Microsoft overcomes this limitation in Kerberos starting with Windows Server 2003. Using protocol transition and constrained delegation, the ASA can authenticate to the Kerberos Key Distribution Center (KCD) on the Windows domain controller and obtain impersonate tickets for users who have authenticated to the ASA using non-Kerberos protocols. The ASA can use the impersonate ticket to obtain other Kerberos service tickets for remote users.

 
           [bookmark: pgfId-101795]To configure the domain controller so that Kerberos constrained delegation works, you must do the following:

 
            
            		 [bookmark: pgfId-101797]Each instance of a service that uses Kerberos authentication must have a service principle name (SPN) defined so that clients can identify it on the network. Register the SPN in the Active Directory  Service-Principal-Name attribute of the Windows account under which the instance of the service is running. When a service needs to authenticate to another service running on a specific computer, it uses that service’s SPN to differentiate it from other services running on that computer.

 
           

 
           [bookmark: pgfId-101799]The SPN syntax is service_class/host_name:port, where:

 
           [bookmark: pgfId-101801] – service_class identifies the service. It can be a built-in service, such as http, or a user defined service.

 
           [bookmark: pgfId-101803] – host_name identifies the fully-qualified domain name or NetBIOS name of the server that hosts the service, but it cannot be an IP address.

 
           [bookmark: pgfId-101805] – port identifies the port on which the service runs. You can omit the port if you use the default service port.

 
            
            		 [bookmark: pgfId-101807]Create a service account username and password that the ASA can use. Configure the account to allow Kerberos constrained delegation to any authentication protocol. In addition, the user account must not be marked as a sensitive account that cannot be delegated.

 
           

 
           [bookmark: pgfId-101809]To configure the ASA to allow KCD, once the ASA joins the domain, an entry should appear under the Users and Computers list on the domain controller for the ASA. In the Properties dialog box, on the Delegation tab, select Trust this computer for delegation to specified services only, and then select Use any authentication protocol. In the table of authorized services, add all services for which the ASA is delegated for authentication on behalf of users.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-101811]Tip For definitive information on configuring this feature on the Windows domain controller, refer to the Microsoft documentation.


           
            

           

           

 
           [bookmark: pgfId-101816]For the ASA to use Kerberos constrained delegation, you must configure the ASA as described in Configuring Kerberos Constrained Delegation (KCD) for SSL VPN (ASA). The feature is available on ASA Software release 8.4 and higher only.

 
           [bookmark: pgfId-101818]Following is an example that explains how Kerberos constrained delegation works with a clientless SSL VPN hosted on an ASA.

 
           [bookmark: pgfId-101822]Figure 31-1 [bookmark: 81281]Kerberos Constrained Delegation Example

 
           [bookmark: pgfId-101825] 

 
            
            [image: ] 
           
 
           [bookmark: pgfId-101827]After verifying the identity of an SSL VPN user with the configured authentication mechanism, the ASA uses protocol transition to switch to the Kerberos protocol for authentication on behalf of the user and then sends a Kerberos service ticket instead of the user’s credentials to a published Web server that accepts Kerberos for authentication. Following are the steps:

 
           [bookmark: pgfId-101829] 1. An SSL VPN user session is authenticated by the ASA using the authentication mechanism configured for the user. For example, in case of Smartcard credentials, the ASA extracts the required information (the user’s principle name) from the digital certificate and performs LDAP authorization against Windows Active Directory.

 
           [bookmark: pgfId-101831] 2. After successful authentication, the user logs into the ASA SSL VPN portal page. The VPN user accesses a web service by entering a URL in the portal page or by clicking on a bookmark. If the access requires authentication, the server challenges the ASA for credentials and along with the challenge sends a list of authentication mechanisms supported by the server. Based on the HTTP headers in the challenge, the ASA deduces whether the server requires Kerberos authentication. If connecting to a backend server requires Kerberos authentication, then the ASA requests an impersonate ticket, for itself on behalf the user, from the KDC.

 
           [bookmark: pgfId-101833] 3. The KDC returns the requested tickets to the ASA. Even though these tickets are passed to the ASA, they contain the user’s authorization data.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-101835]Note These first steps comprise protocol transition; after these steps, a user who authenticated to the ASA using a non-Kerberos authentication protocol is transparently authenticated to the KDC using Kerberos.


           
            

           

           

 
           [bookmark: pgfId-101837] 4. The ASA now requests a service ticket from the KDC for the specific service that the user wants to access. The service ticket request contains the SPN (the unique identifier) of the service.

 
           [bookmark: pgfId-101839] 5. The KDC returns a service ticket for the specific service to the ASA.

 
           [bookmark: pgfId-101841] 6. The ASA uses the service ticket to request access to the web service, in the above scenario this is sent to the web server in a HTTP GET request.

 
           [bookmark: pgfId-101843] 7. The web server authenticates the Kerberos service ticket and grants access to the service. An authentication failure will display an appropriate error message after acknowledgment of which the portal will be displayed.

 
          
 
           
            [bookmark: pgfId-101861][bookmark: 81302][bookmark: ravpnch_proc_ConfiguringSSLVPNKerberosConstrainedDelegationASA]Configuring Kerberos Constrained Delegation (KCD) for SSL VPN (ASA)[bookmark: marker-101849][bookmark: marker-101851][bookmark: marker-101853][bookmark: marker-101855][bookmark: marker-101857][bookmark: marker-101859]

 
           [bookmark: pgfId-101863]Use the Microsoft KCD Server tab of the SSL VPN Other Settings page to configure Kerberos Constrained Delegation (KCD) for clientless SSL VPNs hosted on an ASA.

 
           [bookmark: pgfId-101865]KCD addresses a limitation of Kerberos. If a user authenticates to the SSL VPN using a method other than Kerberos, the user cannot access Kerberos-protected resources. This prevents a remote access device, such as ASA, from authenticating users using non- Kerberos methods and still provide single sign-on access to Kerberos-authenticated web applications in the enterprise.

 
           [bookmark: pgfId-101867]If this limitation applies to your network, you can configure KCD to get around the limitation. KCD offloads the Kerberos authentication to the ASA. Users log into the corporate network using the SSL VPN portal, and from then on, access Kerberos-protected services in a transparent fashion.

 
           [bookmark: pgfId-101869]Tips

 
            
            		 [bookmark: pgfId-101871]KCD requires ASA release 8.4+. If you configure KCD for other releases, the configuration is ignored.

 
            		 [bookmark: pgfId-101873]The feature is used with clientless SSL VPN access only.

 
            		 [bookmark: pgfId-101875]Microsoft Windows Server (2003 or 2008), configured as domain controllers, are required for KCD.

 
            		 [bookmark: pgfId-101877]If you use SSL VPN Bookmark policy objects to define bookmarks to include on the SSL VPN portal page, you might need to add explicit service principle name (SPN) parameters to bookmarks if a service uses a non-default port. For services that use Kerberos authentication, an SPN must be defined in the Service-Principle-Name attribute of the account under which the service runs.

 
           

 
           [bookmark: pgfId-101882]Bookmarks need to reflect this configuration. The SPN is a parameter on the URL: http://<url>?SPN=<spn> or http://<url>?SPN=<spn>. For example, http://owa.example.com?SPN=http/owa:444. For more details about the SPN syntax, see Understanding Kerberos Constrained Delegation (KCD) for SSL VPN (ASA).

 
            
            		 [bookmark: pgfId-101884]To configure this feature, you must also configure the Hostname, DNS, and NTP policies. Configure both hostname and domain name in the Hostname policy.

 
            		 [bookmark: pgfId-101886]Kerberos authentication requires that the clock between the hosts to be synchronized with a maximum drift of 5 minutes (this is the default setting). This restriction is applicable to the clocks on the ASA, the domain controller, and the application servers. Configuring the same NTP server for all servers should address the requirement.

 
           

 
           [bookmark: pgfId-101888]Related Topics

 
            
            		 [bookmark: pgfId-101893]Configuring Other SSL VPN Settings (ASA)

 
            		 [bookmark: pgfId-101898]Understanding AAA Server and Server Group Objects

 
           

 
           
 
           [bookmark: pgfId-101900]Step 1 Do one of the following:

 
            
            		 [bookmark: pgfId-101902](Device view) With an ASA device selected, select  Remote Access VPN > SSL VPN > Other Settings from the Policy selector.

 
            		 [bookmark: pgfId-101904](Policy view) Select  Remote Access VPN > SSL VPN > Other Settings (ASA) from the Policy Type selector. Select an existing policy or create a new one.

 
           

 
           [bookmark: pgfId-101906]Step 2 On the Other Settings page, click the Microsoft KCD Server tab.

 
           [bookmark: pgfId-101908]Step 3 Select Configure KCD and configure the following options:

 
            
            		 [bookmark: pgfId-101910] KCD Server —The AAA server group object that identifies the Microsoft KCD server (the domain controller) to use for Kerberos Constrained Delegation. Enter the name of the object or click  Select to select it from a list or to create a new object. The object must use a Kerberos AAA server policy object to identify the domain controller.

 
            		 [bookmark: pgfId-101912] Username, Password, Confirm —A user account that the ASA can use to join the Active Directory domain.

 
           

 
           [bookmark: pgfId-101917]For the ASA to use Kerberos protocol transition and constrained delegation, and obtain service tickets on behalf of the remote access users, the account used by the ASA to authenticate with the domain controller must be configured in Active Directory and configured to allow Kerberos constrained delegation to any authentication protocol. In addition, the user account must not be marked as a sensitive account that cannot be delegated. For more information about Active Directory configuration requirements, see Understanding Kerberos Constrained Delegation (KCD) for SSL VPN (ASA).

 
           [bookmark: pgfId-101919]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-101937][bookmark: 81385][bookmark: ravpnch_proc_ConfiguringOtherSettings_AnyConnectCustomAttributesTab]Configuring AnyConnect Custom Attributes (ASA)[bookmark: marker-101925][bookmark: marker-101927][bookmark: marker-101929][bookmark: marker-101931][bookmark: marker-101933][bookmark: marker-101935]

 
           [bookmark: pgfId-101939]AnyConnect custom attributes allow for a more expeditious delivery and deployment of new endpoint features by giving the ASA the ability to generically support the addition of new client controls without the need for an ASA software upgrade.

 
           [bookmark: pgfId-101941]In the AnyConnect Custom Attribute tab of the SSL VPN Other Settings page, you can view configured AnyConnect custom attributes, add new attributes, and modify or delete existing attributes.

 
           [bookmark: pgfId-101943]Related Topics

 
            
            		 [bookmark: pgfId-101948]Understanding and Managing SSL VPN Support Files

 
            		 [bookmark: pgfId-101953]Configuring Other SSL VPN Settings (ASA)

 
           

 
           
 
           [bookmark: pgfId-101955]Step 1 Do one of the following:

 
            
            		 [bookmark: pgfId-101957](Device view) With an ASA device selected, select  Remote Access VPN > SSL VPN > Other Settings from the Policy selector.

 
            		 [bookmark: pgfId-101959](Policy view) Select  Remote Access VPN > SSL VPN > Other Settings (ASA) from the Policy Type selector. Select an existing policy or create a new one.

 
           

 
           [bookmark: pgfId-101961]Step 2 On the Other Settings page, click the AnyConnect Custom Attribute tab. The AnyConnect Custom Attribute tab lists all defined custom attributes.

 
           [bookmark: pgfId-101963]Step 3 Do any of the following:

 
            
            		 [bookmark: pgfId-101968]To add a custom attribute, click the  Add Row button beneath the table and fill in the Add AnyConnect Custom Attribute dialog box. The options are described in detail in Add/Edit AnyConnect Custom Attribute Dialog Box.

 
            		 [bookmark: pgfId-101970]To edit a custom attribute, select it, click the  Edit Row button, and make your changes in the Edit Plug-In Entry dialog box.

 
            		 [bookmark: pgfId-101972]To delete a custom attribute, select it and click the  Delete Row button. You are asked to confirm the deletion.

 
           

 
           [bookmark: pgfId-101974]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-101994][bookmark: 81446][bookmark: ravpnpg_cncpt_AddEditAnyConnectCustomAttributeDialogBox]Add/Edit AnyConnect Custom Attribute Dialog Box[bookmark: marker-101982][bookmark: marker-101984][bookmark: marker-101986][bookmark: marker-101988][bookmark: marker-101990][bookmark: marker-101992]

 
           [bookmark: pgfId-101996]Use the Add or Edit AnyConnect Custom Attribute dialog box to add or modify an AnyConnect custom attribute. AnyConnect custom attributes allow for a more expeditious delivery and deployment of new endpoint features by giving the ASA the ability to generically support the addition of new client controls without the need for an ASA software upgrade.

 
           [bookmark: pgfId-102001]Beginning with version 4.7, Security Manager enables to add Custom Attribute Data to an existing Custom Attribute Type for ASA devices running the software version 9.3(1) or higher. Use the Add or Edit AnyConnect Custom Attribute Data dialog box to add or modify the attribute name and attribute value for an existing AnyConnect custom attribute type. For more information see Add/Edit AnyConnect Custom Attribute Data Dialog Box.

 
           [bookmark: pgfId-102003]Navigation Path

 
           [bookmark: pgfId-102008]From the AnyConnect Custom Attribute tab of the SSL VPN Other Settings policy for ASA devices, click the Add Row button for the AnyConnect Custom Attributes table, or select an attribute and click the Edit Row button. For detailed information on opening the tab, see Configuring AnyConnect Custom Attributes (ASA).

 
           [bookmark: pgfId-102010]Related Topics

 
            
            		 [bookmark: pgfId-102015]Understanding SSL VPN AnyConnect Client Settings

 
            		 [bookmark: pgfId-102020]Configuring SSL VPN AnyConnect Client Settings (ASA)

 
            		 [bookmark: pgfId-102025]Understanding and Managing SSL VPN Support Files

 
           

 
           [bookmark: pgfId-102027]Field Reference

 
           [bookmark: pgfId-102030] 

 
            
             
              
              [bookmark: pgfId-97996]Table 31-24 [bookmark: 81494]Add or Edit AnyConnect Custom Attributes Dialog Box 

 
              
             
               
               		
                 
                 [bookmark: pgfId-98002]Element
                
  
               		
                 
                 [bookmark: pgfId-98004]Description
                
  
              

 
               
               		[bookmark: pgfId-98010]Type

  
               		[bookmark: pgfId-98012]The type of the AnyConnect custom attribute. This is used when referencing the attribute in Security Manager and in the aggregate auth protocol messages sent to the AnyConnect client. The maximum length is 32 characters.

  
              

 
               
               		[bookmark: pgfId-98018]Description

  
               		[bookmark: pgfId-98020]A free form description of attribute usage. This text will appear in the command help when the custom attribute is referenced from the group-policy attribute configuration mode. The maximum length is 128 characters.

  
              

 
             
            

 
           
 
          
 
           
            [bookmark: pgfId-102050][bookmark: 81515][bookmark: ravpnpg_cncpt_AddEditAnyConnectCustomAttributeDataDialogBox]Add/Edit AnyConnect Custom Attribute Data Dialog Box[bookmark: marker-102038][bookmark: marker-102040][bookmark: marker-102042][bookmark: marker-102044][bookmark: marker-102046][bookmark: marker-102048]

 
           [bookmark: pgfId-102052]Beginning with Security Manager version 4.7, you can use the Add or Edit AnyConnect Custom Attribute Data dialog box to add or modify the attribute name and attribute value for an existing AnyConnect custom attribute type.

 
           [bookmark: pgfId-102054]Navigation Path

 
           [bookmark: pgfId-102056]Click the AnyConnect Custom Attribute tab of the SSL VPN Other Settings policy for ASA devices. On the Custom Attribute table, select an attribute type and then click the Add Row button for the Custom Attribute Data table. Or on the Custom Attribute Data table select an existing Custom Attribute Data and click the Edit Row button.

 
           [bookmark: pgfId-102058]For each attribute type, you can define multiple attribute names with corresponding values.

 
           [bookmark: pgfId-102063]For information on adding or modifying an attribute type, see Understanding SSL VPN AnyConnect Client Settings.

 
           [bookmark: pgfId-102065]Related Topics

 
            
            		 [bookmark: pgfId-102070]Understanding SSL VPN AnyConnect Client Settings

 
            		 [bookmark: pgfId-102075]Add/Edit AnyConnect Custom Attribute Dialog Box

 
            		 [bookmark: pgfId-102080]Configuring SSL VPN AnyConnect Client Settings (ASA)

 
            		 [bookmark: pgfId-102085]Understanding and Managing SSL VPN Support Files

 
           

 
           [bookmark: pgfId-102087]Field Reference

 
           [bookmark: pgfId-102090] 

 
            
             
              
              [bookmark: pgfId-98033]Table 31-25 [bookmark: 81565]Add or Edit AnyConnect Custom Attribute Data Dialog Box 

 
              
             
               
               		
                 
                 [bookmark: pgfId-98039]Element
                
  
               		
                 
                 [bookmark: pgfId-98041]Description
                
  
              

 
               
               		[bookmark: pgfId-98047]Attribute Name

  
               		[bookmark: pgfId-98049]The name of an AnyConnect custom attribute. The name is used when referencing the attribute in group-policy and dynamic-access-policy-record config mode. The maximum length is 32 characters.

  
              

 
               
               		[bookmark: pgfId-98055]Attribute Value

  
               		[bookmark: pgfId-98057]A free form string containing the attribute value. The attribute value is associated with the attribute name and it is passed to the client during the configuration of the connection. The maximum length of the string can be 420 characters.

 [bookmark: pgfId-98059]The attribute value can contain multiple text lines.

  
              

 
             
            

 
           
 
          
 
           
            [bookmark: pgfId-102108][bookmark: 81588][bookmark: ravpnch_proc_ConfiguringOtherSettings_AdvancedTab]Configuring SSL VPN Advanced Settings (ASA)[bookmark: marker-102098][bookmark: marker-102100][bookmark: marker-102102][bookmark: marker-102104][bookmark: marker-102106]

 
           [bookmark: pgfId-102110]Use the Advanced tab of the SSL VPN Other Settings page to configure the memory, on-screen keyboard, and internal password features on ASA devices. All of these settings are optional.

 
           [bookmark: pgfId-102112]Related Topics

 
            
            		 [bookmark: pgfId-102117]Configuring Other SSL VPN Settings (ASA)

 
           

 
           
 
           [bookmark: pgfId-102119]Step 1 Do one of the following:

 
            
            		 [bookmark: pgfId-102121](Device view) With an ASA device selected, select  Remote Access VPN > SSL VPN > Other Settings from the Policy selector.

 
            		 [bookmark: pgfId-102123](Policy view) Select  Remote Access VPN > SSL VPN > Other Settings (ASA) from the Policy Type selector. Select an existing policy or create a new one.

 
           

 
           [bookmark: pgfId-102125]Step 2 On the Other Settings page, click the Advanced Tab.

 
           [bookmark: pgfId-102127]Step 3 In the Memory Size field, specify the amount of memory you want to allocate to SSL VPN sessions. The default is 50%.

 
           [bookmark: pgfId-102129]To change the setting, select one of the following options and enter the desired number:

 
            
            		 [bookmark: pgfId-102131] % of Total Physical Memory —As a percentage of total memory. Default is 50%.

 
            		 [bookmark: pgfId-102133] Kilobytes —In kilobytes. 20KB is the minimum setting allowed. Cisco recommends that you do not specify memory in terms of KB because different ASA models have different total amounts of memory, for example:

 
           

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-102135]Note When you change the memory size, the new setting takes effect only after the system reboots.


           
            

           

           

 
           [bookmark: pgfId-102137]Step 4 In the Enable On-Screen Keyboard field, select one of the following options:

 
            
            		 [bookmark: pgfId-102139] Disabled —The on-screen keyboard is not displayed. Users must input their credentials using the standard keyboard. This is the default.

 
            		 [bookmark: pgfId-102141] On All Pages —Allows a user to input credentials using an on-screen keyboard, which is displayed whenever logon credentials are required.

 
            		 [bookmark: pgfId-102143] On Logon Page Only —Allows a user to input credentials using an on-screen keyboard, which is displayed on the logon page but not on any other pages that require credentials.

 
           

 
           [bookmark: pgfId-102145]Step 5 Select Allow Users to Enter Internal Password to require an additional password when accessing internal sites. This feature is useful if you require that the internal password be different from the SSL VPN password. For example, you can use a one-time password for authentication to ASA and another password for internal sites.

 
           [bookmark: pgfId-102147]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-102163][bookmark: 81662][bookmark: ravpnch_proc_ConfiguringOtherSettings_SSLServerVerificationTab]Configuring SSL VPN Server Verification (ASA)[bookmark: marker-102153][bookmark: marker-102155][bookmark: marker-102157][bookmark: marker-102159][bookmark: marker-102161]

 
           [bookmark: pgfId-102165]When connecting to a remote SSL-enabled server through clientless SSL VPN, it is important to know that you can trust the remote server, and that it is in fact the server you are trying to connect to. ASA 9.0 introduces support for SSL server certificate verification against a list of trusted certificate authority (CA) certificates for clientless SSL VPN.

 
           [bookmark: pgfId-102167]When you connect to a remote server via a web browser using the HTTPS protocol, the server will provide a digital certificate signed by a CA to identify itself. Web browsers ship with a collection of CA certificates which are used to verify the validity of the server certificate. This is a form of public key infrastructure (PKI).

 
           [bookmark: pgfId-102169]Just as browsers provide certificate management facilities, so does the ASA in the form of trusted certificate pool management facility: trustpools. This can be thought of as a special case of trustpoint representing multiple known CA certificates. The ASA includes a default bundle of certificates, similar to that provided with web browsers, but it is inactive until activated by the administrator.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-102171]Note If you are already familiar with trustpools from Cisco IOS then you should be aware that the ASA version is similar, but not identical.


           
            

           

           

 
           [bookmark: pgfId-102173]This procedure describes how to enable HTTPS server verification for clientless SSL VPN users.

 
           [bookmark: pgfId-102175]Related Topics

 
            
            		 [bookmark: pgfId-102180]Configuring Other SSL VPN Settings (ASA)

 
            		 [bookmark: pgfId-102185]Configuring Trusted Pool Settings (ASA)

 
            		 [bookmark: pgfId-102190]Using the Trustpool Manager

 
           

 
           
 
           [bookmark: pgfId-102192]Step 1 Do one of the following:

 
            
            		 [bookmark: pgfId-102194](Device view) With an ASA device selected, select  Remote Access VPN > SSL VPN > Other Settings from the Policy selector. Click the  SSL Server Verification tab.

 
            		 [bookmark: pgfId-102196](Policy view) Select  Remote Access VPN > SSL VPN > Other Settings (ASA) from the Policy Type selector. Select an existing policy or create a new one. Click the  SSL Server Verification tab.

 
           

 
           [bookmark: pgfId-102198]Step 2 Select Enable to enable HTTPS Server Verification for Clientless SSL VPN users.

 
           [bookmark: pgfId-102200]Step 3 Specify the action you want to be taken if server certificate verification fails:

 
            
            		 [bookmark: pgfId-102202] Disconnect user from Https page – Disconnect if the server could not be verified.

 
            		 [bookmark: pgfId-102204] Allow user to continue to Https page – Allow the user to continue the connection, even if the check failed.

 
           

 
           [bookmark: pgfId-102206]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-102224][bookmark: 81728][bookmark: ravpnch_cncpt_UnderstandingSSLVPNSharedLicenses]Configuring SSL VPN Shared Licenses (ASA 8.2+)[bookmark: marker-102214][bookmark: marker-102216][bookmark: marker-102218][bookmark: marker-102220][bookmark: marker-102222]

 
           [bookmark: pgfId-102226]Use the SSL VPN Shared License page to configure your SSL VPN Shared License.

 
           [bookmark: pgfId-102228]You can purchase a shared license with a large number of SSL or remote access IKEv2 IPsec VPN sessions and share the sessions as needed among a group of ASA devices by configuring one of the ASA devices as a shared license server, and the rest as clients. For the server license, you can share 500-50,000 licenses in increments of 500 and 50,000-1,040,000 licenses in increments of 1000.

 
           [bookmark: pgfId-102230]A license is consumed by each remote access user that makes an SSL or IKEv2 IPsec connection.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-102232]Note The shared license cannot be used at the same time as the AnyConnect Essentials license.


           
            

           

           

 
           [bookmark: pgfId-102234]The following topics explain the procedure for configuring shared licenses:

 
            
            		 [bookmark: pgfId-102239]Configuring an ASA Device as a Shared License Client

 
            		 [bookmark: pgfId-102244]Configuring an ASA Device as a Shared License Server

 
           

 
           [bookmark: pgfId-102246]Navigation Path

 
            
            		 [bookmark: pgfId-102248](Device View) Select an ASA device using version 8.2 or higher, and select  Remote Access VPN > SSL VPN > Shared License from the Policy selector.

 
            		 [bookmark: pgfId-102250](Policy View) Select  Remote Access VPN > SSL VPN > Shared License (ASA 8.2+) from the Policy Type selector. Select an existing policy or create a new one.

 
           

 
           [bookmark: pgfId-102252]Field Reference

 
           [bookmark: pgfId-102255] 

 
            
             
              
              [bookmark: pgfId-98072]Table 31-26 [bookmark: 81774]SSL VPN Shared License Page 

 
              
             
               
               		
                 
                 [bookmark: pgfId-98078]Element
                
  
               		
                 
                 [bookmark: pgfId-98080]Description
                
  
              

 
               
               		[bookmark: pgfId-98086]Select Role

  
               		[bookmark: pgfId-98088]The role you are configuring, either Shared License Client or Shared License Server. Depending on your choice, different fields appear.

  
              

 
               
               		 
                 
                 [bookmark: pgfId-98094]Shared License Client
                
  
              

 
               
               		[bookmark: pgfId-98102]Shared Secret

  
               		[bookmark: pgfId-98104]The case-sensitive string (4-128 characters) used for communicating with the shared license server.

  
              

 
               
               		[bookmark: pgfId-98110]License Server

  
               		[bookmark: pgfId-98112]The IP address or the name of a network/host object that identifies the ASA device configured as the license server. Click Select to select an existing object or to create a new one.

  
              

 
               
               		[bookmark: pgfId-98118]License Server Port

  
               		[bookmark: pgfId-98120]The number of the TCP port on which the license server communicates. Enter a port number or the name of a port list object, or click Select to select an object or to create a new one.

  
              

 
               
               		[bookmark: pgfId-98126]Select Backup Role of Client

  
               		[bookmark: pgfId-98128]The backup role of the client:

 
                 
                 		 [bookmark: pgfId-98130]Client Only—When selected, the client acts only as the client. In this case, you can specify another device as a backup server. Enter the IP address or the name of a network/host object, or click  Select to select the object from a list or to create a new object.

 
                 		 [bookmark: pgfId-98132]Backup Server—When selected, the client also acts as the backup server. In this case, you must also specify the interfaces to be used for this purpose. Enter a comma-separated list of interface names or interface role objects, or click  Select to select interfaces or objects or to create new objects.

 
                

  
              

 
               
               		 
                 
                 [bookmark: pgfId-98138]Shared License Server
                
  
              

 
               
               		[bookmark: pgfId-98146]Shared Secret

  
               		[bookmark: pgfId-98148]The case-sensitive string (4-128 characters) used for communicating with the shared license server.

  
              

 
               
               		[bookmark: pgfId-98154]License Server Port

  
               		[bookmark: pgfId-98156]The number of the TCP port on which the license server communicates. Enter a port number or the name of a port list object, or click Select to select an object or to create a new one.

  
              

 
               
               		[bookmark: pgfId-98162]Refresh Interval

  
               		[bookmark: pgfId-98164]The refresh interval, between 10-300 seconds. The default is 30 seconds.

  
              

 
               
               		[bookmark: pgfId-98170]Interfaces

  
               		[bookmark: pgfId-98172]A comma-separated list of interfaces used for communicating shared licenses to clients. Enter the names of interfaces or interface role objects, or click Select to select interfaces or objects or to create new objects.

  
              

 
               
               		[bookmark: pgfId-98178]Configure Backup shared SSL VPN License Server

  
               		[bookmark: pgfId-98180]Whether to configure a backup server for the shared license server. If you select this option, configure the following:

 
                 
                 		 [bookmark: pgfId-98182] Backup License Server —The IP address, or network/host object that contains the address, of the server to act as a backup license server if the current one is unavailable. Click  Select to select an object or to create a new one.

 
                 		 [bookmark: pgfId-98184] Backup Server Serial Number —The serial number of the backup license server.

 
                 		 [bookmark: pgfId-98186] HA Peer Serial Number —(Optional) The serial number of the backup server of a failover pair.

 
                

  
              

 
             
            

 
           
 
           [bookmark: pgfId-102257]This section contains the following topics:

 
            
            		 [bookmark: pgfId-102262]Configuring an ASA Device as a Shared License Client

 
            		 [bookmark: pgfId-102267]Configuring an ASA Device as a Shared License Server

 
           

 
          
 
           
            [bookmark: pgfId-102283][bookmark: 81866][bookmark: ravpnch_proc_ConfiguringSharedLicensesClientASA]Configuring an ASA Device as a Shared License Client[bookmark: marker-102273][bookmark: marker-102275][bookmark: marker-102277][bookmark: marker-102279][bookmark: marker-102281]

 
           [bookmark: pgfId-102285]This procedures describes how to configure an ASA device as a shared license client.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-102287]Tip You must ensure that the SSL VPN Shared License Client activation key is present on the device.


           
            

           

           

 
           
 
           [bookmark: pgfId-102289]Step 1 Do one of the following:

 
            
            		 [bookmark: pgfId-102291](Device view) With an ASA device selected, select  Remote Access VPN > SSL VPN > Shared License from the Policy selector.

 
            		 [bookmark: pgfId-102293](Policy view) Select  Remote Access VPN > SSL VPN >Shared License (ASA 8.2+) from the Policy Type selector. Select an existing policy or create a new one.

 
           

 
           [bookmark: pgfId-102298]The SSL VPN Shared License page appears (see Configuring SSL VPN Shared Licenses (ASA 8.2+)).

 
           [bookmark: pgfId-102300]Step 2 Select Shared License Client as the role of the device.

 
           [bookmark: pgfId-102302]Step 3 In the Shared Secret field, enter and confirm a case-sensitive string (4-128 characters) used for communicating with the shared license server.

 
           [bookmark: pgfId-102304]Step 4 In the License Server field, enter the IP address or the name of a network/host object that identifies the ASA device configured as the license server.

 
           [bookmark: pgfId-102306]Step 5 In the License Server Port field, enter the number of the TCP port on which the license server communicates.

 
           [bookmark: pgfId-102308]Step 6 Select the role of the client:

 
            
            		 [bookmark: pgfId-102310] Client Only —When selected, the client acts only as the client. In this case, you can specify another device as a backup server.

 
            		 [bookmark: pgfId-102312] Backup Server —When selected, the client also acts as the backup server. In this case, you must also specify the interfaces to be used for this purpose.

 
           

 
           [bookmark: pgfId-102314]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-102330][bookmark: 81922][bookmark: ravpnch_proc_ConfiguringSharedLicensesServerASA]Configuring an ASA Device as a Shared License Server[bookmark: marker-102320][bookmark: marker-102322][bookmark: marker-102324][bookmark: marker-102326][bookmark: marker-102328]

 
           [bookmark: pgfId-102332]This procedures describe how to configure an ASA device as a shared license server.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-102334]Tip You must ensure that the SSL VPN Shared License Server activation key is present on the device.


           
            

           

           

 
           
 
           [bookmark: pgfId-102336]Step 1 Do one of the following:

 
            
            		 [bookmark: pgfId-102338](Device view) With an ASA device selected, select  Remote Access VPN > SSL VPN > Shared License from the Policy selector.

 
            		 [bookmark: pgfId-102340](Policy view) Select  Remote Access VPN > SSL VPN >Shared License (ASA 8.2+) from the Policy Type selector. Select an existing policy or create a new one.

 
           

 
           [bookmark: pgfId-102345]The SSL VPN Shared License page appears (see Configuring SSL VPN Shared Licenses (ASA 8.2+)).

 
           [bookmark: pgfId-102347]Step 2 Select Shared License Server as the role of the device.

 
           [bookmark: pgfId-102349]Step 3 In the Shared Secret field, enter and confirm a case-sensitive string (4-128 characters) used for communicating with the shared license server.

 
           [bookmark: pgfId-102351]Step 4 In the License Server Port field, enter the number of the TCP port on which the license server communicates.

 
           [bookmark: pgfId-102353]Step 5 In the Refresh Interval field, enter a value between 10-300 seconds to be used as the refresh interval. Default is 30 seconds.

 
           [bookmark: pgfId-102355]Step 6 In the Interfaces field, enter or select the interfaces to be used for communicating with clients.

 
           [bookmark: pgfId-102357]Step 7 (Optional.) Select Configure Backup shared SSL VPN License Server to configure a backup server for the shared license server, then configure the following:

 
            
            		 [bookmark: pgfId-102359] Backup License Server —The IP address, or network/host object that contains the address, of the server to act as a backup license server if the current one is unavailable.

 
            		 [bookmark: pgfId-102361] Backup Server Serial Number —The serial number of the backup license server.

 
            		 [bookmark: pgfId-102363] HA Peer Serial Number —(Optional) The serial number of the backup server of a failover pair.

 
           

 
           [bookmark: pgfId-102365]


           
            

           
 
           

 
          
 
         
 
          
           [bookmark: pgfId-102381][bookmark: 81986][bookmark: obman_cncpt_ConfiguringSSLVPNCustomizationObjects]Customizing Clientless SSL VPN Portals [bookmark: marker-102371][bookmark: marker-102373][bookmark: marker-102375][bookmark: marker-102377][bookmark: marker-102379]

 
          [bookmark: pgfId-102383]You can customize the web site and its contents that you use for the portal page for a browser-based clientless SSL VPN. ASA devices allow much more customization than IOS devices. You can create several policy objects that define the look of the web pages the user sees when logging into or out of the VPN and the home page for the portal, as well as the bookmarks and smart tunnels available to the user.

 
          [bookmark: pgfId-102385]This section contains the following topics:

 
           
           		 [bookmark: pgfId-102390]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
           		 [bookmark: pgfId-102395]Localizing SSL VPN Web Pages for ASA Devices

 
           		 [bookmark: pgfId-102400]Creating Your Own SSL VPN Logon Page for ASA Devices

 
           		 [bookmark: pgfId-102405]Configuring SSL VPN Bookmark Lists for ASA and IOS Devices

 
           		 [bookmark: pgfId-102410]Using the Post URL Method and Macro Substitutions in SSL VPN Bookmarks

 
           		 [bookmark: pgfId-102415]Configuring SSL VPN Smart Tunnels for ASA Devices

 
           		 [bookmark: pgfId-102420]Configuring WINS/NetBIOS Name Service (NBNS) Servers To Enable File System Access in SSL VPNs

 
          

 
           
            [bookmark: pgfId-102442][bookmark: 82009][bookmark: obman_cncpt_UnderstandingSSLVPNCustomizationObjects]Configuring ASA Portal Appearance Using SSL VPN Customization Objects [bookmark: marker-102426][bookmark: marker-102428][bookmark: marker-102430][bookmark: marker-102432][bookmark: marker-102434][bookmark: marker-102436][bookmark: marker-102438][bookmark: marker-102440]

 
           [bookmark: pgfId-102444]An SSL VPN Customization object describes the appearance of browser-based clientless SSL VPN web pages displayed to users. This includes the Logon page displayed when they connect to the ASA security appliance, the Home page displayed after authentication, and the Logout page displayed when users log out of the SSL VPN service.

 
           [bookmark: pgfId-102449]You use SSL VPN Customization objects when defining ASA group objects or Remote Access VPN Connection policies for ASA devices. You can create several customization objects and define multiple ASA group or connection profiles so that each user group sees web pages designed specifically for their use. Customization can include localizing the web pages in the languages appropriate for each group. For more information about localization, see Localizing SSL VPN Web Pages for ASA Devices.

 
           [bookmark: pgfId-102451]Initially, when a user first connects, the default customization object identified in the connection profile determines how the logon screen appears. If the user selects a different group from the connection profile list on the logon page, and that group has its own customization, the screen changes to reflect the customization object for the selected group. After the remote user is authenticated, the screen appearance is determined by the customization object that has been assigned to the group policy.

 
           [bookmark: pgfId-102453]After you create the SSL VPN customization object as described in this procedure, you can use the object to specify the portal characteristics in these policies:

 
            
            		 [bookmark: pgfId-102458]On the  SSL VPN > Settings page in an ASA group policy object (see ASA Group Policies SSL VPN Settings), which you then select in one of these policies:

 
           

 
           [bookmark: pgfId-102460] – Remote Access VPN > Group Policies

 
           [bookmark: pgfId-102462] – Remote Access VPN > Connection Profiles on the General tab

 
            
            		 [bookmark: pgfId-102467]In the  Remote Access VPN > Connection Profiles policy, you can also specify the SSL VPN customization object on the  SSL tab (see SSL Tab (Connection Profiles)).

 
           

 
           [bookmark: pgfId-102469]Related Topics

 
            
            		 [bookmark: pgfId-102474]Localizing SSL VPN Web Pages for ASA Devices

 
            		 [bookmark: pgfId-102479]Creating Policy Objects

 
            		 [bookmark: pgfId-102484]Add and Edit SSL VPN Customization Dialog Boxes

 
           

 
           
 
           [bookmark: pgfId-102489]Step 1 Select Manage > Policy Objects to open the Policy Object Manager (see Policy Object Manager).

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-102494]Tip You can also create SSL VPN Customization objects when defining policies or objects that use this object type. For more information, see Selecting Objects for Policies.


           
            

           

           

 
           [bookmark: pgfId-102496]Step 2 Select SSL VPN Customization from the Object Type selector. The SSL VPN Customization page opens, displaying a list of the existing SSL VPN Customization objects.

 
           [bookmark: pgfId-102498]Step 3 Right-click in the work area and select New Object.

 
           [bookmark: pgfId-102503]The Add SSL VPN Customization dialog box appears (see Add and Edit SSL VPN Customization Dialog Boxes).

 
           [bookmark: pgfId-102505]Step 4 Enter a name for the object and optionally a description of the object.

 
           [bookmark: pgfId-102507]Step 5 Before you configure settings for the various pages, use the Preview button to view the default settings. Clicking Preview opens a browser window to display the current settings for the Logon page, Portal page, or Logout page, whichever one is selected in the table of contents (selecting a page within one of these folders is the same as selecting the parent folder).
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           [bookmark: pgfId-102509]Tip Click Preview after making any changes to settings to verify that the changes are what you desire.


           
            

           

           

 
           [bookmark: pgfId-102511]Step 6 Configure the settings for the Logon page. This web page is the one users see first when connecting to the SSL VPN portal. It is used for logging into the VPN. Select the following items in the Logon Page folder in the table of contents on the left of the dialog box to view and change the settings:

 
            
            		 [bookmark: pgfId-102513] Logon Page —Specify the title of the web page, which is displayed in the browser’s title bar.

 
            		 [bookmark: pgfId-102518] Title Panel —Determine whether the Logon page will have a title displayed in the web page itself. If you enable the title panel, you can specify the title, font, font size and weight, styles, and colors used. You can also select a File object that identifies a logo graphic. For more information about the settings, see SSL VPN Customization Dialog Box—Title Panel.

 
            		 [bookmark: pgfId-102526] Language —If you want to configure translation tables for other languages on the ASA device and use them, you can configure the supported languages and allow users to choose their language. For information about translation tables and localization support, see Localizing SSL VPN Web Pages for ASA Devices. For more information about the settings, see SSL VPN Customization Dialog Box—Language.

 
            		 [bookmark: pgfId-102531] Logon Form —Configure the labels and colors used in the form that accepts user logon information. For more information about the settings, see SSL VPN Customization Dialog Box—Logon Form.

 
            		 [bookmark: pgfId-102536] Informational Panel —If you want to provide extra information to the user, you can enable an informational panel and add text and a logo graphic. For more information about the settings, see SSL VPN Customization Dialog Box—Informational Panel.

 
            		 [bookmark: pgfId-102541] Copyright Panel —If you want to include copyright information on the logon page, you can enable the copyright panel and enter your copyright statement. For more information about the settings, see SSL VPN Customization Dialog Box—Copyright Panel.

 
            		 [bookmark: pgfId-102549] Full Customization —If you do not want to use the security appliance’s built-in logon page, even customized, you can instead enable full customization and supply your own web page. For information on creating the required file, see Creating Your Own SSL VPN Logon Page for ASA Devices. For more information about the settings, see SSL VPN Customization Dialog Box—Full Customization.

 
           

 
           [bookmark: pgfId-102551]Step 7 Configure the settings for the Portal page. This is the home page for the SSL VPN portal, and is displayed after the users log in. Select the following items in the Portal Page folder in the table of contents on the left of the dialog box to view and change the settings:

 
            
            		 [bookmark: pgfId-102553] Portal Page —Specify the title of the web page, which is displayed in the browser’s title bar.

 
            		 [bookmark: pgfId-102558] Title Panel —Determine whether the Portal page will have a title displayed in the web page itself. If you enable the title panel, you can specify the title, font, font size and weight, styles, and colors used. You can also select a File object that identifies a logo graphic. For more information about the settings, see SSL VPN Customization Dialog Box—Title Panel.

 
            		 [bookmark: pgfId-102563] Toolbar —Determine whether the Portal page will have a toolbar, which contains a field for entering a URL to browse. For more information about the settings, see SSL VPN Customization Dialog Box—Toolbar.

 
            		 [bookmark: pgfId-102568] Applications —Determine which application buttons will appear on the page. For more information about the settings, see SSL VPN Customization Dialog Box—Applications.

 
            		 [bookmark: pgfId-102573] Custom Panes —Determine how you want to organize the body of the Portal page. The default is a single column with no internal panes. You can create a multiple-column layout, create internal panes that display text or references to URLs, and determine in which column and row to place the panes. For more information about the settings, see SSL VPN Customization Dialog Box—Custom Panes.

 
            		 [bookmark: pgfId-102578] Home Page —Determine how and whether to display URL lists on the home page, and whether to use your own web page for the main body of the Portal page. For more information about the settings, see SSL VPN Customization Dialog Box—Home Page.

 
           

 
           [bookmark: pgfId-102583]Step 8 Select Logout Page to configure the settings of the page displayed when a user logs out of the SSL VPN. You can configure the title, message text, fonts, and colors. For more information about the settings, see SSL VPN Customization Dialog Box—Logout Page.

 
           [bookmark: pgfId-102588]Step 9 (Optional) Under Category, select a category to help you identify this object in the Objects table. See Using Category Objects.

 
           [bookmark: pgfId-102593]Step 10 (Optional) Select Allow Value Override per Device to allow the properties of this object to be redefined on individual devices. See Allowing a Policy Object to Be Overridden.

 
           [bookmark: pgfId-102595]Step 11 Click OK to save the object.

 
           [bookmark: pgfId-102597]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-102609][bookmark: 82174][bookmark: obman_cncpt_LocalizingSSLVPNWebPagesforASADevices]Localizing SSL VPN Web Pages for ASA Devices[bookmark: marker-102603][bookmark: marker-102605][bookmark: marker-102607]

 
           [bookmark: pgfId-102611]Localization is the process of providing text in a language that is appropriate for the target users. When you create an SSL VPN Customization object for defining the look of browser-based clientless SSL VPN web pages hosted on an ASA device, you can configure the pages to use the desired language.

 
           [bookmark: pgfId-102613]To see localized web pages correctly, users must configure their browsers to use UTF-8 encoding (for example, in Internet Explorer, select View > Encoding > Unicode (UTF-8). They also must install the required fonts or language support files for their language using the Regional and Language Options control panel. On the Languages tab, click Details to install the desired languages, and select the appropriate supplemental language settings for East Asian, complex scripting, and right-left languages. On the Advanced tab, select the desired code page conversion tables. If users do not configure the browser correctly, they might see boxes instead of characters.

 
           [bookmark: pgfId-102615]There are two techniques you can use to localize SSL VPN web pages that are hosted on an ASA device. These techniques are not mutually exclusive; you can use both of them. These are the techniques:

 
            
            		 [bookmark: pgfId-102617] Configure the SSL VPN Customization object using the desired language —When you create the SSL VPN Customization object, you can enter text for labels and messages in non-English, non-ASCII languages in UTF-8 encoding. To enter non-ASCII languages in UTF-8 encoding, you must configure Windows with the correct locale setting and have the required fonts installed. Use the Regional and Language Options control panel to configure your system and install files required for complex script or East Asian languages. If you want to type in text directly, you also need to install an appropriate keyboard; otherwise, you can use a text editor that supports the language’s characters and copy and paste text from a document that contains the text you want to use.

 
           

 
           [bookmark: pgfId-102619]You can also enter non-ASCII languages into SSL VPN Bookmarks objects.

 
            
            		 [bookmark: pgfId-102621] Configure translation tables on the ASA device to support the languages you want to make available —To enable the security appliance to provide language translation for the portal and screens displayed to users, you must define the necessary languages in a translation table and import the table into the security appliance. The software image package for the security appliance includes a translation table template. Every language you list in an SSL VPN Customization object must have a corresponding translation table on the device. Conversely, translation tables for languages that are not listed in the SSL VPN Customization object are ignored.

 
           

 
           [bookmark: pgfId-102626]If you use this technique, you must use the ASA CLI or ASDM to configure and upload the translation tables. You cannot manage the translation tables with Security Manager. However, the SSL VPN Customization object includes settings that allow you to configure automatic browser language selection and to enable users to select their desired language. Thus, if you install translation tables for ten languages, the pages defined in the SSL VPN Customization object will be available to users in all of those languages. For more information on these settings, see SSL VPN Customization Dialog Box—Language.

 
           [bookmark: pgfId-102628]Although both of the following features require translation tables, they are separate and complementary:

 
           [bookmark: pgfId-102630] – Automatic Browser Language Selection—Automatic browser language selection attempts to select the appropriate language based on the user’s browser settings. This technique does not ask for user input. In the SSL VPN Customization object, you create a list of languages that will be used in the negotiation with the browser. During a connection, the security appliance receives a list of languages (and their priorities) from the browser, and looks through your list of languages top to bottom until a match is found. If there is no match, then the language you defined in the list as the default language is used. If you do not specify a default language, English is used.

 
           [bookmark: pgfId-102632]The languages on the security appliance are labels for the translation tables. The languages must mirror those of the browser, and can consist of groups of up to 8 alphanumeric characters (starting from alpha characters), separated by hyphens. For example, fr-FR-paris-univ8. However, when you add a language to the list in Security Manager, only the first two characters are available.

 
           [bookmark: pgfId-102634]When looking for a match, the security appliance starts with the longest language name, and if it does not match, it discards the rightmost group of the name. For example, if the preferred language on the browser is fr-FR-paris-univ8, and the security appliance supports fr-FR-paris-univ8, fr-FR-paris, fr-FR, and fr, it matches fr-FR-paris-univ8 and uses the translated strings from that translation table. If fr is the only language on the security appliance, the security appliance considers it a match also, and uses that translation table.

 
           [bookmark: pgfId-102636]For more information about setting up translation tables, see the user documentation for the ASA device and operating system or the ASDM online help.

 
           [bookmark: pgfId-102638] – Language Selector—By enabling the language selector, you provide the user with the ability to actively select the desired language from a list of languages that you support. This technique does not rely on the browser language settings being configured correctly. The language selector is displayed on the logon page.

 
           [bookmark: pgfId-102640]Related Topics

 
            
            		 [bookmark: pgfId-102645]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
            		 [bookmark: pgfId-102650]Creating Policy Objects

 
            		 [bookmark: pgfId-102655]Add and Edit SSL VPN Customization Dialog Boxes

 
           

 
          
 
           
            [bookmark: pgfId-102667][bookmark: 82225][bookmark: obman_cncpt_CreatingYourOwnSSLVPNLogonPage]Creating Your Own SSL VPN Logon Page for ASA Devices [bookmark: marker-102661][bookmark: marker-102663][bookmark: marker-102665]

 
           [bookmark: pgfId-102669]You can create your own custom SSL VPN Logon page rather than use the page provided by the security appliance for browser-based clientless SSL VPNs. This is called full customization, and replaces the settings you can configure in the SSL VPN Customization policy object.

 
           [bookmark: pgfId-102674]To provide your own Logon page, you must create the page, copy it to the Security Manager server, and identify the page on the Full Customization page of the SSL VPN Customization object dialog box. For information on creating SSL VPN Customization objects, see Configuring ASA Portal Appearance Using SSL VPN Customization Objects.

 
           [bookmark: pgfId-102676]When you enable full customization, all other settings for the Logon page configured in the policy object are ignored. When you deploy your configuration to the ASA device, Security Manager copies your custom page to the device.

 
           [bookmark: pgfId-102678]The Logon page you create must include all of the HTML code required to present the page correctly, and include special Cisco HTML code that provides the functions for the login form and the Language Selector drop-down list. Keep the following in mind when you create the HTML file:

 
            
            		 [bookmark: pgfId-102680]The file extension must be  .inc .

 
            		 [bookmark: pgfId-102682]All images in the custom Logon page must be present on the security appliance. Replace the file path with the keyword  /+CSCOU+/ , which is an internal directory on the ASA device. When you upload an image to the device, it is saved in this directory.

 
            		 [bookmark: pgfId-102684]Use the  csco_ShowLoginForm(’lform’) Javascript function to add the login form to the page. This form prompts for the username, passwords, and group information. You must include this function somewhere on the page.

 
            		 [bookmark: pgfId-102686]Use the  csco_ShowLanguageSelector(’selector’) Javascript function to add the Language Selector drop-down list to the page. You do not have to use this function if you are not supporting the use of more than one language.

 
           

 
           [bookmark: pgfId-102688]Related Topics

 
            
            		 [bookmark: pgfId-102693]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
            		 [bookmark: pgfId-102698]Add and Edit SSL VPN Customization Dialog Boxes

 
            		 [bookmark: pgfId-102703]SSL VPN Customization Dialog Box—Full Customization

 
           

 
          
 
           
            [bookmark: pgfId-102733][bookmark: 82269][bookmark: obman_cncpt_UnderstandingSSLVPNBookmarkObjects]Configuring SSL VPN Bookmark Lists for ASA and IOS Devices [bookmark: marker-102709][bookmark: marker-102711][bookmark: marker-102713][bookmark: marker-102715][bookmark: marker-102717][bookmark: marker-102719][bookmark: marker-102721][bookmark: marker-102723][bookmark: marker-102725][bookmark: marker-102727][bookmark: marker-102729][bookmark: marker-102731]

 
           [bookmark: pgfId-102735]When you configure a browser-based clientless SSL VPN, you can define a list of bookmarks, or URLS, to include on the SSL VPN portal page. Use SSL VPN bookmarks policy objects to define bookmark lists.

 
           [bookmark: pgfId-102740]You can create SSL VPN bookmark objects for SSL VPNs hosted on IOS devices or ASA devices. However, these device types allow different bookmark configurations, the ASA device allowing more configuration options than IOS devices. Besides allowing more configuration options, you can also create bookmarks for ASA devices in non-English, non-ASCII languages. For more information on localizing the bookmarks and portal for ASA devices, see Localizing SSL VPN Web Pages for ASA Devices.

 
           [bookmark: pgfId-102742]After you create the SSL VPN bookmark object as described in this procedure, you can use the object to specify the bookmark object in the Portal Web Pages or Bookmarks fields in these policies:

 
            
            		 [bookmark: pgfId-102747]ASA devices—On the  SSL VPN > Clientless page in an ASA group policy object (see ASA Group Policies SSL VPN Clientless Settings), which you then select in one of these policies:

 
           

 
           [bookmark: pgfId-102749] – Remote Access VPN > Group Policies

 
           [bookmark: pgfId-102751] – Remote Access VPN > Connection Profiles on the General tab

 
            
            		 [bookmark: pgfId-102756]ASA devices—In the  Remote Access VPN > Dynamic Access policy, you can specify the SSL VPN bookmark object on the  Main > Bookmarks tab (see Main Tab).

 
            		 [bookmark: pgfId-102761]IOS devices—On the  Clientless page in a user group policy object configured for SSL VPN (see User Group Dialog Box—Clientless Settings), which you then select in the  Remote Access VPN > SSL VPN policy on the  General tab.

 
           

 
           [bookmark: pgfId-102763]Related Topics

 
            
            		 [bookmark: pgfId-102768]Creating Group Policies (ASA, PIX 7.0+)

 
            		 [bookmark: pgfId-102773]Configuring Dynamic Access Policies

 
            		 [bookmark: pgfId-102778]Configuring Connection Profiles (ASA, PIX 7.0+)

 
            		 [bookmark: pgfId-102783]Configuring an SSL VPN Policy (IOS)

 
            		 [bookmark: pgfId-102788]Creating Policy Objects

 
            		 [bookmark: pgfId-102793]Policy Object Manager

 
           

 
           
 
           [bookmark: pgfId-102798]Step 1 Select Manage > Policy Objects to open the Policy Object Manager (see Policy Object Manager).

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-102803]Tip You can also create SSL VPN bookmark objects when you define policies or objects that use this object type. For more information, see Selecting Objects for Policies.


           
            

           

           

 
           [bookmark: pgfId-102805]Step 2 Select SSL VPN Bookmarks from the Object Type selector. The SSL VPN Bookmarks page opens, displaying a list of the existing SSL VPN bookmark objects.

 
           [bookmark: pgfId-102807]Step 3 Right-click in the work area, then select New Object.

 
           [bookmark: pgfId-102812]The Add SSL VPN Bookmark dialog box appears (see Add or Edit Bookmarks Dialog Boxes).

 
           [bookmark: pgfId-102814]Step 4 Enter a name for the object and optionally a description of the object.

 
           [bookmark: pgfId-102816]Step 5 If you are creating the object for an SSL VPN hosted on an IOS device, you can enter a name for the heading that is displayed above the bookmarks list in the Bookmarks Heading (IOS) field.

 
           [bookmark: pgfId-102818]Step 6 The Bookmarks table displays any URLs that are defined for the object. To add a bookmark, click the Add Row button below the table; to edit an existing bookmark, select it and click the Edit Row button.

 
           [bookmark: pgfId-102823]The Add/Edit SSL VPN Bookmark Entry dialog box opens. For more information about the fields on this dialog box, see Add or Edit Bookmark Entry Dialog Boxes.

 
            
            		 [bookmark: pgfId-102825]In the  Bookmark Option field, select whether you are defining a bookmark ( Enter Bookmark ) or adding bookmarks from another SSL VPN bookmark object ( Include Existing Bookmarks ). If you are including an existing object, enter the object’s name or click  Select to select it from a list of existing objects.

 
            		 [bookmark: pgfId-102827]If you are creating the object for use on an IOS device, enter the title of the bookmark, which is displayed to users, and the URL. Be careful to select the correct protocol for the URL. Click  OK to add the bookmark to the table of bookmarks.

 
            		 [bookmark: pgfId-102829]If you are creating the object for use on an ASA device, you have many more options. Besides the title and the URL, you can define a subtitle and image icon for the bookmark plus other options.

 
           

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-102834]Tip If you choose the protocols RDP, SSH, Telnet, VNC, or ICA, you must configure the plug-in for the protocol in the Remote Access VPN > SSL VPN > Other Settings policy (see Configuring SSL VPN Browser Plug-ins (ASA)).


           
            

           

           

 
           [bookmark: pgfId-102836]You can also configure the bookmark to use the Post method rather than the Get method. If you use Post, you must configure the post parameters by clicking Add Row beneath the Post Parameters table. For more information on Post parameters, see these topics:

 
           [bookmark: pgfId-102841] – Using the Post URL Method and Macro Substitutions in SSL VPN Bookmarks

 
           [bookmark: pgfId-102846] – Add and Edit Post Parameter Dialog Boxes

 
           [bookmark: pgfId-102848]Click OK to add the bookmark to the table of bookmarks.

 
           [bookmark: pgfId-102853]Step 7 (Optional) Under Category, select a category to help you identify this object in the Objects table. See Using Category Objects.

 
           [bookmark: pgfId-102858]Step 8 (Optional) Select Allow Value Override per Device to allow the properties of this object to be redefined on individual devices. See Allowing a Policy Object to Be Overridden.

 
           [bookmark: pgfId-102860]Step 9 Click OK to save the object.

 
           [bookmark: pgfId-102862]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-102884][bookmark: 82434][bookmark: obman_cncpt_UsingthePostURLMethodandMacroSubstitutionsinBookmarks]Using the Post URL Method and Macro Substitutions in SSL VPN Bookmarks[bookmark: marker-102868][bookmark: marker-102870][bookmark: marker-102872][bookmark: marker-102874][bookmark: marker-102876][bookmark: marker-102878][bookmark: marker-102880][bookmark: marker-102882]

 
           [bookmark: pgfId-102886]One of the options you have for configuring bookmarks on an SSL VPN hosted on an ASA device is the method used by a URL, either Get or Post. The Get method is the standard method; a user clicks the URL and is taken to the web page. The Post method is useful when processing the data might involve changes to it, for example, storing or updating data, ordering a product, or sending e-mail.

 
           [bookmark: pgfId-102888]If you choose the Post URL method, you must configure Post parameters for bookmark entries. Because these are often personalized resources that contain the user ID and password or other input parameters, you might need to define clientless SSL VPN macro substitutions.

 
           [bookmark: pgfId-102890]Clientless SSL VPN macro substitutions let you configure users for access to personalized resources that contain the user ID and password or other input parameters. Examples of such resources include bookmark entries, URL lists, and file shares.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-102892]Note For security reasons, password substitutions are disabled for file access URLs (cifs://). Also for security reasons, use caution when introducing password substitutions for web links, especially for non-SSL instances.


           
            

           

           

 
           [bookmark: pgfId-102894]You can use the following macro substitutions:

 
            
            		 [bookmark: pgfId-102896] Logon Information Substitutions — The security appliance obtains values for these substitutions from the SSL VPN Logon page. It recognizes these strings in user requests, and replaces them with the value specific to the user before it passes the request on to a remote server.

 
           

 
           [bookmark: pgfId-102898]These are the available macro substitutions:

 
           [bookmark: pgfId-102900] – CSCO_WEBVPN_USERNAME

 
           [bookmark: pgfId-102902]The username used to log into the SSL VPN.

 
           [bookmark: pgfId-102904] – CSCO_WEBVPN_PASSWORD

 
           [bookmark: pgfId-102906]The password used to log into the SSL VPN.

 
           [bookmark: pgfId-102908] – CSCO_WEBVPN_INTERNAL_PASSWORD

 
           [bookmark: pgfId-102910]The internal resource password entered when logging into the SSL VPN.

 
           [bookmark: pgfId-102912] – CSCO_WEBVPN_CONNECTION_PROFILE

 
           [bookmark: pgfId-102914]The connection profile associated with the user group selected when logging into the SSL VPN.

 
           [bookmark: pgfId-102916]For example, if a URL list contains the link http://someserver/homepage/CSCO_WEBVPN_USERNAME.html, the security appliance translates it to the following unique links:

 
           [bookmark: pgfId-102918] – For USER1 the link becomes http://someserver/homepage/USER1.html

 
           [bookmark: pgfId-102920] – For USER2 the link is http://someserver/homepage/USER2.html

 
           [bookmark: pgfId-102922]In the following example, cifs://server/users/CSCO_WEBVPN_USERNAME lets the security appliance map a file drive to specific users:

 
           [bookmark: pgfId-102924] – For USER1 the link becomes cifs://server/users/USER1

 
           [bookmark: pgfId-102926] – For USER2 the link is cifs://server/users/USER2

 
            
            		 [bookmark: pgfId-102928] RADIUS/LDAP Vendor-Specific Attributes (VSAs) —These substitutions let you set substitutions configured on either a RADIUS or an LDAP server. These are the available macro substitutions:

 
           

 
           [bookmark: pgfId-102930] – CSCO_WEBVPN_MACRO1

 
           [bookmark: pgfId-102932] – CSCO_WEBVPN_MACRO2

 
           [bookmark: pgfId-102937]For information on configuring bookmarks, see Configuring SSL VPN Bookmark Lists for ASA and IOS Devices.

 
          
 
           
            [bookmark: pgfId-102961][bookmark: 82513][bookmark: obman_cncpt_UnderstandingSSLVPNSmartTunnelListObjects]Configuring SSL VPN Smart Tunnels for ASA Devices [bookmark: marker-102943][bookmark: marker-102945][bookmark: marker-102947][bookmark: marker-102949][bookmark: marker-102951][bookmark: marker-102953][bookmark: marker-102955][bookmark: marker-102957][bookmark: marker-102959]

 
           [bookmark: pgfId-102963]A smart tunnel is a connection between an application running on a user’s workstation and a private site. The connection uses a clientless (browser-based) SSL VPN session with the security appliance as the pathway and proxy server. Smart tunnels do not require the user to connect the application to the local port, so the application can gain access to the network without giving the user administrative privileges, as is required for full tunnel support. If you do not otherwise configure the network to allow access to an application, you can create a smart tunnel for those applications that you want to support.

 
           [bookmark: pgfId-102965]You can configure smart tunnel access to an application under the following conditions:

 
            
            		 [bookmark: pgfId-102967]The application is a Winsock 2, TCP-based application and there is a browser plug-in for the application. Cisco distributes plug-ins for some applications for use in clientless SSL VPN, including SSH (for both SSH and Telnet sessions), RDP, and VNC. You must supply or obtain plug-ins for any other applications. Configure plug-ins in the  Remote Access VPN > SSL VPN > Other Settings policy on the Plug-Ins tab.

 
            		 [bookmark: pgfId-102971]The user’s workstation is a supported platform. See the Cisco ASA 5500 Series Adaptive Security Appliances documentation that corresponds with your ASA version for supported platforms,  http://www.cisco.com/en/US/products/ps6120/products_installation_and_configuration_guides_list.html .

 
           

 
           [bookmark: pgfId-102973]Users of Microsoft Windows Vista who use smart tunnels (or port forwarding) must add the URL of the ASA device to the Trusted Site zone. Configure the Trusted Site zone in Internet Explorer (Tools > Internet Options, Security tab).

 
            
            		 [bookmark: pgfId-102975]The user’s browser must be enabled with Java, Microsoft ActiveX, or both.

 
            		 [bookmark: pgfId-102977]If the user’s workstation requires a proxy server to reach the security appliance, the URL of the terminating end of the connection must be in the list of URLs excluded from proxy services. In this configuration, smart tunnels support only basic authentication.
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           [bookmark: pgfId-102979]Tip A stateful failover does not retain smart tunnel connections. Users must reconnect following a failover.


           
            

           

           

 
           [bookmark: pgfId-102981]You configure smart tunnel access for an application by creating an SSL VPN smart tunnel list policy object and including that object in an ASA group policy object. You then assign the ASA group policy object to a device in the Remote Access VPN > Group Policies policy.

 
           [bookmark: pgfId-102983]Related Topics

 
            
            		 [bookmark: pgfId-102988]Understanding Group Policies (ASA)

 
            		 [bookmark: pgfId-102993]Creating Policy Objects

 
            		 [bookmark: pgfId-102998]Policy Object Manager

 
           

 
           
 
           [bookmark: pgfId-103000]Step 1 Create an SSL VPN smart tunnel list policy object:

 
           [bookmark: pgfId-103005] a. Select Manage > Policy Objects to open the Policy Object Manager (see Policy Object Manager), and select SSL VPN Smart Tunnel Lists from the table of contents.
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           [bookmark: pgfId-103010]Tip You can also create SSL VPN smart tunnel list objects when you create or edit the ASA group policy object. For more information, see Selecting Objects for Policies.


           
            

           

           

 
           [bookmark: pgfId-103015] b. Click the Add Object button to open the Add and Edit Smart Tunnel List Dialog Boxes.

 
           [bookmark: pgfId-103017] c. Enter a name for the object, up to 64 characters.

 
           [bookmark: pgfId-103022] d. To the table of applications, add those applications for which you are granting smart tunnel access (click the Add Row button to open the Add and Edit A Smart Tunnel Entry Dialog Boxes). Consider the following:

 
            
            		 [bookmark: pgfId-103024]Enter an application name that is easy to understand and include version numbers if you support more than one version. For example, Microsoft Outlook.

 
            		 [bookmark: pgfId-103026]For the application path, entering only the filename, for example, outlook.exe, is the simplest and most maintainable option. This allows the user to install the application in any folder. Enter the full path if you want to enforce a specific installation structure.

 
            		 [bookmark: pgfId-103031]Hash values are optional, but you can use them to prevent spoofing. Without hash values, a user can rename an application to a supported filename; the security appliance checks only the filename and path (if specified). However, if you enter hash values, you must maintain them as users apply patches or application upgrades. For specific information on determining hash values, see Add and Edit A Smart Tunnel Entry Dialog Boxes.

 
           

 
           [bookmark: pgfId-103033]Click OK to save the entry.

 
           [bookmark: pgfId-103035] e. You can also incorporate other SSL VPN smart list objects into the object. This allows you to create a core set of smart list objects that you can use repeatedly in other objects.

 
           [bookmark: pgfId-103037] f. Click OK to save the object.

 
           [bookmark: pgfId-103039]Step 2 (Optional) Create an SSL VPN smart tunnel auto sign-on list policy object:

 
           [bookmark: pgfId-103044] a. Select Manage > Policy Objects to open the Policy Object Manager (see Policy Object Manager), and select SSL VPN Smart Tunnel Auto Signon Lists from the table of contents.
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           [bookmark: pgfId-103049]Tip You can also create SSL VPN smart tunnel auto sign-on list objects when you create or edit the ASA group policy object. For more information, see Selecting Objects for Policies.


           
            

           

           

 
           [bookmark: pgfId-103054] b. Click the Add Object button to open the Add and Edit Smart Tunnel Auto Signon List Dialog Boxes.

 
           [bookmark: pgfId-103056] c. Enter a name for the object, up to 64 characters.

 
           [bookmark: pgfId-103061] d. To the table of smart tunnel auto sign-on entries, add the servers for which to automate the submission of login credentials during smart tunnel setup (click the Add Row button to open the Add and Edit Smart Tunnel Auto Signon Entry Dialog Boxes).

 
           [bookmark: pgfId-103063] e. You can also incorporate other SSL VPN smart tunnel auto sign-on list objects into the object. This allows you to create a core set of smart tunnel auto sign-on list objects that you can use repeatedly in other objects.

 
           [bookmark: pgfId-103065] f. Click OK to save the object.

 
           [bookmark: pgfId-103067]Step 3 Configure the ASA group policy object to use the SSL VPN smart tunnel list object:

 
           [bookmark: pgfId-103072] a. Edit (or create) the ASA group policy object either from the Policy Object Manager or the Remote Access VPN > Group Policies policy. The object must be configured to support SSL VPNs. (You can also edit these objects from the Remote Access VPN > Connection Profiles policy from an individual profile.)

 
           [bookmark: pgfId-103077] b. Select the SSL VPN > Clientless folder from the table of contents to open ASA Group Policies SSL VPN Clientless Settings.

 
           [bookmark: pgfId-103079] c. Enter the name of the SSL VPN smart tunnel list object in the Smart Tunnel field.

 
           [bookmark: pgfId-103081] d. Select Auto Start Smart Tunnel to automatically start smart tunnels for the applications when the user connects to the SSL VPN portal.

 
           [bookmark: pgfId-103083]If you do not select this option, users must start smart tunnel access using the Application Access > Start Smart Tunnels button on the clientless SSL VPN portal page.

 
           [bookmark: pgfId-103085] e. Enter the name of the SSL VPN smart tunnel auto sign-on list object in the Smart Tunnel Auto Signon Server List field.

 
           [bookmark: pgfId-103087] f. If the universal naming convention (domain\username) is required for authentication, specify the Windows domain to add it to the username during auto sign-on in the Domain Name field. For example, enter CISCO to specify CISCO\qa_team when authenticating for the username qa_team. You must also check the Use Domain option when configuring associated entries in the auto sign-on server list.

 
           [bookmark: pgfId-103089]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-103119][bookmark: 82670][bookmark: obman_proc_CreatingWINSServerListObjects]Configuring WINS/NetBIOS Name Service (NBNS) Servers To Enable File System Access in SSL VPNs [bookmark: marker-103095][bookmark: marker-103097][bookmark: marker-103099][bookmark: marker-103101][bookmark: marker-103103][bookmark: marker-103105][bookmark: marker-103107][bookmark: marker-103109][bookmark: marker-103111][bookmark: marker-103113][bookmark: marker-103115][bookmark: marker-103117]

 
           [bookmark: pgfId-103121]Clientless SSL VPN uses WINS and the Common Internet File System (CIFS) protocol to access or share files, printers, and other machine resources on remote systems. The ASA or IOS device uses a proxy CIFS client to provide this access transparently; users appear to have direct access to the file systems (subject to individual file and user permissions).

 
           [bookmark: pgfId-103123]When users attempt a file-sharing connection to a Windows computer by using its computer name, the file server they specify corresponds to a specific WINS name that identifies a resource on the network. The security appliance queries WINS or NetBIOS name servers to map WINS names to IP addresses. SSL VPN requires NetBIOS to access or share files on remote systems.

 
           [bookmark: pgfId-103125]You use WINS server list policy objects to configure the list of WINS servers that are used to resolve these Microsoft file-directory share names. The WINS server list objects define the NetBIOS Name Service (NBNS) server list on the device (using the nbns-list and nbns-server commands) for Common Internet File System (CIFS) name resolution.

 
           [bookmark: pgfId-103127]After creating the WINS server list policy object, you can configure it in the following policies and policy objects, and also select the file access services that you want to allow:

 
            
            		 [bookmark: pgfId-103132]ASA devices—In the  Remote Access VPN > Connection Profiles policy, specify the WINS server list object on the  SSL tab (see SSL Tab (Connection Profiles)).

 
           

 
           [bookmark: pgfId-103137]Select the file access options on the SSL VPN > Clientless page in an ASA group policy object (see ASA Group Policies SSL VPN Clientless Settings), which you then select in one of these policies:

 
           [bookmark: pgfId-103139] – Remote Access VPN > Group Policies

 
           [bookmark: pgfId-103141] – Remote Access VPN > Connection Profiles on the General tab

 
            
            		 [bookmark: pgfId-103146]IOS devices—On the  Clientless page in a user group policy object configured for SSL VPN (see User Group Dialog Box—Clientless Settings), which you then select in the  Remote Access VPN > SSL VPN policy on the  General tab.

 
           

 
           [bookmark: pgfId-103148]Related Topics

 
            
            		 [bookmark: pgfId-103153]Creating Policy Objects

 
           

 
           
 
           [bookmark: pgfId-103158]Step 1 Select Manage > Policy Objects to open the Policy Object Manager.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-103163]Tip You can also create WINS server list objects when defining policies or objects that use this object type. For more information, see Selecting Objects for Policies.


           
            

           

           

 
           [bookmark: pgfId-103165]Step 2 Select WINS Server Lists from the Object Type selector.

 
           [bookmark: pgfId-103167]The WINS Server List page opens, displaying the currently defined WINS server list objects.

 
           [bookmark: pgfId-103172]Step 3 Right-click in the work area and select New Object to open the Add or Edit WINS Server List Dialog Box.

 
           [bookmark: pgfId-103174]Step 4 Enter a name for the object and optionally a description of the object.

 
           [bookmark: pgfId-103176]Step 5 Click the Add Row button below the table, or select a server in the table and click Edit Row, to configure the WINS servers defined in the object. Configure these settings:

 
            
            		 [bookmark: pgfId-103178] Server —The IP address of the WINS server. You can select a network/host object or enter the address directly.

 
            		 [bookmark: pgfId-103180] Set as Master Browser —Select this option if the server is a master browser, which maintains the list of computers and shared resources.

 
           

 
           [bookmark: pgfId-103185]Other fields are optional; change them if you want non-default values. For more information, see Add or Edit WINS Server Dialog Box.

 
           [bookmark: pgfId-103187]Click OK to save your changes.

 
           [bookmark: pgfId-103192]Step 6 (Optional) Under Category, select a category to help you identify this object in the Objects table. See Using Category Objects.

 
           [bookmark: pgfId-103197]Step 7 (Optional) Select Allow Value Override per Device to allow the properties of this object to be redefined on individual devices. See Allowing a Policy Object to Be Overridden.

 
           [bookmark: pgfId-103199]Step 8 Click OK to save the object.

 
           [bookmark: pgfId-103201]
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     [bookmark: pgfId-900652][bookmark: 13780][bookmark: obman_cncpt_ManagingObjects]Managing Policy Objects[bookmark: marker-900648][bookmark: marker-900650]
      
      
 
     
 

 
    [bookmark: pgfId-900654]Policy objects enable you to define logical collections of elements. They are reusable, named components that can be used by other objects and policies. Objects aid policy definition by eliminating the need to define that component each time you define a policy. When used, an object becomes an integral component of the object or policy. This means that if you change the definition of an object, this change is reflected in all objects and policies that reference the object.

 
    [bookmark: pgfId-900656]Objects facilitate network updates, because you can identify objects separately but maintain them in a central location. For example, you can identify the servers in your network as a network/host object called MyServers, and the protocols to allow on these servers in a service object. You can then create an access rule that permits the MyServers network/host object to send and receive traffic for the services defined in the service object. If a change is made to these servers, you need only update the network/host or service object and redeploy, instead of trying to locate and edit each rule in which the servers are used.

 
    [bookmark: pgfId-900661]Objects are defined globally. This means that the definition of an object is the same for every object and policy that references it. However, many object types (for example, interface roles) can be overridden at the device level. Thus, you can create an object that works for most of your devices, yet customize the object to match the configuration of a particular device that has slightly different requirements. For more information, see Understanding Policy Object Overrides for Individual Devices.

 
    [bookmark: pgfId-900663]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-900668]Selecting Objects for Policies

 
     		 [bookmark: pgfId-900673]Policy Object Manager

 
     		 [bookmark: pgfId-900678]Working with Policy Objects—Basic Procedures

 
     		 [bookmark: pgfId-900683]Understanding AAA Server and Server Group Objects

 
     		 [bookmark: pgfId-900688]Creating Access Control List Objects

 
     		 [bookmark: pgfId-900693]Configuring Time Range Objects

 
     		 [bookmark: pgfId-900698]Understanding Interface Role Objects

 
     		 [bookmark: pgfId-900703]Understanding Map Objects

 
     		 [bookmark: pgfId-900708]Understanding Networks/Hosts Objects

 
     		 [bookmark: pgfId-900713]Understanding Pool Objects

 
     		 [bookmark: pgfId-900718]Understanding and Specifying Services and Service and Port List Objects

 
     		 [bookmark: pgfId-900723]How Policy Objects are Provisioned as Object Groups

 
    

 
   
 
    
     [bookmark: pgfId-900747][bookmark: 13794][bookmark: obman_proc_SelectingObjectsforPolicies]Selecting Objects for Policies[bookmark: marker-900733][bookmark: marker-900735][bookmark: marker-900737][bookmark: marker-900739][bookmark: marker-900741][bookmark: marker-900743][bookmark: marker-900745]

 
    [bookmark: pgfId-900749]Modifying Policies using Drag and Drop

 
    [bookmark: pgfId-900751]If you are modifying an existing policy, you can easily update the policy definition by dragging and dropping objects from the Policy Object Manager onto the applicable field in the policy. You can select a range of objects from the Policy Object Manager window by selecting the first object in the range and then, with the Shift key pressed, selecting the last object in the range. You can select multiple objects by clicking those objects while keeping the Ctrl key pressed. You can also select a range of objects and then add additional objects to your selection by using the Ctrl key method. To drag multiple objects, press and hold the Ctrl key while dragging or drag using the right-mouse button.

 
    [bookmark: pgfId-900753]Creating Policies using Object Selector

 
    [bookmark: pgfId-900755]When creating a policy, you often need to select one or more objects to include in the policy definition. For example, firewall policies make use of network/host objects, interface role objects, and service objects.

 
    [bookmark: pgfId-900757]To include objects in policies, you can manually enter the object name or click the Select button to display an object selector dialog box. In certain cases, the object selector is prefiltered to display only the objects that are applicable to the policy that you are configuring. For example, when configuring a policy that requires a subnet, the object selector displays only those network/host objects that represent subnets, not network/host objects that represent single hosts. Object selectors make it easy for you to select which objects to include in a particular policy.

 
    [bookmark: pgfId-900759]Additionally, object selectors enable you to create and edit objects of that type on the fly. This makes it easy to work with objects without leaving the policy you are defining to open the Policy Object Manager. For example, if when creating a dynamic NAT rule you discover that the ACL object you require does not exist, you can click the Create button to open the dialog box for creating an ACL object. When you finish creating the object, you are returned to the object selector with the new object selected and ready for inclusion in the policy. If you need to modify an existing object before using it, select it, click the Edit button and make your modifications, then click OK to save your changes; this returns you to the object selector.

 
    [bookmark: pgfId-900761]When you create an object by opening the object editor from within a selector, the new object must conform to the requirements of the field from which the selector was opened. For example, if you open a selector from a field requiring a host and then decide to create a network/host object for that field, you must define the network/host object as a host.

 
     
      
       
       [bookmark: pgfId-895291]Table 6-1 [bookmark: 13830]Object Selectors 

 
       
      
        
        		
          
          [bookmark: pgfId-895297]Element
         
  
        		
          
          [bookmark: pgfId-895299]Description
         
  
       

 
        
        		[bookmark: pgfId-895305]Type

  
        		[bookmark: pgfId-895307]The type of object to display in the selector, if there is an option. For example:

 
          
          		 [bookmark: pgfId-895309]You can choose between network/host objects and interface roles when configuring sources and destinations in some rule-based policies.

 
          		 [bookmark: pgfId-895311]You can choose between standard and extended ACL objects when configuring some ACLs (for example, when configuring VLAN ACLs on Catalyst 6500/7600 devices).

 
         

 [bookmark: pgfId-895313]Tip In some policies, if you select more than one type of object, they are displayed on different tabs within the field.  
       

 
        
        		[bookmark: pgfId-895319]Available [object type]

  
        		[bookmark: pgfId-895321]Displays all objects that are relevant to the policy or object you are configuring.

 [bookmark: pgfId-895326]When selecting interfaces, be aware that there can be interfaces and interface roles with the same name. They can be distinguished by the icon displayed next to the name. For more information, see Specifying Interfaces During Policy Definition.

 [bookmark: pgfId-895328]Tip You can quickly find an object inside a selector by clicking in the list box and then starting to type the name of the object.  
       

 
        
        		[bookmark: pgfId-895334]Selected [object type]

  
        		[bookmark: pgfId-895336]Displays the objects that you selected to apply to the policy or object that you are editing.

  
       

 
        
        		 
          
          [bookmark: pgfId-895342]Multi-Object Selector Buttons
         
  
       

 
        
        		[bookmark: pgfId-895350]>> button

 [bookmark: pgfId-895352]<< button

  
        		[bookmark: pgfId-895354]Moves the selected objects from one list to the other list in the direction indicated. You can select multiple objects by using Ctrl+click.

 [bookmark: pgfId-895356]You can also move objects between lists by double-clicking them or by selecting them and pressing Enter.

  
       

 
        
        		[bookmark: pgfId-895362]Up/Down arrow buttons

  
        		[bookmark: pgfId-895364]For a limited number of object types, order matters. If the selector includes Move Up and Move Down buttons, arrange the objects in priority order. For example, when defining a method list for AAA, use the arrows to determine the order in which different types of AAA server groups are used.

  
       

 
        
        		 
          
          [bookmark: pgfId-895370]Common Buttons
         
  
       

 
        
        		[bookmark: pgfId-895378]Create button

  
        		[bookmark: pgfId-895380]Click this button to create an object of this type.

 [bookmark: pgfId-895382]Tip In a few cases, such as network/host and service objects, clicking this button opens a list from which you need to select a specific type for the object.  
       

 
        
        		[bookmark: pgfId-895388]Edit button

  
        		[bookmark: pgfId-895390]Click this button to edit the selected user-defined object. If you try to edit a system-defined object, it is opened in read-only mode.

  
       

 
      
     

 
    
 
    [bookmark: pgfId-900768]Related Topics

 
     
     		 [bookmark: pgfId-900773]Allowing a Policy Object to Be Overridden

 
     		 [bookmark: pgfId-900778]Filtering Items in Selectors

 
    

 
   
 
    
     [bookmark: pgfId-900910][bookmark: 13909][bookmark: pobjpage_cncpt_PolicyObjectManagerWindow]Policy Object Manager [bookmark: marker-900908]

 
    [bookmark: pgfId-900912]Use the Policy Object Manager to:

 
     
     		 [bookmark: pgfId-900914]View all available objects grouped by object type.

 
     		 [bookmark: pgfId-900916]Create, copy, edit, and delete policy objects.

 
     		 [bookmark: pgfId-900918]Drag and drop objects onto existing policies to update the policy definition.

 
     		 [bookmark: pgfId-900920]Generate usage reports, which describe how selected objects are being used by other Security Manager objects and policies.

 
    

 
    [bookmark: pgfId-900922]Navigation Path

 
    [bookmark: pgfId-900924]In Device view or Policy view, click the Policy Object Manager button on the toolbar, or choose Policy Objects from the Manage menu. (The Policy Object Manager cannot be opened from Map view.)

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-900929]Note When you open the Policy Object Manager, it is initially displayed as a pane in the lower half of the current view to make dragging and dropping objects easier. You can “undock” this pane, making the Policy Object Manager a separate window; you also can “re-dock” the window. See Policy Object Manager: Undocking and Docking for more information.


    
     

    

    

 
    [bookmark: pgfId-900931]Related Topics

 
     
     		 [bookmark: pgfId-900936]Creating Policy Objects

 
     		 [bookmark: pgfId-900941]Selecting Objects for Policies

 
     		 [bookmark: pgfId-900946]Generating Object Usage Reports

 
     		 [bookmark: pgfId-900951]Managing Object Overrides

 
     		 [bookmark: pgfId-900956]Filtering Tables

 
    

 
    [bookmark: pgfId-900958]Field Reference

 
    [bookmark: pgfId-900961] 

 
     
     


     


     


      
       
       [bookmark: pgfId-895403]Table 6-2 [bookmark: 14017]Policy Object Manager Window 

 
       
      
        
        		
          
          [bookmark: pgfId-895409]Element
         
  
        		
          
          [bookmark: pgfId-895411]Description
         
  
       

 
        
        		[bookmark: pgfId-895417]Object Type selector, or table of contents

 [bookmark: pgfId-895419](Left pane)

  
        		[bookmark: pgfId-895421]Lists the object types available in Security Manager. When you select an object type, all existing objects of that type are listed in the table in the right pane.

 [bookmark: pgfId-895423]The objects are organized into three folders: Favorites, Recent Objects, and All Object Types. Click the arrow to left of a folder name to expand that folder.

 [bookmark: pgfId-895425]You can also specify your favorite object types and they will be presented in a separate list so that they can be more easily accessed. To add an object type to your favorites list, right-click the object and then select Add to Favorites. To remove an object type from your Favorites list, right-click the object and choose Remove from Favorites.

 [bookmark: pgfId-895427]Recent Objects is a list of the ten most recently modified objects. Click a recent object to see a summary of the object that includes the name, type, description, and last modified date. You can also access the View Object, Edit Object, and Find Usage buttons for the object.

 [bookmark: pgfId-895429]Expand the All Object Types folder to view all types of object available.

  
       

 
        
        		 [bookmark: pgfId-895435]Policy Object Table (Right Pane)

 [bookmark: pgfId-895440]The policy object table in the right pane lists existing objects of the type selected in the table of contents. Using this table, you create new objects and work with existing ones. You can use the buttons below the table, or right-click within the table to see additional commands (see Policy Object Manager Shortcut Menu).

 [bookmark: pgfId-895442]Except for the Access Control Lists (ACL) object, there is one table per object type. For ACLs, there are tabs to separate Extended, Standard, Web, and Unified ACL objects. Select the appropriate tab to work with the desired object type.

 [bookmark: pgfId-895444]The columns in the table vary based on the type of object you select. You can alter the columns displayed in the table by right-clicking the table heading and selecting or deselecting columns in the Show Columns command. You can also sort the information by the contents in a column by clicking the column heading; click the heading to toggle between alphabetical and reverse alphabetical sorting.

 [bookmark: pgfId-895446]For detailed information on the settings that are displayed in the table, click the Create or Edit buttons below the table and click Help in the dialog box that is opened. The following section, “Table Columns,” is a description of the columns that you typically see.

  
       

 
        
        		 
          
          [bookmark: pgfId-895454]Buttons Above Table
         
  
       

 
        
        		[bookmark: pgfId-895462]Referenced

  
        		[bookmark: pgfId-895464]Select this option to view reference information for objects. When selected, a "Referenced" column is added to the table to display information on whether an object is being used by any policies or policy objects.

  
       

 
        
        		[bookmark: pgfId-895470]Find Usage

  
        		[bookmark: pgfId-895475]Use the Find Usage feature to view a report on the policies or policy objects that are using the selected object and any device overrides for the object. For more information, see Generating Object Usage Reports.

  
       

 
        
        		[bookmark: pgfId-895481]View Object

  
        		[bookmark: pgfId-895483]When a single object is selected in the table, you can click this button to open the Edit dialog box for that type of object in read-only mode to view the settings for that particular object.

  
       

 
        
        		[bookmark: pgfId-895489]Export

  
        		[bookmark: pgfId-895491]Use the Export feature to download a CSV file of the object data for the selected object type.

  
       

 
        
        		[bookmark: pgfId-895497]Print

  
        		[bookmark: pgfId-895499]Use the Print feature to print the object data for the selected object type.

  
       

 
        
        		[bookmark: pgfId-895505]Filter

  
        		[bookmark: pgfId-895510]Allows you to filter the rows displayed to help you find items in a large table. For more information, see Filtering Tables.

  
       

 
        
        		 
          
          [bookmark: pgfId-895516]Table Columns
         
  
       

 
        
        		[bookmark: pgfId-895524]*

  
        		[bookmark: pgfId-895526]Indicates the policy object status:

 
          
          		 [bookmark: pgfId-895529]

 
          [image: ] - Policy object has been locked for editing. Hover over the lock icon to see the user and ticket/activity that has the object locked.
         

 
          
          		 [bookmark: pgfId-895532]

 
          [image: ] - Policy object has been modified in the current ticket/activity but the changes have not been submitted.
         

 [bookmark: pgfId-895534]Note You can hover over the status icons to see details about the ticket/activity in which the policy object has been modified/locked and to navigate to that ticket/activity.

  
       

 
        
        		[bookmark: pgfId-895540]Icon (unlabeled field)

  
        		[bookmark: pgfId-895542]The icon displayed for a policy object type identifies objects of that type wherever they appear, such as in rules tables. If the icon includes the image of a pencil, you can edit it.

  
       

 
        
        		[bookmark: pgfId-895548]Name

  
        		[bookmark: pgfId-895550]The name of the policy object.

  
       

 
        
        		[bookmark: pgfId-895556]Content

  
        		[bookmark: pgfId-895558]A summary of the object definition that might not include all defined settings.

  
       

 
        
        		[bookmark: pgfId-895564]Permit

  
        		[bookmark: pgfId-895566]For ACL objects, if the Access Control Entry (ACE) allows traffic, a check mark appears in the Permit column. If the action is deny, a red circle with a slash appears.

  
       

 
        
        		[bookmark: pgfId-895572]Category

  
        		[bookmark: pgfId-895577]The category object that is assigned to the object, if any. Categories help you organize and identify rules and objects. For more information, see Using Category Objects.

  
       

 
        
        		[bookmark: pgfId-895583]Overrides

  
        		[bookmark: pgfId-895585]Whether a user can override the object properties at the device level. A check mark indicates that the object can be overridden. Not all object types are overridable.

 [bookmark: pgfId-895587]If an object has been overridden, the Overrides column displays the number of overrides for that object. You can click on the number to see the list of overrides.

 [bookmark: pgfId-895592]For more information about device overrides, see Managing Object Overrides.

  
       

 
        
        		[bookmark: pgfId-895598]Referenced

  
        		[bookmark: pgfId-895603]Whether the object is being used in any policy definitions. You can find out which policies or policy objects are using the selected object and any device overrides for the object using the Find Usage feature (see Generating Object Usage Reports).

 [bookmark: pgfId-895605]Note To view reference information, make sure the Referenced option is selected on the toolbar above the Policy Object Table.

 [bookmark: pgfId-895607]Note The Referenced column reports usage based on both committed data and uncommitted data across all activities/tickets, whereas as the Find Usage feature only reports usage based on committed data and data from the current activity/ticket.

  
       

 
        
        		[bookmark: pgfId-895613]Description

  
        		[bookmark: pgfId-895615]The description for the object. If the column is too narrow to display the description, you can double-click the icon to view the description or mouse-over the icon.

  
       

 
        
        		[bookmark: pgfId-895621]Last Ticket(s)

  
        		[bookmark: pgfId-895623]If ticketing is enabled, shows the Ticket ID of the ticket last used to modify the object. You can click on the

 [bookmark: pgfId-895628]If ticketing is enabled, shows the ticket(s) associated with last modification to the object. You can click the ticket ID in the Last Ticket(s) column to view details of the ticket and to navigate to the ticket. If linkage to an external ticket management system has been configured, you can also navigate to that system from the ticket details (see Ticket Management Page).

  
       

 
        
        		[bookmark: pgfId-895634]Last Modified Date

  
        		[bookmark: pgfId-895636]Shows the date and time the object was last modified.

  
       

 
        
        		 
          
          [bookmark: pgfId-895642]Buttons Below Table
         
  
       

 
       
            
        		[bookmark: pgfId-895653]Click the New Object button to create a new object. The same icon is used for any button that adds an item to a table.

 [bookmark: pgfId-895655]Tip In a few cases such as Networks/Hosts and Services objects, clicking this button opens a list from which you need to select a specific type for the object. [bookmark: pgfId-895660]Clicking this button opens a dialog box to create the object. Click the Help button in the dialog box for information on the selected object type. Also, see Creating Policy Objects.

  
       

 
       
            
        		[bookmark: pgfId-895669]Click the Edit Object button to edit the selected object. The same icon is used for editing any object in a table.

 [bookmark: pgfId-895674]The dialog box used for editing the object is the same as the one used for creating the object. If you try to edit a system-defined default object, you are allowed only to view the object contents. Click the Help button in the dialog box for information on the settings. For more information, see Editing Objects.

  
       

 
       
            
        		[bookmark: pgfId-895686]Click the Delete Object button to delete the selected object. You can delete only user-defined objects that are not currently being used in a policy or another policy object. For more information, see Deleting Objects.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-900969][bookmark: 14193][bookmark: pobjpage_cncpt_POMWindowDockUndock]Policy Object Manager: Undocking and Docking [bookmark: marker-900967]

 
     [bookmark: pgfId-900971]Whenever you open the Policy Object Manager, it is initially displayed as a pane in the lower half of the current view to make dragging and dropping objects easier. You can “undock” this pane, making the Policy Object Manager a separate window, you can “re-dock” the window, and you can close the pane or window:

 
      
      		 [bookmark: pgfId-900973]To undock the Policy Object Manager from the current view in the Configuration Manager window, click the Undock Window button in the upper right corner of the pane’s title bar.

 
      		 [bookmark: pgfId-900975]To put the floating window back as a pane in the Configuration Manager window, click the Dock Frame button in the upper right corner of the Policy Object Manager window.

 
      		 [bookmark: pgfId-900977]To close either the pane or the floating window, click the Close button in its upper right corner.

 
     

 
     [bookmark: pgfId-900979]Navigation Path

 
     [bookmark: pgfId-900981]In Device view or Policy view, click the Policy Object Manager button on the toolbar, or choose Policy Objects from the Manage menu. (The Policy Object Manager cannot be opened from Map view.)

 
    
 
     
      [bookmark: pgfId-900989][bookmark: 14213][bookmark: pobjpage_cncpt_PolicyObjectManagerWindowShortcutMenu]Policy Object Manager Shortcut Menu[bookmark: marker-900987]

 
     [bookmark: pgfId-900994]Right-clicking inside the policy object table in the Policy Object Manager displays a shortcut menu for performing various functions on the selected object type.

 
     [bookmark: pgfId-900996]Field Reference

 
     [bookmark: pgfId-900999] 

 
      
       
        
        [bookmark: pgfId-895699]Table 6-3 [bookmark: 14223]Policy Object Manager Shortcut Menu 

 
        
       
         
         		
           
           [bookmark: pgfId-895705]Menu Command
          
  
         		
           
           [bookmark: pgfId-895707]Description
          
  
        

 
         
         		[bookmark: pgfId-895713]New Object

  
         		[bookmark: pgfId-895718]Choose this command to create a new policy object. Click Help in the dialog box that is opened for information specific to the object type. Also, see Creating Policy Objects.

 [bookmark: pgfId-895720]Tip For network/host and service objects, you need to also select an object type from the submenu.  
        

 
         
         		[bookmark: pgfId-895726]Edit Object

  
         		[bookmark: pgfId-895731]Choose this command to edit the policy object selected in the table. If you select a system-defined default object, you are presented with a view-only look at the object definition. For more information, see Editing Objects.

  
        

 
         
         		[bookmark: pgfId-895737]Delete Object

  
         		[bookmark: pgfId-895742]Choose this command to delete the policy object selected in the table. You can delete only user-defined objects that are not being used in a policy or in another policy object. For more information, see Deleting Objects.

  
        

 
         
         		[bookmark: pgfId-895748]Enable/Disable Device Overrides

  
         		[bookmark: pgfId-895750]Choose the Enable Device Overrides command to enable device overrides on one or more devices on which overrides are disabled. Choose the Disable Device Overrides command to disable device overrides on one or more devices on which overrides are enabled.

  
        

 
         
         		[bookmark: pgfId-895756]Edit Device Overrides

  
         		[bookmark: pgfId-895764]Select this command to change the device-level overrides for this object using the Policy Object Overrides Window. You can create, edit, and delete overrides. For more information, see Managing Object Overrides.

  
        

 
         
         		[bookmark: pgfId-895770]Clone Object

  
         		[bookmark: pgfId-895775]Select this command to create a copy of the policy object. For more information, see Cloning (Duplicating) Objects.

  
        

 
         
         		[bookmark: pgfId-895781]Copy Object

  
         		[bookmark: pgfId-895783]Choose this command to copy one or more selected objects to the system Clipboard.

 to copy objects.  
        

 
         
         		[bookmark: pgfId-895791]Paste Object

  
         		[bookmark: pgfId-895793]Choose this command to paste the object(s) on the system Clipboard into another object. For example, you might add a host-type Networks/Hosts object to an existing group-type Networks/Hosts object. The two object types must be compatible.

 to paste objects.  
        

 
         
         		[bookmark: pgfId-895801]Find Usage

  
         		[bookmark: pgfId-895806]Choose this command to generate a usage report for the selected object using the Object Usage dialog box. The usage report tells you where the object is currently being used. for more information, see Generating Object Usage Reports.

  
        

 
         
         		[bookmark: pgfId-895812]View Object

  
         		[bookmark: pgfId-895817]Choose this command to view the definition of the object using a read-only version of the edit dialog box for the object. For more information, see Viewing Object Details.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-901009][bookmark: 14298][bookmark: obman_cncpt_ManagingExistingObjects]Working with Policy Objects—Basic Procedures[bookmark: marker-901005][bookmark: marker-901007]

 
    [bookmark: pgfId-901011]The following topics describe the actions that you can perform on policy objects. Some tasks are limited to certain types of objects. For example, not all types of object can be overridden, you cannot edit predefined objects, and you cannot import or export all objects.

 
    [bookmark: pgfId-901013]This section contains the following topics:

 
     
     		 [bookmark: pgfId-901018]Creating Policy Objects

 
     		 [bookmark: pgfId-901023]Editing Objects

 
     		 [bookmark: pgfId-901028]Using Category Objects

 
     		 [bookmark: pgfId-901033]Cloning (Duplicating) Objects

 
     		 [bookmark: pgfId-901038]Viewing Object Details

 
     		 [bookmark: pgfId-901043]Generating Object Usage Reports

 
     		 [bookmark: pgfId-901048]Deleting Objects

 
     		 [bookmark: pgfId-901053]Managing Object Overrides

 
     		 [bookmark: pgfId-901058]Importing and Exporting Policy Objects

 
    

 
     
      [bookmark: pgfId-901070][bookmark: 14307][bookmark: obman_cncpt_CreatingObjects]Creating Policy Objects [bookmark: marker-901066][bookmark: marker-901068]

 
     [bookmark: pgfId-901072]Security Manager provides predefined policy objects of various types that you can use to define policies. Additionally, you can create your own objects, as required.

 
     [bookmark: pgfId-901074]You can create objects in one of two ways:

 
      
      		 [bookmark: pgfId-901079]Using the Policy Object Manager window. This option is best suited for situations where you are defining one or more objects outside of the context of defining a particular policy. See Policy Object Manager.

 
      		 [bookmark: pgfId-901084]Using object selectors. When you define a policy that uses objects, object selectors include buttons for creating and editing objects so you don’t have to leave the policy you are defining. This is frequently the best method to use, because during policy creation you are prompted for the specific type of object that applies to the situation, and you are more aware of the settings you need for the policy. See Selecting Objects for Policies.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-901089]Tip Your ability to create multiple objects with the same definition depends on a setting on the Policy Objects page in the Security Manager Administration window (select Tools > Security Manager Administration). By default, Security Manager warns you when you create an object whose definition is identical to that of an existing object, but it does not prevent you from proceeding. For more information, see Policy Objects Page.


     
      

     

     

 
     [bookmark: pgfId-901091]Related Topics

 
      
      		 [bookmark: pgfId-901096]Chapter 6, “Managing Policy Objects”

 
      		 [bookmark: pgfId-901101]Working with Policy Objects—Basic Procedures

 
     

 
     
 
     [bookmark: pgfId-901103]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-901108]Select  Manage > Policy Objects to open the Policy Object Manager. Select the type of object you want to create from the table of contents, right-click in the table and select  New Object .

 
      		 [bookmark: pgfId-901110]While configuring a rule, click  Select next to a field that allows or requires a policy object. In the object selector, click the  Create button below the available objects list.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-901112]Tip In a few cases, such as network/host and service objects, clicking these buttons opens a list from which you need to select a specific type for the object.


     
      

     

     

 
     [bookmark: pgfId-901114]The dialog box for adding the selected type of object opens. For more information about the individual types of objects, see the following topics:

 
      
      		 [bookmark: pgfId-901119]Understanding AAA Server and Server Group Objects

 
      		 [bookmark: pgfId-901124]Creating Access Control List Objects

 
      		 [bookmark: pgfId-901129]Add or Edit As Path Object Dialog Boxes

 
      		 [bookmark: pgfId-901134]ASA Group Policies Dialog Box

 
      		 [bookmark: pgfId-901139]Using Category Objects

 
      		 [bookmark: pgfId-901144]Add or Edit Community List Object Dialog Box

 
      		 [bookmark: pgfId-901149]Configuring Credentials Policy Objects

 
      		 [bookmark: pgfId-901154]Add and Edit File Object Dialog Boxes

 
      		 [bookmark: pgfId-901165]Understanding FlexConfig Policies and Policy Objects and Creating FlexConfig Policy Objects (in Chapter 7, “Managing FlexConfigs”)

 
      		 [bookmark: pgfId-901170]Creating Identity User Group Objects

 
      		 [bookmark: pgfId-901175]Configuring IKEv1 Proposal Policy Objects

 
      		 [bookmark: pgfId-901180]Configuring IKEv2 Proposal Policy Objects

 
      		 [bookmark: pgfId-901185]Understanding Interface Role Objects

 
      		 [bookmark: pgfId-901190]Configuring IPSec IKEv1 or IKEv2 Transform Set Policy Objects

 
      		 [bookmark: pgfId-901195]Add and Edit LDAP Attribute Map Dialog Boxes

 
      		 [bookmark: pgfId-901200]Understanding Map Objects

 
      		 [bookmark: pgfId-901205]Understanding Networks/Hosts Objects

 
      		 [bookmark: pgfId-901210]PKI Enrollment Dialog Box

 
      		 [bookmark: pgfId-901215]Add or Edit Policy List Object Dialog Box

 
      		 [bookmark: pgfId-901220]Understanding Pool Objects

 
      		 [bookmark: pgfId-901225]Add or Edit Port Forwarding List Dialog Boxes

 
      		 [bookmark: pgfId-901230]Configuring Port List Objects

 
      		 [bookmark: pgfId-901235]Add or Edit Prefix List Object Dialog Box

 
      		 [bookmark: pgfId-901240]Configuring Risk Rating Policy Objects

 
      		 [bookmark: pgfId-901245]Add or Edit Route Map Object Dialog Boxes

 
      		 [bookmark: pgfId-901250]Creating Security Group Objects

 
      		 [bookmark: pgfId-901255]Creating Cisco Secure Desktop Configuration Objects

 
      		 [bookmark: pgfId-901260]Understanding and Specifying Services and Service and Port List Objects

 
      		 [bookmark: pgfId-901265]Add or Edit Single Sign On Server Dialog Boxes

 
      		 [bookmark: pgfId-901270]Monitoring Service Level Agreements (SLAs) To Maintain Connectivity

 
      		 [bookmark: pgfId-901275]Configuring SSL VPN Bookmark Lists for ASA and IOS Devices

 
      		 [bookmark: pgfId-901280]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
      		 [bookmark: pgfId-901285]Add or Edit SSL VPN Gateway Dialog Box

 
      		 [bookmark: pgfId-901290]Add and Edit Smart Tunnel Auto Signon List Dialog Boxes

 
      		 [bookmark: pgfId-901295]Configuring SSL VPN Smart Tunnels for ASA Devices

 
      		 [bookmark: pgfId-901300]Add or Edit Text Object Dialog Box

 
      		 [bookmark: pgfId-901305]Configuring Time Range Objects

 
      		 [bookmark: pgfId-901310]Configuring Traffic Flow Objects

 
      		 [bookmark: pgfId-901315]Add or Edit User Group Dialog Box

 
      		 [bookmark: pgfId-901320]Configuring WINS/NetBIOS Name Service (NBNS) Servers To Enable File System Access in SSL VPNs

 
     

 
     [bookmark: pgfId-901322]Step 2 Enter a name for the object and optionally a description of the object.

 
     [bookmark: pgfId-901324]Object names are not case-sensitive and are limited to 128 characters. You can begin object names with a letter, a number, or an underscore. You can use a mix of letters, numbers, special characters, and spaces for the remainder of the object name. Supported special characters include hyphens (-), underscores (_), periods (.), and plus signs (+). Some objects also support the use of colons (:) in the object name; however, objects with a colon in the name are not supported on IPS devices. If you share objects between different device types that include IPS devices, you should avoid using a colon (:) in the object name.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-901326]Note Certain object types, such as AAA server groups, ASA user groups, maps, network/host objects, service objects, and traffic flows, have different naming guidelines. For more details, refer to the online help when you are creating each object type.


     
      

     

     

 
     [bookmark: pgfId-901328]Step 3 Configure the settings specific to the type of object. Refer to the online help page for the dialog box.

 
     [bookmark: pgfId-901333]Step 4 (Optional) Under Category, select a category to help you identify this object in the Objects table. See Using Category Objects.

 
     [bookmark: pgfId-901338]Step 5 (Optional) If the object type provides the option, select Allow Value Override per Device to allow the properties of this object to be redefined on individual devices. See Allowing a Policy Object to Be Overridden.

 
     [bookmark: pgfId-901340]Step 6 Click OK to save the object.

 
     [bookmark: pgfId-901342]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-901352][bookmark: 14495][bookmark: obman_proc_EditingObjects]Editing Objects[bookmark: marker-901348][bookmark: marker-901350]

 
     [bookmark: pgfId-901354]You can edit any user-defined object as required. Changes that you make to the object are reflected in all policies (and other objects) that use the object. However, if an override for the object is already defined for a device, your edits are not reflected in the object used on those devices.

 
     [bookmark: pgfId-901356]Tips

 
      
      		 [bookmark: pgfId-901361]You cannot edit predefined objects, but you can copy them to create new objects. See Cloning (Duplicating) Objects.

 
      		 [bookmark: pgfId-901363]Messages appear at the top of the Edit dialog box to indicate the following situations:

 
     

 
     [bookmark: pgfId-901365] – That you have read-only access to the object. You cannot save changes to these objects.

 
     [bookmark: pgfId-901373] – That the policy object was imported using the procedure described in Importing Policies or Devices. Imported objects might be re-imported at some point if the shared policy that uses the object is managed on a different server. Any changes that you make are eliminated if the policy object is imported again. Before editing the object, ensure that you understand the protocols used in your organization for policy management and importation. You can control whether this message appears using an option on the Tools > Security Manager Administration > Policy Management page (see Policy Management Page).

 
      
      		 [bookmark: pgfId-901378]You can also edit objects when you define policies or objects that use this object type. For more information, see Selecting Objects for Policies.

 
     

 
     [bookmark: pgfId-901380]Before You Begin

 
     [bookmark: pgfId-901385]Determine if the object is being used, and which policies, objects, and devices would be affected by the changes. You can generate a usage report for this purpose. See Generating Object Usage Reports.

 
     [bookmark: pgfId-901387]Related Topics

 
      
      		 [bookmark: pgfId-901392]Creating Policy Objects

 
     

 
     
 
     [bookmark: pgfId-901397]Step 1 Select Manage > Policy Objects to open the Policy Object Manager.

 
     [bookmark: pgfId-901399]Step 2 Select the object type from the table of contents.

 
     [bookmark: pgfId-901401]Step 3 Right-click the object you want to edit and select Edit Object.

 
     [bookmark: pgfId-901403]Step 4 Modify the fields in the Edit dialog box for that object type as required, then click OK to save your changes. Click the Help button for information specific to the type of object.

 
     [bookmark: pgfId-901405]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-901421][bookmark: 14548][bookmark: obman_proc_EditingCategoryObjects]Using Category Objects[bookmark: marker-901415][bookmark: marker-901417][bookmark: marker-901419]

 
     [bookmark: pgfId-901423]Categories provide an intermediate level of detail to objects. By assigning a category to an object, you can look for the name and color of a category to more easily identify rules and objects in rules tables. You can assign a category to a rule or object when you create the rule, or you can edit the rule or object to include category information later. No device configuration commands are generated for category assignments.

 
     [bookmark: pgfId-901425]The benefits of assigning categories to policy objects are:

 
      
      		 [bookmark: pgfId-901427]Visibility is improved when you view rules tables using objects that are categorized.

 
      		 [bookmark: pgfId-901429]Objects can be filtered in the rules tables based on category, facilitating rule maintenance.

 
     

 
     [bookmark: pgfId-901431]For example, you might want to create a network/host object and keep track of its use for administrative purposes. When you define this network/host object, you associate it with a category. When you view the access rules table, you can easily identify those rules that use your network/host object. You can also filter the table to display only those items associated with the category.

 
     [bookmark: pgfId-901433]Security Manager includes a set of predefined categories. Although you cannot change the colors, you can change their names and descriptions. The following procedure explains how to change the name and description.

 
     
 
     [bookmark: pgfId-901438]Step 1 Select Manage > Policy Objects to open the Policy Object Manager (see Policy Object Manager).

 
     [bookmark: pgfId-901440]Step 2 Select Categories from the Object Type selector.

 
     [bookmark: pgfId-901442]Step 3 Click Edit Object to open the Category Editor dialog box.

 
     [bookmark: pgfId-901444]Step 4 Modify the names and descriptions of the predefined category objects as required:

 
      
      		 [bookmark: pgfId-901446]Label—The color associated with the category.

 
      		 [bookmark: pgfId-901448]Name—The category name. Names can have a maximum of 128 characters, including special characters and spaces.

 
      		 [bookmark: pgfId-901450]Description—Additional information about the object (up to 1024 characters).

 
     

 
     [bookmark: pgfId-901452]Step 5 Click OK to save your changes.

 
     [bookmark: pgfId-901454]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-901464][bookmark: 14597][bookmark: obman_proc_DuplicatingObjects]Cloning (Duplicating) Objects[bookmark: marker-901460][bookmark: marker-901462]

 
     [bookmark: pgfId-901466]An alternative to creating a policy object from scratch is to clone, or duplicate, an existing object. The new object contains all the attributes of the copied object. You can then modify the name and all attributes as required.

 
     [bookmark: pgfId-901468]Cloning is useful for creating objects that are based on predefined objects that cannot be edited.

 
     [bookmark: pgfId-901470]Related Topics

 
      
      		 [bookmark: pgfId-901475]Working with Policy Objects—Basic Procedures

 
     

 
     
 
     [bookmark: pgfId-901480]Step 1 Select Manage > Policy Objects to open the Policy Object Manager.

 
     [bookmark: pgfId-901482]Step 2 Select the object type from the table of contents.

 
     [bookmark: pgfId-901484]Step 3 Right-click the object you want to duplicate and select Clone Object.

 
     [bookmark: pgfId-901486]The dialog box for that object type appears. The Name field contains the following default name for the new object: Copy of name of copied object. The remaining fields contain the same values as the copied object.

 
     [bookmark: pgfId-901488]Step 4 Modify the name of the new object and its configuration, as required. Click the Help button for information specific to that type of object.

 
     [bookmark: pgfId-901490]Step 5 Click OK to save your changes.

 
     [bookmark: pgfId-901492]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-901502][bookmark: 14633][bookmark: obman_proc_ViewingObjectDetails]Viewing Object Details[bookmark: marker-901498][bookmark: marker-901500]

 
     [bookmark: pgfId-901504]You can view contents of an object in read-only mode, even when the object is locked by another activity. This is useful when you need to view complete configuration details for complex objects whose definitions cannot be fully displayed in the Policy Object Manager window or when your user privileges allow you only to view object information.

 
     [bookmark: pgfId-901506]Related Topics

 
      
      		 [bookmark: pgfId-901511]Working with Policy Objects—Basic Procedures

 
     

 
     
 
     [bookmark: pgfId-901516]Step 1 Select Manage > Policy Objects to open the Policy Object Manager.

 
     [bookmark: pgfId-901518]Step 2 Select the object type from the table of contents.

 
     [bookmark: pgfId-901520]Step 3 Right-click the object and select View Object.

 
     [bookmark: pgfId-901522]The dialog box for that object appears in read-only mode.

 
     [bookmark: pgfId-901524]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-901540][bookmark: 14662][bookmark: obman_proc_GeneratingObjectUsageReports]Generating Object Usage Reports[bookmark: marker-901532][bookmark: marker-901534][bookmark: marker-901536][bookmark: marker-901538]

 
     [bookmark: pgfId-901542]Before you make any changes to a policy object, you should determine if the object is being used. You can do this by viewing the Referenced column in the Policy Object Manager window. Select the Referenced button above the Policy Object Table to enable the Referenced column.

 
     [bookmark: pgfId-901544]For objects that are referenced, you can generate usage reports that show which policies, objects, VPNs, and devices are using the selected object and would therefore be affected by changes to that object. Usage reports contain any references to the selected object in your current activity as well as references found in the data committed to the database.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-901546]Note The Referenced column reports usage based on both committed data and uncommitted data across all activities/tickets, whereas as the Find Usage feature only reports usage based on committed data and data from the current activity/ticket.


     
      

     

     

 
     [bookmark: pgfId-901548]You can use either of these methods to generate usage reports:

 
      
      		 [bookmark: pgfId-901553]Policy Object Manager—Select  Manage > Policy Objects to open the Policy Object Manager. Select the type of object from the table of contents, right-click the object and select  Find Usage .

 
      		 [bookmark: pgfId-901555]Firewall rules policies—Left-click an object in a firewall rules table, then right-click and select  Find Usage .

 
     

 
     [bookmark: pgfId-901557]The usage information is displayed in the Object Usage dialog box. Select the appropriate usage type above the table to view devices, policies, VPNs, or other objects that use the selected object.

 
     [bookmark: pgfId-901559]For certain policies,

 
     [bookmark: pgfId-901561]The following table describes the fields in the dialog box.

 
     [bookmark: pgfId-901564] 

 
      
       
        
        [bookmark: pgfId-895830]Table 6-4 [bookmark: 14694]Object Usage Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-895836]Element
          
  
         		
           
           [bookmark: pgfId-895838]Description
          
  
        

 
         
         		[bookmark: pgfId-895844]Name

 [bookmark: pgfId-895846]Type

 [bookmark: pgfId-895848]Description

  
         		[bookmark: pgfId-895850]General information about the object for which you are finding usage is displayed at the top of the Object Usage dialog box.

  
        

 
         
         		[bookmark: pgfId-895856]Devices

 [bookmark: pgfId-895858]Policies

 [bookmark: pgfId-895860]Objects

 [bookmark: pgfId-895862]VPN

  
         		[bookmark: pgfId-895864]The type of references you want to view. For example, you can select Objects to view only references to the object from other objects.

  
        

 
         
         		[bookmark: pgfId-895870]Used By

  
         		[bookmark: pgfId-895872]The name of the device, policy, VPN, or object that is referencing the selected object.

  
        

 
         
         		[bookmark: pgfId-895878]Type

  
         		[bookmark: pgfId-895880]The type of item that is referencing the selected object. This can be a device, policy, VPN, or another object.

  
        

 
         
         		[bookmark: pgfId-895886]Usage

  
         		[bookmark: pgfId-895888]Indicates how the object is being referenced. For example, if a device is referencing the selected object, this column will indicate that it is a policy assigned to the device that is referencing the object.

  
        

 
         
         		[bookmark: pgfId-895894]Proximity

  
         		[bookmark: pgfId-895896]Indicates the relationship between the selected object and the item that it using it. For example:

 
           
           		 [bookmark: pgfId-895898]A policy that includes a network/host object in its definition has a  direct relationship with the object and an  indirect relationship with any other network/host objects contained within the object.

 
           		 [bookmark: pgfId-895900]A device on which this policy is assigned references the network/host object  directly and any other network/host objects contained within the object  indirectly .

 
          

  
        

 
         
         		[bookmark: pgfId-895906]Details Panel

  
         		[bookmark: pgfId-895908]Shows additional details for certain types of references:

 
           
           		 [bookmark: pgfId-895910] Devices - For supported policy types, device information is displayed in the Details panel.

 
           		 [bookmark: pgfId-895912] Policies - For the following supported policy types, the actual rules referencing the object are presented in the Details panel:

 
          

 [bookmark: pgfId-895914] – AAA Rules

 [bookmark: pgfId-895916] – Access Rules

 [bookmark: pgfId-895918] – IPv6 Access Rules

 [bookmark: pgfId-895920] – Inspection Rules

 [bookmark: pgfId-895922] – Translation Rules

 [bookmark: pgfId-895924] – Web Filter Rules (PIX/FWSM/ASA)

 [bookmark: pgfId-895926] – Zone Based Firewall Rules

 [bookmark: pgfId-895928]You can navigate to the rule, export the rule data, or print the rule data from the Details panel.

 
           
           		 [bookmark: pgfId-895930] Objects - Details for other objects that are referencing the specified object are presented in the Details panel. You can export the detailed information, print the information, view the object in read-only mode, edit the object, or even find usage for the object from the Details panel in the Object Usage dialog box.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-901574][bookmark: 14780][bookmark: obman_proc_DeletingObjects]Deleting Objects [bookmark: marker-901570][bookmark: marker-901572]

 
     [bookmark: pgfId-901576]You can delete user-defined objects only when they are not being used by policies or other objects. You cannot delete predefined objects. If you delete an object for which device-level overrides are defined, all overrides are also deleted.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-901578]Tip You might be prevented from deleting an unused object from the database, if, for example, you replace a local policy that used the object with a shared policy that does not. If object deletion fails, submit or discard all pending changes (in Workflow mode, submit or discard all pending activities), then try again to delete the object. Alternatively, you can leave unused objects in the database, because they will not affect your policies.


     
      

     

     

 
     [bookmark: pgfId-901580]Before You Begin

 
     [bookmark: pgfId-901585]Determine if the object is currently being used and which policies, objects, and devices would be affected by the deletion. You need to remove all references to the object before you can delete it. You can generate a usage report for this purpose. See Generating Object Usage Reports.

 
     
 
     [bookmark: pgfId-901590]Step 1 Select Manage > Policy Objects to open the Policy Object Manager.

 
     [bookmark: pgfId-901592]Step 2 Select the object type from the table of contents.

 
     [bookmark: pgfId-901594]Step 3 Right-click the object you want to delete and select Delete Object, or select the object and click the Delete Object button. You are asked to confirm the deletion.

 
     [bookmark: pgfId-901596]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-901608][bookmark: 14808][bookmark: obman_proc_ManagingObjectOverrides]Managing Object Overrides [bookmark: marker-901602][bookmark: marker-901604][bookmark: marker-901606]

 
     [bookmark: pgfId-901610]When you create a policy object, you can elect to allow the object to be overridden. This makes it possible to create a generic object to enable you to create general policies. For individual devices, you override the policy object definition to make the policy apply correctly to the device.

 
     [bookmark: pgfId-901618]From the Policy Object Manager, you can select a policy object that can be overridden and generate a table of device-level overrides that are defined for that global object. Right-click the object and select Edit Device Overrides to generate the table (see Policy Object Overrides Window).

 
     [bookmark: pgfId-901620]You can create device-level overrides in two places:

 
      
      		 [bookmark: pgfId-901625]In the Device Properties window of a selected device, which allows you to create and manage overrides for the selected device only. For more information, see Creating or Editing Object Overrides for a Single Device.

 
      		 [bookmark: pgfId-901630]In the Policy Object Manager window, which allows you to create and manage overrides for more than one device at a time. For more information, see Creating or Editing Object Overrides for Multiple Devices At A Time.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-901632]Tip If you override any part of the object definition at the device level, any subsequent changes made to the policy definition at the global level do not affect the device on which the object was overridden.


     
      

     

     

 
     [bookmark: pgfId-901634]The following topics explain policy object overrides in more detail:

 
      
      		 [bookmark: pgfId-901639]Understanding Policy Object Overrides for Individual Devices

 
      		 [bookmark: pgfId-901644]Allowing a Policy Object to Be Overridden

 
      		 [bookmark: pgfId-901649]Creating or Editing Object Overrides for a Single Device

 
      		 [bookmark: pgfId-901654]Creating or Editing Object Overrides for Multiple Devices At A Time

 
      		 [bookmark: pgfId-901659]Deleting Device-Level Object Overrides

 
     

 
    
 
     
      [bookmark: pgfId-901671][bookmark: 14852][bookmark: obman_cncpt_OverridingGlobalObjectsforIndividualDevices]Understanding Policy Object Overrides for Individual Devices[bookmark: marker-901665][bookmark: marker-901667][bookmark: marker-901669]

 
     [bookmark: pgfId-901673]For many types of policy objects, you can elect to allow an object to be overridden for a particular device. Thus, you can create an object whose definition works for most devices, and then create modifications to the object for the few devices that need slightly different definitions. Or, you can create an object that needs to be overridden for all devices, but which allows you to create a single policy for all devices. Object overrides make it possible for you to create a smaller set of shared policies for use across your devices without giving up the ability to alter policies when needed for individual devices.

 
     [bookmark: pgfId-901675]For example, you might want to deny ICMP traffic to the different departments in your company, each of which is connected to a different network. You can do this by defining an access rule firewall policy with a rule that includes a network/host object called Departmental Network. By allowing device override for this object, you can then create overrides on each relevant device that specify the actual network to which that device is connected.

 
     [bookmark: pgfId-901677]Device-level object overrides are especially important when the global object is included in the definition of a VPN policy, which applies to every device in the VPN topology. For example, you select a PKI enrollment object when defining a PKI policy on a site-to-site VPN. If the hub of your VPN uses a different CA server than the spokes, you must use device-level overrides to specify the CA server used by the hub. Although the PKI policy references a single PKI enrollment object, the actual CA server represented by this object will differ for the hub, based on the device-level override you define.

 
     [bookmark: pgfId-901682]You can quickly tell if an object can be overridden by looking for the Overrides column in the objects table in the Policy Object Manager. A green checkmark indicates that you can create overrides for the object; the presence of the column indicates the object type allows overrides.

 
     [bookmark: pgfId-901684]Related Topics

 
      
      		 [bookmark: pgfId-901689]Allowing a Policy Object to Be Overridden

 
      		 [bookmark: pgfId-901694]Creating or Editing Object Overrides for a Single Device

 
      		 [bookmark: pgfId-901699]Creating or Editing Object Overrides for Multiple Devices At A Time

 
      		 [bookmark: pgfId-901704]Deleting Device-Level Object Overrides

 
     

 
    
 
     
      [bookmark: pgfId-901716][bookmark: 14886][bookmark: obman_proc_AllowingaGlobalObjecttoBeOverridden]Allowing a Policy Object to Be Overridden[bookmark: marker-901710][bookmark: marker-901712][bookmark: marker-901714]

 
     [bookmark: pgfId-901718]To create overrides for an object, the object must allow overrides. Not all object types allow overrides.

 
     [bookmark: pgfId-901723]For those that do allow overrides, you define the object as allowing overrides by selecting Allow Value Override per Device when defining the object. After selecting this option, you must click OK to save the object before you can define any overrides. For more information on creating objects, see Creating Policy Objects.

 
     [bookmark: pgfId-901725]You can also configure Security Manager to create device-level overrides for existing objects when you discover policies on devices that you add to the inventory. During discovery, if Security Manager determines that an existing object applies to a discovered policy, but that it is not a perfect fit, the object is used but a device-level override is created to account for the difference. For example, if you run policy discovery on a device that has an ACL with the same name as an ACL policy object in Security Manager, the name of the discovered policy object is reused, but a device-level override is created for the object. If you do not allow device-level overrides during discovery, a new policy object is created with a number appended to the name; this is the default.

 
     [bookmark: pgfId-901727]To configure Security Manager to allow device overrides during discovery, select Tools > Security Manager Administration > Discovery and select Allow Device Override for Discovered Policy Objects.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-901729]Note To ensure that a specific policy object will be reused for device-level override during discovery, make sure the Allow Value Override per Device check box has been selected for the policy object in Policy Object Manager before policy discovery.


     
      

     

     

 
     [bookmark: pgfId-901731]Related Topics

 
      
      		 [bookmark: pgfId-901736]Understanding Policy Object Overrides for Individual Devices

 
      		 [bookmark: pgfId-901741]Creating or Editing Object Overrides for a Single Device

 
      		 [bookmark: pgfId-901746]Creating or Editing Object Overrides for Multiple Devices At A Time

 
      		 [bookmark: pgfId-901751]Deleting Device-Level Object Overrides

 
     

 
    
 
     
      [bookmark: pgfId-901767][bookmark: 14926][bookmark: obman_proc_CreatingObjectOverridesforaSingleDevice]Creating or Editing Object Overrides for a Single Device [bookmark: marker-901757][bookmark: marker-901759][bookmark: marker-901761][bookmark: marker-901763][bookmark: marker-901765]

 
     [bookmark: pgfId-901769]You can create or edit device-level object overrides from the Device Properties window.

 
     [bookmark: pgfId-901771]An override specifies a definition for a global object that affects only the selected device. For example, you can override the definition of a AAA server group object so that the object represents a different group of AAA servers for one device than the group it represents for other devices.

 
     [bookmark: pgfId-901773]Related Topics

 
      
      		 [bookmark: pgfId-901778]Understanding Policy Object Overrides for Individual Devices

 
      		 [bookmark: pgfId-901783]Allowing a Policy Object to Be Overridden

 
      		 [bookmark: pgfId-901788]Creating or Editing Object Overrides for Multiple Devices At A Time

 
      		 [bookmark: pgfId-901793]Deleting Device-Level Object Overrides

 
     

 
     
 
     [bookmark: pgfId-901795]Step 1 (Device view) Right-click a device in the Device selector and select Device Properties.

 
     [bookmark: pgfId-901797]Step 2 Select the object type you want to override from the Policy Object Overrides folder.

 
     [bookmark: pgfId-901799]The table displays all objects of the selected type that can be overridden at the device level. If an object has an override already defined for the device, the Value Overridden? column contains a check mark.

 
     [bookmark: pgfId-901801]Step 3 Select the object whose override you want to change and do one of the following:

 
      
      		 [bookmark: pgfId-901803]Click the  Create Override button, or right-click and select  Create Override .

 
      		 [bookmark: pgfId-901805]Click the  Edit Override button, or right-click and select  Edit Override .

 
     

 
     [bookmark: pgfId-901807]The dialog box for defining that type of object is displayed with the current properties (either the global properties or the local override).

 
     [bookmark: pgfId-901809]Step 4 Modify the definition of the object and click OK to save the device-level override. In the Device Properties window, a green check mark appears in the Value Overridden? column.

 
     [bookmark: pgfId-901811]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-901825][bookmark: 14988][bookmark: obman_proc_CreatingObjectOverridesforMultipleDevices]Creating or Editing Object Overrides for Multiple Devices At A Time [bookmark: marker-901817][bookmark: marker-901819][bookmark: marker-901821][bookmark: marker-901823]

 
     [bookmark: pgfId-901827]You can create or edit device-level object overrides from the Policy Object Manager window.

 
     [bookmark: pgfId-901829]This method enables you to create overrides on multiple devices at the same time, which is especially useful when creating overrides for several devices that participate in the same VPN topology. For example, if the spokes located in one part of the VPN use a different CA server than the spokes located in a different part of the VPN, you can override the PKI enrollment object that defines the server for these devices. This is a more convenient method than selecting each device individually from Device view and defining the override from the Device Properties window.

 
     [bookmark: pgfId-901831]Related Topics

 
      
      		 [bookmark: pgfId-901836]Understanding Policy Object Overrides for Individual Devices

 
      		 [bookmark: pgfId-901841]Allowing a Policy Object to Be Overridden

 
      		 [bookmark: pgfId-901846]Creating or Editing Object Overrides for a Single Device

 
      		 [bookmark: pgfId-901851]Deleting Device-Level Object Overrides

 
     

 
     
 
     [bookmark: pgfId-901856]Step 1 Select Manage > Policy Objects to open the Policy Object Manager.

 
     [bookmark: pgfId-901858]Step 2 Select the object type you want to override from the table of contents, and then select the object to override.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-901863]Tip Not all types of object allow overrides, and not all objects are defined as overridable. Look for a green check mark in the Overridable column. If the object type allows overrides, but this object does not have a check mark, edit the object to enable object override (see Allowing a Policy Object to Be Overridden).


     
      

     

     

 
     [bookmark: pgfId-901868]Step 3 Double-click the checkmark, or right-click the object and select Edit Device Overrides, to open the Policy Object Overrides Window. The window contains a table listing each device for which an override is defined for the object.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-901870]Tip You can also edit the overridable object and click Edit next to the Overrides field.


     
      

     

     

 
     [bookmark: pgfId-901872]Step 4 Do one of the following:

 
      
      		 [bookmark: pgfId-901874]To add an override, click the  Create Override button, select the devices to which you want to apply the override, and define the override.

 
     

 
     [bookmark: pgfId-901876]The dialog boxes for creating and editing the override are the same ones used to create the object; click the Help button for information specific to the type of object.

 
     [bookmark: pgfId-901878]The override you create applies to all policies on the device that use the object; you cannot override the object for one policy but not for another policy.

 
      
      		 [bookmark: pgfId-901880]To edit an override, select it and click the  Edit Override button.

 
     

 
     [bookmark: pgfId-901882]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-901896][bookmark: 15049][bookmark: pobjpage_cncpt_PolicyObjectOverridesWindow]Policy Object Overrides Window[bookmark: marker-901892][bookmark: marker-901894]

 
     [bookmark: pgfId-901898]Use the Policy Object Overrides window to view a list of all device-level overrides that are defined for the selected object. The content displayed in the table differs depending on the type of object, but it always includes the device name, object description, and category. Sometimes the content of the object is shown, including the overrides.

 
      
      		 [bookmark: pgfId-901900]To add an override, click the  Create Override button. In the Create Overrides for Device window, select the devices from the available list and click  >> to move them to the selected list. When you click  OK , you are presented with the dialog box for defining your override, which applies to all newly selected devices. (You are not changing the override of the greyed out devices)

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-901902]Note The available devices list shows the devices that have not already had overrides defined for the object. Devices with overrides are shown greyed out in the selected devices list.


     
      

     

     

 
     [bookmark: pgfId-901904]The dialog boxes for creating and editing the override are the same ones used to create the object; click the Help button for information specific to the type of object.

 
     [bookmark: pgfId-901906]The override you create applies to all policies on the device that use the object; you cannot override the object for one policy but not for another policy.

 
      
      		 [bookmark: pgfId-901908]To edit an override, select it and click the  Edit Override button.

 
      		 [bookmark: pgfId-901910]To delete an override, select it and click the  Delete Override button.

 
     

 
     [bookmark: pgfId-901912]Deleting an override does not delete the object or remove the object from its device assignment. When you delete the override, the policies on the device that use the object start using the global definition for the object. This changes the meaning of the policies.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-901917]Tip You can also create and edit device-level overrides from the Device Properties window of a selected device. Using the Device Properties windows makes it easy for you to manage the overrides for all objects used by a single device. For more information, see Creating or Editing Object Overrides for a Single Device.


     
      

     

     

 
     [bookmark: pgfId-901919]Navigation Path

 
     [bookmark: pgfId-901924]Open the Policy Object Manager. Select an object type that can be overridden (its object page contains a column called Overrides), then do one of the following:

 
      
      		 [bookmark: pgfId-901926]Double-click the green checkmark in the Overrides column.

 
      		 [bookmark: pgfId-901928]Right-click the object and select  Edit Device Overrides .

 
      		 [bookmark: pgfId-901930]Edit the overridable object and click  Edit next to the Overrides field.

 
     

 
     [bookmark: pgfId-901932]Related Topics

 
      
      		 [bookmark: pgfId-901937]Understanding Policy Object Overrides for Individual Devices

 
      		 [bookmark: pgfId-901942]Allowing a Policy Object to Be Overridden

 
      		 [bookmark: pgfId-901947]Creating or Editing Object Overrides for Multiple Devices At A Time

 
      		 [bookmark: pgfId-901952]Deleting Device-Level Object Overrides

 
      		 [bookmark: pgfId-901957]Filtering Tables

 
      		 [bookmark: pgfId-901962]Filtering Items in Selectors

 
     

 
    
 
     
      [bookmark: pgfId-901980][bookmark: 15113][bookmark: obman_cncpt_DeletingDeviceLevelObjectOverrides]Deleting Device-Level Object Overrides [bookmark: marker-901968][bookmark: marker-901970][bookmark: marker-901972][bookmark: marker-901974][bookmark: marker-901976][bookmark: marker-901978]

 
     [bookmark: pgfId-901982]Deleting a device-level override restores the global definition of the object to the selected device. You can delete overrides from the Device Properties window or from the Policy Object Manager window:

 
      
      		 [bookmark: pgfId-901984]Deleting overrides from Device view—Right-click the device and select  Device Properties , then select the object type from the  Policy Object Overrides folder. Select the override you want to delete and click  Delete Override .

 
      		 [bookmark: pgfId-901986]Deleting overrides from the Policy Object Manager—Select the object type from the table of contents, then right-click the object and select  Edit Device Overrides . Select the override you want to delete and click  Delete Override .

 
     

 
     [bookmark: pgfId-901988]Related Topics

 
      
      		 [bookmark: pgfId-901993]Understanding Policy Object Overrides for Individual Devices

 
      		 [bookmark: pgfId-901998]Allowing a Policy Object to Be Overridden

 
      		 [bookmark: pgfId-902003]Policy Object Override Pages

 
      		 [bookmark: pgfId-902008]Policy Object Overrides Window

 
     

 
    
 
     
      [bookmark: pgfId-902026][bookmark: 15163][bookmark: obman_cncpt_ImportingAndExportingPolicyObjects]Importing and Exporting Policy Objects[bookmark: marker-902014][bookmark: marker-902016][bookmark: marker-902018][bookmark: marker-902020][bookmark: marker-902022][bookmark: marker-902024]

 
     [bookmark: pgfId-902028]Security Manager includes a Perl script that you can use to export network/host, service, and port list policy objects so that you can import them into another Security Manager server. The information includes device-level overrides for policy objects that have them.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-902030]Note The command works with network/host objects that contain IPv4 addresses only. You cannot use the command to import network/host-IPv6 objects.


     
      

     

     

 
     [bookmark: pgfId-902032]You can also manually create a CSV file that you can import. For example, you might obtain a list of IP addresses that identify networks or hosts that should be denied entry to your network. You can create a CSV file that will bulk-load the list as one or more network/host objects if that is easier than manually creating the object in the Policy Object Manager.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-902043]Tip Besides using this command, you can use other facilities to export and import policy objects that are assigned to shared policies or configured in local device policies. For more information, see the following topics: Exporting the Device Inventory from the Security Manager Client, Exporting Shared Policies, and Importing Policies or Devices


     
      

     

     

 
     [bookmark: pgfId-902045]The Perl command is located in $NMSROOT\bin, which is typically C:\Program Files\CSCSpx\bin. The syntax of the command is:

 
     [bookmark: pgfId-902047]perl [path]PolicyObjectImportExport.pl -u username -p password -o {import | export} [-a activity] -t object_type -f filename [-c {true | false}] [-d {true | false}] [-e {true | false}] [-g {true | false}] [-h]

 
     [bookmark: pgfId-902050]Syntax

 
      
       
       
         
         		[bookmark: pgfId-895937]perl [path] PolicyObjectImportExport.pl

  
         		[bookmark: pgfId-895939]The Perl script command. Include the path to the PolicyObjectImportExport.pl file if the path is not defined in the system path variable.

 [bookmark: pgfId-895941]Tip If you forget to include the “perl” command, the system accepts the input but does nothing and provides no feedback on your error. Use Ctrl+Z to return to the command prompt.  
        

 
         
         		[bookmark: pgfId-895947]-u username

  
         		[bookmark: pgfId-895949]A Security Manager username. The data exported is limited by the permissions assigned to this user. The user must have Modify Objects permission for the import or export of policy objects, and additionally the Modify Devices permission for the import or export of device-level overrides.

 [bookmark: pgfId-895951]If you are importing objects in non-Workflow mode, you must also have Submit and Approve privileges.

  
        

 
         
         		[bookmark: pgfId-895957]-p password

  
         		[bookmark: pgfId-895959]The user’s password.

  
        

 
         
         		
           
           [bookmark: pgfId-895965]-o {import | export}
          
  
         		[bookmark: pgfId-895967]The type of operation you are performing, either to import policy objects from an existing file, or to export policy objects to a CSV file. Only committed objects are exported.

  
        

 
         
         		[bookmark: pgfId-895973]-a activity

  
         		[bookmark: pgfId-895975](Optional.) The name of a Workflow activity. If you do not specify a name, a new activity is created with the name username_time.

  
        

 
         
         		[bookmark: pgfId-895981]-t object_type

  
         		[bookmark: pgfId-895983]Object type, one of the following:

 
           
           		 [bookmark: pgfId-895985]network—For network/host objects.

 
           		 [bookmark: pgfId-895987]service—For service objects.

 
           		 [bookmark: pgfId-895989]portlist—For port-list objects.

 
          

  
        

 
         
         		[bookmark: pgfId-895995]-f filename

  
         		[bookmark: pgfId-895997]The name of the CSV file. When exporting, if the file exists, it is overwritten.

  
        

 
         
         		
           
           [bookmark: pgfId-896003]-c {true | false}
          
  
         		[bookmark: pgfId-896005](Optional.) When importing objects, whether to enable policy object conflict detection.

 
           
           		 [bookmark: pgfId-896007]false—An object is imported even if an existing object has the same content.

 
           		 [bookmark: pgfId-896012]true—If an existing object has the same content as an imported object, the imported object is skipped. You must also select  Enforce for the  When Redundant Objects Detected option on the Policy Objects Page.

 
          

  
        

 
         
         		
           
           [bookmark: pgfId-896018]-d {true | false}
          
  
         		[bookmark: pgfId-896020](Optional.) How to handle device-level policy object overrides during either an import or export operation:

 
           
           		 [bookmark: pgfId-896022]true—Include all globally-defined objects and all device-level overrides of the objects.

 
           		 [bookmark: pgfId-896024]false—Include only the global definitions of the policy objects. Do not include any device-level policy object override information. This is the default.

 
          

  
        

 
         
         		
           
           [bookmark: pgfId-896030]-e {true | false}
          
  
         		[bookmark: pgfId-896032](Optional.) Whether to “flatten” port-list objects in service objects and service-group objects:

 
           
           		 [bookmark: pgfId-896034]true—The names of any port-list objects found in service objects and service-group objects are replaced with the actual ports from the lists. That is, the two objects, port-list and service, or port-list and service-group, are “flattened” into a single service or service-group.

 
          

 [bookmark: pgfId-896036]Port-list objects are used in Security Manager to group sets of port definitions, and are used when defining service and service-group objects. However, port-list objects are not supported in PRSM.

 
           
           		 [bookmark: pgfId-896038]false—Port-list objects in service and service-group objects are not flattened. This is the default.

 
          

  
        

 
         
         		
           
           [bookmark: pgfId-896044]-g {true | false}
          
  
         		[bookmark: pgfId-896046](Optional.) Whether to include object and object-group types in the CSV file:

 
           
           		 [bookmark: pgfId-896048]true—The final column in the file will be  Type and it will indicate “Service” or “Network.”

 
           		 [bookmark: pgfId-896050]false—The Type column is not included. This is the default.

 
          

  
        

 
         
         		
           
           [bookmark: pgfId-896056]-h
          
  
         		[bookmark: pgfId-896058](Optional.) Display the command line help. If you include this option, all other options are ignored.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-902052]Importing Policy Objects

 
     [bookmark: pgfId-902054]When you are importing objects, if an object refers to another object, that object must already be defined in Security Manager, or it must be defined in the same CSV file that you are importing. If the object is in the same CSV file, it must come before the object that refers to it. (Security Manager automatically sorts objects as required when exporting them.)

 
     [bookmark: pgfId-902056]If Security Manager already has a policy object of the same name as one you are importing, the object is skipped and not imported. The name conflict can even occur if another user has created an object but not yet committed it for public viewing, so you might not be able to see the conflicting object. Security Manager creates only new objects, it does not update existing objects. Use the -c option to specify whether new objects can be created that have the same content as existing objects.

 
     [bookmark: pgfId-902058]When you run the command, if there are any errors in the file, only the affected objects are not imported. Error messages indicate these problems as they occur, and Security Manager continues evaluating all records in the file. All correctly defined policy objects are imported, and the objects with errors are skipped. The total count and the names of the policy objects that are not imported are shown in the output screen.

 
     [bookmark: pgfId-902060]After the import command completes, additional actions depend on the Workflow mode you are using:

 
      
      		 [bookmark: pgfId-902062]Workflow mode—You must log into Security Manager using the same username and password and submit the activity you specified during the import. The activity must be submitted and approved for the changes to take effect.

 
      		 [bookmark: pgfId-902064]Non-Workflow mode—The imported objects are automatically submitted and approved without action on your part. However, you will receive an error if the username you supplied does not have Submit and Approve privileges, and the import operation will fail.

 
     

 
     [bookmark: pgfId-902066]CSV File Format

 
     [bookmark: pgfId-902068]All objects in a single file are of the same policy object type. The file is in standard comma-separated values (CSV) format. The first line has column headings. Each row represents a single policy object. The columns, left to right, are:

 
      
      		 [bookmark: pgfId-902070]Name—(Mandatory.) The name of the object.

 
      		 [bookmark: pgfId-902072]Node—The display name of the device on which an override of the policy object is defined. If the policy object is defined on the global level, the field is empty. When importing objects, if the display name does not match a device already in the Security Manager inventory, the object is skipped and not imported.

 
      		 [bookmark: pgfId-902074]Description—The description of the object, if any.

 
      		 [bookmark: pgfId-902076]Category—The category identifier of the object, if any. The category ID is from 10 to 19.

 
      		 [bookmark: pgfId-902078]Allow Override—Whether the object can be overridden. True if the policy object can be overridden on device level, False (or an empty field) if not.

 
      		 [bookmark: pgfId-902080]Group—The names of other policy objects with the same type referenced by this policy object. If there is more than one object, they are separated by commas. For example, network building block Net1 references network building block Net2 and Net3. The Group field of Net1 would have “Net2,Net3” as its value.

 
      		 [bookmark: pgfId-902082]Data—The content of the object.

 
      		 [bookmark: pgfId-902090]Subtype—The object subtype, if any, for network/host and service objects. For an explanation of network/host and service object types, see Understanding Networks/Hosts Objects and Understanding and Specifying Services and Service and Port List Objects. Possible values are:

 
     

 
     [bookmark: pgfId-902092] – Blank, or space—The object is a group object, either network/host or service.

 
     [bookmark: pgfId-902094] – NH—(Network/host objects only.) Single host network/host object.

 
     [bookmark: pgfId-902096] – NF—(Network/host objects only.) Single fully-qualified domain name (FQDN) network/host object.

 
     [bookmark: pgfId-902098] – NN—(Network/host objects only.) Single network address network/host object.

 
     [bookmark: pgfId-902100] – NR—(Network/host objects only.) Single Address range network/host object.

 
     [bookmark: pgfId-902102] – SO—(Service objects only.) Single-service service object.

 
      
      		 [bookmark: pgfId-902104]Type—The type of object represented by this entry: “Network” or “Service.”

 
     

 
     [bookmark: pgfId-902106]If there is no value for a particular field, that field is blank in the output. If there are multiple values for a field, the field is enclosed in double quotation marks.

 
    
 
   
 
    
     [bookmark: pgfId-902124][bookmark: 15393][bookmark: obman_cncpt_UnderstandingAAAServerObjects]Understanding AAA Server and Server Group Objects[bookmark: marker-902112][bookmark: marker-902114][bookmark: marker-902116][bookmark: marker-902118][bookmark: marker-902120][bookmark: marker-902122]

 
    [bookmark: pgfId-902126]You use AAA server objects to identify the AAA servers used in your network. AAA enables devices to determine who the user is (authentication), what the user is permitted to do (authorization), and what the user actually did (accounting), as described below:

 
     
     		 [bookmark: pgfId-902128]Authentication—Authentication is the way a user is identified before being allowed access to the network and network services. It controls access by requiring valid user credentials, which are typically a username and password. All authentication methods, except for local, line password, and enable authentication, must be defined through AAA. You can use authentication alone or with authorization and accounting.

 
     		 [bookmark: pgfId-902130]Authorization—After authentication is complete, authorization controls the services and commands available to each authenticated user. Authorization works by assembling a set of attributes that describe what the user is authorized to perform. These attributes are compared to the information contained in a database for a given user and the result is returned to AAA to determine the user’s actual capabilities and restrictions. The database can be located locally on the access server or router or it can be hosted remotely on a RADIUS or TACACS+ security server. Were you not to use authorization, authentication alone would provide the same access to services to all authenticated users. You must use authorization together with authentication.

 
     		 [bookmark: pgfId-902132]Accounting—Accounting is used to track the services users are accessing, as well as the amount of network resources they are consuming. When AAA accounting is activated, the network access server reports user activity to the RADIUS or TACACS+ security server (depending on which security method you have implemented) in the form of accounting records. Accounting information includes when sessions start and stop, usernames, the number of bytes that pass through the device for each session, the service used, and the duration of each session. This data can then be analyzed for network management, client billing, or auditing. You can use accounting alone or together with authentication and authorization.

 
    

 
    [bookmark: pgfId-902134]AAA provides an extra level of protection and control for user access over using access rules (ACLs) alone. For example, you can create an access rule allowing all outside users to attempt to use Telnet on a server on the DMZ network. If you want only some users to actually reach the server (and you might not always know the IP addresses of these users, making it impossible to configure simple access rules), you can enable AAA to allow only authenticated or authorized users to make it through the network device (for example, the ASA or router). Thus, users must authenticate before reaching the Telnet server, where Telnet can also require a separate login.

 
    [bookmark: pgfId-902136]AAA server objects are collected into AAA server group objects. Policies requiring AAA (such as Easy VPN, Remote Access VPNs, and router platform policies such as Secured Device Provisioning and 802.1x) usually refer to AAA server group objects. These objects contain multiple AAA servers that use the same protocol, such as RADIUS or TACACS+. In essence, AAA server groups represent collections of authentication servers focused on enforcing specific aspects of your overall network security policy. For example, you can group those servers dedicated to authenticating internal traffic, external traffic, or remote dial-in users, as well as servers that authorize the administration of your firewall devices.

 
    [bookmark: pgfId-902138]The following topics describe how to work with AAA server objects:

 
     
     		 [bookmark: pgfId-902143]Supported AAA Server Types

 
     		 [bookmark: pgfId-902148]Additional AAA Support on ASA, PIX, and FWSM Devices

 
     		 [bookmark: pgfId-902153]Predefined AAA Authentication Server Groups

 
     		 [bookmark: pgfId-902158]Default AAA Server Groups and IOS Devices

 
     		 [bookmark: pgfId-902163]Creating AAA Server Objects

 
     		 [bookmark: pgfId-902168]Add or Edit AAA Server Dialog Box

 
     		 [bookmark: pgfId-902173]Add and Edit LDAP Attribute Map Dialog Boxes

 
     		 [bookmark: pgfId-902178]Creating AAA Server Group Objects

 
    

 
     
      [bookmark: pgfId-902190][bookmark: 15453][bookmark: obman_cncpt_SupportedAAAServerTypes]Supported AAA Server Types[bookmark: marker-902184][bookmark: marker-902186][bookmark: marker-902188]

 
     [bookmark: pgfId-902195]You can use AAA servers that use the RADIUS protocol with all devices, and the TACACS+ and LDAP protocols with all devices except IPS. For ASA, PIX, and FWSM devices, you can also use the protocols described in Additional AAA Support on ASA, PIX, and FWSM Devices

 
      
      		 [bookmark: pgfId-902199] RADIUS —Remote Authentication Dial-In User Service (RADIUS) is a distributed client/server system that secures networks against unauthorized access. In the Cisco implementation, RADIUS clients run on Cisco devices and send authentication requests to a central RADIUS server that contains all user authentication and network service access information.[bookmark: marker-902197]

 
     

 
     [bookmark: pgfId-902201]You can use RADIUS with other AAA security protocols, such as TACACS+, Kerberos, and local username lookup, depending on what is supported by a particular device type. RADIUS is supported on all Cisco platforms, but some RADIUS-supported features run only on specified platforms.

 
      
      		 [bookmark: pgfId-902205] TACACS+ —Terminal Access Controller Access Control System (TACACS+) is a security application that provides centralized validation of users attempting to gain access to a router or network access server. The goal of TACACS+ is to provide a methodology for managing multiple network access points from a single management service.[bookmark: marker-902203]

 
     

 
     [bookmark: pgfId-902207]TACACS+ provides for separate and modular authentication, authorization, and accounting facilities. TACACS+ allows for a single access control server (the TACACS+ daemon) to provide each service independently.

 
      
      		 [bookmark: pgfId-902212] LDAP —Lightweight Directory Access Protocol (LDAP). The use of LDAP servers is specific to certain policies. For example, identity firewall configurations on ASA, VPN configurations on ASA, and ScanSafe configurations on IOS devices. For more information on using LDAP on ASA, see Additional AAA Support on ASA, PIX, and FWSM Devices.

 
     

 
     [bookmark: pgfId-902214]Related Topics

 
      
      		 [bookmark: pgfId-902219]Additional AAA Support on ASA, PIX, and FWSM Devices

 
      		 [bookmark: pgfId-902224]Creating AAA Server Objects

 
      		 [bookmark: pgfId-902229]Understanding AAA Server and Server Group Objects

 
     

 
    
 
     
      [bookmark: pgfId-902249][bookmark: 15500][bookmark: obman_cncpt_AAASupportonASADevices]Additional AAA Support on ASA, PIX, and FWSM Devices[bookmark: marker-902235][bookmark: marker-902237][bookmark: marker-902239][bookmark: marker-902241][bookmark: marker-902243][bookmark: marker-902245][bookmark: marker-902247]

 
     [bookmark: pgfId-902251]In addition to supporting RADIUS and TACACS+, ASA, PIX 7.0+, and FWSM 3.1+ devices can support AAA servers running the following protocols. For more information, see the explanation of AAA usage in the configuration guides for the device type and operating system version that interests you.

 
      
      		 [bookmark: pgfId-902255] Kerberos —These devices can use Kerberos servers for authentication. 3DES, DES, and RC4 encryption types are supported.[bookmark: marker-902253]

 
      		 [bookmark: pgfId-902259] NT —These devices can use Windows Domain servers for NTLMv1 authentication.[bookmark: marker-902257]

 
      		 [bookmark: pgfId-902263] SDI Servers —SecureID servers from RSA Security, Inc. are known as SDI servers. When a user attempts to establish VPN access and the applicable tunnel-group policy specifies an SDI authentication server group, the ASA device sends the username and one-time password to the SDI server. The device then grants or denies user access based on the response from the server. Version 5.0 of SDI introduced the concept of SDI master and slave servers that share a single-node secret file (SECURID). As a result, when you configure an SDI server as a AAA server object, you must specify whether the server is version 5.0 or an earlier version.[bookmark: marker-902261]

 
      		 [bookmark: pgfId-902269][bookmark: obman_cncpt_AAASupportonASADevices_ldap] LDAP —These devices can use Lightweight Directory Access Protocol (LDAP) servers for VPN authorization and user group identification for identity-aware firewall policies. These devices support LDAP version 3 and are compatible with any v3 or v2 directory server. However, password management is supported only on the Sun Microsystems JAVA System Directory Server and the Microsoft Active Directory.[bookmark: marker-902267]

 
     

 
     [bookmark: pgfId-902271]With any other type of LDAP server (such as Novell or OpenLDAP), all LDAP functions are supported except for password management. Therefore, if someone tries to log in to one of these devices using one of these other servers for authentication and their password has expired, the device drops the connection and a manual password reset is required.

 
     [bookmark: pgfId-902273]You can configure Simple Authentication and Security Layer (SASL) mechanisms to authenticate an LDAP client (in this case, the ASA, PIX, or FWSM device) to an LDAP server. These devices and LDAP servers can support multiple mechanisms. If both mechanisms (MD5 and Kerberos) are available, the ASA, PIX, or FWSM device uses the stronger mechanism, Kerberos, for authentication.

 
     [bookmark: pgfId-902275]When user authentication for VPN access has succeeded and the applicable tunnel-group policy specifies an LDAP authorization server group, the ASA, PIX, or FWSM device queries the LDAP server and applies the authorizations it receives to the VPN session.

 
      
      		 [bookmark: pgfId-902277] HTTP-Form —These devices can use the HTTP Form protocol for single sign-on (SSO) authentication of WebVPN users only. Single sign-on support lets WebVPN users enter a username and password only once to access multiple protected services and Web servers. The WebVPN server running on the security appliance acts as a proxy for the user to the authenticating server. When a user logs in, the WebVPN server sends an SSO authentication request, including username and password, to the authenticating server using HTTPS. If the server approves the authentication request, it returns an SSO authentication cookie to the WebVPN server. The security appliance keeps this cookie on behalf of the user and uses it to authenticate the user to secure websites within the domain protected by the SSO server.

 
     

 
      
       
        
        [bookmark: pgfId-896085]Table 6-5 [bookmark: 15567]AAA Services Supported by ASA, PIX, and FWSM Devices 

 
        
       
         
         		 
           
           [bookmark: pgfId-896105]AAA Service
          
  
         		 
           
           [bookmark: pgfId-896107]Database Type
          
  
        

 
         
         		
           
           [bookmark: pgfId-896143]Local
          
  
         		
           
           [bookmark: pgfId-896145]RADIUS
          
  
         		
           
           [bookmark: pgfId-896147]TACACS+
          
  
         		
           
           [bookmark: pgfId-896149]SDI
          
  
         		
           
           [bookmark: pgfId-896151]NT
          
  
         		
           
           [bookmark: pgfId-896153]Kerberos
          
  
         		
           
           [bookmark: pgfId-896155]LDAP
          
  
         		
           
           [bookmark: pgfId-896157]HTTP Form
          
  
        

 
         
         		 
           
           [bookmark: pgfId-896177]Authentication of...
          
  
        

 
         
         		[bookmark: pgfId-896213]VPN users

  
         		[bookmark: pgfId-896215]Yes

  
         		[bookmark: pgfId-896217]Yes

  
         		[bookmark: pgfId-896219]Yes

  
         		[bookmark: pgfId-896221]Yes

  
         		[bookmark: pgfId-896223]Yes

  
         		[bookmark: pgfId-896225]Yes

  
         		[bookmark: pgfId-896227]Yes

  
         		[bookmark: pgfId-896231]Yes1

  
        

 
         
         		[bookmark: pgfId-896251]Firewall sessions

  
         		[bookmark: pgfId-896253]Yes

  
         		[bookmark: pgfId-896255]Yes

  
         		[bookmark: pgfId-896257]Yes

  
         		[bookmark: pgfId-896259]Yes

  
         		[bookmark: pgfId-896261]Yes

  
         		[bookmark: pgfId-896263]Yes

  
         		[bookmark: pgfId-896265]Yes

  
         		[bookmark: pgfId-896267]No

  
        

 
         
         		[bookmark: pgfId-896287]Administrators

  
         		[bookmark: pgfId-896289]Yes

  
         		[bookmark: pgfId-896291]Yes

  
         		[bookmark: pgfId-896293]Yes

  
         		[bookmark: pgfId-896297]Yes2

  
         		[bookmark: pgfId-896299]Yes

  
         		[bookmark: pgfId-896301]Yes

  
         		[bookmark: pgfId-896303]Yes

  
         		[bookmark: pgfId-896305]No

  
        

 
         
         		 
           
           [bookmark: pgfId-896325]Authorization of...
          
  
        

 
         
         		[bookmark: pgfId-896361]VPN users

  
         		[bookmark: pgfId-896363]Yes

  
         		[bookmark: pgfId-896365]Yes

  
         		[bookmark: pgfId-896367]No

  
         		[bookmark: pgfId-896369]No

  
         		[bookmark: pgfId-896371]No

  
         		[bookmark: pgfId-896373]No

  
         		[bookmark: pgfId-896375]Yes

  
         		[bookmark: pgfId-896377]No

  
        

 
         
         		[bookmark: pgfId-896397]Firewall sessions

  
         		[bookmark: pgfId-896399]No

  
         		[bookmark: pgfId-896403]Yes3

  
         		[bookmark: pgfId-896405]Yes

  
         		[bookmark: pgfId-896407]No

  
         		[bookmark: pgfId-896409]No

  
         		[bookmark: pgfId-896411]No

  
         		[bookmark: pgfId-896413]No

  
         		[bookmark: pgfId-896415]No

  
        

 
         
         		[bookmark: pgfId-896435]Administrators

  
         		[bookmark: pgfId-896439]Yes4

  
         		[bookmark: pgfId-896441]No

  
         		[bookmark: pgfId-896443]Yes

  
         		[bookmark: pgfId-896445]No

  
         		[bookmark: pgfId-896447]No

  
         		[bookmark: pgfId-896449]No

  
         		[bookmark: pgfId-896451]No

  
         		[bookmark: pgfId-896453]No

  
        

 
         
         		 
           
           [bookmark: pgfId-896473]Accounting of...
          
  
        

 
         
         		[bookmark: pgfId-896509]VPN connections

  
         		[bookmark: pgfId-896511]No

  
         		[bookmark: pgfId-896513]Yes

  
         		[bookmark: pgfId-896515]Yes

  
         		[bookmark: pgfId-896517]No

  
         		[bookmark: pgfId-896519]No

  
         		[bookmark: pgfId-896521]No

  
         		[bookmark: pgfId-896523]No

  
         		[bookmark: pgfId-896525]No

  
        

 
         
         		[bookmark: pgfId-896545]Firewall sessions

  
         		[bookmark: pgfId-896547]No

  
         		[bookmark: pgfId-896549]Yes

  
         		[bookmark: pgfId-896551]Yes

  
         		[bookmark: pgfId-896553]No

  
         		[bookmark: pgfId-896555]No

  
         		[bookmark: pgfId-896557]No

  
         		[bookmark: pgfId-896559]No

  
         		[bookmark: pgfId-896561]No

  
        

 
         
         		[bookmark: pgfId-896581]Administrators

  
         		[bookmark: pgfId-896583]No

  
         		[bookmark: pgfId-896587]Yes5

  
         		[bookmark: pgfId-896589]Yes

  
         		[bookmark: pgfId-896591]No

  
         		[bookmark: pgfId-896593]No

  
         		[bookmark: pgfId-896595]No

  
         		[bookmark: pgfId-896597]No

  
         		[bookmark: pgfId-896599]No

  
        

 
         
         		 [bookmark: pgfId-896629][bookmark: obman_cncpt_AAASupportonASADevices_footnote1]1. HTTP Form protocol supports single sign-on (SSO) authentication for WebVPN users only.
[bookmark: obman_cncpt_AAASupportonASADevices_footnote2]2. SDI is not supported for HTTP administrative access.
[bookmark: obman_cncpt_AAASupportonASADevices_footnote3]3. For firewall sessions, RADIUS authorization is supported with user-specific ACLs only, which are received or specified in a RADIUS authentication response.
[bookmark: obman_cncpt_AAASupportonASADevices_footnote4]4. Local command authorization is supported by privilege level only.
[bookmark: obman_cncpt_AAASupportonASADevices_footnote5]5. Command accounting is available for TACACS+ only.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-902284]Related Topics

 
      
      		 [bookmark: pgfId-902289]Supported AAA Server Types

 
      		 [bookmark: pgfId-902294]Creating AAA Server Objects

 
      		 [bookmark: pgfId-902299]Understanding AAA Server and Server Group Objects

 
     

 
    
 
     
      [bookmark: pgfId-902313][bookmark: 15854][bookmark: obman_cncpt_PredefinedAAAAuthenticationServerGroups]Predefined AAA Authentication Server Groups[bookmark: marker-902305][bookmark: marker-902307][bookmark: marker-902309][bookmark: marker-902311]

 
     [bookmark: pgfId-902315]There are several predefined AAA server groups that define an authentication method without specifying particular AAA servers. In policies such as IPSec proposals, you can use these predefined server groups to define the types of AAA authentication to perform and the order in which to perform them.

 
     [bookmark: pgfId-902320]Table 6-6 describes the predefined AAA authentication server groups.

 
     [bookmark: pgfId-902323] 

 
      
       
        
        [bookmark: pgfId-896658]Table 6-6 [bookmark: 15874]Predefined AAA Authentication Server Groups 

 
        
       
         
         		
           
           [bookmark: pgfId-896664]Name
          
  
         		
           
           [bookmark: pgfId-896666]Description
          
  
        

 
         
         		[bookmark: pgfId-896672]Enable

  
         		[bookmark: pgfId-896674]Uses the enable password defined on the device for authentication.

  
        

 
         
         		[bookmark: pgfId-896680]KRB5

 [bookmark: pgfId-896682]KRB5-Telnet

  
         		[bookmark: pgfId-896684]Uses Kerberos 5 for authentication. Use KRB5-Telnet when using Telnet to connect.

 [bookmark: pgfId-896686]For Cisco IOS routers, you can use Kerberos 5 client configuration only on selected platforms running IOS Software versions that support this protocol. Server configuration is not supported. The device must include an Advanced series feature set (k9 crypto image).

  
        

 
         
         		[bookmark: pgfId-896692]If-Authenticated

  
         		[bookmark: pgfId-896694]Uses the if-authenticated method, which allows the user to access the requested function if the user is authenticated.

  
        

 
         
         		[bookmark: pgfId-896700]Line

  
         		[bookmark: pgfId-896702]Uses the line password defined on the device for authentication.

  
        

 
         
         		[bookmark: pgfId-896708]Local

 [bookmark: pgfId-896710]Local-case

  
         		[bookmark: pgfId-896712]Uses the local username database (defined on the device) for authentication. Use Local-case if you want the login to be case-sensitive.

  
        

 
         
         		[bookmark: pgfId-896718]None

  
         		[bookmark: pgfId-896720]Uses no authentication.

  
        

 
         
         		[bookmark: pgfId-896726]RADIUS

 [bookmark: pgfId-896728]TACACS+

  
         		[bookmark: pgfId-896730]Use RADIUS or TACACS+ authentication. (Does not apply to Cisco IOS routers.)

 [bookmark: pgfId-896735]These AAA server groups do not contain any AAA servers. To use one of them when defining a policy, you must create a device-level override and define the AAA servers to associate with the group. For more information, see Creating or Editing Object Overrides for a Single Device.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-902325]Related Topics

 
      
      		 [bookmark: pgfId-902330]Creating AAA Server Group Objects

 
      		 [bookmark: pgfId-902335]Default AAA Server Groups and IOS Devices

 
      		 [bookmark: pgfId-902340]Understanding AAA Server and Server Group Objects

 
     

 
    
 
     
      [bookmark: pgfId-902354][bookmark: 15938][bookmark: obman_cncpt_DefaultAAAServerGroupsandIOSDevices]Default AAA Server Groups and IOS Devices[bookmark: marker-902346][bookmark: marker-902348][bookmark: marker-902350][bookmark: marker-902352]

 
     [bookmark: pgfId-902356]IOS software enables you to define AAA servers either as members of AAA server groups or as individual servers. Security Manager, however, requires all AAA servers to belong to a AAA server group.

 
     [bookmark: pgfId-902358]Therefore, when you discover an IOS device whose device configuration contains individual AAA servers that do not belong to a AAA server group, Security Manager creates the following server groups to contain these servers:

 
      
      		 [bookmark: pgfId-902360]For RADIUS: CSM-rad-grp

 
      		 [bookmark: pgfId-902362]For TACACS+: CSM-tac-grp

 
     

 
     [bookmark: pgfId-902364]Both of these special AAA server groups are marked in the Policy Object Manager as the default groups for their protocol. This is indicated by the Make this Group the Default AAA Server Group check box.

 
     [bookmark: pgfId-902366]These groups are created solely for the purpose of management by Security Manager. During deployment, the AAA servers in these special groups are deployed back to the IOS device as individual servers, not as part of the group.

 
     [bookmark: pgfId-902368]You can also create your own default group. The default group can be used in most cases, except when you need to configure multiple AAA server groups that use the same protocol. For example, you might want to define multiple RADIUS groups so that one group can be used for authentication and another group for authorization. Service providers may want to define multiple groups with the same protocol in order to provide customer separation when using VRF.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-902370]Note If you use one of these default AAA server groups in a policy defined for a PIX/ASA/FWSM device, the AAA servers are deployed as a group to that device, not as individual servers. This is because all AAA servers on PIX/ASA/FWSM devices must belong to a AAA server group.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     
      [bookmark: pgfId-902372]
      Caution We recommend that you use caution when using these default AAA server groups in a policy definition. There are certain commands (for example, 
      ip radius and 
      ip tacacs, which are configured using the Interface field in the AAA Server dialog box) that can be defined once for each AAA server group and once for all individual AAA servers. Because the AAA servers in the default group are deployed to IOS devices as individual servers, you might inadvertently change the 
      ip radius or 
      ip tacacs settings for all the individual AAA severs configured on the device, including servers that are not being managed by Security Manager (and whose configurations would otherwise be left undisturbed).
       
       
 
      

     
 
     [bookmark: pgfId-902374]Related Topics

 
      
      		 [bookmark: pgfId-902379]Predefined AAA Authentication Server Groups

 
      		 [bookmark: pgfId-902384]Creating AAA Server Group Objects

 
      		 [bookmark: pgfId-902389]Understanding AAA Server and Server Group Objects

 
     

 
    
 
     
      [bookmark: pgfId-902401][bookmark: 15985][bookmark: obman_proc_CreatingAAAServerObjects]Creating AAA Server Objects[bookmark: marker-902395][bookmark: marker-902397][bookmark: marker-902399]

 
     [bookmark: pgfId-902403]You can create AAA server objects to populate the AAA server group objects that are referenced by policies such as AAA rules, Easy VPN, and 802.1x. In some cases, AAA server objects are used directly by a policy, such as in AAA policies on IPS devices.

 
     [bookmark: pgfId-902405]When creating a AAA server object, you must specify the IP address or DNS name of the external AAA server and the protocol used by the server. The other settings required depend on the protocol.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-902407]Note On PIX/ASA/FWSM devices, AAA objects in a device configuration that are not referenced by any policies are removed from the device during the next deployment. However, the predefined AAA objects named RADIUS and TACACS+ are never removed from PIX 6.3 devices, even if they are not referenced by any policies.


     
      

     

     

 
     [bookmark: pgfId-902409]Related Topics

 
      
      		 [bookmark: pgfId-902414]Creating Policy Objects

 
      		 [bookmark: pgfId-902419]Supported AAA Server Types

 
      		 [bookmark: pgfId-902424]Additional AAA Support on ASA, PIX, and FWSM Devices

 
      		 [bookmark: pgfId-902429]Understanding AAA Server and Server Group Objects

 
     

 
     
 
     [bookmark: pgfId-902434]Step 1 Select Manage > Policy Objects to open the Policy Object Manager (see Policy Object Manager).

 
     [bookmark: pgfId-902436]Step 2 Select AAA Servers from the Object Type selector.

 
     [bookmark: pgfId-902441]Step 3 Right-click in the work area, then select New Object to open the Add or Edit AAA Server Dialog Box.

 
     [bookmark: pgfId-902443]Step 4 Enter a name for the object and optionally a description of the object.

 
     [bookmark: pgfId-902445]Step 5 Identify the AAA server:

 
      
      		 [bookmark: pgfId-902447]In the Host field, enter the IP address or for ASA or PIX 7.2+ devices, the host name of the AAA server. You can also enter the name of a network/host object that contains the host IP address, or click  Select to select the object.

 
      		 [bookmark: pgfId-902449]Optionally, in the Interfaces field, enter the name of an interface or an interface role (which must resolve to a single interface name on the device) whose IP address should be used for all outgoing RADIUS or TACACS+ packets. Do not specify an interface for objects used on an IPS device.

 
      		 [bookmark: pgfId-902451]Optionally, enter the amount of time to wait until a AAA server is considered unresponsive.

 
     

 
     [bookmark: pgfId-902453]Step 6 Select the protocol used by the AAA server and configure protocol-specific properties. You can use RADIUS with all device types, and TACACS+ with all device types except for IPS devices. You can use the Kerberos, LDAP, NT, SDI, and HTTP-FORM protocols only with ASA, PIX 7.x+, and FWSM 3.1+ devices.

 
     [bookmark: pgfId-902455]For details about the properties, see the following topics:

 
      
      		 [bookmark: pgfId-902460]RADIUS—See AAA Server Dialog Box—RADIUS Settings.

 
      		 [bookmark: pgfId-902465]TACACS+—See AAA Server Dialog Box—TACACS+ Settings.

 
      		 [bookmark: pgfId-902470]Kerberos—See AAA Server Dialog Box—Kerberos Settings.

 
      		 [bookmark: pgfId-902475]LDAP—See AAA Server Dialog Box—LDAP Settings.

 
      		 [bookmark: pgfId-902480]NT—See AAA Server Dialog Box—NT Settings.

 
      		 [bookmark: pgfId-902485]SDI—See AAA Server Dialog Box—SDI Settings.

 
      		 [bookmark: pgfId-902490]HTTP-FORM—See AAA Server Dialog Box—HTTP-FORM Settings.

 
     

 
     [bookmark: pgfId-902495]Step 7 (Optional) Under Category, select a category to help you identify this object in the Objects table. See Using Category Objects.

 
     [bookmark: pgfId-902497]Step 8 Click OK to save the object.

 
     [bookmark: pgfId-902499]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-902511][bookmark: 16074][bookmark: pobjpage_cncpt_AAAServerDialogBox]Add or Edit AAA Server Dialog Box[bookmark: marker-902507][bookmark: marker-902509]

 
     [bookmark: pgfId-902513]Use Add or Edit AAA Server dialog box to create, copy, and edit a AAA server object. These objects are collected into AAA server group objects and identify the AAA servers that you want to use when defining various AAA policies. In some cases these objects are used directly in a AAA policy.

 
     [bookmark: pgfId-902521]For a description of the protocols you can use, see Supported AAA Server Types and Additional AAA Support on ASA, PIX, and FWSM Devices.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-902523]Note You cannot edit the protocol if the object is already included in a AAA server group.


     
      

     

     

 
     [bookmark: pgfId-902525]Navigation Path

 
     [bookmark: pgfId-902527]Select Manage > Policy Objects, then select AAA Servers from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-902529]Related Topics

 
      
      		 [bookmark: pgfId-902534]Creating AAA Server Objects

 
      		 [bookmark: pgfId-902539]Understanding AAA Server and Server Group Objects

 
      		 [bookmark: pgfId-902544]Policy Object Manager

 
     

 
     [bookmark: pgfId-902546]Field Reference

 
     [bookmark: pgfId-902549] 

 
      
       
        
        [bookmark: pgfId-896748]Table 6-7 [bookmark: 16109]AAA Server Dialog Box—General Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-896754]Element
          
  
         		
           
           [bookmark: pgfId-896756]Description
          
  
        

 
         
         		[bookmark: pgfId-896762]Name

  
         		[bookmark: pgfId-896767]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
        

 
         
         		[bookmark: pgfId-896773]Description

  
         		[bookmark: pgfId-896775]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-896781]Host

  
         		[bookmark: pgfId-896783]The address of the AAA server to which authentication requests will be sent. Specify one of the following:

 
           
           		 [bookmark: pgfId-896785]IP Address—The IP address of the AAA server. You can also enter the name of a network/host object that contains the host IP address, or click  Select to select the object.

 
           		 [bookmark: pgfId-896787]DNS Name (for PIX/ASA 7.2+ devices only)—The DNS hostname of the AAA server, up to 128 characters. The hostname can contain alphanumeric characters and hyphens, but each element of the hostname must begin and end with an alphanumeric character.

 
          

  
        

 
         
         		[bookmark: pgfId-896793]Interface

  
         		[bookmark: pgfId-896795]The interface whose IP address should be used for all outgoing RADIUS or TACACS packets (known as the source interface). Enter the name of an interface or interface role, or click Select to select it from a list or to create a new interface role.

 [bookmark: pgfId-896797]Tips

 
           
           		 [bookmark: pgfId-896799]If you enter the name of an interface, make sure the policy that uses this AAA object is assigned to a device containing an interface with this name.

 
           		 [bookmark: pgfId-896801]If you enter the name of an interface role, make sure the role represents a single interface, not multiple interfaces.

 
           		 [bookmark: pgfId-896806]Only one source interface can be defined for the AAA servers in a AAA server group. An error is displayed when you submit your changes if different AAA servers in the group use different source interfaces. See Creating AAA Server Group Objects.

 
           		 [bookmark: pgfId-896808]You cannot specify an interface name for a AAA server used on an IPS device.

 
          

  
        

 
         
         		[bookmark: pgfId-896814]Timeout

  
         		[bookmark: pgfId-896816]The amount of time to wait for a response to a request until the AAA server is considered unresponsive. If there are other servers in the group, the next server is tried.

 
           
           		 [bookmark: pgfId-896818]Cisco IOS routers—The range is 1-1000 seconds. The default is 5 seconds.

 
           		 [bookmark: pgfId-896820]ASA/PIX 7.x+, FWSM 3.1+ devices—The range is 1-300 seconds. The default is 10 seconds.

 
           		 [bookmark: pgfId-896822]PIX 6.3 firewalls—The range is 1-512 seconds. The default is 5 seconds.

 
           		 [bookmark: pgfId-896824]IPS devices—The range is 1-512 seconds. The default is 3 seconds.

 
          

  
        

 
         
         		[bookmark: pgfId-896830]Protocol

  
         		[bookmark: pgfId-896832]The protocol used by the AAA server. The fields below the protocol list change depending on your selection.

 [bookmark: pgfId-896834]For specific information about the fields, see the topics indicated.

 
           
           		 [bookmark: pgfId-896836]The following protocols are the most common:

 
          

 [bookmark: pgfId-896841] – RADIUS—All device types. See AAA Server Dialog Box—RADIUS Settings.

 [bookmark: pgfId-896846] – TACACS+—All device types except IPS. See AAA Server Dialog Box—TACACS+ Settings.

 
           
           		 [bookmark: pgfId-896848]The following protocols are supported for ASA/PIX 7.x+ and FWSM 3.1+ devices; LDAP is supported on IOS devices that support ScanSafe policies:

 
          

 [bookmark: pgfId-896853] – Kerberos—See AAA Server Dialog Box—Kerberos Settings.

 [bookmark: pgfId-896858] – LDAP—See AAA Server Dialog Box—LDAP Settings.

 [bookmark: pgfId-896863] – NT—See AAA Server Dialog Box—NT Settings.

 [bookmark: pgfId-896868] – SDI—See AAA Server Dialog Box—SDI Settings.

 [bookmark: pgfId-896873] – HTTP-FORM—See AAA Server Dialog Box—HTTP-FORM Settings.

  
        

 
         
         		[bookmark: pgfId-896879]Category

  
         		[bookmark: pgfId-896884]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-902563][bookmark: 16213][bookmark: pobjpage_cncpt_AAAServerDialogBoxRADIUSSettings]AAA Server Dialog Box—RADIUS Settings [bookmark: marker-902555][bookmark: marker-902557][bookmark: marker-902559][bookmark: marker-902561]

 
     [bookmark: pgfId-902565]Use the RADIUS settings in the AAA Server dialog box to configure a RADIUS AAA server object.

 
     [bookmark: pgfId-902567]Navigation Path

 
     [bookmark: pgfId-902572]Go to the Add or Edit AAA Server Dialog Box and select RADIUS in the Protocol field.

 
     [bookmark: pgfId-902574]Related Topics

 
      
      		 [bookmark: pgfId-902579]Creating AAA Server Objects

 
      		 [bookmark: pgfId-902584]Understanding AAA Server and Server Group Objects

 
      		 [bookmark: pgfId-902589]AAA Server Group Dialog Box

 
     

 
     [bookmark: pgfId-902591]Field Reference

 
     [bookmark: pgfId-902594] 

 
      
       
        
        [bookmark: pgfId-896897]Table 6-8 [bookmark: 16250]AAA Server Dialog Box—RADIUS Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-896903]Element
          
  
         		
           
           [bookmark: pgfId-896905]Description
          
  
        

 
         
         		[bookmark: pgfId-896911]Key

 [bookmark: pgfId-896913]Confirm

  
         		[bookmark: pgfId-896915]The shared secret that is used to encrypt data between the network device (client) and AAA server. The key is a case-sensitive, alphanumeric string of up to 127 characters. Special characters are permitted.

 [bookmark: pgfId-896917]The key you define in this field must match the key on the RADIUS server. Enter the key again in the Confirm field.

 [bookmark: pgfId-896919]Note the following:

 
           
           		 [bookmark: pgfId-896921]A key is required for AAA server objects used in an IPS AAA policy. Otherwise, the key is optional.

 
           		 [bookmark: pgfId-896923]Spaces are not permitted on PIX, ASA, or FWSM devices. Otherwise, they are permitted.

 
           		 [bookmark: pgfId-896925]If you do not define a key, all traffic between the AAA server and its AAA clients is sent unencrypted.

 
          

  
        

 
         
         		[bookmark: pgfId-896931]Authentication/Authorization Port

  
         		[bookmark: pgfId-896933]The port on which AAA authentication and authorization are performed. The default is 1645.

 [bookmark: pgfId-896935]Tip The default port for IPS devices is 1812, so you need to change this value if you are configuring the object for IPS and you want to use the default port.  
        

 
         
         		[bookmark: pgfId-896941]Accounting Port

  
         		[bookmark: pgfId-896943]The port on which AAA accounting is performed. The default is 1646.

  
        

 
         
         		[bookmark: pgfId-896949]RADIUS Password

 [bookmark: pgfId-896951]Confirm

 [bookmark: pgfId-896953](ASA, PIX 7.x+, and FWSM 3.x+ devices only.)

  
         		[bookmark: pgfId-896955]A case-sensitive, alphanumeric keyword of up to 127 characters that is common among users who access this RADIUS authorization server through this device. Enter the password again in the Confirm field.

 [bookmark: pgfId-896957]The RADIUS authorization server requires a password and username for each connecting user. The RADIUS server administrator must configure the RADIUS server to associate this password with each user authorizing to the server through this device. Be sure to provide this information to your RADIUS server administrator.

 [bookmark: pgfId-896959]If you do not specify a common user password, each user password is the username.

 [bookmark: pgfId-896961]Never use a RADIUS authorization server for authentication. Common passwords or usernames as passwords are less secure than assigning unique user passwords.

 [bookmark: pgfId-896963]Tips

 
           
           		 [bookmark: pgfId-896965]The password applies to authorization servers only, not to authentication servers. For an authentication RADIUS servers, do not configure a common password.

 
           		 [bookmark: pgfId-896967]Although the password is required by the RADIUS protocol and the RADIUS server for authorization, users do not need to know it. The device provides the password automatically.

 
          

  
        

 
         
         		[bookmark: pgfId-896973]Retry Interval

 [bookmark: pgfId-896975](ASA, PIX 7.x+, and FWSM 3.x+ devices only.)

  
         		[bookmark: pgfId-896977]The interval between attempts to contact the AAA server. Values are:

 
           
           		 [bookmark: pgfId-896979]ASA/FWSM devices—1 to 10 seconds.

 
           		 [bookmark: pgfId-896981]PIX devices—1 to 5 seconds.

 
          

  
        

 
         
         		[bookmark: pgfId-896987]ACL Netmask Convert

 [bookmark: pgfId-896989](ASA, PIX 7.x+, and FWSM 3.x+ devices only.)

  
         		[bookmark: pgfId-896991]The method for handling the netmask expressions that are contained in downloadable ACLs received from the RADIUS server. The ASA/PIX/FWSM expects downloadable ACLs to contain standard netmask expressions whereas devices using Cisco IOS Software expect downloadable ACLs to contain wildcard netmask expressions, which are the reverse of a standard netmask expression. A wildcard mask has ones in bit positions to ignore, zeros in bit positions to match. Translation of wildcard netmask expressions means that downloadable ACLs written for Cisco IOS routers can be used by ASA/PIX/FWSM devices without altering the configuration of the ACLs on the RADIUS server.

 [bookmark: pgfId-896993]Select one of the following options:

 
           
           		 [bookmark: pgfId-896995]Standard—The security appliance assumes that all downloadable ACLs received from the RADIUS server contain only standard netmask expressions. No translation from wildcard netmask expressions is performed. This is the default.

 
           		 [bookmark: pgfId-896997]Auto-Detect—The security appliance tries to determine the type of netmask expression used in the downloadable ACL. If it detects a wildcard netmask expression, it converts it to a standard netmask expression.

 
          

 [bookmark: pgfId-896999]This option is useful when you are uncertain how the RADIUS server is configured; however, wildcard netmask expressions with holes in them cannot be unambiguously detected and converted. For example, the wildcard netmask 0.0.255.0 permits anything in the third octet, but the device might not detect this expression as a wildcard netmask.

 
           
           		 [bookmark: pgfId-897001]Wildcard—The security appliance assumes that all downloadable ACLs received from the RADIUS server contain only wildcard netmask expressions, which it converts to standard netmask expressions.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-902608][bookmark: 16330][bookmark: pobjpage_cncpt_AAAServerDialogBoxTACACSSettings]AAA Server Dialog Box—TACACS+ Settings [bookmark: marker-902600][bookmark: marker-902602][bookmark: marker-902604][bookmark: marker-902606]

 
     [bookmark: pgfId-902610]Use the TACACS+ settings in the AAA Server dialog box to configure a TACACS+ AAA server object.

 
     [bookmark: pgfId-902612]Navigation Path

 
     [bookmark: pgfId-902617]Go to the Add or Edit AAA Server Dialog Box and select TACACS+ in the Protocol field.

 
     [bookmark: pgfId-902619]Related Topics

 
      
      		 [bookmark: pgfId-902624]Creating AAA Server Objects

 
      		 [bookmark: pgfId-902629]Understanding AAA Server and Server Group Objects

 
      		 [bookmark: pgfId-902634]AAA Server Group Dialog Box

 
     

 
     [bookmark: pgfId-902636]Field Reference

 
     [bookmark: pgfId-902639] 

 
      
       
        
        [bookmark: pgfId-897014]Table 6-9 [bookmark: 16367]AAA Server Dialog Box—TACACS+ Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-897020]Element
          
  
         		
           
           [bookmark: pgfId-897022]Description
          
  
        

 
         
         		[bookmark: pgfId-897028]Key

 [bookmark: pgfId-897030]Confirm

  
         		[bookmark: pgfId-897032]The shared secret that is used to encrypt data between the client and the AAA server. The key is a case-sensitive, alphanumeric string of up to 127 characters (U.S. English). Spaces and special characters are permitted.

 [bookmark: pgfId-897034]The key you define in this field must match the key on the TACACS+ server. Enter the key again in the Confirm field.

 [bookmark: pgfId-897036]Note the following:

 
           
           		 [bookmark: pgfId-897038]Activity validation fails if you try defining a key with a space on a PIX, ASA, or FWSM device.

 
           		 [bookmark: pgfId-897040]If you do not define a key, all traffic between the AAA server and its AAA clients is sent unencrypted.

 
          

  
        

 
         
         		[bookmark: pgfId-897046]Server Port

  
         		[bookmark: pgfId-897048]The port used for communicating with the AAA server. The default is 49.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-902653][bookmark: 16396][bookmark: pobjpage_cncpt_AAAServerDialogBoxKerberosSettings]AAA Server Dialog Box—Kerberos Settings [bookmark: marker-902645][bookmark: marker-902647][bookmark: marker-902649][bookmark: marker-902651]

 
     [bookmark: pgfId-902655]Use the Kerberos settings in the AAA Server dialog box to configure a Kerberos AAA server object.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-902657]Note This type of AAA server can be configured only on ASA, PIX 7.x+, and FWSM 3.1+ devices.


     
      

     

     

 
     [bookmark: pgfId-902659]Navigation Path

 
     [bookmark: pgfId-902664]Go to the Add or Edit AAA Server Dialog Box and select Kerberos in the Protocol field.

 
     [bookmark: pgfId-902666]Related Topics

 
      
      		 [bookmark: pgfId-902671]Creating AAA Server Objects

 
      		 [bookmark: pgfId-902676]Understanding AAA Server and Server Group Objects

 
      		 [bookmark: pgfId-902681]AAA Server Group Dialog Box

 
     

 
     [bookmark: pgfId-902683]Field Reference

 
     [bookmark: pgfId-902686] 

 
      
       
        
        [bookmark: pgfId-897061]Table 6-10 [bookmark: 16434]AAA Server Dialog Box—Kerberos Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-897067]Element
          
  
         		
           
           [bookmark: pgfId-897069]Description
          
  
        

 
         
         		[bookmark: pgfId-897075]Server Port

  
         		[bookmark: pgfId-897077]The port used for communicating with the AAA server. The default is 88.

  
        

 
         
         		[bookmark: pgfId-897083]Kerberos Realm Name

  
         		[bookmark: pgfId-897085]The name of the realm containing the Kerberos authentication server and ticket granting server (maximum of 64 characters, typically all uppercase). For example, EXAMPLE.COM.

  
        

 
         
         		[bookmark: pgfId-897091]Retry Interval

  
         		[bookmark: pgfId-897093]The interval between attempts to contact the AAA server. Values range from 1 to 10 seconds.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-902702][bookmark: 16460][bookmark: pobjpage_cncpt_AAAServerDialogBoxLDAPSettings]AAA Server Dialog Box—LDAP Settings [bookmark: marker-902694][bookmark: marker-902696][bookmark: marker-902698][bookmark: marker-902700]

 
     [bookmark: pgfId-902704]Use the LDAP settings in the AAA Server dialog box to configure an LDAP AAA server object.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-902706]Note This type of AAA server can be configured only on ASA, PIX 7.x+, FWSM 3.1+, and IOS devices.


     
      

     

     

 
     [bookmark: pgfId-902708]Navigation Path

 
     [bookmark: pgfId-902713]Go to the Add or Edit AAA Server Dialog Box and select LDAP in the Protocol field.

 
     [bookmark: pgfId-902715]Related Topics

 
      
      		 [bookmark: pgfId-902720]Creating AAA Server Objects

 
      		 [bookmark: pgfId-902725]Understanding AAA Server and Server Group Objects

 
      		 [bookmark: pgfId-902730]AAA Server Group Dialog Box

 
     

 
     [bookmark: pgfId-902732]Field Reference

 
     [bookmark: pgfId-902735] 

 
      
       
        
        [bookmark: pgfId-897106]Table 6-11 [bookmark: 16499]AAA Server Dialog Box—LDAP Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-897112]Element
          
  
         		
           
           [bookmark: pgfId-897114]Description
          
  
        

 
         
         		[bookmark: pgfId-897120]Enable LDAP over SSL/Secure Communication

  
         		[bookmark: pgfId-897122]Whether to establish a secure SSL connection between the device and the LDAP server.

 [bookmark: pgfId-897124]Tip You must select this option when using a Microsoft Active Directory LDAP server in order to enable password management.  
        

 
         
         		[bookmark: pgfId-897130]No Negotiation

 [bookmark: pgfId-897132](IOS only.)

  
         		[bookmark: pgfId-897134]When selected, this checkbox precludes further negotiation and moves to accept the channels previously established and accepted.

  
        

 
         
         		[bookmark: pgfId-897140]Server Port

  
         		[bookmark: pgfId-897142]The port used for communicating with the AAA server. The default is 389.

  
        

 
         
         		[bookmark: pgfId-897148]Login Directory

  
         		[bookmark: pgfId-897150]The name of the username or directory object in the LDAP hierarchy used for authenticated binding (maximum of 128 characters). Authenticated binding is required by some LDAP servers (including the Microsoft Active Directory server) before other LDAP operations can be performed. This field describes the authentication characteristics of the device. These characteristics should correspond to those of a user with administrator privileges.

 [bookmark: pgfId-897152]This string is case-sensitive. Spaces are not permitted in the string, but other special characters are allowed.

 [bookmark: pgfId-897154]Typically, this is a username such as DOMAIN\Administrator. However, you can use the more traditional format too, for example, cn=Administrator,OU=Employees,DN=example,DN=com.

  
        

 
         
         		[bookmark: pgfId-897160]Login Password

  
         		[bookmark: pgfId-897162]The case-sensitive, alphanumeric password for accessing the LDAP server (maximum of 64 characters). Spaces are not allowed.

  
        

 
         
         		[bookmark: pgfId-897168]Encrypted (IOS)

  
         		[bookmark: pgfId-897170]Whether the login password is encrypted.

  
        

 
         
         		[bookmark: pgfId-897176]LDAP Hierarchy Location

  
         		[bookmark: pgfId-897178]The base distinguished name (DN), which is the location in the LDAP hierarchy where the authentication server should being searching when it receives an authorization request. For example, OU=Cisco. The maximum length is 128 characters.

 [bookmark: pgfId-897180]The string is case-sensitive. Spaces are not permitted, but other special characters are allowed.

  
        

 
         
         		 
           
           [bookmark: pgfId-897186]PIX/ASA/FWSM Tab
          
  
        

 
         
         		[bookmark: pgfId-897194]LDAP Scope

  
         		[bookmark: pgfId-897196]The extent of the search the server should make in the LDAP hierarchy when it receives an authorization request. The available options are:

 
           
           		 [bookmark: pgfId-897198]onelevel—Searches only one level beneath the base DN. This type of search scope is faster than a subtree search, because it is less comprehensive. This is the default.

 
           		 [bookmark: pgfId-897200]subtree—Searches all levels beneath the base DN (that is, searches the entire subtree hierarchy). This option takes more time.

 
          

  
        

 
         
         		[bookmark: pgfId-897206]LDAP Distinguished Name

  
         		[bookmark: pgfId-897208]The Relative Distinguished Name attribute (or attributes) that uniquely identifies an entry on the LDAP server. Common naming attributes are Common Name (CN), sAMAccountName, userPrincipalName, and User ID (uid). The case-sensitive, alphanumeric string can be up to 128 characters. Spaces are not permitted in the string, but other special characters are allowed.

  
        

 
         
         		[bookmark: pgfId-897214]SASL MD5 Authentication

 [bookmark: pgfId-897216]SASL Kerberos Authentication

 [bookmark: pgfId-897218]Kerberos Server Group

  
         		[bookmark: pgfId-897220]These options establish a Simple Authentication and Security Layer (SASL) mechanism to authenticate an LDAP client (the ASA/PIX/FWSM device) with an LDAP server. If you do not select one of these options, the simple mechanism is used, and usernames and passwords are transmitted in clear text.

 [bookmark: pgfId-897222]You can define one or both SASL authentication mechanisms. When negotiating SASL authentication, the ASA/PIX/FWSM device retrieves the list of SASL mechanisms configured on the LDAP server and selects the strongest mechanism configured on both devices.

 
           
           		 [bookmark: pgfId-897224]SASL MD5 Authentication—Whether to have the device send the LDAP server an MD5 value computed from the username and password. You must configure the LDAP server to store the user passwords in reversible manner, or the LDAP server will not be able to validate the passwords.

 
           		 [bookmark: pgfId-897226]SASL Kerberos Authentication—Whether to have the device send the LDAP server the username and realm using the GSSAPI (Generic Security Services Application Programming Interface) Kerberos mechanism. This mechanism is stronger than the MD5 mechanism.

 
          

 [bookmark: pgfId-897228]If you select Kerberos, you must also enter the name of the Kerberos AAA server group used for SASL authentication. The maximum length is 16 characters.

  
        

 
         
         		[bookmark: pgfId-897234]LDAP Server Type

  
         		[bookmark: pgfId-897236]The type of LDAP server used for AAA:

 
           
           		 [bookmark: pgfId-897238]Auto-Detect—The ASA/PIX/FWSM device tries to determine the server type automatically. This is the default.

 
           		 [bookmark: pgfId-897240]Microsoft—The LDAP server is a Microsoft Active Directory server.

 
          

 [bookmark: pgfId-897242]Note You must configure LDAP over SSL to enable password management with Microsoft Active Directory.

 
           
           		 [bookmark: pgfId-897244]Sun—The LDAP server is a Sun Microsystems JAVA System Directory Server.

 
           		 [bookmark: pgfId-897246]OpenLDAP—The server is an Open LDAP server. You can use this only with ASA/PIX 8.0+ devices.

 
           		 [bookmark: pgfId-897248]Novell—The server is a Novell LDAP server. You can use this only with ASA/PIX 8.0+ devices.

 
          

  
        

 
         
         		[bookmark: pgfId-897254]LDAP Attribute Map

  
         		[bookmark: pgfId-897256]The LDAP attribute configuration to bind to the LDAP server. Enter the name of an LDAP attribute map policy object or click Select to select it from a list or to create a new object.

 [bookmark: pgfId-897261]LDAP attribute maps take the attribute names that you define and map them to Cisco-defined attributes. For more information, see Add and Edit LDAP Attribute Map Dialog Boxes.

  
        

 
         
         		[bookmark: pgfId-897267]Group Base DN

  
         		[bookmark: pgfId-897269](Microsoft LDAP AD servers only.) The base designated name (DN) under which all user groups are defined. When the ASA contacts the AD server for user group membership, the search starts at this DN. All groups must reside under this DN in the LDAP directory hierarchy and no group can reside outside of this path, or the group will not be found. Specifying this location can decrease the time required to complete user group searches.

 [bookmark: pgfId-897271]The alphanumeric string is case-sensitive and can be up to 128 characters. Spaces are not permitted in the string, but other special characters are allowed.

 [bookmark: pgfId-897273]For example:

 [bookmark: pgfId-897275]DN=cisco,DN=com

 [bookmark: pgfId-897277]Tip If you do not specify the group base DN, the LDAP Distinguished Name setting is used as the starting point for group searches.  
        

 
         
         		[bookmark: pgfId-897283]Group Search Timeout

  
         		[bookmark: pgfId-897285](Microsoft LDAP AD servers only.) The maximum time to wait for a response from an Active Directory server queried for user group information, in seconds. The default is 10 seconds, the range is 1 to 300 seconds.

  
        

 
         
         		 
           
           [bookmark: pgfId-897291]IOS Tab
          
  
        

 
         
         		[bookmark: pgfId-897299]Secure Cipher

  
         		[bookmark: pgfId-897301]The encryption method to be used.

  
        

 
         
         		[bookmark: pgfId-897307]Attribute Map (IOS)

  
         		[bookmark: pgfId-897309]The name of the IOS attribute map the server employs.

  
        

 
         
         		[bookmark: pgfId-897315]Secure Trust Point

  
         		[bookmark: pgfId-897317]The name of a trust point for certificates.

  
        

 
         
         		[bookmark: pgfId-897323]Authentication bind-first

  
         		[bookmark: pgfId-897325]You can configure the sequence of search and bind of an authentication request with this option. The default is search first and then bind.

  
        

 
         
         		[bookmark: pgfId-897331]No Authorization Required

  
         		[bookmark: pgfId-897333]No authorization required for authentication requests.

  
        

 
         
         		[bookmark: pgfId-897339]Authentication Compare

  
         		[bookmark: pgfId-897341]Select this checkbox to replace the bind request with compare request for authentication. By default authentication request is performed with bind request.

  
        

 
         
         		[bookmark: pgfId-897347]User Object Filter

  
         		[bookmark: pgfId-897349]Specify the search filter user attribute type to be used in a search request. This helps in filtering out the requested user being searched.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-902749][bookmark: 16663][bookmark: pobjpage_cncpt_AAAServerDialogBoxNTSettings]AAA Server Dialog Box—NT Settings [bookmark: marker-902741][bookmark: marker-902743][bookmark: marker-902745][bookmark: marker-902747]

 
     [bookmark: pgfId-902751]Use the NT settings in the AAA Server dialog box to configure an NT AAA server object.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-902753]Note This type of AAA server can be configured only on ASA, PIX 7.x+, and FWSM 3.1+ devices.


     
      

     

     

 
     [bookmark: pgfId-902755]Navigation Path

 
     [bookmark: pgfId-902760]Go to the Add or Edit AAA Server Dialog Box and select NT in the Protocol field.

 
     [bookmark: pgfId-902762]Related Topics

 
      
      		 [bookmark: pgfId-902767]Creating AAA Server Objects

 
      		 [bookmark: pgfId-902772]Understanding AAA Server and Server Group Objects

 
      		 [bookmark: pgfId-902777]AAA Server Group Dialog Box

 
     

 
     [bookmark: pgfId-902779]Field Reference

 
     [bookmark: pgfId-902782] 

 
      
       
        
        [bookmark: pgfId-897362]Table 6-12 [bookmark: 16701]AAA Server Dialog Box—NT Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-897368]Element
          
  
         		
           
           [bookmark: pgfId-897370]Description
          
  
        

 
         
         		[bookmark: pgfId-897376]Server Port

  
         		[bookmark: pgfId-897378]The port used for communicating with the AAA server. The default is 139.

  
        

 
         
         		[bookmark: pgfId-897384]NT Authentication Host

  
         		[bookmark: pgfId-897386]The name of the authentication domain controller hostname (maximum of 16 characters).

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-902796][bookmark: 16722][bookmark: pobjpage_cncpt_AAAServerDialogBoxSDISettings]AAA Server Dialog Box—SDI Settings [bookmark: marker-902788][bookmark: marker-902790][bookmark: marker-902792][bookmark: marker-902794]

 
     [bookmark: pgfId-902798]Use the SDI settings in the AAA Server dialog box to configure an SDI AAA server object.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-902800]Note This type of AAA server can be configured only on ASA, PIX 7.x+, and FWSM 3.1+ devices.


     
      

     

     

 
     [bookmark: pgfId-902802]Navigation Path

 
     [bookmark: pgfId-902807]Go to the Add or Edit AAA Server Dialog Box and select SDI in the Protocol field.

 
     [bookmark: pgfId-902809]Related Topics

 
      
      		 [bookmark: pgfId-902814]Creating AAA Server Objects

 
      		 [bookmark: pgfId-902819]Understanding AAA Server and Server Group Objects

 
      		 [bookmark: pgfId-902824]AAA Server Group Dialog Box

 
     

 
     [bookmark: pgfId-902826]Field Reference

 
     [bookmark: pgfId-902829] 

 
      
       
        
        [bookmark: pgfId-897399]Table 6-13 [bookmark: 16760]AAA Server Dialog Box—SDI Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-897405]Element
          
  
         		
           
           [bookmark: pgfId-897407]Description
          
  
        

 
         
         		[bookmark: pgfId-897413]Server Port

  
         		[bookmark: pgfId-897415]The port used for communicating with the AAA server. The default is 5500.

  
        

 
         
         		[bookmark: pgfId-897421]Retry Interval

  
         		[bookmark: pgfId-897423]The interval between attempts to contact the AAA server. Values range from 1 to 10 seconds. The default is 10 seconds.

  
        

 
         
         		[bookmark: pgfId-897429]SDI Server Version

  
         		[bookmark: pgfId-897431]The SDI server version:

 
           
           		 [bookmark: pgfId-897433]SDI-pre-5—All SDI versions before version 5.0

 
           		 [bookmark: pgfId-897435]SDI-5—SDI version 5.0 or later.

 
          

  
        

 
         
         		[bookmark: pgfId-897441]SDI pre-5 Slave Server

  
         		[bookmark: pgfId-897443](Optional) A secondary server to be used for authentication if the primary server fails when using an SDI version prior to 5.0. Enter the IP address or the name of a network/host object, or click Select to select an object or create a new one.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-902843][bookmark: 16797][bookmark: pobjpage_cncpt_AAAServerDialogBoxHTTPFORMSettings]AAA Server Dialog Box—HTTP-FORM Settings [bookmark: marker-902835][bookmark: marker-902837][bookmark: marker-902839][bookmark: marker-902841]

 
     [bookmark: pgfId-902845]Use the HTTP-FORM settings in the AAA Server dialog box to configure an HTTP-Form AAA server object for single sign-on authentication (SSO).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-902847]Note This type of AAA server can be configured only on ASA, PIX 7.x+, and FWSM 3.1+ devices.


     
      

     

     

 
     [bookmark: pgfId-902849]Navigation Path

 
     [bookmark: pgfId-902854]Go to the Add or Edit AAA Server Dialog Box and select HTTP-FORM in the Protocol field.

 
     [bookmark: pgfId-902856]Related Topics

 
      
      		 [bookmark: pgfId-902861]Creating AAA Server Objects

 
      		 [bookmark: pgfId-902866]Understanding AAA Server and Server Group Objects

 
      		 [bookmark: pgfId-902871]AAA Server Group Dialog Box

 
     

 
     [bookmark: pgfId-902873]Field Reference

 
     [bookmark: pgfId-902876] 

 
      
       
        
        [bookmark: pgfId-897456]Table 6-14 [bookmark: 16835]AAA Server Dialog Box—HTTP-Form Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-897462]Element
          
  
         		
           
           [bookmark: pgfId-897464]Description
          
  
        

 
         
         		[bookmark: pgfId-897470]Start URL

  
         		[bookmark: pgfId-897472]The URL from which the WebVPN server of the security appliance should retrieve an optional pre-login cookie. The maximum URL length is 1024 characters.

 [bookmark: pgfId-897474]The authenticating web server might execute a pre-login sequence by sending a Set-Cookie header along with the login page content. The URL in this field defines the location from which the cookie is retrieved.

 [bookmark: pgfId-897476]Note The actual login sequence starts after the pre-login cookie sequence.

  
        

 
         
         		[bookmark: pgfId-897482]Action URI

  
         		[bookmark: pgfId-897484]The Uniform Resource Identifier (URI) that defines the location and name of the authentication program on the web server to which the security appliance sends HTTP POST requests for single sign-on (SSO) authentication.

 [bookmark: pgfId-897486]The maximum length of the action URI is 2048 characters.

 [bookmark: pgfId-897488]Tip You can discover the action URI on the authenticating web server by connecting to the web server’s login page directly with a browser. The URL of the login web page displayed in your browser is the action URI for the authenticating web server.  
        

 
         
         		[bookmark: pgfId-897494]Username Parameter

  
         		[bookmark: pgfId-897496]The name of the username parameter included in HTTP POST requests for SSO authentication. The maximum length is 128 characters.

 [bookmark: pgfId-897498]At login, the user enters the actual name value, which is entered into the HTTP POST request and passed on to the authenticating web server.

  
        

 
         
         		[bookmark: pgfId-897504]Password Parameter

  
         		[bookmark: pgfId-897506]The name of the password parameter included in HTTP POST requests for SSO authentication. The maximum length is 128 characters.

 [bookmark: pgfId-897508]At login, the user enters the actual password value, which is entered into the HTTP POST request and passed on to the authenticating web server.

  
        

 
         
         		[bookmark: pgfId-897514]Hidden Values

  
         		[bookmark: pgfId-897516]The hidden parameters included in HTTP POST requests for SSO authentication. They are referred to as hidden parameters because, unlike the username and password, they are not visible to the user.

 [bookmark: pgfId-897518]The maximum length of the hidden parameters is 2048 characters.

 [bookmark: pgfId-897520]Tip You can discover the hidden parameters that the authenticating web server expects in POST requests by using an HTTP header analyzer on a form received from the web server.  
        

 
         
         		[bookmark: pgfId-897526]Authentication Cookie Name

  
         		[bookmark: pgfId-897528]The name of the authentication cookie used for SSO by the security appliance. The maximum length is 128 characters.

 [bookmark: pgfId-897530]If SSO authentication succeeds, the authenticating web server passes this authentication cookie to the client browser. The client browser then authenticates to other web servers in the SSO domain by presenting this cookie.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-902894][bookmark: 16886][bookmark: pobjpage_cncpt_AddandEditLDAPAttributeMapDialogBoxes]Add and Edit LDAP Attribute Map Dialog Boxes[bookmark: marker-902884][bookmark: marker-902886][bookmark: marker-902888][bookmark: marker-902890][bookmark: marker-902892]

 
     [bookmark: pgfId-902896]Use the Add and Edit LDAP (Lightweight Directory Access Protocol) Attribute Map dialog boxes to populate the attribute map with name mappings that translate Cisco LDAP attribute names to custom, user-defined attribute names.

 
     [bookmark: pgfId-902898]If you are introducing a security appliance to an existing LDAP directory, your existing custom LDAP attribute names and values are probably different from the Cisco attribute names and values. Rather than renaming your existing attributes, you can create LDAP attribute maps that map your custom attribute names and values to Cisco attribute names and values. By using simple string substitution, the security appliance then presents you with only your own custom names and values. You can then bind these attribute maps to LDAP servers or remove them as needed. You can also delete entire attribute maps or remove individual name and value entries.

 
     [bookmark: pgfId-902903]For more information regarding LDAP support on ASA, PIX, and FWSM devices, see Additional AAA Support on ASA, PIX, and FWSM Devices.

 
     [bookmark: pgfId-902905]Navigation Path

 
     [bookmark: pgfId-902907]Select Manage > Policy Objects, then select LDAP Attribute Map from the Object Type selector. Right-click inside the table and select New Object, or right-click a row and select Edit Object.

 
     [bookmark: pgfId-902909]Related Topics

 
      
      		 [bookmark: pgfId-902914]Creating AAA Server Objects

 
      		 [bookmark: pgfId-902919]AAA Server Dialog Box—LDAP Settings

 
     

 
     [bookmark: pgfId-902921]Field Reference

 
     [bookmark: pgfId-902924] 

 
      
       
        
        [bookmark: pgfId-897543]Table 6-15 [bookmark: 16927]Add and Edit LDAP Attribute Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-897549]Element
          
  
         		
           
           [bookmark: pgfId-897551]Description
          
  
        

 
         
         		[bookmark: pgfId-897557]Name

  
         		[bookmark: pgfId-897562]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
        

 
         
         		[bookmark: pgfId-897568]Description

  
         		[bookmark: pgfId-897570]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-897576]Attribute Map table

  
         		[bookmark: pgfId-897578]The table shows the mapped values. Each entry shows the customer map name, Cisco map name, and the attribute mapping of customer name to Cisco name.

 
           
           		 [bookmark: pgfId-897583]To add a mapping, click the  Add Row button to open the Add and Edit LDAP Attribute Map Value Dialog Boxes.

 
           		 [bookmark: pgfId-897585]To edit a mapping, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-897587]To delete a mapping, select it and click the  Delete Row button.

 
          

  
        

 
         
         		[bookmark: pgfId-897593]Category

  
         		[bookmark: pgfId-897598]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-897604]Allow Value Override per Device

 [bookmark: pgfId-897606]Overrides

 [bookmark: pgfId-897608]Edit button

  
         		[bookmark: pgfId-897616]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-897618]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-902936][bookmark: 16982][bookmark: pobjpage_cncpt_AddandEditLDAPAttributeMapAddandEditLDAPAttributeMapValue]Add and Edit LDAP Attribute Map Value Dialog Boxes[bookmark: marker-902932][bookmark: marker-902934]

 
     [bookmark: pgfId-902938]Use the Add and Edit LDAP Attribute Map Value dialog boxes to populate the attribute map with value mappings that apply user-defined attribute values to the custom attribute name and to the matching Cisco attribute name and value.

 
     [bookmark: pgfId-902940]Navigation Path

 
     [bookmark: pgfId-902945]From the Add and Edit LDAP Attribute Map Dialog Boxes, click the Add Row button to add a new mapping, or select a row and click the Edit Row button.

 
     [bookmark: pgfId-902947]Field Reference

 
     [bookmark: pgfId-902950] 

 
      
       
        
        [bookmark: pgfId-897631]Table 6-16 [bookmark: 16999]Add and Edit LDAP Attribute Map Value Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-897637]Element
          
  
         		
           
           [bookmark: pgfId-897639]Description
          
  
        

 
         
         		[bookmark: pgfId-897645]Customer Map Name

  
         		[bookmark: pgfId-897647]The name of your attribute map that relates to the Cisco map.

  
        

 
         
         		[bookmark: pgfId-897653]Cisco Map Name

  
         		[bookmark: pgfId-897655]The Cisco attribute map name you want to map to the customer map name.

  
        

 
         
         		[bookmark: pgfId-897661]Customer to Cisco Map Value table

  
         		[bookmark: pgfId-897663]The mappings of customer names to Cisco names.

 
           
           		 [bookmark: pgfId-897668]To add a mapping, click the  Add Row button to open the Add and Edit Map Value Dialog Boxes.

 
           		 [bookmark: pgfId-897670]To edit a mapping, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-897672]To delete a mapping, select it and click the  Delete Row button.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-902962][bookmark: 17036][bookmark: pobjpage_cncpt_AddandEditLDAPAttributeMapAddandEditLDAPAttributeMapValueAddandEditMapValue]Add and Edit Map Value Dialog Boxes [bookmark: marker-902958][bookmark: marker-902960]

 
     [bookmark: pgfId-902964]Use the Add and Edit Map Value dialog boxes to map a customer LDAP attribute value to a Cisco map value. Enter the value from your LDAP map that you want to equate with a Cisco value.

 
     [bookmark: pgfId-902966]Navigation Path

 
     [bookmark: pgfId-902971]From the Add and Edit LDAP Attribute Map Value Dialog Boxes, click the Add Row button to add a new mapping, or select a row and click the Edit Row button.

 
    
 
     
      [bookmark: pgfId-902983][bookmark: 17052][bookmark: obman_proc_CreatingAAAServerGroupObjects]Creating AAA Server Group Objects[bookmark: marker-902977][bookmark: marker-902979][bookmark: marker-902981]

 
     [bookmark: pgfId-902985]You can create AAA server group objects for Security Manager policies requiring AAA services, such as authentication and authorization. Each AAA server group object can contain multiple AAA servers, all of which use the same protocol, such as RADIUS or TACACS+. For example, if you want to use RADIUS to authenticate network access and TACACS+ to authenticate CLI access, you must create at least two AAA server group objects, one for RADIUS servers and one for TACACS+ servers.

 
     [bookmark: pgfId-902987]In addition, only one source interface can be defined for the AAA servers in the group. An error is displayed when you submit your changes if different AAA servers in the group use different source interfaces.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-902989]Note The error is triggered by the actual interface defined as the source, not the name of the interface role that represents the interface. That is, two AAA servers can have different interface roles defined as the source interface as long as they both resolve to the same device interface. An error is also displayed if the interface role defined for the source interface matches more than one actual interface on the device.


     
      

     

     

 
     [bookmark: pgfId-902991]The number of AAA server group objects that can be created and the number of AAA server objects that can be included in each group object depend on the selected platform. For example, ASA devices support up to 18 single-mode server groups (with up to 16 servers each) and 7 multi-mode server groups (with up to 4 servers each). PIX firewalls support up to 14 server groups, each containing up to 14 servers.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-902993]Note Security Manager includes a predefined AAA server group object that you can use when you perform authentication locally inside the Cisco IOS router.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-902998]Tip You can also create AAA server group objects when you define policies or objects that use this object type. For more information, see Selecting Objects for Policies.


     
      

     

     

 
     [bookmark: pgfId-903000]Related Topics

 
      
      		 [bookmark: pgfId-903005]Creating Policy Objects

 
      		 [bookmark: pgfId-903010]Predefined AAA Authentication Server Groups

 
      		 [bookmark: pgfId-903015]Default AAA Server Groups and IOS Devices

 
      		 [bookmark: pgfId-903020]Understanding AAA Server and Server Group Objects

 
     

 
     
 
     [bookmark: pgfId-903025]Step 1 Select Manage > Policy Objects to open the Policy Object Manager (see Policy Object Manager).

 
     [bookmark: pgfId-903027]Step 2 Select AAA Server Groups from the Object Type selector.

 
     [bookmark: pgfId-903032]Step 3 Right-click inside the work area, then select New Object to open the AAA Server Group Dialog Box.

 
     [bookmark: pgfId-903034]Step 4 Enter a name for the object. The maximum name length is 16 characters if you plan to use this object with ASA, PIX, or FWSM devices and 128 characters for Cisco IOS routers. Spaces are not supported.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-903036]Note Cisco IOS routers do not support the following AAA server group names: RADIUS, TACACS, TACACS+. In addition, we do not recommend using an abbreviation of one of these names, such as rad or tac.


     
      

     

     

 
     [bookmark: pgfId-903038]Step 5 Select the protocol to be used by the servers in the group.

 
     [bookmark: pgfId-903040]Step 6 Enter the names of the AAA server policy objects that define the AAA servers to include in the group. Click Select to select the objects from a list filtered by the protocol you selected. You can also create new AAA server objects from the selection list. Separate multiple objects with commas.

 
     [bookmark: pgfId-903042]Step 7 Configure the additional options that you want:

 
      
      		 [bookmark: pgfId-903047]Make this Group the Default AAA Server Group—For IOS devices only, whether you are using this group as the default group. Use this option if you intend to have a single global server group for this protocol for all policies requiring AAA. For more information, see Default AAA Server Groups and IOS Devices.

 
      		 [bookmark: pgfId-903049]ASA 8.4(2+) devices—If you are creating a RADIUS group containing Active Directory agent servers, select  AD Agent Mode . This option indicates that the servers in the group are not full-function RADIUS servers but instead provide AD agent functions for identity-aware firewall. Use this group in the Identity Options policy.

 
      		 [bookmark: pgfId-903054]ASA, PIX, FWSM devices—Select options for how to handle AAA servers that stop responding, and for how to send accounting messages. For more information, see AAA Server Group Dialog Box.

 
     

 
     [bookmark: pgfId-903059]Step 8 (Optional) Under Category, select a category to help you identify this object in the Objects table. See Using Category Objects.

 
     [bookmark: pgfId-903064]Step 9 (Optional) Select Allow Value Override per Device to allow the properties of this object to be redefined on individual devices. See Allowing a Policy Object to Be Overridden.

 
     [bookmark: pgfId-903066]Step 10 Click OK to save the object.

 
     [bookmark: pgfId-903068]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-903086][bookmark: 17131][bookmark: pobjpage_cncpt_AAAServerGroupDialogBox]AAA Server Group Dialog Box[bookmark: marker-903076][bookmark: marker-903078][bookmark: marker-903080][bookmark: marker-903082][bookmark: marker-903084]

 
     [bookmark: pgfId-903088]Use the AAA Server Group dialog box to create, copy, and edit AAA server groups. When defining a policy that uses a AAA server for authentication, authorization, or accounting, you select the server by selecting the server group to which the server belongs.

 
     [bookmark: pgfId-903090]Navigation Path

 
     [bookmark: pgfId-903092]Select Manage > Policy Objects, then select AAA Server Groups from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-903094]Related Topics

 
      
      		 [bookmark: pgfId-903099]Creating AAA Server Group Objects

 
      		 [bookmark: pgfId-903104]Understanding AAA Server and Server Group Objects

 
      		 [bookmark: pgfId-903109]Creating Policy Objects

 
      		 [bookmark: pgfId-903114]Add or Edit AAA Server Dialog Box

 
      		 [bookmark: pgfId-903119]Policy Object Manager

 
     

 
     [bookmark: pgfId-903121]Field Reference

 
     [bookmark: pgfId-903124] 

 
      
       
        
        [bookmark: pgfId-897685]Table 6-17 [bookmark: 17179]AAA Server Group Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-897691]Element
          
  
         		
           
           [bookmark: pgfId-897693]Description
          
  
        

 
         
         		[bookmark: pgfId-897699]Name

  
         		[bookmark: pgfId-897701]The object name (up to 16 characters when using this object with firewall devices; up to 128 characters for Cisco IOS routers). Object names are not case-sensitive. Spaces are not supported.

 [bookmark: pgfId-897703]Consider the following important points:

 
           
           		 [bookmark: pgfId-897705]Cisco IOS routers do not support AAA server groups named RADIUS, TACACS, or TACACS+. In addition, we do not recommend using an abbreviation of one of these names, such as rad or tac.

 
           		 [bookmark: pgfId-897707]If you define this AAA server group as the RADIUS or TACACS+ default group, any name you define here is automatically replaced in the device configuration by the default name (RADIUS or TACACS+) upon deployment.

 
          

  
        

 
         
         		[bookmark: pgfId-897713]Description

  
         		[bookmark: pgfId-897715]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-897721]Protocol

  
         		[bookmark: pgfId-897729]The protocol used by the AAA servers in the group. For more information about these options, see Supported AAA Server Types and Additional AAA Support on ASA, PIX, and FWSM Devices.

  
        

 
         
         		[bookmark: pgfId-897735]AAA Servers

  
         		[bookmark: pgfId-897737]The AAA server policy objects that comprise the server group. Enter the names of the objects or click Select to select them from a list that is filtered to show only those AAA server objects that use the selected protocol. Separate multiple objects with commas. You can also create new objects from the selection list.

  
        

 
         
         		[bookmark: pgfId-897743]Make this Group the Default AAA Server Group (IOS)

 [bookmark: pgfId-897745](IOS devices only.)

  
         		[bookmark: pgfId-897747]Whether to designate this AAA server group as the default group for the RADIUS or TACACS+ protocol. Select this option if you intend to use a single global group for the selected protocol for all policies on a specific device requiring AAA.

 [bookmark: pgfId-897749]Do not select this option if you intend to create multiple RADIUS or TACACS+ AAA server groups. Multiple groups can be used to separate different AAA functions (for example, use one group for authentication and a different group for authorization) or to separate different customers in a VRF environment.

 [bookmark: pgfId-897754]Note When you discover an IOS router, any AAA servers in the device configuration that are not members of a AAA server group are placed in special groups called CSM-rad-grp (for RADIUS) and CSM-tac-grp (for TACACS+), both of which are marked as default groups. These two groups are created solely to enable Security Manager to manage these servers. During deployment, the AAA servers in these special groups are deployed back to the device as individual servers. For more information, see Default AAA Server Groups and IOS Devices.

  
        

 
         
         		[bookmark: pgfId-897760]AD Agent Mode

 [bookmark: pgfId-897762](ASA 8.4(2+) devices only.)

  
         		[bookmark: pgfId-897764]Whether the servers in the group are Active Directory agents, which are used in identity-aware firewall configurations. You must select this option for an AD agent group to indicate that the group is not a full-function RADIUS server group.

 [bookmark: pgfId-897769]Use the AD agent group in the Identity Options policy. For more information, see Identifying Active Directory Servers and Agents.

  
        

 
         
         		[bookmark: pgfId-897775]Dynamic Authorization

 [bookmark: pgfId-897777](ASA 9.2(1+) devices only.)

  
         		[bookmark: pgfId-897779]When using the RADIUS protocol, select the Dynamic Authorization check box to enable the RADIUS Dynamic Authorization Change of Authorization (CoA) services for the AAA server group.

 [bookmark: pgfId-897781]Specify the listening port for RADIUS CoA requests in the Port field. The valid range is 1024 to 65535 and the default value is 1700.

 [bookmark: pgfId-897783]Once defined, the corresponding RADIUS server group will be registered for CoA notification and the ASA will listen to the port for the CoA policy updates from the Cisco Identity Services Engine (ISE).

  
        

 
         
         		[bookmark: pgfId-897789]Interim Account Update

 [bookmark: pgfId-897791](ASA 9.2(1+) devices only.)

  
         		[bookmark: pgfId-897793]When using the RADIUS protocol, select the Interim Account Update check box to enable the generation of RADIUS interim-accounting-update messages. Currently these messages are only generated when a VPN tunnel connection is added to a clientless VPN session. When this happens the accounting update is generated in order to inform the RADIUS server of the newly assigned IP address.

 [bookmark: pgfId-897795]Specify the length, in hours, of the interval between periodic accounting updates in the Interval field. The valid range is 1 to 120 and the default value is 24.

  
        

 
         
         		[bookmark: pgfId-897801]Authorize only

 [bookmark: pgfId-897803](ASA 9.2(1+) devices only.)

  
         		[bookmark: pgfId-897805]When using the RADIUS protocol, select the Authorize only check box to enables authorize-only mode for the RADIUS server group. When this check box is selected, the common password configured for individual AAA servers is not required and does not need to be configured.

  
        

 
         
         		[bookmark: pgfId-897811]Max Failed Attempts

 [bookmark: pgfId-897813](PIX, ASA, FWSM devices only.)

  
         		[bookmark: pgfId-897815]The number of connection failures that will be tolerated for any given server in the server group before that server is deactivated. The default is 3 attempts, the range is 1 to 5.

  
        

 
         
         		[bookmark: pgfId-897821]Reactivation Mode

 [bookmark: pgfId-897823](PIX, ASA, FWSM devices only.)

  
         		[bookmark: pgfId-897825]The method to use when reactivating failed servers in the group:

 
           
           		 [bookmark: pgfId-897827]Depletion—Reactivate failed servers only after all of the servers in the group are inactive. This is the default.

 
          

 [bookmark: pgfId-897829]When a server is deactivated, it remains inactive until all other servers in the group are inactive. When and if this occurs, all servers in the group are reactivated. This approach minimizes the occurrence of connection delays due to failed servers.

 [bookmark: pgfId-897831]If you configured a fallback method using the local database (for management access only) and all the servers in the group fail to respond, then the group is considered to be unresponsive, and the fallback method is tried. You can configure the Reactivation Deadtime value to determine the number of minutes that will elapse between the disabling of the last server in the group and the subsequent re-enabling of all servers.

 [bookmark: pgfId-897833]If you do not have a fallback method, the device continues to retry the servers in the group.

 
           
           		 [bookmark: pgfId-897835]Timed—Reactivate failed servers after 30 seconds of downtime. This option is useful if the first server in the group is the primary server and you prefer that it be used whenever possible rather than the backup servers. This policy breaks down in the case of UDP servers. Because a connection to a UDP server will not fail, even if the server is not present, UDP servers are put back on line blindly. This could lead to slowed connection times or connection failures if a server group contains multiple servers that are not reachable.

 
          

  
        

 
         
         		[bookmark: pgfId-897841]Reactivation Deadtime

 [bookmark: pgfId-897843](PIX, ASA, FWSM devices only.)

  
         		[bookmark: pgfId-897845]When you select Depletion as the reactivation mode, the number of minutes that should elapse between the deactivation of the last server in the group and the reactivation of all the servers in the group. The default is 10, the range is 0 to 1440 minutes (24 hours).

  
        

 
         
         		[bookmark: pgfId-897851]Group Accounting Mode

 [bookmark: pgfId-897853](PIX, ASA, FWSM devices only.)

  
         		[bookmark: pgfId-897855]When using the RADIUS or TACACS+ protocols, the method for sending accounting messages to the AAA servers in the group:

 [bookmark: pgfId-897857]When using the server group for accounting (the protocol must be RADIUS or TACACS+), the method for sending accounting messages to the AAA servers in the group:

 
           
           		 [bookmark: pgfId-897859]Single—Accounting messages are sent to a single server in the group. This is the default.

 
           		 [bookmark: pgfId-897861]Simultaneous—Accounting messages are sent to all servers in the group simultaneously. If you select this option, the ASA forces the use of  Timed as the reactivation mode.

 
          

  
        

 
         
         		[bookmark: pgfId-897867]Category

  
         		[bookmark: pgfId-897872]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-897878]Allow Value Override per Device

 [bookmark: pgfId-897880]Overrides

 [bookmark: pgfId-897882]Edit button

  
         		[bookmark: pgfId-897890]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-897892]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-903136][bookmark: 17317][bookmark: obman_cncpt_CreatingAccessControlListObjects]Creating Access Control List Objects[bookmark: marker-903130][bookmark: marker-903132][bookmark: marker-903134]

 
    [bookmark: pgfId-903138]An Access Control List (ACL) object is made up of one or more access control entries (ACEs), one or more ACL objects, or a combination of both. Each ACE is an individual permit or deny statement within an ACL. You can use ACL policy objects in several other policies and policy objects.

 
    [bookmark: pgfId-903140]You can create the following types of ACL objects:

 
     
     		 [bookmark: pgfId-903145]Extended – Extended ACLs enable you to specify source and destination addresses and service (or traffic protocol), and, based on the protocol type, the ports (for TCP or UDP), or the ICMP type (for ICMP) can be specified. For information on extended ACL objects, see Creating Extended Access Control List Objects.

 
     		 [bookmark: pgfId-903150]Standard – Standard ACLs use the source address for matching traffic. For information on standard ACL objects, see Creating Standard Access Control List Objects.

 
     		 [bookmark: pgfId-903155]Web – Web ACLs use destination address and port or a URL filter. For information on Web Type ACL objects, Creating Web Access Control List Objects.

 
     		 [bookmark: pgfId-903160]Unified – Unified ACL objects let you use source networks/hosts, source security groups, users, destination source networks/hosts, destination security groups, and services to match traffic. Further, the network/host specifications can contain IPv4 addresses, IPv6 addresses, or a combination of both. (With the release of Security Manager 4.4 and the ASA 9.0+, the separate IPv4 and IPv6 addressing/objects were “unified.”) See Creating Unified Access Control List Objects for more information these ACLs.

 
    

 
    [bookmark: pgfId-903165]For reference information about the dialog boxes used with these objects, see Add or Edit Access List Dialog Boxes.

 
     
      [bookmark: pgfId-903177][bookmark: 17347][bookmark: obman_proc_CreatingExtendedAccessControlListObjects]Creating Extended Access Control List Objects[bookmark: marker-903171][bookmark: marker-903173][bookmark: marker-903175]

 
     [bookmark: pgfId-903179]Extended access control lists allow you to permit or deny traffic from specific IP addresses to specific destination IP address and port, and specify the protocol of the traffic, such as ICMP, TCP, UDP, and so forth. Extended ACLs range from 100 to 199, and for devices running Cisco IOS Software Release 12.0.1 and higher, 2000 to 2699.

 
      
       
        
        [bookmark: pgfId-897907]Table 6-18 [bookmark: 17382]Policy Objects and Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-897915]Policy Object
          
  
         		
           
           [bookmark: pgfId-897917]Device
          
  
         		
           
           [bookmark: pgfId-897919]Purpose
          
  
        

 
         
         		[bookmark: pgfId-897927]VPN Topology

  
         		[bookmark: pgfId-897929]Any

  
         		[bookmark: pgfId-897931]Selecting Protected Networks.

  
        

 
         
         		[bookmark: pgfId-897939]ASA User Group

  
         		[bookmark: pgfId-897941]ASA

  
         		[bookmark: pgfId-897943]Inbound Firewall Policy; Outbound Firewall Policy; Filter ACL.

  
        

 
         
         		[bookmark: pgfId-897951]Traffic Flow

  
         		[bookmark: pgfId-897953]ASA, PIX 7+

  
         		[bookmark: pgfId-897955]Service Policy Rules (MPC). The traffic flow BB (class-map) uses Extended ACL as one of its traffic match types.

  
        

 
         
         		[bookmark: pgfId-897963]User Group

  
         		
           
           		 [bookmark: pgfId-897965]IOS

 
           		 [bookmark: pgfId-897967]Catalyst 6500/7600

 
           		 [bookmark: pgfId-897969]PIX 6.3

 
          

  
         		[bookmark: pgfId-897971]For Easy VPN, Split Tunnel ACL and Firewall ACL (IOS devices only).

  
        

 
       
      

 
     
 
     [bookmark: pgfId-903211]Related Topics

 
      
      		 [bookmark: pgfId-903216]Creating Access Control List Objects

 
      		 [bookmark: pgfId-903221]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
      		 [bookmark: pgfId-903226]Creating Policy Objects

 
      		 [bookmark: pgfId-903231]Understanding Networks/Hosts Objects

 
      		 [bookmark: pgfId-903236]Understanding and Specifying Services and Service and Port List Objects

 
     

 
     
 
     [bookmark: pgfId-903241]Step 1 Choose Manage > Policy Objects to open the Policy Object Manager (see Policy Object Manager).

 
     [bookmark: pgfId-903243]Step 2 From the Object Type selector, select Access Control Lists.

 
     [bookmark: pgfId-903245]The Access Control List page appears. The Extended tab is displayed by default.

 
     [bookmark: pgfId-903247]Step 3 Right-click inside the work area, then select New Object.

 
     [bookmark: pgfId-903252]The Add Extended Access List dialog box appears (see Add or Edit Access List Dialog Boxes).

 
     [bookmark: pgfId-903254]Step 4 Enter a name for the object and optionally a description of the object.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1075352]Note Make sure that the name of the ACL Object is unique and is not the same name as the Firewall Rules ACL defined in the Firewall ACL Setting. For more information, see Firewall ACL Setting Dialog Box.


     
      

     

     

 
     [bookmark: pgfId-903256]Step 5 Right-click inside the table in the dialog box, then select Add.

 
     [bookmark: pgfId-903258]The Add Extended Access Control Entry dialog box appears.

 
     [bookmark: pgfId-903260]Step 6 Create the access control entry:

 
      
      		 [bookmark: pgfId-903265]If you choose  Access Control Entry for Type, specify the characteristics of the traffic that you want to match and whether you are permitting or denying the traffic. Enter the source addresses whence the traffic originates, the destination addresses whither the traffic travels, and the services that define the characteristics of the traffic. Click  Advanced to define logging options. For detailed information about the fields on the dialog box, see Add and Edit Extended Access Control Entry Dialog Boxes.

 
      		 [bookmark: pgfId-903267]If you choose  ACL Object , select the object in the available objects list and click  >> to add it to the list of selected objects.

 
     

 
     [bookmark: pgfId-903269]Step 7 Click OK to save your changes.

 
     [bookmark: pgfId-903271]The dialog box closes and you return to the Add Extended Access List page. The new entry is shown in the table. If necessary, select it and click the up or down buttons to position it at the desired location.

 
     [bookmark: pgfId-903276]Step 8 (Optional) Under Category, select a category to help you identify this object in the Objects table. See Using Category Objects.

 
     [bookmark: pgfId-903278]Step 9 Click OK to save the object.

 
     [bookmark: pgfId-903280]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-903292][bookmark: 17491][bookmark: obman_proc_CreatingStandardAccessControlListObjects]Creating Standard Access Control List Objects[bookmark: marker-903286][bookmark: marker-903288][bookmark: marker-903290]

 
     [bookmark: pgfId-903294]A standard access control list allows you to permit or deny traffic from specific IP addresses. The destination of the packet and the ports involved can be anything. Standard IP ACLs range from 1 to 99.

 
     [bookmark: pgfId-903296]Standard ACL example:

 
     
      [bookmark: pgfId-903298]access-list 10 permit 192.168.2.0 0.0.0.255
     

     
      [bookmark: pgfId-903300] 
     

     [bookmark: pgfId-903302]Uses:

 
      
      		 [bookmark: pgfId-903304]Identifying OSPF route redistribution.

 
      		 [bookmark: pgfId-903306]Filtering users of a community string using SNMP.

 
      		 [bookmark: pgfId-903308]Configuring VLAN ACLs for a Catalyst 6500/7600 device.

 
     

 
     [bookmark: pgfId-903310]Related Topics

 
      
      		 [bookmark: pgfId-903315]Creating Access Control List Objects

 
      		 [bookmark: pgfId-903320]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
      		 [bookmark: pgfId-903325]Creating Policy Objects

 
      		 [bookmark: pgfId-903330]Understanding Networks/Hosts Objects

 
     

 
     
 
     [bookmark: pgfId-903335]Step 1 Choose Manage > Policy Objects to open the Policy Object Manager (see Policy Object Manager).

 
     [bookmark: pgfId-903337]Step 2 From the Object Type selector, select Access Control Lists.

 
     [bookmark: pgfId-903339]The Access Control List page appears.

 
     [bookmark: pgfId-903341]Step 3 Click the Standard tab.

 
     [bookmark: pgfId-903343]Step 4 Right-click inside the work area, then select New Object.

 
     [bookmark: pgfId-903348]The Add Standard Access List dialog box appears (see Add or Edit Access List Dialog Boxes).

 
     [bookmark: pgfId-903350]Step 5 Enter a name for the object and optionally a description of the object.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1075385]Note Make sure that the name of the ACL Object is unique and is not the same name as the Firewall Rules ACL defined in the Firewall ACL Setting. For more information, see Firewall ACL Setting Dialog Box.


     
      

     

     

 
     [bookmark: pgfId-903352]Step 6 Right-click inside the table, then select Add.

 
     [bookmark: pgfId-903354]The Add Standard Access Control Entry dialog box appears.

 
     [bookmark: pgfId-903356]Step 7 Create the access control entry:

 
      
      		 [bookmark: pgfId-903361]If you choose  Access Control Entry for Type, specify the characteristics of the traffic that you want to match and whether you are permitting or denying the traffic. Enter the source addresses whence the traffic originates and select logging options. For detailed information about the fields on the dialog box, see Add and Edit Standard Access Control Entry Dialog Boxes.

 
      		 [bookmark: pgfId-903363]If you choose  ACL Object , select the object in the available objects list and click  >> to add it to the list of selected objects.

 
     

 
     [bookmark: pgfId-903365]Step 8 Click OK to save your changes.

 
     [bookmark: pgfId-903367]The dialog box closes and you return to the Add Standard Access List dialog box. The new entry is shown in the table. If necessary, select it and click the up or down buttons to position it at the desired location.

 
     [bookmark: pgfId-903372]Step 9 (Optional) Under Category, select a category to help you identify this object in the Objects table. See Using Category Objects.

 
     [bookmark: pgfId-903374]Step 10 Click OK to save the object.

 
     [bookmark: pgfId-903376]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-903388][bookmark: 17577][bookmark: obman_proc_CreatingWebAccessControlListObjects]Creating Web Access Control List Objects[bookmark: marker-903382][bookmark: marker-903384][bookmark: marker-903386]

 
     [bookmark: pgfId-903390]Web ACLs, also referred to as WebVPN, let you establish a secure, remote-access VPN tunnel to the security appliance using a web browser. There is no need for either a software or hardware client. WebVPN provides easy access to a broad range of web resources and both web-enabled and legacy applications from almost any computer that can reach HTTPS Internet sites. WebVPN uses Secure Socket Layer Protocol and its successor, Transport Layer Security (SSL/TLS1) to provide a secure connection between remote users and specific, supported internal resources that you configure at a central site.

 
     [bookmark: pgfId-903392]The following table presents examples of Web VPN ACLs.

 
     [bookmark: pgfId-903395] 

 
      
       
        
        [bookmark: pgfId-897986]Table 6-19 [bookmark: 17594]Examples of Web VPN ACLs 

 
        
       
         
         		
           
           [bookmark: pgfId-897994]Action
          
  
         		
           
           [bookmark: pgfId-897996]Filter
          
  
         		
           
           [bookmark: pgfId-897998]Effect
          
  
        

 
         
         		[bookmark: pgfId-898006]Deny

  
         		[bookmark: pgfId-898008]url http://*.yahoo.com/

  
         		[bookmark: pgfId-898010]Denies access to all of Yahoo!

  
        

 
         
         		[bookmark: pgfId-898018]Deny

  
         		[bookmark: pgfId-898020]url cifs://fileserver/share/directory

  
         		[bookmark: pgfId-898022]Denies access to all files in the specified location.

  
        

 
         
         		[bookmark: pgfId-898030]Deny

  
         		[bookmark: pgfId-898032]url https://www.company.com/ directory/file.html

  
         		[bookmark: pgfId-898034]Denies access to the specified file.

  
        

 
         
         		[bookmark: pgfId-898042]Permit

  
         		[bookmark: pgfId-898044]url https://www.company.com/directory

  
         		[bookmark: pgfId-898046]Permits access to the specified location

  
        

 
         
         		[bookmark: pgfId-898054]Deny

  
         		[bookmark: pgfId-898056]url http://*:8080/

  
         		[bookmark: pgfId-898058]Denies HTTPS access to anywhere via port 8080.

  
        

 
         
         		[bookmark: pgfId-898066]Deny

  
         		[bookmark: pgfId-898068]url http://10.10.10.10

  
         		[bookmark: pgfId-898070]Denies HTTP access to 10.10.10.10.

  
        

 
         
         		[bookmark: pgfId-898078]Permit

  
         		[bookmark: pgfId-898080]url any

  
         		[bookmark: pgfId-898082]Permits access to any URL. Usually used after an ACL that denies url access.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-903397]Uses:

 
      
      		 [bookmark: pgfId-903399]As a filter ACL in an ASA User Group policy object (under SSL VPN > Clientless).

 
     

 
     [bookmark: pgfId-903401]Related Topics

 
      
      		 [bookmark: pgfId-903406]Creating Access Control List Objects

 
      		 [bookmark: pgfId-903411]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
      		 [bookmark: pgfId-903416]Creating Policy Objects

 
     

 
     
 
     [bookmark: pgfId-903421]Step 1 Choose Manage > Policy Objects to open the Policy Object Manager (see Policy Object Manager).

 
     [bookmark: pgfId-903423]Step 2 From the Object Type selector, select Access Control Lists.

 
     [bookmark: pgfId-903425]The Access Control List page appears.

 
     [bookmark: pgfId-903427]Step 3 Click the Web tab.

 
     [bookmark: pgfId-903429]Step 4 Right-click inside the work area and select New Object.

 
     [bookmark: pgfId-903434]The Add WebType Access List dialog box appears (see Add or Edit Access List Dialog Boxes).

 
     [bookmark: pgfId-903436]Step 5 Enter a name for the object and optionally a description of the object.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1075444]Note Make sure that the name of the ACL Object is unique and is not the same name as the Firewall Rules ACL defined in the Firewall ACL Setting. For more information, see Firewall ACL Setting Dialog Box.


     
      

     

     

 
     [bookmark: pgfId-903438]Step 6 Right-click inside the access control entry table and choose Add.

 
     [bookmark: pgfId-903440]The Add Web Access Control Entry dialog box appears.

 
     [bookmark: pgfId-903442]Step 7 Create the access control entry:

 
      
      		 [bookmark: pgfId-903447]If you choose  Access Control Entry for Type, specify the characteristics of the traffic that you want to match and whether you are permitting or denying the traffic. You can filter based on the network destination of the traffic (Network Filter) or the web address (URL Filter). For detailed information about the fields on the dialog box, see Add and Edit Web Access Control Entry Dialog Boxes.

 
      		 [bookmark: pgfId-903449]If you choose  ACL Object , select the object in the available objects list and click  >> to add it to the list of selected objects.

 
     

 
     [bookmark: pgfId-903451]Step 8 Click OK to save your changes.

 
     [bookmark: pgfId-903453]The dialog box closes and you return to the Add WebType Access List page. The new entry is shown in the table. If necessary, select it and click the up or down buttons to position it at the desired location.

 
     [bookmark: pgfId-903458]Step 9 (Optional) Under Category, select a category to help you identify this object in the Objects table. See Using Category Objects.

 
     [bookmark: pgfId-903460]Step 10 Click OK to save the object.

 
     [bookmark: pgfId-903462]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-903474][bookmark: 17718][bookmark: obman_proc_CreatingUnifiedAccessControlListObjects]Creating Unified Access Control List Objects[bookmark: marker-903468][bookmark: marker-903470][bookmark: marker-903472]

 
     [bookmark: pgfId-903476]A unified access control list allows you to permit or deny traffic from specific networks, hosts, security groups, and users, destined for specific networks, hosts and security groups. You also specify the service(s) involved.

 
     [bookmark: pgfId-903478]Related Topics

 
      
      		 [bookmark: pgfId-903483]Creating Access Control List Objects

 
      		 [bookmark: pgfId-903488]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
      		 [bookmark: pgfId-903493]Creating Policy Objects

 
      		 [bookmark: pgfId-903498]Understanding Networks/Hosts Objects

 
     

 
     
 
     [bookmark: pgfId-903503]Step 1 Choose Manage > Policy Objects to open the Policy Object Manager (see Policy Object Manager).

 
     [bookmark: pgfId-903505]Step 2 From the Object Type selector, select Access Control Lists.

 
     [bookmark: pgfId-903507]The Access Control List page appears.

 
     [bookmark: pgfId-903509]Step 3 Click the Unified tab.

 
     [bookmark: pgfId-903511]Step 4 Right-click inside the work area, then select New Object.

 
     [bookmark: pgfId-903516]The Add Unified Access List dialog box appears (see Add or Edit Access List Dialog Boxes).

 
     [bookmark: pgfId-903518]Step 5 Enter a name for the object and optionally a description of the object.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1075490]Note Make sure that the name of the ACL Object is unique and is not the same name as the Firewall Rules ACL defined in the Firewall ACL Setting. For more information, see Firewall ACL Setting Dialog Box.


     
      

     

     

 
     [bookmark: pgfId-903520]Step 6 Right-click inside the table in the dialog box, then choose Add.

 
     [bookmark: pgfId-903522]The Add Unified Access Control Entry dialog box appears.

 
     [bookmark: pgfId-903524]Step 7 Create the access control entry:

 
      
      		 [bookmark: pgfId-903529]If you choose  Access Control Entry for Type, specify the characteristics of the traffic that you want to match and whether you are permitting or denying the traffic. Enter the source addresses whence the traffic originates and select logging options. For detailed information about the fields on the dialog box, see Add and Edit Unified Access Control Entry Dialog Boxes.

 
      		 [bookmark: pgfId-903531]If you choose  ACL Object , select the object in the available objects list and click  >> to add it to the list of selected objects.

 
     

 
     [bookmark: pgfId-903533]Step 8 Click OK to save your changes.

 
     [bookmark: pgfId-903535]The dialog box closes and you return to the Add Unified Access List dialog box. The new entry is shown in the table. If necessary, select it and click the up or down buttons to position it at the desired location.

 
     [bookmark: pgfId-903540]Step 9 (Optional) Under Category, select a category to help you identify this object in the Objects table. See Using Category Objects.

 
     [bookmark: pgfId-903542]Step 10 Click OK to save the object.

 
     [bookmark: pgfId-903544]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-903568][bookmark: 17794][bookmark: pobjpage_cncpt_AddorEditAccessListObjects]Add or Edit Access List Dialog Boxes [bookmark: marker-903556][bookmark: marker-903558][bookmark: marker-903560][bookmark: marker-903562][bookmark: marker-903564][bookmark: marker-903566]

 
     [bookmark: pgfId-903570]Use the Add and Edit Access List dialog boxes to define access control entries (ACEs) for an ACL object. From this page, you can change the order of the ACEs and ACL objects within the table, add or edit ACEs and ACL objects, and delete ACEs and ACL objects.

 
     [bookmark: pgfId-903572]The title of the dialog box indicates the type of ACL you are creating: Extended, Standard, or Web Type. The dialog boxes are essentially the same, the difference being the columns displayed in the ACE table.

 
     [bookmark: pgfId-903574]Navigation Path

 
     [bookmark: pgfId-903576]Select Manage > Policy Objects, then select Access Control Lists from the Object Type selector. Select the tab for the type of ACL object you want to create, and then right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-903578]Related Topics

 
      
      		 [bookmark: pgfId-903583]Creating Access Control List Objects

 
      		 [bookmark: pgfId-903588]Creating Extended Access Control List Objects

 
      		 [bookmark: pgfId-903593]Creating Standard Access Control List Objects

 
      		 [bookmark: pgfId-903598]Creating Web Access Control List Objects

 
      		 [bookmark: pgfId-903603]Contiguous and Discontiguous Network Masks for IPv4 Addresses

 
      		 [bookmark: pgfId-903608]Understanding Networks/Hosts Objects

 
      		 [bookmark: pgfId-903613]Understanding and Specifying Services and Service and Port List Objects

 
     

 
     [bookmark: pgfId-903615]Field Reference

 
     [bookmark: pgfId-903618] 

 
      
       
        
        [bookmark: pgfId-898095]Table 6-20 [bookmark: 17848]Add and Edit Access List Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-898101]Element
          
  
         		
           
           [bookmark: pgfId-898103]Description
          
  
        

 
         
         		[bookmark: pgfId-898109]Name

  
         		[bookmark: pgfId-898114]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
        

 
         
         		[bookmark: pgfId-898120]Description

  
         		[bookmark: pgfId-898122]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-898128]Access Control Entry table

  
         		[bookmark: pgfId-898130]The access control entries (ACEs) and ACL objects that are part of the ACL. The table displays the name of the entry or object, description, options, services, and other attributes of the entry.

 [bookmark: pgfId-898132]In the Permit column, a green checkmark indicates that the entry permits traffic (typically, the traffic is considered a match for the service you are defining), whereas a red circle with a slash indicates that traffic is denied (typically, the traffic is considered to not match, and the service you are defining is not applied to the denied traffic).

 [bookmark: pgfId-898134]The source and, if applicable, destination addresses can be host IP addresses, network addresses, or network/host policy objects.

 
           
           		 [bookmark: pgfId-898136]To add an ACE, click the Add button and fill in the dialog box for the type of ACL you are creating:

 
          

 [bookmark: pgfId-898141] – Add and Edit Extended Access Control Entry Dialog Boxes

 [bookmark: pgfId-898146] – Add and Edit Standard Access Control Entry Dialog Boxes

 [bookmark: pgfId-898151] – Add and Edit Web Access Control Entry Dialog Boxes

 
           
           		 [bookmark: pgfId-898153]To edit an ACE, select it and click the Edit button.

 
           		 [bookmark: pgfId-898155]To delete an ACE, select it and click the Delete button.

 
           		 [bookmark: pgfId-898157]To change the position of an entry, select it and click the Up/Down arrow buttons as required. Entries are evaluated top to bottom, so correct positioning is crucial for you to get the results you intend.

 
          

  
        

 
         
         		[bookmark: pgfId-898163]Category

  
         		[bookmark: pgfId-898168]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-898174]Allow Value Override per Device

 [bookmark: pgfId-898176]Overrides

 [bookmark: pgfId-898178]Edit button

  
         		[bookmark: pgfId-898186]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-898188]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-903630][bookmark: 17913][bookmark: pobjpage_cncpt_AddandEditExtendedAccessControlEntryDialogBoxes]Add and Edit Extended Access Control Entry Dialog Boxes[bookmark: marker-903626][bookmark: marker-903628]

 
     [bookmark: pgfId-903632]Use the Add or Edit Extended Access Control Entry dialog box to add an access control entry (ACE) or an ACL object to an Extended ACL object.

 
     [bookmark: pgfId-903634]Navigation Path

 
     [bookmark: pgfId-903639]From the Add or Edit Access List Dialog Boxes for Extended ACL objects, click the Add button in the ACE table, or select a row and click the Edit button.

 
     [bookmark: pgfId-903641]Related Topics

 
      
      		 [bookmark: pgfId-903646]Creating Extended Access Control List Objects

 
      		 [bookmark: pgfId-903651]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
      		 [bookmark: pgfId-903656]Understanding Networks/Hosts Objects

 
      		 [bookmark: pgfId-903661]Understanding and Specifying Services and Service and Port List Objects

 
      		 [bookmark: pgfId-903666]Filtering Items in Selectors

 
     

 
     [bookmark: pgfId-903668]Field Reference

 
     [bookmark: pgfId-903671] 

 
      
       
        
        [bookmark: pgfId-898201]Table 6-21 [bookmark: 17949]Add and Edit Extended Access Control Entry Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-898207]Element
          
  
         		
           
           [bookmark: pgfId-898209]Description
          
  
        

 
         
         		[bookmark: pgfId-898215]Type

  
         		[bookmark: pgfId-898217]The type of entry you are adding. The fields on the dialog box change based on your selection.

 
           
           		 [bookmark: pgfId-898219]Access Control Entry—You want to define an ACE.

 
           		 [bookmark: pgfId-898221]ACL Objects—You want to include an existing ACL object. You are presented with a list of available ACL objects. Select the objects you want to include and click the  >> button to move them to the list of selected objects. You can remove an object by selecting it and clicking  << . You can also edit objects in the selected objects list.

 
          

  
        

 
         
         		[bookmark: pgfId-898227]Action

  
         		[bookmark: pgfId-898229]The action to take on traffic defined in the entry:

 
           
           		 [bookmark: pgfId-898231]Permit—The service associated with this ACL is applied to this traffic. That is, the traffic is permitted to use the service.

 
           		 [bookmark: pgfId-898233]Deny—The service associated with this ACL is not applied to this traffic. If there are multiple ACLs configured for a service, denied traffic is typically compared to the next ACL in the list; if it matches no permit entry in any ACL for the service, the service is not applied to the traffic. Whether the traffic is dropped from the network depends on the service.

 
          

  
        

 
         
         		[bookmark: pgfId-898239]Category

  
         		[bookmark: pgfId-898244]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-898250]Source

 [bookmark: pgfId-898252]Destination

  
         		[bookmark: pgfId-898254]The source or destination of the traffic. You can enter more than one value by separating the items with commas.

 [bookmark: pgfId-898259]You can enter any combination of the following address types. For more information, see Specifying IP Addresses During Policy Definition.

 
           
           		 [bookmark: pgfId-898261]Network/host object. Enter the name of the object or click  Select to select it from a list. You can also create new network/host objects from the selection list.

 
          

 [bookmark: pgfId-898263](ASA 8.4(2+) only.) You can select FQDN network/host objects to select traffic based on fully-qualified host names.

 
           
           		 [bookmark: pgfId-898265]Host IP address, for example, 10.10.10.100.

 
           		 [bookmark: pgfId-898267]Network address, including subnet mask, in either the format 10.10.10.0/24 or 10.10.10.0/255.255.255.0.

 
           		 [bookmark: pgfId-898269]A range of IP addresses, for example, 10.10.10.100-10.10.10.200.

 
           		 [bookmark: pgfId-898274]An IP address pattern in the format 10.10.0.10/255.255.0.255, where the mask is a discontiguous bit mask (see Contiguous and Discontiguous Network Masks for IPv4 Addresses).

 
          

  
        

 
         
         		[bookmark: pgfId-898280]Users

  
         		[bookmark: pgfId-898282](ASA 8.4(2+) only.) The Active Directory (AD) usernames, user groups, or identity user group objects for the rule, if any. The user specification is conjoined to the source address to limit the match to user addresses within the source address range. You can enter more than one value by separating the items with commas.

 [bookmark: pgfId-898284]You can enter any combination of the following values.

 
           
           		 [bookmark: pgfId-898286]Individual user names: NetBIOS_DOMAIN\username

 
           		 [bookmark: pgfId-898288]User groups (note the double \): NetBIOS_DOMAIN\\user_group

 
           		 [bookmark: pgfId-898290]Identity user group object names.

 
          

 [bookmark: pgfId-898292]Click Select to select objects, users, or user groups from a list or to create new objects.

 [bookmark: pgfId-898294]For more information, see:

 
           
           		 [bookmark: pgfId-898299]Selecting Identity Users in Policies

 
           		 [bookmark: pgfId-898304]Configuring Identity-Based Firewall Rules

 
           		 [bookmark: pgfId-898309]Creating Identity User Group Objects

 
          

  
        

 
         
         		[bookmark: pgfId-898315]Services

  
         		[bookmark: pgfId-898317]The services that define the type of traffic to act on. You can enter more than one value by separating the items with commas.

 [bookmark: pgfId-898319]You can enter any combination of service objects and service types (which are typically a protocol and port combination). If you type in a service, you are prompted as you type with valid values. You can select a value from the list and press Enter or Tab.

 [bookmark: pgfId-898324]For complete information on how to specify services, see Understanding and Specifying Services and Service and Port List Objects.

  
        

 
         
         		[bookmark: pgfId-898330]Description

  
         		[bookmark: pgfId-898332]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-898338]Advanced button

  
         		[bookmark: pgfId-898340]Click this button to define logging options for the entry:

 
           
           		 [bookmark: pgfId-898342]For PIX, ASA, and FWSM devices, you can enable:

 
          

 [bookmark: pgfId-898344] – Default logging—If a packet is denied, message 106023 is generated. If a packet is permitted, no message is generated.

 [bookmark: pgfId-898346] – Per ACE logging—If a packet is denied, message 106100 is generated. You can select the logging severity level for the messages, and the interval (in seconds from 1 to 600) for generating messages.

 
           
           		 [bookmark: pgfId-898348]For IOS devices, when you enable logging, informational messages about packets that match the entry are sent to the console. You can also elect to include the input interface and source MAC address or VC in the logging output.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-903683][bookmark: 18064][bookmark: pobjpage_cncpt_AddandEditStandardAccessControlEntryDialogBoxes]Add and Edit Standard Access Control Entry Dialog Boxes[bookmark: marker-903679][bookmark: marker-903681]

 
     [bookmark: pgfId-903685]Use the Add or Edit Standard Access Control Entry dialog box to add an access control entry (ACE) or an ACL object to a Standard ACL object.

 
     [bookmark: pgfId-903687]Navigation Path

 
     [bookmark: pgfId-903692]From the Add or Edit Access List Dialog Boxes for Standard ACL objects, click the Add button in the ACE table, or select a row and click the Edit button.

 
     [bookmark: pgfId-903694]Related Topics

 
      
      		 [bookmark: pgfId-903699]Creating Standard Access Control List Objects

 
      		 [bookmark: pgfId-903704]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
      		 [bookmark: pgfId-903709]Understanding Networks/Hosts Objects

 
      		 [bookmark: pgfId-903714]Understanding and Specifying Services and Service and Port List Objects

 
      		 [bookmark: pgfId-903719]Filtering Items in Selectors

 
     

 
     [bookmark: pgfId-903721]Field Reference

 
     [bookmark: pgfId-903724] 

 
      
       
        
        [bookmark: pgfId-898361]Table 6-22 [bookmark: 18100]Add and Edit Standard Access Control Entry Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-898367]Element
          
  
         		
           
           [bookmark: pgfId-898369]Description
          
  
        

 
         
         		[bookmark: pgfId-898375]Type

  
         		[bookmark: pgfId-898377]The type of entry you are adding. The fields on the dialog box change based on your selection.

 
           
           		 [bookmark: pgfId-898379]Access Control Entry—You want to define an ACE.

 
           		 [bookmark: pgfId-898381]ACL Objects—You want to include an existing ACL object. You are presented with a list of available ACL objects. Select the objects you want to include and click the  >> button to move them to the list of selected objects. You can remove an object by selecting it and clicking  << . You can also edit objects in the selected objects list.

 
          

  
        

 
         
         		[bookmark: pgfId-898387]Action

  
         		[bookmark: pgfId-898389]The action to take on traffic defined in the entry:

 
           
           		 [bookmark: pgfId-898391]Permit—The service associated with this ACL is applied to this traffic. That is, the traffic is permitted to use the service.

 
           		 [bookmark: pgfId-898393]Deny—The service associated with this ACL is not applied to this traffic. If there are multiple ACLs configured for a service, denied traffic is typically compared to the next ACL in the list; if it matches no permit entry in any ACL for the service, the service is not applied to the traffic. Whether the traffic is dropped from the network depends on the service.

 
          

  
        

 
         
         		[bookmark: pgfId-898399]Category

  
         		[bookmark: pgfId-898404]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-898410]Source

  
         		[bookmark: pgfId-898412]The source of the traffic. You can enter more than one value by separating the items with commas.

 [bookmark: pgfId-898417]You can enter any combination of the following address types. For more information, see Specifying IP Addresses During Policy Definition.

 
           
           		 [bookmark: pgfId-898419]Network/host object. Enter the name of the object or click  Select to select it from a list. You can also create new network/host objects from the selection list.

 
           		 [bookmark: pgfId-898421]Host IP address, for example, 10.10.10.100.

 
           		 [bookmark: pgfId-898423]Network address, including subnet mask, in either the format 10.10.10.0/24 or 10.10.10.0/255.255.255.0.

 
           		 [bookmark: pgfId-898425]A range of IP addresses, for example, 10.10.10.100-10.10.10.200.

 
           		 [bookmark: pgfId-898430]An IP address pattern in the format 10.10.0.10/255.255.0.255, where the mask is a discontiguous bit mask (see Contiguous and Discontiguous Network Masks for IPv4 Addresses).

 
          

  
        

 
         
         		[bookmark: pgfId-898436]Description

  
         		[bookmark: pgfId-898438]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-898444]Log Option

  
         		[bookmark: pgfId-898446]Whether to create log entries when traffic meets the entry criteria. ACL logging generates syslog message 106023 for denied packets. Deny packets must be present to log denied packets.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-903736][bookmark: 18169][bookmark: pobjpage_cncpt_AddandEditWebAccessControlEntryDialogBoxes]Add and Edit Web Access Control Entry Dialog Boxes[bookmark: marker-903732][bookmark: marker-903734]

 
     [bookmark: pgfId-903738]Use the Add or Edit Web Access Control Entry dialog box to add an access control entry (ACE) or an ACL object to a Web Type ACL object.

 
     [bookmark: pgfId-903740]Navigation Path

 
     [bookmark: pgfId-903745]From the Add or Edit Access List Dialog Boxes for Web Type ACL objects, click the Add button in the ACE table, or select a row and click the Edit button.

 
     [bookmark: pgfId-903747]Related Topics

 
      
      		 [bookmark: pgfId-903752]Creating Web Access Control List Objects

 
      		 [bookmark: pgfId-903757]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
      		 [bookmark: pgfId-903762]Understanding Networks/Hosts Objects

 
      		 [bookmark: pgfId-903767]Understanding and Specifying Services and Service and Port List Objects

 
      		 [bookmark: pgfId-903772]Filtering Items in Selectors

 
     

 
     [bookmark: pgfId-903774]Field Reference

 
     [bookmark: pgfId-903777] 

 
      
       
        
        [bookmark: pgfId-898459]Table 6-23 [bookmark: 18205]Add and Edit Web Access Control Entry Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-898465]Element
          
  
         		
           
           [bookmark: pgfId-898467]Description
          
  
        

 
         
         		[bookmark: pgfId-898473]Type

  
         		[bookmark: pgfId-898475]The type of entry you are adding. The fields on the dialog box change based on your selection.

 
           
           		 [bookmark: pgfId-898477]Access Control Entry—You want to define an ACE.

 
           		 [bookmark: pgfId-898479]ACL Objects—You want to include an existing ACL object. You are presented with a list of available ACL objects. Select the objects you want to include and click the  >> button to move them to the list of selected objects. You can remove an object by selecting it and clicking  << . You can also edit objects in the selected objects list.

 
          

  
        

 
         
         		[bookmark: pgfId-898485]Action

  
         		[bookmark: pgfId-898487]The action to take on traffic defined in the entry:

 
           
           		 [bookmark: pgfId-898489]Permit—The service associated with this ACL is applied to this traffic. That is, the traffic is permitted to use the service.

 
           		 [bookmark: pgfId-898491]Deny—The service associated with this ACL is not applied to this traffic. If there are multiple ACLs configured for a service, denied traffic is typically compared to the next ACL in the list; if it matches no permit entry in any ACL for the service, the service is not applied to the traffic. Whether the traffic is dropped from the network depends on the service.

 
          

  
        

 
         
         		[bookmark: pgfId-898497]Filter Destination

  
         		[bookmark: pgfId-898499]Whether the entry specifies a network filter (host or network address) or a URL filter (web site address). Your selection changes the fields on the dialog box. The fields are described below.

  
        

 
         
         		[bookmark: pgfId-898505]Destination

 [bookmark: pgfId-898507](Network Filter only.)

  
         		[bookmark: pgfId-898509]The destination of the traffic. You can enter more than one value by separating the items with commas.

 [bookmark: pgfId-898514]You can enter any combination of the following address types. For more information, see Specifying IP Addresses During Policy Definition.

 
           
           		 [bookmark: pgfId-898516]Network/host object. Enter the name of the object or click  Select to select it from a list. You can also create new network/host objects from the selection list.

 
           		 [bookmark: pgfId-898518]Host IP address, for example, 10.10.10.100.

 
           		 [bookmark: pgfId-898520]Network address, including subnet mask, in either the format 10.10.10.0/24 or 10.10.10.0/255.255.255.0.

 
           		 [bookmark: pgfId-898522]A range of IP addresses, for example, 10.10.10.100-10.10.10.200.

 
           		 [bookmark: pgfId-898527]An IP address pattern in the format 10.10.0.10/255.255.0.255, where the mask is a discontiguous bit mask (see Contiguous and Discontiguous Network Masks for IPv4 Addresses).

 
          

  
        

 
         
         		[bookmark: pgfId-898533]Ports

 [bookmark: pgfId-898535](Network Filter only.)

  
         		[bookmark: pgfId-898537]The port numbers or port list policy objects that define the port the traffic uses, if you want to use port identification. You can enter more than one value by separating the items with commas.

 [bookmark: pgfId-898539]You can enter any combination of the following types:

 
           
           		 [bookmark: pgfId-898541]Port list object. Enter the name of the object or click  Select to select it from a list. You can also create new port list objects from the selection list.

 
           		 [bookmark: pgfId-898543]Port number, for example, 80.

 
           		 [bookmark: pgfId-898545]A range of ports, for example, 80-90.

 
          

  
        

 
         
         		[bookmark: pgfId-898551]URL Filter

 [bookmark: pgfId-898553](URL Filter only.)

  
         		[bookmark: pgfId-898555]The Universal Resource Locator (URL), or web address, of the traffic. You can use an asterisk as a match-all wildcard. For example, http://*.cisco.com matches all servers on the cisco.com network. You can specify any valid URL.

  
        

 
         
         		[bookmark: pgfId-898561]Logging

  
         		[bookmark: pgfId-898563]The type of logging to use for this entry:

 
           
           		 [bookmark: pgfId-898565]Select Log Disabled to not create log entries.

 
           		 [bookmark: pgfId-898567]Select Default to use the default settings on the device.

 
           		 [bookmark: pgfId-898569]All other available options enable logging and identify the log level that will be used.

 
          

  
        

 
         
         		[bookmark: pgfId-898575]Logging Interval

  
         		[bookmark: pgfId-898577]The interval of time, in seconds, used to generate logging messages, from 1 to 600. The default is 300. You can modify this field only if you select a logging level in the Logging field.

  
        

 
         
         		[bookmark: pgfId-898583]Time Range

  
         		[bookmark: pgfId-898588]The time range policy object that defines the time range associated with the entry. The time range defines the access to the device and relies on the device’s system clock. For more information, see Configuring Time Range Objects.

 [bookmark: pgfId-898590]Enter the name of the object or click Select to select it from a list. You can also create new time range objects from the selection list.

 [bookmark: pgfId-898592]Note Time range is not supported on FWSM 2.x or PIX 6.3 devices.

  
        

 
         
         		[bookmark: pgfId-898598]Category

  
         		[bookmark: pgfId-898603]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-898609]Description

  
         		[bookmark: pgfId-898611]An optional description of the object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-903789][bookmark: 18322][bookmark: pobjpage_cncpt_AddandEditUnifiedAccessControlEntryDialogBoxes]Add and Edit Unified Access Control Entry Dialog Boxes[bookmark: marker-903785][bookmark: marker-903787]

 
     [bookmark: pgfId-903791]Use the Add or Edit Unified Access Control Entry dialog box to add an access control entry (ACE) or an ACL object to a Unified ACL object.

 
     [bookmark: pgfId-903793]Navigation Path

 
     [bookmark: pgfId-903798]From the Add or Edit Access List Dialog Boxes for Unified ACL objects, click the Add button in the ACE table, or select a row and click the Edit button.

 
     [bookmark: pgfId-903800]Related Topics

 
      
      		 [bookmark: pgfId-903805]Creating Unified Access Control List Objects

 
      		 [bookmark: pgfId-903810]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
      		 [bookmark: pgfId-903815]Understanding Networks/Hosts Objects

 
      		 [bookmark: pgfId-903820]Understanding and Specifying Services and Service and Port List Objects

 
      		 [bookmark: pgfId-903825]Filtering Items in Selectors

 
     

 
     [bookmark: pgfId-903827]Field Reference

 
     [bookmark: pgfId-903830] 

 
      
       
        
        [bookmark: pgfId-898624]Table 6-24 [bookmark: 18357]Add and Edit Unified Access Control Entry Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-898630]Element
          
  
         		
           
           [bookmark: pgfId-898632]Description
          
  
        

 
         
         		[bookmark: pgfId-898638]Type

  
         		[bookmark: pgfId-898640]The type of entry; the fields in the dialog box change based on your choice:

 
           
           		 [bookmark: pgfId-898642]Access Control Entry—You want to define an ACE.

 
           		 [bookmark: pgfId-898644]ACL Objects—You want to include one or more existing ACL objects. You are presented with a list of available ACL objects. Select the objects you want to include and click the  >> button to move them to the list of selected objects. You can remove an object by selecting it and clicking  << . You can also edit an object in the selected objects list.

 
          

  
        

 
         
         		[bookmark: pgfId-898650]Action

  
         		[bookmark: pgfId-898652]The action to take on traffic defined in the entry:

 
           
           		 [bookmark: pgfId-898654]Permit—The Services associated with the ACE are applied to this traffic. That is, the traffic defined by this entry is permitted to use the Services.

 
           		 [bookmark: pgfId-898656]Deny—The Services associated with this ACE are not applied to this traffic. If there are multiple ACLs configured for a service, denied traffic is typically compared to the next ACE in the list; if it matches no permit entry in any ACL for the service, the service is not applied to the traffic. Whether the traffic is dropped from the network depends on the service.

 
          

  
        

 
         
         		[bookmark: pgfId-898662]Source

  
         		[bookmark: pgfId-898664]Provide traffic sources for this rule; can be networks and hosts. You can enter values or object names, or Select objects, for one or more of the following:

 
           
           		 [bookmark: pgfId-898666]Networks/Hosts – You can specify a various network, host and interface definitions, either individually or as objects. If you Select an interface object as a source, the dialog box displays tabs to differentiate between hosts/networks and interfaces.

 
          

 [bookmark: pgfId-898668]The “All-Address” objects do not restrict the rule to specific hosts, networks, or interfaces. These addresses are IPv4 or IPv6 addresses for hosts or networks, network/host objects, interfaces, or interface roles.

 [bookmark: pgfId-898670]Note (ASA 8.4.2+ only) You can only specify a fully qualified domain name (FQDN) by providing an FQDN network/host object, or a group object that includes an FQDN object. You cannot directly type in an FQDN.

 [bookmark: pgfId-898681]See Understanding Networks/Hosts Objects, Specifying IP Addresses During Policy Definition and Understanding Interface Role Objects for additional information about these definitions.

 [bookmark: pgfId-898683]Note Enter more than one value in any of these fields by separating the items with commas.

 [bookmark: pgfId-898685]All Source, Source SG, and Users specifications area combined to limit traffic matches to only those flows that include all source definitions. For example, specified user traffic originating from within a specified source address range.

  
        

 
         
         		[bookmark: pgfId-898691]Source SG

  
         		[bookmark: pgfId-898693](ASA 9.0+ only) Enter or Select the name or tag number for one or more source Security Groups for the ACE, if any. For more information about security groups, see:

 
           
           		 [bookmark: pgfId-898698]Selecting Security Groups in Policies

 
           		 [bookmark: pgfId-898703]Configuring TrustSec-Based Firewall Rules

 
           		 [bookmark: pgfId-898708]Creating Security Group Objects

 
          

  
        

 
         
         		[bookmark: pgfId-898714]Users

  
         		[bookmark: pgfId-898716](ASA 8.4.2+ only) Enter or Select the Active Directory (AD) user names, user groups, or identity user group objects for the ACE, if any. The user specification is conjoined to the source address to limit the match to user addresses within the source address range. You can enter more than one value by separating the items with commas.

 [bookmark: pgfId-898718]You can enter any combination of the following values:

 
           
           		 [bookmark: pgfId-898720]Individual user names: NetBIOS_DOMAIN\username

 
           		 [bookmark: pgfId-898722]User groups (note the double \): NetBIOS_DOMAIN\\user_group

 
           		 [bookmark: pgfId-898724]Identity user group object names.

 
          

 [bookmark: pgfId-898726]For more information, see:

 
           
           		 [bookmark: pgfId-898731]Selecting Identity Users in Policies

 
           		 [bookmark: pgfId-898736]Configuring Identity-Based Firewall Rules

 
           		 [bookmark: pgfId-898741]Creating Identity User Group Objects

 
          

  
        

 
         
         		[bookmark: pgfId-898747]Destination

 [bookmark: pgfId-898749]Destination SG

  
         		[bookmark: pgfId-898751]The source or destination of the traffic. You can enter more than one value by separating the items with commas.

 [bookmark: pgfId-898753]Provide traffic destinations, and optionally destination security groups (ASA 9.0+ only), for this ACE. As with the source entries, you can enter values or object names, or Select objects, for one or more destinations.

  
        

 
         
         		[bookmark: pgfId-898759]Service

  
         		[bookmark: pgfId-898761]The services that define the type of traffic to act on. You can enter more than one value by separating the items with commas.

 [bookmark: pgfId-898763]You can enter or Select any combination of service objects and service types (which are typically a protocol and port combination). If you type in a service, you are prompted as you type with valid values.

 [bookmark: pgfId-898768]For complete information on how to specify services, see Understanding and Specifying Services and Service and Port List Objects.

  
        

 
         
         		[bookmark: pgfId-898774]Advanced button

  
         		[bookmark: pgfId-898776]Click this button to open the Advanced dialog box and define logging options for the ACE. For PIX, ASA, and FWSM devices, you can enable:

 
           
           		 [bookmark: pgfId-898778]Default logging—If a packet is denied, message 106023 is generated. If a packet is permitted, no message is generated.

 
           		 [bookmark: pgfId-898780]Per ACE logging—If a packet is denied, message 106100 is generated. You can select the logging severity level for the messages, and the interval (in seconds from 1 to 600) for generating messages.

 
          

  
        

 
         
         		[bookmark: pgfId-898786]Category

  
         		[bookmark: pgfId-898791]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-898797]Description

  
         		[bookmark: pgfId-898799]An optional description of the object.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-903848][bookmark: 18483][bookmark: pobjpage_cncpt_TimeRangeDialogBox]Configuring Time Range Objects[bookmark: marker-903838][bookmark: marker-903840][bookmark: marker-903842][bookmark: marker-903844][bookmark: marker-903846]

 
    [bookmark: pgfId-903850]Use the Add or Edit Time Range dialog box to create, edit, or copy a time range object.

 
    [bookmark: pgfId-903852]You can create time range objects for use when creating time-based ACLs and some firewall rules. While similar to extended ACLs in function, time-based ACLs allow for access control based on time considerations. The time range applies to specific rules, and makes those rules active for the specific time period defined in the range. For example, you can implement a rule for typical work hours to allow or prevent certain types of access.

 
    [bookmark: pgfId-903857]You can also use time range objects when defining ASA user groups to restrict VPN access to specific times during the week. For more information, see ASA Group Policies SSL VPN Settings.

 
    [bookmark: pgfId-903859]Time range objects can rely on the device’s system clock, but they work best when using Network Time Protocol (NTP) synchronization.

 
    [bookmark: pgfId-903861]Navigation Path

 
    [bookmark: pgfId-903863]Select Manage > Policy Objects, then select Time Ranges from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
    [bookmark: pgfId-903865]Field Reference

 
    [bookmark: pgfId-903868] 

 
     
      
       
       [bookmark: pgfId-898812]Table 6-25 [bookmark: 18517]Time Range Dialog Box 

 
       
      
        
        		
          
          [bookmark: pgfId-898818]Element
         
  
        		
          
          [bookmark: pgfId-898820]Description
         
  
       

 
        
        		[bookmark: pgfId-898826]Name

  
        		[bookmark: pgfId-898831]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
       

 
        
        		[bookmark: pgfId-898837]Description

  
        		[bookmark: pgfId-898839]An optional description of the object (up to 1024 characters).

  
       

 
        
        		[bookmark: pgfId-898845]Start Time

 [bookmark: pgfId-898847]End Time

  
        		[bookmark: pgfId-898849]The overall starting and ending time for the time range object:

 
          
          		 [bookmark: pgfId-898851]Start Now—Defines the time of deployment as the start time.

 
          		 [bookmark: pgfId-898853]Never End—Defines no end time for the range.

 
          		 [bookmark: pgfId-898855]Start At, End At—Defines a specific start or end date and time. Click the calendar icon to display a tool for selecting the date. Enter the time in the Time field using the 24-hour clock format, HH:MM.

 
         

  
       

 
        
        		[bookmark: pgfId-898861]Recurring Ranges

  
        		[bookmark: pgfId-898863]Recurring time periods that happen within the overall start and end times, if any. For example, if you want to create a time range object that defines work hours, you could select Start Now and Never End for the overall range, and enter a recurring range of weekdays from 08:00 to 18:00 hours.

 
          
          		 [bookmark: pgfId-898868]To add a range, click the  New Recurring Range button and fill in the Recurring Ranges Dialog Box.

 
          		 [bookmark: pgfId-898870]To edit a range, select it and click the  Edit Recurring Range button.

 
          		 [bookmark: pgfId-898872]To delete a range, select it and click the  Delete Recurring Range button.

 
         

  
       

 
        
        		[bookmark: pgfId-898878]Category

  
        		[bookmark: pgfId-898883]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-903884][bookmark: 18573][bookmark: pobjpage_cncpt_RecurringRangesDialogBox]Recurring Ranges Dialog Box[bookmark: marker-903876][bookmark: marker-903878][bookmark: marker-903880][bookmark: marker-903882]

 
     [bookmark: pgfId-903886]Use the Recurring Ranges dialog box to add or edit recurring time intervals that are defined as part of a time range object. You can define as many recurring ranges as required.

 
     [bookmark: pgfId-903888]Navigation Path

 
     [bookmark: pgfId-903893]Go to the Add or Edit Time Range dialog box and click the New Recurring Range button under Recurring Ranges, or select a range and click Edit Recurring Range. See Configuring Time Range Objects.

 
     [bookmark: pgfId-903895]Field Reference

 
     [bookmark: pgfId-903898] 

 
      
       
        
        [bookmark: pgfId-898896]Table 6-26 [bookmark: 18600]Recurring Ranges Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-898902]Element
          
  
         		
           
           [bookmark: pgfId-898904]Description
          
  
        

 
         
         		[bookmark: pgfId-898910]Specify days of the week and times during which this recurring range will be active

  
         		[bookmark: pgfId-898912]Defines a recurring range that is based on specific days and times of the week. You can select from:

 
           
           		 [bookmark: pgfId-898914]Every day

 
           		 [bookmark: pgfId-898916]Weekdays

 
           		 [bookmark: pgfId-898918]Weekends

 
           		 [bookmark: pgfId-898920]On these days of the week—Select the specific days to include in the range.

 
          

 [bookmark: pgfId-898922]Also select the starting and ending time during the day. The default is all day.

  
        

 
         
         		[bookmark: pgfId-898928]Specify a weekly interval during which this recurring range will be active

  
         		[bookmark: pgfId-898930]Defines a recurring range for every week. Select the starting and ending day and time. For example, you can start the weekly period on Sunday and end it on Thursday.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-903912][bookmark: 18632][bookmark: obman_cncpt_UnderstandingInterfaceRoleObjects]Understanding Interface Role Objects[bookmark: marker-903904][bookmark: marker-903906][bookmark: marker-903908][bookmark: marker-903910]

 
    [bookmark: pgfId-903914]Interface Role objects have the following uses:

 
     
     		 [bookmark: pgfId-903916]Specifying multiple interfaces— Interface role objects allow you to apply policies to specific interfaces on multiple devices without having to manually define the names of each interface. Because most devices follow a standard naming convention for their interfaces, you can define a naming pattern that describes a particular interface type and then assign a policy to all interfaces matching that pattern.

 
     		 [bookmark: pgfId-903918]Zones—You use interface role objects to define the zones in a zone-based firewall rules policy.

 
    

 
    [bookmark: pgfId-903920]For example, you might define an interface role with a naming pattern of DMZ*. When you include this interface role in a policy, the policy is applied to all interfaces whose name begins with “DMZ” on the selected devices. As a result, you can, for example, assign a policy that enables anti-spoof checking on all DMZ interfaces to all relevant device interfaces with a single action. Interface roles can refer to any of the actual interfaces on the device, including physical interfaces, subinterfaces, and virtual interfaces, such as loopback interfaces.

 
    [bookmark: pgfId-903922]Interface roles serve as an indirection entity between interfaces on the one hand and policies on the other. This enables you to apply policies to particular device interfaces based on the assigned role. Additionally, if you change the naming convention used for a particular interface type, you do not need to determine which policies are affected by the change. All you do is edit the interface role.

 
    [bookmark: pgfId-903924]Interface roles are especially useful when you apply policies to new devices. As long as the devices you are adding share the same interface naming scheme as existing devices, the relevant policies can be extended to them without the need to make additional assignments.

 
    [bookmark: pgfId-903926]Security Manager includes the following predefined interface roles:

 
     
     		 [bookmark: pgfId-903928]All-Interfaces—Includes every interface defined on a device.

 
     		 [bookmark: pgfId-903930]Internal—Includes only specific interfaces that are meant to be on the inside of a network. See the object definition for a list.

 
     		 [bookmark: pgfId-903932]External—Includes only specific interfaces that are meant to be on the outside of a network. See the object definition for a list.

 
     		 [bookmark: pgfId-903934]Self—Does not include any interfaces. The Self interface role is specific to zone-based firewall rules policies. The Self zone is the router itself. You can use it to identify traffic originating from the router, or traffic directed to the router. It does not include traffic passing through the router.

 
    

 
    [bookmark: pgfId-903936]The following topics describe how to work with interface role objects:

 
     
     		 [bookmark: pgfId-903941]Creating Interface Role Objects

 
     		 [bookmark: pgfId-903946]Specifying Interfaces During Policy Definition

 
     		 [bookmark: pgfId-903951]Using Interface Roles When a Single Interface Specification is Allowed

 
     		 [bookmark: pgfId-903956]Handling Name Conflicts between Interfaces and Interface Roles

 
     		 [bookmark: pgfId-903961]Chapter 22, “Managing Traffic Zones”

 
    

 
     
      [bookmark: pgfId-903977][bookmark: 18683][bookmark: obman_proc_CreatingInterfaceRoleObjects]Creating Interface Role Objects[bookmark: marker-903967][bookmark: marker-903969][bookmark: marker-903971][bookmark: marker-903973][bookmark: marker-903975]

 
     [bookmark: pgfId-903979]You can create interface role objects that represent one or more interfaces on devices. You can then use these roles when you define policies that require interfaces or zones. When you create an interface role object, you must define the naming pattern of the device interfaces to include in the object. Interface roles can refer to any of the actual interfaces on the device, including physical interfaces, subinterfaces, and virtual interfaces.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-903984]Tip You can also create interface role objects when you define policies or objects that use this object type. For more information, see Selecting Objects for Policies.


     
      

     

     

 
     [bookmark: pgfId-903986]Related Topics

 
      
      		 [bookmark: pgfId-903991]Creating Policy Objects

 
      		 [bookmark: pgfId-903996]Specifying Interfaces During Policy Definition

 
      		 [bookmark: pgfId-904001]Understanding Interface Role Objects

 
      		 [bookmark: pgfId-904006]Using Interface Roles When a Single Interface Specification is Allowed

 
      		 [bookmark: pgfId-904011]Managing Object Overrides

 
      		 [bookmark: pgfId-904016]Chapter 22, “Managing Traffic Zones”

 
     

 
     
 
     [bookmark: pgfId-904021]Step 1 Select Manage > Policy Objects to open the Policy Object Manager (see Policy Object Manager).

 
     [bookmark: pgfId-904023]Step 2 Select Interface Roles from the Object Type selector.

 
     [bookmark: pgfId-904025]Step 3 Right-click in the work area, then select New Object.

 
     [bookmark: pgfId-904027]The Interface Role dialog box appears.

 
     [bookmark: pgfId-904029]Step 4 Enter a name for the object and optionally a description of the object. Names can be up to 128 characters, descriptions up to 1024.

 
     [bookmark: pgfId-904031]Step 5 Enter one or more naming patterns for the interface role object. The names are the complete or partial names of interfaces, subinterfaces, and other virtual interfaces. Separate multiple name patterns with commas.

 
     [bookmark: pgfId-904033]You can use these wildcards to create name patterns that apply to multiple interfaces:

 
      
      		 [bookmark: pgfId-904035]Use a period (.) as a wildcard for a single character. To use a period as part of the pattern itself, enter a backslash (\) before the period.

 
      		 [bookmark: pgfId-904037]Use an asterisk (*) as a wildcard for one or more characters at the end of the interface pattern.

 
     

 
     [bookmark: pgfId-904039]For example, DMZ* would include all interfaces whose name begins with “DMZ”, while DMZ. would match interfaces such as DMZ1 and DMZ2, but would not match DMZ10.

 
     [bookmark: pgfId-904041]If the pattern does not include a wildcard, it must match the exact name of the interface. For example, the pattern FastEthernet will not match FastEthernet0/1 unless you include an asterisk at the end of the pattern.

 
     [bookmark: pgfId-904046]Step 6 (Optional) Under Category, select a category to help you identify this object in the Objects table. See Using Category Objects.

 
     [bookmark: pgfId-904051]Step 7 (Optional) Select Allow Value Override per Device to allow the properties of this object to be redefined on individual devices. See Allowing a Policy Object to Be Overridden.

 
     [bookmark: pgfId-904053]Step 8 Click OK to save the object.

 
     [bookmark: pgfId-904055]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-904067][bookmark: 18765][bookmark: pobjpage_cncpt_InterfaceRoleDialogBox]Interface Role Dialog Box[bookmark: marker-904063][bookmark: marker-904065]

 
     [bookmark: pgfId-904069]Use the Interface Role dialog box to create, copy, or edit an interface role object. Interface Role objects have the following uses:

 
      
      		 [bookmark: pgfId-904071]Specifying multiple interfaces— Interface role objects allow you to apply policies to specific interfaces on multiple devices without having to manually define the names of each interface.

 
      		 [bookmark: pgfId-904073]Zones—You use interface role objects to define the zones in a zone-based firewall rules policy.

 
     

 
     [bookmark: pgfId-904075]Navigation Path

 
     [bookmark: pgfId-904077]Select Manage > Policy Objects, then select Interface Roles from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-904079]Related Topics

 
      
      		 [bookmark: pgfId-904084]Creating Policy Objects

 
      		 [bookmark: pgfId-904089]Creating Interface Role Objects

 
      		 [bookmark: pgfId-904094]Using Interface Roles When a Single Interface Specification is Allowed

 
      		 [bookmark: pgfId-904099]Specifying Interfaces During Policy Definition

 
      		 [bookmark: pgfId-904104]Understanding Interface Role Objects

 
      		 [bookmark: pgfId-904109]Chapter 22, “Managing Traffic Zones”

 
      		 [bookmark: pgfId-904114]Policy Object Manager

 
     

 
     [bookmark: pgfId-904116]Field Reference

 
     [bookmark: pgfId-904119] 

 
      
       
        
        [bookmark: pgfId-898943]Table 6-27 [bookmark: 18815]Interface Role Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-898949]Element
          
  
         		
           
           [bookmark: pgfId-898951]Description
          
  
        

 
         
         		[bookmark: pgfId-898957]Name

  
         		[bookmark: pgfId-898959]The name of the policy object. A maximum of 128 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-898965]Description

  
         		[bookmark: pgfId-898967]A description of the policy object. A maximum of 1024 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-898973]Interface Name Patterns

  
         		[bookmark: pgfId-898975]The names to include in this interface role. The names are the complete or partial names of interfaces, subinterfaces, and other virtual interfaces. Separate multiple name patterns with commas.

 [bookmark: pgfId-898977]Note For firewall devices, use the name assigned to the interface (for example, Inside, Outside, or DMZ) and not the hardware port identifier (for example, Ethernet0).

 [bookmark: pgfId-898979]You can use these wildcards to create name patterns that apply to multiple interfaces:

 
           
           		 [bookmark: pgfId-898981]Use a period (.) as a wildcard for a single character. To use a period as part of the pattern itself, enter a backslash (\) before the period.

 
           		 [bookmark: pgfId-898983]Use an asterisk (*) as a wildcard for one or more characters at the end of the interface pattern.

 
          

 [bookmark: pgfId-898985]For example, DMZ* would include all interfaces whose name begins with “DMZ”, while DMZ. would match interfaces such as DMZ1 and DMZ2, but would not match DMZ10.

 [bookmark: pgfId-898987]If the pattern does not include a wildcard, it must match the exact name of the interface. For example, the pattern “FastEthernet” will not match FastEthernet0/1 unless you include an asterisk at the end of the pattern.

  
        

 
         
         		[bookmark: pgfId-898993]Category

  
         		[bookmark: pgfId-898998]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-899004]Allow Value Override per Device

 [bookmark: pgfId-899006]Overrides

 [bookmark: pgfId-899008]Edit button

  
         		[bookmark: pgfId-899016]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-899018]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-904137][bookmark: 18869][bookmark: obman_cncpt_SpecifyingInterfacesDuringPolicyDefinition]Specifying Interfaces During Policy Definition[bookmark: marker-904125][bookmark: marker-904127][bookmark: marker-904129][bookmark: marker-904131][bookmark: marker-904133][bookmark: marker-904135]

 
     [bookmark: pgfId-904139]When you configure policies that require you to identify an interface, you have several options for specifying the interface:

 
      
      		 [bookmark: pgfId-904141]Enter the name of the interface manually, for example, Ethernet0.

 
     

 
     [bookmark: pgfId-904147]To manually specify a subinterface as part of a policy definition, you must enter a backslash (\) before the period. For example, Ethernet0\.1.[bookmark: marker-904143][bookmark: marker-904145]

 
     [bookmark: pgfId-904149]If you enter the period without the backslash, Security Manager treats the period as a wildcard for a single character. For example, if you want to define Ethernet1/1.0 as part of an access rule, you need to enter Ethernet1/1\.0. If you enter Ethernet1/1.0 instead, the name matches interfaces named Ethernet1/1.0 and Ethernet1/1/0, because the period on its own is treated as a wildcard.

 
      
      		 [bookmark: pgfId-904154]Enter the name of an interface role manually. For more information about interface roles, see Understanding Interface Role Objects.

 
      		 [bookmark: pgfId-904156]Select an interface or interface role from a list. By clicking  Select next to the Interfaces field, you are prompted with a list of valid interface names and interface roles. Subinterfaces appear with a backslash before the period in their names.

 
     

 
     [bookmark: pgfId-904161]By selecting from a list, you can ensure that your entry is valid. For more information, see Selecting Objects for Policies.

 
     [bookmark: pgfId-904163]When a policy allows multiple interfaces, separate entries with commas.

 
     [bookmark: pgfId-904168]In policies and object selectors, icons distinguish between interfaces and interface roles. If you create interface roles with the same name as interfaces, be careful to select exactly what you want. Table 6-28 explains the icons.

 
     [bookmark: pgfId-904171] 

 
      
      


      


      


       
        
        [bookmark: pgfId-899031]Table 6-28 [bookmark: 18915]Icons for Interfaces and Interface Roles 

 
        
       
         
         		
           
           [bookmark: pgfId-899037]Type
          
  
         		
           
           [bookmark: pgfId-899039]Icon
          
  
        

 
         
         		[bookmark: pgfId-899045]Interface

     
        

 
         
         		[bookmark: pgfId-899054]Interface role

 [bookmark: pgfId-899056]If you can edit the role, a pencil image overlays the icon.

     
        

 
         
         		[bookmark: pgfId-899065]Global “interface” on ASA 8.3+ devices, used for rules created as global instead of interface-specific.

     
        

 
       
      

 
     
 
     [bookmark: pgfId-904173]Related Topics

 
      
      		 [bookmark: pgfId-904178]Basic Interface Settings on Cisco IOS Routers

 
      		 [bookmark: pgfId-904183]Configuring Firewall Device Interfaces

 
      		 [bookmark: pgfId-904188]Understanding Interface Role Objects

 
      		 [bookmark: pgfId-904193]Creating Interface Role Objects

 
      		 [bookmark: pgfId-904198]Using Interface Roles When a Single Interface Specification is Allowed

 
     

 
    
 
     
      [bookmark: pgfId-904206][bookmark: 18963][bookmark: obman_cncpt_ExceptionalCasesWhenUsingInterfaceRoles]Using Interface Roles When a Single Interface Specification is Allowed[bookmark: marker-904204]

 
     [bookmark: pgfId-904208]Interface role objects can match a variable number of actual interfaces defined on a device depending on how you define the role. Thus, for a particular device, an interface role might match zero, one, or more than one interface. When you use an interface role in a policy, Security Manager converts the role to commands that configure all interfaces defined on the device that match the role.

 
     [bookmark: pgfId-904210]Many policies, however, require that you specify a single interface name. If you use an interface role in a situation where the policy allows a single interface name, you should define the interface role so that it matches a single interface. If you use an interface role that matches two or more interfaces on the device, Security Manager selects the first interface on the device that matches the role, which might not be the interface you desire (or that will work properly).

 
     [bookmark: pgfId-904212]Related Topics

 
      
      		 [bookmark: pgfId-904217]Specifying Interfaces During Policy Definition

 
      		 [bookmark: pgfId-904222]Understanding Interface Role Objects

 
      		 [bookmark: pgfId-904227]Creating Interface Role Objects

 
     

 
    
 
     
      [bookmark: pgfId-904239][bookmark: 18983][bookmark: pobjpage_cncpt_InterfaceNameConflictDialogBox]Handling Name Conflicts between Interfaces and Interface Roles[bookmark: marker-904235][bookmark: marker-904237]

 
     [bookmark: pgfId-904244]Under normal circumstances, you can configure an interface role that has the same name as an actual interface on the device. If you use object selectors when defining policies (see Selecting Objects for Policies), both the interface and the interface role are listed as available choices, enabling you to select either option. If you type in this common name when you define a policy, Security Manager automatically associates the interface role with the policy, not the interface.

 
     [bookmark: pgfId-904246]However, a naming conflict can occur under the following circumstances:

 
     [bookmark: pgfId-904248] 1. You type the name of an interface when defining a policy.

 
     [bookmark: pgfId-904250] 2. You later create an interface role that has the same name.

 
     [bookmark: pgfId-904252] 3. You type this name again when defining a policy.

 
     [bookmark: pgfId-904254] 4. You click Select to display the object selector, or Save to save the policy, or in some cases, OK to update the policy.

 
     [bookmark: pgfId-904256]When this sequence of events occurs, the Interface Name Conflict dialog box opens automatically so that you can select whether you want to specify the interface or the interface role. The dialog box lists only those names for which there are conflicts.

 
     [bookmark: pgfId-904258]Related Topics

 
      
      		 [bookmark: pgfId-904263]Specifying Interfaces During Policy Definition

 
      		 [bookmark: pgfId-904268]Understanding Interface Role Objects

 
     

 
    
 
   
 
    
     [bookmark: pgfId-904288][bookmark: 19019][bookmark: obman_cncpt_UnderstandingInspectionMapObjects]Understanding Map Objects[bookmark: marker-904274][bookmark: marker-904276][bookmark: marker-904278][bookmark: marker-904280][bookmark: marker-904282][bookmark: marker-904284][bookmark: marker-904286]

 
    [bookmark: pgfId-904290]The objects in the Maps folder in the Policy Object Manager allow you to configure class, parameter, and policy maps for inspection rules, zone-based firewall rules, or IPS, QoS and connection rules policies. The types of maps you can use with these policies depends on the operating system running on the device as well as the specific version number, so typically it is best to configure the maps when you are configuring the policies.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-904292]Tip Devices enforce unique names for all configured maps. For example, you cannot use the same name for an FTP and DNS class map on the same device. If you select maps with the same name for a device, Security Manager automatically adds a numerical suffix to the duplicate names, for example, dnsmap_1.


    
     

    

    

 
    [bookmark: pgfId-904294]The Maps folder contains the following folders. Subfolders organize the maps based on whether they are used for inspection or web content filtering.

 
     
     		 [bookmark: pgfId-904296]Class Maps—Layer 7 class maps used for identifying traffic that you want to act on.

 
     		 [bookmark: pgfId-904298]Parameter Maps—Parameter maps that configure settings used in zone-based firewall rules policies or other maps.

 
     		 [bookmark: pgfId-904300]Policy Maps—Layer 7 policy maps used for identifying the action to take on selected traffic.

 
    

 
    [bookmark: pgfId-904302]Also included in the Maps folder are entries for TCP Map objects (a Layer 4 object), Regular Expression objects, and Regular Expression Group objects.

 
    [bookmark: pgfId-904304]The following sections describe the different types of maps in more detail.

 
    [bookmark: pgfId-904306]Class Maps

 
    [bookmark: pgfId-904308]Class maps are subordinate to policy maps. You cannot specify a class map directly in a device policy. Instead, you create a policy map to incorporate the class map. The class map itself defines the match conditions for the traffic that you want to target in an inspection rule or zone-based firewall rule.

 
     
     		 [bookmark: pgfId-904310]ASA/PIX 7.2 and higher, and FWSM devices—You can create class maps for the inspection of DNS, FTP, HTTP, IM, and SIP traffic. You also have the option of defining the traffic match directly in the policy map object, but if you create separate class maps, you can reuse them in more than one policy map.

 
     		 [bookmark: pgfId-904312]IOS 12.4(6)T and higher devices—You can create class maps for the inspection of IM applications (AOL, ICQ, MSN Messenger, Windows Messenger, and Yahoo Messenger), P2P applications (eDonkey, FastTrack, Gnutella, Kazaa2), H.323, HTTP, IMAP, POP3, SIP, SMTP, Sun RPC. You can also create class maps for filtering web content using the Local, N2H2, Trend, and Websense objects.

 
    

 
    [bookmark: pgfId-904314]Unlike the class maps used for ASA/PIX/FWSM, you must create separate class maps and refer to them from the related policy maps. You can use these policy maps in zone-based firewall inspection or content filtering rules. For more information, see these topics:

 
    [bookmark: pgfId-904319] – Configuring Inspection Maps for Zone-based Firewall Policies

 
    [bookmark: pgfId-904324] – Configuring Content Filtering Maps for Zone-based Firewall Policies

 
    [bookmark: pgfId-904326]To create class maps, see these topics:

 
     
     		 [bookmark: pgfId-904331]Configuring Class Maps for Inspection Policies

 
     		 [bookmark: pgfId-904336]Configuring Class Maps for Zone-Based Firewall Policies

 
    

 
    [bookmark: pgfId-904338]To create the regular expressions and regular expression groups that you can use in class, parameter, and policy maps, see these topics:

 
     
     		 [bookmark: pgfId-904343]Add/Edit Regular Expressions

 
     		 [bookmark: pgfId-904348]Configuring Regular Expression Groups

 
    

 
    [bookmark: pgfId-904350]Parameter Maps

 
    [bookmark: pgfId-904352]Parameter maps define settings that you can use in zone-based firewall inspection or content filtering rules, or in other policy map objects.

 
     
     		 [bookmark: pgfId-904354]Inspection—You can create Inspection Parameter maps for general zone-based firewall rule parameters, or Protocol Info Parameter maps for use with IM application inspection.

 
     		 [bookmark: pgfId-904356]Content Filtering—You can create the following parameter maps to define web content filtering: Local, N2H2, Trend, URL Filter, URLF Glob, Websense.

 
    

 
    [bookmark: pgfId-904358]Policy Maps

 
    [bookmark: pgfId-904360]You can configure policy maps to alter the default actions of inspection or to configure web content filtering in zone-based firewall settings policies. Policy maps typically apply to applications that require special handling, perhaps due to embedded IP address information or the fact that the traffic opens secondary channels on dynamically assigned ports.

 
    [bookmark: pgfId-904362]The policy map identifies the action to take on traffic that matches the conditions identified in the map. For most policy maps, you can specify traffic match conditions by referring to a class map. However, some policy maps require that you specify the match criteria within the policy map.

 
    [bookmark: pgfId-904364]You can configure these types of policy maps:

 
     
     		 [bookmark: pgfId-904369]Inspection Rules—When configuring inspection rules, you can use Security Manager to create policy map objects for the following applications: DCE/RPC, DNS, ESMTP, FTP, GTP, H.323, HTTP, IM, IP options, IPsec, NetBIOS, SIP, Skinny, and SNMP. for more information, see Configuring Protocols and Maps for Inspection.

 
     		 [bookmark: pgfId-904374]Zone-Based Firewall Inspection Rules—When configuring zone-based firewall inspection rules, you can use Security Manager to create policy map objects for the following applications: H.323, HTTP, IM (includes AOL, ICQ, MSN Messenger, Windows Messenger, and Yahoo Messenger), IMAP, P2P (includes eDonkey, FastTrack, Gnutella, Kazaa2), POP3, SIP, SMTP, Sun RPC. For more information, see Configuring Inspection Maps for Zone-based Firewall Policies.

 
     		 [bookmark: pgfId-904379]Zone-Based Firewall Content Filtering Rules—When configuring zone-based firewall content filtering rules, you can use Security Manager to create Web Filter policy maps. You can also configure HTTP policy maps to inspect HTTP traffic. For more information, see Configuring Content Filtering Maps for Zone-based Firewall Policies.

 
     		 [bookmark: pgfId-904387]IPS, QoS and Connection Rules—When configuring this service policy, which is specific to PIX 7.x+ and ASA devices, you can customize TCP inspection using a TCP map. For more information, see Configuring TCP Maps and Chapter 57, “Configuring Service Policy Rules on Firewall Devices”.

 
    

 
   
 
    
     [bookmark: pgfId-904401][bookmark: 19116][bookmark: obman_cncpt_UnderstandingNetworkHostObjects]Understanding Networks/Hosts Objects [bookmark: marker-904393][bookmark: marker-904395][bookmark: marker-904397][bookmark: marker-904399]

 
    [bookmark: pgfId-904403]Networks/Hosts objects are logical collections of IP addresses that represent networks, hosts, or both.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-904408]Note As of Security Manager 4.4, there are no longer separate IPv4 and IPv6 Networks/Hosts objects—there is now a single, unified Networks/Hosts object, which may accept IPv4 addresses, IPv6 addresses, or both (in the case of group objects). However, group objects containing a mixture of IPv4 and IPv6 addresses can be assigned only to policies on ASA 9.0.1 and later devices. See Policy Object Changes in Security Manager 4.4 for more information.


    
     

    

    

 
    [bookmark: pgfId-904410]When you create a Networks/Hosts object, you must choose the type of object, which defines and limits the type of addresses the object can contain:

 
     
     		 [bookmark: pgfId-904412]Group – You can include combinations of any of the following types of addresses:

 
    

 
    [bookmark: pgfId-904414] – Networks or subnets, specified by IPv4 addresses and subnet masks, or IPv6 prefixes and prefix lengths.

 
    [bookmark: pgfId-904416] – Ranges of IPv4 or IPv6 network addresses.

 
    [bookmark: pgfId-904418] – Individual hosts, specified by IPv4 or IPv6 addresses (but not a domain name).

 
    [bookmark: pgfId-904420] – Other network/host objects, selected from a list of existing Networks/Hosts objects, including fully qualified domain name (FQDN) objects.

 
     
     		 [bookmark: pgfId-904422]FQDN – (ASA 8.4(2+) only) This object can contain a single host’s fully qualified domain name, such as myhost.cisco.com. The device uses DNS to periodically resolve the FQDN to its IP address.

 
     		 [bookmark: pgfId-904424]Host – This object can contain a single host IPv4 or IPv6 address, such as 10.100.10.10 or 2001:DB8::0DB8:800:200C:417A.

 
     		 [bookmark: pgfId-904426]Address Range – This object can contain a single range of IPv4 or IPv6 addresses; the start and end addresses must be different, with the start being lower than the end.

 
     		 [bookmark: pgfId-904428]Network – This object can contain a single IPv4 network address and subnet mask, such as 10.100.10.0/24, or a single IPv6 prefix and prefix length, such as 2001:DB8::/32.

 
    

 
    [bookmark: pgfId-904430]Networks/Hosts group objects make it easier to manage scalable policies. By using the associative capabilities of Networks/Hosts objects, you can expand your policies along with your network. For example, when you make changes to the list of addresses contained in a Networks/Hosts object, the changes propagate to all other Networks/Hosts objects, and to policies that refer to that Networks/Hosts object.

 
    [bookmark: pgfId-904432]The host, network, and address range objects have special uses when used in policies for an ASA 8.3+ device. On these devices, you can configure object NAT rules in the policy object itself. If you use the object on other types of device, this NAT configuration is ignored.

 
    [bookmark: pgfId-904434]The following topics describe how to work with Networks/Hosts objects:

 
     
     		 [bookmark: pgfId-904439]Contiguous and Discontiguous Network Masks for IPv4 Addresses

 
     		 [bookmark: pgfId-904444]Creating Networks/Hosts Objects

 
     		 [bookmark: pgfId-904449]Using Unspecified Networks/Hosts Objects

 
     		 [bookmark: pgfId-904454]Specifying IP Addresses During Policy Definition

 
    

 
     
      [bookmark: pgfId-904466][bookmark: 19172][bookmark: obman_cncpt_ContiguousandDiscontiguousNetworkMasks]Contiguous and Discontiguous Network Masks for IPv4 Addresses[bookmark: marker-904460][bookmark: marker-904462][bookmark: marker-904464]

 
     [bookmark: pgfId-904468]A network mask determines which portion of an IPv4 address identifies the network and which portion identifies the host. Like the IP address, the mask is represented by four octets. (An octet is an 8-bit binary number equivalent to a decimal number in the range 0-255.) If a given bit of the mask is 1, the corresponding bit of the IP address is in the network portion of the address, and if a given bit of the mask is 0, the corresponding bit of the IP address is in the host portion.

 
     [bookmark: pgfId-904470]Standard, or contiguous, network masks start with zero or more 1s followed by zero or more 0s. This kind of network mask is considered contiguous because it represents a network that consists of a contiguous IP address range. For example, the network 192.168.1.0/255.255.255.0 contains all the IP addresses ranging from 192.168.1.0 to 192.168.1.255.

 
     [bookmark: pgfId-904472]The following table shows different methods of representing commonly used standard network masks:

 
     [bookmark: pgfId-904475] 

 
      
       
        
        [bookmark: pgfId-899081]Table 6-29 [bookmark: 19187]Standard Network Masks 

 
        
       
         
         		
           
           [bookmark: pgfId-899087]Dotted Decimal Notation
          
  
         		
           
           [bookmark: pgfId-899089]Classless Inter-Domain Routing (CIDR) Notation
          
  
        

 
         
         		[bookmark: pgfId-899095]255.0.0.0

  
         		[bookmark: pgfId-899097]/8

  
        

 
         
         		[bookmark: pgfId-899103]255.255.0.0

  
         		[bookmark: pgfId-899105]/16

  
        

 
         
         		[bookmark: pgfId-899111]255.255.255.0

  
         		[bookmark: pgfId-899113]/24

  
        

 
         
         		[bookmark: pgfId-899119]255.255.255.255

  
         		[bookmark: pgfId-899121]/32

  
        

 
       
      

 
     
 
     [bookmark: pgfId-904477]For example, 255.255.255.0 indicates that the first three octets of the IP address (24 bits or /24 in CIDR notation) are made up of ones and identify the network; the last octet is made up of zeros and identifies the host.

 
     [bookmark: pgfId-904481]Discontiguous Network Masks[bookmark: marker-904479]

 
     [bookmark: pgfId-904483]Nonstandard, or discontiguous, network masks are masks that do not conform to the contiguous format. For example, 10.0.1.1/255.0.255.255 indicates that you want to match an address that matches octets 1, 3, and 4 exactly, but any value in octet 2 is accepted.

 
     [bookmark: pgfId-904485]Although discontiguous network masks are not typically used for network configurations, they are sometimes used for certain commands, such as filtering commands when defining access control lists (ACLs). Security Manager supports the use of nonstandard network masks in the policies whose CLI commands support them. An error is displayed if you try to define a discontiguous network mask in a policy that does not support them.

 
     [bookmark: pgfId-904491]Network Masks and Discovery[bookmark: marker-904487][bookmark: marker-904489]

 
     [bookmark: pgfId-904493]During discovery, Security Manager attempts to match network/host objects with existing equivalent objects defined in the Policy Object Manager:

 
      
      		 [bookmark: pgfId-904495]For contiguous network masks—Two network/host objects containing only standard networks are considered equivalent if they consist of the same set of IP addresses.

 
      		 [bookmark: pgfId-904497]For discontiguous network masks—Two network/host objects are considered equivalent only if the standard networks consist of the same set of IP addresses and the nonstandard networks are syntactically equivalent.

 
     

 
     [bookmark: pgfId-904501]How Network Masks are Displayed[bookmark: marker-904499]

 
     [bookmark: pgfId-904503]Although you can enter both contiguous and discontiguous network masks using dotted decimal notation, all contiguous network masks are converted to CIDR notation. This makes it easier to distinguish them from discontiguous network masks, which are displayed in dotted decimal notation only.

 
     [bookmark: pgfId-904505]Related Topics

 
      
      		 [bookmark: pgfId-904510]Creating Networks/Hosts Objects

 
      		 [bookmark: pgfId-904515]Specifying IP Addresses During Policy Definition

 
      		 [bookmark: pgfId-904520]Using Unspecified Networks/Hosts Objects

 
      		 [bookmark: pgfId-904525]Understanding Networks/Hosts Objects

 
     

 
    
 
     
      [bookmark: pgfId-904539][bookmark: 19261][bookmark: obman_proc_CreatingNetworkHostObjects]Creating Networks/Hosts Objects[bookmark: marker-904531][bookmark: marker-904533][bookmark: marker-904535][bookmark: marker-904537]

 
     [bookmark: pgfId-904541]You can create Networks/Hosts objects to represent networks, individual hosts, or groups of both. When you create a Networks/Hostst object, you must choose the type of object (group, host, FQDN, network, address range). Once created, you cannot change the object type.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-904546]Tip You can create Networks/Hosts objects “on the fly” when defining policies or objects that use this object type. For more information, see Selecting Objects for Policies.


     
      

     

     

 
     [bookmark: pgfId-904548]Related Topics

 
      
      		 [bookmark: pgfId-904553]Understanding Networks/Hosts Objects

 
      		 [bookmark: pgfId-904558]Creating Policy Objects

 
      		 [bookmark: pgfId-904563]Contiguous and Discontiguous Network Masks for IPv4 Addresses

 
      		 [bookmark: pgfId-904568]Specifying IP Addresses During Policy Definition

 
      		 [bookmark: pgfId-904573]Using Unspecified Networks/Hosts Objects

 
      		 [bookmark: pgfId-904578]How Network/Host, Port List, and Service Objects are Named When Provisioned As Object Groups

 
     

 
     
 
     [bookmark: pgfId-904583]Step 1 Choose Policy Objects from the Manage menu, or click the Policy Object Manager button in the button bar, to open the Policy Object Manager pane in the lower section of the Configuration Manager window; see Policy Object Manager for more information.

 
     [bookmark: pgfId-904585]Step 2 Select Networks/Hosts in the Object Type selector.

 
     [bookmark: pgfId-904590]Step 3 Click the New Object button at the bottom of the window and choose one of the following types of Networks/Hosts object to open the Add or Edit Network/Host Dialog Box. You also can right-click in the work area, choose New Object, and then choose one of the following options to open the dialog box.

 
      
      		 [bookmark: pgfId-904592] Group – To create an object that has one or more entry. You can include any combination of networks, hosts, address ranges, or other network/host objects (including FQDN objects).

 
      		 [bookmark: pgfId-904594] FQDN – (ASA 8.4(2+) only) To create an object with a single host’s fully qualified domain name, such as myhost.cisco.com.

 
      		 [bookmark: pgfId-904596] Host – To create an object with a single host address, such as 10.100.10.10 or 2001:DB8::12ab:5689.

 
      		 [bookmark: pgfId-904598] Address Range – To create an object with a single range of addresses, such as 10.100.10.1-10.100.10.255.

 
      		 [bookmark: pgfId-904600] Network – To create an object with a single network address, such as 10.100.10.0/24 or 2001:DB8::/32.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-904602]Tip Host, network, and address range objects also let you configure object NAT rules for ASA 8.3+ devices. Any NAT configuration is ignored for other devices.


     
      

     

     

 
     [bookmark: pgfId-904607]Step 4 Provide the appropriate information in the Add or Edit Network/Host Dialog Box.

 
     [bookmark: pgfId-904609]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-904625][bookmark: 19336][bookmark: pobjpage_cncpt_NetworkHostDialogBox]Add or Edit Network/Host Dialog Box [bookmark: marker-904619][bookmark: marker-904621][bookmark: marker-904623]

 
     [bookmark: pgfId-904627]Use the Add or Edit Network/Host dialog box to view, create, or edit network/host objects. The title, content and appearance of the dialog box differ slightly based on the type of network/host object you are creating: Group, FQDN, Host, Address Range, or Network. (FQDN objects require ASA 8.4.2 or later devices.) The Group type lets you enter multiple definitions, so you can have a collection of networks, hosts, and other network/host objects, whereas the other types allow a single definition only.

 
     [bookmark: pgfId-904632]The Host, Network, and Address Range versions of the dialog box provide two tabbed panels of options: General and NAT. Options on the General panel and the non-tabbed versions of the dialog box are described in the following table; the NAT options are described in Add or Edit Network/Host Dialog Box: NAT Tab.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-904634]Note As of Security Manager 4.4, there are no longer separate IPv4 and IPv6 Networks/Hosts objects—there is now a single, unified Networks/Hosts object, which may accept IPv4 addresses, IPv6 addresses, or both (in the case of group objects only). However, group objects containing a mixture of IPv4 and IPv6 addresses can be assigned only to policies on ASA 9.0.1 and later devices.


     
      

     

     

 
     [bookmark: pgfId-904639]When you create IPv4-based Host, Network, or Address Range objects for use on ASA 8.3+ devices, or unified Host, Network, or Address Range objects for use on ASA 9.0.1+ devices, you can also configure object NAT rules on the NAT tab of the dialog box. In both cases, you must select Allow Value Override per Device to allow object NAT. For reference information on the NAT tab, see Add or Edit Network/Host Dialog Box: NAT Tab.

 
     [bookmark: pgfId-904644]In addition, you can create an object with no addresses. For this type of object, you must also select Allow Value Override per Device and create overrides for every device that uses the object. For more information about using unspecified addresses, see Using Unspecified Networks/Hosts Objects.

 
     [bookmark: pgfId-904646]Navigation Path

 
     [bookmark: pgfId-904648]Choose Policy Objects from the Manage menu, or click the Policy Object Manager button in the button bar, to open the Policy Object Manager pane in the lower section of the Configuration Manager window. Select Networks/Hosts from the Object Type Selector. Right-click inside the work area and select New Object (and select an object type), or right-click a row and select Edit Object; you also can use the related buttons at the bottom of the pane to open either dialog box.

 
     [bookmark: pgfId-904650]Related Topics

 
      
      		 [bookmark: pgfId-904655]Creating Networks/Hosts Objects

 
      		 [bookmark: pgfId-904660]Understanding Networks/Hosts Objects

 
      		 [bookmark: pgfId-904665]Policy Object Manager

 
      		 [bookmark: pgfId-904670]How Network/Host, Port List, and Service Objects are Named When Provisioned As Object Groups

 
      		 [bookmark: pgfId-904675]Filtering Items in Selectors

 
     

 
     [bookmark: pgfId-904677]Field Reference

 
     [bookmark: pgfId-904680] 

 
      
       
        
        [bookmark: pgfId-899134]Table 6-30 [bookmark: 19389]Network/Host Dialog Box (General Tab) 

 
        
       
         
         		
           
           [bookmark: pgfId-899140]Element
          
  
         		
           
           [bookmark: pgfId-899142]Description
          
  
        

 
         
         		[bookmark: pgfId-899148]Name

  
         		[bookmark: pgfId-899153]The object name (up to 64 characters). Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
        

 
         
         		[bookmark: pgfId-899159]Description

  
         		[bookmark: pgfId-899161]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-899167]Category

  
         		[bookmark: pgfId-899172]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-899178]Allow Value Override per Device

 [bookmark: pgfId-899180]Overrides

 [bookmark: pgfId-899182]Edit button

  
         		[bookmark: pgfId-899190]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-899192]Tip If you configure NAT for host, address range, or network objects, you must select this option. The NAT configuration is created as a device override and is not kept in the object. [bookmark: pgfId-899194]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
         
         		 
           
           [bookmark: pgfId-899200]Group object options
          
  
        

 
         
         		[bookmark: pgfId-899208]Available Networks/Hosts

 [bookmark: pgfId-899210]Members In Group

 [bookmark: pgfId-899212]Type in comma separated IP addresses

  
         		[bookmark: pgfId-899214]The Members In Group list shows the networks, hosts, and other network/host objects that are included in this object. To populate the list, do any combination of the following:

 
           
           		 [bookmark: pgfId-899216]Select one or more Address, FQDN, Group, Host, Network objects in the Existing Networks/Hosts list and then click the >> button between the lists.

 
           		 [bookmark: pgfId-899218]Type one or more IP addresses in the “Type in comma separated IP addresses” field and then click the >> button between the lists. Separate multiple addresses with commas; they are added as separate lines in the Members list.

 
          

 [bookmark: pgfId-899220]For IPv4 addresses, you can include host addresses, network addresses (with subnet masks entered after a / character, such as 10.100.10.0/24), or a range of addresses (separate the starting and ending address with a hyphen, and optionally include a subnet mask).

 [bookmark: pgfId-899222]For IPv6 addresses, you can include host addresses, network addresses (with prefixes entered after a / character, such as 2001:DB8::/32), or a range of addresses (such as 2001:DB8::1-2001:DB8::100).

 [bookmark: pgfId-899227]See Specifying IP Addresses During Policy Definition for more information.

 
           
           		 [bookmark: pgfId-899229]To remove an item from the Members In Group list, select it and click the appropriate << button to return the item to its source location. You can select and remove multiple items at one time.

 
          

 [bookmark: pgfId-899231]Note Group objects containing a mixture of IPv4 and IPv6 addresses can be assigned only to policies on ASA 9.0.1 and later devices.

  
        

 
         
         		 
           
           [bookmark: pgfId-899237]FQDN object options
          
  
        

 
         
         		[bookmark: pgfId-899245]FQDN

 [bookmark: pgfId-899247]FQDN Type

  
         		[bookmark: pgfId-899249]The fully qualified domain name of a single host; for example, somehost.cisco.com.

 [bookmark: pgfId-899251]The FQDN Type specifies the type of IP address mapped to the provided domain: IPv4 Only, IPv6 Only, or Default, which applies a device-specific default; for all non-ASA and pre-9.0.1 ASA devices, the default is IPv4.

  
        

 
         
         		 
           
           [bookmark: pgfId-899257]Host object options
          
  
        

 
         
         		[bookmark: pgfId-899265]IP Address

  
         		[bookmark: pgfId-899267]The IPv4 or IPv6 address of the single host to include in the object.

  
        

 
         
         		 
           
           [bookmark: pgfId-899273]Address Range object options
          
  
        

 
         
         		[bookmark: pgfId-899281]Start IP Address

 [bookmark: pgfId-899283]End IP Address

  
         		[bookmark: pgfId-899285]The first and last IP address that define a range of addresses. The start and end addresses must be different, with the start being lower than the end.

  
        

 
         
         		 
           
           [bookmark: pgfId-899291]Network object options
          
  
        

 
         
         		[bookmark: pgfId-899299]IP Address

 [bookmark: pgfId-899301]Net Mask/Prefix

  
         		[bookmark: pgfId-899303]The IPv4 or IPv6 address that represents the network; for example, 10.100.10.0 or 2001:DB8::/32.

 [bookmark: pgfId-899305]If you entered an IPv4 address, enter its subnet mask in the Net Mask/Prefix field. You can type a mask in either CIDR format, for example, 24 (without the forward slash), or in dotted decimal format, for example, 255.255.255.0.

 [bookmark: pgfId-899307]If you entered an IPv6 address, enter its prefix length in the Net Mask/Prefix field.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-904692][bookmark: 19502][bookmark: obman_proc_UsingUnspecifiedNetworkHostObjects]Using Unspecified Networks/Hosts Objects[bookmark: marker-904686][bookmark: marker-904688][bookmark: marker-904690]

 
     [bookmark: pgfId-904694]When you define a Networks/Hosts object, you can leave the address fields blank, thereby creating a Networks/Hosts object with an unspecified value. Networks/Hosts objects with unspecified values require that you create overrides for every device that uses them.

 
     [bookmark: pgfId-904696]The advantage of using a Networks/Hosts object with an unspecified value is that Security Manager displays an error if you submit your changes without creating a device-level override on every device using the object. By contrast, when you define the global object with a placeholder value (such as, 10.10.10.10), that global value could be deployed by mistake if you fail to define an override.

 
     [bookmark: pgfId-904698]The following procedure describes how to create and implement Networks/Hosts objects with unspecified values.

 
     [bookmark: pgfId-904700]Related Topics

 
      
      		 [bookmark: pgfId-904705]Creating Networks/Hosts Objects

 
      		 [bookmark: pgfId-904710]Understanding Policy Object Overrides for Individual Devices

 
      		 [bookmark: pgfId-904715]Contiguous and Discontiguous Network Masks for IPv4 Addresses

 
      		 [bookmark: pgfId-904720]Specifying IP Addresses During Policy Definition

 
      		 [bookmark: pgfId-904725]Understanding Networks/Hosts Objects

 
     

 
     
 
     [bookmark: pgfId-904727]Step 1 Create a Networks/Hosts object, making sure to:

 
      
      		 [bookmark: pgfId-904729]Leave the address fields blank (for example, the Members in Group, IP Address and Net Mask/Prefix, FQDN, or Start and End IP Address).

 
      		 [bookmark: pgfId-904731]Select the  Allow Value Override per Device check box.

 
     

 
     [bookmark: pgfId-904736]For more information, see Creating Networks/Hosts Objects.

 
     [bookmark: pgfId-904738]Step 2 Create overrides for each device that will use the object:

 
     [bookmark: pgfId-904743] a. Click the green checkmark in the Overrides column for the object in the Networks/Hosts table to open the Policy Object Overrides Window.

 
     [bookmark: pgfId-904748] b. Click the Create Override button and select the devices on which you want to create overrides, then define a value in the address field. At this point, this override value applies to all the selected devices. For more information, see Creating or Editing Object Overrides for Multiple Devices At A Time.

 
     [bookmark: pgfId-904750] c. Double-click each device in the Policy Object Overrides dialog box, then modify the address field for the value required by that device.

 
     [bookmark: pgfId-904752]Step 3 Define a policy that requires this object. You can use one of two methods:

 
      
      		 [bookmark: pgfId-904760]Define the policy on a single device in Device view, share the policy, then assign the policy to the other devices. See Sharing a Local Policy and Modifying Shared Policy Assignments in Device View or the Site-to-Site VPN Manager.

 
      		 [bookmark: pgfId-904765]Create a shared policy in Policy view, then assign the policy to the other devices using the Assignments tab. See Modifying Policy Assignments in Policy View.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-904767]Note You can create a Networks/Hosts group object that refers to a Networks/Hosts object with an unspecified value. You do not have to create the device-level overrides before you assign the policy containing the object to devices.


     
      

     

     

 
     [bookmark: pgfId-904769]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-904781][bookmark: 19573][bookmark: obman_cncpt_SpecifyingIPAddressesDuringPolicyDefinition]Specifying IP Addresses During Policy Definition [bookmark: marker-904775][bookmark: marker-904777][bookmark: marker-904779]

 
     [bookmark: pgfId-904783]Many policies and policy objects require that you enter an IP address for a host or network. For some policies or objects, you must enter just a host, or just a network. For other policies or objects, you can enter some combination of hosts and networks. You are prevented from entering or selecting addresses that are not appropriate for the circumstances.

 
     [bookmark: pgfId-904785]The following is a description of all acceptable formats that you can use, both for IPv4 and IPv6 addresses, although a particular policy or object might not allow specific formats (for example, interface roles are allowed as address designations in only a very limited number of policies). If the policy or object allows it, you can enter multiple addresses by separating them with commas.

 
      
      		 [bookmark: pgfId-904787]Networks/Hosts object. Enter the name of the object or click  Select to select it from a list. You can also create new Networks/Hosts objects from the selection list.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-904789]Note The only way to specify a fully qualified domain name (FQDN) is to use an FQDN Networks/Hosts object, or a group object that includes an FQDN object. You cannot directly type in an FQDN.


     
      

     

     

 
      
      		 [bookmark: pgfId-904791]Host IP address, in v4 or v6 format.

 
     

 
     [bookmark: pgfId-904793] – Complete IPv4 address; for example, 10.10.10.100

 
     [bookmark: pgfId-904795] – Complete IPv6 address, showing all eight components. For example, 2001:DB8:0:0:0DB8:800:200C:417A. It is not necessary to include the leading zeros in an individual field. Security Manager converts the address to compressed format if possible.

 
     [bookmark: pgfId-904797] – Compressed IPv6 address, where a group of fields is replaced by two colons (::). It is common for IPv6 addresses to contain successive hexadecimal fields of zeros. To make IPv6 addresses less cumbersome, you can use two colons (::) to compress successive hexadecimal fields of zeros at the beginning, middle, or end of an IPv6 address (the colons represent successive hexadecimal fields of zeros). You can use :: at most once in an IPv6 address. For example, 2001:DB8::0DB8:800:200C:417A. The unspecified address, 0:0:0:0:0:0:0:0, can be represented as ::. The loopback address is ::1.

 
     [bookmark: pgfId-904799] – IPv6 representation of an IPv4 address. When dealing in mixed IPv4/IPv6 environments, you can represent the IPv4 addresses in an alternate IPv6 format: x:x:x:x:x:x:d.d.d.d, where the Xs are the hexadecimal values of the first 6 fields, and the Ds are the IPv4 address with the octets separated by periods. The first 6 fields are either all zeros, ::FFFF, or 2001:DB8::. For example, 0:0:0:0:0:0:10.1.68.3, which in compressed format is ::10.1.68.3, or 0:0:0:0:0:FFFF:10.1.68.3, or 2001:DB8::10.1.68.3.

 
      
      		 [bookmark: pgfId-904801]Network address, in either IPv4 or IPv6 format:

 
     

 
     [bookmark: pgfId-904803] – IPv4 address, including subnet mask, in either CIDR format (10.10.10.0/24), or dotted decimal format (10.10.10.0/255.255.255.0).

 
     [bookmark: pgfId-904805] – IPv6 address, including the prefix length in decimal format in a manner similar to CIDR notation for IPv4, for example, /64. The number specifies the number of the left-most contiguous bit of the address that comprise the prefix. For example, 2001:DB8:0:CD30::/60.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-904807]Note You could also enter 2001:DB8:0:CD30::/60 as 2001::CD30:0:0:0:0/60. However, compressing the trailing zeros is the preferred method, and Security Manager will translate the address to 2001:DB8:0:CD30::/60.


     
      

     

     

 
     [bookmark: pgfId-904811]For more detailed information on IPv6 addressing, see the IETF RFC 4291, IP Version 6 Addressing Architecture, at http://www.ietf.org/rfc/rfc4291.txt.

 
      
      		 [bookmark: pgfId-904813]A range of IP addresses. Separate the beginning and ending addresses with a hyphen. The range does not need to be within a single subnet unless the policy requires it.

 
     

 
     [bookmark: pgfId-904815]You can also include a prefix or subnet mask in CIDR format; for example, 2001:db8::1 - 2001:db8::2/64, or 10.10.10.100-10.10.10.200/24.

 
      
      		 [bookmark: pgfId-904820]An IPv4 address pattern in the format 10.10.0.10/255.255.0.255, where the mask is a discontiguous bit mask (see Contiguous and Discontiguous Network Masks for IPv4 Addresses).

 
      		 [bookmark: pgfId-904825]Interface role object (in rare cases). Enter the name of the object or click  Select to select it from a list (you must select Interface Role as the object type). When you use an interface role, the rule behaves as if you supplied the IP address of the selected interface. This is useful for interfaces that get their address through DHCP, because you do not know what IP address will be assigned to the device. For more information, see Understanding Interface Role Objects.

 
     

 
     [bookmark: pgfId-904827]When you create a network/host object or define IP addresses as part of a policy, Security Manager verifies that the syntax of the address is correct and that a mask or prefix was entered when required. For example, when you define a policy that requires a host, you do not need to enter a mask/prefix. However, when you define a policy that requires a subnet, you must enter the address with the mask/prefix, or select a network/host object that has a mask/prefix defined.

 
     [bookmark: pgfId-904829]Related Topics

 
      
      		 [bookmark: pgfId-904834]Creating Networks/Hosts Objects

 
      		 [bookmark: pgfId-904839]Contiguous and Discontiguous Network Masks for IPv4 Addresses

 
      		 [bookmark: pgfId-904844]Using Unspecified Networks/Hosts Objects

 
      		 [bookmark: pgfId-904849]Policy Object Manager

 
      		 [bookmark: pgfId-904854]Understanding Networks/Hosts Objects

 
     

 
    
 
   
 
    
     [bookmark: pgfId-904864][bookmark: 19644][bookmark: obman_cncpt_UnderstandingPoolObjects]Understanding Pool Objects[bookmark: marker-904860][bookmark: marker-904862]

 
    [bookmark: pgfId-904866]Pool objects have the following uses:

 
     
     		 [bookmark: pgfId-904868]Specifying pools for use in Layer 3 load balancing for ASA clusters

 
     		 [bookmark: pgfId-904870]Specifying pools for use in Layer 3 EIGRP and OSPFv3 on ASA clusters

 
    

 
    [bookmark: pgfId-904872]The following topics describe how to work with pool objects:

 
     
     		 [bookmark: pgfId-904877]Add or Edit IPv4 Pool Dialog Box

 
     		 [bookmark: pgfId-904882]Add or Edit IPv6 Pool Dialog Box

 
     		 [bookmark: pgfId-904887]Add or Edit MAC Address Pool Dialog Box

 
    

 
     
      [bookmark: pgfId-904901][bookmark: 19670][bookmark: pobjpage_cncpt_AddEditIPv4PoolObject]Add or Edit IPv4 Pool Dialog Box[bookmark: marker-904895][bookmark: marker-904897][bookmark: marker-904899]

 
     [bookmark: pgfId-904903]Use the Add or Edit IPv4 Pool dialog box to view, create, or edit IPv4 pool objects.

 
     [bookmark: pgfId-904905]Navigation Path

 
     [bookmark: pgfId-904907]Choose Policy Objects from the Manage menu, or click the Policy Object Manager button in the button bar, to open the Policy Object Manager pane in the lower section of the Configuration Manager window. Select Pool Objects > IPv4 Pool Object from the Object Type Selector. Right-click inside the work area and select New Object (and select an object type), or right-click a row and select Edit Object; you also can use the related buttons at the bottom of the pane to open either dialog box.

 
     [bookmark: pgfId-904909]Related Topics

 
      
      		 [bookmark: pgfId-904914]Policy Object Manager

 
      		 [bookmark: pgfId-904919]Selecting Objects for Policies

 
     

 
     [bookmark: pgfId-904921]Field Reference

 
     [bookmark: pgfId-904924] 

 
      
       
        
        [bookmark: pgfId-899320]Table 6-31 [bookmark: 19701]Add IPv4 Pool Object Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-899326]Element
          
  
         		
           
           [bookmark: pgfId-899328]Description
          
  
        

 
         
         		[bookmark: pgfId-899334]Name

  
         		[bookmark: pgfId-899339]The object name (up to 64 characters). Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
        

 
         
         		[bookmark: pgfId-899345]Description

  
         		[bookmark: pgfId-899347]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-899353]Type

  
         		[bookmark: pgfId-899355]Select whether the pool object is a single IP address or a range of IP addresses.

  
        

 
         
         		[bookmark: pgfId-899361]Address

  
         		[bookmark: pgfId-899363]The IPv4 address of the single host to include in the object.

  
        

 
         
         		[bookmark: pgfId-899369]Start Address

 [bookmark: pgfId-899371]End Address

  
         		[bookmark: pgfId-899373]The first and last IP address that define a range of addresses. The start and end addresses must be different, with the start being lower than the end.

  
        

 
         
         		[bookmark: pgfId-899379]Mask

  
         		[bookmark: pgfId-899381]The subnet mask for the IP address or address range.

  
        

 
         
         		[bookmark: pgfId-899387]Category

  
         		[bookmark: pgfId-899392]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-899398]Allow Value Override per Device

 [bookmark: pgfId-899400]Overrides

 [bookmark: pgfId-899402]Edit button

  
         		[bookmark: pgfId-899410]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-899412]Note IPv4 Pool objects are always overridable. Clearing this option results in an error.

 [bookmark: pgfId-899414]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-904938][bookmark: 19763][bookmark: pobjpage_cncpt_AddEditIPv6PoolObject]Add or Edit IPv6 Pool Dialog Box[bookmark: marker-904932][bookmark: marker-904934][bookmark: marker-904936]

 
     [bookmark: pgfId-904940]Use the Add or Edit IPv6 Pool dialog box to view, create, or edit IPv6 pool objects.

 
     [bookmark: pgfId-904942]Navigation Path

 
     [bookmark: pgfId-904944]Choose Policy Objects from the Manage menu, or click the Policy Object Manager button in the button bar, to open the Policy Object Manager pane in the lower section of the Configuration Manager window. Select Pool Objects > IPv6 Pool Object from the Object Type Selector. Right-click inside the work area and select New Object (and select an object type), or right-click a row and select Edit Object; you also can use the related buttons at the bottom of the pane to open either dialog box.

 
     [bookmark: pgfId-904946]Related Topics

 
      
      		 [bookmark: pgfId-904951]Policy Object Manager

 
      		 [bookmark: pgfId-904956]Selecting Objects for Policies

 
     

 
     [bookmark: pgfId-904958]Field Reference

 
     [bookmark: pgfId-904961] 

 
      
       
        
        [bookmark: pgfId-899427]Table 6-32 [bookmark: 19794]Add IPv6 Pool Object Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-899433]Element
          
  
         		
           
           [bookmark: pgfId-899435]Description
          
  
        

 
         
         		[bookmark: pgfId-899441]Name

  
         		[bookmark: pgfId-899446]The object name (up to 64 characters). Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
        

 
         
         		[bookmark: pgfId-899452]Description

  
         		[bookmark: pgfId-899454]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-899460]Address

  
         		[bookmark: pgfId-899462]The IPv6 address in address/prefix length format to include in the object.

  
        

 
         
         		[bookmark: pgfId-899468]Count

  
         		[bookmark: pgfId-899470]The number of addresses to be included in the pool. Must be between 1 and 16384.

  
        

 
         
         		[bookmark: pgfId-899476]Category

  
         		[bookmark: pgfId-899481]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-899487]Allow Value Override per Device

 [bookmark: pgfId-899489]Overrides

 [bookmark: pgfId-899491]Edit button

  
         		[bookmark: pgfId-899499]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-899501]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-904975][bookmark: 19844][bookmark: pobjpage_cncpt_AddEditMACAddressPoolObject]Add or Edit MAC Address Pool Dialog Box[bookmark: marker-904969][bookmark: marker-904971][bookmark: marker-904973]

 
     [bookmark: pgfId-904977]Use the Add or Edit MAC Address Pool dialog box to view, create, or edit MAC Address pool objects.

 
     [bookmark: pgfId-904979]Navigation Path

 
     [bookmark: pgfId-904981]Choose Policy Objects from the Manage menu, or click the Policy Object Manager button in the button bar, to open the Policy Object Manager pane in the lower section of the Configuration Manager window. Select Pool Objects > MAC Address Pool Object from the Object Type Selector. Right-click inside the work area and select New Object (and select an object type), or right-click a row and select Edit Object; you also can use the related buttons at the bottom of the pane to open either dialog box.

 
     [bookmark: pgfId-904983]Related Topics

 
      
      		 [bookmark: pgfId-904988]Policy Object Manager

 
      		 [bookmark: pgfId-904993]Selecting Objects for Policies

 
     

 
     [bookmark: pgfId-904995]Field Reference

 
     [bookmark: pgfId-904998] 

 
      
       
        
        [bookmark: pgfId-899514]Table 6-33 [bookmark: 19875]Add MAC Address Pool Object Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-899520]Element
          
  
         		
           
           [bookmark: pgfId-899522]Description
          
  
        

 
         
         		[bookmark: pgfId-899528]Name

  
         		[bookmark: pgfId-899533]The object name (up to 64 characters). Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
        

 
         
         		[bookmark: pgfId-899539]Description

  
         		[bookmark: pgfId-899541]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-899547]Start MAC Address

 [bookmark: pgfId-899549]End MAC Address

  
         		[bookmark: pgfId-899551]The first and last MAC address that define a range of addresses. The start and end addresses must be different, with the start being lower than the end.

  
        

 
         
         		[bookmark: pgfId-899557]Category

  
         		[bookmark: pgfId-899562]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-899568]Allow Value Override per Device

 [bookmark: pgfId-899570]Overrides

 [bookmark: pgfId-899572]Edit button

  
         		[bookmark: pgfId-899580]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-899582]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-905020][bookmark: 19922][bookmark: obman_cncpt_UnderstandingServiceObjects]Understanding and Specifying Services and Service and Port List Objects[bookmark: marker-905004][bookmark: marker-905006][bookmark: marker-905008][bookmark: marker-905010][bookmark: marker-905012][bookmark: marker-905014][bookmark: marker-905016][bookmark: marker-905018]

 
    [bookmark: pgfId-905022]Many policies in Security Manager require that you identify a service to which the policy applies. A service is a protocol and port definition that identifies a particular type of traffic. In many cases, you can specify the service directly in the policy. You can also select service policy objects that define the required services, or use a combination of service objects and policy-specific service designations.

 
    [bookmark: pgfId-905024]Service objects are convenient because you can create objects to represent the composition of a particular application, or you can model them after the logical organizations that exist on your network, such as a development team or corporate department. There are two types of service policy object:

 
     
     		 [bookmark: pgfId-905026]Service group—Can contain one or more service, including other service objects. This is the type of service object that was available in all Security Manager 3.x releases.

 
     		 [bookmark: pgfId-905028]Service object—Can contain a single service.

 
    

 
    [bookmark: pgfId-905036]When configuring a policy that requires that you identify a service, you can select or create service objects by clicking the Select button next to the Services field. To create a new service from the selection dialog box, click the Add button beneath the service list and select a type: group or object. You can also create services from the Policy Object Manager by selecting Services > Services from the table of contents and clicking the Add Object button and selecting group or object. For information on the specific fields available when creating a service object, see Configuring Service Objects.

 
    [bookmark: pgfId-905041]Security Manager includes a comprehensive collection of predefined service group objects, including ICMP messages and objects for commonly used services such as HTTP, Syslog, POP3, Telnet, and SNMP. Before using a predefined service group object, you should review the object definition to verify that it conforms to your network implementation. If the predefined object does not meet your needs (for example, if you require different destination ports), you can create a new service object from scratch or based on a copy of an existing object. For more information, see Cloning (Duplicating) Objects.

 
    [bookmark: pgfId-905043]Whether you are creating a service object or specifying services directly in a policy, you can specify services using the following formats. As you type, Security Manager might prompt you with text-completion options related to your entry. You can select a value from the list and press Enter or Tab. You can enter more than one service by separating services with commas.

 
     
     		 [bookmark: pgfId-905045] protocol , where the protocol is 1-255 or a well known protocol name such as tcp, udp, gre, icmp, and so forth. If you enter a number, Security Manager might convert it to the associated name.

 
     		 [bookmark: pgfId-905047] icmp/  message_type / message_code , where the message type is 1 to 255 or a well-known ICMP message type name such as echo, and the message code is 0 to 255 (for example,  icmp/unreachable/1 or  icmp/echo-reply ).

 
     		 [bookmark: pgfId-905049] icmp6/  message_type / message_code , where the message type is 1 to 255 or a well-known ICMP message type name such as echo, and the message code is 0 to 255 (for example,  icmp6/unreachable/1 or  icmp6/echo-reply ).

 
     		 [bookmark: pgfId-905054] {tcp | udp | tcp&udp}/ { destination_port_number |  port_list_object } where the destination port number is 1-65535 or the name of a port list object. You can enter a range of ports using a hyphen, for example, 10-20. The source port number is the Default Range port list object. The Default Range object includes either all ports (1-65535) or all secure ports (1024-65535), depending on the setting you select in the Policy Objects Page (select  Tools > Security Manager Administration > Policy Objects ).

 
    

 
    [bookmark: pgfId-905056]For example, defining a service as tcp/10 means that 10 is the destination port and no source port is defined.

 
    [bookmark: pgfId-905058]When you specify ports, you can also use the following special keywords: lt (less than), gt (greater than), eq (equal to), and neq (not equal to), followed by a number. For example, lt 440 specifies all ports less than 440.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-905066]Tip To create port list objects, select Services > Port Lists in the Policy Object Manager and click the Add Object button. For more information, see Configuring Port List Objects.


    
     

    

    

 
     
     		 [bookmark: pgfId-905068] {tcp | udp | tcp&udp}/ { source_port_number |  port_list_object } / { destination_port_number |  port_list_object }, where the source and destination port numbers are 1-65535 or the name of a port list object. You can enter a range of ports using a hyphen, for example, 10-20.

 
    

 
    [bookmark: pgfId-905070]For example, defining a service as tcp/10/20 means that 10 is the source port and 20 is the destination port. If you do not want to specify a destination port, use the Default Range port list object, for example, tcp/10/Default Range.

 
     
     		 [bookmark: pgfId-905072](Service groups only)  service_object_name , which is the name of another existing service object. Specifying other objects lets you nest object definitions. Click  Select to select a service object or to create a new object.

 
    

 
    [bookmark: pgfId-905074]Related Topics

 
     
     		 [bookmark: pgfId-905079]Selecting Objects for Policies

 
     		 [bookmark: pgfId-905084]Creating Policy Objects

 
     		 [bookmark: pgfId-905089]Editing Objects

 
     		 [bookmark: pgfId-905094]How Service Objects are Provisioned as Object Groups

 
     		 [bookmark: pgfId-905099]Using Category Objects

 
     		 [bookmark: pgfId-905104]Managing Object Overrides

 
     		 [bookmark: pgfId-905109]Allowing a Policy Object to Be Overridden

 
    

 
     
      [bookmark: pgfId-905127][bookmark: 20043][bookmark: pobjpage_cncpt_PortListDialogBox]Configuring Port List Objects[bookmark: marker-905117][bookmark: marker-905119][bookmark: marker-905121][bookmark: marker-905123][bookmark: marker-905125]

 
     [bookmark: pgfId-905129]Use the Port List dialog box to create, edit, or copy a port list object. Each port list object can contain one or more ports or port ranges (for example, 1-1000 and 2000-2500). Additionally, a port list object can include other port list objects.

 
     [bookmark: pgfId-905134]You typically use port list objects when defining services, but you can also use them in various policies to identify a port rather than typing in the port number. For more information about using port lists in service definitions, see Understanding and Specifying Services and Service and Port List Objects.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-905139]Tip The predefined Default Range port list object includes either all ports (1-65535) or all secure ports (1024-65535), depending on the setting you select in the Security Manager Administration window (select Tools > Security Manager Administration > Policy Objects and see Policy Objects Page).


     
      

     

     

 
     [bookmark: pgfId-905141]Navigation Path

 
     [bookmark: pgfId-905143]Select Manage > Policy Objects, then select Services > Port Lists from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-905145]Related Topics

 
      
      		 [bookmark: pgfId-905150]Understanding and Specifying Services and Service and Port List Objects

 
      		 [bookmark: pgfId-905155]Configuring Service Objects

 
     

 
     [bookmark: pgfId-905157]Field Reference

 
     [bookmark: pgfId-905160] 

 
      
       
        
        [bookmark: pgfId-899595]Table 6-34 [bookmark: 20087]Port List Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-899601]Element
          
  
         		
           
           [bookmark: pgfId-899603]Description
          
  
        

 
         
         		[bookmark: pgfId-899609]Name

  
         		[bookmark: pgfId-899614]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
        

 
         
         		[bookmark: pgfId-899620]Description

  
         		[bookmark: pgfId-899622]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-899628]Ports

  
         		[bookmark: pgfId-899630]The ports or ranges included in the port list object, for example, 443, or 1-1000. You can define a single port, a range of ports, multiple port ranges, or any combination of single ports and ranges. Separate multiple entries with commas. Port values range from 1 to 65535.

 [bookmark: pgfId-899632]You can use the following operators to identify ranges:

 
           
           		 [bookmark: pgfId-899634] gt —Greater than. For example, gt 1000.

 
           		 [bookmark: pgfId-899636] lt —Less than. For example, lt 1000.

 
           		 [bookmark: pgfId-899638] eq —Equals. For example, eq 1000. However,  eq 1000 has the same meaning as simply entering  1000 .

 
           		 [bookmark: pgfId-899640] neq —Does not equal. For example, neq 1000.

 
          

 [bookmark: pgfId-899642]If you use this operator, you can include only the neq value in the Ports field. However, you can include port ranges in the object. Thus, if you want to create an object that specifies all ports from 1000-1200 except for 1150, create a port list object for the 1000-1200 range, and another object that specifies neq 1150 and that includes the other port list object.

  
        

 
         
         		[bookmark: pgfId-899648]Port Lists

  
         		[bookmark: pgfId-899650]The other port list objects included in the object, if any. Enter the name of the port lists or click Select to select them from a list or to create new objects. Separate multiple entries with commas.

  
        

 
         
         		[bookmark: pgfId-899656]Category

  
         		[bookmark: pgfId-899661]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-899667]Allow Value Override per Device

 [bookmark: pgfId-899669]Overrides

 [bookmark: pgfId-899671]Edit button

  
         		[bookmark: pgfId-899679]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-899681]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-905176][bookmark: 20155][bookmark: pobjpage_cncpt_ServiceDialogBox]Configuring Service Objects[bookmark: marker-905170][bookmark: marker-905172][bookmark: marker-905174]

 
     [bookmark: pgfId-905178]Use the Add and Edit Service dialog boxes to create or edit service objects. You can create a service object to describe a type of traffic carried by the devices in your network. When creating a service object, you must specify the protocol used by the service.

 
     [bookmark: pgfId-905180]When you create a service object, you must choose the object type:

 
      
      		 [bookmark: pgfId-905182]Service Group—Can contain one or more services, including other service objects. This is the type of service object available in all Security Manager 3.x releases.

 
      		 [bookmark: pgfId-905184]Service object—Can contain a single service.

 
     

 
     [bookmark: pgfId-905186]Security Manager provides many predefined service group objects. Before creating an object, scan the list in the Policy Object Manager to see if an existing object fits your needs. Note that although you can duplicate a predefined object, you cannot edit it.

 
     [bookmark: pgfId-905188]Navigation Path

 
     [bookmark: pgfId-905190]Select Manage > Policy Objects, then select Services > Services from the Object Type Selector. Right-click inside the work area and select New Object (and select an object type) or right-click a row and select Edit Object.

 
     [bookmark: pgfId-905192]Related Topics

 
      
      		 [bookmark: pgfId-905197]Understanding and Specifying Services and Service and Port List Objects

 
      		 [bookmark: pgfId-905202]Policy Object Manager

 
     

 
     [bookmark: pgfId-905204]Field Reference

 
     [bookmark: pgfId-905207] 

 
      
       
        
        [bookmark: pgfId-899694]Table 6-35 [bookmark: 20194]Add and Edit Service Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-899700]Element
          
  
         		
           
           [bookmark: pgfId-899702]Description
          
  
        

 
         
         		[bookmark: pgfId-899708]Name

  
         		[bookmark: pgfId-899710]The object name. If you are using the object for ASA or PIX devices running software version 8.x, limit the length of the name to 64 characters. For other devices the name can be up to 128 characters.

 [bookmark: pgfId-899715]Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
        

 
         
         		[bookmark: pgfId-899721]Description

  
         		[bookmark: pgfId-899723]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-899729]Services (for groups)

 [bookmark: pgfId-899731]Service (for objects)

  
         		[bookmark: pgfId-899733]The services to include in this policy object. When creating a Service Group, you can enter more than one service by separating services with commas. When creating a Service Object, you can enter one service only.

 [bookmark: pgfId-899735]You can specify services using the following formats. As you type, Security Manager may prompt you with text-completion options related to your entry. If you enter a service that translates directly to a predefined service object, the entry is converted to the predefined object name; for example, TCP/80 is converted to HTTP.

 
           
           		 [bookmark: pgfId-899737] protocol , where the protocol is 1 to 255 or a well known protocol name such as tcp, udp, gre, icmp, and so forth. If you enter a number, Security Manager might convert it to the associated name.

 
           		 [bookmark: pgfId-899739] icmp/  message_type / message_code , where the message type is 1 to 255 or a well-known ICMP message type name such as echo, and the message code is 0 to 255 (for example,  icmp/unreachable/1 or  icmp/echo-reply ).

 
           		 [bookmark: pgfId-899741] icmp6/  message_type / message_code , where the message type is 1 to 255 or a well-known ICMP message type name such as echo, and the message code is 0 to 255 (for example,  icmp6/unreachable/1 or  icmp6/echo-reply ).

 
           		 [bookmark: pgfId-899746] {tcp | udp | tcp&udp}/ { destination_port_number |  port_list_object } where the destination port number can be 1 to 65535, or the name of a port list object. You can enter a range of ports using a hyphen, for example, 10-20. In this instance, the source port number is the Default Range port list object, which specifies the range 1-65535. (See Configuring Port List Objects for information about creating and editing port list objects.)

 
          

 [bookmark: pgfId-899748]Whenever you specify ports, you can also use the following special keywords: lt (less than), gt (greater than), eq (equal to), and neq (not equal to), followed by a number. For example, lt 440 specifies all ports less than 440.

 
           
           		 [bookmark: pgfId-899750] {tcp | udp | tcp&udp}/ { source_port_number |  port_list_object } / { destination_port_number |  port_list_object }, where the source and destination port numbers can be 1 to 65535, or the name of a port list object. You can enter a range of ports using a hyphen, for example, 10-20.

 
           		 [bookmark: pgfId-899752](Service groups only)  service_object_name , which is the name of another existing service object. Specifying other objects lets you nest object definitions. Click  Select to select a service object or to create a new object.

 
          

  
        

 
         
         		[bookmark: pgfId-899758]Category

  
         		[bookmark: pgfId-899763]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-899769]Allow Value Override per Device

 [bookmark: pgfId-899771]Overrides

 [bookmark: pgfId-899773]Edit button

  
         		[bookmark: pgfId-899781]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-899783]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-905217][bookmark: 20285][bookmark: obman_cncpt_HowPolicyObjectsareProvisionedasPIXASAObjectGroups]How Policy Objects are Provisioned as Object Groups[bookmark: marker-905213][bookmark: marker-905215]

 
    [bookmark: pgfId-905219]Object groups are a feature of ASA, PIX, FWSM, and IOS 12.4(20)T+ devices that enable you reduce the size of access rules by grouping objects such as IP hosts, networks, protocols, ports, and ICMP message types. Although the functionality of object groups is similar to the functionality of policy objects in Security Manager, there are several important differences in implementation.

 
    [bookmark: pgfId-905221]As a result, when deploying policies to a device, it is not always possible to create object groups that are an exact copy of the policy objects that you configured in Security Manager. To take one example, policy object names are unique per object type in Security Manager (that is, you can define a network/host object and a service object with the same name), whereas object groups of all types defined on the device share a single naming scheme. Therefore, if you deploy a network/host object whose name matches an existing service object group on the device, a suffix is added to the name of the network/host object to distinguish it from the service object group.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-905226]Note For information about the options available when deploying object groups, see Deployment Page.


    
     

    

    

 
    [bookmark: pgfId-905228]Similarly, when discovering policies on a device, it is not always possible to create policy objects that are an exact copy of the object groups that are configured on the device. However, Security Manager preserves as much of the original configuration as possible.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-905230]Note For IOS devices, any policy objects that are used by access control list objects are subsequently replaced during deployment by the contents of the object. Object groups used with ACL objects are not preserved, although they are discovered as Security Manager policy objects.


    
     

    

    

 
    [bookmark: pgfId-905232]The following sections describe the changes that are made when provisioning policy objects to object groups on the device, or when creating the policy objects when discovering policies on these devices:

 
     
     		 [bookmark: pgfId-905237]How Network/Host, Port List, and Service Objects are Named When Provisioned As Object Groups

 
     		 [bookmark: pgfId-905242]How Service Objects are Provisioned as Object Groups

 
    

 
     
      [bookmark: pgfId-905266][bookmark: 20307][bookmark: obman_cncpt_HowNetworkHostObjectsareProvisionedasPIXASAObjectGroups]How Network/Host, Port List, and Service Objects are Named When Provisioned As Object Groups[bookmark: marker-905248][bookmark: marker-905250][bookmark: marker-905252][bookmark: marker-905254][bookmark: marker-905256][bookmark: marker-905258][bookmark: marker-905260][bookmark: marker-905262][bookmark: marker-905264]

 
     [bookmark: pgfId-905271]In most cases, network/host, port list, and service objects can be provisioned as object groups without changing the object name. Table 6-36 describes how object names are changed when the names cannot be converted directly to object groups on supported devices.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-905273]Note The predefined network/host object any is not provisioned as an object group.


     
      

     

     

 
     [bookmark: pgfId-905276] 

 
      
       
        
        [bookmark: pgfId-899798]Table 6-36 [bookmark: 20348]How Network/Host, Port List, and Service Objects are Named as Object Groups 

 
        
       
         
         		
           
           [bookmark: pgfId-899806]Condition
          
  
         		
           
           [bookmark: pgfId-899808]New Name
          
  
         		
           
           [bookmark: pgfId-899810]Examples
          
  
        

 
         
         		[bookmark: pgfId-899818]Object name includes a space.

  
         		[bookmark: pgfId-899820]Space is replaced with an underscore.

  
         		[bookmark: pgfId-899822]An object named my object is provisioned as an object group named my_object.

  
        

 
         
         		[bookmark: pgfId-899830]Object name is longer than 64 characters (the maximum supported by object groups).

  
         		[bookmark: pgfId-899832]Name is truncated so that any suffixes required by the object group (such as _TCP or _UDP, or unique numbers, such as _1) can be added while remaining within the 64-character limit.

  
         		[bookmark: pgfId-899834] 

  
        

 
         
         		[bookmark: pgfId-899842]Device already has an object group (Protocol/ICMP/Service) with the same name.

  
         		[bookmark: pgfId-899844]A numeric suffix is added to the name, starting from 1.

  
         		[bookmark: pgfId-899846]If you have a network/host object named West and the device already has a TCP service object group named West, the name of the object group is changed to West_1 when deployed.

  
        

 
         
         		[bookmark: pgfId-899854]You have already created a network/host object group with the same name.

  
         		[bookmark: pgfId-899856]A numeric suffix is added to the name, starting from 1.

  
         		[bookmark: pgfId-899858]If you have a network/host object and a port list or service object that are both named West, the network/host object is deployed as West and the port list is deployed as West_1.

  
        

 
       
      

 
     
 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1074665]Note For ASA software versions 8.2 and earlier, if you create an object of the type Network Object on Security Manager, upon discovering the ASA device with an object of the same object name but of type Network- Object Group, Security Manager does not create a new object. Instead, it reuses the existing objects.However, for ASA software versions 8.3 and later, if you create an object of type Network Object on Security Manager, upon discovering the ASA device with an object of the same object name but of type Network-Object Group, Security Manager creates new objects, say, name_1, name_2, and so on. This implies that for Security Manager managing ASA devices that are running the software version 8.2 or earlier, it creates new objects upon upgrading the ASA to version 8.3 or later.


     
      

     

     

 
      
      		 [bookmark: pgfId-905283]Understanding Networks/Hosts Objects

 
      		 [bookmark: pgfId-905288]Understanding and Specifying Services and Service and Port List Objects

 
      		 [bookmark: pgfId-905293]How Service Objects are Provisioned as Object Groups

 
      		 [bookmark: pgfId-905298]How Policy Objects are Provisioned as Object Groups

 
     

 
    
 
     
      [bookmark: pgfId-905310][bookmark: 20413][bookmark: obman_cncpt_HowServiceObjectsareProvisionedasPIXASAObjectGroups]How Service Objects are Provisioned as Object Groups [bookmark: marker-905304][bookmark: marker-905306][bookmark: marker-905308]

 
     [bookmark: pgfId-905312]The following table describes how Security Manager creates object groups when deploying service objects to supported devices.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-905314]Tip For ASA 8.3+ devices, service objects are provisioned using the object service command instead of the object-group command.


     
      

     

     

 
     [bookmark: pgfId-905317] 

 
      
       
        
        [bookmark: pgfId-899873]Table 6-37 [bookmark: 20432]How Service Objects are Provisioned as Object Groups 

 
        
       
         
         		
           
           [bookmark: pgfId-899881]Condition
          
  
         		
           
           [bookmark: pgfId-899883]Generated Object Group
          
  
         		
           
           [bookmark: pgfId-899885]Examples
          
  
        

 
         
         		[bookmark: pgfId-899893]Service object contains the ICMP protocol and ICMP message types.

  
         		[bookmark: pgfId-899895]Generates an ICMP-type object group with the same name as the service object.

  
         		[bookmark: pgfId-899897]Service object service1: icmp/icmp-echo, 23

 [bookmark: pgfId-899899]Object group:

 
           
           [bookmark: pgfId-899901]object-group icmp-type service1
          
 
           
           [bookmark: pgfId-899903] icmp-object icmp-echo
          
 
           
           [bookmark: pgfId-899905] icmp-object 23
          
  
        

 
         
         		[bookmark: pgfId-899913]Service object contains only protocols.

  
         		[bookmark: pgfId-899915]Generates a protocol object group with the same name as the service object.

  
         		[bookmark: pgfId-899917]Service object service1: tcp, gre, 34

 [bookmark: pgfId-899919]Object group:

 
           
           [bookmark: pgfId-899921]object-group protocol service1
          
 
           
           [bookmark: pgfId-899923] protocol-object tcp
          
 
           
           [bookmark: pgfId-899925] protocol-object gre
          
 
           
           [bookmark: pgfId-899927] protocol-object 34
          
  
        

 
         
         		[bookmark: pgfId-899935]Service object uses port list objects for both source and destination ports.

  
         		[bookmark: pgfId-899937]Generates service object groups that match the port list objects.

  
         		[bookmark: pgfId-899939] 

  
        

 
         
         		[bookmark: pgfId-899947]Service object contains multiple ports or port ranges, but does not use a port list object for the source ports.

  
         		[bookmark: pgfId-899949]Generates service object group with the name <ObjectName>.src for the source ports.

  
         		[bookmark: pgfId-899951]Service object serv1: tcp/400,600/23-80

 [bookmark: pgfId-899953]Object group:

 
           
           [bookmark: pgfId-899955]object-group service serv1.src tcp
          
 
           
           [bookmark: pgfId-899957] port-object eq 400
          
 
           
           [bookmark: pgfId-899959] port-object eq 600
          
  
        

 
         
         		[bookmark: pgfId-899967]Service object contains multiple ports or port ranges, but does not use a port list object for the destination ports.

  
         		[bookmark: pgfId-899969]Generates service object group for the destination ports with the same name as the service object.

  
         		[bookmark: pgfId-899971]Service object serv1: tcp/400,600/23-80, 566

 [bookmark: pgfId-899973]Object group:

 
           
           [bookmark: pgfId-899975]object-group service serv1 tcp
          
 
           
           [bookmark: pgfId-899977] port-object range 23 80
          
 
           
           [bookmark: pgfId-899979] port-object eq 566
          
 
           
           [bookmark: pgfId-899981]object-group service serv1.src tcp
          
 
           
           [bookmark: pgfId-899983] port-object eq 400
          
 
           
           [bookmark: pgfId-899985] port-object eq 600
          
  
        

 
         
         		[bookmark: pgfId-899993]Service object contains the TCP&UDP protocol and includes defined ports.

  
         		[bookmark: pgfId-899995] 

  
         		[bookmark: pgfId-899997]Service object serv1: tcp&udp/400,600/23-80, 566

 [bookmark: pgfId-899999]Object group:

 
           
           [bookmark: pgfId-900001]object-group service serv1 tcp
          
 
           
           [bookmark: pgfId-900003] port-object range 23 80
          
 
           
           [bookmark: pgfId-900005] port-object eq 566
          
 
           
           [bookmark: pgfId-900007]object-group service serv1.src tcp
          
 
           
           [bookmark: pgfId-900009] port-object eq 400
          
 
           
           [bookmark: pgfId-900011] port-object eq 600
          
 
           
           [bookmark: pgfId-900013]object-group protocol tcp-udp
          
 
           
           [bookmark: pgfId-900015] protocol-object tcp
          
 
           
           [bookmark: pgfId-900017] protocol-object udp
          
  
        

 
       
      

 
     
 
     [bookmark: pgfId-905319]Related Topics

 
      
      		 [bookmark: pgfId-905324]Understanding and Specifying Services and Service and Port List Objects

 
      		 [bookmark: pgfId-905329]How Network/Host, Port List, and Service Objects are Named When Provisioned As Object Groups

 
      		 [bookmark: pgfId-905334]How Policy Objects are Provisioned as Object Groups
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     [bookmark: pgfId-501680][bookmark: 60034][bookmark: trfczone_cncpt_ManagingTrafficZones]Managing Traffic Zones[bookmark: marker-501678]
      
      
 
     
 

 
    [bookmark: pgfId-501682]You can assign multiple interfaces to a traffic zone, which lets traffic from an existing flow exit or enter the ASA on any interface within the zone. This capability allows Equal-Cost Multi-Path (ECMP) routing on the ASA as well as external load balancing of traffic to the ASA across multiple interfaces.

 
    [bookmark: pgfId-501684]Non-Zoned Behavior

 
    [bookmark: pgfId-501686]The Adaptive Security Algorithm takes into consideration the state of a packet when deciding to permit or deny the traffic. One of the enforced parameters for the flow is that traffic enters and exits the same interface. Any traffic for an existing flow that enters a different interface is dropped by the ASA.

 
    [bookmark: pgfId-501688]Traffic zones let you group multiple interfaces together so that traffic entering or exiting any interface in the zone fulfills the Adaptive Security Algorithm security checks.

 
    [bookmark: pgfId-501690]Related Topics

 
     
     		 [bookmark: pgfId-501695]Why Use Zones?

 
     		 [bookmark: pgfId-501700]ECMP Routing

 
     		 [bookmark: pgfId-501705]Understanding Traffic Zones

 
     		 [bookmark: pgfId-501710]Prerequisites for Traffic Zones

 
     		 [bookmark: pgfId-501715]Guidelines for Traffic Zones

 
     		 [bookmark: pgfId-501720]Configuring Traffic Zones

 
    

 
   
 
    
     [bookmark: pgfId-501734][bookmark: 60064][bookmark: trfczone_cncpt_WhyUseTrafficZones]Why Use Zones?[bookmark: marker-501726][bookmark: marker-501728][bookmark: marker-501730][bookmark: marker-501732]

 
    [bookmark: pgfId-501736]Asymmetric Routing

 
     
     [image: ] 
    
 
    [bookmark: pgfId-501743]Non-Zoned Problem: The ASA maintains the connection tables on a per-interface basis. When the returning traffic arrives at Outside2, it will not match the connection table and will be dropped.

 
    [bookmark: pgfId-501745]Zoned Solution: The ASA maintains connection tables on a per-zone basis. If you group Outside1 and Outside2 into a zone, then when the returning traffic arrives at Outside2, it will match the per-zone connection table, and the connection will be allowed.

 
    [bookmark: pgfId-501747]Lost Route

 
     
     [image: ] 
    
 
    [bookmark: pgfId-501754]Non-Zoned Problem: The connection between the inside and outside host will be deleted; a new connection must be established using a new next-best route. For UDP, the new route will be used after a single packet drop, but for TCP, a new connection has to be reestablished.

 
    [bookmark: pgfId-501756]Zoned Solution: The ASA detects the lost route and switches the flow to the new path through ISP 2. Traffic will be seamlessly forwarded without any packet drops.

 
    [bookmark: pgfId-501758]Load Balancing

 
     
     [image: ] 
    
 
    [bookmark: pgfId-501765]Non-Zoned Problem: Load-balancing across interfaces is not possible; you can only load-balance with equal cost routes on one interface.

 
    [bookmark: pgfId-501767]Zoned Solution: The ASA load-balances connections across up to eight equal cost routes on all the interfaces in the zone.

 
    [bookmark: pgfId-501769]Related Topics

 
     
     		 [bookmark: pgfId-501774]Chapter 22, “Managing Traffic Zones”

 
     		 [bookmark: pgfId-501779]ECMP Routing

 
     		 [bookmark: pgfId-501784]Understanding Traffic Zones

 
     		 [bookmark: pgfId-501789]Prerequisites for Traffic Zones

 
     		 [bookmark: pgfId-501794]Guidelines for Traffic Zones

 
     		 [bookmark: pgfId-501799]Configuring Traffic Zones

 
    

 
   
 
    
     [bookmark: pgfId-501811][bookmark: 60127][bookmark: trfczone_cncpt_ECMPRouting]ECMP Routing[bookmark: marker-501805][bookmark: marker-501807][bookmark: marker-501809]

 
    [bookmark: pgfId-501813]The ASA supports Equal-Cost Multi-Path (ECMP) routing.

 
    [bookmark: pgfId-501815]Non-Zoned ECMP Support

 
    [bookmark: pgfId-501817]Without zones, you can have up to three equal cost static or dynamic routes per interface. For example, you can configure three default routes on the outside interface that specify different gateways:

 
    [bookmark: pgfId-501819]route outside 0 0 10.1.1.2

 
    [bookmark: pgfId-501821]route outside 0 0 10.1.1.3

 
    [bookmark: pgfId-501823]route outside 0 0 10.1.1.4

 
    [bookmark: pgfId-501825]In this case, traffic is load-balanced on the outside interface between 10.1.1.2, 10.1.1.3, and 10.1.1.4. Traffic is distributed among the specified gateways based on an algorithm that hashes the source and destination IP addresses.

 
    [bookmark: pgfId-501827]ECMP is not supported across multiple interfaces, so you cannot define a route to the same destination on a different interface. The following route is disallowed when configured with any of the routes above:

 
    [bookmark: pgfId-501829]route outside2 0 0 10.2.1.1

 
    [bookmark: pgfId-501831]Zoned ECMP Support

 
    [bookmark: pgfId-501833]With zones, you can have up to 8 equal cost static or dynamic routes across up to 8 interfaces within a zone. For example, you can configure three default routes across three interfaces in the zone:

 
    [bookmark: pgfId-501835]route outside1 0 0 10.1.1.2

 
    [bookmark: pgfId-501837]route outside2 0 0 10.2.1.2

 
    [bookmark: pgfId-501839]route outside3 0 0 10.3.1.2

 
    [bookmark: pgfId-501841]Similarly, your dynamic routing protocol can automatically configure equal cost routes. The ASA load-balances traffic across the interfaces with a more robust load balancing mechanism.

 
    [bookmark: pgfId-501843]When a route is lost, the ASA seamlessly moves the flow to a different route.

 
    [bookmark: pgfId-501845]How Connections Are Load-Balanced

 
    [bookmark: pgfId-501847]The ASA load balances connections across equal cost routes using a hash made from the packet 6-tuple (source and destination IP address, source and destination port, protocol, and ingress interface). Unless the route is lost, a connection will stay on the chosen interface for its duration.

 
    [bookmark: pgfId-501849]Packets within a connection are not load-balanced across routes; a connection uses a single route unless that route is lost.

 
    [bookmark: pgfId-501851]The ASA does not consider the interface bandwidth or other parameters when load balancing. You should make sure all interfaces within the same zone have the same characteristics such as MTU, bandwidth, and so on.

 
    [bookmark: pgfId-501853]The load-balancing algorithm is not user configurable.

 
    [bookmark: pgfId-501855]Falling Back to a Route in Another Zone

 
    [bookmark: pgfId-501857]When a route is lost on an interface, if there are no other routes available within the zone, then the ASA will use a route from a different interface/zone. If this backup route is used, then you may experience packet drops as with non-zoned routing support.

 
    [bookmark: pgfId-501859]Related Topics

 
     
     		 [bookmark: pgfId-501864]Chapter 22, “Managing Traffic Zones”

 
     		 [bookmark: pgfId-501869]Why Use Zones?

 
     		 [bookmark: pgfId-501874]Understanding Traffic Zones

 
     		 [bookmark: pgfId-501879]Prerequisites for Traffic Zones

 
     		 [bookmark: pgfId-501884]Guidelines for Traffic Zones

 
     		 [bookmark: pgfId-501889]Configuring Traffic Zones

 
    

 
   
 
    
     [bookmark: pgfId-501901][bookmark: 60192][bookmark: trfczone_cncpt_UnderstandingTrafficZones]Understanding Traffic Zones[bookmark: marker-501895][bookmark: marker-501897][bookmark: marker-501899]

 
    [bookmark: pgfId-501903]Interface-Based Security Policy

 
    [bookmark: pgfId-501908]Zones allow traffic to and from any interface in the zone, but the security policy itself (access rules, NAT, and so on) is still applied per interface, not per zone. If you configure the same security policy for all interfaces within the zone, then you can successfully implement ECMP and load balancing for that traffic. For more information about required parallel interface configuration, see Prerequisites for Traffic Zones.

 
    [bookmark: pgfId-501910]Supported Services for Traffic Zones

 
    [bookmark: pgfId-501912]The following services are supported with zones:

 
     
     		 [bookmark: pgfId-501914]Access Rules

 
     		 [bookmark: pgfId-501916]NAT

 
     		 [bookmark: pgfId-501918]Service Rules, except for QoS traffic policing.

 
     		 [bookmark: pgfId-501920]Routing

 
    

 
    [bookmark: pgfId-501922]You can also configure to- and from-the-box services (see below), although full zoned support is not available.

 
    [bookmark: pgfId-501924]Do not configure other services (such as VPN or Botnet Traffic Filter) for interfaces in a traffic zone; they may not function or scale as expected.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-501929]Note For detailed information about how to configure the security policy, see Prerequisites for Traffic Zones.


    
     

    

    

 
    [bookmark: pgfId-501931]Security Levels

 
    [bookmark: pgfId-501933]The first interface that you add to a zone determines the security level of the zone. All additional interfaces must have the same security level. To change the security level for interfaces in a zone, you must remove all but one interface, and then change the security levels, and re-add the interfaces.

 
    [bookmark: pgfId-501935]Primary and Current Interface for the Flow

 
    [bookmark: pgfId-501937]Each connection flow is built based on the initial ingress and egress interfaces. These interfaces are the primary interfaces.

 
    [bookmark: pgfId-501939]If a new egress interface is used because of route changes or asymmetric routing, then the new interfaces are the current interfaces.

 
    [bookmark: pgfId-501941]Joining or Leaving a Zone

 
    [bookmark: pgfId-501943]When you assign an interface to a zone, any connections on that interface are deleted. The connections must be reestablished.

 
    [bookmark: pgfId-501945]If you remove an interface from a zone, any connections that have the interface as the primary interface are deleted. The connections must be reestablished. If the interface is the current interface, the ASA moves the connections back to the primary interface. The zone route table is also refreshed.

 
    [bookmark: pgfId-501947]To- and From-the-Box Traffic

 
     
     		 [bookmark: pgfId-501949]You cannot add management-only or management-access interfaces to a zone.

 
     		 [bookmark: pgfId-501951]For management traffic on regular interfaces in a zone, only asymmetric routing on existing flows is supported; there is no ECMP support.

 
     		 [bookmark: pgfId-501953]You can configure a management service on only one zone interface, but to take advantage of asymmetric routing support, you need to configure it on all interfaces. Even when the configurations are parallel on all interfaces, ECMP is not supported.

 
     		 [bookmark: pgfId-501955]The ASA supports the following to- and from-the-box services in a zone:

 
    

 
    [bookmark: pgfId-501957] – Telnet

 
    [bookmark: pgfId-501959] – SSH

 
    [bookmark: pgfId-501961] – HTTPS

 
    [bookmark: pgfId-501963] – SNMP

 
    [bookmark: pgfId-501965] – Syslog

 
    [bookmark: pgfId-501967] – BGP

 
    [bookmark: pgfId-501969]Overlapping IP Addresses Within a Zone

 
    [bookmark: pgfId-501971]For non-zoned interfaces, the ASA supports overlapping IP address networks on interfaces so long as you configure NAT properly. However, overlapping networks are not supported on interfaces in the same zone.

 
    [bookmark: pgfId-501973]Related Topics

 
     
     		 [bookmark: pgfId-501978]Chapter 22, “Managing Traffic Zones”

 
     		 [bookmark: pgfId-501983]Why Use Zones?

 
     		 [bookmark: pgfId-501988]ECMP Routing

 
     		 [bookmark: pgfId-501993]Prerequisites for Traffic Zones

 
     		 [bookmark: pgfId-501998]Guidelines for Traffic Zones

 
     		 [bookmark: pgfId-502003]Configuring Traffic Zones

 
    

 
   
 
    
     [bookmark: pgfId-502011][bookmark: 60285][bookmark: trfczone_cncpt_PrerequisitesForTrafficZones]Prerequisites for Traffic Zones[bookmark: marker-502009]

 
     
     		 [bookmark: pgfId-502013]Configure all interface parameters including the name, IP address, and security level. Note that the security level must match for all interfaces in the zone. You should plan to group together like interfaces in terms of bandwidth and other Layer 2 properties.

 
     		 [bookmark: pgfId-502015]Configure the following services to match on all zone interfaces:

 
    

 
    [bookmark: pgfId-502017] – Access Rules—Apply the same access rule to all zone member interfaces, or use a global access rule.

 
    [bookmark: pgfId-502019] – NAT—Configure the same NAT policy on all member interfaces of the zone or use a global NAT rule.

 
    [bookmark: pgfId-502021]Interface PAT is not supported.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-502023]Note When you use interface-specific NAT and PAT pools, the ASA cannot switch connections over in case of the original interface failure.

If you use interface-specific PAT pools, multiple connections from the same host might load-balance to different interfaces and use different mapped IP addresses. Internet services that use multiple concurrent connections may not work correctly in this case.


    
     

    

    

 
    [bookmark: pgfId-502025] – Service Rules—Use the global service policy, or assign the same policy to each interface in a zone.

 
    [bookmark: pgfId-502027]QoS traffic policing is not supported.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-502029]Note For VoIP inspections, zone load balancing can cause increased out-of-order packets. This situation can occur because later packets might reach the ASA before earlier packets that take a different path. Symptoms of out-of-order packets include:

–Higher memory utilization at intermediate nodes (firewall and IDS) and the receiving end nodes if queuing is used.

–Poor video or voice quality.

To mitigate these effects, we recommend that you use IP addresses only for load distribution for VoIP traffic.


    
     

    

    

 
     
     		 [bookmark: pgfId-502031]Configure routing with ECMP zone capabilities in mind.

 
    

 
    [bookmark: pgfId-502033]Related Topics

 
     
     		 [bookmark: pgfId-502038]Chapter 22, “Managing Traffic Zones”

 
     		 [bookmark: pgfId-502043]Why Use Zones?

 
     		 [bookmark: pgfId-502048]ECMP Routing

 
     		 [bookmark: pgfId-502053]Understanding Traffic Zones

 
     		 [bookmark: pgfId-502058]Guidelines for Traffic Zones

 
     		 [bookmark: pgfId-502063]Configuring Traffic Zones

 
    

 
   
 
    
     [bookmark: pgfId-502077][bookmark: 60343][bookmark: trfczone_cncpt_GuidelinesForTrafficZones]Guidelines for Traffic Zones[bookmark: marker-502069][bookmark: marker-502071][bookmark: marker-502073][bookmark: marker-502075]

 
    [bookmark: pgfId-502079]Firewall Mode

 
    [bookmark: pgfId-502081]Supported in routed firewall mode only. Does not support transparent firewall mode.

 
    [bookmark: pgfId-502083]Failover

 
     
     		 [bookmark: pgfId-502085]You cannot add the failover or state link to a zone.

 
     		 [bookmark: pgfId-502087]In Active/Active failover mode, you can assign an interface in each context to an asymmetrical routing (ASR) group. This service allows traffic returning on a similar interface on the peer unit to be restored to the original unit. You cannot configure both ASR groups and traffic zones within a context. If you configure a zone in a context, none of the context interfaces can be part of an ASR group.

 
     		 [bookmark: pgfId-502089]Only the primary interfaces for each connection are replicated to the standby unit; current interfaces are not replicated. If the standby unit becomes active, it will assign a new current interface if necessary.

 
    

 
    [bookmark: pgfId-502091]Clustering

 
    [bookmark: pgfId-502093]You cannot add the cluster control link to a zone.

 
    [bookmark: pgfId-502095]Additional Guidelines

 
     
     		 [bookmark: pgfId-502097]You can create a maximum of 256 zones.

 
     		 [bookmark: pgfId-502099]You can only add physical interfaces to a zone.

 
     		 [bookmark: pgfId-502101]An interface can be a member of only one zone.

 
     		 [bookmark: pgfId-502103]You can include up to 8 interfaces per zone.

 
     		 [bookmark: pgfId-502105]The first interface that you add to a zone determines the security level of the zone. All additional interfaces must have the same security level.

 
     		 [bookmark: pgfId-502107]For ECMP, you can add up to 8 equal cost routes per zone, across all zone interfaces. You can also configure multiple routes on a single interface as part of the 8 route limit.

 
    

 
    [bookmark: pgfId-502109]Related Topics

 
     
     		 [bookmark: pgfId-502114]Chapter 22, “Managing Traffic Zones”

 
     		 [bookmark: pgfId-502119]Why Use Zones?

 
     		 [bookmark: pgfId-502124]ECMP Routing

 
     		 [bookmark: pgfId-502129]Understanding Traffic Zones

 
     		 [bookmark: pgfId-502134]Prerequisites for Traffic Zones

 
     		 [bookmark: pgfId-502139]Configuring Traffic Zones

 
    

 
   
 
    
     [bookmark: pgfId-502151][bookmark: 60409][bookmark: trfczone_proc_ConfiguringTrafficZones]Configuring Traffic Zones[bookmark: marker-502149]

 
    [bookmark: pgfId-502153]You can assign multiple interfaces to a traffic zone, which lets traffic from an existing flow exit or enter the ASA on any interface within the zone. This capability allows Equal-Cost Multi-Path (ECMP) routing on the ASA as well as external load balancing of traffic to the ASA across multiple interfaces.

 
    [bookmark: pgfId-502155]Related Topics

 
     
     		 [bookmark: pgfId-502160]Understanding Interface Role Objects

 
     		 [bookmark: pgfId-502165]Chapter 22, “Managing Traffic Zones”

 
     		 [bookmark: pgfId-502170]Why Use Zones?

 
     		 [bookmark: pgfId-502175]ECMP Routing

 
     		 [bookmark: pgfId-502180]Understanding Traffic Zones

 
     		 [bookmark: pgfId-502185]Prerequisites for Traffic Zones

 
     		 [bookmark: pgfId-502190]Guidelines for Traffic Zones

 
    

 
    
 
    [bookmark: pgfId-502192]Step 1 Do one of the following:

 
     
     		 [bookmark: pgfId-502194](Device view) Select  Firewall > Settings > Zone from the Policy selector.

 
     		 [bookmark: pgfId-502196](Policy view) Select  Firewall > Settings > Zone from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-502198]Step 2 Click the Add Row button beneath the Zone table to open the Zone dialog box.

 
    [bookmark: pgfId-502203]Step 3 Enter the name of an interface role that identifies the interfaces that belong to the traffic zone you are configuring and then click OK. For more information about interface role object, see Understanding Interface Role Objects.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-502205]Tip You can click Select to select the interface role from a list of interface role objects or to define a new interface role object.


    
     

    

    

 
    [bookmark: pgfId-502207]Step 4 Click Save to save the changes.

 
    [bookmark: pgfId-502209]
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     [bookmark: pgfId-376394][bookmark: 165446][bookmark: monidiag_cncpt_UsingMonitoringTroubleshootingandDiagnosticTools]Using External Monitoring, Troubleshooting, and Diagnostic Tools[bookmark: marker-376390][bookmark: marker-376392]
      
      
 
     
 

 
    [bookmark: pgfId-376396]A high degree of network availability is a requirement for large enterprises and service providers. Network managers face various challenges in maintaining network availability, including unscheduled down time, lack of expertise, insufficient tools, complex technologies, business consolidation, and competing markets. Network monitoring, problem diagnosis, and troubleshooting are essential to meeting and overcoming these challenges.

 
    [bookmark: pgfId-376398]Monitoring involves the study of network activity and device status to identify anomalous events and behaviors. Quickly diagnosing and correcting network and system faults such as outages and degradations increase service availability, and thus tools to isolate, analyze and correct problems are essential.

 
    [bookmark: pgfId-376406]The main Security Manager tools for monitoring device events are the Health and Performance Monitor (see Chapter 70, “Health and Performance Monitoring”) and the Event Viewer (see Chapter 68, “Viewing Events”).

 
    [bookmark: pgfId-376408]In addition to Health and Performance Monitor and Event Viewer, the following topics describe additional monitoring, troubleshooting and diagnostic tools that are available with Security Manager:

 
     
     		 [bookmark: pgfId-376413]Dashboard Overview

 
     		 [bookmark: pgfId-376418]CSM Mobile

 
     		 [bookmark: pgfId-376423]Viewing Inventory Status

 
     		 [bookmark: pgfId-376428]Starting Device Managers

 
     		 [bookmark: pgfId-376433]Launching Cisco Prime Security Manager or FireSIGHT Management Center

 
     		 [bookmark: pgfId-376438]Analyzing an ASA or PIX Configuration Using Packet Tracer

 
     		 [bookmark: pgfId-376443]Analyzing Connectivity Issues Using the Ping, Trace Route, or NS Lookup Tools

 
     		 [bookmark: pgfId-376448]Using the Packet Capture Wizard

 
     		 [bookmark: pgfId-376453]IP Intelligence

 
     		 [bookmark: pgfId-376458]Integrating CS-MARS and Security Manager

 
    

 
   
 
    
     [bookmark: pgfId-376466][bookmark: 165491][bookmark: monidiag_cncpt_DashboardOverview]Dashboard Overview

 
    [bookmark: pgfId-376470]Beginning with Version 4.5, the Security Manager client has a new launch point—a configurable dashboard, for which this topic presents an overview. [bookmark: marker-376469]

 
    [bookmark: pgfId-376482]The dashboard is one of the six client applications that you can select as your default client application when you start the Security Manager client. (The others are Configuration Manager, Event Viewer, Report Manager, Health and Performance Manager, and Image Manager; there is also an application designed for mobile devices called CSM Mobile.) The dashboard is a convenient way for you to accomplish tasks that are found in several other areas of Security Manager, such as the IPS Health Monitor page, Report Manager, Health and Performance Monitor, and IP Intelligence Settings. [bookmark: marker-376472][bookmark: marker-376474][bookmark: marker-376476][bookmark: marker-376478][bookmark: marker-376480]

 
    [bookmark: pgfId-376484]The dashboard contains the widgets shown in the following table, categorized by whether they are for use with IPS, firewalls, or both. (Not all of these widgets are shown by default). In addition to the original dashboard, you can create new, additional dashboards, which are displayed as tabs. You can customize all dashboards, both the original dashboard and any new, additional dashboards that you create. To customize a dashboard, you can drag and drop widgets from the list of available widgets into any dashboard.

 
    [bookmark: pgfId-376487] 

 
     
      
       
       [bookmark: pgfId-374236]Table 71-1 [bookmark: 165511]Widgets for IPS, Firewalls, and Both 

 
       
      
        
        		
          
          [bookmark: pgfId-374242]Widgets for IPS
         
  
        		
          
          		 [bookmark: pgfId-374244]IPS Inspection Load Trends

 
          		 [bookmark: pgfId-374246]Top 10 Reports for IPS Attackers, Victims, and Signatures

 
          		 [bookmark: pgfId-374248]IPS Missed PacketTrends

 
          		 [bookmark: pgfId-374250]IPS License

 
          		 [bookmark: pgfId-374252]IPS Update Packages

 
          		 [bookmark: pgfId-374254]IPS Sensors Out of Date

 
         

  
       

 
        
        		
          
          [bookmark: pgfId-374260]Widgets for Firewalls
         
  
        		
          
          		 [bookmark: pgfId-374262]Top 10 Reports for Firewall Sources, Destinations, and Services

 
          		 [bookmark: pgfId-374264]Top 10 Reports for Botnet Malware Sites, Ports, and Hosts

 
          		 [bookmark: pgfId-374266]Firewall CPU Usage Trends

 
         

  
       

 
        
        		
          
          [bookmark: pgfId-374272]Widgets for Both IPS and Firewalls
         
  
        		
          
          		 [bookmark: pgfId-374274]Device Health Summary

 
          		 [bookmark: pgfId-374276]Memory Usage Trends

 
          		 [bookmark: pgfId-374278]Deployment

 
          		 [bookmark: pgfId-374280]IP Intelligence

 
         

  
       

 
      
     

 
    
 
    [bookmark: pgfId-376493]The way in which you use the dashboard and its widgets depends upon your goals in using Security Manager. For example, you can use the following four widgets to observe device health trends: [bookmark: marker-376489][bookmark: marker-376491]

 
     
     		 [bookmark: pgfId-376495]IPS Inspection Load Trends

 
     		 [bookmark: pgfId-376497]IPS Missed Packet Trends

 
     		 [bookmark: pgfId-376499]Memory Usage Trends

 
     		 [bookmark: pgfId-376501]Firewall CPU Usage Trends

 
    

 
    [bookmark: pgfId-376509]Individual widgets are described in the following table. One of the key widgets is the Device Health Summary widget. One reason it is important is that it provides the same information accessible through CSM Mobile, which is designed specifically for mobile devices. For more information about CSM Mobile, see CSM Mobile. For information on enabling or disabling CSM Mobile, see CSM Mobile Page.

 
    [bookmark: pgfId-376512] 

 
     
      
       
       [bookmark: pgfId-374293]Table 71-2 [bookmark: 165577]Description of Individual WidgetsDashboard widgetswidgets for IPS in Dashboardwidgets for firewall in dashboard 

 
       
      
        
        		
          
          [bookmark: pgfId-374299]IPS Inspection Load Trends
         
  
        		[bookmark: pgfId-374301]A measure of the IPS inspection load trends. The inspection load trend data will appear in this widget only when an IPS device issues an alert because of inspection load, and the data will disappear when the alert is cleared.

 [bookmark: pgfId-374303]Indicates how much traffic inspection capacity the sensor is using. 0 indicates that there is no traffic backup, and 100 indicates that the buffers are completely backed up. Inspection load trends are affected by the following things:

 
          
          		 [bookmark: pgfId-374305]Rate of traffic that needs inspection

 
          		 [bookmark: pgfId-374307]Type of traffic being inspected

 
          		 [bookmark: pgfId-374309]Number of active connections being inspected

 
          		 [bookmark: pgfId-374311]Rate of new connections per second

 
          		 [bookmark: pgfId-374313]Rate of attacks being detected

 
          		 [bookmark: pgfId-374315]Signatures active on the sensor

 
          		 [bookmark: pgfId-374317]Custom signatures created on the sensor

 
         

 [bookmark: pgfId-374319]You can set monitoring parameters on the IPS Health Monitor page at [IPS device in Device View] Platform > Device Admin > Health Monitor.

  
       

 
        
        		
          
          [bookmark: pgfId-374325]Top 10 Reports for IPS Attackers, Victims, and Signatures
         
  
        		[bookmark: pgfId-374327]Pre-defined system reports that you can use to analyze top attackers, victims, and signatures for IPS alerts in your network.

 [bookmark: pgfId-374332]Clickable Link—In the Top Attackers widget, the IP address is an active hyperlink; click it to display IP intelligence. For details on IP intelligence in Security Manager, refer to IP Intelligence.

 [bookmark: pgfId-374334]Clickable Link—In the Top Signatures widget, the Signature ID is an active hyperlink; click it to display signature information.

 [bookmark: pgfId-374336]To use these reports, use Report Manager (Launch > Report Manager...).

 [bookmark: pgfId-374338]To cross-launch Event Viewer from one of these top ten reports, select a particular attacker, victim, or signature, and click the number of occurrences. The number of occurrences is listed for the last 24 hours by default; you can change it to the last hour if desired.

 [bookmark: pgfId-374340]Note When you cross-launch Event Viewer, the event query time in Event Viewer will be shown as the last 10 minutes despite its being the last 24 hours or the last hour in the Summary Dashboard. You can change the event query time in Event Viewer from the last 10 minutes to another value by using the dropdown list.

  
       

 
        
        		
          
          [bookmark: pgfId-374346]IPS Missed Packet Trends
         
  
        		[bookmark: pgfId-374348]A measure of the IPS missed packets trends. The missed packets trend data will appear in this widget only when there is an alert based on missed packets, and the data will disappear when the alert is cleared.

 [bookmark: pgfId-374350]You can set monitoring parameters on the IPS Health Monitor page at [IPS device in Device View] Platform > Device Admin > Health Monitor.

  
       

 
        
        		
          
          [bookmark: pgfId-374356]IPS License
         
  
        		[bookmark: pgfId-374358]Displays IPS devices for which the license will expire in 30 days or 60 days. (Use the dropdown list to choose 30 days or 60 days.)

 [bookmark: pgfId-374360]If the license will expire in 30 days or 60 days (whichever you select) this widget displays the license expiry date.

  
       

 
        
        		
          
          [bookmark: pgfId-374366]IPS Update Packages
         
  
        		[bookmark: pgfId-374368]Displays sensor updates and signature updates that are available on Cisco.com or on a local download server but not downloaded to the Security Manager server.

 [bookmark: pgfId-374370]If there are many such updates, then this widget displays only the 10 most recent updates.

  
       

 
        
        		
          
          [bookmark: pgfId-374376]IPS Sensors Out of Date
         
  
        		[bookmark: pgfId-374378]Sensors requiring a signature update.

  
       

 
        
        		
          
          [bookmark: pgfId-374384]Top 10 Reports for Firewall Sources, Destinations, and Services
         
  
        		[bookmark: pgfId-374386]Pre-defined system reports that you can use to identify the top destinations, services, and sources for firewall ACL events. The statistics are based on the events collected by the Event Manager service (as displayed in Event Viewer).

 [bookmark: pgfId-374388]To use these reports, use Report Manager (Launch > Report Manager...).

  
       

 
        
        		
          
          [bookmark: pgfId-374394]Top 10 Reports for Botnet Malware Sites, Ports, and Hosts
         
  
        		[bookmark: pgfId-374396]Pre-defined system reports that you can use to analyze botnet traffic filtering. The statistics are based on the botnet events collected by the Event Manager service (as displayed in Event Viewer) for blacklisted and gray-listed sites.

 [bookmark: pgfId-374398]To use these reports, use Report Manager (Launch > Report Manager...).

  
       

 
        
        		
          
          [bookmark: pgfId-374404]Firewall CPU Usage Trends
         
  
        		[bookmark: pgfId-374406]A measure of the firewall CPU usage trends. The CPU usage trend data will appear in this widget only when a firewall issues an alert because of CPU usage, and the data will disappear when the alert is cleared.

  
       

 
        
        		
          
          [bookmark: pgfId-374412]Device Health Summary
         
  
        		[bookmark: pgfId-374414]Shows current high- or medium-severity active alerts generated by HPM. Alerts can be grouped by Alert-Description, Predefined-Category, Device, or Alert Technology.

 [bookmark: pgfId-374416]Clickable Link—The device name is an active hyperlink; click it to display the Device Summary dialog box in the Dashboard. This link works for any option in the Group by _____ dropdown list: Alert, Category, Device, or Technology.

 [bookmark: pgfId-374418]To configure these alerts, use HPM (Launch > Health and Performance Monitor...).

 [bookmark: pgfId-374420]Note After enabling a device for monitoring in HPM, it can take up to 5 minutes for priority devices and 10 minutes for non-priority devices before actual values can be seen in the Device Health Summary.

 [bookmark: pgfId-374422]Acknowledge Alert—To acknowledge an alert, follow these steps:

 [bookmark: pgfId-374424] 1. Use the Group by _____ dropdown list to choose Alert, Category, Device, or Technology.

 [bookmark: pgfId-374426] 2. Expand the alert, category, device, or technology that you are interested in. Doing this will show you an alert, category, device, or technology for each device that you are monitoring in Security Manager.

 [bookmark: pgfId-374428] 3. Click the Details icon (pictured at the end of this topic). Doing this will open the Alert dialog box.

 [bookmark: pgfId-374430] 4. Click Acknowledge Alert

 [bookmark: pgfId-374432]Clear Alert—To clear an alert, follow these steps:

 [bookmark: pgfId-374434] 1. Use the Group by _____ dropdown list to choose Alert, Category, Device, or Technology.

 [bookmark: pgfId-374436] 2. Expand the alert, category, device, or technology that you are interested in. Doing this will show you an alert, category, device, or technology for each device that you are monitoring in Security Manager.

 [bookmark: pgfId-374438] 3. Click the Details icon (pictured at the end of this topic). Doing this will open the Alert dialog box.

 [bookmark: pgfId-374440] 4. Click Clear Alert

 [bookmark: pgfId-374445]You can also access device health summary information from mobile devices. To do this, use the CSM Mobile application. The information available to you from CSM Mobile is the same as that available in the Device Health Summary widget in the Dashboard. For information on enabling or disabling CSM Mobile, see CSM Mobile Page.

  
       

 
        
        		
          
          [bookmark: pgfId-374451]Memory Usage Trends
         
  
        		[bookmark: pgfId-374453]A measure of IPS health status or firewall health trends.

 [bookmark: pgfId-374455]For IPS devices, you can set monitoring parameters on the IPS Health Monitor page at [IPS device in Device View] Platform > Device Admin > Health Monitor.

  
       

 
        
        		
          
          [bookmark: pgfId-374461]Deployment
         
  
        		[bookmark: pgfId-374463]Shows the deployment status for all devices for the past 24 hours

 [bookmark: pgfId-374465]You can also monitor deployment status by using Deployment Manager (Configuration Manager > Manage > Deployments...) .

  
       

 
        
        		
          
          [bookmark: pgfId-374471]IP Intelligence
         
  
        		[bookmark: pgfId-374473]Information about an IP address related to the following things:

 
          
          		 [bookmark: pgfId-374475]IP Geolocation

 
          		 [bookmark: pgfId-374477]FQDN through DNS reverse lookup

 
          		 [bookmark: pgfId-374479]WHOIS information

 
         

 [bookmark: pgfId-374481]For IP Intelligence settings in Security Manager, navigate to Configuration Manager > Tools > Security Manager Administration > IP Intelligence Settings.

  
       

 
        
        		[bookmark: pgfId-374491]CSM Monitor[bookmark: marker-374487][bookmark: marker-374489]

  
        		[bookmark: pgfId-374493]Shows server information in three categories:

 
          
          		 [bookmark: pgfId-374495]CSM Server Statistics. This information is self-explanatory; for example, the operating system boot time is listed.

 
          		 [bookmark: pgfId-374497]CSM User Related Information. This information consists of only one item, the number of users logged in.

 
          		 [bookmark: pgfId-374499]CSM DB Backup Related Information. This information tells you if the CSM Monitor widget has found a dangling backup lock file.

 
         

 [bookmark: pgfId-374501]Knowing if you have a dangling backup lock file is important for the following reason: When a CSM backup is performed, it fails with an error similar to this: "Backup failed.ERROR(383): C:\PROGRA~2\CSCOpx\backup.LOCK file exists."

 [bookmark: pgfId-374503]The solution can be described as follows: Security Manager creates a new lock file (backup.LOCK) in the backup directory before it starts a backup. If a backup is interrupted or fails, the file does not get cleaned up. You must delete the current backup.LOCK file from the Security Manager server, and then execute the backup process again.

 [bookmark: pgfId-374505]The CSM Monitor widget makes it faster and more convenient for you to detect a dangling backup lock file.

 [bookmark: pgfId-374509]For detailed information, refer to the Cisco TAC document at the following URL: http://www.cisco.com/en/US/products/ps6498/products_tech_note09186a0080c13cdd.shtml

  
       

 
      
     

 
    
 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-376514]Note In some cases, Top Infected Hosts, for example, the dashboard report has a slightly different appearance than the report generated by Report Manager. This is caused by a difference in sorting, but the data is identical. Such a case will occur when more than one entry in the dashboard report has the same count.


    
     

    

    

 
    [bookmark: pgfId-376516]Basic dashboard operations are listed in the following table:

 
    [bookmark: pgfId-376519] 

 
     
      
       
       [bookmark: pgfId-374522]Table 71-3 [bookmark: 165770]Basic Dashboard OperationsDashboard operations 

 
       
      
        
        		
          
          [bookmark: pgfId-374528]Launch Dashboard
         
  
        		[bookmark: pgfId-374530]Configuration Manager or other Security Manager client application > Launch > Dashboard...

  
       

 
        
        		
          
          [bookmark: pgfId-374536]Add a new dashboard
         
  
        		[bookmark: pgfId-374538]File > New Dashboard

  
       

 
        
        		[bookmark: pgfId-374548]Re-arrange Dashboard Tabs for a Default View[bookmark: marker-374544][bookmark: marker-374546]

  
        		[bookmark: pgfId-374550]You can re-arrange the dashboard tabs so that you can set a default view. For example, you might want the IPS tab to be first (on the extreme left):

 [bookmark: pgfId-374552] 1. Click a tab that you are interested in, e.g., Summary, Firewall, or IPS.

 [bookmark: pgfId-374554] 2. While your tab of interest is still selected, right-click to see the following context menu options: Move to Left, Move to Right, Move to First, Move to Last.

 [bookmark: pgfId-374556] 3. Click your choice.

 [bookmark: pgfId-374558] 4. You do not need to save your changes, and your changes will be persistent--the individual dashboard tabs will be arranged in the same way the next time you launch the Dashboard.

  
       

 
        
        		
          
          [bookmark: pgfId-374564]Display a different dashboard
         
  
        		[bookmark: pgfId-374566]Click the tab for the desired dashboard, such as Summary, Firewall, or IPS.

  
       

 
        
        		
          
          [bookmark: pgfId-374572]Show or hide widgets
         
  
        		[bookmark: pgfId-374574]File > Show Widgets or File > Hide Widgets

  
       

 
        
        		
          
          [bookmark: pgfId-374580]Add a widget
         
  
        		[bookmark: pgfId-374582]Drag-and-Drop Method:

 [bookmark: pgfId-374584] 1. File > Show Widgets

 [bookmark: pgfId-374586] 2. Drag and drop the desired widget onto the dashboard.

 [bookmark: pgfId-374588]Menu Method:

 [bookmark: pgfId-374590] 1. File > Show Widgets

 [bookmark: pgfId-374592] 2. Select the desired widget by clicking it.

 [bookmark: pgfId-374594] 3. Click Add in the Description bar.

 [bookmark: pgfId-374596] 4. Click Done in the Description bar.

 [bookmark: pgfId-374598]Note When using the menu method, the widget will be added to the upper left-hand corner of the Dashboard. If desired, you can rearrange all the widgets by dragging and dropping them.

  
       

 
        
        		
          
          [bookmark: pgfId-374604]Remove a widget
         
  
        		[bookmark: pgfId-374606]Click the Remove icon in the title bar of the widget that you want to remove.

  
       

 
        
        		
          
          [bookmark: pgfId-374612]Expand a widget
         
  
        		[bookmark: pgfId-374614]If a widget is shown in the dashboard, you can expand it with the down arrow. The down arrow becomes visible when you hover the mouse pointer over the right side of the widget title bar. The tooltip for the down arrow is labeled "Expand."

 [bookmark: pgfId-374616]Note A special consideration applies when you 1) collapse a widget, 2) exit the dashboard, and then 3) launch the dashboard again. In this case, you will find that the widget is still collapsed, but the down arrow (normally used to expand it) is not present; only the up arrow (normally used to collapse it) is present. To expand the widget in this case, click the up arrow, note that the down arrow re-appears, and then click the down arrow as usual.

  
       

 
        
        		
          
          [bookmark: pgfId-374622]Collapse a widget
         
  
        		[bookmark: pgfId-374624]If a widget is shown in the dashboard, you can collapse it with the up arrow. The up arrow becomes visible when you hover the mouse pointer over the right side of the widget title bar. The tooltip for the up arrow is labeled "Expand" (not "Collapse").

  
       

 
        
        		[bookmark: pgfId-374630]Group by _____

 [bookmark: pgfId-374632](Device Health Summary widget only)

  
        		[bookmark: pgfId-374634]A dropdown list offering you the following choices:

 
          
          		 [bookmark: pgfId-374636]Group by Alert

 
          		 [bookmark: pgfId-374638]Group by Category

 
          		 [bookmark: pgfId-374640]Group by Device

 
          		 [bookmark: pgfId-374642]Group by Technology

 
         

 [bookmark: pgfId-374644]Note In the Group by _____ dropdown list, you can click the display name of a device (underlined to indicate that it is a hyperlink) to see an information box on the health of that device in terms of memory and other parameters. The information box contains an address field; the address can be either Host.Domain or the IP address: if Host.Domain is configured, that information will be displayed; otherwise, the IP address will be displayed.

  
       

 
      
     

 
    
 
    [bookmark: pgfId-376521]In the Dashboard, many of the icons can be clicked to accomplish a particular action, such as "Refresh" or "Add Dashboard." Most of these "clickable" icons have a tooltip to document the action that clicking the icon will accomplish, but a few do not. Clickable icons that have no tooltip in the dashboard are documented in the following table.

 
    [bookmark: pgfId-376524] 

 
     
     


     


     


     


     


      
       
       [bookmark: pgfId-374661]Table 71-4 [bookmark: 165886]Clickable Icons that have no Tooltip in the DashboardDashboard iconsicons without tooltips in Dashboard 

 
       
      
        
        		
          
          [bookmark: pgfId-374671]Icon
         
  
        		
          
          [bookmark: pgfId-374673]Appearance
         
  
        		
          
          [bookmark: pgfId-374675]Widget
         
  
        		
          
          [bookmark: pgfId-374677]Description
         
  
       

 
       
            
        		[bookmark: pgfId-1052335]Black exclamation point (bang) on a yellow background in a triangle.

  
        		[bookmark: pgfId-374692]Deployment widget

  
        		[bookmark: pgfId-1052332]Deploying icon.

 [bookmark: pgfId-374696]Indicates that a job is in the deploying state. Click this icon to open/close the job description:

 
          
          		 [bookmark: pgfId-374698]Created date and time

 
          		 [bookmark: pgfId-374700]Job Name

 
          		 [bookmark: pgfId-374702]Description

 
          		 [bookmark: pgfId-374704]State

 
          		 [bookmark: pgfId-1052326]User

 
          		 [bookmark: pgfId-1052322]Job Type

 
         

  
       

 
       
            
        		[bookmark: pgfId-374721]White rectangle (a document) with red and yellow dots.

  
        		[bookmark: pgfId-374723]Deployment widget

  
        		[bookmark: pgfId-374725]Status Report icon.

 [bookmark: pgfId-374727]Click this icon to see a detailed Deployment Status report

  
       

 
       
            
        		[bookmark: pgfId-374740]White checkmark in a green circle with a grey border.

  
        		[bookmark: pgfId-374742]Deployment widget

  
        		[bookmark: pgfId-374744]Succeeded icon.

 [bookmark: pgfId-374746]Indicates that a job is in the success state. Click this icon to open/close the job description:

 
          
          		 [bookmark: pgfId-374748]Created date and time

 
          		 [bookmark: pgfId-374750]Job Name

 
          		 [bookmark: pgfId-374752]Description

 
          		 [bookmark: pgfId-374754]State

 
          		 [bookmark: pgfId-374756]User

 
          		 [bookmark: pgfId-374758]Job Type

 
         

  
       

 
       
            
        		[bookmark: pgfId-374771]White "X" in a red circle with a grey border.

  
        		[bookmark: pgfId-374773]Deployment widget

  
        		[bookmark: pgfId-374775]Failed icon.

 [bookmark: pgfId-374777]Indicates that a job is in the failed state. Click this icon to open/close the job description:

 
          
          		 [bookmark: pgfId-374779]Created date and time

 
          		 [bookmark: pgfId-374781]Job Name

 
          		 [bookmark: pgfId-374783]Description

 
          		 [bookmark: pgfId-374785]State

 
          		 [bookmark: pgfId-374787]User

 
          		 [bookmark: pgfId-374789]Job Type

 
         

  
       

 
       
            
        		[bookmark: pgfId-374802]Clipboard with a pencil making annotations on a sheet of paper.

  
        		[bookmark: pgfId-374804]Device Health Summary widget

  
        		[bookmark: pgfId-374806]Details icon.

 [bookmark: pgfId-374808]Click this icon to open/close the job description:

 
          
          		 [bookmark: pgfId-374810]Created date and time

 
          		 [bookmark: pgfId-374812]Job Name

 
          		 [bookmark: pgfId-374814]Description

 
          		 [bookmark: pgfId-374816]State

 
          		 [bookmark: pgfId-374818]User

 
          		 [bookmark: pgfId-374820]Job Type

 
         

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-376530][bookmark: 166017][bookmark: monidiag_cncpt_CSM_Mobile]CSM Mobile

 
    [bookmark: pgfId-376536]Beginning with Version 4.5, Security Manager has an application called CSM Mobile. [bookmark: marker-376532][bookmark: marker-376534]

 
    [bookmark: pgfId-376541]CSM Mobile allows you to access device health summary information from mobile devices. The information available to you in this way is the same as that available in the Device Health Summary widget in the Dashboard: current high or medium severity active alerts generated by Health and Performance Monitor. Alerts can be grouped by Alert-Description, Predefined-Category, Device, or Alert Technology. For more details on device health summary information in the Dashboard, see Dashboard Overview.

 
    [bookmark: pgfId-376543]The principal users of CSM Mobile are expected to be those who use an Apple iPad, an Apple iPhone, the Google Chrome browser, or the Apple Safari browser.

 
    [bookmark: pgfId-376548]CSM Mobile must be enabled for you to use it. For information on enabling or disabling CSM Mobile, see CSM Mobile Page.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-376550]Note If the CSM Mobile feature is not enabled, you will be redirected to the default Security Manager login page (which is provided by the CiscoWorks Common Services framework software); you will not receive an error message.


    
     

    

    

 
    [bookmark: pgfId-376552]The home page for CSM Mobile has the following alert categories:

 
     
     		 [bookmark: pgfId-376554]Device Not Reachable

 
     		 [bookmark: pgfId-376556]Interface Down

 
     		 [bookmark: pgfId-376558]Overall Device Health Alerts

 
     		 [bookmark: pgfId-376560]High Memory Utilization

 
     		 [bookmark: pgfId-376562]Firewall—High CPU Utilization

 
     		 [bookmark: pgfId-376564]IPS—High Inspection Load

 
     		 [bookmark: pgfId-376566]IPS—High Missed Packets

 
     		 [bookmark: pgfId-376568]IPS—Bypass Mode

 
     		 [bookmark: pgfId-376570]Other Alerts

 
    

 
    [bookmark: pgfId-376572]Navigation and other tasks in CSM Mobile are accomplished by using a few simple screens and icons:

 
     
     		 [bookmark: pgfId-376574] Login —A screen reading "Cisco Security Manager Mobile—Version 4.5.0" with fields for username and password and a button for login.

 
     		 [bookmark: pgfId-376576] Logout —On the CSM Mobile home page, a white X icon on a blue background. This icon is located in the upper left-hand corner.

 
     		 [bookmark: pgfId-376578] Refresh —On the CSM Mobile home page, a white circular arrow icon on a blue background. This icon is located in the upper right-hand corner.

 
     		 [bookmark: pgfId-376580] Alert Detail —For each type of alert on the CSM Mobile Home page, an grey arrow icon to the right of the alert count.

 
     		 [bookmark: pgfId-376582] CSM Mobile Back Button —On each alert detail page, a white angle arrow on a blue pentagon-shaped background [available only on alert detail pages]. The CSM Mobile back button is functionally equivalent to your browser’s back button.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-376584]Note The CSM Mobile display does not refresh itself automatically; you must manually click the refresh button to obtain up-to-date alert data.


    
     

    

    

 
   
 
    
     [bookmark: pgfId-376594][bookmark: 166079][bookmark: monidiag_proc_ViewingInventoryStatus]Viewing Inventory Status[bookmark: marker-376590][bookmark: marker-376592]

 
    [bookmark: pgfId-376596]You can view a summary of device properties for all devices that you are authorized to view. The summary includes device contact information and all device configurations, indicating which settings are local and which are using a shared policy, and indicating any policy object overrides in effect. You can also view the status of configuration deployment to the device.

 
    [bookmark: pgfId-376598]The report is in table format, allowing you to organize information by filtering, sorting, reordering and removing columns. You can also export the table contents to a comma-separated values (CSV) file on the Security Manager server.

 
    
 
    [bookmark: pgfId-376603]Step 1 In Device view, select Tools > Inventory Status to open the Inventory Status Window.

 
    [bookmark: pgfId-376605]Step 2 Select the device whose detailed status you want to view in the upper table. The detailed information is shown in the tabs in the lower pane. The information is organized into folders; click the +/- icons to open and close folders, or double-click the folder name. The following tabs are available:

 
     
     		 [bookmark: pgfId-376607]Inventory—Lists summary information about the selected device’s device properties, deployment methods, device group membership, and the parent device for modules.

 
     		 [bookmark: pgfId-376609]Policy—Lists the current status of the policies that can be configured for the selected device, whether the policy is unassigned (not defined), a local policy, or a shared policy.

 
     		 [bookmark: pgfId-376611]Policy Object Overrides—Lists policy objects that have overrides defined for the selected device.

 
     		 [bookmark: pgfId-376613]Status—Lists status messages from Security Manager deployment jobs for the selected device, organized by event type.

 
    

 
    [bookmark: pgfId-376615]An event is a notification that a managed device or component has experienced an abnormal condition. Multiple events can occur simultaneously on a single monitored device or service module.

 
    [bookmark: pgfId-376617]Security Manager displays only the most-recent event of each type. To view historical status information, use the Deployment Manager.

 
    [bookmark: pgfId-376619]Step 3 Click Close to close the Inventory Status window.

 
    [bookmark: pgfId-376621]


    
     

    
 
    

 
     
      [bookmark: pgfId-376631][bookmark: 166113][bookmark: monidiag_cncpt_InventoryStatusWindow]Inventory Status Window[bookmark: marker-376629]

 
     [bookmark: pgfId-376633]Use the Inventory Status window to view device properties and status for the devices that you are allowed to view. This window summarizes device information so that you do not have to open the device properties for each individual device.

 
     [bookmark: pgfId-376635]In addition to device property information, you can view summary information about how the policies on each device are configured (whether local, shared, or not configured) and the policy objects that have overrides for each device. You can also view the status of configuration deployment to the device.

 
     [bookmark: pgfId-376637]The Inventory Status window contains two panes. Use the upper pane to view a complete listing of all devices, to sort the devices by attribute, or to filter out certain ones. Use the lower pane to view the device property details of the device selected in the upper pane.

 
     [bookmark: pgfId-376639]Navigation Path

 
     [bookmark: pgfId-376641]Select Tools > Inventory Status.

 
     [bookmark: pgfId-376643]Related Topics

 
      
      		 [bookmark: pgfId-376648]Viewing Inventory Status

 
      		 [bookmark: pgfId-376653]Filtering Tables

 
      		 [bookmark: pgfId-376658]Table Columns and Column Heading Features

 
     

 
     [bookmark: pgfId-376660]Field Reference

 
     [bookmark: pgfId-376663] 

 
      
       
        
        [bookmark: pgfId-374833]Table 71-5 [bookmark: 166140]Inventory Status Window 

 
        
       
         
         		
           
           [bookmark: pgfId-374839]Element
          
  
         		
           
           [bookmark: pgfId-374841]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-374847]Device Summary Information for All Devices (Upper Pane)
          
  
        

 
         
         		[bookmark: pgfId-374855]Export button

  
         		[bookmark: pgfId-374857]Click this button to export the inventory as a comma-separated values (CSV) file. You are prompted to specify a file name and to select a folder on the Security Manager server. You can use the export file for reference or analysis.

  
        

 
         
         		[bookmark: pgfId-374863]Display Name

  
         		[bookmark: pgfId-374865]The name of the device as it is displayed in Security Manager.

  
        

 
         
         		[bookmark: pgfId-374871]Deployment

  
         		[bookmark: pgfId-374873]The status of the configuration deployment for the device.

  
        

 
         
         		[bookmark: pgfId-374879]OS Type

  
         		[bookmark: pgfId-374881]The family of the operating system running on the device, for example, IOS, IPS, ASA, FWSM, or PIX.

  
        

 
         
         		[bookmark: pgfId-374887]Running OS Version

  
         		[bookmark: pgfId-374889]The version of the operating system running on the device.

  
        

 
         
         		[bookmark: pgfId-374895]Target OS Version

  
         		[bookmark: pgfId-374897]The target OS version for which you want to apply the configuration. Configurations are based on the commands supported by this version.

  
        

 
         
         		[bookmark: pgfId-374903]Host Name.Domain Name

  
         		[bookmark: pgfId-374905]The DNS host and domain names for the device.

  
        

 
         
         		[bookmark: pgfId-374911]IP Address

  
         		[bookmark: pgfId-374913]The management IP address of the device.

  
        

 
         
         		[bookmark: pgfId-374919]Device Type

  
         		[bookmark: pgfId-374921]The type of device.

  
        

 
         
         		 [bookmark: pgfId-374927]Details for the Selected Device (Lower Pane)

 [bookmark: pgfId-374929]The detailed information is shown in the tabs in the lower pane. The information is organized into folders; click the +/- icons to open and close folders, or double-click the folder name.

  
        

 
         
         		[bookmark: pgfId-374937]Inventory

  
         		[bookmark: pgfId-374939]Lists summary information about the selected device’s device properties, deployment methods, device group membership, and the parent device for modules.

  
        

 
         
         		[bookmark: pgfId-374945]Policy

  
         		[bookmark: pgfId-374947]Lists the current status of the policies that can be configured for the selected device, whether the policy is unassigned (not defined), a local policy, or a shared policy.

  
        

 
         
         		[bookmark: pgfId-374953]Policy Object Overrides

  
         		[bookmark: pgfId-374958]Lists policy objects that have overrides defined for the selected device. For more information on policy object overrides, see Policy Object Override Pages.

  
        

 
         
         		[bookmark: pgfId-374964]Status

  
         		[bookmark: pgfId-374966]Lists any deployment status messages for the selected device.

 [bookmark: pgfId-374968]Events are organized by event type. Event details include timestamp, description, and recommended action. The time stamp indicates the time of the last change in status for the device, not the time of the latest polling of the device.

 [bookmark: pgfId-374970]Also shown is the highest severity level of the status messages.

  
        

 
         
         		[bookmark: pgfId-374976]Navigation buttons

  
         		[bookmark: pgfId-374978]Click the navigation buttons to move through the inventory list. From left to right, buttons mean go to the first device in the list, go to the previous device, go to the next device, and go to the last device. The center field indicates which device is currently selected based on the row number (for example 5/10 means the fifth of 10 devices in the list).

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-376679][bookmark: 166236][bookmark: monidiag_cncpt_DeviceManagers]Starting Device Managers[bookmark: marker-376669][bookmark: marker-376671][bookmark: marker-376673][bookmark: marker-376675][bookmark: marker-376677]

 
    [bookmark: pgfId-376681]You can start a device manager to view a device’s configuration and status from within Security Manager. You can start device managers for ASA, ASA-SM, PIX, FWSM, IPS, and IOS devices. Each device manager includes several monitoring and diagnostic features that provide information regarding the services running on the device and a snapshot of the overall health of the system. You can use these device managers to view the existing device configuration and to monitor current status, but you cannot use it to apply configuration changes to the device.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-376683]Note You cannot start device managers for IPS virtual sensors.


    
     

    

    

 
    [bookmark: pgfId-376688]To start a device manager, select the device in Device view, right-click and select Device Manager. You can also start the device manager by selecting Launch > Device Manager. (These commands are disabled when you select an ASA CX device, and the Prime Security Manager commands are enabled. Cisco Prime Security Manager is used to configure and manage ASA CX devices. See Launching Cisco Prime Security Manager or FireSIGHT Management Center for more information.)

 
    [bookmark: pgfId-376693]When you start a device manager from Security Manager, the device manager executable is downloaded to your client system; the device manager does not need to be installed on the network device. The first time you start a device manager, it takes time to download the software to your workstation (you are shown a progress bar). (If you run into problems, review the tips in Troubleshooting Device Managers.)

 
    [bookmark: pgfId-376695]Security Manager selects the most appropriate device manager version based on the operating system running on the network device. Subsequent communications with the selected device are completely transparent. Connections are made through the Security Manager server; that is, the Security Manager server acts as a proxy server. By starting a device manager from Security Manager, you eliminate the need to open an HTTPS connection between your client system and the device you want to monitor.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-376697]Tip When you start a device manager session, Security Manager opens a version of the manager that is appropriate for the operating system software version running on the device. However, Security Manager might not open the most recently-available version of the device manager if new device manager versions have been released after the release of the Security Manager version you are using. When you start the device manager, check its version (for example, select Help > About in the device manager window); if there is a more recent device manager available with features that you require, you must install and use that device manager outside of Security Manager to use those new features.


    
     

    

    

 
    [bookmark: pgfId-376699]Keep in mind that if you use an external device manager running on the device to modify device configurations directly, these changes are considered out-of-band by Security Manager, and might be subsequently overwritten when you next deploy configurations from Security Manager. For more information about out-of-band changes, and what you can do to identify and recreate them, see the following topics:

 
     
     		 [bookmark: pgfId-376704]Understanding How Out-of-Band Changes are Handled

 
     		 [bookmark: pgfId-376709]Detecting and Analyzing Out of Band Changes

 
    

 
    [bookmark: pgfId-376711]Security Manager starts only one instance of a device manager per device, and closes the device manager when you exit Security Manager, or when the idle-session timeout period is exceeded. You can have more than one device manager window open at one time (connected to different devices).

 
    [bookmark: pgfId-376713]The following table outlines the device managers you can launch from Security Manager.

 
    [bookmark: pgfId-376716] 

 
     
      
       
       [bookmark: pgfId-374991]Table 71-6 [bookmark: 166276]Device Managers Available in Security Manager 

 
       
      
        
        		
          
          [bookmark: pgfId-374997]Device Manager
         
  
        		
          
          [bookmark: pgfId-374999]Description
         
  
       

 
        
        		[bookmark: pgfId-375011]IDM[bookmark: marker-375005][bookmark: marker-375007][bookmark: marker-375009]

  
        		[bookmark: pgfId-375013]The IPS Device Manager (IDM) lets you monitor IPS sensors and modules that are part of the Security Manager inventory.

 [bookmark: pgfId-375017]See the IDM documentation for more information about using this device manager.

  
       

 
        
        		[bookmark: pgfId-375031]PDM[bookmark: marker-375023][bookmark: marker-375025][bookmark: marker-375027][bookmark: marker-375029]

  
        		[bookmark: pgfId-375033]The PIX Device Manager (PDM) lets you monitor PIX 6.x devices and early FWSMs, specifically FWSM releases 1.1, 2.2 and 2.3 in single- or multiple-context modes.

 [bookmark: pgfId-375037]See the PDM documentation for more information about using this device manager.

  
       

 
        
        		[bookmark: pgfId-375049]ASDM[bookmark: marker-375043][bookmark: marker-375045][bookmark: marker-375047]

  
        		[bookmark: pgfId-375051]The Adaptive Security Device Manager (ASDM) lets you monitor ASA, ASA-SM, PIX 7.x+, and FWSM 3.x+ devices.

 [bookmark: pgfId-375055]See the ASDM documentation for more information about using this device manager.

  
       

 
        
        		[bookmark: pgfId-375067]SDM[bookmark: marker-375061][bookmark: marker-375063][bookmark: marker-375065]

  
        		[bookmark: pgfId-375069]The Security Device Manager (SDM) lets you monitor Cisco IOS-based resources. SDM requires no previous experience with Cisco devices or the Cisco command-line interface (CLI). Cisco SDM supports a wide range of Cisco IOS software releases.

 [bookmark: pgfId-375073]See the SDM documentation for more information about using this device manager.

  
       

 
      
     

 
    
 
    [bookmark: pgfId-376718]The following topics explain more about troubleshooting and using device managers:

 
     
     		 [bookmark: pgfId-376723]Troubleshooting Device Managers

 
     		 [bookmark: pgfId-376728]Access Rule Look-up from Device Managers

 
     		 [bookmark: pgfId-376733]Navigating to an Access Rule from ASDM

 
     		 [bookmark: pgfId-376738]Navigating to an Access Rule from SDM

 
    

 
     
      [bookmark: pgfId-376750][bookmark: 166367][bookmark: monidiag_cncpt_WorkingWithDevicesAndManagers]Troubleshooting Device Managers[bookmark: marker-376744][bookmark: marker-376746][bookmark: marker-376748]

 
     [bookmark: pgfId-376755]If you can successfully deploy configurations to a device, Security Manager should be able to open a device manager session with the device (as described in Starting Device Managers). However, if you have problems making a connection or using one that is open, consider the following troubleshooting tips, which are divided into basic tips and tips for using multiple device managers.

 
     [bookmark: pgfId-376757]Basic Device Manager Troubleshooting Tips

 
      
      		 [bookmark: pgfId-376765]Generally, the credentials configured for the device in the Security Manager inventory are used to start the device manager. However, some versions of SDM require that you enter a user name and password when the device manager is started. If you get an error that says device credentials are missing, or they are not valid, update the Device Properties Credentials page with a username and password that can log into the device. In Device view, right-click the device and select  Device Properties . For more information, see Viewing or Changing Device Properties and Device Credentials Page.

 
      		 [bookmark: pgfId-376767]All users associated with any of the CiscoWorks Common Services roles have permission to start device managers from Security Manager, with the exception of the Help Desk role or any of the predefined Cisco Secure ACS roles. Ensure you have appropriate permissions.

 
      		 [bookmark: pgfId-376772]SSL/HTTPS must be enabled on the target device to provide secure communications between Security Manager and the device. An error message is displayed if SSL is not enabled on the device. See Understanding Device Communication Requirements for more information.

 
      		 [bookmark: pgfId-376778]You might need to modify Cisco Security Agent, or other anti-virus and network firewall software, on the Security Manager system and on your workstation to allow the device manager service ( xdm-launcher.exe ) to be started.[bookmark: marker-376774][bookmark: marker-376776]

 
      		 [bookmark: pgfId-376783]Ensure that Security Manager is correctly configured for contacting and communicating with the target device. Specifically verify device properties such as identity, operating system and credentials. Select the desired device, right-click and choose  Device Properties . Verify the settings on the General and Credentials pages. You can test whether Security Manager can connect to the device by selecting the Credentials tab and clicking  Test Connectivity (see Testing Device Connectivity).

 
      		 [bookmark: pgfId-376785]Device managers can be started for FWSMs and ASAs running in transparent mode (Layer 2 firewall) or routed mode (Layer 3 firewall), and supporting a single security context or multiple security contexts. For FWSM and ASA devices running multiple security contexts, you must define a unique management IP address for each security context.

 
      		 [bookmark: pgfId-376790]If you get a message saying that the platform is not supported for device manager launch, but you believe the platform should be supported based on information in this guide, consider the relative newness of the operating system version running on the device and the age of the Security Manager software version you are using. If you are using very recent operating systems, but a relatively older version of Security Manager, you might need to upgrade Security Manager (or apply a service pack), contact Cisco Technical Support, or simply install the latest device manager on the network device and use it outside of Security Manager. Before using a device manager outside of Security Manager, review the information on out-of-band changes in Starting Device Managers.

 
     

 
     [bookmark: pgfId-376792]Multiple Device Manager Sessions Troubleshooting Tips

 
      
      		 [bookmark: pgfId-376794]Starting multiple device managers might affect the performance of both the Security Manager server and your client. On the client, memory requirements and performance impact are proportional to the number of device managers launched. On the server, a large number of requests to start device managers or retrieve current information from the device can have an adverse impact on performance.

 
      		 [bookmark: pgfId-376796]The maximum number of persistent HTTPS connections that can be established with any one device from all clients depends on the device type and model. An error message is displayed if you attempt to exceed this limit.

 
     

 
     [bookmark: pgfId-376798]For example, a single PIX 6.x allows multiple clients to each have one browser session open, supporting up to 16 concurrent PDM sessions. An FWSM (1.1, 2.2, or 2.3) allows up to 32 PDM sessions for the entire module, with a maximum of five concurrent HTTPS connections per context.

 
     [bookmark: pgfId-376800]Refer to the appropriate device documentation for information about specific limits.

 
    
 
     
      [bookmark: pgfId-376812][bookmark: 166422][bookmark: monidiag_cncpt_SecurityManagerAccessRuleLookupfromDeviceManagerSyslog]Access Rule Look-up from Device Managers[bookmark: marker-376806][bookmark: marker-376808][bookmark: marker-376810]

 
     [bookmark: pgfId-376814]A set of access rules is associated with each device interface. These rules are presented in the form of an ordered list or table. This list is often referred to as an access-control list (ACL), with each rule in the list known as an access-control entry (ACE). When deciding whether to forward or drop a packet, the device tests the packet against each access rule in the order listed. When a rule is matched, the device performs the specified action, either permitting the packet into the device for further processing, or denying entry. If the packet does not match any rule, the packet is denied.

 
     [bookmark: pgfId-376816]Activity on your firewall or router can be monitored through syslog messages. If logging is enabled on the device, whenever an access rule that is configured to generate syslog messages is matched—for example, a connection was attempted from a denied IP address—a log entry is generated.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-376827]Note For the device to generate log entries, logging must be enabled on the device (on the Logging Setup Page for ASA/PIX devices and the Logging policies for IOS devices, described in Logging on Cisco IOS Routers), and the individual access rules must be configured to generate log messages when they are matched (in the Advanced and Edit Options Dialog Boxes).


     
      

     

     

 
     [bookmark: pgfId-376829]You can monitor syslog messages in device managers launched from Security Manager. For certain device managers, you can also look up the access rule in Security Manager that generated a particular message from the monitoring window. The access rule that triggered the syslog entry is highlighted in Security Manager on a first-match basis, even if there are multiple matches.

 
     [bookmark: pgfId-376831]This access rule look-up is available through SDM for all managed routers running IOS, and through ASDM for managed PIX and ASA devices (including ASA-SM) running version 8.0(3) and above, and FWSM devices running version 3.1 and above.

 
     [bookmark: pgfId-376833]The following topics describe how to look up access rules in Security Manager from a device manager:

 
      
      		 [bookmark: pgfId-376838]Navigating to an Access Rule from ASDM

 
      		 [bookmark: pgfId-376843]Navigating to an Access Rule from SDM

 
     

 
    
 
     
      [bookmark: pgfId-376857][bookmark: 166450][bookmark: monidiag_proc_NavigatingtoACLinSecurityManagerfromASDMSyslog]Navigating to an Access Rule from ASDM[bookmark: marker-376849][bookmark: marker-376851][bookmark: marker-376853][bookmark: marker-376855]

 
     [bookmark: pgfId-376859]In an ASDM device manager launched from Security Manager, you can monitor system log messages in the Real-time Log Viewer window and the Log Buffer window. You can select a syslog message displayed in either window and navigate to the access-control rule in Security Manager that triggered the message, where you can update the rule as necessary.

 
     [bookmark: pgfId-376861]The Real-time Log Viewer is a separate window that lets you view syslog messages as they are logged. The separate Log Buffer window lets you view messages present in the syslog buffer.

 
     [bookmark: pgfId-376863]You can look up access rules associated with the following syslog message IDs:

 
      
      		 [bookmark: pgfId-376865]106023 – Generated when an IP packet is denied by the access rule. This message appears even when logging is not enabled for the rule.

 
      		 [bookmark: pgfId-376870]106100 – If logging is enabled for a matched access rule (in the Advanced and Edit Options Dialog Boxes), this message provides information about the traffic flow, depending on the parameters set. This message provides more information than message 106023, which logs only denied packets.

 
     

 
     [bookmark: pgfId-376872]This procedure describes how to look up an access rule in Security Manager from ASDM’s Real-time Log Viewer or Log Buffer windows.

 
     [bookmark: pgfId-376874]Related Topics

 
      
      		 [bookmark: pgfId-376879]Access Rule Look-up from Device Managers

 
      		 [bookmark: pgfId-376884]Navigating to an Access Rule from SDM

 
     

 
     
 
     [bookmark: pgfId-376886]Step 1 Select a PIX, ASA, ASA-SM, or FWSM in the Security Manager device inventory.

 
     [bookmark: pgfId-376891]Step 2 Select Launch > Device Manager to start ASDM. For more information about starting device managers, see Starting Device Managers.

 
     [bookmark: pgfId-376893]Step 3 In the ASDM window, click the Monitoring button to display the Monitoring panel; click Logging in the left pane to access the log-viewing options.

 
     [bookmark: pgfId-376895]Step 4 Select either Real-time Log Viewer or Log Buffer.

 
     [bookmark: pgfId-376897]Step 5 Click the View button to open the selected log-viewing window.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-376899]Note The View button is not displayed if logging is not enabled on the device.


     
      

     

     

 
     [bookmark: pgfId-376901]Each syslog message listed in the window includes the following information: message ID number, date and time the message was generated, the logging level, and the network or host addresses from which the packet was sent and received.

 
     [bookmark: pgfId-376903]Step 6 To view the access rule that triggered a specific syslog message, select the message and click the Show Rule button in the ASDM toolbar (or right-click the message and choose Go to Rule in CSM from the pop-up menu).

 
     [bookmark: pgfId-376905]The Security Manager client window is activated and the Access Rules page appears with the rule highlighted in the rules table. If the syslog entry was triggered by an access rule not referenced in the current Security Manager activity, an error message appears.

 
     [bookmark: pgfId-376907]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-376917][bookmark: 166510][bookmark: monidiag_proc_NavigatingtoACLinSecurityManagerfromSDMSyslog]Navigating to an Access Rule from SDM[bookmark: marker-376913][bookmark: marker-376915]

 
     [bookmark: pgfId-376919]In an SDM device manager launched from Security Manager, you can view a log of events categorized by security level under the Syslog tab of the Logging window. You can select a syslog message and navigate to the access-control rule in Security Manager that triggered the message, where you can update the rule as necessary.

 
     [bookmark: pgfId-376921]The Monitor > Logging option in SDM offers four log tabs; Syslog is the only one of these offering the Security Manager access-rule look-up option. The router contains a log of events categorized by severity level. The Syslog tab displays the router log, even if log messages are being forwarded to a syslog server.

 
     [bookmark: pgfId-376923]On Cisco IOS devices, syslog messages are generated for access rules configured with the log or log-input keywords. The log keyword produces a message when a packet matches the rule. The log-input keyword produces a message that includes ingress interface and source MAC address, in addition to the packet’s source and destination IP addresses and ports. When identical packets are matched, the message is updated at five-minute intervals with the number of packets permitted or denied in the previous five minutes.

 
     [bookmark: pgfId-376925]This procedure describes how to look up an access rule in Security Manager from the Syslog tab of SDM’s Logging panel.

 
     [bookmark: pgfId-376927]Related Topics

 
      
      		 [bookmark: pgfId-376932]Access Rule Look-up from Device Managers

 
      		 [bookmark: pgfId-376937]Navigating to an Access Rule from ASDM

 
     

 
     
 
     [bookmark: pgfId-376939]Step 1 Select an IOS router in the Security Manager device inventory.

 
     [bookmark: pgfId-376944]Step 2 Select Launch > Device Manager to start SDM. For more information about starting device managers, see Starting Device Managers.

 
     [bookmark: pgfId-376946]Step 3 In the SDM window, click the Monitoring button to display the Monitoring panel; click Logging in the left pane to access the log-viewing options.

 
     [bookmark: pgfId-376948]The Logging pane appears with Syslog tab displayed.

 
     [bookmark: pgfId-376950]Step 4 To view the access rule that triggered a specific syslog message, select the message and click the Go to Rule in CSM button above the table of log messages.

 
     [bookmark: pgfId-376952]The Security Manager client window is activated and the Access Rules page appears with the rule highlighted in the rules table. If the syslog entry was triggered by an access rule not referenced in the current Security Manager activity, an error message appears.

 
     [bookmark: pgfId-376954]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-376970][bookmark: 166557][bookmark: monidiag_proc_LaunchingPRSM]Launching Cisco Prime Security Manager or FireSIGHT Management Center[bookmark: marker-376960][bookmark: marker-376962][bookmark: marker-376964][bookmark: marker-376966][bookmark: marker-376968]

 
    [bookmark: pgfId-376972]The ASA CX is an Adaptive Security Appliance module that provides advanced ConteXt-aware security, extending the ASA platform to provide in-depth “who-what-where-when-how” application visibility and control. The ASA FirePOWER module supplies next-generation firewall services, including Next-Generation IPS (NGIPS), Application Visibility and Control (AVC), URL filtering, and Advanced Malware Protection (AMP).

 
    [bookmark: pgfId-376974]The ASA CX devices are managed by the Cisco Prime Security Manager (PRSM) application and the ASA FirePOWER modules are managed by the FireSIGHT Management Center application—they cannot be directly managed by Cisco Security Manager. However, Security Manager has been enhanced to allow you to discover the presence of these modules on ASA devices; to “cross launch” PRSM and FireSIGHT Management Center from the Configuration Manager application; and to share Policy Object data between Security Manager and PRSM.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-376976]Note PRSM and FireSIGHT Management Center are browser-based applications; that is, they are launched and operate within a browser window. Therefore, when you cross-launch PRSM or FireSIGHT Management Center from the Configuration Manager client, the host system’s default browser is opened and the management application initiated. However, some browsers have not been certified with PRSM or FireSIGHT Management Center and you may need to change the default browser on the Security Manager client’s host system prior to cross-launching. See “Browser Requirements” in the PRSM or FireSIGHT Management Center installation guide for more information.


    
     

    

    

 
    [bookmark: pgfId-376978]Before You Begin

 
    [bookmark: pgfId-376983]In order to cross-launch PRSM or FireSIGHT Management Center, Security Manager must be aware of the presence of the modules. This is accomplished through discovery of either new ASA devices, or of modules which have been added to existing ASAs. This process is outlined in Detecting ASA CX and FirePOWER Modules.

 
    [bookmark: pgfId-376990]Also, you can enable and configure “single sign-on” (SSO) to allow Security Manager users direct access to PRSM or FireSIGHT Management Center without logging into the applications separately. To allow this, the appropriate user credentials must be defined in both applications. (Note that SSO is not necessary to cross-launch PRSM or FireSIGHT Management Center.) See Security Manager’s Single Sign-on Configuration Page, and “Configuring Single Sign-On for Cisco Security Manager” in the User Guide for ASA CX and Cisco Prime Security Manager (Cisco ASA CX Context-Aware Security End-User Guides) for more information.

 
    [bookmark: pgfId-376992]Related Topics

 
     
     		 [bookmark: pgfId-376997]Single Sign-on Configuration Page

 
     		 [bookmark: pgfId-377002]Detecting ASA CX and FirePOWER Modules

 
     		 [bookmark: pgfId-377007]Sharing Device Inventory and Policy Objects with PRSM

 
    

 
    [bookmark: pgfId-377009]To monitor and manage your ASA CX devices or FirePOWER Modules, cross-launch PRSM or FireSIGHT Management Center:

 
    
 
    [bookmark: pgfId-377011]Step 1 Select a previously discovered ASA CX device or ASA with FirePOWER module in Configuration Manager’s Device view—in either the device-selector tree, or the table of devices in the content area.

 
    [bookmark: pgfId-377016]Again, discovering ASA CX devices or FirePOWER modules in Security Manager is described in Detecting ASA CX and FirePOWER Modules.

 
    [bookmark: pgfId-377018]Step 2 Right-click the selected device and choose Prime Security Manager or FireSIGHT Management Center from the pop-up menu. Alternatively, you can choose Prime Security Manager or FireSIGHT Management Center from the Configuration Manager’s Launch menu. (These commands are available only when you have selected an ASA CX or an ASA with a FirePOWER module.)

 
    [bookmark: pgfId-377020]The browser-based PRSM or FireSIGHT Management Center window appears, displaying the device screen for the selected device.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-377022]Note The URL used by Security Manager to launch PRSM incorporates the management IP address of the CX module (obtained during device detection), and includes the string /admin/mgmt?rtp. During cross-launch, this type of request is redirected to the appropriate PRSM central server, if one exists. Otherwise, the “on-box” version of PRSM is launched. (To directly launch the on-box version of PRSM yourself, you must type https://<management_IP_address>, where <management_IP_address> is the management address of the desired CX module, into your browser’s address field.)


    
     

    

    

 
    [bookmark: pgfId-377028]Information about using PRSM can be found on the Cisco ASA CX Context-Aware Security End-User Guides page of cisco.com and information about using FireSIGHT Management Center can be found on the Cisco FireSIGHT Management Center page of cisco.com.

 
    [bookmark: pgfId-377030]


    
     

    
 
    

 
     
      [bookmark: pgfId-377046][bookmark: 166620][bookmark: monidiag_cncpt_DetectingASACXModules]Detecting ASA CX and FirePOWER Modules[bookmark: marker-377036][bookmark: marker-377038][bookmark: marker-377040][bookmark: marker-377042][bookmark: marker-377044]

 
     [bookmark: pgfId-377048]Prior to being able to share Policy Object data between Security Manager and PRSM, and to cross-launch PRSM or FireSIGHT Management Center from Configuration Manager, you must ensure that Security Manager is aware of the module.

 
     [bookmark: pgfId-377053]Detection of a CX or FirePOWER module is automatic when you discover a new ASA device by selecting the relevant options in the New Device wizard, as described in Adding Devices to the Device Inventory.

 
     [bookmark: pgfId-377055]When you add a CX or FirePOWER module to an ASA device already in the inventory, you can detect the new module without affecting the existing policies on the host ASA, as follows:

 
     [bookmark: pgfId-377057] 1. Select one or more ASA devices in Configuration Manager’s device-selector tree.

 
     [bookmark: pgfId-377059]You can detect more than one module at once—any selected devices that are not ASAs, or that are ASAs which do not include a CX or FirePOWER module, are ignored.

 
     [bookmark: pgfId-377061] 2. Right-click any selected device and choose Detect ASA-CX/FirePOWER Module from the pop-up menu.

 
     [bookmark: pgfId-377063]The Create Discovery Task dialog box or Bulk Rediscovery dialog box appears, with the Detect ASA-CX/FirePOWER Module option selected—none of the other discovery options are available.

 
     [bookmark: pgfId-377068]See Create Discovery Task and Bulk Rediscovery Dialog Boxes for more information about using this dialog box.

 
     [bookmark: pgfId-377070] 3. Click OK on the Create Discovery Task dialog box or click Finish on the Bulk Rediscovery dialog box to close the dialog box and begin module detection.

 
     [bookmark: pgfId-377072]You may be warned that discovery will replace existing policies; you can safely click Yes to close the warning and proceed.

 
     [bookmark: pgfId-377077]The Discovery Status dialog box opens automatically displaying discovery progress; see Viewing Policy Discovery Task Status for more information about this process.

 
     [bookmark: pgfId-377085]When a CX or FirePOWER module is detected on an ASA, the management IP address of the module itself is fetched and the ASA-CX/FirePOWER Module section of the Device Properties window is updated; see Device Properties: General Page. The management IP address is used to cross-launch PRSM or FireSIGHT Management Center. (Cisco Prime Security Manager, or PRSM, is the application used to configure and manage ASA CX devices and FireSIGHT Management Center is the application used to configure and manage ASA FirePOWER modules, as described in Launching Cisco Prime Security Manager or FireSIGHT Management Center.)

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-377087]Note The URL used by Security Manager to launch PRSM incorporates the management IP address of the CX module (obtained during device detection), and includes the string /admin/mgmt?rtp. During cross-launch, this type of request is redirected to the appropriate PRSM central server, if one exists. Otherwise, the “on-box” version of PRSM is launched. (To directly launch the on-box version of PRSM yourself, you must type https://<management_IP_address>, where <management_IP_address> is the management address of the desired CX module, into your browser’s address field.)


     
      

     

     

 .
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      [bookmark: pgfId-377096]
      Caution You also can detect the presence of a CX or FirePOWER module on an existing ASA by choosing 
      Discover Policies on Device(s) from the selected-device right-click menu, or by choosing 
      Discover Policies on Device from the Policy menu. Depending on the number of devices selected and which command you choose, the Create Discovery Task dialog box, or the Bulk Rediscovery Task dialog box, opens and all discovery-rediscovery options are available. This means you can potentially overwrite any shared policies already established on the selected device(s). Be sure to deselect all options except 
      Detect ASA-CX/FirePOWER Module, unless you are sure you want to rediscover existing policies. See 
      Discovering Policies on Devices Already in Security Manager for more information.
       
       
 
      

     
 
    
 
     
      [bookmark: pgfId-377114][bookmark: 166680][bookmark: monidiag_cncpt_SharingDevicesandPolicieswithPRSM]Sharing Device Inventory and Policy Objects with PRSM [bookmark: marker-377102][bookmark: marker-377104][bookmark: marker-377106][bookmark: marker-377108][bookmark: marker-377110][bookmark: marker-377112]

 
     [bookmark: pgfId-377116]You can export the current device inventory, and the current set of policy objects, as defined in Security Manager for import into Cisco Prime Security Manager (PRSM).

 
     [bookmark: pgfId-377118]Exporting the Device Inventory

 
     [bookmark: pgfId-377123]To share the Security Manager device inventory with PRSM, export the inventory as a comma-separated values (CSV) file, as described in Exporting the Device Inventory. Be sure to specify “Cisco Security Manager” as the format type for the export file.

 
     [bookmark: pgfId-377125]Exporting Networks/Hosts and Services Policy Objects

 
     [bookmark: pgfId-377127]To export Security Manager policy objects—specifically Networks/Hosts objects, or Services objects; PRSM does not support Port List objects—for import into PRSM, you must execute a Perl script on the Security Manager server host to create a CSV file.

 
     [bookmark: pgfId-377132]The Perl script is included in the Security Manager server installation, and its use is described in detail in Importing and Exporting Policy Objects. The basic procedure is as follows:

 
     [bookmark: pgfId-377134] 1. Log into the computer running the Security Manager server, open a Cmd window, navigate to the Perl-script location, and then execute the Perl-script command at the command prompt.

 
     [bookmark: pgfId-377136]Here is an example of the command as used to export Networks/Hosts objects: perl PolicyObjectImportExport.pl -u user -p password -o export -t network -f C:\CSM_Net_objects.csv -e true

 
     [bookmark: pgfId-377138] 2. Copy the CSV file to the PRSM client system.

 
     [bookmark: pgfId-377140]This file can be edited, if necessary.

 
     [bookmark: pgfId-377142] 3. Launch PRSM and import the CSV file. For information about this process, see the section “Importing Objects” in the “Managing Policy Objects” chapter of the PRSM user guide.

 
    
 
   
 
    
     [bookmark: pgfId-377160][bookmark: 166728][bookmark: monidiag_proc_PacketTracer]Analyzing an ASA or PIX Configuration Using Packet Tracer[bookmark: marker-377150][bookmark: marker-377152][bookmark: marker-377154][bookmark: marker-377156][bookmark: marker-377158]

 
    [bookmark: pgfId-377162]Packet tracer is a policy debugging tool for ASA and PIX security appliances running version 7.2.1+ that are not operating in transparent mode. It inspects the active policies currently running on the appliance. Without having to generate real traffic, you can analyze how traffic between two addresses traverses the security appliance, whether it is dropped or allowed. If the result is unexpected, you can determine where the issue exists and update the corresponding policy in Security Manager to resolve it.

 
    [bookmark: pgfId-377164]Packet tracer presents a step-by-step analysis of how a simulated packet is processed by the security appliance’s active configuration. It traces the packet’s flow through the active firewall modules, such as route lookup, access lists, NAT translations, and VPN. The set of active modules changes based on the type of packet configured and the active configuration. For example, if no VPN policies are configured, the VPN module is not evaluated.

 
    [bookmark: pgfId-377166]You can inspect the simulated packet’s traversal rather than having to generate network traffic, enable syslog messages, and manually review resulting syslog messages. Packet tracer details the actions enforced by the active configuration on the packet. If a configuration command causes the packet to be dropped, the reason is provided, such as “Drop-reason: (telnet-not-permitted) Telnet not permitted on least secure interface.”

 
    [bookmark: pgfId-377168]You can trace the life span of a simulated packet through the security appliance to see whether the packet is behaving as expected. Packet tracer uses include the following:

 
     
     		 [bookmark: pgfId-377170]Debug all packet drops in a production network.

 
     		 [bookmark: pgfId-377172]Verify the configuration is working as intended.

 
     		 [bookmark: pgfId-377174]Show all rules applicable to a packet including the CLI that defines the rule.

 
     		 [bookmark: pgfId-377176]Show a time line of packet changes in a data path.

 
     		 [bookmark: pgfId-377178]Trace packets in the data path.

 
     		 [bookmark: pgfId-377180]If the packet is blocked or permitted by some explicit access rule, you can use a short-cut to go to the policy so that you can edit the rule.

 
    

 
    [bookmark: pgfId-377182]Tips:

 
     
     		 [bookmark: pgfId-377186]Packet Tracer is also available in the ASDM application and the ASA command line, and the Security Manager version is equivalent to the ASDM version. For an example of using Packet Tracer from ASDM and the CLI to analyze a configuration, see  PIX/ASA 7.2(1) and later: Intra-Interface Communications .

 
     		 [bookmark: pgfId-377188]Before you can use packet tracer on a device, you must submit your policy changes at least once after adding the device to the inventory.

 
     		 [bookmark: pgfId-377190]Packet tracer analyzes only the active configuration running on a device. Therefore, you cannot use packet tracer to test proposed configurations before they are deployed and running on the device. Do not use packet tracer on a device with pending configuration changes—deploy the changes first and then use packet tracer to ensure the packet tracer results are valid.

 
    

 
    [bookmark: pgfId-377192]To use Packet Tracer:

 
    
 
    [bookmark: pgfId-377194]Step 1 (Device view) Right click on the ASA or PIX 7.2.1+ device and select Packet Tracer on the shortcut menu to open the Packet Tracer window.

 
    [bookmark: pgfId-377196]Step 2 Select the interface you want to test from the Interfaces list. The list contains all interfaces defined on the device.

 
    [bookmark: pgfId-377198]Step 3 Model the packet that you want to trace by configuring the following fields:

 
     
     		 [bookmark: pgfId-377200] Packet Type —Select whether you are tracing a TCP, UDP, ICMP, or IP packet.

 
     		 [bookmark: pgfId-377202] Source, Destination IP Address —Select from the following address types and enter the host addresses for both ends of the communication (from source to destination):

 
    

 
    [bookmark: pgfId-377204] – IP Address of the host.

 
    [bookmark: pgfId-377206] – User (source only). For example, DOMAIN\Administrator. The IP address mapped to the user is used for the trace. You must enable identity-aware firewall by configuring identity options to use this type of address.

 
    [bookmark: pgfId-377208] – FQDN, or fully-qualified domain name, of the host. For example, host.example.com. You must configure DNS to use this type of address.

 
    [bookmark: pgfId-377210] – Security Name (ASA 9.x+ only).

 
    [bookmark: pgfId-377212] – Security Tag (ASA 9.x+ only).

 
     
     		 [bookmark: pgfId-377214] Source, Destination Port (TCP and UDP only) —Enter, or select, the port numbers that represent the traffic type. The selection list uses names that equate to the standard port numbers for the named application. For example, selecting  http and entering  80 is the same.

 
     		 [bookmark: pgfId-377216] Type, Code, ID (ICMP only) —When modeling an ICMP packet, you must enter values in all of these fields:

 
    

 
    [bookmark: pgfId-377220] – Type—Select the ICMP packet type or enter the equivalent number. The list includes all main ICMP types. For a complete list of types and related codes, see RFC 1700 at http://www.ietf.org/rfc/rfc1700.txt and search for “ICMP Type Numbers.”

 
    [bookmark: pgfId-377222] – Code—Enter 0 unless you are modeling a packet type that has non-zero codes. These are destination unreachable (type 3, codes 0-12), redirect (type 5, codes 0-3), time exceeded (type 11, codes 0-1), and parameter problem (type 12, codes 0-2). See RFC 1700 for code explanations, and note that additional codes might have been introduced in other RFCs.

 
    [bookmark: pgfId-377224] – ID—You must enter a value for ID even though the field is used for a limited number of message types only. The ID is used for ICMP types that include request and reply versions, such as echo and echo request, to help match replies to requests. The value should be between 1-255.

 
     
     		 [bookmark: pgfId-377228] Protocol (IP only) —Enter the number that identifies the next level protocol. For a complete list of protocol codes, see RFC 1700 at  http://www.ietf.org/rfc/rfc1700.txt and search for the “Protocol Numbers” heading. As of the writing of this topic, numbers 1-54 and 61-100 represent values assigned to actual protocols from the accepted range of 0-255.

 
    

 
    [bookmark: pgfId-377230]Step 4 If you want to see the progress of the trace while it is happening, select Show animation. Otherwise, the window is not updated with the results until the trace is completed.

 
    [bookmark: pgfId-377232]Step 5 Click Start to trace the packet.

 
    [bookmark: pgfId-377234]The policies are examined, and the bottom of the window shows the results in two forms: graphical and detailed information. The graphical view summarizes the phases evaluated in the packet’s path. Checkmarks indicate the packet passed the phase, a red X indicates the packet was dropped at that point.

 
    [bookmark: pgfId-377236]The detailed information organizes the results in folders that correspond to the phases, with an Action column that indicates the results of the phase (checkmark for passed, red X for dropped). To open a folder, click its heading. Detailed information can include the specific configuration commands evaluated and the data derived from show commands. The final folder, named Result, summaries the results of the trace.

 
    [bookmark: pgfId-377238]Tips:

 
     
     		 [bookmark: pgfId-377240]If the packet is allowed or denied by an explicit access rule, then you can jump to that rule. Select the Access-List folder to open it, then click the  Show access rule link at the top of the section. You are taken to the Access Rule policy with the rule highlighted; you can edit the rule as desired. If a packet is dropped due to an implicit drop rule, the Show access rule link is not available because the rule does not exist in the policy table.

 
     		 [bookmark: pgfId-377242]If the device is shut down or not reachable due to a network failure during the analysis, an error message stating “Device Connectivity is Failed” appears.

 
     		 [bookmark: pgfId-377244]If you start a new trace, the information shown is cleared automatically. However, you can clear it yourself by clicking  Clear .

 
    

 
    [bookmark: pgfId-377246]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-377258][bookmark: 166847][bookmark: monidiag_cncpt_PingTraceLookup]Analyzing Connectivity Issues Using the Ping, Trace Route, or NS Lookup Tools[bookmark: marker-377252][bookmark: marker-377254][bookmark: marker-377256]

 
    [bookmark: pgfId-377260]You can use the Ping or Trace Route tools to investigate and troubleshoot your network configuration and connectivity. You typically run these commands in the device, from within Security Manager by specifying specific launch points and parameters. This causes Security Manager to generate the corresponding command. NS Lookup, on the other hand, is typically run from the Security Manager client.

 
    [bookmark: pgfId-377263] 

 
     
      
       
       [bookmark: pgfId-375086]Table 71-7 [bookmark: 166857]Profiles of the Ping, Trace Route, and NS Lookup Troubleshooting Commands 

 
       
      
        
        		
          
          [bookmark: pgfId-375092]Tool
         
  
        		
          
          [bookmark: pgfId-375094]Profile
         
  
       

 
        
        		
          
          [bookmark: pgfId-375100]Ping
         
  
        		[bookmark: pgfId-375102]Use Ping to test whether a particular host is reachable across an IP network and to measure the round-trip time for packets sent from the local host to a destination computer. This can include measuring the local host’s own interfaces using ICMP messages.

 [bookmark: pgfId-375107]See Analyzing Configuration Using Ping for details on using this tool.

  
       

 
        
        		
          
          [bookmark: pgfId-375113]Trace Route
         
  
        		[bookmark: pgfId-375115]Use trace route to show the route taken by packets across an IP network. The system returns the number of hops taken and the addresses of each device traversed.

 [bookmark: pgfId-375120]See Analyzing Configuration Using TraceRoute for details on using this tool.

  
       

 
        
        		
          
          [bookmark: pgfId-375126]NS Lookup
         
  
        		[bookmark: pgfId-375128]Use NS lookup (namespace lookup) to issue an NS lookup command from a device so you can test the contents of the DNS server that the queried device uses.

 [bookmark: pgfId-375133]See Analyzing Configuration Using NS Lookup for details on using this tool.

 [bookmark: pgfId-375135] 

  
       

 
      
     

 
    
 
    [bookmark: pgfId-377265]Applicability

 
    [bookmark: pgfId-377267]The Ping tool is applicable on the following devices: ASA (7.0 – 8.3), PIX [6.3(1-5) to 8.0(2-4)], FWSM [2.2(1) – 4.1(1)], all IOS. It is not applicable to IPS.

 
    [bookmark: pgfId-377269]The Trace Route tool is applicable on the following devices: ASA [7.2(1) and onward], PIX [6.3(1-5) to 8.0(2-4)], and all IOS. It is not applicable to FWSM nor IPS.

 
    [bookmark: pgfId-377271]The NS Lookup tool is not supported in any of the devices managed by CSM; rather, you run it from the CSM client using the Windows API.

 
     
      [bookmark: pgfId-377281][bookmark: 166898][bookmark: monidiag_proc_Ping]Analyzing Configuration Using Ping[bookmark: marker-377279]

 
     [bookmark: pgfId-377283]The ping tool, by default uses the ICMP echo request and echo reply messages to test reachability to a remote system. You can also choose to employ TCP to ping. In its simplest form, ping simply confirms that an IP packet is capable of getting to and getting back from a destination IP address. A ping is sent to an IP address and it returns a reply. This process enables network devices to discover, identify, and test each other. From within Security Manager, you can designate both the network device from which to issue the ping command, and the target of the echo request. This tool generally returns two pieces of information: whether the source can reach the destination (and, by inference, vice versa), and the round-trip time (RTT, typically in milliseconds).

 
     [bookmark: pgfId-377285]You can use the Ping diagnostic tool in a variety of ways, including:

 
      
      		 [bookmark: pgfId-377287] Pinging to a security appliance —Ping an interface on another security appliance to verify that it is up and responding.

 
      		 [bookmark: pgfId-377289] Loopback testing of two interfaces —Initiate a ping from one interface to another on the same security appliance, as an external loopback test to verify basic “up” status and operation of each interface.

 
      		 [bookmark: pgfId-377291] Pinging through a security appliance —Ping packets originating from the Ping tool may pass through an intermediate security appliance on their way to a device.The echo packets also pass through two of its interfaces as they return. You can use this to perform a basic test of the interfaces, operation, and response time of the intermediate unit.

 
      		 [bookmark: pgfId-377293] Pinging to test intermediate communications —Initiate a ping from a security appliance interface to a network device that is known to be functioning correctly and returning echo requests. If you receive the echo, you confirm physical connectivity and the correct operation of any intermediate devices.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-377295]Tip From within the Event Manager, you can right-click on an event to open the Ping Tool and ping the associated device.


     
      

     

     

 
     
 
     [bookmark: pgfId-377297]Step 1 In Device view, select Tools > Ping, TraceRoute and NS Lookup . . ..

 
     [bookmark: pgfId-377299]The Ping, TraceRoute and NS Lookup dialog box appears.

 
     [bookmark: pgfId-377301]Step 2 From the device selector, select the device from which to issue the Ping command.

 
     [bookmark: pgfId-377303]The selected device is listed in the top right of the dialog box.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-377305]Note To employ TCP for the ping, select TCP for the Packet Type. (The default packet type is ICMP)


     
      

     

     

 
     [bookmark: pgfId-377307]Step 3 In Hostname/IPv4address, enter the IP address of the host network/host policy object to be pinged.

 
     [bookmark: pgfId-377309]Alternatively, click Select to choose a host network/host object that defines the host network/host policy object to be pinged.

 
     [bookmark: pgfId-377311]Step 4 Enter a timeout value. [Optional]

 
     [bookmark: pgfId-377313]Step 5 Click Ping.

 
     [bookmark: pgfId-377315]The results are displayed in the lower window area.

 
     [bookmark: pgfId-377317]Example Ping output:

 
     
      [bookmark: pgfId-377319]Sending 5, 100-byte ICMP Echos to out-pc, timeout is 2 seconds:
     

     
      [bookmark: pgfId-377321] 
     

     
      [bookmark: pgfId-377323]!!!!!
     

     
      [bookmark: pgfId-377325]Success rate is 100 percent (5/5), round-trip min/avg/max = 1/1/1 ms
     

     
      [bookmark: pgfId-377327] 
     

     
      [bookmark: pgfId-377329] 
     

     [bookmark: pgfId-377331]Example Ping unsuccessful output:

 
     
      [bookmark: pgfId-377333]Sending 5, 100-byte ICMP Echos to 10.132.80.101, timeout is 2 seconds:
     

     
      [bookmark: pgfId-377335]?????
     

     
      [bookmark: pgfId-377337] 
     

     
      [bookmark: pgfId-377339]Success rate is 0 percent (0/5)
     

     
      [bookmark: pgfId-377341] 
     

     [bookmark: pgfId-377343]You can click Clear Output to remove the previous response from the Ping output area.

 
     [bookmark: pgfId-377347]For additional details on the ping command, see Troubleshooting TCP/IP on Cisco.com.

 
     [bookmark: pgfId-377349]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-377359][bookmark: 166961][bookmark: monidiag_proc_Traceroute]Analyzing Configuration Using TraceRoute[bookmark: marker-377357]

 
     [bookmark: pgfId-377361]The Traceroute tool helps you to determine the route that packets will take to their destination. The tool prints the result of each probe sent. Every line of output corresponds to a TTL value in increasing order.

 
     [bookmark: pgfId-377363]Traceroute can return useful information about TCP/IP connectivity across your network. The following table shows some of the codes that can be returned by the Traceroute utility, along with their possible cause.

 
     [bookmark: pgfId-377366] 

 
      
       
        
        [bookmark: pgfId-375148]Table 71-8 [bookmark: 166969]Traceroute Output Symbols 

 
        
       
         
         		
           
           [bookmark: pgfId-375154]Output Symbol
          
  
         		
           
           [bookmark: pgfId-375156]Description
          
  
        

 
         
         		[bookmark: pgfId-375162]*

  
         		[bookmark: pgfId-375164]No response was received for the probe within the timeout period.

  
        

 
         
         		[bookmark: pgfId-375170]nn msec

  
         		[bookmark: pgfId-375172]For each node, the round-trip time (in milliseconds) for the specified number of probes.

  
        

 
         
         		[bookmark: pgfId-375178]!N.

  
         		[bookmark: pgfId-375180]ICMP network unreachable.

  
        

 
         
         		[bookmark: pgfId-375186]!H

  
         		[bookmark: pgfId-375188]ICMP host unreachable.

  
        

 
         
         		[bookmark: pgfId-375194]!P

  
         		[bookmark: pgfId-375196]ICMP unreachable.

  
        

 
         
         		[bookmark: pgfId-375202]!A

  
         		[bookmark: pgfId-375204]ICMP administratively prohibited.

  
        

 
         
         		[bookmark: pgfId-375210]?

  
         		[bookmark: pgfId-375212]Unknown ICMP error.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-377368] 

 
     
 
     [bookmark: pgfId-377370]Step 1 In Device view, select Tools > Ping, TraceRoute and NS Lookup . . ..

 
     [bookmark: pgfId-377372]The Ping, TraceRoute and NS Lookup dialog box appears.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-377374]Tip From within the Event Manager, you can right-click on an event to open the TraceRoute page and trace the route of the associated device.


     
      

     

     

 
     [bookmark: pgfId-377376]Step 2 Select the Trace Route tab.

 
     [bookmark: pgfId-377378]The Trace Route page appears.

 
     [bookmark: pgfId-377380]Step 3 From the device selector, select the host from which the route is traced.

 
     [bookmark: pgfId-377382]Step 4 Enter the IPv4 Address/Hostname to specify the address or name of the host to which the route is traced.

 
     [bookmark: pgfId-377384]Alternatively, click Select to choose a host network/host object that defines the IP address.

 
     [bookmark: pgfId-377386]Step 5 Specify values, as required, for the following:

 
     [bookmark: pgfId-377389] 

 
      
       
        
        [bookmark: pgfId-375225]Table 71-9 [bookmark: 167037]Traceroute Fields 

 
        
       
         
         		
           
           [bookmark: pgfId-375231]Field
          
  
         		
           
           [bookmark: pgfId-375233]Description
          
  
        

 
         
         		[bookmark: pgfId-375239]Timeout[optional]

  
         		[bookmark: pgfId-375241]The amount of time, in seconds, to wait for a response before the connection times out. The default is three seconds.

  
        

 
         
         		[bookmark: pgfId-375247]Port[optional]

  
         		[bookmark: pgfId-375249]The destination port used by the UDP probe messages. The default is 33434.

  
        

 
         
         		[bookmark: pgfId-375255]Probes per hop[optional]

  
         		[bookmark: pgfId-375257]The number of probes to be sent at each TTL level. The default is three.

  
        

 
         
         		[bookmark: pgfId-375263]TTL Min[optional]

  
         		[bookmark: pgfId-375265]The minimum TTL value for the first probes. (Default is 1.)

  
        

 
         
         		[bookmark: pgfId-375271]TTL Max[optional]

  
         		[bookmark: pgfId-375273]The maximum TTL value for the first probes.(Default is 30.)

  
        

 
       
      

 
     
 
     [bookmark: pgfId-377391]Step 6 If desired, select Specify Source Interface or IP Address, and then do one of the following:

 
      
      		 [bookmark: pgfId-377393]Select a source  Interface from the dropdown list

 
      		 [bookmark: pgfId-377395]Enter an  IP Address 

 
     

 
     [bookmark: pgfId-377397]Step 7 If desired, select Reverse Resolve to reverse between displaying the address or hostname.

 
     [bookmark: pgfId-377399]Step 8 If desired, select ICMP to use that protocol rather than IP.

 
     [bookmark: pgfId-377401]Step 9 Click Trace.

 
     [bookmark: pgfId-377403]The traceroute terminates when the packet reaches the destination or when the TTL Max value is reached. The hops taken and the device address corresponding to each hop are displayed.

 
     [bookmark: pgfId-377405]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-377415][bookmark: 167100][bookmark: monidiag_proc_Lookup]Analyzing Configuration Using NS Lookup[bookmark: marker-377413]

 
     [bookmark: pgfId-377417]You use the NS Lookup tool to look up a remote host address when you have the hostname, or to look up the hostname when you have the address.

 
     [bookmark: pgfId-377419]Unlike the Ping and Traceroute tools, NS Lookup is done on the Security Manager client.

 
     
 
     [bookmark: pgfId-377421]Step 1 In Device view, select Tools > Ping, TraceRoute and NS Lookup . . ..

 
     [bookmark: pgfId-377423]The Ping, TraceRoute and NS Lookup dialog box appears.

 
     [bookmark: pgfId-377425]Step 2 Select the NS Lookup tab.

 
     [bookmark: pgfId-377427]Step 3 Enter an address or hostname in IPv4Address/Hostname.

 
     [bookmark: pgfId-377429]Alternatively, click Select to choose a host network/host object that defines the IP address.

 
     [bookmark: pgfId-377431]Step 4 Optionally, to employ a particular DNS server in the lookup, enter the server’s name or address in DNS Server.

 
     [bookmark: pgfId-377433]Step 5 Click Lookup.

 
     [bookmark: pgfId-377435]The system displays the particular address/hostname pair, as well as the DNS server used in the lookup.

 
     [bookmark: pgfId-377437]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-377455][bookmark: 167130][bookmark: monidiag_proc_PacketCapture]Using the Packet Capture Wizard[bookmark: marker-377445][bookmark: marker-377447][bookmark: marker-377449][bookmark: marker-377451][bookmark: marker-377453]

 
    [bookmark: pgfId-377457]You can use the Packet Capture Wizard to configure, run, view, and save captures for troubleshooting errors. The captures can be run using preconfigured access lists or using match criteria of packet parameters such as source and destination addresses/ports on one or more interfaces. The wizard runs one capture on each of the ingress and egress interfaces. You can save the captures on the Cisco Security Manager client computer to examine them using a packet analyzer.

 
    [bookmark: pgfId-377459]The Packet Capture Wizard also supports packet captures on ASA clusters. If you run the Packet Capture Wizard on the master unit of an ASA cluster, you are given the option of capturing data for just the selected device or all devices in the cluster. After running the capture for a cluster, you can view summary information for the cluster and also view or download capture buffers for specific devices in the cluster.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-377464]Note If the cluster master has changed, it should be updated in Security Manager before running the Packet Capture Wizard. If not, capture for cluster members will contain errors. You can update the cluster master for a cluster using the Retrieve From Device button on the Device Properties > Cluster Information page. For more information, see Cluster Information Page.


    
     

    

    

 
    [bookmark: pgfId-377466]The captures can be run using pre-configured access-lists or using match criteria of packet parameters such as source, destination address/port on one or more interfaces.

 
    [bookmark: pgfId-377468]Please note the following:

 
     
     		 [bookmark: pgfId-377470]You can only use the Packet Capture Wizard on firewall devices (PIX, ASA, or FWSM).

 
     		 [bookmark: pgfId-377472]Packet capture based on packet match criteria is only supported on devices running ASA version 7.2(3) or later. For other devices, packet capture can only be performed based on access-lists.

 
    

 
    [bookmark: pgfId-377474]To use the Packet Capture Wizard:

 
    
 
    [bookmark: pgfId-377476]Step 1 Launch the Packet Capture Wizard using one of the following methods:

 
     
     		 [bookmark: pgfId-377478]Select  Tools > Packet Capture Wizard .

 
     		 [bookmark: pgfId-377483](Device view) Right-click on an ASA, PIX, or FWSM device and select  Packet Capture on the shortcut menu. Proceed to Step 3.

 
     		 [bookmark: pgfId-377488](Event Viewer) Right-click on an event from an ASA, PIX, or FWSM device and select  Packet Capture on the shortcut menu. Proceed to Step 3.

 
    

 
    [bookmark: pgfId-377490]Step 2 If you launched the Packet Capture Wizard from the Tools menu, select the device on which you want to capture packets. The Security Devices list contains only devices on which packet capture can be run.

 
    [bookmark: pgfId-377494]Step 3 [bookmark: 167177]If you selected a device that is the master unit of an ASA cluster, specify whether to run the capture for the selected device only or for the entire cluster, and then click Next.

 
    [bookmark: pgfId-377496]Step 4 Select the ingress interface from the drop-down list.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-377498]Note You cannot select the same interface as ingress and egress in the same wizard.


    
     

    

    

 
    [bookmark: pgfId-377500]Step 5 In the Packet Match Criteria area, do one of the following:

 
     
     		 [bookmark: pgfId-377502]To specify the access list to use for matching packets, select the  Access-List radio button, and then choose the access list from the drop-down list.

 
     		 [bookmark: pgfId-377504]To specify packet parameters, select the  Packet Parameters radio button and complete the following fields:

 
    

 
    [bookmark: pgfId-377506] – Specify the source and destination in the Source Host / Network and Destination Host / Network fields, respectively. You can use any of the following to specify the source or destination:

 
    [bookmark: pgfId-377508] – Network/host object. Enter the name of the object or click Select to select it from a list. You can also create new network/host objects from the selection list.

 
    [bookmark: pgfId-377510] – Host IP address, for example, 10.10.10.100.

 
    [bookmark: pgfId-377512] – Network address, including subnet mask, in either the format 10.10.10.0/24 or 10.10.10.0/255.255.255.0.

 
    [bookmark: pgfId-377514] – Choose the protocol type to capture from the drop-down list. Available protocol types to capture are ah, eigrp, esp, gre, icmp, icmp6, igmp, igrp, ip, ipinip, nos, ospf, pcp, pim, snp, tcp, or udp.

 
    [bookmark: pgfId-377516]If the protocol is ICMP, select the ICMP type from the drop-down list. Available types include ALL, alternate-address, conversion-error, echo, echo-reply, information-reply, information-request, mask-reply, mask-request, mobile-redirect, parameter-problem, redirect, router-advertisement, router-solicitation, source-quench, time-exceeded, timestamp-reply, timestamp-request, traceroute, or unreachable.

 
    [bookmark: pgfId-377518]If the protocol is TCP or UDP, specify the source and destination port services. Available options include the following:

 
    [bookmark: pgfId-377520] – To include all services, choose All Services.

 
    [bookmark: pgfId-377522] – To indicate specific services, choose an appropriate operator from the drop-down list (=, !=, >, <, or range) and then select one of the following: aol, bgp, chargen, cifs, citrix-ica, ctiqbe, daytime, discard, domain, echo, exec, finger, ftp, ftp-data, gopher, h323, hostname, http, https, ident, imap4, irc, kerberos, klogin, kshell, ldap, ldaps, login, lotusnotes, lpd, netbios-ssn, nfs, nntp, pcanywhere-data, pim-auto-rp, pop2, pop3, pptp, rsh, rtsp, sip, smtp, sqlnet, ssh, sunrpc, tacacs, talk, telnet, uucp, whois, or www. The >, <, and range operators function based on the port number assigned to the selected service.

 
    [bookmark: pgfId-377524]When using the range operator, a second drop-down list is enabled. Use the two drop-down lists to select the starting and ending services in the range you want to specify. The service with the lower corresponding port number should be selected in the first drop-down list, and the service with higher corresponding port number should be selected in the second drop-down list.

 
    [bookmark: pgfId-377526]Step 6 Click Next to proceed to the Select egress interface step.

 
    [bookmark: pgfId-377528]Step 7 Select the egress interface from the drop-down list.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-377530]Note You cannot select the same interface as ingress and egress in the same wizard.


    
     

    

    

 
    [bookmark: pgfId-377532]Step 8 In the Packet Match Criteria area, do one of the following:

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-377534]Note The Packet Match Criteria option (Access-list or Packet Parameters) you selected for the ingress interface will also be used for the egress interface. Also, if you used packet parameters for matching on the ingress interface, the protocol definition you used will also be used for the egress interface.


    
     

    

    

 
     
     		 [bookmark: pgfId-377536]If you are using an access list to match packets, choose the access list from the drop-down list.

 
     		 [bookmark: pgfId-377538]If you are using packet parameters to match packets, the parameters used for ingress are also used for egress.

 
    

 
    [bookmark: pgfId-377540]Step 9 Click Next to proceed to the Set buffer parameters step.

 
    [bookmark: pgfId-377542]Step 10 Specify the buffer parameters by configuring the following fields:

 
    [bookmark: pgfId-377544]In the Buffer Parameters area, you specify the buffer size and packet size. The buffer size is the maximum amount of memory that the capture can use to store packets. The packet size is the longest packet that the capture can hold. We recommend that you use the longest packet size to capture as much information as possible.

 
     
     		 [bookmark: pgfId-377546] Read capture buffer every 10 seconds —Select this option to automatically retrieve captured data every 10 seconds. You must use the circular buffer when selecting this option.

 
     		 [bookmark: pgfId-377548] Use a circular buffer —Select this option to continue capturing packets after the buffer is full. When you choose this setting, if all the buffer storage is used, the capture starts overwriting the oldest packets.

 
     		 [bookmark: pgfId-377550] Buffer Size —Enter the number of bytes (between 1534 and 33554432) that the capture can use to store packets.

 
     		 [bookmark: pgfId-377552] Maximum Packet Size —Enter the number of bytes (between 14 and 1522) that the capture can use to store a single packet. Use the largest value, 1522,to capture as much information as possible.

 
    

 
    [bookmark: pgfId-377554]Step 11 Click Next to proceed to the Summary step, which shows the traffic selectors and buffer parameters that you have entered.

 
    [bookmark: pgfId-377556]Step 12 Click Next to proceed to the Run, View & Save step.

 
    [bookmark: pgfId-377558]Step 13 From the Run, View & Save step, you can do the following:

 
     
     		 [bookmark: pgfId-377560]Click  Start Capture to begin capturing packets.

 
     		 [bookmark: pgfId-377562]Click  Stop Capture to stop capturing packets.

 
     		 [bookmark: pgfId-377564]To fetch the next set of captured packets, do one of the following:

 
    

 
    [bookmark: pgfId-377566] – For individual devices, click Display Capture Packets to fetch the next set of captured packets from the device and update the buffer status bar. This button is only enabled if the Read capture buffer every 10 seconds option was not selected during the Set buffer parameters step.

 
    [bookmark: pgfId-377568] – For clusters, click Get Cluster Capture Summary to fetch the next set of captured packets from the devices in the cluster and update the buffer status bar. This button is only enabled if the Read capture buffer every 10 seconds option was not selected during the Set buffer parameters step.

 
     
     		 [bookmark: pgfId-377570]When running a capture for an ASA cluster, the following option are available for working with the capture buffers of the devices in the cluster:

 
    

 
    [bookmark: pgfId-377572] – To view the captured packets from a device in the cluster, select the device in the Device Name list under Get Capture Buffer, and then click Get Capture Buffer.

 
    [bookmark: pgfId-377574]The capture information for the selected device is displayed. Refer to the other options in this list for the actions you can perform on this data.

 
    [bookmark: pgfId-377576] – To remove the capture content for a specific device or all devices in the cluster and allow room in the buffer to capture more packets, select the device or --All-- in the Device Name field under Clear Capture Buffer, and then click Clear Capture Buffer.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-377578]Note We recommend saving captures prior to clearing the device buffers. If you do not save captures prior to clearing the device buffers, captured data will be lost.


    
     

    

    

 
     
     		 [bookmark: pgfId-377580]Click the  Launch Network Sniffer button above the Ingress Capture window or the Egress Capture window to view the corresponding ingress or egress capture using an external packet analyzer tool. You must have a packet analyzer installed and associated with *.pcap file extension.

 
     		 [bookmark: pgfId-377582]Click  View Data in Larger Window to view the packet capture data side-by-side in a larger window.

 
     		 [bookmark: pgfId-377584]Click  Save captures to display the Save Capture dialog box. Choose the format in which you want to include the captures: ASCII or PCAP. You have the option of saving either the ingress capture or the egress capture.

 
     		 [bookmark: pgfId-377586]Click  Clear Device Buffer to remove the current content and allow room in the buffer to capture more packets.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-377588]Note We recommend saving captures prior to clearing the device buffers. If you do not save captures prior to clearing the device buffers, captured data will be lost.


    
     

    

    

 
     
     		 [bookmark: pgfId-377590]Click  Refresh Capture Buffers to fetch the next set of captured packets for a device in a cluster and update the buffer status bar.

 
    

 
    [bookmark: pgfId-377592]Step 14 Click Finish to exit the wizard.

 
    [bookmark: pgfId-377594]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-377600][bookmark: 167304][bookmark: monidiag_cncpt_IP_Intelligence]IP Intelligence

 
    [bookmark: pgfId-377602]Network security devices managed by Cisco Security Manager generate large amounts of security logs and security events containing the IP address information of the attacker or victim machines or both.

 
    [bookmark: pgfId-377604]Useful details about an IP address, collectively referred to as IP intelligence, can be discovered by using tools such as ping, trace route, and NS lookup. Often, however, it is desirable to augment these somewhat rudimentary tools with more advanced tools.

 
    [bookmark: pgfId-377606]Beginning with Version 4.5, Security Manager provides advanced tools that furnish critical details about an IP address in real time or in generated reports. These critical details are provided by Security Manager in the following categories:

 
     
     		 [bookmark: pgfId-377608]Reverse DNS (FQDN) Lookup Service

 
     		 [bookmark: pgfId-377610]GeoIP Lookup Service

 
     		 [bookmark: pgfId-377612]Whois Lookup Service

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-377614]Note IP intelligence for IPv6 addresses is not supported.


    
     

    

    

 
    [bookmark: pgfId-377616]These IP intelligence categories are described in the following table:

 
    [bookmark: pgfId-377619] 

 
     
      
       
       [bookmark: pgfId-375288]Table 71-10 [bookmark: 167320]IP Intelligence Categories 

 
       
      
        
        		
          
          [bookmark: pgfId-375296]IP Lookup Provider
         
  
        		
          
          [bookmark: pgfId-375298]Information Source
         
  
        		
          
          [bookmark: pgfId-375300]Real Time or Manual/Limitations
         
  
       

 
        
        		[bookmark: pgfId-375308]Reverse DNS (FQDN) Lookup Service

  
        		[bookmark: pgfId-375310]DNS servers

  
        		[bookmark: pgfId-375312]Real time

 [bookmark: pgfId-375314]Note External DNS configuration is an additional option that you can configure, but you will need to evaluate your individual situation.

  
       

 
        
        		[bookmark: pgfId-375322]GeoIP Lookup Service

  
        		[bookmark: pgfId-375324]External third-party commercial vendor

  
        		[bookmark: pgfId-375326]Real time

  
       

 
        
        		[bookmark: pgfId-375334]Whois Lookup Service

  
        		[bookmark: pgfId-375336]Provided by free whois server, a third-party web server.

  
        		[bookmark: pgfId-375338]Real time

 [bookmark: pgfId-375340]Limitations:

 
          
          		 [bookmark: pgfId-375342]Whois is a query and response protocol that is widely used for querying databases that store the registered users or assignees of an Internet resource, such as a domain name, an IP address block, or an autonomous system. There are five regional internet registry (RIR) organizations that manage the allocation and registration of IP addresses.

 
          		 [bookmark: pgfId-375344]ARIN (American Registry for Internet Numbers), RIPE (Réseaux IP Européens Network Coordination Centre), and APNIC (Asia-Pacific Network Information Centre) are the 3 RIR’s that Security Manager will use to query directly; they also provide the referred URL. For RIPE and APNIC, if there is any parsing error, only the direct URL link will be shown.

 
          		 [bookmark: pgfId-375346]Clicking on the provided URL will display the details for the given IP address in web browsers. If an IP address belongs to LACNIC ( Latin America and Caribbean Network Information Centre) or AfriNIC (African Network Information Centre) , the web browser will display the homepage of the respective RIR.

 
          		 [bookmark: pgfId-375348]In some cases (such as dns query getting blocked by windows firewall or invalid proxy has configured in the cco settings page) , Whois may not work even though it is enabled. In such scenario as a “Fail-safe” method it will provide only the referred url.

 
         

  
       

 
      
     

 
    
 
    [bookmark: pgfId-377624]Before you begin looking up IP intelligence, you must enable the necessary services at Configuration Manager > Tools > Security Manager Administration... > IP Intelligence Settings. Refer to IP Intelligence Settings Page.

 
    [bookmark: pgfId-377626]IP intelligence lookup can be done by using any of the following methods:

 
     
     		 [bookmark: pgfId-377630]Use the IP Intelligence dialog box: Navigate to  Configuration Manager > Tools > IP Intelligence... and then enter a valid IPv4 address in the search field of the IP Intelligence dialog box that pops up. (You must press  Enter after typing the IP address.)[bookmark: marker-377628]

 
     		 [bookmark: pgfId-377636]Use "Quick Launch" by mousing over (hovering over) a valid IPv4 address in the Security Manager interface. You can do this in Event Viewer, for example; in general, you can do this in all GUI tables in which an IP address is part of the data displayed. If more than one IP address is displayed in one cell of a GUI table, only the first IP address is displayed.[bookmark: marker-377632][bookmark: marker-377634]

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-377638]Note You may experience a second or two of latency with Quick Launch before you see the "IP Intelligence" option in the GUI.
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    [bookmark: pgfId-377640]Note You can enable or disable Quick Launch by selecting or clearing the "Enable Quick Launch" check box in the IP Intelligence dialog box at Configuration Manager > Tools > IP Intelligence....


    
     

    

    

 
     
     		 [bookmark: pgfId-377644]Use the IP Intelligence widget in the Dashboard ( Launch > Dashboard... ). This method is equivalent to using the IP Intelligence dialog box described above.[bookmark: marker-377642]

 
     		 [bookmark: pgfId-377648]Use Report Manager ( Launch > Report Manager... ) to see IP intelligence in any of the following reports:[bookmark: marker-377646]

 
    

 
    [bookmark: pgfId-377650] – FW/Summary Botnet—Top Infected Hosts

 
    [bookmark: pgfId-377652] – FW/Summary Botnet—Top Malware Sites

 
    [bookmark: pgfId-377654] – FW—Top Destinations

 
    [bookmark: pgfId-377656] – FW—Top Sources

 
    [bookmark: pgfId-377658] – IPS—Target Analysis

 
    [bookmark: pgfId-377660] – IPS—Top Attackers

 
    [bookmark: pgfId-377662] – IPS—Top Victims

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-377664]Note There are several points to note about these reports: 1) They will not contain Whois information. 2) If you have disabled all the providers at Configuration Manager > Tools > Security Manager Administration... > IP Intelligence Settings, then none of the IP intelligence-related columns will be displayed in the report. 3) If you enable all the services, only the reverse dns (FQDN) and GeoIP details will be displayed in the report. 4) If you enable only one service, then that service only will be displayed in the report.


    
     

    

    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-377666]Note The generated report in both PDF and CSV formats will contain the IP intelligence details.
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    [bookmark: pgfId-377671]Note All these reports require the necessary services to be enabled. Refer to IP Intelligence Settings Page.


    
     

    

    

 
   
 
    
     [bookmark: pgfId-377683][bookmark: 167430][bookmark: monidiag_cncpt_SecurityManagerPolicyTableLookupfromaMARSEvent]Integrating CS-MARS and Security Manager[bookmark: marker-377677][bookmark: marker-377679][bookmark: marker-377681]

 
    [bookmark: pgfId-377685]While Cisco Security Manager lets you centrally manage security policies and device settings in your network, the Cisco Security Monitoring, Analysis and Response System (CS-MARS) is a separate application that monitors devices and collects event information, including syslog messages and NetFlow traffic records, with much more extensive network monitoring capabilities than Security Manager. CS-MARS aggregates and presents massive amounts of network and security data in an easy-to-use format. Based on information derived from CS-MARS reports, you can edit device policies in Security Manager to counter security threats.

 
    [bookmark: pgfId-377687]Specifically, if you use Security Manager to configure firewall access rules and IPS signatures, you can configure CS-MARS to collect information related to those policies and make it available to Security Manager users. By registering the CS-MARS servers with Security Manager, users can navigate directly from a specific access rule or IPS signature to a CS-MARS report window, pre-populated with query criteria for that rule or signature.

 
    [bookmark: pgfId-377689]Similarly, CS-MARS users can view the Security Manager policies related to specific CS-MARS events. This bi-directional mapping of specific events to the policies that triggered them, combined with the ability to immediately modify the policies, can dramatically reduce the time spent configuring and troubleshooting large or complex networks.

 
    [bookmark: pgfId-377691]To enable this cross-communication, you must register your CS-MARS servers with Security Manager, and register your Security Manager server with the CS-MARS servers. You must also register the specific devices with each application. Then, when working with firewall access rules or IPS signatures for a device, a Security Manager user can quickly view real-time and historical event information related to that rule or signature.

 
    [bookmark: pgfId-377693]The following sections explain how to enable and use CS-MARS and Security Manager cross-communication:

 
     
     		 [bookmark: pgfId-377698]Checklist for Integrating CS-MARS with Security Manager

 
     		 [bookmark: pgfId-377703]Looking Up CS-MARS Events for a Security Manager Policy

 
     		 [bookmark: pgfId-377708]Looking Up a Security Manager Policy from a CS-MARS Event

 
    

 
     
      [bookmark: pgfId-377718][bookmark: 167457][bookmark: monidiag_cncpt_ChecklistforEventsLookupfromSecurityManager]Checklist for Integrating CS-MARS with Security Manager[bookmark: marker-377714][bookmark: marker-377716]

 
     [bookmark: pgfId-377723]To enable the cross-communication between CS-MARS and Security Manager (as described in Integrating CS-MARS and Security Manager), you must identify the applications to each other and ensure that devices managed by both applications are configured appropriately. The following table describes the integration steps.

 
     [bookmark: pgfId-377728]If you have problems with cross-communications, see Troubleshooting Tips for CS-MARS Querying.

 
     [bookmark: pgfId-377731] 

 
      
       
        
        [bookmark: pgfId-375361]Table 71-11 [bookmark: 167470]Integrating CS-MARS and Security Manager 

 
        
       
         
         		
           
           [bookmark: pgfId-375367]Task
          
  
         		
           
           [bookmark: pgfId-375369]Description
          
  
        

 
         
         		
           
           [bookmark: pgfId-375375]Add the devices to Security Manager and CS-MARS
          
  
         		[bookmark: pgfId-375382]See Adding Devices to the Device Inventory for information about adding devices to Security Manager. See the Device Configuration Guide for Cisco Security MARS for information about adding devices to the CS-MARS inventory.

 [bookmark: pgfId-375384]A device must be supported by both applications to provide cross-communication for the device. Supported device types generally are those providing Firewall > Access Rules, or IPS > Signatures policies. (These include: PIX, ASA and FWSM appliances, Cisco IOS routers, Cisco IPS sensors and modules, and Cisco Catalyst switches.)

  
        

 
         
         		
           
           [bookmark: pgfId-375390]Configure the devices as required by each application
          
  
         		[bookmark: pgfId-375397]See Chapter 2, “Preparing Devices for Management” for information about basic configuration requirements for Security Manager. See Device Configuration Guide for Cisco Security MARS for the more extensive requirements for CS-MARS.

  
        

 
         
         		
           
           [bookmark: pgfId-375403]Register Security Manager with CS-MARS
          
  
         		[bookmark: pgfId-375407]For information on configuring CS-MARS to communicate with Security Manager, see User Guide for Cisco Security MARS Local and Global Controllers.

 [bookmark: pgfId-375412]You might want to create a CS-MARS user account specifically for linking with Security Manager. See Configuring the Security Manager Server to Respond to CS-MARS Policy Queries.

  
        

 
         
         		
           
           [bookmark: pgfId-375418]Register CS-MARS controllers with Security Manager
          
  
         		[bookmark: pgfId-375423]For information on registering CS-MARS controllers with Security Manager, see Registering CS-MARS Servers in Security Manager.

  
        

 
         
         		
           
           [bookmark: pgfId-375429]Link CS-MARS controllers to the devices in Security Manager
          
  
         		[bookmark: pgfId-375434]In Security Manager, you can proactively discover the CS-MARS controllers that monitor a particular device by clicking Discover CS-MARS on the device’s Device Properties page, as described in Discovering or Changing the CS-MARS Controllers for a Device. Otherwise, the appropriate controller is discovered automatically when a user attempts to look up events for the device (the user is prompted to select a controller if more than one monitors the device).

  
        

 
       
      

 
     
 
     [bookmark: pgfId-377733]Related Topics

 
      
      		 [bookmark: pgfId-377738]Viewing CS-MARS Events for an Access Rule

 
      		 [bookmark: pgfId-377743]Viewing CS-MARS Events for an IPS Signature

 
      		 [bookmark: pgfId-377748]Looking Up a Security Manager Policy from a CS-MARS Event

 
     

 
    
 
     
      [bookmark: pgfId-377758][bookmark: 167536][bookmark: monidiag_cncpt_BootstrappingSecurityManagerServertoCommunicatewithMARS]Configuring the Security Manager Server to Respond to CS-MARS Policy Queries[bookmark: marker-377754][bookmark: marker-377756]

 
     [bookmark: pgfId-377760]CS-MARS must be allowed access to the Security Manager server so that it can perform policy lookup queries and obtain policy information.

 
      
      		 [bookmark: pgfId-377762]If you are using Common Services AAA authentication on the server (for example, Cisco Secure ACS), you must update the administrative access settings to ensure that CS-MARS has the necessary client access to the Security Manager server.

 
      		 [bookmark: pgfId-377764]Define a user account in Security Manager that CS-MARS can use to perform queries. A separate account is recommended to provide a specific audit trail on the Security Manager server. This account must be assigned one of the following Common Services roles:

 
     

 
     [bookmark: pgfId-377766] – Approver

 
     [bookmark: pgfId-377768] – Network Operator

 
     [bookmark: pgfId-377770] – Network Administrator

 
     [bookmark: pgfId-377772] – System Administrator

 
     [bookmark: pgfId-377774]Users with the Help Desk security level can only view the policy look-up table in CS-MARS; that is, they cannot cross-launch Security Manager to modify policies.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-377776]Note When you register a Security Manager server with CS-MARS, if you choose to prompt for Security Manager credentials for policy table look-up, a separate CS-MARS account in Common Services for authentication purposes might not be necessary.


     
      

     

     

 
     [bookmark: pgfId-377778]For more information on adding users and associating roles with them in Common Services, see the User Guide for CiscoWorks Common Services.

 
     [bookmark: pgfId-377780]Related Topics

 
      
      		 [bookmark: pgfId-377785]Registering CS-MARS Servers in Security Manager

 
      		 [bookmark: pgfId-377790]Discovering or Changing the CS-MARS Controllers for a Device

 
     

 
    
 
     
      [bookmark: pgfId-377798][bookmark: 167573][bookmark: wfplan_proc_ConfiguringCSMARSServers]Registering CS-MARS Servers in Security Manager[bookmark: marker-377796]

 
     [bookmark: pgfId-377803]As described in Checklist for Integrating CS-MARS with Security Manager, you must register your CS-MARS controllers with Security Manager to enable cross-communication between the applications if you intend to use the applications together.

 
     [bookmark: pgfId-377808]Then, when a user looks up events for a device, Security Manager identifies the CS-MARS controller that is collecting events for that device. If more than one CS-MARS controller is collecting events for a device, the user can select which to use. You can also specify the correct CS-MARS controller to use in the Device Properties window for each device. (See Discovering or Changing the CS-MARS Controllers for a Device for more information.)

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-377812]Note For information about the CS-MARS versions explicitly supported by Security Manager, see the Release Notes for Cisco Security Manager for this version of the product. If you do try to use a version that is not explicitly supported, you cannot use CS-MARS versions earlier than 4.3.4 or 5.3.4.


     
      

     

     

 
     
 
     [bookmark: pgfId-377817]Step 1 Choose Tools > Security Manager Administration and select CS-MARS in the table of contents to display the CS-MARS Page.

 
     [bookmark: pgfId-377822]Step 2 Click the Add button to add a CS-MARS server. The New CS-MARS Device dialog box opens (see New or Edit CS-MARS Device Dialog Box for detailed information).

 
     [bookmark: pgfId-377824]Step 3 In the New CS-MARS Device dialog box, enter the IP address or fully qualified DNS host name of the server, and a user name and password for logging into the server. If you add a local controller, the user name you enter can be either a local account or a global account. Choose the type of account from the User Type list.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-377826]Tip If you are using CS-MARS Global Controllers, add them instead of individual Local Controllers. By adding Global Controllers, Security Manager can identify the correct Local Controller for a device, without you having to add each Local Controller. When you add a Global Controller, do not add the individual Local Controllers monitored by the Global Controller.


     
      

     

     

 
     [bookmark: pgfId-377828]Click Retrieve From Device to get the server’s authentication certificate. Click Accept when the certificate is presented to you.

 
     [bookmark: pgfId-377830]Click OK when finished. The New CS-MARS Device dialog box closes and the server is added to the CS-MARS device list.

 
     [bookmark: pgfId-377832]Step 4 From the When Launching CS-MARS list, choose whether you want users to be prompted to log in to the CS-MARS server when they request event status, or whether Security Manager should automatically log in to CS-MARS using the credentials provided when the user logged in to Security Manager.

 
     [bookmark: pgfId-377834]If you elect to use Security Manager credentials, the necessary user accounts must be configured in CS-MARS. Refer to the CS-MARS documentation for more information.

 
     [bookmark: pgfId-377836]Step 5 Click Save on the CS-MARS page to save your changes.

 
     [bookmark: pgfId-377838]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-377848][bookmark: 167613][bookmark: ivman_proc_DiscoveringorChangingtheCSMARSServerforaDevice]Discovering or Changing the CS-MARS Controllers for a Device[bookmark: marker-377844][bookmark: marker-377846]

 
     [bookmark: pgfId-377850]If you use the Cisco Security Monitoring, Analysis and Response System (CS-MARS) controllers to monitor devices, you can register them in Security Manager and then view syslogs and events that are related to firewall access or IPS signature rules for individual devices.

 
     [bookmark: pgfId-377852]Security Manager can automatically discover the CS-MARS controllers that monitor a device when you try to view events related to a rule. If more than one controller monitors a device, you are prompted to select which controller to use.

 
     [bookmark: pgfId-377854]You can also proactively select the CS-MARS controller for a device in its Device Properties window. Similarly, if you ever need to change the CS-MARS controller assigned to a device, you can change the selection in its Device Properties window. This procedure explains how to discover or change the CS-MARS controller for a device from its Device Properties window.

 
     [bookmark: pgfId-377856]Before You Begin

 
     [bookmark: pgfId-377861]The CS-MARS controller that monitors the device must already be registered with Security Manager on the CS-MARS administration page (Tools > Security Manager Administration > CS-MARS). For more information, see Registering CS-MARS Servers in Security Manager.

 
     
 
     [bookmark: pgfId-377863]Step 1 In Device view, do one of the following in the Device selector to open the Device Properties dialog box:

 
      
      		 [bookmark: pgfId-377865]Double-click a device.

 
      		 [bookmark: pgfId-377867]Right-click a device and choose  Device Properties .

 
      		 [bookmark: pgfId-377869]Select a device and choose  Tools > Device Properties .

 
     

 
     [bookmark: pgfId-377874]Step 2 Click General in the table of contents to open the General properties page (see Device Properties: General Page).

 
     [bookmark: pgfId-377876]Step 3 In the CS-MARS Monitoring group, click Discover CS-MARS. Security Manager determines which registered controller is monitoring the device, if any. If there are more than one, you are prompted to select which CS-MARS controller to use.

 
     [bookmark: pgfId-377878]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-377890][bookmark: 167651][bookmark: monidiag_cncpt_TroubleshootingTipsforCSMARSQuerying]Troubleshooting Tips for CS-MARS Querying[bookmark: marker-377884][bookmark: marker-377886][bookmark: marker-377888]

 
     [bookmark: pgfId-377892]Use the following troubleshooting tips to help you identify and resolve problems you might encounter when using CS-MARS and Security Manager together:

 
      
      		 [bookmark: pgfId-377894]HTTPS is required for communication between the Security Manager server and CS-MARS.

 
      		 [bookmark: pgfId-377896]Interface names are not case-sensitive in Security Manager, but they are in CS-MARS. For example, “outside” and “Outside” are considered exclusive by a CS-MARS appliance, while they are equivalent in Security Manager. Further, syslog messages use lower case for all interface names. As a result, when you perform a query for a Security Manager policy from an event generated in CS-MARS, the interface name logged in the syslog event might not match the interface name in that policy in Security Manager. To avoid this problem, use lower case for all interface names, and in the definition of interface roles, in CS-MARS.

 
      		 [bookmark: pgfId-377898]To query for CS-MARS events from Security Manager policies, the Security Manager client must be on the same side of a network address translation (NAT) boundary as the CS-MARS appliance and the Security Manager server.

 
     

 
     [bookmark: pgfId-377900]Similarly, when the CS-MARS client is not on the same side of a NAT boundary as the CS-MARS appliance and the Security Manager server, you can look up Security Manager policies, but in read-only mode. However, you cannot start the Security Manager client from the read-only policy look-up table. The Security Manager client must be on the same side of the NAT boundary as the CS-MARS appliance and the Security Manager server if you want to start the client from CS-MARS to modify a matching policy.

 
      
      		 [bookmark: pgfId-377902]For FWSM, PIX and ASA devices on which multiple independent security contexts exist, to query for CS-MARS events, you must define a unique management IP address in Security Manager for each security context. Also, the host name and reporting IP address for each virtual context must be configured before adding it to CS-MARS. Otherwise, event look-up from policies on these contexts fails.

 
      		 [bookmark: pgfId-377904]For all IPS device and service policies, a default signature policy is assigned to the device when you do not discover IPS policies, or when you remove the configured policies from the device. If you try to perform event look-up from the default signature, a “Policy not found” error message is displayed. However, if you edit the default signature and save it, you can then navigate to events in CS-MARS.

 
      		 [bookmark: pgfId-377906]If object grouping or rule optimization is enabled for an access rule defined in Security Manager and the associated access-list commands on the device do not match the optimized rules, no events are displayed in CS-MARS.

 
      		 [bookmark: pgfId-377908]If logging is not enabled for an access rule, a warning message is displayed, and you can only look up traffic-flow events for those rules.

 
      		 [bookmark: pgfId-377910]When supported by the device, Security Manager uses access-control entry (ACE) hashcodes as additional keywords when querying CS-MARS for syslog messages generated by an ACE, and large access-control lists (ACLs) might contain thousands of such hashcodes. If the number of keywords, or the sum of the number of sources, destinations, and protocols for an ACE or a signature exceeds the query limit of 150, an error message is displayed. The error message indicates the probable cause and recommended action.

 
      		 [bookmark: pgfId-377912]Problems with the synchronization between rules and reported events can occur in the following situations:

 
     

 
     [bookmark: pgfId-377914] – The device has been added to Security Manager, but the configuration or changes to it have not been saved to the database. This is especially true for access rules that have been changed but not deployed since the device was added to CS-MARS.

 
     [bookmark: pgfId-377916] – Access rules exist on the device for which there are no corresponding rules in Security Manager, and vice versa. Be sure all devices are added to Security Manager, and that access rules are configured on them using Security Manager.

 
     [bookmark: pgfId-377918] – Traffic in the “wrong” direction triggering events for which there is no defined rule. For example, outbound traffic on a higher-security-level interface on which only inbound-traffic rules have been defined.

 
      
      		 [bookmark: pgfId-377920]If you perform a policy lookup from CS-MARS and the Security Manager client is active, the query is performed on all policies within the open activity or configuration session plus what is saved in the database (the committed configurations). If the Security Manager client is not active, only committed policies are considered.

 
     

 
     [bookmark: pgfId-377922]Related Topics

 
      
      		 [bookmark: pgfId-377927]Checklist for Integrating CS-MARS with Security Manager

 
      		 [bookmark: pgfId-377932]Looking Up CS-MARS Events for a Security Manager Policy

 
      		 [bookmark: pgfId-377937]Registering CS-MARS Servers in Security Manager

 
     

 
    
 
     
      [bookmark: pgfId-377951][bookmark: 167708][bookmark: monidiag_cncpt_LookingUpCSMARSEventsforaSecurityManagerPolicy]Looking Up CS-MARS Events for a Security Manager Policy[bookmark: marker-377943][bookmark: marker-377945][bookmark: marker-377947][bookmark: marker-377949]

 
     [bookmark: pgfId-377953]After you integrate CS-MARS and Security Manager, you can look up events in CS-MARS that relate to specific firewall access rules or IPS signatures.

 
     [bookmark: pgfId-377955]When CS-MARS receives events, they are parsed, “sessionized,” written to an event buffer, and then written to the database. Sessionizing takes two forms: with a session-oriented protocol, such as TCP, the session encompasses the initial handshake to the connection tear-down; with a sessionless protocol, such as UDP, the session start and end times are based more on first and last packets tracked within a restricted time period—packets that fall outside of the time period are considered parts of other sessions.

 
     [bookmark: pgfId-377957]Because there is a difference between newly-received and fully processed data, you can look up either real-time or historical events:

 
      
      		 [bookmark: pgfId-377959] Real-time —Because sessionization takes time, keeping an event in cache for up to two minutes, you can use the real-time event query to view events right after parsing, providing access to the most current data received.

 
     

 
     [bookmark: pgfId-377961]When you query for real-time events, the query is run automatically, based on the policy values obtained from Security Manager, and the results are displayed in the CS-MARS Query Results window. This real-time event viewer lets you monitor CS-MARS traffic in near real-time, as raw events streaming to CS-MARS, before they are sessionized, with a maximum delay of five seconds. You also can elect to view the sessionized event stream by clicking Edit in the Query Results window and then choosing “Sessionized events” from the Realtime drop-down menu. Note that more delay is possible when there are many events in a session.

 
      
      		 [bookmark: pgfId-377963] Historical —Historical event reports help you identify trends over longer periods of time than is possible with real-time monitoring. When you query for historical events, the CS-MARS Query Criteria: Result window opens. You can either run the query immediately, or save the criteria as a “report” to run at a later time. For historical events, the Result Format is the All Matching Events option, and the Filter By Time value is set to the previous 10 minutes.

 
     

 
     [bookmark: pgfId-377965]The following topics explain event lookup in more detail:

 
      
      		 [bookmark: pgfId-377970]Viewing CS-MARS Events for an Access Rule

 
      		 [bookmark: pgfId-377975]Viewing CS-MARS Events for an IPS Signature

 
     

 
    
 
     
      [bookmark: pgfId-377991][bookmark: 167745][bookmark: monidiag_proc_NavigatingtoMARSEventsfromanAccessRulePolicy]Viewing CS-MARS Events for an Access Rule[bookmark: marker-377981][bookmark: marker-377983][bookmark: marker-377985][bookmark: marker-377987][bookmark: marker-377989]

 
     [bookmark: pgfId-377993]From the Firewall > Access Rules policy in Security Manager, you can select an access rule and view related event information in CS-MARS. You can view real-time or historical events matching the rule, the traffic flow, the source address, or the destination address. You can view events for any device that supports access rules, including ASA, PIX, FWSM, routers, and switches.

 
     [bookmark: pgfId-377998]Firewall access rules are presented in the form of an ordered list or table. When deployed, this policy becomes an access-control list (ACL), with each entry in the list known as an access-control entry (ACE). (For more detailed information, see Understanding Access Rules.)

 
     [bookmark: pgfId-378003]When deciding whether to forward or drop a packet, a device tests the packet against each access rule in the ordered listed. If you enable logging for an access rule, the results of the test are recording according to your per-rule log settings. Some devices, such as ASA, generate log entries for denied access even if you do not configure logging explicitly. For information on creating access rules, including logging options, see Configuring Access Rules.

 
     [bookmark: pgfId-378005]You can query CS-MARS for real-time or historical events related to an access rule for the following types of traffic. To use the commands, right-click the rule and select them from the context menu.

 
      
      		 [bookmark: pgfId-378007] Flow —A traffic flow is defined by the rule’s source and destination IP addresses, protocol, and ports. The reported flow events include connection set-up and tear-down. Logging need not be enabled for the access rule to record this information.

 
     

 
     [bookmark: pgfId-378009]To view flow-related events, use the following right-click commands:

 
     [bookmark: pgfId-378011] – Show MARS Events > Realtime > Matching this Flow—To view real-time query results in CS-MARS for events matching this traffic flow. You can change the query criteria in the CS-MARS window at any time, applying new parameters to alter the real-time results.

 
     [bookmark: pgfId-378013] – Show MARS Events > Historical > Matching this Flow—Opens the historical query criteria page in CS-MARS with fields populated based on the selected rule’s traffic flow. Edit the rule parameters and query criteria as desired, and click Apply to continue. Next, in the Query window, you can submit the query or save it for later submission and re-use.

 
      
      		 [bookmark: pgfId-378018] Rule —If logging is enabled for the rule (in the Advanced and Edit Options Dialog Boxes), the device sends syslog messages to CS-MARS to record the logged events (assuming CS-MARS monitors the device). This query includes the access-rule parameters, including available keyword information. Reported events do not include connection set-up and tear-down.

 
     

 
     [bookmark: pgfId-378020]To view rule-related events, use the following right-click commands:

 
     [bookmark: pgfId-378022] – Show MARS Events > Realtime > Matching this Rule—To view real-time query results in CS-MARS for events matching this rule (flow parameters plus keywords); results begin scrolling within five seconds. You can change the query criteria in the CS-MARS window at any time, applying new parameters to alter the real-time results.

 
     [bookmark: pgfId-378024] – Show MARS Events > Historical > Matching this Rule—Opens the historical query criteria page in CS-MARS with fields populated based on the access rule (flow parameters plus keywords). Edit the rule parameters and query criteria as desired, and click Apply to continue. Next, in the Query window, you can submit the query, or save it for later submission and re-use.

 
      
      		 [bookmark: pgfId-378026] Source or Destination —If you right-click the Source or Destination cell in an access rule entry, you also can choose to view real-time or historical events matching the rule’s source or destination IP address.

 
     

 
     [bookmark: pgfId-378028]To view events for a source or destination address, right-click the address in the Source or Destination cell and choose one of the following commands (the specific command differs depending on the cell you select):

 
     [bookmark: pgfId-378030] – Show MARS Events > Realtime > Matching this Source/Destination—To view real-time query results in CS-MARS for events with a matching source or destination address. You can change the query criteria in the CS-MARS window at any time, applying new parameters to alter the real-time results.

 
     [bookmark: pgfId-378032] – Show MARS Events > Historical > Matching this Source/Destination—Opens the historical query criteria page in CS-MARS with fields populated based on the access rule’s source or destination address. Edit the rule parameters and query criteria as desired, and click Apply to continue. Next, in the Query window, you can submit the query, or save it for later submission and re-use.

 
     [bookmark: pgfId-378034]Security Manager provides the following information to CS-MARS as criteria for a traffic-flow or access-rule event queries:

 
      
      		 [bookmark: pgfId-378036]Device details—General information about the device, such as host name, domain name, management IP address, and display name.

 
      		 [bookmark: pgfId-378038]Source addresses—Source addresses of hosts and the network/host objects expanded to display the networks or collections of IP addresses.

 
      		 [bookmark: pgfId-378040]Destination addresses—Destination addresses of hosts and the network/host objects expanded to display the networks or collections of IP addresses.

 
      		 [bookmark: pgfId-378042]Service—Protocol and port information.

 
      		 [bookmark: pgfId-378044]Event Type—“Built/teardown/permitted IP connection” for permit rules and “Deny packet due to security policy” for deny rules.

 
      		 [bookmark: pgfId-378046]Keyword (rule events only, not provided for traffic-flow queries)—ACL name and ACE hashcode, if available, connected by the logical operator OR.

 
     

 
     [bookmark: pgfId-378048]On Version 7.0 or later PIX and ASA devices, each access rule is assigned an MD5 hashcode, which is included in the syslogs generated by that rule. Large ACLs can include thousands of access rules. Used as query keywords, these hashcodes can help produce more-accurate event matches. If a device does not support hashcodes, a warning is displayed that query results might be inaccurate because of keyword ambiguity; you can proceed with the query, and then edit the query keyword list and resubmit.

 
     [bookmark: pgfId-378050]Tips:

 
      
      		 [bookmark: pgfId-378052]You can query on only one access rule at a time.

 
      		 [bookmark: pgfId-378054]When NAT or PAT is configured on a security device, the source and destination addresses are mapped to pre-translation and post-translation addresses, respectively, and the translated addresses are used when Security Manager sends a query to CS-MARS. For inbound access rules, the destination address is considered the pre-translation address, and for outbound access rules, the source address is considered the post-translation address.

 
      		 [bookmark: pgfId-378056]If the device is monitored by multiple CS-MARS controllers, you are prompted to select the CS-MARS instance to be used.

 
      		 [bookmark: pgfId-378061]Depending on how credentials verification is set up on your system, you might be prompted to log into CS-MARS. For more information, see Registering CS-MARS Servers in Security Manager.

 
     

 
     [bookmark: pgfId-378063]Related Topics

 
      
      		 [bookmark: pgfId-378068]Access Rules Page

 
      		 [bookmark: pgfId-378073]Looking Up CS-MARS Events for a Security Manager Policy

 
      		 [bookmark: pgfId-378078]Viewing CS-MARS Events for an IPS Signature

 
     

 
    
 
     
      [bookmark: pgfId-378096][bookmark: 167850][bookmark: monidiag_proc_NavigatingtoMARSEventsfromanIPSSignaturePolicy]Viewing CS-MARS Events for an IPS Signature[bookmark: marker-378084][bookmark: marker-378086][bookmark: marker-378088][bookmark: marker-378090][bookmark: marker-378092][bookmark: marker-378094]

 
     [bookmark: pgfId-378098]When an IPS or IOS IPS device detects and reports a network intrusion by comparing incoming traffic to a configured signature, a syslog message is generated on the device. If the device is monitored by CS-MARS, an incident is generated in CS-MARS after the log associated with the signature is obtained from the device. Looking up the events associated with a specific signature lets you quickly identify attacks and tune your device configuration to minimize or prevent intrusions.

 
     [bookmark: pgfId-378100]To view reported network intrusion events in CS-MARS, you can select one or more entries in the Signatures policy for a device in Security Manager and navigate to the CS-MARS Query page to view real-time and historical events.

 
     [bookmark: pgfId-378102]When you look up real-time events for a signature, the query is run automatically and the results displayed in CS-MARS. However, when you look up historical events for a signature, the values sent by Security Manager to CS-MARS are used to populate the query fields. You can modify the query fields as desired, and then run the query, or save it for later use.

 
     [bookmark: pgfId-378104]Security Manager provides the following signature information to CS-MARS as query criteria:

 
      
      		 [bookmark: pgfId-378106]Device details—General information about the device, such as host name, domain name, management IP address, and display name.

 
      		 [bookmark: pgfId-378108]Keyword—Signature ID, subsignature ID, and virtual sensor name, if applicable.

 
     

 
     [bookmark: pgfId-378110]For virtual sensors, the name of the sensor is included as a keyword criterion along with other device information and signature parameters.

 
     [bookmark: pgfId-378112]Related Topics

 
      
      		 [bookmark: pgfId-378117]Looking Up CS-MARS Events for a Security Manager Policy

 
      		 [bookmark: pgfId-378122]Viewing CS-MARS Events for an Access Rule

 
     

 
     
 
     [bookmark: pgfId-378127]Step 1 (Device view) With an IPS or IOS IPS device selected, select IPS > Signatures > Signatures to display the Signatures Page.

 
     [bookmark: pgfId-378129]Step 2 Right-click the desired entry in the signatures table, or select multiple entries before right-clicking one of them, and choose one of the following commands from the Show MARS Events menu:

 
      
      		 [bookmark: pgfId-378131] Realtime —To view real-time query results in CS-MARS for events matching this signature; results begin scrolling within five seconds. Use this option to view raw events as they stream to CS-MARS.

 
     

 
     [bookmark: pgfId-378133]You can change the query criteria in the CS-MARS Query Results window at any time, applying new parameters to alter the real-time results.

 
      
      		 [bookmark: pgfId-378135] Historical —Opens the historical query criteria page in CS-MARS with fields populated based on the signature parameters. Edit the parameters and query criteria as desired, and click Apply to continue. Next, in the Query window, you can submit the query or save it for later submission and re-use. You can edit the query and save it as a report if you want to run it again later.

 
     

 
     [bookmark: pgfId-378137]Tips:

 
      
      		 [bookmark: pgfId-378139]If a signature is disabled, you are warned and asked if you want to proceed to event lookup.

 
      		 [bookmark: pgfId-378141]If the device is monitored by multiple CS-MARS controllers, you are prompted to select the CS-MARS instance to be used.

 
      		 [bookmark: pgfId-378146]Depending on how credentials verification is set up on your system, you might be prompted to log into CS-MARS. For more information, see Registering CS-MARS Servers in Security Manager.

 
      		 [bookmark: pgfId-378148]All custom signatures are categorized as “Unknown Device Event Type” events in CS-MARS.

 
      		 [bookmark: pgfId-378150]A default signature is assigned to an IPS device if you elect not to discover IPS policies when adding the device to the Security Manager inventory, or when you remove configured IPS policies from the device. If you try to look up events from the default signature, a “Policy not found” error message is displayed. However, if you edit the default signature and save it, you can then query for related events in CS-MARS.

 
      		 [bookmark: pgfId-378152]Events of type Packet Data and Context Data are not displayed in the query results because these events are not triggered by signature rules.

 
     

 
     [bookmark: pgfId-378154]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-378176][bookmark: 167927][bookmark: monidiag_proc_LookingUpaSecurityManagerPolicyfromaCSMARSEvent]Looking Up a Security Manager Policy from a CS-MARS Event[bookmark: marker-378160][bookmark: marker-378162][bookmark: marker-378164][bookmark: marker-378166][bookmark: marker-378168][bookmark: marker-378170][bookmark: marker-378172][bookmark: marker-378174]

 
     [bookmark: pgfId-378180]The User Guide for Cisco Security MARS Local and Global Controllers contains detailed information about how to look up policies based on events shown in CS-MARS. The information includes extensive troubleshooting information to help resolve any problems you might have, plus a checklist of what you must configure in CS-MARS to enable the interaction.

 
     [bookmark: pgfId-378182]The main reason you would want to perform policy lookup is to adjust a policy based on the events that it is generating. For example, an access rule might be dropping traffic that you actually want to allow. Because you are looking at the event, you know there is a policy that is causing the event, so with a few clicks, you can get from that event to the policy you need to reconfigure.

 
     [bookmark: pgfId-378184]The general process for looking up a policy based on a device-generated event is as follows. Note that the Security Manager client must be installed on your system to perform policy lookup.

 
     [bookmark: pgfId-378186]Related Topics

 
      
      		 [bookmark: pgfId-378191]Viewing CS-MARS Events for an Access Rule

 
      		 [bookmark: pgfId-378196]Viewing CS-MARS Events for an IPS Signature

 
     

 
     
 
     [bookmark: pgfId-378198]Step 1 Find the event in CS-MARS in the Query Results or Incident Details pages.

 
     [bookmark: pgfId-378200]For more information on the syslog and NetFlow events you can use for querying access rules, see the following topics:

 
      
      		 [bookmark: pgfId-378205]System Log Messages Supported for Policy Look-up

 
      		 [bookmark: pgfId-378210]NetFlow Event Reporting in CS-MARS

 
     

 
     [bookmark: pgfId-378212]Step 2 Click the Security Manager icon in the Reporting Device cell for the event. You might be prompted to log into Security Manager, based on how you configured CS-MARS.

 
     [bookmark: pgfId-378214]If more than one device in Security Manager matches the event characteristics, you are prompted to select a device.

 
     [bookmark: pgfId-378216]Step 3 Detailed information is obtained from Security Manager and presented based on whether the event is for an access rule or IPS signature:

 
      
      		 [bookmark: pgfId-378218] Access rule —The access rules are displayed in CS-MARS in a read-only window with the rule that matches the event highlighted.

 
     

 
     [bookmark: pgfId-378220]If you decide to edit a rule, click the rule number, and you are taken to the rule in the Access Rule policy in the Security Manager client. You can then make your edits, save them, and then deploy configurations. Remember that your changes are not made to the device until you deploy them.

 
     [bookmark: pgfId-378225]For more information on configuring access rules, see Configuring Access Rules.

 
      
      		 [bookmark: pgfId-378227] IPS Signature —Signature details are displayed in CS-MARS in a read-only window.

 
     

 
     [bookmark: pgfId-378232]To edit the signature, click Edit Signature, and you are taken to the signature in the Signatures policy, where you can make your changes. For more information, see Editing Signature Parameters (Tuning Signatures).

 
     [bookmark: pgfId-378237]If you decide you want to instead remove specific actions from an event, or remove the event entirely, and prevent further processing by the sensor, click Add Filter. This opens the Add Event Filter dialog box in Security Manager, where you can configure an event filter. For more information, see Filter Item Dialog Box.

 
     [bookmark: pgfId-378239]As with access rules, your changes do not take effect until you deploy the new configuration.

 
     [bookmark: pgfId-378241]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-378257][bookmark: 168005][bookmark: monidiag_cncpt_SystemLogMessagesSupportedforPolicyLookup]System Log Messages Supported for Policy Look-up[bookmark: marker-378247][bookmark: marker-378249][bookmark: marker-378251][bookmark: marker-378253][bookmark: marker-378255]

 
     [bookmark: pgfId-378262]When you configure access rules on security appliances and IOS devices, you can configure logging options in the Advanced and Edit Options Dialog Boxes that generate system log (syslog) messages. On devices with multiple contexts, each security context includes its own logging configuration and generates its own messages. If Security Manager is configured to interoperate with CS-MARS, these messages are reported to CS-MARS and you can query for the reported information on a per-rule basis.

 
     [bookmark: pgfId-378264]For additional information about each of these message IDs, see the System Message Guide of the relevant product documentation.

 
     [bookmark: pgfId-378266]Security-appliance messages

 
     [bookmark: pgfId-378268]Security-appliance syslog messages begin with a percent sign (%) and are structured as follows:

 
     
      [bookmark: pgfId-378270]%{ASA | PIX | FWSM}-Level-Message_number: Message_text
     

     
      [bookmark: pgfId-378272] 
     

     [bookmark: pgfId-378274]For example:

 
     
      [bookmark: pgfId-378276]%ASA-2-302013: Built outbound TCP connection 42210 
     

     
      [bookmark: pgfId-378278]for outside:9.1.154.12/23 (9.1.154.12/23) to inside:2.168.154.12/4402 (192.168.154.12/4402)
     

     
      [bookmark: pgfId-378280] 
     

     [bookmark: pgfId-378282]Note that additional information, such as date and timestamp, precedes these messages. The specific additional information depends on the type of device.

 
     [bookmark: pgfId-378285]A unique six-digit number identifies each message (302013 in the preceding example). The following security-appliance syslog message IDs are supported for Security Manager-to-CS-MARS queries. If you change the logging level of a security appliance, be sure these messages are generated at the new level.

 
      
       
       
         
         		
           
           [bookmark: pgfId-375441]Message ID
          
  
         		
           
           [bookmark: pgfId-375443]Message
          
  
        

 
         
         		[bookmark: pgfId-375449]106023

  
         		[bookmark: pgfId-375451]An IP packet was denied by the access rule. This message is recorded even if logging is not enabled for the rule; this is the Default Logging option.

  
        

 
         
         		[bookmark: pgfId-375457]106100

  
         		[bookmark: pgfId-375462]An IP packet was permitted or denied by the access rule. Additional information is provided, based on the logging level defined for the rule in the Advanced and Edit Options Dialog Boxes.

  
        

 
         
         		[bookmark: pgfId-375468]302013

  
         		[bookmark: pgfId-375470]A TCP connection between two hosts was created.

  
        

 
         
         		[bookmark: pgfId-375476]302014

  
         		[bookmark: pgfId-375478]A TCP connection between two hosts was torn down.

  
        

 
         
         		[bookmark: pgfId-375484]302015

  
         		[bookmark: pgfId-375486]A UDP connection between two hosts was created.

  
        

 
         
         		[bookmark: pgfId-375492]302016

  
         		[bookmark: pgfId-375494]A UDP connection between two hosts was torn down.

  
        

 
         
         		[bookmark: pgfId-375500]302020

  
         		[bookmark: pgfId-375502]A ICMP connection between two hosts was created.

  
        

 
         
         		[bookmark: pgfId-375508]302021

  
         		[bookmark: pgfId-375510]A ICMP connection between two hosts was torn down.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-378287]Router messages

 
     [bookmark: pgfId-378289]On Cisco IOS routers, syslog messages are also generated for access rules. The first packet that triggers the access list causes an immediate logging message, and subsequent packets are collected over five-minute intervals before they are displayed or logged. Each logging message includes the access list number, whether the packet was permitted or denied, the source IP address of the packet, and the number of packets from that source permitted or denied in the prior five-minute interval.

 
     [bookmark: pgfId-378292]The following IOS syslog message IDs are supported for Security Manager-to-CS-MARS queries.

 
      
       
       
         
         		[bookmark: pgfId-375517]%SEC-6-IPACCESSLOGP

  
         		[bookmark: pgfId-375519]A packet matching the log criteria for the given access list was detected: TCP and UDP.

  
        

 
         
         		[bookmark: pgfId-375525]%SEC-6-IPACCESSLOGS

  
         		[bookmark: pgfId-375527]A packet matching the log criteria for the given access list was detected: IP address.

  
        

 
         
         		[bookmark: pgfId-375533]%SEC-6-IPACCESSLOGDP

  
         		[bookmark: pgfId-375535]A packet matching the log criteria for the given access list was detected: ICMP.

  
        

 
         
         		[bookmark: pgfId-375541]%SEC-6-IPACCESSLOGNP

  
         		[bookmark: pgfId-375543]A packet matching the log criteria for the given access list was detected: all other IPv4 protocols.

  
        

 
       
      

 
     
 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-378297]Note If an excessive number of syslog messages are being generated and reported to CS-MARS, use the Advanced and Edit Options Dialog Boxes to change the logging level for those access rules that are producing the largest number of messages. You can also look at changing the logging policies on the device to limit the types of messages generated.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-378309][bookmark: 168115][bookmark: monidiag_cncpt_AboutNetflowSupport]NetFlow Event Reporting in CS-MARS[bookmark: marker-378303][bookmark: marker-378305][bookmark: marker-378307]

 
     [bookmark: pgfId-378311]Event reporting in CS-MARS can include NetFlow events from an ASA 8.1+ device.

 
     [bookmark: pgfId-378313]NetFlow Security Event Logging uses NetFlow version 9 fields and templates to efficiently deliver security telemetry in high-performance environments. NetFlow Security Event Logging scales better than syslog messaging, while offering the same level of detail and granularity in logged events. The ASA NetFlow implementation exports only significant events in the life of a flow, rather than exporting data about flows at regular intervals. The following flow events are exported:

 
      
      		 [bookmark: pgfId-378315]Flow creation

 
      		 [bookmark: pgfId-378317]Flow tear-down

 
      		 [bookmark: pgfId-378319]Flows denied by an access rule

 
     

 
     [bookmark: pgfId-378325]The ASA also exports syslog messages that contain the same information. If you enable NetFlow on a device, you can consider disabling the equivalent syslog messages. Disabling equivalent syslog messages can help avoid the potential performance degradation caused by generating and processing both NetFlow records and syslog messages representing the same event. The following table lists syslog messages with an equivalent NetFlow event; the NetFlow Event IDs and Extended Event IDs are included. For information on how to disable NetFlow equivalent syslog messages, see Server Setup Page.

 
      
       
       
         
         		 
           
           [bookmark: pgfId-375554]Syslog ID
          
  
         		 
           
           [bookmark: pgfId-375556]Syslog Description
          
  
         		 
           
           [bookmark: pgfId-375558]NetFlow Event ID
          
  
         		 
           
           [bookmark: pgfId-375560]Extended Event ID
          
  
        

 
         
         		[bookmark: pgfId-375570]302013
302015
302017
302020

  
         		[bookmark: pgfId-375572]TCP, UDP, GRE, and ICMP connection creation.

  
         		[bookmark: pgfId-375574]1 = Flow Created.

  
         		[bookmark: pgfId-375576]0 = Ignore.

  
        

 
         
         		[bookmark: pgfId-375586]302014
302016
302018
302021

  
         		[bookmark: pgfId-375588]TCP, UDP, GRE, and ICMP connection tear-down.

  
         		[bookmark: pgfId-375590]2 = Flow Deleted.

  
         		[bookmark: pgfId-375592]0 = Ignore, or
> 2000 = ASP drop reasons.

  
        

 
         
         		[bookmark: pgfId-375602]710003

  
         		[bookmark: pgfId-375604]An attempt to connect to the device’s interface was denied.

  
         		[bookmark: pgfId-375606]3 = Flow Denied.

  
         		[bookmark: pgfId-375608]1003 = To-the-box flow denied due to configuration.

  
        

 
         
         		[bookmark: pgfId-375618]106015

  
         		[bookmark: pgfId-375620]A TCP flow was denied because the first packet was not a SYN packet.

  
         		[bookmark: pgfId-375622]3 = Flow Denied.

  
         		[bookmark: pgfId-375624]1004 = Flow denied because first packet was not a TCP SYN packet.

  
        

 
         
         		[bookmark: pgfId-375634]313001

  
         		[bookmark: pgfId-375636]An ICMP packet to the device was denied.

  
         		[bookmark: pgfId-375638]3 = Flow Denied.

  
         		[bookmark: pgfId-375640]1003 = To-the-box flow denied due to configuration.

  
        

 
         
         		[bookmark: pgfId-375650]313008

  
         		[bookmark: pgfId-375652]An ICMP v6 packet to the device was denied.

  
         		[bookmark: pgfId-375654]3 = Flow Denied.

  
         		[bookmark: pgfId-375656]1003 = To-the-box flow denied due to configuration.

  
        

 
         
         		[bookmark: pgfId-375666]106023

  
         		[bookmark: pgfId-375668]A flow was denied by an access list attached to an interface with the access group command.

  
         		[bookmark: pgfId-375670]3 = Flow Denied.

  
         		[bookmark: pgfId-375672]1001 – Flow denied by Ingress ACL.
1002 – Flow denied by Egress ACL.

  
        

 
         
         		[bookmark: pgfId-375682]106100

  
         		[bookmark: pgfId-375684]An access rule was hit.

  
         		[bookmark: pgfId-375686]1 = Flow Created (if ACL permitted the flow).
3 = Flow Denied (if ACL denied the flow).

  
         		[bookmark: pgfId-375688]0 – If Flow permitted by ACL.
1001 – Flow denied by Ingress ACL.
1002 – Flow denied by Egress ACL.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-378328]For the Flow Denied NetFlow event, an Extended Event ID indicates the reason for denial, as shown in the following table.

 
      
       
       
         
         		 
           
           [bookmark: pgfId-375697]Extended Event ID
          
  
         		 
           
           [bookmark: pgfId-375699]Event
          
  
         		 
           
           [bookmark: pgfId-375701]Description
          
  
        

 
         
         		[bookmark: pgfId-375709]1001

  
         		[bookmark: pgfId-375711]FLOW DENIED

  
         		[bookmark: pgfId-375713]The flow was denied by an Ingress ACL.

  
        

 
         
         		[bookmark: pgfId-375721]1002

  
         		[bookmark: pgfId-375723]FLOW DENIED

  
         		[bookmark: pgfId-375725]The flow was denied by an Egress ACL.

  
        

 
         
         		[bookmark: pgfId-375733]1003

  
         		[bookmark: pgfId-375735]FLOW DENIED

  
         		[bookmark: pgfId-375737]The security appliance denied an attempt to connect to the interface service. For example, this message appears (with the service SNMP) when the security appliance receives an SNMP request from an unauthorized SNMP management station.

  
        

 
         
         		[bookmark: pgfId-375745]1004

  
         		[bookmark: pgfId-375747]FLOW DENIED

  
         		[bookmark: pgfId-375749]The flow was denied because the first packet was not a TCP SYN packet.

  
        

 
         
         		[bookmark: pgfId-375757]> 2000

  
         		[bookmark: pgfId-375759]FLOW DELETED

  
         		[bookmark: pgfId-375761]Values above 2000 represent various reasons for a flow being terminated.
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     [bookmark: pgfId-149438][bookmark: 97873][bookmark: ipdvchap_cncpt_ConfiguringVirtualSensors]Configuring Virtual Sensors[bookmark: marker-149432][bookmark: marker-149434][bookmark: marker-149436]
      
      
 
     
 

 
    [bookmark: pgfId-149440]All IPS devices and service modules have a base virtual sensor named vs0. When you configure the IPS appliance or service module, you must configure the base vs0 sensor to assign interfaces to it. This assignment tells the device which interfaces to inspect. There are also other settings that are configured on virtual sensors.

 
    [bookmark: pgfId-149442]In addition to the base vs0 virtual sensor, many IPS appliances and service modules allow you to create user-defined virtual sensors. You can use these virtual sensors to create separate policies for traffic, so that a single physical sensor can act as if it were multiple sensors. A virtual sensor is a logical grouping of sensing interfaces and the configuration policy for the signature engines and event action filters to apply.

 
    [bookmark: pgfId-149444]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-149449]Understanding the Virtual Sensor

 
     		 [bookmark: pgfId-149454]Defining A Virtual Sensor

 
     		 [bookmark: pgfId-149459]Editing Policies for a Virtual Sensor

 
     		 [bookmark: pgfId-149464]Deleting A Virtual Sensor

 
    

 
   
 
    
     [bookmark: pgfId-149476][bookmark: 97888][bookmark: ipdvchap_cncpt_UnderstandingtheVirtualSensor]Understanding the Virtual Sensor[bookmark: marker-149470][bookmark: marker-149472][bookmark: marker-149474]

 
    [bookmark: pgfId-149478]The sensor can receive data inputs from one or many monitored data streams. These monitored data streams can either be physical interface ports or virtual interface ports. For example, a single sensor can monitor traffic from in front of the firewall, from behind the firewall, or from in front of and behind the firewall concurrently. A single sensor can monitor one or more data streams. In this situation a single sensor policy or configuration is applied to all monitored data streams.

 
    [bookmark: pgfId-149480]With virtual sensors, you can create separate policies to apply to specific traffic feeds. For example, if you want to create a policy for a data center and a second much different policy for the campus network, yet run both policies on the same hardware device, you can configure separate virtual sensors to implement these policies.

 
    [bookmark: pgfId-149482]You configure the following policies and settings separately for a virtual sensor:

 
     
     		 [bookmark: pgfId-149484]Signature and signature settings (policies in the IPS > Signatures folder).

 
     		 [bookmark: pgfId-149486]Event action policies (policies in the IPS > Event Actions folder).

 
     		 [bookmark: pgfId-149488]Anomaly detection policies (the IPS > Anomaly Detection policy) and the anomaly detection mode (in the Virtual Sensors policy).

 
     		 [bookmark: pgfId-149490]The promiscuous interfaces, inline interface pairs, inline VLAN pairs, inline VLAN groups, or promiscuous VLAN groups that the virtual sensor monitors.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-149492]Note No packet is processed by more than one virtual sensor; you cannot assign the same physical or logical interface to more than one sensor. Packets from interfaces, inline interface pairs, inline VLAN pairs, and VLAN groups that are not assigned to any virtual sensor are disposed of according to the inline bypass configuration that you define in the Interfaces policy.


    
     

    

    

 
     
     		 [bookmark: pgfId-149494]The inline TCP session tracking and Normalizer modes (in the Virtual Sensors policy).

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-149496]Note If you create a policy instance on an IPS device for signatures, event actions, or anomaly detection but do not assign it to any of the virtual sensors on that device (that is, you do not use that policy instance), then that policy instance is deleted by Security Manager during deployment.


    
     

    

    

 
    [bookmark: pgfId-149498]All other policies and settings are configured on the parent device that hosts the virtual sensor. For example, if you want to use global correlation, you configure it on the parent device and the virtual sensors share that configuration.

 
    [bookmark: pgfId-149500]You can configure up to four virtual sensors on one appliance, but you can add only three user-defined virtual sensors. The first virtual sensor, vs0, is the base sensor and you cannot delete it. In Security Manager, virtual sensors are presented as follows:

 
     
     		 [bookmark: pgfId-149502]The device selector in Device view contains the parent device, which doubles as the base virtual sensor, vs0. Select this device to configure all device-level policies and to create virtual sensors in the Virtual Sensors policy.

 
     		 [bookmark: pgfId-149504]Any user-defined virtual sensors are also shown in the device selector in Device view. The display name of the real device is prepended to the beginning of the name of the virtual sensor. In most cases, the result is that the virtual sensors appear next to the parent (real) device that the virtual sensor is on. For example, on the host (real device) named “bob,” the virtual sensor with the name “vs1” will appear in the device list as “bob_vs1.”

 
    

 
    [bookmark: pgfId-149506]To configure the signature, anomaly detection, and event action policies for a virtual sensor, you must select it in the device selector. You cannot configure these policies by selecting the parent device; those policies on the parent device are for the vs0 base sensor.

 
    [bookmark: pgfId-149508]The following topics explain more about virtual sensors:

 
     
     		 [bookmark: pgfId-149513]Advantages and Restrictions of Virtualization

 
     		 [bookmark: pgfId-149518]Inline TCP Session Tracking Mode

 
     		 [bookmark: pgfId-149523]Understanding Normalizer Mode

 
     		 [bookmark: pgfId-149528]Assigning Interfaces to Virtual Sensors

 
     		 [bookmark: pgfId-149533]Identifying the Virtual Sensors for a Device

 
     		 [bookmark: pgfId-149538]Defining A Virtual Sensor

 
     		 [bookmark: pgfId-149543]Editing Policies for a Virtual Sensor

 
     		 [bookmark: pgfId-149548]Deleting A Virtual Sensor

 
    

 
     
      [bookmark: pgfId-149566][bookmark: 97952][bookmark: ipdvchap_cncpt_AdvantagesofVirtualization]Advantages and Restrictions of Virtualization[bookmark: marker-149554][bookmark: marker-149556][bookmark: marker-149558][bookmark: marker-149560][bookmark: marker-149562][bookmark: marker-149564]

 
     [bookmark: pgfId-149568]An advantage of using virtual sensors is that you can operate more than one virtual sensor on one appliance while configuring each virtual sensor differently with regard to signature behavior and traffic feed. For example, if you want to create a policy for a data center and a second much different policy for the campus network, yet run both policies on the same hardware device, you can configure separate virtual sensors to implement these policies.

 
     [bookmark: pgfId-149570]Virtualization has the following advantages:

 
      
      		 [bookmark: pgfId-149572]You can apply different configurations to different sets of traffic.

 
      		 [bookmark: pgfId-149574]You can monitor two networks with overlapping IP spaces with one sensor.

 
      		 [bookmark: pgfId-149576]You can monitor both inside and outside a firewall or NAT device.

 
     

 
     [bookmark: pgfId-149578]Virtualization has the following restrictions:

 
      
      		 [bookmark: pgfId-149580]You must assign both sides of asymmetric traffic to the same virtual sensor.

 
      		 [bookmark: pgfId-149582]Using VACL capture or SPAN (promiscuous monitoring) is inconsistent with regard to VLAN tagging, which causes problems with VLAN groups.

 
     

 
     [bookmark: pgfId-149584] – When using Cisco IOS software, a VACL capture port or a SPAN target does not always receive tagged packets even if it is configured for trunking.

 
     [bookmark: pgfId-149586] – When using the MSFC, fast path switching of learned routes changes the behavior of VACL captures and SPAN.

 
      
      		 [bookmark: pgfId-149588]Persistent store is limited.

 
      		 [bookmark: pgfId-149590]Not all IPS sensors support multiple virtual sensors. The Virtual Sensors policy appears for all IPS appliances and service modules, because you must use it to assign interfaces to the base vs0 sensor. If the Add button in the policy is disabled for a device, and you have not configured user-defined virtual sensors, then the device does not support virtualization. Examples of devices that do not support virtualization include the Cisco IPS 4215, NM-CIDS, AIM-IPS, NME-IPS, and AIP-SSC. IDSM2 supports virtualization, but it does not support VLAN groups or inline interface pairs.

 
      		 [bookmark: pgfId-149592]You must use IPS 6.0+ software. Older software versions do not support virtualization.

 
      		 [bookmark: pgfId-149594]Cisco IOS IPS devices do not support virtualization. Use the  IPS > Interface Rules policy to specify the interfaces that IPS should monitor.

 
     

 
     [bookmark: pgfId-149596]Virtualization has the following traffic capture requirements:

 
      
      		 [bookmark: pgfId-149598]The virtual sensor must receive traffic that has 802.1q headers (other than traffic on the native VLAN of the capture port).

 
      		 [bookmark: pgfId-149600]The sensor must see both directions of traffic in the same VLAN group in the same virtual sensor for any given sensor.

 
     

 
     [bookmark: pgfId-149602]Related Topics

 
      
      		 [bookmark: pgfId-149607]Understanding the Virtual Sensor

 
      		 [bookmark: pgfId-149612]Defining A Virtual Sensor

 
     

 
    
 
     
      [bookmark: pgfId-149624][bookmark: 98021][bookmark: ipdvchap_cncpt_UnderstandingInlineTCPSessionTrackingMode]Inline TCP Session Tracking Mode[bookmark: marker-149618][bookmark: marker-149620][bookmark: marker-149622]

 
     [bookmark: pgfId-149626]When you choose to modify packets inline, if the packets from a stream are seen twice by the Normalizer engine, it cannot properly track the stream state and often the stream is dropped. This situation occurs most often when a stream is routed through multiple VLANs or interfaces that are being monitored by the IPS. A further complication in this situation is the necessity of allowing asymmetric traffic to merge for proper tracking of streams when the traffic for either direction is received from different VLANs or interfaces.

 
     [bookmark: pgfId-149628]To deal with this situation, you can set the mode so that streams are perceived as unique if they are received on separate interfaces or VLANs (or the subinterface for VLAN pairs).

 
     [bookmark: pgfId-149630]The following inline TCP session tracking modes apply:

 
      
      		 [bookmark: pgfId-149632] Interface and VLAN —All packets with the same session key (AaBb) in the same VLAN (or inline VLAN pair) and on the same interface belong to the same session. Packets with the same key but on different VLANs are tracked separately.

 
      		 [bookmark: pgfId-149634] VLAN Only —All packets with the same session key (AaBb) in the same VLAN (or inline VLAN pair) regardless of the interface belong to the same session. Packets with the same key but on different VLANs are tracked separately.

 
      		 [bookmark: pgfId-149636] Virtual Sensor —All packets with the same session key (AaBb) within a virtual sensor belong to the same session. This is the default and almost always the best option to choose.

 
     

 
     [bookmark: pgfId-149641]You configure the inline TCP session tracking mode as a property of the virtual sensor as described in Defining A Virtual Sensor.

 
    
 
     
      [bookmark: pgfId-149653][bookmark: 98050][bookmark: ipdvchap_cncpt_UnderstandingNormalizerMode]Understanding Normalizer Mode[bookmark: marker-149647][bookmark: marker-149649][bookmark: marker-149651]

 
     [bookmark: pgfId-149655]Normalizer mode applies only when the sensor is operating in inline mode. The default is strict evasion protection, which is full enforcement of TCP state and sequence tracking. The Normalizer enforces duplicate packets, changed packets, out-of-order packets, and so forth, which helps prevent attackers from evading the IPS.

 
     [bookmark: pgfId-149657]Asymmetric mode disables most of the Normalizer checks. Use Asymmetric mode only when the entire stream cannot be inspected, because in this situation, attackers can now evade the IPS.

 
     [bookmark: pgfId-149662]You configure the Normalizer mode as a property of the virtual sensor as described in Defining A Virtual Sensor.

 
    
 
     
      [bookmark: pgfId-149674][bookmark: 98068][bookmark: ipdvchap_cncpt_AssigningInterfacestoVirtualSensors]Assigning Interfaces to Virtual Sensors[bookmark: marker-149668][bookmark: marker-149670][bookmark: marker-149672]

 
     [bookmark: pgfId-149676]An IPS sensor monitors traffic that traverses interfaces, interface pairs, or VLAN pairs assigned to a virtual sensor.

 
     [bookmark: pgfId-149678]You can assign one or more of the following types of interfaces to a virtual sensor:

 
      
      		 [bookmark: pgfId-149680]Promiscuous interface—A physical interface that does not have VLAN groups and which is not part of an inline interface pair.

 
      		 [bookmark: pgfId-149682]Inline interface pair—A logical interface composed of two physical interfaces.

 
      		 [bookmark: pgfId-149684]Inline VLAN pair—A logical interface composed of two VLANs.

 
      		 [bookmark: pgfId-149686]Promiscuous VLAN group—A VLAN group that is assigned to a subinterface on a physical interface.

 
     

 
     [bookmark: pgfId-149688]The physical interface cannot already be used for an inline interface or VLAN pair. There can be many promiscuous VLAN groups on the same promiscuous interface, but the VLANs assigned cannot overlap. Once a VLAN group is assigned to a promiscuous interface, it is no longer a plain promiscuous interface and can only be used for promiscuous VLAN groups.

 
      
      		 [bookmark: pgfId-149690]Inline VLAN group—A VLAN group that is assigned to a subinterface of an inline interface pair.

 
     

 
     [bookmark: pgfId-149692]There can be many inline VLAN groups on the same inline interface pair, but the VLANs assigned cannot overlap. Once a VLAN group is assigned to an inline interface pair it is no longer a plain inline interface pair and can only be used for inline VLAN groups.

 
     [bookmark: pgfId-149694]VLAN groups cannot be assigned to inline VLAN pairs.

 
     [bookmark: pgfId-149702]You must configure the interfaces before you can assign them to virtual sensors. For more information about configuring all of these types of interfaces, see Configuring Interfaces. For information on assigning interfaces to virtual sensors, see Defining A Virtual Sensor.

 
    
 
     
      [bookmark: pgfId-149714][bookmark: 98101][bookmark: ipdvchap_proc_ViewingYourVirtualSensors]Identifying the Virtual Sensors for a Device[bookmark: marker-149708][bookmark: marker-149710][bookmark: marker-149712]

 
     [bookmark: pgfId-149716]If you configure user-defined virtual sensors on an IPS appliance or service module, the virtual sensor appears in the device selector in Device view.

 
     [bookmark: pgfId-149718]Normally, the display name of a virtual sensor is in the form device-name_virtual-sensor-name, where device-name is the name of the parent device, and virtual-sensor-name is the name of the virtual sensor. For example, the virtual sensor vs1 on device 10.100.10.10 would be 10.100.10.10_vs1.

 
     [bookmark: pgfId-149720]Thus, under normal conditions, the virtual sensors for a device should appear immediately after the parent device in the device selector. However, you can change the virtual sensor’s display name by editing the device properties. If you alter the default name, the virtual sensors might not appear anywhere near the parent device in the device selector.

 
     [bookmark: pgfId-149722]You can use the following techniques to identify the virtual sensors defined on a device, or to identify the parent device of a virtual sensor:

 
      
      		 [bookmark: pgfId-149724]To see a list of virtual sensors defined on an IPS device, select the  Virtual Sensors policy on the device. The table shows all virtual sensors, including the base vs0 sensor. Note that the vs0 sensor does not appear separately in the device selector; it is represented by the parent device itself.

 
     

 
     [bookmark: pgfId-149726]Unless you radically alter the display names of virtual sensors, the virtual sensor name, along with the parent device’s display name, should help you find the virtual sensor in the device selector.

 
      
      		 [bookmark: pgfId-149728]To determine which IPS device is the host of a virtual sensor, right-click the virtual sensor in the device selector and select  Device Properties . The Hostname display-only field on the General tab shows the host device display name plus the virtual sensor name as defined on the device.

 
     

 
    
 
   
 
    
     [bookmark: pgfId-149744][bookmark: 98131][bookmark: ipdvchap_proc_DefiningAVirtualSensor]Defining A Virtual Sensor[bookmark: marker-149736][bookmark: marker-149738][bookmark: marker-149740][bookmark: marker-149742]

 
    [bookmark: pgfId-149746]Use the Virtual Sensors policy to configure virtual sensors on your Cisco IPS devices. Even if your IPS device does not support multiple virtual sensors, you must use this policy to assign interfaces to the base sensor, vs0, and configure properties that are associated with the virtual sensor.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-149748]Tip For Cisco IOS IPS devices, you configure the interfaces that the IPS examines in the IPS > Interface Rules policy. You cannot configure virtual sensors in an IOS IPS device.


    
     

    

    

 
    [bookmark: pgfId-149750]Before You Begin

 
    [bookmark: pgfId-149755]Configure the interfaces on the sensor, including inline interface pairs, inline VLAN pairs, and promiscuous and inline VLAN groups. The interface configurations must exist before you can assign them to a virtual sensor. For information on interfaces, interface modes, and how to configure them, see Chapter 37, “Managing IPS Device Interfaces”.

 
    [bookmark: pgfId-149757]Related Topics

 
     
     		 [bookmark: pgfId-149762]Understanding Interfaces

 
     		 [bookmark: pgfId-149767]Understanding Interface Modes

 
     		 [bookmark: pgfId-149772]Advantages and Restrictions of Virtualization

 
     		 [bookmark: pgfId-149777]Inline TCP Session Tracking Mode

 
     		 [bookmark: pgfId-149782]Understanding Normalizer Mode

 
     		 [bookmark: pgfId-149787]Assigning Interfaces to Virtual Sensors

 
     		 [bookmark: pgfId-149792]Identifying the Virtual Sensors for a Device

 
     		 [bookmark: pgfId-149797]Editing Policies for a Virtual Sensor

 
    

 
    
 
    [bookmark: pgfId-149799]Step 1 (Device view only.) Select Virtual Sensors from the Policies selector to open the Virtual Sensors policy.

 
    [bookmark: pgfId-149801]The policy lists all existing virtual sensors, including the base vs0 sensor, which you cannot delete. The information for each sensor shows the interfaces assigned to the sensor, anomaly detection mode, inline TCP tracking mode, normalizer mode, and a description, if any. If the Assignments cell is empty, no interfaces are assigned to the virtual sensor, which means the virtual sensor cannot analyze any traffic.

 
    [bookmark: pgfId-149803]Step 2 Do one of the following:

 
     
     		 [bookmark: pgfId-149805]To add a virtual sensor, click the  Add Row button. The Add Virtual Sensor dialog box opens.

 
    

 
    [bookmark: pgfId-149807]You can add at most three sensors. The device supports four virtual sensors, including the base vs0 sensor. If the Add Row button is disabled, you either have configured the maximum number of sensors, or your device does not support multiple virtual sensors.

 
     
     		 [bookmark: pgfId-149809]To edit a virtual sensor, select it and click the  Edit Row button. The Edit Virtual Sensor dialog box opens.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-149814]Tip You can also delete a virtual sensor by selecting it and clicking the Delete Row button. You cannot delete the base vs0 sensor. For more information about deleting virtual sensors, see Deleting A Virtual Sensor.


    
     

    

    

 
    [bookmark: pgfId-149819]Step 3 In the Add or Edit Virtual Sensor dialog box, configure at least the following options. The defaults for the other options are appropriate in most cases. For detailed information on all available options, see Virtual Sensor Dialog Box.

 
     
     		 [bookmark: pgfId-149821]Virtual Sensor Name—The name of the virtual sensor. The virtual sensor name can be up to 64 characters and it cannot contain spaces.

 
     		 [bookmark: pgfId-149823]Interface assignments (Available, Assigned lists)—The promiscuous interfaces, inline interface pairs, inline VLAN pairs, promiscuous VLAN groups, or inline VLAN groups that you want this virtual sensor to use. The list of available interfaces shows only those interfaces that are configured in the Interfaces policy and that are not yet assigned to another virtual sensor.

 
    

 
    [bookmark: pgfId-149825] – To assign interfaces, select them in the available list and click >>.

 
    [bookmark: pgfId-149827] – To remove an assignment, select the interface in the assigned list and click <<. You must remove an assignment before you can assign an interface to a different virtual sensor.

 
    [bookmark: pgfId-149829]Tip: If you are not sure about the content of a specific interface, for example, its mode or assigned VLANs, close the dialog box, go to the Interfaces policy, and examine the various tabs.

 
    [bookmark: pgfId-149831]Step 4 Click OK to save your changes and add them to the Virtual Sensors policy.

 
    [bookmark: pgfId-149833]Step 5 Click Save to save the Virtual Sensors policy.

 
    [bookmark: pgfId-149835]Step 6 If you created a new virtual sensor, you must submit your changes to the database for the new virtual sensor to appear in the device selector in Device view.

 
     
     		 [bookmark: pgfId-149837]Non-Workflow mode—Select  File > Submit .

 
     		 [bookmark: pgfId-149839]Workflow mode—Select  Activities > Approve Activity , or if you are operating with an activity approver,  Activities > Submit Activity . The activity must be approved before the virtual sensor appears in the device selector.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-149841]Note In the device selector, the display name of the real device is prepended to the beginning of the name of the virtual sensor. In most cases, the result is that the virtual sensors appear next to the parent (real) device that the virtual sensor is on. For example, on the host (real device) named “bob,” the virtual sensor with the name “vs1” will appear in the device list as “bob_vs1.”


    
     

    

    

 
    [bookmark: pgfId-149843]Step 7 To configure the policies associated with a virtual sensor, select it in the device selector in Device view. You can then configure the associated policies. See the following topics:

 
     
     		 [bookmark: pgfId-149848]Chapter 39, “Defining IPS Signatures”

 
     		 [bookmark: pgfId-149853]Chapter 40, “Configuring Event Action Rules”

 
     		 [bookmark: pgfId-149858]Configuring Anomaly Detection

 
    

 
    [bookmark: pgfId-149860]


    
     

    
 
    

 
     
      [bookmark: pgfId-149880][bookmark: 98248][bookmark: ipspage_cncpt_AddVirtualSensorDialogBox]Virtual Sensor Dialog Box[bookmark: marker-149870][bookmark: marker-149872][bookmark: marker-149874][bookmark: marker-149876][bookmark: marker-149878]

 
     [bookmark: pgfId-149882]Use the Add or Edit Virtual Sensor dialog box to configure the properties for a virtual sensor.

 
     [bookmark: pgfId-149884]Navigation Path

 
     [bookmark: pgfId-149886](Device view only.) Select Virtual Sensors from the Policy selector. Click the Add Row button, or select an existing virtual sensor and click the Edit Row button.

 
     [bookmark: pgfId-149888]Related Topics

 
      
      		 [bookmark: pgfId-149893]Defining A Virtual Sensor

 
      		 [bookmark: pgfId-149898]Advantages and Restrictions of Virtualization

 
      		 [bookmark: pgfId-149903]Assigning Interfaces to Virtual Sensors

 
      		 [bookmark: pgfId-149908]Chapter 37, “Managing IPS Device Interfaces”

 
      		 [bookmark: pgfId-149913]Understanding Interfaces

 
      		 [bookmark: pgfId-149918]Understanding Interface Modes

 
     

 
     [bookmark: pgfId-149920]Field Reference

 
     [bookmark: pgfId-149923] 

 
      
       
        
        [bookmark: pgfId-148701]Table 38-1 [bookmark: 98299]Add or Edit Virtual Sensor Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-148707]Element
          
  
         		
           
           [bookmark: pgfId-148709]Description
          
  
        

 
         
         		[bookmark: pgfId-148715]Virtual Sensor Name

  
         		[bookmark: pgfId-148717]The name of the virtual sensor. The virtual sensor name can be up to 64 characters and it cannot contain spaces. The name of the default virtual sensor is vs0.

 [bookmark: pgfId-148732]You cannot change the name after you create the virtual sensor. To change a virtual sensor name, delete the sensor and create a new sensor with the desired name. If you already configured local policies for the sensor (that is, signature, event action, and anomaly detection policies), first save the policies as shared policies, delete the sensor, create the new sensor, then assign the shared policies to the new virtual sensor. For more information about creating shared policies from local policies, see Sharing a Local Policy.[bookmark: marker-148722][bookmark: marker-148724][bookmark: marker-148726][bookmark: marker-148728][bookmark: marker-148730]

  
        

 
         
         		[bookmark: pgfId-148738]Interface Assignments

 [bookmark: pgfId-148740](Available, Assigned)

  
         		[bookmark: pgfId-148742]The promiscuous interfaces, inline interface pairs, inline VLAN pairs, promiscuous VLAN groups, or inline VLAN groups that you want this virtual sensor to use. The list of available interfaces shows only those interfaces that are configured in the Interfaces policy and that are not yet assigned to another virtual sensor.

 
           
           		 [bookmark: pgfId-148744]To assign interfaces, select them in the available list and click  >> .

 
           		 [bookmark: pgfId-148746]To remove an assignment, select the interface in the assigned list and click  << . You must remove an assignment before you can assign an interface to a different virtual sensor.

 
          

 [bookmark: pgfId-148748]Tip If you are not sure about the content of a specific interface, for example, its mode or assigned VLANs, close the dialog box, go to the Interfaces policy, and examine the various tabs.  
        

 
         
         		[bookmark: pgfId-148754]Anomaly Detection Mode

  
         		[bookmark: pgfId-148759]The mode that you want the anomaly detection policy to operate in for this virtual sensor: Detect, Inactive, Learn. The default and normal operational mode is Detect. However, if you are using asymmetric normalizer mode, you might want to set the anomaly detection mode to Inactive. For detailed information about these modes, see Anomaly Detection Modes.

  
        

 
         
         		[bookmark: pgfId-148765]Inline TCP Session Tracking Mode

  
         		[bookmark: pgfId-148770]The mode used to segregate multiple views of the same stream if the same stream passes through the sensor more than once. The default mode is Virtual Sensor. For more information, see Inline TCP Session Tracking Mode. Select one of the following:

 
           
           		 [bookmark: pgfId-148772]Interface and VLAN—All packets with the same session key (AaBb) in the same VLAN (or inline VLAN pair) and on the same interface belong to the same session. Packets with the same key but on different VLANs are tracked separately.

 
           		 [bookmark: pgfId-148774]VLAN Only—All packets with the same session key (AaBb) in the same VLAN (or inline VLAN pair) regardless of the interface belong to the same session. Packets with the same key but on different VLANs are tracked separately.

 
           		 [bookmark: pgfId-148776]Virtual Sensor—All packets with the same session key (AaBb) within a virtual sensor belong to the same session.

 
          

  
        

 
         
         		[bookmark: pgfId-148782]Normalizer Mode

  
         		[bookmark: pgfId-148787]The type of Normalizer mode you need for traffic inspection. For more information, see Understanding Normalizer Mode.

 
           
           		 [bookmark: pgfId-148789]Strict Evasion Protection—(Default) If a packet is missed for any reason, all packets after the missed packet are not processed. Strict evasion protection provides full enforcement of TCP state and sequence tracking.

 
          

 [bookmark: pgfId-148791]Any out-of-order packets or missed packets can produce Normalizer engine signatures 1300 or 1330 firings, which try to correct the situation, but can result in denied connections.

 
           
           		 [bookmark: pgfId-148793]Asymmetric Mode Protection—Can only see one direction of bidirectional traffic flow. Asymmetric mode protection relaxes the evasion protection at the TCP layer.

 
          

 [bookmark: pgfId-148795]Asymmetric mode lets the sensor synchronize state with the flow and maintain inspection for those engines that do not require both directions. Asymmetric mode lowers security because full protection requires both sides of traffic to be seen.

  
        

 
         
         		[bookmark: pgfId-148801]Description

  
         		[bookmark: pgfId-148803]The description of the virtual sensor.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-149935][bookmark: 98385][bookmark: ipdvchap_proc_EditingAVirtualSensor]Editing Policies for a Virtual Sensor[bookmark: marker-149929][bookmark: marker-149931][bookmark: marker-149933]

 
    [bookmark: pgfId-149937]Virtual sensors have two types of policies: the virtual sensor’s properties, and policies assigned to the virtual sensor. You use a different approach to edit these items.

 
     
     		 [bookmark: pgfId-149939]To edit the properties of a virtual sensor, select the virtual sensor’s parent device in the device selector in Device view. Then, select the  Virtual Sensors policy. You can then select the virtual sensor in the table and click the  Edit Row button.

 
    

 
    [bookmark: pgfId-149941]Using the Virtual Sensors policy, you can change the interfaces assigned to a sensor, the anomaly detection mode, inline TCP session tracking mode, and Normalizer mode. For more information, see the following topics:

 
    [bookmark: pgfId-149946] – Defining A Virtual Sensor

 
    [bookmark: pgfId-149951] – Virtual Sensor Dialog Box

 
     
     		 [bookmark: pgfId-149953]To edit the policies assigned to a virtual sensor, select the virtual sensor in the device selector in Device view. A virtual sensor’s name is in the form  device-name_virtual-sensor-name , where  device-name is the name of the parent device, and  virtual-sensor-name is the name of the virtual sensor. For example, the virtual sensor vs1 on device 10.100.10.10 would be 10.100.10.10_vs1.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-149955]Note The base virtual sensor, vs0, is integrated with the parent device and does not appear separately in the device selector. To configure the base virtual sensor, select the parent device.


    
     

    

    

 
    [bookmark: pgfId-149957]You can then select the policies in the Policies selector and configure them. For more information, see the following topics:

 
    [bookmark: pgfId-149962] – Chapter 39, “Defining IPS Signatures”

 
    [bookmark: pgfId-149967] – Chapter 40, “Configuring Event Action Rules”

 
    [bookmark: pgfId-149972] – Configuring Anomaly Detection

 
    [bookmark: pgfId-149974]All other policies are configured on the parent device, and the configurations apply to all virtual sensors configured on the device.

 
   
 
    
     [bookmark: pgfId-149986][bookmark: 98431][bookmark: ipdvchap_proc_DeletingAVirtualSensor]Deleting A Virtual Sensor[bookmark: marker-149980][bookmark: marker-149982][bookmark: marker-149984]

 
    [bookmark: pgfId-149988]Virtual sensors appear in the device selector in Device view. However, you cannot delete them from the selector using the same command used for other devices. Instead, you must delete the virtual sensor from the Virtual Sensors policy of the parent device, that is, the device on which the virtual sensor is defined. The following procedure explains how to delete a user-defined virtual sensor.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-149993]Tip The base virtual sensor, vs0, does not appear in the device selector. Instead, it is represented by the parent IPS sensor; it is considered to be the base IPS device. To delete the base vs0 sensor, you delete the entire device from the inventory. For information on deleting devices from the inventory, see Deleting Devices from the Security Manager Inventory.


    
     

    

    

 
    [bookmark: pgfId-149995]Before You Begin

 
    [bookmark: pgfId-150000]When you delete a virtual sensor, you also delete the policies defined for the sensor, such as signature, event action, and anomaly detection policies. If you configured non-default local policies, and you want to preserve them for use on other virtual sensors, you must first convert the local policies to shared policies. Then, after you delete the virtual sensor, the policies continue to exist as unassigned shared policies. You can then assign them to another virtual sensor. For more information on creating a shared policy from a local policy, see Sharing a Local Policy.

 
    [bookmark: pgfId-150002]Using this technique is ideal if you are deleting a virtual sensor simply as a means to change the virtual sensor’s name. Because you cannot change a virtual sensor’s name, you must delete it and create a new virtual sensor with the desired name. If you created shared policies, you could then assign those shared policies to your new sensor, and it will have the same configuration as the sensor had under the old name.

 
    
 
    [bookmark: pgfId-150004]Step 1 (Device view only.) Select Virtual Sensors from the Policies selector to open the Virtual Sensors policy.

 
    [bookmark: pgfId-150006]Step 2 Select the user-defined virtual sensor that you want to delete and click the Delete Row button.

 
    [bookmark: pgfId-150008]Step 3 You are asked for a two-step confirmation. First, you are warned that you must save the policy to keep the policy and device synchronized. Click OK to continue, and you are also asked to confirm that you want to delete the node.

 
    [bookmark: pgfId-150010]If you confirm, the virtual sensor is removed from both the policy and the device selector. It will take a few moments before the device view is updated and the virtual sensor disappears from the list of devices.

 
    [bookmark: pgfId-150012]
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     [bookmark: pgfId-376947][bookmark: 39987][bookmark: trustsec_intro_ManagingTrustsecFirewallPolicies]Managing TrustSec Firewall Policies[bookmark: marker-376939][bookmark: marker-376941][bookmark: marker-376943][bookmark: marker-376945]
      
      
 
     
 

 
    [bookmark: pgfId-376949]Cisco TrustSec provides an access-control solution that builds upon an existing identity-aware infrastructure to ensure data confidentiality between network devices and integrate security access services on one platform. In the Cisco TrustSec solution, enforcement devices utilize a combination of user attributes and end-point attributes to make role-based and identity-based access control decisions.

 
    [bookmark: pgfId-376951]Cisco ASA, ISR, and ASR devices integrate with Cisco TrustSec to provide security group based policy enforcement. Access policies within the Cisco TrustSec domain are topology-independent, based on the roles of source and destination devices rather than on network IP addresses.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-376953]Note Cisco TrustSec Support for IOS feature is supported on the Cisco Integrated Services Router Generation 2 (ISR G2) only.


    
     

    

    

 
    [bookmark: pgfId-376955]Security group awareness is integrated into several existing firewall rules; there is no unique TrustSec firewall policy. This chapter explains TrustSec firewall policies and how to implement them in the various policies that support security group awareness.

 
    [bookmark: pgfId-376957]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-376962]Overview of TrustSec Firewall Policies

 
     		 [bookmark: pgfId-376967]Configuring TrustSec Firewall Policies

 
     		 [bookmark: pgfId-376972]Monitoring TrustSec Firewall Policies

 
    

 
   
 
    
     [bookmark: pgfId-376986][bookmark: 40007][bookmark: trustsec_intro_OverviewofTrustsecFirewallPolicies]Overview of TrustSec Firewall Policies[bookmark: marker-376978][bookmark: marker-376980][bookmark: marker-376982][bookmark: marker-376984]

 
    [bookmark: pgfId-376988]Traditionally, security features such as firewalls performed access control based on predefined IP addresses, subnets and protocols. However, with enterprises transitioning to borderless networks, both the technology used to connect people and organizations and the security requirements for protecting data and networks have evolved significantly. End points are becoming increasingly nomadic and users often utilize a variety of end points (for example, laptop versus desktop, smart phone, or tablet), which means that a combination of user attributes plus end-point attributes provide the key characteristics, in addition to existing 6-tuple based rules, that enforcement devices, such as switches and routers with firewall features or dedicated firewalls, can reliably use for making access control decisions.

 
    [bookmark: pgfId-376990]As a result, the availability and propagation of end point attributes or client identity attributes have become increasingly important requirements to enable security solutions across the customers’ networks, at the access, distribution, and core layers of the network and in the data center to name but a few examples.

 
    [bookmark: pgfId-376992]Cisco TrustSec provides an access-control solution that builds upon an existing identity-aware infrastructure to ensure data confidentiality between network devices and integrate security access services on one platform. In the Cisco TrustSec solution, enforcement devices utilize a combination of user attributes and end-point attributes to make role-based and identity-based access control decisions.

 
    [bookmark: pgfId-376994]Implementing Cisco TrustSec into your environment has the following advantages:

 
     
     		 [bookmark: pgfId-376996]Provides a growing mobile and complex workforce with appropriate and more secure access from any device

 
     		 [bookmark: pgfId-376998]Lowers security risks by providing comprehensive visibility of who and what is connecting to the wired or wireless network

 
     		 [bookmark: pgfId-377000]Offers exceptional control over activity of network users accessing physical or cloud-based IT resources

 
     		 [bookmark: pgfId-377002]Reduces total cost of ownership through centralized, highly secure access policy management and scalable enforcement mechanisms

 
    

 
    [bookmark: pgfId-377006]For information about Cisco TrustSec, see http://www.cisco.com/go/trustsec.

 
    [bookmark: pgfId-377008]This section contains the following topics:

 
     
     		 [bookmark: pgfId-377013]Understanding SGT and SXP Support in Cisco TrustSec

 
     		 [bookmark: pgfId-377018]Roles in the Cisco TrustSec Solution

 
     		 [bookmark: pgfId-377023]Security Group Policy Enforcement

 
     		 [bookmark: pgfId-377028]About Speaker and Listener Roles

 
     		 [bookmark: pgfId-377033]Prerequisites for Integrating an ASA with Cisco TrustSec

 
    

 
     
      [bookmark: pgfId-377039][bookmark: 40038][bookmark: trustsec_cncpt_AboutSGTandSXP]Understanding SGT and SXP Support in Cisco TrustSec

 
     [bookmark: pgfId-377041]In the Cisco TrustSec solution, security group access transforms a topology-aware network into a role-based network, thus enabling end-to-end policies enforced on the basis of role-based access-control (RBAC). Device and user credentials acquired during authentication are used to classify packets by security groups. Every packet entering the Cisco TrustSec cloud is tagged with a security group tag (SGT). The tagging helps trusted intermediaries identify the source identity of the packet and enforce security policies along the data path.

 
     [bookmark: pgfId-377043]An SGT can indicate a privilege level across the domain when the SGT is used to define a security group ACL. An SGT is assigned to a device through IEEE 802.1X authentication, web authentication, or MAC authentication bypass (MAB), which occurs with a RADIUS vendor-specific attribute. An SGT can be assigned statically to a particular IP address or to a switch interface. An SGT is passed along dynamically to a switch or access point after successful authentication.

 
     [bookmark: pgfId-377045]The Security-group eXchange Protocol (SXP) is a protocol developed for Cisco TrustSec to propagate the IP-to-SGT mapping database across network devices that do not have SGT-capable hardware support to hardware that supports SGTs and security group ACLs. SXP, a control plane protocol, passes IP-SGT mappings from authentication points (such as legacy access layer switches) to upstream devices in the network.

 
     [bookmark: pgfId-377047]The SXP connections are point-to-point and use TCP as the underlying transport protocol. SXP uses the well known TCP port number 64999 to initiate a connection. Additionally, an SXP connection is uniquely identified by the source and destination IP addresses.

 
    
 
     
      [bookmark: pgfId-377053][bookmark: 40045][bookmark: trustsec_cncpt_RolesinTrustsec]Roles in the Cisco TrustSec Solution

 
     [bookmark: pgfId-377055]To provide identity and policy-based access enforcement, the Cisco TrustSec solution includes the functionality:

 
      
      		 [bookmark: pgfId-377057] Access Requestor (AR): Access requestors are end-point devices that request access to protected resources in the network. They are primary subjects of the architecture and their access privilege depends on their Identity credentials.

 
     

 
     [bookmark: pgfId-377059]Access requestors include end-point devices such PCs, laptops, mobile phones, printers, cameras, and MACsec-capable IP phones.

 
      
      		 [bookmark: pgfId-377061] Policy Decision Point (PDP): A policy decision point is responsible for making access control decisions. The PDP provides features such as 802.1x, MAB, and Web authentication. The PDP supports authorization and enforcement through VLAN, DACL, and security group access (SGACL/SXP/SGT).

 
     

 
     [bookmark: pgfId-377063]In the Cisco TrustSec solution, the Cisco Identity Services Engine (ISE) acts as the PDP. The Cisco ISE provides identity and access control policy functionality.

 
      
      		 [bookmark: pgfId-377065] Policy Information Point (PIP): A policy information point is a source that provides external information (for example, reputation, location, and LDAP attributes) to policy decision points.

 
     

 
     [bookmark: pgfId-377067]Policy information points include devices such as Session Directory, Sensors IPS, and Communication Manager.

 
      
      		 [bookmark: pgfId-377069] Policy Administration Point (PAP): A policy administration point defines and inserts policies into authorization system. The PAP acts as an identity repository, by providing Cisco TrustSec tag to user identity mapping and Cisco Trustsec tag to server resource mapping.

 
     

 
     [bookmark: pgfId-377071]In the Cisco TrustSec solution, the Cisco Secure Access Control System (a policy server with integrated 802.1x and SGT support) acts as the PAP.

 
      
      		 [bookmark: pgfId-377073] Policy Enforcement Point (PEP): A policy enforcement point is the entity that carries out the decisions (policy rules and actions) made by the PDP for each AR. PEP devices learn identity information through the primary communication path that exists across networks. PEP devices learn the identity attributes of each AR from many sources, such as end-point agents, authorization servers, peer-enforcement devices, and network flows. In turn, PEP devices use SXP to propagate IP-SGT mappings to mutually-trusted peer devices across the network.

 
     

 
     [bookmark: pgfId-377075]Policy enforcement points include network devices such as Catalyst switches, routers, firewalls (specifically the ASA), servers, VPN devices, and SAN devices.

 
    
 
     
      [bookmark: pgfId-377081][bookmark: 40070][bookmark: trustsec_cncpt_SecurityGroupPolicyEnforcement]Security Group Policy Enforcement

 
     [bookmark: pgfId-377083]Security policy enforcement is based on security group name. Compared to traditional IP-based policies configured on firewalls, identity-based policies are configured based on user and device identities. For example, mktg-contractor is allowed to access mktg-servers; mktg-corp-users are allowed to access mktg-server and corp-servers.

 
     [bookmark: pgfId-377085]The benefits of this type of deployment include:

 
      
      		 [bookmark: pgfId-377087]User group and Resource is defined and enforced using a single object (SGT) - simplified policy management.

 
      		 [bookmark: pgfId-377089]User identity and resource identity are retained throughout the Cisco Trustsec capable switch infrastructure.

 
     

 
     [bookmark: pgfId-377093]Figure 14-1 [bookmark: 40079]Security Group Name Based Policy Enforcement Deployment

 
     [bookmark: pgfId-377096] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-377098]Implementing Cisco TrustSec allows you to configure security policies that support server segmentation and includes the following features:

 
      
      		 [bookmark: pgfId-377100]A pool of servers can be assigned an SGT for simplified policy management.

 
      		 [bookmark: pgfId-377102]The SGT information is retained within the infrastructure of Cisco Trustsec capable switches.

 
      		 [bookmark: pgfId-377104]The ASA, ISR, and ASR can leverage the IP-SGT mapping for policy enforcement across the Cisco TrustSec domain.

 
      		 [bookmark: pgfId-377106]Deployment simplification is possible because 802.1x authorization for servers is mandatory.

 
     

 
     [bookmark: pgfId-377108]How the ASA Enforces Security Group Based Policies

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-377110]Note User-based security policies and security-group based policies can coexist on the ASA. Any combination of network, user-based, and security-group based attributes can be configured in a security policy.


     
      

     

     

 
     [bookmark: pgfId-377112]To configure the ASA to function with Cisco TrustSec, you must import a Protected Access Credential (PAC) file from the ISE.

 
     [bookmark: pgfId-377114]Importing the PAC file to the ASA establishes a secure communication channel with the ISE. After the channel is established, the ASA initiates a PAC secure RADIUS transaction with the ISE and downloads Cisco TrustSec environment data (that is, the security group table). The security group table maps SGTs to security group names. Security group names are created on the ISE and provide user-friendly names for security groups.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-377118]Note For more information about the Cisco Identity Services Engine, see http://www.cisco.com/en/US/products/ps11640/index.html.


     
      

     

     

 
     [bookmark: pgfId-377120]The first time that the ASA downloads the security group table, it walks through all entries in the table and resolves all the security group names included in security policies that have been configured on it; then the ASA activates those security policies locally. If the ASA cannot resolve a security group name, it generates a syslog message for the unknown security group name.

 
     [bookmark: pgfId-377122]The following figure shows how a security policy is enforced in Cisco TrustSec.

 
     [bookmark: pgfId-377126]Figure 14-2 [bookmark: 40101]Security Policy Enforcement

 
     [bookmark: pgfId-377129] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-377131] 1. An end-point device connects to an access layer device directly or via remote access and authenticates with Cisco TrustSec.

 
     [bookmark: pgfId-377133] 2. The access layer device authenticates the end-point device with the ISE by using authentication methods such as 802.1X or web authentication. The end-point device passes role and group membership to classify the device into the appropriate security group.

 
     [bookmark: pgfId-377135] 3. The access layer device uses SXP to propagate the IP-SGT mapping to the upstream devices.

 
     [bookmark: pgfId-377137] 4. The ASA receives the packet and looks up the SGTs for the source and destination IP addresses using the IP-SGT mapping passed by SXP.

 
     [bookmark: pgfId-377139]If the mapping is new, the ASA records it in its local IP-SGT Manager database. The IP-SGT Manager database, which runs in the control plan, tracks IP-SGT mappings for each IPv4 or IPv6 address. The database records the source from which the mapping was learned. The peer IP address of the SXP connection is used as the source of the mapping. Multiple sources can exist for each IP-SGT mapping.

 
     [bookmark: pgfId-377144]If the ASA is configured as a Speaker, the ASA transmits all IP-SGT mappings to its SXP peers. See About Speaker and Listener Roles.

 
     [bookmark: pgfId-377146] 5. If a security policy is configured on the ASA with that SGT or security group name, the ASA enforces the policy. (You can create security policies on the ASA that include SGTs or security group names. To enforce policies based on security group names, the ASA needs the security group table to map security group names to SGTs.)

 
     [bookmark: pgfId-377148]If the ASA cannot find a security group name in the security group table and it is included in a security policy, the ASA considers the security group name unknown and generates a syslog message. After the ASA refreshes the security group table from the ISE and learns the security group name, the ASA generates a syslog message indicating that the security group name is known.

 
    
 
     
      [bookmark: pgfId-377154][bookmark: 40120][bookmark: trustsec_cncpt_AboutSpeakerandListenerRoles]About Speaker and Listener Roles

 
     [bookmark: pgfId-377156]The Security-group eXchange Protocol (SXP) is used to send and receive IP-SGT mappings to and from other network devices. Employing SXP allows security devices and firewalls to learn identity information from access switches without the need for hardware upgrades or changes. SXP can also be used to pass IP-SGT mappings from upstream devices (such as datacenter devices) back to the downstream devices.

 
     [bookmark: pgfId-377158]When configuring an SXP connection to an SXP peer, you must designate the device as a Speaker or a Listener for that connection so that it can exchange identity information:

 
      
      		 [bookmark: pgfId-377160]Speaker mode—configures the device so that it can forward all active IP-SGT mappings to upstream devices for policy enforcement.

 
      		 [bookmark: pgfId-377162]Listener mode—configures the device so that it can receive IP-SGT mappings from downstream devices (SGT-capable switches) and use that information in creating policy definitions.

 
     

 
     [bookmark: pgfId-377164]If one end of an SXP connection is configured as Speaker, then the other end must be configured as a Listener, and vice versa. If both devices on each end of an SXP connection are configured with the same role (either both as Speakers or both as Listeners), the SXP connection will fail and the device will generate a system log message.

 
     [bookmark: pgfId-377166]Configuring the device to be both a Speaker and a Listener for an SXP connection can cause SXP looping, meaning that SXP data can be received by an SXP peer that originally transmitted it.

 
     [bookmark: pgfId-377168]As part of configuring SXP, you configure an SXP reconcile timer. After an SXP peer terminates its SXP connection, the device starts a hold down timer. Only SXP peers designated as Listener devices can terminate a connection. If an SXP peer connects while the hold down timer is running, the device starts the reconcile timer; then, the device updates the IP-SGT mapping database to learn the latest mappings.

 
    
 
     
      [bookmark: pgfId-377174][bookmark: 40133][bookmark: trustsec_cncpt_PrerequisitesforIntegratinganASAwithCiscoTrustSec]Prerequisites for Integrating an ASA with Cisco TrustSec

 
     [bookmark: pgfId-377176]Before configuring the ASA to integrate with Cisco TrustSec, you must perform the following prerequisites:

 
      
      		 [bookmark: pgfId-377178]Register the ASA with the ISE.

 
      		 [bookmark: pgfId-377180]Create a security group for the ASA on the ISE.

 
      		 [bookmark: pgfId-377182]Generate the PAC file on the ISE to import into the ASA.

 
     

 
     [bookmark: pgfId-377184]Registering the ASA with the ISE

 
     [bookmark: pgfId-377186]The ASA must be configured as a recognized Cisco TrustSec network device in the ISE before the ASA can successfully import a PAC file.

 
     [bookmark: pgfId-377188] 1. Log into the ISE.

 
     [bookmark: pgfId-377190] 2. Choose Administration > Network Devices > Network Devices.

 
     [bookmark: pgfId-377192] 3. Click Add.

 
     [bookmark: pgfId-377194] 4. Enter the IP address of the ASA.

 
     [bookmark: pgfId-377196] 5. When the ISE is being used for user authentication in the Cisco TrustSec solution, enter a shared secret in the Authentication Settings area.

 
     [bookmark: pgfId-377198]When you configure the AAA sever on the ASA, provide the shared secret you create here on the ISE. The AAA server on the ASA uses this shared secret to communicate with the ISE.

 
     [bookmark: pgfId-377200] 6. Specify a device name, device ID, password, and a download interval for the ASA. See the ISE documentation for the details to perform these tasks.

 
     [bookmark: pgfId-377202]Creating a Security Group on the ISE

 
     [bookmark: pgfId-377204]When configuring the ASA to communicate with the ISE, you specify a AAA server. When configuring the AAA server on the ASA, you must specify a server group.

 
     [bookmark: pgfId-377206]The security group must be configured to use the RADIUS protocol.

 
     [bookmark: pgfId-377208] 1. Log into the ISE.

 
     [bookmark: pgfId-377210] 2. Choose Policy > Policy Elements > Results > Security Group Access > Security Group.

 
     [bookmark: pgfId-377212] 3. Add a security group for the ASA. (Security groups are global and not ASA specific.)

 
     [bookmark: pgfId-377214]The ISE creates an entry under Security Groups with a tag.

 
     [bookmark: pgfId-377216] 4. Under the Security Group Access section, configure a device ID credentials and password for the ASA.

 
     [bookmark: pgfId-377218]Generating the PAC

 
     [bookmark: pgfId-377220]Before generating the PAC file, you must have registered the ASA with the ISE.

 
     [bookmark: pgfId-377222] 1. Log into the ISE.

 
     [bookmark: pgfId-377224] 2. Choose Administration > Network Resources > Network Devices.

 
     [bookmark: pgfId-377226] 3. From the list of devices, select the ASA device.

 
     [bookmark: pgfId-377228] 4. Under the Security Group Access (SGA), click Generate PAC.

 
     [bookmark: pgfId-377230] 5. To encrypt the PAC file, enter a password.

 
     [bookmark: pgfId-377232]The password (or encryption key) you enter to encrypt the PAC file is independent of the password that was configured on the ISE as part of the device credentials.

 
     [bookmark: pgfId-377234]The ISE generates the PAC file. The ASA can import the PAC from flash or from a remote server via TFTP, FTP, HTTP, HTTPS, or SMB. (The PAC does not have to reside on the ASA flash before you can import it.)

 
    
 
   
 
    
     [bookmark: pgfId-377248][bookmark: 40197][bookmark: trustsec_intro_ConfiguringTrustsecFirewallPolicies]Configuring TrustSec Firewall Policies[bookmark: marker-377240][bookmark: marker-377242][bookmark: marker-377244][bookmark: marker-377246]

 
    [bookmark: pgfId-377250]Security group awareness is integrated into several existing firewall rules; there is no unique TrustSec firewall policy. Additionally, supporting tools have been updated to work on TrustSec firewall policies. For example, you can search for rules that include a specific Security Group using the Find and Replace tool.

 
    [bookmark: pgfId-377252]The topics in this section explain the various procedures for integrating security group awareness into firewall policies.

 
    [bookmark: pgfId-377254]This section contains the following topics:

 
     
     		 [bookmark: pgfId-377259]Configuring Cisco TrustSec Services

 
     		 [bookmark: pgfId-377264]Creating Security Group Objects

 
     		 [bookmark: pgfId-377269]Selecting Security Groups in Policies

 
     		 [bookmark: pgfId-377274]Configuring TrustSec-Based Firewall Rules

 
    

 
     
      [bookmark: pgfId-377286][bookmark: 40215][bookmark: trustsec_proc_ConfiguringtheFirewalltoProvideTrustsecServices]Configuring Cisco TrustSec Services[bookmark: marker-377280][bookmark: marker-377282][bookmark: marker-377284]

 
     [bookmark: pgfId-377288]This procedure explains how to enable and configure Cisco TrustSec in Cisco Security Manager and on the required security devices.

 
     [bookmark: pgfId-377290]Before You Begin

 
     [bookmark: pgfId-377295]Before configuring an ASA to integrate with Cisco TrustSec, you must meet the prerequisites explained in Prerequisites for Integrating an ASA with Cisco TrustSec.

 
     [bookmark: pgfId-377297]To configure Cisco TrustSec, perform the following tasks:

 
     
 
     [bookmark: pgfId-377302]Step 1 Configure communication between Cisco Security Manager and the Cisco Identity Services Engine (ISE). See ISE Settings Page.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-377304]Note Security Manager supports communications with only one ISE appliance/server for fetching and resolving security group names and tags.


     
      

     

     

 
     [bookmark: pgfId-377309]Step 2 Enable and set the default values for the Security Exchange Protocol (SXP). See Configuring Security Exchange Protocol (SXP) Settings.

 
     [bookmark: pgfId-377314]Step 3 Add SXP connection peers for the Cisco TrustSec architecture. See Defining SXP Connection Peers.

 
     [bookmark: pgfId-377319]Step 4 (ASA 9.3.1+ devices only) Configure Security Group Tagging options. See Add/Edit Interface Dialog Box: Advanced Tab (ASA/PIX 7.0+).

 
     [bookmark: pgfId-377324]Step 5 (ASA 9.3.1+ devices only) Configure Security Group Tagging for VPN sessions. See ASA Group Policies SSL VPN Full Client Settings.

 
     [bookmark: pgfId-377329]Step 6 Configure the Security Policy. See Configuring TrustSec-Based Firewall Rules.

 
     [bookmark: pgfId-377334]Step 7 Monitor the TrustSec firewall system. See Monitoring TrustSec Firewall Policies.

 
     [bookmark: pgfId-377336]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-377346][bookmark: 40258][bookmark: trustsec_cncpt_ConfiguringSXPSettings]Configuring Security Exchange Protocol (SXP) Settings[bookmark: marker-377344]

 
     [bookmark: pgfId-377348]Use the SXP Settings page to enable the Security Exchange Protocol (SXP) on your security device and to configure SXP settings for the device.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-377350]Note All settings are available on the SXP Settings page whether you access that page from Policy view or from Device view for a specific device type. If you configure a setting that is not supported on a particular device, you will receive a validation warning and the unsupported CLI will not be generated for the device.


     
      

     

     

 
     [bookmark: pgfId-377352]Navigation Path

 
      
      		 [bookmark: pgfId-377354](Device view) Select the security device, then select  TrustSec > SXP Settings from the Policy selector.

 
      		 [bookmark: pgfId-377356](Policy view) Select  TrustSec > SXP Settings from the Policy selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-377358]Related Topics

 
      
      		 [bookmark: pgfId-377363]Prerequisites for Integrating an ASA with Cisco TrustSec

 
      		 [bookmark: pgfId-377368]Defining SXP Connection Peers

 
     

 
     [bookmark: pgfId-377370]Field Reference

 
     [bookmark: pgfId-377373] 

 
      
       
        
        [bookmark: pgfId-376009]Table 14-1 [bookmark: 40288]SXP Settings Page 

 
        
       
         
         		
           
           [bookmark: pgfId-376015]Element
          
  
         		
           
           [bookmark: pgfId-376017]Description
          
  
        

 
         
         		[bookmark: pgfId-376023]Enable SGT Exchange Protocol (SXP)

  
         		[bookmark: pgfId-376025]Whether to enable the Security Exchange Protocol on the device. The default is disabled

  
        

 
         
         		[bookmark: pgfId-376031]Retry Timer

  
         		[bookmark: pgfId-376033]The default time interval between attempts to set up new SXP connections between SXP peers. Enter the retry timer value as a number of seconds in the range of 0 to 64000 seconds. If you specify 0 seconds, the timer never expires and the device will not attempt to connect to SXP peers. By default, the timer value is 120 seconds.

 [bookmark: pgfId-376035]The device will continue to attempt to connect to new SXP peers until a successful connection is made. The retry timer is triggered as long as there is one SXP connection on the device that is not up.

 [bookmark: pgfId-376037]When the retry timer expires, the device goes through the connection database and if the database contains any connections that are off or in a "pending on" state, the device restarts the retry timer.

  
        

 
         
         		[bookmark: pgfId-376043]Reconcile Timer

  
         		[bookmark: pgfId-376045]The reconcile timer value as a number of seconds in the range of 0 to 64000 seconds. By default, the timer value is 120 seconds.

 [bookmark: pgfId-376047]After an SXP peer terminates its SXP connection, the security device starts a hold down timer. If an SXP peer reconnects while the hold down timer is running, the device starts the reconcile timer; then, the device updates the SXP mapping database to learn the latest mappings.

 [bookmark: pgfId-376049]When the reconcile timer expires, the device scans the SXP mapping database to identify stale mapping entries (entries that were learned in a previous connection session). The device marks these connections as obsolete. When the reconcile timer expires, the device removes the obsolete entries from the SXP mapping database.

 [bookmark: pgfId-376051]Note Setting the reconciliation period to 0 seconds disables the timer and causes all entries from the previous connection to be removed.

  
        

 
         
         		[bookmark: pgfId-376057]Server Group Name

 [bookmark: pgfId-376059](not applicable for IOS-XE)

  
         		[bookmark: pgfId-376061]Enter or select the name of the security group created on the ISE for the device.

 [bookmark: pgfId-376063]Note If you choose to select a server group, you are also give the option to add a AAA Server group.

 [bookmark: pgfId-376065]The server group name you specify here must match the name of the security group created on the ISE for the device. If these two group names do not match, the device will not be able to communicate with the ISE. Contact your ISE administrator if you do not have this information.

  
        

 
         
         		 
           
           [bookmark: pgfId-376071]CTS Server Settings (IOS/IOS-XE Only)
          
  
        

 
         
         		[bookmark: pgfId-376079]Log Binding Changes

  
         		[bookmark: pgfId-376081]Whether to enable logging for IP-to-SGT binding changes causing SXP syslogs (sev 5 syslog) to be generated whenever a change to IP-to-SGT binding occurs (add, delete, change). These changes are learned and propagated on the SXP connection. This logging function is disabled by default.

  
        

 
         
         		[bookmark: pgfId-376087]Enable Cache

 [bookmark: pgfId-376089]Cache NV Storage

 [bookmark: pgfId-376091](not applicable for IOS-XE)

  
         		[bookmark: pgfId-376093]Whether to enable caching of TrustSec authorization and environment data information to DRAM and NVRAM.

 [bookmark: pgfId-376095]To have DRAM cache updates written to non-volatile storage and to enable the DRAM cache to be initially populated from non-volatile storage when the device boots, select the desired file system from the Cache NV Storage list. Options include:

 
           
           		 [bookmark: pgfId-376097]flash

 
           		 [bookmark: pgfId-376099]flash0

 
           		 [bookmark: pgfId-376101]flash1

 
           		 [bookmark: pgfId-376103]flash2

 
           		 [bookmark: pgfId-376105]disk0

 
           		 [bookmark: pgfId-376107]disk1

 
           		 [bookmark: pgfId-376109]disk2

 
          

  
        

 
         
         		[bookmark: pgfId-376115]CTS SGT Number

  
         		[bookmark: pgfId-376117]Enter a number from 1-65533 to manually assign a Security Group Tag (SGT) number for this device.

  
        

 
         
         		[bookmark: pgfId-376123]Server Dead Time

 [bookmark: pgfId-376125](not applicable for IOS-XE)

  
         		[bookmark: pgfId-376127]Specifies how long a server in the group should not be selected for service once it has been marked as dead. The default is 20 seconds; the range is 1 to 864000.

  
        

 
         
         		[bookmark: pgfId-376133]Load Balance

 [bookmark: pgfId-376135](not applicable for IOS-XE)

  
         		[bookmark: pgfId-376137]Whether to configure RADIUS server group load balancing. When Load Balance is enabled, the following options can be specified:

 [bookmark: pgfId-376139]Batch size—The number of transactions to be assigned per batch. The default transactions is 25.

 [bookmark: pgfId-376141]Note Changes in batch size may impact CPU load and network throughput. As batch size increases, CPU load decreases and network throughput increases. However, if a large batch size is used, all available server resources may not be fully utilized. As batch size decreases, CPU load increases, and network throughput decreases. It is recommended that the default batch size, 25, be used because it is optimal for high throughput, without adversely impacting CPU load.

 [bookmark: pgfId-376143]Ignore Preferred-Server—Instructs the device not to try to use the same server throughout a session.

  
        

 
         
         		[bookmark: pgfId-376149]SGT Rolebased Map table

 [bookmark: pgfId-376151](ASA 9.3(1)+, IOS15.2(2)T+, and IOS-XE3.5.x(15.2(1)S)+ only)

  
         		[bookmark: pgfId-376153]Use the SGT Rolebased Map table to manually map Security Group Tag (SGT) numbers to individual IP addresses or host objects.

 [bookmark: pgfId-376155]You can do the following:

 
           
           		 [bookmark: pgfId-376160]To add an entry, click the  Add Row (+) button and fill in the Add Connection Peer dialog box. See Add/Edit SGT Role Dialog Box.

 
           		 [bookmark: pgfId-376162]To edit an entry, select it and click the  Edit Row (pencil) button.

 
           		 [bookmark: pgfId-376164]To delete an entry, select it and click the  Delete Row (trash can) button.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-377383][bookmark: 40399][bookmark: trustsec_cncpt_AddEditSGTRoleDialogBox]Add/Edit SGT Role Dialog Box[bookmark: marker-377381]

 
     [bookmark: pgfId-377385]Use the Add/Edit SGT Role dialog box to manually map Security Group Tag (SGT) numbers to individual IP addresses or host objects.

 
     [bookmark: pgfId-377387]Navigation Path

 
      
      		 [bookmark: pgfId-377389](Device view) Select an ASA, ISR, or ASR, then select  TrustSec > SXP Settings from the Policy selector.

 
     

 
     [bookmark: pgfId-377391] – To add an entry, click the Add Row (+) button beneath the SGT Rolebased Map table.

 
     [bookmark: pgfId-377393] – To edit an entry, select it and click the Edit Row (pencil) button beneath the SGT Rolebased Map table.

 
      
      		 [bookmark: pgfId-377395](Policy view) Select  TrustSec > SXP Settings from the Policy selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-377397] – To add an entry, click the Add Row (+) button beneath the SGT Rolebased Map table.

 
     [bookmark: pgfId-377399] – To edit an entry, select it and click the Edit Row (pencil) button beneath the SGT Rolebased Map table.

 
     [bookmark: pgfId-377401]Related Topics

 
      
      		 [bookmark: pgfId-377406]About Speaker and Listener Roles

 
      		 [bookmark: pgfId-377411]Prerequisites for Integrating an ASA with Cisco TrustSec

 
     

 
     [bookmark: pgfId-377413]Field Reference

 
     [bookmark: pgfId-377416] 

 
      
       
        
        [bookmark: pgfId-376177]Table 14-2 [bookmark: 40442]Add/Edit SGT Role dialog box 

 
        
       
         
         		
           
           [bookmark: pgfId-376183]Element
          
  
         		
           
           [bookmark: pgfId-376185]Description
          
  
        

 
         
         		[bookmark: pgfId-376191]IP Address

  
         		[bookmark: pgfId-376193]The IPv4 address of the host for which you want to manually assign a Security Group Tag (SGT) number.

 [bookmark: pgfId-376195]You can enter an IP address or the name of a host object, or click Select to select the object from a list or to create a new one.

  
        

 
         
         		[bookmark: pgfId-376201]CTS SGT Number

  
         		[bookmark: pgfId-376203]The Security Group Tag (SGT) number to assign to the specified host/IP address. Valid security tag numbers are 2-65519 for ASA 9.3(1)+ and 0-65533 for ISR and ASR.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-377426][bookmark: 40466][bookmark: trustsec_proc_DefiningSXPPeers]Defining SXP Connection Peers[bookmark: marker-377424]

 
     [bookmark: pgfId-377428]The Security-group eXchange Protocol (SXP) is a protocol developed for Cisco TrustSec to propagate the IP-to-SGT mapping database across network devices that do not have SGT-capable hardware support to hardware that supports SGTs and security group ACLs. SXP, a control plane protocol, passes IP-SGT mappings from authentication points (such as legacy access layer switches) to upstream devices in the network. SXP connections between peers are point-to-point and use TCP as the underlying transport protocol.

 
     [bookmark: pgfId-377430]Related Topics

 
      
      		 [bookmark: pgfId-377435]Prerequisites for Integrating an ASA with Cisco TrustSec

 
      		 [bookmark: pgfId-377440]About Speaker and Listener Roles

 
      		 [bookmark: pgfId-377445]Configuring Security Exchange Protocol (SXP) Settings

 
     

 
     
 
     [bookmark: pgfId-377447]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-377449](Device view) Select an ASA, ISR, or ASR, then select  TrustSec > SXP Connection Peers from the Policy selector.

 
      		 [bookmark: pgfId-377451](Policy view) Select  TrustSec > SXP Connection Peers from the Policy selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-377453]Step 2 In Default Source, enter the default local IP address for SXP connections. You can enter an IP address or the name of a network/host object, or click Select to select the object from a list or to create a new one. The IP address can be an IPv4 or IPv6 address.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-377455]Note The device determines the local IP address for an SXP connection as the outgoing interface IP address that is reachable by the peer IP address. If the configured local address is different from the outgoing interface IP address, the device cannot connect to the SXP peer and generates a system log message.


     
      

     

     

 
     [bookmark: pgfId-377457]Step 3 In Default Password and Confirm, enter the default password for TCP MD5 authentication with SXP peers. By default, SXP connections do not have a password set.

 
     [bookmark: pgfId-377459]You can specify the password as an encrypted string up to 162 characters or an ASCII key string up to 80 characters.

 
     [bookmark: pgfId-377461]Step 4 Configure the SXP Peers:

 
     [bookmark: pgfId-377463]You can do the following:

 
      
      		 [bookmark: pgfId-377468]To add an entry, click the  Add Row (+) button and fill in the Add Connection Peer dialog box. See Add/Edit Connection Peer Dialog Box.

 
      		 [bookmark: pgfId-377470]To edit an entry, select it and click the  Edit Row (pencil) button.

 
      		 [bookmark: pgfId-377472]To delete an entry, select it and click the  Delete Row (trash can) button.

 
     

 
     [bookmark: pgfId-377474]Step 5 Click Save to save your changes.

 
     [bookmark: pgfId-377476]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-377488][bookmark: 40524][bookmark: trustsec_cncpt_AddEditConnectionPeerDialogBox]Add/Edit Connection Peer Dialog Box[bookmark: marker-377484][bookmark: marker-377486]

 
     [bookmark: pgfId-377490]Use the Add/Edit Connection Peer dialog box to define the settings for an SXP Connection.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-377492]Note All settings are available on the Add/Edit Connection Peer dialog box whether you access that dialog box from Policy view or from Device view for a specific device type. If you configure a setting that is not supported on a particular device, you will receive a validation warning and the unsupported CLI will not be generated for the device.


     
      

     

     

 
     [bookmark: pgfId-377494]Navigation Path

 
      
      		 [bookmark: pgfId-377496](Device view) Select an ASA, ISR, or ASR, then select  TrustSec > SXP Connection Peers from the Policy selector.

 
     

 
     [bookmark: pgfId-377498] – To add an entry, click the Add Row (+) button.

 
     [bookmark: pgfId-377500] – To edit an entry, select it and click the Edit Row (pencil) button.

 
      
      		 [bookmark: pgfId-377502](Policy view) Select  TrustSec > SXP Connection Peers from the Policy selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-377504] – To add an entry, click the Add Row (+) button.

 
     [bookmark: pgfId-377506] – To edit an entry, select it and click the Edit Row (pencil) button.

 
     [bookmark: pgfId-377508]Related Topics

 
      
      		 [bookmark: pgfId-377513]About Speaker and Listener Roles

 
      		 [bookmark: pgfId-377518]Prerequisites for Integrating an ASA with Cisco TrustSec

 
     

 
     [bookmark: pgfId-377520]Field Reference

 
     [bookmark: pgfId-377523] 

 
      
       
        
        [bookmark: pgfId-376216]Table 14-3 [bookmark: 40571]Add Connection Peer dialog box 

 
        
       
         
         		
           
           [bookmark: pgfId-376222]Element
          
  
         		
           
           [bookmark: pgfId-376224]Description
          
  
        

 
         
         		[bookmark: pgfId-376230]Peer IP Address

  
         		[bookmark: pgfId-376232]The IPv4 or IPv6 address of the SXP peer. The peer IP address must be reachable from the outgoing interface.

 [bookmark: pgfId-376234]You can enter an IP address or the name of a network/host object, or click Select to select the object from a list or to create a new one.

  
        

 
         
         		[bookmark: pgfId-376240]Source IP Address

  
         		[bookmark: pgfId-376242](Optional) The local IPv4 or IPv6 address of the SXP connection. Specifying the source IP address is optional, however, specifying it safeguards misconfiguration.

 [bookmark: pgfId-376244]You can enter an IP address or the name of a network/host object, or click Select to select the object from a list or to create a new one.

 [bookmark: pgfId-376246]Note You cannot configure the Source IP Address and Peer IP Address with the same address. Also, you cannot use an IPv4 address with one field and an IPv6 address with the other.

  
        

 
         
         		[bookmark: pgfId-376252]Password

  
         		[bookmark: pgfId-376254]Whether to use the authentication key for the SXP connection. Select from the following values:

 
           
           		 [bookmark: pgfId-376259]default—Use the default password configured for SXP connections. See Defining SXP Connection Peers.

 
           		 [bookmark: pgfId-376261]none—Do not use a password for the SXP connection.

 
          

  
        

 
         
         		[bookmark: pgfId-376267]Mode

  
         		[bookmark: pgfId-376269]The mode of the SXP connection. Select from the following values:

 
           
           		 [bookmark: pgfId-376271]local—Use the local SXP device.

 
           		 [bookmark: pgfId-376273]peer—Use the peer SXP device.

 
          

  
        

 
         
         		[bookmark: pgfId-376279]Role

  
         		[bookmark: pgfId-376281]Whether the device functions as a Speaker or Listener for the SXP connection:

 
           
           		 [bookmark: pgfId-376283]listener—The device can receive IP-SGT mappings from downstream devices.

 
           		 [bookmark: pgfId-376285]speaker—The device can forward IP-SGT mappings to upstream devices.

 
          

 [bookmark: pgfId-376290]See About Speaker and Listener Roles.

  
        

 
         
         		[bookmark: pgfId-376296]Hold Time Min

 [bookmark: pgfId-376298]Only applicable on IOS and IOS-XE

  
         		[bookmark: pgfId-376300]The minimum length of the hold-time period in seconds for the speaker or listener device.

  
        

 
         
         		[bookmark: pgfId-376306]Hold Time Max

 [bookmark: pgfId-376308]Only applicable on IOS and IOS-XE

  
         		[bookmark: pgfId-376310]The maximum length of the hold-time period in seconds for the speaker or listener device. A hold-time maximum-period value is required only when you use the following option combinations: peer speaker and local listener. In other instances, only a hold-time minimum-period value is required.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-377539][bookmark: 40644][bookmark: trustsec_proc_CreatingTrustsecSecurityGroupObjects]Creating Security Group Objects[bookmark: marker-377531][bookmark: marker-377533][bookmark: marker-377535][bookmark: marker-377537]

 
     [bookmark: pgfId-377541]You can create security group object groups for use in features that support Cisco TrustSec by including the group in an extended ACL, which in turn can be used in an access rule, for example.

 
     [bookmark: pgfId-377543]When integrated with Cisco TrustSec, the security device downloads security group information from the Cisco Identity Services Engine (ISE). The ISE acts as an identity repository, by providing Cisco TrustSec tag to user identity mapping and Cisco TrustSec tag to server resource mapping. You provision and manage security group access lists centrally on the ISE.

 
     [bookmark: pgfId-377545]However, the device might have localized network resources that are not defined globally that require local security groups with localized security policies. Local security groups can contain nested security groups that are downloaded from the ISE. The security device consolidates local and central security groups.

 
     [bookmark: pgfId-377547]To create local security groups on the device, you create a local security object group. A local security object group can contain one or more nested security object groups or Security IDs or security group names. Users can also create a new Security ID or security group name that does not exist on the device.

 
     [bookmark: pgfId-377549]You can use the security object groups you create to control access to network resources. You can use the security object group as part of an access group or service policy.

 
     [bookmark: pgfId-377551]Tips

 
      
      		 [bookmark: pgfId-377553]Use of these objects is supported on ASA 9.0(1)+, IOS 15.2(2)T+, and IOS-XE 3.5.x(15.2(1)S)+ only.

 
      		 [bookmark: pgfId-377555]Although IOS does not support security group object groups, Security Manager allows the use of security group object groups for ISR devices and will automatically expand the object groups to their tag numbers during deployment.

 
      		 [bookmark: pgfId-377557]You must configure the TrustSec policy on the device to enable the use of these objects.

 
      		 [bookmark: pgfId-377562]You can create security group objects when defining policies or objects that use this object type. For more information, see Selecting Security Groups in Policies.

 
     

 
     [bookmark: pgfId-377564]Related Topics

 
      
      		 [bookmark: pgfId-377569]Selecting Security Groups in Policies

 
      		 [bookmark: pgfId-377574]Creating Policy Objects

 
     

 
     
 
     [bookmark: pgfId-377579]Step 1 Select Manage > Policy Objects to open the Policy Object Manager (see Policy Object Manager).

 
     [bookmark: pgfId-377581]Step 2 Select Security Group from the Object Type selector.

 
     [bookmark: pgfId-377583]Step 3 Right-click in the work area, then select New Object to open the Add Security Group dialog box.

 
     [bookmark: pgfId-377585]Step 4 Enter a name for the object and optionally a description of the object.

 
     [bookmark: pgfId-377587]Step 5 Add and remove items in the Members in Group list to identify the users and user groups defined in the object.

 
     [bookmark: pgfId-377589]To populate the list, do any combination of the following:

 
      
      		 [bookmark: pgfId-377591]In  Available Security Group , select an existing object and click the  Add >> button between the lists.

 
      		 [bookmark: pgfId-377596]In  Search name/tag , select a security group from the ISE server configured in the ISE Settings administrative options. You must configure the settings before you can select a name or tag (see ISE Settings Page).

 
     

 
     [bookmark: pgfId-377598]To find a security group, enter a search string. Then, click Search to find matches. A name is considered a match if the string appears anywhere within the security group name.

 
     [bookmark: pgfId-377600]To add the security group, select it in the list and click the Add >> button between the lists.

 
      
      		 [bookmark: pgfId-377602]In  Type in comma separated (Name or Tag) , first select the type of entry you are making, Name or Tag. Type in a valid security group name or tag number, then click the  Add >> button between the lists. Separate multiple names or tags with commas; they are added as separate lines in the members list. When adding multiple names or tags, avoid adding spaces before or after the comma.

 
     

 
     [bookmark: pgfId-377604]Valid security tag numbers are 0-65533 for ASA 9.3+, 1-65533 for ASA versions less than 9.3, 0-65533 for ISR, and 1-65535 for ASR.

 
      
      		 [bookmark: pgfId-377606]To remove an item from the object, select it in the Members list and click the  << Remove button between the lists.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-377608]Note Although IOS and IOS-XE only support security group tags, Security Manager allows the use of security group names for ISR and ASR devices, either directly or as part of a security group object group, and will automatically convert security group names to their tag number during deployment. However, if the ISE is not reachable, Security Manager will not be able to resolve the security group names. In such situations, Security Manager will not generate the rule for the configuration and an appropriate warning/error message will be displayed.


     
      

     

     

 
     [bookmark: pgfId-377613]Step 6 (Optional) Under Category, select a category to help you identify this object in the Objects table. See Using Category Objects.

 
     [bookmark: pgfId-377618]Step 7 (Optional) Select Allow Value Override per Device to allow the properties of this object to be redefined on individual devices. See Allowing a Policy Object to Be Overridden.

 
     [bookmark: pgfId-377620]Step 8 Click OK to save the object.

 
     [bookmark: pgfId-377622]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-377638][bookmark: 40741][bookmark: trustsec_cncpt_SelectingSecurityGroupsinPolicies]Selecting Security Groups in Policies[bookmark: marker-377632][bookmark: marker-377634][bookmark: marker-377636]

 
     [bookmark: pgfId-377640]In any policy or policy object that allows the specification of security groups, whether directly or through the selection of a TrustSec security group object, you can click the Select button next to the Security Groups field to help you enter the information.

 
     [bookmark: pgfId-377642]In the Security Group Selector dialog box, you can define the content of the Security Groups field by populating the Members in Group list. To populate the list, do any combination of the following:

 
      
      		 [bookmark: pgfId-377644]In  Available Security Group , select an existing object and click the  Add >> button between the lists. If the desired object does not exist, you can click the  Add (+) button below the list to create a new object. You can also select an object and click the  Edit (pencil) button to modify it or to examine its contents.

 
      		 [bookmark: pgfId-377649]In  Search name/tag , select a security group from the ISE server configured in the ISE Settings administrative options. You must configure the settings before you can select a name or tag (see ISE Settings Page).

 
     

 
     [bookmark: pgfId-377651]To find a security group, enter a search string. Then, click Search to find matches. A name is considered a match if the string appears anywhere within the security group name.

 
     [bookmark: pgfId-377653]To add the security group, select it in the list and click the Add >> button between the lists.

 
      
      		 [bookmark: pgfId-377655]In  Type in comma separated (Name or Tag) , first select the type of entry you are making, Name or Tag. Type in a valid security group name or tag number, then click the  Add >> button between the lists. Separate multiple names or tags with commas; they are added as separate lines in the members list. When adding multiple names or tags, avoid adding spaces before or after the comma.

 
     

 
     [bookmark: pgfId-377657]Valid security tag numbers are 0-65533 for ASA 9.3+, 1-65533 for ASA versions less than 9.3, 0-65533 for ISR, and 1-65535 for ASR.

 
      
      		 [bookmark: pgfId-377659]To remove an item from the object, select it in the Members list and click the  << Remove button between the lists.

 
     

 
    
 
     
      [bookmark: pgfId-377687][bookmark: 40785][bookmark: trustsec_cncpt_ConfiguringTrustsecBasedFirewallRules]Configuring TrustSec-Based Firewall Rules [bookmark: marker-377665][bookmark: marker-377667][bookmark: marker-377669][bookmark: marker-377671][bookmark: marker-377673][bookmark: marker-377675][bookmark: marker-377677][bookmark: marker-377679][bookmark: marker-377681][bookmark: marker-377683][bookmark: marker-377685]

 
     [bookmark: pgfId-377689]Security group awareness is integrated into the access control entries, or rules, in the ACLs used to provide firewall services. Because the feature is integrated into the ACL, the techniques for adding security group awareness to a firewall policy are the same for all types of firewall policy. This topic provides general guidance on how to incorporate security group awareness into your existing policies, and directs you to more specific information on configuring each type of policy that supports security groups.

 
     [bookmark: pgfId-377691]Firewall Policies That Support Security Groups

 
     [bookmark: pgfId-377693]For ASA 9.0.1+ only, you can configure security groups for the following policy types:

 
      
      		 [bookmark: pgfId-377698]AAA Rules—Select  Firewall > AAA Rules and see Configuring AAA Rules for ASA, PIX, and FWSM Devices.

 
      		 [bookmark: pgfId-377703]Access Rules—Select  Firewall > Access Rules and see Configuring Access Rules.

 
      		 [bookmark: pgfId-377708]Inspection Rules—Select  Firewall > Inspection Rules and see Configuring Inspection Rules.

 
      		 [bookmark: pgfId-377713]Policies that use extended ACL policy objects—Several firewall policies use extended ACL policy objects to define traffic matching criteria instead of incorporating a rule table directly in the policy. You can configure extended ACL policy objects to include security group specifications (see Creating Extended Access Control List Objects). You can then use these extended ACL objects in the following policies:

 
     

 
     [bookmark: pgfId-377718] – Botnet Traffic Filter Rules—Select Firewall > Botnet Traffic Filter Rules and see Enabling Traffic Classification and Actions for the Botnet Traffic Filter. You can use security groups as part of the traffic classification for Enable and Drop rules.

 
     [bookmark: pgfId-377723] – IPS, QoS, and Connection Rules (service policy rules)—Select Platform > Service Policy Rules > IPS, QoS, and Connection Rules and see Service Policy Rules Page.

 
     [bookmark: pgfId-377728]Traffic match criteria in this policy is based on extended ACL policy objects that are incorporated into traffic flow policy objects. You must select one of the options for specifying an ACL in the traffic flow object to incorporate security group traffic classification. For more information, see Configuring Traffic Flow Objects.

 
     [bookmark: pgfId-377733]For devices running IOS 15.2(2)T+ and IOS-XE 3.5.x(15.2(1)S)+, you can configure security groups for Zone-based Firewall Rules (Firewall > Zone Based Firewall Rules). For more information, see Adding Zone-Based Firewall Rules.

 
    
 
   
 
    
     [bookmark: pgfId-377747][bookmark: 40861][bookmark: trustsec_cncpt_MonitoringTrustsecFirewallPolicies]Monitoring TrustSec Firewall Policies[bookmark: marker-377739][bookmark: marker-377741][bookmark: marker-377743][bookmark: marker-377745]

 
    [bookmark: pgfId-377752]You can use Event Viewer to monitor TrustSec firewall policies the same way you would monitor other types of policies and events. The following are some tips to help you effectively monitor identity policies. For general information on using Event Viewer, see Chapter 68, “Viewing Events”.

 
     
     		 [bookmark: pgfId-377756]There are groups of syslog messages that relate specifically to Cisco TrustSec: 766001-766020, 766201-766205, 766251-766254, and 766301-766313. You can find descriptions of these messages in the Syslog Message document for your ASA software version at  http://www.cisco.com/en/US/products/ps6120/products_system_message_guides_list.html .

 
     		 [bookmark: pgfId-377758]Event Viewer has the following columns to display TrustSec information: TrustSec Security Group Name, TrustSec Security Group Tag, SXP Connection Source IP, SXP Connection Failure Reason, SXP Peer IP, SXP Peer Connection Failure Reason.

 
     		 [bookmark: pgfId-377760]You can filter on all identity-related syslog messages by creating a filter on Event Type and selecting the All Firewall Events > Trustsec Events folder.
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     [bookmark: pgfId-994396][bookmark: 118696][bookmark: pxchap_cncpt_ConfiguringMulticastPoliciesonFirewallDevices]Configuring Multicast Policies on Firewall Devices[bookmark: marker-994392][bookmark: marker-994394]
      
      
 
     
 

 
    [bookmark: pgfId-994398]The Multicast section contains pages for defining IP multicast routing on security devices. Multicast routing is supported in single-context, routed mode only.

 
    [bookmark: pgfId-994400]Enabling multicast routing enables IGMP and PIM on all interfaces by default. Internet Group Management Protocol (IGMP) is used to learn whether members of a group are present on directly attached subnets. Hosts join multicast groups by sending IGMP report messages. Protocol Independent Multicast (PIM) is used to maintain forwarding tables for multicast datagrams.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-994402]Note Only the UDP transport layer is supported for multicast routing.


    
     

    

    

 
    [bookmark: pgfId-994404]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-994409]Enabling PIM and IGMP

 
     		 [bookmark: pgfId-994414]Configuring IGMP

 
     		 [bookmark: pgfId-994419]Configuring Multicast Routes

 
     		 [bookmark: pgfId-994424]Configuring Multicast Boundary Filters

 
     		 [bookmark: pgfId-994429]Configuring PIM

 
    

 
   
 
    
     [bookmark: pgfId-994447][bookmark: 118708][bookmark: pxpage_cncpt_EnableMulticastRoutingPage]Enabling PIM and IGMP[bookmark: marker-994437][bookmark: marker-994439][bookmark: marker-994441][bookmark: marker-994443][bookmark: marker-994445]

 
    [bookmark: pgfId-994449]The Enable PIM and IGMP page lets you enable or disable Internet Group Management Protocol (IGMP) and Protocol Independent Multicast (PIM) on all interfaces on the security appliance. IGMP is used to learn whether members of a group are present on directly attached subnets. Hosts join multicast groups by sending IGMP report messages. PIM is used to maintain forwarding tables to forward multicast datagrams.

 
    [bookmark: pgfId-994451]When Enable PIM and IGMP is checked on this page, PIM and IGMP are enabled on all interfaces on the security appliance. Deselect the option to disable PIM and IGMP on all interfaces.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-994459]Note You can disable PIM and IGMP on a per-interface basis; see IGMP Page - Protocol Tab and PIM Page - Protocol Tab for more information.


    
     

    

    

 
    [bookmark: pgfId-994461]Navigation Path

 
     
     		 [bookmark: pgfId-994463](Device view) Select  Platform > Multicast > Enable PIM and IGMP from the Device Policy selector.

 
     		 [bookmark: pgfId-994465](Policy view) Select  PIX/ASA/FWSM Platform > Multicast > Enable PIM and IGMP from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-994467]Related Topics

 
     
     		 [bookmark: pgfId-994472]Configuring IGMP

 
     		 [bookmark: pgfId-994477]Configuring Multicast Routes

 
     		 [bookmark: pgfId-994482]Configuring Multicast Boundary Filters

 
     		 [bookmark: pgfId-994487]Configuring PIM

 
    

 
   
 
    
     [bookmark: pgfId-994501][bookmark: 118761][bookmark: pxchap_cncpt_ConfiguringIGMP]Configuring IGMP [bookmark: marker-994495][bookmark: marker-994497][bookmark: marker-994499]

 
    [bookmark: pgfId-994503]Internet Protocol hosts use IGMP to report their group memberships to directly connected multicast routers. Internet Group Management Protocol (IGMP) uses group-address (Class D) IP addresses.

 
    [bookmark: pgfId-994505]Host group addresses can be in the range 224.0.0.0 to 239.255.255.255. The address 224.0.0.0 is never assigned to any group. The address 224.0.0.1 is assigned to all systems on a subnet. The address 224.0.0.2 is assigned to all routers on a subnet.

 
    [bookmark: pgfId-994507]The IGMP page provides four tabbed panels, used to configure and manage IGMP in Security Manager:

 
     
     		 [bookmark: pgfId-994512]IGMP Page - Protocol Tab – This panel displays interface-specific IGMP parameters; you can disable IGMP and change IGMP parameters.

 
     		 [bookmark: pgfId-994517]IGMP Page - Access Group Tab – Lets you manage access groups that restrict the multicast sources allowed on an interface.

 
     		 [bookmark: pgfId-994522]IGMP Page - Static Group Tab – Sometimes, hosts on a network may have a configuration that prevents them from answering IGMP queries; however, you still want multicast traffic to be forwarded to that network segment. There are two methods to pull multicast traffic down to a network segment:

 
    

 
    [bookmark: pgfId-994524] – Use the Join Group tab to configure the interface as a member of the multicast group. With this method, the security appliance accepts the multicast packets in addition to forwarding them to the specified interface.

 
    [bookmark: pgfId-994526] – Use the Static Group tab to configure the security appliance to be a statically connected member of a group. With this method, the security appliance does not accept the packets itself, but only forwards them. Therefore, this method allows fast switching. The outgoing interface appears in the IGMP cache, but itself is not a member of the multicast group.

 
    [bookmark: pgfId-994528]Use this tab to statically assign a multicast group to an interface, or change existing static group assignments.

 
     
     		 [bookmark: pgfId-994533]IGMP Page - Join Group Tab – Use this tab to manage the multicast groups to which the security appliance belongs.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-994538]Note If you simply want to forward multicast packets for a specific group to an interface without the security appliance accepting those packets as part of the group, see IGMP Page - Static Group Tab.


    
     

    

    

 
    [bookmark: pgfId-994540]Navigation Path

 
     
     		 [bookmark: pgfId-994542](Device view) Select  Platform > Multicast > IGMP from the Device Policy selector.

 
     		 [bookmark: pgfId-994544](Policy view) Select  PIX/ASA/FWSM Platform > Multicast > IGMP from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
     
      [bookmark: pgfId-994558][bookmark: 118809][bookmark: pxpage_cncpt_ProtocolTab-1]IGMP Page - Protocol Tab[bookmark: marker-994550][bookmark: marker-994552][bookmark: marker-994554][bookmark: marker-994556]

 
     [bookmark: pgfId-994560]Use the Protocol tab to configure IGMP parameters for an interface on the security appliance.

 
     [bookmark: pgfId-994562]Navigation Path

 
     [bookmark: pgfId-994567]You can access the Protocol tab from the IGMP page. For more information about the IGMP page, see Configuring IGMP.

 
     [bookmark: pgfId-994569]Related Topics

 
      
      		 [bookmark: pgfId-994574]Configure IGMP Parameters Dialog Box

 
      		 [bookmark: pgfId-994579]Enabling PIM and IGMP

 
      		 [bookmark: pgfId-994584]Configuring PIM

 
      		 [bookmark: pgfId-994589]Configuring Multicast Routes

 
     

 
     [bookmark: pgfId-994591]Field Reference

 
     [bookmark: pgfId-994594] 

 
      
       
        
        [bookmark: pgfId-992769]Table 54-1 [bookmark: 118849]Protocol Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-992775]Element
          
  
         		
           
           [bookmark: pgfId-992777]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-992783]Protocol Table
          
  
        

 
         
         		[bookmark: pgfId-992791]Interface

  
         		[bookmark: pgfId-992793]The name of the interface to which the IGMP settings apply.

  
        

 
         
         		[bookmark: pgfId-992799]Enabled

  
         		[bookmark: pgfId-992801]Indicates whether IGMP is enabled on the interface.

  
        

 
         
         		[bookmark: pgfId-992807]Version

  
         		[bookmark: pgfId-992809]The version of IGMP enabled on the interface.

  
        

 
         
         		[bookmark: pgfId-992815]Query Interval

  
         		[bookmark: pgfId-992817]The interval, in seconds, at which the designated router sends IGMP host-query messages. Valid values range from 1 to 3600 seconds. The default value is 125 seconds.

  
        

 
         
         		[bookmark: pgfId-992823]Query Timeout

  
         		[bookmark: pgfId-992825]The period of time, in seconds, before the security appliance takes over querying the interface, after the previous appliance has stopped doing so. Valid values range from 60 to 300 seconds. The default value is 255 seconds.

  
        

 
         
         		[bookmark: pgfId-992831]Response Time

  
         		[bookmark: pgfId-992833]The maximum response time, in seconds, advertised in IGMP queries. If the security appliance does not receive any host reports within the designated response time, the IGMP group is pruned. Decreasing this value lets the security appliance prune groups faster. Valid values range from 1 to 12 seconds. The default value is 10 seconds. Changing this value is only valid only for IGMP Version 2.

  
        

 
         
         		[bookmark: pgfId-992839]Group Limit

  
         		[bookmark: pgfId-992841]The maximum number of hosts that can join on an interface. Valid values range from 1 to 500. The default value is 500.

  
        

 
         
         		[bookmark: pgfId-992847]Maximum Groups (PIX 6.3)

  
         		[bookmark: pgfId-992849]The maximum number of groups enabled for multicast. Valid values range from 0 to 2000.

  
        

 
         
         		[bookmark: pgfId-992855]Forward Interface

  
         		[bookmark: pgfId-992857]The name of the interface to which the selected interface forwards IGMP host reports if IGMP forwarding is enabled.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-994608][bookmark: 118909][bookmark: pxpage_cncpt_ConfigureIGMPParametersDialogBox]Configure IGMP Parameters Dialog Box[bookmark: marker-994602][bookmark: marker-994604][bookmark: marker-994606]

 
     [bookmark: pgfId-994610]Use the Configure IGMP Parameters dialog box to configure IGMP parameters for an interface on the security appliance.

 
     [bookmark: pgfId-994612]Navigation Path

 
     [bookmark: pgfId-994617]You can access the Configure IGMP Parameters dialog box from the IGMP Page - Protocol tab. For more information, see IGMP Page - Protocol Tab.

 
     [bookmark: pgfId-994619]Related Topics

 
      
      		 [bookmark: pgfId-994624]IGMP Page - Protocol Tab

 
      		 [bookmark: pgfId-994629]Configuring IGMP

 
     

 
     [bookmark: pgfId-994631]Field Reference

 
     [bookmark: pgfId-994634] 

 
      
       
        
        [bookmark: pgfId-992870]Table 54-2 [bookmark: 118941]Configure IGMP Parameters Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-992876]Element
          
  
         		
           
           [bookmark: pgfId-992878]Description
          
  
        

 
         
         		[bookmark: pgfId-992884]Interface

  
         		[bookmark: pgfId-992886]The name of the interface to which the IGMP settings apply.

  
        

 
         
         		[bookmark: pgfId-992892]Forward Interface

  
         		[bookmark: pgfId-992894]The name of the interface to which IGMP host reports are forwarded if IGMP forwarding is enabled.

  
        

 
         
         		[bookmark: pgfId-992900]Version

  
         		[bookmark: pgfId-992902]The version of IGMP to enable on the interface. Choose 1 to enable IGMP Version 1, or 2 to enable IGMP Version 2. Some features require IGMP Version 2. By default, the security appliance uses IGMP Version 2.

  
        

 
         
         		[bookmark: pgfId-992908]Query Interval

  
         		[bookmark: pgfId-992910]The interval, in seconds, at which the designated router sends IGMP host-query messages. Valid values range from 1 to 3600 seconds. The default value is 125 seconds.

  
        

 
         
         		[bookmark: pgfId-992916]Response Time

  
         		[bookmark: pgfId-992918]The maximum response time, in seconds, advertised in IGMP queries. If the security appliance does not receive any host reports within the designated response time, the IGMP group is pruned. Decreasing this value lets the security appliance prune groups faster. Valid values range from 1 to 12 seconds. The default value is 10 seconds. Changing this value is valid only for IGMP Version 2.

  
        

 
         
         		[bookmark: pgfId-992924]Maximum Groups (PIX 6.3)

  
         		[bookmark: pgfId-992926]The maximum number of groups enabled for multicast. Valid values range from 0 to 2000.

  
        

 
         
         		 
           
           [bookmark: pgfId-992932]PIX 7.x and ASA Only
          
  
        

 
         
         		[bookmark: pgfId-992940]Enable IGMP

  
         		[bookmark: pgfId-992942]When selected, IGMP is enabled on the specified interface.

  
        

 
         
         		[bookmark: pgfId-992948]Group Limit

  
         		[bookmark: pgfId-992950]The maximum number of hosts that can join on an interface. Valid values range from 1 to 500. The default value is 500.

  
        

 
         
         		[bookmark: pgfId-992956]Query Timeout

  
         		[bookmark: pgfId-992958]The period of time, in seconds, before the security appliance takes over querying the interface, after the previous appliance has stopped doing so. Valid values range from 60 to 300 seconds. The default value is 255 seconds.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-994650][bookmark: 119003][bookmark: pxpage_cncpt_AccessGroupTab]IGMP Page - Access Group Tab[bookmark: marker-994642][bookmark: marker-994644][bookmark: marker-994646][bookmark: marker-994648]

 
     [bookmark: pgfId-994652]Use the Access Group tab to control the multicast groups that are allowed on an interface.

 
     [bookmark: pgfId-994657]The table on this page lists all currently defined multicast access groups, showing for each, the name of the interface or interface role for which the group is defined, the group network(s), and whether this group is permitted or denied. For a detailed explanation of these fields, see Configure IGMP Access Group Parameters Dialog Box.

 
      
      		 [bookmark: pgfId-994659]To add a multicast access group to the table, click the Add Row button.

 
      		 [bookmark: pgfId-994661]To edit the settings for a group, select it and click the Edit Row button.

 
      		 [bookmark: pgfId-994663]To delete a group, select it and click the Delete Row button.

 
     

 
     [bookmark: pgfId-994665]Navigation Path

 
     [bookmark: pgfId-994670]You can access the Access Group tab from the Configuring IGMP.

 
     [bookmark: pgfId-994672]Related Topics

 
      
      		 [bookmark: pgfId-994677]Enabling PIM and IGMP

 
      		 [bookmark: pgfId-994682]Configuring Multicast Routes

 
     

 
    
 
     
      [bookmark: pgfId-994696][bookmark: 119043][bookmark: pxpage_cncpt_ConfigureIGMPAccessGroupParametersDialogBox]Configure IGMP Access Group Parameters Dialog Box[bookmark: marker-994690][bookmark: marker-994692][bookmark: marker-994694]

 
     [bookmark: pgfId-994698]Use the Configure IGMP Access Group Parameters dialog box to add or modify an access group entry.

 
     [bookmark: pgfId-994700]Navigation Path

 
     [bookmark: pgfId-994705]You can access the Configure IGMP Access Group Parameters dialog box from the IGMP Page - Access Group Tab.

 
     [bookmark: pgfId-994707]Related Topics

 
      
      		 [bookmark: pgfId-994712]IGMP Page - Access Group Tab

 
      		 [bookmark: pgfId-994717]Configuring IGMP

 
     

 
     [bookmark: pgfId-994719]Field Reference

 
     [bookmark: pgfId-994722] 

 
      
       
        
        [bookmark: pgfId-992971]Table 54-3 [bookmark: 119075]Configure IGMP Access Group Parameters Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-992977]Element
          
  
         		
           
           [bookmark: pgfId-992979]Description
          
  
        

 
         
         		[bookmark: pgfId-992985]Interface

  
         		[bookmark: pgfId-992987]Enter or Select the name of the interface to which the access group is assigned.

  
        

 
         
         		[bookmark: pgfId-992993]Multicast Group Network

  
         		[bookmark: pgfId-992995]Enter or Select the multicast group address(es) assigned to the specified interface. You can provide one or more IP address/netmask entries, one or more Networks/Hosts objects, or a combination of both; separate the entries with commas.

 [bookmark: pgfId-992997]Group network addresses can range from 224.0.0.0 to 239.255.255.255.

  
        

 
         
         		[bookmark: pgfId-993003]Action

  
         		[bookmark: pgfId-993005]Choose permit if the multicast group is permitted on the interface. Choose deny if the multicast group is not permitted.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-994738][bookmark: 119105][bookmark: pxpage_cncpt_StaticGroupTab]IGMP Page - Static Group Tab[bookmark: marker-994730][bookmark: marker-994732][bookmark: marker-994734][bookmark: marker-994736]

 
     [bookmark: pgfId-994740]Use the Static Group tab to statically assign a multicast group to an interface.

 
     [bookmark: pgfId-994742]Navigation Path

 
     [bookmark: pgfId-994747]You can access the Static Group tab from the IGMP page. For more information about the IGMP page, see Configuring IGMP.

 
     [bookmark: pgfId-994749]Related Topics

 
      
      		 [bookmark: pgfId-994754]Enabling PIM and IGMP

 
      		 [bookmark: pgfId-994759]Configuring Multicast Routes

 
      		 [bookmark: pgfId-994764]Configuring PIM

 
     

 
     [bookmark: pgfId-994766]Field Reference

 
     [bookmark: pgfId-994769] 

 
      
       
        
        [bookmark: pgfId-993018]Table 54-4 [bookmark: 119142]Static Group Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-993024]Element
          
  
         		
           
           [bookmark: pgfId-993026]Description
          
  
        

 
         
         		[bookmark: pgfId-993032]Interface

  
         		[bookmark: pgfId-993034]The name of the interface with which the static group is associated.

  
        

 
         
         		[bookmark: pgfId-993040]Multicast Group Address

  
         		[bookmark: pgfId-993042]The multicast group address to which this rule applies.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-994783][bookmark: 119162][bookmark: pxpage_cncpt_ConfigureIGMPStaticGroupParametersDialogBox]Configure IGMP Static Group Parameters Dialog Box[bookmark: marker-994777][bookmark: marker-994779][bookmark: marker-994781]

 
     [bookmark: pgfId-994785]Use the Configure IGMP Static Group Parameters dialog box to statically assign a multicast group to an interface or to change existing static group assignments.

 
     [bookmark: pgfId-994787]Navigation Path

 
     [bookmark: pgfId-994792]You can access the Configure IGMP Static Group Parameters dialog box from the IGMP Page - Static Group tab. For more information, see IGMP Page - Static Group Tab.

 
     [bookmark: pgfId-994794]Related Topics

 
      
      		 [bookmark: pgfId-994799]IGMP Page - Static Group Tab

 
      		 [bookmark: pgfId-994804]Configuring IGMP

 
     

 
     [bookmark: pgfId-994806]Field Reference

 
     [bookmark: pgfId-994809] 

 
      
       
        
        [bookmark: pgfId-993055]Table 54-5 [bookmark: 119194]Configure IGMP Static Group Parameters Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-993061]Element
          
  
         		
           
           [bookmark: pgfId-993063]Description
          
  
        

 
         
         		[bookmark: pgfId-993069]Interface

  
         		[bookmark: pgfId-993071]The name of the interface with which the static group is associated.

  
        

 
         
         		[bookmark: pgfId-993077]Multicast Group

  
         		[bookmark: pgfId-993079]The multicast group address to which this rule applies. The group address must be from 224.0.0.0 to 239.255.255.255.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-994825][bookmark: 119216][bookmark: pxpage_cncpt_JoinGroupTab]IGMP Page - Join Group Tab[bookmark: marker-994817][bookmark: marker-994819][bookmark: marker-994821][bookmark: marker-994823]

 
     [bookmark: pgfId-994827]Use the Join Group tab to configure an interface to be a member of a multicast group.

 
     [bookmark: pgfId-994829]Navigation Path

 
     [bookmark: pgfId-994834]You can access the Join Group tab from the IGMP page. For more information about the IGMP page, see Configuring IGMP.

 
     [bookmark: pgfId-994836]Related Topics

 
      
      		 [bookmark: pgfId-994841]Enabling PIM and IGMP

 
      		 [bookmark: pgfId-994846]Configuring PIM

 
      		 [bookmark: pgfId-994851]Configuring Multicast Routes

 
     

 
     [bookmark: pgfId-994853]Field Reference

 
     [bookmark: pgfId-994856] 

 
      
       
        
        [bookmark: pgfId-993092]Table 54-6 [bookmark: 119253]Join Group Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-993098]Element
          
  
         		
           
           [bookmark: pgfId-993100]Description
          
  
        

 
         
         		[bookmark: pgfId-993106]Interface

  
         		[bookmark: pgfId-993108]The name of the interface for which you are configuring multicast group membership.

  
        

 
         
         		[bookmark: pgfId-993114]Multicast Group Address

  
         		[bookmark: pgfId-993116]The multicast group address to which this rule applies.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-994870][bookmark: 119273][bookmark: pxpage_cncpt_ConfigureIGMPJoinGroupParametersDialogBox]Configure IGMP Join Group Parameters Dialog Box[bookmark: marker-994864][bookmark: marker-994866][bookmark: marker-994868]

 
     [bookmark: pgfId-994872]Use the Configure IGMP Join Group Parameters dialog box to configure an interface to be a member of a multicast group or to change existing membership information.

 
     [bookmark: pgfId-994874]Navigation Path

 
     [bookmark: pgfId-994879]You can access the Configure IGMP Join Group Parameters dialog box from the IGMP Page - Join Group tab. For more information, see IGMP Page - Join Group Tab.

 
     [bookmark: pgfId-994881]Related Topics

 
      
      		 [bookmark: pgfId-994886]IGMP Page - Join Group Tab

 
      		 [bookmark: pgfId-994891]Configuring IGMP

 
     

 
     [bookmark: pgfId-994893]Field Reference

 
     [bookmark: pgfId-994896] 

 
      
       
        
        [bookmark: pgfId-993129]Table 54-7 [bookmark: 119305]Configure IGMP Join Group Parameters Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-993135]Element
          
  
         		
           
           [bookmark: pgfId-993137]Description
          
  
        

 
         
         		[bookmark: pgfId-993143]Interface

  
         		[bookmark: pgfId-993145]The name of the interface for which you are configuring multicast group membership.

  
        

 
         
         		[bookmark: pgfId-993151]Join Group

  
         		[bookmark: pgfId-993153]The multicast group address to which this rule applies. The group address must be from 224.0.0.0 to 239.255.255.255.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-994910][bookmark: 119328][bookmark: pxchap_proc_ConfiguringMulticastRoutes]Configuring Multicast Routes[bookmark: marker-994904][bookmark: marker-994906][bookmark: marker-994908]

 
    [bookmark: pgfId-994912]Static multicast routes let you separate multicast traffic from unicast traffic. For example, when a path between a source and destination does not support multicast routing, the solution is to configure two multicast devices with a GRE tunnel between them, sending the multicast packets over the tunnel.

 
    [bookmark: pgfId-994914]Static multicast routes are local to the security appliance and are not advertised or redistributed.

 
    [bookmark: pgfId-994916]Use the Multicast Routes page to manage static multicast routes—currently defined routes are listed, and you can add, edit and delete static multicast routes.

 
    [bookmark: pgfId-994921]See Add/Edit MRoute Configuration Dialog Box for more information about the fields displayed in the table on this page.

 
    [bookmark: pgfId-994923]Navigation Path

 
     
     		 [bookmark: pgfId-994925](Device view) Select  Platform > Multicast > Multicast Routes from the Device Policy selector.

 
     		 [bookmark: pgfId-994927](Policy view) Select  PIX/ASA/FWSM Platform > Multicast > Multicast Routes from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-994929]Related Topics

 
     
     		 [bookmark: pgfId-994934]Chapter 54, “Configuring Multicast Policies on Firewall Devices”

 
     		 [bookmark: pgfId-994939]Enabling PIM and IGMP

 
     		 [bookmark: pgfId-994944]Configuring IGMP

 
     		 [bookmark: pgfId-994949]Configuring PIM

 
    

 
     
      [bookmark: pgfId-994965][bookmark: 119371][bookmark: pxpage_cncpt_AddEditMRouteConfigurationDialogBox]Add/Edit MRoute Configuration Dialog Box [bookmark: marker-994957][bookmark: marker-994959][bookmark: marker-994961][bookmark: marker-994963]

 
     [bookmark: pgfId-994967]Use the Add/Edit MRoute Configuration dialog box to add a static multicast route to the security appliance, or to change an existing route.

 
     [bookmark: pgfId-994969]Navigation Path

 
     [bookmark: pgfId-994974]You can access the Add/Edit MRoute Configuration dialog box from the Multicast Routing page. See Configuring Multicast Routes for more information.

 
     [bookmark: pgfId-994976]Field Reference

 
     [bookmark: pgfId-994979] 

 
      
       
        
        [bookmark: pgfId-993166]Table 54-8 [bookmark: 119396]Add/Edit MRoute Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-993172]Element
          
  
         		
           
           [bookmark: pgfId-993174]Description
          
  
        

 
         
         		[bookmark: pgfId-993180]Source Interface

  
         		[bookmark: pgfId-993182]Enter or Select the incoming interface for the multicast route.

  
        

 
         
         		[bookmark: pgfId-993188]Source Network

  
         		[bookmark: pgfId-993190]Enter the IP address and mask of the multicast source, or select a Networks/Hosts object.

  
        

 
         
         		[bookmark: pgfId-993196]Output Interface/Dense

  
         		[bookmark: pgfId-993198](Optional) Enter or Select the outgoing interface for the multicast route. If you specify the destination interface, the route is forwarded through the selected interface. If you do not specify a destination interface, then RPF is used to forward the route. You can specify the interface, or the RPF neighbor, but not both at the same time.

  
        

 
         
         		[bookmark: pgfId-993204]Multicast Network (PIX 6.3)

  
         		[bookmark: pgfId-993206]Enter or Select the group that is to receive the multicast packets. This must be a multicast IP address in the range of 224.0.1.0 to 239.255.255.255.

  
        

 
         
         		[bookmark: pgfId-993212]Distance (PIX 7.x, ASA and FWSM)

  
         		[bookmark: pgfId-993214]Enter an administrative distance for the static multicast route. If the static multicast route has the same administrative distance as the unicast route, the static multicast route takes precedence.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-994995][bookmark: 119433][bookmark: pxpage_cncpt_MulticastBoundaryFilterPage]Configuring Multicast Boundary Filters[bookmark: marker-994987][bookmark: marker-994989][bookmark: marker-994991][bookmark: marker-994993]

 
    [bookmark: pgfId-994997]On an ASA running version 7.2(1) or later, you can use the Multicast Boundary Filter page to configure the appliance to act as a boundary between multicast domains. The ASA compares multicast group addresses to an access list, blocking all multicast traffic except that specifically permitted by the list.

 
    [bookmark: pgfId-994999]The Multicast Boundary Filter page lists all currently defined per-interface boundary filter lists; you can add, edit and delete filter lists from this page.

 
    [bookmark: pgfId-995004]Refer to Add/Edit MBoundary Configuration Dialog Box for a description of the fields on this page.

 
    [bookmark: pgfId-995006]Navigation Path

 
     
     		 [bookmark: pgfId-995008](Device view) Select  Platform > Multicast > Multicast Boundary Filter from the Device Policy selector.

 
     		 [bookmark: pgfId-995010](Policy view) Select  PIX/ASA/FWSM Platform > Multicast > Multicast Boundary Filter from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-995012]Related Topics

 
     
     		 [bookmark: pgfId-995017]Add/Edit MBoundary Interface Configuration Dialog Box

 
    

 
     
      [bookmark: pgfId-995031][bookmark: 119470][bookmark: pxpage_cncpt_AddEditMBoundaryConfigurationDialogBox]Add/Edit MBoundary Configuration Dialog Box[bookmark: marker-995025][bookmark: marker-995027][bookmark: marker-995029]

 
     [bookmark: pgfId-995035][bookmark: marker-995033] Use the Add/Edit MBoundary Configuration dialog box to add, edit and delete multicast boundary filter lists for individual interfaces.

 
     [bookmark: pgfId-995037]Navigation Path

 
     [bookmark: pgfId-995042]You can access the Add/Edit MBoundary Configuration dialog box from the Configuring Multicast Boundary Filters.

 
     [bookmark: pgfId-995044]Related Topics

 
      
      		 [bookmark: pgfId-995049]Add/Edit MBoundary Interface Configuration Dialog Box

 
      		 [bookmark: pgfId-995054]Configuring Multicast Boundary Filters

 
     

 
     [bookmark: pgfId-995056]Field Reference

 
     [bookmark: pgfId-995059] 

 
      
       
        
        [bookmark: pgfId-993227]Table 54-9 [bookmark: 119505]Add/Edit MBoundary Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-993233]Element
          
  
         		
           
           [bookmark: pgfId-993235]Description
          
  
        

 
         
         		[bookmark: pgfId-993241]Interface

  
         		[bookmark: pgfId-993243]Enter or Select an interface for this multicast boundary.

  
        

 
         
         		[bookmark: pgfId-993249]Remove any Auto_RP group range announcements

  
         		[bookmark: pgfId-993251]If you check this box, Auto-RP messages denied by the boundary access control list for this interface are dropped. This is referred to as AutoFiltering.

  
        

 
         
         		[bookmark: pgfId-993257]Multicast boundary filter configuration list

  
         		[bookmark: pgfId-993262]Lists the multicast group addresses specifically permitted or denied for the specified interface. This list is managed with the Add/Edit MBoundary Interface Configuration Dialog Box (click Add Row or Edit Row).

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-995075][bookmark: 119531][bookmark: pxpage_cncpt_AddEditMBoundaryInterfaceConfigurationDialogBox]Add/Edit MBoundary Interface Configuration Dialog Box [bookmark: marker-995067][bookmark: marker-995069][bookmark: marker-995071][bookmark: marker-995073]

 
     [bookmark: pgfId-995077]Use this dialog box to define permit or deny multicast group entries for the list in the Add/Edit MBoundary Configuration dialog box.

 
     [bookmark: pgfId-995079]Navigation Path

 
     [bookmark: pgfId-995084]You can access the Add/Edit MBoundary Interface Configuration dialog box from the Add/Edit MBoundary Configuration Dialog Box.

 
     [bookmark: pgfId-995086]Related Topics

 
      
      		 [bookmark: pgfId-995091]Configuring Multicast Boundary Filters

 
     

 
     [bookmark: pgfId-995093]Field Reference

 
     [bookmark: pgfId-995096] 

 
      
       
        
        [bookmark: pgfId-993275]Table 54-10 [bookmark: 119562]Add/Edit MBoundary Interface Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-993281]Element
          
  
         		
           
           [bookmark: pgfId-993283]Description
          
  
        

 
         
         		[bookmark: pgfId-993289]Action

  
         		[bookmark: pgfId-993291]Choose permit or deny to specify the action taken for this multicast group.

  
        

 
         
         		[bookmark: pgfId-993297]Multicast Group

  
         		[bookmark: pgfId-993299]Enter a single multicast address, or a multicast group address, to which this action applies. The address must be 0.0.0.0, or from 224.0.0.0 to 239.255.255.255. A group address range can be entered using either a standard subnet mask (e.g., 239.0.0.0 255.0.0.0), or using CIDR prefix notation (e.g., 239.0.0.0/8).

 [bookmark: pgfId-993301]You also can Select a named network/host object.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-995116][bookmark: 119588][bookmark: pxchap_cncpt_ConfiguringPIM]Configuring PIM[bookmark: marker-995104][bookmark: marker-995106][bookmark: marker-995108][bookmark: marker-995110][bookmark: marker-995112][bookmark: marker-995114]

 
    [bookmark: pgfId-995118]Protocol independent multicast (PIM) provides a scalable method for determining the best paths in a network for distributing a specific multicast transmission to each host that has registered using IGMP to receive the transmission. Routers and security devices use PIM to maintain tables for forwarding multicast datagrams.

 
    [bookmark: pgfId-995120]With PIM sparse mode (PIM SM), which is the default for Cisco routers, when the source of a multicast transmission begins broadcasting, the traffic is forwarded from one multicast router to the next until the packets reach every registered host. If a more direct path to the traffic source exists, the last-hop router sends a join message to the source that causes the traffic to be rerouted along the better path.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-995122]Note PIM is not supported with PAT—the PIM protocol does not use ports and PAT only works with protocols that use ports.


    
     

    

    

 
    [bookmark: pgfId-995124]When you enable multicast routing on a security appliance, PIM and IGMP are enabled on all interfaces by default. You can disable PIM on a per-interface basis.

 
    [bookmark: pgfId-995126]The PIM page provides up to six tabbed panels:

 
     
     		 [bookmark: pgfId-995131]PIM Page - Protocol Tab – Lets you manage interface-specific PIM properties.

 
     		 [bookmark: pgfId-995136]PIM Page - Neighbor Filter Tab – Lets you manage neighbor filters for individual interfaces; available only on ASA 7.2(1)+ devices.

 
     		 [bookmark: pgfId-995141]PIM Page - Bidirectional Neighbor Filter Tab – Lets you manage bidirectional neighbor filters for individual interfaces; available only on ASA 7.2(1)+ devices.

 
     		 [bookmark: pgfId-995146]PIM Page - Rendezvous Points Tab – When you configure PIM, you must choose one or more devices to operate as the rendezvous point (RP). An RP is a single, common root of a shared distribution tree and is statically configured on each device. First-hop routers use the RP to send registration packets on behalf of the source multicast hosts.

 
     		 [bookmark: pgfId-995151]PIM Page - Route Tree Tab – By default, PIM leaf routers join the shortest-path tree immediately after the first packet arrives from a new source. This reduces delay, but requires more memory than shared tree. You can configure whether the security appliance should join shortest-path tree, or use a shared tree, either for all multicast groups or only for specific multicast addresses.

 
     		 [bookmark: pgfId-995156]PIM Page - Request Filter Tab – When the security appliance is acting as an RP, you can restrict specific multicast sources from registering. This prevents unauthorized sources from registering with the RP. The Request Filter panel lets you define the multicast sources from which the security appliance will accept PIM registration messages.

 
    

 
     
      [bookmark: pgfId-995168][bookmark: 119636][bookmark: pxpage_cncpt_ProtocolTab-2]PIM Page - Protocol Tab[bookmark: marker-995162][bookmark: marker-995164][bookmark: marker-995166]

 
     [bookmark: pgfId-995170]Use the Protocol tab to configure PIM properties for the interfaces on a security appliance (not available on PIX 6.3 devices). All currently configured interfaces are listed; you can add, edit and delete entries on this panel.

 
     [bookmark: pgfId-995175]Refer to Add/Edit PIM Protocol Dialog Box for a description of the fields on this panel.

 
     [bookmark: pgfId-995177]Navigation Path

 
     [bookmark: pgfId-995182]You access the Protocol tab from the PIM page. For more information, see Configuring PIM.

 
     [bookmark: pgfId-995184]Related Topics

 
      
      		 [bookmark: pgfId-995189]PIM Page - Rendezvous Points Tab

 
      		 [bookmark: pgfId-995194]PIM Page - Route Tree Tab

 
      		 [bookmark: pgfId-995199]PIM Page - Request Filter Tab

 
     

 
    
 
     
      [bookmark: pgfId-995215][bookmark: 119669][bookmark: pxpage_cncpt_AddEditPIMProtocolDialogBox]Add/Edit PIM Protocol Dialog Box [bookmark: marker-995207][bookmark: marker-995209][bookmark: marker-995211][bookmark: marker-995213]

 
     [bookmark: pgfId-995217]Use the Add/Edit PIM Protocol dialog box to configure PIM properties for an interface on a security appliance running PIX 7.x or later.

 
     [bookmark: pgfId-995219]About the Designated Router

 
     [bookmark: pgfId-995221]The DR is responsible for sending PIM register, join, and prune messaged to the Rendezvous Point (RP). When there is more than one multicast routing device on a network segment, there is an election process to select the Designated Router based on DR priority. If multiple devices have the same DR priority, then the device with the highest IP address becomes the DR. By default, security appliances have a DR priority of 1.

 
     [bookmark: pgfId-995223]Navigation Path

 
     [bookmark: pgfId-995228]You can access the Add/Edit PIM Protocol dialog box from the PIM Page - Protocol Tab.

 
     [bookmark: pgfId-995230]Field Reference

 
     [bookmark: pgfId-995233] 

 
      
       
        
        [bookmark: pgfId-993314]Table 54-11 [bookmark: 119698]Add/Edit PIM Protocol Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-993320]Element
          
  
         		
           
           [bookmark: pgfId-993322]Description
          
  
        

 
         
         		[bookmark: pgfId-993328]Interface

  
         		[bookmark: pgfId-993330]Enter or Select the interface on which you are configuring PIM.

  
        

 
         
         		[bookmark: pgfId-993336]Enable PIM

  
         		[bookmark: pgfId-993338]When checked, PIM is enabled on the selected interface. You can deselect this option to disable PIM on the interface without deleting this PIM Protocol entry from the table.

  
        

 
         
         		[bookmark: pgfId-993344]DR Priority

  
         		[bookmark: pgfId-993346]The designated router (DR) priority for this interface. The router with the highest DR priority on subnet becomes the designated router. Valid values range from 0 to 4294967294. The default DR priority is 1. Setting this value to zero makes the security appliance interface ineligible to become the default router.

  
        

 
         
         		[bookmark: pgfId-993352]Hello Interval (seconds)

  
         		[bookmark: pgfId-993354]The frequency, in seconds, at which the interface sends PIM hello messages. Valid values range from 1 to 3600 seconds; the default value is 30 seconds.

  
        

 
         
         		[bookmark: pgfId-993360]Join-Prune Interval (seconds)

  
         		[bookmark: pgfId-993362]The frequency, in seconds, at which the interface sends PIM join and prune advertisements. Valid values range from 10 to 600 seconds; the default value is 60 seconds.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-995249][bookmark: 119735][bookmark: pxpage_cncpt_NeighborFilterTab]PIM Page - Neighbor Filter Tab[bookmark: marker-995241][bookmark: marker-995243][bookmark: marker-995245][bookmark: marker-995247]

 
     [bookmark: pgfId-995251]A PIM neighbor filter is an access control list (ACL) that defines the neighbor devices that can participate in PIM. If a neighbor filter is not configured for an interface, then there are no restrictions. If a PIM neighbor filter is configured, only those neighbors permitted by the filter list can participate in PIM with the security appliance.

 
     [bookmark: pgfId-995256]On an ASA running version 7.2(1) or later, you can use the Neighbor Filter tab to control the devices that can become PIM neighbors. This panel is used to define and manage the per-interface neighbor filter list. Refer to Add/Edit PIM Neighbor Filter Dialog Box for a description of the fields on this panel.

 
     [bookmark: pgfId-995258]Navigation Path

 
     [bookmark: pgfId-995263]You access the Protocol tab from the PIM page. For more information, see Configuring PIM.

 
     [bookmark: pgfId-995265]Related Topics

 
      
      		 [bookmark: pgfId-995270]PIM Page - Protocol Tab

 
      		 [bookmark: pgfId-995275]PIM Page - Bidirectional Neighbor Filter Tab

 
      		 [bookmark: pgfId-995280]PIM Page - Rendezvous Points Tab

 
      		 [bookmark: pgfId-995285]PIM Page - Route Tree Tab

 
      		 [bookmark: pgfId-995290]PIM Page - Request Filter Tab

 
     

 
    
 
     
      [bookmark: pgfId-995308][bookmark: 119778][bookmark: pxpage_cncpt_AddEditPIMNeighborFilterDialogBox]Add/Edit PIM Neighbor Filter Dialog Box [bookmark: marker-995298][bookmark: marker-995300][bookmark: marker-995302][bookmark: marker-995304][bookmark: marker-995306]

 
     [bookmark: pgfId-995310]Use the Add/Edit PIM Neighbor Filter dialog box to add and edit entries in the PIM neighbor filter ACL displayed on the Neighbor Filter panel of the PIM page.

 
     [bookmark: pgfId-995312]Navigation Path

 
     [bookmark: pgfId-995317]You can access the Add/Edit PIM Neighbor Filter dialog box from the PIM Page - Neighbor Filter Tab.

 
     [bookmark: pgfId-995319]Field Reference

 
     [bookmark: pgfId-995322] 

 
      
       
        
        [bookmark: pgfId-993375]Table 54-12 [bookmark: 119807]Add/Edit PIM Neighbor Filter Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-993381]Element
          
  
         		
           
           [bookmark: pgfId-993383]Description
          
  
        

 
         
         		[bookmark: pgfId-993389]Interface

  
         		[bookmark: pgfId-993391]Enter or Select the interface to which this PIM Neighbor filter entry will be applied.

  
        

 
         
         		[bookmark: pgfId-993397]Neighbor Filter Group

  
         		[bookmark: pgfId-993399]Enter a single multicast address, or a multicast group address, to which the chosen Action applies. A group address range can be entered using either a standard subnet mask (e.g., 239.0.0.0 255.0.0.0), or using CIDR prefix notation (e.g., 239.0.0.0/8).

 [bookmark: pgfId-993401]You also can Select a named network/host object.

  
        

 
         
         		[bookmark: pgfId-993407]Action

  
         		[bookmark: pgfId-993409]Choose permit to allow the specified neighbors to participate in PIM, or deny to prevent the specified neighbors from participating in PIM.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-995338][bookmark: 119837][bookmark: pxpage_cncpt_BidirectionNeighborFilterTab]PIM Page - Bidirectional Neighbor Filter Tab [bookmark: marker-995330][bookmark: marker-995332][bookmark: marker-995334][bookmark: marker-995336]

 
     [bookmark: pgfId-995340]A PIM bidirectional neighbor filter is an access control list (ACL) that defines the neighbor devices that can participate in the bidirectional trees and designated forwarder (DF) election. If a PIM bidirectional neighbor filter is not configured for an interface, then there are no restrictions. If a PIM bidirectional neighbor filter is configured, only those neighbors permitted by the ACL can participate in DF election process.

 
     [bookmark: pgfId-995342]The PIM bidirectional neighbor filters enable the transition from a sparse-mode-only network to a “bidir” network by letting you specify the devices that should participate in DF election, while still allowing all devices to participate in the sparse-mode domain. The bidir-enabled devices can elect a DF from among themselves, even when there are non-bidir devices on the segment. Multicast boundaries on the non-bidir devices prevent PIM messages and data from the bidir groups from leaking in or out of the bidir subset cloud.

 
     [bookmark: pgfId-995344]Bidirectional PIM allows multicast devices to maintain reduced state information. All of the multicast devices in a segment must be bidirectionally enabled for bidir to elect a DF.

 
     [bookmark: pgfId-995346]When a PIM bidirectional neighbor filter is enabled, the routers and other devices that are permitted by the ACL are considered to be bidir-capable. Therefore:

 
      
      		 [bookmark: pgfId-995348]If a permitted neighbor does not support bidir, the DF election does not occur.

 
      		 [bookmark: pgfId-995350]If a denied neighbor supports bidir, then DF election does not occur.

 
      		 [bookmark: pgfId-995352]If a denied neighbor does not support bidir, the DF election can occur.

 
     

 
     [bookmark: pgfId-995354]Managing the Bidirectional Neighbor Filter List

 
     [bookmark: pgfId-995359]On an ASA running version 7.2(1) or later, you can use this panel to define and manage the per-interface bidirectional neighbor filter list, permitting or denying multicast source addresses for specific interfaces. Refer to Add/Edit PIM Bidirectional Neighbor Filter Dialog Box for a description of the fields on this panel.

 
     [bookmark: pgfId-995361]Navigation Path

 
     [bookmark: pgfId-995366]You access the Bidirectional Neighbor Filter tab from the PIM page. For more information, see Configuring PIM.

 
     [bookmark: pgfId-995368]Related Topics

 
      
      		 [bookmark: pgfId-995373]PIM Page - Protocol Tab

 
      		 [bookmark: pgfId-995378]PIM Page - Neighbor Filter Tab

 
      		 [bookmark: pgfId-995383]PIM Page - Rendezvous Points Tab

 
      		 [bookmark: pgfId-995388]PIM Page - Route Tree Tab

 
      		 [bookmark: pgfId-995393]PIM Page - Request Filter Tab

 
     

 
    
 
     
      [bookmark: pgfId-995409][bookmark: 119892][bookmark: pxpage_cncpt_AddEditPIMBidirNeighborFilterDialog]Add/Edit PIM Bidirectional Neighbor Filter Dialog Box [bookmark: marker-995401][bookmark: marker-995403][bookmark: marker-995405][bookmark: marker-995407]

 
     [bookmark: pgfId-995414]Use the Add/Edit PIM Bidirectional Neighbor Filter dialog box to add or edit an entry in the bidirectional neighbor access control list displayed on the PIM Page - Bidirectional Neighbor Filter Tab.

 
     [bookmark: pgfId-995416]Navigation Path

 
     [bookmark: pgfId-995421]You can access the Add/Edit PIM Bidirectional Neighbor Filter dialog box from the PIM Page - Bidirectional Neighbor Filter Tab.

 
     [bookmark: pgfId-995423]Field Reference

 
     [bookmark: pgfId-995426] 

 
      
       
        
        [bookmark: pgfId-993422]Table 54-13 [bookmark: 119918]Add/Edit PIM Bidirectional Neighbor Filter Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-993428]Element
          
  
         		
           
           [bookmark: pgfId-993430]Description
          
  
        

 
         
         		[bookmark: pgfId-993436]Interface

  
         		[bookmark: pgfId-993438]Enter or Select the interface to which this PIM Bidirectional Neighbor filter entry will be applied.

  
        

 
         
         		[bookmark: pgfId-993444]Neighbor Filter Group

  
         		[bookmark: pgfId-993446]Enter a single multicast address, or a multicast group address, to which the chosen Action applies. A group address range can be entered using either a standard subnet mask (e.g., 239.0.0.0 255.0.0.0), or using CIDR prefix notation (e.g., 239.0.0.0/8).

 [bookmark: pgfId-993448]You also can Select a named network/host object.

  
        

 
         
         		[bookmark: pgfId-993454]Action

  
         		[bookmark: pgfId-993456]Choose permit to allow the specified neighbors to participate in the DF election process, or deny to prevent the specified neighbors from participating in the process.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-995442][bookmark: 119948][bookmark: pxpage_cncpt_RendezvousPointsTab]PIM Page - Rendezvous Points Tab[bookmark: marker-995434][bookmark: marker-995436][bookmark: marker-995438][bookmark: marker-995440]

 
     [bookmark: pgfId-995444]When you configure PIM, you must choose one or more routers or routing devices to operate as the RP. An RP is a single, common root of a shared distribution tree and is statically configured on each device. First hop routers use the RP to send register packets on behalf of the source multicast hosts.

 
     [bookmark: pgfId-995446]You can configure a single RP to serve more than one group. If a specific group is not specified, the RP for the group is applied to the entire IP multicast group range (224.0.0.0/4).

 
     [bookmark: pgfId-995448]Use the Rendezvous Points panel to define rendezvous points. You can configure more than one RP, but you cannot have more than one entry with the same RP.

 
     [bookmark: pgfId-995450]Navigation Path

 
     [bookmark: pgfId-995455]You access the Rendezvous Points tab from the PIM page. For more information, see Configuring PIM.

 
     [bookmark: pgfId-995457]Related Topics

 
      
      		 [bookmark: pgfId-995462]PIM Page - Protocol Tab

 
      		 [bookmark: pgfId-995467]PIM Page - Route Tree Tab

 
      		 [bookmark: pgfId-995472]PIM Page - Request Filter Tab

 
     

 
     [bookmark: pgfId-995474]Field Reference

 
     [bookmark: pgfId-995477] 

 
      
       
        
        [bookmark: pgfId-993469]Table 54-14 [bookmark: 119988]Rendezvous Points Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-993475]Element
          
  
         		
           
           [bookmark: pgfId-993477]Description
          
  
        

 
         
         		[bookmark: pgfId-993483]Generate older IOS compatible register messages

  
         		[bookmark: pgfId-993485]Check this box if your rendezvous point is a Cisco IOS router. The security appliance software accepts register messages with the checksum calculated on the PIM header and only the next 4 bytes, while Cisco IOS software accepts register messages with the checksum calculated on the entire PIM message for all PIM message types.

  
        

 
         
         		[bookmark: pgfId-993491]Rendezvous Points table

  
         		[bookmark: pgfId-993496]Lists the rendezvous points currently configured on the security appliance. Use the Add Row, Edit Row and Delete Row buttons to manage this list; the Add Row and Edit Row buttons open the Add/Edit Rendezvous Point Dialog Box.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-995493][bookmark: 120009][bookmark: pxpage_cncpt_AddEditRendezvousPointDialogBox]Add/Edit Rendezvous Point Dialog Box [bookmark: marker-995485][bookmark: marker-995487][bookmark: marker-995489][bookmark: marker-995491]

 
     [bookmark: pgfId-995495]Use the Add/Edit Rendezvous Point dialog box to add an entry to the Rendezvous Points table, or to edit an existing rendezvous point entry. Please note the following:

 
      
      		 [bookmark: pgfId-995497]You cannot use the same rendezvous point address twice.

 
      		 [bookmark: pgfId-995499]You cannot specify “All Groups” for more than one rendezvous point.

 
     

 
     [bookmark: pgfId-995501]Navigation Path

 
     [bookmark: pgfId-995506]You can access the Add/Edit Rendezvous Point dialog box from the PIM Page - Rendezvous Points Tab.

 
     [bookmark: pgfId-995508]Field Reference

 
     [bookmark: pgfId-995511] 

 
      
       
        
        [bookmark: pgfId-993509]Table 54-15 [bookmark: 120041]Add/Edit Rendezvous Point Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-993515]Element
          
  
         		
           
           [bookmark: pgfId-993517]Description
          
  
        

 
         
         		[bookmark: pgfId-993523]Rendezvous Point IP Address

  
         		[bookmark: pgfId-993525]Enter the IP address of the rendezvous point. This is a unicast address. You also can click Select to select a Networks/Hosts object.

 [bookmark: pgfId-993527]When editing a rendezvous point entry, you cannot change this value.

  
        

 
         
         		[bookmark: pgfId-993533]Use bi-directional forwarding

  
         		[bookmark: pgfId-993535]Check this box if you want the specified Multicast Groups to operate in bidirectional mode. In bidirectional mode, if the security appliance receives a multicast packet and has no directly connected members or PIM neighbors present, it sends a Prune message back to the source. Deselect this option if you want the specified Multicast Groups to operate in Sparse Mode.

 [bookmark: pgfId-993537]Note The security appliance always advertises bidirectional capability in PIM hello messages regardless of the actual bidir configuration.

  
        

 
         
         		[bookmark: pgfId-993543]Use this RP for All Multicast Groups

  
         		[bookmark: pgfId-993545]Select this option to use the specified Rendezvous Point for all multicast groups on the interface.

  
        

 
         
         		[bookmark: pgfId-993551]Use this RP for the Multicast Groups as specified below

  
         		[bookmark: pgfId-993553]Select this option to define the multicast groups that are to use the specified Rendezvous Point; the Multicast Groups table is activated.

  
        

 
         
         		[bookmark: pgfId-993559]Multicast Groups table

  
         		[bookmark: pgfId-993561]The multicast groups currently associated with the specified Rendezvous Point are listed.

 [bookmark: pgfId-993563]Table entries are processed from the top down. For example, you can create an entry that includes a range of multicast groups, and then exclude specific groups within that range by placing deny rules for those specific groups at the top of the table. That is, the permit rule for the range of multicast groups follows the individual deny statements.

 [bookmark: pgfId-993568]Use the buttons at the bottom of the table to open the Add/Edit Multicast Group Rules Dialog Box to add or edit an entry; to delete an entry; and to move entries up or down in the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-995527][bookmark: 120081][bookmark: pxpage_cncpt_AddEditMulticastGroupsDialogBox]Add/Edit Multicast Group Rules Dialog Box [bookmark: marker-995521][bookmark: marker-995523][bookmark: marker-995525]

 
     [bookmark: pgfId-995529]Use the Add/Edit Multicast Group Rules dialog box to create a multicast group rule, or modify a multicast group rule, for the Multicast Groups table in the Add/Edit Rendezvous Point dialog box. This dialog box is also used to specify individual multicast groups that use Shared Tree route filtering on the Route Tree tab

 
     [bookmark: pgfId-995531]Navigation Path

 
     [bookmark: pgfId-995539]When defining Rendezvous Points, you access the Add/Edit Multicast Group Rules dialog box from the Add/Edit Rendezvous Point Dialog Box. See PIM Page - Rendezvous Points Tab for more information.

 
     [bookmark: pgfId-995544]When specifying how PIM register messages are filtered, you open this dialog box by clicking Add Row or Edit row buttons below the Multicast Groups table on the PIM Page - Route Tree Tab.

 
     [bookmark: pgfId-995546]Field Reference

 
     [bookmark: pgfId-995549] 

 
      
       
        
        [bookmark: pgfId-993581]Table 54-16 [bookmark: 120109]Add/Edit Multicast Group Rules Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-993587]Element
          
  
         		
           
           [bookmark: pgfId-993589]Description
          
  
        

 
         
         		[bookmark: pgfId-993595]Action

  
         		[bookmark: pgfId-993597]Choose permit to create a group rule that allows the specified multicast addresses; choose deny to create a group rule that denies the specified multicast addresses.

  
        

 
         
         		[bookmark: pgfId-993603]Multicast Group Network

  
         		[bookmark: pgfId-993605]Enter the multicast address and network mask associated with the group, or Select the desired Networks/Hosts object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-995565][bookmark: 120134][bookmark: pxpage_cncpt_RouteTreeTab]PIM Page - Route Tree Tab[bookmark: marker-995557][bookmark: marker-995559][bookmark: marker-995561][bookmark: marker-995563]

 
     [bookmark: pgfId-995567]If the security appliance is acting as a Rendezvous Point, use the Route Tree tab to specify how the PIM register messages from various sources are filtered: shortest-path tree or shared tree, either for all multicast groups or only for specific multicast addresses.

 
     [bookmark: pgfId-995569]Navigation Path

 
     [bookmark: pgfId-995574]You can access the Route Tree tab from the PIM page. For more information, see Configuring PIM.

 
     [bookmark: pgfId-995576]Related Topics

 
      
      		 [bookmark: pgfId-995581]PIM Page - Protocol Tab

 
      		 [bookmark: pgfId-995586]PIM Page - Rendezvous Points Tab

 
      		 [bookmark: pgfId-995591]PIM Page - Request Filter Tab

 
     

 
     [bookmark: pgfId-995593]Field Reference

 
     [bookmark: pgfId-995596] 

 
      
       
        
        [bookmark: pgfId-993618]Table 54-17 [bookmark: 120172]Route Tree Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-993624]Element
          
  
         		
           
           [bookmark: pgfId-993626]Description
          
  
        

 
         
         		[bookmark: pgfId-993632]If.., specify how the PIM register messages from various sources are filtered

  
         		[bookmark: pgfId-993634]Select a tree/groups option:

 
           
           		 [bookmark: pgfId-993636] Use Shortest Path Tree for All Groups – The security appliance uses shortest-path tree for all multicast groups.

 
           		 [bookmark: pgfId-993638] Use Shared Tree for All Groups – The security appliance uses shared tree for all multicast groups.

 
           		 [bookmark: pgfId-993640] Use Shared Tree for the Groups specified below – The security appliance uses shared tree for those groups specified below in the Multicast Groups table. Shortest-path tree is used for any group not listed in the Multicast Groups table.

 
          

  
        

 
         
         		[bookmark: pgfId-993646]Multicast Groups table

  
         		[bookmark: pgfId-993648]The multicast groups using Shared Tree are listed.

 [bookmark: pgfId-993650]Table entries are processed from the top down. For example, you can create an entry that includes a range of multicast groups, and then exclude specific groups within that range by placing deny rules for those specific groups at the top of the table. That is, the permit rule for the range of multicast groups follows the individual deny statements.

 [bookmark: pgfId-993655]Use the buttons at the bottom of the table to open the Add/Edit Multicast Group Rules Dialog Box to add or edit an entry; to delete an entry; and to move entries up or down in the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-995612][bookmark: 120206][bookmark: pxpage_cncpt_RequestFilterTab]PIM Page - Request Filter Tab [bookmark: marker-995604][bookmark: marker-995606][bookmark: marker-995608][bookmark: marker-995610]

 
     [bookmark: pgfId-995614]When the security appliance acts as a rendezvous point, you can restrict specific multicast sources from registering with it. This prevents unauthorized sources from registering with the rendezvous point. You can use the Request Filter tab to define the multicast sources from which the security appliance accepts and denies PIM register messages.

 
     [bookmark: pgfId-995616]Navigation Path

 
     [bookmark: pgfId-995621]You can access the Request Filter tab from the PIM page. For more information, see Configuring PIM.

 
     [bookmark: pgfId-995623]Related Topics

 
      
      		 [bookmark: pgfId-995628]PIM Page - Protocol Tab

 
      		 [bookmark: pgfId-995633]PIM Page - Rendezvous Points Tab

 
      		 [bookmark: pgfId-995638]PIM Page - Route Tree Tab

 
     

 
     [bookmark: pgfId-995640]Field Reference

 
     [bookmark: pgfId-995643] 

 
      
       
        
        [bookmark: pgfId-993668]Table 54-18 [bookmark: 120244]Request Filter Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-993674]Element
          
  
         		
           
           [bookmark: pgfId-993676]Description
          
  
        

 
         
         		[bookmark: pgfId-993682]Filter PIM register messages using

  
         		[bookmark: pgfId-993684]Choose how PIM register messages are filtered for different multicast groups:

 
           
           		 [bookmark: pgfId-993686] None – Do not filter PIM register messages.

 
           		 [bookmark: pgfId-993688] route-map – Filter PIM register messages using a specified route map; the Route Map field is activated. Only PIM register messages that are permitted by the route map are allowed to reach the rendezvous point.

 
           		 [bookmark: pgfId-993690] access-list – Filter PIM register messages using an access list; the Multicast Groups table is activated. Only PIM register messages that are permitted by the access list are allowed to reach the rendezvous point.

 
          

  
        

 
         
         		[bookmark: pgfId-993696]Route Map

  
         		[bookmark: pgfId-993698]When route-map is the chosen filter, enter a route-map name. Use standard host ACLs in the referenced route map; extended ACLs are not supported.

 [bookmark: pgfId-993703]Note This field contains only the Route Map name. The Route Map is created and contained within a FlexConfig; see Chapter 7, “Managing FlexConfigs” for more information.

  
        

 
         
         		[bookmark: pgfId-993709]Multicast Groups table

  
         		[bookmark: pgfId-993711]Lists the currently defined multicast group Request Filter rules.

 [bookmark: pgfId-993713]Table entries are processed from the top down. For example, you can create an entry that includes a range of multicast groups, and then exclude specific groups within that range by placing deny rules for those specific groups at the top of the table. That is, the permit rule for the range of multicast groups follows the individual deny statements.

 [bookmark: pgfId-993718]Use the buttons at the bottom of the table to open the Add/Edit Multicast Group Rules Dialog Box to add or edit an entry; to delete an entry; and to move entries up or down in the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-995657][bookmark: 120285][bookmark: pxpage_cncpt_MulticastGroupDialogBox-2]Add/Edit Multicast Group Rules Dialog Box [bookmark: marker-995651][bookmark: marker-995653][bookmark: marker-995655]

 
     [bookmark: pgfId-995659]Use the Add/Edit Multicast Group Rules dialog box to define the multicast sources that are denied or permitted to register with the security appliance when the appliance acts as a rendezvous point. You create the filter rules based on the source IP address and the destination multicast address.

 
     [bookmark: pgfId-995661]Navigation Path

 
     [bookmark: pgfId-995666]You can access the Add/Edit Multicast Group Rules dialog box from the PIM Page - Request Filter Tab.

 
     [bookmark: pgfId-995668]Field Reference

 
     [bookmark: pgfId-995671] 

 
      
       
        
        [bookmark: pgfId-993731]Table 54-19 [bookmark: 120308]Add/Edit Multicast Group Rules Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-993737]Element
          
  
         		
           
           [bookmark: pgfId-993739]Description
          
  
        

 
         
         		[bookmark: pgfId-993745]Action

  
         		[bookmark: pgfId-993747]Choose permit to create a rule that allows the specified Source of the specified Destination multicast traffic to register with the security appliance; choose deny to create a rule that denies registration to the specified Source/Destination multicast traffic.

  
        

 
         
         		[bookmark: pgfId-993753]Source Network

  
         		[bookmark: pgfId-993755]Enter the IP address and network mask for the source of the register message, or Select the appropriate Networks/Hosts object.

  
        

 
         
         		[bookmark: pgfId-993761]Destination Network

  
         		[bookmark: pgfId-993763]Enter the IP address and network mask for the multicast destination, or Select the appropriate Networks/Hosts object.
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     [bookmark: pgfId-698428][bookmark: 8738][bookmark: wfact_cncpt_ManagingActivities]Managing Activities[bookmark: marker-698426]
      
      
 
     
 

 
    [bookmark: pgfId-698430]Whether you are using Workflow or non-Workflow mode, all policy configuration is done within an activity, which is also called a configuration session in non-Workflow mode. In Workflow mode, you must explicitly create and manage activities, whereas in non-Workflow mode much of the activity creation and management is done automatically for you. However, in non-Workflow mode, you are in fact working within an activity whenever you modify policies, and so you should understand the basic activity concepts.

 
    [bookmark: pgfId-698432]In non-Workflow mode with Ticket Management enabled, an activity is created automatically and transparently whenever you open a ticket. You must actively open and manage tickets in this mode.

 
    [bookmark: pgfId-698434]The following topics provide information about activities:

 
     
     		 [bookmark: pgfId-698439]Understanding Activities

 
     		 [bookmark: pgfId-698444]Working with Activities/Tickets

 
    

 
   
 
    
     [bookmark: pgfId-698454][bookmark: 8753][bookmark: wfact_cncpt_UnderstandingActivities]Understanding Activities[bookmark: marker-698450][bookmark: marker-698452]

 
    [bookmark: pgfId-698456]An activity is a temporary context within which you define policies and assign them to devices. You do not need to create an activity to import, create, or delete devices (unless you perform policy discovery as part of the action), or to perform various system management tasks.

 
    [bookmark: pgfId-698458]The requirements for creating or opening activities differ depending on your Workflow mode:

 
     
     		 [bookmark: pgfId-698460]Non-Workflow mode with Ticket Management—An activity is created automatically and transparently whenever you open a ticket. If you do not explicitly open a ticket, you are prompted to create a new ticket or open an existing one whenever you perform an action that requires an activity. You must actively open and manage tickets in this mode.

 
     		 [bookmark: pgfId-698462]Non-Workflow mode without Ticket Management—An activity is created automatically and transparently for you whenever you define, modify, or assign policies to devices. The same activity is used until you submit your changes to the database, and is automatically closed and reopened as needed. You cannot actively open or manage activities in non-Workflow mode. These types of activities are also called configuration sessions.

 
     		 [bookmark: pgfId-698464]Workflow mode—If you do not explicitly open an activity, you are prompted to create a new activity or open an existing one whenever you perform an action that requires an activity. You must actively open and manage activities in Workflow mode.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-698466]Note Workflow mode works in the same manner whether Ticket Management is enabled or not. Enabling Ticket Management in Workflow mode simply enables the Ticket field for use with Activities. Entering a ticket ID is not required, but if one is used, the Ticket field can be configured to link to an external change management system. For more information, see Ticket Management.


    
     

    

    

 
    [bookmark: pgfId-698468]When you create an activity, or one is created for you, you open a virtual copy of the Security Manager policy database. You define and assign policies within this copy. Changes that you made within this copy are only available within the copy. Other users in different activities cannot see these changes. After the activity is submitted and, in Workflow mode, approved, the changes within this copy are committed to the database so that all other users can view the changes. Then, you can create a deployment job to generate the relevant CLI commands and deploy them to the devices.

 
    [bookmark: pgfId-698470]How you submit your activity changes differs depending on Workflow mode:

 
     
     		 [bookmark: pgfId-698472]Non-Workflow mode with Ticket Management (default)—Select  Tickets > Submit Ticket to submit your changes to the policy database.

 
     		 [bookmark: pgfId-698474]Non-Workflow mode without Ticket Management—Select  File > Submit to submit your changes to the policy database.

 
     		 [bookmark: pgfId-698476]Workflow mode—Select  Activities > Submit Activity if you are working with an activity approver, or  Activities > Approve Activity if you do not have a separate activity approver.

 
    

 
    [bookmark: pgfId-698478]The following topics describe why activities are important and how they operate in Workflow mode:

 
     
     		 [bookmark: pgfId-698483]Benefits of Activities

 
     		 [bookmark: pgfId-698488]Activity Approval

 
     		 [bookmark: pgfId-698493]Activities and Locking

 
     		 [bookmark: pgfId-698498]Activities and Multiple Users

 
     		 [bookmark: pgfId-698503]Understanding Activity/Ticket States

 
    

 
     
      [bookmark: pgfId-698511][bookmark: 8801][bookmark: wfact_cncpt_BenefitsofActivities]Benefits of Activities[bookmark: marker-698509]

 
     [bookmark: pgfId-698513]You use activities to control changes made to policies and policy assignments. Although how activities are implemented depends on the workflow settings you choose, all activities provide the following benefits:

 
      
      		 [bookmark: pgfId-698521]Audit trail—Activities track changes that are made in Security Manager. You can use this information to determine what changes were made and who made the changes as described in Viewing Activity/Ticket Status and History. For both Workflow and non-Workflow mode, there is also an audit report that provides visibility into activities and other actions, as described in Working with Audit Reports.

 
      		 [bookmark: pgfId-698526]Safety mechanism—Activities provide a means for experimenting with changes. Because you are making the changes to a private database view, if you do not want to implement the changes, you can easily discard the activity or configuration session. For more information, see Discarding an Activity/Ticket.

 
      		 [bookmark: pgfId-698531]Task isolation—The policies that are modified within an activity (or configuration session) are locked from being modified within other activities. This prevents conflicting changes that could make a policy unstable. For more information, see Activities and Locking.

 
     

 
     [bookmark: pgfId-698533]In addition, the changes you make within an activity are visible only within the activity. Other users see only the last approved committed configurations, unless they view your activity before you close it (in Workflow mode).

 
    
 
     
      [bookmark: pgfId-698541][bookmark: 8821][bookmark: wfact_cncpt_ActivityApproval]Activity Approval[bookmark: marker-698539]

 
     [bookmark: pgfId-698543]When you enable Workflow mode, you can choose to operate with or without an activity approver.

 
     [bookmark: pgfId-698545]If your organization requires a different person with higher permissions to approve activities, you can enable workflow with an approver. When using Workflow mode with an approver, the activity must be approved by a person with the appropriate permissions so the policies can be committed to the database. This approval process at the policy definition level helps to ensure that no inappropriate configurations reach the network devices.

 
     [bookmark: pgfId-698547]If you choose to operate without an approver, the person defining the policies has the permissions to approve them.

 
     [bookmark: pgfId-698552]For information about enabling or disabling activity approval and changing the default activity approver, see Workflow Page.

 
    
 
     
      [bookmark: pgfId-698564][bookmark: 8832][bookmark: wfact_cncpt_ActivitiesandLocking]Activities and Locking[bookmark: marker-698558][bookmark: marker-698560][bookmark: marker-698562]

 
     [bookmark: pgfId-698566]To prevent multiple users from making conflicting changes, Security Manager obtains activity-level locks when a user performs certain actions within an activity or configuration session in Workflow or non-Workflow mode. This prevents two or more people from making changes to the same feature policy, policy assignment, or object at the same time.

 
     [bookmark: pgfId-698568]Security Manager also uses locking to ensure that operations related to the committed configuration always run exclusive of one another. These operations can be divided into two categories:

 
     [bookmark: pgfId-698570]Operations that change the committed configuration:

 
      
      		 [bookmark: pgfId-698572]Activity approval, which includes configuration session submission in non-Workflow mode.

 
      		 [bookmark: pgfId-698574]Device deletion.

 
      		 [bookmark: pgfId-698576]Editing device properties.

 
     

 
     [bookmark: pgfId-698578]Operations that read the committed configuration:

 
      
      		 [bookmark: pgfId-698580]Configuration preview.

 
      		 [bookmark: pgfId-698582]Deployment (in non-Workflow mode).

 
      		 [bookmark: pgfId-698584]Creation of deployment job (in Workflow mode).

 
      		 [bookmark: pgfId-698586]Activity or configuration session validation.

 
     

 
     [bookmark: pgfId-698588]If you are performing an operation that changes the committed configuration, no one can perform any of the operations in either list until this operation is complete. An error message is displayed to the user who tries, indicating the action and activity (or user, in non-Workflow mode) that has the lock. For example, if you are approving an activity (which occurs automatically when an activity is submitted in non-Workflow mode), no one else can delete a device or validate a different activity until the approval is complete. This type of locking is particularly important in multi-user settings as it prevents multiple users from simultaneously making changes to the committed configuration.

 
     [bookmark: pgfId-698590]If you are performing an operation that reads the committed configuration, no one can perform an operation that changes the committed configuration. For example, if you are validating an activity, another user cannot approve an activity. However, other users can perform another operation that reads the configuration. For example, if you are validating an activity, another user can create a deployment job. Similarly, if you are previewing the configuration before deployment, another user is permitted to do the same. This is because these two operations are limited to reading the committed configuration; they do not make any changes to it.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-698595]Tip Activity locking is broader in scope than policy locking, which is described in Understanding Policy Locking. Policy locking prevents two users from changing the same policy on the same device simultaneously.


     
      

     

     

 
     [bookmark: pgfId-698597]Related Topics

 
      
      		 [bookmark: pgfId-698602]Approving or Rejecting an Activity (Workflow Mode)

 
      		 [bookmark: pgfId-698607]Deleting Devices from the Security Manager Inventory

 
      		 [bookmark: pgfId-698612]Viewing or Changing Device Properties

 
      		 [bookmark: pgfId-698617]Working with Deployment and the Configuration Archive

 
      		 [bookmark: pgfId-698622]Validating an Activity/Ticket

 
     

 
    
 
     
      [bookmark: pgfId-698636][bookmark: 8887][bookmark: wfact_cncpt_ActivitiesandMultipleUsers]Activities and Multiple Users[bookmark: marker-698628][bookmark: marker-698630][bookmark: marker-698632][bookmark: marker-698634]

 
     [bookmark: pgfId-698638]Only one user can define or change policies within an individual activity at one time. However, when Workflow mode is enabled or when Ticket Management is enabled in non-Workflow mode, multiple users can work in the activity in sequence. That is, if an activity or ticket is closed (but not yet approved or submitted for approval), another user can open it and make changes to it if they have the necessary privileges. Multiple users can work in parallel in different activities.

 
    
 
     
      [bookmark: pgfId-698658][bookmark: 8903][bookmark: wfact_cncpt_UnderstandingActivityStates]Understanding Activity/Ticket States[bookmark: marker-698646][bookmark: marker-698648][bookmark: marker-698650][bookmark: marker-698652][bookmark: marker-698654][bookmark: marker-698656]

 
     [bookmark: pgfId-698660]Activities in Workflow mode and tickets in non-Workflow mode (when Ticket Management is enabled) can have the states described in the following table. The main states are shown in bold.

 
     [bookmark: pgfId-698663] 

 
      
       
        
        [bookmark: pgfId-697193]Table 4-1 [bookmark: 8927]Activity/Ticket States 

 
        
       
         
         		
           
           [bookmark: pgfId-697199]State
          
  
         		
           
           [bookmark: pgfId-697201]Description
          
  
        

 
         
         		[bookmark: pgfId-697207]Edit

  
         		[bookmark: pgfId-697209]The activity/ticket was created, but the activity is not currently being edited. The activity/ticket can be opened or discarded while it is in the Edit state.

  
        

 
         
         		[bookmark: pgfId-697219]Edit Open[bookmark: marker-697215][bookmark: marker-697217]

  
         		[bookmark: pgfId-697221]The activity/ticket is open for editing. Changes, such as defining and assigning policies, can be made in the activity/ticket. The policies, policy assignments (devices being assigned policies), and objects being configured or modified in the activity/ticket are locked. That is, they cannot be configured or modified within the context of another activity/ticket. An activity can be closed, discarded, submitted, or approved while it is in the Edit Open state. A ticket can be closed, discarded, or submitted while it is in the Edit Open state.

 [bookmark: pgfId-697223]The configuration changes can be seen only in the context of the activity/ticket.

  
        

 
         
         		[bookmark: pgfId-697233]Submitted[bookmark: marker-697229][bookmark: marker-697231]

 [bookmark: pgfId-697235]Submitted Open

  
         		[bookmark: pgfId-697240]The activity was submitted for review and approval or the ticket was submitted. (In Workflow mode, this state is available only if you have activity approval required. For more information, see Workflow Page.) No further changes can be made within the activity/ticket. The policies, devices (through policy assignment), or objects affected by the policy changes remain locked to other activities/tickets.

 [bookmark: pgfId-697242]When an activity is submitted, an e-mail is sent to the approver. The approver can open the activity (in read-only mode, moving to the Submitted Open state) to review the changes within the activity, then approve or reject it. An approved activity moves to the approved state. A rejected activity returns to the Edit state.

  
        

 
         
         		[bookmark: pgfId-697252]Approved[bookmark: marker-697248][bookmark: marker-697250]
(Workflow mode only)

  
         		[bookmark: pgfId-697254]The activity was approved, and the corresponding configuration elements are now committed policy configurations. The devices affected by the policy changes are no longer locked to other activities. The activity can be deployed while it is in the Approved state.

  
        

 
         
         		[bookmark: pgfId-697260]Approve Failed
(Workflow mode only)

  
         		[bookmark: pgfId-697262]The activity is placed in the Approve Failed state if errors occur during approval (for example, due to a power failure). If this happens, try to approve the activity again or reboot the server.

  
        

 
         
         		[bookmark: pgfId-697268]Discarded

  
         		[bookmark: pgfId-697270]Changes made to the activity/ticket since it was created were discarded and further changes to the activity/ticket are not allowed. Devices associated with the activity/ticket are unlocked and can now be used in a new activity/ticket. The activity/ticket remains in the table showing a Discarded state until it is purged from the system.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-698674]Figure 4-1 shows the stages in the ticket workflow. Figure 4-2 shows the stages in the activity workflow without an approver. Figure 4-3 shows the stages in the activity workflow with an approver.

 
     [bookmark: pgfId-698678]Figure 4-1 [bookmark: 8995]Ticket Workflow

 
     [bookmark: pgfId-698681] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-698685]Figure 4-2 [bookmark: 8998]Activity Workflow without an Approver

 
     [bookmark: pgfId-698688] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-698692]Figure 4-3 [bookmark: 9001]Activity Workflow with an Approver

 
     [bookmark: pgfId-698695] 

 
      
      [image: ] 
     
 
    
 
   
 
    
     [bookmark: pgfId-698705][bookmark: 9006][bookmark: wfact_cncpt_WorkingwithActivities]Working with Activities/Tickets[bookmark: marker-698701][bookmark: marker-698703]

 
    [bookmark: pgfId-698707]The following topics provide information to help you use activities and configuration sessions:

 
     
     		 [bookmark: pgfId-698712]Accessing Activity Functions in Workflow Mode

 
     		 [bookmark: pgfId-698717]Accessing Ticket Functions in Non-Workflow Mode

 
     		 [bookmark: pgfId-698722]Creating an Activity/Ticket

 
     		 [bookmark: pgfId-698727]Opening an Activity/Ticket

 
     		 [bookmark: pgfId-698732]Closing an Activity/Ticket

 
     		 [bookmark: pgfId-698737]Viewing Change Reports

 
     		 [bookmark: pgfId-698742]Validating an Activity/Ticket

 
     		 [bookmark: pgfId-698747]Submitting an Activity for Approval (Workflow Mode with Activity Approver)

 
     		 [bookmark: pgfId-698752]Approving or Rejecting an Activity (Workflow Mode)

 
     		 [bookmark: pgfId-698757]Discarding an Activity/Ticket

 
     		 [bookmark: pgfId-698762]Viewing Activity/Ticket Status and History

 
    

 
     
      [bookmark: pgfId-698772][bookmark: 9049][bookmark: wfact_cncpt_AccessingActivityFunctions]Accessing Activity Functions in Workflow Mode[bookmark: marker-698768][bookmark: marker-698770]

 
     [bookmark: pgfId-698774]In Workflow mode, you can access activity management functions in the following ways:

 
      
      		 [bookmark: pgfId-698779]Select  Manage > Activities . The Activity Manager window contains a list of existing activities and their states. From this window, you can create new activities, and open, close, submit, approve, reject, or discard existing activities. For more information, see Activity/Ticket Manager Window.

 
      		 [bookmark: pgfId-698781]Click a button in the Activities portion of the main toolbar or select the equivalent command in the Activities menu. Whether a button or command is active depends on your user permissions, the state of the activity, and whether you are using workflow with or without an approver. The following table explains the buttons and commands and the conditions under which you can them.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-698783]Note If an activity is open, the activity name is displayed above the Global Search field in the upper right corner of the Configuration Manager interface. You can click the activity name to open the Activity Manager window.


     
      

     

     

 
     [bookmark: pgfId-698786] 

 
      
      


      


      


      


      


      


      


      


      


       
        
        [bookmark: pgfId-697285]Table 4-2 [bookmark: 9068]Activities Tool Bar Buttons and Commands When Workflow Mode Is Enabled 

 
        
       
         
         		
           
           [bookmark: pgfId-697293]Button
          
  
         		
           
           [bookmark: pgfId-697295]Activities Menu Command
          
  
         		
           
           [bookmark: pgfId-697297]Description
          
  
        

 
        
             
         		[bookmark: pgfId-697308]New Activity

  
         		[bookmark: pgfId-697310]Creates an activity.

  
        

 
        
             
         		[bookmark: pgfId-697321]Open Activity

  
         		[bookmark: pgfId-1058626]Opens an activity. You can open an activity when it is in the Edit or the Submitted state.

 [bookmark: pgfId-697327]To open a submitted activity, you must have user privileges to approve or reject changes made in that activity. For more information, see the Installation Guide for Cisco Security Manager.

  
        

 
        
             
         		[bookmark: pgfId-697338]Close Activity

  
         		[bookmark: pgfId-697340]Saves all changes made while the activity was open and closes it.

 [bookmark: pgfId-697342]You can close an activity when it is in the Edit Open or the Submit Open state.

  
        

 
        
             
         		[bookmark: pgfId-697353]View Changes

  
         		[bookmark: pgfId-697358]Evaluates all changes made in the activity and produces an Activity Change Report in PDF format in a separate window. For more information, see Viewing Change Reports

  
        

 
        
             
         		[bookmark: pgfId-697369]Validate Activity

  
         		[bookmark: pgfId-697371]Validates the integrity of changed policies within the current activity. By validating an activity, you can check for configuration errors that you might have introduced by your policy changes.

  
        

 
        
             
         		[bookmark: pgfId-697382]Submit Activity

  
         		[bookmark: pgfId-697384]In Workflow mode with an activity approver, submits the activity for approval. You can submit an activity when it is in the Edit or the Edit Open state.

  
        

 
        
             
         		[bookmark: pgfId-697395]Approve Activity

  
         		[bookmark: pgfId-697397]Approves the changes proposed in an activity.

 [bookmark: pgfId-697401]You can approve an activity when it is in the Submitted state when using an activity approver, or the Edit or Edit Open state when not using an approver. You must have user privileges to accept the changes proposed in an activity. For more information, see the Installation Guide for Cisco Security Manager.

  
        

 
        
             
         		[bookmark: pgfId-697412]Reject Activity

  
         		[bookmark: pgfId-697414]In Workflow mode with an activity approver, rejects the changes proposed in an activity.

 [bookmark: pgfId-697418]You can reject an activity when it is in the Submitted or Submitted Open state. You must have user privileges to deny changes proposed in an activity. For more information, see the Installation Guide for Cisco Security Manager.

  
        

 
        
             
         		[bookmark: pgfId-697429]Discard Activity

  
         		[bookmark: pgfId-697431]Discards the selected activity. The activity is discarded and later purged from the system after it exceeds the age for keeping activities as set under Tools > Security Manager Administration > Workflow. The activity state is shown as discarded until the activity is actually purged from the system.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-698798][bookmark: 9164][bookmark: wfact_cncpt_AccessingTicketFunctions]Accessing Ticket Functions in Non-Workflow Mode[bookmark: marker-698794][bookmark: marker-698796]

 
     [bookmark: pgfId-698800]In non-Workflow mode with Ticket Management enabled, you can access ticket management functions in the following ways:

 
      
      		 [bookmark: pgfId-698805]Select  Manage > Tickets . The Ticket Manager window contains a list of existing tickets and their states. From this window, you can create new tickets, and open, close, submit, or discard existing tickets. For more information, see Activity/Ticket Manager Window.

 
      		 [bookmark: pgfId-698807]Click a button in the Tickets portion of the main toolbar or select the equivalent command in the Tickets menu. Whether a button or command is active depends on your user permissions and the state of the ticket. The following table explains the buttons and commands and the conditions under which you can them.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-698809]Note If a ticket is open, the ticket ID is displayed above the Global Search field in the upper right corner of the Configuration Manager interface. You can click the ticket ID to open the Ticket Manager window.


     
      

     

     

 
     [bookmark: pgfId-698812] 

 
      
      


      


      


      


      


      


      


       
        
        [bookmark: pgfId-697446]Table 4-3 [bookmark: 9184]Tickets Tool Bar Buttons and Commands When Ticket Management Is Enabled in Non-Workflow Mode 

 
        
       
         
         		
           
           [bookmark: pgfId-697454]Button
          
  
         		
           
           [bookmark: pgfId-697456]Activities Menu Command
          
  
         		
           
           [bookmark: pgfId-697458]Description
          
  
        

 
        
             
         		[bookmark: pgfId-697469]New Ticket

  
         		[bookmark: pgfId-697471]Creates a ticket.

  
        

 
        
             
         		[bookmark: pgfId-697482]Open Ticket

  
         		[bookmark: pgfId-697484]Opens a ticket. You can open a ticket when it is in the Edit state.

  
        

 
        
             
         		[bookmark: pgfId-697495]Close Ticket

  
         		[bookmark: pgfId-697497]Saves all changes made while the ticket was open and closes it.

 [bookmark: pgfId-697499]You can close a ticket when it is in the Edit Open state.

  
        

 
        
             
         		[bookmark: pgfId-697510]View Changes

  
         		[bookmark: pgfId-697515]Evaluates all changes made in the ticket and produces a Ticket Change Report in PDF format in a separate window. For more information, see Viewing Change Reports

  
        

 
        
             
         		[bookmark: pgfId-697526]Validate Ticket

  
         		[bookmark: pgfId-697528]Validates the integrity of changed policies within the current ticket. By validating a ticket, you can check for configuration errors that you might have introduced by your policy changes.

  
        

 
        
             
         		[bookmark: pgfId-697539]Submit Ticket

  
         		[bookmark: pgfId-697541]Submits the ticket. Submitting the ticket saves the proposed changes to the database. Devices associated with the ticket are unlocked, meaning they can be included in policy definitions and changes in other tickets. You can submit a ticket when it is in the Edit or the Edit Open state.

  
        

 
        
             
         		[bookmark: pgfId-697552]Discard Ticket

  
         		[bookmark: pgfId-697557]Discards the selected ticket. The ticket is discarded and later purged from the system after it exceeds the age for keeping tickets as set under Tools > Security Manager Administration > Ticket Management. The ticket state is shown as discarded until the ticket is actually purged from the system. For more information, see Ticket Management Page.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-698830][bookmark: 9256][bookmark: wfpage_cncpt_ActivityManagerWindow]Activity/Ticket Manager Window[bookmark: marker-698822][bookmark: marker-698824][bookmark: marker-698826][bookmark: marker-698828]

 
     [bookmark: pgfId-698835]Activity management and ticket management are very similar processes. The primary difference between activities and tickets is that tickets do not use an approval process. For a comparison of the various modes of operation, see Comparing Workflow Modes.

 
      
      		 [bookmark: pgfId-698837] Activity Manager —Use the Activity Manager window to create and manage activities and to view activity status and history. The upper pane lists the activities that have been created. Select an activity to view its details and history in the lower pane.

 
      		 [bookmark: pgfId-698839] Ticket Manager —Use the Ticket Manager window to create and manage tickets and to view ticket status and history. The upper pane lists the tickets that have been created. Select a ticket to view its details and history in the lower pane.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-698844]Note The Activity Manager window is available only if you are operating in Workflow mode. The Ticket Manager window is available only if you are operating in non-Workflow mode with Ticket Management enabled. In non-Workflow mode without Ticket Management enabled, Security Manager automatically and transparently manages activities. For information on selecting a mode, see Changing Workflow Modes.


     
      

     

     

 
     [bookmark: pgfId-698846]Navigation Path

 
      
      		 [bookmark: pgfId-698848]In non-Workflow mode with Ticket Management enabled, click the Ticket Manager button on the Main toolbar, or select  Manage > Tickets .

 
      		 [bookmark: pgfId-698850]In Workflow mode, click the Activity Manager button on the Main toolbar, or select  Manage > Activities .

 
     

 
     [bookmark: pgfId-698852]Field Reference

 
     [bookmark: pgfId-698855] 

 
      
       
        
        [bookmark: pgfId-697570]Table 4-4 [bookmark: 9296]Activity/Ticket Manager Window 

 
        
       
         
         		
           
           [bookmark: pgfId-697576]Element
          
  
         		
           
           [bookmark: pgfId-697578]Description
          
  
        

 
         
         		[bookmark: pgfId-697584]*

  
         		[bookmark: pgfId-697586]Activities with unapproved changes (Edit, Edit Open, or Submitted state) or tickets with unsubmitted changes (Edit or Edit Open state) are flagged for easy identification.

  
        

 
         
         		[bookmark: pgfId-697592]Activity

 [bookmark: pgfId-697594]Ticket

  
         		[bookmark: pgfId-697596]The name of the activity or ID of the ticket. If Ticket Management is enabled in Workflow mode, both columns are displayed.

 [bookmark: pgfId-697601]If Ticket Management is enabled, you can click the ticket ID to view details of the ticket. If linkage to an external ticket management system has been configured, you can also navigate to that system from the ticket details (see Ticket Management Page).

  
        

 
         
         		[bookmark: pgfId-697607]Last Modified

  
         		[bookmark: pgfId-697609]The date and time of the most recent change to the activity/ticket.

  
        

 
         
         		[bookmark: pgfId-697615]State

  
         		[bookmark: pgfId-697620]The state of the activity/ticket. For a list of states, see Understanding Activity/Ticket States.

  
        

 
         
         		[bookmark: pgfId-697626]User

  
         		[bookmark: pgfId-697628]The username of the person who last changed the state of the activity/ticket.

  
        

 
         
         		[bookmark: pgfId-697634]Last Action

  
         		[bookmark: pgfId-697636]The most recent action performed on the activity/ticket.

  
        

 
         
         		[bookmark: pgfId-697642]Create button

  
         		[bookmark: pgfId-697647]Click this button to create a new activity or ticket so that you can create or change policies or assign policies to devices. For more information, see Creating an Activity/Ticket.

  
        

 
         
         		[bookmark: pgfId-697653]Open button

  
         		[bookmark: pgfId-697658]Click this button to open the selected activity/ticket so that changes, such as defining and assigning policies, are captured within the activity/ticket. You can open an activity when it is in the Edit or the Submitted state. Submitted activities are opened read-only. You can open a ticket when it is in the Edit state. For more information, see Opening an Activity/Ticket.

  
        

 
         
         		[bookmark: pgfId-697664]Close button

  
         		[bookmark: pgfId-697669]Click this button to close the selected activity/ticket if you or others want to continue configuring policies at a later time. For more information, see Closing an Activity/Ticket.

  
        

 
         
         		[bookmark: pgfId-697675]Validate button

  
         		[bookmark: pgfId-697680]Click this button to validate changes that you have made to the selected activity/ticket from the time you created it to the current time. Validating an activity/ticket checks policy integrity and deployability, and displays detailed error information if errors are detected. For more information, see Validating an Activity/Ticket.

  
        

 
         
         		[bookmark: pgfId-697686]Submit button

  
         		[bookmark: pgfId-697688]In Workflow mode with an activity approver, click this button to submit the selected activity. Submitting the activity sends notification that the activity is ready for review to the specified approver. You can submit an activity when it is in the Edit or the Edit Open state.

 [bookmark: pgfId-697690]In non-Workflow mode with Ticket Management enabled, click this button to submit the selected ticket. Submitting the ticket saves the proposed changes to the database. Devices associated with the ticket are unlocked, meaning they can be included in policy definitions and changes in other tickets. You can submit a ticket when it is in the Edit or the Edit Open state.

 [bookmark: pgfId-697695]You are prompted for a comment. For more information, see Submitting an Activity for Approval (Workflow Mode with Activity Approver).

  
        

 
         
         		[bookmark: pgfId-697701]Approve button

 [bookmark: pgfId-697703](Activity Manager only)

  
         		[bookmark: pgfId-697705]Click this button to approve the selected activity, which saves the proposed changes to the database. Devices associated with the activity are unlocked, meaning they can be included in policy definitions and changes in other activities. You must have appropriate user permissions to approve the activity.

 [bookmark: pgfId-697707]In Workflow mode without an approver, you can approve your own activities when they are in the Edit state. In workflow mode with an approver, you must submit your activity, and the approver can approve an activity only when it is in the Submitted state.

 [bookmark: pgfId-697712]You are prompted for an approval comment. For more information, see Approving or Rejecting an Activity (Workflow Mode).

  
        

 
         
         		[bookmark: pgfId-697718]Reject button

 [bookmark: pgfId-697720](Activity Manager only)

  
         		[bookmark: pgfId-697722]In Workflow mode with an activity approver, click this button to reject the changes proposed in the selected activity or activities. You must have appropriate user permissions to reject an activity. If the activity is rejected, the submitter can continue to make changes to the activity. Devices associated with the activity are not unlocked, meaning that they cannot be included in policy definitions or changes in another activity. You can reject an activity only when it is in the Submitted or the Submitted Open state.

 [bookmark: pgfId-697727]You are prompted for a rejection comment. For more information, see Approving or Rejecting an Activity (Workflow Mode).

  
        

 
         
         		[bookmark: pgfId-697733]Discard button

  
         		[bookmark: pgfId-697735]Click this button to discard the selected activity/ticket. Devices associated with the activity/ticket are unlocked, meaning they can be used by other activities/tickets. Multiple activities/tickets can be discarded at the same time.

 [bookmark: pgfId-697740]You are prompted for a comment. For more information, see Discarding an Activity/Ticket.

 [bookmark: pgfId-697745]Discarded activities are removed from the system according to the settings defined in the Security Manager settings for Workflow. The activity state is shown as discarded until the activity is purged from the system. For more information, see Workflow Page.

 [bookmark: pgfId-697750]Discarded tickets are removed from the system according to the settings defined in the Security Manager settings for Ticket Management. The ticket state is shown as discarded until the ticket is purged from the system. For more information, see Ticket Management Page.

  
        

 
         
         		[bookmark: pgfId-697756]View Changes

  
         		[bookmark: pgfId-697761]Click this button to generate a report in PDF format for the selected activity/ticket. If the activity/ticket is closed, this button is grayed out. For more information, see Viewing Change Reports.

  
        

 
         
         		[bookmark: pgfId-697767]Refresh button

  
         		[bookmark: pgfId-697769]Click this button to refresh the information presented in the window.

  
        

 
         
         		[bookmark: pgfId-697775]Details tab

  
         		[bookmark: pgfId-697777]Displays detailed information for the selected activity/ticket. Besides the information repeated from the table, the details include this information:

 
           
           		 [bookmark: pgfId-697779]Activity ID—The identification number assigned by Security Manager when you created the activity.

 
           		 [bookmark: pgfId-697781]Ticket ID—The identification number entered when the ticket was created. You can click the Edit Ticket button next to the ticket ID to edit the ticket ID.

 
           		 [bookmark: pgfId-697783]Created—The date and time the activity/ticket was created.

 
           		 [bookmark: pgfId-697785]Last Modified—The date and time changes were last made to the activity/ticket.

 
           		 [bookmark: pgfId-697787]Description—The description that was entered when the activity/ticket was created.

 
           		 [bookmark: pgfId-697789]Comments History—Shows a history of the comments that were entered for this activity/ticket. The user that entered the comment is shown as well as the date and time the comment was entered. You can add and edit comments using the buttons below the Comments History table.

 
          

  
        

 
         
         		[bookmark: pgfId-697795]History tab

  
         		[bookmark: pgfId-697797]Displays a log of the changes that have been made to the selected activity/ticket. The information includes the state changes, the user who made the change, the date and time of the change (based on the Security Manager server time), and any comments the user entered to document the change.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-698877][bookmark: 9435][bookmark: wfact_proc_CreatinganActivity]Creating an Activity/Ticket[bookmark: marker-698865][bookmark: marker-698867][bookmark: marker-698869][bookmark: marker-698871][bookmark: marker-698873][bookmark: marker-698875]

 
     [bookmark: pgfId-698879]In Workflow mode, before you create or change policies or assign policies to devices, you must create an activity. In non-Workflow mode, if you have Ticket Management enabled, before you create or change policies or assign policies to devices, you must create a ticket.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-698881]Tip In non-Workflow mode with Ticket Management disabled, activities are created automatically when needed.


     
      

     

     

 
     [bookmark: pgfId-698883]Related Topics

 
      
      		 [bookmark: pgfId-698888]Understanding Activities

 
      		 [bookmark: pgfId-698893]Opening an Activity/Ticket

 
     

 
     
 
     [bookmark: pgfId-698895]Step 1 Do one of the following:

 
     [bookmark: pgfId-698897]For activities:

 
      
      		 [bookmark: pgfId-698899]Click the  Create Activity button in the activity toolbar.

 
      		 [bookmark: pgfId-698901]Select  Activities > New Activity .

 
      		 [bookmark: pgfId-698903]Click  Create in the Activity Manager window.

 
     

 
     [bookmark: pgfId-698905]For tickets:

 
      
      		 [bookmark: pgfId-698907]Click the  Create Ticket button in the tickets toolbar.

 
      		 [bookmark: pgfId-698909]Select  Tickets > New Ticket .

 
      		 [bookmark: pgfId-698911]Click  Create in the Ticket Manager window.

 
     

 
     [bookmark: pgfId-698913]The Create Activity/Ticket dialog box appears.

 
     [bookmark: pgfId-698915]Step 2 In the Create Activity/Ticket dialog box, enter a name for the activity or keep the system-generated name. The default name contains the username, date, and time the activity/ticket was created. You can also enter a comment to describe the activity/ticket.

 
     [bookmark: pgfId-698920]Ticket Management supports linking between a Ticket ID and an external ticket management system. For more information, see Ticket Management Page.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-698922]Tip You can use a comma to separate multiple ticket IDs.


     
      

     

     

 
     [bookmark: pgfId-698924]Step 3 Click OK.

 
     [bookmark: pgfId-698929]The activity/ticket is listed in the Activity/Ticket Manager window. For more information, see Activity/Ticket Manager Window.

 
     [bookmark: pgfId-698931]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-698945][bookmark: 9506][bookmark: wfpage_cncpt_ActivityRequiredCreateActivityDialogBox]Responding to the Activity/Ticket Required Dialog Box[bookmark: marker-698941][bookmark: marker-698943]

 
     [bookmark: pgfId-698947]When in Workflow mode, you must create or open an activity before you create or modify policies. When in non-Workflow mode, if Ticket Management is enabled, you must create or open a ticket before you create or modify policies. If you attempt to perform an action that requires an activity or a ticket, and you have not created or opened one yet, you are prompted to do so with the Activity/Ticket Required dialog box.

 
     [bookmark: pgfId-698949]You can choose from the following options:

 
      
      		 [bookmark: pgfId-698951] Create a new activity/ticket —Create a completely new activity/ticket, specifying an activity name or ticket ID and optionally a description of the purpose of the activity/ticket. The default activity/ticket name contains the username, date, and time the activity/ticket was created.

 
      		 [bookmark: pgfId-698953] Open an existing activity/ticket —To open the activity/ticket you select from the Activity/Ticket list. This option is displayed only if there are activities/tickets available in the Edit state.

 
     

 
     [bookmark: pgfId-698955]Related Topics

 
      
      		 [bookmark: pgfId-698960]Creating an Activity/Ticket

 
      		 [bookmark: pgfId-698965]Understanding Activity/Ticket States

 
     

 
    
 
     
      [bookmark: pgfId-698985][bookmark: 9537][bookmark: wfact_cncpt_OpeninganActivity]Opening an Activity/Ticket[bookmark: marker-698973][bookmark: marker-698975][bookmark: marker-698977][bookmark: marker-698979][bookmark: marker-698981][bookmark: marker-698983]

 
     [bookmark: pgfId-698987]In Workflow mode, you can open an existing activity if no one else has it opened. You might open an existing activity in the Edit state to make further policy changes, or you might open an existing activity in the Submitted state to review proposed policy changes before approving or rejecting it (if you have the appropriate permissions and you are working in Workflow mode with an approver).

 
     [bookmark: pgfId-698989]You can make changes to activities in the Edit state, but you can only view activities in the Submitted state.

 
     [bookmark: pgfId-698991]In non-Workflow mode, if you have Ticket Management enabled, you can open an existing ticket to make further policy changes if no one else has it opened.

 
     [bookmark: pgfId-698993]To open an activity/ticket, do one of the following:

 
      
      		 [bookmark: pgfId-698995]For activities:

 
     

 
     [bookmark: pgfId-698997] – Click the Open button in the activity toolbar or select Activities > Open Activity. The Openable Activities dialog box lists all activities that can be opened, including the name of the activity, its state, and the username of the person who created the activity. Select the activity you want to open and click OK.

 
     [bookmark: pgfId-698999] – Select Manage > Activities. From the Activity Manager window, select the activity you want to open and click Open.

 
      
      		 [bookmark: pgfId-699001]For tickets:

 
     

 
     [bookmark: pgfId-699003] – Click the Open button in the tickets toolbar or select Tickets > Open Ticket. The Openable Tickets dialog box lists all tickets that can be opened, including the ticket ID, its state, and the username of the person who created the ticket. Select the ticket you want to open and click OK.

 
     [bookmark: pgfId-699005] – Select Manage > Tickets. From the Ticket Manager window, select the ticket you want to open and click Open.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-699007]Tip In non-Workflow mode with Ticket Management disabled, your previous configuration session is opened whenever needed until you submit it. A new activity is then created the next time you perform an action that requires an activity.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-699009]Note In Workflow mode and in non-Workflow mode with Ticket Management enabled, you are prompted to open or create an activity/ticket when you launch Security Manager.


     
      

     

     

 
     [bookmark: pgfId-699011]Related Topics

 
      
      		 [bookmark: pgfId-699016]Understanding Activities

 
     

 
    
 
     
      [bookmark: pgfId-699026][bookmark: 9595][bookmark: wfact_cncpt_ClosinganActivity]Closing an Activity/Ticket[bookmark: marker-699022][bookmark: marker-699024]

 
     [bookmark: pgfId-699028]You can close an activity without approving it (or submitting it for approval) or close a ticket without submitting it if you or others want to continue configuring policies at a later time.

 
     [bookmark: pgfId-699030]A person with administrator privileges can close an activity/ticket opened by another user.

 
     [bookmark: pgfId-699032]To close an open activity/ticket, do one of the following:

 
      
      		 [bookmark: pgfId-699034]For activities:

 
     

 
     [bookmark: pgfId-699036] – Click the Close button in the activity toolbar.

 
     [bookmark: pgfId-699038] – Select Activities > Close Activity.

 
     [bookmark: pgfId-699040] – Select Manage > Activities. From the Activity Manager window, click Close.

 
      
      		 [bookmark: pgfId-699042]For tickets:

 
     

 
     [bookmark: pgfId-699044] – Click the Close button in the tickets toolbar.

 
     [bookmark: pgfId-699046] – Select Tickets > Close Ticket.

 
     [bookmark: pgfId-699048] – Select Manage > Tickets. From the Ticket Manager window, click Close.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-699050]Tip In non-Workflow mode with Ticket Management disabled, your configuration session is closed whenever you log out. The same session is reopened the next time you log in.


     
      

     

     

 
     [bookmark: pgfId-699052]Related Topics

 
      
      		 [bookmark: pgfId-699057]Understanding Activities

 
     

 
    
 
     
      [bookmark: pgfId-699071][bookmark: 9641][bookmark: wfact_cncpt_UnderstandingActivityChangeReports]Viewing Change Reports[bookmark: marker-699063][bookmark: marker-699065][bookmark: marker-699067][bookmark: marker-699069]

 
     [bookmark: pgfId-699073]There are many places in the interface where you can open change reports. Typically, the button or command to generate the report is View Changes. These change reports provide detailed information about the policy and policy object changes, and the devices that were acted on, that have been made in an activity/ticket, whether you are operating in Workflow or non-Workflow mode.

 
     [bookmark: pgfId-699075]The change report is in Adobe Acrobat (PDF) format. You can use all of the Acrobat features, including the bookmarks tab, to view the report.

 
     [bookmark: pgfId-699077]If you discover a device or rediscover policies on a device, then subsequent policy changes in the same activity/ticket performed on that device are not listed in the activity change report. This is also true on a device that you clone from another device.

 
     [bookmark: pgfId-699079]Following are some of the ways you can view change reports:

 
      
      		 [bookmark: pgfId-699081]Non-Workflow mode with Ticket Management:

 
     

 
     [bookmark: pgfId-699083] – Select Tickets > View Changes, or click the View Changes button in the toolbar, to view the changes made during the currently open ticket.

 
     [bookmark: pgfId-699085] – Highlight a ticket in the Ticket Manager window and click View Changes to view the changes made in that ticket

 
      
      		 [bookmark: pgfId-699087]Non-Workflow mode without Ticket Management:

 
     

 
     [bookmark: pgfId-699089] – Select File > View Changes to view the changes made during the current configuration session.

 
     [bookmark: pgfId-699094] – Select Manage > Change Reports to view the changes made during previous sessions (which are closed when you submit or discard your changes). Select a configuration session from the Change Report window and click View Changes. (See Selecting a Change Report in Non-Workflow Mode with Ticket Management Disabled.)

 
      
      		 [bookmark: pgfId-699096]Workflow mode:

 
     

 
     [bookmark: pgfId-699098] – Select Activities > View Changes, or click the View Changes button in the toolbar, to view the changes made during the currently open activity.

 
     [bookmark: pgfId-699100] – Highlight an activity in the Activity Manager window and click View Changes to view the changes made in that activity.

 
      
      		 [bookmark: pgfId-699102]In all modes, you can view changes from various dialog boxes when creating deployment jobs.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-699104]Note You must disable any popup-blocker applications you have running to ensure the activity report will open.


     
      

     

     

 
     [bookmark: pgfId-699106]The following illustration shows a sample activity report.

 
     [bookmark: pgfId-699110]Figure 4-4 [bookmark: 9696]Activity Change Report

 
     [bookmark: pgfId-699113] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-699115]The change report includes these elements:

 
      
      		 [bookmark: pgfId-699117]Activity name/Ticket ID—The name of the activity (or the user and session start date and time if it is unnamed) or the Ticket ID.

 
      		 [bookmark: pgfId-699119]Created by—The username of the person who created the activity/ticket, with the date and time.

 
      		 [bookmark: pgfId-699121]Current state—The current state of the activity.

 
      		 [bookmark: pgfId-699123]Report created on—The date and time the report was created.

 
      		 [bookmark: pgfId-699125]Devices section—A summary of the devices that were acted on in the activity/ticket (that is, they were added, modified, or deleted). Changes to local policies are displayed here.

 
     

 
     [bookmark: pgfId-699127]Changes in this section and the other sections of the report are color-coded to help you identify changes:

 
     [bookmark: pgfId-699129] – Green—Indicates a newly inserted item.

 
     [bookmark: pgfId-699131] – Red—Indicates a deleted item or the old value of a changed item.

 
     [bookmark: pgfId-699133] – Blue—Indicates the new value of a changed item.

 
      
      		 [bookmark: pgfId-699135]Shared Policies section—Changes to all shared policies are displayed here.

 
      		 [bookmark: pgfId-699137]Policy Bundles—Changes to all policy bundles are displayed here.

 
      		 [bookmark: pgfId-699139]Policy Objects—Changes to all policy objects are displayed here.

 
      		 [bookmark: pgfId-699141]VPN—Changes to VPN topologies and policies are displayed here, including newly discovered VPNs and deleted VPN topologies.

 
     

 
    
 
     
      [bookmark: pgfId-699155][bookmark: 9727][bookmark: wfpage_cncpt_ChangeReportDialogBox]Selecting a Change Report in Non-Workflow Mode with Ticket Management Disabled[bookmark: marker-699149][bookmark: marker-699151][bookmark: marker-699153]

 
     [bookmark: pgfId-699157]In non-Workflow mode with Ticket Management disabled, you can view change reports for closed configuration sessions by selecting Manage > Change Reports and then selecting the session in the Change Report dialog box.

 
     [bookmark: pgfId-699162]In non-Workflow mode with Ticket Management disabled, a configuration session is considered complete when you either submit or discard your changes. The Change Report dialog box lists all closed sessions, showing the date and time the session was closed, the action that closed it (submitted or discarded), and the user name associated with the session. These sessions are equivalent to activities in Workflow mode. Select a session and click View Changes to view the report. For information on reading the report, see Viewing Change Reports.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-699164]Tip To view the report for the current configuration session, close this dialog box and select File > View Changes.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-699180][bookmark: 9748][bookmark: wfact_proc_ValidatinganActivity]Validating an Activity/Ticket[bookmark: marker-699172][bookmark: marker-699174][bookmark: marker-699176][bookmark: marker-699178]

 
     [bookmark: pgfId-699182]In Workflow mode, Security Manager validates activities when you submit them for approval, or you can validate an activity at any time while you are creating and changing policies in an activity. After an activity is submitted, the validation report remains static.

 
     [bookmark: pgfId-699184]In non-Workflow mode, Security Manager validates policies when you submit them to the database, when you try to deploy them, or when you validate them. The validation process reports on policy changes that were made up until the changes are submitted or deployed.

 
     [bookmark: pgfId-699186]The validation process checks the following areas. If there are errors, you can display a detailed summary of the validation results.

 
      
      		 [bookmark: pgfId-699188]Policy integrity—There are no unresolvable references (for example, missing objects, unresolved interface roles, overrides of mandatory settings, and so on).

 
      		 [bookmark: pgfId-699190]Policy deployability—The platform, operating system, and configured features are supported by the target devices so that policies can be correctly translated into CLI commands.

 
     

 
     [bookmark: pgfId-699192]If a policy contains options that require specific device types or operation system versions, you will see validation warnings for non-supported devices, but Security Manager will not generate the associated commands for unsupported devices. This allows you to create policies that apply to a wide range of devices without having to create policies that are too device-specific.

 
      
      		 [bookmark: pgfId-699194]FlexConfig integrity—There are no corrupted FlexConfig objects. If corrupted objects are found, a warning with a list of the corrupted FlexConfig objects results.

 
      		 [bookmark: pgfId-699196]FlexConfig syntax—If syntax errors are found, a warning with a list of affected FlexConfigs and their syntax errors results.

 
      		 [bookmark: pgfId-699198]FlexConfig object references—All object references are resolvable. If FlexConfig objects reference non-existent objects, a warning with a list of the missing objects results.

 
     

 
     [bookmark: pgfId-699200]Related Topics

 
      
      		 [bookmark: pgfId-699205]Submitting an Activity for Approval (Workflow Mode with Activity Approver)

 
      		 [bookmark: pgfId-699210]Deploying Configurations in Non-Workflow Mode

 
     

 
     
 
     [bookmark: pgfId-699212]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-699214]In Workflow mode:

 
     

 
     [bookmark: pgfId-699216] – Open an activity, and then click the Validate button on the activity toolbar or select Activities > Validate Activity.

 
     [bookmark: pgfId-699218] – Select Manage > Activities. From the Activity Manager window, select an activity, and then click Validate.

 
      
      		 [bookmark: pgfId-699220]In non-Workflow mode with Ticket Management enabled:

 
     

 
     [bookmark: pgfId-699222] – Open a ticket, and then click the Validate Saved Changes button on the tickets toolbar or select Tickets > Validate Ticket.

 
     [bookmark: pgfId-699224] – Select Manage > Tickets. From the Ticket Manager window, select a ticket, and then click Validate.

 
      
      		 [bookmark: pgfId-699226]In non-Workflow mode with Ticket Management disabled, select  File > Validate , or try to preview or deploy policies.

 
     

 
     [bookmark: pgfId-699228]Security Manager performs the validation and opens an informational message dialog box that summarizes the validation results. If there are no errors, validation passes. If there are errors or warnings, click Details to open the Validation dialog box, where you can view detailed information about the errors.

 
     [bookmark: pgfId-699230]Step 2 Evaluate the errors to determine how to fix them.

 
     [bookmark: pgfId-699232]The Validation dialog box organizes the errors and warnings in two ways, which are displayed on separate tabs:

 
      
      		 [bookmark: pgfId-699234]Errors tab—The Errors tab organizes validation problems based on the type of error. Each error indicates the number of devices that are affected and the severity of the error.

 
     

 
     [bookmark: pgfId-699236]Select an error in the upper pane, and a list of devices (with the type of device) that have the error appears in the lower left pane. The lower right pane describes the error, its cause, and what you might do to fix it.

 
      
      		 [bookmark: pgfId-699238]Devices tab—The Devices tab organizes validation problems based on the device. Each device indicates the number and types of errors and warnings for the device, and the device type. The device status indicates the worst problem in the device configuration (error or warning).

 
     

 
     [bookmark: pgfId-699240]Select a device in the upper pane, and a list of the errors for that device appears in the lower left pane. Select an error and the lower right pane describes the error, its cause, and what you might do to fix it.

 
     [bookmark: pgfId-699242]You must correct errors before submitting the activity. Security Manager does not allow an activity to be submitted with validation errors.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-699244]Note A validation warning (as opposed to an error) will not prevent activity approval or deployment.


     
      

     

     

 
     [bookmark: pgfId-699246]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-699260][bookmark: 9832][bookmark: wfact_proc_SubmittinganActivityforApproval]Submitting an Activity for Approval (Workflow Mode with Activity Approver)[bookmark: marker-699256][bookmark: marker-699258]

 
     [bookmark: pgfId-699265]In Workflow mode with an activity approver, you must submit activities for approval. When you submit the activity, the integrity and deployability of the activity is validated. For details about the validation process and report, see Validating an Activity/Ticket.

 
     [bookmark: pgfId-699267]The activity is also closed so that it can be opened by the user who has the permissions to approve it. When the activity is approved, its configurations are committed to the Security Manager database, and they can be deployed to the devices.

 
     [bookmark: pgfId-699269]When you submit an activity, Security Manager sends an e-mail to the relevant approvers to notify them that an activity requires approval.

 
     [bookmark: pgfId-699274]If you are working in Workflow mode without an activity approver, you do not need to submit activities (in fact, you cannot submit them). You can approve the activity yourself. For more information about changing activity approval settings, and configuring the e-mail addresses for notifications, see Workflow Page.

 
     [bookmark: pgfId-699276]Related Topics

 
      
      		 [bookmark: pgfId-699281]Understanding Activities

 
      		 [bookmark: pgfId-699286]Opening an Activity/Ticket

 
      		 [bookmark: pgfId-699291]Understanding Activity/Ticket States

 
      		 [bookmark: pgfId-699296]Configuring an SMTP Server and Default Addresses for E-Mail Notifications

 
     

 
     
 
     [bookmark: pgfId-699298]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-699300]Open an activity and click the  Submit Activity button on the activity toolbar or select  Activities > Submit Activity .

 
      		 [bookmark: pgfId-699302]Select  Manage > Activities . From the Activity Manager window, select an activity, then click  Submit .

 
     

 
     [bookmark: pgfId-699304]The Submit Activity dialog box opens.

 
     [bookmark: pgfId-699306]Step 2 In the Submit Activity dialog box, fill in the following fields:

 
      
      		 [bookmark: pgfId-699308] Approver —Enter the e-mail address of the person who should approve the activity if the default address is not the right one. This person receives notification of your submission.

 
     

 
     [bookmark: pgfId-699310]The default e-mail address is set in Tools > Security Manager Administration > Workflow.

 
      
      		 [bookmark: pgfId-699312] Comment —Enter comments that will help the approver evaluate the activity.

 
      		 [bookmark: pgfId-699314] Submitter —Enter the e-mail address of the person submitting the approval request if the default address is not the right one. The field initially contains the e-mail address associated with the username you used to log into Security Manager. Notifications of activity state changes are sent to this address.

 
     

 
     [bookmark: pgfId-699319]If desired, you can click the View Changes button to view a report in PDF format of the changes made in the activity. For more information, see Viewing Change Reports.

 
     [bookmark: pgfId-699321]Step 3 Click OK. The activity status changes to Submitted in the Activity Manager window and notifications are sent.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-699323]Note Security Manager warns you if the e-mail cannot be sent and you must contact the approver directly.


     
      

     

     

 
     [bookmark: pgfId-699325]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-699345][bookmark: 9899][bookmark: wfact_proc_ApprovingorRejectinganActivity]Approving or Rejecting an Activity (Workflow Mode)[bookmark: marker-699337][bookmark: marker-699339][bookmark: marker-699341][bookmark: marker-699343]

 
     [bookmark: pgfId-699347]Before the changes in an activity are committed to the database, you must approve the activity. If you have activity approval permissions, you can open an activity, review the policies and policy assignments, and then either approve or reject the activity.

 
     [bookmark: pgfId-699349]If you are operating in Workflow mode without an approver, you can approve your own activities. When working without an approver, you cannot reject an activity, but you can discard it if you do not want to save your changes. In non-Workflow mode, you use the Submit and Discard commands on the file menu to submit (and automatically approve) or discard the configuration session.

 
     [bookmark: pgfId-699351]In Workflow mode with an activity approver, the activity must be submitted before you can open it and approve it. In this mode, you can also reject the activity.

 
     [bookmark: pgfId-699353]If you approve an activity, policies and policy assignments are committed to the database and are ready to be deployed to devices or files. Devices associated with the activity are unlocked, meaning they can be included in policy definitions and changes in other activities.

 
     [bookmark: pgfId-699355]If you reject the activity, it is returned to the Edit state and the submitter can reopen the activity to make the necessary changes and resubmit it for approval. Devices associated with the activity are not unlocked, meaning that they cannot be included in policy definitions or changes in another activity.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-699357]Note After an activity is approved, changes cannot be undone. You must create a new activity and manually change policies and policy assignments to the desired state.


     
      

     

     

 
     [bookmark: pgfId-699359]Related Topics

 
      
      		 [bookmark: pgfId-699364]Understanding Activities

 
      		 [bookmark: pgfId-699369]Opening an Activity/Ticket

 
      		 [bookmark: pgfId-699374]Understanding Activity/Ticket States

 
     

 
     
 
     [bookmark: pgfId-699376]Step 1 Perform the appropriate step below:

 
      
      		 [bookmark: pgfId-699378]To approve an activity, do one of the following:

 
     

 
     [bookmark: pgfId-699380] – Open an activity and click the Approve Activity button on the activity toolbar or select Activities > Approve Activity from the menu.

 
     [bookmark: pgfId-699382] – Select Manage > Activities. In the Activity Manager window, select an activity and click Approve.

 
      
      		 [bookmark: pgfId-699384]To reject an activity or multiple activities, do one of the following:

 
     

 
     [bookmark: pgfId-699386] – Open an activity and click the Reject Activity button on the activity toolbar or select Activities > Reject Activity from the menu.

 
     [bookmark: pgfId-699388] – Select Manage > Activities. In the Activity Manager window, select an activity or multiple activities and click Reject.

 
     [bookmark: pgfId-699390]The Approve Activity, Reject Activity, or Reject Multiple Activities dialog box appears.

 
     [bookmark: pgfId-699392]Step 2 In the Comment field, enter a brief explanation of why you are approving or rejecting the activity or activities. If you are rejecting, you might want to include suggested revisions.

 
     [bookmark: pgfId-699397]Step 3 Click OK (for a single activity) or Reject (for multiple activities). The activity status changes to Approved or Edit (if rejected) in the Activity Manager window. For a description of the elements in the window, see Activity/Ticket Manager Window.

 
     [bookmark: pgfId-699399]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-699423][bookmark: 9970][bookmark: wfact_cncpt_DiscardinganActivity]Discarding an Activity/Ticket[bookmark: marker-699413][bookmark: marker-699415][bookmark: marker-699417][bookmark: marker-699419][bookmark: marker-699421]

 
     [bookmark: pgfId-699425]You can discard an activity/ticket (configuration session in non-Workflow mode) if it is no longer required. When you discard an activity/ticket, you delete all the policies and policy assignments that were defined within the activity. Those policies and policy assignments are not in the database; therefore, they cannot be deployed.

 
     [bookmark: pgfId-699430]Discarded activities are removed from the system according to the settings defined in the Security Manager settings for Workflow and devices associated with the activity are unlocked, meaning they can be used by other activities. For more information, see Workflow Page.

 
     [bookmark: pgfId-699435]Discarded tickets are removed from the system according to the settings defined in the Security Manager settings for Ticket Management and devices associated with the ticket are unlocked, meaning they can be used by other tickets. The ticket state is shown as discarded until the ticket is purged from the system. For more information, see Ticket Management Page.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-699437]Note When a ticket is discarded, Image Management jobs assigned to that ticket will not be discarded automatically. If required, you must search for pending Image Manager jobs with that ticket ID in Image Manager and delete those jobs.


     
      

     

     

 
     [bookmark: pgfId-699439]To discard an activity/ticket:

 
     [bookmark: pgfId-699441]Workflow Mode—Do one of the following:

 
      
      		 [bookmark: pgfId-699443]To discard a single activity, do one of the following:

 
     

 
     [bookmark: pgfId-699445] – Open an activity, then click the Discard button on the activity toolbar or select Activities > Discard Activity.

 
     [bookmark: pgfId-699447] – Select Manage > Activities. From the Activity Manager window, select an activity, then click Discard. Only an activity in the Edit or Edit Open state can be discarded.

 
     [bookmark: pgfId-699449]Using either method, you are prompted with the Discard Activity dialog box, which allows you to enter an optional comment to explain why you are discarding the activity. Enter a comment and click OK to discard it.

 
      
      		 [bookmark: pgfId-699451]To discard multiple activities, select  Manage > Activities . From the Activity Manager window, select the activities you wish to discard, then click  Discard . Only activities in the Edit or Edit Open state can be discarded.

 
     

 
     [bookmark: pgfId-699453]You are prompted with the Discard Multiple Activities dialog box, which allows you to enter an optional comment to explain why you are discarding the activities. If you selected activities belonging to other users, you can choose to discard those activities or not using the Discard selected activities of other users as well check box. Enter a comment, select or deselect the Discard selected activities of other users as well check box as desired, and then click OK to discard the selected activities.

 
     [bookmark: pgfId-699455]Non-Workflow Mode with Ticket Management Enabled—Do one of the following:

 
      
      		 [bookmark: pgfId-699457]To discard a single ticket, do one of the following:

 
     

 
     [bookmark: pgfId-699459] – Open a ticket, then click the Discard button on the tickets toolbar or select Tickets > Discard Ticket.

 
     [bookmark: pgfId-699461] – Select Manage > Tickets. From the Ticket Manager window, select a ticket, then click Discard. Only a ticket in the Edit or Edit Open state can be discarded.

 
     [bookmark: pgfId-699463]Using either method, you are prompted with the Discard Ticket dialog box, which allows you to enter an optional comment to explain why you are discarding the ticket. Enter a comment and click OK to discard it.

 
      
      		 [bookmark: pgfId-699465]To discard multiple activities, select  Manage > Tickets . From the Ticket Manager window, select the tickets you want to discard, then click  Discard . Only tickets in the Edit or Edit Open state can be discarded.

 
     

 
     [bookmark: pgfId-699467]You are prompted with the Discard Multiple Tickets dialog box, which allows you to enter an optional comment to explain why you are discarding the tickets. If you selected tickets belonging to other users, you can choose to discard those tickets or not using the Discard selected tickets of other users as well check box. Enter a comment, select or deselect the Discard selected tickets of other users as well check box as desired, and then click OK to discard the selected tickets.

 
     [bookmark: pgfId-699469]Non-Workflow Mode with Ticket Management Disabled—Select File > Discard to discard the changes in the current configuration session.

 
     [bookmark: pgfId-699471]Related Topics

 
      
      		 [bookmark: pgfId-699476]Understanding Activities

 
      		 [bookmark: pgfId-699481]Opening an Activity/Ticket

 
      		 [bookmark: pgfId-699486]Understanding Activity/Ticket States

 
     

 
    
 
     
      [bookmark: pgfId-699496][bookmark: 10056][bookmark: wfact_cncpt_ViewingActivityStatusandHistory]Viewing Activity/Ticket Status and History[bookmark: marker-699492][bookmark: marker-699494]

 
     [bookmark: pgfId-699498]In Workflow mode, you can view the status and history of changes for activities in the Activity Manager window. In non-Workflow mode with Ticket Management enabled, you can view the status and history of changes for tickets in the Ticket Manager window.

 
     [bookmark: pgfId-699500]To open the window for activities, click the Activity Manager button in the toolbar or select Manage > Activities.

 
     [bookmark: pgfId-699502]To open the window for tickets, click the Ticket Manager button in the toolbar or select Manage > Tickets.

 
     [bookmark: pgfId-699504]The upper pane lists all available activities/tickets, including the current state of the activity/ticket. Select an activity/ticket to see additional information in the tabs in the lower pane:

 
      
      		 [bookmark: pgfId-699506]Details tab—Shows the date and time the activity/ticket was created, and its description.

 
      		 [bookmark: pgfId-699508]History tab—Shows the transaction history for the activity/ticket. Each time the state is changed, a record of the change is kept, including the user who made the change and any comments about the change.

 
     

 
     [bookmark: pgfId-699510]Related Topics

 
      
      		 [bookmark: pgfId-699515]Understanding Activities

 
      		 [bookmark: pgfId-699520]Activity/Ticket Manager Window
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     [bookmark: pgfId-232400][bookmark: 86996][bookmark: pobjpage_cncpt_PolicyObjectManagerUserInterfaceReference]Configuring Policy Objects for Remote Access VPNs[bookmark: marker-232396][bookmark: marker-232398]
      
      
 
     
 

 
    [bookmark: pgfId-232402]There are several policy objects that you use primarily or exclusively with remote access VPNs. Some of these objects, the ASA Group Policies and User Group objects, are also used with Easy VPN site-to-site topologies. This reference explains the configuration of these policy objects.

 
    [bookmark: pgfId-232404]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-232409]ASA Group Policies Dialog Box

 
     		 [bookmark: pgfId-232414]Add or Edit Secure Desktop Configuration Dialog Box

 
     		 [bookmark: pgfId-232419]Add and Edit File Object Dialog Boxes

 
     		 [bookmark: pgfId-232424]Add or Edit Port Forwarding List Dialog Boxes

 
     		 [bookmark: pgfId-232429]Add or Edit Single Sign On Server Dialog Boxes

 
     		 [bookmark: pgfId-232434]Add or Edit Bookmarks Dialog Boxes

 
     		 [bookmark: pgfId-232439]Add and Edit SSL VPN Customization Dialog Boxes

 
     		 [bookmark: pgfId-232444]Add or Edit SSL VPN Gateway Dialog Box

 
     		 [bookmark: pgfId-232449]Add and Edit Smart Tunnel List Dialog Boxes

 
     		 [bookmark: pgfId-232454]Add and Edit Smart Tunnel Network Lists Dialog Boxes

 
     		 [bookmark: pgfId-232459]Add and Edit Smart Tunnel Auto Signon List Dialog Boxes

 
     		 [bookmark: pgfId-232464]Add or Edit User Group Dialog Box

 
     		 [bookmark: pgfId-232469]Add or Edit WINS Server List Dialog Box

 
    

 
   
 
    
     [bookmark: pgfId-232491][bookmark: 87008][bookmark: pobjpage_cncpt_ASAUserGroupDialogBox]ASA Group Policies Dialog Box[bookmark: marker-232477][bookmark: marker-232479][bookmark: marker-232481][bookmark: marker-232483][bookmark: marker-232485][bookmark: marker-232487][bookmark: marker-232489]

 
    [bookmark: pgfId-232493]Use the Add or Edit ASA Group Policies dialog box to create, copy, and edit an ASA user group policies object.

 
    [bookmark: pgfId-232495]ASA group policies are configured on ASA security appliances in Easy VPN topologies, remote access IPSec VPNs, and remote access SSL VPNs. When you configure an Easy VPN or remote access VPN, you must create group policies to which remote clients will belong. A group policy is a set of user-oriented attribute/value pairs for VPN connections that are stored either internally (locally) on the device or externally on a AAA server. The tunnel group uses a group policy that sets terms for user connections after the tunnel is established. Group policies let you apply whole sets of attributes to a user or a group of users rather than having to specify each attribute individually for each user.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-232497]Note You must select the technology for which you are creating the object. Depending on the selected technology, the appropriate settings are available for configuration. If you select the IKEv1 or IKEv2 options, the IKE Proposal and IPSec Proposal policies must also be configured to support the selected IKE version.


    
     

    

    

 
    [bookmark: pgfId-232499]Navigation Path

 
    [bookmark: pgfId-232504]Select ASA Group Policies in the Policy Object Manager. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-232506]Tip You can also create objects while configuring policies that use this type of object, including Connection Profile policies for remote access and Easy VPN, or the Group Policies policy for remote access VPNs.


    
     

    

    

 
    [bookmark: pgfId-232508]Related Topics

 
     
     		 [bookmark: pgfId-232513]Configuring Connection Profiles (ASA, PIX 7.0+)

 
     		 [bookmark: pgfId-232518]Creating Group Policies (ASA, PIX 7.0+)

 
    

 
    [bookmark: pgfId-232520]Field Reference

 
    [bookmark: pgfId-232523] 

 
     
      
       
       [bookmark: pgfId-226171]Table 34-1 [bookmark: 87057]Add or Edit ASA Group Policies Dialog Box, including Technology Settings 

 
       
      
        
        		
          
          [bookmark: pgfId-226177]Element
         
  
        		
          
          [bookmark: pgfId-226179]Description
         
  
       

 
        
        		[bookmark: pgfId-226185]Name

  
        		[bookmark: pgfId-226190]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
       

 
        
        		[bookmark: pgfId-226196]Description

  
        		[bookmark: pgfId-226198]An optional description of the object.

  
       

 
        
        		 [bookmark: pgfId-226204]Settings Pane

 [bookmark: pgfId-226206]The body of the dialog box is a pane with a table of contents on the left and settings related to the item selected in the table of contents on the right.

 [bookmark: pgfId-226208]You must first configure technology settings, then you can select items from the table of contents on the left and configure the options you require. Your selections on the Technology page control which options are available on these pages and in the table of contents.

 [bookmark: pgfId-226210]The top folders in the table of contents represent the VPN technologies or other settings that you can configure, and are explained next.

  
       

 
        
        		[bookmark: pgfId-226218]Technology settings

  
        		[bookmark: pgfId-226220]These settings control what you can define in the group policy:

 
          
          		 [bookmark: pgfId-226222] Group Policy Type —Whether you are storing the group policy on the ASA device itself ( Internal ) or on a AAA server ( External ). You cannot change this option when editing an object.

 
         

 [bookmark: pgfId-226224]If you select External, the only attributes you can configure are the name of the AAA server group object that identifies the AAA server and its password.

 
          
          		 [bookmark: pgfId-226226] Technology —The types of VPN for which this object defines group policies. Select all that apply:

 
         

 [bookmark: pgfId-226228] – Easy VPN/IPSec IKEv1—For Easy VPN topologies or remote access IPsec VPNs that allow IKEv1 negotiations.

 [bookmark: pgfId-226230] – Easy VPN/IPSec IKEv2—For remote access IPsec VPNs that allow IKEv2 negotiations. IKEv2 is not supported in Easy VPN topologies.

 [bookmark: pgfId-226232] – SSL Clientless—For remote access SSL VPNs of all types, not just clientless.

 [bookmark: pgfId-226234]Note To enable web-based VPN (webvpn) option in group-policy attribute, you must enable either “ssl-client” or “ssl-clientless” tunneling protocol. In other words, upon device discovery in Security Manager, if the group-policy attribute “vpn-tunnel-protocol” does not have either “ssl-client” or “ssl-clientless” in the configuration, during the next deployment of the device, Security Manager would remove the “webvpn” option under group-policy attributes.

 
          
          		 [bookmark: pgfId-226236] External Server Group —If you are storing the group policy attributes on an external AAA server, specify the AAA server group that will be used for authentication. Click  Select to select the object from a list or to create a new object.

 
         

 [bookmark: pgfId-226238]After you select an external server group, the Password and Confirm fields become active. Enter the alphanumeric password to use for authenticating with the server in both fields. The password can be a maximum of 128 characters; spaces are not allowed.

  
       

 
        
        		[bookmark: pgfId-226244]DNS/WINS

  
        		[bookmark: pgfId-226249]The DNS and WINS servers and the domain name that should be pushed to clients associated with the group. See ASA Group Policies DNS/WINS Settings.

  
       

 
        
        		[bookmark: pgfId-226255]Split Tunneling

  
        		[bookmark: pgfId-226260]Settings to allow a remote client to conditionally direct encrypted packets through a secure tunnel to the central site and simultaneously allow clear text tunnels to the Internet through a network interface. See ASA Group Policies Split Tunneling Settings.

  
       

 
        
        		[bookmark: pgfId-226266]Easy VPN/IPSec VPN

  
        		[bookmark: pgfId-226268]Settings for Easy VPN and remote access IPSec VPNs:

 
          
          		 [bookmark: pgfId-226273]Client Configuration—The Cisco client parameters for the group. See ASA Group Policies Client Configuration Settings.

 
          		 [bookmark: pgfId-226278]Client Firewall Attributes—The firewall settings for VPN clients for the group. See ASA Group Policies Client Firewall Attributes.

 
          		 [bookmark: pgfId-226283]Hardware Client Attributes—The VPN 3002 Hardware Client settings for the group. See ASA Group Policies Hardware Client Attributes.

 
          		 [bookmark: pgfId-226288]IPSec—The tunneling protocols, filters, connection settings, and servers for the group. See ASA Group Policies IPSec Settings.

 
         

  
       

 
        
        		[bookmark: pgfId-226294]SSL VPN

  
        		[bookmark: pgfId-226296]Settings for SSL VPN:

 
          
          		 [bookmark: pgfId-226301]Clientless—Settings for the clientless mode of access to the corporate network in an SSL VPN. See ASA Group Policies SSL VPN Clientless Settings.

 
          		 [bookmark: pgfId-226306]Full Client—Settings for the full client mode of access to the corporate network in an SSL VPN. See ASA Group Policies SSL VPN Full Client Settings.

 
          		 [bookmark: pgfId-226311]Settings—The general settings that are required for clientless/port forwarding in an SSL VPN. See ASA Group Policies SSL VPN Settings.

 
         

  
       

 
        
        		[bookmark: pgfId-226317]Connection Settings

  
        		[bookmark: pgfId-226322]The connection settings for the group, such as the session and idle timeouts, including the banner text. See ASA Group Policies Connection Settings.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-232541][bookmark: 87168][bookmark: pobjpage_cncpt_ASAUserGroupDialogBoxClientConfigurationSettings]ASA Group Policies Client Configuration Settings [bookmark: marker-232531][bookmark: marker-232533][bookmark: marker-232535][bookmark: marker-232537][bookmark: marker-232539]

 
     [bookmark: pgfId-232543]Use the Client Configuration settings page to configure the Cisco client parameters for the ASA group policy for Easy VPN or remote access VPN.

 
     [bookmark: pgfId-232545]Navigation Path

 
     [bookmark: pgfId-232550]Select Easy VPN/IPSec VPN > Client Configuration from the table of contents in the ASA Group Policies Dialog Box.

 
     [bookmark: pgfId-232552]Field Reference

 
     [bookmark: pgfId-232555] 

 
      
       
        
        [bookmark: pgfId-226335]Table 34-2 [bookmark: 87197]ASA Group Policies Client Configuration Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-226341]Element
          
  
         		
           
           [bookmark: pgfId-226343]Description
          
  
        

 
         
         		[bookmark: pgfId-226349]Store Password on Client System

  
         		[bookmark: pgfId-226351]Whether to allow users to store a password on their local systems. Enable this feature only if you are certain that the local systems will be in secure sites.

  
        

 
         
         		[bookmark: pgfId-226357]Enable IPsec over UDP

 [bookmark: pgfId-226359]UDP Port

  
         		[bookmark: pgfId-226361]Whether to allow a Cisco VPN client or hardware client to connect using UDP to a security appliance that is running NAT.

 [bookmark: pgfId-226363]If you select this option, specify the UDP port number within the range of 4001-49151. In IPsec negotiations, the security appliance listens on the configured port and forwards UDP traffic for that port even if other filter rules drop UDP traffic.

 [bookmark: pgfId-226365]Note The Cisco VPN client must also be configured to use IPsec over UDP, which is configured by default on certain devices.

  
        

 
         
         		[bookmark: pgfId-226371]IPsec Backup Servers

 [bookmark: pgfId-226373]Servers List

  
         		[bookmark: pgfId-226375]Specify the backup server configuration:

 
           
           		 [bookmark: pgfId-226377] Keep Client Configuration —The security appliance sends no backup server information to the client. The client uses its own backup server list, if configured. This is the default.

 
           		 [bookmark: pgfId-226379] Clear Client Configuration —The client uses no backup servers. The security appliance pushes a null server list.

 
           		 [bookmark: pgfId-226381] Use Specified Backup Servers —Use the backup servers you specify in the servers list. Enter the IP addresses of the servers, or the name of a network/host object. Click  Select to select the object from a list or to create a new object.

 
          

 [bookmark: pgfId-226383]You can configure backup servers either on the client or on the primary security appliance. If you configure backup servers on the security appliance, it pushes the backup server policy to the clients in the group, replacing the backup server list on the client if one is configured.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-232573][bookmark: 87239][bookmark: pobjpage_cncpt_ASAUserGroupDialogBoxClientFirewallAttributes]ASA Group Policies Client Firewall Attributes[bookmark: marker-232563][bookmark: marker-232565][bookmark: marker-232567][bookmark: marker-232569][bookmark: marker-232571]

 
     [bookmark: pgfId-232575]Use the Client Firewall Attributes settings to configure the firewall settings for VPN clients for the ASA group policy for Easy VPN or remote access IPSec VPN. Only VPN clients running Microsoft Windows can use these firewall settings.

 
     [bookmark: pgfId-232577]Navigation Path

 
     [bookmark: pgfId-232582]Select Easy VPN/IPSec VPN > Client Firewall Attributes from the table of contents in the ASA Group Policies Dialog Box.

 
     [bookmark: pgfId-232584]Field Reference

 
     [bookmark: pgfId-232587] 

 
      
       
        
        [bookmark: pgfId-226396]Table 34-3 [bookmark: 87268]ASA Group Policies Client Firewall Attributes 

 
        
       
         
         		
           
           [bookmark: pgfId-226402]Element
          
  
         		
           
           [bookmark: pgfId-226404]Description
          
  
        

 
         
         		[bookmark: pgfId-226410]Firewall Mode

  
         		[bookmark: pgfId-226412]The firewall requirements for client systems for the group:

 
           
           		 [bookmark: pgfId-226414] No Firewall —Do not use a firewall. You cannot configure any other options on the page.

 
           		 [bookmark: pgfId-226416] Firewall Required —All users in this group must use the designated firewall. The security appliance drops any session that attempts to connect without the designated firewall installed and running. In this case, the security appliance notifies the VPN client that its firewall configuration does not match.

 
          

 [bookmark: pgfId-226418]Note Make sure the group does not include any clients other than Windows VPN Clients. Any other clients in the group (including VPN 3002 Hardware Clients) are unable to connect if you require a client firewall.

 
           
           		 [bookmark: pgfId-226420] Firewall Optional —Users can use a firewall but it is not required. This option allows all users in the group to connect. Those who have a firewall can use it; users that connect without a firewall receive a warning message. This setting is useful if you are creating a group in which some users have firewalls and others do not. For example, you might have clients with systems that do not run Microsoft windows, or your clients have not all had the opportunity to install firewall software.

 
          

  
        

 
         
         		[bookmark: pgfId-226426]Firewall Type

  
         		[bookmark: pgfId-226428]The type of firewall that you are making required or optional. The list shows all of the supported firewall software, which includes software from Cisco, Network ICE, Sygate, and Zone Labs.

 
           
           		 [bookmark: pgfId-226430]If you select Custom Firewall, you must fill in the fields in the Custom Firewall group. You also need to configure the policy source; select options only if they are supported by the vendor.

 
           		 [bookmark: pgfId-226432]Some firewall types require you to specify the source of the policy implemented by the firewall.

 
          

  
        

 
         
         		[bookmark: pgfId-226438]Policy Source

  
         		[bookmark: pgfId-226440]Some types of firewall allow you to configure where the client firewall should obtain its policies:

 
           
           		 [bookmark: pgfId-226442]Get Policy From Remote Firewall—The policy is configured in the client firewall application. This is how most client firewalls work.

 
           		 [bookmark: pgfId-226444]Use Specified Policy—The policy you specify should be pushed to the client firewall application, which should use your policy.

 
          

 [bookmark: pgfId-226446]You must enter the name of an extended access control list policy object, or click Select to select one from a list or to create a new one, in both in the Inbound Traffic Policy and Outbound Traffic Policy fields.

  
        

 
         
         		[bookmark: pgfId-226452]Custom Firewall

  
         		[bookmark: pgfId-226454]The attributes that define the required or optional firewall if you select custom firewall as the firewall type:

 
           
           		 [bookmark: pgfId-226456]Vendor ID—The number that identifies the vendor of the custom firewall. Values are 1-255.

 
           		 [bookmark: pgfId-226458]Product ID—The number that identifies the product or model of the custom firewall. Values are 1-32 or 255. Multiple ranges are allowed, for example, 4-12, 24-32. Use 255 for all supported products.

 
           		 [bookmark: pgfId-226460]Description—An optional description of the custom firewall, for example, the name of the vendor and product.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-232605][bookmark: 87331][bookmark: pobjpage_cncpt_ASAUserGroupDialogBoxHardwareClientAttributes]ASA Group Policies Hardware Client Attributes[bookmark: marker-232595][bookmark: marker-232597][bookmark: marker-232599][bookmark: marker-232601][bookmark: marker-232603]

 
     [bookmark: pgfId-232607]Use the Hardware Client Attributes settings to configure the VPN 3002 Hardware Client settings for the ASA group policy in an Easy VPN or remote access IPSec VPN.

 
     [bookmark: pgfId-232609]Navigation Path

 
     [bookmark: pgfId-232614]Select Easy VPN/IPSec VPN > Hardware Client Attributes from the table of contents in the ASA Group Policies Dialog Box.

 
     [bookmark: pgfId-232616]Field Reference

 
     [bookmark: pgfId-232619] 

 
      
       
        
        [bookmark: pgfId-226473]Table 34-4 [bookmark: 87360]ASA Group Policies Hardware Client Attributes 

 
        
       
         
         		
           
           [bookmark: pgfId-226479]Element
          
  
         		
           
           [bookmark: pgfId-226481]Description
          
  
        

 
         
         		[bookmark: pgfId-226487]Require Interactive Client Authentication

  
         		[bookmark: pgfId-226489]Whether to enable secure unit authentication, which provides additional security by requiring VPN hardware clients to authenticate with a username and password each time that the client initiates a tunnel. The hardware client does not have a saved username and password.

 [bookmark: pgfId-226491]Note Secure unit authentication requires that you have an authentication server group configured for the tunnel group the hardware clients use. If you require secure unit authentication on the primary security appliance, be sure to configure it on any backup servers as well.

  
        

 
         
         		[bookmark: pgfId-226497]Require Individual User Authentication

  
         		[bookmark: pgfId-226499]Whether to require that individual users behind a hardware client authenticate to gain access to the network across the tunnel. Individual users authenticate according to the order of authentication servers that you configure.

 [bookmark: pgfId-226501]If you do not select this option, the security appliance allows inheritance of a value for user authentication from another group policy.

  
        

 
         
         		[bookmark: pgfId-226507]Enable Cisco IP Phone Bypass

  
         		[bookmark: pgfId-226509]Whether to allow IP phones behind hardware clients to connect without undergoing a user authentication processes. Secure unit authentication remains in effect for other users.

  
        

 
         
         		[bookmark: pgfId-226515]Enable LEAP Bypass

  
         		[bookmark: pgfId-226517]Whether to enable Lightweight Extensible Authentication Protocol (LEAP) packets from wireless devices behind a VPN hardware client to travel across a VPN tunnel prior to user authentication. This action lets workstations using Cisco wireless access point devices establish LEAP authentication and then authenticate again per user authentication.

 [bookmark: pgfId-226519]Note LEAP is an 802.1X wireless authentication method that implements mutual authentication between a wireless client on one side of a connection and a RADIUS server on the other side. The credentials used for authentication, including a password, are always encrypted before they are transmitted over the wireless medium.

  
        

 
         
         		[bookmark: pgfId-226525]Allow Network Extension Mode

  
         		[bookmark: pgfId-226527]Whether to enable network extension mode for hardware clients.

 [bookmark: pgfId-226529]Network extension mode lets hardware clients present a single, routable network to the remote private network over the VPN tunnel. IPsec encapsulates all traffic from the private network behind the hardware client to networks behind the security appliance. PAT does not apply. Devices behind the security appliance have direct access to devices on the private network behind the hardware client over the tunnel, and only over the tunnel, and vice versa. The hardware client must initiate the tunnel, but after the tunnel is up, either side can initiate data exchange.

  
        

 
         
         		[bookmark: pgfId-226535]Idle Timeout Mode

  
         		[bookmark: pgfId-226537]How to handle periods of inactivity from individual clients:

 
           
           		 [bookmark: pgfId-226539]Specified Timeout—If there is no communication activity by a user behind a hardware client for the number of minutes you specify, the security appliance terminates the client’s access. Values are 1-35791394 minutes.

 
           		 [bookmark: pgfId-226541]Unlimited Timeout—User sessions are not terminated due to inactivity.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-232637][bookmark: 87410][bookmark: pobjpage_cncpt_ASAUserGroupDialogBoxIPsecSettings]ASA Group Policies IPSec Settings[bookmark: marker-232627][bookmark: marker-232629][bookmark: marker-232631][bookmark: marker-232633][bookmark: marker-232635]

 
     [bookmark: pgfId-232639]Use the IPsec settings to specify tunneling protocols, filters, connection settings, and servers for the ASA group policy for Easy VPN or remote access IPSec VPN. This creates security associations that govern authentication, encryption, encapsulation, and key management.

 
     [bookmark: pgfId-232641]Navigation Path

 
     [bookmark: pgfId-232646]Select Easy VPN/IPSec VPN > IPsec from the table of contents in the ASA Group Policies Dialog Box.

 
     [bookmark: pgfId-232648]Field Reference

 
     [bookmark: pgfId-232651] 

 
      
       
        
        [bookmark: pgfId-226554]Table 34-5 [bookmark: 87439]ASA Group Policies IPSec Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-226560]Element
          
  
         		
           
           [bookmark: pgfId-226562]Description
          
  
        

 
         
         		[bookmark: pgfId-226568]Enable Re-Authentication on IKE Re-Key

  
         		[bookmark: pgfId-226570]Whether the security appliance should prompt the user to enter a username and password during initial Phase 1 IKE negotiation and also prompt for user authentication whenever an IKE rekey occurs, providing additional security. Reauthentication fails if no user is at the other end of the connection.

  
        

 
         
         		[bookmark: pgfId-226576]Enable IPsec Compression

  
         		[bookmark: pgfId-226578]Whether to enable data compression, which speeds up transmission rates for remote dial-in users connecting with modems.

 
           
           [image: ] 
          
 
          
 
          
           [bookmark: pgfId-226580]Caution Data compression increases the memory requirement and CPU usage for each user session and consequently decreases the overall throughput of the security appliance. For this reason, it is recommended that you enable data compression only for remote users connecting with a modem. Design a group policy specific to modem users and enable compression only for them.
            
            
 
           

          
  
        

 
         
         		[bookmark: pgfId-226586]Enable Perfect Forward Secrecy (PFS)

  
         		[bookmark: pgfId-226588]Whether to enable the use of Perfect Forward Secrecy (PFS) to generate and use a unique session key for each encrypted exchange. In IPsec negotiations, PFS ensures that each new cryptographic key is unrelated to any previous key.

  
        

 
         
         		[bookmark: pgfId-226594]Tunnel Group Lock

  
         		[bookmark: pgfId-226596]Tunnel group lock restricts users by checking if the group configured in the VPN client is the same as the tunnel group to which the user is assigned. If it is not, the security appliance prevents the user from connecting.

 [bookmark: pgfId-226598]If you do not specify a tunnel name, the security appliance authenticates users without regard to the assigned group. Group locking is disabled by default.

  
        

 
         
         		[bookmark: pgfId-226604]Client Access Rules table

  
         		[bookmark: pgfId-226606]The access rules for clients. These rules control which types of clients are denied access, if any. You can have up to 25 rules, and combined they are limited to 255 characters.

 [bookmark: pgfId-226608]Tip If you define any rule, an implicit deny all rule is added. Thus, if a client matches no permit rule, the client is denied access. If you create rules, ensure that you have permit rules for all allowed clients. You can use * as a wildcard to match partial strings. [bookmark: pgfId-226610]The rule with the lowest integer has the highest priority. Therefore, the rule with the lowest integer that matches a client type or version is the rule that applies. If a lower priority rule contradicts, the security appliance ignores it.

 
           
           		 [bookmark: pgfId-226615]To add a rule, click the  Add Row button to open the Add or Edit Client Access Rules Dialog Box.

 
           		 [bookmark: pgfId-226617]To edit a rule, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-226619]To delete a rule, select it and click the  Delete button.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-232663][bookmark: 87489][bookmark: pobjpage_cncpt_ASAUserGroupDialogBoxClientAccessRulesDialogBox]Add or Edit Client Access Rules Dialog Box[bookmark: marker-232659][bookmark: marker-232661]

 
     [bookmark: pgfId-232665]Use the Client Access Rules dialog box to create or edit the priority, action, VPN client type and VPN client version for a client access rule.

 
     [bookmark: pgfId-232667]Navigation Path

 
     [bookmark: pgfId-232672]From ASA Group Policies IPSec Settings, click the Add Row button beneath the Client Access Rules table, or select a rule and click the Edit Row button.

 
     [bookmark: pgfId-232674]Field Reference

 
     [bookmark: pgfId-232677] 

 
      
       
        
        [bookmark: pgfId-226632]Table 34-6 [bookmark: 87506]Add or Edit Client Access Rules Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-226638]Element
          
  
         		
           
           [bookmark: pgfId-226640]Description
          
  
        

 
         
         		[bookmark: pgfId-226646]Priority

  
         		[bookmark: pgfId-226648]The relative priority of the rule.

 [bookmark: pgfId-226650]The rule with the lowest integer has the highest priority. Therefore, the rule with the lowest integer that matches a client type or version is the rule that applies. If a lower priority rule contradicts, the security appliance ignores it. Values are 1-65535.

  
        

 
         
         		[bookmark: pgfId-226656]Action

  
         		[bookmark: pgfId-226658]Whether this rule permits or denies traffic access to the client.

  
        

 
         
         		[bookmark: pgfId-226664]VPN Client Type

 [bookmark: pgfId-226666]VPN Client Version

  
         		[bookmark: pgfId-226668]The type or version of VPN client to which this rule applies. Spaces are allowed.

 [bookmark: pgfId-226670]You can use * as a wildcard to match zero or more characters. You can use n/a for clients that do not send their type or version. The strings you enter in these fields must match the strings displayed using the show vpn-sessiondb remote command on the ASA device.

 [bookmark: pgfId-226672]Following are some examples, where priority, permit/deny, type, and version are shown in order:

 
           
           		 [bookmark: pgfId-226674] 3 Deny * version 3.* is a priority 3 rule that denies all client types with software version 3.x.

 
           		 [bookmark: pgfId-226676] 5 Permit VPN3002 * is a priority 5 rule that allows VPN3002 clients of all software versions.

 
           		 [bookmark: pgfId-226678] 255 Permit * * is a priority 255 rule that allows all types and versions of clients. This is useful if you are only trying to deny specific types of clients without wanting to create permit rules for all the other types.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-232695][bookmark: 87548][bookmark: pobjpage_cncpt_ASAUserGroupDialogBoxSSLVPNClientlessSettings]ASA Group Policies SSL VPN Clientless Settings[bookmark: marker-232685][bookmark: marker-232687][bookmark: marker-232689][bookmark: marker-232691][bookmark: marker-232693]

 
     [bookmark: pgfId-232697]Use the Clientless settings to configure the clientless mode of access to the corporate network in a remote access SSL VPN for the ASA group policy object.

 
     [bookmark: pgfId-232699]When a user connects to the SSL VPN in clientless mode, the user logs into the SSL VPN portal page. From the portal page, the user can access all available HTTP sites, access web e-mail, and browse Common Internet File System (CIFS) file servers, depending on how you configure the portal.

 
     [bookmark: pgfId-232701]Navigation Path

 
     [bookmark: pgfId-232706]Select SSL VPN > Clientless from the table of contents in the ASA Group Policies Dialog Box.

 
     [bookmark: pgfId-232708]Field Reference

 
     [bookmark: pgfId-232711] 

 
      
       
        
        [bookmark: pgfId-226691]Table 34-7 [bookmark: 87578]ASA Group Policies SSL VPN Clientless Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-226697]Element
          
  
         		
           
           [bookmark: pgfId-226699]Description
          
  
        

 
         
         		[bookmark: pgfId-226705]Portal Page Websites

  
         		[bookmark: pgfId-226707]The name of the SSL VPN bookmarks policy object that includes the website URLs to display on the portal page. These websites help users access desired resources. Enter the name of the object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-226713]Allow Users to Enter Websites

  
         		[bookmark: pgfId-226715]Whether to allow the remote user to enter website URLs directly into the browser. If you do not select this option, the user can access only those URLs included on the portal.

  
        

 
         
         		[bookmark: pgfId-226721]Enable File Server Browsing

  
         		[bookmark: pgfId-226723]Whether to allow the remote user to browse for file shares on the CIFS file servers.

  
        

 
         
         		[bookmark: pgfId-226729]Enable File Server Entry

  
         		[bookmark: pgfId-226731]Whether to allow the remote user to locate file shares on the CIFS file servers by entering the names of the file shares.

  
        

 
         
         		[bookmark: pgfId-226737]Enable Hidden Shares

  
         		[bookmark: pgfId-226739]Whether to make hidden CIFS shares visible, and thus accessible, to users.

  
        

 
         
         		[bookmark: pgfId-226745]HTTP Proxy

  
         		[bookmark: pgfId-226747]The type of access you want to allow to the external HTTP proxy server to which the security appliance forwards HTTP connections. You can enable access, disable access, or select Auto Start, which starts the proxy automatically upon user login.

  
        

 
         
         		[bookmark: pgfId-226753]Filter ACL

  
         		[bookmark: pgfId-226755]The name of the web type access control list policy object to use to restrict user access to the SSL VPN. Enter the name of the object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-226761]Enable ActiveX Relay

  
         		[bookmark: pgfId-226763]Whether to enable ActiveX relay, which allows users to start ActiveX programs from the portal page. This allows users to start Microsoft Office applications from the web browser and upload and download Office documents.

  
        

 
         
         		[bookmark: pgfId-226769]UNIX Authentication Group ID

  
         		[bookmark: pgfId-226771]The UNIX authentication group ID.

  
        

 
         
         		[bookmark: pgfId-226777]UNIX Authentication User ID

  
         		[bookmark: pgfId-226779]The UNIX authentication user ID.

  
        

 
         
         		[bookmark: pgfId-226785]Smart Tunnel

  
         		[bookmark: pgfId-226787]The name of the smart tunnel list policy object assigned to this group. Click Select to select it from a list or to create a new object.

 [bookmark: pgfId-226792]A smart tunnel is a connection between a Winsock 2, TCP-based application and a private site. The connection uses a clientless (browser-based) SSL VPN session with the security appliance as the pathway, and the security appliance as a proxy server. Thus, smart tunnels do not require users to have administrator privileges. For more information, see Configuring SSL VPN Smart Tunnels for ASA Devices.

  
        

 
         
         		[bookmark: pgfId-226798]Auto Start Smart Tunnel

  
         		[bookmark: pgfId-226800]Whether to start smart tunnel access automatically upon user login. If you do not select this option, the user must start the tunnel manually through the Application Access tools on the portal page.

 [bookmark: pgfId-226802]Auto sign-on supports only applications that use HTTP and HTTPS using the Microsoft WININET library on a Microsoft Windows operating system. For example, Microsoft Internet Explorer uses the WININET dynamic linked library to communicate with web servers.

  
        

 
         
         		[bookmark: pgfId-226808]Smart Tunnel Network List

  
         		[bookmark: pgfId-226813]Choose from the following options to select the list of hosts or network for which you want to use the smart tunnel. To enable the selection, you must first create the smart tunnel network list entries. For more information, see Add and Edit Smart Tunnel Network Lists Dialog Boxes. Note that this feature is supported on devices that are running ASA software version 8.3(1) and higher.

 
           
           		 [bookmark: pgfId-226815]None—If you select this option, the group policy inherits the values from the default Group Policy. This option is enabled by default.

 
           		 [bookmark: pgfId-226817]Tunnel All—Select this option if you want to use the smart tunnel for all network traffic.

 
           		 [bookmark: pgfId-226822]Include—Select this option if you want to use the smart tunnel for specific networks. Then click  Select to open the Smart Tunnel Network List Selector dialog box. You can select from the available entries or add entries. To add smart tunnel network list entries, see Add and Edit Smart Tunnel Network Lists Dialog Boxes.

 
           		 [bookmark: pgfId-226827]Exclude—Select this option if you do not want to use the smart tunnel for specific networks. Then click  Select to open the Smart Tunnel Network List Selector dialog box. You can select from the available entries or add entries. To add smart tunnel network list entries, see Add and Edit Smart Tunnel Network Lists Dialog Boxes.

 
          

  
        

 
         
         		[bookmark: pgfId-226833]Smart Tunnel Auto Signon Server List

  
         		[bookmark: pgfId-226835]The name of the smart tunnel auto sign-on list policy object assigned to this group. Click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-226841]Domain Name
(Optional)

  
         		[bookmark: pgfId-226843]The Windows domain to add to the username during auto sign-on, if the universal naming convention (domain\username) is required for authentication. For example, enter CISCO to specify CISCO\qa_team when authenticating for the username qa_team. You must also check the Use Domain option when configuring associated entries in the auto sign-on server list.

  
        

 
         
         		[bookmark: pgfId-226849]Port Forwarding List

  
         		[bookmark: pgfId-226851]The name of the port forwarding list policy object assigned to this group. Port forwarding lists contain the set of applications that users of clientless SSL VPN sessions can access over forwarded TCP ports. Enter the name of the object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-226857]Auto Start Port Forwarding

  
         		[bookmark: pgfId-226859]Whether to start port forwarding automatically upon user login.

  
        

 
         
         		[bookmark: pgfId-226865]Port Forwarding Applet Name

  
         		[bookmark: pgfId-226867]The application name or short description to display on the Port Forwarding Java applet screen on the portal, up to 64 characters. This is the name of the applet users will download to act as a TCP proxy on the client machine for the services configured on the SSL VPN gateway.

  
        

 
         
         		[bookmark: pgfId-226873]VDI Servers List table

  
         		[bookmark: pgfId-226875]The Citrix XenApp or XenDesktop servers that comprise the Virtual Desktop Infrastructure.

 
           
           		 [bookmark: pgfId-226880]To add a VDI server, click the  Add Row button to open the Add or Edit VDI Server Dialog Box.

 
           		 [bookmark: pgfId-226882]To edit a rule, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-226884]To delete a rule, select it and click the  Delete button.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-232725][bookmark: 87717][bookmark: pobjpage_cncpt_ASAUserGroupDialogBoxVDIServerDialogBox]Add or Edit VDI Server Dialog Box[bookmark: marker-232719][bookmark: marker-232721][bookmark: marker-232723]

 
     [bookmark: pgfId-232727]Use the VDI Server dialog box to create or edit a Citrix XenApp or XenDesktop Server entry.

 
     [bookmark: pgfId-232729]In a Virtual Desktop Infrastructure (VDI) model, administrators publish enterprise applications or desktops pre-loaded with enterprise applications, and end users remotely access these applications. These virtualized resources appear just as any other resources, such as email, so that users do not need to go through a Citrix Access Gateway to access them. Users log onto the ASA using Citrix Receiver mobile client, and the ASA connects to a pre-defined Citrix XenApp or XenDesktop Server. The administrator must configure the Citrix server’s address and logon credentials under Group Policy so that when users connect to their Citrix Virtualized resource, they enter the ASA’s SSL VPN IP address and credentials instead of pointing to the Citrix Server’s address and credentials. When the ASA has verified the credentials, the receiver client starts to retrieve entitled applications through the ASA.

 
     [bookmark: pgfId-232731]Supported Mobile Devices

 
      
      		 [bookmark: pgfId-232733]iPad—Citrix Receiver version 4.x or later

 
      		 [bookmark: pgfId-232735]iPhone/iTouch—Citrix Receiver version 4.x or later

 
      		 [bookmark: pgfId-232737]Android 2.x/3.x/4.0/4.1 phone—Citrix Receiver version 2.x or later

 
      		 [bookmark: pgfId-232739]Android 4.0 phone—Citrix Receiver version 2.x or later

 
     

 
     [bookmark: pgfId-232741]Navigation Path

 
     [bookmark: pgfId-232746]From ASA Group Policies SSL VPN Clientless Settings, click the Add Row button beneath the VDI Servers List table, or select a rule and click the Edit Row button.

 
     [bookmark: pgfId-232748]Field Reference

 
     [bookmark: pgfId-232751] 

 
      
       
        
        [bookmark: pgfId-226897]Table 34-8 [bookmark: 87747]Add or Edit VDI Server Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-226903]Element
          
  
         		
           
           [bookmark: pgfId-226905]Description
          
  
        

 
         
         		[bookmark: pgfId-226911]Hostname/IP Address

  
         		[bookmark: pgfId-226913]Address of the XenApp or XenDesktop server. This value can be a clientless macro.

  
        

 
         
         		[bookmark: pgfId-226919]Port Number (Optional)

  
         		[bookmark: pgfId-226921]Port number for connecting to the Citrix server. This value can be a clientless macro.

  
        

 
         
         		[bookmark: pgfId-226927]Domain

  
         		[bookmark: pgfId-226929]Domain for logging into the virtualization infrastructure server. This value can be a clientless macro.

  
        

 
         
         		[bookmark: pgfId-226935]Secure HTTP

  
         		[bookmark: pgfId-226937]Check the checkbox if you want the server to connect using SSL.

  
        

 
         
         		[bookmark: pgfId-226943]Username

  
         		[bookmark: pgfId-226945]Username for logging into the virtualization infrastructure server. This value can be a clientless macro.

 [bookmark: pgfId-226947]The macros available for username are:

 
           
           		 [bookmark: pgfId-226949]CSCO_WEBVPN_USERNAME—SSL VPN user login ID.

 
           		 [bookmark: pgfId-226951]CSCO_WEBVPN_CONNECTION_PROFILE—SSL VPN user login group drop-down, a group alias within the connection profile.

 
           		 [bookmark: pgfId-226953]CSCO_WEBVPN_MACRO1—Set via the RADIUS/LDAP vendor-specific attribute. If you are mapping this from LDAP via an ldap-attribute-map, the Cisco attribute that uses this variable is WEBVPN-Macro-Substitution-Value1. Variable substitution via RADIUS is performed by VSA#223.

 
           		 [bookmark: pgfId-226955]CSCO_WEBVPN_MACRO2—Set via the RADIUS/LDAP vendor-specific attribute. If you are mapping this from LDAP via an ldap-attribute-map, the Cisco attribute that uses this variable is WEBVPN-Macro-Substitution-Value2. Variable substitution via RADIUS is performed by VSA#224.

 
           		 [bookmark: pgfId-226957]CSCO_WEBVPN_MACROLIST1 and CSCO_WEBVPN_MACROLIST2—Statically configured bookmarks which can use arbitrarily-sized lists provided by LDAP attribute maps.

 
          

 [bookmark: pgfId-226959]These macros take the following three parameters:

 [bookmark: pgfId-226961] – Delimiter—Delimiter is an administrator-supplied string which includes the characters used to separate the LDAP-mapped string into a list of values, using one delimiter per use of the macro.

 [bookmark: pgfId-226963] – Index—Index is an administrator-supplied integer which specifies the number of the element in the list to select. The value can range between 1 and 128.

 [bookmark: pgfId-226965] – URL Encoding—URL Encoding is the choice to apply the LDAP string before it is substituted into the ASA device’s request. You can select one of the following values:

 [bookmark: pgfId-226967] – None—No transformation occurs on the string value before sending to the backend server.

 [bookmark: pgfId-226969] – url-encode—Each parsed value is URL encoded, except for a list of reserved characters that make up the special characters in a URL.

 [bookmark: pgfId-226971] – url-encode-data—Each parsed value is transformed fully with URL encoding.

 [bookmark: pgfId-226973] – base64—Each parsed value is base 64 encoded.

 
           
           		 [bookmark: pgfId-226975]CSCO_WEBVPN_PRIMARY_USERNAME—Primary user login ID when double authentication is enabled and login ID has primary login username.

 
           		 [bookmark: pgfId-226977]CSCO_WEBVPN_SECONDARY_USERNAME—Secondary user login ID when double authentication is enabled.

 
          

  
        

 
         
         		[bookmark: pgfId-226983]Password

  
         		[bookmark: pgfId-226985]Password for logging into the virtualization infrastructure server. This value can be a clientless macro.

 [bookmark: pgfId-226987]The macros available for password are:

 
           
           		 [bookmark: pgfId-226989]CSCO_WEBVPN_PASSWORD—SSL VPN user login password.

 
           		 [bookmark: pgfId-226991]CSCO_WEBVPN_INTERNAL_PASSWORD—SSL VPN user internal resource password. This is a cached credential, and not authenticated by a AAA server. If a user enters this value, it is used as the password for auto sign-on, instead of the password value.

 
           		 [bookmark: pgfId-226993]CSCO_WEBVPN_MACRO1—Password for the MACRO1 username.

 
           		 [bookmark: pgfId-226995]CSCO_WEBVPN_MACRO2—Password for the MACRO2 username.

 
           		 [bookmark: pgfId-226997]CSCO_WEBVPN_MACROLIST1 and CSCO_WEBVPN_MACROLIST2—Statically configured bookmarks which can use arbitrarily-sized lists provided by LDAP attribute maps.

 
          

 [bookmark: pgfId-226999]These macros take the following three parameters:

 [bookmark: pgfId-227001] – Delimiter—Delimiter is an administrator-supplied string which includes the characters used to separate the LDAP-mapped string into a list of values, using one delimiter per use of the macro.

 [bookmark: pgfId-227003] – Index—Index is an administrator-supplied integer which specifies the number of the element in the list to select. The value can range between 1 and 128.

 [bookmark: pgfId-227005] – URL Encoding—URL Encoding is the choice to apply the LDAP string before it is substituted into the ASA device’s request. You can select one of the following values:

 [bookmark: pgfId-227007] – None—No transformation occurs on the string value before sending to the backend server.

 [bookmark: pgfId-227009] – url-encode—Each parsed value is URL encoded, except for a list of reserved characters that make up the special characters in a URL.

 [bookmark: pgfId-227011] – url-encode-data—Each parsed value is transformed fully with URL encoding.

 [bookmark: pgfId-227013] – base64—Each parsed value is base 64 encoded.

 
           
           		 [bookmark: pgfId-227015]CSCO_WEBVPN_PRIMARY_PASSWORD—Primary user login password for double authentication.

 
           		 [bookmark: pgfId-227017]CSCO_WEBVPN_SECONDARY_PASSWORD—Secondary user login ID for double authentication.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-232771][bookmark: 87855][bookmark: pobjpage_cncpt_ASAUserGroupDialogBoxSSLVPNFullTunnelSettings]ASA Group Policies SSL VPN Full Client Settings[bookmark: marker-232761][bookmark: marker-232763][bookmark: marker-232765][bookmark: marker-232767][bookmark: marker-232769]

 
     [bookmark: pgfId-232773]Use the Full Client settings to configure the full client mode of access to the corporate network in a remote access SSL VPN for the ASA group policy object.

 
     [bookmark: pgfId-232775]Full client mode enables access to the corporate network completely over an SSL VPN tunnel. In full client access mode, the tunnel connection is determined by the group policy configuration. The full client software, SSL VPN Client (SVC) or AnyConnect, is downloaded to the remote client, so that a tunnel connection is established when the remote user logs in to the SSL VPN gateway.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-232783]Tip To enable full client access, you must configure the Remote Access VPN > SSL VPN > Other Settings policy on the device to identify AnyConnect image packages to install on the device. The images must be on the device so that users can download them. For more information, see Understanding SSL VPN AnyConnect Client Settings and Add and Edit File Object Dialog Boxes.


     
      

     

     

 
     [bookmark: pgfId-232785]Navigation Path

 
     [bookmark: pgfId-232790]Select SSL VPN > Full Client from the table of contents in the ASA Group Policies Dialog Box.

 
     [bookmark: pgfId-232792]Field Reference

 
     [bookmark: pgfId-232795] 

 
      
       
        
        [bookmark: pgfId-227030]Table 34-9 [bookmark: 87890]ASA Group Policies SSL VPN Full Client Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-227036]Element
          
  
         		
           
           [bookmark: pgfId-227038]Description
          
  
        

 
         
         		[bookmark: pgfId-227044]Enable Full Client

  
         		[bookmark: pgfId-227046]Whether to enable full client mode.

  
        

 
         
         		[bookmark: pgfId-227052]Mode

  
         		[bookmark: pgfId-227054]The mode in which to operate the SSL VPN:

 
           
           		 [bookmark: pgfId-227056] Use Other Access Modes if AnyConnect Client Download Fails —If the full client fails to download to the remote user, allow the user to make clientless or thin client access to the VPN.

 
           		 [bookmark: pgfId-227058] Full Client Only —Prohibit clientless or thin client access. The user must have the full client installed and functional to connect to the VPN.

 
          

  
        

 
         
         		[bookmark: pgfId-227064]Keep AnyConnect Client on Client System

  
         		[bookmark: pgfId-227066]Whether to leave the AnyConnect client installed on the client system after the client disconnects. If you do not leave the client installed, it must be download each time the user connects to the gateway.

  
        

 
         
         		[bookmark: pgfId-227072]Enable Keepalive Messages

  
         		[bookmark: pgfId-227074]Whether to exchange keepalive messages between peers to demonstrate that they are available to send and receive data in the tunnel. Keepalive messages transmit at set intervals, and any disruption in that interval results in the creation of a new tunnel using a backup device.

 [bookmark: pgfId-227076]If you select this option, enter the time interval (in seconds) that the remote client waits between sending IKE keepalive packets in the Interval field.

  
        

 
         
         		[bookmark: pgfId-227082]SSL Compression

  
         		[bookmark: pgfId-227084]Whether to enable data compression, and if so, the method of data compression to use: None, Deflate, or LZS. Data compression speeds up transmission rates for remote dial-in users connecting with modems.

 
           
           [image: ] 
          
 
          
 
          
           [bookmark: pgfId-227086]Caution Data compression increases the memory requirement and CPU usage for each user session and consequently decreases the overall throughput of the security appliance. For this reason, it is recommended that you enable data compression only for remote users connecting with a modem. Design a group policy specific to modem users and enable compression only for them.
            
            
 
           

          
  
        

 
         
         		[bookmark: pgfId-227092]Client Dead Peer Detection Timeout (sec)

  
         		[bookmark: pgfId-227094]The time interval, in seconds, that the Dead Peer Detection (DPD) timer is reset each time a packet is received over the SSL VPN tunnel from the remote user.

 [bookmark: pgfId-227096]DPD is used to send keepalive messages between peer devices only when no incoming traffic is received and outbound traffic needs to be sent.

  
        

 
         
         		[bookmark: pgfId-227102]Gateway Dead Peer Detection Timeout (sec)

  
         		[bookmark: pgfId-227104]The time interval, in seconds, that the Dead Peer Detection (DPD) timer is reset each time a packet is received over the SSL VPN tunnel from the gateway.

  
        

 
         
         		[bookmark: pgfId-227110]Key Renegotiation Method

  
         		[bookmark: pgfId-227112]The method by which the tunnel key is refreshed for the remote user group client:

 
           
           		 [bookmark: pgfId-227114] Disabled —Disables the tunnel key refresh.

 
           		 [bookmark: pgfId-227116] Use Existing Tunnel —Renegotiates the SSL tunnel connection.

 
           		 [bookmark: pgfId-227118] Create New Tunnel —Initiates a new tunnel connection.

 
          

 [bookmark: pgfId-227120]Enter the time interval (in minutes) between the tunnel refresh cycles in the Interval field.

  
        

 
         
         		[bookmark: pgfId-227126]Enable Datagram Transport Layer Security

  
         		[bookmark: pgfId-227128]Whether to enable Datagram Transport Layer Security (DTLS) connections for the group.

 [bookmark: pgfId-227130]Enabling DTLS allows the AnyConnect client establishing an SSL VPN connection to use two simultaneous tunnels, an SSL tunnel and a DTLS tunnel. Using DTLS avoids latency and bandwidth problems associated with some SSL connections and improves the performance of real-time applications that are sensitive to packet delays.

  
        

 
         
         		[bookmark: pgfId-227136]Datagram Transport Layer Security Compression

  
         		[bookmark: pgfId-227138]Whether to compress Datagram Transport Layer Security (DTLS) connections for the group, and if so, the method of data compression to use: None, Default, or LZS.

  
        

 
         
         		[bookmark: pgfId-227144]Ignore Don’t Fragment (DF) bit

  
         		[bookmark: pgfId-227146]Whether to ignore the DF bit in packets that need fragmentation. This feature allows the force fragmentation of packets that have the DF bit set, allowing them to pass through the tunnel. An example use case is for servers in your network that do not respond correctly to TCP MSS negotiations.

  
        

 
         
         		[bookmark: pgfId-227152]AnyConnect Module

  
         		[bookmark: pgfId-227154]The modules that the AnyConnect client needs to enable optional features. Click Select to select the applicable modules from the Add AnyConnect Module dialog box.

 
           
           		 [bookmark: pgfId-227156] AnyConnect DART —Select this module to enable the AnyConnect Diagnostics and Reporting Tool (DART), which bundles specified log files and diagnostic information that can be used for analyzing and debugging the client connection.

 
           		 [bookmark: pgfId-227158] AnyConnect Network Access Manager —Select this module to enable the Network Access Manager, which enforces administratively defined end user and authentication policies and makes the pre-configured network profiles available to end users.

 
           		 [bookmark: pgfId-227160] AnyConnect SBL —Select this module to enable Start Before Logon (SBL), which forces the user to connect to the enterprise infrastructure over a VPN connection before logging on to Windows by starting AnyConnect before the Windows login dialog box appears. After authenticating to the ASA, the Windows login dialog appears, and the user logs in as usual. SBL is only available for Windows and lets you control the use of login scripts, password caching, mapping network drives to local drives, and more.

 
           		 [bookmark: pgfId-227162] AnyConnect Web Security Module —Select this module to enable the AnyConnect Web Security module, which is an endpoint component that routes HTTP traffic to a ScanSafe scanning proxy where the ScanSafe web scanning service evaluates it.

 
           		 [bookmark: pgfId-227164] AnyConnect Telemetry Module —Select this module to enable the AnyConnect telemetry module for AnyConnect Secure Mobility Client, which sends information about the origin of malicious content to the web filtering infrastructure of the Cisco IronPort Web Security Appliance (WSA). The web filtering infrastructure uses this data to strengthen its web security scanning algorithms, improve the accuracy of the URL categories and web reputation database, and ultimately provide better URL filtering rules.

 
           		 [bookmark: pgfId-227166] AnyConnect ISE Network Setup Assistant —Select this module to enable the AnyConnect ISE Network Setup Assistant module.

 
           		 [bookmark: pgfId-227168] AnyConnect ISE Posture —Select this module to enable the AnyConnect ISE Posture module.

 
           		 [bookmark: pgfId-227170] AnyConnect Posture Module —Select this module to enable the AnyConnect Posture Module, which provides the AnyConnect Secure Mobility Client the ability to identify the operating system, antivirus, antispyware, and firewall software installed on the host. The Host Scan application, which is among the components delivered by the posture module, is the application that gathers this information.

 
          

 [bookmark: pgfId-227172]Note If other options are listed, see the release notes for the Cisco AnyConnect VPN Client for an explanation of the feature.

  
        

 
         
         		[bookmark: pgfId-227178]AnyConnect MTU

  
         		[bookmark: pgfId-227180]The maximum transmission unit (MTU) size for SSL VPN connections established by the Cisco AnyConnect VPN Client.

  
        

 
         
         		[bookmark: pgfId-227186]AnyConnect Always-On VPN

  
         		[bookmark: pgfId-227188]Always-On VPN enables AnyConnnect to automatically establish a VPN session after you log onto the system. Note that until you log off from the system, the VPN session will remain open.

 [bookmark: pgfId-227190]Select one of these options:

 
           
           		 [bookmark: pgfId-227192]None—AnyConnect service profile remains unchanged. It inherits the value from the default group policy.

 
           		 [bookmark: pgfId-227194]AnyConnect Profile Setting—Always-On VPN option configured in the AnyConnect VPN profile is used by the AnyConnect client.

 
           		 [bookmark: pgfId-227196]Disable—disables the Always-On VPN option.

 
          

  
        

 
         
         		[bookmark: pgfId-227202]AnyConnect Profile Name

  
         		[bookmark: pgfId-227204]The name of the AnyConnect profile to use for the group. You can enter multiple profile names each separated by a comma. You must configure this name and relate it to a profile in the Remote Access VPN > SSL VPN > Other Settings policy.

  
        

 
         
         		[bookmark: pgfId-227210]Prompt User to Choose Client

 [bookmark: pgfId-227212]Time User Has to Choose

 [bookmark: pgfId-227214]Default Location

  
         		[bookmark: pgfId-227216]Whether to ask the user to download the client. Enter the number of seconds the user has to make a selection in the Time User Has to Choose field. The default is 120 seconds.

 [bookmark: pgfId-227218]If you do not select this option, the user is immediately taken to the default location. The user is also taken to the default location after the time to choose expires.

 
           
           		 [bookmark: pgfId-227220] Web Portal —The portal page is loaded in the web browser.

 
           		 [bookmark: pgfId-227222] AnyConnect Client —The AnyConnect client is downloaded.

 
          

  
        

 
         
         		[bookmark: pgfId-227228]Security Group Tag

  
         		[bookmark: pgfId-227230]ASA Version 9.3(1)+ supports security group tagging of VPN sessions. A Security Group Tag (SGT) can be assigned to a VPN session using an external AAA server, or by configuration of the local user database. This tag can then be propagated through the Cisco TrustSec system over Layer 2 Ethernet. Security group tags are useful on group policies and for local users when the AAA server cannot provide an SGT.

 [bookmark: pgfId-227232]When the Default check box is selected, no Security Group Tag is assigned.

 [bookmark: pgfId-227234]To specify a Security Group Tag, clear the Default check box and then enter the numerical value of the SGT tag that will be assigned to VPN users connecting with this group policy in the Security Group Tag field. Valid values are from 2 to 65519.

  
        

 
         
         		[bookmark: pgfId-227240]Periodic Certificate Verification

  
         		[bookmark: pgfId-227242]Whether to enable periodic validation and revocation checking of the client certificates in VPN sessions. If you select this option, enter the interval of time, in hours, between 1 to 168. This feature is supported only in devices running ASA software version 9.4(1) or higher.

 [bookmark: pgfId-227244]Periodic certificate verification is disabled by default.

  
        

 
         
         		[bookmark: pgfId-227250]AnyConnect Firewall-Client Public ACL

  
         		[bookmark: pgfId-227252]The name of the extended access control list policy object to use to restrict user access to the SSL VPN. Public rules are applied to all interfaces on the client. Enter the name of the object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-227258]AnyConnect Firewall-Client Private ACL

  
         		[bookmark: pgfId-227260]The name of the extended access control list policy object to use to restrict user access to the SSL VPN. Private rules are applied to the Virtual Adapter. Enter the name of the object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-227266]AnyConnect Custom Attributes table

  
         		[bookmark: pgfId-227271]The AnyConnect Custom Attribute table lists the custom attributes, names, and the corresponding values that are assigned to this group policy. AnyConnect custom attributes that are defined on the AnyConnect Custom Attribute tab of the SSL VPN Other Settings page are listed here (see Configuring AnyConnect Custom Attributes (ASA)). Beginning with version 4.7, Security Manager enables to add a Custom Attribute Data to an existing Custom Attribute Type.

 [bookmark: pgfId-227273]You can add or remove the custom attributes for a group policy, and configure values for each attribute.

 
           
           		 [bookmark: pgfId-227275]To add a custom attribute and its value click the  Add Row button beneath the table and fill in the Add AnyConnect Custom Attribute dialog box.

 
           		 [bookmark: pgfId-227277]To edit a custom attribute and its value, select it, click the  Edit Row button, and make your changes in the Edit AnyConnect Custom Attribute dialog box.

 
           		 [bookmark: pgfId-227279]To delete a custom attribute, select it and click the  Delete Row button. You are asked to confirm the deletion.

 
          

 [bookmark: pgfId-227284]For more details, see Add/Edit AnyConnect Custom Attribute Dialog Box.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-232813][bookmark: 88097][bookmark: pobjpage_cncpt_ASAUserGroupDialogBoxSSLVPNGeneralSettings]ASA Group Policies SSL VPN Settings[bookmark: marker-232803][bookmark: marker-232805][bookmark: marker-232807][bookmark: marker-232809][bookmark: marker-232811]

 
     [bookmark: pgfId-232815]Use the SSL VPN Settings to configure attributes that are required for clientless and port forwarding (thin client) access modes to work, including auto signon rules for user access to servers. Auto Signon configures the security appliance to automatically pass SSL VPN user login credentials (username and password) on to internal servers. You can configure multiple auto signon rules.

 
     [bookmark: pgfId-232817]Navigation Path

 
     [bookmark: pgfId-232822]Select SSL VPN > Settings from the table of contents in the ASA Group Policies Dialog Box.

 
     [bookmark: pgfId-232824]Field Reference

 
     [bookmark: pgfId-232827] 

 
      
       
        
        [bookmark: pgfId-227297]Table 34-10 [bookmark: 88126]ASA Group Policies SSL VPN Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-227303]Element
          
  
         		
           
           [bookmark: pgfId-227305]Description
          
  
        

 
         
         		[bookmark: pgfId-227311]Home Page

  
         		[bookmark: pgfId-227313]The URL of the SSL VPN home page. The page is displayed when users log into the VPN. If you do not enter a URL, no home page is displayed.

  
        

 
         
         		[bookmark: pgfId-227319]Authentication Failure Message

  
         		[bookmark: pgfId-227321]The message to deliver to a remote user who successfully logs into the VPN but has no VPN privileges, and so can do nothing. The default message is:

 [bookmark: pgfId-227323]“Login was successful, but because certain criteria have not been met or due to some specific group policy, you do not have permission to use any of the VPN features. Contact your IT administrator for more information.”

  
        

 
         
         		[bookmark: pgfId-227329]Minimum Keepalive Object Size (kilobytes)

  
         		[bookmark: pgfId-227331]The minimum size (in kilobytes) of an IKE keepalive packet that can be stored in the cache on the security appliance.

  
        

 
         
         		[bookmark: pgfId-227337]Single Sign On Server

  
         		[bookmark: pgfId-227339]The name of the single sign on (SSO) server policy object that identifies the server to use for this group, if any. An SSO server allows users to enter their username and password once and be able to access other server in the network without logging into each of them. If configure an SSO server, also configure the auto signon rules table.

 [bookmark: pgfId-227344]Enter the name of the object or click Select to select it from a list or to create a new object. For more information, see Add or Edit Single Sign On Server Dialog Boxes.

  
        

 
         
         		[bookmark: pgfId-227350]Enable HTTP Compression

  
         		[bookmark: pgfId-227352]Whether to allow an HTTP compressed object to be cached on the security appliance.

  
        

 
         
         		[bookmark: pgfId-227358]Auto Signon Rules table

  
         		[bookmark: pgfId-227360]If you configure a single sign on server, the auto signon rules table contains the rules that determine which internal servers are provided the user’s credentials. Thus, you can provide single sign on for some servers in your network but not others.

 [bookmark: pgfId-227362]Each rule is an allow rule, and indicates the IP address, subnet, or Universal Resource Identifier (URI) that identifies the server, and the type of authentication that will be sent to the server when the user tries to access it (either basic HTML, NTLM, FTP, or all of these). The rules are processed in order, top to bottom, and the first match is applied. Therefore, be sure to order the rules correctly using the up and down arrow buttons.

 [bookmark: pgfId-227364]If the user accesses a server that is not identified in one of these rules, the user must log into the server to gain access.

 
           
           		 [bookmark: pgfId-227369]To add a rule, click the  Add Row button to open the Add or Edit Auto Signon Rules Dialog Box.

 
           		 [bookmark: pgfId-227371]To edit a rule, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-227373]To delete a rule, select it and click the  Delete Row button.

 
          

  
        

 
         
         		[bookmark: pgfId-227379]Portal Page Customization

  
         		[bookmark: pgfId-227381]The name of the SSL VPN customization policy object that defines the appearance of the portal web page. The portal page allows the remote user access to all the resources available on the SSL VPN network. If you do not specify an object, the default page appearance is used.

 [bookmark: pgfId-227386]Enter the name of the object or click Select to select it from a list or to create a new object. For more information, see Configuring ASA Portal Appearance Using SSL VPN Customization Objects.

  
        

 
         
         		[bookmark: pgfId-227392]User Storage Location

  
         		[bookmark: pgfId-227394]The location where personalized user information is stored between clientless SSL VPN sessions. If you do not specify a location, information is not stored between sessions. Stored information is encrypted.

 [bookmark: pgfId-227396]Enter a file system designation in the following format:

 [bookmark: pgfId-227398]protocol://username:password@host:port/path

 [bookmark: pgfId-227400]Where protocol is the protocol of the server, username and password are a valid user account on the server, and host is the name of the server. Also indicate the port number (if you do not use the default for the protocol) and directory path of the location on the server to use. For example:

 [bookmark: pgfId-227402]cifs://newuser:12345678@anyfiler02a/new_share

  
        

 
         
         		[bookmark: pgfId-227408]Storage Key

 [bookmark: pgfId-227410]Confirm

  
         		[bookmark: pgfId-227412]The storage key used to protect data stored between sessions. Spaces are not supported.

  
        

 
         
         		[bookmark: pgfId-227418]Post Max Size

  
         		[bookmark: pgfId-227420]The maximum size allowed for a posted object. The range is 0 through 2147483647 (which is the default). Specify 0 to prevent posting.

  
        

 
         
         		[bookmark: pgfId-227426]Upload Max Size

  
         		[bookmark: pgfId-227428]The maximum size allowed for a uploaded object. The range is 0 through 2147483647 (which is the default). Specify 0 to prevent uploading.

  
        

 
         
         		[bookmark: pgfId-227434]Download Max Size

  
         		[bookmark: pgfId-227436]The maximum size allowed for a downloaded object. The range is 0 through 2147483647 (which is the default). Specify 0 to prevent downloads.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-232841][bookmark: 88229][bookmark: pobjpage_cncpt_ASAUserGroupDialogBoxAutoSignonRulesDialogBox]Add or Edit Auto Signon Rules Dialog Box[bookmark: marker-232835][bookmark: marker-232837][bookmark: marker-232839]

 
     [bookmark: pgfId-232843]Use the Add or Edit Auto Signon Rules dialog box to configure the Auto Signon rules that the security appliance uses to pass SSL VPN user login credentials on to an internal server.

 
     [bookmark: pgfId-232845]Navigation Path

 
     [bookmark: pgfId-232850]Open the ASA Group Policies SSL VPN Settings, then click Create, or select an item in the table and click Edit.

 
     [bookmark: pgfId-232852]Field Reference

 
     [bookmark: pgfId-232855] 

 
      
       
        
        [bookmark: pgfId-227449]Table 34-11 [bookmark: 88249]Add or Edit Auto Signon Rules Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-227455]Element
          
  
         		
           
           [bookmark: pgfId-227457]Description
          
  
        

 
         
         		[bookmark: pgfId-227463]Allow IP

  
         		[bookmark: pgfId-227465]Select this option to configure an IP address or subnet for the rule. Any server within this subnet is supplied the specified login credentials.

 
           
           		 [bookmark: pgfId-227467]To enter the IP address of a single server, enter the full IP address and use 255.255.255.255 as the subnet mask.

 
           		 [bookmark: pgfId-227469]To specify a subnet, enter the network address and subnet mask, for example, IP address 10.100.10.0 mask 255.255.255.0.

 
          

 [bookmark: pgfId-227471]If you want the appliance to send credentials to any internal server the user tries to access, create rules for all of your internal networks. You might be able to do this with a single rule.

  
        

 
         
         		[bookmark: pgfId-227477]Allow URI

  
         		[bookmark: pgfId-227479]Select this option to configure a Universal Resource Identifier (URI) for the rule. This identifies the internal server based on URI rather than IP address. For example, https://*.example.com/* creates a rule for all web pages on any server in the example.com domain. Use the asterisk as a wildcard to apply to zero or more characters.

  
        

 
         
         		[bookmark: pgfId-227485]Login Credentials

  
         		[bookmark: pgfId-227487]Beginning with Security Manager version 4.7, you can select the login username and password from the available variables or macros.

 [bookmark: pgfId-227489]Note These macros are supported on devices running ASA software release version 8.2(1) and higher.

 [bookmark: pgfId-227491]The macros available for username are:

 
           
           		 [bookmark: pgfId-227493]CSCO_WEBVPN_USERNAME—SSL VPN user login ID.

 
           		 [bookmark: pgfId-227495]CSCO_WEBVPN_CONNECTION_PROFILE—SSL VPN user login group drop-down, a group alias within the connection profile.

 
           		 [bookmark: pgfId-227497]CSCO_WEBVPN_MACRO1—Set via the RADIUS/LDAP vendor-specific attribute. If you are mapping this from LDAP via an ldap-attribute-map, the Cisco attribute that uses this variable is WEBVPN-Macro-Substitution-Value1. Variable substitution via RADIUS is performed by VSA#223.

 
           		 [bookmark: pgfId-227499]CSCO_WEBVPN_MACRO2—Set via the RADIUS/LDAP vendor-specific attribute. If you are mapping this from LDAP via an ldap-attribute-map, the Cisco attribute that uses this variable is WEBVPN-Macro-Substitution-Value2. Variable substitution via RADIUS is performed by VSA#224.

 
           		 [bookmark: pgfId-227501]CSCO_WEBVPN_MACROLIST1 and CSCO_WEBVPN_MACROLIST2—Statically configured bookmarks which can use arbitrarily-sized lists provided by LDAP attribute maps.

 
          

 [bookmark: pgfId-227503]These macros take the following three parameters:

 [bookmark: pgfId-227505] – Delimiter—Delimiter is an administrator-supplied string which includes the characters used to separate the LDAP-mapped string into a list of values, using one delimiter per use of the macro.

 [bookmark: pgfId-227507] – Index—Index is an administrator-supplied integer which specifies the number of the element in the list to select. The value can range between 1 and 128.

 [bookmark: pgfId-227509] – URL Encoding—URL Encoding is the choice to apply the LDAP string before it is substituted into the ASA device’s request. You can select one of the following values:

 [bookmark: pgfId-227511] – None—No transformation occurs on the string value before sending to the backend server.

 [bookmark: pgfId-227513] – url-encode—Each parsed value is URL encoded, except for a list of reserved characters that make up the special characters in a URL.

 [bookmark: pgfId-227515] – url-encode-data—Each parsed value is transformed fully with URL encoding.

 [bookmark: pgfId-227517] – base64—Each parsed value is base 64 encoded.

 
           
           		 [bookmark: pgfId-227519]CSCO_WEBVPN_PRIMARY_USERNAME—Primary user login ID when double authentication is enabled and login ID has primary login username.

 
           		 [bookmark: pgfId-227521]CSCO_WEBVPN_SECONDARY_USERNAME—Secondary user login ID when double authentication is enabled.

 
          

 [bookmark: pgfId-227523]The macros available for password are:

 
           
           		 [bookmark: pgfId-227525]CSCO_WEBVPN_PASSWORD—SSL VPN user login password.

 
           		 [bookmark: pgfId-227527]CSCO_WEBVPN_INTERNAL_PASSWORD—SSL VPN user internal resource password. This is a cached credential, and not authenticated by a AAA server. If a user enters this value, it is used as the password for auto sign-on, instead of the password value.

 
           		 [bookmark: pgfId-227529]CSCO_WEBVPN_PRIMARY_PASSWORD—Primary user login password for double authentication.

 
           		 [bookmark: pgfId-227531]CSCO_WEBVPN_SECONDARY_PASSWORD—Secondary user login ID for double authentication.

 
          

  
        

 
         
         		[bookmark: pgfId-227537]Authentication Type

  
         		[bookmark: pgfId-227539]The type of credentials that the security appliance will pass on to the servers covered by this rule: Basic HTML, NTLM (NT LAN Manager) authentication, FTP, or all of these methods.

 [bookmark: pgfId-227541]The default option is All. Use the default unless you want to limit logins to a certain type.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-232873][bookmark: 88333][bookmark: pobjpage_cncpt_ASAUserGroupDialogBoxBrowserProxy]ASA Group Policies Browser Proxy Settings[bookmark: marker-232863][bookmark: marker-232865][bookmark: marker-232867][bookmark: marker-232869][bookmark: marker-232871]

 
     [bookmark: pgfId-232875]Use the Browser Proxy settings to configure the attributes for the browser.

 
     [bookmark: pgfId-232877]Navigation Path

 
     [bookmark: pgfId-232882]Select Browser Proxy from the table of contents in the ASA Group Policies Dialog Box.

 
     [bookmark: pgfId-232884]Field Reference

 
     [bookmark: pgfId-232887] 

 
      
       
        
        [bookmark: pgfId-227554]Table 34-12 [bookmark: 88362]ASA Group Policies Browser Proxy Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-227560]Element
          
  
         		
           
           [bookmark: pgfId-227562]Description
          
  
        

 
         
         		[bookmark: pgfId-227568]Proxy Server Policy

  
         		[bookmark: pgfId-227570]Select one of the following:

 
           
           		 [bookmark: pgfId-227572]No proxy—If you select this option, proxy settings will not be used.

 
           		 [bookmark: pgfId-227574]Do not modify client proxy—If you select this option, ASA will not modify the proxy setting on the endpoint device.

 
           		 [bookmark: pgfId-227576]Use proxy—If you select this option, select one or more methods available in Select Proxy Method.

 
          

  
        

 
         
         		[bookmark: pgfId-227582]Select Proxy Method

  
         		[bookmark: pgfId-227584]Select one or more of the following:

 
           
           		 [bookmark: pgfId-227586]Auto Detect—Select this option to enable the use of automatic proxy server detection in the client device’s browser.

 
           		 [bookmark: pgfId-227588]Use Proxy Server Setting Configured Below—Select this option and then specify the proxy server settings.

 
           		 [bookmark: pgfId-227590]User Proxy Auto Configuration (PAC) configured below—Select this option to direct the browser to retrieve the HTTP proxy server setting from the proxy auto-configuration file URL.

 
          

  
        

 
         
         		[bookmark: pgfId-227596]Proxy Server Setting

  
         		[bookmark: pgfId-227598]Enter the following:

 
           
           		 [bookmark: pgfId-227600]Server Address—Specify the IP address or name and the port of the browser server that is applied for the client device in the format ’ServerAddress:PortNumber’. To configure multiple proxy servers, separate the server addresses using a space.

 
           		 [bookmark: pgfId-227602]Exception List—List the server names and IP addresses that you want to exclude from proxy server access. Enter the list of addresses that you do not want to have accessed through a proxy server. This list corresponds to the Exceptions list in the Proxy Settings dialog box in the browser. To configure multiple exception lists, separate the lists using a space, comma, or semicolon.

 
           		 [bookmark: pgfId-227604]Bypass Server for Local Addresses—Configures the browser proxy local-bypass settings for a client device. Click  Yes to enable local bypass or  No to disable local bypass. Select  None if you do not want to use this option. The default selected option is None.

 
          

  
        

 
         
         		[bookmark: pgfId-227610]Proxy Auto Configuration (PAC) URL

  
         		[bookmark: pgfId-227612]Specify the URL of the auto-configuration file. This file tells the browser where to look for proxy information.

  
        

 
         
         		[bookmark: pgfId-227618]Policy Lockdown

  
         		[bookmark: pgfId-227620]Select Enable to hide the Connections tab in the browser for the duration of an AnyConnect VPN session. Select Disable to leave the display of the Connections tab unchanged. Select None if you do not want to use this option. The default selected option is None.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-232905][bookmark: 88426][bookmark: pobjpage_cncpt_ASAUserGroupDialogBoxDNSWINSSettings]ASA Group Policies DNS/WINS Settings[bookmark: marker-232895][bookmark: marker-232897][bookmark: marker-232899][bookmark: marker-232901][bookmark: marker-232903]

 
     [bookmark: pgfId-232907]Use the DNS/WINS settings to define the DNS and WINS servers and the domain name that should be pushed to clients associated with the ASA group policy. These settings apply to Easy VPN and remote access IPSec and SSL VPN configurations.

 
     [bookmark: pgfId-232909]Navigation Path

 
     [bookmark: pgfId-232914]Select DNS/WINS from the table of contents in the ASA Group Policies Dialog Box.

 
     [bookmark: pgfId-232916]Field Reference

 
     [bookmark: pgfId-232919] 

 
      
       
        
        [bookmark: pgfId-227633]Table 34-13 [bookmark: 88455]ASA Group Policies DNS/WINS Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-227639]Element
          
  
         		
           
           [bookmark: pgfId-227641]Description
          
  
        

 
         
         		[bookmark: pgfId-227647]Primary DNS Server

  
         		[bookmark: pgfId-227649]The IP address of the primary DNS server for the group. Enter the IP address or the name of a network/host object, or click Select to select an object from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-227655]Secondary DNS Server

  
         		[bookmark: pgfId-227657]The IP address of the secondary DNS server for the group. Enter the IP address or the name of a network/host object, or click Select to select an object from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-227663]Primary WINS Server

  
         		[bookmark: pgfId-227665]The IP address of the primary WINS server for the group. Enter the IP address or the name of a network/host object, or click Select to select an object from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-227671]Secondary WINS Server

  
         		[bookmark: pgfId-227673]The IP address of the primary WINS server for the group. Enter the IP address or the name of a network/host object, or click Select to select an object from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-227679]DHCP Network Scope

  
         		[bookmark: pgfId-227681]The scope of the DHCP network for the group. Enter the IP network address or the name of a network/host object, or click Select to select an object from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-227687]Default Domain

  
         		[bookmark: pgfId-227689]The default domain name for the group. The default, blank, is none.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-232937][bookmark: 88501][bookmark: pobjpage_cncpt_ASAUserGroupDialogBoxSplitTunneling]ASA Group Policies Split Tunneling Settings [bookmark: marker-232927][bookmark: marker-232929][bookmark: marker-232931][bookmark: marker-232933][bookmark: marker-232935]

 
     [bookmark: pgfId-232939]Use the Split Tunneling settings to configure a secure tunnel to the central site and simultaneous clear text tunnels to the Internet. These settings apply to Easy VPN and remote access IPSec and SSL VPN configurations.

 
     [bookmark: pgfId-232941]Split tunneling lets a remote client conditionally direct packets over an IPsec or SSL VPN tunnel in encrypted form or to a network interface in clear text form. With split tunneling enabled, packets not bound for destinations on the other side of the tunnel do not have to be encrypted, sent across the tunnel, decrypted, and then routed to a final destination. The split tunneling policy is applied to specific networks.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-232943]Tip For optimum security, we recommend that you not enable split tunneling.


     
      

     

     

 
     [bookmark: pgfId-232945]Navigation Path

 
     [bookmark: pgfId-232950]Select Split Tunneling from the table of contents in the ASA Group Policies Dialog Box.

 
     [bookmark: pgfId-232952]Field Reference

 
     [bookmark: pgfId-232955] 

 
      
       
        
        [bookmark: pgfId-227702]Table 34-14 [bookmark: 88532]ASA Group Policies Split Tunneling Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-227708]Element
          
  
         		
           
           [bookmark: pgfId-227710]Description
          
  
        

 
         
         		[bookmark: pgfId-227716]DNS Names

  
         		[bookmark: pgfId-227718]A list of domain names to be resolved through the split tunnel. All other names are resolved using the public DNS server. If you do not enter a list, the list is inherited from the default group policy.

 [bookmark: pgfId-227720]Separate multiple entries with spaces or commas. The entire string can be a maximum of 255 characters.

  
        

 
         
         		[bookmark: pgfId-227726]Send all DNS traffic through the tunnel

  
         		[bookmark: pgfId-227728]Whether the AnyConnect client should resolve all DNS addresses through the VPN tunnel (SSL or IPsec/IKEv2). If DNS resolution through the tunnel fails, the address remains unresolved and the AnyConnect client does not try to resolve the address through public DNS servers.

 [bookmark: pgfId-227730]If you do not select this option, the client sends DNS queries over the tunnel according to the split tunnel policy specified by the Tunnel Option setting.

  
        

 
         
         		[bookmark: pgfId-227736]Tunnel Option

  
         		[bookmark: pgfId-227738]The policy you want to enable for split tunneling:

 
           
           		 [bookmark: pgfId-227740]Disabled—(Default) No traffic goes in the clear or to any other destination than the security appliance. Remote users reach networks through the corporate network and do not have access to local networks.

 
           		 [bookmark: pgfId-227742]Tunnel Specified Traffic—Tunnel all traffic from or to the networks permitted in the network ACL. Traffic to all other addresses travels in the clear and is routed by the remote user’s Internet service provider.

 
           		 [bookmark: pgfId-227744]Exclude Specified Traffic—Traffic goes in the clear from and to the networks permitted in the network ACL. This is useful for remote users who want to access devices on their local network, such as printers, while they are connected to the corporate network through a tunnel. This option applies only to the Cisco VPN Client.

 
          

  
        

 
         
         		[bookmark: pgfId-227750]Networks

  
         		[bookmark: pgfId-227752]The name of a standard access control list policy object that identifies the networks that require traffic to travel across the tunnel and those that do not require tunneling. How permit and deny are interpreted depends on your selection for Tunnel Option.

 [bookmark: pgfId-227754]Enter the name of the object, or click Select to select it from a list or to create a new object. If you do not specify an ACL, the network list is inherited from the default group policy.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-232973][bookmark: 88575][bookmark: pobjpage_cncpt_ASAUserGroupDialogBoxGeneralSettings]ASA Group Policies Connection Settings[bookmark: marker-232963][bookmark: marker-232965][bookmark: marker-232967][bookmark: marker-232969][bookmark: marker-232971]

 
     [bookmark: pgfId-232975]Use the Connection Settings to configure the connection characteristics for the ASA group policy, including access control and session timeouts. These settings are used for Easy VPN and remote access IPsec or SSL VPN sessions.

 
     [bookmark: pgfId-232977]Navigation Path

 
     [bookmark: pgfId-232982]Select Connection Settings from the table of contents in the ASA Group Policies Dialog Box.

 
     [bookmark: pgfId-232984]Field Reference

 
     [bookmark: pgfId-232987] 

 
      
       
        
        [bookmark: pgfId-227767]Table 34-15 [bookmark: 88604]ASA Group Policies Connection Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-227773]Element
          
  
         		
           
           [bookmark: pgfId-227775]Description
          
  
        

 
         
         		[bookmark: pgfId-227781]Filter ACL

  
         		[bookmark: pgfId-227783]The name of the extended access control list (ACL) policy object to use for filtering traffic on the VPN connection. The ACL determines which traffic is permitted or denied. Enter the name of the object or click Select to select it from a list or to create a new object.

 [bookmark: pgfId-227785]This ACL does not apply to clientless SSL VPN connections.

  
        

 
         
         		[bookmark: pgfId-227791]Banner Text

  
         		[bookmark: pgfId-227793]The banner, or welcome text, to display on remote clients when they connect to the VPN.

 
           
           		 [bookmark: pgfId-227795]Beginning with version 4.9, Security Manager supports up to 4000 characters for the banner text for ASA devices on version 9.5(1) or higher.

 
           		 [bookmark: pgfId-227797]For ASA version lower than 9.5(1), Security Manager allows you to enter up to 500 characters for the banner text.

 
          

  
        

 
         
         		[bookmark: pgfId-227803]Address Pools

  
         		[bookmark: pgfId-227805]Specifies the name of one or more IPv4 address pools to use for this group policy. Enter the names of the IPv4 address pool objects separated by a comma or click Select to select the objects from a list or to create a new objects.

  
        

 
         
         		[bookmark: pgfId-227811]Access hours

  
         		[bookmark: pgfId-227813]The name of a time range policy object that specifies the times that users are allowed to access the VPN. If you do not specify a time range, users can access the VPN at all times. Specify a time range if you want to limit access to the network to certain hours, such as the typical work days and work hours for your organization.

 [bookmark: pgfId-227818]Enter the name of the object or click Select to select it from a list or to create a new object. For more information, see Configuring Time Range Objects.

  
        

 
         
         		[bookmark: pgfId-227824]Max Simultaneous Logins

  
         		[bookmark: pgfId-227826]The number of simultaneous logins a single user is allowed. Values are 0-2147483647. The default is 3. Specify 0 to disable logins and prevent user access.

  
        

 
         
         		[bookmark: pgfId-227832]Max Connection Time

  
         		[bookmark: pgfId-227834]The maximum amount of time a user is allowed to be connected to the VPN. Select one of the following:

 
           
           		 [bookmark: pgfId-227836]Specified Connection time—Use the maximum time value that you enter. Values are 1-35791394 minutes. After the time is exceeded, the security appliance closes the connection.

 
           		 [bookmark: pgfId-227838]Unlimited Connection time—The security appliance does not close connections based on connection time.

 
          

  
        

 
         
         		[bookmark: pgfId-227844]Idle Timeout

  
         		[bookmark: pgfId-227846]The amount of time a user is allowed to be connected to the VPN while the connection is idle, that is, there is no communication activity. Select one of the following:

 
           
           		 [bookmark: pgfId-227848]Specified Timeout—Use the time out value you enter. Values are 1-4473924 minutes. When the idle time is exceeded, the security appliance closes the connection. The default is 30 minutes.

 
           		 [bookmark: pgfId-227850]Unlimited Timeout—The security appliance does not close idle connections.

 
          

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-232999][bookmark: 88672][bookmark: pobjpage_cncpt_SecureDesktopConfigurationDialogBox]Add or Edit Secure Desktop Configuration Dialog Box [bookmark: marker-232995][bookmark: marker-232997]

 
    [bookmark: pgfId-233001]Use the Add or Edit Cisco Secure Desktop Configuration dialog box to create, copy, and edit Cisco Secure Desktop Configuration objects for IOS routers. You can configure the settings required for Windows clients who are connecting from different location types, enable or restrict web browsing and file access for Windows CE clients, and configure the cache cleaner for Macintosh and Linux clients.

 
    [bookmark: pgfId-233003]Cisco Secure Desktop (CSD) secures network endpoints by providing a reliable means of eliminating all traces of sensitive data by providing a single, secure location for session activity and removal on the client system.

 
    [bookmark: pgfId-233007]This policy object uses the Secure Desktop Manager application to configure the settings. For an example of configuring settings, see Cisco Secure Desktop on IOS Configuration Example Using SDM at http://www.cisco.com/en/US/products/ps6496/products_configuration_example09186a008072aa7b.shtml. The first part of the configuration example explains setting up SDM, which you can ignore. Instead, look for the sections that describe setting up Windows locations midway through the example. The screen shots will help you identify when you are looking at CSD configuration.

 
    [bookmark: pgfId-233009]Navigation Path

 
    [bookmark: pgfId-233011]Select Manage > Policy Objects, then select Cisco Secure Desktop (Router) from the Object Type Selector. Right-click inside the work area and select New Object, or right-click a row and select Edit Object.

 
    [bookmark: pgfId-233013]Related Topics

 
     
     		 [bookmark: pgfId-233018]Creating Cisco Secure Desktop Configuration Objects

 
     		 [bookmark: pgfId-233023]Policy Object Manager

 
    

 
    [bookmark: pgfId-233025]Field Reference

 
    [bookmark: pgfId-233028] 

 
     
      
       
       [bookmark: pgfId-227863]Table 34-16 [bookmark: 88703]Add or Edit Secure Desktop Configuration Dialog Box 

 
       
      
        
        		
          
          [bookmark: pgfId-227869]Element
         
  
        		
          
          [bookmark: pgfId-227871]Description
         
  
       

 
        
        		[bookmark: pgfId-227877]Name

  
        		[bookmark: pgfId-227882]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
       

 
        
        		[bookmark: pgfId-227888]Description

  
        		[bookmark: pgfId-227890]An optional description of the object (up to 1024 characters).

  
       

 
        
        		 
          
          [bookmark: pgfId-227896]Windows Location Settings
         
  
       

 
        
        		[bookmark: pgfId-227904]Windows Locations

  
        		[bookmark: pgfId-227906]The names of the locations that you want to configure for Windows clients connecting from specific locations, such as Work, Home, or Insecure.

 [bookmark: pgfId-227908]When you create a location, an item for the location is added to the table of contents, where you can select the settings folders related to the location and configure its properties. The settings include a definition of how to determine if a client is connecting from that particular location.

 [bookmark: pgfId-227910]For each location you want to configure, enter its name in the Location to Add field and click Add to move it to the Locations list.

 [bookmark: pgfId-227915]You can reorder the locations using the Move Up/Move Down buttons. CSD checks locations in the order listed in this dialog box, and grants privileges to client PCs based on the first location definition they match. You can create a default location, such as Insecure, as the final location and configure the strictest security for it. For more information, see Creating Cisco Secure Desktop Configuration Objects.

  
       

 
        
        		[bookmark: pgfId-227921]Close all open browser windows after installation

  
        		[bookmark: pgfId-227923]Whether to close all the open browser windows after installing the Secure Desktop application.

  
       

 
        
        		[bookmark: pgfId-227929]VPN Feature Policy

  
        		[bookmark: pgfId-227931]Select the check boxes to enable these features if installation or location matching fails:

 
          
          		 [bookmark: pgfId-227933]Web Browsing

 
          		 [bookmark: pgfId-227935]File Access

 
          		 [bookmark: pgfId-227937]Port Forwarding

 
          		 [bookmark: pgfId-227939]Full Tunneling

 
         

  
       

 
        
        		 
          
          [bookmark: pgfId-227945]Windows CE
         
  
       

 
        
        		[bookmark: pgfId-227953]VPN Feature Policy

  
        		[bookmark: pgfId-227955]The Windows CE options enable you to configure a VPN feature policy to enable or restrict web browsing and remote server file access for remote clients running Microsoft Windows CE. You cannot configure locations for these clients.

  
       

 
        
        		 
          
          [bookmark: pgfId-227961]Mac and Linux Cache Cleaner
         
  
       

 
        
        		[bookmark: pgfId-227969]Launch Cleanup Upon Global Timeout

  
        		[bookmark: pgfId-227971]Whether to set a global timeout after which CSD launches the cache cleaner. Select a timeout (the default is 30 minutes), and select whether to allow the user to reset the timeout value.

  
       

 
        
        		[bookmark: pgfId-227977]Launch Cleanup Upon Exiting of Browser

  
        		[bookmark: pgfId-227979]Whether to start the cache cleaner when the user closes all web browser windows.

  
       

 
        
        		[bookmark: pgfId-227985]Enable Canceling of Cleaning

  
        		[bookmark: pgfId-227987]Whether to allow the remote user to cancel the cleaning of the cache.

  
       

 
        
        		[bookmark: pgfId-227993]Secure Delete

  
        		[bookmark: pgfId-227995]The number of passes for CSD to perform a secure cleanup. The default is 1 pass.

 [bookmark: pgfId-227997]CSD encrypts and writes the cache to the remote client’s disk. Upon termination of the Secure Desktop, CSD converts all bits occupied by the cache to all 0’s, then to all 1’s, and then to randomized 0’s and 1’s.

  
       

 
        
        		[bookmark: pgfId-228003]Enable Web Browsing if Mac or Linux Installation Fails

  
        		[bookmark: pgfId-228005]Whether to allow web browsing (but not other remote access features) if the cache cleaner installation fails.

  
       

 
        
        		[bookmark: pgfId-228011]VPN Feature Policy

  
        		[bookmark: pgfId-228013]Whether to allow web browsing, remote server file access, and port forwarding for Macintosh and Linux clients. Port forwarding permits the use of the Secure Desktop to connect a client application installed on the local PC to the TCP/IP port of a peer application on a remote server.

  
       

 
        
        		[bookmark: pgfId-228019]Category

  
        		[bookmark: pgfId-228024]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-233046][bookmark: 88813][bookmark: pobjpage_cncpt_FileObjectDialogBox]Add and Edit File Object Dialog Boxes[bookmark: marker-233036][bookmark: marker-233038][bookmark: marker-233040][bookmark: marker-233042][bookmark: marker-233044]

 
    [bookmark: pgfId-233048]Use the Add and Edit File Object dialog boxes to create, copy, and edit file objects. File objects represent files that are used in device configurations, typically for remote access VPN policies and policy objects. Such files include Anyconnect client profile and image files, image (graphic) files, plug-in jar files, and Cisco Secure Desktop package files.

 
    [bookmark: pgfId-233050]When you create a file object, Security Manager makes a copy of the file in its storage system. These files are backed up whenever you create a backup of the Security Manager database, and they are restored if you restore the database. When you deploy configurations that specify a file object, the associated file is download to the device in the appropriate directory.

 
    [bookmark: pgfId-233052]After you create a file object, you typically should not edit it. If you need to replace the file, edit the file object to select the new file, or create a new file object. If the file is editable, you can edit the file object to identify the file’s location in the file repository, and use the desired editor to open and edit the file outside of Security Manager. The file repository is the CSCOpx\MDC\FileRepository folder in the installation directory (typically, C:\Program Files). The files are organized in subfolders named for the file type.

 
    [bookmark: pgfId-233057]For all file types except Image files, you can add a file from the Security Manager server or from the local Security Manager client by selecting the appropriate tab on the Choose a file dialog box. You cannot select files from a network server. You can control the ability to add files from the Security Manager client from Tools > Security Manager Administration > Customize Desktop. For more information, see Customize Desktop Page.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-233059]Tip If you are copying a file to the Security Manager server so that it can be used in a file object, do not copy the file directly to the file repository.


    
     

    

    

 
    [bookmark: pgfId-233061]When you delete a file object, the associated file is not deleted from the file repository.

 
    [bookmark: pgfId-233063]Navigation Path

 
    [bookmark: pgfId-233065]Select Manage > Policy Objects, then select File Objects from the Object Type Selector. Right-click inside the work area, then select New Object or right-click a row, then select Edit Object.

 
    [bookmark: pgfId-233067]Related Topics

 
     
     		 [bookmark: pgfId-233072]Understanding and Managing SSL VPN Support Files

 
     		 [bookmark: pgfId-233077]Configuring SSL VPN AnyConnect Client Settings (ASA)

 
     		 [bookmark: pgfId-233082]Configuring SSL VPN Browser Plug-ins (ASA)

 
     		 [bookmark: pgfId-233087]Configuring Cisco Secure Desktop Policies on ASA Devices

 
     		 [bookmark: pgfId-233092]SSL VPN Customization Dialog Box—Informational Panel

 
     		 [bookmark: pgfId-233097]SSL VPN Customization Dialog Box—Title Panel

 
    

 
    [bookmark: pgfId-233099]Field Reference

 
    [bookmark: pgfId-233102] 

 
     
      
       
       [bookmark: pgfId-228037]Table 34-17 [bookmark: 88871]Add and Edit File Object Dialog Boxes 

 
       
      
        
        		
          
          [bookmark: pgfId-228043]Element
         
  
        		
          
          [bookmark: pgfId-228045]Description
         
  
       

 
        
        		[bookmark: pgfId-228051]Name

  
        		[bookmark: pgfId-228056]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

 [bookmark: pgfId-228058]If you do not enter a name, the name of the file is used for the object name.

  
       

 
        
        		[bookmark: pgfId-228064]Description

  
        		[bookmark: pgfId-228066]An optional description of the object.

  
       

 
        
        		[bookmark: pgfId-228072]File Type

  
        		[bookmark: pgfId-228074]The type of file. If you create the object while configuring a policy, the correct file type is pre-selected. Options are:

 
          
          		 [bookmark: pgfId-228076]Image—For graphic files.

 
          		 [bookmark: pgfId-228078]Cisco Secure Desktop Package

 
          		 [bookmark: pgfId-228080]Plug-In—For browser plug-in files.

 
          		 [bookmark: pgfId-228082]AnyConnect Profile

 
          		 [bookmark: pgfId-228084]AnyConnect Image

 
          		 [bookmark: pgfId-228086]Hostscan Image

 
         

  
       

 
        
        		[bookmark: pgfId-228092]File

  
        		[bookmark: pgfId-228094]The name and full path of the file. Click Browse to select the file.

 [bookmark: pgfId-228099]The following file types are managed using Image Manager. For more information, see Image Manager Supported Image Types.

 
          
          		 [bookmark: pgfId-228101]Cisco Secure Desktop Package

 
          		 [bookmark: pgfId-228103]Plug-In—For browser plug-in files.

 
          		 [bookmark: pgfId-228105]AnyConnect Image

 
          		 [bookmark: pgfId-228107]Hostscan Image

 
         

 [bookmark: pgfId-228109]For AnyConnect Profile and Image files, you can add a file from the Security Manager server. You cannot select files from a network server.

 . For more information, see Customize Desktop Page. [bookmark: pgfId-228116]For file objects that you are editing, the path indicates the location in the Security Manager file repository.

  
       

 
        
        		[bookmark: pgfId-228122]File Name on Device

  
        		[bookmark: pgfId-228124]The file name you want to use when the file is downloaded to the device when you deploy policies. The default is to use the same file name as the original file.

 [bookmark: pgfId-228126]If the object was created by discovering policies from the device, this field uses the original name of the file as it existed on the device. This might not be the same name as it exists on the Security Manager server if the original name duplicated existing file names on the server.

  
       

 
        
        		[bookmark: pgfId-228132]Category

  
        		[bookmark: pgfId-228137]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-233118][bookmark: 88945][bookmark: pobjpage_cncpt_FileObjectSelectorDialogBox]File Object — Choose a file Dialog Box[bookmark: marker-233110][bookmark: marker-233112][bookmark: marker-233114][bookmark: marker-233116]

 
     [bookmark: pgfId-233123]Use the File Object — Choose a file dialog box to select the file to use for the file object you are adding or editing. The available files are managed using Image Manager. For more information, see Image Manager Supported Image Types.

 
     [bookmark: pgfId-233125]Navigation Path

 
     [bookmark: pgfId-233127]Select Manage > Policy Objects, then select File Objects from the Object Type Selector. Add or Edit a file object and from the Add or Edit File Object dialog box, click Browse to open the File Object — Choose a file dialog box.

 
     [bookmark: pgfId-233129]Related Topics

 
      
      		 [bookmark: pgfId-233134]Understanding and Managing SSL VPN Support Files

 
      		 [bookmark: pgfId-233139]Add and Edit File Object Dialog Boxes

 
      		 [bookmark: pgfId-233144]Configuring SSL VPN AnyConnect Client Settings (ASA)

 
      		 [bookmark: pgfId-233149]Configuring SSL VPN Browser Plug-ins (ASA)

 
      		 [bookmark: pgfId-233154]Configuring Cisco Secure Desktop Policies on ASA Devices

 
      		 [bookmark: pgfId-233159]SSL VPN Customization Dialog Box—Informational Panel

 
      		 [bookmark: pgfId-233164]SSL VPN Customization Dialog Box—Title Panel

 
     

 
     [bookmark: pgfId-233166]Field Reference

 
     [bookmark: pgfId-233169] 

 
      
       
        
        [bookmark: pgfId-228150]Table 34-18 [bookmark: 88996]File Object — Choose a file Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-228156]Element
          
  
         		
           
           [bookmark: pgfId-228158]Description
          
  
        

 
         
         		[bookmark: pgfId-228164]Image Repository

  
         		[bookmark: pgfId-228169]Lists the available files you can use for defining your file object. The available files are managed using Image Manager. For more information, see Image Manager Supported Image Types.

  
        

 
         
         		[bookmark: pgfId-228175]File selected

  
         		[bookmark: pgfId-228177]Shows the currently select file object.

  
        

 
         
         		[bookmark: pgfId-228183]Files of Type

  
         		[bookmark: pgfId-228185]Filters the list of files. Options are:

 [bookmark: pgfId-228187]Note You can only view all file objects or only objects filtered by the type of file object you are adding or editing.

 
           
           		 [bookmark: pgfId-228189]Cisco Secure Desktop Package

 
           		 [bookmark: pgfId-228191]Plug-In—For browser plug-in files.

 
           		 [bookmark: pgfId-228193]AnyConnect Image

 
           		 [bookmark: pgfId-228195]Hostscan Image

 
           		 [bookmark: pgfId-228197]All

 
          

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-233187][bookmark: 89036][bookmark: pobjpage_cncpt_PortForwardingListDialogBox]Add or Edit Port Forwarding List Dialog Boxes[bookmark: marker-233177][bookmark: marker-233179][bookmark: marker-233181][bookmark: marker-233183][bookmark: marker-233185]

 
    [bookmark: pgfId-233189]Use the Port Forwarding List dialog box to create, copy and edit port forwarding list policy objects. You can create port forwarding list objects to use when you are configuring the thin client access mode for SSL VPN.

 
    [bookmark: pgfId-233191]Port forwarding allows users to access applications (such as Telnet, e-mail, VNC, SSH, and Terminal services) inside the enterprise through an SSL VPN session. When port forwarding is enabled, the hosts file on the SSL VPN client is modified to map the application to the port number configured in the forwarding list. A port forwarding list object defines the mappings of port numbers on the remote client to the application’s IP address and port behind the SSL VPN gateway.

 
    [bookmark: pgfId-233193]Navigation Path

 
    [bookmark: pgfId-233195]Select Manage > Policy Objects, then select Port Forwarding List from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
    [bookmark: pgfId-233197]Related Topics

 
     
     		 [bookmark: pgfId-233202]SSL VPN Access Modes

 
     		 [bookmark: pgfId-233207]ASA Group Policies SSL VPN Clientless Settings

 
     		 [bookmark: pgfId-233212]User Group Dialog Box—Thin Client Settings

 
     		 [bookmark: pgfId-233217]Create Group Policy Wizard—Clientless and Thin Client Access Modes Page

 
     		 [bookmark: pgfId-233222]Policy Object Manager

 
    

 
    [bookmark: pgfId-233224]Field Reference

 
    [bookmark: pgfId-233227] 

 
     
      
       
       [bookmark: pgfId-228210]Table 34-19 [bookmark: 89084]Port Forwarding List Dialog Box 

 
       
      
        
        		
          
          [bookmark: pgfId-228216]Element
         
  
        		
          
          [bookmark: pgfId-228218]Description
         
  
       

 
        
        		[bookmark: pgfId-228224]Name

  
        		[bookmark: pgfId-228229]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
       

 
        
        		[bookmark: pgfId-228235]Description

  
        		[bookmark: pgfId-228237]An optional description of the object.

  
       

 
        
        		[bookmark: pgfId-228243]Port Forwarding List table

  
        		[bookmark: pgfId-228245]The port forwarding entries that are defined in the object. The entries show the mapping of the local port to the remote server and port.

 
          
          		 [bookmark: pgfId-228250]To add a mapping, click the  Add Row button to open the Add or Edit A Port Forwarding Entry Dialog Box.

 
          		 [bookmark: pgfId-228252]To edit a mapping, select it and click the  Edit Row button.

 
          		 [bookmark: pgfId-228254]To delete a mapping, select it and click the  Delete Row button.

 
         

  
       

 
        
        		[bookmark: pgfId-228260]Include Port Forwarding Lists

  
        		[bookmark: pgfId-228262]The names of other port forwarding list objects to include in the object. Enter the name of the object or click Select to select it from a list or to create a new object. Separate multiple entries with commas.

 [bookmark: pgfId-228264]When you add other port forwarding lists, the entries from those lists are treated as if they were directly entered into this object, and the names of the included objects are not reflected in the device configuration commands during deployment.

  
       

 
        
        		[bookmark: pgfId-228270]Category

  
        		[bookmark: pgfId-228275]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
        
        		[bookmark: pgfId-228281]Allow Value Override per Device

 [bookmark: pgfId-228283]Overrides

 [bookmark: pgfId-228285]Edit button

  
        		[bookmark: pgfId-228293]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-228295]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-233239][bookmark: 89146][bookmark: pobjpage_cncpt_AddEditPortForwardingEntryDialogBox]Add or Edit A Port Forwarding Entry Dialog Box [bookmark: marker-233235][bookmark: marker-233237]

 
     [bookmark: pgfId-233241]Use the Add or Edit A Port Forwarding Entry dialog boxes to create a new port forwarding list entry or edit an existing one.

 
     [bookmark: pgfId-233243]Navigation Path

 
     [bookmark: pgfId-233248]Go to the Add or Edit Port Forwarding List Dialog Boxes and click the Add Row button or select an entry and click the Edit Row button beneath the Port Forwarding List table.

 
     [bookmark: pgfId-233250]Field Reference

 
     [bookmark: pgfId-233253] 

 
      
       
        
        [bookmark: pgfId-228308]Table 34-20 [bookmark: 89163]Add or Edit A Port Forwarding Entry Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-228314]Element
          
  
         		
           
           [bookmark: pgfId-228316]Description
          
  
        

 
         
         		[bookmark: pgfId-228322]Local TCP Port

  
         		[bookmark: pgfId-228324]The port number to which the local application is mapped (between 1 and 65535).

  
        

 
         
         		[bookmark: pgfId-228330]Remote Server

 [bookmark: pgfId-228332]IP Address

 [bookmark: pgfId-228334]Name

  
         		[bookmark: pgfId-228336]The IP address or fully qualified domain name of the remote server. Select the type of entry and enter the IP address or name.

 [bookmark: pgfId-228338]For the IP address, you can enter the name of a network/host object that specifies the remote server’s IP address, or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-228344]Remote TCP Port

  
         		[bookmark: pgfId-228346]The port number of the application for which port forwarding is configured (between 1 and 65535).

  
        

 
         
         		[bookmark: pgfId-228352]Description

  
         		[bookmark: pgfId-228354]A description of the port forwarding entry. This information is mandatory on Cisco IOS devices.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-233271][bookmark: 89199][bookmark: pobjpage_cncpt_SingleSignOnServerSSODialogBox]Add or Edit Single Sign On Server Dialog Boxes[bookmark: marker-233261][bookmark: marker-233263][bookmark: marker-233265][bookmark: marker-233267][bookmark: marker-233269]

 
    [bookmark: pgfId-233276]Use the Add or Edit Single Sign On Server dialog box to create, copy, and edit single sign on (SSO) server objects for use with SSL VPNs (as configured in ASA group policy objects). For information on how to configure SSO servers in an ASA group policy, see ASA Group Policies SSL VPN Settings.

 
    [bookmark: pgfId-233278]Single sign-on lets users access different secure services on different servers without entering a username and password more than once. In the authentication, the security appliance acts as a proxy for the SSL VPN user to the SSO server. You can configure this object to identify either a Computer Associates SiteMinder SSO server or a Security Assertion Markup Language (SAML) Browser Post Profile version 1.1 server.

 
    [bookmark: pgfId-233280]The SSO mechanism starts as part of the AAA process or just after successful user authentication to an AAA server. The SSL VPN server running on the security appliance acts as a proxy for the user to the authenticating server. When a user logs in, the SSL VPN server sends an SSO authentication request, including username and password, to the authenticating server. If the server approves the authentication request, it returns an SSO authentication cookie to the SSL VPN server. The security appliance keeps this cookie on behalf of the user and uses it to authenticate the user to secure web sites within the domain protected by the SSO server.

 
    [bookmark: pgfId-233282]If you want to configure SSO for an SSL VPN group, you must also configure a AAA server, such as a RADIUS or LDAP server.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-233284]Note The SAML Browser Artifact profile method of exchanging assertions is not supported.


    
     

    

    

 
    [bookmark: pgfId-233286]Navigation Path

 
    [bookmark: pgfId-233291]Select Single Sign On Servers in the Policy Object Manager. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
    [bookmark: pgfId-233296]You can also create the object when configuring an ASA user group object for SSL VPN (see ASA Group Policies SSL VPN Settings).

 
    [bookmark: pgfId-233298]Field Reference

 
    [bookmark: pgfId-233301] 

 
     
      
       
       [bookmark: pgfId-228367]Table 34-21 [bookmark: 89235]Add or Edit Single Sign-On Server Dialog Box 

 
       
      
        
        		
          
          [bookmark: pgfId-228373]Element
         
  
        		
          
          [bookmark: pgfId-228375]Description
         
  
       

 
        
        		[bookmark: pgfId-228381]Name

  
        		[bookmark: pgfId-228386]The object name, which must be 4 to 31 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
       

 
        
        		[bookmark: pgfId-228392]Description

  
        		[bookmark: pgfId-228394]An optional description of the object.

  
       

 
        
        		[bookmark: pgfId-228400]Authentication Type

  
        		[bookmark: pgfId-228402]The type of SSO server to use with clientless SSL VPN connections. The other attributes on the page change based on your selection.

 
          
          		 [bookmark: pgfId-228404] SiteMinder —Computer Associates SiteMinder SSO server.

 
          		 [bookmark: pgfId-228406] SAML POST —Security Assertion Markup Language (SAML) Browser Post Profile server.

 
         

  
       

 
        
        		[bookmark: pgfId-228412]URL

 [bookmark: pgfId-228414](SiteMinder only.)

  
        		[bookmark: pgfId-228416]The URL of the SiteMinder SSO server to which the security appliance makes authentication requests. Select whether to use HTTP or HTTPS and enter the URL.

 command.  
       

 
        
        		[bookmark: pgfId-228424]Secret Key

 [bookmark: pgfId-228426]Confirm

 [bookmark: pgfId-228428](SiteMinder only.)

  
        		[bookmark: pgfId-228430]The key used to encrypt authentication communications with the SiteMinder server, if any. The key can contain any alphanumeric characters. There is no minimum or maximum number of characters. Enter the same key in both fields.

 [bookmark: pgfId-228432]Tip If you enter a secret key, you must configure the same key in the SiteMinder server using the Cisco Java plug-in authentication scheme.  
       

 
        
        		[bookmark: pgfId-228438]Assertion URL

 [bookmark: pgfId-228440](SAML POST only.)

  
        		[bookmark: pgfId-228442]The URL for the SAML-type SSO assertion consumer service. Select whether to use HTTP or HTTPS and enter the URL, which must be fewer than 255 characters.

  
       

 
        
        		[bookmark: pgfId-228448]Assertion Issuer

 [bookmark: pgfId-228450](SAML POST only.)

  
        		[bookmark: pgfId-228452]The name of the security device that is sending assertions to a SAML-type SSO server. This is usually the name of the security appliance, for example, asa.example.com. The name must be fewer than 65 characters.

  
       

 
        
        		[bookmark: pgfId-228458]Trustpoint

 [bookmark: pgfId-228460](SAML POST only.)

  
        		[bookmark: pgfId-228462]The name of the PKI enrollment policy object that identifies the certificate authority (CA) server that acts as the trustpoint that contains the certificate to use to sign the SAML-type browser assertion. Enter the name or click Select to select it from a list or to create a new object.

  
       

 
        
        		[bookmark: pgfId-228468]Max Retries

  
        		[bookmark: pgfId-228470]The number of times the security appliance retries a failed SSO authentication attempt before the authentication times out. The range is 1 to 5 retries, and the default is 3 retries.

  
       

 
        
        		[bookmark: pgfId-228476]Request Timeout

  
        		[bookmark: pgfId-228478]The number of seconds before a failed SSO authentication attempt times out. The range is 1 to 30 seconds, and the default is 5 seconds.

  
       

 
        
        		[bookmark: pgfId-228484]Category

  
        		[bookmark: pgfId-228489]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
        
        		[bookmark: pgfId-228495]Allow Value Override per Device

 [bookmark: pgfId-228497]Overrides

 [bookmark: pgfId-228499]Edit button

  
        		[bookmark: pgfId-228507]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-228509]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-233311][bookmark: 89332][bookmark: pobjpage_cncpt_SSLVPNBookmarksDialogBox]Add or Edit Bookmarks Dialog Boxes[bookmark: marker-233309]

 
    [bookmark: pgfId-233313]Use the Add or Edit Bookmarks dialog boxes to configure browser-based clientless SSL VPN bookmarks (URL lists) for an SSL VPN Bookmark object. From this dialog box, you can change the order of the bookmark entries within the table, create, copy, edit, and delete SSL VPN Bookmark objects.

 
    [bookmark: pgfId-233315]An SSL VPN Bookmark object defines the URLs that are displayed on the portal page after a successful login.

 
    [bookmark: pgfId-233317]Navigation Path

 
    [bookmark: pgfId-233319]Select Manage > Policy Objects, then select SSL VPN Bookmarks from the Object Type Selector. Right-click inside the work area, then select New Object or right-click a row, then select Edit Object.

 
    [bookmark: pgfId-233321]Related Topics

 
     
     		 [bookmark: pgfId-233326]Configuring SSL VPN Bookmark Lists for ASA and IOS Devices

 
     		 [bookmark: pgfId-233331]Using the Post URL Method and Macro Substitutions in SSL VPN Bookmarks

 
     		 [bookmark: pgfId-233336]Localizing SSL VPN Web Pages for ASA Devices

 
    

 
    [bookmark: pgfId-233338]Field Reference

 
    [bookmark: pgfId-233341] 

 
     
      
       
       [bookmark: pgfId-228522]Table 34-22 [bookmark: 89363]Add and Edit Bookmarks Dialog Boxes 

 
       
      
        
        		
          
          [bookmark: pgfId-228528]Element
         
  
        		
          
          [bookmark: pgfId-228530]Description
         
  
       

 
        
        		[bookmark: pgfId-228536]Name

  
        		[bookmark: pgfId-228541]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
       

 
        
        		[bookmark: pgfId-228547]Description

  
        		[bookmark: pgfId-228549]An optional description of the object.

  
       

 
        
        		[bookmark: pgfId-228555]Bookmarks Heading (IOS)

 [bookmark: pgfId-228557](IOS devices only)

  
        		[bookmark: pgfId-228559]The heading that is displayed above the URLs listed on the portal page of an SSL†VPN hosted on an IOS device.

  
       

 
        
        		[bookmark: pgfId-228565]Bookmarks

  
        		[bookmark: pgfId-228567]The list of bookmark entries for the object.

 
          
          		 [bookmark: pgfId-228569]To change the order of an entry, select it and click the Move Up or Move Down arrow buttons. The order of entries in the table defines the order in which the bookmarks are presented to the user.

 
          		 [bookmark: pgfId-228574]To add an entry, click the Add button and fill in the Add Bookmark Entry dialog box (see Add or Edit Bookmark Entry Dialog Boxes).

 
          		 [bookmark: pgfId-228576]To edit an entry, select it and click the Edit button.

 
          		 [bookmark: pgfId-228578]To delete an entry, select it and click the Delete button.

 
         

  
       

 
        
        		[bookmark: pgfId-228584]Category

  
        		[bookmark: pgfId-228589]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
        
        		[bookmark: pgfId-228595]Allow Value Override per Device

 [bookmark: pgfId-228597]Overrides

 [bookmark: pgfId-228599]Edit button

  
        		[bookmark: pgfId-228607]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-228609]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-233357][bookmark: 89423][bookmark: pobjpage_cncpt_SSLVPNBookmarkEntryDialogBox]Add or Edit Bookmark Entry Dialog Boxes[bookmark: marker-233353][bookmark: marker-233355]

 
     [bookmark: pgfId-233359]Use the Add or Edit Bookmark Entry dialog boxes to create or edit a bookmark to be included in an SSL VPN Bookmark object.

 
     [bookmark: pgfId-233364]You can use non-English, non-ASCII languages for the text to display for bookmarks if you are configuring the object for use on an ASA device. For more information about how you can configure the SSL VPN portal in local languages, see Localizing SSL VPN Web Pages for ASA Devices.

 
     [bookmark: pgfId-233366]Navigation Path

 
     [bookmark: pgfId-233371]In the Policy Object Manager, from the Add or Edit Bookmarks Dialog Boxes, right-click inside the Bookmarks table, then select Add Row or right-click a row, then select Edit Row.

 
     [bookmark: pgfId-233373]Related Topics

 
      
      		 [bookmark: pgfId-233378]Configuring SSL VPN Bookmark Lists for ASA and IOS Devices

 
      		 [bookmark: pgfId-233383]Using the Post URL Method and Macro Substitutions in SSL VPN Bookmarks

 
     

 
     [bookmark: pgfId-233385]Field Reference

 
     [bookmark: pgfId-233388] 

 
      
       
        
        [bookmark: pgfId-228622]Table 34-23 [bookmark: 89455]Add or Edit Bookmark Entry Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-228628]Element
          
  
         		
           
           [bookmark: pgfId-228630]Description
          
  
        

 
         
         		[bookmark: pgfId-228636]Bookmark Option

  
         		[bookmark: pgfId-228638]Select whether you want to define a new SSL VPN Bookmark entry or use the entries from an existing object:

 
           
           		 [bookmark: pgfId-228640] Enter Bookmark —You want to define a bookmark entry.

 
           		 [bookmark: pgfId-228642] Include Existing Bookmarks —You want to include bookmark entries defined in an existing SSL VPN Bookmark object. Enter the name of the object or click  Select to select it from a list or to create a new object.

 
           		 [bookmark: pgfId-228644] Predefined Application Templates —You want to use a predefined template that contains the pre-filled necessary values for certain well-defined applications.

 
          

  
        

 
         
         		[bookmark: pgfId-228650]Select Auto sign-on Application

  
         		[bookmark: pgfId-228652]If you selected Predefined Application Templates as the Bookmark Option, select the auto sign-on application whose template you want to use:

 
           
           		 [bookmark: pgfId-228654]Citrix XenApp

 
           		 [bookmark: pgfId-228656]Citrix XenDesktop

 
           		 [bookmark: pgfId-228658]Domino Web Access

 
           		 [bookmark: pgfId-228660]Microsoft Outlook Web Access 2010

 
           		 [bookmark: pgfId-228662]Microsoft Outlook Web Access 2013 (ASA 9.4(1)+ only)

 
           		 [bookmark: pgfId-228664]Microsoft SharePoint 2007

 
           		 [bookmark: pgfId-228666]Microsoft SharePoint 2010

 
           		 [bookmark: pgfId-228668]Microsoft SharePoint 2013 (ASA 9.5(1)+ only)

 
           		 [bookmark: pgfId-228670]Citrix StoreFront 2.1 (ASA 9.3(1)+ only)

 
           		 [bookmark: pgfId-228672]Citrix StoreFront 2.5 (ASA 9.4(1)+ only)

 
          

 [bookmark: pgfId-228674]After selecting an auto sign-on application, the Advanced Form and URL Settings are populated based on the selected application.

  
        

 
         
         		[bookmark: pgfId-228680]Title

  
         		[bookmark: pgfId-228682]The text label that the user sees for the bookmark.

  
        

 
         
         		[bookmark: pgfId-228688]URL

  
         		[bookmark: pgfId-228690]The Universal Resource Locator address for the bookmark. Select the protocol for the bookmark and enter the rest of the URL in the edit box.

 [bookmark: pgfId-228695]Tip If you are creating bookmarks for use on an ASA device, and you are also configuring Kerberos Constrained Delegation on the device, you might need to add the service principle name (SPN) to the URL. For more information, see Configuring Kerberos Constrained Delegation (KCD) for SSL VPN (ASA).  
        

 
         
         		 [bookmark: pgfId-228701]Settings

 [bookmark: pgfId-228703]These settings are applicable only to SSL VPN portals hosted on ASA devices running software version 8.x or later. Do not configure these settings for SSL VPN Bookmark objects that you will use on other devices.

  
        

 
         
         		[bookmark: pgfId-228711]Subtitle

  
         		[bookmark: pgfId-228713]An additional user-visible title that describes the bookmark entry.

  
        

 
         
         		[bookmark: pgfId-228719]Thumbnail

  
         		[bookmark: pgfId-228721]The File object that represents an icon you want to associate with the bookmark on the Portal. Enter the name of the File object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-228727]Authentication Access

  
         		[bookmark: pgfId-228729]Whether to display the thumbnail only on the Portal page. If you deselect this option, the thumbnail is also displayed on the Logon page.

  
        

 
         
         		[bookmark: pgfId-228735]Enable Favorite URL Option

  
         		[bookmark: pgfId-228737]Whether to display the bookmark entry on the portal home page. Deselect the check box if you want the bookmark entry to appear on the application page only.

  
        

 
         
         		 [bookmark: pgfId-228743]Advanced Form and URL Settings

 [bookmark: pgfId-228745]These settings are applicable only to SSL VPN portals hosted on ASA devices running software version 8.x or later. Do not configure these settings for SSL VPN Bookmark objects that you will use on other devices.

  
        

 
         
         		[bookmark: pgfId-228753]URL Method

  
         		[bookmark: pgfId-228755]Select the required URL method from the list:

 
           
           		 [bookmark: pgfId-228757] Get —Select this option if you want simple data retrieval.

 
           		 [bookmark: pgfId-228759] Post —Select this option when processing the data might involve changes to it, for example, storing or updating data, ordering a product, or sending e-mail. If you select this option, you must configure the Post parameters in the Post Parameters table.

 
           		 [bookmark: pgfId-228761] Auto Sign-on Form —Select this option if you want to use auto sign-on.

 
          

  
        

 
         
         		[bookmark: pgfId-228767]Enable Smart Tunnel Option

 [bookmark: pgfId-228769](Get and Post URL Method only)

  
         		[bookmark: pgfId-228771]Whether to open the bookmark in a new window that uses the smart tunnel functionality to pass data to and from the security appliance.

  
        

 
         
         		[bookmark: pgfId-228777]Preload Page Options

 [bookmark: pgfId-228779](Get and Post URL Method only)

  
         		[bookmark: pgfId-228781]Optionally, configure the following Preload options:

 [bookmark: pgfId-228783]Preload URL—The URL of a page to load before the bookmark link is loaded.

 [bookmark: pgfId-228785]Wait Time—The time to allow for loading of the page before you are forwarded to the actual POST URL.

  
        

 
         
         		[bookmark: pgfId-228791]Auto Sign-on (ASA 9.0.1+ only)

 [bookmark: pgfId-228793](Auto Sign-on Form URL Method only)

  
         		[bookmark: pgfId-228795]When Auto Sign-on Form is selected as the URL Method, configure the following options:

 [bookmark: pgfId-228797]Note Wildcards can be used in the URLs you enter for the following fields. For example, you can enter http*://www.example.com/myurl*.

 [bookmark: pgfId-228799]Login Page URL—The URL of the login page for which to auto sign-on.

 [bookmark: pgfId-228801]Landing Page URL—The URL of the page that is loaded after a successful login. The ASA requires the Landing Page to be configured to detect a successful login to the application.

 [bookmark: pgfId-228803]Pre-Login Page URL—The URL of the page which is loaded before the login page. This page will require user interaction to proceed to the login screen.

 [bookmark: pgfId-228805]Control ID—The ID of the control/tag that will get a click event on the pre-login page URL to proceed to the login page.

  
        

 
         
         		[bookmark: pgfId-228811]Post Parameters

  
         		[bookmark: pgfId-228813]The list of the names and values of the Post parameters for the bookmark entry.

 
           
           		 [bookmark: pgfId-228818]To add a parameter, click the Add button and fill in the Add Post Parameter dialog box (see Add and Edit Post Parameter Dialog Boxes).

 
           		 [bookmark: pgfId-228820]To edit a parameter, select it and click the Edit button.

 
           		 [bookmark: pgfId-228822]To delete a parameter, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-228828]Post Script

  
         		[bookmark: pgfId-228830]An optional field for entering JavaScript required by some applications. Some Web applications, such as Microsoft Outlook Web Access, may execute a JavaScript to change the request parameters before the log-on form is submitted.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-233398][bookmark: 89618][bookmark: pobjpage_cncpt_SSLVPNBookmarkPostParameterDialogBox]Add and Edit Post Parameter Dialog Boxes[bookmark: marker-233396]

 
     [bookmark: pgfId-233403]Use the Add and Edit Post Parameter dialog boxes to create a new Post parameter entry or edit an existing one in the table. For a detailed discussion of Post parameters, see Using the Post URL Method and Macro Substitutions in SSL VPN Bookmarks.

 
     [bookmark: pgfId-233405]Navigation Path

 
     [bookmark: pgfId-233410]In the Policy Object Manager, from the Add or Edit Bookmark Entry Dialog Boxes, right-click inside the Post Parameters table, then select Add Row or right-click a row, then select Edit Row.

 
     [bookmark: pgfId-233412]Related Topics

 
      
      		 [bookmark: pgfId-233417]Configuring SSL VPN Bookmark Lists for ASA and IOS Devices

 
      		 [bookmark: pgfId-233422]Using the Post URL Method and Macro Substitutions in SSL VPN Bookmarks

 
     

 
     [bookmark: pgfId-233424]Field Reference

 
     [bookmark: pgfId-233427] 

 
      
       
        
        [bookmark: pgfId-228843]Table 34-24 [bookmark: 89645]Add and Edit Post Parameter Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-228849]Element
          
  
         		
           
           [bookmark: pgfId-228851]Description
          
  
        

 
         
         		[bookmark: pgfId-228857]Name

  
         		[bookmark: pgfId-228859]The name of the post parameter exactly as defined in the corresponding HTML form. For example, param_name in <input name=“param_name” value=“param_value”>.

  
        

 
         
         		[bookmark: pgfId-228865]Value

  
         		[bookmark: pgfId-228867]The value of the post parameter exactly as defined in the corresponding HTML form. For example, param_value in <input name=“param_name” value=“param_value”>.

 [bookmark: pgfId-228869]Select one of the following:

 
           
           		 [bookmark: pgfId-228871]CSCO_WEBVPN_USERNAME—SSL VPN user login ID.

 
           		 [bookmark: pgfId-228873]CSCO_WEBVPN_PASSWORD—SSL VPN user login password.

 
           		 [bookmark: pgfId-228875]CSCO_WEBVPN_INTERNAL_PASSWORD—SSL VPN user internal resource password. This is a cached credential, and not authenticated by a AAA server. If a user enters this value, it is used as the password for auto sign-on, instead of the password value.

 
           		 [bookmark: pgfId-228877]CSCO_WEBVPN_CONNECTION_PROFILE—SSL VPN user login group drop-down, a group alias within the connection profile.

 
           		 [bookmark: pgfId-228879]CSCO_WEBVPN_DYNAMIC_URL1—A single bookmark that can generate multiple bookmark links on the user’s portal. This macro takes  delimiter as an option, where delimiter is an administrator-supplied string which includes the characters used to separate the LDAP-mapped string into a list of values, using one delimiter per use of the macro.

 
           		 [bookmark: pgfId-228881]CSCO_WEBVPN_DYNAMIC_URL2—A single bookmark that can generate multiple bookmark links on the user’s portal. This macro takes  delimiter as an option, where delimiter is an administrator-supplied string which includes the characters used to separate the LDAP-mapped string into a list of values, using one delimiter per use of the macro.

 
           		 [bookmark: pgfId-228883]CSCO_WEBVPN_MACRO1—Set via the RADIUS/LDAP vendor-specific attribute. If you are mapping this from LDAP via an ldap-attribute-map, the Cisco attribute that uses this variable is WEBVPN-Macro-Substitution-Value1. Variable substitution via RADIUS is performed by VSA#223.

 
           		 [bookmark: pgfId-228885]CSCO_WEBVPN_MACRO2—Set via the RADIUS/LDAP vendor-specific attribute. If you are mapping this from LDAP via an ldap-attribute-map, the Cisco attribute that uses this variable is WEBVPN-Macro-Substitution-Value2. Variable substitution via RADIUS is performed by VSA#224.

 
           		 [bookmark: pgfId-228887]CSCO_WEBVPN_MACROLIST1 and CSCO_WEBVPN_MACROLIST2—Statically configured bookmarks which can use arbitrarily-sized lists provided by LDAP attribute maps.

 
          

 [bookmark: pgfId-228889]These macros take the following three parameters:

 [bookmark: pgfId-228891] – Delimiter—Delimiter is an administrator-supplied string which includes the characters used to separate the LDAP-mapped string into a list of values, using one delimiter per use of the macro.

 [bookmark: pgfId-228893] – Index—Index is an administrator-supplied integer which specifies the number of the element in the list to select. The value can range between 1 and 128.

 [bookmark: pgfId-228895] – URL Encoding—URL Encoding is the choice to apply the LDAP string before it is substituted into the ASA device’s request. You can select one of the following values:

 [bookmark: pgfId-228897] – None—No transformation occurs on the string value before sending to the backend server.

 [bookmark: pgfId-228899] – url-encode—Each parsed value is URL encoded, except for a list of reserved characters that make up the special characters in a URL.

 [bookmark: pgfId-228901] – url-encode-data—Each parsed value is transformed fully with URL encoding.

 [bookmark: pgfId-228903] – base64—Each parsed value is base 64 encoded.

 
           
           		 [bookmark: pgfId-228905]CSCO_WEBVPN_PRIMARY_USERNAME—Primary user login ID when double authentication is enabled and login ID has primary login username.

 
           		 [bookmark: pgfId-228907]CSCO_WEBVPN_SECONDARY_USERNAME—Secondary user login ID when double authentication is enabled.

 
           		 [bookmark: pgfId-228909]CSCO_WEBVPN_PRIMARY_PASSWORD—Primary user login password for double authentication.

 
           		 [bookmark: pgfId-228911]CSCO_WEBVPN_SECONDARY_PASSWORD—Secondary user login ID for double authentication.

 
          

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-233467][bookmark: 89720][bookmark: pobjpage_cncpt_SSLVPNCustomizationDialogBox]Add and Edit SSL VPN Customization Dialog Boxes[bookmark: marker-233463][bookmark: marker-233465]

 
    [bookmark: pgfId-233472]Use the Add and Edit SSL VPN Customization dialog boxes to create, copy, and edit SSL VPN Customization objects. An SSL VPN Customization policy object describes how to customize web pages for a browser-based clientless SSL VPN hosted on an ASA 8.x device. For more information, see Configuring ASA Portal Appearance Using SSL VPN Customization Objects.

 
    [bookmark: pgfId-233477]You can use non-English, non-ASCII languages for the text to display on these pages. For more information about how you can configure the SSL VPN portal in local languages, see Localizing SSL VPN Web Pages for ASA Devices.

 
    [bookmark: pgfId-233479]Navigation Path

 
    [bookmark: pgfId-233481]Select Manage > Policy Objects, then select SSL VPN Customization from the Object Type Selector. Right-click inside the work area, then select New Object or right-click a row, then select Edit Object.

 
    [bookmark: pgfId-233483]Related Topics

 
     
     		 [bookmark: pgfId-233488]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
     		 [bookmark: pgfId-233493]Localizing SSL VPN Web Pages for ASA Devices

 
     		 [bookmark: pgfId-233498]Creating Your Own SSL VPN Logon Page for ASA Devices

 
    

 
    [bookmark: pgfId-233500]Field Reference

 
    [bookmark: pgfId-233503] 

 
     
      
       
       [bookmark: pgfId-228924]Table 34-25 [bookmark: 89767]Add and Edit SSL VPN Customization Dialog Boxes 

 
       
      
        
        		
          
          [bookmark: pgfId-228930]Element
         
  
        		
          
          [bookmark: pgfId-228932]Description
         
  
       

 
        
        		[bookmark: pgfId-228938]Name

  
        		[bookmark: pgfId-228943]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
       

 
        
        		[bookmark: pgfId-228949]Description

  
        		[bookmark: pgfId-228951]An optional description of the object.

  
       

 
        
        		 [bookmark: pgfId-228957]Settings Pane

 [bookmark: pgfId-228959]The body of the dialog box is a pane with a table of contents on the left and settings related to the item selected in the table of contents on the right. Before configuring settings, click the Preview button to see the default settings to help you determine what, if anything, you want to change.

 [bookmark: pgfId-228961]The top folders in the table of contents represent the SSL VPN web pages that you can customize, and are explained next.

  
       

 
        
        		[bookmark: pgfId-228969]Logon Page

  
        		[bookmark: pgfId-228971]The Logon web page is the one users see first when connecting to the SSL VPN portal. It is used for logging into the VPN. Select the following items in the Logon Page folder in the table of contents to view and change the settings:

 
          
          		 [bookmark: pgfId-228973] Logon Page —The Browser Window Title field defines the title of the web page, which is displayed in the browser’s title bar.

 
          		 [bookmark: pgfId-228978] Title Panel —The title displayed in the web page itself. For more information about the settings, see SSL VPN Customization Dialog Box—Title Panel.

 
          		 [bookmark: pgfId-228983] Language —The languages you will support for the Logon, Portal, and Logout pages. For more information about the settings, see SSL VPN Customization Dialog Box—Language.

 
          		 [bookmark: pgfId-228988] Logon Form —The labels and colors used in the form that accepts user logon information. For more information about the settings, see SSL VPN Customization Dialog Box—Logon Form.

 
          		 [bookmark: pgfId-228993] Informational Panel —An extra informational panel for conveying information to users. For more information about the settings, see SSL VPN Customization Dialog Box—Informational Panel.

 
          		 [bookmark: pgfId-228998] Copyright Panel —The copyright information on the logon page. For more information about the settings, see SSL VPN Customization Dialog Box—Copyright Panel.

 
          		 [bookmark: pgfId-229006] Full Customization —If you do not want to use the security appliance’s built-in logon page, even customized, you can instead enable full customization and supply your own web page. For more information about creating a custom Logon page and the settings, see Creating Your Own SSL VPN Logon Page for ASA Devices and SSL VPN Customization Dialog Box—Full Customization.

 
         

  
       

 
        
        		[bookmark: pgfId-229012]Portal Page

  
        		[bookmark: pgfId-229014]The Portal web page is the one users see after logging into the SSL VPN; it is the home page. Select the following items in the Portal Page folder in the table of contents to view and change the settings:

 
          
          		 [bookmark: pgfId-229016] Portal Page —The  Browser Window Title field defines the title of the web page, which is displayed in the browser’s title bar.

 
          		 [bookmark: pgfId-229021] Title Panel —The title displayed in the web page itself. For more information about the settings, see SSL VPN Customization Dialog Box—Title Panel.

 
          		 [bookmark: pgfId-229026] Toolbar —The toolbar displayed above the main part of the Portal page. For more information about the settings, see SSL VPN Customization Dialog Box—Toolbar.

 
          		 [bookmark: pgfId-229031] Applications —The application buttons that will appear on the page. For more information about the settings, see SSL VPN Customization Dialog Box—Applications.

 
          		 [bookmark: pgfId-229036] Custom Panes —The layout of the main part of the Portal page. The default is a single column with no internal panes. For more information about the settings, see SSL VPN Customization Dialog Box—Custom Panes.

 
          		 [bookmark: pgfId-229041] Home Page —How and whether to display URL lists on the home page. For more information about the settings, see SSL VPN Customization Dialog Box—Home Page.

 
         

  
       

 
        
        		[bookmark: pgfId-229047]Logout Page

  
        		[bookmark: pgfId-229052]The Logout web page is the one users see after logging out of the SSL VPN. For more information about the settings, see SSL VPN Customization Dialog Box—Logout Page.

  
       

 
        
        		[bookmark: pgfId-229058]Category

  
        		[bookmark: pgfId-229063]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
        
        		[bookmark: pgfId-229069]Allow Value Override per Device

 [bookmark: pgfId-229071]Overrides

 [bookmark: pgfId-229073]Edit button

  
        		[bookmark: pgfId-229081]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-229083]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-233513][bookmark: 89882][bookmark: pobjpage_cncpt_SSLVPNCustomizationDialogBoxTitlePanel]SSL VPN Customization Dialog Box—Title Panel [bookmark: marker-233509][bookmark: marker-233511]

 
     [bookmark: pgfId-233515]Use the Title Panel page of the SSL VPN Customization dialog box to determine whether the Logon page or Portal page will have a title displayed in the web page itself. If you enable the title panel, you can specify the title, font, font size and weight, styles, and colors used. You can also select a File object that identifies a logo graphic.

 
     [bookmark: pgfId-233517]Navigation Path

 
     [bookmark: pgfId-233522]From the Add and Edit SSL VPN Customization Dialog Boxes, select Logon Page > Title Panel in the table of contents to configure the title of the Logon page, or Portal Page > Title Panel to configure the title of the Portal page.

 
     [bookmark: pgfId-233524]Related Topics

 
      
      		 [bookmark: pgfId-233529]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
      		 [bookmark: pgfId-233534]Localizing SSL VPN Web Pages for ASA Devices

 
     

 
     [bookmark: pgfId-233536]Field Reference

 
     [bookmark: pgfId-233539] 

 
      
       
        
        [bookmark: pgfId-229096]Table 34-26 [bookmark: 89909]SSL VPN Customization Dialog Box—Title Panel 

 
        
       
         
         		
           
           [bookmark: pgfId-229102]Element
          
  
         		
           
           [bookmark: pgfId-229104]Description
          
  
        

 
         
         		[bookmark: pgfId-229110]Display Title Panel

  
         		[bookmark: pgfId-229112]Whether to display a title panel within the web page. The default is to not display a title. If you select this option, you can configure the title using the other fields on this page.

  
        

 
         
         		[bookmark: pgfId-229118]Gradient

  
         		[bookmark: pgfId-229120]Whether to have the background color change in a gradual progression.

  
        

 
         
         		[bookmark: pgfId-229126]Title Text

  
         		[bookmark: pgfId-229128]The text to display in the title panel.

  
        

 
         
         		[bookmark: pgfId-229134]Font Weight

 [bookmark: pgfId-229136]Font Size

 [bookmark: pgfId-229138]Font Color

  
         		[bookmark: pgfId-229140]The characteristics of the font used for the title text. You can select a weight, font size, and color. Click Select to choose a font color.

  
        

 
         
         		[bookmark: pgfId-229146]Background Color

  
         		[bookmark: pgfId-229148]The color of the background of the title panel. Click Select to choose a color.

  
        

 
         
         		[bookmark: pgfId-229154]Style (CSS)

  
         		[bookmark: pgfId-229156]Cascading Style Sheet (CSS) parameters that define the style characteristics of the title panel. You can include a maximum of 256 characters.

 .  
        

 
         
         		[bookmark: pgfId-229166]Logo Image

  
         		[bookmark: pgfId-229168]The File policy object that identifies the logo image you want to include in the title panel, if any. Enter the name of the File object or click Select to select it from a list or to create a new object.

 [bookmark: pgfId-229170]Tip The image file can be a GIF, JPG, or PNG file, and it can be up to 100 kilobytes in size. [bookmark: pgfId-229175]For more information about File objects, see Add and Edit File Object Dialog Boxes.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-233549][bookmark: 89965][bookmark: pobjpage_cncpt_SSLVPNCustomizationDialogBoxLanguage]SSL VPN Customization Dialog Box—Language [bookmark: marker-233545][bookmark: marker-233547]

 
     [bookmark: pgfId-233554]Use the Language page of the SSL VPN Customization dialog box identify the languages you will support on the browser-based clientless SSL VPN portal. If you want to configure translation tables for other languages on the ASA device and use them, you can configure the supported languages and allow users to choose their language. Before you configure these settings, read Localizing SSL VPN Web Pages for ASA Devices.

 
     [bookmark: pgfId-233556]Navigation Path

 
     [bookmark: pgfId-233561]From the Add and Edit SSL VPN Customization Dialog Boxes, select Logon Page > Language in the table of contents.

 
     [bookmark: pgfId-233563]Related Topics

 
      
      		 [bookmark: pgfId-233568]Localizing SSL VPN Web Pages for ASA Devices

 
      		 [bookmark: pgfId-233573]Add and Edit SSL VPN Customization Dialog Boxes

 
      		 [bookmark: pgfId-233578]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
     

 
     [bookmark: pgfId-233580]Field Reference

 
     [bookmark: pgfId-233583] 

 
      
       
        
        [bookmark: pgfId-229188]Table 34-27 [bookmark: 89995]SSL VPN Customization Dialog Box—Language 

 
        
       
         
         		
           
           [bookmark: pgfId-229194]Element
          
  
         		
           
           [bookmark: pgfId-229196]Description
          
  
        

 
         
         		[bookmark: pgfId-229202]Automatic Browser Language Selection

  
         		[bookmark: pgfId-229207]This table lists the languages you will support on the web pages for automatic browser language selection. Automatic browser language select allows the ASA device to negotiate with the user’s web browser to determine the language in which to present the web pages. You must configure a translation table on the ASA device for any language you list here. For more detailed information about automatic browser language selection, see Localizing SSL VPN Web Pages for ASA Devices.

 [bookmark: pgfId-229209]Languages are listed by their abbreviation in the table. The languages are evaluated top to bottom until a match is found. The language that is indicated as the default language (indicated as True in the table) is used if the device is unable to negotiate a different language with the browser. If you do not specify a default, English is the default.

 
           
           		 [bookmark: pgfId-229211]To add a language, click the Add Row button below the table.

 
           		 [bookmark: pgfId-229213]To edit a language, select it and click the Edit Row button.

 
           		 [bookmark: pgfId-229215]To delete a language, select it and click the Delete Row button.

 
          

  
        

 
         
         		[bookmark: pgfId-229221]Enable Language Selector

  
         		[bookmark: pgfId-229223]Whether to display the Language Selector on the Logon page. The Language Selector allows users to select their preferred language. The Language Selector is complementary to the automatic browser language selection capability.

  
        

 
         
         		[bookmark: pgfId-229229]Language Selector Prompt

  
         		[bookmark: pgfId-229231]The text label for the Language Selector prompt.

  
        

 
         
         		[bookmark: pgfId-229237]Language Table

  
         		[bookmark: pgfId-229242]The list of languages included in the Language Selector drop-down list. You must configure a translation table on the ASA device for any language you list here. For more detailed information, see Localizing SSL VPN Web Pages for ASA Devices.

 [bookmark: pgfId-229244]The table lists the languages by abbreviation and title, or the common name of the language. The title is the text displayed in the drop-down list. You can change the language title but not the abbreviation.

 
           
           		 [bookmark: pgfId-229246]To add a language, click the Add Row button below the table.

 
           		 [bookmark: pgfId-229248]To edit a language, select it and click the Edit Row button.

 
           		 [bookmark: pgfId-229250]To delete a language, select it and click the Delete Row button.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-233597][bookmark: 90043][bookmark: pobjpage_cncpt_SSLVPNCustomizationLanguageSelectionDialogBox]Add and Edit Language Dialog Boxes [bookmark: marker-233593][bookmark: marker-233595]

 
     [bookmark: pgfId-233599]Use the Add and Edit Language dialog boxes to add or edit an entry for a language you will support for automatic browser language selection or in the Language Selector drop-down list.

 
     [bookmark: pgfId-233601]Navigation Path

 
     [bookmark: pgfId-233606]From the SSL VPN Customization Dialog Box—Language page, click the Add Row button for either the Automatic Browser Language Selection table or the Language Selector table, or select a row and click the Edit Row button.

 
     [bookmark: pgfId-233608]Related Topics

 
      
      		 [bookmark: pgfId-233613]Localizing SSL VPN Web Pages for ASA Devices

 
      		 [bookmark: pgfId-233618]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
     

 
     [bookmark: pgfId-233620]Field Reference

 
     [bookmark: pgfId-233623] 

 
      
       
        
        [bookmark: pgfId-229263]Table 34-28 [bookmark: 90070]Add and Edit Language Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-229269]Element
          
  
         		
           
           [bookmark: pgfId-229271]Description
          
  
        

 
         
         		[bookmark: pgfId-229277]Language

  
         		[bookmark: pgfId-229279]The list of languages that you can support on the browser-based clientless SSL VPN web pages, listed by their abbreviation.

  
        

 
         
         		[bookmark: pgfId-229285]Default

 [bookmark: pgfId-229287](Automatic Browser Language Selection only)

  
         		[bookmark: pgfId-229289]Whether the language should be defined as the default language for the portal. The default language is used if the ASA device cannot negotiate a language with the client’s browser.

  
        

 
         
         		[bookmark: pgfId-229295]Title

 [bookmark: pgfId-229297](Language Selector only)

  
         		[bookmark: pgfId-229299]The name of the language that should appear in the Language Selector on the Logon page.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-233633][bookmark: 90099][bookmark: pobjpage_cncpt_SSLVPNCustomizationDialogBoxLogonForm]SSL VPN Customization Dialog Box—Logon Form [bookmark: marker-233629][bookmark: marker-233631]

 
     [bookmark: pgfId-233635]Use the Logon Form settings of the SSL VPN Customization dialog box to customize the title of the login box, login prompts of the SSL VPN page (including username, password, and group prompts), login buttons, and style elements of the login box that appears to browser-based clientless SSL VPN users when they initially connect to the security appliance.

 
     [bookmark: pgfId-233637]Navigation Path

 
     [bookmark: pgfId-233642]From the Add and Edit SSL VPN Customization Dialog Boxes, select Logon Page > Logon Form in the table of contents.

 
     [bookmark: pgfId-233644]Related Topics

 
      
      		 [bookmark: pgfId-233649]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
     

 
     [bookmark: pgfId-233651]Field Reference

 
     [bookmark: pgfId-233654] 

 
      
       
        
        [bookmark: pgfId-229312]Table 34-29 [bookmark: 90122]SSL VPN Customization Dialog Box—Logon Page 

 
        
       
         
         		
           
           [bookmark: pgfId-229318]Element
          
  
         		
           
           [bookmark: pgfId-229320]Description
          
  
        

 
         
         		[bookmark: pgfId-229326]Title

  
         		[bookmark: pgfId-229328]The text displayed as the title of the login box.

  
        

 
         
         		[bookmark: pgfId-229334]Message

  
         		[bookmark: pgfId-229336]The message that appears in the login box above the username and password fields. You can enter a maximum of 256 characters.

  
        

 
         
         		[bookmark: pgfId-229342]Username Prompt

  
         		[bookmark: pgfId-229344]The text of the prompt for the username entry field.

  
        

 
         
         		[bookmark: pgfId-229350]Password Prompt

  
         		[bookmark: pgfId-229352]The text of the prompt for the password entry field.

  
        

 
         
         		[bookmark: pgfId-229358]Secondary Username Prompt

 [bookmark: pgfId-229360]Secondary Password Prompt

  
         		[bookmark: pgfId-229362]The prompts for a second username and password if you require two login credentials. You can enable secondary authentication only if the Connection Profile policy is configured to require it.

 [bookmark: pgfId-229364]The secondary username and password prompt are displayed only if you configure them. If you leave the username prompt blank, the primary username is used and the secondary password must be associated with the primary username.

  
        

 
         
         		[bookmark: pgfId-229370]Internal Password Prompt

  
         		[bookmark: pgfId-229372]The text of the prompt for the internal password entry field.

  
        

 
         
         		[bookmark: pgfId-229378]Show Internal Password First

  
         		[bookmark: pgfId-229380]Whether the prompt for the internal password should be placed above the password prompt. The internal password is required when using a clientless SSL VPN to access an internal protected website.

  
        

 
         
         		[bookmark: pgfId-229386]Group Selector Prompt

  
         		[bookmark: pgfId-229388]The text of the prompt for the Group Selector drop-down list.

  
        

 
         
         		[bookmark: pgfId-229394]Button Text

  
         		[bookmark: pgfId-229396]The name of the button the user clicks to log onto the SSL VPN.

  
        

 
         
         		[bookmark: pgfId-229402]Border Color

  
         		[bookmark: pgfId-229404]The color of the border of the login box. Click Select to choose a color.

  
        

 
         
         		[bookmark: pgfId-229410]Title Font Color

  
         		[bookmark: pgfId-229412]The color of the font for the login box title. Click Select to choose a color.

  
        

 
         
         		[bookmark: pgfId-229418]Title Background Color

  
         		[bookmark: pgfId-229420]The background color for the Title area of the login box. Click Select to choose a color.

  
        

 
         
         		[bookmark: pgfId-229426]Font Color

  
         		[bookmark: pgfId-229428]The color of the font of the login form. Click Select to choose a color.

  
        

 
         
         		[bookmark: pgfId-229434]Background Color

  
         		[bookmark: pgfId-229436]The background color for the login form. Click Select to choose a color.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-233664][bookmark: 90210][bookmark: pobjpage_cncpt_SSLVPNCustomizationDialogBoxInformationalPanel]SSL VPN Customization Dialog Box—Informational Panel [bookmark: marker-233660][bookmark: marker-233662]

 
     [bookmark: pgfId-233666]Use the Informational Panel page of the SSL VPN Customization dialog box to customize the appearance of the Informational panel in the Logon page. The Informational panel is an area where you can provide extra information to the user, and is optional.

 
     [bookmark: pgfId-233668]Navigation Path

 
     [bookmark: pgfId-233673]From the Add and Edit SSL VPN Customization Dialog Boxes, select Logon Page > Informational Panel in the table of contents.

 
     [bookmark: pgfId-233675]Related Topics

 
      
      		 [bookmark: pgfId-233680]Add and Edit SSL VPN Customization Dialog Boxes

 
      		 [bookmark: pgfId-233685]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
     

 
     [bookmark: pgfId-233687]Field Reference

 
     [bookmark: pgfId-233690] 

 
      
       
        
        [bookmark: pgfId-229449]Table 34-30 [bookmark: 90236]SSL VPN Customization Dialog Box—Informational Panel 

 
        
       
         
         		
           
           [bookmark: pgfId-229455]Element
          
  
         		
           
           [bookmark: pgfId-229457]Description
          
  
        

 
         
         		[bookmark: pgfId-229463]Display Informational Panel

  
         		[bookmark: pgfId-229465]Whether to display the Informational panel. The default is to not display the panel. If you select this option, you can configure the panel using the other fields on this page.

  
        

 
         
         		[bookmark: pgfId-229471]Panel Position

  
         		[bookmark: pgfId-229473]The location of the Informational panel, either to the left of the Logon box or to the right of it.

  
        

 
         
         		[bookmark: pgfId-229479]Text

  
         		[bookmark: pgfId-229481]The text that appears in the Informational panel. You can enter a maximum of 256 characters.

  
        

 
         
         		[bookmark: pgfId-229487]Logo Image

  
         		[bookmark: pgfId-229489]The File policy object that identifies the logo image you want to include in the Informational panel, if any. Enter the name of the File object or click Select to select it from a list or to create a new object.

 [bookmark: pgfId-229491]Tip The image file can be a GIF, JPG, or PNG file, and it can be up to 100 kilobytes in size. [bookmark: pgfId-229496]For more information about File objects, see Add and Edit File Object Dialog Boxes.

  
        

 
         
         		[bookmark: pgfId-229502]Image Position

  
         		[bookmark: pgfId-229504]The position of the logo image in the panel, either above the text or below it.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-233700][bookmark: 90276][bookmark: pobjpage_cncpt_SSLVPNCustomizationDialogBoxCopyrightPanel]SSL VPN Customization Dialog Box—Copyright Panel [bookmark: marker-233696][bookmark: marker-233698]

 
     [bookmark: pgfId-233702]Use the Copyright Panel page of the SSL VPN Customization dialog box to customize the appearance of the Copyright panel in the Logon page. The Copyright panel provides your copyright information, appears at the bottom of the page, and is optional.

 
     [bookmark: pgfId-233704]Navigation Path

 
     [bookmark: pgfId-233709]From the Add and Edit SSL VPN Customization Dialog Boxes, select Logon Page > Copyright Panel in the table of contents.

 
     [bookmark: pgfId-233711]Related Topics

 
      
      		 [bookmark: pgfId-233716]Add and Edit SSL VPN Customization Dialog Boxes

 
      		 [bookmark: pgfId-233721]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
     

 
     [bookmark: pgfId-233723]Field Reference

 
     [bookmark: pgfId-233726] 

 
      
       
        
        [bookmark: pgfId-229517]Table 34-31 [bookmark: 90302]SSL VPN Customization Dialog Box—Copyright Panel 

 
        
       
         
         		
           
           [bookmark: pgfId-229523]Element
          
  
         		
           
           [bookmark: pgfId-229525]Description
          
  
        

 
         
         		[bookmark: pgfId-229531]Display Copyright Panel

  
         		[bookmark: pgfId-229533]Whether to display the Copyright panel. The default is to not display the panel. If you select this option, you can configure the panel using the other fields on this page.

  
        

 
         
         		[bookmark: pgfId-229539]Text

  
         		[bookmark: pgfId-229541]The text that appears in the copyright panel. You can enter a maximum of 256 characters.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-233736][bookmark: 90323][bookmark: pobjpage_cncpt_SSLVPNCustomizationDialogBoxFullCustomization]SSL VPN Customization Dialog Box—Full Customization [bookmark: marker-233732][bookmark: marker-233734]

 
     [bookmark: pgfId-233741]Use the Full Customization page of the SSL VPN Customization dialog box to identify your own custom Logon page. The custom page replaces the Logon page settings available on the dialog box. For information on creating a custom Logon page, see Creating Your Own SSL VPN Logon Page for ASA Devices.

 
     [bookmark: pgfId-233743]Navigation Path

 
     [bookmark: pgfId-233748]From the Add and Edit SSL VPN Customization Dialog Boxes, select Logon Page > Full Customization in the table of contents.

 
     [bookmark: pgfId-233750]Related Topics

 
      
      		 [bookmark: pgfId-233755]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
     

 
     [bookmark: pgfId-233757]Field Reference

 
     [bookmark: pgfId-233760] 

 
      
       
        
        [bookmark: pgfId-229554]Table 34-32 [bookmark: 90347]SSL VPN Customization Dialog Box—Full Customization 

 
        
       
         
         		
           
           [bookmark: pgfId-229560]Element
          
  
         		
           
           [bookmark: pgfId-229562]Description
          
  
        

 
         
         		[bookmark: pgfId-229568]Enable Full Customization

  
         		[bookmark: pgfId-229570]Whether you want to use your own custom Logon page. If you enable full customization, all of the other Logon page configuration settings are ignored.

  
        

 
         
         		[bookmark: pgfId-229576]Custom Page

  
         		[bookmark: pgfId-229581]The custom Logon page. You must copy the file to the Security Manager server before specifying it here. Click Browse to select the file. For information on selecting files, see Selecting or Specifying a File or Directory in Security Manager.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-233770][bookmark: 90370][bookmark: pobjpage_cncpt_SSLVPNCustomizationDialogBoxToolbar]SSL VPN Customization Dialog Box—Toolbar [bookmark: marker-233766][bookmark: marker-233768]

 
     [bookmark: pgfId-233772]Use the Toolbar page of the SSL VPN Customization dialog box to customize the appearance of the toolbar in the Portal page. The toolbar appears above the main body of the Portal page and includes a field to allow users to enter URLs to browse. The toolbar is optional.

 
     [bookmark: pgfId-233774]Navigation Path

 
     [bookmark: pgfId-233779]From the Add and Edit SSL VPN Customization Dialog Boxes, select Portal Page > Toolbar in the table of contents.

 
     [bookmark: pgfId-233781]Related Topics

 
      
      		 [bookmark: pgfId-233786]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
     

 
     [bookmark: pgfId-233788]Field Reference

 
     [bookmark: pgfId-233791] 

 
      
       
        
        [bookmark: pgfId-229594]Table 34-33 [bookmark: 90393]SSL VPN Customization Dialog Box—Toolbar 

 
        
       
         
         		
           
           [bookmark: pgfId-229600]Element
          
  
         		
           
           [bookmark: pgfId-229602]Description
          
  
        

 
         
         		[bookmark: pgfId-229608]Display Toolbar

  
         		[bookmark: pgfId-229610]Whether to display the toolbar. The default is to not display the toolbar. If you select this option, you can configure the toolbar using the other fields on this page.

  
        

 
         
         		[bookmark: pgfId-229616]Prompt Box Title

  
         		[bookmark: pgfId-229618]The text of the prompt for the field where users select the protocol of the target web page and enter the URL.

  
        

 
         
         		[bookmark: pgfId-229624]Browse Button Text

  
         		[bookmark: pgfId-229626]The name of the button the user clicks to go to the target URL.

  
        

 
         
         		[bookmark: pgfId-229632]Logout Prompt

  
         		[bookmark: pgfId-229634]The text of the prompt for logging out of the SSL VPN.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-233801][bookmark: 90424][bookmark: pobjpage_cncpt_SSLVPNCustomizationDialogBoxApplications]SSL VPN Customization Dialog Box—Applications [bookmark: marker-233797][bookmark: marker-233799]

 
     [bookmark: pgfId-233803]Use the Applications page of the SSL VPN Customization dialog box to customize the application links that appear in the Portal page. This page lists all the application links that you can display in the navigational panel on the left side of the SSL VPN portal page.

 
     [bookmark: pgfId-233805]Navigation Path

 
     [bookmark: pgfId-233810]From the Add and Edit SSL VPN Customization Dialog Boxes, select Portal Page > Applications in the table of contents.

 
     [bookmark: pgfId-233812]Related Topics

 
      
      		 [bookmark: pgfId-233817]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
     

 
     [bookmark: pgfId-233819]Field Reference

 
     [bookmark: pgfId-233822] 

 
      
       
        
        [bookmark: pgfId-229647]Table 34-34 [bookmark: 90447]SSL VPN Customization Dialog Box—Applications 

 
        
       
         
         		
           
           [bookmark: pgfId-229653]Element
          
  
         		
           
           [bookmark: pgfId-229655]Description
          
  
        

 
         
         		[bookmark: pgfId-229661]No.

 [bookmark: pgfId-229663]Move Up and Move Down buttons (below the table)

  
         		[bookmark: pgfId-229665]The sequential number of the application in the table. To change the order of an application, select it and click the Move Up or Move down buttons to the desired position. The applications appear on the Portal page in the order represented here.

  
        

 
         
         		[bookmark: pgfId-229671]Application

  
         		[bookmark: pgfId-229673]The graphic associated with an application.

  
        

 
         
         		[bookmark: pgfId-229679]Title

  
         		[bookmark: pgfId-229681]The name of the application. Standard applications include Home, Web Applications, Browse Networks, Application Access, and AnyConnect Client. Also listed are the browser plug-ins that you create when you configure the SSL VPN global settings are also available for selection from this page.

 [bookmark: pgfId-229683]Double-click a title to make it editable so that you can change the name.

  
        

 
         
         		[bookmark: pgfId-229689]Enable

  
         		[bookmark: pgfId-229691]Whether the application is included on the Portal page.

  
        

 
         
         		[bookmark: pgfId-229697]Show Navigation Panel

  
         		[bookmark: pgfId-229699]Whether to display the navigation panel in the portal page. If you deselect this option, the list of applications does not appear on the portal.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-233832][bookmark: 90485][bookmark: pobjpage_cncpt_SSLVPNCustomizationDialogBoxCustomPanes]SSL VPN Customization Dialog Box—Custom Panes[bookmark: marker-233828][bookmark: marker-233830]

 
     [bookmark: pgfId-233834]Use the Custom Panes page of the SSL VPN Customization dialog box to customize the appearance of the main body of the Portal page. By creating custom panes and specifying a column layout, you can create a grid of information that can help you present portal information effectively to your end users.

 
     [bookmark: pgfId-233836]Navigation Path

 
     [bookmark: pgfId-233841]From the Add and Edit SSL VPN Customization Dialog Boxes, select Portal Page > Custom Panes in the table of contents.

 
     [bookmark: pgfId-233843]Related Topics

 
      
      		 [bookmark: pgfId-233848]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
     

 
     [bookmark: pgfId-233850]Field Reference

 
     [bookmark: pgfId-233853] 

 
      
       
        
        [bookmark: pgfId-229712]Table 34-35 [bookmark: 90508]SSL VPN Customization Dialog Box—Custom Panes 

 
        
       
         
         		
           
           [bookmark: pgfId-229718]Element
          
  
         		
           
           [bookmark: pgfId-229720]Description
          
  
        

 
         
         		[bookmark: pgfId-229726]Columns table

  
         		[bookmark: pgfId-229728]The list of columns that the main body of the Portal page should be divided into. You define the column based on a percentage of the width of the page. The percentages should add up to 100. If they do not add up to 100, the device will adjust the column widths.

 [bookmark: pgfId-229730]Create the columns as you want them to appear, left to right, on the Portal page.

 
           
           		 [bookmark: pgfId-229732]To add a column, click the Add Row button below the table.

 
           		 [bookmark: pgfId-229734]To edit a column, select it and click the Edit Row button.

 
           		 [bookmark: pgfId-229736]To delete a column, select it and click the Delete Row button.

 
          

  
        

 
         
         		[bookmark: pgfId-229742]Custom Panes table

  
         		[bookmark: pgfId-229744]The custom panes that should appear in the main body of the Portal page. The table shows whether a pane is enabled to appear, the type of pane, its characteristics, and the column and row in which it will appear on the page. The panes can display plain text or include a URL for HTML, image, or RSS links.

 [bookmark: pgfId-229749]For more detailed information about the settings, see Add or Edit Custom Pane Dialog Boxes.

 
           
           		 [bookmark: pgfId-229751]To add a custom pane, click the Add Row button below the table.

 
           		 [bookmark: pgfId-229753]To edit a custom pane, select it and click the Edit Row button.

 
           		 [bookmark: pgfId-229755]To delete a custom pane, select it and click the Delete Row button.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-233865][bookmark: 90545][bookmark: pobjpage_cncpt_SSLVPNCustomizationCustomPaneColumnDialogBox]Add and Edit Column Dialog Boxes [bookmark: marker-233861][bookmark: marker-233863]

 
     [bookmark: pgfId-233867]Use the Add or Edit Column dialog box to create or edit columns in the main body of the Portal page for browser-based clientless SSL VPNs. Enter the desired width of the column as a percentage of the total area in the Percentage field.

 
     [bookmark: pgfId-233869]Navigation Path

 
     [bookmark: pgfId-233874]From the SSL VPN Customization Dialog Box—Custom Panes page, click the Add Row button in the Column table, or select a column and click the Edit Row button.

 
    
 
     
      [bookmark: pgfId-233886][bookmark: 90560][bookmark: pobjpage_cncpt_SSLVPNCustomizationCustomPaneCustomPaneDialogBox]Add or Edit Custom Pane Dialog Boxes [bookmark: marker-233882][bookmark: marker-233884]

 
     [bookmark: pgfId-233888]Use the Add or Edit Custom Pane dialog box to create or edit a pane to display in the main body or the Portal page of a browser-based clientless SSL VPN.

 
     [bookmark: pgfId-233890]Navigation Path

 
     [bookmark: pgfId-233895]From the SSL VPN Customization Dialog Box—Custom Panes page, click the Add Row button in the Custom Pane table, or select a pane and click the Edit Row button.

 
     [bookmark: pgfId-233897]Field Reference

 
     [bookmark: pgfId-233900] 

 
      
       
        
        [bookmark: pgfId-229768]Table 34-36 [bookmark: 90577]Add and Edit Custom Pane Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-229774]Element
          
  
         		
           
           [bookmark: pgfId-229776]Description
          
  
        

 
         
         		[bookmark: pgfId-229782]Enable

  
         		[bookmark: pgfId-229784]Whether to display the custom pane on the Portal page.

  
        

 
         
         		[bookmark: pgfId-229790]Type

  
         		[bookmark: pgfId-229792]The type of content to show in the pane, one of:

 
           
           		 [bookmark: pgfId-229794]Text—Plain text. You can include HTML mark up.

 
           		 [bookmark: pgfId-229796]HTML—HTML content provided by a URL.

 
           		 [bookmark: pgfId-229798]Image—An Image provided by a URL.

 
           		 [bookmark: pgfId-229800]RSS—An RSS feed provided by a URL.

 
          

  
        

 
         
         		[bookmark: pgfId-229806]Show Title

 [bookmark: pgfId-229808]Title

  
         		[bookmark: pgfId-229810]Whether to display a title in the pane. If you select this option, enter the title in the Title field.

  
        

 
         
         		[bookmark: pgfId-229816]Show Border

  
         		[bookmark: pgfId-229818]Whether to display a border around the pane.

  
        

 
         
         		[bookmark: pgfId-229824]Column

 [bookmark: pgfId-229826]Row

  
         		[bookmark: pgfId-229828]The column and row numbers in which the pane should appear. Select or enter the number for each to specify the desired grid location.

  
        

 
         
         		[bookmark: pgfId-229834]Height

  
         		[bookmark: pgfId-229836]The height of the pane in pixels.

  
        

 
         
         		[bookmark: pgfId-229842]URL

 [bookmark: pgfId-229844](HTML, Image, and RSS content only.)

  
         		[bookmark: pgfId-229846]The URL that hosts the content you want to display in the pane.

  
        

 
         
         		[bookmark: pgfId-229852]Text

 [bookmark: pgfId-229854](Text content only.)

  
         		[bookmark: pgfId-229856]The text you want to display in the pane. You can include HTML markup in the text.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-233910][bookmark: 90642][bookmark: pobjpage_cncpt_SSLVPNCustomizationDialogBoxHomePage]SSL VPN Customization Dialog Box—Home Page[bookmark: marker-233906][bookmark: marker-233908]

 
     [bookmark: pgfId-233912]Use the Home Page page in the SSL VPN Customization dialog box to customize the appearance of the URL and file lists on the Portal page and the content of the main body of the Portal page. URL lists are considered to be default elements on the portal home page unless they are explicitly disabled.

 
     [bookmark: pgfId-233914]Navigation Path

 
     [bookmark: pgfId-233919]From the Add and Edit SSL VPN Customization Dialog Boxes, select Portal Page > Home Page in the table of contents.

 
     [bookmark: pgfId-233921]Related Topics

 
      
      		 [bookmark: pgfId-233926]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
     

 
     [bookmark: pgfId-233928]Field Reference

 
     [bookmark: pgfId-233931] 

 
      
       
        
        [bookmark: pgfId-229869]Table 34-37 [bookmark: 90665]SSL VPN Customization Dialog Box—Home Page 

 
        
       
         
         		
           
           [bookmark: pgfId-229875]Element
          
  
         		
           
           [bookmark: pgfId-229877]Description
          
  
        

 
         
         		[bookmark: pgfId-229883]Enable Custom Intranet Web Page

  
         		[bookmark: pgfId-229885]Whether to display a custom Intranet web page, which also enables URL bookmarks to be displayed on the Portal page. If you select this option, you can configure the panel using the other fields on this page.

  
        

 
         
         		[bookmark: pgfId-229891]URL List Mode

  
         		[bookmark: pgfId-229893]How you want to display URL lists on the home page. If you display URL lists, they are displayed in the column cells that are not occupied by custom panes (as configured on Portal Page > Custom Panes). The options are:

 
           
           		 [bookmark: pgfId-229895] Group By Application —Bookmarks are grouped by application type. For example, Web Bookmarks, File Bookmarks.

 
           		 [bookmark: pgfId-229897] No Group —URL lists are shown as separate panes.

 
           		 [bookmark: pgfId-229899] Do Not Display —URL lists are not shown.

 
          

  
        

 
         
         		[bookmark: pgfId-229905]Custom Intranet Web Page URL

  
         		[bookmark: pgfId-229907]The URL of the custom web page that you want to be loaded as the home page. This page is displayed in the main body of the Portal page.

 [bookmark: pgfId-229909]If you specify a custom page, the settings on the Custom Panes page are ignored, and bookmark lists appear on the application pages that are accessed through the navigation panel on the left of the Portal page.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-233941][bookmark: 90702][bookmark: pobjpage_cncpt_SSLVPNCustomizationDialogBoxLogoutPage]SSL VPN Customization Dialog Box—Logout Page [bookmark: marker-233937][bookmark: marker-233939]

 
     [bookmark: pgfId-233943]Use the Logout Page page of the SSL VPN Customization dialog box to customize the appearance of the Logout page for browser-based clientless SSL VPNs. The Logout page appears after the user logs out of the VPN.

 
     [bookmark: pgfId-233945]Navigation Path

 
     [bookmark: pgfId-233950]From the Add and Edit SSL VPN Customization Dialog Boxes, select Logout Page in the table of contents.

 
     [bookmark: pgfId-233952]Related Topics

 
      
      		 [bookmark: pgfId-233957]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
     

 
     [bookmark: pgfId-233959]Field Reference

 
     [bookmark: pgfId-233962] 

 
      
       
        
        [bookmark: pgfId-229922]Table 34-38 [bookmark: 90725]SSL VPN Customization Dialog Box—Logout Page 

 
        
       
         
         		
           
           [bookmark: pgfId-229928]Element
          
  
         		
           
           [bookmark: pgfId-229930]Description
          
  
        

 
         
         		[bookmark: pgfId-229936]Title

  
         		[bookmark: pgfId-229938]The text to display in the title panel.

  
        

 
         
         		[bookmark: pgfId-229944]Text

  
         		[bookmark: pgfId-229946]The message to display on the Logout page. Click Preview to see the default logout message. You can enter a maximum of 256 characters.

  
        

 
         
         		[bookmark: pgfId-229952]Show Login Button

 [bookmark: pgfId-229954]Login Button Text

  
         		[bookmark: pgfId-229956]Whether to display the Login button on the page. Displaying the button makes it easier for the user to log back into the portal.

 [bookmark: pgfId-229958]If you enable the button, you can specify the name of the button in the Login Button Text field.

  
        

 
         
         		[bookmark: pgfId-229964]Border Color

  
         		[bookmark: pgfId-229966]The color of the border around the logout box. Click Select to choose a color.

  
        

 
         
         		[bookmark: pgfId-229972]Title Font Color

 [bookmark: pgfId-229974]Title Background Color

  
         		[bookmark: pgfId-229976]The color of the font and background for the title area of the page. Click Select to choose a color.

  
        

 
         
         		[bookmark: pgfId-229982]Font Color

 [bookmark: pgfId-229984]Background Color

  
         		[bookmark: pgfId-229986]The font and background color of the message that appears in the logout box. Click Select to choose a color.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-233980][bookmark: 90774][bookmark: pobjpage_cncpt_SSLVPNGatewayDialogBox]Add or Edit SSL VPN Gateway Dialog Box[bookmark: marker-233970][bookmark: marker-233972][bookmark: marker-233974][bookmark: marker-233976][bookmark: marker-233978]

 
    [bookmark: pgfId-233985]Use the Add or Edit SSL VPN Gateway dialog box to create, copy and edit SSL VPN gateway objects. You use these objects when you are configuring an SSL VPN connection on an IOS device. For more information, see SSL VPN Configuration Wizard—Gateway and Context Page (IOS).

 
    [bookmark: pgfId-233987]An SSL VPN gateway acts as a proxy for connections to protected resources that are accessed through an SSL-encrypted connection between the gateway and a web-enabled browser on a remote device. You can configure only one gateway per SSL VPN.

 
    [bookmark: pgfId-233989]Navigation Path

 
    [bookmark: pgfId-233991]Select Manage > Policy Objects, then select SSL VPN Gateway from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
    [bookmark: pgfId-233993]Related Topics

 
     
     		 [bookmark: pgfId-233998]SSL VPN Configuration Wizard—Gateway and Context Page (IOS)

 
     		 [bookmark: pgfId-234003]General Tab

 
     		 [bookmark: pgfId-234008]Policy Object Manager

 
    

 
    [bookmark: pgfId-234010]Field Reference

 
    [bookmark: pgfId-234013] 

 
     
      
       
       [bookmark: pgfId-229999]Table 34-39 [bookmark: 90817]Add and Edit SSL VPN Gateway Dialog Boxes 

 
       
      
        
        		
          
          [bookmark: pgfId-230005]Element
         
  
        		
          
          [bookmark: pgfId-230007]Description
         
  
       

 
        
        		[bookmark: pgfId-230013]Name

  
        		[bookmark: pgfId-230018]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
       

 
        
        		[bookmark: pgfId-230024]Description

  
        		[bookmark: pgfId-230026]An optional description of the object (up to 1024 characters).

  
       

 
        
        		[bookmark: pgfId-230032]IP Address

  
        		[bookmark: pgfId-230034]The IP address for the gateway, which is the address to which remote users connect:

 
          
          		 [bookmark: pgfId-230036] Use Static IP Address —Specify the address that you want to use. You must also configure this address on an interface on the router.

 
          		 [bookmark: pgfId-230038] Obtained from Interface —Specify the interface role that resolves to a single interface on the device. The IP address configured for the interface is used. This option allows you to identify the external interface you want to use for connections without having to explicitly enter the IP address. If you have to change the address on the interface, you do not have to also reconfigure this object.

 
         

  
       

 
        
        		[bookmark: pgfId-230044]Port

  
        		[bookmark: pgfId-230046]The number of the port that will carry the HTTPS traffic. You can also enter the name of a port list object that specifies the single port number, or click Select to select the object from a list. The default is the HTTPS object, which specifies port 443. If you do not use port 443, you can enter another port number between 1025 and 65535.

  
       

 
        
        		[bookmark: pgfId-230052]Trustpoint

  
        		[bookmark: pgfId-230054]The digital certificate required to establish the secure connection. A self-signed certificate is generated when an SSL VPN gateway is activated.

  
       

 
        
        		[bookmark: pgfId-230060]Enable Gateway

  
        		[bookmark: pgfId-230062]Whether to activate the SSL VPN gateway.

  
       

 
        
        		[bookmark: pgfId-230068]Specify SSL Encryption Algorithms

  
        		[bookmark: pgfId-230070]Whether to restrict the encryption algorithms used for the connection, or to specify a different order of use. The default is to make all algorithms available in this order of preference: 3DES and SHA1, AES and SHA1, RC4 and MD5.

 [bookmark: pgfId-230072]Select the priority order for the algorithms. Select None to eliminate one or two algorithms.

  
       

 
        
        		[bookmark: pgfId-230078]Redirect HTTP Traffic

 [bookmark: pgfId-230080]HTTP Port

  
        		[bookmark: pgfId-230082]Whether to have the gateway redirect HTTP traffic over secure HTTP (HTTPS). Traffic that comes to this port is redirected to the port you specify in the Port field.

 [bookmark: pgfId-230084]Enter the port number for HTTP traffic in the HTTP Port field. You can enter a number or the name of a port list object, or click Select to select an object from a list or to create a new object.

 [bookmark: pgfId-230086]The HTTP port is normally 80. However, you can enter any other number that is used in your network between 1025-65535.

  
       

 
        
        		[bookmark: pgfId-230092]Hostname

  
        		[bookmark: pgfId-230094]The hostname for the gateway.

 
          
          		 [bookmark: pgfId-230096]Do Not Specify—No hostname is assigned; the IP address to the gateway is used.

 
          		 [bookmark: pgfId-230098]Use the host and domain names of the device—These are defined in the  Platform > Device Admin > Hostname policy.

 
          		 [bookmark: pgfId-230100]Use the Object—The hostname is the value defined in a text policy object. Enter the name of the object or click  Select to select it from a list or to create a new object.

 
         

  
       

 
        
        		[bookmark: pgfId-230106]Category

  
        		[bookmark: pgfId-230111]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
        
        		[bookmark: pgfId-230117]Allow Value Override per Device

 [bookmark: pgfId-230119]Overrides

 [bookmark: pgfId-230121]Edit button

  
        		[bookmark: pgfId-230129]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-230131]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-234031][bookmark: 90916][bookmark: pobjpage_cncpt_SSLVPNSmartTunnelListsDialogBox]Add and Edit Smart Tunnel List Dialog Boxes[bookmark: marker-234021][bookmark: marker-234023][bookmark: marker-234025][bookmark: marker-234027][bookmark: marker-234029]

 
    [bookmark: pgfId-234033]Use the Add and Edit Smart Tunnel Lists dialog boxes to create, copy, and edit SSL VPN smart tunnel objects.

 
    [bookmark: pgfId-234038]An SSL VPN smart tunnel list object lists the applications that are eligible for smart tunnel access to a private site. You can configure the clientless settings of an ASA group policy with a smart tunnel list to allow users to access the specified applications through the SSL VPN portal. For an explanation of the types of applications that support smart tunnel access, see Configuring SSL VPN Smart Tunnels for ASA Devices.

 
    [bookmark: pgfId-234040]You can include other SSL VPN smart tunnel list objects in an object. Thus, you can create a smaller set of objects that identify your basic list of applications, then create other objects that create the required combination of applications. For example, you might want all three of your ASA group policies to allow smart tunnel access to applications A and B, but the remaining applications are unique for each group. By creating a single object that specifies A and B, you can include that object in each of the SSL VPN smart tunnel list objects for the group policies, and these objects need only specify their unique applications in the applications table.

 
    [bookmark: pgfId-234042]Navigation Path

 
    [bookmark: pgfId-234044]Select Manage > Policy Objects, then select SSL VPN Smart Tunnel Lists from the Object Type selector. Right-click inside the work area and select New Object, or right-click a row and select Edit Object.

 
    [bookmark: pgfId-234046]Related Topics

 
     
     		 [bookmark: pgfId-234051]ASA Group Policies SSL VPN Clientless Settings

 
     		 [bookmark: pgfId-234056]Configuring SSL VPN Smart Tunnels for ASA Devices

 
     		 [bookmark: pgfId-234061]Policy Object Manager

 
    

 
    [bookmark: pgfId-234063]Field Reference

 
    [bookmark: pgfId-234066] 

 
     
      
       
       [bookmark: pgfId-230144]Table 34-40 [bookmark: 90960]Add and Edit Smart Tunnel Lists Dialog Boxes 

 
       
      
        
        		
          
          [bookmark: pgfId-230150]Element
         
  
        		
          
          [bookmark: pgfId-230152]Description
         
  
       

 
        
        		[bookmark: pgfId-230158]Name

  
        		[bookmark: pgfId-230163]The object name, which can be up to 64 characters. Spaces are not allowed. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
       

 
        
        		[bookmark: pgfId-230169]Description

  
        		[bookmark: pgfId-230171]An optional description of the object.

  
       

 
        
        		[bookmark: pgfId-230177]Smart Tunnel Entries table

  
        		[bookmark: pgfId-230179]The applications to which users will be allowed smart tunnel access through the SSL VPN, including the name of the application and its location on client workstations.

 
          
          		 [bookmark: pgfId-230184]To add an application, click the  Add Row button to open the Add and Edit A Smart Tunnel Entry Dialog Boxes.

 
          		 [bookmark: pgfId-230186]To edit an application, select it and click the  Edit Row button.

 
          		 [bookmark: pgfId-230188]To delete an application, select it and click the  Delete Row button.

 
         

  
       

 
        
        		[bookmark: pgfId-230194]Include Smart Tunnel Lists

  
        		[bookmark: pgfId-230196]The other SSL VPN smart tunnel list objects that you want to include in this object, if any. Enter the names of the objects or click Select to select them from a list or to create new objects. Separate multiple entries with commas.

  
       

 
        
        		[bookmark: pgfId-230202]Category

  
        		[bookmark: pgfId-230207]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
        
        		[bookmark: pgfId-230213]Allow Value Override per Device

 [bookmark: pgfId-230215]Overrides

 [bookmark: pgfId-230217]Edit button

  
        		[bookmark: pgfId-230225]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-230227]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-234078][bookmark: 91021][bookmark: pobjpage_cncpt_SSLVPNSmartTunnelEntryDialogBox]Add and Edit A Smart Tunnel Entry Dialog Boxes[bookmark: marker-234074][bookmark: marker-234076]

 
     [bookmark: pgfId-234080]Use the Add and Edit A Smart Tunnel Entry dialog boxes to create a new smart tunnel entry or edit an existing entry in the table in the SSL VPN Smart Tunnel Lists dialog box.

 
     [bookmark: pgfId-234082]Navigation Path

 
     [bookmark: pgfId-234087]From Add and Edit Smart Tunnel List Dialog Boxes, click the Add Row button beneath the Smart Tunnel Entries table, or select an entry and click the Edit Row button.

 
     [bookmark: pgfId-234089]Related Topics

 
      
      		 [bookmark: pgfId-234094]Configuring SSL VPN Smart Tunnels for ASA Devices

 
      		 [bookmark: pgfId-234099]Policy Object Manager

 
     

 
     [bookmark: pgfId-234101]Field Reference

 
     [bookmark: pgfId-234104] 

 
      
       
        
        [bookmark: pgfId-230240]Table 34-41 [bookmark: 91047]Add and Edit Smart Tunnel Entry Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-230246]Element
          
  
         		
           
           [bookmark: pgfId-230248]Description
          
  
        

 
         
         		[bookmark: pgfId-230254]App Name

  
         		[bookmark: pgfId-230256]The name of the application to which you are allowing smart tunnel access. The name can be up to 64 characters. Consider including the version number of the application if you are allowing more than one version smart tunnel access.

  
        

 
         
         		[bookmark: pgfId-230262]App Path

  
         		[bookmark: pgfId-230264]The filename and optionally, the path, of the application. This entry can be up to 128 characters. Use one of the following:

 
           
           		 [bookmark: pgfId-230266]Filename—For example,  outlook.exe . By only specifying the file name, it does not matter where users install the application on their workstations. However, the file name must match exactly.

 
           		 [bookmark: pgfId-230268]Full path and filename—For example,  C:\Program Files\Microsoft Office\OFFICE11\OUTLOOK.EXE . This allows the application smart tunnel access only if it is installed in the specified directory, which you can use to enforce organizational standards.

 
          

 [bookmark: pgfId-230270]Tips

 
           
           		 [bookmark: pgfId-230272]If you specify the full path, and the smart tunnel application stops working after it had been working for a while, it is likely that a product upgrade changed the installation path. Add a new entry that accounts for the new path.

 
           		 [bookmark: pgfId-230274]If you are granting smart tunnel access to an application that is started from the command line, create one entry for  cmd.exe (the Windows command line), and another entry for the application.

 
          

  
        

 
         
         		[bookmark: pgfId-230280]Platform

  
         		[bookmark: pgfId-230282]Specify the host operating system of the application:

 
           
           		 [bookmark: pgfId-230284]Windows

 
           		 [bookmark: pgfId-230286]Mac

 
          

  
        

 
         
         		[bookmark: pgfId-230292]Hash Value

  
         		[bookmark: pgfId-230294](Optional) The hash value for the application. By specifying a hash value, you can ensure that the user does not rename another application to use a supported filename and thus start an unsupported and undesired application over the smart tunnel.

 [bookmark: pgfId-230298]To obtain the hash value, enter the checksum of the application (that is, the checksum of the executable file) into a utility that calculates a hash using the SHA-1 algorithm. One example of such a utility is the Microsoft File Checksum Integrity Verifier (FCIV), which is available at http://support.microsoft.com/kb/841290/. Place a temporary copy of the application to be hashed on a path that contains no spaces (for example, c:\temp) and then enter fciv.exe -sha1 application at the command line (for example, fciv.exe -sha1 c:\msimn.exe) to display the SHA-1 hash. Copy and paste the value into this field.

 [bookmark: pgfId-230300]The SHA-1 hash is always 40 hexadecimal characters. Before authorizing an application for smart tunnel access, clientless SSL VPN calculates the hash of the application matching the App Name. It qualifies the application for smart tunnel access if the result matches the value of hash.

 [bookmark: pgfId-230302]Because the checksum varies with each version or patch of an application, the hash you enter can match only one version or patch on the remote host. To specify a hash for more than one version of an application, create a unique smart tunnel entry for each hash value.

 [bookmark: pgfId-230304]Tip Hash values require maintenance. You must update the smart tunnel list if you want to support future versions or patches of an application for which you supply a hash value. A sudden problem with smart tunnel access might be an indication that the application list containing hash values is not up-to-date with an application upgrade. You can avoid this problem by not entering a hash.  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-234122][bookmark: 91106][bookmark: pobjpage_cncpt_SSLVPNSmartTunnelNetworkListsDialogBox]Add and Edit Smart Tunnel Network Lists Dialog Boxes[bookmark: marker-234112][bookmark: marker-234114][bookmark: marker-234116][bookmark: marker-234118][bookmark: marker-234120]

 
    [bookmark: pgfId-234124]Beginning from Security Manager version 4.7, you can use the Add and Edit Smart Tunnel Network Lists dialog boxes to create and edit a list of hosts that you can use for configuring smart tunnel policies.

 
    [bookmark: pgfId-234126]Navigation Path

 
    [bookmark: pgfId-234128]Select Manage > Policy Objects, then select SSL VPN Smart Tunnel Network Lists from the Object Type selector. Right-click inside the work area and select New Object, or right-click a row and select Edit Object. Alternatively, you can click the Add (+)button to add a new object, or click the Edit (pencil) button to edit an object.

 
    [bookmark: pgfId-234130]Related Topics

 
     
     		 [bookmark: pgfId-234135]ASA Group Policies SSL VPN Clientless Settings

 
     		 [bookmark: pgfId-234140]Configuring SSL VPN Smart Tunnels for ASA Devices

 
     		 [bookmark: pgfId-234145]Policy Object Manager

 
     		 [bookmark: pgfId-234150]Add and Edit A Smart Tunnel Network List Entry Dialog Box

 
    

 
    [bookmark: pgfId-234152]Field Reference

 
    [bookmark: pgfId-234155] 

 
     
      
       
       [bookmark: pgfId-230317]Table 34-42 [bookmark: 91152]Add and Edit Smart Tunnel Network Lists Dialog Boxes 

 
       
      
        
        		
          
          [bookmark: pgfId-230323]Element
         
  
        		
          
          [bookmark: pgfId-230325]Description
         
  
       

 
        
        		[bookmark: pgfId-230331]Name

  
        		[bookmark: pgfId-230336]The smart tunnel network list object name that you use to apply to the tunnel policy. The name can be up to 64 characters. Spaces are not allowed. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
       

 
        
        		[bookmark: pgfId-230342]Description

  
        		[bookmark: pgfId-230344]An optional description of the network list object.

  
       

 
        
        		[bookmark: pgfId-230350]Smart Tunnel Network List Entries table

  
        		[bookmark: pgfId-230352]The host mask or IP address of the network to which applications will be allowed smart tunnel access through the SSL VPN.

 
          
          		 [bookmark: pgfId-230357]To add an entry, click the  Add Row button to open the Add and Edit A Smart Tunnel Entry Dialog Boxes.

 
          		 [bookmark: pgfId-230359]To edit an entry, select it and click the  Edit Row button.

 
          		 [bookmark: pgfId-230361]To delete an entry, select it and click the  Delete Row button.

 
         

  
       

 
        
        		[bookmark: pgfId-230367]Include Other Lists

  
        		[bookmark: pgfId-230369]The other SSL VPN smart tunnel network list objects that you want to include in this object, if any. Enter the names of the objects or click Select to select them from a list or to create new objects. Separate multiple entries with commas.

  
       

 
        
        		[bookmark: pgfId-230375]Category

  
        		[bookmark: pgfId-230380]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
        
        		[bookmark: pgfId-230386]Allow Value Override per Device

 [bookmark: pgfId-230388]Overrides

 [bookmark: pgfId-230390]Edit button

  
        		[bookmark: pgfId-230398]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-230400]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-234167][bookmark: 91214][bookmark: pobjpage_cncpt_SSLVPNSmartTunnelNetworkListsEntryDialogBox]Add and Edit A Smart Tunnel Network List Entry Dialog Box[bookmark: marker-234163][bookmark: marker-234165]

 
     [bookmark: pgfId-234169]Use the Add and Edit A Smart Tunnel Network List Entry dialog box to create a new smart tunnel network list entry or edit an existing entry in the table in the SSL VPN Smart Tunnel Network Lists dialog box.

 
     [bookmark: pgfId-234171]Navigation Path

 
     [bookmark: pgfId-234176]From Add and Edit Smart Tunnel List Dialog Boxes, click the Add Row button beneath the Smart Tunnel Network List Entries table, or select an entry and click the Edit Row button.

 
     [bookmark: pgfId-234178]Related Topics

 
      
      		 [bookmark: pgfId-234183]Add and Edit Smart Tunnel Network Lists Dialog Boxes

 
      		 [bookmark: pgfId-234188]ASA Group Policies SSL VPN Clientless Settings

 
      		 [bookmark: pgfId-234193]Configuring SSL VPN Smart Tunnels for ASA Devices

 
      		 [bookmark: pgfId-234198]Policy Object Manager

 
     

 
     [bookmark: pgfId-234200]Field Reference

 
     [bookmark: pgfId-234203] 

 
      
       
        
        [bookmark: pgfId-230413]Table 34-43 [bookmark: 91247]Add and Edit Smart Tunnel Entry Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-230419]Element
          
  
         		
           
           [bookmark: pgfId-230421]Description
          
  
        

 
         
         		[bookmark: pgfId-230427]Host

  
         		[bookmark: pgfId-230429]The host mask that will be part of the smart tunnel network list entry.

  
        

 
         
         		[bookmark: pgfId-230435]IP Address

  
         		[bookmark: pgfId-230437]The IP address of the host that will be part of the smart tunnel network list entry.

  
        

 
         
         		[bookmark: pgfId-230443]Subnet Mask

  
         		[bookmark: pgfId-230445]The subnet mask for the specified IP address.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-234223][bookmark: 91274][bookmark: pobjpage_cncpt_SSLVPNSmartTunnelAutoSignonListsDialogBox]Add and Edit Smart Tunnel Auto Signon List Dialog Boxes[bookmark: marker-234211][bookmark: marker-234213][bookmark: marker-234215][bookmark: marker-234217][bookmark: marker-234219][bookmark: marker-234221]

 
    [bookmark: pgfId-234225]Use the Add and Edit Smart Tunnel Auto Signon Lists dialog boxes to create, copy, and edit SSL VPN smart tunnel auto sign-on objects.

 
    [bookmark: pgfId-234227]Smart Tunnel Auto Sign-on is a single sign-on method for Clientless SSL VPN users. It passes the login credentials (username and password) to internal servers for authentication using NTLM authentication, HTTP Basic authentication, or both. Smart Tunnel Auto Sign-on is supported on ASA 5500 devices running software version 7.1(1) and later.

 
    [bookmark: pgfId-234232]An SSL VPN smart tunnel auto sign-on list object identifies the servers for which to automate the submission of login credentials during smart tunnel setup. You can configure the clientless settings of an ASA group policy with a smart tunnel auto sign-on list if you want to reissue the user credentials when the user establishes a smart tunnel connection to a server. For an explanation of the types of applications that support smart tunnel access, see Configuring SSL VPN Smart Tunnels for ASA Devices.

 
    [bookmark: pgfId-234234]You can include other SSL VPN smart tunnel auto sign-on list objects in an object. Thus, you can create a set of objects that identify your basic list of servers and include those objects in another object that expands upon that list of servers.

 
    [bookmark: pgfId-234236]Navigation Path

 
    [bookmark: pgfId-234238]Select Manage > Policy Objects, then select SSL VPN Smart Tunnel Auto Signon Lists from the Object Type selector. Right-click inside the work area and select New Object, or right-click a row and select Edit Object.

 
    [bookmark: pgfId-234240]Related Topics

 
     
     		 [bookmark: pgfId-234245]ASA Group Policies SSL VPN Clientless Settings

 
     		 [bookmark: pgfId-234250]Configuring SSL VPN Smart Tunnels for ASA Devices

 
     		 [bookmark: pgfId-234255]Policy Object Manager

 
    

 
    [bookmark: pgfId-234257]Field Reference

 
    [bookmark: pgfId-234260] 

 
     
      
       
       [bookmark: pgfId-230458]Table 34-44 [bookmark: 91321]Add and Edit Smart Tunnel Auto Signon List Dialog Boxes 

 
       
      
        
        		
          
          [bookmark: pgfId-230464]Element
         
  
        		
          
          [bookmark: pgfId-230466]Description
         
  
       

 
        
        		[bookmark: pgfId-230472]Name

  
        		[bookmark: pgfId-230477]The object name, which can be up to 64 characters. Spaces are not allowed. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
       

 
        
        		[bookmark: pgfId-230483]Description

  
        		[bookmark: pgfId-230485]An optional description of the object.

  
       

 
        
        		[bookmark: pgfId-230491]Smart Tunnel Auto Signon Entries table

  
        		[bookmark: pgfId-230493]The servers for which to automate the submission of login credentials during smart tunnel setup.

 
          
          		 [bookmark: pgfId-230498]To add servers, click the  Add Row button to open the Add and Edit Smart Tunnel Auto Signon Entry Dialog Boxes.

 
          		 [bookmark: pgfId-230500]To edit an entry, select it and click the  Edit Row button.

 
          		 [bookmark: pgfId-230502]To delete an entry, select it and click the  Delete Row button.

 
         

  
       

 
        
        		[bookmark: pgfId-230508]Include Other Lists

  
        		[bookmark: pgfId-230510]The other smart tunnel auto sign-on list objects that you want to include in this object, if any. Enter the names of the objects or click Select to select them from a list or to create new objects. Separate multiple entries with commas.

  
       

 
        
        		[bookmark: pgfId-230516]Category

  
        		[bookmark: pgfId-230521]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
        
        		[bookmark: pgfId-230527]Allow Value Override per Device

 [bookmark: pgfId-230529]Overrides

 [bookmark: pgfId-230531]Edit button

  
        		[bookmark: pgfId-230539]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-230541]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-234274][bookmark: 91382][bookmark: pobjpage_cncpt_SSLVPNSmartTunnelAutoSignonEntryDialogBox]Add and Edit Smart Tunnel Auto Signon Entry Dialog Boxes[bookmark: marker-234268][bookmark: marker-234270][bookmark: marker-234272]

 
     [bookmark: pgfId-234276]Use the Add and Edit Smart Tunnel Auto Signon Entry dialog boxes to create a new smart tunnel entry or edit an existing entry in the table in the SSL VPN Smart Tunnel Auto Signon List dialog box.

 
     [bookmark: pgfId-234278]Navigation Path

 
     [bookmark: pgfId-234283]From Add and Edit Smart Tunnel Auto Signon List Dialog Boxes, click the Add Row button beneath the Smart Tunnel Auto Signon Entries table, or select an entry and click the Edit Row button.

 
     [bookmark: pgfId-234285]Related Topics

 
      
      		 [bookmark: pgfId-234290]Configuring SSL VPN Smart Tunnels for ASA Devices

 
      		 [bookmark: pgfId-234295]Policy Object Manager

 
     

 
     [bookmark: pgfId-234297]Field Reference

 
     [bookmark: pgfId-234300] 

 
      
       
        
        [bookmark: pgfId-230554]Table 34-45 [bookmark: 91410]Add and Edit Smart Tunnel Auto Signon Entry Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-230560]Element
          
  
         		
           
           [bookmark: pgfId-230562]Description
          
  
        

 
         
         		[bookmark: pgfId-230568]Matching Mode:

 
           
           		 [bookmark: pgfId-230570]Host

 
           		 [bookmark: pgfId-230572]IP Address

 
          

  
         		[bookmark: pgfId-230574]Identifies the server for which to automate the submission of login credentials during smart tunnel setup. Use Host to specify the server by host name or wildcard mask, and use IP Address to specify the server by IP address and netmask:

 
           
           		 [bookmark: pgfId-230576] Host —Select Host and then enter the host name or a wildcard mask in the Hostname Mask field that identifies the host for which to automate the submission of login credentials during smart tunnel setup.

 
          

 [bookmark: pgfId-230578]Note Using this option protects the configuration from dynamic changes to IP addresses.

 
           
           		 [bookmark: pgfId-230580] IP Address —Select IP Address and then enter the IP address and netmask of the host or sub-network of hosts for which to automate the submission of login credentials during smart tunnel setup.

 
          

 [bookmark: pgfId-230582]Note Firefox requires the administrator to specify hosts using an exact host name or IP address (instead of a host mask with wild cards, a subnet using IP addresses, or a netmask). For example, within Firefox, you cannot enter *.cisco.com and expect auto sign-on to host email.cisco.com.

  
        

 
         
         		[bookmark: pgfId-230588]Port Number

  
         		[bookmark: pgfId-230590]The port that performs auto sign-on. For Firefox, if no port number is specified, auto sign-on is performed on HTTP and HTTPS, accessed by default port numbers 80 and 443 respectively.

  
        

 
         
         		[bookmark: pgfId-230596]Authentication Realm

  
         		[bookmark: pgfId-230598]The realm for the authentication. The Authentication Realm is associated with the protected area of the website and is passed back to the browser either in the authentication prompt or in the HTTP headers during authentication. After auto sign-on is configured and a realm string is specified, users can configure the realm string on a web application (such as Outlook Web Access) and access web applications without signing on.

  
        

 
         
         		[bookmark: pgfId-230604]Use Domain

  
         		[bookmark: pgfId-230606]Select this option to add the Windows domain to the username if authentication requires it. If you use this option, be sure to specify the domain name when assigning the smart tunnel list to one or more group policies.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-234324][bookmark: 91458][bookmark: pobjpage_cncpt_UserGroupDialogBox]Add or Edit User Group Dialog Box [bookmark: marker-234310][bookmark: marker-234312][bookmark: marker-234314][bookmark: marker-234316][bookmark: marker-234318][bookmark: marker-234320][bookmark: marker-234322]

 
    [bookmark: pgfId-234326]Use the Add or Edit User Group dialog box to create or edit a user group object. User group objects are used in Easy VPN topologies, remote access VPNs, and SSL VPNs for IOS devices.

 
    [bookmark: pgfId-234328]When you configure a remote access VPN, SSL VPN, or Easy VPN server, you can create user groups to which remote clients belong. The remote clients must be configured with the same group name as the user group on the VPN server in order to connect to the server; otherwise, no connection is established. When the remote client connects to the VPN server successfully, the group policies for that particular user group are pushed to all remote clients belonging to the user group.

 
    [bookmark: pgfId-234330]For more information about user groups, see:

 
     
     		 [bookmark: pgfId-234335]Configuring User Group Policies

 
     		 [bookmark: pgfId-234340]Configuring a User Group Policy for Easy VPN

 
     		 [bookmark: pgfId-234345]Configuring an SSL VPN Policy (IOS)

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-234347]Note You must select the technology (Easy VPN/Remote Access VPN, or SSL VPN) for which you are creating the user group object. If you are editing an existing user group object, the technology is already selected and you cannot change it. Depending on the selected technology, the appropriate settings are available for configuration.


    
     

    

    

 
    [bookmark: pgfId-234349]Navigation Path

 
    [bookmark: pgfId-234351]Select Manage > Policy Objects, then select User Groups from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-234353]Tip You can also access this dialog box from the Remote Access VPN > IPSec VPN > User Groups or the Remote Access VPN > SSL VPN policies.


    
     

    

    

 
    [bookmark: pgfId-234355]Related Topics

 
     
     		 [bookmark: pgfId-234360]Policy Object Manager

 
    

 
    [bookmark: pgfId-234362]Field Reference

 
    [bookmark: pgfId-234365] 

 
     
      
       
       [bookmark: pgfId-230619]Table 34-46 [bookmark: 91518]User Group Dialog Box 

 
       
      
        
        		
          
          [bookmark: pgfId-230625]Element
         
  
        		
          
          [bookmark: pgfId-230627]Description
         
  
       

 
        
        		[bookmark: pgfId-230633]Name

  
        		[bookmark: pgfId-230638]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
       

 
        
        		[bookmark: pgfId-230644]Description

  
        		[bookmark: pgfId-230646]An optional description of the object.

  
       

 
        
        		 [bookmark: pgfId-230652]Settings Pane

 [bookmark: pgfId-230654]The body of the dialog box is a pane with a table of contents on the left and settings related to the item selected in the table of contents on the right.

 [bookmark: pgfId-230656]You must first configure technology settings, then you can select items from the table of contents on the left and configure the options you require. Your selections on the Technology page control which options are available on these pages and in the table of contents.

 [bookmark: pgfId-230658]The top folders in the table of contents represent the VPN technologies or other settings that you can configure, and are explained next.

  
       

 
        
        		[bookmark: pgfId-230666]Technology settings

  
        		[bookmark: pgfId-230668]These settings control what you can define in the group policy:

 
          
          		 [bookmark: pgfId-230670] Group Name —The name for the user group (up to 128 characters). Configure the same user group name within the remote client or device to ensure that the appropriate group attributes are downloaded.

 
          		 [bookmark: pgfId-230672] Technology —The types of VPN for which this object defines group policies. You cannot change this option when editing an object, or if you are creating the user group object while editing a VPN policy. You can configure settings for Easy VPN/Remote Access IPSec VPN or SSL VPN, but not both.

 
         

  
       

 
        
        		[bookmark: pgfId-230678]Easy VPN/Remote Access IPSec VPN pages

  
        		[bookmark: pgfId-230680]When you select Easy VPN/Remote Access IPSec VPN as the technology, you can configure settings on the following pages:

 
          
          		 [bookmark: pgfId-230685]User Group Dialog Box—General Settings

 
          		 [bookmark: pgfId-230690]User Group Dialog Box—DNS/WINS Settings

 
          		 [bookmark: pgfId-230695]User Group Dialog Box—Split Tunneling

 
          		 [bookmark: pgfId-230700]User Group Dialog Box—IOS Client Settings

 
          		 [bookmark: pgfId-230705]User Group Dialog Box—IOS Xauth Options

 
          		 [bookmark: pgfId-230710]User Group Dialog Box—IOS Client VPN Software Update

 
          		 [bookmark: pgfId-230715]User Group Dialog Box—Advanced PIX Options

 
         

  
       

 
        
        		[bookmark: pgfId-230721]SSL VPN pages

  
        		[bookmark: pgfId-230723]When you select SSL VPN as the technology, you can configure settings on the following pages:

 
          
          		 [bookmark: pgfId-230728]User Group Dialog Box—Clientless Settings

 
          		 [bookmark: pgfId-230733]User Group Dialog Box—Thin Client Settings

 
          		 [bookmark: pgfId-230738]User Group Dialog Box—SSL VPN Full Tunnel Settings

 
          		 [bookmark: pgfId-230743]User Group Dialog Box—DNS/WINS Settings

 
          		 [bookmark: pgfId-230748]User Group Dialog Box—SSL VPN Split Tunneling

 
          		 [bookmark: pgfId-230753]User Group Dialog Box—Browser Proxy Settings

 
          		 [bookmark: pgfId-230758]User Group Dialog Box—SSL VPN Connection Settings

 
         

  
       

 
        
        		[bookmark: pgfId-230764]Category

  
        		[bookmark: pgfId-230769]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-234383][bookmark: 91619][bookmark: pobjpage_cncpt_UserGroupDialogBoxGeneralSettings]User Group Dialog Box—General Settings [bookmark: marker-234373][bookmark: marker-234375][bookmark: marker-234377][bookmark: marker-234379][bookmark: marker-234381]

 
     [bookmark: pgfId-234385]The general settings you configure for your user group include the authentication method, IP address pool information, and connection attributes for PIX 6.3 Firewalls.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-234387]Note These settings apply in Easy VPN and remote access IPSec VPN configurations.


     
      

     

     

 
     [bookmark: pgfId-234389]Navigation Path

 
     [bookmark: pgfId-234394]Select General from the table of contents in the Add or Edit User Group Dialog Box.

 
     [bookmark: pgfId-234396]Field Reference

 
     [bookmark: pgfId-234399] 

 
      
       
        
        [bookmark: pgfId-230782]Table 34-47 [bookmark: 91649]User Group Dialog Box—General Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-230788]Element
          
  
         		
           
           [bookmark: pgfId-230790]Description
          
  
        

 
         
         		[bookmark: pgfId-230796]Preshared Key

  
         		[bookmark: pgfId-230798]The preshared key that will be used to authenticate the clients associated to the user group.

 [bookmark: pgfId-230800]Note You do not have to enter a preshared key if you are using digital certificates for group authentication.

 [bookmark: pgfId-230802]In regular IPsec VPNs, preshared keys allow for one or more peers to use individual shared secrets to authenticate encrypted tunnels. A preshared key must be configured on each participating peer. If one of the participating peers is not configured with the same preshared key, the IKE SA cannot be established.

 [bookmark: pgfId-230804]In Easy VPN authentication, the same Easy VPN server key is used for the spoke configuration to ensure that the server/client keys match.

 [bookmark: pgfId-230806]In remote access IPSec VPN authentication, the same key is used to negotiate a VPN connection between the remote access VPN server and the remote clients.

  
        

 
         
         		[bookmark: pgfId-230812]IP Address Pool Subnet/Ranges

  
         		[bookmark: pgfId-230814]The IP address ranges for a local pool that will be used to allocate an internal IP address to a client. Remote clients are assigned IP addresses from this pool. Separate multiple entries with commas. The default is 172.16.0.1-172.16.4.254.

  
        

 
         
         		[bookmark: pgfId-230820]Backup Servers IP Address

  
         		[bookmark: pgfId-230822]The IP address of the servers to be used as backups for the Easy VPN or remote access IPSec VPN server. The router tries to connect to these servers if the primary connection to the Easy VPN or remote access VPN server fails. Separate multiple entries with commas.

  
        

 
         
         		[bookmark: pgfId-230828]PIX Only Attributes

  
         		[bookmark: pgfId-230830]These attributes apply only to PIX 6.3 devices.

 
           
           		 [bookmark: pgfId-230832] Idle Time —The timeout period for VPN connections, in seconds. If no communication occurs on the connection during this period, the device terminates the connection. The minimum is 60 seconds, and the maximum time is 35791394 minutes. The default is 30 minutes.

 
           		 [bookmark: pgfId-230834] Max Time —The maximum amount of time for VPN connections, in seconds. At the end of the time, the device terminates the connection. The minimum is 60 seconds, and the maximum is 35791394 minutes. There is no default.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-234417][bookmark: 91691][bookmark: pobjpage_cncpt_UserGroupDialogBoxDNSWINSSettings]User Group Dialog Box—DNS/WINS Settings [bookmark: marker-234407][bookmark: marker-234409][bookmark: marker-234411][bookmark: marker-234413][bookmark: marker-234415]

 
     [bookmark: pgfId-234419]Configure the DNS/WINS settings for your user group to define the DNS and WINS servers and the domain name that should be pushed to clients associated with the user group.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-234421]Note The DNS/WINS settings you configure for a user group apply in Easy VPN, remote access VPN, and SSL VPN configurations.


     
      

     

     

 
     [bookmark: pgfId-234423]Navigation Path

 
     [bookmark: pgfId-234428]Select DNS/WINS from the table of contents in the Add or Edit User Group Dialog Box.

 
     [bookmark: pgfId-234430]Field Reference

 
     [bookmark: pgfId-234433] 

 
      
       
        
        [bookmark: pgfId-230847]Table 34-48 [bookmark: 91721]User Group Dialog Box—DNS/WINS Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-230853]Element
          
  
         		
           
           [bookmark: pgfId-230855]Description
          
  
        

 
         
         		[bookmark: pgfId-230861]Primary DNS Server

  
         		[bookmark: pgfId-230863]The IP address of the primary DNS server for the group. Enter the IP address or the name of a network/host object, or click Select to select an object from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-230869]Secondary DNS Server

  
         		[bookmark: pgfId-230871]The IP address of the secondary DNS server for the group. Enter the IP address or the name of a network/host object, or click Select to select an object from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-230877]Domain Name

  
         		[bookmark: pgfId-230879]The domain name of the DNS server you want to configure on the user group.

  
        

 
         
         		[bookmark: pgfId-230885]Primary WINS Server

  
         		[bookmark: pgfId-230887]The IP address of the primary WINS server for the group. Enter the IP address or the name of a network/host object, or click Select to select an object from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-230893]Secondary WINS Server

  
         		[bookmark: pgfId-230895]The IP address of the primary WINS server for the group. Enter the IP address or the name of a network/host object, or click Select to select an object from a list or to create a new object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-234451][bookmark: 91761][bookmark: pobjpage_cncpt_UserGroupDialogBoxSplitTunneling]User Group Dialog Box—Split Tunneling [bookmark: marker-234441][bookmark: marker-234443][bookmark: marker-234445][bookmark: marker-234447][bookmark: marker-234449]

 
     [bookmark: pgfId-234453]Split tunneling lets a remote client conditionally direct packets over an IPsec or SSL VPN tunnel in encrypted form or to a network interface in clear text form. With split tunneling enabled, packets not bound for destinations on the other side of the tunnel do not have to be encrypted, sent across the tunnel, decrypted, and then routed to a final destination.

 
     [bookmark: pgfId-234455]The split tunneling policy is applied to a specific network. When you configure split tunneling, you can transmit both secured and unsecured traffic on the same interface. You must specify which traffic will be secured and what the destination of that traffic is, so that you have a secure tunnel to the central site, while the clear (unsecured) traffic is transmitted across the public network.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-234457]Tip For optimum security, we recommend that you not enable split tunneling.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-234462]Note Split tunneling can be applied in Easy VPN, remote access VPN, and SSL VPN configurations. For information about configuring split tunneling for SSL VPN, see User Group Dialog Box—SSL VPN Split Tunneling.


     
      

     

     

 
     [bookmark: pgfId-234464]Navigation Path

 
     [bookmark: pgfId-234469]Select Split Tunneling from the table of contents in the Add or Edit User Group Dialog Box when configuring Easy VPN/Remote Access IPSec VPN.

 
     [bookmark: pgfId-234471]Field Reference

 
     [bookmark: pgfId-234474] 

 
      
       
        
        [bookmark: pgfId-230908]Table 34-49 [bookmark: 91794]User Group Dialog Box—Split Tunneling 

 
        
       
         
         		
           
           [bookmark: pgfId-230914]Element
          
  
         		
           
           [bookmark: pgfId-230916]Description
          
  
        

 
         
         		[bookmark: pgfId-230922]Split Tunneling

  
         		[bookmark: pgfId-230924]The networks for which you want to tunnel traffic. Traffic to all other addresses travels in the clear and is routed by the remote user’s Internet service provider. You can identify the networks using one of these options:

 
           
           		 [bookmark: pgfId-230929] Protected Networks —Specify the networks by network addresses. Enter the addresses or network/host objects, or click  Select to select the objects from a list or to create new objects. For information on specifying addresses, see Specifying IP Addresses During Policy Definition.

 
           		 [bookmark: pgfId-230931] ACL —Specify the networks using an extended access control list policy object. Enter the name of the object or click  Select to select the object from a list or to create a new object.

 
          

  
        

 
         
         		[bookmark: pgfId-230937]Split DNS

  
         		[bookmark: pgfId-230939]A list of domain names that must be tunneled or resolved to the private network. All other names will be resolved through the public DNS server.

 [bookmark: pgfId-230941]You can enter multiple domain names separated by commas.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-234492][bookmark: 91826][bookmark: pobjpage_cncpt_UserGroupDialogBoxIOSClientSettings]User Group Dialog Box—IOS Client Settings[bookmark: marker-234482][bookmark: marker-234484][bookmark: marker-234486][bookmark: marker-234488][bookmark: marker-234490]

 
     [bookmark: pgfId-234494]Configure IOS client settings to define Cisco IOS specific options for your user group, including firewall settings for VPN clients.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-234496]Note These settings apply in Easy VPN and remote access IPSec VPN configurations.


     
      

     

     

 
     [bookmark: pgfId-234498]Navigation Path

 
     [bookmark: pgfId-234503]Select Client Settings (IOS) from the table of contents in the Add or Edit User Group Dialog Box.

 
     [bookmark: pgfId-234505]Field Reference

 
     [bookmark: pgfId-234508] 

 
      
       
        
        [bookmark: pgfId-230954]Table 34-50 [bookmark: 91856]User Group Dialog Box—Client Settings (IOS) 

 
        
       
         
         		
           
           [bookmark: pgfId-230960]Element
          
  
         		
           
           [bookmark: pgfId-230962]Description
          
  
        

 
         
         		[bookmark: pgfId-230968]Enable Firewall Are-You-There

 [bookmark: pgfId-230970](Not available on 7600 series or ASR routers.)

  
         		[bookmark: pgfId-230972]This feature may be used if a VPN client is running the Black Ice or Zone Alarm personal firewall.

 [bookmark: pgfId-230974]When selected, it ensures that the personal firewall is running at connection time and throughout the connection. The Firewall-Are-U-There attribute is sent by the Black Ice and Zone Alarm personal firewalls if the server prompts them to do so. If the personal firewall stops running, the connection is terminated. If this feature is enabled and there is no personal firewall running on the server, the connection is never established.

  
        

 
         
         		[bookmark: pgfId-230980]Mode

  
         		[bookmark: pgfId-230982]A Central Policy Push (CPP) firewall policy on a server allows or denies a tunnel on the basis of whether the remote device has a required firewall for a local AAA server.

 [bookmark: pgfId-230984]The Mode option specifies whether the Central Policy Push (CPP) policy is optional or mandatory, as follows:

 
           
           		 [bookmark: pgfId-230986] Optional —If the CPP policy is defined as optional, and is included in the Easy VPN server configuration, the tunnel setup is continued even if the client does not confirm the defined policy.

 
           		 [bookmark: pgfId-230988] Required —If the CPP policy is defined as mandatory and is included in the Easy VPN server configuration, the tunnel setup is allowed only if the client confirms this policy. Otherwise, the tunnel is terminated.

 
          

  
        

 
         
         		[bookmark: pgfId-230994]Firewall Type

  
         		[bookmark: pgfId-230996]The type of firewall that you are making required or optional. The list shows all of the supported firewall software, which includes software from Cisco and Zone Labs.

  
        

 
         
         		[bookmark: pgfId-231002]Policy Type

  
         		[bookmark: pgfId-231004]Specifies the CPP firewall policy type:

 
           
           		 [bookmark: pgfId-231006] Check Presence —Instructs the server to check for the presence of the specified firewall type.

 
           		 [bookmark: pgfId-231008] Central Policy Push —The actual policy, such as the input and output access lists, that must be applied by the specified client firewall type. Specify the following:

 
          

 [bookmark: pgfId-231010] – The access control list to be used. Enter the name of the extended ACL object or click Select to select it from a list or to create a new object.

 [bookmark: pgfId-231012] – The direction of the access control list—Inbound or Outbound.

  
        

 
         
         		[bookmark: pgfId-231018]Include Local LAN

  
         		[bookmark: pgfId-231020]Whether to allow a non split-tunneling connection to access the local LAN at the same time as the client.

  
        

 
         
         		[bookmark: pgfId-231026]Perfect Forward Secrecy

  
         		[bookmark: pgfId-231028]Whether to enable Perfect Forward Secrecy (PFS). If PFS is enabled, the server is configured to notify the client of the central-site policy about whether PFS is required for any IPsec SA. The Diffie-Hellman (D-H) group that is proposed for PFS is the same that was negotiated in Phase 1 of the IKE negotiation.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-234526][bookmark: 91920][bookmark: pobjpage_cncpt_UserGroupDialogBoxIOSXauthOptions]User Group Dialog Box—IOS Xauth Options [bookmark: marker-234516][bookmark: marker-234518][bookmark: marker-234520][bookmark: marker-234522][bookmark: marker-234524]

 
     [bookmark: pgfId-234528]IOS Xauth options configure IKE Extended Authentication (Xauth) user authentication and connection parameters for the user group, including the banner text.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-234530]Note These settings apply in Easy VPN and remote access VPN configurations.


     
      

     

     

 
     [bookmark: pgfId-234532]Navigation Path

 
     [bookmark: pgfId-234537]Select Xauth Options (IOS) from the table of contents in the Add or Edit User Group Dialog Box.

 
     [bookmark: pgfId-234539]Field Reference

 
     [bookmark: pgfId-234542] 

 
      
       
        
        [bookmark: pgfId-231041]Table 34-51 [bookmark: 91950]User Group Dialog Box—IOS Xauth Options 

 
        
       
         
         		
           
           [bookmark: pgfId-231047]Element
          
  
         		
           
           [bookmark: pgfId-231049]Description
          
  
        

 
         
         		[bookmark: pgfId-231055]Banner

  
         		[bookmark: pgfId-231057]The banner text that is displayed to Easy VPN remote clients during Xauth and web-based activation the first time the Easy VPN tunnel is brought up. A maximum of 1024 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-231063]Maximum Logins Per User

  
         		[bookmark: pgfId-231065]The maximum number of connections a user can establish simultaneously. The maximum is 10.

  
        

 
         
         		[bookmark: pgfId-231071]Maximum Connections

  
         		[bookmark: pgfId-231073]The maximum number of client connections to the Easy VPN Server from this group. The maximum is 5000 per group.

  
        

 
         
         		[bookmark: pgfId-231079]Enable Group-Lock

  
         		[bookmark: pgfId-231081]Whether to enable group lock, which requires that the user enter the extended Xauth username in one of the following formats:

 
           
           		 [bookmark: pgfId-231083]username/groupname

 
           		 [bookmark: pgfId-231085]username\groupname

 
           		 [bookmark: pgfId-231087]username@groupname

 
           		 [bookmark: pgfId-231089]username%groupname

 
          

 [bookmark: pgfId-231091]The group that is specified after the delimiter is then compared to the group identifier that is sent during IKE aggressive mode. The groups must match or the connection is rejected.

 [bookmark: pgfId-231093]Note Do not select this option if you are using RSA signature authentication mechanisms such as certificates.

  
        

 
         
         		[bookmark: pgfId-231099]Enable Save Password

  
         		[bookmark: pgfId-231101]Whether to allow users to save their Xauth password locally on the client. On subsequent authentications, users can activate the password by using the check box on the software client or by adding the username and password to the Cisco IOS hardware client profile. After users activate the password, their username and password are sent to the server automatically during Xauth.

 [bookmark: pgfId-231103]This option is useful only if users have static passwords, that is, they are not one-time passwords such as those that are generated by a token.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-234560][bookmark: 91998][bookmark: pobjpage_cncpt_UserGroupDialogBoxIOSClientVPNSoftwareUpdate]User Group Dialog Box—IOS Client VPN Software Update [bookmark: marker-234550][bookmark: marker-234552][bookmark: marker-234554][bookmark: marker-234556][bookmark: marker-234558]

 
     [bookmark: pgfId-234562]Client VPN Software Update (IOS) settings configure, for an IOS VPN client, the platform type, VPN Client revisions, and image URL for each client VPN software package installed, for your user group.

 
     [bookmark: pgfId-234564]The Client Update feature is supported on IOS routers version 12.4(2)T and later, and Catalyst 6500/7600 devices version 12.2(33)SRA and later.

 
      
      		 [bookmark: pgfId-234569]To add a client, click the  Add Row button to open the Add/Edit Client Update Dialog Box.

 
      		 [bookmark: pgfId-234571]To edit a client, select it and click the  Edit Row button.

 
      		 [bookmark: pgfId-234573]To delete a client, select it and click the  Delete Row button.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-234575]Note These settings apply in Easy VPN and remote access VPN configurations.


     
      

     

     

 
     [bookmark: pgfId-234577]Navigation Path

 
     [bookmark: pgfId-234582]Select Client VPN Software Update (IOS) from the table of contents in the Add or Edit User Group Dialog Box.

 
    
 
     
      [bookmark: pgfId-234594][bookmark: 92037][bookmark: pobjpage_cncpt_AddEditClientUpdateDialogBox]Add/Edit Client Update Dialog Box [bookmark: marker-234590][bookmark: marker-234592]

 
     [bookmark: pgfId-234596]Use the Add or Edit Client Update dialog box to configure the platform type, image URL, and VPN Client revisions for a client VPN software package.

 
     [bookmark: pgfId-234598]Navigation Path

 
     [bookmark: pgfId-234603]Open the User Group Dialog Box—IOS Client VPN Software Update, then click Add Row, or select an item in the table and click Edit Row.

 
     [bookmark: pgfId-234605]Related Topics

 
      
      		 [bookmark: pgfId-234610]Add or Edit User Group Dialog Box

 
     

 
     [bookmark: pgfId-234612]Field Reference

 
     [bookmark: pgfId-234615] 

 
      
       
        
        [bookmark: pgfId-231116]Table 34-52 [bookmark: 92060]Add or Edit Client Update Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-231122]Element
          
  
         		
           
           [bookmark: pgfId-231124]Description
          
  
        

 
         
         		[bookmark: pgfId-231130]System Type

  
         		[bookmark: pgfId-231132]The platform on which the IOS VPN client operates.

 
           
           		 [bookmark: pgfId-231134]All Windows (Default)—This option includes any Windows platform for which a VPN client is available.

 
           		 [bookmark: pgfId-231136]Macintosh OS X

 
          

  
        

 
         
         		[bookmark: pgfId-231142]IOS Image URL

  
         		[bookmark: pgfId-231144]Enter the URL from where the client can be downloaded. The URL must start with http:// or https://.

  
        

 
         
         		[bookmark: pgfId-231150]IOS VPN Client Revisions

  
         		[bookmark: pgfId-231152]Enter the revision level of the VPN client. You can specify more than one client revision separated by commas.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-234633][bookmark: 92092][bookmark: pobjpage_cncpt_UserGroupDialogBoxAdvancedPIXOptions]User Group Dialog Box—Advanced PIX Options [bookmark: marker-234623][bookmark: marker-234625][bookmark: marker-234627][bookmark: marker-234629][bookmark: marker-234631]

 
     [bookmark: pgfId-234635]The Advanced PIX Options are specifically for PIX 6.3 Firewalls in your user group.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-234637]Note These settings apply in Easy VPN and remote access VPN configurations.


     
      

     

     

 
     [bookmark: pgfId-234639]Navigation Path

 
     [bookmark: pgfId-234644]Select Advanced Options (PIX) from the table of contents in the Add or Edit User Group Dialog Box.

 
     [bookmark: pgfId-234646]Field Reference

 
     [bookmark: pgfId-234649] 

 
      
       
        
        [bookmark: pgfId-231165]Table 34-53 [bookmark: 92122]User Group Dialog Box—Advanced PIX Options 

 
        
       
         
         		
           
           [bookmark: pgfId-231171]Element
          
  
         		
           
           [bookmark: pgfId-231173]Description
          
  
        

 
         
         		[bookmark: pgfId-231179]User Idle Timeout (sec)

  
         		[bookmark: pgfId-231181]The length of time that a VPN tunnel can remain open without user activity, in seconds. Values range from 60-86400 seconds.

  
        

 
         
         		[bookmark: pgfId-231187]User Authentication Server

  
         		[bookmark: pgfId-231192]The AAA server to which remote devices send user authentication requests. Enter the name of the server group or click Select to select it from a list or to create a new group. See Understanding AAA Server and Server Group Objects.

  
        

 
         
         		[bookmark: pgfId-231198]Enable Device Pass-Through

  
         		[bookmark: pgfId-231200]Whether to use Media Access Control (MAC) addresses to bypass authentication for devices, such as Cisco IP phones, that do not support AAA authentication.

 [bookmark: pgfId-231202]When MAC-based AAA exemption is enabled, the device bypasses the AAA server for traffic that matches both the MAC address of the device and the IP address that was dynamically assigned by a DHCP server. Authorization services are disabled automatically when you bypass authentication. Accounting records continue to be generated (if enabled), but the username is not displayed.

  
        

 
         
         		[bookmark: pgfId-231208]Enable Secure Unit Authentication

  
         		[bookmark: pgfId-231210]Whether to provide increased security when allowing access to the device from a remote client.

 [bookmark: pgfId-231212]With Secure Unit Authentication (SUA), you can use one-time passwords, two-factor authentication, and similar authentication schemes to authenticate the remote device during Extended Authentication (Xauth).

 [bookmark: pgfId-231214]SUA is specified in the VPN policy on the device and is downloaded to the remote client. This enables SUA and determines the connection behavior of the remote client.

  
        

 
         
         		[bookmark: pgfId-231220]Enable User Authentication

  
         		[bookmark: pgfId-231222]Whether to enable Individual User Authentication (IUA), which supports individually authenticating clients on the inside network of the remote access VPN, based on the IP address of each inside client. IUA supports both static and OTP authentication mechanisms.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-234667][bookmark: 92163][bookmark: pobjpage_cncpt_UserGroupDialogBoxClientlessSettings]User Group Dialog Box—Clientless Settings [bookmark: marker-234657][bookmark: marker-234659][bookmark: marker-234661][bookmark: marker-234663][bookmark: marker-234665]

 
     [bookmark: pgfId-234669]Use the Clientless settings to configure the clientless mode of access to the corporate network in an SSL VPN.

 
     [bookmark: pgfId-234671]In clientless access mode, once a user is authenticated and a session is established, an SSL VPN portal page and toolbar is displayed on the user’s web browser. From the portal page, the user can access all available HTTP sites, access web e-mail, and browse Common Internet File System (CIFS) file servers.

 
     [bookmark: pgfId-234673]Navigation Path

 
     [bookmark: pgfId-234678]Select Clientless from the table of contents in the Add or Edit User Group Dialog Box.

 
     [bookmark: pgfId-234680]Related Topics

 
      
      		 [bookmark: pgfId-234685]Create Group Policy Wizard—Clientless and Thin Client Access Modes Page

 
     

 
     [bookmark: pgfId-234687]Field Reference

 
     [bookmark: pgfId-234690] 

 
      
       
        
        [bookmark: pgfId-231235]Table 34-54 [bookmark: 92199]User Group Dialog Box—Clientless Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-231241]Element
          
  
         		
           
           [bookmark: pgfId-231243]Description
          
  
        

 
         
         		[bookmark: pgfId-231249]Portal Page Websites

  
         		[bookmark: pgfId-231251]The name of the SSL VPN bookmarks policy object that includes the web site URLs to display on the portal page. These web sites help users access desired resources. Enter the name of the object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-231257]Allow Users to Enter Websites

  
         		[bookmark: pgfId-231259]Whether to allow the remote user to enter web site URLs directly into the browser. If you do not select this option, the user can access only those URLs included on the portal.

  
        

 
         
         		[bookmark: pgfId-231265]Enable Common Internet File System (CIFS)

  
         		[bookmark: pgfId-231267]In Clientless mode, files and directories created on Microsoft Windows servers can be accessed by the remote client through the web browser. When you enable the Common Internet File System (CIFS), a list of file server and directory links are displayed on the portal page after login.

 [bookmark: pgfId-231269]The CIFS protocol lets you customize permissions on the SSL VPN gateway to allow shared files to be accessed or modified by the remote client, as follows:

 
           
           		 [bookmark: pgfId-231271] Enable File Browsing —Whether to allow the remote user to browse for file shares on the CIFS file servers.

 
           		 [bookmark: pgfId-231273] Enable File Entry —Whether to allow the remote user to locate file shares on the CIFS file servers by entering the names of the file shares.

 
          

  
        

 
         
         		[bookmark: pgfId-231279]WINS Server List

  
         		[bookmark: pgfId-231281]The name of the WINS server list policy object that identifies the WINS/NetBIOS servers to use for resolving file server names. You should supply an object if you enable CIFS. Enter the name of the object or click Select to select if from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-231287]Enable Citrix

  
         		[bookmark: pgfId-231289]Whether to enable remote clients to run Citrix-enabled applications, such as Microsoft Word or Excel, through the SSL VPN as if the application were locally installed, without the need for client software. The Citrix software must be installed on one or more servers on a network that the router can reach.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-234708][bookmark: 92245][bookmark: pobjpage_cncpt_UserGroupDialogBoxThinClientSettings]User Group Dialog Box—Thin Client Settings[bookmark: marker-234698][bookmark: marker-234700][bookmark: marker-234702][bookmark: marker-234704][bookmark: marker-234706]

 
     [bookmark: pgfId-234710]Use the Thin Client settings to enable the thin client, or port forwarding, mode of access to the corporate network in an SSL VPN. Port forwarding allows users to access applications (such as Telnet, e-mail, VNC, SSH, and Terminal services) inside the enterprise through an SSL VPN session. A port forwarding list object defines the mappings of port numbers on the remote client to the application’s IP address and port behind the SSL VPN gateway.

 
     [bookmark: pgfId-234712]In thin client access mode, the remote user downloads a Java applet that acts as a TCP proxy on the client machine for the services configured on the SSL VPN gateway. The proxy provides the port forwarding services.

 
     [bookmark: pgfId-234714]Navigation Path

 
     [bookmark: pgfId-234719]Select Thin Client from the table of contents in the Add or Edit User Group Dialog Box.

 
     [bookmark: pgfId-234721]Related Topics

 
      
      		 [bookmark: pgfId-234726]Create Group Policy Wizard—Clientless and Thin Client Access Modes Page

 
     

 
     [bookmark: pgfId-234728]Field Reference

 
     [bookmark: pgfId-234731] 

 
      
       
        
        [bookmark: pgfId-231302]Table 34-55 [bookmark: 92281]User Group Dialog Box—Thin Client Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-231308]Element
          
  
         		
           
           [bookmark: pgfId-231310]Description
          
  
        

 
         
         		[bookmark: pgfId-231316]Enable Thin Client

  
         		[bookmark: pgfId-231318]Whether to allow thin client access to the SSL VPN.

  
        

 
         
         		[bookmark: pgfId-231324]Port Forward List

  
         		[bookmark: pgfId-231326]The name of the port forwarding list policy object assigned to this group. Port forwarding lists contain the set of applications that users of clientless SSL VPN sessions can access over forwarded TCP ports. Enter the name of the object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-231332]Download Port Forwarding Applet on Client Login

  
         		[bookmark: pgfId-231334]Whether the port forwarding Java applet should be automatically downloaded to the client when a user logs into the SSL VPN. If you do not automatically download the applet, users must download it manually after login.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-234749][bookmark: 92308][bookmark: pobjpage_cncpt_UserGroupDialogBoxSSLVPNFullTunnelSettings]User Group Dialog Box—SSL VPN Full Tunnel Settings[bookmark: marker-234739][bookmark: marker-234741][bookmark: marker-234743][bookmark: marker-234745][bookmark: marker-234747]

 
     [bookmark: pgfId-234751]Use the SSL VPN Full Tunnel settings to enable the full tunnel client access mode in your SSL VPN. When you enable full tunnel access, you should also define DNS/WINS server settings, browser proxy settings, and split tunneling for the user group.

 
     [bookmark: pgfId-234753]In full tunnel client access mode, the tunnel connection is determined by the group policy configuration. The full tunnel client software, SSL VPN Client (SVC), must be downloaded to the remote client so that a tunnel connection can be established when the remote user logs in to the SSL VPN gateway.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-234755]Tip For full tunnel client access to work, you must install the client software on the gateway. The user downloads the client when connecting to the gateway.


     
      

     

     

 
     [bookmark: pgfId-234757]Navigation Path

 
     [bookmark: pgfId-234762]Select Full Tunnel > Settings from the table of contents in the Add or Edit User Group Dialog Box.

 
     [bookmark: pgfId-234764]Related Topics

 
      
      		 [bookmark: pgfId-234769]Create Group Policy Wizard—Full Tunnel Page

 
     

 
     [bookmark: pgfId-234771]Field Reference

 
     [bookmark: pgfId-234774] 

 
      
       
        
        [bookmark: pgfId-231347]Table 34-56 [bookmark: 92345]User Group Dialog Box—Full Tunnel Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-231353]Element
          
  
         		
           
           [bookmark: pgfId-231355]Description
          
  
        

 
         
         		[bookmark: pgfId-231361]Enable Full Tunnel

  
         		[bookmark: pgfId-231363]Whether to enable full tunnel client access to the SSL VPN.

  
        

 
         
         		[bookmark: pgfId-231369]Use Other Access Modes if SSL VPN Client Download Fails

 [bookmark: pgfId-231371]Full Tunnel Only

  
         		[bookmark: pgfId-231373]Whether to allow users to connect to the SSL VPN even if a problem prevents the client from downloading, installing, and starting correctly on the user’s system.

 [bookmark: pgfId-231375]If you select Full Tunnel Only, a user cannot connect to the SSL VPN if the download fails, which locks the user out of the network. Select Use Other Access Modes to allow clientless or thin client access if there is a download problem.

  
        

 
         
         		[bookmark: pgfId-231381]Client IP Address Pool

  
         		[bookmark: pgfId-231383]The IP address ranges of the address pool that full tunnel clients will draw from when they log on. The address pool must be in the same subnet as one of the device’s interface IP addresses.

 [bookmark: pgfId-231385]Enter the address range separating the first and last IP address with a hyphen, for example, 10.100.10.2-10.100.10.255. If you enter a single address, the pool has just one address. Do not enter subnet designations.

 [bookmark: pgfId-231387]You can also enter the name of a network/host policy object that defines the range, or click Select to select the object from a list or to create a new object. Separate multiple ranges with commas.

  
        

 
         
         		[bookmark: pgfId-231393]Filter ACL

  
         		[bookmark: pgfId-231395]The name of an extended access control list (ACL) object that restricts access to the SSL VPN. Enter the name of the object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-231401]Keep SSL VPN Client on Client Computer

  
         		[bookmark: pgfId-231403]Whether to leave the full client installed on the user’s workstation after the user disconnects. If you do not allow the client to remain on the user’s system, the client must be downloaded each time the user establishes a connection to the SSL VPN gateway.

  
        

 
         
         		[bookmark: pgfId-231409]Home Page URL

  
         		[bookmark: pgfId-231411]The web address of the login home page for the full client.

  
        

 
         
         		[bookmark: pgfId-231417]Client Dead Peer Detection Timeout

  
         		[bookmark: pgfId-231419]The time interval that the Dead Peer Detection (DPD) timer is reset each time a packet is received over the SSL VPN tunnel from the remote user. Enter a value in the range 1-3600 seconds.

  
        

 
         
         		[bookmark: pgfId-231425]Gateway Dead Peer Detection Timeout

  
         		[bookmark: pgfId-231427]The time interval that the Dead Peer Detection (DPD) timer is reset each time a packet is received over the SSL VPN tunnel from the gateway. Enter a value in the range 1-3600 seconds.

  
        

 
         
         		[bookmark: pgfId-231433]Key Renegotiation Method

  
         		[bookmark: pgfId-231435]The method by which the tunnel key is refreshed for the remote user group client:

 
           
           		 [bookmark: pgfId-231437] Disabled —Disables the tunnel key refresh.

 
           		 [bookmark: pgfId-231439] Create New Tunnel —Initiates a new tunnel connection. Enter the time interval (in seconds) between the tunnel refresh cycles in the  Interval field.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-234792][bookmark: 92418][bookmark: pobjpage_cncpt_UserGroupDialogBoxSSLVPNSplitTunneling]User Group Dialog Box—SSL VPN Split Tunneling[bookmark: marker-234782][bookmark: marker-234784][bookmark: marker-234786][bookmark: marker-234788][bookmark: marker-234790]

 
     [bookmark: pgfId-234794]Use the Split Tunneling settings to configure a secure tunnel to the central site and simultaneous clear text tunnels to the Internet for SSL VPNs.

 
     [bookmark: pgfId-234796]Split tunneling lets a remote client conditionally direct packets over an IPsec or SSL VPN tunnel in encrypted form or to a network interface in clear text form. With split tunneling enabled, packets not bound for destinations on the other side of the tunnel do not have to be encrypted, sent across the tunnel, decrypted, and then routed to a final destination. The split tunneling policy is applied to specific networks.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-234798]Tip For optimum security, we recommend that you not enable split tunneling.


     
      

     

     

 
     [bookmark: pgfId-234800]Navigation Path

 
     [bookmark: pgfId-234805]Select Full Tunnel > Split Tunneling from the table of contents in the Add or Edit User Group Dialog Box.

 
     [bookmark: pgfId-234807]Field Reference

 
     [bookmark: pgfId-234810] 

 
      
       
        
        [bookmark: pgfId-231452]Table 34-57 [bookmark: 92449]User Group Dialog Box—Split Tunneling Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-231458]Element
          
  
         		
           
           [bookmark: pgfId-231460]Description
          
  
        

 
         
         		[bookmark: pgfId-231466]Tunnel Option

  
         		[bookmark: pgfId-231468]Whether to allow split tunneling and if so, which traffic should be secured or transmitted unencrypted across the public network:

 
           
           		 [bookmark: pgfId-231470]Disabled—(Default) No traffic goes in the clear or to any other destination than the gateway. Remote users reach networks through the corporate network and do not have access to local networks.

 
           		 [bookmark: pgfId-231472]Tunnel Specified Traffic—Tunnel all traffic from or to the addresses listed in the  Destinations field. Traffic to all other addresses travels in the clear and is routed by the remote user’s Internet service provider.

 
           		 [bookmark: pgfId-231474]Exclude Specified Traffic—Traffic goes in the clear from and to the addresses listed in the  Destinations field. This is useful for remote users who want to access devices on their local network, such as printers, while they are connected to the corporate network through a tunnel.

 
          

  
        

 
         
         		[bookmark: pgfId-231480]Destinations

  
         		[bookmark: pgfId-231482]The IP addresses for hosts or networks that identify the networks that require traffic to travel across the tunnel and those that do not require tunneling. Whether traffic to these addresses is encrypted and tunneled to the gateway, or sent in the clear, is determined by your selection for Tunnel Option.

 [bookmark: pgfId-231484]Enter network addresses such as 10.100.10.0/24 or host addresses such as 10.100.10.12. You can also enter the name of a network/host policy object, or click Select to select the object from a list or to create a new object. Separate multiple addresses with commas.

  
        

 
         
         		[bookmark: pgfId-231490]Exclude Local LANs

  
         		[bookmark: pgfId-231492]Whether to exclude local LANs from the encrypted tunnel. This option is available only if you selected the Exclude Specified Traffic tunnel option. By selecting this option, you do not have to enter local LAN addresses into the destinations field to allow users to communicate with systems (such as printers) that are attached to their LAN.

 [bookmark: pgfId-231494]When selected, this attribute disallows a non split-tunneling connection to access the local subnetwork at the same time as the client.

  
        

 
         
         		[bookmark: pgfId-231500]Split DNS Names

  
         		[bookmark: pgfId-231502]A list of domain names to be resolved through the split tunnel to the private network. All other names are resolved using the public DNS server.

 [bookmark: pgfId-231504]Enter up to 10 entries in the list of domains, separated by commas. The entire string can be no longer than 255 characters.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-234828][bookmark: 92495][bookmark: pobjpage_cncpt_UserGroupDialogBoxBrowserProxySettings]User Group Dialog Box—Browser Proxy Settings[bookmark: marker-234818][bookmark: marker-234820][bookmark: marker-234822][bookmark: marker-234824][bookmark: marker-234826]

 
     [bookmark: pgfId-234830]Use the Browser Proxy settings to configure proxy bypass for full tunnel access in an SSL VPN.

 
     [bookmark: pgfId-234832]A security appliance can terminate HTTPS connections and forward HTTP/HTTPS requests to HTTP and HTTPS proxy servers, which act as intermediaries between users and the Internet. Proxy bypass is an alternative method of content rewriting that makes minimal changes to the original content. It is useful with custom web applications.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-234834]Tip The browser proxy settings work only for Microsoft Internet Explorer; they do not work for other types of browsers.


     
      

     

     

 
     [bookmark: pgfId-234836]Navigation Path

 
     [bookmark: pgfId-234841]Select Full Tunnel > Browser Proxy Settings from the table of contents in the Add or Edit User Group Dialog Box.

 
     [bookmark: pgfId-234843]Related Topics

 
      
      		 [bookmark: pgfId-234848]Configuring SSL VPN Proxies and Proxy Bypass (ASA)

 
     

 
     [bookmark: pgfId-234850]Field Reference

 
     [bookmark: pgfId-234853] 

 
      
       
        
        [bookmark: pgfId-231517]Table 34-58 [bookmark: 92532]User Group Dialog Box—Browser Proxy Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-231523]Element
          
  
         		
           
           [bookmark: pgfId-231525]Description
          
  
        

 
         
         		[bookmark: pgfId-231531]Browser Proxy Option

  
         		[bookmark: pgfId-231533]Whether and how to configure proxy settings on the remote client’s browser:

 
           
           		 [bookmark: pgfId-231535]Blank—Do not configure proxy settings.

 
           		 [bookmark: pgfId-231537]Do Not Use Proxy Server—Configure the browser to not use a proxy.

 
           		 [bookmark: pgfId-231539]Automatically Detect Settings—Configure the browser to automatically detect proxy settings.

 
           		 [bookmark: pgfId-231541]Bypass Proxy Server for Local Addresses—Configure the browser to bypass proxy settings configured by the user.

 
          

  
        

 
         
         		[bookmark: pgfId-231547]Proxy Server

  
         		[bookmark: pgfId-231549]The address of the proxy server:

 
           
           		 [bookmark: pgfId-231551]IP address—The IP address or the name of a network/host object that specifies the address. Click  Select to select the object from a list.

 
           		 [bookmark: pgfId-231553]Name—The fully qualified domain name, for example, proxy.example.com.

 
          

  
        

 
         
         		[bookmark: pgfId-231559]Proxy Server Port

  
         		[bookmark: pgfId-231561]The port number on the server that is used for proxy traffic, for example, 80. Enter a value in the range 1-65535.

  
        

 
         
         		[bookmark: pgfId-231567]Do Not Use Proxy Server for Addresses Beginning With

  
         		[bookmark: pgfId-231569]If you configured a proxy, you can identify specific hosts for which the proxy should be bypassed. If the user opens these hosts in the browser, the proxy is not used in the connection.

 [bookmark: pgfId-231571]Enter full IP addresses or fully qualified domain names. For example, 10.100.10.14 or www.cisco.com.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-234871][bookmark: 92579][bookmark: pobjpage_cncpt_UserGroupDialogBoxSSLVPNConnectionSettings]User Group Dialog Box—SSL VPN Connection Settings [bookmark: marker-234861][bookmark: marker-234863][bookmark: marker-234865][bookmark: marker-234867][bookmark: marker-234869]

 
     [bookmark: pgfId-234873]Use this SSL VPN Connection Settings page to configure the SSL VPN session connection settings for the user group, including the banner text. An SSL VPN session is disconnected if the client is connected longer than the session timeout or if it is idle longer than the idle timeout.

 
     [bookmark: pgfId-234875]Navigation Path

 
     [bookmark: pgfId-234880]Select Connection Settings from the table of contents in the Add or Edit User Group Dialog Box.

 
     [bookmark: pgfId-234882]Field Reference

 
     [bookmark: pgfId-234885] 

 
      
       
        
        [bookmark: pgfId-231584]Table 34-59 [bookmark: 92608]User Group Dialog Box—Connection Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-231590]Element
          
  
         		
           
           [bookmark: pgfId-231592]Description
          
  
        

 
         
         		[bookmark: pgfId-231598]Idle Timeout

  
         		[bookmark: pgfId-231600]The idle timeout period for the SSL VPN session. The session is disconnected if the client is idle longer than the specified idle timeout. Values range from 0-3600 seconds.

  
        

 
         
         		[bookmark: pgfId-231606]Session Timeout

  
         		[bookmark: pgfId-231608]The timeout period for the SSL VPN session. The session is disconnected when this timeout is reached even if the user is still active. Values range from 1-1209600 seconds.

  
        

 
         
         		[bookmark: pgfId-231614]Banner Text

  
         		[bookmark: pgfId-231616]The banner, for example, a welcome message, that is displayed to remote users when they connect to the SSL VPN.

 [bookmark: pgfId-231618]You cannot use double quotes or new lines (carriage returns) in the banner text. However, you can include HTML tags to create the desired layout.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-234897][bookmark: 92636][bookmark: pobjpage_cncpt_WINSServerListsDialogBox]Add or Edit WINS Server List Dialog Box[bookmark: marker-234893][bookmark: marker-234895]

 
    [bookmark: pgfId-234899]Use the WINS Server Lists dialog box to create, copy, and edit WINS server list objects. A WINS Server List object defines a list of Windows Internet Naming Server (WINS) servers, which are used to translate Windows file server names to IP addresses.

 
    [bookmark: pgfId-234901]Navigation Path

 
    [bookmark: pgfId-234903]Select Manage > Policy Objects, then select WINS Server Lists from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
    [bookmark: pgfId-234905]Related Topics

 
     
     		 [bookmark: pgfId-234910]Configuring WINS/NetBIOS Name Service (NBNS) Servers To Enable File System Access in SSL VPNs

 
     		 [bookmark: pgfId-234915]Policy Object Manager

 
    

 
    [bookmark: pgfId-234917]Field Reference

 
    [bookmark: pgfId-234920] 

 
     
      
       
       [bookmark: pgfId-231631]Table 34-60 [bookmark: 92663]WINS Server Lists Dialog Box 

 
       
      
        
        		
          
          [bookmark: pgfId-231637]Element
         
  
        		
          
          [bookmark: pgfId-231639]Description
         
  
       

 
        
        		[bookmark: pgfId-231645]Name

  
        		[bookmark: pgfId-231650]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
       

 
        
        		[bookmark: pgfId-231656]Description

  
        		[bookmark: pgfId-231658]An optional description of the object.

  
       

 
        
        		[bookmark: pgfId-231664]WINS Server List

  
        		[bookmark: pgfId-231666]The WINS servers that are defined for the object.

 
          
          		 [bookmark: pgfId-231671]To add a server, click the Add button and fill in the Add WINS Server dialog box (see Add or Edit WINS Server Dialog Box).

 
          		 [bookmark: pgfId-231673]To edit a server, select it and click the Edit button.

 
          		 [bookmark: pgfId-231675]To delete a server, select it and click the Delete button.

 
         

  
       

 
        
        		[bookmark: pgfId-231681]Category

  
        		[bookmark: pgfId-231686]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
        
        		[bookmark: pgfId-231692]Allow Value Override per Device

 [bookmark: pgfId-231694]Overrides

 [bookmark: pgfId-231696]Edit button

  
        		[bookmark: pgfId-231704]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-231706]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-234938][bookmark: 92715][bookmark: pobjpage_cncpt_AddEditWINSServerDialogBox]Add or Edit WINS Server Dialog Box[bookmark: marker-234928][bookmark: marker-234930][bookmark: marker-234932][bookmark: marker-234934][bookmark: marker-234936]

 
     [bookmark: pgfId-234940]Use the Add/Edit WINS Server dialog box to create a new WINS server entry or edit an existing entry in the table in the WINS Server Lists dialog box.

 
     [bookmark: pgfId-234942]Navigation Path

 
     [bookmark: pgfId-234947]From the Add or Edit WINS Server List Dialog Box, click the Add button beneath the WINS Server List table, or select a server in the table and click the Edit button.

 
     [bookmark: pgfId-234949]Related Topics

 
      
      		 [bookmark: pgfId-234954]Configuring WINS/NetBIOS Name Service (NBNS) Servers To Enable File System Access in SSL VPNs

 
     

 
     [bookmark: pgfId-234956]Field Reference

 
     [bookmark: pgfId-234959] 

 
      
       
        
        [bookmark: pgfId-231719]Table 34-61 [bookmark: 92749]Add/Edit WINS Server Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-231725]Element
          
  
         		
           
           [bookmark: pgfId-231727]Description
          
  
        

 
         
         		[bookmark: pgfId-231733]Server

  
         		[bookmark: pgfId-231735]The IP address of the WINS server used to translate Windows file server names to IP addresses. You can also enter the name of a network/host policy object that identifies the server. Click Select to choose a network/hosts object or to create a new object.

  
        

 
         
         		[bookmark: pgfId-231741]Set as Master Browser

  
         		[bookmark: pgfId-231743]Whether to server is a master browser. The master browser maintains the list of computers and shared resources.

  
        

 
         
         		[bookmark: pgfId-231749]Timeout

  
         		[bookmark: pgfId-231751]The period of time the security appliance waits for a response to a WINS query before sending the query again to the same server (if it is the only one), or to the next server (if there is more than one).

 [bookmark: pgfId-231753]The default timeout is 2 seconds. The range is between 1 and 30 seconds.

  
        

 
         
         		[bookmark: pgfId-231759]Retries

  
         		[bookmark: pgfId-231761]The number of times to retry sending WINS queries to the configured servers. The security appliance recycles through the list of servers this number of times before sending an error message.

 [bookmark: pgfId-231763]The default is 2. The range is between 0 and 10.
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     [bookmark: pgfId-79428][bookmark: 152305][bookmark: catman_cncpt_ManagingCatalystDevices]Managing Cisco Catalyst Switches and Cisco 7600 Series Routers[bookmark: marker-79424][bookmark: marker-79426]
      
      
 
     
 

 
    [bookmark: pgfId-79430]Cisco Security Manager supports the management and configuration of security services and other platform-specific services on Cisco Catalyst switches and Cisco 7600 Series routers.

 
    [bookmark: pgfId-79436]You can manage Catalyst switches and 7600 devices configured in VTP transparent or VTP client/server mode. Security Manager manages switches configured in client/server mode by bypassing VLAN database management on the device (including VLAN creation, deletion, and monitoring VLANs in the VLAN database on switches).[bookmark: marker-79432][bookmark: marker-79434]

 
    [bookmark: pgfId-79438]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-79443]Discovering Policies on Cisco Catalyst Switches and Cisco 7600 Series Routers

 
     		 [bookmark: pgfId-79448]Viewing Catalyst Summary Information

 
     		 [bookmark: pgfId-79453]Viewing a Summary of Catalyst Interfaces, VLANs, and VLAN Groups

 
     		 [bookmark: pgfId-79458]Interfaces

 
     		 [bookmark: pgfId-79463]VLANs

 
     		 [bookmark: pgfId-79468]VLAN Groups

 
     		 [bookmark: pgfId-79473]VLAN ACLs (VACLs)

 
     		 [bookmark: pgfId-79478]IDSM Settings

 
    

 
   
 
    
     [bookmark: pgfId-79488][bookmark: 152321][bookmark: catman_cncpt_DiscoveringPoliciesonSeriesandSeriesDevices]Discovering Policies on Cisco Catalyst Switches and Cisco 7600 Series Routers[bookmark: marker-79484][bookmark: marker-79486]

 
    [bookmark: pgfId-79493]You can discover the configurations of your Cisco Catalyst switches and Cisco 7600 Series Routers (as well as the configurations of the services modules and security contexts associated with them) and import the configurations as policies into Security Manager. This makes it possible to add existing devices and manage them with Security Manager without having to configure each device manually, policy by policy. For more information, see Adding Devices to the Device Inventory.

 
    [bookmark: pgfId-79495]You can discover any command that Security Manager can configure. Discovery ignores unsupported commands, which means that they are left intact on the device even after subsequent deployments. Additionally, in cases where Security Manager can discover the command, but not all the subcommands and keywords related to that command, the unsupported elements are ignored and left intact on the device.

 
    [bookmark: pgfId-79500]At any time, you can also rediscover the configurations of devices that you are already managing with Security Manager. Be aware, however, that we do not recommend rediscovery generally because performing rediscovery overwrites the policies that you have defined in Security Manager. For more information, see Discovering Policies on Devices Already in Security Manager.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-79505]Note We recommend that you perform deployment immediately after you discover policies, before you make any changes to policies or unassign policies from the device. (This recommendation also applies to any services module or security context hosted by the device.) Otherwise, the changes that you configure in Security Manager might not be deployed to the device. See Working with Deployment and the Configuration Archive.


    
     

    

    

 
    [bookmark: pgfId-79507]Related Topics

 
     
     		 [bookmark: pgfId-79512]Understanding Policies

 
     		 [bookmark: pgfId-79517]Discovering Policies

 
     		 [bookmark: pgfId-79522]Chapter 67, “Managing Cisco Catalyst Switches and Cisco 7600 Series Routers”

 
     		 [bookmark: pgfId-79527]Working with Deployment and the Configuration Archive

 
    

 
   
 
    
     [bookmark: pgfId-79535][bookmark: 152354][bookmark: catpage_cncpt_CatalystSummaryInfoPage]Viewing Catalyst Summary Information[bookmark: marker-79533]

 
    [bookmark: pgfId-79537]Use the Catalyst Summary Info page to view high-level system information, including any service modules, ports, and VLANs that Security Manager has discovered.

 
    [bookmark: pgfId-79539]To view Catalyst summary information, in Device view, right-click a Catalyst switch or Cisco 7600 Series router, then select Catalyst Summary Info, or select Tools > Catalyst Summary Info.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-79541]Note If Security Manager has not completed discovery for a particular Cisco Catalyst switch or Cisco 7600 Series router, the Catalyst Summary Info page for that device displays this message: “No information is available. This information is acquired during device discovery.”


    
     

    

    

 
    [bookmark: pgfId-79543]Related Topics

 
     
     		 [bookmark: pgfId-79548]IDSM Settings Page

 
     		 [bookmark: pgfId-79553]VLAN Access Lists Page

 
     		 [bookmark: pgfId-79558]Filtering Tables

 
    

 
    [bookmark: pgfId-79560]Field Reference

 
    [bookmark: pgfId-79563] 

 
     
      
       
       [bookmark: pgfId-75683]Table 67-1 [bookmark: 152379]Catalyst Summary Info Page 

 
       
      
        
        		
          
          [bookmark: pgfId-75689]Element
         
  
        		
          
          [bookmark: pgfId-75691]Description
         
  
       

 
        
        		[bookmark: pgfId-75697]Hostname

  
        		[bookmark: pgfId-75699]Displays the configured hostname of the device.

  
       

 
        
        		[bookmark: pgfId-75705]Device Type

  
        		[bookmark: pgfId-75707]Displays the device type.

  
       

 
        
        		[bookmark: pgfId-75713]Serial Number

  
        		[bookmark: pgfId-75715]Displays the serial number of the device.

  
       

 
        
        		[bookmark: pgfId-75721]OS Version

  
        		[bookmark: pgfId-75723]Displays the Cisco IOS image version the device is running.

  
       

 
        
        		[bookmark: pgfId-75729]Image

  
        		[bookmark: pgfId-75731]Displays the name of the image running on the device.

  
       

 
        
        		[bookmark: pgfId-75737]Last Update

  
        		[bookmark: pgfId-75739]Displays a time stamp for the most recent discovery.

  
       

 
        
        		[bookmark: pgfId-75745]Total Ports

  
        		[bookmark: pgfId-75747]Displays the total number of configured ports, combining access ports, routed ports, and trunk ports.

  
       

 
        
        		[bookmark: pgfId-75753]Access Ports

  
        		[bookmark: pgfId-75755]Displays the number of configured access ports on the chassis.

  
       

 
        
        		[bookmark: pgfId-75761]Trunk Ports

  
        		[bookmark: pgfId-75763]Displays the number of configured trunk ports on the chassis.

  
       

 
        
        		[bookmark: pgfId-75769]Routed Ports

  
        		[bookmark: pgfId-75771]Displays the number of configured routed ports on the chassis.

  
       

 
        
        		[bookmark: pgfId-75777]Total VLANs

  
        		[bookmark: pgfId-75779]Displays the total number of configured VLANs on the chassis and all its services modules.

  
       

 
        
        		[bookmark: pgfId-75785]Layer 2 VLANs

  
        		[bookmark: pgfId-75787]Displays the number of VLANs that run on Layer 2.

  
       

 
        
        		[bookmark: pgfId-75793]Layer 3 VLANs

  
        		[bookmark: pgfId-75795]Displays the number of VLANs that run on Layer 3.

  
       

 
        
        		 
          
          [bookmark: pgfId-75801]Service Module Table
         
  
       

 
        
        		[bookmark: pgfId-75809]Slot

  
        		[bookmark: pgfId-75811]Identifies the slot to which a service module is attached.

  
       

 
        
        		[bookmark: pgfId-75817]Device Type

  
        		[bookmark: pgfId-75819]Displays a brief description of the service module.

  
       

 
        
        		[bookmark: pgfId-75825]Serial Number

  
        		[bookmark: pgfId-75827]Displays the serial number of the service module.

  
       

 
        
        		[bookmark: pgfId-75833]Model

  
        		[bookmark: pgfId-75835]Displays the model type of the service module.

  
       

 
        
        		[bookmark: pgfId-75841]OS Version

  
        		[bookmark: pgfId-75843]Identifies the OS version that is installed and running on the service module.

  
       

 
        
        		[bookmark: pgfId-75849]Assigned VLANs

  
        		[bookmark: pgfId-75851]Displays the total number of VLANs to which an FWSM is assigned.

 [bookmark: pgfId-75853]Tip Click the Summary tab of the Interfaces/VLANs policy to learn which VLANs are assigned to an IDSM or a VPNSM.  
       

 
        
        		[bookmark: pgfId-75859]Contexts

  
        		[bookmark: pgfId-75861]Displays the total number of configured security contexts for an FWSM that runs in multicontext mode.

 [bookmark: pgfId-75863]Tip Click the Summary tab of the Interfaces/VLANs policy to learn how many virtual sensors are configured for an IDSM.  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-79577][bookmark: 152497][bookmark: catpage_cncpt_InterfacesVLANsPageSummaryTab]Viewing a Summary of Catalyst Interfaces, VLANs, and VLAN Groups[bookmark: marker-79571][bookmark: marker-79573][bookmark: marker-79575]

 
    [bookmark: pgfId-79579]Use the Summary tab of the Interfaces/VLAN policy to view attributes of all VLANs, VLAN groups, interfaces, and subinterfaces configured on supported Catalyst 6500 Series and 7600 Series chassis and their associated services modules.

 
    [bookmark: pgfId-79581]To view summary interface information, in Device view, select Interfaces/VLANs from the Policy selector, then click the Summary tab.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-79583]Note The Summary tab is available only for Cisco Catalyst 6500 Series switches and Cisco 7600 Series routers.


    
     

    

    

 
    [bookmark: pgfId-79585]Related Topics

 
     
     		 [bookmark: pgfId-79590]Interfaces/VLANs Page—VLANs Tab

 
     		 [bookmark: pgfId-79595]Interfaces/VLANs Page—VLAN Groups Tab

 
     		 [bookmark: pgfId-79600]Interfaces/VLANs Page—Interfaces Tab

 
     		 [bookmark: pgfId-79605]Viewing Catalyst Summary Information

 
     		 [bookmark: pgfId-79610]Filtering Tables

 
    

 
    [bookmark: pgfId-79612]Field Reference

 
    [bookmark: pgfId-79615] 

 
     
      
       
       [bookmark: pgfId-75876]Table 67-2 [bookmark: 152538]Interfaces/VLANs Page—Summary Tab 

 
       
      
        
        		
          
          [bookmark: pgfId-75882]Element
         
  
        		
          
          [bookmark: pgfId-75884]Description
         
  
       

 
        
        		[bookmark: pgfId-75890]VLAN ID

  
        		[bookmark: pgfId-75892]The VLAN ID associated with an interface or subinterface. The VLAN ID specifies where 802.1Q tagged packets are sent and received on the specified an interface or subinterface; without a VLAN ID, the interface or subinterface cannot send or receive traffic.

 [bookmark: pgfId-75894]Note All VLAN IDs must be unique among all subinterfaces configured on the same physical interface.

  
       

 
        
        		[bookmark: pgfId-75900]VLAN Name

  
        		[bookmark: pgfId-75902]Name of the VLAN that corresponds to an interface or subinterface. For example, VLAN003 or Trunk1.

  
       

 
        
        		[bookmark: pgfId-75908]VLAN Group

  
        		[bookmark: pgfId-75910]Numeric identity of a VLAN group that is configured on the VLAN that a table row describes.

  
       

 
        
        		[bookmark: pgfId-75916]VLAN Type

  
        		[bookmark: pgfId-75918]Specifies whether a VLAN has access to Layer 2 or Layer 3.

  
       

 
        
        		[bookmark: pgfId-75924]IP Address/Mask

  
        		[bookmark: pgfId-75926]The IP address and corresponding subnet mask of the VLAN configured on an interface or subinterface.

  
       

 
        
        		[bookmark: pgfId-75932]Access Port

  
        		[bookmark: pgfId-75934]Displays the assigned name, if a name is assigned, of the access port that a VLAN uses.

  
       

 
        
        		[bookmark: pgfId-75940]Trunk Port

  
        		[bookmark: pgfId-75942]Specifies which VLANs are permitted to carry traffic over the trunk.

  
       

 
        
        		[bookmark: pgfId-75948]Slot (-Port)

  
        		[bookmark: pgfId-75950]Associates the chassis slot number (in which the relevant services module is installed) with the port number, as a hyphenated pair in the format x -y, for example 3-1.

  
       

 
        
        		[bookmark: pgfId-75956]Blade Type

  
        		[bookmark: pgfId-75958]Identifies the kind of services module on which a particular VLAN is configured, such as FWSM or VPNSM.

  
       

 
        
        		[bookmark: pgfId-75964]Security Context

  
        		[bookmark: pgfId-75966]Identifies the security context associated with an interface, but only if Multiple Mode is active on the installed module and an Admin context is configured for the module.

  
       

 
        
        		[bookmark: pgfId-75972]Security Context Interface

  
        		[bookmark: pgfId-75974]Displays the physical interface and subinterface IDs for which a security context inspects traffic. The displayed ID can represent a physical interface, a single sub-interface (defined as a range of one), or a range of sub-interfaces.

  
       

 
        
        		[bookmark: pgfId-75980]Security Level

  
        		[bookmark: pgfId-75982]Displays the security level of an interface, where values range from 0 (the lowest security) to 100 (the highest):

 
          
          		 [bookmark: pgfId-75984]For an outside interface, the default is 0.

 
          		 [bookmark: pgfId-75986]For an inside interface, the default is 100.

 
          		 [bookmark: pgfId-75988]For an interface in the DMZ, the default is typically from 1 to 99.

 
         

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-79625][bookmark: 152619][bookmark: catman_cncpt_Interfaces]Interfaces[bookmark: marker-79621][bookmark: marker-79623]

 
    [bookmark: pgfId-79627]You use the Interfaces tab on the Interfaces/VLANs page to view and manage the following types of ports:

 
     
     		 [bookmark: pgfId-79633]Access ports—A switching port that is used to connect host machines or servers. An access port belongs to and carries the traffic of only one VLAN. Traffic is received and sent in native formats with no VLAN tagging.[bookmark: marker-79629][bookmark: marker-79631]

 
     		 [bookmark: pgfId-79639]Trunk ports—A switching port operating at Layer 2 to carry the traffic of multiple VLANs. Traffic is tagged with a VLAN number to differentiate traffic from each VLAN. A trunk port is used to connect switches to switches or to connect switches to routers.[bookmark: marker-79635][bookmark: marker-79637]

 
     		 [bookmark: pgfId-79645]Routed ports—A physical port that acts like a port on a router. A routed port is not associated with a particular VLAN, and it behaves like a regular router interface. You can configure a routed port with a Layer 3 routing protocol.[bookmark: marker-79641][bookmark: marker-79643]

 
     		 [bookmark: pgfId-79647]Dynamic ports—A port that can change dynamically to a trunk port if the neighboring port is configured as a trunk port.

 
     		 [bookmark: pgfId-79649]Unsupported ports—Ports on the Catalyst device that are not supported by Security Manager.

 
    

 
    [bookmark: pgfId-79651]To display the Interfaces tab, select a Catalyst device in Device view, select Interfaces/VLANs from the Policy selector, then click the Interfaces tab in the work area.

 
    [bookmark: pgfId-79653]The following topics describe the actions you can perform when defining interfaces on Catalyst devices:

 
     
     		 [bookmark: pgfId-79658]Creating or Editing Ports on Cisco Catalyst Switches and Cisco 7600 Series Routers

 
     		 [bookmark: pgfId-79663]Deleting Ports on Cisco Catalyst Switches and Cisco 7600 Series Routers

 
     		 [bookmark: pgfId-79668]Interfaces/VLANs Page—Interfaces Tab

 
    

 
    [bookmark: pgfId-79670]Related Topics

 
     
     		 [bookmark: pgfId-79675]VLANs

 
     		 [bookmark: pgfId-79680]VLAN Groups

 
     		 [bookmark: pgfId-79685]VLAN ACLs (VACLs)

 
     		 [bookmark: pgfId-79690]Chapter 67, “Managing Cisco Catalyst Switches and Cisco 7600 Series Routers”

 
    

 
     
      [bookmark: pgfId-79700][bookmark: 152687][bookmark: catman_proc_CreatingorEditingPortsonCatalystDevices]Creating or Editing Ports on Cisco Catalyst Switches and Cisco 7600 Series Routers[bookmark: marker-79696][bookmark: marker-79698]

 
     [bookmark: pgfId-79702]You can create access ports, routed ports, or trunk ports on Cisco Catalyst Switches and Cisco 7600 Series Routers, with these restrictions:

 
      
      		 [bookmark: pgfId-79704]Each interface must have a name.

 
      		 [bookmark: pgfId-79706]You can associate an access port with only one VLAN.

 
      		 [bookmark: pgfId-79708]You can associate a trunk port with one or more VLANs.

 
     

 
     [bookmark: pgfId-79710]Related Topics

 
      
      		 [bookmark: pgfId-79715]Deleting Ports on Cisco Catalyst Switches and Cisco 7600 Series Routers

 
      		 [bookmark: pgfId-79720]Creating or Editing VLANs

 
      		 [bookmark: pgfId-79725]Creating or Editing VLAN Groups

 
      		 [bookmark: pgfId-79730]Interfaces/VLANs Page—Interfaces Tab

 
      		 [bookmark: pgfId-79735]Interfaces

 
     

 
     
 
     [bookmark: pgfId-79737]Step 1 (Device view) Select a Catalyst device, select Interfaces/VLANs from the Policy selector, then click the Interfaces tab in the work area.

 
     [bookmark: pgfId-79742]The Interfaces tab is displayed. For a description of the fields on this tab, see Interfaces/VLANs Page—Interfaces Tab.

 
     [bookmark: pgfId-79744]Step 2 Do one of the following:

 
      
      		 [bookmark: pgfId-79746]To define the attributes of a new interface, click  Add Row .

 
      		 [bookmark: pgfId-79748]To edit the attributes of an interface, select it in the list, then click  Edit Row .

 
     

 
     [bookmark: pgfId-79750]Step 3 (Optional) Deselect the Enable Interface check box if you want this interface to be in shutdown mode.

 
     [bookmark: pgfId-79752]Step 4 From the Type list, select Interface or Subinterface:

 
     [bookmark: pgfId-79761]Step 5 (Interfaces only) Enter a name for the interface. You can click Select to open a dialog box that will help you generate a standard name based on interface type and details about the interface’s location, such as card, slot, and subinterface. For more information on using the dialog box to generate an interface name, see Interface Auto Name Generator Dialog Box.[bookmark: marker-79757][bookmark: marker-79759]

 
     [bookmark: pgfId-79763]Step 6 (Interfaces only) Select an option from the Mode list to specify the port configuration type. The fields in the dialog box vary according to your selection.

 
     [bookmark: pgfId-79765]Step 7 (Subinterfaces only) Select the parent interface of the subinterface, then enter the ID number.

 
     [bookmark: pgfId-79767]Step 8 Define or configure the settings for the type that you selected:

 
      
      		 [bookmark: pgfId-79772]Access Port—See Create and Edit Interface Dialog Boxes—Access Port Mode for a description of the fields.

 
      		 [bookmark: pgfId-79777]Routed Port—See Create and Edit Interface Dialog Boxes—Routed Port Mode for a description of the fields.

 
      		 [bookmark: pgfId-79782]Trunk Port—See Create and Edit Interface Dialog Boxes—Trunk Port Mode for a description of the fields.

 
      		 [bookmark: pgfId-79787]Dynamic Port—See Create and Edit Interface Dialog Boxes—Dynamic Mode for a description of the fields.

 
      		 [bookmark: pgfId-79792]Subinterface—See Create and Edit Interface Dialog Boxes—Subinterfaces for a description of the fields.

 
      		 [bookmark: pgfId-79797]Unsupported—See Create and Edit Interface Dialog Boxes—Unsupported Mode for a description of the fields.

 
     

 
     [bookmark: pgfId-79799]Step 9 From the Speed list, select an option to define the speed of the interface.

 
     [bookmark: pgfId-79801]Step 10 If you defined a specific speed for the interface, and therefore the Duplex list is enabled, select a duplexing option.

 
     [bookmark: pgfId-79803]Step 11 In the MTU field, enter the maximum transmission unit value.

 
     [bookmark: pgfId-79805]Step 12 Configure whether to use flow control on inbound (Receive) and outbound (Send) traffic.

 
     [bookmark: pgfId-79807]Step 13 (Optional) Enter a description for the interface in the Description field.

 
     [bookmark: pgfId-79809]Step 14 Click OK to save your definitions locally on the client and close the dialog box.

 
     [bookmark: pgfId-79811]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-79821][bookmark: 152799][bookmark: catman_proc_DeletingPortsonCatalystDevices]Deleting Ports on Cisco Catalyst Switches and Cisco 7600 Series Routers[bookmark: marker-79817][bookmark: marker-79819]

 
     [bookmark: pgfId-79823]Although you can delete the definition of an interface at any time, use this option with great care. If the relevant device includes the interface definition in any policy definitions, deleting the interface causes these policy definitions to fail when they are deployed to the device.

 
     [bookmark: pgfId-79825]Related Topics

 
      
      		 [bookmark: pgfId-79830]Creating or Editing Ports on Cisco Catalyst Switches and Cisco 7600 Series Routers

 
      		 [bookmark: pgfId-79835]Interfaces

 
     

 
     
 
     [bookmark: pgfId-79837]Step 1 (Device view) Select a Cisco Catalyst switch or Cisco 7600 Series router from the Device selector.

 
     [bookmark: pgfId-79839]Step 2 Select Interfaces/VLANs from the Policy selector.

 
     [bookmark: pgfId-79841]Step 3 Click the Interfaces tab in the work area.

 
     [bookmark: pgfId-79846]The Interfaces tab is displayed. For a description of the fields on this tab, see Interfaces/VLANs Page—Interfaces Tab.

 
     [bookmark: pgfId-79848]Step 4 Select an interface from the table, then click Delete Row. The interface is deleted.

 
     [bookmark: pgfId-79850]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-79862][bookmark: 152834][bookmark: catpage_cncpt_InterfacesVLANsPageInterfacesTab]Interfaces/VLANs Page—Interfaces Tab[bookmark: marker-79858][bookmark: marker-79860]

 
     [bookmark: pgfId-79864]Use the Interfaces tab to view and configure interfaces and subinterfaces on supported Cisco Catalyst switches and Cisco 7600 Series routers and their associated services modules (blades).

 
     [bookmark: pgfId-79866]Navigation Path

 
     [bookmark: pgfId-79868](Device view) Select Interfaces/VLANs from the Device selector, then click the Interfaces tab.

 
     [bookmark: pgfId-79870]Related Topics

 
      
      		 [bookmark: pgfId-79875]Interfaces/VLANs Page—VLANs Tab

 
      		 [bookmark: pgfId-79880]Interfaces/VLANs Page—VLAN Groups Tab

 
      		 [bookmark: pgfId-79885]Viewing a Summary of Catalyst Interfaces, VLANs, and VLAN Groups

 
      		 [bookmark: pgfId-79890]Filtering Tables

 
     

 
     [bookmark: pgfId-79892]Field Reference

 
     [bookmark: pgfId-79895] 

 
      
       
        
        [bookmark: pgfId-76001]Table 67-3 [bookmark: 152870]Interfaces/VLANs Page—Interfaces Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-76007]Element
          
  
         		
           
           [bookmark: pgfId-76009]Description
          
  
        

 
         
         		[bookmark: pgfId-76015]Name

  
         		[bookmark: pgfId-76017]Interface type, chassis slot, and the number of the interface card. For example, FastEthernet 2/7 means Fast Ethernet, slot 2, interface 7.

  
        

 
         
         		[bookmark: pgfId-76023]Mode

  
         		[bookmark: pgfId-76025]Configuration mode for physical ports:

 
           
           		 [bookmark: pgfId-76027]Access

 
           		 [bookmark: pgfId-76029]Routed

 
           		 [bookmark: pgfId-76031]Trunk

 
           		 [bookmark: pgfId-76033]Dynamic Auto

 
           		 [bookmark: pgfId-76035]Dynamic Desirable

 
           		 [bookmark: pgfId-76037]Unsupported

 
          

  
        

 
         
         		[bookmark: pgfId-76043]VLAN ID

  
         		[bookmark: pgfId-76045]The VLAN ID associated with the described subinterface, displayed only for Ethernet interfaces and VLAN interfaces.

  
        

 
         
         		[bookmark: pgfId-76051]IP Address

  
         		[bookmark: pgfId-76053]The IP address of the interface.

  
        

 
         
         		[bookmark: pgfId-76059]Enabled

  
         		[bookmark: pgfId-76061]Indicates whether the interface is enabled or disabled (shutdown state).

  
        

 
         
         		[bookmark: pgfId-76067]Interface Roles

  
         		[bookmark: pgfId-76072]The interface roles whose naming patterns match this interface. See Understanding Interface Role Objects.

  
        

 
         
         		[bookmark: pgfId-76078]Description

  
         		[bookmark: pgfId-76080]An optional description of the interface.

  
        

 
         
         		[bookmark: pgfId-76086]Add Row button

  
         		[bookmark: pgfId-76088]Opens the Create Interface dialog box, where you can define a new interface. For more information, see the instructions for the relevant mode:

 
           
           		 [bookmark: pgfId-76093]Access Port Mode—Create and Edit Interface Dialog Boxes—Access Port Mode.

 
           		 [bookmark: pgfId-76098]Routed Port Mode—Create and Edit Interface Dialog Boxes—Routed Port Mode

 
           		 [bookmark: pgfId-76103]Trunk Port Mode—Create and Edit Interface Dialog Boxes—Trunk Port Mode

 
           		 [bookmark: pgfId-76108]Dynamic Mode—Create and Edit Interface Dialog Boxes—Dynamic Mode

 
          

  
        

 
         
         		[bookmark: pgfId-76114]Edit Row button

  
         		[bookmark: pgfId-76116]Opens the Edit Interface dialog box, where you can edit the selected interface. For more information, see the instructions for the relevant mode:

 
           
           		 [bookmark: pgfId-76121]Access Port Mode—Create and Edit Interface Dialog Boxes—Access Port Mode.

 
           		 [bookmark: pgfId-76126]Routed Port Mode—Create and Edit Interface Dialog Boxes—Routed Port Mode

 
           		 [bookmark: pgfId-76131]Trunk Port Mode—Create and Edit Interface Dialog Boxes—Trunk Port Mode

 
           		 [bookmark: pgfId-76136]Dynamic Mode—Create and Edit Interface Dialog Boxes—Dynamic Mode

 
           		 [bookmark: pgfId-76141]Unsupported—Create and Edit Interface Dialog Boxes—Unsupported Mode

 
          

  
        

 
         
         		[bookmark: pgfId-76147]Delete Row button

  
         		[bookmark: pgfId-76149]Deletes the selected interface.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-79909][bookmark: 152974][bookmark: catpage_cncpt_CreateandEditInterfaceDialogBoxesAccessPortMode]Create and Edit Interface Dialog Boxes—Access Port Mode[bookmark: marker-79903][bookmark: marker-79905][bookmark: marker-79907]

 
     [bookmark: pgfId-79911]Use the Create Interface dialog box (or the Edit Interface dialog box) to configure the attributes of physical and virtual interfaces that run in access port mode.

 
     [bookmark: pgfId-79913]Navigation Path

 
     [bookmark: pgfId-79918]Go to the Interfaces/VLANs Page—Interfaces Tab, click Add or Edit to open the Create/Edit Interface dialog box, then select Access Port from the Mode list.

 
     [bookmark: pgfId-79920]Related Topics

 
      
      		 [bookmark: pgfId-79925]Create and Edit Interface Dialog Boxes—Routed Port Mode

 
      		 [bookmark: pgfId-79930]Create and Edit Interface Dialog Boxes—Trunk Port Mode

 
      		 [bookmark: pgfId-79935]Create and Edit Interface Dialog Boxes—Dynamic Mode

 
      		 [bookmark: pgfId-79940]Interface Auto Name Generator Dialog Box

 
      		 [bookmark: pgfId-79945]Understanding FlexConfig Policies and Policy Objects

 
      		 [bookmark: pgfId-79950]Understanding Interface Role Objects

 
     

 
     [bookmark: pgfId-79952]Field Reference

 
     [bookmark: pgfId-79955] 

 
      
       
        
        [bookmark: pgfId-76162]Table 67-4 [bookmark: 153020]Create and Edit Interface Dialog Boxes—Access Port Mode 

 
        
       
         
         		
           
           [bookmark: pgfId-76168]Element
          
  
         		
           
           [bookmark: pgfId-76170]Description
          
  
        

 
         
         		[bookmark: pgfId-76176]Enable Interface

  
         		[bookmark: pgfId-76178]When selected, enables the interface.

 [bookmark: pgfId-76180]When deselected, disables the interface using the shutdown command.

  
        

 
         
         		[bookmark: pgfId-76186]Type

  
         		[bookmark: pgfId-76188]Specifies whether the definitions apply to an interface or a subinterface.

 [bookmark: pgfId-76193]For details about defining a subinterface, see Create and Edit Interface Dialog Boxes—Subinterfaces.

  
        

 
         
         		[bookmark: pgfId-76199]Name (Select button)

  
         		[bookmark: pgfId-76201]Displays the generated interface name, if the name has been set.

 [bookmark: pgfId-76206]Click Select to open the Interface Auto Name Generator Dialog Box. From here, you can enter or edit the details that Security Manager uses to generate an interface name.

  
        

 
         
         		[bookmark: pgfId-76212]Mode

  
         		[bookmark: pgfId-76214]The port configuration type for this interface.

 [bookmark: pgfId-76216]Select Access Port to display the configuration options that are relevant for access ports.

  
        

 
         
         		 
           
           [bookmark: pgfId-76222]Access Port settings
          
  
        

 
         
         		[bookmark: pgfId-76230]VLAN ID (Select button)

  
         		[bookmark: pgfId-76235]Displays the interface-specific identity of the VLAN to use in access port mode, if you have selected a VLAN. Otherwise, click Select to open the VLAN Selector Dialog Box.

 [bookmark: pgfId-76237]The VLAN ID specifies where 802.1Q tagged packets are sent and received on the subinterface; without a VLAN ID, the subinterface cannot send or receive traffic. Valid values range from 1 to 4094. Some VLAN IDs might be reserved on connected devices, so see the device documentation for more information. For multiple context mode, you can only set the VLAN in the system configuration.

 [bookmark: pgfId-76239]Note All VLAN IDs must be unique among all subinterfaces configured on the same physical interface.

 command using CLI commands or FlexConfigs. Configuring VLANs on the main interface increases the number of VLANs that can be configured on the device.  
        

 
         
         		[bookmark: pgfId-76247]Enable Port Security

  
         		[bookmark: pgfId-76249]When selected, enables you to restrict input to an interface by limiting the MAC addresses that are allowed to access the port.

 [bookmark: pgfId-76251]When deselected, disables port security.

  
        

 
         
         		[bookmark: pgfId-76257]Max. MAC Addresses

  
         		[bookmark: pgfId-76259]Applies only when Enable Port Security is selected.

 [bookmark: pgfId-76261]The maximum number of secure MAC addresses for the interface. Valid values range from 1 to 4097.

 [bookmark: pgfId-76263]Note Secure MAC addresses are configured dynamically using the MAC addresses of connected devices.

  
        

 
         
         		[bookmark: pgfId-76269]Violation Policy

  
         		[bookmark: pgfId-76271]The action to take if a security violation occurs:

 
           
           		 [bookmark: pgfId-76273]Port Security Protect—Drops packets with unknown source addresses until you remove a sufficient number of secure MAC addresses and the count drops below the maximum value.

 
           		 [bookmark: pgfId-76275]Port Security Restrict—Drops packets with unknown source addresses until you remove a sufficient number of secure MAC addresses and the count drops below the maximum value. In addition, it causes the SecurityViolation counter to increment.

 
           		 [bookmark: pgfId-76277]Port Security Shutdown—Immediately puts the interface into the error-disabled state and sends an SNMP trap notification.

 
          

 [bookmark: pgfId-76279]A security violation occurs if a workstation whose MAC address is not in the address table attempts to access the interface after the maximum number of secure MAC addresses is configured.

  
        

 
         
         		[bookmark: pgfId-76285]Enable VACL Capture

  
         		[bookmark: pgfId-76287]When selected, enables VACL capture. If the capture bit is set, ports with the capture function enabled can receive forwarded packets.

 [bookmark: pgfId-76289]When deselected, disables VACL capture.

  
        

 
         
         		[bookmark: pgfId-76295]Capture VLANs (Select button)

  
         		[bookmark: pgfId-76297]Enables you to identify the VLANs where VACLs should receive forwarded VLAN packets. This option is available if you selected the Enable VACL Capture check box.

 [bookmark: pgfId-76302]Enter a comma-separated list of VLAN IDs or click Select to open the VLAN Selector Dialog Box.

 [bookmark: pgfId-76304]VACLs can capture VLAN packets only when they are initially routed or bridged into the VLAN. Only forwarded packets can be captured.

  
        

 
         
         		 
           
           [bookmark: pgfId-76310]Common interface settings
          
  
        

 
         
         		[bookmark: pgfId-76318]Speed

  
         		[bookmark: pgfId-76320]The speed of the physical interface:

 
           
           		 [bookmark: pgfId-76322]10—Transmits at 10 Mbps.

 
           		 [bookmark: pgfId-76324]100—Transmits at 100 Mbps.

 
           		 [bookmark: pgfId-76326]1000—Transmits at 1,000 Mbps.

 
           		 [bookmark: pgfId-76328]10000—Transmits at 10,000 Mbps.

 
           		 [bookmark: pgfId-76330]Auto—If Speed is set to Auto, both Speed and Duplex are autonegotiated.

 
           		 [bookmark: pgfId-76332]Non-Negotiate—Disables link negotiation.

 
          

  
        

 
         
         		[bookmark: pgfId-76338]Duplex

  
         		[bookmark: pgfId-76340]The duplex setting of the interface:

 
           
           		 [bookmark: pgfId-76342]Auto—Autonegotiates the duplex.

 
           		 [bookmark: pgfId-76344]Half—Sends and receives data, but not at the same time

 
           		 [bookmark: pgfId-76346]Full—Sends and receives data at the same time.

 
          

 [bookmark: pgfId-76348]If the speed is set to Auto, the duplex setting must also be set to Auto.

  
        

 
         
         		[bookmark: pgfId-76354]MTU

  
         		[bookmark: pgfId-76356]The maximum transmission unit, which refers to the largest packet size (in bytes) that can be handled by the interface. The range of valid values depends on the interface type.

  
        

 
         
         		[bookmark: pgfId-76362]Description

  
         		[bookmark: pgfId-76364]A text description of the interface. Enter up to 240 characters on a single line, without using carriage returns.

 [bookmark: pgfId-76366]Note For multiple context mode, the system description is independent of the context description.

  
        

 
         
         		[bookmark: pgfId-76372]Flow Control Receive

  
         		[bookmark: pgfId-76374]The flow control setting for incoming frames:

 
           
           		 [bookmark: pgfId-76376]Off—The port does not use flow control, regardless of whether the neighboring port requests flow control.

 
           		 [bookmark: pgfId-76378]On—The port uses flow control, as dictated by the neighboring port.

 
           		 [bookmark: pgfId-76380]Desired—The port allows, but does not require, flow control frames.

 
          

 [bookmark: pgfId-76382]Flow control frames (also called pause frames) are special packets that signal a source to stop sending frames for a defined interval when buffers are full.

  
        

 
         
         		[bookmark: pgfId-76388]Flow Control Send

  
         		[bookmark: pgfId-76390]The flow control setting for outgoing frames:

 
           
           		 [bookmark: pgfId-76392]Off—The port does not send flow control frames to the neighboring port.

 
           		 [bookmark: pgfId-76394]On—The port sends flow control frames to the neighboring port.

 
           		 [bookmark: pgfId-76396]Desired—The port allows, but does not require, flow control frames.

 
          

  
        

 
         
         		[bookmark: pgfId-76402]Roles

  
         		[bookmark: pgfId-76407]Lists the interface roles associated with the interface. Interface roles are objects that are replaced with the actual interface IP addresses when the configuration is generated for each device. They allow you to define generic rules—ones that can apply to multiple interfaces. See Understanding Interface Role Objects.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-79969][bookmark: 153194][bookmark: catpage_cncpt_CreateandEditInterfaceDialogBoxesRoutedPortMode]Create and Edit Interface Dialog Boxes—Routed Port Mode[bookmark: marker-79963][bookmark: marker-79965][bookmark: marker-79967]

 
     [bookmark: pgfId-79971]Use the Create Interface dialog box (or the Edit Interface dialog box) to configure the attributes of physical interfaces that run in routed port mode on Layer 3.

 
     [bookmark: pgfId-79973]Navigation Path

 
     [bookmark: pgfId-79978]Go to the Interfaces/VLANs Page—Interfaces Tab, click Add or Edit to open the Create/Edit Interface dialog box, then select Routed Port from the Mode list.

 
     [bookmark: pgfId-79980]Related Topics

 
      
      		 [bookmark: pgfId-79985]Create and Edit Interface Dialog Boxes—Access Port Mode

 
      		 [bookmark: pgfId-79990]Create and Edit Interface Dialog Boxes—Trunk Port Mode

 
      		 [bookmark: pgfId-79995]Create and Edit Interface Dialog Boxes—Dynamic Mode

 
      		 [bookmark: pgfId-80000]Understanding Interface Role Objects

 
      		 [bookmark: pgfId-80005]Selecting Objects for Policies

 
      		 [bookmark: pgfId-80010]Understanding Networks/Hosts Objects

 
     

 
     [bookmark: pgfId-80012]Field Reference

 
     [bookmark: pgfId-80015] 

 
      
       
        
        [bookmark: pgfId-76420]Table 67-5 [bookmark: 153240]Create and Edit Interface Dialog Boxes—Routed Port Mode 

 
        
       
         
         		
           
           [bookmark: pgfId-76426]Element
          
  
         		
           
           [bookmark: pgfId-76428]Description
          
  
        

 
         
         		[bookmark: pgfId-76434]Enable Interface

  
         		[bookmark: pgfId-76436]When selected, enables the interface.

 [bookmark: pgfId-76438]When deselected, disables the interface using the shutdown command.

  
        

 
         
         		[bookmark: pgfId-76444]Type

  
         		[bookmark: pgfId-76446]Specifies whether the definitions apply to an interface or a subinterface.

 [bookmark: pgfId-76451]For details about defining a subinterface, see Create and Edit Interface Dialog Boxes—Subinterfaces.

  
        

 
         
         		[bookmark: pgfId-76457]Name (Select button)

  
         		[bookmark: pgfId-76459]Displays the generated interface name, if the name has been set.

 [bookmark: pgfId-76464]Click Select to open the Interface Auto Name Generator Dialog Box. From here, you can enter or edit the details that Security Manager uses to generate an interface name.

  
        

 
         
         		[bookmark: pgfId-76470]Mode

  
         		[bookmark: pgfId-76472]The port configuration type for this interface.

 [bookmark: pgfId-76474]Select Routed Port to display the configuration options that are relevant for routed ports.

  
        

 
         
         		 
           
           [bookmark: pgfId-76480]Routed Port settings
          
  
        

 
         
         		[bookmark: pgfId-76488]IP Type

  
         		[bookmark: pgfId-76490]The type of IP address used by the port:

 
           
           		 [bookmark: pgfId-76492]Static IP—Specifies that the interface uses a permanent IP address and activates related GUI elements.

 
          

  
        

 
         
         		[bookmark: pgfId-76498]IP Address (Select button)

  
         		[bookmark: pgfId-76500]Enables you to enter an IP address, or you can click Select to open the Networks/Hosts Selector, where you can select an IP address.

  
        

 
         
         		[bookmark: pgfId-76506]Helper IP Addresses (Select button)

  
         		[bookmark: pgfId-76508]Enables you to assign a helper IP address to the interface. A helper IP address converts broadcast DHCP requests to unicast requests that are directed exclusively to the DHCP server.

  
        

 
         
         		[bookmark: pgfId-76514]Mask

  
         		[bookmark: pgfId-76516]Enables you to specify the subnet mask. You can enter a netmask value or you can select a netmask from the list. If you enter a netmask, you can express its value in dotted decimal format (for example, 255.255.255.0) or you can enter the number of bits (for example, 24).

 [bookmark: pgfId-76518]Note Do not use 255.255.255.254 or 255.255.255.255 for any interface that is connected to your network; these netmasks cause all traffic on an interface to stop.

  
        

 
         
         		 
           
           [bookmark: pgfId-76524]Common interface settings
          
  
        

 
         
         		[bookmark: pgfId-76532]Speed

  
         		[bookmark: pgfId-76534]The speed of the physical interface:

 
           
           		 [bookmark: pgfId-76536]10—Transmits at 10 Mbps.

 
           		 [bookmark: pgfId-76538]100—Transmits at 100 Mbps.

 
           		 [bookmark: pgfId-76540]1000—Transmits at 1,000 Mbps.

 
           		 [bookmark: pgfId-76542]10000—Transmits at 10,000 Mbps.

 
           		 [bookmark: pgfId-76544]Auto—If Speed is set to Auto, both Speed and Duplex are autonegotiated.

 
           		 [bookmark: pgfId-76546]Non-Negotiate—Disables link negotiation.

 
          

  
        

 
         
         		[bookmark: pgfId-76552]Duplex

  
         		[bookmark: pgfId-76554]The duplex setting of the interface:

 
           
           		 [bookmark: pgfId-76556]Auto—Autonegotiates the duplex.

 
           		 [bookmark: pgfId-76558]Half—Sends and receives data, but not at the same time

 
           		 [bookmark: pgfId-76560]Full—Sends and receives data at the same time.

 
          

 [bookmark: pgfId-76562]If the speed is set to Auto, the duplex setting must also be set to Auto.

  
        

 
         
         		[bookmark: pgfId-76568]MTU

  
         		[bookmark: pgfId-76570]The maximum transmission unit, which refers to the largest packet size (in bytes) that can be handled by the interface. The range of valid values depends on the interface type.

  
        

 
         
         		[bookmark: pgfId-76576]Description

  
         		[bookmark: pgfId-76578]A text description of the interface. Enter up to 240 characters on a single line, without using carriage returns.

 [bookmark: pgfId-76580]Note For multiple context mode, the system description is independent of the context description.

  
        

 
         
         		[bookmark: pgfId-76586]Flow Control Receive

  
         		[bookmark: pgfId-76588]The flow control setting for incoming frames:

 
           
           		 [bookmark: pgfId-76590]Off—The port does not use flow control, regardless of whether the neighboring port requests flow control.

 
           		 [bookmark: pgfId-76592]On—The port uses flow control, as dictated by the neighboring port.

 
           		 [bookmark: pgfId-76594]Desired—The port allows, but does not require, flow control frames.

 
          

 [bookmark: pgfId-76596]Flow control frames (also called pause frames) are special packets that signal a source to stop sending frames for a defined interval when buffers are full.

  
        

 
         
         		[bookmark: pgfId-76602]Flow Control Send

  
         		[bookmark: pgfId-76604]The flow control setting for outgoing frames:

 
           
           		 [bookmark: pgfId-76606]Off—The port does not send flow control frames to the neighboring port.

 
           		 [bookmark: pgfId-76608]On—The port sends flow control frames to the neighboring port.

 
           		 [bookmark: pgfId-76610]Desired—The port allows, but does not require, flow control frames.

 
          

  
        

 
         
         		[bookmark: pgfId-76616]Roles

  
         		[bookmark: pgfId-76621]Lists the interface roles associated with the interface. Interface roles are objects that are replaced with the actual interface IP addresses when the configuration is generated for each device. They allow you to define generic rules—ones that can apply to multiple interfaces. See Understanding Interface Role Objects.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-80029][bookmark: 153387][bookmark: catpage_cncpt_CreateandEditInterfaceDialogBoxesTrunkPortMode]Create and Edit Interface Dialog Boxes—Trunk Port Mode[bookmark: marker-80023][bookmark: marker-80025][bookmark: marker-80027]

 
     [bookmark: pgfId-80031]Use the Create Interface dialog box (or the Edit Interface dialog box) to configure the attributes of physical and virtual interfaces that run in trunk port mode.

 
     [bookmark: pgfId-80033]Navigation Path

 
     [bookmark: pgfId-80038]Go to the Interfaces/VLANs Page—Interfaces Tab, click Add or Edit to open the Create/Edit Interface dialog box, then select Trunk Port from the Mode list.

 
     [bookmark: pgfId-80040]Related Topics

 
      
      		 [bookmark: pgfId-80045]Create and Edit Interface Dialog Boxes—Access Port Mode

 
      		 [bookmark: pgfId-80050]Create and Edit Interface Dialog Boxes—Routed Port Mode

 
      		 [bookmark: pgfId-80055]Create and Edit Interface Dialog Boxes—Dynamic Mode

 
      		 [bookmark: pgfId-80060]Understanding FlexConfig Policies and Policy Objects

 
      		 [bookmark: pgfId-80065]Understanding Interface Role Objects

 
     

 
     [bookmark: pgfId-80067]Field Reference

 
     [bookmark: pgfId-80070] 

 
      
       
        
        [bookmark: pgfId-76634]Table 67-6 [bookmark: 153430]Create and Edit Interface Dialog Boxes—Trunk Port Mode 

 
        
       
         
         		
           
           [bookmark: pgfId-76640]Element
          
  
         		
           
           [bookmark: pgfId-76642]Description
          
  
        

 
         
         		[bookmark: pgfId-76648]Enable Interface

  
         		[bookmark: pgfId-76650]When selected, enables the interface.

 [bookmark: pgfId-76652]When deselected, disables the interface using the shutdown command.

  
        

 
         
         		[bookmark: pgfId-76658]Type

  
         		[bookmark: pgfId-76660]Specifies whether the definitions apply to an interface or a subinterface.

 [bookmark: pgfId-76665]For details about defining a subinterface, see Create and Edit Interface Dialog Boxes—Subinterfaces.

  
        

 
         
         		[bookmark: pgfId-76671]Name (Select button)

  
         		[bookmark: pgfId-76673]Displays the generated interface name, if the name has been set.

 [bookmark: pgfId-76678]Click Select to open the Interface Auto Name Generator Dialog Box. From here, you can enter or edit the details that Security Manager uses to generate an interface name.

  
        

 
         
         		[bookmark: pgfId-76684]Mode

  
         		[bookmark: pgfId-76686]The port configuration type for this interface.

 [bookmark: pgfId-76688]Select Trunk Port to display the configuration options that are relevant for trunk ports.

  
        

 
         
         		 
           
           [bookmark: pgfId-76694]Trunk Port settings
          
  
        

 
         
         		[bookmark: pgfId-76702]Encapsulation

  
         		[bookmark: pgfId-76704]Select one of the following:

 
           
           		 [bookmark: pgfId-76706]DOT1Q—Specifies VLAN encapsulation on the trunk link, as defined by the IEEE 802.1Q standard. Applies only to Ethernet subinterfaces.

 
           		 [bookmark: pgfId-76708]ISL—Specifies ISL encapsulation on the trunk link. 10-Gigabit Ethernet ports do not support ISL encapsulation.

 
          

 command using CLI commands or FlexConfigs. Configuring VLANs on the main interface increases the number of VLANs that can be configured on the router.  
        

 
         
         		[bookmark: pgfId-76716]Native VLAN (Select button)

  
         		[bookmark: pgfId-76718]Enables you to select the Native VLAN to associate with this interface, using the ID specified in the VLAN ID field. (If no VLAN ID is specified for the Native VLAN, the default is 1.) This option applies to you only if you are configuring a physical interface that is meant to serve as an 802.1Q trunk interface.

 [bookmark: pgfId-76720]You must first specify DOT1Q as the encapsulation type.

 [bookmark: pgfId-76722]The Native VLAN of a trunk interface is the VLAN to which all untagged VLAN packets are logically assigned. This includes the management traffic associated with the VLAN.

 [bookmark: pgfId-76724]When deselected, the Native VLAN is not associated with this interface.

 [bookmark: pgfId-76726]Note The Native VLAN cannot be configured on a subinterface of the trunk interface. Be sure to configure the same Native VLAN value at both ends of the link; otherwise, traffic may be lost or sent to the wrong VLAN.

 [bookmark: pgfId-76731]Click Select to open the VLAN Selector Dialog Box. From here, you can associate a native VLAN with the described interface.

  
        

 
         
         		[bookmark: pgfId-76737]Enable DTP negotiation

  
         		[bookmark: pgfId-76739]When selected, enables Dynamic Trunking Protocol (DTP) negotiation. DTP manages trunk auto-negotiation (ISL and 802.1Q) between devices.

 [bookmark: pgfId-76741]When deselected, disables DTP negotiation.

  
        

 
         
         		[bookmark: pgfId-76747]Allowed VLANs (Select button)

  
         		[bookmark: pgfId-76749]Enables you to specify which VLANs are allowed on the trunk. Enter the VLAN IDs. Use commas to separate multiple VLANs or use a hyphen to indicate a range of VLANs (for example, 12,17,22 or 2-200). Valid IDs range from 1 to 4094.

 [bookmark: pgfId-76754]Or, click Select to open the VLAN Selector Dialog Box. From here, you can select the VLANs to include on the trunk.

  
        

 
         
         		[bookmark: pgfId-76760]Prune VLANs (Select button)

  
         		[bookmark: pgfId-76762]Enables you to specify which VLANs are eligible for pruning. Enter the VLAN IDs. Use commas to separate multiple VLANs or use a hyphen to indicate a range of VLANs (for example, 12,17,22 or 2-200.)

 [bookmark: pgfId-76767]Or, click Select to open the VLAN Selector Dialog Box. From here, you can select the VLANs that are eligible for pruning.

  
        

 
         
         		[bookmark: pgfId-76773]Enable VACL Capture

  
         		[bookmark: pgfId-76775]When selected, enables VACL capture. If the capture bit is set, ports with the capture function enabled can receive forwarded packets.

 [bookmark: pgfId-76777]When deselected, disables VACL capture.

  
        

 
         
         		[bookmark: pgfId-76783]Capture VLANs (Select button)

  
         		[bookmark: pgfId-76785]Enables you to identify the VLANs where VACLs should receive forwarded VLAN packets. This option is available if you selected the Enable VACL Capture check box.

 [bookmark: pgfId-76790]Enter a comma-separated list of VLAN IDs, or click Select to open the VLAN Selector Dialog Box.

 [bookmark: pgfId-76792]VACLs can capture VLAN packets only when they are initially routed or bridged into the VLAN. Only forwarded packets can be captured.

  
        

 
         
         		[bookmark: pgfId-76798]Enable Port Security

  
         		[bookmark: pgfId-76800]Applies only to devices running IOS Software Version 12.2(18)SXE2 or later.

 [bookmark: pgfId-76802]When selected, enables you to restrict input to an interface by limiting the MAC addresses that are allowed to access the port.

 [bookmark: pgfId-76804]When deselected, disables port security.

 [bookmark: pgfId-76806]Note If you select this option, the Enable DTP Negotiation option is automatically deselected.

  
        

 
         
         		[bookmark: pgfId-76812]Max. MAC Addresses

  
         		[bookmark: pgfId-76814]Applies only when Enable Port Security is selected.

 [bookmark: pgfId-76816]The maximum number of secure MAC addresses for the interface. Valid values range from 1 to 4097.

 [bookmark: pgfId-76818]Note Secure MAC addresses are configured dynamically using the MAC addresses of connected devices.

  
        

 
         
         		[bookmark: pgfId-76824]Violation Policy

  
         		[bookmark: pgfId-76826]The action to take if a security violation occurs:

 
           
           		 [bookmark: pgfId-76828]Port Security Protect—Drops packets with unknown source addresses until you remove a sufficient number of secure MAC addresses and the count drops below the maximum value.

 
           		 [bookmark: pgfId-76830]Port Security Restrict—Drops packets with unknown source addresses until you remove a sufficient number of secure MAC addresses and the count drops below the maximum value. In addition, it causes the SecurityViolation counter to increment.

 
           		 [bookmark: pgfId-76832]Port Security Shutdown—Immediately puts the interface into the error-disabled state and sends an SNMP trap notification.

 
          

 [bookmark: pgfId-76834]A security violation occurs if a workstation whose MAC address is not in the address table attempts to access the interface after the maximum number of secure MAC addresses is configured.

  
        

 
         
         		 
           
           [bookmark: pgfId-76840]Common interface settings
          
  
        

 
         
         		[bookmark: pgfId-76848]Speed

  
         		[bookmark: pgfId-76850]The speed of the physical interface:

 
           
           		 [bookmark: pgfId-76852]10—Transmits at 10 Mbps.

 
           		 [bookmark: pgfId-76854]100—Transmits at 100 Mbps.

 
           		 [bookmark: pgfId-76856]1000—Transmits at 1,000 Mbps.

 
           		 [bookmark: pgfId-76858]10000—Transmits at 10,000 Mbps.

 
           		 [bookmark: pgfId-76860]Auto—If Speed is set to Auto, both Speed and Duplex are autonegotiated.

 
           		 [bookmark: pgfId-76862]Non-Negotiate—Disables link negotiation.

 
          

  
        

 
         
         		[bookmark: pgfId-76868]Duplex

  
         		[bookmark: pgfId-76870]The duplex setting of the interface:

 
           
           		 [bookmark: pgfId-76872]Auto—Autonegotiates the duplex.

 
           		 [bookmark: pgfId-76874]Half—Sends and receives data, but not at the same time

 
           		 [bookmark: pgfId-76876]Full—Sends and receives data at the same time.

 
          

 [bookmark: pgfId-76878]If the speed is set to Auto, the duplex setting must also be set to Auto.

  
        

 
         
         		[bookmark: pgfId-76884]MTU

  
         		[bookmark: pgfId-76886]The maximum transmission unit, which refers to the largest packet size (in bytes) that can be handled by the interface. The range of valid values depends on the interface type.

  
        

 
         
         		[bookmark: pgfId-76892]Description

  
         		[bookmark: pgfId-76894]A text description of the interface. Enter up to 240 characters on a single line, without using carriage returns.

 [bookmark: pgfId-76896]Note For multiple context mode, the system description is independent of the context description.

  
        

 
         
         		[bookmark: pgfId-76902]Flow Control Receive

  
         		[bookmark: pgfId-76904]The flow control setting for incoming frames:

 
           
           		 [bookmark: pgfId-76906]Off—The port does not use flow control, regardless of whether the neighboring port requests flow control.

 
           		 [bookmark: pgfId-76908]On—The port uses flow control, as dictated by the neighboring port.

 
           		 [bookmark: pgfId-76910]Desired—The port allows, but does not require, flow control frames.

 
          

 [bookmark: pgfId-76912]Flow control frames (also called pause frames) are special packets that signal a source to stop sending frames for a defined interval when buffers are full.

  
        

 
         
         		[bookmark: pgfId-76918]Flow Control Send

  
         		[bookmark: pgfId-76920]The flow control setting for outgoing frames:

 
           
           		 [bookmark: pgfId-76922]Off—The port does not send flow control frames to the neighboring port.

 
           		 [bookmark: pgfId-76924]On—The port sends flow control frames to the neighboring port.

 
           		 [bookmark: pgfId-76926]Desired—The port allows, but does not require, flow control frames.

 
          

  
        

 
         
         		[bookmark: pgfId-76932]Roles

  
         		[bookmark: pgfId-76937]Lists the interface roles associated with the interface. Interface roles are objects that are replaced with the actual interface IP addresses when the configuration is generated for each device. They allow you to define generic rules—ones that can apply to multiple interfaces. See Understanding Interface Role Objects.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-80082][bookmark: 153641][bookmark: catpage_cncpt_CreateandEditInterfaceDialogBoxesDynamicMode]Create and Edit Interface Dialog Boxes—Dynamic Mode[bookmark: marker-80078][bookmark: marker-80080]

 
     [bookmark: pgfId-80084]Use the Create Interface dialog box (or the Edit Interface dialog box) to configure the attributes of physical and virtual interfaces that run in dynamic mode. Dynamic ports can convert the link into a trunk link based on the settings of the neighboring port.

 
     [bookmark: pgfId-80086]Navigation Path

 
     [bookmark: pgfId-80091]Go to the Interfaces/VLANs Page—Interfaces Tab, click Add or Edit to open the Create/Edit Interface dialog box, then select Dynamic from the Mode list.

 
     [bookmark: pgfId-80093]Related Topics

 
      
      		 [bookmark: pgfId-80098]Create and Edit Interface Dialog Boxes—Access Port Mode

 
      		 [bookmark: pgfId-80103]Create and Edit Interface Dialog Boxes—Routed Port Mode

 
      		 [bookmark: pgfId-80108]Create and Edit Interface Dialog Boxes—Trunk Port Mode

 
      		 [bookmark: pgfId-80113]Interface Auto Name Generator Dialog Box

 
      		 [bookmark: pgfId-80118]Understanding FlexConfig Policies and Policy Objects

 
      		 [bookmark: pgfId-80123]Understanding Interface Role Objects

 
     

 
     [bookmark: pgfId-80125]Field Reference

 
     [bookmark: pgfId-80128] 

 
      
       
        
        [bookmark: pgfId-76950]Table 67-7 [bookmark: 153684]Create and Edit Interface Dialog Boxes—Dynamic Mode 

 
        
       
         
         		
           
           [bookmark: pgfId-76956]Element
          
  
         		
           
           [bookmark: pgfId-76958]Description
          
  
        

 
         
         		[bookmark: pgfId-76964]Enable Interface

  
         		[bookmark: pgfId-76966]When selected, enables the interface.

 [bookmark: pgfId-76968]When deselected, disables the interface using the shutdown command.

  
        

 
         
         		[bookmark: pgfId-76974]Type

  
         		[bookmark: pgfId-76976]Specifies whether the definitions apply to an interface or a subinterface.

 [bookmark: pgfId-76981]For details about defining a subinterface, see Create and Edit Interface Dialog Boxes—Subinterfaces.

  
        

 
         
         		[bookmark: pgfId-76987]Name (Select button)

  
         		[bookmark: pgfId-76989]Displays the generated interface name, if the name has been set.

 [bookmark: pgfId-76994]Click Select to open the Interface Auto Name Generator Dialog Box. From here, you can enter or edit the details that Security Manager uses to generate an interface name.

  
        

 
         
         		[bookmark: pgfId-77000]Mode

  
         		[bookmark: pgfId-77002]The port configuration type for this interface.

 [bookmark: pgfId-77004]Select Dynamic to display the configuration options that are relevant for dynamic ports.

  
        

 
         
         		 
           
           [bookmark: pgfId-77010]Dynamic Port settings
          
  
        

 
         
         		[bookmark: pgfId-77018]Dynamic Mode

  
         		[bookmark: pgfId-77020]The dynamic trunk mode:

 
           
           		 [bookmark: pgfId-77022]Auto—Allows the port to convert the link to a trunk link. The port becomes a trunk port if the neighboring port is set to Trunk or Desirable mode.

 
           		 [bookmark: pgfId-77024]Desirable—Makes the port actively attempt to convert the link to a trunk link.

 
          

  
        

 
         
         		[bookmark: pgfId-77030]Access VLAN ID

  
         		[bookmark: pgfId-77032]The access VLAN ID to use when the port does not function as a trunking link. This can occur when the neighboring interface is not set to trunk, auto, or desirable mode.

 [bookmark: pgfId-77034]Valid values range from 1 to 4094.

  
        

 
         
         		[bookmark: pgfId-77040]Encapsulation

  
         		[bookmark: pgfId-77042]Select one of the following:

 
           
           		 [bookmark: pgfId-77044]DOT1Q—Specifies VLAN encapsulation on the trunk link, as defined by the IEEE 802.1Q standard. Applies only to Ethernet subinterfaces.

 
           		 [bookmark: pgfId-77046]ISL—Specifies ISL encapsulation on the trunk link. 10-Gigabit Ethernet ports do not support ISL encapsulation.

 
           		 [bookmark: pgfId-77048]Negotiate—Specifies that the interface negotiates with the neighboring interface to become either an ISL or 802.1Q trunk, based on the configuration and capabilities of the neighboring interface.

 
          

 command using CLI commands or FlexConfigs. Configuring VLANs on the main interface increases the number of VLANs that can be configured on the router.  
        

 
         
         		[bookmark: pgfId-77056]Native VLAN (Select button)

  
         		[bookmark: pgfId-77058]Enables you to select the Native VLAN to associate with this interface, using the ID specified in the VLAN ID field. (If no VLAN ID is specified for the Native VLAN, the default is 1.) This option applies to you only if you are configuring a physical interface that is meant to serve as an 802.1Q trunk interface.

 [bookmark: pgfId-77060]You must first specify DOT1Q as the encapsulation type.

 [bookmark: pgfId-77062]The Native VLAN of a trunk interface is the VLAN to which all untagged VLAN packets are logically assigned. This includes the management traffic associated with the VLAN.

 [bookmark: pgfId-77064]When deselected, the Native VLAN is not associated with this interface.

 [bookmark: pgfId-77066]Note The Native VLAN cannot be configured on a subinterface of the trunk interface. Be sure to configure the same Native VLAN value at both ends of the link; otherwise, traffic may be lost or sent to the wrong VLAN.

 [bookmark: pgfId-77071]Click Select to open the VLAN Selector Dialog Box. From here, you can associate a native VLAN with the described interface.

  
        

 
         
         		[bookmark: pgfId-77077]Allowed VLANs (Select button)

  
         		[bookmark: pgfId-77079]Enables you to specify which VLANs are allowed on the trunk. Enter the VLAN IDs. Use commas to separate multiple VLANs or use a hyphen to indicate a range of VLANs (for example, 12,17,22 or 2-200). Valid IDs range from 1 to 4094.

 [bookmark: pgfId-77084]Alternatively, click Select to open the VLAN Selector Dialog Box. From here, you can select the VLANs to include on the trunk.

  
        

 
         
         		[bookmark: pgfId-77090]Prune VLANs (Select button)

  
         		[bookmark: pgfId-77092]Enables you to specify which VLANs are eligible for pruning. Enter the VLAN IDs. Use commas to separate multiple VLANs or use a hyphen to indicate a range of VLANs (for example, 12,17,22 or 2-200.)

 [bookmark: pgfId-77097]Alternatively, click Select to open the VLAN Selector Dialog Box. From here, you can select the VLANs that are eligible for pruning.

  
        

 
         
         		[bookmark: pgfId-77103]Enable VACL Capture

  
         		[bookmark: pgfId-77105]When selected, enables VACL capture. If the capture bit is set, ports with the capture function enabled can receive forwarded packets.

 [bookmark: pgfId-77107]When deselected, disables VACL capture.

  
        

 
         
         		[bookmark: pgfId-77113]Capture VLANs (Select button)

  
         		[bookmark: pgfId-77115]Enables you to identify the VLANs where VACLs should receive forwarded VLAN packets. This option is available if you selected the Enable VACL Capture check box.

 [bookmark: pgfId-77120]Enter a comma-separated list of VLAN IDs or click Select to open the VLAN Selector Dialog Box.

 [bookmark: pgfId-77122]VACLs can capture VLAN packets only when they are initially routed or bridged into the VLAN. Only forwarded packets can be captured.

  
        

 
         
         		 
           
           [bookmark: pgfId-77128]Common interface settings
          
  
        

 
         
         		[bookmark: pgfId-77136]Speed

  
         		[bookmark: pgfId-77138]The speed of the physical interface:

 
           
           		 [bookmark: pgfId-77140]10—Transmits at 10 Mbps.

 
           		 [bookmark: pgfId-77142]100—Transmits at 100 Mbps.

 
           		 [bookmark: pgfId-77144]1000—Transmits at 1,000 Mbps.

 
           		 [bookmark: pgfId-77146]10000—Transmits at 10,000 Mbps.

 
           		 [bookmark: pgfId-77148]Auto—If Speed is set to Auto, both Speed and Duplex are autonegotiated.

 
           		 [bookmark: pgfId-77150]Non-Negotiate—Disables link negotiation.

 
          

  
        

 
         
         		[bookmark: pgfId-77156]Duplex

  
         		[bookmark: pgfId-77158]The duplex setting of the interface:

 
           
           		 [bookmark: pgfId-77160]Auto—Autonegotiates the duplex.

 
           		 [bookmark: pgfId-77162]Half—Sends and receives data, but not at the same time

 
           		 [bookmark: pgfId-77164]Full—Sends and receives data at the same time.

 
          

 [bookmark: pgfId-77166]If the speed is set to Auto, the duplex setting must also be set to Auto.

  
        

 
         
         		[bookmark: pgfId-77172]MTU

  
         		[bookmark: pgfId-77174]The maximum transmission unit, which refers to the largest packet size (in bytes) that can be handled by the interface. The range of valid values depends on the interface type.

  
        

 
         
         		[bookmark: pgfId-77180]Description

  
         		[bookmark: pgfId-77182]A text description of the interface. Enter up to 240 characters on a single line, without using carriage returns.

 [bookmark: pgfId-77184]Note For multiple context mode, the system description is independent of the context description.

  
        

 
         
         		[bookmark: pgfId-77190]Flow Control Receive

  
         		[bookmark: pgfId-77192]The flow control setting for incoming frames:

 
           
           		 [bookmark: pgfId-77194]Off—The port does not use flow control, regardless of whether the neighboring port requests flow control.

 
           		 [bookmark: pgfId-77196]On—The port uses flow control, as dictated by the neighboring port.

 
           		 [bookmark: pgfId-77198]Desired—The port allows, but does not require, flow control frames.

 
          

 [bookmark: pgfId-77200]Flow control frames (also called pause frames) are special packets that signal a source to stop sending frames for a defined interval when buffers are full.

  
        

 
         
         		[bookmark: pgfId-77206]Flow Control Send

  
         		[bookmark: pgfId-77208]The flow control setting for outgoing frames:

 
           
           		 [bookmark: pgfId-77210]Off—The port does not send flow control frames to the neighboring port.

 
           		 [bookmark: pgfId-77212]On—The port sends flow control frames to the neighboring port.

 
           		 [bookmark: pgfId-77214]Desired—The port allows, but does not require, flow control frames.

 
          

  
        

 
         
         		[bookmark: pgfId-77220]Roles

  
         		[bookmark: pgfId-77225]Lists the interface roles associated with the interface. Interface roles are objects that are replaced with the actual interface IP addresses when the configuration is generated for each device. They allow you to define generic rules—ones that can apply to multiple interfaces. See Understanding Interface Role Objects.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-80140][bookmark: 153880][bookmark: catpage_cncpt_CreateandEditInterfaceDialogBoxesSubinterfaces]Create and Edit Interface Dialog Boxes—Subinterfaces[bookmark: marker-80136][bookmark: marker-80138]

 
     [bookmark: pgfId-80142]Use the Create Interface dialog box (or the Edit Interface dialog box) to configure the attributes of subinterfaces defined on Catalyst 6500/7600 devices.

 
     [bookmark: pgfId-80144]Navigation Path

 
     [bookmark: pgfId-80149]Go to the Interfaces/VLANs Page—Interfaces Tab, click Add or Edit to open the Create/Edit Interface dialog box, then select Subinterface from the Type list.

 
     [bookmark: pgfId-80151]Related Topics

 
      
      		 [bookmark: pgfId-80156]Create and Edit Interface Dialog Boxes—Access Port Mode

 
      		 [bookmark: pgfId-80161]Create and Edit Interface Dialog Boxes—Routed Port Mode

 
      		 [bookmark: pgfId-80166]Create and Edit Interface Dialog Boxes—Trunk Port Mode

 
      		 [bookmark: pgfId-80171]Create and Edit Interface Dialog Boxes—Dynamic Mode

 
      		 [bookmark: pgfId-80176]Understanding Interface Role Objects

 
     

 
     [bookmark: pgfId-80178]Field Reference

 
     [bookmark: pgfId-80181] 

 
      
       
        
        [bookmark: pgfId-77238]Table 67-8 [bookmark: 153920]Create and Edit Interface Dialog Boxes—Subinterfaces 

 
        
       
         
         		
           
           [bookmark: pgfId-77244]Element
          
  
         		
           
           [bookmark: pgfId-77246]Description
          
  
        

 
         
         		[bookmark: pgfId-77252]Enable Interface

  
         		[bookmark: pgfId-77254]When selected, enables the subinterface.

 [bookmark: pgfId-77256]When deselected, disables the subinterface using the shutdown command.

  
        

 
         
         		[bookmark: pgfId-77262]Type

  
         		[bookmark: pgfId-77264]Specifies whether the definitions apply to an interface or a subinterface. Select Subinterface.

  
        

 
         
         		[bookmark: pgfId-77270]Parent

  
         		[bookmark: pgfId-77272]Identifies the parent interface of the subinterface.

  
        

 
         
         		[bookmark: pgfId-77278]Subint. ID

  
         		[bookmark: pgfId-77280]Specifies the ID for the subinterface. The numeric ID string cannot exceed 10 characters.

  
        

 
         
         		[bookmark: pgfId-77286]IP Type

  
         		[bookmark: pgfId-77288]The type of IP address used by the subinterface:

 
           
           		 [bookmark: pgfId-77290]Static IP—Specifies that the subinterface uses a permanent IP address and activates related GUI elements.

 
          

  
        

 
         
         		[bookmark: pgfId-77296]IP Address

  
         		[bookmark: pgfId-77298]Enables you to enter an IP address.

  
        

 
         
         		[bookmark: pgfId-77304]Helper IP Addresses

  
         		[bookmark: pgfId-77306]Enables you to assign a helper IP address to the subinterface. A helper IP address converts broadcast DHCP requests to unicast requests that are directed exclusively to the DHCP server.

  
        

 
         
         		[bookmark: pgfId-77312]Mask

  
         		[bookmark: pgfId-77314]Enables you to specify the subnet mask. You can enter a netmask value or you can select a netmask from the list. If you enter a netmask, you can express its value in dotted decimal format (for example, 255.255.255.0) or you can enter the number of bits (for example, 24).

 [bookmark: pgfId-77316]Note Do not use 255.255.255.254 or 255.255.255.255 for any interface that is connected to your network; these netmasks cause all traffic on an interface to stop.

  
        

 
         
         		[bookmark: pgfId-77322]Encapsulation

  
         		[bookmark: pgfId-77324]The encapsulation type defined for the subinterface:

 
           
           		 [bookmark: pgfId-77326][blank]—No encapsulation is defined.

 
           		 [bookmark: pgfId-77328]DOT1Q—Specifies VLAN encapsulation on the trunk link, as defined by the IEEE 802.1Q standard. Applies only to Ethernet subinterfaces.

 
           		 [bookmark: pgfId-77330]ISL—Specifies ISL encapsulation on the trunk link. 10-Gigabit Ethernet ports do not support ISL encapsulation.

 
          

 command using CLI commands or FlexConfigs. Configuring VLANs on the main interface increases the number of VLANs that can be configured on the router.  
        

 
         
         		[bookmark: pgfId-77338]VLAN ID

  
         		[bookmark: pgfId-77340]Applies only when encapsulation is defined for the subinterface.

 [bookmark: pgfId-77342]The VLAN ID associated with the subinterface.

  
        

 
         
         		[bookmark: pgfId-77348]Description

  
         		[bookmark: pgfId-77350]A text description of the interface. Enter up to 240 characters on a single line, without using carriage returns.

 [bookmark: pgfId-77352]Note For multiple context mode, the system description is independent of the context description.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-80193][bookmark: 154003][bookmark: catpage_cncpt_CreateandEditInterfaceDialogBoxesUnsupportedMode]Create and Edit Interface Dialog Boxes—Unsupported Mode[bookmark: marker-80189][bookmark: marker-80191]

 
     [bookmark: pgfId-80195]If you discover an interface configured with a mode that is not supported by Security Manager (such as dot1q-tunnel or private-vlan), the interface is displayed in Unsupported mode. You can view the attributes of this interface, but you cannot make any changes to the configuration unless you first change the mode. All definition fields, other than Mode, are read-only.

 
     [bookmark: pgfId-80197]Navigation Path

 
     [bookmark: pgfId-80202]Go to the Interfaces/VLANs Page—Interfaces Tab, select an interface whose mode is defined as Unsupported, then click Add or Edit to open the Create/Edit Interface dialog box.

 
     [bookmark: pgfId-80204]Related Topics

 
      
      		 [bookmark: pgfId-80209]Create and Edit Interface Dialog Boxes—Access Port Mode

 
      		 [bookmark: pgfId-80214]Create and Edit Interface Dialog Boxes—Routed Port Mode

 
      		 [bookmark: pgfId-80219]Create and Edit Interface Dialog Boxes—Trunk Port Mode

 
      		 [bookmark: pgfId-80224]Create and Edit Interface Dialog Boxes—Dynamic Mode

 
     

 
     [bookmark: pgfId-80226]Field Reference

 
     [bookmark: pgfId-80229] 

 
      
       
        
        [bookmark: pgfId-77365]Table 67-9 [bookmark: 154039]Create and Edit Interface Dialog Boxes—Unsupported Mode 

 
        
       
         
         		
           
           [bookmark: pgfId-77371]Element
          
  
         		
           
           [bookmark: pgfId-77373]Description
          
  
        

 
         
         		[bookmark: pgfId-77379]Enable Interface

  
         		[bookmark: pgfId-77381]When selected, indicates that the interface is enabled.

 [bookmark: pgfId-77383]When deselected, indicates that the interface has been disabled using the shutdown command.

  
        

 
         
         		[bookmark: pgfId-77389]Type

  
         		[bookmark: pgfId-77391]Specifies whether the definitions apply to an interface or a subinterface.

  
        

 
         
         		[bookmark: pgfId-77397]Name (Select button)

  
         		[bookmark: pgfId-77399]Displays the name of the interface.

  
        

 
         
         		[bookmark: pgfId-77405]Mode

  
         		[bookmark: pgfId-77407]Displays Unsupported, which designates an interface whose mode is not supported by Security Manager.

 [bookmark: pgfId-77409]Select a different option to change the interface mode.

 [bookmark: pgfId-77411]Note If you change the interface mode, you can then modify the other settings in this dialog box.

  
        

 
         
         		[bookmark: pgfId-77417]Speed

  
         		[bookmark: pgfId-77419]Displays the speed of the physical interface:

 
           
           		 [bookmark: pgfId-77421]10—Transmits at 10 Mbps.

 
           		 [bookmark: pgfId-77423]100—Transmits at 100 Mbps.

 
           		 [bookmark: pgfId-77425]1000—Transmits at 1,000 Mbps.

 
           		 [bookmark: pgfId-77427]10000—Transmits at 10,000 Mbps.

 
           		 [bookmark: pgfId-77429]Auto—If Speed is set to Auto, both Speed and Duplex are autonegotiated.

 
           		 [bookmark: pgfId-77431]Non-Negotiate—Disables link negotiation.

 
          

  
        

 
         
         		[bookmark: pgfId-77437]Duplex

  
         		[bookmark: pgfId-77439]Displays the duplex setting of the interface:

 
           
           		 [bookmark: pgfId-77441]Auto—Autonegotiates the duplex.

 
           		 [bookmark: pgfId-77443]Half—Sends and receives data, but not at the same time

 
           		 [bookmark: pgfId-77445]Full—Sends and receives data at the same time.

 
          

 [bookmark: pgfId-77447]If the speed is set to Auto, the duplex setting must also be set to Auto.

  
        

 
         
         		[bookmark: pgfId-77453]MTU

  
         		[bookmark: pgfId-77455]Displays the maximum transmission unit, which refers to the largest packet size (in bytes) that can be handled by the interface. The range of valid values depends on the interface type.

  
        

 
         
         		[bookmark: pgfId-77461]Description

  
         		[bookmark: pgfId-77463]Displays a text description of the interface. For multiple context mode, the system description is independent of the context description.

  
        

 
         
         		[bookmark: pgfId-77469]Flow Control Receive

  
         		[bookmark: pgfId-77471]Displays the flow control setting for incoming frames:

 
           
           		 [bookmark: pgfId-77473]Off—The port does not use flow control, regardless of whether the neighboring port requests flow control.

 
           		 [bookmark: pgfId-77475]On—The port uses flow control, as dictated by the neighboring port.

 
           		 [bookmark: pgfId-77477]Desired—The port allows, but does not require, flow control frames.

 
          

 [bookmark: pgfId-77479]Flow control frames (also called pause frames) are special packets that signal a source to stop sending frames for a defined interval when buffers are full.

  
        

 
         
         		[bookmark: pgfId-77485]Flow Control Send

  
         		[bookmark: pgfId-77487]Displays the flow control setting for outgoing frames:

 
           
           		 [bookmark: pgfId-77489]Off—The port does not send flow control frames to the neighboring port.

 
           		 [bookmark: pgfId-77491]On—The port sends flow control frames to the neighboring port.

 
           		 [bookmark: pgfId-77493]Desired—The port allows, but does not require, flow control frames.

 
          

  
        

 
         
         		[bookmark: pgfId-77499]Roles

  
         		[bookmark: pgfId-77504]Lists the interface roles associated with the interface. Interface roles are objects that are replaced with the actual interface IP addresses when the configuration is generated for each device. They allow you to define generic rules—ones that can apply to multiple interfaces. See Understanding Interface Role Objects.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-80239][bookmark: 154147][bookmark: catman_cncpt_VLANs]VLANs[bookmark: marker-80235][bookmark: marker-80237]

 
    [bookmark: pgfId-80241]A VLAN is a switched network that is segmented logically instead of on the basis of geography. For example, a VLAN might interconnect members of a geographically dispersed workgroup. VLANs offer a practical convenience for many organizations because they reduce the need to rearrange the physical placement of personnel, equipment, and network infrastructure. Properly configured VLANs are scalable, secure, and can simplify the tasks of network management.

 
    [bookmark: pgfId-80243]A VLAN consists of hosts and network devices (such as bridges and routers), connected by a single bridging domain. Traffic between VLANs must be routed.

 
    [bookmark: pgfId-80245]Security Manager helps you to create VLANs and define VLAN settings for the defined interfaces on Cisco Catalyst switches and Cisco 7600 Series routers, their supported services modules, and their security contexts.

 
    [bookmark: pgfId-80247]The following topics describe the actions you can perform when defining VLANs on Catalyst devices:

 
     
     		 [bookmark: pgfId-80252]Creating or Editing VLANs

 
     		 [bookmark: pgfId-80257]Deleting VLANs

 
     		 [bookmark: pgfId-80262]Interfaces/VLANs Page—VLANs Tab

 
    

 
    [bookmark: pgfId-80264]Related Topics

 
     
     		 [bookmark: pgfId-80269]VLAN Groups

 
     		 [bookmark: pgfId-80274]VLAN ACLs (VACLs)

 
     		 [bookmark: pgfId-80279]Chapter 67, “Managing Cisco Catalyst Switches and Cisco 7600 Series Routers”

 
    

 
     
      [bookmark: pgfId-80289][bookmark: 154182][bookmark: catman_proc_CreatingorEditingVLANs]Creating or Editing VLANs[bookmark: marker-80285][bookmark: marker-80287]

 
     [bookmark: pgfId-80291]You can create a VLAN or reconfigure the attributes of a VLAN.

 
     [bookmark: pgfId-80293]Related Topics

 
      
      		 [bookmark: pgfId-80298]Deleting VLANs

 
      		 [bookmark: pgfId-80303]Creating or Editing VLAN Groups

 
      		 [bookmark: pgfId-80308]Creating or Editing VACLs

 
      		 [bookmark: pgfId-80313]Create and Edit VLAN Dialog Boxes

 
      		 [bookmark: pgfId-80318]VLANs

 
     

 
     
 
     [bookmark: pgfId-80320]Step 1 (Device view) Select a Catalyst device, select Interfaces/VLANs from the Policy selector, then click the VLANs tab in the work area.

 
     [bookmark: pgfId-80325]The VLANs tab is displayed. For a description of the fields on this tab, see Interfaces/VLANs Page—VLANs Tab.

 
     [bookmark: pgfId-80327]Step 2 Do one of the following:

 
      
      		 [bookmark: pgfId-80329]To define the attributes of a new VLAN, click  Add Row .

 
      		 [bookmark: pgfId-80331]To edit the attributes of a VLAN, select it in the list, then click  Edit Row .

 
     

 
     [bookmark: pgfId-80336]See Create and Edit VLAN Dialog Boxes, for a description of the fields in the dialog box.

 
     [bookmark: pgfId-80338]Step 3 In the VLAN ID field, enter a unique ID number for the VLAN. The number that you enter must not be assigned to any other VLAN in the bridging group.

 
     [bookmark: pgfId-80340]Step 4 (Optional) Enter a name for the VLAN.

 
     [bookmark: pgfId-80345]Step 5 (Optional) If the VLAN is part of a VLAN group, select the group ID, or select Add Group to open the Create VLAN Group dialog box. For more information, see Creating or Editing VLAN Groups.

 
     [bookmark: pgfId-80347]Step 6 From the Status list, specify the status of the VLAN (active or suspended).

 
     [bookmark: pgfId-80349]Step 7 From the Type list, select either Layer 2 or Layer 3.

 
     [bookmark: pgfId-80351]Step 8 (Optional) For a Layer 3 VLAN, define a switched virtual interface (SVI):

 
     [bookmark: pgfId-80353] a. To make the SVI active, select the Enable Interface check box. An SVI enables routing between VLANs and provides IP host connectivity to the switch. If you do not select this check box, the SVI is created in shutdown mode.

 
     [bookmark: pgfId-80355] b. Enter the IP address for the SVI.

 
     [bookmark: pgfId-80357] c. Enter the SVI subnet mask by typing it, or select a netmask value from the Subnet Mask list.

 
     [bookmark: pgfId-80359] d. Enter an optional description, if required.

 
     [bookmark: pgfId-80361]Step 9 Do one or both of the following:

 
      
      		 [bookmark: pgfId-80363]To associate access ports with the VLAN, enter their names in the Access Ports text box or click  Select to open an interface selector.

 
      		 [bookmark: pgfId-80365]To associate trunk ports with the VLAN, enter their names in the Trunk Ports text box or click  Select to open an interface selector.

 
     

 
     [bookmark: pgfId-80373]See Interface Selector Dialog Box—VLAN ACL Content for a description of the fields in the dialog box. For more information about defining ports, see Creating or Editing Ports on Cisco Catalyst Switches and Cisco 7600 Series Routers.

 
     [bookmark: pgfId-80375]Step 10 Click OK to save your definitions locally on the client and close the dialog box.

 
     [bookmark: pgfId-80377]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-80387][bookmark: 154270][bookmark: catman_proc_DeletingVLANs]Deleting VLANs[bookmark: marker-80383][bookmark: marker-80385]

 
     [bookmark: pgfId-80389]You can delete a VLAN. However, deleting a VLAN does not delete it from any policy that might reference it. Ensure that your other policies do not use the VLAN before you delete it. When you submit your changes to the database, Security Manager points out any undefined VLANs that are referenced by other policies.

 
     [bookmark: pgfId-80391]Related Topics

 
      
      		 [bookmark: pgfId-80396]Creating or Editing VLANs

 
      		 [bookmark: pgfId-80401]VLANs

 
     

 
     
 
     [bookmark: pgfId-80403]Step 1 (Device view) Select a Cisco Catalyst switch or Cisco 7600 Series router from the Device selector.

 
     [bookmark: pgfId-80405]Step 2 Select Interfaces/VLANs from the Policies selector.

 
     [bookmark: pgfId-80407]Step 3 Click the VLANs tab in the work area.

 
     [bookmark: pgfId-80412]The VLANs tab is displayed. For a description of the fields on this tab, see Interfaces/VLANs Page—VLANs Tab.

 
     [bookmark: pgfId-80414]Step 4 Select a VLAN from the table, then click Delete Row.

 
     [bookmark: pgfId-80416]The VLAN is deleted.

 
     [bookmark: pgfId-80418]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-80432][bookmark: 154306][bookmark: catpage_cncpt_InterfacesVLANsPageVLANsTab]Interfaces/VLANs Page—VLANs Tab[bookmark: marker-80426][bookmark: marker-80428][bookmark: marker-80430]

 
     [bookmark: pgfId-80434]Use the VLANs tab to view and configure VLANs on supported Cisco Catalyst switches and Cisco 7600 Series routers.

 
     [bookmark: pgfId-80436]Navigation Path

 
      
      		 [bookmark: pgfId-80438](Device view) Select  Interfaces/VLANs from the Device selector, then click the  VLANs tab.

 
     

 
     [bookmark: pgfId-80440]Related Topics

 
      
      		 [bookmark: pgfId-80445]Interfaces/VLANs Page—VLAN Groups Tab

 
      		 [bookmark: pgfId-80450]Interfaces/VLANs Page—Interfaces Tab

 
      		 [bookmark: pgfId-80455]Viewing a Summary of Catalyst Interfaces, VLANs, and VLAN Groups

 
      		 [bookmark: pgfId-80460]Understanding FlexConfig Policies and Policy Objects

 
      		 [bookmark: pgfId-80465]Create and Edit VLAN Dialog Boxes

 
      		 [bookmark: pgfId-80470]Filtering Tables

 
     

 
     [bookmark: pgfId-80472]Field Reference

 
     [bookmark: pgfId-80475] 

 
      
       
        
        [bookmark: pgfId-77517]Table 67-10 [bookmark: 154354]Interfaces/VLANs Page—VLANs Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-77523]Element
          
  
         		
           
           [bookmark: pgfId-77525]Description
          
  
        

 
         
         		[bookmark: pgfId-77531]VLAN ID

  
         		[bookmark: pgfId-77533]Interface-specific identity of the VLAN that a table row describes. The VLAN ID specifies where 802.1Q tagged packets are sent and received on the subinterface; without a VLAN ID, the subinterface cannot send or receive traffic. Valid values range from 2 to 4094 (VLAN ID 1 is reserved).

 [bookmark: pgfId-77535]Note All VLAN IDs must be unique among all subinterfaces configured on the same physical interface.

 command using CLI commands or FlexConfigs. Configuring VLANs on the main interface increases the number of VLANs that can be configured on the device.  
        

 
         
         		[bookmark: pgfId-77543]Name

  
         		[bookmark: pgfId-77545]Name of the corresponding VLAN for an interface or subinterface.

  
        

 
         
         		[bookmark: pgfId-77551]Interface

  
         		[bookmark: pgfId-77553]Identifies the logical name of the interface (interface role) or physical interface.

  
        

 
         
         		[bookmark: pgfId-77559]Type

  
         		[bookmark: pgfId-77561]Specifies whether a VLAN has access to Layer 2 or Layer 3.

  
        

 
         
         		[bookmark: pgfId-77567]Status

  
         		[bookmark: pgfId-77569]Indicates whether a VLAN is active or suspended.

  
        

 
         
         		[bookmark: pgfId-77575]Add Row button

  
         		[bookmark: pgfId-77577]Opens the Create VLAN dialog box to define a new VLAN.

  
        

 
         
         		[bookmark: pgfId-77583]Edit Row button

  
         		[bookmark: pgfId-77585]Opens the Edit VLAN dialog box to edit the selected VLAN.

  
        

 
         
         		[bookmark: pgfId-77591]Delete Row button

  
         		[bookmark: pgfId-77593]Deletes the selected VLAN.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-80489][bookmark: 154407][bookmark: catpage_cncpt_CreateandEditVLANDialogBoxes]Create and Edit VLAN Dialog Boxes[bookmark: marker-80483][bookmark: marker-80485][bookmark: marker-80487]

 
     [bookmark: pgfId-80491]Use the Create VLAN dialog box (or the Edit VLAN dialog box) to configure or reconfigure VLAN settings and attributes.

 
     [bookmark: pgfId-80493]Navigation Path

 
     [bookmark: pgfId-80498]Go to the Interfaces/VLANs Page—VLANs Tab, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-80500]Related Topics

 
      
      		 [bookmark: pgfId-80505]Understanding FlexConfig Policies and Policy Objects

 
      		 [bookmark: pgfId-80510]Create and Edit VLAN Group Dialog Boxes

 
      		 [bookmark: pgfId-80515]Interface Selector Dialog Box—VLAN ACL Content

 
     

 
     [bookmark: pgfId-80517]Field Reference

 
     [bookmark: pgfId-80520] 

 
      
       
        
        [bookmark: pgfId-77606]Table 67-11 [bookmark: 154444]Create and Edit VLAN Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-77612]Element
          
  
         		
           
           [bookmark: pgfId-77614]Description
          
  
        

 
         
         		[bookmark: pgfId-77620]VLAN ID

  
         		[bookmark: pgfId-77622]Displays the VLAN ID if one is configured. Otherwise, enter the ID manually. The VLAN ID specifies where 802.1Q tagged packets are sent and received on an interface or subinterface; without a VLAN ID, the interface or subinterface cannot send or receive traffic. Each VLAN must have an ID. Valid values range from 1 to 4094.

 [bookmark: pgfId-77624]Note All VLAN IDs must be unique among all subinterfaces configured on the same physical interface.

 command using CLI commands or FlexConfigs. Configuring VLANs on the main interface increases the number of VLANs that can be configured on the device.  
        

 
         
         		[bookmark: pgfId-77632]Name

  
         		[bookmark: pgfId-77634]Enter a name for the VLAN, or view the VLAN name if you entered one previously. Each VLAN must have an ID, and can optionally have a name. The maximum length is 32 characters.

  
        

 
         
         		[bookmark: pgfId-77640]Group

  
         		[bookmark: pgfId-77642]The VLAN group to which the VLAN belongs. A VLAN can be associated with one group only.

 [bookmark: pgfId-77644]You can associate the VLAN with an existing group, or select Add Group to open the Create VLAN Group dialog box.

  
        

 
         
         		[bookmark: pgfId-77650]Status

  
         		[bookmark: pgfId-77652]The current status of the VLAN:

 
           
           		 [bookmark: pgfId-77654]Active—The VLAN carries traffic.

 
           		 [bookmark: pgfId-77656]Suspended—The VLAN does not pass packets.

 
          

  
        

 
         
         		[bookmark: pgfId-77662]Type

  
         		[bookmark: pgfId-77664]Indicates whether the specified VLAN is configured for Layer 2 or Layer 3, and enables you to choose the kind of VLAN that you prefer.

 [bookmark: pgfId-77666]A Layer 3 VLAN requires an IP address and creates a VLAN interface.

  
        

 
         
         		[bookmark: pgfId-77672]Switch Virtual Interface

  
         		[bookmark: pgfId-77674]Applies only when defining a Layer 3 VLAN.

 
           
           		 [bookmark: pgfId-77676]Enable Interface—When selected, enables the switched virtual interface (SVI), which is a virtual interface that you can attach to any VLAN. The SVI enables routing between VLANs and provides IP host connectivity to the switch. When deselected, disables the SVI.

 
           		 [bookmark: pgfId-77678]IP Address—The IP address for the SVI. An IP address is required for management access.

 
           		 [bookmark: pgfId-77680]Subnet Mask—The subnet mask for the SVI. Select any option from the list of valid subnet mask entries.

 
           		 [bookmark: pgfId-77682]Description—Enables you to enter a description of up to 240 characters on a single line, without carriage returns. For multiple context mode, the system description is independent of the context description.

 
          

  
        

 
         
         		[bookmark: pgfId-77688]Access Ports (Select button)

  
         		[bookmark: pgfId-77690]Lists which access ports are associated with the specified VLAN, if any are associated, and enables you to add or remove access port associations for the specified VLAN. You can associate any number of access ports with a VLAN.

 [bookmark: pgfId-77695]Click Select to open the Access Port Selector Dialog Box. From here, you can associate access ports with the specified VLAN, or remove access port associations from the VLAN.

  
        

 
         
         		[bookmark: pgfId-77701]Trunk Ports (Select button)

  
         		[bookmark: pgfId-77703]Lists which trunk ports are associated with the specified VLAN, if any are associated, and enables you to add or remove trunk port associations for the specified VLAN. A VLAN can belong to the allowed list of one or more trunk ports. You can include a VLAN in a trunk port group.

 [bookmark: pgfId-77708]Click Select to open the Trunk Port Selector Dialog Box. From here, you can associate trunk ports with the specified VLAN, or remove trunk port associations from the VLAN.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-80532][bookmark: 154521][bookmark: catpage_cncpt_AccessPortSelectorDialogBox]Access Port Selector Dialog Box[bookmark: marker-80528][bookmark: marker-80530]

 
     [bookmark: pgfId-80534]Use the Access Port Selector dialog box to define which access ports are associated with a selected VLAN.

 
     [bookmark: pgfId-80536]Navigation Path

 
     [bookmark: pgfId-80541]Open the Create and Edit VLAN Dialog Boxes, then click Select in the Access Ports field.

 
     [bookmark: pgfId-80543]Related Topics

 
      
      		 [bookmark: pgfId-80548]Create and Edit Interface Dialog Boxes—Access Port Mode

 
      		 [bookmark: pgfId-80553]Trunk Port Selector Dialog Box

 
      		 [bookmark: pgfId-80558]Filtering Tables

 
     

 
     [bookmark: pgfId-80560]Field Reference

 
     [bookmark: pgfId-80563] 

 
      
       
        
        [bookmark: pgfId-77721]Table 67-12 [bookmark: 154553]Access Port Selector Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-77727]Element
          
  
         		
           
           [bookmark: pgfId-77729]Description
          
  
        

 
         
         		[bookmark: pgfId-77735]Available Access Ports

  
         		[bookmark: pgfId-77737]Displays the access ports that are not assigned to a particular VLAN.

  
        

 
         
         		[bookmark: pgfId-77743]Add >> button

  
         		[bookmark: pgfId-77745]Adds interfaces that are selected in the Available Access Ports list to the Selected Access Ports list.

  
        

 
         
         		[bookmark: pgfId-77751]Remove << button

  
         		[bookmark: pgfId-77753]Removes selected interfaces from the Selected Access Ports list.

  
        

 
         
         		[bookmark: pgfId-77759]Selected Access Ports

  
         		[bookmark: pgfId-77761]Displays the interface objects that are selected.

  
        

 
         
         		[bookmark: pgfId-77767]Add Row button

  
         		[bookmark: pgfId-77769]Opens the Create Interface dialog box to define a new interface.

  
        

 
         
         		[bookmark: pgfId-77775]Edit Row button

  
         		[bookmark: pgfId-77777]Opens the Edit Interface dialog box to edit the selected interface.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-80575][bookmark: 154594][bookmark: catpage_cncpt_TrunkPortSelectorDialogBox]Trunk Port Selector Dialog Box[bookmark: marker-80571][bookmark: marker-80573]

 
     [bookmark: pgfId-80577]Use the Trunk Port Selector dialog box to define which trunk ports are associated with a selected VLAN.

 
     [bookmark: pgfId-80579]Navigation Path

 
     [bookmark: pgfId-80584]Open the Create and Edit VLAN Dialog Boxes, then click Select in the Trunk Ports field.

 
     [bookmark: pgfId-80586]Related Topics

 
      
      		 [bookmark: pgfId-80591]Create and Edit Interface Dialog Boxes—Trunk Port Mode

 
      		 [bookmark: pgfId-80596]Access Port Selector Dialog Box

 
      		 [bookmark: pgfId-80601]Filtering Tables

 
     

 
     [bookmark: pgfId-80603]Field Reference

 
     [bookmark: pgfId-80606] 

 
      
       
        
        [bookmark: pgfId-77790]Table 67-13 [bookmark: 154626]Trunk Port Selector Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-77796]Element
          
  
         		
           
           [bookmark: pgfId-77798]Description
          
  
        

 
         
         		[bookmark: pgfId-77804]Available Trunk Ports

  
         		[bookmark: pgfId-77806]Displays all available trunk ports.

  
        

 
         
         		[bookmark: pgfId-77812]Add >> button

  
         		[bookmark: pgfId-77814]Adds interfaces that are selected in the Available Trunk Ports list to the Selected Trunk Ports list.

  
        

 
         
         		[bookmark: pgfId-77820]Remove << button

  
         		[bookmark: pgfId-77822]Removes selected interfaces from the Selected Trunk Ports list.

  
        

 
         
         		[bookmark: pgfId-77828]Selected Trunk Ports

  
         		[bookmark: pgfId-77830]Displays the interface objects that are selected.

  
        

 
         
         		[bookmark: pgfId-77836]Add Row button

  
         		[bookmark: pgfId-77838]Opens the Create Interface dialog box to define a new interface.

  
        

 
         
         		[bookmark: pgfId-77844]Edit Row button

  
         		[bookmark: pgfId-77846]Opens the Edit Interface dialog box to edit the selected interface.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-80616][bookmark: 154669][bookmark: catman_cncpt_VLANGroups]VLAN Groups[bookmark: marker-80612][bookmark: marker-80614]

 
    [bookmark: pgfId-80618]A VLAN group defines a logical collection of VLANs. The VLAN Groups tab on the Interfaces/VLANs page displays:

 
     
     		 [bookmark: pgfId-80620]All VLAN groups that are defined on the selected device.

 
     		 [bookmark: pgfId-80622]The service module slots to which a VLAN group is bound.

 
     		 [bookmark: pgfId-80624]Which VLANs belong to each VLAN group.

 
    

 
    [bookmark: pgfId-80629]VLAN groups can be used when assigning VLANs to an FWSM security context. A VLAN group can be assigned to multiple FWSMs, and each FWSM can have multiple VLAN groups assigned to it. To perform this assignment, see Add/Edit Security Context Dialog Box (FWSM).

 
    [bookmark: pgfId-80631]The following topics describe the actions you can perform when defining VLAN groups on Catalyst devices:

 
     
     		 [bookmark: pgfId-80636]Creating or Editing VLAN Groups

 
     		 [bookmark: pgfId-80641]Deleting VLAN Groups

 
     		 [bookmark: pgfId-80646]Interfaces/VLANs Page—VLAN Groups Tab

 
    

 
    [bookmark: pgfId-80648]Related Topics

 
     
     		 [bookmark: pgfId-80653]Interfaces

 
     		 [bookmark: pgfId-80658]VLANs

 
     		 [bookmark: pgfId-80663]VLAN ACLs (VACLs)

 
     		 [bookmark: pgfId-80668]Chapter 67, “Managing Cisco Catalyst Switches and Cisco 7600 Series Routers”

 
    

 
     
      [bookmark: pgfId-80678][bookmark: 154714][bookmark: catman_proc_CreatingorEditingVLANGroups]Creating or Editing VLAN Groups[bookmark: marker-80674][bookmark: marker-80676]

 
     [bookmark: pgfId-80680]You can create VLAN groups. When you create a VLAN group, remember that:

 
      
      		 [bookmark: pgfId-80682]Each group must have an ID.

 
      		 [bookmark: pgfId-80684]You can associate a VLAN group with one or more FWSM modules.

 
      		 [bookmark: pgfId-80686]Each VLAN can be a member of only one VLAN group.

 
     

 
     [bookmark: pgfId-80688]Related Topics

 
      
      		 [bookmark: pgfId-80693]Deleting VLAN Groups

 
      		 [bookmark: pgfId-80698]Creating or Editing VLANs

 
      		 [bookmark: pgfId-80703]Creating or Editing VACLs

 
      		 [bookmark: pgfId-80708]Interfaces/VLANs Page—VLAN Groups Tab

 
      		 [bookmark: pgfId-80713]VLAN Groups

 
     

 
     
 
     [bookmark: pgfId-80715]Step 1 (Device view) Select a Catalyst device, select Interfaces/VLANs from the Policy selector, then click the VLAN Groups tab in the work area.

 
     [bookmark: pgfId-80720]The VLAN Groups tab is displayed. For a description of the fields on this tab, see Interfaces/VLANs Page—VLAN Groups Tab.

 
     [bookmark: pgfId-80722]Step 2 Do one of the following:

 
      
      		 [bookmark: pgfId-80724]To define the attributes of a new VLAN group, click  Add Row .

 
      		 [bookmark: pgfId-80726]To edit the attributes of a VLAN group, select it in the list, then click  Edit Row .

 
     

 
     [bookmark: pgfId-80731]See Create and Edit VLAN Group Dialog Boxes, for a description of the fields in this dialog box.

 
     [bookmark: pgfId-80733]Step 3 In the VLAN Group ID field, enter a unique ID number for the VLAN group. The number that you enter must not be assigned to any other VLAN group.

 
     [bookmark: pgfId-80735]Step 4 To associate the VLAN group with specific service module slots, enter their slot numbers in the Service Module Slots text box, or click Select to open a selector.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-80740]Note Defining this association makes it possible to later assign this VLAN group to a security context on the FWSM. See Add/Edit Security Context Dialog Box (FWSM).


     
      

     

     

 
     [bookmark: pgfId-80742]Step 5 Enter the VLANs to add to the VLAN group, or click Select to open a selector.

 
     [bookmark: pgfId-80744]Step 6 Click OK to save your definitions locally on the client and close the dialog box.

 
     [bookmark: pgfId-80746]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-80756][bookmark: 154782][bookmark: catman_proc_DeletingVLANGroups]Deleting VLAN Groups[bookmark: marker-80752][bookmark: marker-80754]

 
     [bookmark: pgfId-80758]You can delete VLAN groups. Deleting a VLAN group has no affect on the VLANs in the group.

 
     [bookmark: pgfId-80760]Related Topics

 
      
      		 [bookmark: pgfId-80765]Creating or Editing VLAN Groups

 
      		 [bookmark: pgfId-80770]VLAN Groups

 
     

 
     
 
     [bookmark: pgfId-80772]Step 1 (Device view) Select a Catalyst 6500 Series switch or Cisco 7600 Series router from the Device selector.

 
     [bookmark: pgfId-80774]Step 2 Select Interfaces/VLANs from the Policy selector.

 
     [bookmark: pgfId-80776]Step 3 Click the VLAN Groups tab in the work area.

 
     [bookmark: pgfId-80781]The VLANs tab is displayed. For a description of the fields on this tab, see Interfaces/VLANs Page—VLAN Groups Tab.

 
     [bookmark: pgfId-80783]Step 4 Select a VLAN group from the table, then click Delete Row. The VLAN group is deleted.

 
     [bookmark: pgfId-80785]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-80797][bookmark: 154817][bookmark: catpage_cncpt_InterfacesVLANsPageVLANGroupsTab]Interfaces/VLANs Page—VLAN Groups Tab[bookmark: marker-80793][bookmark: marker-80795]

 
     [bookmark: pgfId-80799]Use the VLAN Groups tab to view and configure VLAN groups on supported 6500 Series switches and 7600 Series routers.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-80801]Note The VLAN Groups tab is available only for Cisco Catalyst 6500 Series switches and Cisco 7600 Series routers.


     
      

     

     

 
     [bookmark: pgfId-80803]Navigation Path

 
      
      		 [bookmark: pgfId-80805](Device view) Select  Interfaces/VLANs from the Device selector, then click the  VLAN Groups tab.

 
     

 
     [bookmark: pgfId-80807]Related Topics

 
      
      		 [bookmark: pgfId-80812]Interfaces/VLANs Page—VLANs Tab

 
      		 [bookmark: pgfId-80817]Interfaces/VLANs Page—Interfaces Tab

 
      		 [bookmark: pgfId-80822]Viewing a Summary of Catalyst Interfaces, VLANs, and VLAN Groups

 
      		 [bookmark: pgfId-80827]Create and Edit VLAN Group Dialog Boxes

 
      		 [bookmark: pgfId-80832]Filtering Tables

 
     

 
     [bookmark: pgfId-80834]Field Reference

 
     [bookmark: pgfId-80837] 

 
      
       
        
        [bookmark: pgfId-77859]Table 67-14 [bookmark: 154859]Interfaces/VLANs Page—VLAN Groups Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-77865]Element
          
  
         		
           
           [bookmark: pgfId-77867]Description
          
  
        

 
         
         		[bookmark: pgfId-77873]VLAN Group

  
         		[bookmark: pgfId-77875]Numeric ID of a VLAN group that is configured on the selected device.

  
        

 
         
         		[bookmark: pgfId-77881]Service Module Slots

  
         		[bookmark: pgfId-77883]Associates the chassis slot number (in which the relevant services module is installed) with the interface through which a particular VLAN participates in the VLAN group.

  
        

 
         
         		[bookmark: pgfId-77889]VLAN IDs

  
         		[bookmark: pgfId-77891]The VLAN IDs associated with this group. Valid values range from 1 to 65535.

  
        

 
         
         		[bookmark: pgfId-77897]Add Row button

  
         		[bookmark: pgfId-77899]Opens the Create VLAN Group dialog box to define a new VLAN group.

  
        

 
         
         		[bookmark: pgfId-77905]Edit Row button

  
         		[bookmark: pgfId-77907]Opens the Edit VLAN Group dialog box to edit the selected VLAN group.

  
        

 
         
         		[bookmark: pgfId-77913]Delete Row button

  
         		[bookmark: pgfId-77915]Deletes the selected VLAN group.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-80849][bookmark: 154899][bookmark: catpage_cncpt_CreateandEditVLANGroupDialogBoxes]Create and Edit VLAN Group Dialog Boxes[bookmark: marker-80845][bookmark: marker-80847]

 
     [bookmark: pgfId-80851]Use the Create and Edit VLAN Group dialog box to configure or reconfigure the attributes of VLAN groups, which are logical groups of VLANs that you want to associate with one another when you define VLAN port policies.

 
     [bookmark: pgfId-80853]Navigation Path

 
     [bookmark: pgfId-80855]Do one of the following:

 
      
      		 [bookmark: pgfId-80860]Go to the Interfaces/VLANs Page—VLAN Groups Tab, then click the  Add or  Edit button beneath the table.

 
      		 [bookmark: pgfId-80865]Go to the Interfaces/VLANs Page—VLANs Tab, click the  Add or  Edit button beneath the table, then select  Add Group from the Group list.

 
     

 
     [bookmark: pgfId-80867]Related Topics

 
      
      		 [bookmark: pgfId-80872]Service Module Slot Selector Dialog Box

 
     

 
     [bookmark: pgfId-80874]Field Reference

 
     [bookmark: pgfId-80877] 

 
      
       
        
        [bookmark: pgfId-77928]Table 67-15 [bookmark: 154935]Create and Edit VLAN Group Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-77934]Element
          
  
         		
           
           [bookmark: pgfId-77936]Description
          
  
        

 
         
         		[bookmark: pgfId-77942]VLAN Group ID

  
         		[bookmark: pgfId-77944]The 802.1q VLAN group name. Valid values range from 1 to 65535.

  
        

 
         
         		[bookmark: pgfId-77950]Service Module Slots (Select button)

  
         		[bookmark: pgfId-77952]The chassis slot number (in which the relevant services module is installed) that is associated with the interface through which a particular VLAN participates in the VLAN group.

 [bookmark: pgfId-77957]Enter the slot number or click Select to open the Service Module Slot Selector Dialog Box.

 [bookmark: pgfId-77962]Note After you associate the VLAN group with a service module, such as an FWSM, you can assign the VLAN group to the security contexts of the FWSM. See Add/Edit Security Context Dialog Box (FWSM).

  
        

 
         
         		[bookmark: pgfId-77968]VLAN IDs (Select button)

  
         		[bookmark: pgfId-77970]The comma-separated IDs of all VLANs that are part of the group. Each VLAN can be a member of only one group.

 [bookmark: pgfId-77975]Click Select to open the Service Module Slot Selector Dialog Box. From here, you can select VLANs to include in the VLAN group.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-80889][bookmark: 154969][bookmark: catpage_cncpt_ServiceModuleSlotSelectorDialogBox]Service Module Slot Selector Dialog Box[bookmark: marker-80885][bookmark: marker-80887]

 
     [bookmark: pgfId-80891]Use the Service Module Slot Selector dialog box to associate a service module with a VLAN.

 
     [bookmark: pgfId-80893]Navigation Path

 
     [bookmark: pgfId-80898]Go to the Create and Edit VLAN Group Dialog Boxes, then click Select in the Service Module Slots field.

 
     [bookmark: pgfId-80900]Related Topics

 
      
      		 [bookmark: pgfId-80905]VLAN Selector Dialog Box

 
      		 [bookmark: pgfId-80910]Filtering Tables

 
     

 
     [bookmark: pgfId-80912]Field Reference

 
     [bookmark: pgfId-80915] 

 
      
       
        
        [bookmark: pgfId-77988]Table 67-16 [bookmark: 154998]Service Module Selector Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-77994]Element
          
  
         		
           
           [bookmark: pgfId-77996]Description
          
  
        

 
         
         		[bookmark: pgfId-78002]Available Service Module Slots

  
         		[bookmark: pgfId-78004]Displays the defined service module slots.

  
        

 
         
         		[bookmark: pgfId-78010]Add >> button

  
         		[bookmark: pgfId-78012]Moves selected service module slots from the Available Service Module Slots list to the Selected Service Module Slots list.

  
        

 
         
         		[bookmark: pgfId-78018]Remove << button

  
         		[bookmark: pgfId-78020]Removes selected service module slots from the Selected Service Modules list.

  
        

 
         
         		[bookmark: pgfId-78026]Selected Service Module Slots

  
         		[bookmark: pgfId-78028]Displays the selected service module slots.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-80927][bookmark: 155029][bookmark: catpage_cncpt_VLANSelectorDialogBox]VLAN Selector Dialog Box[bookmark: marker-80923][bookmark: marker-80925]

 
     [bookmark: pgfId-80929]Use the VLAN Selector dialog box to associate VLANs with interfaces, VLAN groups, security contexts, and VACLs.

 
     [bookmark: pgfId-80931]Navigation Path

 
     [bookmark: pgfId-80933]You can access this dialog box when you define interfaces, VLAN groups, IDSM settings, or VACLs by clicking the Select button in any field used for defining VLANs.

 
     [bookmark: pgfId-80935]Related Topics

 
      
      		 [bookmark: pgfId-80940]Service Module Slot Selector Dialog Box

 
      		 [bookmark: pgfId-80945]Filtering Tables

 
     

 
     [bookmark: pgfId-80947]Field Reference

 
     [bookmark: pgfId-80950] 

 
      
       
        
        [bookmark: pgfId-78041]Table 67-17 [bookmark: 155057]VLAN Selector Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-78047]Element
          
  
         		
           
           [bookmark: pgfId-78049]Description
          
  
        

 
         
         		[bookmark: pgfId-78055]Available VLANs

  
         		[bookmark: pgfId-78057]Displays defined VLANs that are available to be associated with the object you are configuring.

 [bookmark: pgfId-78059]Note The VLANs that are available will depend on the type of object you are configuring and other settings defined on the device. For example, when selecting VLANs to assign to a VLAN group, the Available VLANs list will only contain VLANs that have not been assigned to another VLAN group. When selecting VLANs to assign to a security context, the Available VLANs list will only contain VLANs that are part of a VLAN group that has been assigned to the service module you are configuring.

  
        

 
         
         		[bookmark: pgfId-78065]Add >> button

  
         		[bookmark: pgfId-78067]Moves selected VLANs from the Available VLANs list to the Selected VLANs list.

  
        

 
         
         		[bookmark: pgfId-78073]Remove << button

  
         		[bookmark: pgfId-78075]Removes selected VLANs from the Selected VLANs list.

  
        

 
         
         		[bookmark: pgfId-78081]Selected VLANs

  
         		[bookmark: pgfId-78083]Displays the selected VLANs.

  
        

 
         
         		[bookmark: pgfId-78089]VLAN Ranges

  
         		[bookmark: pgfId-78091]The VLAN ranges entered manually before the selector was opened, if any.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-80962][bookmark: 155096][bookmark: catman_cncpt_VLANACLsVACLs]VLAN ACLs (VACLs)[bookmark: marker-80956][bookmark: marker-80958][bookmark: marker-80960]

 
    [bookmark: pgfId-80964]Cisco IOS standard or extended ACLs are configured on router interfaces only, and are applied on routed packets only. In contrast, Cisco Catalyst switches and Cisco 7600 Series routers can use VLAN ACLs (VACLs) to control the access of all packets that are bridged within a VLAN or that are routed to or from a VLAN for VACL capture through a WAN interface. VACLs:

 
     
     		 [bookmark: pgfId-80966]Are processed in hardware.

 
     		 [bookmark: pgfId-80968]Use Cisco IOS ACLs.

 
     		 [bookmark: pgfId-80970]Ignore any Cisco IOS ACL fields that are not supported in hardware.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-80972]Note Security Manager does not support the creation or configuration of MAC ACLs (MACLs), which are named ACLs that are sometimes used with VACLs to filter IPX, DECnet, AppleTalk, VINES, or XNS traffic based on MAC addresses.


    
     

    

    

 
    [bookmark: pgfId-80974]When you configure a VACL and apply it to a VLAN, all packets entering the VLAN are checked against the VACL.

 
    [bookmark: pgfId-80976]If you apply a VACL to a VLAN and you apply an ACL to a routed interface in that same VLAN, any packet coming into the VLAN is first checked against the VACL. Then, if permitted, the packet is checked against the input ACL before it reaches the routed interface.

 
    [bookmark: pgfId-80978]When a packet is routed from one VLAN to another, it is first checked against the output ACL that is applied to the routed interface. Then, if permitted, the packet is checked against any VACLs that are configured for the destination VLAN.

 
    [bookmark: pgfId-80980]If a VACL is configured for a packet type, and a packet of that type does not match the VACL, the default action is deny.

 
    [bookmark: pgfId-80984] VLAN Access Maps[bookmark: marker-80982]

 
    [bookmark: pgfId-80986]Security Manager uses VLAN access maps to configure VACLs. Conceptually similar to a route map, a VLAN access map is a container in which you place one or more statements (conditions that match an action) and number them by their order of importance. A VLAN access map must also identify the VLANs to which it is applied, contain the map name, and identify at least one VACL sequence.

 
    [bookmark: pgfId-80988]A VACL sequence must have a sequence number and at least one action, and must match at least one ACL.

 
    [bookmark: pgfId-80990]Devices evaluate map statements in sequence and you can associate more than one VLAN access map with any device chassis.

 
    [bookmark: pgfId-80992]To manage a VACL, select a Catalyst device in Device View, then select Platform > VLAN Access Lists. You use VLAN access maps to configure VACLs for IP traffic.

 
    [bookmark: pgfId-80994]The following topics describe the actions you can perform when defining VACLs on Catalyst devices:

 
     
     		 [bookmark: pgfId-80999]Creating or Editing VACLs

 
     		 [bookmark: pgfId-81004]Deleting VACLs

 
     		 [bookmark: pgfId-81009]VLAN Access Lists Page

 
    

 
    [bookmark: pgfId-81011]Related Topics

 
     
     		 [bookmark: pgfId-81016]VLANs

 
     		 [bookmark: pgfId-81021]VLAN Groups

 
     		 [bookmark: pgfId-81026]Chapter 67, “Managing Cisco Catalyst Switches and Cisco 7600 Series Routers”

 
    

 
     
      [bookmark: pgfId-81038][bookmark: 155156][bookmark: catman_proc_CreatingorEditingVACLs]Creating or Editing VACLs[bookmark: marker-81032][bookmark: marker-81034][bookmark: marker-81036]

 
     [bookmark: pgfId-81040]When you can create or edit a VACL, you must:

 
      
      		 [bookmark: pgfId-81042]Name the VACL.

 
      		 [bookmark: pgfId-81044]Define the VLANs to which the VACL applies.

 
      		 [bookmark: pgfId-81046]Define a sequence map containing at least one VACL sequence.

 
     

 
     [bookmark: pgfId-81048]Related Topics

 
      
      		 [bookmark: pgfId-81053]Deleting VACLs

 
      		 [bookmark: pgfId-81058]Creating or Editing VLANs

 
      		 [bookmark: pgfId-81063]Creating or Editing VLAN Groups

 
      		 [bookmark: pgfId-81068]Create and Edit VLAN ACL Dialog Boxes

 
      		 [bookmark: pgfId-81073]VLAN Access Lists Page

 
     

 
     
 
     [bookmark: pgfId-81075]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-81077](Device view) Select a Catalyst device, then select  Platform > VLAN Access Lists from the Policy selector.

 
      		 [bookmark: pgfId-81079](Policy view) Select  Catalyst Platform > VLAN Access Lists .

 
     

 
     [bookmark: pgfId-81084]The VLAN Access Lists page is displayed. For a description of the fields on this page, see VLAN Access Lists Page.

 
     [bookmark: pgfId-81086]Step 2 Do one of the following:

 
      
      		 [bookmark: pgfId-81088]To define the attributes of a new VACL, click  Add Row .

 
      		 [bookmark: pgfId-81090]To edit the attributes of a VACL, select it in the list, then click  Edit Row .

 
     

 
     [bookmark: pgfId-81095]A dialog box opens. See Create and Edit VLAN ACL Dialog Boxes, for a description of the fields in the dialog box.

 
     [bookmark: pgfId-81097]Step 3 Enter a name for the VACL in the VLAN ACL Name field.

 
     [bookmark: pgfId-81099]Step 4 In the VLANs field, specify the VLANs to which the VACL should be applied, or click Select to open a VLAN selector.

 
     [bookmark: pgfId-81101]Step 5 Define the sequence map:

 
     [bookmark: pgfId-81106] a. Click Add Row or Edit Row beneath the Sequence Map table. A dialog box opens. See Create and Edit VLAN ACL Content Dialog Boxes.

 
     [bookmark: pgfId-81108] b. Enter a number to identify the sequence.

 
     [bookmark: pgfId-81113] c. Specify the standard and extended ACLs to assign to the sequence, or click Select to select the ACL object from a list or to create a new ACL object. For more information about ACL objects, see Creating Access Control List Objects.

 
     [bookmark: pgfId-81118] d. Specify the action to perform on traffic that matches the ACLs defined in this sequence. (When you select Redirect as the action, you must specify the physical destination interfaces, or click Select to display a selector. See Specifying Interfaces During Policy Definition.)

 
     [bookmark: pgfId-81120] e. Click OK to save your definitions locally on the client and close the dialog box. The sequence is displayed in the Sequence Map table.

 
     [bookmark: pgfId-81122] f. Repeat the process to add sequences to the sequence map.

 
     [bookmark: pgfId-81124] g. Use the up and down arrows to reorder the sequences, if required.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-81126]Note The order in which you place the sequences is significant. When a flow matches a permit ACL entry, the associated action is taken without checking the remaining sequences. When a flow matches a deny ACL entry, it is checked against the next ACL in the same sequence or the next sequence. If a flow does not match any ACL entry and at least one ACL is configured for that packet type, the packet is denied.


     
      

     

     

 
     [bookmark: pgfId-81128]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-81140][bookmark: 155252][bookmark: catman_proc_DeletingVACLs]Deleting VACLs[bookmark: marker-81134][bookmark: marker-81136][bookmark: marker-81138]

 
     [bookmark: pgfId-81142]You can delete a VACL if it is not being used by any device, policy, or object.

 
     [bookmark: pgfId-81144]Before You Begin

 
     [bookmark: pgfId-81149]You must delete all references to the VACL before you can remove it from the database. To locate all references to the VACL, run an object usage report for it. See Generating Object Usage Reports.

 
     [bookmark: pgfId-81151]Related Topics

 
      
      		 [bookmark: pgfId-81156]Creating or Editing VACLs

 
      		 [bookmark: pgfId-81161]Interfaces/VLANs Page—VLANs Tab

 
      		 [bookmark: pgfId-81166]VLAN ACLs (VACLs)

 
     

 
     
 
     [bookmark: pgfId-81168]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-81170](Device view) Select a Catalyst device, then select  Platform > VLAN Access Lists from the Policy selector.

 
      		 [bookmark: pgfId-81172](Policy view) Select  Catalyst Platform > VLAN Access Lists .

 
     

 
     [bookmark: pgfId-81177]The VLAN Access Lists page is displayed. For a description of the fields on this page, see VLAN Access Lists Page.

 
     [bookmark: pgfId-81179]Step 2 Click in a row to select a VACL, then click Delete.

 
     [bookmark: pgfId-81181]Step 3 Click OK to save your changes.

 
     [bookmark: pgfId-81183]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-81197][bookmark: 155302][bookmark: catpage_cncpt_VLANAccessListsPage]VLAN Access Lists Page[bookmark: marker-81191][bookmark: marker-81193][bookmark: marker-81195]

 
     [bookmark: pgfId-81199]Use the VLAN Access Lists page to view and configure VLAN access lists for Cisco Catalyst switches and Cisco 7600 Series routers.

 
     [bookmark: pgfId-81201]Navigation Path

 
     [bookmark: pgfId-81203]You can access this page from:

 
      
      		 [bookmark: pgfId-81205](Device view) Select  Platform > VLAN Access Lists from the Device Policy selector.

 
      		 [bookmark: pgfId-81207](Device view) Select  Catalyst Platform >VLAN Access Lists from the Policy Types selector.

 
     

 
     [bookmark: pgfId-81209]Related Topics

 
      
      		 [bookmark: pgfId-81214]Creating Access Control List Objects

 
      		 [bookmark: pgfId-81219]Create and Edit VLAN ACL Dialog Boxes

 
      		 [bookmark: pgfId-81224]Create and Edit VLAN ACL Content Dialog Boxes

 
      		 [bookmark: pgfId-81229]Filtering Tables

 
     

 
     [bookmark: pgfId-81231]Field Reference

 
     [bookmark: pgfId-81234] 

 
      
       
        
        [bookmark: pgfId-78104]Table 67-18 [bookmark: 155345]VLAN Access Lists Page 

 
        
       
         
         		
           
           [bookmark: pgfId-78110]Element
          
  
         		
           
           [bookmark: pgfId-78112]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-78118]VLAN Access Lists table
          
  
        

 
         
         		[bookmark: pgfId-78126]VLAN ACL

  
         		[bookmark: pgfId-78128]Displays the VLAN ACL name.

  
        

 
         
         		[bookmark: pgfId-78134]Sequence

  
         		[bookmark: pgfId-78136]Specifies the map sequence number. VACL sequences are applied in order of sequence, from lowest number to highest.

  
        

 
         
         		[bookmark: pgfId-78142]Matching

  
         		[bookmark: pgfId-78144]Displays the Match ACLs, if any are defined. VACL matching occurs only when an ACL permit is encountered. ACL denies are ignored.

  
        

 
         
         		[bookmark: pgfId-78150]Action

  
         		[bookmark: pgfId-78152]Specify whether the action is to drop, drop and log, forward, forward and capture, or redirect packets.

 [bookmark: pgfId-78154]Note The redirect action helps you to specify as many as five interfaces, which can be physical interfaces or EtherChannels. You cannot redirect packets to an EtherChannel member or a VLAN interface.

  
        

 
         
         		[bookmark: pgfId-78160]VLAN IDs

  
         		[bookmark: pgfId-78162]Interface-specific identity of the VLAN that a table row describes. The VLAN ID specifies where 802.1Q tagged packets are sent and received on the subinterface; without a VLAN ID, the subinterface cannot send or receive traffic.

  
        

 
         
         		[bookmark: pgfId-78168]Add Row button

  
         		[bookmark: pgfId-78170]Opens the Create VLAN ACL dialog box, where you can define a new VACL.

  
        

 
         
         		[bookmark: pgfId-78176]Edit Row button

  
         		[bookmark: pgfId-78178]Opens the Edit VLAN ACL dialog box, where you can edit the selected VACL.

  
        

 
         
         		[bookmark: pgfId-78184]Delete Row button

  
         		[bookmark: pgfId-78186]Deletes the selected access list.

  
        

 
         
         		 
           
           [bookmark: pgfId-78192]Additional fields
          
  
        

 
         
         		[bookmark: pgfId-78200]Log Table Size

  
         		[bookmark: pgfId-78202]Displays the log table size.

 [bookmark: pgfId-78204]Valid sizes range from 0 to 2048 and the default is 500. Logged packets from new flows are dropped when the table is full.

  
        

 
         
         		[bookmark: pgfId-78210]Max. Packet Rate

  
         		[bookmark: pgfId-78212]Displays the maximum redirect VACL logging packet rate per second.

 [bookmark: pgfId-78214]Valid rates range from 10 to 5000 packets per second and the default rate is 2000. Packets that exceed the limit are dropped.

  
        

 
         
         		[bookmark: pgfId-78220]Logging Threshold

  
         		[bookmark: pgfId-78222]Displays the logging threshold if one is set. By default, no threshold is set.

 [bookmark: pgfId-78224]When you configure VACL logging, IP packets that are denied generate log messages on a per-flow basis if the threshold for a flow is reached in any interval of less than 5 minutes. Only dropped IP packets can be logged.

  
        

 
         
         		[bookmark: pgfId-78230]Capture Interfaces

  
         		[bookmark: pgfId-78232]Identifies the interface that captures forwarded packets in which the capture bit is set. You can configure any interface as the capture interface.

 [bookmark: pgfId-78234]The capture action sets the capture bit for the forwarded packets so that ports with the capture function enabled can receive the packets. Only forwarded packets can be captured.

 [bookmark: pgfId-78239]Note The information shown here is read-only. To define capture interfaces, use the Create/Edit Interface dialog box. See Interfaces/VLANs Page—Interfaces Tab.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-81246][bookmark: 155432][bookmark: catpage_cncpt_CreateandEditVLANACLDialogBoxes]Create and Edit VLAN ACL Dialog Boxes[bookmark: marker-81242][bookmark: marker-81244]

 
     [bookmark: pgfId-81248]Use the Create VLAN ACL dialog box (or the Edit VLAN ACL dialog box) to configure or reconfigure VACL attributes.

 
     [bookmark: pgfId-81250]Navigation Path

 
     [bookmark: pgfId-81255]Go to the VLAN Access Lists Page, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-81257]Related Topics

 
      
      		 [bookmark: pgfId-81262]Create and Edit VLAN Dialog Boxes

 
      		 [bookmark: pgfId-81267]Create and Edit VLAN Group Dialog Boxes

 
      		 [bookmark: pgfId-81272]Filtering Tables

 
     

 
     [bookmark: pgfId-81274]Field Reference

 
     [bookmark: pgfId-81277] 

 
      
       
        
        [bookmark: pgfId-78252]Table 67-19 [bookmark: 155465]Create and Edit VLAN ACL Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-78258]Element
          
  
         		
           
           [bookmark: pgfId-78260]Description
          
  
        

 
         
         		[bookmark: pgfId-78266]VLAN ACL Name

  
         		[bookmark: pgfId-78268]The user-defined name for the VACL.

  
        

 
         
         		[bookmark: pgfId-78274]VLANs (Select button)

  
         		[bookmark: pgfId-78276]Enables you to designate the VLANs to which the VACL should be applied. Do one of the following:

 
           
           		 [bookmark: pgfId-78278]Enter VLAN IDs. You can use commas to separate multiple VLANs or use a hyphen to indicate a range of VLANs. For example: 12,17,22 or 2-200. Valid IDs range from 1 to 4094.

 
           		 [bookmark: pgfId-78283]Click  Select to open the VLAN Selector Dialog Box.

 
          

  
        

 
         
         		[bookmark: pgfId-78289]Sequence Map table

  
         		[bookmark: pgfId-78291]The sequence maps included in the VLAN access map.

 [bookmark: pgfId-78293]A VLAN access map can consist of one or more map sequences, where each sequence pairs a match clause, which specifies an ACL object for traffic filtering, to an action clause, which specifies the action to take on packets that meet the criteria defined in the match ACLs.

 
           
           		 [bookmark: pgfId-78298]To add a sequence map, click the Add Row (+) button and fill in the Create VLAN ACL Content dialog box (see Create and Edit VLAN ACL Content Dialog Boxes).

 
           		 [bookmark: pgfId-78300]To edit a sequence map, select it and click the Edit Row button.

 
           		 [bookmark: pgfId-78302]To delete a sequence map, select it and click the Delete Row button.

 
           		 [bookmark: pgfId-78304]To change the order of a map, select it and click the Up or Down arrow buttons until it is in the desired position. The sequence number changes as you move it.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-81289][bookmark: 155511][bookmark: catpage_cncpt_CreateandEditVLANACLContentDialogBoxes]Create and Edit VLAN ACL Content Dialog Boxes[bookmark: marker-81285][bookmark: marker-81287]

 
     [bookmark: pgfId-81291]Use the Create VLAN ACL Content dialog box (or the Edit VLAN ACL Content dialog box) to configure or reconfigure VACL sequences.

 
     [bookmark: pgfId-81293]Navigation Path

 
     [bookmark: pgfId-81298]Go to the Create and Edit VLAN ACL Dialog Boxes, then click the Add or Edit button beneath the Sequence Map table.

 
     [bookmark: pgfId-81300]Related Topics

 
      
      		 [bookmark: pgfId-81305]Create and Edit VLAN Dialog Boxes

 
      		 [bookmark: pgfId-81310]Create and Edit VLAN Group Dialog Boxes

 
     

 
     [bookmark: pgfId-81312]Field Reference

 
     [bookmark: pgfId-81315] 

 
      
       
        
        [bookmark: pgfId-78317]Table 67-20 [bookmark: 155541]Create and Edit VLAN ACL Content Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-78323]Element
          
  
         		
           
           [bookmark: pgfId-78325]Description
          
  
        

 
         
         		[bookmark: pgfId-78331]Sequence

  
         		[bookmark: pgfId-78333]Specify the map sequence number for the VLAN access map. Valid values range from 1 to 65535.

  
        

 
         
         		[bookmark: pgfId-78339]Match ACLs

  
         		[bookmark: pgfId-78341]Specify which ACLs the sequence should include in its match clause.

 [bookmark: pgfId-78343]Enter the names of the standard and extended ACL objects to include in the sequence, or click Select to select them from a list or to create new ones.

 [bookmark: pgfId-78345]You cannot use a MAC-layer ACL.

  
        

 
         
         		[bookmark: pgfId-78351]Action

  
         		[bookmark: pgfId-78353]The option to perform on packets that meet the criteria defined in the match ACLs:

 
           
           		 [bookmark: pgfId-78355]Drop—Drops the packets.

 
           		 [bookmark: pgfId-78357]Drop/Log—Logs the dropped packets.

 
           		 [bookmark: pgfId-78359]Forward—Forwards the packets to their destination (using hardware switching).

 
           		 [bookmark: pgfId-78361]Forward/Capture—Sets the capture bit for the forwarded packets so that ports with the capture function enabled also receive the packets.

 
           		 [bookmark: pgfId-78363]Redirect—Redirects packets to the Ethernet interfaces defined in the Interfaces field.

 
          

  
        

 
         
         		[bookmark: pgfId-78369]Interfaces (Select button)

  
         		[bookmark: pgfId-78371]Applies only when the specified action is Redirect.

 [bookmark: pgfId-78376]The destination interfaces for redirect packets. Enter the names of up to five physical interfaces, or click Select to open the Interface Selector Dialog Box—VLAN ACL Content. The redirect interfaces must be in the VLAN for which the VACL access map is configured.

 [bookmark: pgfId-78378]Note You cannot redirect packets to an EtherChannel member or a VLAN interface. You also cannot redirect packets to a subinterface.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-81325][bookmark: 155589][bookmark: catpage_cncpt_InterfaceSelectorDialogBoxVLANACLContent]Interface Selector Dialog Box—VLAN ACL Content [bookmark: marker-81323]

 
     [bookmark: pgfId-81327]Use the Interface Selector dialog box to define redirect interfaces when you create entries for a VACL sequence map.

 
     [bookmark: pgfId-81329]Navigation Path

 
     [bookmark: pgfId-81334]Open the Create and Edit VLAN ACL Content Dialog Boxes, select Redirect as the action, then click Select in the Interfaces field.

 
     [bookmark: pgfId-81336]Related Topics

 
      
      		 [bookmark: pgfId-81341]Create and Edit VLAN ACL Dialog Boxes

 
      		 [bookmark: pgfId-81346]VLAN Access Lists Page

 
      		 [bookmark: pgfId-81351]Filtering Tables

 
     

 
     [bookmark: pgfId-81353]Field Reference

 
     [bookmark: pgfId-81356] 

 
      
       
        
        [bookmark: pgfId-78391]Table 67-21 [bookmark: 155616]Interface Selector Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-78397]Element
          
  
         		
           
           [bookmark: pgfId-78399]Description
          
  
        

 
         
         		[bookmark: pgfId-78405]Available Interfaces

  
         		[bookmark: pgfId-78407]Displays the physical interfaces that are defined in the Interfaces/VLANs policy.

  
        

 
         
         		[bookmark: pgfId-78413]Add >> button

  
         		[bookmark: pgfId-78415]Adds interfaces that are selected in the Available Interfaces list to the Selected Interfaces list.

  
        

 
         
         		[bookmark: pgfId-78421]Remove << button

  
         		[bookmark: pgfId-78423]Removes selected interfaces from the Selected Interfaces list.

  
        

 
         
         		[bookmark: pgfId-78429]Selected Interfaces

  
         		[bookmark: pgfId-78431]Displays the interfaces that are selected.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-81366][bookmark: 155650][bookmark: catman_cncpt_IDSMSettings]IDSM Settings[bookmark: marker-81362][bookmark: marker-81364]

 
    [bookmark: pgfId-81368]When you select a Catalyst device in Device view, then select Platform > IDSM Settings from the Policy selector, a list is displayed that:

 
     
     		 [bookmark: pgfId-81370]Displays the settings for data ports on Intrusion Detection System Service Modules (IDSMs).

 
     		 [bookmark: pgfId-81372]Helps you to organize IDSM data ports in channel groups.

 
    

 
    [bookmark: pgfId-81374]The IDSM card detects and stops security threats on network connections. The card inspects the traffic that enters its two data ports and drops packets if a security threat is detected. The data port settings define:

 
     
     		 [bookmark: pgfId-81376]Which traffic is received by the data ports, as defined by the VLAN IDs.

 
     		 [bookmark: pgfId-81378]The sensing mode used by the data ports:

 
    

 
    [bookmark: pgfId-81380] – Trunk (IPS)—The IDSM performs VLAN bridging between pairs of VLANs within the same data port, operating as an 802.1q trunk. The IDSM inspects the traffic it receives on each VLAN in a VLAN pair and can either forward the packets on the other VLAN in the pair or drop the packet if an intrusion attempt is detected.

 
    [bookmark: pgfId-81382] – Capture (IDS)—The IDSM passively monitors network traffic that was copied to the data ports by the Catalyst switch using either VACL capture or SPAN. The data ports operate as 802.1q trunks that can be configured to trunk different VLANs. When operating in this passive mode, the IDSM cannot drop packets in response to a network intrusion attempt, but it can send TCP resets over the data ports in an attempt to block the intrusion.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-81388]Note Security Manager supports a subset of IDSM settings on chassis running IOS 12.2(18)SXF4 or later. Trunk (IPS) and Capture (IDS) modes are supported; inline mode is not supported. Security Manager cannot manage IDSM data ports that are part of a spanning tree or access VLAN.[bookmark: marker-81384][bookmark: marker-81386]


    
     

    

    

 
    [bookmark: pgfId-81390]For high-traffic networks, EtherChannel is used to perform load balancing among multiple data ports. These data ports might be located on different IDSM cards within the same Catalyst device.

 
    [bookmark: pgfId-81392]EtherChannel is also used to redirect traffic in the event of port failure to the remaining ports within the channel group. This resiliency help preserve intrusion detection and prevention without user intervention and with minimum packet loss.

 
    [bookmark: pgfId-81394]The following topics describe the actions you can perform when defining IDSM settings:

 
     
     		 [bookmark: pgfId-81399]Creating or Editing EtherChannel VLAN Definitions

 
     		 [bookmark: pgfId-81404]Deleting EtherChannel VLAN Definitions

 
     		 [bookmark: pgfId-81409]Creating or Editing Data Port VLAN Definitions

 
     		 [bookmark: pgfId-81414]Deleting Data Port VLAN Definitions

 
     		 [bookmark: pgfId-81419]IDSM Settings Page

 
    

 
    [bookmark: pgfId-81421]Related Topics

 
     
     		 [bookmark: pgfId-81426]VLANs

 
     		 [bookmark: pgfId-81431]Chapter 67, “Managing Cisco Catalyst Switches and Cisco 7600 Series Routers”

 
    

 
     
      [bookmark: pgfId-81445][bookmark: 155711][bookmark: catman_proc_CreatingorEditingEtherChannelVLANDefinitions]Creating or Editing EtherChannel VLAN Definitions[bookmark: marker-81437][bookmark: marker-81439][bookmark: marker-81441][bookmark: marker-81443]

 
     [bookmark: pgfId-81447]When defining an EtherChannel VLAN definition, you must:

 
      
      		 [bookmark: pgfId-81449]Define the slot-port combination containing the data ports to include in the channel group.

 
      		 [bookmark: pgfId-81451]Select the sensing mode used by the data ports.

 
      		 [bookmark: pgfId-81453]Define which VLANs are forwarded to the data ports.

 
     

 
     [bookmark: pgfId-81455]The following restrictions apply:

 
      
      		 [bookmark: pgfId-81457]You can have a single definition only for each channel group.

 
      		 [bookmark: pgfId-81459]You can have a single definition only for each slot-data port combination. This means that you cannot create an EtherChannel VLAN definition if a data port definition already exists for this slot-data port.

 
     

 
     [bookmark: pgfId-81461]Related Topics

 
      
      		 [bookmark: pgfId-81466]Deleting EtherChannel VLAN Definitions

 
      		 [bookmark: pgfId-81471]Creating or Editing Data Port VLAN Definitions

 
      		 [bookmark: pgfId-81476]IDSM Settings

 
     

 
     
 
     [bookmark: pgfId-81478]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-81480](Device view) Select a Catalyst device, then select  Platform > IDSM Settings from the Policy selector.

 
      		 [bookmark: pgfId-81482](Policy view) Select  Catalyst Platform > IDSM Settings .

 
     

 
     [bookmark: pgfId-81487]The IDSM Settings page is displayed. For a description of the fields on this page, see IDSM Settings Page.

 
     [bookmark: pgfId-81489]Step 2 Do one of the following:

 
      
      		 [bookmark: pgfId-81491]To create an IDSM EtherChannel VLAN definition, click  Add Row beneath the EtherChannel VLANs table.

 
      		 [bookmark: pgfId-81493]To edit an IDSM EtherChannel VLAN definition, select it in the list, then click  Edit Row beneath the table.

 
     

 
     [bookmark: pgfId-81498]The IDSM EtherChannel VLAN dialog box is displayed. For a description of the fields in this dialog box, see Create and Edit IDSM EtherChannel VLANs Dialog Boxes.

 
     [bookmark: pgfId-81500]Step 3 To assign a channel group number to the Ethernet interface for the VLAN, or to change the channel group number, enter a number in the Channel Group text box.

 
     [bookmark: pgfId-81502]Step 4 To associate the VLAN with the numbered chassis slot where you installed your IDSM services module and to associate one module data port with the VLAN, do one of the following:

 
      
      		 [bookmark: pgfId-81504]Enter the slot-port number in the  Slot-Ports text box.

 
      		 [bookmark: pgfId-81506]Click  Select to open the IDSM Slot-Port Selector dialog box.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-81508]Note Associating one module data port with the VLAN enables you to configure the port at the group level instead of configuring it manually.


     
      

     

     

 
     [bookmark: pgfId-81510]Step 5 From the Mode list, select the running mode of the EtherChannel VLAN. If you select Capture, select the check box to configure the specified channel group as a capture destination.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-81512]Note If you do not select this check box, the capture port is created in shutdown mode.


     
      

     

     

 
     [bookmark: pgfId-81514]Step 6 To include a VLAN in the specified channel group, do one of the following:

 
      
      		 [bookmark: pgfId-81516]Enter its numeric ID in the VLAN IDs text box.

 
      		 [bookmark: pgfId-81518]Click  Select to open the VLAN Selector dialog box.

 
     

 
     [bookmark: pgfId-81520]You can enter or select more than one VLAN ID.

 
     [bookmark: pgfId-81522]Step 7 Click OK to save your definitions locally on the client and close the dialog box.

 
     [bookmark: pgfId-81524]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-81538][bookmark: 155806][bookmark: catman_proc_DeletingEtherChannelVLANDefinitions]Deleting EtherChannel VLAN Definitions[bookmark: marker-81530][bookmark: marker-81532][bookmark: marker-81534][bookmark: marker-81536]

 
     [bookmark: pgfId-81540]You can delete an EtherChannel VLAN definition on the IDSM.

 
     [bookmark: pgfId-81542]Related Topics

 
      
      		 [bookmark: pgfId-81547]Creating or Editing EtherChannel VLAN Definitions

 
      		 [bookmark: pgfId-81552]Deleting Data Port VLAN Definitions

 
      		 [bookmark: pgfId-81557]IDSM Settings

 
     

 
     
 
     [bookmark: pgfId-81559]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-81561](Device view) Select a Catalyst device, then select  Platform > IDSM Settings from the Policy selector.

 
      		 [bookmark: pgfId-81563](Policy view) Select  Catalyst Platform > IDSM Settings .

 
     

 
     [bookmark: pgfId-81568]The IDSM Settings page is displayed. For a description of the fields on this page, see IDSM Settings Page.

 
     [bookmark: pgfId-81570]Step 2 Click a row in the table to select the VLAN definition to delete.

 
     [bookmark: pgfId-81572]Step 3 Click Delete Row.

 
     [bookmark: pgfId-81574]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-81586][bookmark: 155854][bookmark: catman_proc_CreatingorEditingDataPortVLANDefinitions]Creating or Editing Data Port VLAN Definitions[bookmark: marker-81580][bookmark: marker-81582][bookmark: marker-81584]

 
     [bookmark: pgfId-81588]When defining a data port VLAN definition, you must:

 
      
      		 [bookmark: pgfId-81590]Define the slot-port combination where the data port is located.

 
      		 [bookmark: pgfId-81592]Select the sensing mode used by the data port.

 
      		 [bookmark: pgfId-81594]Define which VLANs are forwarded to the data port.

 
     

 
     [bookmark: pgfId-81596]The following restrictions apply:

 
      
      		 [bookmark: pgfId-81598]You may have a single definition only for each data port.

 
      		 [bookmark: pgfId-81600]You cannot create a data port definition if the port is already defined as part of a channel group.

 
     

 
     [bookmark: pgfId-81602]Related Topics

 
      
      		 [bookmark: pgfId-81607]Deleting Data Port VLAN Definitions

 
      		 [bookmark: pgfId-81612]Creating or Editing EtherChannel VLAN Definitions

 
      		 [bookmark: pgfId-81617]IDSM Settings

 
     

 
     
 
     [bookmark: pgfId-81619]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-81621](Device view) Select a Catalyst device, then select  Platform > IDSM Settings from the Policy selector.

 
      		 [bookmark: pgfId-81623](Device view) Select  Catalyst Platform > IDSM Settings .

 
     

 
     [bookmark: pgfId-81628]The IDSM Settings page is displayed. For a description of the fields on this page, see IDSM Settings Page.

 
     [bookmark: pgfId-81630]Step 2 Do one of the following:

 
      
      		 [bookmark: pgfId-81632]To create an IDSM data port VLAN definition, click  Add Row beneath the Data Port VLANs table.

 
      		 [bookmark: pgfId-81634]To edit an IDSM data port VLAN definition, select it in the list, then click  Edit Row beneath the table.

 
     

 
     [bookmark: pgfId-81639]The IDSM Data Port VLAN dialog box is displayed. For a description of the fields in this dialog box, see Create and Edit IDSM Data Port VLANs Dialog Boxes.

 
     [bookmark: pgfId-81641]Step 3 To associate the VLAN with the numbered chassis slot where you installed your IDSM services module and to associate one module data port with the VLAN, do one of the following:

 
      
      		 [bookmark: pgfId-81643]Enter the slot-port number in the  Slot-Ports text box.

 
      		 [bookmark: pgfId-81645]Click  Select to open the IDSM Slot-Port Selector dialog box.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-81647]Note Associating one module data port with the VLAN enables you to configure the port at the group level instead of configuring it manually.


     
      

     

     

 
     [bookmark: pgfId-81649]Step 4 From the Mode list, select the running mode of the data port VLAN. If you select Capture, select the check box to configure the specified data port as a capture destination.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-81651]Note If you do not select this check box, the capture port is created in shutdown mode.


     
      

     

     

 
     [bookmark: pgfId-81653]Step 5 To assign a VLAN to the specified data port, do one of the following:

 
      
      		 [bookmark: pgfId-81655]Enter its numeric ID in the VLAN IDs text box.

 
      		 [bookmark: pgfId-81657]Click  Select to open the VLAN Selector dialog box.

 
     

 
     [bookmark: pgfId-81659]You can enter or select more than one VLAN ID.

 
     [bookmark: pgfId-81661]Step 6 Click OK to save your definitions locally on the client and close the dialog box.

 
     [bookmark: pgfId-81663]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-81675][bookmark: 155943][bookmark: catman_proc_DeletingDataPortVLANDefinitions]Deleting Data Port VLAN Definitions[bookmark: marker-81669][bookmark: marker-81671][bookmark: marker-81673]

 
     [bookmark: pgfId-81677]You can delete a data port VLAN definition on the IDSM.

 
     [bookmark: pgfId-81679]Related Topics

 
      
      		 [bookmark: pgfId-81684]Creating or Editing Data Port VLAN Definitions

 
      		 [bookmark: pgfId-81689]Deleting EtherChannel VLAN Definitions

 
      		 [bookmark: pgfId-81694]IDSM Settings

 
     

 
     
 
     [bookmark: pgfId-81696]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-81698](Device view) Select a Catalyst device, then select  Platform > IDSM Settings from the Policy selector.

 
      		 [bookmark: pgfId-81700](Policy view) Select  Catalyst Platform > IDSM Settings .

 
     

 
     [bookmark: pgfId-81705]The IDSM Settings page is displayed. For a description of the fields on this page, see IDSM Settings Page.

 
     [bookmark: pgfId-81707]Step 2 Click a row in the table to select the VLAN definition to delete.

 
     [bookmark: pgfId-81709]Step 3 Click Delete Row.

 
     [bookmark: pgfId-81711]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-81725][bookmark: 155988][bookmark: catpage_cncpt_IDSMSettingsPage]IDSM Settings Page[bookmark: marker-81719][bookmark: marker-81721][bookmark: marker-81723]

 
     [bookmark: pgfId-81727]Use the IDSM Settings page to view and configure the VLAN settings for data ports and channel groups on Intrusion Detection System Service Modules (IDSM).

 
     [bookmark: pgfId-81729]Navigation Path

 
     [bookmark: pgfId-81731]You can access this page from:

 
      
      		 [bookmark: pgfId-81733](Device view) Select  Platform > IDSM Settings from the Device Policy selector.

 
      		 [bookmark: pgfId-81735](Policy view) Select  Catalyst Platform > IDSM Settings from the Policy Types selector.

 
     

 
     [bookmark: pgfId-81737]Related Topics

 
      
      		 [bookmark: pgfId-81742]Create and Edit IDSM EtherChannel VLANs Dialog Boxes

 
      		 [bookmark: pgfId-81747]Create and Edit IDSM Data Port VLANs Dialog Boxes

 
      		 [bookmark: pgfId-81752]Chapter 46, “Managing Firewall Devices”

 
      		 [bookmark: pgfId-81757]Filtering Tables

 
     

 
     [bookmark: pgfId-81759]Field Reference

 
     [bookmark: pgfId-81762] 

 
      
       
        
        [bookmark: pgfId-78444]Table 67-22 [bookmark: 156030]IDSM Settings Page 

 
        
       
         
         		
           
           [bookmark: pgfId-78450]Element
          
  
         		
           
           [bookmark: pgfId-78452]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-78458]EtherChannel VLANs table
          
  
        

 
         
         		[bookmark: pgfId-78466]Channel Group

  
         		[bookmark: pgfId-78468]Identifies the EtherChannel group to which the Ethernet interface is assigned.

  
        

 
         
         		[bookmark: pgfId-78474]Module Slot-Data Port

  
         		[bookmark: pgfId-78476]Identifies the IDSM service module data port by number (1 or 2) to distinguish between the two ports.

 [bookmark: pgfId-78478]Each IDSM service module (blade) has two data ports. You can configure a data port individually or you can assign it to an EtherChannel group. All data ports in a channel group are configured at the group level

  
        

 
         
         		[bookmark: pgfId-78484]Mode

  
         		[bookmark: pgfId-78486]Indicates whether the running mode is trunk (IPS) or capture (IDS).

  
        

 
         
         		[bookmark: pgfId-78492]Capture Enabled

  
         		[bookmark: pgfId-78494]Indicates whether the specified channel group is configured as a capture destination.

  
        

 
         
         		[bookmark: pgfId-78500]Allowed VLANs

  
         		[bookmark: pgfId-78502]Lists which VLANs are allowed for the specified channel group.

  
        

 
         
         		[bookmark: pgfId-78508]Add Row button

  
         		[bookmark: pgfId-78510]Opens the Create IDSM EtherChannel VLANs dialog box. From here you can define which traffic is directed to the data ports in an EtherChannel group and which sensing mode is used.

  
        

 
         
         		[bookmark: pgfId-78516]Edit Row button

  
         		[bookmark: pgfId-78518]Opens the Edit IDSM EtherChannel VLANs dialog box. From here you can modify the attributes of an EtherChannel VLAN definition.

  
        

 
         
         		[bookmark: pgfId-78524]Delete Row button

  
         		[bookmark: pgfId-78526]Deletes the selected VLAN from the IDSM.

  
        

 
         
         		 
           
           [bookmark: pgfId-78532]Data Port VLANs table
          
  
        

 
         
         		[bookmark: pgfId-78540]Module Slot-Data Port

  
         		[bookmark: pgfId-78542]Identifies the IDSM service module data port by number (1 or 2), to distinguish between the two ports.

  
        

 
         
         		[bookmark: pgfId-78548]Mode

  
         		[bookmark: pgfId-78550]Indicates whether the running mode is trunk (IPS) or capture (IDS). To change the mode, select and edit the relevant table row.

  
        

 
         
         		[bookmark: pgfId-78556]Capture Enabled

  
         		[bookmark: pgfId-78558]Indicates whether the specified data port is configured as a capture destination.

  
        

 
         
         		[bookmark: pgfId-78564]Allowed VLANs

  
         		[bookmark: pgfId-78566]Lists which VLANs are allowed for the specified data port.

  
        

 
         
         		[bookmark: pgfId-78572]Add Row button

  
         		[bookmark: pgfId-78574]Opens the Create IDSM Data Port VLANs dialog box. From here you can define which traffic is directed to a specific data port and which sensing mode is used.

  
        

 
         
         		[bookmark: pgfId-78580]Edit Row button

  
         		[bookmark: pgfId-78582]Opens the Edit IDSM Data Port VLANs dialog box. From here you can modify the attributes of a data port VLAN definition.

  
        

 
         
         		[bookmark: pgfId-78588]Delete Row button

  
         		[bookmark: pgfId-78590]Deletes the selected VLAN from the IDSM.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-81776][bookmark: 156126][bookmark: catpage_cncpt_CreateandEditIDSMEtherChannelVLANsDialogBoxes]Create and Edit IDSM EtherChannel VLANs Dialog Boxes[bookmark: marker-81770][bookmark: marker-81772][bookmark: marker-81774]

 
     [bookmark: pgfId-81778]Use the Create IDSM EtherChannel VLANs dialog box (or the Edit IDSM EtherChannel VLANs dialog box) to configure or reconfigure the attributes of an IDSM EtherChannel VLAN.

 
     [bookmark: pgfId-81780]Navigation Path

 
     [bookmark: pgfId-81785]Go to the IDSM Settings Page, then click the Add or Edit button beneath the EtherChannel VLANs table.

 
     [bookmark: pgfId-81787]Related Topics

 
      
      		 [bookmark: pgfId-81792]Create and Edit IDSM Data Port VLANs Dialog Boxes

 
      		 [bookmark: pgfId-81797]IDSM Slot-Port Selector Dialog Box

 
      		 [bookmark: pgfId-81802]Service Module Slot Selector Dialog Box

 
     

 
     [bookmark: pgfId-81804]Field Reference

 
     [bookmark: pgfId-81807] 

 
      
       
        
        [bookmark: pgfId-78603]Table 67-23 [bookmark: 156161]Create and Edit IDSM EtherChannel VLANs Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-78609]Element
          
  
         		
           
           [bookmark: pgfId-78611]Description
          
  
        

 
         
         		[bookmark: pgfId-78617]Channel Group

  
         		[bookmark: pgfId-78619]The EtherChannel group to which the Ethernet interface is assigned.

  
        

 
         
         		[bookmark: pgfId-78625]Slot-Ports (Select button)

  
         		[bookmark: pgfId-78627]Associates the chassis slot number (in which the relevant services module is installed) with the data port in the format x -y, where x is the slot number and y is the port number. For example, 2-1 refers to data port 1 in slot 2.

 [bookmark: pgfId-78632]Click Select to open the IDSM Slot-Port Selector Dialog Box. From here, you can select the IDSM slot-port combinations to include in the EtherChannel group.

  
        

 
         
         		[bookmark: pgfId-78638]Mode

  
         		[bookmark: pgfId-78640]The running mode of the EtherChannel group:

 
           
           		 [bookmark: pgfId-78642]Capture (IDS)—The IDSM2 passively monitors network traffic that was copied to its data ports by the Catalyst switch using either VACL capture or SPAN.

 
           		 [bookmark: pgfId-78644]Trunk (IPS)—The IDSM2 operates as an 802.1Q trunk by performing VLAN bridging between pairs of VLANs within the same data port.

 
          

  
        

 
         
         		[bookmark: pgfId-78650]Capture Enabled

  
         		[bookmark: pgfId-78652]Applies only when the running mode is Capture (IDS).

 [bookmark: pgfId-78654]When selected, configures the specified channel group as a capture destination. When deselected, the channel group does not act as a capture destination.

  
        

 
         
         		[bookmark: pgfId-78660]VLAN IDs (Select button)

  
         		[bookmark: pgfId-78662]Identifies which VLANs the specified channel group should allow.

 [bookmark: pgfId-78667]Click Select to open the VLAN Selector Dialog Box. From here, you can select VLANs to include or exclude.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-81819][bookmark: 156213][bookmark: catpage_cncpt_CreateandEditIDSMDataPortVLANsDialogBoxes]Create and Edit IDSM Data Port VLANs Dialog Boxes[bookmark: marker-81815][bookmark: marker-81817]

 
     [bookmark: pgfId-81821]Use the Create IDSM Data Port VLANs dialog box (or the Edit IDSM Data Port VLANs dialog box) to define which traffic is directed to an IDSM data port and which sensing mode is used on that traffic.

 
     [bookmark: pgfId-81823]Navigation Path

 
     [bookmark: pgfId-81828]Go to the IDSM Settings Page, then click the Add or Edit button beneath the Data Port VLANs table.

 
     [bookmark: pgfId-81830]Related Topics

 
      
      		 [bookmark: pgfId-81835]Create and Edit IDSM EtherChannel VLANs Dialog Boxes

 
      		 [bookmark: pgfId-81840]IDSM Slot-Port Selector Dialog Box

 
      		 [bookmark: pgfId-81845]Service Module Slot Selector Dialog Box

 
     

 
     [bookmark: pgfId-81847]Field Reference

 
     [bookmark: pgfId-81850] 

 
      
       
        
        [bookmark: pgfId-78680]Table 67-24 [bookmark: 156245]Create and Edit IDSM Data Port VLANs Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-78686]Element
          
  
         		
           
           [bookmark: pgfId-78688]Description
          
  
        

 
         
         		[bookmark: pgfId-78694]Slot-Port

  
         		[bookmark: pgfId-78696]Associates the chassis slot number (in which the relevant services module is installed) with the data port in the format x -y, where x is the slot number and y is the port number. For example, 2-1 refers to data port 1 in slot 2.

 [bookmark: pgfId-78701]Click Select to open the IDSM Slot-Port Selector Dialog Box. From here, you can select the IDSM slot-port combinations to include in the data port VLAN definition.

  
        

 
         
         		[bookmark: pgfId-78707]Mode

  
         		[bookmark: pgfId-78709]The running mode of the data port:

 
           
           		 [bookmark: pgfId-78711]Capture (IDS)—The IDSM2 passively monitors network traffic that was copied to its data ports by the Catalyst switch using either VACL capture or SPAN.

 
           		 [bookmark: pgfId-78713]Trunk (IPS)—The IDSM2 operates as an 802.1Q trunk by performing VLAN bridging between pairs of VLANs within the same data port.

 
          

  
        

 
         
         		[bookmark: pgfId-78719]Capture Enabled

  
         		[bookmark: pgfId-78721]Applies only when the running mode is Capture (IDS).

 [bookmark: pgfId-78723]When selected, configures the specified channel group as a capture destination. When deselected, the channel group does not act as a capture destination.

  
        

 
         
         		[bookmark: pgfId-78729]VLAN IDs (Select button)

  
         		[bookmark: pgfId-78731]Identifies which VLANs the specified data port should allow.

 [bookmark: pgfId-78736]Click Select to open the VLAN Selector Dialog Box. From here, you can select VLANs to include or exclude.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-81862][bookmark: 156291][bookmark: catpage_cncpt_IDSMSlotPortSelectorDialogBox]IDSM Slot-Port Selector Dialog Box[bookmark: marker-81858][bookmark: marker-81860]

 
     [bookmark: pgfId-81864]Use the IDSM Slot-Port Selector dialog box to associate slot-port objects with EtherChannel groups.

 
     [bookmark: pgfId-81866]Navigation Path

 
     [bookmark: pgfId-81874]Go to the Create and Edit IDSM EtherChannel VLANs Dialog Boxes or the Create and Edit IDSM Data Port VLANs Dialog Boxes, then click Select in the Slot-Port field.

 
     [bookmark: pgfId-81876]Related Topics

 
      
      		 [bookmark: pgfId-81881]VLAN Selector Dialog Box

 
      		 [bookmark: pgfId-81886]Filtering Tables

 
     

 
     [bookmark: pgfId-81888]Field Reference

 
     [bookmark: pgfId-81891] 

 
      
       
        
        [bookmark: pgfId-78749]Table 67-25 [bookmark: 156320]IDSM Slot-Port Selector Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-78755]Element
          
  
         		
           
           [bookmark: pgfId-78757]Description
          
  
        

 
         
         		[bookmark: pgfId-78763]Available IDSM Slot-Ports list

  
         		[bookmark: pgfId-78765]Displays the available slot-port definitions.

  
        

 
         
         		[bookmark: pgfId-78771]Add >> button

  
         		[bookmark: pgfId-78773]Applies only when selecting slot-ports for EtherChannel VLANs.

 [bookmark: pgfId-78775]Adds IDSM slot-port objects that you selected in the Available IDSM Slot-Ports list to the Selected IDSM Slot-Ports list.

  
        

 
         
         		[bookmark: pgfId-78781]Remove << button

  
         		[bookmark: pgfId-78783]Applies only when selecting slot-ports for EtherChannel VLANs.

 [bookmark: pgfId-78785]Removes selected IDSM slot-port objects from the Selected IDSM Slot-Ports list.

  
        

 
         
         		[bookmark: pgfId-78791]Selected IDSM Slot-Ports list

  
         		[bookmark: pgfId-78793]Displays the IDSM slot-port objects that are selected for an association with a data port or an EtherChannel group.
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     [bookmark: pgfId-747335][bookmark: 109494][bookmark: pxchap_cncpt_ConfiguringDeviceAdministrationPoliciesonFirewallDevices]Configuring Device Administration Policies on Firewall Devices[bookmark: marker-747331][bookmark: marker-747333]
      
      
 
     
 

 
    [bookmark: pgfId-747337]The Device Admin section contains pages for configuring device administration policies for firewall devices.

 
    [bookmark: pgfId-747339]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-747344]About AAA on Security Devices

 
     		 [bookmark: pgfId-747349]Configuring Banners

 
     		 [bookmark: pgfId-747354]Configuring Boot Image/Configuration Settings

 
     		 [bookmark: pgfId-747359]Configuring CLI Prompt

 
     		 [bookmark: pgfId-747364]Setting the Device Clock

 
     		 [bookmark: pgfId-747369]Configuring Device Credentials

 
     		 [bookmark: pgfId-747374]Managing Mount Points

 
    

 
   
 
    
     [bookmark: pgfId-747388][bookmark: 109503][bookmark: pxchap_cncpt_ConfiguringAAA]About AAA on Security Devices [bookmark: marker-747380][bookmark: marker-747382][bookmark: marker-747384][bookmark: marker-747386]

 
    [bookmark: pgfId-747390]Authentication-Authorization-Accounting (AAA) enables the security appliance to determine who a user is (authentication), what the user can do (authorization), and what the user did (accounting). You can use authentication alone, or with authorization and accounting. Authorization always requires a user to be authenticated first. You also can use accounting alone, or with authentication and authorization.

 
    [bookmark: pgfId-747392]Authentication-Authorization-Accounting provides an extra level of protection and control for user access beyond access lists alone. For example, you can create an ACL that allows all outside users to access Telnet on a server on the DMZ network. If you want to limit user access to the server when you may not always know the IP addresses of these users, you can enable AAA to allow only authenticated and/or authorized users to make it through the security appliance. (The Telnet server enforces authentication, too; the security appliance prevents unauthorized users from attempting to access the server.)

 
     
     		 [bookmark: pgfId-747394] Authentication —Authentication grants access based on user identity. Authentication establishes user identity by requiring valid user credentials, which are typically a user name and password. You can configure the security appliance to authenticate the following items:

 
    

 
    [bookmark: pgfId-747396] – Administrative connections to the security appliance using Telnet, SSH, HTTPS/ASDM, or serial console.

 
    [bookmark: pgfId-747398] – The enable command.

 
     
     		 [bookmark: pgfId-747400] Authorization —Authorization controls user capabilities after users are authenticated. Authorization controls the services and commands available to each authenticated user. If you do not enable authorization, authentication alone would provide the same access to services for all authenticated users.

 
    

 
    [bookmark: pgfId-747402]If you need the control that authorization provides, you can configure a broad authentication rule, and then have a detailed authorization configuration. For example, you might authenticate inside users who attempt to access any server on the outside network, and then use authorization to limit the outside servers that a particular user can access.

 
    [bookmark: pgfId-747404]The security appliance caches the first 16 authorization requests per user, so if the user accesses the same services during the current authentication session, the security appliance does not resend the request to the authorization server.

 
     
     		 [bookmark: pgfId-747406] Accounting —Accounting tracks traffic that passes through the security appliance, providing a record of user activity. If you enable authentication for that traffic, you can account for traffic per user. If you do not authenticate the traffic, you can account for traffic per IP address. Accounting information includes when sessions start and stop, user name, the number of bytes that pass through the security appliance for the session, the service used, and the duration of each session.

 
    

 
     
      [bookmark: pgfId-747414][bookmark: 109538][bookmark: pxchap_cncpt_PreparingforAAA]Preparing for AAA [bookmark: marker-747412]

 
     [bookmark: pgfId-747416]AAA services depend upon the use of the Local database or at least one AAA server. You can also use the Local database as a fallback for most services provided by an AAA server. Before you implement AAA, you should configure the Local database and configure AAA server groups and servers.

 
     [bookmark: pgfId-747421]Configuration of the Local database and AAA servers depends upon the AAA services you want the security appliance to support. Regardless of whether you use AAA servers, you should configure the Local database with user accounts that support administrative access, to prevent accidental lock-outs and, if so desired, to provide a fallback method when AAA servers are unreachable. For more information, see Configuring User Accounts.

 
     [bookmark: pgfId-747426]The following table provides a summary of AAA service support by each AAA server type and by the Local database. You manage the Local database by configuring user accounts on the Platform > Device Admin > User Accounts page (see Configuring User Accounts). You establish AAA server groups and add individual AAA servers to the server groups using the Platform > Device Admin > AAA page.

 
     [bookmark: pgfId-747429] 

 
      
       
        
        [bookmark: pgfId-745297]Table 48-1 [bookmark: 109558]Summary of AAA Support 

 
        
       
         
         		 
           
           [bookmark: pgfId-745317]AAA Service
          
  
         		 
           
           [bookmark: pgfId-745319]Database Type
          
  
        

 
         
         		
           
           [bookmark: pgfId-745355]Local
          
  
         		
           
           [bookmark: pgfId-745357]RADIUS
          
  
         		
           
           [bookmark: pgfId-745359]TACACS+
          
  
         		
           
           [bookmark: pgfId-745361]SDI
          
  
         		
           
           [bookmark: pgfId-745363]NT
          
  
         		
           
           [bookmark: pgfId-745365]Kerberos
          
  
         		
           
           [bookmark: pgfId-745367]LDAP
          
  
         		
           
           [bookmark: pgfId-745369]HTTP Form
          
  
        

 
         
         		 [bookmark: pgfId-745389]Authentication of...

  
        

 
         
         		[bookmark: pgfId-745425]VPN users

  
         		[bookmark: pgfId-745427]Yes

  
         		[bookmark: pgfId-745429]Yes

  
         		[bookmark: pgfId-745431]Yes

  
         		[bookmark: pgfId-745433]Yes

  
         		[bookmark: pgfId-745435]Yes

  
         		[bookmark: pgfId-745437]Yes

  
         		[bookmark: pgfId-745439]Yes

  
         		[bookmark: pgfId-745441]Yes1

  
        

 
         
         		[bookmark: pgfId-745461]Firewall sessions

  
         		[bookmark: pgfId-745463]Yes

  
         		[bookmark: pgfId-745465]Yes

  
         		[bookmark: pgfId-745467]Yes

  
         		[bookmark: pgfId-745469]No

  
         		[bookmark: pgfId-745471]No

  
         		[bookmark: pgfId-745473]No

  
         		[bookmark: pgfId-745475]No

  
         		[bookmark: pgfId-745477]No

  
        

 
         
         		[bookmark: pgfId-745497]Administrators

  
         		[bookmark: pgfId-745499]Yes

  
         		[bookmark: pgfId-745501]Yes

  
         		[bookmark: pgfId-745503]Yes

  
         		[bookmark: pgfId-745505]No

  
         		[bookmark: pgfId-745507]No

  
         		[bookmark: pgfId-745509]No

  
         		[bookmark: pgfId-745511]No

  
         		[bookmark: pgfId-745513]No

  
        

 
         
         		 [bookmark: pgfId-745533]Authorization of...

  
        

 
         
         		[bookmark: pgfId-745569]VPN users

  
         		[bookmark: pgfId-745571]Yes

  
         		[bookmark: pgfId-745573]Yes

  
         		[bookmark: pgfId-745575]No

  
         		[bookmark: pgfId-745577]No

  
         		[bookmark: pgfId-745579]No

  
         		[bookmark: pgfId-745581]No

  
         		[bookmark: pgfId-745583]Yes

  
         		[bookmark: pgfId-745585]No

  
        

 
         
         		[bookmark: pgfId-745605]Firewall sessions

  
         		[bookmark: pgfId-745607]No

  
         		[bookmark: pgfId-745609]Yes2

  
         		[bookmark: pgfId-745611]Yes

  
         		[bookmark: pgfId-745613]No

  
         		[bookmark: pgfId-745615]No

  
         		[bookmark: pgfId-745617]No

  
         		[bookmark: pgfId-745619]No

  
         		[bookmark: pgfId-745621]No

  
        

 
         
         		[bookmark: pgfId-745641]Administrators

  
         		[bookmark: pgfId-745643]Yes3

  
         		[bookmark: pgfId-745645]No

  
         		[bookmark: pgfId-745647]Yes

  
         		[bookmark: pgfId-745649]No

  
         		[bookmark: pgfId-745651]No

  
         		[bookmark: pgfId-745653]No

  
         		[bookmark: pgfId-745655]No

  
         		[bookmark: pgfId-745657]No

  
        

 
         
         		 [bookmark: pgfId-745677]Accounting of...

  
        

 
         
         		[bookmark: pgfId-745713]VPN connections

  
         		[bookmark: pgfId-745715]No

  
         		[bookmark: pgfId-745717]Yes

  
         		[bookmark: pgfId-745719]Yes

  
         		[bookmark: pgfId-745721]No

  
         		[bookmark: pgfId-745723]No

  
         		[bookmark: pgfId-745725]No

  
         		[bookmark: pgfId-745727]No

  
         		[bookmark: pgfId-745729]No

  
        

 
         
         		[bookmark: pgfId-745749]Firewall sessions

  
         		[bookmark: pgfId-745751]No

  
         		[bookmark: pgfId-745753]Yes

  
         		[bookmark: pgfId-745755]Yes

  
         		[bookmark: pgfId-745757]No

  
         		[bookmark: pgfId-745759]No

  
         		[bookmark: pgfId-745761]No

  
         		[bookmark: pgfId-745763]No

  
         		[bookmark: pgfId-745765]No

  
        

 
         
         		[bookmark: pgfId-745785]Administrators

  
         		[bookmark: pgfId-745787]No

  
         		[bookmark: pgfId-745789]Yes

  
         		[bookmark: pgfId-745791]Yes

  
         		[bookmark: pgfId-745793]No

  
         		[bookmark: pgfId-745795]No

  
         		[bookmark: pgfId-745797]No

  
         		[bookmark: pgfId-745799]No

  
         		[bookmark: pgfId-745801]No

  
        

 
       
      

 
     
 
     [bookmark: pgfId-747431]1 HTTP Form protocol supports single sign-on authentication for WebVPN users only.

 
     [bookmark: pgfId-747433]2 For firewall sessions, RADIUS authorization is supported with user-specific ACLs only, which are received or specified in a RADIUS authentication response.

 
     [bookmark: pgfId-747435]3 Local command authorization is supported by privilege level only.

 
    
 
     
      [bookmark: pgfId-747443][bookmark: 109806][bookmark: pxchap_cncpt_LOCALDatabase]Local Database[bookmark: marker-747441]

 
     [bookmark: pgfId-747448]The security appliance maintains a Local database that you can populate with user accounts, which contain, at a minimum, a user name. Typically, you assign a password and a privilege level to each user name, although passwords are optional. You can manage Local user accounts on the Platform > Device Admin > User Accounts page (see Configuring User Accounts).

 
     [bookmark: pgfId-747450]If you enable command authorization using the Local database, the security appliance refers to the assigned user privilege level to determine what commands are available. By default, all commands are assigned either privilege level 0 or level 15.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-747452]Note If you add users to the Local database with access to the CLI and whom you do not want to enter privileged mode, you should enable command authorization. Without command authorization, users can access privileged mode (and all commands) at the CLI using their own password if their privilege level is 2 or greater (2 is the default). Alternatively, you can use RADIUS or TACACS+ authentication for console access so the user will not be able to use the login command, or you can set all local users to level 1 so you can control who can use the system enable password to access privileged mode.


     
      

     

     

 
     [bookmark: pgfId-747454]You cannot use the local database for network access authorization.

 
     [bookmark: pgfId-747456]The user accounts in the Local database can provide fallback support for console and enable-password authentication, for command authorization, and for VPN authentication and authorization. This behavior is designed to help you prevent accidental lock-out from the security appliance.

 
     [bookmark: pgfId-747458]For users who need fallback support, we recommend that their user names and passwords in the Local database match their user names and passwords on the AAA servers. This provides transparent fallback support. Because the user cannot determine whether a AAA server or the local database is providing the service, using user names and passwords on AAA servers that are different than the user names and passwords in the Local database means that the user cannot be certain which user name and password should be given.

 
     [bookmark: pgfId-747460]For multiple-context mode, you can configure user names in the system execution space to provide individual logins at the CLI using the login command; however, you cannot configure any aaa commands that use the local database in the system execution space.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-747462]Note VPN functions are not supported in multiple mode.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-747472][bookmark: 109824][bookmark: pxchap_cncpt_AAAforDeviceAdministration]AAA for Device Administration[bookmark: marker-747468][bookmark: marker-747470]

 
     [bookmark: pgfId-747474]You can authenticate all administrative connections to the security appliance, including:

 
      
      		 [bookmark: pgfId-747476]Telnet

 
      		 [bookmark: pgfId-747478]SSH

 
      		 [bookmark: pgfId-747480]Serial console

 
      		 [bookmark: pgfId-747482]ASDM

 
      		 [bookmark: pgfId-747484]VPN management access

 
     

 
     [bookmark: pgfId-747486]You can also authenticate administrators who attempt to enter enable mode. You can authorize administrative commands. You can have accounting data for administrative sessions and for commands issued during a session sent to an accounting server.

 
     [bookmark: pgfId-747491]You can configure AAA for device administration using the Platform > Device Admin > AAA page (see About AAA on Security Devices).

 
    
 
     
      [bookmark: pgfId-747499][bookmark: 109849][bookmark: pxchap_cncpt_AAAforNetworkAccess]AAA for Network Access[bookmark: marker-747497]

 
     [bookmark: pgfId-747504]You can configure rules for authenticating, authorizing, and accounting for traffic passing through the firewall by using the Firewall > AAA Rules page (see Chapter 15, “Managing Firewall AAA Rules”). The rules you create are similar to access rules, except that they specify whether to authenticate, authorize, or perform accounting for the traffic defined; and which AAA server group the security appliance is to use to process the AAA service request.

 
    
 
     
      [bookmark: pgfId-747514][bookmark: 109858][bookmark: pxchap_cncpt_AAAforVPNAccess]AAA for VPN Access[bookmark: marker-747510][bookmark: marker-747512]

 
     [bookmark: pgfId-747516]AAA services for VPN access include the following:

 
      
      		 [bookmark: pgfId-747521]User account settings for assigning users to VPN groups, configured on the  Platform > Device Admin > User Accounts page (see Configuring User Accounts).

 
      		 [bookmark: pgfId-747523]VPN group policies that can be referenced by many user accounts or tunnel groups, configured on the  Remote Access VPN > RA VPN Policies > User Group Policy or  Site to Site VPN > User Group Policy page.

 
      		 [bookmark: pgfId-747525]Tunnel group policies, configured on the  Remote Access VPN > RA VPN Policies > PIX7.0/ASA Tunnel Group Policy or  Site to Site VPN > PIX7.0/ASA Tunnel Group Policy page.

 
     

 
    
 
     
      [bookmark: pgfId-747541][bookmark: 109882][bookmark: pxpage_cncpt_AAAPage]Configuring AAA - Authentication Tab[bookmark: marker-747533][bookmark: marker-747535][bookmark: marker-747537][bookmark: marker-747539]

 
     [bookmark: pgfId-747543]The AAA page presents three tabbed panels; the Authentication panel is presented when you navigate to the AAA page. Use these options to control privileged access to the device console, to restrict access by connection type, and to define access messages.

 
     [bookmark: pgfId-747548]Use the Authorization Tab to control the services and commands available to authenticated users.

 
     [bookmark: pgfId-747553]Use the Accounting Tab to activate tracking of console traffic, providing a record of user activity.

 
     [bookmark: pgfId-747555]Navigation Path

 
      
      		 [bookmark: pgfId-747557](Device view) Select  Platform > Device Admin > AAA from the Device Policy selector.

 
      		 [bookmark: pgfId-747559](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > AAA from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
     

 
     [bookmark: pgfId-747561]Related Topics

 
      
      		 [bookmark: pgfId-747566]About AAA on Security Devices

 
      		 [bookmark: pgfId-747571]Configuring User Accounts

 
     

 
     [bookmark: pgfId-747573]Using the Authentication Tab

 
     [bookmark: pgfId-747575]Use the Authentication tab to enable authentication for administrator access to the security appliance. The Authentication tab also lets you configure the prompts and messages a user sees when authenticated by an AAA server.

 
     [bookmark: pgfId-747577]The device will prompt for a user name and password before you can enter commands. If the authentication server is offline, wait until the console login request times out. You can then access the console with the firewall username and the enable password.

 
     [bookmark: pgfId-747579]Field Reference

 
     [bookmark: pgfId-747582] 

 
      
       
        
        [bookmark: pgfId-745814]Table 48-2 [bookmark: 109930]Authentication Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-745820]Element
          
  
         		
           
           [bookmark: pgfId-745822]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-745828]Require AAA Authentication to allow use of privileged commands
          
  
        

 
         
         		[bookmark: pgfId-745836]Enable

  
         		[bookmark: pgfId-745838]Requires authentication from an AAA server to allow a user to access EXEC mode on the firewall. This option allows up to three attempts to access the firewall console. If this number is exceeded, an “access denied” message is displayed.

 [bookmark: pgfId-745840]When checked, the Server Group field is enabled.

  
        

 
         
         		[bookmark: pgfId-745846]Server Group

  
         		[bookmark: pgfId-745848]Enter or Select the name of an AAA server to contact for user authentication.

  
        

 
         
         		[bookmark: pgfId-745854]Use LOCAL when server group fails

  
         		[bookmark: pgfId-745856]Check this box to use the LOCAL database as back-up if the selected server fails. (This option is not enabled until you provide a Server Group.)

  
        

 
         
         		 
           
           [bookmark: pgfId-745862]Require AAA Authentication for the following types of connections
          
  
        

 
         
         		 [bookmark: pgfId-745870]Select the connections that require authentication. For each type, users are allowed up to three attempts to access the firewall console. If this number is exceeded, an “access denied” message is displayed.

 [bookmark: pgfId-745872]Select each connection option individually:

 
           
           		 [bookmark: pgfId-745874] HTTP – Require AAA authentication when a user initiates an HTTPS connection to the firewall console.

 
           		 [bookmark: pgfId-745876] Serial – Require AAA authentication when a user initiates a connection to the firewall console via the serial console cable.

 
           		 [bookmark: pgfId-745878] SSH – Require AAA authentication when a user initiates a Secure Shell (SSH) connection to the console.

 
           		 [bookmark: pgfId-745880] Telnet – Require AAA authentication when a user initiates a Telnet connection to the firewall console.

 
          

 [bookmark: pgfId-745882]For each selected connection, provide a Server Group and indicate whether the LOCAL database is used as a back-up:

 
           
           		 [bookmark: pgfId-745884] Server Group – Enter or Select the name of an AAA server to contact for user authentication.

 
           		 [bookmark: pgfId-745886] Use LOCAL when server group fails – Check this box to use the LOCAL database as back-up if the selected server fails. (This option is not enabled until you provide a Server Group.)

 
          

  
        

 
         
         		 
           
           [bookmark: pgfId-745894]Authentication Prompts
          
  
        

 
         
         		[bookmark: pgfId-745902]Login Prompt

  
         		[bookmark: pgfId-745904]Enter the prompt a user will see when logging in to the security appliance.

  
        

 
         
         		[bookmark: pgfId-745910]Accepted Message

  
         		[bookmark: pgfId-745912]Enter the message displayed when successfully authenticated.

  
        

 
         
         		[bookmark: pgfId-745918]Rejected Message

  
         		[bookmark: pgfId-745920]Enter the message displayed when authentication fails for any reason.

  
        

 
         
         		[bookmark: pgfId-745926]Rejected Message for Invalid Credentials

  
         		[bookmark: pgfId-745928]Enter the message displayed when authentication fails following entry of unknown or invalid credentials.

 [bookmark: pgfId-745930]Available only on FWSM 3.2+ devices.

  
        

 
         
         		[bookmark: pgfId-745936]Rejected Message for Expired Password

  
         		[bookmark: pgfId-745938]Enter the message displayed when authentication fails following entry of an expired password.

 [bookmark: pgfId-745940]Available only on FWSM 3.2+ devices.

  
        

 
         
         		[bookmark: pgfId-745946]Maximum Local Authentication Failed Attempts

  
         		[bookmark: pgfId-745948]Specify the number of times the device will try to authenticate a user in the LOCAL database before that account is locked; valid values are 1 through 16.

 [bookmark: pgfId-745950]Available only on ASA/PIX 7.01+ and FWSM 3.11+ devices.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-747592][bookmark: 110030][bookmark: pxpage_cncpt_AuthorizationTab]Authorization Tab[bookmark: marker-747588][bookmark: marker-747590]

 
     [bookmark: pgfId-747594]The Authorization tab allows you to configure authorization for accessing firewall commands.

 
     [bookmark: pgfId-747596]Navigation Path

 
     [bookmark: pgfId-747601]You can access the Authorization tab from the AAA page; see Configuring AAA - Authentication Tab.

 
     [bookmark: pgfId-747603]Related Topics

 
      
      		 [bookmark: pgfId-747608]About AAA on Security Devices

 
      		 [bookmark: pgfId-747613]Accounting Tab

 
     

 
     [bookmark: pgfId-747615]Field Reference

 
     [bookmark: pgfId-747618] 

 
      
       
        
        [bookmark: pgfId-745963]Table 48-3 [bookmark: 110057]Authorization Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-745969]Element
          
  
         		
           
           [bookmark: pgfId-745971]Description
          
  
        

 
         
         		[bookmark: pgfId-745977]Enable Authorization for Command Access

 [bookmark: pgfId-745979]Server Group

 [bookmark: pgfId-745981]Use LOCAL when server group fails

  
         		[bookmark: pgfId-745983]Requires authorization for accessing firewall commands.

 [bookmark: pgfId-745985]Specify the server group to use for authorization.

 [bookmark: pgfId-745987]Uses the LOCAL server group if the selected server group fails.

  
        

 
         
         		[bookmark: pgfId-745993]Enable Authorization for exec shell access

 [bookmark: pgfId-745995](ASA 8.0(2)+ only)

  
         		[bookmark: pgfId-745997]When selected, enables management authorization.

 [bookmark: pgfId-745999]After enabling management authorization, specify whether to use the remote server or the local database for authorization:

 
           
           		 [bookmark: pgfId-746001] Local Server —the local user database is the source for the username entered and the Service-Type and Privilege-Level attributes assigned.

 
           		 [bookmark: pgfId-746003] Remote Server —the same server is used for both authentication and authorization.

 
          

  
        

 
         
         		[bookmark: pgfId-746009]Auto Enable Authorization for exec shell access

 [bookmark: pgfId-746011](ASA 9.1(5)+ only)

  
         		[bookmark: pgfId-746013]Allows users with sufficient privileges from the login authentication server to be placed directly in privileged EXEC mode. Otherwise, users are placed in user EXEC mode. These privileges are determined by the Service-Type and Privilege-Level attributes that are required to enter each EXEC mode. To enter privileged EXEC mode, users must have a Service-Type attribute of Administrative and a Privilege Level attribute of greater than 1 assigned to them.

 [bookmark: pgfId-746015]This option is not supported in the system context. However, if you configure Telnet or serial authentication in the admin context, then authentication also applies to sessions from the switch to the ASASM.

  
        

 
         
         		[bookmark: pgfId-746021]Enable Authorization for HTTP Connection

 [bookmark: pgfId-746023]Server Group

 [bookmark: pgfId-746025]Use LOCAL when server group fails

 [bookmark: pgfId-746027](ASA 9.4(1)+ only)

  
         		[bookmark: pgfId-746029]When selected, authorization via HTTP is enabled. Authorization of username is disabled by default.

 [bookmark: pgfId-746031]Select the server group to use for authorization.

 [bookmark: pgfId-746033]Uses the LOCAL server group if the selected server group fails.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-747630][bookmark: 110108][bookmark: pxpage_cncpt_AccountingTab]Accounting Tab[bookmark: marker-747626][bookmark: marker-747628]

 
     [bookmark: pgfId-747632]Use the Accounting tab to enable accounting for access to the firewall device and for access to commands on the device.

 
     [bookmark: pgfId-747634]Navigation Path

 
     [bookmark: pgfId-747639]You can access the Accounting tab from the AAA page; see Configuring AAA - Authentication Tab.

 
     [bookmark: pgfId-747641]Related Topics

 
      
      		 [bookmark: pgfId-747646]About AAA on Security Devices

 
      		 [bookmark: pgfId-747651]Authorization Tab

 
     

 
     [bookmark: pgfId-747653]Field Reference

 
     [bookmark: pgfId-747656] 

 
      
       
        
        [bookmark: pgfId-746046]Table 48-4 [bookmark: 110136]Accounting Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-746052]Element
          
  
         		
           
           [bookmark: pgfId-746054]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-746060]Require AAA Accounting for privileged commands
          
  
        

 
         
         		[bookmark: pgfId-746068]Enable

  
         		[bookmark: pgfId-746070]When selected, enables the generation of accounting records to mark the entry to and exit from privileged mode for administrative access via the console.

  
        

 
         
         		[bookmark: pgfId-746076]Server Group

  
         		[bookmark: pgfId-746078]Specify the server or group of RADIUS or TACACS+ servers to which accounting records are sent.

  
        

 
         
         		 
           
           [bookmark: pgfId-746084]Require AAA Accounting for the following types of connections
          
  
        

 
         
         		[bookmark: pgfId-746092]Connection type

  
         		[bookmark: pgfId-746094]Specify the connection types that will generate accounting records:

 
           
           		 [bookmark: pgfId-746096] HTTP —Enable or disable the generation of accounting records to mark the establishment and termination of admin sessions created over HTTP. Valid server group protocols are RADIUS and TACACS+.

 
           		 [bookmark: pgfId-746098] Serial —Enable or disable the generation of accounting records to mark the establishment and termination of admin sessions that are established via the serial interface to the console. Valid server group protocols are RADIUS and TACACS+.

 
           		 [bookmark: pgfId-746100] SSH —Enable or disable the generation of accounting records to mark the establishment and termination of admin sessions created over SSH. Valid server group protocols are RADIUS and TACACS+.

 
           		 [bookmark: pgfId-746102] Telnet —Enable or disable the generation of accounting records to mark the establishment and termination of admin sessions created over Telnet. Valid server group protocols are RADIUS and TACACS+.

 
          

  
        

 
         
         		[bookmark: pgfId-746108]Server Group

  
         		[bookmark: pgfId-746110]Specify the server or group of RADIUS or TACACS+ servers to which accounting records are sent.

  
        

 
         
         		 
           
           [bookmark: pgfId-746116]Require Accounting for command access
          
  
        

 
         
         		[bookmark: pgfId-746124]Enable

  
         		[bookmark: pgfId-746126]When selected, enables the generation of accounting records for commands entered by an administrator/user.

  
        

 
         
         		[bookmark: pgfId-746132]Server Group

  
         		[bookmark: pgfId-746134]Provides a drop-down menu from which you can choose the server or group of RADIUS or TACACS+ servers to which accounting records are sent.

  
        

 
         
         		[bookmark: pgfId-746140]Privilege Level

  
         		[bookmark: pgfId-746142]Minimum privilege level that must be associated with a command for an accounting record to be generated. The default privilege level is 0.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-747668][bookmark: 110212][bookmark: pxchap_proc_ConfiguringBanners]Configuring Banners [bookmark: marker-747664][bookmark: marker-747666]

 
    [bookmark: pgfId-747670]You can use the Banner page to specify Session (exec), Login, and Message-of-the-Day (motd) banners for a security appliance or shared policy.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-747672]Note If you use the token $(hostname) or $(domain) in a banner, it is replaced with the host name or domain name of the security appliance. When you enter the $(system) token in a context configuration, the context uses the banner configured in the system configuration.


    
     

    

    

 
    [bookmark: pgfId-747674]Spaces in banner text are preserved; however, tabs cannot be entered. Multiple lines in a banner are created by entering a separate line of text for each line you wish to add. Each line is then appended to the end of the existing banner. If the line is empty, a carriage return (CR) is added to the banner.

 
    [bookmark: pgfId-747676]There is no limit on the length of a banner other than RAM and flash-memory limits. You can only use ASCII characters, including new-line (press the Enter key), which counts as two characters. When accessing the security appliance through Telnet or SSH, the session closes if there is not enough system memory available to process the banner messages, or if a TCP write error occurs when attempting to display the banner messages.

 
    [bookmark: pgfId-747678]Related Topics

 
     
     		 [bookmark: pgfId-747683]Chapter 52, “Configuring Server Access Settings on Firewall Devices”

 
    

 
    
 
    [bookmark: pgfId-747685]Step 1 To configure banners, access the Banner page:

 
     
     		 [bookmark: pgfId-747687](Device view) Select  Platform > Device Admin > Banner from the Device Policy selector.

 
     		 [bookmark: pgfId-747689](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Banner from the Policy Types selector. Select an existing policy from the Policies selector, or create a new one.

 
    

 
    [bookmark: pgfId-747691]Step 2 In the Session (exec) Banner field, enter the text you want the system to display as a banner before displaying the enable prompt.

 
    [bookmark: pgfId-747693]Step 3 In the Login Banner field, enter the text you want the system to display as a banner before the password login prompt when accessing the security appliance using Telnet.

 
    [bookmark: pgfId-747695]Step 4 In the Message-of-the-Day (motd) Banner field, enter the text you want the system to display as a message-of-the-day banner.

 
    [bookmark: pgfId-747697]Step 5 To replace a banner, change the contents of the appropriate box.

 
    [bookmark: pgfId-747699]Step 6 To remove a banner, clear the contents of the appropriate box.

 
    [bookmark: pgfId-747701]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-747713][bookmark: 110260][bookmark: pxpage_cncpt_BootImageConfigurationPage]Configuring Boot Image/Configuration Settings [bookmark: marker-747709][bookmark: marker-747711]

 
    [bookmark: pgfId-747715]Use the Boot Image/Configuration page to specify which configuration file the security appliance will use at start-up. You can also specify the path to an Adaptive Security Device Manager (ASDM) configuration file.

 
    [bookmark: pgfId-747717]If you do not specify a boot-image location, the first valid image on internal flash memory will be chosen to launch the system.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-747719]Note This page is available only on ASA and PIX 7.0+ devices


    
     

    

    

 
    [bookmark: pgfId-747721]Navigation Path

 
     
     		 [bookmark: pgfId-747723](Device view) Select  Platform > Device Admin > Boot Image/Configuration from the Device Policy selector.

 
     		 [bookmark: pgfId-747725](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Boot Image/Configuration from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-747727]Field Reference

 
    [bookmark: pgfId-747730] 

 
     
      
       
       [bookmark: pgfId-746155]Table 48-5 [bookmark: 110284]Boot Image/Configuration Page 

 
       
      
        
        		
          
          [bookmark: pgfId-746161]Element
         
  
        		
          
          [bookmark: pgfId-746163]Description
         
  
       

 
        
        		[bookmark: pgfId-746169]Boot Config Location

  
        		[bookmark: pgfId-746171]Enter the path to and name of the configuration file to be used when the system is loaded. On an ASA, you can use any of the following syntactical constructs:

 
          
          		 [bookmark: pgfId-746173] disk0:/ [ path/ ] filename 

 
         

 [bookmark: pgfId-746175]The value “disk0” represents the internal flash card. You can also use “flash” instead of “disk0,” as they are aliased:

 [bookmark: pgfId-746177] – flash:/[path/]filename

 
          
          		 [bookmark: pgfId-746179] disk1: /[ path/ ] filename 

 
         

 [bookmark: pgfId-746181]The value “disk1” represents the external flash card.

 [bookmark: pgfId-746183]On a PIX device, you can use only the “flash” syntax; that is:

 
          
          		 [bookmark: pgfId-746185] flash:/ [ path/ ] filename 

 
         

  
       

 
        
        		[bookmark: pgfId-746191]ASDM Image Location

  
        		[bookmark: pgfId-746193]The location and name of the ASDM software image to be used when ASDM sessions are initiated. (You can use ASDM to monitor both ASA and PIX devices.)

 [bookmark: pgfId-746195]On a PIX device, as with the Boot Config Location, you are restricted to only the “flash” syntax.

 [bookmark: pgfId-746197]On an ASA, as with the Boot Config Location, you can use the “disk0,” “flash,” or “disk1” constructs. In addition, you can specify an image file on a TFTP server, as follows

 
          
          		 [bookmark: pgfId-746199] tftp:// [ user [ :password ]@] server [ :port ]/[ path/ ] filename 

 
         

  
       

 
        
        		[bookmark: pgfId-746205]Boot Images Table

  
        		[bookmark: pgfId-746207]This table lists any alternate configuration files you have defined; you can specify up to four. The first available image in this list is used if you did not specify a primary file in the Boot Config Location field, or if that file is unavailable.

 [bookmark: pgfId-746212]This is a standard Security Manager table; use the up-arrow, down-arrow, Add Row, Edit Row, and Delete Row buttons below the table to manage these entries, as described in Using Tables.

 [bookmark: pgfId-746217]The Add Row and Edit Row open the Images Dialog Box, used to add and edit the paths to alternate configuration files.

 [bookmark: pgfId-746219]Note On an ASA, the first (and only the first) entry in this table can refer to an ASDM configuration file on a TFTP server. If the device cannot reach the TFTP server, it will attempt to load the next image file in the list.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-747742][bookmark: 110354][bookmark: pxpage_cncpt_ImagesDialogBox]Images Dialog Box[bookmark: marker-747738][bookmark: marker-747740]

 
     [bookmark: pgfId-747744]Use the Images dialog box to add or edit a configuration file entry in the Boot Images table on the Boot Image/Configuration page.

 
     [bookmark: pgfId-747746]Navigation Path

 
     [bookmark: pgfId-747751]You can access the Images dialog box from the Boot Image/Configuration page. For more information, see Configuring Boot Image/Configuration Settings.

 
     [bookmark: pgfId-747753]Field Reference

 
     [bookmark: pgfId-747755]The Images dialog box contains one field, used to define the path to a boot image or configuration file, as follows:

 
     [bookmark: pgfId-747758] 

 
      
       
        
        [bookmark: pgfId-746232]Table 48-6 [bookmark: 110374]Images Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-746238]Element
          
  
         		
           
           [bookmark: pgfId-746240]Description
          
  
        

 
         
         		[bookmark: pgfId-746246]Image File

  
         		[bookmark: pgfId-746248]Enter the path to and name of the configuration file to add to the ordered Boot Images list.

 [bookmark: pgfId-746250]On a PIX device, you can use only the “flash” syntax; that is:

 
           
           		 [bookmark: pgfId-746252] flash:/ [ path/ ] filename 

 
          

 [bookmark: pgfId-746254]On an ASA, you can use any of the following syntactical constructs:

 
           
           		 [bookmark: pgfId-746256] disk0:/ [ path/ ] filename 

 
          

 [bookmark: pgfId-746258]The value “disk0” represents the internal flash card. You can also use “flash” instead of “disk0,” as they are aliased:

 [bookmark: pgfId-746260] – flash:/[path/]filename

 
           
           		 [bookmark: pgfId-746262] disk1: /[ path/ ] filename 

 
          

 [bookmark: pgfId-746264]The value “disk1” represents the external flash card.

 [bookmark: pgfId-746266]In addition, on an ASA, you can specify an ASDM image file on a TFTP server, as follows

 
           
           		 [bookmark: pgfId-746268] tftp:// [ user [ :password ]@] server [ :port ]/[ path/ ] filename 

 
          

 [bookmark: pgfId-746270]Note that you can specify only one TFTP location, and it must be listed first in the Boot Images table on the Boot Image/Configuration page.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-747772][bookmark: 110432][bookmark: pxchap_proc_ConfiguringCliPrompt]Configuring CLI Prompt[bookmark: marker-747766][bookmark: marker-747768][bookmark: marker-747770]

 
    [bookmark: pgfId-747774]You can use the CLI Prompt page to customize the prompt used by ASA 7.2(1)+ devices during CLI sessions. By default, the prompt shows the hostname of the ASA. In multiple context mode, the prompt also displays the context name. You can display the following items in the CLI prompt:

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-747777]Note The attributes that are available differ by ASA version:


    
     

    

    

 
     
      
      
        
        		[bookmark: pgfId-746277]cluster-unit

 [bookmark: pgfId-746279](ASA 9.1.1+ only)

  
        		[bookmark: pgfId-746281]Displays the cluster unit name. Each unit in a cluster can have a unique name.

  
       

 
        
        		
          
          [bookmark: pgfId-746287]context
         
  
        		[bookmark: pgfId-746289](Multiple mode only) Displays the name of the current context.

  
       

 
        
        		
          
          [bookmark: pgfId-746295]domain
         
  
        		[bookmark: pgfId-746297]Displays the domain name.

  
       

 
        
        		
          
          [bookmark: pgfId-746303]hostname
         
  
        		[bookmark: pgfId-746305]Displays the hostname.

  
       

 
        
        		[bookmark: pgfId-746311]management-mode

 [bookmark: pgfId-746313](ASA 9.2.1+ only)

  
        		[bookmark: pgfId-746315]Displays the management mode.

  
       

 
        
        		
          
          [bookmark: pgfId-746321]priority
         
  
        		[bookmark: pgfId-746323]Displays the failover priority as pri (primary) or sec (secondary).

  
       

 
        
        		
          
          [bookmark: pgfId-746329]state
         
  
        		[bookmark: pgfId-746331]Displays the traffic-passing state or role of the unit.

 [bookmark: pgfId-746333]For failover, the following values appear for the state:

 
          
          		 [bookmark: pgfId-746335]act—Failover is enabled, and the unit is actively passing traffic.

 
          		 [bookmark: pgfId-746337]stby— Failover is enabled, and the unit is not passing traffic and is in a standby, failed, or another inactive state.

 
          		 [bookmark: pgfId-746339]actNoFailover—Failover is not enabled, and the unit is actively passing traffic.

 
          		 [bookmark: pgfId-746341]stbyNoFailover—Failover is not enabled, and the unit is not passing traffic. This condition might occur when there is an interface failure above the threshold on the standby unit.

 
         

 [bookmark: pgfId-746343]For clustering, the following values are displayed for state:

 
          
          		 [bookmark: pgfId-746345]master

 
          		 [bookmark: pgfId-746347]slave

 
         

 [bookmark: pgfId-746349]For example, in the prompt ciscoasa/cl2/slave, the hostname is ciscoasa, the unit name is cl2, and the state is slave.

  
       

 
      
     

 
    
 
    
 
    [bookmark: pgfId-747779]Step 1 Access the CLI Prompt page by doing one of the following:

 
     
     		 [bookmark: pgfId-747781](Device view) Select  Platform > Device Admin > CLI Prompt from the Device Policy selector.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-747783]Note For devices in multiple context mode, the CLI Prompt page is only available in the system context. In the admin context, the CLI Prompt page is not available.


    
     

    

    

 
     
     		 [bookmark: pgfId-747785](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > CLI Prompt from the Policy Types selector. Select an existing policy from the Policies selector, or create a new one.

 
    

 
    [bookmark: pgfId-747787]Step 2 Customize the CLI prompt by doing the following:

 
     
     		 [bookmark: pgfId-747789]To add an attribute to the prompt, select the attribute in the Available Members list and then click  >> . The attribute is moved from the Available Members list to the Selected Members list.

 
    

 
    [bookmark: pgfId-747791]You can add multiple attributes to the prompt. The order in which the attributes are added to the Selected Members list will dictate the order in which they are shown in the CLI prompt.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-747793]Note For ASA 9.1.1+, you can configure up to six attributes for the CLI prompt. For earlier ASA versions, you can only configure up to five attributes.


    
     

    

    

 
     
     		 [bookmark: pgfId-747795]To remove an attribute from the prompt, select the attribute in the Selected Members list and then click  << . The attribute is moved from the Selected Members list to the Available Members list.

 
    

 
    [bookmark: pgfId-747797]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-747809][bookmark: 110536][bookmark: pxpage_cncpt_ClockPage]Setting the Device Clock [bookmark: marker-747805][bookmark: marker-747807]

 
    [bookmark: pgfId-747811]Use the Clock page to set the date and time on the selected device.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-747813]Note This page is not available on Catalyst 6500 service modules (the Firewall Services Module and the Adaptive Security Appliance Service Module).


    
     

    

    

 
    [bookmark: pgfId-747818]To dynamically set the time using an NTP server, see NTP Page; time derived from an NTP server overrides any time set manually on the Clock page.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-747820]Note In multiple-context mode, set the time in the system context only.


    
     

    

    

 
    [bookmark: pgfId-747822]Navigation Path

 
     
     		 [bookmark: pgfId-747824](Device view) Select  Platform > Device Admin > Clock from the Device Policy selector.

 
     		 [bookmark: pgfId-747826](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Clock from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-747828]Field Reference

 
    [bookmark: pgfId-747831] 

 
     
      
       
       [bookmark: pgfId-746362]Table 48-7 [bookmark: 110562]Clock Page 

 
       
      
        
        		
          
          [bookmark: pgfId-746368]Element
         
  
        		
          
          [bookmark: pgfId-746370]Description
         
  
       

 
        
        		[bookmark: pgfId-746376]Device Time Zone

  
        		[bookmark: pgfId-746378]Choose a time zone for the device. These options represent Greenwich Mean Time (GMT) plus or minus a number of hours.

 [bookmark: pgfId-746380]Note Changing the time zone on the device may drop the connection to any installed Security Services modules (SSMs).

  
       

 
        
        		[bookmark: pgfId-746386]Daylight Savings Time (Summer Time)

  
        		[bookmark: pgfId-746388]Choose a daylight savings time option, and if necessary, specify when and how daylight savings time is applied:

 [bookmark: pgfId-746390]None – Choose this option to disable automatic correction for daylight savings time.

 [bookmark: pgfId-746392]Set by Date – Choose this option to specify the date and time when daylight savings time begins and ends for a specific year. If you use this option, you will need to reset the dates every year.

 [bookmark: pgfId-746394]Set by Day – Choose this option to specify the start and end dates for daylight saving time using the month, week, and day on which daylight savings time begins and ends. This option also lets you set a recurring date range that you do not need to alter yearly.

  
       

 
        
        		 [bookmark: pgfId-746400]Set by Date

 [bookmark: pgfId-746402]The following three parameters appear in a Start section and an End section. Use the two sets to define when daylight savings time starts and ends.

  
       

 
        
        		[bookmark: pgfId-746410]Date

  
        		[bookmark: pgfId-746412]Enter the date on which daylight savings time begins or ends, in MMM DD YYYY format (for example, Jul 15 2011). You also can click the calendar icon to select the date from a pop-up calendar.

  
       

 
        
        		[bookmark: pgfId-746418]Hour

  
        		[bookmark: pgfId-746420]Choose the hour, from 00 to 23, in which daylight savings time begins or ends.

  
       

 
        
        		[bookmark: pgfId-746426]Minute

  
        		[bookmark: pgfId-746428]Choose the minute, from 00 to 59, at which daylight savings time begins or ends.

  
       

 
        
        		 
          
          [bookmark: pgfId-746434]Set by Day
         
  
       

 
        
        		[bookmark: pgfId-746442]Specify Recurring Time

  
        		[bookmark: pgfId-746444]Check this box to enable the Start and End parameters, which are used to set a recurring start and end for daylight savings time that you do not need to alter yearly.

  
       

 
        
        		 [bookmark: pgfId-746450]The following five parameters appear in a Start section and an End section. Use the two sets to define when daylight savings time starts and ends.

  
       

 
        
        		[bookmark: pgfId-746458]Month

  
        		[bookmark: pgfId-746460]Choose the month in which daylight savings time begins or ends.

  
       

 
        
        		[bookmark: pgfId-746466]Week

  
        		[bookmark: pgfId-746468]Choose the week of the month in which daylight savings time begins or ends. You can select a numerical value that corresponds to the week—1 through 4—or you can specify the first or last week in the month by choosing first or last. For example, if the day might fall in the partial fifth week, choose last.

  
       

 
        
        		[bookmark: pgfId-746474]Weekday

  
        		[bookmark: pgfId-746476]Choose the day of the week on which daylight savings time begins or ends.

  
       

 
        
        		[bookmark: pgfId-746482]Hour

  
        		[bookmark: pgfId-746484]Choose the hour, from 0 to 23, in which daylight savings time begins or ends.

  
       

 
        
        		[bookmark: pgfId-746490]Minute

  
        		[bookmark: pgfId-746492]Choose the minute, from 00 to 59, at which daylight savings time begins or ends.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-747843][bookmark: 110652][bookmark: pxchap_proc_ConfiguringContactCredentials]Configuring Device Credentials [bookmark: marker-747839][bookmark: marker-747841]

 
    [bookmark: pgfId-747845]Use the Credentials page to specify the user credentials Security Manager will use when contacting this device. You can also change the Enable password and the Telnet/SSH password on the device.

 
    [bookmark: pgfId-747850]This user name-password combination lets you log into the device (in EXEC mode) if you connect to the security appliance using an HTTP, HTTPS, Telnet, or SSH session. You also can specify a separate password specifically for Telnet and SSH sessions. (Further, you can define separate credentials for HTTP/HTTPS connections on the Device Credentials Page in the Device Properties window.)

 
    [bookmark: pgfId-747852]The Enable password lets you access privileged EXEC mode after you log in.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-747857]Tip The Username, Password, and Enable Password on this page are linked to the Credentials settings in the Device Properties window. When you update these parameters and then deploy the changes to the device, Security Manager uses the existing credentials defined in the Device Properties to log into the device and deploy changes. After successful deployment, the Device Properties credentials are updated to match these settings. For more information about Credentials in Device Properties, see Device Credentials Page.


    
     

    

    

 
    [bookmark: pgfId-747859]Navigation Path

 
     
     		 [bookmark: pgfId-747861](Device view) Select  Platform > Device Admin > Credentials from the Device Policy selector.

 
     		 [bookmark: pgfId-747863](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Credentials from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-747865]Warning Since several user accounts may exist on each device, applying a shared Credentials policy to multiple devices will update only the Enable Password on each device; the Username and Password provided in the shared policy are not applied (nor is the Telnet/SSH password). The Enable Password is sufficient for subsequent access to PIX/ASA/FWSM devices, unless external authentication such as AAA or TACACS+ is configured, in which case the Enable Password alone is not sufficient. In this situation, you must manually update the Username, Password and Enable Password on each device that uses external authentication.


    
     

    

    

 
    [bookmark: pgfId-747867]Related Topics

 
     
     		 [bookmark: pgfId-747872]Configuring User Accounts

 
    

 
    [bookmark: pgfId-747874]Field Reference

 
    [bookmark: pgfId-747877] 

 
     
      
       
       [bookmark: pgfId-746505]Table 48-8 [bookmark: 110686]Credentials Page 

 
       
      
        
        		
          
          [bookmark: pgfId-746511]Element
         
  
        		
          
          [bookmark: pgfId-746513]Description
         
  
       

 
        
        		[bookmark: pgfId-746519]Username

  
        		[bookmark: pgfId-746521]Enter a user name for logging into the device. The name must be at least four characters; the maximum is 64 characters. Entries are case-sensitive.

  
       

 
        
        		[bookmark: pgfId-746527]Password

 [bookmark: pgfId-746529]Confirm

  
        		[bookmark: pgfId-746531]Provide a password for logging into the device (EXEC mode) with the specified Username. This password must be at least three characters; the maximum is 32 characters. Entries are case-sensitive.

 [bookmark: pgfId-746533]Re-enter the user password in the Confirm field.

 [bookmark: pgfId-746535]Note We recommend a password length of at least 8 characters.

  
       

 
        
        		[bookmark: pgfId-746541]Privilege Level

  
        		[bookmark: pgfId-746543]Choose a privilege level for this user; available values are 1 through 15. Level 1 allows EXEC-mode access only, the default level for log-in; level 15 allows Privileged EXEC-mode access; that is, access to the Enable mode. Other levels must be explicitly defined on the device.

  
       

 
        
        		[bookmark: pgfId-746549]Enable Password

 [bookmark: pgfId-746551]Confirm

  
        		[bookmark: pgfId-746553]You can specify an Enable password that lets this user access Privileged EXEC mode after logging in. This password must be at least three characters; the maximum is 32 characters. Entries are case-sensitive.

 [bookmark: pgfId-746555]Re-enter the Enable password in the Confirm field.

 [bookmark: pgfId-746560]Note If you configure user authentication for Enable access, each user has their own password and this password is not used. See Configuring AAA - Authentication Tab for more information.

  
       

 
        
        		[bookmark: pgfId-746566]Telnet/SSH Password

 [bookmark: pgfId-746568]Confirm

  
        		[bookmark: pgfId-746570]You can specify a password that provides access to EXEC mode when connecting to the device via a Telnet or SSH session. This password must be at least three characters; the maximum is 32 characters. Entries are case-sensitive.

 [bookmark: pgfId-746572]Re-enter the Telnet/SSH password in the Confirm field.

 [bookmark: pgfId-746577]Note If you configure user authentication for Telnet or SSH access, each user has their own password and this password is not used. See Configuring AAA - Authentication Tab for more information.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-747889][bookmark: 110733][bookmark: pxpage_cncpt_MountPointPage]Managing Mount Points[bookmark: marker-747885][bookmark: marker-747887]

 
    [bookmark: pgfId-747891]Use the Mount Points page to make a Common Internet File System (CIFS) or a File Transfer Protocol (FTP) file system accessible to the security appliance.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-747893]Note When you create an FTP-type mount point, the FTP server must have a UNIX directory listing style. Microsoft FTP servers have the MS-DOS directory listing style as their default.


    
     

    

    

 
    [bookmark: pgfId-747901]The File Mount Point Configuration table lists the configured mount points. The File Mount Point Configuration table is a standard Security Manager table, with Add Row, Edit Row and Delete Row buttons. (These are standard buttons, as described in Using Tables.) The Add Row button opens the Add Mount Point Configuration dialog box, and Edit Row opens the Edit Mount Point Configuration dialog box. Other than the titles, the two dialog boxes are identical. For more information, see Add/Edit Mount Point Configuration Dialog Box.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-747903]Note This feature is available only on ASA 8.0(2)+ devices. Mount points are supported in router mode only. For ASA versions between 8.0(2) and 9.x, mount points are not supported in multiple-context mode. Mount points are supported in the Admin context on ASA 9.x+ devices in multiple-context, routed mode.


    
     

    

    

 
    [bookmark: pgfId-747905]Navigation Path

 
     
     		 [bookmark: pgfId-747907](Device view) Select  Platform > Device Admin > Mount Points from the Device Policy selector.

 
     		 [bookmark: pgfId-747909](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Mount Points from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
     
      [bookmark: pgfId-747921][bookmark: 110757][bookmark: pxpage_cncpt_AddEditMountPointDialogBox]Add/Edit Mount Point Configuration Dialog Box[bookmark: marker-747917][bookmark: marker-747919]

 
     [bookmark: pgfId-747923]Use the Add/Edit Mount Point Configuration dialog box to add or edit a mount point entry in the File Mount Point Configuration table on the Mount Points page. You use mount points to make a Common Internet File System (CIFS) or a File Transfer Protocol (FTP) file system accessible to the security appliance.

 
     [bookmark: pgfId-747925]Navigation Path

 
     [bookmark: pgfId-747930]You can access the Add/Edit Mount Point Configuration dialog box from the Mount Points page. For more information, see Managing Mount Points.

 
     [bookmark: pgfId-747932]Field Reference

 
     [bookmark: pgfId-747935] 

 
      
       
        
        [bookmark: pgfId-746590]Table 48-9 [bookmark: 110776]Add/Edit Mount Point Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-746596]Element
          
  
         		
           
           [bookmark: pgfId-746598]Description
          
  
        

 
         
         		[bookmark: pgfId-746604]Enable Mount Point

  
         		[bookmark: pgfId-746606]Whether the file system is mounted or unmounted (available or unavailable).

  
        

 
         
         		[bookmark: pgfId-746612]Connection Type

  
         		[bookmark: pgfId-746614]Select the type of file system to mount:

 
           
           		 [bookmark: pgfId-746616] cifs —Specifies that the file system being mounted is CIFS, a file system that provides volume-mounting capabilities for CIFS-shared directories.

 
           		 [bookmark: pgfId-746618] ftp —Specifies that the file system being mounted is FTP, a Linux kernel module, enhancing the Virtual File System (VFS) with FTP volume-mounting capabilities that allow you to mount FTP-shared directories.

 
          

 [bookmark: pgfId-746620]Note When you create an FTP-type mount point, the FTP server must have a UNIX directory listing style. Microsoft FTP servers have the MS-DOS directory listing style as their default.

  
        

 
         
         		[bookmark: pgfId-746626]Mount Point Name

  
         		[bookmark: pgfId-746628]Specifies the name of the mount point. The mount point name is used when other CLI commands refer to the filesystem already mounted on the security appliance. A maximum of 31 characters are allowed for the mount point name.

  
        

 
         
         		[bookmark: pgfId-746634]Server Name/IP Address

  
         		[bookmark: pgfId-746636]Specifies the predefined name (or the IP address in dotted decimal notation) of the CIFS or FTP file-system server.

  
        

 
         
         		[bookmark: pgfId-746642]Username

  
         		[bookmark: pgfId-746644]Specifies the authorized username for file-system mounting.

  
        

 
         
         		[bookmark: pgfId-746650]Password

 [bookmark: pgfId-746652]Confirm

  
         		[bookmark: pgfId-746654]Identifies the authorized password for file-system mounting.

  
        

 
         
         		[bookmark: pgfId-746660]Encrypt Password

  
         		[bookmark: pgfId-746662]Select to indicate that the password supplied is in encrypted format.

  
        

 
         
         		[bookmark: pgfId-746668]Share Name

 [bookmark: pgfId-746670](CIFS only)

  
         		[bookmark: pgfId-746672]Explicitly identifies a specific server share (a folder) by name to access file data within a server.

  
        

 
         
         		[bookmark: pgfId-746678]Domain Name

 [bookmark: pgfId-746680](CIFS only)

  
         		[bookmark: pgfId-746682]For CIFS file systems only, this argument specifies the Windows NT domain name. A maximum of 63 characters is permitted.

  
        

 
         
         		[bookmark: pgfId-746688]Mode

 [bookmark: pgfId-746690](FTP only)

  
         		[bookmark: pgfId-746692]Identifies the FTP transfer mode as either active or passive.

  
        

 
         
         		[bookmark: pgfId-746698]Path

 [bookmark: pgfId-746700](FTP only)

  
         		[bookmark: pgfId-746702]Specifies the directory pathname to the specified FTP file-system server. Question marks and spaces are not allowed in the pathname and will be suppressed.
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     [bookmark: pgfId-390455][bookmark: 102884][bookmark: ipsvchap_cncpt_ConfiguringCollaboration]Configuring Global Correlation[bookmark: marker-390449][bookmark: marker-390451][bookmark: marker-390453]
      
      
 
     
 

 
    [bookmark: pgfId-390457]You can configure global correlation so that your sensors are aware of network devices with a reputation for malicious activity and can take action against them. Global correlation allows you to dynamically use information about malicious activity collected from networks around the globe to change the risk rating of events that have known bad devices as their source.

 
    [bookmark: pgfId-390459]To configure global correlation, your sensor must be running IPS 7.0+ software. Global correlation is not available on Cisco IOS IPS devices.

 
    [bookmark: pgfId-390461]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-390466]Understanding Global Correlation

 
     		 [bookmark: pgfId-390471]Configuring Global Correlation Inspection and Reputation

 
     		 [bookmark: pgfId-390476]Configuring Network Participation

 
    

 
   
 
    
     [bookmark: pgfId-390494][bookmark: 102899][bookmark: ipsvchap_cncpt_ExplainingGlobalCorrelation]Understanding Global Correlation[bookmark: marker-390482][bookmark: marker-390484][bookmark: marker-390486][bookmark: marker-390488][bookmark: marker-390490][bookmark: marker-390492]

 
    [bookmark: pgfId-390496]You can configure global correlation so that your sensors are aware of network devices with a reputation for malicious activity and can take action against them. Participating IPS devices in a centralized Cisco threat database, the SensorBase, receive and absorb global correlation updates. The reputation data contained in the global correlation updates is factored into the analysis of network traffic, which increases IPS efficacy, because traffic is denied or allowed based on the reputation of the source IP address. The participating IPS devices send data back to the Cisco SensorBase Network, which results in a feedback loop that keeps the updates current and global.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-390503]Tip The Botnet Traffic Filter feature of adaptive security appliances (ASA) is another dynamic feature you can deploy in your network to defend against malicious activity. Configuring global correlation on IPS devices, and Botnet Traffic Filtering on ASA firewalls, can be an effective combined security implementation. For more information about Botnet Traffic Filtering, see Chapter 19, “Managing Firewall Botnet Traffic Filter Rules”.[bookmark: marker-390501]


    
     

    

    

 
    [bookmark: pgfId-390505]There are three main features of global correlation:

 
     
     		 [bookmark: pgfId-390510]Global Correlation Inspection—The IPS uses the global correlation reputation knowledge of attackers to influence alert handling and to deny actions when attackers with a bad score are seen on the sensor. For more information about reputation, see Understanding Reputation.

 
     		 [bookmark: pgfId-390512]Reputation Filtering—Applies automatic deny actions to packets from known malicious sites.

 
     		 [bookmark: pgfId-390517]Network Participation—The sensor sends alert and TCP fingerprint data to the SensorBase Network so that other users can share in the community knowledge. For more information, see Understanding Network Participation.

 
    

 
    [bookmark: pgfId-390519]Global correlation has the following goals:

 
     
     		 [bookmark: pgfId-390521]Dealing intelligently with alerts thus improving efficacy.

 
     		 [bookmark: pgfId-390523]Improving protection against known malicious sites.

 
     		 [bookmark: pgfId-390525]Sharing telemetry data with the SensorBase Network to improve visibility of alerts and sensor actions on a global scale.

 
     		 [bookmark: pgfId-390527]Simplifying configuration settings.

 
     		 [bookmark: pgfId-390529]Automatic handling of the uploads and downloads of the information.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-390537]Tip You can use Report Manager to generate reports comparing the number of alerts generated by global correlation to those generated by traditional IPS inspection. For information on the Inspection/Global Correlation report, see Understanding General IPS Reports. For information on generating reports, see Opening and Generating Reports.


    
     

    

    

 
    [bookmark: pgfId-390539]For information on how to configure global correlation, see the following topics:

 
     
     		 [bookmark: pgfId-390544]Global Correlation Requirements and Limitations

 
     		 [bookmark: pgfId-390549]Configuring Global Correlation Inspection and Reputation

 
     		 [bookmark: pgfId-390554]Configuring Network Participation

 
    

 
     
      [bookmark: pgfId-390572][bookmark: 102963][bookmark: ipsvchap_cncpt_UnderstandingReputation]Understanding Reputation[bookmark: marker-390560][bookmark: marker-390562][bookmark: marker-390564][bookmark: marker-390566][bookmark: marker-390568][bookmark: marker-390570]

 
     [bookmark: pgfId-390574]Similar to human social interaction, reputation is an opinion toward a device on the Internet. Reputation indicates the probability that a particular attacker IP address will initiate malicious behavior based on its known past activity. Reputation enables the installed base of IPS sensors to collaborate using the existing network infrastructure and identify network devices that are likely to be malicious or infected.

 
     [bookmark: pgfId-390576]By collecting data about devices and assigning reputation scores to them, the global correlation database provides important data that the IPS sensor can use to adjust the risk rating of an attack. Risk rating is the probability that a network event is malicious. Each signature has an associated risk rating. If you enable global correlation, the IPS sensor computes a score based on the reputation of an attacker and adds this score to the risk rating of the event. The updated risk rating is then used by your event action override and filter policies to help determine what actions to take for the event.

 
     [bookmark: pgfId-390578]Thus, you might have an event that is initially configured to simply produce an alert. But, if the attacker has a bad reputation, the IPS might increase the risk rating to a number high enough that it triggers an event action override rule that adds the Deny Packet Inline action. Thus, for some source devices, the event simply produces an alert, but for others, the event drops the packet in addition to producing the alert.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-390580]Tip The Produce Alert action is added to an event whenever global correlation raises the risk rating of the event, or when global correlation adds the Deny Packet Inline or Deny Attacker Inline actions.


     
      

     

     

 
     [bookmark: pgfId-390582]Because the global correlation database changes rapidly, the sensor must periodically download global correlation updates from the global correlation servers.

 
     [bookmark: pgfId-390584]Using reputation scores to adjust the risk rating of an event improves the efficacy of the sensor by improving the following metrics:

 
      
      		 [bookmark: pgfId-390586]False positives as a percentage of actionable events.

 
      		 [bookmark: pgfId-390588]False negatives as a percentage of threats that do not result in actionable events.

 
      		 [bookmark: pgfId-390590]Actionable events as a percentage of all events.

 
     

 
     [bookmark: pgfId-390592]Related Topics

 
      
      		 [bookmark: pgfId-390597]Understanding Global Correlation

 
      		 [bookmark: pgfId-390602]Understanding Network Participation

 
      		 [bookmark: pgfId-390607]Configuring Global Correlation Inspection and Reputation

 
      		 [bookmark: pgfId-390612]Configuring Network Participation

 
     

 
    
 
     
      [bookmark: pgfId-390628][bookmark: 103014][bookmark: ipsvchap_cncpt_ExplainingNetworkParticipation]Understanding Network Participation[bookmark: marker-390618][bookmark: marker-390620][bookmark: marker-390622][bookmark: marker-390624][bookmark: marker-390626]

 
     [bookmark: pgfId-390630]Network participation lets Cisco collect nearly real-time data from sensors around the world. Sensors installed at customer sites can send data to the SensorBase Network. These data feed in to the global correlation database to increase reputation fidelity. Communication between sensors and the SensorBase Network involves an HTTPS request and response over TCP/IP.

 
     [bookmark: pgfId-390632]There are three modes for Network Participation:

 
      
      		 [bookmark: pgfId-390634] Off —The Network Participation server does not collect data, track statistics, or try to contact the Cisco SensorBase network.

 
      		 [bookmark: pgfId-390636] Partial Participation —The Network Participation server collects data, tracks statistics, and communicates with the SensorBase network. Data considered to be potentially sensitive is filtered out and never sent.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-390638]Note Configuring the sensor for partial network participation limits a third party from extracting reconnaissance information about your internal network from the global correlation database.


     
      

     

     

 
      
      		 [bookmark: pgfId-390640] Full Participation —The Network Participation server collects data, tracks statistics, and communicates with the SensorBase network. All data collected is sent.

 
     

 
     [bookmark: pgfId-390642]If you select partial or full participation, you are prompted to accept a participation agreement. You must accept the agreement to participate or you cannot change the participation mode.

 
     [bookmark: pgfId-390654]The following table explains the data collected and the purpose of collecting it.[bookmark: marker-390644][bookmark: marker-390646][bookmark: marker-390648][bookmark: marker-390650][bookmark: marker-390652]

 
     [bookmark: pgfId-390657] 

 
      
       
        
        [bookmark: pgfId-389748]Table 42-1 [bookmark: 103070]Network Participation Data Sharing and Usage 

 
        
       
         
         		
           
           [bookmark: pgfId-389756]Participation Level
          
  
         		
           
           [bookmark: pgfId-389758]Type of Data
          
  
         		
           
           [bookmark: pgfId-389760]Purpose
          
  
        

 
         
         		 [bookmark: pgfId-389768]Partial

  
         		[bookmark: pgfId-389770]Protocol attributes (TCP maximum segment size and options string, for example).

  
         		[bookmark: pgfId-389772]Tracks potential threats and helps Cisco to understand threat exposure.

  
        

 
         
         		[bookmark: pgfId-389782]Attack type (signature fired, including signature ID and version, risk rating, and reputation, for example).

  
         		[bookmark: pgfId-389784]Used to understand current attacks and attack severity.

  
        

 
         
         		[bookmark: pgfId-389794]Connecting IP address and port.

  
         		[bookmark: pgfId-389796]Identifies attack source.

  
        

 
         
         		[bookmark: pgfId-389806]Summary IPS performance (CPU utilization, memory usage, inline vs promiscuous, for example).

  
         		[bookmark: pgfId-389808]Tracks product efficacy.

  
        

 
         
         		[bookmark: pgfId-389816]Full

  
         		[bookmark: pgfId-389818]Victim IP address and port.

  
         		[bookmark: pgfId-389820]Detects threat behavioral pattern.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-390662]To configure network participation, the IPS device requires at least 100 MB of available memory, a network connection to the sensor, and a network connection to the Internet. For information on configuring network participation, see Configuring Network Participation.

 
    
 
     
      [bookmark: pgfId-390680][bookmark: 103117][bookmark: ipsvchap_cncpt_GlobalCorrelationConfigurationRequirementsandLimitations]Global Correlation Requirements and Limitations[bookmark: marker-390668][bookmark: marker-390670][bookmark: marker-390672][bookmark: marker-390674][bookmark: marker-390676][bookmark: marker-390678]

 
     [bookmark: pgfId-390682]The following list explains the requirements that you must meet to configure and successfully use global correlation on IPS devices. It also explains some limitations.

 
      
      		 [bookmark: pgfId-390687] Valid license —You must have a valid sensor license for global correlation features to function. You can still configure and display statistics for the global correlation features, but the global correlation databases are cleared and no updates are attempted. Once you install a valid license, the global correlation features are reactivated. For information on configuring licenses, see Updating IPS License Files.

 
      		 [bookmark: pgfId-390695] Agree to Network Participation disclaimer —If you decide to configure network participation, you must accept the disclaimer. For more information, see Understanding Network Participation and Configuring Network Participation.

 
      		 [bookmark: pgfId-390703] External connectivity for sensor and a DNS server or HTTP proxy —Global correlation requires the sensor to connect to the Cisco SensorBase Network. Domain name resolution is also required for these features to function. You can either configure the sensor to connect through an HTTP proxy server that has a DNS client running on it, or you can assign an Internet routeable address to the management interface of the sensor and configure the sensor to use a DNS server. For more information, see Identifying DNS Servers and Identifying an HTTP Proxy Server.

 
      		 [bookmark: pgfId-390705] Sensor in inline mode —The sensor must operate in inline mode so that the global correlation features can increase efficacy by being able to use the inline deny actions.

 
      		 [bookmark: pgfId-390707] Sensor and IPS version that supports the global correlation features —The sensor must run IPS 7.0+ software. You cannot configure global correlation on Cisco IOS IPS devices.

 
      		 [bookmark: pgfId-390709] Sufficient available memory —To configure network participation, the IPS device requires at least 100 MB of available memory.

 
      		 [bookmark: pgfId-390714] Firewall access for port 80, 443 traffic —Because global correlation updates occur through the sensor management interface, any firewall that lies between the sensor and the internet must allow traffic on ports 80 and 443. You can also use an HTTP proxy (see Identifying an HTTP Proxy Server).

 
      		 [bookmark: pgfId-390716] Exposure to external traffic —The global correlation database contains external IP addresses only, so if you position a sensor in an internal lab that has no interaction with outside networks, you might never receive global correlation information. The feature will have no effect.

 
      		 [bookmark: pgfId-390718] Bypass mode might be triggered during global correlation updates — As with signature updates, when the sensor applies a global correlation update, it might trigger bypass. Whether bypass is triggered depends on the traffic load of the sensor and the size of the signature or global correlation update. If bypass mode is turned off, an inline sensor stops passing traffic while the update is being applied.

 
      		 [bookmark: pgfId-390720] No IPv6 address support —Global correlation inspection and the reputation filtering deny features do not support IPv6 addresses. For global correlation inspection, the sensor does not receive or process reputation data for IPv6 addresses. The risk rating for IPv6 addresses is not modified for global correlation inspection. Similarly, network participation does not include event data for attacks from IPv6 addresses. And finally, IPv6 addresses do not appear in the deny list.

 
     

 
     [bookmark: pgfId-390722]Related Topics

 
      
      		 [bookmark: pgfId-390727]Understanding Global Correlation

 
      		 [bookmark: pgfId-390732]Understanding Reputation

 
      		 [bookmark: pgfId-390737]Understanding Network Participation

 
      		 [bookmark: pgfId-390742]Configuring Global Correlation Inspection and Reputation

 
      		 [bookmark: pgfId-390747]Configuring Network Participation

 
     

 
    
 
   
 
    
     [bookmark: pgfId-390765][bookmark: 103197][bookmark: ipsvchap_proc_ConfiguringGlobalCorrelation]Configuring Global Correlation Inspection and Reputation[bookmark: marker-390755][bookmark: marker-390757][bookmark: marker-390759][bookmark: marker-390761][bookmark: marker-390763]

 
    [bookmark: pgfId-390767]Use the Inspection/Reputation policy to configure the sensor to use updates from the SensorBase Network to adjust the risk rating of events. The global correlation client on the sensor determines which updates are available and applicable to the sensor by communicating with the global correlation update server and a file server. The global correlation update server provides the server manifest document to the sensor, which identifies which updates are available and how to obtain them from a file server. The sensor downloads the update files from the file server using the information in the server manifest.

 
    [bookmark: pgfId-390769]When you configure global correlation, updates are automatic and happen at regular intervals, approximately every five minutes by default, but this interval can be modified by the global correlation server. The sensor initially gets a full update and then applies an incremental update periodically.

 
    [bookmark: pgfId-390771]If you turn on global correlation, you can choose how aggressively you want the deny actions to be enforced against malicious hosts. You can then enable reputation filtering to deny access to known malicious hosts. If you only want a report of what could have happened, you can enable Test Global Correlation. This puts the sensor in Audit mode, and actions the sensor would have performed are generated in the events.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-390773]Tip When you view IPS events in Event Viewer, there are several columns specific to global correlation that you can add to the event table; these columns are not shown by default, so you must add them to your view. To monitor global correlation in general, use the IPS device manager (IDM) and look at the Sensor Health gadget. Use either the full IDM or open a read-only copy from Security Manager by right-clicking the device in Device view and selecting Device Manager.


    
     

    

    

 
    [bookmark: pgfId-390775]Before You Begin

 
     
     		 [bookmark: pgfId-390783]You must also configure a DNS server or HTTP proxy for global correlation to function. For details, see Identifying DNS Servers or Identifying an HTTP Proxy Server.

 
     		 [bookmark: pgfId-390788]There are several configuration requirements and limitations that you should be aware of before configuring global configuration. For details, see Global Correlation Requirements and Limitations.

 
    

 
    [bookmark: pgfId-390790]Related Topics

 
     
     		 [bookmark: pgfId-390795]Understanding Global Correlation

 
     		 [bookmark: pgfId-390800]Understanding Reputation

 
     		 [bookmark: pgfId-390805]Configuring Network Participation

 
    

 
    
 
    [bookmark: pgfId-390807]Step 1 Do one of the following to open the Inspection/Reputation policy:

 
     
     		 [bookmark: pgfId-390809](Device view) Select  IPS > Global Correlation > Inspection/Reputation from the Policy selector.

 
     		 [bookmark: pgfId-390811](Policy view) Select  IPS > Global Correlation > Inspection/Reputation from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-390813]Step 2 Configure the following settings:

 
     
     		 [bookmark: pgfId-390815] Global Correlation Inspection —Whether to enable global correlation inspection. When turned on, the sensor uses updates from the SensorBase Network to adjust the risk rating. Deselect this option to disable inspection.

 
     		 [bookmark: pgfId-390817] Global Correlation Influence —How aggressively the sensor uses global correlation information to initiate deny actions. Select one of the following:

 
    

 
    [bookmark: pgfId-390819] – Permissive—Has the least aggressive effect on deny actions.

 
    [bookmark: pgfId-390821] – Standard—(The default.) Has a moderately aggressive effect on deny actions.

 
    [bookmark: pgfId-390823] – Aggressive—Has a very aggressive effect on deny actions.

 
     
     		 [bookmark: pgfId-390825] Reputation Filtering —Select whether you want reputation filtering  on or  off . When turned on, the sensor denies access to malicious hosts that are listed in the global correlation database.

 
     		 [bookmark: pgfId-390827] Test Global Correlation —Whether to place global correlation in audit mode. In audit mode, reputation filtering does not deny access to known malicious hosts; only a report of what could have happened is generated.

 
    

 
    [bookmark: pgfId-390829]Audit mode allows you to test the global correlation features without actually denying any hosts. If you decide the effects are desirable, you can deselect this option to activate reputation filtering.

 
    [bookmark: pgfId-390831]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-390849][bookmark: 103287][bookmark: ipsvchap_proc_ConfiguringNetworkParticipation]Configuring Network Participation[bookmark: marker-390839][bookmark: marker-390841][bookmark: marker-390843][bookmark: marker-390845][bookmark: marker-390847]

 
    [bookmark: pgfId-390854]Use the Network Participation policy to configure the sensor to send data to the SensorBase Network. You can configure the sensor to fully participate and send all data to the SensorBase Network, or you can configure the sensor to collect the data but to omit potentially sensitive data, such as the destination IP address of trigger packets. For detailed information about network participation and the data that is collected, see Understanding Network Participation.

 
    [bookmark: pgfId-390856]Related Topics

 
     
     		 [bookmark: pgfId-390861]Understanding Global Correlation

 
     		 [bookmark: pgfId-390866]Understanding Reputation

 
     		 [bookmark: pgfId-390871]Global Correlation Requirements and Limitations

 
     		 [bookmark: pgfId-390876]Configuring Global Correlation Inspection and Reputation

 
    

 
    
 
    [bookmark: pgfId-390878]Step 1 Do one of the following to open the Network Participation policy:

 
     
     		 [bookmark: pgfId-390880](Device view) Select  IPS > Global Correlation > Network Participation from the Policy selector.

 
     		 [bookmark: pgfId-390882](Policy view) Select  IPS > Global Correlation > Network Participation from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-390884]Step 2 Select the level of participation from the Network Participation list:

 
     
     		 [bookmark: pgfId-390886] Off —No data is contributed to the SensorBase network.

 
     		 [bookmark: pgfId-390888] Partial —Data is contributed to the SensorBase network but potentially sensitive information is withheld.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-390890]Note Configuring the sensor for partial network participation limits a third party from extracting reconnaissance information about your internal network from the Global Correlation database.


    
     

    

    

 
     
     		 [bookmark: pgfId-390892] Full —All data is contributed to the SensorBase network.

 
    

 
    [bookmark: pgfId-390894]Step 3 If you select Full or Partial, when you click Save, the Network Participation Disclaimer dialog box opens, prompting you to read and accept a disclaimer. Carefully read the disclaimer. Click Agree if you agree to it.

 
    [bookmark: pgfId-390896]If you click Disagree, you cannot enable network participation. Change the setting to Off and save the policy.

 
    [bookmark: pgfId-390898]
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     [bookmark: pgfId-248593][bookmark: 55040][bookmark: porules_cncpt_WorkingwithZoneBasedFWRules]Managing Zone-based Firewall Rules[bookmark: marker-248581][bookmark: marker-248583][bookmark: marker-248585][bookmark: marker-248587][bookmark: marker-248589][bookmark: marker-248591]
      
      
 
     
 

 
    [bookmark: pgfId-248595]The Zone-based Firewall feature (also known as Zone-based Policy Firewall) allows unidirectional application of IOS firewall policies between groups of interfaces known as “zones.” That is, interfaces are assigned to zones, and firewall rules are applied to specific types of traffic moving in one direction between the zones. Zone-based firewalls enforce a secure inter-zone policy by default, meaning traffic cannot pass between security zones until an explicit policy allowing that traffic is defined.

 
    [bookmark: pgfId-248597]The “zone” itself is an abstraction—multiple interfaces with the same or similar security requirements that can be logically grouped together. For example, router interfaces Ethernet 0/0 and Ethernet 0/1 might be connected to the local LAN. When viewed from a firewall perspective, these two interfaces are similar in that they represent the internal network, and they can be grouped into a single zone for the purposes of firewall configuration. Then you can specify firewall policies between that and other zones. These inter-zone policies offer considerable flexibility and granularity, so different inspection policies can be applied to multiple host groups connected to the same router interface.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-248599]Note The zone-based firewall feature is supported on IOS devices running 12.4(6)T or later, and ASR devices running 12.2(33) or later.


    
     

    

    

 
    [bookmark: pgfId-248601]A Simple Example

 
    [bookmark: pgfId-248603]A security zone should be configured for each region of similar security within the network, so that all interfaces assigned to the same zone are protected with a similar level of security. For example, consider an access router with three interfaces:

 
     
     		 [bookmark: pgfId-248605]One interface is connected to the public Internet

 
     		 [bookmark: pgfId-248607]One interface is connected to a private LAN that must not be accessible from the public Internet

 
     		 [bookmark: pgfId-248609]One interface is connected to an Internet-service “demilitarized zone” (DMZ), where a Web server, Domain Name System (DNS) server, and e-mail server must have access to the public Internet

 
    

 
    [bookmark: pgfId-248611]Each interface in this network would be assigned to its own zone, as shown in the following figure.

 
    [bookmark: pgfId-248615]Figure 21-1 [bookmark: 55077]Basic Security Zone Topology

 
    [bookmark: pgfId-248618] 

 
     
     [image: ] 
    
 
    [bookmark: pgfId-248620]This example configuration typically would have three main policies (sets of rules) defining:

 
     
     		 [bookmark: pgfId-248622]Private zone connectivity to the Internet

 
     		 [bookmark: pgfId-248624]Private zone connectivity to DMZ hosts

 
     		 [bookmark: pgfId-248626]Internet zone connectivity to DMZ hosts

 
    

 
    [bookmark: pgfId-248628]Zone-based firewalls impose a prohibitive default security posture. In other words, for example, unless the DMZ hosts are specifically allowed access to other networks, those networks are protected against any undesired connections from the DMZ hosts. Similarly, unless access is specifically provided for Internet hosts to access the Private zone directly, the Private zone hosts are safe from unwanted access by Internet hosts.

 
    [bookmark: pgfId-248630]In this simple example, each zone has only one member interface. If an additional interface is added to the Private zone, for example, the hosts connected to that new interface can immediately pass traffic to all hosts connected to the existing interface in the zone. Additionally, traffic to hosts in other zones is immediately controlled by existing Private zone policies.

 
    [bookmark: pgfId-248632]In a more realistic example, you might allow varied access from the public Internet to specific hosts in the DMZ, and varied application-use policies for hosts in the protected LAN.

 
    [bookmark: pgfId-248634]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-248639]Understanding the Zone-based Firewall Rules

 
     		 [bookmark: pgfId-248644]Understanding the Relationship Between Permit/Deny and Action in Zone-based Firewall Rules

 
     		 [bookmark: pgfId-248649]Understanding the Relationship Between Services and Protocols in Zone-based Firewall Rules

 
     		 [bookmark: pgfId-248654]General Recommendations for Zone-based Firewall Rules

 
     		 [bookmark: pgfId-248659]Developing and Applying Zone-based Firewall Rules

 
     		 [bookmark: pgfId-248664]Adding Zone-Based Firewall Rules

 
     		 [bookmark: pgfId-248669]Configuring Inspection Maps for Zone-based Firewall Policies

 
     		 [bookmark: pgfId-248674]Configuring Content Filtering Maps for Zone-based Firewall Policies

 
     		 [bookmark: pgfId-248679]Changing the Default Drop Behavior

 
     		 [bookmark: pgfId-248684]Configuring Settings for Zone-based Firewall Rules

 
     		 [bookmark: pgfId-248689]Troubleshooting Zone-based Rules and Configurations

 
     		 [bookmark: pgfId-248694]Zone-based Firewall Rules Page

 
    

 
   
 
    
     [bookmark: pgfId-248712][bookmark: 55091][bookmark: porules_cncpt_UnderstandingZoneBasedFirewalls]Understanding the Zone-based Firewall Rules[bookmark: marker-248700][bookmark: marker-248702][bookmark: marker-248704][bookmark: marker-248706][bookmark: marker-248708][bookmark: marker-248710]

 
    [bookmark: pgfId-248714]Zones establish the security borders of your network. A zone defines a boundary where traffic is subjected to inspection or filtering as it crosses to another region of your network. The default zone-based firewall policy between zones is “deny all.” Thus, if no zone-based firewall rules are explicitly configured, all traffic moving between all zones is blocked.

 
    [bookmark: pgfId-248716]Zone-based firewall rules apply specific actions—Drop, Pass, Inspect, and Content Filter—to various types of unidirectional traffic between pairs of zones. The direction of the traffic is determined by specifying a source and destination zone as part of each rule.

 
    [bookmark: pgfId-248718]Logging

 
    [bookmark: pgfId-248723]Zone-based firewall rules offer syslog, alert, and audit-trail logging options. Most messages are logged to the router console unless a syslog server is configured. See Logging on Cisco IOS Routers for information about configuring syslog logging.

 
    [bookmark: pgfId-248725]Important Points

 
    [bookmark: pgfId-248727]Please note the following points regarding zones and zone-based firewall rules:

 
     
     		 [bookmark: pgfId-248729]Zone-based firewall rules are supported only on IOS devices running 12.4(6)T or later, and ASR devices running 12.2(33) or later.

 
     		 [bookmark: pgfId-248731]If a zone-based firewall rule and an IOS Inspection rule use the same interface, an error results.

 
    

 
    [bookmark: pgfId-248733]The zone-based firewall model and the earlier interface-based inspection rules model are not mutually exclusive on the router, but they cannot be combined on any given interface. That is, an interface cannot be configured as a member of a security zone if it is configured with Inspection rules. Further, configuring a router to use both models at the same time is not recommended.

 
     
     		 [bookmark: pgfId-248735]An interface can be assigned to only one security zone, but zones can include multiple interfaces. If an interface is assigned to more than one zone, an error results.

 
     		 [bookmark: pgfId-248737]All traffic to and from a given interface is implicitly blocked when the interface is assigned to a zone (except traffic to and from other interfaces in the same zone, and traffic to any interface on the router). Thus, to permit traffic to and from a zone-member interface, one or more rules allowing or inspecting traffic must be configured between that zone and any other zone.

 
     		 [bookmark: pgfId-248739]Traffic is implicitly allowed to flow between interfaces that are members of the same zone. However, you can define rules that require inspection of traffic between same-zone members.

 
     		 [bookmark: pgfId-248741]The “Self” zone is a default zone that defines the router itself as a separate security zone, which you can specify as either the source or destination zone. The Self zone is the only exception to the default “deny all” policy. All traffic to any router interface is allowed until explicitly denied.

 
    

 
    [bookmark: pgfId-248746]A zone-based firewall rule that includes the Self zone applies to local traffic—that is, traffic directed to the router, or to traffic generated by the router; it does not apply to traffic through the router. See The Self Zone for more information.

 
     
     		 [bookmark: pgfId-248748]The Inspect action is not allowed in rules that apply to the Self zone.

 
     		 [bookmark: pgfId-248750]The Pass action permits traffic in one direction only. You must explicitly define rules for return traffic. However, with the Inspect action, return traffic is automatically allowed for established connections.

 
     		 [bookmark: pgfId-248752]Traffic cannot flow between a zone-member interface and any interface that is not a zone member.

 
     		 [bookmark: pgfId-248754]Interfaces that have not been assigned to a zone can still function as classical router ports and might still have other types of firewall rules configured on them.

 
    

 
    [bookmark: pgfId-248756]However, if an interface is not part of your zone-based firewall policy, it might still be necessary to add that interface to a zone and configure a “pass all” policy (sort of a “dummy policy”) between that zone and any other zone to which inter-zone traffic flow is desired.

 
     
     		 [bookmark: pgfId-248758]Access-control list (ACL) rules applied on interfaces that are also zone members are processed before the zone rules are applied. Therefore, to continue using both rule types, it may be necessary to relax the interface ACLs to ensure certain traffic flows are processed by the zone-based rules.

 
     		 [bookmark: pgfId-248763]All interfaces in a zone must belong to the same Virtual Routing and Forwarding (VRF) instance. Zone-based rules can be configured between zones whose member interfaces are in separate VRFs. However, if traffic cannot flow between these VRFs, these rules will never be executed. See Zones and VRF-aware Firewalls for more information.

 
     		 [bookmark: pgfId-248765]Zones are defined using Interface Role objects. If you change the definition of an interface role that you are using for a zone, you are changing the zone, which can affect existing traffic flows. In addition, if you use wildcards in the interface role to specify an interface name pattern, be aware that interfaces may automatically be added to the zone when you create new interfaces on the router.

 
     		 [bookmark: pgfId-248767]If zone-based firewall rules contain conflicting zone information, the first rule defined in the table takes precedence. Rules that do not reference valid zones are not deployed and an activity validation warning is shown.

 
     		 [bookmark: pgfId-248769]Empty zones result in activity validation errors for certain devices; refer to the following restriction lists.

 
     		 [bookmark: pgfId-248771]Source and destination zones cannot be the same for certain devices; refer to the following restriction lists.

 
     		 [bookmark: pgfId-248773]For devices that support nested class-maps (IOS devices running 12.4(6)T+ and ASR devices running 3.5S+/15.2(1)S+), Security Manager will configure multiple traffic classes as a single traffic class when appropriate.

 
     		 [bookmark: pgfId-248775]When discovering policies on an ISR, Security Manager will discover the zone-based firewall policies as they are on the device. When discovering policies on an ASR, Security Manager will try to match policies to existing object-groups and reuse them when possible.

 
    

 
    [bookmark: pgfId-248777]ASR Restrictions

 
    [bookmark: pgfId-248779]The following are restrictions specific to ASR devices:

 
     
     		 [bookmark: pgfId-248781]Deep Packet Inspection (DPI) is not allowed.

 
     		 [bookmark: pgfId-248783]Source and destination zones can be the same. This is possible because intra-zone traffic inspection is allowed.

 
     		 [bookmark: pgfId-248785]Content (URL) Filtering is not allowed.

 
     		 [bookmark: pgfId-248787]Only certain protocols are supported, such as DNS, FTP, H.323, ICMP, RTSP, SIP, Skinny, TCP, TFTP, and UDP.

 
     		 [bookmark: pgfId-248789]Although IOS-XE only supports security group tags, Security Manager allows the use of security group names for ASR devices, either directly or as part of a security group object group, and will automatically convert security group names to their tag number during deployment. However, if the ISE is not reachable, Security Manager will not be able to resolve the security group names. In such situations, Security Manager will not generate the rule for the configuration and an appropriate warning/error message will be displayed.

 
     		 [bookmark: pgfId-248791]IOS-XE only supports the use of security group object groups. Security Manager will generate a validation error message if inline security group tags or names are deployed to an ASR. Also, when discovering policies on an ASR, Security Manager will try to match security group object groups to existing object groups and reuse them when possible.

 
    

 
    [bookmark: pgfId-248793]ISR Restrictions

 
    [bookmark: pgfId-248795]The following are restrictions specific to ISR devices:

 
     
     		 [bookmark: pgfId-248797]Empty zones cannot exist.

 
     		 [bookmark: pgfId-248799]Source and destination zones cannot be the same.

 
     		 [bookmark: pgfId-248801]Cisco TrustSec Support for IOS feature is supported on the Cisco Integrated Services Router Generation 2 (ISR G2) only.

 
     		 [bookmark: pgfId-248803]Destination security group tags are not supported.

 
     		 [bookmark: pgfId-248805]Although IOS only supports security group tags, Security Manager allows the use of security group names for ISR devices and will automatically convert security group names to their tag number during deployment. However, if the ISE is not reachable, Security Manager will not be able to resolve the security group names. In such situations, Security Manager will not generate the rule for the configuration and an appropriate warning/error message will be displayed.

 
     		 [bookmark: pgfId-248807]Although IOS does not support security group object groups, Security Manager allows the use of security group object groups for ISR devices and will automatically expand the object groups to their tag numbers during deployment.

 
    

 
    [bookmark: pgfId-248809]Related Topics

 
     
     		 [bookmark: pgfId-248814]The Self Zone

 
     		 [bookmark: pgfId-248819]Using VPNs with Zone-based Firewall Policies

 
     		 [bookmark: pgfId-248824]Zones and VRF-aware Firewalls

 
     		 [bookmark: pgfId-248829]Configuring Settings for Zone-based Firewall Rules

 
     		 [bookmark: pgfId-248834]Understanding the Relationship Between Permit/Deny and Action in Zone-based Firewall Rules

 
     		 [bookmark: pgfId-248839]Understanding the Relationship Between Services and Protocols in Zone-based Firewall Rules

 
     		 [bookmark: pgfId-248844]General Recommendations for Zone-based Firewall Rules

 
     		 [bookmark: pgfId-248849]Developing and Applying Zone-based Firewall Rules

 
    

 
     
      [bookmark: pgfId-248861][bookmark: 55225][bookmark: porules_cncpt_SelfZone]The Self Zone [bookmark: marker-248855][bookmark: marker-248857][bookmark: marker-248859]

 
     [bookmark: pgfId-248863]The router itself is defined as a separate security zone, with the fixed name Self, and since IOS firewalls support examination of traffic (TCP, UDP and H.323 only) that terminates or originates on the router (together known as “local” traffic), incoming and outgoing router traffic can be subject to rules in the same way as routed inter-zone traffic.

 
     [bookmark: pgfId-248865]When an interface is assigned to a zone, the hosts connected to that interface are included in that zone. By default, traffic is allowed to flow between interfaces that are members of the same zone, while a default “deny-all” policy is applied to traffic moving between zones.

 
     [bookmark: pgfId-248867]However, traffic flowing directly between other zones and the router’s IP interfaces (the Self zone) is implicitly allowed. This ensures that connectivity to the router’s management interfaces is maintained when a zone firewall configuration is applied to the router.

 
     [bookmark: pgfId-248869]This also means that traffic flowing to and from the IP addresses of the router’s interfaces is not initially controlled by zone policies. If you wish to control traffic moving between the router interfaces and other zones, you must apply rules that block or allow this local traffic.

 
     [bookmark: pgfId-248871]When configuring the rules for the Self zone, consider the following:

 
      
      		 [bookmark: pgfId-248873]All IP addresses configured on the router belong to the Self zone, regardless of interface zone membership.

 
      		 [bookmark: pgfId-248875]Traffic to and from the Self zone is unrestricted until you configure explicit rules to the contrary.

 
     

 
     [bookmark: pgfId-248877]That is, when you configure a zone-based firewall rule that includes the Self zone, traffic between the Self zone and the other zone is immediately restricted in both directions. For example, if you define a rule affecting traffic from the “Private” zone to the Self zone, the router cannot originate any traffic to the Private zone until you define one or more rules for Self to Private.

 
     [bookmark: pgfId-248879]Traffic between the router itself and other zones that are not included in the Self-zone rules remains unaffected.

 
      
      		 [bookmark: pgfId-248881]The Inspect action is not allowed in rules that apply to the Self zone.

 
     

 
     [bookmark: pgfId-248883]When configuring restrictions on inbound Self-zone traffic, consider the necessary outbound traffic (including the routing and network management protocols). For example, if you restrict inbound traffic from a zone to the router itself, the routing protocols could stop working on all interfaces belonging to that zone.

 
     [bookmark: pgfId-248885]Related Topics

 
      
      		 [bookmark: pgfId-248890]Understanding the Zone-based Firewall Rules

 
     

 
    
 
     
      [bookmark: pgfId-248904][bookmark: 55259][bookmark: porules_cncpt_ZoneBasedFW_IPSecVPN]Using VPNs with Zone-based Firewall Policies[bookmark: marker-248896][bookmark: marker-248898][bookmark: marker-248900][bookmark: marker-248902]

 
     [bookmark: pgfId-248906]Recent enhancements to the IP Security (IPsec) VPN implementation simplify firewall policy configuration for VPN connectivity. IPSec Virtual Tunnel Interface (VTI) and GRE+IPSec allow the confinement of VPN site-to-site and client connections to a specific security zone by placing the tunnel interfaces in that security zone. Connections can be isolated in a VPN DMZ if connectivity must be limited by a specific policy. Or, if VPN connectivity is implicitly trusted, VPN connections can be placed in the same security zone as the trusted inside network.

 
     [bookmark: pgfId-248908]To configure the router to use zone-based firewall rules with dynamic VPNs (those which dynamically create Tunnel/Loopback/Virtual interfaces):

 
      
      		 [bookmark: pgfId-248910]Define a zone specifically for the VPN interfaces.

 
      		 [bookmark: pgfId-248915]Enter this zone in the  VPN Zone field on the VPN tab of the Zone Based Firewall Page.

 
      		 [bookmark: pgfId-248917]Create zone-based firewall rules to allow the VPN traffic, as appropriate.

 
     

 
     [bookmark: pgfId-248919]If non-VTI IPsec is employed, you must exercise caution when you configure a zone-based firewall policy for VPN. The zone policy must specifically allow access to protected hosts by remote VPN hosts or clients if they are in a different zone than the ingress interface for encrypted VPN traffic. This access policy must be configured by including an access control list (ACL) enumerating the source IP addresses of the VPN clients, and the destination IP addresses of all protected hosts the VPN clients are allowed to reach. If the access policy is not properly configured, the policy could expose vulnerable hosts to hostile traffic.

 
     [bookmark: pgfId-248923]Refer to this white paper on cisco.com “Using VPN with Zone-Based Policy Firewall” for further discussion of these topics.

 
     [bookmark: pgfId-248925]Related Topics

 
      
      		 [bookmark: pgfId-248930]Understanding the Zone-based Firewall Rules

 
     

 
    
 
     
      [bookmark: pgfId-248940][bookmark: 55295][bookmark: porules_cncpt_ZoneBasedFW_ZonesandVRF]Zones and VRF-aware Firewalls [bookmark: marker-248936][bookmark: marker-248938]

 
     [bookmark: pgfId-248942]Cisco IOS firewalls are VRF-aware (Virtual Routing and Forwarding), providing management of IP address overlap across different VRFs, separate thresholds and timeouts for VRFs, and so forth. For application of zone-based firewall rules, all interfaces in a zone must belong to the same VRF.

 
     [bookmark: pgfId-248944]When multiple VRFs are configured on a router and one interface provides common services to all the VRFs (for example, Internet service), you should place that interface in a separate zone. You can then define policies between the common zone and other zones. (There can be one or more zones per VRF.)

 
     [bookmark: pgfId-248946]You can configure rules between two zones that contain different VRFs, as shown in the following illustration.

 
     [bookmark: pgfId-248950]Figure 21-2 [bookmark: 55307]Zones and VRF

 
     [bookmark: pgfId-248953] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-248955]In this illustration:

 
      
      		 [bookmark: pgfId-248957]The interface providing common services is a member of the zone “common.”

 
      		 [bookmark: pgfId-248959]All of VRF A is in a single zone, “vrf_A.”

 
      		 [bookmark: pgfId-248961]VRF B, which has multiple interfaces, is partitioned into two zones “vrf_B_1” and “vrf_B_2.”

 
      		 [bookmark: pgfId-248963]Zone Z1 does not have VRF interfaces.

 
     

 
     [bookmark: pgfId-248965]Based on this configuration:

 
      
      		 [bookmark: pgfId-248967]You can specify policies between each of these zones and the common zone. Additionally, you can specify polices between each of the zones vrf_A, vrf_B_n and Z1 if VRF route export is configured and the traffic patterns make sense.

 
      		 [bookmark: pgfId-248969]You can configure a policy between zones vrf_A and vrf_B_1, but be sure that traffic can flow between them.

 
      		 [bookmark: pgfId-248971]You do not need to specify the global thresholds and timers on a per-VRF basis. Instead, parameters are supplied to the Inspect action through a parameter map.

 
     

 
     [bookmark: pgfId-248973]Related Topics

 
      
      		 [bookmark: pgfId-248978]Understanding the Zone-based Firewall Rules

 
     

 
    
 
   
 
    
     [bookmark: pgfId-248988][bookmark: 55336][bookmark: porules_cncpt_ZoneBasedFW_PermitDeny]Understanding the Relationship Between Permit/Deny and Action in Zone-based Firewall Rules [bookmark: marker-248984][bookmark: marker-248986]

 
    [bookmark: pgfId-248990]When you create a zone-based firewall rule, you must specify two execution-related settings: Permit/Deny and an Action (Drop, Pass, Inspect, or Content Filter). To obtain the results you want, you must clearly understand the relationship between these two parameters:

 
     
     		 [bookmark: pgfId-248992] Permit/Deny —The Permit/Deny setting appears to correspond to Permit/Deny in an access control list (ACL) entry. However, in zone-based firewall rules, unlike in standard access rules, these keywords do not permit or deny traffic. Instead, they specify whether you want to apply an Action to the traffic flow defined by the Source, Destination, and Services fields, and they affect processing of related class maps.

 
    

 
    [bookmark: pgfId-248994] – Permit – Applies the specified Action to traffic that matches the Source, Destination, and Services fields. (If protocols are listed in the Protocols table, the Action is further limited to those protocols.)

 
    [bookmark: pgfId-248996]Tip: Essentially all of your zone-based rules should be Permit rules. This is the easiest configuration to understand—it means you are identifying the traffic to which you want the chosen Action applied.

 
    [bookmark: pgfId-249001] – Deny – Exempts the traffic defined by the Source, Destination, and Services fields. (If protocols are listed in the Protocols table, the exemption is further limited to those protocols.) In other words, treat the traffic as not matching the rule. Instead, evaluate subsequent class maps (which are not the same as zone rules) for the zone pair and look for a subsequent map that matches the traffic. If no subsequent map matches the traffic, apply the default rule to the traffic (see Changing the Default Drop Behavior).

 
    [bookmark: pgfId-249006]It is important to understand that there is not a one-to-one relationship between zone rules and class maps. Therefore, you cannot determine just by looking at the rules table how the rules will be converted to class maps. You must preview the configuration to see which subsequent rules might be applied to traffic that matches your Deny rule. (To preview the configuration, save your changes and select Tools > Preview Configuration. For more information, see Previewing Configurations.)

 
    [bookmark: pgfId-249008]In general, you might use a Deny rule to exempt a specific IP address within a subnet from a Permit rule you want to apply to the subnet in general; for example, exempting 10.100.10.1 from a rule applying to 10.100.10.0/24. However, it is much easier to create a Permit rule for the specific IP address and apply a desired Action, and ensure that the rule is listed above the general rule in the zone-based rules table.

 
    [bookmark: pgfId-249013]If you decide to use Deny rules, be sure to also read Troubleshooting Zone-based Rules and Configurations.

 
     
     		 [bookmark: pgfId-249015] Action —The Action parameters define what happens to traffic that matches a Permit rule. These parameters are ignored for Deny rules, except to determine to which class map the rule is added.

 
    

 
    [bookmark: pgfId-249017]When you create a Permit rule, traffic that matches the Source, Destination, Services, and Protocol fields is processed according to the Action you choose: drop the traffic (and optionally log it), pass the traffic (and optionally log it), inspect the traffic, or apply content filtering (for Web traffic only).

 
    [bookmark: pgfId-249019]When you inspect traffic for some protocols, or perform content filtering, you have the option of specifying a policy map to use for deep inspection. The deep inspection policy map also specifies actions based on the deeper characteristics of the traffic. This additional inspection applies to packets that meet the requirements of the class map to which the assigned policy map refers. Packets that do not match the deep inspection class map are allowed. Thus, deep inspection might reset TCP connections if the policy map specifies that action.

 
     
      
       
       [bookmark: pgfId-244542]Table 21-1 [bookmark: 55376]Relationship Between Permit/Deny and Action in Zone-based Rules 

 
       
      
        
        		
          
          [bookmark: pgfId-244554]Permit / Deny
         
  
        		
          
          [bookmark: pgfId-244556]Service
         
  
        		
          
          [bookmark: pgfId-244558]Rule Action
         
  
        		
          
          [bookmark: pgfId-244560]Protocol
         
  
        		
          
          [bookmark: pgfId-244562]Result
         
  
       

 
        
        		[bookmark: pgfId-244574]Permit

  
        		[bookmark: pgfId-244576]TCP

  
        		[bookmark: pgfId-244578]Pass

  
        		[bookmark: pgfId-244580](None)

  
        		[bookmark: pgfId-244582]Pass all TCP traffic.

  
       

 
        
        		[bookmark: pgfId-244594]Deny

  
        		[bookmark: pgfId-244596]TCP

  
        		[bookmark: pgfId-244598]Pass

  
        		[bookmark: pgfId-244600](None)

  
        		[bookmark: pgfId-244602]Skip the rule and evaluate the next class map. Either a subsequent class map with a Permit rule is applied, or the class default rule is applied.

 [bookmark: pgfId-244604]The Pass action is ignored.

  
       

 
        
        		[bookmark: pgfId-244616]Permit

  
        		[bookmark: pgfId-244618]TCP

  
        		[bookmark: pgfId-244620]Drop

  
        		[bookmark: pgfId-244622](None)

  
        		[bookmark: pgfId-244624]Drop all TCP traffic.

  
       

 
        
        		[bookmark: pgfId-244636]Deny

  
        		[bookmark: pgfId-244638]TCP

  
        		[bookmark: pgfId-244640]Drop

  
        		[bookmark: pgfId-244642](None)

  
        		[bookmark: pgfId-244644]Skip the rule and evaluate the next class map. Either a subsequent class map with a Permit rule is applied, or the class default rule is applied.

 [bookmark: pgfId-244646]The Drop action is ignored.

  
       

 
        
        		[bookmark: pgfId-244658]Permit

  
        		[bookmark: pgfId-244660]TCP

  
        		[bookmark: pgfId-244662]Pass

  
        		[bookmark: pgfId-244664]DNS

  
        		[bookmark: pgfId-244666]Only DNS traffic passes. Other TCP traffic is handled by subsequent rules.

  
       

 
        
        		[bookmark: pgfId-244678]Permit

  
        		[bookmark: pgfId-244680]TCP

  
        		[bookmark: pgfId-244682]Drop

  
        		[bookmark: pgfId-244684]DNS

  
        		[bookmark: pgfId-244686]DNS traffic is dropped. Other TCP traffic is handled by subsequent rules.

  
       

 
        
        		[bookmark: pgfId-244698]Deny

  
        		[bookmark: pgfId-244700]TCP

  
        		[bookmark: pgfId-244702]Pass

  
        		[bookmark: pgfId-244704]DNS

  
        		[bookmark: pgfId-244706]Skip the rule for DNS traffic and evaluate the next class map. Either a subsequent class map with a Permit rule is applied, or the class default rule is applied.

 [bookmark: pgfId-244708]The Pass action is ignored.

  
       

 
        
        		[bookmark: pgfId-244720]Deny

  
        		[bookmark: pgfId-244722]TCP

  
        		[bookmark: pgfId-244724]Drop

  
        		[bookmark: pgfId-244726]DNS

  
        		[bookmark: pgfId-244728]Skip the rule for DNS traffic and evaluate the next class map. Either a subsequent class map with a Permit rule is applied, or the class default rule is applied.

 [bookmark: pgfId-244730]The Drop action is ignored.

  
       

 
        
        		[bookmark: pgfId-244742]Permit

  
        		[bookmark: pgfId-244744]TCP

  
        		[bookmark: pgfId-244746]Inspect

  
        		[bookmark: pgfId-244748]HTTP

  
        		[bookmark: pgfId-244750]Allow and inspect HTTP traffic. If you specify a policy map for deep inspection, the action from the policy map is applied to any packets that match deep inspection parameters (for example, reset the connection for protocol violations).

  
       

 
        
        		[bookmark: pgfId-244762]Deny

  
        		[bookmark: pgfId-244764]TCP

  
        		[bookmark: pgfId-244766]Inspect

  
        		[bookmark: pgfId-244768]HTTP

  
        		[bookmark: pgfId-244770]Skip the rule for HTTP traffic and evaluate the next class map. Either a subsequent class map with a Permit rule is applied, or the class default rule is applied.

 [bookmark: pgfId-244772]The Inspect action is ignored.

 [bookmark: pgfId-244774]Tip If subsequent rules, or the class default, pass the traffic without inspection, you need to create a Permit/Pass rule in the other direction (or an access rule) to allow return traffic for the HTTP connection. If your intention is to prohibit HTTP connections, create a Permit/Drop rule instead of a Deny/Inspect rule.  
       

 
        
        		[bookmark: pgfId-244786]Permit

  
        		[bookmark: pgfId-244788]TCP

  
        		[bookmark: pgfId-244790]Content Filter

  
        		[bookmark: pgfId-244792]HTTP

  
        		[bookmark: pgfId-244794]Allow and inspect HTTP traffic, and apply URL filtering maps to selectively permit or deny Web connections based on the Web sites requested.

 [bookmark: pgfId-244796]If you specify a policy map for deep inspection, the action from the policy map is applied to any packets that match deep inspection parameters (for example, reset the connection for protocol violations).

 [bookmark: pgfId-244798]Thus, traffic can be dropped either because the Web site is blacklisted, or because the HTTP packets violate your deep inspection rules.

  
       

 
        
        		[bookmark: pgfId-244810]Deny

  
        		[bookmark: pgfId-244812]TCP

  
        		[bookmark: pgfId-244814]Content Filter

  
        		[bookmark: pgfId-244816]HTTP

  
        		[bookmark: pgfId-244818]Skip the rule for HTTP traffic and evaluate the next class map. Either a subsequent class map with a Permit rule is applied, or the class default rule is applied.

 [bookmark: pgfId-244820]The Content Filter action is ignored.

 [bookmark: pgfId-244822]Tip This type of rule can exempt the specified source/destination from content filtering if no subsequent class maps drop the traffic or apply content filtering. However, if you want to allow HTTP connections for this traffic, you must create a Permit/Inspect rule for the traffic.  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-249034][bookmark: 55535][bookmark: porules_cncpt_ZoneBasedFW_ServicesProtocols]Understanding the Relationship Between Services and Protocols in Zone-based Firewall Rules [bookmark: marker-249030][bookmark: marker-249032]

 
    [bookmark: pgfId-249036]When you create a zone-based firewall rule, there are two seemingly similar parameters which help identify the characteristics of the target traffic: Services and Protocols. The entries in these fields can provide very similar information, but it is used differently when constructing zone-based firewall policies in the device configuration. This section describes the recommended uses of these fields.

 
     
     		 [bookmark: pgfId-249038] Services – The Services field is used to define traffic protocol(s) in an access control list (ACL) entry. Along with the Sources and Destinations specified, this ACL entry is used by a class map to define the traffic to which you want to apply a policy. However, unlike in standard access rules, the Services information is not the primary means of identifying the traffic protocol. It is required only because ACLs must have a service designation for each entry.

 
    

 
    [bookmark: pgfId-249040]In general, you can leave the default entry (IP) in the Services field for all of your zone-based firewall rules, using the Protocol table to identify specific protocols that you want to Drop, Pass, or Inspect.

 
    [bookmark: pgfId-249042]If you do elect to specify a Service other than IP, ensure that your selection does not conflict with any protocols listed in the Protocol table. For example, do not specify UDP in the Services field, and then list a TCP-based protocol in the table. In general, for a given rule, if you specify a specific service in the Services field, do not enter any protocols in the Protocol table.

 
     
     		 [bookmark: pgfId-249044] Protocol – The Protocol table, in the Action area of the Add and Edit Zone Based Rule dialog boxes, is used to select one or more protocols, add custom port application mappings (if you specify non-default ports), and apply deep inspection policy maps. You can specify very specific protocols, such as DNS, general protocols such as TCP and UDP, and even custom protocols that identify ports you use for special applications.

 
    

 
    [bookmark: pgfId-249046]As a general rule, leave Services set to IP and use the Protocol table to identify the protocols (which are also services) for all of your zone-based rules for the Drop, Pass, and Inspect actions. (The Content Filter action automatically uses the HTTP protocol, which you can configure but not change.) Following this approach will create a configuration that is as “clean” and easy to interpret (and troubleshoot) as possible.

 
    [bookmark: pgfId-249051]For more detailed information on how these fields are used when generating device configurations, see Troubleshooting Zone-based Rules and Configurations.

 
   
 
    
     [bookmark: pgfId-249061][bookmark: 55558][bookmark: porules_cncpt_ZoneBasedFW_Recommendations]General Recommendations for Zone-based Firewall Rules [bookmark: marker-249057][bookmark: marker-249059]

 
    [bookmark: pgfId-249063]Zone-based firewall rules allow a wide variety of configurations. You can quickly generate a set of rules that will be very complex and difficult to analyze, because you can use the zone-based rules in place of the standard access rules, inspection rules, and Web filter rules.

 
    [bookmark: pgfId-249065]When defining zone-based rules, strive to keep them as simple and straightforward as possible. Consider the following recommendations for helping to maintain simplicity in your zone-based firewall policy:

 
     
     		 [bookmark: pgfId-249070]Only use  Permit rules. The chosen Action determines what happens to matched traffic, and  Deny rules are difficult to analyze. For more information, see Understanding the Relationship Between Permit/Deny and Action in Zone-based Firewall Rules.

 
     		 [bookmark: pgfId-249072]The  Drop and  Pass rules are equivalent to standard interface access rules, but are applied to the specified zone pair. You can use either the Services field or the Protocol table to identify the type of traffic, but we recommend using the Protocol table exclusively. To drop traffic, specify  Permit with the Action  Drop .

 
     		 [bookmark: pgfId-249074]You do not need to first pass traffic before inspecting it. For example, if you want to allow HTTP traffic between zones, you need only a single Permit/Inspect rule; you do not need to first create a Permit/Pass rule. If you do use Pass rules, note that you must also create a Pass rule in the return direction if you want to allow returning traffic. In practice, you generally can avoid creating Pass rules, using only Inspect rules.

 
     		 [bookmark: pgfId-249076]You can use Permit/Pass and Permit/Drop rules to perform the same functions as standard access rules. Thus, you can eliminate your access rules policy and use only zone-based firewall rules.

 
    

 
    [bookmark: pgfId-249078]However, because there are several tools available for analyzing interface access rules, and Security Manager allows you to use the same interface roles in zone-base rules and access rules, you might find it more convenient to create your Pass/Drop policies (which are Permit/Deny in standard access rules) in the access rules table instead of the zone rules table. Use the zone rules table primarily for zone-based Inspection and Content Filter rules.

 
     
     		 [bookmark: pgfId-249083]Use sections to organize the rules for each zone pair. Sections make it easy for you to see all of the rules for a pair, which can be critical if your rules have sequential dependencies. For more information on working with sections, see Using Sections to Organize Rules Tables.

 
    

 
   
 
    
     [bookmark: pgfId-249093][bookmark: 55590][bookmark: porules_cncpt_ZoneBasedFW_DevelopmentOverview]Developing and Applying Zone-based Firewall Rules[bookmark: marker-249089][bookmark: marker-249091]

 
    [bookmark: pgfId-249095]The following is a general overview of how to develop and apply zone-based firewall rules to your network.

 
     
     		 [bookmark: pgfId-249097]Consider your network, and its sub-networks, in terms of security zones—think about the security requirements of the various zones. As a general guideline, group router interfaces that are similar when viewed from a security perspective.

 
     		 [bookmark: pgfId-249099]Determine the types of traffic to be examined as it travels from one zone to another, decide how each type is to be examined and handled.

 
     		 [bookmark: pgfId-249101]Define zone-based firewall rules that implement these decisions. This process may include some or all of the following procedures, which you can perform prior to defining the rules themselves, or which you can perform as necessary during rule definition:

 
    

 
    [bookmark: pgfId-249103] – Define the zones by creating named Interface Role objects, assigning the appropriate interfaces and interface patterns to them.

 
    [bookmark: pgfId-249105] – Define/edit Port Application Mapping (PAM) settings for specific Layer 4 protocols and ports, and optionally specific networks and hosts.

 
    [bookmark: pgfId-249107] – Configure Deep Packet Inspection (DPI) policies for Layer 7 protocols—HTTP, IMAP, instant messaging (IM), and peer-to-peer (P2P).

 
    [bookmark: pgfId-249109] – Configure Protocol Info parameter maps; these define DNS servers that interact with the IM applications.

 
    [bookmark: pgfId-249111] – Configure Inspect parameter maps that define connection, timeout, and other settings for the Inspect action.

 
    [bookmark: pgfId-249113] – Define WebFilter parameter or policy maps for URL-based content filtering.

 
    [bookmark: pgfId-249115]The following topics provide additional information about these procedures:

 
     
     		 [bookmark: pgfId-249120]Understanding Map Objects

 
     		 [bookmark: pgfId-249125]Configuring Content Filtering Maps for Zone-based Firewall Policies

 
     		 [bookmark: pgfId-249130]Configuring Inspection Maps for Zone-based Firewall Policies

 
    

 
   
 
    
     [bookmark: pgfId-249140][bookmark: 55632][bookmark: porules_proc_ZoneBasedFW_AddingRules]Adding Zone-Based Firewall Rules[bookmark: marker-249136][bookmark: marker-249138]

 
    [bookmark: pgfId-249142]This procedure explains how to configure a zone-based firewall rule in Security Manager.

 
    [bookmark: pgfId-249144]Related Topics

 
     
     		 [bookmark: pgfId-249149]Understanding the Zone-based Firewall Rules

 
     		 [bookmark: pgfId-249154]Configuring Settings for Zone-based Firewall Rules

 
     		 [bookmark: pgfId-249159]Understanding Map Objects

 
     		 [bookmark: pgfId-249164]Enabling and Disabling Rules

 
     		 [bookmark: pgfId-249169]Adding and Removing Rules

 
     		 [bookmark: pgfId-249174]Moving Rules and the Importance of Rule Order

 
    

 
    
 
    [bookmark: pgfId-249179]Step 1 Access the Zone-based Firewall Rules Page as follows:

 
     
     		 [bookmark: pgfId-249181](Device view) Select an IOS router and then select  Firewall > Zone Based Firewall Rules from the Policy selector.

 
     		 [bookmark: pgfId-249183](Policy view) Select  Firewall > Zone Based Firewall Rules from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-249185]Step 2 Click the Add Row button below the rules table, or right-click anywhere inside the table, and choose Add Row to open the Add Zone Based Firewall Rule dialog box.

 
    [bookmark: pgfId-249190]Refer to Adding and Editing Zone-based Firewall Rules for a complete description of this dialog box.

 
    [bookmark: pgfId-249192]Step 3 Define the base Traffic flow for this rule.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-249194]Note Together, the Permit/Deny, Sources, Destinations, and Services options can be thought of as defining a simple access rule that can be enhanced by the application of in-depth Action-related policies, and restricted to a specific direction between a specific pair of zones.


    
     

    

    

 
    [bookmark: pgfId-249199] a. Choose whether to Permit or Deny further processing of traffic that matches this rule. See Understanding the Relationship Between Permit/Deny and Action in Zone-based Firewall Rules for more information.

 
    [bookmark: pgfId-249201] b. Optionally, provide Source and Destination hosts/networks or Security Groups (IOS 15.2(2)T+ and IOS-XE 3.5.x(15.2(1)S)+ only).

 
    [bookmark: pgfId-249209]By default, the traffic definition encompasses packets from “any” source, to “any” destination. You can use these fields to refine this base traffic definition by providing one or more source and destination hosts/networks. (See Understanding Networks/Hosts Objects and Selecting Security Groups in Policies for more information.)

 
    [bookmark: pgfId-249211] c. Specify one or more Services (protocols) that indicate the type of traffic; for example, IP, TCP, etc.

 
    [bookmark: pgfId-249216]You can provide more than one Service; however, IP generally stands alone. (See Understanding and Specifying Services and Service and Port List Objects.)

 
    [bookmark: pgfId-249218] d. Provide the From Zone; that is, the only zone from which matched traffic can originate.

 
    [bookmark: pgfId-249220] e. Provide the To Zone; that is, the only zone to which matched traffic can flow.

 
    [bookmark: pgfId-249225]Refer to Understanding Interface Role Objects for more information about zone/interface objects.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-249227]Note Together, the From Zone and the To Zone constitute what is sometimes referred to as a “zone-pair.”


    
     

    

    

 
    [bookmark: pgfId-249229] f. Click the Advanced button to add a time range, or to apply a packet-fragment or an established-connection restriction to this zone-based firewall rule.

 
    [bookmark: pgfId-249234]See Zone-based Firewall Rule: Advanced Options Dialog Box for more information about these options.

 
    [bookmark: pgfId-249236]Step 4 Specify the actions to be applied to traffic matching this definition by choosing a base Action, and supplying additional parameters as necessary.

 
    [bookmark: pgfId-249238] a. Choose a base Action:

 
     
     		 [bookmark: pgfId-249240] Drop – Matching traffic is silently dropped; no notification of the drop is sent to the originating host.

 
     		 [bookmark: pgfId-249242] Drop and Log – Matching traffic is dropped and a syslog message generated; no notification of the drop is sent to the originating host.

 
     		 [bookmark: pgfId-249244] Pass – Traffic is forwarded. This action is unidirectional; Pass allows traffic in only the specified direction.

 
     		 [bookmark: pgfId-249246] Pass and Log – Traffic is forwarded and a syslog message generated.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-249248]Note The Pass actions do not track the state of connections or sessions within the traffic. Pass only allows the traffic in one direction. A corresponding rule must be defined to allow return traffic. The Pass actions are useful for protocols such as IPSec ESP, IPSec AH, ISAKMP, and other inherently secure protocols with predictable behavior. However, most application traffic is better handled in the zone-based firewall rules with the Inspect action.


    
     

    

    

 
     
     		 [bookmark: pgfId-249250] Inspect – This option offers state-based traffic control—the device maintains connection or session information for TCP and UDP traffic, meaning return traffic in reply to connection requests is permitted.

 
    

 
    [bookmark: pgfId-249252]Choose this option to apply packet inspection based on your selected Layer 4 (TCP, UDP) and Layer 7 (HTTP, IMAP, instant messaging, and peer-to-peer) protocols. You also can edit the Port Application Mapping (PAM) settings for the selected protocols, and you can set up deep packet inspection (DPI) and provide additional protocol-related information for the Layer 7 protocols.

 
     
     		 [bookmark: pgfId-249254] Content Filter – Lets you configure HTTP content inspection (URL filtering) based on a WebFilter parameter map, or a WebFilter policy map. This action is generally equivalent to a Web Filter rule; however, zone-based firewall rules support additional advanced options, such as HTTP deep packet inspection (DPI).

 
    

 
    [bookmark: pgfId-249256]The router intercepts HTTP requests, performs protocol-related inspection, and optionally contacts a third-party server to determine whether the requests should be allowed or blocked. You can provide a WebFilter parameter map, which defines filtering based on local URL lists, as well as information from an external SmartFilter (previously N2H2) or Websense server. Alternately, you can provide a WebFilter policy map that accesses Local, N2H2, Websense, or Trend Micro filtering data.

 
    [bookmark: pgfId-249258] b. For any Action except Content Filter, you can select and edit the specific traffic Protocol(s) to be considered:

 
    [bookmark: pgfId-249266]Click Select next to the Protocol table to open the Protocol Selector Dialog Box. Select one or more protocols and click >> to move them to the Selected Protocol list. You can edit the Port Application Mapping (PAM) settings for the selected protocols; see Configure Protocol Dialog Box for more information.

 
    [bookmark: pgfId-249268]The Instant Messaging and Stun-ice protocols also allow selection of Protocol Info parameter maps. Further, when Inspect is the chosen Action, some protocols allow selection of deep-inspection policy maps.

 
    [bookmark: pgfId-249276]See Configuring Inspection Maps for Zone-based Firewall Policies, and Configuring Protocol Info Parameter Maps for more information.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-249278]Note It is not necessary to specify protocols for the Drop, Drop and Log, Pass, and Pass and Log actions. You can leave the Protocol table empty and pass or drop traffic based on the Sources, Destinations, and Services parameters.


    
     

    

    

 
    [bookmark: pgfId-249280] c. When the chosen Action is Content Filter, configure the URL filtering:

 
    [bookmark: pgfId-249285] 1. Click Configure next to the Protocol field to customize the HTTP PAM settings, and to apply an HTTP deep-inspection policy map. See the Configure Protocol Dialog Box for more information

 
    [bookmark: pgfId-249290] 2. Select either WebFilter Parameter Map, or WebFilter Policy Map, and enter or Select the name of the appropriate WebFilter map. See Configuring Content Filtering Maps for Zone-based Firewall Policies for more information.

 
    [bookmark: pgfId-249295] d. When the chosen Action is Inspect or Content Filter, you can enter or Select the name of an Inspect Parameter map to apply a customized set of connection, timeout, and other settings. See Configuring Inspect Parameter Maps for more information.

 
    [bookmark: pgfId-249297]Step 5 (Optional) Enter a description to help you identify the rule.

 
    [bookmark: pgfId-249302]Step 6 (Optional) Under Category, select a category to help you identify this rule in the rules table. See Using Category Objects.

 
    [bookmark: pgfId-249304]Step 7 Click OK to close the Add Zone Based Firewall Rule dialog box and return to the Zone Based Firewall Rules table.

 
    [bookmark: pgfId-249306]The new rule is listed in the table.

 
    [bookmark: pgfId-249308]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-249390][bookmark: 55767][bookmark: obman_cncpt_ConfiguringMapsforInspectioninZoneBasedFirewallRulesPolicies]Configuring Inspection Maps for Zone-based Firewall Policies [bookmark: marker-249314][bookmark: marker-249316][bookmark: marker-249318][bookmark: marker-249320][bookmark: marker-249322][bookmark: marker-249324][bookmark: marker-249326][bookmark: marker-249328][bookmark: marker-249330][bookmark: marker-249332][bookmark: marker-249334][bookmark: marker-249336][bookmark: marker-249338][bookmark: marker-249340][bookmark: marker-249342][bookmark: marker-249344][bookmark: marker-249346][bookmark: marker-249348][bookmark: marker-249350][bookmark: marker-249352][bookmark: marker-249354][bookmark: marker-249356][bookmark: marker-249358][bookmark: marker-249360][bookmark: marker-249362][bookmark: marker-249364][bookmark: marker-249366][bookmark: marker-249368][bookmark: marker-249370][bookmark: marker-249372][bookmark: marker-249374][bookmark: marker-249376][bookmark: marker-249378][bookmark: marker-249380][bookmark: marker-249382][bookmark: marker-249384][bookmark: marker-249386][bookmark: marker-249388]

 
    [bookmark: pgfId-249392]When you configure zone-based firewall policies for a router, you can define rules to inspect traffic by choosing Inspect as the Action for the rule. You can then select the specific protocols to inspect.

 
    [bookmark: pgfId-249394]For some protocols, you can select policy maps to perform deep inspection on packets that match your criteria. You can configure these maps from the policy object selector dialog box while defining the rule, or at any time in the Policy Object Manager window (select Manage > Policy Objects). In addition to policy maps, there are some parameter maps you can configure for inspection.

 
     
     		 [bookmark: pgfId-249399]For protocols that allow deep inspection, you can select a related policy map, which in turn incorporates class maps that define match conditions for the targeted traffic. To create these policy maps in the Policy Object Manager, select one of the available map types (which are listed in the following table) from the  Maps > Policy Maps > Inspect folder, and review the detailed usage information in Configuring Policy Maps for Zone-Based Firewall Policies.

 
    

 
     
      
       
       [bookmark: pgfId-244843]Table 21-2 [bookmark: 55915]Policy Objects for Zone-based Firewall Inspection Rules 

 
       
      
        
        		
          
          [bookmark: pgfId-244857]Protocol
         
  
        		
          
          [bookmark: pgfId-244859]Minimum IOS Software Version
         
  
        		
          
          [bookmark: pgfId-244861]Policy Map
         
  
        		
          
          [bookmark: pgfId-244863]Class Map
         
  
        		
          
          [bookmark: pgfId-244865]Parameter Map
         
  
        		
          
          [bookmark: pgfId-244867]Description and Match Criteria Reference
         
  
       

 
        
        		[bookmark: pgfId-244881]Instant Messaging: AOL, ICQ, MSN Messenger, Windows Messenger, Yahoo Messenger

  
        		[bookmark: pgfId-244883]12.4(9)T

  
        		[bookmark: pgfId-244885]IM (Zone based IOS)

  
        		[bookmark: pgfId-244887]AOL

 [bookmark: pgfId-244889]ICQ

 [bookmark: pgfId-244891]MSN Messenger

 [bookmark: pgfId-244893]Windows Messenger

 [bookmark: pgfId-244895]Yahoo Messenger

  
        		[bookmark: pgfId-244897]Protocol Info

  
        		[bookmark: pgfId-244902]Inspect traffic based on the type of service (text-chat or any other). See Zone-based Firewall IM Application Class Maps: Add or Edit Match Condition Dialog Boxes.

 [bookmark: pgfId-244907]You must also select a Protocol Info parameter map to define the DNS servers used by the traffic you are inspecting. See Configuring Protocol Info Parameter Maps.

  
       

 
        
        		[bookmark: pgfId-244921]Peer-to-peer (P2P): eDonkey, FastTrack, Gnutella, Kazaa2

  
        		[bookmark: pgfId-244923]12.4(9)T

  
        		[bookmark: pgfId-244925]P2P

  
        		[bookmark: pgfId-244927]eDonkey

 [bookmark: pgfId-244929]FastTrack

 [bookmark: pgfId-244931]Gnutella

 [bookmark: pgfId-244933]Kazaa2

  
        		[bookmark: pgfId-244935]None

  
        		[bookmark: pgfId-244940]Inspect traffic based on file name. See Zone-based Firewall P2P Application Class Maps: Add or Edit Match Condition Dialog Boxes.

  
       

 
        
        		[bookmark: pgfId-244954]H.323

  
        		[bookmark: pgfId-244956]12.4(6)T

  
        		[bookmark: pgfId-244958]H.323 (IOS)

  
        		[bookmark: pgfId-244960]H.323 (IOS)

  
        		[bookmark: pgfId-244962]None

  
        		[bookmark: pgfId-244967]Inspect traffic based on the H.323 message type. See H.323 (IOS) Class Maps Add or Edit Match Criterion Dialog Boxes.

  
       

 
        
        		[bookmark: pgfId-244981]HTTP

  
        		[bookmark: pgfId-244983]12.4(6)T

  
        		[bookmark: pgfId-244985]HTTP (Zone based IOS)

  
        		[bookmark: pgfId-244987]HTTP (IOS)

  
        		[bookmark: pgfId-244989]None

  
        		[bookmark: pgfId-244994]Inspect traffic based on a wide variety of criteria including the content of the header or body, port misuse, and whether the traffic includes a Java applet. See HTTP (IOS) Class Add or Edit Match Criterion Dialog Boxes.

  
       

 
        
        		[bookmark: pgfId-245008]IMAP (Internet Message Access Protocol)

 [bookmark: pgfId-245010]POP3 (Post Office Protocol 3)

  
        		[bookmark: pgfId-245012]12.4(6)T

  
        		[bookmark: pgfId-245014]IMAP

 [bookmark: pgfId-245016]POP3

  
        		[bookmark: pgfId-245018]IMAP

 [bookmark: pgfId-245020]POP3

  
        		[bookmark: pgfId-245022]None

  
        		[bookmark: pgfId-245027]Inspect traffic based on invalid commands or clear-text logins. See IMAP and POP3 Class Maps Add or Edit Match Criterion Dialog Boxes.

  
       

 
        
        		[bookmark: pgfId-245041]SIP (Session Initiation Protocol)

  
        		[bookmark: pgfId-245043]12.4(6)T

  
        		[bookmark: pgfId-245045]SIP (IOS)

  
        		[bookmark: pgfId-245047]SIP (IOS)

  
        		[bookmark: pgfId-245049]None

  
        		[bookmark: pgfId-245054]Inspect traffic based on a wide variety of criteria. See SIP (IOS) Class Add or Edit Match Criterion Dialog Boxes.

  
       

 
        
        		[bookmark: pgfId-245068]SMTP (Simple Mail Transfer Protocol)

  
        		[bookmark: pgfId-245070]12.4(6)T

  
        		[bookmark: pgfId-245072]SMTP

  
        		[bookmark: pgfId-245074]SMTP

  
        		[bookmark: pgfId-245076]None

  
        		[bookmark: pgfId-245081]Inspect traffic based on data length. See SMTP Class Maps Add or Edit Match Criterion Dialog Boxes.

  
       

 
        
        		[bookmark: pgfId-245095]Stun-ice

  
        		[bookmark: pgfId-245097]12.4(9)T

  
        		[bookmark: pgfId-245099]None

  
        		[bookmark: pgfId-245101]None

  
        		[bookmark: pgfId-245103]Protocol Info

  
        		[bookmark: pgfId-245108]You must select a Protocol Info parameter map to define the DNS servers used by the traffic you are inspecting. See Configuring Protocol Info Parameter Maps.

  
       

 
        
        		[bookmark: pgfId-245122]Sun RPC (Remote Procedure Call)

  
        		[bookmark: pgfId-245124]12.4(6)T

  
        		[bookmark: pgfId-245126]Sun RPC

  
        		[bookmark: pgfId-245128]Sun RPC

  
        		[bookmark: pgfId-245130]None

  
        		[bookmark: pgfId-245135]Inspect traffic based on the RPC protocol number. See Sun RPC Class Maps Add or Edit Match Criterion Dialog Boxes.

  
       

 
      
     

 
    
 
    [bookmark: pgfId-249417]Related Topics

 
     
     		 [bookmark: pgfId-249422]Understanding the Zone-based Firewall Rules

 
     		 [bookmark: pgfId-249427]Zone-based Firewall Rules Page

 
     		 [bookmark: pgfId-249432]Creating Policy Objects

 
     		 [bookmark: pgfId-249437]Understanding Map Objects

 
    

 
     
      [bookmark: pgfId-249529][bookmark: 56086][bookmark: pobjpage_cncpt_ClassMapsDialogBoxesZBF]Configuring Class Maps for Zone-Based Firewall Policies[bookmark: marker-249447][bookmark: marker-249449][bookmark: marker-249451][bookmark: marker-249453][bookmark: marker-249455][bookmark: marker-249457][bookmark: marker-249459][bookmark: marker-249461][bookmark: marker-249463][bookmark: marker-249465][bookmark: marker-249467][bookmark: marker-249469][bookmark: marker-249471][bookmark: marker-249473][bookmark: marker-249475][bookmark: marker-249477][bookmark: marker-249479][bookmark: marker-249481][bookmark: marker-249483][bookmark: marker-249485][bookmark: marker-249487][bookmark: marker-249489][bookmark: marker-249491][bookmark: marker-249493][bookmark: marker-249495][bookmark: marker-249497][bookmark: marker-249499][bookmark: marker-249501][bookmark: marker-249503][bookmark: marker-249505][bookmark: marker-249507][bookmark: marker-249509][bookmark: marker-249511][bookmark: marker-249513][bookmark: marker-249515][bookmark: marker-249517][bookmark: marker-249519][bookmark: marker-249521][bookmark: marker-249523][bookmark: marker-249525][bookmark: marker-249527]

 
     [bookmark: pgfId-249531]Use the Add and Edit Class Map dialog boxes to define class maps to be used in policy maps of the same type. The name of the dialog box indicates the type of map you are creating.

 
     [bookmark: pgfId-249533]A class map defines application traffic based on criteria specific to the application. You then select the class map in the corresponding policy map and configure the action to take for the selected traffic. Thus, each class map must contain traffic that you want to handle in the same way (for example, to allow it or to drop it).

 
     [bookmark: pgfId-249535]When configuring zone-based firewall rules for devices running Cisco IOS Software, you can create class maps for the following purposes:

 
      
      		 [bookmark: pgfId-249537]For 12.4(6)T and higher, you can create classes for the inspection of the following types of traffic: H.323, HTTP, IMAP, POP3, SIP, SMTP, and Sun RPC. You can create classes for web filtering using the following class types: Local, N2H2 (SmartFilter), and WebSense. See the following topics for information on the match criteria:

 
     

 
     [bookmark: pgfId-249542] – H.323 (IOS) Class Maps Add or Edit Match Criterion Dialog Boxes

 
     [bookmark: pgfId-249547] – HTTP (IOS) Class Add or Edit Match Criterion Dialog Boxes

 
     [bookmark: pgfId-249552] – IMAP and POP3 Class Maps Add or Edit Match Criterion Dialog Boxes

 
     [bookmark: pgfId-249557] – SIP (IOS) Class Add or Edit Match Criterion Dialog Boxes

 
     [bookmark: pgfId-249562] – SMTP Class Maps Add or Edit Match Criterion Dialog Boxes

 
     [bookmark: pgfId-249567] – Sun RPC Class Maps Add or Edit Match Criterion Dialog Boxes

 
     [bookmark: pgfId-249572] – Local Web Filter Class Add or Edit Match Criterion Dialog Boxes

 
     [bookmark: pgfId-249577] – N2H2 and Websense Class Add or Edit Match Criterion Dialog Boxes

 
      
      		 [bookmark: pgfId-249579]For 12.4(9)T and higher, you can create classes for the inspection of the following types of traffic: AOL, eDonkey, FastTrack, Gnutella, ICQ, Kazaa2, MSN Messenger, Windows Messenger, and Yahoo Messenger. See the following topics for information on the match criteria:

 
     

 
     [bookmark: pgfId-249584] – Zone-based Firewall IM Application Class Maps: Add or Edit Match Condition Dialog Boxes

 
     [bookmark: pgfId-249589] – Zone-based Firewall P2P Application Class Maps: Add or Edit Match Condition Dialog Boxes

 
      
      		 [bookmark: pgfId-249591]For 12.4(20)T and higher, you can create classes for web filtering using the Trend policy object. Match criteria for Trend Content Filter class maps is described in the table below.

 
     

 
     [bookmark: pgfId-249593]Navigation Path

 
     [bookmark: pgfId-249595]Select Manage > Policy Objects, then select any zone-based class map object in the folders in the Maps > Class Maps folder in the table of contents. Right-click inside the work area, then select New Object, or right-click a row, then select Edit Object.

 
     [bookmark: pgfId-249597]Related Topics

 
      
      		 [bookmark: pgfId-249602]Understanding Map Objects

 
      		 [bookmark: pgfId-249607]Configuring Inspection Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-249612]Configuring Content Filtering Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-249617]Understanding the Zone-based Firewall Rules

 
     

 
     [bookmark: pgfId-249619]Field Reference

 
     [bookmark: pgfId-249622] 

 
      
       
        
        [bookmark: pgfId-245148]Table 21-3 [bookmark: 56242]Add or Edit Class Maps Dialog Boxes for Zone-Based Firewall Policies 

 
        
       
         
         		
           
           [bookmark: pgfId-245154]Element
          
  
         		
           
           [bookmark: pgfId-245156]Description
          
  
        

 
         
         		[bookmark: pgfId-245162]Name

  
         		[bookmark: pgfId-245164]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-245170]Description

  
         		[bookmark: pgfId-245172]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-245178]Match table

 [bookmark: pgfId-245180]Match Type

 [bookmark: pgfId-245182](Except for Trend Content Filter class maps.)

  
         		[bookmark: pgfId-245184]The Match table lists the criteria included in the class map. Each row indicates whether the inspection is looking for traffic that matches or does not match each criterion and the criterion and value that is inspected.

 [bookmark: pgfId-245186]The name of the table indicates whether every one of the criteria must be met for the traffic to match the class (Match All), or whether matching any of the listed criteria is sufficient (Match Any). For the HTTP (IOS) and SMTP classes, you can choose whether to match all or any. When using a Match All table, if you add more than one criteria, ensure that you are not defining a set of characteristics that no traffic can match.

 [bookmark: pgfId-245188]Tip Match All works for devices running Cisco IOS Software version 12.4(20)T or higher only. 
           
           		 [bookmark: pgfId-245190]To add a criterion, click the Add button and fill in the Match Criterion dialog box. For more information, see the topics referenced above.

 
           		 [bookmark: pgfId-245192]To edit a criterion, select it and click the Edit button.

 
           		 [bookmark: pgfId-245194]To delete a criterion, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-245200]Trend Content Filter Match Criteria

  
         		[bookmark: pgfId-245202]The match criteria for Trend Content Filter class maps differs from that of all other class maps. Instead of adding items to a table, you simply select the items you want from a list. Select the Enable checkbox for any of the Trend-Micro classifications on the following tabs. Traffic matches the class if it matches any of your selections.

 
           
           		 [bookmark: pgfId-245206]Productivity Categories—Matches the traffic to the category to which the URL belongs. For example, you can target traffic associated with gambling or pornography.[bookmark: marker-245204]

 
           		 [bookmark: pgfId-245210]Security Ratings—Matches the traffic to the security rating assigned to it by Trend-Micro. For example, you can target adware, which is traffic associated with advertising.[bookmark: marker-245208]

 
          

 [bookmark: pgfId-245212]See the Trend-Micro documentation for specific information on these categories or security classifications.

  
        

 
         
         		[bookmark: pgfId-245218]Category

  
         		[bookmark: pgfId-245223]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-245229]Allow Value Override per Device

 [bookmark: pgfId-245231]Overrides

 [bookmark: pgfId-245233]Edit button

  
         		[bookmark: pgfId-245241]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-245243]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-249664][bookmark: 56311][bookmark: pobjpage_cncpt_ZoneBasedFirewallIMApplicationsMatchCriterionDialogBoxes]Zone-based Firewall IM Application Class Maps: Add or Edit Match Condition Dialog Boxes [bookmark: marker-249630][bookmark: marker-249632][bookmark: marker-249634][bookmark: marker-249636][bookmark: marker-249638][bookmark: marker-249640][bookmark: marker-249642][bookmark: marker-249644][bookmark: marker-249646][bookmark: marker-249648][bookmark: marker-249650][bookmark: marker-249652][bookmark: marker-249654][bookmark: marker-249656][bookmark: marker-249658][bookmark: marker-249660][bookmark: marker-249662]

 
     [bookmark: pgfId-249666]Use the Add or Edit Match Criterion dialog boxes for the various instant messenger (IM) application classes used with zone-based firewall policies to define a match criterion and value for the class map.

 
     [bookmark: pgfId-249668]You can define a match for the following types of traffic:

 
      
      		 [bookmark: pgfId-249670]Any—Any type of traffic from the application except text chat traffic.

 
      		 [bookmark: pgfId-249672]Text-chat—Text chat traffic.

 
     

 
     [bookmark: pgfId-249674]Navigation Path

 
     [bookmark: pgfId-249679]From the Add or Edit Class Maps dialog boxes for AOL, ICQ, MSN Messenger, Windows Messenger, or Yahoo Messenger classes, right-click inside the table and select Add Row or right-click a row and select Edit Row. See Configuring Class Maps for Zone-Based Firewall Policies.

 
     [bookmark: pgfId-249681]Related Topics

 
      
      		 [bookmark: pgfId-249686]Understanding Map Objects

 
      		 [bookmark: pgfId-249691]Configuring Inspection Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-249696]Understanding the Zone-based Firewall Rules

 
     

 
    
 
     
      [bookmark: pgfId-249732][bookmark: 56391][bookmark: pobjpage_cncpt_ZoneBasedFirewallP2PApplicationsMatchCriterionDialogBoxes]Zone-based Firewall P2P Application Class Maps: Add or Edit Match Condition Dialog Boxes [bookmark: marker-249704][bookmark: marker-249706][bookmark: marker-249708][bookmark: marker-249710][bookmark: marker-249712][bookmark: marker-249714][bookmark: marker-249716][bookmark: marker-249718][bookmark: marker-249720][bookmark: marker-249722][bookmark: marker-249724][bookmark: marker-249726][bookmark: marker-249728][bookmark: marker-249730]

 
     [bookmark: pgfId-249734]Use the Add or Edit Match Criterion dialog boxes for the various peer-to-peer (P2P) application classes used with zone-based firewall policies to define a match criterion and value for the class map.

 
     [bookmark: pgfId-249736]Navigation Path

 
     [bookmark: pgfId-249741]From the Add or Edit Class Maps dialog boxes for eDonkey, FastTrack, Gnutella, or Kazaa2 classes, right-click inside the table and select Add Row, or right-click a row and select Edit Row. See Configuring Class Maps for Zone-Based Firewall Policies.

 
     [bookmark: pgfId-249743]Related Topics

 
      
      		 [bookmark: pgfId-249748]Understanding Map Objects

 
      		 [bookmark: pgfId-249753]Configuring Inspection Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-249758]Understanding the Zone-based Firewall Rules

 
     

 
     [bookmark: pgfId-249760]Field Reference

 
     [bookmark: pgfId-249763] 

 
      
       
        
        [bookmark: pgfId-245256]Table 21-4 [bookmark: 56458]Zone-based Firewall P2P Application Class Maps Add or Edit Match Condition Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-245262]Element
          
  
         		
           
           [bookmark: pgfId-245264]Description
          
  
        

 
         
         		[bookmark: pgfId-245270]Criterion

  
         		[bookmark: pgfId-245272]Choose which criterion to match:

 
           
           		 [bookmark: pgfId-245274]File Transfer – Matches file-transfer traffic.

 
           		 [bookmark: pgfId-245276]Search Filename – Matches the names of files for which the user is searching. You can use this criterion to block users from searching for particular files using eDonkey.

 
           		 [bookmark: pgfId-245278]Text Chat – Matches eDonkey text chat traffic.

 
          

  
        

 
         
         		[bookmark: pgfId-245284]Type

  
         		[bookmark: pgfId-245286]Specifies that the map includes traffic that matches the criterion.

  
        

 
         
         		[bookmark: pgfId-245292]File Name

  
         		[bookmark: pgfId-245297]The name of the file associated with the traffic. You can use regular expressions to specify a name pattern. For information on the metacharacters you can use to build regular expressions, see Metacharacters Used to Build Regular Expressions.

 [bookmark: pgfId-245299]Tip eDonkey does not require a file name.  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-249777][bookmark: 56493][bookmark: pobjpage_cncpt_H323IOSMatchCriterionDialogBoxes]H.323 (IOS) Class Maps Add or Edit Match Criterion Dialog Boxes [bookmark: marker-249771][bookmark: marker-249773][bookmark: marker-249775]

 
     [bookmark: pgfId-249779]Use the Add or Edit Match Criterion dialog boxes for the H.323 (IOS) class used with zone-based firewall policies to define a match criterion and value for the class map. You can match traffic based on the H.323 protocol message type. Select the message that you want to match.

 
     [bookmark: pgfId-249781]Navigation Path

 
     [bookmark: pgfId-249786]From the Add or Edit Class Maps dialog boxes for the H.323 (IOS) class, right-click inside the table and select Add Row or right-click a row and select Edit Row. See Configuring Class Maps for Zone-Based Firewall Policies.

 
     [bookmark: pgfId-249788]Related Topics

 
      
      		 [bookmark: pgfId-249793]Understanding Map Objects

 
      		 [bookmark: pgfId-249798]Configuring Inspection Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-249803]Understanding the Zone-based Firewall Rules

 
     

 
    
 
     
      [bookmark: pgfId-249817][bookmark: 56526][bookmark: pobjpage_cncpt_HTTPIOSMatchCriterionDialogBoxes]HTTP (IOS) Class Add or Edit Match Criterion Dialog Boxes [bookmark: marker-249811][bookmark: marker-249813][bookmark: marker-249815]

 
     [bookmark: pgfId-249819]Use the Add or Edit Match Criterion dialog boxes for the HTTP (IOS) class used with zone-based firewall policies to define a match criterion and value for the class map.

 
     [bookmark: pgfId-249821]The fields on this dialog box change based on the criterion you select. You can use the following criteria:

 
      
      		 [bookmark: pgfId-249823]Request/Response Body Length, Request Body Length, Response Body Length—Specifies that the body length of the request, response, or both, is less than or greater than the specified number. This allows you to set a minimum or maximum message length.

 
      		 [bookmark: pgfId-249825]Request/Response Body, Request Body, Response Body—Applies a regular expression to match the body of the request, response, or both.

 
      		 [bookmark: pgfId-249827]Request/Response Header, Request Header, Response Header—You can match a regular expression against the header, test for repeated fields, check the content type, or check the total length or number of records in the header.

 
      		 [bookmark: pgfId-249829]Request/Response Protocol Violation—Matches non-compliant HTTP traffic.

 
      		 [bookmark: pgfId-249831]Request Argument, Request URI—Matches the length or content (with a regular expression) of the argument (parameters) or uniform resource identifier (URI) in a request message.

 
      		 [bookmark: pgfId-249833]Request Port Misuse—Matches the misuse of ports by certain types of applications.

 
      		 [bookmark: pgfId-249835]Response Body Java Applet—Matches Java applets in an HTTP connection.

 
      		 [bookmark: pgfId-249837]Response Header Status Line—Applies a regular expression to match the content of the status line in the header.

 
     

 
     [bookmark: pgfId-249839]Navigation Path

 
     [bookmark: pgfId-249844]From the Add or Edit Class Maps dialog boxes for the HTTP (IOS) class, right-click inside the table and select Add Row or right-click a row and select Edit Row. See Configuring Class Maps for Zone-Based Firewall Policies.

 
     [bookmark: pgfId-249846]Related Topics

 
      
      		 [bookmark: pgfId-249851]Understanding Map Objects

 
      		 [bookmark: pgfId-249856]Configuring Inspection Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-249861]Configuring Content Filtering Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-249866]Understanding the Zone-based Firewall Rules

 
     

 
     [bookmark: pgfId-249868]Field Reference

 
     [bookmark: pgfId-249871] 

 
      
       
        
        [bookmark: pgfId-245312]Table 21-5 [bookmark: 56581]HTTP (IOS) Class Add or Edit Match Criterion Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-245318]Element
          
  
         		
           
           [bookmark: pgfId-245320]Description
          
  
        

 
         
         		[bookmark: pgfId-245326]Criterion

  
         		[bookmark: pgfId-245328]Specifies which criterion of HTTP traffic to match. The criteria are described above.

  
        

 
         
         		[bookmark: pgfId-245334]Type

  
         		[bookmark: pgfId-245336]Specifies that the map includes traffic that matches the criterion.

  
        

 
         
         		 [bookmark: pgfId-245342]Variable Fields

 [bookmark: pgfId-245344]The following fields vary based on what you select in the Criterion field. This list is a super-set of the fields you might see.

  
        

 
         
         		[bookmark: pgfId-245352]Less Than Length

  
         		[bookmark: pgfId-245354]The minimum length in bytes of the evaluated field. The criterion matches if the length is less than the specified number.

  
        

 
         
         		[bookmark: pgfId-245360]Greater Than Length

  
         		[bookmark: pgfId-245362]The maximum length in bytes of the evaluated field. The criterion matches if the length is greater than the specified number.

  
        

 
         
         		[bookmark: pgfId-245368]Header Option

  
         		[bookmark: pgfId-245370]The type of header record. If you do not select a record type, the count or expression is applied to all records in the header. If you select a record type, those selections are applied only to the records of the selected type. If you select content type or transfer encoding, you can make additional selections related to those types.

  
        

 
         
         		[bookmark: pgfId-245376]Request Method

  
         		[bookmark: pgfId-245378]The request method you want to match.

  
        

 
         
         		[bookmark: pgfId-245384]Value (Content Type)

  
         		[bookmark: pgfId-245386]If you select content-type in the Header Option field, you can select these types:

 
           
           		 [bookmark: pgfId-245388]Mismatch—Verifies the content-type of the response message against the accept field value of the request message.

 
           		 [bookmark: pgfId-245390]Unknown—The content type is not known. Select Unknown when you want to evaluate the item against all known MIME types.

 
           		 [bookmark: pgfId-245392]Violation—The content-type definition and the content type of the actual body do not match.

 
          

  
        

 
         
         		[bookmark: pgfId-245398]Encoding Type

  
         		[bookmark: pgfId-245400]If you select transfer encoding in the Header Option field, you can select these types:

 
           
           		 [bookmark: pgfId-245402]All—All of the transfer encoding types.

 
           		 [bookmark: pgfId-245404]Chunked—The message body is transferred as a series of chunks; each chunk contains its own size indicator.

 
           		 [bookmark: pgfId-245406]Compress—The message body is transferred using UNIX file compression.

 
           		 [bookmark: pgfId-245408]Deflate—The message body is transferred using zlib format (RFC 1950) and deflate compression (RFC 1951).

 
           		 [bookmark: pgfId-245410]GZIP—The message body is transferred using GNU zip (RFC 1952).

 
           		 [bookmark: pgfId-245412]Identity—No transfer encoding is performed.

 
          

  
        

 
         
         		[bookmark: pgfId-245418]Greater Than Count

  
         		[bookmark: pgfId-245420]The maximum number of records allowed in the header. If you select a specific header option, the count applies to those types of records. If you do not select a specific header option, the count applies to the total number of records in the header without regard to type.

  
        

 
         
         		[bookmark: pgfId-245426]Regular Expression

  
         		[bookmark: pgfId-245428]The regular expression object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click Select to choose the object from a list of existing ones or to create a new regular expression object.

  
        

 
         
         		[bookmark: pgfId-245434]Port Misuse

  
         		[bookmark: pgfId-245436]The type of request port misuse you want to match. Your options are:

 
           
           		 [bookmark: pgfId-245438]Any—Any of the listed types of misuse.

 
           		 [bookmark: pgfId-245440]IM—Instant messaging protocol applications subject to inspection.

 
           		 [bookmark: pgfId-245442]P2P—Peer-to-peer protocol applications subject to inspection.

 
           		 [bookmark: pgfId-245444]Tunneling—Tunneling applications subject to inspection: HTTPPort/HTTPHost.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-249891][bookmark: 56683][bookmark: pobjpage_cncpt_IMAPPOP3MatchCriterionDialogBoxes]IMAP and POP3 Class Maps Add or Edit Match Criterion Dialog Boxes [bookmark: marker-249879][bookmark: marker-249881][bookmark: marker-249883][bookmark: marker-249885][bookmark: marker-249887][bookmark: marker-249889]

 
     [bookmark: pgfId-249893]Use the Add or Edit Match Criterion dialog boxes for the Internet Message Access Protocol (IMAP) and Post Office Protocol 3 (POP3) classes used with zone-based firewall policies to define a match criterion and value for the class map.

 
     [bookmark: pgfId-249895]You can select the following criteria to identify matching traffic:

 
      
      		 [bookmark: pgfId-249897]Invalid Command—Matches commands that are not valid on a POP3 server or IMAP connection.

 
      		 [bookmark: pgfId-249899]Login Clear Text—Matches non-secure logins, where the password is being provided in clear text.

 
     

 
     [bookmark: pgfId-249901]Navigation Path

 
     [bookmark: pgfId-249906]From the Add or Edit Class Maps dialog boxes for the IMAP or POP3 classes, right-click inside the table and select Add Row or right-click a row and select Edit Row. See Configuring Class Maps for Zone-Based Firewall Policies.

 
     [bookmark: pgfId-249908]Related Topics

 
      
      		 [bookmark: pgfId-249913]Understanding Map Objects

 
      		 [bookmark: pgfId-249918]Configuring Inspection Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-249923]Understanding the Zone-based Firewall Rules

 
     

 
    
 
     
      [bookmark: pgfId-249937][bookmark: 56730][bookmark: pobjpage_cncpt_SIPIOSMatchCriterionDialogBoxes]SIP (IOS) Class Add or Edit Match Criterion Dialog Boxes [bookmark: marker-249931][bookmark: marker-249933][bookmark: marker-249935]

 
     [bookmark: pgfId-249939]Use the Add or Edit Match Criterion dialog boxes for the SIP (IOS) class used with zone-based firewall policies to define a match criterion and value for the class map.

 
     [bookmark: pgfId-249941]The fields on this dialog box change based on the criterion you select.

 
     [bookmark: pgfId-249943]Navigation Path

 
     [bookmark: pgfId-249948]From the Add or Edit Class Maps dialog boxes for the SIP (IOS) class, right-click inside the table and select Add Row or right-click a row and select Edit Row. See Configuring Class Maps for Zone-Based Firewall Policies.

 
     [bookmark: pgfId-249950]Related Topics

 
      
      		 [bookmark: pgfId-249955]Understanding Map Objects

 
      		 [bookmark: pgfId-249960]Configuring Inspection Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-249965]Understanding the Zone-based Firewall Rules

 
     

 
     [bookmark: pgfId-249967]Field Reference

 
     [bookmark: pgfId-249970] 

 
      
       
        
        [bookmark: pgfId-245457]Table 21-6 [bookmark: 56765]SIP (IOS) Class Add or Edit Match Criterion Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-245463]Element
          
  
         		
           
           [bookmark: pgfId-245465]Description
          
  
        

 
         
         		[bookmark: pgfId-245471]Criterion

  
         		[bookmark: pgfId-245473]Specifies which criterion of traffic to match. You can select from the following:

 
           
           		 [bookmark: pgfId-245475]Protocol Violation—Matches traffic that violates the protocol.

 
           		 [bookmark: pgfId-245477]Request/Response Header Options—Matches a regular expression against the selected request or response header field.

 
           		 [bookmark: pgfId-245479]Request Options—Matches the request method or matches a regular expression against the selected request header field.

 
           		 [bookmark: pgfId-245481]Response Options—Matches a regular expression against the selected response header field or status message.

 
          

  
        

 
         
         		[bookmark: pgfId-245487]Type

  
         		[bookmark: pgfId-245489]Specifies that the map includes traffic that matches the criterion.

  
        

 
         
         		 [bookmark: pgfId-245495]Variable Fields

 [bookmark: pgfId-245497]The following fields vary based on what you select in the Criterion field. This list is a super-set of the fields you might see.

  
        

 
         
         		[bookmark: pgfId-245505]Header

  
         		[bookmark: pgfId-245507]The type of header in the request or response message. The regular expression is matched against the content of headers of the selected type.

  
        

 
         
         		[bookmark: pgfId-245513]Method

  
         		[bookmark: pgfId-245515]The request method you want to inspect:

 
           
           		 [bookmark: pgfId-245517]ack—Acknowledges that the previous message is valid and accepted.

 
           		 [bookmark: pgfId-245519]bye—Signifies the intention to terminate a call.

 
           		 [bookmark: pgfId-245521]cancel—Terminates any pending request.

 
           		 [bookmark: pgfId-245523]info—Communicates mid-session signaling information along the signaling path for the call.

 
           		 [bookmark: pgfId-245525]invite—Sets up a call.

 
           		 [bookmark: pgfId-245527]message—Sends an instant message.

 
           		 [bookmark: pgfId-245529]notify—Informs subscribers of state changes.

 
           		 [bookmark: pgfId-245531]options—Queries the capabilities of another user agent or a proxy server.

 
           		 [bookmark: pgfId-245533]prack—Provides reliable transfer of provisional response messages.

 
           		 [bookmark: pgfId-245535]refer—Indicates that the recipient should contact a third party using the contact information provided in the request.

 
           		 [bookmark: pgfId-245537]register—Includes a contact address to which SIP requests for the address-of-record should be forwarded.

 
           		 [bookmark: pgfId-245539]subscribe—Requests notification of an event or set of events at a later time.

 
           		 [bookmark: pgfId-245541]update—Permits a client to update parameters of a session but has no impact on the state of a dialog.

 
          

  
        

 
         
         		[bookmark: pgfId-245547]Status

  
         		[bookmark: pgfId-245549]The regular expression is matched against the status line in the response.

  
        

 
         
         		[bookmark: pgfId-245555]Regular Expression

  
         		[bookmark: pgfId-245557]The regular expression object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click Select to choose the object from a list of existing ones or to create a new regular expression object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-250000][bookmark: 56849][bookmark: pobjpage_cncpt_SMTPMatchCriterionDialogBoxes]SMTP Class Maps Add or Edit Match Criterion Dialog Boxes [bookmark: marker-249978][bookmark: marker-249980][bookmark: marker-249982][bookmark: marker-249984][bookmark: marker-249986][bookmark: marker-249988][bookmark: marker-249990][bookmark: marker-249992][bookmark: marker-249994][bookmark: marker-249996][bookmark: marker-249998]

 
     [bookmark: pgfId-250002]Use the Add or Edit Match Criterion dialog boxes for the SMTP classes used with zone-based firewall policies to define a match criterion and value for the class map.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-250004]Tip Only the Data Length criterion is available for routers running Cisco IOS Software lower than 12.4(20)T.


     
      

     

     

 
     [bookmark: pgfId-250006]The fields on this dialog box change based on the criterion you select. You can use the following criteria:

 
      
      		 [bookmark: pgfId-250008]Data Length—Specifies that the data length of the traffic is greater than the specified number. You can match the data length of the traffic to determine if the data transferred in an SMTP connection exceeds the specified length in bytes. By default, inspection keeps data length below 20.

 
      		 [bookmark: pgfId-250010]Body Regular Expression—Applies a regular expression to match the content types and content encoding types for text and HTML in the body of an e-mail message. Only text or HTML that uses 7-bit or 8-bit encoding is checked. The regular expression cannot be scanned in messages that use another encoding type (such as base64 or zip files).

 
      		 [bookmark: pgfId-250012]Command Line Length—Specifies that the length of the ESMTP command line not be greater than the specified number. Use this to thwart Denial of Service (DoS) attacks.

 
      		 [bookmark: pgfId-250014]Command Verb—Limits inspection to the selected SMTP or ESMTP command. If you configure inspection for SMTP, all commands are inspected unless you limit them.

 
      		 [bookmark: pgfId-250016]Header Length—Specifies that the length of the SMTP header is greater than the specified number. Use this to thwart DoS attacks by limiting the possible size of the header.

 
      		 [bookmark: pgfId-250018]Header Regular Expression—Applies a regular expression to match the content of the header of an e-mail message. For example, you can use this to test for particular patterns in the subject, from, or to fields.

 
      		 [bookmark: pgfId-250020]Mime Content-Type Regular Expression—Applies a regular expression to match the Multipurpose Internet Message Exchange (MIME) content type of an e-mail attachment. Use this to prevent the transmission of undesired types of attachments.

 
      		 [bookmark: pgfId-250022]Mime Encoding—Specifies the MIME encoding type for e-mail attachments that you want to inspect. You can use this to identify unknown or non-standard encodings to restrict their transmission.

 
      		 [bookmark: pgfId-250024]Recipient Address—Applies a regular expression to match the recipient of an e-mail message in the SMTP RCPT command. Use this to search for a non-existent recipient, which might help you identify the source of spam.

 
      		 [bookmark: pgfId-250026]Recipient Count—Specifies that the number of recipients for an e-mail message cannot be greater than the specified number. Use this to prevent spammers from sending e-mails to a large number of users.

 
      		 [bookmark: pgfId-250028]Recipient Invalid Count—Specifies that the number of invalid recipients for an e-mail message cannot be greater than the specified number. Use this prevent spammers from sending e-mails to a large number common names, where they are fishing for real addresses. SMTP typically replies with a “no such address” message when an address is invalid; by putting a limit on the number of invalid addresses, you can prevent these replies to spammers.

 
      		 [bookmark: pgfId-250030]Reply EHLO—Specifies the service extension parameter in an EHLO server reply. Use this to prevent a client from using a particular service extension.

 
      		 [bookmark: pgfId-250032]Sender Address—Applies a regular expression to match the sender of an e-mail message. Use this to block specific senders, such as known spammers, from sending e-mail messages through the device.

 
     

 
     [bookmark: pgfId-250034]Navigation Path

 
     [bookmark: pgfId-250039]From the Add or Edit Class Maps dialog boxes for SMTP classes, right-click inside the table and select Add Row or right-click a row and select Edit Row. See Configuring Class Maps for Zone-Based Firewall Policies.

 
     [bookmark: pgfId-250041]Related Topics

 
      
      		 [bookmark: pgfId-250046]Understanding Map Objects

 
      		 [bookmark: pgfId-250051]Configuring Inspection Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-250056]Understanding the Zone-based Firewall Rules

 
     

 
     [bookmark: pgfId-250058]Field Reference

 
     [bookmark: pgfId-250061] 

 
      
       
        
        [bookmark: pgfId-245570]Table 21-7 [bookmark: 56936]SMTP Class Add or Edit Match Criterion Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-245576]Element
          
  
         		
           
           [bookmark: pgfId-245578]Description
          
  
        

 
         
         		[bookmark: pgfId-245584]Criterion

  
         		[bookmark: pgfId-245586]Specifies which criterion of SMTP traffic to match. The criteria are described above.

  
        

 
         
         		[bookmark: pgfId-245592]Type

  
         		[bookmark: pgfId-245594]Specifies that the map includes traffic that matches the criterion.

  
        

 
         
         		 [bookmark: pgfId-245600]Variable Fields

 [bookmark: pgfId-245602]The following fields vary based on what you select in the Criterion field. This list is a super-set of the fields you might see.

  
        

 
         
         		[bookmark: pgfId-245610]Greater Than Length

  
         		[bookmark: pgfId-245612]The maximum length in bytes of the evaluated field. The criterion matches if the length is greater than the specified number.

  
        

 
         
         		[bookmark: pgfId-245618]Greater Than Count

  
         		[bookmark: pgfId-245620]The maximum number of recipients or invalid recipients allowed in the e-mail message. The criterion matches if the number is greater than the specified number.

  
        

 
         
         		[bookmark: pgfId-245626]Verb Option

 [bookmark: pgfId-245628]User Defined Format

 [bookmark: pgfId-245630](For the Command Verb criterion.)

  
         		[bookmark: pgfId-245632]The SMTP or ESMTP command that you want to inspect. If you select User Defined, you must enter the text string that corresponds to a word in the body of the e-mail message. The word cannot include spaces or special characters; only alphanumeric characters.

  
        

 
         
         		[bookmark: pgfId-245638]Service Extension Parameter

 [bookmark: pgfId-245640]User Defined Format

 [bookmark: pgfId-245642](For the Reply EHLO criterion.

  
         		[bookmark: pgfId-245644]The service extension parameter of an EHLO server reply that you want to inspect. Select one of the well-known parameters, or select User Defined to specify a private extension in the User Defined Format field.

  
        

 
         
         		[bookmark: pgfId-245650]Encoding Format

 [bookmark: pgfId-245652]User Defined Format

  
         		[bookmark: pgfId-245654]The MIME encoding format for which you want to test. Encoding types are:

 
           
           		 [bookmark: pgfId-245656]7-bit—ASCII encoding.

 
           		 [bookmark: pgfId-245658]8-bit—Used for the exchange of e-mail messages containing octets outside the 7-bit ASCII range.

 
           		 [bookmark: pgfId-245660]base64—Encodes binary data by treating it numerically and translating it into a base 64 representation.

 
           		 [bookmark: pgfId-245662]quoted-printable-Encoding that uses printable characters to transmit 8-bit data over a 7-bit data path.

 
           		 [bookmark: pgfId-245664]binary—Encodes using only 0 and 1.

 
           		 [bookmark: pgfId-245666]unknown—Encoding type is not known.

 
           		 [bookmark: pgfId-245668]x-uuencode-Nonstandard encoding.

 
           		 [bookmark: pgfId-245670]user defined—An encoding type you define. If you select User Defined, you must enter the text string that defines the encoding type you are looking for.

 
          

  
        

 
         
         		[bookmark: pgfId-245676]Regular Expression

  
         		[bookmark: pgfId-245678]The regular expression object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click Select to choose the object from a list of existing ones or to create a new regular expression object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-250075][bookmark: 57016][bookmark: pobjpage_cncpt_SunRPCMatchCriterionDialogBoxes]Sun RPC Class Maps Add or Edit Match Criterion Dialog Boxes [bookmark: marker-250069][bookmark: marker-250071][bookmark: marker-250073]

 
     [bookmark: pgfId-250077]Use the Add or Edit Match Criterion dialog boxes for the Sun Remote Procedure Call (RPC) classes used with zone-based firewall policies to define a match criterion and value for the class map. You can enter the RPC protocol number that you want to match. See the Sun RPC documentation for information about protocol numbers.

 
     [bookmark: pgfId-250079]Navigation Path

 
     [bookmark: pgfId-250084]From the Add or Edit Class Maps dialog boxes for Sun RPC classes, right-click inside the table and select Add Row or right-click a row and select Edit Row. See Configuring Class Maps for Zone-Based Firewall Policies.

 
     [bookmark: pgfId-250086]Related Topics

 
      
      		 [bookmark: pgfId-250091]Understanding Map Objects

 
      		 [bookmark: pgfId-250096]Configuring Inspection Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-250101]Understanding the Zone-based Firewall Rules

 
     

 
    
 
     
      [bookmark: pgfId-250115][bookmark: 57048][bookmark: pobjpage_cncpt_LocalWebFilterMatchCriterionDialogBoxes]Local Web Filter Class Add or Edit Match Criterion Dialog Boxes[bookmark: marker-250109][bookmark: marker-250111][bookmark: marker-250113]

 
     [bookmark: pgfId-250117]Use the Add or Edit Match Criterion dialog boxes for the Local web filter class to define a match criterion and value for the class map.

 
     [bookmark: pgfId-250119]Navigation Path

 
     [bookmark: pgfId-250124]From the Add or Edit Class Maps dialog boxes for the Local web filter class, right-click inside the table and select Add Row or right-click a row and select Edit Row. See Configuring Class Maps for Zone-Based Firewall Policies.

 
     [bookmark: pgfId-250126]Related Topics

 
      
      		 [bookmark: pgfId-250131]Understanding Map Objects

 
      		 [bookmark: pgfId-250136]Configuring Content Filtering Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-250141]Understanding the Zone-based Firewall Rules

 
     

 
     [bookmark: pgfId-250143]Field Reference

 
     [bookmark: pgfId-250146] 

 
      
       
        
        [bookmark: pgfId-245691]Table 21-8 [bookmark: 57082]Local Web Filter Class Add or Edit Match Criterion Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-245697]Element
          
  
         		
           
           [bookmark: pgfId-245699]Description
          
  
        

 
         
         		[bookmark: pgfId-245705]Criterion

  
         		[bookmark: pgfId-245707]Specifies which criterion of traffic to match. You can select from the following:

 
           
           		 [bookmark: pgfId-245709]Server Domain—Matches traffic based on the name of the server. The URLF Glob parameter map you select should specify server domain names such as *.cisco.com or www.cisco.com.

 
           		 [bookmark: pgfId-245711]URL Keyword—Matches traffic based on keywords in the URLs. A key word is any complete string that occurs between / characters in a URL. For example, in the URL segment www.cisco.com/en/US, en and US are examples of keywords.

 
          

  
        

 
         
         		[bookmark: pgfId-245717]Type

  
         		[bookmark: pgfId-245719]Specifies that the map includes traffic that matches the criterion.

  
        

 
         
         		[bookmark: pgfId-245725]URLF Glob Parameter Map

  
         		[bookmark: pgfId-245727]The URLF Glob parameter map object that defines the URL patterns that you want to match. Ensure that the object you select has the appropriate content for the type of matching you selected.

 [bookmark: pgfId-245729]Enter the name of the object. You can click Select to choose the object from a list of existing ones or to create a new object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-250166][bookmark: 57115][bookmark: pobjpage_cncpt_N2H2WebSenseMatchCriterionDialogBoxes]N2H2 and Websense Class Add or Edit Match Criterion Dialog Boxes [bookmark: marker-250154][bookmark: marker-250156][bookmark: marker-250158][bookmark: marker-250160][bookmark: marker-250162][bookmark: marker-250164]

 
     [bookmark: pgfId-250168]Use the Add or Edit Match Criterion dialog boxes for the N2H2 (SmartFilter) and Websense web filter classes to define a match criterion and value for the class map. The only match criterion available is to match any response from the SmartFilter or Websense server.

 
     [bookmark: pgfId-250170]Navigation Path

 
     [bookmark: pgfId-250175]From the Add or Edit Class Maps dialog boxes for the N2H2 or Websense web filter class, right-click inside the table and select Add Row or right-click a row and select Edit Row. See Configuring Class Maps for Zone-Based Firewall Policies.

 
     [bookmark: pgfId-250177]Related Topics

 
      
      		 [bookmark: pgfId-250182]Understanding Map Objects

 
      		 [bookmark: pgfId-250187]Configuring Content Filtering Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-250192]Understanding the Zone-based Firewall Rules

 
     

 
    
 
     
      [bookmark: pgfId-250214][bookmark: 57157][bookmark: pobjpage_cncpt_InspectParameterMapDialogBoxes]Configuring Inspect Parameter Maps [bookmark: marker-250200][bookmark: marker-250202][bookmark: marker-250204][bookmark: marker-250206][bookmark: marker-250208][bookmark: marker-250210][bookmark: marker-250212]

 
     [bookmark: pgfId-250216]Use the Add and Edit Inspect Parameter Map dialog boxes to define a parameter map for inspection for zone-based firewall policies on routers. If you configure the action of a zone-based firewall policy rule as Inspect or Content Filter, you can select an inspect parameter map to define connection, timeout, and other settings for the inspection action. If you do not select an inspect parameter map for a zone-based firewall rule, the system uses default values for these settings.

 
     [bookmark: pgfId-250218]Navigation Path

 
     [bookmark: pgfId-250220]Select Manage > Policy Objects, then select Maps > Parameter Maps > Inspect > Inspect Parameters in the table of contents. Right-click inside the work area and select New Object, or right-click a row and select Edit Object.

 
     [bookmark: pgfId-250222]Related Topics

 
      
      		 [bookmark: pgfId-250227]Understanding Map Objects

 
      		 [bookmark: pgfId-250232]Configuring Inspection Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-250237]Configuring Content Filtering Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-250242]Understanding the Zone-based Firewall Rules

 
     

 
     [bookmark: pgfId-250244]Field Reference

 
     [bookmark: pgfId-250247] 

 
      
       
        
        [bookmark: pgfId-245742]Table 21-9 [bookmark: 57209]Add or Edit Inspect Parameter Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-245748]Element
          
  
         		
           
           [bookmark: pgfId-245750]Description
          
  
        

 
         
         		[bookmark: pgfId-245756]Name

  
         		[bookmark: pgfId-245758]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-245764]Description

  
         		[bookmark: pgfId-245766]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-245772]DNS Timeout

  
         		[bookmark: pgfId-245774]The length of time, in seconds, for which a DNS lookup session is managed while there is no activity.

  
        

 
         
         		[bookmark: pgfId-245780]ICMP Timeout

  
         		[bookmark: pgfId-245782]The length of time, in seconds, for which an inactive ICMP (Internet Control Message Protocol) session is maintained.

  
        

 
         
         		[bookmark: pgfId-245788]Max Incomplete Low

 [bookmark: pgfId-245790]Max Incomplete High

  
         		[bookmark: pgfId-245792]The number of existing half-open sessions that will cause the software to start (at the high threshold) and stop (at the low threshold) deleting half-open sessions.

 [bookmark: pgfId-245794]Ensure that you enter a lower number in the Low field than you enter in the High field, for example, 400 and 500. The default is unlimited half-open sessions.

  
        

 
         
         		[bookmark: pgfId-245800]One Minute Low

 [bookmark: pgfId-245802]One Minute High

  
         		[bookmark: pgfId-245804]The number of new unestablished sessions that causes the system to start and stop deleting half-open sessions. Ensure that you enter a lower number in the Low field than you enter in the High field. The default is unlimited.

  
        

 
         
         		[bookmark: pgfId-245810]Max Sessions

  
         		[bookmark: pgfId-245812]The maximum number of inspection sessions on a zone pair, for example, 200. The default is unlimited.

  
        

 
         
         		[bookmark: pgfId-245818]TCP FINWAIT Timeout

  
         		[bookmark: pgfId-245820]How long to maintain TCP session state information after the firewall detects a FIN-exchange, in seconds. The FIN-exchange occurs when the TCP session is ready to close.

  
        

 
         
         		[bookmark: pgfId-245826]TCP SYNWAIT Timeout

  
         		[bookmark: pgfId-245828]How long to wait for a TCP session to reach the established state before dropping the session, in seconds.

  
        

 
         
         		[bookmark: pgfId-245834]TCP Idle Timeout

  
         		[bookmark: pgfId-245836]How long to maintain a TCP session while there is no activity in the session, in seconds.

  
        

 
         
         		[bookmark: pgfId-245842]TCP Max Incomplete Hosts

 [bookmark: pgfId-245844]TCP Max Incomplete Block Time

  
         		[bookmark: pgfId-245846]The threshold and blocking time (in minutes) for TCP host-specific denial-of-service (DoS) detection and prevention.

 [bookmark: pgfId-245848]The maximum incomplete hosts is the number of half-open TCP sessions with the same host destination address that can simultaneously exist before the software starts deleting half-open sessions to that host. An unusually high number of half-open sessions with the same destination host address could indicate that a DoS attack is being launched against the host.

 [bookmark: pgfId-245850]When the threshold is exceeded, half-open sessions are dropped based on the maximum incomplete block time:

 
           
           		 [bookmark: pgfId-245852]If the block time is 0, the software deletes the oldest existing half-open session for the host for every new connection request to the host. This ensures that the number of half-open sessions to a given host never exceeds the threshold.

 
           		 [bookmark: pgfId-245854]If the block time is greater than 0, the software deletes all existing half-open sessions for the host and then blocks all new connection requests to the host. The software continues to block all new connection requests until the block time expires.

 
          

 [bookmark: pgfId-245856]The software sends syslog messages whenever the specified threshold is exceeded and when blocking of connection initiations to a host starts or ends.

  
        

 
         
         		[bookmark: pgfId-245862]UDP Idle Timeout

  
         		[bookmark: pgfId-245864]How long to maintain a UDP session while there is no activity in the session, in seconds.

 [bookmark: pgfId-245866]When the software detects a valid UDP packet, the software establishes state information for a new UDP session. Because UDP is a connectionless service, there are no actual sessions, so the software approximates sessions by examining the information in the packet and determining if the packet is similar to other UDP packets (for example, it has similar source or destination addresses) and if the packet was detected soon after another similar UDP packet.

 [bookmark: pgfId-245868]If the software detects no UDP packets for the UDP session for the period of time defined by the UDP idle timeout, the software will not continue to manage state information for the session.

  
        

 
         
         		[bookmark: pgfId-245874]Enable Alert

  
         		[bookmark: pgfId-245876]Whether to generate stateful packet inspection alert messages on the console.

  
        

 
         
         		[bookmark: pgfId-245882]Enable Audit Trail

  
         		[bookmark: pgfId-245884]Whether audit trail messages are logged to the syslog server or router.

  
        

 
         
         		[bookmark: pgfId-245890]Category

  
         		[bookmark: pgfId-245895]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-245901]Allow Value Override per Device

 [bookmark: pgfId-245903]Overrides

 [bookmark: pgfId-245905]Edit button

  
         		[bookmark: pgfId-245913]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-245915]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-250271][bookmark: 57322][bookmark: pobjpage_cncpt_ProtocolInfoParameterMapDialogBoxes]Configuring Protocol Info Parameter Maps [bookmark: marker-250255][bookmark: marker-250257][bookmark: marker-250259][bookmark: marker-250261][bookmark: marker-250263][bookmark: marker-250265][bookmark: marker-250267][bookmark: marker-250269]

 
     [bookmark: pgfId-250273]Use the Add and Edit Protocol Info Parameter Map dialog boxes to define a parameter map for the inspection of Instant Messaging (IM) applications or the Stun-ice protocol for zone-based firewall policies on routers. If you configure the action of a zone-based firewall policy rule as Inspect, you must select a protocol info parameter map when you configure any of these applications: AOL, ICQ, MSN Messenger, Windows Messenger, Yahoo Messenger, Stun-ice. The protocol info parameter map defines the DNS servers that interact with these applications, which helps the instant messenger application engine to recognize the instant messenger traffic and to enforce the configured policy for that instant messenger application.

 
     [bookmark: pgfId-250275]Navigation Path

 
     [bookmark: pgfId-250277]Select Manage > Policy Objects, then select Maps > Parameter Maps > Inspect > Protocol Info Parameters in the table of contents. Right-click inside the work area and select New Object, or right-click a row and select Edit Object.

 
     [bookmark: pgfId-250279]Related Topics

 
      
      		 [bookmark: pgfId-250284]Understanding Map Objects

 
      		 [bookmark: pgfId-250289]Configuring Inspection Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-250294]Understanding the Zone-based Firewall Rules

 
     

 
     [bookmark: pgfId-250296]Field Reference

 
     [bookmark: pgfId-250299] 

 
      
       
        
        [bookmark: pgfId-245928]Table 21-10 [bookmark: 57374]Add or Edit Protocol Info Parameter Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-245934]Element
          
  
         		
           
           [bookmark: pgfId-245936]Description
          
  
        

 
         
         		[bookmark: pgfId-245942]Name

  
         		[bookmark: pgfId-245944]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-245950]Description

  
         		[bookmark: pgfId-245952]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-245958]DNS Server Table

  
         		[bookmark: pgfId-245960]The DNS servers for which traffic will be permitted (and inspected) or denied.

 
           
           		 [bookmark: pgfId-245965]To add servers, click the Add button and fill in the Add Server dialog box (see Add or Edit DNS Server for Protocol Info Parameters Dialog Box).

 
           		 [bookmark: pgfId-245967]To edit a server, select it and click the Edit button.

 
           		 [bookmark: pgfId-245969]To delete a server, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-245975]Category

  
         		[bookmark: pgfId-245980]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-245986]Allow Value Override per Device

 [bookmark: pgfId-245988]Overrides

 [bookmark: pgfId-245990]Edit button

  
         		[bookmark: pgfId-245998]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-246000]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-250311][bookmark: 57425][bookmark: pobjpage_cncpt_ProtocolInfoParameterMapAddServerDialogBoxes]Add or Edit DNS Server for Protocol Info Parameters Dialog Box [bookmark: marker-250307][bookmark: marker-250309]

 
     [bookmark: pgfId-250313]Use the Add or Edit DNS Server dialog box to identify DNS servers for which traffic will be permitted (and inspected) or denied. These servers are defined in a Protocol Info parameter map for use with the inspection of protocols that require them in a zone-based firewall policy.

 
     [bookmark: pgfId-250315]You can identify a server using any of these types:

 
      
      		 [bookmark: pgfId-250317]Server Name—The name of the DNS server. You can use an asterisk (*) as a wildcard character to match one or more characters. For example, if you want to identify all DNS servers on the cisco.com domain, you can specify *.cisco.com.

 
      		 [bookmark: pgfId-250319]IP Address—The IP address of a single DNS server.

 
      		 [bookmark: pgfId-250321]IP Address Range—A range of IP addresses identifying any DNS server within the start and end addresses.

 
     

 
     [bookmark: pgfId-250323]Navigation Path

 
     [bookmark: pgfId-250328]From the Add or Edit Protocol Info Parameter Map dialog boxes, click the Add button beneath the server table, or select a server and click the Edit button. See Configuring Protocol Info Parameter Maps.

 
    
 
     
      [bookmark: pgfId-250368][bookmark: 57452][bookmark: pobjpage_cncpt_PolicyMapsDialogBoxesforZoneBasedFirewallPolicies]Configuring Policy Maps for Zone-Based Firewall Policies[bookmark: marker-250336][bookmark: marker-250338][bookmark: marker-250340][bookmark: marker-250342][bookmark: marker-250344][bookmark: marker-250346][bookmark: marker-250348][bookmark: marker-250350][bookmark: marker-250352][bookmark: marker-250354][bookmark: marker-250356][bookmark: marker-250358][bookmark: marker-250360][bookmark: marker-250362][bookmark: marker-250364][bookmark: marker-250366]

 
     [bookmark: pgfId-250370]Use the Add and Edit Policy Map dialog boxes for zone-based firewall policies to define the match criterion and values for an inspection map used in a zone-based firewall policy for a Cisco IOS router. You can create policy inspection maps for H.323 (IOS), HTTP (Zone based IOS), IM (Zone based IOS), IMAP, P2P, POP3, SIP (IOS), SMTP, and Sun RPC inspection, and the name of the dialog box indicates the type of map you are creating.

 
     [bookmark: pgfId-250372]When defining the inspection map, you select class maps of the same type and define the action to take for matching traffic. You can configure the required class maps before creating the policy maps or while you are creating them.

 
     [bookmark: pgfId-250374]Navigation Path

 
     [bookmark: pgfId-250376]Select Manage > Policy Objects, then any of the following items in the Maps > Policy Maps > Inspect folder in the table of contents: H.323 (IOS), HTTP (Zone based IOS), IM (Zone based IOS), IMAP, P2P, POP3, SIP (IOS), SMTP, and Sun RPC. Right-click inside the work area and select New Object, or right-click a row and select Edit Object.

 
     [bookmark: pgfId-250378]Related Topics

 
      
      		 [bookmark: pgfId-250383]Understanding Map Objects

 
      		 [bookmark: pgfId-250388]Configuring Inspection Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-250393]Configuring Content Filtering Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-250398]Understanding the Zone-based Firewall Rules

 
     

 
     [bookmark: pgfId-250400]Field Reference

 
     [bookmark: pgfId-250403] 

 
      
       
        
        [bookmark: pgfId-246013]Table 21-11 [bookmark: 57515]Add or Edit Policy Maps Dialog Boxes for Zone-Based Firewall Policies 

 
        
       
         
         		
           
           [bookmark: pgfId-246019]Element
          
  
         		
           
           [bookmark: pgfId-246021]Description
          
  
        

 
         
         		[bookmark: pgfId-246027]Name

  
         		[bookmark: pgfId-246029]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-246035]Description

  
         		[bookmark: pgfId-246037]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-246043]Match All table

  
         		[bookmark: pgfId-246045]The Match All table lists class maps included in the policy map, and the action to take for traffic that matches the class. For traffic to match this class, all criteria defined in the selected class maps must be met.

 
           
           		 [bookmark: pgfId-246050]To add a criterion, click the Add button and fill in the Match Condition and Action dialog box (see Add or Edit Match Condition and Action Dialog Boxes for Zone-Based Firewall and Web Filter Policies).

 
           		 [bookmark: pgfId-246052]To edit a criterion, select it and click the Edit button.

 
           		 [bookmark: pgfId-246054]To delete a criterion, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-246060]Category

  
         		[bookmark: pgfId-246065]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-246071]Allow Value Override per Device

 [bookmark: pgfId-246073]Overrides

 [bookmark: pgfId-246075]Edit button

  
         		[bookmark: pgfId-246083]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-246085]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-250471][bookmark: 57566][bookmark: pobjpage_cncpt_MatchConditionandActionDialogBoxesforZoneBasedFirewallPolicies]Add or Edit Match Condition and Action Dialog Boxes for Zone-Based Firewall and Web Filter Policies[bookmark: marker-250411][bookmark: marker-250413][bookmark: marker-250415][bookmark: marker-250417][bookmark: marker-250419][bookmark: marker-250421][bookmark: marker-250423][bookmark: marker-250425][bookmark: marker-250427][bookmark: marker-250429][bookmark: marker-250431][bookmark: marker-250433][bookmark: marker-250435][bookmark: marker-250437][bookmark: marker-250439][bookmark: marker-250441][bookmark: marker-250443][bookmark: marker-250445][bookmark: marker-250447][bookmark: marker-250449][bookmark: marker-250451][bookmark: marker-250453][bookmark: marker-250455][bookmark: marker-250457][bookmark: marker-250459][bookmark: marker-250461][bookmark: marker-250463][bookmark: marker-250465][bookmark: marker-250467][bookmark: marker-250469]

 
     [bookmark: pgfId-250473]Use the Add or Edit Match Condition and Action dialog boxes for zone-based firewall and web filter policies to select the class maps for inspection and to define the action to take for traffic that matches the class. This dialog box is used for the following types of policy maps: H.323 (IOS), HTTP (Zone based IOS), IM (Zone based IOS), IMAP, P2P, POP3, SIP (IOS), SMTP, Sun RPC, Web Filter.

 
     [bookmark: pgfId-250475]The fields on this dialog box differ slightly depending on the type of policy map you are defining.

 
     [bookmark: pgfId-250477]Navigation Path

 
     [bookmark: pgfId-250482]From the Add or Edit Policy Maps dialog boxes for Zone-Based Firewall Policies, right-click inside the match table and select Add Row or right-click a row and select Edit Row. See Configuring Policy Maps for Zone-Based Firewall Policies.

 
     [bookmark: pgfId-250484]Related Topics

 
      
      		 [bookmark: pgfId-250489]Understanding Map Objects

 
      		 [bookmark: pgfId-250494]Configuring Inspection Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-250499]Configuring Content Filtering Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-250504]Understanding the Zone-based Firewall Rules

 
     

 
     [bookmark: pgfId-250506]Field Reference

 
     [bookmark: pgfId-250509] 

 
      
       
        
        [bookmark: pgfId-246098]Table 21-12 [bookmark: 57686]Add or Edit Match Condition and Action Dialog Boxes for Zone-Based Firewall Policies 

 
        
       
         
         		
           
           [bookmark: pgfId-246104]Element
          
  
         		
           
           [bookmark: pgfId-246106]Description
          
  
        

 
         
         		[bookmark: pgfId-246112]Match Type

  
         		[bookmark: pgfId-246114]Indicates that you are selecting a class map. You must define class maps when creating policy maps for zone-based firewall policies.

  
        

 
         
         		[bookmark: pgfId-246120]Class Map

 [bookmark: pgfId-246122]P2P, IM, and Web Filter class map types.

  
         		[bookmark: pgfId-246124]The name of the class map for the type of policy map you are creating. Click Select to select the map from a list or to create a new class map object.

 [bookmark: pgfId-246126]For P2P, IM, and Web Filter policy maps, you must also select the type of policy map you are creating. For example, in a P2P map you must select between eDonkey, FastTrack, Gnutella, and Kazaa2. In an IM (Zone Based IOS) map, you must select between AOL, MSN Messenger, Yahoo Messenger, Windows Messenger, and ICQ. In a Web Filter map, you must select between Local, N2H2, WebSense, and Trend.

  
        

 
         
         		[bookmark: pgfId-246132]Action

  
         		[bookmark: pgfId-246134]The action you want the device to take for traffic that matches the selected class.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-250567][bookmark: 57717][bookmark: obman_cncpt_ConfiguringMapsforContentFilteringinZoneBasedFirewallRulesPolicies]Configuring Content Filtering Maps for Zone-based Firewall Policies [bookmark: marker-250515][bookmark: marker-250517][bookmark: marker-250519][bookmark: marker-250521][bookmark: marker-250523][bookmark: marker-250525][bookmark: marker-250527][bookmark: marker-250529][bookmark: marker-250531][bookmark: marker-250533][bookmark: marker-250535][bookmark: marker-250537][bookmark: marker-250539][bookmark: marker-250541][bookmark: marker-250543][bookmark: marker-250545][bookmark: marker-250547][bookmark: marker-250549][bookmark: marker-250551][bookmark: marker-250553][bookmark: marker-250555][bookmark: marker-250557][bookmark: marker-250559][bookmark: marker-250561][bookmark: marker-250563][bookmark: marker-250565]

 
    [bookmark: pgfId-250569]When you configure zone-based firewall policies for a router, you can define rules to filter Web content by choosing Content Filter as the Action for the rule.

 
    [bookmark: pgfId-250571]To filter Web content, you must configure certain map objects, which you can do from the policy object selector dialog box while defining the rule, or at any time in the Policy Object Manager window (select Manage > Policy Objects).

 
    [bookmark: pgfId-250573]The type of maps required depends on the technique you are using to filter content, and on the Cisco IOS software version you are using. You can filter content based on URL lists defined locally on the device, or you can use external filtering servers such as SmartFilter (N2H2), Websense, or Trend Micro.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-250578]Tip If you use an external server, you must have set up and configured the server appropriately based on the documentation for the type of server you select. If you use Trend Micro servers, you must specify the server details, and register the product and download certificates, on the Content Filtering tab of the Zone Based Firewall page (select Firewall > Settings > Zone Based Firewall). See Zone Based Firewall Page.


    
     

    

    

 
    [bookmark: pgfId-250580]The following are requirements for the map objects used with zone-based content filtering:

 
     
     		 [bookmark: pgfId-250585]For devices running releases below 12.4(20)T, you must create a URL Filter parameter map. In the Policy Object Manager, select  Maps > Parameter Maps > Web Filter > URL Filter , and review the detailed usage information in Configuring URL Filter Parameter Maps.

 
    

 
    [bookmark: pgfId-250587] – To perform local filtering on the router using lists of allowed (whitelisted) and denied (blacklisted) hosts, create the lists on the Local Filtering tab. Any Web access request is first compared to these lists before the request is sent on to an external filtering server (if you have configured one). These lists contain either complete domain names (such as www.cisco.com), or partial names (such as cisco.com), but they do not include paths or page names, and you cannot use wildcards.

 
    [bookmark: pgfId-250589] – To use a SmartFilter (N2H2) or Websense server, configure the type of server you are using and its address information on the External Filter tab. You can also configure other settings that control communication with the server. You cannot configure a Trend Micro server using the URL Filter parameter map.

 
     
     		 [bookmark: pgfId-250594]For devices running release 12.4(20)T and higher, the preferred approach is to use a Web Filter policy map. Although Web Filter policy maps are more complex, they provide added flexibility, and they let you access Trend Micro filtering servers. In the Policy Object Manager, select  Maps > Policy Maps > Web Filter > Web Filter , and review the detailed usage information in Configuring Web Filter Maps.

 
    

 
    [bookmark: pgfId-250596]A Web Filter policy map incorporates other types of maps. To create the policy map, you will need one or more of these other types of maps:

 
    [bookmark: pgfId-250607] – Parameter maps – On the Parameters tab of the Add and Edit Web Filter Map dialog boxes, you can select parameter maps for the various types of Web filtering if you do not want to use the default settings. If you are using SmartFilter (N2H2) or Websense, you need to select a parameter map because the map identifies those servers. For Local and Trend Micro filtering, parameter maps configure some general settings, the most interesting of which is whether to display a message or Web page when a URL is blocked. In the Policy Object Manager, you can find parameter maps for Local, N2H2, Trend, and Websense in the Maps > Parameter Maps > Web Filter folder. For detailed usage information, see Configuring Local Web Filter Parameter Maps, Configuring N2H2 or WebSense Parameter Maps, or Configuring Trend Parameter Maps.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-250612]Note You configure Trend Micro server information on the Content Filtering tab of the Zone Based Firewall page (select Firewall > Settings > Zone Based Firewall). See Zone Based Firewall Page.


    
     

    

    

 
    [bookmark: pgfId-250614] – Class maps for match conditions – These class maps define the type of traffic you want to target and specify the action to be taken. You select a type of filtering (Local, SmartFilter/N2H2, Websense, or Trend Micro), specify the class map that identifies the targeted traffic, and choose an action (such as Allow, Reset, etc.) to be taken for that traffic. In the Policy Object Manager, you can find class maps for Local, N2H2, Trend, and Websense in the Maps > Class Maps > Web Filter folder.

 
    [bookmark: pgfId-250616]These class-map configurations depend on the type of filtering:

 
    [bookmark: pgfId-250627]Local Filtering – The Local WebFilter class map is a list of one or more URLF Glob parameter maps that specify either domain names or URL keywords that you want to target. A URL keyword is any text string delineated by forward-slash (/) characters in a URL. These class maps help you define allowed (whitelisted) and denied (blacklisted) URL lists for a WebFilter policy—create separate maps for each list. For detailed usage information, see Configuring Class Maps for Zone-Based Firewall Policies, Local Web Filter Class Add or Edit Match Criterion Dialog Boxes, and Configuring URLF Glob Parameter Maps.

 
    [bookmark: pgfId-250632]SmartFilter (N2H2) or Websense Filtering—The class maps for N2H2 and Websense define any server response as the matching criterion. For detailed usage information, see Configuring Class Maps for Zone-Based Firewall Policies.

 
    [bookmark: pgfId-250637]Trend Micro Filtering – The Trend class map lets you select various Productivity Categories and Security Ratings, as defined by Trend Micro, that you want to target. For detailed usage information, see Configuring Class Maps for Zone-Based Firewall Policies.

 
    [bookmark: pgfId-250639]Besides the maps used to define content filtering, you can also configure the following maps for content filter rules:

 
     
     		 [bookmark: pgfId-250644]Inspect Parameters maps – Zone-based firewall inspection includes several general settings, all of which have default values that are appropriate for most networks. If you want to adjust any of these settings, you can create an Inspect Parameters map. In the Policy Object Manager, select  Maps > Parameter Maps > Inspect > Inspect Parameters , and review the detailed usage information in Configuring Inspect Parameter Maps.

 
     		 [bookmark: pgfId-250658]HTTP policy map – If you want to use deep inspection on the individual HTTP packets in addition to Web filtering, you can configure an HTTP policy map by clicking  Configure next to the Protocol field in the Action section of the Adding and Editing Zone-based Firewall Rules. The HTTP policy map incorporates HTTP class maps that define the type of traffic you want to match and then defines the action to take. For example, you can target traffic that includes Java applets. In the Policy Object Manager, select  Maps > Policy Maps > Inspect > HTTP (Zone Based IOS) , and review the detailed usage information in Configuring Policy Maps for Zone-Based Firewall Policies, HTTP (IOS) Class Add or Edit Match Criterion Dialog Boxes, and Configuring Class Maps for Zone-Based Firewall Policies.

 
    

 
    [bookmark: pgfId-250660]Related Topics

 
     
     		 [bookmark: pgfId-250665]Understanding the Zone-based Firewall Rules

 
     		 [bookmark: pgfId-250670]Zone-based Firewall Rules Page

 
     		 [bookmark: pgfId-250675]Creating Policy Objects

 
     		 [bookmark: pgfId-250680]Understanding Map Objects

 
    

 
     
      [bookmark: pgfId-250700][bookmark: 57881][bookmark: pobjpage_cncpt_LocalWebFilterParameterMapDialogBoxes]Configuring Local Web Filter Parameter Maps [bookmark: marker-250688][bookmark: marker-250690][bookmark: marker-250692][bookmark: marker-250694][bookmark: marker-250696][bookmark: marker-250698]

 
     [bookmark: pgfId-250705]Use the Add and Edit Local Parameter Map dialog boxes to define a parameter map for local web filtering for zone-based firewall policies on routers. If you configure the action of a zone-based firewall policy rule as Content Filter, you can select a Web Filter policy map that incorporates a Local web filter parameter map (when you select Local for the parameter type on the Parameter tab). For more information about Web Filter policy maps, see Configuring Web Filter Maps.

 
     [bookmark: pgfId-250707]Navigation Path

 
     [bookmark: pgfId-250709]Select Manage > Policy Objects, then select Maps > Parameter Maps > Web Filter > Local in the table of contents. Right-click inside the work area and select New Object, or right-click a row and select Edit Object.

 
     [bookmark: pgfId-250711]Related Topics

 
      
      		 [bookmark: pgfId-250716]Understanding Map Objects

 
      		 [bookmark: pgfId-250721]Configuring Content Filtering Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-250726]Understanding the Zone-based Firewall Rules

 
     

 
     [bookmark: pgfId-250728]Field Reference

 
     [bookmark: pgfId-250731] 

 
      
       
        
        [bookmark: pgfId-246147]Table 21-13 [bookmark: 57928]Add or Edit Local Web Filter Parameter Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-246153]Element
          
  
         		
           
           [bookmark: pgfId-246155]Description
          
  
        

 
         
         		[bookmark: pgfId-246161]Name

  
         		[bookmark: pgfId-246163]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-246169]Description

  
         		[bookmark: pgfId-246171]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-246177]Enable Alert

  
         		[bookmark: pgfId-246179]Whether to generate stateful packet inspection alert messages on the console.

  
        

 
         
         		[bookmark: pgfId-246185]Enable Allow Mode

  
         		[bookmark: pgfId-246187]Whether to allow or block URL requests when the URL filtering process does not have connectivity to a URL filtering database. When allow-mode is on, all unmatched URL requests are allowed; when off, all unmatched URL requests are blocked.

  
        

 
         
         		[bookmark: pgfId-246193]Block Page

  
         		[bookmark: pgfId-246195]The web page you want to present to the user if the user attempts to access a page that you block. You can select from the following:

 
           
           		 [bookmark: pgfId-246197]None—The user is not presented with any information.

 
           		 [bookmark: pgfId-246199]Message—The user is presented with the text message you enter in the edit box.

 
           		 [bookmark: pgfId-246201]Redirect URL—The user is redirected to the URL you enter in the edit box.

 
          

  
        

 
         
         		[bookmark: pgfId-246207]Category

  
         		[bookmark: pgfId-246212]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-246218]Allow Value Override per Device

 [bookmark: pgfId-246220]Overrides

 [bookmark: pgfId-246222]Edit button

  
         		[bookmark: pgfId-246230]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-246232]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-250769][bookmark: 57989][bookmark: pobjpage_cncpt_N2H2WebSenseParameterMapDialogBoxes]Configuring N2H2 or WebSense Parameter Maps [bookmark: marker-250739][bookmark: marker-250741][bookmark: marker-250743][bookmark: marker-250745][bookmark: marker-250747][bookmark: marker-250749][bookmark: marker-250751][bookmark: marker-250753][bookmark: marker-250755][bookmark: marker-250757][bookmark: marker-250759][bookmark: marker-250761][bookmark: marker-250763][bookmark: marker-250765][bookmark: marker-250767]

 
     [bookmark: pgfId-250774]Use the Add and Edit N2H2 or Websense Parameter Map dialog boxes to define a parameter map for Smartfilter (N2H2) or Websense web filtering for zone-based firewall policies on routers. If you configure the action of a zone-based firewall policy rule as Content Filter, you can select a Web Filter policy map that incorporates an N2H2 or Websense web filter parameter map (when you select N2H2 or Websense for the parameter type on the Parameter tab). For more information about Web Filter policy maps, see Configuring Web Filter Maps.

 
     [bookmark: pgfId-250776]Navigation Path

 
     [bookmark: pgfId-250778]Select Manage > Policy Objects, then select N2H2 or WebSense from the Maps > Parameter Maps > Web Filter folder in the table of contents. Right-click inside the work area and select New Object, or right-click a row and select Edit Object.

 
     [bookmark: pgfId-250780]Related Topics

 
      
      		 [bookmark: pgfId-250785]Understanding Map Objects

 
      		 [bookmark: pgfId-250790]Configuring Content Filtering Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-250795]Understanding the Zone-based Firewall Rules

 
     

 
     [bookmark: pgfId-250797]Field Reference

 
     [bookmark: pgfId-250800] 

 
      
       
        
        [bookmark: pgfId-246245]Table 21-14 [bookmark: 58064]Add or Edit N2H2 or WebSense Parameter Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-246251]Element
          
  
         		
           
           [bookmark: pgfId-246253]Description
          
  
        

 
         
         		[bookmark: pgfId-246259]Name

  
         		[bookmark: pgfId-246261]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-246267]Description

  
         		[bookmark: pgfId-246269]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-246275]URL Filtering Server Table

  
         		[bookmark: pgfId-246277]The list of URL filtering servers and their attributes.

 
           
           		 [bookmark: pgfId-246282]To add servers, click the Add button and fill in the Add External Filter dialog box (see Add or Edit External Filter Dialog Box).

 
           		 [bookmark: pgfId-246284]To edit a server, select it and click the Edit button.

 
           		 [bookmark: pgfId-246286]To delete a server, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-246292]Enable Alert

  
         		[bookmark: pgfId-246294]Whether to generate stateful packet inspection alert messages on the console.

  
        

 
         
         		[bookmark: pgfId-246300]Enable Allow Mode

  
         		[bookmark: pgfId-246302]Whether to allow or block URL requests when the URL filtering process does not have connectivity to a URL filtering database. When allow-mode is on, all unmatched URL requests are allowed; when off, all unmatched URL requests are blocked.

  
        

 
         
         		[bookmark: pgfId-246308]Block Page

  
         		[bookmark: pgfId-246310]The web page you want to present to the user if the user attempts to access a page that you block. You can select from the following:

 
           
           		 [bookmark: pgfId-246312]None—The user is not presented with any information.

 
           		 [bookmark: pgfId-246314]Message—The user is presented with the text message you enter in the edit box.

 
           		 [bookmark: pgfId-246316]Redirect URL—The user is redirected to the URL you enter in the edit box.

 
          

  
        

 
         
         		[bookmark: pgfId-246322]Source Interface

  
         		[bookmark: pgfId-246324]The interface whose IP address should be used as the source IP address when a TCP connection is established between the system and the URL filtering server.

  
        

 
         
         		[bookmark: pgfId-246330]Maximum Cache Entries

  
         		[bookmark: pgfId-246332]The maximum number of entries to store in the categorization cache. The default is 5000.

  
        

 
         
         		[bookmark: pgfId-246338]Cache Life Time

  
         		[bookmark: pgfId-246340]How long, in hours, an entry remains in the cache table. The default is 24.

  
        

 
         
         		[bookmark: pgfId-246346]Maximum Requests

  
         		[bookmark: pgfId-246348]The maximum number of pending requests. The range is from 1 to 2147483647. The default is 1000.

  
        

 
         
         		[bookmark: pgfId-246354]Maximum Responses

  
         		[bookmark: pgfId-246356]The maximum number of HTTP responses that can be buffered. The range is from 0 and 20000. The default is 200.

  
        

 
         
         		[bookmark: pgfId-246362]Truncate Hostname

 [bookmark: pgfId-246364]Truncate Script Parameters

  
         		[bookmark: pgfId-246366]Whether to truncate the URLs:

 
           
           		 [bookmark: pgfId-246368]If you do not select an option, URLs are not truncated.

 
           		 [bookmark: pgfId-246370]If you select Hostname, URLs are truncated at the end of the domain name.

 
           		 [bookmark: pgfId-246372]If you select Script Parameters, URLs are truncated at the left-most question mark in the URL.

 
          

 [bookmark: pgfId-246374]Tip Although you can select both options, it is illogical to do so.  
        

 
         
         		[bookmark: pgfId-246380]Enable Server Log

  
         		[bookmark: pgfId-246382]Whether to send information about HTTP requests to the URL filtering server’s log server. The information includes the URL, the hostname, the source IP address, and the destination IP address.

  
        

 
         
         		[bookmark: pgfId-246388]Category

  
         		[bookmark: pgfId-246393]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-246399]Allow Value Override per Device

 [bookmark: pgfId-246401]Overrides

 [bookmark: pgfId-246403]Edit button

  
         		[bookmark: pgfId-246411]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-246413]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-250818][bookmark: 58181][bookmark: pobjpage_cncpt_WebFilterParameterMapAddExternalFilterDialogBoxes]Add or Edit External Filter Dialog Box [bookmark: marker-250808][bookmark: marker-250810][bookmark: marker-250812][bookmark: marker-250814][bookmark: marker-250816]

 
     [bookmark: pgfId-250820]Use the Add or Edit External Filter dialog box to add a URL filtering server to an N2H2, Websense, or URL Filter parameter map policy object.

 
     [bookmark: pgfId-250822]Navigation Path

 
     [bookmark: pgfId-250824]Click the Add button beneath the server table, or select a server and click the Edit button, from any of the following dialog boxes:

 
      
      		 [bookmark: pgfId-250829]Add or Edit N2H2 or WebSense Parameter Map dialog boxes. See Configuring N2H2 or WebSense Parameter Maps.

 
      		 [bookmark: pgfId-250834]Add or Edit URL Filter Parameter Map dialog boxes. See Configuring URL Filter Parameter Maps.

 
     

 
     [bookmark: pgfId-250836]Field Reference

 
     [bookmark: pgfId-250839] 

 
      
       
        
        [bookmark: pgfId-246426]Table 21-15 [bookmark: 58214]Add or Edit External Filter Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-246432]Element
          
  
         		
           
           [bookmark: pgfId-246434]Description
          
  
        

 
         
         		[bookmark: pgfId-246440]Server

  
         		[bookmark: pgfId-246442]The fully-qualified domain name or IP address of the URL filtering server.

  
        

 
         
         		[bookmark: pgfId-246448]Port

  
         		[bookmark: pgfId-246450]The port that is listening for requests.

  
        

 
         
         		[bookmark: pgfId-246456]Retransmission Count

  
         		[bookmark: pgfId-246458]The number of times the router retransmits the lookup request when a response is not received from the server. The range is from 1 to 10.

  
        

 
         
         		[bookmark: pgfId-246464]Timeout

  
         		[bookmark: pgfId-246466]The number of seconds that the router waits for a response from the server. The range is from 1 to 300.

  
        

 
         
         		[bookmark: pgfId-246472]Outside

  
         		[bookmark: pgfId-246474]Whether the server is outside the network.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-250859][bookmark: 58251][bookmark: pobjpage_cncpt_TrendParameterMapDialogBoxes]Configuring Trend Parameter Maps [bookmark: marker-250847][bookmark: marker-250849][bookmark: marker-250851][bookmark: marker-250853][bookmark: marker-250855][bookmark: marker-250857]

 
     [bookmark: pgfId-250864]Use the Add and Edit Trend Parameter Map dialog boxes to define a parameter map for Trend Micro web filtering for zone-based firewall policies on routers. If you configure the action of a zone-based firewall policy rule as Content Filter, you can select a Web Filter policy map that incorporates a Trend web filter parameter map (when you select Trend for the parameter type on the Parameter tab). For more information about Web Filter policy maps, see Configuring Web Filter Maps.

 
     [bookmark: pgfId-250866]Navigation Path

 
     [bookmark: pgfId-250868]Select Manage > Policy Objects, then select Maps > Parameter Maps > Web Filter > Trend in the table of contents. Right-click inside the work area and select New Object, or right-click a row and select Edit Object.

 
     [bookmark: pgfId-250870]Related Topics

 
      
      		 [bookmark: pgfId-250875]Understanding Map Objects

 
      		 [bookmark: pgfId-250880]Configuring Content Filtering Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-250885]Understanding the Zone-based Firewall Rules

 
     

 
     [bookmark: pgfId-250887]Field Reference

 
     [bookmark: pgfId-250890] 

 
      
       
        
        [bookmark: pgfId-246487]Table 21-16 [bookmark: 58298]Add or Edit Trend Parameter Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-246493]Element
          
  
         		
           
           [bookmark: pgfId-246495]Description
          
  
        

 
         
         		[bookmark: pgfId-246501]Name

  
         		[bookmark: pgfId-246503]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-246509]Description

  
         		[bookmark: pgfId-246511]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-246517]Enable Allow Mode

  
         		[bookmark: pgfId-246519]Whether to allow or block URL requests when the URL filtering process does not have connectivity to a URL filtering database. When allow-mode is on, all unmatched URL requests are allowed; when off, all unmatched URL requests are blocked.

  
        

 
         
         		[bookmark: pgfId-246525]Block Page

  
         		[bookmark: pgfId-246527]The web page you want to present to the user if the user attempts to access a page that you block. You can select from the following:

 
           
           		 [bookmark: pgfId-246529]None—The user is not presented with any information.

 
           		 [bookmark: pgfId-246531]Message—The user is presented with the text message you enter in the edit box.

 
           		 [bookmark: pgfId-246533]Redirect URL—The user is redirected to the URL you enter in the edit box.

 
          

  
        

 
         
         		[bookmark: pgfId-246539]Maximum Requests

  
         		[bookmark: pgfId-246541]The maximum number of pending requests. The range is from 1 to 2147483647. The default is 1000.

  
        

 
         
         		[bookmark: pgfId-246547]Maximum Responses

  
         		[bookmark: pgfId-246549]The maximum number of HTTP responses that can be buffered. The range is from 0 and 20000. The default is 200.

  
        

 
         
         		[bookmark: pgfId-246555]Truncate Hostname

  
         		[bookmark: pgfId-246557]Whether to truncate URLs at the end of the domain name.

  
        

 
         
         		[bookmark: pgfId-246563]Category

  
         		[bookmark: pgfId-246568]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-246574]Allow Value Override per Device

 [bookmark: pgfId-246576]Overrides

 [bookmark: pgfId-246578]Edit button

  
         		[bookmark: pgfId-246586]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-246588]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-250910][bookmark: 58369][bookmark: pobjpage_cncpt_URLFilterParameterMapDialogBoxes]Configuring URL Filter Parameter Maps [bookmark: marker-250898][bookmark: marker-250900][bookmark: marker-250902][bookmark: marker-250904][bookmark: marker-250906][bookmark: marker-250908]

 
     [bookmark: pgfId-250912]Use the Add and Edit URL Filter Parameter Map dialog boxes to define the parameters and match criterion and values for an inspection map used in a zone-based firewall policy for a router.

 
     [bookmark: pgfId-250917]If you configure the action of a zone-based firewall policy rule as Content Filter, you can select a URL Filter parameter map to define web filtering parameters and match criteria. However, if the router is running Cisco IOS Software release 12.4(20)T or higher, the recommended approach is to configure a Web Filter policy map along with parameter and class maps for the appropriate server type (local, N2H2, Trend, or Websense). For more information, see Configuring Web Filter Maps.

 
     [bookmark: pgfId-250919]Navigation Path

 
     [bookmark: pgfId-250921]Select Manage > Policy Objects, then select Maps > Parameter Maps > Web Filter > URL Filter in the table of contents. Right-click inside the work area and select New Object, or right-click a row and select Edit Object.

 
     [bookmark: pgfId-250923]Related Topics

 
      
      		 [bookmark: pgfId-250928]Understanding Map Objects

 
      		 [bookmark: pgfId-250933]Configuring Content Filtering Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-250938]Understanding the Zone-based Firewall Rules

 
     

 
     [bookmark: pgfId-250940]Field Reference

 
     [bookmark: pgfId-250943] 

 
      
       
        
        [bookmark: pgfId-246601]Table 21-17 [bookmark: 58417]Add or Edit URL Filter Parameter Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-246607]Element
          
  
         		
           
           [bookmark: pgfId-246609]Description
          
  
        

 
         
         		[bookmark: pgfId-246615]Name

  
         		[bookmark: pgfId-246617]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-246623]Description

  
         		[bookmark: pgfId-246625]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		 [bookmark: pgfId-246631]Local Filtering Tab

 [bookmark: pgfId-246633]The fields on this tab define the properties for local URL filtering.

  
        

 
         
         		[bookmark: pgfId-246641]Whitelisted and Blacklisted Domains tables

  
         		[bookmark: pgfId-246643]These tables define the domain names for which the software will not contact the external URL filtering server. Domain names on the whitelist are always allowed. Domain names on the blacklist are always blocked. Use these lists to identify entire domains that you want to allow without restriction (such as your company’s web site) or block completely (such as pornography sites).

 [bookmark: pgfId-246645]Domain names can be complete (including the host name, such as www.cisco.com), or partial (such as cisco.com). For partial names, all web site hosts on that domain are either permitted or denied. You can also enter host IP addresses.

 
           
           		 [bookmark: pgfId-246650]To add a domain name, click the Add button and fill in the Add Server dialog box (see Add or Edit URL Domain Name Dialog Box for URL Filter Parameters).

 
           		 [bookmark: pgfId-246652]To edit a domain name, select it and click the Edit button.

 
           		 [bookmark: pgfId-246654]To delete a domain name, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-246660]Enable Alert

  
         		[bookmark: pgfId-246662]Whether to generate stateful packet inspection alert messages on the console.

  
        

 
         
         		[bookmark: pgfId-246668]Enable Audit Trail

  
         		[bookmark: pgfId-246670]Whether to log URL information to the syslog server or router.

  
        

 
         
         		[bookmark: pgfId-246676]Enable Allow Mode

  
         		[bookmark: pgfId-246678]Whether to allow or block URL requests when the URL filtering process does not have connectivity to a URL filtering database. When allow-mode is on, all unmatched URL requests are allowed; when off, all unmatched URL requests are blocked.

  
        

 
         
         		 [bookmark: pgfId-246684]External Filtering Tab

 [bookmark: pgfId-246686]The fields on this tab define the properties for an external URL filtering server.

  
        

 
         
         		[bookmark: pgfId-246694]Server Type

 [bookmark: pgfId-246696]Server Table

  
         		[bookmark: pgfId-246698]The type of external URL filtering server you are configuring, either SmartFilter (N2H2) or Websense.

 
           
           		 [bookmark: pgfId-246703]To add servers, click the Add button and fill in the Add External Filter dialog box (see Add or Edit External Filter Dialog Box).

 
           		 [bookmark: pgfId-246705]To edit a server, select it and click the Edit button.

 
           		 [bookmark: pgfId-246707]To delete a server, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-246713]Source Interface

  
         		[bookmark: pgfId-246715]The interface whose IP address should be used as the source IP address when a TCP connection is established between the system and the URL filtering server.

  
        

 
         
         		[bookmark: pgfId-246721]Maximum Cache Entries

  
         		[bookmark: pgfId-246723]The maximum number of entries to store in the categorization cache. The default is 5000.

  
        

 
         
         		[bookmark: pgfId-246729]Maximum Requests

  
         		[bookmark: pgfId-246731]The maximum number of pending requests. The range is from 1 to 2147483647. The default is 1000.

  
        

 
         
         		[bookmark: pgfId-246737]Maximum Responses

  
         		[bookmark: pgfId-246739]The maximum number of HTTP responses that can be buffered. The range is from 0 and 20000. The default is 200.

  
        

 
         
         		[bookmark: pgfId-246745]Truncate Hostname

 [bookmark: pgfId-246747]Truncate Script Parameters

  
         		[bookmark: pgfId-246749]Whether to truncate the URLs:

 
           
           		 [bookmark: pgfId-246751]If you do not select an option, URLs are not truncated.

 
           		 [bookmark: pgfId-246753]If you select Hostname, URLs are truncated at the end of the domain name.

 
           		 [bookmark: pgfId-246755]If you select Script Parameters, URLs are truncated at the left-most question mark in the URL.

 
          

 [bookmark: pgfId-246757]Do not select any truncate options for devices running software releases lower than 12.4(15)T or you will receive a validation error.

 [bookmark: pgfId-246759]Tip Although you can select both options, it is illogical to do so.  
        

 
         
         		[bookmark: pgfId-246765]Enable Server Log

  
         		[bookmark: pgfId-246767]Whether to send information about HTTP requests to the URL filtering server’s log server. The information includes the URL, the hostname, the source IP address, and the destination IP address.

  
        

 
         
         		 
           
           [bookmark: pgfId-246773]Additional Fields
          
  
        

 
         
         		[bookmark: pgfId-246781]Category

  
         		[bookmark: pgfId-246786]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-246792]Allow Value Override per Device

 [bookmark: pgfId-246794]Overrides

 [bookmark: pgfId-246796]Edit button

  
         		[bookmark: pgfId-246804]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-246806]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-250955][bookmark: 58555][bookmark: pobjpage_cncpt_URLFilterParameterMapAddURLDialogBoxes]Add or Edit URL Domain Name Dialog Box for URL Filter Parameters [bookmark: marker-250951][bookmark: marker-250953]

 
     [bookmark: pgfId-250957]Use the Add URL Domain Name dialog box to add web site domain names to the whitelisted (allowed) or blacklisted (not allowed) lists.

 
     [bookmark: pgfId-250959]Domain names can be complete (including the host name, such as www.cisco.com), or partial (such as cisco.com). For partial names, all web site hosts on that domain are either permitted or denied. You can also enter host IP addresses.

 
     [bookmark: pgfId-250961]Navigation Path

 
     [bookmark: pgfId-250966]From the Add or Edit URL Filter Parameter Map dialog boxes, click the Add button beneath the whitelist or blacklist tables, or select a name and click the Edit button. See Configuring URL Filter Parameter Maps.

 
    
 
     
      [bookmark: pgfId-250986][bookmark: 58573][bookmark: pobjpage_cncpt_URLFGlobParameterMapDialogBoxes]Configuring URLF Glob Parameter Maps [bookmark: marker-250974][bookmark: marker-250976][bookmark: marker-250978][bookmark: marker-250980][bookmark: marker-250982][bookmark: marker-250984]

 
     [bookmark: pgfId-250988]Use the Add and Edit URLF Glob Parameter Map dialog boxes to define a parameter map for the inspection of URLs in a Local web filter class map.

 
     [bookmark: pgfId-250990]A single URLF Glob should contain only segments of URLs that you want to block or allow. Your goal is to create class maps of white listed (allowed) or blacklisted (blocked) URLs. You can then define Local web filter policy maps to allow or block the identified URLs.

 
     [bookmark: pgfId-250992]A single URLF Glob must also be limited to one of these types of URL segments:

 
      
      		 [bookmark: pgfId-250994]Strings that appear in the server name of a URL, which includes the name of the server and the domain name of the network. For example, www.cisco.com.

 
      		 [bookmark: pgfId-250996]Strings that appear in URL keywords, which are the strings that appear between / characters in a URL, or which are the file names. For example, in the URL segment www.cisco.com/en/US/, both en and US are keywords. The file name in a URL, such as index.html, is also considered a keyword.

 
     

 
     [bookmark: pgfId-250998]You cannot use the characters /, {, }, and ? in a URLF glob.

 
     [bookmark: pgfId-251000]To match a server name or URL keyword, the string in the URL must match exactly the string included in the URLF glob unless you use wildcard metacharacters to specify a variable string pattern. You can use the following metacharacters for pattern matching for either server names or URL keywords:

 
      
      		 [bookmark: pgfId-251010]* (Asterisk). Matches any sequence of zero or more characters. For example, *.edu matches all servers in the education domain, and you could use hack* to block www.example.com/hacksite/123.html.[bookmark: marker-251002][bookmark: marker-251004][bookmark: marker-251006][bookmark: marker-251008]

 
      		 [bookmark: pgfId-251012][abc] (Character class). Matches any character in the brackets. The character matching is case sensitive. For example, [abc] matches a, b, or c, but not A, B, or C. Thus, you could use www.[ey]xample.com to block both www.example.com and www.yxample.com.

 
      		 [bookmark: pgfId-251014][a-c] (Character range class). Matches any character in the range. The character matching is case sensitive. [a-z] matches any lowercase letter. You can mix characters and ranges; for example, [abcq-z] matches a, b, c, q, r, s, t, u, v, w, x, y, z, and so does [a-cq-z].The dash (-) character is literal only if it is the last or the first character within the brackets, [abc-] or [-abc].

 
      		 [bookmark: pgfId-251016][0-9] (Numerical range class). Matches any number in the brackets. For example [0-9] matches 0, 1, 2, 3, 4, 5, 6, 7, 8, or 9. Thus, you can use www.example[0-9][0-9].com to block www.example01.com, www.example33.com, and www.example99.com (and so forth).

 
     

 
     [bookmark: pgfId-251018]Navigation Path

 
     [bookmark: pgfId-251020]Select Manage > Policy Objects, then select Maps > Parameter Maps > Web Filter > URLF Glob Parameters in the table of contents. Right-click inside the work area and select New Object, or right-click a row and select Edit Object.

 
     [bookmark: pgfId-251022]Related Topics

 
      
      		 [bookmark: pgfId-251027]Understanding Map Objects

 
      		 [bookmark: pgfId-251032]Local Web Filter Class Add or Edit Match Criterion Dialog Boxes

 
      		 [bookmark: pgfId-251037]Configuring Content Filtering Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-251042]Understanding the Zone-based Firewall Rules

 
     

 
     [bookmark: pgfId-251044]Field Reference

 
     [bookmark: pgfId-251047] 

 
      
       
        
        [bookmark: pgfId-246819]Table 21-18 [bookmark: 58654]Add or Edit URLF Glob Parameter Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-246825]Element
          
  
         		
           
           [bookmark: pgfId-246827]Description
          
  
        

 
         
         		[bookmark: pgfId-246833]Name

  
         		[bookmark: pgfId-246835]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-246841]Description

  
         		[bookmark: pgfId-246843]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-246849]Value

  
         		[bookmark: pgfId-246851]The server domains or keywords for the URLs you are targeting. Enter only one type of glob: either all server domains, or all URL keywords, but not a mixture of both.

 [bookmark: pgfId-246853]If you include more than one entry, separate the entries with new lines. For example, the following entries identify all government or education web servers:

 
           
           [bookmark: pgfId-246855]*.gov
          
 
           
           [bookmark: pgfId-246857]*.edu
          
 
           
           [bookmark: pgfId-246859] 
          
  
        

 
         
         		[bookmark: pgfId-246865]Category

  
         		[bookmark: pgfId-246870]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-246876]Allow Value Override per Device

 [bookmark: pgfId-246878]Overrides

 [bookmark: pgfId-246880]Edit button

  
         		[bookmark: pgfId-246888]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-246890]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-251067][bookmark: 58702][bookmark: pobjpage_cncpt_WebFilterPolicyMapDialogBoxes]Configuring Web Filter Maps[bookmark: marker-251055][bookmark: marker-251057][bookmark: marker-251059][bookmark: marker-251061][bookmark: marker-251063][bookmark: marker-251065]

 
     [bookmark: pgfId-251069]Use the Add and Edit Web Filter Map dialog boxes to define the parameters and match criterion and values for an inspection map used in a zone-based firewall policy for a router.

 
     [bookmark: pgfId-251074]If you configure the action of a zone-based firewall policy rule as Content Filter, you can select a Web Filter policy map to define web filtering parameters and match criteria. You can select Web Filter policy maps only for routers running Cisco IOS Software release 12.4(20)T and higher. If you are configuring zone-based firewalls for routers running Cisco IOS Software release 12.4(6)T up to 12.4(20)T, you must configure a URL Filter parameter map instead of a Web Filter policy map. For more information, see Configuring URL Filter Parameter Maps.

 
     [bookmark: pgfId-251076]You can configure a mix of local and server-based web filtering. To do this, you should select a parameter map appropriate for the type of server you are using, and for the match criteria, an appropriate mix of local and server class maps. Do not mix class and parameter maps for different types of servers.

 
     [bookmark: pgfId-251078]Navigation Path

 
     [bookmark: pgfId-251080]Select Manage > Policy Objects, then select Maps > Policy Maps > Web Filter > Web Filter from the Object Type selector. Right-click inside the table and select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-251082]Related Topics

 
      
      		 [bookmark: pgfId-251087]Understanding Map Objects

 
      		 [bookmark: pgfId-251092]Configuring Content Filtering Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-251097]Understanding the Zone-based Firewall Rules

 
     

 
     [bookmark: pgfId-251099]Field Reference

 
     [bookmark: pgfId-251102] 

 
      
       
        
        [bookmark: pgfId-246903]Table 21-19 [bookmark: 58751]Add and Edit FTP Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-246909]Element
          
  
         		
           
           [bookmark: pgfId-246911]Description
          
  
        

 
         
         		[bookmark: pgfId-246917]Name

  
         		[bookmark: pgfId-246919]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-246925]Description

  
         		[bookmark: pgfId-246927]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		 
           
           [bookmark: pgfId-246933]Parameters tab
          
  
        

 
         
         		[bookmark: pgfId-246941]Parameter Type

 [bookmark: pgfId-246943]Parameter Map

  
         		[bookmark: pgfId-246945]The type of parameter map to include in the Web Filter policy map. Select None if you do not want to select a parameter map.

 [bookmark: pgfId-246947]If you select a specific parameter type, enter the name of the parameter map in the Parameter Map field. Click Select to select the map from a list or to create a new parameter map object.

  
        

 
         
         		 [bookmark: pgfId-246953]Match Condition and Action Tab

 [bookmark: pgfId-246955]The Match All table lists class maps included in the policy map, and the action to take for traffic that matches the class. For traffic to match this class, all criteria defined in the selected class maps must be met.

 
           
           		 [bookmark: pgfId-246960]To add a criterion, click the Add button and fill in the Match Condition and Action dialog box (see Add or Edit Match Condition and Action Dialog Boxes for Zone-Based Firewall and Web Filter Policies).

 
           		 [bookmark: pgfId-246962]To edit a criterion, select it and click the Edit button.

 
           		 [bookmark: pgfId-246964]To delete a criterion, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-246972]Category

  
         		[bookmark: pgfId-246977]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-246983]Allow Value Override per Device

 [bookmark: pgfId-246985]Overrides

 [bookmark: pgfId-246987]Edit button

  
         		[bookmark: pgfId-246995]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-246997]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-251112][bookmark: 58819][bookmark: porules_cncpt_ZoneBasedFW_ClassDefault]Changing the Default Drop Behavior[bookmark: marker-251108][bookmark: marker-251110]

 
    [bookmark: pgfId-251114]By default, all traffic between zones is dropped unless explicitly allowed. However, you can change this default behavior, as described in this section.

 
    [bookmark: pgfId-251122]Security Manager converts the parameters—including class, parameter, and policy maps—that you supply for zone-based firewall rules into a series of IOS commands that the router will recognize. These are the so-called "CLI" (command line interface) configuration commands, which you can preview in separate window by choosing Tools > Preview Configuration. See Previewing Configurations for more information. In addition, the section, Troubleshooting Zone-based Rules and Configurations, discusses an example of zone-based firewall CLI commands.

 
    [bookmark: pgfId-251124]For the purposes of this discussion, the most interesting of these commands is policy-map, which is used to apply your zone policy for each pair of zones. That is, for any given zone-pair, all rules defining traffic (classes) and actions are applied within one policy-map. Further, Security Manager appends the current class-default class to the end of each policy-map’s class list to capture any packets not processed by a zone rule.

 
    [bookmark: pgfId-251126]The default class-default is drop—appending this class to each policy-map is how the implicit dropping of traffic between zones is accomplished. However, as mentioned, you can change this default behavior for any zone-pair. For example, you might elect to pass all unmatched traffic, or you might change the default to drop and log so you can determine what traffic is not being matched by your existing rules.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-251128]Note The only options for the default behavior are Drop, Drop and Log, Pass, and Pass and Log.


    
     

    

    

 
    [bookmark: pgfId-251133]If you want the default policy to continue to drop packets, you do not have to do anything in Security Manager. This rule is generated automatically. If you do want to change the default behavior for a zone-pair, you must provide a Permit any any IP rule (that is, Match: Permit; Sources: any; Destinations: any; Services: IP in the Adding and Editing Zone-based Firewall Rules), with Drop and Log, Pass, or Pass and Log as the chosen Action. You must also ensure that this rule appears last in the list of rules for a zone pair. Security Manager interprets this as the intended class-default rule.

 
    [bookmark: pgfId-251135]If your zone-based rules table includes a large number of rules, it might be difficult to ensure that this rule comes after all other rules for a zone pair. Here are a couple of techniques you can use to alleviate this:

 
     
     		 [bookmark: pgfId-251140]Use sections to organize the table, with one section per zone-pair. This will make it easier for you to order the rules for a zone-pair, as well as ensuring that the class-default rule comes last. For more information on working with sections, see Using Sections to Organize Rules Tables.

 
     		 [bookmark: pgfId-251148]Create a shared zone-based rules policy that includes the class-default rule in the Default scope, and inherit this rule in the device’s local zone-based rule policy. For more information on inheritance and creating shared policies, see Inheriting or Uninheriting Rules and Creating a New Shared Policy.

 
    

 
   
 
    
     [bookmark: pgfId-251162][bookmark: 58853][bookmark: porules_proc_ZoneBasedFW_ConfiguringSettings]Configuring Settings for Zone-based Firewall Rules[bookmark: marker-251154][bookmark: marker-251156][bookmark: marker-251158][bookmark: marker-251160]

 
    [bookmark: pgfId-251164]Use the Zone Based Firewall settings page to: identify unreferenced zones; specify a zone for VPN interfaces; enable or disable WAAS support; maintain Trend Micro server and certificate information; and specify global Log settings on supported ASR devices.

 
    [bookmark: pgfId-251166]Related Topics

 
     
     		 [bookmark: pgfId-251171]Zone Based Firewall Page

 
     		 [bookmark: pgfId-251176]Understanding the Zone-based Firewall Rules

 
    

 
    
 
    [bookmark: pgfId-251181]Step 1 Access the Zone Based Firewall Page as follows:

 
     
     		 [bookmark: pgfId-251183](Device view) Select an IOS device and then select  Firewall > Settings > Zone Based Firewall from the Policy selector.

 
     		 [bookmark: pgfId-251185](Policy view) Select  Firewall > Settings > Zone Based Firewall from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-251187]Step 2 (Optional) On the Zones tab: add, edit and delete unreferenced zones.

 
    [bookmark: pgfId-251189]The Zones tab lists all unreferenced zones defined on the device; that is, zones without any associated interfaces, rules or policies. Unreferenced zones are usually found and listed during device discovery, but you also can create named, “empty” zones here.

 
    [bookmark: pgfId-251191]Step 3 (Optional) On the VPN tab, supply the name of the zone specifically set up for VPN traffic.

 
    [bookmark: pgfId-251196]This zone ensures that dynamic VPN traffic can be processed by the zone-based firewall rules on this router. See Using VPNs with Zone-based Firewall Policies for more information.

 
    [bookmark: pgfId-251198]Step 4 (Optional) On the WAAS tab, select Enable WAAS to enable Wide Area Application Services interoperability.

 
    [bookmark: pgfId-251200]If this option is not enabled, packets being optimized by a WAAS device may be dropped because WAAS increases the TCP packet sequence number during the TCP handshake. This behavior may be viewed as a possible attack by the IOS device.

 
    [bookmark: pgfId-251202]Step 5 (Optional) On the Content Filter Settings tab, provide server settings for Trend Micro-based content filtering.

 
    [bookmark: pgfId-251204]To use Trend Micro-based content filtering, you must configure contact information for the Trend Micro server on this tab of the Zone Based Firewall page. This tab also provides links to Trend Micro registration and certificate download. You must have an active subscription with Trend Micro to utilize this form of content filtering, and you must download and install a valid subscription certificate on this IOS device.

 
    [bookmark: pgfId-251209]For more information, see Zone Based Firewall Page - Content Filter Tab.

 
    [bookmark: pgfId-251211]Step 6 (Optional) On the Global Parameters (ASR) tab, you can configure global, logging-related settings specific to ASR devices:

 
     
     		 [bookmark: pgfId-251213]Log Dropped Packets – Select this option to log all packets dropped by the device; syslog logging must be enabled to view the information.

 
     		 [bookmark: pgfId-251215]Log Flow export timeout rate – NetFlow logs are created after a flow either expires or is timed out, and it is important to put a time limit on how long a flow can be active before expiring. This value is maximum number of minutes a flow can remain active before it is expired. The value can be any integer from 1 to 3600; the default is 30.

 
     		 [bookmark: pgfId-251217]Log Flow export destination IP – The IP address or host name of the NetFlow collector to which flow data is to be sent.

 
     		 [bookmark: pgfId-251219]Log Flow export destination port – The UDP port monitored by the NetFlow collector for flow data.

 
    

 
    [bookmark: pgfId-251221]


    
     

    
 
    

 
     
      [bookmark: pgfId-251259][bookmark: 58918][bookmark: fwlsvcpg_cncpt_ZoneBasedFWSettingsPage]Zone Based Firewall Page[bookmark: marker-251237][bookmark: marker-251239][bookmark: marker-251241][bookmark: marker-251243][bookmark: marker-251245][bookmark: marker-251247][bookmark: marker-251249][bookmark: marker-251251][bookmark: marker-251253][bookmark: marker-251255][bookmark: marker-251257]

 
     [bookmark: pgfId-251261]Use the Zone Based Firewall page to configure and identify unreferenced zones, specify a VPN zone, enable or disable WAAS support, maintain Trend Micro server and certificate information, and specify global Log settings on supported ASR devices.

 
     [bookmark: pgfId-251263]The following tabs are described in the table on this page:

 
      
      		 [bookmark: pgfId-251265] Zones 

 
      		 [bookmark: pgfId-251267] VPN 

 
      		 [bookmark: pgfId-251269] WAAS 

 
      		 [bookmark: pgfId-251271] Global Parameters (ASR) 

 
     

 
     [bookmark: pgfId-251276]The Content Filtering tab is detailed in Zone Based Firewall Page - Content Filter Tab.

 
     [bookmark: pgfId-251278]Navigation Path

 
     [bookmark: pgfId-251280]To access the Zone Based Firewall page, do one of the following:

 
      
      		 [bookmark: pgfId-251282](Device view) Select a device, then select  Firewall > Settings > Zone Based Firewall from the Policy selector.

 
      		 [bookmark: pgfId-251284](Policy view) Select  Firewall > Settings > Zone Based Firewall from the Policy Type selector. Create a new policy or select an existing one.

 
      		 [bookmark: pgfId-251286](Map view) Right-click a device and choose  Edit Firewall Settings > Zone Based Firewall .

 
     

 
     [bookmark: pgfId-251288]Related Topics

 
      
      		 [bookmark: pgfId-251293]Configuring Settings for Zone-based Firewall Rules

 
      		 [bookmark: pgfId-251298]Understanding the Zone-based Firewall Rules

 
      		 [bookmark: pgfId-251303]Adding Zone-Based Firewall Rules

 
     

 
     [bookmark: pgfId-251305]Field Reference

 
     [bookmark: pgfId-251308] 

 
      
       
        
        [bookmark: pgfId-247010]Table 21-20 [bookmark: 59010]Zone Based Firewall Page 

 
        
       
         
         		
           
           [bookmark: pgfId-247016]Element
          
  
         		
           
           [bookmark: pgfId-247018]Description
          
  
        

 
         
         		[bookmark: pgfId-247024]Zones tab

  
         		[bookmark: pgfId-247026]This tab displays the Zones table, which lists unreferenced zones; that is zones without any associated interfaces, rules or policies. Unreferenced zones are usually found and listed during device discovery, but you also can create named, “empty” zones here.

 [bookmark: pgfId-247028]The Zones table lists the following information for each unreferenced zone:

 
           
           		 [bookmark: pgfId-247030]Zone – The name of the Zone/Interface Role.

 
           		 [bookmark: pgfId-247032]Content – Any interfaces assigned to the zone.

 
           		 [bookmark: pgfId-247034]Description – Any user-provided comments about the zone.

 
          

 [bookmark: pgfId-247036]To add a zone to this table, click the Add Row button and provide a Zone name in the Zone dialog box.

  
        

 
         
         		[bookmark: pgfId-247042]VPN tab

  
         		[bookmark: pgfId-247047]This tab presents the VPN Zone field; a zone entry in this field ensures that dynamic VPN traffic can be processed by the zone-based firewall rules on this router. See Using VPNs with Zone-based Firewall Policies for more information about this zone.

 [bookmark: pgfId-247049]Enter or Select the zone through which VPN traffic will pass.

  
        

 
         
         		[bookmark: pgfId-247055]WAAS tab

  
         		[bookmark: pgfId-247057]This tab presents the Enable WAAS check box. Select this option to enable Wide Area Application Services interoperability.

 [bookmark: pgfId-247059]If this option is not enabled, packets being optimized by a WAAS device may be dropped because WAAS increases the TCP packet sequence number during the TCP handshake. This behavior may be viewed as a possible attack by the IOS device.

  
        

 
         
         		[bookmark: pgfId-247065]Content Filtering tab

  
         		[bookmark: pgfId-247070]This tab displays server settings and certificate links for Trend Micro-based content filtering. For more information, see Zone Based Firewall Page - Content Filter Tab.

  
        

 
         
         		[bookmark: pgfId-247076]Global Parameters (ASR) tab

  
         		[bookmark: pgfId-247078]This tab displays global, logging-related settings specific to ASR devices. Configure these settings as follows:

 
           
           		 [bookmark: pgfId-247080]Log Dropped Packets – Select this option to log all packets dropped by the device; syslog logging must be enabled to view the information.

 
           		 [bookmark: pgfId-247082]Log Flow export timeout rate – NetFlow logs are created after a flow either expires or is timed out, and it is important to put a time limit on how long a flow can be active before expiring. This value is maximum number of minutes a flow can remain active before it is expired. The value can be any integer from 1 to 3600; the default is 30.

 
           		 [bookmark: pgfId-247084]Log Flow export destination IP – The IP address or host name of the NetFlow collector to which flow data is to be sent.

 
           		 [bookmark: pgfId-247086]Log Flow export destination port – The UDP port monitored by the NetFlow collector for flow data.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-251320][bookmark: 59067][bookmark: fwlsvcpg_cncpt_ZBFWSettingsContentFilterTab]Zone Based Firewall Page - Content Filter Tab[bookmark: marker-251316][bookmark: marker-251318]

 
     [bookmark: pgfId-251322]To use Trend Micro-based content filtering, you must configure contact information for the Trend Micro server on this tab of the Zone Based Firewall page. This tab also provides links to Trend Micro registration and certificate download. You must have an active subscription with Trend Micro to utilize this form of content filtering, and you must download and install a valid subscription certificate on this IOS device.

 
     [bookmark: pgfId-251324]Navigation Path

 
     [bookmark: pgfId-251326]To access the Zone Based Firewall page, do one of the following:

 
      
      		 [bookmark: pgfId-251328](Device view) Select a device, then select  Firewall > Settings > Zone Based Firewall from the Device selector.

 
      		 [bookmark: pgfId-251330](Policy view) Select  Firewall > Settings > Zone Based Firewall from the Policy selector.

 
      		 [bookmark: pgfId-251332](Map view) Right-click a device and choose  Edit Firewall Settings > Zone Based Firewall .

 
     

 
     [bookmark: pgfId-251334]Related Topics

 
      
      		 [bookmark: pgfId-251339]Zone-based Firewall Rules Page

 
      		 [bookmark: pgfId-251344]Configuring Content Filtering Maps for Zone-based Firewall Policies

 
      		 [bookmark: pgfId-251349]Understanding the Zone-based Firewall Rules

 
      		 [bookmark: pgfId-251354]Adding Zone-Based Firewall Rules

 
     

 
     [bookmark: pgfId-251356]Field Reference

 
     [bookmark: pgfId-251359] 

 
      
       
        
        [bookmark: pgfId-247099]Table 21-21 [bookmark: 59109]Zone Based Firewall Page - Content Filter Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-247105]Element
          
  
         		
           
           [bookmark: pgfId-247107]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-247113]Trend Micro Server Settings
          
  
        

 
         
         		[bookmark: pgfId-247121]Cache-entry-lifetime (hrs)

  
         		[bookmark: pgfId-247123]How long, in hours, a look-up request to the Trend Micro server remains in the router’s local URL cache table. The allowed range is 0 to 120; the default value is 24.

  
        

 
         
         		[bookmark: pgfId-247129]Cache-size (KBytes)

  
         		[bookmark: pgfId-247131]The maximum amount of memory to be used by the router’s local URL cache. The allowed range is 0 to 120,000 KB; the default value is 250.

  
        

 
         
         		[bookmark: pgfId-247137]Server

  
         		[bookmark: pgfId-247139]The fully-qualified domain name or IP address of the Trend Micro URL filtering server.

  
        

 
         
         		[bookmark: pgfId-247145]HTTP Port

  
         		[bookmark: pgfId-247147]The port the Trend Micro server is listening to for HTTP requests. The default is 80.

  
        

 
         
         		[bookmark: pgfId-247153]HTTPS Port

  
         		[bookmark: pgfId-247155]The port the Trend Micro server is listening to for HTTPS requests. The default is 443.

  
        

 
         
         		[bookmark: pgfId-247161]Retransmission Count

  
         		[bookmark: pgfId-247163]The number of times the router retransmits a look-up request when a response is not received from the server. The range is 1 to 10.

  
        

 
         
         		[bookmark: pgfId-247169]Retransmission Timeout

  
         		[bookmark: pgfId-247171]The number of seconds that the router waits for a response from the server. The range is 1 to 300.

  
        

 
         
         		[bookmark: pgfId-247177]Alert

  
         		[bookmark: pgfId-247179]Whether stateful packet inspection messages are copied to the syslog.

  
        

 
         
         		 
           
           [bookmark: pgfId-247185]Trend Micro Server Certificate Download Links
          
  
        

 
         
         		[bookmark: pgfId-247193]Link to download certificates

  
         		[bookmark: pgfId-247195]Opens the page for installing Trusted Authority Certificates on Cisco IOS Routers for Trend URL Filtering Support.

  
        

 
         
         		[bookmark: pgfId-247201]Link for product registration

  
         		[bookmark: pgfId-247203]Opens the page for Product License Registration. You must enter the Product Authorization Key and register the router.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-251371][bookmark: 59180][bookmark: fwlsvcpg_cncpt_ZoneBasedFWSettingsAddEditZone]Zone Dialog Box[bookmark: marker-251367][bookmark: marker-251369]

 
     [bookmark: pgfId-251373]Use the Add and Edit Zone dialog boxes to add and edit unreferenced zones—zones without any associated interfaces, rules or policies.

 
     [bookmark: pgfId-251375]Navigation Path

 
     [bookmark: pgfId-251377]To access the Add and Edit Zone dialog boxes, do one of the following:

 
      
      		 [bookmark: pgfId-251379](Device view) Select a device, then select  Firewall > Settings > Zone Based Firewall from the Device selector. Right-click inside the Zones table, then select  Add Row , or right-click a line item, then select  Edit Row .

 
      		 [bookmark: pgfId-251381](Policy view) Select  Firewall > Settings > Zone Based Firewall from the Policy selector. Right-click inside the table, then select  Add Row , or right-click a line item, then select  Edit Row .

 
      		 [bookmark: pgfId-251383](Map view) Right-click a device and select  Edit Firewall Policies > Settings > Zone Based Firewall Rules .

 
     

 
     [bookmark: pgfId-251385]Enter a zone name in the Zone field, or click Select to choose one from the Interfaces Selector dialog box.

 
     [bookmark: pgfId-251387]Related Topics

 
      
      		 [bookmark: pgfId-251392]Zone Based Firewall Page

 
      		 [bookmark: pgfId-251397]Understanding the Zone-based Firewall Rules

 
      		 [bookmark: pgfId-251402]Configuring Settings for Zone-based Firewall Rules

 
     

 
    
 
   
 
    
     [bookmark: pgfId-251412][bookmark: 59225][bookmark: porules_cncpt_ZoneBasedFW_Troubleshooting]Troubleshooting Zone-based Rules and Configurations [bookmark: marker-251408][bookmark: marker-251410]

 
    [bookmark: pgfId-251414]Zone-based firewall rules are powerful, but also complex. Using zone rules, you can replace access rules, inspection rules, and Web filter rules with a single type of firewall rule. Because zone-based firewall rules can perform so many possible actions, the configuration generated from them uses many different types of configuration commands, including structures for access control lists (ACLs), class maps, and policy maps. There is no one-to-one correspondence between a zone-based firewall rule and a line in the configuration (unlike access rules, for example).

 
    [bookmark: pgfId-251416]To illustrate this complexity, this topic describes the relationship between zone-based firewall rules and the configuration generated from them. You do not need to know any of the information in this topic to create and deploy zone-based firewall rules. However, if you are familiar with the CLI (command line interface), or if you find that your rules are generating undesired results, this information can help you understand and troubleshoot zone-based firewall rules.

 
    [bookmark: pgfId-251418]Consider the set of rules shown in the following illustration. These rules form a policy for a single zone pair, affecting traffic moving from the Inside zone to the Outside zone. This is traffic from your internal network going to the Internet. The rules define the following actions:

 
     
     		 [bookmark: pgfId-251420]Drop all traffic from the 10.100.10.0/24 and 10.100.11.0/24 networks.

 
     		 [bookmark: pgfId-251422]Drop all FTP and FTPS traffic from the 10.100.12.0/24 network.

 
     		 [bookmark: pgfId-251424]Drop all peer-to-peer traffic from any network.

 
     		 [bookmark: pgfId-251426]Inspect (and allow) all FTP/FTPS traffic (except for that from 10.100.12.0/24, which is already dropped).

 
     		 [bookmark: pgfId-251428]Inspect all HTTP traffic using an additional deep-inspection policy map.

 
     		 [bookmark: pgfId-251430]And finally, perform generic inspection of all remaining TCP/UDP traffic.

 
    

 
    [bookmark: pgfId-251434]Figure 21-3 [bookmark: 59250]Example of Zone-based Rules for a Zone Pair

 
    [bookmark: pgfId-251437] 

 
     
     [image: ] 
    
 
    [bookmark: pgfId-251439]When you deploy these rules, Security Manager generates the following configuration. The bold letters are added for reference in the explanation that follows the configuration.

 
    [bookmark: pgfId-251441]A.

 
    
     [bookmark: pgfId-251443]class-map type inspect http match-any HTTPcmap
    

    
     [bookmark: pgfId-251445] match req-resp protocol-violation
    

    
     [bookmark: pgfId-251447] match request port-misuse any
    

    
     [bookmark: pgfId-251449]!
    

    
     [bookmark: pgfId-251451] 
    

    
     [bookmark: pgfId-251453] 
    

    [bookmark: pgfId-251455]B.

 
    
     [bookmark: pgfId-251457]policy-map type inspect http HTTPpmap
    

    
     [bookmark: pgfId-251459] class type inspect http HTTPcmap
    

    
     [bookmark: pgfId-251461] reset
    

    
     [bookmark: pgfId-251463] log
    

    
     [bookmark: pgfId-251465]!
    

    
     [bookmark: pgfId-251467] 
    

    
     [bookmark: pgfId-251469] 
    

    [bookmark: pgfId-251471]C.

 
    
     [bookmark: pgfId-251473]class-map type inspect CSM_ZBF_CLASS_MAP_1
    

    
     [bookmark: pgfId-251475] match access-group name CSM_ZBF_CMAP_ACL_1
    

    
     [bookmark: pgfId-251477]!
    

    
     [bookmark: pgfId-251479] 
    

    
     [bookmark: pgfId-251481] 
    

    [bookmark: pgfId-251483]D.

 
    
     [bookmark: pgfId-251485]class-map type inspect match-any CSM_ZBF_CMAP_PLMAP_1
    

    
     [bookmark: pgfId-251487] match protocol ftp
    

    
     [bookmark: pgfId-251489] match protocol ftps
    

    
     [bookmark: pgfId-251491]!
    

    
     [bookmark: pgfId-251493] 
    

    
     [bookmark: pgfId-251495] 
    

    [bookmark: pgfId-251497]E.

 
    
     [bookmark: pgfId-251499]class-map type inspect CSM_ZBF_CLASS_MAP_2
    

    
     [bookmark: pgfId-251501] match access-group name CSM_ZBF_CMAP_ACL_2
    

    
     [bookmark: pgfId-251503] match class-map CSM_ZBF_CMAP_PLMAP_1
    

    
     [bookmark: pgfId-251505]!
    

    
     [bookmark: pgfId-251507] 
    

    
     [bookmark: pgfId-251509] 
    

    [bookmark: pgfId-251511]F.

 
    
     [bookmark: pgfId-251513]class-map type inspect match-any CSM_ZBF_CLASS_MAP_3
    

    
     [bookmark: pgfId-251515] match protocol bittorrent
    

    
     [bookmark: pgfId-251517] match protocol edonkey
    

    
     [bookmark: pgfId-251519] match protocol fasttrack
    

    
     [bookmark: pgfId-251521] match protocol icq
    

    
     [bookmark: pgfId-251523] match protocol kazaa2
    

    
     [bookmark: pgfId-251525]!
    

    
     [bookmark: pgfId-251527] 
    

    
     [bookmark: pgfId-251529] 
    

    [bookmark: pgfId-251531]G.

 
    
     [bookmark: pgfId-251533]class-map type inspect CSM_ZBF_CLASS_MAP_4
    

    
     [bookmark: pgfId-251535] match protocol http
    

    
     [bookmark: pgfId-251537]!
    

    
     [bookmark: pgfId-251539] 
    

    
     [bookmark: pgfId-251541] 
    

    [bookmark: pgfId-251543]H.

 
    
     [bookmark: pgfId-251545]class-map type inspect match-any CSM_ZBF_CLASS_MAP_5
    

    
     [bookmark: pgfId-251547] match protocol tcp
    

    
     [bookmark: pgfId-251549] match protocol udp
    

    
     [bookmark: pgfId-251551]!
    

    
     [bookmark: pgfId-251553] 
    

    
     [bookmark: pgfId-251555] 
    

    [bookmark: pgfId-251557]I.

 
    
     [bookmark: pgfId-251559]policy-map type inspect CSM_ZBF_POLICY_MAP_1
    

    
     [bookmark: pgfId-251561] class type inspect CSM_ZBF_CLASS_MAP_1
    

    
     [bookmark: pgfId-251563] drop
    

    
     [bookmark: pgfId-251565] class type inspect CSM_ZBF_CLASS_MAP_2
    

    
     [bookmark: pgfId-251567] drop
    

    
     [bookmark: pgfId-251569] class type inspect CSM_ZBF_CLASS_MAP_3
    

    
     [bookmark: pgfId-251571] drop 
    

    
     [bookmark: pgfId-251573]class type inspect CSM_ZBF_CMAP_PLMAP_1
    

    
     [bookmark: pgfId-251575] inspect
    

    
     [bookmark: pgfId-251577] class type inspect CSM_ZBF_CLASS_MAP_4
    

    
     [bookmark: pgfId-251579] inspect
    

    
     [bookmark: pgfId-251581] service-policy http HTTPpmap
    

    
     [bookmark: pgfId-251583] class type inspect CSM_ZBF_CLASS_MAP_5
    

    
     [bookmark: pgfId-251585] inspect
    

    
     [bookmark: pgfId-251587] class class-default
    

    
     [bookmark: pgfId-251589] drop
    

    
     [bookmark: pgfId-251591]!
    

    
     [bookmark: pgfId-251593] 
    

    
     [bookmark: pgfId-251595] 
    

    [bookmark: pgfId-251597]J.

 
    
     [bookmark: pgfId-251599]zone security Inside
    

    
     [bookmark: pgfId-251601]zone security Outside
    

    
     [bookmark: pgfId-251603]zone-pair security CSM_Inside-Outside_1 source Inside destination Outside
    

    
     [bookmark: pgfId-251605] service-policy type inspect CSM_ZBF_POLICY_MAP_1
    

    
     [bookmark: pgfId-251607]!
    

    
     [bookmark: pgfId-251609]interface GigabitEthernet0/1
    

    
     [bookmark: pgfId-251611] ip address dhcp
    

    
     [bookmark: pgfId-251613] zone-member security Inside
    

    
     [bookmark: pgfId-251615]!
    

    
     [bookmark: pgfId-251617]interface GigabitEthernet0/2
    

    
     [bookmark: pgfId-251619] ip address dhcp
    

    
     [bookmark: pgfId-251621] zone-member security Outside
    

    
     [bookmark: pgfId-251623]!
    

    
     [bookmark: pgfId-251625] 
    

    
     [bookmark: pgfId-251627] 
    

    [bookmark: pgfId-251629]K.

 
    
     [bookmark: pgfId-251631]ip access-list extended CSM_ZBF_CMAP_ACL_1
    

    
     [bookmark: pgfId-251633] permit ip 10.100.10.0 0.0.0.255 any
    

    
     [bookmark: pgfId-251635] permit ip 10.100.11.0 0.0.0.255 any
    

    
     [bookmark: pgfId-251637]!
    

    
     [bookmark: pgfId-251639] 
    

    
     [bookmark: pgfId-251641] 
    

    [bookmark: pgfId-251643]L.

 
    
     [bookmark: pgfId-251645]ip access-list extended CSM_ZBF_CMAP_ACL_2
    

    
     [bookmark: pgfId-251647] permit ip 10.100.12.0 0.0.0.255 any
    

    
     [bookmark: pgfId-251649]!
    

    
     [bookmark: pgfId-251651] 
    

    
     [bookmark: pgfId-251653] 
    

    [bookmark: pgfId-251655]The following list explains how the rules in Security Manager are converted to device-configuration commands, to aid your understanding of the relationship between the two. The list numbering corresponds to the rule numbers from the rules table in Security Manager (see the previous illustration):

 
    [bookmark: pgfId-251657] 1. This rule drops all traffic from the 10.100.10.0/24 network. The Permit, Source, Destination, and Service fields are used to create the first access control entry (ACE) in the ACL named CSM_ZBF_CMAP_ACL_1 defined in (K). This ACL is referenced from the class map CSM_ZBF_CLASS_MAP_1 defined in (C), which then defines the first drop rule in the policy map CSM_ZBF_POLICY_MAP_1, defined in (I).

 
    [bookmark: pgfId-251659]The policy map (I) is used to define the zone service policy in (J). Because this policy map is how all of the rules are assigned to the zone pair, (J) is not mentioned again.

 
    [bookmark: pgfId-251661] 2. This rule drops all traffic from the 10.100.11.0/24 network. This rule is combined with rule 1 by adding an ACE to the ACL defined in (K). The rest of the configuration is identical to rule 1. Thus, rules 1 and 2 essentially become a single rule in the device configuration.

 
    [bookmark: pgfId-251663] 3. This rule drops all FTP/FTPS traffic from the 10.100.10.12/24 network. The Permit, Source, Destination, and Service fields are used to create the ACL named CSM_ZBF_CMAP_ACL_2 defined in (L). The Protocol table generates the class map CSM_ZBF_CMAP_PLMAP_1 defined in (D), which specifies the FTP and FTPS protocols. The ACL and FTP/FTPS class map are then used in a new class map, CSM_ZBF_CLASS_MAP_2 defined in (E), which completes the characterization of the traffic based on the combination of source and protocol. Finally, (E) is referenced in the policy map (I) as the second rule.

 
    [bookmark: pgfId-251665] 4. This rule drops peer-to-peer traffic from any source that uses any of these protocols: Bittorrent, eDonkey, FastTrack, ICQ, or Kazaa2. This rule prevents any of your internal servers from being used as a file-sharing source for these services. Because the rule applies to all sources and destinations for the default IP service, no ACL is required. Instead, the configuration starts with the class map CSM_ZBF_CLASS_MAP_3 defined in (F). This class map is referenced by the third drop rule in the policy map (I).

 
    [bookmark: pgfId-251667] 5. This rule inspects FTP/FTPS traffic from any source to any destination, which means these services are allowed. Note that rule 3, because it comes above rule 5, already drops FTP/FTPS traffic from the 10.100.12.0/24 network, so the combination of these rules means that FTP/FTPS traffic is inspected for all sources except 10.100.12.0/24. Because the Protocol table specifies the same protocols as it does for rule 3, no new class map is needed. Instead, the policy map (I) simply refers to the class map (D) as the fourth class type, but this time with the Inspect action.

 
    [bookmark: pgfId-251669] 6. This rule inspects HTTP traffic and applies a deep-inspection policy map named HTTPpmap. The HTTPpmap policy map (B) defines the action to take when traffic matches the criteria defined in the class map HTTPcmap (A). These maps specify that any HTTP connection that violates the HTTP protocol, or that misuses ports, should be reset (dropped) and a syslog entry generated. (Protocol violation and port misuse can characterize Denial of Service attacks.) The combination of (A) and (B) define the deep-inspection rules for this policy.

 
    [bookmark: pgfId-251671]An additional class map, CSM_ZBF_CLASS_MAP_4, is needed to specify the HTTP protocol (G). Then, the fifth class type rule in the policy map (I) refers to class map (G) for inspection, and the service-policy command refers to the policy map (B) for deep inspection.

 
    [bookmark: pgfId-251673] 7. This rule provides generic inspection on TCP/UDP traffic, allowing and inspecting the remaining TCP/UDP traffic from the internal network to the Internet and back. The class map CSM_ZBF_CLASS_MAP_5 defined in (H) is generated from the Protocols table. This class map then becomes the next-to-last rule in the policy map (I).

 
    [bookmark: pgfId-251678] 8. Finally, there is an automatic rule, which appears as the final class-default rule in the policy map (I). This rule drops any traffic that does not match one of the class maps referenced in the policy map (I). For example, ICMP traffic from the internal network to the Internet will not be allowed. For information on configuring a different class-default rule, see Changing the Default Drop Behavior.

 
   
 
    
     [bookmark: pgfId-251690][bookmark: 59383][bookmark: fwlsvcpg_cncpt_ZoneBasedFWRulesPage]Zone-based Firewall Rules Page[bookmark: marker-251686][bookmark: marker-251688]

 
    [bookmark: pgfId-251692]Zone-based firewall rules provide unidirectional application of firewall policies between groups of interfaces known as “zones.” That is, interfaces are assigned to zones, and specific inspection policies are applied to traffic moving between zones in one direction or the other.

 
    [bookmark: pgfId-251694]A zone defines a boundary where traffic is subjected to specific restrictions as it crosses into another region of your network. The default zone-based firewall policy between zones is deny all. Thus, if no policy is explicitly configured, all traffic between zones is blocked.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-251696]Note Zone-based firewall policies can be configured only on Cisco IOS and ASR devices.


    
     

    

    

 
    [bookmark: pgfId-251698]The Zone Based Firewall Rules page displays a list of currently configured zone-based firewall rules, and lets you add, edit and delete rules.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-251703]Tip Disabled rules are shown with hash marks covering the table row. When you deploy the configuration, disabled rules are removed from the device. For more information, see Enabling and Disabling Rules.


    
     

    

    

 
    [bookmark: pgfId-251705]Navigation Path

 
    [bookmark: pgfId-251707]To access the Zone Based Firewall Rules page, do one of the following:

 
     
     		 [bookmark: pgfId-251709](Device view) Select a device, then select  Firewall > Zone Based Firewall Rules from the Policy selector.

 
     		 [bookmark: pgfId-251711](Policy view) Select  Firewall > Zone Based Firewall Rules from the Policy Type selector. Create a new policy or select an existing one.

 
     		 [bookmark: pgfId-251713](Map view) Right-click a device and select  Edit Firewall Policies > Zone Based Firewall Rules .

 
    

 
    [bookmark: pgfId-251715]Related Topics

 
     
     		 [bookmark: pgfId-251720]Understanding the Zone-based Firewall Rules

 
     		 [bookmark: pgfId-251725]Adding Zone-Based Firewall Rules

 
     		 [bookmark: pgfId-251730]Filtering Tables

 
    

 
    [bookmark: pgfId-251732]Field Reference

 
    [bookmark: pgfId-251735] 

 
     
      
       
       [bookmark: pgfId-247216]Table 21-22 [bookmark: 59428]Zone Based Firewall Rules Page 

 
       
      
        
        		
          
          [bookmark: pgfId-247222]Element
         
  
        		
          
          [bookmark: pgfId-247224]Description
         
  
       

 
        
        		[bookmark: pgfId-247230]No.

  
        		[bookmark: pgfId-247232]This number indicates the rule’s position in the ordering of the list. You can use the Up Row and Down Row buttons to change the position of the selected rule.

  
       

 
        
        		[bookmark: pgfId-247238]Permit

  
        		[bookmark: pgfId-247240]Indicates whether the rule permits or denies traffic.

 
          
          		 [bookmark: pgfId-247242]Permit – Shown as a green check mark.

 
          		 [bookmark: pgfId-247244]Deny – Shown as a red circle with a slash.

 
         

  
       

 
        
        		[bookmark: pgfId-247250]Sources

  
        		[bookmark: pgfId-247252]The sources of traffic for this rule; can be networks or security groups. Multiple entries are displayed on separate lines within the table cell.

 
          
          		 [bookmark: pgfId-247254]Network – The network, host, or IP address objects and definitions that are defined as the sources for this rule. The “All-Address” objects do not restrict the rule to specific hosts or networks.

 
         

 [bookmark: pgfId-247262]See Understanding Networks/Hosts Objects and Specifying IP Addresses During Policy Definition for additional information about these definitions.

 
          
          		 [bookmark: pgfId-247273]Security Groups (IOS 15.2(2)T+ and IOS-XE 3.5.x(15.2(1)S)+ only) – The names or tag numbers of the security groups defined as the sources for the rule. See Selecting Security Groups in Policies, Configuring TrustSec-Based Firewall Rules and Creating Security Group Objects for more information about security groups.

 
         

 [bookmark: pgfId-247275]Note Security groups are part of the Cisco TrustSec Support for IOS feature which is supported on Cisco Integrated Services Router Generation 2 (ISR G2) only.

 [bookmark: pgfId-247277]Each specification is combined with any others to limit traffic matches to only those flows that include all definitions. For example, specified user traffic originating from within a specified source address range.

  
       

 
        
        		[bookmark: pgfId-247283]Destinations

  
        		[bookmark: pgfId-247285]The destinations of traffic for this rule; can be networks or security groups. Multiple entries are displayed on separate lines within the table cell.

 
          
          		 [bookmark: pgfId-247287]Network – The network, host, or IP address objects and definitions that are defined as the destinations for this rule. The “All-Address” objects do not restrict the rule to specific hosts or networks.

 
         

 [bookmark: pgfId-247295]See Understanding Networks/Hosts Objects and Specifying IP Addresses During Policy Definition for additional information about these definitions.

 
          
          		 [bookmark: pgfId-247306]Security Groups (IOS 15.2(2)T+ and IOS-XE 3.5.x(15.2(1)S)+ only) – The names or tag numbers of the security groups defined as the destinations for the rule. See Selecting Security Groups in Policies, Configuring TrustSec-Based Firewall Rules and Creating Security Group Objects for more information about security groups.

 
         

 [bookmark: pgfId-247308]Note Security groups are part of the Cisco TrustSec Support for IOS feature which is supported on Cisco Integrated Services Router Generation 2 (ISR G2) only.

 [bookmark: pgfId-247310]Each specification is combined with any others to limit traffic matches to only those flows that include all definitions. For example, specified user traffic originating from within a specified source address range.

  
       

 
        
        		[bookmark: pgfId-247316]Service

  
        		[bookmark: pgfId-247321]The services that define the types of traffic matched by this rule. Services are defined by objects that specify protocol and port information. See Understanding and Specifying Services and Service and Port List Objects for more information.

  
       

 
        
        		[bookmark: pgfId-247327]From Zone

  
        		[bookmark: pgfId-247329]This rule applies only to traffic originating from this zone.

  
       

 
        
        		[bookmark: pgfId-247335]To Zone

  
        		[bookmark: pgfId-247337]This rule applies only to traffic destined for this zone.

  
       

 
        
        		[bookmark: pgfId-247343]Inspected Protocol

  
        		[bookmark: pgfId-247345]The protocol(s) on which the rule performs the chosen Action.

  
       

 
        
        		[bookmark: pgfId-247351]Action

  
        		[bookmark: pgfId-247353]Identifies how matched protocols are processed:

 
          
          		 [bookmark: pgfId-247355]Drop – Matched traffic is silently dropped. The default action for all traffic.

 
          		 [bookmark: pgfId-247357]Drop and Log – Matched traffic is logged and dropped.

 
          		 [bookmark: pgfId-247359]Pass – The router forwards matched traffic from the source zone to the destination zone.

 
          		 [bookmark: pgfId-247361]Pass and Log – Traffic is logged and forwarded.

 
          		 [bookmark: pgfId-247363]Inspect – State-based traffic control; Inspect can provide application inspection and control for certain protocols, based on Port to Application Mapping (PAM).

 
          		 [bookmark: pgfId-247365]Content Filter – HTTP content inspection based on a WebFilter parameter map, or a WebFilter policy map.

 
         

 [bookmark: pgfId-247367]Note The Log options generate system-log messages; you must ensure that syslog logging is configured to capture these messages.

  
       

 
        
        		[bookmark: pgfId-247373]Options

  
        		[bookmark: pgfId-247375]The Inspect Parameter map assigned to this rule; available only with Inspect and Content Filter actions.

  
       

 
        
        		[bookmark: pgfId-247381]Category

  
        		[bookmark: pgfId-247386]The category assigned to the rule. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
        
        		[bookmark: pgfId-247392]Description

  
        		[bookmark: pgfId-247394]The description of this rule, if provided. A maximum of 1024 characters is allowed.

  
       

 
        
        		[bookmark: pgfId-247400]Last Ticket(s)

  
        		[bookmark: pgfId-247405]Shows the ticket(s) associated with last modification to the rule. You can click the ticket ID in the Last Ticket(s) column to view details of the ticket and to navigate to the ticket. If linkage to an external ticket management system has been configured, you can also navigate to that system from the ticket details (see Ticket Management Page).

  
       

 
        
        		[bookmark: pgfId-247411]Query button

  
        		[bookmark: pgfId-247416]To run policy queries, which can help you evaluate your rules and identify ineffective rules that you can delete. See Generating Policy Query Reports.

  
       

 
        
        		[bookmark: pgfId-247422]Find and Replace button (binoculars icon)

  
        		[bookmark: pgfId-247427]Searches for values in rules tables, such as IP addresses and policy object names, to facilitate locating and making changes to rules in tables. See Finding and Replacing Items in Rules Tables.

  
       

 
        
        		[bookmark: pgfId-247433]Up button

  
        		[bookmark: pgfId-247435]Moves the selected rule up one row in the table.

  
       

 
        
        		[bookmark: pgfId-247441]Down button

  
        		[bookmark: pgfId-247443]Moves the selected rule down one row in the table.

  
       

 
        
        		[bookmark: pgfId-247449]Add button

  
        		[bookmark: pgfId-247451]Opens the Add Zone-based Firewall Rule dialog box, where you can create a new rule.

  
       

 
        
        		[bookmark: pgfId-247457]Edit button

  
        		[bookmark: pgfId-247459]Used to edit the selected rule in the table; opens the Edit Zone-based Firewall Rule dialog box.

  
       

 
        
        		[bookmark: pgfId-247465]Delete button

  
        		[bookmark: pgfId-247467]Deletes the selected rule from the table.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-251747][bookmark: 59588][bookmark: fwlsvcpg_cncpt_ZoneBasedFWRulesAddEditDialogBox]Adding and Editing Zone-based Firewall Rules[bookmark: marker-251743][bookmark: marker-251745]

 
     [bookmark: pgfId-251749]Use the Add and Edit Zone based Firewall Rule dialog boxes to add and edit zone-based firewall rules on Cisco IOS and ASR devices.

 
     [bookmark: pgfId-251751]Navigation Path

 
     [bookmark: pgfId-251756]From the Zone-based Firewall Rules Page, click the Add Row button, or select a row and click the Edit Row button.

 
     [bookmark: pgfId-251758]Related Topics

 
      
      		 [bookmark: pgfId-251763]Understanding the Zone-based Firewall Rules

 
      		 [bookmark: pgfId-251768]Configuring Settings for Zone-based Firewall Rules

 
      		 [bookmark: pgfId-251773]Adding Zone-Based Firewall Rules

 
     

 
     [bookmark: pgfId-251775]Field Reference

 
     [bookmark: pgfId-251778] 

 
      
       
        
        [bookmark: pgfId-247480]Table 21-23 [bookmark: 59620]Add and Edit Zone based Firewall Rule Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-247486]Element
          
  
         		
           
           [bookmark: pgfId-247488]Description
          
  
        

 
         
         		[bookmark: pgfId-247494]Enable Rule

  
         		[bookmark: pgfId-247496]When selected, the rule is enabled on the device after the configuration is generated and deployed. Deselect this option to disable the rule without deleting it.

  
        

 
         
         		
           
           [bookmark: pgfId-247502]Traffic
          
  
         		[bookmark: pgfId-247504]Define the traffic flow to which this rule is applied.

  
        

 
         
         		[bookmark: pgfId-247510]Match

  
         		[bookmark: pgfId-247515]Choose whether to Permit or Deny matched traffic. See Understanding the Relationship Between Permit/Deny and Action in Zone-based Firewall Rules for additional information about this option.

  
        

 
         
         		[bookmark: pgfId-247521]Sources

  
         		[bookmark: pgfId-247523]Provide traffic sources for this rule; can be networks or security groups. You can enter values, enter object names, or select objects for one or more of the following types of sources:

 [bookmark: pgfId-247525]Note Enter more than one value in any of these fields by separating the items with commas.

 
           
           		 [bookmark: pgfId-247527]Network – You can specify various network, host, and IP address definitions, either individually or as objects. The “All-Address” objects do not restrict the rule to specific hosts or networks.

 
          

 [bookmark: pgfId-247535]See Understanding Networks/Hosts Objects and Specifying IP Addresses During Policy Definition for additional information about these definitions.

 
           
           		 [bookmark: pgfId-247546]Security Groups (IOS 15.2(2)T+ and IOS-XE 3.5.x(15.2(1)S)+ only) – Enter or Select the name or tag number for one or more source security groups for the rule, if any. See Selecting Security Groups in Policies, Configuring TrustSec-Based Firewall Rules and Creating Security Group Objects for more information about security groups.

 
          

 [bookmark: pgfId-247548]Note Security groups are part of the Cisco TrustSec Support for IOS feature which is supported on Cisco Integrated Services Router Generation 2 (ISR G2) only.

 [bookmark: pgfId-247550]Each specification is combined with any others to limit traffic matches to only those flows that include all definitions. For example, specified user traffic originating from within a specified source address range.

  
        

 
         
         		[bookmark: pgfId-247556]Destinations

  
         		[bookmark: pgfId-247558]Provide traffic destinations for this rule; can be networks or security groups. You can enter values, enter object names, or select objects for one or more of the following types of sources:

 [bookmark: pgfId-247560]Note Enter more than one value in any of these fields by separating the items with commas.

 
           
           		 [bookmark: pgfId-247562]Network – You can specify various network, host, and IP address definitions, either individually or as objects. The “All-Address” objects do not restrict the rule to specific hosts or networks.

 
          

 [bookmark: pgfId-247570]See Understanding Networks/Hosts Objects and Specifying IP Addresses During Policy Definition for additional information about these definitions.

 
           
           		 [bookmark: pgfId-247581]Security Groups (IOS 15.2(2)T+ and IOS-XE 3.5.x(15.2(1)S)+ only) – Enter or Select the name or tag number for one or more destination security groups for the rule, if any. See Selecting Security Groups in Policies, Configuring TrustSec-Based Firewall Rules and Creating Security Group Objects for more information about security groups.

 
          

 [bookmark: pgfId-247583]Note Security groups are part of the Cisco TrustSec Support for IOS feature which is supported on Cisco Integrated Services Router Generation 2 (ISR G2) only.

 [bookmark: pgfId-247585]Each specification is combined with any others to limit traffic matches to only those flows that include all definitions. For example, specified user traffic originating from within a specified source address range.

  
        

 
         
         		[bookmark: pgfId-247591]Services

  
         		[bookmark: pgfId-247596]Specify the services that define the type of traffic to matched by this rule. You can enter any combination of service objects and service types (which are typically a protocol and port combination), separated by commas. See Understanding the Relationship Between Services and Protocols in Zone-based Firewall Rules for additional information about this option.

 [bookmark: pgfId-247601]If you type in a service, you are prompted as you type with valid values. You also can click Select to select services from a list. For complete information on how to specify services, see Understanding and Specifying Services and Service and Port List Objects.

  
        

 
         
         		[bookmark: pgfId-247607]From Zone

 [bookmark: pgfId-247609]To Zone

  
         		[bookmark: pgfId-247611]Basic zone-based firewall rules are unidirectional; that is, they define a traffic flow that moves in only one direction between two zones.

 [bookmark: pgfId-247613]Enter or select the zone from which traffic flows can originate for this rule, and enter or select the zone to which traffic can flow.

  
        

 
         
         		[bookmark: pgfId-247619]Advanced button

  
         		[bookmark: pgfId-247624]Opens the Advanced Options dialog box where you can select time-range options. See Zone-based Firewall Rule: Advanced Options Dialog Box.

  
        

 
         
         		
           
           [bookmark: pgfId-247630]Action
          
  
         		[bookmark: pgfId-247632]The action applied to traffic that matches this rule. Choose the desired Action:

  
        

 
         
         		[bookmark: pgfId-247638]Action: Drop, Drop and Log, Pass, Pass and Log

  
         		
           
           		 [bookmark: pgfId-247640] Drop – Silently drops all packets for the specified Services. The default action for all traffic.

 
           		 [bookmark: pgfId-247642] Drop and Log – Matched traffic is logged and dropped.

 
           		 [bookmark: pgfId-247644] Pass – The router forwards matched packets from the From Zone to the To Zone. Return traffic is not recognized, so you have to specify additional rules for return traffic. This option is useful only for protocols such as IPsec-encrypted traffic.

 
           		 [bookmark: pgfId-247646] Pass and Log – Traffic is logged and forwarded.

 
          

 [bookmark: pgfId-247651]For any of these Actions, you can select one or more protocols to be matched by clicking the Select button next to the Protocol table to open the Protocol Selector Dialog Box. However, this is not necessary; you can leave the Protocol table empty and pass or drop traffic based on the Sources, Destinations, and Services parameters; in effect, these are standard access rules.

 [bookmark: pgfId-247656]The Protocol Selector dialog box also provides access to the Configure Protocol Dialog Box, where you can edit the Port Application Mapping (PAM) parameters for the selected protocol.

 [bookmark: pgfId-247658]Note The Log options generate system-log messages; you must ensure that syslog logging is configured to capture these messages.

  
        

 
         
         		[bookmark: pgfId-247664]Action: Inspect

  
         		[bookmark: pgfId-247666]Inspect provides state-based traffic control—the device maintains connection or session information for TCP and UDP traffic, meaning return traffic in reply to connection requests is permitted.

 [bookmark: pgfId-247671]Choose this option to apply packet inspection based on your selected Layer 4 (TCP, UDP) and Layer 7 (HTTP, IMAP, instant messaging, and peer-to-peer) protocols. You also can edit PAM settings for the selected protocols, and you can set up deep packet inspection (DPI) and provide additional protocol-related information for the Layer 7 protocols. See Configuring Inspection Maps for Zone-based Firewall Policies for more information.

 [bookmark: pgfId-247676] 1. You can select one or more protocols for inspection by clicking the Select button next to the Protocol table to open the Protocol Selector Dialog Box.

 [bookmark: pgfId-247681] 2. The Protocol Selector dialog box also provides access to the Configure Protocol Dialog Box, where you can create custom protocols, and edit the PAM and DPI parameters for the selected protocol.

 [bookmark: pgfId-247686] 3. Inspect Parameters – You can apply a customized set of connection, timeout, and other settings by entering the name of an Inspect Parameter map in this field, or you can click Select to select one from a list. You also can create new Inspect Parameter maps from the selection-list dialog box; see Configuring Inspect Parameter Maps for more information.

 [bookmark: pgfId-247688]If you do not specify an Inspect Parameters map, the default settings are used.

  
        

 
         
         		[bookmark: pgfId-247694]Action: Content Filter

  
         		[bookmark: pgfId-247696]Content Filter provides URL filtering based on a supplied parameter or policy map. The router intercepts HTTP requests, performs protocol-related inspection, and optionally contacts a third-party server to determine whether the requests should be allowed or blocked. You can provide a WebFilter parameter map, which defines filtering based on local URL lists, as well as information from an external SmartFilter (previously N2H2) or Websense server. Alternately, you can provide a WebFilter policy map that accesses Local, N2H2, Websense, or Trend Micro filtering data.

 [bookmark: pgfId-247701] 1. When Content Filter is the chosen Action, HTTP is the specified Protocol. You can click Configure to open the Configure Protocol Dialog Box, where you can edit the HTTP PAM settings, and apply an HTTP DPI map.

 [bookmark: pgfId-247706] 2. Select WebFilter Parameter Map, or WebFilter Policy Map, and supply the name of an appropriate map. You can click the appropriate Select button to select the map from a list; you also can create new maps from the selection-list dialog box. See Configuring Content Filtering Maps for Zone-based Firewall Policies for information about configuring these maps.

 [bookmark: pgfId-247711] 3. Inspect Parameters – You can apply a customized set of connection, timeout, and other settings by entering the name of an Inspect Parameter map in this field, or you can click Select to select one from a list. You also can create new Inspect Parameter maps from the selection-list dialog box; see Configuring Inspect Parameter Maps for more information.

 [bookmark: pgfId-247713]If you do not specify an Inspect Parameters map, the default settings are used.

  
        

 
         
         		[bookmark: pgfId-247719]Description

  
         		[bookmark: pgfId-247721](Optional) You can enter a description of up to 1024 characters to help you identify the rule when viewing the rules table.

  
        

 
         
         		[bookmark: pgfId-247727]Category

  
         		[bookmark: pgfId-247732](Optional) You can assign a category to the rule, to help you organize and identify rules and objects. See Using Category Objects.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-251790][bookmark: 59788][bookmark: fwlsvcpg_cncpt_ZoneBasedFWRulesAdvancedOptionsDialogBox]Zone-based Firewall Rule: Advanced Options Dialog Box[bookmark: marker-251786][bookmark: marker-251788]

 
     [bookmark: pgfId-251792]Use the Zone-Based Firewall Rule Advanced Options dialog box to apply specific time-range information to a zone-based firewall rule.

 
     [bookmark: pgfId-251794]Navigation Path

 
     [bookmark: pgfId-251796]In the Traffic section of the Add or Edit Zone based Firewall Rule dialog box, click the Advanced button.

 
     [bookmark: pgfId-251798]Related Topics

 
      
      		 [bookmark: pgfId-251803]Adding and Editing Zone-based Firewall Rules

 
      		 [bookmark: pgfId-251808]Understanding the Zone-based Firewall Rules

 
     

 
     [bookmark: pgfId-251810]Field Reference

 
     [bookmark: pgfId-251813] 

 
      
       
        
        [bookmark: pgfId-247745]Table 21-24 [bookmark: 59815]Advanced Options Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-247751]Element
          
  
         		
           
           [bookmark: pgfId-247753]Description
          
  
        

 
         
         		[bookmark: pgfId-247759]Time Range

  
         		[bookmark: pgfId-247761]This feature lets you define time periods during which this zone-based firewall rule is active. If you do not specify a time range, the rule is immediately and always active.

 [bookmark: pgfId-247766]Enter the name of a time-range object, or click Select to choose one from a list in the Time Ranges Selector dialog box. You can create and edit time-range objects from this dialog box. For more information, see Configuring Time Range Objects.

  
        

 
         
         		[bookmark: pgfId-247772]Options

  
         		[bookmark: pgfId-247774]This feature lets you apply an initial-packet-fragment or an established-connection restriction to this zone-based firewall rule. Choose one of the following options:

 
           
           		 [bookmark: pgfId-247776] None —No packet-fragment or established-connection restrictions are applied.

 
           		 [bookmark: pgfId-247780] Fragment – If chosen, the rule is applied to non-initial packet fragments; the fragment is either permitted or denied accordingly. The white paper, “ Access Control Lists and IP Fragments ,” provides additional information that is also relevant to zone-based firewall rules.

 
           		 [bookmark: pgfId-247782] Established – For the TCP protocol only; requires an established connection. A match occurs if the TCP datagram has the ACK or RST control bits set. The non-matching case is that of the initial TCP datagram to form a connection.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-251825][bookmark: 59851][bookmark: fwlsvcpg_cncpt_ZoneBasedFWProtocolSelector]Protocol Selector Dialog Box[bookmark: marker-251821][bookmark: marker-251823]

 
     [bookmark: pgfId-251827]Use the Protocol Selector dialog box to specify one or more communication protocols as part of the definition of traffic for a zone-based firewall rule.

 
     [bookmark: pgfId-251832]The Protocol Selector dialog box also provides access to the Configure Protocol dialog box, which you can use to create custom protocols and edit Port Application Mapping (PAM) parameters for existing protocols. The Configure Protocol dialog box is also where you select Deep Inspection policy maps, and Protocol Info parameter maps, for certain protocols. See Configure Protocol Dialog Box for more information.

 
     [bookmark: pgfId-251834]Navigation Path

 
     [bookmark: pgfId-251839]The Protocol Selector dialog box can be accessed from the Add and Edit Zone based Firewall Rule dialog boxes (described in Adding and Editing Zone-based Firewall Rules). In either dialog box, choose any Action except Content Filter and then click the Select button next to the Protocol table.

 
     [bookmark: pgfId-251841]You can also open the Protocol Selector dialog box by right-clicking the Inspected Protocol column for any entry in the Zone Based Firewall Rules table, and then choosing Edit Protocols.

 
     [bookmark: pgfId-251843]Related Topics

 
      
      		 [bookmark: pgfId-251848]Understanding the Zone-based Firewall Rules

 
      		 [bookmark: pgfId-251853]Adding and Editing Zone-based Firewall Rules

 
      		 [bookmark: pgfId-251858]Selecting Objects for Policies

 
      		 [bookmark: pgfId-251863]Configure Protocol Dialog Box

 
     

 
     [bookmark: pgfId-251866] 

 
      
       
        
        [bookmark: pgfId-247795]Table 21-25 [bookmark: 59885]Protocol Selector Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-247801]Element
          
  
         		
           
           [bookmark: pgfId-247803]Description
          
  
        

 
         
         		[bookmark: pgfId-247809]Available Protocols

  
         		[bookmark: pgfId-247811]A list of protocols that can be selected for a zone-based firewall rule.

 [bookmark: pgfId-247816]Tip You can create a custom protocol by clicking the Create button below the Selected Protocols column, opening the Configure Protocol Dialog Box.  
        

 
         
         		[bookmark: pgfId-247822]Selected Protocols

  
         		[bookmark: pgfId-247824]The list of protocols you have selected for this zone-based firewall rule.

 [bookmark: pgfId-247829]Tip You can edit Port Application Mapping (PAM) settings for the protocol highlighted in the Selected Protocols column: click the Edit button below the Selected Protocols column to open the Configure Protocol Dialog Box.  
        

 
         
         		[bookmark: pgfId-247835]>> button

  
         		[bookmark: pgfId-247837]Moves the highlighted protocols from the Available Protocols column to the Selected Protocols column. You can select multiple protocols using the standard Shift-click and Ctrl+click functions.

  
        

 
         
         		[bookmark: pgfId-247843]<< button

  
         		[bookmark: pgfId-247845]Moves the highlighted protocols from the Selected Protocols column back to the Available Protocols column. You can select multiple protocols using the standard Shift-click and Ctrl+click functions.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-251882][bookmark: 59919][bookmark: fwlsvcpg_cncpt_ZoneBasedFWRulesConfigProtocolDialogBox]Configure Protocol Dialog Box[bookmark: marker-251874][bookmark: marker-251876][bookmark: marker-251878][bookmark: marker-251880]

 
     [bookmark: pgfId-251887]Packet inspection can be configured in zone-based firewall rules by the selection of specific protocol objects, which define Port Application Mapping (PAM) parameters (Layer 4 protocols and ports, and optionally specific networks and hosts). A Layer 7 (HTTP, IMAP, Instant Messaging, and peer-to-peer) protocol can also include a deep-packet inspection policy specific to that protocol. Refer to Adding and Editing Zone-based Firewall Rules for information about selecting protocols during zone-based firewall rule definition.

 
     [bookmark: pgfId-251889]The Configure Protocol dialog box is used to edit existing protocol definitions, and to create custom definitions, for use with zone-based firewall rules. For example, if a protocol does not use its default ports for some or all networks, you can configure different port mappings.

 
     [bookmark: pgfId-251891]Navigation Path

 
     [bookmark: pgfId-251896]The Configure Protocol dialog box is accessed from the Protocol Selector Dialog Box, as follows:

 
      
      		 [bookmark: pgfId-251898]Click the Create (+) button below the Selected Protocols list to create a new protocol.

 
      		 [bookmark: pgfId-251900]Select a protocol in the Selected Protocols list, and click the Edit (pencil) button to edit that protocol.

 
     

 
     [bookmark: pgfId-251902]Related Topics

 
      
      		 [bookmark: pgfId-251907]Understanding the Zone-based Firewall Rules

 
      		 [bookmark: pgfId-251912]Adding Zone-Based Firewall Rules

 
      		 [bookmark: pgfId-251917]Protocol Selector Dialog Box

 
     

 
     [bookmark: pgfId-251920] 

 
      
       
        
        [bookmark: pgfId-247858]Table 21-26 [bookmark: 59961]Configure Protocol Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-247864]Element
          
  
         		
           
           [bookmark: pgfId-247866]Description
          
  
        

 
         
         		[bookmark: pgfId-247872]Protocol Name

  
         		[bookmark: pgfId-247874]The name of the selected protocol. If you are creating a custom protocol, you can enter a name of up to 19 characters. Custom protocol names must begin with user-.

  
        

 
         
         		[bookmark: pgfId-247880]Enable Signature

  
         		[bookmark: pgfId-247882]This option is available only when editing the peer-to-peer (eDonkey, FastTrack, Gnutella, Kazaa2) protocols.

 [bookmark: pgfId-247884]Enabling this option means Network-based Application Recognition (NBAR) heuristics will be applied to the traffic to detect “telltales” that signify specific P2P application activity. These telltales includes port-hopping and other changes in application behavior to avoid traffic detection.

 [bookmark: pgfId-247886]Note This level of traffic inspection comes at the price of increased CPU utilization and reduced network throughput capability.

  
        

 
         
         		[bookmark: pgfId-247892]Deep Inspection

  
         		[bookmark: pgfId-247894]This option is available only when editing the H.323, HTTP, IM (AOL, ICQ, MSN Messenger, Windows Messenger, and Yahoo Messenger), IMAP, P2P (eDonkey, FastTrack, Gnutella, Kazaa2), POP3, SIP, SMTP, Sun RPC protocols, and Inspect is the chosen Action for the zone-based firewall rule.

 [bookmark: pgfId-247899]Enter or Select the name of the Inspect policy map to be used with the selected protocol. See Configuring Inspection Maps for Zone-based Firewall Policies for more information about these policy maps.

  
        

 
         
         		[bookmark: pgfId-247905]Protocol Info

  
         		[bookmark: pgfId-247907]This option is available only when editing the Instant Messaging (AOL, ICQ, MSN Messenger, Windows Messenger, and Yahoo Messenger) and Stun-ice protocols.

 [bookmark: pgfId-247909]Enter or Select the name of the Protocol Info parameter map to be used with the selected protocol. These parameter maps define the DNS servers that interact with these applications, which helps the Instant Messaging (IM) application engine recognize the IM traffic and enforce the configured policy for that IM application.

 [bookmark: pgfId-247914]See Configuring Protocol Info Parameter Maps for more information about these parameter maps.

  
        

 
         
         		
           
           [bookmark: pgfId-247920]Port Application Mapping
          
  
         		[bookmark: pgfId-247922]These options let you customize the Port Application Mapping (PAM) parameters for the selected protocol.

  
        

 
         
         		[bookmark: pgfId-247928]Protocol

  
         		[bookmark: pgfId-247930]Select the transport protocol(s) for this mapping:

 
           
           		 [bookmark: pgfId-247932]TCP/UDP

 
           		 [bookmark: pgfId-247934]TCP

 
           		 [bookmark: pgfId-247936]UDP

 
          

  
        

 
         
         		[bookmark: pgfId-247942]Ports

  
         		[bookmark: pgfId-247944]Enter any combination of a single port number, multiple port numbers, or a range of ports (for example, 60000-60005). Separate multiple entries with commas. Do not specify a range that overlaps already mapped ports.

  
        

 
         
         		[bookmark: pgfId-247950]Networks

  
         		[bookmark: pgfId-247952]If this protocol/port mapping is only for specific networks or hosts, enter the names or IP addresses of the networks or hosts, or the names of the network/host objects. You can click Select to open the Networks/Hosts Selector. Separate multiple entries with commas.
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     [bookmark: pgfId-809536][bookmark: 160566][bookmark: rptmgmt_cncpt_ManagingReports]Managing Reports[bookmark: marker-809532][bookmark: marker-809534]
      
      
 
     
 

 
    [bookmark: pgfId-809538]Use the Report Manager application to view security and usage reports for devices and remote access IPsec and SSL VPNs.

 
    [bookmark: pgfId-809540]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-809545]Understanding Report Management

 
     		 [bookmark: pgfId-809550]Overview of Report Manager

 
     		 [bookmark: pgfId-809555]Understanding the Predefined System Reports in Report Manager

 
     		 [bookmark: pgfId-809560]Working with Reports in Report Manager

 
     		 [bookmark: pgfId-809565]Scheduling Reports

 
     		 [bookmark: pgfId-809570]Troubleshooting Report Manager

 
    

 
   
 
    
     [bookmark: pgfId-809580][bookmark: 160575][bookmark: rptmgmt_cncpt_UnderstandingReportManagement]Understanding Report Management[bookmark: marker-809576][bookmark: marker-809578]

 
    [bookmark: pgfId-809582]Use the Report Manager application to view security and usage reports for devices and remote access IPsec and SSL VPNs. These reports can provide useful information about your network.

 
    [bookmark: pgfId-809587]The Report Manager aggregates information that is collected from monitored devices by the Event Manager service. Thus, to view reports about a device, you must also be monitoring the device in Event Viewer. Some statistics, such as VPN statistics, are obtained directly from the device through regular polling at five minute intervals. Aggregated data is kept for 90 days with data aggregated at 15-minute, hourly, daily, and monthly intervals; 15-minute aggregated data is kept for up to three days, hourly data up to one week. For more information about data aggregation, see Understanding Report Manager Data Aggregation.

 
    [bookmark: pgfId-809589]You can use Report Manager to develop reports on the following:

 
     
     		 [bookmark: pgfId-809591]Adaptive Security Appliances (ASA) running ASA Software releases 8.0 and higher. ASA Software 7.x releases are also supported for VPN reports.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-809593]Note VPN reports are not available for Cisco Catalyst 6500 Series ASA Services Modules (ASA-SM), which do not support any VPN configuration. Other types of reports are available for the ASA-SM.


    
     

    

    

 
     
     		 [bookmark: pgfId-809595]IPS devices running IPS software release 6.1 and higher (but not IOS IPS devices). This includes dedicated IPS modules installed in ASAs, routers, and switches.

 
     		 [bookmark: pgfId-809597]Remote access IPsec and SSL VPNs hosted on a supported ASA device.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-809599]Note Report Manager does not report on FWSM events even though Event Viewer works with FWSM.


    
     

    

    

 
    [bookmark: pgfId-809601]The following topics explain Report Manager and its available reports in more detail, and also describe the other types of reports available in Security Manager:

 
     
     		 [bookmark: pgfId-809606]Understanding the Types of Reports Available in Security Manager

 
     		 [bookmark: pgfId-809611]Preparing Devices for Report Manager Reporting

 
     		 [bookmark: pgfId-809616]Understanding Report Manager Data Aggregation

 
     		 [bookmark: pgfId-809621]Understanding Report Manager Access Control

 
     		 [bookmark: pgfId-809626]Understanding the Predefined System Reports in Report Manager

 
    

 
     
      [bookmark: pgfId-809636][bookmark: 160613][bookmark: rptmgmt_cncpt_UnderstandingtheTypesofReportsAvailableinSecurityManager]Understanding the Types of Reports Available in Security Manager[bookmark: marker-809632][bookmark: marker-809634]

 
     [bookmark: pgfId-809638]Security Manager provides a variety of reporting capabilities. The following are the types of reports available:

 
      
      		 [bookmark: pgfId-809640] Security and Usage Reports (Report Manager application) —You can use the Report Manager application to view aggregated information collected by the Event Manager service from monitored devices. Some information is also obtained directly from the devices. These reports can provide information on network security and remote access IPsec and SSL VPN usage.

 
      		 [bookmark: pgfId-809645] Activity (Configuration Session) Change Reports —These reports provide detailed information about the policies changed within a specific activity (in Workflow mode) or configuration session (in non-Workflow mode). For more information, see Viewing Change Reports.

 
      		 [bookmark: pgfId-809650] Out of Band Change Report —These reports identify inconsistencies between the configuration that exists on a device and the configuration for the device maintained in Security Manager. You can use this information to proactively address these inconsistencies before deploying configurations, where the change will either be overwritten or the deployment will fail, depending on the behavior you select in the deployment job. For more information, see Detecting and Analyzing Out of Band Changes.

 
      		 [bookmark: pgfId-809655] Audit Report —This report provides information about changes to Security Manager and the objects contained in the database. The report includes information about the runtime environment, such as logins and authentication failures, changes to objects, such as activity changes and deployments, and changes to managed devices, such as inventory additions and deletions. For more information, see Generating the Audit Report.

 
      		 [bookmark: pgfId-809660] Inventory Status —This report provides information on policy deployment status. For more information, see Viewing Inventory Status.

 
      		 [bookmark: pgfId-809665] Policy Discovery Status reports —When you discover policies from a device, either while adding it to the inventory or when rediscovering policies on a managed device, the information about the policy discovery is maintained so that you can view it at a later time. For more information, see Viewing Policy Discovery Task Status.

 
      		 [bookmark: pgfId-809670] Deployment Status reports —When you deploy configurations to managed devices, information about the deployment is maintained so that you can view it at a later time. For more information, see Viewing Deployment Status and History for Jobs and Schedules.

 
      		 [bookmark: pgfId-809675] Deployment and Discovery Status reports for troubleshooting —You can export deployment and policy discovery status reports in a form suitable for sending to Cisco Technical Support (TAC) to help troubleshoot problems. You might also find these reports useful for your own purposes. For more information, see Generating Deployment or Discovery Status Reports.

 
      		 [bookmark: pgfId-809680] Extranet VPN Configuration Summaries —You can print, or generate a PDF file of, a summary of the configuration of an Extranet VPN. This summary can include the preshared key used for the connection. You can use this information to maintain a current record of connections between your network and the networks of partners or service providers. For more information, see Viewing a Summary of a VPN Topology’s Configuration.

 
      		 [bookmark: pgfId-809685] Policy Object Usage report —This report shows you where a policy object is used, including instances where it is referred to by a policy or another policy object. You can use this information to help determine whether a proposed change to the object will provide the desired effect in all cases where it is used. The information is also helpful if you want to delete an object, because you cannot delete an object that is actively being used by a policy or another policy object. For more information, see Generating Object Usage Reports.

 
      		 [bookmark: pgfId-809693] Policy Object Override report —This report shows you all of the device-level overrides currently defined for a policy object, if the object is defined so that overrides are allowed. You can also create and delete overrides from this report. For more information, see Creating or Editing Object Overrides for Multiple Devices At A Time and Policy Object Overrides Window.

 
      		 [bookmark: pgfId-809698] Device Manager reports —Security Manager includes read-only versions of individual device managers, such as the Adaptive Security Device Manager (ASDM), for most supported devices. You can start these device managers directly from Security Manager’s Configuration Manager application and use any type of report available in those device managers. These reports are for a single device, and can augment the reports available through Report Manager. They can also provide status information for devices that are not directly supported by Event Viewer or Report Manager. For more information, see Starting Device Managers.

 
     

 
    
 
     
      [bookmark: pgfId-809712][bookmark: 160672][bookmark: rptmgmt_proc_PreparingDevicesforSystemStatusReporting]Preparing Devices for Report Manager Reporting[bookmark: marker-809704][bookmark: marker-809706][bookmark: marker-809708][bookmark: marker-809710]

 
     [bookmark: pgfId-809714]Before you can view reports about a device in Report Manager, you must configure the device to send events to Security Manager and configure Security Manager to monitor the device. Report Manager can provide reports only for devices you are monitoring in Event Viewer, so the device configuration for reporting is identical to the configuration for event monitoring.

 
     
 
     [bookmark: pgfId-809716]Step 1 Configure the devices to send events to Security Manager. You can use Report Manager with the following types of devices:

 
      
      		 [bookmark: pgfId-809721]ASA 8.0 and higher—For the detailed configuration steps, see Configuring ASA and FWSM Devices for Event Management.

 
      		 [bookmark: pgfId-809726]IPS 6.1 and higher—For the detailed configuration steps, see Configuring IPS Devices for Event Management.

 
     

 
     [bookmark: pgfId-809731]Step 2 Ensure that the devices are selected for event management as described in Selecting Devices to Monitor.

 
     [bookmark: pgfId-809736]Step 3 Ensure that the Event Manager service is enabled as described in Starting, Stopping, and Configuring the Event Manager Service.

 
     [bookmark: pgfId-809738]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-809748][bookmark: 160706][bookmark: rptmgmt_cncpt_UnderstandingReportManagerDataAggregation]Understanding Report Manager Data Aggregation[bookmark: marker-809744][bookmark: marker-809746]

 
     [bookmark: pgfId-809750]Report Manager aggregates information that is collected from monitored devices by the Event Manager service. Thus, to view reports about a device, you must also be monitoring the device in Event Viewer.

 
     [bookmark: pgfId-809752]Report Manager collects data using two techniques. First, the Event Manager service provides relevant events to Report Manager and then Report Manager decides if it should store those events based on the predefined reports and custom reports that are currently configured. Second, some statistics, such as VPN statistics, are obtained directly from the device through regular polling at five minute intervals.

 
     [bookmark: pgfId-809755] 

 
      
       
        
        [bookmark: pgfId-808497]Table 69-1 [bookmark: 160717]Report Manager Data Sources 

 
        
       
         
         		
           
           [bookmark: pgfId-808503]Reports
          
  
         		
           
           [bookmark: pgfId-808505]Data Sources
          
  
        

 
         
         		 
           
           [bookmark: pgfId-808511]FW Reports
          
  
        

 
         
         		[bookmark: pgfId-808519]Top Sources

 [bookmark: pgfId-808521]Top Destinations

 [bookmark: pgfId-808523]Top Services

  
         		[bookmark: pgfId-808525]Built Syslogs:

 [bookmark: pgfId-808527]302013,302015,302017,302020

 [bookmark: pgfId-808529]Deny syslogs:

 [bookmark: pgfId-808531]106001,106006,106007,106010,106011,106014,106015,106016,106017

  
        

 
         
         		[bookmark: pgfId-808537]Top Malware Sites

 [bookmark: pgfId-808539]Top Malware Ports

 [bookmark: pgfId-808541]Top Infected Hosts

  
         		[bookmark: pgfId-808543]BOTNET Syslogs:

 [bookmark: pgfId-808545]338001,338002,338003,338004,338005,338006,338007,338008,338201,338202,338203,338204

  
        

 
         
         		 
           
           [bookmark: pgfId-808551]IPS Reports
          
  
        

 
         
         		[bookmark: pgfId-808559]All IPS Reports

  
         		[bookmark: pgfId-808561]All IPS Alerts

  
        

 
         
         		 
           
           [bookmark: pgfId-808567]VPN Reports
          
  
        

 
         
         		[bookmark: pgfId-808575]Top Bandwidth Users (Full-Client)

 [bookmark: pgfId-808577]Top Duration Users (Full-Client)

 [bookmark: pgfId-808579]Top Throughput Users (Full-Client)

  
         		
           
           [bookmark: pgfId-808589]show vpn-sessiondb full anyconnect
          
  
        

 
         
         		[bookmark: pgfId-808595]Top Bandwidth Users (IPSec-RA)

 [bookmark: pgfId-808597]Top Duration Users (IPSec-RA)

 [bookmark: pgfId-808599]Top Throughput Users (IPSec-RA)

  
         		[bookmark: pgfId-808601]For ASA version 8.3 and earlier:

 
           
           [bookmark: pgfId-808603]show vpn-sessiondb full remote
          
 
           
           [bookmark: pgfId-808605] 
          
 [bookmark: pgfId-808607]For ASA version 8.4.1 and later:

 
           
           [bookmark: pgfId-808609]show vpn-sessiondb full ra-ikev1-ipsec
          
  
        

 
         
         		[bookmark: pgfId-808615]Top Bandwidth Users (Clientless)

 [bookmark: pgfId-808617]Top Duration Users (Clientless)

 [bookmark: pgfId-808619]Top Throughput Users (Clientless)

  
         		[bookmark: pgfId-808621]For all ASA versions:

 
           
           [bookmark: pgfId-808623]show vpn-sessiondb full webvpn
          
  
        

 
         
         		[bookmark: pgfId-808629]User Report

  
         		[bookmark: pgfId-808631]All above show commands.

  
        

 
         
         		[bookmark: pgfId-808637]VPN Device Usage Report

  
         		[bookmark: pgfId-808639]All above show commands.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-809757]Report Manager aggregates this collected information at 15-minute, hourly, daily, and monthly intervals. Fifteen-minute aggregated data is kept a day, hourly data up to five days, and the other data for 90 days.

 
     [bookmark: pgfId-809759]The aggregation schedule occurs at fixed times: 15-minute aggregation occurs at 00, 15, 30, and 45 minutes past the hour; hourly aggregation occurs on the hour (00 minutes); daily aggregation occurs at the change of day (when midnight is reached, the day is aggregated); monthly aggregation occurs at the change of the month.

 
     [bookmark: pgfId-809761]The aggregation cycle has implications in what you will see in reports:

 
      
      		 [bookmark: pgfId-809763]Report data does not cover the immediate past. Instead, it covers the most recently completed whole time period of the selected duration. For example, a one-day report covers yesterday, it does not include data for today. In other words, a one day report is not the previous 24 hours starting from the time the report is generated.

 
      		 [bookmark: pgfId-809765]When configuring reports with a custom time period, you cannot select a time period of less than 15 minutes long. A report will always contain at least 15 minutes of aggregated data. Minute entries are rounded to the nearest aggregation time (that is, 00, 15, 30, or 45). You can configure minutes only for custom reports that start and end on the current day.

 
     

 
     [bookmark: pgfId-809767]Also, because hourly data is kept only up to five days, you can specify hours in a custom time period only for the past five days.

 
      
      		 [bookmark: pgfId-809769]You cannot generate a report for periods that are longer than the device has been monitored. For example, when you start the Event Manager service for the first time, you will not be able to generate a monthly report until after the month changes. This might be only a few days (for example, if you start the service on the twenty-ninth day of the month), or it might be almost a full month (for example, if you start the service on the first day of the month).

 
     

 
     [bookmark: pgfId-809771]The exception to this rule is the custom time period report. Custom time period reports are generated using daily aggregation data, so you can select any custom time period.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-809773]Note Be aware that your first month of aggregated data might be significantly less than one month’s worth of data. If you compare monthly reports, this might appear as a significant discrepancy when in reality you are comparing 30 days of data to 15 days (as an example).


     
      

     

     

 
     [bookmark: pgfId-809775]You can configure the default time interval for predefined system reports and configure time intervals in individual reports. The following topics explain the time controls:

 
      
      		 [bookmark: pgfId-809780]Configuring Default Settings for Reports

 
      		 [bookmark: pgfId-809785]Editing Report Settings

 
     

 
    
 
     
      [bookmark: pgfId-809799][bookmark: 160825][bookmark: rptmgmt_cncpt_UnderstandingReportManagerAccessControl]Understanding Report Manager Access Control[bookmark: marker-809791][bookmark: marker-809793][bookmark: marker-809795][bookmark: marker-809797]

 
     [bookmark: pgfId-809801]The user privileges assigned to your username control what you can do in Report Manager. If you use local users, or other types of non-ACS access control, then all users have access to Report Manager and all reports. However, the following access limits are imposed:

 
      
      		 [bookmark: pgfId-809806]You must have system administrator or network administrator privileges to configure default settings for the predefined system reports. See Configuring Default Settings for Reports.

 
      		 [bookmark: pgfId-809808]You must have system administrator or network administrator privileges to do the following to another user’s schedules: see them, enable or disable them, view results generated from them, or delete them. See the following topics:

 
     

 
     [bookmark: pgfId-809813] – Viewing Report Schedules

 
     [bookmark: pgfId-809818] – Viewing Scheduled Report Results

 
     [bookmark: pgfId-809823] – Enabling and Disabling Report Schedules

 
     [bookmark: pgfId-809828] – Deleting Report Schedules

 
      
      		 [bookmark: pgfId-809833]You must have system administrator or network administrator privileges to see a list of all custom reports configured on the server and to delete another user’s custom report. See Managing Custom Reports.

 
     

 
     [bookmark: pgfId-809835]If you use ACS to control access to Security Manager, you can also control user access to Report Manager. When using ACS:

 
      
      		 [bookmark: pgfId-809837]You can control access to the Report Manager application using the View Report Manager privilege. Using this privilege, you could prevent certain users from accessing Report Manager, or create roles that allow access to Report Manager without allowing access to Event Viewer.

 
      		 [bookmark: pgfId-809839]Users can view reports on devices only if they have at least View privileges to the device.

 
     

 
     [bookmark: pgfId-809843]For information on integrating Security Manager with Cisco Secure ACS, see the Installation Guide for Cisco Security Manager.

 
    
 
   
 
    
     [bookmark: pgfId-809855][bookmark: 160873][bookmark: rptmgmt_cncpt_OverviewofReportManager]Overview of Report Manager[bookmark: marker-809851][bookmark: marker-809853]

 
    [bookmark: pgfId-809860]Use Report Manager to create security and usage reports for ASA and IPS devices, and for remote access IPsec and SSL VPNs hosted on ASA devices. For more information about supported devices and the reports you can generate using Report Manager, see Understanding Report Management.

 
    [bookmark: pgfId-809862]To open Report Manager, do any of the following:

 
     
     		 [bookmark: pgfId-809867]Select  Start > All Programs > Cisco Security Manager Client > Report Manager from the Windows Start menu (your exact command path might differ), or double-click the Report Manager icon on the desktop. You are prompted to log in. For more information about starting a Security Manager client application, see Logging In to and Exiting the Security Manager Client.

 
     		 [bookmark: pgfId-809869]Select  Launch > Report Manager from the Configuration Manager or Event Viewer applications. Report Manager is opened using the same user account that you used to log into the other application.

 
    

 
    [bookmark: pgfId-809871]The following illustration and subsequent list explain the basics of Report Manager.

 
    [bookmark: pgfId-809875]Figure 69-1 [bookmark: 160896]Report Manager Main Window

 
    [bookmark: pgfId-809878] 

 
     
     [image: ] 
    
 
    [bookmark: pgfId-809880]The following list explains the main Report Manager window and its call-outs in more detail.

 
     
     		 [bookmark: pgfId-809885] Menu Bar (1) —General commands for performing actions in Report Manager. For a description of the commands, see Report Manager Menus.

 
     		 [bookmark: pgfId-809887] Main Window Tabs (2) —The main window area consists of the following tabs:

 
    

 
    [bookmark: pgfId-809892] – Reports—Use the Reports tab to generate reports on demand, to create custom reports, and to perform other report-oriented tasks. The illustration above, and most of the information in this topic, relates to the Reports tab. For information on the tasks you can perform from the Reports tab, see Working with Reports in Report Manager.

 
    [bookmark: pgfId-809900] – Scheduled Reports—Use the Scheduled Reports tab to view and manage report schedules. For more information on the Scheduled Reports tab, see Viewing Report Schedules. For information on the tasks you can perform from the Scheduled Reports tab, see Scheduling Reports.

 
     
     		 [bookmark: pgfId-809905] Report List (3) —The left pane of the Reports tab is a list of reports. The list is organized into folders; the System Reports are predefined reports, whereas the My Reports folder contains the custom reports that you create. Double-click a report to open it, select the report and select  File > Open , or right-click the report and select  Open Report . For more information about using the report list, see Understanding the Report List in Report Manager.

 
     		 [bookmark: pgfId-809910] Report Pane (4, 5, 6, 7) —The right pane of the Reports tab shows the open reports. Each open report is represented on separate tabs (you can have up to five open reports). Note that you can arrange reports horizontally or vertically in this space, or even make a report float to a separate window. For more information about how you can arrange or float reports, see Arranging Report Windows.

 
    

 
    [bookmark: pgfId-809912]You can use the Maximize control (7) above the pane to make it take over the entire workspace (hiding the report list). After maximizing the pane, the control changes to a Restore control to return the main window to a two-pane view.

 
    [bookmark: pgfId-809914]You can use the right and left arrows, and the Show List icon button, to scroll through the open reports or to go directly to a report. However, clicking the tab with the desired report name is the easiest way to go to a report.

 
    [bookmark: pgfId-809916]The Report Pane includes these areas for each open report:

 
    [bookmark: pgfId-809921] – Report Settings pane (5)—The top part of the report shows the report settings, which are the criteria used to generate the report. You can open and close the settings pane by clicking on the heading, or on the expand/collapse icon button. The heading includes a toolbar that has commands that you can perform on the report. For more information about the settings pane, see Understanding the Report Settings Pane.

 
    [bookmark: pgfId-809923] – Generated Report Pane and Report Toolbar (6)—Below the settings pane is an additional toolbar used to generate and manipulate report data. Use these controls to generate the report using the criteria defined in the report settings, to print the report or to export it to PDF or CSV format, or to change the type of graphic displayed in the report.

 
    [bookmark: pgfId-809931]The bottom part of the report pane is the actual report. This area is empty until you click the Generate Report button. The top of the report shows a graphical representation of the information, the lower page shows the tabular data. For more information, see Understanding the Generated Report Pane and Toolbar and Opening and Generating Reports.

 
     
      [bookmark: pgfId-809951][bookmark: 160938][bookmark: rptmgmt_cncpt_ReportManagerMenus]Report Manager Menus[bookmark: marker-809937][bookmark: marker-809939][bookmark: marker-809941][bookmark: marker-809943][bookmark: marker-809945][bookmark: marker-809947][bookmark: marker-809949]

 
      
       
        
        [bookmark: pgfId-808654]Table 69-2 [bookmark: 160964]Report Manager Menu Reference 

 
        
       
         
         		
           
           [bookmark: pgfId-808662]Menu
          
  
         		
           
           [bookmark: pgfId-808664]Command
          
  
         		
           
           [bookmark: pgfId-808666]Description
          
  
        

 
         
         		 [bookmark: pgfId-808674]File

  
         		[bookmark: pgfId-808678]Open[bookmark: marker-808676]

  
         		[bookmark: pgfId-808683]Opens the report selected in the report list on the Reports tab. See Opening and Generating Reports.

  
        

 
         
         		[bookmark: pgfId-808695]Save[bookmark: marker-808693]

  
         		[bookmark: pgfId-808700]Saves changes made to the report settings. This command is available for custom reports only. See Saving Reports.

  
        

 
         
         		[bookmark: pgfId-808712]Save As[bookmark: marker-808710]

  
         		[bookmark: pgfId-808717]Saves the report as a new report. Use this command to create new reports from existing reports. See Saving Reports.

  
        

 
         
         		[bookmark: pgfId-808729]Close Report[bookmark: marker-808727]

 [bookmark: pgfId-808733]Close All Reports[bookmark: marker-808731]

  
         		[bookmark: pgfId-808738]Closes the active open report, or closes all open reports. See Closing Report Windows.

  
        

 
         
         		[bookmark: pgfId-808750]Exit[bookmark: marker-808748]

  
         		[bookmark: pgfId-808752]Exits Report Manager.

  
        

 
         
         		[bookmark: pgfId-808760]Launch

  
         		[bookmark: pgfId-808762]Dashboard

 [bookmark: pgfId-808764]Configuration Manager

 [bookmark: pgfId-808766]Event Viewer

 [bookmark: pgfId-808768]Health and Performance Monitor

 [bookmark: pgfId-808770]Image Manager

  
         		[bookmark: pgfId-808772]Opens the indicated Security Manager application.

  
        

 
         
         		 [bookmark: pgfId-808780]Tools

  
         		[bookmark: pgfId-808784]Default Report Settings[bookmark: marker-808782]

  
         		[bookmark: pgfId-808789]Configures the default settings for predefined system reports. See Configuring Default Settings for Reports.

  
        

 
         
         		[bookmark: pgfId-808801]Custom Report List[bookmark: marker-808799]

  
         		[bookmark: pgfId-808806]Displays all custom reports configured on the server, not just those that you created. You can manage reports from this window. See Managing Custom Reports.

  
        

 
         
         		 [bookmark: pgfId-808814]Help

  
         		[bookmark: pgfId-808816]Help about this page

  
         		[bookmark: pgfId-808818]Opens the online help to a topic relevant to the page currently displayed in the main window.

  
        

 
         
         		[bookmark: pgfId-808828]About Report Manager

  
         		[bookmark: pgfId-808830]Displays copyright, version, and licensing information for the application.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-809966][bookmark: 161068][bookmark: rptmgmt_cncpt_UnderstandingtheReportListinReportManager]Understanding the Report List in Report Manager[bookmark: marker-809962][bookmark: marker-809964]

 
     [bookmark: pgfId-809968]The left pane of the Reports tab in Report Manager displays a list of available reports, as shown in the following illustration.

 
     [bookmark: pgfId-809972]Figure 69-2 [bookmark: 161078]Report Manager Report List

 
     [bookmark: pgfId-809975] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-809977]The Report List includes the following controls (illustration call-outs cited):

 
      
      		 [bookmark: pgfId-809979] Quick Filter search box (1) —Use the quick filter search box to search for reports in the list. The list is filtered as you type, although folders are not opened automatically. The default is to search for the text string anywhere in the report name. However, you can click the down arrow in the Quick Filter box to select a variety of options to change how your search string is evaluated.

 
      		 [bookmark: pgfId-809987] List of reports (2) —The list is organized into folders; the System Reports are predefined reports (explained in Understanding the Predefined System Reports in Report Manager), whereas the My Reports folder contains the custom reports that you create. Double-click a report to open it, or select the report and select  File > Open . For more information, see Opening and Generating Reports.

 
      		 [bookmark: pgfId-809989] Right-click shortcut menu (not shown) —If you right-click on a report, you get a list of additional commands that you can perform, such as opening the report, creating a schedule, or saving the report as a new report.

 
      		 [bookmark: pgfId-809994] Edit button (3) —Click the Edit button to change the name of the selected custom report. You can edit custom reports only. For more information, see Renaming Reports.

 
      		 [bookmark: pgfId-809999] Delete button (4) —Click the Delete button to delete the selected custom report. You can delete custom reports only. For more information, see Deleting Reports

 
      		 [bookmark: pgfId-810001] Push Pin button (5) —Click the Push Pin icon to control whether the report list pane is opened or closed. If the pin is vertical, the report list remains open unless you maximize the report pane (the right pane). If the pin is horizontal, the report list collapses to the left margin, and you must click the Report List heading in the left margin to open the list.

 
     

 
     [bookmark: pgfId-810003]Related Topics

 
      
      		 [bookmark: pgfId-810008]Overview of Report Manager

 
      		 [bookmark: pgfId-810013]Understanding Report Management

 
      		 [bookmark: pgfId-810018]Working with Reports in Report Manager

 
      		 [bookmark: pgfId-810023]Viewing Report Schedules

 
      		 [bookmark: pgfId-810028]Scheduling Reports

 
      		 [bookmark: pgfId-810033]Arranging Report Windows

 
     

 
    
 
     
      [bookmark: pgfId-810045][bookmark: 161128][bookmark: rptmgmt_cncpt_UnderstandingtheReportSettingsPane]Understanding the Report Settings Pane[bookmark: marker-810039][bookmark: marker-810041][bookmark: marker-810043]

 
     [bookmark: pgfId-810047]The top part of the right side of the Reports tab, with a report open, shows the report settings. These settings define the criteria that are used to generate a report. The following illustration shows an example of the report settings pane.

 
     [bookmark: pgfId-810051]Figure 69-3 [bookmark: 161141]Report Manager Report Settings

 
     [bookmark: pgfId-810054] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-810056]The Report List includes the following controls (illustration call-outs cited):

 
      
      		 [bookmark: pgfId-810061] Report tab (3) —Although not part of the settings per se, each report appears on its own tab. The settings are the top part of the tab. If you right-click the tab itself, you get a menu of commands that allow you to arrange report windows. For more information, see Arranging Report Windows.

 
      		 [bookmark: pgfId-810063] Heading and toolbar (2) —The top of the settings pane includes the heading (for example, Top Sources - Settings) and a row of buttons for manipulating the settings. You can open or close the pane by clicking the heading or the up arrow button in the far right of the toolbar. The other buttons have the following functions:

 
     

 
     [bookmark: pgfId-810068] – Create Schedule button—Creates a new schedule for automatically generating reports based on these settings. For more information, see Configuring Report Schedules.

 
     [bookmark: pgfId-810073] – Edit button—Edits the report settings. For more information, see Editing Report Settings.

 
     [bookmark: pgfId-810081] – Save As button—Saves the report as a new report. If you edit the settings for a predefined system report, and you want to save your changes, you must use Save As to create a custom report. For more information, see Saving Reports and Creating Custom Reports.

 
     [bookmark: pgfId-810086] – Save button—Saves changes to the settings. You can save changes for custom reports only. For more information, see Saving Reports.

 
     [bookmark: pgfId-810088] – Reset button—Resets the settings to the last saved values.

 
     [bookmark: pgfId-810090] – Expand/Collapse button (double up/down arrows)—Toggles between opening and closing the report setting pane.

 
      
      		 [bookmark: pgfId-810092] Settings display (1) —Below the heading and toolbar is a summarization of the report settings. Information includes the type of report, the devices included in the report, the time range, a description, the schedules defined for the report, and other properties unique to the report.

 
     

 
     [bookmark: pgfId-810094]To change the description, type your changes directly into the Description edit box.

 
     [bookmark: pgfId-810096]Related Topics

 
      
      		 [bookmark: pgfId-810101]Opening and Generating Reports

 
      		 [bookmark: pgfId-810106]Understanding the Generated Report Pane and Toolbar

 
      		 [bookmark: pgfId-810111]Overview of Report Manager

 
      		 [bookmark: pgfId-810116]Understanding Report Management

 
      		 [bookmark: pgfId-810121]Working with Reports in Report Manager

 
      		 [bookmark: pgfId-810126]Viewing Report Schedules

 
      		 [bookmark: pgfId-810131]Scheduling Reports

 
     

 
    
 
     
      [bookmark: pgfId-810143][bookmark: 161200][bookmark: rptmgmt_cncpt_UnderstandingtheGeneratedReportPaneandToolbar]Understanding the Generated Report Pane and Toolbar[bookmark: marker-810137][bookmark: marker-810139][bookmark: marker-810141]

 
     [bookmark: pgfId-810145]The bottom part of the right side of the Reports tab, with a report open, shows the generated report and report toolbar. This pane displays the results of clicking the Generate Report button.

 
     [bookmark: pgfId-810147]The following illustration shows an example of the generated report pane and its associated report toolbar.

 
     [bookmark: pgfId-810151]Figure 69-4 [bookmark: 161214]Report Manager Generated Report Pane and Toolbar

 
     [bookmark: pgfId-810154] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-810156]The Report List includes the following controls (illustration call-outs cited):

 
      
      		 [bookmark: pgfId-810158] Report toolbar (1) —The top of the generated report pane is a row of controls for generating and manipulating reports. The controls have the following functions:

 
     

 
     [bookmark: pgfId-810163] – Generate Report button—Generates a report based on the criteria defined in the report settings (in the upper pane). For more information, see Opening and Generating Reports.

 
     [bookmark: pgfId-810168] – Print button—Prints the generated report. For more information, see Printing Reports.

 
     [bookmark: pgfId-810173] – Export button—Exports the report. Click the down arrow in the button and select the type of file you want to create: As PDF (for Adobe Acrobat) or As CSV (for comma-separated values). For more information, see Exporting Reports.

 
     [bookmark: pgfId-810178] – Chart Type—Determines the type of graphical chart displayed in the upper part of the report, typically pie, bar, and XY (linear) graphs are available. In some cases, you do not have a choice of chart types. For more information, see Opening and Generating Reports.

 
      
      		 [bookmark: pgfId-810180] Graphical view (2, 3, 5) —The top part of the generated report shows a graphical, color-coded view of the report data, and includes a legend that explains the colors. Also included is the date and time the report was generated.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-810185]Note For the Top Destinations, Top Services, and Top Sources firewall reports and the Top Attackers, Top Signatures, and Top Victims IPS reports, you can click on a data point in the Pie, XY, or Bar graph to see additional details for that data point. For example, if you click on a slice in the Pie chart for the Top Signatures report, you will see report details for the top attackers and top victims for the selected signature. For more information, see Drilling Down into Report Data.


     
      

     

     

 
     [bookmark: pgfId-810187]At the bottom of the graphical view are the following controls:

 
     [bookmark: pgfId-810189] – Up and Down arrows (5)—These icon buttons, to the left of the graphic, allow you to open and close the graphical part of the report.

 
     [bookmark: pgfId-810191] – Window size control (3)—If you hover the mouse pointer over the vertical dashes below the graphic in the center of the window, you can click and move the pointer to change the size of the graphical portion of the report. The graphic is automatically resized as you increase or decrease the size of the area. In fact, you can hover over any part of the top of the table to access this control.

 
      
      		 [bookmark: pgfId-810193] Tabular view (4) —The bottom part of the report is a table that presents the data collected for the report and used to produce the graphic. The columns in the table vary according to the type of report.

 
     

 
     [bookmark: pgfId-810195]You can click a heading to sort the table by the column. There are three sort orders, and clicking the column heading cycles through these orders with an arrow indicating the sort order: ascending (up arrow), descending (down arrow), and no sort (empty). You can use Ctrl+click to create a second sort order on a separate column, which has an effect only if the first sort column repeats one or more entry. Numbers indicate whether the column is the first, second, third, and so on, sort criteria.

 
     [bookmark: pgfId-810197]Related Topics

 
      
      		 [bookmark: pgfId-810202]Understanding the Report Settings Pane

 
      		 [bookmark: pgfId-810207]Overview of Report Manager

 
      		 [bookmark: pgfId-810212]Understanding Report Management

 
      		 [bookmark: pgfId-810217]Working with Reports in Report Manager

 
      		 [bookmark: pgfId-810222]Viewing Report Schedules

 
      		 [bookmark: pgfId-810227]Scheduling Reports

 
     

 
    
 
   
 
    
     [bookmark: pgfId-810237][bookmark: 161275][bookmark: rptmgmt_cncpt_UnderstandingthePredefinedSystemReportsinReportManager]Understanding the Predefined System Reports in Report Manager[bookmark: marker-810233][bookmark: marker-810235]

 
    [bookmark: pgfId-810239]Report Manager includes several predefined system reports that you can use to analyze your network. You can customize these reports to focus on specific sets of devices and time periods or to focus on other configurable parameters.

 
    [bookmark: pgfId-810241]This section contains the following topics:

 
     
     		 [bookmark: pgfId-810246]Understanding Firewall Traffic Reports

 
     		 [bookmark: pgfId-810251]Understanding Firewall Summary Botnet Reports

 
     		 [bookmark: pgfId-810256]Understanding VPN Top Reports

 
     		 [bookmark: pgfId-810261]Understanding General VPN Reports

 
     		 [bookmark: pgfId-810266]Understanding IPS Top Reports

 
     		 [bookmark: pgfId-810271]Understanding General IPS Reports

 
    

 
     
      [bookmark: pgfId-810285][bookmark: 161286][bookmark: rptmgmt_cncpt_UnderstandingFirewallTopReports]Understanding Firewall Traffic Reports[bookmark: marker-810277][bookmark: marker-810279][bookmark: marker-810281][bookmark: marker-810283]

 
     [bookmark: pgfId-810287]Report Manager includes predefined system reports that you can use to identify the top destinations, services, and sources for firewall ACL events. The statistics are based on the events collected by the Event Manager service (as displayed in Event Viewer).

 
     [bookmark: pgfId-810289]The following reports are available in the System Reports > FW folder.

 
      
      		 [bookmark: pgfId-810294] Top Destinations —This report ranks the session destinations of all built/deny firewall events received by Security Manager. The report shows the destination IP address, the count of the number of events for each address, and the percentage of the count compared to the sum of all counts in the report. You can click on a data point in the Pie, XY, or Bar graph that represents a specific destination to see report information about the top sources and top services associated with that destination (see Drilling Down into Report Data).

 
      		 [bookmark: pgfId-810299] Top Sources —This report ranks the session sources of all built/deny firewall events received by Security Manager. The report shows the source IP address, the count of the number of events for each address, and the percentage of the count compared to the sum of all counts in the report. You can click on a data point in the Pie, XY, or Bar graph that represents a specific source to see report information about the top destinations and top services associated with that source (see Drilling Down into Report Data).

 
      		 [bookmark: pgfId-810304] Top Services —This report ranks the destination services of all built/deny firewall events received by Security Manager. TCP and UDP services include the port number. The report shows the service, the count of the number of events for each service, and the percentage of the count compared to the sum of all counts in the report. You can click on a data point in the Pie, XY, or Bar graph that represents a specific service to see report information about the top destinations and top sources associated with that service (see Drilling Down into Report Data).

 
     

 
     [bookmark: pgfId-810309]The parameters used to define the number of addresses or services to included in the report and the reporting time period are defined in the system defaults as described in Configuring Default Settings for Reports.

 
     [bookmark: pgfId-810311]You can also edit the report settings and create custom versions of the reports. You can narrow the reports to focus on specific sets of source or destination addresses or services, or on just permit or deny actions, or limit the report to focus on a sub-set of firewall devices, as described in the following topics:

 
      
      		 [bookmark: pgfId-810316]Editing Report Settings

 
      		 [bookmark: pgfId-810321]Creating Custom Reports

 
     

 
    
 
     
      [bookmark: pgfId-810335][bookmark: 161334][bookmark: rptmgmt_cncpt_UnderstandingFirewallSummaryBotnetReports]Understanding Firewall Summary Botnet Reports[bookmark: marker-810327][bookmark: marker-810329][bookmark: marker-810331][bookmark: marker-810333]

 
     [bookmark: pgfId-810337]Report Manager includes predefined system reports that you can use to analyze botnet traffic filtering. The statistics are based on the botnet events collected by the Event Manager service (as displayed in Event Viewer) for blacklisted and gray-listed sites.

 
     [bookmark: pgfId-810342]For more information about botnet, see Chapter 19, “Managing Firewall Botnet Traffic Filter Rules”.

 
     [bookmark: pgfId-810344]The following reports are available in the System Reports > FW > Summary Botnet folder.

 
      
      		 [bookmark: pgfId-810346] Top Infected Hosts —This report ranks the top infected hosts for traffic originating from infected hosts to black- or gray-listed sites based on all botnet events received by Security Manager. The report shows the IP address of the infected host with the firewall interface name on which the event was detected in parentheses, the count of the number of connections logged to blacklisted or gray-listed sites for each address, the count of the number of connections that were blocked (dropped) by botnet traffic filtering, and the percentage of the count compared to the sum of all counts in the report.

 
      		 [bookmark: pgfId-810348] Top Malware Ports —This report ranks the top destination ports for traffic originating from infected hosts to black or gray-listed sites based on all botnet events received by Security Manager. The report shows the destination malware port, the count of the number of connections logged to blacklisted or gray-listed sites for each port, the count of the number of connections that were blocked (dropped) by botnet traffic filtering, and the percentage of the count compared to the sum of all counts in the report.

 
      		 [bookmark: pgfId-810350] Top Malware Sites —This report ranks the top botnet sites (black or gray-listed sites) for all inbound and outbound sessions based on all botnet events received by Security Manager. The report shows the following information:

 
     

 
     [bookmark: pgfId-810352] – IP Address—The IP address that is indicated as the malicious host in botnet events, either on the black list or the grey list.

 
     [bookmark: pgfId-810354] – Malware Site—The domain name or IP address in the dynamic filter database to which the traffic was initiated.

 
     [bookmark: pgfId-810356] – List Type—Whether the site is on the black list or the grey list.

 
     [bookmark: pgfId-810358] – Connections Logged—The count of the number of connections logged or monitored for each site.

 
     [bookmark: pgfId-810360] – Connections Blocked—The count of the number of connections that were blocked (dropped) by botnet traffic filtering for each site.

 
     [bookmark: pgfId-810362] – Threat Level—The botnet threat level for the site, from very low to very high, or none.

 
     [bookmark: pgfId-810364] – Category—The category of threat the site poses as defined in the botnet database, such as botnet, Trojan, spyware, and so on.

 
     [bookmark: pgfId-810369]The parameters used to define the number of hosts, ports, or sites in the report and the reporting time period are defined in the system defaults as described in Configuring Default Settings for Reports. You can also edit the report settings and create custom versions of the reports, as described in the following topics:

 
      
      		 [bookmark: pgfId-810374]Editing Report Settings

 
      		 [bookmark: pgfId-810379]Creating Custom Reports

 
     

 
    
 
     
      [bookmark: pgfId-810399][bookmark: 161394][bookmark: rptmgmt_cncpt_UnderstandingVPNTopReports]Understanding VPN Top Reports[bookmark: marker-810385][bookmark: marker-810387][bookmark: marker-810389][bookmark: marker-810391][bookmark: marker-810393][bookmark: marker-810395][bookmark: marker-810397]

 
     [bookmark: pgfId-810401]Report Manager includes predefined system reports that you can use to identify the top remote access VPN users based on bandwidth usage, duration of connection to your network, and data throughput. Separate reports are provided based on the type of connection made by the user.

 
     [bookmark: pgfId-810403]These reports are available in the System Reports > VPN folder in the AnyConnect (SSL) Remote Access VPN, Cisco VPN Client (IPsec) Remote Access VPN, and Clientless SSL VPN.

 
     [bookmark: pgfId-810405]The following reports are available in each folder. Each report is specific to the connection type indicated by the folder name and also included in parentheses in the report name.

 
      
      		 [bookmark: pgfId-810407] Top Bandwidth Users —This report ranks the VPN users who consumed the most bandwidth. The report shows the usernames, the bandwidth in total number of bytes sent and received, and the percentage of reported bandwidth used by each user.

 
      		 [bookmark: pgfId-810409] Top Duration Users —This report ranks the VPN users who remained connected to the network for the longest time. The report shows the usernames, the connection duration time in  days hours:minutes:seconds format, and the percentage of the reported duration by each user. The chart shows duration in seconds.

 
      		 [bookmark: pgfId-810411] Top Throughput Users —This report ranks the VPN users who sent and received data at the highest throughput rate. The report shows the usernames, the throughput for each user in kbps, and the percentage of reported throughput by each user. The throughput is calculated as 8.0*(bandwidth of the user in bytes)/(duration for which the user is connected in seconds*1000.0).

 
     

 
     [bookmark: pgfId-810416]The parameters used to define the number of users included in the report and the reporting time period are defined in the system defaults as described in Configuring Default Settings for Reports. You can also edit the report settings and create custom versions of the reports, including focusing on specific users, as described in the following topics:

 
      
      		 [bookmark: pgfId-810421]Editing Report Settings

 
      		 [bookmark: pgfId-810426]Creating Custom Reports

 
     

 
    
 
     
      [bookmark: pgfId-810446][bookmark: 161452][bookmark: rptmgmt_cncpt_UnderstandingGeneralVPNReports]Understanding General VPN Reports[bookmark: marker-810432][bookmark: marker-810434][bookmark: marker-810436][bookmark: marker-810438][bookmark: marker-810440][bookmark: marker-810442][bookmark: marker-810444]

 
     [bookmark: pgfId-810448]Report Manager includes predefined system reports that you can use to analyze general remote access VPN usage in your network. These reports are not specific to the connection types used in the VPN.

 
     [bookmark: pgfId-810450]The following reports are available in the System Reports > VPN folder.

 
      
      		 [bookmark: pgfId-810452] Connection Profile Report —This report provides a count of user, session, and summary of the bandwidth utilization and throughput usage for each remote access connection profile.

 
     

 
     [bookmark: pgfId-810457]The default report contains this information for all devices for the previous hour. You can customize the report in several different ways (see Editing Report Settings).

 
      
      		 [bookmark: pgfId-810459] User Report —This report provides a summary of the bandwidth utilization, connection duration and throughput usage for each remote access VPN user. The report shows the usernames, the bandwidth in total number of bytes sent and received, the connection duration time in  days hours:minutes:seconds format, and the throughput for each user in kbps. The throughput is calculated as 8.0*(bandwidth of the user in bytes)/(duration for which the user is connected in seconds*1000.0).

 
     

 
     [bookmark: pgfId-810461]Beginning with Security Manager 4.7, the User Report provides both user-level details and session-level details:

 
     [bookmark: pgfId-810463] – User-Level Details—For a particular user, the user-level details represent the combined value of all that user’s sessions: Username, Total no. of Sessions, Bandwidth, Duration, and Throughput.

 
     [bookmark: pgfId-810465] – Session-Level Details—Expanding the tree displays the session-level details for each session that a particular user has a VPN connection with; the session-level details encompass the Session ID, Login Time, Logout Time, Bandwidth, Throughput, and Duration of the Session. (Here the logout time is calculated by using the formula Logout Time = Login Time + Duration.)

 
     [bookmark: pgfId-810470]The default report includes information for all connection technologies and all users. You can customize the report to focus on a single technology type or one or more specific users (see Editing Report Settings).

 
     [bookmark: pgfId-810472]The "Criteria" section of the User Report has filters for Technology (All, Clientless, Full Client, and IPSec RA), Username, and User Session Duration (<= and >= in hours).

 
      
      		 [bookmark: pgfId-810474] VPN Device Usage Report —This report provides a summary of the usage statistics for each device that hosts remote access VPN connections. The report shows the device (using the Security Manager display name), the average number of users logged into the VPN at any given time during the reported time range, the total bandwidth of all users in the VPN in bytes (sent and received), the total connection duration time in  days hours:minutes:seconds format, and the average throughput in kbps at any given time during this report period.

 
     

 
     [bookmark: pgfId-810479]The default report includes information for all connection technologies. You can customize the report to focus on a single technology type (see Editing Report Settings).

 
     [bookmark: pgfId-810484]The parameter used to define the reporting time period is defined in the system defaults as described in Configuring Default Settings for Reports. You can also edit the report settings and create custom versions of the reports, as described in the following topics:

 
      
      		 [bookmark: pgfId-810489]Editing Report Settings

 
      		 [bookmark: pgfId-810494]Creating Custom Reports

 
     

 
    
 
     
      [bookmark: pgfId-810506][bookmark: 161533][bookmark: rptmgmt_cncpt_UnderstandinglIPSTopReports]Understanding IPS Top Reports[bookmark: marker-810500][bookmark: marker-810502][bookmark: marker-810504]

 
     [bookmark: pgfId-810508]Report Manager includes predefined system reports that you can use to analyze top attackers, victims, and signatures for IPS alerts in your network.

 
     [bookmark: pgfId-810510]The following reports are available in the System Reports > IPS folder.

 
      
      		 [bookmark: pgfId-810515] Top Attackers —This report ranks the attacker (source) addresses that generated the highest numbers of recorded IPS alerts. The report shows the attacker IP address, the count of the number of alerts for each address, and the percentage of the count compared to the sum of all counts in the report. You can click on a data point in the Pie, XY, or Bar graph that represents a specific attacker to see report information about the top signatures and top victims associated with that attacker (see Drilling Down into Report Data).

 
     

 
     [bookmark: pgfId-810520]The default report includes information for all attackers, victims, and signatures for both blocked and unblocked actions. You can customize the report to focus on subsets of attackers, victims, or signatures, or limit the analysis to blocked only or unblocked only actions (see Editing Report Settings).

 
      
      		 [bookmark: pgfId-810525] Top Victims —This report ranks the victim (destination) addresses that generated the highest numbers of recorded IPS alerts. The report shows the victim address, the count of the number of alerts for each address, and the percentage of the count compared to the sum of all counts in the report. You can click on a data point in the Pie, XY, or Bar graph that represents a specific victim to see report information about the top signatures and top attackers associated with that victim (see Drilling Down into Report Data).

 
     

 
     [bookmark: pgfId-810530]The default report includes information for all attackers, victims, and signatures for both blocked and unblocked actions. You can customize the report to focus on subsets of attackers, victims, or signatures, or limit the analysis to blocked only or unblocked only actions (see Editing Report Settings).

 
      
      		 [bookmark: pgfId-810535] Top Signatures —This report ranks the signatures that fired the highest numbers of alerts. The report shows the signature ID number, the name of the signature, the count of the number of alerts for each signature, and the percentage of the count compared to the sum of all counts in the report. You can click on a data point in the Pie, XY, or Bar graph that represents a specific signature to see report information about the top victims and top attackers associated with that signature (see Drilling Down into Report Data).

 
     

 
     [bookmark: pgfId-810540]The default report includes information for all attackers, victims, and signatures for both blocked and unblocked actions. You can customize the report to focus on subsets of attackers, victims, or signatures, or limit the analysis to blocked only or unblocked only actions (see Editing Report Settings).

 
      
      		 [bookmark: pgfId-810542] Top Blocked/Unblocked Signatures —This report ranks the signatures that blocked the highest numbers of attacks. The report shows the signature ID number, the name of the signature, the count of the number of alerts for each signature, and the percentage of the count compared to the sum of all counts in the report.

 
     

 
     [bookmark: pgfId-810547]The default report shows blocked actions only. However, you can customize the report to show unblocked only or a combination of blocked and unblocked actions (see Editing Report Settings).

 
     [bookmark: pgfId-810549]If you want to see blocked or unblocked lists that are limited to specific attacker or victim addresses, or to a subset of signatures, use the Top Signatures report instead of the Top Blocked/Unblocked Signatures report. Customize the report to show blocked only or unblocked only signatures.

 
      
      		 [bookmark: pgfId-810551] IPS Target Analysis —This report provides the top targets by signature and frequency of attack. The report shows the signatures that generated the alerts, the number of alerts, and the victim IP address, and is based on an aggregated view of the Top Signatures and Top Victims reports. The report contains up to ten signatures and five attackers. The information is plotted on a scatter plot, which is the only graphical representation available for the report.

 
     

 
     [bookmark: pgfId-810556]The parameters used to define the number of addresses or signatures to included in the report and the reporting time period are defined in the system defaults as described in Configuring Default Settings for Reports. You can also edit the report settings and create custom versions of the reports, as described in the following topics:

 
      
      		 [bookmark: pgfId-810561]Editing Report Settings

 
      		 [bookmark: pgfId-810566]Creating Custom Reports

 
     

 
    
 
     
      [bookmark: pgfId-810578][bookmark: 161593][bookmark: rptmgmt_cncpt_UnderstandingGeneralIPSReports]Understanding General IPS Reports[bookmark: marker-810572][bookmark: marker-810574][bookmark: marker-810576]

 
     [bookmark: pgfId-810580]Report Manager includes predefined system reports that you can use to analyze general IPS activity in your network.

 
     [bookmark: pgfId-810582]The following reports are available in the System Reports > IPS folder.

 
      
      		 [bookmark: pgfId-810584] Inspection/Global Correlation —This report provides a comparison of alerts generated by global correlation against alerts generated by traditional IPS inspection. The report shows the number and percentage of alerts per IPS inspection method (either Global Correlation or Inspection).

 
      		 [bookmark: pgfId-810586] IPS Simulation Mode —This report provides a comparison of alerts in inline (IPS) and promiscuous (IDS or IPS simulation) modes. The report shows the number and percentage of alerts based on mode, either Non Simulation Count (inline) or Simulation Mode Count (promiscuous). The IPS sensor cannot directly block attacks that occur in promiscuous mode.

 
     

 
     [bookmark: pgfId-810588]When working with IPS events, the Report Manager component of Cisco Security Manager reports events individually; the Event Viewer component of Cisco Security Manager displays alerts. In the Event Viewer component, the IPS Summarizer groups events into a single alert, thus decreasing the number of alerts that the IPS sensor sends out.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-810590]Tip Cisco IPS Manager Express (IME) and Cisco Security Manager do not summarize events in precisely the same way.


     
      

     

     

 
     [bookmark: pgfId-810595]The parameter used to define the reporting time period is defined in the system defaults as described in Configuring Default Settings for Reports. You can also edit the report settings and create custom versions of the reports, as described in the following topics:

 
      
      		 [bookmark: pgfId-810600]Editing Report Settings

 
      		 [bookmark: pgfId-810605]Creating Custom Reports

 
     

 
    
 
   
 
    
     [bookmark: pgfId-810615][bookmark: 161633][bookmark: rptmgmt_cncpt_UsingReportManager]Working with Reports in Report Manager[bookmark: marker-810611][bookmark: marker-810613]

 
    [bookmark: pgfId-810620]Use the Report Manager application to view security and usage reports for devices and remote access IPsec and SSL VPNs. The following topics explain the basics of creating reports. For information on working with report schedules, see Scheduling Reports.

 
    [bookmark: pgfId-810622]This section contains the following topics:

 
     
     		 [bookmark: pgfId-810627]Opening and Generating Reports

 
     		 [bookmark: pgfId-810632]Creating Custom Reports

 
     		 [bookmark: pgfId-810637]Editing Report Settings

 
     		 [bookmark: pgfId-810642]Drilling Down into Report Data

 
     		 [bookmark: pgfId-810647]Printing Reports

 
     		 [bookmark: pgfId-810652]Exporting Reports

 
     		 [bookmark: pgfId-810657]Configuring Default Settings for Reports

 
     		 [bookmark: pgfId-810662]Arranging Report Windows

 
     		 [bookmark: pgfId-810667]Saving Reports

 
     		 [bookmark: pgfId-810672]Renaming Reports

 
     		 [bookmark: pgfId-810677]Closing Report Windows

 
     		 [bookmark: pgfId-810682]Deleting Reports

 
     		 [bookmark: pgfId-810687]Managing Custom Reports

 
    

 
     
      [bookmark: pgfId-810701][bookmark: 161643][bookmark: rptmgmt_proc_OpeningandGeneratingReports]Opening and Generating Reports[bookmark: marker-810693][bookmark: marker-810695][bookmark: marker-810697][bookmark: marker-810699]

 
     [bookmark: pgfId-810703]Reports are not static. When you open a report, it contains no data, although it does contain settings that define the data that shall be used to generate the report. Thus, to view a report, you need to open it and then generate it. This procedure explains the process.

 
     [bookmark: pgfId-810705]Related Topics

 
      
      		 [bookmark: pgfId-810710]Overview of Report Manager

 
      		 [bookmark: pgfId-810715]Creating Custom Reports

 
      		 [bookmark: pgfId-810720]Arranging Report Windows

 
      		 [bookmark: pgfId-810725]Troubleshooting Report Manager

 
     

 
     
 
     [bookmark: pgfId-810727]Step 1 In Report Manager, do one of the following to open a report:

 
      
      		 [bookmark: pgfId-810729]Double-click the name of the report in the report list (in the left pane).

 
      		 [bookmark: pgfId-810731]Select the report in the reports list and select  File > Open .

 
      		 [bookmark: pgfId-810733]Right-click a report in the reports list and select  Open Report .

 
     

 
     [bookmark: pgfId-810735]The report opens with the report settings pane open and the report content area empty.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-810737]Tip You can have five reports at most open at one time. You can also collapse the report settings pane to provide more room for viewing the generated report by clicking on any area of the settings toolbar that is not a button that performs another function.


     
      

     

     

 
     [bookmark: pgfId-810742]Step 2 (Optional) Verify that the report settings contain the desired values, for example, the desired time window for the report. The settings for system reports are based on the system defaults (which you can configure as described in Configuring Default Settings for Reports). The settings for custom reports are those that were last saved for the report.

 
     [bookmark: pgfId-810747]If you need to change the settings, click the Edit button in the settings toolbar and make your changes in the Edit Settings dialog box. For more information, see Editing Report Settings.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-810749]Tip Be sure to save your changes if you want to make them permanent. If you change the settings for a system report and you want to preserve them, you must use Save As to create a new custom report; you cannot change the settings of a system report from the default settings.


     
      

     

     

 
     [bookmark: pgfId-810751]Step 3 Click the Generate Report button below the settings pane to retrieve the report data from the reporting database and to display the resulting information. The information is displayed in two formats:

 
      
      		 [bookmark: pgfId-810753]Graphical—A graphical representation of the data is shown in the top part of the report. You can select different types of graphics from the  Chart menu above the report data: pie, XY (for linear graphs), and bar. If there are more than 10 items in the report (for example, you configured a Top report to show 25 values), all values after the tenth are summarized in the chart as “others.”

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-810758]Note For the Top Destinations, Top Services, and Top Sources firewall reports and the Top Attackers, Top Signatures, and Top Victims IPS reports, you can click on a data point in the Pie, XY, or Bar graph to see additional details for that data point. For example, if you click on a slice in the Pie chart for the Top Signatures report, you will see report details for the top attackers and top victims for the selected signature. For more information, see Drilling Down into Report Data.


     
      

     

     

 
     [bookmark: pgfId-810760]Some reports, such as the IPS Target Analysis report, use scatter plots. For these reports, you do not have the option to select a different graphic type.

 
      
      		 [bookmark: pgfId-810765]Tabular—The table below the graphic lists the data used to generate the graphic. The table has different columns based on the type of report. Following are some typical columns; for more detailed information about the content of each report, see Understanding the Predefined System Reports in Report Manager.

 
     

 
     [bookmark: pgfId-810767] – Rank—The order of the information by magnitude. For example, for a firewall top destinations report, a rank of 1 indicates that the destination is the most used in the evaluated events.

 
     [bookmark: pgfId-810769] – (Name of reported characteristic)—There is always a column whose name is based on the characteristic targeted by the report, for example, Source/Destination (IP addresses), Service (protocol and port), or User (usernames).

 
     [bookmark: pgfId-810771] – Count—The number of times the item appears in an event or related statistic.

 
     [bookmark: pgfId-810773] – Percentage—The ratio of the reported characteristic to the total sum of that characteristic in the report. The ratio includes only those numbers included in a report, so for example, you could get a different percentage for the same item in a top 10 verses a top 25 report.

 
     [bookmark: pgfId-810775]Step 4 (Optional) If desired, you can print the report or export it to a PDF or comma-separated values (CSV) file.

 
      
      		 [bookmark: pgfId-810780]To print the report, click the  Print button and select your printer. For more information, see Printing Reports.

 
      		 [bookmark: pgfId-810785]To export the report, click the  Export button and select the file type, PDF or CSV. For more information, see Exporting Reports.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-810787]Tip The report data is not preserved when you close the report. If you want to keep the displayed information, you must print or export the report.


     
      

     

     

 
     [bookmark: pgfId-810789]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-810799][bookmark: 161731][bookmark: rptmgmt_proc_CreatingCustomReports]Creating Custom Reports[bookmark: marker-810795][bookmark: marker-810797]

 
     [bookmark: pgfId-810801]You can create custom reports to target specific characteristics that require regular analysis or presentation. For example, you might want to create separate Top Destination firewall reports for different groups of firewall devices so that you can separately analyze activity in separate physical sites. You can also use custom reports to analyze sources, destinations, or services that otherwise do not make it into the top reports.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-810803]Tip It might take up to one hour for data to be available for a newly-created custom report. If you get the message that no records are found after creating the report, wait an hour and then ensure that the time span for the report is Last 1 Hour.


     
      

     

     

 
     [bookmark: pgfId-810805]Related Topics

 
      
      		 [bookmark: pgfId-810810]Opening and Generating Reports

 
      		 [bookmark: pgfId-810815]Overview of Report Manager

 
     

 
     
 
     [bookmark: pgfId-810817]Step 1 Select the report on which you want to base your custom report in the reports list. Open it by double-clicking it, by selecting it and selecting File > Open, or by right-clicking and selecting Open Report.

 
     [bookmark: pgfId-810819]Step 2 Click the Edit (pencil) button in the settings toolbar to open the Edit Settings dialog box.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-810821]Note Do not click the Edit button above the reports list. That edit button allows you to change the name of the report only.


     
      

     

     

 
     [bookmark: pgfId-810823]The Edit Settings dialog box is divided into two panes. The left pane lists the available settings pages; the right pane shows the settings for the page selected in the left pane.

 
     [bookmark: pgfId-810828]Step 3 Configure the settings so that they define the desired report parameters. For more information, see Editing Report Settings.

 
     [bookmark: pgfId-810830]Step 4 Click the Save As button in the settings toolbar, or select File > Save As.

 
     [bookmark: pgfId-810832]Step 5 Enter the name of the report and optionally a description and click OK.

 
     [bookmark: pgfId-810834]Report names can be up to 64 characters and contain alphanumeric characters, spaces, hyphens (-), and the underscore character (_). The description can be up to 1024 characters.

 
     [bookmark: pgfId-810836]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-810858][bookmark: 161774][bookmark: rptmgmt_proc_EditingReportSettings]Editing Report Settings[bookmark: marker-810844][bookmark: marker-810846][bookmark: marker-810848][bookmark: marker-810850][bookmark: marker-810852][bookmark: marker-810854][bookmark: marker-810856]

 
     [bookmark: pgfId-810860]You can change the settings that define the criteria used to generate a report. For custom reports, you can save your changes.

 
     [bookmark: pgfId-810865]For predefined system reports, you cannot directly save your changes. Instead, you can use Save As to create a new custom report using the updated settings. You can also change the default settings used in all predefined system reports rather than editing report settings, as described in Configuring Default Settings for Reports.

 
     [bookmark: pgfId-810867]Related Topics

 
      
      		 [bookmark: pgfId-810872]Opening and Generating Reports

 
      		 [bookmark: pgfId-810877]Overview of Report Manager

 
      		 [bookmark: pgfId-810882]Creating Custom Reports

 
      		 [bookmark: pgfId-810887]Understanding Report Manager Data Aggregation

 
      		 [bookmark: pgfId-810892]Arranging Report Windows

 
     

 
     
 
     [bookmark: pgfId-810894]Step 1 In Report Manager, open the report whose settings you want to change. To open the report, double-click it, select it and select File > Open, or right-click it and select Open Report.

 
     [bookmark: pgfId-810896]The report opens with the settings pane open at the top of the report. The settings pane shows the type of report, the devices included in the report, the time range, a description, the schedules defined for the report, and other properties unique to the report.

 
     [bookmark: pgfId-810898]Step 2 (Optional) Change the Description by typing into the Description edit box in the report settings pane.

 
     [bookmark: pgfId-810900]Step 3 Click the Edit (pencil) button in the settings toolbar to open the Edit Settings dialog box.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-810902]Note Do not click the Edit button above the reports list. That edit button allows you to change the name of the report only.


     
      

     

     

 
     [bookmark: pgfId-810904]The Edit Settings dialog box is divided into two panes. The left pane lists the available settings pages; the right pane shows the settings for the page selected in the left pane.

 
     [bookmark: pgfId-810906]Step 4 Edit the settings on the desired pages as follows:

 
      
      		 [bookmark: pgfId-810908] Devices —To change which monitored devices are included in the report. The default is  All Devices .

 
     

 
     [bookmark: pgfId-810910]If you want the report to reflect a subset of monitored devices, select Filter Devices and then select the desired devices from the list. If a device is in italics, it means that the device is not currently selected for monitoring in Event Viewer; you can select these devices, and the report will include data for the device if it was monitored during the selected time period. You can select a folder to select all the devices in the folder.

 
     [bookmark: pgfId-810912]The device list is pre-filtered to show devices of the appropriate type only. For example, if you are editing the settings for a firewall report, IPS devices do not appear in the list of selectable devices.

 
      
      		 [bookmark: pgfId-810914] Time —To change the time span used to select events and data to include in the report. The time is based on the Security Manager server time. You can select one of the following options to define the time span:

 
     

 
     [bookmark: pgfId-810916] – Last 1 Hour—The last full one hour on the zeros, for example, if the current time is 11:45 AM, the Last 1 Hour report shows data from 10:00 to 11:00.

 
     [bookmark: pgfId-810918] – Last 1 Day—The last full day, from midnight to midnight. For example, if the current day is Tuesday, the Last 1 Day report shows data from Monday.

 
     [bookmark: pgfId-810920] – Last 1 Week—The previous Monday through Sunday.

 
     [bookmark: pgfId-810922] – Last 1 Month—The previous month. For example, if the current date is September 29, the Last 1 Month report shows data from August.

 
     [bookmark: pgfId-810927] – Custom—Use the Start Date and End Date calendars to select the desired starting and ending times for the report. Click the down arrow, select the desired day and time, then click OK in the calendar widget. Reportable data is kept for 90 days, so you cannot select a date more than 90 days into the past. Additionally, you cannot specify a time if you select a start date more than five days into the past. If you select the current date for the start date, you can also specify minutes for both starting and ending dates, but because report data is aggregated every 15 minutes at 00, 15, 30, and 45 minutes past each hour, minute entries are rounded to the nearest of these figures. The allowed time selection is based on how data is aggregated, as explained in Understanding Report Manager Data Aggregation.

 
      
      		 [bookmark: pgfId-810929] Criteria —To change the other criteria used to define the report. The attributes available on the Criteria settings page are variable. In some cases, there are no selectable criteria. Following is a list of the possible criteria:

 
     

 
     [bookmark: pgfId-810931] – Top (All “Top” reports.)—The number of items targeted by the report to include. For example, the Top 10 firewall destinations returns the 10 most frequent destinations for firewall events in the configured time range. Select 10, 20, 25, or 50.

 
     [bookmark: pgfId-810933] – Service (Firewall reports except Botnet)—The services to include in the report. To specify services, click the Edit button next to the field and select the desired service policy objects. You can select multiple objects.

 
     [bookmark: pgfId-810935] – Source IP, Destination IP (Firewall reports except Botnet)—The source and destination IP address fields are separate, but they are functionally the same. They define the IP addresses for sources or destinations to include in the report. You can enter individual addresses, such as 10.100.10.10, or address ranges, such as 10.100.10.10-10.100.10.20. Both IPv4 and IPv6 addresses are accepted. Separate multiple addresses with commas.

 
     [bookmark: pgfId-810937]You can click the Edit button next to the field to open a dialog box where you can more easily create complex lists of addresses and address ranges. However, you cannot use network/host objects to define addresses.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-810939]Note Do not specify values for all of the Service, Source IP, and Destination IP criteria in a single report. You can specify the criteria on which the report is based (for example, Service for the Top Services report) plus one other criteria. If you specify all three values, the report will always contain no data.


     
      

     

     

 
     [bookmark: pgfId-810941] – Permit/Deny (Firewall reports except Botnet)—The action reflected in the event, either permitting the matching traffic (Permit), denying the matching traffic (Deny), or either (All). The default is All.

 
     [bookmark: pgfId-810943] – Signature ID (IPS top attackers, top signatures, top victims)—The signatures to include in the report. To specify signatures, click the Edit button next to the field and select the desired signatures. You can select a folder to select all signatures in the folder.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-810945]Note In the predefined system reports, you cannot specify values for all three of the Signature ID, Attacker IP, and Victim IP criteria. You can specify a value for the key attribute of the report (for example, Victim IP for the top victims report) plus one of the other values. If you want to configure values for all three criteria, you must create a custom report.


     
      

     

     

 
     [bookmark: pgfId-810947] – Attacker IP, Victim IP (IPS top attackers, top signatures, top victims)—The attacker and victim IP address fields are separate, but they are functionally the same. They define the IP addresses for attackers (sources) or victims (destinations) to include in the report. You can enter individual addresses, such as 10.100.10.10, or address ranges, such as 10.100.10.10-10.100.10.20. Both IPv4 and IPv6 addresses are accepted. Separate multiple addresses with commas.

 
     [bookmark: pgfId-810949]You can click the Edit button next to the field to open a dialog box where you can more easily create complex lists of addresses and address ranges. However, you cannot use network/host objects to define addresses.

 
     [bookmark: pgfId-810951] – Blocked (IPS top attackers, top blocked/unblocked signatures, top signatures, top victims)—Whether the event resulted in dropped traffic (Blocked), traffic that was not dropped (Unblocked), or either (All).

 
     [bookmark: pgfId-810953] – Username (Connection Profile Report and User Report)—The names of the users to include in the report. The default, an empty list, includes all users. If you want the report to focus on specific users, use the Add (+), Edit (pencil), and Delete (trash can) buttons beneath the table to create the desired list of users. Beginning with Version 4.7 of Security Manager, the Username filter supports uppercase/lowercase character sensitivity, wildcard characters, and "NOT" operation support. Please refer to Enabling Uppercase/Lowercase Character Sensitivity and Disabling Wildcard Support in the paragraphs at the end of this topic.

 
     [bookmark: pgfId-810955] – Technology (Connection Profile Report, User Report, and VPN Device Usage Report)—The type of remote access technology to include in the report: All, Clientless (SSL VPN), Full Client (SSL VPN), IPsec RA (IPsec remote access VPN).

 
     [bookmark: pgfId-810963] – Connection Profile (Connection Profile Report)—Allows you to customize a Connection Profile Report in Report Manager by adding or editing a connection profile for a Clientless (SSL VPN), Full Client (SSL VPN), or IPsec RA (IPsec remote access VPN) topology. For more information, see Connection Profiles Page and Configuring Connection Profiles (ASA, PIX 7.0+). Beginning with Version 4.7 of Security Manager, the Connection Profile filter supports uppercase/lowercase character sensitivity, wildcard characters, and "NOT" operation support. Please refer to Enabling Uppercase/Lowercase Character Sensitivity and Disabling Wildcard Support in the paragraphs at the end of this topic.

 
     [bookmark: pgfId-810968] – Group Policy (Connection Profile Report)—Allows you to customize a Connection Profile Report in Report Manager by specifying a single or multiple group polices in the filter to generate the report for the user who has logged with the specified group policies. For more information, see Configuring Group Policies for Remote Access VPNs. Beginning with Version 4.7 of Security Manager, the Group Policy filter supports uppercase/lowercase character sensitivity, wildcard characters, and "NOT" operation support. Please refer to Enabling Uppercase/Lowercase Character Sensitivity and Disabling Wildcard Support in the paragraphs at the end of this topic.

 
     [bookmark: pgfId-810970] – User Session Duration (Connection Profile Report and User Report)—As the title indicates, allows you to specify the duration of a user session as <= or >= a given number of hours.

 
     [bookmark: pgfId-810972]Step 5 Click OK in the Edit Settings dialog box to implement your changes.

 
     [bookmark: pgfId-810974]You can now click the Generate Report button to retrieve the data defined by the settings and display it in the report. You can also use Save or Save As to permanently save the changes to the settings.

 
     [bookmark: pgfId-810976]Enabling Uppercase/Lowercase Character Sensitivity

 
     [bookmark: pgfId-810978]Beginning with Version 4.7 of Security Manager, uppercase/lowercase character sensitivity is available for the Username filter, the Connection Profile filter, and the Group Policy filter. Uppercase/lowercase character sensitivity is disabled by default. If you want to use it, you must enable it by following these steps; note that enabling it for one of these three filters enables it for all three of them:

 
     [bookmark: pgfId-810980] 1. Locate the reporting.properties file. The default location is NMSROOT/MDC/reports/config. (The default value for NMSROOT is C:\Program Files (x86)\CSCOpx

 
     [bookmark: pgfId-810982] 2. Set the parameter reports.reportgeneration.vpnUserReport.casesensitive.enable=true

 
     [bookmark: pgfId-810984] 3. Restart the Report Manager service, which is CsmReportServer

 
     [bookmark: pgfId-810986]Disabling Wildcard Support

 
     [bookmark: pgfId-810988]Beginning with Version 4.7 of Security Manager, wildcard support is available for the Username filter, the Connection Profile filter, and the Group Policy filter. Wildcard support is enabled by default. If you do not want to use it, you must disable it by following these steps; note that disabling it for one of these three filters disables it for all three of them:

 
     [bookmark: pgfId-810990] 1. Locate the reporting.properties file. The default location is NMSROOT/MDC/reports/config. (The default value for NMSROOT is C:\Program Files (x86)\CSCOpx

 
     [bookmark: pgfId-810992] 2. Set the parameter reports.reportgeneration.vpnUserReport.wildcard.enable=false

 
     [bookmark: pgfId-810994] 3. Restart the Report Manager service, which is CsmReportServer

 
     [bookmark: pgfId-810996]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-811008][bookmark: 161927][bookmark: rptmgmt_proc_DrillingDown]Drilling Down into Report Data[bookmark: marker-811002][bookmark: marker-811004][bookmark: marker-811006]

 
     [bookmark: pgfId-811010]The Top Destinations, Top Services, and Top Sources firewall reports and the Top Attackers, Top Signatures, and Top Victims IPS reports allow you to drill down into the report data.

 
     [bookmark: pgfId-811012]To drill down into one of the supported reports, click on a data point in the Pie, XY, or Bar graph for that report. For example, if you click on a slice in the Pie chart for the Top Signatures report, you will see report details for the top attackers and top victims for the selected signature.
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     [bookmark: pgfId-811014]Note The filter criteria you use for a report affects the data available in the associated drill-down reports. If you apply filters to the report data, only one drill-down report will be shown when drilling down into the report data.


     
      

     

     

 
     [bookmark: pgfId-811017]The following table shows the drill-down reports that are shown for each supported report type.

 
      
       
       
         
         		 
           
           [bookmark: pgfId-808837]Report Name
          
  
         		 
           
           [bookmark: pgfId-808839]Drill-down Reports Shown
          
  
        

 
         
         		 
           
           [bookmark: pgfId-808845]Firewall
          
  
        

 
         
         		[bookmark: pgfId-808853]Top Sources

  
         		[bookmark: pgfId-808855]Top Destinations, Top Services

  
        

 
         
         		[bookmark: pgfId-808861]Top Destinations

  
         		[bookmark: pgfId-808863]Top Sources, Top Services

  
        

 
         
         		[bookmark: pgfId-808869]Top Services

  
         		[bookmark: pgfId-808871]Top Sources, Top Destinations

  
        

 
         
         		 
           
           [bookmark: pgfId-808877]IPS
          
  
        

 
         
         		[bookmark: pgfId-808885]Top Signatures

  
         		[bookmark: pgfId-808887]Top Attackers, Top Victims

  
        

 
         
         		[bookmark: pgfId-808893]Top Attackers

  
         		[bookmark: pgfId-808895]Top Signatures, Top Victims

  
        

 
         
         		[bookmark: pgfId-808901]Top Victims

  
         		[bookmark: pgfId-808903]Top Signatures, Top Attackers

  
        

 
       
      

 
     
 
     [bookmark: pgfId-811019]For each of the drill-down reports, you can view a chart or a table of the drill-down data. If you have drilled down into a specific data point in one of the supported reports, the drill-down report graph and tabular data will be included in the printed report and in the exported report data.

 
     [bookmark: pgfId-811021]The following illustration shows an example of the drill-down report data for the Top Attackers report.

 
     [bookmark: pgfId-811025]Figure 69-5 [bookmark: 161991]Top Attackers Drill-down Reports

 
     [bookmark: pgfId-811028] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-811030]Related Topics

 
      
      		 [bookmark: pgfId-811035]Opening and Generating Reports

 
      		 [bookmark: pgfId-811040]Overview of Report Manager

 
     

 
    
 
     
      [bookmark: pgfId-811052][bookmark: 162004][bookmark: rptmgmt_proc_PrintingReports]Printing Reports[bookmark: marker-811046][bookmark: marker-811048][bookmark: marker-811050]

 
     [bookmark: pgfId-811057]After you generate a report as described in Opening and Generating Reports, you can print it.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-811062]Note If you have opened drill-down reports for a specific data point in the Top Destinations, Top Services, or Top Sources firewall reports or the Top Attackers, Top Signatures, or Top Victims IPS reports, the drill-down report graph and tabular data will be included in the printed report. For more information, see Drilling Down into Report Data.


     
      

     

     

 
     [bookmark: pgfId-811064]To print the report, click the Print button above the report. You are prompted to select a printer.

 
    
 
     
      [bookmark: pgfId-811076][bookmark: 162022][bookmark: rptmgmt_proc_ExportingReports]Exporting Reports[bookmark: marker-811070][bookmark: marker-811072][bookmark: marker-811074]

 
     [bookmark: pgfId-811081]After you generate a report as described in Opening and Generating Reports, you can export it to an Adobe Acrobat (PDF) or comma-separated values (CSV) file.

 
     [bookmark: pgfId-811083]Exported files include the following information:

 
      
      		 [bookmark: pgfId-811085]The creation time of the report.

 
      		 [bookmark: pgfId-811087]The settings used to generate the report.

 
      		 [bookmark: pgfId-811089](PDF only.) The graphical representation of the report data.

 
      		 [bookmark: pgfId-811091]The tabular report data. In PDFs, the information is represented as a table. In CSVs, the information is comma-separated, with the first row being the column headings.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-811096]Note If you have opened drill-down reports for a specific data point in the Top Destinations, Top Services, or Top Sources firewall reports or the Top Attackers, Top Signatures, or Top Victims IPS reports, the drill-down report graph and tabular data will be included in the export. For more information, see Drilling Down into Report Data.


     
      

     

     

 
     [bookmark: pgfId-811098]To export the report, click the down arrow in the Export button above the report and select either As PDF or As CSV. You are prompted to select a folder for the report. A default file name is provided, but you can change the file name.

 
    
 
     
      [bookmark: pgfId-811110][bookmark: 162052][bookmark: rptmgmt_proc_ConfiguringDefaultSettingsforReports]Configuring Default Settings for Reports[bookmark: marker-811106][bookmark: marker-811108]

 
     [bookmark: pgfId-811112]You can control the default settings that Report Manager uses for System reports. When you change the defaults, you automatically change the settings for all System reports, but the changes do not apply to any reports you saved as custom reports (in the My Reports folder). You must have system administrator or network administrator privileges to change these settings.

 
     [bookmark: pgfId-811114]While viewing a report, you can edit any system report to specify different values for these settings, either to use temporarily while viewing the report, or to save as a custom report in the My Reports folder.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-811116]Tip If you change the settings in a system report, you can return the report to the default settings by clicking the Reset button in the Report Settings toolbar.


     
      

     

     

 
     
 
     [bookmark: pgfId-811118]Step 1 In Report Manager, select Tools > Default Report Settings to open the Default Report Settings dialog box.

 
     [bookmark: pgfId-811120]Step 2 Configure any of the following options:

 
      
      		 [bookmark: pgfId-811122] Top —The number of results listed in any of the “Top” reports, which list the most-often occurring items of the type targeted by the report. For example, if you select 20, the firewall Top Destinations report shows the 20 most often occurring traffic destinations in events reported to Security Manager. The default is 10.

 
     

 
     [bookmark: pgfId-811124]If you select more than 10, all items after the tenth are summarized as “others” in charts, although the detailed information for each additional item is listed in the report table.

 
      
      		 [bookmark: pgfId-811126] Time Range —The time window for events included in the report:

 
     

 
     [bookmark: pgfId-811128] – Last 1 Hour—The last full one hour on the zeros, for example, if the current time is 11:45 AM, the Last 1 Hour report shows data from 10:00 to 11:00.

 
     [bookmark: pgfId-811130] – Last 1 Day—The last full day, from midnight to midnight. For example, if the current day is Tuesday, the Last 1 Day report shows data from Monday.

 
     [bookmark: pgfId-811132] – Last 1 Week—The previous Monday through Sunday.

 
     [bookmark: pgfId-811134] – Last 1 Month—The previous month. For example, if the current date is September 29, the Last 1 Month report shows data from August.

 
     [bookmark: pgfId-811139]For more information on the implications of the time range setting, see Understanding Report Manager Data Aggregation.

 
      
      		 [bookmark: pgfId-811141] Default Email Address —The email address used as the default destination for scheduled reports.

 
     

 
     [bookmark: pgfId-811143]If you decide you want to return to the installation default values, click Restore Defaults.

 
     [bookmark: pgfId-811145]Step 3 Click Apply to save your changes, then click Close to close the dialog box.

 
     [bookmark: pgfId-811147]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-811163][bookmark: 162103][bookmark: rptmgmt_proc_ArrangingReportWindows]Arranging Report Windows[bookmark: marker-811153][bookmark: marker-811155][bookmark: marker-811157][bookmark: marker-811159][bookmark: marker-811161]

 
      
      [image: ] 
     
 
     [bookmark: pgfId-811170]You have many options for arranging report windows based on your requirements. For example, you might want to compare two reports side-by-side, or remove a report from the main window without closing it.

 
     [bookmark: pgfId-811172]You can use the following techniques to arrange the report windows to get the view that you desire:

 
      
      		 [bookmark: pgfId-811174]Floating a report—To remove a report from the main Report Manager window without closing it, right-click the report tab and select  Floating . The report is moved to its own window.

 
     

 
     [bookmark: pgfId-811176]If you have already floated a report, you can select Floating to and choose one of the already-floated windows. The report becomes a new tab in that window.

 
      
      		 [bookmark: pgfId-811178]Docking a report—To move a floating report back to the main Report Manager window, right-click the report tab and select  Docking .

 
      		 [bookmark: pgfId-811180]Arranging reports horizontally or vertically for side-to-side comparison—To create a vertical or horizontal arrangement of reports to allow for easy comparison, without floating the reports, right-click the report tab and select  New Horizontal Group or  New Vertical Group . These commands split the current tabbed group into the selected layout. You must have at least two reports open to use these commands. If you have more than two open reports, and you want all of them in separate windows, you need to use the command multiple times.

 
      		 [bookmark: pgfId-811182]Move reports to different tabbed groups—If you have several open reports, and you have arranged them into horizontal or vertical groups, you can move reports among the groups by right-clicking the report tab and selecting  Move to Next Tab Group or  Move to Previous Tab Group . The commands appear only if reports are arranged in a manner where such movement is possible:

 
      		 [bookmark: pgfId-811184]Change the orientation of groups—You can switch between horizontal and vertical layouts by right-clicking the report tab and selecting  Change Tab Groups Orientation .

 
     

 
    
 
     
      [bookmark: pgfId-811196][bookmark: 162146][bookmark: rptmgmt_proc_SavingReports]Saving Reports[bookmark: marker-811192][bookmark: marker-811194]

 
     [bookmark: pgfId-811198]If you edit the settings for a report, you must save it to make those changes permanent. However, to save changes to predefined system reports, you must save the report as a custom report.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-811200]Tip When you save a report, you are saving the settings that define the report. You are not saving the generated content of the report. If you want to save the generated content of the report, that is, the graphs and the report data, you must export the report rather than save it.


     
      

     

     

 
      
      		 [bookmark: pgfId-811202]To save changes to a custom report, do one of the following in Report Manager:

 
     

 
     [bookmark: pgfId-811204] – Select File > Save from the menu bar.

 
     [bookmark: pgfId-811206] – Click the Save button in the Report Settings toolbar.

 
      
      		 [bookmark: pgfId-811208]To save your changes as a new custom report, do one of the following to open the Save Report As dialog box:

 
     

 
     [bookmark: pgfId-811210] – Select File > Save As from the menu bar.

 
     [bookmark: pgfId-811212] – Click the Save As button in the Report Settings toolbar.

 
     [bookmark: pgfId-811214] – Right-click the report in the reports list and select Save As.

 
     [bookmark: pgfId-811216]Then, enter a name for the report and optionally a description of the report and click OK. The report is added to the My Reports folder in the reports list.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-811218]Note Report names can be up to 64 characters and contain alphanumeric characters, spaces, hyphens (-), and the underscore character (_). The description can be up to 1024 characters.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-811230][bookmark: 162184][bookmark: rptmgmt_proc_RenamingReports]Renaming Reports[bookmark: marker-811226][bookmark: marker-811228]

 
     [bookmark: pgfId-811232]You can change the name of custom reports, but you cannot change the names of predefined system reports.

 
     [bookmark: pgfId-811234]Related Topics

 
      
      		 [bookmark: pgfId-811239]Overview of Report Manager

 
      		 [bookmark: pgfId-811244]Understanding the Report List in Report Manager

 
     

 
     
 
     [bookmark: pgfId-811246]Step 1 In Report Manager, select the report whose name you want to change from the reports list. You do not need to open the report; simply select it in the list.

 
     [bookmark: pgfId-811248]Step 2 Click the Edit (pencil) button above the reports list to open the dialog box that allows you to change the report name.

 
     [bookmark: pgfId-811250]Step 3 Enter the new name and click OK.

 
     [bookmark: pgfId-811252]Report names can be up to 64 characters and contain alphanumeric characters, spaces, hyphens (-), and the underscore character (_).

 
     [bookmark: pgfId-811254]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-811266][bookmark: 162217][bookmark: rptmgmt_proc_ClosingReportWindows]Closing Report Windows[bookmark: marker-811260][bookmark: marker-811262][bookmark: marker-811264]

 
     [bookmark: pgfId-811268]You can close any report by clicking the X icon on the report tab. For reports that you have floated, you can simply click the X icon in the window’s title bar.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-811270]Tip When you close a report, none of the generated report data is preserved. If you want to preserve the generated data, you must print it or export it before you close the report window.


     
      

     

     

 
     [bookmark: pgfId-811272]You can also use the following techniques to close the report windows without exiting Report Manager:

 
      
      		 [bookmark: pgfId-811274]Close a report—Select  File > Close Report to close the currently-viewed report, or right-click the desired report tab and select  Close .

 
      		 [bookmark: pgfId-811276]Close all reports—Select  File > Close All Reports , or right-click any report tab and select  Close All .

 
      		 [bookmark: pgfId-811278]Close all reports except one—Right-click the report tab of the report you want to keep open and select  Close Others .

 
     

 
    
 
     
      [bookmark: pgfId-811288][bookmark: 162244][bookmark: rptmgmt_proc_DeletingReports]Deleting Reports[bookmark: marker-811284][bookmark: marker-811286]

 
     [bookmark: pgfId-811290]You can delete custom reports, but you cannot delete predefined system reports.

 
     [bookmark: pgfId-811292]To delete a custom report, select it in the reports list and click the Delete (trash can) button above the reports list. You are asked to confirm your deletion.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-811294]Tip Deleting a report also deletes any schedules for that report.


     
      

     

     

 
     [bookmark: pgfId-811299]If you need to delete another user’s custom report, see Managing Custom Reports.

 
    
 
     
      [bookmark: pgfId-811315][bookmark: 162259][bookmark: rptmgmt_proc_ManagingCustomReports]Managing Custom Reports[bookmark: marker-811307][bookmark: marker-811309][bookmark: marker-811311][bookmark: marker-811313]

 
     [bookmark: pgfId-811317]If you have system administrator or network administrator privileges, you can view a list of custom reports created by all Report Manager users on this Security Manager server.

 
     [bookmark: pgfId-811319]To view the list of custom reports, select Tools > Custom Report List to open the Manage Custom Reports dialog box. The list shows the report name, the type of report, the type of device analyzed by the report, and the username of the person who created the custom report.

 
     [bookmark: pgfId-811321]You can use the following controls to manage custom reports from this page:

 
      
      		 [bookmark: pgfId-811323] Pagination controls —If there are a lot of custom reports, use the pagination controls to move through the list. You can click the buttons to move to the first page, previous page, next page, or last page, or type the page number into the Page X of Y edit box. You can also click the down arrow in the edit box to change the edit box to work by record number rather than page number.

 
      		 [bookmark: pgfId-811325] Delete button —Click this button to delete the selected report. Any schedules (and schedule results) that use the report are also deleted.

 
      		 [bookmark: pgfId-811327] Refresh button —Click this button to update the list with the latest information.

 
     

 
    
 
   
 
    
     [bookmark: pgfId-811339][bookmark: 162291][bookmark: rptmgmt_cncpt_SchedulingReports]Scheduling Reports[bookmark: marker-811333][bookmark: marker-811335][bookmark: marker-811337]

 
    [bookmark: pgfId-811341]You can create schedules to regularly generate reports from Report Manager.

 
    [bookmark: pgfId-811343]This section contains the following topics:

 
     
     		 [bookmark: pgfId-811348]Viewing Report Schedules

 
     		 [bookmark: pgfId-811353]Configuring Report Schedules

 
     		 [bookmark: pgfId-811358]Viewing Scheduled Report Results

 
     		 [bookmark: pgfId-811363]Enabling and Disabling Report Schedules

 
     		 [bookmark: pgfId-811368]Deleting Report Schedules

 
    

 
     
      [bookmark: pgfId-811382][bookmark: 162303][bookmark: rptmgmt_proc_ViewingReportSchedules]Viewing Report Schedules[bookmark: marker-811376][bookmark: marker-811378][bookmark: marker-811380]

 
     [bookmark: pgfId-811384]You can view a list of report schedules that are configured in Report Manager. If you have system administrator or network administrator privileges, the list includes all schedules configured on the server, whether you configured them or another user configured them. Users with lesser privileges can see their own schedules only.

 
     [bookmark: pgfId-811386]To view the list of report schedules, select the Scheduled Reports tab, and if necessary, the Schedule List sub-tab. The list shows the schedule name, description, the report that will be generated by the schedule, the frequency of report generation, the e-mail addresses to which reports are sent (if any), whether the schedule is enabled or disabled, and the username of the person who created the schedule.

 
     [bookmark: pgfId-811388]You can use the following controls to manage report schedules from this page:

 
      
      		 [bookmark: pgfId-811390] Pagination controls —If there are a lot of schedules, use the pagination controls (below the table to the left) to move through the list. You can click the buttons to move to the first page, previous page, next page, or last page, or type the page number into the Page X of Y edit box. You can also click the down arrow in the edit box to change the edit box to work by record number rather than page number.

 
      		 [bookmark: pgfId-811395] Add button —Click this button to add a new schedule. For more information, see Configuring Report Schedules.

 
      		 [bookmark: pgfId-811400] Edit button —Click this button to edit the selected schedule. For more information, see Configuring Report Schedules.

 
      		 [bookmark: pgfId-811405] Delete button —Click this button to delete the selected schedule. For more information, see Deleting Report Schedules.

 
      		 [bookmark: pgfId-811407] Refresh button —Click this button to update the list with the latest information.

 
      		 [bookmark: pgfId-811412] Enable button —Click this button to enable the selected schedule. The button is active only if the selected schedule is disabled. For more information, see Enabling and Disabling Report Schedules.

 
      		 [bookmark: pgfId-811417] Disable button —Click this button to disable the selected schedule. The button is active only if the selected schedule is disabled. For more information, see Enabling and Disabling Report Schedules.

 
     

 
    
 
     
      [bookmark: pgfId-811431][bookmark: 162349][bookmark: rptmgmt_proc_ConfiguringReportSchedules]Configuring Report Schedules[bookmark: marker-811425][bookmark: marker-811427][bookmark: marker-811429]

 
     [bookmark: pgfId-811433]You can create schedules to automatically generate reports at set times. The generated reports are e-mailed to identified recipients and are also stored and available for viewing from Report Manager. By scheduling reports, you can easily and efficiently create regular milestone views of network security and usage. This procedure explains how to set up a schedule for a report.

 
     [bookmark: pgfId-811435]Related Topics

 
      
      		 [bookmark: pgfId-811440]Overview of Report Manager

 
      		 [bookmark: pgfId-811445]Opening and Generating Reports

 
      		 [bookmark: pgfId-811450]Viewing Report Schedules

 
      		 [bookmark: pgfId-811455]Troubleshooting Report Manager

 
     

 
     
 
     [bookmark: pgfId-811457]Step 1 In Report Manager, do one of the following:

 
      
      		 [bookmark: pgfId-811459]On the Reports tab, open the report for which you are creating a new schedule by double-clicking the name of the report in the report list (in the left pane). Then, click the  Create Schedule button in the report settings toolbar.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-811461]Note You cannot edit an existing schedule from the Reports tab.


     
      

     

     

 
      
      		 [bookmark: pgfId-811463]On the Reports tab, right-click the report on which you are creating a schedule and select  Create Schedule . If the report is not already open, it is opened.

 
      		 [bookmark: pgfId-811465]On the Scheduled Reports tab, Schedule List sub-tab, click the  Add button below the list of schedules to create a new schedule. To edit an existing schedule, select it in the list and click the  Edit button.

 
     

 
     [bookmark: pgfId-811467]The Add or Edit Report Schedule dialog box opens.

 
     [bookmark: pgfId-811469]Step 2 Configure the following options in the dialog box:

 
      
      		 [bookmark: pgfId-811471] Schedule Name —A name for the schedule, up to 64 characters.

 
      		 [bookmark: pgfId-811473] Report Name —Select the name of the report to be generated by the schedule. When you create a schedule from the report settings pane, the name is pre-selected and you cannot change it.

 
      		 [bookmark: pgfId-811475] Schedule —Select whether the report shall be generated daily, weekly (once per week), or monthly (once per month). Then, enter the day and time for generating the report:

 
     

 
     [bookmark: pgfId-811477] – Daily schedules—Select whether the schedule is for Monday through Friday (five days) or Monday through Sunday (all seven days). Enter the time of day (in 24-hour notation) to generate the report.

 
     [bookmark: pgfId-811479] – Weekly schedules—Select the day of the week and enter the time of day in 24-hour notation.

 
     [bookmark: pgfId-811481] – Monthly schedules—Select whether to generate the report on the first day of the month, the last day, or custom. If you select Custom, enter the day number. Then, enter the time of day in 24-hour notation.

 
      
      		 [bookmark: pgfId-811486] Email To —The email addresses that should be sent the report. Separate multiple addresses with commas. If you do not want reports e-mailed, ensure that the field is empty. Note that for e-mails to be sent successfully, you must configure SMTP on the Security Manager server as described in Configuring an SMTP Server and Default Addresses for E-Mail Notifications.

 
     

 
     [bookmark: pgfId-811488]If the report fails to generate for some reason, notification of the failure is sent to these e-mail addresses.

 
      
      		 [bookmark: pgfId-811493] Export Report Format —Whether to generate the report in Adobe Acrobat (PDF) or comma-separated value (CSV) format. The PDF includes graphics, the CSV does not. For more information on export formats, see Exporting Reports.

 
      		 [bookmark: pgfId-811495] Description —A description of the schedule.

 
      		 [bookmark: pgfId-811497] Status —Whether the schedule is enabled (reports will be generated) or disabled (reports will not be generated).

 
     

 
     [bookmark: pgfId-811499]Step 3 Click OK to save the schedule. New schedules are added to the schedules list on the Schedules tab.

 
     [bookmark: pgfId-811501]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-811515][bookmark: 162434][bookmark: rptmgmt_proc_ViewingScheduledReportResults]Viewing Scheduled Report Results[bookmark: marker-811509][bookmark: marker-811511][bookmark: marker-811513]

 
     [bookmark: pgfId-811517]Typically, report schedules include e-mail addresses to which generated reports are sent. You can also view reports generated from schedules in Report Manager. If you have system administrator or network administrator privileges, you can view results generated by other users’ schedules.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-811519]Tip Report Manager maintains a copy of the last report generated by the schedule. You cannot retrieve previously generated reports.


     
      

     

     

 
     [bookmark: pgfId-811521]Related Topics

 
      
      		 [bookmark: pgfId-811526]Overview of Report Manager

 
      		 [bookmark: pgfId-811531]Opening and Generating Reports

 
      		 [bookmark: pgfId-811536]Viewing Report Schedules

 
      		 [bookmark: pgfId-811541]Troubleshooting Report Manager

 
     

 
     
 
     [bookmark: pgfId-811543]Step 1 In Report Manager, select the Scheduled Reports tab.

 
     [bookmark: pgfId-811545]Step 2 Select the Results sub-tab.

 
     [bookmark: pgfId-811547]All results that you are authorized to see are listed on this tab. The list shows the schedule name, the name of the report that was generated, the frequency of report generation, the date and time of the last schedule run (when the report was generated), the status of the report generation (Success or Failed), a link to the generated report (in the Last Report column), and the username of the person who created the schedule.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-811549]Tip If the status of a report is Failed, click the link to see the reason for failure.


     
      

     

     

 
     [bookmark: pgfId-811551]Step 3 Double-click the icon link to the report in the Last Report column to open it. While viewing the report, you can save it to your workstation.

 
     [bookmark: pgfId-811553]If you cannot find the report you are looking for, click the Refresh button to update the list with the latest information.

 
     [bookmark: pgfId-811555]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-811573][bookmark: 162480][bookmark: rptmgmt_proc_EnablingandDisablingReportSchedules]Enabling and Disabling Report Schedules[bookmark: marker-811561][bookmark: marker-811563][bookmark: marker-811565][bookmark: marker-811567][bookmark: marker-811569][bookmark: marker-811571]

 
     [bookmark: pgfId-811575]You can enable or disable report schedules to change whether reports are generated based on the schedules. By disabling a schedule, you can prevent reports from being generated without deleting the schedule. If you have system administrator or network administrator privileges, you can enable or disable another user’s schedule.

 
     [bookmark: pgfId-811577]Related Topics

 
      
      		 [bookmark: pgfId-811582]Overview of Report Manager

 
      		 [bookmark: pgfId-811587]Viewing Report Schedules

 
     

 
     
 
     [bookmark: pgfId-811589]Step 1 In Report Manager, select the Scheduled Reports tab, then if necessary, the Schedule List sub-tab. This tab lists all currently-defined schedules that you are authorized to see.

 
     [bookmark: pgfId-811591]Step 2 Select the schedule whose status you want to change and click either the Enable or Disable button.

 
     [bookmark: pgfId-811593]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-811605][bookmark: 162522][bookmark: rptmgmt_proc_DeletingReportSchedules]Deleting Report Schedules[bookmark: marker-811599][bookmark: marker-811601][bookmark: marker-811603]

 
     [bookmark: pgfId-811607]You can delete report schedules if you no longer need them. If you have system administrator or network administrator privileges, you can delete another user’s schedule.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-811609]Tip If you do not want to generate reports from a schedule, but you want to keep the schedule definition, you can disable the schedule. Disabled schedules do not generate reports.


     
      

     

     

 
     
 
     [bookmark: pgfId-811611]Step 1 In Report Manager, select the Scheduled Reports tab, then if necessary, the Schedule List sub-tab. This tab lists all currently-defined schedules that you are authorized to see.

 
     [bookmark: pgfId-811613]Step 2 Select the schedule and click the Delete button below the list. You are asked to confirm the deletion.

 
     [bookmark: pgfId-811615]When you delete a schedule, any results of the schedule are also deleted from the server and they are removed from the Results tab.

 
     [bookmark: pgfId-811617]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-811627][bookmark: 162546][bookmark: rptmgmt_cncpt_TroubleshootingReportManager]Troubleshooting Report Manager[bookmark: marker-811623][bookmark: marker-811625]

 
    [bookmark: pgfId-811629]Following are some problems you might encounter when using the Report Manager application, and some ways to resolve the problems.

 
    [bookmark: pgfId-811633]Problem: Report Manager does not open, you get the message “Not able to connect to server.”[bookmark: marker-811631]

 
    [bookmark: pgfId-811635]Solution: Report Manager requires that the csmReportServer, rptDbEngine, and rptDbMonitor processes be started. Report Manager also relies on the Event Management service VmsEventServer. Ensure that all services are started and running correctly on the Security Manager server.

 
    [bookmark: pgfId-811637]To view the current state of the processes, log into the Security Manager web interface using http://SecManServer:1741, where SecManServer is the DNS name of the server. From the Security Management Suite home page, click the Server Administration link to open CiscoWorks Common Services at the Admin page. Click Processes in the TOC on the left side of the window to open the list of processes that displays their current states. Select these processes and click Start to start them. If necessary, you might want to stop them, and then restart them. Wait for the processes to fully restart, then try again to open Report Manager.

 
    [bookmark: pgfId-811639]Problem: When generating a report, you get the message “No records found.”

 
    [bookmark: pgfId-811641]Solution: This message indicates that there were no event records in the event data storage location that relate to the report type and the configured settings, or that the required Report Manager aggregation cycle has not completed. Investigate the following:

 
     
     		 [bookmark: pgfId-811646]Ensure that devices of the appropriate type are selected for monitoring as described in Selecting Devices to Monitor.

 
     		 [bookmark: pgfId-811654]Ensure that these devices are appropriately configured for sending events to Security Manager, and that events from the device appear in Event Viewer. Ensure that the device and Security Manager are using the same syslog port. For information on configuring the devices, see Configuring ASA and FWSM Devices for Event Management and Configuring IPS Devices for Event Management. To check the syslog port that Security Manager is using, view the setting on the  Tools > Security Manager Administration > Event Management page in Configuration Manager.

 
     		 [bookmark: pgfId-811656]For IPS devices, ensure that the certificate has not expired. Check the certificates table by selecting  Manage > IPS > IPS Certificates in Configuration Manager and regenerate the certificate if necessary.

 
     		 [bookmark: pgfId-811661]The report settings might specify a time period in which no aggregated data exists for the report. Data is aggregated every 15 minutes, 1 hour (on the hour), and 1 day (at midnight). Try changing the time parameters of the report. See Editing Report Settings. Consider the following:

 
    

 
    [bookmark: pgfId-811663] – To see a Last 1 Hour report, a change of hour must occur since initially starting the Event Manager service. For example, if you start the service at 10:05, hourly reports are available only after 11:00.

 
    [bookmark: pgfId-811665] – To see a Last 1 Day report, a change of day must occur since initially starting the Event Manager service. For example, if you start the service at 10:05, you must wait until after midnight to see a daily report.

 
    [bookmark: pgfId-811667] – To see a Last 1 Week report, at least one full day cycle must occur. Weekly reports are based on daily reports.

 
    [bookmark: pgfId-811669] – To see a Last 1 Month report, at least one full month must pass since starting the service.

 
    [bookmark: pgfId-811671] – To see a custom time period report, at least one daily cycle must occur.

 
     
     		 [bookmark: pgfId-811673]If you create a new custom report, it might take up to one hour for data to become available. Also, ensure that the time period is Last 1 Hour until the report is old enough to have data for other time periods.

 
    

 
    [bookmark: pgfId-811675]Problem: You cannot get reports for a specific device.

 
    [bookmark: pgfId-811677]Solution: Investigate the following:

 
     
     		 [bookmark: pgfId-811685]The device must have been selected for event management during the reporting time-frame as described in Selecting Devices to Monitor. Even if a device is selected, Report Manager might not support all devices that are supported for Event Viewer. For information on the supported device types, see Understanding Report Management.

 
     		 [bookmark: pgfId-811690]The report settings might exclude the device. Unless the report settings indicate that All Devices are considered in the report, check the device selection to ensure the device is included. See Editing Report Settings.

 
     		 [bookmark: pgfId-811695]The report settings might specify a time period in which no data exists for the device. Try changing the time parameters of the report. See Editing Report Settings.

 
     		 [bookmark: pgfId-811697]If your organization uses Cisco Secure ACS to control access to the application, you can view reports on a device only if you have at least View privileges to the device. Check whether you have the required permissions.

 
    

 
    [bookmark: pgfId-811699]Problem: You cannot see data in certain IPS predefined reports after specifying values for each of signature, victim IP, and attacker IP.

 
    [bookmark: pgfId-811701]Solution: The top attackers, top victims, and top signatures predefined reports include criteria for signature, victim IP address, and attacker IP address. However, you cannot configure all three criteria in a predefined report. Instead, you can configure the criteria on which the report is based (for example, victim IP address for the top victims report) plus one, and only one, of the remaining values. Note that this limitation does not apply to the other criteria, such as Blocked and Top.

 
    [bookmark: pgfId-811703]Problem: You cannot see data in certain Firewall predefined reports after specifying values for each of service, source IP, and destination IP.

 
    [bookmark: pgfId-811705]Solution: The top destinations, top services, and top sources predefined reports include criteria for service, source IP address, and destination IP address. However, you cannot configure all three criteria in a predefined report. Instead, you can configure the criteria on which the report is based (for example, service for the top services report) plus one, and only one, of the remaining values. Note that this limitation does not apply to the other criteria, such as Permit/Deny and Top.

 
    [bookmark: pgfId-811707]Problem: Statistics for VPN reports are not available.

 
    [bookmark: pgfId-811709]Solution: VPN statistics are partially obtained directly from the device rather than from events stored in the event data storage location. To obtain the statistics, Report Manager must be able to log into the device and use show commands. Ensure that the device properties for your VPN devices have the correct credentials for logging in.

 
    [bookmark: pgfId-811711]Problem: Scheduled reports are not getting sent to recipients.

 
    [bookmark: pgfId-811716]Solution: Ensure that the SMTP server is configured correctly and that a valid source e-mail address is configured for Security Manager. For more information, see Configuring an SMTP Server and Default Addresses for E-Mail Notifications.
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     [bookmark: pgfId-821859][bookmark: 28235][bookmark: dptrbl_cncpt_TroubleshootingDeviceCommunicationandDeployment]Troubleshooting Device Communication and Deployment[bookmark: marker-821851][bookmark: marker-821853][bookmark: marker-821855][bookmark: marker-821857]
      
      
 
     
 

 
    [bookmark: pgfId-821861]One of the more likely areas where you can run into problems is with actions where Security Manager must log into a device. These types of actions include policy discovery and deployment using live devices, or actions that involve retrieving information from a device.

 
    [bookmark: pgfId-821863]The key point to remember is that the communication pathway is from the Security Manager server to the device; the workstation on which you are running the Security Manager client is not involved in device communication (unless the server is installed on the same machine, of course). The Security Manager server must have a network pathway to the device as well as the correct credentials and certificates to authenticate with the device for communication to be successful.

 
    [bookmark: pgfId-821865]The following topics can help you troubleshoot general device communication and policy deployment problems:

 
     
     		 [bookmark: pgfId-821870]Testing Device Connectivity

 
     		 [bookmark: pgfId-821875]Managing Device Communication Settings and Certificates

 
     		 [bookmark: pgfId-821880]Resolving Red X Marks in the Device Selector

 
     		 [bookmark: pgfId-821885]Troubleshooting Deployment

 
    

 
   
 
    
     [bookmark: pgfId-821901][bookmark: 28265][bookmark: ivman_proc_WorkingwithDeviceConnectivityTest]Testing Device Connectivity[bookmark: marker-821891][bookmark: marker-821893][bookmark: marker-821895][bookmark: marker-821897][bookmark: marker-821899]

 
    [bookmark: pgfId-821903]Security Manager must be able to connect to and log into a device in order to manage it. You can test whether Security Manager can use the credentials and transport method you have defined within Security Manager for this purpose.

 
    [bookmark: pgfId-821905]You can test connectivity only for devices that have static IP addresses. You also cannot test connectivity for devices that use Token Management Server (TMS) as the transport protocol.

 
    [bookmark: pgfId-821907]If you add a device from the network or from an inventory file to the inventory, Security Manager tests connectivity automatically.

 
    [bookmark: pgfId-821912]You can manually test device connectivity for any device in the inventory or for new devices that you are adding manually. The following procedure describes how to test connectivity for devices that are already in the inventory. When adding devices manually, click Test Connectivity on the Device Credentials page of the New Device wizard to perform the test described below. For more information on adding devices manually, see Adding Devices by Manual Definition.

 
    [bookmark: pgfId-821914]Before You Begin

 
    [bookmark: pgfId-821916]Security Manager uses the settings on the Device Communication page to determine the connection timeout, how often to retry the connection, the transport protocol, and which credentials to use. To configure these settings, select Tools > Security Manager Administration and select Device Communication from the table of contents.

 
    [bookmark: pgfId-821918]Related Topics

 
     
     		 [bookmark: pgfId-821923]Understanding the Device View

 
     		 [bookmark: pgfId-821928]Viewing or Changing Device Properties

 
     		 [bookmark: pgfId-821933]Device Communication Page

 
    

 
    
 
    [bookmark: pgfId-821935]Step 1 In Device view, do one of the following in the Device selector to open the Device Properties dialog box:

 
     
     		 [bookmark: pgfId-821937]Double-click a device.

 
     		 [bookmark: pgfId-821939]Right-click a device and select  Device Properties .

 
     		 [bookmark: pgfId-821941]Select a device and select  Tools > Device Properties .

 
    

 
    [bookmark: pgfId-821943]Step 2 Select Credentials from the table of contents.

 
    [bookmark: pgfId-821945]Step 3 Click Test Connectivity.

 
    [bookmark: pgfId-821950]The Device Connectivity Test dialog box opens and displays the progress of the test, including the protocol being used (see Device Connectivity Test Dialog Box). You can abort the test while it is running. When the test is finished, click Details to see:

 
     
     		 [bookmark: pgfId-821952]For successful tests, the output of the  show version command or the  getVersion command (for IPS Sensors and Cisco IOS IPS Sensors). You can select the text, press Ctrl+C to copy the text to the clipboard, and then paste it into another file for later analysis.

 
     		 [bookmark: pgfId-821954]For unsuccessful tests, the error information. Some common problems are:

 
    

 
    [bookmark: pgfId-821956] – The username or password is incorrect.

 
    [bookmark: pgfId-821958] – The wrong protocol is selected. For example, the device might not be configured to respond to the selected protocol.

 
    [bookmark: pgfId-821960] – The device is not configured to accept connections correctly. Ensure that at least one supported protocol is configured.

 
    [bookmark: pgfId-821962] – The wrong operating system is specified for the device (for example, you specified PIX for an ASA device).

 
    [bookmark: pgfId-821964] – If you are using ACS authentication and the connection to the device is completed, you can get errors when Security Manager tries to obtain version information if you do not have Control authorization.

 
    [bookmark: pgfId-821966] – There might be general network configuration problems. Test connectivity to the device from outside of Security Manager. Look for hardware, media, and booting errors, excessive traffic causing queues to overflow, duplicate MAC or IP addresses on the device, physical discrepancies, such as link, duplex, and speed mismatch, or logical discrepancies, such as VLAN and VTP inconsistencies or ATM network misconfiguration.

 
    [bookmark: pgfId-821968]


    
     

    
 
    

 
     
      [bookmark: pgfId-821978][bookmark: 28347][bookmark: ivpage_cncpt_DeviceConnectivityTestDialogBox]Device Connectivity Test Dialog Box [bookmark: marker-821976]

 
     [bookmark: pgfId-821980]Use the Device Connectivity Test dialog box to view whether Security Manager can contact the device using the configured credentials.

 
     [bookmark: pgfId-821982]Navigation Path

 
     [bookmark: pgfId-821984]To start the device connectivity test, click Test Connectivity from the Credentials page in one of these areas:

 
      
      		 [bookmark: pgfId-821989]New Device wizard when adding a device manually. See Adding Devices by Manual Definition.

 
      		 [bookmark: pgfId-821991]Device Properties. To open the page, double-click a device in the Device selector or select  Tools > Device Properties .

 
     

 
     [bookmark: pgfId-821993]The connectivity test is done automatically when you click Next or Finish on the Credentials page when adding a device from the network.

 
     [bookmark: pgfId-821995]Related Topics

 
      
      		 [bookmark: pgfId-822000]Testing Device Connectivity

 
      		 [bookmark: pgfId-822005]Device Credentials Page

 
      		 [bookmark: pgfId-822010]Viewing or Changing Device Properties

 
     

 
     [bookmark: pgfId-822012]Field Reference

 
     [bookmark: pgfId-822015] 

 
      
       
        
        [bookmark: pgfId-821012]Table 9-1 [bookmark: 28382]Device Connectivity Test Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-821018]Element
          
  
         		
           
           [bookmark: pgfId-821020]Description
          
  
        

 
         
         		[bookmark: pgfId-821026]Connectivity Protocol

  
         		[bookmark: pgfId-821031]The transport protocol being used to log into the device. Security Manager uses the protocol specified in the device properties for the device, which is usually the default protocol configured on the Device Communications page (see Device Communication Page).

  
        

 
         
         		[bookmark: pgfId-821037]Connectivity Status

  
         		[bookmark: pgfId-821039]Displays the status of the test and the time elapsed since the start of the test.

  
        

 
         
         		[bookmark: pgfId-821045]Details button

  
         		[bookmark: pgfId-821047]Click this button to display detailed information about the result of the test.

 
           
           		 [bookmark: pgfId-821049]Passed tests—The details display the output of the  show version command for PIX Firewall, Adaptive Security Appliances (ASA), Firewall Service Modules (FWSM), Cisco IOS routers, and VPN Services Modules (VPNSM), or the output of the  getVersion command for IPS Sensors and Cisco IOS IPS Sensors. You can copy the command output and paste it into a file for analysis.

 
           		 [bookmark: pgfId-821051]Failed tests—The detailed error message.

 
          

  
        

 
         
         		[bookmark: pgfId-821057]Abort button

  
         		[bookmark: pgfId-821059]Stops the connectivity test before it is completed.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-822029][bookmark: 28422][bookmark: ivman_cncpt_ManagingDeviceCommunicationSettingsandCertificates]Managing Device Communication Settings and Certificates[bookmark: marker-822021][bookmark: marker-822023][bookmark: marker-822025][bookmark: marker-822027]

 
    [bookmark: pgfId-822031]If you discover device inventory and policies directly from devices, or deploy configurations to devices rather than to files, you must configure Security Manager to use the transport protocols that your devices use. For some device types, only one transport protocol is supported, so you do not need to make a choice. For other devices, such as Cisco IOS routers, you have options concerning the protocols you use.

 
    [bookmark: pgfId-822036]Security Manager has default settings for transport protocols that are the most-used protocols for each device type. To change these settings, select Tools > Security Manager Administration and select Device Communication from the table of contents (see Device Communication Page).

 
    [bookmark: pgfId-822038]For most users, the communication settings that require management are the certificates used for SSL (HTTPS) connections and the public keys used for SSH connections. You might update the certificates and keys on the device, which would leave Security Manager holding an outdated copy. The following topics provide more information about managing certificates and keys, and how to troubleshooting device communications:

 
     
     		 [bookmark: pgfId-822043]SSL certificates—You can configure Security Manager to automatically replace certificates using the ones obtained from the device on the Device Communication page. If you decide to manually manage the SSL certificate store, see Manually Adding SSL Certificates for Devices that Use HTTPS Communications. The following topics provide more information about certificate errors:

 
    

 
    [bookmark: pgfId-822048] – Security Certificate Rejected When Discovering Device

 
    [bookmark: pgfId-822053] – Invalid Certificate Error During Device Discovery

 
    [bookmark: pgfId-822058] – Managing IPS Certificates

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-822063]Tip Ensure that all PIX Firewalls and Adaptive Security Appliances that you intend to manage with Security Manager have a 3DES/AES license. See Understanding Device Communication Requirements.


    
     

    

    

 
     
     		 [bookmark: pgfId-822068]SSH Public Keys—By default, Security Manager replaces public keys with the new ones obtained during SSH connections. If you have problems with SSH communications, see Troubleshooting SSH Connection Problems.

 
     		 [bookmark: pgfId-822073]General Device Communication Troubleshooting—For other problems you might encounter, see Troubleshooting Device Communication Failures.

 
    

 
     
      [bookmark: pgfId-822105][bookmark: 28464][bookmark: defapset_proc_AddingCertificatesforIPSDevicesCiscoIOSDevicesandPIXASAFWSMDevices]Manually Adding SSL Certificates for Devices that Use HTTPS Communications [bookmark: marker-822079][bookmark: marker-822081][bookmark: marker-822083][bookmark: marker-822085][bookmark: marker-822087][bookmark: marker-822089][bookmark: marker-822091][bookmark: marker-822093][bookmark: marker-822095][bookmark: marker-822097][bookmark: marker-822099][bookmark: marker-822101][bookmark: marker-822103]

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-822110]Note In addition to the techniques described in this topic, for IPS devices you can use the IPS Certificates utility to manage the certificates in Security Manager’s certificate data store. For more information, see Managing IPS Certificates.


     
      

     

     

 
     [bookmark: pgfId-822115]When you use SSL (HTTPS) as the transport protocol for communicating with IPS, PIX, ASA, or FWSM devices, or Cisco IOS routers, you can configure Security Manager to automatically retrieve the device authentication certificate when adding the device (see Device Communication Page).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-822117]Tip Having an accurate certificate is required for successful HTTPS communications; Security Manager cannot communicate with the device without the correct certificate, which prevents configuration deployment. When using self-signed certificates, the device might create a new certificate if Security Manager attempts to access it using the wrong certificate. Thus, it is best to configure Security Manager to always retrieve the certificate from the device.


     
      

     

     

 
     [bookmark: pgfId-822119]Instead of having Security Manager automatically retrieve the certificates, you can manually add them to increase the level of network security. On the Device Communication page, you would configure the device authentication setting for the device type as Manually add certificates.

 
     [bookmark: pgfId-822121]The easiest way to manually update the certificate for a device is to retrieve it from the device. Right-click the device and select Device Properties. Click Credentials to open the Credentials page, and then click Retrieve From Device to the right of the Authentication Certificate Thumbprint field. Security Manager retrieves the certificate and prompts you to accept it. You might need to do this if you encounter certificate problems during configuration deployment. (You can also type or paste the certificate into this field.)

 
     [bookmark: pgfId-822123]You can also manually type in, or copy and paste, the certificate thumbprint without having Security Manager log into the device. Use the following procedure to manually enter the SSL certificate thumbprint for a device if you configured that device type to require manually added certificates.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-822125]Tip Security Manager allows you to generate a 2048-bit self-signed certificate under Megamenu > Server Administration > Server > Security > Single Server Management > Certificate Setup.
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     [bookmark: pgfId-822127]Tip To reach the Megamenu, double-click the Cisco Security Manager icon on your server desktop and log on. Another way to reach the Megamenu is as follows: Windows > Start > All Programs > Cisco Security Manager > Cisco Security Manager > [log on]. This second navigation path may differ slightly, depending upon how you have personalized your Windows Server installation.


     
      

     

     

 
     [bookmark: pgfId-822129]Before You Begin

 
     [bookmark: pgfId-822131]Obtain the certificate thumbprint (a hexadecimal string) for the device.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-822133]Tip If the thumbprint is not readily available, you can copy it from the error message that is displayed when you add the device from the network or from an export file.


     
      

     

     

 
     
 
     [bookmark: pgfId-822138]Step 1 Select Tools > Security Manager Administration and select Device Communication from the table of contents to open the Device Communication page (see Device Communication Page).

 
     [bookmark: pgfId-822143]Step 2 Click Add Certificate to open the Add Certificate dialog box (see Add Certificate Dialog Box).

 
     [bookmark: pgfId-822145]Step 3 Enter the DNS hostname or IP Address of the device, the certificate thumbprint in hexadecimal format, and click OK. The thumbprint is added to the certificate store.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-822147]Tip To erase an existing thumbprint, leave the Certificate Thumbprint field empty.


     
      

     

     

 
     [bookmark: pgfId-822149]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-822159][bookmark: 28541][bookmark: ivman_cncpt_SecurityCertificateRejectedWhenDiscoveringDevice]Security Certificate Rejected When Discovering Device [bookmark: marker-822155][bookmark: marker-822157]

 
     [bookmark: pgfId-822161]If an error occurs when you attempt to discover a device, and the error message states that the security certificate received from the device was rejected, you need to update the certificate. You can do this using one of the following methods:

 
      
      		 [bookmark: pgfId-822166]For IPS devices only, select  Manage > IPS > IPS Certificates and synchronize the certificates. You might also need to regenerate the certificate. For more information, see Managing IPS Certificates.

 
      		 [bookmark: pgfId-822168]Manually enter the thumbprint required by the certificate by doing one of the following:

 
     

 
     [bookmark: pgfId-822170] – Select Tools > Security Manager Administration > Device Communication. Click Add Certificate, enter the IP address of the device, then copy and paste the thumbprint displayed in the error message into the Certificate Thumbprint field.

 
     [bookmark: pgfId-822172] – Right-click the device and select Device Properties > Credentials. Copy and paste the thumbprint displayed in the error message into the Authentication Certificate Thumbprint field.

 
     [bookmark: pgfId-822174]You must manually enter the thumbprint whenever you add a new device using the Add New Device or Add From Configuration File options and when you perform rediscovery. It is not required when you add a new device using the Add New Device From Network or Add Device From File options.

 
      
      		 [bookmark: pgfId-822176]Configure the SSL certificate settings to automatically retrieve the certificate when adding devices. You can select different settings for IPS, router, and ASA/PIX/FWSM devices. To configure these settings, select  Tools > Security Manager Administration > Device Communication , and look at the  SSL Certificate Parameters group.

 
     

 
     [bookmark: pgfId-822178]Related Topics

 
      
      		 [bookmark: pgfId-822183]Manually Adding SSL Certificates for Devices that Use HTTPS Communications

 
      		 [bookmark: pgfId-822188]Adding Devices to the Device Inventory

 
      		 [bookmark: pgfId-822193]Chapter 2, “Preparing Devices for Management”

 
      		 [bookmark: pgfId-822198]Device Communication Page

 
      		 [bookmark: pgfId-822203]Device Credentials Page

 
     

 
    
 
     
      [bookmark: pgfId-822217][bookmark: 28589][bookmark: ivman_cncpt_InvalidCertificateErrorDuringDeviceDiscovery]Invalid Certificate Error During Device Discovery [bookmark: marker-822209][bookmark: marker-822211][bookmark: marker-822213][bookmark: marker-822215]

 
     [bookmark: pgfId-822219]If the time settings on the device and Security Manager are not in synchronization, when you try to discover policies on a device (adding it to the inventory or rediscovering policies on a device already in the inventory), an error message might state that the certificate is not yet valid.

 
     [bookmark: pgfId-822221]When the time set on the Security Manager server is lagging behind the time set on the device, Security Manager cannot validate the device certificate if the start time of the validity period is ahead of the Security Manager time setting. Even if the time zones configured on the device and Security Manager are the same, the invalid certificate error occurs if the daylight saving time (summertime) settings are different. To resolve this problem, make sure that the daylight saving time settings are the same on the device and Security Manager, regardless of whether the time zone is the same. After setting the daylight saving time, synchronize the clock on the device with Security Manager so that both of them display the same time.

 
     [bookmark: pgfId-822223]To obtain best results, we recommend that you set the same time zone on the device and Security Manager, and modify the time zone after you discover the certificates at a later time, if necessary.

 
     [bookmark: pgfId-822225]Related Topics

 
      
      		 [bookmark: pgfId-822230]Manually Adding SSL Certificates for Devices that Use HTTPS Communications

 
      		 [bookmark: pgfId-822235]Managing IPS Certificates

 
      		 [bookmark: pgfId-822240]Adding Devices to the Device Inventory

 
      		 [bookmark: pgfId-822245]Chapter 2, “Preparing Devices for Management”

 
     

 
    
 
     
      [bookmark: pgfId-822255][bookmark: 28622][bookmark: defapset_cncpt_DefiningSSHbyEditingtheDCSPropertiesFile]Troubleshooting SSH Connection Problems [bookmark: marker-822251][bookmark: marker-822253]

 
     [bookmark: pgfId-822257]For devices that use SSH as the transport protocol, Security Manager automatically detects the appropriate SSH version (1.5 or 2) to use with each device. During SSH version 2 connections, Security Manager automatically negotiates encryption algorithms or ciphers with the device. Security Manager also automatically overwrites the SSH public key for the device if the key changes. Thus, you typically will not run into SSH connection problems.

 
     [bookmark: pgfId-822259]If you do have SSH connection problems, consider these fixes:

 
      
      		 [bookmark: pgfId-822261]If the public key on the device changed, and SSH connections are failing due to a key problem, remove the key for the device from the Program Files/CSCOpx/MDC/be/tmp/.shh/known_hosts file on the Security Manager server and retry the operation.

 
      		 [bookmark: pgfId-822263]Security Manager uses 3DES (Data Encryption Standard) as the default encryption algorithm. If this is not the correct algorithm for your devices, either change the configuration of your devices, or update the Program Files/MDC/athena/config/DCS.properties file to indicate the correct algorithm on the DCS.ssh.encipher property. (Contact Cisco TAC if you need more help). You must restart the Security Manager daemon manager if you change this file.

 
     

 
     [bookmark: pgfId-822265]Related Topics

 
      
      		 [bookmark: pgfId-822270]Chapter 2, “Preparing Devices for Management”

 
      		 [bookmark: pgfId-822275]Device Communication Page

 
      		 [bookmark: pgfId-822280]Device Credentials Page

 
     

 
    
 
     
      [bookmark: pgfId-822296][bookmark: 28650][bookmark: ivman_cncpt_TroubleshootingDeviceCommunicationFailures]Troubleshooting Device Communication Failures [bookmark: marker-822286][bookmark: marker-822288][bookmark: marker-822290][bookmark: marker-822292][bookmark: marker-822294]

 
     [bookmark: pgfId-822298]If Security Manager fails to communicate with a device, for example, by failing to log into it, during discovery, deployment, or other actions, look at these areas to identify and resolve the problem:

 
      
      		 [bookmark: pgfId-822300]Ensure the device is operational.

 
      		 [bookmark: pgfId-822302]Check which transport protocol is selected. You must select a protocol that the device is configured to accept. For most devices, the protocol is selected on the Device Properties General page (select  Tools > Device Properties > General ). For IPS devices, the IPS RDEP mode is selected on the device properties Credentials page.

 
     

 
     [bookmark: pgfId-822304]For IOS devices that do not have a K8 or K9 crypto image, ensure that you select Telnet as the protocol.

 
     [bookmark: pgfId-822306]Some methods of adding devices also allow you to select a non-default transport protocol. To configure the default transport protocols for classes of devices, select Tools > Security Manager Administration > Device Communications.

 
      
      		 [bookmark: pgfId-822308]On the Device Properties General page, ensure that the hostname, domain name, and IP address are correct. Keep in mind that the Hostname and Accounts and Credentials policies for the device define the actual names and credentials that get configured on the device. However, the policies are not used for device communication. If you make changes to the policies that affect the credentials you are using for device communication, you must also manually update the device properties.

 
      		 [bookmark: pgfId-822310]Make sure DNS names can be resolved from the Security Manager server. You might need to fix the DNS settings on the server.

 
      		 [bookmark: pgfId-822312]Check the credentials for the device in Security Manager and ensure that they are correct and that there is a route between the server and device. Right-click the device, select  Device Properties , select the Credentials tab, and click the  Test Connectivity button. If the connection fails, check error messages to determine whether the problem is connectivity or credentials. Update the credentials in the device properties if necessary.

 
     

 
     [bookmark: pgfId-822314]When adding new devices the credentials are defined within the New Device wizard if your method of adding the device requires credentials. Keep the following in mind:

 
     [bookmark: pgfId-822316] – The primary credentials are used for SSH and Telnet connections.

 
     [bookmark: pgfId-822318] – The HTTP/HTTPS credentials are used for HTTP and SSL connections unless you select Use Primary Credentials, in which case the primary credentials are also used for these connections.

 
     [bookmark: pgfId-822320]Related Topics

 
      
      		 [bookmark: pgfId-822325]Adding Devices to the Device Inventory

 
      		 [bookmark: pgfId-822330]Understanding Device Communication Requirements

 
      		 [bookmark: pgfId-822335]Chapter 2, “Preparing Devices for Management”

 
      		 [bookmark: pgfId-822340]Device Communication Page

 
      		 [bookmark: pgfId-822345]Device Credentials Page

 
     

 
    
 
   
 
    
     [bookmark: pgfId-822359][bookmark: 28712][bookmark: ivpage_cncpt_DeviceServerAssignmentDialogBox]Resolving Red X Marks in the Device Selector[bookmark: marker-822353][bookmark: marker-822355][bookmark: marker-822357]

 
    [bookmark: pgfId-822361]If a device is marked with a red X in the device selector in Device view, it means that the Auto Update Server (AUS) or Configuration Engine server assignment for the device was lost during an upgrade from a Security Manager release prior to 3.2.0. AUS and Configuration Engines are not migrated during an upgrade from 3.1.x, and devices managed by them need to be reassigned to them after the upgrade using the following procedure.

 
    
 
    [bookmark: pgfId-822363]Step 1 Do one of the following in Device view:

 
     
     		 [bookmark: pgfId-822365]From the Device selector, right-click a device with a red X icon, then select  Update Server Info .

 
     		 [bookmark: pgfId-822367]Click any red X icon in the device selection tree. A warning message is displayed stating that AUS and Configuration Engine information was not migrated after the upgrade process. Click  Yes to add these servers manually.

 
    

 
    [bookmark: pgfId-822369]The Device Server Assignment dialog box opens.

 
    [bookmark: pgfId-822371]Step 2 From the Available Devices list, select all the devices that use the same AUS or Configuration Engine server and click >> to move them to the selected list. The Available Devices list includes all devices that are managed by AUS or Configuration Engine that are marked with a red X.

 
    [bookmark: pgfId-822376]Step 3 Select the AUS or Configuration Engine that manages the selected devices from the Server list. If the correct server is not listed, select + Add Server... to add it to the inventory using the Server Properties Dialog Box.

 
    [bookmark: pgfId-822381]For more information on adding AUS or Configuration Engine servers to the inventory, see Adding, Editing, or Deleting Auto Update Servers or Configuration Engines.

 
    [bookmark: pgfId-822383]Step 4 Repeat the process until no device is marked with a red X.

 
    [bookmark: pgfId-822385]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-822395][bookmark: 28749][bookmark: dpman_cncpt_TroubleshootingDeployment]Troubleshooting Deployment [bookmark: marker-822391][bookmark: marker-822393]

 
    [bookmark: pgfId-822397]The deployment process is one of the most likely areas in which you will encounter problems when using Security Manager. There are many different processes involved in deployment that influence whether the deployment job is successful:

 
     
     		 [bookmark: pgfId-822399]Security Manager itself.

 
     		 [bookmark: pgfId-822401]The stability and availability of your network, including links to remotely-managed devices.

 
     		 [bookmark: pgfId-822403]Any bugs inherent in the versions of the operating systems that you are using on your network devices that affect the commands Security Manager is trying to deploy (Security Manager is not immune to these bugs).

 
     		 [bookmark: pgfId-822405]The licenses you have enabled on the device, because many security commands require specific device licenses.

 
     		 [bookmark: pgfId-822407]The specific features supported by your devices, which Security Manager cannot always determine ahead of time. For example, some platforms support features only if the device has a certain minimum RAM, and some interface settings are available for specific interface cards only.

 
     		 [bookmark: pgfId-822409]The correct functioning of interim applications such as AUS, Configuration Engine, or your TMS server.

 
    

 
    [bookmark: pgfId-822411]If you encounter deployment failures, examine the messages in the deployment status window carefully. In addition, the following topics address some of the problems you might encounter:

 
     
     		 [bookmark: pgfId-822416]Changing How Security Manager Responds to Device Messages

 
     		 [bookmark: pgfId-822421]Memory Violation Deployment Errors for ASA 8.3+ Devices

 
     		 [bookmark: pgfId-822426]Security Manager Unable to Communicate With Device After Deployment

 
     		 [bookmark: pgfId-822431]Updating VPNs That Include Routing Processes

 
     		 [bookmark: pgfId-822436]Mixing Deployment Methods with Router and VPN Policies

 
     		 [bookmark: pgfId-822441]Deployment Failures for Routers

 
     		 [bookmark: pgfId-822446]Deployment Failures for Catalyst Switches and Service Modules

 
     		 [bookmark: pgfId-822451]Deployment Failures to Devices Managed by AUS

 
     		 [bookmark: pgfId-822456]Troubleshooting the Setup of Configuration Engine-Managed Devices

 
    

 
     
      [bookmark: pgfId-822474][bookmark: 28800][bookmark: dpman_proc_ChangingHowSecurityManagerRespondstoDeviceMessages]Changing How Security Manager Responds to Device Messages [bookmark: marker-822462][bookmark: marker-822464][bookmark: marker-822466][bookmark: marker-822468][bookmark: marker-822470][bookmark: marker-822472]

 
     [bookmark: pgfId-822476]Security Manager has built-in responses to many of the response messages that can be encountered when configuring a device. You might find that messages Security Manager treats as errors are messages that you want to ignore or treat as informational. Although you can configure your deployment jobs to ignore errors, you might instead want to update Security Manager to treat specific messages differently using a properties file.

 
     [bookmark: pgfId-822478]It is important to understand that setting the properties file to ignore the error is not always sufficient. Deployment can fail because the Allow Download on Error check box (located on the Tools > Security Manager Administration > Deployment page) is deselected by default. The following table provides details about how Security Manager behaves when an error occurs during deployment, the Allow Download on Error option is either selected or deselected, and the Save Changes Permanently on Device option is selected or deselected.

 
     [bookmark: pgfId-822481] 

 
      
       
        
        [bookmark: pgfId-821078]Table 9-2 [bookmark: 28829]Deployment Device Error Handling for SSL and SSH on PIX Firewall, ASA, and Cisco IOS Routers 

 
        
       
         
         		
           
           [bookmark: pgfId-821090]Allow Download on Error
          
  
         		
           
           [bookmark: pgfId-821092]Error Occurred
          
  
         		
           
           [bookmark: pgfId-821094]Error Ignored Using Warning Expression
          
  
         		
           
           [bookmark: pgfId-821096]Deployment Status
          
  
         		
           
           [bookmark: pgfId-821098]Write Memory Done
          
  
        

 
         
         		[bookmark: pgfId-821110]Selected

  
         		[bookmark: pgfId-821112]Yes

  
         		[bookmark: pgfId-821114]No

  
         		[bookmark: pgfId-821116]Failed

  
         		[bookmark: pgfId-821118]Based on whether Save Changes Permanently on Device is selected.

  
        

 
         
         		[bookmark: pgfId-821130]Selected

  
         		[bookmark: pgfId-821132]Yes

  
         		[bookmark: pgfId-821134]Yes

  
         		[bookmark: pgfId-821136]Success

  
         		[bookmark: pgfId-821138]Based on whether Save Changes Permanently on Device is selected.

  
        

 
         
         		[bookmark: pgfId-821150]Selected

  
         		[bookmark: pgfId-821152]No

  
         		[bookmark: pgfId-821154]Not applicable

  
         		[bookmark: pgfId-821156]Success

  
         		[bookmark: pgfId-821158]Based on whether Save Changes Permanently on Device is selected.

  
        

 
         
         		[bookmark: pgfId-821170]Deselected

  
         		[bookmark: pgfId-821172]Yes

  
         		[bookmark: pgfId-821174]No

  
         		[bookmark: pgfId-821176]Failed (Deploy not Completed message)

  
         		[bookmark: pgfId-821178]No.

  
        

 
         
         		[bookmark: pgfId-821190]Deselected

  
         		[bookmark: pgfId-821192]Yes

  
         		[bookmark: pgfId-821194]Yes

  
         		[bookmark: pgfId-821196]SSL (ASA, PIX, IOS devices)—Failed

 [bookmark: pgfId-821198]SSH (IOS devices—Success

  
         		[bookmark: pgfId-821200]SSL—No.

 [bookmark: pgfId-821202]SSH (IOS devices)—Based on whether Save Changes Permanently on Device is selected.

  
        

 
         
         		[bookmark: pgfId-821214]Deselected

  
         		[bookmark: pgfId-821216]No

  
         		[bookmark: pgfId-821218]Not applicable

  
         		[bookmark: pgfId-821220]Success

  
         		[bookmark: pgfId-821222]Based on whether Save Changes Permanently on Device is selected.
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     [bookmark: pgfId-822483]Note On Cisco IOS routers using the SSL protocol, deployment on devices stops on command syntax errors. It does not stop when configuration-related errors occur.


     
      

     

     

 
     [bookmark: pgfId-822485]To change how Security Manager treats a message, you need to update the DCS.properties file in \CSCOpx\MDC\athena\config folder in the installation directory (usually c:\Program Files). Use a text editor such as NotePad to update the file.

 
     [bookmark: pgfId-822487]It is easiest to determine the message you want to ignore by looking at the transcript of a deployment job that encountered the error using the following procedure.

 
     [bookmark: pgfId-822489]Related Topics

 
      
      		 [bookmark: pgfId-822494]Viewing Deployment Status and History for Jobs and Schedules

 
     

 
     
 
     [bookmark: pgfId-822496]Step 1 Click the Deployment Manager button in the Main toolbar.

 
     [bookmark: pgfId-822498]The Deployment Manager window appears. Click the Deployment Jobs tab if it is not active.

 
     [bookmark: pgfId-822500]Step 2 Select the job with the error message.

 
     [bookmark: pgfId-822502]Step 3 Click the Transcript button in the Deployment Details tab to open the transcript.

 
     [bookmark: pgfId-822504]Step 4 Identify the error text that you want to ignore.

 
     [bookmark: pgfId-822506]Step 5 Locate the appropriate warning expressions property in the DCS.properties file. For example, for PIX devices the property is called dev.pix.warningExpressions, whereas for IOS devices the property is called dev.ios.warningExpressions.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-822508]Tip Conversely, you can make device responses that are not tagged with the Error prefix to appear as error messages. To do this, add the message to the Error Expressions list (for example, dev.pix.ErrorExpressions).


     
      

     

     

 
     [bookmark: pgfId-822510]Step 6 Add the error text to the warning expressions list. The warning message should be a generic regular expression string. Except for the last expression, you must delimit all expressions with “$\”. For example, if the message you want to ignore is “Enter a public key as a hexadecimal number,” enter the following string:

 
     [bookmark: pgfId-822512].*Enter a public key as a hexadecimal number .*$

 
     [bookmark: pgfId-822514]Step 7 Restart the CiscoWorks Daemon Manager.

 
     [bookmark: pgfId-822516]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-822526][bookmark: 28955][bookmark: dpman_cncpt_MinimumMemoryDeploymentErrorsforASA83Devices]Memory Violation Deployment Errors for ASA 8.3+ Devices[bookmark: marker-822522][bookmark: marker-822524]

 
     [bookmark: pgfId-822528]ASA Software release 8.3+ requires significantly more device memory than previous versions of the ASA software. If you upgrade an ASA device that does not meet the minimum memory requirements, the upgrade process notifies you of the problem and the device regularly sends syslog messages until the minimum memory requirement is met.

 
     [bookmark: pgfId-822530]Because an ASA device that does not meet the minimum memory requirements can function poorly, Security Manager does not deploy configurations to these devices, although you are allowed to add the device to the inventory and discover policies from it. However, if you try to deploy policies to the device before you add memory, you get a deployment error stating that the device does not meet the minimum memory requirements and deployment fails.

 
     [bookmark: pgfId-822534]The best way to resolve the error is to add memory to the device. For information about ASA devices and memory upgrade possibilities, see http://www.cisco.com/go/asa.

 
     [bookmark: pgfId-822536]Alternatively, you can downgrade the ASA software version, in which case you should delete the device from the inventory, then add it back to the inventory and discover policies.

 
    
 
     
      [bookmark: pgfId-822546][bookmark: 28970][bookmark: dpman_cncpt_DeploymentFailsAttemptingtoRemoveUnreferencedObject]Error While Attempting to Remove Unreferenced Object[bookmark: marker-822542][bookmark: marker-822544]

 
     [bookmark: pgfId-822548]If you enable the Remove Unreferenced Object Groups from Device option on the Tools > Security Manager Administration > Deployment page, Security Manager will remove objects during deployment that are not used in any policies managed or discovered by Security Manager. If any policy that is NOT discovered or managed by Security Manager is using such an object, Security Manager will still attempt to delete that object during deployment. In such cases, deployment will fail with a transcript error indicating that it was unable to delete the object as the object is being used. To successfully deploy, disable the Remove Unreferenced Object Groups from Device option.

 
    
 
     
      [bookmark: pgfId-822560][bookmark: 28981][bookmark: dpman_cncpt_SecurityManagerUnabletoCommunicateWithDeviceAfterDeployment]Security Manager Unable to Communicate With Device After Deployment [bookmark: marker-822554][bookmark: marker-822556][bookmark: marker-822558]

 
     [bookmark: pgfId-822562]There are a number of policies that you can configure in Security Manager that prevent access to a device. That is the point of security, ensuring that unwanted hosts cannot enter your network or network devices.

 
     [bookmark: pgfId-822564]However, you can inadvertently lock the Security Manager server out of a device, making it impossible for Security Manager to deploy configurations to it or manage it. If you find that after a deployment, Security Manager can no longer contact a device, and you have already checked that the device is up and running and otherwise functioning normally, look into the following policies to see if they are causing the lock-out:

 
      
      		 [bookmark: pgfId-822566] Firewall > Access Rules, or Firewall > Zone Based Firewall Rules —If you use these policies, the rules must allow management traffic from the Security Manager server. Consider allowing at least HTTP, HTTPS, SSH, and Telnet. Consider creating a shared policy that defines the required access for Security Manager and applying it to all devices. Keep in mind that if you create any rules in these policies, an implicit rule is added to the end of the policy that denies any traffic that is not explicitly allowed.

 
      		 [bookmark: pgfId-822568] NAT policies —Make sure that you are not using a local address on the device as the original address to be translated. Translating this address might result in translating the management traffic sent between Security Manager and the device, causing the interruption.

 
      		 [bookmark: pgfId-822570] Device Access policies on routers —Security Manager might loose contact with a device after you unassign a device access policy from the device and redeploy it. Device access policies can be used to define the enable password for accessing the device. If you unassign this policy and redeploy, the password is removed from the device. In such cases, the device typically reverts to the default password. However, in some cases, the device might contain an additional password that is unknown to Security Manager, such as a line console password. If this additional password exists, the device reverts to that password instead of the default password. If that happens, Security Manager cannot configure this device. Therefore, if you use a device access policy to configure the enable password or enable secret password on a device, make sure that you do not unassign the policy without assigning a new policy before the next deployment.

 
      		 [bookmark: pgfId-822572] Site-to-Site VPNs —If you lose communication with a spoke in a VPN, the problem can occur when the Security Manager server communicates with an external interface on the spoke from within the hub’s protected network. We recommend that when you add the hub device to Security Manager that you define a management IP address that is located outside of the hub’s protected network.

 
      		 [bookmark: pgfId-822574] Platform > Device Admin > Device Access > Allowed Hosts —For IPS devices, the Allowed Hosts policy identifies the hosts that can connect to the sensor. The Security Manager server must be included in this policy.

 
     

 
     [bookmark: pgfId-822576]Related Topics

 
      
      		 [bookmark: pgfId-822581]Troubleshooting Device Communication Failures

 
      		 [bookmark: pgfId-822586]Managing Device Communication Settings and Certificates

 
      		 [bookmark: pgfId-822591]Managing IPS Certificates

 
      		 [bookmark: pgfId-822596]Understanding Device Communication Requirements

 
     

 
    
 
     
      [bookmark: pgfId-822610][bookmark: 29027][bookmark: dpman_cncpt_UpdatingVPNsThatIncludeRoutingProcesses]Updating VPNs That Include Routing Processes [bookmark: marker-822602][bookmark: marker-822604][bookmark: marker-822606][bookmark: marker-822608]

 
     [bookmark: pgfId-822612]Problem: When you define and deploy changes to a routing process that is being used by a VPN topology (using either the Site-to-Site VPN Manager or the routing policies), the changes that you make are not reflected in the CLI commands configured on the device.

 
     [bookmark: pgfId-822614]Solution: When you discover a VPN topology that includes routing processes, such as GRE full mesh, Security Manager populates the GRE Modes policy in the Site-to-Site VPN Manager, as well as the relevant routing policies. However, changes made to one of these policies in Security Manager are not automatically reflected in the other policy, which can lead to unexpected results after deployment. Therefore, if you make changes to the secured IGP in the Site-to-Site VPN Manager, be sure to go to Platform > Routing in Device view to make the necessary changes in the device’s routing policies. Likewise, if you make changes directly to the routing policy, be sure to make the necessary changes in the Site-to-Site VPN Manager as well.

 
     [bookmark: pgfId-822616]Related Topics

 
      
      		 [bookmark: pgfId-822621]Chapter 25, “Managing Site-to-Site VPNs: The Basics”

 
      		 [bookmark: pgfId-822626]Chapter 60, “Managing Routers”

 
      		 [bookmark: pgfId-822631]Chapter 46, “Managing Firewall Devices”

 
     

 
    
 
     
      [bookmark: pgfId-822645][bookmark: 29059][bookmark: dpman_cncpt_MixingDeploymentMethodswithRouterandVPNPolicies]Mixing Deployment Methods with Router and VPN Policies [bookmark: marker-822637][bookmark: marker-822639][bookmark: marker-822641][bookmark: marker-822643]

 
     [bookmark: pgfId-822647]You might receive unpredictable results when you deploy router platform and VPN policies to a live device after previously deploying to a configuration file.

 
     [bookmark: pgfId-822649]This problem can occur when you use a mix of deployment methods (deploy to device and deploy to file) with router platform policies and VPN policies. Because Security Manager does not manage all the available CLI commands for these policy types, it maintains a snapshot of the commands it has configured and leaves all other commands (which includes unsupported commands as well as supported commands in policies that have not been configured in Security Manager) intact on the device.

 
     [bookmark: pgfId-822651]After each deployment, Security Manager creates a snapshot of the policies that were deployed to each device. This snapshot is used during the next deployment to generate the list of configuration changes that will be deployed to the device. Only one snapshot is maintained at a time per device.

 
     [bookmark: pgfId-822653]Mixing deployment methods with router platform policies and VPN policies can lead to unpredictable results, as shown in this example:

 
     [bookmark: pgfId-822655] 1. Configure router platform policy A to a live device. When deployment completes, Security Manager creates a snapshot for that device with policy A.

 
     [bookmark: pgfId-822657] 2. Next, configure policy B to replace policy A, but instead of deploying policy B to the device, deploy it to a file instead. When this deployment completes, Security Manager creates a snapshot with policy B that replaces the previous snapshot with policy A. However, because you did not deploy policy B to the device, the CLI commands that are required to negate policy A have not been deployed. Policy A is still deployed on the device.

 
     [bookmark: pgfId-822659] 3. Deploy again to the device without first copying the changes in the configuration file to the device. Security Manager cannot generate the commands that are required to negate policy A from the device because the snapshot with policy A no longer exists.

 
     [bookmark: pgfId-822661]Because policy A is a router platform policy, any of the following results might occur:

 
      
      		 [bookmark: pgfId-822663]The policy in the latest deployment overrides policy A.

 
      		 [bookmark: pgfId-822665]Both policies end up defined on the device.

 
      		 [bookmark: pgfId-822667]Deployment fails because the two policies cannot coexist.

 
     

 
     [bookmark: pgfId-822669]Therefore, if you deploy to a file when working on a live device, we strongly recommend that you copy your configuration changes from the file to the device before performing additional deployments to the device.

 
     [bookmark: pgfId-822671]Related Topics

 
      
      		 [bookmark: pgfId-822676]Chapter 25, “Managing Site-to-Site VPNs: The Basics”

 
      		 [bookmark: pgfId-822681]Chapter 60, “Managing Routers”

 
     

 
    
 
     
      [bookmark: pgfId-822693][bookmark: 29104][bookmark: dpman_cncpt_DeploymentFailuresforRouters]Deployment Failures for Routers [bookmark: marker-822687][bookmark: marker-822689][bookmark: marker-822691]

 
     [bookmark: pgfId-822695]Following are some potential problems you might encounter when deploying configurations to Cisco IOS routers.

 
     [bookmark: pgfId-822701]Deployment Fails for Interface Settings[bookmark: marker-822697][bookmark: marker-822699]

 
     [bookmark: pgfId-822703]Problem: Deployment fails for interface settings on a router.

 
     [bookmark: pgfId-822705]Solution: Security Manager cannot validate whether you have the appropriate types of interface cards or shared port adapters (SPAs) installed on the router, or the appropriate licenses configured, to support your interface policies. If you add or remove an interface card without changing your interface policies, you can encounter deployment errors. The best practice is to ensure that you discover inventory from the router whenever you change interface modules or SPAs so that Security Manager can discover the appropriate interface features.

 
     [bookmark: pgfId-822709]Deploying Layer 2 Interface Definitions[bookmark: marker-822707]

 
     [bookmark: pgfId-822711]Problem: Deployment fails if the interface policy includes a definition for a Layer 2 interface.

 
     [bookmark: pgfId-822713]Solution: Layer 2 interfaces do not support Layer 3 interface definitions, such as IP addresses. Make sure that you did not define a Layer 3 definition on the Layer 2 interface.

 
     [bookmark: pgfId-822719]VPN Traffic Sent Unencrypted[bookmark: marker-822715][bookmark: marker-822717]

 
     [bookmark: pgfId-822721]Problem: Traffic that should be sent encrypted over a VPN is instead being sent unencrypted.

 
     [bookmark: pgfId-822723]Solution: Ensure that you are not performing NAT on VPN traffic. Performing address translation on VPN traffic prevents the traffic from being encrypted and sent through the VPN tunnel. When defining dynamic NAT rules, make sure that the Do Not Translate VPN Traffic check box is selected, even when you perform NAT into IPSec. (This option does not interfere with the translation of addresses arriving from overlapping networks.)

 
     [bookmark: pgfId-822728]This option can be used only on site-to-site VPNs. For remote access VPNs, you need to create an ACL object that explicitly denies the flow containing VPN traffic and define this ACL as part of a dynamic rule in the NAT policy. For more information, see NAT Page: Dynamic Rules.

 
     [bookmark: pgfId-822736]Unable to Deploy ADSL or PVC Policy[bookmark: marker-822730][bookmark: marker-822732][bookmark: marker-822734]

 
     [bookmark: pgfId-822738]Problem: Deployment fails for your ADSL or PVC policy.

 
     [bookmark: pgfId-822740]Solution: Make sure that you have selected the correct ATM interface card type in the policy definition. Security Manager cannot properly validate the policy definition without knowing the correct card type, which can lead to deployment failures.

 
     [bookmark: pgfId-822744]DHCP Traffic Not Being Transmitted[bookmark: marker-822742]

 
     [bookmark: pgfId-822746]Problem: DHCP traffic is not being transmitted even after you deploy a DHCP policy to the device.

 
     [bookmark: pgfId-822748]Solution: Check whether an access rule on the device blocks Bootstrap Protocol (BootP) traffic. Having such a rule prevents DHCP traffic from being transmitted.

 
     [bookmark: pgfId-822752]NAC Not Implemented on Router[bookmark: marker-822750]

 
     [bookmark: pgfId-822754]Problem: Network admission control is not being implemented on the router, even though a NAC policy was deployed to it.

 
     [bookmark: pgfId-822756]Solution: Ensure that the default ACL on the router permits UDP traffic over the port defined in the NAC policy for EAP over UDP traffic. This is the protocol that NAC uses for communication between the Cisco Trust Agent (CTA), which is the NAC client that provides posture credentials for the endpoint device on which it is installed and the network access device (NAD; in this case, the router) that relays the posture credentials to the AAA server for validation. The default port used for EAP over UDP traffic is 21862, but you can change this port as part of the NAC policy. If the default ACL blocks UDP traffic, EAP over UDP traffic is likewise blocked, which prevents NAC from taking place.

 
     [bookmark: pgfId-822766]Deployment Fails with Error Writing to Server or HTTP Response Code 500 Messages[bookmark: marker-822758][bookmark: marker-822760][bookmark: marker-822762][bookmark: marker-822764]

 
     [bookmark: pgfId-822768]Problem: Deployment to a Cisco IOS router fails and an “Error Writing to Server” or “Http Response Code 500” error message occurs.

 
     [bookmark: pgfId-822770]Solution: When you use SSL as the transport protocol for deploying configurations to a Cisco IOS router, the configuration is split into multiple configuration bulks. The size of this configuration bulk varies from platform to platform. If Security Manager tries to deploy a configuration bulk that exceeds the size of the SSL chunk configured on that device, the deployment fails and you get an “Error Writing to Server” or “Http Response Code 500” error message.

 
     [bookmark: pgfId-822772]To resolve this, do the following:

 
     [bookmark: pgfId-822774] 1. On the Security Manager server, open the DCS.properties file in the \CSCOpx\MDC\athena\config folder in the installation directory (usually C:\Program Files).

 
     [bookmark: pgfId-822776] 2. Locate DCS.IOS.ssl.maxChunkSize=<value of the configuration bulk>.

 
     [bookmark: pgfId-822778] 3. Reduce the value of the configuration bulk.

 
     [bookmark: pgfId-822780] 4. Restart the CiscoWorks Daemon Manager.

 
     [bookmark: pgfId-822782]Related Topics

 
      
      		 [bookmark: pgfId-822787]Chapter 60, “Managing Routers”

 
     

 
    
 
     
      [bookmark: pgfId-822803][bookmark: 29225][bookmark: dpman_cncpt_DeploymentFailuresforCatalystSwitchesandServiceModules]Deployment Failures for Catalyst Switches and Service Modules[bookmark: marker-822793][bookmark: marker-822795][bookmark: marker-822797][bookmark: marker-822799][bookmark: marker-822801]

 
     [bookmark: pgfId-822805]Following are some potential problems you might encounter when deploying configurations to Catalyst switches and Catalyst 6500/7600 service modules.

 
     [bookmark: pgfId-822811]Deployment Fails for Interface Settings[bookmark: marker-822807][bookmark: marker-822809]

 
     [bookmark: pgfId-822813]Problem: Deployment fails for interface settings on a Catalyst 6500/7600 device.

 
     [bookmark: pgfId-822815]Solution: Certain interface settings (such as speed, duplex, and MTU settings) are specific to particular card types and are not validated prior to deployment. Make sure to enter the correct values for your specific card type to ensure successful deployment.

 
     [bookmark: pgfId-822819]Deployment Failures to FWSM Security Contexts After Changing Interface Policies[bookmark: marker-822817]

 
     [bookmark: pgfId-822821]Problem: You add an FWSM with security contexts and discover its policies. The configuration includes interface aliases (the allocate interface command). After changing the interfaces policy for a context, deployment fails.

 
     [bookmark: pgfId-822823]Solution: Connect directly to the FWSM and remove all mapped interface names from the system execution space configuration and in all other contexts, replace interface references to mapped names with the VLAN ID of the interface. You can then delete the FWSM from the Security Manager inventory and rediscover it.

 
     [bookmark: pgfId-822827]Deployment Failures for FWSMs That Have Multiple Contexts[bookmark: marker-822825]

 
     [bookmark: pgfId-822829]Problem: Deployment to an FWSM that has multiple security contexts sometimes fails or results in a temporary performance impact to the FWSM.

 
     [bookmark: pgfId-822834]Solution: The problem is that Security Manager is trying to deploy configurations to more than one security context on a device at the same time. Depending on the configuration changes, this can result in errors on the device that prevent successful deployment. If you use FWSM in multiple-context mode, configure Security Manager to deploy configurations serially to the device so that one context at a time is configured, as described in Changing How Security Manager Deploys Configurations to Multiple-Context FWSM.

 
     [bookmark: pgfId-822840]Deployment Fails for Internal VLANs[bookmark: marker-822836][bookmark: marker-822838]

 
     [bookmark: pgfId-822842]Problem: Deployment fails when Security Manager tries to create a VLAN with an ID that is within the range of the device’s internal VLAN list.

 
     [bookmark: pgfId-822844]Solution: Security Manager cannot detect internal VLANs. Therefore, you must define a VLAN ID that falls outside of the device’s internal VLAN list. Use the show vlan internal usage command on the device to view the list of internal VLANs.

 
     [bookmark: pgfId-822848]Deployment Fails When Changing the Running Mode of an IDSM Data Port VLAN[bookmark: marker-822846]

 
     [bookmark: pgfId-822850]Problem: Deployment fails when you attempt to change the running mode of the data port VLAN from Trunk (IPS) to Capture (IDS) and the following error message is displayed:

 
     [bookmark: pgfId-822852]Command Rejected: Remove trunk allowed vlan configuration from data port 2 before configuring capture allowed-vlans

 
     [bookmark: pgfId-822854]Solution: On some software releases such as 12.2(18)SFX4, there is a bug that prevents the change from occurring correctly. Reload the device to overcome the problem.

 
     [bookmark: pgfId-822860]Deployment Fails for FWSM Configuration With Large Numbers of ACLs[bookmark: marker-822856][bookmark: marker-822858]

 
     [bookmark: pgfId-822862]Problem: Deployment to FWSM devices fail when the configuration contains a large number of ACLs.

 
     [bookmark: pgfId-822864]Solution: This could occur because the CPU utilization is high during ACL compilation. To resolve this, reconfigure the CPU utilization threshold limit by doing the following:

 
     [bookmark: pgfId-822866] 1. On the Security Manager server, open the DCS.properties file in the \CSCOpx\MDC\athena\config folder in the installation directory (usually C:\Program Files).

 
     [bookmark: pgfId-822868] 2. Locate the DCS.FWSM.checkThreshold=False property.

 
     [bookmark: pgfId-822870] 3. Change the value to true: DCS.FWSM.checkThreshold=True.

 
     [bookmark: pgfId-822872] 4. Restart the CiscoWorks Daemon Manager.

 
     [bookmark: pgfId-822874] 5. Deploy the configuration to the device again.

 
     [bookmark: pgfId-822876]After you set the value to true, discovery and deployment checks the CPU utilization and generates error messages if the CPU utilization is not within the configured value set in the DCS.FWSM.minThresholdLimit property. The default value is 85.

 
     [bookmark: pgfId-822878]Related Topics

 
      
      		 [bookmark: pgfId-822883]Chapter 67, “Managing Cisco Catalyst Switches and Cisco 7600 Series Routers”

 
     

 
    
 
     
      [bookmark: pgfId-822897][bookmark: 29332][bookmark: dpman_proc_ChangingHowSecurityManagerDeploysConfigurationstoMultipleContextFWSM]Changing How Security Manager Deploys Configurations to Multiple-Context FWSM [bookmark: marker-822889][bookmark: marker-822891][bookmark: marker-822893][bookmark: marker-822895]

 
     [bookmark: pgfId-822899]If you configure a Firewall Services Module (FWSM) to run in multiple context mode, so that you host more than one security context on the FWSM, you need to configure Security Manager to deploy configurations serially to the FWSM. The FWSM has some limitations that can prevent successful deployments if more than one context is updated at the same time, so you might run into deployment failures if you do not use serial deployment. There can also be an impact on FWSM performance during deployment if you do not use serial deployment.

 
     [bookmark: pgfId-822901]To change how Security Manager deploys configurations to multiple-context FWSM, you need to update the DCS.properties file. You also need to add the FWSM contexts to the inventory using the FWSM admin context, rather than adding the individual security contexts.

 
     [bookmark: pgfId-822903]The following procedure explains the end-to-end process for ensuring that FWSM deployments are done serially.

 
     
 
     [bookmark: pgfId-822905]Step 1 Make it a standard practice to add FWSM security contexts using the admin context management IP address. Manage the contexts through the admin context.

 
     [bookmark: pgfId-822907]Although it is possible to add security contexts for an FWSM individually, using each context’s management IP address, Security Manager cannot recognize these individually-added contexts as being hosted on the same physical device. This prevents Security Manager from doing serial deployments to the contexts.

 
     [bookmark: pgfId-822912]If you have any FWSM security contexts that you added using the security context management IP, delete the contexts and FWSM from the inventory, then add them using the admin context (discover all policies). See Adding Devices to the Device Inventory.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-822914]Tip If you have any undeployed changes to these contexts that you want to keep, first deploy the changes to ensure that the configurations on the device are complete. Do the deployments one context at a time.


     
      

     

     

 
     [bookmark: pgfId-822916]Step 2 Log into Windows on the Security Manager server and edit the DCS.properties file in the \CSCOpx\MDC\athena\config folder in the installation directory (usually c:\Program Files). Use a text editor such as NotePad to update the file.

 
     [bookmark: pgfId-822918]Step 3 Locate the DCS.doSerialAccessForFWSMVCs property in the DCS.properties file and set it to true:

 
     [bookmark: pgfId-822920]DCS.doSerialAccessForFWSMVCs=true

 
     [bookmark: pgfId-822922]Step 4 Restart the CiscoWorks Daemon Manager.

 
     [bookmark: pgfId-822924]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-822936][bookmark: 29369][bookmark: dpman_cncpt_DeploymentFailurestoDevicesManagedbyAUS]Deployment Failures to Devices Managed by AUS [bookmark: marker-822930][bookmark: marker-822932][bookmark: marker-822934]

 
     [bookmark: pgfId-822938]Deployment might fail when deploying to multiple AUS-managed devices after starting the AUS if you perform deployment before the Auto Update Server (AUS) is fully operational. The AUS requires time to start up after the following operations:

 
      
      		 [bookmark: pgfId-822940]New installation or upgrade.

 
      		 [bookmark: pgfId-822942]Manual restart (including after a power outage).

 
      		 [bookmark: pgfId-822944]Manual restart of the Cisco Security Manager Daemon Manager service.

 
     

 
     [bookmark: pgfId-822946]You can verify whether the AUS is fully operational by verifying the status of its Windows services. To do this, select Start > Control Panel > Administrative Services > Services, then check the status of the CiscoWorks AUS Database Engine service. If this service has started, try again to deploy.

 
    
 
     
      [bookmark: pgfId-822958][bookmark: 29392][bookmark: dpman_cncpt_TroubleshootingtheSetupofConfigurationEngineManagedDevices]Troubleshooting the Setup of Configuration Engine-Managed Devices [bookmark: marker-822952][bookmark: marker-822954][bookmark: marker-822956]

 
     [bookmark: pgfId-822960]The following questions and answers describe issues that might arise when you set up a device managed by a Cisco Configuration Engine (also known as CNS) and how to solve them:

 
     [bookmark: pgfId-822962]Question: Why does Configuration Engine deployment fail?

 
     [bookmark: pgfId-822966]Answer: Not all versions of Configuration Engine function in a compatible manner. Because Security Manager does not verify the software version running on a Configuration Engine when you add it to the device inventory, you can add unsupported versions to the inventory. Then, when you try to deploy, you can run into unpredictable errors. Ensure that you are running a supported version of Configuration Engine (for version information, see the release notes for this version of Security Manager at http://www.cisco.com/en/US/products/ps6498/prod_release_notes_list.html).

 
     [bookmark: pgfId-822968]Question: Why do I receive an InvalidParameterException when I click on an IOS device on the Configuration Engine web page?

 
     [bookmark: pgfId-822970]Answer: This is the expected behavior. For IOS devices, Security Manager uses deployment jobs to deploy configurations to Configuration Engine instead of associating a configuration to the IOS device in Configuration Engine. Therefore, you do not see an associated configuration when you click the device name on the Configuration Engine web page. For ASA/PIX devices, Security Manager associates the configuration to the device in Configuration Engine. Therefore, clicking the device name displays the associated configuration.

 
     [bookmark: pgfId-822972]Question: Why am I getting the following error: com.cisco.netmgmt.ce.websvc.exec.ExecServiceException: [002-01003]]deviceName does not exists?

 
     [bookmark: pgfId-822974]Answer: This error indicates that the device has not been added to Configuration Engine. It appears if you have not performed rollback or deployment in Security Manager (both of which add the device automatically), and have not manually added the device to Configuration Engine.

 
     [bookmark: pgfId-822976]Question: Why am I getting the following error: com.cisco.netmgmt.ce.websvc.config.ConfigServiceException: [002-01003]]Device device id is not connected

 
     [bookmark: pgfId-822978]Answer: The answer depends on the type of setup you are performing:

 
      
      		 [bookmark: pgfId-822980]Event mode setup—Make sure that the Configuration Engine device ID defined in the Device Properties window in Security Manager matches the device ID configured on the router (using the  cns id string command).

 
      		 [bookmark: pgfId-822982]Call home mode setup—The device is not connected to Configuration Engine in this mode; therefore, all Security Manager operations that require the retrieval of the device configuration using Configuration Engine are not supported. This includes discovery, preview configuration, display running configuration, and connectivity tests (and rollback, for IOS devices).

 
     

 
     [bookmark: pgfId-822984]Question: Why is deployment to my Configuration Engine-managed ASA/PIX device not working?

 
     [bookmark: pgfId-822986]Answer: There are several possibilities:

 
      
      		 [bookmark: pgfId-822988]The configuration contains invalid commands. You can test this by copying the configuration associated with the ASA/PIX device in Configuration Engine and pasting it directly into the device.

 
      		 [bookmark: pgfId-822990]The  auto-update server command contains an invalid username and password.

 
      		 [bookmark: pgfId-822992]You did not wait long enough for the configuration to be polled into the ASA/PIX device. Use the  show auto command to verify when the next polling cycle will occur.

 
      		 [bookmark: pgfId-822994]If you previously used the Configuration Engine server for the same ASA/PIX device and did not delete the device from the Configuration Engine server before you started the current task, it is possible that the device received the previous configuration from the server before you deployed the new configuration to it.

 
      		 [bookmark: pgfId-822996]If none of the suggestions above solves the problem, turn on Configuration Engine debug mode on the ASA/PIX device and check the log for errors after the next polling cycle.

 
     

 
     [bookmark: pgfId-822998]Question: Why was I able to deploy successfully to a Configuration Engine-managed ASA/PIX device the first time, but subsequent deployments were unsuccessful?

 
     [bookmark: pgfId-823000]Answer: This can happen if the configuration pushed during the first deployment contains incorrect CLI commands for the auto-update feature. Check the following:

 
      
      		 [bookmark: pgfId-823002]Make sure the username and password of the Configuration Engine server is defined correctly in the  auto-update command.

 
      		 [bookmark: pgfId-823004]If you used  name commands when configuring the auto-update server using the device CLI, make sure that you have defined a FlexConfig that contains the necessary  name commands. A FlexConfig is necessary because Security Manager does not support this command directly. As a result, even though the command was discovered, it does not appear in the full configuration. If you use Security Manager to configure the AUS policy,  name commands are not necessary.

 
     

 
     [bookmark: pgfId-823006]Question: How do I debug Configuration Engine on an ASA/PIX device?

 
     [bookmark: pgfId-823020]Question: How do I debug Configuration Engine on an IOS device?

 
     [bookmark: pgfId-823022]Answer: Enter the following CLI commands:

 
     
      [bookmark: pgfId-823024]debug cns all
     

     
      [bookmark: pgfId-823026]debug kron exec-cli
     

     
      [bookmark: pgfId-823028]terminal monitor
     

     
      [bookmark: pgfId-823030] 
     

     [bookmark: pgfId-823032]When working in event mode, you can also find relevant information in the event log on the Configuration Engine server. When working in call home mode, check the config server log on the Configuration Engine server.

 
     [bookmark: pgfId-823034]Question: Why did I fail to discover an IOS device and acquire its configuration through Configuration Engine?

 
     [bookmark: pgfId-823036]Answer: If you see the following errors in debug mode:

 
     [bookmark: pgfId-823038]*Feb 23 21:42:15.677: CNS exec decode: Unknown hostname cnsServer-lnx.cisco.com ... 474F6860: 72726F72 2D6D6573 73616765 3E584D4C error-message>XML 474F6870: 5F504152 53455F45 52524F52 3C2F6572 _PARSE_ERROR

 
     [bookmark: pgfId-823040]Verify the following:

 
      
      		 [bookmark: pgfId-823042]The CNS commands use a fully-qualified host name (host name and domain name).

 
      		 [bookmark: pgfId-823044]The device contains the  ip domain name command.

 
      		 [bookmark: pgfId-823046]The device contains the  ip host command with the fully qualified hostname of the Configuration Engine with its IP address.

 
     

 
     [bookmark: pgfId-823048]Question: Why does the event mode router not appear on the Configuration Engine Discover Device page or appear in green on the Configuration Engine web page?

 
     [bookmark: pgfId-823050]Answer: Check the following:

 
      
      		 [bookmark: pgfId-823052]Make sure that the router and the Configuration Engine server can ping each other.

 
      		 [bookmark: pgfId-823054]Make sure that the event gateway on the Configuration Engine server is up and running by using one of the following commands:

 
     

 
     [bookmark: pgfId-823056]Status for plain text mode: /etc/init.d/EvtGateway

 
     [bookmark: pgfId-823058]Status for SSL encrypted mode: /etc/init.d/EvtGatewayCrypto

 
      
      		 [bookmark: pgfId-823060]Clear the  cns event command, then re-enter it without specifying a port number.
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     [bookmark: pgfId-18504][bookmark: 72051][bookmark: vpchap_intro_GREandDMVPNs]GRE and DM VPNs[bookmark: marker-18498][bookmark: marker-18500][bookmark: marker-18502]
      
      
 
     
 

 
    [bookmark: pgfId-18506]You can configure Generic Routing Encapsulation (GRE) and Dynamic Multipoint (DM) VPNs that include GRE mode configurations. You can configure IPsec GRE VPNs for hub-and-spoke, point-to-point, and full mesh VPN topologies. DMVPN is available for hub-and-spoke topologies only.

 
    [bookmark: pgfId-18508]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-18513]Understanding the GRE Modes Page

 
     		 [bookmark: pgfId-18518]GRE and Dynamic GRE VPNs

 
     		 [bookmark: pgfId-18523]Dynamic Multipoint VPNs (DMVPN)

 
    

 
   
 
    
     [bookmark: pgfId-18533][bookmark: 72063][bookmark: vpnpage_cncpt_GREModesPage]Understanding the GRE Modes Page[bookmark: marker-18531]

 
    [bookmark: pgfId-18535]Use the GRE Modes page to define the routing and tunnel parameters for IPsec tunneling with GRE, GRE Dynamic IP, and DMVPN policies.

 
    [bookmark: pgfId-18537]The content of the policy differs depending on how you access it:

 
     
     		 [bookmark: pgfId-18542](Site-to-Site VPN Manager Window) When you select a GRE VPN or DMVPN, the GRE Modes policy contains the properties related to the technology and technology type used in the VPN.

 
     		 [bookmark: pgfId-18544](Policy view) When you select  Site-to-Site VPN > GRE Modes , and create a new policy or select an existing policy, there is an additional field in the policy called  GRE Method . From the GRE Method list, you must select the VPN technology and technology type for which you are defining the policy: IPsec/GRE, GRE Dynamic IP, DMVPN, or Large Scale DMVPN. This option controls which fields are displayed in the policy. You cannot change the GRE Method after you save the policy.

 
    

 
    [bookmark: pgfId-18546]When you assign a shared GRE Modes policy to a VPN, the GRE Method and the VPN’s technology and type must match or the policy cannot be selected. For example, you cannot assign a shared DMVPN GRE Modes policy to an IPsec/GRE VPN.

 
    [bookmark: pgfId-18548]The following topics describe the GRE Modes policy in detail based on the selected GRE Methods:

 
     
     		 [bookmark: pgfId-18553]IPsec/GRE or GRE Dynamic IP—See Configuring GRE Modes for GRE or GRE Dynamic IP VPNs.

 
     		 [bookmark: pgfId-18558]DMVPN or Large Scale DMVPN—See Configuring GRE Modes for DMVPN.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-18560]Note When configuring an IPsec/GRE, GRE Dynamic IP, or DMVPN routing policy, Security Manager adds a routing protocol to all the devices in the secured IGP, on deployment. If you want to maintain this secured IGP, you must create a router platform policy (on each member device) using the same routing protocol and autonomous system (or process ID) number as defined in the GRE Modes policy.


    
     

    

    

 
    [bookmark: pgfId-18562]Related Topics

 
     
     		 [bookmark: pgfId-18567]Understanding GRE

 
     		 [bookmark: pgfId-18572]Understanding GRE Configuration for Dynamically Addressed Spokes

 
     		 [bookmark: pgfId-18577]Understanding DMVPN

 
     		 [bookmark: pgfId-18582]Understanding IPsec Technologies and Policies

 
    

 
   
 
    
     [bookmark: pgfId-18592][bookmark: 72106][bookmark: vpchap_intro_GREandDynamicGREVPNs]GRE and Dynamic GRE VPNs[bookmark: marker-18588][bookmark: marker-18590]

 
    [bookmark: pgfId-18594]You can use Generic Routing Encapsulation (GRE) to create VPNs using Cisco IOS security routers and Catalyst 6500/7600 devices in hub-and-spoke, point-to-point, and full mesh VPN topologies.

 
    [bookmark: pgfId-18596]This section contains the following topics:

 
     
     		 [bookmark: pgfId-18601]Understanding GRE

 
     		 [bookmark: pgfId-18606]Configuring IPsec GRE VPNs

 
     		 [bookmark: pgfId-18611]Configuring GRE Modes for GRE or GRE Dynamic IP VPNs

 
    

 
     
      [bookmark: pgfId-18621][bookmark: 72115][bookmark: vpchap_cncpt_UnderstandingGRE]Understanding GRE[bookmark: marker-18617][bookmark: marker-18619]

 
     [bookmark: pgfId-18623]Generic Routing Encapsulation (GRE) is a tunneling protocol that encapsulates a variety of protocol packet types inside IP tunnels, creating a virtual point-to-point connection to devices at remote points over an IP network. With this technology, GRE encapsulates the entire original packet with a standard IP header and GRE header before the IPsec process. Then, IPsec views the GRE packet as an unremarkable IP packet and performs encryption and authentication services, as dictated by the IKE negotiated parameters. Because GRE can carry multicast and broadcast traffic, it is possible to configure a routing protocol for virtual GRE tunnels. The routing protocol detects loss of connectivity and reroutes packets to the backup GRE tunnel, thus providing high resiliency.

 
     [bookmark: pgfId-18625]For VPN resilience, a spoke must be configured with two GRE tunnels, one to the primary hub and the other to the backup hub. Both GRE tunnels are secured with IPsec: each one has its own IKE security association (SA) and a pair of IPsec SAs. An associated routing protocol automates the failover mechanism, transferring to the backup tunnel if virtual link loss is detected.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-18627]Note GRE can be configured on Cisco IOS security routers and Catalyst 6500/7600 devices in hub-and-spoke, point-to-point, and full mesh VPN topologies.


     
      

     

     

 
     [bookmark: pgfId-18629]This section contains the following topics:

 
      
      		 [bookmark: pgfId-18634]Advantages of IPsec Tunneling with GRE

 
      		 [bookmark: pgfId-18639]How Does Security Manager Implement GRE?

 
      		 [bookmark: pgfId-18644]Prerequisites for Successful Configuration of GRE

 
      		 [bookmark: pgfId-18649]Understanding GRE Configuration for Dynamically Addressed Spokes

 
     

 
    
 
     
      [bookmark: pgfId-18659][bookmark: 72126][bookmark: vpchap_cncpt_AdvantagesofIPsecTunnelingwithGRE]Advantages of IPsec Tunneling with GRE[bookmark: marker-18655][bookmark: marker-18657]

 
     [bookmark: pgfId-18661]The main advantages of IPsec tunneling with GRE are the following:

 
      
      		 [bookmark: pgfId-18663]GRE uses a routing protocol by which every IPsec peer knows the status of every other peer at all times.

 
      		 [bookmark: pgfId-18665]GRE provides higher resiliency than IKE keepalive.

 
      		 [bookmark: pgfId-18667]Spoke-to-spoke connectivity is supported when you use GRE.

 
      		 [bookmark: pgfId-18669]GRE supports multicast and broadcast transmissions.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-18671]Note GRE does not support the use of dynamic cryptographic tunnels.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-18681][bookmark: 72146][bookmark: vpchap_cncpt_HowDoesSecurityManagerImplementGRE]How Does Security Manager Implement GRE?[bookmark: marker-18677][bookmark: marker-18679]

 
     [bookmark: pgfId-18683]Security Manager implements an additional Interior Gateway Protocol (IGP) solution for GRE. An IGP refers to a group of devices that receive routing updates from one another by a routing protocol, EIGRP, OSPF, or RIP. Each “routing group” is identified by a logical number. For general routing purposes, the interfaces on the routers in your networks belong to an IGP. Security Manager adds an additional IGP that is dedicated for IPsec and GRE-secured communication. This additional IGP is the secured IGP. The existing IGP (unsecured IGP), is used for routing traffic that does not require encryption.

 
     [bookmark: pgfId-18685]For a GRE tunnel to be established, Security Manager configures a virtual interface on each device. These virtual interfaces are the endpoints of the GRE tunnel. Each virtual interface is unique. The GRE tunnel interface has an IP address (inside tunnel IP address) which is taken from an interface that Security Manager creates. The GRE tunnel points to the source and destination IP addresses of either the physical or loopback interfaces on each device. The GRE virtual interfaces belong to the secured IGP, as do the inside interfaces. Routing updates within the secured IGP are GRE encapsulated and IPsec is applied. A flow whose destination is a secured interface (according to the routing updates of the secured IGP) is directed through the GRE interface where it is GRE encapsulated and then evaluated against the crypto ACL. If it matches the crypto ACL, it is routed through the GRE and VPN tunnels.

 
    
 
     
      [bookmark: pgfId-18695][bookmark: 72157][bookmark: vpchap_cncpt_PrerequisitesforSuccessfulConfigurationofGRE]Prerequisites for Successful Configuration of GRE[bookmark: marker-18691][bookmark: marker-18693]

 
     [bookmark: pgfId-18697]Consider the following prerequisites before using GRE in your network:

 
      
      		 [bookmark: pgfId-18699]You must identify the inside interfaces on your devices—the physical interfaces on the device that connect the device with its internal subnets and networks.

 
      		 [bookmark: pgfId-18701]You must select a routing protocol (known as an IGP) or a static route, whenever you enable GRE.

 
     

 
     [bookmark: pgfId-18703]Security Manager supports the EIGRP, OSPF, and RIPv2 dynamic routing protocols, and GRE static routes.

 
     [bookmark: pgfId-18708] – EIGRP—Enhanced Interior Gateway Routing Protocol enables the exchange of routing information within an autonomous system and addresses some of the more difficult issues associated with routing in large, heterogeneous networks. Compared to other protocols, EIGRP provides superior convergence properties and operating efficiency, and combines the advantages of several different protocols. For more information, see EIGRP Routing on Cisco IOS Routers.

 
     [bookmark: pgfId-18710] – OSPF—Open Shortest Path First is a link-state, hierarchical protocol that features least-cost routing, multipath routing, and load balancing.

 
     [bookmark: pgfId-18715]Using OSPF, a host that obtains a change to a routing table or detects a change in the network immediately multicasts the information to all other hosts in the network, so that all will have the same routing table information. For more information, see OSPF Routing on Cisco IOS Routers.

 
     [bookmark: pgfId-18717] – RIPv2—Routing Information Protocol is a distance-vector protocol that sends routing-update messages at regular intervals and whenever the network topology changes.

 
     [bookmark: pgfId-18719]Using RIPv2, a gateway host (with a router) sends its entire routing table to its closest neighbor host every 30 seconds, which in turn passes the information on to its next neighbor, and so on, until all hosts within the network have the same knowledge of routing paths. RIPv2 uses a hop count to determine network distance. Each host with a router in the network uses the routing table information to determine the next host to route a packet to for a specified destination.

 
     [bookmark: pgfId-18724]RIP is considered an effective solution for small homogeneous networks. For larger, more complicated networks, RIP’s transmission of the entire routing table every 30 seconds may put a heavy amount of extra traffic in the network. For more information, see RIP Routing on Cisco IOS Routers.

 
     [bookmark: pgfId-18729] – Static route—Use a static routing policy to provide a robust, stable IPsec-protected GRE tunnel if there is a fixed, unchanging route between two devices. For each device subnet, a static route is created on the device pointing to the corresponding tunnel interface. For more information, see Static Routing on Cisco IOS Routers.

 
      
      		 [bookmark: pgfId-18731]You must specify an IGP process number. The IGP process number identifies the IGP process to which the inside interface on the device belongs. When GRE is implemented, this will be the secured IGP. For secure communication, the inside interfaces on the devices in your VPN must use the same IGP process. The IGP process number must be within a specified range. If you have an existing IGP process on the device that is within this range, but is different from the IGP process number specified in your GRE settings, Security Manager removes the existing IGP process. If the existing IGP process matches the one specified in your GRE settings, any networks included in the existing IGP process that do not match the specified inside interfaces are removed.

 
      		 [bookmark: pgfId-18733]If the inside interfaces on your devices are configured to use an IGP process other than the IGP process specified in your GRE settings (meaning that the interfaces belong to an unsecured IGP):

 
     

 
     [bookmark: pgfId-18735] – For spokes: Manually remove the inside interfaces from the unsecured IGP through the device CLI before configuring GRE.

 
     [bookmark: pgfId-18737] – For hubs: If the hub inside interface is used as a network access point for Security Manager, then on deployment, the interface is advertised in both secured and unsecured IGPs. To ensure that the spoke peers use only the secured IGP, manually add the auto-summary command for the unsecured IGP or remove the unsecured IGP for that inside interface.

 
      
      		 [bookmark: pgfId-18739]You must provide a subnet that is unique yet it can be non-globally-routable for loopback. This subnet must only be used to support the implementation of loopback for GRE. The loopback interfaces are created, maintained, and used only by Security Manager. You should not use them for any other purpose.

 
      		 [bookmark: pgfId-18741]If you are using static routes, not unsecured IGP, make sure you configure static routes on the spokes through to the hub inside interfaces.
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     [bookmark: pgfId-18743]Note You can configure the above settings in the GRE Modes page when IPsec/GRE is the selected IPsec technology.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-18753][bookmark: 72203][bookmark: vpchap_cncpt_UnderstandingGREConfigurationforDynamicallyAddressedSpokes]Understanding GRE Configuration for Dynamically Addressed Spokes [bookmark: marker-18749][bookmark: marker-18751]

 
     [bookmark: pgfId-18755]When a spoke has a dynamic IP address, there is no fixed GRE tunnel source address (to be used by the GRE tunnel on the spoke side) or destination address (to be used by the GRE tunnel on the hub side). Therefore, Security Manager creates additional loopback interfaces on the hub and the spoke, to be used as the GRE tunnel endpoints. You must specify a subnet from which Security Manager can allocate an IP address for the loopback interfaces.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-18757]Note GRE Dynamic IP can only be configured on Cisco IOS routers and Catalyst 6500/7600 devices in hub-and-spoke VPN topologies.


     
      

     

     

 
     [bookmark: pgfId-18759]Security Manager uses the Cisco Configuration Engine to retrieve device IP addresses and other information from dynamically addressed devices. Devices that have dynamic IP addresses connect to the Configuration Engine manager at periodic intervals to upgrade device configuration files and to pass device and status information.

 
     [bookmark: pgfId-18764]For more information, see Adding, Editing, or Deleting Auto Update Servers or Configuration Engines.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-18766]Note You can configure the GRE Dynamic IP settings in the GRE Modes page when GRE Dynamic IP is the selected IPsec technology.


     
      

     

     

 
     [bookmark: pgfId-18768]Related Topics

 
      
      		 [bookmark: pgfId-18773]Understanding GRE

 
      		 [bookmark: pgfId-18778]Configuring GRE Modes for GRE or GRE Dynamic IP VPNs

 
     

 
    
 
     
      [bookmark: pgfId-18788][bookmark: 72228][bookmark: vpchap_proc_ConfiguringIPsecGREVPNs]Configuring IPsec GRE VPNs[bookmark: marker-18784][bookmark: marker-18786]

 
     [bookmark: pgfId-18796]To configure an IPsec GRE (generic routing encapsulation) VPN, use the Create VPN wizard as described in Creating or Editing VPN Topologies. You can also edit the membership of the VPN, or some of its policies, using the described procedures. If you are creating a hub-and-spoke VPN with dynamically addressed spokes, also see Understanding GRE Configuration for Dynamically Addressed Spokes.

 
     [bookmark: pgfId-18798]If you need to make changes to other policies and settings, open the policies from the Site-to-Site Manager page, as follows:

 
      
      		 [bookmark: pgfId-18803]For ISAKMP and IPSec settings, select  VPN Global Settings . See Configuring VPN Global Settings.

 
      		 [bookmark: pgfId-18808]For IKE proposal policies, select  IKE Proposal . See Configuring an IKE Proposal.

 
      		 [bookmark: pgfId-18813]For IPSec proposals, select  IPsec Proposal . See Configuring IPsec Proposals in Site-to-Site VPNs.

 
      		 [bookmark: pgfId-18818]For preshared key policies, select  IKEv1 Preshared Key . See Configuring IKEv1 Preshared Key Policies.

 
      		 [bookmark: pgfId-18823]For public key (PKI) policies, select  Public Key Infrastructure . See Configuring IKEv1 Public Key Infrastructure Policies in Site-to-Site VPNs.

 
      		 [bookmark: pgfId-18828]For Generic Routing Encapsulation configuration, select  GRE Modes . See Configuring GRE Modes for DMVPN.

 
     

 
     [bookmark: pgfId-18830]Related Topics

 
      
      		 [bookmark: pgfId-18835]Understanding IKE

 
      		 [bookmark: pgfId-18840]Understanding GRE

 
      		 [bookmark: pgfId-18845]Prerequisites for Successful Configuration of GRE

 
      		 [bookmark: pgfId-18850]Advantages of IPsec Tunneling with GRE

 
     

 
    
 
     
      [bookmark: pgfId-18862][bookmark: 72281][bookmark: vpnpage_cncpt_GREModesPageGREorGREDynamicIPPolicy]Configuring GRE Modes for GRE or GRE Dynamic IP VPNs[bookmark: marker-18856][bookmark: marker-18858][bookmark: marker-18860]

 
     [bookmark: pgfId-18864]Use the GRE Modes policy to define the routing and tunnel parameters for IPsec tunneling in a GRE or GRE Dynamic IP VPN.

 
     [bookmark: pgfId-18866]To open the GRE Modes policy:

 
      
      		 [bookmark: pgfId-18871](Site-to-Site VPN Manager Window) Select an IPsec/GRE or GRE Dynamic IP topology, then select  GRE Modes from the policies list.

 
      		 [bookmark: pgfId-18873](Policy view) Select  Site-to-Site VPN > GRE Modes , and create a new policy or select an existing policy. Then, select either IPsec/GRE or Dynamic GRE from the  GRE Method list.

 
     

 
     [bookmark: pgfId-18875]The following table describes the elements on the GRE Modes page for configuring IPsec tunneling with GRE or GRE Dynamic IP.
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     [bookmark: pgfId-18877]Note When configuring a GRE routing policy, Security Manager adds a routing protocol to all the devices in the secured IGP, on deployment. If you want to maintain this secured IGP, you must create a router platform policy (on each member device) using the same routing protocol and autonomous system (or process ID) number as defined in the GRE Modes policy.


     
      

     

     

 
     [bookmark: pgfId-18880] 

 
      
       
        
        [bookmark: pgfId-17264]Table 27-1 [bookmark: 72306]GRE Modes Page for GRE or GRE Dynamic IP VPNs 

 
        
       
         
         		
           
           [bookmark: pgfId-17270]Element
          
  
         		
           
           [bookmark: pgfId-17272]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-17278]Routing Parameters Tab
          
  
        

 
         
         		[bookmark: pgfId-17286]Routing Protocol

  
         		[bookmark: pgfId-17288]Select the required dynamic routing protocol (EIGRP, OSPF, or RIPv2,) or static route to be used for GRE or GRE Dynamic IP.

 [bookmark: pgfId-17290]The default routing protocol is EIGRP.

 [bookmark: pgfId-17295]For more information about configuring these protocols, see Prerequisites for Successful Configuration of GRE.

  
        

 
         
         		[bookmark: pgfId-17301]AS Number

 [bookmark: pgfId-17303](EIGRP only.)

  
         		[bookmark: pgfId-17305]The number that is used to identify the autonomous system (AS) area to which the EIGRP packet belongs. The range is 1-65535. The default is 110.

 [bookmark: pgfId-17307]An autonomous system (AS) is a collection of networks that share a common routing strategy. An AS can be divided into a number of areas, which are groups of contiguous networks and attached hosts. Routers with multiple interfaces can participate in multiple areas. An AS ID identifies the area to which the packet belongs. All EIGRP packets are associated with a single area, so all devices must have the same AS number.

  
        

 
         
         		[bookmark: pgfId-17313]Hello Interval

 [bookmark: pgfId-17315](EIGRP only.)

  
         		[bookmark: pgfId-17317]The interval between hello packets sent on the interface, between 1 and 65535 seconds. The default is 5 seconds.

  
        

 
         
         		[bookmark: pgfId-17323]Hold Time

 [bookmark: pgfId-17325](EIGRP only.)

  
         		[bookmark: pgfId-17327]The number of seconds the router will wait to receive a hello message before invalidating the connection. The range is between 1 and 65535. The default hold time is 15 seconds (three times the hello interval).

  
        

 
         
         		[bookmark: pgfId-17333]Delay

 [bookmark: pgfId-17335](EIGRP only.)

  
         		[bookmark: pgfId-17337]The throughput delay for the primary route interface, in microseconds. The range of the tunnel delay time is 1-16777215. The default is 1000.

  
        

 
         
         		[bookmark: pgfId-17343]Failover Delay

 [bookmark: pgfId-17345](EIGRP only.)

  
         		[bookmark: pgfId-17347]The throughput delay for the failover route interface, in microseconds. The range of the tunnel delay time is 1-16777215. The default is 1500.

  
        

 
         
         		[bookmark: pgfId-17353]Bandwidth

 [bookmark: pgfId-17355](EIGRP only.)

  
         		[bookmark: pgfId-17357]The amount of bandwidth available to the primary route interface for the EIGRP packets. You should enter a value that gives priority to the primary route over other routes.

 [bookmark: pgfId-17359]You can enter a value in the range 1 to 10000000 kb. The default is 1000 kb.

 [bookmark: pgfId-17361]Note By default, the cost of sending a packet on an interface is calculated based on the bandwidth—the higher the bandwidth, the lower the cost.

  
        

 
         
         		[bookmark: pgfId-17367]Failover Bandwidth

 [bookmark: pgfId-17369](EIGRP only.)

  
         		[bookmark: pgfId-17371]The amount of bandwidth available to the failover route interface for the EIGRP packets.

 [bookmark: pgfId-17373]Enter a value in the range 1 to 10000000 kb. The default is 1000 kb.

  
        

 
         
         		[bookmark: pgfId-17379]Process Number

 [bookmark: pgfId-17381](OSPF only.)

  
         		[bookmark: pgfId-17383]The routing process ID number that will be used to identify the secured IGP that Security Manager adds when configuring GRE.

 [bookmark: pgfId-17385]The range is between 1 and 65535. The default is 110.

 [bookmark: pgfId-17387]Security Manager adds an additional Interior Gateway Protocol (IGP) that is dedicated for IPsec and GRE secured communication. An IGP refers to a group of devices that receive routing updates from one another by means of a routing protocol. Each “routing group” is identified by the process number.

 [bookmark: pgfId-17392]For more information, see Understanding GRE.

  
        

 
         
         		[bookmark: pgfId-17398]Hub Network Area ID

 [bookmark: pgfId-17400](OSPF only.)

  
         		[bookmark: pgfId-17402]The ID number of the area in which the hub’s protected networks will be advertised, including the tunnel subnet. You can specify any number. The default is 0.

  
        

 
         
         		[bookmark: pgfId-17408]Spoke Protected Network Area ID

 [bookmark: pgfId-17410](OSPF only.)

  
         		[bookmark: pgfId-17412]The ID number of the area in which the remote protected networks will be advertised, including the tunnel subnet. You can specify any number. The default is 1.

  
        

 
         
         		[bookmark: pgfId-17418]Authentication

 [bookmark: pgfId-17420](OSPF or RIPv2 only.)

  
         		[bookmark: pgfId-17422]A string that specifies the OSPF or RIPv2 authentication key. The string can be up to eight characters long.

  
        

 
         
         		[bookmark: pgfId-17428]Cost

 [bookmark: pgfId-17430](OSPF or RIPv2 only.)

  
         		[bookmark: pgfId-17432]The cost of sending a packet on the primary route interface.

 [bookmark: pgfId-17434]If the selected protocol is OSPF, enter a value in the range 1-65535; the default is 100.

 [bookmark: pgfId-17436]If the selected protocol is RIPv2, enter a value in the range 1-15; the default is 1.

  
        

 
         
         		[bookmark: pgfId-17442]Failover Cost

 [bookmark: pgfId-17444](OSPF or RIPv2 only.)

  
         		[bookmark: pgfId-17446]The cost of sending a packet on the secondary (failover) route interface.

 [bookmark: pgfId-17448]You can enter a value in the range 1-65535 for OSPF (the default is 125), or in the range 1-15 for RIPv2 (the default is 2).

  
        

 
         
         		[bookmark: pgfId-17454]Filter Dynamic Updates on Spokes

  
         		[bookmark: pgfId-17456]When selected, enables the creation of a redistribution list that filters all dynamic routing updates on the spokes. This forces the spoke devices to advertise (populate on the hub device) only their own protected subnets and not other IP addresses.

  
        

 
         
         		 
           
           [bookmark: pgfId-17462]Tunnel Parameters Tab
          
  
        

 
         
         		[bookmark: pgfId-17470]Tunnel IP

  
         		[bookmark: pgfId-17472]Select the required option to specify the GRE or GRE Dynamic IP tunnel interface IP address.

 
           
           		 [bookmark: pgfId-17474] Use Physical Interface —When selected, uses the private IP address of the tunnel taken from the protected network.

 
           		 [bookmark: pgfId-17476] Use Subnet —When selected, uses the tunnel IP address taken from an IP range. This is the default.

 
          

 [bookmark: pgfId-17478]In the Subnet field, enter the private IP address including the unique subnet mask (default is 1.1.1.0/24).

 [bookmark: pgfId-17480]If you are also configuring a dial backup interface, enter its subnet in the Dial Backup Subnet field provided (default is 1.1.2.0/24).

 [bookmark: pgfId-17482]Note In most cases, when you use a subnet to specify a GRE tunnel interface IP address, Security Manager creates a loopback interface on the device which is used for the tunnel IP address. If the device belongs to a VPN topology whose configurations were discovered by Security Manager, and you configure an IP address directly on the device’s GRE tunnel, Security Manager keeps that configuration and does not create a loopback interface on the device. However, a loopback is always configured on a hub in a VPN topology; in a hub-and-spoke VPN topology with multiple hubs, a loopback interface is also configured on the spokes.

 
           
           		 [bookmark: pgfId-17484] Use Loopback Interface —When selected, uses the tunnel IP address taken from an existing loopback interface. In the Role field, enter the name of the interface role object that defines the loopback interface name, or click  Select to select it from a list or to create a new object.

 
          

 [bookmark: pgfId-17486]Note To view the new GRE tunnel or loopback interfaces in the Router Interfaces page, you must rediscover the device inventory details after successfully deploying the VPN to the device.

  
        

 
         
         		[bookmark: pgfId-17492]Configure Unique Tunnel Source for each Tunnel

  
         		[bookmark: pgfId-17494]When enabled, each GRE tunnel interface in the VPN is assigned a unique tunnel source. In the Tunnel Source IP Range field, enter a subnet IP to be used as tunnel sources.

 [bookmark: pgfId-17499]Note When enabled, this feature is set for all GRE tunnel interfaces in the VPN. If you want to assign a specific tunnel source for an interface, use the Peers policy to configure the endpoints for the desired devices; see Defining the Endpoints and Protected Networks.

  
        

 
         
         		[bookmark: pgfId-17505]Tunnel Source IP Range

 [bookmark: pgfId-17507](GRE Dynamic IP only.)

  
         		[bookmark: pgfId-17509]The private IP address including the unique subnet mask that supports the loopback for GRE. The GRE tunnel interface has an IP address (inside tunnel IP address) which is taken from a loopback interface that Security Manager creates specifically for this purpose.

 [bookmark: pgfId-17511]When a spoke has a dynamic IP address, there is no fixed GRE tunnel source address (to be used by the GRE tunnel on the spoke side) or destination address (to be used by the GRE tunnel on the hub side). Therefore, Security Manager creates additional loopback interfaces on the hub and the spoke to use as the GRE tunnel endpoints. You must specify a subnet from which Security Manager can allocate an IP address for the loopback interfaces.

  
        

 
         
         		[bookmark: pgfId-17517]Enable IP Multicast

  
         		[bookmark: pgfId-17519]When selected, enables multicast transmissions across your GRE tunnels. IP multicast delivers application source traffic to multiple receivers without burdening the source or the receivers, while using a minimum of network bandwidth.

  
        

 
         
         		[bookmark: pgfId-17525]Rendezvous Point

  
         		[bookmark: pgfId-17527]Only available if you selected the Enable IP Multicast check box.

 [bookmark: pgfId-17529]If required, you can enter the IP address of the interface that will serve as the rendezvous point (RP) for multicast transmission. Sources send their traffic to the RP. This traffic is then forwarded to receivers down a shared distribution tree.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-18888][bookmark: 72476][bookmark: vpchap_intro_DynamicMultipointVPNsDMVPN]Dynamic Multipoint VPNs (DMVPN)[bookmark: marker-18886]

 
    [bookmark: pgfId-18890]Dynamic Multipoint VPN (DMVPN) is a hub-and-spoke VPN technology that enables better scaling of large and small IPsec VPNs by combining generic routing encapsulation (GRE) tunnels, IP Security (IPsec) encryption, and Next Hop Resolution Protocol (NHRP) routing.

 
    [bookmark: pgfId-18892]This section contains the following topics:

 
     
     		 [bookmark: pgfId-18897]Understanding DMVPN

 
     		 [bookmark: pgfId-18902]Configuring DMVPN

 
     		 [bookmark: pgfId-18907]Configuring GRE Modes for DMVPN

 
     		 [bookmark: pgfId-18912]Configuring Large Scale DMVPNs

 
     		 [bookmark: pgfId-18917]Configuring Server Load Balancing in Large Scale DMVPN

 
    

 
     
      [bookmark: pgfId-18925][bookmark: 72482][bookmark: vpchap_cncpt_UnderstandingDMVPN]Understanding DMVPN[bookmark: marker-18923]

 
     [bookmark: pgfId-18930]Dynamic Multipoint VPN (DMVPN) enables better scaling of large and small IPsec VPNs by combining generic routing encapsulation (GRE) tunnels, IP Security (IPsec) encryption, and Next Hop Resolution Protocol (NHRP) routing. (For information about large scale DMVPNs, see Configuring Large Scale DMVPNs.)

 
     [bookmark: pgfId-18932]Security Manager supports DMVPN using the EIGRP, OSPF, and RIPv2 dynamic routing protocols, and GRE static routes. In addition, On-Demand Routing (ODR) is supported. ODR is not a routing protocol. It may be used in a hub-and-spoke VPN topology when the spoke routers do not connect to any router other than the hub. If you are running dynamic protocols, ODR is not suitable for your network environment.

 
     [bookmark: pgfId-18937]You can use DMVPN on a hub-and-spoke VPN topology only with devices running Cisco IOS Software release 12.3T devices and later, or ASRs running Cisco IOS XE Software 2.x or later (known as 12.2(33)XNA+ in Security Manager). DMVPN is not supported on Catalyst VPN Services Module devices or on High Availability (HA) groups. If your device does not support DMVPN, use GRE dynamic IP to configure GRE for dynamically addressed spokes. See Understanding GRE Configuration for Dynamically Addressed Spokes.

 
     [bookmark: pgfId-18939]The following topics provide more overview information on DMVPN:

 
      
      		 [bookmark: pgfId-18944]Enabling Spoke-to-Spoke Connections in DMVPN Topologies

 
      		 [bookmark: pgfId-18949]Advantages of DMVPN with GRE

 
     

 
     [bookmark: pgfId-18951]The following documents on Cisco.com explain DMVPN in further detail:

 
      
      		 [bookmark: pgfId-18955]   Cisco Dynamic Multipoint VPN: Simple and Secure Branch-to-Branch Communications —Explains DMVPN technology and where and why you would use it. This data sheet explains the technologies used with DMVPN and the benefits derived from those technologies.

 
      		 [bookmark: pgfId-18959]   Migrating from Dynamic Multipoint VPN Phase 2 to Phase 3 —Explains the difference between phase 2 and phase 3 spoke-to-spoke connections. Creating spoke-to-spoke connections is a configuration option with DMVPN. Phase 3 uses shortcut switching enhancements to increase network performance and scalability.

 
      		 [bookmark: pgfId-18963]Additional white papers and presentations are available at  http://www.cisco.com/en/US/products/ps6658/prod_literature.html .

 
     

 
    
 
     
      [bookmark: pgfId-18973][bookmark: 72513][bookmark: vpchap_cncpt_EnablingSpoketoSpokeConnectionsinDMVPNTopologies]Enabling Spoke-to-Spoke Connections in DMVPN Topologies[bookmark: marker-18969][bookmark: marker-18971]

 
     [bookmark: pgfId-18975]You can use DMVPN to essentially create a full-mesh VPN, in which traditional hub-and-spoke connectivity is supplemented by dynamically-created IPsec tunnels directly between the spokes. With direct spoke-to-spoke tunnels, traffic between remote sites does not need to traverse the hub; this eliminates additional delays and conserves WAN bandwidth. Spoke-to-spoke capability is supported in a single-hub or multihub environment. Multihub deployments provide increased spoke-to-spoke resiliency and redundancy.

 
     [bookmark: pgfId-18977]You can use the 80:20 traffic rule to determine whether to use a pure hub-and-spoke topology or to allow direct spoke-to-spoke connections:

 
      
      		 [bookmark: pgfId-18979]If 80 percent or more of the traffic from the spokes are directed into the hub network itself, deploy the hub-and-spoke model.

 
      		 [bookmark: pgfId-18981]If more than 20 percent of the traffic is meant for other spokes, consider the spoke-to-spoke model.

 
     

 
     [bookmark: pgfId-18983]For networks with a high volume of IP Multicast traffic, the hub-and-spoke model is usually preferred.

 
     [bookmark: pgfId-18985]When you configure the GRE Modes policy for a DMVPN, you can elect to allow spokes to create these direct connections. You must select the DMVPN phase to use for these connections:

 
      
      		 [bookmark: pgfId-18987] Phase 2 —Spoke to spoke connections go through regional hubs and routing protocol updates from hubs to spokes are not summarized.

 
      		 [bookmark: pgfId-18989] Phase 3 (Default)—Spokes can create direct connections with each other and routing updates from hubs to spokes are summarized. This option allows the greatest scalability and reduces latency. Devices must run IOS Software release 12.4(6)T or higher; ASRs must run IOS XE Software release 2.4 (called 12.2(33)XND) or higher. Security Manager automatically creates a phase 2 configuration for devices running a lower OS version.

 
     

 
     [bookmark: pgfId-18994]For more information on configuring the GRE Modes policy, see Configuring GRE Modes for DMVPN.

 
     [bookmark: pgfId-18996]Related Topics

 
      
      		 [bookmark: pgfId-19001]Understanding DMVPN

 
      		 [bookmark: pgfId-19005]   Cisco Dynamic Multipoint VPN: Simple and Secure Branch-to-Branch Communications 

 
      		 [bookmark: pgfId-19009]   Migrating from Dynamic Multipoint VPN Phase 2 to Phase 3 

 
     

 
    
 
     
      [bookmark: pgfId-19019][bookmark: 72553][bookmark: vpchap_cncpt_AdvantagesofDMVPN]Advantages of DMVPN with GRE[bookmark: marker-19015][bookmark: marker-19017]

 
     [bookmark: pgfId-19021]Using DMVPN with GRE provides the following advantages:

 
      
      		 [bookmark: pgfId-19023] Simplified GRE configuration on the hub 

 
     

 
     [bookmark: pgfId-19025]With GRE, a tunnel is configured on the hub for each connected spoke. With GRE + DMVPN, only one tunnel is configured for all the connected spokes.

 
      
      		 [bookmark: pgfId-19027] Support for dynamically addressed spokes 

 
     

 
     [bookmark: pgfId-19029]When using GRE, the physical interface IP address of the spoke routers must be configured as the GRE tunnel destination address, when configuring the hub router. DMVPN enables spoke routers to have dynamic external interface IP addresses, and provides robust configuration that does not have to be redeployed to the device even if the external interface IP address changes. When the spoke comes online, it sends to the hub registration packets that contain the physical interface IP address of the spoke.

 
      
      		 [bookmark: pgfId-19031] Dynamic tunnel creation for direct spoke-to-spoke communication 

 
     

 
     [bookmark: pgfId-19033]NHRP enables spoke routers to dynamically learn the external interface IP address of the routers in the VPN network. Using NHRP, the hub maintains an NHRP database of the public interface addresses of all the spokes (the clients). Each spoke registers its real address with the hub when it boots.

 
     [bookmark: pgfId-19035]When a spoke wants to transmit a packet to another spoke, it can use NHRP to dynamically determine the required destination address of the destination spoke. The hub acts as the NHRP server, handling the request for the source spoke. This enables the dynamic creation of an IPsec+GRE tunnel directly between spoke routers, without having to go through a hub router, thus reducing the delay of multiple encryption and decryption actions on the hub.

 
    
 
     
      [bookmark: pgfId-19043][bookmark: 72578][bookmark: vpchap_proc_ConfiguringDMVPN]Configuring DMVPN[bookmark: marker-19041]

 
     [bookmark: pgfId-19051]To configure a hub-and-spoke Dynamic Multipoint VPN, use the Create VPN wizard as described in Creating or Editing VPN Topologies. You can also edit the membership of the VPN, or some of its policies, using the described procedures. If you are creating a Large Scale DMVPN, also see Configuring Large Scale DMVPNs.

 
     [bookmark: pgfId-19053]If you need to make changes to other policies and settings, open the policies from the Site-to-Site Manager page, as follows:

 
      
      		 [bookmark: pgfId-19058]For ISAKMP and IPSec settings, select  VPN Global Settings . See Configuring VPN Global Settings.

 
      		 [bookmark: pgfId-19063]For IKE proposal policies, select  IKE Proposal . See Configuring an IKE Proposal.

 
      		 [bookmark: pgfId-19068]For IPSec proposals, select  IPsec Proposal . See Configuring IPsec Proposals in Site-to-Site VPNs.

 
      		 [bookmark: pgfId-19073]For preshared key policies, select  IKEv1 Preshared Key . See Configuring IKEv1 Preshared Key Policies.

 
      		 [bookmark: pgfId-19078]For public key (PKI) policies, select  Public Key Infrastructure . See Configuring IKEv1 Public Key Infrastructure Policies in Site-to-Site VPNs.

 
      		 [bookmark: pgfId-19083]For Generic Routing Encapsulation configuration, including the selection of phase 2 or 3 connections between spokes, select  GRE Modes . See Configuring GRE Modes for DMVPN.

 
      		 [bookmark: pgfId-19088]For server load balancing policies that are used with Large Scale DMVPN, select  Server Load Balance . See Configuring Server Load Balancing in Large Scale DMVPN.

 
     

 
     [bookmark: pgfId-19090]Related Topics

 
      
      		 [bookmark: pgfId-19095]Understanding IKE

 
      		 [bookmark: pgfId-19100]Understanding DMVPN

 
      		 [bookmark: pgfId-19105]Enabling Spoke-to-Spoke Connections in DMVPN Topologies

 
      		 [bookmark: pgfId-19110]Advantages of DMVPN with GRE

 
     

 
    
 
     
      [bookmark: pgfId-19120][bookmark: 72632][bookmark: vpnpage_cncpt_GREModesPageDMVPNPolicy]Configuring GRE Modes for DMVPN[bookmark: marker-19116][bookmark: marker-19118]

 
     [bookmark: pgfId-19122]Use the GRE Modes policy to define the routing and tunnel parameters for IPsec tunneling in a DMVPN.

 
     [bookmark: pgfId-19124]To open the GRE Modes policy:

 
      
      		 [bookmark: pgfId-19129](Site-to-Site VPN Manager Window) Select a DMVPN or Large Scale DMVPN topology, then select  GRE Modes from the policies list.

 
      		 [bookmark: pgfId-19131](Policy view) Select  Site-to-Site VPN > GRE Modes , and create a new policy or select an existing policy. Then, select either DMVPN or Large Scale DMVPN from the  GRE Method list.

 
     

 
     [bookmark: pgfId-19133]The following table describes the elements on the GRE Modes page for configuring a DMVPN.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-19135]Note When configuring a DMVPN routing policy, Security Manager adds a routing protocol to all the devices in the secured IGP, on deployment. If you want to maintain this secured IGP, you must create a router platform policy (on each member device) using the same routing protocol and autonomous system (or process ID) number as defined in the GRE Modes policy.


     
      

     

     

 
     [bookmark: pgfId-19138] 

 
      
       
        
        [bookmark: pgfId-17542]Table 27-2 [bookmark: 72654]GRE Modes Page for DMVPN 

 
        
       
         
         		
           
           [bookmark: pgfId-17548]Element
          
  
         		
           
           [bookmark: pgfId-17550]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-17556]Routing Parameters Tab
          
  
        

 
         
         		[bookmark: pgfId-17564]Routing Protocol

  
         		[bookmark: pgfId-17566]Select the required dynamic routing protocol, or static route, to be used in the DMVPN tunnel.

 [bookmark: pgfId-17568]Options include the EIGRP, OSPF, and RIPv2 dynamic routing protocols, and GRE static routes. On-Demand Routing (ODR) is also supported. On-Demand Routing is not a routing protocol. It can be used in a hub-and-spoke VPN topology when the spoke routers connect to no other router other than the hub. If you are running dynamic protocols, On-Demand Routing is not suitable for your network environment.

 [bookmark: pgfId-17573]For more information, see Understanding GRE.

  
        

 
         
         		[bookmark: pgfId-17579]AS Number

 [bookmark: pgfId-17581](EIGRP only.)

  
         		[bookmark: pgfId-17583]The number that is used to identify the autonomous system (AS) area to which the EIGRP packet belongs. The range is 1-65535. The default is 110.

 [bookmark: pgfId-17585]An autonomous system (AS) is a collection of networks that share a common routing strategy. An AS can be divided into a number of areas, which are groups of contiguous networks and attached hosts. Routers with multiple interfaces can participate in multiple areas. An AS ID identifies the area to which the packet belongs. All EIGRP packets are associated with a single area, so all devices must have the same AS number.

  
        

 
         
         		[bookmark: pgfId-17591]Hello Interval

 [bookmark: pgfId-17593](EIGRP only.)

  
         		[bookmark: pgfId-17595]The interval between hello packets sent on the interface, from 1 to 65535 seconds. The default is 5 seconds.

  
        

 
         
         		[bookmark: pgfId-17601]Hold Time

 [bookmark: pgfId-17603](EIGRP only.)

  
         		[bookmark: pgfId-17605]The number of seconds the router will wait to receive a hello message before invalidating the connection. The range is 1-65535. The default hold time is 15 seconds (three times the hello interval)

  
        

 
         
         		[bookmark: pgfId-17611]Delay

 [bookmark: pgfId-17613](EIGRP only.)

  
         		[bookmark: pgfId-17615]The throughput delay for the primary route interface, in microseconds. The range of the tunnel delay time is 1-16777215. The default is 1000.

  
        

 
         
         		[bookmark: pgfId-17621]Bandwidth

 [bookmark: pgfId-17623](EIGRP only.)

  
         		[bookmark: pgfId-17625]The bandwidth for the primary route interface, in kilobits. The range of bandwidth is 1 to 10000000. The default is 1000.

  
        

 
         
         		[bookmark: pgfId-17631]Bandwidth

 [bookmark: pgfId-17633](EIGRP only.)

  
         		[bookmark: pgfId-17635]The amount of bandwidth available to the primary route interface for the EIGRP packets. You should enter a value that gives priority to the primary route over other routes.

 [bookmark: pgfId-17637]You can enter a value in the range 1 to 10000000 kb. The default is 1000 kb.

 [bookmark: pgfId-17639]Note By default, the cost of sending a packet on an interface is calculated based on the bandwidth—the higher the bandwidth, the lower the cost.

  
        

 
         
         		[bookmark: pgfId-17645]Process Number

 [bookmark: pgfId-17647](OSPF only.)

  
         		[bookmark: pgfId-17649]The routing process ID number that will be used to identify the secured IGP that Security Manager adds when configuring DMVPN.

 [bookmark: pgfId-17651]The valid range for either protocol is 1-65535. The default is 110.

  
        

 
         
         		[bookmark: pgfId-17657]Hub Network Area ID

 [bookmark: pgfId-17659](OSPF only.)

  
         		[bookmark: pgfId-17661]The ID number of the area in which the hub’s protected networks will be advertised, including the tunnel subnet. You can enter any number. The default is 0.

  
        

 
         
         		[bookmark: pgfId-17667]Spoke Protected Network Area ID

 [bookmark: pgfId-17669](OSPF only.)

  
         		[bookmark: pgfId-17671]The ID number of the area in which the remote protected networks will be advertised, including the tunnel subnet. You can enter any number. The default is 1.

  
        

 
         
         		[bookmark: pgfId-17677]Authentication Key

 [bookmark: pgfId-17679](OSPF and RIPv2.)

  
         		[bookmark: pgfId-17681]A string that indicates the OSPF or RIPv2 authentication key. The string can be up to eight characters long.

  
        

 
         
         		[bookmark: pgfId-17687]Cost

 [bookmark: pgfId-17689](OSPF and RIPv2.)

  
         		[bookmark: pgfId-17691]The cost of sending a packet on the primary route interface.

 [bookmark: pgfId-17693]If the selected protocol is OSPF, enter a value in the range 1-65535; the default is 100.

 [bookmark: pgfId-17695]If the selected protocol is RIPv2, enter a value in the range 1-15; the default is 1.

  
        

 
         
         		[bookmark: pgfId-17701]Allow Direct Spoke to Spoke Connectivity

  
         		[bookmark: pgfId-17703]Whether to enable direct communication between spokes without going through the hub. Select the DMVPN phase you want to use, which determines the types of connections that spokes can make:

 
           
           		 [bookmark: pgfId-17705] Phase 2 —Spoke to spoke connections go through regional hubs and routing protocol updates from hubs to spokes are not summarized.

 
           		 [bookmark: pgfId-17707] Phase 3 (Default)—Spokes can create direct connections with each other and routing updates from hubs to spokes are summarized. This option allows the greatest scalability and reduces latency. Devices must run IOS Software release 12.4(6)T or higher; ASRs must run IOS XE Software release 2.4 (called 12.2(33)XND) or higher. Security Manager automatically creates a phase 2 configuration for devices running a lower OS version.

 
          

 [bookmark: pgfId-17711]For detailed information on how phase 2 and 3 differ, see “Migrating from Dynamic Multipoint VPN Phase 2 to Phase 3” on Cisco.com.

 [bookmark: pgfId-17716]Note With direct spoke-to-spoke communication, you must use the Main Mode Address option for preshared key negotiation. For more information, see Understanding IKEv1 Preshared Key Policies in Site-to-Site VPNs.

  
        

 
         
         		[bookmark: pgfId-17722]Filter Dynamic Updates On Spokes

  
         		[bookmark: pgfId-17724]Unavailable if you are using On-Demand Routing or a static route for your DMVPN tunnel.

 [bookmark: pgfId-17726]When selected, enables the creation of a redistribution list that filters all dynamic routing updates (EIGRP, OSPF, and RIPv2) on spokes. This forces the spoke devices to advertise (populate on the hub device) only their own protected subnets and not other IP addresses.

  
        

 
         
         		 
           
           [bookmark: pgfId-17732]Tunnel Parameters Tab
          
  
        

 
         
         		[bookmark: pgfId-17740]Tunnel IP Range

  
         		[bookmark: pgfId-17742]The IP address range of the inside tunnel interface IP address, including the unique subnet mask. This field defines a subnet, such as 10.1.1.0/24.

 [bookmark: pgfId-17744]Note If Security Manager detects that a tunnel interface IP address already exists on the device, and its IP address matches the tunnel’s IP subnet field, it will use that interface as the GRE tunnel.

  
        

 
         
         		[bookmark: pgfId-17750]Dial Backup Tunnel IP Range

  
         		[bookmark: pgfId-17752]If you are configuring a dial backup interface, enter its inside tunnel interface IP address range, including the unique subnet mask. This field defines a subnet.

  
        

 
         
         		[bookmark: pgfId-17758]Server Load Balance

  
         		[bookmark: pgfId-17760]When selected, enables the configuration of load balancing on a Cisco IOS router that serves as a hub in a multiple hubs configuration.

 [bookmark: pgfId-17762]Server load balancing optimizes performance in a multiple hubs configuration, by sharing the workload. In this configuration, the DMVPN server hubs share the same tunnel IP and source IP addresses, presenting the appearance of a single device to the spokes in a VPN topology.

  
        

 
         
         		[bookmark: pgfId-17768]Enable IP Multicast

  
         		[bookmark: pgfId-17770]When selected, enables multicast transmissions across your GRE tunnels.

 [bookmark: pgfId-17772]IP multicast delivers application source traffic to multiple receivers without burdening the source or the receivers, while using a minimum of network bandwidth.

  
        

 
         
         		[bookmark: pgfId-17778]Rendezvous Point

  
         		[bookmark: pgfId-17780]Only available if you selected the Enable IP Multicast check box.

 [bookmark: pgfId-17782]If required, you can enter the IP address of the interface that will serve as the rendezvous point (RP) for multicast transmission. Sources send their traffic to the RP. This traffic is then forwarded to receivers down a shared distribution tree.

  
        

 
         
         		[bookmark: pgfId-17788]Tunnel Key

  
         		[bookmark: pgfId-17790]A number that identifies the tunnel key. The default is 1.

 [bookmark: pgfId-17792]The tunnel key differentiates between different multipoint GRE (mGRE) tunnel Non Broadcast Multiple Access (NBMA) networks. All mGRE interfaces in the same NBMA network must use the same tunnel key value. If there are two mGRE interfaces on the same router, they must have different tunnel key values.

 [bookmark: pgfId-17794]Note To view the newly created tunnel interfaces in the Router Interfaces page for routers that are members of the VPN, you must rediscover the device inventory details after successfully deploying the VPN to the device.

  
        

 
         
         		 
           
           [bookmark: pgfId-17800]NHRP Parameters
          
  
        

 
         
         		[bookmark: pgfId-17808]Network ID

  
         		[bookmark: pgfId-17810]All Next Hop Resolution Protocol (NHRP) stations within one logical Non-Broadcast Multi-Access (NBMA) network must be configured with the same network identifier. Enter a globally unique, 32-bit network identifier within the range of 1 to 4294967295.

  
        

 
         
         		[bookmark: pgfId-17816]Hold time

  
         		[bookmark: pgfId-17818]The time, in seconds, that routers will keep information provided in authoritative NHRP responses. The cached IP-to-NBMA address mapping entries are discarded after the hold time expires.

 [bookmark: pgfId-17820]The default is 300 seconds.

  
        

 
         
         		[bookmark: pgfId-17826]Authentication

  
         		[bookmark: pgfId-17828]An authentication string that controls whether the source and destination NHRP stations allow intercommunication. All routers within the same network using NHRP must share the same authentication string. The string can be up to eight characters long.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-19150][bookmark: 72834][bookmark: vpchap_proc_ConfiguringLargeScaleDMVPNs]Configuring Large Scale DMVPNs[bookmark: marker-19144][bookmark: marker-19146][bookmark: marker-19148]

 
     [bookmark: pgfId-19152]You can configure DMVPN for large scale deployments that might comprise thousands of spokes. In large scale DMVPN topologies, IPsec Terminators, also referred to as Server Load Balance (SLB) devices, reside between the spokes and the hubs. The hubs must be directly connected to the IPsec Terminator—there can be no other device between them.

 
     [bookmark: pgfId-19154]The IPsec Terminator, which is a Catalyst 6500/7600 device, performs encryption and decryption while the hubs handle all tasks related to Next Hop Resolution Protocol (NHRP) and multipoint generic routing encapsulation (mGRE). The IPsec Terminator is configured to specifically load balance GRE traffic to the hubs, and is configured with dynamic crypto to accept any spokes with any proxies. When using tunnel protection on spokes, these proxies are automatically set to match GRE traffic. One GRE tunnel is configured on the spokes. All hubs connecting to the same IPsec Terminator will use the same Tunnel IP address, and the tunnel source is the Virtual IP address of the IPsec Terminator.

 
     [bookmark: pgfId-19159]In Security Manager, you configure a Large Scale DMVPN during the creation of a new hub-and-spoke VPN topology as described in Creating or Editing VPN Topologies. You cannot edit an existing standard DMVPN and convert it to a Large Scale DMVPN. When you create the Large Scale DMVPN, keep the following points in mind:

 
      
      		 [bookmark: pgfId-19164]When you define the technology of the VPN, select  DMVPN as the technology, and  Large Scale with IPsec Terminator as the type. For the procedure, see Defining the Name and IPsec Technology of a VPN Topology.

 
      		 [bookmark: pgfId-19169]When you select the devices for the VPN, select the required IPsec Terminators (Catalyst 6500/7600 devices), the hubs and all the spokes. For the procedure, see Selecting Devices for Your VPN Topology.

 
     

 
     [bookmark: pgfId-19171]There must be direct connectivity between the IPsec Terminators and the hubs.

 
      
      		 [bookmark: pgfId-19176]When you configure the endpoints, as described Defining the Endpoints and Protected Networks, configure the following in the Edit Endpoints dialog box:

 
     

 
     [bookmark: pgfId-19178] – For each hub device, in the Hub Interface tab, select the interface that is connected to the IPsec Terminator. Each hub can be connected to only one IPsec Terminator. Also, identify the protected networks. Each hub in the Large Scale DMVPN must identify itself and its protected networks.

 
     [bookmark: pgfId-19180] – For each IPsec Terminator in the Large Scale DMVPN, specify a VPN external interface, the crypto engine slot, and the Inside VLAN. No protected networks are configured on an IPsec Terminator.

 
     [bookmark: pgfId-19185]After you create the Large Scale DMVPN topology, a Server Load Balance policy is configured on the IPsec Terminators with all the required parameters, which you can edit if required. Initially, all hubs are given the same priority and number of VPN connections. For information on configuring the Server Load Balance policy, see Configuring Server Load Balancing in Large Scale DMVPN.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-19187]Note VRF-Aware IPsec cannot be configured in a Large Scale DMVPN.


     
      

     

     

 
     [bookmark: pgfId-19189]Related Topics

 
      
      		 [bookmark: pgfId-19194]Understanding DMVPN

 
      		 [bookmark: pgfId-19199]Configuring DMVPN

 
     

 
    
 
     
      [bookmark: pgfId-19215][bookmark: 72881][bookmark: vpnpage_cncpt_ServerLoadBalancePage]Configuring Server Load Balancing in Large Scale DMVPN[bookmark: marker-19207][bookmark: marker-19209][bookmark: marker-19211][bookmark: marker-19213]

 
     [bookmark: pgfId-19220]Use the Server Load Balance page to view or edit the server load balance policy configured on the IPsec Terminators in a large scale DMVPN. Server load balancing optimizes performance in multiple hub-and-spoke VPN topologies by sharing the workload among a group of hubs. In large scale DMVPN configurations, the IPsec Terminators perform the traffic load balancing. For more information, see Configuring Large Scale DMVPNs.

 
     [bookmark: pgfId-19222]A weighted round robin (WRR) scheduling algorithm is used to control the bandwidth allocated to output transmission queues. Weighting is based on the amount of bandwidth used by each transmit queue on an interface. Packets from queues with higher capacity are transmitted more often than those from queues with less capacity.

 
     [bookmark: pgfId-19227]To open the Server Load Balance policy, in the Site-to-Site VPN Manager Window, select an existing Large Scale DMVPN topology, then select Server Load Balance from the Policies list.

 
     [bookmark: pgfId-19232]The table displays the hubs in the VPN, the hub’s weight relative to other hubs connected to the same IPsec Terminator, and the maximum number of active connections allowed for the hub. To change the weight or maximum connections, select the hub and click the Edit (pencil) button beneath the table to open the Edit Load Balancing Parameters Dialog Box.

 
     [bookmark: pgfId-19234]Related Topics

 
      
      		 [bookmark: pgfId-19239]Configuring Large Scale DMVPNs

 
      		 [bookmark: pgfId-19244]Filtering Tables

 
     

 
    
 
     
      [bookmark: pgfId-19258][bookmark: 72914][bookmark: vpnpage_cncpt_EditLoadBalancingParametersDialogBox]Edit Load Balancing Parameters Dialog Box[bookmark: marker-19252][bookmark: marker-19254][bookmark: marker-19256]

 
     [bookmark: pgfId-19260]Use the Edit Load Balancing Parameters dialog box to change the server load balance parameters configured on a hub that is connected to an IPsec Terminator in a large scale DMVPN.

 
     [bookmark: pgfId-19262]Navigation Path

 
     [bookmark: pgfId-19267]From the Server Load Balance policy, select a hub and click the Edit (pencil) button below the table. For information on opening the Server Load Balance policy, see Configuring Server Load Balancing in Large Scale DMVPN.

 
     [bookmark: pgfId-19269]Related Topics

 
      
      		 [bookmark: pgfId-19274]Configuring Large Scale DMVPNs

 
     

 
     [bookmark: pgfId-19276]Field Reference

 
     [bookmark: pgfId-19279] 

 
      
       
        
        [bookmark: pgfId-17841]Table 27-3 [bookmark: 72941]Edit Load Balancing Parameters Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-17847]Element
          
  
         		
           
           [bookmark: pgfId-17849]Description
          
  
        

 
         
         		[bookmark: pgfId-17855]Weight

  
         		[bookmark: pgfId-17857]The capacity of the hub relative to other hubs connected to the IPsec Terminator, based on the weighted round robin (WRR) scheduling algorithm.

 [bookmark: pgfId-17859]You can enter a value between 1 and 255. The default is 1.

  
        

 
         
         		[bookmark: pgfId-17865]Max Connections

  
         		[bookmark: pgfId-17867]The maximum number of active connections to the IPsec Terminator that are permitted to the hub.

 [bookmark: pgfId-17869]You can enter a value between 1 and 65535. The default is 500.
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     [bookmark: pgfId-299097][bookmark: 101964][bookmark: ipsvchap_cncpt_ManagingIPSAnomalyDetection]Managing IPS Anomaly Detection[bookmark: marker-299091][bookmark: marker-299093][bookmark: marker-299095]
      
      
 
     
 

 
    [bookmark: pgfId-299099]Anomaly detection is designed to recognize network congestion caused by worm traffic that exhibits scanning behavior. Anomaly detection also will identify infected hosts on the network that are scanning for other vulnerable hosts.

 
    [bookmark: pgfId-299101]Anomaly detection is enabled by default, but there are some configuration settings you should adjust to use it effectively.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-299103]Note The sensor must use IPS software version 6.x or higher to configure anomaly detection. In addition, Cisco IOS IPS and the AIP-SSC-5 do not support anomaly detection.


    
     

    

    

 
    [bookmark: pgfId-299105]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-299110]Understanding Anomaly Detection

 
     		 [bookmark: pgfId-299115]Configuring Anomaly Detection

 
    

 
   
 
    
     [bookmark: pgfId-299129][bookmark: 101980][bookmark: ipsvchap_cncpt_ExplainingAnomalyDetection]Understanding Anomaly Detection[bookmark: marker-299121][bookmark: marker-299123][bookmark: marker-299125][bookmark: marker-299127]

 
    [bookmark: pgfId-299131]The anomaly detection component of the sensor detects worm-infected hosts. This enables the sensor to be less dependent on signature updates for protection again worms and scanners, such as Code Red and SQL Slammer and so forth. The anomaly detection component lets the sensor learn normal activity and send alerts or take dynamic response actions for behavior that deviates from what it has learned as normal behavior.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-299133]Note Anomaly detection does not detect email-based worms, such as Nimda.


    
     

    

    

 
    [bookmark: pgfId-299135]Anomaly detection detects the following two situations:

 
     
     		 [bookmark: pgfId-299137]When the network starts on the path of becoming congested by worm traffic.

 
     		 [bookmark: pgfId-299139]When a single worm-infected source enters the network and starts scanning for other vulnerable hosts.

 
    

 
    [bookmark: pgfId-299141]The following topics explain anomaly detection in more detail:

 
     
     		 [bookmark: pgfId-299146]Worm Viruses

 
     		 [bookmark: pgfId-299151]Anomaly Detection Modes

 
     		 [bookmark: pgfId-299156]Anomaly Detection Zones

 
     		 [bookmark: pgfId-299161]Knowing When to Turn Off Anomaly Detection

 
     		 [bookmark: pgfId-299166]Configuring Anomaly Detection Signatures

 
     		 [bookmark: pgfId-299171]Configuring Anomaly Detection

 
    

 
     
      [bookmark: pgfId-299185][bookmark: 102024][bookmark: ipsvchap_cncpt_WormViruses]Worm Viruses[bookmark: marker-299177][bookmark: marker-299179][bookmark: marker-299181][bookmark: marker-299183]

 
     [bookmark: pgfId-299187]Worm viruses are automated, self-propagating, intrusion agents that make copies of themselves and then facilitate their spread. Worm viruses attack a vulnerable host, infect it, and then use it as a base to attack other vulnerable hosts. They search for other hosts by using a form of network inspection, typically a scan, and then propagate to the next target. A scanning worm virus locates vulnerable hosts by generating a list of IP addresses to probe, and then contacts the hosts. Code Red worm, Sasser worm, Blaster worm, and the Slammer worm are examples of worms that spread in this manner.

 
     [bookmark: pgfId-299189]Anomaly detection identifies worm-infected hosts by their behavior as a scanner. To spread, a worm virus must find new hosts. It finds them by scanning the Internet using TCP, UDP, and other protocols to generate unsuccessful attempts to access different destination IP addresses. A scanner is defined as a source IP address that generates events on the same destination port (in TCP and UDP) for too many destination IP addresses.

 
     [bookmark: pgfId-299191]The events that are important for TCP are non-established connections, such as a SYN packet that does not have its SYN-ACK response for a given amount of time. A worm-infected host that scans using TCP generates non-established connections on the same destination port for an anomalous number of IP addresses.

 
     [bookmark: pgfId-299193]The events that are important for UDP are unidirectional connections, such as a UDP connection where all packets are going in only one direction. A worm-infected host that scans using UDP generates UDP packets but does not receive UDP packets on the same IP address within a time-out period on the same destination port for multiple destination IP addresses.

 
     [bookmark: pgfId-299195]The events that are important for other protocols, such as ICMP (protocol number 1), are from a source IP address to many different destination IP addresses, that is, packets that are received in only one direction.

 
      
      [image: ] 
     
 
     
 
     
      [bookmark: pgfId-299197]
      Caution If a worm virus has a list of IP addresses it should infect and does not have to use scanning to spread itself (for example, it uses passive mapping—listening to the network as opposed to active scanning), it will not be detected by anomaly detection worm policies. Worm viruses that receive a mailing list from probing files within the infected host and email this list will not be detected, because no Layer 3 or Layer 4 anomaly is generated.
       
       
 
      

     
 
    
 
     
      [bookmark: pgfId-299209][bookmark: 102047][bookmark: ipsvchap_cncpt_LearningMode]Anomaly Detection Modes[bookmark: marker-299203][bookmark: marker-299205][bookmark: marker-299207]

 
     [bookmark: pgfId-299211]Anomaly detection initially conducts a “peacetime” learning process when the most normal state of the network is reflected. Anomaly detection then derives a set of policy thresholds that best fit the normal network. This is done in two phases: an initial learning mode phase, followed by the ongoing operational detect mode phase.

 
     [bookmark: pgfId-299213]Anomaly detection has the following modes:

 
      
      		 [bookmark: pgfId-299215]Learning accept mode (initial setup)

 
     

 
     [bookmark: pgfId-299217]Although anomaly detection is in detect mode by default, it conducts an initial learning accept mode for the default period of 24 hours. We assume that during this phase no attack is being carried out. Anomaly detection creates an initial baseline, known as a knowledge base, of the network traffic. The default interval value for periodic schedules is 24 hours and the default action is rotate, meaning that a new knowledge base is saved and loaded, and then replaces the initial knowledge base after 24 hours.

 
     [bookmark: pgfId-299219]Keep the following in mind:

 
     [bookmark: pgfId-299221] – Anomaly detection does not detect attacks when working with the initial knowledge base, which is empty. After the default of 24 hours, a knowledge base is saved and loaded and now anomaly detection also detects attacks.

 
     [bookmark: pgfId-299226] – Depending on your network complexity, you may want to have anomaly detection in learning accept mode for longer than the default 24 hours. You configure the mode in the Virtual Sensors policy; see Defining A Virtual Sensor. After your learning period has finished, edit the virtual sensor and change the mode to Detect.

 
      
      		 [bookmark: pgfId-299228]Detect mode

 
     

 
     [bookmark: pgfId-299230]For ongoing operation, the sensor should remain in detect mode. This is for 24 hours a day, 7 days a week. Once a knowledge base is created and replaces the initial knowledge base, anomaly detection detects attacks based on it. It looks at the network traffic flows that violate thresholds in the knowledge base and sends alerts. As anomaly detection looks for anomalies, it also records gradual changes to the knowledge base that do not violate the thresholds and thus creates a new knowledge base. The new knowledge base is periodically saved and takes the place of the old one thus maintaining an up-to-date knowledge base.

 
      
      		 [bookmark: pgfId-299232]Inactive mode

 
     

 
     [bookmark: pgfId-299234]You can turn anomaly detection off by putting it in inactive mode. Under certain circumstances, anomaly detection should be in inactive mode, for example, if the sensor is running in an asymmetric environment. Because anomaly detection assumes it gets traffic from both directions, if the sensor is configured to see only one direction of traffic, anomaly detection identifies all traffic as having incomplete connections, that is, as scanners, and sends alerts for all traffic flows.

 
     [bookmark: pgfId-299236]The following example summarizes the default anomaly detection configuration. If you add a virtual sensor at 11:00 pm and do not change the default anomaly detection configuration, anomaly detection begins working with the initial knowledge base and only performs learning. Although it is in detect mode, it cannot detect attacks until it has gathered information for 24 hours and replaced the initial knowledge base. At the first start time (10:00 am by default), and the first interval (24 hours by default), the learning results are saved to a new knowledge base and this knowledge base is loaded and replaces the initial knowledge base. Because the anomaly detection is in detect mode by default, now that anomaly detection has a new knowledge base, the anomaly detection begins to detect attacks.

 
    
 
     
      [bookmark: pgfId-299250][bookmark: 102081][bookmark: ipsvchap_cncpt_AnomalyDetectionZones]Anomaly Detection Zones[bookmark: marker-299242][bookmark: marker-299244][bookmark: marker-299246][bookmark: marker-299248]

 
     [bookmark: pgfId-299252]By subdividing the network into zones, you can achieve a lower false negative rate. A zone is a set of destination IP addresses. There are three zones, each with its own thresholds: internal, illegal, and external.

 
     [bookmark: pgfId-299254]The external zone is the default zone with the default Internet range of 0.0.0.0-255.255.255.255. By default, the internal and illegal zones contain no IP addresses. Packets that do not match the set of IP addresses in the internal or illegal zone are handled by the external zone.

 
     [bookmark: pgfId-299256]We recommend that you configure the internal zone with the IP address range of your internal network. If you configure it in this way, the internal zone is all the traffic that comes to your IP address range, and the external zone is all the traffic that goes to the Internet.

 
     [bookmark: pgfId-299258]You can configure the illegal zone with IP address ranges that should never be seen in normal traffic, for example, unallocated IP addresses or part of your internal IP address range that is unoccupied. An illegal zone can be very helpful for accurate detection, because we do not expect any legal traffic to reach this zone. This allows very low thresholds, which in turn can lead to very quick worm virus detection.

 
    
 
     
      [bookmark: pgfId-299272][bookmark: 102102][bookmark: ipsvchap_cncpt_KnowingWhentoTurnOffAnomalyDetection]Knowing When to Turn Off Anomaly Detection[bookmark: marker-299264][bookmark: marker-299266][bookmark: marker-299268][bookmark: marker-299270]

 
     [bookmark: pgfId-299274]Anomaly detection assumes that it gets traffic from both directions. If the sensor is configured to see only one direction of traffic, you should turn off anomaly detection. Otherwise, when anomaly detection is running in an asymmetric environment, it identifies all traffic as having incomplete connections, that is, as scanners, and sends alerts for all traffic flows.

 
     [bookmark: pgfId-299279]You turn off anomaly detection in the Virtual Sensors policy. Edit the virtual sensor for which you are disabling anomaly detection, and change the Anomaly Detection Mode to Inactive. For information on editing virtual sensors, see Editing Policies for a Virtual Sensor.

 
    
 
     
      [bookmark: pgfId-299293][bookmark: 102122][bookmark: ipsvchap_cncpt_ConfiguringAnomalyDetectionSignatures]Configuring Anomaly Detection Signatures[bookmark: marker-299285][bookmark: marker-299287][bookmark: marker-299289][bookmark: marker-299291]

 
     [bookmark: pgfId-299295]The Traffic Anomaly engine contains nine anomaly detection signatures covering three protocols (TCP, UDP, and other). Each signature has two subsignatures, one for the scanner and the other for the worm-infected host (or a scanner under worm attack). When anomaly detection discovers an anomaly, it triggers an alert for these signatures. All anomaly detection signatures are enabled by default and the alert severity for each one is set to high.

 
     [bookmark: pgfId-299297]When a scanner is detected but no histogram anomaly occurred, the scanner signature fires for that attacker (scanner) IP address. If the histogram signature is triggered, the attacker addresses that are doing the scanning each trigger the worm signature (instead of the scanner signature). The alert details state which threshold is being used for the worm detection now that the histogram has been triggered. From that point on, all scanners are detected as worm-infected hosts.

 
     [bookmark: pgfId-299299]The following anomaly detection event actions are possible:

 
      
      		 [bookmark: pgfId-299301]Produce alert—Writes the event to the Event Store.

 
      		 [bookmark: pgfId-299303]Deny attacker inline—(Inline only) Does not transmit this packet and future packets originating from the attacker address for a specified period of time.

 
      		 [bookmark: pgfId-299305]Log attacker packets—Starts IP logging for packets that contain the attacker address.

 
      		 [bookmark: pgfId-299307]Deny attacker service pair inline—Blocks the source IP address and the destination port.

 
      		 [bookmark: pgfId-299312]Request SNMP trap—Sends a trap notification to an SNMP trap destination. To use this action, you must configure SNMP trap hosts as described in Configuring SNMP.

 
      		 [bookmark: pgfId-299317]Request block host—Sends a request to ARC to block this host (the attacker). To use this action, you must configure blocking devices as described in Configuring IPS Blocking and Rate Limiting.

 
     

 
     [bookmark: pgfId-299319]You can add actions to the signatures either directly, in the Signatures policy, or to events generated by the signatures based on risk rating in the Event Actions Overrides policy.

 
     [bookmark: pgfId-299321]The following table lists the anomaly detection worm signatures.

 
     [bookmark: pgfId-299324] 

 
      
       
        
        [bookmark: pgfId-297996]Table 41-1 [bookmark: 102161]Anomaly Detection Worm Signatures 

 
        
       
         
         		
           
           [bookmark: pgfId-298006]Signature ID
          
  
         		
           
           [bookmark: pgfId-298008]Subsignature ID
          
  
         		
           
           [bookmark: pgfId-298010]Name
          
  
         		
           
           [bookmark: pgfId-298012]Description
          
  
        

 
         
         		[bookmark: pgfId-298022]13000

  
         		[bookmark: pgfId-298024]0

  
         		[bookmark: pgfId-298026]Internal TCP Scanner

  
         		[bookmark: pgfId-298028]Identified a single scanner over a TCP protocol in the internal zone.

  
        

 
         
         		[bookmark: pgfId-298038]13000

  
         		[bookmark: pgfId-298040]1

  
         		[bookmark: pgfId-298042]Internal TCP Scanner

  
         		[bookmark: pgfId-298044]Identified a worm attack over a TCP protocol in the internal zone; the TCP histogram threshold was crossed and a scanner over a TCP protocol was identified.

  
        

 
         
         		[bookmark: pgfId-298054]13001

  
         		[bookmark: pgfId-298056]0

  
         		[bookmark: pgfId-298058]Internal UDP Scanner

  
         		[bookmark: pgfId-298060]Identified a single scanner over a UDP protocol in the internal zone.

  
        

 
         
         		[bookmark: pgfId-298070]13001

  
         		[bookmark: pgfId-298072]1

  
         		[bookmark: pgfId-298074]Internal UDP Scanner

  
         		[bookmark: pgfId-298076]Identified a worm attack over a UDP protocol in the internal zone; the UDP histogram threshold was crossed and a scanner over a UDP protocol was identified.

  
        

 
         
         		[bookmark: pgfId-298086]13002

  
         		[bookmark: pgfId-298088]0

  
         		[bookmark: pgfId-298090]Internal Other Scanner

  
         		[bookmark: pgfId-298092]Identified a single scanner over an Other protocol in the internal zone.

  
        

 
         
         		[bookmark: pgfId-298102]13002

  
         		[bookmark: pgfId-298104]1

  
         		[bookmark: pgfId-298106]Internal Other Scanner

  
         		[bookmark: pgfId-298108]Identified a worm attack over an Other protocol in the internal zone; the Other histogram threshold was crossed and a scanner over an Other protocol was identified.

  
        

 
         
         		[bookmark: pgfId-298118]13003

  
         		[bookmark: pgfId-298120]0

  
         		[bookmark: pgfId-298122]External TCP Scanner

  
         		[bookmark: pgfId-298124]Identified a single scanner over a TCP protocol in the external zone.

  
        

 
         
         		[bookmark: pgfId-298134]13003

  
         		[bookmark: pgfId-298136]1

  
         		[bookmark: pgfId-298138]External TCP Scanner

  
         		[bookmark: pgfId-298140]Identified a worm attack over a TCP protocol in the external zone; the TCP histogram threshold was crossed and a scanner over a TCP protocol was identified.

  
        

 
         
         		[bookmark: pgfId-298150]13004

  
         		[bookmark: pgfId-298152]0

  
         		[bookmark: pgfId-298154]External UDP Scanner

  
         		[bookmark: pgfId-298156]Identified a single scanner over a UDP protocol in the external zone.

  
        

 
         
         		[bookmark: pgfId-298166]13004

  
         		[bookmark: pgfId-298168]1

  
         		[bookmark: pgfId-298170]External UDP Scanner

  
         		[bookmark: pgfId-298172]Identified a worm attack over a UDP protocol in the external zone; the UDP histogram threshold was crossed and a scanner over a UDP protocol was identified.

  
        

 
         
         		[bookmark: pgfId-298182]13005

  
         		[bookmark: pgfId-298184]0

  
         		[bookmark: pgfId-298186]External Other Scanner

  
         		[bookmark: pgfId-298188]Identified a single scanner over an Other protocol in the external zone.

  
        

 
         
         		[bookmark: pgfId-298198]13005

  
         		[bookmark: pgfId-298200]1

  
         		[bookmark: pgfId-298202]External Other Scanner

  
         		[bookmark: pgfId-298204]Identified a worm attack over an Other protocol in the external zone; the Other histogram threshold was crossed and a scanner over an Other protocol was identified.

  
        

 
         
         		[bookmark: pgfId-298214]13006

  
         		[bookmark: pgfId-298216]0

  
         		[bookmark: pgfId-298218]Illegal TCP Scanner

  
         		[bookmark: pgfId-298220]Identified a single scanner over a TCP protocol in the illegal zone.

  
        

 
         
         		[bookmark: pgfId-298230]13006

  
         		[bookmark: pgfId-298232]1

  
         		[bookmark: pgfId-298234]Illegal TCP Scanner

  
         		[bookmark: pgfId-298236]Identified a worm attack over a TCP protocol in the illegal zone; the TCP histogram threshold was crossed and a scanner over a TCP protocol was identified.

  
        

 
         
         		[bookmark: pgfId-298246]13007

  
         		[bookmark: pgfId-298248]0

  
         		[bookmark: pgfId-298250]Illegal UDP Scanner

  
         		[bookmark: pgfId-298252]Identified a single scanner over a UDP protocol in the illegal zone.

  
        

 
         
         		[bookmark: pgfId-298262]13007

  
         		[bookmark: pgfId-298264]1

  
         		[bookmark: pgfId-298266]Illegal UDP Scanner

  
         		[bookmark: pgfId-298268]Identified a worm attack over a UDP protocol in the illegal zone; the UDP histogram threshold was crossed and a scanner over a UDP protocol was identified.

  
        

 
         
         		[bookmark: pgfId-298278]13008

  
         		[bookmark: pgfId-298280]0

  
         		[bookmark: pgfId-298282]Illegal Other Scanner

  
         		[bookmark: pgfId-298284]Identified a single scanner over an Other protocol in the illegal zone.

  
        

 
         
         		[bookmark: pgfId-298294]13008

  
         		[bookmark: pgfId-298296]1

  
         		[bookmark: pgfId-298298]Illegal Other Scanner

  
         		[bookmark: pgfId-298300]Identified a worm attack over an Other protocol in the illegal zone; the Other histogram threshold was crossed and a scanner over an Other protocol was identified.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-299338][bookmark: 102339][bookmark: ipsvchap_cncpt_ConfiguringAnomalyDetection]Configuring Anomaly Detection[bookmark: marker-299332][bookmark: marker-299334][bookmark: marker-299336]

 
    [bookmark: pgfId-299340]Use the Anomaly Detection policy to configure anomaly detection settings. The Virtual Sensors policy also contains a setting important for anomaly detection.

 
    [bookmark: pgfId-299342]This procedure explains the overall configuration of anomaly detection. Before configuring these settings, read the following topics:

 
     
     		 [bookmark: pgfId-299347]Understanding Anomaly Detection

 
     		 [bookmark: pgfId-299352]Worm Viruses

 
     		 [bookmark: pgfId-299357]Anomaly Detection Modes

 
     		 [bookmark: pgfId-299362]Anomaly Detection Zones

 
     		 [bookmark: pgfId-299367]Knowing When to Turn Off Anomaly Detection

 
     		 [bookmark: pgfId-299372]Configuring Anomaly Detection Signatures

 
    

 
    
 
    [bookmark: pgfId-299374]Step 1 Do one of the following to open the Anomaly Detection policy you want to modify:

 
     
     		 [bookmark: pgfId-299376](Device view) Select  IPS > Anomaly Detection from the Policy selector.

 
     		 [bookmark: pgfId-299378](Policy view) Select  IPS > Anomaly Detection from the Policy selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-299380]The Anomaly detection policy includes these tabs:

 
     
     		 [bookmark: pgfId-299382] Operation Settings —Defines the worm timeout and identifies any IP addresses that should be ignored by anomaly detection.

 
     		 [bookmark: pgfId-299384] Learning Accept Mode —The configuration for learning mode, including how the knowledge base is handled.

 
     		 [bookmark: pgfId-299389] Internal Zone, Illegal Zone, External Zone —The zones of your network that you define. You can configure unique settings for each zone. For an explanation of the zones, see Anomaly Detection Zones.

 
    

 
    [bookmark: pgfId-299391]Step 2 Click the Operation Settings tab, if necessary, and configure the following:

 
     
     		 [bookmark: pgfId-299396] Worm Timeout —The time in seconds for the worm termination timeout. The range is 120 to 10,000,000 seconds. The default is 600 seconds. For an explanation of how this timeout is used, see Understanding Anomaly Detection Thresholds and Histograms.

 
     		 [bookmark: pgfId-299398] Enable Ignored Addresses and  Source/Destination Addresses to Ignore —Whether you are configuring a list of addresses that should be ignored while anomaly detection is processing. You can specify a list of source addresses (those that initiate a scan) or destination addresses (the hosts that are scanned).

 
    

 
    [bookmark: pgfId-299400]The addresses can be single host (such as 10.100.10.1), a range of addresses (such as 10.100.10.0-10.100.10.255), or network/host objects that contain single hosts, address ranges, or a combination of hosts and ranges. Click Select to select objects from a list or to create new objects.

 
    [bookmark: pgfId-299405]Step 3 Click the Learning Accept Mode tab and define how the knowledge base will be generated and used. For detailed information, see Configuring Anomaly Detection Learning Accept Mode.

 
    [bookmark: pgfId-299407]Step 4 Configure the internal, illegal, and external zones:

 
     
     		 [bookmark: pgfId-299409]Define the internal and illegal zones—The internal zones are the IP addresses of your internal network, the network that you manage. The illegal zone should represent IP address ranges that should never be seen in normal traffic, for example, unallocated IP addresses or part of your internal IP address range that is unoccupied.

 
    

 
    [bookmark: pgfId-299411]Click the Internal Zone and Illegal Zone tabs in turn and configure the following on the General tab:

 
    [bookmark: pgfId-299413] – Enable this zone—Whether the zone will be processed by anomaly detection.

 
    [bookmark: pgfId-299415] – Service Subnets—The IP addresses that comprise the zone. The default (0.0.0.0) is that no address is included in the zone. Replace 0.0.0.0 to define addresses for the zone.

 
    [bookmark: pgfId-299417]The addresses can be single host (such as 10.100.10.1), a range of addresses (such as 10.100.10.0-10.100.10.255), or network/host objects that contain single hosts, address ranges, or a combination of hosts and ranges. Click Select to select objects from a list or to create new objects.

 
     
     		 [bookmark: pgfId-299419]Decide whether to enable the external zone—The external zone comprises all IP addresses that are not configured for the internal or illegal zones. You do not explicitly assign addresses to this zone. On the  External Zone tab,  General sub-tab, you can enable or disable the zone using the  Enable this zone checkbox. The external zone is enabled by default.

 
     		 [bookmark: pgfId-299424]Configure scanner thresholds and histograms—Each zone has sub-tabs for  TCP Protocol ,  UDP Protocol , and  Other Protocols . On these tabs, you can configure non-default settings for specific services that override the learned histograms. For detailed information about configuring these settings, see Configuring Anomaly Detection Thresholds and Histograms.

 
    

 
    [bookmark: pgfId-299426]At this point, you have finished configuring the basic anomaly detection settings.

 
    [bookmark: pgfId-299428]Step 5 (Device view only.) Configure the anomaly detection mode. This setting is defined in the Virtual Sensors policy. Consider the following tips to select the correct policy:

 
     
     		 [bookmark: pgfId-299430]If you configured the anomaly detection policy on a virtual sensor (other than vs0, which is represented by the parent IPS device), you must select the parent IPS device, then select the Virtual Sensors policy.

 
     		 [bookmark: pgfId-299432]If you configured the Anomaly Detection policy as a shared policy in Policy view, select the IPS device to which the policy is assigned, or that hosts a virtual sensor to which the policy is assigned.

 
    

 
    [bookmark: pgfId-299434]Then, complete the following steps in the Virtual Sensors policy:

 
    [bookmark: pgfId-299436] a. Select the desired virtual sensor in the table and click the Edit Row button.

 
    [bookmark: pgfId-299444] b. In the Modify Virtual Sensors dialog box, select the appropriate option for the Anomaly Detection Mode setting: Detect, Inactive, Learn. The default and normal operational mode is Detect. However, if you are using asymmetric normalizer mode, you might want to set the anomaly detection mode to Inactive. For detailed information about these modes, see Anomaly Detection Modes. For information about the other settings in this dialog box, see Virtual Sensor Dialog Box.

 
    [bookmark: pgfId-299446] c. If you placed anomaly detection in Learning mode, remember to change the mode to Detect after the desired learning period has completed.

 
    [bookmark: pgfId-299451]Step 6 Add additional actions to the anomaly detection signatures, if desired. For example, you might want to add a deny action so that attacks are dropped. You can alternatively configure event action overrides to add actions based on risk rating. For more information, see Configuring Anomaly Detection Signatures.

 
    [bookmark: pgfId-299453]Step 7 Manage the knowledge base, if necessary.

 
    [bookmark: pgfId-299455]If you configured the knowledge base to automatically rotate (on the Learning Accept Mode tab), then the knowledge base is refreshed automatically and manual intervention is not necessary.

 
    [bookmark: pgfId-299457]If you configured anomaly detection to only save new databases, and not use them, then you need to manually load updated knowledge bases periodically. You cannot do this in Security Manager; use the IPS Device Manager (IDM) instead.

 
    [bookmark: pgfId-299459]Using IDM (or IME), you can load, delete, and rename knowledge bases, and upload them to or download them from an external server. For more information about what you can do, see the online help for IDM or IME.

 
    [bookmark: pgfId-299461]


    
     

    
 
    

 
     
      [bookmark: pgfId-299481][bookmark: 102474][bookmark: ipsvchap_proc_ConfiguringAnomalyDetectionLearningAcceptMode]Configuring Anomaly Detection Learning Accept Mode[bookmark: marker-299471][bookmark: marker-299473][bookmark: marker-299475][bookmark: marker-299477][bookmark: marker-299479]

 
     [bookmark: pgfId-299483]Use the Learning Accept Mode tab of the Anomaly Detection policy to configure whether you want the sensor to create a new knowledge base every so many hours. You can configure whether the knowledge base is created and loaded (Rotate) or saved (Save Only). You can schedule how often and when the knowledge base is loaded or saved.

 
     [bookmark: pgfId-299485]The default generated filename is YYYY-Mon-dd-hh_mm_ss (that is, year-month-day-hour_minute_second),where Mon is a three-letter abbreviation of the current month.

 
     [bookmark: pgfId-299487]The knowledge base has a tree structure and contains the following information:

 
      
      		 [bookmark: pgfId-299489]Knowledge base name

 
      		 [bookmark: pgfId-299491]Zone name

 
      		 [bookmark: pgfId-299493]Protocol

 
      		 [bookmark: pgfId-299495]Service

 
     

 
     [bookmark: pgfId-299497]The knowledge base holds a scanner threshold and a histogram for each service. If you have learning accept mode set to automatic and the action set to rotate, a new knowledge base is created every 24 hours and used in the next 24 hours. If you have learning accept mode set to automatic and the action is set to save only, a new knowledge base is created but not loaded, and the current knowledge base is used. If you do not have learning accept mode set to automatic, no knowledge base is created.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-299499]Tip Although you can use Security Manager to configure how knowledge bases are generated, you cannot manage the knowledge bases themselves. Use the IPS Device Manager (IDM), or IPS Manager Express (IME) instead. Using IDM (or IME), you can load, delete, and rename knowledge bases, and upload them to or download them from an external server. For more information about what you can do, see the online help for IDM or IME.


     
      

     

     

 
     [bookmark: pgfId-299501]Related Topics

 
      
      		 [bookmark: pgfId-299506]Anomaly Detection Modes

 
      		 [bookmark: pgfId-299511]Configuring Anomaly Detection

 
      		 [bookmark: pgfId-299516]Understanding Anomaly Detection Thresholds and Histograms

 
     

 
     
 
     [bookmark: pgfId-299518]Step 1 Do one of the following to open the Anomaly Detection policy you want to modify:

 
      
      		 [bookmark: pgfId-299520](Device view) Select  IPS > Anomaly Detection from the Policy selector.

 
      		 [bookmark: pgfId-299522](Policy view) Select  IPS > Anomaly Detection from the Policy selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-299524]Step 2 Click the Learning Accept Mode tab and configure the following options:

 
      
      		 [bookmark: pgfId-299526] Automatically accept learning knowledge base —Whether to have the sensor automatically update the knowledge base. If you do not select this option, anomaly detection does not automatically create a new knowledge base, and you cannot configure the other options on this tab.

 
      		 [bookmark: pgfId-299528] Action —Whether to rotate or save the knowledge base when it is created.

 
     

 
     [bookmark: pgfId-299530]If you choose Rotate (the default), the new knowledge base is created and loaded according to the schedule you define. If you choose Save Only, the new knowledge base is created but not loaded. You can examine it and decide whether to load it into anomaly detection using IDM or IME.

 
     [bookmark: pgfId-299532]Step 3 In the Schedule field, select the schedule for generating a new knowledge base. The default schedule is periodic starting at 10 AM and running for 24 hours. Options are:

 
      
      		 [bookmark: pgfId-299534] Periodic —Base the schedule on a recurring period. Configure the following options:

 
     

 
     [bookmark: pgfId-299536] – Start Time—The starting time for the learning window in hh:mm:ss format (24-hour clock).

 
     [bookmark: pgfId-299538] – Learning Interval in hours—How long you want anomaly detection to learn from the network before creating a new knowledge base.

 
      
      		 [bookmark: pgfId-299540] Calendar Schedule —Base the schedule on specific times of day and days of the week. The dialog box changes to show Time of Day and Days of the Week tables. These times apply to every day selected; you cannot specify different times for different days.

 
     

 
     [bookmark: pgfId-299542] – To add a time or day, click the Add Row (+) button beneath the appropriate table. The time is in hh:mm:ss format (24-hour clock). For day, select the day from the list.

 
     [bookmark: pgfId-299544] – To edit an existing time or day, select it and click the Edit Row (pencil) button.

 
     [bookmark: pgfId-299546] – To delete a time or day, select it and click the Delete Row (trash can) button. Ensure that you have at least one time and one day configured.

 
     [bookmark: pgfId-299548]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-299570][bookmark: 102573][bookmark: ipsvchap_cncpt_UnderstandingAnomalyDetectionThresholdsandHistograms]Understanding Anomaly Detection Thresholds and Histograms[bookmark: marker-299554][bookmark: marker-299556][bookmark: marker-299558][bookmark: marker-299560][bookmark: marker-299562][bookmark: marker-299564][bookmark: marker-299566][bookmark: marker-299568]

 
     [bookmark: pgfId-299572]Anomaly detection uses thresholds and histograms to determine if scanning behavior is an attack.

 
     [bookmark: pgfId-299580]During learning mode, anomaly detection develops histograms for each TCP and UDP port, and for other protocols, to create a baseline of the normal behavior of your network (see Anomaly Detection Modes). For example, the histogram for a TCP port lists the “normal” number of source addresses that make incomplete connections to a certain number of destination addresses during a minute. The histograms contain three buckets: low number of destination addresses (5), medium number (20), and high number (100). (The destination buckets are a fixed number.) Separate histograms are kept for each service and zone (see Anomaly Detection Zones).

 
     [bookmark: pgfId-299583]For example, learning mode might develop the following histogram for TCP port 80:

 
      
       
       
         
         		 
           
           [bookmark: pgfId-298307]Number of Destination Addresses
          
  
         		 
           
           [bookmark: pgfId-298309]Number of Source Addresses
          
  
        

 
         
         		[bookmark: pgfId-298315]Low (5)

  
         		[bookmark: pgfId-298317]18

  
        

 
         
         		[bookmark: pgfId-298323]Medium (20)

  
         		[bookmark: pgfId-298325]6

  
        

 
         
         		[bookmark: pgfId-298331]High (100)

  
         		[bookmark: pgfId-298333]2

  
        

 
       
      

 
     
 
     [bookmark: pgfId-299585]In addition to these learned histograms, the anomaly detection scanner has a threshold setting that you configure. You configure a general scanner threshold, and you can override the threshold (configuring a different value) for any specific service (TCP port, UDP port, or other protocol). Each zone has its own thresholds.

 
     [bookmark: pgfId-299587]When anomaly detection moves to detect mode, where it is actively scanning for worms, the thresholds and histograms are used as follows:

 
      
      		 [bookmark: pgfId-299589]Histograms are ignored until the threshold for the service is exceeded. For example, consider the above table for TCP/80 traffic. If the threshold is set at 200 (the default), a scanner must scan 200 hosts in a minute to trigger a scanner alert. If 7 source addresses scanned 50 hosts (which is an anomaly in the histogram, which expects no more than 6 hosts scanning 20-99 destinations), but a single scanner scanned only 100 addresses, no alert is generated, and no anomaly is detected.

 
      		 [bookmark: pgfId-299591]When the scanner threshold is exceeded, anomaly detection uses the histogram to determine if the service is under worm attack. In this example, if a source scans more than 200 destinations, anomaly detection evaluates the collected activity in the network. Because 7 hosts have scanned 50 hosts, a worm alert is generated.

 
     

 
     [bookmark: pgfId-299593]When under worm attack, anomaly detection stops learning and clears the current learning information. It also temporarily lowers the thresholds.

 
      
      		 [bookmark: pgfId-299595]When a worm attack is detected, the worm timeout counter is started. When the timeout is reached, the scanner is reset. If the worm attack continues, new alerts are generated. You configure the worm timeout on the Operation Settings tab of the Anomaly Detection policy.

 
     

 
     [bookmark: pgfId-299597]If you leave the defaults in place, anomaly detection generates histograms based on what it learns about your network from the network’s actual behavior. However, if you understand your network you can fine-tune these histograms to reduce false positives, creating your own definition of expected (or desired or tolerated) behavior for each TCP/UDP port or other protocol, for each zone. You can create your own histograms for only those services that interest you, and leave the defaults for all other ports. Additionally, you can configure the general scanner threshold for each zone, and configure different thresholds for specific services.

 
     [bookmark: pgfId-299602]For information on configuring thresholds and histograms, see Configuring Anomaly Detection Thresholds and Histograms.

 
    
 
     
      [bookmark: pgfId-299624][bookmark: 102647][bookmark: ipsvchap_proc_ConfiguringAnomalyDetectionThresholdsandHistograms]Configuring Anomaly Detection Thresholds and Histograms[bookmark: marker-299608][bookmark: marker-299610][bookmark: marker-299612][bookmark: marker-299614][bookmark: marker-299616][bookmark: marker-299618][bookmark: marker-299620][bookmark: marker-299622]

 
     [bookmark: pgfId-299629]Anomaly detection uses thresholds and histograms to determine if scanning behavior is an attack. In most cases, you can use the default thresholds and the histograms that anomaly detection generates during learning mode (see Anomaly Detection Modes). However, you might want to fine-tune these settings. Changing the thresholds is a more likely change than creating your own histograms.

 
     [bookmark: pgfId-299634]Before you configure these settings, read Understanding Anomaly Detection Thresholds and Histograms. You must understand how thresholds and histograms are used together to configure them.

 
     
 
     [bookmark: pgfId-299636]Step 1 Do one of the following to open the Anomaly Detection policy you want to modify:

 
      
      		 [bookmark: pgfId-299638](Device view) Select  IPS > Anomaly Detection from the Policy selector.

 
      		 [bookmark: pgfId-299640](Policy view) Select  IPS > Anomaly Detection from the Policy selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-299645]Step 2 Click the tab for the zone whose thresholds or histograms you want to change. You configure separate values for each zone: Internal Zone, Illegal Zone, External Zone. For an explanation of the zones, see Anomaly Detection Zones.

 
     [bookmark: pgfId-299647]The tabs for each zone contain four sub-tabs: General, TCP Protocol, UDP Protocol, and Other Protocols. The General tab defines the IP addresses for the zone and whether the zone is enabled (the External zone includes all IP addresses not specified for the other zones, you do not configure specific addresses for the External zone).

 
     [bookmark: pgfId-299649]The other tabs are where you define thresholds and histograms.

 
     [bookmark: pgfId-299651]Step 3 Select the tab for the protocol for which you want to modify thresholds or histograms: TCP Protocol, UDP Protocol, Other Protocol.

 
     [bookmark: pgfId-299653]On each tab, configure the following options:

 
      
      		 [bookmark: pgfId-299655] Enabled —Whether anomaly detection is enabled for the protocol. You can turn off detection for all of TCP, UDP, or for all non-TCP/UDP protocols with this option. If you deselect the option, any other settings configured on the tab are ignored.

 
      		 [bookmark: pgfId-299657] Destination Port Map or  Protocol Number Map table—This table lists the TCP/UDP ports, or other protocols, for which you are configuring non-default mappings. By default, all ports and protocols are enabled and use the default scanner threshold.

 
     

 
     [bookmark: pgfId-299659]Add items to this table only if you want to: disable detection for a port or protocol; set a different threshold value for a port or protocol; or configure an explicit histogram for a port or protocol, which will be used instead of the learned histogram.

 
     [bookmark: pgfId-299664] – To add a mapping, click the Add Row (+) button and fill in the Add Dest or Protocol Map dialog box. For detailed information, see Dest Port or Protocol Map Dialog Box.

 
     [bookmark: pgfId-299666] – To edit a mapping, select it and click the Edit Row (pencil) button.

 
     [bookmark: pgfId-299668] – To delete a mapping, select it and click the Delete Row (trash can) button. Deleting a mapping returns the service to the default settings.

 
      
      		 [bookmark: pgfId-299670] Scanner Threshold —The threshold for all TCP, UDP, or other protocols. This threshold is used for all services except those for which you configured a scanner override in the mapping table. The range is 5 to 1000. The default is 200.

 
      		 [bookmark: pgfId-299672] Threshold Histogram —The default histogram for all TCP, UDP, or other protocols. This histogram is used for all services except those for which you configured a scanner override in the mapping table.

 
     

 
     [bookmark: pgfId-299677]The content of this table is fixed; you cannot add or delete items. However, you can select a row and click Edit Row (pencil) to change the number of source addresses configured for a threshold setting. See Histogram Dialog Box.

 
     [bookmark: pgfId-299679]Step 4 Repeat the process for each combination of zone and protocol for which you are defining non-default settings.

 
     [bookmark: pgfId-299681]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-299695][bookmark: 102738][bookmark: ipspage_cncpt_DestPortMapDialogBox]Dest Port or Protocol Map Dialog Box[bookmark: marker-299691][bookmark: marker-299693]

 
     [bookmark: pgfId-299697]Use the Add or Modify Dest Port Map dialog box to add or modify destination port scanner settings for TCP or UDP, and the Add or Modify Protocol Map dialog box to add or modify scanner settings for other protocols.

 
     [bookmark: pgfId-299699]Before you configure these settings, read the following topics:

 
      
      		 [bookmark: pgfId-299704]Understanding Anomaly Detection Thresholds and Histograms

 
      		 [bookmark: pgfId-299709]Configuring Anomaly Detection Thresholds and Histograms

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-299711]Tip You do not need to add a port or protocol to have anomaly detection look for worm attacks against it. By default, all ports and protocols are processed. You need to configure specific settings only if you want to turn off detection on a specific port or protocol, or if you want non-default thresholds or histograms.


     
      

     

     

 
     [bookmark: pgfId-299713]Navigation Path

 
     [bookmark: pgfId-299718]In the Anomaly Detection policy, on the TCP Protocol, UDP Protocol, or Other Protocol sub tabs on the Internal Zone, Illegal Zone, or External Zone tabs, click the Add Row button beneath the Destination Port Map or Protocol Number Map tables, or select a row and click the Edit Row button. For more information on the steps required to get here, see Configuring Anomaly Detection Thresholds and Histograms.

 
     [bookmark: pgfId-299720]Field Reference

 
     [bookmark: pgfId-299723] 

 
      
       
        
        [bookmark: pgfId-298346]Table 41-2 [bookmark: 102769]Destination Port or Protocol Map Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-298352]Element
          
  
         		
           
           [bookmark: pgfId-298354]Description
          
  
        

 
         
         		[bookmark: pgfId-298360]Destination Port Number

 [bookmark: pgfId-298362](Dest Port Map dialog box only.)

  
         		[bookmark: pgfId-298364]The destination port number for which you are defining non-default values. The range is 0 to 65535.

 [bookmark: pgfId-298366]Enter a single port number, or the name of a port list object that contains a single port number. Click Select to select an object from a list or to create a new one.

  
        

 
         
         		[bookmark: pgfId-298372]Protocol Number

 [bookmark: pgfId-298374](Protocol Map dialog box only.)

  
         		[bookmark: pgfId-298378]The protocol number for non-TCP/UDP protocols. For a list of protocol numbers, see RFC 1700 at http://www.ietf.org/rfc/rfc1700.txt and search for “Protocol Numbers.” Look for a heading (at the time of this writing, the second search hit). The range is 0 to 255.

 [bookmark: pgfId-298380]For example, ICMP is protocol 1.

  
        

 
         
         		[bookmark: pgfId-298386]Enabled

  
         		[bookmark: pgfId-298388]Whether to enable this service. If you do not enable the service, the associated port or protocol is not processed by anomaly detection.

  
        

 
         
         		[bookmark: pgfId-298394]Override Scanner Settings

  
         		[bookmark: pgfId-298396]Whether to override the scanner settings for this service or protocol. You must select this option to enable the remaining fields on the dialog box.

  
        

 
         
         		[bookmark: pgfId-298402]Scanner Threshold

  
         		[bookmark: pgfId-298404]The scanner threshold for this port or protocol. The range is 5 to 1000. The default is 200.

  
        

 
         
         		[bookmark: pgfId-298410]Threshold Histogram table

  
         		[bookmark: pgfId-298412]The histograms for this port or protocol. If you leave the table empty, the default histograms are used. You can have up to three rows, for low, medium, and high numbers of destination addresses, with different threshold levels (source addresses) for each.

 
           
           		 [bookmark: pgfId-298417]To add a threshold, click the  Add Row button and fill in the Histogram Dialog Box. The Add button is disabled if you already have three rows.

 
           		 [bookmark: pgfId-298419]To edit a threshold, select it and click the  Edit Row button. You cannot change the destination bucket to one that is already defined in the table.

 
           		 [bookmark: pgfId-298421]To delete a threshold, select it and click the  Delete Row button. Any buckets not included in the table use the default histogram for the bucket.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-299733][bookmark: 102827][bookmark: ipspage_cncpt_HistogramDialogBox]Histogram Dialog Box[bookmark: marker-299731]

 
     [bookmark: pgfId-299735]Use the Histogram dialog box to create or modify entries in a histogram. The histograms you create or modify override the default histograms that anomaly detection generates. For detailed information about how these histograms are used, see:

 
      
      		 [bookmark: pgfId-299740]Understanding Anomaly Detection Thresholds and Histograms

 
      		 [bookmark: pgfId-299745]Configuring Anomaly Detection Thresholds and Histograms

 
     

 
     [bookmark: pgfId-299747]Navigation Path

 
     [bookmark: pgfId-299752]Do one of the following from the Anomaly Detection policy (see Configuring Anomaly Detection):

 
      
      		 [bookmark: pgfId-299754]On the TCP Protocol, UDP Protocol, or Other Protocol sub tabs on the Internal Zone, Illegal Zone, or External Zone tabs, select a row in the Threshold Histogram table and click the  Edit Row button.

 
      		 [bookmark: pgfId-299759]On the Add or Modify Dest or Protocol Map dialog boxes, click the  Add Row button, or select a row and click the  Edit Row button. For information on opening the map dialog boxes, see Dest Port or Protocol Map Dialog Box.

 
     

 
     [bookmark: pgfId-299761]Field Reference

 
     [bookmark: pgfId-299764] 

 
      
       
        
        [bookmark: pgfId-298434]Table 41-3 [bookmark: 102857]Histogram Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-298440]Element
          
  
         		
           
           [bookmark: pgfId-298442]Description
          
  
        

 
         
         		[bookmark: pgfId-298448]Number of Destination IP Addresses

  
         		[bookmark: pgfId-298450]The histogram bucket you are defining. The buckets have a fixed number of destination addresses: Low (5 addresses); Medium (20); High (100).

 [bookmark: pgfId-298452]Tip A histogram can have a single entry for each destination bucket (low, medium, high). Thus, you cannot change this value to one that is already defined in the histogram you are editing.  
        

 
         
         		[bookmark: pgfId-298458]Number of Source IP Addresses

  
         		[bookmark: pgfId-298460]The number of source addresses that are allowed to simultaneously scan the associated number of destination addresses. Enter the desired number.

 [bookmark: pgfId-298462]The range is 0 to 4096. If you are editing a histogram, the current value is shown.
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     [bookmark: pgfId-404458][bookmark: 98469][bookmark: ipsvchap_cncpt_ManagingIPSServices]Defining IPS Signatures[bookmark: marker-404450][bookmark: marker-404452][bookmark: marker-404454][bookmark: marker-404456]
      
      
 
     
 

 
    [bookmark: pgfId-404460]You can use Security Manager to configure IPS signatures for dedicated IPS appliances and service modules or Cisco IOS IPS devices. When configuring signatures for Cisco IOS IPS, keep in mind that the router cannot use as many signatures as a dedicated appliance or service module.

 
    [bookmark: pgfId-404462]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-404467]Understanding Signatures

 
     		 [bookmark: pgfId-404472]Configuring Signatures

 
     		 [bookmark: pgfId-404477]Configuring Signature Settings

 
    

 
   
 
    
     [bookmark: pgfId-404491][bookmark: 98489][bookmark: ipsvchap_cncpt_UnderstandingSignatures]Understanding Signatures[bookmark: marker-404483][bookmark: marker-404485][bookmark: marker-404487][bookmark: marker-404489]

 
    [bookmark: pgfId-404493]Network intrusions are attacks on, or other misuses of, network resources. Cisco IPS sensors and Cisco IOS IPS devices use a signature-based technology to detect network intrusions. A signature specifies the types of network intrusions that you want the sensor to detect and report. As sensors scan network packets, they use signatures to detect known types of attacks, such as denial of service (DoS) attacks, and respond with actions that you define.

 
    [bookmark: pgfId-404495]On a basic level, signature-based intrusion detection technology can be compared to virus-checking programs. Cisco IPS contains a set of signatures that the sensor compares with network activity. When a match is found, the sensor takes some action, such as logging the event or sending an alarm to the Security Manager Event Viewer.

 
    [bookmark: pgfId-404497]Signatures can produce false positives, because certain normal network activity can be construed as malicious. For example, some network applications or operating systems may send out numerous ICMP messages, which a signature-based detection system might interpret as an attempt by an attacker to map out a network segment. You can minimize false positives by editing your signature parameters (tuning your signatures).

 
    [bookmark: pgfId-404499]To configure a sensor to monitor network traffic for a particular signature, you must enable the signature. By default, the most critical signatures are enabled when you install the signature update. When an attack is detected that matches an enabled signature, the sensor generates an alert, which is stored in the event store of the sensor. The alerts, as well as other events, may be retrieved from the event store by web-based clients such as Event Viewer. By default the sensor logs all Informational alerts or higher.

 
    [bookmark: pgfId-404501]Some signatures have subsignatures, that is, the signature is divided into subcategories. When you configure a subsignature, changes made to the parameters of one subsignature apply only to that subsignature. For example, if you edit signature 3050 subsignature 1 and change the severity, the severity change applies to only subsignature 1 and not to 3050 2, 3050 3, and 3050 4.

 
    [bookmark: pgfId-404503]Cisco IPS contains over 10,000 built-in default signatures. You cannot rename or delete signatures from the list of built-in signatures, but you can retire signatures to remove them from the sensing engine. You can later activate retired signatures; however, this process requires the sensing engines to rebuild their configuration, which takes time and could delay the processing of traffic. You can tune built-in signatures by adjusting several signature parameters. Built-in signatures that have been modified are called tuned signatures.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-404505]Note We recommend that you retire any signatures that you are not using. This improves sensor performance.


    
     

    

    

 
    [bookmark: pgfId-404507]You can create signatures, which are called custom signatures. Custom signature IDs begin at 60000. You can configure them for several things, such as matching of strings on UDP connections, tracking of network floods, and scans. Each signature is created using a signature engine specifically designed for the type of traffic being monitored.

 
    [bookmark: pgfId-404509]For more about signatures, see:

 
     
     		 [bookmark: pgfId-404514]Obtaining Detailed Information About a Signature

 
     		 [bookmark: pgfId-404519]Understanding Signature Inheritance

 
    

 
    [bookmark: pgfId-404521]Related Topics

 
     
     		 [bookmark: pgfId-404526]Configuring Signatures

 
     		 [bookmark: pgfId-404531]Chapter 42, “Configuring Global Correlation”

 
    

 
     
      [bookmark: pgfId-404545][bookmark: 98531][bookmark: ipsvchap_cncpt_ObtainingDetailedInformationAboutaSignature]Obtaining Detailed Information About a Signature[bookmark: marker-404537][bookmark: marker-404539][bookmark: marker-404541][bookmark: marker-404543]

 
     [bookmark: pgfId-404549]You can find detailed information about each signature from the Cisco Security Intelligence Operations web site. The web site includes a wealth of information and best practice recommendations for network security, and you can set up IntelliShield alerts. There is education on advanced security topics to help you protect your network, prioritize remediation, and structure your systems to reduce organizational risk.

 
     [bookmark: pgfId-404556]When you edit the Signatures policy in Security Manager (see Signatures Page), the signature ID is linked directly into the Cisco Security Intelligence Operations database of IPS signatures. Clicking a signature ID opens a page containing information about the signature, including a description, the vulnerabilities on which the signature is based, when the signature was created, and so forth. You can search this database yourself at http://tools.cisco.com/security/center/search.x?search=Signature. (The database was formerly called the Cisco Network Security Database or NSDB.)

 
     [bookmark: pgfId-404558]If you do not have access to Cisco.com, then the signature ID is linked to a local copy of the signature database information. Security Manager detects whether you have access to Cisco.com and makes the appropriate link for you without your having to set a preference.

 
     [bookmark: pgfId-404560]The database includes information only for built-in, default signatures. You cannot find information about custom (user-defined) signatures.

 
     [bookmark: pgfId-404562]Beginning with Security Manager 4.4, the Signatures Page (IPS > Signatures > Signatures) contains an Explanation tab and a Related Threats tab for each signature. These tabs display detailed information in a separate window on the Signatures page. For example, the Explanation tab displays Description, Signature ID, and so forth; the Related Threats tab displays vulnerabilities for other software that you may be using, and so forth.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-404564]Tip If this window is not visible to you, expand it with the up arrow button in the bottom-left corner of the Signatures page. To hide this window, collapse it with the corresponding down arrow, also in the bottom-left corner of the Signatures page. You can resize this window with standard controls.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-404582][bookmark: 98558][bookmark: ipsvchap_proc_UnderstandingSignatureInheritance]Understanding Signature Inheritance[bookmark: marker-404570][bookmark: marker-404572][bookmark: marker-404574][bookmark: marker-404576][bookmark: marker-404578][bookmark: marker-404580]

 
     [bookmark: pgfId-404584]Signature inheritance for IPS devices is different than for any other Security Manager rules-based policy. Inheritance refers to the capability of Security Manager to enforce hierarchical lists of first-match, rule-based policies such as access rules. Signature inheritance is different because for IPS devices, Security Manager allows inheritance on a per-signature basis.

 
     [bookmark: pgfId-404586]This example shows what is meant by inheritance on a per-signature basis:

 
     
 
     [bookmark: pgfId-404588]Step 1 In Policy View, select IPS > Signatures > Signatures.

 
     [bookmark: pgfId-404590]Step 2 Create a policy named test1.

 
     [bookmark: pgfId-404592]Step 3 Create a second policy, named test2.

 
     [bookmark: pgfId-404594]Step 4 Right-click test 2 and select Inherit Signatures. The Inherit Rules—test 2 dialog box appears.

 
     [bookmark: pgfId-404596]Step 5 Select test1 and click the OK button.

 
     [bookmark: pgfId-404598]Step 6 Select test1 and edit a signature. Note the edit that you made and save your change.

 
     [bookmark: pgfId-404600]Step 7 Select test2 and select the signature that you just edited. Observe that test2 inherited the editing that you did on test1.

 
     [bookmark: pgfId-404602]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-404608][bookmark: 98609][bookmark: ipsvchap_cncpt_IPSSignaturePurge]IPS Signature Purge

 
     [bookmark: pgfId-404610]Beginning with Security Manager 4.1, old signature versions (defined as being older than the lowest signature level deployed) are purged during a periodic purge operation, the purpose of which is to optimize the database.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-404612]Note As a result of the purge operation, you may notice the deletion of some of your unused tuning contexts.


     
      

     

     

 
     [bookmark: pgfId-404614]Some of the purged signatures may be restored during your next download of IPS signature packages from Cisco.com.

 
     [bookmark: pgfId-404616]IPS signature purge is disabled by default. To enable IPS signature purge,

 
     
 
     [bookmark: pgfId-404618]Step 1 Stop the Cisco Security Manager Daemon Manager: At the command prompt, enter net stop crmdmgtd.

 
     [bookmark: pgfId-404620]Step 2 Navigate to NMSROOT\MDC\ips\etc\sensorupdate.properties file, where NMSROOT is the path to the Security Manager installation directory. The default is C:\Program Files\CSCOpx.

 
     [bookmark: pgfId-404622]Step 3 In sensorupdate.properties, change purgeUnusedSignautesEntriesinDB:false to purgeUnusedSignautesEntriesinDB:true.

 
     [bookmark: pgfId-404624]Step 4 Re-start the Cisco Security Manager Daemon Manager: At the command prompt, enter net start crmdmgtd.

 
     [bookmark: pgfId-404626]IPS signature purge now runs at midnight every day.

 
     [bookmark: pgfId-404628]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-404642][bookmark: 98632][bookmark: ipsvchap_cncpt_ConfiguringSignatures]Configuring Signatures[bookmark: marker-404634][bookmark: marker-404636][bookmark: marker-404638][bookmark: marker-404640]

 
    [bookmark: pgfId-404644]The Signatures policy is where you configure signatures for Cisco IPS sensors and Cisco IOS IPS devices.

 
    [bookmark: pgfId-404646]This section contains the following topics:

 
     
     		 [bookmark: pgfId-404651]Signatures Page

 
     		 [bookmark: pgfId-404656]Viewing Signature Update Levels

 
     		 [bookmark: pgfId-404661]Enabling and Disabling Signatures

 
     		 [bookmark: pgfId-404666]Editing Signatures

 
     		 [bookmark: pgfId-404671]Adding Custom Signatures

 
     		 [bookmark: pgfId-404676]Cloning Signatures

 
     		 [bookmark: pgfId-404681]Regular Expressions in Custom Signatures

 
     		 [bookmark: pgfId-404686]Editing Signature Parameters (Tuning Signatures)

 
    

 
     
      [bookmark: pgfId-404704][bookmark: 98650][bookmark: ipspage_cncpt_SignaturesPage]Signatures Page[bookmark: marker-404694][bookmark: marker-404696][bookmark: marker-404698][bookmark: marker-404700][bookmark: marker-404702]

 
     [bookmark: pgfId-404706]Use the Signatures page to display the signature summary table, in which you can add, edit, and delete IPS signatures. From this page you can tune the active signature set in a policy by enabling or disabling signatures. You can also use this page to unload signatures from the engine.

 
     [bookmark: pgfId-404714]Beginning with Version 4.6, Security Manager enables you to apply a signature threat profile to one or more signature policies, starting from IPS device version 7.3(1). A signature threat profile is a predefined signature template that includes customized tunings. These tunings adjust the signature coverage and response actions to enable the sensor to make better choices in various deployment and threat scenarios. This Signatures page displays the threat profile and its version, that has been applied to the policy. Click the To Change button to select a threat profile to apply to the policy. For more information, see Apply Signature Threat Profiles. To see the signatures that belong to a threat profile, filter the Source column to contain the text Threat Profile. For information about how to filter tables, see Filtering Tables

 
     [bookmark: pgfId-404716]If you download a particular signature package that does not contain one or more of the threat profiles already created in shared signature policy, Security Manager displays the warning message "Currently applied threat profile is not applicable to this signature version" on the shared signature Policy View. Similarly on the Device View, Security Manager displays the same warning message if you try to apply the shared signature policy to an unsupported device.

 
     [bookmark: pgfId-404718]Since threat profile updates cannot be performed separately, you must update the current signature version of the device if you want to update its threat profile version. Note that any update made to a threat profile version modifies the signatures associated with the threat profiles, but retains any user-defined signature tuning already performed by the user.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-404720]Note Threat profiles are not supported in IOS-IPS.


     
      

     

     

 
     [bookmark: pgfId-404722]Tips

 
      
      		 [bookmark: pgfId-404727]Enabled and disabled signatures are indicated by the "Enabled" checkbox for a particular signature. In previous releases of Security Manager, disabled signatures were indicated by hash marks covering the table row. When you deploy the configuration, disabled signatures are removed from the device. For more information, see Enabling and Disabling Signatures.

 
      		 [bookmark: pgfId-404732]For many columns, you can right-click the column and edit the property directly. Your edits apply to all rows that you have selected. If you select more than one row, the options that you can select are limited to those that are valid for all selected rows. The contents of the right-click menu differ on the basis of the cell that you right-click. For more information on the available commands, see Signature Shortcut Menu.

 
      		 [bookmark: pgfId-404734]To show or hide a column, right-click the table heading row on the signature summary table and then click  Show Columns . By default, all columns are shown.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-404736]Note Beginning with Version 4.5, Security Manager has a Notes column for each signature; this feature enables you to add a note so that you can revisit particular signatures later to see what you or other users have added for a signature or an event. This feature is helpful for network administrators in monitoring noisy signatures or signatures that need particular attention. However, the Notes column may not appear by default after you restore a Security Manager database. To show the Notes column, right-click the table heading row on the signature summary table, then click Show Columns, and finally click Notes. You may discover this situation during installation of Security Manager if you back up and restore the database; however, this situation will not occur during inline upgrades.


     
      

     

     

 
     [bookmark: pgfId-404738]Navigation Path

 
      
      		 [bookmark: pgfId-404740](Device view) Select  IPS > Signatures > Signatures from the Policy selector.

 
      		 [bookmark: pgfId-404742](Policy view, IPS appliances and service modules) Select  IPS > Signatures > Signatures , then select an existing policy or create a new one.

 
      		 [bookmark: pgfId-404744](Policy view, Cisco IOS IPS devices) Select  IPS (Router) > Signatures , then select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-404746]Related Topics

 
      
      		 [bookmark: pgfId-404751]Filtering Tables

 
      		 [bookmark: pgfId-404756]Table Columns and Column Heading Features

 
      		 [bookmark: pgfId-404761]Understanding Signatures

 
      		 [bookmark: pgfId-404766]Understanding Signature Inheritance

 
      		 [bookmark: pgfId-404771]Enabling and Disabling Signatures

 
      		 [bookmark: pgfId-404776]Cloning Signatures

 
      		 [bookmark: pgfId-404781]Editing Signature Parameters (Tuning Signatures)

 
      		 [bookmark: pgfId-404786]Configuring Event Action Filters

 
      		 [bookmark: pgfId-404791]Chapter 40, “Configuring Event Action Rules”

 
     

 
     [bookmark: pgfId-404793]Field Reference

 
     [bookmark: pgfId-404796] 

 
      
       
        
        [bookmark: pgfId-402628]Table 39-1 [bookmark: 98742]Signature Policy 

 
        
       
         
         		
           
           [bookmark: pgfId-402634]Element
          
  
         		
           
           [bookmark: pgfId-402636]Description
          
  
        

 
         
         		[bookmark: pgfId-402642]ID

  
         		[bookmark: pgfId-402647]The signature ID, which is the unique numerical value assigned to this signature. This value lets the sensor identify a particular signature. Click the ID number to open a page in your web browser with detailed information about the signature, as explained in Obtaining Detailed Information About a Signature.

  
        

 
         
         		[bookmark: pgfId-402653]Sub

  
         		[bookmark: pgfId-402655]The subsignature ID, which is the unique numerical value assigned to this subsignature. A Subsignature ID identifies a more granular version of a broad signature.

  
        

 
         
         		[bookmark: pgfId-402661]Name

  
         		[bookmark: pgfId-402663]The name assigned to the signature.

  
        

 
         
         		[bookmark: pgfId-402669]Enabled

  
         		[bookmark: pgfId-402671]A checkbox indicating whether the signature is enabled or disabled in this policy. A signature must be enabled for the sensor to protect against the traffic specified by the signature.

  
        

 
         
         		[bookmark: pgfId-402677]Severity

  
         		[bookmark: pgfId-402679]The severity level that the signature reports: High, Medium, Low, or Informational.

  
        

 
         
         		[bookmark: pgfId-402685]Fidelity

  
         		[bookmark: pgfId-402687]The weight associated with how well this signature might perform in the absence of specific knowledge of the target.

  
        

 
         
         		[bookmark: pgfId-402693]Notes

  
         		[bookmark: pgfId-402695]Enables you to add a note so that you can revisit particular signatures later to see what you or other users have added for a signature or an event. This feature is helpful for network administrators in monitoring noisy signatures or signatures that need particular attention.

 [bookmark: pgfId-402697]Notes are not saved to the device during deployment to the device. Notes as described here are a Security Manager GUI feature only and are disregarded during deployment to the device, as they are not part of any IPS policy in Security Manager.

 [bookmark: pgfId-402699]Notes are not part of any IPS policy, so assignment or inheritance of a shared signature policy will have no effect on Notes.

 [bookmark: pgfId-402701]Right-clicking a signature and adding notes will not prompt for activity/ticket creation. However, adding notes by double-clicking a signature or clicking the Edit button will prompt for activity/ticket creation because this involves signature policy modification.

 [bookmark: pgfId-402703]Notes cannot be added to signatures as part of a signature update operation. Other parameters can be edited, though.

 [bookmark: pgfId-402705]Notes cannot be searched by the Global Search feature.

 [bookmark: pgfId-402707]The Notes column will not display the Notes text. Only an icon will be displayed. You must double-click the icon to display the Notes text.

 [bookmark: pgfId-402709]If you use the "Export to File" button, then in the resultant .csv file, the Notes column will display only Y or N, and in this way signifies that those signatures were annotated. The actual text will not be exported.

 [bookmark: pgfId-402711]Notes cannot be edited. All added notes are appended to the existing notes as a new note entry. You can of course delete the note and add the updated note afresh.

 [bookmark: pgfId-402713]To add a note, right-click the row for a particular signature and then click Add Note. After you add the note, click Save and then close the Notes dialog box. After you close the Notes dialog box, the row for a particular signature will display a "Note" icon.

 [bookmark: pgfId-402715]To add a note to more than one signature, select the signatures you want (Shift-click or Ctrl-click in Windows) and proceed as you would for one particular signature.

 [bookmark: pgfId-402717]Notes can be local or shared. If you add a note to a device with only local policies, you can add, edit, and delete only local notes. If you add a note to a device with a shared policy assigned, you can add, edit, and delete both local and shared notes—check the Share this Note option. However, you can add notes only to that particular device (i.e., local override of notes) even if a shared policy is assigned.

 option in Device View. [bookmark: pgfId-402721]Tip You can also work with notes in the Edit Signature dialog box. Refer to Edit Button later in this table.  
        

 
         
         		[bookmark: pgfId-402727]Base RR

  
         		[bookmark: pgfId-402729]The base risk rating value of the signature.

  
        

 
         
         		[bookmark: pgfId-402735]Actions

  
         		[bookmark: pgfId-402737]The actions the sensor takes when this signature fires.

  
        

 
         
         		[bookmark: pgfId-402743]Source

  
         		[bookmark: pgfId-402745]The lowest policy in the inheritance hierarchy that overrides the settings for a signature. Values can be:

 
           
           		 [bookmark: pgfId-402747]Default—The signature uses the default Cisco-defined settings.

 
           		 [bookmark: pgfId-402749]Local—The signature is defined specifically for the selected device (Device view only.)

 
           		 [bookmark: pgfId-402751]Policy name—The lowest shared policy in the inheritance hierarchy. You can see policy names in Policy view, or in Device view if you assign a shared signature policy to the device.

 
          

  
        

 
         
         		[bookmark: pgfId-402757]Retired

  
         		[bookmark: pgfId-402759]The conditions under which the signature is retired, if any. A retired signature is removed from the signature engine. You can activate a retired signature to place it back in the signature engine.

 
           
           [bookmark: pgfId-402761]Timesaver Use the retired field to unload disabled signatures on your IOS-IPS device to achieve the most favorable memory consumption of that device.
          
 [bookmark: pgfId-402763]If the engine level of a signature policy is less than E-4, the Retired field has two possible values: false and true. False means that the signature is not retired; true means that the signature is retired.

 [bookmark: pgfId-402765]If the engine level of a signature policy is equal to E-4, the Retired field has four possible values:

 
           
           		 [bookmark: pgfId-402767] false —The signature is not retired.

 
           		 [bookmark: pgfId-402769] low-mem-retired —The signature should be retired on low-memory platforms. A low-memory device is one that has 2 GB RAM or less.

 
           		 [bookmark: pgfId-402771] med-mem-retired —The signature should be retired on both low-end and medium platforms. A medium-memory device is one that has 4 GB RAM or less, but more than 2 GB RAM. (Any device with more than 4 GB RAM is considered a high-memory platform.)

 
           		 [bookmark: pgfId-402773] true —The signature is retired on all platforms.

 
          

 [bookmark: pgfId-402775]When you select low-mem-retired or med-mem-retired, Security Manager configures the device with those signatures. Whether the signature is actually retired on the device depends on amount of memory installed on the device; the device makes the decision on which signatures are actually retired.

 in the row above.  
        

 
         
         		[bookmark: pgfId-402783]Engine

  
         		[bookmark: pgfId-402785]The engine that parses and inspects the traffic specified by this signature.

  
        

 
         
         		[bookmark: pgfId-402791]View Update Level button

 [bookmark: pgfId-402793](Device view only.)

  
         		[bookmark: pgfId-402798]Click this button view the signature update level for this device. For more information, see Viewing Signature Update Levels.

  
        

 
         
         		[bookmark: pgfId-402804]Export to File button

  
         		[bookmark: pgfId-402814]Click this button to export the signature summary for the current device to a comma-separated values (CSV) file. You are prompted to select the folder on the Security Manager server and to specify a file name.[bookmark: marker-402806][bookmark: marker-402808][bookmark: marker-402810][bookmark: marker-402812]

  
        

 
         
         		[bookmark: pgfId-402820]Add button

  
         		[bookmark: pgfId-402822]Click this button to add a custom signature. For more information, see the following topics:

 
           
           		 [bookmark: pgfId-402827]Adding Custom Signatures

 
           		 [bookmark: pgfId-402832]Edit Signature or Add Custom Signature Dialog Boxes

 
          

  
        

 
         
         		[bookmark: pgfId-402838]Edit button

  
         		[bookmark: pgfId-402840]Click this button to edit the selected signature. You can edit one signature at a time. For more information, see the following topics:

 
           
           		 [bookmark: pgfId-402845]Editing Signatures

 
           		 [bookmark: pgfId-402850]Edit Signature or Add Custom Signature Dialog Boxes

 
          

  
        

 
         
         		[bookmark: pgfId-402856]Delete button

  
         		[bookmark: pgfId-402858]Click this button to delete the selected custom signatures.

 [bookmark: pgfId-402860]You cannot delete Cisco-defined signatures. If you do not want to deploy a Cisco-defined signature, you can retire it or disable it.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-404814][bookmark: 98920][bookmark: ipsvchap_proc_ApplyThreatProfileDialogBox]Apply Signature Threat Profiles[bookmark: marker-404804][bookmark: marker-404806][bookmark: marker-404808][bookmark: marker-404810][bookmark: marker-404812]

 
     [bookmark: pgfId-404822]Use the Apply Threat Profile dialog box to select a signature threat profile from the available profiles and apply to the policy. Applying a threat profile modifies only the Enabled and Retired fields on the Signatures Page. After you have applied a particular threat profile to a policy, the corresponding signature tunings are merged with the existing signatures on the Signatures page. To see the signatures that belong to a threat profile, on the Signatures page, filter the Source column to contain the text Threat Profile. For information about how to filter tables, see Filtering Tables

 
     [bookmark: pgfId-404824]Select any of the following threat profiles that are currently provided by Cisco:

 
      
      		 [bookmark: pgfId-404826]SCADA—Select this threat profile template if you are using the Cisco IPS device primarily to protect industrial control systems. In addition to signatures in the default set, SCADA signature template includes specialized signatures for general SCADA protocol detections and specific identifiers that address tools and environments common to most device controlled environments.

 
      		 [bookmark: pgfId-404828]Edge—Select this threat profile template if you are using the Cisco IPS device primarily for securing an internet connection. In addition to signatures in the default set, Edge signature template includes additional signatures that provide broader protection for desktop operating systems, web browsers, web technologies, and common desktop applications.

 
      		 [bookmark: pgfId-404830]Web_Applications—Select this threat profile template if you are using the Cisco IPS device primarily for protecting web server farms. In addition to signatures in the default set, Web_Applications signature template includes additional signatures that provide broader protection for web servers, web development tools and frameworks, content management systems, load balancers, and databases.

 
      		 [bookmark: pgfId-404832]Data Center—Select this threat profile template if you are using the Cisco IPS device primarily for protecting data centers. In addition to signatures in the default set, Data Center signature template includes additional signatures that provide broader protection for server operating systems, web servers, application servers, databases, content management systems, messaging servers and virtualization systems.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-404834]Note Any signature tuning performed by the user on Local signatures (signatures defined for a selected device and for which the source policy is Local) will be preserved over the threat profile. For Default signatures, the threat profile tunings will be preserved.


     
      

     

     

 
     [bookmark: pgfId-404836]Navigation Path

 
      
      		 [bookmark: pgfId-404838](Device view) Select  IPS > Signatures > Signatures from the Policy selector.

 
      		 [bookmark: pgfId-404840](Policy view, IPS devices) Select  IPS > Signatures > Signatures , then select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-404842]Field Reference

 
     [bookmark: pgfId-404845] 

 
      
       
        
        [bookmark: pgfId-402873]Table 39-2 [bookmark: 98969]Threat Profile Details 

 
        
       
         
         		
           
           [bookmark: pgfId-402879]Element
          
  
         		
           
           [bookmark: pgfId-402881]Description
          
  
        

 
         
         		[bookmark: pgfId-402887]Signature ID

  
         		[bookmark: pgfId-402889]The signature ID, which is the unique numerical value assigned to this signature. This value lets the sensor identify a particular signature.

  
        

 
         
         		[bookmark: pgfId-402895]Sub Signature ID

  
         		[bookmark: pgfId-402897]The sub signature ID, which is the unique numerical value assigned to this sub signature. A sub signature ID identifies a more granular version of a broad signature.

  
        

 
         
         		[bookmark: pgfId-402903]Enabled

  
         		[bookmark: pgfId-402905]Indicates whether the signature is enabled or disabled in this threat profile. A signature must be enabled for the sensor to protect against the traffic specified by the signature.

  
        

 
         
         		[bookmark: pgfId-402911]Retired

  
         		[bookmark: pgfId-402913]Indicates whether the signature is retired or active in this threat profile.

  
        

 
         
         		[bookmark: pgfId-402919]Has Conflict

  
         		[bookmark: pgfId-402921]Indicates whether a signature with tunings from the applied threat profile also has tunings performed by the user. Signatures that are tuned by the user and by the applied threat profile are flagged as True in the Has Conflict column. If there is no conflict between the applied threat profile and user tunings for a signature, the Has Conflict column for that signature shows False.

 [bookmark: pgfId-402923]Note Any signature tuning performed by the user on Local signatures (signatures defined for a selected device and for which the source policy is Local) will be preserved over the threat profile. For Default signatures, the threat profile tunings will be preserved.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-404861][bookmark: 99006][bookmark: ipspage_cncpt_RowShortcutMenu]Signature Shortcut Menu[bookmark: marker-404851][bookmark: marker-404853][bookmark: marker-404855][bookmark: marker-404857][bookmark: marker-404859]

 
     [bookmark: pgfId-404866]Right-clicking inside the signature summary table in the Signatures policy displays a shortcut menu for performing various functions on the selected signatures. Some commands appear only if you select a single signature, while some commands can be used on more than one signature at a time; your changes apply to all selected signatures. For more information about the Signatures policy, see Signatures Page.

 
     [bookmark: pgfId-404868]Additionally, the available commands differ depending on which cell you right click. Some commands are available when right-clicking any cell, while others are specific to a single cell.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-404870]Tip When you use a right-click command to change the value in a cell of a Default signature, the signature is converted to a Local signature in Device view or a shared-policy-specific signature in Policy view.


     
      

     

     

 
      
       
        
        [bookmark: pgfId-402936]Table 39-3 [bookmark: 99032]Signature Shortcut Menu 

 
        
       
         
         		
           
           [bookmark: pgfId-402942]Menu Command
          
  
         		
           
           [bookmark: pgfId-402944]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-402950]Commands Available for All Cells
          
  
        

 
         
         		[bookmark: pgfId-402958]Add Row

  
         		[bookmark: pgfId-402960]Adds a custom signature. For more information, see the following topics:

 
           
           		 [bookmark: pgfId-402965]Adding Custom Signatures

 
           		 [bookmark: pgfId-402970]Edit Signature or Add Custom Signature Dialog Boxes

 
          

  
        

 
         
         		[bookmark: pgfId-402976]Edit Row

  
         		[bookmark: pgfId-402978]Edits the selected signature. You can edit one signature at a time. For more information, see the following topics:

 
           
           		 [bookmark: pgfId-402983]Editing Signatures

 
           		 [bookmark: pgfId-402988]Edit Signature or Add Custom Signature Dialog Boxes

 
          

  
        

 
         
         		[bookmark: pgfId-402994]Delete Row

  
         		[bookmark: pgfId-402996]Deletes the selected custom signatures.

 [bookmark: pgfId-402998]You cannot delete Cisco-defined signatures. If you do not want to deploy a Cisco-defined signature, you can retire it or disable it.

  
        

 
         
         		[bookmark: pgfId-403004]Clone

  
         		[bookmark: pgfId-403009]Creates a new custom signature that contains the same properties as the selected signature. For more information, see Cloning Signatures.

  
        

 
         
         		[bookmark: pgfId-403015]Enable, Disable

  
         		[bookmark: pgfId-403020]Places the signature in the enabled or disabled state, respectively. Disabled signatures appear with crosshatching over them. For more information, see Enabling and Disabling Signatures.

  
        

 
         
         		[bookmark: pgfId-403026]Show Events

 [bookmark: pgfId-403028]Show MARS Events

  
         		[bookmark: pgfId-403036]Enables navigation to the Event Viewer or Cisco Security MARS application to view the realtime or historical events detected by the selected signature. For more information, see Viewing Events for an IPS Signature and Viewing CS-MARS Events for an IPS Signature.

  
        

 
         
         		 
           
           [bookmark: pgfId-403042]Action Cell Commands
          
  
        

 
         
         		[bookmark: pgfId-403050]Add to Actions

  
         		[bookmark: pgfId-403052]Adds an action to the current list of actions for the selected signature.

  
        

 
         
         		[bookmark: pgfId-403058]Delete from Actions

  
         		[bookmark: pgfId-403060]Deletes an action from the current list of actions for the selected signature.

  
        

 
         
         		[bookmark: pgfId-403066]Replace Actions With

  
         		[bookmark: pgfId-403068]Replace the current set of actions for the selected signature with the single action selected. If you want to select more than one action, select More from the submenu, then use Ctrl+click to select the desired actions.

  
        

 
         
         		[bookmark: pgfId-403074]Edit Actions

  
         		[bookmark: pgfId-403079]Opens the Edit Actions dialog box, where you can select the desired actions for the signature. Your selection replaces the current list of actions for the signature. For more information, see Edit, Add, Replace Action Dialog Boxes.

  
        

 
         
         		 
           
           [bookmark: pgfId-403085]Severity Cell Commands
          
  
        

 
         
         		
           
           		 [bookmark: pgfId-403093]High

 
           		 [bookmark: pgfId-403095]Medium

 
           		 [bookmark: pgfId-403097]Low

 
           		 [bookmark: pgfId-403099]Informational

 
          

  
         		[bookmark: pgfId-403101]Changes the severity level of the signature to the level you select.

  
        

 
         
         		 
           
           [bookmark: pgfId-403107]Fidelity Cell Commands
          
  
        

 
         
         		[bookmark: pgfId-403115]Edit Fidelity

  
         		[bookmark: pgfId-403117]Changes the fidelity rating of the signature, which is the weight associated with how well this signature might perform in the absence of specific knowledge of the target.

  
        

 
         
         		 
           
           [bookmark: pgfId-403123]Retired Cell Commands
          
  
        

 
         
         		
           
           		 [bookmark: pgfId-403131]Retire

 
           		 [bookmark: pgfId-403133]Activate

 
           		 [bookmark: pgfId-403135]Retire on Low Memory

 
           		 [bookmark: pgfId-403137]Retire on Medium Memory

 
          

  
         		[bookmark: pgfId-403142]Changes the retired status of the signature to the selected status. For more information about the retired status categories, see Edit Signature or Add Custom Signature Dialog Boxes.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-404885][bookmark: 99172][bookmark: ipspage_cncpt_EditActionsDialogBox]Edit, Add, Replace Action Dialog Boxes[bookmark: marker-404883]

 
     [bookmark: pgfId-404890]Use the Edit, Add, or Replace Action dialog boxes to change the actions defined for a signature. These dialog boxes are available only when you edit the Action cell using the right click menu as explained in Signature Shortcut Menu. The behavior differs depending on the dialog box name:

 
      
      		 [bookmark: pgfId-404892]Add Actions—The actions that you select are added to those already defined in the signature. To open this dialog box, right-click the Actions cell of a signature and select  Add to Actions > More .

 
      		 [bookmark: pgfId-404894]Replace Actions—The actions that you select completely replace those defined in the signature. To open this dialog box, right-click the Actions cell of a signature and select  Replace Actions With > More .

 
      		 [bookmark: pgfId-404896]Edit Actions—The actions that you select completely replace those defined in the signature. To open this dialog box, right-click the Actions cell of a signature and select  Edit Actions .

 
     

 
     [bookmark: pgfId-404901]For an explanation of the available actions, see Understanding IPS Event Actions. You can select multiple actions using Ctrl+click.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-404903]Note When you open dialog box, the list of actions that you see varies. The list of actions depends upon whether you right-click in only one signature row in the Actions column or select more than one signature row before right-clicking in the Actions column. If you right-click in only one signature row in the Actions column, the list of actions is that of the engine for that signature. If you select more than one signature row before right-clicking in the Actions column, the list of actions is that which is available for each affected engine. (It is the list of common actions, not the union of actions.)


     
      

     

     

 
    
 
     
      [bookmark: pgfId-404913][bookmark: 99194][bookmark: ipspage_cncpt_EditFidelityDialogBox]Edit Fidelity Dialog Box[bookmark: marker-404911]

 
     [bookmark: pgfId-404915]Use the Edit Fidelity dialog box to make changes in the Fidelity Rating for a particular signature. The Fidelity Rating, or Signature Fidelity Rating (SFR), identifies the weight associated with how well this signature might perform in the absence of specific knowledge of the target. This rating can be any number from 0 to 100, with 100 indicating the most confidence in the signature.

 
     [bookmark: pgfId-404917]Navigation Path

 
     [bookmark: pgfId-404925]In the Signatures policy, right-click the Fidelity cell in a signature and select Edit Fidelity. For information on opening the Signatures policy, see Signatures Page. For more information on the signature shortcut menu, see Signature Shortcut Menu.

 
    
 
     
      [bookmark: pgfId-404941][bookmark: 99208][bookmark: ipspage_cncpt_UpdateLevelDialogBox]Viewing Signature Update Levels[bookmark: marker-404931][bookmark: marker-404933][bookmark: marker-404935][bookmark: marker-404937][bookmark: marker-404939]

 
     [bookmark: pgfId-404943]In Device view, you can determine the current signature update packages applied to the device in Security Manager and compare it to the one deployed on the device.

 
     [bookmark: pgfId-404945]Differences between the applied and deployed update levels can occur when:

 
      
      		 [bookmark: pgfId-404947]The device is updated outside of Security Manager.

 
      		 [bookmark: pgfId-404949]An update is applied to the policy in Security Manager but not yet published to the device.

 
      		 [bookmark: pgfId-404951]During initial Security Manager deployment before the devices are under Security Manager control.

 
     

 
     [bookmark: pgfId-404953]To view the signature update level, select the IPS > Signatures > Signatures policy for an IPS device in Device view. Then, click the View Update Level button to open the Update Level dialog box.

 
      
       
        
        [bookmark: pgfId-403155]Table 39-4 [bookmark: 99241]Update Level Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-403161]Element
          
  
         		
           
           [bookmark: pgfId-403163]Description
          
  
        

 
         
         		[bookmark: pgfId-403169]Applied Level

  
         		[bookmark: pgfId-403171]This column displays the patch level that is applied to this device in Security Manager.

  
        

 
         
         		[bookmark: pgfId-403177]Deployed Level

  
         		[bookmark: pgfId-403179]This column displays the patch level that is currently running on the selected device.

  
        

 
         
         		[bookmark: pgfId-403185]Major Update

  
         		[bookmark: pgfId-403187]Identifies the major update level.

  
        

 
         
         		[bookmark: pgfId-403193]Minor Update

  
         		[bookmark: pgfId-403195]Identifies the minor update level.

  
        

 
         
         		[bookmark: pgfId-403201]Service Pack

  
         		[bookmark: pgfId-403203]Identifies the service pack level.

  
        

 
         
         		[bookmark: pgfId-403209]Patch

  
         		[bookmark: pgfId-403211]Identifies the patch level.

  
        

 
         
         		[bookmark: pgfId-403217]Engine

  
         		[bookmark: pgfId-403219]Identifies the engine level.

  
        

 
         
         		[bookmark: pgfId-403225]Signature Update

  
         		[bookmark: pgfId-403227]Identifies the signature update level.

 [bookmark: pgfId-403229]Note This field is the only field on this page that applies to the IOS IPS devices; all of the other fields are exclusive to IPS devices.

  
        

 
         
         		[bookmark: pgfId-403235]Revert button

  
         		[bookmark: pgfId-403237]If you mistakenly modify Applied Level, allows you to discard that new Applied Level; clicking Revert syncs the Applied Level to the Deployed Level.

 [bookmark: pgfId-403239]Tip A warning dialog appears before performing Revert. Also, a warning dialog appears asking you to submit the activity.  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-404972][bookmark: 99300][bookmark: ipsvchap_proc_EnablingandDisablingSignatures]Enabling and Disabling Signatures[bookmark: marker-404964][bookmark: marker-404966][bookmark: marker-404968][bookmark: marker-404970]

 
     [bookmark: pgfId-404974]You can enable and disable individual signatures. Your change takes effect when you redeploy the configuration to the device.

 
     [bookmark: pgfId-404976]If a signature is disabled, it appears in the table overlain with hash marks. When you deploy the configuration, disabled signatures are removed from the device.

 
     [bookmark: pgfId-404978]Disabling signatures is useful when you want to reduce the number of signatures used by a device, or if you want to temporarily stop using a custom signature without deleting it. You can later reenable a signature that you disabled.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-404980]Note You can enable a signature that is retired, but it then is not used to scan traffic, because it is not in the signature micro-engine. If you want a sensor to scan network traffic for a particular signature, you must enable it and not retire it. The AIP-SSC-5 does not support enabling a signature that is retired.


     
      

     

     

 
     
 
     [bookmark: pgfId-404982]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-404984](Device view) Select  IPS > Signatures > Signatures from the Policy selector.

 
      		 [bookmark: pgfId-404986](Policy view, IPS appliances and service modules) Select  IPS > Signatures > Signatures , then select an existing policy or create a new one.

 
      		 [bookmark: pgfId-404988](Policy view, Cisco IOS IPS devices) Select  IPS (Router) > Signatures , then select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-404993]The Signature page appears; see Signatures Page.

 
     [bookmark: pgfId-404995]Step 2 Right-click the signature whose enabled status you want to change and select Enable or Disable, as appropriate.

 
     [bookmark: pgfId-404997]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-405011][bookmark: 99343][bookmark: ipsvchap_proc_EditingSignaturesSeverityFidelityRatingandAction]Editing Signatures[bookmark: marker-405003][bookmark: marker-405005][bookmark: marker-405007][bookmark: marker-405009]

 
     [bookmark: pgfId-405013]You can edit signatures to change their behavior. For example, you can change the action that should be taken when a signature fires, or the severity and fidelity ratings used to calculate the risk rating of the signature.

 
     [bookmark: pgfId-405015]Some signatures have special requirements. For example, to configure a sensor to detect ACL violation signatures, you must first configure one or more Cisco IOS routers to log ACL violations. Then, you must configure those routers to communicate with the sensor. Finally, you must configure the sensor to accept syslog traffic from those routers.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-405020]Tip This procedure describes how to edit an entire signature. You can also selectively edit individual properties of a signature using the right-click menu in the Signatures policy. For information on the available commands, see Signature Shortcut Menu.


     
      

     

     

 
     [bookmark: pgfId-405022]Related Topics

 
      
      		 [bookmark: pgfId-405027]Understanding Signatures

 
      		 [bookmark: pgfId-405032]Understanding IPS Event Actions

 
      		 [bookmark: pgfId-405037]Enabling and Disabling Signatures

 
      		 [bookmark: pgfId-405042]Cloning Signatures

 
      		 [bookmark: pgfId-405047]Configuring Event Action Filters

 
      		 [bookmark: pgfId-405052]Chapter 40, “Configuring Event Action Rules”

 
     

 
     
 
     [bookmark: pgfId-405054]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-405056](Device view) Select  IPS > Signatures > Signatures from the Policy selector.

 
      		 [bookmark: pgfId-405058](Policy view, IPS appliances and service modules) Select  IPS > Signatures > Signatures , then select an existing policy or create a new one.

 
      		 [bookmark: pgfId-405060](Policy view, Cisco IOS IPS devices) Select  IPS (Router) > Signatures , then select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-405065]The Signature page appears; see Signatures Page.

 
     [bookmark: pgfId-405067]Step 2 Right-click the signature you want to edit and select Edit Row. You can also select the signature and click the Edit Row (pencil) button beneath the signatures table. The Edit Signature dialog box opens.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-405072]Tip Use the filter fields above the table to help you find the desired signature. For information on filtering tables, see Filtering Tables.


     
      

     

     

 
     [bookmark: pgfId-405077]Step 3 Make the desired changes to the signature. For specific details about each option, see Edit Signature or Add Custom Signature Dialog Boxes.

 
     [bookmark: pgfId-405079]When editing signatures, keep the following in mind:

 
      
      		 [bookmark: pgfId-405081]You cannot edit a Default signature. Default signatures are the Cisco-defined version of a signature. Before you can edit a Default signature, you must convert it either to a Local signature (one defined specifically on the selected device) or a shared-policy-specific signature (one defined in a shared policy). You must select either Local or the shared policy name from the Source Policy field before you can change any field on the Edit Signature dialog box.

 
      		 [bookmark: pgfId-405083]You cannot change every characteristic of a signature. For example, you cannot change the signature or subsignature IDs. These fields are read-only.

 
      		 [bookmark: pgfId-405088]If you want to change the detailed parameters of a signature, follow the procedure described in Editing Signature Parameters (Tuning Signatures).

 
     

 
     [bookmark: pgfId-405090]Step 4 Click OK to save your changes.

 
     [bookmark: pgfId-405092]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-405106][bookmark: 99422][bookmark: ipspage_cncpt_EditSignatureDialogBox]Edit Signature or Add Custom Signature Dialog Boxes[bookmark: marker-405102][bookmark: marker-405104]

 
     [bookmark: pgfId-405108]The Edit Signature and Add Custom Signature dialog boxes are essentially the same. Most of the fields are identical, although there are some layout differences. Use these dialog boxes as follows:

 
      
      		 [bookmark: pgfId-405110]Use the Edit Signature dialog box to edit the characteristics of a non-default signature (you can only view the characteristics of a default signature in read-only mode).

 
     

 
     [bookmark: pgfId-405112]You cannot edit default signatures. To make any changes to a signature, you must select something other than Default in the Source Policy field at the top of the dialog box.

 
      
      		 [bookmark: pgfId-405114]Use the Add Custom Signature dialog box to create a custom signature. In the Add Custom Signature dialog box, you enter a name and then select an existing engine from a drop-down list. The signature ID and subsignature ID are assigned by Security Manager. After you finish selecting the remaining parameters, the new signature is added to the Signatures page in the appropriate numerical location, and it is selected.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-405116]Note Beginning with Security Manager 4.4, you can specify a signature ID and a subsignature ID while adding a custom signature. If you specify a signatureID/subsignature ID combination that already exists, you will receive an error message.


     
      

     

     

 
     [bookmark: pgfId-405118]Navigation Path

 
     [bookmark: pgfId-405120]From the Signatures page:

 
      
      		 [bookmark: pgfId-405122]To edit a signature, right-click the policy you want to edit and select  Edit Row .

 
      		 [bookmark: pgfId-405124]To add a custom signature, click the  Add Row (+) button beneath the table, or right-click any row and select  Add Row .

 
     

 
     [bookmark: pgfId-405129]For information on opening the Signature page, see Signatures Page.

 
     [bookmark: pgfId-405131]Related Topics

 
      
      		 [bookmark: pgfId-405136]Edit, Add, Replace Action Dialog Boxes

 
      		 [bookmark: pgfId-405141]Edit Signature Parameters Dialog Box

 
      		 [bookmark: pgfId-405146]Engine Options

 
     

 
     [bookmark: pgfId-405148]Field Reference

 
     [bookmark: pgfId-405151] 

 
      
       
        
        [bookmark: pgfId-403252]Table 39-5 [bookmark: 99467]Edit Signature or Add Custom Signature Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-403258]Element
          
  
         		
           
           [bookmark: pgfId-403260]Description
          
  
        

 
         
         		[bookmark: pgfId-403266]Source Policy

 [bookmark: pgfId-403268](Edit signature only.)

  
         		[bookmark: pgfId-403270]The policy in which you are editing the signature:

 
           
           		 [bookmark: pgfId-403272]Default—The default Cisco-defined signature, which you cannot edit. You must select something other than Default to edit the signature.

 
           		 [bookmark: pgfId-403274]Local—The signature is a local signature defined specifically for the selected device. This option is not available in Policy view.

 
           		 [bookmark: pgfId-403276]Policy name (variable)—The name of a shared policy. In Device view, a policy name is available only if you assign a shared policy to the device. In Policy view, this is the name of the policy you are editing. Select the policy name to edit the signature and to have your edits reflected on all devices that are assigned the shared policy.

 
          

  
        

 
         
         		[bookmark: pgfId-403282]Name

 [bookmark: pgfId-403284](Add only.)

  
         		[bookmark: pgfId-403286]The name of the signature.

 [bookmark: pgfId-403288]You cannot change the name after you create the signature. If you want to change the name, you must create a clone of the signature.

  
        

 
         
         		[bookmark: pgfId-403294]SigID

 [bookmark: pgfId-403296](Add only.)

  
         		[bookmark: pgfId-403298]The signature ID that you specify while adding a custom signature.

 [bookmark: pgfId-403300]The allowed range of values is 60000 - 65000.

  
        

 
         
         		[bookmark: pgfId-403306]SubSigID

 [bookmark: pgfId-403308](Add only.)

  
         		[bookmark: pgfId-403310]The subsignature ID that you specify while adding a custom signature.

 [bookmark: pgfId-403312]The allowed range of values is 0 - 255.

  
        

 
         
         		[bookmark: pgfId-403318]Inheritance Mandatory

 [bookmark: pgfId-403320](Edit signature only.)

  
         		[bookmark: pgfId-403322]When selected, forces any policy that inherits from this policy to use the signature settings defined.

  
        

 
         
         		[bookmark: pgfId-403328]Enabled

  
         		[bookmark: pgfId-403330]Whether the signature is enabled.

  
        

 
         
         		[bookmark: pgfId-403336]Severity

  
         		[bookmark: pgfId-403338]The severity level that the signature will report: High, Medium, Low, or Informational.

  
        

 
         
         		[bookmark: pgfId-403344]Fidelity Rating

  
         		[bookmark: pgfId-403346]The weight associated with how well this signature might perform in the absence of specific knowledge of the target.

  
        

 
         
         		[bookmark: pgfId-403352]Actions

  
         		[bookmark: pgfId-403357]The actions that the sensor will take when this signature fires. For a complete list of actions, see the Understanding IPS Event Actions.

 [bookmark: pgfId-403359]Use Ctrl+click to select multiple actions.

  
        

 
         
         		[bookmark: pgfId-403365]Base Risk Rating

 [bookmark: pgfId-403367]Risk Rating

 [bookmark: pgfId-403369](Fields have slightly different names when adding or editing signatures.)

  
         		[bookmark: pgfId-403371]The base risk rating value of the signature, which is calculated by multiplying the fidelity rating and the severity factor and dividing them by 100 (Fidelity Rating x Severity Factor /100). This value is read only; you cannot directly change it. To change the value, alter the Severity and Fidelity fields.

 [bookmark: pgfId-403373]The Severity Factor has the following values based on what you select in the Severity field:

 
           
           		 [bookmark: pgfId-403375]High = 100

 
           		 [bookmark: pgfId-403377]Medium = 75

 
           		 [bookmark: pgfId-403379]Low = 50

 
           		 [bookmark: pgfId-403381]Informational = 25

 
          

  
        

 
         
         		[bookmark: pgfId-403387]Engine

 [bookmark: pgfId-403389](Read-only when editing; read-write when adding custom signatures.)

  
         		[bookmark: pgfId-403394]The engine that parses and inspects the traffic specified by this signature. For a description of the engines, see Engine Options.

 [bookmark: pgfId-403398]When adding a custom signature, you must select the appropriate engine. For detailed information about each engine, and the parameters available, see the “Signature Engines” section in the Installing and Using Cisco Intrusion Prevention System Device Manager document for the IPS Software release you are using.

 used in the row below.  
        

 
         
         		[bookmark: pgfId-403406]Retired

  
         		[bookmark: pgfId-403408]The conditions under which the signature is retired, if any. A retired signature is removed from the signature engine. You can activate a retired signature to place it back in the signature engine.

 
           
           [bookmark: pgfId-403410]Timesaver Use the retired field to unload disabled signatures on your IOS-IPS device to achieve the most favorable memory consumption of that device.
          
 [bookmark: pgfId-403412]If the engine level of a signature policy is less than E-4, the Retired field has two possible values: false and true. False means that the signature is not retired; true means that the signature is retired.

 [bookmark: pgfId-403414]If the engine level of a signature policy is equal to E-4, the Retired field has four possible values:

 
           
           		 [bookmark: pgfId-403416] false —The signature is not retired.

 
           		 [bookmark: pgfId-403418] low-mem-retired —The signature should be retired on low-memory platforms. A low-memory device is one that has 2 MB RAM or less.

 
           		 [bookmark: pgfId-403420] med-mem-retired —The signature should be retired on both low-end and medium platforms. A medium-memory device is one that has 4 MB RAM or less, but more than 2 MB RAM. (Any device with more than 4 MB RAM is considered a high-memory platform.)

 
           		 [bookmark: pgfId-403422] true —The signature is retired on all platforms.

 
          

 [bookmark: pgfId-403424]When you select low-mem-retired or med-mem-retired, Security Manager configures the device with those signatures. Whether the signature is actually retired on the device depends on amount of memory installed on the device; the device makes the decision on which signatures are actually retired.

 in the row above.  
        

 
         
         		[bookmark: pgfId-403432]Obsolete

 [bookmark: pgfId-403434](Edit signature only.)

  
         		[bookmark: pgfId-403436]Identifies whether the signature is obsolete. An obsolete signature is removed from the signature engine. It cannot be re-activated.

  
        

 
         
         		[bookmark: pgfId-403442]Restore Defaults button

 [bookmark: pgfId-403444](Non-custom signatures only. Edit signature only.)

  
         		[bookmark: pgfId-403446]Click this button to revert to default values for this signature as defined by Cisco.

  
        

 
         
         		[bookmark: pgfId-403452]Edit Parameters button

  
         		[bookmark: pgfId-403454]Click this button to edit the detailed parameters for this signature using the Edit Signature Parameters dialog box. For more information, see the following topics:

 
           
           		 [bookmark: pgfId-403459]Edit Signature Parameters Dialog Box

 
           		 [bookmark: pgfId-403464]Editing Signature Parameters (Tuning Signatures)

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-405165][bookmark: 99624][bookmark: ipsvchap_proc_AddingCustomSignatures]Adding Custom Signatures[bookmark: marker-405157][bookmark: marker-405159][bookmark: marker-405161][bookmark: marker-405163]

 
     [bookmark: pgfId-405167]If you want to look for traffic patterns that are not identified by the built-in signatures, you can create your own custom signatures to define the traffic patterns.

 
     [bookmark: pgfId-405172]Even if a built-in signature covers the traffic pattern, you might want to create a custom signature to edit the detailed signature parameters without altering the default signature. If you are creating a custom signature that is similar to an existing signature, the easiest way to do it is to clone the signature as described in Cloning Signatures.

 
     [bookmark: pgfId-405177]When adding a custom signature to some IPS devices, you can use regular expressions. For more information on the importance of proper syntax when using regular expressions, refer to Regular Expressions in Custom Signatures

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-405179]Note The AIP-SSC-5 does not support custom signatures.


     
      

     

     

 
     
 
     [bookmark: pgfId-405181]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-405183](Device view) Select  IPS > Signatures > Signatures from the Policy selector.

 
      		 [bookmark: pgfId-405185](Policy view, IPS appliances and service modules) Select  IPS > Signatures > Signatures , then select an existing policy or create a new one.

 
      		 [bookmark: pgfId-405187](Policy view, Cisco IOS IPS devices) Select  IPS (Router) > Signatures , then select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-405192]The Signature page appears; see Signatures Page.

 
     [bookmark: pgfId-405194]Step 2 Click the Add Row (+) button beneath the signature table to open the Add Custom Signature dialog box.

 
     [bookmark: pgfId-405199]Step 3 Configure the desired settings. For specific details about each option, see Edit Signature or Add Custom Signature Dialog Boxes.

 
     [bookmark: pgfId-405201]When creating signatures, keep the following in mind:

 
      
      		 [bookmark: pgfId-405203]You cannot change the signature name after you define the signature. If you later want to change the name, you must clone the signature and change it while creating the clone.

 
      		 [bookmark: pgfId-405208]Select the appropriate signature engine for the signature. For a description of the signature engines, see Engine Options. You cannot change the engine after you create the signature; if you select the wrong engine and click OK to save the signature, you must start over and create an entirely new signature.

 
      		 [bookmark: pgfId-405210]The default is to create an enabled signature, but you can deselect the Enabled check box to initially create a disabled signature. You might want to disable the signature if you have not finished editing its parameters.

 
      		 [bookmark: pgfId-405215]Follow the procedure described in Editing Signature Parameters (Tuning Signatures) to define the detailed signature parameters. You must select the desired engine before you edit the parameters, because many of the parameters are determined by the signature engine.

 
     

 
     [bookmark: pgfId-405217]Whether you can save the signature before configuring parameters differs based on the engine that you select. At minimum, you must click Edit Parameters to open the Edit Signature Parameters dialog box, and then click OK in the Edit Signature Parameters dialog box, before you can save the signature definition. However, to create a meaningful signature, you will need to configure the parameters to identify the desired traffic pattern.

 
     [bookmark: pgfId-405219]Step 4 Click OK to save your changes.

 
     [bookmark: pgfId-405221]The custom signature is added to the end of the table and given the next available signature ID starting at 60000.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-405223]Note Beginning with Security Manager 4.4, you can specify a signature ID and a subsignature ID while adding a custom signature. If you specify a signatureID/subsignature ID combination that already exists, you will receive an error message.


     
      

     

     

 
     [bookmark: pgfId-405225]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-405239][bookmark: 99690][bookmark: ipspage_cncpt_EngineOptions]Engine Options[bookmark: marker-405231][bookmark: marker-405233][bookmark: marker-405235][bookmark: marker-405237]

 
     [bookmark: pgfId-405243]The following list identifies the options you can specifying in the Engine field of the Edit Signature Parameters dialog box. For detailed information about each engine, and the parameters available, see the “Signature Engines” section in the Installing and Using Cisco Intrusion Prevention System Device Manager document for the IPS Software release you are using.

 
      
      		 [bookmark: pgfId-405245]AIC FTP—Inspects FTP traffic and lets you control the commands being issued.

 
      		 [bookmark: pgfId-405247]AIC HTTP—Provides granular control over HTTP sessions to prevent abuse of the HTTP protocol.

 
      		 [bookmark: pgfId-405249]Atomic ARP—Inspects Layer-2 ARP protocol. The Atomic ARP engine is different because most engines are based on Layer-3-IP.

 
      		 [bookmark: pgfId-405251]atomic-ip—Inspects IP protocol packets and associated Layer-4 transport protocols.

 
      		 [bookmark: pgfId-405253]Atomic IPv6—Detects IOS vulnerabilities that are stimulated by malformed IPv6 traffic.

 
      		 [bookmark: pgfId-405255]Flood Host—Detects ICMP and UDP floods directed at hosts.

 
      		 [bookmark: pgfId-405257]Flood Net—Detects ICMP and UDP floods directed at networks.

 
      		 [bookmark: pgfId-405259]Meta—Defines events that occur in a related manner within a sliding time interval. This engine processes events rather than packets.

 
      		 [bookmark: pgfId-405261]multi-string—Defines signatures that inspect Layer 4 transport protocol (ICMP, TCP, and UDP) payloads using multiple string matches for one signature. You can specify a series of regular expression patterns that must be matched to fire the signature.

 
      		 [bookmark: pgfId-405263]normalizer—Configures how the IP and TCP normalizer functions and provides configuration for signature events related to the IP and TCP normalizer. Allows you to enforce RFC compliance.

 
      		 [bookmark: pgfId-405265]service-dns—Inspects DNS (TCP and UDP) traffic.

 
      		 [bookmark: pgfId-405267]service-ftp—Inspects FTP traffic.

 
      		 [bookmark: pgfId-405269]Service Generic—Decodes custom service and payload.

 
     

 
     [bookmark: pgfId-405271]The Service Generic engine allows programmatic signatures to be issued in a config-file-only signature update. It has a simple machine and assembly language that is defined in the configuration file. It runs the machine code (distilled from the assembly language) through its virtual machine, which processes the instructions and pulls the important pieces of information out of the packet and runs them through the comparisons and operations specified in the machine code. It is intended as a rapid signature response engine to supplement the String and State engines.

 
     [bookmark: pgfId-405273]You cannot use the Service Generic engine to create custom signatures.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-405275]Note Due to the proprietary nature of this complex language, we do not recommend that you edit the Service Generic engine signature parameters. Change only the severity and event action for these signatures.


     
      

     

     

 
      
      		 [bookmark: pgfId-405277]Service Generic Advanced—Generically analyzes network protocols.

 
      		 [bookmark: pgfId-405279]Service H225—Inspects VoIP traffic.

 
      		 [bookmark: pgfId-405281]service-http—Inspects HTTP traffic. The WEBPORTS variable defines inspection port for HTTP traffic.

 
      		 [bookmark: pgfId-405283]Service IDENT—Inspects IDENT (client and server) traffic.

 
      		 [bookmark: pgfId-405285]Service MSRPC—Inspects MSRPC traffic.

 
      		 [bookmark: pgfId-405287]Service MSSQL—Inspects Microsoft SQL traffic.

 
      		 [bookmark: pgfId-405289]Service NTP—Inspects NTP traffic.

 
      		 [bookmark: pgfId-405291]service-rpc—Inspects RPC traffic.

 
      		 [bookmark: pgfId-405293]Service SMB—Inspects SMB traffic.

 
      		 [bookmark: pgfId-405295]Service SMB Advanced—Processes Microsoft SMB and Microsoft RPC over SMB packets.

 
      		 [bookmark: pgfId-405297]Service SNMP—Inspects SNMP traffic.

 
      		 [bookmark: pgfId-405299]Service SSH—Inspects SSH traffic.

 
      		 [bookmark: pgfId-405301]Service TNS—Inspects TNS traffic.

 
      		 [bookmark: pgfId-405303]state—Stateful searches of strings in protocols such as SMTP.

 
      		 [bookmark: pgfId-405305]string-icmp—Searches on Regex strings based on ICMP protocol.

 
      		 [bookmark: pgfId-405307]string-tcp—Searches on Regex strings based on TCP protocol.

 
      		 [bookmark: pgfId-405309]string-udp—Searches on Regex strings based on UDP protocol.

 
      		 [bookmark: pgfId-405311]Sweep—Analyzes sweeps of ports, hosts, and services, from a single host (ICMP and TCP), from destination ports (TCP and UDP), and multiple ports with RPC requests between two nodes.

 
      		 [bookmark: pgfId-405313]Sweep Other TCP—Analyzes TCP flag combinations from reconnaissance scans that are trying to get information about a single host. The signatures look for flags A, B, and C. When all three are seen, an alert is fired.

 
      		 [bookmark: pgfId-405315]Traffic ICMP—Analyzes nonstandard protocols, such as TFN2K, LOKI, and DDOS. There are only two signatures with configurable parameters.

 
      		 [bookmark: pgfId-405317]Traffic Anomaly—Analyzes TCP, UDP, and other traffic for worm-infested hosts.

 
      		 [bookmark: pgfId-405319]Trojan Bo2k—Analyzes traffic from the nonstandard protocol BO2K. There are no user-configurable parameters in this engine.

 
      		 [bookmark: pgfId-405321]Trojan Tfn2k—Analyzes traffic from the nonstandard protocol TFN2K. There are no user-configurable parameters in this engine.

 
      		 [bookmark: pgfId-405323]Trojan UDP—Analyzes traffic from the UDP protocol. There are no user-configurable parameters in this engine.

 
     

 
    
 
     
      [bookmark: pgfId-405337][bookmark: 99790][bookmark: ipsvchap_proc_CloningSignatures]Cloning Signatures[bookmark: marker-405329][bookmark: marker-405331][bookmark: marker-405333][bookmark: marker-405335]

 
     [bookmark: pgfId-405339]If you want to create a custom signature that is similar to an existing signature, you can create a clone, or copy, of the signature. You can then edit the parameters to make the clone perform according to your requirements.

 
     [bookmark: pgfId-405341]For example, you might want to create a clone of a Cisco-defined signature to customize it to your needs. You might find this preferable to converting the Cisco signature to a Local or shared policy signature and directly editing its parameters.

 
     [bookmark: pgfId-405343]To clone a signature, follow these steps:

 
     
 
     [bookmark: pgfId-405345]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-405347](Device view) Select  IPS > Signatures > Signatures from the Policy selector.

 
      		 [bookmark: pgfId-405349](Policy view, IPS appliances and service modules) Select  IPS > Signatures > Signatures , then select an existing policy or create a new one.

 
      		 [bookmark: pgfId-405351](Policy view, Cisco IOS IPS devices) Select  IPS (Router) > Signatures , then select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-405356]The Signature page appears; see Signatures Page.

 
     [bookmark: pgfId-405358]Step 2 Right-click the signature that you want to clone and select Clone.

 
     [bookmark: pgfId-405360]Security Manager takes some time to make the copy, and might warn you that some attributes are read-only and cannot be copied. If you receive a warning, click OK. The Add Custom Signature dialog box then appears.

 
     [bookmark: pgfId-405365]Step 3 Edit the properties of the cloned signature, as described in Adding Custom Signatures.

 
     [bookmark: pgfId-405367]Step 4 Click OK. The clone appears in the summary table on the Signatures page as the last signature.

 
     [bookmark: pgfId-405369]Cloned signatures are enabled and active by default.

 
     [bookmark: pgfId-405371]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-405377][bookmark: 99840][bookmark: ipsvchap_proc_RegExInCustomSignatures]Regular Expressions in Custom Signatures

 
     [bookmark: pgfId-405379]You can use regular expressions when adding a custom signature to some IPS devices.

 
     [bookmark: pgfId-405381]Regardless of the type of IPS device or the particular characteristics of the custom signature, incorrect syntax in a regular expression will cause device deployment to fail after adding the custom signature.

 
     [bookmark: pgfId-405383]Regular expressions may contain many control characters or regex notations which are used to describe the regex pattern itself. If you intend to use them as literal characters in the regular expression itself, they should be escaped with the "\" escape character. If you intend to use them for their real meaning, on the other hand, you should be careful to conform to proper regular expression syntax.

 
     [bookmark: pgfId-405385]Example of regular expression that will cause deployment failure: !@#$%^&*()_+{}|:"<>?

 
     [bookmark: pgfId-405387]Example of regular expression that will be deployed successfully: !@#$%\^&*\(\)_+\{\}|:\"<>\?

 
     [bookmark: pgfId-405389]Using regular expressions in custom IPS signatures is described in this example:

 
     
 
     [bookmark: pgfId-405391]Step 1 Add a Cisco ASA 5500 Series IPS Security Services Processor (e.g., 5525-X).

 
     [bookmark: pgfId-405393]Step 2 Add a custom signature with a string-XL engine (e.g., string-xl-tcp) to the IPS device.

 
     [bookmark: pgfId-405395]Step 3 Click Edit Parameter and create a regular expression for the custom signature.

 
     [bookmark: pgfId-405397]Step 4 Deploy the IPS device.

 
     [bookmark: pgfId-405399]Step 5 Deployment will fail if incorrect syntax for regular expressions used, but deployment will succeed if correct syntax is used.

 
     [bookmark: pgfId-405401]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-405415][bookmark: 99863][bookmark: ipsvchap_proc_EditingSignatureParametersTuningSignatures]Editing Signature Parameters (Tuning Signatures)[bookmark: marker-405407][bookmark: marker-405409][bookmark: marker-405411][bookmark: marker-405413]

 
     [bookmark: pgfId-405417]If you cannot alter the behavior of a signature to fit your needs using the Event Action Filters and Overrides policies, or by changing the actions associated with a signature, you might need to fine-tune the signature parameters. You should considered editing parameters to be your last option, however, because these parameters can be complex and frequently require that you have a deep understanding of packet characteristics.

 
     [bookmark: pgfId-405419]The reason you would want to edit parameters is to reduce false positives and false negatives:

 
      
      		 [bookmark: pgfId-405423]A  false positive occurs when legitimate network activity, such as virus scanning, is interpreted and reported as an attack. This happens when network activity meets criteria that were specified to identify an attack before the attack occurred. You can decrease the number false positives by tuning your sensor configurations.[bookmark: marker-405421]

 
      		 [bookmark: pgfId-405427]A  false negative occurs when an attack was not detected. Tuning your sensor configurations will help you decrease the number of false negatives.[bookmark: marker-405425]

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-405429]Tip You cannot edit the parameters of a default signature. Before editing the parameters of a default signature, you must convert the signature to a local- or shared-policy signature. In some cases, such as regular expression editing, you must clone the signature and convert it to a custom signature.


     
      

     

     

 
     [bookmark: pgfId-405431]This procedure describes how to edit signature parameters to tune a signature.

 
     [bookmark: pgfId-405433]Related Topics

 
      
      		 [bookmark: pgfId-405438]Editing Signatures

 
      		 [bookmark: pgfId-405443]Understanding Signatures

 
      		 [bookmark: pgfId-405448]Configuring Event Action Filters

 
      		 [bookmark: pgfId-405453]Configuring Event Action Overrides

 
     

 
     
 
     [bookmark: pgfId-405455]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-405457](Device view) Select  IPS > Signatures > Signatures from the Policy selector.

 
      		 [bookmark: pgfId-405459](Policy view, IPS appliances and service modules) Select  IPS > Signatures > Signatures , then select an existing policy or create a new one.

 
      		 [bookmark: pgfId-405461](Policy view, Cisco IOS IPS devices) Select  IPS (Router) > Signatures , then select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-405466]The Signature page appears; see Signatures Page.

 
     [bookmark: pgfId-405471]Step 2 Right-click the signature whose parameters you want to edit and select Edit Row. The Edit Signature dialog box appears (see Edit Signature or Add Custom Signature Dialog Boxes).

 
     [bookmark: pgfId-405473]Step 3 If the Source Policy field shows Default, you must change it to Local or to the name of a shared policy before you can edit the parameters. The Local option is available in Device view only, and makes your changes apply to the device you are editing and to no other devices. If you select the name of a shared policy, your changes apply to all devices that are assigned the policy.

 
     [bookmark: pgfId-405475]Step 4 Click Edit Parameters. The Edit Signature Parameters dialog box appears.

 
     [bookmark: pgfId-405477]The Edit Signature Parameters dialog box contains a folder tree structure, with the parameter names in the left side tree, and the values of the parameters shown on the right side.

 
     [bookmark: pgfId-405479]Values that you can change contain a little box in the name; this is a check box. An empty check box indicates that the default value is being used for the parameter. Check the check box to configure that parameter. Click the value field to change the parameter. A green check indicates that a user-defined value is being used. Click the green check to change the value back to the default. (Editing the field typically adds a check mark to the box.)

 
     [bookmark: pgfId-405481]To change a parameter, click in the associated filed in the right side. The behavior of clicking on a parameter differs based on the parameter type:

 
      
      		 [bookmark: pgfId-405483]Read-only parameters—Many parameters are read-only and cannot be changed, such as signature ID. Clicking these parameters typically has no effect, although parameter lists will open a dialog box (such as the Obsoletes list).

 
      		 [bookmark: pgfId-405485]Text or Numeric parameters—When you click a parameter that requires that you type in a value, whether alphanumeric or numeric, the field becomes an edit box. Type in the desired value and either press enter or click outside the edit box.

 
      		 [bookmark: pgfId-405487]Predefined value parameters—Many parameters have a small set of possible values, such as Yes/No. When you click these parameters, you activate a drop-down list. Select the desired option and click outside the field.

 
      		 [bookmark: pgfId-405492]List parameters—Some parameters contain a list of items. These parameters are represented by a pencil icon in the parameter value along with a word, such as Set or List. When you click in the field, a dialog box opens where you can configure the list associated with the item. The Meta engine component list is an example; for more information, see Editing the Component List for Meta Engine Signatures.

 
      		 [bookmark: pgfId-405494]Variable parameters—Some parameters allow you to select policy objects to identify the contents of the parameters. For example, you can select port list objects to identify ports in some signature engines. When you click these parameters, an edit box with a Select button appears. You can type the items directly into the edit box, including the name of the policy object, or click  Select to select the policy object from a list or to create a new object.

 
     

 
     [bookmark: pgfId-405499]For more information about the Edit Signature Parameters dialog box, see Edit Signature Parameters Dialog Box.

 
     [bookmark: pgfId-405501]Step 5 Change the settings as desired, then click OK to save your changes. You are returned to the Edit Signature dialog box.

 
     [bookmark: pgfId-405503]Step 6 Click OK in the Edit Signature dialog box to save your changes to the signature.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-405505]Tip If you decide that your edits did not have the desired effect, or you suspect that you made a mistake, you can click the Restore Defaults button in the Edit Signature dialog box to erase your changes. You can then start over.


     
      

     

     

 
     [bookmark: pgfId-405507]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-405525][bookmark: 99964][bookmark: ipspage_cncpt_EditSignatureParametersDialogBox]Edit Signature Parameters Dialog Box[bookmark: marker-405515][bookmark: marker-405517][bookmark: marker-405519][bookmark: marker-405521][bookmark: marker-405523]

 
     [bookmark: pgfId-405530]Use the Edit Signature Parameters dialog box to edit (also called tune) the built-in micro-engine parameters for a particular signature. Different engines have different parameters, so the appearance of the Edit Signature Parameters dialog box varies. For more information about editing signature parameters, see Editing Signature Parameters (Tuning Signatures).

 
     [bookmark: pgfId-405532]The Edit Signature Parameters dialog box contains a folder tree structure, with the parameter names in the left side tree, and the values of the parameters shown on the right side.

 
     [bookmark: pgfId-405534]Values that you can change contain a little box in the name; this is a check box. An empty check box indicates that the default value is being used for the parameter. Check the check box to configure that parameter. Click the value field to change the parameter. A green check indicates that a user-defined value is being used. Click the green check to change the value back to the default. (Editing the field typically adds a check mark to the box.)

 
     [bookmark: pgfId-405536]To change a parameter, click in the associated filed in the right side. The behavior of clicking on a parameter differs based on the parameter type:

 
      
      		 [bookmark: pgfId-405538]Read-only parameters—Many parameters are read-only and cannot be changed, such as signature ID. Clicking these parameters typically has no effect, although parameter lists will open a dialog box (such as the Obsoletes list).

 
      		 [bookmark: pgfId-405540]Text or Numeric parameters—When you click a parameter that requires that you type in a value, whether alphanumeric or numeric, the field becomes an edit box. Type in the desired value and either press enter or click outside the edit box.

 
      		 [bookmark: pgfId-405542]Predefined value parameters—Many parameters have a small set of possible values, such as Yes/No. When you click these parameters, you activate a drop-down list. Select the desired option and click outside the field.

 
      		 [bookmark: pgfId-405547]List parameters—Some parameters contain a list of items. These parameters are represented by a pencil icon in the parameter value along with a word, such as Set or List. When you click in the field, a dialog box opens where you can configure the list associated with the item. The Meta engine component list is an example; for more information, see Editing the Component List for Meta Engine Signatures.

 
      		 [bookmark: pgfId-405549]Variable parameters—Some parameters allow you to select policy objects to identify the contents of the parameters. For example, you can select port list objects to identify ports in some signature engines. When you click these parameters, an edit box with a Select button appears. You can type the items directly into the edit box, including the name of the policy object, or click  Select to select the policy object from a list or to create a new object.

 
     

 
     [bookmark: pgfId-405551]Navigation Path

 
     [bookmark: pgfId-405556]From the Edit Signature or Add Custom Signature dialog boxes, click the Edit Parameters button. For information on opening these dialog boxes, see Edit Signature or Add Custom Signature Dialog Boxes.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-405558]Tip If the button is not active, you must first select Local or the name of a shared policy from the Source Policy field, or clone the signature to create a custom policy. The Local option is available in Device view only, and makes your changes apply to the device you are editing and to no other devices. If you select the name of a shared policy, your changes apply to all devices that are assigned the policy.


     
      

     

     

 
     [bookmark: pgfId-405560]Field Reference

 
     [bookmark: pgfId-405563] 

 
      
       
        
        [bookmark: pgfId-403477]Table 39-6 [bookmark: 100012]Edit Signature Parameters Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-403483]Elements
          
  
         		
           
           [bookmark: pgfId-403485]Description
          
  
        

 
         
         		[bookmark: pgfId-403491]Tuning Context

 [bookmark: pgfId-403493](Policy view only)

  
         		[bookmark: pgfId-403495]Displays the information needed by Security Manager to uniquely describe how the signature parameters were edited (tuned) for a particular signature policy. The Tuning Context field is a character string that contains the following items:

 
           
           		 [bookmark: pgfId-403497] Context —The identification given by the Security Manager server for the unique definition of this micro-engine.

 
           		 [bookmark: pgfId-403499] SigLevel (IPS) or Version (IOS IPS) —For IPS policies, the range of signature update levels to which this definition of the signature micro-engine applies. For IOS IPS, this is the IOS IPS version.

 
           		 [bookmark: pgfId-403501] Engine —The name of the IPS engine.

 
          

 [bookmark: pgfId-403503]Tip As an example, the Tuning Context field could contain the following character string: Context:9, SigLevel:302-449, Engine:atomic-ip. [bookmark: pgfId-403505]For any particular signature policy, the Tuning Context field can contain one or many tuning contexts:

 
           
           		 [bookmark: pgfId-403507]The tuning context with the highest signature level is pre-pended with "Reference context."

 
           		 [bookmark: pgfId-403509]If you modify the shared policy that is pre-pended with "Reference context," Security Manager may ask you if you want to copy the policy to other applicable contexts. (A particular device may appear in more than one context.)

 
           		 [bookmark: pgfId-403511]If you choose to copy the policy to other applicable contexts, an error message informs you if some parameters cannot be copied.

 
          

 [bookmark: pgfId-403513]Note Beginning with Security Manager 4.1, old signature versions (defined as being older than the lowest signature level deployed) are purged during a periodic purge operation, the purpose of which is to optimize the database. As a result, you may notice the deletion of some of your unused tuning contexts.

  
        

 
         
         		[bookmark: pgfId-403519]Signature ID

  
         		[bookmark: pgfId-403521]The unique numerical value assigned to this signature. This value lets the sensor identify a particular signature.

 [bookmark: pgfId-403523]The value is 1000 to 65000.

  
        

 
         
         		[bookmark: pgfId-403529]SubSignature ID

  
         		[bookmark: pgfId-403531]The unique numerical value assigned to this subsignature. The subsignature ID identifies a more granular version of a broad signature.

 [bookmark: pgfId-403533]The value is 0 to 255.

  
        

 
         
         		[bookmark: pgfId-403539]Promiscuous Delta

  
         		[bookmark: pgfId-403541]Modifies the seriousness of an alert when operating in promiscuous mode. The value is subtracted from an alert’s overall risk rating. The promiscuous delta is ignored when operating in inline mode. The value can be 0 to 30.

  
        

 
         
         		[bookmark: pgfId-403547]Sig Description

  
         		[bookmark: pgfId-403549]A description of the signature to help you distinguish this signature from other signatures:

 
           
           		 [bookmark: pgfId-403551]Alert Notes—Additional information about this signature that will be included in the alert message.

 
           		 [bookmark: pgfId-403553]User Comments—Your comments about the signature.

 
           		 [bookmark: pgfId-403555]Alarm Traits—Traits you want to document about this signature. The value is 0 to 65535. The default is 0.

 
           		 [bookmark: pgfId-403557]Release—The release in which the signature was most recently updated.

 
           		 [bookmark: pgfId-403559]Signature Creation Date—The date on which the signature was created.

 
           		 [bookmark: pgfId-403561]Signature Type—The type of signature: Anomaly, Component, Exploit, Vulnerability, or Other.

 
          

  
        

 
         
         		[bookmark: pgfId-403567]Engine

  
         		[bookmark: pgfId-403572]The engine that parses and inspects the traffic specified by this signature. The engine determines which parameters are available in the Engines folder. For a description of the engines, see Engine Options.

 [bookmark: pgfId-403576]For detailed information about each engine, and the parameters available, see the “Signature Engines” section in the Installing and Using Cisco Intrusion Prevention System Device Manager document for the IPS Software release you are using.

 [bookmark: pgfId-403578]Tip Many engines include the Fragment Status parameter, which lets you identify whether packet fragments should be inspected. You can elect to not inspect fragments, to inspect fragments, or to apply the signature to any packet status.  
        

 
         
         		[bookmark: pgfId-403584]Event Counter

  
         		[bookmark: pgfId-403586]How the sensor counts events. For example, you can specify that you want the sensor to send an alert only if the same signature fires 5 times for the same address set. Configure the following values:

 
           
           		 [bookmark: pgfId-403588]Event Count—The number of times an event must occur before an alert is generated. The value is 1 to 65535. The default is 1.

 
           		 [bookmark: pgfId-403590]Event Count Key—The storage type used to count events for this signature. Choose attacker address, attacker address and victim port, attacker and victim addresses, attacker and victim addresses and ports, or victim address. The default is attacker address.

 
           		 [bookmark: pgfId-403592]Specify Alert Interval—Whether you want to specify the time between alerts for resetting the event count, Yes or No. If you select Yes, enter the time in seconds from 2 to 1000.

 
          

  
        

 
         
         		[bookmark: pgfId-403598]Alert Frequency

  
         		[bookmark: pgfId-403600]How often the sensor alerts you when this signature is firing. Specify the following parameters for this signature. These parameters are explained below.

 
           
           		 [bookmark: pgfId-403602]Summary Mode

 
           		 [bookmark: pgfId-403604]Summary Interval

 
           		 [bookmark: pgfId-403606]Summary Key

 
           		 [bookmark: pgfId-403608]Specify Global Summary Threshold

 
          

  
        

 
         
         		[bookmark: pgfId-403614]Summary Mode

 [bookmark: pgfId-403616](Alert Frequency group)

  
         		[bookmark: pgfId-403618]The mode of alert summarization. There are four modes: Fire All, Fire Once, Summarize, and Global Summarize. The summary mode is changed dynamically to adapt to the current alert volume. For example, you can configure the signature to Fire All, but after a certain threshold is reached, it starts summarizing. Your selection of summary mode controls which other parameters are available in the Summary Mode group.

 
           
           		 [bookmark: pgfId-403620]Fire All—Fires an alert on all events.

 
           		 [bookmark: pgfId-403622]Fire Once—Fires an alert only once.

 
           		 [bookmark: pgfId-403624]Summarize—Summarizes alerts.

 
           		 [bookmark: pgfId-403626]Global Summarize—Summarizes an alert so that it only fires once regardless of how many attackers or victims.

 
          

 [bookmark: pgfId-403628]Note When multiple contexts from an ASA device are contained in one virtual sensor, the summary alerts contain the context name of the last context that was summarized. Thus, the summary is the result of all alerts of this type from all contexts that are being summarized.

  
        

 
         
         		[bookmark: pgfId-403634]Specify Summary Threshold

 [bookmark: pgfId-403636](Summary Mode group.)

  
         		[bookmark: pgfId-403638]When you select Fire All, you can select whether you want to configure the summary threshold settings that will be used if the device dynamically changes to summary mode. If you select Yes, you can configure the summary interval, key, or global summary thresholds.

  
        

 
         
         		[bookmark: pgfId-403644]Summary Interval

 [bookmark: pgfId-403646](Summary Mode group.)

  
         		[bookmark: pgfId-403648]The time in seconds used in each summary alert. The value is 1 to 65535. The default is 15.

  
        

 
         
         		[bookmark: pgfId-403654]Summary Key

 [bookmark: pgfId-403656](Summary Mode group.)

  
         		[bookmark: pgfId-403658]The storage type used to summarize alerts. Choose Attacker address, Attacker address and victim port, Attacker and victim addresses, Attacker and victim addresses and ports, or Victim address. The default is Attacker address.

  
        

 
         
         		[bookmark: pgfId-403664]Specify Global Summary Threshold

 [bookmark: pgfId-403666](Summary Mode group.)

  
         		[bookmark: pgfId-403668]Whether to specify the threshold number of events to take the alert into global summary, Yes or No. If you select Yes, enter the threshold number of events, from 1 to 65535. The default is 240.

  
        

 
         
         		[bookmark: pgfId-403674]Status

  
         		[bookmark: pgfId-403676]The status of the signature.

 [bookmark: pgfId-403678]The Obsoletes list shows the signatures that are obsoleted by this signature; click the pencil icon to open the list. In many cases, this information is read-only. If you can modify the list, click Set in the parameter field to open the list, where you can add the obsoleted signature IDs.

  
        

 
         
         		[bookmark: pgfId-403684]Vulnerable OS List

  
         		[bookmark: pgfId-403686]The list of operating systems that this attack targets.

  
        

 
         
         		[bookmark: pgfId-403692]MARS Category

  
         		[bookmark: pgfId-403694]The category in Cisco Security MARS to which this signature belongs. This metadata is used to color the events generated in such a way as to provide MARS with the data that it needs to process this signature relative to the event categories that it studies.

  
        

 
         
         		[bookmark: pgfId-403700]Expand All button

  
         		[bookmark: pgfId-403702]Expands all categories and subcategories.

  
        

 
         
         		[bookmark: pgfId-403708]Collapse All button

  
         		[bookmark: pgfId-403710]Collapses all fields to the category.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-405585][bookmark: 100189][bookmark: ipspage_cncpt_EditSignatureParameterComponentListDialogBox]Editing the Component List for Meta Engine Signatures[bookmark: marker-405575][bookmark: marker-405577][bookmark: marker-405579][bookmark: marker-405581][bookmark: marker-405583]

 
     [bookmark: pgfId-405587]Use the Edit Signature Parameter—Component List dialog box to edit the component list for a meta engine signature.

 
     [bookmark: pgfId-405589]The Meta engine defines events that occur in a related manner within a sliding time interval. This engine processes events rather than packets. As signature events are generated, the Meta engine inspects them to determine if they match any or several Meta definitions. The Meta engine generates a signature event after all requirements for the event are met.

 
     [bookmark: pgfId-405591]All signature events are handed off to the Meta engine by the Signature Event Action Processor. The Signature Event Action Processor hands off the event after processing the minimum hits option. Summarization and event action are processed after the Meta engine has processed the component events.

 
     [bookmark: pgfId-405593]The Meta engine is different from other engines in that it takes alerts as input where most engines take packets as input. Thus, in a Meta engine signature, you must identify the signatures that the Meta signature should be looking for. This list of signatures is contained in the Component list.

 
     [bookmark: pgfId-405598]The Component list is part of the signature parameters. To edit the parameters, follow the procedure described in Editing Signature Parameters (Tuning Signatures). When you open the Edit Signature Parameters dialog box for a signature that uses the Meta engine, look for the Engine > Component List parameter. The parameter value contains a pencil icon and the word List. Click List to open the Edit Signature Parameter—Component List dialog box.

 
     [bookmark: pgfId-405600]The dialog box is divided into two lists, an Inactive list (on the left) and an active list (on the right). The active list defines the signatures that the Meta engine signature is looking for.

 
     [bookmark: pgfId-405602]To modify the components list:

 
      
      		 [bookmark: pgfId-405604] Add new components —Click the  Add Entry (+) button to the left of the inactive list. The Add Signature Parameter—List Entry dialog box opens. Configure the following values:

 
     

 
     [bookmark: pgfId-405606] – Entry Key—A name for the component.

 
     [bookmark: pgfId-405608] – Component Sig ID—The signature ID of the signature you are looking for.

 
     [bookmark: pgfId-405610] – Component SubSig ID—The subsignature ID; enter 0 if there are no subsignatures.

 
     [bookmark: pgfId-405612] – Component Count—The number of times this signature must fire before the Meta signature is triggered.

 
     [bookmark: pgfId-405614] – Is a Not Component—This field lets you create negative entries; thus, you can identify a list where some signatures must fire, and some signatures must not fire. Select No for signatures that must fire, and Yes for signatures that must not fire.

 
     [bookmark: pgfId-405616]When you click OK in the Add Signature Parameter—List Entry dialog box, the new component is added to the inactive list. Select it and click the >> button to move it to the active list. Then, use the Up and Down arrow buttons to position the component in the active component list; a third button is available to reset the order to the previously saved order.

 
      
      		 [bookmark: pgfId-405618] Edit an existing component —Select the component (in either list) and click the  Edit Entry (pencil) button that is between the lists. The Edit Signature Parameter—List Entry dialog box opens. The parameters are the same as for adding a new entry, except that you cannot change the component name.

 
      		 [bookmark: pgfId-405620] Delete a component —Select the component in the inactive list and click the  Delete Entry (trash can) button that is to the left of the inactive list. If you want to delete an active component, you must first select it in the active list and click the << button to move it to the inactive list.

 
      		 [bookmark: pgfId-405622] Restore defaults —If you want to restore the default values of a component, select it and click  Restore .

 
     

 
    
 
     
      [bookmark: pgfId-405636][bookmark: 100260][bookmark: ipspage_cncpt_ObsoletesDialogBox]Obsoletes Dialog Box[bookmark: marker-405632][bookmark: marker-405634]

 
     [bookmark: pgfId-405638]Use the Obsoletes dialog box to identify obsolete signatures associated with a particular signature. In many cases, this information is read-only. In some cases, it is read-write; for example, you can edit the list for IOS IPS signature policies for Local or shared-policy-specific signatures.

 
     [bookmark: pgfId-405640]If you can edit the list:

 
      
      		 [bookmark: pgfId-405642]Click the  Add Entry (+) button to add the signature and subsignature ID of a signature that is made obsolete by the signature you are editing.

 
      		 [bookmark: pgfId-405644]Select an entry and click the  Delete Entry (trash can) button to remove it from the list of obsoleted signatures.

 
     

 
     [bookmark: pgfId-405646]Navigation Path

 
     [bookmark: pgfId-405651]The Obsoletes list is part of the signature parameters. To edit the parameters, follow the procedure described in Editing Signature Parameters (Tuning Signatures). When you open the Edit Signature Parameters dialog box, look for the Status > Obsoletes parameter. The parameter value contains a pencil icon and the word Set (when the parameter is not read-only). Click the pencil or word to open the Obsoletes dialog box.

 
    
 
   
 
    
     [bookmark: pgfId-405667][bookmark: 100286][bookmark: ipsvchap_proc_ConfiguringSignatureSettings]Configuring Signature Settings[bookmark: marker-405659][bookmark: marker-405661][bookmark: marker-405663][bookmark: marker-405665]

 
    [bookmark: pgfId-405669]Use the Signature Settings page to define settings for IPS appliances and service modules (but not Cisco IOS IPS devices). These settings define the following policies:

 
     
     		 [bookmark: pgfId-405671] Application policy —Enable or disable HTTP, determine and specify the maximum number of HTTP requests, specify AIC web ports, and enable or disable FTP.

 
     		 [bookmark: pgfId-405673] Fragment reassembly policy —Configure the sensor to reassemble a datagram that has been fragmented over more than one packet by selecting the IP reassembly mode.

 
     		 [bookmark: pgfId-405675] Stream reassembly policy —Configure the sensor to monitor only TCP sessions that have been established by a complete three-way handshake by specifying whether a TCP handshake is required and by selecting the TCP reassembly mode.

 
     		 [bookmark: pgfId-405677] IP logging policy —Configure the sensor to generate an IP session log when the sensor detects an attack by determining and selecting the maximum allowable number of log packets, the IP log time and the maximum allowable size of the IP log.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-405679]Tip All of these settings have default values, so configure this policy only if you need to use a non-default value.


    
     

    

    

 
    [bookmark: pgfId-405681]To configure the Signature Settings policy, do one of the following:

 
     
     		 [bookmark: pgfId-405683](Device view) Select  IPS > Signatures > Settings from the Policy selector.

 
     		 [bookmark: pgfId-405685](Policy view) Select  IPS > Signatures > Settings , then select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-405687]You can then configure the options that are explained in the following table.

 
    [bookmark: pgfId-405690] 

 
     
      
       
       [bookmark: pgfId-403723]Table 39-7 [bookmark: 100328]Signature Settings Page 

 
       
      
        
        		
          
          [bookmark: pgfId-403729]Element
         
  
        		
          
          [bookmark: pgfId-403731]Description
         
  
       

 
        
        		[bookmark: pgfId-403737]Enable HTTP

  
        		[bookmark: pgfId-403739]Enables protection for web services. Select Yes to require the sensor to inspect HTTP traffic for compliance with the RFC.

  
       

 
        
        		[bookmark: pgfId-403745]Max HTTP Requests

  
        		[bookmark: pgfId-403747]The maximum number of outstanding HTTP requests per connection.

  
       

 
        
        		[bookmark: pgfId-403753]AIC Web Ports

  
        		[bookmark: pgfId-403755]The ports on which to look for AIC traffic. Enter a comma-separated list of port numbers or port list objects that define the ports. You can click Select to select a port list object from a list or to create a new object.

  
       

 
        
        		[bookmark: pgfId-403761]Enable FTP

  
        		[bookmark: pgfId-403763]Enables protection for FTP services. Select Yes to require the sensor to inspect FTP traffic.

  
       

 
        
        		[bookmark: pgfId-403769]IP Reassembly Mode

  
        		[bookmark: pgfId-403771]The method the sensor uses to reassemble the fragments, based on the operating system.

  
       

 
        
        		[bookmark: pgfId-403777]TCP Handshake Required

  
        		[bookmark: pgfId-403779]Whether the sensor should only track sessions for which the three-way handshake is completed.

  
       

 
        
        		[bookmark: pgfId-403785]TCP Reassembly Mode

  
        		[bookmark: pgfId-403787]The mode the sensor should use to reassemble TCP sessions with the following options:

 
          
          		 [bookmark: pgfId-403789]Asymmetric—May only be seeing one direction of bidirectional traffic flow.

 
         

 [bookmark: pgfId-403791]Note Asymmetric mode lets the sensor synchronize state with the flow and maintain inspection for those engines that do not require both directions. Asymmetric mode lowers security because full protection requires both sides of traffic to be seen.

 
          
          		 [bookmark: pgfId-403793]Loose—Use in environments where packets might be dropped.

 
          		 [bookmark: pgfId-403795]Strict—If a packet is missed for any reason, all packets after the missed packet are not processed.

 
         

  
       

 
        
        		[bookmark: pgfId-403801]Max IP Log Packets

  
        		[bookmark: pgfId-403803]The number of packets you want logged.

  
       

 
        
        		[bookmark: pgfId-403809]IP Log Time

  
        		[bookmark: pgfId-403811]The duration you want the sensor to log, from 1 to 60 minutes. The default is 30 minutes.

  
       

 
        
        		[bookmark: pgfId-403817]Max IP Log Bytes

  
        		[bookmark: pgfId-403819]The maximum number of bytes you want logged.
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     [bookmark: pgfId-28169][bookmark: 110859][bookmark: pxchap_cncpt_ConfiguringDeviceAccessSettingsonFirewallDevices]Configuring Device Access Settings on Firewall Devices[bookmark: marker-28165][bookmark: marker-28167]
      
      
 
     
 

 
    [bookmark: pgfId-28171]The Device Access section, located under the Device Admin folder in the Policy selector, contains pages for defining access to firewall devices.

 
    [bookmark: pgfId-28173]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-28178]Configuring Console Timeout

 
     		 [bookmark: pgfId-28183]HTTP Page

 
     		 [bookmark: pgfId-28188]Configuring ICMP

 
     		 [bookmark: pgfId-28193]Configuring Management Access

 
     		 [bookmark: pgfId-28198]Configuring Secure Shell Access

 
     		 [bookmark: pgfId-28203]Configuring SSL - Basic and Advanced tabs

 
     		 [bookmark: pgfId-28208]Configuring SNMP

 
     		 [bookmark: pgfId-28213]Telnet Page

 
    

 
   
 
    
     [bookmark: pgfId-28227][bookmark: 110868][bookmark: pxpage_cncpt_ConsolePage]Configuring Console Timeout [bookmark: marker-28221][bookmark: marker-28223][bookmark: marker-28225]

 
    [bookmark: pgfId-28229]Use the Console page to specify a timeout value for inactive console sessions. When the time limit you specify is reached, the console session is closed.

 
    [bookmark: pgfId-28231]In the Console Timeout field, enter the number of minutes a console session can remain idle before the device closes it. Valid values are 0 to 60 minutes. To prevent a console session from timing out, enter 0.

 
    [bookmark: pgfId-28233]Navigation Path

 
     
     		 [bookmark: pgfId-28235](Device view) Select  Platform > Device Admin > Device Access > Console from the Device Policy selector.

 
     		 [bookmark: pgfId-28237](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Device Access > Console from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-28239]Related Topics

 
     
     		 [bookmark: pgfId-28244]Chapter 49, “Configuring Device Access Settings on Firewall Devices”

 
    

 
   
 
    
     [bookmark: pgfId-28258][bookmark: 110901][bookmark: pxpage_cncpt_HTTPPage]HTTP Page[bookmark: marker-28252][bookmark: marker-28254][bookmark: marker-28256]

 
    [bookmark: pgfId-28260]Use the table on the HTTP page to manage the interfaces configured to access the HTTP server on a device, as well as HTTP redirect to HTTPS on those interfaces. You also can enable or disable the HTTP server on the device from this page. Administrative access by the specific device manager requires HTTPS access.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-28262]Note To redirect HTTP, the interface requires an access list that permits HTTP. Otherwise, the interface cannot listen to port 80, or to any other port that you configure for HTTP.


    
     

    

    

 
    [bookmark: pgfId-28264]Navigation Path

 
     
     		 [bookmark: pgfId-28266](Device view) Select  Platform > Device Admin > Device Access > HTTP from the Device Policy selector.

 
     		 [bookmark: pgfId-28268](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Device Access > HTTP from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-28270]Field Reference

 
    [bookmark: pgfId-28273] 

 
     
      
       
       [bookmark: pgfId-26311]Table 49-1 [bookmark: 110929]HTTP Page 

 
       
      
        
        		
          
          [bookmark: pgfId-26317]Element
         
  
        		
          
          [bookmark: pgfId-26319]Description
         
  
       

 
        
        		[bookmark: pgfId-26325]HTTP Interface table

  
        		[bookmark: pgfId-26330]Use the Add Row, Edit Row, and Delete Row buttons below this table to manage device interfaces on which HTTP-to-HTTPS redirect is configured. Add Row and Edit Row open the HTTP Configuration Dialog Box.

  
       

 
        
        		[bookmark: pgfId-26336]Fetch user name from certificate settings

  
        		[bookmark: pgfId-26338]Select this option to set the rules for extracting a username from the certificate. Enter the following:

 
          
          		 [bookmark: pgfId-1058843]Enable HTTP username from certificate—Check this box to get the HTTP username from the certificate for authentication. 

 
          		 [bookmark: pgfId-26340]Pre-fill user name—Check the Pre-fill Username checkbox to enable the use of this name for authentication. When enabled, this username, along with the password entered by the user, are used for authentication.

 
         

 [bookmark: pgfId-26342]Choose one of the following options:

 [bookmark: pgfId-26344]Note This feature is supported only in devices running ASA software version 9.4(1) or higher.

 
          
          		 [bookmark: pgfId-26346]Use the Entire DN as the username—Select this option if you want to use the entire DN as the username. This option is disabled by default.

 
          		 [bookmark: pgfId-26348]Specify individual DN fields as the username—Choose from the Primary DN Field and Secondary DN Field drop-down values to specify which attributes and additional attributes to use to derive the username. This option is enabled by default.

 
         

 [bookmark: pgfId-26350] – C—Country: the two-letter country abbreviation which conforms to the ISO 3166 country abbreviations.

 [bookmark: pgfId-26352] – CN—Common Name: the name of a person, system, or other entity. Not available as a secondary attribute.

 [bookmark: pgfId-26354] – DNQ—Domain Name Qualifier.

 [bookmark: pgfId-26356] – EA—Email address.

 [bookmark: pgfId-26358] – GENQ—Generational qualifier.

 [bookmark: pgfId-26360] – GN—Given name.

 [bookmark: pgfId-26362] – I—Initials.

 [bookmark: pgfId-26364] – L—Locality: the city or town where the organization is located.

 [bookmark: pgfId-26366] – N—Name.

 [bookmark: pgfId-26368] – O—Organization: the name of the company, institution, agency, association, or other entity.

 [bookmark: pgfId-26370] – OU—Organizational Unit: the subgroup within the organization (O).

 [bookmark: pgfId-26372] – SER—Serial number.

 [bookmark: pgfId-26374] – SN—Surname.

 [bookmark: pgfId-26376] – SP—State/Province: the state or province where the organization is located.

 [bookmark: pgfId-26378] – T—Title.

 [bookmark: pgfId-26380] – UID—User Identifier.

 [bookmark: pgfId-26382] – UPN—User Principal Name.

 
          
          		 [bookmark: pgfId-26384]Use LUA Script generated by ASDM—Choose this option if you want to use the LUA script that is generated by ASDM. This option is disabled by default.

 
         

  
       

 
        
        		[bookmark: pgfId-26390]Enable HTTP Server

  
        		[bookmark: pgfId-26392]Enables or disables the HTTP server on the device. When enabled, you can specify a communications Port for the server. The Port range is 1 to 65535; the default is 443.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-28287][bookmark: 111002][bookmark: pxpage_cncpt_HTTPConfigurationDialogBox]HTTP Configuration Dialog Box[bookmark: marker-28281][bookmark: marker-28283][bookmark: marker-28285]

 
     [bookmark: pgfId-28289]Use the HTTP Configuration dialog box to add or edit a host or network that will be allowed to access the HTTP server on the device via a specific interface; you also can enable and disable HTTP redirect.

 
     [bookmark: pgfId-28291]Navigation Path

 
     [bookmark: pgfId-28296]You can access the HTTP Configuration dialog box from the HTTP Page.

 
     [bookmark: pgfId-28298]Field Reference

 
     [bookmark: pgfId-28301] 

 
      
       
        
        [bookmark: pgfId-26405]Table 49-2 [bookmark: 111025]HTTP Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-26411]Element
          
  
         		
           
           [bookmark: pgfId-26413]Description
          
  
        

 
         
         		[bookmark: pgfId-26419]Interface Name

  
         		[bookmark: pgfId-26421]Enter or Select the interface on which access to the HTTP server on the device is allowed.

  
        

 
         
         		[bookmark: pgfId-26427]IP Address/Netmask

  
         		[bookmark: pgfId-26429]Enter the IP address and netmask, separated by a forward slash (“/”) of the host or network that is permitted to establish an HTTP connection with the device. Alternately, you can click Select to select a Networks/Hosts object.

  
        

 
         
         		[bookmark: pgfId-26435]Enable Authentication Certificate

  
         		[bookmark: pgfId-26437]Select this option to require user certificate authentication in order to establish an HTTP connection. On ASA and PIX 8.0(2)+ devices, you can specify the authentication Port.

  
        

 
         
         		[bookmark: pgfId-26443]Redirect port

  
         		[bookmark: pgfId-26445]The port on which the security appliance listens for HTTP requests, which it then redirects to HTTPS. To disable HTTP redirect, ensure that this field is blank.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-28315][bookmark: 111058][bookmark: pxpage_cncpt_ICMPPage]Configuring ICMP [bookmark: marker-28309][bookmark: marker-28311][bookmark: marker-28313]

 
    [bookmark: pgfId-28317]Use the table on the ICMP page to manage Internet Control Message Protocol (ICMP) rules, which specify the addresses of all hosts or networks that are allowed or denied ICMP access to specific interfaces on the security device.

 
    [bookmark: pgfId-28319]The ICMP rules control ICMP traffic that terminates on any device interface. If no ICMP control list is configured, the device accepts all ICMP traffic that terminates at any interface, including the outside interface. However, by default, the device does not respond to ICMP echo requests directed to a broadcast address.

 
    [bookmark: pgfId-28321]It is recommended that permission is always granted for the ICMP Unreachable message (type 3). Denying ICMP Unreachable messages disables ICMP Path MTU discovery, which can halt IPsec and PPTP traffic. See RFC 1195 and RFC 1435 for details about Path MTU Discovery.

 
    [bookmark: pgfId-28323]If an ICMP control list is configured, the device uses a first match to the ICMP traffic, followed by an implicit deny all. That is, if the first matched entry is a permit entry, the processing of the ICMP packet continues. If the first matched entry is a deny entry, or an entry is not matched, the device discards the ICMP packet and generates a syslog message. If an ICMP control list is not configured, a permit rule is assumed in all cases.

 
    [bookmark: pgfId-28325]Navigation Path

 
     
     		 [bookmark: pgfId-28327](Device view) Select  Platform > Device Admin > Device Access > ICMP from the Device Policy selector.

 
     		 [bookmark: pgfId-28329](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Device Access > ICMP from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-28331]Field Reference

 
    [bookmark: pgfId-28334] 

 
     
      
       
       [bookmark: pgfId-26458]Table 49-3 [bookmark: 111088]ICMP Page 

 
       
      
        
        		
          
          [bookmark: pgfId-26464]Element
         
  
        		
          
          [bookmark: pgfId-26466]Description
         
  
       

 
        
        		[bookmark: pgfId-26472]ICMP Rules Table

  
        		[bookmark: pgfId-26477]Use the Add Row, Edit Row, and Delete Row buttons below this table to manage ICMP rules. Add Row opens the Add ICMP dialog box, while Edit Row opens the Edit ICMP dialog box. See Add and Edit ICMP Dialog Boxes for information about these dialog boxes.

  
       

 
        
        		 
          
          [bookmark: pgfId-26483]ICMP Unreachable Parameters
         
  
       

 
        
        		[bookmark: pgfId-26491]Rate Limit

  
        		[bookmark: pgfId-26493]For ICMP traffic that terminates at an interface on this device, the maximum number of ICMP Unreachable messages the device can transmit per second. This value can be between 1 and 100 messages per second; the default is 1 message per second.

  
       

 
        
        		[bookmark: pgfId-26499]Burst Size

  
        		[bookmark: pgfId-26501]The burst size for ICMP Unreachable messages; this can be a value between 1 and 10.

 [bookmark: pgfId-26503]Note This parameter is not currently used by the system, so you can choose any value.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-28348][bookmark: 111120][bookmark: pxpage_cncpt_ICMPConfigurationDialogBox]Add and Edit ICMP Dialog Boxes[bookmark: marker-28342][bookmark: marker-28344][bookmark: marker-28346]

 
     [bookmark: pgfId-28350]Use the Add ICMP dialog box to add an ICMP rule, which specifies a host/network that is allowed or denied the specified ICMP access on the specified device interface.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-28352]Note The Edit ICMP dialog box is virtually identical to the Add ICMP dialog box, and is used to modify existing ICMP rules. The following descriptions apply to both dialog boxes.


     
      

     

     

 
     [bookmark: pgfId-28354]Navigation Path

 
     [bookmark: pgfId-28359]You can access the Add or Edit ICMP dialog boxes from the Configuring ICMP.

 
     [bookmark: pgfId-28361]Field Reference

 
     [bookmark: pgfId-28364] 

 
      
       
        
        [bookmark: pgfId-26516]Table 49-4 [bookmark: 111144]Add and ICMP Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-26522]Element
          
  
         		
           
           [bookmark: pgfId-26524]Description
          
  
        

 
         
         		[bookmark: pgfId-26530]Action

  
         		[bookmark: pgfId-26532]Whether this rule permits or denies the selected ICMP Service message from the specified Network on the specified Interface. Choose:

 
           
           		 [bookmark: pgfId-26534] Permit – ICMP messages from the specified networks/hosts are allowed to the specified interface.

 
           		 [bookmark: pgfId-26536] Deny – ICMP messages from the specified networks/hosts to the specified interface are dropped.

 
          

  
        

 
         
         		[bookmark: pgfId-26542]ICMP Service

  
         		[bookmark: pgfId-26544]Enter or Select the specific ICMP service message to which the rule applies.

  
        

 
         
         		[bookmark: pgfId-26550]Interface

  
         		[bookmark: pgfId-26552]Enter or Select the device interface to which these ICMP messages are directed.

  
        

 
         
         		[bookmark: pgfId-26558]Network

  
         		[bookmark: pgfId-26560]Enter a host name or IP address, or Select a Networks/Hosts object, to define the specified ICMP message source.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-28380][bookmark: 111183][bookmark: pxpage_cncpt_ManagementAccessPage]Configuring Management Access[bookmark: marker-28372][bookmark: marker-28374][bookmark: marker-28376][bookmark: marker-28378]

 
    [bookmark: pgfId-28382]Use the Management Access page to enable or disable access on a high-security interface so you can perform management functions on the device. You can enable this feature on an internal interface to allow management functions to be performed on the interface over an IPsec VPN tunnel. You can enable the Management Access feature on only one interface at a time.

 
    [bookmark: pgfId-28384]Navigation Path

 
     
     		 [bookmark: pgfId-28386](Device view) Select  Platform > Device Admin > Device Access > Management Access from the Device Policy selector.

 
     		 [bookmark: pgfId-28388](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Device Access > Management Access from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-28390]Enabling and Disabling Management Access

 
    [bookmark: pgfId-28392]In the Management Access Interface field, enter the name of the device interface that is to permit management access connections. You can click Select to select the interface from a list of interface objects.

 
    [bookmark: pgfId-28394]You can enable the Management Access feature on only one interface at a time.

 
    [bookmark: pgfId-28396]Clear the Management Access Interface field to disable management access.

 
   
 
    
     [bookmark: pgfId-28410][bookmark: 111219][bookmark: pxpage_cncpt_SecureShellPage]Configuring Secure Shell Access [bookmark: marker-28404][bookmark: marker-28406][bookmark: marker-28408]

 
    [bookmark: pgfId-28412]Use the Secure Shell page to configure rules that permit administrative access to a security device using the SSH protocol. The rules restrict SSH access to a specific IP address and netmask. Any SSH connection attempts that comply with these rules must then be authenticated by an AAA server or Telnet password.

 
    [bookmark: pgfId-28414]Navigation Path

 
     
     		 [bookmark: pgfId-28416](Device view) Select  Platform > Device Admin > Device Access > Secure Shell from the Device Policy selector.

 
     		 [bookmark: pgfId-28418](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Device Access > Secure Shell from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-28420]Field Reference

 
    [bookmark: pgfId-28423] 

 
     
      
       
       [bookmark: pgfId-26573]Table 49-5 [bookmark: 111246]Secure Shell Page 

 
       
      
        
        		
          
          [bookmark: pgfId-26579]Element
         
  
        		
          
          [bookmark: pgfId-26581]Description
         
  
       

 
        
        		[bookmark: pgfId-26587]SSH Version

  
        		[bookmark: pgfId-26589]Specify the SSH version(s) accepted by the device: choose 1, 2, or 1 and 2. By default, SSH Version 1 and SSH Version 2 connections are accepted.

  
       

 
        
        		[bookmark: pgfId-26595]Timeout

  
        		[bookmark: pgfId-26597]Enter the number of minutes, 1 to 60, the Secure Shell session can remain idle before the device closes it. The default value is 5 minutes.

  
       

 
        
        		[bookmark: pgfId-26603]Allowed Hosts table

  
        		[bookmark: pgfId-26608]Use the Add Row, Edit Row, and Delete Row buttons below this table to manage the hosts allowed to connect to the security device via SSH. Add Row opens the Add Host dialog box, while Edit Row opens the Edit Host dialog box. See Add and Edit SSH Host Dialog Boxes for information about these dialog boxes.

  
       

 
        
        		[bookmark: pgfId-26614]Enable Secure Copy

  
        		[bookmark: pgfId-26616]Check this box to enable the secure copy (SCP) server on the security appliance. This allows the appliance to function as an SCP server for transferring files from/to the device. Only clients that are allowed to access the security appliance using SSH can establish a secure copy connection.

 [bookmark: pgfId-26618]This implementation of the secure copy server has the following limitations:

 
          
          		 [bookmark: pgfId-26620]The server can accept and terminate connections for secure copy, but cannot initiate them.

 
          		 [bookmark: pgfId-26622]The server does not have directory support. The lack of directory support limits remote client access to the security appliance internal files.

 
          		 [bookmark: pgfId-26624]The server does not support banners.

 
          		 [bookmark: pgfId-26626]The server does not support wildcards.

 
          		 [bookmark: pgfId-26628]The security appliance license must have the VPN-3DES-AES feature to support SSH version 2 connections.

 
         

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-28437][bookmark: 111292][bookmark: pxpage_cncpt_SSHConfigurationDialogBox]Add and Edit SSH Host Dialog Boxes[bookmark: marker-28431][bookmark: marker-28433][bookmark: marker-28435]

 
     [bookmark: pgfId-28439]Use the Add Host dialog box to add an SSH access rule.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-28441]Note The Edit Host dialog box is virtually identical to the Add Host dialog box, and is used to modify existing SSH access rules. The following descriptions apply to both dialog boxes.


     
      

     

     

 
     [bookmark: pgfId-28443]Navigation Path

 
     [bookmark: pgfId-28448]You can access the Add and Edit Host dialog boxes from the Configuring Secure Shell Access.

 
     [bookmark: pgfId-28450]Field Reference

 
     [bookmark: pgfId-28453] 

 
      
       
        
        [bookmark: pgfId-26641]Table 49-6 [bookmark: 111316]Add and Edit Host Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-26647]Element
          
  
         		
           
           [bookmark: pgfId-26649]Description
          
  
        

 
         
         		[bookmark: pgfId-26655]Interface

  
         		[bookmark: pgfId-26657]Enter or Select the name of the device interface on which SSH connections are permitted.

  
        

 
         
         		[bookmark: pgfId-26663]IP Addresses

  
         		[bookmark: pgfId-26665]Enter the name or IP address for each host or network that is permitted to establish an SSH connection with the security device on the specified interface; use commas to separate multiple entries. You also can click Select to select Networks/Hosts objects from a list.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-28467][bookmark: 111338][bookmark: pxpage_cncpt_SSLPage]Configuring SSL - Basic and Advanced tabs [bookmark: marker-28461][bookmark: marker-28463][bookmark: marker-28465]

 
    [bookmark: pgfId-28469]Beginning from version 4.8, Security Manager provides enhanced security features using Secure Sockets Layer (SSL).

 
    [bookmark: pgfId-28471]Navigation Path

 
     
     		 [bookmark: pgfId-28473](Device view) Select  Platform > Device Admin > Device Access > SSL from the Device Policy selector.

 
     		 [bookmark: pgfId-28475](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Device Access > SSL from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-28477]Field Reference

 
    [bookmark: pgfId-28480] 

 
     
      
       
       [bookmark: pgfId-26678]Table 49-7 [bookmark: 111365]SSL Page Basic Tab 

 
       
      
        
        		
          
          [bookmark: pgfId-26684]Element
         
  
        		
          
          [bookmark: pgfId-26686]Description
         
  
       

 
        
        		 
          
          [bookmark: pgfId-26692]Certificate Authentication
         
  
       

 
        
        		[bookmark: pgfId-26700]FCA Timeout

  
        		[bookmark: pgfId-26702]Enter a value in the range of 1 to 120.

 [bookmark: pgfId-26704]Note FCA Timeout is applicable for devices running the ASA software version 9.1(2) or higher.

  
       

 
        
        		[bookmark: pgfId-26710]Interface

  
        		[bookmark: pgfId-26712]Use the Add Row, Edit Row, and Delete Row buttons below the Interface table to manage the interfaces and their port numbers allowed to connect to the security device via SSL. Add Row opens the Add Interface and Port dialog box, while Edit Row opens the Edit Interface and Port dialog box. You can select the interface from the available entries in the Interface Selector dialog box. Enter a value in the range of 1 to 65535 for the port number.

  
       

 
        
        		[bookmark: pgfId-26718]Client Version

 [bookmark: pgfId-26720]SSL/TLS Protocol Version

  
        		[bookmark: pgfId-26722]The Client Version is the SSL/TLS protocol version to use when the device acts as a client. Select any one of the following:

 
          
          		 [bookmark: pgfId-26724]Any—Select this keyword to transmit SSLV3 ClientHellos and negotiate SSLV3 or greater. This is the default keyword.

 
          		 [bookmark: pgfId-26726]SSLV3—Enter this keyword to transmit SSLv3 ClientHellos and negotiate SSLV3 or greater.

 
          		 [bookmark: pgfId-26728]TLSV1—Enter this keyword to transmit TLSv1 ClientHellos and negotiate TLSV1 or greater.

 
          		 [bookmark: pgfId-26730]TLSV1.1—Enter this keyword to transmit TLSV1.1 ClientHellos and negotiate TLSV1.1 or greater.

 
          		 [bookmark: pgfId-26732]TLSV1.2—Enter this keyword to transmit TLSV1.2 ClientHellos and negotiate TLSV1.2 or greater.

 
         

 [bookmark: pgfId-26734]Note TLSV1.1 and TLSV1.2 protocol versions are applicable for devices running the ASA software version 9.3(2) or higher.

  
       

 
        
        		[bookmark: pgfId-26740]Server Version

 [bookmark: pgfId-26742]SSL/TLS Protocol Version

  
        		[bookmark: pgfId-26744]The Server Version is the minimum SSL/TLS protocol version to use when the device acts as a server. Select any one of the following:

 
          
          		 [bookmark: pgfId-26746]Any—Select this keyword to accept SSLV2 ClientHellos and negotiate the highest common version. This is the default keyword.

 
          		 [bookmark: pgfId-26748]SSLV3—Enter this keyword to accept SSLV2 ClientHellos and negotiate SSLV3 or greater.

 
          		 [bookmark: pgfId-26750]SSLV3-Only—Enter this keyword to accept SSLV2 ClientHellos and negotiate SSLV3 or greater.

 
          		 [bookmark: pgfId-26752]TLSV1—Enter this keyword to accept SSLV2 ClientHellos and negotiate TLSV1 or greater.

 
          		 [bookmark: pgfId-26754]TLSV1-Only—Enter this keyword to accept SSLV2 ClientHellos and negotiate TLSV1 or greater.

 
          		 [bookmark: pgfId-26756]TLSV1.1—Enter this keyword to accept SSLV2 ClientHellos and negotiate TLSV1.1 or greater.

 
          		 [bookmark: pgfId-26758]TLSV1.2—Enter this keyword to accept SSLV2 ClientHellos and negotiate TLSV1.2 or greater.

 
         

 [bookmark: pgfId-26760]NOTES:

 
          
          		 [bookmark: pgfId-26762]The  Any keyword is the default for both Server Version and Client Version and means that the device will negotiate the highest common supported version of TLS.

 
          		 [bookmark: pgfId-26764]TLSV1.1 and TLSV1.2 protocol versions are applicable for devices running the ASA software version 9.3(2) or higher.

 
          		 [bookmark: pgfId-26766]SSLV3-Only and TLSV1-Only protocol versions are applicable for devices running the ASA software version older than 9.3(2).

 
         

  
       

 
      
     

 
    
 
    [bookmark: pgfId-28483] 

 
     
      
       
       [bookmark: pgfId-26779]Table 49-8 [bookmark: 111441]SSL Page Advanced Tab 

 
       
      
        
        		
          
          [bookmark: pgfId-26785]Element
         
  
        		
          
          [bookmark: pgfId-26787]Description
         
  
       

 
        
        		 
          
          [bookmark: pgfId-26793]Advanced SSL Settings for devices running the ASA software version older than 9.3(2)
         
  
       

 
        
        		[bookmark: pgfId-26801]Encryption

  
        		[bookmark: pgfId-26803]Choose the encryption algorithms from the available list. To add an encryption algorithm, select the item in the Available Members list and then click >>. The item is moved from the Available Members list to the Selected Members list. You can add multiple encryption algorithms.

 [bookmark: pgfId-26805]The available encryption algorithms are as follows:

 
          
          		 [bookmark: pgfId-26807]3DES-SHA1

 
          		 [bookmark: pgfId-26809]AES128-SHA1

 
          		 [bookmark: pgfId-26811]AES256-SHA1

 
          		 [bookmark: pgfId-26813]DES-SHA1

 
          		 [bookmark: pgfId-26815]RC4-MD5

 
          		 [bookmark: pgfId-26817]RC4-SHA1

 
          		 [bookmark: pgfId-26819]NULL-SHA1

 
          		 [bookmark: pgfId-26821]DHE-AES128-SHA1

 
          		 [bookmark: pgfId-26823]DHE-AES256-SHA1

 
         

 [bookmark: pgfId-26825]To remove an encryption algorithm, select the item in the Selected Members list and then click <<. The item is moved from the Selected Members list to the Available Members list.

 [bookmark: pgfId-26827]Click Save to save your settings.

  
       

 
        
        		 
          
          [bookmark: pgfId-26833]Advanced SSL Settings for devices running the ASA software version 9.3(2) or higher
         
  
       

 
        
        		[bookmark: pgfId-26841]SSL Cipher

  
        		[bookmark: pgfId-26843]Use the Add Row, Edit Row, and Delete Row buttons below the SSL Cipher table to manage the SSL cipher version and level. On the Add Cipher dialog select a combination of the version and level.

  
       

 
        
        		[bookmark: pgfId-26849]Version

  
        		[bookmark: pgfId-26851]Select one of the following versions:

 
          
          		 [bookmark: pgfId-26853]DEFAULT

 
          		 [bookmark: pgfId-26855]DTLSV1

 
          		 [bookmark: pgfId-26857]SSLV3

 
          		 [bookmark: pgfId-26859]TLSV1

 
          		 [bookmark: pgfId-26861]TLSV1.1

 
          		 [bookmark: pgfId-26863]TLSV1.2

 
         

 [bookmark: pgfId-26865]Note The DEFAULT keyword is used to configure outbound connections when the device is acting as a client and establishing a connection to a server. All the other keywords are used when the device is acting as a server and accepting connections from a client.

 [bookmark: pgfId-26867]Note The SSLV3 version has been deprecated from ASA version 9.4(1). Therefore, beginning with version 4.9, Security Manager performs a validation to check if SSLV3 option has been configured for any ASA devices running the version 9.4(1) or higher.

  
       

 
        
        		[bookmark: pgfId-26873]Level

  
        		[bookmark: pgfId-26875]Select one of the following versions:

 
          
          		 [bookmark: pgfId-26877]ALL - It includes all ciphers including NULL-SHA.

 
          		 [bookmark: pgfId-26879]LOW - It includes all ciphers except NULL-SHA.

 
          		 [bookmark: pgfId-26881]MEDIUM - It includes all ciphers except NULL-SHA:DES-CBC-SHA:RC4-SHA:RC4-MD5.

 
          		 [bookmark: pgfId-26883]FIPS - It includes all FIPS-compliant ciphers (that is, not NULL-SHA:DES-CBC-SHA:RC4-MD5:RC4-SHA:DES-CBC3-SHA)

 
          		 [bookmark: pgfId-26885]HIGH - It includes only AES-256 with SHA-2 ciphers, so it only applies to TLSV1.2.

 
         

  
       

 
        
        		[bookmark: pgfId-26891]Custom String

  
        		[bookmark: pgfId-26893]Use the CUSTOM keyword for Security Manager to exercise full control over the cipher suite using OpenSSL cipher definition strings.

 [bookmark: pgfId-26895]Note Beginning with version 4.9, Security Manager provides support for the following new TLSV1.2 ciphers for devices running the ASA software version 9.4(1) or higher.

 
          
          		 [bookmark: pgfId-26897]ECDHE_RSA_AES128_SHA256

 
          		 [bookmark: pgfId-26899]ECDHE_RSA_AES256_SHA384

 
          		 [bookmark: pgfId-26901]ECDHE_ECDSA_AES128_SHA256

 
          		 [bookmark: pgfId-26903]ECDHE_ECDSA_AES256_SHA384

 
         

  
       

 
        
        		[bookmark: pgfId-26909]ECDH Configuration

  
        		[bookmark: pgfId-26911]Select from one of the options (19,20,21,none) in the ECDH Group. This feature is available from Security Manager version 4.9 onwards for ASA devices version 9.4(1) or higher.
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    [bookmark: pgfId-28485]Note Due to import regulations in some countries the Oracle implementation provides a default cryptographic jurisdiction policy file that limits the strength of cryptographic algorithms. If stronger algorithms need to be configured or are already configured on the device (for example, AES with 256-bit keys, DH group with 5,14,24), follow these steps:


    
     

    

    

 
    [bookmark: pgfId-28489] 1. Download the Java 7 unlimited strength cryptography policy .jar files from http://www.oracle.com. Cisco recommends to search for the following on the Oracle website:

 
    [bookmark: pgfId-28491]Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy Files Java 7

 
    [bookmark: pgfId-28493](Click the download button to download the files by accepting the license agreement.)

 
    [bookmark: pgfId-28495] 2. Replace local_policy.jar and US_export_policy.jar on your Security Manager server in the folder CSCOpx\MDC\vms\jre\lib\security.

 
    [bookmark: pgfId-28497] 3. Restart your Security Manager server.

 
   
 
    
     [bookmark: pgfId-28513][bookmark: 111562][bookmark: pxchap_cncpt_ConfiguringSNMP-1]Configuring SNMP [bookmark: marker-28503][bookmark: marker-28505][bookmark: marker-28507][bookmark: marker-28509][bookmark: marker-28511]

 
    [bookmark: pgfId-28515]Simple Network Management Protocol (SNMP) defines a standard way for network management stations running on PCs or workstations to monitor the health and status of many types of devices, including switches, routers, and security appliances. You can use the SNMP page to configure a firewall device for monitoring by SNMP management stations.

 
    [bookmark: pgfId-28517]The Simple Network Management Protocol (SNMP) enables monitoring of network devices from a central location. Cisco security appliances support network monitoring using SNMP versions 1, 2c, and 3, as well as traps and SNMP read access; SNMP write access is not supported.

 
    [bookmark: pgfId-28519]You can configure a security appliance to send “traps” (event notifications) to a network management station (NMS), or you can use the NMS to browse the management information bases (MIBs) on the security appliance. Use CiscoWorks for Windows or any other SNMP MIB-II-compliant browser to receive SNMP traps and browse a MIB.

 
    [bookmark: pgfId-28521]The security appliance has an SNMP agent that notifies designated management stations if specified events occur, for example, when a link in the network goes up or down. The notification includes an SNMP system object ID (OID), identifying the device to the management stations. The security appliance SNMP agent also replies when a management station asks for information.

 
    [bookmark: pgfId-28523]SNMP MIBs and OIDs

 
    [bookmark: pgfId-28525]An SNMP trap reports significant events occurring on a network device, most often errors or failures. SNMP traps are defined in Management Information Bases (MIBs), which can be either standard or enterprise-specific.

 
    [bookmark: pgfId-28529]Standard traps and MIBs are created by the Internet Engineering Task Force (IETF) and documented in various RFCs. Standard traps are compiled into the security appliance software. If needed, you can also download RFCs, standard MIBS, and standard traps from the IETF website: http://www.ietf.org/.

 
    [bookmark: pgfId-28533]For Cisco MIB files and OIDs, refer to: http://www.cisco.com/public/sw-center/netmgmt/cmtk/mibs.shtml. OIDs may be downloaded from this FTP site: ftp://ftp.cisco.com/pub/mibs/oid/oid.tar.gz.

 
    [bookmark: pgfId-28535]This section contains the following topics:

 
     
     		 [bookmark: pgfId-28540]SNMP Terminology

 
     		 [bookmark: pgfId-28545]SNMP Version 3

 
     		 [bookmark: pgfId-28550]SNMP Page

 
    

 
     
      [bookmark: pgfId-28558][bookmark: 111592][bookmark: pxchap_cncpt_SNMPTerminology]SNMP Terminology[bookmark: marker-28556]

 
     [bookmark: pgfId-28560]Here are definitions for some common SNMP terms:

 
      
      		 [bookmark: pgfId-28562] Agent – The SNMP server running on the security appliance. The agent responds to requests for information and action from the management station. The agent also controls access to its management information base (MIB), the collection of data objects that can be viewed or changed by the SNMP manager.

 
      		 [bookmark: pgfId-28564] Management stations – The PCs or workstations set up to monitor SNMP events and manage devices such as the security appliance. Management stations can also receive messages about events which require attention, such as hardware failures.

 
      		 [bookmark: pgfId-28566] MIBs – The agent maintains standardized data structures called Management Information Bases (MIBs), used to collect information, such as packet, connection and error counters, and buffer usage and failover status. A number of MIBs are defined for specific products, and for the common protocols and hardware standards used by most network devices. SNMP management stations can browse MIBs, or request only specific fields. In some applications, MIB data can be modified for administrative purposes.

 
      		 [bookmark: pgfId-28568] OID – The SNMP standard assigns a system object ID (OID) so that a management station can uniquely identify network devices with SNMP agents, and indicate to users the source of information monitored and displayed.

 
      		 [bookmark: pgfId-28570] Traps – Specified events that generate a message from the SNMP agent to the management station. Events include alarm conditions such as linkup, linkdown, coldstart, warmstart, authentication, or syslog events.

 
     

 
    
 
     
      [bookmark: pgfId-28580][bookmark: 111615][bookmark: pxchap_cncpt_SNMPv3Overview]SNMP Version 3[bookmark: marker-28576][bookmark: marker-28578]

 
     [bookmark: pgfId-28582]SNMP Version 3 provides security enhancements that are not available in SNMP Version 1 or SNMP Version 2c. SNMP Versions 1 and 2c transmit data between the SNMP server and SNMP agent in clear text. SNMP Version 3 adds authentication and privacy options to secure protocol operations. In addition, this version controls access to the SNMP agent and MIB objects through the User-based Security Model (USM) and View-based Access Control Model (VACM). The ASA and ASASM also support the creation of SNMP groups and users, as well as hosts, which is required to enable transport authentication and encryption for secure SNMP communications.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-28584]Note SNMP Version 3 is supported on ASA devices running 8.2(1) or later and on ASASM devices running 8.5(1) or later.


     
      

     

     

 
     [bookmark: pgfId-28586]Security Models

 
     [bookmark: pgfId-28588]For configuration purposes, the authentication and privacy options are grouped together into security models. Security models apply to users and groups, which are divided into the following three types:

 
      
      		 [bookmark: pgfId-28590]NoAuth—No Authentication and No Privacy, which means that no security is applied to messages.

 
      		 [bookmark: pgfId-28592]Auth—Authentication but No Privacy, which means that messages are authenticated.

 
      		 [bookmark: pgfId-28594]Priv—Authentication and Privacy, which means that messages are authenticated and encrypted.

 
     

 
     [bookmark: pgfId-28596]SNMP Groups

 
     [bookmark: pgfId-28598]An SNMP group is an access control policy to which users can be added. Each SNMP group is configured with a security model, and is associated with an SNMP view. A user within an SNMP group must match the security model of the SNMP group. These parameters specify what type of authentication and privacy a user within an SNMP group uses. Each SNMP group name and security model pair must be unique.

 
     [bookmark: pgfId-28600]SNMP Users

 
     [bookmark: pgfId-28602]SNMP users have a specified username, a group to which the user belongs, authentication password, encryption password, and authentication and encryption algorithms to use. The authentication algorithm options are MD5 and SHA. The encryption algorithm options are DES, 3DES, and AES (which is available in 128, 192, and 256 versions). When you create a user, you must associate it with an SNMP group. The user then inherits the security model of the group.

 
     [bookmark: pgfId-28604]SNMP Hosts

 
     [bookmark: pgfId-28606]An SNMP host is an IP address to which SNMP notifications and traps are sent. To configure SNMP Version 3 hosts, along with the target IP address, you must configure a username, because traps are only sent to a configured user. SNMP target IP addresses and target parameter names must be unique on the ASA and ASA Services Module. Each SNMP host can have only one username associated with it. To receive SNMP traps, configure the SNMP NMS, and make sure that you configure the user credentials on the NMS to match the credentials for the ASA and ASASM.

 
     [bookmark: pgfId-28608]Implementation Differences Between the ASA, ASA Services Module, and the Cisco IOS Software

 
     [bookmark: pgfId-28610]The SNMP Version 3 implementation in the ASA and ASASM differs from the SNMP Version 3 implementation in the Cisco IOS software in the following ways:

 
      
      		 [bookmark: pgfId-28612]The local-engine and remote-engine IDs are not configurable. The local engine ID is generated when the ASA or ASASM starts or when a context is created.

 
      		 [bookmark: pgfId-28614]No support exists for view-based access control, which results in unrestricted MIB browsing.

 
      		 [bookmark: pgfId-28616]Support is restricted to the following MIBs: USM, VACM, FRAMEWORK, and TARGET.

 
      		 [bookmark: pgfId-28618]You must create users and groups with the correct security model.

 
      		 [bookmark: pgfId-28620]You must remove users, groups, and hosts in the correct sequence.

 
      		 [bookmark: pgfId-28622]Use of the  snmp-server host command creates an ASA or ASASM rule to allow incoming SNMP traffic.

 
     

 
    
 
     
      [bookmark: pgfId-28636][bookmark: 111662][bookmark: pxpage_cncpt_SNMPPage-1]SNMP Page[bookmark: marker-28630][bookmark: marker-28632][bookmark: marker-28634]

 
     [bookmark: pgfId-28638]Use the SNMP page to configure the security appliance for monitoring by Simple Network Management Protocol (SNMP) management stations.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-28640]Note For SNMP Version 3, configuration must occur in the following order: group, user, host.


     
      

     

     

 
     [bookmark: pgfId-28642]Navigation Path

 
      
      		 [bookmark: pgfId-28644](Device view) Select  Platform > Device Admin > Device Access > SNMP from the Device Policy selector.

 
      		 [bookmark: pgfId-28646](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Device Access > SNMP from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
     

 
     [bookmark: pgfId-28648]Related Topics

 
      
      		 [bookmark: pgfId-28653]Configuring SNMP

 
      		 [bookmark: pgfId-28658]SNMP Trap Configuration Dialog Box

 
      		 [bookmark: pgfId-28663]Add/Edit SNMP Host Access Entry Dialog Box

 
      		 [bookmark: pgfId-28668]Add/Edit SNMP Group Entry Dialog Box

 
      		 [bookmark: pgfId-28673]Add/Edit SNMP User Entry Dialog Box

 
     

 
     [bookmark: pgfId-28675]Field Reference

 
     [bookmark: pgfId-28678] 

 
      
       
        
        [bookmark: pgfId-26924]Table 49-9 [bookmark: 111708]SNMP Page 

 
        
       
         
         		
           
           [bookmark: pgfId-26930]Element
          
  
         		
           
           [bookmark: pgfId-26932]Description
          
  
        

 
         
         		[bookmark: pgfId-26938]Enable SNMP Servers

  
         		[bookmark: pgfId-26940]When this option is selected, the security device provides SNMP information on the specified interface(s). You can deselect this option to disable SNMP monitoring while retaining the configuration information.

  
        

 
         
         		[bookmark: pgfId-26946]Read Community String

 [bookmark: pgfId-26948]Confirm

  
         		[bookmark: pgfId-26950]Enter the password used by a SNMP management station when sending requests to this device. The SNMP community string is a shared secret among the SNMP management stations and the network nodes being managed. The security device uses the password to determine if the incoming SNMP request is valid. The password is a case-sensitive alphanumeric string of up to 32 characters; spaces are not permitted.

 [bookmark: pgfId-26952]Repeat the password in the Confirm field to ensure it was entered correctly.

  
        

 
         
         		[bookmark: pgfId-26958]System Administrator Name

  
         		[bookmark: pgfId-26960]Enter the name of the device administrator or other contact person. This string is case-sensitive and can be up to 127 characters. Spaces are accepted, but multiple spaces are shortened to a single space.

  
        

 
         
         		[bookmark: pgfId-26966]Location

  
         		[bookmark: pgfId-26968]Describe the location of this security device (for example, Building 42, Sector 54). This string is case-sensitive and can be up to 127 characters. Spaces are accepted, but multiple spaces are shortened to a single space.

  
        

 
         
         		[bookmark: pgfId-26974]Port (PIX 7.x, ASA and FWSM 3.x only)

  
         		[bookmark: pgfId-26976]Specify the port on which incoming requests will be accepted. The default is 161.

  
        

 
         
         		[bookmark: pgfId-26982]Configure SNMP Traps

  
         		[bookmark: pgfId-26987]Click this button to configure SNMP traps in the SNMP Trap Configuration Dialog Box.

  
        

 
         
         		[bookmark: pgfId-26993]SNMP Engine ID

  
         		[bookmark: pgfId-26995]Shows the ID of the SNMP engine configured on the device. Click Get SNMP Engine ID to retrieve the engine ID from the device.

  
        

 
         
         		[bookmark: pgfId-27001]SNMP Hosts table

  
         		[bookmark: pgfId-27006]This table lists the SNMP management stations that can access the security appliance. This is a standard Security Manager table, with Add Row, Edit Row and Delete Row buttons, as described in Using Tables.

 [bookmark: pgfId-27011]The Add Row and Edit Row buttons open the Add/Edit SNMP Host Access Entry Dialog Box, used to add and edit management station host entries.

 [bookmark: pgfId-27013]Note For ASA devices running 9.1(5) or later, you can configure up to 128 SNMP hosts. For other devices and earlier ASA versions, you can only configure up to 32 SNMP hosts.

  
        

 
         
         		 
           
           [bookmark: pgfId-27019]SNMPv3 Configuration
          
  
        

 
         
         		[bookmark: pgfId-27027]SNMP Group tab

  
         		[bookmark: pgfId-27032]Lists the SNMP groups that have been configured. This is a standard Security Manager table, with Add Row, Edit Row and Delete Row buttons, as described in Using Tables.

 [bookmark: pgfId-27037]The Add Row and Edit Row buttons open the Add/Edit SNMP Group Entry Dialog Box, used to add and edit SNMP groups.

  
        

 
         
         		[bookmark: pgfId-27043]SNMP User tab

  
         		[bookmark: pgfId-27048]Lists the SNMP users that have been configured. This is a standard Security Manager table, with Add Row, Edit Row and Delete Row buttons, as described in Using Tables.

 [bookmark: pgfId-27053]The Add Row and Edit Row buttons open the Add/Edit SNMP User Entry Dialog Box, used to add and edit SNMP users.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-28692][bookmark: 111789][bookmark: pxpage_cncpt_SNMPTrapConfigurationDialogBox]SNMP Trap Configuration Dialog Box [bookmark: marker-28686][bookmark: marker-28688][bookmark: marker-28690]

 
     [bookmark: pgfId-28694]Use the SNMP Trap Configuration dialog box to configure SNMP traps (event notifications) for the selected security device.

 
     [bookmark: pgfId-28696]Traps are different than browsing; they are unsolicited “comments” from the managed device to the management station for certain events, such as linkup, linkdown, and syslog event generated.

 
     [bookmark: pgfId-28698]An SNMP object ID (OID) for the device appears in SNMP event traps sent from the device. The SNMP service running on a security device performs two functions:

 
      
      		 [bookmark: pgfId-28700]Replies to SNMP requests from management stations.

 
      		 [bookmark: pgfId-28702]Sends traps to management stations or other devices that are registered to receive them from the security appliance.

 
     

 
     [bookmark: pgfId-28704]Cisco security devices support three types of traps:

 
      
      		 [bookmark: pgfId-28706]firewall

 
      		 [bookmark: pgfId-28708]generic

 
      		 [bookmark: pgfId-28710]syslog

 
     

 
     [bookmark: pgfId-28712]In the SNMP Trap Configuration dialog box, available traps are presented on four tabbed panels: Standard, Entity MIB, Resource, and Other.

 
     [bookmark: pgfId-28714]Navigation Path

 
     [bookmark: pgfId-28719]You can access the SNMP Trap Configuration dialog box from the SNMP Page.

 
     [bookmark: pgfId-28721]Related Topics

 
      
      		 [bookmark: pgfId-28726]Configuring SNMP

 
      		 [bookmark: pgfId-28731]Add/Edit SNMP Host Access Entry Dialog Box

 
     

 
     [bookmark: pgfId-28733]Field Reference

 
     [bookmark: pgfId-28736] 

 
      
       
        
        [bookmark: pgfId-27066]Table 49-10 [bookmark: 111840]SNMP Trap Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-27072]Element
          
  
         		
           
           [bookmark: pgfId-27074]Description
          
  
        

 
         
         		[bookmark: pgfId-27080]Enable All SNMP Traps

  
         		[bookmark: pgfId-27082]Check this box to quickly select all traps on all four tabbed panels.

  
        

 
         
         		[bookmark: pgfId-27088]Enable Syslog Traps

  
         		[bookmark: pgfId-27090]Check this box to enable transmission of trap-related syslog messages.

 [bookmark: pgfId-27095]The severity level for syslog messages trapped is set on the Logging Filters Page.

  
        

 
         
         		 [bookmark: pgfId-27101]Select the desired event-notification traps on the following four tabbed panels. Note that only the traps applicable to the selected device are displayed in the dialog box.

  
        

 
         
         		[bookmark: pgfId-27109]Standard

  
         		
           
           		 [bookmark: pgfId-27111] Authentication – Unauthorized SNMP access. This authentication failure occurs for packets with an incorrect community string.

 
           		 [bookmark: pgfId-27113] Link Up – One of the device’s communication links has become available (it has “come up”), as indicated in the notification.

 
           		 [bookmark: pgfId-27115] Link Down – One of the device’s communication links has failed, as indicated in the notification.

 
           		 [bookmark: pgfId-27117] Cold Start – The device is reinitializing itself such that its configuration or the protocol entity implementation may be altered.

 
           		 [bookmark: pgfId-27119] Warm Start – The device is reinitializing itself such that its configuration and the protocol entity implementation is unaltered.

 
          

  
        

 
         
         		[bookmark: pgfId-27125]Entity MIB

  
         		
           
           		 [bookmark: pgfId-27127] Field Replaceable Unit Insert – A Field Replaceable Unit (FRU) has been inserted, as indicated. (FRUs include assemblies such as power supplies, fans, processor modules, interface modules, etc.)

 
           		 [bookmark: pgfId-27129] Field Replaceable Unit Delete – A Field Replaceable Unit (FRU) has been removed, as indicated in the notification.

 
           		 [bookmark: pgfId-27131] Configuration Change – There has been a hardware change, as indicated in the notification.

 
           		 [bookmark: pgfId-27133] Fan Failure – A device cooling fan has failed, as indicated in the notification.

 
           		 [bookmark: pgfId-27135] CPU Temperature – Temperature of the central processing unit has reached the configured limit.

 
           		 [bookmark: pgfId-27137] Power-Supply Failure – A device power supply has failed, as indicated in the notification.

 
           		 [bookmark: pgfId-27139] Redundancy Switchover – Switchover occurred for redundant component, as indicated in the notification.

 
           		 [bookmark: pgfId-27141] Alarm Asserted – The condition described by the alarm exists.

 
           		 [bookmark: pgfId-27143] Alarm Cleared – The condition described by the alarm does not exist.

 
          

  
        

 
         
         		[bookmark: pgfId-27149]Resource

  
         		
           
           		 [bookmark: pgfId-27151] Connection Limit Reached – This trap indicates that a connection attempt was rejected because the configured connections limit has been reached.

 
           		 [bookmark: pgfId-27153] Resource Limit Reached – This notification is generated when the configured resource limit is reached, as described in the notification.

 
           		 [bookmark: pgfId-27155] Resource Rate Limit Reached – This notification is generated when the configured resource rate limit is reached, as described in the notification

 
          

  
        

 
         
         		[bookmark: pgfId-27161]Other

  
         		
           
           		 [bookmark: pgfId-27163] IKEv2 Start – Internet Key Exchange version 2 (IKEv2) exchange initiated.

 
           		 [bookmark: pgfId-27165] IKEv2 Stop – Internet Key Exchange version 2 (IKEv2) exchange terminated.

 
           		 [bookmark: pgfId-27167] Memory Threshold – Available free memory has fallen below configured threshold, as indicated in the notification.

 
           		 [bookmark: pgfId-27169] ASA CPU Rising Threshold – This notification is triggered when utilization of CPU resources exceeds the specified Percentage for a specified Period of time:

 
          

 [bookmark: pgfId-27171]Percentage – Enter the desired upper limit of CPU resource usage as a percentage of total available. Valid values range from 10 to 94; default is 70%.

 [bookmark: pgfId-27173]Period – Specify the length of time, in minutes, that the specified Percentage can be exceeded before notification is triggered. Valid values range from 1 to 60.

 
           
           		 [bookmark: pgfId-27175] Interface Threshold – This notification is triggered when utilization of a physical interface exceeds the specified Percentage of total bandwidth:

 
          

 [bookmark: pgfId-27177]Percentage – Enter the desired upper limit on interface usage as a percentage of total available bandwidth. Valid values range from 30 to 99; default is 70%.

 
           
           		 [bookmark: pgfId-27179] IPSec Start – IPsec has started, as indicated in the notification.

 
           		 [bookmark: pgfId-27181] IPSec Stop – IPsec has stopped, as indicated in the notification.

 
           		 [bookmark: pgfId-27183] Remote Access Session Threshold Exceeded – The number of remote access sessions has reach the defined limit, as indicated in the notification.

 
           		 [bookmark: pgfId-27185] NAT Packet Discard – This notification is generated when IP packets are discarded by the NAT function. Available Network Address Translation addresses or ports have fallen below configured threshold.

 
           		 [bookmark: pgfId-27187] CPU Rising Threshold – This notification is triggered when utilization of CPU resources exceeds the specified Percentage for a specified Period of time:

 
          

 [bookmark: pgfId-27189]Percentage – Enter the desired upper limit of CPU resource usage as a percentage of total available. Valid values range from 10 to 100; default is 70%.

 [bookmark: pgfId-27191]Period – Specify the length of time, in seconds, that the specified Percentage can be exceeded before notification is triggered. Valid values range from 60 to 3600.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-28750][bookmark: 111978][bookmark: pxpage_cncpt_AddSNMPHostAccessEntryDialogBox]Add/Edit SNMP Host Access Entry Dialog Box [bookmark: marker-28744][bookmark: marker-28746][bookmark: marker-28748]

 
     [bookmark: pgfId-28752]Use the Add/Edit SNMP Host Access Entry dialog box to add and edit entries in the SNMP Hosts table on the SNMP page. These entries represent SNMP management stations allowed to access the security device.

 
     [bookmark: pgfId-28754]For ASA devices running any software version between 9.1(5) and 9.3(2), you can configure 128 SNMP hosts. For ASA devices running the software version lower than 9.1(5) you can configure only 32 SNMP hosts.

 
     [bookmark: pgfId-28756]Beginning with version 4.9, Security Manager enables you to configure up to 4096 SNMP hosts for ASA devices running the software version 9.4(1) or higher. However, only 128 of this number can be for traps. You cannot configure more than 128 trap configured SNMP hosts.

 
     [bookmark: pgfId-28758]Navigation Path

 
     [bookmark: pgfId-28763]You can access the Add/Edit SNMP Host Access Entry dialog box from the SNMP Page.

 
     [bookmark: pgfId-28765]Related Topics

 
      
      		 [bookmark: pgfId-28770]Configuring SNMP

 
      		 [bookmark: pgfId-28775]SNMP Trap Configuration Dialog Box

 
      		 [bookmark: pgfId-28780]Add/Edit SNMP Group Entry Dialog Box

 
      		 [bookmark: pgfId-28785]Add/Edit SNMP User Entry Dialog Box

 
     

 
     [bookmark: pgfId-28787]Field Reference

 
     [bookmark: pgfId-28790] 

 
      
       
        
        [bookmark: pgfId-27204]Table 49-11 [bookmark: 112018]Add/Edit SNMP Host Access Entry Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-27210]Element
          
  
         		
           
           [bookmark: pgfId-27212]Description
          
  
        

 
         
         		[bookmark: pgfId-27218]Interface Name

  
         		[bookmark: pgfId-27220]Enter or Select the interface on which this SNMP management station contacts the device.

  
        

 
         
         		[bookmark: pgfId-27226]IP Address

  
         		[bookmark: pgfId-27228]Enter the IP address, or Select a Networks/Hosts object, representing the SNMP management station.

  
        

 
         
         		[bookmark: pgfId-27234]UDP Port

  
         		[bookmark: pgfId-27236](Optional) Enter a UDP port for requests from the SNMP host. You can use this field to override the global value specified on the SNMP page.

  
        

 
         
         		[bookmark: pgfId-27242]Community String

 [bookmark: pgfId-27244]Confirm

  
         		[bookmark: pgfId-27246]Enter the password used by the SNMP management station when sending requests to the security device. The SNMP community string is a shared secret among the SNMP management stations and the network nodes being managed. Thus, the password is used to determine if the incoming SNMP request is valid. The password is a case-sensitive alphanumeric string of up to 32 characters; spaces are not permitted.

 [bookmark: pgfId-27248]Repeat the password in the Confirm field.

  
        

 
         
         		[bookmark: pgfId-27254]SNMP Version

  
         		[bookmark: pgfId-27256]Choose the version of SNMP used by this management station: 1, 2c, or 3.

  
        

 
         
         		[bookmark: pgfId-27262]SNMP User Name

  
         		[bookmark: pgfId-27267]If SNMP version 3 is selected, select the SNMP user. For information on SNMP users, see Add/Edit SNMP User Entry Dialog Box.

  
        

 
         
         		[bookmark: pgfId-27273]Server Poll/Trap Specification

  
         		[bookmark: pgfId-27275]Specify the type(s) of communication with this management station: poll only, trap only, or both trap and poll. Check either or both:

 
           
           		 [bookmark: pgfId-27277]Poll – The security device waits for periodic requests from the management station.

 
           		 [bookmark: pgfId-27279]Trap – The device sends trap events when they occur.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-28802][bookmark: 112076][bookmark: pxpage_cncpt_SNMPGroupDialogBox]Add/Edit SNMP Group Entry Dialog Box[bookmark: marker-28798][bookmark: marker-28800]

 
     [bookmark: pgfId-28804]Use the Add/Edit SNMP Group Entry dialog box to add and edit entries in the SNMP Groups table on the SNMP page. An SNMP group is an access control policy to which users can be added. Each SNMP group is configured with a security model, and is associated with an SNMP view. A user within an SNMP group must match the security model of the SNMP group. These parameters specify what type of authentication and privacy a user within an SNMP group uses. Each SNMP group name and security model pair must be unique.

 
     [bookmark: pgfId-28806]For configuration purposes, the authentication and privacy options are grouped together into security models. Security models apply to users and groups, which are divided into the following three types:

 
      
      		 [bookmark: pgfId-28808]NoAuth—No Authentication and No Privacy, which means that no security is applied to messages.

 
      		 [bookmark: pgfId-28810]Auth—Authentication but No Privacy, which means that messages are authenticated.

 
      		 [bookmark: pgfId-28812]Priv—Authentication and Privacy, which means that messages are authenticated and encrypted.

 
     

 
     [bookmark: pgfId-28814]Notes

 
      
      		 [bookmark: pgfId-28816]Before a group can be deleted, you must ensure that all users associated with that group are deleted. If any hosts are associated with a user that needs to be deleted, you must delete those hosts before you can delete the user.

 
      		 [bookmark: pgfId-28818]If users have been configured to belong to a particular group with a certain security model, you must do the following to change the security level of that group:

 
     

 
     [bookmark: pgfId-28820] a. Remove all host entries associated with any users belonging to the group.

 
     [bookmark: pgfId-28822] b. Remove the users from the group.

 
     [bookmark: pgfId-28824] c. Deploy the changes to the device.

 
     [bookmark: pgfId-28826] d. Change the group security level.

 
     [bookmark: pgfId-28828] e. Add users that belong to the group.

 
     [bookmark: pgfId-28830] f. Add hosts belonging to the users that were added for the group.

 
     [bookmark: pgfId-28832] g. Deploy the changes to the device.

 
     [bookmark: pgfId-28834]Navigation Path

 
     [bookmark: pgfId-28839]You can access the Add/Edit SNMP Group Entry dialog box from the SNMP Page.

 
     [bookmark: pgfId-28841]Related Topics

 
      
      		 [bookmark: pgfId-28846]Configuring SNMP

 
      		 [bookmark: pgfId-28851]SNMP Trap Configuration Dialog Box

 
      		 [bookmark: pgfId-28856]Add/Edit SNMP Host Access Entry Dialog Box

 
      		 [bookmark: pgfId-28861]Add/Edit SNMP User Entry Dialog Box

 
     

 
     [bookmark: pgfId-28863]Field Reference

 
     [bookmark: pgfId-28866] 

 
      
       
        
        [bookmark: pgfId-27292]Table 49-12 [bookmark: 112140]Add/Edit SNMP Group Entry Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-27298]Element
          
  
         		
           
           [bookmark: pgfId-27300]Description
          
  
        

 
         
         		[bookmark: pgfId-27306]Group Name

  
         		[bookmark: pgfId-27308]Enter the name of the SNMP group. Group names must be 32 characters or less.

  
        

 
         
         		[bookmark: pgfId-27314]Security Level

  
         		[bookmark: pgfId-27316]Specify the security level for the group:

 
           
           		 [bookmark: pgfId-27318]NoAuth—No Authentication and No Privacy, which means that no security is applied to messages.

 
           		 [bookmark: pgfId-27320]Auth—Authentication but No Privacy, which means that messages are authenticated.

 
           		 [bookmark: pgfId-27322]Priv—Authentication and Privacy, which means that messages are authenticated and encrypted.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-28878][bookmark: 112168][bookmark: pxpage_cncpt_SNMPUserDialogBox]Add/Edit SNMP User Entry Dialog Box[bookmark: marker-28874][bookmark: marker-28876]

 
     [bookmark: pgfId-28880]Use the Add/Edit SNMP User Entry dialog box to add a user to an SNMP group or to edit entries in the SNMP User table on the SNMP page. SNMP users inherit the security model of the group to which they are assigned.

 
     [bookmark: pgfId-28882]Notes

 
      
      		 [bookmark: pgfId-28884]After a user has been created, you cannot change the group to which the user belongs.

 
      		 [bookmark: pgfId-28886]Before a user can be deleted, you must ensure that no hosts are configured that are associated with that username.

 
     

 
     [bookmark: pgfId-28888]Navigation Path

 
     [bookmark: pgfId-28893]You can access the Add/Edit SNMP User Entry dialog box from the SNMP Page.

 
     [bookmark: pgfId-28895]Related Topics

 
      
      		 [bookmark: pgfId-28900]Configuring SNMP

 
      		 [bookmark: pgfId-28905]SNMP Trap Configuration Dialog Box

 
      		 [bookmark: pgfId-28910]Add/Edit SNMP Host Access Entry Dialog Box

 
      		 [bookmark: pgfId-28915]Add/Edit SNMP Group Entry Dialog Box

 
     

 
     [bookmark: pgfId-28917]Field Reference

 
     [bookmark: pgfId-28920] 

 
      
       
        
        [bookmark: pgfId-27335]Table 49-13 [bookmark: 112209]Add/Edit SNMP User Entry Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-27341]Element
          
  
         		
           
           [bookmark: pgfId-27343]Description
          
  
        

 
         
         		[bookmark: pgfId-27349]Group Name

  
         		[bookmark: pgfId-27354]Select the SNMP group to which this user belongs. For information on SNMP groups, see Add/Edit SNMP Group Entry Dialog Box.

  
        

 
         
         		[bookmark: pgfId-27360]Security Level

  
         		[bookmark: pgfId-27362]Shows the security level for the selected group:

 
           
           		 [bookmark: pgfId-27364]NoAuth—No Authentication and No Privacy, which means that no security is applied to messages.

 
           		 [bookmark: pgfId-27366]Auth—Authentication but No Privacy, which means that messages are authenticated.

 
           		 [bookmark: pgfId-27368]Priv—Authentication and Privacy, which means that messages are authenticated and encrypted.

 
          

  
        

 
         
         		[bookmark: pgfId-27374]User Name

  
         		[bookmark: pgfId-27376]Enter the name of the SNMP user. Usernames must be 32 characters or less and must be unique for the SNMP server group selected.

  
        

 
         
         		[bookmark: pgfId-27382]Encrypt Password Type

  
         		[bookmark: pgfId-27384]Specify the type of password you want to use: Clear Text or Encrypted.

 [bookmark: pgfId-27386]If the password type is Clear Text, Security Manager will encrypt the password when deploying to the device. If the password type is Encrypted, Security Manager will directly deploy the encrypted password. Security Manager will never directly deploy the clear text password to device.

  
        

 
         
         		[bookmark: pgfId-27392]Auth Algorithm Type

  
         		[bookmark: pgfId-27394]Specify the type of authentication you want to use: MD5 or SHA.

  
        

 
         
         		[bookmark: pgfId-27400]Authentication Password

 [bookmark: pgfId-27402]Confirm

  
         		[bookmark: pgfId-27404]Enter the password to use for authentication. If you selected Encrypted as the Encrypt Password Type, the password must be formatted as xx:xx:xx..., where xx are hexadecimal values.

 [bookmark: pgfId-27406]Note The length of the password will depend on the authentication algorithm selected. For all passwords, the length must be 256 characters or less.

 [bookmark: pgfId-27408]If you selected Clear Text as the Encrypt Password Type, repeat the password in the Confirm field.

  
        

 
         
         		[bookmark: pgfId-27414]Encryption Type

  
         		[bookmark: pgfId-27416]Specify the type of encryption you want to use: AES128, AES192, AES256, 3DES, DES.

 [bookmark: pgfId-27418]Note To use AES or 3DES encryption, you must have the appropriate license installed on the device.

  
        

 
         
         		[bookmark: pgfId-27424]Encryption Password

 [bookmark: pgfId-27426]Confirm

  
         		[bookmark: pgfId-27428]Enter the password to use for encryption. If you selected Encrypted as the Encrypt Password Type, the password must be formatted as xx:xx:xx..., where xx are hexadecimal values.

 [bookmark: pgfId-27430]For encrypted passwords, the length of the password depends on the encryption type selected. The password sizes are as follows (where each xx is one octal):

 
           
           		 [bookmark: pgfId-27432]AES 128 requires 16 octals

 
           		 [bookmark: pgfId-27434]AES 192 requires 24 octals

 
           		 [bookmark: pgfId-27436]AES 256 requires 32 octals

 
           		 [bookmark: pgfId-27438]3DES requires 32 octals

 
           		 [bookmark: pgfId-27440]DES can be any size

 
          

 [bookmark: pgfId-27442]Note For all passwords, the length must be 256 characters or less.

 [bookmark: pgfId-27444]If you selected Clear Text as the Encrypt Password Type, repeat the password in the Confirm field.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-28934][bookmark: 112297][bookmark: pxpage_cncpt_TelnetPage]Telnet Page[bookmark: marker-28928][bookmark: marker-28930][bookmark: marker-28932]

 
    [bookmark: pgfId-28936]Use the Telnet page to configure rules that permit only specific hosts or networks to connect to the firewall device using the Telnet protocol.

 
    [bookmark: pgfId-28938]The rules restrict administrative Telnet access through a firewall device interface to a specific IP address and netmask. Connection attempts that comply with the rules must then be authenticated by a preconfigured AAA server or the Telnet password. You can monitor Telnet sessions using Monitoring > Telnet Sessions.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-28940]Note Only five Telnet sessions can be active at the same time in single-context mode. In multiple-context mode on ASAs, there can be only five Telnet sessions active per context, 100 Telnet sessions active per blade. With resource class, the administrator can further tune this parameter.


    
     

    

    

 
    [bookmark: pgfId-28942]Related Topics

 
    [bookmark: pgfId-28944]Navigation Path

 
     
     		 [bookmark: pgfId-28946](Device view) Select  Platform > Device Admin > Device Access > Telnet from the Device Policy selector.

 
     		 [bookmark: pgfId-28948](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Device Access > Telnet from the Policy Type selector. Right-click  Telnet to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-28950]Related Topics

 
     
     		 [bookmark: pgfId-28955]Telnet Configuration Dialog Box

 
    

 
    [bookmark: pgfId-28957]Field Reference

 
    [bookmark: pgfId-28960] 

 
     
      
       
       [bookmark: pgfId-27457]Table 49-14 [bookmark: 112335]Telnet Page 

 
       
      
        
        		
          
          [bookmark: pgfId-27463]Element
         
  
        		
          
          [bookmark: pgfId-27465]Description
         
  
       

 
        
        		[bookmark: pgfId-27471]Timeout

  
        		[bookmark: pgfId-27473]Number of minutes a Telnet session can remain idle before the firewall device closes it. Values can range from 1 to 1440 minutes.

  
       

 
        
        		 
          
          [bookmark: pgfId-27479]Telnet Access Table
         
  
       

 
        
        		[bookmark: pgfId-27487]Interface

  
        		[bookmark: pgfId-27489]Interface that receives Telnet packets from the client.

  
       

 
        
        		[bookmark: pgfId-27495]IP Addresses

  
        		[bookmark: pgfId-27497]The IP address and network mask of each host or network that can access the Telnet console through the specified interface.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-28974][bookmark: 112365][bookmark: pxpage_cncpt_TelnetConfigurationDialogBox]Telnet Configuration Dialog Box[bookmark: marker-28968][bookmark: marker-28970][bookmark: marker-28972]

 
     [bookmark: pgfId-28976]Use the Telnet Configuration dialog box to configure Telnet options for an interface.

 
     [bookmark: pgfId-28978]Navigation Path

 
     [bookmark: pgfId-28983]You can access the Telnet Configuration dialog box from the Telnet Page.

 
     [bookmark: pgfId-28985]Field Reference

 
     [bookmark: pgfId-28988] 

 
      
       
        
        [bookmark: pgfId-27510]Table 49-15 [bookmark: 112388]Telnet Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-27516]Element
          
  
         		
           
           [bookmark: pgfId-27518]Description
          
  
        

 
         
         		[bookmark: pgfId-27524]Interface Name

  
         		[bookmark: pgfId-27526]Enter or Select an interface that can receive Telnet packets from a client.

  
        

 
         
         		[bookmark: pgfId-27532]IP Addresses/Netmask

  
         		[bookmark: pgfId-27534]Enter or Select the IP address and netmask, separated by a “/”, of each host or network permitted to access the firewall device’s Telnet console through the specified interface. Use commas to separate multiple entries.

 [bookmark: pgfId-27536]Note To limit access to a single IP address, use 255.255.255.255 or 32 as the netmask. Do not use the subnetwork mask of the internal network.
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     [bookmark: pgfId-242093][bookmark: 54461][bookmark: porules_cncpt_WorkingwithScanSafe]Working with ScanSafe Web Security
      
      
 
     
 

 
    [bookmark: pgfId-242095]Security Manager provides integration with ScanSafe Web Security. ScanSafe Web Security is a cloud-based SaaS (Security as a Service) function that makes available its web security data centers at various locations worldwide. When ScanSafe Web Security is integrated with a router, selected HTTP and HTTPS traffic is redirected to ScanSafe Cloud for content scanning and for malware detection by other means. Also, you can use ScanSafe Web Security to provide differentiated services to particular users, user groups, and IPs.

 
    [bookmark: pgfId-242097]Invoking ScanSafe Web Security from Security Manager, you can define policies and settings in the following areas:

 
     
     		 [bookmark: pgfId-242099]Content scanning settings

 
     		 [bookmark: pgfId-242101]Content scanning policies

 
     		 [bookmark: pgfId-242103]AAA server settings

 
     		 [bookmark: pgfId-242105]AAA policies

 
    

 
    [bookmark: pgfId-242108]With ScanSafe Web Security integration in Security Manager you can copy and share most policies and framework-based policy features. The following table details the scope of support for scanning and AAA policy types.

 
     
      
      
        
        		
          
          [bookmark: pgfId-241015]Supported Type
         
  
        		
          
          [bookmark: pgfId-241017]Example
         
  
       

 
        
        		[bookmark: pgfId-241023]Content Scan Settings

  
        		[bookmark: pgfId-241025]Primary server IP, secondary server IP, server timeouts

  
       

 
        
        		[bookmark: pgfId-241031]Content Scan Policies

  
        		[bookmark: pgfId-241033]Global whitelist policies

 [bookmark: pgfId-241035]Include/exclude user groups, default user configuration, default user group configuration

 [bookmark: pgfId-241037]Interfaces that must have content scanning enabled

  
       

 
        
        		[bookmark: pgfId-241043]AAA Server Settings

  
        		[bookmark: pgfId-241045]Identity policy object used in http-basic and NTLM policy

 [bookmark: pgfId-241047]Http-basic and NTLM related timeouts

 [bookmark: pgfId-241049]Order of occurrence for proxy, http-basic, and NTLM

 [bookmark: pgfId-241051]LDAP server and LDAP attribute map configuration for IOS

 [bookmark: pgfId-241053]Note Radius and TACAS servers are also supported.

 [bookmark: pgfId-241055]Per interface AAA list

  
       

 
        
        		[bookmark: pgfId-241061]AAA Policies

  
        		[bookmark: pgfId-241063]Http-basic and NTLM admission rule support (authentication methods) now join the previously available Auth-Proxy method

  
       

 
      
     

 
    
 
    [bookmark: pgfId-242110]Security Manager does not support the following features:

 
     
     		 [bookmark: pgfId-242112]PAM configuration when inspect or ZBF rules for http/https are not present

 
     		 [bookmark: pgfId-242114]Auth-proxy using LDAP on older IOS versions. (That is, only IOS versions that support ScanSafe Web Security)

 
     		 [bookmark: pgfId-242116]Identity policy with auth-proxy as AAA method. (Support only for NTLM and http-basic.)

 
     		 [bookmark: pgfId-242118]Validation of Virtual Template number for identity policy creation

 
     		 [bookmark: pgfId-242120]Validation of the Secure Trust Point for LDAP server

 
     		 [bookmark: pgfId-242122]Inheritance of content scanning rules

 
     		 [bookmark: pgfId-242124]AD browsing of user groups and users

 
     		 [bookmark: pgfId-242126]Tool support for newer policies (such as policy query)

 
     		 [bookmark: pgfId-242128]Control tag policy

 
    

 
    [bookmark: pgfId-242132]For more information on the ScanSafe Web Security product, go to http://www.cisco.com/en/US/partner/products/ps11720/index.html.

 
    [bookmark: pgfId-242134]Related Topics

 
     
     		 [bookmark: pgfId-242139]ScanSafe Web Security Page

 
     		 [bookmark: pgfId-242144]ScanSafe Web Security Settings Page

 
     		 [bookmark: pgfId-242149]Configuring ScanSafe Web Security

 
     		 [bookmark: pgfId-242154]Add and Edit Default User Groups Dialog Box

 
    

 
    [bookmark: pgfId-242156]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-242161]Configuring ScanSafe Web Security

 
     		 [bookmark: pgfId-242166]ScanSafe Web Security Page

 
     		 [bookmark: pgfId-242171]ScanSafe Web Security Settings Page

 
    

 
   
 
    
     [bookmark: pgfId-242177][bookmark: 54549][bookmark: porules_proc_ConfiguringScanSafe]Configuring ScanSafe Web Security

 
    [bookmark: pgfId-242179]Use the ScanSafe Web Security Settings page to define the settings for the default user group. As with other settings policies, you can share the default user group policy settings.

 
    [bookmark: pgfId-242181]Related Topics

 
     
     		 [bookmark: pgfId-242186]ScanSafe Web Security Page

 
     		 [bookmark: pgfId-242191]ScanSafe Web Security Settings Page

 
     		 [bookmark: pgfId-242196]Chapter 20, “Working with ScanSafe Web Security”

 
     		 [bookmark: pgfId-242201]Add and Edit Default User Groups Dialog Box

 
     		 [bookmark: pgfId-242206]AAA Rules Page

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-242208]Note All steps are shown as performed from the Policy view.


    
     

    

    

 
    [bookmark: pgfId-242210]To configure ScanSafe Web Security, perform the following steps:

 
    
 
    [bookmark: pgfId-242212]Step 1 From the Policy Types selector, select Firewall > ScanSafe Web Security.

 
    [bookmark: pgfId-242214]The ScanSafe Web Security page appears with the Interfaces tab selected.

 
    [bookmark: pgfId-242216]Step 2 Enable those interfaces by which web requests are to be forwarded to the ScanSafe Web Security server by selecting them from the list in the Available Interfaces column and moving them to the Selected Interfaces column.

 
    [bookmark: pgfId-242218]Step 3 Select the WhiteListing Regular Expressions tab.

 
    [bookmark: pgfId-242220]Step 4 Select the Notify Tower checkbox to send notifications to the ScanSafe Web Security server regarding the whitelisting. It is applicable to all whitelisting except that which is IP-based.

 
    [bookmark: pgfId-242222](ScanSafe Web Security receives a warning when no regular expression is specified for white listing.)

 
    [bookmark: pgfId-242224]Step 5 In the HTTP Host area specify the regular expressions to be whitelisted (using regular expression matching) by selecting them from the list in the Available Regular Expressions column and moving them to the Selected Regular Expressions column.

 
    [bookmark: pgfId-242226]Step 6 In the HTTP User Agent area specify the regular expressions to be whitelisted by selecting them from the list in the Available Regular Expressions column and moving them to the Selected Regular Expressions column.

 
    [bookmark: pgfId-242228]Step 7 Select the WhiteListing ACLs tab.

 
    [bookmark: pgfId-242230]Step 8 Specify the type of ACLs to operate upon by selecting either Extended or Standard from the Type list.

 
    [bookmark: pgfId-242232]Step 9 Specify the ACLs to whitelist by selecting them from the list in the column on the left and moving them to the Selected items column.

 
    [bookmark: pgfId-242234]Step 10 Select the User Groups tab.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-242236]Tip You can use the User Groups page to define user groups, specify both the default user and default user group, and to include or exclude user groups. You can also edit or delete entries in all three of these lists.


    
     

    

    

 
    [bookmark: pgfId-242238]Step 11 Specify a default user by entering the user name in the Default User field (optional).

 
    [bookmark: pgfId-242240]Step 12 Specify a default user group by entering the user group name in the Default User Group field.

 
    [bookmark: pgfId-242242]Step 13 Include a user group by selecting the interface and then adding the user group to the Include list.

 
    [bookmark: pgfId-242244]Step 14 Exclude a user group by selecting the interface and then adding the user group to the Exclude list.

 
    [bookmark: pgfId-242246]Step 15 Select Policy > Firewall > Settings > ScanSafe Web Security from the policy selector.

 
    [bookmark: pgfId-242248]Step 16 With the Details tab selected, specify the Primary ScanSafe Server by entering the following values:

 
     
     		 [bookmark: pgfId-242250]IP Address/Name

 
     		 [bookmark: pgfId-242252]HTTP Port (default 8080)

 
     		 [bookmark: pgfId-242254]HTTPS Port (default 8080)

 
    

 
    [bookmark: pgfId-242256]Step 17 With the Details tab selected, specify the Secondary ScanSafe Server by entering the following values:

 
     
     		 [bookmark: pgfId-242258]IP Address/Name (only a valid IP address or FQDN).

 
     		 [bookmark: pgfId-242260]HTTP Port (default 8080)

 
     		 [bookmark: pgfId-242262]HTTPS Port (default 8080)

 
    

 
    [bookmark: pgfId-242264]Step 18 Specify the Server Timeout period in seconds (default 300).

 
    [bookmark: pgfId-242266]Step 19 Specify the Session Idle Timeout period in seconds (default 300).

 
    [bookmark: pgfId-242268]Step 20 Specify the source address by doing one of the following:

 
     
     		 [bookmark: pgfId-242270]Click the  IP Address button and then enter the IP address.

 
     		 [bookmark: pgfId-242272]Click the  Interface button, and then click the  Select button and browse the Interface Selector to select an interface.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-242274]Note A valid source IP or interface must be one of the interfaces on which ScanSafe Web Security is enabled (on the Firewall > ScanSafe Web Security page > Interface tab.


    
     

    

    

 
    [bookmark: pgfId-242276]Step 21 Enter the License and select the checkbox if it is encrypted.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-242278]Tip If Encrypted is not selected, the value entered must be 32 hexadecimal characters.


    
     

    

    

 
    [bookmark: pgfId-242280]Step 22 If desired, select the Enable Logging checkbox.

 
    [bookmark: pgfId-242282]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-242296][bookmark: 54670][bookmark: fwlsvcpg_cncpt_ScanSafeWebSecurityPage]ScanSafe Web Security Page

 
    [bookmark: pgfId-242298]Security Manager provides integration with ScanSafe Web Security. ScanSafe Web Security is a cloud-based SaaS (Security as a Service) function that makes available its web security data centers at various locations worldwide. When ScanSafe Web Security is integrated with a router, selected HTTP and HTTPS traffic is redirected to ScanSafe Cloud for content scanning and for malware detection by other means. Also, you can use ScanSafe Web Security to provide differentiated services to particular users, user groups, and IPs.

 
    [bookmark: pgfId-242300]Using ScanSafe Web Security in Security Manager, you can define settings and policies in the following areas:

 
     
     		 [bookmark: pgfId-242302]Content scanning settings

 
     		 [bookmark: pgfId-242304]Content scanning policies

 
     		 [bookmark: pgfId-242306]AAA server settings

 
     		 [bookmark: pgfId-242308]AAA policies

 
    

 
    [bookmark: pgfId-242310]With ScanSafe Web Security integration in Security Manager you can copy and share most policies and framework-based policy features.

 
    [bookmark: pgfId-242314]For information on how best to configure the ScanSafe Web Security Page for your particular purposes, see Working with ScanSafe Web Security.

 
    [bookmark: pgfId-242316]Navigation Path

 
    [bookmark: pgfId-242318](Policy view) Select Firewall and open Settings from the Policy Type selector. Then click ScanSafe Web Security to open the ScanSafe Web Security Settings Page.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-242320]Note Configuration of the ScanSafe Web Security policies and settings is also possible by way of the Map view.


    
     

    

    

 
    [bookmark: pgfId-242322]Related Topics

 
     
     		 [bookmark: pgfId-242327]Chapter 20, “Working with ScanSafe Web Security”

 
     		 [bookmark: pgfId-242332]Configuring ScanSafe Web Security

 
     		 [bookmark: pgfId-242337]ScanSafe Web Security Settings Page

 
     		 [bookmark: pgfId-242342]Add and Edit Default User Groups Dialog Box

 
     		 [bookmark: pgfId-242347]AAA Rules Page

 
    

 
    [bookmark: pgfId-242350]Field Reference

 
     
      
      
        
        		 
          
          [bookmark: pgfId-241070]Element
         
  
        		 
          
          [bookmark: pgfId-241072]Description
         
  
       

 
        
        		 
          
          [bookmark: pgfId-241078]Interfaces Tab
         
  
       

 
        
        		[bookmark: pgfId-241086]—Filter

  
        		[bookmark: pgfId-241091]Details on using filters in Security Manager are found at Filtering Tables.

  
       

 
        
        		[bookmark: pgfId-241097]Interfaces

  
        		[bookmark: pgfId-241099]This tab allows you to select interfaces and Security Manager-defined interface roles on which web requests will be forwarded to the ScanSafe Web Security server for content scanning.

  
       

 
        
        		[bookmark: pgfId-241105]—Available Interfaces

  
        		[bookmark: pgfId-241107]Interfaces that are available to be selected for ScanSafe Web Security.

  
       

 
        
        		[bookmark: pgfId-241113]—Selected Interfaces

  
        		[bookmark: pgfId-241115]Interfaces selected must be facing the WAN on which hosts’ requests for web services are forwarded to ScanSafe Web Security server

  
       

 
        
        		[bookmark: pgfId-241121]-

  
        		[bookmark: pgfId-241123]-

  
       

 
        
        		 
          
          [bookmark: pgfId-241129]Whitelisting Regular Expressions Tab
         
  
       

 
        
        		[bookmark: pgfId-241137]—Notify Tower

  
        		[bookmark: pgfId-241139]This checkbox, when selected, specifies that the ScanSafe Web Security tower must be notified regarding the whitelisting. It is applicable to all ACL-based whitelisting variants except IP based whitelisting. The default behavior is that the notification is not sent.

  
       

 
        
        		[bookmark: pgfId-241145]—Available Regular Expressions (HTTP Host)

  
        		[bookmark: pgfId-241147]Lists the regular expressions available and considered for delivery to the ScanSafe Web Security server.

  
       

 
        
        		[bookmark: pgfId-241153]——Filter (HTTP Host)

  
        		[bookmark: pgfId-241155]Enables the administrator to filter whitelisted regular expressions sent to ScanSafe Web Security server by specifying include and exclude user group list. It operates on a match-all or match-any basis.

  
       

 
        
        		[bookmark: pgfId-241161]—Selected Regular Expressions (HTTP Host)

  
        		[bookmark: pgfId-241163]A host that matches the selected regular expressions is whitelisted, and is not redirected to the ScanSafe Web Security server.

  
       

 
        
        		[bookmark: pgfId-241169]—Available Regular Expressions (HTTP User Agent)

  
        		[bookmark: pgfId-241171]An agent that matches the available regular expressions is whitelisted, and is not redirected to the ScanSafe Web Security server.

  
       

 
        
        		[bookmark: pgfId-241177]—Selected Regular Expressions (HTTP User Agent)

  
        		[bookmark: pgfId-241179]When configured, only regular expressions that are in the Selected Regular Expressions list are sent to ScanSafe Cloud.

  
       

 
        
        		 
          
          [bookmark: pgfId-241185]Whitelisting ACLs Tab
         
  
       

 
        
        		[bookmark: pgfId-241193]—ACL Type

  
        		[bookmark: pgfId-241195]Specifies the type of ACL Whitelisting, either standard or extended.

 [bookmark: pgfId-241197]Note Standard ACLs used for whitelisting are discovered as extended ACLs. A prefix of "CSM_EXT_" is added to the ACL name. Standard ACls are converted to extended ACLs as extended ACLs are complete and recommended

  
       

 
        
        		[bookmark: pgfId-241203]—Selected ACLS

  
        		[bookmark: pgfId-241205]When configured, only regular expressions that are in the Selected Regular Expressions list are sent to ScanSafe Cloud.

  
       

 
        
        		 
          
          [bookmark: pgfId-241211]User Groups Tab
         
  
       

 
        
        		[bookmark: pgfId-241219]—Default User

  
        		[bookmark: pgfId-241221]A global name that is sent to the ScanSafe Web Security server when there is no content-scan-session specific user name. Use it when you want the same content scan policy for all users in a branch office (for example).

  
       

 
        
        		[bookmark: pgfId-241227]—Default User Group

  
        		[bookmark: pgfId-241229]A global name that is sent to the ScanSafe Web Security server when there is no content-scan-session specific user name. Use it when you want the same content scan policy for all user groups in a branch office (for example).

  
       

 
        
        		[bookmark: pgfId-241235]—Interface Specific Default User Groups

  
        		[bookmark: pgfId-241237]Lists default user group for each interface.

  
       

 
        
        		[bookmark: pgfId-241243]—Include/Exclude

  
        		[bookmark: pgfId-241245]You can use the Include and Exclude lists to specify the particular user groups to be included or excluded.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-242358][bookmark: 54847][bookmark: fwlsvcpg_cncpt_AddEditDefaultUserGroupDialogBox]Add and Edit Default User Groups Dialog Box

 
     [bookmark: pgfId-242360]Use the Default User Groups dialog box to specify the default user group for a particular interface.

 
     [bookmark: pgfId-242362]This dialog box is only useful when the ISR cannot determine user credentials, but would like to assign the users (that is, the IP addresses) to a user group so that other group-based policies in the ISR can be enforced. Only one group can be configured on an interface.

 
     [bookmark: pgfId-242366]For details on these ScanSafe Web Security server configuration settings, see the ScanSafe Web Security Settings Page.

 
     [bookmark: pgfId-242368]Related Topics

 
      
      		 [bookmark: pgfId-242373]ScanSafe Web Security Page

 
      		 [bookmark: pgfId-242378]ScanSafe Web Security Settings Page

 
      		 [bookmark: pgfId-242383]Chapter 20, “Working with ScanSafe Web Security”

 
      		 [bookmark: pgfId-242388]Configuring ScanSafe Web Security

 
      		 [bookmark: pgfId-242393]AAA Rules Page

 
     

 
     [bookmark: pgfId-242395]Navigation Path

 
     [bookmark: pgfId-242397](Policy view) Select Firewall and open the ScanSafe Web Security Page. Then click on the User Groups tab.

 
    
 
   
 
    
     [bookmark: pgfId-242409][bookmark: 54877][bookmark: fwlsvcpg_cncpt_ScanSafeWebSecuritySettingsPage]ScanSafe Web Security Settings Page [bookmark: marker-242405][bookmark: marker-242407]

 
    [bookmark: pgfId-242411]Related Topics

 
     
     		 [bookmark: pgfId-242416]ScanSafe Web Security Page

 
     		 [bookmark: pgfId-242421]Chapter 20, “Working with ScanSafe Web Security”

 
     		 [bookmark: pgfId-242426]Configuring ScanSafe Web Security

 
     		 [bookmark: pgfId-242431]Add and Edit Default User Groups Dialog Box

 
     		 [bookmark: pgfId-242436]AAA Rules Page

 
    

 
    [bookmark: pgfId-242438]Navigation Path

 
    [bookmark: pgfId-242440](Policy view) Select Firewall and open Settings from the Policy Type selector. Then click ScanSafe Web Security to open the ScanSafe Web Security Settings Page.

 
    [bookmark: pgfId-242442](Device view) Select Firewall and open Settings from the Policy Type selector. Then click ScanSafe Web Security to open the ScanSafe Web Security Settings Page.

 
    [bookmark: pgfId-242444]Field Reference

 
    [bookmark: pgfId-242447] 

 
     
      
       
       [bookmark: pgfId-241260]Table 20-1 [bookmark: 54912]ScanSafe Web Security Settings 

 
       
      
        
        		
          
          [bookmark: pgfId-241268]Element
         
  
        		
          
          [bookmark: pgfId-241270]Description
         
  
        		
          
          [bookmark: pgfId-241272]Usage
         
  
       

 
        
        		[bookmark: pgfId-241280]IP Address|Name (Primary ScanSafe Server)

  
        		[bookmark: pgfId-241282]The primary FQDN or IP address of the server configured to operate ScanSafe Web Security.

  
        		[bookmark: pgfId-241284]Both

  
       

 
        
        		[bookmark: pgfId-241292]HTTP Port (Primary ScanSafe Server)

  
        		[bookmark: pgfId-241294]Default primary port for proxied HTTP traffic (default=8080).

  
        		[bookmark: pgfId-241296]Both

  
       

 
        
        		[bookmark: pgfId-241304]HTTPS Port (Primary ScanSafe Server)

  
        		[bookmark: pgfId-241306]Default primary port for proxied HTTPS traffic (default=8080).

  
        		[bookmark: pgfId-241308]Both

  
       

 
        
        		[bookmark: pgfId-241316]IP Address/Name (Backup ScanSafe Server)

  
        		[bookmark: pgfId-241318]The secondary FQDN or IP address of the server configured to operate ScanSafe Web Security.

  
        		[bookmark: pgfId-241320]Both

  
       

 
        
        		[bookmark: pgfId-241328]HTTP Port (Backup ScanSafe Server)

  
        		[bookmark: pgfId-241330]Default secondary port for proxied HTTP traffic (default=8080).

  
        		[bookmark: pgfId-241332]Both

  
       

 
        
        		[bookmark: pgfId-241340]HTTPS Port (Secondary ScanSafe Server)

  
        		[bookmark: pgfId-241342]Default secondary port for proxied HTTPS traffic (default=8080).

  
        		[bookmark: pgfId-241344]Both

  
       

 
        
        		[bookmark: pgfId-241352]Server Timeout

  
        		[bookmark: pgfId-241354]Polling timeout when checking the availability of the ScanSafe Web Security server.

  
        		[bookmark: pgfId-241356]IOS Only

  
       

 
        
        		[bookmark: pgfId-241364]Session Idle Timeout

  
        		[bookmark: pgfId-241366]Inactivity timeout of the ScanSafe Web Security server (default=300 seconds). Used to remove the session if it is found inactive.

  
        		[bookmark: pgfId-241368]IOS Only

  
       

 
        
        		[bookmark: pgfId-241376]On Failure

  
        		[bookmark: pgfId-241378]Determines the action to be taken (Drop all Traffic or Allow All Traffic) when both primary and secondary ScanSafe Web Security servers are found inactive.

  
        		[bookmark: pgfId-241380]IOS Only

  
       

 
        
        		[bookmark: pgfId-241388]IP Address (Source Address)

  
        		[bookmark: pgfId-241390]IP address from which a packet to the ScanSafe Web Security server originates from the router.

  
        		[bookmark: pgfId-241392]IOS Only

  
       

 
        
        		[bookmark: pgfId-241400]Interface (Source Address)

  
        		[bookmark: pgfId-241402]Interface address from which a packet to the ScanSafe Web Security server originates from the router.

  
        		[bookmark: pgfId-241404]IOS Only

  
       

 
        
        		[bookmark: pgfId-241412]License

  
        		[bookmark: pgfId-241414]The license sent to the ScanSafe Web Security server (32 hexadecimal characters).

  
        		[bookmark: pgfId-241416]Both

  
       

 
        
        		[bookmark: pgfId-241424]Encrypted

  
        		[bookmark: pgfId-241426]When selected, enables the encryption. ASA does not accept encrypted license text to be configured.

  
        		[bookmark: pgfId-241428]IOS Only

  
       

 
        
        		[bookmark: pgfId-241436]Enable Logging Checkbox

  
        		[bookmark: pgfId-241438]Enables IOS syslogs (default=not enabled).

  
        		[bookmark: pgfId-241440]IOS Only

  
       

 
        
        		[bookmark: pgfId-241448]Public Key File

  
        		[bookmark: pgfId-241450]Name of the public key file

  
        		[bookmark: pgfId-241452]ASA Only

  
       

 
        
        		[bookmark: pgfId-241460]Connection Retry Count

  
        		[bookmark: pgfId-241462]Number of times that the system should retry connecting.

  
        		[bookmark: pgfId-241464]ASA Only
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     [bookmark: pgfId-542495][bookmark: 137792][bookmark: rtdvcadm_intro_RouterDeviceAdmin]Router Device Administration
      
      
 
     
 

 
    [bookmark: pgfId-542497]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-542502]AAA on Cisco IOS Routers

 
     		 [bookmark: pgfId-542507]AAA Policy Page

 
     		 [bookmark: pgfId-542512]User Accounts and Device Credentials on Cisco IOS Routers

 
     		 [bookmark: pgfId-542517]Accounts and Credential s Policy Page

 
     		 [bookmark: pgfId-542522]Bridging on Cisco IOS Routers

 
     		 [bookmark: pgfId-542527]Bridging Policy Page

 
     		 [bookmark: pgfId-542532]Time Zone Settings on Cisco IOS Routers

 
     		 [bookmark: pgfId-542537]Clock Policy Page

 
     		 [bookmark: pgfId-542542]CPU Utilization Settings on Cisco IOS Routers

 
     		 [bookmark: pgfId-542547]CPU Policy Page

 
     		 [bookmark: pgfId-542552]HTTP and HTTPS on Cisco IOS Routers

 
     		 [bookmark: pgfId-542557]HTTP Policy Page

 
     		 [bookmark: pgfId-542562]Line Access on Cisco IOS Routers

 
     		 [bookmark: pgfId-542567]Console Policy Page

 
     		 [bookmark: pgfId-542572]VTY Policy Page

 
     		 [bookmark: pgfId-542577]Optional SSH Settings on Cisco IOS Routers

 
     		 [bookmark: pgfId-542582]Secure Shell Policy Page

 
     		 [bookmark: pgfId-542587]SNMP on Cisco IOS Routers

 
     		 [bookmark: pgfId-542592]SNMP Policy Page

 
     		 [bookmark: pgfId-542597]DNS on Cisco IOS Routers

 
     		 [bookmark: pgfId-542602]DNS Policy Page

 
     		 [bookmark: pgfId-542607]Hostnames and Domain Names on Cisco IOS Routers

 
     		 [bookmark: pgfId-542612]Hostname Policy Page

 
     		 [bookmark: pgfId-542617]Memory Settings on Cisco IOS Routers

 
     		 [bookmark: pgfId-542622]Memory Policy Page

 
     		 [bookmark: pgfId-542627]Secure Device Provisioning on Cisco IOS Routers

 
     		 [bookmark: pgfId-542632]Secure Device Provisioning Policy Page

 
     		 [bookmark: pgfId-542637]DHCP on Cisco IOS Routers

 
     		 [bookmark: pgfId-542642]DHCP Policy Page

 
     		 [bookmark: pgfId-542647]NTP on Cisco IOS Routers

 
     		 [bookmark: pgfId-542652]NTP Policy Page

 
    

 
   
 
    
     [bookmark: pgfId-542664][bookmark: 137794][bookmark: rtchap_cncpt_AAAonCiscoIOSRouters]AAA on Cisco IOS Routers[bookmark: marker-542658][bookmark: marker-542660][bookmark: marker-542662]

 
    [bookmark: pgfId-542666]Authentication, authorization, and accounting (AAA) network security services provide the primary framework through which you set up access control on your Cisco IOS router. Use the AAA policy in Security Manager to enable AAA functionality on Cisco IOS routers and to configure default AAA settings. The default settings that you define in this policy can be used in other policies, such as HTTP and line access (console and VTY) policies. Enabling AAA functionality is a prerequisite for any device policy that makes use of AAA, including NAC, SDP, and 802.1x.

 
    [bookmark: pgfId-542668]For more information about AAA, see:

 
     
     		 [bookmark: pgfId-542673]Supported Authorization Types

 
     		 [bookmark: pgfId-542678]Supported Accounting Types

 
     		 [bookmark: pgfId-542683]Understanding Method Lists

 
    

 
    [bookmark: pgfId-542685]To configure a AAA policy, see:

 
     
     		 [bookmark: pgfId-542690]Defining AAA Services

 
    

 
    [bookmark: pgfId-542692]Related Topics

 
     
     		 [bookmark: pgfId-542697]Understanding AAA Server and Server Group Objects

 
     		 [bookmark: pgfId-542702]Line Access on Cisco IOS Routers

 
    

 
     
      [bookmark: pgfId-542710][bookmark: 137833][bookmark: rtchap_cncpt_SupportedAuthorizationTypes]Supported Authorization Types[bookmark: marker-542708]

 
     [bookmark: pgfId-542712]AAA authorization enables you to limit the services available to an authenticated user. Security Manager supports the following types of authorization:

 
      
      		 [bookmark: pgfId-542714]Network—Authorizes various types of network connections, such as PPP, SLIP, and ARAP.

 
      		 [bookmark: pgfId-542716]EXEC—Authorizes the launching of EXEC (CLI) sessions.

 
      		 [bookmark: pgfId-542718]Command—Authorizes the use of all EXEC mode commands that are associated with specific privilege levels.

 
     

 
     [bookmark: pgfId-542720]When authorization is enabled, the router uses information retrieved from the user’s profile to configure the user session. The profiles are located either in the local user database or on a security server. Users are granted access to a requested service only if the profile allows it.

 
     [bookmark: pgfId-542722]Related Topics

 
      
      		 [bookmark: pgfId-542727]Supported Accounting Types

 
      		 [bookmark: pgfId-542732]Understanding Method Lists

 
      		 [bookmark: pgfId-542737]Defining AAA Services

 
      		 [bookmark: pgfId-542742]AAA on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-542750][bookmark: 137864][bookmark: rtchap_cncpt_SupportedAccountingTypes]Supported Accounting Types[bookmark: marker-542748]

 
     [bookmark: pgfId-542752]AAA accounting enables you to track the services the users are accessing and the amount of network resources that they are consuming. Security Manager supports the following accounting types:

 
      
      		 [bookmark: pgfId-542754]Connection—Records information about all outbound connections made from this device, such as Telnet, local-area transport (LAT), TN3270, packet assembler/disassembler (PAD), and rlogin connections.

 
     

 
     [bookmark: pgfId-542756]For example, a RADIUS connection accounting record for an outbound Telnet connection includes such information as the port and IP address of the network access server (NAS), the start and end times of the connection, the identity of the user, and the number of packets that were transmitted during the session.

 
      
      		 [bookmark: pgfId-542758]EXEC—Records information about user EXEC (CLI) sessions on the devices, including the username, date, start and stop times, and the IP address of the NAS. For dial-in users, the record includes the telephone number from which the call originated.

 
      		 [bookmark: pgfId-542760]Command—Records information about the EXEC commands executed on the device by users with specific privilege levels. Each command accounting record includes a list of the commands executed for that privilege level, the date and time each command was executed, and the name of the user who executed it.

 
     

 
     [bookmark: pgfId-542762]For each accounting type, you can choose whether you want to generate an accounting record at the start and end of each user session or only at the end.

 
     [bookmark: pgfId-542764]When AAA accounting is enabled, the router sends accounting records of user activity to the TACACS+ or RADIUS security server. Each accounting record contains accounting attribute-value (AV) pairs and is stored on the security server. This data can later be analyzed for network management, client billing, and auditing purposes.

 
     [bookmark: pgfId-542766]Related Topics

 
      
      		 [bookmark: pgfId-542771]Supported Accounting Types

 
      		 [bookmark: pgfId-542776]Understanding Method Lists

 
      		 [bookmark: pgfId-542781]Defining AAA Services

 
      		 [bookmark: pgfId-542786]AAA on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-542794][bookmark: 137897][bookmark: rtchap_cncpt_UnderstandingMethodLists]Understanding Method Lists[bookmark: marker-542792]

 
     [bookmark: pgfId-542796]A method list is a sequential list describing the methods to use to perform a particular AAA function. In Security Manager, you define method lists by selecting AAA server groups, which are reusable objects that typically contain one or more AAA servers running the same protocol, such as RADIUS or TACACS+. Method lists enable you to designate one or more security protocols to be used for each AAA function, thus ensuring a backup system if the initial method fails.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-542801]Note Security Manager also contains predefined AAA server group objects for using the enable password or a local database. See Predefined AAA Authentication Server Groups.


     
      

     

     

 
     [bookmark: pgfId-542803]For each AAA function, the device initially uses the first method defined in the list. If that method fails to respond, the device selects the next method in the list. This process continues until there is successful communication with a listed method, or all methods defined in the method list are exhausted.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-542805]Note The device attempts to communicate with the next listed method only when there is no response from the previous method. If the AAA service fails at any point in this cycle—meaning that the security server or local username database responds by denying the user access or services—the process stops and no other methods are attempted.


     
      

     

     

 
     [bookmark: pgfId-542807]Related Topics

 
      
      		 [bookmark: pgfId-542812]Supported Authorization Types

 
      		 [bookmark: pgfId-542817]Supported Accounting Types

 
      		 [bookmark: pgfId-542822]Defining AAA Services

 
      		 [bookmark: pgfId-542827]AAA on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-542835][bookmark: 137924][bookmark: rtchap_proc_DefiningAAAServices]Defining AAA Services[bookmark: marker-542833]

 
     [bookmark: pgfId-542837]To define AAA services on a Cisco IOS router, you must first enable AAA functionality on the router. After you do this, you can define the kind of functionality (authentication, authorization, and accounting) that you want the device to implement. You must define a method list for each function, including lists for each type of authorization and accounting that you enable.

 
     [bookmark: pgfId-542839]For example, if you want to configure EXEC authorization and command authorization, you must define one method list for EXEC authorization and other method lists for each privilege level on which command authorization is performed.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-542841]Note If you use RADIUS for authentication, you must use the same RADIUS server group for authorization as well.


     
      

     

     

 
     [bookmark: pgfId-542843]Related Topics

 
      
      		 [bookmark: pgfId-542848]Understanding Method Lists

 
      		 [bookmark: pgfId-542853]AAA on Cisco IOS Routers

 
      		 [bookmark: pgfId-542858]Understanding AAA Server and Server Group Objects

 
     

 
     
 
     [bookmark: pgfId-542860]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-542862](Device view) Select  Platform > Device Admin > AAA from the Policy selector.

 
      		 [bookmark: pgfId-542864](Policy view) Select  Router Platform > Device Admin > AAA from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-542869]The AAA page is displayed. See AAA Policy Page for a description of the fields on this page.

 
     [bookmark: pgfId-542871]Step 2 Define which login authentication methods to use on users who access the device:

 
     [bookmark: pgfId-542876] a. On the Authentication tab (see AAA Page—Authentication Tab), select the Enable Device Login Authentication check box.

 
     [bookmark: pgfId-542878] b. Enter the names of one or more AAA server group objects (up to four) in the Prioritized Method List field, or click Select select the object from a list or to create a new one. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-542880]Note If you select None as a method, it must appear as the last method in the list.


     
      

     

     

 
     [bookmark: pgfId-542882]Step 3 (Optional) In the Maximum Number of Attempts field, define the maximum number of unsuccessful authentication attempts to allow before a user is locked out.

 
     [bookmark: pgfId-542884]Step 4 (Optional) Define which authorization methods to use on users who have been successfully authenticated:

 
     [bookmark: pgfId-542889] a. Click the Authorization tab on the AAA page. See Table 62-3 for a description of the fields on this tab.

 
     [bookmark: pgfId-542891] b. Define method lists for one or more of the following types of authorization:

 
      
      		 [bookmark: pgfId-542893]Network

 
      		 [bookmark: pgfId-542895]EXEC

 
      		 [bookmark: pgfId-542900]Command—Click the  Add button to display the Command Authorization dialog box (see Command Authorization Dialog Box). From here, you can select a privilege level and the method list to apply to it.

 
     

 
     [bookmark: pgfId-542905]For more information about these authorization types, see Supported Authorization Types.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-542907]Note RADIUS uses the same server for authentication and authorization. Therefore, if you use define a RADIUS method list for authentication, you must define the same method list for authorization.


     
      

     

     

 
     [bookmark: pgfId-542909]Step 5 (Optional) Define which accounting methods to use on the activities performed by users:

 
     [bookmark: pgfId-542914] a. Click the Accounting tab on the AAA page. See Table 62-5 for a description of the fields on this tab.

 
     [bookmark: pgfId-542916] b. Define method lists for one or more of the following types of accounting:

 
      
      		 [bookmark: pgfId-542918]Connection

 
      		 [bookmark: pgfId-542920]EXEC

 
      		 [bookmark: pgfId-542925]Command—Click the  Add button to display the Command Accounting dialog box (see Command Accounting Dialog Box). From here, you can select a privilege level and the method list to apply to it.

 
     

 
     [bookmark: pgfId-542930]For more information about these accounting types, see Supported Accounting Types.

 
     [bookmark: pgfId-542932] c. For each accounting type defined above, select a value from the Accounting Process Notices list. This defines when to create an accounting record, at the beginning and end of the user process or only at the end.

 
     [bookmark: pgfId-542934] d. For each accounting type defined above, select the Enable broadcast to multiple servers check box if you want accounting information sent simultaneously to the first server in each AAA server group defined in the method list.

 
     [bookmark: pgfId-542936]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-542948][bookmark: 138020][bookmark: rtpage_cncpt_AAAPolicyPage]AAA Policy Page[bookmark: marker-542944][bookmark: marker-542946]

 
    [bookmark: pgfId-542950]Use the AAA page to define the default authentication, authorization, and accounting methods to use on the router. You do this by configuring method lists, which define which methods to use and the sequence in which to use them.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-542958]Note You can use the method lists defined in this policy as default settings when you configure AAA on the router’s console port and VTY lines. See Console Policy Page and VTY Policy Page.


    
     

    

    

 
    [bookmark: pgfId-542960]Navigation Path

 
     
     		 [bookmark: pgfId-542962](Device view) Select  Platform > Device Admin > AAA from the Policy selector.

 
     		 [bookmark: pgfId-542964](Policy view) Select  Router Platform > Device Admin > AAA from the Policy Type selector. Right-click  AAA to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-542966]Related Topics

 
     
     		 [bookmark: pgfId-542971]AAA on Cisco IOS Routers

 
     		 [bookmark: pgfId-542976]Understanding AAA Server and Server Group Objects

 
     		 [bookmark: pgfId-542981]Console Policy Page

 
     		 [bookmark: pgfId-542986]VTY Policy Page

 
    

 
    [bookmark: pgfId-542988]Field Reference

 
    [bookmark: pgfId-542991] 

 
     
      
       
       [bookmark: pgfId-537489]Table 62-1 [bookmark: 138063]AAA Page 

 
       
      
        
        		
          
          [bookmark: pgfId-537495]Element
         
  
        		
          
          [bookmark: pgfId-537497]Description
         
  
       

 
        
        		[bookmark: pgfId-537503]Authentication tab

  
        		[bookmark: pgfId-537508]Defines the login authentication methods to use and the sequence in which to use them. See AAA Page—Authentication Tab.

  
       

 
        
        		[bookmark: pgfId-537514]Authorization tab

  
        		[bookmark: pgfId-537519]Defines the types of network, EXEC, and command authorization to perform and the methods to use for each type. See AAA Page—Authorization Tab.

  
       

 
        
        		[bookmark: pgfId-537525]Accounting tab

  
        		[bookmark: pgfId-537530]Defines types of connection, EXEC, and command accounting to perform and the methods to use for each type. See AAA Page—Accounting Tab.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-543005][bookmark: 138091][bookmark: rtpage_cncpt_AAAPageAuthenticationTab]AAA Page—Authentication Tab[bookmark: marker-542999][bookmark: marker-543001][bookmark: marker-543003]

 
     [bookmark: pgfId-543007]Use the Authentication tab of the AAA page to define the methods used to authenticate users who access the device. Authentication methods are defined in a method list, which define the security protocols to use, such as LDAP, RADIUS, and TACACS+.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-543015]Note You can use the method list defined in this policy on the console and VTY lines that are used to communicate with the device. See Console Policy Page and VTY Line Dialog Box—Authentication Tab.


     
      

     

     

 
     [bookmark: pgfId-543017]Navigation Path

 
     [bookmark: pgfId-543022]Go to the AAA Policy Page, then click the Authentication tab.

 
     [bookmark: pgfId-543024]Related Topics

 
      
      		 [bookmark: pgfId-543029]Defining AAA Services

 
      		 [bookmark: pgfId-543034]Understanding Method Lists

 
      		 [bookmark: pgfId-543039]AAA Server Group Dialog Box

 
      		 [bookmark: pgfId-543044]Predefined AAA Authentication Server Groups

 
     

 
     [bookmark: pgfId-543046]Field Reference

 
     [bookmark: pgfId-543049] 

 
      
       
        
        [bookmark: pgfId-537543]Table 62-2 [bookmark: 138133]AAA Page—Authentication Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-537549]Element
          
  
         		
           
           [bookmark: pgfId-537551]Description
          
  
        

 
         
         		[bookmark: pgfId-537557]Enable Device Login Authentication

  
         		[bookmark: pgfId-537559]When selected, enables the authentication of all users when they log in to the device, using the methods defined in the method list.

 [bookmark: pgfId-537561]When deselected, authentication is not performed.

  
        

 
         
         		[bookmark: pgfId-537567]Prioritized Method List

  
         		[bookmark: pgfId-537569]Defines a sequential list of methods to be queried when authenticating a user. Enter the names of one or more AAA server group objects (up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-537571]The device tries initially to authenticate users using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-537573]Supported methods include Line, Local, Kerberos, LDAP, RADIUS, TACACS+, and None.

 [bookmark: pgfId-537575]Note If you select None as a method, it must appear as the last method in the list.

  
        

 
         
         		[bookmark: pgfId-537581]Maximum Number of Attempts

  
         		[bookmark: pgfId-537583]The maximum number of unsuccessful authentication attempts before a user is locked out. This feature is disabled by default. Valid values range from 1 to 65535.

 commands.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-543063][bookmark: 138167][bookmark: rtpage_cncpt_AAAPageAuthorizationTab]AAA Page—Authorization Tab[bookmark: marker-543057][bookmark: marker-543059][bookmark: marker-543061]

 
     [bookmark: pgfId-543065]Use the Authorization tab of the AAA page to define the type of authorization services to enable on the device and the methods to use for each type. Security Manager supports the following types of authorization:

 
      
      		 [bookmark: pgfId-543067]Network—Authorizes various types of network connections, such as PPP.

 
      		 [bookmark: pgfId-543069]EXEC—Authorizes the launching of EXEC sessions.

 
      		 [bookmark: pgfId-543071]Command—Authorizes the use of all EXEC mode commands that are associated with specific privilege levels.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-543079]Note You can use the method lists defined in this policy on the console and VTY lines that are used to communicate with the device. See Console Policy Page and VTY Line Dialog Box—Authentication Tab.


     
      

     

     

 
     [bookmark: pgfId-543081]Navigation Path

 
     [bookmark: pgfId-543086]Go to the AAA Policy Page, then click the Authorization tab.

 
     [bookmark: pgfId-543088]Related Topics

 
      
      		 [bookmark: pgfId-543093]Defining AAA Services

 
      		 [bookmark: pgfId-543098]Supported Authorization Types

 
      		 [bookmark: pgfId-543103]Understanding Method Lists

 
      		 [bookmark: pgfId-543108]AAA Server Group Dialog Box

 
      		 [bookmark: pgfId-543113]Filtering Tables

 
     

 
     [bookmark: pgfId-543115]Field Reference

 
     [bookmark: pgfId-543118] 

 
      
       
        
        [bookmark: pgfId-537598]Table 62-3 [bookmark: 138219]AAA Page—Authorization Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-537604]Element
          
  
         		
           
           [bookmark: pgfId-537606]Description
          
  
        

 
         
         		 [bookmark: pgfId-537612]Network Authorization settings

  
        

 
         
         		[bookmark: pgfId-537620]Enable Network Authorization

  
         		[bookmark: pgfId-537622]When selected, enables the authorization of network connections, such as PPP, SLIP, or ARAP connections, using the methods defined in the method list.

 [bookmark: pgfId-537624]When deselected, network authorization is not performed.

  
        

 
         
         		[bookmark: pgfId-537630]Prioritized Method List

  
         		[bookmark: pgfId-537632]Defines a sequential list of methods to be queried when authorizing a user. Enter the names of one or more AAA server group objects (up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-537634]The device tries initially to authorize users using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-537636]Supported methods include LDAP, RADIUS, TACACS+, Local, and None.

 [bookmark: pgfId-537638]Note RADIUS uses the same server for authentication and authorization. Therefore, if you use define a RADIUS method list for authentication, you must define the same method list for authorization.

 [bookmark: pgfId-537640]Note If you select None as a method, it must appear as the last method in the list.

  
        

 
         
         		 [bookmark: pgfId-537646]EXEC Authorization settings

  
        

 
         
         		[bookmark: pgfId-537654]Enable CLI/EXEC Operations Authorization

  
         		[bookmark: pgfId-537656]When selected, this type of authorization determines whether the user is permitted to open an EXEC (CLI) session, using the methods defined in the method list.

 [bookmark: pgfId-537658]When deselected, EXEC authorization is not performed.

  
        

 
         
         		[bookmark: pgfId-537664]Prioritized Method List

  
         		[bookmark: pgfId-537666]Defines a sequential list of methods to be queried when authorizing a user. Enter the names of one or more AAA server group objects (up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-537668]The device tries initially to authorize users using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

  
        

 
         
         		 [bookmark: pgfId-537674]Command Authorization settings

  
        

 
         
         		[bookmark: pgfId-537682]Privilege Level

  
         		[bookmark: pgfId-537684]The privilege level to which the command authorization definition applies.

  
        

 
         
         		[bookmark: pgfId-537690]Prioritized Method List

  
         		[bookmark: pgfId-537692]The method list to use when authorizing users with this privilege level.

  
        

 
         
         		[bookmark: pgfId-537698]Add button

  
         		[bookmark: pgfId-537703]Opens the Command Authorization Dialog Box. From here you can configure a command authorization definition.

  
        

 
         
         		[bookmark: pgfId-537709]Edit button

  
         		[bookmark: pgfId-537714]Opens the Command Authorization Dialog Box. From here you can edit the command authorization definition.

  
        

 
         
         		[bookmark: pgfId-537720]Delete button

  
         		[bookmark: pgfId-537722]Deletes the selected command authorization definitions from the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-543130][bookmark: 138299][bookmark: rtpage_cncpt_CommandAuthorizationDialogBox]Command Authorization Dialog Box[bookmark: marker-543126][bookmark: marker-543128]

 
     [bookmark: pgfId-543132]Use the Command Authorization dialog box to define which methods to use when authorizing the EXEC commands that are associated with a given privilege level. This enables you to authorize all commands associated with a specific privilege level, from 0 to 15.

 
     [bookmark: pgfId-543134]Navigation Path

 
     [bookmark: pgfId-543139]From the AAA Page—Authorization Tab, click the Add button beneath the Command Authorization table.

 
     [bookmark: pgfId-543141]Related Topics

 
      
      		 [bookmark: pgfId-543146]Defining AAA Services

 
      		 [bookmark: pgfId-543151]Supported Authorization Types

 
      		 [bookmark: pgfId-543156]Understanding Method Lists

 
     

 
     [bookmark: pgfId-543158]Field Reference

 
     [bookmark: pgfId-543161] 

 
      
       
        
        [bookmark: pgfId-537735]Table 62-4 [bookmark: 138331]Command Authorization Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-537741]Element
          
  
         		
           
           [bookmark: pgfId-537743]Description
          
  
        

 
         
         		[bookmark: pgfId-537749]Privilege Level

  
         		[bookmark: pgfId-537751]The privilege level for which you want to define a command accounting list. Valid values range from 0 to 15.

  
        

 
         
         		[bookmark: pgfId-537757]Prioritized Method List

  
         		[bookmark: pgfId-537759]Defines a sequential list of methods to be used when authorizing a user. Enter the names of one or more AAA server group objects (up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-537761]The device tries initially to authorize users using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-537763]Supported methods include TACACS+, Local, and None.

 [bookmark: pgfId-537765]Note If you select None as a method, it must appear as the last method in the list.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-543175][bookmark: 138358][bookmark: rtpage_cncpt_AAAPageAccountingTab]AAA Page—Accounting Tab[bookmark: marker-543169][bookmark: marker-543171][bookmark: marker-543173]

 
     [bookmark: pgfId-543177]Use the Accounting tab of the AAA page to define the type of accounting services to enable on the device and the methods to use for each type. Security Manager supports the following types of accounting:

 
      
      		 [bookmark: pgfId-543179]Connection—Records information about all outbound connections made from this device.

 
      		 [bookmark: pgfId-543181]EXEC—Records information about user EXEC sessions on the devices, including the username, date, start and stop times, and the IP address.

 
      		 [bookmark: pgfId-543183]Command—Records information about the EXEC commands executed on the device by users with specific privilege levels.

 
     

 
     [bookmark: pgfId-543185]In addition, you use the Accounting page to determine when accounting records should be generated and whether they should be broadcast to more than one AAA server.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-543193]Note You can use the method lists defined in this policy on the console and VTY lines that are used to communicate with the device. See Console Policy Page and VTY Line Dialog Box—Authentication Tab.


     
      

     

     

 
     [bookmark: pgfId-543195]Navigation Path

 
     [bookmark: pgfId-543200]Go to the AAA Policy Page, then click the Accounting tab.

 
     [bookmark: pgfId-543202]Related Topics

 
      
      		 [bookmark: pgfId-543207]Defining AAA Services

 
      		 [bookmark: pgfId-543212]Supported Accounting Types

 
      		 [bookmark: pgfId-543217]Understanding Method Lists

 
      		 [bookmark: pgfId-543222]AAA Server Group Dialog Box

 
      		 [bookmark: pgfId-543227]Filtering Tables

 
     

 
     [bookmark: pgfId-543229]Field Reference

 
     [bookmark: pgfId-543232] 

 
      
       
        
        [bookmark: pgfId-537778]Table 62-5 [bookmark: 138411]AAA Page—Accounting Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-537784]Element
          
  
         		
           
           [bookmark: pgfId-537786]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-537792]Connection Accounting settings
          
  
        

 
         
         		[bookmark: pgfId-537800]Enable Connection Accounting

  
         		[bookmark: pgfId-537802]When selected, enables the recording of information about outbound connections (such as Telnet) made over this device, using the methods defined in the method list.

 [bookmark: pgfId-537804]When deselected, connection accounting is not performed.

  
        

 
         
         		[bookmark: pgfId-537810]Generate Accounting Records for

  
         		[bookmark: pgfId-537812]Defines when the device sends an accounting notice to the accounting server:

 
           
           		 [bookmark: pgfId-537814]Start and Stop—Generates accounting records at the beginning and the end of the user process. The user process begins regardless of whether the accounting server receives the “start” accounting record.

 
           		 [bookmark: pgfId-537816]Stop Only—Generates an accounting record at the end of the user process only.

 
           		 [bookmark: pgfId-537818]None—Disables this type of accounting.

 
          

  
        

 
         
         		[bookmark: pgfId-537824]Prioritized Method List

  
         		[bookmark: pgfId-537826]Defines a sequential list of methods to be queried when creating connection accounting records for a user. Enter the names of one or more AAA server group objects (up to 10 for IOS 12.4(22)T+, otherwise up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-537828]Supported methods include LDAP, RADIUS, and TACACS+.

  
        

 
         
         		[bookmark: pgfId-537834]Enable Broadcast to Multiple Servers

  
         		[bookmark: pgfId-537836]When selected, enables the sending of accounting records to multiple AAA servers. Accounting records are sent simultaneously to the first server in each AAA server group defined in the method list. If the first server is unavailable, failover occurs using the backup servers defined within that group.

 [bookmark: pgfId-537838]When deselected, accounting records are sent only to the first server in the first AAA server group defined in the method list.

  
        

 
         
         		 
           
           [bookmark: pgfId-537844]EXEC Accounting Settings
          
  
        

 
         
         		[bookmark: pgfId-537852]Enable CLI/EXEC Operations Accounting

  
         		[bookmark: pgfId-537854]When selected, enables the recording of basic information about user EXEC sessions, using the methods defined in the method list.

 [bookmark: pgfId-537856]When deselected, EXEC accounting is not performed.

  
        

 
         
         		[bookmark: pgfId-537862]Generate Accounting Records for

  
         		[bookmark: pgfId-537867]See description Table 43-7.

  
        

 
         
         		[bookmark: pgfId-537873]Prioritized Method List

  
         		[bookmark: pgfId-537875]Defines a sequential list of methods to be queried when creating connection accounting records for a user. Enter the names of one or more AAA server group objects (up to 10 for IOS 12.4(22)T+, otherwise up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

  
        

 
         
         		[bookmark: pgfId-537881]Enable Broadcast to Multiple Servers

  
         		[bookmark: pgfId-537883]When selected, enables the sending of accounting records to multiple AAA servers. Accounting records are sent simultaneously to the first server in each AAA server group defined in the method list. If the first server is unavailable, failover occurs using the backup servers defined within that group.

  
        

 
         
         		 
           
           [bookmark: pgfId-537889]Command Accounting settings
          
  
        

 
         
         		[bookmark: pgfId-537897]Privilege Level

  
         		[bookmark: pgfId-537899]The privilege level to which the command authorization definition applies.

  
        

 
         
         		[bookmark: pgfId-537905]Generate Accounting Records for

  
         		[bookmark: pgfId-537907]The points in the process where the device sends an accounting notice to the accounting server.

  
        

 
         
         		[bookmark: pgfId-537913]Enable Broadcast

  
         		[bookmark: pgfId-537915]Whether accounting records are broadcast to multiple servers simultaneously.

  
        

 
         
         		[bookmark: pgfId-537921]Prioritized Method List

  
         		[bookmark: pgfId-537923]The method list to use when authorizing users with this privilege level.

  
        

 
         
         		[bookmark: pgfId-537929]Add button

  
         		[bookmark: pgfId-537934]Opens the Command Accounting Dialog Box. From here you can configure a command accounting definition.

  
        

 
         
         		[bookmark: pgfId-537940]Edit button

  
         		[bookmark: pgfId-537945]Opens the Command Accounting Dialog Box. From here you can edit the command accounting definition.

  
        

 
         
         		[bookmark: pgfId-537951]Delete button

  
         		[bookmark: pgfId-537953]Deletes the selected command accounting definitions from the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-543244][bookmark: 138529][bookmark: rtpage_cncpt_CommandAccountingDialogBox]Command Accounting Dialog Box[bookmark: marker-543240][bookmark: marker-543242]

 
     [bookmark: pgfId-543246]Use the Command Accounting dialog box to define which methods to use when recording information about the EXEC commands that are executed for a given privilege level. Each accounting record includes a list of the commands executed for that privilege level, as well as the date and time each command was executed, and the name of the user who executed it.

 
     [bookmark: pgfId-543248]Navigation Path

 
     [bookmark: pgfId-543253]From the AAA Page—Accounting Tab, click the Add button beneath the Command Accounting table.

 
     [bookmark: pgfId-543255]Related Topics

 
      
      		 [bookmark: pgfId-543260]Defining AAA Services

 
      		 [bookmark: pgfId-543265]Supported Accounting Types

 
      		 [bookmark: pgfId-543270]Understanding Method Lists

 
     

 
     [bookmark: pgfId-543272]Field Reference

 
     [bookmark: pgfId-543275] 

 
      
       
        
        [bookmark: pgfId-537966]Table 62-6 [bookmark: 138561]Command Accounting Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-537972]Element
          
  
         		
           
           [bookmark: pgfId-537974]Description
          
  
        

 
         
         		[bookmark: pgfId-537980]Privilege Level

  
         		[bookmark: pgfId-537982]The privilege level for which you want to define a command accounting list. Valid values range from 0 to 15.

  
        

 
         
         		[bookmark: pgfId-537988]Generate Accounting Records for

  
         		[bookmark: pgfId-537990]Defines when the device sends an accounting notice to the accounting server:

 
           
           		 [bookmark: pgfId-537992]Start and Stop—Generates accounting records at the beginning and the end of the user process. The user process begins regardless of whether the accounting server receives the “start” accounting record.

 
           		 [bookmark: pgfId-537994]Stop Only—Generates an accounting record at the end of the user process only.

 
           		 [bookmark: pgfId-537996]None—No accounting records are generated.

 
          

  
        

 
         
         		[bookmark: pgfId-538002]Prioritized Method List

  
         		[bookmark: pgfId-538004]Defines a sequential list of methods to be used when creating accounting records for a user. Enter the names of one or more AAA server group objects (up to 10 for IOS 12.4(22)T+, otherwise up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-538006]The device tries initially to perform accounting using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-538008]TACACS+ is the only supported method, but you can select multiple AAA server groups configured with TACACS+.

 [bookmark: pgfId-538010]Note If you select None as a method, it must appear as the last method in the list.

  
        

 
         
         		[bookmark: pgfId-538016]Enable Broadcast to Multiple Servers

  
         		[bookmark: pgfId-538018]When selected, enables the sending of accounting records to multiple AAA servers. Accounting records are sent simultaneously to the first server in each AAA server group defined in the method list. If the first server is unavailable, failover occurs using the backup servers defined within that group.

 [bookmark: pgfId-538020]When deselected, accounting records are sent only to the first server in the first AAA server group defined in the method list.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-543287][bookmark: 138607][bookmark: rtchap_cncpt_UserAccountsandDeviceCredentialsonCiscoIOSRouters]User Accounts and Device Credentials on Cisco IOS Routers[bookmark: marker-543281][bookmark: marker-543283][bookmark: marker-543285]

 
    [bookmark: pgfId-543289]Accounts and credential policies define the contact information for accessing the router, including the privilege level provided to each user account. You can configure as many user accounts as required. However, the user account that Security Manager uses to connect to the router is always the one configured in the Device Properties page.

 
    [bookmark: pgfId-543291]Additionally, you use device access policies to define the enable or enable secret password required to access privileged EXEC mode. This is the mode required to make any configuration changes on the router.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-543293]Note If you use this policy to define a password, be careful later not to unassign this policy without assigning a replacement policy before your next deployment. If you deploy a device access policy that removes this password and the device contains a different type of password not known to Security Manager, such as a line console password, you will not be able to configure this device in the future. This is because the device reverts to this unknown password if Security Manager removes the enable password that it had previously configured.


    
     

    

    

 
    [bookmark: pgfId-543295]Related Topics

 
     
     		 [bookmark: pgfId-543300]Defining Accounts and Credential Policies

 
    

 
     
      [bookmark: pgfId-543308][bookmark: 138629][bookmark: rtchap_proc_DefiningAccountsandCredentialPolicies]Defining Accounts and Credential Policies[bookmark: marker-543306]

 
     [bookmark: pgfId-543313]This procedure describes how to define a device access policy on a Cisco IOS router. If the username that you configured on the Device Properties page to connect to the router (see Viewing or Changing Device Properties) matches one of the user accounts you defined in this policy, Security Manager updates the device credentials according to your policy definition.

 
     [bookmark: pgfId-543318]If you change the password for the user defined in the device properties, which Security Manager uses to deploy configurations to the device, or change the enable password, Security Manager uses the existing credentials defined in the device properties to log into the device and deploy changes. After successful deployment, the device properties are then changed to use your new settings. For more information on credentials in device properties, see Device Credentials Page.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-543320]Note You can discover encrypted passwords, but any password you enter must be in clear text. If you discover an encrypted password and then modify it, the password is saved as clear text.


     
      

     

     

 
     [bookmark: pgfId-543322]Related Topics

 
      
      		 [bookmark: pgfId-543327]User Accounts and Device Credentials on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-543329]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-543331](Device view) Select  Platform > Device Admin > Accounts and Credentials from the Policy selector.

 
      		 [bookmark: pgfId-543333](Policy view) Select  Router Platform > Device Admin > Accounts and Credentials from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-543338]The Accounts and Credentials page is displayed. See Table 62-7 for a description of the fields on this page.

 
     [bookmark: pgfId-543340]Step 2 Enter the password for switching to privileged EXEC mode on the router:

 
     [bookmark: pgfId-543342] a. Select Enable Password or Enable Secret Password. The Enable Secret Password option offers better security than the Enable Password option by storing the password using MD5 encryption. This option is useful in environments in which the password crosses the network or is stored on a TFTP server.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-543344]Note After you set an enable secret password, you can switch to an enable password only if the enable secret is disabled or an older version of Cisco IOS software is being used, such as when running an older rxboot image.


     
      

     

     

 
     [bookmark: pgfId-543346] b. Enter a password, then enter it again in the Confirm field. The password that you enter must be in clear text. If you are configuring the enable secret password, the password is encrypted on deployment.

 
     [bookmark: pgfId-543348]Step 3 (Optional) Select the Enable Password Encryption Service check box to encrypt all passwords on the device. This includes, for example, the enable password, username passwords, authentication key passwords, console and VTY line access passwords, and BGP neighbor passwords.

 
     [bookmark: pgfId-543350]We recommend using this feature to help prevent unauthorized individuals from viewing the passwords in your configuration file.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-543352]Note This option does not provide a high level of security and should not be used as a substitute for additional network security measures.


     
      

     

     

 
     [bookmark: pgfId-543354]Step 4 To define new user accounts for the router:

 
     [bookmark: pgfId-543356] a. Click the Add button under the table to display the User Accounts dialog box.

 
     [bookmark: pgfId-543361] b. Enter the details for the new user. See Table 62-8 for a description of the available fields.

 
     [bookmark: pgfId-543363] c. Click OK to save your definitions locally on the client and close the dialog box. Your definitions are displayed in the User Accounts table.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-543365]Note To edit a user account, select it from the User Accounts table, then click Edit. To remove a user account, select it, then click Delete.


     
      

     

     

 
     [bookmark: pgfId-543367]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-543379][bookmark: 138691][bookmark: rtpage_cncpt_AccountsandCredentialsPolicyPage]Accounts and Credential s Policy Page[bookmark: marker-543375][bookmark: marker-543377]

 
    [bookmark: pgfId-543381]Use the Accounts and Credentials page to define the enable password or enable secret password assigned to the router. In addition, you can define a list of usernames that can be used to access the router.

 
    [bookmark: pgfId-543386]For more information, see Defining Accounts and Credential Policies.

 
    [bookmark: pgfId-543388]Navigation Path

 
     
     		 [bookmark: pgfId-543390](Device view) Select  Platform > Device Admin > Accounts and Credentials from the Policy selector.

 
     		 [bookmark: pgfId-543392](Policy view) Select  Router Platform > Device Admin > Accounts and Credentials from the Policy Type selector. Right-click  Accounts and Credentials to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-543394]Related Topics

 
     
     		 [bookmark: pgfId-543399]User Accounts and Device Credentials on Cisco IOS Routers

 
     		 [bookmark: pgfId-543404]User Account Dialog Box

 
     		 [bookmark: pgfId-543409]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-543414]Filtering Tables

 
    

 
    [bookmark: pgfId-543416]Field Reference

 
    [bookmark: pgfId-543419] 

 
     
      
       
       [bookmark: pgfId-538033]Table 62-7 [bookmark: 138732]Accounts and Credentials Page 

 
       
      
        
        		
          
          [bookmark: pgfId-538039]Element
         
  
        		
          
          [bookmark: pgfId-538041]Description
         
  
       

 
        
        		[bookmark: pgfId-538047]Enable Secret Password

  
        		[bookmark: pgfId-538049]The enable secret password for entering privileged EXEC mode on the router. This option offers better security than the Enable Password option.

 [bookmark: pgfId-538051]The enable secret password can contain between 1-25 alphanumeric characters. The first character must be a letter. Spaces are allowed, but leading spaces are ignored. Question marks are also allowed.

 [bookmark: pgfId-538053]Note You can discover an encrypted password, but any password you enter must be in clear text. If you modify an encrypted password, it is saved as clear text.

 [bookmark: pgfId-538055]Note After you set an enable secret password, you can switch to an enable password only if the enable secret is disabled or an older version of Cisco IOS software is being used, such as when running an older rxboot image.

  
       

 
        
        		[bookmark: pgfId-538061]Enable Password

  
        		[bookmark: pgfId-538063]The enable password for entering privileged EXEC mode on the router.

 [bookmark: pgfId-538065]The enable password can contain between 1-25 alphanumeric characters. The first character must be a letter. Spaces are allowed, but leading spaces are ignored. Question marks are also allowed.

 [bookmark: pgfId-538067]Note You must enter the password in clear text.

  
       

 
        
        		[bookmark: pgfId-538073]Enable Password Encryption Service

  
        		[bookmark: pgfId-538075]When selected, encrypts all passwords on the device, including the enable password (which is otherwise saved in clear text).

 [bookmark: pgfId-538077]For example, use this option to encrypt username passwords, authentication key passwords, console and VTY line access passwords, and BGP neighbor passwords. This command is primarily used for keeping unauthorized individuals from viewing your passwords in your configuration file.

 [bookmark: pgfId-538079]When deselected, device passwords are stored unencrypted in the configuration file.

 [bookmark: pgfId-538081]Note This option does not provide a high level of network security. You should also take additional network security measures.

  
       

 
        
        		 [bookmark: pgfId-538087]User Accounts Table

  
       

 
        
        		[bookmark: pgfId-538095]Username

  
        		[bookmark: pgfId-538097]The username that can be used to access the router. The username must be a single word up to 64 characters in length. Spaces and quotation marks are not allowed.

  
       

 
        
        		[bookmark: pgfId-538103]Encryption

  
        		[bookmark: pgfId-538105]Indicates whether password information for the user is encrypted using MD5 encryption.

  
       

 
        
        		[bookmark: pgfId-538111]Privilege Level

  
        		[bookmark: pgfId-538113]The privilege level assigned to the user.

  
       

 
        
        		[bookmark: pgfId-538119]Add button

  
        		[bookmark: pgfId-538124]Opens the User Account Dialog Box. From here you can define a user account.

  
       

 
        
        		[bookmark: pgfId-538130]Edit button

  
        		[bookmark: pgfId-538135]Opens the User Account Dialog Box. From here you can edit the selected user.

  
       

 
        
        		[bookmark: pgfId-538141]Delete button

  
        		[bookmark: pgfId-538143]Deletes the selected user accounts from the table.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-543431][bookmark: 138801][bookmark: rtpage_cncpt_UserAccountDialogBox]User Account Dialog Box[bookmark: marker-543427][bookmark: marker-543429]

 
     [bookmark: pgfId-543433]Employ the User Account dialog box to define a username and password combination that can be used by Security Manager to access the router. You can also define the privilege level of the user account, which determines whether you can configure all commands on this router or only a subset of them.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-543435]Note Remember—there may be additional user accounts defined on the router using other methods, such as the CLI.


     
      

     

     

 
     [bookmark: pgfId-543437]Navigation Path

 
     [bookmark: pgfId-543442]Go to the Accounts and Credential s Policy Page, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-543444]Related Topics

 
      
      		 [bookmark: pgfId-543449]Defining Accounts and Credential Policies

 
      		 [bookmark: pgfId-543454]User Accounts and Device Credentials on Cisco IOS Routers

 
      		 [bookmark: pgfId-543459]Understanding FlexConfig Policies and Policy Objects

 
     

 
     [bookmark: pgfId-543461]Field Reference

 
     [bookmark: pgfId-543464] 

 
      
       
        
        [bookmark: pgfId-538156]Table 62-8 [bookmark: 138834]User Account Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-538162]Element
          
  
         		
           
           [bookmark: pgfId-538164]Description
          
  
        

 
         
         		[bookmark: pgfId-538170]Username

  
         		[bookmark: pgfId-538172]The username for accessing the router.

  
        

 
         
         		[bookmark: pgfId-538178]Password

  
         		[bookmark: pgfId-538180]The password for accessing the router with this user account.

 [bookmark: pgfId-538182]Note You can discover an encrypted password, but any password you enter must be in clear text.

  
        

 
         
         		[bookmark: pgfId-538188]Confirm

  
         		[bookmark: pgfId-538190]Confirms the password for this user account.

  
        

 
         
         		[bookmark: pgfId-538196]Encrypt password using MD5

  
         		[bookmark: pgfId-538198]When selected, uses MD5 encryption to encrypt the password for this user account. This is the default.

 [bookmark: pgfId-538200]When deselected, the password is sent to the router unencrypted.

  
        

 
         
         		[bookmark: pgfId-538206]Privilege Level

  
         		[bookmark: pgfId-538208]The privilege level assigned to the user account. Valid values range from 0 to 15:

 
           
           		 [bookmark: pgfId-538210]0—Grants access to these commands only:  disable ,  enable ,  exit ,  help , and  logout .

 
           		 [bookmark: pgfId-538212]1—Enables nonprivileged access to the router (normal EXEC-mode use privileges).

 
           		 [bookmark: pgfId-538214]15—Enables privileged access to the router (traditional enable privileges).

 
          

 [bookmark: pgfId-538216]Note Levels 2-14 are not normally used in a default configuration, but custom configurations can be created by moving commands that are normally at level 15 to a lower level and commands that are normally at level 1 to a higher level. You can configure the privilege levels of commands using the CLI or by defining a FlexConfig.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-543478][bookmark: 138886][bookmark: rtchap_cncpt_BridgingonCiscoIOSRouters]Bridging on Cisco IOS Routers[bookmark: marker-543470][bookmark: marker-543472][bookmark: marker-543474][bookmark: marker-543476]

 
    [bookmark: pgfId-543483]Bridging policies enable you to perform transparent bridging (as specified in RFC 1286) on selected interfaces that you have configured to function as a bridge group. Security Manager supports integrated routing and bridging, which makes it possible to route a specific protocol between routed interfaces and bridge groups, or route a specific protocol between bridge groups. Local or unroutable traffic can be bridged among the bridged interfaces in the same bridge group, while routable traffic can be routed to other routed interfaces or bridge groups, as shown in Figure 62-1.

 
    [bookmark: pgfId-543485]Using integrated routing and bridging, you can:

 
     
     		 [bookmark: pgfId-543487]Switch packets from a bridged interface to a routed interface.

 
     		 [bookmark: pgfId-543489]Switch packets from a routed interface to a bridged interface.

 
     		 [bookmark: pgfId-543491]Switch packets within the same bridge group.

 
    

 
    [bookmark: pgfId-543495]Figure 62-1 [bookmark: 138913]Transparent Bridging

 
    [bookmark: pgfId-543498] 

 
     
     [image: ] 
    
 
    [bookmark: pgfId-543500]Related Topics

 
     
     		 [bookmark: pgfId-543505]Defining Bridge Groups

 
     		 [bookmark: pgfId-543510]Bridge-Group Virtual Interfaces

 
    

 
     
      [bookmark: pgfId-543520][bookmark: 138925][bookmark: rtchap_cncpt_BridgeGroupVirtualInterfaces]Bridge-Group Virtual Interfaces[bookmark: marker-543516][bookmark: marker-543518]

 
     [bookmark: pgfId-543525]Because bridging takes places at the data link layer and routing takes place at the network layer, they have different protocol configuration models. With IP, for example, bridge group interfaces belong to the same network and have a collective IP network address. In contrast, each routed interface represents a distinct network and has its own IP network address. Integrated routing and bridging uses the concept of a bridge-group virtual interface (BVI) to enable these interfaces to exchange packets for a given protocol. As shown in Figure 62-2, the interface number assigned to the BVI corresponds to the bridge group that the BVI represents. This number serves as the link between the virtual interface and the bridge group.

 
     [bookmark: pgfId-543529]Figure 62-2 [bookmark: 138937]Bridge-Group Virtual Interface

 
     [bookmark: pgfId-543532] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-543534]When you enable routing for a given protocol on the BVI, packets coming from a routed interface that are destined for a host in a bridged domain are routed to the BVI and then forwarded to the corresponding bridged interface. All traffic routed to the BVI is forwarded to the corresponding bridge group as bridged traffic. All routable traffic received on a bridged interface is routed to other routed interfaces as if it is coming directly from the BVI.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-543539]Note BVI interfaces are configured using the Interfaces policy. See Defining Basic Router Interface Settings. The BVI interface must have a corresponding bridge group with the same number; otherwise, deployment will fail.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-543541]Note When the bridge group contains more than two interfaces, add a BVI interface to the group to help prevent unicast flooding, which is a potential security issue.


     
      

     

     

 
     [bookmark: pgfId-543543]Related Topics

 
      
      		 [bookmark: pgfId-543548]Defining Bridge Groups

 
      		 [bookmark: pgfId-543553]Bridging on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-543563][bookmark: 138954][bookmark: rtchap_proc_DefiningBridgeGroups]Defining Bridge Groups[bookmark: marker-543559][bookmark: marker-543561]

 
     [bookmark: pgfId-543565]You define a bridge group by selecting the L3 interfaces that are part of the bridge group and assigning the group a number. All bridge groups in Security Manager perform integrated routing and bridging on IP traffic only and use the standard Spanning Tree Protocol (IEEE 802.1D).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-543567]Note Use CLI commands or FlexConfigs to bridge other protocols, such as AppleTalk or IPX, and to use other spanning tree protocols, such as VLAN-Bridge. Concurrent routing and bridging is not supported.


     
      

     

     

 
     [bookmark: pgfId-543569]Related Topics

 
      
      		 [bookmark: pgfId-543574]Bridging on Cisco IOS Routers

 
      		 [bookmark: pgfId-543579]Bridge-Group Virtual Interfaces

 
     

 
     
 
     [bookmark: pgfId-543581]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-543583](Device view) Select  Platform > Device Admin > Bridging from the Policy selector.

 
      		 [bookmark: pgfId-543585](Policy view) Select  Router Platform > Device Admin > Bridging from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-543590]The Bridging page is displayed. See Table 62-9 for a description of the fields on this page.

 
     [bookmark: pgfId-543595]Step 2 Click the Add button under the table to display the Bridge Group dialog box. See Table 62-10 for a description of the fields in this dialog box. From here you can define a bridge group.

 
     [bookmark: pgfId-543597]Step 3 Enter a number to identify the bridge group.

 
     [bookmark: pgfId-543602]Step 4 Enter the names of the interfaces and interface roles that are part of the bridge group, or click Select to select an interface role or to create a new one. For more information, see Specifying Interfaces During Policy Definition.

 
     [bookmark: pgfId-543604]You can select most Layer 3 interfaces, except X.25 and Integrated Services Digital Network (ISDN) bridged interfaces and certain types of logical interfaces (such as loopback, tunnel, null, and BVI). Each interface can be included in only one bridge group.

 
     [bookmark: pgfId-543606]You can select a LAN subinterface only if the parent interface is configured with Inter-Switch Link (ISL) or 802.1Q encapsulation.

 
     [bookmark: pgfId-543608]Step 5 Click OK to save your definitions locally on the client and close the dialog box. The bridge group is displayed in the table on the Bridging page.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-543610]Note To edit a bridge group, select it from the Groups table, then click Edit. To remove a bridge group, select it, then click Delete.


     
      

     

     

 
     [bookmark: pgfId-543612]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-543624][bookmark: 139007][bookmark: rtpage_cncpt_BridgingPolicyPage]Bridging Policy Page[bookmark: marker-543620][bookmark: marker-543622]

 
    [bookmark: pgfId-543629]Use the Bridging page to define bridge groups that can perform integrated routing and bridging on the router. For more information, see Defining Bridge Groups.

 
    [bookmark: pgfId-543631]Navigation Path

 
     
     		 [bookmark: pgfId-543633](Device view) Select  Platform > Device Admin > Bridging from the Policy selector.

 
     		 [bookmark: pgfId-543635](Policy view) Select  Router Platform > Device Admin > Bridging from the Policy Type selector. Right-click  Bridging to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-543637]Related Topics

 
     
     		 [bookmark: pgfId-543642]Bridging on Cisco IOS Routers

 
     		 [bookmark: pgfId-543647]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-543652]Filtering Tables

 
    

 
    [bookmark: pgfId-543654]Field Reference

 
    [bookmark: pgfId-543657] 

 
     
      
       
       [bookmark: pgfId-538229]Table 62-9 [bookmark: 139045]Bridging Page 

 
       
      
        
        		
          
          [bookmark: pgfId-538235]Element
         
  
        		
          
          [bookmark: pgfId-538237]Description
         
  
       

 
        
        		[bookmark: pgfId-538243]Group Number

  
        		[bookmark: pgfId-538245]The number that identifies the bridge group.

  
       

 
        
        		[bookmark: pgfId-538251]Group Interfaces

  
        		[bookmark: pgfId-538253]The interfaces and interface roles that are included in the bridge group.

  
       

 
        
        		[bookmark: pgfId-538259]Add button

  
        		[bookmark: pgfId-538264]Opens the Bridge Group Dialog Box. From here you can define a bridge group.

  
       

 
        
        		[bookmark: pgfId-538270]Edit button

  
        		[bookmark: pgfId-538275]Opens the Bridge Group Dialog Box. From here you can edit the bridge group.

  
       

 
        
        		[bookmark: pgfId-538281]Delete button

  
        		[bookmark: pgfId-538283]Deletes the selected bridge groups from the table.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-543669][bookmark: 139082][bookmark: rtpage_cncpt_BridgeGroupDialogBox]Bridge Group Dialog Box[bookmark: marker-543665][bookmark: marker-543667]

 
     [bookmark: pgfId-543671]Use the Bridge Group dialog box to define bridge groups on the router. Each bridge group can contain multiple Layer 3 interfaces of various types, including serial interfaces.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-543673]Note All bridge groups use the standard Spanning Tree Protocol (IEEE 802.1D). Use CLI commands or FlexConfigs to bridge other protocols, such as AppleTalk or IPX, and to use other spanning tree protocols, such as VLAN-Bridge.


     
      

     

     

 
     [bookmark: pgfId-543675]Navigation Path

 
     [bookmark: pgfId-543680]Go to the Bridging Policy Page, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-543682]Related Topics

 
      
      		 [bookmark: pgfId-543687]Defining Bridge Groups

 
      		 [bookmark: pgfId-543692]Bridging on Cisco IOS Routers

 
      		 [bookmark: pgfId-543697]Understanding Interface Role Objects

 
     

 
     [bookmark: pgfId-543699]Field Reference

 
     [bookmark: pgfId-543702] 

 
      
       
        
        [bookmark: pgfId-538296]Table 62-10 [bookmark: 139116]Bridge Group Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-538302]Element
          
  
         		
           
           [bookmark: pgfId-538304]Description
          
  
        

 
         
         		[bookmark: pgfId-538310]Group Number

  
         		[bookmark: pgfId-538312]The number assigned to the bridge group. Valid values range from 1 to 255.

  
        

 
         
         		[bookmark: pgfId-538318]Group Interfaces

  
         		[bookmark: pgfId-538320]The interfaces that are included in the bridge group. Enter the name of one or more interfaces and interface roles, or click Select to select them. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-538322]You can select most Layer 3 interfaces, including serial interfaces, provided the serial interface is configured with high-level data link control (HDLC) or Frame Relay encapsulation. Each interface can belong to only one bridge group.

 [bookmark: pgfId-538324]You can select a LAN subinterface only if the parent interface is configured with Inter-Switch Link (ISL) or 802.1Q encapsulation.

 [bookmark: pgfId-538326]Note Certain types of interfaces, such as loopback, tunnel, null, and BVI, cannot be bridged.

 [bookmark: pgfId-538328]Note Make sure that your bridge group does not prevent Security Manager from communicating with the device.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-543716][bookmark: 139144][bookmark: rtchap_cncpt_TimeZoneSettingsonCiscoIOSRouters]Time Zone Settings on Cisco IOS Routers[bookmark: marker-543708][bookmark: marker-543710][bookmark: marker-543712][bookmark: marker-543714]

 
    [bookmark: pgfId-543718]The local time on a Cisco IOS router is typically set using the clock set command in the CLI command or by dynamically deriving the time from an NTP server. You can adjust these time settings by defining the time zone in which the router resides and the start and end dates of Daylight Saving Time (DST) in that time zone.

 
    [bookmark: pgfId-543720]Related Topics

 
     
     		 [bookmark: pgfId-543725]Defining Time Zone and DST Settings

 
     		 [bookmark: pgfId-543730]NTP on Cisco IOS Routers

 
    

 
     
      [bookmark: pgfId-543738][bookmark: 139171][bookmark: rtchap_proc_DefiningTimeZoneandDSTSettings]Defining Time Zone and DST Settings[bookmark: marker-543736]

 
     [bookmark: pgfId-543740]Security Manager enables you to define the time zone in which a Cisco IOS router is located. You can also define the start and end dates for Daylight Saving Time (DST).

 
     [bookmark: pgfId-543742]Related Topics

 
      
      		 [bookmark: pgfId-543747]Defining NTP Servers

 
      		 [bookmark: pgfId-543752]Time Zone Settings on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-543754]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-543756](Device view) Select  Platform > Device Admin > Clock from the Policy selector.

 
      		 [bookmark: pgfId-543758](Policy view) Select  Router Platform > Device Admin > Clock from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-543763]The Clock page is displayed. See Table 62-11 for a description of the fields on this page.

 
     [bookmark: pgfId-543765]Step 2 Select the time zone in which the router is located. Time zones are listed according the number of hours behind or ahead of Greenwich Mean Time (GMT).

 
     [bookmark: pgfId-543767]Step 3 (Optional) Select the method for determining the start and end dates for DST:

 
      
      		 [bookmark: pgfId-543772]Set by Date—Select this option when DST starts and ends on fixed dates. Continue with Step 4.

 
      		 [bookmark: pgfId-543777]Set by Day—Select this option when DST starts and ends on days whose specific dates vary from year to year. Continue with Step 5.

 
      		 [bookmark: pgfId-543779]None—Select this option when DST is not used.

 
     

 
     [bookmark: pgfId-543783]Step 4 [bookmark: 139212](When Set by Date is selected) Define the fixed dates when DST starts and ends:

 
     [bookmark: pgfId-543785] a. Under Start, click the calendar icon, then click the appropriate date.

 
     [bookmark: pgfId-543787] b. Select the hour and minute from the displayed lists.

 
     [bookmark: pgfId-543789] c. Repeat steps a and b to configure the end date and time.

 
     [bookmark: pgfId-543793]Step 5 [bookmark: 139221](When Set by Day is selected) Select the Specify Recurring Time check box if you want to define a DST period other than the default, which is the period used throughout most of the United States.

 
     [bookmark: pgfId-543797]Step 6 [bookmark: 139225](When Specify Recurring Time is selected) Define the start and end of DST:

 
     [bookmark: pgfId-543799] a. Under Start, select the month when DST begins.

 
     [bookmark: pgfId-543801] b. Select the week of the month (1, 2, 3, 4, first, or last).

 
     [bookmark: pgfId-543803] c. Select the day of the week.

 
     [bookmark: pgfId-543805] d. Select the hour and minute from the displayed lists. For example, if DST begins at 1:00 a.m. on the last Sunday of each March, select March, last, Sunday, 1, and 00.

 
     [bookmark: pgfId-543807] e. Repeat Steps a through d to configure the end date and time.

 
     [bookmark: pgfId-543809]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-543823][bookmark: 139242][bookmark: rtpage_cncpt_ClockPolicyPage]Clock Policy Page[bookmark: marker-543817][bookmark: marker-543819][bookmark: marker-543821]

 
    [bookmark: pgfId-543828]Use the Clock page to configure the time zone in which the router is located and the settings for Daylight Saving Time (DST). For more information, see Time Zone Settings on Cisco IOS Routers.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-543830]Tip You can configure the local time on the router by defining an NTP policy or by configuring the clock set command using the CLI.


    
     

    

    

 
    [bookmark: pgfId-543832]Navigation Path

 
     
     		 [bookmark: pgfId-543834](Device view) Select  Platform > Device Admin > Clock from the Policy selector.

 
     		 [bookmark: pgfId-543836](Policy view) Select  Router Platform > Device Admin > Clock from the Policy Type selector. Right-click  Clock to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-543838]Related Topics

 
     
     		 [bookmark: pgfId-543843]NTP Policy Page

 
    

 
    [bookmark: pgfId-543845]Field Reference

 
    [bookmark: pgfId-543848] 

 
     
      
       
       [bookmark: pgfId-538341]Table 62-11 [bookmark: 139279]Clock Page 

 
       
      
        
        		
          
          [bookmark: pgfId-538347]Element
         
  
        		
          
          [bookmark: pgfId-538349]Description
         
  
       

 
        
        		[bookmark: pgfId-538355]Device Time Zone

  
        		[bookmark: pgfId-538357]The time zone in which the router is located, expressed in relation to GMT (Greenwich Mean Time), also known as UTC (Coordinated Universal Time).

 
          
          [image: ] 
         
 
         
 
         
          [bookmark: pgfId-1056071]Caution If you want to use the Command Line Interface (CLI) to configure the time zone on the router, you must use the required Time Zone acronym provided in the 
          Cisco IOS Configuration Fundamentals Command Reference document. If you use any other format for the time zone and then use Security Manager to discover the router, Security Manager will not discover the time zone CLI.
           
           
 
          

         
  
       

 
        
        		[bookmark: pgfId-538363]Daylight Savings Time (Summer Time)

  
        		[bookmark: pgfId-538365]The type of DST to apply to the local time on the router:

 
          
          		 [bookmark: pgfId-538367]Set by Date—Enables you to define the exact date and time when DST begins and ends.

 
          		 [bookmark: pgfId-538369]Set by Day—Enables you to define the relative recurring date and time when DST begins and ends. For example, you can use this option when DST begins the last Sunday of March and ends the last Sunday of October.

 
          		 [bookmark: pgfId-538371]None—Daylight savings time is not used.

 
         

  
       

 
        
        		 [bookmark: pgfId-538377]Additional Set by Date fields

  
       

 
        
        		[bookmark: pgfId-538385]Start

  
        		[bookmark: pgfId-538387]The date and time when DST begins:

 
          
          		 [bookmark: pgfId-538389]Date—Click the calendar icon to select the start date.

 
          		 [bookmark: pgfId-538391]Hour—Select the start hour.

 
          		 [bookmark: pgfId-538393]Minute—Select the start minute.

 
         

  
       

 
        
        		[bookmark: pgfId-538399]End

  
        		[bookmark: pgfId-538401]The date and time when DST ends:

 
          
          		 [bookmark: pgfId-538403]Date—Click the calendar icon to select the end date.

 
          		 [bookmark: pgfId-538405]Hour—Select the end hour.

 
          		 [bookmark: pgfId-538407]Minute—Select the end minute.

 
         

 [bookmark: pgfId-538409]Note Cisco IOS Software supports dates up to and including December 31st, 2035.

  
       

 
        
        		 [bookmark: pgfId-538415]Additional Set by Day fields

  
       

 
        
        		[bookmark: pgfId-538423]Specify Recurring Time

  
        		[bookmark: pgfId-538425]When selected, the router implements DST according to the dates and times specified in this policy.

 [bookmark: pgfId-538427]When deselected, the router implements DST according to the schedule used throughout most of the United States.

  
       

 
        
        		[bookmark: pgfId-538433]Start

  
        		[bookmark: pgfId-538435]The relative date and time when daylight savings time begins:

 
          
          		 [bookmark: pgfId-538437]Month—Select the month.

 
          		 [bookmark: pgfId-538439]Week—Select the week of the month (1, 2, 3, 4, first, or last).

 
          		 [bookmark: pgfId-538441]Weekday—Select the day of the week.

 
          		 [bookmark: pgfId-538443]Hour—Select the hour.

 
          		 [bookmark: pgfId-538445]Minute—Select the minute.

 
         

 [bookmark: pgfId-538447]For example, if DST begins at 1:00 a.m. on the last Sunday of each March, select March, last, Sunday, 1, and 00.

  
       

 
        
        		[bookmark: pgfId-538453]End

  
        		[bookmark: pgfId-538455]The relative date and time when daylight savings time ends:

 
          
          		 [bookmark: pgfId-538457]Month—Select the month.

 
          		 [bookmark: pgfId-538459]Week—Select the week of the month (1, 2, 3, 4, first, or last).

 
          		 [bookmark: pgfId-538461]Weekday—Select the day of the week.

 
          		 [bookmark: pgfId-538463]Hour—Select the hour.

 
          		 [bookmark: pgfId-538465]Minute—Select the minute.

 
         

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-543860][bookmark: 139379][bookmark: rtchap_cncpt_CPUUtilizationSettingsonCiscoIOSRouters]CPU Utilization Settings on Cisco IOS Routers[bookmark: marker-543854][bookmark: marker-543856][bookmark: marker-543858]

 
    [bookmark: pgfId-543862]The CPU policy configures settings relating to CPU utilization. This policy provides you with methods for monitoring CPU resources and tracking processes that exceed a predetermined level of utilization.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-543864]Note The CPU policy is supported on routers running Cisco IOS Software Release 12.3(14)T or later.


    
     

    

    

 
    [bookmark: pgfId-543866]Related Topics

 
     
     		 [bookmark: pgfId-543871]Defining CPU Utilization Settings

 
    

 
     
      [bookmark: pgfId-543879][bookmark: 139399][bookmark: rtchap_proc_DefiningCPUUtilizationSettings]Defining CPU Utilization Settings[bookmark: marker-543877]

 
     [bookmark: pgfId-543881]You can use Security Manager to modify the following default CPU utilization settings:

 
      
      		 [bookmark: pgfId-543883]The size of the CPU history table.

 
      		 [bookmark: pgfId-543885]The size of the extended CPU load history table.

 
      		 [bookmark: pgfId-543887]Whether to enable the automatic CPU Hog profiling.

 
     

 
     [bookmark: pgfId-543889]In addition, you can optionally define:

 
      
      		 [bookmark: pgfId-543891]The CPU utilization level that causes a process to be included in the history table.

 
      		 [bookmark: pgfId-543893]The types of CPU utilization thresholds to enable. For each type of threshold, you can determine the threshold values that trigger notifications.

 
     

 
     [bookmark: pgfId-543895]Related Topics

 
      
      		 [bookmark: pgfId-543900]CPU Utilization Settings on Cisco IOS Routers

 
      		 [bookmark: pgfId-543905]Logging on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-543907]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-543909](Device view) Select  Platform > Device Admin > CPU from the Policy selector.

 
      		 [bookmark: pgfId-543911](Policy view) Select  Router Platform > Device Admin > CPU from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-543913]The CPU page is displayed.

 
     [bookmark: pgfId-543918]Step 2 (Optional) Define the CPU utilization settings of the router, as required. See Table 62-12 for a description of the available fields.

 
     [bookmark: pgfId-543920]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-543932][bookmark: 139445][bookmark: rtpage_cncpt_CPUPolicyPage]CPU Policy Page[bookmark: marker-543928][bookmark: marker-543930]

 
    [bookmark: pgfId-543934]Use the CPU page to configure settings related to router CPU utilization, including the thresholds for sending log messages, the size of the CPU history table, and whether to enable automatic CPU Hog profiling.

 
    [bookmark: pgfId-543939]For more information, see Defining CPU Utilization Settings.

 
    [bookmark: pgfId-543941]Navigation Path

 
     
     		 [bookmark: pgfId-543943](Device view) Select  Platform > Device Access > CPU from the Policy selector.

 
     		 [bookmark: pgfId-543945](Policy view) Select  Router Platform > Device Access > CPU from the Policy Type selector. Right-click  CPU to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-543947]Related Topics

 
     
     		 [bookmark: pgfId-543952]Memory Policy Page

 
     		 [bookmark: pgfId-543957]Syslog Logging Setup Policy Page

 
     		 [bookmark: pgfId-543962]Syslog Servers Policy Page

 
    

 
    [bookmark: pgfId-543964]Field Reference

 
    [bookmark: pgfId-543967] 

 
     
      
       
       [bookmark: pgfId-538478]Table 62-12 [bookmark: 139482]CPU Page 

 
       
      
        
        		
          
          [bookmark: pgfId-538484]Element
         
  
        		
          
          [bookmark: pgfId-538486]Description
         
  
       

 
        
        		[bookmark: pgfId-538492]CPU Utilization Statistics

  
        		[bookmark: pgfId-538494]Settings related to the history table for CPU utilization statistics:

 
          
          		 [bookmark: pgfId-538496]History Table Entry Limit—The percentage of CPU utilization that a process must use to be included in the history table.

 
          		 [bookmark: pgfId-538498]History Table Size—The length of time for which CPU statistics are stored in the history table. Valid values range from 5 to 86400 seconds (24 hours). The default is 600 seconds (10 minutes).

 
         

  
       

 
        
        		[bookmark: pgfId-538504]CPU Total Utilization

  
        		[bookmark: pgfId-538506]The thresholds for total CPU utilization that trigger notifications:

 
          
          		 [bookmark: pgfId-538508]Enable CPU Total Utilization—When selected, CPU total utilization thresholds are enabled. When deselected, these thresholds are disabled and do not trigger notifications. This is the default.

 
          		 [bookmark: pgfId-538510]Maximum Total Utilization Resources—The percentage of CPU resources that, when usage  exceeds this level for the defined interval, triggers a notification.

 
          		 [bookmark: pgfId-538512]Maximum Total Utilization Violation Duration—The violation interval that triggers a maximum CPU threshold notification. Valid values range from 5 to 86400 seconds (24 hours).

 
          		 [bookmark: pgfId-538514]Minimum Total Utilization Resources—The percentage of CPU resources that, when usage  falls below this level for the defined interval, triggers a notification.

 
          		 [bookmark: pgfId-538516]Minimum Total Utilization Violation Duration—The violation interval that triggers a minimum CPU threshold notification. Valid values range from 5 to 86400 seconds (24 hours).

 
         

  
       

 
        
        		[bookmark: pgfId-538522]CPU Interrupt Utilization

  
        		[bookmark: pgfId-538524]The thresholds for CPU interrupt utilization that trigger notifications:

 
          
          		 [bookmark: pgfId-538526]Enable CPU Interrupt Utilization—When selected, CPU interrupt utilization thresholds are enabled. When deselected, these thresholds are disabled and do not trigger notifications. This is the default.

 
          		 [bookmark: pgfId-538528]Maximum Interrupt Utilization Resources—The percentage of CPU resources that, when usage  exceeds this level for the defined interval, triggers a notification.

 
          		 [bookmark: pgfId-538530]Maximum Interrupt Utilization Violation Duration—The violation interval that triggers a maximum CPU threshold notification. Valid values range from 5 to 86400 seconds (24 hours).

 
          		 [bookmark: pgfId-538532]Minimum Interrupt Utilization Resources—The percentage of CPU resources that, when usage  falls below this level for the defined interval, triggers a notification.

 
          		 [bookmark: pgfId-538534]Minimum Interrupt Utilization Violation Duration—The violation interval that triggers a minimum CPU threshold notification. Valid values range from 5 to 86400 seconds (24 hours).

 
         

  
       

 
        
        		[bookmark: pgfId-538540]CPU Process Utilization

  
        		[bookmark: pgfId-538542]The thresholds for CPU process utilization that trigger notifications:

 
          
          		 [bookmark: pgfId-538544]Enable CPU Process Utilization—When selected, CPU process utilization thresholds are enabled. When deselected, these thresholds are disabled and do not trigger notifications. This is the default.

 
          		 [bookmark: pgfId-538546]Maximum Process Utilization Resources—The percentage of CPU resources that, when usage  exceeds this level for the defined interval, triggers a notification.

 
          		 [bookmark: pgfId-538548]Maximum Process Utilization Violation Duration—The violation interval that triggers a maximum CPU threshold notification. Valid values range from 5 to 86400 seconds (24 hours).

 
          		 [bookmark: pgfId-538550]Minimum Process Utilization Resources—The percentage of CPU resources that, when usage  falls below this level for the defined interval, triggers a notification.

 
          		 [bookmark: pgfId-538552]Minimum Process Utilization Violation Duration—The violation interval that triggers a minimum CPU threshold notification. Valid values range from 5 to 86400 seconds (24 hours).

 
         

  
       

 
        
        		[bookmark: pgfId-538558]Extended CPU History Size

  
        		[bookmark: pgfId-538560]The size of the history to collect for the extended CPU load, in increments of 5 seconds. Valid values range from 2 to 720. The default is 12, which is equivalent to a 1-minute history.

  
       

 
        
        		[bookmark: pgfId-538566]Enable Automatic CPU Hog Profiling

  
        		[bookmark: pgfId-538568]When selected, automatic CPU Hog profiling is enabled. This is the default.

 [bookmark: pgfId-538570]When deselected, automatic CPU Hog profiling is disabled.

 [bookmark: pgfId-538572]This feature predicts when a process could hog the CPU and begins profiling that process.

 command in the CLI.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-543979][bookmark: 139571][bookmark: rtchap_cncpt_HTTPandHTTPSonCiscoIOSRouters]HTTP and HTTPS on Cisco IOS Routers[bookmark: marker-543973][bookmark: marker-543975][bookmark: marker-543977]

 
    [bookmark: pgfId-543981]Security Manager enables you to configure HTTP and HTTP over Secure Socket Layer (known as HTTP over SSL or HTTPS) server functionality on Cisco IOS routers. This feature provides SSL version 3.0 support for the HTTP 1.1 server.

 
    [bookmark: pgfId-543983]A secure HTTP connection means that data sent to and received from an HTTP server are encrypted before being sent out over the internet. HTTP with SSL encryption provides a secure connection to allow such functions as configuring a router from a web browser.

 
    [bookmark: pgfId-543985]In addition to providing access to the device via the Cisco web browser user interface, HTTP and HTTPS are used by device management applications, such as the Cisco Router and Security Device Manager (SDM), to communicate with the device.

 
    [bookmark: pgfId-543987]Related Topics

 
     
     		 [bookmark: pgfId-543992]Defining HTTP Policies

 
    

 
     
      [bookmark: pgfId-544000][bookmark: 139593][bookmark: rtchap_proc_DefiningHTTPPolicies]Defining HTTP Policies[bookmark: marker-543998]

 
     [bookmark: pgfId-544002]When you define an HTTP policy, you can:

 
      
      		 [bookmark: pgfId-544004]Enable and disable HTTP and SSL functionality on the router.

 
      		 [bookmark: pgfId-544006]Specify the ports used by each protocol.

 
      		 [bookmark: pgfId-544008]Optionally define a standard, numbered ACL that restricts access to the device using these protocols.

 
     

 
     [bookmark: pgfId-544010]In addition, you can define the methods of AAA authentication and authorization methods to perform on users.

 
     [bookmark: pgfId-544012]You must use caution when defining an HTTP policy, as your settings may affect communication between Security Manager (as well as other management applications that use these protocols) and the device.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544017]Note As a general rule, Cisco IOS routers that have been discovered by Security Manager already have HTTPS enabled because Security Manager uses SSL as the default protocol for communicating with them. See Setting Up SSL on Cisco IOS Routers.


     
      

     

     

 
     [bookmark: pgfId-544019]Before You Begin

 
      
      		 [bookmark: pgfId-544024]Enable AAA services on the router. See Defining AAA Services.

 
     

 
     [bookmark: pgfId-544026]Related Topics

 
      
      		 [bookmark: pgfId-544031]HTTP and HTTPS on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-544033]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-544035](Device view) Select  Platform > Device Admin > Device Access > HTTP from the Policy selector, then click the  Setup tab in the work area.

 
      		 [bookmark: pgfId-544037](Policy view) Select  Router Platform > Device Admin > Device Access > HTTP from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-544042]The HTTP Setup tab is displayed. See Table 62-13 for a description of the fields on this tab.

 
     [bookmark: pgfId-544044]Step 2 Select the check boxes to enable HTTP and SSL (HTTPS) server functionality on the router.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544049]Note If SSL is disabled (or if the HTTP policy as a whole is unassigned), Security Manager cannot communicate with the device after deployment unless you change the transport protocol for this device to SSH. This setting can be found in Device Properties. See Managing Device Communication Settings and Certificates.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544051]Tip We recommend that you disable HTTP when SSL is enabled. This is required to ensure only secure connections to the server.


     
      

     

     

 
     [bookmark: pgfId-544053]Step 3 (Optional) Modify the default ports used by HTTP (80) and HTTPS (443).

 
     [bookmark: pgfId-544058]Step 4 (Optional) In the Allow Connection From field, enter the name of the standard, numbered ACL object that specifies which addresses can use HTTP and HTTPS on this device, or click Select to select the ACL object from a list or to create a new one. Use this option to restrict access to these protocols. For more information about creating standard ACL objects, see Creating Standard Access Control List Objects

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544060]Note Make sure that the ACL you select permits the Security Manager server; otherwise, communication with the device is lost.


     
      

     

     

 
     [bookmark: pgfId-544062]Step 5 (Optional) On the AAA tab, modify the default type of authentication to perform on users who attempt to access the device using HTTP or HTTPS. Options include AAA, Enable Password (default), Local Database, and TACACS.

 
     [bookmark: pgfId-544070]If you select AAA, continue with Step 6; otherwise, continue with Step 8.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544072]Note The TACACS option applies only to devices using an IOS software version prior to 12.3(8).


     
      

     

     

 
     [bookmark: pgfId-544077]See Table 62-14 for a description of the fields on the AAA tab.

 
     [bookmark: pgfId-544081]Step 6 [bookmark: 139656]Select the authentication method to perform on users:

 
      
      		 [bookmark: pgfId-544089]If you want to use the default AAA login authentication methods defined in the device’s AAA policy (see Defining AAA Services), do  not select the Enable Device Login Authentication check box. Continue with Step 7.

 
      		 [bookmark: pgfId-544091]If you want to define a method list especially for this policy, do the following:

 
     

 
     [bookmark: pgfId-544093] a. Select the Enable Device Login Authentication check box.

 
     [bookmark: pgfId-544095] b. Under Prioritized Method List, enter the names of the AAA server groups to use for authentication, or click Select to select the AAA server groups from a list or to create new ones. Use the up and down arrows in the selector to define the order in which you want to apply these authentication methods.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544097]Note Make sure that Security Manager users are defined on the AAA servers; otherwise communication with the device is lost.


     
      

     

     

 
     [bookmark: pgfId-544101]Step 7 [bookmark: 139674]Select the authorization method to perform on users who use HTTP or HTTPS to begin an EXEC session:

 
      
      		 [bookmark: pgfId-544106]If you want to use the default AAA authorization methods defined in the device’s AAA policy, do  not select the Enable CLI/EXEC Operations Authorization check box. Continue with Step 8.

 
      		 [bookmark: pgfId-544108]If you want to define a method list especially for this policy, select the  Enable CLI/EXEC Operations Authorization check box, then define the method list.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544113]Note If you leave this option deselected, make sure that EXEC authorization is enabled in the router’s AAA policy. Otherwise, you will be unable to connect to the device via HTTP or HTTPS (SSL). This applies to Security Manager as well as other applications, such as SDM. See Defining AAA Services.


     
      

     

     

 
     [bookmark: pgfId-544117]Step 8 [bookmark: 139686](Optional) Create command authorization definitions for specific privilege levels:

 
     [bookmark: pgfId-544124] a. [bookmark: 139687]Click the Add button under the Command Authorization Override table. The Command Authorization Override dialog box is displayed. See Table 62-15 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-544126] b. Configure the command authorization definition as required.

 
     [bookmark: pgfId-544130] c. [bookmark: 139693]Click OK. The dialog box closes and the authorization method is displayed in the Command Authorization Override table.

 
     [bookmark: pgfId-544138] d. Repeat a. through c. to create additional command authorization definitions.

 
     [bookmark: pgfId-544140]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-544150][bookmark: 139706][bookmark: rtpage_cncpt_HTTPPolicyPage]HTTP Policy Page[bookmark: marker-544146][bookmark: marker-544148]

 
    [bookmark: pgfId-544152]Use the HTTP page to configure HTTP and HTTPS access on the router. You can configure HTTP policies on a Cisco IOS router from the following tabs on the HTTP policy page:

 
     
     		 [bookmark: pgfId-544157]HTTP Page—Setup Tab

 
     		 [bookmark: pgfId-544162]HTTP Page—AAA Tab

 
    

 
    [bookmark: pgfId-544167]For more information, see HTTP and HTTPS on Cisco IOS Routers.

 
    [bookmark: pgfId-544169]Navigation Path

 
     
     		 [bookmark: pgfId-544171](Device view) Select  Platform > Device Admin > Device Access > HTTP from the Policy selector.

 
     		 [bookmark: pgfId-544173](Policy view) Select  Router Platform > Device Admin > Device Access > HTTP from the Policy Type selector. Right-click  HTTP to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
     
      [bookmark: pgfId-544185][bookmark: 139736][bookmark: rtpage_cncpt_HTTPPageSetupTab]HTTP Page—Setup Tab[bookmark: marker-544181][bookmark: marker-544183]

 
     [bookmark: pgfId-544187]Use the Setup tab of the HTTP page to enable HTTP and HTTP over Secure Socket Layer (HTTP over SSL or HTTPS) on the router. You can optionally limit access to these protocols to the addresses defined in an access control list.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544192]Note As a general rule, Cisco IOS routers that have been discovered by Security Manager already have HTTPS enabled because Security Manager uses SSL as the default protocol for communicating with them. See Setting Up SSL on Cisco IOS Routers.


     
      

     

     

 
     [bookmark: pgfId-544194]Navigation Path

 
     [bookmark: pgfId-544199]Go to the HTTP Policy Page, then click the Setup tab.

 
     [bookmark: pgfId-544201]Related Topics

 
      
      		 [bookmark: pgfId-544206]HTTP Page—AAA Tab

 
      		 [bookmark: pgfId-544211]HTTP and HTTPS on Cisco IOS Routers

 
     

 
     [bookmark: pgfId-544213]Field Reference

 
     [bookmark: pgfId-544216] 

 
      
       
        
        [bookmark: pgfId-538587]Table 62-13 [bookmark: 139767]HTTP Page—Setup Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-538593]Element
          
  
         		
           
           [bookmark: pgfId-538595]Description
          
  
        

 
         
         		[bookmark: pgfId-538601]Enable HTTP

  
         		[bookmark: pgfId-538603]When selected, an HTTP server is enabled on the router.

 [bookmark: pgfId-538605]When deselected, HTTP is disabled on the router. This is the default for devices that were not discovered.

  
        

 
         
         		[bookmark: pgfId-538611]HTTP Port

  
         		[bookmark: pgfId-538613]The port number to use for HTTP. Valid values are 80 or any value from 1024 to 65535. The default is 80.

  
        

 
         
         		[bookmark: pgfId-538619]Enable SSL

  
         		[bookmark: pgfId-538621]When selected, a secure HTTP server (HTTP over SSL or HTTPS) is enabled on the router.

 [bookmark: pgfId-538623]When deselected, HTTPS is disabled. This is the default for devices that were not discovered.

 [bookmark: pgfId-538625]Note If SSL is disabled (or if the HTTP policy as a whole is unassigned), Security Manager cannot communicate with the device after deployment unless you change the transport protocol for this device to SSH. This setting can be found in Device Properties.

 [bookmark: pgfId-538627]Note We recommend that you disable HTTP when SSL is enabled. This is required to ensure only secure connections to the server.

  
        

 
         
         		[bookmark: pgfId-538633]SSL Port

  
         		[bookmark: pgfId-538635]The port number to use for HTTPS. Valid values are 443 or any value from 1025 to 65535. The default is 443.

  
        

 
         
         		[bookmark: pgfId-538641]Allow Connection From

  
         		[bookmark: pgfId-538643]The name of the standard numbered ACL that restricts use of HTTP and HTTPS on this device. Enter the name of an ACL object, or click Select to select it. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-538645]Note If you define an ACL, make sure that it includes the Security Manager server. Otherwise, Security Manager cannot communicate with this device using SSL.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-544228][bookmark: 139810][bookmark: rtpage_cncpt_HTTPPageAAATab]HTTP Page—AAA Tab[bookmark: marker-544224][bookmark: marker-544226]

 
     [bookmark: pgfId-544230]Use the AAA tab of the HTTP page to define the authentication and authorization methods to perform on users who attempt to access the router using HTTP or HTTPS.

 
     [bookmark: pgfId-544232]Navigation Path

 
     [bookmark: pgfId-544237]Go to the HTTP Policy Page, then click the AAA tab.

 
     [bookmark: pgfId-544239]Related Topics

 
      
      		 [bookmark: pgfId-544244]HTTP Page—Setup Tab

 
      		 [bookmark: pgfId-544249]HTTP and HTTPS on Cisco IOS Routers

 
      		 [bookmark: pgfId-544254]Filtering Tables

 
     

 
     [bookmark: pgfId-544256]Field Reference

 
     [bookmark: pgfId-544259] 

 
      
       
        
        [bookmark: pgfId-538658]Table 62-14 [bookmark: 139842]HTTP Page—AAA Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-538664]Element
          
  
         		
           
           [bookmark: pgfId-538666]Description
          
  
        

 
         
         		[bookmark: pgfId-538672]Authenticate Using

  
         		[bookmark: pgfId-538674]The type of authentication to use:

 
           
           		 [bookmark: pgfId-538676]AAA—Performs AAA login authentication.

 
           		 [bookmark: pgfId-538678]Enable Password—Uses the enable password configured on the router. This is the default.

 
           		 [bookmark: pgfId-538680]Local Database—Uses the local username database configured on the router.

 
           		 [bookmark: pgfId-538682]TACACS—Uses the TACACS or XTACACS server configured on the router. Applies only to devices using an IOS software version prior to 12.3(8) or 12.3(8)T.

 
          

  
        

 
         
         		 [bookmark: pgfId-538688]Login Authentication settings

  
        

 
         
         		[bookmark: pgfId-538696]Enable Device Login Authentication

  
         		[bookmark: pgfId-538698]Applies only when AAA is selected as the authentication method.

 [bookmark: pgfId-538700]When selected, authentication is based on the methods defined in the Prioritized Method List field.

 [bookmark: pgfId-538705]When deselected, the default authentication list defined in the router’s AAA policy is used. See AAA Page—Authentication Tab.

  
        

 
         
         		[bookmark: pgfId-538711]Prioritized Method List

  
         		[bookmark: pgfId-538713]Applies only when the Enable Device Login Authentication check box is selected.

 [bookmark: pgfId-538715]Defines a sequential list of methods to be queried when authenticating a user. Enter the names of one or more AAA server group objects (up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-538717]The device tries initially to authenticate users using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-538719]Note If you select None as a method, it must appear as the last method in the list.

  
        

 
         
         		 [bookmark: pgfId-538725]EXEC Authorization settings

  
        

 
         
         		[bookmark: pgfId-538733]Enable CLI/EXEC Operations Authorization

  
         		[bookmark: pgfId-538735]Applies only when AAA is selected as the authentication method.

 [bookmark: pgfId-538737]When selected, EXEC authorization is based on the methods defined in the Prioritized Method List field. This type of authorization determines whether the user is permitted to open an EXEC (CLI) session.

 [bookmark: pgfId-538742]When deselected, the default EXEC authorization list defined in the router’s AAA policy is used. See AAA Page—Authorization Tab.

 [bookmark: pgfId-538744]Note If you leave this option deselected, make sure that EXEC authorization is enabled in the router’s AAA policy. Otherwise, you will be unable to connect to the device via HTTP or HTTPS (SSL). This applies to Security Manager as well as other applications, such as SDM and the device’s web interface.

  
        

 
         
         		[bookmark: pgfId-538750]Prioritized Method List

  
         		[bookmark: pgfId-538752]Applies only when the Enable CLI/EXEC Operations Authorization check box is selected.

 [bookmark: pgfId-538754]Defines a sequential list of methods to be queried when authorizing a user to open an EXEC (CLI) session. Enter the names of one or more AAA server group objects (up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-538756]The device tries initially to authorize users using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-538758]Note If you select None as a method, it must appear as the last method in the list.

  
        

 
         
         		 [bookmark: pgfId-538764]Command Authorization settings

  
        

 
         
         		[bookmark: pgfId-538772]Privilege Level

  
         		[bookmark: pgfId-538774]The privilege level to which the command authorization definition applies.

  
        

 
         
         		[bookmark: pgfId-538780]Prioritized Method List

  
         		[bookmark: pgfId-538782]The method list to use when authorizing users with this privilege level.

  
        

 
         
         		[bookmark: pgfId-538788]Add button

  
         		[bookmark: pgfId-538793]Opens the Command Authorization Override Dialog Box. From here you can configure a command authorization definition.

  
        

 
         
         		[bookmark: pgfId-538799]Edit button

  
         		[bookmark: pgfId-538804]Opens the Command Authorization Override Dialog Box. From here you can edit the command authorization definition.

  
        

 
         
         		[bookmark: pgfId-538810]Delete button

  
         		[bookmark: pgfId-538812]Deletes the selected command authorization definitions from the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-544271][bookmark: 139942][bookmark: rtpage_cncpt_CommandAuthorizationOverrideDialogBox]Command Authorization Override Dialog Box[bookmark: marker-544267][bookmark: marker-544269]

 
     [bookmark: pgfId-544273]Use the Command Authorization Override dialog box to define which methods to use when authorizing the EXEC commands that are associated with a given privilege. This enables you to authorize all commands associated with a specific privilege level, from 0 to 15.

 
     [bookmark: pgfId-544275]Navigation Path

 
     [bookmark: pgfId-544280]From the HTTP Page—AAA Tab, click the Add button beneath the Command Authorization Override table.

 
     [bookmark: pgfId-544282]Related Topics

 
      
      		 [bookmark: pgfId-544287]HTTP Policy Page

 
      		 [bookmark: pgfId-544292]AAA Policy Page

 
     

 
     [bookmark: pgfId-544294]Field Reference

 
     [bookmark: pgfId-544297] 

 
      
       
        
        [bookmark: pgfId-538825]Table 62-15 [bookmark: 139971]Command Authorization Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-538831]Element
          
  
         		
           
           [bookmark: pgfId-538833]Description
          
  
        

 
         
         		[bookmark: pgfId-538839]Privilege Level

  
         		[bookmark: pgfId-538841]The privilege level for which you want to define a command accounting list. Valid values range from 0 to 15.

  
        

 
         
         		[bookmark: pgfId-538847]Prioritized Method List

  
         		[bookmark: pgfId-538849]Defines a sequential list of methods to be used when authorizing a user. Enter the names of one or more AAA server group objects (up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-538851]The device tries initially to authorize users using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-538853]Supported methods include TACACS+, Local, and None.

 [bookmark: pgfId-538855]Note If you select None as a method, it must appear as the last method in the list.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-544309][bookmark: 139999][bookmark: rtchap_cncpt_LineAccessonCiscoIOSRouters]Line Access on Cisco IOS Routers[bookmark: marker-544303][bookmark: marker-544305][bookmark: marker-544307]

 
    [bookmark: pgfId-544311]Security Manager enables you to configure command line access (also called EXEC access) to a router using the following methods:

 
     
     		 [bookmark: pgfId-544313]Console port—Physical connection via a standard RS232 cable for local access. For more information, see:

 
    

 
    [bookmark: pgfId-544318] – Defining Console Port Setup Parameters

 
    [bookmark: pgfId-544323] – Defining Console Port AAA Settings

 
     
     		 [bookmark: pgfId-544325]VTY lines—Virtual terminal lines for remote access, typically using protocols such as Telnet, SSH, or rlogin. For more information, see:

 
    

 
    [bookmark: pgfId-544330] – Defining VTY Line Setup Parameters

 
    [bookmark: pgfId-544335] – Defining VTY Line AAA Settings

 
    [bookmark: pgfId-544337]After you configure and deploy these policies, you can use these lines to communicate with individual devices directly when you want to configure or diagnose them using the CLI.

 
     
      [bookmark: pgfId-544345][bookmark: 140033][bookmark: rtchap_proc_DefiningConsolePortSetupParameters]Defining Console Port Setup Parameters[bookmark: marker-544343]

 
     [bookmark: pgfId-544347]The console port on a router is generally used for local system access by an administrator with physical access to the device. By default, the console port is set up as follows:

 
      
      		 [bookmark: pgfId-544349]All permitted users have privileged access to the router, including all configuration commands (privilege level 15).

 
      		 [bookmark: pgfId-544351]The line is disconnected after 10 minutes without user input.

 
      		 [bookmark: pgfId-544353]Incoming connections are not permitted.

 
      		 [bookmark: pgfId-544355]Outgoing connections support Telnet only.

 
     

 
     [bookmark: pgfId-544357]In addition to modifying any of the default settings, you can optionally define the following settings:

 
      
      		 [bookmark: pgfId-544359]The password for accessing the console.

 
      		 [bookmark: pgfId-544361]Whether to disable all EXEC sessions on the console.

 
      		 [bookmark: pgfId-544363]Incoming and outgoing ACLs that restrict the connections that are permitted on the console.

 
      		 [bookmark: pgfId-544365]Whether VRF connections are permitted on the console.

 
     

 
     [bookmark: pgfId-544367]Related Topics

 
      
      		 [bookmark: pgfId-544372]Line Access on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-544374]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-544376](Device view) Select  Platform > Device Admin > Device Access > Line Access > Console from the Policy selector, then click the  Setup tab in the work area.

 
      		 [bookmark: pgfId-544378](Policy view) Select  Router Platform > Device Admin > Device Access > Line Access > Console from the Policy Type selector. Select an existing policy or create a new one, and then click the  Setup tab.

 
     

 
     [bookmark: pgfId-544383]The Console Setup tab is displayed. See Table 62-16 for a description of the fields on this tab.

 
     [bookmark: pgfId-544385]Step 2 (Optional) Enter the password for accessing the console port, then enter it again in the Confirm field.

 
     [bookmark: pgfId-544390]Step 3 (Optional) Modify the default (15) granted to users of the console port. See Console Page—Authorization Tab.

 
     [bookmark: pgfId-544392]Step 4 (Optional) Select the Disable all the EXEC sessions to the router via this line check box to prevent any incoming connections via the console.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544394]Note Selecting this option blocks all access to the device via the console port.


     
      

     

     

 
     [bookmark: pgfId-544396]Step 5 (Optional) Modify the default timeout after which the line is disconnected if no user input is detected.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544398]Note Setting this value to 0 disables the timeout. Disabling the timeout could compromise the security of your network.


     
      

     

     

 
     [bookmark: pgfId-544400]Step 6 (Optional) Specify which protocols can be used for outbound connections on the console port:

 
      
      		 [bookmark: pgfId-544402]All—All supported protocols are permitted.

 
      		 [bookmark: pgfId-544404]None—No protocols are permitted.

 
      		 [bookmark: pgfId-544406]Protocol—Enables one or more of the following protocols: SSH, Telnet, and rlogin.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544411]Note You must configure AAA authentication on devices where the console port permits the SSH and rlogin protocols. See Defining Console Port AAA Settings.


     
      

     

     

 
     [bookmark: pgfId-544413]Step 7 (Optional) Enter the names of ACLs that restrict incoming and outgoing connections between the device and the addresses in these lists, or click Select to select the ACL object or to create a new one. At the top of the selector, in the Type field, select the ACL type as either Standard or Extended.

 
     [bookmark: pgfId-544418]Step 8 (Optional) Click the AAA tab to define authentication, authorization, and accounting settings for the console port. See Defining Console Port AAA Settings.

 
     [bookmark: pgfId-544420]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-544428][bookmark: 140112][bookmark: rtchap_proc_DefiningConsolePortAAASettings]Defining Console Port AAA Settings[bookmark: marker-544426]

 
     [bookmark: pgfId-544430]By default, authentication, authorization, and accounting are not performed on the console port. When you configure one or more of these access control options, you can either make use of the default method lists defined in the device’s AAA policy or define a custom method list containing one or more AAA methods.

 
     [bookmark: pgfId-544432]Related Topics

 
      
      		 [bookmark: pgfId-544437]Defining Console Port Setup Parameters

 
      		 [bookmark: pgfId-544442]Line Access on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-544444]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-544446](Device view) Select  Platform > Device Admin > Device Access > Line Access > Console from the Policy selector, then click the  Authentication tab in the work area.

 
      		 [bookmark: pgfId-544448](Policy view) Select  Router Platform > Device Admin > Device Access > Line Access > Console from the Policy Type selector. Select an existing policy or create a new one, and then click the  Authentication tab.

 
     

 
     [bookmark: pgfId-544450]The Console Authentication tab is displayed.

 
     [bookmark: pgfId-544452]Step 2 (Optional) Select the authentication method to perform on users who attempt to access the console line.

 
     [bookmark: pgfId-544457]See Table 62-17 for a description of the fields on the Authentication tab.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544459]Note If you select local authentication, preview the full configuration before deployment to make sure that the aaa new-model command is not configured by another policy (for example, by configuring a method list in the AAA policy) or is already configured on the device itself.


     
      

     

     

 
     [bookmark: pgfId-544461]Step 3 (Optional) On the Authorization tab, select the authorization method to perform on users who access the console line and begin an EXEC session.

 
     [bookmark: pgfId-544466]See Table 62-18 for a description of the fields on the Authorization tab.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544468]Note RADIUS uses the same server for authentication and authorization. Therefore, if you use define a RADIUS method list for authentication, you must define the same method list for authorization.


     
      

     

     

 
     [bookmark: pgfId-544470]Step 4 (Optional) Create command authorization definitions for specific privilege levels:

 
     [bookmark: pgfId-544477] a. [bookmark: 140153]Click the Add button under the Commands Authorization table. The Command Authorization dialog box is displayed. See Table 62-26 for details.

 
     [bookmark: pgfId-544479] b. Configure the command authorization definition as required.

 
     [bookmark: pgfId-544483] c. [bookmark: 140159]Click OK. The dialog box closes and the authorization method is displayed in the Commands Authorization table.

 
     [bookmark: pgfId-544491] d. Repeat a. through c. to create additional command authorization definitions.

 
     [bookmark: pgfId-544493]Step 5 (Optional) On the Accounting tab, select the EXEC and connection accounting methods to perform on users who access the console line.

 
     [bookmark: pgfId-544498]See Table 62-19 for a description of the fields on this tab.

 
     [bookmark: pgfId-544500]Step 6 (Optional) Create command accounting definitions for specific privilege levels:

 
     [bookmark: pgfId-544507] a. [bookmark: 140173]Click the Add button under the Commands Accounting table. The Command Accounting Dialog Box—Line Access is displayed.

 
     [bookmark: pgfId-544509] b. Configure the command accounting definition as required.

 
     [bookmark: pgfId-544513] c. [bookmark: 140179]Click OK. The dialog box closes and the accounting method is displayed in the Commands Accounting table.

 
     [bookmark: pgfId-544521] d. Repeat a. through c. to create additional command accounting definitions.

 
     [bookmark: pgfId-544523]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-544531][bookmark: 140191][bookmark: rtchap_proc_DefiningVTYLineSetupParameters]Defining VTY Line Setup Parameters[bookmark: marker-544529]

 
     [bookmark: pgfId-544533]All Cisco IOS routers are configured by default with five VTY lines (labeled 0-4) that have the following settings:

 
      
      		 [bookmark: pgfId-544535]All permitted users have privileged access to the router, including all configuration commands (privilege level 15).

 
      		 [bookmark: pgfId-544537]VTY lines are disconnected after 10 minutes without user input.

 
      		 [bookmark: pgfId-544539]Incoming connections are not permitted.

 
      		 [bookmark: pgfId-544541]Outgoing connections support Telnet only.

 
     

 
     [bookmark: pgfId-544543]You can use Security Manager to modify the default settings on these five VTY lines or to configure additional lines (up to a maximum of 16). In addition, you can optionally configure the following settings on each line:

 
      
      		 [bookmark: pgfId-544545]The password for accessing the line.

 
      		 [bookmark: pgfId-544547]Whether to disable all EXEC sessions on the line.

 
      		 [bookmark: pgfId-544549]Incoming and outgoing ACLs that restrict the connections that are permitted on the line.

 
      		 [bookmark: pgfId-544551]Whether VRF connections are permitted on the line.

 
     

 
     [bookmark: pgfId-544555][bookmark: marker-544553]Defining Groups of VTY Lines

 
     [bookmark: pgfId-544557]You can configure multiple VTY lines as a contiguous group, which enables you to define identical settings for all the lines in the group with one procedure. All the lines within the group must fall within one of two ranges, 0-4 or 6-15. The group cannot overlap these two ranges.

 
     [bookmark: pgfId-544559]The rules for configuring VTY line 5 are as follows. Line 5 can be part of the same definition as lines 0-4 only when there are no lines configured above line 5. If there are lines configured above line 5, you cannot include line 5 in the definition for lines 0-4, even if their configurations are the same. Line 5 can be included in the definition of the lines above line 5 if their configurations are the same.

 
     [bookmark: pgfId-544561]For example, if lines 0-5 all share one configuration and lines 6-9 have a different configuration, you need to create three definitions—one definition for lines 0-4, a second definition for line 5, and a third definition for lines 6-9.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544563]Note When you configure VTY lines, bear in mind that users are assigned a line at random when they connect to the device.
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     [bookmark: pgfId-544565]Note You can create only one definition per VTY line. An error is displayed if you create a VTY line definition that overlaps an existing definition.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544567]Note If you use Security Manager to configure the default VTY lines (0-4), your definition overrides the default settings on the device. If you later delete this definition from Security Manager, the input protocol settings are retained and the other default settings are restored. This ensures that you always have VTY lines available for remote access to the device.
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     [bookmark: pgfId-544569]Note You can use the CLI or FlexConfigs to configure additional VTY lines on devices that support more than 16 lines.


     
      

     

     

 
     [bookmark: pgfId-544571]Related Topics

 
      
      		 [bookmark: pgfId-544576]Line Access on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-544578]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-544580](Device view) Select  Platform > Device Admin > Device Access > Line Access > VTY from the Policy selector.

 
      		 [bookmark: pgfId-544582](Policy view) Select  Router Platform > Device Admin > Device Access > Line Access > VTY from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-544587]The VTY page is displayed. See Table 62-20 for a description of the fields on this page.

 
     [bookmark: pgfId-544592]Step 2 Click the Add button beneath the Lines table, or select a line definition and then click the Edit button. The Setup tab of the VTY Lines dialog box is displayed. See Table 62-21 for a description of the fields on this tab.

 
     [bookmark: pgfId-544594]Step 3 Enter the relative line number of the VTY line. If you are configuring a group of VTY lines, enter the first and last numbers of the group in the fields provided.

 
     [bookmark: pgfId-544596]Step 4 (Optional) Enter the password for accessing the console line, then enter it again in the Confirm field.

 
     [bookmark: pgfId-544598]Step 5 (Optional) Modify the default Privilege (15) granted to users of this VTY line (or group of lines).

 
     [bookmark: pgfId-544600]Step 6 (Optional) Select the Disable all the EXEC sessions to the router via this line check box to prevent any incoming connections over this VTY line (or group of lines).

 
     [bookmark: pgfId-544602]Step 7 (Optional) Modify the default timeout after which the line is disconnected if no user input is detected.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544604]Note Setting this value to 0 to disables the timeout. Disabling the timeout could cause abandoned sessions to block available VTY lines. It can also compromise the security of your network.


     
      

     

     

 
     [bookmark: pgfId-544606]Step 8 (Optional) Specify which protocols can be used for inbound and outbound connections on this VTY line (or group of lines):

 
      
      		 [bookmark: pgfId-544608]All—All supported protocols are permitted.

 
      		 [bookmark: pgfId-544610]None—No protocols are permitted.

 
      		 [bookmark: pgfId-544612]Protocol—Enables one or more of the following protocols: SSH, Telnet, and rlogin.
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      [bookmark: pgfId-544614]
      Caution Setting the inbound connections setting to None might prevent Security Manager from connecting to the device after deployment.
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     [bookmark: pgfId-544619]Note You must configure AAA authentication when the VTY line permits the SSH and rlogin protocols. See Defining VTY Line AAA Settings.


     
      

     

     

 
     [bookmark: pgfId-544621]Step 9 (Optional) Enter the names of ACLs that restrict incoming and outgoing connections between the device and the addresses in these lists, or click Select to select an ACL object from a list or to create a new one. You can choose from standard or extended ACLs.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544623]Tip Defining an inbound ACL is a good way to reserve a VTY line for administrative access only.


     
      

     

     

 
     [bookmark: pgfId-544628]Step 10 (Optional) Click the AAA tab to define authentication, authorization, and accounting settings for this VTY line (or group of lines). See Defining VTY Line AAA Settings.

 
     [bookmark: pgfId-544630]Step 11 Click OK to save your definitions locally on the client and close the dialog box. Your definitions are displayed in the Lines table.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544632]Note To remove a VTY line definition, select it, then click Delete. If you delete a VTY line from an IOS device, any subsequent lines are also deleted. For example, if the device contains lines 0-9 and you delete line 5, lines 6-9 are deleted as well. If you delete the definition for lines 0-4 from Security Manager, the router retains the inbound protocol definition and restores the other default settings for these lines on the device. This ensures that five VTY lines are always available.


     
      

     

     

 
     [bookmark: pgfId-544634]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-544642][bookmark: 140294][bookmark: rtchap_proc_DefiningVTYLineAAASettings]Defining VTY Line AAA Settings[bookmark: marker-544640]

 
     [bookmark: pgfId-544644]By default, authentication, authorization, and accounting are not performed on VTY lines. When you configure one or more of these access control options, you can either make use of the default method lists defined in the device’s AAA policy or define a custom method list containing one or more AAA methods.

 
     [bookmark: pgfId-544646]Before You Begin

 
      
      		 [bookmark: pgfId-544651]Define the basic parameters of the VTY line or group of VTY lines. See Defining VTY Line Setup Parameters.

 
     

 
     [bookmark: pgfId-544653]Related Topics

 
      
      		 [bookmark: pgfId-544658]Defining VTY Line Setup Parameters

 
      		 [bookmark: pgfId-544663]Line Access on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-544665]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-544667](Device view) Select  Platform > Device Admin > Device Access > Line Access > VTY from the Policy selector.

 
      		 [bookmark: pgfId-544669](Policy view) Select  Router Platform > Device Admin > Device Access > Line Access > VTY from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-544674]The VTY page is displayed. See Table 62-20 for a description of the fields on this page.

 
     [bookmark: pgfId-544676]Step 2 Select a VTY line definition in the Lines tables, click the Edit button to display the VTY Line dialog box, then click the Authentication tab.

 
     [bookmark: pgfId-544678]Step 3 (Optional) Select the authentication method to perform on users who attempt to access the VTY line.

 
     [bookmark: pgfId-544683]See Table 62-23 for a description of the fields on this tab.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544685]Note If you select local authentication, preview the full configuration before deployment to make sure that the aaa new-model command is not configured by another policy (for example, by configuring a method list in the AAA policy) or is already configured on the device itself.


     
      

     

     

 
     [bookmark: pgfId-544687]Step 4 (Optional) On the Authorization tab, select the authorization method to perform on users who access the VTY line and begin an EXEC session.

 
     [bookmark: pgfId-544692]See Table 62-24 for a description of the fields on the Authorization tab.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544694]Note RADIUS uses the same server for authentication and authorization. Therefore, if you use define a RADIUS method list for authentication, you must define the same method list for authorization.


     
      

     

     

 
     [bookmark: pgfId-544696]Step 5 (Optional) Create command authorization definitions for specific privilege levels:

 
     [bookmark: pgfId-544703] a. [bookmark: 140344]Click the Add button under the Commands Authorization table. The Command Authorization Dialog Box—Line Access is displayed.

 
     [bookmark: pgfId-544705] b. Configure the command authorization definition as required.

 
     [bookmark: pgfId-544709] c. [bookmark: 140350]Click OK. The dialog box closes and the authorization method is displayed in the Commands Authorization table.

 
     [bookmark: pgfId-544717] d. Repeat a. through c. to create additional command authorization definitions.

 
     [bookmark: pgfId-544719]Step 6 (Optional) On the Accounting tab, select the EXEC and connection accounting methods to perform on users who attempt to access the VTY line.

 
     [bookmark: pgfId-544724]See Table 62-25 for a description of the fields on the Accounting tab.

 
     [bookmark: pgfId-544726]Step 7 (Optional) Create command accounting definitions for specific privilege levels:

 
     [bookmark: pgfId-544733] a. [bookmark: 140364]Click the Add button under the Commands Accounting table. The Command Accounting Dialog Box—Line Access is displayed.

 
     [bookmark: pgfId-544735] b. Configure the command accounting definition as required.

 
     [bookmark: pgfId-544739] c. [bookmark: 140370]Click OK. The dialog box closes and the accounting method is displayed in the Commands Accounting table.

 
     [bookmark: pgfId-544747] d. Repeat a. through c. to create additional command accounting definitions.

 
     [bookmark: pgfId-544749]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-544761][bookmark: 140383][bookmark: rtpage_cncpt_ConsolePolicyPage]Console Policy Page[bookmark: marker-544755][bookmark: marker-544757][bookmark: marker-544759]

 
    [bookmark: pgfId-544763]Use the Console page to configure access to the router over the console port. You can configure console policies on a Cisco IOS router from the following tabs on the Console policy page:

 
     
     		 [bookmark: pgfId-544768]Console Page—Setup Tab

 
     		 [bookmark: pgfId-544773]Console Page—Authentication Tab

 
     		 [bookmark: pgfId-544778]Console Page—Authorization Tab

 
     		 [bookmark: pgfId-544783]Console Page—Accounting Tab

 
    

 
    [bookmark: pgfId-544788]For more information, see Line Access on Cisco IOS Routers.

 
    [bookmark: pgfId-544790]Navigation Path

 
     
     		 [bookmark: pgfId-544792](Device view) Select  Platform > Device Admin > Device Access > Line Access > Console from the Policy selector.

 
     		 [bookmark: pgfId-544794](Policy view) Select  Router Platform > Device Admin > Device Access > Line Access > Console from the Policy Type selector. Right-click  Console to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-544796]Related Topics

 
     
     		 [bookmark: pgfId-544801]VTY Policy Page

 
    

 
     
      [bookmark: pgfId-544813][bookmark: 140429][bookmark: rtpage_cncpt_ConsolePageSetupTab]Console Page—Setup Tab[bookmark: marker-544809][bookmark: marker-544811]

 
     [bookmark: pgfId-544815]Use the Setup tab of the Console page to define the basic parameters of the console port. This includes the password for accessing the port, the privilege level assigned to users, the protocols that are permitted, and the ACLs that limit access.

 
     [bookmark: pgfId-544817]Navigation Path

 
     [bookmark: pgfId-544822]Go to the Console Policy Page, then click the Setup tab.

 
     [bookmark: pgfId-544824]Related Topics

 
      
      		 [bookmark: pgfId-544829]Console Page—Authentication Tab

 
      		 [bookmark: pgfId-544834]Console Page—Authorization Tab

 
      		 [bookmark: pgfId-544839]Console Page—Accounting Tab

 
      		 [bookmark: pgfId-544844]VTY Line Dialog Box—Setup Tab

 
     

 
     [bookmark: pgfId-544846]Field Reference

 
     [bookmark: pgfId-544849] 

 
      
       
        
        [bookmark: pgfId-538868]Table 62-16 [bookmark: 140464]Console Page—Setup Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-538874]Element
          
  
         		
           
           [bookmark: pgfId-538876]Description
          
  
        

 
         
         		[bookmark: pgfId-538882]Password

  
         		[bookmark: pgfId-538884]The password for accessing the console port.

 [bookmark: pgfId-538886]The password is case sensitive and can contain up to 80 alphanumeric characters. The first character cannot be a number. Spaces are not allowed.

 [bookmark: pgfId-538888]Enter the password again in the Confirm field.

  
        

 
         
         		[bookmark: pgfId-538894]Privilege Level

  
         		[bookmark: pgfId-538896]The privilege level assigned to users connected to the console port. Valid values range from 0 to 15:

 
           
           		 [bookmark: pgfId-538898]0—Grants access to these commands only:  disable ,  enable ,  exit ,  help , and  logout .

 
           		 [bookmark: pgfId-538900]1—Enables nonprivileged access to the router (normal EXEC-mode use privileges).

 
           		 [bookmark: pgfId-538902]15—Enables privileged access to the router (traditional enable privileges).

 
          

 [bookmark: pgfId-538904]Note Levels 2-14 are not normally used in a default configuration, but custom configurations can be created by moving commands that are normally at level 15 to a lower level and commands that are normally at level 1 to a higher level. You can configure the privilege levels of commands using the CLI or by defining a FlexConfig.

 [bookmark: pgfId-538906]Note If you do not define a value, level 1 is assigned by default. This value does not appear in the device configuration.

  
        

 
         
         		[bookmark: pgfId-538912]Disable all the EXEC sessions to the router via this line

  
         		[bookmark: pgfId-538914]When selected, disables EXEC sessions over this line. Select this option when you want to allow only an outgoing connection on the console. This option is useful for keeping the console port free from unsolicited incoming data that can tie up the line.

 [bookmark: pgfId-538916]When deselected, EXEC sessions are enabled on the console port. This is the default.

 [bookmark: pgfId-538918]Note Selecting this option blocks all access to the device via the console port.

  
        

 
         
         		[bookmark: pgfId-538924]Exec Timeout

  
         		[bookmark: pgfId-538926]The amount of time (in seconds) that the EXEC command interpreter waits to detect user input on the console port. If no input is detected, the line is disconnected. Valid values range from 0 to 2147483. The default is 600 (10 minutes). Setting the value to 0 disables the timeout.

 [bookmark: pgfId-538928]Note Although the timeout is defined in seconds, it appears in the CLI in the format [mm ss].

  
        

 
         
         		[bookmark: pgfId-538934]Output Protocols

  
         		[bookmark: pgfId-538936]The protocols that you can use for outgoing connections on the console port:

 
           
           		 [bookmark: pgfId-538938]All—All supported protocols are permitted. Supported protocols include LAT, MOP, NASI, PAD, rlogin, SSH, Telnet, and V.120.

 
           		 [bookmark: pgfId-538940]None—No protocols are permitted. This makes the port unusable by outgoing connections.

 
           		 [bookmark: pgfId-538942]Protocol—Enables one or more of the following protocols:

 
          

 [bookmark: pgfId-538944] – SSH—Secure Shell protocol.

 [bookmark: pgfId-538946] – Telnet—Standard TCP/IP terminal emulation protocol.

 [bookmark: pgfId-538948] – rlogin—UNIX rlogin protocol.

 [bookmark: pgfId-538953]Note SSH and rlogin require that you configure AAA authentication. See Console Page—Authentication Tab.

 [bookmark: pgfId-538955]Note Not all IOS Software Versions support rlogin as an output protocol.

  
        

 
         
         		[bookmark: pgfId-538961]Inbound Access List

  
         		[bookmark: pgfId-538963]The name of the ACL object that restricts incoming connections on the console port. Enter the name of the ACL object, or click Select to select it. If the object that you want is not listed, click the Create button to create it.

  
        

 
         
         		[bookmark: pgfId-538969]Permit VRF Interface Connections

  
         		[bookmark: pgfId-538971]Applies only when an inbound ACL is defined on the console port.

 [bookmark: pgfId-538973]When selected, accepts incoming connections from interfaces that belong to a VRF. When deselected, rejects incoming connections from interfaces that belong to a VRF.

  
        

 
         
         		[bookmark: pgfId-538979]Outbound Access List

  
         		[bookmark: pgfId-538981]The name of the ACL object that restricts outgoing connections on the console port. Enter the name of an ACL object, or click Select to select it. If the object that you want is not listed, click the Create button to create it.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-544865][bookmark: 140556][bookmark: rtpage_cncpt_ConsolePageAuthenticationTab]Console Page—Authentication Tab[bookmark: marker-544857][bookmark: marker-544859][bookmark: marker-544861][bookmark: marker-544863]

 
     [bookmark: pgfId-544867]Use the Authentication tab of the Console page to define the AAA authentication methods to perform on users who attempt to access the console port.

 
     [bookmark: pgfId-544869]Navigation Path

 
     [bookmark: pgfId-544874]Go to the Console Policy Page, then click the Authentication tab.

 
     [bookmark: pgfId-544876]Related Topics

 
      
      		 [bookmark: pgfId-544881]Console Page—Setup Tab

 
      		 [bookmark: pgfId-544886]Console Page—Authorization Tab

 
      		 [bookmark: pgfId-544891]Console Page—Accounting Tab

 
      		 [bookmark: pgfId-544896]VTY Line Dialog Box—Authentication Tab

 
     

 
     [bookmark: pgfId-544898]Field Reference

 
     [bookmark: pgfId-544901] 

 
      
       
        
        [bookmark: pgfId-538994]Table 62-17 [bookmark: 140599]Console Page—Authentication Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-539000]Element
          
  
         		
           
           [bookmark: pgfId-539002]Description
          
  
        

 
         
         		[bookmark: pgfId-539008]Authenticate Using

  
         		[bookmark: pgfId-539010]Authentication settings for the console port:

 
           
           		 [bookmark: pgfId-539012]None—Authentication is not performed. This is the default.

 
           		 [bookmark: pgfId-539014]Local Database—Uses the local username database for authentication.

 
           		 [bookmark: pgfId-539019]AAA Policy Default List—Uses the default authentication method list that is defined in the device’s AAA policy. See AAA Page—Authentication Tab.

 
           		 [bookmark: pgfId-539021]Custom Method List—Uses the authentication methods specified in the Authentication Method List field.

 
          

 command is not configured by another policy (for example, by configuring a method list in the AAA policy) or is already configured on the device itself.

  
        

 
         
         		[bookmark: pgfId-539029]Prioritized Method List

  
         		[bookmark: pgfId-539031]Applies only when Custom Method List is selected as the authentication method.

 [bookmark: pgfId-539033]Defines a sequential list of methods to be queried when authenticating a user. Enter the names of one or more AAA server group objects (up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-539035]The device tries initially to authenticate users using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-539037]Note If you select None as a method, it must appear as the last method in the list.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-544913][bookmark: 140637][bookmark: rtpage_cncpt_ConsolePageAuthorizationTab]Console Page—Authorization Tab[bookmark: marker-544909][bookmark: marker-544911]

 
     [bookmark: pgfId-544915]Use the Authorization tab of the Console page to define the EXEC and command authorization methods to perform on users who access the console port.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544920]Note You must enable AAA services on the router to use this feature; otherwise, deployment will fail. See Defining AAA Services.


     
      

     

     

 
     [bookmark: pgfId-544922]Navigation Path

 
     [bookmark: pgfId-544927]Go to the Console Policy Page, then click the Authorization tab.

 
     [bookmark: pgfId-544929]Related Topics

 
      
      		 [bookmark: pgfId-544934]Console Page—Setup Tab

 
      		 [bookmark: pgfId-544939]Console Page—Authentication Tab

 
      		 [bookmark: pgfId-544944]Console Page—Accounting Tab

 
      		 [bookmark: pgfId-544949]VTY Line Dialog Box—Authorization Tab

 
      		 [bookmark: pgfId-544954]Filtering Tables

 
     

 
     [bookmark: pgfId-544956]Field Reference

 
     [bookmark: pgfId-544959] 

 
      
       
        
        [bookmark: pgfId-539050]Table 62-18 [bookmark: 140677]Console Page—Authorization Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-539056]Element
          
  
         		
           
           [bookmark: pgfId-539058]Description
          
  
        

 
         
         		 [bookmark: pgfId-539064]EXEC Authorization settings

  
        

 
         
         		[bookmark: pgfId-539072]Authorize EXEC Operations Using

  
         		[bookmark: pgfId-539074]The authorization method that determines whether a user is allowed to run an EXEC session:

 
           
           		 [bookmark: pgfId-539076]None—Authorization is not performed. This is the default.

 
           		 [bookmark: pgfId-539081]AAA Policy Default List—Uses the default authorization method list that is defined in the device’s AAA policy. See AAA Page—Authorization Tab.

 
           		 [bookmark: pgfId-539083]Custom Method List—Uses the authorization methods specified in the EXEC Method List field.

 
          

  
        

 
         
         		[bookmark: pgfId-539089]Prioritized Method List

  
         		[bookmark: pgfId-539091]Applies only when Custom Method List is selected as the EXEC method.

 [bookmark: pgfId-539093]Defines a sequential list of methods to be queried when authorizing a user. Enter the names of one or more AAA server group objects (up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-539095]The device tries initially to authorize users using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-539097]Note If you select None as a method, it must appear as the last method in the list.

 [bookmark: pgfId-539099]Note RADIUS uses the same server for authentication and authorization. Therefore, if you use define a RADIUS method list for authentication, you must define the same method list for authorization.

  
        

 
         
         		 [bookmark: pgfId-539105]Command Authorization settings

  
        

 
         
         		[bookmark: pgfId-539113]Privilege Level

  
         		[bookmark: pgfId-539115]The privilege level to which the command authorization definition applies.

  
        

 
         
         		[bookmark: pgfId-539121]Prioritized Method List

  
         		[bookmark: pgfId-539123]The method list to use when authorizing users with this privilege level.

  
        

 
         
         		[bookmark: pgfId-539129]Add button

  
         		[bookmark: pgfId-539134]Opens the Command Authorization Dialog Box—Line Access. From here you can configure a command authorization definition.

  
        

 
         
         		[bookmark: pgfId-539140]Edit button

  
         		[bookmark: pgfId-539145]Opens the Command Authorization Dialog Box—Line Access. From here you can edit the command authorization definition.

  
        

 
         
         		[bookmark: pgfId-539151]Delete button

  
         		[bookmark: pgfId-539153]Deletes the selected command authorization definitions from the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-544971][bookmark: 140747][bookmark: rtpage_cncpt_ConsolePageAccountingTab]Console Page—Accounting Tab[bookmark: marker-544967][bookmark: marker-544969]

 
     [bookmark: pgfId-544973]Use the Accounting tab of the Console page to define the EXEC, connection, and command accounting methods to perform on users who access the console port.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-544978]Note You must enable AAA services on the router to use this feature; otherwise, deployment will fail. See Defining AAA Services.


     
      

     

     

 
     [bookmark: pgfId-544980]Navigation Path

 
     [bookmark: pgfId-544985]Go to the Console Policy Page, then click the Accounting tab.

 
     [bookmark: pgfId-544987]Related Topics

 
      
      		 [bookmark: pgfId-544992]Console Page—Setup Tab

 
      		 [bookmark: pgfId-544997]Console Page—Authentication Tab

 
      		 [bookmark: pgfId-545002]Console Page—Authorization Tab

 
      		 [bookmark: pgfId-545007]VTY Line Dialog Box—Accounting Tab

 
      		 [bookmark: pgfId-545012]Filtering Tables

 
     

 
     [bookmark: pgfId-545014]Field Reference

 
     [bookmark: pgfId-545017] 

 
      
       
        
        [bookmark: pgfId-539166]Table 62-19 [bookmark: 140787]Console Page—Accounting Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-539172]Element
          
  
         		
           
           [bookmark: pgfId-539174]Description
          
  
        

 
         
         		 [bookmark: pgfId-539180]EXEC Accounting settings

  
        

 
         
         		[bookmark: pgfId-539188]Perform EXEC Accounting Using

  
         		[bookmark: pgfId-539190]The accounting method to use for recording basic information about user EXEC sessions:

 
           
           		 [bookmark: pgfId-539192]None—Accounting is not performed. This is the default.

 
           		 [bookmark: pgfId-539197]AAA Policy Default List—Uses the default EXEC accounting method list that is defined in the device’s AAA policy. See AAA Page—Accounting Tab.

 
           		 [bookmark: pgfId-539199]Custom Method List—Uses the accounting methods specified in the EXEC Method List field.

 
          

 [bookmark: pgfId-539201]EXEC accounting records basic details about EXEC sessions, such as the username, date, start and stop times, and the access server IP address.

  
        

 
         
         		[bookmark: pgfId-539207]Generate Accounting Records for

  
         		[bookmark: pgfId-539209]Applies only when Custom Method List is selected as the EXEC method.

 [bookmark: pgfId-539211]Defines when the device sends an accounting notice to the accounting server:

 
           
           		 [bookmark: pgfId-539213]Start and Stop—Generates accounting records at the beginning and the end of the user process. The user process begins regardless of whether the accounting server receives the “start” accounting record. This is the default.

 
           		 [bookmark: pgfId-539215]Stop Only—Generates an accounting record at the end of the user process only.

 
           		 [bookmark: pgfId-539217]None—No accounting records are generated.

 
          

  
        

 
         
         		[bookmark: pgfId-539223]Prioritized Method List

  
         		[bookmark: pgfId-539225]Applies only when Custom Method List is selected as the EXEC method.

 [bookmark: pgfId-539227]Defines a sequential list of methods to be queried when creating accounting methods for a user. Enter the names of one or more AAA server group objects (up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-539229]The device tries initially to perform accounting using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-539231]Note If you select None as a method, it must appear as the last method in the list.

  
        

 
         
         		[bookmark: pgfId-539237]Enable Broadcast to Multiple Servers

  
         		[bookmark: pgfId-539239]Applies only when Method List is selected as the EXEC method.

 [bookmark: pgfId-539241]When selected, enables the sending of accounting records to multiple AAA servers. Accounting records are sent simultaneously to the first server in each AAA server group defined in the method list. If the first server is unavailable, failover occurs using the backup servers defined within that group.

 [bookmark: pgfId-539243]When deselected, accounting records are sent only to the first server in the first AAA server group defined in the method list.

  
        

 
         
         		 [bookmark: pgfId-539249]Connection Accounting settings

  
        

 
         
         		[bookmark: pgfId-539257]Perform Connection Accounting Using

  
         		[bookmark: pgfId-539259]The accounting method to use for recording information about outbound connections made over the console line:

 
           
           		 [bookmark: pgfId-539261]None—Accounting is not performed. This is the default.

 
           		 [bookmark: pgfId-539266]AAA Policy Default List—Uses the default connection accounting method list that is defined in the device’s AAA policy. See AAA Page—Accounting Tab.

 
           		 [bookmark: pgfId-539268]Custom Method List—Uses the accounting methods specified in the Connection Method List field.

 
          

 [bookmark: pgfId-539270]Connection accounting records details about outgoing connections over the line, such as Telnet and rlogin connections.

  
        

 
         
         		[bookmark: pgfId-539276]Generate Accounting Records for

  
         		[bookmark: pgfId-539278]Applies only when Custom Method List is selected as the connection method.

 [bookmark: pgfId-539280]Defines when the device sends an accounting notice to the accounting server:

 
           
           		 [bookmark: pgfId-539282]Start and Stop—Generates accounting records at the beginning and the end of the user process. The user process begins regardless of whether the accounting server receives the “start” accounting record. This is the default.

 
           		 [bookmark: pgfId-539284]Stop Only—Generates an accounting record at the end of the user process only.

 
           		 [bookmark: pgfId-539286]None—No accounting records are generated.

 
          

  
        

 
         
         		[bookmark: pgfId-539292]Prioritized Method List

  
         		[bookmark: pgfId-539294]Applies only when Custom Method List is selected as the connection method.

 [bookmark: pgfId-539296]Defines a sequential list of methods to be queried when creating accounting methods for a user. Enter the names of one or more AAA server group objects (up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-539298]The device tries initially to perform accounting using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-539300]Note If you select None as a method, it must appear as the last method in the list.

  
        

 
         
         		[bookmark: pgfId-539306]Enable Broadcast to Multiple Servers

  
         		[bookmark: pgfId-539308]Applies only when Custom Method List is selected as the connection method.

 [bookmark: pgfId-539310]When selected, enables the sending of accounting records to multiple AAA servers. Accounting records are sent simultaneously to the first server in each AAA server group defined in the method list. If the first server is unavailable, failover occurs using the backup servers defined within that group.

 [bookmark: pgfId-539312]When deselected, accounting records are sent only to the first server in the first AAA server group defined in the method list.

  
        

 
         
         		 [bookmark: pgfId-539318]Command Accounting settings

  
        

 
         
         		[bookmark: pgfId-539326]Privilege Level

  
         		[bookmark: pgfId-539328]The privilege level to which the command authorization definition applies.

  
        

 
         
         		[bookmark: pgfId-539334]Generate Accounting Records for

  
         		[bookmark: pgfId-539336]The points in the process where the device sends an accounting notice to the accounting server.

  
        

 
         
         		[bookmark: pgfId-539342]Enable Broadcast

  
         		[bookmark: pgfId-539344]Whether accounting records are broadcast to multiple servers simultaneously.

  
        

 
         
         		[bookmark: pgfId-539350]Prioritized Method List

  
         		[bookmark: pgfId-539352]The method list to use when authorizing users with this privilege level.

  
        

 
         
         		[bookmark: pgfId-539358]Add button

  
         		[bookmark: pgfId-539363]Opens the Command Accounting Dialog Box—Line Access. From here you can configure a command accounting definition.

  
        

 
         
         		[bookmark: pgfId-539369]Edit button

  
         		[bookmark: pgfId-539374]Opens the Command Accounting Dialog Box—Line Access. From here you can edit the command accounting definition.

  
        

 
         
         		[bookmark: pgfId-539380]Delete button

  
         		[bookmark: pgfId-539382]Deletes the selected command accounting definitions from the table.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-545031][bookmark: 140936][bookmark: rtpage_cncpt_VTYPolicyPage]VTY Policy Page[bookmark: marker-545025][bookmark: marker-545027][bookmark: marker-545029]

 
    [bookmark: pgfId-545033]Use the VTY page to configure up to 16 VTY lines for remote access to the router. In addition to configuring individual lines, you can configure a group of lines that share the same definition.

 
    [bookmark: pgfId-545038]For more information, see Line Access on Cisco IOS Routers.

 
    [bookmark: pgfId-545040]Navigation Path

 
     
     		 [bookmark: pgfId-545042](Device view) Select  Platform > Device Admin > Device Access > Line Access > VTY from the Policy selector.

 
     		 [bookmark: pgfId-545044](Policy view) Select  Router Platform > Device Admin > Device Access > Line Access > VTY from the Policy Type selector. Right-click  VTY to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-545046]Related Topics

 
     
     		 [bookmark: pgfId-545051]Console Policy Page

 
     		 [bookmark: pgfId-545056]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-545061]Filtering Tables

 
    

 
    [bookmark: pgfId-545063]Field Reference

 
    [bookmark: pgfId-545066] 

 
     
      
       
       [bookmark: pgfId-539395]Table 62-20 [bookmark: 140979]VTY Lines Page 

 
       
      
        
        		
          
          [bookmark: pgfId-539401]Element
         
  
        		
          
          [bookmark: pgfId-539403]Description
         
  
       

 
        
        		[bookmark: pgfId-539409]Line

  
        		[bookmark: pgfId-539411]The relative line number of the VTY line. This field may also contain multiple VTY lines configured as a contiguous group.

  
       

 
        
        		 [bookmark: pgfId-539417]Line/Line Group Parameters

  
       

 
        
        		[bookmark: pgfId-539425]Input Protocols

  
        		[bookmark: pgfId-539427]The protocols that you can use for incoming connections on the VTY line.

  
       

 
        
        		[bookmark: pgfId-539433]Output Protocols

  
        		[bookmark: pgfId-539435]The protocols that you can use for outgoing connections on the VTY line.

  
       

 
        
        		[bookmark: pgfId-539441]Privilege Level

  
        		[bookmark: pgfId-539443]The privilege level assigned to users.

  
       

 
        
        		[bookmark: pgfId-539449]Exec Timeout

  
        		[bookmark: pgfId-539451]The amount of time the EXEC command interpreter waits until user input is detected.

  
       

 
        
        		[bookmark: pgfId-539457]Inbound ACL

  
        		[bookmark: pgfId-539459]The ACL used to limit inbound traffic.

  
       

 
        
        		[bookmark: pgfId-539465]Outbound ACL

  
        		[bookmark: pgfId-539467]The ACL used to limit outbound traffic.

  
       

 
        
        		[bookmark: pgfId-539473]Authentication

  
        		[bookmark: pgfId-539475]The type of AAA authentication used.

  
       

 
        
        		[bookmark: pgfId-539481]Authorization

  
        		[bookmark: pgfId-539483]The types of AAA authorization used.

  
       

 
        
        		[bookmark: pgfId-539489]Accounting

  
        		[bookmark: pgfId-539491]The types of AAA accounting used.

  
       

 
        
        		 [bookmark: pgfId-539497]VTY Line Page Buttons

  
       

 
        
        		[bookmark: pgfId-539505]Add button

  
        		[bookmark: pgfId-539510]Opens the VTY Line Dialog Box. From here you can define a VTY line or line group.

  
       

 
        
        		[bookmark: pgfId-539516]Edit button

  
        		[bookmark: pgfId-539521]Opens the VTY Line Dialog Box. From here you can edit the VTY line or line group.

  
       

 
        
        		[bookmark: pgfId-539527]Delete button

  
        		[bookmark: pgfId-539529]Deletes the selected VTY lines from the table.

 [bookmark: pgfId-539531]If you delete a VTY line from an IOS device, any subsequent lines are also deleted. For example, if the device contains lines 0-9 and you delete line 5, lines 6-9 are deleted as well.

 [bookmark: pgfId-539533]Note If you delete any of the default VTY lines (0-4) on the device, the input protocol settings are retained and the other default settings are restored. This helps prevent you from cutting off remote access to the device.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-545078][bookmark: 141066][bookmark: rtpage_cncpt_VTYLineDialogBox]VTY Line Dialog Box[bookmark: marker-545072][bookmark: marker-545074][bookmark: marker-545076]

 
     [bookmark: pgfId-545080]Use the VTY Line dialog box to configure one or more VTY lines (up to 16) that enable remote users to access the router. When you configure a VTY line, you can define the type of authentication and authorization to perform on users who access the lines.

 
     [bookmark: pgfId-545082]Navigation Path

 
     [bookmark: pgfId-545087]Go to the VTY Policy Page, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-545089]Related Topics

 
      
      		 [bookmark: pgfId-545094]Line Access on Cisco IOS Routers

 
      		 [bookmark: pgfId-545099]Console Policy Page

 
     

 
     [bookmark: pgfId-545101]Field Reference

 
     [bookmark: pgfId-545104] 

 
      
       
        
        [bookmark: pgfId-539546]Table 62-21 [bookmark: 141097]VTY Line Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-539552]Element
          
  
         		
           
           [bookmark: pgfId-539554]Description
          
  
        

 
         
         		[bookmark: pgfId-539560]Setup tab

  
         		[bookmark: pgfId-539565]Defines the basic configuration of the VTY line or line group. See VTY Line Dialog Box—Setup Tab.

  
        

 
         
         		[bookmark: pgfId-539571]Authentication tab

  
         		[bookmark: pgfId-539576]Defines the type of AAA authentication to perform on users who access the VTY line. See VTY Line Dialog Box—Authentication Tab.

  
        

 
         
         		[bookmark: pgfId-539582]Authorization tab

  
         		[bookmark: pgfId-539587]Defines the types of AAA authorization to perform on users who access the VTY line. See VTY Line Dialog Box—Authorization Tab.

  
        

 
         
         		[bookmark: pgfId-539593]Accounting tab

  
         		[bookmark: pgfId-539598]Defines the types of AAA accounting to perform on users who access the VTY line. See VTY Line Dialog Box—Accounting Tab.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-545114][bookmark: 141131][bookmark: rtpage_cncpt_VTYLineDialogBoxSetupTab]VTY Line Dialog Box—Setup Tab[bookmark: marker-545112]

 
     [bookmark: pgfId-545116]Use the Setup tab of the VTY Line dialog box to define the basic parameters of the VTY line. This includes the password for accessing the line, the privilege level assigned to users, the protocols that are permitted on the line, and the ACLs that limit access.

 
     [bookmark: pgfId-545118]Navigation Path

 
     [bookmark: pgfId-545123]Go to the VTY Line Dialog Box, then click the Setup tab.

 
     [bookmark: pgfId-545125]Related Topics

 
      
      		 [bookmark: pgfId-545130]Defining VTY Line Setup Parameters

 
      		 [bookmark: pgfId-545135]VTY Line Dialog Box—Authentication Tab

 
      		 [bookmark: pgfId-545140]VTY Line Dialog Box—Authorization Tab

 
      		 [bookmark: pgfId-545145]VTY Line Dialog Box—Accounting Tab

 
      		 [bookmark: pgfId-545150]Console Page—Setup Tab

 
     

 
     [bookmark: pgfId-545152]Field Reference

 
     [bookmark: pgfId-545155] 

 
      
       
        
        [bookmark: pgfId-539611]Table 62-22 [bookmark: 141164]VTY Line Dialog Box—Setup Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-539617]Element
          
  
         		
           
           [bookmark: pgfId-539619]Description
          
  
        

 
         
         		[bookmark: pgfId-539625]Starting VTY Line Number

  
         		[bookmark: pgfId-539627]The relative line number of the VTY line. If you are configuring a group of VTY lines, enter the number of the first line in the group. Valid values range from 0 to 15.

 [bookmark: pgfId-539629]Note Although different routers support a different number of VTY lines (from four to several thousand), Security Manager supports a maximum of 16 lines per device. You cannot configure the same line number more than once.

  
        

 
         
         		[bookmark: pgfId-539635]Ending VTY Line Number

  
         		[bookmark: pgfId-539637]Applies only when configuring a group of lines.

 [bookmark: pgfId-539639]The relative line number of the last VTY line in the group.

 [bookmark: pgfId-539641]Note When you configure a group of lines, all the lines in the group must fall within one of two ranges, 0-4 or 6-15.

  
        

 
         
         		[bookmark: pgfId-539647]Password

  
         		[bookmark: pgfId-539649]The password for accessing this VTY line.

 [bookmark: pgfId-539651]The password is case sensitive and can contain up to 80 alphanumeric characters. The first character cannot be a number. Spaces are not allowed.

 [bookmark: pgfId-539653]Enter the password again in the Confirm field.

  
        

 
         
         		[bookmark: pgfId-539659]Privilege Level

  
         		[bookmark: pgfId-539661]The privilege level assigned to users on this VTY line. Valid values range from 0 to 15:

 
           
           		 [bookmark: pgfId-539663]0—Grants access to these commands only:  disable ,  enable ,  exit ,  help , and  logout .

 
           		 [bookmark: pgfId-539665]1—Enables nonprivileged access to the router (normal EXEC-mode use privileges).

 
           		 [bookmark: pgfId-539667]15—Enables privileged access to the router (traditional enable privileges).

 
          

 [bookmark: pgfId-539669]Note Levels 2-14 are not normally used in a default configuration, but custom configurations can be created by moving commands that are normally at level 15 to a lower level and commands that are normally at level 1 to a higher level. You can configure the privilege levels of commands using the CLI or by defining a FlexConfig.

 [bookmark: pgfId-539671]Note If you do not define a value, level 1 is assigned by default. This value does not appear in the device configuration.

  
        

 
         
         		[bookmark: pgfId-539677]Disable all the EXEC sessions to the router via this line

  
         		[bookmark: pgfId-539679]When selected, EXEC sessions are disabled over this line. Select this option when you want to allow only an outgoing connection on this line. This option is useful for keeping a particular line free from unsolicited incoming data that can tie up the line.

 [bookmark: pgfId-539681]When deselected, EXEC sessions are enabled over this line. This is the default.

  
        

 
         
         		[bookmark: pgfId-539687]Exec Timeout

  
         		[bookmark: pgfId-539689]The amount of time (in seconds) that the EXEC command interpreter waits to detect user input on the line. If no input is detected, the line is disconnected. Valid values range from 0 to 2147483. The default is 600 (10 minutes). Setting the value to 0 disables the timeout.

 [bookmark: pgfId-539691]Note Although the timeout is defined in seconds, it appears in the CLI in the format [mm ss].

  
        

 
         
         		[bookmark: pgfId-539697]Input Protocols

  
         		[bookmark: pgfId-539699]The protocols that you can use for incoming connections on this line:

 
           
           		 [bookmark: pgfId-539701]All—All supported protocols are permitted. Supported protocols include LAT, MOP, NASI, PAD, rlogin, SSH, Telnet, and V.120.

 
           		 [bookmark: pgfId-539703]None—No protocols are permitted. This makes the port unusable by incoming SSH, Telnet, and rlogin connections.

 
          

 [bookmark: pgfId-539708]Note Setting the input protocols setting to None might prevent Security Manager from connecting to the device after deployment. The device can still be managed using SSL, if SSL is enabled in the HTTP policy. See HTTP Page—Setup Tab.

 
           
           		 [bookmark: pgfId-539710]Protocol—Enables one or more of the following protocols:

 
          

 [bookmark: pgfId-539712] – SSH—Secure Shell protocol.

 [bookmark: pgfId-539714] – Telnet—Standard TCP/IP terminal emulation protocol.

 [bookmark: pgfId-539716] – rlogin—UNIX rlogin protocol.

 [bookmark: pgfId-539721]Note SSH and rlogin require that you configure AAA authentication. See VTY Line Dialog Box—Authentication Tab.

 [bookmark: pgfId-539723]Note Not all IOS Software Versions support rlogin as an input protocol.

  
        

 
         
         		[bookmark: pgfId-539729]Output Protocols

  
         		[bookmark: pgfId-539731]The protocols that you can use for outgoing connections on this line:

 
           
           		 [bookmark: pgfId-539733]All—All supported protocols are permitted. Supported protocols include LAT, MOP, NASI, PAD, rlogin, SSH, Telnet, and V.120.

 
           		 [bookmark: pgfId-539735]None—No protocols are permitted. This makes the port unusable by outgoing connections.

 
           		 [bookmark: pgfId-539737]Protocol—Enables one or more of the following protocols:

 
          

 [bookmark: pgfId-539739] – SSH—Secure Shell protocol.

 [bookmark: pgfId-539741] – Telnet—Standard TCP/IP terminal emulation protocol.

 [bookmark: pgfId-539743] – rlogin—UNIX rlogin protocol.

 [bookmark: pgfId-539748]Note SSH and rlogin require that you configure AAA authentication. See VTY Line Dialog Box—Authentication Tab.

 [bookmark: pgfId-539750]Note Not all IOS Software Versions support rlogin as an output protocol.

  
        

 
         
         		[bookmark: pgfId-539756]Inbound Access List

  
         		[bookmark: pgfId-539758]The name of the ACL object that restricts incoming connections on this line. Enter the name of the ACL object, or click Select to select it. If the object that you want is not listed, click the Create button to create it.

  
        

 
         
         		[bookmark: pgfId-539764]Permit VRF Interface Connections

  
         		[bookmark: pgfId-539766]Applies only when an inbound ACL is defined on this line.

 [bookmark: pgfId-539768]When selected, accepts incoming connections from interfaces that belong to a VRF. When deselected, rejects incoming connections from interfaces that belong to a VRF.

  
        

 
         
         		[bookmark: pgfId-539774]Outbound Access List

  
         		[bookmark: pgfId-539776]The name of the ACL object that restricts outgoing connections on this line. Enter the name of the ACL object, or click Select to select it. If the object that you want is not listed, click the Create button to create it.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-545165][bookmark: 141292][bookmark: rtpage_cncpt_VTYLineDialogBoxAuthenticationTab]VTY Line Dialog Box—Authentication Tab[bookmark: marker-545163]

 
     [bookmark: pgfId-545167]Use the Authentication tab of the VTY Line dialog box to define the authentication methods to perform on users who attempt to access the selected VTY line or group of lines.

 
     [bookmark: pgfId-545169]Navigation Path

 
     [bookmark: pgfId-545174]Go to the VTY Line Dialog Box, then click the Authentication tab.

 
     [bookmark: pgfId-545176]Related Topics

 
      
      		 [bookmark: pgfId-545181]Defining VTY Line AAA Settings

 
      		 [bookmark: pgfId-545186]VTY Line Dialog Box—Setup Tab

 
      		 [bookmark: pgfId-545191]VTY Line Dialog Box—Authorization Tab

 
      		 [bookmark: pgfId-545196]VTY Line Dialog Box—Accounting Tab

 
      		 [bookmark: pgfId-545201]Console Page—Authentication Tab

 
     

 
     [bookmark: pgfId-545203]Field Reference

 
     [bookmark: pgfId-545206] 

 
      
       
        
        [bookmark: pgfId-539789]Table 62-23 [bookmark: 141325]VTY Line Dialog Box—Authentication Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-539795]Element
          
  
         		
           
           [bookmark: pgfId-539797]Description
          
  
        

 
         
         		[bookmark: pgfId-539803]Authenticate Using

  
         		[bookmark: pgfId-539805]Authentication settings for the VTY line:

 
           
           		 [bookmark: pgfId-539807]None—Authentication is not performed. This is the default.

 
           		 [bookmark: pgfId-539809]Local Database—Uses the local username database for authentication.

 
           		 [bookmark: pgfId-539814]AAA Policy Default List—Uses the default authentication method list that is defined in the device’s AAA policy. See AAA Page—Authentication Tab.

 
           		 [bookmark: pgfId-539816]Custom Method List—Uses the authentication methods specified in the Prioritized Method List field.

 
          

 command is not configured by another policy (for example, by configuring a method list in the AAA policy) or is already configured on the device itself.

  
        

 
         
         		[bookmark: pgfId-539824]Prioritized Method List

  
         		[bookmark: pgfId-539826]Applies only when Custom Method List is selected as the authentication method.

 [bookmark: pgfId-539828]Defines a sequential list of methods to be queried when authenticating a user. Enter the names of one or more AAA server group objects (up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-539830]The device tries initially to authenticate users using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-539832]Note If you select None as a method, it must appear as the last method in the list.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-545216][bookmark: 141363][bookmark: rtpage_cncpt_VTYLineDialogBoxAuthorizationTab]VTY Line Dialog Box—Authorization Tab[bookmark: marker-545214]

 
     [bookmark: pgfId-545218]Use the Authorization tab of the VTY Line dialog box to define the EXEC and command authorization methods to perform on users who access the selected VTY line or group of lines.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-545223]Note You must enable AAA services on the router to use this feature; otherwise, deployment will fail. See Defining AAA Services.


     
      

     

     

 
     [bookmark: pgfId-545225]Navigation Path

 
     [bookmark: pgfId-545230]Go to the VTY Line Dialog Box, then click the Authorization tab.

 
     [bookmark: pgfId-545232]Related Topics

 
      
      		 [bookmark: pgfId-545237]Defining VTY Line AAA Settings

 
      		 [bookmark: pgfId-545242]VTY Line Dialog Box—Setup Tab

 
      		 [bookmark: pgfId-545247]VTY Line Dialog Box—Authentication Tab

 
      		 [bookmark: pgfId-545252]VTY Line Dialog Box—Accounting Tab

 
      		 [bookmark: pgfId-545257]Console Page—Authentication Tab

 
      		 [bookmark: pgfId-545262]Filtering Tables

 
     

 
     [bookmark: pgfId-545264]Field Reference

 
     [bookmark: pgfId-545267] 

 
      
       
        
        [bookmark: pgfId-539845]Table 62-24 [bookmark: 141401]VTY Line Dialog Box—Authorization Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-539851]Element
          
  
         		
           
           [bookmark: pgfId-539853]Description
          
  
        

 
         
         		 [bookmark: pgfId-539859]EXEC Authorization settings

  
        

 
         
         		[bookmark: pgfId-539867]Authorize EXEC Operations Using

  
         		[bookmark: pgfId-539869]The authorization method that determines whether a user is allowed to run an EXEC session:

 
           
           		 [bookmark: pgfId-539871]None—Authorization is not performed. This is the default.

 
           		 [bookmark: pgfId-539876]AAA Policy Default List—Uses the default authorization method list that is defined in the device’s AAA policy. See AAA Page—Authorization Tab.

 
           		 [bookmark: pgfId-539878]Custom Method List—Uses the authorization methods specified in the Prioritized Method List field.

 
          

  
        

 
         
         		[bookmark: pgfId-539884]Prioritized Method List

  
         		[bookmark: pgfId-539886]Applies only when Custom Method List is selected as the EXEC method.

 [bookmark: pgfId-539888]Defines a sequential list of methods to be queried when authorizing a user. Enter the names of one or more AAA server group objects (up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-539890]The device tries initially to authorize users using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-539892]Note If you select None as a method, it must appear as the last method in the list.

 [bookmark: pgfId-539894]Note RADIUS uses the same server for authentication and authorization. Therefore, if you use define a RADIUS method list for authentication, you must define the same method list for authorization.

  
        

 
         
         		 [bookmark: pgfId-539900]Command Authorization settings

  
        

 
         
         		[bookmark: pgfId-539908]Privilege Level

  
         		[bookmark: pgfId-539910]The privilege level to which the command authorization definition applies.

  
        

 
         
         		[bookmark: pgfId-539916]Prioritized Method List

  
         		[bookmark: pgfId-539918]The method list to use when authorizing users with this privilege level.

  
        

 
         
         		[bookmark: pgfId-539924]Add button

  
         		[bookmark: pgfId-539929]Opens the Command Authorization Dialog Box—Line Access. From here you can configure a command authorization definition.

  
        

 
         
         		[bookmark: pgfId-539935]Edit button

  
         		[bookmark: pgfId-539940]Opens the Command Authorization Dialog Box—Line Access. From here you can edit the command authorization definition.

  
        

 
         
         		[bookmark: pgfId-539946]Delete button

  
         		[bookmark: pgfId-539948]Deletes the selected command authorization definitions from the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-545277][bookmark: 141471][bookmark: rtpage_cncpt_VTYLineDialogBoxAccountingTab]VTY Line Dialog Box—Accounting Tab[bookmark: marker-545275]

 
     [bookmark: pgfId-545279]Use the Accounting tab of the VTY Line dialog box to define the EXEC, connection, and command accounting methods to perform on users who access the selected VTY line or group of lines.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-545284]Note You must enable AAA services on the router to use this feature; otherwise, deployment will fail. See Defining AAA Services.


     
      

     

     

 
     [bookmark: pgfId-545286]Navigation Path

 
     [bookmark: pgfId-545291]Go to the VTY Line Dialog Box, then click the Accounting tab.

 
     [bookmark: pgfId-545293]Related Topics

 
      
      		 [bookmark: pgfId-545298]Defining VTY Line AAA Settings

 
      		 [bookmark: pgfId-545303]VTY Line Dialog Box—Setup Tab

 
      		 [bookmark: pgfId-545308]VTY Line Dialog Box—Authentication Tab

 
      		 [bookmark: pgfId-545313]Console Page—Accounting Tab

 
      		 [bookmark: pgfId-545318]Filtering Tables

 
     

 
     [bookmark: pgfId-545320]Field Reference

 
     [bookmark: pgfId-545323] 

 
      
       
        
        [bookmark: pgfId-539961]Table 62-25 [bookmark: 141506]VTY Line Dialog Box—Accounting Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-539967]Element
          
  
         		
           
           [bookmark: pgfId-539969]Description
          
  
        

 
         
         		 [bookmark: pgfId-539975]EXEC Accounting settings

  
        

 
         
         		[bookmark: pgfId-539983]Perform EXEC Accounting Using

  
         		[bookmark: pgfId-539985]The accounting method to use for recording basic information about user EXEC sessions:

 
           
           		 [bookmark: pgfId-539987]None—Accounting is not performed. This is the default.

 
           		 [bookmark: pgfId-539992]AAA Policy Default List—Uses the default EXEC accounting method list that is defined in the device’s AAA policy. See AAA Page—Accounting Tab.

 
           		 [bookmark: pgfId-539994]Custom Method List—Uses the accounting methods specified in the Prioritized Method List field.

 
          

 [bookmark: pgfId-539996]EXEC accounting records basic details about EXEC sessions, such as the username, date, start and stop times, and the access server IP address.

  
        

 
         
         		[bookmark: pgfId-540002]Generate Accounting Records for

  
         		[bookmark: pgfId-540004]Applies only when Custom Method List is selected as the EXEC method.

 [bookmark: pgfId-540006]Defines when the device sends an accounting notice to the accounting server:

 
           
           		 [bookmark: pgfId-540008]Start and Stop—Generates accounting records at the beginning and the end of the user process. The user process begins regardless of whether the accounting server receives the “start” accounting record. This is the default.

 
           		 [bookmark: pgfId-540010]Stop Only—Generates an accounting record at the end of the user process only.

 
           		 [bookmark: pgfId-540012]None—No accounting records are generated.

 
          

  
        

 
         
         		[bookmark: pgfId-540018]Prioritized Method List

  
         		[bookmark: pgfId-540020]Applies only when Custom Method List is selected as the EXEC method.

 [bookmark: pgfId-540022]Defines a sequential list of methods to be queried when creating accounting methods for a user. Enter the names of one or more AAA server group objects (up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-540024]The device tries initially to perform accounting using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-540026]Note If you select None as a method, it must appear as the last method in the list.

  
        

 
         
         		[bookmark: pgfId-540032]Enable Broadcast to Multiple Servers

  
         		[bookmark: pgfId-540034]Applies only when Method List is selected as the EXEC method.

 [bookmark: pgfId-540036]When selected, enables the sending of accounting records to multiple AAA servers. Accounting records are sent simultaneously to the first server in each AAA server group defined in the method list. If the first server is unavailable, failover occurs using the backup servers defined within that group.

 [bookmark: pgfId-540038]When deselected, accounting records are sent only to the first server in the first AAA server group defined in the method list.

  
        

 
         
         		 [bookmark: pgfId-540044]Connection Accounting settings

  
        

 
         
         		[bookmark: pgfId-540052]Perform Connection Accounting Using

  
         		[bookmark: pgfId-540054]The accounting method to use for recording information about outbound connections made over the VTY line:

 
           
           		 [bookmark: pgfId-540056]None—Accounting is not performed. This is the default.

 
           		 [bookmark: pgfId-540061]AAA Policy Default List—Uses the default connection accounting method list that is defined in the device’s AAA policy. See AAA Page—Accounting Tab.

 
           		 [bookmark: pgfId-540063]Custom Method List—Uses the accounting methods specified in the Prioritized Method List field.

 
          

 [bookmark: pgfId-540065]Connection accounting records details about outgoing connections over the line, such as Telnet and rlogin connections.

  
        

 
         
         		[bookmark: pgfId-540071]Generate Accounting Records for

  
         		[bookmark: pgfId-540073]Applies only when Custom Method List is selected as the connection method.

 [bookmark: pgfId-540075]Defines when the device sends an accounting notice to the accounting server:

 
           
           		 [bookmark: pgfId-540077]Start and Stop—Generates accounting records at the beginning and the end of the user process. The user process begins regardless of whether the accounting server receives the “start” accounting record. This is the default.

 
           		 [bookmark: pgfId-540079]Stop Only—Generates an accounting record at the end of the user process only.

 
           		 [bookmark: pgfId-540081]None—No accounting records are generated.

 
          

  
        

 
         
         		[bookmark: pgfId-540087]Prioritized Method List

  
         		[bookmark: pgfId-540089]Applies only when Custom Method List is selected as the connection method.

 [bookmark: pgfId-540091]Defines a sequential list of methods to be queried when creating accounting methods for a user. Enter the names of one or more AAA server group objects (up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-540093]The device tries initially to perform accounting using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-540095]Note If you select None as a method, it must appear as the last method in the list.

  
        

 
         
         		[bookmark: pgfId-540101]Enable Broadcast to Multiple Servers

  
         		[bookmark: pgfId-540103]Applies only when Custom Method List is selected as the connection method.

 [bookmark: pgfId-540105]When selected, enables the sending of accounting records to multiple AAA servers. Accounting records are sent simultaneously to the first server in each AAA server group defined in the method list. If the first server is unavailable, failover occurs using the backup servers defined within that group.

 [bookmark: pgfId-540107]When deselected, accounting records are sent only to the first server in the first AAA server group defined in the method list.

  
        

 
         
         		 [bookmark: pgfId-540113]Command Accounting settings

  
        

 
         
         		[bookmark: pgfId-540121]Privilege Level

  
         		[bookmark: pgfId-540123]The privilege level to which the command authorization definition applies.

  
        

 
         
         		[bookmark: pgfId-540129]Generate Accounting Records for

  
         		[bookmark: pgfId-540131]The points in the process where the device sends an accounting notice to the accounting server.

  
        

 
         
         		[bookmark: pgfId-540137]Enable Broadcast

  
         		[bookmark: pgfId-540139]Whether accounting records are broadcast to multiple servers simultaneously.

  
        

 
         
         		[bookmark: pgfId-540145]Prioritized Method List

  
         		[bookmark: pgfId-540147]The method list to use when authorizing users with this privilege level.

  
        

 
         
         		[bookmark: pgfId-540153]Add button

  
         		[bookmark: pgfId-540158]Opens the Command Accounting Dialog Box—Line Access. From here you can configure a command accounting definition.

  
        

 
         
         		[bookmark: pgfId-540164]Edit button

  
         		[bookmark: pgfId-540169]Opens the Command Accounting Dialog Box—Line Access. From here you can edit the command accounting definition.

  
        

 
         
         		[bookmark: pgfId-540175]Delete button

  
         		[bookmark: pgfId-540177]Deletes the selected command accounting definitions from the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-545335][bookmark: 141654][bookmark: rtpage_cncpt_CommandAuthorizationDialogBoxLineAccess]Command Authorization Dialog Box—Line Access[bookmark: marker-545331][bookmark: marker-545333]

 
     [bookmark: pgfId-545337]Use the Command Authorization dialog box to define which methods to use when authorizing the EXEC commands that are associated with a given privilege. This enables you to authorize all commands associated with a specific privilege level, from 0 to 15.

 
     [bookmark: pgfId-545339]Navigation Path

 
     [bookmark: pgfId-545347]From the Console Page—Authorization Tab or the VTY Line Dialog Box—Authorization Tab, click the Add button beneath the Command Authorization table.

 
     [bookmark: pgfId-545349]Related Topics

 
      
      		 [bookmark: pgfId-545354]Console Policy Page

 
      		 [bookmark: pgfId-545359]VTY Policy Page

 
     

 
     [bookmark: pgfId-545361]Field Reference

 
     [bookmark: pgfId-545364] 

 
      
       
        
        [bookmark: pgfId-540190]Table 62-26 [bookmark: 141684]Command Authorization Dialog Box—Line Access 

 
        
       
         
         		
           
           [bookmark: pgfId-540196]Element
          
  
         		
           
           [bookmark: pgfId-540198]Description
          
  
        

 
         
         		[bookmark: pgfId-540204]Privilege Level

  
         		[bookmark: pgfId-540206]The privilege level for which you want to define a command authorization list. Valid values range from 0 to 15.

 [bookmark: pgfId-540208]Note If you do not define a value, level 1 is assigned by default. This value does not appear in the device configuration.

  
        

 
         
         		[bookmark: pgfId-540214]AAA Policy Default List

  
         		[bookmark: pgfId-540219]Select this option to apply the default authorization list defined in the device’s AAA policy to the EXEC commands associated with this privilege level. See Command Accounting Dialog Box.

  
        

 
         
         		[bookmark: pgfId-540225]Custom Method List

  
         		[bookmark: pgfId-540227]Select this option to define an authorization method list for this privilege level.

  
        

 
         
         		[bookmark: pgfId-540233]Prioritized Method List

  
         		[bookmark: pgfId-540235]Applies only when the Custom Method List option is selected.

 [bookmark: pgfId-540237]Defines a sequential list of methods to be queried when authorizing a user. Enter the names of one or more AAA server group objects (up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-540239]The device tries initially to authorize users using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-540241]Note If you select None as a method, it must appear as the last method in the list.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-545376][bookmark: 141722][bookmark: rtpage_cncpt_CommandAccountingDialogBoxLineAccess]Command Accounting Dialog Box—Line Access[bookmark: marker-545372][bookmark: marker-545374]

 
     [bookmark: pgfId-545378]Use the Command Accounting dialog box to define which methods to use when recording information about the EXEC commands that are executed for a given privilege. Each accounting record includes a list of the commands executed for that privilege level, as well as the date and time each command was executed, and the name of the user who executed it.

 
     [bookmark: pgfId-545380]Navigation Path

 
     [bookmark: pgfId-545388]From the Console Page—Accounting Tab or the VTY Line Dialog Box—Accounting Tab, click the Add button beneath the Command Accounting table.

 
     [bookmark: pgfId-545390]Related Topics

 
      
      		 [bookmark: pgfId-545395]Console Policy Page

 
      		 [bookmark: pgfId-545400]VTY Policy Page

 
     

 
     [bookmark: pgfId-545402]Field Reference

 
     [bookmark: pgfId-545405] 

 
      
       
        
        [bookmark: pgfId-540254]Table 62-27 [bookmark: 141752]Command Accounting Dialog Box—Line Access 

 
        
       
         
         		
           
           [bookmark: pgfId-540260]Element
          
  
         		
           
           [bookmark: pgfId-540262]Description
          
  
        

 
         
         		[bookmark: pgfId-540268]Privilege Level

  
         		[bookmark: pgfId-540270]The privilege level for which you want to define a command accounting list. Valid values range from 0 to 15.

 [bookmark: pgfId-540272]Note If you do not define a value, level 1 is assigned by default. This value does not appear in the device configuration.

  
        

 
         
         		[bookmark: pgfId-540278]AAA Policy Default List

  
         		[bookmark: pgfId-540280]Select this option to apply the default accounting list defined in the device’s AAA policy to the EXEC commands executed for this privilege level.

  
        

 
         
         		[bookmark: pgfId-540286]Custom Method List

  
         		[bookmark: pgfId-540288]Select this option to define an accounting method list for this privilege level.

  
        

 
         
         		[bookmark: pgfId-540294]Generate Accounting Records for

  
         		[bookmark: pgfId-540296]Applies only when Custom Method List is selected.

 [bookmark: pgfId-540298]Defines when the device sends an accounting notice to the accounting server:

 
           
           		 [bookmark: pgfId-540300]Start and Stop—Generates accounting records at the beginning and the end of the user process. The user process begins regardless of whether the accounting server receives the “start” accounting record. This is the default.

 
           		 [bookmark: pgfId-540302]Stop Only—Generates an accounting record at the end of the user process only.

 
           		 [bookmark: pgfId-540304]None—No accounting records are generated.

 
          

  
        

 
         
         		[bookmark: pgfId-540310]Prioritized Method List

  
         		[bookmark: pgfId-540312]Applies only when the Custom Method List option is selected.

 [bookmark: pgfId-540314]Defines a sequential list of accounting methods to be used when creating accounting records for a user. Enter the names of one or more AAA server group objects (up to four), or click Select to select them. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-540316]The device tries initially to perform accounting using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-540318]Note If you select None as a method, it must appear as the last method in the list.

  
        

 
         
         		[bookmark: pgfId-540324]Enable Broadcast to Multiple Servers

  
         		[bookmark: pgfId-540326]Applies only when Custom Method List is selected.

 [bookmark: pgfId-540328]When selected, enables the sending of accounting records to multiple AAA servers. Accounting records are sent simultaneously to the first server in each AAA server group defined in the method list. If the first server is unavailable, failover occurs using the backup servers defined within that group.

 [bookmark: pgfId-540330]When deselected, accounting records are sent only to the first server in the first AAA server group defined in the method list.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-545417][bookmark: 141811][bookmark: rtchap_cncpt_OptionalSSHSettingsonCiscoIOSRouters]Optional SSH Settings on Cisco IOS Routers[bookmark: marker-545411][bookmark: marker-545413][bookmark: marker-545415]

 
    [bookmark: pgfId-545419]Secure Shell (SSH) is an application and a protocol that uses encryption to provide secure communication between a client and server. You can use SSH to connect remotely to a Cisco IOS router over a VTY line and establish an EXEC session. SSH is the recommended replacement for other protocols, such as Telnet and rlogin, in environments where security is a concern.

 
    [bookmark: pgfId-545421]All Cisco IOS routers are required to have SSH configured before they can be added to Security Manager. This is because Security Manager uses SSH (in addition to SSL) to communicate with them. The SSH policy provides a way to modify selected default settings and configure selected optional settings.

 
    [bookmark: pgfId-545423]Related Topics

 
     
     		 [bookmark: pgfId-545428]Defining Optional SSH Settings

 
     		 [bookmark: pgfId-545433]Chapter 2, “Preparing Devices for Management”

 
     		 [bookmark: pgfId-545438]Setting Up SSH

 
    

 
     
      [bookmark: pgfId-545446][bookmark: 141838][bookmark: rtchap_proc_DefiningOptionalSSHSettings]Defining Optional SSH Settings[bookmark: marker-545444]

 
     [bookmark: pgfId-545448]SSH is configured by default with the following settings:

 
      
      		 [bookmark: pgfId-545450]Both SSH version 1 and SSH version 2 are supported.

 
      		 [bookmark: pgfId-545452]The negotiation phase is terminated if not completed successfully after 120 seconds.

 
      		 [bookmark: pgfId-545454]The router tries 3 times to authenticate SSH clients before disconnecting.

 
     

 
     [bookmark: pgfId-545456]You can use Security Manager to modify these default settings and optionally configure the following settings:

 
      
      		 [bookmark: pgfId-545458]The source interface for SSH packets.

 
      		 [bookmark: pgfId-545460]The name of the RSA key pair to use.

 
      		 [bookmark: pgfId-545462]Whether to regenerate the key during the next deployment.

 
     

 
     [bookmark: pgfId-545464]Before You Begin

 
      
      		 [bookmark: pgfId-545469]Make sure that SSH is enabled on the router. See Chapter 2, “Preparing Devices for Management”.

 
      		 [bookmark: pgfId-545474]Make sure that the VTY lines on the router allow inbound SSH traffic. See Defining VTY Line Setup Parameters.

 
      		 [bookmark: pgfId-545479]Make sure that a hostname and domain name are configured on the router (unless you plan to use a different RSA key pair). You can use the CLI or the Hostname policy in Security Manager for this purpose. See Hostnames and Domain Names on Cisco IOS Routers.

 
     

 
     [bookmark: pgfId-545481]Related Topics

 
      
      		 [bookmark: pgfId-545486]Optional SSH Settings on Cisco IOS Routers

 
      		 [bookmark: pgfId-545491]Setting Up SSH

 
     

 
     
 
     [bookmark: pgfId-545493]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-545495](Device view) Select  Platform > Device Admin > Device Access > Secure Shell from the Policy selector.

 
      		 [bookmark: pgfId-545497](Policy view) Select  Router Platform > Device Admin > Device Access > Secure Shell from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-545502]The Secure Shell page is displayed. See Table 62-28 for a description of the fields on this page.

 
     [bookmark: pgfId-545504]Step 2 (Optional) Modify the following default settings:

 
     [bookmark: pgfId-545506] a. The version of SSH to support.

 
     [bookmark: pgfId-545508] b. The timeout for completing the negotiation phase of the SSH connection.

 
     [bookmark: pgfId-545510] c. The number of times to attempt authentication of the SSH client.

 
     [bookmark: pgfId-545512]Step 3 (Optional) In the Source Interface field, enter the name of the interface or interface role whose address should be used as the source interface for all SSH packets sent to SSH clients, or click Select to select an interface role object from a list or to create a new one. The source interface must have an IP address.

 
     [bookmark: pgfId-545514]If you do not enter a value in this field, the address of the closest interface to the destination is used.

 
     [bookmark: pgfId-545516]Step 4 (Optional) Enter the name of the RSA key pair to use for SSH connections. If you do not enter a value in this field, the router uses the key pair that is based on the hostname and domain name.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-545518]Tip Use the CLI command show crypto key mypubkey rsa to display the names and values of each key pair configured on the device.


     
      

     

     

 
     [bookmark: pgfId-545520]Step 5 (Optional) Select the Regenerate Key During Deployment check box if you want the router to regenerate the RSA key pair used for SSH. This option is useful if you believe that the secrecy of the keys might be compromised. Enter the size of the modulus to use to regenerate the keys.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-545522]Note You must remember to return to this policy after deployment to deselect the check box. If you do not do this, a new key is generated during each deployment.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-545524]Note This option requires interaction with the device during deployment. Therefore, you should use it only when deploying to live devices, not when deploying to a file.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-545526]Note A key pair must already exist on the device before you select this option; otherwise, deployment will fail. (This will typically be the case, since IOS routers must have SSH enabled to be added to Security Manager.)


     
      

     

     

 
     [bookmark: pgfId-545528]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-545540][bookmark: 141920][bookmark: rtpage_cncpt_SecureShellPolicyPage]Secure Shell Policy Page[bookmark: marker-545536][bookmark: marker-545538]

 
    [bookmark: pgfId-545542]Use the Secure Shell page to change the default SSH settings on the router and to define additional optional settings, if required.

 
    [bookmark: pgfId-545547]For more information, see Optional SSH Settings on Cisco IOS Routers.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-545552]Note You must configure SSH on the device using CLI commands before adding the device to Security Manager. This is because Security Manager uses SSH (as well as SSL) to communicate with Cisco IOS routers. For more information, see Setting Up SSH.


    
     

    

    

 
    [bookmark: pgfId-545554]Navigation Path

 
     
     		 [bookmark: pgfId-545556](Device view) Select  Platform > Device Admin > Device Access > Secure Shell from the Policy selector.

 
     		 [bookmark: pgfId-545558](Policy view) Select  Router Platform > Device Admin > Device Access > Secure Shell from the Policy Type selector. Right-click  Secure Shell to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-545560]Related Topics

 
     
     		 [bookmark: pgfId-545565]Chapter 2, “Preparing Devices for Management”

 
     		 [bookmark: pgfId-545570]VTY Policy Page

 
     		 [bookmark: pgfId-545575]Console Policy Page

 
    

 
    [bookmark: pgfId-545577]Field Reference

 
    [bookmark: pgfId-545580] 

 
     
      
       
       [bookmark: pgfId-540343]Table 62-28 [bookmark: 141960]Secure Shell Page 

 
       
      
        
        		
          
          [bookmark: pgfId-540349]Element
         
  
        		
          
          [bookmark: pgfId-540351]Description
         
  
       

 
        
        		[bookmark: pgfId-540357]SSH Version

  
        		[bookmark: pgfId-540359]The version of SSH to use when connecting to the router:

 
          
          		 [bookmark: pgfId-540361]1 and 2—SSH version 1 and SSH version 2. This is the default.

 
          		 [bookmark: pgfId-540363]1—SSH version 1 only.

 
          		 [bookmark: pgfId-540365]2—SSH version 2 only.

 
         

  
       

 
        
        		[bookmark: pgfId-540371]Timeout

  
        		[bookmark: pgfId-540373]The amount of time the router should wait for the SSH client to respond during the negotiation phase before disconnecting. The default value (and the maximum) is 120 seconds.

 [bookmark: pgfId-540378]Note After negotiation finishes and the EXEC session begins, the timeout configured for the VTY line applies. See VTY Line Dialog Box—Setup Tab.

  
       

 
        
        		[bookmark: pgfId-540384]Authentication Retries

  
        		[bookmark: pgfId-540386]The number of times the router attempts to authenticate SSH clients. Valid values range from 0 to 5. The default is 3.

  
       

 
        
        		[bookmark: pgfId-540392]Source Interface

  
        		[bookmark: pgfId-540394]The source address for all SSH packets sent to the SSH client.

 [bookmark: pgfId-540396]If you do not define a value in this field, the address of the closest interface to the destination (that is, the output interface through which SSH packets are sent) is used.

 [bookmark: pgfId-540398]Enter the name of an interface or interface role, or click Select to select the object from a list or to create a new one.

  
       

 
        
        		[bookmark: pgfId-540404]RSA Key Pair

  
        		[bookmark: pgfId-540406]The name of the RSA key pair to use for SSH connections.

 [bookmark: pgfId-540408]If you do not enter a value, the router uses the RSA key pair generated from its hostname and domain name. This is the default.

 to display the names and values of each key pair configured on the device. These are the valid names that can be entered in this field.  
       

 
        
        		[bookmark: pgfId-540416]Regenerate Key During Deployment

  
        		[bookmark: pgfId-540418]When selected, regenerates the RSA key pair on the router during the next deployment. This option is useful if you are concerned that the secrecy of the keys might be compromised.

 [bookmark: pgfId-540420]When deselected, a new key pair is not generated.

 deselected automatically after deployment. If you do not return to this policy to deselect the check box, the key is regenerated each time you deploy.

 [bookmark: pgfId-540424]Note This option requires interaction with the device during deployment. Therefore, you should use it only when deploying to live devices, not when deploying to a file.

 you select this option; otherwise, deployment will fail. (This will typically be the case, since IOS routers must have SSH enabled in order to be added to Security Manager.)

  
       

 
        
        		[bookmark: pgfId-540432]Modulus Size

  
        		[bookmark: pgfId-540434]Applies only when the Regenerate Key check box is selected.

 [bookmark: pgfId-540436]The size of the modulus used to generate a new key pair. A larger modulus is more secure but takes longer to generate. Valid values range from 360 to 2048 bits. The default is 1024 bits.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-545592][bookmark: 142028][bookmark: rtchap_cncpt_SNMPonCiscoIOSRouters]SNMP on Cisco IOS Routers[bookmark: marker-545586][bookmark: marker-545588][bookmark: marker-545590]

 
    [bookmark: pgfId-545594]Simple Network Management Protocol (SNMP) defines a standard way for network management stations or workstations to monitor the health and status of many types of devices, including switches, routers, and firewall devices. It comprises a protocol, a database-structure specification, and a set of management data objects. Each SNMP device or member is part of a community, which determines the access that each device has (read-only or read-write).

 
    [bookmark: pgfId-545596]SNMP obtains information from the managed device through a Management Information Base (MIB). The MIB is a database of code blocks called MIB objects, each of which controls one specific function. The MIB object comprises MIB variables, which define the MIB object name, description, default value, and so forth. MIB objects are structured hierarchically in a MIB tree.

 
    [bookmark: pgfId-545598]SNMP policies enable you to configure the behavior of the SNMP agent running on the router. The agent sends unsolicited information back to the SNMP host as events occur. These unsolicited messages, which are generated in response to significant, predetermined events on the router, are called traps.

 
    [bookmark: pgfId-545600]The following topics describe the tasks you perform to create SNMP policies on Cisco IOS routers:

 
     
     		 [bookmark: pgfId-545605]Defining SNMP Agent Properties

 
     		 [bookmark: pgfId-545610]Enabling SNMP Traps

 
    

 
     
      [bookmark: pgfId-545618][bookmark: 142053][bookmark: rtchap_proc_DefiningSNMPAgentProperties]Defining SNMP Agent Properties[bookmark: marker-545616]

 
     [bookmark: pgfId-545620]When you define the properties of the SNMP agent, you must define the community string and community string type, as well as the address and properties of the SNMP host that receives the traps.

 
     [bookmark: pgfId-545622]SNMP community strings are embedded passwords to MIBs, which store data about the router’s operation and are meant to be available to authenticated remote users. Two types of community strings exist: “public” community strings, which provide read-only access to all objects in the MIB (except community strings themselves), and “private” community strings, which provide read-write access to all objects in the MIB (except community strings).

 
     [bookmark: pgfId-545624]SNMP hosts receive the traps generated by the router. You must define the address, password, and port number for accessing the SNMP host, as well as the SNMP version being used. Security Manager supports SNMP version 1, version 2c (also called “community-based SNMP”) and version 3, which offers authentication and encryption.

 
     [bookmark: pgfId-545626]Related Topics

 
      
      		 [bookmark: pgfId-545631]SNMP on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-545633]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-545635](Device view) Select  Platform > Device Admin > Device Access > SNMP from the Policy selector.

 
      		 [bookmark: pgfId-545637](Policy view) Select  Router Platform > Device Admin > Device Access > SNMP from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-545642]The SNMP page is displayed. See Table 62-29 for a description of the fields on this page.

 
     [bookmark: pgfId-545644]Step 2 Define the community string needed to access the MIB:

 
     [bookmark: pgfId-545646] a. Under Permissions, click Add to display the Permission dialog box.

 
     [bookmark: pgfId-545651] b. Define the string. See Table 62-30 for a description of the available fields.

 
     [bookmark: pgfId-545653] c. Click OK to save your definitions locally on the client and close the dialog box. Your definitions are displayed in the Permissions table.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-545655]Note A warning is displayed if you attempt to edit or delete a community string that is in use by an SNMP host. If you continue with the operation, the device creates a private, read-only string that matches the definition for the host in the Trap Receiver table.


     
      

     

     

 
     [bookmark: pgfId-545659]Step 3 [bookmark: 142093]Define the SNMP host that receives the traps generated by the SNMP agent:

 
     [bookmark: pgfId-545661] a. Under Trap Receiver, click Add to display the Trap Receiver dialog box.

 
     [bookmark: pgfId-545666] b. Define the host. See Table 62-31 for a description of the available fields.

 
     [bookmark: pgfId-545668] c. Click OK to save your definitions locally on the client and close the dialog box. Your definitions are displayed in the Trap Receiver table.

 
     [bookmark: pgfId-545670]Step 4 Under SNMP Server Properties, enter the location and contact information for the administrator responsible for routers configured with this SNMP policy.

 
     [bookmark: pgfId-545672]This definition, which is text-only and does not affect the operation of the router, provides useful information to the manager of the SNMP host when the manager investigates a particular trap.

 
     [bookmark: pgfId-545677]Step 5 Click Configure Traps to display the SNMP Traps dialog box, which is used to select which traps to enable on the router. For more information, see Enabling SNMP Traps.

 
     [bookmark: pgfId-545679]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-545687][bookmark: 142115][bookmark: rtchap_proc_EnablingSNMPTraps]Enabling SNMP Traps[bookmark: marker-545685]

 
     [bookmark: pgfId-545689]The router immediately sends notifications, also called SNMP traps, to the designated SNMP host (management station) when a defined condition occurs, such as a link up, link down, or a syslog event.

 
     [bookmark: pgfId-545691]To enable SNMP traps, select the check box next to each relevant trap. Certain check boxes activate multiple, related traps.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-545693]Note Each trap that you enable consumes system resources. To lessen the impact on system performance, select only those traps that you need for network monitoring.


     
      

     

     

 
     [bookmark: pgfId-545695]Related Topics

 
      
      		 [bookmark: pgfId-545700]SNMP on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-545705]Step 1 Open the SNMP page for defining SNMP server policies on Cisco IOS routers, as described in Defining SNMP Agent Properties.

 
     [bookmark: pgfId-545707]Step 2 On the SNMP page, click Configure Traps. The SNMP Traps dialog box is displayed.

 
     [bookmark: pgfId-545709]Step 3 Select the check box next to each type of trap to enable. The traps are divided into the following four categories:

 
      
      		 [bookmark: pgfId-545711]Standard SNMP traps (for example, Authentication, Cold Start, and Warm Start).

 
      		 [bookmark: pgfId-545713]ISAKMP traps (related to Phase 1 of the IPsec process).

 
      		 [bookmark: pgfId-545715]IPsec traps (related to Phase 2 of the IPsec process).

 
      		 [bookmark: pgfId-545717]Other traps (includes syslog messages, protocol-related notifications, and CPU usage warnings).

 
     

 
     [bookmark: pgfId-545722]See Table 62-32 for a description of the available traps.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-545727]Note You must add command-line interface (CLI) commands to fully implement the IP multicast and CPU traps. One method available for entering these commands is by using FlexConfigs. See Chapter 7, “Managing FlexConfigs”.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-545729]Tip Click Select All to enable all traps displayed in the dialog box or Deselect All to disable all the traps.


     
      

     

     

 
     [bookmark: pgfId-545731]Step 4 Click OK to save your definitions locally on the client and close the dialog box.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-545736]Tip To configure SNMP traps not included in this dialog box, define a FlexConfig. See Chapter 7, “Managing FlexConfigs” for more information.


     
      

     

     

 
     [bookmark: pgfId-545738]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-545750][bookmark: 142164][bookmark: rtpage_cncpt_SNMPPolicyPage]SNMP Policy Page[bookmark: marker-545746][bookmark: marker-545748]

 
    [bookmark: pgfId-545752]Use the SNMP page to configure the parameters necessary to send traps from the router to a designated SNMP host. These traps are unsolicited messages that notify the SNMP host of important events occurring on the router.

 
    [bookmark: pgfId-545757]For more information, see Defining SNMP Agent Properties.

 
    [bookmark: pgfId-545759]Navigation Path

 
     
     		 [bookmark: pgfId-545761](Device view) Select  Platform > Device Admin > Device Access > SNMP from the Policy selector.

 
     		 [bookmark: pgfId-545763](Policy view) Select  Router Platform > Device Admin > Device Access > SNMP from the Policy Type selector. Right-click  SNMP to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-545765]Related Topics

 
     
     		 [bookmark: pgfId-545770]SNMP on Cisco IOS Routers

 
     		 [bookmark: pgfId-545775]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-545780]Filtering Tables

 
    

 
    [bookmark: pgfId-545782]Field Reference

 
    [bookmark: pgfId-545785] 

 
     
      
       
       [bookmark: pgfId-540449]Table 62-29 [bookmark: 142203]SNMP Page 

 
       
      
        
        		
          
          [bookmark: pgfId-540455]Element
         
  
        		
          
          [bookmark: pgfId-540457]Description
         
  
       

 
        
        		 [bookmark: pgfId-540463]Permissions table

  
       

 
        
        		[bookmark: pgfId-540471]Community String

  
        		[bookmark: pgfId-540473]The community string used for accessing the router’s MIB.

  
       

 
        
        		[bookmark: pgfId-540479]Type

  
        		[bookmark: pgfId-540481]The community string type—read-only or read-write.

  
       

 
        
        		[bookmark: pgfId-540487]ACL

  
        		[bookmark: pgfId-540489]The standard ACL that defines the IP addresses permitted to access the router’s MIB.

  
       

 
        
        		[bookmark: pgfId-540495]Add button

  
        		[bookmark: pgfId-540500]Opens the Permission Dialog Box. From here you can enter the community string and type required to generate traps.

  
       

 
        
        		[bookmark: pgfId-540506]Edit button

  
        		[bookmark: pgfId-540511]Opens the Permission Dialog Box. From here you can edit the selected permissions profile.

  
       

 
        
        		[bookmark: pgfId-540517]Delete button

  
        		[bookmark: pgfId-540519]Deletes the selected permissions profiles from the table.

  
       

 
        
        		 [bookmark: pgfId-540525]Trap Receiver table

  
       

 
        
        		[bookmark: pgfId-540533]Host IP Address

  
        		[bookmark: pgfId-540535]The IP address of the SNMP host receiving the traps generated by the router.

  
       

 
        
        		[bookmark: pgfId-540541]SNMP Version

  
        		[bookmark: pgfId-540543]The SNMP version being used by the router.

  
       

 
        
        		[bookmark: pgfId-540549]UDP Port

  
        		[bookmark: pgfId-540551]The UDP port that is being used by the SNMP host.

  
       

 
        
        		[bookmark: pgfId-540557]Add button

  
        		[bookmark: pgfId-540562]Opens the Trap Receiver Dialog Box. From here you can define the SNMP host that receives the traps generated by the router.

  
       

 
        
        		[bookmark: pgfId-540568]Edit button

  
        		[bookmark: pgfId-540573]Open the Trap Receiver Dialog Box. From here you can edit the selected SNMP host.

  
       

 
        
        		[bookmark: pgfId-540579]Delete button

  
        		[bookmark: pgfId-540581]Deletes the selected SNMP hosts from the table.

  
       

 
        
        		 [bookmark: pgfId-540587]Additional fields and buttons

  
       

 
        
        		[bookmark: pgfId-540595]SNMP Server Properties

  
        		[bookmark: pgfId-540597]The name and contact information of the system administrator responsible for the SNMP server/agent (that is, the router). The person managing the SNMP host can use this information when tracking down the source of unusual events.

 [bookmark: pgfId-540599]The maximum length of each of these properties is 255 characters, including spaces.

 [bookmark: pgfId-540601]Note The values entered in these fields are text-only and do not affect the operation of the router.

  
       

 
        
        		[bookmark: pgfId-540607]Configure Traps button

  
        		[bookmark: pgfId-540612]Opens a dialog box for selecting which SNMP traps the router should generate. See SNMP Traps Dialog Box.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-545797][bookmark: 142302][bookmark: rtpage_cncpt_PermissionDialogBox]Permission Dialog Box[bookmark: marker-545793][bookmark: marker-545795]

 
     [bookmark: pgfId-545799]Use the Permission dialog box to define the community string and string type required by the SNMP policy. The community string is an embedded password for accessing the Management Information Base (MIB) that stores operational data about the router.

 
     [bookmark: pgfId-545801]Navigation Path

 
     [bookmark: pgfId-545806]Go to SNMP Policy Page, then click the Add or Edit button beneath the Permissions table.

 
     [bookmark: pgfId-545808]Related Topics

 
      
      		 [bookmark: pgfId-545813]SNMP Policy Page

 
      		 [bookmark: pgfId-545818]Trap Receiver Dialog Box

 
      		 [bookmark: pgfId-545823]SNMP Traps Dialog Box

 
      		 [bookmark: pgfId-545828]Defining SNMP Agent Properties

 
      		 [bookmark: pgfId-545833]SNMP on Cisco IOS Routers

 
     

 
     [bookmark: pgfId-545835]Field Reference

 
     [bookmark: pgfId-545838] 

 
      
       
        
        [bookmark: pgfId-540625]Table 62-30 [bookmark: 142341]Permission Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-540631]Element
          
  
         		
           
           [bookmark: pgfId-540633]Description
          
  
        

 
         
         		[bookmark: pgfId-540639]Community String

  
         		[bookmark: pgfId-540641]The community string for accessing the router’s MIB. String length ranges from 1 to 128 characters.

  
        

 
         
         		[bookmark: pgfId-540647]Access Control Lists

  
         		[bookmark: pgfId-540649]Applies only to routers running Cisco IOS Software Release 12.3(2)T and up (T-train) or any 12.4 version.

 [bookmark: pgfId-540651]The standard ACL containing the IP addresses that can access the router’s MIB. Defining an ACL provides an additional layer of security by limiting the source addresses that can make use of the community string.

 [bookmark: pgfId-540653]Enter the name of a standard ACL object, or click Select to select the object from a list or to create a new one.

  
        

 
         
         		[bookmark: pgfId-540659]Read-Write

  
         		[bookmark: pgfId-540661]This community string type provides read-write access to all objects in the MIB (except community strings).

  
        

 
         
         		[bookmark: pgfId-540667]Read-Only

  
         		[bookmark: pgfId-540669]This community string type provides read-only access to all objects in the MIB (except community strings). This is the default.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-545850][bookmark: 142375][bookmark: rtpage_cncpt_TrapReceiverDialogBox]Trap Receiver Dialog Box[bookmark: marker-545846][bookmark: marker-545848]

 
     [bookmark: pgfId-545852]Use the Trap Receiver dialog box to define the SNMP hosts that receive traps generated by the router. This includes defining the version of SNMP to use.

 
     [bookmark: pgfId-545854]Navigation Path

 
     [bookmark: pgfId-545859]Go to the SNMP Policy Page, then click the Add or Edit button beneath the Trap Receiver table.

 
     [bookmark: pgfId-545861]Related Topics

 
      
      		 [bookmark: pgfId-545866]SNMP Policy Page

 
      		 [bookmark: pgfId-545871]Permission Dialog Box

 
      		 [bookmark: pgfId-545876]SNMP Traps Dialog Box

 
      		 [bookmark: pgfId-545881]Defining SNMP Agent Properties

 
      		 [bookmark: pgfId-545886]SNMP on Cisco IOS Routers

 
     

 
     [bookmark: pgfId-545888]Field Reference

 
     [bookmark: pgfId-545891] 

 
      
       
        
        [bookmark: pgfId-540682]Table 62-31 [bookmark: 142414]Trap Receiver Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-540688]Element
          
  
         		
           
           [bookmark: pgfId-540690]Description
          
  
        

 
         
         		[bookmark: pgfId-540696]Host IP Address

  
         		[bookmark: pgfId-540698]The IP address of the SNMP host receiving the traps generated by the router. Enter an IP address or the name of a network/host object, or click Select to select the object from a list or to create a new one.

  
        

 
         
         		[bookmark: pgfId-540704]SNMP Version

  
         		[bookmark: pgfId-540706]The version of SNMP to use—version 1, version 2c, or version 3.

  
        

 
         
         		[bookmark: pgfId-540712]Community String

  
         		[bookmark: pgfId-540714]Applies only when version 1 or version 2c is selected.

 [bookmark: pgfId-540716]The password required to access the SNMP host. Enter the string again in the Confirm field.

 [bookmark: pgfId-540718]Note We recommend that you use one of the strings defined in the Permissions table as the password to the SNMP host. You may, however, enter a different password. String length ranges from 1 to 128 characters. Your entry does not appear in the Permissions table and is read-only.

  
        

 
         
         		[bookmark: pgfId-540724]User Name

  
         		[bookmark: pgfId-540726]Applies only when version 3 is selected.

 [bookmark: pgfId-540728]The password required to access the SNMP host. Enter the string again in the Confirm field.

 [bookmark: pgfId-540730]Note We recommend that you use one of the strings defined in the Permissions table as the password to the SNMP host. You may, however, enter a different password. String length ranges from 1 to 128 characters. Your entry does not appear in the Permissions table and is read-only.

  
        

 
         
         		[bookmark: pgfId-540736]SNMPv3 Security

  
         		[bookmark: pgfId-540738]Applies only when version 3 is selected.

 [bookmark: pgfId-540740]The level of security to apply to SNMP traffic:

 
           
           		 [bookmark: pgfId-540742]No MD5, No DES—No packet authentication.

 
           		 [bookmark: pgfId-540744]MD5 (auth)—MD5 authentication, but no encryption.

 
           		 [bookmark: pgfId-540746]DES (priv)—MD5 authentication and DES encryption.

 
          

  
        

 
         
         		[bookmark: pgfId-540752]UDP Port

  
         		[bookmark: pgfId-540754]The port number for the SNMP host. The default is 162. Valid values range from 0 to 65535.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-545903][bookmark: 142468][bookmark: rtpage_cncpt_SNMPTrapsDialogBox]SNMP Traps Dialog Box[bookmark: marker-545899][bookmark: marker-545901]

 
     [bookmark: pgfId-545905]Use the SNMP Traps dialog box to select the events in the router that should generate SNMP traps. To lessen possible degradation of system performance, select only those traps that are needed for network monitoring purposes.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-545910]Tip You can configure SNMP traps not included in this dialog box by defining FlexConfigs. For more information, see Understanding FlexConfig Policies and Policy Objects.


     
      

     

     

 
     [bookmark: pgfId-545912]Navigation Path

 
     [bookmark: pgfId-545917]Go to the SNMP Policy Page, then click Configure Traps.

 
     [bookmark: pgfId-545919]Related Topics

 
      
      		 [bookmark: pgfId-545924]SNMP Policy Page

 
      		 [bookmark: pgfId-545929]Permission Dialog Box

 
      		 [bookmark: pgfId-545934]Trap Receiver Dialog Box

 
      		 [bookmark: pgfId-545939]Enabling SNMP Traps

 
      		 [bookmark: pgfId-545944]SNMP on Cisco IOS Routers

 
     

 
     [bookmark: pgfId-545946]Field Reference

 
     [bookmark: pgfId-545949] 

 
      
       
        
        [bookmark: pgfId-540767]Table 62-32 [bookmark: 142508]SNMP Traps Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-540773]Element
          
  
         		
           
           [bookmark: pgfId-540775]Description
          
  
        

 
         
         		[bookmark: pgfId-540781]Standard SNMP Traps

  
         		[bookmark: pgfId-540783]Enables or disables standard SNMP traps. Options are:

 
           
           		 [bookmark: pgfId-540785]Cold start—Sends a trap when the router reinitializes in a way that could change the configuration of the SNMP agent (or any other trap-receiving entity).

 
           		 [bookmark: pgfId-540787]Warm start—Sends a trap when the router reinitializes in a way that does not change the configuration of the SNMP agent (or any other trap-receiving entity).

 
           		 [bookmark: pgfId-540789]Authentication—Sends a trap if an SNMP request from the SNMP host fails because of an invalid community string.

 
          

  
        

 
         
         		[bookmark: pgfId-540795]IPsec Traps

  
         		[bookmark: pgfId-540797]Enables or disables individual IPsec-related traps. Options are:

 
           
           		 [bookmark: pgfId-540799]Cryptomap—Sends a trap when a crypto map entry is added to, or removed from, the device’s crypto map set. Additionally, this option sends a trap when a crypto map set is attached to, or detached from, an active interface.

 
           		 [bookmark: pgfId-540801]Too Many SAs—Sends a trap if an attempt is made to create a security association (SA) when there is insufficient memory on the device.

 
           		 [bookmark: pgfId-540803]Tunnel—Sends a trap when an IPsec Phase 2 tunnel becomes active or inactive.

 
          

 [bookmark: pgfId-540808]For more information, see Understanding IPsec Proposals for Site-to-Site VPNs.

  
        

 
         
         		[bookmark: pgfId-540814]ISAKMP Traps

  
         		[bookmark: pgfId-540816]Enables or disables individual Internet Security Association and Key Exchange Protocol (ISAKMP) traps. Options are:

 
           
           		 [bookmark: pgfId-540818]Policy—Sends a trap when an ISAKMP policy is created or deleted.

 
           		 [bookmark: pgfId-540820]Tunnel—Sends a trap when a Phase 1 IKE tunnel becomes active or inactive.

 
          

 [bookmark: pgfId-540825]For more information, see Understanding IKE.

  
        

 
         
         		[bookmark: pgfId-540831]Other Traps

  
         		[bookmark: pgfId-540833]Enables or disables additional SNMP traps. Options are:

 
           
           		 [bookmark: pgfId-540835]Syslog—Sends syslog messages to the SNMP host.

 
           		 [bookmark: pgfId-540837]TTY—Sends Cisco-specific notifications when a Transmission Control Protocol (TCP) connection closes.

 
           		 [bookmark: pgfId-540842]BGP—Sends notifications when Border Gateway Protocol (BGP) state changes occur. See BGP Routing on Cisco IOS Routers.

 
           		 [bookmark: pgfId-540844]IP Multicast—(Applicable to multicast routers only) Sends a trap if the router fails to receive a defined number of heartbeat packets from heartbeat sources within a defined time interval.

 
          

 [bookmark: pgfId-540846]If you select IP Multicast, you must also manually configure the ip multicast heartbeat command on the device to configure the multicast address and heartbeat limits. You can use FlexConfigs to do this.

 
           
           		 [bookmark: pgfId-540848]CPU—Sends a trap when CPU usage rises and remains above an upper threshold or falls and remains below a lower threshold.

 
          

 [bookmark: pgfId-540850]If you select CPU, you must also manually configure the process cpu threshold type command on the device to configure the thresholds. You can use FlexConfigs to do this.

 
           
           		 [bookmark: pgfId-540852]HSRP—Sends Hot Standby Routing Protocol (HSRP) notifications.

 
          

  
        

 
         
         		[bookmark: pgfId-540858]Select All button

  
         		[bookmark: pgfId-540860]Enables all the SNMP traps displayed in the dialog box.

  
        

 
         
         		[bookmark: pgfId-540866]Deselect All button

  
         		[bookmark: pgfId-540868]Disables all the SNMP traps displayed in the dialog box.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-545961][bookmark: 142591][bookmark: rtchap_cncpt_DNSonCiscoIOSRouters]DNS on Cisco IOS Routers[bookmark: marker-545955][bookmark: marker-545957][bookmark: marker-545959]

 
    [bookmark: pgfId-545963]The Domain Name System (DNS) is a distributed database in which you can map hostnames to IP addresses through the DNS protocol from a DNS server. Each unique IP address can have an associated hostname. DNS is what makes it possible to connect to hosts without having to know the 32-bit IP address of that host. The DNS server takes the provided hostname and translates it into the appropriate IP address.

 
    [bookmark: pgfId-545965]In addition to the translation provided by remote DNS servers, you can configure Cisco IOS routers with a local host table containing static mappings of hosts to IP addresses. When commands such as connect, telnet, and ping are used, the router checks this host table before querying the DNS servers, which speeds the translation process.

 
    [bookmark: pgfId-545967]By default, the DNS feature is enabled on all Cisco IOS routers.

 
    [bookmark: pgfId-545969]Related Topics

 
     
     		 [bookmark: pgfId-545974]Defining DNS Policies

 
    

 
     
      [bookmark: pgfId-545982][bookmark: 142613][bookmark: rtchap_proc_DefiningDNSPolicies]Defining DNS Policies[bookmark: marker-545980]

 
     [bookmark: pgfId-545984]When you define a DNS policy in Security Manager, you can specify the remote DNS servers used by the router for hostname-to-address translations. In addition, you can define a static host table that contains local translations used exclusively by this device. Having selected addresses in this type of cache can speed the translation process by eliminating the need to query the DNS servers.

 
     [bookmark: pgfId-545986]Related Topics

 
      
      		 [bookmark: pgfId-545991]DNS on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-545993]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-545995](Device view) Select  Platform > Device Admin > DNS from the Policy selector.

 
      		 [bookmark: pgfId-545997](Policy view) Select  Router Platform > Device Admin > DNS from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-546002]The DNS page is displayed. See Table 62-33 for a description of the fields on this page.

 
     [bookmark: pgfId-546007]Step 2 In the Servers field, enter the addresses of the DNS servers (up to 6) that can perform hostname-to-address translations for the router. You can use a combination of addresses and network/host objects, or click Select to display a selector. For more information, see Specifying IP Addresses During Policy Definition.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-546012]Tip If the network you want is not listed in the selector, click the Create button or the Edit button in the selector to display the Add or Edit Network/Host Dialog Box. From here you can create a network/host object to use in the policy.


     
      

     

     

 
     [bookmark: pgfId-546014]Step 3 (Optional) In the Hosts field, enter the static host mappings that you want to define in the router’s host table:

 
     [bookmark: pgfId-546021] a. [bookmark: 142647]Click Add to display the IP Host Dialog Box.

 
     [bookmark: pgfId-546023] b. Enter the hostname to translate.

 
     [bookmark: pgfId-546025] c. Enter up to three addresses or network/host objects, or click Select to display a selector. These are the addresses to which the router translates the hostname.

 
     [bookmark: pgfId-546029] d. [bookmark: 142656]Click OK. The mapping is displayed in the Hosts field on the DNS page.

 
     [bookmark: pgfId-546037] e. Repeat a. through d. to add more hosts to the host table.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-546039]Note To edit a host mapping, select the definition from the Hosts field, then click Edit. To remove a host mapping, select it, then click Delete.


     
      

     

     

 
     [bookmark: pgfId-546041]Step 4 (Optional) Deselect the Domain Lookup check box to disable DNS functionality on the router.

 
     [bookmark: pgfId-546043]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-546055][bookmark: 142675][bookmark: rtpage_cncpt_DNSPolicyPage]DNS Policy Page[bookmark: marker-546051][bookmark: marker-546053]

 
    [bookmark: pgfId-546057]Use the DNS policy page to define the local IP host table and the Domain Name System (DNS) servers that the router should use for translating hostnames to IP addresses. You can also prevent the router from performing DNS lookups by disabling the DNS feature.

 
    [bookmark: pgfId-546059]Navigation Path

 
     
     		 [bookmark: pgfId-546061](Device view) Select  Platform > Device Admin > DNS from the Policy selector.

 
     		 [bookmark: pgfId-546063](Policy view) Select  Router Platform > Device Admin > DNS from the Policy Type selector. Right-click  DNS to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-546065]Related Topics

 
     
     		 [bookmark: pgfId-546070]DNS on Cisco IOS Routers

 
    

 
    [bookmark: pgfId-546072]Field Reference

 
    [bookmark: pgfId-546075] 

 
     
      
       
       [bookmark: pgfId-540881]Table 62-33 [bookmark: 142705]DNS Page 

 
       
      
        
        		
          
          [bookmark: pgfId-540887]Element
         
  
        		
          
          [bookmark: pgfId-540889]Description
         
  
       

 
        
        		[bookmark: pgfId-540895]Servers

  
        		[bookmark: pgfId-540897]The DNS servers used by the router to perform DNS lookups. Enter one or more addresses or network/host objects, or click Select to select an object from a list or to create a new one. You can define a maximum of six DNS servers.

  
       

 
        
        		[bookmark: pgfId-540903]Hosts

  
        		[bookmark: pgfId-540905]The local host table configured on the router. When a user types in a hostname, the router checks this table first before querying the DNS servers defined in the Servers field.

 [bookmark: pgfId-540910]Click Add to display the IP Host Dialog Box. From here you can define a hostname and the IP addresses to associate with that hostname.

 .

  
       

 
        
        		[bookmark: pgfId-540918]Domain Lookup

  
        		[bookmark: pgfId-540920]When selected, the router performs lookups on the defined DNS servers. This is the default.

 [bookmark: pgfId-540922]When deselected, lookups on remote DNS servers are disabled.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-546087][bookmark: 142738][bookmark: rtpage_cncpt_IPHostDialogBox]IP Host Dialog Box[bookmark: marker-546083][bookmark: marker-546085]

 
     [bookmark: pgfId-546089]Use the IP Host dialog box to configure the host table on the router. This is the table of static, local mappings that the router uses to translate hostnames to IP addresses. If the router does not find the required entry in the host table, it queries the DNS servers that are defined on the DNS page.

 
     [bookmark: pgfId-546091]Navigation Path

 
     [bookmark: pgfId-546096]Go to the DNS Policy Page, then click Add under Hosts.

 
     [bookmark: pgfId-546098]Related Topics

 
      
      		 [bookmark: pgfId-546103]DNS on Cisco IOS Routers

 
     

 
     [bookmark: pgfId-546105]Field Reference

 
     [bookmark: pgfId-546108] 

 
      
       
        
        [bookmark: pgfId-540935]Table 62-34 [bookmark: 142764]IP Host Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-540941]Element
          
  
         		
           
           [bookmark: pgfId-540943]Description
          
  
        

 
         
         		[bookmark: pgfId-540949]Host Name

  
         		[bookmark: pgfId-540951]The hostname to include in the router’s local host table.

  
        

 
         
         		[bookmark: pgfId-540957]Addresses

  
         		[bookmark: pgfId-540959]The addresses to associate with the hostname. Enter one or more addresses or network/host objects, or click Select to select an object from a list or to create a new object. You can define a maximum of three addresses per hostname.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-546120][bookmark: 142787][bookmark: rtchap_cncpt_HostnamesandDomainNamesonCiscoIOSRouters]Hostnames and Domain Names on Cisco IOS Routers[bookmark: marker-546114][bookmark: marker-546116][bookmark: marker-546118]

 
    [bookmark: pgfId-546125]The Hostname policy configures the hostname and domain name of the selected router. After you deploy this policy, any changes that you made to the hostname and domain name are reflected in the Device Properties page (see Viewing or Changing Device Properties).

 
    [bookmark: pgfId-546127]Related Topics

 
     
     		 [bookmark: pgfId-546132]Defining Hostname Policies

 
    

 
     
      [bookmark: pgfId-546140][bookmark: 142808][bookmark: rtchap_proc_DefiningHostnamePolicies]Defining Hostname Policies[bookmark: marker-546138]

 
     [bookmark: pgfId-546145]When you define a hostname policy, Security Manager updates the hostname and domain name fields in the Device Properties dialog box after deployment. See Viewing or Changing Device Properties.

 
     [bookmark: pgfId-546147]Related Topics

 
      
      		 [bookmark: pgfId-546152]Hostnames and Domain Names on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-546154]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-546156](Device view) Select  Platform > Device Admin > Hostname from the Policy selector.

 
      		 [bookmark: pgfId-546158](Policy view) Select  Router Platform > Device Admin > Hostname from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-546163]The Hostname page is displayed. See Table 62-35 for a description of the fields on this page.

 
     [bookmark: pgfId-546165]Step 2 Enter the hostname for the router. Names must start with a letter, end with a letter or digit, and include only letters, digits, and hyphens. The maximum length is 63 characters.

 
     [bookmark: pgfId-546167]Step 3 Enter the domain name for the router. The router uses this domain name for RSA key generation and in policies when you do not enter the fully-qualified domain name.

 
     [bookmark: pgfId-546169]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-546181][bookmark: 142842][bookmark: rtpage_cncpt_HostnamePolicyPage]Hostname Policy Page[bookmark: marker-546177][bookmark: marker-546179]

 
    [bookmark: pgfId-546186]Use the Hostname page to define the hostname and domain name assigned to the router. For more information, see Defining Hostname Policies.

 
    [bookmark: pgfId-546188]Navigation Path

 
     
     		 [bookmark: pgfId-546190](Device view) Select  Platform > Device Admin > Hostname from the Policy selector.

 
     		 [bookmark: pgfId-546192](Policy view) Select  Router Platform > Device Admin > Hostname from the Policy Type selector. Right-click  Hostname to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-546194]Related Topics

 
     
     		 [bookmark: pgfId-546199]Hostnames and Domain Names on Cisco IOS Routers

 
    

 
    [bookmark: pgfId-546201]Field Reference

 
    [bookmark: pgfId-546204] 

 
     
      
       
       [bookmark: pgfId-540972]Table 62-35 [bookmark: 142873]Hostname Page 

 
       
      
        
        		
          
          [bookmark: pgfId-540978]Element
         
  
        		
          
          [bookmark: pgfId-540980]Description
         
  
       

 
        
        		[bookmark: pgfId-540986]Host Name

  
        		[bookmark: pgfId-540988]The hostname of the router.

 [bookmark: pgfId-540990]Names must start with a letter, end with a letter or digit, and include only letters, digits, and hyphens. The maximum length is 63 characters.

  
       

 
        
        		[bookmark: pgfId-540996]Domain Name

  
        		[bookmark: pgfId-540998]The default domain name of the router. The maximum length is 63 characters.

 [bookmark: pgfId-541000]The router uses this domain name for RSA key generation and in policies when you do not enter the fully-qualified domain name (FQDN).

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-546216][bookmark: 142896][bookmark: rtchap_cncpt_MemorySettingsonCiscoIOSRouters]Memory Settings on Cisco IOS Routers[bookmark: marker-546210][bookmark: marker-546212][bookmark: marker-546214]

 
    [bookmark: pgfId-546218]The Memory policy configures settings relating to router memory. This policy provides you with methods for monitoring memory consumption, including the ability to generate notification messages when available memory drops below predefined thresholds.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-546220]Note The Memory policy is supported on routers running Cisco IOS Software Release 12.3(14)T or later.


    
     

    

    

 
    [bookmark: pgfId-546222]Related Topics

 
     
     		 [bookmark: pgfId-546227]Defining Router Memory Settings

 
    

 
     
      [bookmark: pgfId-546235][bookmark: 142917][bookmark: rtchap_proc_DefiningRouterMemorySettings]Defining Router Memory Settings[bookmark: marker-546233]

 
     [bookmark: pgfId-546237]You can use Security Manager to modify the following default memory settings:

 
      
      		 [bookmark: pgfId-546239]The number of hours that the router maintains the log of memory consumption.

 
      		 [bookmark: pgfId-546241]Whether to enable the Memory Allocation Lite feature.

 
      		 [bookmark: pgfId-546243]The amount of memory to reserve for critical system log messages.

 
     

 
     [bookmark: pgfId-546245]In addition, you can define:

 
      
      		 [bookmark: pgfId-546247]The lower thresholds for processor and I/O memory. Log messages are sent when available memory drops below these thresholds.

 
      		 [bookmark: pgfId-546249]The types of sanity checks to perform.

 
     

 
     [bookmark: pgfId-546251]Related Topics

 
      
      		 [bookmark: pgfId-546256]Memory Settings on Cisco IOS Routers

 
      		 [bookmark: pgfId-546261]Logging on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-546263]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-546265](Device view) Select  Platform > Device Admin > Memory from the Policy selector.

 
      		 [bookmark: pgfId-546267](Policy view) Select  Router Platform > Device Admin > Memory from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-546269]The Memory page is displayed.

 
     [bookmark: pgfId-546274]Step 2 (Optional) Define the memory settings of the router, as required. See Table 62-36 for a description of the available fields.

 
     [bookmark: pgfId-546276]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-546288][bookmark: 142964][bookmark: rtpage_cncpt_MemoryPolicyPage]Memory Policy Page[bookmark: marker-546284][bookmark: marker-546286]

 
    [bookmark: pgfId-546290]Use the Memory page to define settings related to router memory, including:

 
     
     		 [bookmark: pgfId-546292]The amount of time to retain the memory log.

 
     		 [bookmark: pgfId-546294]The thresholds for available processor and I/O memory.

 
     		 [bookmark: pgfId-546296]The amount of memory reserved for critical log messages.

 
     		 [bookmark: pgfId-546298]Whether to perform sanity checks on buffers and queues.

 
     		 [bookmark: pgfId-546300]Whether to enable the “memory-allocation lite” feature.

 
    

 
    [bookmark: pgfId-546305]For more information, see Defining Router Memory Settings.

 
    [bookmark: pgfId-546307]Navigation Path

 
     
     		 [bookmark: pgfId-546309](Device view) Select  Platform > Device Admin > Memory from the Policy selector.

 
     		 [bookmark: pgfId-546311](Policy view) Select  Router Platform > Device Admin > Memory from the Policy Type selector. Right-click  Memory to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-546313]Related Topics

 
     
     		 [bookmark: pgfId-546318]Memory Settings on Cisco IOS Routers

 
     		 [bookmark: pgfId-546323]CPU Policy Page

 
     		 [bookmark: pgfId-546328]Syslog Logging Setup Policy Page

 
     		 [bookmark: pgfId-546333]Syslog Servers Policy Page

 
    

 
    [bookmark: pgfId-546335]Field Reference

 
    [bookmark: pgfId-546338] 

 
     
      
       
       [bookmark: pgfId-541013]Table 62-36 [bookmark: 143015]Memory Page 

 
       
      
        
        		
          
          [bookmark: pgfId-541019]Element
         
  
        		
          
          [bookmark: pgfId-541021]Description
         
  
       

 
        
        		[bookmark: pgfId-541027]Maintain Memory Log

  
        		[bookmark: pgfId-541029]The number of hours that the router should maintain the log containing the history of memory consumption on the device. Valid values range from 12 to 72 hours. The default is 24 (1 day).

 [bookmark: pgfId-541031]Note The memory log is enabled by default and cannot be disabled.

  
       

 
        
        		[bookmark: pgfId-541037]Processor Threshold

  
        		[bookmark: pgfId-541039]The processor memory threshold in kilobytes. When available processor memory falls below this threshold, a notification message is triggered. Valid values range from 1 to 4294967295 kilobytes (4096 gigabytes).

 [bookmark: pgfId-541041]Note Another notification message is generated when available free memory rises to 5% above the threshold.

  
       

 
        
        		[bookmark: pgfId-541047]I/O Threshold

  
        		[bookmark: pgfId-541049]The I/O memory threshold in kilobytes. When available processor memory falls below this threshold, a notification message is triggered. Valid values range from 1 to 4294967295 kilobytes (4096 gigabytes).

 [bookmark: pgfId-541051]Note Another notification message is generated when available free memory rises to 5% above the threshold.

  
       

 
        
        		[bookmark: pgfId-541059][bookmark: marker-541057] Memory Allocation Lite

  
        		[bookmark: pgfId-541061]When selected, the “memory-allocation lite” (malloc_lite) feature on the router is enabled. This feature avoids excessive memory allocation overhead for situations where less than 128 bytes are required. This is the default.

 [bookmark: pgfId-541063]When deselected, the “memory-allocation lite” feature is disabled.

 [bookmark: pgfId-541065]Note This feature is supported for processor memory pools only.

  
       

 
        
        		[bookmark: pgfId-541071]Memory Region For Critical Notifications

  
        		[bookmark: pgfId-541073]The amount of memory (in kilobytes) reserved for critical system log messages. Valid values range from 1 to 4294967295 kilobytes (4096 gigabytes), but the value you specify cannot exceed 25% of total memory.

 [bookmark: pgfId-541075]This option reserves a region of memory on the router so that the router can issue critical system log messages even when system resources are overloaded.

  
       

 
        
        		[bookmark: pgfId-541081]Perform Sanity Checks

  
        		[bookmark: pgfId-541083]The types of sanity checks to perform:

 
          
          		 [bookmark: pgfId-541085]Buffer—When selected, performs sanity checks on all buffers. Sanity checks are performed when a packet buffer is allocated and when the packet buffer is returned to the buffer pool.

 
          		 [bookmark: pgfId-541087]Queue—When selected, performs sanity checks on all queues.

 
          		 [bookmark: pgfId-541089]All—When selected, performs sanity checks on all buffers and queues.

 
         

 [bookmark: pgfId-541091]Note Enabling any of these options may result in a slight degradation of router performance.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-546350][bookmark: 143072][bookmark: rtchap_cncpt_SecureDeviceProvisioningonCiscoIOSRouters]Secure Device Provisioning on Cisco IOS Routers[bookmark: marker-546344][bookmark: marker-546346][bookmark: marker-546348]

 
    [bookmark: pgfId-546352]Secure Device Provisioning (SDP) offers an integrated solution for streamlining VPN and network security deployment. SDP (previously called Easy Secure Device Deployment, or EzSDD) enables remote-site users to securely bootstrap their VPN device through an easy-to-use web interface, thereby easing the deployment burden, lowering costs, and shortening the network development cycle. For example, a telecommuter or small branch office user can remove a new device from its shipping package, plug it in, open a simple web management interface, and establish VPN connectivity, all within a period of just a few minutes.

 
    [bookmark: pgfId-546354]For more information about SDP, see Setting Up Secure Device Provisioning (SDP) for Enrollment in a PKI, which can be found in Cisco IOS Security Configuration Guide, Release 12.4T.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-546356]Note SDP requires Cisco IOS Software Release 12.3(8)T or later. Attempting to deploy this policy to a router running an earlier version could result in deployment failure. You also cannot configure the policy on NO-VPN router models (those that do not allow VPN configurations, such as the 3845 NOVPN).


    
     

    

    

 
    [bookmark: pgfId-546365][bookmark: marker-546358][bookmark: marker-546360] Trusted Transitive Introduction (TTI) is the protocol that acts as the primary mechanism for implementing SDP. As shown in Figure 62-3, TTI comprises the following three entities:

 
     
     		 [bookmark: pgfId-546372][bookmark: marker-546367] Introducer—A mutually trusted device that introduces the petitioner to the registrar. Introducers can be end users who use SDP to deploy VPN devices associated with themselves to the PKI network, or an administrator/management system that uses SDP to deploy many VPN devices to the PKI network. This latter type is known as an administrative introducer. For more information, see Configuring a AAA Server Group for Administrative Introducers.

 
     		 [bookmark: pgfId-546376][bookmark: marker-546374] Petitioner—A remote-site device that is joined to the secure domain. The petitioner serves web pages to the introducer and receives the bootstrap configuration from the introducer’s web browser. The petitioner component is enabled by default on all Cisco IOS devices.

 
     		 [bookmark: pgfId-546380][bookmark: marker-546378] Registrar—A server that authorizes the petitioner by communicating directly with an authentication, authorization, and accounting (AAA) server to verify user credentials, permit or deny enrollment, and retrieve user-specific configuration information.

 
    

 
    [bookmark: pgfId-546382]Use the SDP policy in Security Manager to configure the router as a registrar.

 
    [bookmark: pgfId-546386]Figure 62-3 [bookmark: 143119]Secure Device Provisioning

 
    [bookmark: pgfId-546389] 

 
     
     [image: ] 
    
 
    [bookmark: pgfId-546391]For more information about Secure Device Provisioning, see:

 
     
     		 [bookmark: pgfId-546396]Contents of Bootstrap Configuration

 
     		 [bookmark: pgfId-546401]Secure Device Provisioning Workflow

 
     		 [bookmark: pgfId-546406]Defining Secure Device Provisioning Policies

 
    

 
     
      [bookmark: pgfId-546414][bookmark: 143133][bookmark: rtchap_cncpt_ContentsofBootstrapConfiguration]Contents of Bootstrap Configuration[bookmark: marker-546412]

 
     [bookmark: pgfId-546416]The bootstrap configuration provided by SDP typically does the following:

 
      
      		 [bookmark: pgfId-546418]Sets the petitioner’s hostname.

 
      		 [bookmark: pgfId-546420]Synchronizes the petitioner’s system clock with the registrar.

 
      		 [bookmark: pgfId-546422]Sets the petitioner’s trustpoint.

 
      		 [bookmark: pgfId-546424]Sets the petitioner’s authentication and authorization mechanism.

 
      		 [bookmark: pgfId-546426]Pushes the CA certificate.

 
      		 [bookmark: pgfId-546428]Enrolls the petitioner with the PKI server.

 
      		 [bookmark: pgfId-546430]Sets other VPN configurations, such as the configuration required to establish a management tunnel.

 
      		 [bookmark: pgfId-546432]Sets Cisco Networking Services (CNS) configuration.

 
      		 [bookmark: pgfId-546434]Sets the petitioner’s DHCP pool.

 
     

 
     [bookmark: pgfId-546436]Related Topics

 
      
      		 [bookmark: pgfId-546441]Secure Device Provisioning Workflow

 
      		 [bookmark: pgfId-546446]Secure Device Provisioning on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-546454][bookmark: 143168][bookmark: rtchap_cncpt_SecureDeviceProvisioningWorkflow]Secure Device Provisioning Workflow[bookmark: marker-546452]

 
     [bookmark: pgfId-546456]The following illustrates the steps required to use SDP to register a remote-site device in a secure network:

 
     [bookmark: pgfId-546458] 1. Unpack the router and connect the power, LAN, and WAN cables.

 
     [bookmark: pgfId-546460] 2. Turn on a computer (introducer) that is assigned an IP address from the DHCP server on the router, open a web browser, and go to the petitioner URL (http://device/ezsdd/welcome) on the router. The router responds with a registration page (also called the local login dialog box).

 
     [bookmark: pgfId-546462] 3. Enter the username and password, then click OK. On the welcome page, enter the URL for the registrar. The following actions occur:

 
     [bookmark: pgfId-546464] a. The browser opens an HTTPS-secured session to the central-site registrar, which verifies the username with the AAA server and returns the appropriate bootstrap configuration to the browser.

 
     [bookmark: pgfId-546466] b. The browser feeds the bootstrap configuration to the remote-site router, configuring PKI trustpoint enrollment and IPsec VPN connectivity, and provisioning system attributes and other information.

 
     [bookmark: pgfId-546468] c. You are notified that bootstrap configuration is complete.

 
     [bookmark: pgfId-546470]Related Topics

 
     [bookmark: pgfId-546475] – Contents of Bootstrap Configuration

 
     [bookmark: pgfId-546480] – Secure Device Provisioning on Cisco IOS Routers

 
    
 
     
      [bookmark: pgfId-546488][bookmark: 143200][bookmark: rtchap_proc_DefiningSecureDeviceProvisioningPolicies]Defining Secure Device Provisioning Policies[bookmark: marker-546486]

 
     [bookmark: pgfId-546490]The petitioner component is automatically enabled on all Cisco IOS routers. The SDP policy in Security Manager enables the registrar. To define an SDP policy you must define:

 
      
      		 [bookmark: pgfId-546492]The AAA server group containing the AAA server that the registrar uses to authenticate and authorize the introducer.

 
      		 [bookmark: pgfId-546494]The CA server to which the petitioner enrolls during the bootstrap process.

 
      		 [bookmark: pgfId-546496]The location of the introduction page that is displayed after authorization was performed.

 
      		 [bookmark: pgfId-546498]The location of the bootstrap configuration to be provided to the petitioner.

 
     

 
     [bookmark: pgfId-546500]Related Topics

 
      
      		 [bookmark: pgfId-546505]Secure Device Provisioning Workflow

 
      		 [bookmark: pgfId-546510]Configuring a AAA Server Group for Administrative Introducers

 
      		 [bookmark: pgfId-546515]Secure Device Provisioning on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-546517]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-546519](Device view) Select  Platform > Device Admin > Secure Device Provisioning from the Policy selector.

 
      		 [bookmark: pgfId-546521](Policy view) Select  Router Platform > Device Admin > Secure Device Provisioning from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-546526]The Secure Device Provisioning page is displayed. See Table 62-37 for a description of the fields on this page.

 
     [bookmark: pgfId-546528]Step 2 Under Introducer Authentication, enter the name of the AAA server group containing the relevant AAA server, or click Select to select it from a list or to create a new object.

 
     [bookmark: pgfId-546530]The selected AAA server determines whether the username and password supplied by the introducer represent an authorized user. The AAA server must use TACACS+, RADIUS, or be local.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-546535]Note Each AAA server in the selected group must be configured to communicate with an interface that exists on the router; otherwise, validation fails. If you want to configure a different AAA server group for authenticating and authorizing administrative introducers, see Configuring a AAA Server Group for Administrative Introducers.


     
      

     

     

 
     [bookmark: pgfId-546537]Step 3 Under Petitioner Authentication, define the CA server that authenticates the identity of the petitioner by doing one of the following:

 
      
      		 [bookmark: pgfId-546539]Select  Local CA Server , then enter the local CA name in the field provided. If you have already configured the CA server locally on the registrar, a trustpoint is generated automatically.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-546541]Note If you have not configured the router as the CA server, enter the command Crypto pki server [name] using the CLI or FlexConfigs. This command is mandatory when you deploy an SDP policy configured with a local CA server.


     
      

     

     

 
      
      		 [bookmark: pgfId-546543]Select Remote CA Server, then enter the name of a PKI enrollment object, or click  Select to select it from a list or to create a new object.

 
     

 
     [bookmark: pgfId-546545]The PKI enrollment object defines the external CA server used in the SDP policy.

 
     [bookmark: pgfId-546547]Step 4 Select the source of the introduction page that is displayed after you log in to the registrar. The introduction page indicates whether authorization was successfully completed and contains a button for completing the process of obtaining the bootstrap configuration.

 
     [bookmark: pgfId-546549]If you do not select the default welcome page, you must enter the URL required to access a different welcome page that you prepared elsewhere.

 
     [bookmark: pgfId-546551]Step 5 Select the source of the bootstrap configuration provided to the petitioner to implement its first-time configuration:

 
      
      		 [bookmark: pgfId-546553]If the source of the bootstrap configuration is a non-Security Manager URL, enter the URL and also the username and password for accessing the URL, if required.

 
      		 [bookmark: pgfId-546555]If the source of the configuration file is a Security Manager URL:

 
     

 
     [bookmark: pgfId-546560] – Enter the name of a FlexConfig, or click Select to select it from a list or to create a new object. The FlexConfig contains the device commands required to retrieve the appropriate bootstrap configuration. For more information, see Add or Edit FlexConfig Dialog Box.

 
     [bookmark: pgfId-546562] – Enter the device name formula required by the FlexConfig to derive the device name of the petitioner from the username submitted by the introducer. (The two names typically have a fixed relationship.) The default formula is $n, which uses the introducer name to determine the device name.

 
     [bookmark: pgfId-546564]The device name determines which bootstrap configuration the petitioner should receive. The resulting URL contains the name of the FlexConfig you selected, as well as the parameters and formula you defined.

 
     [bookmark: pgfId-546566] – Enter a username and password for accessing the Security Manager server containing the FlexConfig. The password can contain alphanumeric characters, but cannot consist of a single digit.

 
     [bookmark: pgfId-546568]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-546586][bookmark: 143280][bookmark: rtchap_cncpt_ConfiguringaAAAServerGroupforAdministrativeIntroducers]Configuring a AAA Server Group for Administrative Introducers[bookmark: marker-546574][bookmark: marker-546576][bookmark: marker-546578][bookmark: marker-546580][bookmark: marker-546582][bookmark: marker-546584]

 
     [bookmark: pgfId-546616]For more information about administrative introducers, see Administrative Secure Device Provisioning Introducer on Cisco.com at this URL: http://www.cisco.com/en/US/docs/ios/12_3t/12_3t14/feature/guide/gtadintr.html

 
     [bookmark: pgfId-546618]Related Topics

 
      
      		 [bookmark: pgfId-546623]Secure Device Provisioning on Cisco IOS Routers

 
      		 [bookmark: pgfId-546628]Defining Secure Device Provisioning Policies

 
      		 [bookmark: pgfId-546633]Understanding FlexConfig Policies and Policy Objects

 
     

 
    
 
   
 
    
     [bookmark: pgfId-546645][bookmark: 143332][bookmark: rtpage_cncpt_SecureDeviceProvisioningPolicyPage]Secure Device Provisioning Policy Page[bookmark: marker-546641][bookmark: marker-546643]

 
    [bookmark: pgfId-546647]Secure Device Provisioning (SDP) policies (formerly known as Easy Secure Device Deployment or EzSDD) enable you to configure a Cisco IOS router as a registrar. This is the SDP component that retrieves bootstrap configurations for petitioners, which are remote-site devices that are enrolling in the network security infrastructure. These devices uses the bootstrap configuration for first-time configuration purposes. The registrar also verifies the identity of the introducer, which is the user who introduces the petitioner to the registrar.

 
    [bookmark: pgfId-546652]For more information, see Defining Secure Device Provisioning Policies.

 
    [bookmark: pgfId-546654]Navigation Path

 
     
     		 [bookmark: pgfId-546656](Device view) Select  Platform > Device Admin > Secure Device Provisioning from the Policy selector.

 
     		 [bookmark: pgfId-546658](Policy view) Select  Router Platform > Device Admin > Secure Device Provisioning from the Policy Type selector. Create a new policy or select an existing one.

 
    

 
    [bookmark: pgfId-546660]Related Topics

 
     
     		 [bookmark: pgfId-546665]Secure Device Provisioning on Cisco IOS Routers

 
     		 [bookmark: pgfId-546670]Secure Device Provisioning Workflow

 
     		 [bookmark: pgfId-546675]Understanding AAA Server and Server Group Objects

 
     		 [bookmark: pgfId-546680]Understanding FlexConfig Policies and Policy Objects

 
    

 
    [bookmark: pgfId-546682]Field Reference

 
    [bookmark: pgfId-546685] 

 
     
      
       
       [bookmark: pgfId-541104]Table 62-37 [bookmark: 143374]Secure Device Provisioning Page 

 
       
      
        
        		
          
          [bookmark: pgfId-541110]Element
         
  
        		
          
          [bookmark: pgfId-541112]Description
         
  
       

 
        
        		[bookmark: pgfId-541118]Introducer Authentication (AAA)

  
        		[bookmark: pgfId-541120]The AAA server group that authenticates the username and password supplied by the introducer. Enter the name of a AAA server group object, or click Select to select it from a list or to create a new object.

 [bookmark: pgfId-541125]Note To configure a separate AAA server group for authenticating administrative introducers, see Configuring a AAA Server Group for Administrative Introducers.

  
       

 
        
        		[bookmark: pgfId-541131]Petitioner Authentication

  
        		[bookmark: pgfId-541133]The CA server that authenticates the identity of the petitioner:

 
          
          		 [bookmark: pgfId-541135]Local CA Server—Select this option when the router itself is already configured to act as the CA server. Enter the name of the local CA in the field provided.

 
         

 using the CLI or FlexConfigs. This command is mandatory when you deploy an SDP policy configured with a local CA server.

 
          
          		 [bookmark: pgfId-541142]Remote CA Server—Select this option when using an external CA server. Enter the name of a a PKI enrollment object, or click  Select to select it from a list or to create a new object. For more information about PKI enrollment objects, see PKI Enrollment Dialog Box.

 
         

  
       

 
        
        		[bookmark: pgfId-541148]Introduction Page

  
        		[bookmark: pgfId-541150]The source of the introduction page to display to the introducer after authorization is performed:

 
          
          		 [bookmark: pgfId-541152]Use default introduction page—Uses a default page provided with Security Manager.

 
          		 [bookmark: pgfId-541154]Specify introduction page URL—Uses the introduction page specified in the URL field. Supported protocols include: FTP, HTTP, HTTPS, null, NVRAM, RCP, SCP, system, TFTP, Webflash, and XMODEM.

 
         

  
       

 
        
        		[bookmark: pgfId-541160]Bootstrap Configuration

  
        		[bookmark: pgfId-541162]The source of the bootstrap configuration to provide to the petitioner for first-time configuration:

 
          
          		 [bookmark: pgfId-541164]Non-Security Manager URL—Used when the bootstrap configuration is located externally to Security Manager. Enter its location in the URL field.

 
         

 [bookmark: pgfId-541166]If required, enter a username and password to access the server containing the bootstrap configuration.

 
          
          		 [bookmark: pgfId-541168]Security Manager URL—Used when Security Manager is providing the bootstrap configuration. Enter information in the following fields:

 
         

 [bookmark: pgfId-541170] – FlexConfig—The FlexConfig that contains the basic CLI structure required to create the bootstrap configuration. Enter the name of a FlexConfig object, or click Select to display a selector.

 [bookmark: pgfId-541172]After selecting the FlexConfig, you must enter a username and password to access the Security Manager server that contains the FlexConfig.

 [bookmark: pgfId-541174] – Device name formula—The formula required by Security Manager to determine the device name of the petitioner from the username that the introducer supplied.

 [bookmark: pgfId-541176]Typically a fixed relationship exists between the username and the device name, which enables a formula like this to be established. The default formula is $n, which uses the introducer name to determine the device name. The device name is required to determine the configuration file that the petitioner should receive.

 [bookmark: pgfId-541178]If required, enter a username and password to access the server containing the bootstrap configuration. The password can contain alphanumeric characters, but cannot consist of a single digit.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-546697][bookmark: 143438][bookmark: rtchap_cncpt_DHCPonCiscoIOSRouters]DHCP on Cisco IOS Routers[bookmark: marker-546691][bookmark: marker-546693][bookmark: marker-546695]

 
    [bookmark: pgfId-546699]In Security Manager, certain security features, such as Easy VPN and 802.1x, require Dynamic Host Configuration Protocol (DHCP) client/server configuration. DHCP is widely used in LAN environments to dynamically assign host IP addresses from a centralized server, which significantly reduces the overhead of administering IP addresses.

 
    [bookmark: pgfId-546701]DHCP servers assign and manage IP addresses from specified address pools within a router to DHCP clients. If the DHCP server cannot satisfy a DHCP request from its own database, it can forward the request to one or more secondary DHCP servers defined by the network administrator.

 
    [bookmark: pgfId-546703]Security Manager enables you to configure a Cisco IOS device as a DHCP server for clients (hosts) that are connected to the device’s inside interface. When you configure a DHCP server, you use IP pools (a range of IP addresses reserved for a DHCP server). The IP pools you select determine the range of IP addresses the server can use. These addresses are provided to client devices for a defined period of time called a lease. When this lease expires, the address is returned to the address pool, enabling the DHCP server to assign it to a different device.

 
    [bookmark: pgfId-546705]For more information about DHCP, see:

 
     
     		 [bookmark: pgfId-546710]Understanding DHCP Database Agents

 
     		 [bookmark: pgfId-546715]Understanding DHCP Relay Agents

 
     		 [bookmark: pgfId-546720]Understanding DHCP Option 82

 
     		 [bookmark: pgfId-546725]Understanding Secured ARP

 
    

 
    [bookmark: pgfId-546727]To configure a DHCP policy, see:

 
     
     		 [bookmark: pgfId-546732]Defining DHCP Policies

 
     		 [bookmark: pgfId-546737]Defining DHCP Address Pools

 
    

 
     
      [bookmark: pgfId-546745][bookmark: 143476][bookmark: rtchap_cncpt_UnderstandingDHCPDatabaseAgents]Understanding DHCP Database Agents[bookmark: marker-546743]

 
     [bookmark: pgfId-546747]A DHCP database agent is any external host—for example, an FTP, TFTP, or RCP server—that stores the DHCP bindings database. You can include one or more DHCP database agents in each DHCP policy, as well as configure the interval between database updates to the agent.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-546752]Note If you configure an external DHCP database agent, it is not necessary to define IP address pools, but you may do so. For more information about IP address pools, see Defining DHCP Address Pools.


     
      

     

     

 
     [bookmark: pgfId-546754]Related Topics

 
      
      		 [bookmark: pgfId-546759]Understanding DHCP Relay Agents

 
      		 [bookmark: pgfId-546764]Understanding DHCP Option 82

 
      		 [bookmark: pgfId-546769]Understanding Secured ARP

 
      		 [bookmark: pgfId-546774]Defining DHCP Policies

 
      		 [bookmark: pgfId-546779]DHCP on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-546787][bookmark: 143504][bookmark: rtchap_cncpt_UnderstandingDHCPRelayAgents]Understanding DHCP Relay Agents[bookmark: marker-546785]

 
     [bookmark: pgfId-546789]A DHCP relay agent is any host that forwards DHCP packets between clients and servers when they do not reside on the same physical subnet. Relay agents receive DHCP messages and then generate a new DHCP message to send on another interface. You can configure a reforwarding policy that determines what the DHCP relay agent should do if a forwarded message already contains relay information.

 
     [bookmark: pgfId-546791]DHCP relay options in Security Manager include:

 
      
      		 [bookmark: pgfId-546793]Drop—The relay agent discards messages with existing relay information if Option 82 information is also present.

 
      		 [bookmark: pgfId-546795]Keep—The relay agent retains existing relay information.

 
      		 [bookmark: pgfId-546797]Replace—The relay agent overwrites existing information with its own relay information.

 
     

 
     [bookmark: pgfId-546799]For example, you can have the DHCP relay agent replace the forwarded message with a new relay message. Additionally, you can choose whether to have the relay agent check the validity of relay information contained within forwarded BOOTREPLY messages.

 
     [bookmark: pgfId-546801]Related Topics

 
      
      		 [bookmark: pgfId-546806]Understanding DHCP Database Agents

 
      		 [bookmark: pgfId-546811]Understanding DHCP Option 82

 
      		 [bookmark: pgfId-546816]Understanding Secured ARP

 
      		 [bookmark: pgfId-546821]Defining DHCP Policies

 
      		 [bookmark: pgfId-546826]DHCP on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-546834][bookmark: 143539][bookmark: rtchap_cncpt_UnderstandingDHCPOption]Understanding DHCP Option 82[bookmark: marker-546832]

 
     [bookmark: pgfId-546836]DHCP option 82 enables the DHCP relay agent to include information about itself and its attached client when it forwards requests from a DHCP client to a DHCP server. The DHCP server can use this information to assign IP addresses, perform access control, and set quality of service (QoS) and security policies for each of its subscribers. When the DHCP option 82 feature is enabled, a subscriber is identified by the switch port through which it connects to the networks, instead of by its MAC address. Multiple hosts on the subscriber LAN can be connected to the same port on the access switch and are uniquely identified. Option 82 also enhances security on access switches by providing the ability to use a user’s IP address to locate the port on which a user is attached.

 
     [bookmark: pgfId-546838]Related Topics

 
      
      		 [bookmark: pgfId-546843]Understanding DHCP Database Agents

 
      		 [bookmark: pgfId-546848]Understanding DHCP Relay Agents

 
      		 [bookmark: pgfId-546853]Understanding Secured ARP

 
      		 [bookmark: pgfId-546858]Defining DHCP Policies

 
      		 [bookmark: pgfId-546863]DHCP on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-546871][bookmark: 143565][bookmark: rtchap_cncpt_UnderstandingSecuredARP]Understanding Secured ARP[bookmark: marker-546869]

 
     [bookmark: pgfId-546873]The DHCP Secure IP Address Assignment feature (also called DHCP Authorized ARP) enables you to secure Address Resolution Protocol (ARP) table entries to DHCP leases in the DHCP database. This feature secures and synchronizes the client’s MAC address to the DHCP binding, preventing unauthorized clients or hackers from spoofing the DHCP server and taking over a DHCP lease of an authorized client.

 
     [bookmark: pgfId-546875]When you enable this feature and the DHCP server assigns an IP address to the DHCP client, the DHCP server adds a secure ARP entry to the ARP table with the assigned IP address and the MAC address of the client. These ARP entries cannot be updated by any other dynamic ARP packets, and they exist in the ARP table for as long as the lease is active.

 
     [bookmark: pgfId-546877]Secure ARP entries can be deleted only by an explicit termination message from the DHCP client or by the DHCP server when the binding expires. To detect when a client has logged out, Secured ARP sends periodic ARP messages to which only authorized users can respond. Unauthorized responses are blocked at the DHCP server, providing an additional level of security.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-546879]Note Secured ARP disables dynamic ARP learning on an interface.


     
      

     

     

 
     [bookmark: pgfId-546881]Related Topics

 
      
      		 [bookmark: pgfId-546886]Understanding DHCP Database Agents

 
      		 [bookmark: pgfId-546891]Understanding DHCP Relay Agents

 
      		 [bookmark: pgfId-546896]Understanding DHCP Option 82

 
      		 [bookmark: pgfId-546901]Defining DHCP Policies

 
      		 [bookmark: pgfId-546906]DHCP on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-546914][bookmark: 143594][bookmark: rtchap_proc_DefiningDHCPPolicies]Defining DHCP Policies[bookmark: marker-546912]

 
     [bookmark: pgfId-546916]When you configure a DHCP policy, you must define the IP address pools for the server to use to provide addresses to DHCP clients. In addition, you can optionally define the following:

 
      
      		 [bookmark: pgfId-546918]External DHCP database agent.

 
      		 [bookmark: pgfId-546920]IP ranges to exclude from DHCP.

 
      		 [bookmark: pgfId-546922]DHCP relay parameters.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-546924]Note When configuring DHCP on a Cisco IOS router, make sure that the router does not contain an access rule denying Bootstrap Protocol (BootP) traffic. Having such a rule blocks DHCP traffic from being transmitted.


     
      

     

     

 
     [bookmark: pgfId-546926]Related Topics

 
      
      		 [bookmark: pgfId-546931]DHCP on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-546933]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-546935](Device view) Select  Platform > Device Admin > Server Access > DHCP from the Policy selector.

 
      		 [bookmark: pgfId-546937](Policy view) Select  Router Platform > Device Admin > Server Access > DHCP from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-546942]The DHCP Policy page is displayed. See Table 62-38 for a description of the fields on this page.

 
     [bookmark: pgfId-546950]Step 2 (Optional) Under Databases, click the Add button to display the DHCP Database Dialog Box. From here you can define external DHCP database agents. For more information, see Understanding DHCP Database Agents.

 
     [bookmark: pgfId-546955]Step 3 (Optional) Under Excluded IPs, enter the IP addresses or address ranges within a DHCP address pool that should not be made available to DHCP clients. You can use a combination of addresses and network/host objects, or click Select to display a selector. For more information, see Specifying IP Addresses During Policy Definition.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-546960]Tip If the network you want is not listed in the selector, click the Create button to display the Add or Edit Network/Host Dialog Box. From here you can create a network/host object.


     
      

     

     

 
     [bookmark: pgfId-546968]Step 4 Under IP Pools, click the Add button to display the IP Pool Dialog Box. From here you can define the address pools to be used by the DHCP server. For more information, see Defining DHCP Address Pools.

 
     [bookmark: pgfId-546970]Step 5 (Optional) When you use a relay agent to manage requests from DHCP clients located on a different subnet from the DHCP server, define the following DHCP relay options:

 
     [bookmark: pgfId-546972] a. Select the relay agent information reforwarding policy (Drop, Keep, or Replace). DHCP relay agents implement this policy when they receive messages already containing relay information.

 
     [bookmark: pgfId-546974] b. Select the Option check box to enable the insertion of Option 82 data in requests that the relay agent forwards to the DHCP server.

 
     [bookmark: pgfId-546976] c. Select the Check check box to validate DHCP Option 82 reply packets sent by the DHCP server.

 
     [bookmark: pgfId-546978]When you enable this option, invalid messages are dropped. Valid messages are stripped of the option-82 field before they are forwarded to the DHCP client. When you disable this option, the option-82 field is removed from the packet without being checked first for validity.

 
     [bookmark: pgfId-546983]See Understanding DHCP Relay Agents for more information.

 
     [bookmark: pgfId-546985]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-546993][bookmark: 143661][bookmark: rtchap_proc_DefiningDHCPAddressPools]Defining DHCP Address Pools[bookmark: marker-546991]

 
     [bookmark: pgfId-546995]When you configure a DHCP policy that does not include an external database agent, you must define at least one IP address pool. This pool contains the addresses that the DHCP server can dynamically assign to DHCP clients. Additionally, you can define the following IP pool-specific options:

 
      
      		 [bookmark: pgfId-546997]The default routers, DNS servers, WINS servers, and domain used by DHCP clients.

 
      		 [bookmark: pgfId-546999]Whether to use the Secured ARP feature.

 
      		 [bookmark: pgfId-547001]Whether to import information regarding IP pool options from a centralized DHCP server.

 
      		 [bookmark: pgfId-547003]The length of the lease.

 
      		 [bookmark: pgfId-547005]The location of the TFTP server that IP telephony devices require to use addresses from this pool.

 
     

 
     [bookmark: pgfId-547007]Related Topics

 
      
      		 [bookmark: pgfId-547012]Defining DHCP Policies

 
      		 [bookmark: pgfId-547017]DHCP on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-547021]Step 1 [bookmark: 143689]On the DHCP page, click the Create button under IP Pools. The IP Pool dialog box is displayed.

 
     [bookmark: pgfId-547026]Step 2 Define the address pool. See Table 62-40 for a description of the available fields.

 
     [bookmark: pgfId-547030]Step 3 [bookmark: 143695]Click OK to save your definitions locally on the client and close the dialog box. The IP pool appears in the table displayed under IP Pools on the DHCP page.

 
     [bookmark: pgfId-547038]Step 4 Repeat Step 1 through Step 3 to define additional address pools, if required.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-547040]Note To edit an IP pool, select it from the table, then click the Edit button. To delete an IP pool, select it from the table, then click the Delete button. You cannot delete a pool whose addresses have been assigned to DHCP clients.


     
      

     

     

 
     [bookmark: pgfId-547042]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-547054][bookmark: 143709][bookmark: rtpage_cncpt_DHCPPolicyPage]DHCP Policy Page[bookmark: marker-547050][bookmark: marker-547052]

 
    [bookmark: pgfId-547056]Use the DHCP policy page to define a DHCP server policy on the selected router. This includes specifying the address pools used by the DHCP server when assigning addresses to requesting clients.

 
    [bookmark: pgfId-547061]For more information, see Defining DHCP Policies.

 
    [bookmark: pgfId-547063]Navigation Path

 
     
     		 [bookmark: pgfId-547065](Device view) Select  Platform > Device Admin > Server Access > DHCP from the Policy selector.

 
     		 [bookmark: pgfId-547067](Policy view) Select  Router Platform > Device Admin > Server Access > DHCP from the Policy Type selector. Right-click  DHCP to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-547069]Related Topics

 
     
     		 [bookmark: pgfId-547074]DHCP on Cisco IOS Routers

 
     		 [bookmark: pgfId-547079]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-547084]Filtering Tables

 
    

 
    [bookmark: pgfId-547086]Field Reference

 
    [bookmark: pgfId-547089] 

 
     
      
       
       [bookmark: pgfId-541191]Table 62-38 [bookmark: 143748]DHCP Policy Page 

 
       
      
        
        		
          
          [bookmark: pgfId-541197]Element
         
  
        		
          
          [bookmark: pgfId-541199]Description
         
  
       

 
        
        		 [bookmark: pgfId-541205]Databases Table

  
       

 
        
        		[bookmark: pgfId-541213]Database URL

  
        		[bookmark: pgfId-541215]The URL of the external DHCP database agent.

  
       

 
        
        		[bookmark: pgfId-541221]Timeout

  
        		[bookmark: pgfId-541223]The amount of time to wait (in seconds) for a response from the external DHCP database agent before aborting a database transfer.

  
       

 
        
        		[bookmark: pgfId-541229]Write Delay

  
        		[bookmark: pgfId-541231]The interval (in seconds) between DHCP assignment updates sent to the external DHCP database agent.

  
       

 
        
        		[bookmark: pgfId-541237]Add button

  
        		[bookmark: pgfId-541242]Opens the DHCP Database Dialog Box. From here you can define a DHCP database agent.

  
       

 
        
        		[bookmark: pgfId-541248]Edit button

  
        		[bookmark: pgfId-541253]Opens the DHCP Database Dialog Box. From here you can edit the selected DHCP database agent.

  
       

 
        
        		[bookmark: pgfId-541259]Delete button

  
        		[bookmark: pgfId-541261]Deletes the selected DHCP database agents.

  
       

 
        
        		 [bookmark: pgfId-541267]Excluded IPs

  
       

 
        
        		[bookmark: pgfId-541275]Excluded IPs or IP Ranges

  
        		[bookmark: pgfId-541277]The IP addresses or address ranges to exclude from DHCP. These addresses are not assigned by the DHCP server to DHCP clients requesting addresses.

 [bookmark: pgfId-541279]Enter one or more network addresses or network/host objects, or click Select to select an object from a list or to create a new object.

 [bookmark: pgfId-541284]For more information, see Specifying IP Addresses During Policy Definition.

  
       

 
        
        		 [bookmark: pgfId-541290]IP Pools Table

  
       

 
        
        		[bookmark: pgfId-541298]Name

  
        		[bookmark: pgfId-541300]The name of the IP pool.

  
       

 
        
        		[bookmark: pgfId-541306]Network

  
        		[bookmark: pgfId-541308]The IP address and subnet mask of the IP pool.

  
       

 
        
        		[bookmark: pgfId-541314]Default Router

  
        		[bookmark: pgfId-541316]The IP addresses of the default routers used by DHCP clients.

  
       

 
        
        		[bookmark: pgfId-541322]DNS Server

  
        		[bookmark: pgfId-541324]The IP addresses of the DNS servers used by DHCP clients.

  
       

 
        
        		[bookmark: pgfId-541330]NetBIOS (WINS) Server

  
        		[bookmark: pgfId-541332]The IP addresses of the Windows Internet Naming Service (WINS) servers used by Microsoft DHCP clients.

  
       

 
        
        		[bookmark: pgfId-541338]Domain Name

  
        		[bookmark: pgfId-541340]The domain name for DHCP clients.

  
       

 
        
        		[bookmark: pgfId-541346]Import All

  
        		[bookmark: pgfId-541348]Indicates whether the remote DHCP server imports certain DHCP options from a centralized DHCP server.

  
       

 
        
        		[bookmark: pgfId-541354]Secured ARP

  
        		[bookmark: pgfId-541356]Indicates whether secured ARP is enabled on this IP pool to help prevent IP spoofing by unauthorized users.

  
       

 
        
        		[bookmark: pgfId-541362]Lease

  
        		[bookmark: pgfId-541364]The duration of the lease for each IP address assigned by the DHCP server from this IP pool.

  
       

 
        
        		[bookmark: pgfId-541370]Option 150

  
        		[bookmark: pgfId-541372]The IP address of the TFTP server required by IP phones for configuration, as defined using DHCP option 150.

  
       

 
        
        		[bookmark: pgfId-541378]Option 66

  
        		[bookmark: pgfId-541380]The IP address of the TFTP server required by IP phones for configuration, as defined using DHCP option 66.

  
       

 
        
        		[bookmark: pgfId-541386]Add button

  
        		[bookmark: pgfId-541391]Opens the IP Pool Dialog Box. From here you can define a DHCP IP address pool.

  
       

 
        
        		[bookmark: pgfId-541397]Edit button

  
        		[bookmark: pgfId-541402]Opens the IP Pool Dialog Box. From here you can edit the selected IP pool.

  
       

 
        
        		[bookmark: pgfId-541408]Delete button

  
        		[bookmark: pgfId-541410]Deletes the selected IP pools.

  
       

 
        
        		 [bookmark: pgfId-541416]Relay parameters

  
       

 
        
        		[bookmark: pgfId-541424]Policy

  
        		[bookmark: pgfId-541426]The policy that DHCP relay agents implement when they receive messages already containing relay information:

 
          
          		 [bookmark: pgfId-541428]Drop—The relay agent discards messages with existing relay information if option-82 information is also present.

 
          		 [bookmark: pgfId-541430]Keep—The relay agent retains existing relay information.

 
          		 [bookmark: pgfId-541432]Replace—The relay agent overwrites existing information with its own relay information.

 
         

  
       

 
        
        		[bookmark: pgfId-541438]Option

  
        		[bookmark: pgfId-541443]When selected, enables DHCP Option 82 data insertion in message requests forwarded from the DHCP client to the server. DHCP Option 82 provides the DHCP server with both the switch and port ID of the requesting client. This option makes it possible to locate where a user is physically connected to the network and prevent spoofing. See Understanding DHCP Option 82.

 [bookmark: pgfId-541445]When deselected, DHCP Option 82 is disabled.

  
       

 
        
        		[bookmark: pgfId-541451]Check

  
        		[bookmark: pgfId-541453]When selected, DHCP Option 82 reply packets received from the DHCP server are validated. Invalid messages are dropped; valid messages are stripped of the option-82 field before being forwarded to the DHCP client.

 [bookmark: pgfId-541455]When deselected, the option-82 field is removed from the packet without being checked first for validity.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-547101][bookmark: 143912][bookmark: rtpage_cncpt_DHCPDatabaseDialogBox]DHCP Database Dialog Box[bookmark: marker-547097][bookmark: marker-547099]

 
     [bookmark: pgfId-547103]Use the DHCP Database dialog box to define external DHCP database agents that contain the automatic bindings. Each database URL that you define must be unique.

 
     [bookmark: pgfId-547108]For more information, see Understanding DHCP Database Agents.

 
     [bookmark: pgfId-547110]Navigation Path

 
     [bookmark: pgfId-547115]Go to the DHCP Policy Page, then click the Add or Edit button beneath the Databases table.

 
     [bookmark: pgfId-547117]Related Topics

 
      
      		 [bookmark: pgfId-547122]Defining DHCP Policies

 
      		 [bookmark: pgfId-547127]DHCP on Cisco IOS Routers

 
      		 [bookmark: pgfId-547132]IP Pool Dialog Box

 
     

 
     [bookmark: pgfId-547134]Field Reference

 
     [bookmark: pgfId-547137] 

 
      
       
        
        [bookmark: pgfId-541468]Table 62-39 [bookmark: 143947]DHCP Database Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-541474]Element
          
  
         		
           
           [bookmark: pgfId-541476]Description
          
  
        

 
         
         		[bookmark: pgfId-541482]Database URL

  
         		[bookmark: pgfId-541484]The URL of the external DHCP database agent containing the automatic bindings. The URL can be in HTTP, FTP, TFTP, or RCP format.

 [bookmark: pgfId-541486]Note If you define a URL, it is not necessary to define an IP address pool. However, you may do so.

  
        

 
         
         		[bookmark: pgfId-541492]Timeout

  
         		[bookmark: pgfId-541494]The amount of time (in seconds) the DHCP server should wait for a response from the external DHCP database agent before aborting a database transfer. The default is 300 seconds (5 minutes).

 [bookmark: pgfId-541496]Note A value of 0 disables the timeout.

  
        

 
         
         		[bookmark: pgfId-541502]Write Delay

  
         		[bookmark: pgfId-541504]The interval (in seconds) between updates sent from the DHCP server to the external DHCP database agent. The minimum delay is 60 seconds. The default is 300 seconds (5 minutes).

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-547149][bookmark: 143975][bookmark: rtpage_cncpt_IPPoolDialogBox]IP Pool Dialog Box[bookmark: marker-547145][bookmark: marker-547147]

 
     [bookmark: pgfId-547151]Use the IP Pool dialog box to define one or more address pools, which the DHCP server uses to assign dynamic addresses to DHCP clients. You must define at least one address pool, unless you have defined an external DHCP database agent.

 
     [bookmark: pgfId-547153]Navigation Path

 
     [bookmark: pgfId-547158]Go to the DHCP Policy Page, then click the Add or Edit button beneath the IP Pools table.

 
     [bookmark: pgfId-547160]Related Topics

 
      
      		 [bookmark: pgfId-547165]Defining DHCP Address Pools

 
      		 [bookmark: pgfId-547170]Understanding DHCP Database Agents

 
      		 [bookmark: pgfId-547175]DHCP Database Dialog Box

 
      		 [bookmark: pgfId-547180]DHCP on Cisco IOS Routers

 
     

 
     [bookmark: pgfId-547182]Field Reference

 
     [bookmark: pgfId-547185] 

 
      
       
        
        [bookmark: pgfId-541517]Table 62-40 [bookmark: 144011]IP Pool Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-541523]Element
          
  
         		
           
           [bookmark: pgfId-541525]Description
          
  
        

 
         
         		[bookmark: pgfId-541531]Pool Name

  
         		[bookmark: pgfId-541533]The name of the IP pool.

  
        

 
         
         		[bookmark: pgfId-541539]Network

  
         		[bookmark: pgfId-541541]The IP address and subnet mask of the IP pool. This subnet contains the range of available IP addresses that the DHCP server may assign to clients.

 [bookmark: pgfId-541543]Enter an address and mask or the name of a network/host object, or click Select to select an object from a list or to create a new one.

 [bookmark: pgfId-541548]Tip You can exclude specific addresses within the range by defining them in the Excluded IPs field. See DHCP Policy Page.  
        

 
         
         		[bookmark: pgfId-541554]Default Router Addresses

  
         		[bookmark: pgfId-541556]The IP addresses of the default routers for DHCP clients using this IP pool. After a DHCP client is booted, it begins sending packets to this router, which should be located on the same subnet as the client.

 [bookmark: pgfId-541558]Enter up to eight (8) network addresses or network/host objects, or click Select to select an object from a list or to create a new one.

  
        

 
         
         		[bookmark: pgfId-541564]DNS Server Addresses

  
         		[bookmark: pgfId-541566]The IP addresses of the DNS servers that DHCP clients using this IP pool should query when they need to correlate hostnames to IP addresses.

 [bookmark: pgfId-541568]Enter up to eight (8) network addresses or network/host objects, or click Select to select an object from a list or to create a new one.

  
        

 
         
         		[bookmark: pgfId-541574]NetBIOS (WINS) Server Addresses

  
         		[bookmark: pgfId-541576]The IP addresses of the Windows Internet Naming Service (WINS) servers used by Microsoft DHCP clients to correlate hostnames to IP addresses within a general grouping of networks.

 [bookmark: pgfId-541578]Enter up to eight (8) network addresses or network/host objects, or click Select to select an object from a list or to create a new one.

  
        

 
         
         		[bookmark: pgfId-541584]Domain Name

  
         		[bookmark: pgfId-541586]The domain name for DHCP clients using this IP pool. This name places these clients in the general grouping of networks that make up the domain.

  
        

 
         
         		[bookmark: pgfId-541592]Import All

  
         		[bookmark: pgfId-541594]When selected, enables remote DHCP servers to import specific DHCP options (such as the DNS server) from a centralized server. Use this option to enable configuration information to be updated automatically.

 [bookmark: pgfId-541596]When deselected, all DHCP options are local to this specific server.

  
        

 
         
         		[bookmark: pgfId-541602]Secured ARP

  
         		[bookmark: pgfId-541607]When selected, enables the DHCP Authorized ARP feature, which limits the leasing of IP addresses to authorized mobile users. This feature helps prevent IP spoofing by unauthorized users. See Understanding Secured ARP.

 [bookmark: pgfId-541609]When deselected, the DHCP Authorized ARP feature is disabled.

 [bookmark: pgfId-541611]Note This feature also disables dynamic ARP learning on an interface.

  
        

 
         
         		[bookmark: pgfId-541617]Lease Never Expires

  
         		[bookmark: pgfId-541619]When selected, the DHCP server permanently assigns IP addresses to its clients.

 [bookmark: pgfId-541621]When deselected, addresses are leased for a predefined amount of time, as defined in the Time Length field.

  
        

 
         
         		[bookmark: pgfId-541627]Time Length (DD:HH:MM)

  
         		[bookmark: pgfId-541629]Applies only when the Lease Never Expires check box is deselected.

 [bookmark: pgfId-541631]The duration of the lease provided to each IP address assigned from this IP pool (using the format DD:HH:MM). After the lease expires, the assigned IP address is no longer valid and is returned to the pool.

  
        

 
         
         		[bookmark: pgfId-541637]Option 66 (IP Addresses)

  
         		[bookmark: pgfId-541639]The IP address of the TFTP server used to provide configuration files to IP phones. These configuration files define parameters required by IP phones to connect to Cisco CallManager.

 [bookmark: pgfId-541641]Enter up to eight (8) network addresses or network/host objects, or click Select to select an object from a list or to create a new one.

 [bookmark: pgfId-541643]Note This option is functionally similar to option 150. Either or both options may be used.

  
        

 
         
         		[bookmark: pgfId-541649]Option 150 (IP Addresses)

  
         		[bookmark: pgfId-541651]The IP address of the TFTP server used to provide configuration files to IP phones. These configuration files define parameters required by IP phones to connect to Cisco CallManager.

 [bookmark: pgfId-541653]Enter up to eight (8) network addresses or network/host objects, or click Select to select an object from a list or to create a new one.

 [bookmark: pgfId-541655]Note This option is functionally similar to option 66. Either or both options may be used.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-547199][bookmark: 144105][bookmark: rtchap_cncpt_NTPonCiscoIOSRouters]NTP on Cisco IOS Routers[bookmark: marker-547191][bookmark: marker-547193][bookmark: marker-547195][bookmark: marker-547197]

 
    [bookmark: pgfId-547201]The Network Time Protocol (NTP) is the standard for time synchronization between network devices. Synchronized time enables you to correlate syslog and other debug output to specific events, which is essential for troubleshooting, fault analysis, and security incident tracking. Time comparisons are not possible without precise time synchronization between the logging, management, and AAA functions occurring in your network.

 
    [bookmark: pgfId-547203]NTP uses the concept of a stratum to describe how far removed a machine is from an authoritative time source. For example, a stratum 1 time server is directly attached to a radio or atomic clock. NTP then distributes the time from this authoritative time source across the network. A stratum 2 time server synchronizes with a stratum 1 time server; a stratum 3 time server synchronizes with a stratum 2 time server and so on. One NTP transaction per minute is sufficient to synchronize two machines to within a millisecond.

 
    [bookmark: pgfId-547205]NTP runs over the User Datagram Protocol (UDP) using port 123. Security Manager supports NTP version 3, as defined in RFC 1305.

 
    [bookmark: pgfId-547207]Related Topics

 
     
     		 [bookmark: pgfId-547212]Defining NTP Servers

 
    

 
     
      [bookmark: pgfId-547220][bookmark: 144129][bookmark: rtchap_proc_DefiningNTPServers]Defining NTP Servers[bookmark: marker-547218]

 
     [bookmark: pgfId-547222]This procedure describes how to define the NTP servers that the routers users to synchronize time. After the NTP policy is deployed, the router uses an algorithm (based on factors such as delay, dispersion, and jitter) to determine which NTP server is the most accurate and synchronizes to that one.

 
     [bookmark: pgfId-547224]At the global level, you can enable MD5 authentication and specify a source address to use on all NTP packets sent from the router.

 
     [bookmark: pgfId-547226]To add an NTP server to the policy, all you need to do is enter its IP address. In addition, you can optionally define authentication parameters and determine whether a particular server should be preferred over other NTP servers of similar accuracy.

 
     [bookmark: pgfId-547228]Related Topics

 
      
      		 [bookmark: pgfId-547233]NTP on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-547235]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-547237](Device view) Select  Platform > Device Admin > Server Access > NTP from the Policy selector.

 
      		 [bookmark: pgfId-547239](Policy view) Select  Router Platform > Device Admin > Server Access > NTP from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-547244]The NTP page is displayed. See Table 62-41 for a description of the fields on this page.

 
     [bookmark: pgfId-547246]Step 2 (Optional) In the Source Interface field, enter the name of the interface or interface role whose address should be used as the source interface for all NTP packets sent from the router, or click Select to select an interface role from a list or to create a new one. The source interface must have an IP address.

 
     [bookmark: pgfId-547248]This option is useful when the NTP server cannot reach the address from which the connection originated (for example, due to a firewall). If you do not enter a value in this field, the address of the outgoing interface is used.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-547253]Note You can override this global setting for individual NTP servers, as described in Step 5.


     
      

     

     

 
     [bookmark: pgfId-547255]Step 3 (Optional) Select the Enable NTP Authentication check box to authenticate all associations between this router and the NTP servers defined in this policy.

 
     [bookmark: pgfId-547257]Step 4 Click the Add button under the Servers table to display the NTP Server dialog box. From here you can define an NTP server.

 
     [bookmark: pgfId-547264]Step 5 [bookmark: 144168]Define an NTP server. See Table 62-42 for a description of the available fields.

 
     [bookmark: pgfId-547268]Step 6 [bookmark: 144171](Optional) Define authentication parameters for this NTP server.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-547270]Note If you modify the value of a previously defined authentication key, the change affects all NTP servers that share this key.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-547272]Note When you define an authentication key in Security Manager, the value 0 is automatically appended to the end of the CLI command. This value, which represents the default authentication key encryption type, can be modified using the CLI.


     
      

     

     

 
     [bookmark: pgfId-547280]Step 7 Repeat Step 5 and Step 6 to define additional NTP servers.

 
     [bookmark: pgfId-547282]Step 8 Click OK to save your definitions locally on the client and close the dialog box. Your definitions are displayed in the Servers table.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-547284]Note To edit an NTP server, select it from the Servers table, then click Edit. To remove an NTP server, select it, then click Delete. If the key defined on the server you delete is not defined on a different NTP server, the key is also deleted.


     
      

     

     

 
     [bookmark: pgfId-547286]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-547298][bookmark: 144189][bookmark: rtpage_cncpt_NTPPolicyPage]NTP Policy Page[bookmark: marker-547294][bookmark: marker-547296]

 
    [bookmark: pgfId-547300]Use the NTP page to define one or more NTP servers that the router can use for time synchronization. This includes enabling authentication, if required, and defining a global source interface for all traffic sent to these servers.

 
    [bookmark: pgfId-547305]For more information, see Defining NTP Servers.

 
    [bookmark: pgfId-547307]Navigation Path

 
     
     		 [bookmark: pgfId-547309](Device view) Select  Platform > Device Admin > Server Access > NTP from the Policy selector.

 
     		 [bookmark: pgfId-547311](Policy view) Select  Router Platform > Device Admin > Server Access > NTP from the Policy Type selector. Right-click  NTP to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-547313]Related Topics

 
     
     		 [bookmark: pgfId-547318]NTP on Cisco IOS Routers

 
     		 [bookmark: pgfId-547323]Understanding Interface Role Objects

 
     		 [bookmark: pgfId-547328]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-547333]Filtering Tables

 
    

 
    [bookmark: pgfId-547335]Field Reference

 
    [bookmark: pgfId-547338] 

 
     
      
       
       [bookmark: pgfId-541668]Table 62-41 [bookmark: 144231]NTP Page 

 
       
      
        
        		
          
          [bookmark: pgfId-541674]Element
         
  
        		
          
          [bookmark: pgfId-541676]Description
         
  
       

 
        
        		[bookmark: pgfId-541682]Source Interface

  
        		[bookmark: pgfId-541684]The source address for all packets sent to an NTP server. This setting might be necessary when the NTP server cannot respond to the address from which the packet originated (for example, due to a firewall). The source interface must have an IP address.

 [bookmark: pgfId-541686]If you do not define a value in this field, the address of the outgoing interface is used.

 [bookmark: pgfId-541688]Enter the name of an interface or interface role, or click Select to select the object from a list or to create a new one.

 [bookmark: pgfId-541693]Note The source interface defined in this field is a global setting that you can override for individual NTP servers. For more information, see NTP Server Dialog Box.

  
       

 
        
        		[bookmark: pgfId-541699]Enable NTP Authentication

  
        		[bookmark: pgfId-541701]When selected, enables authentication using MD5 when connecting to an NTP server.

 [bookmark: pgfId-541703]When deselected, authentication is disabled.

  
       

 
        
        		 [bookmark: pgfId-541709]Servers Table

  
       

 
        
        		[bookmark: pgfId-541717]IP Address

  
        		[bookmark: pgfId-541719]The IP address of the NTP server.

  
       

 
        
        		[bookmark: pgfId-541725]Source Interface

  
        		[bookmark: pgfId-541727]The source address for all packets sent to this NTP server. This setting overrides the global setting defined at the top of the page.

  
       

 
        
        		[bookmark: pgfId-541733]Preferred

  
        		[bookmark: pgfId-541735]Indicates whether this NTP server is preferred over other NTP servers of similar accuracy.

 [bookmark: pgfId-541737]Note By default, preferred servers are listed first in the table.

  
       

 
        
        		[bookmark: pgfId-541743]Key Number

  
        		[bookmark: pgfId-541745]The ID number of the key used for authentication with this NTP server.

  
       

 
        
        		[bookmark: pgfId-541751]Trusted

  
        		[bookmark: pgfId-541753]Indicates whether the authentication key defined for this NTP server is a trusted key.

  
       

 
        
        		[bookmark: pgfId-541759]Add button

  
        		[bookmark: pgfId-541764]Opens the NTP Server Dialog Box. From here you can define an NTP server.

  
       

 
        
        		[bookmark: pgfId-541770]Edit button

  
        		[bookmark: pgfId-541775]Opens the NTP Server Dialog Box. From here you can edit the selected NTP server.

  
       

 
        
        		[bookmark: pgfId-541781]Delete button

  
        		[bookmark: pgfId-541783]Deletes the selected NTP server from the table.

 [bookmark: pgfId-541785]If the key defined on the server you delete is not defined on a different NTP server, the key is also deleted.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-547350][bookmark: 144305][bookmark: rtpage_cncpt_NTPServerDialogBox]NTP Server Dialog Box[bookmark: marker-547346][bookmark: marker-547348]

 
     [bookmark: pgfId-547352]Use the NTP Server dialog box to define the address of an NTP server that the router can use to perform time synchronization. In addition, you can use this dialog box to define a default source interface for NTP packets sent to this server and authentication parameters.

 
     [bookmark: pgfId-547354]Navigation Path

 
     [bookmark: pgfId-547359]Go to the NTP Policy Page, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-547361]Related Topics

 
      
      		 [bookmark: pgfId-547366]Defining NTP Servers

 
      		 [bookmark: pgfId-547371]NTP on Cisco IOS Routers

 
      		 [bookmark: pgfId-547376]Understanding Interface Role Objects

 
     

 
     [bookmark: pgfId-547378]Field Reference

 
     [bookmark: pgfId-547381] 

 
      
       
        
        [bookmark: pgfId-541798]Table 62-42 [bookmark: 144338]NTP Server Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-541804]Element
          
  
         		
           
           [bookmark: pgfId-541806]Description
          
  
        

 
         
         		[bookmark: pgfId-541812]IP Address

  
         		[bookmark: pgfId-541814]The IP address of the NTP server. Enter an address or the name of a network/host object, or click Select to select the object from a list or to create a new one.

  
        

 
         
         		[bookmark: pgfId-541820]Source Interface

  
         		[bookmark: pgfId-541822]The source address for all packets sent to this NTP server. This setting might be necessary when the NTP server cannot respond to the address from which the packet originated (for example, due to a firewall). The source interface must have an IP address.

 [bookmark: pgfId-541824]If you do not define a value in this field and there is no global setting, the address of the outgoing interface is used.

 [bookmark: pgfId-541829]Note This setting overrides the global setting you defined on the NTP Policy Page.

 [bookmark: pgfId-541831]Enter the name of an interface or interface role, or click Select to select the object from a list or to create a new one.

  
        

 
         
         		[bookmark: pgfId-541837]Preferred

  
         		[bookmark: pgfId-541839]When selected, this NTP server is preferred over other NTP servers of similar accuracy. If this server is used for synchronization, the time offset used to correct the local clock is calculated from this server only.

 [bookmark: pgfId-541841]Note If a different NTP server is significantly more accurate than the preferred server (for example, stratum 2 versus stratum 3), the router synchronizes to the more accurate server.

 [bookmark: pgfId-541843]When deselected, this NTP server is not given preference over other NTP servers of similar accuracy. The time offset used to correct the local clock is calculated by taking the combined offset of all NTP servers.

 [bookmark: pgfId-541845]We recommend that you configure an NTP server as preferred only when multiple servers have the same stratum and you can rely on the accuracy of the preferred server.

  
        

 
         
         		[bookmark: pgfId-541851]Authentication Key

  
         		[bookmark: pgfId-541853]The MD5 key that is used to authenticate associations with the NTP server.

 
           
           		 [bookmark: pgfId-541855]Key Number—The ID number of the authentication key. Enter the key number or select a previously defined number from the list.

 
           		 [bookmark: pgfId-541857]Key Value—An arbitrary string of up to 32 characters that defines the authentication key. Enter the string again in the Confirm field.

 
           		 [bookmark: pgfId-541859]Trusted—When selected, this key authenticates the identity of systems attempting to synchronize with this server. When deselected, this key is not used for authentication.

 
          

 [bookmark: pgfId-541861]If you select a key number from the list and then change the key value, you are warned that saving this change affects any other NTP servers using the same authentication key.

 [bookmark: pgfId-541866]Note To use authentication, you must enable it from the NTP Policy Page.
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     [bookmark: pgfId-965423][bookmark: 31295][bookmark: adman_cncpt_ConfiguringAdministrativeSettings]Configuring Security Manager Administrative Settings[bookmark: marker-965415][bookmark: marker-965417][bookmark: marker-965419][bookmark: marker-965421]
      
      
 
     
 

 
    [bookmark: pgfId-965425]Security Manager has default settings for many system functions that you can change if they do not fit the needs of your organization. To view and change these settings, select Tools > Security Manager Administration. You can then select items from the table of contents on the left of the window to view the default settings related to that item.

 
    [bookmark: pgfId-965427]On most pages, when you change a setting, you must click Save to save your changes. If you make a mistake, you can click Reset to return the values to the previously saved values. You can also click Restore Defaults to return the settings to the Security Manager defaults.

 
    [bookmark: pgfId-965429]Besides the pages that contain system defaults, the Security Manager Administration window includes items that relate to system administration activities, such as taking over another user’s work or obtaining access to pages in Common Services to perform server security tasks.

 
    [bookmark: pgfId-965431]The following topics describe the settings and actions available on each of the pages available in the Security Manager Administration window:

 
     
     		 [bookmark: pgfId-965436]API Settings Page

 
     		 [bookmark: pgfId-965441]AutoLink Settings Page

 
     		 [bookmark: pgfId-965446]CCO Settings Page

 
     		 [bookmark: pgfId-965451]Configuration Archive Page

 
     		 [bookmark: pgfId-965456]CS-MARS Page

 
     		 [bookmark: pgfId-965461]CSM Mobile Page

 
     		 [bookmark: pgfId-965466]Customize Desktop Page

 
     		 [bookmark: pgfId-965471]Debug Options Page

 
     		 [bookmark: pgfId-965476]Deployment Page

 
     		 [bookmark: pgfId-965481]Device Communication Page

 
     		 [bookmark: pgfId-965486]Device Groups Page

 
     		 [bookmark: pgfId-965491]Discovery Page

 
     		 [bookmark: pgfId-965496]Event Management Page

 
     		 [bookmark: pgfId-965501]Health and Performance Monitor Page

 
     		 [bookmark: pgfId-965506]Report Manager Page

 
     		 [bookmark: pgfId-965511]Identity Settings Page

 
     		 [bookmark: pgfId-965516]Image Manager Page

 
     		 [bookmark: pgfId-965521]IP Intelligence Settings Page

 
     		 [bookmark: pgfId-965526]Eventing Notification Settings Page

 
     		 [bookmark: pgfId-965531]IPS Updates Page

 
     		 [bookmark: pgfId-965536]ISE Settings Page

 
     		 [bookmark: pgfId-965541]Licensing Page

 
     		 [bookmark: pgfId-965546]Logs Page

 
     		 [bookmark: pgfId-965551]Policy Management Page

 
     		 [bookmark: pgfId-965556]Policy Objects Page

 
     		 [bookmark: pgfId-965561]Single Sign-on Configuration Page

 
     		 [bookmark: pgfId-965566]Rule Expiration Page

 
     		 [bookmark: pgfId-965571]Server Security Page

 
     		 [bookmark: pgfId-965576]Take Over User Session Page

 
     		 [bookmark: pgfId-965581]Ticket Management Page

 
     		 [bookmark: pgfId-965586]Token Management Page

 
     		 [bookmark: pgfId-965591]VPN Policy Defaults Page

 
     		 [bookmark: pgfId-965596]Workflow Page

 
     		 [bookmark: pgfId-965601]Wall Settings Page

 
    

 
   
 
    
     [bookmark: pgfId-965609][bookmark: 31420][bookmark: syspage_cncpt_APISettingsPage]API Settings Page

 
    [bookmark: pgfId-965611]The Security Manager API settings page enables you to enable or disable the API service and change its settings.

 
    [bookmark: pgfId-965613]Navigation Path

 
    [bookmark: pgfId-965615]Click Tools > Security Manager Administration and select API from the table of contents.

 
    [bookmark: pgfId-965617]Field Reference

 
    [bookmark: pgfId-965620] 

 
     
      
       
       [bookmark: pgfId-959532]Table 11-1 [bookmark: 31432]API Settings Page 

 
       
      
        
        		
          
          [bookmark: pgfId-959538]Element
         
  
        		
          
          [bookmark: pgfId-959540]Description
         
  
       

 
        
        		[bookmark: pgfId-959546]Enable API Service

  
        		[bookmark: pgfId-959548]Whether to enable or disable the API service.

  
       

 
        
        		[bookmark: pgfId-959554]Result Set Page Size

  
        		[bookmark: pgfId-959556]Allowed values are 100 through 1000, inclusive.

  
       

 
        
        		[bookmark: pgfId-959562]Active client sessions

  
        		[bookmark: pgfId-959564]Allowed values are 1 through 10, inclusive.

  
       

 
        
        		[bookmark: pgfId-959570]Save button

  
        		[bookmark: pgfId-959572]Saves and applies changes.

  
       

 
        
        		[bookmark: pgfId-959578]Reset button

  
        		[bookmark: pgfId-959580]Resets changes to the last saved values.

  
       

 
        
        		[bookmark: pgfId-959586]Restore Defaults button

  
        		[bookmark: pgfId-959588]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-965638][bookmark: 31473][bookmark: syspage_cncpt_AutoLinkSettingsPage]AutoLink Settings Page[bookmark: marker-965628][bookmark: marker-965630][bookmark: marker-965632][bookmark: marker-965634][bookmark: marker-965636]

 
    [bookmark: pgfId-965640]The Security Manager Map view provides a graphical view of your VPN and layer 3 network topology. Using device nodes to represent managed devices and map objects to represent unmanaged objects such as devices, clouds, and networks, you can create topology maps with which to study your network. AutoLink settings enable you to exclude any one of five private or reserved networks from Map view. For example, you might want to exclude any test networks that are not relevant to the management tasks you are using Security Manager to perform.

 
    [bookmark: pgfId-965642]Navigation Path

 
    [bookmark: pgfId-965644]Click Tools > Security Manager Administration and select AutoLink from the table of contents.

 
    [bookmark: pgfId-965646]Related Topics

 
     
     		 [bookmark: pgfId-965651]Creating and Managing Layer 3 Links on the Map

 
     		 [bookmark: pgfId-965656]Displaying Your Network on the Map

 
    

 
    [bookmark: pgfId-965658]Field Reference

 
    [bookmark: pgfId-965661] 

 
     
      
       
       [bookmark: pgfId-959601]Table 11-2 [bookmark: 31511]AutoLink Page 

 
       
      
        
        		
          
          [bookmark: pgfId-959607]Element
         
  
        		
          
          [bookmark: pgfId-959609]Description
         
  
       

 
        
        		[bookmark: pgfId-959615]Enable AutoLink for 10.0.0.0/8

 [bookmark: pgfId-959617]Enable AutoLink for 172.16.0.0/12

 [bookmark: pgfId-959619]Enable AutoLink for 192.168.0.0/16

  
        		[bookmark: pgfId-959621]Whether to automatically include or omit (deselected) these private networks from the maps you create.

  
       

 
        
        		[bookmark: pgfId-959627]Enable AutoLink for 127.0.0.0/8

  
        		[bookmark: pgfId-959629]Whether to automatically include or omit (deselected) the loopback network from the maps you create.

  
       

 
        
        		[bookmark: pgfId-959635]Enable AutoLink for 224.0.0.0/4

  
        		[bookmark: pgfId-959637]Whether to automatically include or omit (deselected) the multicast networks from the maps you create.

  
       

 
        
        		[bookmark: pgfId-959643]Save button

  
        		[bookmark: pgfId-959645]Saves and applies changes.

  
       

 
        
        		[bookmark: pgfId-959651]Reset button

  
        		[bookmark: pgfId-959653]Resets changes to the last saved values.

  
       

 
        
        		[bookmark: pgfId-959659]Restore Defaults button

  
        		[bookmark: pgfId-959661]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-965669][bookmark: 31554][bookmark: syspage_cncpt_ACLHitCountSettingsPage]ACL Hit Count Settings Page

 
    [bookmark: pgfId-965671]The Security Manager ACL Hit Count Settings page enables you to configure and change the settings for Hit Count. This feature is available in Security Manager version 4.9 and higher for ASA and ASASM devices.

 
    [bookmark: pgfId-965673]Navigation Path

 
    [bookmark: pgfId-965675]Click Tools > Security Manager Administration and select ACL Hit Count Settings from the table of contents.

 
    [bookmark: pgfId-965677]Field Reference

 
    [bookmark: pgfId-965680] 

 
     
      
       
       [bookmark: pgfId-959674]Table 11-3 [bookmark: 31566]Hit Count Settings 

 
       
      
        
        		
          
          [bookmark: pgfId-959680]Element
         
  
        		
          
          [bookmark: pgfId-959682]Description
         
  
       

 
        
        		[bookmark: pgfId-959688]Hit Count History Persist Limit (per ACE)

  
        		[bookmark: pgfId-959690]The Hit Count History Persist Limit is the limit for the Hit Count history details that can be stored for the particular ACE in the database. The default value is 5 and you can enter a maximum value of 10.

  
       

 
        
        		[bookmark: pgfId-959696]Purge Scheduler Process Time

  
        		[bookmark: pgfId-959698]The Purge Scheduler Process Time is used by the Hit Count Scheduler to schedule the Hit Count purge job at the given time on a daily basis. Select a time from the drop-down list. The default is 12 AM.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-965694][bookmark: 31587][bookmark: syspage_cncpt_CCOSettingsPage]CCO Settings Page[bookmark: marker-965690][bookmark: marker-965692]

 
    [bookmark: pgfId-965696]Use the CCO Settings page to configure the settings used to connect to Cisco.com.

 
    [bookmark: pgfId-965708][bookmark: marker-965698][bookmark: marker-965700][bookmark: marker-965702][bookmark: marker-965704][bookmark: marker-965706]Also, use the CCO Settings page for certificate trust management. (Security Manager downloads ASA images from Cisco.com over HTTPS, which uses certificates for establishing trust.) The certificate trust management feature on the Image Manager page is new in Security Manager 4.4. It will help you with improved handling of Cisco.com certificates for ASA image downloads:

 
     
     		 [bookmark: pgfId-965710]You can use it to view a certificate and use discretion in accepting it.

 
     		 [bookmark: pgfId-965712]After you accept a certificate, it is stored on your Security Manager server.

 
     		 [bookmark: pgfId-965714]You can see all your certificates in a summary table on the Image Manager page, and you can use that table to view or remove certificates.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-965716]Tip Please be sure to refer to "Retrieve Certificate" in the table below.


    
     

    

    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1065547]Note Cisco.com now uses SHA2 certificate instead of SHA1. Therefore you must remove the existing SHA1 certificate and retrieve the current SHA2 certificate from cisco.com. Use Remove Certificate to remove the certificate and Retrieve Certificate to connect to and retrieve the certificate from cisco.com.


    
     

    

    

 
    [bookmark: pgfId-1065539]For detailed documentation of the certificate trust management feature, refer to Certificate Trust Management.

 
    [bookmark: pgfId-965723]Navigation Path

 
    [bookmark: pgfId-965725]Select Tools > Security Manager Administration and select CCO Settings from the table of contents.

 
    [bookmark: pgfId-965727]Field Reference

 
    [bookmark: pgfId-965730] 

 
     
      
       
       [bookmark: pgfId-959711]Table 11-4 [bookmark: 31635]CCO Settings Page 

 
       
      
        
        		
          
          [bookmark: pgfId-959717]Element
         
  
        		
          
          [bookmark: pgfId-959719]Description
         
  
       

 
        
        		[bookmark: pgfId-959725]Use IPS Updates Settings

  
        		[bookmark: pgfId-959727]If checked, the other settings on this page are disabled and the default prevails (the Cisco.com credentials from the IPS Updates page apply).

 
          
          [image: ] 
         
 
         
 
         
          [bookmark: pgfId-959729]Caution If checked, be sure that the Cisco.com credentials from the IPS Updates page are configured correctly. On that page, the default value for "Update From:" is "Local Server." You must choose "Cisco.com" to see certificate settings. Improper or incomplete certificate setting will prevent connectivity to Cisco.com, and all Cisco.com-related operations in this area will fail.
           
           
 
          

         
  
       

 
        
        		[bookmark: pgfId-959735]Username

  
        		[bookmark: pgfId-959737]The username Security Manager should use to log in to Cisco.com.

  
       

 
        
        		[bookmark: pgfId-959743]Password

 [bookmark: pgfId-959745]Confirm

  
        		[bookmark: pgfId-959747]The password for the username. Enter the password in both fields.

  
       

 
        
        		 
          
          [bookmark: pgfId-959753]Proxy Server Settings
         
  
       

 
        
        		[bookmark: pgfId-959761]Enable Proxy

  
        		[bookmark: pgfId-959763]Enables Image Manager to connect to Cisco.com via a web proxy server. When Enable Proxy is selected, the other proxy fields (including IP or Hostname, Port, Username, and Password) are enabled and used to connect to the web proxy.

  
       

 
        
        		[bookmark: pgfId-959769]Test Connection

  
        		[bookmark: pgfId-959771]Used to test for connectivity and credentials for Cisco.com.

  
       

 
        
        		 
          
          [bookmark: pgfId-959777]Certificate
         
  
       

 
        
        		[bookmark: pgfId-959785]Contact URL

  
        		
          
          		 [bookmark: pgfId-959787]When selected, "Image Meta-data Locator" is used. This is the URL on Cisco.com that is used to obtain meta-data information about images. Meta-data information consists of the images applicable to a particular product, name, size, checksum, and URL to download for each image.

 
          		 [bookmark: pgfId-959789]When selected, "Other" is used. You can enter any valid HTTPS URL. This URL is intended primarily for the HTTPS URL to download the image as obtained from the meta-data information about the image. This URL may be different from the URL of the image meta-data locator described in the previous paragraph; the certificate may be different, as well.

 
         

 
          
          [image: ] 
         
 
         
 
         
          [bookmark: pgfId-959791]Caution If you choose "Other," you need to explicitly add "https://dl.cisco.com" [without the quotation marks]: Enter it in the text field adjacent to the "Other" button. Failure to do this will prevent connectivity to Cisco.com, and all Cisco.com-related operations in this area will fail.
           
           
 
          

         
  
       

 
        
        		[bookmark: pgfId-959797]Retrieve Certificate

  
        		[bookmark: pgfId-959799]Used to connect to and retrieve the certificate from the selected ‘"Contact URL’." After retrieving the certificate it opens the Certificate Verification dialog, which along with a brief summary of the certificate, i.e., who the certificate is issued to, by whom, and the validity period of the certificate, gives you the following choices:

 
          
          		 [bookmark: pgfId-959801] View Certificate —Opens the Certificate Viewer, where you can see all the details of the certificate: Certificate Authority, version, serial number, thumbprint, and other details. It shows the complete certificate chain information all the way up to the root issuing certificate Authority.

 
          		 [bookmark: pgfId-959803] Accept —Accepts the certificate and adds it to the Cisco Security Manager.

 
          		 [bookmark: pgfId-959805] Reject —Rejects the certificate and no action is taken.

 
          		 [bookmark: pgfId-959807] Cancel —Closes the Certificate Verification dialog with no action taken.

 
         

 [bookmark: pgfId-959809]You must view and accept the following recommended certificates:

 
          
          		 [bookmark: pgfId-959811]https://www.cisco.com

 
          		 [bookmark: pgfId-959813]https://www.dl3.cisco.com

 
          		 [bookmark: pgfId-959815]https://www.cloudsso.cisco.com

 
          		 [bookmark: pgfId-959817]https://www.api.cisco.com

 
         

  
       

 
        
        		[bookmark: pgfId-959823]Certificates

  
        		[bookmark: pgfId-959825]A table that displays, for each certificate in your Security Manager installation, Subject, Issued By, and Accepted By.

  
       

 
        
        		[bookmark: pgfId-959831]View

  
        		[bookmark: pgfId-959833]Opens the Certificate Viewer for a certificate selected in the Certificate table.

  
       

 
        
        		[bookmark: pgfId-959839]Remove

  
        		[bookmark: pgfId-959841]Removes a certificate selected in the Certificate table.

  
       

 
        
        		[bookmark: pgfId-959847]Save button

  
        		[bookmark: pgfId-959849]Saves your changes.

  
       

 
        
        		[bookmark: pgfId-959855]Reset button

  
        		[bookmark: pgfId-959857]Resets changes to the last saved values.

  
       

 
        
        		[bookmark: pgfId-959863]Restore Defaults button

  
        		[bookmark: pgfId-959865]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-965744][bookmark: 31755][bookmark: syspage_cncpt_ConfigurationArchiveSettingsPage]Configuration Archive Page[bookmark: marker-965738][bookmark: marker-965740][bookmark: marker-965742]

 
    [bookmark: pgfId-965746]Use the Configuration Archive page to define the default settings for the Configuration Archive tool, including how many configuration versions to save and the TFTP server to use for rolling back Cisco IOS software device configurations.

 
    [bookmark: pgfId-965748]Navigation Path

 
    [bookmark: pgfId-965750]Click Tools > Security Manager Administration and select Configuration Archive from the table of contents.

 
    [bookmark: pgfId-965752]Related Topics

 
     
     		 [bookmark: pgfId-965757]Configuration Archive Window

 
     		 [bookmark: pgfId-965762]Rolling Back Configurations

 
    

 
    [bookmark: pgfId-965764]Field Reference

 
    [bookmark: pgfId-965767] 

 
     
      
       
       [bookmark: pgfId-959878]Table 11-5 [bookmark: 31785]Configuration Archive Page 

 
       
      
        
        		
          
          [bookmark: pgfId-959884]Element
         
  
        		
          
          [bookmark: pgfId-959886]Description
         
  
       

 
        
        		[bookmark: pgfId-959892]Max. Versions per Device

 [bookmark: pgfId-959894]Purge Now button

 [bookmark: pgfId-959896]Enable Configuration Archive Versions Auto Purge

  
        		[bookmark: pgfId-959898]The number of configuration versions you want to retain for each managed device, from 1 to 100. If you reduce the number, you can click Purge Now to immediately delete extra versions.

 [bookmark: pgfId-959900]Security Manager automatically deletes extra versions during its normal cleanup cycle if you select the Enable Configuration Archive Versions Auto Purge option.

  
       

 
        
        		[bookmark: pgfId-959906]TFTP Server for Rollback

  
        		[bookmark: pgfId-959908]The fully-qualified DNS hostname or IP address of the server to use for TFTP file transfers. TFTP is used during rollback for IOS devices when the configuration cannot be updated using the configure replace command, which does not force a system reload. Enter localhost to use the Security Manager server.

 [bookmark: pgfId-959910]By default, a TFTP server is enabled on the Security Manager server. If you specify a remote TFTP server, you must configure that server appropriately to provide TFTP services.

  
       

 
        
        		[bookmark: pgfId-959916]TFTP Root Directory

  
        		[bookmark: pgfId-959918]The root directory for configuration file transfers if you are using the Security Manager server as the TFTP server. Click Browse to select a directory on the Security Manager server.

 [bookmark: pgfId-959920]If you specify a server other than the Security Manager server as the TFTP host, Security Manager always uses the root directory of that TFTP server. You cannot specify a non-root directory for remote TFTP servers.

  
       

 
        
        		[bookmark: pgfId-959926]Save button

  
        		[bookmark: pgfId-959928]Saves and applies changes.

  
       

 
        
        		[bookmark: pgfId-959934]Reset button

  
        		[bookmark: pgfId-959936]Resets changes to the last saved values.

  
       

 
        
        		[bookmark: pgfId-959942]Restore Defaults button

  
        		[bookmark: pgfId-959944]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-965781][bookmark: 31836][bookmark: syspage_cncpt_CSMARSPage]CS-MARS Page [bookmark: marker-965775][bookmark: marker-965777][bookmark: marker-965779]

 
    [bookmark: pgfId-965783]Use the CS-MARS page to register the Cisco Security Monitoring, Analysis and Response System servers that are monitoring your devices with Security Manager. By registering your CS-MARS servers, you can view messages and events captured in CS-MARS based on a device’s firewall access rules or IPS signature rules configured in Security Manager. You must register a CS-MARS server before users can see events collected from it.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-965785]Tip If you are using CS-MARS global controllers, add them instead of the individual local controllers. By adding global controllers, Security Manager can identify the correct local controller for a device automatically, without you having to add each of the local controllers. This simplifies your CS-MARS configuration in Security Manager.


    
     

    

    

 
    [bookmark: pgfId-965787]Navigation Path

 
    [bookmark: pgfId-965789]Select Tools > Security Manager Administration and select CS-MARS from the table of contents.

 
    [bookmark: pgfId-965791]Related Topics

 
     
     		 [bookmark: pgfId-965796]Registering CS-MARS Servers in Security Manager

 
    

 
    [bookmark: pgfId-965798]Field Reference

 
    [bookmark: pgfId-965801] 

 
     
      
       
       [bookmark: pgfId-959957]Table 11-6 [bookmark: 31864]CS-MARS Page 

 
       
      
        
        		
          
          [bookmark: pgfId-959963]Element
         
  
        		
          
          [bookmark: pgfId-959965]Description
         
  
       

 
        
        		[bookmark: pgfId-959971]CS-MARS Devices

  
        		[bookmark: pgfId-959973]The CS-MARS servers that are registered with Security Manager.

 
          
          		 [bookmark: pgfId-959978]To add a server, click the Add (+) button and fill in the New or Edit CS-MARS Device Dialog Box.

 
          		 [bookmark: pgfId-959980]To edit a server, select it and click the Edit (pencil) button.

 
          		 [bookmark: pgfId-959982]To delete a server, select it and click the Delete (trash can) button. When you delete a server, the device properties for all devices that use the server are updated to remove the server connection. If a device is also monitored by another CS-MARS server on the list, its properties are updated to point to the other server.

 
         

  
       

 
        
        		[bookmark: pgfId-959988]When Launching CS-MARS

 [bookmark: pgfId-959990]Allow User to Save Credentials

  
        		[bookmark: pgfId-959992]The type of credentials Security Manager should use to log into CS-MARS when obtaining event information:

 
          
          		 [bookmark: pgfId-959994] Prompt users —When the user tries to get event information from CS-MARS, prompt the user to log into CS-MARS. If you select this option, you can also select  Allow User to Save Credentials , which gives users the option to save their credentials so they do not have to log into CS-MARS again the next time they request event status.

 
          		 [bookmark: pgfId-959996] Use CS-Manager Credentials —When the user tries to get event information from CS-MARS, log into CS-MARS using the same username and password the user used to log into Security Manager.

 
         

  
       

 
        
        		[bookmark: pgfId-960002]Save button

  
        		[bookmark: pgfId-960004]Saves and applies changes.

  
       

 
        
        		[bookmark: pgfId-960010]Reset button

  
        		[bookmark: pgfId-960012]Resets changes to the last saved values.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-965813][bookmark: 31911][bookmark: syspage_cncpt_AddorEditNewCSMARSDeviceDialogBox]New or Edit CS-MARS Device Dialog Box[bookmark: marker-965811]

 
     [bookmark: pgfId-965818]Use the New or Edit CS-MARS Device dialog box to register a CS-MARS server with Security Manager. Users can obtain messages or event status for a device’s firewall or IPS policies from the CS-MARS server that is monitoring the device. For more information, see Registering CS-MARS Servers in Security Manager.

 
     [bookmark: pgfId-965820]Navigation Path

 
     [bookmark: pgfId-965825]From the CS-MARS Page, click the Add button to add a new server, or select a server and click the Edit button.

 
     [bookmark: pgfId-965827]Field Reference

 
     [bookmark: pgfId-965830] 

 
      
       
        
        [bookmark: pgfId-960025]Table 11-7 [bookmark: 31927]Add or Edit CS-MARS Device Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-960031]Element
          
  
         		
           
           [bookmark: pgfId-960033]Description
          
  
        

 
         
         		[bookmark: pgfId-960039]CS-MARS Hostname/IP

  
         		[bookmark: pgfId-960041]The IP address or fully-qualified DNS host name of the CS-MARS server.

 [bookmark: pgfId-960043]Tip If you add a CS-MARS global controller, do not add any of the local controllers that the global controller monitors. Security Manager will automatically determine the local controller that is monitoring a specific device. Adding global controllers simplifies your CS-MARS configuration.  
        

 
         
         		[bookmark: pgfId-960049]Username

 [bookmark: pgfId-960051]Password

 [bookmark: pgfId-960053]User Type

  
         		[bookmark: pgfId-960055]The username and password for logging into the server to validate that the CS-MARS server is running the appropriate software version and to obtain other basic information. Security Manager also uses this account to determine which CS-MARS server is monitoring a particular device.

 [bookmark: pgfId-960057]For CS-MARS local controllers, you can enter either a global or local user account. For global controllers, you must enter a global account. Identify the type of account in the User Type field.

  
        

 
         
         		[bookmark: pgfId-960063]Certificate Thumbprint

 [bookmark: pgfId-960065]Retrieve From Device button

  
         		[bookmark: pgfId-960067]The CS-MARS server certificate, a hexadecimal string that is unique to the device. Click Retrieve From Device to have Security Manager retrieve the certificate from the CS-MARS server.

 [bookmark: pgfId-960069]If the certificate is retrieved successfully, it is displayed. After verifying the certificate, click Accept to save it on the Security Manager server. You must have a correct certificate to use the CS-MARS server from Security Manager.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-965844][bookmark: 31962][bookmark: syspage_cncpt_CsmMobileSettings]CSM Mobile Page[bookmark: marker-965838][bookmark: marker-965840][bookmark: marker-965842]

 
    [bookmark: pgfId-965846]Use the CSM Mobile page of the Security Manager Administration window to enable or disable the CSM Mobile feature in Cisco Security Manager. If the CSM Mobile feature is enabled, users can access device health and summary information from mobile devices by navigating to the following link, where <SecManServer> is the DNS name or IP address of the Security Manager server:

 
    [bookmark: pgfId-965848]https://<SecManServer>/mobile/

 
    [bookmark: pgfId-965850]or

 
    [bookmark: pgfId-965852]https://<SecManServer>/mobile

 
    [bookmark: pgfId-965857]For more information about the types of information provided, see Dashboard Overview.

 
    [bookmark: pgfId-965862]For more information about CSM Mobile, see CSM Mobile.

 
    [bookmark: pgfId-965864]Navigation Path

 
    [bookmark: pgfId-965866]Click Tools > Security Manager Administration and select CSM Mobile from the table of contents.

 
    [bookmark: pgfId-965868]Field Reference

 
    [bookmark: pgfId-965871] 

 
     
      
       
       [bookmark: pgfId-960082]Table 11-8 [bookmark: 31992]CSM Mobile Page 

 
       
      
        
        		
          
          [bookmark: pgfId-960088]Element
         
  
        		
          
          [bookmark: pgfId-960090]Description
         
  
       

 
        
        		[bookmark: pgfId-960096]Enable CSM Mobile Feature

  
        		[bookmark: pgfId-960098]Lets you enable or disable the CSM Mobile feature. If you disable this feature, you cannot access device health summary information from mobile devices.

  
       

 
        
        		[bookmark: pgfId-960104]Save button

  
        		[bookmark: pgfId-960106]Saves and applies changes.

 [bookmark: pgfId-960108]If you change whether the service is enabled, it stops or starts, as appropriate. You are shown a progress indicator.

  
       

 
        
        		[bookmark: pgfId-960114]Reset button

  
        		[bookmark: pgfId-960116]Resets changes to the last saved values.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-965889][bookmark: 32019][bookmark: syspage_cncpt_CustomizeDesktopPage]Customize Desktop Page[bookmark: marker-965879][bookmark: marker-965881][bookmark: marker-965883][bookmark: marker-965885][bookmark: marker-965887]

 
    [bookmark: pgfId-965891]Use the Customize Desktop page to control whether Security Manager applications close automatically after being idle for a specified time, to reset whether you are prompted to verify your actions in certain circumstances, and to control whether certain file operations can be performed on the Security Manager client.

 
    [bookmark: pgfId-965893]Navigation Path

 
    [bookmark: pgfId-965895]Select Tools > Security Manager Administration and select Customize Desktop from the table of contents.

 
    [bookmark: pgfId-965897]Related Topics

 
     
     		 [bookmark: pgfId-965902]Installing Security Manager License Files

 
     		 [bookmark: pgfId-965907]Importing Policies or Devices

 
     		 [bookmark: pgfId-965912]Exporting the Device Inventory from the Security Manager Client

 
     		 [bookmark: pgfId-965917]Exporting Shared Policies

 
     		 [bookmark: pgfId-965922]Add and Edit File Object Dialog Boxes

 
     		 [bookmark: pgfId-965927]Selecting IPS License Files

 
    

 
    [bookmark: pgfId-965929]Field Reference

 
    [bookmark: pgfId-965932] 

 
     
      
       
       [bookmark: pgfId-960129]Table 11-9 [bookmark: 32065]Customize Desktop Page 

 
       
      
        
        		
          
          [bookmark: pgfId-960135]Element
         
  
        		
          
          [bookmark: pgfId-960137]Description
         
  
       

 
        
        		[bookmark: pgfId-960143]Reset ‘Do Not Ask’ on Warnings button

  
        		[bookmark: pgfId-960145]Click this button to reestablish ‘Are you sure...?’ pop-up warnings. When you perform some actions, you are warned about the consequences and you are given the option to not be warned again. If you selected Do Not Ask Me Again for any of these warnings, clicking this button reenables the warning.

  
       

 
        
        		[bookmark: pgfId-960151]Enable Idle Timeout

 [bookmark: pgfId-960153]Idle Timeout (minutes)

  
        		[bookmark: pgfId-960155]Whether to have the Security Manager client applications close automatically if you do not use them for the specified period of time. The timeout applies across all applications; working in one application resets the timer in all applications.

 [bookmark: pgfId-960157]If you select this option, enter the number of minutes that must elapse before closing the client in the Idle Timeout field. The default is to close the client after 120 minutes of inactivity.

  
       

 
        
        		[bookmark: pgfId-960163]Enable Client side file browser

  
        		[bookmark: pgfId-960165]Whether to allow file operations on the Security Manager client. If you select this option, you will be able to choose between client and server file systems when performing the following file operations:

 
          
          		 [bookmark: pgfId-960167]Installing Security Manager license files

 
          		 [bookmark: pgfId-960169]Installing IPS license files

 
          		 [bookmark: pgfId-960171]Importing/exporting device inventory files

 
          		 [bookmark: pgfId-960173]Importing/exporting shared policies

 
          		 [bookmark: pgfId-960175]Creating the following file objects:

 
         

 [bookmark: pgfId-960177] – Cisco Secure Desktop Package

 [bookmark: pgfId-960179] – Plug-In—For browser plug-in files.

 [bookmark: pgfId-960181] – AnyConnect Profile

 [bookmark: pgfId-960183] – AnyConnect Image

 [bookmark: pgfId-960185] – Hostscan Image

 [bookmark: pgfId-960187]This option is enabled by default.

  
       

 
        
        		 
          
          [bookmark: pgfId-960193]Global Search
         
  
       

 
        
        		[bookmark: pgfId-960201]Enable Global Search

  
        		[bookmark: pgfId-960203]Whether to enable or disable the Global Search feature. This feature is enabled by default.

 [bookmark: pgfId-960205]Tip You can disable Global Search before performing bulk discovery or rediscovery of devices to improve performance. You can reenable Global Search and then recreate the index after discovery is complete or when users are least likely to be using the system.  
       

 
        
        		[bookmark: pgfId-960211]Recreate Index

  
        		[bookmark: pgfId-960213]Click this button to regenerate the search index. The global search feature is not available while the index is being recreated.

  
       

 
        
        		[bookmark: pgfId-960219]Save button

  
        		[bookmark: pgfId-960221]Saves and applies changes.

  
       

 
        
        		[bookmark: pgfId-960227]Reset button

  
        		[bookmark: pgfId-960229]Resets changes to the last saved values.

  
       

 
        
        		[bookmark: pgfId-960235]Restore Defaults button

  
        		[bookmark: pgfId-960237]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-965956][bookmark: 32147][bookmark: syspage_cncpt_DebugOptionsPage]Debug Options Page[bookmark: marker-965940][bookmark: marker-965942][bookmark: marker-965944][bookmark: marker-965946][bookmark: marker-965948][bookmark: marker-965950][bookmark: marker-965952][bookmark: marker-965954]

 
    [bookmark: pgfId-965958]Use the Debug Options page to configure the severity level of messages to include in debugging logs and to determine what other debugging information is collected.

 
    [bookmark: pgfId-965960]You should change debugging levels only if the Cisco Technical Assistance Center (TAC) asks you to change them. This makes it possible for you to include more detailed information in the CSMDiagnostics.zip file.

 
    [bookmark: pgfId-965965]After you change the message level for the appropriate subcomponent, redo the actions that are resulting in system problems. After the problems occur, create the CSMDiagnostics.zip file (or the CSMDiagnostics_light.zip file) by selecting Tools > Security Manager Diagnostics... > General Diagnostics... (or Tools > Security Manager Diagnostics... > Light Diagnostics...). You can then reset the debug options to the default levels so that the Security Manager server does not become bogged down collecting extra debug information. For more information about generating the CSMDiagnostics.zip file, see Creating Diagnostics Files for the Cisco Technical Assistance Center.

 
    [bookmark: pgfId-965967]By default, logs contain messages of the Error severity or worse. The severity levels in order of severity are:

 
     
     		 [bookmark: pgfId-965969]Severe—Problems that make the system unusable.

 
     		 [bookmark: pgfId-965971]Error—Problems from which Security Manager cannot recover.

 
     		 [bookmark: pgfId-965973]Warning—Unexpected conditions from which Security Manager can recover.

 
     		 [bookmark: pgfId-965975]Info—Informational messages.

 
     		 [bookmark: pgfId-965977]Debug—Internal status information.

 
    

 
    [bookmark: pgfId-965979]Navigation Path

 
    [bookmark: pgfId-965981]Select Tools > Security Manager Administration, then select Debug Options from the table of contents.

 
    [bookmark: pgfId-965983]Field Reference

 
    [bookmark: pgfId-965986] 

 
     
      
       
       [bookmark: pgfId-960250]Table 11-10 [bookmark: 32201]Debug Options Page 

 
       
      
        
        		
          
          [bookmark: pgfId-960256]Element
         
  
        		
          
          [bookmark: pgfId-960258]Description
         
  
       

 
        
        		[bookmark: pgfId-960264]Capture Discovery/Deployment Debugging Snapshots to File

  
        		[bookmark: pgfId-960266]Whether Security Manager generates data files about configuration generation, deployment, and discovery as these functions are performed. The temporary data files are stored in the MDC\temp directory in the Security Manager installation folder on the server, and you can use these files for debugging purposes.

 [bookmark: pgfId-960268]Enable this setting if you encounter problems with deployment or discovery.

 [bookmark: pgfId-960270]If you need to send these files to Cisco TAC for debugging, encrypt the files, because they can contain sensitive data such as passwords.

 [bookmark: pgfId-960272]Note Selecting this check box slows down Security Manager response time. Enable this option only in limited circumstances.

  
       

 
        
        		[bookmark: pgfId-960278]Deployment Debug Level

  
        		[bookmark: pgfId-960280]The message severity level for deployment-related actions such as device communication.

  
       

 
        
        		[bookmark: pgfId-960286]Event Manager Debug Level

  
        		[bookmark: pgfId-960288]The message severity level for the Event Manager subsystem.

  
       

 
        
        		[bookmark: pgfId-960294]Health and Performance Monitor Debug Level

  
        		[bookmark: pgfId-960296]The message severity level for the Health and Performance Monitor subsystem.

  
       

 
        
        		[bookmark: pgfId-960302]Image Manager Debug Level

  
        		[bookmark: pgfId-960304]The message severity level for the Image Manager subsystem.

  
       

 
        
        		[bookmark: pgfId-960310]Firewall Services Debug Level

  
        		[bookmark: pgfId-960312]The message severity level for firewall-related policies.

  
       

 
        
        		[bookmark: pgfId-960318]IOS Platform Debug Level

  
        		[bookmark: pgfId-960320]The message severity level for Cisco IOS Software platform policies.

  
       

 
        
        		[bookmark: pgfId-960326]PIX Platform Debug Level

  
        		[bookmark: pgfId-960328]The message severity level for PIX, ASA, and FWSM platform policies.

  
       

 
        
        		[bookmark: pgfId-960334]Report Manager Debug Level

  
        		[bookmark: pgfId-960336]The message severity level for the Report Manager subsystem.

  
       

 
        
        		[bookmark: pgfId-960342]VPN Services Debug Level

  
        		[bookmark: pgfId-960344]The message severity level for VPN services policies.

  
       

 
        
        		[bookmark: pgfId-960350]API Debug Level

  
        		[bookmark: pgfId-960352]The message severity level for the Application Programming Interface subsystem.

  
       

 
        
        		[bookmark: pgfId-960358]Save button

  
        		[bookmark: pgfId-960360]Saves your changes.

  
       

 
        
        		[bookmark: pgfId-960366]Reset button

  
        		[bookmark: pgfId-960368]Restores all fields to their previous values.

  
       

 
        
        		[bookmark: pgfId-960374]Restore Defaults button

  
        		[bookmark: pgfId-960376]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-966000][bookmark: 32285][bookmark: syspage_cncpt_DeploymentPage-1]Deployment Page[bookmark: marker-965994][bookmark: marker-965996][bookmark: marker-965998]

 
    [bookmark: pgfId-966002]Use the Deployment page to define the default methods by which Security Manager deploys configurations to devices. You can override some of these settings when you create deployment jobs.

 
    [bookmark: pgfId-966004]Navigation Path

 
    [bookmark: pgfId-966006]Select Tools > Security Manager Administration and select Deployment from the table of contents.

 
    [bookmark: pgfId-966008]Related Topics

 
     
     		 [bookmark: pgfId-966013]Chapter 8, “Managing Deployment”

 
     		 [bookmark: pgfId-966018]Chapter 6, “Managing Policy Objects”

 
    

 
    [bookmark: pgfId-966020]Field Reference

 
    [bookmark: pgfId-966023] 

 
     
      
       
       [bookmark: pgfId-960389]Table 11-11 [bookmark: 32315]Deployment Page 

 
       
      
        
        		
          
          [bookmark: pgfId-960395]Element
         
  
        		
          
          [bookmark: pgfId-960397]Description
         
  
       

 
        
        		 
          
          [bookmark: pgfId-960403]General Parameters
         
  
       

 
        
        		[bookmark: pgfId-960411]Purge Debugging Files Older Than (days)

  
        		[bookmark: pgfId-960413]The maximum number of days the system should keep debugging files. Debug files are automatically deleted. If you decrease the number of days, you can click Purge Now to immediately delete all debugging files older than the number of days specified.

  
       

 
        
        		[bookmark: pgfId-960419]Default Deployment Method

 [bookmark: pgfId-960421]Directory

  
        		[bookmark: pgfId-960423]The method to use as the default method for deploying configurations to devices:

 
          
          		 [bookmark: pgfId-960428]Device—Deploys the configuration directly to the device or to the transport mechanism specified for the device. For more information, see Deploying Directly to a Device.

 
          		 [bookmark: pgfId-960433]File—Deploys the configuration file to a directory on the Security Manager server. If you select File, specify the directory to which you want to deploy the configuration file in the Destination column. Even if you select file as the default, the setting does not apply to IPS devices; you can use device deployment only for IPS devices. For more information, see Deploying to a File.

 
         

 [bookmark: pgfId-960435]You can override this method when you create deployment jobs.

  
       

 
        
        		[bookmark: pgfId-960441]When Out of Band Changes Detected

  
        		[bookmark: pgfId-960443]How Security Manager should respond when it detects that changes were made directly on the device CLI since a configuration was last deployed to the device. Out of band change detection works correctly only when deploying to device, not to file, and applies only when the deployment method is configured to obtain the reference configuration from the device (see below for a description of the Reference Configuration setting).

 [bookmark: pgfId-960445]This setting specifies the default action, which you can override when you create deployment jobs. You can choose one of the following:

 
          
          		 [bookmark: pgfId-960447] Overwrite changes and show warning (default)—If changes were made to the device manually, Security Manager continues with the deployment, overwrites the changes, and displays a warning notifying you of this action.

 
          		 [bookmark: pgfId-960449] Cancel deployment —If changes were made to the device manually, Security Manager cancels the deployment and displays a warning notifying you of this action.

 
          		 [bookmark: pgfId-960451] Do not check for changes —Security Manager does not check for changes and deploys the changes to the device, overwriting any local modifications.

 
         

 [bookmark: pgfId-960456]For a more complete discussion of out-of-band change handling, see Understanding How Out-of-Band Changes are Handled.

 
          
          [image: ] 
         
 
         
 [bookmark: pgfId-1065446]Note For devices in which failover is not configured, if you select the Cancel Deployment option when Out of Band changes are detected, the bootstrap configuration may cause deployments to fail. For deployments to be successful, you must configure failover before discovering the device in Security Manager.


         
          

         


  
       

 
        
        		[bookmark: pgfId-960462]Deploy to File Reference Configuration

  
        		[bookmark: pgfId-960464]The configuration that Security Manager uses to compare new policies against the previous configuration for the device, if you are deploying the configuration to a file on the Security Manager server.

 
          
          		 [bookmark: pgfId-960466]Archive (default)—The most recently archived configuration.

 
          		 [bookmark: pgfId-960468]Device—The current running device configuration, which is obtained from the device.

 
         

 [bookmark: pgfId-960470]After comparing the configurations, Security Manager generates the correct CLI for deployment.

  
       

 
        
        		[bookmark: pgfId-960476]Deploy to Device Reference Configuration

  
        		[bookmark: pgfId-960478]The configuration that Security Manager uses to compare new policies against the previous configuration for the device, if you are deploying the configuration directly to the device (or to a transport server).

 
          
          		 [bookmark: pgfId-960480]Archive—The most recently archived configuration.

 
          		 [bookmark: pgfId-960482]Device (default)—The current running device configuration, which is obtained from the device.

 
         

 [bookmark: pgfId-960484]After comparing the configurations, Security Manager generates the correct CLI for deployment.

  
       

 
        
        		[bookmark: pgfId-960490]Allow Download on Error

  
        		[bookmark: pgfId-960492]Whether deployments to devices should continue even if there are minor device configuration errors.

  
       

 
        
        		[bookmark: pgfId-960498]Save Changes Permanently on Device

  
        		[bookmark: pgfId-960500]Whether to save the running configuration to the startup configuration (using the write memory command) after deploying a configuration to a device. This applies to PIX, FWSM, ASA, or Cisco IOS devices. If you deselect this check box, the startup configuration is not changed, which means your configuration changes will be lost if the device reloads for any reason.

  
       

 
        
        		[bookmark: pgfId-960506]Preselect Devices with Undeployed Changes

  
        		[bookmark: pgfId-960508]Whether the list of changed devices you see when you create a deployment job has all changed devices preselected. If you deselect this option, users must manually select the devices to include in the deployment job.

  
       

 
        
        		[bookmark: pgfId-960514]Enable Auto Refresh in Deployment Main Panel

  
        		[bookmark: pgfId-960516]Whether the deployment job and schedule status information should be automatically refreshed in the Deployment Manager window. If you deselect this option, you must click the Refresh button to refresh the information manually.

  
       

 
        
        		[bookmark: pgfId-960522]Remove Unreferenced SSL VPN Files on Device

 [bookmark: pgfId-960524](ASA Only)

  
        		[bookmark: pgfId-960526]Whether to have Security Manager delete files related to the SSL VPN configuration from the device if the files are no longer referred to by the device’s SSL VPN configuration. If you deselect this option, unused files remain on the device after deployment.

  
       

 
        
        		[bookmark: pgfId-960532]Mask Passwords and Keys When Viewing Configs and Transcripts

 [bookmark: pgfId-960534]Mask Passwords and Keys When Deploying to File

  
        		[bookmark: pgfId-960536]The conditions, if any, under which Security Manager will mask the following items so that they cannot be read: passwords for users, enable mode, Telnet, and console; SNMP community strings; keys, including those for TACACS+, Preshared Key, RADIUS server, ISAKMP, failover, web VPN attributes, logging policy attributes, AAA, AUS, OSPF, RIP, NTP, logging FTP server, point-to-point protocol, Storage Key, single sign-on server, load balancing, HTTP/HTTPS proxy, and the IPSEC shared key.

 
          
          		 [bookmark: pgfId-960538]Mask Passwords and Keys When Viewing Configs and Transcripts—This option affects only the screen display of the credentials, which guards against unauthorized personnel viewing them. If you do not select this option, credentials in full transcripts might still be masked depending on how the device handles them.

 
          		 [bookmark: pgfId-960540]Mask Passwords and Keys When Deploying to File—This option affects the contents of configuration files that are deployed to file, making them undeployable to actual devices. Select this option only if you will never need to actually deploy these configurations to real devices. Selecting this option has no effect on whether credentials are masked when viewed.

 
         

  
       

 
        
        		[bookmark: pgfId-960546]Deploy only new or modified Flexconfigs

  
        		[bookmark: pgfId-960548]Whether to deploy FlexConfigs only one time after creation or modification of a FlexConfig, or to deploy all FlexConfigs with each deployment. This option is selected by default.

 [bookmark: pgfId-960550]Note If you have FlexConfigs that need to be deployed with each deployment, then you will need to disable this option. After changing this setting, you will need to manage one-time FlexConfigs by deleting them after they have been deployed.

  
       

 
        
        		 
          
          [bookmark: pgfId-960556]ACL Parameters
         
  
       

 
        
        		[bookmark: pgfId-960564]Optimize the Deployment of Access Rules For

 [bookmark: pgfId-960566](IPv4 and IPv6 access rules.)

  
        		[bookmark: pgfId-960568]How firewall rules are deployed. You can choose one of the following:

 
          
          		 [bookmark: pgfId-960570]Speed (default)—Increases deployment speed by sending only the delta (difference) between the new and old ACLs. This is the recommended option. By making use of ACL line numbers, this approach selectively adds, updates, or deletes ACEs at specific positions and avoids resending the entire ACL. Because the ACL being edited is still in use, there is a small chance that some traffic might be handled incorrectly between the time an ACE is removed and the time that it is added to a new position. The ACL line number feature is supported by most Cisco IOS, PIX and ASA versions, and became available in FWSM from FWSM 3.1(1).

 
          		 [bookmark: pgfId-960572]Traffic—This approach switches ACLs seamlessly and avoids traffic interruption. However, deployment takes longer and uses more device memory before the temporary ACLs are deleted. First, a temporary copy is made of the ACL that is intended for deployment. This temporary ACL binds to the target interface. Then the old ACL is recreated with its original name but with the content of the new ACL. It also binds to the target interface. At this point, the temporary ACL is deleted.

 
         

 [bookmark: pgfId-960574]Note For FWSM devices, this option affects processing only if you also select the Let FWSM Decide When to Compile Access Lists option.

  
       

 
        
        		[bookmark: pgfId-960580]Firewall Access-List Names

 [bookmark: pgfId-960582](IPv4 and IPv6 access rules.)

  
        		[bookmark: pgfId-960584]How ACL names are deployed to devices if the access rule does not have a name in Security Manager.

 
          
          		 [bookmark: pgfId-960586]Reuse existing names—Reuse the ACL name that is configured in the reference configuration (which is usually from the device).

 
          		 [bookmark: pgfId-960588]Reset to CS-Manager generated names—Reset the name to a Security Manager auto-generated ACL name.

 
         

  
       

 
        
        		[bookmark: pgfId-960602]Enable ACL Sharing for Firewall Rules[bookmark: marker-960594][bookmark: marker-960596][bookmark: marker-960598][bookmark: marker-960600]

 [bookmark: pgfId-960604](IPv4 and IPv6 access rules.)

  
        		[bookmark: pgfId-960606]Whether Security Manager should share a single access control list (ACL) for an access rule policy with more than one interface. If you do not select this option, Security Manager creates unique ACLs for every interface to which you apply an IPv4 or IPv6 access rule policy. The sharing of ACLs is done only for ACLs created by access rule policies.

 [bookmark: pgfId-960608]If you select this option, Security Manager evaluates the access rules policy for each interface and deploys the minimum number required to implement your policy while preserving your ACL naming requirements. For example, if you use an interface role to assign the same rules to four interfaces, you specify Reset to CS-Manager generated names for the Firewall Access-List Names property, and you do not specify ACL names for the interfaces in the access control settings policy, only a single ACL is deployed, and each interface uses that ACL.

 [bookmark: pgfId-960610]If you select this option, keep the following in mind:

 
          
          		 [bookmark: pgfId-960612]An interface might use an ACL that is named for a different interface.

 
          		 [bookmark: pgfId-960614]If you specify a name for the ACL in the access control settings policy, an ACL by that name is created even if it is otherwise identical to one used by another interface. Names specified in this policy have precedence over any other settings.

 
          		 [bookmark: pgfId-960616]If you select  Reuse existing names for the Firewall Access-List Names property, the existing names are preserved (unless you override them in the access control settings policy). This means that you might end up with duplicate ACLs under different names if duplicate ACLs already exist on the device.

 
          		 [bookmark: pgfId-960618]Hit count statistics are based on ACL, not on interface, so a shared ACL provides statistics that are combined from all interfaces that share the ACL.

 
          		 [bookmark: pgfId-960620]Sharing ACLs is primarily beneficial for memory-constrained devices such as the FWSM.

 
         

  
       

 
        
        		[bookmark: pgfId-960626]Let FWSM Decide When to Compile Access Lists

 [bookmark: pgfId-960628](IPv4 access rules only.)

  
        		[bookmark: pgfId-960630]Whether to have the Firewall Services Module (FWSM) automatically determine when to compile access lists. Selecting this option might increase deployment speed but traffic might be disrupted and the system might become incapable of reporting ACL compilation error messages. If you select this option, you can use the Optimize the Deployment of Access Rules For Traffic setting to mitigate potential traffic disruptions.

 [bookmark: pgfId-960632]When deselected, Security Manager controls ACL compilation to avoid traffic interruption and to minimize peak memory usage on the device.

 
          
          [image: ] 
         
 
         
 
         
          [bookmark: pgfId-960634]Caution You should not select this option unless you are experiencing deployment problems and you are an advanced user.
           
           
 
          

         
  
       

 
        
        		[bookmark: pgfId-960640]Remove Unreferenced Access-lists on Device

 [bookmark: pgfId-960642](IPv4 and IPv6 access rules.)

  
        		[bookmark: pgfId-960644]Whether to delete any access lists that are not being used by other CLI commands managed by Security Manager from devices during deployment.

 [bookmark: pgfId-960646]Note After enabling this option, Security Manager will remove access lists during deployment that are not used in any policies managed or discovered by Security Manager. If any policy that is NOT discovered or managed by Security Manager is using such an access list, Security Manager will still attempt to delete that object during deployment. This also applies to access lists that are used in FlexConfigs but are not used in any other policies managed by Security Manager.

  
       

 
        
        		[bookmark: pgfId-960652]Generate ACL Remarks During Deployment

 [bookmark: pgfId-960654](IPv4 and IPv6 access rules.)

  
        		[bookmark: pgfId-960656]Whether to display ACL warning messages and remarks during deployment.

  
       

 
        
        		[bookmark: pgfId-960662]Preserve Sections for Access Rules

  
        		[bookmark: pgfId-960664]Whether to deploy the section name under which access rules are organized. This option ensures that if a device is discovered or rediscovered, the section names will not be lost.

  
       

 
        
        		[bookmark: pgfId-960670]Generate CSM Rule Number

  
        		[bookmark: pgfId-960672]Whether to deploy the rule number used in the Cisco Security Manager user interface. This option helps in correlating an access rule in a device configuration to its position in rule table.

  
       

 
        
        		 
          
          [bookmark: pgfId-960678]Object Group Parameters
         
  
       

 
        
        		[bookmark: pgfId-960686]Remove Unreferenced Object Groups from Device (PIX, ASA, FWSM, IOS 12.4(20)T+)

 [bookmark: pgfId-960688](IPv4 and IPv6 objects.)

  
        		[bookmark: pgfId-960690]Whether Security Manager should remove object groups that are not being used by other CLI commands managed by Security Manager from devices during deployment. Object groups include network/host, service, and identity user groups.

 [bookmark: pgfId-960692]Note After enabling this option, Security Manager will remove objects during deployment that are not used in any policies managed or discovered by Security Manager. If any policy that is NOT discovered or managed by Security Manager is using such an object, Security Manager will still attempt to delete that object during deployment. In such cases, deployment will fail with a transcript error indicating that it was unable to delete the object.

 [bookmark: pgfId-960694]Tip Network/host objects that include object NAT configurations on ASA 8.3+ devices are never considered unreferenced.  
       

 
        
        		[bookmark: pgfId-960700]Create Object Groups for Policy Objects (PIX, ASA, FWSM, IOS 12.4(20)T+)

 [bookmark: pgfId-960702]Create Object Groups for Multiple Sources, Destinations or Services in a Rule (PIX, ASA, FWSM, IOS 12.4(20)T+)

 [bookmark: pgfId-960704]Optimize Network Object Groups During Deployment (PIX, ASA, FWSM, IOS 12.4(20)T+)

 [bookmark: pgfId-960706](IPv4 and IPv6 objects.)

  
        		[bookmark: pgfId-960708]Whether Security Manager should create object groups, such as network objects, service group objects, and identity user group objects, to replace comma-separated values in a rule table cell for the indicated devices. When deselected, Security Manager flattens the object groups to display the IP addresses, sources and destinations, users, ports, and protocols for these devices.

 [bookmark: pgfId-960710]Tip These options do not apply to host, network, or address range network/host objects, or to service objects (as opposed to service group objects), which are always created as objects. Multiple FQDN network objects can be grouped into a single network object. [bookmark: pgfId-960712]If you select this option, you can also select these options:

 
          
          		 [bookmark: pgfId-960717]Create Object Groups for Multiple Sources, Destinations or Services in a Rule—Whether to automatically create network objects, service objects, and identity user group objects to replace comma-separated values in a rule table cell that resulted when multiple rules were combined. The objects are created during deployment and are in the format of ’CSM_INLINE...’ for example, ’CSM_INLINE_src_rule_8589960758’. For more information, see Combining Rules.

 
          		 [bookmark: pgfId-960722]Optimize Network Object Groups During Deployment—Whether to optimize network object groups by making them more succinct. For more information on optimizing policy objects, see Optimizing Network Object Groups When Deploying Firewall Rules.

 
         

  
       

 
        
        		 
          
          [bookmark: pgfId-960728]IPS Parameters
         
  
       

 
        
        		 
       

 
        
        		 
       

 
        
        		[bookmark: pgfId-960752]Remove Unreferenced Signature and Event Action Variables from IPS Device (IPS Parameters object group)

  
        		[bookmark: pgfId-960754]Whether to delete the unused variables from the sensor (IPS device) configuration during the next deployment. IPS Event and Signature Variables are defined as policy objects in Security Manager.

 [bookmark: pgfId-960756]Disabled by default (checkbox is cleared by default); that is, do not remove the unreferenced variables.

 [bookmark: pgfId-960758]Applies to the following variables; applies to both IPv4 and IPv6:

 
          
          		 [bookmark: pgfId-960760]signature source and destination addresses

 
          		 [bookmark: pgfId-960762]signature service port variables in signature engine parameters

 
          		 [bookmark: pgfId-960764]victim and attacker addresses in event action filters

 
          		 [bookmark: pgfId-960766]network information target addresses

 
         

 [bookmark: pgfId-960768]Does not apply to the following variables:

 
          
          		 [bookmark: pgfId-960770]signature source port

 
          		 [bookmark: pgfId-960772]OS identification address

 
          		 [bookmark: pgfId-960774]signature destination port

 
         

  
       

 
        
        		[bookmark: pgfId-960780]Save button

  
        		[bookmark: pgfId-960782]Saves and applies changes.

  
       

 
        
        		[bookmark: pgfId-960788]Reset button

  
        		[bookmark: pgfId-960790]Resets changes to the last saved values.

  
       

 
        
        		[bookmark: pgfId-960796]Restore Defaults button

  
        		[bookmark: pgfId-960798]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-966035][bookmark: 32613][bookmark: syspage_cncpt_DeviceCommunicationPage]Device Communication Page[bookmark: marker-966031][bookmark: marker-966033]

 
    [bookmark: pgfId-966037]Use the Device Communication page to define default settings for communicating with devices. These settings mainly affect device inventory and policy discovery and configuration deployment. You can override the transport settings for individual devices in the device properties for the device.

 
    [bookmark: pgfId-966039]If you change the transport protocol settings, ensure that your devices are appropriately configured to accept those types of connections.

 
    [bookmark: pgfId-966041]Navigation Path

 
    [bookmark: pgfId-966043]Select Tools > Security Manager Administration and select Device Communication from the table of contents.

 
    [bookmark: pgfId-966045]Related Topics

 
     
     		 [bookmark: pgfId-966050]Adding Devices to the Device Inventory

 
     		 [bookmark: pgfId-966055]Chapter 3, “Managing the Device Inventory”

 
     		 [bookmark: pgfId-966060]Chapter 2, “Preparing Devices for Management”

 
     		 [bookmark: pgfId-966065]Viewing or Changing Device Properties

 
    

 
    [bookmark: pgfId-966067]Field Reference

 
    [bookmark: pgfId-966070] 

 
     
      
       
       [bookmark: pgfId-960811]Table 11-12 [bookmark: 32647]Device Communication Page 

 
       
      
        
        		
          
          [bookmark: pgfId-960817]Element
         
  
        		
          
          [bookmark: pgfId-960819]Description
         
  
       

 
        
        		 
          
          [bookmark: pgfId-960825]Device Connection Parameters
         
  
       

 
        
        		[bookmark: pgfId-960837]Device Connection Timeout[bookmark: marker-960833][bookmark: marker-960835]

  
        		[bookmark: pgfId-960839]The number of seconds that Security Manager has to establish a connection with a device before timing out.

  
       

 
        
        		[bookmark: pgfId-960849]Retry Count[bookmark: marker-960845][bookmark: marker-960847]

  
        		[bookmark: pgfId-960851]The number of times that Security Manager should try to establish a connection to a device before concluding that the connection cannot be completed. The default value is 3.

  
       

 
        
        		[bookmark: pgfId-960861]Socket Read Timeout[bookmark: marker-960857][bookmark: marker-960859]

  
        		[bookmark: pgfId-960863]For SSH and Telnet sessions, the maximum number of seconds Security Manager can wait for incoming data before concluding that the connection is lost.

  
       

 
        
        		[bookmark: pgfId-960873]Transport Protocol (IPS)[bookmark: marker-960869][bookmark: marker-960871]

  
        		[bookmark: pgfId-960875]The default transport protocol for IPS sensors and routers that include the IPS feature. The default is HTTPS.

  
       

 
        
        		[bookmark: pgfId-960883]Transport Protocol (IOS Routers 12.3 and above)[bookmark: marker-960881]

  
        		[bookmark: pgfId-960885]The default transport protocol for routers that run Cisco IOS software release 12.3 and above. The default is HTTPS.

  
       

 
        
        		[bookmark: pgfId-960895]Transport Protocol (Catalyst Switch/7600)[bookmark: marker-960891][bookmark: marker-960893]

  
        		[bookmark: pgfId-960897]The default transport protocol for Catalyst 6500/7600 devices and all other Catalyst switches, regardless of the Cisco IOS software version running on the devices. The default is SSH.

  
       

 
        
        		[bookmark: pgfId-960905]Transport Protocol (IOS Routers 12.2, 12.1)[bookmark: marker-960903]

  
        		[bookmark: pgfId-960907]The default transport protocol for routers that run Cisco IOS software releases 12.1 and 12.2. The default is Telnet.

  
       

 
        
        		[bookmark: pgfId-960913]Connect to Device Using

  
        		[bookmark: pgfId-960918]The type of credentials Security Manager should use when accessing devices. For more information, see Understanding Device Credentials.

 
          
          		 [bookmark: pgfId-960920] Security Manager User Login Credentials —Security Manager contacts the device using the credentials that you entered while logging in to Security Manager. The same set of credentials are used for all devices regardless of the credentials configured for each device on the Device Credentials page.

 
          		 [bookmark: pgfId-960922] Security Manager Device Credentials —Security Manager contacts the device using the credentials specified in the Device Properties Credentials page. This is the default.

 
         

 
          
          [image: ] 
         
 
         
 
         
          [bookmark: pgfId-960924]Caution You must use Security Manager Device Credentials, not Security Manager User Login Credentials, if a connection to an IPS sensor is involved. When Security Manager contacts an IPS sensor, it must use device credentials whether or not someone is logged in to Security Manager.
           
           
 
          

         
  
       

 
        
        		 [bookmark: pgfId-960946]SSL Certificate Parameters[bookmark: marker-960930][bookmark: marker-960932][bookmark: marker-960934][bookmark: marker-960936][bookmark: marker-960938][bookmark: marker-960940][bookmark: marker-960942][bookmark: marker-960944]

  
       

 
        
        		[bookmark: pgfId-960954]Device Authentication Certificates (IPS)

 [bookmark: pgfId-960956]Device Authentication Certificates (Router)

 [bookmark: pgfId-960958]PIX/ ASA/ FWSM Device Authentication Certificates

 [bookmark: pgfId-960960]Add Certificate button

  
        		[bookmark: pgfId-960962]How to handle device authentication certificates for SSL (HTTPS) communications. You can configure different behaviors for different types of devices, but the settings have the same meaning:

 
          
          		 [bookmark: pgfId-960964] Retrieve while adding devices —Security Manager automatically obtains certificates from the devices while you add devices from the network or from an export file.

 
          		 [bookmark: pgfId-960972] Manually add certificates —Security Manager does not automatically accept certificates from the device. Click  Add Certificate to open the Add Certificate dialog box (see Add Certificate Dialog Box) where you can manually add the thumbprint before you try to add the device from the network or from an export file. You can also add certificates for devices that you create manually from the Device Properties Credentials page to be successful. For more information, see Manually Adding SSL Certificates for Devices that Use HTTPS Communications.

 
          		 [bookmark: pgfId-960974] Do not use certificate authentication —Security Manager ignores device authentication certificates. This option leaves your system vulnerable to third-party interference with device validation. We recommend that you do not use this option.

 
         

  
       

 
        
        		[bookmark: pgfId-960980]Accept Device SSL Certificate after Rollback

  
        		[bookmark: pgfId-960982]For devices that use SSL, whether to obtain the certificate installed on an IPS device, firewall device, FWSM, ASA, or Cisco IOS router from the device when you roll back the configuration on the device.

  
       

 
        
        		[bookmark: pgfId-960988]HTTPS Port Number

  
        		[bookmark: pgfId-960990]The default port number that the device uses for secure communication with Security Manager (as well as other management applications that use these protocols). This value overrides the HTTPS port number that you configure in the HTTP policy for a device.

 [bookmark: pgfId-960992]Note If you configure the local HTTP policy to be a shared policy and assign the HTTP policy to multiple devices, the HTTPS port number setting in the shared policy overrides the port number configured in the Device Properties Credentials page for all devices to which the policy is assigned.

 [bookmark: pgfId-960994]In addition to providing access to the device through the Cisco web browser user interface, the HTTPS port number is used by device management applications (such as the Cisco Router and Security Device Manager (SDM)) and monitoring tools to communicate with the device.

 [bookmark: pgfId-960996]Note The security appliance can support both SSL VPN connections and HTTPS connections for device manager administrative sessions simultaneously on the same interface. Both HTTPS and SSL VPN use port 443 by default. Therefore, to enable both HTTPS and SSL VPN on the same interface, you must specify a different port number for either HTTPS or WebVPN. An alternative is to configure SSL VPN and HTTPS on different interfaces.

  
       

 
        
        		[bookmark: pgfId-961002]Overwrite SSH Keys

  
        		[bookmark: pgfId-961004]Whether Security Manager can overwrite the SSH key for a device when it changes on the device. For SSH connections, a correct key is required for successful communication.

 [bookmark: pgfId-961006]Deselect this check box with caution, and only if you require a greater level of security. Security Manager does not communicate with the device if keys are changed on the device.

  
       

 
        
        		[bookmark: pgfId-961012]Save button

  
        		[bookmark: pgfId-961014]Saves and applies changes.

  
       

 
        
        		[bookmark: pgfId-961020]Reset button

  
        		[bookmark: pgfId-961022]Resets changes to the last saved values.

  
       

 
        
        		[bookmark: pgfId-961028]Restore Defaults button

  
        		[bookmark: pgfId-961030]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-966080][bookmark: 32831][bookmark: syspage_cncpt_AddCertificateDialogBox]Add Certificate Dialog Box[bookmark: marker-966078]

 
     [bookmark: pgfId-966082]Use the Add Certificate dialog box to add device certificates manually for devices that use the SSL transport protocol (firewall devices, FWSMs, ASAs, IPS devices, and Cisco IOS devices). Adding the device certificates manually gives you the highest level of security because then an intruder is prevented from introducing a fraudulent certificate thumbprint. Device certificates are stored in the database to be used for device authentication.

 
     [bookmark: pgfId-966087]For more information about manually adding SSL certificates, see Manually Adding SSL Certificates for Devices that Use HTTPS Communications.

 
     [bookmark: pgfId-966089]Navigation Path

 
     [bookmark: pgfId-966091]Select Tools > Security Manager Administration, select Device Communication from the table of content, and click Add Certificate.

 
     [bookmark: pgfId-966093]Field Reference

 
     [bookmark: pgfId-966096] 

 
      
       
        
        [bookmark: pgfId-961043]Table 11-13 [bookmark: 32849]Add Certificate Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-961049]Element
          
  
         		
           
           [bookmark: pgfId-961051]Description
          
  
        

 
         
         		[bookmark: pgfId-961057]Host Name or IP Address

  
         		[bookmark: pgfId-961059]The hostname or IP address of the device for which you are adding the certificate.

  
        

 
         
         		[bookmark: pgfId-961065]Certificate Thumbprint

  
         		[bookmark: pgfId-961067]The certificate thumbprint, which is a string of hexadecimal digits that is unique to the device.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-966108][bookmark: 32871][bookmark: syspage_cncpt_DeviceGroupsPage-1]Device Groups Page[bookmark: marker-966104][bookmark: marker-966106]

 
    [bookmark: pgfId-966110]Use the Device Groups page to manage the device groups and group types defined in the device inventory.

 
    [bookmark: pgfId-966112]Navigation Path

 
    [bookmark: pgfId-966114]Select Tools > Security Manager Administration, then select Device Groups from the table of contents.

 
    [bookmark: pgfId-966116]Related Topics

 
     
     		 [bookmark: pgfId-966121]Understanding Device Grouping

 
     		 [bookmark: pgfId-966126]Working with Device Groups

 
    

 
    [bookmark: pgfId-966128]Field Reference

 
    [bookmark: pgfId-966131] 

 
     
      
       
       [bookmark: pgfId-961080]Table 11-14 [bookmark: 32898]Device Groups Page 

 
       
      
        
        		
          
          [bookmark: pgfId-961086]Element
         
  
        		
          
          [bookmark: pgfId-961088]Description
         
  
       

 
        
        		[bookmark: pgfId-961094]Groups

  
        		[bookmark: pgfId-961096]Displays the device groups and group types.

 [bookmark: pgfId-961098]To rename a group or type, select it and then click it again to make the text editable. Type in the new name and press Enter.

  
       

 
        
        		[bookmark: pgfId-961104]Add Type button

  
        		[bookmark: pgfId-961106]Click this button to create a new group type. The type is added with a default name. Overtype the name and press Enter.

  
       

 
        
        		[bookmark: pgfId-961112]Add Group to Type button

  
        		[bookmark: pgfId-961114]Click this button to add a device group to the selected device group or group type.

  
       

 
        
        		[bookmark: pgfId-961120]Delete button (trash can)

  
        		[bookmark: pgfId-961122]Click this button to delete the selected device group or group type and all device groups that it contains. Deleting a device group or group type does not delete any devices it contains.

  
       

 
        
        		[bookmark: pgfId-961128]Save button

  
        		[bookmark: pgfId-961130]Saves your changes.

  
       

 
        
        		[bookmark: pgfId-961136]Reset button

  
        		[bookmark: pgfId-961138]Restores all fields to their previous values.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-966145][bookmark: 32940][bookmark: syspage_cncpt_DiscoveryPage]Discovery Page[bookmark: marker-966139][bookmark: marker-966141][bookmark: marker-966143]

 
    [bookmark: pgfId-966147]Use the Discovery page to define how Security Manager should handle certain types of objects or events during inventory and policy discovery. You can also control how long Security Manager keeps discovery tasks.

 
    [bookmark: pgfId-966149]Navigation Path

 
    [bookmark: pgfId-966151]Select Tools > Security Manager Administration and select Discovery from the table of contents.

 
    [bookmark: pgfId-966153]Field Reference

 
    [bookmark: pgfId-966156] 

 
     
      
       
       [bookmark: pgfId-961151]Table 11-15 [bookmark: 32961]Discovery Page 

 
       
      
        
        		
          
          [bookmark: pgfId-961157]Element
         
  
        		
          
          [bookmark: pgfId-961159]Description
         
  
       

 
        
        		[bookmark: pgfId-961165]Prepend Device Name when Generating Security Context Names

  
        		[bookmark: pgfId-961167]Whether the name of the device that contains the security context should be added to the front of the security context’s name. For example, if a security context is named admin, and it is contained in the device with the display name 10.100.15.16, the name that will appear in the Device selector is 10.100.15.16_admin.

 [bookmark: pgfId-961169]If you do not prepend the device name, the security context name appears in the inventory by itself. Because Security Manager does not place security contexts in a folder related to the parent device, the only way to easily see contexts that are related to a device is to prepend the device name.

 [bookmark: pgfId-961171]If you do not prepend device names, Security Manager adds a numbered suffix to distinguish identically named devices. For example, if the admin context exists in more than one firewall, you will see admin_01, admin_02, and so on, in the Device selector.

  
       

 
        
        		[bookmark: pgfId-961177]Purge Discovery Tasks Older Than

  
        		[bookmark: pgfId-961179]The number of days to save discovery and device-import tasks. Tasks older than the number of days you enter are deleted.

  
       

 
        
        		[bookmark: pgfId-961185]Reuse Policy Objects for Inline Values

  
        		[bookmark: pgfId-961190]Whether to substitute any named policy objects, such as network/host or identity user group objects already defined in Security Manager, for inline values in the CLI. For more information on policy objects, see Chapter 6, “Managing Policy Objects”.

 [bookmark: pgfId-961192]Tip Although this option generally applies to network/host objects, it does not apply to FQDN network/host objects because you cannot specify a fully-qualified domain name (FQDN) as an inline value.  
       

 
        
        		[bookmark: pgfId-961198]Allow Device Override for Discovered Policy Objects

  
        		[bookmark: pgfId-961200]For the types of objects for which overrides are possible, whether to allow users to override the parent object values at the device level for policy objects that are discovered. For example, if you select this option, if you run policy discovery on a device that has an ACL with the same name as an ACL policy object in Security Manager, the name of the discovered policy object is reused, but a device-level override is created for the object. If you deselect this option, a new policy object is created with a number appended to the name.

 [bookmark: pgfId-961202]Tip For objects that have subtypes, such as network/host and service, overrides are limited to within a type. For example, an override can be created for a network/host group when discovering a same-named network/host group, but no override would be created when discovering a same-named network/host address range. Instead, the newly-discovered object will have a number appended to the name. [bookmark: pgfId-961207]For more information, see Understanding Policy Object Overrides for Individual Devices.

  
       

 
        
        		[bookmark: pgfId-961213]On Error, Rollback Discovery for Entire Device

  
        		[bookmark: pgfId-961218]Whether Security Manager should roll back all discovered policies if even one error is encountered for a single policy during policy discovery. When deselected, Security Manager keeps the policies successfully discovered and discards only those policies with errors. For more information on policy discovery, see Discovering Policies.

  
       

 
        
        		[bookmark: pgfId-961224]Auto-Expand Object Groups with Prefixes

  
        		[bookmark: pgfId-961229]Expands object groups, such as network or identity user group, with the listed prefixes during the device import process. Separate the prefixes with a comma. This expansion causes the elements of the object group to display as separate items in the discovered policies. For more information, see Expanding Object Groups During Discovery.

 commands from ASA 8.3+ devices. These commands create host, FQDN, network, or address range network/host objects or service objects.  
       

 
        
        		[bookmark: pgfId-961237]Save button

  
        		[bookmark: pgfId-961239]Saves your changes.

  
       

 
        
        		[bookmark: pgfId-961245]Reset button

  
        		[bookmark: pgfId-961247]Resets changes to the previously applied values.

  
       

 
        
        		[bookmark: pgfId-961253]Restore Defaults button

  
        		[bookmark: pgfId-961255]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-966170][bookmark: 33029][bookmark: syspage_cncpt_EventManagementSettingsPage]Event Management Page[bookmark: marker-966164][bookmark: marker-966166][bookmark: marker-966168]

 
    [bookmark: pgfId-966172]Use the Event Management page to enable event management, which allows you to view ASA, FWSM, and IPS events using the Event Viewer. You can also configure settings required for event collection.

 
    [bookmark: pgfId-966174]The Event Manager service is also required by the Report Manager application, which allows you to view reports that aggregate information collected by the service.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-966180]Tip If you get a message that Event Viewer is unavailable when you select Launch > Event Viewer, but the Enable Event Management option is selected on this page, try restarting the Event Manager Service. First, deselect the Enable option and click Save. Wait for the service to stop. Then, select the Enable option, click Save, and wait for the service to finish restarting. You can then try opening Event Viewer again.[bookmark: marker-966176][bookmark: marker-966178]


    
     

    

    

 
    [bookmark: pgfId-966182]Navigation Path

 
    [bookmark: pgfId-966184]Click Tools > Security Manager Administration and select Event Management from the table of contents.

 
    [bookmark: pgfId-966186]Field Reference

 
    [bookmark: pgfId-966189] 

 
     
      
       
       [bookmark: pgfId-961268]Table 11-16 [bookmark: 33060]Event Management Page 

 
       
      
        
        		
          
          [bookmark: pgfId-961274]Element
         
  
        		
          
          [bookmark: pgfId-961276]Description
         
  
       

 
        
        		 
          
          [bookmark: pgfId-961282]Event Management Options
         
  
       

 
        
        		[bookmark: pgfId-961290]Enable Event Management

  
        		[bookmark: pgfId-961292]Whether to enable the Event Manager service, which allows Security Manager to collect event information. If you disable this feature, you cannot use the Event Viewer or Report Manager applications.

 , you are prompted to confirm that you want to start or stop the Event Manager Service. If you click Yes, the service is started or stopped immediately, and you are shown a progress indicator and told when the change is completed. Wait until the status change is completed before continuing.  
       

 
        
        		[bookmark: pgfId-961300]Event Data Store Location

  
        		[bookmark: pgfId-961302]The directory to use for collecting event information. This is known as the primary event store. Click Browse to select a directory on the Security Manager server.

 [bookmark: pgfId-961304]If the directory does not yet exist, create it in Windows Explorer. You cannot create the directory from within Security Manager.

 [bookmark: pgfId-961306]Tip If you change the location after you have started using the Event Manager service, you cannot query old events.  
       

 
        
        		[bookmark: pgfId-961312]Event Data Store Disk Size

  
        		[bookmark: pgfId-961314]The amount of disk space you want to allocate for storing event data, in gigabytes (GB). Events are incrementally deleted (rotated out) from the extended store when it becomes 90% full. Before changing this setting, consider the following:

 
          
          		 [bookmark: pgfId-961316]If you reduce the size below the amount of disk space already used by event data, the oldest events are deleted until your new size limit is reached.

 
          		 [bookmark: pgfId-961318]You can see a visual representation of the amount of space currently used for event data. Open the Event Viewer ( Launch > Event Viewer ), then from Event Viewer, select  Views > Show Event Store Disk Usage .

 
         

  
       

 
        
        		[bookmark: pgfId-961324]Event Syslog Capture Port

  
        		[bookmark: pgfId-961326]The port on which you want to enable syslog event capture. The default is 514.

 [bookmark: pgfId-961328]You must ensure that the Security Manager server, and intervening firewalls, allow incoming traffic on this port for Security Manager to collect the events. Managed devices must be configured to send syslog information to this port on the Security Manager server.

 [bookmark: pgfId-961333]Tip If you change this port, you must also change the Syslog Servers policies for all ASA and FWSM devices and security contexts that send events to Security Manager. For more information, see Syslog Servers Page.  
       

 
        
        		[bookmark: pgfId-961339]Event Data Pagination Size

  
        		[bookmark: pgfId-961341]The maximum number of events per page each query response can contain. The default is 20000, but you can select a different size from the list of supported values.

  
       

 
        
        		 
          
          [bookmark: pgfId-961347]Extended Store Management Options
         
  
       

 
        
        		[bookmark: pgfId-961355]Auto Copy Events to Extended Store

  
        		[bookmark: pgfId-961357]Whether you want to define an extended storage location for event storage. Events are copied from the regular event storage location to the extended location so that they remain available for use. When you query for historical events in Event Viewer, events in the extended storage location are automatically retrieved if they are needed.

 [bookmark: pgfId-961359]Tip You are prompted to verify that you want to start the extended service and to make changes to the extended storage location.  
       

 
        
        		[bookmark: pgfId-961365]Extended Data Store Location

  
        		[bookmark: pgfId-961367]The location of the extended data store for events. This location can be on directly-attached storage that appears as a drive on the server and that uses DAS protocols. For example, SAN storage attached through fiber channel. CIFS storage is not supported. Click Browse to select the desired drive and directory.

 [bookmark: pgfId-961369]Tips

 
          
          		 [bookmark: pgfId-961371]When you select an extended storage location and save your changes, Security Manager checks that it can be accessed and that it has write permissions. The primary storage location is used as a reference, and any data that exists in the primary storage location that does not exist in the extended storage location is copied to the extended storage location. Any data that already exists in the extended storage location is not evaluated and is left untouched, although it can be deleted later to make room for new data.

 
          		 [bookmark: pgfId-961373]If you change the extended data store location, you cannot query events that exist only in the previous extended data store location (that is, you cannot query events that have already be removed from the primary location). If you want to preserve these events, copy the data from the old location to the new location.

 
         

  
       

 
        
        		[bookmark: pgfId-961379]Extended Data Store Disk Size

  
        		[bookmark: pgfId-961381]The amount of space you want to allocate to the extended event storage location, in gigabytes (GB). Events are incrementally deleted (rotated out) from the extended store when it becomes 90% full. The size must be equal to or larger than the primary event data storage location.

 [bookmark: pgfId-961383]You can see a visual representation of the amount of space currently used for event data. Open the Event Viewer (Launch > Event Viewer), then from Event Viewer, select Views > Show Event Store Disk Usage.

  
       

 
        
        		[bookmark: pgfId-961389]Error Notification Email IDs

  
        		[bookmark: pgfId-961394]The email addresses that should receive notifications if problems arise with the use of the extended storage location. Separate multiple addresses with commas. For notifications to be sent successfully, you must also configure an SMTP server as described in Configuring an SMTP Server and Default Addresses for E-Mail Notifications.

 [bookmark: pgfId-961396]The message indicates the problem, cause, and recommended action. For example, you get notifications if the extended storage is chronically unreachable, if data copy fails repeatedly, or if a partition was deleted from the primary storage area before it could be copied to the extended storage area (which might happen if the storage is chronically unreachable or if there are persistent copy problems).

  
       

 
        
        		 
          
          [bookmark: pgfId-961402]Syslog Relay Service
         
  
       

 
        
        		[bookmark: pgfId-961410]Enable Syslog Relay Service

  
        		[bookmark: pgfId-961412]Enables or disables the Syslog Relay Service. Select the Enable Syslog Relay Service check box to enable the fields required for configuring the Syslog Relay Service.

  
       

 
        
        		[bookmark: pgfId-961418]Syslog Relay Capture Port

  
        		[bookmark: pgfId-961420]Specifies the UDP port on which the Syslog Relay Service listens for syslogs. The default is 514.

 [bookmark: pgfId-961422]If the Syslog Relay Service is enabled, devices must send syslogs to the Syslog Relay Capture Port so that they can be forwarded to the local collector and remote collectors. If the Syslog Relay Service is turned off, devices should send syslogs to the Event Syslog Capture Port.

 [bookmark: pgfId-961424]Note The Syslog Relay Capture Port and the Event Syslog Capture Port cannot be the same. When enabling the Syslog Relay Service, if devices are currently configured to send syslogs to the Event Syslog Capture Port, you should instead use that port number for the Syslog Relay Capture Port and then change the Event Syslog Capture Port to something else.

 [bookmark: pgfId-961426]You must ensure that the Security Manager server, and intervening firewalls, allow incoming traffic on this port for Security Manager to collect the events. Managed devices must be configured to send syslog information to this port on the Security Manager server.

 [bookmark: pgfId-961431]Tip If you change this port, you must also change the Syslog Servers policies for all ASA and FWSM devices and security contexts that send events to Security Manager. For more information, see Syslog Servers Page.  
       

 
        
        		[bookmark: pgfId-961437]Relay to Local Event Collector

  
        		[bookmark: pgfId-961439]Enables or disables syslog relay for the local event collector.

  
       

 
        
        		[bookmark: pgfId-961445]Relay to Remote Collector 1

  
        		[bookmark: pgfId-961447]Enables or disables syslog relay for Remote Collector 1.

  
       

 
        
        		[bookmark: pgfId-961453]Collector 1 IP address

  
        		[bookmark: pgfId-961455]Specifies the IP address to which syslogs should be sent for Remote Collector 1.

  
       

 
        
        		[bookmark: pgfId-961461]Collector 1 Syslog Capture Port

  
        		[bookmark: pgfId-961463]Specifies the UDP port on which Remote Collector 1 is listening for relayed syslogs.

  
       

 
        
        		[bookmark: pgfId-961469]Relay to Remote Collector 2

  
        		[bookmark: pgfId-961471]Enables or disables syslog relay for Remote Collector 2.

  
       

 
        
        		[bookmark: pgfId-961477]Collector 2 IP address

  
        		[bookmark: pgfId-961479]Specifies the IP address to which syslogs should be sent for Remote Collector 2.

  
       

 
        
        		[bookmark: pgfId-961485]Collector 2 Syslog Capture Port

  
        		[bookmark: pgfId-961487]Specifies the UDP port on which Remote Collector 2 is listening for relayed syslogs.

  
       

 
        
        		[bookmark: pgfId-961493]Device Filter

  
        		[bookmark: pgfId-961495]You can filter the devices for which syslogs should be relayed for a specific collector. Using this feature, you can configure syslogs for one set of devices to go to one collector and syslogs for a different set of devices to go to another collector:

 [bookmark: pgfId-961497] 1. Select the tab (Local Collector, Remote Collector 1, or Remote Collector 2) for which you want to filter devices.

 [bookmark: pgfId-961499] 2. To specify the devices for which you want relay syslogs for this collector, select Permit Relay. If instead you want to specify the devices for which you want to disable syslog relay for this collector, clear the Permit Relay check box. If the Permit Relay check box is not selected, then syslogs for the devices you add to the filter will not be relayed; however, syslogs for all other devices will be relayed.

 [bookmark: pgfId-961501]Note For each enabled collector, syslog relays from all devices are enabled by default.

 [bookmark: pgfId-961503]Note When adding a cluster to the filter list, the IP addresses for the cluster management pool will be included as part of filter configuration.

 [bookmark: pgfId-961508] 3. Select the devices or device groups from the Available Devices list that you want to add to the filter and click >> to move them to the Selected Devices list. For more information on selecting devices, see Using Selectors.

 [bookmark: pgfId-961510] 4. To add a device that is not managed in Security Manager, enter the IP address of the device in the Add Special Device field and then click the bottom >> to move the device to the Selected Devices list.

  
       

 
        
        		[bookmark: pgfId-961516]Restart

  
        		[bookmark: pgfId-961518]Restarts the Syslog Relay Service.

  
       

 
        
        		[bookmark: pgfId-961524]CPU Throttle Settings

  
        		[bookmark: pgfId-961529]Opens the CPU Throttling Policy dialog box in which you can control the CPU load used by the syslog relay service. For more information, see CPU Throttling Policy Dialog Box.

  
       

 
        
        		[bookmark: pgfId-961535]View Statistics

  
        		[bookmark: pgfId-961540]Opens the Syslog Relay Statistics dialog box in which you can see the average CPU and memory usage of the syslog relay service process as well as traffic rates for the different collectors. For more information, see Syslog Relay Statistics Dialog Box.

  
       

 
        
        		[bookmark: pgfId-961546]Save button

  
        		[bookmark: pgfId-961548]Saves and applies changes.

 [bookmark: pgfId-961550]Most changes related to the Event Viewer settings require that the Event Manager service briefly stop and then restart. If you change whether the service is enabled, it stops or starts, as appropriate. You are shown a progress indicator.

 [bookmark: pgfId-961552]Changes to Syslog Relay Service settings require that the Syslog Relay Service briefly stop and then restart. If you change whether the service is enabled, it stops or starts, as appropriate.

  
       

 
        
        		[bookmark: pgfId-961558]Reset button

  
        		[bookmark: pgfId-961560]Resets changes to the last saved values.

  
       

 
        
        		[bookmark: pgfId-961566]Restore Defaults button

  
        		[bookmark: pgfId-961568]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-966205][bookmark: 33267][bookmark: syspage_cncpt_EventManagementCPUThrottlingPolicy]CPU Throttling Policy Dialog Box[bookmark: marker-966197][bookmark: marker-966199][bookmark: marker-966201][bookmark: marker-966203]

 
     [bookmark: pgfId-966207]Use the CPU Throttling Policy dialog box to specify settings for controlling the CPU load used by the syslog relay service.

 
     [bookmark: pgfId-966209]After CPU throttling is enabled, if the syslog relay service’s average CPU usage over the time period selected in the Average Max CPU Usage Time field is greater than the Maximum CPU Usage threshold, then CPU throttling will take place for the collectors specified in the Stop Forwarding To field for the time specified in the Stop Forwarding For field.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-966214]Note You can use the Syslog Relay Statistics dialog box to see the number of syslog packets dropped per collector due to the throttle policy (see Syslog Relay Statistics Dialog Box).


     
      

     

     

 
     [bookmark: pgfId-966216]Navigation Path

 
     [bookmark: pgfId-966218]Click Tools > Security Manager Administration, select Event Management from the table of contents, and then click CPU Throttle Settings.

 
     [bookmark: pgfId-966220]Field Reference

 
     [bookmark: pgfId-966223] 

 
      
       
        
        [bookmark: pgfId-961581]Table 11-17 [bookmark: 33295]CPU Throttling Policy Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-961587]Element
          
  
         		
           
           [bookmark: pgfId-961589]Description
          
  
        

 
         
         		[bookmark: pgfId-961595]Enable CPU Throttling

  
         		[bookmark: pgfId-961597]Whether to enable throttling for the syslog relay service. CPU throttling for the syslog relay service is disabled by default.

  
        

 
         
         		[bookmark: pgfId-961603]Maximum CPU Usage

  
         		[bookmark: pgfId-961605]Specify the maximum CPU usage for the syslog relay service as a percentage of total CPU capacity. This is threshold at which CPU throttling will be initiated.

  
        

 
         
         		[bookmark: pgfId-961611]Average Max CPU Usage Time (Minutes)

  
         		[bookmark: pgfId-961613]Specifies the time in minutes for which CPU usage by the syslog relay service is calculated. Options are 1 minute, 5 minutes, and 15 minutes. This average is compared to the Maximum CPU Usage value to determine whether throttling should take place.

  
        

 
         
         		[bookmark: pgfId-961619]Stop Forwarding To

  
         		[bookmark: pgfId-961621]Specify the collectors for which you want to stop forwarding syslogs when throttling is engaged.

  
        

 
         
         		[bookmark: pgfId-961627]Stop Forwarding For

  
         		[bookmark: pgfId-961629]Specify how long, in minutes, throttling should be enabled when the threshold is hit. After the specified interval of time has elapsed, if the CPU usage is still above the Maximum CPU Usage threshold, throttling will remain in effect.

  
        

 
         
         		[bookmark: pgfId-961635]Enable Email Notifications

  
         		[bookmark: pgfId-961637]Whether to send email notifications when the syslog relay service enters or exits throttle mode. Email notifications are disabled by default.

 [bookmark: pgfId-961642]For the e-mails to be sent, you must configure an SMTP server as described in Configuring an SMTP Server and Default Addresses for E-Mail Notifications.

  
        

 
         
         		[bookmark: pgfId-961648]Notification Email IDs

  
         		[bookmark: pgfId-961650]Enter one or more valid addresses in the Notification Email IDs field; separate multiple addresses with commas.

  
        

 
         
         		[bookmark: pgfId-961656]Send Email

  
         		[bookmark: pgfId-961658]Specify how often to send notification emails:

 
           
           		 [bookmark: pgfId-961660] Every time —Select this option to have a notification sent every time the syslog relay service enters or exits throttle mode. If the CPU usage is still above the Maximum CPU Usage threshold after the Stop Forwarding For timer has elapsed, throttling will remain in effect and an additional notification will be sent.

 
           		 [bookmark: pgfId-961662] Every —Select this option to have at most one notification sent when the syslog relay service enters or exits throttle mode during a specific period of time. If you select this option, specify the time period by entering the number of minutes or hours and then selecting the corresponding option (Min/Hour) from the drop-down list.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-966237][bookmark: 33357][bookmark: syspage_cncpt_EventManagementSyslogRelayStatistics]Syslog Relay Statistics Dialog Box[bookmark: marker-966231][bookmark: marker-966233][bookmark: marker-966235]

 
     [bookmark: pgfId-966239]Use the Syslog Relay Statistics dialog box to view the average CPU and memory usage of the syslog relay service process as well as traffic rates for the different collectors.

 
     [bookmark: pgfId-966241]Navigation Path

 
     [bookmark: pgfId-966243]Click Tools > Security Manager Administration, select Event Management from the table of contents, and then click View Statistics.

 
     [bookmark: pgfId-966245]Field Reference

 
     [bookmark: pgfId-966248] 

 
      
       
        
        [bookmark: pgfId-961675]Table 11-18 [bookmark: 33378]Syslog Relay Statistics Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-961681]Element
          
  
         		
           
           [bookmark: pgfId-961683]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-961689]Log Relay Service
          
  
        

 
         
         		[bookmark: pgfId-961697]Memory Usage Average (last 1 min.)

  
         		[bookmark: pgfId-961699]Shows the amount of memory used by the syslog relay service on average over the last minute.

  
        

 
         
         		[bookmark: pgfId-961705]CPU Usage Average (last 1 min.)

  
         		[bookmark: pgfId-961707]Shows the percentage of CPU capacity used by the syslog relay service on average over the last minute.

 [bookmark: pgfId-961712]Tip If the average CPU usage is too high, you might consider enabling CPU throttling for the syslog relay service (see CPU Throttling Policy Dialog Box).  
        

 
         
         		[bookmark: pgfId-961718]Total sylog packets received

  
         		[bookmark: pgfId-961720]Shows the total number of syslog packets that have been received by the syslog relay service since the service was started.

  
        

 
         
         		[bookmark: pgfId-961726]Average syslog received per second since start

  
         		[bookmark: pgfId-961728]Shows the average number of syslog packets that have been received by the syslog relay service per second since the service was started.

  
        

 
         
         		[bookmark: pgfId-961734]Average syslog received per second for last 1 minute

  
         		[bookmark: pgfId-961736]Shows the average number of syslog packets that have been received by the syslog relay service per second over the last minute.

  
        

 
         
         		[bookmark: pgfId-961742]Average syslog received per second for last 5 minute

  
         		[bookmark: pgfId-961744]Shows the average number of syslog packets that have been received by the syslog relay service per second over the last five minutes.

  
        

 
         
         		[bookmark: pgfId-961750]Average syslog received per second for last 15 minute

  
         		[bookmark: pgfId-961752]Shows the average number of syslog packets that have been received by the syslog relay service per second over the last fifteen minutes.

  
        

 
         
         		[bookmark: pgfId-961758]Period (in mins.) for which throttle policy is active

  
         		[bookmark: pgfId-961763]Shows how long, in minutes, the CPU throttle policy for the syslog relay service has been active. For more information, see CPU Throttling Policy Dialog Box.

  
        

 
         
         		 
           
           [bookmark: pgfId-961769]Local Collector/Remote Collector 1/Remote Collector 2
          
  
        

 
         
         		[bookmark: pgfId-961777]Total syslog packets sent successfully

  
         		[bookmark: pgfId-961779]Shows the total number of syslog packets that have been sent by the syslog relay service since the service was started.

  
        

 
         
         		[bookmark: pgfId-961785]Total syslog packets dropped (filter policy)

  
         		[bookmark: pgfId-961787]Shows the total number of syslog packets that have been dropped by the syslog relay service in accordance with the defined filter policy since the service was started.

  
        

 
         
         		[bookmark: pgfId-961793]Total syslog packets dropped (throttle policy)

  
         		[bookmark: pgfId-961795]Shows the total number of syslog packets that have been dropped by the syslog relay service in accordance with the throttle policy since the service was started.

  
        

 
         
         		[bookmark: pgfId-961801]Total syslog packets failed during transmit

  
         		[bookmark: pgfId-961803]Shows the total number of syslog packets that were not able to be forwarded by the syslog relay service since the service was started.

  
        

 
         
         		[bookmark: pgfId-961809]Average syslog sent per second since start

  
         		[bookmark: pgfId-961811]Shows the average number of syslog packets that have been sent by the syslog relay service per second since the service was started.

  
        

 
         
         		[bookmark: pgfId-961817]Average syslog sent per second for last 1 minute

  
         		[bookmark: pgfId-961819]Shows the average number of syslog packets that have been sent by the syslog relay service per second over the last minute.

  
        

 
         
         		[bookmark: pgfId-961825]Average syslog sent per second for last 5 minute

  
         		[bookmark: pgfId-961827]Shows the average number of syslog packets that have been sent by the syslog relay service per second over the last five minutes.

  
        

 
         
         		[bookmark: pgfId-961833]Average syslog sent per second for last 15 minute

  
         		[bookmark: pgfId-961835]Shows the average number of syslog packets that have been sent by the syslog relay service per second over the last fifteen minutes.

  
        

 
         
         		[bookmark: pgfId-961841]Refresh

  
         		[bookmark: pgfId-961843]Refreshes the statistics displayed on the Syslog Relay Statistics dialog box.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-966260][bookmark: 33488][bookmark: syspage_cncpt_HPMSettings]Health and Performance Monitor Page[bookmark: marker-966256][bookmark: marker-966258]

 
    [bookmark: pgfId-966262]Use the Health and Performance Monitor page of the Security Manager Administration window to enable network-wide health and performance monitoring. The Health and Performance Monitor (HPM) is a stand-alone application that lets you monitor key health and performance data for ASA devices, IPS devices, and VPN services by providing network-level visibility into device status and traffic information.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-966268]Tip If you get a message that the application is unavailable when you attempt to launch the Health and Performance Monitor, but the Enable Health and Performance Monitor option is selected on this page, try restarting Health and Performance Monitoring. First, deselect the Enable option and click Save. Wait for the service to stop. Then, select the Enable option, click Save, and wait for the service to finish restarting. You can then try opening the HPM application again.[bookmark: marker-966264][bookmark: marker-966266]


    
     

    

    

 
    [bookmark: pgfId-966270]Navigation Path

 
    [bookmark: pgfId-966272]Click Tools > Security Manager Administration and select Health and Performance Monitor from the table of contents.

 
    [bookmark: pgfId-966274]Field Reference

 
    [bookmark: pgfId-966277] 

 
     
      
       
       [bookmark: pgfId-961856]Table 11-19 [bookmark: 33516]Health and Performance Monitor Page 

 
       
      
        
        		
          
          [bookmark: pgfId-961862]Element
         
  
        		
          
          [bookmark: pgfId-961864]Description
         
  
       

 
        
        		[bookmark: pgfId-961870]Enable Health and Performance Monitor

  
        		[bookmark: pgfId-961872]Lets you enable or disable the Health and Performance Monitoring service, which allows Security Manager to collect event information. If you disable this feature, you cannot use the HPM application.

 , you are prompted to confirm that you want to start or stop the Health and Performance Monitoring service. If you click Yes, the service is started or stopped immediately, and you are shown a progress indicator and told when the change is completed. Wait until the status change is completed before continuing.  
       

 
        
        		[bookmark: pgfId-961880]Save button

  
        		[bookmark: pgfId-961882]Saves and applies changes.

 [bookmark: pgfId-961884]Most changes require that the Health and Performance Monitoring service briefly stop and then restart. If you change whether the service is enabled, it stops or starts, as appropriate. You are shown a progress indicator.

  
       

 
        
        		[bookmark: pgfId-961890]Reset button

  
        		[bookmark: pgfId-961892]Resets changes to the last saved values.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-966289][bookmark: 33545][bookmark: syspage_cncpt_ReportManagerSettings]Report Manager Page[bookmark: marker-966285][bookmark: marker-966287]

 
    [bookmark: pgfId-966291]Use the Report Manager page of the Security Manager Administration window to enable or disable the Report Manager feature in Cisco Security Manager. Report Manager is a stand-alone application that lets you view security and usage reports for devices and remote access IPsec and SSL VPNs.

 
    [bookmark: pgfId-966293]Navigation Path

 
    [bookmark: pgfId-966295]Click Tools > Security Manager Administration and select Report Manager from the table of contents.

 
    [bookmark: pgfId-966297]Field Reference

 
    [bookmark: pgfId-966300] 

 
     
      
       
       [bookmark: pgfId-961905]Table 11-20 [bookmark: 33563]Health and Performance Monitoring Page 

 
       
      
        
        		
          
          [bookmark: pgfId-961911]Element
         
  
        		
          
          [bookmark: pgfId-961913]Description
         
  
       

 
        
        		[bookmark: pgfId-961919]Enable Report Manager

  
        		[bookmark: pgfId-961921]Lets you enable or disable the Report Manager service. If you disable this feature, you cannot use the Report Manager application.

 , you are prompted to confirm that you want to start or stop the Report Manager service. If you click Yes, the service is started or stopped immediately, and you are shown a progress indicator and told when the change is completed. Wait until the status change is completed before continuing.  
       

 
        
        		[bookmark: pgfId-961929]Save button

  
        		[bookmark: pgfId-961931]Saves and applies changes.

 [bookmark: pgfId-961933]If you change whether the service is enabled, it stops or starts, as appropriate. You are shown a progress indicator.

  
       

 
        
        		[bookmark: pgfId-961939]Reset button

  
        		[bookmark: pgfId-961941]Resets changes to the last saved values.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-966318][bookmark: 33592][bookmark: syspage_cncpt_IdentitySettingsPage]Identity Settings Page [bookmark: marker-966308][bookmark: marker-966310][bookmark: marker-966312][bookmark: marker-966314][bookmark: marker-966316]

 
    [bookmark: pgfId-966320]Use the Identity Settings page to configure the Active Directory (AD) server group to use for a NetBIOS domain for use with identity-aware firewall policies on ASA devices. These settings enable you to use the Find feature when selecting users or user groups for identity-aware policies or identity user group policy objects.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-966322]Tip You can also add entries by configuring the Identity Options policy on an ASA. When you save the policy, you are asked if you want to update the identity settings administrative page. Keep in mind that you can have a single domain-to-AD server match on the settings page, whereas you can configure different ASAs to use different server groups for a domain. Username lookup always selects the AD servers defined in the identity settings administrative page, regardless of what server group is configured for the individual ASA that you are configuring.


    
     

    

    

 
    [bookmark: pgfId-966324]Navigation Path

 
    [bookmark: pgfId-966326]Select Tools > Security Manager Administration and select Identity Settings from the table of contents.

 
    [bookmark: pgfId-966328]Related Topics

 
     
     		 [bookmark: pgfId-966333]Creating Identity User Group Objects

 
     		 [bookmark: pgfId-966338]Selecting Identity Users in Policies

 
    

 
    [bookmark: pgfId-966340]Field Reference

 
    [bookmark: pgfId-966343] 

 
     
      
       
       [bookmark: pgfId-961954]Table 11-21 [bookmark: 33630]Identity Settings Page 

 
       
      
        
        		
          
          [bookmark: pgfId-961960]Element
         
  
        		
          
          [bookmark: pgfId-961962]Description
         
  
       

 
        
        		[bookmark: pgfId-961968]Domain-AD Server Group Mapping table.

  
        		[bookmark: pgfId-961970]Each row in the table defines the Active Directory (AD) server group to use for a NetBIOS domain for use with identity-aware firewall policies on ASA devices.

 
          
          		 [bookmark: pgfId-961975]To add an entry, click the  Add Row (+) button and fill in the Add AD Domain Server dialog box. See Domain AD Server Dialog Box. You need to enter the domain name and select the AAA server group object that specifies the LDAP AD servers.

 
          		 [bookmark: pgfId-961977]To edit an entry, select it and click the  Edit Row (pencil) button.

 
          		 [bookmark: pgfId-961979]To delete an entry, select it and click the  Delete Row (trash can) button.

 
          		 [bookmark: pgfId-961981]To test whether Security Manager can successfully contact the servers defined in a server group, select the row and click  Test. 

 
         

  
       

 
        
        		[bookmark: pgfId-961987]Default Domain

  
        		[bookmark: pgfId-961989]The NetBIOS domain to use when you do not type in a domain when specifying a user or group name in a firewall policy or an identity user group policy object.

 [bookmark: pgfId-961991]The default is LOCAL, which means the name is defined on the ASA itself, either as a local user or as a VPN user who was authenticated by a means other than an LDAP server group associated with a domain name.

 [bookmark: pgfId-961993]Other than LOCAL, only domains configured in the Domain-AD Server Group Mapping table appear in this list.

 [bookmark: pgfId-961995]Tip This setting is not related to the default domain configured on the ASA using the user-identity default-domain command. This setting is a convenience setting to allow you to type in usernames without always having to include the domain name. Select the domain for which you will most often type user names.  
       

 
        
        		[bookmark: pgfId-962001]Route query via

  
        		[bookmark: pgfId-962003]When you use the Find feature while selecting users or user groups, Security Manager must query the AD server. Select whether the query comes from the Security Manager client (the workstation on which you are running the client) or the server.

 [bookmark: pgfId-962005]By default, LDAP queries come from the client.

  
       

 
        
        		[bookmark: pgfId-962011]For user strings without domain

  
        		[bookmark: pgfId-962013]If you select something other than LOCAL for the default domain, how to handle username or user group names that you type in without a domain name:

 
          
          		 [bookmark: pgfId-962015] Auto determine user/user-group from AD —Check the AD server associated with the default domain to determine whether the name is for a user or user group, and add the appropriate string: Default-Domain\user or Default-Domain\\user-group. If the name cannot be found, you must manually type in the domain name and the one or two \ characters to indicate whether the name is for a user or a group.

 
          		 [bookmark: pgfId-962017] Change it to Default-Domain/user —Assume that typed in names are user names, not user group names, and add the default domain: Default-Domain\user.

 
         

 [bookmark: pgfId-962019]Tip When typing, if you precede the name with \ or \\, the default domain is automatically added. Thus, if you select the Change it to Default-Domain/user option, you can still enter group names without typing the domain by first entering \\.  
       

 
        
        		[bookmark: pgfId-962025]Save button

  
        		[bookmark: pgfId-962027]Saves your changes.

  
       

 
        
        		[bookmark: pgfId-962033]Reset button

  
        		[bookmark: pgfId-962035]Resets changes to the previously applied values.

  
       

 
        
        		[bookmark: pgfId-962041]Restore Defaults button

  
        		[bookmark: pgfId-962043]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-966355][bookmark: 33702][bookmark: syspage_cncpt_ImageManagerPage]Image Manager Page[bookmark: marker-966351][bookmark: marker-966353]

 
    [bookmark: pgfId-966357]Use the Image Manager page to control the administrative settings for Image Manager within Security Manager.

 
    [bookmark: pgfId-966359]Navigation Path

 
    [bookmark: pgfId-966361]Select Tools > Security Manager Administration and select Image Manager from the table of contents.

 
    [bookmark: pgfId-966363]Field Reference

 
    [bookmark: pgfId-966366] 

 
     
      
       
       [bookmark: pgfId-962056]Table 11-22 [bookmark: 33721]Image Manager Page 

 
       
      
        
        		
          
          [bookmark: pgfId-962062]Element
         
  
        		
          
          [bookmark: pgfId-962064]Description
         
  
       

 
        
        		[bookmark: pgfId-962070]Edit CCO Settings

  
        		[bookmark: pgfId-962075]Use the Edit CCO Settings link to quickly navigate to the CCO Settings page. For information on the CCO Settings page, see CCO Settings Page.

  
       

 
        
        		[bookmark: pgfId-962081]Purge Jobs Older Than

  
        		[bookmark: pgfId-962083]Enter the length of time in days to hold Image Manager jobs before purging them. The default is 365 days. Select Purge Now to immediately clear previous Image Manager job specifications.

  
       

 
        
        		[bookmark: pgfId-962089]Include Repository

  
        		[bookmark: pgfId-962091]If checked, the image repository is part of Security Manager backup. The default is to exclude images.

  
       

 
        
        		[bookmark: pgfId-962097]Save button

  
        		[bookmark: pgfId-962099]Saves your changes.

  
       

 
        
        		[bookmark: pgfId-962105]Reset button

  
        		[bookmark: pgfId-962107]Resets changes to the last saved values.

  
       

 
        
        		[bookmark: pgfId-962113]Restore Defaults button

  
        		[bookmark: pgfId-962115]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-966378][bookmark: 33764][bookmark: syspage_cncpt_IPIntelligencePage]IP Intelligence Settings Page[bookmark: marker-966374][bookmark: marker-966376]

 
    [bookmark: pgfId-966380]Use the IP Intelligence Settings page to control the administrative settings for the IP Intelligence features within Security Manager.

 
    [bookmark: pgfId-966382]Navigation Path

 
    [bookmark: pgfId-966384]Select Tools > Security Manager Administration and select IP Intelligence Settings from the table of contents.

 
    [bookmark: pgfId-966386]Field Reference

 
    [bookmark: pgfId-966389] 

 
     
      
       
       [bookmark: pgfId-962128]Table 11-23 [bookmark: 33782]IP Intelligence Settings Page 

 
       
      
        
        		
          
          [bookmark: pgfId-962134]Element
         
  
        		
          
          [bookmark: pgfId-962136]Description
         
  
       

 
        
        		[bookmark: pgfId-962142]Edit CCO Settings

  
        		 
       

 
        
        		[bookmark: pgfId-962163]Enable Reverse DNS (FQDN) Lookup Service

  
        		[bookmark: pgfId-962165]Whether to enable or disable the Reverse DNS (FQDN) lookup service. Enable this service if you want to be able to determine the fully qualified domain name (FQDN) for an IPv4 address using the IP Intelligence tool.

  
       

 
        
        		[bookmark: pgfId-962171]Use CSM Server’s DNS Server

  
        		[bookmark: pgfId-962173]Select this option to use the DNS server defined on the Cisco Security Manager server for reverse DNS lookup requests.

  
       

 
        
        		[bookmark: pgfId-962179]Use custom DNS servers

  
        		[bookmark: pgfId-962181]Select this option to manually specify the DNS servers to use for reverse DNS lookup requests. You can enter up to three DNS server addresses in the fields provided.

 [bookmark: pgfId-962183]Note Security Manager does not support the use of external DNS servers configured inside of a virtual machine.

  
       

 
        
        		[bookmark: pgfId-962189]Enable Load Balancing

  
        		[bookmark: pgfId-962191]Whether to distribute reverse DNS lookup requests amongst the DNS servers when multiple DNS servers are available.

  
       

 
        
        		[bookmark: pgfId-962197]Default Blocking Ranges

  
        		[bookmark: pgfId-962199]Lists the IP address ranges that are excluded from Reverse DNS lookup by default:

 [bookmark: pgfId-962201]0.0.0.0, 255.255.255.255, 127.0.0.1, 169.254.0.0-169.254.255.255, 224.0.0.0-239.255.255.255

  
       

 
        
        		[bookmark: pgfId-962207]User-defined Blocking Ranges

  
        		 
       

 
        
        		[bookmark: pgfId-962225]Enable GeoIP Lookup Service

  
        		[bookmark: pgfId-962227]Whether to enable or disable the GeoIP lookup service. Enable this service if you want to be able to retrieve geographic location information for an IPv4 address using the IP Intelligence tool.

 [bookmark: pgfId-962229]Note You will need to download the geographic location database from Cisco.com before GeoIP information will be included in the IP intelligence data. You will also need to download the geographic location database from Cisco.com after restoring the Security Manager database from a backup. Beginning with version 4.9, Security Manager mandates you to read and accept the End User License Agreement (EULA) before you can proceed to downloading updates from cisco.com.

  
       

 
        
        		 [bookmark: pgfId-962235]GeoIP Manual Upload

 [bookmark: pgfId-962237]Use the GeoIP Manual Upload fields to update the geographic location database in Security Manager using a MaxMind GeoLite City update package downloaded from Cisco.com.

 [bookmark: pgfId-962239]Note New update packages are made available on Cisco.com on a monthly basis.

  
       

 
        
        		[bookmark: pgfId-962247]GeoIP Database Artifact Location

  
        		[bookmark: pgfId-962249]Click Browse and then navigate to and select the MaxMind GeoLite City update package that you downloaded from Cisco.com. Then, click Upload to upload the selected database to Cisco Security Manager.

 [bookmark: pgfId-962251]Note Geolocation updates obtained directly from MaxMind or any other source are not supported in Cisco Security Manager.

  
       

 
        
        		 [bookmark: pgfId-962257]GeoIP Maxmind Database Update Settings

 [bookmark: pgfId-962259]MaxMind GeoLite City update packages are updated monthly on Cisco.com. Use the GeoIP Maxmind Database Update Settings to download an update package automatically from Cisco.com and to configure scheduled updates.

 link to quickly navigate to the CCO Settings page where these credentials are configured. For information on the CCO Settings page, see CCO Settings Page.

  
       

 
        
        		[bookmark: pgfId-962272]Run immediate database update

  
        		[bookmark: pgfId-962274]Click Update Now to update the geographic location database in Security Manager using the latest update package from Cisco.com.

  
       

 
        
        		[bookmark: pgfId-962280]Enable scheduled update

  
        		[bookmark: pgfId-962282]Whether to enable or disable automatic updates of the geographic location database on a regular schedule. After enabling scheduled updates, click Edit Settings to specify the schedule for when the update should take place.

 [bookmark: pgfId-962284]Using the Weekly option, you can specify the days of the week on which the automatic update should take place. Using the Monthly option, you can specify the day of the month on which the automatic update should take place. For either option, you can specify the time of day that the update should take place.

 [bookmark: pgfId-962286]Tip The geographic location database is updated by MaxMind on the first Tuesday of every month. New update packages are typically available on Cisco.com approximately one week after they are issued by MaxMind. We recommend configuring your update schedule to occur monthly on day 15 or later. However, you can schedule the updates to take place more frequently if you want to ensure that the updated database is made available in Security Manager as close to the time it is available on Cisco.com as possible. [bookmark: pgfId-962288]Note Beginning with version 4.9, Security Manager mandates you to read and accept the End User License Agreement (EULA) before you can proceed to downloading updates from cisco.com.

  
       

 
        
        		[bookmark: pgfId-962294]Default Blocking Ranges

  
        		[bookmark: pgfId-962296]Lists the IP address ranges that are excluded from GeoIP lookup by default:

 [bookmark: pgfId-962298]0.0.0.0, 255.255.255.255, 127.0.0.1, 10.0.0.0-10.255.255.255, 169.254.0.0-169.254.255.255, 172.16.0.0-172.31.255.255, 192.168.0.0-192.168.255.255, 224.0.0.0-239.255.255.255

  
       

 
        
        		[bookmark: pgfId-962304]User-defined Blocking Ranges

  
        		 
       

 
        
        		[bookmark: pgfId-962322]Enable Whois Lookup Service

  
        		[bookmark: pgfId-962324]Whether to enable or disable the Whois lookup service. Enable this service if you want to be able to retrieve WHOIS information for an IPv4 address using the IP Intelligence tool.

  
       

 
        
        		[bookmark: pgfId-962330]Enable External Proxy

  
        		[bookmark: pgfId-962332]Whether to enable or disable use of an external proxy for Whois requests. Proxy server configuration is specified on the CCO Settings page.

 link to quickly navigate to the CCO Settings page where the proxy server settings are configured. For information on the CCO Settings page, see CCO Settings Page.  
       

 
        
        		[bookmark: pgfId-962343]Default Blocking Ranges

  
        		[bookmark: pgfId-962345]Lists the IP address ranges that are excluded from Whois lookup by default:

 [bookmark: pgfId-962347]0.0.0.0, 255.255.255.255, 127.0.0.1, 10.0.0.0-10.255.255.255, 169.254.0.0-169.254.255.255, 172.16.0.0-172.31.255.255, 192.168.0.0-192.168.255.255, 224.0.0.0-239.255.255.255

  
       

 
        
        		[bookmark: pgfId-962353]User-defined Blocking Ranges

  
        		[bookmark: pgfId-962355]Specifies additional IP addresses or address ranges that should be excluded from Whois lookup requests. Click the Edit (pencil) button to open the Edit IPv4 Blocking Range Addresses dialog box in which you can specify the IPv4 addresses or address ranges to be excluded. Separate multiple entries using a comma ",".

  
       

 
        
        		[bookmark: pgfId-962361]View Statistics

  
        		[bookmark: pgfId-962363]Opens the IP Intelligence Statistics dialog box which shows statistics for the IP Intelligence feature. Information provided in the IP Intelligence Statistics dialog box includes:

 
          
          		 [bookmark: pgfId-962365]Average number of IP Intelligence lookup requests during the last 5 minutes and last 15 minutes

 
          		 [bookmark: pgfId-962367]Average lookup time for all IP Intelligence service requests

 
          		 [bookmark: pgfId-962369]Average lookup times for each individual service that is currently enabled

 
          		 [bookmark: pgfId-962371]Counts of the number of lookups, both successful and failed, for each individual service that is currently enabled

 
          		 [bookmark: pgfId-962373]Cache hit ratios for each individual service that is currently enabled

 
          		 [bookmark: pgfId-962375]Upload information for GeoIP updates: last update time, status, and version information for the update

 
         

 [bookmark: pgfId-962377]Click Refresh to update the data in the IP Intelligence Statistics dialog box.

  
       

 
        
        		[bookmark: pgfId-962383]Save button

  
        		[bookmark: pgfId-962385]Saves your changes.

  
       

 
        
        		[bookmark: pgfId-962391]Reset button

  
        		[bookmark: pgfId-962393]Resets changes to the last saved values.

  
       

 
        
        		[bookmark: pgfId-962399]Restore Defaults button

  
        		[bookmark: pgfId-962401]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-966397][bookmark: 33962][bookmark: syspage_cncpt_EventingNotificationSettingsPage]Eventing Notification Settings Page

 
    [bookmark: pgfId-966399]Use the Eventing Notification Settings page to receive email notifications for IPS events and critical ASA events. You can configure the time interval at which you want to receive the email notifications.

 
    [bookmark: pgfId-966401]The events are sent in the form of .CSV files in a .zip file format. By default, email notification is disabled. When you enable email notification, only the notification for IPS events is enabled. To receive email notification for critical events you must enable the additional settings for critical events.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-966406]Note For notifications to be sent successfully by Security Manager, you must configure an SMTP server, as described in Configuring an SMTP Server and Default Addresses for E-Mail Notifications.


    
     

    

    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-966408]Tip You can also use the Security Manager Event Viewer application or the Dashboard to view and monitor all events. 


    
     

    

    

 
    [bookmark: pgfId-966410]Navigation Path

 
    [bookmark: pgfId-966412]Select Tools > Security Manager Administration and select Eventing Notification Settings from the table of contents.

 
    [bookmark: pgfId-966414]Field Reference

 
    [bookmark: pgfId-966417] 

 
     
      
       
       [bookmark: pgfId-962414]Table 11-24 [bookmark: 33979]Eventing Notification Settings Page 

 
       
      
        
        		
          
          [bookmark: pgfId-962420]Element
         
  
        		
          
          [bookmark: pgfId-962422]Description
         
  
       

 
        
        		[bookmark: pgfId-962428]Enable Eventing Email Notification

  
        		[bookmark: pgfId-962430]Select to enable notification of IPS events through email.

  
       

 
        
        		[bookmark: pgfId-962436]Notification Interval (15 - 60 minutes)

  
        		[bookmark: pgfId-962438]Enter the interval at which you want Security Manager to send email notifications for IPS events or critical events.

 [bookmark: pgfId-962440]Note If Security Manager receives more than 50000 events during the configured time interval, only the first 50000 events are selected and sent through email.

  
       

 
        
        		 
          
          [bookmark: pgfId-962446]Notification Settings (IPS)
         
  
       

 
        
        		[bookmark: pgfId-962454]Email IDs (for IPS Events)

  
        		[bookmark: pgfId-962456]Enter one or more email addresses (comma separated).

  
       

 
        
        		[bookmark: pgfId-962462]Select Severity of Events

  
        		[bookmark: pgfId-962464]The severity level that the IPS signature reports: High, Medium, Low, or Informational. By default, High and Medium severity are selected.

  
       

 
        
        		[bookmark: pgfId-962470]Notification Content

  
        		[bookmark: pgfId-962472]Whether to send summarized or detailed notifications through email. If you select Detailed Notifications, select the fields that you want information for, in the email notification. Some fields are selected by default.

  
       

 
        
        		 
          
          [bookmark: pgfId-962478]Fields
         
  
       

 
        
        		[bookmark: pgfId-962486]Event ID

  
        		[bookmark: pgfId-962488]A unique sequential number for each event, assigned internally.

  
       

 
        
        		[bookmark: pgfId-962494]Severity

  
        		[bookmark: pgfId-962496]The Firewall or IPS severity values.

  
       

 
        
        		[bookmark: pgfId-962502]Device

  
        		[bookmark: pgfId-962504]The source of the event; usually the device ID.

 [bookmark: pgfId-962506]A device identified as Not Available has been deleted from the Security Manager inventory.

  
       

 
        
        		[bookmark: pgfId-962512]Application Name

  
        		[bookmark: pgfId-962514]The name of the application originating the event.

  
       

 
        
        		[bookmark: pgfId-962520]Receive Time

  
        		[bookmark: pgfId-962522]The time the event was received by Security Manager.

  
       

 
        
        		[bookmark: pgfId-962528]Event Time

  
        		[bookmark: pgfId-962530]The time the event was generated by the device.

  
       

 
        
        		[bookmark: pgfId-962536]Sensor Local Time

  
        		[bookmark: pgfId-962538]The local time of the sensor where the event originated.

  
       

 
        
        		[bookmark: pgfId-962544]Sig ID

  
        		[bookmark: pgfId-962546]The Sig ID value is used by the alert originator to identify the activity. It identifies the pre-defined signature defined for this activity.

  
       

 
        
        		[bookmark: pgfId-962552]Sub Sig. ID

  
        		[bookmark: pgfId-962554]Identifies the unique numerical value assigned to the sub signature. The Sub Sig. Id identifies a more granular version of a broad signature.

  
       

 
        
        		[bookmark: pgfId-962560]Sig. Name

  
        		[bookmark: pgfId-962562]The name assigned to the signature.

  
       

 
        
        		[bookmark: pgfId-962568]Sig. Details

  
        		[bookmark: pgfId-962570]The details of the reported signature that was triggered and resulted in the generation of the alert.

  
       

 
        
        		[bookmark: pgfId-962576]Sig. Version

  
        		[bookmark: pgfId-962578]The version of the signature definition used to generate an alert.

  
       

 
        
        		[bookmark: pgfId-962584]Attacker IP

  
        		[bookmark: pgfId-962586]The IP address of the host that sent the offending packet.

  
       

 
        
        		[bookmark: pgfId-962592]Attacker Port

  
        		[bookmark: pgfId-962594]The port used by the attacker host. This is the port from which the offending packet originated.

  
       

 
        
        		[bookmark: pgfId-962600]Attacker Locality

  
        		[bookmark: pgfId-962602]Identifies whether the attacker address is located inside or outside of a given network, as specified by the intrusion detection device’s configuration.

  
       

 
        
        		[bookmark: pgfId-962608]Victim IP

  
        		[bookmark: pgfId-962610]The IP address of the host being attacked.

  
       

 
        
        		[bookmark: pgfId-962616]Victim Port

  
        		[bookmark: pgfId-962618]The port of the host being attacked (the recipient of the offending packet). This is the port to which the offending packet was sent.

  
       

 
        
        		[bookmark: pgfId-962624]Victim OS

  
        		[bookmark: pgfId-962626]The OS of the host being attacked.

  
       

 
        
        		[bookmark: pgfId-962632]Victim Locality

  
        		[bookmark: pgfId-962634]Identifies whether the target address is located inside or outside of a given network, as specified by the intrusion detection device’s configuration.

  
       

 
        
        		[bookmark: pgfId-962640]Summary Count

  
        		[bookmark: pgfId-962642]Specifies that this is a summary alert, representing one or more alerts with common characteristics. The numeric value indicates the number of times the signature fired since the last summary alert with a matching initialAlert attribute value.

  
       

 
        
        		[bookmark: pgfId-962648]Initial Alert

  
        		[bookmark: pgfId-962650]This field applies to a summary alert, representing one or more alerts with common characteristics. The value of InitialAlert provides the event ID of the last nonsummary evIdsAlert with the same characteristic (sigid/ subsigid).

  
       

 
        
        		[bookmark: pgfId-962656]Summary Type

  
        		[bookmark: pgfId-962658]Defines the common characteristics of all alerts in a summary alert.

  
       

 
        
        		[bookmark: pgfId-962664]Is Final

  
        		[bookmark: pgfId-962666]Applies to a summary alert, representing one or more alerts with common characteristics. It indicates whether this is the last event alert containing the same value in the initialAlert attribute.

  
       

 
        
        		[bookmark: pgfId-962672]Interface

  
        		[bookmark: pgfId-962674]Name of the IPS interface.

  
       

 
        
        		[bookmark: pgfId-962680]VLAN

  
        		[bookmark: pgfId-962682]The VLAN number associated with packets involved in the activity that triggered the alert.

  
       

 
        
        		[bookmark: pgfId-962688]Virtual Sensor

  
        		[bookmark: pgfId-962690]The name of the virtual sensor associated with the event.

  
       

 
        
        		[bookmark: pgfId-962696]Action Taken

  
        		[bookmark: pgfId-962698]The action performed on the flow. For example: Terminated or denied.

  
       

 
        
        		[bookmark: pgfId-962704]Alert Details

  
        		[bookmark: pgfId-962706]The details regarding the alerts.

  
       

 
        
        		[bookmark: pgfId-962712]Risk Rating

  
        		[bookmark: pgfId-962714]A value that represents the calculated risk associated with the event.

  
       

 
        
        		[bookmark: pgfId-962720]Threat Rating

  
        		[bookmark: pgfId-962722]The threat rating of the event, if any.

  
       

 
        
        		[bookmark: pgfId-962728]Reputation

  
        		[bookmark: pgfId-962730]The attacker’s reputation score in the range -10.0 to +10.0. A lower (more negative) score indicates a greater likelihood that the host is malicious.

  
       

 
        
        		[bookmark: pgfId-962736]Reputation Details

  
        		[bookmark: pgfId-962738]Deny Attacker: Whether a deny-attacker action occurred (or would have occurred) because an internal override was exceeded due to the calculated risk rating: true or false.

  
       

 
        
        		[bookmark: pgfId-962744]Protocol

  
        		[bookmark: pgfId-962746]The Level-3 or Level-4 protocol.

  
       

 
        
        		 
          
          [bookmark: pgfId-962752]Notification Settings (Critical Events only)
         
  
       

 
        
        		[bookmark: pgfId-962760]Enable

 [bookmark: pgfId-962762]Email IDs

  
        		[bookmark: pgfId-962764]Whether to send email notification for critical events. If you select this option, also enter one or more email addresses (comma separated).

  
       

 
        
        		[bookmark: pgfId-962770]Save button

  
        		[bookmark: pgfId-962772]Saves your changes.

  
       

 
        
        		[bookmark: pgfId-962778]Reset button

  
        		[bookmark: pgfId-962780]Resets changes to the previously applied values.

  
       

 
        
        		[bookmark: pgfId-962786]Restore Defaults button

  
        		[bookmark: pgfId-962788]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-966427][bookmark: 34218][bookmark: syspage_cncpt_IPSUpdatesPage-1]IPS Updates Page[bookmark: marker-966425]

 
    [bookmark: pgfId-966429]Use the IPS Updates page to perform administrative tasks associated with keeping your sensors up to date with regard to signatures, minor version updates, and service packs. You can use the IPS Updates page to:

 
     
     		 [bookmark: pgfId-966431]Monitor update status.

 
     		 [bookmark: pgfId-966433]Check the availability of updates and download them.

 
     		 [bookmark: pgfId-966435]Configure an IPS update server.

 
     		 [bookmark: pgfId-966437]Configure automatic update settings.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-966439]Note Beginning with Security Manager version 4.9, only the latest sensor and signature packages for IPS will be available for download from CCO. The older packages will not be available for download from CCO.


    
     

    

    

 
    [bookmark: pgfId-966441]Tips

 
     
     		 [bookmark: pgfId-966446]To apply IPS updates manually, select  Tools > Apply IPS Update . For more information, see Manually Applying IPS Updates.

 
     		 [bookmark: pgfId-966448]If you later decide that you did not want to apply a signature update, you can revert to the previous update level by selecting the Signatures policy on the device, clicking the  View Update Level button, and clicking  Revert .

 
    

 
    [bookmark: pgfId-966453]Beginning with version 4.4, Security Manager has a certificate trust management feature. This feature helps you with improved handling of Cisco.com certificates. For detailed documentation of this feature, refer to Certificate Trust Management.

 
    [bookmark: pgfId-966455]Navigation Path

 
    [bookmark: pgfId-966457]Select Tools > Security Manager Administration and select IPS Updates from the table of contents.

 
    [bookmark: pgfId-966459]Related Topics

 
     
     		 [bookmark: pgfId-966464]Configuring the IPS Update Server

 
     		 [bookmark: pgfId-966469]Checking for IPS Updates and Downloading Them

 
     		 [bookmark: pgfId-966474]Automating IPS Updates

 
     		 [bookmark: pgfId-966479]Selecting a Signature Category for Cisco IOS IPS

 
    

 
    [bookmark: pgfId-966481]Field Reference

 
    [bookmark: pgfId-966484] 

 
     
      
       
       [bookmark: pgfId-962801]Table 11-25 [bookmark: 34272]IPS Updates Page 

 
       
      
        
        		
          
          [bookmark: pgfId-962807]Element
         
  
        		
          
          [bookmark: pgfId-962809]Description
         
  
       

 
        
        		[bookmark: pgfId-962815]Update Status group

 [bookmark: pgfId-962817]Refresh button

  
        		[bookmark: pgfId-962819]Displays the following items. Click Refresh to update the information.

 
          
          		 [bookmark: pgfId-962821]Latest Available—The most recent signature and sensor update available on Cisco.com or the local HTTP server when you last checked for updates.

 
          		 [bookmark: pgfId-962823]Latest Downloaded—The most recent signature and sensor update downloaded to Security Manager.

 
          		 [bookmark: pgfId-962825]Latest Applied—The most recent signature and sensor update applied to any device in Security Manager.

 
          		 [bookmark: pgfId-962827]Latest Deployed—The most recent signature and sensor update deployed to any device in Security Manager.

 
          		 [bookmark: pgfId-962829]Last Check On—The time that the last check of Cisco.com was performed.

 
          		 [bookmark: pgfId-962831]Last Download On—The time that the last update was downloaded to Security Manager.

 
          		 [bookmark: pgfId-962833]Last Deployed On—The time that the last update was deployed to any of the devices.

 
         

  
       

 
        
        		[bookmark: pgfId-962839]Check for Updates button

 [bookmark: pgfId-962841]Download Latest Updates button

  
        		[bookmark: pgfId-962843]These buttons check for updates, or download signature and sensor updates that have not already been downloaded to the Security Manager server, from the IPS Update server. You must configure an IPS Update server before checking for updates or downloading them (click Edit Settings in the Update Server group).

 [bookmark: pgfId-962848]When you click one of these buttons, a dialog box opens to display the results of the operation. Security Manager logs into the IPS Update server, checks for updates, and downloads them if you clicked the Download button. If a Cisco.com download fails, ensure that the account you are using has applied for eligibility to download strong encryption software. For details, see the description of User Name in Edit Update Server Settings Dialog Box.

 at the bottom of the page and try again. [bookmark: pgfId-962852]Note Beginning with version 4.9, Security Manager mandates you to read and accept the End User License Agreement (EULA) before you can proceed to downloading updates from cisco.com.

  
       

 
        
        		[bookmark: pgfId-962858]Update Server group

  
        		[bookmark: pgfId-962863]Displays the settings used to access Cisco.com or the local server that contains the IPS update packages. The fields indicate whether the update server is Cisco.com or a locally-configured HTTP server, the name of the local server if you are using one, the user account for logging into the server, and the name of the proxy server, if any. To configure or change the IPS Update server, click Edit Settings to open the Edit Update Server Settings dialog box (see Edit Update Server Settings Dialog Box).

 [bookmark: pgfId-962868]For more information, see Configuring the IPS Update Server

 [bookmark: pgfId-962873]Beginning with version 4.4, Security Manager has a certificate trust management feature. This feature helps you with improved handling of Cisco.com certificates. For detailed documentation of this feature, refer to Certificate Trust Management.

  
       

 
        
        		[bookmark: pgfId-962879]Signature Filter Settings group

  
        		[bookmark: pgfId-962884]Enables you to download IPS signature updates selectively. Click Edit Settings to open the Edit Signature Download Filter Settings dialog box (see Edit Signature Download Filter Settings Dialog Box).

  
       

 
        
        		[bookmark: pgfId-962890]Auto Update Settings group

  
        		[bookmark: pgfId-962895]Contains the settings specific to automatic updates. For more information, see Automating IPS Updates.

  
       

 
        
        		[bookmark: pgfId-962901]Auto Update Mode

  
        		[bookmark: pgfId-962903]Establishes whether, and to what extent, automatic updates are performed. Contains the following options:

 
          
          		 [bookmark: pgfId-962905]Download, Apply, and Deploy Updates

 
          		 [bookmark: pgfId-962907]Disable Auto Update

 
          		 [bookmark: pgfId-962909]Check for Updates

 
          		 [bookmark: pgfId-962911]Download Updates

 
          		 [bookmark: pgfId-962913]Download and Apply Updates

 
         

 [bookmark: pgfId-962915]By default, auto update is disabled. The other options are a combination of one or more of the following options:

 
          
          		 [bookmark: pgfId-962917]Check for Updates—Security Manager contacts the IPS Update server to check if an update is available and sends e-mail if e-mail notification is configured. No files are downloaded.

 
          		 [bookmark: pgfId-962919]Download Updates—Security Manager downloads the latest updates from the IPS Update server, and sends e-mail notification if e-mail notification is configured.

 
          		 [bookmark: pgfId-962921]Apply Updates—Security Manager modifies the configuration of the devices selected in the Apply Update To list based on the downloaded update packages. You have to separately deploy these updates unless you also select Deploy Updates.

 
          		 [bookmark: pgfId-962923]Deploy Updates—Security Manager starts a deployment job to send the applicable update packages to the devices selected in the Apply Update To list. The device must have the required license for a signature update to be successful.

 
         

  
       

 
        
        		[bookmark: pgfId-962929]Update Schedule

 [bookmark: pgfId-962931]Edit Update Schedule button

  
        		[bookmark: pgfId-962933]The schedule for the actions selected in the Auto Update Mode field. To change the schedule, click Edit Update Schedule and define the schedule in the Edit IPS Updates Schedule dialog box. You can specify that Security Manager perform the updates based on hourly, daily, weekly, or monthly schedules, or specify a one-time event. When entering the start time, use the 24-hour clock and the hh:mm format.

 [bookmark: pgfId-962935]Note If you schedule an update to occur in less than 10 minutes from your Security Manager server time, the "Next Update" field will show tomorrow’s date and the job will run accordingly. This is a safety feature designed to guarantee the first occurrence to run.

 [bookmark: pgfId-962937]Tip Cisco recommends scheduling automatic downloads during off hours so that they do not conflict with other user operations, such as device discovery. [bookmark: pgfId-962939]Tip Cisco recommends using an account other than the admin account for routine user operations.  
       

 
        
        		[bookmark: pgfId-962945]Notify Email

  
        		[bookmark: pgfId-962947]The e-mail address to which notifications of automatic updates are sent. If you enter more than one address, separate the addresses with commas. A notification is sent when an update:

 
          
          		 [bookmark: pgfId-962949]Is available for download.

 
          		 [bookmark: pgfId-962951]Has been downloaded.

 
          		 [bookmark: pgfId-962953]Has been downloaded and applied.

 
          		 [bookmark: pgfId-962955]Has been downloaded, applied, and deployed.

 
         

  
       

 
        
        		[bookmark: pgfId-962961]Apply Update To

 [bookmark: pgfId-962963]Type

 [bookmark: pgfId-962965]Edit Row button

 [bookmark: pgfId-962967]Devices to be Auto Updated

  
        		[bookmark: pgfId-962969]The selector includes the IPS devices that have local signature policies and the shared signature policies that are defined in Security Manager. The columns in the selector indicate whether a local device policy or a shared policy is selected for these types of updates:

 
          
          		 [bookmark: pgfId-962971]Signature—For auto updating the signature update level.

 
          		 [bookmark: pgfId-962973]Minor—For minor updates and service packs.

 
          		 [bookmark: pgfId-962975]S.P.—For service pack updates.

 
         

 [bookmark: pgfId-962977]For shared policies, a partial grey checked box indicates that some, but not all, of the devices that use the policy are selected. If you change the devices assigned to the shared policy between automatic update events, the shared policy is grayed out, and only the old assignments are shown on this page. After the update runs, the assignment list will be synchronized with the shared policy device assignments. To update the device list proactively prior to the next auto update run, select the policy and edit it (to select auto update settings), and the device assignment list will be corrected.

 [bookmark: pgfId-962979]Note Also for shared policies: You can select only the shared policy assigned to the default virtual sensor (vs0). If you attempt to select the shared policy for a different virtual sensor, your changes will not be applied, and you will not receive an error message.

 [bookmark: pgfId-962981]Use the Type field to toggle between viewing local and shared policies. Changing the view does not change your auto update selections.

 [bookmark: pgfId-962983]To select a local or shared policy for auto update, select it in the selector and click the Edit Row button below the selector. This opens the Edit Auto Update Settings dialog box, where you can select the types of updates for the policy. When you select any type of auto update for a policy, the affected devices are listed in the Devices to be Auto Updated list to the right of the selector.

  
       

 
        
        		[bookmark: pgfId-962989]Save button

  
        		[bookmark: pgfId-962991]Saves your changes.

  
       

 
        
        		[bookmark: pgfId-962997]Reset button

  
        		[bookmark: pgfId-962999]Resets changes to the last saved values.

  
       

 
        
        		[bookmark: pgfId-963005]Restore Defaults button

  
        		[bookmark: pgfId-963007]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-966494][bookmark: 34427][bookmark: syspage_cncpt_EditUpdateServerSettingsDialogBox]Edit Update Server Settings Dialog Box[bookmark: marker-966492]

 
     [bookmark: pgfId-966496]Use the Edit Update Server Settings dialog box to configure the server to use for obtaining IPS updates. If necessary, you can configure a proxy server for communicating with the update server.

 
     [bookmark: pgfId-966508][bookmark: marker-966498][bookmark: marker-966500][bookmark: marker-966502][bookmark: marker-966504][bookmark: marker-966506]Also, use the Edit Update Server Settings dialog box for certificate trust management. (Security Manager downloads IPS packages from Cisco.com over HTTPS, which uses certificates for establishing trust.) The certificate trust management feature on the Image Manager page is new in Security Manager 4.4. It will help you with improved handling of Cisco.com certificates for IPS package downloads:

 
      
      		 [bookmark: pgfId-966510]You can use it to view a certificate and use discretion in accepting it.

 
      		 [bookmark: pgfId-966512]After you accept a certificate, it is stored on your Security Manager server.

 
      		 [bookmark: pgfId-966514]You can see all your certificates in a summary table on the Image Manager page, and you can use that table to view or remove certificates.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-966516]Tip Please be sure to refer to "Retrieve Certificate" in the table below.


     
      

     

     

 
     [bookmark: pgfId-966518]Navigation Path

 
     [bookmark: pgfId-966520]Select Tools > Security Manager Administration > IPS Updates and click Edit Settings in the Update Server group.

 
     [bookmark: pgfId-966522]Field Reference

 
     [bookmark: pgfId-966525] 

 
      
       
        
        [bookmark: pgfId-963020]Table 11-26 [bookmark: 34468]Edit Update Server Settings Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-963026]Element
          
  
         		
           
           [bookmark: pgfId-963028]Description
          
  
        

 
         
         		[bookmark: pgfId-963034]Update From

  
         		[bookmark: pgfId-963036]Whether to get IPS updates from Cisco.com or from a local HTTP/HTTPS server. Your selection changes the fields on the dialog box.

 [bookmark: pgfId-963038]If you select local, you must configure an HTTP or HTTPS server to use as the IPS update server.

 
           
           [image: ] 
          
 
          
 
          
           [bookmark: pgfId-963040]Caution The default value for "Update From:" is "Local Server." You must choose "Cisco.com" to see certificate settings. Improper or incomplete certificate setting will prevent connectivity to Cisco.com, and all Cisco.com-related operations in this area will fail.
            
            
 
           

          
  
        

 
         
         		[bookmark: pgfId-963046]IP Address/ Host Name

 [bookmark: pgfId-963048](Local server only.)

  
         		[bookmark: pgfId-963050]The hostname or IP address of the local IPS update web server.

  
        

 
         
         		[bookmark: pgfId-963056]Web Server Port

 [bookmark: pgfId-963058](Local server only.)

  
         		[bookmark: pgfId-963060]The port number that your local server listens to for connection requests. The default is 80.

  
        

 
         
         		[bookmark: pgfId-963066]User Name

  
         		[bookmark: pgfId-963068]The username to log into the IPS update server. If you are configuring a local server that does not require a user login, leave this field blank.

 [bookmark: pgfId-963072]If you are specifying a Cisco.com username, the user account on Cisco.com must be eligible for downloading strong encryption software. If you are not certain that the account has the required permissions, use the account to log into Cisco.com and try to download an IPS update file (http://www.cisco.com/cgi-bin/tablebuild.pl/ips5-system). If the account does not have the appropriate permissions, you are prompted to read and accept the required conditions. If you meet the eligibility requirements, you can accept them. Otherwise, talk to your Cisco sales representative for help.

  
        

 
         
         		[bookmark: pgfId-963078]Password

 [bookmark: pgfId-963080]Confirm

  
         		[bookmark: pgfId-963082]The password for the specified username, entered in both fields. If you are configuring a local server that does not require a password, leave these fields blank.

  
        

 
         
         		[bookmark: pgfId-963088]Path to Update Files

 [bookmark: pgfId-963090](Local server only.)

  
         		[bookmark: pgfId-963092]The path to the IPS update files location on your local server. For example, if update files can be accessed at http://local-server-ip:port/update_files_path/, then enter update_files_path in this field.

  
        

 
         
         		[bookmark: pgfId-963098]Connect Using HTTPS

 [bookmark: pgfId-963100](Local server only.)

  
         		[bookmark: pgfId-963102]Whether to use SSL when connecting to the local IPS Update server.

  
        

 
         
         		[bookmark: pgfId-963108]Certificate Thumbprint

  
         		[bookmark: pgfId-963110]Displays the certificate thumbprint after it is calculated from the certificate on the local server.

  
        

 
         
         		[bookmark: pgfId-963116]Retrieve From Server

  
         		[bookmark: pgfId-963118]Used to connect to the local server specified in this dialog box, retrieve the certificate from the local server given, and calculate the certificate thumbprint, which is displayed in the Certificate Thumbprint field.

  
        

 
         
         		[bookmark: pgfId-963124]Contact URL

  
         		
           
           		 [bookmark: pgfId-963126]When selected, "Image Meta-data Locator" is used. This is the URL on Cisco.com that is used to obtain meta-data information about images. Meta-data information consists of the images applicable to a particular product, name, size, checksum, and URL to download for each image.

 
           		 [bookmark: pgfId-963128]When selected, "Other" is used. You can enter any valid HTTPS URL. This URL is intended primarily for the HTTPS URL to download the image as obtained from the meta-data information about the image. This URL may be different from the URL of the image meta-data locator described in the previous paragraph; the certificate may be different, as well.

 
          

 
           
           [image: ] 
          
 
          
 
          
           [bookmark: pgfId-963130]Caution If you choose "Other," you need to explicitly add "https://dl.cisco.com" [without the quotation marks]: Enter it in the text field adjacent to the "Other" button. Failure to do this will prevent connectivity to Cisco.com, and all Cisco.com-related operations in this area will fail.
            
            
 
           

          
  
        

 
         
         		[bookmark: pgfId-963136]Retrieve Certificate

  
         		[bookmark: pgfId-963138]Used to connect to and retrieve the certificate from the selected ‘"Contact URL’." After retrieving the certificate it opens the Certificate Verification dialog, which along with a brief summary of the certificate, i.e., who the certificate is issued to, by whom, and the validity period of the certificate, gives you the following choices:

 
           
           		 [bookmark: pgfId-963140] View Certificate —Opens the Certificate Viewer, where you can see all the details of the certificate: Certificate Authority, version, serial number, thumbprint, and other details. It shows the complete certificate chain information all the way up to the root issuing certificate Authority.

 
           		 [bookmark: pgfId-963142] Accept —Accepts the certificate and adds it to the Cisco Security Manager.

 
           		 [bookmark: pgfId-963144] Reject —Rejects the certificate and no action is taken.

 
           		 [bookmark: pgfId-963146] Cancel —Closes the Certificate Verification dialog with no action taken.

 
          

  
        

 
         
         		[bookmark: pgfId-963152]Certificate

  
         		[bookmark: pgfId-963154]A table that displays, for each certificate in your Security Manager installation, Subject, Issued By, and Accepted By.

  
        

 
         
         		[bookmark: pgfId-963160]View

  
         		[bookmark: pgfId-963162]Opens the Certificate Viewer for a certificate selected in the Certificate table.

  
        

 
         
         		[bookmark: pgfId-963168]Remove

  
         		[bookmark: pgfId-963170]Removes a certificate selected in the Certificate table.

  
        

 
         
         		 
           
           [bookmark: pgfId-963176]Proxy Server Group
          
  
        

 
         
         		[bookmark: pgfId-963184]Enable Proxy Server

  
         		[bookmark: pgfId-963186]Whether a proxy server is needed to connect to Cisco.com or to your local server.

  
        

 
         
         		[bookmark: pgfId-963192]IP Address/ Host Name

  
         		[bookmark: pgfId-963194]The hostname or IP address of the proxy server.

 [bookmark: pgfId-963196]You can configure the proxy server to use basic, digest, NT LAN Manager (NTLM) V1, or NTLM V2 authentication. NTLM V2 is the most secure scheme.

  
        

 
         
         		[bookmark: pgfId-963202]Port

  
         		[bookmark: pgfId-963204]The port number that the proxy server listens to for connection requests. The default is 80.

  
        

 
         
         		[bookmark: pgfId-963210]User Name

  
         		[bookmark: pgfId-963212]The username to log into the proxy server. If the proxy server does not require a user login, leave this field blank.

  
        

 
         
         		[bookmark: pgfId-963218]Password

 [bookmark: pgfId-963220]Confirm

  
         		[bookmark: pgfId-963222]The password for the specified username, entered in both fields. If the proxy server does not require a password, leave these fields blank.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-966535][bookmark: 34612][bookmark: syspage_cncpt_ModifySignatureUpdatePoliciesDialogBox]Edit Auto Update Settings Dialog Box[bookmark: marker-966533]

 
     [bookmark: pgfId-966540]Use the Edit Auto Update Settings dialog box to configure the automatic update options for the device or policy selected in the Apply Update To table on the IPS Updates page. For information on configuring automatic updates, see Automating IPS Updates.

 
     [bookmark: pgfId-966542]Navigation Path

 
     [bookmark: pgfId-966547]Select a device or policy on in the Apply Update To table on the IPS Updates page (see IPS Updates Page) and click the Edit Row button.

 
     [bookmark: pgfId-966549]Field Reference

 
     [bookmark: pgfId-966552] 

 
      
       
        
        [bookmark: pgfId-963235]Table 11-27 [bookmark: 34627]Edit Auto Update Settings Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-963241]Element
          
  
         		
           
           [bookmark: pgfId-963243]Description
          
  
        

 
         
         		[bookmark: pgfId-963249]Auto Update

 [bookmark: pgfId-963251](IPS sensors and shared policies only)

  
         		[bookmark: pgfId-963253]The type of sensor updates to apply to the selected devices or shared policies. You can apply both minor updates and service packs, service packs only, or select None to apply no sensor updates automatically.

  
        

 
         
         		[bookmark: pgfId-963259]Auto Update Signature Update Level

  
         		[bookmark: pgfId-963261]Whether to select the device or policy for automatic signature updates.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-966560][bookmark: 34649][bookmark: syspage_cncpt_EditSignatureDownloadFilterSettingsDialogBox]Edit Signature Download Filter Settings Dialog Box

 
     [bookmark: pgfId-966562]The Edit Signature Download Filter Settings dialog box enables you to download IPS signature updates selectively. It applies both to the manual download and to the automated download.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-966564]Note Filtering does not apply to IPS sensor packages or to IPS engine packages; it applies to IPS signature packages only. All the available sensor packages on Cisco.com or on the local server will be downloaded as part of a signature download.


     
      

     

     

 
     [bookmark: pgfId-966566]The benefits of selective download are reduced download time, reduced disk storage space, and faster troubleshooting because you can download only what you need.

 
     [bookmark: pgfId-966568]There are four types of signature download available to you with the Edit Signature Download Filter Settings dialog box:

 
      
      		 [bookmark: pgfId-966570]No filter

 
      		 [bookmark: pgfId-966572]Download all signatures for engine versions starting with [choose E4, E3, E2, or E1]

 
      		 [bookmark: pgfId-966574]Download all signature versions starting with [enter a signature version such as 1000]

 
      		 [bookmark: pgfId-966576]Download a single signature version number [enter a signature number such as 1000]

 
     

 
     [bookmark: pgfId-966578]The default signature configuration is to download all signatures for engine versions starting with E4.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-966580]Tip This default value is the same for a new installation of Security Manager 4.3 and for upgrades from previous versions.


     
      

     

     

 
     [bookmark: pgfId-966582]Navigation Path

 
     [bookmark: pgfId-966584]Select Tools > Security Manager Administration and then select IPS Updates from the table of contents; then click Edit Settings in the Signature Filter Settings group.

 
     [bookmark: pgfId-966586]Related Topics

 
      
      		 [bookmark: pgfId-966591]Configuring the IPS Update Server

 
      		 [bookmark: pgfId-966596]Checking for IPS Updates and Downloading Them

 
      		 [bookmark: pgfId-966601]Automating IPS Updates

 
     

 
     [bookmark: pgfId-966603]Field Reference

 
     [bookmark: pgfId-966606] 

 
      
       
        
        [bookmark: pgfId-963274]Table 11-28 [bookmark: 34688]Edit Signature Download Filter Settings Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-963280]Element
          
  
         		
           
           [bookmark: pgfId-963282]Description
          
  
        

 
         
         		[bookmark: pgfId-963288]Filter Type: No filter

  
         		[bookmark: pgfId-963290]All available signatures for all available engines are downloaded.

  
        

 
         
         		[bookmark: pgfId-963296]Filter Type: Download all signatures for engine versions starting with

  
         		[bookmark: pgfId-963298]All available signatures for the engine that you select (E4, E3, E2, or E1) are downloaded.

  
        

 
         
         		[bookmark: pgfId-963304]Filter Type: Download all signature versions starting with

  
         		[bookmark: pgfId-963306]All available signatures starting with the ID that you enter are downloaded.

  
        

 
         
         		[bookmark: pgfId-963312]Filter Type: Download single signature version number

  
         		[bookmark: pgfId-963314]The single signature having the ID that you enter is downloaded.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-966624][bookmark: 34720][bookmark: syspage_cncpt_ISESettingsPage]ISE Settings Page[bookmark: marker-966614][bookmark: marker-966616][bookmark: marker-966618][bookmark: marker-966620][bookmark: marker-966622]

 
    [bookmark: pgfId-966626]Use the ISE Settings page to configure communication between Cisco Security Manager and the Cisco Identity Services Engine (ISE) for use with TrustSec firewall policies.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-966628]Note Security Manager supports communications with only one ISE appliance/server for fetching and resolving security group names and tags.


    
     

    

    

 
    [bookmark: pgfId-966630]Navigation Path

 
    [bookmark: pgfId-966632]Select Tools > Security Manager Administration and select ISE Settings from the table of contents.

 
    [bookmark: pgfId-966634]Related Topics

 
     
     		 [bookmark: pgfId-966639]Chapter 14, “Managing TrustSec Firewall Policies”

 
     		 [bookmark: pgfId-966644]Creating Security Group Objects

 
     		 [bookmark: pgfId-966649]Selecting Security Groups in Policies

 
    

 
    [bookmark: pgfId-966651]Field Reference

 
    [bookmark: pgfId-966654] 

 
     
      
       
       [bookmark: pgfId-963327]Table 11-29 [bookmark: 34761]Identity Settings Page 

 
       
      
        
        		
          
          [bookmark: pgfId-963333]Element
         
  
        		
          
          [bookmark: pgfId-963335]Description
         
  
       

 
        
        		[bookmark: pgfId-963341]Enable ISE feature

  
        		[bookmark: pgfId-963343]Whether to enable communication with the ISE.

  
       

 
        
        		[bookmark: pgfId-963349]Username

  
        		[bookmark: pgfId-963351]The username Security Manager should use to log on to the ISE.

  
       

 
        
        		[bookmark: pgfId-963357]Password

  
        		[bookmark: pgfId-963359]The password for the username.

  
       

 
        
        		[bookmark: pgfId-963365]ISE Server (IP Address/Hostname)

  
        		[bookmark: pgfId-963367]The DNS hostname or IP address of the ISE.

  
       

 
        
        		[bookmark: pgfId-963373]Test Connectivity

  
        		[bookmark: pgfId-963375]Click Test Connectivity to ensure that Security Manager can communicate with the ISE given the settings you have entered.

  
       

 
        
        		[bookmark: pgfId-963381]Save button

  
        		[bookmark: pgfId-963383]Saves your changes.

  
       

 
        
        		[bookmark: pgfId-963389]Reset button

  
        		[bookmark: pgfId-963391]Resets changes to the previously applied values.

  
       

 
        
        		[bookmark: pgfId-963397]Restore Defaults button

  
        		[bookmark: pgfId-963399]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-966668][bookmark: 34812][bookmark: syspage_cncpt_LicensingPage]Licensing Page[bookmark: marker-966664][bookmark: marker-966666]

 
    [bookmark: pgfId-966673]Use the Licensing page to manage licenses for the Security Manager application and for IPS devices. For more information, see Managing IPS Licenses.

 
    [bookmark: pgfId-966675]Navigation Path

 
    [bookmark: pgfId-966677]Select Tools > Security Manager Administration and select Licensing from the table of contents.

 
    [bookmark: pgfId-966679]Field Reference

 
    [bookmark: pgfId-966682] 

 
     
      
       
       [bookmark: pgfId-963412]Table 11-30 [bookmark: 34833]Licensing Page 

 
       
      
        
        		
          
          [bookmark: pgfId-963418]Element
         
  
        		
          
          [bookmark: pgfId-963420]Description
         
  
       

 
        
        		[bookmark: pgfId-963426]CSM tab

  
        		[bookmark: pgfId-963431]The license settings for the Security Manager application. For a description of the fields on this tab, see CSM Tab, Licensing Page.

  
       

 
        
        		[bookmark: pgfId-963437]IPS tab

  
        		[bookmark: pgfId-963442]The license settings for IPS devices managed by Security Manager. For a description of the fields on this tab, see IPS Tab, Licensing Page.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-966690][bookmark: 34855][bookmark: syspage_cncpt_CSMTab]CSM Tab, Licensing Page[bookmark: marker-966688]

 
     [bookmark: pgfId-966695]Use the CSM tab on the Licensing page to view the list of installed Security Manager licenses and to install new licenses. For more information, see Installing Security Manager License Files.

 
     [bookmark: pgfId-966697]Navigation Path

 
     [bookmark: pgfId-966699]Select Tools > Security Manager Administration, select Licensing from the table of contents, and click CSM.

 
     [bookmark: pgfId-966701]Field Reference

 
     [bookmark: pgfId-966704] 

 
      
       
        
        [bookmark: pgfId-963455]Table 11-31 [bookmark: 34870]CSM Tab, Licensing Page 

 
        
       
         
         		
           
           [bookmark: pgfId-963461]Element
          
  
         		
           
           [bookmark: pgfId-963463]Description
          
  
        

 
         
         		[bookmark: pgfId-963469]License Information

  
         		[bookmark: pgfId-963471]Displays information about the license registered with the product: the edition, license type, expiration date, the number of licensed devices, the number of devices in use, and the percentage of the device count used.

  
        

 
         
         		[bookmark: pgfId-963477]Install License

  
         		[bookmark: pgfId-963479]The list of installed licenses with their installation dates.

  
        

 
         
         		[bookmark: pgfId-963485]Install a License button

  
         		[bookmark: pgfId-963487]Click this button to install a license file. The dialog box that is opened includes links to Cisco.com, where you can obtain licenses if you have not already obtained them. You must copy license files to a local drive on the Security Manager server before you can install them.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-966712][bookmark: 34896][bookmark: syspage_cncpt_IPSTab]IPS Tab, Licensing Page [bookmark: marker-966710]

 
     [bookmark: pgfId-966714]Use the IPS tab on the Licensing page to view the list of installed IPS device licenses, to install new or updated licenses, or to redeploy licenses. The license list shows current licenses, unlicensed devices, devices with expired licenses, and devices with invalid licenses. You can also use the settings on this page to send a report of all those IPS devices whose license would expire within a specified number of days.

 
     [bookmark: pgfId-966716]Navigation Path

 
     [bookmark: pgfId-966718]Select Tools > Security Manager Administration, select Licensing from the table of contents, and click IPS.

 
     [bookmark: pgfId-966720]Related Topics

 
      
      		 [bookmark: pgfId-966725]Updating IPS License Files

 
      		 [bookmark: pgfId-966730]Redeploying IPS License Files

 
      		 [bookmark: pgfId-966735]Automating IPS License File Updates

 
      		 [bookmark: pgfId-966740]License Update Status Details Dialog Box

 
      		 [bookmark: pgfId-966745]Filtering Tables

 
      		 [bookmark: pgfId-966750]Table Columns and Column Heading Features

 
     

 
     [bookmark: pgfId-966752]Field Reference

 
     [bookmark: pgfId-966755] 

 
      
       
        
        [bookmark: pgfId-963500]Table 11-32 [bookmark: 34931]IPS Tab, Licensing Page 

 
        
       
         
         		
           
           [bookmark: pgfId-963506]Element
          
  
         		
           
           [bookmark: pgfId-963508]Description
          
  
        

 
         
         		[bookmark: pgfId-963514]IPS License Table

  
         		[bookmark: pgfId-963516]Displays all the IPS devices in the device inventory and their license status as of the last time you refreshed the information. Click the Refresh button to obtain the latest information from the devices.

 [bookmark: pgfId-963518]Information includes the serial number for the device, which is used to register for licenses, the license status, and the expiration date of the license. The list shows not only current licenses, but also unlicensed devices, devices with expired licenses, and devices with invalid licenses.

 [bookmark: pgfId-963520]Tip The list does not include Cisco IOS IPS devices. You cannot use Security Manager to manage licenses for routers running IPS.  
        

 
         
         		[bookmark: pgfId-963526]Update Selected via CCO button

  
         		[bookmark: pgfId-963528]Click this button to update the license file for the selected devices by connecting to Cisco.com and retrieving a new license. When you click this button, a dialog box opens listing devices that can be updated from Cisco.com, which might not be all the devices you selected. Click OK to perform the update. For successful updates, the updated file is automatically applied to the device.

 [bookmark: pgfId-963530]To successfully update the license using this method, you must have a Cisco.com support contract that includes the serial numbers of the selected devices.

 [bookmark: pgfId-963532]Tip The Cisco software license server (SWIFT) that contains the licenses might block requests from the same server for more than 9 licenses within a three minute period. Thus, you should select fewer than 9 devices at a time when performing manual license updates.  
        

 
         
         		[bookmark: pgfId-963538]Redeploy Selected Licenses button

  
         		[bookmark: pgfId-963540]Click this button to redeploy licenses to the selected devices. Redeploying licenses might be necessary when you have obtained an updated license file and it was not applied to the device successfully during an automatic update.

 [bookmark: pgfId-963542]When you click this button, a dialog box opens listing devices whose licenses you are redeploying. Click OK to perform the update. For successful updates, the updated file is automatically applied to the device.

  
        

 
         
         		[bookmark: pgfId-963548]Update from License File button

  
         		[bookmark: pgfId-963550]Click this button to update licenses by selecting a license file from the Security Manager server. When you click this button, a dialog box opens where you can specify the license files. Click Browse to select the files, which must be on a local drive on the Security Manager server. When you click OK, the updated files are automatically applied to the devices.

  
        

 
         
         		[bookmark: pgfId-963560]Export As button[bookmark: marker-963556][bookmark: marker-963558]

  
         		[bookmark: pgfId-963562]Select one or more IPS devices from the list and then click the Export As button to export their licenses to a Portable Document Format (PDF) or comma-separated values (CSV) file. You are prompted to select the folder on the Security Manager server and to specify a file name. If you do not select any device from the list, the licenses of all available devices are exported.

  
        

 
         
         		[bookmark: pgfId-963568]Refresh License button

  
         		[bookmark: pgfId-963570]Click this button to refresh the data in the IPS license table for the selected devices. The updated information is retrieved from the device. If you do not select any devices, all devices are refreshed; this can take a long time depending on the number of devices listed.

  
        

 
         
         		[bookmark: pgfId-963576]Download and apply licenses

 [bookmark: pgfId-963578]Days before the expiration date.

  
         		[bookmark: pgfId-963580]Whether to automatically download IPS licenses from Cisco.com and apply them to the devices. To successfully configure automatic updates, you must have a Cisco.com support contract that includes the serial numbers of your IPS devices.

 [bookmark: pgfId-963582]If you select this option, also specify the number of days before the license expiration date for downloading and applying licenses. Security Manager evaluates only those devices that do not have licenses, have expired licenses, or have valid licenses within this number of days of expiration. Licenses are applied only if they are valid and either have an expiration date farther out than the current one, or that have different license information.

  
        

 
         
         		[bookmark: pgfId-963588]Discover devices daily at

  
         		[bookmark: pgfId-963590]If you select automatic license updates, the time of day when Security Manager should contact devices for current licenses status and evaluate whether there are devices that have licenses that will expire within the specified number of days. Cisco.com is contacted only if one or more device meets the expiration requirements.

  
        

 
         
         		[bookmark: pgfId-963596]Email License Update Results

 [bookmark: pgfId-963598]Email Notification

  
         		[bookmark: pgfId-963600]Whether to send email notifications of expiration alerts and license update job results. If you select this option, also enter one or more email addresses (comma separated).

  
        

 
         
         		[bookmark: pgfId-963606]Email License Expiration Status

 [bookmark: pgfId-963608]Email Notification

  
         		[bookmark: pgfId-963610]Whether to send a PDF report of those IPS devices whose license would expire within a specified number of days. If you select this option:

 
           
           		 [bookmark: pgfId-963612]Enter the number of days (not more than 100) before the device license expiry date, by which you want Security Manager to send the PDF report.

 
           		 [bookmark: pgfId-963614]Select the time and day for Security Manager to check the license expiry.

 
           		 [bookmark: pgfId-963616]Enter one or more email addresses (comma separated) to which you want the License Expiration Status PDF report to be sent.

 
          

  
        

 
         
         		[bookmark: pgfId-963622]Save button

  
         		[bookmark: pgfId-963624]Saves your changes to the automatic license update and e-mail notification settings.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-966769][bookmark: 35024][bookmark: syspage_cncpt_RedeployingLicensesDialogBox]Verifying IPS Devices for License Update or Redeployment[bookmark: marker-966765][bookmark: marker-966767]

 
     [bookmark: pgfId-966774]When you select a device on the Licensing > IPS tab (see IPS Tab, Licensing Page) and try to update the license from Cisco.com (CCO) or redeploy the license, you are first shown a list of devices that will be updated. The name of the dialog box is based on the action you are taking:

 
      
      		 [bookmark: pgfId-966776] Updating Licenses via CCO dialog box —Review the IPS devices you selected to update from Cisco.com. The device list displays the IPS devices for which you can update the license from Cisco.com, which might not be all of the devices you selected.

 
     

 
     [bookmark: pgfId-966778]To successfully update the license using this method, you must have a Cisco.com support contract that includes the serial numbers of the selected devices.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-966780]Tip The Cisco software license server (SWIFT) that contains the licenses might block requests from the same server for more than 9 licenses within a three minute period. Thus, you should select fewer than 9 devices at a time when performing manual license updates.


     
      

     

     

 
      
      		 [bookmark: pgfId-966782] Redeploying Licenses dialog box —Review the IPS devices you selected for redeploying licenses. Before you can redeploy a license to a device, you must have already deployed the license. Security Manager uses the file already associated with the IPS device to redeploy the license.

 
     

 
     [bookmark: pgfId-966787]When you click OK, the License Update Status Details dialog box opens so that you can view the status of the license redeployment task. See License Update Status Details Dialog Box.

 
     [bookmark: pgfId-966789]Navigation Path

 
     [bookmark: pgfId-966791]To open these dialog boxes, select one or more device on the Tools > Security Manager Administration > Licensing > IPS tab and click Update Selected via CCO or Redeploy Selected Licenses.

 
    
 
     
      [bookmark: pgfId-966801][bookmark: 35055][bookmark: syspage_cncpt_UpdatingLicensesfromFileDialogBox]Selecting IPS License Files[bookmark: marker-966799]

 
     [bookmark: pgfId-966803]If you select one or more devices on the Tools > Security Manager Administration > Licensing > IPS tab and click Update from License File, you are prompted to select the license file you want to use with the Updating Licenses from File dialog box.

 
     [bookmark: pgfId-966805]You can store the license file on a local drive on the Security Manager server, and, beginning with Version 4.5 of Security Manager, you can store it on a local drive on a client.

 
     [bookmark: pgfId-966807]Click Browse to select the license file. You can select multiple license files using Ctrl+click or a range of files using Shift+click.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-966809]Note If you installed the Security Manager client on a different machine than the one on which Security Manager server is installed, you can choose to select the license file from either the client machine or the server machine. If both the client and the server are installed on the same machine, Security Manager allows you to select the license file only from the server.


     
      

     

     

 
     [bookmark: pgfId-966811]When you have selected the license files you want to use, click OK to apply them to the IPS devices.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-966813]Note If you want to store the license file on a client machine, you must select "Enable Client side file browser" on the Customize Desktop page at Tools > Security Manager Administration > Customize Desktop.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-966823][bookmark: 35072][bookmark: syspage_cncpt_LicenseUpdateStatusDetailsDialogBox]License Update Status Details Dialog Box[bookmark: marker-966821]

 
     [bookmark: pgfId-966828]Use the License Update Status Details dialog box to view the status of an IPS license update task. This dialog box opens whenever you start an update task from the IPS tab of the Licensing page. For more information, see IPS Tab, Licensing Page.

 
     [bookmark: pgfId-966830]Field Reference

 
     [bookmark: pgfId-966833] 

 
      
       
        
        [bookmark: pgfId-963637]Table 11-33 [bookmark: 35083]License Update Status Details Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-963643]Element
          
  
         		
           
           [bookmark: pgfId-963645]Description
          
  
        

 
         
         		[bookmark: pgfId-963651]Progress bar

  
         		[bookmark: pgfId-963653]Indicates what percentage of the license update task on the current device has been completed.

  
        

 
         
         		[bookmark: pgfId-963659]Status

  
         		[bookmark: pgfId-963661]The current state of the update task.

  
        

 
         
         		[bookmark: pgfId-963667]Devices to be updated

  
         		[bookmark: pgfId-963669]The total number of devices being updated during this task.

  
        

 
         
         		[bookmark: pgfId-963675]Devices updated successfully

  
         		[bookmark: pgfId-963677]The number of devices updated without errors.

  
        

 
         
         		[bookmark: pgfId-963683]Devices updated with errors

  
         		[bookmark: pgfId-963685]The number of devices that generated errors during the update.

  
        

 
         
         		[bookmark: pgfId-963691]Device list

  
         		[bookmark: pgfId-963693]The devices that are being updated, including the device name, the status of the update, and summary information about the update. Select a device to see the messages generated during the update for that device in the message list below the summary list.

  
        

 
         
         		[bookmark: pgfId-963699]Messages list

  
         		[bookmark: pgfId-963701]The messages generated during the license update for the selected device. Select a message to see detailed information in the fields to the right of the list.

  
        

 
         
         		[bookmark: pgfId-963707]Description

  
         		[bookmark: pgfId-963709]Additional information about the message selected in the message list.

  
        

 
         
         		[bookmark: pgfId-963715]Action

  
         		[bookmark: pgfId-963717]The steps you should take to resolve the described problem.

  
        

 
         
         		[bookmark: pgfId-963723]Abort button

  
         		[bookmark: pgfId-963725]Aborts the license update task.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-966849][bookmark: 35146][bookmark: syspage_cncpt_LogsPage]Logs Page[bookmark: marker-966841][bookmark: marker-966843][bookmark: marker-966845][bookmark: marker-966847]

 
    [bookmark: pgfId-966851]Use the Logs page to configure the default settings for the audit and operations logs. The audit log keeps a record of all state changes that occur in Security Manager.

 
    [bookmark: pgfId-966853]Navigation Path

 
    [bookmark: pgfId-966855]Select Tools > Security Manager Administration and select Logs from the table of contents.

 
    [bookmark: pgfId-966857]Related Topics

 
     
     		 [bookmark: pgfId-966862]Using the Audit Report Window

 
     		 [bookmark: pgfId-966867]Understanding Audit Reports

 
     		 [bookmark: pgfId-966872]Generating the Audit Report

 
     		 [bookmark: pgfId-966877]Purging Audit Log Entries

 
    

 
    [bookmark: pgfId-966879]Field Reference

 
    [bookmark: pgfId-966882] 

 
     
      
       
       [bookmark: pgfId-963738]Table 11-34 [bookmark: 35185]Logs Page 

 
       
      
        
        		
          
          [bookmark: pgfId-963744]Element
         
  
        		
          
          [bookmark: pgfId-963746]Description
         
  
       

 
        
        		[bookmark: pgfId-963752]Keep Audit Log For

 [bookmark: pgfId-963754]Purge Now button

  
        		[bookmark: pgfId-963756]The maximum number of days to save audit report entries before deleting them. If the number of entries in the log exceeds the number entered in the Purge Audit Log After field, old log entries might be deleted before they reach this age.

 [bookmark: pgfId-963758]If you reduce the number of days, you can click Purge Now to immediately delete the older entries.

 >\CSCOpx\MDC\log\audit folder. These *.csv files can be deleted directly.

  
       

 
        
        		[bookmark: pgfId-963766]Purge Audit Log After (entries)

  
        		[bookmark: pgfId-963768]The maximum number of audit report entries to save. If an entry becomes older than the number of days specified in the Keep Audit Log For field, it is deleted even if the log has fewer than the maximum number of entries.

  
       

 
        
        		[bookmark: pgfId-963774]Keep Operation Log For

  
        		[bookmark: pgfId-963776]The number of days that Security Manager keeps operation logs before deleting them. These logs are used for debugging purposes.

  
       

 
        
        		[bookmark: pgfId-963782]Log Level

  
        		[bookmark: pgfId-963784]The level of information, according to severity, that you would like collected in the operation logs. Each level collects different amounts of data. For example, the Info level yields the most data, and the Severe level collects the least.

  
       

 
        
        		[bookmark: pgfId-963790]Save button

  
        		[bookmark: pgfId-963792]Saves your changes.

  
       

 
        
        		[bookmark: pgfId-963798]Reset button

  
        		[bookmark: pgfId-963800]Resets changes to the previously applied values.

  
       

 
        
        		[bookmark: pgfId-963806]Restore Defaults button

  
        		[bookmark: pgfId-963808]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-966896][bookmark: 35236][bookmark: syspage_cncpt_PolicyManagementPage]Policy Management Page[bookmark: marker-966890][bookmark: marker-966892][bookmark: marker-966894]

 
    [bookmark: pgfId-966898]Use the Policy Management page to select the types of router and firewall policies you will manage in Security Manager. These selections apply to routers and firewall devices, but do not apply to IPS devices. By default, all policies are selected for management.

 
    [bookmark: pgfId-966900]Unmanaged policies are removed from both Device view and Policy view. Any unmanaged policies, local or shared, are removed from the Security Manager database. The only exception is interface policies, which continue to appear in Security Manager but are marked as read-only policies. For firewall devices, interface and failover settings are considered a unit and are managed or unmanaged together.

 
    [bookmark: pgfId-966905]For detailed information on managing and unmanaging policy types, including what you should do before and after changing these settings, see Customizing Policy Management for Routers and Firewall Devices.

 
     
     [image: ] 
    
 
    
 
    
     [bookmark: pgfId-966907]
     Caution If you use AUS or CNS to deploy configurations to ASA or PIX devices, be aware that the device downloads a full configuration from AUS or CNS. Thus, reducing the policies managed by Security Manager actually removes the configurations from the device. If you intend to deselect some ASA/PIX policies for management to use other applications along with Security Manager to configure devices, do not use AUS or CNS.
      
      
 
     

    
 
    [bookmark: pgfId-966909]Navigation Path

 
    [bookmark: pgfId-966911]Select Tools > Security Manager Administration and select Policy Management from the table of contents.

 
    [bookmark: pgfId-966913]Field Reference

 
    [bookmark: pgfId-966916] 

 
     
      
       
       [bookmark: pgfId-963821]Table 11-35 [bookmark: 35261]Policy Management Page 

 
       
      
        
        		
          
          [bookmark: pgfId-963827]Element
         
  
        		
          
          [bookmark: pgfId-963829]Description
         
  
       

 
        
        		[bookmark: pgfId-963835]Policies to Manage

  
        		[bookmark: pgfId-963837]The policy types are organized in folders, with router and firewall (which includes all ASA, PIX, and FWSM devices) handled separately, and then by category (NAT, Interfaces, and Platform). Select or deselect policy types as desired and click Save. Deselecting the check box for a group of policies deselects all policies in that group. By default, all policies are selected.

  
       

 
        
        		[bookmark: pgfId-963843]Display a warning on all shared policies and imported objects

  
        		[bookmark: pgfId-963845]Whether to add a message to all shared policies and to objects that were imported using the File > Import command. If you select this option, messages appear on the following:

 
          
          		 [bookmark: pgfId-963847]All shared policies, whether they were imported or locally created.

 
          		 [bookmark: pgfId-963852]Policy objects that were created by importing devices or shared policies using the  File > Import command, but not imported policy objects created by the PolicyObjectImportExport.pl command (described in Importing and Exporting Policy Objects.

 
         

 [bookmark: pgfId-963854]If you regularly import shared policies, the imported policies and objects replace any same-named policies and objects, so any changes made locally are removed. This message can notify users that policies might be imported and help users identify policy objects that they might not want to edit.

 [bookmark: pgfId-963859]Tip When importing policies or devices, you are prompted to select a setting for this option. Thus, users who import policies or devices can change this setting without accessing this page provided they have the required authorization. The change is effective only after the importer submits (and if necessary, approves) the changes. For more information, see Importing Policies or Devices.  
       

 
        
        		[bookmark: pgfId-963865]Save button

  
        		[bookmark: pgfId-963867]Saves your changes.

 [bookmark: pgfId-963869]If you are unmanaging a policy, you are shown a list of devices that have the policy assigned to them. Security Manager must be able to obtain the required locks to unassign the policy from all devices, or you must manually unassign the policies (or remove the locks) before unmanaging the policy.

 [bookmark: pgfId-963871]If you are managing a previously unmanaged policy, be sure to rediscover all affected devices to bring the existing configurations into Security Manager.

  
       

 
        
        		[bookmark: pgfId-963877]Reset button

  
        		[bookmark: pgfId-963879]Resets changes to the previously applied values.

  
       

 
        
        		[bookmark: pgfId-963885]Restore Defaults button

  
        		[bookmark: pgfId-963887]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-966930][bookmark: 35311][bookmark: syspage_cncpt_PolicyObjectsPage]Policy Objects Page[bookmark: marker-966924][bookmark: marker-966926][bookmark: marker-966928]

 
    [bookmark: pgfId-966932]Use the Policy Objects page to define system defaults related to policy object creation.

 
    [bookmark: pgfId-966934]Navigation Path

 
    [bookmark: pgfId-966936]Select Tools > Security Manager Administration and select Policy Objects from the table of contents.

 
    [bookmark: pgfId-966938]Related Topics

 
     
     		 [bookmark: pgfId-966943]Understanding and Specifying Services and Service and Port List Objects

 
     		 [bookmark: pgfId-966948]Chapter 6, “Managing Policy Objects”

 
    

 
    [bookmark: pgfId-966950]Field Reference

 
    [bookmark: pgfId-966953] 

 
     
      
       
       [bookmark: pgfId-963900]Table 11-36 [bookmark: 35341]Policy Objects Page 

 
       
      
        
        		
          
          [bookmark: pgfId-963906]Element
         
  
        		
          
          [bookmark: pgfId-963908]Description
         
  
       

 
        
        		[bookmark: pgfId-963914]When Redundant Objects Detected

  
        		[bookmark: pgfId-963916]The action you want Security Manager to take when you try to create a policy object that has the same definition as an existing object:

 
          
          		 [bookmark: pgfId-963918]Ignore—You can freely create objects with identical definitions. Any conflicts are ignored by Security Manager.

 
          		 [bookmark: pgfId-963920]Warn—Security Manager displays a warning if you attempt to create an object that is identical to an existing object. You may proceed to create the object, if you wish.

 
          		 [bookmark: pgfId-963922]Enforce—Security Manager prevents you from creating an object that is identical to an existing object. An error message is displayed.

 
         

  
       

 
        
        		[bookmark: pgfId-963928]Default Source Ports

  
        		[bookmark: pgfId-963930]The port range value that is used as the default source port range for service objects. You can choose one of the following:

 
          
          		 [bookmark: pgfId-963932]Use all ports—Includes all ports from 1 to 65535.

 
          		 [bookmark: pgfId-963934]Use secure ports—Includes all ports from 1024 to 65535.

 
         

 [bookmark: pgfId-963936]If you change the default source ports, you must manually redeploy any previously deployed devices that might be affected. These changes might not be reflected in any open activities until you refresh the data.

 [bookmark: pgfId-963941]For more information on port list objects, see Configuring Port List Objects.

  
       

 
        
        		[bookmark: pgfId-963947]Enable AutoComplete Dropdown Box

  
        		[bookmark: pgfId-963949]Whether to have Security Manager list matching service and port list names as you type them when you create a service. You can then easily select from names you have already defined. If you deselect AutoComplete, you have to remember the complete service and port list names and type them in yourself.

  
       

 
        
        		[bookmark: pgfId-963955]Save button

  
        		[bookmark: pgfId-963957]Saves your changes.

  
       

 
        
        		[bookmark: pgfId-963963]Reset button

  
        		[bookmark: pgfId-963965]Resets changes to the previously applied values.

  
       

 
        
        		[bookmark: pgfId-963971]Restore Defaults button

  
        		[bookmark: pgfId-963973]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-966961][bookmark: 35397][bookmark: syspage_cncpt_PRSM_SSO_Settings]Single Sign-on Configuration Page

 
    [bookmark: pgfId-966963]Use the Single Sign-on Configuration page of the Security Manager Administration window to enable and configure a “single sign-on” (SSO) shared key to use for cross-launching Cisco Prime Security Manager or FireSIGHT Management Center.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-966965]Note Single sign-on allows users to cross-launch Prime Security Manager or FireSIGHT Management Center from Security Manager without logging into Prime Security Manager or FireSIGHT Management Center separately. However, SSO is not required to cross-launch Prime Security Manager or FireSIGHT Management Center.


    
     

    

    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-966967]Tip Cisco Prime Security Manager is used to manage ASA CX modules. FireSIGHT Management Center is used to manager ASA FirePOWER modules.


    
     

    

    

 
    [bookmark: pgfId-966969]Related Topics

 
     
     		 [bookmark: pgfId-966974]Detecting ASA CX and FirePOWER Modules

 
     		 [bookmark: pgfId-966979]Launching Cisco Prime Security Manager or FireSIGHT Management Center

 
     		 [bookmark: pgfId-966984]Sharing Device Inventory and Policy Objects with PRSM

 
    

 
    [bookmark: pgfId-966986]Navigation Path

 
    [bookmark: pgfId-966988] 1. Click Tools > Security Manager Administration and select Single Sign-on Configuration from the table of contents.

 
    [bookmark: pgfId-966990] 2. Select Enable for Prime Security Manager [checkbox] or Enable for FireSIGHT Management Center [checkbox].

 
    [bookmark: pgfId-966992]Field Reference

 
    [bookmark: pgfId-966995] 

 
     
      
       
       [bookmark: pgfId-963986]Table 11-37 [bookmark: 35432]Single Sign-on Configuration Page 

 
       
      
        
        		
          
          [bookmark: pgfId-963992]Element
         
  
        		
          
          [bookmark: pgfId-963994]Description
         
  
       

 
        
        		[bookmark: pgfId-964000]Enable for Prime Security Manager

  
        		[bookmark: pgfId-964002][checkbox] Lets you enable or disable the SSO feature for Prime Security Manager. When disabled, the shared key is retained.

  
       

 
        
        		[bookmark: pgfId-964008]Enable for FireSIGHT Management Center

  
        		[bookmark: pgfId-964010][checkbox] Lets you enable or disable the SSO feature for FireSIGHT Management Center. When disabled, the shared key is retained.

  
       

 
        
        		[bookmark: pgfId-964016]Shared Key for Single Sign-on

  
        		[bookmark: pgfId-964018]Use the features in this section to generate and view an encryption key for cross-launching Prime Security Manager or FireSIGHT Management Center.

 [bookmark: pgfId-964020]Click the Generate button to randomly generate a 128-bit AES key, which is then displayed as a 32 hexadecimal string in the SSO Shared Key field.

 [bookmark: pgfId-964022]Note This key must be provided when configuring single sign-on cross-launching in Prime Security Manager or FireSIGHT Management Center. Also, each allowed Security Manager user must be configured in the Prime Security Manager database or the FireSIGHT Management Center user database with the same username as that in the Security Manager user database (the password can be different).

 ) for information about configuring SSO in PRSM.  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-967007][bookmark: 35464][bookmark: syspage_cncpt_RuleExpirationPage]Rule Expiration Page[bookmark: marker-967003][bookmark: marker-967005]

 
    [bookmark: pgfId-967009]Use the Rule Expiration page to define the default values for policy rule expiration. When you create policies for some types of policy rules (such as access rules), you can set an expiration date for the rule, and Security Manager can notify you by e-mail of the approaching expiration date.

 
    [bookmark: pgfId-967014]You must configure an SMTP server to enable e-mail notifications. For more information, see Configuring an SMTP Server and Default Addresses for E-Mail Notifications.

 
    [bookmark: pgfId-967016]Navigation Path

 
    [bookmark: pgfId-967018]Select Tools > Security Manager Administration and select Rule Expiration from the table of contents.

 
    [bookmark: pgfId-967020]Field Reference

 
    [bookmark: pgfId-967023] 

 
     
      
       
       [bookmark: pgfId-964039]Table 11-38 [bookmark: 35484]Rule Expiration Page 

 
       
      
        
        		
          
          [bookmark: pgfId-964045]Element
         
  
        		
          
          [bookmark: pgfId-964047]Description
         
  
       

 
        
        		[bookmark: pgfId-964053]Notify Email

  
        		[bookmark: pgfId-964055]The default e-mail address that should receive notifications of rule expiration. Users can override this address when configuring individual rules.

  
       

 
        
        		[bookmark: pgfId-964061]Notify Before Expiration

  
        		[bookmark: pgfId-964063]The default number of days before a rule expires that Security Manager should send the e-mail message. Users can override this value when configuring individual rules.

  
       

 
        
        		[bookmark: pgfId-964069]Sender

  
        		[bookmark: pgfId-964071]The e-mail address that Security Manager will use for sending e-mail notifications.

  
       

 
        
        		[bookmark: pgfId-964077]Email Format

  
        		[bookmark: pgfId-964079]The format of the e-mail message:

 
          
          		 [bookmark: pgfId-964081]Text—The e-mail is sent in HTML and plain text formats.

 
          		 [bookmark: pgfId-964083]XML—The e-mail is sent using an XML markup. This option might be appropriate if you decide to write a program to automatically process and respond to notifications.

 
         

  
       

 
        
        		[bookmark: pgfId-964089]Save button

  
        		[bookmark: pgfId-964091]Saves your changes.

  
       

 
        
        		[bookmark: pgfId-964097]Reset button

  
        		[bookmark: pgfId-964099]Restores all fields to their previous values.

  
       

 
        
        		[bookmark: pgfId-964105]Restore Defaults button

  
        		[bookmark: pgfId-964107]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-967035][bookmark: 35535][bookmark: syspage_cncpt_ServerSecurityPage]Server Security Page[bookmark: marker-967031][bookmark: marker-967033]

 
    [bookmark: pgfId-967037]Use the Server Security page to open specific pages in the CiscoWorks Common Services application, where you can configure various security features on the Security Manager server. CiscoWorks Common Services controls the basic functions of the Security Manager server, including user access control and system security.

 
    [bookmark: pgfId-967039]When you log in to Security Manager, your username and password are compared with the account information stored in the CiscoWorks or Cisco Secure Access Control Server (ACS) database, depending on which system you established at installation as your AAA provider. After the authentication of your credentials, you have access according to the role you have been assigned.

 
    [bookmark: pgfId-967043]For more information on Security Manager roles and privileges, including descriptions of how Common Services roles translate to user functions in Security Manager, see the Installation Guide for Cisco Security Manager.

 
    [bookmark: pgfId-967045]Navigation Path

 
    [bookmark: pgfId-967047]Select Tools > Security Manager Administration and select Server Security from the table of contents.

 
    [bookmark: pgfId-967049]Field Reference

 
    [bookmark: pgfId-967052] 

 
     
      
       
       [bookmark: pgfId-964120]Table 11-39 [bookmark: 35557]Server Security Page 

 
       
      
        
        		
          
          [bookmark: pgfId-964126]Element
         
  
        		
          
          [bookmark: pgfId-964128]Description
         
  
       

 
        
        		[bookmark: pgfId-964134]AAA Setup button

  
        		[bookmark: pgfId-964136]Opens Common Services and displays the AAA Mode Setup page. From this page, you can set AAA as your fallback sign-on method. For more information about AAA, click Help from the AAA Mode Setup page.

  
       

 
        
        		[bookmark: pgfId-964142]Certificate Setup button

  
        		[bookmark: pgfId-964144]Opens Common Services and displays the Self-Signed Certificate Setup page. CiscoWorks enables you to create self-signed security certificates, which you can use to enable SSL connections between your client browser and management server. For more information about self-signed certificates, click Help from the Certificate Setup page.

  
       

 
        
        		[bookmark: pgfId-964150]Single Sign On button

  
        		[bookmark: pgfId-964152]Opens Common Services and displays the Single Sign-On Setup page. With Single Sign On (SSO), you can use your browser session to transparently navigate to multiple CiscoWorks servers without having to authenticate to each of them. Communication between multiple CiscoWorks servers is enabled by a trust mode addressed by certificates and shared secrets. For more information about setting up SSO, click Help from the Single Sign-On page.

  
       

 
        
        		[bookmark: pgfId-964158]Local User Setup

  
        		[bookmark: pgfId-964162]Opens Common Services and displays the Local User Setup page, from which you can add and delete users, edit user settings, and assign roles or permissions. For more information, click Help from the Local User Setup page and see the Installation Guide for Cisco Security Manager.

  
       

 
        
        		[bookmark: pgfId-964168]System Identity Setup

  
        		[bookmark: pgfId-964170]Opens Common Services and displays the System Identity Setup page. Communication between multiple CiscoWorks servers is enabled by a trust mode addressed by certificates and shared secrets. System Identity setup helps you to create a trust user on servers that are part of a multi- server setup. For more information about system identity setup, click Help from the System Identity Setup page.

  
       

 
        
        		 
          
          [bookmark: pgfId-964176]Native RBAC Parameters
         
  
       

 
        
        		[bookmark: pgfId-964184]Allow logon for user ids not available in Local User Database

  
        		[bookmark: pgfId-964186]For Security Manager installations integrated with an external authentication server like Active Directory, TACACS+, or RADIUS, specifies whether users can log in even when their user name is not defined in the Security Manager user list. When enabled, users are allowed to log in using the default role specified in Role Management Setup. If a default role is not configured, the user is not allowed to log in.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-967064][bookmark: 35610][bookmark: syspage_cncpt_TakeOverUserSessionPage]Take Over User Session Page[bookmark: marker-967060][bookmark: marker-967062]

 
    [bookmark: pgfId-967066]Use the Take Over User Session page to take over another user’s configuration session. A user with administrative privileges can take over the work of another user in non-Workflow mode. Taking over a session is useful when a user is working on devices and policies, causing the devices and policies to be locked, and another user needs access to the same devices and policies. However, when you take over another user’s session, your current session is discarded, so make sure that you submit your changes before taking over a session.

 
    [bookmark: pgfId-967068]The table shows all current configuration sessions, listing the user name and the state of the session, whether the user is currently logged in or logged out. Select the configuration session you want to take over and click Take over session. The session is transferred to you in its current state, including any saved changes the user made during the session.

 
    [bookmark: pgfId-967070]If the selected user is logged in at the time you take over the session, the user receives a warning message, loses any unsaved changes in progress, and then is logged out.

 
    [bookmark: pgfId-967075]For more information, see Taking Over Another User’s Work.

 
    [bookmark: pgfId-967077]Navigation Path

 
    [bookmark: pgfId-967079]Select Tools > Security Manager Administration and select Take Over User Session from the table of contents.

 
   
 
    
     [bookmark: pgfId-967091][bookmark: 35631][bookmark: syspage_cncpt_TicketManagementPage]Ticket Management Page[bookmark: marker-967087][bookmark: marker-967089]

 
    [bookmark: pgfId-967093]Use the Ticket Management page to enable Ticket Management, to configure a ticketing system URL for integration with an external change management system, and to configure purge settings for ticket information.

 
    [bookmark: pgfId-967095]When Ticket Management is enabled, every Image Management installation job must have an assigned ticket or it will not be performed.

 
    [bookmark: pgfId-967097]Navigation Path

 
    [bookmark: pgfId-967099]Select Tools > Security Manager Administration and select Ticket Management from the table of contents.

 
    [bookmark: pgfId-967101]Related Topics

 
     
     		 [bookmark: pgfId-967106]Changing Workflow Modes

 
     		 [bookmark: pgfId-967111]Comparing Workflow Modes

 
    

 
    [bookmark: pgfId-967113]Field Reference

 
    [bookmark: pgfId-967116] 

 
     
      
       
       [bookmark: pgfId-964199]Table 11-40 [bookmark: 35660]Ticket Management Page 

 
       
      
        
        		
          
          [bookmark: pgfId-964205]Element
         
  
        		
          
          [bookmark: pgfId-964207]Description
         
  
       

 
        
        		[bookmark: pgfId-964213]Enable Ticketing

  
        		[bookmark: pgfId-964215]Whether to enable Ticket Management.

  
       

 
        
        		 
          
          [bookmark: pgfId-964221]Ticketing System URL
         
  
       

 
        
        		[bookmark: pgfId-964229]Ticketing System URL

  
        		[bookmark: pgfId-964231]The URL to use for launching an external change management system. When this field is configured, the Ticket ID is a hyperlink that will launch the URL specified. The URL must be formatted as a template that accepts the Ticket ID as part of the URL. The template format uses {0} in place of the actual Ticket ID.

 [bookmark: pgfId-964233]For example, if the URL to launch an external ticket management system for a ticket with the ticket ID of TKT12345 is http://ticketsystem/displayticket?ticketid=TKT12345, then the template URL you would use would be http://ticketsystem/displayticket?ticketid={0}.

 [bookmark: pgfId-964235]When you create a ticket, the Ticket ID you specify will be used in the hyperlink in place of the {0}.

  
       

 
        
        		[bookmark: pgfId-964241]Generate

  
        		[bookmark: pgfId-964243]Click to display the Generate Template URL dialog box that can be used to create a Ticketing System URL.

 [bookmark: pgfId-964245]Using the example above, you would enter TKT12345 in the Ticket ID field and http://ticketsystem/displayticket?ticketid=TKT12345 in the Ticket URL field. When you click OK, the appropriate template URL is created and entered into the Ticketing System URL field.

  
       

 
        
        		 [bookmark: pgfId-964251]Ticket History

 [bookmark: pgfId-964256]Ticket History settings are only available in non-Workflow mode. In Workflow mode, purge settings are controlled via the settings for Activities (see Workflow Page).

  
       

 
        
        		[bookmark: pgfId-964264]Purge Tickets (including change report) Older than

  
        		[bookmark: pgfId-964266]The number of days that ticket information should be kept in the Ticket Manager table. The default is 30. You can specify from 1 to 120 days.

 [bookmark: pgfId-964268]Click Purge Now to delete all tickets older than the number of days specified.

  
       

 
        
        		[bookmark: pgfId-964274]Purge Change Report older than

  
        		[bookmark: pgfId-964276]The number of days that change reports should be maintained. The default is 30. You can specify a value that is less than the Purge Tickets (including change report) Older than setting.

 [bookmark: pgfId-964278]Click Purge Now to delete all change reports older than the number of days specified.

  
       

 
        
        		[bookmark: pgfId-964284]Save button

  
        		[bookmark: pgfId-964286]Saves your changes.

  
       

 
        
        		[bookmark: pgfId-964292]Reset button

  
        		[bookmark: pgfId-964294]Resets changes to the last saved values.

  
       

 
        
        		[bookmark: pgfId-964300]Restore Defaults button

  
        		[bookmark: pgfId-964302]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-967130][bookmark: 35735][bookmark: syspage_cncpt_TokenManagementPage]Token Management Page[bookmark: marker-967124][bookmark: marker-967126][bookmark: marker-967128]

 
    [bookmark: pgfId-967132]Use the Token Management page to identify the Token Management System (TMS) server to use for deploying configurations to Cisco IOS routers that use TMS as the communication protocol. Security Manager uses the settings on this page to contact the TMS server.

 
    [bookmark: pgfId-967134]Security Manager uses FTP to deploy the delta configuration file to the TMS server, from which the configuration file can be downloaded and encrypted onto an eToken.

 
    [bookmark: pgfId-967142]To use TMS with Cisco IOS routers, you must specify TMS as the transport protocol. You can do this for all routers on the Device Communication page (see Device Communication Page), or for a specific router in its device properties (see Device Properties: General Page). You must also configure the TMS server as an FTP server, otherwise deployment will fail.

 
    [bookmark: pgfId-967144]Navigation Path

 
    [bookmark: pgfId-967146]Select Tools > Security Manager Administration and select Token Management from the table of contents.

 
    [bookmark: pgfId-967148]Related Topics

 
     
     		 [bookmark: pgfId-967153]Deploying Configurations to a Token Management Server

 
     		 [bookmark: pgfId-967158]Understanding Deployment Methods

 
    

 
    [bookmark: pgfId-967160]Field Reference

 
    [bookmark: pgfId-967163] 

 
     
      
       
       [bookmark: pgfId-964315]Table 11-41 [bookmark: 35769]Token Management Page 

 
       
      
        
        		
          
          [bookmark: pgfId-964321]Element
         
  
        		
          
          [bookmark: pgfId-964323]Description
         
  
       

 
        
        		[bookmark: pgfId-964329]Server Name or IP Address

  
        		[bookmark: pgfId-964331]The DNS hostname or IP address of the TMS server.

  
       

 
        
        		[bookmark: pgfId-964337]Username

  
        		[bookmark: pgfId-964339]The username Security Manager should use to log on to the TMS server.

  
       

 
        
        		[bookmark: pgfId-964345]Password

 [bookmark: pgfId-964347]Confirm Password

  
        		[bookmark: pgfId-964349]The password for the username. Enter the password in both fields.

  
       

 
        
        		[bookmark: pgfId-964355]Directory in the TMS Server for Config Files

  
        		[bookmark: pgfId-964357]The directory on the TMS server where deployed configuration files will be downloaded. The root FTP directory (“.”) is the default FTP location on the TMS server.

  
       

 
        
        		[bookmark: pgfId-964363]Public Key File Location

  
        		[bookmark: pgfId-964365]The location of the public and private key files on the Security Manager server, as copied from the TMS server. Security Manager uses the public key to encrypt data sent to the TMS server. Then the server uses its private key to decrypt the data. Security Manager comes with a default public key that matches the default private key on the server.

 [bookmark: pgfId-964367]Note If needed, you can generate a new pair of public and private keys using the TMS server. If you do this, you need to copy the new public key to the Security Manager server.

  
       

 
        
        		[bookmark: pgfId-964373]Save button

  
        		[bookmark: pgfId-964375]Saves your changes.

  
       

 
        
        		[bookmark: pgfId-964381]Reset button

  
        		[bookmark: pgfId-964383]Resets changes to the last saved values.

  
       

 
        
        		[bookmark: pgfId-964389]Restore Defaults button

  
        		[bookmark: pgfId-964391]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-967179][bookmark: 35822][bookmark: syspage_cncpt_VPNPolicyDefaultsPage]VPN Policy Defaults Page[bookmark: marker-967171][bookmark: marker-967173][bookmark: marker-967175][bookmark: marker-967177]

 
    [bookmark: pgfId-967184]Use the VPN Policy Defaults page to view or assign the default VPN policies that Security Manager uses for each IPsec technology. Before you can select a policy as a default, you must create the policy as a shared policy, submit it to the database and have it approved. You cannot create policies from this page. For detailed information on how to configure these defaults, see Understanding and Configuring VPN Default Policies.

 
    [bookmark: pgfId-967186]For each tab that relates to a VPN topology, the drop-down lists for each policy type list the existing shared policies that you can select. You can select a policy and click the View Content button to see the definition of that policy. In some cases, you are allowed to make changes, but you cannot save them.

 
    [bookmark: pgfId-967188]Security Manager uses VPN policy defaults to simplify VPN configuration while ensuring that policy consistency is maintained. Security Manager provides factory default policies for mandatory policies, which provide values for settings that must be configured on the devices in your VPN topology for the VPN to work. Mandatory policies differ depending on the assigned IPsec technology. Factory default policies with their default configurations enable you to deploy to your devices immediately after creating the VPN topology. Default settings are not provided for optional policies. You might want to create shared policies to provide different default settings instead of using the factory default settings.

 
    [bookmark: pgfId-967190]Navigation Path

 
    [bookmark: pgfId-967192]Select Tools > Security Manager Administration and select VPN Policy Defaults from the table of contents.

 
    [bookmark: pgfId-967194]Related Topics

 
     
     		 [bookmark: pgfId-967199]Assigning Initial Policies (Defaults) to a New VPN Topology

 
     		 [bookmark: pgfId-967204]Creating IPSec VPNs Using the Remote Access VPN Configuration Wizard (ASA and PIX 7.0+ Devices)

 
     		 [bookmark: pgfId-967209]Creating IPSec VPNs Using the Remote Access VPN Configuration Wizard (IOS and PIX 6.3 Devices)

 
    

 
    [bookmark: pgfId-967211]Field Reference

 
    [bookmark: pgfId-967214] 

 
     
      
       
       [bookmark: pgfId-964404]Table 11-42 [bookmark: 35862]VPN Policy Defaults Page 

 
       
      
        
        		
          
          [bookmark: pgfId-964410]Element
         
  
        		
          
          [bookmark: pgfId-964412]Description
         
  
       

 
        
        		[bookmark: pgfId-964418]DMVPN tab

  
        		[bookmark: pgfId-964420]Lists the policy types for which you can configure default policies for the Dynamic Multipoint VPN technology.

  
       

 
        
        		[bookmark: pgfId-964426]Large Scale DMVPN tab

  
        		[bookmark: pgfId-964428]Lists the policy types for which you can configure default policies for the Large Scale Dynamic Multipoint VPN technology.

  
       

 
        
        		[bookmark: pgfId-964434]Easy VPN tab

  
        		[bookmark: pgfId-964436]Lists the policy types for which you can configure default policies for the Easy VPN technology.

  
       

 
        
        		[bookmark: pgfId-964442]IPsec/GRE tab

  
        		[bookmark: pgfId-964444]Lists the policy types for which you can configure default policies for the IPsec/GRE VPN technology.

  
       

 
        
        		[bookmark: pgfId-964450]GRE Dynamic IP tab

  
        		[bookmark: pgfId-964452]Lists the policy types for which you can configure default policies for the GRE Dynamic IP VPN technology.

  
       

 
        
        		[bookmark: pgfId-964458]Regular IPsec tab

  
        		[bookmark: pgfId-964460]Lists the policy types for which you can configure default policies for regular IPsec VPN technology.

  
       

 
        
        		[bookmark: pgfId-964466]GET VPN

  
        		[bookmark: pgfId-964468]Lists the policy types for which you can configure default policies for the Group Encrypted Transport (GET) VPN technology.

  
       

 
        
        		[bookmark: pgfId-964474]Remote Access VPN

  
        		[bookmark: pgfId-964476]Lists the policy types for which you can configure default policies for IPsec remote access VPNs.

  
       

 
        
        		[bookmark: pgfId-964482]S2S Endpoints tab

  
        		[bookmark: pgfId-964484]The interface roles that define the default endpoints for internal and external interfaces in site-to-site VPNs.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-967226][bookmark: 35918][bookmark: syspage_cncpt_WorkflowPage]Workflow Page[bookmark: marker-967222][bookmark: marker-967224]

 
    [bookmark: pgfId-967228]Use the Workflow page to select the workflow mode that Security Manager enforces and to define the default settings for activity and deployment job notifications and logging.

 
    [bookmark: pgfId-967230]Before changing the workflow mode, read the following topics to understand how the modes differ and the effects of changing the modes:

 
     
     		 [bookmark: pgfId-967235]Working in Workflow Mode

 
     		 [bookmark: pgfId-967240]Working in Non-Workflow Mode

 
     		 [bookmark: pgfId-967245]Comparing Workflow Modes

 
     		 [bookmark: pgfId-967250]Changing Workflow Modes

 
    

 
    [bookmark: pgfId-967252]Navigation Path

 
    [bookmark: pgfId-967254]Click Tools > Security Manager Administration and select Workflow from the table of contents.

 
    [bookmark: pgfId-967256]Related Topics

 
     
     		 [bookmark: pgfId-967261]Chapter 4, “Managing Activities”

 
     		 [bookmark: pgfId-967266]Chapter 8, “Managing Deployment”

 
    

 
    [bookmark: pgfId-967268]Field Reference

 
    [bookmark: pgfId-967271] 

 
     
      
       
       [bookmark: pgfId-964497]Table 11-43 [bookmark: 35959]Workflow Page 

 
       
      
        
        		
          
          [bookmark: pgfId-964503]Element
         
  
        		
          
          [bookmark: pgfId-964505]Description
         
  
       

 
        
        		 
          
          [bookmark: pgfId-964511]Workflow Control
         
  
       

 
        
        		[bookmark: pgfId-964519]Enable Workflow

  
        		[bookmark: pgfId-964521]Whether to enable Workflow mode. When Workflow mode is enabled, you can select whether to have an approver for activities and deployment jobs.

  
       

 
        
        		[bookmark: pgfId-964527]Require Activity Approval

  
        		[bookmark: pgfId-964532]Whether to require that activities be approved explicitly by an assigned approver. For more information about the differences between working with and without an approver, see Activity Approval.

  
       

 
        
        		[bookmark: pgfId-964538]Require Deployment & Install Image Approval

  
        		[bookmark: pgfId-964543]Whether to require that deployment jobs and install image jobs be approved explicitly by an assigned approver. For more information about the differences between working with and without an approver, see Understanding Deployment.

  
       

 
        
        		 
          
          [bookmark: pgfId-964549]Email Notifications
         
  
       

 
        
        		[bookmark: pgfId-964557]Sender

  
        		[bookmark: pgfId-964559]The e-mail address that Security Manager will use for sending e-mail notifications.

  
       

 
        
        		[bookmark: pgfId-964565]Activity Approver

  
        		[bookmark: pgfId-964570]The default e-mail address for the person responsible for approving activities. Users can override this address when submitting an activity for approval. For more information, see Submitting an Activity for Approval (Workflow Mode with Activity Approver).

  
       

 
        
        		[bookmark: pgfId-964576]Job/Schedule Approver

  
        		[bookmark: pgfId-964581]The default e-mail address of the person responsible for approving deployment jobs or schedules. Users can override this address when submitting a job or schedule for approval. For more information, see Submitting Deployment Jobs.

  
       

 
        
        		[bookmark: pgfId-964587]Require Deployment Status Notification

 [bookmark: pgfId-964589]Include Job Deployer

 [bookmark: pgfId-964591]Job Completion Notification

  
        		[bookmark: pgfId-964593]Whether to have e-mail notifications sent whenever the status of a deployment job changes. If you select this option, enter the e-mail addresses that should receive notification in the Job Completion Notification field. Separate multiple addresses with commas.

 [bookmark: pgfId-964595]You can also select Include Job Deployer to include the e-mail address of the person who deployed the job on the notification e-mail message.

  
       

 
        
        		 
          
          [bookmark: pgfId-964601]Workflow History
         
  
       

 
        
        		[bookmark: pgfId-964609]Keep Activity for

  
        		[bookmark: pgfId-964611]The number of days that activity information should be kept in the Activity table. The default is 30. You can specify from 1 to 180 days.

 [bookmark: pgfId-964613]Click Purge Now to delete all activities older than the number of days specified.

 [bookmark: pgfId-964618]Note If ticketing is enabled in non-Workflow mode, purge settings are controlled via the settings for Tickets (see Ticket Management Page).

  
       

 
        
        		[bookmark: pgfId-964624]Keep Job for

  
        		[bookmark: pgfId-964626]The number of days that deployment job information should be kept in the Deployment Job table. The default is 30. You can specify from 1 to 180 days.

 [bookmark: pgfId-964628]Click Purge Now to delete all jobs older than the number of days specified.

  
       

 
        
        		[bookmark: pgfId-964634]Keep job per schedule for

  
        		[bookmark: pgfId-964636]The number of days that deployment job information should be kept in the Deployment Job table for each job schedule. This setting applies only to jobs that were initiated by a schedule. The default is 30. You can specify from 1 to 180 days.

 [bookmark: pgfId-964638]Click Purge Now to delete all jobs older than the number of days specified.

  
       

 
        
        		[bookmark: pgfId-964644]Save button

  
        		[bookmark: pgfId-964646]Saves your changes.

  
       

 
        
        		[bookmark: pgfId-964652]Reset button

  
        		[bookmark: pgfId-964654]Resets changes to the previously applied values.

  
       

 
        
        		[bookmark: pgfId-964660]Restore Defaults button

  
        		[bookmark: pgfId-964662]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-967279][bookmark: 36065][bookmark: syspage_cncpt_WallSettingsPage]Wall Settings Page

 
    [bookmark: pgfId-967281]The Security Manager Wall Settings page is where you can enable or disable the Wall feature.

 
    [bookmark: pgfId-967283]The "Wall" feature is also called the "ShoutBox" feature. You can use it to send messages to all users who are logged in on the same Security Manager server. First, however, it must be enabled on the Wall Settings page.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-967285]Note Only admin users have permission to enable or disable the Wall feature, but all users have permission to send messages.


    
     

    

    

 
    [bookmark: pgfId-967287]You would want to use the Wall feature, for example, to interact with other users while making some changes in your Security Manager installation, perhaps about the changes being made or certain immediate actions to be performed on the changes. The message being sent is broadcast to all users who are logged in. The Wall feature allows users to enter basic profile information that can be viewed by others when logged in. A significant use of the Wall feature is that it can be used to view a list of all users who are currently logged in. (A user is removed from the Wall window after idle timeout or logging out through the Security Manager client.)

 
    [bookmark: pgfId-967289]You cannot use the Wall feature to send *.pdf, *.xls, or other file attachments.

 
    [bookmark: pgfId-967291]Navigation Path

 
    [bookmark: pgfId-967293]Click Tools > Security Manager Administration and select Wall Settings from the table of contents.

 
    [bookmark: pgfId-967295]Field Reference

 
    [bookmark: pgfId-967298] 

 
     
      
       
       [bookmark: pgfId-964675]Table 11-44 [bookmark: 36081]Wall Settings Page 

 
       
      
        
        		
          
          [bookmark: pgfId-964681]Element
         
  
        		
          
          [bookmark: pgfId-964683]Description
         
  
       

 
        
        		[bookmark: pgfId-964689]Enable users to send messages to others

  
        		[bookmark: pgfId-964691]Whether to enable or disable the Wall feature.

  
       

 
        
        		[bookmark: pgfId-964697]Save button

  
        		[bookmark: pgfId-964699]Saves and applies changes.

  
       

 
        
        		[bookmark: pgfId-964705]Reset button

  
        		[bookmark: pgfId-964707]Resets changes to the last saved values.

  
       

 
        
        		[bookmark: pgfId-964713]Restore Defaults button

  
        		[bookmark: pgfId-964715]Resets values to Security Manager defaults.

  
       

 
      
     

 
    
 
    [bookmark: pgfId-967300]When the Wall feature is enabled, you can open the Wall window by clicking Tools > Wall... or by clicking the Wall icon in Configuration Manager.

 
    [bookmark: pgfId-967302]You can also open the Wall window by clicking the Wall icon in Health and Performance Monitor or Image Manager. You cannot open the Wall window in Event Viewer or Report Manager.

 
    [bookmark: pgfId-967304]Detailed Wall feature help is available on the Wall window by clicking the help icon.

 
    [bookmark: pgfId-967306]The Wall window contains the following elements:

 
     
     		 [bookmark: pgfId-967308]Left-hand pane, which shows the users who are logged in on the same Security Manager server and an expand/collapse button.

 
     		 [bookmark: pgfId-967311]Right-hand pane, which occupies most of the page and contains the text of the messages that users have sent. The right-hand pane also has a button to enable or disable wall alerts and the help icon, which you can click to see detailed help.

 
      
       
       
         
         		 [bookmark: pgfId-964722]Summary of the Wall Window

  
        

 
         
         		[bookmark: pgfId-964730]Message Display

  
         		[bookmark: pgfId-964732]Messages are displayed in the right-hand pane of the Wall window. The latest messages are always displayed at the top. Selective copy of text is allowed from the messages.

 [bookmark: pgfId-964734]You are allowed to type a maximum of 280 characters in the message panel, and after completing this number of characters you are alerted by a beep sound.

  
        

 
         
         		[bookmark: pgfId-964740]Message Log

  
         		[bookmark: pgfId-964742]You can see a log of previous messages. The message log keeps 100 messages. The messages become visible to you when you launch the Wall window.

  
        

 
         
         		[bookmark: pgfId-964748]Profile Picture

  
         		[bookmark: pgfId-964750]You can upload a picture for your profile. Valid image types such as JPG, PNG, BMP, and GIF types are supported.

 [bookmark: pgfId-964752]To upload a picture, use the upload link in the user profile window. To open the user profile window, click on the username or user picture in the Wall window.

 [bookmark: pgfId-964754]The user profile window also has an icon that toggles between Edit profile information and Save profile information.

  
        

 
         
         		[bookmark: pgfId-964760]User Profile Window

  
         		[bookmark: pgfId-964762]To open the user profile window, click on the username or user picture in the Wall window. The user profile window contains the following information:

 
           
           		 [bookmark: pgfId-964764]Profile Name (maximum 20 characters)

 
           		 [bookmark: pgfId-964766]Designation (maximum 15 characters)

 
           		 [bookmark: pgfId-964768]Email (maximum 15 characters)

 
           		 [bookmark: pgfId-964770]Phone

 
          

 [bookmark: pgfId-964772]Click the corresponding email link to send the mail.

  
        

 
         
         		[bookmark: pgfId-964778]Notification Alert

  
         		[bookmark: pgfId-964780]On receipt of a new message and when the Wall window is not focused, a new notification alert popup is shown to you. You can simply click on the notification to launch the Wall window.

 [bookmark: pgfId-964782]When the notification alert popup is shown to you, the Wall window icon also flashes with the message count displayed.

 [bookmark: pgfId-964784]You can turn off the notifications alert from the settings options provided on the alert popup or in the Wall window.

  
        

 
       
      

 
     
 
    

 
    [bookmark: pgfId-967315]Figure 11-1 [bookmark: 36170]Wall Window

 
    [bookmark: pgfId-967318] 

 
     
     [image: ] 
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     [bookmark: pgfId-983569][bookmark: 74859][bookmark: ravpnch_cncpt_ManagingRemoteAccessVPNs]Managing Remote Access VPNs: The Basics[bookmark: marker-983565][bookmark: marker-983567]
      
      
 
     
 

 
    [bookmark: pgfId-983571]Cisco Security Manager lets you configure both remote access IPSec VPNs and remote access SSL VPNs. Security Manager provides flexible configuration and management of remote access VPNs:

 
     
     		 [bookmark: pgfId-983573]You can discover existing remote access VPN configuration policies from existing live devices or from configuration files. Then, you can change and deploy new or updated policies, as necessary.

 
     		 [bookmark: pgfId-983575]You can use the configuration wizard to help you quickly and easily set up these two types of remote access VPNs with basic functionality.

 
     		 [bookmark: pgfId-983577]If you know the functions and feature your network requires, you can configure remote access VPNs independently. You can also use the wizard to create a basic remote access VPN and then configure additional features that are not included in the wizard separately.

 
    

 
    [bookmark: pgfId-983579]In addition, Cisco Security Manager provides flexibility in how remote access VPN configuration policies are assigned: Device view or Policy view.

 
    [bookmark: pgfId-983581]For some policies, you can also assign either the factory default policy (a private policy), or a shared policy that you created using Security Manager.

 
    [bookmark: pgfId-983583]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-983588]Understanding Remote Access VPNs

 
     		 [bookmark: pgfId-983593]Understanding Devices Supported by Each Remote Access VPN Technology

 
     		 [bookmark: pgfId-983598]Overview of Remote Access VPN Policies

 
     		 [bookmark: pgfId-983603]Discovering Remote Access VPN Policies

 
     		 [bookmark: pgfId-983608]Using the Remote Access VPN Configuration Wizard

 
    

 
   
 
    
     [bookmark: pgfId-983618][bookmark: 74879][bookmark: ravpnch_cncpt_UnderstandingRemoteAccessVPNs]Understanding Remote Access VPNs[bookmark: marker-983614][bookmark: marker-983616]

 
    [bookmark: pgfId-983620]Security Manager supports two types of remote access VPNs: IPSec and SSL.

 
    [bookmark: pgfId-983622]This section contains the following topics:

 
     
     		 [bookmark: pgfId-983627]Understanding Remote Access IPSec VPNs

 
     		 [bookmark: pgfId-983632]Understanding Remote Access SSL VPNs

 
    

 
     
      [bookmark: pgfId-983644][bookmark: 74888][bookmark: ravpnch_cncpt_UnderstandingRemoteAccessIPSecVPNs]Understanding Remote Access IPSec VPNs[bookmark: marker-983638][bookmark: marker-983640][bookmark: marker-983642]

 
     [bookmark: pgfId-983646]Remote access IPSec VPNs permit secure, encrypted connections between a company’s private network and remote users, by establishing an encrypted IPSec tunnel across the Internet using broadband cable, DSL, dial-up, or other connections.

 
     [bookmark: pgfId-983648]A remote access IPSec VPN consists of a VPN client and a VPN headend device, or VPN gateway. The VPN client software resides on a user’s workstation and initiates the VPN tunnel access to the corporate network. At the other end of the VPN tunnel is the VPN gateway at the edge of the corporate site.

 
     [bookmark: pgfId-983650]When a VPN client initiates a connection to the VPN gateway device, negotiation consists of authenticating the device through Internet Key Exchange (IKE), followed by user authentication using IKE Extended Authentication (Xauth). Next the group profile is pushed to the VPN client using mode configuration, and an IPsec security association (SA) is created to complete the VPN connection.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-983655]Tip For a remote access IPsec VPN hosted on an ASA 8.4(x) device, you have the option of configuring IKE version 2 (IKEv2). If you decide to use IKEv2, you must configure several SSL VPN policies in addition to the regular IPSec policies. The user also must use the AnyConnect 3.0+ VPN client to make an IKEv2 connection. For more information, see Creating IPSec VPNs Using the Remote Access VPN Configuration Wizard (ASA and PIX 7.0+ Devices).


     
      

     

     

 
     [bookmark: pgfId-983660]For remote access IPSec VPNs, AAA (authentication, authorization, and accounting) is used for secure access. With user authentication, a valid user name and password must be entered before the connection is completed. User names and passwords can be stored on the VPN device itself, or on an external AAA server that can provide authentication to numerous other databases. For more information on using AAA servers, see Understanding AAA Server and Server Group Objects.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-983665]Note Site-to-site Easy VPN topologies use some of the same policies and policy objects that are used in remote access IPsec VPNs, but the policies are kept distinct from the remote access policies. In Easy VPN, the remote clients are hardware clients, such as routers, whereas in remote access IPSec VPNs, remote clients are workstations or other devices that use VPN client software. For more information, see Understanding Easy VPN.


     
      

     

     

 
     [bookmark: pgfId-983667]Related Topics

 
      
      		 [bookmark: pgfId-983672]Creating IPSec VPNs Using the Remote Access VPN Configuration Wizard (ASA and PIX 7.0+ Devices)

 
      		 [bookmark: pgfId-983677]Creating IPSec VPNs Using the Remote Access VPN Configuration Wizard (IOS and PIX 6.3 Devices)

 
      		 [bookmark: pgfId-983682]Overview of Remote Access VPN Policies

 
      		 [bookmark: pgfId-983687]Discovering Remote Access VPN Policies

 
     

 
    
 
     
      [bookmark: pgfId-983699][bookmark: 74927][bookmark: ravpnch_cncpt_UnderstandingRemoteAccessSSLVPNs1]Understanding Remote Access SSL VPNs[bookmark: marker-983693][bookmark: marker-983695][bookmark: marker-983697]

 
     [bookmark: pgfId-983701]An SSL VPN lets users access enterprise networks from any Internet-enabled location. Users can make clientless connections, which use only a Web browser that natively supports Secure Socket Layer (SSL) encryption, or they can make connections using a full client (such as AnyConnect) or a thin client.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-983703]Note SSL VPN is supported on ASA 5500 devices running software version 8.0 and later, running in single-context and router modes, on Cisco 870, 880, 890, 1800, 2800, 3700, 3800, 7200, and 7301 Series routers running software version 12.4(6)T and later, and on Cisco 1900, 2900, and 3900 Series routers running software version 15.0(1)M and later. For the 880 Series routers, the minimum software version is 12.4(15)XZ, which is mapped to 12.4(20)T in Security Manager.


     
      

     

     

 
     [bookmark: pgfId-983705]On IOS devices, remote access is provided through an SSL-enabled VPN gateway. Using an SSL-enabled Web browser, the remote user establishes a connection to the SSL VPN gateway. After the remote user is authenticated to the secure gateway via the Web browser, an SSL VPN session is established and the user can access the internal corporate network. A portal page lets users access all the resources available on the SSL VPN networks.

 
     [bookmark: pgfId-983707]On ASA devices, remote users establish a secure, remote access VPN tunnel to the security appliance using the Web browser. The SSL protocol provides the secure connection between remote users and specific, supported internal resources that you configure at a central site. The security appliance recognizes connections that need to be proxied, and the HTTP server interacts with the authentication subsystem to authenticate users.

 
     [bookmark: pgfId-983709]User authentication can be done using usernames and passwords, certificates, or both.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-983711]Note Network administrators provide user access to SSL VPN resources on a group basis instead of on an individual user basis.


     
      

     

     

 
     [bookmark: pgfId-983713]This section contains the following topics:

 
      
      		 [bookmark: pgfId-983718]Remote Access SSL VPN Example

 
      		 [bookmark: pgfId-983723]SSL VPN Access Modes

 
      		 [bookmark: pgfId-983728]Understanding and Managing SSL VPN Support Files

 
      		 [bookmark: pgfId-983733]Prerequisites for Configuring SSL VPNs

 
      		 [bookmark: pgfId-983738]SSL VPN Limitations

 
     

 
    
 
     
      [bookmark: pgfId-983750][bookmark: 74947][bookmark: ravpnch_cncpt_UnderstandingRemoteAccessSSLVPNsExample]Remote Access SSL VPN Example[bookmark: marker-983744][bookmark: marker-983746][bookmark: marker-983748]

 
     [bookmark: pgfId-983752]The following illustration shows how a mobile worker can access protected resources from the main office and branch offices. Site-to-site IPsec connectivity between the main and remote sites is unaltered. The mobile worker needs only Internet access and supported software (Web browser and operating system) to securely access the corporate network.

 
     [bookmark: pgfId-983756]Figure 30-1 [bookmark: 74962]Secure SSL VPN Access Example

 
     [bookmark: pgfId-983759] 

 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-983771][bookmark: 74966][bookmark: ravpnch_cncpt_SSLVPNAccessModes]SSL VPN Access Modes[bookmark: marker-983765][bookmark: marker-983767][bookmark: marker-983769]

 
     [bookmark: pgfId-983773]SSL VPN provides three modes of remote access on IOS routers: Clientless, Thin Client and Full Client. On ASA devices, there are two modes: Clientless (which includes Clientless and Thin Client port forwarding) and AnyConnect Client (a full client).

 
     [bookmark: pgfId-983777]Clientless Access Mode[bookmark: marker-983775]

 
     [bookmark: pgfId-983779]In Clientless mode, the remote user accesses the internal or corporate network using a Web browser on the client machine. No applet downloading is required.

 
     [bookmark: pgfId-983781]Clientless mode is useful for accessing most content that you would expect in a Web browser, such as Internet access, databases, and online tools that employ a Web interface. It supports Web browsing (using HTTP and HTTPS), file sharing using Common Internet File System (CIFS), and Outlook Web Access (OWA) email. For Clientless mode to work successfully, the remote user’s PC must be running Windows 2000, Windows XP, or Linux operating systems.

 
     [bookmark: pgfId-983783]Browser-based SSL VPN users connecting from Windows operating systems can browse shared file systems and perform the following operations: view folders, view folder and file properties, create, move, copy, copy from the local host to the remote host, copy from the remote host to the local host, and delete. Internet Explorer indicates when a Web folder is accessible. Accessing this folder launches another window, providing a view of the shared folder, on which users can perform web folder functions, assuming the properties of the folders and documents permit them.

 
     [bookmark: pgfId-983789][bookmark: ravpnch_cncpt_SSLVPNAccessModes_ThinClientAccessMode]Thin Client Access Mode[bookmark: marker-983787]

 
     [bookmark: pgfId-983791]Thin Client mode, also called TCP port forwarding, assumes that the client application uses TCP to connect to a well-known server and port. In this mode, the remote user downloads a Java applet by clicking the link provided on the portal page. The Java applet acts as a TCP proxy on the client machine for the services configured on the SSL VPN gateway. The Java applet starts a new SSL connection for every client connection.

 
     [bookmark: pgfId-983793]The Java applet initiates an HTTP request from the remote user client to the SSL VPN gateway. The name and port number of the internal email server is included in the HTTP request. The SSL VPN gateway creates a TCP connection to that internal email server and port.

 
     [bookmark: pgfId-983795]Thin Client mode extends the capability of the cryptographic functions of the Web browser to enable remote access to TCP-based applications such as Post Office Protocol version 3 (POP3), Simple Mail Transfer Protocol (SMTP), Internet Message Access protocol (IMAP), Telnet, and Secure Shell (SSH).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-983797]Note The TCP port-forwarding proxy works only with Sun’s Java Runtime Environment (JRE) version 1.4 or later. A Java applet is loaded through the browser that verifies the JRE version. The Java applet refuses to run if a compatible JRE version is not detected.


     
      

     

     

 
     [bookmark: pgfId-983799]When using Thin Client mode, you should be aware of the following:

 
      
      		 [bookmark: pgfId-983801]The remote user must allow the Java applet to download and install.

 
      		 [bookmark: pgfId-983803]For TCP port-forwarding applications to work seamlessly, administrative privileges must be enabled for remote users.

 
      		 [bookmark: pgfId-983805]You cannot use Thin Client mode for applications such as FTP, where the ports are negotiated dynamically. That is, you can use TCP port forwarding only with static ports.

 
     

 
     [bookmark: pgfId-983809]Full Tunnel Client Access Mode[bookmark: marker-983807]

 
     [bookmark: pgfId-983811]Full Tunnel Client mode enables access to the corporate network completely over an SSL VPN tunnel, which is used to move data at the network (IP) layer. This mode supports most IP-based applications, such as Microsoft Outlook, Microsoft Exchange, Lotus Notes E-mail, and Telnet. Being part of the SSL VPN is completely transparent to the applications run on the client. A Java applet is downloaded to handle the tunneling between the client host and the SSL VPN gateway. The user can use any application as if the client host was in the internal network.

 
     [bookmark: pgfId-983813]The tunnel connection is determined by the group policy configuration. The SSL VPN client (SVC) or AnyConnect client is downloaded and installed to the remote client, and the tunnel connection is established when the remote user logs in to the SSL VPN gateway. By default, the client software is removed from the remote client after the connection is closed, but you can keep it installed, if required.
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     [bookmark: pgfId-983815]Note Full Tunnel SSL VPN access requires administrative privileges on the remote client.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-983827][bookmark: 75014][bookmark: ravpnch_cncpt_UnderstandingandManagingSSLVPNSupportFiles]Understanding and Managing SSL VPN Support Files[bookmark: marker-983821][bookmark: marker-983823][bookmark: marker-983825]

 
     [bookmark: pgfId-983829]SSL VPNs sometimes require supporting files that reside in the device’s flash storage. This is especially true of SSL VPNs configured on ASA devices. Supporting files include Cisco Secure Desktop (CSD) packages, AnyConnect client images, and plug-in files. Security Manager includes many of these files for your use. However, some supporting files, such as graphic files used for portal pages, or client profiles used for AnyConnect clients are not provided by Security Manager.

 
     [bookmark: pgfId-983834]Typically, you need to create a File Object to specify a supporting file, and you then select the File Object when you create a policy that refers to it. You can create the File Objects that you need when you create the policies, or you can create them before you start defining policies. For more information, see Add and Edit File Object Dialog Boxes.

 
     [bookmark: pgfId-983836]When you deploy policies to the devices, any supporting files referenced in your policies are copied to the device and placed in flash memory in the \csm folder. For the most part, you do not have to do any manual work to make this happen. The following are some situations where you might need to do some manual work:

 
      
      		 [bookmark: pgfId-983841]If you are trying to discover existing SSL VPN policies, or rediscover them, file references from the SSL VPN policies must be correct. For detailed information on how supporting files are handled during policy discovery, see Discovering Remote Access VPN Policies.

 
      		 [bookmark: pgfId-983843]If you have configured the ASA device in an Active/Failover configuration, you must get the supporting files onto the failover device. The supporting files are not copied over to the failover device during a failover. You have these choices for getting the files onto the failover device:

 
     

 
     [bookmark: pgfId-983845] – Manually copy the files from the \csm folder on the active unit to the failover unit.

 
     [bookmark: pgfId-983847] – After deploying the policies to the active unit, force a failover and redeploy the policies to the now-active unit.

 
      
      		 [bookmark: pgfId-983849]If you are using a VPN cluster for load balancing, the same supporting files must be deployed to all devices in the cluster.

 
     

 
     [bookmark: pgfId-983851]Cisco Secure Desktop (CSD) Packages

 
     [bookmark: pgfId-983853]These packages are for ASA SSL VPNs. You select a package in the Dynamic Access policy. The package you select must be compatible with the ASA operating system version running on the device. When you create a Dynamic Access policy for an ASA device, the version number that is compatible with the device’s operating system is displayed in the Version field.

 
     [bookmark: pgfId-983855]You can find the CSD packages in Program Files\CSCOpx\files\vms\repository\. The file names are in the form securedesktop-asa_k9-version.pkg or csd_version.pkg, where version is the CSD version number such as 3.5.1077.

 
     [bookmark: pgfId-983857]Following is the CSD compatibility with ASA versions for the CSD packages shipped with Security Manager:

 
      
      		 [bookmark: pgfId-983859]csd_3_6_181-3.6.181.pkg—ASA 8.4 or later.

 
      		 [bookmark: pgfId-983861]csd_3_5_2008-3.5.2008.pkg—ASA 8.0(4) or later.

 
      		 [bookmark: pgfId-983863]csd_3_5_2001-3.5.2001.pkg—ASA 8.0(4) or later.

 
      		 [bookmark: pgfId-983865]csd_3_5_1077-3.5.1077.pkg—ASA 8.0(4) or later.

 
      		 [bookmark: pgfId-983867]csd_3_5_841-3.5.841.pkg—ASA 8.0(4) or later.

 
      		 [bookmark: pgfId-983869]csd_3_4_2048-3.4.2048.pkg—ASA 8.0(4) or later.

 
      		 [bookmark: pgfId-983871]csd_3_4_1108-3.4.1108.pkg—ASA 8.0(4) or later.

 
      		 [bookmark: pgfId-983873]securedesktop_asa_k9-3.3.0.151.pkg—ASA 8.0(3.1) or later.

 
      		 [bookmark: pgfId-983875]securedesktop_asa-k9-3.3.0.118.pkg—ASA 8.0(3.1) or later.

 
      		 [bookmark: pgfId-983877]securedesktop-asa-k9-3.2.1.126.pkg—ASA 8.0(3) or later.

 
      		 [bookmark: pgfId-983879]securedesktop-asa_k9-3.2.0.136.pkg—ASA 8.0(2) or later.

 
     

 
     [bookmark: pgfId-983885]For more information on CSD version compatibility with ASA versions, see the CSD release notes at http://www.cisco.com/en/US/products/ps6742/prod_release_notes_list.html and Supported VPN Platforms on Cisco.com.

 
     [bookmark: pgfId-983890]For more information on creating Dynamic Access policies to specify the CSD, see Configuring Cisco Secure Desktop Policies on ASA Devices.

 
     [bookmark: pgfId-983892]AnyConnect Client Images

 
     [bookmark: pgfId-983894]These images are for remote access SSL and IKEv2 IPsec VPNs hosted on an ASA. The AnyConnect client is downloaded to the user’s PC and manages the client’s VPN connection. Security Manager includes several AnyConnect images, which you can find in Program Files\CSCOpx\files\vms\repository\. The package names indicate the workstation operating system and the anyconnect release number in this general pattern: anyconnect-client_OS_information-anyconnect_release.pkg. For example, anyconnect-win-3.0.0610-k9-3.0.0610.pkg is the AnyConnect 3.0(0610) client for Windows workstations. The k9 indicates that the package includes encryption. In this example, the AnyConnect release number is repeated; in some file names, the release number appears once.

 
     [bookmark: pgfId-983896]Packages are available for the following workstation operating systems (OS). For specific information on which OS versions that each client supports, see the documentation for the AnyConnect client on Cisco.com.

 
      
      		 [bookmark: pgfId-983898]Linux—Packages start with anyconnect-linux, or anyconnect-linux-64 for 64-bit versions.

 
      		 [bookmark: pgfId-983900]Mac OS—Packages start with anyconnect-macosx for Mac OS X on i386 workstations, and anyconnect-macosx-powerpc for Mac OS X on Power PC workstations.

 
      		 [bookmark: pgfId-983902]Windows—Packages start with anyconnect-win.

 
     

 
     [bookmark: pgfId-983904]You can also download other AnyConnect client packages to the Security Manager server or your local Security Manager client and use them in remote access policies. However, Security Manager might not be able to configure newer parameters for those clients, although it might be possible to use FlexConfigs to configure newer parameters.

 
     [bookmark: pgfId-983906]For more information on the AnyConnect client, its profiles, and how to configure policies to load the client onto the device, see the following topics:

 
      
      		 [bookmark: pgfId-983911]Understanding SSL VPN AnyConnect Client Settings

 
      		 [bookmark: pgfId-983916]Configuring SSL VPN AnyConnect Client Settings (ASA)

 
      		 [bookmark: pgfId-983921]Cisco AnyConnect Profile Editor

 
     

 
     [bookmark: pgfId-983923]Plug-in Files

 
     [bookmark: pgfId-983928]These files are used as browser plug-ins. You can find plug-in files in Program Files\CSCOpx\files\vms\repository\. For complete information on the available files, see Configuring SSL VPN Browser Plug-ins (ASA).

 
    
 
     
      [bookmark: pgfId-983940][bookmark: 75112][bookmark: ravpnch_cncpt_PrerequisitesForConfiguringSSLVPN]Prerequisites for Configuring SSL VPNs[bookmark: marker-983934][bookmark: marker-983936][bookmark: marker-983938]

 
     [bookmark: pgfId-983942]For a remote user to securely access resources on a private network behind an SSL VPN gateway, the following prerequisites must be met:

 
      
      		 [bookmark: pgfId-983944]A user account (login name and password).

 
      		 [bookmark: pgfId-983946]An SSL-enabled browser (such as Internet Explorer, Netscape, Mozilla, or Firefox).

 
      		 [bookmark: pgfId-983948]An email client (such as Eudora, Microsoft Outlook, or Netscape Mail).

 
      		 [bookmark: pgfId-983950]One of the following operating systems:

 
     

 
     [bookmark: pgfId-983952] – Microsoft Windows 2000 or Windows XP, with either JRE for Windows version 1.4 or later, or a browser that supports ActiveX controls.

 
     [bookmark: pgfId-983954] – Linux with JRE for Linux version 1.4 or later. To access Microsoft shared files from Linux in clientless remote access mode, Samba must also be installed.

 
     [bookmark: pgfId-983956]Related Topics

 
      
      		 [bookmark: pgfId-983961]SSL VPN Access Modes

 
      		 [bookmark: pgfId-983966]Creating SSL VPNs Using the Remote Access VPN Configuration Wizard (ASA Devices)

 
      		 [bookmark: pgfId-983971]Creating SSL VPNs Using the Remote Access VPN Configuration Wizard (IOS Devices)

 
     

 
    
 
     
      [bookmark: pgfId-983983][bookmark: 75155][bookmark: ravpnch_cncpt_SSLVPNLimitations]SSL VPN Limitations[bookmark: marker-983977][bookmark: marker-983979][bookmark: marker-983981]

 
     [bookmark: pgfId-983985]SSL VPN configurations in Security Manager are subject to the following limitations:

 
      
      		 [bookmark: pgfId-983987]SSL VPN license information cannot be imported into Security Manager. As a result, certain command parameters, such as  vpn sessiondb and  max-webvpn-session-limit , cannot be validated.

 
      		 [bookmark: pgfId-983989]You must configure DNS on each device in the topology in order to use clientless SSL VPN. Without DNS, the device cannot retrieve named URLs, but only URLs with IP addresses.

 
      		 [bookmark: pgfId-983997]If you share your Connection Profiles policy among multiple ASA devices, bear in mind that all devices share the same address pool unless you use device-level object overrides to replace the global definition with a unique address pool for each device. Unique address pools are required to avoid overlapping addresses in cases where the devices are not using NAT.[bookmark: marker-983991][bookmark: marker-983993][bookmark: marker-983995]

 
      		 [bookmark: pgfId-983999]If the device configuration contains an address pool for SSL VPN with a name that begins CSM_ (the naming convention used by Security Manager), Security Manager cannot detect whether the addresses in that pool overlap with the pool configured in your SSL VPN policy. (This can occur, for example, when the pool was configured by a user on a different installation of Security Manager.) This can lead to errors during deployment. Therefore, we recommend that you configure the same IP address pool as a network/host object in Security Manager and define it as part of the SSL VPN policy. This enables the proper validation to take place.

 
      		 [bookmark: pgfId-984001]The same IP address and port number cannot be shared by multiple SSL VPN gateways on the same IOS device. As a result, deployment errors can occur if a duplicate gateway exists in the device configuration but was not redefined using the Security Manager interface. If such an error occurs, you must choose a different IP address and port number and redeploy.

 
      		 [bookmark: pgfId-984003]If you define AAA authentication or accounting as part of an SSL VPN policy, the  aaa new-model command is deployed to enable AAA services. Bear in mind that this command is not removed if you later delete the SSL VPN policy, as there might be other parts of the device configuration that require the  aaa new-model command for AAA services.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-984005]Note In addition, we recommend that you define at least one local user on the device with a privilege level of 15. This ensures that you will not be locked out of the device if the aaa new-model command is configured without an associated AAA server.


     
      

     

     

 
     [bookmark: pgfId-984007]Related Topics

 
      
      		 [bookmark: pgfId-984012]SSL VPN Access Modes

 
      		 [bookmark: pgfId-984017]Creating SSL VPNs Using the Remote Access VPN Configuration Wizard (ASA Devices)

 
      		 [bookmark: pgfId-984022]Creating SSL VPNs Using the Remote Access VPN Configuration Wizard (IOS Devices)

 
     

 
    
 
   
 
    
     [bookmark: pgfId-984038][bookmark: 75214][bookmark: ravpnch_cncpt_UnderstandingDevicesSupportedbyEachRemoteAccessVPNTechnology]Understanding Devices Supported by Each Remote Access VPN Technology[bookmark: marker-984028][bookmark: marker-984030][bookmark: marker-984032][bookmark: marker-984034][bookmark: marker-984036]

 
    [bookmark: pgfId-984040]There are three types of remote access VPN: IKE version 1 (IKEv1) IPsec, IKE version 2 (IKEv2) IPsec, and SSL. The devices on which you can configure these technologies differs, and broadly speaking, the configuration for each type of VPN differs for ASA/PIX 7.0+ compared to IOS/PIX 6.3 devices.

 
    [bookmark: pgfId-984042]The following table describes the basic device support. When you select a device, the device type will determine which remote access policies are visible or configurable.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-984044]Tip Some device models have NO-VPN versions, which do not support VPN configuration. Thus, although the 3845 model might be supported for a type of VPN, the 3845 NOVPN model is not supported. In addition, the Cisco Catalyst 6500 series ASA Services Module (running software release 8.5(x)) does not support any type of VPN.


    
     

    

    

 
    [bookmark: pgfId-984047] 

 
     
      
       
       [bookmark: pgfId-981951]Table 30-1 [bookmark: 75237]Devices Supported by Each Remote Access Technology 

 
       
      
        
        		
          
          [bookmark: pgfId-981957]Technology
         
  
        		
          
          [bookmark: pgfId-981959]Supported Platforms
         
  
       

 
        
        		[bookmark: pgfId-981965]IKE version 1 IPsec

  
        		
          
          		 [bookmark: pgfId-981967]ASA/PIX 7.0+—ASA 5500 series and PIX 515, 515E, 525, or 535 with PIX Software 7.0+ (including 8.0+), running in single context and router modes.

 
          		 [bookmark: pgfId-981969]IOS/PIX 6.3—Cisco IOS security routers (including Aggregation Service Routers, or ASRs), Catalyst 6500/7600, and PIX Firewalls running PIX Software 6.3 only.

 
         

  
       

 
        
        		[bookmark: pgfId-981975]IKE version 2 IPsec

  
        		[bookmark: pgfId-981977]ASA 5500 series only, running ASA Software 8.4(x) only.

  
       

 
        
        		[bookmark: pgfId-981983]SSL

  
        		
          
          		 [bookmark: pgfId-981985]ASA—ASA 5500 series devices running software version 8.0 and later, running in single-context and router modes.

 
          		 [bookmark: pgfId-981987]IOS—Cisco 870, 880, 890, 1800, 2800, 3700, 3800, 7200, and 7301 Series routers running software version 12.4(6)T and later, and on Cisco 1900, 2900, and 3900 Series routers running software version 15.0(1)M and later. For the 880 Series routers, the minimum software version is 12.4(15)XZ, which is mapped to 12.4(20)T in Security Manager.

 
         

 [bookmark: pgfId-981989]Tip No version of PIX is supported for SSL VPN configuration.  
       

 
      
     

 
    
 
    [bookmark: pgfId-984049]Related Topics

 
     
     		 [bookmark: pgfId-984054]Understanding Remote Access IPSec VPNs

 
     		 [bookmark: pgfId-984059]Understanding Remote Access SSL VPNs

 
     		 [bookmark: pgfId-984064]Using the Remote Access VPN Configuration Wizard

 
     		 [bookmark: pgfId-984069]Overview of Remote Access VPN Policies for ASA and PIX 7.0+ Devices

 
     		 [bookmark: pgfId-984074]Overview of Remote Access VPN Policies for IOS and PIX 6.3 Devices

 
    

 
   
 
    
     [bookmark: pgfId-984084][bookmark: 75290][bookmark: ravpnch_cncpt_OverviewofRemoteAccessVPNPolicies]Overview of Remote Access VPN Policies[bookmark: marker-984080][bookmark: marker-984082]

 
    [bookmark: pgfId-984086]The following list summarizes the various policies used in remote access VPN configuration based on the technology used in the VPN. Possible remote access VPN types are: IKE version 1 (IKEv1) IPsec, IKE version 2 (IKEv2) IPsec, and SSL. Where indicated, many of these policies apply to specific device types only. To see an edited version of this list per device type, see the following topics:

 
     
     		 [bookmark: pgfId-984091]Overview of Remote Access VPN Policies for ASA and PIX 7.0+ Devices

 
     		 [bookmark: pgfId-984096]Overview of Remote Access VPN Policies for IOS and PIX 6.3 Devices

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-984098]Note You cannot configure SSL VPNs on PIX devices; PIX devices support remote access IKEv1 IPsec VPNs only.


    
     

    

    

 
     
     		 [bookmark: pgfId-984100] Policies used with remote access IKEv1 and IKEv2 IPsec and SSL VPNs: 

 
    

 
    [bookmark: pgfId-984105] – ASA Cluster Load Balancing (ASA/PIX 7.0+)—In a remote client configuration in which you are using two or more devices connected to the same network to handle remote sessions, you can configure these devices to share their session load. This feature is called load balancing. Load balancing directs session traffic to the least loaded device, thus distributing the load among all devices. Load balancing is effective only on remote sessions initiated with an ASA device. For more information, see Understanding Cluster Load Balancing (ASA).

 
    [bookmark: pgfId-984110] – Connection Profiles (ASA/PIX 7.0+)—A connection profile is a set of records that contain VPN tunnel connection policies, including the attributes that pertain to creating the tunnel itself. Connection profiles identify the group policies for a specific connection, which includes user-oriented attributes. For more information, see Configuring Connection Profiles (ASA, PIX 7.0+).

 
    [bookmark: pgfId-984115] – Dynamic Access (ASA 8.0+)—Multiple variables can affect each VPN connection, for example, intranet configurations that frequently change, the various roles that each user might inhabit within an organization, and logins from remote access sites with different configurations and levels of security. Dynamic access policies (DAP) let you configure authorization that addresses these many variables. You create a dynamic access policy by setting a collection of access control attributes that you associate with a specific user tunnel or session. For more information, see Chapter 32, “Managing Dynamic Access Policies for Remote Access VPNs (ASA 8.0+ Devices)”.

 
    [bookmark: pgfId-984120] – Global Settings—You can define global settings that apply to all devices in your remote access VPNs. These settings include Internet Key Exchange (IKE), IKEv2, IPsec, NAT, and fragmentation definitions. The global settings typically have defaults that work in most situations, so configuring the Global Settings policy is optional in most cases; configure it only if you need non-default behavior or if you are supporting IKEv2 negotiations. For more information, see Configuring VPN Global Settings.

 
    [bookmark: pgfId-984125] – Group Policies (ASA/PIX 7.0+)—You can view the user group policies defined for your remote access VPN connection profiles. From this page, you can specify new ASA user groups and edit existing ones. When you create a connection profile, if you specify a group policy that has not been used on the device, the group policy is automatically added to the Group Policies page; you do not need to add it to this policy before you create the connection profile. For more information, see Configuring Group Policies for Remote Access VPNs.

 
    [bookmark: pgfId-984133] – Public Key Infrastructure—You can create a Public Key Infrastructure (PKI) policy to generate enrollment requests for CA certificates and RSA keys, and to manage keys and certificates. Certification Authority (CA) servers are used to manage these certificate requests and issue certificates to users who connect to your IPsec or SSL remote access VPN. For more information, see Understanding Public Key Infrastructure Policies and Configuring Public Key Infrastructure Policies for Remote Access VPNs.

 
     
     		 [bookmark: pgfId-984135] Policies used in remote access IPsec VPNs only: 

 
    

 
    [bookmark: pgfId-984140] – Certificate To Connection Profile Maps, Policy and Rules (IKEv1 IPSec only, ASA/PIX 7.0+ only.)—Certificate to connection profile map policies let you define rules to match a user’s certificate to a permission group based on specified fields. To establish authentication, you can use any field of the certificate, or you can have all certificate users share a permission group. You can match the group from the DN rules, the Organization Unit (OU) field, the IKE identity, or the peer IP address. You can use any or all of these methods. For more information, see Configuring Certificate to Connection Profile Map Policies (ASA).

 
    [bookmark: pgfId-984145] – IKE Proposal—Internet Key Exchange (IKE), also called ISAKMP, is the negotiation protocol that enables two hosts to agree on how to build an IPsec security association. IKE is used to authenticate IPsec peers, negotiate and distribute IPsec encryption keys, and to automatically establish IPsec security associations (SAs). Use the IKE Proposal policy to define the requirements for phase 1 of the IKE negotiation. For more information, see Configuring an IKE Proposal.

 
    [bookmark: pgfId-984150] – IPsec Proposal (ASA/PIX 7.x)—An IPsec proposal is a collection of one or more crypto maps. A crypto map combines all the components required to set up IPsec security associations (SAs), including IPsec rules, transform sets, remote peers, and other parameters that might be necessary to define an IPsec SA. The policy is used for IKE phase 2 negotiations. For more information, see Configuring an IPsec Proposal on a Remote Access VPN Server (ASA, PIX 7.0+ Devices).

 
    [bookmark: pgfId-984155] – IPsec Proposal (IOS/PIX 6.x)—An IPsec proposal is a collection of one or more crypto maps. A crypto map combines all the components required to set up IPsec security associations (SAs), including IPsec rules, transform sets, remote peers, and other parameters that might be necessary to define an IPsec SA. The policy is used for IKE phase 2 negotiations. For more information, see Configuring an IPsec Proposal on a Remote Access VPN Server (IOS, PIX 6.3 Devices).

 
    [bookmark: pgfId-984160] – High Availability (IOS/PIX 6.3)—High Availability (HA) is supported by the creation of an HA group made up of two or more hub devices that use Hot Standby Routing Protocol (HSRP) to provide transparent, automatic device failover. For more information, see Configuring High Availability in Remote Access VPNs (IOS).

 
    [bookmark: pgfId-984165] – User Groups (IOS/PIX 6.x)—A user group policy specifies the attributes that determine user access to and use of the VPN. For more information, see Configuring User Group Policies.

 
     
     		 [bookmark: pgfId-984167] Policies used in remote access IKEv2 IPSec and SSL VPNs only: 

 
    

 
    [bookmark: pgfId-984172] – Access (ASA only.)—An Access policy specifies the security appliance interfaces on which a remote access SSL or IKEv2 IPsec VPN connection profile can be enabled, the port to be used for the connection profile, Datagram Transport Layer Security (DTLS) settings, the SSL VPN session timeout and maximum number of sessions. You can also specify whether to use the AnyConnect VPN Client or AnyConnect Essentials Client. For more information, see Understanding SSL VPN Access Policies (ASA).

 
    [bookmark: pgfId-984177] – Other Settings (ASA only.)—The SSL VPN Other Settings policy defines settings that include caching, content rewriting, character encoding, proxy and proxy bypass definitions, browser plug-ins, AnyConnect client images and profiles, Kerberos Constrained Delegation, and some other advanced settings. For more information, see Configuring Other SSL VPN Settings (ASA).

 
    [bookmark: pgfId-984182] – Shared License (ASA only.)—Use the SSL VPN Shared License page to configure your SSL VPN Shared License. For more information, see Configuring SSL VPN Shared Licenses (ASA 8.2+).

 
    [bookmark: pgfId-984187] – SSL VPN (IOS devices only.)—The SSL VPN policy table lists all of the contexts that define the virtual configurations of the SSL VPN. Each context has a gateway, domain or virtual hostname, and user group policies. For more information, see Configuring an SSL VPN Policy (IOS).

 
   
 
    
     [bookmark: pgfId-984203][bookmark: 75388][bookmark: ravpnch_cncpt_DiscoveringRemoteAccessVPNPolicies]Discovering Remote Access VPN Policies[bookmark: marker-984193][bookmark: marker-984195][bookmark: marker-984197][bookmark: marker-984199][bookmark: marker-984201]

 
    [bookmark: pgfId-984205]Security Manager allows you to import the configurations of remote access IPSec VPN policies during policy discovery. You can also discover SSL VPN policies on ASA devices, but not on IOS devices. To discover remote access VPN policies, select the RA VPN Policies option in the Discover Device settings when adding the device to the inventory or when discovering policies on a device already in the inventory. For more information on adding devices or discovering policies, see the following topics:

 
     
     		 [bookmark: pgfId-984210]Adding Devices to the Device Inventory

 
     		 [bookmark: pgfId-984215]Discovering Policies on Devices Already in Security Manager

 
    

 
    [bookmark: pgfId-984217]You can discover configurations on devices that are already deployed in your remote access VPN network, so that Security Manager can manage them. These configurations are imported into Security Manager as remote access VPN policies. Remote access VPN policy discovery can be performed by importing the configuration of a live device or by importing a configuration file. However, SSL VPN policies that refer to files in flash storage cannot be discovered from configuration files, therefore, we recommend that you do not discover SSL VPNs from configuration files.

 
    [bookmark: pgfId-984219]When you initiate policy discovery on a device in a remote access VPN, the system analyzes the configuration on the device and then translates this configuration into Security Manager policies so that the device can be managed. Warnings are displayed if the imported configuration completes only a partial policy definition. If additional settings are required, you must go to the relevant page in the Security Manager interface to complete the policy definition. You can also rediscover the configurations of devices that are already managed with Security Manager.

 
    [bookmark: pgfId-984221]When discovering SSL VPN policies, files residing in flash storage that are referenced in SSL VPN policies are copied to the Security Manager server to be stored in the /csm directory on the target device when policies are deployed from Security Manager. If the flash storage contains files that you want to use, but they are not referenced by an SSL VPN policy, either configure commands that refer to them or manually copy them to the Security Manager server. Policy discovery fails if an SSL VPN policy on the device refers to a file that has been deleted from flash; in this case, either fix the configuration directly before discovering the device, or deselect the RA VPN Policies option when adding the device and create the desired SSL VPN configuration in Security Manager.

 
    [bookmark: pgfId-984223]Tips

 
     
     		 [bookmark: pgfId-984225]You should perform deployment immediately after you discover the policies on a device before you make any changes to policies or unassign policies from the device; otherwise, the changes that you configure in Security Manager might not be deployed to the device.

 
     		 [bookmark: pgfId-984227]For ASA and PIX 7.0+ devices, the default connection profiles and group policy are discovered and added to the Connection Profiles and Group Policies policy. You can modify these default profiles and group, but you cannot delete them:

 
    

 
    [bookmark: pgfId-984229] – DefaultRAGroup—The default connection profile for remote access IPsec VPNs.

 
    [bookmark: pgfId-984231] – DefaultWEBVPNGroup—The default connection profile for SSL VPNs. This connection profile is discovered only for ASA 8.0+ devices.

 
    [bookmark: pgfId-984233] – DfltGrpPolicy—The default group policy, which is used by the default connection profiles. When discovered, Security Manager uses the name <device_display_name>DfltGrpPolicy. However, when you deploy configurations, the device display name is stripped off and DfltGrpPolicy is used.

 
    [bookmark: pgfId-984235]This naming convention is necessary because group policies are modeled as shared policy objects, and you might have modified the default group policy differently on your devices. However, the naming convention does not prevent you from using shared policies that incorporate the default group policy; the device display name is stripped from the object name regardless of the device to which it is assigned. For example, if you use the object 10.100.10.1DfltGrpPolicy with device 10.200.11.1, Security Manager still uses “DfltGrpPolicy” in the configuration.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-984237]Note Although these default connection profiles use the DfltCustomization object for SSL VPN portal customization, Security Manager does not discover it. To modify DfltCustomization, you must do so directly on the device. However, you can simply create your own customization object and specify it in the default connection profile to use non-default settings.


    
     

    

    

 
    [bookmark: pgfId-984239]Related Topics

 
     
     		 [bookmark: pgfId-984244]Discovering Policies

 
     		 [bookmark: pgfId-984249]Site-To-Site VPN Discovery

 
     		 [bookmark: pgfId-984254]VPN Discovery Rules

 
    

 
   
 
    
     [bookmark: pgfId-984280][bookmark: 75449][bookmark: ravpnch_cncpt_UsingtheRemoteAccessConfigurationWizard]Using the Remote Access VPN Configuration Wizard[bookmark: marker-984262][bookmark: marker-984264][bookmark: marker-984266][bookmark: marker-984268][bookmark: marker-984270][bookmark: marker-984272][bookmark: marker-984274][bookmark: marker-984276][bookmark: marker-984278]

 
    [bookmark: pgfId-984282]You can use the Remote Access VPN Configuration wizard to create the policies required to configure a basic IPsec or SSL VPN. The wizard provides simplified options to configure the basic settings. Thus, after using the wizard, you might need to configure additional settings in the individual remote access VPN policies.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-984284]Tip The wizard never creates a valid IKEv2 IPSec VPN. You must always configure additional policies to complete an IKEv2 configuration.


    
     

    

    

 
    [bookmark: pgfId-984286]Depending on the device type and VPN type (IPSec or SSL), the wizard takes you through the steps to configure a basic remote access VPN.

 
    [bookmark: pgfId-984288]To access the Remote Access Configuration wizard:

 
    [bookmark: pgfId-984290] 1. In Device view, select the device to configure as your remote access server from the Device selector.

 
    [bookmark: pgfId-984292] 2. Select Remote Access VPN > Configuration Wizard from the Policy selector.

 
    [bookmark: pgfId-984294] 3. Select the radio button corresponding to the type of remote access VPN you want to create: Remote Access SSL VPN or Remote Access IPSec VPN.

 
    [bookmark: pgfId-984296] 4. Click Remote Access Configuration Wizard to open the appropriate wizard.

 
    [bookmark: pgfId-984298]For detailed information on how to use each version of the wizard, see the following topics:

 
     
     		 [bookmark: pgfId-984303]Creating SSL VPNs Using the Remote Access VPN Configuration Wizard (ASA Devices)

 
     		 [bookmark: pgfId-984308]Creating IPSec VPNs Using the Remote Access VPN Configuration Wizard (ASA and PIX 7.0+ Devices)

 
     		 [bookmark: pgfId-984313]Creating SSL VPNs Using the Remote Access VPN Configuration Wizard (IOS Devices)

 
     		 [bookmark: pgfId-984318]Creating IPSec VPNs Using the Remote Access VPN Configuration Wizard (IOS and PIX 6.3 Devices)

 
    

 
     
      [bookmark: pgfId-984336][bookmark: 75517][bookmark: ravpnch_proc_CreatingSSLVPNsUsingtheRemoteAccessVPNConfigurationWizard_ASA]Creating SSL VPNs Using the Remote Access VPN Configuration Wizard (ASA Devices)[bookmark: marker-984324][bookmark: marker-984326][bookmark: marker-984328][bookmark: marker-984330][bookmark: marker-984332][bookmark: marker-984334]

 
     [bookmark: pgfId-984338]This procedure describes how to create or edit SSL VPNs on ASA devices using the Remote Access SSL VPN Configuration Wizard.

 
     [bookmark: pgfId-984340]Related Topics

 
      
      		 [bookmark: pgfId-984345]Understanding Remote Access SSL VPNs

 
      		 [bookmark: pgfId-984350]Understanding Devices Supported by Each Remote Access VPN Technology

 
     

 
     
 
     [bookmark: pgfId-984352]Step 1 In Device view, select the desired ASA device.

 
     [bookmark: pgfId-984354]Step 2 From the Policy selector, select Remote Access VPN > Configuration Wizard.

 
     [bookmark: pgfId-984356]Step 3 Select the Remote Access SSL VPN radio button.

 
     [bookmark: pgfId-984361]Step 4 Click Remote Access Configuration Wizard. The Access page opens. For a description of the elements on this page, see SSL VPN Configuration Wizard—Access Page (ASA).

 
     [bookmark: pgfId-984363]Step 5 Specify the interfaces on which you want to enable the SSL VPN connections. Click Select to select an interface or an interface role object that identifies the interfaces.

 
     [bookmark: pgfId-984365]Step 6 Specify the port number you want to use for the SSL VPN sessions. Enter the port number or the name of a port list object that defines the number, or click Select to select the object or to create a new object.

 
     [bookmark: pgfId-984367]The default port is 443, for HTTPS traffic. The port number can be 443, or within the range of 1024-65535. If you change the port number, all current SSL VPN connections terminate, and current users must reconnect.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-984369]Note If HTTP port redirection is enabled, the default HTTP port number is 80.


     
      

     

     

 
     [bookmark: pgfId-984371]Step 7 To allow users to select a tunnel group from a list of tunnel group connection profiles configured on the device at login, select the Allow Users to Select Connection Profile in Portal Page option.

 
     [bookmark: pgfId-984373]Step 8 To allow users to use the AnyConnect VPN client to connect to the SSL VPN, select the Enable AnyConnect Access check box.

 
     [bookmark: pgfId-984378]Step 9 Click Next. The Connection Profile page opens. For a description of the elements on this page, see SSL VPN Configuration Wizard—Connection Profile Page (ASA).

 
     [bookmark: pgfId-984383]Step 10 In Connection Profile Name, enter the name of the connection profile. This is the name of the tunnel group, and will appear in the Remote Access VPN > Connection Profiles policy. For more information about the connection profile policy, see Configuring Connection Profiles (ASA, PIX 7.0+).

 
     [bookmark: pgfId-984388]Step 11 On the Connection Profile page, configure these options that will later appear in the General tab of the connection profile (see General Tab (Connection Profiles)):

 
      
      		 [bookmark: pgfId-984393] Group Policy —Enter the name of the ASA Group Policy policy object that will be the default group for the connection profile, or click  Select to select the object. If the required object does not yet exist, click  Select , then click the  Create (+) button in the ASA User Groups Selector dialog box, which opens a wizard to guide you through the creation process as described in Creating User Groups with the Create Group Policy Wizard.

 
     

 
     [bookmark: pgfId-984398]For more information about ASA Group Policies objects, see ASA Group Policies Dialog Box.

 
      
      		 [bookmark: pgfId-984400] Group Policies —This table lists all group policies currently used on the device, whether for SSL or IPsec VPNs. You can click  Edit to add other group policies.

 
      		 [bookmark: pgfId-984402] Global IP Address Pool —Enter the address pools from which IP addresses are assigned. The server uses these address pools in the order listed. If all addresses in the first pool have been assigned, it uses the next pool, and so on. You can specify up to 6 pools.

 
     

 
     [bookmark: pgfId-984404]Specify the pools as address ranges or network/host objects that contain address ranges, in the format Start_Address-End_Address, for example, 10.100.10.2-10.100.10.254. Click Select to select network/host objects or to create new objects.

 
     [bookmark: pgfId-984409]Step 12 On the Connection Profile page, configure these options that will later appear in the SSL VPN tab of the connection profile (see SSL Tab (Connection Profiles)):

 
      
      		 [bookmark: pgfId-984411] Portal Page Customization —The name of the SSL VPN Customization policy object that defines the default portal page for the VPN. Click  Select to select the object or to create a new object.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-984413]Note You can set up different login windows for different groups by using a combination of customization profiles and tunnel groups. For example, assuming that you had created a customization profile called salesgui, you can create an SSL VPN tunnel group called sales that uses that customization profile.


     
      

     

     

 
      
      		 [bookmark: pgfId-984415] Connection URL —The URL of the connection profile. This URL provides users with direct access to the customized portal page. Select a protocol ( http or  https ) from the list, and specify the URL including the name of the connection profile, in the field provided.

 
     

 
     [bookmark: pgfId-984417]The URL is made up of the host name or IP address of the ASA device and port number, and the alias used to identify the SSL VPN connection profile.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-984422]Note If you do not specify a URL, you can access the portal page by entering the portal page URL, and then selecting the connection profile alias from a list of configured connection profile aliases configured on the device. See SSL VPN Configuration Wizard—Access Page (ASA).


     
      

     

     

 
     [bookmark: pgfId-984430]Step 13 On the Connection Profile page, configure the AAA options for authentication, authorization, and accounting, and secondary authentication, which will later appear on the AAA and Secondary AAA tab of the connection profile (see AAA Tab (Connection Profiles) and Secondary AAA Tab (Connection Profiles)).

 
     [bookmark: pgfId-984432]Step 14 Click Finish to save your changes.

 
     [bookmark: pgfId-984434]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-984446][bookmark: 75637][bookmark: ravpnpg_cncpt_AccessPageASA]SSL VPN Configuration Wizard—Access Page (ASA)[bookmark: marker-984442][bookmark: marker-984444]

 
     [bookmark: pgfId-984451]Use the Access page of the SSL VPN Configuration Wizard to configure the security appliance interfaces for SSL VPN sessions. After you complete the wizard, you can later edit these settings in the SSL VPN Access policy; see SSL VPN Access Policy Page.

 
     [bookmark: pgfId-984453]Navigation Path

 
     [bookmark: pgfId-984458](Device view) Open the Remote Access VPN Configuration Wizard for configuring a remote access SSL VPN on an ASA device (see Using the Remote Access VPN Configuration Wizard). The Access page is the first page that appears.

 
     [bookmark: pgfId-984460]Related Topics

 
      
      		 [bookmark: pgfId-984465]Creating SSL VPNs Using the Remote Access VPN Configuration Wizard (ASA Devices)

 
      		 [bookmark: pgfId-984470]Understanding Interface Role Objects

 
     

 
     [bookmark: pgfId-984472]Field Reference

 
     [bookmark: pgfId-984475] 

 
      
       
        
        [bookmark: pgfId-982002]Table 30-2 [bookmark: 75666]SSL VPN Wizard—Access Page (ASA) 

 
        
       
         
         		
           
           [bookmark: pgfId-982008]Element
          
  
         		
           
           [bookmark: pgfId-982010]Description
          
  
        

 
         
         		[bookmark: pgfId-982016]Interfaces to Enable SSL VPN Service

  
         		[bookmark: pgfId-982018]The interfaces or interface roles that identify the interfaces on which you want to enable SSL VPN connections. Click Select to select interfaces or interface roles, or to create new interface roles.

  
        

 
         
         		[bookmark: pgfId-982024]Port Number

  
         		[bookmark: pgfId-982026]The port number to use for the SSL VPN sessions. Enter a port number or port list object name, or click Select to select an object that defines the port, or to create a new object.

 [bookmark: pgfId-982028]The default port is 443, for HTTPS traffic. The port number can be 443, or within the range of 1024-65535. If you change the port number, all current SSL VPN connections terminate, and current users must reconnect.

 [bookmark: pgfId-982030]Note If HTTP port redirection is enabled, the default HTTP port number is 80.

  
        

 
         
         		[bookmark: pgfId-982036]Portal Page URLs

  
         		[bookmark: pgfId-982038]The URLs that users would use to connect to the VPN. The URLs are displayed after you specify the interfaces and port number.

  
        

 
         
         		[bookmark: pgfId-982044]Allow Users to Select Connection Profile in Portal Page

  
         		[bookmark: pgfId-982046]Whether to present a list of configured connection profiles (tunnel groups) from which the user can select the appropriate profile when the user logs in (for example, in the SSL VPN portal page). If you do not select this option, the user cannot select a profile and must use the default profile for the connection.

  
        

 
         
         		[bookmark: pgfId-982052]Enable AnyConnect Access

  
         		[bookmark: pgfId-982057]Whether to allow the user to use the AnyConnect VPN client to make an SSL or IKEv2 IPSec VPN connection. The option is selected by default. For details about AnyConnect VPN clients, see Understanding SSL VPN AnyConnect Client Settings.

 [bookmark: pgfId-982062]Note To enable AnyConnect Essentials, go to Remote Access VPN > SSL VPN > Access. For details, see Configuring an Access Policy.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-984487][bookmark: 75709][bookmark: ravpnpg_cncpt_ConnectionProfilePageASA]SSL VPN Configuration Wizard—Connection Profile Page (ASA)[bookmark: marker-984483][bookmark: marker-984485]

 
     [bookmark: pgfId-984489]Use the Connection Profile page in the SSL VPN Configuration wizard to configure the tunnel group policies on your security appliance. You can specify a name for the tunnel connection profile policy that you are adding, select the user group policy, specify address pools for this policy, and specify authentication server group settings.

 
     [bookmark: pgfId-984491]Navigation Path

 
     [bookmark: pgfId-984496](Device view) Open the Remote Access VPN Configuration Wizard for configuring a remote access SSL VPN on an ASA device (see Using the Remote Access VPN Configuration Wizard); then click Next until you reach this page.

 
     [bookmark: pgfId-984498]Related Topics

 
      
      		 [bookmark: pgfId-984503]Creating SSL VPNs Using the Remote Access VPN Configuration Wizard (ASA Devices)

 
      		 [bookmark: pgfId-984508]ASA Group Policies Dialog Box

 
      		 [bookmark: pgfId-984513]Configuring ASA Portal Appearance Using SSL VPN Customization Objects

 
      		 [bookmark: pgfId-984518]Understanding Networks/Hosts Objects

 
      		 [bookmark: pgfId-984523]Understanding AAA Server and Server Group Objects

 
     

 
     [bookmark: pgfId-984525]Field Reference

 
     [bookmark: pgfId-984528] 

 
      
       
        
        [bookmark: pgfId-982075]Table 30-3 [bookmark: 75747]SSL VPN Configuration Wizard, Connection Profile Page (ASA) 

 
        
       
         
         		
           
           [bookmark: pgfId-982081]Element
          
  
         		
           
           [bookmark: pgfId-982083]Description
          
  
        

 
         
         		[bookmark: pgfId-982089]Connection Profile Name

  
         		[bookmark: pgfId-982091]The name of the connection profile (tunnel group).

  
        

 
         
         		[bookmark: pgfId-982097]Group Policy

  
         		[bookmark: pgfId-982099]Default ASA user group associated with the device. Enter an ASA user group policy or click Select to select one from a list or to create a new one.

 [bookmark: pgfId-982101]If required, the name of the ASA group policy object that defines the default user group associated with the connection profile. A group policy is a collection of user-oriented attribute/value pairs stored either internally on the device or externally on a RADIUS/LDAP server.

 [bookmark: pgfId-982106]Click Select to select an existing object or to create a new one. If you click the Create (+) button in the group policy selection dialog box, you are guided through the group creation process using a wizard, as explained in Creating User Groups with the Create Group Policy Wizard.

  
        

 
         
         		[bookmark: pgfId-982112]Full Tunnel

  
         		[bookmark: pgfId-982114]A read-only field that indicates whether full tunnel access mode is configured for the object selected in the Group Policy field.

  
        

 
         
         		[bookmark: pgfId-982120]Group Policies

  
         		[bookmark: pgfId-982122]The names of all ASA user group policies that are configured for the device, even those that are configured for IPSec VPN connections only. The contents of this table is identical to the contents of the Remote Access VPN > Group Policies policy. The table shows whether full tunnel access mode is enabled or disabled for each group policy.

 [bookmark: pgfId-982124]You can change the list by clicking Edit. This opens a dialog box where you can select additional group policies, or deselect currently selected policies (do not deselect policies that are used by other connection profiles). You can also create new group policies (click the Create (+) button below the available group policies list) or edit the group policy object by selecting it and clicking the Edit (pencil) button below either list.

 [bookmark: pgfId-982129]If you create a new group policy, the Create Group Policy wizard is used to guide you through the process. See Creating User Groups with the Create Group Policy Wizard.

  
        

 
         
         		[bookmark: pgfId-982135]Portal Page Customization

  
         		[bookmark: pgfId-982137]The name of the SSL VPN Customization policy object that defines the default portal page for the VPN. This profile defines the appearance of the portal page that allows the remote user access to all resources available on the SSL VPN. Click Select to select the object or to create a new object.

  
        

 
         
         		[bookmark: pgfId-982143]Connection URL

  
         		[bookmark: pgfId-982145]The URL of the connection profile. This URL provides users with direct access to the customized portal page.

 [bookmark: pgfId-982147]Select a protocol (http or https) from the list and specify the URL, including host name or IP address of the ASA device and port number and the alias used to identify the SSL VPN connection profile.

 [bookmark: pgfId-982152]Note If you do not specify a URL, you can access the portal page by entering the portal page URL, and then selecting the connection profile alias from a list of configured connection profile aliases configured on the device. See SSL VPN Configuration Wizard—Access Page (ASA).

  
        

 
         
         		[bookmark: pgfId-982158]Global IP Address Pool

  
         		[bookmark: pgfId-982160]The address pools from which IP addresses will be assigned to clients if no pool is specified for the interface to which the client connects. Address pools are entered as a range of addresses, such as 10.100.12.2-10.100.12.254. The server uses these pools in the order listed. If all addresses in the first pool have been assigned, it uses the next pool, and so on. You can specify up to 6 pools.

 [bookmark: pgfId-982162]Enter the address pool ranges or the names of network/host objects that define these pools. Click Select to select existing network/host objects or to create new ones. Separate multiple entries with commas.

  
        

 
         
         		[bookmark: pgfId-982168]Authentication Server Group

  
         		[bookmark: pgfId-982170]The name of the authentication server group (LOCAL if the tunnel group is configured on the local device). Enter the name of a AAA server group object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-982176]Use LOCAL if Server Group Fails

  
         		[bookmark: pgfId-982178]Whether to fall back to the local database for authentication if the selected authentication server group fails.

  
        

 
         
         		[bookmark: pgfId-982184]Authorization Server Group

  
         		[bookmark: pgfId-982186]The name of the authorization server group (LOCAL if the tunnel group is configured on the local device). Enter the name of a AAA server group object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-982192]Accounting Server Group

  
         		[bookmark: pgfId-982194]The name of the accounting server group. Enter the name of a AAA server group object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-982200]Secondary Authentication

  
         		[bookmark: pgfId-982202]Whether to enable double authentication, which prompts the user for two sets of credentials (username and password) before completing the remote access VPN connection.

 
           
           		 [bookmark: pgfId-982204] Enable Secondary Authentication —Select this option to require double authentication.

 
           		 [bookmark: pgfId-982206] Authentication Server Group —The name of the authentication server group (LOCAL if the tunnel group is configured on the local device) to be used with the second set of credentials. Enter the name of a AAA server group object or click  Select to select it from a list or to create a new object.

 
           		 [bookmark: pgfId-982208] Use LOCAL if Server Group Fails —Whether to fall back to the local database for authentication if the selected authentication server group fails.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-984544][bookmark: 75853][bookmark: ravpnch_proc_CreatingUserGroupswiththeCreateGroupPolicyWizard]Creating User Groups with the Create Group Policy Wizard[bookmark: marker-984538][bookmark: marker-984540][bookmark: marker-984542]

 
     [bookmark: pgfId-984546]When you are using the Remote Access SSL VPN Configuration wizard to create an SSL VPN on ASA or IOS devices, you can create new ASA group policy or IOS user group objects using a wizard. The wizard lets you configure select elements of the group, so you might need to edit the object after creating it to configure additional settings.

 
     [bookmark: pgfId-984548]The Create Group Policy wizard is available only through the Remote Access SSL VPN Configuration wizard. For an explanation of how to start and use the wizard, see the following topics:

 
     [bookmark: pgfId-984550]The following procedure assumes that you are already in the Remote Access SSL VPN Configuration wizard, as described in the following topics:

 
      
      		 [bookmark: pgfId-984555]Creating SSL VPNs Using the Remote Access VPN Configuration Wizard (ASA Devices)

 
      		 [bookmark: pgfId-984560]Creating SSL VPNs Using the Remote Access VPN Configuration Wizard (IOS Devices)

 
     

 
     [bookmark: pgfId-984562]Related Topics

 
      
      		 [bookmark: pgfId-984567]SSL VPN Access Modes

 
     

 
     
 
     [bookmark: pgfId-984569]Step 1 When using the Remote Access VPN Configuration wizard for SSL VPNs, proceed to the page where you select group policies. On this page, you can open the selection page for user groups by doing the following:

 
      
      		 [bookmark: pgfId-984571]ASA devices—On the Connection Profile page of the wizard, click  Select next to the Group Policy field, or click  Edit next to the Group Policies table.

 
      		 [bookmark: pgfId-984573]IOS devices—On the Gateway and Context page of the wizard, click  Edit next to the Group Policies table.

 
     

 
     [bookmark: pgfId-984575]Step 2 In the Group Policy Selector dialog box, click the Create (+) button below the list of available group policies to start the Create Group Policy wizard. The wizard starts at the Group Policy page.

 
     [bookmark: pgfId-984577]You can also do the following on the Group Policy Selector:

 
      
      		 [bookmark: pgfId-984579]Select existing groups and click >> to use them in the SSL VPN. When selecting a group for the default group on an ASA (the Group Policy field), you select the object simply by clicking it in the list.

 
      		 [bookmark: pgfId-984581]Select an existing group and click  Edit (pencil) to change its properties.

 
     

 
     [bookmark: pgfId-984583]Step 3 On the Group Policy page, configure the following options:

 
      
      		 [bookmark: pgfId-984585] Name —The name of the user group. Enter up to 128 characters, including uppercase and lowercase characters and most alphanumeric or symbol characters.

 
      		 [bookmark: pgfId-984587] Access Method —Select the required remote access method options, as follows:

 
     

 
     [bookmark: pgfId-984589] – Full Tunnel—To access to the corporate network completely over an SSL VPN tunnel. This is the recommended option.

 
     [bookmark: pgfId-984591] – Clientless—To access the internal or corporate network using a web browser on the client machine.

 
     [bookmark: pgfId-984593] – Thin Client—To download a Java applet that acts as a TCP proxy on the client machine.

 
     [bookmark: pgfId-984595]Step 4 Click Next. The page that opens next depends on which access methods you selected. This procedure assumes that you selected all methods, in which case the Full Client page opens.

 
     [bookmark: pgfId-984600]Step 5 On the Full Client page, select whether to restrict access to full tunnel only or to allow other methods of access if the full client download fails. Also, specify DNS and WINS server information, and configure split tunneling if you want to allow it. For an explanation of the options, see Create Group Policy Wizard—Full Tunnel Page.

 
     [bookmark: pgfId-984602]Step 6 Click Next. The Clientless and Thin Client page opens.

 
     [bookmark: pgfId-984607]Step 7 On the Clientless and Thin Client page, configure these access modes. For an explanation of the options, see Create Group Policy Wizard—Clientless and Thin Client Access Modes Page.

 
     [bookmark: pgfId-984609]Step 8 Click Finish to create the group policy object.

 
     [bookmark: pgfId-984611]Step 9 When you complete the wizard, the group policy is added to the available groups list, but it is not selected (unless you are configuring the default group for an ASA). To select it, highlight it in the available groups list and click >> to move it to the selected groups list.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-984613]Note To specify a user group as the default user group, select it and click Set As Default. This option is only available for IOS routers.


     
      

     

     

 
     [bookmark: pgfId-984615]Step 10 Click OK in the Group Policy Selector page to save your changes and return to the Remote Access SSL VPN Configuration wizard.

 
     [bookmark: pgfId-984617]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-984627][bookmark: 75950][bookmark: ravpnpg_cncpt_FullTunnelAccessModePage]Create Group Policy Wizard—Full Tunnel Page[bookmark: marker-984625]

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-984629]Note This page is available only if you selected the Full Client option in the Group Policy of the Create Group Policy wizard.


     
      

     

     

 
     [bookmark: pgfId-984631]In this page, you can configure the mode used to access the corporate network.

 
     [bookmark: pgfId-984633]Navigation Path

 
     [bookmark: pgfId-984638]For information on starting the Create Group Policy wizard, see Creating User Groups with the Create Group Policy Wizard.

 
     [bookmark: pgfId-984640]Field Reference

 
     [bookmark: pgfId-984643] 

 
      
       
        
        [bookmark: pgfId-982221]Table 30-4 [bookmark: 75967]Create User Group Wizard—Full Tunnel Page 

 
        
       
         
         		
           
           [bookmark: pgfId-982227]Element
          
  
         		
           
           [bookmark: pgfId-982229]Description
          
  
        

 
         
         		[bookmark: pgfId-982235]Mode

  
         		[bookmark: pgfId-982237]The access modes to allow in the SSL VPN. Select one of the following:

 
           
           		 [bookmark: pgfId-982239] Use Other Access Modes if SSL VPN Client Download Fails —To allow the remote client to use clientless or thin client access modes if the download of the VPN client fails.

 
           		 [bookmark: pgfId-982241] Full Tunnel Only —Prohibit clientless or thin client access. The user must have the full client installed and functional to connect to the VPN.

 
          

 [bookmark: pgfId-982249]Ensure that you configure the full client images on the device. For ASA devices, use the Client Settings tab of the SSL VPN > Other Settings policy; see Configuring SSL VPN AnyConnect Client Settings (ASA). For IOS devices, the client is managed using a FlexConfig policy; see Predefined FlexConfig Policy Objects.

  
        

 
         
         		[bookmark: pgfId-982255]Client IP Address Pools

 [bookmark: pgfId-982257](IOS device only.)

  
         		[bookmark: pgfId-982259]The IP address ranges of the address pool that full tunnel clients will draw from when they log on. The address pool must be in the same subnet as one of the device’s interface IP addresses.

 [bookmark: pgfId-982261]Enter the address range separating the first and last IP address with a hyphen, for example, 10.100.10.2-10.100.10.255. If you enter a single address, the pool has just one address. Do not enter subnet designations.

 [bookmark: pgfId-982263]You can also enter the name of a network/host policy object that defines the range, or click Select to select the object from a list or to create a new object. Separate multiple ranges with commas.

  
        

 
         
         		[bookmark: pgfId-982269]Primary DNS Server

  
         		[bookmark: pgfId-982271]The IP address of the primary DNS server for the group. Enter the IP address or the name of a network/host object, or click Select to select an object from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-982277]Secondary DNS Server

  
         		[bookmark: pgfId-982279]The IP address of the secondary DNS server for the group. Enter the IP address or the name of a network/host object, or click Select to select an object from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-982285]Default DNS Domain

  
         		[bookmark: pgfId-982287]The domain name of the DNS server to be used for Full Client SSL VPN connections.

  
        

 
         
         		[bookmark: pgfId-982293]Primary WINS Server

  
         		[bookmark: pgfId-982295]The IP address of the primary WINS server for the group. Enter the IP address or the name of a network/host object, or click Select to select an object from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-982301]Secondary WINS Server

  
         		[bookmark: pgfId-982303]The IP address of the primary WINS server for the group. Enter the IP address or the name of a network/host object, or click Select to select an object from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-982309]Split Tunnel Option

  
         		[bookmark: pgfId-982311]Whether to allow split tunneling and if so, which traffic should be secured or transmitted unencrypted across the public network:

 
           
           		 [bookmark: pgfId-982313]Disabled—(Default) No traffic goes in the clear or to any other destination than the gateway. Remote users reach networks through the corporate network and do not have access to local networks.

 
           		 [bookmark: pgfId-982315]Tunnel Specified Traffic—Tunnel all traffic from or to the addresses listed in the  Networks or  Destinations field. Traffic to all other addresses travels in the clear and is routed by the remote user’s Internet service provider.

 
           		 [bookmark: pgfId-982317]Exclude Specified Traffic—Traffic goes in the clear from and to the addresses listed in the  Networks or  Destinations field. This is useful for remote users who want to access devices on their local network, such as printers, while they are connected to the corporate network through a tunnel.

 
          

  
        

 
         
         		[bookmark: pgfId-982323]Networks

 [bookmark: pgfId-982325](ASA device only.)

  
         		[bookmark: pgfId-982327]If you select Tunnel Specified Traffic or Exclude Specified traffic in the Split Tunnel Option, enter the name of the ACL object that defines the traffic to be tunneled or excluded. Click Select to select the object or to create a new object.

  
        

 
         
         		[bookmark: pgfId-982333]Destinations

 [bookmark: pgfId-982335](IOS device only.)

  
         		[bookmark: pgfId-982337]If you select Tunnel Specified Traffic or Exclude Specified traffic in the Split Tunnel Option, specify the IP addresses that define the traffic to be tunneled or excluded.

 [bookmark: pgfId-982339]Enter network addresses such as 10.100.10.0/24 or host addresses such as 10.100.10.12. You can also enter the name of a network/host policy object, or click Select to select the object from a list or to create a new object. Separate multiple addresses with commas.

  
        

 
         
         		[bookmark: pgfId-982345]Exclude Local LANs

 [bookmark: pgfId-982347](IOS device only.)

  
         		[bookmark: pgfId-982349]Whether to exclude local LANs from the encrypted tunnel. This option is available only if you selected the Exclude Specified Traffic split tunnel option. By selecting this option, you do not have to enter local LAN addresses into the destinations field to allow users to communicate with systems (such as printers) that are attached to their LAN.

 [bookmark: pgfId-982351]When selected, this attribute disallows a non split-tunneling connection to access the local subnetwork at the same time as the client.

  
        

 
         
         		[bookmark: pgfId-982357]Split DNS Names

  
         		[bookmark: pgfId-982359]A list of domain names to be resolved through the split tunnel to the private network. All other names are resolved using the public DNS server.

 [bookmark: pgfId-982361]Enter up to 10 entries in the list of domains, separated by commas. The entire string can be no longer than 255 characters.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-984653][bookmark: 76076][bookmark: ravpnpg_cncpt_ClientlessandThinClientAccessModesPage]Create Group Policy Wizard—Clientless and Thin Client Access Modes Page[bookmark: marker-984651]

 
     [bookmark: pgfId-984655]In the Clientless and Thin Client page of the Create Group Policy wizard, you can configure the Clientless and Thin Client modes to be used for accessing the corporate network in your SSL VPN.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-984657]Note This page is only available if you selected the Clientless or Thin Client options in step 1 of the Create Group Policy wizard.


     
      

     

     

 
     [bookmark: pgfId-984659]Navigation Path

 
     [bookmark: pgfId-984664]For information on starting the Create Group Policy wizard, see Creating User Groups with the Create Group Policy Wizard.

 
     [bookmark: pgfId-984666]Related Topics

 
      
      		 [bookmark: pgfId-984671]SSL VPN Access Modes

 
      		 [bookmark: pgfId-984676]Configuring SSL VPN Bookmark Lists for ASA and IOS Devices

 
      		 [bookmark: pgfId-984681]Add or Edit Port Forwarding List Dialog Boxes

 
     

 
     [bookmark: pgfId-984683]Field Reference

 
     [bookmark: pgfId-984686] 

 
      
       
        
        [bookmark: pgfId-982374]Table 30-5 [bookmark: 76106]Create User Group Wizard—Clientless and Thin Client Page 

 
        
       
         
         		
           
           [bookmark: pgfId-982380]Element
          
  
         		
           
           [bookmark: pgfId-982382]Description
          
  
        

 
         
         		 [bookmark: pgfId-982388]Clientless—Appears only if you selected Clientless in step 1 of the wizard.

  
        

 
         
         		[bookmark: pgfId-982396]Portal Page Websites

  
         		[bookmark: pgfId-982398]The name of the SSL VPN bookmarks policy object that includes the web site URLs to display on the portal page. These web sites help users access desired resources. Enter the name of the object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-982404]Allow Users to Enter Websites

  
         		[bookmark: pgfId-982406]Whether to allow the remote user to enter web site URLs directly into the browser. If you do not select this option, the user can access only those URLs included on the portal.

  
        

 
         
         		 [bookmark: pgfId-982412]Thin Client—Appears only if you selected Thin Client in step 1 of the wizard.

  
        

 
         
         		[bookmark: pgfId-982420]Port Forwarding List

  
         		[bookmark: pgfId-982422]The name of the port forwarding list policy object assigned to this group. Port forwarding lists contain the set of applications that users of clientless SSL VPN sessions can access over forwarded TCP ports. Enter the name of the object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-982428]Port Forwarding Applet Name

 [bookmark: pgfId-982430](ASA device only.)

  
         		[bookmark: pgfId-982432]The application name or short description to display on the Port Forwarding Java applet screen on the portal, up to 64 characters. This is the name of the applet users will download to act as a TCP proxy on the client machine for the services configured on the SSL VPN gateway.

  
        

 
         
         		[bookmark: pgfId-982438]Download Port Forwarding Applet on Client Login

  
         		[bookmark: pgfId-982440]Whether the port forwarding Java applet should be automatically downloaded to the client when a user logs into the SSL VPN. If you do not automatically download the applet, users must download it manually after login.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-984704][bookmark: 76158][bookmark: ravpnch_proc_CreatingIPSecVPNsUsingtheRemoteAccessVPNConfigurationWizard_ASA]Creating IPSec VPNs Using the Remote Access VPN Configuration Wizard (ASA and PIX 7.0+ Devices)[bookmark: marker-984692][bookmark: marker-984694][bookmark: marker-984696][bookmark: marker-984698][bookmark: marker-984700][bookmark: marker-984702]

 
     [bookmark: pgfId-984706]This procedure describes how to create IPSec VPNs on ASA or PIX 7.0+ devices using the Remote Access VPN Configuration Wizard.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-984711]Tip The wizard allows you to select shared policies to use in the VPN on the Defaults page (the final step of the wizard). If you want to use this feature, you must first ensure that all required shared policies are configured and submitted to the database. For information on configuring shared policies and VPN policy defaults, see Understanding and Configuring VPN Default Policies.


     
      

     

     

 
     [bookmark: pgfId-984713]Related Topics

 
      
      		 [bookmark: pgfId-984718]Understanding Remote Access IPSec VPNs

 
      		 [bookmark: pgfId-984723]Understanding Devices Supported by Each Remote Access VPN Technology

 
     

 
     
 
     [bookmark: pgfId-984725]Step 1 In Device view, select the desired ASA or PIX 7.0+ device.

 
     [bookmark: pgfId-984727]Step 2 From the Policy selector, select Remote Access VPN > Configuration Wizard.

 
     [bookmark: pgfId-984729]Step 3 Select the Remote Access IPSec VPN radio button.

 
     [bookmark: pgfId-984734]Step 4 Click Remote Access Configuration Wizard. The Connection Profile page opens. For a description of the options that appear on this page, see Remote Access VPN Configuration Wizard—IPSec VPN Connection Profile Page (ASA).

 
     [bookmark: pgfId-984736]Step 5 On the Connection Profile page, configure these basic options:

 
      
      		 [bookmark: pgfId-984741] Connection Profile name —Enter the name of the connection profile. This is the name of the tunnel group, and will appear in the Remote Access VPN > Connection Profiles policy. For more information about the connection profile policy, see Configuring Connection Profiles (ASA, PIX 7.0+).

 
      		 [bookmark: pgfId-984743] IKE Versions —Select the IKE versions to use during IKE negotiations between the VPN server and the remote users, version 1, 2 or both. IKEv2 is supported on ASA Software release 8.4(1)+ only.

 
     

 
     [bookmark: pgfId-984748]Step 6 On the Connection Profile page, configure these options that will later appear in the General tab of the connection profile (see General Tab (Connection Profiles)):

 
      
      		 [bookmark: pgfId-984750] Group Policy —Enter the name of the ASA Group Policy policy object that will be the default group for the connection profile, or click  Select to select the object. If the required object does not yet exist, click  Select , then click the  Create (+) button in the ASA User Groups Selector dialog box to open the dialog boxes that are used to create these objects.

 
     

 
     [bookmark: pgfId-984752]When creating a new group policy object, you must select the same IKE versions that you select in the Connection Profile page of the wizard. These options are on the Technology page of the Add ASA Group Policies dialog box: Easy VPN/IPSec IKEv1 and Easy VPN/IPSec IKEv2.

 
     [bookmark: pgfId-984757]For more information about ASA Group Policies objects, see ASA Group Policies Dialog Box.

 
      
      		 [bookmark: pgfId-984759] Global IP Address Pool —Enter the address pools from which IP addresses are assigned. The server uses these address pools in the order listed. If all addresses in the first pool have been assigned, it uses the next pool, and so on. You can specify up to 6 pools.

 
     

 
     [bookmark: pgfId-984761]Specify the pools as address ranges or network/host objects that contain address ranges, in the format Start_Address-End_Address, for example, 10.100.10.2-10.100.10.254. Click Select to select network/host objects or to create new objects.

 
     [bookmark: pgfId-984766]Step 7 On the Connection Profile page, configure the AAA options for authentication, authorization, and accounting, which will later appear on the AAA tab of the connection profile (see AAA Tab (Connection Profiles)).

 
     [bookmark: pgfId-984768]Step 8 Click Next to move to the IPsec Settings page.

 
     [bookmark: pgfId-984773]Step 9 On the IPSec Settings page, configure the options for IPSec, which will later appear on the IPSec tab of the connection profile (see IPSec Tab (Connection Profiles)). Note that some of these settings apply to IKEv1 only.

 
      
      		 [bookmark: pgfId-984775] Preshared Key ,  Confirm —Enter the IKEv1 preshared key for the tunnel group in each field. The maximum length of a preshared key is 127 characters.

 
     

 
     [bookmark: pgfId-984777]You cannot configure a preshared key for remote access IKEv2 IPsec VPNs.

 
      
      		 [bookmark: pgfId-984779] Trustpoint Name —Enter the name of the PKI enrollment policy object that defines the trustpoint name, if any trustpoints are configured, for an IKEv1 connection. A trustpoint represents a Certificate Authority (CA)/identity pair and contains the identity of the CA, CA-specific configuration parameters, and an association with one enrolled identity certificate. Click  Select to select the object from a list or to create a new object.

 
     

 
     [bookmark: pgfId-984781]For IKEv2, the trustpoint name is not configured here, but on the IKEv2 Settings tab of the Global Settings policy. The configuration is explained later in this procedure.

 
      
      		 [bookmark: pgfId-984786]The other options (other than the client table) apply to both IKEv1 and IKEv2. Change the settings if you need non-default behavior. For an explanation of the options, including the client software update table, see Remote Access VPN Configuration Wizard—IPSec Settings Page (ASA).

 
     

 
     [bookmark: pgfId-984788]Step 10 Click Next to move to the VPN Defaults page.

 
     [bookmark: pgfId-984790]Step 11 On the Defaults page, select the additional shared policies that you want to assign to the VPN. Initially, the policies listed are those chosen on the Security Manager Administration VPN Defaults page.

 
     [bookmark: pgfId-984795]For more information about selecting these policies, see Remote Access VPN Configuration Wizard—Defaults Page.

 
     [bookmark: pgfId-984797]Step 12 Click Finish to save your changes.

 
     [bookmark: pgfId-984799]Because the wizard does not configure all possible options, inspect the policies created and configure any additional options that you want to implement.

 
     [bookmark: pgfId-984801]The remaining steps are required if you selected IKE version 2 as a supported IKE version, or if you specified an IPsec trustpoint.

 
     [bookmark: pgfId-984803]Step 13 (IKEv2 Optional.) Configure group aliases and double authentication if required:

 
     [bookmark: pgfId-984805] a. Select the Connection Profiles policy.

 
     [bookmark: pgfId-984807] b. Select the connection profile you configured in the wizard, and click the Edit Row (pencil) button to open the Connection Profiles dialog box.

 
      
      		 [bookmark: pgfId-984812]If you want to configure double authentication, select the Secondary AAA tab and configure the required settings. For more information, see Secondary AAA Tab (Connection Profiles).

 
      		 [bookmark: pgfId-984817]If you want to configure aliases for the profile, which helps users select the correct profile during login, select the SSL tab and configure the alias table. For more information, see SSL Tab (Connection Profiles).

 
      		 [bookmark: pgfId-984819]There are several additional connection profile settings that are not configured in the wizard. Examine the tabs in the Connection Profile dialog box to determine if additional changes are required.

 
     

 
     [bookmark: pgfId-984821] c. Click OK in the Connection Profiles dialog box to save your changes.

 
     [bookmark: pgfId-984826]Step 14 (IKEv2 Requirement.) Select the Remote Access VPN > SSL VPN > Access policy and configure at least the following. For detailed information about configuring an Access policy, see Understanding SSL VPN Access Policies (ASA).

 
      
      		 [bookmark: pgfId-984828]Add the remote access VPN interface to the access interfaces table.

 
      		 [bookmark: pgfId-984830]Select  Allow Users to Select Connection Profile in Portal Page .

 
      		 [bookmark: pgfId-984832]Select  Enable AnyConnect Access .

 
     

 
     [bookmark: pgfId-984834]Step 15 (IKEv2 Requirement.) Select the Remote Access VPN > SSL VPN > Other Settings policy, and click the Client Settings tab.

 
     [bookmark: pgfId-984836]In the AnyConnect Client Image table, add an AnyConnect 3.0 or higher client image, one that supports IKEv2 negotiations.

 
     [bookmark: pgfId-984841]For more information on configuring client images, see Configuring SSL VPN AnyConnect Client Settings (ASA).

 
     [bookmark: pgfId-984843]Step 16 (IKEv2 Requirement.) Select the Remote Access VPN > Global Settings policy, and click the IKEv2 Settings tab.

 
     [bookmark: pgfId-984845]At minimum, configure the RA Trustpoint for remote access IKEv2 authentication. Enter the name of the PKI enrollment object that identifies the certificate authority (CA) server or click Select to select the object or to create a new one.

 
     [bookmark: pgfId-984850]For more information on configuring IKEv2 global settings, see Configuring VPN Global IKEv2 Settings.

 
     [bookmark: pgfId-984852]Step 17 (IKEv1, IKEv2 Requirement.) Select the Remote Access VPN > Public Key Infrastructure policy and ensure that the following PKI enrollment objects are selected:

 
      
      		 [bookmark: pgfId-984854](IKEv1) The object specified on the IPSec tab of the connection profile, if a trustpoint is configured.

 
      		 [bookmark: pgfId-984856](IKEv2) The object specified on the IKEv2 Settings tab of the Global Settings policy.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-984858]Note In the wizard, you might have applied a shared Public Key Infrastructure policy that already specifies these objects.


     
      

     

     

 
     [bookmark: pgfId-984860]Step 18 (IKEv2 Optional.) IKEv2 connections require the use of the AnyConnect 3.0+ client. The AnyConnect client might need to download files, such as software upgrades, profiles, localization and customization files, CSD, SCEP, and so forth. The wizard does not enable these types of download.

 
     [bookmark: pgfId-984862]To enable AnyConnect file downloads:

 
     [bookmark: pgfId-984864] a. Select Remote Access VPN > IPSec VPN > IPSec Proposal.

 
     [bookmark: pgfId-984869] b. Select the IPSec proposal created by the wizard, and click Edit Row (pencil) to open the IPSec Proposal Editor. For information about the various options, see IPsec Proposal Editor (ASA, PIX 7.0+ Devices).

 
     [bookmark: pgfId-984871] c. Select the Enable Client Services option, and enter a port number if you do not want to use the default port 443. (You can use the same port number used for SSL VPN or other SSL uses.)

 
     [bookmark: pgfId-984873] d. Click OK to save your changes.

 
     [bookmark: pgfId-984875]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-984885][bookmark: 76349][bookmark: ravpnpg_cncpt_ConnectionProfilePageIPSecASA]Remote Access VPN Configuration Wizard—IPSec VPN Connection Profile Page (ASA)[bookmark: marker-984883]

 
     [bookmark: pgfId-984887]Use the Connection Profile page of the Remote Access VPN Configuration wizard to configure the connection profile policies on your security appliance for a remote access IPSec VPN. You can specify a name for the connection profile policy that you are adding, select the IKE versions to allow during IKE negotiations, select the user group policy, specify address pools for this policy, and specify authentication, authorization, and accounting server group settings.

 
     [bookmark: pgfId-984892]For more information about using the wizard to configure remote access IPsec VPNs on ASA, see Creating IPSec VPNs Using the Remote Access VPN Configuration Wizard (ASA and PIX 7.0+ Devices).

 
     [bookmark: pgfId-984894]Navigation Path

 
     [bookmark: pgfId-984899](Device view) Open the Remote Access VPN Configuration Wizard for configuring a remote access IPsec VPN on an ASA or PIX 7.0+ device (see Using the Remote Access VPN Configuration Wizard). The IPSec Connection Profile page is the first page that appears.

 
     [bookmark: pgfId-984901]Field Reference

 
     [bookmark: pgfId-984904] 

 
      
       
        
        [bookmark: pgfId-982453]Table 30-6 [bookmark: 76367]Remote Access VPN Configuration Wizard, IPSec Connection Profile Page (ASA) 

 
        
       
         
         		
           
           [bookmark: pgfId-982459]Element
          
  
         		
           
           [bookmark: pgfId-982461]Description
          
  
        

 
         
         		[bookmark: pgfId-982467]Connection Profile Name

  
         		[bookmark: pgfId-982469]The name of the connection profile (tunnel group).

  
        

 
         
         		[bookmark: pgfId-982475]IKE Versions

  
         		[bookmark: pgfId-982477]The IKE versions to use during IKE negotiations between the VPN server and the remote users. IKEv2 is supported on ASA Software release 8.4(1)+ only; you cannot change the option selection on other types of device.

 [bookmark: pgfId-982479]Select IKE Version 1, IKE Version 2, or Both (to allow either version). IKEv2 connections are allowed using Anyconnect clients only.

  
        

 
         
         		[bookmark: pgfId-982485]Group Policy

  
         		[bookmark: pgfId-982487]If required, the name of the ASA group policy object that defines the default user group associated with the connection profile. A group policy is a collection of user-oriented attribute/value pairs stored either internally on the device or externally on a RADIUS/LDAP server.

 [bookmark: pgfId-982489]Click Select to select an existing object or to create a new one.

 [bookmark: pgfId-982494]Tip If you enable IKEv2 for this VPN, there are special considerations for the group policy you choose. For detailed information, see Creating IPSec VPNs Using the Remote Access VPN Configuration Wizard (ASA and PIX 7.0+ Devices).  
        

 
         
         		[bookmark: pgfId-982500]Global IP Address Pool

  
         		[bookmark: pgfId-982502]The address pools from which IP addresses will be assigned to clients if no pool is specified for the interface to which the client connects. Address pools are entered as a range of addresses, such as 10.100.12.2-10.100.12.254. The server uses these pools in the order listed. If all addresses in the first pool have been assigned, it uses the next pool, and so on. You can specify up to 6 pools.

 [bookmark: pgfId-982504]Enter the address pool ranges or the names of network/host objects that define these pools. Click Select to select existing network/host objects or to create new ones. Separate multiple entries with commas.

  
        

 
         
         		[bookmark: pgfId-982510]Authentication Server Group

  
         		[bookmark: pgfId-982512]The name of the authentication server group (LOCAL if the tunnel group is configured on the local device). Enter the name of a AAA server group object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-982518]Use LOCAL if Server Group Fails

  
         		[bookmark: pgfId-982520]Whether to fall back to the local database for authentication if the selected authentication server group fails.

  
        

 
         
         		[bookmark: pgfId-982526]Authorization Server Group

  
         		[bookmark: pgfId-982528]The name of the authorization server group (LOCAL if the tunnel group is configured on the local device). Enter the name of a AAA server group object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-982534]Accounting Server Group

  
         		[bookmark: pgfId-982536]The name of the accounting server group. Enter the name of a AAA server group object or click Select to select it from a list or to create a new object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-984914][bookmark: 76431][bookmark: ravpnpg_cncpt_IPSecSettingsPageIPSecASA]Remote Access VPN Configuration Wizard—IPSec Settings Page (ASA)[bookmark: marker-984912]

 
     [bookmark: pgfId-984916]Use the IPSec Settings page of the Remote Access VPN Configuration wizard to configure the IPSec settings on your security appliance for a remote access IPSec VPN. Some of these settings apply to IKE version 1 (IKEv1) only; if you are configuring an IKEv2-only VPN, these fields are greyed and unconfigurable.

 
     [bookmark: pgfId-984921]For more information about using the wizard to configure remote access IPsec VPNs on ASA, see Creating IPSec VPNs Using the Remote Access VPN Configuration Wizard (ASA and PIX 7.0+ Devices).

 
     [bookmark: pgfId-984923]Navigation Path

 
     [bookmark: pgfId-984928](Device view) Open the Remote Access VPN Configuration Wizard for configuring a remote access IPsec VPN on an ASA or PIX 7.0+ device (see Using the Remote Access VPN Configuration Wizard); then click Next until you reach this page.

 
     [bookmark: pgfId-984930]Field Reference

 
     [bookmark: pgfId-984933] 

 
      
       
        
        [bookmark: pgfId-982549]Table 30-7 [bookmark: 76450]Remote Access VPN Configuration Wizard, IPSec VPN Wizard—IPSec Settings (ASA) 

 
        
       
         
         		
           
           [bookmark: pgfId-982555]Element
          
  
         		
           
           [bookmark: pgfId-982557]Description
          
  
        

 
         
         		[bookmark: pgfId-982563]Preshared Key

 [bookmark: pgfId-982565](IKEv1 only.)

  
         		[bookmark: pgfId-982567]The preshared key for the connection profile. The maximum length of a preshared key is 127 characters. Enter the key again in the Confirm field.

 [bookmark: pgfId-982569]Tip You cannot configure preshared keys for IKEv2 remote access VPNs.  
        

 
         
         		[bookmark: pgfId-982575]Trustpoint Name

 [bookmark: pgfId-982577](IKEv1 only.)

  
         		[bookmark: pgfId-982579]The name of the PKI enrollment policy object that defines the trustpoint name if any trustpoints are configured for IKEv1 connections. A trustpoint represents a Certificate Authority (CA)/identity pair and contains the identity of the CA, CA-specific configuration parameters, and an association with one enrolled identity certificate.

 [bookmark: pgfId-982581]Click Select to select the object from a list or to create a new object.

 [bookmark: pgfId-982586]Tip This trustpoint is used for IKEv1 negotiations only. To configure the global trustpoint for IKEv2 negotiations, use the IKEv2 Settings tab of the Global Settings policy; see Configuring VPN Global IKEv2 Settings.  
        

 
         
         		[bookmark: pgfId-982592]IKE Peer ID Validation

  
         		[bookmark: pgfId-982594]Select whether IKE peer ID validation is ignored (Do not check), required, or checked only if supported by a certificate. During IKE negotiations, peers must identify themselves to one another.

  
        

 
         
         		[bookmark: pgfId-982600]Enable Sending Certificate Chain

  
         		[bookmark: pgfId-982602]Whether to enable the sending of the certificate chain for authorization. A certificate chain includes the root CA certificate, identity certificate, and key pair.

  
        

 
         
         		[bookmark: pgfId-982608]Enable Password Update with RADIUS Authentication

  
         		[bookmark: pgfId-982610]When selected, enables passwords to be updated with the RADIUS authentication protocol.

 [bookmark: pgfId-982615]Whether to enable passwords to be updated with the RADIUS authentication protocol. For more information, see Supported AAA Server Types.

  
        

 
         
         		[bookmark: pgfId-982621]ISAKMP Keepalive

  
         		[bookmark: pgfId-982623]Whether to monitor ISAKMP keepalive. If you select the Monitor Keepalive option, you can configure IKE keepalive as the default failover and routing mechanism. Enter the following parameters:

 
           
           		 [bookmark: pgfId-982625] Confidence Interval —The number of seconds that a device waits between sending IKE keepalive packets.

 
           		 [bookmark: pgfId-982627] Retry Interval —The number of seconds a device waits between attempts to establish an IKE connection with the remote peer. The default is 2 seconds.

 
          

 [bookmark: pgfId-982632]For more information, see Configuring VPN Global ISAKMP/IPsec Settings.

  
        

 
         
         		[bookmark: pgfId-982638]Client Software Update table

 [bookmark: pgfId-982640](IKEv1 only.)

  
         		[bookmark: pgfId-982642]The VPN client revision level and URLs for client platforms. You can configure different revision levels for All Windows Platforms, Windows 95/98/ME, Windows NT4.0/2000/XP, or the VPN3002 Hardware Client.

 [bookmark: pgfId-982647]To configure the client for a platform, select it, click the Edit Row button, and fill in the IPSec Client Software Update Dialog Box.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-984945][bookmark: 76519][bookmark: ravpnpg_cncpt_DefaultsPageIPSecASA]Remote Access VPN Configuration Wizard—Defaults Page [bookmark: marker-984943]

 
     [bookmark: pgfId-984950]Use the Defaults page of the Remote Access VPN Configuration wizard to select the shared policies to assign to the remote access IPSec VPN. Initially, the policies selected are those configured in the Security Manager Administration VPN Defaults for remote access VPNs. For information on how to configure these defaults, see Understanding and Configuring VPN Default Policies.

 
     [bookmark: pgfId-984952]Required policies must always have a policy selected. If “Factory Default” is shown, then the policy applied is not a shared policy but default policy settings supplied by Security Manager. If you can select the empty option, the policy is optional and you need to configure it only if you want the associated features.

 
     [bookmark: pgfId-984954]When evaluating which policies to assign (if any), keep the following in mind:

 
      
      		 [bookmark: pgfId-984956]The drop-down lists for each policy type list the existing shared policies that you can select. You can select only shared policies that have been committed to the Security Manager database (and approved, if you are using Workflow mode with an approver). You cannot create a shared policy and use it before you submit it.

 
      		 [bookmark: pgfId-984958]To view the content of a policy, select it and click the  View Content button. You are presented with a read-only view of the policy. Use this to help verify that you are selecting the desired policy.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-984963]Note If you try to select a default policy that is currently locked by another user, a message is displayed warning you of a lock problem. To bypass the lock, select a different policy or cancel the VPN creation until the lock is removed. For more information, see Understanding Policy Locking.


     
      

     

     

 
     [bookmark: pgfId-984965]Navigation Path

 
     [bookmark: pgfId-984970](Device view) Open the Remote Access VPN Configuration Wizard for configuring a remote access IPsec VPN (see Using the Remote Access VPN Configuration Wizard) and click Next until you reach this page.

 
     [bookmark: pgfId-984972]Related Topics

 
      
      		 [bookmark: pgfId-984977]Creating IPSec VPNs Using the Remote Access VPN Configuration Wizard (ASA and PIX 7.0+ Devices)

 
      		 [bookmark: pgfId-984982]Creating IPSec VPNs Using the Remote Access VPN Configuration Wizard (IOS and PIX 6.3 Devices)

 
      		 [bookmark: pgfId-984987]Overview of Remote Access VPN Policies

 
     

 
     [bookmark: pgfId-984989]Field Reference

 
     [bookmark: pgfId-984992] 

 
      
       
        
        [bookmark: pgfId-982660]Table 30-8 [bookmark: 76560]Remote Access VPN Configuration Wizard, Defaults Page 

 
        
       
         
         		
           
           [bookmark: pgfId-982666]Element
          
  
         		
           
           [bookmark: pgfId-982668]Description
          
  
        

 
         
         		[bookmark: pgfId-982674]ASA Cluster Load Balance

  
         		[bookmark: pgfId-982676]Defines load balancing for an ASA device in your remote access VPN.

  
        

 
         
         		[bookmark: pgfId-982682]High Availability

  
         		[bookmark: pgfId-982684]Defines a High Availability (HA) policy on a Cisco IOS router in a remote access VPN.

  
        

 
         
         		[bookmark: pgfId-982690]Certificate to Connection Profile Map Policy

  
         		[bookmark: pgfId-982692](IKEv1 only.) Defines the certificate to connection profile map options for an ASA device in your remote access VPN.

  
        

 
         
         		[bookmark: pgfId-982698]IKE Proposal

  
         		[bookmark: pgfId-982700]Defines the set of algorithms that two peers use to secure the IKE negotiation between them.

  
        

 
         
         		[bookmark: pgfId-982706]IPSec Proposal

  
         		[bookmark: pgfId-982708]Defines the crypto maps required to set up IPsec security associations (SAs), including IPsec rules, transform sets, remote peers, and other parameters that might be necessary to define an IPsec SA.

  
        

 
         
         		[bookmark: pgfId-982714]Public Key Infrastructure

  
         		[bookmark: pgfId-982716]Defines the Public Key Infrastructure (PKI) policy used to generate PKI enrollment requests for PKI certificates and RSA keys.

  
        

 
         
         		[bookmark: pgfId-982722]VPN Global Settings

  
         		[bookmark: pgfId-982724]Defines global settings for IKE, IPsec, IKEv2, NAT, and fragmentation that apply to devices in your remote access VPN.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-985010][bookmark: 76607][bookmark: ravpnch_proc_CreatingSSLVPNsUsingtheRemoteAccessVPNConfigurationWizard_IOS]Creating SSL VPNs Using the Remote Access VPN Configuration Wizard (IOS Devices)[bookmark: marker-984998][bookmark: marker-985000][bookmark: marker-985002][bookmark: marker-985004][bookmark: marker-985006][bookmark: marker-985008]

 
     [bookmark: pgfId-985012]This procedure describes how to create or edit SSL VPNs on IOS devices using the Remote Access SSL VPN Configuration Wizard.

 
     [bookmark: pgfId-985014]Related Topics

 
      
      		 [bookmark: pgfId-985019]Understanding Remote Access SSL VPNs

 
      		 [bookmark: pgfId-985024]Understanding Devices Supported by Each Remote Access VPN Technology

 
     

 
     
 
     [bookmark: pgfId-985026]Step 1 In Device view, select the desired IOS device.

 
     [bookmark: pgfId-985028]Step 2 From the Policy selector, select Remote Access VPN > Configuration Wizard.

 
     [bookmark: pgfId-985030]Step 3 Select the Remote Access SSL VPN radio button.

 
     [bookmark: pgfId-985035]Step 4 Click Remote Access Configuration Wizard. The Gateway and Context page opens. For a description of the elements on this page, see SSL VPN Configuration Wizard—Gateway and Context Page (IOS).

 
     [bookmark: pgfId-985037]Step 5 Select the gateway to be used as a proxy for connections to the protected resources in your SSL VPN. Options are:

 
      
      		 [bookmark: pgfId-985039] Use Existing Gateway —Lets you use an existing gateway object. If you select this option, specify the name of the SSL VPN Gateway policy object that defines the gateway. Click  Select to select the object or to create a new object.

 
      		 [bookmark: pgfId-985041] Create Using IP Address —Lets you configure a new gateway object using a reachable (public, static) IP address on the router. Enter the IP address.

 
      		 [bookmark: pgfId-985043] Create Using Interface —Lets you configure a new gateway using the public, static IP address of a router interface. Select the interface or interface role object.

 
     

 
     [bookmark: pgfId-985045]If you elected to create a new gateway using an IP address or an interface:

 
      
      		 [bookmark: pgfId-985047]Specify a gateway name.

 
      		 [bookmark: pgfId-985049]Specify the number of the port that will carry the HTTPS traffic. The default is 443, unless HTTP port redirection is enabled, in which case the default HTTP port number is 80. If you want to use a different port, it must be between 1024 and 65535.

 
     

 
     [bookmark: pgfId-985051]Step 6 Enter the name of the name of the context that defines the virtual configuration of the SSL VPN.

 
     [bookmark: pgfId-985053]Step 7 Select the user groups that will be used in your SSL VPN policy. User groups define the resources available to users when connecting to an SSL VPN gateway. The table shows whether full client access is enabled for the group. Click Edit to select the desired groups, or to create new groups.

 
     [bookmark: pgfId-985058]Step 8 Configure the AAA options for authentication, authentication domain, and accounting. For detailed information, see SSL VPN Configuration Wizard—Gateway and Context Page (IOS).

 
     [bookmark: pgfId-985063]Step 9 Click Next. The Portal Page Customization page opens. For a description of the elements on this page, see SSL VPN Configuration Wizard—Portal Page Customization Page (IOS).

 
     [bookmark: pgfId-985065]Step 10 On the Portal Customization page, configure the following options. The bottom of the page is a preview of what the portal page will look like based on your selections; use the preview to fine-tune your selections.

 
      
      		 [bookmark: pgfId-985067] Title —The name of the portal page, which appears at the top of the page.

 
      		 [bookmark: pgfId-985069] Logo —The graphic to show in the title area of the page: None, Default (the Cisco logo graphic), or Custom. If you select custom, click  Select to select the graphic on the Security Manager server. You must copy the custom graphic to the server before you can use it in the portal customization.

 
     

 
     [bookmark: pgfId-985071]The source image file for the logo can be a GIF, JPG, or PNG file, with a file name of up to 255 characters, and up to 100 kilobytes in size.

 
      
      		 [bookmark: pgfId-985073] Login Message —The text that should appear above the login prompt.

 
      		 [bookmark: pgfId-985075] Title and Text Colors —The colors to use for the title and login area and the fonts.

 
     

 
     [bookmark: pgfId-985077]Step 11 Click Finish to save your changes.

 
     [bookmark: pgfId-985079]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-985091][bookmark: 76708][bookmark: ravpnpg_cncpt_GatewayandContextPageIOS]SSL VPN Configuration Wizard—Gateway and Context Page (IOS) [bookmark: marker-985087][bookmark: marker-985089]

 
     [bookmark: pgfId-985093]A gateway and context must be configured on a device before a remote user can access resources on a private network behind the SSL VPN. Use this step of the SSL VPN Configuration wizard to specify a gateway and context configuration, including information that will allow users to access a portal page.

 
     [bookmark: pgfId-985095]Navigation Path

 
     [bookmark: pgfId-985100](Device view) Open the Remote Access VPN Configuration Wizard for configuring a remote access SSL VPN on an IOS device (see Using the Remote Access VPN Configuration Wizard). The Gateway and Context page is the first page that appears.

 
     [bookmark: pgfId-985102]Related Topics

 
      
      		 [bookmark: pgfId-985107]Creating SSL VPNs Using the Remote Access VPN Configuration Wizard (IOS Devices)

 
      		 [bookmark: pgfId-985112]Add or Edit SSL VPN Gateway Dialog Box

 
      		 [bookmark: pgfId-985117]Understanding AAA Server and Server Group Objects

 
     

 
     [bookmark: pgfId-985119]Field Reference

 
     [bookmark: pgfId-985122] 

 
      
       
        
        [bookmark: pgfId-982737]Table 30-9 [bookmark: 76739]SSL VPN Configuration Wizard, Gateway and Context Page 

 
        
       
         
         		
           
           [bookmark: pgfId-982743]Element
          
  
         		
           
           [bookmark: pgfId-982745]Description
          
  
        

 
         
         		[bookmark: pgfId-982751]Gateway

  
         		[bookmark: pgfId-982753]The gateway to be used as a proxy for connections to the protected resources in your SSL VPN. Options are:

 
           
           		 [bookmark: pgfId-982755] Use Existing Gateway —When selected, enables you to use an existing gateway for your SSL VPN.

 
           		 [bookmark: pgfId-982757] Create Using IP Address —When selected, enables you to configure a new gateway using a reachable (public static) IP address on the router.

 
           		 [bookmark: pgfId-982759] Create Using Interface —When selected, enables you to configure a new gateway using the public static IP address of the router interface.

 
          

  
        

 
         
         		[bookmark: pgfId-982765]Gateway Name

  
         		[bookmark: pgfId-982767]The name of the SSL VPN gateway policy object that defines the gateway:

 
           
           		 [bookmark: pgfId-982769]If you selected Use Existing Gateway, click  Select to select the object from a list or to create a new object.

 
          

 [bookmark: pgfId-982771]Note After selecting the gateway, the port number and digital certificate required to establish a secure connection are displayed in the relevant fields.

 
           
           		 [bookmark: pgfId-982773]If you selected Create Using IP Address or Interface, enter the name of the object that you want to create (up to 128 characters).

 
          

  
        

 
         
         		[bookmark: pgfId-982779]IP Address

  
         		[bookmark: pgfId-982781]Available if you selected to create a gateway using an IP address.

 [bookmark: pgfId-982783]The IP address on the router that should be used as the gateway address.

  
        

 
         
         		[bookmark: pgfId-982789]Interface

  
         		[bookmark: pgfId-982791]Available if you selected to create a gateway using an interface.

 [bookmark: pgfId-982793]The name of the interface, or the interface role object that defines the interface, that should be used as the SSL VPN gateway. Click Select to select the interface or interface role, or to create a new interface role.

  
        

 
         
         		[bookmark: pgfId-982799]Port

  
         		[bookmark: pgfId-982801]The port number used for SSL VPN connections. The default is 443, unless HTTP port redirection is enabled, in which case the default HTTP port number is 80. If you enter a different number, it must be between 1024 and 65535.

 
           
           		 [bookmark: pgfId-982803]If you selected Use Existing Gateway, this is a read-only field that shows the port number configured in the selected object.

 
           		 [bookmark: pgfId-982805]If you selected Create Using IP Address or Interface, enter the port number or the name of a port list object that specifies the number, or click  Select to select the port list object.

 
          

  
        

 
         
         		[bookmark: pgfId-982811]Trustpoint

  
         		[bookmark: pgfId-982813]The digital certificate required to establish the secure connection. A self-signed certificate is generated when an SSL VPN gateway is activated.

  
        

 
         
         		[bookmark: pgfId-982819]Context Name

  
         		[bookmark: pgfId-982821]The name of the context that defines the virtual configuration of the SSL VPN.

 [bookmark: pgfId-982823]Note To simplify the management of multiple context configurations, make the context name the same as the domain or virtual hostname.

  
        

 
         
         		[bookmark: pgfId-982829]Portal Page URL

  
         		[bookmark: pgfId-982831]The URL for the SSL VPN, which is filled in when you select (or define) a gateway object. Users connect to this URL to enter the VPN.

  
        

 
         
         		[bookmark: pgfId-982837]Group Policies

  
         		[bookmark: pgfId-982839]The user groups that will be used in your SSL VPN policy. User groups define the resources available to users when connecting to an SSL VPN gateway. The table shows whether full client access is enabled for the group. Click Edit to select the desired groups, or to create new groups.

  
        

 
         
         		[bookmark: pgfId-982845]Authentication Server Group

  
         		[bookmark: pgfId-982847]The authentication server groups. The list is in prioritized order. Authentication is attempted using the first group and proceeds through the list until the user is successfully authenticated or denied. Use the LOCAL group if the users are defined on the gateway itself.

 [bookmark: pgfId-982849]Enter the names of the AAA server groups; separate multiple entries with commas. You can click Select to select the groups or to create new ones.

  
        

 
         
         		[bookmark: pgfId-982855]Authentication Domain

  
         		[bookmark: pgfId-982857]A list or method for SSL VPN remote user authentication. If you do not specify a list or method, the gateway uses global AAA parameters for remote-user authentication.

  
        

 
         
         		[bookmark: pgfId-982863]Accounting Server Group

  
         		[bookmark: pgfId-982865]The accounting server group. Enter the name of the AAA server group policy object, or click Select to select it from a list or to create a new object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-985134][bookmark: 76841][bookmark: ravpnpg_cncpt_PortalPageCustomizationPage]SSL VPN Configuration Wizard—Portal Page Customization Page (IOS)[bookmark: marker-985130][bookmark: marker-985132]

 
     [bookmark: pgfId-985136]Use this step of the SSL VPN Configuration wizard to define the appearance of the portal page that remote users see when connecting to the SSL VPN. The portal page allows remote users access to all websites available on the SSL VPN networks.

 
     [bookmark: pgfId-985138]Navigation Path

 
     [bookmark: pgfId-985143](Device view) Open the Remote Access VPN Configuration Wizard for configuring a remote access SSL VPN on an ASA device (see Using the Remote Access VPN Configuration Wizard); then click Next until you reach this page.

 
     [bookmark: pgfId-985145]Related Topics

 
      
      		 [bookmark: pgfId-985150]Creating SSL VPNs Using the Remote Access VPN Configuration Wizard (IOS Devices)

 
     

 
     [bookmark: pgfId-985152]Field Reference

 
     [bookmark: pgfId-985155] 

 
      
       
        
        [bookmark: pgfId-982878]Table 30-10 [bookmark: 76867]SSL VPN Configuration Wizard, Portal Page Customization Page 

 
        
       
         
         		
           
           [bookmark: pgfId-982884]Element
          
  
         		
           
           [bookmark: pgfId-982886]Description
          
  
        

 
         
         		[bookmark: pgfId-982892]Title

  
         		[bookmark: pgfId-982894]The text displayed at the top of the page. Control the color using the Primary settings in the Title Color and Text Color fields.

  
        

 
         
         		[bookmark: pgfId-982900]Logo

  
         		[bookmark: pgfId-982902]The graphic displayed next to the title. Select None, Default, or Custom. To configure a custom graphic, you must copy the desired graphic to the Security Manager server, then click Browse to select the file. Supported graphic types are GIF, JPG, and PNG, with a maximum size of 100 KB.

  
        

 
         
         		[bookmark: pgfId-982908]Login Message

  
         		[bookmark: pgfId-982910]The text displayed immediately above the login prompt. Control the color using the Secondary settings in the Title Color and Text Color fields.

  
        

 
         
         		[bookmark: pgfId-982916]Title Color

 [bookmark: pgfId-982918]Text Color

  
         		[bookmark: pgfId-982920]The colors used for the title and login area and the text:

 
           
           		 [bookmark: pgfId-982922]Primary—The Title, Login Box title, and the text in those areas.

 
           		 [bookmark: pgfId-982924]Secondary—The Login Box username/password background and the text in that area.

 
          

 [bookmark: pgfId-982926]Click Select to choose background colors. For text, select either Black or White from the text list.

  
        

 
         
         		[bookmark: pgfId-982932]Preview

  
         		[bookmark: pgfId-982934]A preview of how the portal page will appear based on your selections.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-985177][bookmark: 76913][bookmark: ravpnch_proc_CreatingIPSecVPNsUsingtheRemoteAccessVPNConfigurationWizard_IOS]Creating IPSec VPNs Using the Remote Access VPN Configuration Wizard (IOS and PIX 6.3 Devices)[bookmark: marker-985163][bookmark: marker-985165][bookmark: marker-985167][bookmark: marker-985169][bookmark: marker-985171][bookmark: marker-985173][bookmark: marker-985175]

 
     [bookmark: pgfId-985179]This procedure describes how to create or edit IPSec VPNs on IOS and PIX 6.3 devices using the Remote Access VPN Configuration Wizard.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-985184]Tip The wizard allows you to select shared policies to use in the VPN on the Defaults page (the final step of the wizard). If you want to use this feature, you must first ensure that all required shared policies are configured and submitted to the database. For information on configuring shared policies and VPN policy defaults, see Understanding and Configuring VPN Default Policies.


     
      

     

     

 
     [bookmark: pgfId-985186]Related Topics

 
      
      		 [bookmark: pgfId-985191]Understanding Remote Access IPSec VPNs

 
      		 [bookmark: pgfId-985196]Understanding Devices Supported by Each Remote Access VPN Technology

 
     

 
     
 
     [bookmark: pgfId-985198]Step 1 In Device view, select the desired IOS or PIX 6.3 device.

 
     [bookmark: pgfId-985200]Step 2 From the Policy selector, select Remote Access VPN > Configuration Wizard.

 
     [bookmark: pgfId-985202]Step 3 Select the Remote Access IPSec VPN radio button.

 
     [bookmark: pgfId-985204]Step 4 Click Remote Access Configuration Wizard. The User Group Policy page opens.

 
     [bookmark: pgfId-985206]Step 5 Select the required user groups from the Available User Groups list and click >>.

 
      
      		 [bookmark: pgfId-985211]If the required user group is not in the list, click  Create (+) to open the Add User Groups dialog box, which enables you to create or edit a user group object. See Add or Edit User Group Dialog Box.

 
      		 [bookmark: pgfId-985213]You can edit an existing user group by selecting it in either list and clicking  Edit (pencil) .

 
      		 [bookmark: pgfId-985215]To deselect a user group, select it and click  << .

 
     

 
     [bookmark: pgfId-985217]Step 6 Click Next. The Defaults page opens.

 
     [bookmark: pgfId-985222]Step 7 Select the shared policies to assign to the VPN. Initially, the selected policies are those configured on the Security Manager Administration VPN Defaults page. You can use the defaults or select different policies, if any are available. For more information about these policy defaults, see Remote Access VPN Configuration Wizard—Defaults Page.

 
     [bookmark: pgfId-985224]Step 8 Click Finish to save your changes.

 
     [bookmark: pgfId-985226]Inspect the policies created and configure any additional options that you want to implement.

 
     [bookmark: pgfId-985228]
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     [bookmark: pgfId-12098][bookmark: 130060][bookmark: pxchap_proc_ConfiguringServicePolicyRulesonFirewallDevices]Configuring Service Policy Rules on Firewall Devices[bookmark: marker-12094][bookmark: marker-12096]
      
      
 
     
 

 
    [bookmark: pgfId-12100]This section describes configuring service policy rules. Service policies provide a consistent and flexible way to configure certain security appliance features, including priority queuing, application inspection, and QoS (quality of service). For example, you can use a service policy to create a timeout configuration that is specific to a particular TCP application, as opposed to one that applies to all TCP applications.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-12106]Note Detailed information regarding the range and implementation of particular service policies can be found on cisco.com. For example, the following references may be helpful:
 
Using Modular Policy Framework
 
QoS Configuration and Monitoring


    
     

    

    

 
    [bookmark: pgfId-12108]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-12113]About Service Policy Rules

 
     		 [bookmark: pgfId-12118]About TCP State Bypass

 
     		 [bookmark: pgfId-12123]Priority Queues Page

 
     		 [bookmark: pgfId-12128]Service Policy Rules Page

 
     		 [bookmark: pgfId-12133]Configuring Traffic Flow Objects

 
     		 [bookmark: pgfId-12138]Configuring TCP Maps

 
    

 
   
 
    
     [bookmark: pgfId-12144][bookmark: 130078][bookmark: pxchap_cncpt_AboutServicePolicyRules]About Service Policy Rules

 
    [bookmark: pgfId-12146]Service policy rules encompass these features:

 
     
     		 [bookmark: pgfId-12151]TCP and general connection settings (including TCP State Bypass; see About TCP State Bypass)

 
     		 [bookmark: pgfId-12153]Content security control (CSC)

 
     		 [bookmark: pgfId-12155]Application inspection

 
     		 [bookmark: pgfId-12157]Intrusion Prevention Services

 
     		 [bookmark: pgfId-12159]QoS queuing and policing

 
     		 [bookmark: pgfId-12164]ASA CX redirection (see About the ASA CX)

 
     		 [bookmark: pgfId-12166]ASA FirePOWER redirection

 
     		 [bookmark: pgfId-12168]User statistics for identity-based firewall policies

 
    

 
    [bookmark: pgfId-12170]The configuration options for these features are presented on two pages in Security Manager—Priority Queues and Rules—accessed by navigating to Platform > Service Policy.

 
    [bookmark: pgfId-12172]Priority Queuing

 
    [bookmark: pgfId-12174]Priority queuing establishes two queues on an interface, a Low Latency Queuing (LLQ) priority queue and a “best effort” queue. This lets you prioritize latency-sensitive traffic like voice and video, so it is transmitted ahead of other traffic. Packets in the priority queue are always transmitted before packets in the best effort queue.

 
    [bookmark: pgfId-12176]Because queues are not of infinite size, they can fill and overflow. When a queue is full, additional packets cannot get into the queue and are dropped. This is called “tail drop.” To minimize tail drop, you can increase the queue buffer size. You can also fine-tune the maximum number of packets allowed into the transmit queue. These options let you control the latency and robustness of priority queuing.

 
    [bookmark: pgfId-12184]Priority queuing is a Quality of Service (QoS) feature. In Security Manager, priority queue size and transmit queue size are managed on the Priority Queues Page, while establishment of priority queuing for a traffic class is an option on the QoS tab of the Service Policy (MPC) Rule Wizard, which is accessed from the Service Policy Rules Page.

 
    [bookmark: pgfId-12186]Application Inspection and QoS

 
    [bookmark: pgfId-12188]Some applications require special handling by the security appliance, and specific application inspection engines are provided for this purpose. Specifically, applications that embed IP addressing information in the user data packet, or open secondary channels on dynamically assigned ports require special inspection.

 
    [bookmark: pgfId-12190]Application inspection is enabled by default for many protocols, while it is disabled for others. In many cases, you can change the port which the application inspection engine monitors for traffic.

 
    [bookmark: pgfId-12192]Application inspection engines work with network address translation (NAT) to help identify the location of embedded addressing information. This allows NAT to translate these embedded addresses, and to update any checksum or other fields that are affected by the translation.

 
    [bookmark: pgfId-12194]Service policy rules define how specific types of application inspection are applied to different types of traffic processed by the security appliance. You can apply rules to specific interfaces, or globally to every interface.

 
    [bookmark: pgfId-12196]These rules provide a means to configure security appliance features in a manner similar to the Cisco IOS software quality-of-service (QoS) CLI. For example, with service policy rules you can include IP Precedence as one of the criteria to identify traffic for rate-limiting. You can also create a timeout configuration that is specific to a particular TCP application, as opposed to one that applies to all TCP applications.

 
    [bookmark: pgfId-12200][bookmark: marker-12198]Traffic match criteria are used to define the types of traffic to which you want to apply application inspection. For example, TCP traffic on port 23 might be classified as the Telnet traffic class. You then might use the traffic class to apply connection limits.

 
    [bookmark: pgfId-12202]Multiple traffic match criteria can be assigned to a single interface, but a packet will only match the first criteria within a specific service policy rule.

 
   
 
    
     [bookmark: pgfId-12214][bookmark: 130122][bookmark: pxchap_cncpt_AboutTCPstateBypass]About TCP State Bypass[bookmark: marker-12208][bookmark: marker-12210][bookmark: marker-12212]

 
    [bookmark: pgfId-12216]By default, all traffic that enters an ASA or FWSM is inspected using the Adaptive Security Algorithm, and is either allowed through or dropped based on the security policy. The device maximizes its firewall performance by checking the state of each packet—to determine whether this a new connection, or an established connection—and assigning it to the session management path (if it is a new connection SYN packet), the fast path (if it is an established connection), or the control-plane path (for advanced inspection).

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-12218]Note TCP State Bypass is available on FWSM 3.2+ and ASA 8.2+ devices only.


    
     

    

    

 
    [bookmark: pgfId-12220]TCP packets that match existing connections in the fast path can pass through the appliance without every aspect of the security policy being rechecked. This feature maximizes performance. However, the method of establishing the session in the fast path using the SYN packet, and the checks that occur in the fast path (such as TCP sequence number), require that both outbound and inbound flows for a connection pass through the same device, which is not the case in asymmetric routing environments.

 
    [bookmark: pgfId-12222]For example, assume a new connection is assigned to security device 1. The SYN packet goes through the session management path, and an entry for the connection is added to the fast path table. If subsequent packets of this connection go through device 1, then the packets match the entry in the fast path, and are passed through. But if subsequent packets go to device 2, where a SYN packet did not go through the session management path, there is no entry in the fast path for the connection, and the packets are dropped.

 
    [bookmark: pgfId-12224]Thus, if you have asymmetric routing configured on upstream routers, and traffic alternates between two security devices, enable TCP state bypass for those specific traffic flows. TCP state bypass alters the way sessions are established in the fast path and disables the fast path checks. TCP traffic is then treated much as a UDP connection is treated: when a non-SYN packet matching the specified networks enters the security device, and there is not a fast path entry, then the packet goes through the session management path to establish a connection in the fast path. Once in the fast path, the traffic bypasses the fast path checks.

 
    [bookmark: pgfId-12226]Unsupported Features

 
    [bookmark: pgfId-12228]The following features are not supported when you enable TCP state bypass:

 
     
     		 [bookmark: pgfId-12230]Application inspection – Application inspection requires both inbound and outbound traffic to go through the same security device, so application inspection is not supported with TCP state bypass.

 
     		 [bookmark: pgfId-12232]AAA authenticated sessions – When a user authenticates with one security device, traffic returning via the other security device will be denied because the user did not authenticate with that device.

 
     		 [bookmark: pgfId-12234]TCP Intercept, Maximum Embryonic Connections limit, TCP sequence number randomization – If TCP state bypass is enabled, the device does not keep track of the state of the connection, so these features are not applicable.

 
     		 [bookmark: pgfId-12236]Cisco CSC SSM (Content Security and Control Security Services Module) – SSM and SSC functionality cannot be used with TCP state bypass.

 
    

 
    [bookmark: pgfId-12238]Compatibility with NAT

 
    [bookmark: pgfId-12240]Because the translation session is established separately for each security device, be sure to configure static NAT on both devices for TCP state bypass traffic; if you use dynamic NAT, the address chosen for the session on device 1 will differ from the address chosen for the session on device 2.

 
    [bookmark: pgfId-12242]Related Topics

 
     
     		 [bookmark: pgfId-12247]About Service Policy Rules

 
    

 
   
 
    
     [bookmark: pgfId-12263][bookmark: 130160][bookmark: pxpage_cncpt_PriorityQueuesPage]Priority Queues Page[bookmark: marker-12257][bookmark: marker-12259][bookmark: marker-12261]

 
    [bookmark: pgfId-12265]Priority queues let you define how traffic is prioritized in the network. You can define a series of filters based on packet characteristics to cause traffic to be placed in a higher or lower priority queue. The queue with the highest priority is serviced first until it is empty, then the lower queues are serviced in sequence.

 
    [bookmark: pgfId-12270]In Security Manager, priority queue size and transmit queue size are managed on this page, while establishment of priority queuing for a traffic class is an option on the QoS tab of the Service Policy (MPC) Rule Wizard, which is accessed from the Service Policy Rules Page.

 
    [bookmark: pgfId-12275]The Priority Queue Configuration dialog box is used to add and edit these queues. Refer to Priority Queue Configuration Dialog Box for descriptions of the fields displayed in the Priority Queues table on this page.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-12277]Note Priority queuing is are not available on Catalyst 6500 service modules (the Firewall Services Module and the Adaptive Security Appliance Service Module).


    
     

    

    

 
    [bookmark: pgfId-12279]Navigation Path

 
     
     		 [bookmark: pgfId-12281](Device view) Select  Platform > Service Policy > Priority Queues from the Device Policy selector.

 
     		 [bookmark: pgfId-12283](Policy view) Select  PIX/ASA/FWSM Platform > Service Policy > Priority Queues from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-12285]Related Topics

 
     
     		 [bookmark: pgfId-12290]Chapter 57, “Configuring Service Policy Rules on Firewall Devices”

 
     		 [bookmark: pgfId-12295]Insert/Edit Service Policy (MPC) Rule Wizard

 
     		 [bookmark: pgfId-12300]About Service Policy Rules

 
     		 [bookmark: pgfId-12305]Understanding Queuing Parameters

 
    

 
     
      [bookmark: pgfId-12319][bookmark: 130205][bookmark: pxpage_cncpt_PriorityQueueConfigurationDialogBox]Priority Queue Configuration Dialog Box[bookmark: marker-12313][bookmark: marker-12315][bookmark: marker-12317]

 
     [bookmark: pgfId-12321]Use the Priority Queue Configuration dialog box to define and edit the priority queues on the Priority Queues page.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-12323]Note Priority queuing is are not available on Catalyst 6500 service modules (the Firewall Services Module and the Adaptive Security Appliance Service Module).


     
      

     

     

 
     [bookmark: pgfId-12325]Navigation Path

 
     [bookmark: pgfId-12330]You open the Priority Queue Configuration dialog box by clicking the Add Row or Edit Row buttons on the Priority Queues Page.

 
     [bookmark: pgfId-12332]Related Topics

 
      
      		 [bookmark: pgfId-12337]Chapter 57, “Configuring Service Policy Rules on Firewall Devices”

 
      		 [bookmark: pgfId-12342]Insert/Edit Service Policy (MPC) Rule Wizard

 
      		 [bookmark: pgfId-12347]About Service Policy Rules

 
      		 [bookmark: pgfId-12352]Understanding Queuing Parameters

 
     

 
     [bookmark: pgfId-12354]Field Reference

 
     [bookmark: pgfId-12357] 

 
      
       
        
        [bookmark: pgfId-10090]Table 57-1 [bookmark: 130243]Priority Queue Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-10096]Element
          
  
         		
           
           [bookmark: pgfId-10098]Description
          
  
        

 
         
         		[bookmark: pgfId-10104]Interface Name

  
         		[bookmark: pgfId-10106]Specify the interface to which this rule applies; you can enter the interface name, or click Select to choose an available interface.

  
        

 
         
         		[bookmark: pgfId-10112]Queue Limit

  
         		[bookmark: pgfId-10114]Enter the maximum number of packets that can be queued in a priority queue before it drops data. This limit must be in the range of 0 through 2048 packets.

  
        

 
         
         		[bookmark: pgfId-10120]Transmission Ring Limit

  
         		[bookmark: pgfId-10122]Enter the maximum number of packets allowed into the transmit queue. This fine-tuning of the transmit queue can reduce latency and offer better performance through the transmit driver.

 [bookmark: pgfId-10124]On PIX devices, this value can range from 3 through 128 packets. On ASAs prior to version 7.2, this limit can be in the range 3 through 256 packets, while on ASAs running version 7.2 and higher, the value can be in the range 3 through 512 packets.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-12375][bookmark: 130271][bookmark: pxpage_cncpt_IPSQoSandConnectionRulesPage]Service Policy Rules Page[bookmark: marker-12365][bookmark: marker-12367][bookmark: marker-12369][bookmark: marker-12371][bookmark: marker-12373]

 
    [bookmark: pgfId-12377]Use the Service Policy Rules page to define new service policy rules, and to edit or delete existing service policy rules.

 
    [bookmark: pgfId-12379]Configuring Service Policy Rules consists of three tasks:

 
    [bookmark: pgfId-12384] 1. Configure a service policy. Create a service policy and determine the interfaces to which the service policy applies. For more information, see Step 1. Configure a Service Policy.

 
    [bookmark: pgfId-12389] 2. Configure the traffic class. Specify the criteria you want to use to identify the traffic to which the service policy applies. For more information, see Step 2. Configure the traffic class.

 
    [bookmark: pgfId-12394] 3. Configure the actions. Specify the actions that should be taken to protect information or resources, or to perform QoS functions for the traffic specified in this service policy. For more information, see Step 3. Configure the MPC actions.

 
    [bookmark: pgfId-12399]The three tasks are performed using the Insert/Edit Service Policy (MPC) Rule Wizard. Refer to the individual task topics for descriptions of the fields displayed in the Service Policy Rules table on this page.

 
    [bookmark: pgfId-12401]Navigation Path

 
     
     		 [bookmark: pgfId-12403](Device view) Select  Platform > Service Policy > Rules from the Device Policy selector.

 
     		 [bookmark: pgfId-12405](Policy view) Select  PIX/ASA/FWSM Platform > Service Policy > Rules from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-12407]ASA CX Auth Proxy Configuration

 
    [bookmark: pgfId-12412]The CXSC Auth Proxy button below the Service Policy Rules table opens the Add/Edit CXSC Auth Proxy Configuration dialog box, which is described in ASA CX Auth Proxy Configuration.

 
    [bookmark: pgfId-12414]The CXSC Auth Proxy button is available below the Service Policy Rules table only in Device view; it is not visible in Policy view.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-12416]Note Security Manager uses “CXSC” in some places to refer to an ASA CX Security Services Processor (SSP).


    
     

    

    

 
    [bookmark: pgfId-12418]Related Topics

 
     
     		 [bookmark: pgfId-12423]Chapter 57, “Configuring Service Policy Rules on Firewall Devices”

 
     		 [bookmark: pgfId-12428]About Service Policy Rules

 
     		 [bookmark: pgfId-12430]Standard rules table topics:

 
    

 
    [bookmark: pgfId-12435] – Using Rules Tables

 
    [bookmark: pgfId-12440] – Filtering Tables

 
    [bookmark: pgfId-12445] – Table Columns and Column Heading Features

 
     
      [bookmark: pgfId-12469][bookmark: 130346][bookmark: pxpage_cncpt_InsertEditServicePolicyMPCRuleWizard]Insert/Edit Service Policy (MPC) Rule Wizard[bookmark: marker-12461][bookmark: marker-12463][bookmark: marker-12465][bookmark: marker-12467]

 
     [bookmark: pgfId-12471]Use the Insert/Edit Service Policy (MPC) Rule wizard to add and edit service policy rules on the Service Policy Rules page. The Insert/Edit Service Policy (MPC) Rule wizard presents the following steps:

 
      
      		 [bookmark: pgfId-12476]Step 1. Configure a Service Policy

 
      		 [bookmark: pgfId-12481]Step 2. Configure the traffic class

 
      		 [bookmark: pgfId-12486]Step 3. Configure the MPC actions

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-12490]Note “MPC” refers to what is now called the Modular Policy Framework. Refer to Using Modular Policy Framework for additional information.


     
      

     

     

 
     [bookmark: pgfId-12492]Navigation Path

 
     [bookmark: pgfId-12497]Open the Insert/Edit Service Policy (MPC) Rule wizard by clicking the Add Row or Edit Row button on the Service Policy Rules Page.

 
    
 
     
      [bookmark: pgfId-12507][bookmark: 130383][bookmark: pxpage_cncpt_StepConfigureaServicePolicy]Step 1. Configure a Service Policy[bookmark: marker-12503][bookmark: marker-12505]

 
     [bookmark: pgfId-12509]The first step in using the Insert/Edit Service Policy (MPC) Rule Wizard to configure a Service Policy Rule involves enabling the rule and specifying the interface(s) to which it is applied.

 
     [bookmark: pgfId-12511]Navigation Path

 
     [bookmark: pgfId-12516]Open the Insert/Edit Service Policy (MPC) Rule wizard by clicking the Add Row or Edit Row button on the Service Policy Rules Page.

 
     [bookmark: pgfId-12518]Related Topics

 
      
      		 [bookmark: pgfId-12523]Step 2. Configure the traffic class

 
      		 [bookmark: pgfId-12528]Step 3. Configure the MPC actions

 
     

 
     [bookmark: pgfId-12531] 

 
      
       
        
        [bookmark: pgfId-10137]Table 57-2 [bookmark: 130408]Insert/Edit Service Policy (MPC) Rule Wizard—Step 1. Configure a Service Policy. 

 
        
       
         
         		
           
           [bookmark: pgfId-10143]Element
          
  
         		
           
           [bookmark: pgfId-10145]Description
          
  
        

 
         
         		[bookmark: pgfId-10151]Enable The Current MPC Rule

  
         		[bookmark: pgfId-10153]Check this box to enable this service policy rule. You can deselect this option if you want to define the rule now, but not deploy it to the device until later.

  
        

 
         
         		[bookmark: pgfId-10159]Category

  
         		[bookmark: pgfId-10164]To assign the rule to a category, choose the category from the list. Categories can help you organize and identify rules and objects. For more information, see Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-10170]Description

  
         		[bookmark: pgfId-10172]Optionally, enter a description for the service policy rule.

  
        

 
         
         		[bookmark: pgfId-10178]Global - Applies to All Interfaces

  
         		[bookmark: pgfId-10180]Select this option to apply the rule globally to all interfaces. This option is not compatible with matching traffic based on the source or destination IP address using an access list.

  
        

 
         
         		[bookmark: pgfId-10186]Interfaces

  
         		[bookmark: pgfId-10188]Select this option to apply the rule to a specific interface or group of interfaces (or interface roles), and then enter or Select the name of an interface or interface object.

 [bookmark: pgfId-10190]This selection is required if you want to match traffic based on the source or destination IP address using an access list.

 [bookmark: pgfId-10192]Note Interface-specific rules take precedence over the global service policy for a given feature. For example, if you have a global policy with FTP inspection, and an interface policy with TCP connection limits, then both FTP inspection and TCP connection limits are applied to the interface. However, if you have a global policy with FTP inspection, and an interface policy with FTP inspection, then only the interface policy FTP inspection is applied to that interface.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-12543][bookmark: 130447][bookmark: pxpage_cncpt_StepConfigurethetrafficclass]Step 2. Configure the traffic class[bookmark: marker-12537][bookmark: marker-12539][bookmark: marker-12541]

 
     [bookmark: pgfId-12545]The second step in using the Insert/Edit Service Policy (MPC) Rule Wizard to configure a Service Policy Rule involves specifying the traffic class to which the rule is applied.

 
     [bookmark: pgfId-12547]Specify the class to use to match traffic for this rule:

 
      
      		 [bookmark: pgfId-12549] Use class-default As The Traffic Class —Select this option to use the traffic class  class-default for this service policy. The class-default traffic class matches all traffic.

 
      		 [bookmark: pgfId-12551] Traffic Class —Select this option to apply this rule to a specific traffic class. Enter the name of the previously defined traffic class, or click  Select to select it from the Traffic Flows Selector.

 
     

 
     [bookmark: pgfId-12556]You also can define or edit a traffic flow “on the fly” by clicking the either Create or Edit buttons in the Traffic Flows Selector. (Traffic flows are also created and edited on the Traffic Flows page of the Policy Object Manager.) See Configuring Traffic Flow Objects for more information.

 
     [bookmark: pgfId-12558]Related Topics

 
      
      		 [bookmark: pgfId-12563]Step 1. Configure a Service Policy

 
      		 [bookmark: pgfId-12568]Step 3. Configure the MPC actions

 
     

 
    
 
     
      [bookmark: pgfId-12602][bookmark: 130483][bookmark: pxpage_cncpt_StepConfiguretheactions]Step 3. Configure the MPC actions [bookmark: marker-12574][bookmark: marker-12576][bookmark: marker-12578][bookmark: marker-12580][bookmark: marker-12582][bookmark: marker-12584][bookmark: marker-12586][bookmark: marker-12588][bookmark: marker-12590][bookmark: marker-12592][bookmark: marker-12594][bookmark: marker-12596][bookmark: marker-12598][bookmark: marker-12600]

 
     [bookmark: pgfId-12604]The third step in the Insert/Edit Service Policy (MPC) Rule Wizard involves specifying IPS, CXSC, FirePOWER, Connection Setting, QoS, CSC, User Statistics, ScanSafe Web Security, and NetFlow parameters for the rule; each set of parameters is presented on a separate tabbed panel.

 
     [bookmark: pgfId-12606]Related Topics

 
      
      		 [bookmark: pgfId-12611]Step 1. Configure a Service Policy

 
      		 [bookmark: pgfId-12616]Step 2. Configure the traffic class

 
     

 
     [bookmark: pgfId-12618]Field Reference

 
     [bookmark: pgfId-12621] 

 
      
       
        
        [bookmark: pgfId-10205]Table 57-3 [bookmark: 130551]Insert/Edit Service Policy (MPC) Rule Wizard—Step 3. Configure the actions. 

 
        
       
         
         		
           
           [bookmark: pgfId-10211]Element
          
  
         		
           
           [bookmark: pgfId-10213]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-10219]Intrusion Prevention tab
          
  
        

 
         
         		[bookmark: pgfId-10227]Enable IPS for this Traffic

  
         		[bookmark: pgfId-10229]Enables or disables intrusion prevention for this traffic flow. When this box is checked, the other parameters on this panel are available.

 [bookmark: pgfId-10234]Note These parameters are applicable only on ASA 7.0+ devices that have an IPS module installed. See About IPS Modules on ASA Devices for more information.

  
        

 
         
         		[bookmark: pgfId-10240]IPS Mode

  
         		[bookmark: pgfId-10242]Select the operating mode for intrusion prevention:

 
           
           		 [bookmark: pgfId-10244] Inline —This mode places the IPS module directly in the traffic flow. No traffic that you identified for IPS inspection can continue through the ASA without first passing through, and being inspected by, the IPS module. This mode is the most secure because every packet identified for inspection is analyzed before being allowed through. Also, the IPS module can implement a blocking policy on a packet-by-packet basis. However, this mode can affect throughput.

 
           		 [bookmark: pgfId-10246] Promiscuous —This mode sends a duplicate stream of traffic to the IPS module. This is less secure than Inline mode, but has little impact on traffic throughput. Unlike Inline mode, in Promiscuous mode the IPS module cannot drop the original packets, it can only block traffic by instructing the ASA to shun the traffic, or by resetting the connection on the appliance.

 
          

 [bookmark: pgfId-10248]Also, while the IPS module is analyzing the traffic, a small amount of traffic may pass through the ASA before the IPS module can shun it.

  
        

 
         
         		[bookmark: pgfId-10254]On IPS Card Failure

  
         		[bookmark: pgfId-10256]Specify the action to be taken if the IPS module becomes inoperable. Select either:

 
           
           		 [bookmark: pgfId-10258] Open —Permits traffic if the module or card fails.

 
           		 [bookmark: pgfId-10260] Close —Blocks traffic if the module or card fails.

 
          

  
        

 
         
         		[bookmark: pgfId-10266]Virtual Sensor

  
         		[bookmark: pgfId-10268]Text box in which you can view, edit, or remove the virtual sensor in the service policy that you are adding or editing

  
        

 
         
         		 [bookmark: pgfId-10274]CXSC tab

 [bookmark: pgfId-10276]Note Security Manager uses “CXSC” in places to refer to an ASA CX Security Services Processor (SSP).

  
        

 
         
         		[bookmark: pgfId-10284]Enable CXSC For This Traffic

  
         		[bookmark: pgfId-10286]Check this box to enable redirection of this traffic flow to an ASA CX installed in the ASA. When this box is checked, the other parameters on this panel are available.

 [bookmark: pgfId-10288]Note These parameters are applicable only on ASA 5585-X devices running version 8.4(4)+ and ASA 55xx-X devices running version 9.1(1)+ that have an ASA CX SSP installed.

  
        

 
         
         		[bookmark: pgfId-10294]On Context Security Card Failure

  
         		[bookmark: pgfId-10296]Specify the action to be taken if the ASA CX becomes inoperable. Select either:

 
           
           		 [bookmark: pgfId-10298] Open – If the ASA CX fails for any reason, the ASA will continue to pass traffic that would otherwise be redirected to the ASA CX.

 
           		 [bookmark: pgfId-10300] Close – If the ASA CX fails, the ASA will drop any traffic that would otherwise be redirected to the ASA CX.

 
          

  
        

 
         
         		[bookmark: pgfId-10306]Enable Auth Proxy

  
         		[bookmark: pgfId-10308]Check this box to enable the authentication proxy, which is required if you want to use active authentication in the identity policies on the ASA CX. If not checked, no authentication is performed.

 [bookmark: pgfId-10313]Note You can change the port used for authentication proxy; see ASA CX Auth Proxy Configuration for more information.

  
        

 
         
         		 
           
           [bookmark: pgfId-10319]FirePOWER tab
          
  
        

 
         
         		[bookmark: pgfId-10327]Enable FirePOWER Card For This Traffic

  
         		[bookmark: pgfId-10329]Check this box to enable redirection of this traffic flow to an ASA FirePOWER module installed in the ASA. When this box is checked, the other parameters on this panel are available.

 [bookmark: pgfId-10331]Note These parameters are applicable only on ASA 55xx-X devices running version 9.2(1)+.

  
        

 
         
         		[bookmark: pgfId-10337]On FirePOWER Card Failure

  
         		[bookmark: pgfId-10339]Specify the action to be taken if the ASA FirePOWER module becomes inoperable. Select either:

 
           
           		 [bookmark: pgfId-10341] Open – If the ASA FirePOWER module fails for any reason, the ASA will continue to pass traffic that would otherwise be redirected to the ASA FirePOWER module.

 
           		 [bookmark: pgfId-10343] Close – If the ASA FirePOWER module fails, the ASA will drop any traffic that would otherwise be redirected to the ASA FirePOWER module.

 
          

  
        

 
         
         		[bookmark: pgfId-10349]Enable Monitor Only

  
         		[bookmark: pgfId-10351]Sets the module to monitor-only mode. In monitor-only mode, the module can process traffic for demonstration purposes, but then drops the traffic. You cannot use the traffic-forwarding interface or the device for production purposes.

  
        

 
         
         		 
           
           [bookmark: pgfId-10357]Connection Settings tab
          
  
        

 
         
         		[bookmark: pgfId-10365]Enable Connection Settings For This Traffic

  
         		[bookmark: pgfId-10367]Enables or disables connection settings for this traffic flow. When this box is checked, the other parameters on this panel become active. From the Connection Settings tab you can configure maximum connections, embryonic connections, timeouts, and TCP parameters.

  
        

 
         
         		[bookmark: pgfId-10373]Maximum Connections

  
         		[bookmark: pgfId-10375]You can specify the maximum number of TCP and UDP connections, and the maximum number of embryonic connections for this traffic flow:

 
           
           		 [bookmark: pgfId-10377] Maximum TCP & UDP Connections – Specify the maximum number of simultaneous TCP and UDP connections for the entire subnet, up to 65,535, for ASA versions earlier than 8.4(5); for ASA 8.4(5) and later, the maximum number is 2,000,000. The default is zero for both protocols, which means the maximum possible connections are allowed.

 
           		 [bookmark: pgfId-10379] Maximum TCP & UDP Connections Per Client – For ASA/PIX 7.1+ only; specify the maximum number of simultaneous TCP and UDP connections on a per client basis. For ASA 8.4(5) and later, the maximum number is 2,000,000.

 
           		 [bookmark: pgfId-10381] Maximum Embryonic Connections – For ASA/PIX 7.0+ only; specify the maximum number of embryonic connections per host, up to 65,535, for ASA versions earlier than 8.4(5); for ASA 8.4(5) and later, the maximum number is 2,000,000. An embryonic connection is a connection request that has not finished the necessary handshake between source and destination. This limit enables the TCP Intercept feature. The default is zero, which means the maximum embryonic connections. TCP Intercept protects inside systems from a DoS attack perpetrated by flooding an interface with TCP SYN packets. When the embryonic limit has been surpassed, the TCP intercept feature intercepts TCP SYN packets from clients to servers on a higher security level. SYN cookies are used during the validation process and help minimize the amount of valid traffic being dropped. Thus, connection attempts from unreachable hosts will never reach the server. This feature is not applicable if TCP State Bypass is enabled.

 
           		 [bookmark: pgfId-10383] Maximum Embryonic Connections Per Client – For ASA/PIX 7.1+ only; specify the maximum number of embryonic connections on a per client basis. For ASA 8.4(5) and later, the maximum number is 2,000,000. This feature is not applicable if TCP State Bypass is enabled.

 
          

  
        

 
         
         		[bookmark: pgfId-10389]Connection Timeouts

  
         		[bookmark: pgfId-10391]You can specify the following connection timeout settings for this traffic flow:

 
           
           		 [bookmark: pgfId-10393] Embryonic Connection Timeout – Specify the idle time until an embryonic connection slot is freed. Enter 0:00:00 to disable timeout for the connection. The default is 20 seconds for FWSMs, and 30 seconds for ASA/PIX devices.

 
           		 [bookmark: pgfId-10395] Half Closed Connection Timeout – Specify the idle time until a half-closed connection slot is freed. Enter 0:00:00 to disable timeout for the connection.

 
          

 [bookmark: pgfId-10397]For FWSMs, the default value is 20 seconds; the maximum value is 255 seconds (four minutes, 15 seconds).

 [bookmark: pgfId-10399]For ASA 9.1.2 and later devices, the minimum is 30 seconds. For all other ASA/PIX devices, the minimum is 5 minutes. The default is 10 minutes for all ASA/PIX devices.

 
           
           		 [bookmark: pgfId-10401] Idle Connection Timeout – Specify the idle time until a connection slot is freed. Enter 0:00:00 to disable timeout for the connection. This duration must be at least 5 minutes. The default is 1 hour.

 
          

  
        

 
         
         		[bookmark: pgfId-10407]Reset Connection Upon Timeout

  
         		[bookmark: pgfId-10409]If selected, connections are reset after a timeout occurs. Available for ASA/PIX 7.0(4)+ only.

  
        

 
         
         		[bookmark: pgfId-10415]Detect Dead Connections

  
         		[bookmark: pgfId-10417]Enables the Dead Connection Detection feature; available for ASA/PIX 7.2+ devices. Selecting this option enables these two fields:

 
           
           		 [bookmark: pgfId-10419] Dead Connection Detection Timeout – Specify the period of time between retries when a dead connection is detected. The default is 15 seconds.

 
           		 [bookmark: pgfId-10421] Dead Connection Detection Retries – Specify the number of retries to be performed after a dead connection is detected. The default is five.

 
          

  
        

 
         
         		[bookmark: pgfId-10427]Traffic Flow Idle Timeout

  
         		[bookmark: pgfId-10429]Specify the period of time between a traffic flow becoming idle and the flow’s disconnection. Applicable to FWSM 3.2+ only. The default is 1 hour.

  
        

 
         
         		[bookmark: pgfId-10435]Enable TCP Normalization

  
         		[bookmark: pgfId-10437]Enables TCP normalization, and activates the TCP Map selection option. Applies to ASA/PIX 7.0+ only; not applicable if TCP State Bypass is enabled.

  
        

 
         
         		[bookmark: pgfId-10443]TCP map

  
         		[bookmark: pgfId-10448]Specify the TCP map to use for TCP normalization: enter or Select the name of a TCP map. For more information, see Configuring TCP Maps.

  
        

 
         
         		[bookmark: pgfId-10454]Randomize TCP Sequence Number

  
         		[bookmark: pgfId-10456]Enables the Randomize Sequence Number feature. Disable this feature only if another inline security appliance is also randomizing sequence numbers and the result is scrambling the data. Each TCP connection has two Initial Sequence Numbers: one generated by the client and one generated by the server. The security appliance randomizes the ISN that is generated by the host/server on the higher security interface. At least one ISN must be randomly generated so that attackers cannot predict the next ISN and potentially hijack the session. Not applicable if TCP State Bypass is enabled.

  
        

 
         
         		[bookmark: pgfId-10462]Enable TCP State Bypass

  
         		[bookmark: pgfId-10467]Enables TCP state bypass for this traffic flow. This is allows specific traffic flows in asymmetric routing environments when both the outbound and inbound flow for a connection do not pass through the same device. Applicable to FWSM 3.2+ and ASA 8.2+ only. See About TCP State Bypass for more information.

  
        

 
         
         		[bookmark: pgfId-10473]Enable Decrement TTL

  
         		[bookmark: pgfId-10475]Select this option to turn on decrementing of the time-to-live (TTL) value in packets passed by the security appliance. Applicable to PIX/ASA 7.2.2+ only.

  
        

 
         
         		 
           
           [bookmark: pgfId-10481]QoS tab
          
  
        

 
         
         		[bookmark: pgfId-10489]Enable QoS For This Traffic

  
         		[bookmark: pgfId-10491]Enables Quality of Service (QoS) options for this traffic flow. When selected, the Enable Priority For This Flow and the Traffic Policing options become active.

 [bookmark: pgfId-10493]Note The options on this tab are applicable to PIX/ASA 7.0+ devices only.

  
        

 
         
         		[bookmark: pgfId-10499]Enable Priority For This Flow

  
         		[bookmark: pgfId-10504]Enables strict scheduling priority for this flow. The priority queues must be defined on the Priority Queues Page.

  
        

 
         
         		[bookmark: pgfId-10510]Traffic Policing

  
         		[bookmark: pgfId-10512]Enables output and input traffic policing. Traffic policing lets you control the maximum rate of traffic transmitted or received on an interface.

  
        

 
         
         		[bookmark: pgfId-10518]Output (Traffic Policing)

  
         		[bookmark: pgfId-10520]Enables policing of traffic flowing out of the device. If you enable policing, you can specify the following values:

 
           
           		 [bookmark: pgfId-10522] Committed Rate – The rate limit for this traffic flow; this is a value in the range 8,000 to 2,000,000,000, specifying the maximum speed (bits per second) allowed.

 
           		 [bookmark: pgfId-10524] Burst Rate – A value in the range 1,000 to 512,000,000 that specifies the maximum number of instantaneous bytes allowed in a sustained burst before throttling to the conforming rate value.

 
           		 [bookmark: pgfId-10526] Conform Action – The action to take when the rate is less than the conform-burst value. Choices are Transmit or Drop.

 
           		 [bookmark: pgfId-10528] Exceed Action – Take this action when the rate is between the conform-rate value and the conform-burst value. Choices are Transmit or Drop.

 
          

  
        

 
         
         		[bookmark: pgfId-10534]Input (Traffic Policing)

  
         		[bookmark: pgfId-10536]Enables policing of traffic flowing into the device; these options apply to ASA/PIX 7.2+ devices only. If you enable policing, you can specify the following values:

 
           
           		 [bookmark: pgfId-10538] Committed Rate – The rate limit for this traffic flow; this is a value in the range 8,000 to 2,000,000,000, specifying the maximum speed (bits per second) allowed.

 
           		 [bookmark: pgfId-10540] Burst Rate – A value in the range 1,000 to 512,000,000 that specifies the maximum number of instantaneous bytes allowed in a sustained burst before throttling to the conforming rate value.

 
           		 [bookmark: pgfId-10542] Conform Action – The action to take when the rate is less than the conform-burst value. Choices are Transmit or Drop.

 
           		 [bookmark: pgfId-10544] Exceed Action – Take this action when the rate is between the conform-rate value and the conform-burst value. Choices are Transmit or Drop.

 
          

  
        

 
         
         		 
           
           [bookmark: pgfId-10550]CSC tab
          
  
        

 
         
         		[bookmark: pgfId-10558]Enable Content Security Control For This Traffic

  
         		[bookmark: pgfId-10560]Enables or disables the use of the Cisco CSC SSM (Content Security and Control Security Services Module) for this traffic flow. When this box is checked, the On CSC SSM Failure options become available. These options are applicable on ASA 7.1+ devices only; they are not applicable if TCP State Bypass is enabled.

 [bookmark: pgfId-10562]The CSC SSM provides protection against viruses, spyware, spam, and other unwanted traffic by scanning the FTP, HTTP, POP3, and SMTP packets.

  
        

 
         
         		[bookmark: pgfId-10568]On CSC SSM Failure

  
         		[bookmark: pgfId-10570]Specifies the action to take if the CSC SSM becomes inoperable:

 
           
           		 [bookmark: pgfId-10572] Open – Permits traffic if the CSC SSM fails.

 
           		 [bookmark: pgfId-10574] Close – Blocks traffic if the CSC SSM fails.

 
          

  
        

 
         
         		 
           
           [bookmark: pgfId-10580]User Statistics tab
          
  
        

 
         
         		[bookmark: pgfId-10588]Enable user statistics accounting (ASA 8.4(2)+ only)

  
         		[bookmark: pgfId-10590]Whether to collect user statistics accounting information for identity-based firewall policies. These statistics are kept for users to which a firewall policy is applied based on user name or user group membership. Select the type of information you want to collect:

 
           
           		 [bookmark: pgfId-10592] Account for sent drop count 

 
           		 [bookmark: pgfId-10594] Account for sent packet, sent drop and received packet count 

 
          

  
        

 
         
         		 
           
           [bookmark: pgfId-10600]ScanSafe Web Security tab
          
  
        

 
         
         		[bookmark: pgfId-10608]Enable Scansafe Web Security for this traffic (ASA 9.0+ only)

  
         		[bookmark: pgfId-10610]Enables or disables the use of ScanSafe Web Security for this traffic flow. When this box is checked, two options become available: These options are applicable on ASA 9.0+ devices only.

 
           
           		 [bookmark: pgfId-10612] ScanSafe Policy Map – enables policy map selection.

 
           		 [bookmark: pgfId-10614] On ScanSafe Tower Communication Failure – specifies action the system should take if ScanSafe Tower communication fails.

 
          

  
        

 
         
         		 
           
           [bookmark: pgfId-10620]NetFlow tab
          
  
        

 
         
         		[bookmark: pgfId-10628]Enable NetFlow for this traffic

  
         		[bookmark: pgfId-10630]Enables or disables the use of NetFlow for this traffic flow. When this box is checked, the NetFlow options become available.

  
        

 
         
         		[bookmark: pgfId-10636]Collectors

  
         		[bookmark: pgfId-10638]Specify the collectors that should be used when sending NetFlow events of a specific event type:

 [bookmark: pgfId-10640]Note Only use collectors that have been configured on the NetFlow page at Platform > Logging > NetFlow.

 
           
           		 [bookmark: pgfId-10642]Flow Create Event

 
           		 [bookmark: pgfId-10644]Flow Deny Event

 
           		 [bookmark: pgfId-10646]Flow Tear Event

 
           		 [bookmark: pgfId-10648]All Event Types

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-12635][bookmark: 130898][bookmark: pxchap_cncpt_AboutAIPSSM]About IPS Modules on ASA Devices[bookmark: marker-12627][bookmark: marker-12629][bookmark: marker-12631][bookmark: marker-12633]

 
     [bookmark: pgfId-12637]You can install a variety of IPS modules, such as the Advanced Inspection and Prevention Security Services Module (AIP-SSM), in some ASA device models. The IPS modules supported by each ASA model differ. The IPS modules run advanced IPS software that provides proactive, full-featured intrusion prevention services to stop malicious traffic, including worms and network viruses, before they can affect your network.

 
     [bookmark: pgfId-12639]The ASA IPS module runs separately from the adaptive security appliance, and you need to add it to the device inventory as a separate device. It is, however, integrated into the ASA traffic flow.

 
     [bookmark: pgfId-12644]When you configure the ASA IPS module, you need to configure the service policy rules on the host ASA as well as the IPS policies on the IPS module. The service policy rules determine which traffic is inspected by the IPS module. For an overview of IPS policy configuration, see Overview of IPS Configuration.

 
     [bookmark: pgfId-12646]When you identify traffic for IPS inspection, the traffic flows through the ASA and the IPS module as follows:

 
     [bookmark: pgfId-12648] 1. Traffic enters the ASA.

 
     [bookmark: pgfId-12650] 2. Firewall policies, such as interface access rules, are applied.

 
     [bookmark: pgfId-12652] 3. Traffic is sent to the IPS module over the backplane when you operate in inline mode. If you configure the system to use promiscuous mode, a copy of the traffic is sent to the IPS module.

 
     [bookmark: pgfId-12657]See IPS Mode in the Intrusion Prevention section of the Insert/Edit Service Policy (MPC) Rule wizard (Step 3. Configure the MPC actions) for more information about Inline and Promiscuous modes.

 
     [bookmark: pgfId-12659] 4. The IPS module applies its security policy to the traffic and takes appropriate actions.

 
     [bookmark: pgfId-12661] 5. Allowed traffic is sent back to the adaptive security appliance over the backplane. In Inline mode, the IPS module may block some traffic according to its security policy; in other words, that traffic is not passed back.

 
     [bookmark: pgfId-12663] 6. VPN policies are applied (if configured).

 
     [bookmark: pgfId-12665] 7. Traffic exits the ASA.

 
      
      [image: ] 
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     [bookmark: pgfId-12677]Related Topics

 
      
      		 [bookmark: pgfId-12682]Adding Devices to the Device Inventory

 
     

 
    
 
     
      [bookmark: pgfId-12692][bookmark: 130948][bookmark: pxchap_cncpt_CXSC]About the ASA CX [bookmark: marker-12688][bookmark: marker-12690]

 
     [bookmark: pgfId-12694]The ASA CX is a Security Services Processor (SSP) that can be installed in the Cisco ASA-5585-X series Adaptive Security Appliance. You configure the parent ASA to redirect traffic to the ASA CX, which then applies its security policies and either drops the traffic, or returns it to the ASA for further processing and routing to the next destination.

 
     [bookmark: pgfId-12696]There are two basic policies that may need adjustment in the ASA when you add a ASA CX: access rules and inspection rules:

 
      
      		 [bookmark: pgfId-12698]Access rules, whether global rules or those applied to specific interfaces, are always applied before traffic is redirected to the ASA CX. Thus, the security card sees only the traffic already permitted, and does not process traffic that was dropped at entry to the ASA. Consider adjusting the rules to ensure that all traffic that you want the ASA CX to process is permitted.

 
      		 [bookmark: pgfId-12700]Inspection rules determine which traffic is inspected. The ASA CX does not inspect traffic that has already been inspected by the ASA. Therefore, you must ensure that you do not inspect traffic that you intend the ASA CX to inspect. Specifically, do not inspect HTTP traffic, because HTTP inspection is one of the core functions of the ASA CX. The default inspection rules on the ASA do not include HTTP inspection, so you must alter your inspection rules only if you added HTTP rules.

 
     

 
     [bookmark: pgfId-12702]Determine if you need to create access rules for an interface, or global access rules that apply to all interfaces. Use the ASA access rules to filter traffic before it is redirected to the ASA CX. If you know there are classes of traffic that you never want to pass, it is more efficient to drop them immediately upon entry to the ASA.

 
     [bookmark: pgfId-12704]If you have already established access rules, there is no requirement to change them. However, you should evaluate whether they need to be relaxed in order to have the ASA CX process certain types of traffic that you are now dropping by means of access rules.

 
     [bookmark: pgfId-12712]Enabling traffic redirection to an installed ASA CX is described in Step 3. Configure the MPC actions of the Insert/Edit Service Policy (MPC) Rule Wizard.

 
     [bookmark: pgfId-12714]Related Topics

 
      
      		 [bookmark: pgfId-12719]About Service Policy Rules

 
     

 
    
 
     
      [bookmark: pgfId-12735][bookmark: 130977][bookmark: pxchap_cncpt_MPCAdvancedConfiguration]ASA CX Auth Proxy Configuration [bookmark: marker-12727][bookmark: marker-12729][bookmark: marker-12731][bookmark: marker-12733]

 
     [bookmark: pgfId-12740]If you enabled ASA CX authentication proxy—on the CXSC tab during Step 3 of the Insert/Edit Service Policy (MPC) Rule Wizard; see Step 3. Configure the MPC actions—and you want to use a non-default port for active authentication, use the Add/Edit CXSC Auth Proxy Configuration dialog box to change the ASA CX Auth Proxy Port number.

 
     [bookmark: pgfId-12742]If users must be prompted for authentication credentials, the prompting is done through this port.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-12744]Note Security Manager uses “CXSC” in some places to refer to an ASA CX Security Services Processor (SSP).


     
      

     

     

 
     [bookmark: pgfId-12746]Navigation Path

 
     [bookmark: pgfId-12751]Open the Add/Edit CXSC Auth Proxy Configuration dialog box by clicking the CXSC Auth Proxy button below the rules table on the Service Policy Rules Page.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-12753]Note The CXSC Auth Proxy button is available below the IPS, QoS, and Connection Rules table only in Device view; it is not visible in Policy view.


     
      

     

     

 
     [bookmark: pgfId-12755]Related Topics

 
      
      		 [bookmark: pgfId-12760]Service Policy Rules Page

 
     

 
     [bookmark: pgfId-12762]Field Reference

 
     [bookmark: pgfId-12765] 

 
      
       
        
        [bookmark: pgfId-10661]Table 57-4 [bookmark: 131015]Add/Edit CXSC Auth Proxy Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-10667]Element
          
  
         		
           
           [bookmark: pgfId-10669]Description
          
  
        

 
         
         		[bookmark: pgfId-10675]CXSC Auth Proxy Port

  
         		[bookmark: pgfId-10677]The default authentication proxy TCP port is 885; however, if you change it, you must enter a port number between 1024 and 65535.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-12797][bookmark: 131032][bookmark: pobjpage_cncpt_AddandEditTrafficFlowDialogBoxes]Configuring Traffic Flow Objects[bookmark: marker-12787][bookmark: marker-12789][bookmark: marker-12791][bookmark: marker-12793][bookmark: marker-12795]

 
    [bookmark: pgfId-12802]Use the Add and Edit Traffic Flow dialog boxes to configure traffic-match definitions. These traffic-flow definitions correspond to class maps (the class map command) in the IPS, QoS and Connection Rules service policy for devices running the PIX 7.0+, ASA 7.0+, and FWSM 3.2+ operating systems. For more information on configuring these rules, see Chapter 57, “Configuring Service Policy Rules on Firewall Devices”.

 
    [bookmark: pgfId-12804]Navigation Path

 
    [bookmark: pgfId-12806]Select Manage > Policy Objects, then select Traffic Flows from the Object Type selector. Right-click inside the work area and choose New Object, or right-click a row and choose Edit Object.

 
    [bookmark: pgfId-12811]These dialog boxes also can be opened by clicking the Create or Edit buttons in the Traffic Flows Selector while defining a Service Policy rule. See for Step 2. Configure the traffic class more information about selecting a Traffic Flow class.

 
    [bookmark: pgfId-12813]Related Topics

 
     
     		 [bookmark: pgfId-12818]Creating Access Control List Objects

 
    

 
    [bookmark: pgfId-12820]Field Reference

 
    [bookmark: pgfId-12823] 

 
     
      
       
       [bookmark: pgfId-10690]Table 57-5 [bookmark: 131077]Add and Edit Traffic Flow Dialog Boxes 

 
       
      
        
        		
          
          [bookmark: pgfId-10696]Element
         
  
        		
          
          [bookmark: pgfId-10698]Description
         
  
       

 
        
        		[bookmark: pgfId-10704]Name

  
        		[bookmark: pgfId-10706]The name of the Traffic Flow object. A maximum of 40 characters is allowed. The name space for class maps is local to a security context. Therefore, the same name may be used in multiple security contexts. The maximum number of class maps per security context is 255.

  
       

 
        
        		[bookmark: pgfId-10712]Description

  
        		[bookmark: pgfId-10714]A description of the Traffic Flow (optional). A maximum of 1024 characters is allowed.

  
       

 
        
        		[bookmark: pgfId-10720]Traffic Match Type

  
        		[bookmark: pgfId-10722]The type of traffic to match. The option you choose may change the fields in the dialog box; all possible fields are explained later in this table. The Traffic Match Type options are:

 
          
          		 [bookmark: pgfId-10724]Any Traffic – Matches all traffic.

 
          		 [bookmark: pgfId-10726]Source and Destination IP Address (access-list) – Matches the source and destination IP addresses in a packet based on the access control list that you specify.

 
         

 [bookmark: pgfId-10728]For ASA 8.4(2+) devices, the ACL can include FQDN objects and user specifications to perform identity-based traffic matching.

 
          
          		 [bookmark: pgfId-10733]Default Inspection Traffic – Matches default inspection traffic. For a list of default settings, see Default Inspection Traffic.

 
          		 [bookmark: pgfId-10735]Default Inspection Traffic with access list – Matches default inspection traffic limited by the access control list that you specify.

 
          		 [bookmark: pgfId-10737]TCP or UDP Destination Port – Matches traffic to the TCP or UDP destination port or port range that you specify. Valid port numbers here are 0 to 65535.

 
          		 [bookmark: pgfId-10739]RTP Range – Matches traffic to the range of UDP destination ports that you specify. Valid port numbers here are 2000 to 65535.

 
          		 [bookmark: pgfId-10741]Tunnel Group – Matches the destination address based on flows in VPN tunnels belonging to a specified tunnel group.

 
          		 [bookmark: pgfId-10743]IP Precedence Bits – Matches precedence values assigned to the traffic packets. You can select a maximum of four values.

 
          		 [bookmark: pgfId-10745]IP DiffServe Code Points (DSCP) Values – Matches DSCP values associated with the traffic packets. You can select a maximum of eight values.

 
         

  
       

 
        
        		 [bookmark: pgfId-10751]Variable Fields

 [bookmark: pgfId-10753]The following fields may appear in the Add and Edit Traffic Flow dialog boxes, depending on your choice in the Traffic Match Type field. This list is the complete set of possible fields.

  
       

 
        
        		[bookmark: pgfId-10761]Available ACLs

  
        		[bookmark: pgfId-10766]A list of the access control list (ACL) objects that you can select for the map. Select the ACL that defines the target traffic, or click the Create button to add a new object. You can also select an object and click Edit to change its definition. If the list of objects is large, use the Filter field to limit the display (see Filtering Items in Selectors).

  
       

 
        
        		[bookmark: pgfId-10772]TCP or UDP

 [bookmark: pgfId-10774]TCP/UDP Port or Port Range

  
        		[bookmark: pgfId-10776]Radio buttons used to specify a protocol (either TCP or UDP), and a text field used to specify a destination port number or range of numbers to use when matching traffic based on the specified protocol/ports.

 [bookmark: pgfId-10778]You can specify a single port value, or a range of port numbers (for example, 0-2000). Valid port numbers are 0 to 65535.

  
       

 
        
        		[bookmark: pgfId-10784]RTP Port Range

  
        		[bookmark: pgfId-10786]The range of RTP destination ports associated with the traffic flow. You must enter a port range within the valid range of 2000 to 65535.

 [bookmark: pgfId-10788]Note When you close the dialog box, the port range you entered is converted to port-span values by subtracting the start value from the end value. For example, if you enter the range 2001-3000 in the dialog box, “RTP port 2001 range 999” appears in the Match Value column of the Traffic Flows policy object table. Port-span values are expected by the device.

  
       

 
        
        		[bookmark: pgfId-10794]Tunnel group name

 [bookmark: pgfId-10796]Match Flow IP Destination Address

  
        		[bookmark: pgfId-10798]Lists available VPN tunnel groups. Choose one or enter the name of a group. You can also select Match Flow IP Destination Address to recognize the destination address as the match type.

 [bookmark: pgfId-10803]Tip You can use FlexConfig objects and policies to define a VPN tunnel group on a PIX 7.0+ device. For more information, see Understanding FlexConfig Policies and Policy Objects.  
       

 
        
        		[bookmark: pgfId-10809]Available IP Precedence

 [bookmark: pgfId-10811]Match on IP Precedence

  
        		[bookmark: pgfId-10813]The IP precedence numbers. Select the values you want to match and click >> to add them to the Match table. Ctrl-click to select multiple values. You can select a maximum of four values.

 [bookmark: pgfId-10815]To remove a value from the Match table, select it and click <<.

  
       

 
        
        		[bookmark: pgfId-10821]Available DSCP Values

 [bookmark: pgfId-10823]Match on DSCP

  
        		[bookmark: pgfId-10825]The IP DiffServe Code Points (DSCP) numbers. Select the values you want to match and click >> to add them to the Match table. Ctrl-click to select multiple values. You can select a maximum of eight values.

 [bookmark: pgfId-10827]To remove a value from the Match table, select it and click <<.

  
       

 
        
        		[bookmark: pgfId-10833]Category

  
        		[bookmark: pgfId-10838]The category assigned to the traffic-flow object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-12835][bookmark: 131180][bookmark: pobjpage_cncpt_DefaultInspectionTraffic]Default Inspection Traffic [bookmark: marker-12829][bookmark: marker-12831][bookmark: marker-12833]

 
     [bookmark: pgfId-12840]When you create a Traffic Flow policy object, you can choose to match the default inspection traffic. For more information, see Configuring Traffic Flow Objects. The following table lists the types of traffic included in the Default Inspection Traffic category.

 
     [bookmark: pgfId-12843] 

 
      
       
        
        [bookmark: pgfId-10855]Table 57-6 [bookmark: 131198]Default Inspection Traffic 

 
        
       
         
         		
           
           [bookmark: pgfId-10865]Value
          
  
         		
           
           [bookmark: pgfId-10867]Port
          
  
         		
           
           [bookmark: pgfId-10869]NAT Limitations
          
  
         		
           
           [bookmark: pgfId-10871]Comments
          
  
        

 
         
         		[bookmark: pgfId-10881]CTIQBE

  
         		[bookmark: pgfId-10883]TCP/2748

  
         		[bookmark: pgfId-10885] 

  
         		[bookmark: pgfId-10887] 

  
        

 
         
         		[bookmark: pgfId-10897]CuSeeMe

  
         		[bookmark: pgfId-10899]UDP/7648

  
         		[bookmark: pgfId-10901] 

  
         		[bookmark: pgfId-10903] 

  
        

 
         
         		[bookmark: pgfId-10913]DNS over UDP

  
         		[bookmark: pgfId-10915]UDP/53

  
         		[bookmark: pgfId-10917]No NAT support for name resolution through WINS.

  
         		[bookmark: pgfId-10919]No PTR records are changed.

  
        

 
         
         		[bookmark: pgfId-10929]FTP

  
         		[bookmark: pgfId-10931]TCP/21

  
         		[bookmark: pgfId-10933] 

  
         		[bookmark: pgfId-10935] 

  
        

 
         
         		[bookmark: pgfId-10945]GTP

  
         		[bookmark: pgfId-10947]UDP/2123, 3386

  
         		[bookmark: pgfId-10949] 

  
         		[bookmark: pgfId-10951] 

  
        

 
         
         		[bookmark: pgfId-10961]H.323, H.225

  
         		[bookmark: pgfId-10963]TCP/1720, 1718

  
         		[bookmark: pgfId-10965]No NAT on same security interfaces. No static PAT.

  
         		[bookmark: pgfId-10967] 

  
        

 
         
         		[bookmark: pgfId-10977]RAS

  
         		[bookmark: pgfId-10979]UDP/1718, 1719

  
         		[bookmark: pgfId-10981]No NAT on same security interfaces. No static PAT.

  
         		[bookmark: pgfId-10983] 

  
        

 
         
         		[bookmark: pgfId-10993]HTTP

  
         		[bookmark: pgfId-10995]TCP/80

  
         		[bookmark: pgfId-10997] 

  
         		[bookmark: pgfId-10999] 

  
        

 
         
         		[bookmark: pgfId-11009]ICMP

  
         		[bookmark: pgfId-11011]—

  
         		[bookmark: pgfId-11013] 

  
         		[bookmark: pgfId-11015]All ICMP traffic is matched in the default class map.

  
        

 
         
         		[bookmark: pgfId-11025]ILS (LDAP)

  
         		[bookmark: pgfId-11027]TCP/389

  
         		[bookmark: pgfId-11029]No PAT.

  
         		[bookmark: pgfId-11031] 

  
        

 
         
         		[bookmark: pgfId-11041]IP Options

  
         		[bookmark: pgfId-11043]—

  
         		[bookmark: pgfId-11045] 

  
         		[bookmark: pgfId-11047]All IP Options traffic is matched in the default class map.

  
        

 
         
         		[bookmark: pgfId-11057]MGCP

  
         		[bookmark: pgfId-11059]UDP/2427, 2727

  
         		[bookmark: pgfId-11061] 

  
         		[bookmark: pgfId-11063] 

  
        

 
         
         		[bookmark: pgfId-11073]NETBIOS Name Server

  
         		[bookmark: pgfId-11075]UDP/137, 138 (Source ports)

  
         		[bookmark: pgfId-11077] 

  
         		[bookmark: pgfId-11079]NetBIOS is supported by performing NAT of the packets for NBNS UDP port 137 and NBDS UDP port 138.

  
        

 
         
         		[bookmark: pgfId-11089]RSH

  
         		[bookmark: pgfId-11091]TCP/514

  
         		[bookmark: pgfId-11093]No PAT.

  
         		[bookmark: pgfId-11095] 

  
        

 
         
         		[bookmark: pgfId-11105]RTSP

  
         		[bookmark: pgfId-11107]TCP/554

  
         		[bookmark: pgfId-11109]No PAT. No outside NAT.

  
         		[bookmark: pgfId-11111]No handling for HTTP cloaking.

  
        

 
         
         		[bookmark: pgfId-11121]SIP

  
         		[bookmark: pgfId-11123]TCP/5060; UDP/5060

  
         		[bookmark: pgfId-11125]No outside NAT. No NAT on same security interfaces.

  
         		[bookmark: pgfId-11127] 

  
        

 
         
         		[bookmark: pgfId-11137]Skinny Client Control Protocol (SCCP)

  
         		[bookmark: pgfId-11139]TCP/2000

  
         		[bookmark: pgfId-11141]No outside NAT. No NAT on same security interfaces.

  
         		[bookmark: pgfId-11143] 

  
        

 
         
         		[bookmark: pgfId-11153]SMTP and ESMTP

  
         		[bookmark: pgfId-11155]TCP/25

  
         		[bookmark: pgfId-11157] 

  
         		[bookmark: pgfId-11159] 

  
        

 
         
         		[bookmark: pgfId-11169]SQL*Net

  
         		[bookmark: pgfId-11171]TCP/1521

  
         		[bookmark: pgfId-11173] 

  
         		[bookmark: pgfId-11175]Versions 1 and 2.

  
        

 
         
         		[bookmark: pgfId-11185]Sun RPC over UDP

  
         		[bookmark: pgfId-11187]UDP/111

  
         		[bookmark: pgfId-11189]No NAT or PAT.

  
         		[bookmark: pgfId-11191]The default rule includes UDP port 111; if you want to enable Sun RPC inspection for TCP port 111, you need to create a new rule that matches TCP port 111 and performs Sun RPC inspection.

  
        

 
         
         		[bookmark: pgfId-11201]TFTP

  
         		[bookmark: pgfId-11203]UDP/69

  
         		[bookmark: pgfId-11205] 

  
         		[bookmark: pgfId-11207]Payload IP addresses are not translated.

  
        

 
         
         		[bookmark: pgfId-11217]XDMCP

  
         		[bookmark: pgfId-11219]UDP/177

  
         		[bookmark: pgfId-11221]No NAT or PAT.

  
         		[bookmark: pgfId-11223] 

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-12863][bookmark: 131438][bookmark: pobjpage_cncpt_AddandEditTCPMapDialogBoxes]Configuring TCP Maps[bookmark: marker-12851][bookmark: marker-12853][bookmark: marker-12855][bookmark: marker-12857][bookmark: marker-12859][bookmark: marker-12861]

 
    [bookmark: pgfId-12865]Use the Add and Edit TCP Map dialog boxes to define TCP normalization maps for use with IPS, QoS, and Connection Rules service policies. The TCP normalization feature lets you specify criteria that identify abnormal packets, which the security appliance drops when they are detected. The map is used for TCP traffic that passes through the device or that is going to the device.

 
    [bookmark: pgfId-12870]These TCP maps can be applied to TCP flows on PIX 7.x+ and ASA devices. For more information on configuring IPS, QoS, and Connection Rules, see Chapter 57, “Configuring Service Policy Rules on Firewall Devices”.

 
    [bookmark: pgfId-12872]Navigation Path

 
    [bookmark: pgfId-12874]Select Manage > Policy Objects, then select Maps > TCP Maps from the Object Type selector. Right-click inside the work area and choose New Object, or right-click a row and choose Edit Object.

 
    [bookmark: pgfId-12879]These dialog boxes also can be opened by clicking the Create or Edit buttons in the TCP Maps Selector while defining a Service Policy rule. See the “Connection Settings” section of Step 3. Configure the MPC actions for more information about enabling TCP normalization and selecting a TCP map.

 
    [bookmark: pgfId-12881]Related Topics

 
     
     		 [bookmark: pgfId-12886]Understanding Map Objects

 
    

 
    [bookmark: pgfId-12888]Field Reference

 
    [bookmark: pgfId-12891] 

 
     
      
       
       [bookmark: pgfId-11236]Table 57-7 [bookmark: 131480]Add and Edit TCP Map Dialog Boxes 

 
       
      
        
        		
          
          [bookmark: pgfId-11242]Element
         
  
        		
          
          [bookmark: pgfId-11244]Description
         
  
       

 
        
        		[bookmark: pgfId-11250]Name

  
        		[bookmark: pgfId-11252]The name of the TCP normalization map. A maximum of 128 characters is allowed.

  
       

 
        
        		[bookmark: pgfId-11258]Description

  
        		[bookmark: pgfId-11260]A description of the map object. A maximum of 1024 characters is allowed.

  
       

 
        
        		[bookmark: pgfId-11266]Queue Limit

 [bookmark: pgfId-11268](ASA devices only)

  
        		[bookmark: pgfId-11270]The maximum number of out-of-order packets that can be buffered and put in order for a TCP connection; enter a value between 1 and 250. Enter 0 to disable this setting and use the default system queue limit, which depends on the type of traffic:

 
          
          		 [bookmark: pgfId-11272]Connections for application inspection, IPS, and TCP check-retransmission have a queue limit of 3 packets. If the security appliance receives a TCP packet with a different window size, then the queue limit is dynamically changed to match the advertised setting.

 
          		 [bookmark: pgfId-11274]For other TCP connections, out-of-order packets are passed through untouched.

 
         

 [bookmark: pgfId-11276]However, if you set the Queue Limit to 1 or higher, the number of out-of-order packets allowed for all TCP traffic matches the specified value. For application inspection, IPS, and TCP check-retransmission traffic, any advertised settings are ignored. For other TCP traffic, out-of-order packets are now buffered and put in order instead of passed through untouched.

  
       

 
        
        		[bookmark: pgfId-11282]Time Out

 [bookmark: pgfId-11284](ASA 7.2(4)+ devices only)

  
        		[bookmark: pgfId-11286]The maximum amount of time that out-of-order packets can remain in the buffer before they are dropped; enter a value between 1 and 20 seconds. The default is 4 seconds.

 [bookmark: pgfId-11288]This setting is ignored if you entered 0 for the Queue Limit.

  
       

 
        
        		[bookmark: pgfId-11294]Verify TCP Checksum

  
        		[bookmark: pgfId-11296]If checked, checksum verification is enabled.

  
       

 
        
        		[bookmark: pgfId-11302]Drop SYN Packets with Data

  
        		[bookmark: pgfId-11304]If checked, TCP SYN packets that include data are dropped.

  
       

 
        
        		[bookmark: pgfId-11310]Drop Connection on Window Variation

  
        		[bookmark: pgfId-11312]If checked, connections that change window size unexpectedly are dropped.

  
       

 
        
        		[bookmark: pgfId-11318]Drop Packets that Exceed Maximum Segment Size

  
        		[bookmark: pgfId-11320]If checked, packets that exceed the maximum segment size (MSS) set by a peer are dropped.

  
       

 
        
        		[bookmark: pgfId-11326]Check if Transmitted Data is the Same as Original

  
        		[bookmark: pgfId-11328]If checked, retransmit data checking is enabled.

  
       

 
        
        		[bookmark: pgfId-11334]Clear Urgent Flag

  
        		[bookmark: pgfId-11336]If checked, the URG (urgent) flag is cleared through the security appliance. The URG flag is used to indicate that the packet contains information that is of higher priority than other data within the stream. The TCP RFC is vague about the exact interpretation of the URG flag; therefore end systems handle urgent offsets in different ways, which may make the end system vulnerable.

  
       

 
        
        		[bookmark: pgfId-11342]Clear Selective Ack

  
        		[bookmark: pgfId-11344]Whether the selective acknowledgment mechanism (SACK) option is cleared or allowed.

  
       

 
        
        		[bookmark: pgfId-11350]Clear TCP Timestamp

  
        		[bookmark: pgfId-11352]Whether the timestamp option, which disables PAWS and RTT, is cleared or allowed.

  
       

 
        
        		[bookmark: pgfId-11358]Clear Window Scale

  
        		[bookmark: pgfId-11360]Whether the window scale timestamp option is cleared or allowed.

  
       

 
        
        		[bookmark: pgfId-11366]Enable TTL Evasion Protection

  
        		[bookmark: pgfId-11368]Enables the TTL evasion protection offered by the security appliance. Do not enable this option if you want to prevent attacks that attempt to evade security policy.

 [bookmark: pgfId-11370]For example, an attacker can send a packet that passes policy with a very short TTL. When the TTL goes to zero, a router between the security appliance and the endpoint drops the packet. It is at this point that the attacker can send a malicious packet with a long TTL that appears to the security appliance to be a retransmission and is passed. To the endpoint host, however, it is the first packet that has been received. In this case, an attacker is able to succeed without security preventing the attack.

  
       

 
        
        		[bookmark: pgfId-11376]Reserved Bits

  
        		[bookmark: pgfId-11378]Specify how to handle TCP packets with the reserved bits set in the TCP header. The six reserved bits in the TCP header are for future use and usually have a value of 0.

 
          
          		 [bookmark: pgfId-11380]Clear and Allow—Clears the reserved bits in the TCP header and allows the packet.

 
          		 [bookmark: pgfId-11382]Allow only—Permits packets with the reserved bits set in the TCP header.

 
          		 [bookmark: pgfId-11384]Drop—Drops packets with the reserved bits set in the TCP header.

 
         

  
       

 
        
        		[bookmark: pgfId-11390]TCP Range Options table

  
        		[bookmark: pgfId-11392]The TCP Range Options table lists TCP options ranges defined for the TCP map, and the action to take for those options. The typical range numbers are 6-7 and 9-255; the lower bound must be less than or equal to the upper bound.

 
          
          		 [bookmark: pgfId-11397]To add a range, click the Add button to open the Add TCP Option Range dialog box (see Add and Edit TCP Option Range Dialog Boxes).

 
          		 [bookmark: pgfId-11399]To edit a range, select it and click the Edit button.

 
          		 [bookmark: pgfId-11401]To delete a range, select it and click the Delete button.

 
         

  
       

 
        
        		[bookmark: pgfId-11407]Category

  
        		[bookmark: pgfId-11412]The category assigned to the map object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-12903][bookmark: 131601][bookmark: pobjpage_cncpt_AddandEditTCPOptionRangeDialogBoxes]Add and Edit TCP Option Range Dialog Boxes[bookmark: marker-12899][bookmark: marker-12901]

 
     [bookmark: pgfId-12905]Use the Add and Edit TCP Option Range dialog boxes to define or edit a range of TCP options for use with a TCP normalization map; these are TCP options not explicitly supported on the device. This feature lets you allow or discard packets with the specified TCP options set. The typical range numbers are 6-7 and 9-255.

 
     [bookmark: pgfId-12907]Navigation Path

 
     [bookmark: pgfId-12912]In the Add and Edit TCP Map dialog boxes, right-click inside the TCP Range Options table and choose Add Row, or right-click an existing row and choose Edit Row. See Configuring TCP Maps.

 
     [bookmark: pgfId-12914]Field Reference

 
     [bookmark: pgfId-12917] 

 
      
       
        
        [bookmark: pgfId-11425]Table 57-8 [bookmark: 131617]Add and Edit TCP Option Range Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-11431]Element
          
  
         		
           
           [bookmark: pgfId-11433]Description
          
  
        

 
         
         		[bookmark: pgfId-11439]Lower

  
         		[bookmark: pgfId-11441]The lower bound of the range; enter either 6 or 7, or an integer from 9 to 255.

 [bookmark: pgfId-11443]Note The Lower bound must be less than or equal to the Upper bound.

  
        

 
         
         		[bookmark: pgfId-11449]Upper

  
         		[bookmark: pgfId-11451]The upper bound of the range; enter either 6 or 7, or an integer from 9 to 255.

  
        

 
         
         		[bookmark: pgfId-11457]Action

  
         		[bookmark: pgfId-11459]Choose the action to take for packets with the specified options set:

 
           
           		 [bookmark: pgfId-11461]Allow – Allows any packet with a specified option set.

 
           		 [bookmark: pgfId-11463]Clear – Clears the specified option from any packet that has it set and allows the packet.

 
           		 [bookmark: pgfId-11465]Drop – Discards any packet with a specified option set.
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     [bookmark: pgfId-414828][bookmark: 82802][bookmark: ravpnch_cncpt_ManagingDynamicAccessPolicies]Managing Dynamic Access Policies for Remote Access VPNs (ASA 8.0+ Devices)[bookmark: marker-414812][bookmark: marker-414814][bookmark: marker-414816][bookmark: marker-414818][bookmark: marker-414820][bookmark: marker-414822][bookmark: marker-414824][bookmark: marker-414826]
      
      
 
     
 

 
    [bookmark: pgfId-414830]This chapter explains Dynamic Access Policies (DAP) for assigning remote access users to connection profiles (tunnel groups). You can configure these policies for remote access IKEv1 IPsec on ASA 8.0+ devices, IKEv2 IPsec on ASA 8.4(x) devices, and SSL VPNs on ASA 8.0+ (except 8.5) devices.

 
    [bookmark: pgfId-414835]For information on configuring other remote access policies for ASA and PIX 7.0+ devices, see Chapter 31, “Managing Remote Access VPNs on ASA and PIX 7.0+ Devices”.

 
    [bookmark: pgfId-414837]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-414842]Understanding Dynamic Access Policies

 
     		 [bookmark: pgfId-414847]Configuring Dynamic Access Policies

 
     		 [bookmark: pgfId-414852]Dynamic Access Page (ASA)

 
    

 
   
 
    
     [bookmark: pgfId-414874][bookmark: 82838][bookmark: ravpnch_cncpt_UnderstandingDynamicAccessPolicies]Understanding Dynamic Access Policies[bookmark: marker-414858][bookmark: marker-414860][bookmark: marker-414862][bookmark: marker-414864][bookmark: marker-414866][bookmark: marker-414868][bookmark: marker-414870][bookmark: marker-414872]

 
    [bookmark: pgfId-414876]Multiple variables can affect each VPN connection, for example, intranet configurations that frequently change, the various roles each user may inhabit within an organization, and logins from remote access sites with different configurations and levels of security. The task of authorizing users is much more complicated in a VPN environment than it is in a network with a static configuration.

 
    [bookmark: pgfId-414878]Dynamic access policies (DAP) on a security appliance let you configure authorization that addresses these many variables. You create a dynamic access policy by setting a collection of access control attributes that you associate with a specific user tunnel or session. These attributes address issues of multiple group membership and endpoint security. That is, the security appliance grants access to a particular user for a particular session based on the policies you define. It generates a DAP at the time the user connects by selecting and/or aggregating attributes from one or more DAP records. It selects these DAP records based on the endpoint security information of the remote device and the AAA authorization information for the authenticated user. It then applies the DAP record to the user tunnel or session. The DAP system includes the following components that require your attention:

 
     
     		 [bookmark: pgfId-414880]DAP Selection Configuration File—A text file containing criteria that the security appliance uses for selecting and applying DAP records during session establishment. It is stored on the security appliance. You can use Security Manager to modify it and upload it to the security appliance in XML data format. DAP selection configuration files include all of the attributes that you configure. These can include AAA attributes, endpoint attributes, and access policies as configured in network and web-type ACL filter, port forwarding, and URL lists.

 
     		 [bookmark: pgfId-414882]DfltAccess Policy—Always the last entry in the DAP summary table, always with a priority of 0. You can configure Access Policy attributes for the default access policy, but it does not contain—and you cannot configure—AAA or endpoint attributes. You cannot delete the DfltAccessPolicy, and it must be the last entry in the summary table.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-414884]Tip Dynamic Access policies take precedence over Group policies. If a setting is not specified in a Dynamic Access policy, an ASA device checks for Group policies that specify the setting.


    
     

    

    

 
    [bookmark: pgfId-414886]Integration of Cisco Secure Desktop with DAP

 
    [bookmark: pgfId-414888]The security appliance integrates the Cisco Secure Desktop (CSD) features into dynamic access policies (DAPs). Depending on the configuration, the security appliance uses one or more endpoint attribute values in combination with optional, AAA attribute values as conditions for assigning a DAP. The Cisco Secure Desktop features supported by the endpoint attributes of DAPs include OS detection, prelogin policies, Basic Host Scan results, and Endpoint Assessment.

 
    [bookmark: pgfId-414890]As an administrator, you can specify a single attribute or combine attributes that together form the conditions required to assign a DAP to a session. The DAP provides network access at the level that is appropriate for the endpoint AAA attribute value. The security appliance applies a DAP when all of its configured endpoint criteria are satisfied.

 
    [bookmark: pgfId-414892]Related Topics

 
     
     		 [bookmark: pgfId-414897]Configuring Dynamic Access Policies

 
     		 [bookmark: pgfId-414902]Configuring DAP Attributes

 
    

 
   
 
    
     [bookmark: pgfId-414924][bookmark: 82893][bookmark: ravpnch_proc_ConfiguringDynamicAccessPolicies]Configuring Dynamic Access Policies[bookmark: marker-414908][bookmark: marker-414910][bookmark: marker-414912][bookmark: marker-414914][bookmark: marker-414916][bookmark: marker-414918][bookmark: marker-414920][bookmark: marker-414922]

 
    [bookmark: pgfId-414926]This procedure describes how to create or edit a dynamic access policy.

 
    [bookmark: pgfId-414928]Related Topics

 
     
     		 [bookmark: pgfId-414933]Understanding Dynamic Access Policies

 
     		 [bookmark: pgfId-414938]Understanding DAP Attributes

 
     		 [bookmark: pgfId-414943]Configuring Cisco Secure Desktop Policies on ASA Devices

 
    

 
    
 
    [bookmark: pgfId-414945]Step 1 Do one of the following:

 
     
     		 [bookmark: pgfId-414947](Device view) With an ASA device selected, select  Remote Access VPN > Dynamic Access from the Policy selector.

 
     		 [bookmark: pgfId-414949](Policy view) Select  Remote Access VPN > Dynamic Access (ASA) from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-414954]The Dynamic Access page opens. For a description of the elements on this page, see Dynamic Access Page (ASA).

 
    [bookmark: pgfId-414956]Step 2 Click Create or select a policy in the table and click Edit.

 
    [bookmark: pgfId-414961]The Add/Edit Dynamic Access Policy dialog box opens, with the Main tab open by default. For a description of the elements in this dialog box, see Table 32-4.

 
    [bookmark: pgfId-414963]Step 3 Enter the name of the DAP record (up to 128 characters).

 
    [bookmark: pgfId-414965]Step 4 Specify a priority for the DAP record. The security appliance applies access policies in the order you set here, highest number having the highest priority.

 
    [bookmark: pgfId-414967]Step 5 Enter a description for the DAP record.

 
    [bookmark: pgfId-414972]Step 6 In the Main tab, configure the DAP attributes and the type of remote access method supported by the DAP system on your security appliance. For a detailed description of the elements on this tab, see Table 32-5.

 
    [bookmark: pgfId-414977] a. Click Create below the table, or select a DAP entry in the table and click Edit. The Add/Edit DAP Entry dialog box opens. For a description of the elements on this dialog box, see Add/Edit DAP Entry Dialog Box.

 
    [bookmark: pgfId-414982]For a full description of the procedure to define the DAP attributes, see Configuring DAP Attributes.

 
    [bookmark: pgfId-414984] b. Select the type of remote access permitted by the DAP system.

 
    [bookmark: pgfId-414986] c. Select the Network ACL tab to select and configure network ACLs to apply to this DAP record.

 
    [bookmark: pgfId-414988]This tab is available only if you selected an access method other than Web Portal.

 
    [bookmark: pgfId-414990] d. Select the WebType ACL tab to select and configure Web-type ACLs to apply to this DAP record.

 
    [bookmark: pgfId-414992]This tab is available only if you selected an access method other than AnyConnect Client.

 
    [bookmark: pgfId-414994] e. Select the Functions tab to configure file server entry and browsing, HTTP proxy, and URL entry for the DAP record.

 
    [bookmark: pgfId-414996]This tab is available only if you selected an access method other than AnyConnect Client.

 
    [bookmark: pgfId-414998] f. Select the Port Forwarding tab to select and configure port forwarding lists for user sessions.

 
    [bookmark: pgfId-415000]This tab is available only if you selected an access method other than AnyConnect Client.

 
    [bookmark: pgfId-415002] g. Select the URL List tab to select and configure URL lists for user sessions.

 
    [bookmark: pgfId-415004]This tab is available only if you selected an access method other than AnyConnect Client.

 
    [bookmark: pgfId-415006] h. Select the Action tab to configure the type of remote access permitted.

 
    [bookmark: pgfId-415008]This tab is available for all types of access methods.

 
    [bookmark: pgfId-415010] i. Select the AnyConnect tab to choose if the setting for Always-On VPN on the AnyConnect service profile remains unchanged, is disabled, or the AnyConnect Profile Setting must be used. Always-On VPN enables AnyConnnect to automatically establish a VPN session after you log onto the system.

 
    [bookmark: pgfId-415012] j. Select the Custom Attributes tab to add AnyConnect Custom Attributes.

 
    [bookmark: pgfId-415017]This tab is available only if you selected the access method as Unchanged, AnyConnect Client, Both Default Web Portal, or Both Default Anyconnect Client. For information about how to add AnyConnect Custom Attributes, see Add/Edit AnyConnect Custom Attribute Dialog Box.

 
    [bookmark: pgfId-415022]Step 7 Select the Logical Operators tab to create multiple instances of each type of endpoint attribute. For a description of the elements on this tab, see Table 32-21.

 
    [bookmark: pgfId-415027]Step 8 Select the Advanced Expressions tab to set additional attributes for the DAP using free-form LUA. For a description of the elements on this tab, see Table 32-22.

 
    [bookmark: pgfId-415029]Step 9 Click OK.

 
    [bookmark: pgfId-415031]


    
     

    
 
    

 
     
      [bookmark: pgfId-415053][bookmark: 83022][bookmark: ravpnch_cncpt_UnderstandingDAPAttributes]Understanding DAP Attributes[bookmark: marker-415037][bookmark: marker-415039][bookmark: marker-415041][bookmark: marker-415043][bookmark: marker-415045][bookmark: marker-415047][bookmark: marker-415049][bookmark: marker-415051]

 
     [bookmark: pgfId-415055]DAP records include all of the attributes that you configure. These can include AAA attributes, endpoint attributes, and access policies as configured in network and web-type ACL filter, port forwarding and URL lists.

 
     [bookmark: pgfId-415059]DAP and AAA Attributes[bookmark: ravpnch_cncpt_UnderstandingDAPAttributes_aaa_def]

 
     [bookmark: pgfId-415061]DAP complements AAA services. It provides a limited set of authorization attributes that can override those AAA provides. The security appliance selects DAP records based on the AAA authorization information for the user and posture assessment information for the session. The security appliance can select multiple DAP records depending on this information, which it then aggregates to create DAP authorization attributes.

 
     [bookmark: pgfId-415063]You can specify AAA attributes from the Cisco AAA attribute hierarchy, or from the full set of response attributes that the security appliance receives from a RADIUS or LDAP server.

 
     [bookmark: pgfId-415065]AAA Attribute Definitions

 
      
       
        
        [bookmark: pgfId-411565]Table 32-1 [bookmark: 83070]AAA Attribute Definitions 

 
        
       
         
         		
           
           [bookmark: pgfId-411579]Attribute Type
          
  
         		
           
           [bookmark: pgfId-411581]Attribute Name
          
  
         		
           
           [bookmark: pgfId-411583]Source
          
  
         		
           
           [bookmark: pgfId-411585]Value
          
  
         		
           
           [bookmark: pgfId-411587]Max String Length
          
  
         		
           
           [bookmark: pgfId-411589]Description
          
  
        

 
         
         		 [bookmark: pgfId-411603]Cisco

  
         		[bookmark: pgfId-411605]aaa.cisco.memberof

  
         		[bookmark: pgfId-411607]AAA

  
         		[bookmark: pgfId-411609]string

  
         		[bookmark: pgfId-411611]128

  
         		[bookmark: pgfId-411613]memberof value

  
        

 
         
         		[bookmark: pgfId-411629]aaa.cisco.username

  
         		[bookmark: pgfId-411631]AAA

  
         		[bookmark: pgfId-411633]string

  
         		[bookmark: pgfId-411635]64

  
         		[bookmark: pgfId-411637]username value

  
        

 
         
         		[bookmark: pgfId-411653]aaa.cisco.class

  
         		[bookmark: pgfId-411655]AAA

  
         		[bookmark: pgfId-411657]string

  
         		[bookmark: pgfId-411659]64

  
         		[bookmark: pgfId-411661]class attribute value

  
        

 
         
         		[bookmark: pgfId-411677]aaa.cisco.ipaddress

  
         		[bookmark: pgfId-411679]AAA

  
         		[bookmark: pgfId-411681]number

  
         		[bookmark: pgfId-411683]–

  
         		[bookmark: pgfId-411685]framed-ip address value

  
        

 
         
         		[bookmark: pgfId-411701]aaa.cisco.tunnelgroup

  
         		[bookmark: pgfId-411703]AAA

  
         		[bookmark: pgfId-411705]string

  
         		[bookmark: pgfId-411707]64

  
         		[bookmark: pgfId-411709]tunnel-group name

  
        

 
         
         		[bookmark: pgfId-411723]LDAP

  
         		[bookmark: pgfId-411725]aaa.ldap.<label>

  
         		[bookmark: pgfId-411727]LDAP

  
         		[bookmark: pgfId-411729]string

  
         		[bookmark: pgfId-411731]128

  
         		[bookmark: pgfId-411733]LDAP attribute value pair

  
        

 
         
         		[bookmark: pgfId-411747]RADIUS

  
         		[bookmark: pgfId-411749]aaa.radius.<number>

  
         		[bookmark: pgfId-411751]RADIUS

  
         		[bookmark: pgfId-411753]string

  
         		[bookmark: pgfId-411755]128

  
         		[bookmark: pgfId-411757]Radius attribute value pair

  
        

 
       
      

 
     
 
     [bookmark: pgfId-415075]DAP and Endpoint Security

 
     [bookmark: pgfId-415077]The security appliance obtains endpoint security attributes by using posture assessment methods that you configure. These include Cisco Secure Desktop and NAC. You can use a match of a prelogin policy, Basic Host Scan entry, Host Scan Extension, or any combination of these and any other policy attributes to assign access rights and restrictions. At minimum, configure DAPs to assign to each prelogin policy and Basic Host Scan entry.

 
     [bookmark: pgfId-415079]Endpoint Assessment, a Host Scan extension, examines the remote computer for a large collection of antivirus and antispyware applications, associated definitions updates, and firewalls. You can use this feature to combine endpoint criteria to satisfy your requirements before the security appliance assigns a specific DAP to the session.

 
     [bookmark: pgfId-415081]DAP and Anti-Virus, Anti-Spyware, and Personal Firewall Programs

 
     [bookmark: pgfId-415083]The security appliance uses a DAP policy when the user attributes matches the configured AAA and endpoint attributes. The Prelogin Assessment and Host Scan modules of Cisco Secure Desktop return information to the security appliance about the configured endpoint attributes, and the DAP subsystem uses that information to select a DAP record that matches the values of those attributes. Most, but not all, anti-virus, anti-spyware, and personal firewall programs support active scan, which means that the programs are memory-resident, and therefore always running. Host Scan checks to see if an endpoint has a program installed, and if it is memory-resident as follows:

 
      
      		 [bookmark: pgfId-415085]If the installed program does not support active scan, Host Scan reports the presence of the software. The DAP system selects DAP records that specify the program.

 
      		 [bookmark: pgfId-415087]If the installed program does support active scan, and active scan is enabled for the program, Host Scan reports the presence of the software. Again the security appliance selects DAP records that specify the program.

 
      		 [bookmark: pgfId-415089]If the installed program does support active scan and active scan is disabled for the program, Host Scan ignores the presence of the software. The security appliance does not select DAP records that specify the program. Further, the output of the  debug trace command, which includes a lot of information about DAP, does not indicate the program presence, even though it is installed.

 
     

 
     [bookmark: pgfId-415093]Endpoint Attribute Definitions[bookmark: ravpnch_cncpt_UnderstandingDAPAttributes_endpoint_def]

 
      
       
        
        [bookmark: pgfId-411778]Table 32-2 [bookmark: 83201]Endpoint Attribute Definitions 

 
        
       
         
         		
           
           [bookmark: pgfId-411792]Attribute Type
          
  
         		
           
           [bookmark: pgfId-411794]Attribute Name
          
  
         		
           
           [bookmark: pgfId-411796]Source
          
  
         		
           
           [bookmark: pgfId-411798]Value
          
  
         		
           
           [bookmark: pgfId-411800]Max String Length
          
  
         		
           
           [bookmark: pgfId-411802]Description
          
  
        

 
         
         		 [bookmark: pgfId-411816]Antispyware (Requires Cisco Secure Desktop)

  
         		[bookmark: pgfId-411818]endpoint.as.label.exists

  
         		 [bookmark: pgfId-411820]Host Scan

  
         		[bookmark: pgfId-411822]true

  
         		[bookmark: pgfId-411824]–

  
         		[bookmark: pgfId-411826]Antispyware program exists

  
        

 
         
         		[bookmark: pgfId-411842]endpoint.as.label.version

  
         		[bookmark: pgfId-411846]string

  
         		[bookmark: pgfId-411848]32

  
         		[bookmark: pgfId-411850]Antispyware description

  
        

 
         
         		[bookmark: pgfId-411866]endpoint.as.label.description

  
         		[bookmark: pgfId-411870]string

  
         		[bookmark: pgfId-411872]128

  
         		[bookmark: pgfId-411874]class attribute value

  
        

 
         
         		[bookmark: pgfId-411890]endpoint.as.label.lastupdate

  
         		[bookmark: pgfId-411894]integer

  
         		[bookmark: pgfId-411896]–

  
         		[bookmark: pgfId-411898]Seconds since update of antispyware definitions

  
        

 
         
         		 [bookmark: pgfId-411912]Antivirus (Requires Cisco Secure Desktop)

  
         		[bookmark: pgfId-411914]endpoint.av.label.exists

  
         		 [bookmark: pgfId-411916]Host Scan

  
         		[bookmark: pgfId-411918]true

  
         		[bookmark: pgfId-411920]–

  
         		[bookmark: pgfId-411922]Antivirus program exists

  
        

 
         
         		[bookmark: pgfId-411938]endpoint.av.label.version

  
         		[bookmark: pgfId-411942]string

  
         		[bookmark: pgfId-411944]32

  
         		[bookmark: pgfId-411946]Antivirus description

  
        

 
         
         		[bookmark: pgfId-411962]endpoint.av.label.description

  
         		[bookmark: pgfId-411966]string

  
         		[bookmark: pgfId-411968]128

  
         		[bookmark: pgfId-411970]class attribute value

  
        

 
         
         		[bookmark: pgfId-411986]endpoint.av.label.lastupdate

  
         		[bookmark: pgfId-411990]integer

  
         		[bookmark: pgfId-411992]–

  
         		[bookmark: pgfId-411994]Seconds since update of antivirus definitions

  
        

 
         
         		[bookmark: pgfId-412008]Application

  
         		[bookmark: pgfId-412010]endpoint.application.clienttype

  
         		[bookmark: pgfId-412012]Application

  
         		[bookmark: pgfId-412014]string

  
         		[bookmark: pgfId-412016]–

  
         		[bookmark: pgfId-412018]Client type:

 [bookmark: pgfId-412020]CLIENTLESS

 [bookmark: pgfId-412022]ANYCONNECT

 [bookmark: pgfId-412024]IPSEC

 [bookmark: pgfId-412026]L2TP

  
        

 
         
         		 [bookmark: pgfId-412040]File

  
         		[bookmark: pgfId-412042]endpoint.file.label.exists

  
         		 [bookmark: pgfId-412044]Secure Desktop

  
         		[bookmark: pgfId-412046]true

  
         		[bookmark: pgfId-412048]–

  
         		[bookmark: pgfId-412050]The files exists

  
        

 
         
         		[bookmark: pgfId-412066]endpoint.file.label.lastmodified

  
         		[bookmark: pgfId-412070]integer

  
         		[bookmark: pgfId-412072]–

  
         		[bookmark: pgfId-412074]Seconds since file was last modified

  
        

 
         
         		[bookmark: pgfId-412090]endpoint.file.label.crc.32

  
         		[bookmark: pgfId-412094]integer

  
         		[bookmark: pgfId-412096]–

  
         		[bookmark: pgfId-412098]CRC32 hash of the file

  
        

 
         
         		[bookmark: pgfId-412112]NAC

  
         		[bookmark: pgfId-412114]endpoint.nac.status

  
         		[bookmark: pgfId-412116]NAC

  
         		[bookmark: pgfId-412118]string

  
         		[bookmark: pgfId-412120]-

  
         		[bookmark: pgfId-412122]User defined status string

  
        

 
         
         		 [bookmark: pgfId-412136]Operating System

  
         		[bookmark: pgfId-412138]endpoint.os.version

  
         		 [bookmark: pgfId-412140]Secure Desktop

  
         		[bookmark: pgfId-412142]string

  
         		[bookmark: pgfId-412144]32

  
         		[bookmark: pgfId-412146]Service pack for Windows

  
        

 
         
         		[bookmark: pgfId-412162]endpoint.os.servicepack

  
         		[bookmark: pgfId-412166]integer

  
         		[bookmark: pgfId-412168]–

  
         		[bookmark: pgfId-412170]Operating system

  
        

 
         
         		 [bookmark: pgfId-412184]Personal firewall (Requires Secure Desktop)

  
         		[bookmark: pgfId-412186]endpoint.fw.label.exists

  
         		 [bookmark: pgfId-412188]Host Scan

  
         		[bookmark: pgfId-412190]true

  
         		[bookmark: pgfId-412192]–

  
         		[bookmark: pgfId-412194]The personal firewall exists

  
        

 
         
         		[bookmark: pgfId-412210]endpoint.fw.label.version

  
         		[bookmark: pgfId-412214]string

  
         		[bookmark: pgfId-412216]32

  
         		[bookmark: pgfId-412218]Version

  
        

 
         
         		[bookmark: pgfId-412234]endpoint.fw.label.description

  
         		[bookmark: pgfId-412238]string

  
         		[bookmark: pgfId-412240]128

  
         		[bookmark: pgfId-412242]Personal firewall description

  
        

 
         
         		[bookmark: pgfId-412256]Policy

  
         		[bookmark: pgfId-412258]endpoint.policy.location

  
         		[bookmark: pgfId-412260]Secure Desktop

  
         		[bookmark: pgfId-412262]string

  
         		[bookmark: pgfId-412264]64

  
         		[bookmark: pgfId-412266]Location value from Cisco Secure Desktop

  
        

 
         
         		 [bookmark: pgfId-412280]Process

  
         		[bookmark: pgfId-412282]endpoint.process.label.exists

  
         		 [bookmark: pgfId-412284]Secure Desktop

  
         		[bookmark: pgfId-412286]true

  
         		[bookmark: pgfId-412288]–

  
         		[bookmark: pgfId-412290]The process exists

  
        

 
         
         		[bookmark: pgfId-412306]endpoint.process.label.path

  
         		[bookmark: pgfId-412310]string

  
         		[bookmark: pgfId-412312]255

  
         		[bookmark: pgfId-412314]Full path of the process

  
        

 
         
         		 [bookmark: pgfId-412328]Registry

  
         		[bookmark: pgfId-412330]endpoint.registry.label.type

  
         		 [bookmark: pgfId-412332]Secure Desktop

  
         		[bookmark: pgfId-412334]dword string

  
         		[bookmark: pgfId-412336]–

  
         		[bookmark: pgfId-412338]dword

  
        

 
         
         		[bookmark: pgfId-412354]endpoint.registry.label.value

  
         		[bookmark: pgfId-412358]string

  
         		[bookmark: pgfId-412360]255

  
         		[bookmark: pgfId-412362]Value of the registry entry

  
        

 
         
         		[bookmark: pgfId-412376]VLAN

  
         		[bookmark: pgfId-412378]endpoint.vlan.type

  
         		[bookmark: pgfId-412380]CNA

  
         		[bookmark: pgfId-412382]sting

  
         		[bookmark: pgfId-412384]–

  
         		[bookmark: pgfId-412386]VLAN type:

 [bookmark: pgfId-412388]ACCESS 
AUTH
 ERROR
 GUEST
 QUARANTINE
 ERROR
 STATIC
 TIMEOUT

  
        

 
       
      

 
     
 
     [bookmark: pgfId-415105]About Advanced Expressions for AAA or Endpoint Attributes[bookmark: ravpnch_cncpt_UnderstandingDAPAttributes_advanced_express]

 
     [bookmark: pgfId-415107]In the text box you enter free-form LUA text that represents AAA and/or endpoint selection logical operations. ASDM does not validate text that you enter here; it just copies this text to the DAP policy file, and the security appliance processes it, discarding any expressions it cannot parse.

 
     [bookmark: pgfId-415109]This option is useful for adding selection criteria other than what is possible in the AAA and endpoint attribute areas above. For example, while you can configure the security appliance to use AAA attributes that satisfy any, all, or none of the specified criteria, endpoint attributes are cumulative, and must all be satisfied. To let the security appliance employ one endpoint attribute or another, you need to create appropriate logical expressions in LUA and enter them here.

 
     [bookmark: pgfId-415113]Examples of DAP Logical Expressions[bookmark: ravpnch_cncpt_UnderstandingDAPAttributes_example_advanced_express]

 
     [bookmark: pgfId-415115]Study these examples for help in creating logical expressions in LUA.

 
      
      		 [bookmark: pgfId-415117]This AAA LUA expression tests for a match on usernames that begin with "b". It uses the string library and a regular expression:

 
     

 
     
      [bookmark: pgfId-415119]not(string.find(aaa.cisco.username, "^b") == nil) 
     

      
      		 [bookmark: pgfId-415121]This endpoint expression tests for a match on CLIENTLESS OR CVC client types:

 
     

 
     
      [bookmark: pgfId-415123]endpoint.application.clienttype=="CLIENTLESS" or endpoint.application.clienttype=="CVC"
     

      
      		 [bookmark: pgfId-415125]This endpoint expression tests for Norton Antivirus versions 10.x but excludes 10.5.x:

 
     

 
     
      [bookmark: pgfId-415127](endpoint.av.NortonAV.version > "10" and endpoint.av.NortonAV.version < "10.5") or endpoint.av.NortonAV.version > "10.6"
     

     [bookmark: pgfId-415129]DAP Connection Sequence

 
     [bookmark: pgfId-415131]The following sequence outlines a typical remote access connection establishment.

 
     [bookmark: pgfId-415133] 1. A remote client attempts a VPN connection.

 
     [bookmark: pgfId-415135] 2. The security appliance performs posture assessment, using configured NAC and Cisco Secure Desktop Host Scan values.

 
     [bookmark: pgfId-415137] 3. The security appliance authenticates the user via AAA. The AAA server also returns authorization attributes for the user.

 
     [bookmark: pgfId-415139] 4. The security appliance applies AAA authorization attributes to the session, and establishes the VPN tunnel.

 
     [bookmark: pgfId-415141] 5. The security appliance selects DAP records based on the user AAA authorization information and the session posture assessment information.

 
     [bookmark: pgfId-415143] 6. The security appliance aggregates DAP attributes from the selected DAP records, and they become the DAP policy.

 
     [bookmark: pgfId-415145] 7. The security appliance applies the DAP policy to the session.

 
     [bookmark: pgfId-415147]Related Topics

 
      
      		 [bookmark: pgfId-415152]Configuring Dynamic Access Policies

 
      		 [bookmark: pgfId-415157]Understanding Dynamic Access Policies

 
      		 [bookmark: pgfId-415162]Configuring DAP Attributes

 
     

 
    
 
     
      [bookmark: pgfId-415184][bookmark: 83566][bookmark: ravpnch_proc_ConfiguringDAPAttributes]Configuring DAP Attributes[bookmark: marker-415168][bookmark: marker-415170][bookmark: marker-415172][bookmark: marker-415174][bookmark: marker-415176][bookmark: marker-415178][bookmark: marker-415180][bookmark: marker-415182]

 
     [bookmark: pgfId-415186]The attributes you must define for a DAP policy include specifying the authorization attributes and endpoint attributes. You can also configure network and webtype ACLs, file browsing, file server entry, HTTP proxy, URL entry, port forwarding lists and URL lists.

 
     [bookmark: pgfId-415188]This procedure describes how to create or edit the AAA and endpoint attributes required for a DAP policy.

 
     [bookmark: pgfId-415190]Related Topics

 
      
      		 [bookmark: pgfId-415195]Understanding DAP Attributes

 
      		 [bookmark: pgfId-415200]Understanding Dynamic Access Policies

 
      		 [bookmark: pgfId-415205]Configuring Dynamic Access Policies

 
     

 
     
 
     [bookmark: pgfId-415207]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-415209](Device view) With an ASA device selected, select  Remote Access VPN > Dynamic Access from the Policy selector.

 
      		 [bookmark: pgfId-415211](Policy view) Select  Remote Access VPN > Dynamic Access (ASA) from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-415216]The Dynamic Access page opens. For a description of the elements on this page, see Dynamic Access Page (ASA).

 
     [bookmark: pgfId-415218]Step 2 Click Create on the Dynamic Access policy page, or select the row of a policy in the table on the page, and click Edit.

 
     [bookmark: pgfId-415223]The Add/Edit Dynamic Access Policy dialog box opens, displaying the Main tab. For a description of the elements on the Main tab, see Main Tab.

 
     [bookmark: pgfId-415228]Step 3 Click Create below the table, or select a DAP entry in the table and click Edit. The Add/Edit DAP Entry dialog box opens. For a description of the elements on this dialog box, see Add/Edit DAP Entry Dialog Box.

 
     [bookmark: pgfId-415230]Step 4 Select the attribute type from the Criterion list, then enter the appropriate values. The dialog box values vary based on your selection. Options are:

 
      
      		 [bookmark: pgfId-415235]AAA Attributes Cisco; see Table 32-6.

 
      		 [bookmark: pgfId-415240]AAA Attributes LDAP; see Table 32-7.

 
      		 [bookmark: pgfId-415245]AAA Attributes RADIUS; see Table 32-8.

 
      		 [bookmark: pgfId-415250]Anti-Spyware; see Table 32-9.

 
      		 [bookmark: pgfId-415255]Anti-Virus; see Table 32-10.

 
      		 [bookmark: pgfId-415260]AnyConnect Identity; see Table 32-11.

 
      		 [bookmark: pgfId-415265]Application; see Table 32-12.

 
      		 [bookmark: pgfId-415270]Device; see Table 32-13.

 
      		 [bookmark: pgfId-415275]File; see Table 32-14.

 
      		 [bookmark: pgfId-415280]NAC; see Table 32-15.

 
      		 [bookmark: pgfId-415285]Operating System; see Table 32-16.

 
      		 [bookmark: pgfId-415290]Personal Firewall; see Table 32-17.

 
      		 [bookmark: pgfId-415295]Policy; see Table 32-18.

 
      		 [bookmark: pgfId-415300]Process; see Table 32-19.

 
      		 [bookmark: pgfId-415305]Registry; see Table 32-20.

 
     

 
     [bookmark: pgfId-415307]Step 5 Click OK.

 
     [bookmark: pgfId-415309]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-415331][bookmark: 83690][bookmark: ravpnch_proc_ConfiguringtheCiscoSecureDesktopSoftware]Configuring Cisco Secure Desktop Policies on ASA Devices [bookmark: marker-415315][bookmark: marker-415317][bookmark: marker-415319][bookmark: marker-415321][bookmark: marker-415323][bookmark: marker-415325][bookmark: marker-415327][bookmark: marker-415329]

 
     [bookmark: pgfId-415333]Cisco Secure Desktop (CSD) provides a reliable means of eliminating all traces of sensitive data by providing a single, secure location for session activity and removal on the client system. CSD provides a session-based interface where sensitive data is shared only for the duration of an SSL VPN session. All session information is encrypted, and all traces of the session data are removed from the remote client when the session is terminated, even if the connection terminates abruptly. This ensures that cookies, browser history, temporary files, and downloaded content do not remain on a system.

 
     [bookmark: pgfId-415335]When the session closes, CSD overwrites and removes all data using a U.S. Department of Defense (DoD) sanitation algorithm to provide endpoint security protection.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-415339]Note A complete explanation of the capabilities and configuration of the Cisco Secure Desktop program is beyond the scope of this document. For information about configuring CSD, and what CSD can do for you, see the materials available online at http://www.cisco.com/en/US/products/ps6742/tsd_products_support_configure.html. Select the configuration guide for the CSD version you are configuring.


     
      

     

     

 
     [bookmark: pgfId-415341]This procedure describes how to configure the Cisco Secure Desktop feature on an ASA device.

 
     [bookmark: pgfId-415343]Before You Begin

 
      
      		 [bookmark: pgfId-415348]Make sure a connection profile policy has been configured on the device. See Configuring Connection Profiles (ASA, PIX 7.0+).

 
     

 
     [bookmark: pgfId-415350]Related Topics

 
      
      		 [bookmark: pgfId-415355]Understanding and Managing SSL VPN Support Files

 
     

 
     
 
     [bookmark: pgfId-415357]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-415359](Device view) With an ASA device selected, select  Remote Access VPN > Dynamic Access from the Policy selector.

 
      		 [bookmark: pgfId-415361](Policy view) Select  Remote Access VPN > Dynamic Access (ASA) from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-415366]The Dynamic Access page opens. For a description of the elements on this page, see Dynamic Access Page (ASA).

 
     [bookmark: pgfId-415368]Step 2 In the Cisco Secure Desktop section, select Enable CSD to enable CSD on the ASA device.

 
     [bookmark: pgfId-415373]Step 3 In the CSD Package field, specify the name of the File Object that identifies the Cisco Secure Desktop package you want to upload to the device. Click Select to select an existing File Object or to create a new one. For more information, see Add and Edit File Object Dialog Boxes.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-415378]Note The package version must be compatible with the ASA operating system version. When you create a local policy in Device view, the Version field indicates the CSD package version you should select. (The version is included in the package file name. For example, securedesktop-asa_k9-3.3.0.118.pkg is CSD version 3.3.0.118.) When you create a shared policy in Policy view, the Version field indicates the version of the CSD file you selected. For more information on version compatibility, see Understanding and Managing SSL VPN Support Files.


     
      

     

     

 
     [bookmark: pgfId-415383]Step 4 (Optional) In the Hostscan Package field, specify the name of the File Object that identifies the Host Scan package you want to upload to the device. Click Select to select an existing File Object or to create a new one. For more information, see Add and Edit File Object Dialog Boxes.

 
     [bookmark: pgfId-415385]Step 5 Click Configure to open the Cisco Secure Desktop Manager (CSDM) Policy Editor that lets you configure CSD on the security appliance. This application is independent of Security Manager; read the CSD documentation cited above for an explanation of how to use the policy editor.

 
     [bookmark: pgfId-415387]The editor contains these main items (select them in the table of contents):

 
      
      		 [bookmark: pgfId-415389]Prelogin Policies—This is a decision tree. When a user attempts a connection, the user’s system is evaluated against your rules and the first rule that matches is applied. Typically, you create policies for secure locations, home locations, and insecure public locations. You can make your checks based on registry information, the presence of specific files or certificates, the workstation’s operating system, or IP address.

 
     

 
     [bookmark: pgfId-415391]All editing is done through the right-click menu. Right click on boxes or + signs to activate related settings, if any.

 
     [bookmark: pgfId-415393]For end nodes, you can select these options:

 
     [bookmark: pgfId-415395] – Access Denied—Workstations that match your criteria are prevented from accessing the network.

 
     [bookmark: pgfId-415397] – Policy—You want to define a specific admission policy at this point. After naming the policy, it is added to the table of contents. Select each item in the policy and configure its settings.

 
     [bookmark: pgfId-415399] – Subsequence—You want to perform additional checks. Enter the name of the next decision tree that you want to evaluate for this workstation.

 
      
      		 [bookmark: pgfId-415401]Host scan—You can specify a set of registry entries, file names, and process names, which form a part of the basic host scan. The host scan occurs after the prelogin assessment but before the assignment of a dynamic access policy. Following the basic host scan, the security appliance uses the login credentials, the host scan results, prelogin policy, and other criteria you configure to assign a dynamic access policy. You can also enable:

 
     

 
     [bookmark: pgfId-415403] – Endpoint Assessment—The remote workstation scans for a large collection of antivirus, antispyware, and personal firewall applications, and associated updates.

 
     [bookmark: pgfId-415405] – Advanced Endpoint Assessment—Includes all of the Endpoint Assessment features, and lets you configure an attempt to update noncompliant workstations to meet the version requirements you specify. You must purchase and install a license for this feature before you can configure it.

 
     [bookmark: pgfId-415407]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-415431][bookmark: 83796][bookmark: ravpnpg_cncpt_DynamicAccessPageASA]Dynamic Access Page (ASA) [bookmark: marker-415415][bookmark: marker-415417][bookmark: marker-415419][bookmark: marker-415421][bookmark: marker-415423][bookmark: marker-415425][bookmark: marker-415427][bookmark: marker-415429]

 
    [bookmark: pgfId-415433]Use the Dynamic Access page to view the dynamic access policies (DAP) defined on the security appliance. From this page, you can create, edit, or delete DAPs.

 
    [bookmark: pgfId-415435]Use the Cisco Secure Desktop section to enable and download the Cisco Secure Desktop (CSD) software on the selected ASA device. Cisco Secure Desktop provides a single, secure location for session activity and removal on the client system, ensuring that sensitive data is shared only for the duration of an SSL VPN session.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-415437]Note The CSD client software must be installed and activated on a device in order for an SSL VPN policy to work properly.


    
     

    

    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-415439]Tip Dynamic Access policies take precedence over Group policies. If a setting is not specified in a Dynamic Access policy, an ASA device checks for Group policies that specify the setting.


    
     

    

    

 
    [bookmark: pgfId-415441]Navigation Path

 
     
     		 [bookmark: pgfId-415443](Device View) Select an ASA device; then select  Remote Access VPN > Dynamic Access (ASA) from the Policy selector.

 
     		 [bookmark: pgfId-415445](Policy View) Select  Remote Access VPN > Dynamic Access (ASA) from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-415447]Related Topics

 
     
     		 [bookmark: pgfId-415452]Understanding Dynamic Access Policies

 
     		 [bookmark: pgfId-415457]Configuring Dynamic Access Policies

 
     		 [bookmark: pgfId-415462]Understanding DAP Attributes

 
     		 [bookmark: pgfId-415467]Configuring DAP Attributes

 
     		 [bookmark: pgfId-415472]Configuring Cisco Secure Desktop Policies on ASA Devices

 
    

 
    [bookmark: pgfId-415474]Field Reference

 
    [bookmark: pgfId-415477] 

 
     
      
       
       [bookmark: pgfId-412401]Table 32-3 [bookmark: 83863]Dynamic Access Policy Page (ASA) 

 
       
      
        
        		
          
          [bookmark: pgfId-412407]Element
         
  
        		
          
          [bookmark: pgfId-412409]Description
         
  
       

 
        
        		[bookmark: pgfId-412415]Priority

  
        		[bookmark: pgfId-412417]Priority of the configured dynamic access policy record.

  
       

 
        
        		[bookmark: pgfId-412423]Name

  
        		[bookmark: pgfId-412425]Name of the configured dynamic access policy record.

  
       

 
        
        		[bookmark: pgfId-412431]Network ACL

  
        		[bookmark: pgfId-412433]Name of the firewall ACL that applies to the session.

  
       

 
        
        		[bookmark: pgfId-412439]WebType ACL

  
        		[bookmark: pgfId-412441]Name of the WebType VPN ACL that applies to the session.

  
       

 
        
        		[bookmark: pgfId-412447]Port Forwarding

  
        		[bookmark: pgfId-412449]Name of the port forwarding list that applies to the session.

  
       

 
        
        		[bookmark: pgfId-412455]Bookmark

  
        		[bookmark: pgfId-412457]Name of the SSL VPN Bookmark object that applies to the session.

  
       

 
        
        		[bookmark: pgfId-412463]Terminate

  
        		[bookmark: pgfId-412465]Indicates whether the session is terminated or not.

  
       

 
        
        		[bookmark: pgfId-412471]Description

  
        		[bookmark: pgfId-412473]Additional information about the configured dynamic access policy.

  
       

 
        
        		[bookmark: pgfId-412479]Create button

  
        		[bookmark: pgfId-412484]Click this button to create a dynamic access policy. See Add/Edit Dynamic Access Policy Dialog Box.

  
       

 
        
        		[bookmark: pgfId-412490]Edit button

  
        		[bookmark: pgfId-412495]Click this button to edit the selected dynamic access policy. See Add/Edit Dynamic Access Policy Dialog Box.

  
       

 
        
        		[bookmark: pgfId-412501]Delete button

  
        		[bookmark: pgfId-412503]Click this button to delete the selected dynamic access policies.

  
       

 
        
        		 [bookmark: pgfId-412509]Cisco Secure Desktop

 [bookmark: pgfId-412514]For the procedure to configure CSD on an ASA device, see Configuring Cisco Secure Desktop Policies on ASA Devices.

  
       

 
        
        		[bookmark: pgfId-412522]Enable CSD

  
        		[bookmark: pgfId-412524]When selected, enables the CSD on the device. Enabling CSD loads the specified Cisco Secure Desktop package. If you transfer or replace the CSD package file, disable and then enable CSD to load the file.

  
       

 
        
        		[bookmark: pgfId-412530]CSD Package

  
        		[bookmark: pgfId-412532]Specify the name of the File Object that identifies the Cisco Secure Desktop package you want to upload to the device.

 [bookmark: pgfId-412537]Click Select to select an existing File Object or to create a new one. For more information, see Add and Edit File Object Dialog Boxes.

  
       

 
        
        		[bookmark: pgfId-412543]Hostscan Package

  
        		[bookmark: pgfId-412545]Specify the name of the File Object that identifies the Hostscan package you want to upload to the device.

 [bookmark: pgfId-412550]Click Select to select an existing File Object or to create a new one. For more information, see Add and Edit File Object Dialog Boxes.

  
       

 
        
        		[bookmark: pgfId-412556]Version

  
        		[bookmark: pgfId-412561]The package version must be compatible with the ASA operating system version. When you create a local policy in Device view, the Version field indicates the CSD package version you should select. (The version is included in the package file name. For example, securedesktop-asa_k9-3.3.0.118.pkg is CSD version 3.3.0.118.) When you create a shared policy in Policy view, the Version field indicates the version of the CSD file you selected. For more information on version compatibility, see Understanding and Managing SSL VPN Support Files.

  
       

 
        
        		[bookmark: pgfId-412567]Configure

  
        		[bookmark: pgfId-412572]Click Configure to open the Cisco Secure Desktop Manager (CSDM) Policy Editor that lets you configure CSD on the security appliance. For a description of the elements in this dialog box, see Cisco Secure Desktop Manager Policy Editor Dialog Box.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-415487][bookmark: 83970][bookmark: ravpnpg_cncpt_AddEditDynamicAccessPolicyDialogBox]Add/Edit Dynamic Access Policy Dialog Box[bookmark: marker-415485]

 
     [bookmark: pgfId-415489]Use the Add/Edit Dynamic Access Policy dialog box to configure the dynamic access policies (DAP) on your security appliance. You can specify a name for the dynamic access policy that you are adding, select the priority, specify attributes in a LUA expression, and set attributes for network and webtype ACL filters, file access, HTTP proxy, URL entry and lists, port forwarding, and clientless SSL VPN access methods.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-415494]Note For detailed information about dynamic access policy attributes, see Understanding DAP Attributes


     
      

     

     

 
     [bookmark: pgfId-415496]These tabs are available in the Add/Edit Dynamic Access Policy dialog box:

 
      
      		 [bookmark: pgfId-415501]Main Tab

 
      		 [bookmark: pgfId-415506]Logical Operations Tab

 
      		 [bookmark: pgfId-415511]Advanced Expressions Tab

 
     

 
     [bookmark: pgfId-415513]Navigation Path

 
     [bookmark: pgfId-415518]Open the Dynamic Access Page (ASA), then click Create, or select a dynamic access policy in the table and click Edit. The Add/Edit Dynamic Access Policy dialog box is displayed.

 
     [bookmark: pgfId-415520]Related Topics

 
      
      		 [bookmark: pgfId-415525]Understanding Dynamic Access Policies

 
      		 [bookmark: pgfId-415530]Configuring Dynamic Access Policies

 
     

 
     [bookmark: pgfId-415532]Field Reference

 
     [bookmark: pgfId-415535] 

 
      
       
        
        [bookmark: pgfId-412585]Table 32-4 [bookmark: 84007]Add/Edit Dynamic Access Policy Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-412591]Element
          
  
         		
           
           [bookmark: pgfId-412593]Description
          
  
        

 
         
         		[bookmark: pgfId-412599]Name

  
         		[bookmark: pgfId-412601]The name of the dynamic access policy record (up to 128 characters).

  
        

 
         
         		[bookmark: pgfId-412607]Priority

  
         		[bookmark: pgfId-412609]A priority for the dynamic access policy record. The security appliance applies access policies in the order you set here, highest number having the highest priority. In the case of dynamic access policy records with the same priority setting and conflicting ACL rules, the most restrictive rule applies.

  
        

 
         
         		[bookmark: pgfId-412615]Description

  
         		[bookmark: pgfId-412617]Additional information about the dynamic access policy record (up to 1024 characters).

  
        

 
         
         		[bookmark: pgfId-412623]Main tab

  
         		[bookmark: pgfId-412625]Enables you to add a dynamic access policy entry and set attributes for the access policy depending on the type of remote access that you configure.

 [bookmark: pgfId-412630]For a description of the elements on this tab, see Main Tab.

  
        

 
         
         		[bookmark: pgfId-412636]Logical Operations tab

  
         		[bookmark: pgfId-412638]Enables you to create multiple instances of each type of endpoint attribute.

 [bookmark: pgfId-412643]For a description of the elements on this tab, see Logical Operations Tab.

  
        

 
         
         		[bookmark: pgfId-412649]Advanced Expressions tab

  
         		[bookmark: pgfId-412651]Enables you to configure one or more logical expressions to set AAA or endpoint attributes other than what is possible in the AAA and Endpoint areas.

 [bookmark: pgfId-412656]For a description of the elements on this tab, see Advanced Expressions Tab.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-415543][bookmark: 84053][bookmark: ravpnpg_cncpt_MainTab]Main Tab[bookmark: marker-415541]

 
     [bookmark: pgfId-415545]Use the Main tab of the Add/Edit Dynamic Access Policy dialog box to configure the dynamic access policy attributes and the type of remote access method supported your security appliance. You can set attributes for network and webtype ACL filters, file access, HTTP proxy, URL entry and lists, port forwarding, and clientless SSL VPN access methods.

 
     [bookmark: pgfId-415547]Navigation Path

 
     [bookmark: pgfId-415552]The Main tab appears when you open the Add/Edit Dynamic Access Policy Dialog Box.

 
     [bookmark: pgfId-415554]Related Topics

 
      
      		 [bookmark: pgfId-415559]Configuring Dynamic Access Policies

 
      		 [bookmark: pgfId-415564]Configuring DAP Attributes

 
     

 
     [bookmark: pgfId-415566]Field Reference

 
     [bookmark: pgfId-415569] 

 
      
       
        
        [bookmark: pgfId-412669]Table 32-5 [bookmark: 84076]Add/Edit Dynamic Access Policy Dialog Box > Main Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-412675]Element
          
  
         		
           
           [bookmark: pgfId-412677]Description
          
  
        

 
         
         		[bookmark: pgfId-412683]Criteria ID

  
         		[bookmark: pgfId-412685]The AAA and endpoint selection attribute names that are available for dynamic access policy use.

  
        

 
         
         		[bookmark: pgfId-412691]Content

  
         		[bookmark: pgfId-412693]Values of the AAA and endpoint attributes criteria that the security appliance uses for selecting and applying a dynamic access policy record during session establishment. Attribute values that you configure here override authorization values in the AAA system, including those in existing group policy, tunnel group, and default group records.

  
        

 
         
         		[bookmark: pgfId-412699]Create button

  
         		[bookmark: pgfId-412704]Click this button to configure AAA and endpoint attributes as selection criteria for the DAP record. See Add/Edit DAP Entry Dialog Box.

  
        

 
         
         		[bookmark: pgfId-412710]Edit button

  
         		[bookmark: pgfId-412715]Click this button to edit the selected dynamic access policy. See Add/Edit DAP Entry Dialog Box.

  
        

 
         
         		[bookmark: pgfId-412721]Delete button

  
         		[bookmark: pgfId-412723]Click this button to delete the selected dynamic access policies.

  
        

 
         
         		[bookmark: pgfId-412729]Access Method

  
         		[bookmark: pgfId-412731]Specify the type of remote access permitted:

 
           
           		 [bookmark: pgfId-412733] Unchanged —Continue with the current remote access method.

 
           		 [bookmark: pgfId-412735] AnyConnect Client —Connect using the Cisco AnyConnect VPN Client.

 
           		 [bookmark: pgfId-412737] Web Portal —Connect with clientless VPN.

 
           		 [bookmark: pgfId-412739] Both default Web Portal —Connect via either clientless or the AnyConnect client, with a default of clientless.

 
           		 [bookmark: pgfId-412741] Both default AnyConnect Client —Connect via either clientless or the AnyConnect client, with a default of AnyConnect.

 
          

  
        

 
         
         		 [bookmark: pgfId-412747]Network ACL tab—Lets you select and configure network ACLs to apply to this dynamic access policy. An ACL for a dynamic access policy can contain permit or deny rules, but not both. If an ACL contains both permit and deny rules, the security appliance rejects it.

  
        

 
         
         		[bookmark: pgfId-412755]Network ACL

  
         		[bookmark: pgfId-412757]Lists the Access Control Lists (ACLs) that will be used to restrict user access to the SSL†VPN.

 [bookmark: pgfId-412759]Click the Select button to open the Access Control Lists Selector from which you can make your selection. The ACL contains conditions that describe a traffic stream of packets, and actions that describe what should occur based on those conditions. Only ACLs having all permit or all deny rules are eligible.

  
        

 
         
         		 [bookmark: pgfId-412765]AnyConnect tab—Lets you choose if the setting for Always-On VPN on the AnyConnect service profile remains unchanged, is disabled, or the AnyConnect Profile Setting must be used. Always-On VPN enables AnyConnnect to automatically establish a VPN session after you log onto the system.

  
        

 
         
         		 [bookmark: pgfId-412773]Custom Attributes tab—Lists the AnyConnect Custom Attribute Type and Custom Attribute Name. AnyConnect custom attributes allow for a more expeditious delivery and deployment of new endpoint features by giving the ASA the ability to generically support the addition of new client controls without the need for an ASA software upgrade. Beginning with version 4.7, Security Manager enables to add Custom Attribute Data to an existing Custom Attribute Type. This feature is supported for devices that are running the ASA software version 9.3(1) or higher.

  
        

 
         
         		[bookmark: pgfId-412781]Attribute Type

  
         		[bookmark: pgfId-412786]Select the Attribute Type that you configured in Add/Edit AnyConnect Custom Attribute Dialog Box page.

  
        

 
         
         		[bookmark: pgfId-412792]Attribute Name

  
         		[bookmark: pgfId-412797]Select the Attribute Name that you configured in Add/Edit AnyConnect Custom Attribute Data Dialog Box page.

  
        

 
         
         		 [bookmark: pgfId-412803]WebType ACL tab—Lets you select and configure web-type ACLs to apply to this dynamic access policy. An ACL for a dynamic access policy can contain only permit or deny rules. If an ACL contains both permit and deny rules, the security appliance rejects it.

  
        

 
         
         		[bookmark: pgfId-412811]Web Type ACL

  
         		[bookmark: pgfId-412813]Specifies the WebType access control list that will be used to restrict user access to the SSL†VPN.

 [bookmark: pgfId-412815]Click the Select button to open the Access Control Lists Selector from which you can make your selection. Only ACLs having all permit or all deny rules are eligible.

  
        

 
         
         		 [bookmark: pgfId-412821]Functions tab—Lets you configure file server entry and browsing, HTTP proxy, and URL entry for the dynamic access policy.

  
        

 
         
         		[bookmark: pgfId-412829]File Server Browsing

  
         		[bookmark: pgfId-412831]Specify the file server browsing setting to be configured on the portal page:

 
           
           		 [bookmark: pgfId-412833] Unchanged —Uses values from the group policy that applies to this session.

 
           		 [bookmark: pgfId-412835] Enable —Enables CIFS browsing for file servers or shared features.

 
           		 [bookmark: pgfId-412837] Disable —Disables CIFS browsing for file servers or shared features.

 
          

 The CIFS browse feature does not support internationalization.

  
        

 
         
         		[bookmark: pgfId-412845]File Server Entry

  
         		[bookmark: pgfId-412847]Specify the file server entry setting to be configured on the portal page:

 
           
           		 [bookmark: pgfId-412849] Unchanged —Uses values from the group policy that applies to this session.

 
           		 [bookmark: pgfId-412851] Enable —Enables a user from entering file server paths and names on the portal page.

 
          

 [bookmark: pgfId-412853]When enabled, places the file server entry drawer on the portal page. Users can enter pathnames to Windows files directly. They can download, edit, delete, rename, and move files. They can also add files and folders. Shares must also be configured for user access on the applicable Windows servers. Users might have to be authenticated before accessing files, depending on network requirements.

 
           
           		 [bookmark: pgfId-412855] Disable —Disables a user from entering file server paths and names on the portal page.

 
          

  
        

 
         
         		[bookmark: pgfId-412861]HTTP Proxy

  
         		[bookmark: pgfId-412863]Specify how you want to configure the security appliance to terminate HTTPS connections and forward HTTP/HTTPS requests to HTTP and HTTPS proxy servers:

 
           
           		 [bookmark: pgfId-412865] Unchanged —Uses values from the group policy that applies to this session.

 
           		 [bookmark: pgfId-412867] Enable —Allows the forwarding of an HTTP applet proxy to the client.

 
          

 [bookmark: pgfId-412869]The proxy is useful for technologies that interfere with proper content transformation, such as Java, ActiveX, and Flash. It bypasses mangling while ensuring the continued use of the security appliance. The forwarded proxy modifies the browser’s old proxy configuration and redirects all HTTP and HTTPS requests to the new proxy configuration. It supports virtually all client side technologies, including HTML, CSS, JavaScript, VBScript, ActiveX, and Java. The only browser it supports is Microsoft Internet Explorer.

 
           
           		 [bookmark: pgfId-412871] Disable —Disables the forwarding of an HTTP applet proxy to the client.

 
           		 [bookmark: pgfId-412873] Auto-start —Enables HTTP proxy and to have the DAP record automatically start the applets associated with these features.

 
          

  
        

 
         
         		[bookmark: pgfId-412879]URL Entry

  
         		[bookmark: pgfId-412881]Using SSL VPN does not ensure that communication with every site is secure. SSL VPN ensures the security of data transmission between the remote user’s PC or workstation and the security appliance on the corporate network. If a user then accesses a non-HTTPS web resource (located on the Internet or on the internal network), the communication from the corporate security appliance to the destination web server is not secured.

 [bookmark: pgfId-412883]In a clientless VPN connection, the security appliance acts as a proxy between the end user web browser and target web servers. When a user connects to an SSL-enabled web server, the security appliance establishes a secure connection and validates the server SSL certificate. The end user browser never receives the presented certificate, so therefore cannot examine and validate the certificate. The current implementation of SSL VPN does not permit communication with sites that present expired certificates. Neither does the security appliance perform trusted CA certificate validation. Therefore, users cannot analyze the certificate an SSL-enabled web-server presents before communicating with it.

 [bookmark: pgfId-412885]Specify how the URL entry setting must be configured on the portal page:

 
           
           		 [bookmark: pgfId-412887] Unchanged —Uses values from the group policy that applies to this session.

 
           		 [bookmark: pgfId-412889] Enable —Allows a user from entering HTTP/HTTPS URLs on the portal page. If this feature is enabled, users can enter web addresses in the URL entry box, and use clientless SSL VPN to access those websites.

 
           		 [bookmark: pgfId-412891] Disable —Disables a user from entering HTTP/HTTPS URLs on the portal page.

 
          

 for the URL Entry field. This prevents SSL VPN users from surfing the Web during a clientless VPN connection.

  
        

 
         
         		 [bookmark: pgfId-412899]Port Forwarding tab—Lets you select and configure port forwarding lists for user sessions.

 [bookmark: pgfId-412901]Note Port Forwarding does not work with some SSL/TLS versions.

 
           
           [image: ] 
          
 
          
 
          
           [bookmark: pgfId-412903]Caution Make sure Sun Microsystems Java Runtime Environment (JRE) 1.4+ is installed on the remote computers to support port forwarding (application access) and digital certificates.
            
            
 
           

          
  
        

 
         
         		[bookmark: pgfId-412911]Port Forwarding

  
         		[bookmark: pgfId-412913]Select an option for the port forwarding lists that apply to this DAP record:

 
           
           		 [bookmark: pgfId-412915] Unchanged —Removes the attributes from the running configuration.

 
           		 [bookmark: pgfId-412917] Enable —Enables port forwarding on the device.

 
           		 [bookmark: pgfId-412919] Disable —Disables port forwarding on the device.

 
           		 [bookmark: pgfId-412921] Auto-start —Enables port forwarding, and to have the DAP record automatically start the port forwarding applets associated with its port forwarding lists.

 
          

  
        

 
         
         		[bookmark: pgfId-412927]Port Forwarding List

  
         		[bookmark: pgfId-412929]The Port Forwarding List, that defines the mapping of the port number on the client machine to the application’s IP address and port behind the SSL VPN gateway.

 [bookmark: pgfId-412931]You can click Select to open the Port Forwarding List Selector from which you can select the required Port Forwarding List from a list of Port Forwarding List objects. A Port Forwarding List object defines the mappings of port numbers on the remote client to the application’s IP address and port behind the SSL VPN gateway.

  
        

 
         
         		 [bookmark: pgfId-412937]Bookmark tab—Lets you enable and configure SSL VPN bookmarks. When enabled, users who successfully log into the SSL VPN are presented with the portal page containing the list of defined bookmarks. These bookmarks enable users to access resources available on SSL VPN websites in Clientless access mode.

  
        

 
         
         		[bookmark: pgfId-412945]Enable Bookmarks

  
         		[bookmark: pgfId-412947]Specify the file server browsing setting to be configured on the portal page:

 
           
           		 [bookmark: pgfId-412949] Unchanged —Uses values from the group policy that applies to this session.

 
           		 [bookmark: pgfId-412951] Enable —Enables bookmarks on the SSL VPN portal page.

 
           		 [bookmark: pgfId-412953] Disable —Disables bookmarks on the SSL VPN portal page.

 
          

  
        

 
         
         		[bookmark: pgfId-412959]Bookmarks

  
         		[bookmark: pgfId-412961]A list of websites that will be displayed on the portal page as a bookmark to enable users to access the resources available on the SSL VPN websites.

 [bookmark: pgfId-412963]You can click Select to open the Bookmarks Selector from which you can select the required bookmark from a list or create a new bookmark, as desired.

  
        

 
         
         		 [bookmark: pgfId-412969]Action tab—Specifies special processing to apply to a specific connection or session. Select one of the following options from the drop-down list:

  
        

 
         
         		[bookmark: pgfId-412977]Continue

  
         		[bookmark: pgfId-412979](Default) When selected, continues the session. By default, the access policy attributes are applied to the session and it is running.

  
        

 
         
         		[bookmark: pgfId-412985]Quarantine

  
         		[bookmark: pgfId-412987]When selected, quarantines the session.

 [bookmark: pgfId-412989]By selecting quarantine, you can restrict a particular client who already has an established tunnel through a VPN. Restricted ACLs are applied to a session to form a restricted group, based on the selected DAP record. When an endpoint is not compliant with an administratively defined policy, the user can still access services for remediation (such as updating the antivirus and so on), but restrictions are placed upon the user. After the remediation occurs, the user can reconnect, which invokes a new posture assessment. If this assessment passes, the user connects.

 [bookmark: pgfId-412991]Note This parameter requires an AnyConnect release that supports AnyConnect Secure Mobility features.

  
        

 
         
         		[bookmark: pgfId-412997]Terminate

  
         		[bookmark: pgfId-412999]When selected, terminates the session. By default, the access policy attributes are applied to the session and it is running.

  
        

 
         
         		[bookmark: pgfId-413005]User Message

  
         		[bookmark: pgfId-413007]Enter a text message to display on the portal page when this DAP record is selected. Maximum 128 characters. A user message displays as a yellow orb. When a user logs on it blinks three times to attract attention, and then it is still. If several DAP records are selected, and each of them has a user message, all user messages display.

 For example: All contractors please read <a href=‘http://wwwin.abc.com/procedure.html’> Instructions</a> for the procedure to upgrade your antivirus software.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-415579][bookmark: 84339][bookmark: ravpnpg_cncpt_AddEditDAPEntryDialogBox]Add/Edit DAP Entry Dialog Box[bookmark: marker-415577]

 
     [bookmark: pgfId-415581]Use the Add/Edit DAP Entry dialog box to specify the authorization attributes and endpoint attributes for a dynamic access policy. The security appliance selects the dynamic access policy based on the endpoint security information of the remote device and the AAA authorization information for the authenticated user. It then applies the dynamic access policy to the user tunnel or session.

 
     [bookmark: pgfId-415586]For detailed information about dynamic access policy attributes, see Understanding DAP Attributes.

 
     [bookmark: pgfId-415588]The content of the dialog box differs based on the criterion that you select. The criterion is the authorization or endpoint attribute that serves as the selection criterion that the security appliance uses for selecting and applying dynamic access policies during session establishment. You can select from the following criteria:

 
      
      		 [bookmark: pgfId-415593]AAA Attributes Cisco—Refers to user authorization attributes that are stored in the AAA hierarchical model. See Add/Edit DAP Entry Dialog Box > AAA Attributes Cisco

 
      		 [bookmark: pgfId-415598]AAA Attributes LDAP—Sets the LDAP client stores all native LDAP response attribute value pairs in a database associated with the AAA session for the user. See Add/Edit DAP Entry Dialog Box > AAA Attributes LDAP.

 
      		 [bookmark: pgfId-415603]AAA Attributes RADIUS—Sets the RADIUS client stores all native RADIUS response attribute value pairs in a database associated with the AAA session for the user. See Add/Edit DAP Entry Dialog Box > AAA Attributes RADIUS.

 
      		 [bookmark: pgfId-415608]Anti-Spyware—Creates an endpoint attribute of type Anti-Spyware. You can use the Host Scan modules of Cisco Secure Desktop to scan for antispyware applications and updates that are running on the remote computer. See Add/Edit DAP Entry Dialog Box > Anti-Spyware.

 
      		 [bookmark: pgfId-415613]Anti-Virus—Creates an endpoint attribute of type Anti-Virus. You can use the Host Scan modules of Cisco Secure Desktop to scan for antivirus applications and updates that are running on the remote computer. See Add/Edit DAP Entry Dialog Box > Anti-Virus.

 
      		 [bookmark: pgfId-415618]AnyConnect Identity—Creates an endpoint attribute of type AnyConnect Identity. See Add/Edit DAP Entry Dialog Box > AnyConnect Identity.

 
      		 [bookmark: pgfId-415623]Application—Indicates the type of remote access connection. See Add/Edit DAP Entry Dialog Box > Application.

 
      		 [bookmark: pgfId-415628]Device—Creates an endpoint attribute of type Device. The Device Criterion lets you provide specific device information for use during the associated prelogin policy checking. See Add/Edit DAP Entry Dialog Box > Device.

 
      		 [bookmark: pgfId-415633]File—Creates an endpoint attribute of type File. Filename checking to be performed by Basic Host Scan must be explicitly configured using Cisco Secure Desktop Manager. See Add/Edit DAP Entry Dialog Box > File.

 
      		 [bookmark: pgfId-415638]NAC—Creates an endpoint attribute of type NAC. NAC protects the enterprise network from intrusion and infection from worms, viruses, and rogue applications by performing endpoint compliancy. We refer to these checks as posture†validation. See Add/Edit DAP Entry Dialog Box > NAC.

 
      		 [bookmark: pgfId-415643]Operating System—Creates an endpoint attribute of type Operating System. The prelogin assessment module of the CSD can check the remote device for the OS version, IP address, and Microsoft Windows registry keys. See Add/Edit DAP Entry Dialog Box > Operating System.

 
      		 [bookmark: pgfId-415648]Personal Firewall—Creates an endpoint attribute of type Personal Firewall. You can use the Host Scan modules of Cisco Secure Desktop to scan for personal firewall applications and updates that are running on the remote computer. For a description of the elements in the dialog box, see Add/Edit DAP Entry Dialog Box > Personal Firewall.

 
      		 [bookmark: pgfId-415653]Policy—Creates an endpoint attribute of type Policy. See Add/Edit DAP Entry Dialog Box > Policy.

 
      		 [bookmark: pgfId-415658]Process—Process name checking to be performed by Basic Host Scan must be explicitly configured using Cisco Secure Desktop Manager. See Add/Edit DAP Entry Dialog Box > Process.

 
      		 [bookmark: pgfId-415663]Registry—Creates an endpoint attribute of type Registry. Registry key scans apply only to computers running Windows Microsoft Windows operating systems. See Add/Edit DAP Entry Dialog Box > Registry.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-415665]Note Duplicate entries are not allowed. If you configure a dynamic access policy with no AAA or endpoint attributes, the security appliance always selects it since all selection criteria are satisfied.


     
      

     

     

 
     [bookmark: pgfId-415667]Navigation Path

 
     [bookmark: pgfId-415672]Open the Add/Edit Dynamic Access Policy Dialog Box with the Main tab selected, then click Create, or select a dynamic access policy in the table and click Edit. The Add/Edit DAP Entry dialog box is displayed.

 
     [bookmark: pgfId-415674]Related Topics

 
      
      		 [bookmark: pgfId-415679]Understanding DAP Attributes

 
      		 [bookmark: pgfId-415684]Configuring DAP Attributes

 
      		 [bookmark: pgfId-415689]Configuring Dynamic Access Policies

 
     

 
    
 
     
      [bookmark: pgfId-415699][bookmark: 84416][bookmark: ravpnpg_cncpt_AddEditDAPEntryDialogBoxAAAAttributesCisco]Add/Edit DAP Entry Dialog Box > AAA Attributes Cisco[bookmark: marker-415697]

 
     [bookmark: pgfId-415701]To configure AAA attributes as selection criteria for dynamic access policies, in the Add/Edit DAP Entry dialog box, set AAA Attributes Cisco as the selection criterion to be used to select and apply the dynamic access policies during session establishment. You can set these attributes either to match or not match the value you enter. There is no limit for the number of AAA attributes for each dynamic access policy.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-415703]Note Duplicate entries are not allowed. If you configure a dynamic access policy with no AAA or endpoint attributes, the security appliance always selects it since all selection criteria are satisfied.


     
      

     

     

 
     [bookmark: pgfId-415705]Navigation Path

 
     [bookmark: pgfId-415710]Open the Add/Edit Dynamic Access Policy Dialog Box with the Main tab selected, then click Create, or select a dynamic access policy in the table and click Edit. The Add/Edit DAP Entry dialog box is displayed. Select AAA Attributes Cisco as the Criterion.

 
     [bookmark: pgfId-415712]Related Topics

 
      
      		 [bookmark: pgfId-415717]Understanding DAP Attributes

 
      		 [bookmark: pgfId-415722]Configuring DAP Attributes

 
      		 [bookmark: pgfId-415727]Configuring Dynamic Access Policies

 
     

 
     [bookmark: pgfId-415729]Field Reference

 
     [bookmark: pgfId-415732] 

 
      
       
        
        [bookmark: pgfId-413022]Table 32-6 [bookmark: 84447]Add/Edit DAP Entry Dialog Box > AAA Attributes Cisco 

 
        
       
         
         		
           
           [bookmark: pgfId-413028]Element
          
  
         		
           
           [bookmark: pgfId-413030]Description
          
  
        

 
         
         		[bookmark: pgfId-413036]Criterion

  
         		[bookmark: pgfId-413038]Shows AAA Attributes Cisco as the selection criterion.

  
        

 
         
         		[bookmark: pgfId-413044]Group Policy

  
         		[bookmark: pgfId-413046]Select the check box, select the matching criteria (for example, is) from the drop-down list, and enter the name of the AAA server group associated with the user. The maximum length is 64 characters.

 [bookmark: pgfId-413048]AAA server groups represent collections of authentication servers focused on enforcing specific aspects of your overall network security policy.

  
        

 
         
         		[bookmark: pgfId-413054]IP Address

  
         		[bookmark: pgfId-413056]Select the check box, select the matching criteria (for example, is) from the drop-down list, and enter the assigned IP address.

 [bookmark: pgfId-413058]Addresses are predefined network objects. You can also click Select to open a dialog box that lists all available network hosts, and in which you can create or edit network host objects.

 [bookmark: pgfId-413060]Tip If you select this option and later look at the rule in ASDM, the IP Address attribute is called Assigned IP Address.  
        

 
         
         		[bookmark: pgfId-413066]Member-of

  
         		[bookmark: pgfId-413068]Select the check box, select the matching criteria (for example, is) from the drop-down list, and enter a comma-separated string of group policy names that apply to the user. This attribute lets you indicate multiple group membership. The maximum length is 128 characters.

 [bookmark: pgfId-413070]Tip If you select this option, and later look at the rule in ASDM, this option will not appear. In general, this option is not used because it can be confused with the memberof LDAP attribute. Because this rule applies to Local authentication, you might want to use the Username attribute instead of the Member-of attribute.  
        

 
         
         		[bookmark: pgfId-413076]Username

  
         		[bookmark: pgfId-413078]Select the check box, select the matching criteria (for example, is) from the drop-down list, and enter the username of the authenticated user. A maximum of 64 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-413084]Username 2

  
         		[bookmark: pgfId-413086]Select the check box, select the matching criteria (is or isn’t) from the drop-down list, and enter the secondary username of the authenticated user.

  
        

 
         
         		[bookmark: pgfId-413092]Connection Profiles

  
         		[bookmark: pgfId-413094]Select the check box, select the matching criteria (for example, is) from the drop-down list, and select the connection profile from a list of all the SSL VPN Connection Profile policies defined on the security appliance.

 [bookmark: pgfId-413096]An SSL VPN connection profile comprises a set of records that contain VPN tunnel connection profile policies, including the attributes that pertain to creating the tunnel itself.

 [bookmark: pgfId-413101]Note For a description of the procedure to configure an SSL VPN Connection Profiles policy, see Configuring Connection Profiles (ASA, PIX 7.0+).

  
        

 
         
         		[bookmark: pgfId-413107]SCEP Required

  
         		[bookmark: pgfId-413109]Select the check box, select the matching criteria (is or isn’t) from the drop-down list, and select True or False. This attribute enables to match whether or not the connection fails the certificate authentication.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-415742][bookmark: 84517][bookmark: ravpnpg_cncpt_AddEditDAPEntryDialogBoxAAAAttributesLDAP]Add/Edit DAP Entry Dialog Box > AAA Attributes LDAP[bookmark: marker-415740]

 
     [bookmark: pgfId-415744]The LDAP client stores all native LDAP response attribute value pairs in a database associated with the AAA session for the user. The LDAP client writes the response attributes to the database in the order in which it receives them. It discards all subsequent attributes with that name. This scenario might occur when a user record and a group record are both read from the LDAP server. The user record attributes are read first, and always have priority over group record attributes.

 
     [bookmark: pgfId-415746]To support Active Directory group membership, the AAA LDAP client provides special handling of the LDAP memberOf response attribute. The AD memberOf attribute specifies the DN string of a group record in AD. The name of the group is the first CN value in the DN string. The LDAP client extracts the group name from the DN string and stores it as the AAA memberOf attribute, and in the response attribute database as the LDAP memberOf attribute. If there are additional memberOf attributes in the LDAP response message, then the group name is extracted from those attributes and is combined with the earlier AAA memberOf attribute to form a comma separated string of group names, also updated in the response attribute database.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-415748]Note Duplicate entries are not allowed. If you configure a dynamic access policy with no AAA or endpoint attributes, the security appliance always selects it since all selection criteria are satisfied.


     
      

     

     

 
     [bookmark: pgfId-415750]Navigation Path

 
     [bookmark: pgfId-415755]Open the Add/Edit Dynamic Access Policy Dialog Box with the Main tab selected, then click Create, or select a dynamic access policy in the table and click Edit. The Add/Edit DAP Entry dialog box is displayed. Select AAA Attributes LDAP as the Criterion.

 
     [bookmark: pgfId-415757]Related Topics

 
      
      		 [bookmark: pgfId-415762]Understanding DAP Attributes

 
      		 [bookmark: pgfId-415767]Configuring DAP Attributes

 
      		 [bookmark: pgfId-415772]Configuring Dynamic Access Policies

 
     

 
     [bookmark: pgfId-415774]Field Reference

 
     [bookmark: pgfId-415777] 

 
      
       
        
        [bookmark: pgfId-413122]Table 32-7 [bookmark: 84549]Add/Edit DAP Entry Dialog Box > AAA Attributes LDAP 

 
        
       
         
         		
           
           [bookmark: pgfId-413128]Element
          
  
         		
           
           [bookmark: pgfId-413130]Description
          
  
        

 
         
         		[bookmark: pgfId-413136]Criterion

  
         		[bookmark: pgfId-413138]Shows AAA Attributes LDAP as the selection criterion.

  
        

 
         
         		[bookmark: pgfId-413144]Attribute ID

  
         		[bookmark: pgfId-413146]Specify the name of the LDAP attribute map in the dynamic access policy. LDAP attribute maps take the attribute names that you define and map them to Cisco-defined attributes. A maximum of 64 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-413152]Value

  
         		[bookmark: pgfId-413154]Select the matching criteria (for example, is) from the drop-down list, and enter the custom map value that maps to a Cisco Map Value or enter the Cisco map value that maps to the Custom Map Value. To enter multiple values, separate each value with ; as the delimiter.

 [bookmark: pgfId-413156]The attribute map is populated with value mappings that apply customer, user-defined attribute values to the customer attribute name and to the matching Cisco attribute name and value.

 [bookmark: pgfId-413158]Alternatively, click the Fetch AD Groups button to open the Fetch AD Groups dialog box. The table in the dialog box lists the UserGroup ID and UserGroup Name of the available LDAP servers that you can choose from. Select one or more rows and click the Select button.

 [bookmark: pgfId-413160]To search for a particular UserGroup in the list you can enter text in the Filter text box and click Search. The UserGroup name meeting the criteria appears in the list.

 from the table of contents. For more information, see Identity Settings Page.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-415787][bookmark: 84588][bookmark: ravpnpg_cncpt_AddEditDAPEntryDialogBoxAAAAttributesRADIUS]Add/Edit DAP Entry Dialog Box > AAA Attributes RADIUS[bookmark: marker-415785]

 
     [bookmark: pgfId-415789]The RADIUS client stores all native RADIUS response attribute value pairs in a database associated with the AAA session for the user. The RADIUS client writes the response attributes to the database in the order in which it receives them. It discards all subsequent attributes with that name. This scenario might occur when a user record and a group record are both read from the RADIUS server. The user record attributes are read first, and always have priority over group record attributes.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-415791]Note Duplicate entries are not allowed. If you configure a dynamic access policy with no AAA or endpoint attributes, the security appliance always selects it since all selection criteria are satisfied.


     
      

     

     

 
     [bookmark: pgfId-415793]Navigation Path

 
     [bookmark: pgfId-415798]Open the Add/Edit Dynamic Access Policy Dialog Box with the Main tab selected, then click Create, or select a dynamic access policy in the table and click Edit. The Add/Edit DAP Entry dialog box is displayed. Select AAA Attributes RADIUS as the Criterion.

 
     [bookmark: pgfId-415800]Related Topics

 
      
      		 [bookmark: pgfId-415805]Understanding DAP Attributes

 
      		 [bookmark: pgfId-415810]Configuring DAP Attributes

 
      		 [bookmark: pgfId-415815]Configuring Dynamic Access Policies

 
     

 
     [bookmark: pgfId-415817]Field Reference

 
     [bookmark: pgfId-415820] 

 
      
       
        
        [bookmark: pgfId-413178]Table 32-8 [bookmark: 84619]Add/Edit DAP Entry Dialog Box > AAA Attributes RADIUS 

 
        
       
         
         		
           
           [bookmark: pgfId-413184]Element
          
  
         		
           
           [bookmark: pgfId-413186]Description
          
  
        

 
         
         		[bookmark: pgfId-413192]Criterion

  
         		[bookmark: pgfId-413194]Shows AAA Attributes RADIUS as the selection criterion.

  
        

 
         
         		[bookmark: pgfId-413200]Attribute ID

  
         		[bookmark: pgfId-413202]Specify the name of the RADIUS attribute name or number in the dynamic access policy. A maximum of 64 characters is allowed.

 [bookmark: pgfId-413204]RADIUS attribute names do not contain the cVPN3000 prefix to better reflect support for all three security appliances (VPN 3000, PIX, and the ASA). The appliances enforce the RADIUS attributes based on attribute numeric ID, not attribute name. LDAP attributes are enforced by their name, not by the ID.

  
        

 
         
         		[bookmark: pgfId-413210]Value

  
         		[bookmark: pgfId-413212]Select the matching criteria (for example, is) from the drop-down list, and enter the attribute value.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-415830][bookmark: 84647][bookmark: ravpnpg_cncpt_AddEditDAPEntryDialogBoxAntiSpyware]Add/Edit DAP Entry Dialog Box > Anti-Spyware[bookmark: marker-415828]

 
     [bookmark: pgfId-415832]You can use the Host Scan feature of the Cisco Secure Desktop feature to enable Endpoint Assessment, a scan for antivirus, personal firewall, and antispyware applications and updates that are running on the remote computer. Following the configuration of the prelogin policies and host scan options, you can configure a match of any one or any combination of the Host Scan results to assign a dynamic access policy following the user login.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-415834]Note Duplicate entries are not allowed. If you configure a dynamic access policy with no AAA or endpoint attributes, the security appliance always selects it since all selection criteria are satisfied.


     
      

     

     

 
     [bookmark: pgfId-415836]Navigation Path

 
     [bookmark: pgfId-415841]Open the Add/Edit Dynamic Access Policy Dialog Box with the Main tab selected, then click Create, or select a dynamic access policy in the table and click Edit. The Add/Edit DAP Entry dialog box is displayed. Select Anti-Spyware as the Criterion.

 
     [bookmark: pgfId-415843]Related Topics

 
      
      		 [bookmark: pgfId-415848]Understanding DAP Attributes

 
      		 [bookmark: pgfId-415853]Configuring DAP Attributes

 
      		 [bookmark: pgfId-415858]Configuring Dynamic Access Policies

 
     

 
     [bookmark: pgfId-415860]Field Reference

 
     [bookmark: pgfId-415863] 

 
      
       
        
        [bookmark: pgfId-413225]Table 32-9 [bookmark: 84678]Add/Edit DAP Entry Dialog Box > Anti-Spyware 

 
        
       
         
         		
           
           [bookmark: pgfId-413231]Element
          
  
         		
           
           [bookmark: pgfId-413233]Description
          
  
        

 
         
         		[bookmark: pgfId-413239]Criterion

  
         		[bookmark: pgfId-413241]Shows Anti-Spyware as the selection criterion.

  
        

 
         
         		[bookmark: pgfId-413247]Type

  
         		[bookmark: pgfId-413249]Select one of the following options and assign the associated values:

 
           
           		 [bookmark: pgfId-413251] Not Installed —Select if the absence of the named anti-spyware from the remote PC is sufficient to match the prelogin policy you are configuring.

 
           		 [bookmark: pgfId-413253] Installed and enabled —Select if the named anti-spyware must be present and enabled on the remote PC to match the prelogin policy you are configuring.

 
           		 [bookmark: pgfId-413255] Installed and disabled —Select if the mere presence of the named anti-spyware on the remote PC is sufficient to match the prelogin policy you are configuring.

 
          

  
        

 
         
         		[bookmark: pgfId-413261]Vendor Name

  
         		[bookmark: pgfId-413263]Select the text that describes the application vendor from the list.

  
        

 
         
         		[bookmark: pgfId-413269]Product ID

  
         		[bookmark: pgfId-413271]Select a unique identifier for the product that is supported by the selected vendor from the list.

  
        

 
         
         		[bookmark: pgfId-413277]Product Description

  
         		[bookmark: pgfId-413279]Available only if you selected Matches as the Type.

 [bookmark: pgfId-413281]Select the check box, then select the description of the product from the list.

  
        

 
         
         		[bookmark: pgfId-413287]Version

  
         		[bookmark: pgfId-413289]Available only if you selected Matches as the Type.

 [bookmark: pgfId-413291]Identify the version of the application, and specify whether you want the endpoint attribute to be equal to/not equal to that version.

  
        

 
         
         		[bookmark: pgfId-413297]Last Update

  
         		[bookmark: pgfId-413299]Available only if you selected Matches as the Type.

 [bookmark: pgfId-413301]Specify the number of days since the last update. You might want to indicate that an update should occur in less than or greater than the number of days you enter here.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-415873][bookmark: 84740][bookmark: ravpnpg_cncpt_AddEditDAPEntryDialogBoxAntiVirus]Add/Edit DAP Entry Dialog Box > Anti-Virus[bookmark: marker-415871]

 
     [bookmark: pgfId-415875]You can configure a scan for antivirus applications and updates as a condition for the completion of a Cisco AnyConnect or clientless SSL VPN connection. Following the prelogin assessment, Cisco Secure Desktop loads Endpoint Assessment checks and reports the results back to the security appliance for use in assigning a dynamic access policy.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-415877]Note Duplicate entries are not allowed. If you configure a dynamic access policy with no AAA or endpoint attributes, the security appliance always selects it since all selection criteria are satisfied.


     
      

     

     

 
     [bookmark: pgfId-415879]Navigation Path

 
     [bookmark: pgfId-415884]Open the Add/Edit Dynamic Access Policy Dialog Box with the Main tab selected, then click Create, or select a dynamic access policy in the table and click Edit. The Add/Edit DAP Entry dialog box is displayed. Select Anti-Virus as the Criterion.

 
     [bookmark: pgfId-415886]Related Topics

 
      
      		 [bookmark: pgfId-415891]Understanding DAP Attributes

 
      		 [bookmark: pgfId-415896]Configuring DAP Attributes

 
      		 [bookmark: pgfId-415901]Configuring Dynamic Access Policies

 
     

 
     [bookmark: pgfId-415903]Field Reference

 
     [bookmark: pgfId-415906] 

 
      
       
        
        [bookmark: pgfId-413314]Table 32-10 [bookmark: 84771]Add/Edit DAP Entry Dialog Box > Anti-Virus 

 
        
       
         
         		
           
           [bookmark: pgfId-413320]Element
          
  
         		
           
           [bookmark: pgfId-413322]Description
          
  
        

 
         
         		[bookmark: pgfId-413328]Criterion

  
         		[bookmark: pgfId-413330]Shows Anti-Virus as the selection criterion.

  
        

 
         
         		[bookmark: pgfId-413336]Type

  
         		[bookmark: pgfId-413338]Select one of the following options and assign the associated values:

 
           
           		 [bookmark: pgfId-413340] Not Installed —Select if the absence of the named anti-virus from the remote PC is sufficient to match the prelogin policy you are configuring.

 
           		 [bookmark: pgfId-413342] Installed and enabled —Select if the named anti-virus must be present and enabled on the remote PC to match the prelogin policy you are configuring.

 
           		 [bookmark: pgfId-413344] Installed and disabled —Select if the mere presence of the named anti-virus on the remote PC is sufficient to match the prelogin policy you are configuring.

 
          

  
        

 
         
         		[bookmark: pgfId-413350]Vendor Name

  
         		[bookmark: pgfId-413352]Select the text that describes the application vendor from the list.

  
        

 
         
         		[bookmark: pgfId-413358]Product ID

  
         		[bookmark: pgfId-413360]Select a unique identifier for the product that is supported by the selected vendor from the list.

  
        

 
         
         		[bookmark: pgfId-413366]Product Description

  
         		[bookmark: pgfId-413368]Available only if you selected the criteria to match the endpoint attribute for the dynamic access policy.

 [bookmark: pgfId-413370]Select the check box, then select the description of the product from the list.

  
        

 
         
         		[bookmark: pgfId-413376]Version

  
         		[bookmark: pgfId-413378]Available only if you selected the criteria to match the endpoint attribute for the dynamic access policy.

 [bookmark: pgfId-413380]Identify the version of the application, and specify whether you want the endpoint attribute to be equal to/not equal to that version.

  
        

 
         
         		[bookmark: pgfId-413386]Last Update

  
         		[bookmark: pgfId-413388]Available only if you selected the criteria to match the endpoint attribute for the dynamic access policy.

 [bookmark: pgfId-413390]Specify the number of days since the last update. You might want to indicate that an update should occur in less than or greater than the number of days you enter here.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-415916][bookmark: 84830][bookmark: ravpnpg_cncpt_AddEditDAPEntryDialogBoxAnyConnectIdentity]Add/Edit DAP Entry Dialog Box > AnyConnect Identity[bookmark: marker-415914]

 
     [bookmark: pgfId-415918]To configure AnyConnect Identity attributes as selection criteria for dynamic access policies, set AnyConnect Identity as the selection criterion in the Add/Edit DAP Entry dialog box. The ASA generates DAP endpoint attributes based on the AnyConnect Identification attributes received from the AnyConnect mobile client. You are not required to enable Cisco Secure Desktop to configure these specific attributes using Security Manager.

 
     [bookmark: pgfId-415920]For the purposes of assigning a dynamic access policy, if you configure more than one AnyConnect Identity attribute for a particular DAP entry, the entry will be considered a match if any of the attributes values are true. There is no limit for the number of AnyConnect Identity attributes for each dynamic access policy.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-415922]Note Duplicate entries are not allowed. If you configure a dynamic access policy with no AAA or endpoint attributes, the security appliance always selects it since all selection criteria are satisfied.


     
      

     

     

 
     [bookmark: pgfId-415924]Navigation Path

 
     [bookmark: pgfId-415929]Open the Add/Edit Dynamic Access Policy Dialog Box with the Main tab selected, then click Create, or select a dynamic access policy in the table and click Edit. The Add/Edit DAP Entry dialog box is displayed. Select AnyConnect Identity as the Criterion.

 
     [bookmark: pgfId-415931]Related Topics

 
      
      		 [bookmark: pgfId-415936]Understanding DAP Attributes

 
      		 [bookmark: pgfId-415941]Configuring DAP Attributes

 
      		 [bookmark: pgfId-415946]Configuring Dynamic Access Policies

 
     

 
     [bookmark: pgfId-415948]Field Reference

 
     [bookmark: pgfId-415951] 

 
      
       
        
        [bookmark: pgfId-413403]Table 32-11 [bookmark: 84862]Add/Edit DAP Entry Dialog Box > AnyConnect Identity 

 
        
       
         
         		
           
           [bookmark: pgfId-413409]Element
          
  
         		
           
           [bookmark: pgfId-413411]Description
          
  
        

 
         
         		[bookmark: pgfId-413417]Criterion

  
         		[bookmark: pgfId-413419]Shows AnyConnect Identity as the selection criterion.

  
        

 
         
         		[bookmark: pgfId-413425]Client Version

  
         		[bookmark: pgfId-413427]Select the check box, select the matching criteria (for example, is) from the drop-down list, and enter the AnyConnect Client version number.

  
        

 
         
         		[bookmark: pgfId-413433]Platform

  
         		[bookmark: pgfId-413435]Select the check box, select the matching criteria (for example, is) from the drop-down list, and select the appropriate platform from the drop-down list.

  
        

 
         
         		[bookmark: pgfId-413441]Platform Version

  
         		[bookmark: pgfId-413443]Select the check box, select the matching criteria (for example, is) from the drop-down list, and enter the appropriate version number of the platform.

  
        

 
         
         		[bookmark: pgfId-413449]Device Type

  
         		[bookmark: pgfId-413451]Select the check box, select the matching criteria (for example, is) from the drop-down list, and select the appropriate device type from the drop-down list.

  
        

 
         
         		[bookmark: pgfId-413457]Device Unique ID

  
         		[bookmark: pgfId-413459]Select the check box, select the matching criteria (for example, is) from the drop-down list, and enter the unique device ID. This ID distinguishes the device allowing you to set policies exclusive to that device.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-415961][bookmark: 84908][bookmark: ravpnpg_cncpt_AddEditDAPEntryDialogBoxApplication]Add/Edit DAP Entry Dialog Box > Application[bookmark: marker-415959]

 
     [bookmark: pgfId-415963]Use this dialog box to indicate the type of remote access connection as the endpoint attribute for the dynamic access policy.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-415965]Note Duplicate entries are not allowed. If you configure a dynamic access policy with no AAA or endpoint attributes, the security appliance always selects it since all selection criteria are satisfied.


     
      

     

     

 
     [bookmark: pgfId-415967]Navigation Path

 
     [bookmark: pgfId-415972]Open the Add/Edit Dynamic Access Policy Dialog Box with the Main tab selected, then click Create, or select a dynamic access policy in the table and click Edit. The Add/Edit DAP Entry dialog box is displayed. Select Application as the Criterion.

 
     [bookmark: pgfId-415974]Related Topics

 
      
      		 [bookmark: pgfId-415979]Understanding DAP Attributes

 
      		 [bookmark: pgfId-415984]Configuring DAP Attributes

 
      		 [bookmark: pgfId-415989]Configuring Dynamic Access Policies

 
     

 
     [bookmark: pgfId-415991]Field Reference

 
     [bookmark: pgfId-415994] 

 
      
       
        
        [bookmark: pgfId-413472]Table 32-12 [bookmark: 84939]Add/Edit DAP Entry Dialog Box > Application 

 
        
       
         
         		
           
           [bookmark: pgfId-413478]Element
          
  
         		
           
           [bookmark: pgfId-413480]Description
          
  
        

 
         
         		[bookmark: pgfId-413486]Criterion

  
         		[bookmark: pgfId-413488]Shows Application as the selection criterion.

  
        

 
         
         		[bookmark: pgfId-413494]Client Type

  
         		[bookmark: pgfId-413496]Select the check box, then select the matching criteria (for example, is or isn’t) from the drop-down list, and specify the type of remote access connection from the list: AnyConnect, Clientless, Cut-through Proxy, IPsec, Generic IKEv2 Client, or L2TP.

 [bookmark: pgfId-413498]Note If you select AnyConnect as the client type, make sure to enable Cisco Secure Desktop. If it is not enabled, Security Manager generates an error.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-416006][bookmark: 84963][bookmark: ravpnpg_cncpt_AddEditDAPEntryDialogBoxDevice]Add/Edit DAP Entry Dialog Box > Device[bookmark: marker-416002][bookmark: marker-416004]

 
     [bookmark: pgfId-416008]The DAP Device Criterion lets you provide specific device information for use during the associated prelogin policy checking. You can provide one or more of the following attributes for a device—host name, MAC address, port number, Privacy Protection selection—and indicate whether each is or isn’t to be matched.

 
     [bookmark: pgfId-416010]Note that isn’t is exclusionary. For example, if you specify the criterion Host Name isn’t zulu_2, all devices not named zulu_2 will match.

 
     [bookmark: pgfId-416012]Navigation Path

 
     [bookmark: pgfId-416017]Open the Add/Edit Dynamic Access Policy Dialog Box with the Main tab selected, then click Create, or select a dynamic access policy in the table and click Edit. The Add/Edit DAP Entry dialog box is displayed. Choose Device as the Criterion.

 
     [bookmark: pgfId-416019]Related Topics

 
      
      		 [bookmark: pgfId-416024]Understanding DAP Attributes

 
      		 [bookmark: pgfId-416029]Configuring DAP Attributes

 
      		 [bookmark: pgfId-416034]Configuring Dynamic Access Policies

 
     

 
     [bookmark: pgfId-416036]Field Reference

 
     [bookmark: pgfId-416039] 

 
      
       
        
        [bookmark: pgfId-413511]Table 32-13 [bookmark: 84999]Add/Edit DAP Entry Dialog Box > Device 

 
        
       
         
         		
           
           [bookmark: pgfId-413517]Element
          
  
         		
           
           [bookmark: pgfId-413519]Description
          
  
        

 
         
         		[bookmark: pgfId-413525]Criterion

  
         		[bookmark: pgfId-413527]Shows Device as the selected Criterion.

  
        

 
         
         		[bookmark: pgfId-413533]Host Name

  
         		[bookmark: pgfId-413535]Select this option, choose a match criterion (is or isn’t) from the related drop-down list, and then enter the device host name to be matched.

  
        

 
         
         		[bookmark: pgfId-413541]MAC Address

  
         		[bookmark: pgfId-413543]Select this option, choose a match criterion (is or isn’t) from the related drop-down list, and then enter the device’s MAC address to be matched.

  
        

 
         
         		[bookmark: pgfId-413549]BIOS Serial Number

  
         		[bookmark: pgfId-413551]Select this option, choose a match criterion (is or isn’t) from the related drop-down list, and then enter the BIOS serial number value of the device you are matching for. The number format is manufacturer-specific. There is no format requirement.

  
        

 
         
         		[bookmark: pgfId-413557]Port Number

  
         		[bookmark: pgfId-413559]Select this option, choose a match criterion (is or isn’t), and then enter or Select the device port to be matched.

  
        

 
         
         		[bookmark: pgfId-413565]TCP/UDP Port Number

  
         		[bookmark: pgfId-413567]Select this option, choose a match criterion (is or isn’t), and then enter or Select the TCP/UDP port in listening state that you are matching for.

 [bookmark: pgfId-413569]In the TCP/UDP combo box, select the kind of port you are matching for: TCP (IPv4) or UDP(IPv4). If you are matching for more than one port, make several individual endpoint attribute rules in the DAP and specify one port in each.

  
        

 
         
         		[bookmark: pgfId-413575]Privacy Protection

  
         		[bookmark: pgfId-413577]Select this option, choose a match criterion (is or isn’t), and then choose the Privacy Protection option defined on the device: none, cache cleaner, or secure desktop.

  
        

 
         
         		[bookmark: pgfId-413583]CSD Version

  
         		[bookmark: pgfId-413585]Select this option, choose a match criterion (is or isn’t) from the related drop-down list, and then enter the version of the Host Scan image running on the endpoint.

  
        

 
         
         		[bookmark: pgfId-413591]Endpoint Assessment Version

  
         		[bookmark: pgfId-413593]Select this option, choose a match criterion (is or isn’t) from the related drop-down list, and then enter the version of endpoint assessment (OPSWAT) you are matching for.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-416049][bookmark: 85075][bookmark: ravpnpg_cncpt_AddEditDAPEntryDialogBoxFile]Add/Edit DAP Entry Dialog Box > File[bookmark: marker-416047]

 
     [bookmark: pgfId-416051]The file criterion prelogin check lets you specify that a certain file must or must not exist to be eligible for the associated prelogin policy. For example, you might want to use a file prelogin check to ensure a corporate file is present or one or more peer-to-peer file-sharing programs containing malware are not present before assigning a prelogin policy.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-416053]Note Duplicate entries are not allowed. If you configure a dynamic access policy with no AAA or endpoint attributes, the security appliance always selects it since all selection criteria are satisfied.


     
      

     

     

 
     [bookmark: pgfId-416055]Navigation Path

 
     [bookmark: pgfId-416060]Open the Add/Edit Dynamic Access Policy Dialog Box with the Main tab selected, then click Create, or select a dynamic access policy in the table and click Edit. The Add/Edit DAP Entry dialog box is displayed. Select File as the Criterion.

 
     [bookmark: pgfId-416062]Related Topics

 
      
      		 [bookmark: pgfId-416067]Understanding DAP Attributes

 
      		 [bookmark: pgfId-416072]Configuring DAP Attributes

 
      		 [bookmark: pgfId-416077]Configuring Dynamic Access Policies

 
     

 
     [bookmark: pgfId-416079]Field Reference

 
     [bookmark: pgfId-416082] 

 
      
       
        
        [bookmark: pgfId-413606]Table 32-14 [bookmark: 85106]Add/Edit DAP Entry Dialog Box > File 

 
        
       
         
         		
           
           [bookmark: pgfId-413612]Element
          
  
         		
           
           [bookmark: pgfId-413614]Description
          
  
        

 
         
         		[bookmark: pgfId-413620]Criterion

  
         		[bookmark: pgfId-413622]Shows File as the selection criterion.

  
        

 
         
         		[bookmark: pgfId-413628]Type

  
         		[bookmark: pgfId-413630]Specify whether this endpoint attribute must match or not match the criteria configured for selecting and applying dynamic access policies during session establishment.

  
        

 
         
         		[bookmark: pgfId-413636]Endpoint ID

  
         		[bookmark: pgfId-413638]Select a string that identifies an endpoint for files. Dynamic access policies use this ID to match Cisco Secure Desktop host scan attributes for dynamic access policy selection. You must configure Host Scan before you configure this attribute. When you configure Host Scan, the configuration displays in this pane, so you can select it, reducing the possibility of errors in typing or syntax.

  
        

 
         
         		[bookmark: pgfId-413644]Filename

  
         		[bookmark: pgfId-413646]Specify the filename.

  
        

 
         
         		[bookmark: pgfId-413652]Last Update

  
         		[bookmark: pgfId-413654]Available only if you selected the criteria to match the endpoint attribute for the dynamic access policy.

 [bookmark: pgfId-413656]Specify the number of days since the last update. You might want to indicate that an update should occur in less than (<) or more than (>) the number of days you enter here.

  
        

 
         
         		[bookmark: pgfId-413662]Checksum

  
         		[bookmark: pgfId-413664]Available only if you selected the criteria to match the endpoint attribute for the DAP record.

 [bookmark: pgfId-413666]Select the check box to specify a checksum to authenticate the file, then enter a checksum in hexadecimal format, beginning with 0x.

 [bookmark: pgfId-413668]Beginning with version 4.7, Security Manager provides a utility to compute CRC32 checksum for a file. Click the Compute CRC32 Checksum button to open the Compute Checksum dialog box. Click Browse to open the File browser, select the required file and then click the Compute button. The CRC32 checksum of the file will be calculated and populated in the Checksum field.

 from the table of contents. For more information, see Customize Desktop Page.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-416092][bookmark: 85156][bookmark: ravpnpg_cncpt_AddEditDAPEntryDialogBoxNAC]Add/Edit DAP Entry Dialog Box > NAC[bookmark: marker-416090]

 
     [bookmark: pgfId-416094]NAC protects the enterprise network from intrusion and infection from worms, viruses, and rogue applications by performing endpoint compliancy and vulnerability checks as a condition for production access to the network. We refer to these checks as posture†validation. You can configure posture validation to ensure that the anti-virus files, personal firewall rules, or intrusion protection software on a host with an AnyConnect or Clientless SSL VPN session are up-to-date before providing access to vulnerable hosts on the intranet. Posture validation can include the verification that the applications running on the remote hosts are updated with the latest patches. NAC occurs only after user authentication and the setup of the tunnel. NAC is especially useful for protecting the enterprise network from hosts that are not subject to automatic network policy enforcement, such as home PCs. The security appliance uses Extensible Authentication Protocol (EAP) over UDP (EAPoUDP) messaging to validate the posture of remote hosts.

 
     [bookmark: pgfId-416096]The establishment of a tunnel between the endpoint and the security appliance triggers posture validation. You can configure the security appliance to pass the IP address of the client to an optional audit server if the client does not respond to a posture validation request. The audit server, such as a Trend server, uses the host IP address to challenge the host directly to assess its health. For example, it may challenge the host to determine whether its virus checking software is active and up-to-date. After the audit server completes its interaction with the remote host, it passes a token to the posture validation server, indicating the health of the remote host.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-416098]Note Duplicate entries are not allowed. If you configure a dynamic access policy with no AAA or endpoint attributes, the security appliance always selects it since all selection criteria are satisfied.


     
      

     

     

 
     [bookmark: pgfId-416100]Navigation Path

 
     [bookmark: pgfId-416105]Open the Add/Edit Dynamic Access Policy Dialog Box with the Main tab selected, then click Create, or select a dynamic access policy in the table and click Edit. The Add/Edit DAP Entry dialog box is displayed. Select NAC as the Criterion.

 
     [bookmark: pgfId-416107]Related Topics

 
      
      		 [bookmark: pgfId-416112]Understanding DAP Attributes

 
      		 [bookmark: pgfId-416117]Configuring DAP Attributes

 
      		 [bookmark: pgfId-416122]Configuring Dynamic Access Policies

 
     

 
     [bookmark: pgfId-416124]Field Reference

 
     [bookmark: pgfId-416127] 

 
      
       
        
        [bookmark: pgfId-413686]Table 32-15 [bookmark: 85189]Add/Edit DAP Entry Dialog Box > NAC 

 
        
       
         
         		
           
           [bookmark: pgfId-413692]Element
          
  
         		
           
           [bookmark: pgfId-413694]Description
          
  
        

 
         
         		[bookmark: pgfId-413700]Criterion

  
         		[bookmark: pgfId-413702]Shows NAC as the selection criterion.

  
        

 
         
         		[bookmark: pgfId-413708]Posture Status

  
         		[bookmark: pgfId-413710]Select the matching criteria (for example, is) from the drop-down list, then enter the posture token string received from ACS.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-416137][bookmark: 85211][bookmark: ravpnpg_cncpt_AddEditDAPEntryDialogBoxOperatingSystem]Add/Edit DAP Entry Dialog Box > Operating System[bookmark: marker-416135]

 
     [bookmark: pgfId-416139]The prelogin assessment includes a check for the OS attempting to establish a VPN connection. When the user attempts to connect, however, Cisco Secure Desktop checks for the OS, regardless of whether you insert an OS prelogin check.

 
     [bookmark: pgfId-416141]If the prelogin policy assigned to the connection has Secure Desktop (Secure Session) enabled and if the remote PC is running Microsoft Windows XP or Windows 2000, it installs Secure Session, regardless of whether you insert an OS prelogin check. If the prelogin policy has Secure Desktop enabled and the operating system is Microsoft Windows Vista, Mac OS X 10.4, or Linux, Cache Cleaner runs instead. Therefore, you should make sure the Cache Cleaner settings are appropriate for a prelogin policy on which you have configured Secure Desktop or Cache Cleaner to install. Although Cisco Secure Desktop checks for the OS, you may want to insert an OS prelogin check as a condition for applying a prelogin policy to isolate subsequent checks for each OS.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-416143]Note Duplicate entries are not allowed. If you configure a dynamic access policy with no AAA or endpoint attributes, the security appliance always selects it since all selection criteria are satisfied.


     
      

     

     

 
     [bookmark: pgfId-416145]Navigation Path

 
     [bookmark: pgfId-416150]Open the Add/Edit Dynamic Access Policy Dialog Box with the Main tab selected, then click Create, or select a dynamic access policy in the table and click Edit. The Add/Edit DAP Entry dialog box is displayed. Select Operating System as the Criterion.

 
     [bookmark: pgfId-416152]Related Topics

 
      
      		 [bookmark: pgfId-416157]Understanding DAP Attributes

 
      		 [bookmark: pgfId-416162]Configuring DAP Attributes

 
      		 [bookmark: pgfId-416167]Configuring Dynamic Access Policies

 
     

 
     [bookmark: pgfId-416169]Field Reference

 
     [bookmark: pgfId-416172] 

 
      
       
        
        [bookmark: pgfId-413723]Table 32-16 [bookmark: 85243]Add/Edit DAP Entry Dialog Box > Operating System 

 
        
       
         
         		
           
           [bookmark: pgfId-413729]Element
          
  
         		
           
           [bookmark: pgfId-413731]Description
          
  
        

 
         
         		[bookmark: pgfId-413737]Criterion

  
         		[bookmark: pgfId-413739]Shows Operating System as the selection criterion.

  
        

 
         
         		[bookmark: pgfId-413745]OS Version

  
         		[bookmark: pgfId-413747]Select the check box, then select the matching criteria (for example, is) from the drop-down list, and select the OS version from the list. Select Apple Plugin for iPhones and similar devices.

  
        

 
         
         		[bookmark: pgfId-413753]Service Pack

  
         		[bookmark: pgfId-413755]Select the check box, then select the matching criteria (for example, is) from the drop-down list, and select the service pack for the operating system.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-416182][bookmark: 85271][bookmark: ravpnpg_cncpt_AddEditDAPEntryDialogBoxPersonalFirewall]Add/Edit DAP Entry Dialog Box > Personal Firewall[bookmark: marker-416180]

 
     [bookmark: pgfId-416184]You can click Host Scan in the Cisco Secure Desktop interface to enable Endpoint Assessment, a scan for personal firewalls that are running on the remote computer. Most, but not all, personal firewall programs support active scan, which means that the programs are memory-resident, and therefore always running.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-416186]Note Duplicate entries are not allowed. If you configure a dynamic access policy with no AAA or endpoint attributes, the security appliance always selects it since all selection criteria are satisfied.


     
      

     

     

 
     [bookmark: pgfId-416188]Navigation Path

 
     [bookmark: pgfId-416193]Open the Add/Edit Dynamic Access Policy Dialog Box with the Main tab selected, then click Create, or select a dynamic access policy in the table and click Edit. The Add/Edit DAP Entry dialog box is displayed. Select AAA Attributes Cisco as the Criterion.

 
     [bookmark: pgfId-416195]Related Topics

 
      
      		 [bookmark: pgfId-416200]Understanding DAP Attributes

 
      		 [bookmark: pgfId-416205]Configuring DAP Attributes

 
      		 [bookmark: pgfId-416210]Configuring Dynamic Access Policies

 
     

 
     [bookmark: pgfId-416212]Field Reference

 
     [bookmark: pgfId-416215] 

 
      
       
        
        [bookmark: pgfId-413768]Table 32-17 [bookmark: 85302]Add/Edit DAP Entry Dialog Box > Personal Firewall 

 
        
       
         
         		
           
           [bookmark: pgfId-413774]Element
          
  
         		
           
           [bookmark: pgfId-413776]Description
          
  
        

 
         
         		[bookmark: pgfId-413782]Criterion

  
         		[bookmark: pgfId-413784]Shows Personal Firewall as the selection criterion.

  
        

 
         
         		[bookmark: pgfId-413790]Type

  
         		[bookmark: pgfId-413792]Select one of the following options and assign the associated values:

 
           
           		 [bookmark: pgfId-413794] Not Installed —Select if the absence of the named personal firewall from the remote PC is sufficient to match the prelogin policy you are configuring.

 
           		 [bookmark: pgfId-413796] Installed and enabled —Select if the named personal firewall must be present and enabled on the remote PC to match the prelogin policy you are configuring.

 
           		 [bookmark: pgfId-413798] Installed and disabled —Select if the mere presence of the named personal firewall on the remote PC is sufficient to match the prelogin policy you are configuring.

 
          

  
        

 
         
         		[bookmark: pgfId-413804]Vendor Name

  
         		[bookmark: pgfId-413806]Select the text that describes the application vendor from the list.

  
        

 
         
         		[bookmark: pgfId-413812]Product ID

  
         		[bookmark: pgfId-413814]Select a unique identifier for the product that is supported by the selected vendor from the list.

  
        

 
         
         		[bookmark: pgfId-413820]Product Description

  
         		[bookmark: pgfId-413822]Available only if you selected that this endpoint attribute and all its settings must be available on the remote PC.

 [bookmark: pgfId-413824]Select the check box, then select the description of the product from the list.

  
        

 
         
         		[bookmark: pgfId-413830]Version

  
         		[bookmark: pgfId-413832]Available only if you selected that this endpoint attribute and all its settings must be available on the remote PC.

 [bookmark: pgfId-413834]Identify the version of the application, and specify whether you want the endpoint attribute to be equal to/not equal to that version.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-416225][bookmark: 85355][bookmark: ravpnpg_cncpt_AddEditDAPEntryDialogBoxPolicy]Add/Edit DAP Entry Dialog Box > Policy[bookmark: marker-416223]

 
     [bookmark: pgfId-416227]Windows locations let you determine how clients connect to your virtual private network, and protect it accordingly. For example, clients connecting from within a workplace LAN on a 10.x.x.x network behind a NAT device are an unlikely risk for exposing confidential information. For these clients, you might set up a Cisco Secure Desktop Windows Location named Work that is specified by IP addresses on the 10.x.x.x network, and disable both the Cache Cleaner and the Secure Desktop function for this location. Cisco Secure Desktop checks locations in the order listed on the Windows Location Settings window, and grants privileges to client PCs based on the first location definition they match.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-416229]Note Duplicate entries are not allowed. If you configure a dynamic access policy with no AAA or endpoint attributes, the security appliance always selects it since all selection criteria are satisfied.


     
      

     

     

 
     [bookmark: pgfId-416231]Navigation Path

 
     [bookmark: pgfId-416236]Open the Add/Edit Dynamic Access Policy Dialog Box with the Main tab selected, then click Create, or select a dynamic access policy in the table and click Edit. The Add/Edit DAP Entry dialog box is displayed. Select Policy as the Criterion.

 
     [bookmark: pgfId-416238]Related Topics

 
      
      		 [bookmark: pgfId-416243]Understanding DAP Attributes

 
      		 [bookmark: pgfId-416248]Configuring DAP Attributes

 
      		 [bookmark: pgfId-416253]Configuring Dynamic Access Policies

 
     

 
     [bookmark: pgfId-416255]Field Reference

 
     [bookmark: pgfId-416258] 

 
      
       
        
        [bookmark: pgfId-413847]Table 32-18 [bookmark: 85386]Add/Edit DAP Entry Dialog Box > Policy 

 
        
       
         
         		
           
           [bookmark: pgfId-413853]Element
          
  
         		
           
           [bookmark: pgfId-413855]Description
          
  
        

 
         
         		[bookmark: pgfId-413861]Criterion

  
         		[bookmark: pgfId-413863]Shows Policy as the selection criterion.

  
        

 
         
         		[bookmark: pgfId-413869]Location

  
         		[bookmark: pgfId-413871]Select the matching criteria (for example, is) from the drop-down list, and select the Cisco Secure Desktop Microsoft Windows location profile from the list. All the locations configured in the Cisco Secure Desktop Manager are displayed in this list.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-416268][bookmark: 85408][bookmark: ravpnpg_cncpt_AddEditDAPEntryDialogBoxProcess]Add/Edit DAP Entry Dialog Box > Process[bookmark: marker-416266]

 
     [bookmark: pgfId-416270]You can specify a set of process names, which form a part of Basic Host Scan. The host scan, which includes Basic Host Scan and Endpoint Assessment, or Advanced Endpoint Assessment; occurs after the prelogin assessment but before the assignment of a dynamic access policy. Following the Basic Host Scan, the security appliance uses the login credentials, the host scan results, prelogin policy, and other criteria you configure to assign a DAP.
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     [bookmark: pgfId-416272]Note Duplicate entries are not allowed. If you configure a dynamic access policy with no AAA or endpoint attributes, the security appliance always selects it since all selection criteria are satisfied.


     
      

     

     

 
     [bookmark: pgfId-416274]Navigation Path

 
     [bookmark: pgfId-416279]Open the Add/Edit Dynamic Access Policy Dialog Box with the Main tab selected, then click Create, or select a dynamic access policy in the table and click Edit. The Add/Edit DAP Entry dialog box is displayed. Select Process as the Criterion.

 
     [bookmark: pgfId-416281]Related Topics

 
      
      		 [bookmark: pgfId-416286]Understanding DAP Attributes

 
      		 [bookmark: pgfId-416291]Configuring DAP Attributes

 
      		 [bookmark: pgfId-416296]Configuring Dynamic Access Policies

 
     

 
     [bookmark: pgfId-416298]Field Reference

 
     [bookmark: pgfId-416301] 

 
      
       
        
        [bookmark: pgfId-413884]Table 32-19 [bookmark: 85439]Add/Edit DAP Entry Dialog Box > Process 

 
        
       
         
         		
           
           [bookmark: pgfId-413890]Element
          
  
         		
           
           [bookmark: pgfId-413892]Description
          
  
        

 
         
         		[bookmark: pgfId-413898]Criterion

  
         		[bookmark: pgfId-413900]Shows Process as the selection criterion.

  
        

 
         
         		[bookmark: pgfId-413906]Type

  
         		[bookmark: pgfId-413908]Select one of the following options and assign the associated values:

 
           
           		 [bookmark: pgfId-413910] Matches —Select if the mere presence of the named process on the remote PC is sufficient to match the prelogin policy you are configuring.

 
           		 [bookmark: pgfId-413912] Doesn’t Match —Select if the absence of the named process from the remote PC is sufficient to match the prelogin policy you are configuring.

 
          

  
        

 
         
         		[bookmark: pgfId-413918]Endpoint ID

  
         		[bookmark: pgfId-413920]A string that identifies an endpoint for files, processes or registry entries. Dynamic access policies use this ID to match Cisco Secure Desktop host scan attributes for dynamic access policy selection. You must configure Host Scan before you configure this attribute. When you configure Host Scan, the configuration displays in this pane, so you can select it, reducing the possibility of errors in typing or syntax.

  
        

 
         
         		[bookmark: pgfId-413926]Path

  
         		[bookmark: pgfId-413928]Select the check box, then select the matching criteria (for example, is) from the drop-down list, and enter the name of the process. You can display it in Microsoft Windows by opening the Windows Task Manager window and clicking the Processes tab.

 [bookmark: pgfId-413930]Configure Host Scan before you configure this attribute. When you configure Host Scan, the configuration displays in this pane, so you can select it and specify the same index when you assign this entry as an endpoint attribute when configuring a DAP, reducing the possibility of errors in typing or syntax.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-416311][bookmark: 85479][bookmark: ravpnpg_cncpt_AddEditDAPEntryDialogBoxRegistry]Add/Edit DAP Entry Dialog Box > Registry[bookmark: marker-416309]

 
     [bookmark: pgfId-416313]Registry key scans apply only to computers running Windows Microsoft Windows operating systems. Basic Host Scan ignores registry key scans if the computer is running Mac OS or Linux.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-416315]Note Duplicate entries are not allowed. If you configure a dynamic access policy with no AAA or endpoint attributes, the security appliance always selects it since all selection criteria are satisfied.


     
      

     

     

 
     [bookmark: pgfId-416317]Navigation Path

 
     [bookmark: pgfId-416322]Open the Add/Edit Dynamic Access Policy Dialog Box with the Main tab selected, then click Create, or select a dynamic access policy in the table and click Edit. The Add/Edit DAP Entry dialog box is displayed. Select Registry as the Criterion.

 
     [bookmark: pgfId-416324]Related Topics

 
      
      		 [bookmark: pgfId-416329]Understanding DAP Attributes

 
      		 [bookmark: pgfId-416334]Configuring DAP Attributes

 
      		 [bookmark: pgfId-416339]Configuring Dynamic Access Policies

 
     

 
     [bookmark: pgfId-416341]Field Reference

 
     [bookmark: pgfId-416344] 

 
      
       
        
        [bookmark: pgfId-413943]Table 32-20 [bookmark: 85510]Add/Edit DAP Entry Dialog Box > Registry 

 
        
       
         
         		
           
           [bookmark: pgfId-413949]Element
          
  
         		
           
           [bookmark: pgfId-413951]Description
          
  
        

 
         
         		[bookmark: pgfId-413957]Criterion

  
         		[bookmark: pgfId-413959]Shows Registry as the selection criterion.

  
        

 
         
         		[bookmark: pgfId-413965]Type

  
         		[bookmark: pgfId-413967]Select one of the following options and assign the associated values:

 
           
           		 [bookmark: pgfId-413969] Matches —Select if the mere presence of the named registry key on the remote PC is sufficient to match the prelogin policy you are configuring. For example, select this option if you want to require the following registry key to be present to match a criterion for assigning a prelogin policy: HKEY_LOCAL_MACHINE\SOFTWARE\<Protective_Software>

 
           		 [bookmark: pgfId-413971] Doesn’t Match —Select if the absence of the named registry key from the remote PC is sufficient to match the prelogin policy you are configuring. For example, select this option if you want to require the following registry key to be absent to match a criterion for assigning a prelogin policy: HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Run\<Evil_SpyWare>

 
          

  
        

 
         
         		[bookmark: pgfId-413977]Endpoint ID

  
         		[bookmark: pgfId-413979]A string that identifies an endpoint for files, processes or registry entries. Dynamic access policies use this ID to match Cisco Secure Desktop host scan attributes for dynamic access policy selection. You must configure Host Scan before you configure this attribute. When you configure Host Scan, the configuration displays in this pane, so you can select it, reducing the possibility of errors in typing or syntax.

  
        

 
         
         		[bookmark: pgfId-413985]Registry Name

  
         		[bookmark: pgfId-413987]Select the text that describes the registry name from the list.

  
        

 
         
         		[bookmark: pgfId-413993]Value

  
         		[bookmark: pgfId-413995]Select the value, dword or string, from the list, then select the matching criteria (whether it equals or does not equal), and enter a decimal or a string to compare with the dword or string value of the registry key on the remote PC.

 [bookmark: pgfId-413997]Note “DWORD” refers to the attribute in the Add/Edit Registry Criterion dialog box. “Dword” refers to the attribute as it appears in the registry key. Use the regedit application, accessed on the Windows command line, to view the Dword value of a registry key, or use it to add a Dword value to the registry key to satisfy the requirement you are configuring.

  
        

 
         
         		[bookmark: pgfId-414003]Ignore Case

  
         		[bookmark: pgfId-414005]When selected, ignores the case in the registry entry if it includes a string.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-416352][bookmark: 85562][bookmark: ravpnpg_cncpt_LogicalOperatorsTab]Logical Operations Tab[bookmark: marker-416350]

 
     [bookmark: pgfId-416354]Use the Logical Operations tab of the Add/Edit Dynamic Access Policy dialog box to configure multiple instances of the AAA and each type of endpoint attribute that you defined in the DAP Entry dialog box. On this tab, set each type of endpoint or AAA attribute to require only one instance of a type (Match Any = OR) or to have all instances of a type (Match All = AND).

 
      
      		 [bookmark: pgfId-416356]If you configure only one instance of an endpoint category, you do not need to set a value.

 
      		 [bookmark: pgfId-416358]For some endpoint attributes, it is not useful to configure multiple instances. For example, no users have more than one running OS.

 
      		 [bookmark: pgfId-416360]You are configuring the Match Any/Match All operation within each endpoint type. The security appliance evaluates each type of endpoint attribute, and then performs a logical AND operation on all of the configured endpoints. That is, each user must satisfy the conditions of ALL of the endpoints you configure, as well as the AAA attributes.

 
     

 
     [bookmark: pgfId-416362]Navigation Path

 
     [bookmark: pgfId-416367]Open the Add/Edit Dynamic Access Policy Dialog Box, then click the Logical Operations tab.

 
     [bookmark: pgfId-416369]Related Topics

 
      
      		 [bookmark: pgfId-416374]Understanding DAP Attributes

 
      		 [bookmark: pgfId-416379]Configuring DAP Attributes

 
      		 [bookmark: pgfId-416384]Configuring Dynamic Access Policies

 
     

 
     [bookmark: pgfId-416386]Field Reference

 
     [bookmark: pgfId-416389] 

 
      
       
        
        [bookmark: pgfId-414018]Table 32-21 [bookmark: 85596]Add/Edit Dynamic Access Policy Dialog Box > Logical Operations Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-414024]Element
          
  
         		
           
           [bookmark: pgfId-414026]Description
          
  
        

 
         
         		[bookmark: pgfId-414032]AAA

  
         		[bookmark: pgfId-414034]Select one of the following options if you defined the AAA attribute in the dynamic access policy:

 
           
           		 [bookmark: pgfId-414036] Match Any —Creates an OR relationship among the attributes. Attributes matching any of your criteria are included in the filter. The security appliance grants access to a particular user for a particular session even if any one of the attributes is matching all your criteria.

 
           		 [bookmark: pgfId-414038] Match All —Creates an AND relationship among the attributes. The security appliance grants access to a particular user for a particular session only if the attributes are matching all your criteria.

 
           		 [bookmark: pgfId-414040] Match None —Creates a NOT relationship among the attributes. The dynamic access policy specifies that none of the attributes of the user need to match to be granted access to a session.

 
          

  
        

 
         
         		[bookmark: pgfId-414046]Anti-Spyware

  
         		[bookmark: pgfId-414048]Select one of the following options if you defined Anti-Spyware as an endpoint attribute:

 
           
           		 [bookmark: pgfId-414050] Match Any —Creates an OR relationship among the attributes. Policies matching any instance of your criteria are used to authorize users.

 
           		 [bookmark: pgfId-414052] Match All —Creates an AND relationship among the attributes. Only those attributes matching all your criteria are used to authorize users.

 
          

  
        

 
         
         		[bookmark: pgfId-414058]Anti-Virus

  
         		[bookmark: pgfId-414060]Select one of the following options if you defined Anti-Virus as an endpoint attribute:

 
           
           		 [bookmark: pgfId-414062] Match Any —Set to require that user authorization attributes match any of the values in the Antivirus endpoint attributes you are configuring.

 
           		 [bookmark: pgfId-414064] Match All —Set to require that user authorization attributes match all of the values in the endpoint attributes you are configuring, as well as satisfying the AAA attribute.

 
          

  
        

 
         
         		[bookmark: pgfId-414070]Application

  
         		[bookmark: pgfId-414072]Select one of the following options if you defined Application as an endpoint attribute:

 
           
           		 [bookmark: pgfId-414074] Match Any —Set to require that user authorization attributes match any of the values in the Antivirus endpoint attributes you are configuring.

 
           		 [bookmark: pgfId-414076] Match All —Set to require that user authorization attributes match all of the values in the endpoint attributes you are configuring, as well as satisfying the AAA attribute.

 
          

  
        

 
         
         		[bookmark: pgfId-414082]File

  
         		[bookmark: pgfId-414084]Select one of the following options if you defined File as an endpoint attribute:

 
           
           		 [bookmark: pgfId-414086] Match Any —Set to require that user authorization attributes match any of the values in the Antivirus endpoint attributes you are configuring.

 
           		 [bookmark: pgfId-414088] Match All —Set to require that user authorization attributes match all of the values in the endpoint attributes you are configuring, as well as satisfying the AAA attribute.

 
          

  
        

 
         
         		[bookmark: pgfId-414094]Personal Firewall

  
         		[bookmark: pgfId-414096]Personal firewall rules let you specify applications and ports for the firewall to allow or block. Select one of the following options if you defined Personal Firewall as an endpoint attribute:

 
           
           		 [bookmark: pgfId-414098] Match Any —Set to require that user authorization attributes match any of the values in the Antivirus endpoint attributes you are configuring.

 
           		 [bookmark: pgfId-414100] Match All —Set to require that user authorization attributes match all of the values in the endpoint attributes you are configuring, as well as satisfying the AAA attribute.

 
          

  
        

 
         
         		[bookmark: pgfId-414106]Process

  
         		[bookmark: pgfId-414108]Select one of the following options if you defined Process as an endpoint attribute:

 
           
           		 [bookmark: pgfId-414110] Match Any —Set to require that user authorization attributes match any of the values in the Antivirus endpoint attributes you are configuring.

 
           		 [bookmark: pgfId-414112] Match All —Set to require that user authorization attributes match all of the values in the endpoint attributes you are configuring, as well as satisfying the AAA attribute.

 
          

  
        

 
         
         		[bookmark: pgfId-414118]Registry

  
         		[bookmark: pgfId-414120]Registry key scans apply only to computers running Windows Microsoft Windows operating systems. Basic Host Scan ignores registry key scans if the computer is running Mac OS or Linux.

 [bookmark: pgfId-414122]Select one of the following options if you defined Registry as an endpoint attribute:

 
           
           		 [bookmark: pgfId-414124] Match Any —Set to require that user authorization attributes match any of the values in the Antivirus endpoint attributes you are configuring.

 
           		 [bookmark: pgfId-414126] Match All —Set to require that user authorization attributes match all of the values in the endpoint attributes you are configuring, as well as satisfying the AAA attribute.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-416397][bookmark: 85707][bookmark: ravpnpg_cncpt_AdvancedExpressionsTab]Advanced Expressions Tab[bookmark: marker-416395]

 
     [bookmark: pgfId-416399]Use the Advanced Expressions tab of the Add/Edit Dynamic Access Policy dialog box to set additional attributes for the dynamic access policy. You can configure multiple instances of each type of endpoint attribute. Be aware that this is an advanced feature that requires knowledge of LUA (www.lua.org).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-416405]Note For detailed information about advanced expressions, see About Advanced Expressions for AAA or Endpoint Attributes and Examples of DAP Logical Expressions.


     
      

     

     

 
     [bookmark: pgfId-416407]Navigation Path

 
     [bookmark: pgfId-416412]Open the Add/Edit Dynamic Access Policy Dialog Box, then click the Advanced Expressions tab.

 
     [bookmark: pgfId-416414]Related Topics

 
      
      		 [bookmark: pgfId-416419]Understanding DAP Attributes

 
      		 [bookmark: pgfId-416424]Configuring DAP Attributes

 
      		 [bookmark: pgfId-416429]Configuring Dynamic Access Policies

 
     

 
     [bookmark: pgfId-416431]Field Reference

 
     [bookmark: pgfId-416434] 

 
      
       
        
        [bookmark: pgfId-414139]Table 32-22 [bookmark: 85737]Add/Edit Dynamic Access Policy Dialog Box > Advanced Expressions Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-414145]Element
          
  
         		
           
           [bookmark: pgfId-414147]Description
          
  
        

 
         
         		[bookmark: pgfId-414153]Basic Expressions

  
         		[bookmark: pgfId-414155]This text box is populated with basic expressions based on the endpoint and AAA attributes that you configured in the dynamic access policy.

  
        

 
         
         		[bookmark: pgfId-414161]Relationship Drop-down List

  
         		[bookmark: pgfId-414163]Specify the relationship between the basic selection rules and the logical expressions you enter on this tab, that is, whether the new attributes add to or substitute for the AAA and endpoint attributes already set. Select one of the following options:

 
           
           		 [bookmark: pgfId-414165] Basic AND Advanced —Creates an AND relationship between the basic and advanced expressions. Both the basic and advanced expressions defined in the dynamic access policy are considered while authenticating users.

 
          

 [bookmark: pgfId-414167]By default, this option is selected.

 
           
           		 [bookmark: pgfId-414169] Basic OR Advanced —Creates an OR relationship between the basic and advanced expressions. Users are granted access to a session if either the basic or advanced expressions in the dynamic access policy are matched with the user policy.

 
           		 [bookmark: pgfId-414171] Basic Only —Only the basic expressions defined in the DAP entry are used to determine whether the security appliance grants users access to a particular session.

 
           		 [bookmark: pgfId-414173] Advanced Only —Only the advanced expressions defined in the DAP entry are used to authorize users for an SSL VPN session.

 
          

  
        

 
         
         		[bookmark: pgfId-414179]Advanced Expressions

  
         		[bookmark: pgfId-414181]Enter one or more logical expressions to set AAA or endpoint attributes other than what is possible in the AAA and Endpoint areas above.

 [bookmark: pgfId-414183]Enter free-form LUA text that defines new AAA and/or endpoint selection attributes. Security Manager does not validate text that you enter here; it just copies this text to the dynamic access policy XML file, and the security appliance processes it, discarding any expressions it cannot parse.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-416446][bookmark: 85778][bookmark: ravpnpg_cncpt_CSDMPolicyEditorDialogBox]Cisco Secure Desktop Manager Policy Editor Dialog Box[bookmark: marker-416442][bookmark: marker-416444]

 
     [bookmark: pgfId-416451]Using the Cisco Secure Desktop Manager (CSDM) Policy Editor dialog box, you can configure prelogin policies, specify the checks to be performed between the time the user establishes a connection with the security appliance and the time the user enters the login credentials, and configure host scans. For an explanation of configuring CSD on an ASA device, see Configuring Cisco Secure Desktop Policies on ASA Devices.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-416455]Note The Cisco Secure Desktop Manager Policy Editor is an independent program. For information about configuring CSD, and what CSD can do for you, see the materials available online at http://www.cisco.com/en/US/products/ps6742/tsd_products_support_configure.html. Look specifically for information on configuring prelogin policies and host scan. Select the configuration guide for the CSD version you are configuring.


     
      

     

     

 
     [bookmark: pgfId-416457]Navigation Path

 
     [bookmark: pgfId-416462]Open the Dynamic Access Page (ASA), then click Configure from the Cisco Secure Desktop section (you must first specify a CSD package). The CSDM Policy Editor dialog box is displayed.

 
     [bookmark: pgfId-416464]Related Topics

 
      
      		 [bookmark: pgfId-416469]Understanding DAP Attributes

 
      		 [bookmark: pgfId-416474]Configuring DAP Attributes

 
      		 [bookmark: pgfId-416479]Configuring Dynamic Access Policies
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     [bookmark: pgfId-819841][bookmark: 3814][bookmark: ivman_cncpt_PreparingtheDevicesforSecurityManagertoManage]Preparing Devices for Management[bookmark: marker-819839]
      
      
 
     
 

 
    [bookmark: pgfId-819846]Before you start to manage a device using Security Manager, you should prepare the device with at least a minimal configuration. The following sections describe the basic device configurations needed for various transport protocols or device types. Before configuring transport protocols, determine the requirements for your devices by reading Understanding Device Communication Requirements.

 
     
     		 [bookmark: pgfId-819851]Understanding Device Communication Requirements

 
     		 [bookmark: pgfId-819856]Setting Up SSL (HTTPS)

 
     		 [bookmark: pgfId-819861]Setting Up SSH

 
     		 [bookmark: pgfId-819866]Setting Up AUS or Configuration Engine

 
     		 [bookmark: pgfId-819871]Configuring Licenses on Cisco ASA Devices

 
     		 [bookmark: pgfId-819876]Configuring Licenses on Cisco IOS Devices

 
     		 [bookmark: pgfId-819881]Initializing IPS Devices

 
    

 
   
 
    
     [bookmark: pgfId-819895][bookmark: 3843][bookmark: ivman_cncpt_UnderstandingDeviceCommunicationRequirements]Understanding Device Communication Requirements [bookmark: marker-819887][bookmark: marker-819889][bookmark: marker-819891][bookmark: marker-819893]

 
    [bookmark: pgfId-819897]Security Manager provides many different ways for you to manage devices. The easiest methods involve Security Manager directly contacting the devices. Security Manager might access a device during inventory or policy discovery, during configuration deployment, or in response to actions you take in Security Manager that request device contact (such as testing connectivity).

 
    [bookmark: pgfId-819899]Because you can use off-line methods to add devices to the Security Manager inventory or to deploy configuration changes to the devices, configuring device communication settings for Security Manager’s use is optional. However, you typically need to configure basic device communication settings on the devices to implement your off-line or customized configuration deployment tools.

 
    [bookmark: pgfId-819907]In Security Manager, you can configure which transport protocol to use as the default for a type of device, and change it for specific devices that are configured to respond to a different protocol. Security Manager is configured with default protocols that are the most commonly-used protocols for that type of device. To change the default device communication setting for a type of device, select Tools > Security Manager Administration and select Device Communication from the table of contents (for more information, see Device Communication Page). To change the transport setting for a specific device, modify its device properties as described in Viewing or Changing Device Properties.

 
    [bookmark: pgfId-819909]Security Manager can use these transport protocols:

 
     
     		 [bookmark: pgfId-819911]SSL (HTTPS)—Secure Socket Layer, which is an HTTPS connection, is the only transport protocol used with PIX Firewalls, Adaptive Security Appliances (ASA), and Firewall Services Modules (FWSM). It is also the default protocol for IPS devices and for routers running Cisco IOS Software release 12.3 or higher.

 
    

 
    [bookmark: pgfId-819917]If you use SSL as the transport protocol on Cisco IOS routers, you must also configure SSH on the routers. Security Manager uses SSH connections to handle interactive command deployments during SSL deployments.[bookmark: marker-819913][bookmark: marker-819915]

 
    [bookmark: pgfId-819922]For information on configuring SSL, see Setting Up SSL (HTTPS).

 
     
     		 [bookmark: pgfId-819924]SSH—Secure Shell is the default transport protocol for Catalyst switches and Catalyst 6500/7600 devices. You can also use it with Cisco IOS routers.

 
    

 
    [bookmark: pgfId-819929]For information on configuring SSH, see Setting Up SSH.

 
     
     		 [bookmark: pgfId-819931]Telnet—Telnet is the default protocol for routers running Cisco IOS software releases 12.1 and 12.2. You can also use it with Catalyst switches, Catalyst 6500/7600 devices, and routers running Cisco IOS Software release 12.3 and higher. See the Cisco IOS software documentation for configuring Telnet.

 
     		 [bookmark: pgfId-819933]HTTP—You can use HTTP instead of HTTPS (SSL) with IPS devices. HTTP is not the default protocol for any device type.

 
     		 [bookmark: pgfId-819935]TMS—Token Management Server is treated like a transport protocol in Security Manager, but it is not a real transport protocol. Instead, by configuring TMS as the transport protocol of a router, you are telling Security Manager to deploy configurations to a TMS. From the TMS, you can download the configuration to an eToken, plug the eToken into the router’s USB bus, and update the configuration. TMS is available only for certain routers running Cisco IOS Software 12.3 or higher.

 
    

 
    [bookmark: pgfId-819940]For information on deploying configurations to a TMS and downloading them to a router, see Deploying Configurations to a Token Management Server.

 
    [bookmark: pgfId-819942]Security Manager can also use indirect methods to deploy configurations to devices, staging the configuration on a server that manages the deployment to the devices. These indirect methods also allow you to use dynamic IP addresses on your devices. The methods are not treated as transport protocols, but as adjuncts to the transport protocol for the device. You can use these indirect methods:

 
     
     		 [bookmark: pgfId-819944]AUS (Auto Update Server)—When you add a device to Security Manager, you can select the AUS server that is managing it. You can use AUS with PIX Firewalls and ASA devices.

 
    

 
    [bookmark: pgfId-819949]For information on configuring a device to use an AUS server, see Setting Up AUS or Configuration Engine.

 
     
     		 [bookmark: pgfId-819951]Configuration Engine—When you add a router to Security Manager, you can select the Configuration Engine that is managing it.

 
    

 
    [bookmark: pgfId-819956]For more information on configuring a router to use a Configuration Engine server, see Setting Up AUS or Configuration Engine.

 
    [bookmark: pgfId-819958]For information on adding devices that use AUS or Configuration Engine servers to Security Manager, and how to add the servers, see these topics:

 
     
     		 [bookmark: pgfId-819963]Adding Devices to the Device Inventory

 
     		 [bookmark: pgfId-819968]Adding, Editing, or Deleting Auto Update Servers or Configuration Engines

 
    

 
   
 
    
     [bookmark: pgfId-819980][bookmark: 3908][bookmark: ivman_cncpt_SettingUpSSL]Setting Up SSL (HTTPS)[bookmark: marker-819974][bookmark: marker-819976][bookmark: marker-819978]

 
    [bookmark: pgfId-819982]With many devices, you can use the Secure Socket Layer (SSL) protocol, also known as HTTPS, to communicate with the device. When you deploy configurations with this protocol, Security Manager encrypts the configuration file before sending it to the device.

 
    [bookmark: pgfId-819984]The following topics describe how to set up SSL on the devices:

 
     
     		 [bookmark: pgfId-819989]Setting Up SSL (HTTPS) on PIX Firewall, ASA and FWSM Devices

 
     		 [bookmark: pgfId-819994]Setting Up SSL on Cisco IOS Routers

 
    

 
     
      [bookmark: pgfId-820006][bookmark: 3928][bookmark: ivman_cncpt_SettingUpSSLonPIXFirewallASAandFWSMDevices]Setting Up SSL (HTTPS) on PIX Firewall, ASA and FWSM Devices [bookmark: marker-820000][bookmark: marker-820002][bookmark: marker-820004]

 
     [bookmark: pgfId-820008]This procedure describes the tasks to complete before you use SSL as the transport protocol for device management on PIX Firewall, ASA and FWSM devices.

 
     
 
     [bookmark: pgfId-820010]Step 1 Enter configuration mode.

 
     
      [bookmark: pgfId-820012]hostname# config terminal
     

     
      [bookmark: pgfId-820014] 
     

     [bookmark: pgfId-820016]Respond to the prompts appropriately. Here are some tips:

 
      
      		 [bookmark: pgfId-820018]Enter  y when the prompt asks if you want to preconfigure using interactive prompts.

 
      		 [bookmark: pgfId-820020]Enter the current enable password.

 
      		 [bookmark: pgfId-820022]Specify the time zone, year, month, day, and time.

 
      		 [bookmark: pgfId-820024]If the device:

 
     

 
     [bookmark: pgfId-820026] – Is new—Specify the network interface IP address and network mask that applies to the inside IP address of the device.

 
     [bookmark: pgfId-820028] – Exists—Verify that the interface IP address and mask are correct.

 
      
      		 [bookmark: pgfId-820030]If the device:

 
     

 
     [bookmark: pgfId-820032] – Is new—Specify the hostname and the domain name.

 
     [bookmark: pgfId-820034] – Exists—Verify that the hostname and domain name are correct.

 
      
      		 [bookmark: pgfId-820036]When prompted for the IP address of the host that runs the PIX Device Manager, specify the IP address of the Security Manager server.

 
      		 [bookmark: pgfId-820038]Enter  yes when the prompt asks if you want to write the above changes to Flash.

 
     

 
     [bookmark: pgfId-820042]Step 2 [bookmark: marker-820040]If you are configuring an ASA, specify the SSL/TLS protocol version the ASA uses when acting as a server. Beginning with version 4.8, Security Manager supports all SSL/TLS protocol versions, the latest certified version being TLS 1.2.

 
     
      [bookmark: pgfId-820044]hostname(config)# ssl server-version any
     

     
      [bookmark: pgfId-820046] 
     

     
      [bookmark: pgfId-820048] 
     

     [bookmark: pgfId-820050]Step 3 Enable the HTTP server.

 
     
      [bookmark: pgfId-820052]hostname(config)# http server enable
     

     
      [bookmark: pgfId-820054] 
     

     [bookmark: pgfId-820056]Step 4 Specify the host or network authorized to initiate an HTTP connection to the device.

 
     
      [bookmark: pgfId-820058]hostname(config)# http ip_address  [netmask] [if_name]
     

     
      [bookmark: pgfId-820060] 
     

     [bookmark: pgfId-820062]Where:

 
      
      		 [bookmark: pgfId-820064] ip_address —The IP address of the Security Manager server.

 
      		 [bookmark: pgfId-820066] netmask —The network mask for the IP address.

 
      		 [bookmark: pgfId-820068] if_name —The device interface name (default is  inside ) from which Security Manager initiates the HTTP connection.

 
     

 
     [bookmark: pgfId-820070]Step 5 Save the current configuration in Flash memory.

 
     
      [bookmark: pgfId-820072]hostname(config)# write memory
     

     
      [bookmark: pgfId-820074] 
     

     [bookmark: pgfId-820076]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-820086][bookmark: 4012][bookmark: ivman_cncpt_SettingUpSSLonCiscoIOSRouters]Setting Up SSL on Cisco IOS Routers [bookmark: marker-820082][bookmark: marker-820084]

 
     [bookmark: pgfId-820088]This procedure describes the tasks to complete before you use SSL as the transport protocol for device management on Cisco IOS routers.

 
     
 
     [bookmark: pgfId-820090]Step 1 Enter configuration mode.

 
     
      [bookmark: pgfId-820092]hostname# config terminal
     

     
      [bookmark: pgfId-820094] 
     

     [bookmark: pgfId-820096]Step 2 Configure the hostname and domain name if the device is new.

 
     
      [bookmark: pgfId-820098]router(config)# hostname name 
     

     
      [bookmark: pgfId-820100]hostname(config)# ip domain-name your_domain
     

     
      [bookmark: pgfId-820102] 
     

     [bookmark: pgfId-820104]Step 3 Configure level 15 privilege. SSL requires that you must have level 15 privileges to log in to a Cisco IOS router.

 
     
      [bookmark: pgfId-820106]hostname(config)# username username privilege 15 password 0 password
     

     
      [bookmark: pgfId-820108] 
     

     [bookmark: pgfId-820110]Step 4 Enable either local authorization or AAA authorization:

 
      
      		 [bookmark: pgfId-820112]Local authorization— If you are using AAA for authorization but would like to use local authorization, use the following commands to disable AAA authorization and AAA authentication at login, where  list-name is a character string used to name the list of authorization methods, and to enable local authorization using the username you just configured:

 
     

 
     
      [bookmark: pgfId-820114]hostname(config)# no aaa authorization network list-name 
     

     
      [bookmark: pgfId-820116]hostname(config)# no aaa authentication login list-name
     

     
      [bookmark: pgfId-820118]hostname(config)#ip http authentication local 
     

     
      [bookmark: pgfId-820120] 
     

     [bookmark: pgfId-820122]If you do not enter the ip http authentication local command, the default enable password is used for authentication.

 
      
      		 [bookmark: pgfId-820124]AAA authorization—Use the following commands to enable AAA authentication and authorization. The last two commands are necessary only if multiple AAA lists are defined;  list-name is a character string used to name the list of authorization methods. These commands authenticate the user that is contacting the device using the HTTPS protocol.

 
     

 
     
      [bookmark: pgfId-820126]hostname(config)#ip http authentication aaa 
     

     
      [bookmark: pgfId-820128]hostname(config)#ip http authentication aaa login-authentication list-name
     

     
      [bookmark: pgfId-820130]hostname(config)# ip http authentication aaa exec-authorization list-name 
     

     [bookmark: pgfId-820132]Step 5 Enable the HTTPS server.

 
     
      [bookmark: pgfId-820134]hostname(config)# ip http secure-server 
     

     
      [bookmark: pgfId-820136] 
     

     [bookmark: pgfId-820138]Step 6 Exit configuration mode and return to Exec mode.

 
     
      [bookmark: pgfId-820140]hostname(config)# exit
     

     
      [bookmark: pgfId-820142] 
     

     [bookmark: pgfId-820144]Step 7 Verify that SSL is set up on the device. The Device should respond with an “enabled” status.

 
     
      [bookmark: pgfId-820146]hostname# show ip http server secure status 
     

     
      [bookmark: pgfId-820148] 
     

     [bookmark: pgfId-820150]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-820160][bookmark: 4093][bookmark: ivman_cncpt_SettingUpSSH]Setting Up SSH[bookmark: marker-820156][bookmark: marker-820158]

 
    [bookmark: pgfId-820162]You can use the Secure Shell (SSH) protocol to communicate with Cisco IOS Routers, Catalyst switches, and Catalyst 6500/7600 devices. This protocol provides strong authentication and secure communications over insecure channels. Security Manager supports both SSH versions 1.5 and 2. Once connected to the device, Security Manager determines which version to use and communicates using that version.

 
    [bookmark: pgfId-820164]The following topics describe how to set up SSH on the supported devices:

 
     
     		 [bookmark: pgfId-820169]Critical Line-Ending Conventions for SSH

 
     		 [bookmark: pgfId-820174]Testing Authentication

 
     		 [bookmark: pgfId-820179]Setting Up SSH on Cisco IOS Routers, Catalyst Switches, and Catalyst 6500/7600 devices

 
     		 [bookmark: pgfId-820184]Preventing Non-SSH Connections (Optional)

 
    

 
     
      [bookmark: pgfId-820192][bookmark: 4116][bookmark: ivman_cncpt_CriticalLineendingConventionsforSSH]Critical Line-Ending Conventions for SSH [bookmark: marker-820190]

 
     [bookmark: pgfId-820194]The following line-ending conventions for SSH must be observed to avoid system failure:

 
      
      		 [bookmark: pgfId-820196]Do not end banner message lines with “#”, “# ”, “>”, or “> ”. If your system requires a pound sign or greater-than sign at the end of a banner message, ensure that it is followed by two spaces.

 
      		 [bookmark: pgfId-820198]Do not use banner message lines that contain only “Username: ” or “Password: ”

 
      		 [bookmark: pgfId-820200]Do not customize the device user EXEC mode prompt to not end with “>” or “#”.

 
     

 
    
 
     
      [bookmark: pgfId-820210][bookmark: 4130][bookmark: ivman_cncpt_TestingAuthentication]Testing Authentication[bookmark: marker-820206][bookmark: marker-820208]

 
     [bookmark: pgfId-820212]Before you set up SSH, you must test authentication without SSH to make sure the device can be authenticated. You can authenticate with a local username and password or with an authentication, authorization, and accounting (AAA) server running TACACS+ or RADIUS.

 
     [bookmark: pgfId-820214]This procedure describes how to test authentication without SSH using a local or AAA server username and password.

 
     
 
     [bookmark: pgfId-820216]Step 1 Enter configuration mode.

 
     
      [bookmark: pgfId-820218]router# config terminal
     

     
      [bookmark: pgfId-820220] 
     

     
      [bookmark: pgfId-820222] 
     

     [bookmark: pgfId-820224]Step 2 Specify that the local username and password should be used in the absence of AAA statements. On Cisco IOS routers, you can use the login local command on VTY lines instead of the aaa new-model command.

 
     
      [bookmark: pgfId-820226]hostname(config)#aaa new-model
     

     
      [bookmark: pgfId-820228] 
     

     
      [bookmark: pgfId-820230] 
     

     [bookmark: pgfId-820232]Step 3 (Optional) Configure a user account in the local database of the device.

 
     
      [bookmark: pgfId-820234]hostname(config)# username name password 0 password 
     

     
      [bookmark: pgfId-820236] 
     

     
      [bookmark: pgfId-820238] 
     

     [bookmark: pgfId-820240]Step 4 Exit configuration mode and return to Exec mode.

 
     
      [bookmark: pgfId-820242]hostname(config)# exit
     

     
      [bookmark: pgfId-820244] 
     

     
      [bookmark: pgfId-820246] 
     

     [bookmark: pgfId-820248]Step 5 Save the configuration changes.

 
     
      [bookmark: pgfId-820250]hostname(config)# write memory
     

     
      [bookmark: pgfId-820252] 
     

     
      [bookmark: pgfId-820254] 
     

     [bookmark: pgfId-820256]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-820272][bookmark: 4177][bookmark: ivman_cncpt_SettingUpSSHonCiscoIOSRoutersandCatalystdevices]Setting Up SSH on Cisco IOS Routers, Catalyst Switches, and Catalyst 6500/7600 devices[bookmark: marker-820262][bookmark: marker-820264][bookmark: marker-820266][bookmark: marker-820268][bookmark: marker-820270]

 
     [bookmark: pgfId-820274]This procedure describes the tasks required to set up SSH on Cisco IOS routers, Catalyst switches, and Catalyst 6500/7600 devices.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-820276]Tip You must configure SSH on Cisco IOS routers because Security Manager uses SSH connections to handle interactive command deployments during SSL deployments.


     
      

     

     

 
     [bookmark: pgfId-820278]Related Topics

 
      
      		 [bookmark: pgfId-820283]Critical Line-Ending Conventions for SSH

 
      		 [bookmark: pgfId-820288]Testing Authentication

 
      		 [bookmark: pgfId-820293]Preventing Non-SSH Connections (Optional)

 
     

 
     
 
     [bookmark: pgfId-820295]Step 1 Enter configuration mode.

 
     
      [bookmark: pgfId-820297]router# config terminal
     

     
      [bookmark: pgfId-820299] 
     

     [bookmark: pgfId-820301]Step 2 Configure the hostname and domain name if the device is new.

 
     
      [bookmark: pgfId-820303]router(config)# hostname name 
     

     
      [bookmark: pgfId-820305]hostname(config)# ip domain-name your_domain
     

     
      [bookmark: pgfId-820307] 
     

     [bookmark: pgfId-820309]Step 3 Generate the RSA key pair for the SSH session. When the device prompts you to enter the size of the modulus, we recommend that you enter 1024.

 
     
      [bookmark: pgfId-820311]hostname(config)# crypto key generate rsa
     

     
      [bookmark: pgfId-820313] 
     

     [bookmark: pgfId-820315]Step 4 (Optional) Set the timeout interval in minutes and the number of retries.

 
     
      [bookmark: pgfId-820317]hostname(config)# ip ssh timeout time
     

     
      [bookmark: pgfId-820319]hostname(config)# ip ssh authentication-retries n
     

     
      [bookmark: pgfId-820321] 
     

     [bookmark: pgfId-820323]Step 5 Exit configuration mode and return to Exec mode.

 
     
      [bookmark: pgfId-820325]hostname(config)# exit
     

     
      [bookmark: pgfId-820327] 
     

     [bookmark: pgfId-820329]Step 6 Save the configuration changes.

 
     
      [bookmark: pgfId-820331]hostname# write memory
     

     
      [bookmark: pgfId-820333] 
     

     [bookmark: pgfId-820335]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-820343][bookmark: 4248][bookmark: ivman_cncpt_PreventingNonSSHConnectionsOptional]Preventing Non-SSH Connections (Optional)[bookmark: marker-820341]

 
     [bookmark: pgfId-820345]After configuring SSH, you can configure the Cisco IOS routers, Catalyst switches, and Catalyst 6500/7600 devices to use SSH connections only.

 
     [bookmark: pgfId-820347]Related Topics

 
      
      		 [bookmark: pgfId-820352]Critical Line-Ending Conventions for SSH

 
      		 [bookmark: pgfId-820357]Testing Authentication

 
      		 [bookmark: pgfId-820362]Setting Up SSH on Cisco IOS Routers, Catalyst Switches, and Catalyst 6500/7600 devices

 
     

 
     
 
     [bookmark: pgfId-820364]Step 1 Enter configuration mode.

 
     
      [bookmark: pgfId-820366]router# config terminal
     

     
      [bookmark: pgfId-820368] 
     

     [bookmark: pgfId-820370]Step 2 Set up the router for Telnet access, specifying the first and last line numbers that can be used (numbers range from 0 to 1180, and the last number must be greater than the first number).

 
     
      [bookmark: pgfId-820372]hostname(config)# line vty first_line last_line
     

     
      [bookmark: pgfId-820374] 
     

     [bookmark: pgfId-820376]Step 3 Prevent non-SSH connections, such as Telnet.

 
     
      [bookmark: pgfId-820378]hostname(config-line)# transport input ssh
     

     
      [bookmark: pgfId-820380] 
     

     [bookmark: pgfId-820382]Step 4 Exit configuration mode.

 
     
      [bookmark: pgfId-820384]hostname(config-line)# end
     

     
      [bookmark: pgfId-820386] 
     

     [bookmark: pgfId-820388]Step 5 Save the configuration changes.

 
     
      [bookmark: pgfId-820390]hostname# write memory
     

     
      [bookmark: pgfId-820392] 
     

     [bookmark: pgfId-820394]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-820408][bookmark: 4293][bookmark: ivman_cncpt_SettingUpAUS]Setting Up AUS or Configuration Engine[bookmark: marker-820400][bookmark: marker-820402][bookmark: marker-820404][bookmark: marker-820406]

 
    [bookmark: pgfId-820410]With many devices, you can use an intermediate transport server to stage configuration updates to the device. These transport servers can also allow you to manage devices that use dynamically assigned IP address (using a DHCP server) instead of static IP addresses. When you deploy configurations using a transport server, Security Manager deploys the configuration to the server, and the device retrieves the configuration from the server. You can use Auto Update Server, running the AUS protocol, or Cisco Configuration Engine, running the CNS protocol.

 
    [bookmark: pgfId-820412]The following topics describe how to set up AUS or CNS on the devices:

 
     
     		 [bookmark: pgfId-820417]Setting Up AUS on PIX Firewall and ASA Devices

 
     		 [bookmark: pgfId-820422]Setting Up CNS on Cisco IOS Routers in Event-Bus Mode

 
     		 [bookmark: pgfId-820427]Setting Up CNS on Cisco IOS Routers in Call-Home Mode

 
    

 
     
      [bookmark: pgfId-820441][bookmark: 4319][bookmark: ivman_cncpt_SettingUpAUSonPIXFirewallandASADevices]Setting Up AUS on PIX Firewall and ASA Devices [bookmark: marker-820433][bookmark: marker-820435][bookmark: marker-820437][bookmark: marker-820439]

 
     [bookmark: pgfId-820446]You can configure PIX firewalls and ASA devices to use the AUS protocol to contact an Auto Update Server or CNS Configuration Engine for configuration and image updates. When using Configuration Engine, the device uses the same AUS protocol used for Auto Update Server, so the configuration is the same. For an end-to-end explanation of how AUS/CE deployment works, see Deploying Configurations Using an Auto Update Server or CNS Configuration Engine.

 
     [bookmark: pgfId-820448]You need to initially configure AUS settings on the device so that the device knows that it must contact the AUS/CE server for configuration updates. After the initial deployment, you can change these settings using the Platform > Device Admin > Server Access > AUS policy.

 
     [bookmark: pgfId-820450]This procedure describes the tasks to complete before you use AUS or CNS as the transport protocol for device management on PIX firewall and ASA devices.

 
     
 
     [bookmark: pgfId-820452]Step 1 Enter configuration mode.

 
     
      [bookmark: pgfId-820454]router# config terminal
     

     
      [bookmark: pgfId-820456] 
     

     [bookmark: pgfId-820458]Step 2 Connect to the AUS. Specify a username and its password that can log into Security Manager. The port number is typically 443.

 
     
      [bookmark: pgfId-820460]hostname(config)# auto-update server https:// username:password@AUSserver_IP_address:port  /autoupdate/AutoUpdateServlet
     

     
      [bookmark: pgfId-820462] 
     

     [bookmark: pgfId-820464]Step 3 Specify the polling period for AUS.

 
     
      [bookmark: pgfId-820466]hostname(config)# auto-update poll-period  poll_period  [retry_count ] [retry_period ]
     

     
      [bookmark: pgfId-820468] 
     

     [bookmark: pgfId-820470]Where:

 
      
      		 [bookmark: pgfId-820472] poll_period —The polling period interval between two updates. Default is 720 minutes (12 hours).

 
      		 [bookmark: pgfId-820474] retry_count —(Optional) The number of times to retry if the server connection attempt fails. Default is 0.

 
      		 [bookmark: pgfId-820476] retry_period— (Optional) The number of minutes between retries. Default is 5.

 
     

 
     [bookmark: pgfId-820478]Step 4 Configure the device to use the specified unique device ID to identify itself.

 
     
      [bookmark: pgfId-820480]hostname(config)# auto-update device-id  [ hardware-serial | hostname | 
     

     
      [bookmark: pgfId-820482]ipaddress  [if_name ] | mac-address [if_name ] | string text ]
     

     
      [bookmark: pgfId-820484] 
     

     [bookmark: pgfId-820486]Where:

 
      
      		 [bookmark: pgfId-820488] if_name —The device interface name (the default is  inside ).

 
      		 [bookmark: pgfId-820490] text —A unique string name.

 
     

 
     [bookmark: pgfId-820492]Step 5 Save the configuration changes.

 
     
      [bookmark: pgfId-820494]hostname# write memory
     

     
      [bookmark: pgfId-820496] 
     

     [bookmark: pgfId-820498]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-820512][bookmark: 4397][bookmark: ivprep_cncpt_SettingUpCNSonCiscoIOSRoutersinEventBusMode]Setting Up CNS on Cisco IOS Routers in Event-Bus Mode [bookmark: marker-820504][bookmark: marker-820506][bookmark: marker-820508][bookmark: marker-820510]

 
     [bookmark: pgfId-820517]You can configure Cisco IOS routers to use the CNS protocol to contact a Cisco Configuration Engine for configuration and image updates. The Configuration Engine can operate in two modes, event-bus and call-home. The following procedure describes how to configure a router to use event-bus mode. For information on using call-home mode, see Setting Up CNS on Cisco IOS Routers in Call-Home Mode.

 
     [bookmark: pgfId-820519]See the Configuration Engine product documentation for more information about configuring and using the product.

 
     
 
     [bookmark: pgfId-820521]Step 1 Enter configuration mode.

 
     
      [bookmark: pgfId-820523]router# config terminal
     

     
      [bookmark: pgfId-820525] 
     

     [bookmark: pgfId-820527]Step 2 Configure the hostname and domain name if the device is new.

 
     
      [bookmark: pgfId-820529]router(config)# hostname name 
     

     
      [bookmark: pgfId-820531]hostname(config)# ip domain-name your_domain
     

     
      [bookmark: pgfId-820533] 
     

     [bookmark: pgfId-820535]Step 3 Specify the trusted server for the CNS agent. Enter the IP address of the trusted server.

 
     
      [bookmark: pgfId-820537]hostname(config)# cns trusted-server all-agents ip_address 
     

     
      [bookmark: pgfId-820539] 
     

     [bookmark: pgfId-820541]Step 4 Configure the CNS event gateway, which provides CNS event services to Cisco IOS clients. Enter the IP address of the event gateway, and optionally the port. The default port is either 11011 (with no encryption) or 11012 (with encryption). Include the encrypt keyword to use an SSL encrypted link to the event gateway.

 
     
      [bookmark: pgfId-820543]hostname(config)# cns event ip_address  [encrypt] [port]
     

     
      [bookmark: pgfId-820545] 
     

     [bookmark: pgfId-820547]Step 5 Start the CNS configuration agent and accept a partial configuration. Include the encrypt keyword to use an SSL encrypted link to the web server.

 
     
      [bookmark: pgfId-820549]hostname(config)# cns config partial ip_address [encrypt]
     

     
      [bookmark: pgfId-820551] 
     

     [bookmark: pgfId-820555]Step 6 Set the CNS password, which must be the same password configured on the CNS gateway. For information on how to authenticate a Cisco IOS router on a Configuration Engine, see Cisco Configuration Engine Administrator Guide at http://www.cisco.com/en/US/products/sw/netmgtsw/ps4617/prod_maintenance_guides_list.html.

 
     
      [bookmark: pgfId-820557]hostname(config)# cns password password
     

     
      [bookmark: pgfId-820559] 
     

     [bookmark: pgfId-820561]Step 7 Enable and configure the CNS execute agent. Include the encrypt keyword to use an SSL encrypted link to the exec server. You can specify a port number for the encrypted exchange if you do not want to use the default port 443.

 
     
      [bookmark: pgfId-820563]hostname(config)# cns exec [encrypt [port]]
     

     
      [bookmark: pgfId-820565] 
     

     [bookmark: pgfId-820567]Step 8 Exit configuration mode and return to Exec mode.

 
     
      [bookmark: pgfId-820569]hostname(config)# exit
     

     
      [bookmark: pgfId-820571] 
     

     [bookmark: pgfId-820573]Step 9 Save the configuration changes.

 
     
      [bookmark: pgfId-820575]hostname# write memory
     

     
      [bookmark: pgfId-820577] 
     

     [bookmark: pgfId-820579]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-820593][bookmark: 4478][bookmark: ivprep_cncpt_SettingUpCNSonCiscoIOSRoutersinCallHomeMode]Setting Up CNS on Cisco IOS Routers in Call-Home Mode [bookmark: marker-820585][bookmark: marker-820587][bookmark: marker-820589][bookmark: marker-820591]

 
     [bookmark: pgfId-820598]You can configure Cisco IOS routers to use the CNS protocol to contact a Cisco Configuration Engine for configuration and image updates. The Configuration Engine can operate in two modes, event-bus and call-home. The following table describes the tasks to complete to configure a router to use call-home mode. For information on using event-bus mode, see Setting Up CNS on Cisco IOS Routers in Event-Bus Mode.

 
     [bookmark: pgfId-820600]See the Configuration Engine product documentation for more information about configuring and using the product.

 
     
 
     [bookmark: pgfId-820602]Step 1 Enter configuration mode.

 
     
      [bookmark: pgfId-820604]router# config terminal
     

     
      [bookmark: pgfId-820606] 
     

     [bookmark: pgfId-820608]Step 2 Configure the hostname and domain name if the device is new.

 
     
      [bookmark: pgfId-820610]router(config)# hostname name 
     

     
      [bookmark: pgfId-820612]hostname(config)# ip domain-name your_domain
     

     
      [bookmark: pgfId-820614] 
     

     [bookmark: pgfId-820616]Step 3 Specify the IP address of the trusted server for the CNS agent.

 
     
      [bookmark: pgfId-820618]hostname(config)# cns trusted-server all-agents ip_address 
     

     
      [bookmark: pgfId-820620] 
     

     [bookmark: pgfId-820622]Step 4 Specify schedule parameters for a Command Scheduler occurrence and enter kron-occurrence configuration mode.

 
     
      [bookmark: pgfId-820624]hostname(config)# kron occurrence occurrence-name [user username ] 
     

     
      [bookmark: pgfId-820626]{in [[numdays:]numhours:]nummin  | at hours:min [[month] day-of-month] [day-of-week]} {oneshot  | recurring}
     

     
      [bookmark: pgfId-820628] 
     

     [bookmark: pgfId-820630]Where:

 
      
      		 [bookmark: pgfId-820632] occurrence-name —The name of the occurrence. The name can be from 1 to 31 characters. If the occurrence-name is new, an occurrence structure is created. If the occurrence-name is not new, the existing occurrence is edited.

 
      		 [bookmark: pgfId-820634] username —(Optional) The name of the user.

 
      		 [bookmark: pgfId-820636] in [ [numdays:]numhours:]nummin —The occurrence should run after waiting the specified time. You can enter a number of days, hours, or minutes, or a combination of them. The timer starts when the occurrence is configured.

 
      		 [bookmark: pgfId-820638] at  hours:min [[month] day-of-month] [day-of-week] —The occurrence should run at the specified hour and minute on the specified month and day, or day of the week. Specify the hour using the 24-hour clock.

 
      		 [bookmark: pgfId-820640] oneshot —Specifies that the occurrence is to run only once. After the occurrence runs, the configuration is removed.

 
      		 [bookmark: pgfId-820642] recurring —Specifies that the occurrence is to run on a recurring basis.

 
     

 
     [bookmark: pgfId-820644]Step 5 Specify the policy list associated with a Command Scheduler occurrence. The name can be 1 to 31 characters. If the list-name is new, a policy list structure is created. If the list-name is not new, the existing policy list is edited.

 
     
      [bookmark: pgfId-820654]hostname(config-kron-occurrence)# exit 
     

     
      [bookmark: pgfId-820656] 
     

     [bookmark: pgfId-820658]Step 7 Specify a name for a Command Scheduler policy and enter kron-policy configuration mode. The name can be 1 to 31 characters. If the list-name is new, a policy list structure is created. If the list-name is not new, the existing policy list is edited.

 
     
      [bookmark: pgfId-820660]hostname(config)# kron policy-list list-name 
     

     
      [bookmark: pgfId-820662] 
     

     [bookmark: pgfId-820664]Step 8 Retrieve the configuration from the staged CNS job. Specify the IP address of the CNS server. You must use JobbedDynaConfig status so that the device retrieves the config from the staged CNS job; otherwise, the device retrieves the template associated with the device.

 
     
      [bookmark: pgfId-820666]hostname(config-kron-policy)# cli cns config retrieve ip_address  
     

     
      [bookmark: pgfId-820668] page /cns/JobbedDynaConfig status http:// ip_address /cns/PostStatus
     

     
      [bookmark: pgfId-820670] 
     

     [bookmark: pgfId-820672]Step 9 Exit kron-policy configuration mode and return to configuration mode.

 
     
      [bookmark: pgfId-820674]hostname(config-kron-policy)# exit 
     

     
      [bookmark: pgfId-820676] 
     

     
      [bookmark: pgfId-820678] 
     

     [bookmark: pgfId-820680]Step 10 Enable and configure the CNS execute agent.

 
     
      [bookmark: pgfId-820682]hostname(config)# cns exec 
     

     
      [bookmark: pgfId-820684] 
     

     [bookmark: pgfId-820686]Step 11 Exit configuration mode and return to Exec mode.

 
     
      [bookmark: pgfId-820688]hostname(config)# exit
     

     
      [bookmark: pgfId-820690] 
     

     [bookmark: pgfId-820692]Step 12 Save the configuration changes.

 
     
      [bookmark: pgfId-820694]hostname# write memory
     

     
      [bookmark: pgfId-820696] 
     

     [bookmark: pgfId-820698]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-820710][bookmark: 4607][bookmark: ivprep_cncpt_ConfiguringLicensesonCiscoASADevices]Configuring Licenses on Cisco ASA Devices [bookmark: marker-820704][bookmark: marker-820706][bookmark: marker-820708]

 
    [bookmark: pgfId-820712]Devices that run Cisco ASA Software require Product Activation Keys for each feature license. Some licenses are optional, such as Botnet Traffic Filtering, and can be time-based. Other features are standard on some models, but optional on others, such as the Failover license, which is optional on the 5505 and 5510 models but standard on all other models.

 
    [bookmark: pgfId-820714]You cannot install or activate ASA licenses through Security Manager. Instead, use the Adaptive Security Device Manager (ASDM). Enter the activation keys by selecting Configuration > Device Management > Licensing > Activation Key and following the instructions in the online help for that page. The Activation Key page also lists the state of all feature licenses. The ASDM online help includes extensive information about ASA licensing.

 
    [bookmark: pgfId-820716]When you deploy configurations from Security Manager, the device must have active licenses for all features in the configuration or you will see deployment errors. In most cases, Security Manager does not prevent you from configuring a feature based on the licenses that are active on a device. For example, you can configure Botnet Traffic Filtering for a device even if that device has a disabled Botnet license.

 
    [bookmark: pgfId-820721]The exception is the Failover license on the 5505 and 5510 models. There is a device property that you can set to indicate whether there is an active Failover license on a device: License Supports Failover. You can set this property by double-clicking the device (in Device view) to open the Device Properties page; the option is on the General tab (see Device Properties: General Page). If you discover policies on the device, for example, when adding the device to the inventory using the Add Device From Network or Add Device from File (from an inventory file, not a configuration file) options, Security Manager determines the state of the Failover license and sets the property appropriately. You are responsible for ensuring that the property remains accurate. You will see deployment failures if the property is selected but the device has an inactive Failover license.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-820723]Tip If you add the device using the New Device or Configuration File options, you can set the License Supports Failover property while adding the device instead of waiting to set it in the device properties.


    
     

    

    

 
   
 
    
     [bookmark: pgfId-820737][bookmark: 4626][bookmark: ivprep_cncpt_ConfiguringLicensesonCiscoIOSDevices]Configuring Licenses on Cisco IOS Devices [bookmark: marker-820729][bookmark: marker-820731][bookmark: marker-820733][bookmark: marker-820735]

 
    [bookmark: pgfId-820739]Devices that run Cisco IOS Software require license files for various features, including security features. If these licenses are not installed on the device (such as the securityk9 package), Security Manager cannot configure commands that require a particular license level, and you will experience deployment failures when you try to deploy your policies to an unlicensed device.

 
    [bookmark: pgfId-820745]Although you can use Security Manager to deploy and manage IPS licenses, you cannot use it to deploy and manage any other type of license. Configure these licenses directly on the device using the command line interface or use Cisco License Manager. Following is the general process for configuring licenses. For more information about configuring licenses, see Cisco IOS Software Activation Command Guide and Cisco IOS Software Activation Command Reference on Cisco.com.

 
    [bookmark: pgfId-820747] 1. Obtain the licenses required for the features you want to use or you can use the evaluation licenses that come bundled with some devices. Use the show license all command to view the available licenses.

 
    [bookmark: pgfId-820749] 2. Copy the purchased licenses to the flash storage on the device or put them on a TFTP server. For example, you could place the licenses on a TFTP server and use the copy tftp flash0: command to copy the files to the flash0 storage area.

 
    [bookmark: pgfId-820751] 3. Use the license install command to install each purchased license. For example:

 
    [bookmark: pgfId-820753]license install flash0:uc-base-CISCO2951-FHH1216P06Z.xml

 
    [bookmark: pgfId-820755]Some licenses prompt you to read and accept a license agreement.

 
    [bookmark: pgfId-820757]If you want to use an evaluation license, use the license boot command to enable them and then reload the device. You must accept the end-user license agreement before Security Manager can deploy configurations to the device.

 
    [bookmark: pgfId-820759] 4. You can use the show version, show license feature, and show license all commands to check on your installed licenses.

 
   
 
    
     [bookmark: pgfId-820767][bookmark: 4665][bookmark: ivman_cncpt_InitializingIPSDevices]Initializing IPS Devices[bookmark: marker-820765]

 
    [bookmark: pgfId-820769]To initialize an IPS device, you must configure the following settings. These are network settings, and only a user with administrator privileges on the IPS device can configure them:

 
     
     		 [bookmark: pgfId-820771]Sensor name

 
     		 [bookmark: pgfId-820773]IP address

 
     		 [bookmark: pgfId-820775]Netmask

 
     		 [bookmark: pgfId-820777]Default route

 
     		 [bookmark: pgfId-820779]Enable TLS/SSL (to enable TLS/SSL in the web server on the device)

 
     		 [bookmark: pgfId-820781]Web server port

 
     		 [bookmark: pgfId-820783]Use default ports

 
    

 
    [bookmark: pgfId-820787]You configure these settings through the setup command in Intrusion Prevention System Device Manager (IDM) or in a command-line session, depending upon which platform is used by your IPS device. For a list of supported IPS platforms, see the supported devices and software versions information at the following URL: http://www.cisco.com/en/US/products/ps6498/products_device_support_tables_list.html.

 
    [bookmark: pgfId-820789]For detailed information on these settings, refer to the technical documentation for your IPS device.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-820794]Note For information on preparing an IOS IPS device for use, see Initial Preparation of a Cisco IOS IPS Router.
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     [bookmark: pgfId-791886][bookmark: 53477][bookmark: porules_cncpt_botnet_WorkingWith]Managing Firewall Botnet Traffic Filter Rules[bookmark: marker-791884]
      
      
 
     
 

 
    [bookmark: pgfId-791888]Malware is malicious software that is installed on an unknowing host. Malware that attempts network activity such as sending private data (passwords, credit card numbers, key strokes, or proprietary data) can be detected by the Botnet Traffic Filter when the malware starts a connection to a known bad IP address. The Botnet Traffic Filter checks incoming and outgoing connections against a dynamic database of known bad domain names and IP addresses, and then logs any suspicious activity.

 
    [bookmark: pgfId-791890]You can also supplement the Cisco dynamic database with blacklisted addresses of your choosing by adding them to a static blacklist; if the dynamic database includes blacklisted addresses that you think should not be blacklisted, you can manually enter them into a static whitelist. Whitelisted addresses still generate syslog messages, but because you are only targeting blacklist syslog messages, they are informational. If you do not want to use the Cisco dynamic database at all, because of internal requirements, you can use the static blacklist alone if you can identify all the malware sites that you want to target.

 
    [bookmark: pgfId-791892]Related Topics

 
     
     		 [bookmark: pgfId-791897]Understanding Botnet Traffic Filtering

 
     		 [bookmark: pgfId-791902]Task Flow for Configuring the Botnet Traffic Filter

 
     		 [bookmark: pgfId-791907]Botnet Traffic Filter Rules Page

 
    

 
   
 
    
     [bookmark: pgfId-791919][bookmark: 53496][bookmark: porules_cncpt_botnet_Understanding]Understanding Botnet Traffic Filtering[bookmark: marker-791913][bookmark: marker-791915][bookmark: marker-791917]

 
    [bookmark: pgfId-791921]Botnet Traffic Filter Address Categories

 
    [bookmark: pgfId-791923]Addresses monitored by the Botnet Traffic Filter include:

 
     
     		 [bookmark: pgfId-791925] Known malware addresses —These addresses are on the blacklist identified by the dynamic database and the static blacklist.

 
     		 [bookmark: pgfId-791927] Known allowed addresses —These addresses are on the whitelist. To be whitelisted, an address must be blacklisted by the dynamic database and also identified by the static whitelist.

 
     		 [bookmark: pgfId-791929] Ambiguous addresses —These addresses are associated with multiple domain names, but not all of these domain names are on the blacklist. These addresses are on the graylist.

 
     		 [bookmark: pgfId-791931] Unlisted addresses —These addresses are unknown, and not included on any list.

 
    

 
    [bookmark: pgfId-791933]Botnet Traffic Filter Actions for Known Addresses

 
    [bookmark: pgfId-791935]You can configure the Botnet Traffic Filter to log suspicious activity, and you can optionally configure it to block suspicious traffic automatically.

 
    [bookmark: pgfId-791937]Unlisted addresses do not generate any syslog messages, but addresses on the blacklist, whitelist, and graylist generate syslog messages differentiated by type.

 
    [bookmark: pgfId-791939]Botnet Traffic Filter Databases

 
    [bookmark: pgfId-791941]The Botnet Traffic Filter uses two databases for known addresses. You can use both databases together, or you can disable use of the dynamic database and use the static database alone. This section includes the following topics:

 
     
     		 [bookmark: pgfId-791943]Information About the Dynamic Database

 
     		 [bookmark: pgfId-791945]Information About the Static Database

 
    

 
    [bookmark: pgfId-791947]Information About the Dynamic Database

 
    [bookmark: pgfId-791949]The Botnet Traffic Filter can receive periodic updates for the dynamic database from the Cisco update server. This database lists thousands of known bad domain names and IP addresses.

 
    [bookmark: pgfId-791951]The security appliance uses the dynamic database as follows:

 
    [bookmark: pgfId-791953] 1. When the domain name in a DNS reply matches a name in the dynamic database, the Botnet Traffic Filter adds the name and IP address to the DNS reverse lookup cache.

 
    [bookmark: pgfId-791955] 2. When the infected host starts a connection to the IP address of the malware site, the security appliance sends a syslog message informing you of the suspicious activity.

 
    [bookmark: pgfId-791957] 3. In some cases, the IP address itself is supplied in the dynamic database, and the Botnet Traffic Filter logs any traffic to that IP address without having to inspect DNS requests.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-791959]Note To use the database, be sure to configure a domain name server for the security appliance so that it can access the URL. 

To use the domain names in the dynamic database, you need to enable DNS packet inspection with Botnet Traffic Filter snooping; the security appliance looks inside the DNS packets for the domain name and associated IP address.


    
     

    

    

 
    [bookmark: pgfId-791961]Information About the Static Database

 
    [bookmark: pgfId-791963]You can manually enter domain names or IP addresses (host or subnet) that you want to tag as bad names in a blacklist. You can also enter names or IP addresses in a whitelist, so that names or addresses that appear on both the whitelist and the dynamic blacklist are identified only as whitelist addresses in syslog messages and reports.

 
    [bookmark: pgfId-791965]You can alternatively enable DNS packet inspection with Botnet Traffic Filter snooping. With DNS snooping, when an infected host sends a DNS request for a name on the static database, the security appliance looks inside the DNS packets for the domain name and associated IP address and adds the name and IP address to the DNS reverse lookup cache.

 
    [bookmark: pgfId-791967]Related Topics

 
     
     		 [bookmark: pgfId-791972]Task Flow for Configuring the Botnet Traffic Filter

 
     		 [bookmark: pgfId-791977]Botnet Traffic Filter Rules Page

 
    

 
   
 
    
     [bookmark: pgfId-791985][bookmark: 53567][bookmark: porules_cklst_botnet_taskflow]Task Flow for Configuring the Botnet Traffic Filter[bookmark: marker-791983]

 
    [bookmark: pgfId-791987]To configure the Botnet Traffic Filter, follow these steps:

 
    
 
    [bookmark: pgfId-791989]Step 1 Enable use of a DNS server.

 
    [bookmark: pgfId-791991]This procedure enables security appliance use of a DNS server. In multiple context mode, enable DNS per context.

 
    [bookmark: pgfId-791996]For more information, see DNS Page

 
    [bookmark: pgfId-791998]Step 2 Enable use of the dynamic database.

 
    [bookmark: pgfId-792000]This procedure enables database updates from the Cisco update server, and also enables use of the downloaded dynamic database by the security appliance. Disallowing use of the downloaded database is useful in multiple context mode so you can configure use of the database on a per-context basis.

 
    [bookmark: pgfId-792005]For more information, see Configuring the Dynamic Database

 
    [bookmark: pgfId-792007]Step 3 (Optional) Add static entries to the database.

 
    [bookmark: pgfId-792009]This procedure lets you augment the dynamic database with domain names or IP addresses that you want to blacklist or whitelist. You might want to use the static database instead of the dynamic database if you do not want to download the dynamic database over the Internet.

 
    [bookmark: pgfId-792014]For more information, see Adding Entries to the Static Database

 
    [bookmark: pgfId-792016]Step 4 Enable DNS snooping.

 
    [bookmark: pgfId-792018]This procedure enables inspection of DNS packets, compares the domain name with those in the dynamic database or the static database (when a DNS server for the security appliance is unavailable), and adds the name and IP address to the DNS reverse lookup cache. This cache is then used by the Botnet Traffic Filter logging function when connections are made to the suspicious address.

 
    [bookmark: pgfId-792023]For more information, see Enabling DNS Snooping

 
    [bookmark: pgfId-792025]Step 5 Enable traffic classification and actions for the Botnet Traffic Filter.

 
    [bookmark: pgfId-792027]This procedure enables the Botnet Traffic Filter, which compares the source and destination IP address in each initial connection packet to the IP addresses in the dynamic database, static database, DNS reverse lookup cache, and DNS host cache, and sends a syslog message for any matching traffic or drops that traffic.

 
    [bookmark: pgfId-792032]For more information, see Enabling Traffic Classification and Actions for the Botnet Traffic Filter

 
    [bookmark: pgfId-792034]Step 6 Monitor and Mitigate Botnet Activity.

 
    [bookmark: pgfId-792036]After configuring the Botnet Traffic Filter on a device, the device will begin generating syslog messages to notify you of botnet activity. You should verify the syslog configuration on the device so that messages are appropriately logged and that notifications are sent as needed. As malicious traffic is identified, you will need to perform necessary actions to stop such traffic and to clean any infected computers that are generating the malicious traffic.

 
    [bookmark: pgfId-792038]For more information, see the following references:

 
    [bookmark: pgfId-792043] 1. Chapter 53, “Configuring Logging Policies on Firewall Devices”

 
    [bookmark: pgfId-792048] 2. Monitoring and Mitigating Botnet Activity

 
    [bookmark: pgfId-792053] 3. Understanding Firewall Summary Botnet Reports

 
    [bookmark: pgfId-792055]


    
     

    
 
    

 
     
      [bookmark: pgfId-792063][bookmark: 53621][bookmark: porules_proc_botnet_ConfiguringDynamicDatabase]Configuring the Dynamic Database[bookmark: marker-792061]

 
     [bookmark: pgfId-792065]This procedure enables database updates, and also enables use of the downloaded dynamic database by the security appliance.

 
     [bookmark: pgfId-792067]In multiple context mode, you enable downloading of the dynamic database on the System context so that it is available to all security contexts. You can then decide, on a per-context basis, whether to enable use of the dynamic database or not.

 
     [bookmark: pgfId-792069]By default, downloading and using the dynamic database is disabled.

 
     [bookmark: pgfId-792071]Related Topics

 
      
      		 [bookmark: pgfId-792076]Dynamic Blacklist Configuration Tab

 
      		 [bookmark: pgfId-792081]Understanding Botnet Traffic Filtering

 
      		 [bookmark: pgfId-792086]Task Flow for Configuring the Botnet Traffic Filter

 
      		 [bookmark: pgfId-792091]Adding Entries to the Static Database

 
      		 [bookmark: pgfId-792096]Enabling DNS Snooping

 
      		 [bookmark: pgfId-792101]Enabling Traffic Classification and Actions for the Botnet Traffic Filter

 
      		 [bookmark: pgfId-792106]Botnet Traffic Filter Rules Page

 
     

 
     [bookmark: pgfId-792108]Before You Begin

 
     [bookmark: pgfId-792113]Enable security appliance use of a DNS server (see DNS Page). In multiple context mode, enable DNS per context.

 
     
 
     [bookmark: pgfId-792115]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-792117](Device view) Select  Firewall > Botnet Traffic Filter Rules from the Policy selector.

 
      		 [bookmark: pgfId-792119](Policy view) Select  Firewall > Botnet Traffic Filter Rules from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-792121]Note For devices in multiple context mode, you enable downloading of the dynamic database on the System context and enable use of the dynamic database on each security context, as needed.


     
      

     

     

 
     [bookmark: pgfId-792126]This opens the Botnet Traffic Filter Rules Page.

 
     [bookmark: pgfId-792128]Step 2 On the Dynamic Blacklist Configuration tab, select Enable Dynamic Blacklist From Server to enable downloading of the dynamic database.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-792130]Note In multiple context mode, you enable downloading of the dynamic database on the System context.


     
      

     

     

 
     [bookmark: pgfId-792132]This setting enables downloading of the dynamic database from the Cisco update server. If you do not have a database already installed on the security appliance, it downloads the database after approximately 2 minutes. The update server determines how often the security appliance polls the server for future updates, typically every hour.

 
     [bookmark: pgfId-792137]Step 3 (Multiple context mode only) Click Save to save the changes to the System context. Then change to the context where you want to configure the Botnet Traffic Filter, select Firewall > Botnet Traffic Filter Rules for that context, and then proceed to Step 4.

 
     [bookmark: pgfId-792141]Step 4 [bookmark: 53681]On the Dynamic Blacklist Configuration tab, select Use Dynamic Blacklist to enable use of the dynamic database.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-792143]Note In multiple context mode, these settings are disabled on the System context.


     
      

     

     

 
     [bookmark: pgfId-792145]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-792153][bookmark: 53688][bookmark: porules_proc_botnet_AddingStaticEntries]Adding Entries to the Static Database[bookmark: marker-792151]

 
     [bookmark: pgfId-792158]The static database lets you augment the dynamic database with domain names, IP addresses, or network addresses that you want to blacklist or whitelist. For more information, see Understanding Botnet Traffic Filtering.

 
     [bookmark: pgfId-792160]Related Topics

 
      
      		 [bookmark: pgfId-792165]Whitelist/Blacklist Tab

 
      		 [bookmark: pgfId-792170]Device Whitelist or Device Blacklist Dialog Box

 
      		 [bookmark: pgfId-792175]Understanding Botnet Traffic Filtering

 
      		 [bookmark: pgfId-792180]Task Flow for Configuring the Botnet Traffic Filter

 
      		 [bookmark: pgfId-792185]Configuring the Dynamic Database

 
      		 [bookmark: pgfId-792190]Enabling DNS Snooping

 
      		 [bookmark: pgfId-792195]Enabling Traffic Classification and Actions for the Botnet Traffic Filter

 
      		 [bookmark: pgfId-792200]Botnet Traffic Filter Rules Page

 
     

 
     [bookmark: pgfId-792202]Before You Begin

 
      
      		 [bookmark: pgfId-792207]Enable security appliance use of a DNS server (see DNS Page). In multiple context mode, enable DNS per context.

 
     

 
     
 
     [bookmark: pgfId-792209]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-792211](Device view) Select  Firewall > Botnet Traffic Filter Rules from the Policy selector.

 
      		 [bookmark: pgfId-792213](Policy view) Select  Firewall > Botnet Traffic Filter Rules from the Policy Type selector. Select an existing policy or create a new one.
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     [bookmark: pgfId-792215]Note For devices in multiple context mode, you configure the static database on the security context.


     
      

     

     

 
     [bookmark: pgfId-792220]This opens the Botnet Traffic Filter Rules Page.

 
     [bookmark: pgfId-792222]Step 2 On the Whitelist / Blacklist tab, click the Add Rows button that corresponds with the type of entry you are adding (Whitelist or Blacklist).

 
     [bookmark: pgfId-792227]This opens the Device Whitelist or Device Blacklist Dialog Box.

 
     [bookmark: pgfId-792229]Step 3 In the Domain or IP Address field, enter one or more domain names, IP addresses, and IP address/netmasks. Enter multiple entries separated by commas or on separate lines. You can enter up to 1000 entries for each type.

 
     [bookmark: pgfId-792231]Step 4 Click OK.

 
     [bookmark: pgfId-792233]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-792243][bookmark: 53755][bookmark: porules_proc_botnet_EnablingDNSSnooping]Enabling DNS Snooping[bookmark: marker-792239][bookmark: marker-792241]

 
     [bookmark: pgfId-792245]This procedure enables inspection of DNS packets and enables Botnet Traffic Filter snooping, which compares the domain name with those on the dynamic database or static database, and adds the name and IP address to the Botnet Traffic Filter DNS reverse lookup cache. This cache is then used by the Botnet Traffic Filter logging function when connections are made to the suspicious address.

 
     [bookmark: pgfId-792247]The default configuration for DNS inspection inspects all UDP DNS traffic on all interfaces, and does not have Botnet Traffic Filter snooping enabled. We suggest that you enable Botnet Traffic Filter snooping only on interfaces where external DNS requests are going. Enabling Botnet Traffic Filter snooping on all UDP DNS traffic, including that going to an internal DNS server, creates unnecessary load on the security appliance.
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     [bookmark: pgfId-792249]Note TCP DNS traffic is not supported.


     
      

     

     

 
     [bookmark: pgfId-792251]Related Topics

 
      
      		 [bookmark: pgfId-792256]Configure DNS Dialog Box

 
      		 [bookmark: pgfId-792261]Understanding Botnet Traffic Filtering

 
      		 [bookmark: pgfId-792266]Task Flow for Configuring the Botnet Traffic Filter

 
      		 [bookmark: pgfId-792271]Configuring the Dynamic Database

 
      		 [bookmark: pgfId-792276]Adding Entries to the Static Database

 
      		 [bookmark: pgfId-792281]Enabling Traffic Classification and Actions for the Botnet Traffic Filter

 
      		 [bookmark: pgfId-792286]Botnet Traffic Filter Rules Page

 
     

 
     
 
     [bookmark: pgfId-792291]Step 1 You must first configure DNS inspection for traffic that you want to snoop using the Botnet Traffic Filter. See Chapter 17, “Managing Firewall Inspection Rules”.

 
     [bookmark: pgfId-792293]Step 2 While defining a new inspection rule or editing an existing inspection rule, select DNS as the protocol you want to inspect.

 
     [bookmark: pgfId-792295]The Configure button to the right of the Selected Protocol field becomes active.

 
     [bookmark: pgfId-792297]Step 3 Click Configure.

 
     [bookmark: pgfId-792302]This opens the Configure DNS Dialog Box.

 
     [bookmark: pgfId-792304]Step 4 To enable DNS snooping, select Enable Dynamic Filter Snooping.

 
     [bookmark: pgfId-792306]Step 5 Click OK.

 
     [bookmark: pgfId-792308]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-792318][bookmark: 53814][bookmark: porules_proc_botnet_EnablingTrafficClassification]Enabling Traffic Classification and Actions for the Botnet Traffic Filter[bookmark: marker-792314][bookmark: marker-792316]

 
     [bookmark: pgfId-792320]This procedure enables the Botnet Traffic Filter, which compares the source and destination IP address in each initial connection packet to the IP addresses in the dynamic database, static database, DNS reverse lookup cache, and DNS host cache, and sends a syslog message for any matching traffic. The Botnet Traffic Filter can also drop the connection when matching traffic is encountered. For a particular interface, you can specify only one enable rule that identifies the traffic that is subject to Botnet Traffic Filtering; however, you can specify multiple drop rules to identify traffic that should be dropped by the Botnet Traffic Filter.

 
     [bookmark: pgfId-792325]The DNS snooping is enabled separately (see Enabling DNS Snooping). Typically, for maximum use of the Botnet Traffic Filter, you need to enable DNS snooping, but you can use Botnet Traffic Filter logging independently if desired. Without DNS snooping for the dynamic database, the Botnet Traffic Filter uses only the static database entries, plus any IP addresses in the dynamic database; domain names in the dynamic database are not used.

 
     [bookmark: pgfId-792327]What You Need To Know About Botnet Traffic Classification ACLs

 
     [bookmark: pgfId-792329]When you configure the enable and drop rules, you have the option of specifying an extended ACL policy object to limit the traffic to which Botnet Traffic Filtering will be applied. If you do not specify an ACL object, filtering is done for all traffic: this is equivalent to specifying an ACL with the single rule permit IP any any.

 
     [bookmark: pgfId-792331]If you want to specify an ACL so that filtering is performed on less than all traffic, keep the following in mind:

 
      
      		 [bookmark: pgfId-792333]Permit rules identify the traffic that is subject to Botnet Traffic Filtering. In drop rules, permit entries identify the traffic that the ASA is allowed to drop.

 
      		 [bookmark: pgfId-792335]Deny rules identify the traffic that should not be subject to filtering. The Botnet Traffic Filter ignores traffic that matches deny entries.

 
      		 [bookmark: pgfId-792337]The ACL that you select for drop rules should be a subset of the ACL used in the enable rules for the interface. For traffic to be dropped, there must not only be a permit rule in the drop rule’s ACL, the traffic must also fall under a permit rule in the enable rule’s ACL. This is because the drop rule is not considered until traffic permitted in an enable rule has first been identified as blacklisted.

 
     

 
     [bookmark: pgfId-792339]We recommend enabling the Botnet Traffic Filter on all traffic on the Internet-facing interface, and enabling dropping of traffic with a severity of moderate and higher.

 
     [bookmark: pgfId-792341]Related Topics

 
      
      		 [bookmark: pgfId-792346]Traffic Classification Tab

 
      		 [bookmark: pgfId-792351]BTF Enable Rules Editor

 
      		 [bookmark: pgfId-792356]BTF Drop Rules Editor

 
      		 [bookmark: pgfId-792361]Understanding Botnet Traffic Filtering

 
      		 [bookmark: pgfId-792366]Task Flow for Configuring the Botnet Traffic Filter

 
      		 [bookmark: pgfId-792371]Configuring the Dynamic Database

 
      		 [bookmark: pgfId-792376]Adding Entries to the Static Database

 
      		 [bookmark: pgfId-792381]Enabling DNS Snooping

 
      		 [bookmark: pgfId-792386]Botnet Traffic Filter Rules Page

 
     

 
     
 
     [bookmark: pgfId-792388]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-792390](Device view) Select  Firewall > Botnet Traffic Filter Rules from the Policy selector.

 
      		 [bookmark: pgfId-792392](Policy view) Select  Firewall > Botnet Traffic Filter Rules from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-792394]Note For devices in multiple context mode, you configure traffic classification on the security context.


     
      

     

     

 
     [bookmark: pgfId-792399]This opens the Botnet Traffic Filter Rules Page.

 
     [bookmark: pgfId-792401]Step 2 To enable the Botnet Traffic Filter on specified traffic, follow these steps:

 
     [bookmark: pgfId-792403] a. On the Traffic Classification tab, click Add Row under the Enable Rules table.

 
     [bookmark: pgfId-792408]This opens the BTF Enable Rules Editor.

 
     [bookmark: pgfId-792413] b. In the Interfaces field, specify the interface or interfaces on which you want to enable the Botnet Traffic Filter. Normally, you want to enable the Internet-facing interface only. To select the interfaces or interface role objects using the Interfaces Selector, click Select (see Understanding Interface Role Objects).

 
     [bookmark: pgfId-792415]You can configure a global classification that applies to all interfaces by selecting the All Interfaces role object (selected by default). If you configure an interface-specific classification, the settings for that interface overrides the global setting.

 
     [bookmark: pgfId-792417] c. Do one of the following to identify the traffic that you want to monitor:

 
      
      		 [bookmark: pgfId-792419]To monitor all traffic, leave the ACL field blank.

 
      		 [bookmark: pgfId-792424]To specify the traffic that you want to monitor, click  Select to the right of the ACL field to select an Access Control List object that identifies the traffic that you want to monitor. For example, you might want to monitor all port 80 traffic on the outside interface. For more information about Access Control List objects, see Creating Access Control List Objects.
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     [bookmark: pgfId-792426]Note You can specify only one enable rule per interface.


     
      

     

     

 
     [bookmark: pgfId-792428] d. Click OK.

 
     [bookmark: pgfId-792430]The BTF Enable Rules Editor closes and the rule is added to the Enable Rules table.

 
     [bookmark: pgfId-792432]Step 3 To automatically drop malware traffic, follow these steps:
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     [bookmark: pgfId-792434]Note You must enable the Botnet Traffic Filter for the traffic you want to automatically drop before creating a drop rule for that traffic.


     
      

     

     

 
     [bookmark: pgfId-792436] a. On the Traffic Classification tab, click Add Row under the Drop Rules table.

 
     [bookmark: pgfId-792441]This opens the BTF Drop Rules Editor.

 
     [bookmark: pgfId-792446] b. In the Interfaces field, specify the interface or interfaces on which you want to drop traffic. There must be a corresponding enable rule for the interface. To select the interfaces or interface role objects using the Interfaces Selector, click Select (see Understanding Interface Role Objects).

 
     [bookmark: pgfId-792448]You can configure a global classification that applies to all interfaces by selecting the All Interfaces role object (selected by default). If you configure an interface-specific classification, the settings for that interface overrides the global setting.

 
     [bookmark: pgfId-792450] c. Do one of the following to identify the traffic that you want to drop:

 
      
      		 [bookmark: pgfId-792452]To monitor all traffic, leave the ACL field blank.

 
      		 [bookmark: pgfId-792457]To specify the traffic that you want to monitor, click  Select to the right of the ACL field to select an Access Control List object that identifies the traffic that you want to monitor. For example, you might want to monitor all port 80 traffic on the outside interface. For more information about Access Control List objects, see Creating Access Control List Objects.

 
     

 
     [bookmark: pgfId-792459] d. In the Threat Level area, choose one of the following options to drop traffic specific threat levels. The default level is a range between Moderate and Very High.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-792461]Note We highly recommend using the default setting unless you have strong reasons for changing the setting.


     
      

     

     

 
      
      		 [bookmark: pgfId-792463]Value—Specify the threat level you want to drop.

 
      		 [bookmark: pgfId-792465]Range—Specify a range of threat levels.
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     [bookmark: pgfId-792467]Note Static blacklist entries are always designated with a Very High threat level.


     
      

     

     

 
     [bookmark: pgfId-792469] e. Click OK.

 
     [bookmark: pgfId-792471]The BTF Drop Rules Editor closes and the rule is added to the Drop Rules table.

 
     [bookmark: pgfId-792473]Step 4 To add more rules, repeat steps 2 and 3, as required. When finished adding rules, click Save to save your changes.

 
     [bookmark: pgfId-792475]Step 5 To treat graylisted traffic as blacklisted traffic for action purposes, on the Dynamic Blacklist Configuration tab, check the Treat Ambiguous traffic as Blacklist check box.

 
     [bookmark: pgfId-792477]If you do not enable this option, graylisted traffic will not be dropped if you configure a drop rule for that traffic.

 
     [bookmark: pgfId-792479]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-792489][bookmark: 53959][bookmark: fwlsvcpg_cncpt_BotnetTrafficFilterRulesPage]Botnet Traffic Filter Rules Page[bookmark: marker-792485][bookmark: marker-792487]

 
    [bookmark: pgfId-792491]You can use the Botnet Traffic Filter Rules page to define rules for identifying malicious traffic passing through your ASA security device.

 
    [bookmark: pgfId-792493]The Botnet Traffic Filter Rules page is divided into three sections:

 
     
     		 [bookmark: pgfId-792498]Dynamic Blacklist Configuration Tab

 
     		 [bookmark: pgfId-792503]Traffic Classification Tab

 
     		 [bookmark: pgfId-792508]Whitelist/Blacklist Tab

 
    

 
    [bookmark: pgfId-792510]Navigation Path

 
    [bookmark: pgfId-792512]To access the Botnet Traffic Filter Rules page, do one of the following:

 
     
     		 [bookmark: pgfId-792514](Device view) Select a device, then select  Firewall > Botnet Traffic Filter Rules from the Policy selector.

 
     		 [bookmark: pgfId-792516](Policy view) Select  Firewall > Botnet Traffic Filter Rules from the Policy Type selector. Select an existing policy or create a new one.

 
     		 [bookmark: pgfId-792518](Map view) Right-click a device and select  Edit Firewall Policies > Botnet Traffic Filter Rules .

 
    

 
    [bookmark: pgfId-792520]Related Topics

 
     
     		 [bookmark: pgfId-792525]Understanding Botnet Traffic Filtering

 
     		 [bookmark: pgfId-792530]Task Flow for Configuring the Botnet Traffic Filter

 
     		 [bookmark: pgfId-792535]Dynamic Blacklist Configuration Tab

 
     		 [bookmark: pgfId-792540]Traffic Classification Tab

 
     		 [bookmark: pgfId-792545]BTF Enable Rules Editor

 
     		 [bookmark: pgfId-792550]BTF Drop Rules Editor

 
     		 [bookmark: pgfId-792555]Whitelist/Blacklist Tab

 
     		 [bookmark: pgfId-792560]Device Whitelist or Device Blacklist Dialog Box

 
     		 [bookmark: pgfId-792565]Configure DNS Dialog Box

 
    

 
     
      [bookmark: pgfId-792577][bookmark: 54022][bookmark: fwlsvcpg_cncpt_BotnetDynamicBlacklistConfigurationTab]Dynamic Blacklist Configuration Tab[bookmark: marker-792573][bookmark: marker-792575]

 
     [bookmark: pgfId-792579]Use the Dynamic Blacklist Configuration tab to enable database updates from the Cisco update server and to enable use of the downloaded dynamic database by the security appliance.

 
     [bookmark: pgfId-792581]Navigation Path

 
     [bookmark: pgfId-792586]From the Botnet Traffic Filter Rules Page, click the Dynamic Blacklist Configuration tab.

 
     [bookmark: pgfId-792588]Related Topics

 
      
      		 [bookmark: pgfId-792593]Configuring the Dynamic Database

 
      		 [bookmark: pgfId-792598]Understanding Botnet Traffic Filtering

 
      		 [bookmark: pgfId-792603]Task Flow for Configuring the Botnet Traffic Filter

 
      		 [bookmark: pgfId-792608]Botnet Traffic Filter Rules Page

 
      		 [bookmark: pgfId-792613]Traffic Classification Tab

 
      		 [bookmark: pgfId-792618]BTF Enable Rules Editor

 
      		 [bookmark: pgfId-792623]BTF Drop Rules Editor

 
      		 [bookmark: pgfId-792628]Whitelist/Blacklist Tab

 
      		 [bookmark: pgfId-792633]Device Whitelist or Device Blacklist Dialog Box

 
      		 [bookmark: pgfId-792638]Configure DNS Dialog Box

 
     

 
     [bookmark: pgfId-792640]Field Reference

 
     [bookmark: pgfId-792643] 

 
      
       
        
        [bookmark: pgfId-791093]Table 19-1 [bookmark: 54072]Dynamic Blacklist Configuration Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-791099]Element
          
  
         		
           
           [bookmark: pgfId-791101]Description
          
  
        

 
         
         		[bookmark: pgfId-791107]Enable Dynamic Blacklist From Server

  
         		[bookmark: pgfId-791109]Enables downloading of the dynamic database from the Cisco update server. If you do not have a database already installed on the security appliance, it downloads the database after approximately 2 minutes. The update server determines how often the security appliance polls the server for future updates, typically every hour.

 [bookmark: pgfId-791111]Note If the device is in multiple context mode, configure this option on the System context for that device.

  
        

 
         
         		[bookmark: pgfId-791117]Use Dynamic Blacklist

  
         		[bookmark: pgfId-791119]Enables use of the dynamic database for the Botnet Traffic Filter.

 [bookmark: pgfId-791121]Note In multiple context mode, you configure use of the database on a per-context basis.

  
        

 
         
         		[bookmark: pgfId-791127]Treat Ambiguous traffic as Blacklist

  
         		[bookmark: pgfId-791129]When selected, graylisted traffic will be treated as blacklisted traffic for action purposes.

 [bookmark: pgfId-791131]If you do not enable this option, graylisted traffic will not be dropped if you configure a drop rule for that traffic.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-792655][bookmark: 54101][bookmark: fwlsvcpg_cncpt_BotnetTrafficClassificationTab]Traffic Classification Tab[bookmark: marker-792651][bookmark: marker-792653]

 
     [bookmark: pgfId-792657]Use the Traffic Classification tab to view or to configure the traffic classification definitions for a device or shared policy and to identify malicious traffic that you want automatically dropped. Traffic classification definitions (enable rules) consist of an interface or interface role with an associated ACL that identifies the traffic that is monitored by the Botnet Traffic Filter. You can configure settings for specific interfaces or for interface roles. You can use the All Interfaces role object to enable botnet filtering globally (selected by default). If you configure an interface-specific classification, the settings for that interface override any settings defined for an interface role.

 
     [bookmark: pgfId-792659]For a particular interface, you can specify only one enable rule that identifies the traffic that is subject to Botnet Traffic Filtering; however, you can specify multiple drop rules to identify traffic that should be dropped by the Botnet Traffic Filter.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-792664]Note We highly recommend configuring Dynamic Filter Snooping for proper functioning of the Botnet Traffic Filter. When in Device view, Cisco Security Manager provides a link at the bottom of the Traffic Classification tab that will take you directly to the Inspection Rules page so that you can enable Dynamic Filter Snooping. For more information, see Enabling DNS Snooping.


     
      

     

     

 
     [bookmark: pgfId-792672]The columns in the tables summarize the settings for an entry and are explained in BTF Enable Rules Editor and BTF Drop Rules Editor.

 
     [bookmark: pgfId-792674]To configure traffic classification and actions:

 
      
      		 [bookmark: pgfId-792682]Click the  Add Row button to add an interface or interface role to the table, and fill in the BTF Enable Rules Editor or BTF Drop Rules Editor.

 
      		 [bookmark: pgfId-792684]Select an entry and click the  Edit Row button to edit an existing entry.

 
      		 [bookmark: pgfId-792686]Select an entry and click the  Delete Row button to delete it.

 
     

 
     [bookmark: pgfId-792688]Navigation Path

 
     [bookmark: pgfId-792693]From the Botnet Traffic Filter Rules Page, click the Traffic Classification tab.

 
     [bookmark: pgfId-792695]Related Topics

 
      
      		 [bookmark: pgfId-792700]BTF Enable Rules Editor

 
      		 [bookmark: pgfId-792705]BTF Drop Rules Editor

 
      		 [bookmark: pgfId-792710]Enabling Traffic Classification and Actions for the Botnet Traffic Filter

 
      		 [bookmark: pgfId-792715]Understanding Botnet Traffic Filtering

 
      		 [bookmark: pgfId-792720]Task Flow for Configuring the Botnet Traffic Filter

 
      		 [bookmark: pgfId-792725]Botnet Traffic Filter Rules Page

 
      		 [bookmark: pgfId-792730]Dynamic Blacklist Configuration Tab

 
      		 [bookmark: pgfId-792735]Whitelist/Blacklist Tab

 
      		 [bookmark: pgfId-792740]Device Whitelist or Device Blacklist Dialog Box

 
      		 [bookmark: pgfId-792745]Configure DNS Dialog Box

 
     

 
    
 
     
      [bookmark: pgfId-792757][bookmark: 54167][bookmark: fwlsvcpg_cncpt_BotnetTrafficClassificationDialogBox]BTF Enable Rules Editor[bookmark: marker-792753][bookmark: marker-792755]

 
     [bookmark: pgfId-792759]Use the BTF Enable Rules Editor to specify the interfaces on which you want to enable the Botnet Traffic Filter and to identify the traffic that you want to monitor. You can specify only one enable rule per interface.

 
     [bookmark: pgfId-792761]Navigation Path

 
     [bookmark: pgfId-792763]To access the BTF Enable Rules Editor, right-click inside the work area of the Enable Rules table on the Traffic Classification tab and then select Add Row, or right-click an existing entry and select Edit Row.

 
     [bookmark: pgfId-792765]Related Topics

 
      
      		 [bookmark: pgfId-792770]Enabling Traffic Classification and Actions for the Botnet Traffic Filter

 
      		 [bookmark: pgfId-792775]Understanding Botnet Traffic Filtering

 
      		 [bookmark: pgfId-792780]Task Flow for Configuring the Botnet Traffic Filter

 
      		 [bookmark: pgfId-792785]Botnet Traffic Filter Rules Page

 
      		 [bookmark: pgfId-792790]Dynamic Blacklist Configuration Tab

 
      		 [bookmark: pgfId-792795]Traffic Classification Tab

 
      		 [bookmark: pgfId-792800]BTF Drop Rules Editor

 
      		 [bookmark: pgfId-792805]Whitelist/Blacklist Tab

 
      		 [bookmark: pgfId-792810]Device Whitelist or Device Blacklist Dialog Box

 
      		 [bookmark: pgfId-792815]Configure DNS Dialog Box

 
     

 
     [bookmark: pgfId-792817]Field Reference

 
     [bookmark: pgfId-792820] 

 
      
       
        
        [bookmark: pgfId-791144]Table 19-2 [bookmark: 54217]BTF Enable Rules Editor 

 
        
       
         
         		
           
           [bookmark: pgfId-791150]Element
          
  
         		
           
           [bookmark: pgfId-791152]Description
          
  
        

 
         
         		[bookmark: pgfId-791158]Interfaces

  
         		[bookmark: pgfId-791160]The interfaces or interface roles on which you want to enable the Botnet Traffic Filter. Enter the name of the interface or the interface role, or click Select to select the interface or role from a list, or to create a new role. An interface must already be defined to appear on the list.

 [bookmark: pgfId-791162]You can use the All Interfaces role object to enable botnet filtering globally (selected by default). If you configure an interface-specific classification, the settings for that interface override the global settings.

 [bookmark: pgfId-791167]Interface role objects are replaced with the actual interface names when the configuration is generated for each device. See Understanding Interface Role Objects.

  
        

 
         
         		[bookmark: pgfId-791173]ACL

  
         		[bookmark: pgfId-791175]Specifies the access-list to use for identifying the traffic that you want to monitor. If you do not specify an access list, by default you monitor all traffic.

 [bookmark: pgfId-791180]To specify the traffic that you want to monitor, click Select to the right of the ACL field to select an Access Control List object that identifies the traffic that you want to monitor. For example, you might want to monitor all port 80 traffic on the outside interface. For more information about Access Control List objects, see Creating Access Control List Objects.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-792832][bookmark: 54245][bookmark: fwlsvcpg_cncpt_BotnetTrafficFilterDropRulesEditor]BTF Drop Rules Editor[bookmark: marker-792828][bookmark: marker-792830]

 
     [bookmark: pgfId-792834]Use the BTF Drop Rules Editor to identify malware traffic that you want to automatically drop. You can specify multiple drop rules per interface.

 
     [bookmark: pgfId-792836]Navigation Path

 
     [bookmark: pgfId-792838]To access the BTF Drop Rules Editor, right-click inside the work area of the Drop Rules table on the Traffic Classification tab and then select Add Row, or right-click an existing entry and select Edit Row.

 
     [bookmark: pgfId-792840]Related Topics

 
      
      		 [bookmark: pgfId-792845]Enabling Traffic Classification and Actions for the Botnet Traffic Filter

 
      		 [bookmark: pgfId-792850]Understanding Botnet Traffic Filtering

 
      		 [bookmark: pgfId-792855]Task Flow for Configuring the Botnet Traffic Filter

 
      		 [bookmark: pgfId-792860]Botnet Traffic Filter Rules Page

 
      		 [bookmark: pgfId-792865]Dynamic Blacklist Configuration Tab

 
      		 [bookmark: pgfId-792870]Traffic Classification Tab

 
      		 [bookmark: pgfId-792875]BTF Enable Rules Editor

 
      		 [bookmark: pgfId-792880]Whitelist/Blacklist Tab

 
      		 [bookmark: pgfId-792885]Device Whitelist or Device Blacklist Dialog Box

 
      		 [bookmark: pgfId-792890]Configure DNS Dialog Box

 
     

 
     [bookmark: pgfId-792892]Field Reference

 
     [bookmark: pgfId-792895] 

 
      
       
        
        [bookmark: pgfId-791193]Table 19-3 [bookmark: 54295]BTF Drop Rules Editor 

 
        
       
         
         		
           
           [bookmark: pgfId-791199]Element
          
  
         		
           
           [bookmark: pgfId-791201]Description
          
  
        

 
         
         		[bookmark: pgfId-791207]Interfaces

  
         		[bookmark: pgfId-791209]The interfaces or interface roles on which you want to enable the Botnet Traffic Filter. Enter the name of the interface or the interface role, or click Select to select the interface or role from a list, or to create a new role. An interface must already be defined to appear on the list.

 [bookmark: pgfId-791211]You can use the All Interfaces role object to enable botnet filtering globally (selected by default). If you configure an interface-specific classification, the settings for that interface override the global settings.

 [bookmark: pgfId-791216]Interface role objects are replaced with the actual interface names when the configuration is generated for each device. See Understanding Interface Role Objects.

  
        

 
         
         		[bookmark: pgfId-791222]ACL

  
         		[bookmark: pgfId-791224]Specifies the access-list to use for identifying the traffic that you want to monitor. If you do not specify an access list, by default you monitor all traffic.

 [bookmark: pgfId-791229]To specify the traffic that you want to monitor, click Select to the right of the ACL field to select an Access Control List object that identifies the traffic that you want to monitor. For example, you might want to monitor all port 80 traffic on the outside interface. For more information about Access Control List objects, see Creating Access Control List Objects.

  
        

 
         
         		[bookmark: pgfId-791235]Threat Level

  
         		[bookmark: pgfId-791237]The Threat Level fields identify the threat level of malicious traffic that you want dropped. The default level is a range between Moderate and Very High.

 [bookmark: pgfId-791239]Note We highly recommend using the default setting unless you have strong reasons for changing the setting.

 
           
           		 [bookmark: pgfId-791241]Value—Specify the threat level you want to drop.

 
          

 [bookmark: pgfId-791243] – Very-low

 [bookmark: pgfId-791245] – Low

 [bookmark: pgfId-791247] – Moderate

 [bookmark: pgfId-791249] – High

 [bookmark: pgfId-791251] – Very-high

 
           
           		 [bookmark: pgfId-791253]Range—Specify a range of threat levels.

 
          

 [bookmark: pgfId-791255]Note Static blacklist entries are always designated with a Very High threat level.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-792907][bookmark: 54347][bookmark: fwlsvcpg_cncpt_BotnetWhitelistBlacklistTab]Whitelist/Blacklist Tab[bookmark: marker-792903][bookmark: marker-792905]

 
     [bookmark: pgfId-792909]Use the Whitelist/Blacklist tab to view or to configure the static database entries for a device or shared policy. The Device Blacklist contains domain names or IP addresses of malicious or undesirable sites. You can use the static blacklist to supplement the Cisco dynamic database or you can use the static blacklist alone if you can identify all the malware sites that you want to target.

 
     [bookmark: pgfId-792911]The Device Whitelist contains domain names or IP addresses of sites that are deemed to be acceptable. If the dynamic database includes blacklisted addresses that you think should not be blacklisted, you can manually enter them into a static whitelist. Static whitelist entries take precedence over entries in the static blacklist and the Cisco dynamic database. Whitelisted addresses still generate syslog messages, but because you are only targeting blacklist syslog messages, they are informational.

 
     [bookmark: pgfId-792913]To configure the static database:

 
      
      		 [bookmark: pgfId-792918]Click the  Add Row button to define static database entries using the Device Whitelist or Device Blacklist Dialog Box.

 
      		 [bookmark: pgfId-792920]Select an entry and click the  Edit Row button to edit an existing entry.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-792922]Timesaver Select an entry and press F2 or double-click on an entry in the Device Whitelist or Device Blacklist to edit that entry in place.


     
      

     

     

 
      
      		 [bookmark: pgfId-792924]Select an entry and click the  Delete Row button to delete it.

 
     

 
     [bookmark: pgfId-792926]Navigation Path

 
     [bookmark: pgfId-792931]From the Botnet Traffic Filter Rules Page, click the Whitelist/Blacklist tab.

 
     [bookmark: pgfId-792933]Related Topics

 
      
      		 [bookmark: pgfId-792938]Adding Entries to the Static Database

 
      		 [bookmark: pgfId-792943]Understanding Botnet Traffic Filtering

 
      		 [bookmark: pgfId-792948]Task Flow for Configuring the Botnet Traffic Filter

 
      		 [bookmark: pgfId-792953]Device Whitelist or Device Blacklist Dialog Box

 
      		 [bookmark: pgfId-792958]Botnet Traffic Filter Rules Page

 
      		 [bookmark: pgfId-792963]Dynamic Blacklist Configuration Tab

 
      		 [bookmark: pgfId-792968]Traffic Classification Tab

 
     

 
    
 
     
      [bookmark: pgfId-792986][bookmark: 54400][bookmark: fwlsvcpg_cncpt_BotnetDeviceWhitelistBlacklistDialogBoxes]Device Whitelist or Device Blacklist Dialog Box[bookmark: marker-792978][bookmark: marker-792980][bookmark: marker-792982][bookmark: marker-792984]

 
     [bookmark: pgfId-792988]Use the Device Whitelist or Device Blacklist dialog box to manually define domain names or IP addresses that you want to add to the whitelisted (safe) or blacklisted (malicious) lists. You can use the static blacklist to supplement the Cisco dynamic database or you can use the static blacklist alone if you can identify all the malware sites that you want to target. Names or addresses that appear on both the whitelist and the dynamic blacklist are identified only as whitelist addresses in syslog messages and reports.

 
     [bookmark: pgfId-792990]Domain names can be complete (including the host name, such as www.cisco.com), or partial (such as cisco.com). For partial names, all web site hosts on that domain are either whitelisted or blacklisted. You can also enter host IP addresses. Use a comma or new line to separate multiple entries.

 
     [bookmark: pgfId-792992]Navigation Path

 
     [bookmark: pgfId-792997]From the Whitelist/Blacklist Tab, click the Add Rows button beneath the Device Whitelist or Device Blacklist tables, or select an entry and click the Edit Row button.

 
     [bookmark: pgfId-792999]Related Topics

 
      
      		 [bookmark: pgfId-793004]Adding Entries to the Static Database

 
      		 [bookmark: pgfId-793009]Understanding Botnet Traffic Filtering

 
      		 [bookmark: pgfId-793014]Task Flow for Configuring the Botnet Traffic Filter

 
      		 [bookmark: pgfId-793019]Botnet Traffic Filter Rules Page

 
      		 [bookmark: pgfId-793024]Dynamic Blacklist Configuration Tab

 
      		 [bookmark: pgfId-793029]Traffic Classification Tab

 
      		 [bookmark: pgfId-793034]BTF Enable Rules Editor

 
      		 [bookmark: pgfId-793039]BTF Drop Rules Editor

 
      		 [bookmark: pgfId-793044]Whitelist/Blacklist Tab

 
      		 [bookmark: pgfId-793049]Configure DNS Dialog Box
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     [bookmark: pgfId-599103][bookmark: 146562][bookmark: rtqos_intro_ConfiguringQOS]Configuring Quality of Service
      
      
 
     
 

 
    [bookmark: pgfId-599105]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-599110]Quality of Service on Cisco IOS Routers

 
     		 [bookmark: pgfId-599115]Quality of Service Policy Page

 
    

 
   
 
    
     [bookmark: pgfId-599127][bookmark: 146564][bookmark: rtchap_cncpt_QualityofServiceonCiscoIOSRouters]Quality of Service on Cisco IOS Routers[bookmark: marker-599121][bookmark: marker-599123][bookmark: marker-599125]

 
    [bookmark: pgfId-599129]Quality of service (QoS) refers to the ability of a network to provide priority service to selected network traffic over various underlying technologies, including Frame Relay, ATM, Ethernet and 802.1 networks, SONET, and IP-routed networks. QoS features enhance the predictability of network service by:

 
     
     		 [bookmark: pgfId-599131]Supporting dedicated bandwidth.

 
     		 [bookmark: pgfId-599133]Improving loss characteristics.

 
     		 [bookmark: pgfId-599135]Avoiding and managing network congestion.

 
     		 [bookmark: pgfId-599137]Shaping network traffic.

 
     		 [bookmark: pgfId-599139]Setting traffic priorities across the network.

 
    

 
    [bookmark: pgfId-599141]QoS is generally used at entry points to service providers, as well as at consolidation points where multiple lines converge. QoS is also useful where speed mismatches occur (for example, at the boundary between a WAN and a LAN), as these places are often traffic congestion points.

 
    [bookmark: pgfId-599143]QoS policies in Security Manager are based on the Cisco Systems Modular QoS CLI (MQC). MQC standardizes the CLI and semantics for QoS features across all platforms supported by Cisco IOS software, which provides a modular and highly extensible framework for deploying QoS. Security Manager provides an easy-to-use interface for MQC that concentrates key QoS features inside a single dialog box, streamlining the creation of QoS policies for selected traffic entering and leaving the router.

 
    [bookmark: pgfId-599148]For a description of the procedure for defining a QoS policy in Security Manager, see Defining QoS Policies.

 
    [bookmark: pgfId-599150]Related Topics

 
     
     		 [bookmark: pgfId-599155]Quality of Service and CEF

 
     		 [bookmark: pgfId-599160]Understanding Marking Parameters

 
     		 [bookmark: pgfId-599165]Understanding Queuing Parameters

 
     		 [bookmark: pgfId-599170]Understanding Policing and Shaping Parameters

 
    

 
     
      [bookmark: pgfId-599180][bookmark: 146606][bookmark: rtchap_cncpt_QualityofServiceandCEF]Quality of Service and CEF[bookmark: marker-599176][bookmark: marker-599178]

 
     [bookmark: pgfId-599182]Cisco Express Forwarding (CEF) is an advanced Layer 3 IP switching technology that optimizes network performance and scalability for all kinds of networks. It defines the fastest method by which a Cisco IOS router forwards packets from ingress to egress interfaces.

 
     [bookmark: pgfId-599184]Certain QoS features configurable in Security Manager, such as Class-Based Policing and Class-Based Weighted Random Early Detection, are supported only on routers that run CEF. All routers from the Cisco 800 Series to the Cisco 7200 Series require CEF for these QoS features; the Cisco 7500 Series requires distributed CEF (dCEF).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-599188]Note For a complete list, see When is CEF Required for Quality of Service on Cisco.com at this URL: http://www.cisco.com/en/US/tech/tk39/tk824/technologies_tech_note09186a0080094978.shtml


     
      

     

     

 
     [bookmark: pgfId-599193]By default, CEF is enabled as part of the router’s initial configuration. To verify whether CEF is enabled on your router, use the show ip cef command. You can configure CEF using the CEF interface settings policy (see CEF Interface Settings on Cisco IOS Routers). Be aware, however, that if your router does not have CEF enabled, activating CEF could have a significant impact on your router’s packet streaming. Consult your router documentation before enabling CEF.

 
     [bookmark: pgfId-599195]Related Topics

 
      
      		 [bookmark: pgfId-599200]Quality of Service on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-599208][bookmark: 146629][bookmark: rtchap_cncpt_UnderstandingMatchingParameters]Understanding Matching Parameters[bookmark: marker-599206]

 
     [bookmark: pgfId-599210]You define matching parameters by identifying the traffic on which QoS is performed, that is, classifying the interesting packets. Various classification tools are available, including protocol type, IP precedence (IPP) value, Differentiated Service Code Point (DSCP) value, and ACLs.

 
     [bookmark: pgfId-599212]Traffic classes consist of a series of match criteria and a means of evaluating these criteria. For example, you might define a class with matching criteria based on several specified protocols and a DSCP value. You can then specify that a packet must match only one of these defined criteria to be considered part of this class. Your other option is to specify that packets must match all defined criteria considered part of the traffic class.

 
     [bookmark: pgfId-599214]Packets that are members of a defined traffic class are forwarded according to the QoS specifications that you defined in the policy map. Packets that fail to meet any of the matching criteria are classified as members of the default traffic class.

 
     [bookmark: pgfId-599219]For information about defining matching parameters in a QoS policy, see Defining QoS Class Matching Parameters.

 
     [bookmark: pgfId-599221]Related Topics

 
      
      		 [bookmark: pgfId-599226]Defining QoS Policies

 
      		 [bookmark: pgfId-599231]Quality of Service on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-599239][bookmark: 146650][bookmark: rtchap_cncpt_UnderstandingMarkingParameters]Understanding Marking Parameters[bookmark: marker-599237]

 
     [bookmark: pgfId-599241]Marking parameters enable you to classify packets, which entails using a traffic descriptor to categorize a packet within a specific group. This defines the packet and makes it accessible for QoS handling on the network. Both traffic policers and traffic shapers use the packet classification to ensure adherence to the contracted level of service agreed upon between the source and your network. Additionally, marking parameters enable you to take packets that might have arrived at the device with one QoS classification and reclassify them. Downstream devices use this new classification to identify the packets and apply the appropriate QoS functions to them.

 
     [bookmark: pgfId-599246]Security Manager uses two types of marking for IPv4 packets—one based on IPP classes and one based on DSCP values. IPP is based on the three most significant bits in the Type of Service (ToS) byte of each packet, which means you can partition traffic into eight classes. For historical reasons, each precedence value corresponds with a name, as defined in RFC 791. Table 65-1 lists the numbers and their corresponding names, from least to most important.

 
     [bookmark: pgfId-599249] 

 
      
       
        
        [bookmark: pgfId-597591]Table 65-1 [bookmark: 146660]IP Precedence Classes 

 
        
       
         
         		
           
           [bookmark: pgfId-597597]Class
          
  
         		
           
           [bookmark: pgfId-597599]Name
          
  
        

 
         
         		[bookmark: pgfId-597605]0

  
         		[bookmark: pgfId-597607]routine

  
        

 
         
         		[bookmark: pgfId-597613]1

  
         		[bookmark: pgfId-597615]priority

  
        

 
         
         		[bookmark: pgfId-597621]2

  
         		[bookmark: pgfId-597623]immediate

  
        

 
         
         		[bookmark: pgfId-597629]3

  
         		[bookmark: pgfId-597631]flash

  
        

 
         
         		[bookmark: pgfId-597637]4

  
         		[bookmark: pgfId-597639]flash-override

  
        

 
         
         		[bookmark: pgfId-597645]5

  
         		[bookmark: pgfId-597647]critical

  
        

 
         
         		[bookmark: pgfId-597653]6

  
         		[bookmark: pgfId-597655]internet

  
        

 
         
         		[bookmark: pgfId-597661]7

  
         		[bookmark: pgfId-597663]network
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     [bookmark: pgfId-599251]Note Classes 6 and 7 are generally reserved for network control information, such as routing updates.


     
      

     

     

 
     [bookmark: pgfId-599253]DSCP is based on the six most significant bits in the ToS byte (the remaining two bits are used for flow control), with values ranging from 0 to 63. The DSCP bits contains the IPP bits, which makes DSCP backward-compatible with IPP.

 
     [bookmark: pgfId-599255]Marking is generally used on devices that are close to the network edge or administrative domain so that subsequent devices can provide service based on the classification mark.

 
     [bookmark: pgfId-599260]For information about defining marking parameters in a QoS policy, see Defining QoS Class Marking Parameters.

 
     [bookmark: pgfId-599262]Related Topics

 
      
      		 [bookmark: pgfId-599267]Understanding Queuing Parameters

 
      		 [bookmark: pgfId-599272]Understanding Policing and Shaping Parameters

 
      		 [bookmark: pgfId-599277]Defining QoS Policies

 
      		 [bookmark: pgfId-599282]Quality of Service on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-599292][bookmark: 146731][bookmark: rtchap_cncpt_UnderstandingQueuingParameters]Understanding Queuing Parameters[bookmark: marker-599288][bookmark: marker-599290]

 
     [bookmark: pgfId-599294]Queuing manages congestion on traffic leaving a Cisco IOS router by determining the order in which to send packets out over an interface, based on priorities you assign to those packets. Queuing makes it possible to prioritize traffic to satisfy time-critical applications, such as desktop video conferencing, while still addressing the needs of less time-dependent applications, such as file transfer.

 
     [bookmark: pgfId-599296]During periods of light traffic, that is, when no congestion exists, packets are sent out as soon as they arrive at an interface. However, during periods of transmission congestion at the outgoing interface, packets arrive faster than the interface can send them. By using congestion management features such as queuing, packets accumulating at the interface are queued until the interface is free to send them. They are then scheduled for transmission according to their assigned priority and the queuing mechanism configured for the interface. The router determines the order of packet transmission by controlling which packets are placed in which queue and how queues are serviced with respect to one another.

 
     [bookmark: pgfId-599298]Security Manager uses a form of queuing called Class-Based Weighted Fair Queuing (CBWFQ). With CBWFQ, you define traffic classes based on match criteria. Packets matching the criteria constitute the traffic for this class. A queue is reserved for each class, containing the traffic belonging to that class. You assign characteristics to queues, such as the bandwidth (fixed or minimum) assigned to it and the queue limit, which is the maximum number of packets allowed to accumulate in the queue.

 
     [bookmark: pgfId-599300]When you use CBWFQ, the sum of all bandwidth allocation on an interface cannot exceed 75 percent of the total available interface bandwidth. The remaining 25 percent is used for other overhead, including Layer 2 overhead, routing traffic, and best-effort traffic. Bandwidth for the CBWFQ default class, for instance, is taken from the remaining 25 percent.

 
     [bookmark: pgfId-599302]For more information about queuing, see:

 
      
      		 [bookmark: pgfId-599307]Tail Drop vs. WRED

 
      		 [bookmark: pgfId-599312]Low-Latency Queuing

 
      		 [bookmark: pgfId-599317]Default Class Queuing

 
     

 
     [bookmark: pgfId-599322]For information about defining queuing parameters in a QoS policy, see Defining QoS Class Queuing Parameters.

 
     [bookmark: pgfId-599324]Related Topics

 
      
      		 [bookmark: pgfId-599329]Understanding Marking Parameters

 
      		 [bookmark: pgfId-599334]Understanding Policing and Shaping Parameters

 
      		 [bookmark: pgfId-599339]Defining QoS Policies

 
      		 [bookmark: pgfId-599344]Quality of Service on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-599356][bookmark: 146772][bookmark: rtchap_cncpt_TailDropvsWRED]Tail Drop vs. WRED[bookmark: marker-599350][bookmark: marker-599352][bookmark: marker-599354]

 
     [bookmark: pgfId-599358]After a queue reaches its configured queue limit, the arrival of additional packets causes tail drop or packet drop to take effect, depending on how you configured the QoS policy. Tail drop, which is the default response, treats all traffic equally and does not differentiate between different classes of service. When tail drop is in effect, packets are dropped from full queues until the congestion is eliminated and the queue is no longer full. This often leads to global synchronization, in which a period of congestion is followed by a period of underutilization, as multiple TCP hosts reduce their transmission rates simultaneously.

 
     [bookmark: pgfId-599363]A more sophisticated approach to managing queue congestion is offered by Cisco’s implementation of Random Early Detection, called Weighted Random Early Detection, or WRED. As shown in Figure 65-1, WRED reduces the chances of tail drop by selectively dropping packets when the output interface begins to show signs of congestion. By dropping some packets early instead of waiting until the queue is full, WRED avoids dropping large numbers of packets at once and allows the transmission line to be used fully at all times.

 
     [bookmark: pgfId-599367]Figure 65-1 [bookmark: 146786]Weighted Random Early Detection

 
     [bookmark: pgfId-599370] 
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     [bookmark: pgfId-599372]WRED is useful only when the bulk of the traffic is TCP/IP traffic, because TCP hosts reduce their transmission rate in response to congestion. With other protocols, packet sources might not respond, or might resend dropped packets at the same rate. As a result, dropping packets does not decrease congestion.
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     [bookmark: pgfId-599374]Note WRED treats non-IP traffic as precedence 0, the lowest precedence value. Therefore, non-IP traffic is more likely to be dropped than IP traffic.


     
      

     

     

 
     [bookmark: pgfId-599376]Related Topics

 
      
      		 [bookmark: pgfId-599381]Low-Latency Queuing

 
      		 [bookmark: pgfId-599386]Default Class Queuing

 
      		 [bookmark: pgfId-599391]Understanding Queuing Parameters

 
     

 
    
 
     
      [bookmark: pgfId-599403][bookmark: 146804][bookmark: rtchap_cncpt_LowLatencyQueuing]Low-Latency Queuing[bookmark: marker-599397][bookmark: marker-599399][bookmark: marker-599401]

 
     [bookmark: pgfId-599405]The low-latency queuing (LLQ) feature brings strict priority queuing to CBWFQ. Strict priority queuing gives delay-sensitive data, such as voice traffic, preference over other traffic.
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     [bookmark: pgfId-599407]Note Although it is possible to assign various types of real-time traffic to the strict priority queue, we strongly recommend that you direct only voice traffic to it.


     
      

     

     

 
     [bookmark: pgfId-599409]LLQ defines the maximum bandwidth that you can allocate to priority traffic during times of congestion. Setting a maximum ensures that nonpriority traffic does not starve (meaning that this traffic is also provided with bandwidth). When the device is not congested, the priority class traffic is allowed to exceed its allocated bandwidth. Policing drops packets from the priority queue; therefore, neither WRED nor tail drop (as configured in the Queue Limit field) is used.

 
     [bookmark: pgfId-599411]When LLQ is not used, CBWFQ provides weighted fair queuing based on defined classes, with no strict priority queue available for real-time traffic.

 
     [bookmark: pgfId-599413]Related Topics

 
      
      		 [bookmark: pgfId-599418]Tail Drop vs. WRED

 
      		 [bookmark: pgfId-599423]Default Class Queuing

 
      		 [bookmark: pgfId-599428]Understanding Queuing Parameters

 
     

 
    
 
     
      [bookmark: pgfId-599438][bookmark: 146832][bookmark: rtchap_cncpt_DefaultClassQueuing]Default Class Queuing[bookmark: marker-599434][bookmark: marker-599436]

 
     [bookmark: pgfId-599440]You use the Fair Queue field to define the number of dynamic queues that should be reserved for the default class to use. This is the class to which traffic that does not satisfy the match criteria of other classes is directed. By default, the number of queues that are created is based on the interface bandwidth.

 
     [bookmark: pgfId-599445]Table 65-2 lists the default number of dynamic queues that CBWFQ uses when it is enabled on an interface:

 
     [bookmark: pgfId-599448] 

 
      
       
        
        [bookmark: pgfId-597676]Table 65-2 [bookmark: 146845]Default Number of Queues for Default Class 

 
        
       
         
         		
           
           [bookmark: pgfId-597682]Bandwidth Range
          
  
         		
           
           [bookmark: pgfId-597684]Number of Dynamic Queues
          
  
        

 
         
         		[bookmark: pgfId-597690]Less than or equal to 64 kbps

  
         		[bookmark: pgfId-597692]16

  
        

 
         
         		[bookmark: pgfId-597698]More than 64 kbps and less than or equal to 128 kbps

  
         		[bookmark: pgfId-597700]32

  
        

 
         
         		[bookmark: pgfId-597706]More than 128 kbps and less than or equal to 256 kbps

  
         		[bookmark: pgfId-597708]64

  
        

 
         
         		[bookmark: pgfId-597714]More than 256 kbps and less than or equal to 512 kbps

  
         		[bookmark: pgfId-597716]128

  
        

 
         
         		[bookmark: pgfId-597722]More than 512 kbps

  
         		[bookmark: pgfId-597724]256

  
        

 
       
      

 
     
 
     [bookmark: pgfId-599450]Related Topics

 
      
      		 [bookmark: pgfId-599455]Tail Drop vs. WRED

 
      		 [bookmark: pgfId-599460]Low-Latency Queuing

 
      		 [bookmark: pgfId-599465]Understanding Queuing Parameters

 
     

 
    
 
     
      [bookmark: pgfId-599475][bookmark: 146894][bookmark: rtchap_cncpt_UnderstandingPolicingandShapingParameters]Understanding Policing and Shaping Parameters[bookmark: marker-599471][bookmark: marker-599473]

 
     [bookmark: pgfId-599477]Security Manager offers two kinds of traffic regulation mechanisms:

 
      
      		 [bookmark: pgfId-599484][bookmark: marker-599479] The rate-limiting feature of Class-Based Policing for policing traffic. Policing limits traffic flow to a configured rate. Policing can be performed on a selected interface or on the control plane. See Understanding Control Plane Policing.

 
      		 [bookmark: pgfId-599488][bookmark: marker-599486] Distributed Traffic Shaping (DTS) for shaping traffic. Traffic shaping enables you to control the traffic leaving an interface (output traffic) in order to match its flow to the speed of the remote target interface and to ensure that the traffic conforms to the policies defined for it. By shaping traffic to meet downstream requirements, you can eliminate bottlenecks in topologies with data-rate mismatches. Shaping can either be performed on selected QoS classes or at the interface level (hierarchical shaping).

 
     

 
     [bookmark: pgfId-599496]Both policing and shaping mechanisms use the traffic descriptor for a packet—indicated by the classification of the packet (see Understanding Marking Parameters)—to ensure adherence to the agreed upon level of service. Although policers and shapers usually identify traffic descriptor violations in the same way, they differ in the way they respond to violations, as shown in Figure 65-2:

 
      
      		 [bookmark: pgfId-599498]A policer typically drops excess traffic. In other cases, it transmits the traffic with a different (usually lower) priority.

 
      		 [bookmark: pgfId-599500]A shaper typically delays excess traffic using a buffer, or queuing mechanism, to hold packets and shape the flow when the data rate of the source is higher than expected.

 
     

 
     [bookmark: pgfId-599504]Figure 65-2 [bookmark: 146923]Traffic Policing vs. Traffic Shaping

 
     [bookmark: pgfId-599507] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-599515]For information about defining policing and shaping parameters in a QoS policy, see Defining QoS Class Policing Parameters and Defining QoS Class Shaping Parameters.

 
     [bookmark: pgfId-599517]Related Topics

 
      
      		 [bookmark: pgfId-599522]Understanding the Token-Bucket Mechanism

 
      		 [bookmark: pgfId-599527]Understanding Marking Parameters

 
      		 [bookmark: pgfId-599532]Understanding Queuing Parameters

 
      		 [bookmark: pgfId-599537]Defining QoS Policies

 
      		 [bookmark: pgfId-599542]Quality of Service on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-599550][bookmark: 146947][bookmark: rtchap_cncpt_UnderstandingtheTokenBucketMechanism]Understanding the Token-Bucket Mechanism[bookmark: marker-599548]

 
     [bookmark: pgfId-599552]Both policing and shaping use a token-bucket mechanism to regulate data flow. A token bucket is a formal definition of a rate of transfer. It has three components: a burst size, a mean rate, and a time interval (Tc). Any two values may be derived from the third using this formula:

 
     [bookmark: pgfId-599554]mean rate = burst size / time interval

 
     [bookmark: pgfId-599556]These terms are defined as follows:

 
      
      		 [bookmark: pgfId-599558]Mean rate—Also called the committed information rate (CIR), it specifies how much data can be sent or forwarded per unit time on average. The CIR is defined either as an absolute value or as a percentage of the available bandwidth on the interface. When defined as a percentage, the equivalent value in bits per second (bps) is calculated after deployment based on the interface bandwidth and the percent value defined in the policy.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-599560]Note If the interface bandwidth changes (for example, more bandwidth is added), the bps value of the CIR is recalculated based on the revised amount of bandwidth.


     
      

     

     

 
      
      		 [bookmark: pgfId-599562]Burst size—Also called the committed burst (Bc) size, it specifies for each burst how much data can be sent within a given time without creating scheduling concerns. When you use percentages to calculate the CIR, burst size is measured in milliseconds.

 
      		 [bookmark: pgfId-599564]Time interval—Also called the measurement interval, it specifies the amount of time in seconds per burst. Over any integral multiple of this interval, the bit rate of the interface does not exceed the mean rate. The bit rate, however, might be arbitrarily fast within the interval.

 
     

 
     [bookmark: pgfId-599566]In the token-bucket metaphor, tokens are put into the bucket at a certain rate. These tokens represent permission for the source to send a certain number of bits into the network. To send a packet, the regulator (policer or shaper) must remove a number of tokens from the bucket that equals the packet size.

 
     [bookmark: pgfId-599571]Security Manager uses a two-bucket algorithm, as shown in Figure 65-3. The first bucket is the conform bucket and the second bucket is the exceed bucket. The full size of the conform bucket is the number of bytes specified as the normal burst size. The full size of the exceed bucket is the number of bytes specified in the maximum burst size. Both buckets are initially full, and they are updated based on the token arrival rate, which is determined by the CIR. If the number of bytes in the arriving packet is less than the number of bytes in the conform bucket, the packet conforms. The required number of tokens are removed from the conform bucket and the defined conform action is taken (for example, the packet is transmitted). The exceed bucket is unaffected.

 
     [bookmark: pgfId-599573]If the conform bucket does not contain sufficient tokens, the excess token bucket is checked against the number of bytes in the packet. If enough tokens are present in the two buckets combined, the exceed action is taken on the packet and the required number of bytes are removed from each bucket. If the exceed bucket contains an insufficient number of bytes, the packet is in violation of the burst limits and the violate action is taken on the packet.

 
     [bookmark: pgfId-599577]Figure 65-3 [bookmark: 146968]Two-Token Bucket Algorithm

 
     [bookmark: pgfId-599580] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-599582]When you use traffic policing, the token-bucket algorithm provides three actions for each packet: a conform action, an exceed action, and an optional violate action. For instance, packets that conform can be configured to be transmitted, packets that exceed can be configured to be sent with a decreased priority, and packets that violate can be configured to be dropped.

 
     [bookmark: pgfId-599584]Traffic policing is often configured on interfaces at the edge of a network to limit the rate of traffic entering or leaving the network. In the most common traffic policing configurations, traffic that conforms is transmitted and traffic that exceeds is sent with a decreased priority or is dropped. You can change these configuration options to suit your network needs.

 
     [bookmark: pgfId-599586]When you use traffic shaping, the token-bucket mechanism includes a data buffer for holding packets that cannot be sent immediately. (Policers do not have such a buffer.) The token buckets permit packets to be sent in bursts, but places bounds on this capability so that the flow is never faster than the capacity of the buckets plus the time interval multiplied by the refill rate. The buffer also guarantees that the long-term transmission rate does not exceed the CIR.

 
     [bookmark: pgfId-599588]Related Topics

 
      
      		 [bookmark: pgfId-599593]Understanding Control Plane Policing

 
      		 [bookmark: pgfId-599598]Understanding Policing and Shaping Parameters

 
     

 
    
 
     
      [bookmark: pgfId-599610][bookmark: 146984][bookmark: rtchap_cncpt_UnderstandingControlPlanePolicing]Understanding Control Plane Policing[bookmark: marker-599604][bookmark: marker-599606][bookmark: marker-599608]

 
     [bookmark: pgfId-599612]The Control Plane Policing feature enables you to manage input traffic entering the control plane (CP) of the router. The CP is a collection of processes that run at the process level on the route processor. These processes collectively provide high-level control for most Cisco IOS functions. Control plane policing protects the CP of Cisco IOS routers and switches against reconnaissance and denial-of-service (DoS) attacks, enabling the CP to maintain packet forwarding and protocol states despite an attack or heavy traffic load on the router or switch.

 
     [bookmark: pgfId-599614]The Control Plane Policing feature treats the CP as a separate entity with its own ingress (input) and egress (output) ports, enabling you to use Security Manager to configure QoS policies on input. These policies are applied when a packet enters the CP. You can configure a QoS policy to prevent unwanted packets from progressing after a specified rate limit is reached. For example, a system administrator can limit all TCP/SYN packets that are destined for the CP to a maximum rate of 1 megabit per second. Additional packets beyond this limit are silently discarded.

 
     [bookmark: pgfId-599616]The following types of Layer 3 packets are forwarded to the CP and processed by aggregate control plane policing:

 
      
      		 [bookmark: pgfId-599618]Routing protocol control packets

 
      		 [bookmark: pgfId-599620]Packets destined for the local IP address of the router

 
      		 [bookmark: pgfId-599622]Packets from management protocols, such as SNMP, Telnet, and secure shell (SSH).

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-599624]Note Support for output policing is available only in Cisco IOS Release 12.3(4)T and later T-train releases.


     
      

     

     

 
     [bookmark: pgfId-599629]For information about how to define Control Plane Policing, see Defining QoS on the Control Plane. For more information about this feature, refer to the document, Control Plane Policing on Cisco.com at this URL:

 
     [bookmark: pgfId-599633]http://www.cisco.com/en/US/docs/ios/qos/configuration/guide/ctrl_plane_policng.html

 
     [bookmark: pgfId-599635]Related Topics

 
      
      		 [bookmark: pgfId-599640]Understanding the Token-Bucket Mechanism

 
      		 [bookmark: pgfId-599645]Understanding Policing and Shaping Parameters

 
     

 
    
 
     
      [bookmark: pgfId-599653][bookmark: 147022][bookmark: rtchap_cncpt_DefiningQoSPolicies]Defining QoS Policies[bookmark: marker-599651]

 
     [bookmark: pgfId-599655]When you define QoS policies, you must first decide whether to configure the policy on specific interfaces or on the control plane. This initial choice determines how you configure the rest of the policy, as described in the following topics:

 
      
      		 [bookmark: pgfId-599660]Defining QoS on Interfaces

 
      		 [bookmark: pgfId-599665]Defining QoS on the Control Plane
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     [bookmark: pgfId-599667]Note If you define a QoS policy on both the interfaces and the control plane of the same device, only the control plane configuration is deployed.


     
      

     

     

 
     [bookmark: pgfId-599669]Related Topics

 
      
      		 [bookmark: pgfId-599674]Quality of Service on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-599682][bookmark: 147042][bookmark: rtchap_proc_DefiningQoSonInterfaces]Defining QoS on Interfaces[bookmark: marker-599680]

 
     [bookmark: pgfId-599684]You can create multiple QoS interface definitions, each of which applies to either input traffic (entering the router) or output traffic (exiting the router).

 
     [bookmark: pgfId-599686]When you create a QoS interface definition on output traffic, you have the option of configuring hierarchical shaping on the interface as a whole instead of configuring shaping on individual QoS classes.

 
     [bookmark: pgfId-599688]After you create your interface definitions, you must define one or more QoS classes on each interface. QoS classes contain the matching criteria that determine which packets are included in the class and the QoS functions (marking, queuing, policing, and shaping) to apply to that traffic. You can configure each interface (or interface role) with up to 16 QoS classes, each containing its own set of matching criteria and a defined set of QoS functions to apply to the traffic in that class.

 
     [bookmark: pgfId-599690]For each interface, we recommend that for each interface you define at least one QoS class and a default class. If you do not configure a default class, packets that do not match the criteria of the other defined classes are treated as members of a default class that has no configured QoS functionality. Packets assigned to this class are placed in a simple first-in first-out (FIFO) queue, and are forwarded at a rate determined by the available underlying link bandwidth. This FIFO queue is managed by tail drop, which avoids congestion by dropping packets from the queue until it is no longer full.
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     [bookmark: pgfId-599692]Note QoS is applied to packets on a first-match basis. The router examines the table of QoS classes starting from the top and applies the properties of the first class whose matching criteria matches the packet. Therefore, it is important that you define and order your classes carefully. The default class should be placed last to prevent traffic that matches a specific class from being treated as unmatched traffic.


     
      

     

     

 
     [bookmark: pgfId-599694]Before You Begin

 
     [bookmark: pgfId-599699]Ensure that Cisco Express Forwarding (CEF) is enabled on the router. For more information, see CEF Interface Settings on Cisco IOS Routers.

 
     [bookmark: pgfId-599701]Related Topics

 
      
      		 [bookmark: pgfId-599706]Defining QoS Policies

 
      		 [bookmark: pgfId-599711]Defining QoS on the Control Plane

 
      		 [bookmark: pgfId-599716]Quality of Service on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-599718]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-599720](Device view) Select  Platform > Quality of Service from the Policy selector.

 
      		 [bookmark: pgfId-599722](Policy view) Select  Router Platform > Quality of Service from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-599727]The Quality of Service page is displayed. See Table 65-3 for a description of the fields on this page.

 
     [bookmark: pgfId-599729]Step 2 In the Applied to field, select Interfaces to define QoS parameters for specific interfaces on the selected router.

 
     [bookmark: pgfId-599736]Step 3 [bookmark: 147083]Click the Add button under the upper table to display the QoS Policy dialog box. See Table 65-4 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-599738]Step 4 In the Interface field, enter the name of an interface or interface role, or click Select to display a selector.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-599743]Tip If the interface role you want is not listed in the selector, click the Create button or the Edit button to open the Interface Role Dialog Box. From here you can define an interface role to use in the policy.


     
      

     

     

 
     [bookmark: pgfId-599745]Step 5 Select the traffic direction on which you want to apply the QoS definition, Output (traffic exiting the interface) or Input (traffic entering the interface). Queuing and shaping can be applied only to output traffic.

 
     [bookmark: pgfId-599750]Step 6 (Optional) Define interface-level (hierarchical) shaping parameters. See Table 65-4 for details.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-599755]Note When you enable hierarchical shaping on an interface, you cannot define shaping parameters for specific QoS classes. Shaping can be used only on output traffic. See Understanding Policing and Shaping Parameters for more information about shaping.


     
      

     

     

 
     [bookmark: pgfId-599757]Step 7 Click OK. The QoS interface definition is displayed in the upper table of the Quality of Service page.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-599759]Note To edit a QoS interface definition, select an interface from the upper table, then click the Edit button. To remove an interface definition, select it from the table, then click the Delete button. You cannot delete an interface that has defined classes.


     
      

     

     

 
     [bookmark: pgfId-599766]Step 8 [bookmark: 147107]With the interface selected in the upper table, click the Add button beneath the QoS Classes table. The QoS Class dialog box is displayed. See Table 65-5 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-599768]The QoS Class dialog box enables you to determine which traffic over the selected interface is included in the QoS class and how to handle that traffic.

 
     [bookmark: pgfId-599770]Step 9 (Optional) Select the Default class check box if you are defining the properties of the default QoS class for this interface. The default class is assigned to all traffic that does not match the criteria of the other defined classes.

 
     [bookmark: pgfId-599774]Step 10 [bookmark: 147115]Define the QoS class using one or more tabs in the QoS Class dialog box, as described in:

 
      
      		 [bookmark: pgfId-599779]Defining QoS Class Matching Parameters

 
      		 [bookmark: pgfId-599784]Defining QoS Class Marking Parameters

 
      		 [bookmark: pgfId-599789]Defining QoS Class Queuing Parameters

 
      		 [bookmark: pgfId-599794]Defining QoS Class Policing Parameters

 
      		 [bookmark: pgfId-599799]Defining QoS Class Shaping Parameters

 
     

 
     [bookmark: pgfId-599812]Step 11 [bookmark: 147133]Repeat Step 8 through Step 10 to add QoS classes to the interface defined in Step 3. If required, use the Up Row and Down Row buttons to reorder the classes.
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     [bookmark: pgfId-599814]Note To edit a QoS class, select the relevant interface from the upper table to display its defined classes in the QoS Class table. Select the class to edit, then click the Edit button. To remove a class, select it from the table, then click the Delete button.


     
      

     

     

 
     [bookmark: pgfId-599822]Step 12 Repeat Step 3 through Step 11 to define QoS classes for a different interface on the selected router.

 
     [bookmark: pgfId-599824]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-599834][bookmark: 147150][bookmark: rtchap_proc_DefiningQoSontheControlPlane]Defining QoS on the Control Plane[bookmark: marker-599830][bookmark: marker-599832]

 
     [bookmark: pgfId-599839]When you configure QoS on input traffic entering the control plane, you can define multiple QoS classes, including a default class for traffic that does not match the criteria you define for the other classes. After defining the matching criteria for a particular class, you can configure a policing definition for that class. (Marking, queuing, and shaping are not available.) For more information, see Understanding Control Plane Policing.

 
     [bookmark: pgfId-599841]QoS policies defined on the control plane override any QoS parameters defined on an interface of the same device.
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     [bookmark: pgfId-599843]Note QoS is applied to packets on a first-match basis. The router examines the table of QoS classes starting from the top and applies the properties of the first class whose matching criteria matches the packet. Therefore, it is important that you define and order your classes carefully. The default class should be placed last to prevent traffic that matches a specific class from being treated as unmatched traffic.


     
      

     

     

 
     [bookmark: pgfId-599845]Before You Begin

 
     [bookmark: pgfId-599850]Ensure that Cisco Express Forwarding (CEF) is enabled on the router. For more information, see CEF Interface Settings on Cisco IOS Routers.

 
     [bookmark: pgfId-599852]Related Topics

 
      
      		 [bookmark: pgfId-599857]Defining QoS Policies

 
      		 [bookmark: pgfId-599862]Defining QoS on Interfaces

 
      		 [bookmark: pgfId-599867]Quality of Service on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-599869]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-599871](Device view) Select  Platform > Quality of Service from the Policy selector.

 
      		 [bookmark: pgfId-599873](Policy view) Select  Router Platform > Quality of Service from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-599878]The Quality of Service page is displayed. See Table 65-3 for a description of the fields on this page.

 
     [bookmark: pgfId-599880]Step 2 In the Applied to field, select Control Plane to define QoS policing on input traffic entering the control plane.

 
     [bookmark: pgfId-599887]Step 3 [bookmark: 147193]Click the Add button beneath the Control Plane QoS Classes table. The QoS Class dialog box is displayed. See Table 65-5 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-599889]The QoS Class dialog box enables you to determine which traffic over the selected interface is included in the QoS class and how to handle that traffic.

 
     [bookmark: pgfId-599891]Step 4 (Optional) Select the Default class check box if you are defining the properties of the default QoS class for the control plane. The default class is assigned to all traffic that does not match the criteria of the other defined classes.

 
     [bookmark: pgfId-599895]Step 5 [bookmark: 147201]Define the QoS class using the tabs in the QoS Class dialog box, as described in the following sections:

 
      
      		 [bookmark: pgfId-599900]Defining QoS Class Matching Parameters

 
      		 [bookmark: pgfId-599905]Defining QoS Class Policing Parameters

 
     

 
     [bookmark: pgfId-599915]Step 6 [bookmark: 147210]Repeat Step 3 through Step 5 to add QoS classes to the control plane. If required, use the Up Row and Down Row buttons to reorder the classes.

 
     [bookmark: pgfId-599917]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-599925][bookmark: 147219][bookmark: rtchap_proc_DefiningQoSClassMatchingParameters]Defining QoS Class Matching Parameters[bookmark: marker-599923]

 
     [bookmark: pgfId-599930]When you define matching parameters, you must define matching criteria and specify whether packets must meet one or all of the criteria to be considered part of the class. See Understanding Matching Parameters for more information.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-599932]Note You do not define matching parameters when configuring the default class.


     
      

     

     

 
     [bookmark: pgfId-599934]Related Topics

 
      
      		 [bookmark: pgfId-599939]Defining QoS Class Marking Parameters

 
      		 [bookmark: pgfId-599944]Defining QoS Class Queuing Parameters

 
      		 [bookmark: pgfId-599949]Defining QoS Class Policing Parameters

 
      		 [bookmark: pgfId-599954]Defining QoS Class Shaping Parameters

 
      		 [bookmark: pgfId-599959]Defining QoS Policies

 
      		 [bookmark: pgfId-599964]Quality of Service on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-599966]Step 1 On the Quality of Service page, click the Add button beneath the QoS Classes table, or select a class and then click the Edit button. The QoS Class dialog box is displayed.

 
     [bookmark: pgfId-599971]Step 2 Click the Matching tab. See Table 65-6 for a description of the fields on this tab.

 
     [bookmark: pgfId-599973]Step 3 Select a matching method:

 
      
      		 [bookmark: pgfId-599975]Any—Traffic matching any of the defined parameters is included in this class.

 
      		 [bookmark: pgfId-599977]All—Only traffic matching all of the defined parameters is included in this class.

 
     

 
     [bookmark: pgfId-599979]Step 4 (Optional) Under Protocol, click Add to display a selector for choosing the protocols to include in this class. Select one or more items from the Available Protocols list, then click >> to add them to the Selected Protocols list.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-599981]Note When configuring QoS on the control plane, only the ARP protocol can be selected.


     
      

     

     

 
     [bookmark: pgfId-599983]When you finish, click OK to save your definitions and return to the QoS Class dialog box. Your selections are displayed in the Protocol field.

 
     [bookmark: pgfId-599985]Step 5 (Optional) Under Precedence, click Add to display a selector for choosing which IP precedence values (from 0 to 7) to include in this class. Select one or more items from the Available Precedences list, then click >> to add them to the Selected Precedences list. Traffic that arrives marked with one of these values matches this criterion.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-599990]Note For more information about IP precedence values, see Table 65-1.


     
      

     

     

 
     [bookmark: pgfId-599992]When you finish, click OK to save your definitions and return to the QoS Class dialog box. Your selections are displayed in the Precedences field.

 
     [bookmark: pgfId-599994]Step 6 (Optional) Under DSCP, click Add to display a selector for choosing which DSCP values (from 0 to 63) to include in this class. Select one or more items (up to eight) from the Available DSCPs list, then click >> to add them to the Selected DSCPs list. Traffic that arrives marked with one of these values matches this criterion.

 
     [bookmark: pgfId-599996]When you finish, click OK to save your definitions and return to the QoS Class dialog box. Your selections are displayed in the DSCP field.

 
     [bookmark: pgfId-599998]Step 7 (Optional) Under ACL, define ACLs as part of the matching criteria for this class:

 
     [bookmark: pgfId-600000] a. Click Edit to display the Edit ACLs dialog box. Use this dialog box to define which ACLs to include in this class.

 
     [bookmark: pgfId-600002] b. Enter one or more ACLs, or click Select to select an ACL object from a list or to create a new one. Traffic that matches these ACL definitions matches this criterion.

 
     [bookmark: pgfId-600004] c. When you finish, click OK twice to save your definitions and return to the QoS Class dialog box. Your selections are displayed in the ACL field.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-600006]Tip Use the up and down arrows to order the ACLs. We recommend placing more frequently used ACLs at the top of the list to optimize the matching process.


     
      

     

     

 
     [bookmark: pgfId-600008]Step 8 Go to another tab or click OK to save your definitions locally on the client and close the dialog box. The defined class is displayed in the QoS Classes table on the Quality of Service page.

 
     [bookmark: pgfId-600010]Step 9 Do one of the following:

 
      
      		 [bookmark: pgfId-600015]When defining QoS on interfaces, continue as described in Defining QoS on Interfaces.

 
      		 [bookmark: pgfId-600020]When defining control plane policing, continue as described in Defining QoS on the Control Plane.

 
     

 
     [bookmark: pgfId-600022]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-600030][bookmark: 147313][bookmark: rtchap_proc_DefiningQoSClassMarkingParameters]Defining QoS Class Marking Parameters[bookmark: marker-600028]

 
     [bookmark: pgfId-600035]When you define marking parameters, you can mark the packets in this QoS class with either a precedence value or a DSCP value. See Understanding Marking Parameters for more information.
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     [bookmark: pgfId-600037]Note Marking is not available when you configure QoS on the control plane.


     
      

     

     

 
     [bookmark: pgfId-600039]Related Topics

 
      
      		 [bookmark: pgfId-600044]Defining QoS Class Matching Parameters

 
      		 [bookmark: pgfId-600049]Defining QoS Class Queuing Parameters

 
      		 [bookmark: pgfId-600054]Defining QoS Class Policing Parameters

 
      		 [bookmark: pgfId-600059]Defining QoS Class Shaping Parameters

 
      		 [bookmark: pgfId-600064]Defining QoS Policies

 
      		 [bookmark: pgfId-600069]Quality of Service on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-600071]Step 1 On the Quality of Service page, click the Add button beneath the QoS Classes table, or select a class and then click the Edit button. The QoS Class dialog box is displayed.

 
     [bookmark: pgfId-600076]Step 2 Click the Marking tab. See Table 65-7 for a description of the fields on this tab.

 
     [bookmark: pgfId-600078]Step 3 Select the Enable Marking check box.

 
     [bookmark: pgfId-600080]Step 4 Select one of the following marking options:

 
      
      		 [bookmark: pgfId-600085]Precedence—Select an IP precedence value (0 to 7) from the displayed list. For more information about these values, see Table 65-1.

 
      		 [bookmark: pgfId-600087]DSCP—Select a DSCP value (0 to 63) from the displayed list.

 
     

 
     [bookmark: pgfId-600089]Step 5 Go to another tab or click OK to save your definitions locally on the client and close the dialog box. The defined class is displayed in the QoS Classes table on the Quality of Service page.

 
     [bookmark: pgfId-600094]Step 6 Continue as described in Defining QoS Policies.

 
     [bookmark: pgfId-600096]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-600106][bookmark: 147371][bookmark: rtchap_proc_DefiningQoSClassQueuingParameters]Defining QoS Class Queuing Parameters[bookmark: marker-600102][bookmark: marker-600104]

 
     [bookmark: pgfId-600111]When you define queuing parameters, you can specify the amount of available bandwidth to provide to the traffic in this QoS class. You can also define a fixed amount of bandwidth that must be provided to high-priority traffic; you can define the priority parameter on only one class per interface. In addition, you must specify the type of queue management to perform on this class. See Understanding Queuing Parameters for more information.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-600113]Note Queuing is not available when you configure QoS on the control plane.


     
      

     

     

 
     [bookmark: pgfId-600115]Related Topics

 
      
      		 [bookmark: pgfId-600120]Defining QoS Class Matching Parameters

 
      		 [bookmark: pgfId-600125]Defining QoS Class Marking Parameters

 
      		 [bookmark: pgfId-600130]Defining QoS Class Policing Parameters

 
      		 [bookmark: pgfId-600135]Defining QoS Class Shaping Parameters

 
      		 [bookmark: pgfId-600140]Defining QoS Policies

 
      		 [bookmark: pgfId-600145]Quality of Service on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-600147]Step 1 On the Quality of Service page, click the Add button beneath the QoS Classes table, or select a class and then click the Edit button. The QoS Class dialog box is displayed.

 
     [bookmark: pgfId-600152]Step 2 Click the Queuing and Congestion Avoidance tab. See Table 65-8 for a description of the fields on this tab.

 
     [bookmark: pgfId-600154]Step 3 Click the Enable Queuing and Congestion Avoidance check box.

 
     [bookmark: pgfId-600156]Queuing options depend on whether you are defining the default class or a different class:

 
      
      		 [bookmark: pgfId-600158]When you define any class other than the default class, select one of the following queuing options:

 
     

 
     [bookmark: pgfId-600163] – Priority—Define the amount of bandwidth to make available to high-priority traffic. Low-Latency Queuing (LLQ) ensures that this traffic receives this fixed amount of bandwidth at all times. This is particularly useful for voice traffic, which requires low latency. You can define this amount by percentage or by an absolute value of kilobits per second.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-600165]Note You can define this option for only one class per interface.


     
      

     

     

 
     [bookmark: pgfId-600167] – Bandwidth—Enter the amount of bandwidth to allocate to this class. You can define this amount by percentage or by an absolute value of kilobits per second.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-600169]Note The sum of all class bandwidth allocations on an interface cannot exceed 100 percent of the total available bandwidth.


     
      

     

     

 
      
      		 [bookmark: pgfId-600171]When you define the default class, select one of the following queuing options:

 
     

 
     [bookmark: pgfId-600176] – Fair queue—Enter the number of queues to reserve for the default class. Values range in powers of 2 from 16 to 4096. By default, the number of queues is based on the available bandwidth of the selected interface. For more information, seeTable 65-2.

 
     [bookmark: pgfId-600178] – Bandwidth—Enter the amount of bandwidth to allocate to this class. You can define this amount by percentage or by an absolute value of kilobits per second.

 
     [bookmark: pgfId-600180]Step 4 (Optional) Define one of the following queue length management options:

 
      
      		 [bookmark: pgfId-600182]Queue Limit—(Default) Specify the maximum number of packets allowed. If you select this option, tail drop drops excess packets when the queue reaches its capacity.

 
      		 [bookmark: pgfId-600184]WRED Weight for Mean Queue Depth—WRED proactively drops packets until the transmitting protocol (usually TCP) responds by dropping its transmission rate, thereby alleviating congestion. Configure WRED by entering an exponential weight factor that is used to calculate the average queue size.

 
     

 
     [bookmark: pgfId-600189]For more information, see Tail Drop vs. WRED.
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     [bookmark: pgfId-600191]Note You should change the default only if you are certain that your applications will benefit from a different value.
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     [bookmark: pgfId-600193]Note Do not use WRED with protocols that are not sufficiently robust to reduce their transmission rates in response to packet loss, such as IPX or AppleTalk. WRED cannot be configured when you select the Priority percent option.


     
      

     

     

 
     [bookmark: pgfId-600195]Step 5 Go to another tab or click OK to save your definitions locally on the client and close the dialog box. The defined class is displayed in the QoS Classes table on the Quality of Service page.

 
     [bookmark: pgfId-600200]Step 6 Continue as described in Defining QoS Policies.

 
     [bookmark: pgfId-600202]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-600210][bookmark: 147456][bookmark: rtchap_proc_DefiningQoSClassPolicingParameters]Defining QoS Class Policing Parameters[bookmark: marker-600208]

 
     [bookmark: pgfId-600212]When you define policing parameters, you must specify the average data rate, which determines the amount of traffic that can be transmitted. In addition, you must specify the action to take on traffic bursts that exceed this data rate.

 
     [bookmark: pgfId-600217]You can configure policing for all QoS classes, including the default class. For more information about policing, see Understanding Policing and Shaping Parameters.

 
     [bookmark: pgfId-600222]You can also configure policing on the control plane. For more information, see Understanding Control Plane Policing.

 
     [bookmark: pgfId-600224]Related Topics

 
      
      		 [bookmark: pgfId-600229]Defining QoS Class Matching Parameters

 
      		 [bookmark: pgfId-600234]Defining QoS Class Marking Parameters

 
      		 [bookmark: pgfId-600239]Defining QoS Class Queuing Parameters

 
      		 [bookmark: pgfId-600244]Defining QoS Class Shaping Parameters

 
      		 [bookmark: pgfId-600249]Defining QoS Policies

 
      		 [bookmark: pgfId-600254]Quality of Service on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-600256]Step 1 On the Quality of Service page, click the Add button beneath the QoS Classes table, or select a class and then click the Edit button. The QoS Class dialog box is displayed.

 
     [bookmark: pgfId-600261]Step 2 Click the Policing tab. See Table 65-9 for a description of the fields on this tab.

 
     [bookmark: pgfId-600263]Step 3 Select the Enable Policing check box.

 
     [bookmark: pgfId-600265]Step 4 Define CIR, confirm burst, and excess burst values. You can define the CIR by percentage or by an absolute value of bits per second. The option you choose determines how you define the burst values.

 
     [bookmark: pgfId-600269]Step 5 [bookmark: 147501]Select the action to perform on packets that conform to the rate limit:

 
      
      		 [bookmark: pgfId-600271]transmit—Transmit the packet.

 
      		 [bookmark: pgfId-600273]set-prec-transmit—Set the IP precedence to a defined value, then send the packet. This option is not available when configuring QoS on the control plane.

 
      		 [bookmark: pgfId-600275]set-dscp-transmit—Set the DSCP to a defined value, then send the packet. This option is not available when configuring QoS on the control plane.

 
      		 [bookmark: pgfId-600277]drop—Drop the packet.

 
     

 
     [bookmark: pgfId-600279]Step 6 Select the action to perform on exceed packets. The list of available actions depends on the selected conform action.

 
     [bookmark: pgfId-600284]For example, if transmit is performed on conforming packets, you can select any of the actions listed in Step 5 for exceeding packets. However, if you selected one of the set actions for conforming packets, you can select only a set action or the drop action for exceeding packets. If you selected drop as the conform action, you must select drop as the exceed action.

 
     [bookmark: pgfId-600286]Step 7 Select the action to perform on violate packets. The list of available actions depends on the selected exceed action.

 
     [bookmark: pgfId-600291]For example, if transmit is performed on exceeding packets, you can select any of the actions listed in Step 5 for violating packets. However, if you selected one of the set actions for exceeding packets, you can select only a set action or the drop action for violating packets. If you selected drop as the exceed action, you must select drop as the violate action.

 
     [bookmark: pgfId-600293]Step 8 Go to another tab, or click OK to save your definitions locally on the client and close the dialog box. The defined class is displayed in the QoS Classes table on the Quality of Service page.

 
     [bookmark: pgfId-600295]Step 9 Do one of the following:

 
      
      		 [bookmark: pgfId-600300]When defining QoS on interfaces, continue as described in Defining QoS Policies.

 
      		 [bookmark: pgfId-600305]When defining control plane policing, continue as described in Defining QoS on the Control Plane.

 
     

 
     [bookmark: pgfId-600307]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-600315][bookmark: 147535][bookmark: rtchap_proc_DefiningQoSClassShapingParameters]Defining QoS Class Shaping Parameters[bookmark: marker-600313]

 
     [bookmark: pgfId-600317]When you define shaping parameters, you must specify whether to base traffic shaping on the average data rate or on the average data rate plus the excess burst rate that occurs during traffic peaks. In both cases, traffic that exceeds these definitions is buffered until the rate lowers, allowing the packets to be sent.

 
     [bookmark: pgfId-600319]The following conditions pertain:

 
      
      		 [bookmark: pgfId-600321]Shaping can be used only on output traffic.

 
      		 [bookmark: pgfId-600323]Shaping can be configured for all QoS classes, including the default class.

 
      		 [bookmark: pgfId-600325]Shaping is not available when you configure the QoS class for priority traffic.

 
      		 [bookmark: pgfId-600327]Shaping is not available when you configure QoS on the control plane.

 
     

 
     [bookmark: pgfId-600332]For more information about shaping, see Understanding Policing and Shaping Parameters.
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     [bookmark: pgfId-600337]Tip To configure shaping on all the QoS classes defined for the interface (hierarchical shaping), see Defining QoS on Interfaces.


     
      

     

     

 
     [bookmark: pgfId-600339]Related Topics

 
      
      		 [bookmark: pgfId-600344]Defining QoS Class Matching Parameters

 
      		 [bookmark: pgfId-600349]Defining QoS Class Marking Parameters

 
      		 [bookmark: pgfId-600354]Defining QoS Class Queuing Parameters

 
      		 [bookmark: pgfId-600359]Defining QoS Class Policing Parameters

 
      		 [bookmark: pgfId-600364]Defining QoS Policies

 
      		 [bookmark: pgfId-600369]Quality of Service on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-600371]Step 1 On the Quality of Service page, click the Add button beneath the QoS Classes table, or select a class and then click the Edit button. The QoS Class dialog box is displayed.

 
     [bookmark: pgfId-600376]Step 2 Click the Shaping tab. See Table 65-10 for a description of the fields on this tab.

 
     [bookmark: pgfId-600378]Step 3 Select the Enable Shaping check box.

 
     [bookmark: pgfId-600380]Step 4 Select the shaping type (Average or Peak).

 
     [bookmark: pgfId-600382]Step 5 Define CIR, sustained burst, and excess burst values. You can define the CIR by percentage or by an absolute value of bits per second. The option you choose determines how you define the burst values.

 
     [bookmark: pgfId-600384]Step 6 Proceed to another tab or click OK to save your definitions locally on the client and close the dialog box. The defined class is displayed in the QoS Classes table on the Quality of Service page.

 
     [bookmark: pgfId-600389]Step 7 Continue as described in Defining QoS Policies.

 
     [bookmark: pgfId-600391]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-600403][bookmark: 147603][bookmark: rtpage_cncpt_QualityofServicePolicyPage]Quality of Service Policy Page[bookmark: marker-600399][bookmark: marker-600401]

 
    [bookmark: pgfId-600405]Use the Quality of Service page to view, create, and edit QoS classes on specific interfaces of the selected device or on the control plane. QoS policies enable you to define techniques for managing the delay, delay variation (jitter), bandwidth, and packet loss parameters on a network. In addition, you can use the Quality of Service page to configure hierarchical shaping on an interface as an alternative to configuring shaping parameters for individual QoS classes.

 
    [bookmark: pgfId-600410]For more information, see Quality of Service on Cisco IOS Routers.

 
    [bookmark: pgfId-600412]Navigation Path

 
     
     		 [bookmark: pgfId-600414](Device view) Select  Platform > Quality of Service from the Policy selector.

 
     		 [bookmark: pgfId-600416](Policy view) Select  Router Platform > Quality of Service from the Policy Type selector. Create a new policy or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-600418]Related Topics

 
     
     		 [bookmark: pgfId-600423]Defining QoS Policies

 
     		 [bookmark: pgfId-600428]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-600433]Filtering Tables

 
    

 
    [bookmark: pgfId-600435]Field Reference

 
    [bookmark: pgfId-600438] 

 
     
      
       
       [bookmark: pgfId-597737]Table 65-3 [bookmark: 147640]Quality of Service Page 

 
       
      
        
        		
          
          [bookmark: pgfId-597743]Element
         
  
        		
          
          [bookmark: pgfId-597745]Description
         
  
       

 
        
        		[bookmark: pgfId-597751]Apply To

  
        		[bookmark: pgfId-597753]The router component on which to define the QoS policy:

 
          
          		 [bookmark: pgfId-597755]Interfaces—Configures QoS classes on specific interfaces.

 
          		 [bookmark: pgfId-597760]Control Plane—Configures QoS on the router control plane. See Understanding Control Plane Policing.

 
         

 [bookmark: pgfId-597762]Note If you configure QoS on both the interfaces and the control plane of the same device, only the control plane configuration is deployed.

  
       

 
        
        		[bookmark: pgfId-597768]Interface Table

  
        		[bookmark: pgfId-597770]If you are defining classes on interfaces, the upper table lists the interfaces on which you are defining QoS classes. The direction column indicates the direction of traffic through the interface to which the classes apply (Output or Input). The classes you can define vary based on the direction.

 [bookmark: pgfId-597775]The other fields indicate whether you defined shaping on the interface, and if shaping is defined, the type of hierarchical shaping (average or peak), the committed information rate (CIR), and the sustained and excess burst size. For detailed information about the attributes, see QoS Policy Dialog Box.

 
          
          		 [bookmark: pgfId-597777]To add an interface to the table, click the Add button.

 
          		 [bookmark: pgfId-597779]To edit the settings for an interface, select it and click the Edit button.

 
          		 [bookmark: pgfId-597781]To delete an interface, select it and click the Delete button.

 
         

  
       

 
        
        		[bookmark: pgfId-597787]QoS Classes Table

  
        		[bookmark: pgfId-597789]The classes defined for the interface selected in the upper table, or for the control plane. Each row represents a separate class. The No. column indicates the order of the classes, and is very important: QoS is applied to packets on a first-match basis, based on class order.

 [bookmark: pgfId-597791]The Default Class column indicates whether this class is the default for all packets on the interface that do not match the criteria of the other defined classes. Make this the last class in the list.

 [bookmark: pgfId-597796]The remaining columns indicate the match criteria for the class, and the packet marking, queuing and congestion avoidance, policing, and shaping defined for the class, if any. For detailed information about the attributes, see QoS Class Dialog Box.

 
          
          		 [bookmark: pgfId-597798]To add class to the table, click the Add button.

 
          		 [bookmark: pgfId-597800]To edit the settings for a class, select it and click the Edit button.

 
          		 [bookmark: pgfId-597802]To delete a class, select it and click the Delete button.

 
          		 [bookmark: pgfId-597804]To change the order of a class, select it and click the Up and Down arrow buttons to reposition it.

 
         

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-600450][bookmark: 147693][bookmark: rtpage_cncpt_QoSPolicyDialogBox]QoS Policy Dialog Box[bookmark: marker-600446][bookmark: marker-600448]

 
     [bookmark: pgfId-600452]Use the QoS Policy dialog box to select an interface on which you want to define QoS parameters. In addition, you can use this dialog box to configure a single set of shaping parameters for all the traffic on the selected interface (known as hierarchical shaping). Using hierarchical shaping eliminates the need to configure shaping parameters for each QoS class defined on the interface.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-600457]Note This dialog box is not applicable when defining a QoS policy on the control plane. For more information, see Defining QoS on the Control Plane.


     
      

     

     

 
     [bookmark: pgfId-600462]After you create your QoS interface definitions, you can define one or more QoS classes for each interface. For more information, see QoS Class Dialog Box.

 
     [bookmark: pgfId-600464]Navigation Path

 
     [bookmark: pgfId-600469]Go to the Quality of Service Policy Page, then click the Add or Edit button beneath the upper table to define a QoS interface definition.

 
     [bookmark: pgfId-600471]Related Topics

 
      
      		 [bookmark: pgfId-600476]Defining QoS Policies

 
      		 [bookmark: pgfId-600481]Quality of Service on Cisco IOS Routers

 
      		 [bookmark: pgfId-600486]Basic Interface Settings on Cisco IOS Routers

 
      		 [bookmark: pgfId-600491]Understanding Interface Role Objects

 
     

 
     [bookmark: pgfId-600493]Field Reference

 
     [bookmark: pgfId-600496] 

 
      
       
        
        [bookmark: pgfId-597817]Table 65-4 [bookmark: 147732]QoS Policy Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-597823]Element
          
  
         		
           
           [bookmark: pgfId-597825]Description
          
  
        

 
         
         		[bookmark: pgfId-597831]Interface

  
         		[bookmark: pgfId-597833]The interface on which QoS is defined. Enter the name of an interface or interface role, or click Select to select an object from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-597839]Direction

  
         		[bookmark: pgfId-597841]The direction of the traffic on which to configure QoS:

 
           
           		 [bookmark: pgfId-597843]Output—Traffic that exits the interface.

 
           		 [bookmark: pgfId-597845]Input—Traffic that enters the interface.

 
          

  
        

 
         
         		 [bookmark: pgfId-597851]Hierarchical Shaping settings

  
        

 
         
         		[bookmark: pgfId-597859]Enable Shaping

  
         		[bookmark: pgfId-597861]When selected, configures hierarchical traffic shaping on the selected interface.

 [bookmark: pgfId-597863]When deselected, hierarchical shaping is not used.

 [bookmark: pgfId-597865]Note Shaping can be performed only on output traffic.

  
        

 
         
         		[bookmark: pgfId-597871]Type

  
         		[bookmark: pgfId-597873]The type of shaping to perform:

 
           
           		 [bookmark: pgfId-597875]Average—Limits the data rate for each interval to the sustained burst rate (also known as the Committed Burst rate or Bc), achieving an average rate no higher than the committed information rate (CIR). Additional packets are buffered until they can be sent.

 
           		 [bookmark: pgfId-597877]Peak—Limits the data rate for each interval to the sustained burst rate plus the excess burst rate (Be). Additional packets are buffered until they can be sent.

 
          

  
        

 
         
         		[bookmark: pgfId-597883]CIR

  
         		[bookmark: pgfId-597885]The average data rate (also known as the committed information rate or CIR). You can define this amount by:

 
           
           		 [bookmark: pgfId-597887]Percentage—Valid values range from 0 to 100% of the overall available bandwidth.

 
           		 [bookmark: pgfId-597889]Bit/sec—Valid values range from 8000 to 1000000000 bits per second, and must be in multiples of 8000.

 
          

 [bookmark: pgfId-597891]Although data bursts during an interval may exceed this rate, the average data rate over any multiple integral of the interval will not exceed this rate.

  
        

 
         
         		[bookmark: pgfId-597897]Sustained Burst

  
         		[bookmark: pgfId-597899]The normal burst size. If you select average as the shaping type, data bursts during an interval are limited to this value.

 [bookmark: pgfId-597901]The range of valid values is determined by the CIR:

 
           
           		 [bookmark: pgfId-597903]When the CIR is defined by percentage—Valid values range from 10 to 2000 milliseconds.

 
           		 [bookmark: pgfId-597905]When the CIR is defined by an absolute value—Valid values range from 1000 to 154400000 bytes, in multiples of 128 bytes.

 
          

 [bookmark: pgfId-597907]Note We recommend that you leave this field blank when the CIR is defined by an absolute value. This allows the algorithms used by the device to determine the optimal sustained burst value.

  
        

 
         
         		[bookmark: pgfId-597913]Excess Burst

  
         		[bookmark: pgfId-597915]The excess burst size. If you select peak as the shaping type, data bursts during an interval can equal the sum of the sustained burst value plus this value. The average data rate over multiple intervals, however, will continue to conform to the CIR.

 [bookmark: pgfId-597917]The range of valid values is determined by the CIR:

 
           
           		 [bookmark: pgfId-597919]When the CIR is defined by percentage—Valid values range from 10 to 2000 milliseconds.

 
           		 [bookmark: pgfId-597921]When the CIR is defined by an absolute value—Valid values range from 1000 to 154400000 bytes, in multiples of 128 bytes.

 
          

 [bookmark: pgfId-597923]Note If you do not configure this field when the CIR is defined by an absolute value, the sustained burst value is used.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-600510][bookmark: 147815][bookmark: rtpage_cncpt_QoSClassDialogBox]QoS Class Dialog Box[bookmark: marker-600504][bookmark: marker-600506][bookmark: marker-600508]

 
     [bookmark: pgfId-600512]Use the QoS Class dialog box to create or edit a QoS class on a selected interface or control plane of a Cisco IOS router. You can define up to 16 classes on a single interface and 256 classes for the device as a whole.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-600514]Note QoS is applied to packets on a first-match basis. The router examines the table of QoS classes starting from the top and applies the properties of the first class whose matching criteria matches the packet. Therefore, it is important that you define and order your classes carefully. The default class should be placed last to prevent traffic that matches a specific class from being treated as unmatched traffic.


     
      

     

     

 
     [bookmark: pgfId-600516]Navigation Path

 
     [bookmark: pgfId-600521]Go to the Quality of Service Policy Page. Complete the options at the top of the page, then do one of the following:

 
      
      		 [bookmark: pgfId-600523]To create a QoS class, select an interface from the upper table, then click the  Add button beneath the QoS Class table. When creating a QoS class for the control plane, just click the  Add button beneath the table.

 
      		 [bookmark: pgfId-600525]To edit a QoS class:

 
     

 
     [bookmark: pgfId-600527] – Select the interface whose class you want to edit from the upper table (Not required when selecting the control plane.).

 
     [bookmark: pgfId-600529] – Select the relevant class defined for that interface in the QoS Classes table. (Not required when selecting the control plane.)

 
     [bookmark: pgfId-600531] – Click the Edit button under the QoS Class table.

 
     [bookmark: pgfId-600533]Related Topics

 
      
      		 [bookmark: pgfId-600538]QoS Policy Dialog Box

 
      		 [bookmark: pgfId-600543]Defining QoS Policies

 
      		 [bookmark: pgfId-600548]Defining QoS on Interfaces

 
      		 [bookmark: pgfId-600553]Defining QoS on the Control Plane

 
     

 
     [bookmark: pgfId-600555]Field Reference

 
     [bookmark: pgfId-600558] 

 
      
       
        
        [bookmark: pgfId-597936]Table 65-5 [bookmark: 147866]QoS Class Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-597942]Element
          
  
         		
           
           [bookmark: pgfId-597944]Description
          
  
        

 
         
         		[bookmark: pgfId-597950]Set as Default Class

  
         		[bookmark: pgfId-597952]When selected, enables you to define the default class for all traffic that does not match the other QoS classes on this interface.

 [bookmark: pgfId-597954]When deselected, enables you to define a specific QoS class on this interface.

 [bookmark: pgfId-597956]Note When you define the default class, you do not configure any matching parameters; by definition the class consists of all traffic that does not match any of the other classes. Therefore, the Matching tab is disabled.

  
        

 
         
         		[bookmark: pgfId-597962]Matching tab

  
         		[bookmark: pgfId-597967]Defines the traffic that is included in this QoS class. See QoS Class Dialog Box—Matching Tab.

  
        

 
         
         		[bookmark: pgfId-597973]Marking tab

  
         		[bookmark: pgfId-597978]Marks the traffic in this class so that downstream devices can properly identify it. See QoS Class Dialog Box—Marking Tab.

  
        

 
         
         		[bookmark: pgfId-597984]Queuing and Congestion Avoidance tab

  
         		[bookmark: pgfId-597989]Defines how to queue the output traffic in this class. See QoS Class Dialog Box—Queuing and Congestion Avoidance Tab.

  
        

 
         
         		[bookmark: pgfId-597995]Policing tab

  
         		[bookmark: pgfId-598000]Limits the traffic flow for this class to a configured rate. See QoS Class Dialog Box—Policing Tab.

  
        

 
         
         		[bookmark: pgfId-598006]Shaping tab

  
         		[bookmark: pgfId-598011]Controls the flow of output traffic for this class so that it conforms with the requirements of downstream devices. See QoS Class Dialog Box—Shaping Tab.

  
        

 
       
      

 
     
 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-600560]Note When you configure a QoS policy on the control plane, only the Matching tab and Policing tab are available.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-600570][bookmark: 147914][bookmark: rtpage_cncpt_QoSClassDialogBoxMatchingTab]QoS Class Dialog Box—Matching Tab[bookmark: marker-600568]

 
     [bookmark: pgfId-600572]Use the Matching tab of the QoS Class dialog box to define which traffic over the selected interface is considered to be part of this class.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-600574]Note When you define the default class, the Matching tab is disabled.


     
      

     

     

 
     [bookmark: pgfId-600576]Navigation Path

 
     [bookmark: pgfId-600581]Go to the QoS Class Dialog Box, then click the Matching tab.

 
     [bookmark: pgfId-600583]Related Topics

 
      
      		 [bookmark: pgfId-600588]Defining QoS Class Matching Parameters

 
      		 [bookmark: pgfId-600593]Defining QoS on Interfaces

 
      		 [bookmark: pgfId-600598]Defining QoS on the Control Plane

 
      		 [bookmark: pgfId-600603]Quality of Service Policy Page

 
      		 [bookmark: pgfId-600608]Creating Access Control List Objects

 
     

 
     [bookmark: pgfId-600610]Field Reference

 
     [bookmark: pgfId-600613] 

 
      
       
        
        [bookmark: pgfId-598024]Table 65-6 [bookmark: 147948]QoS Class Dialog Box—Matching Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-598030]Element
          
  
         		
           
           [bookmark: pgfId-598032]Description
          
  
        

 
         
         		[bookmark: pgfId-598038]Match Method

  
         		[bookmark: pgfId-598040]The traffic matching option used for this class:

 
           
           		 [bookmark: pgfId-598042]Any—Assigns traffic matching any of the defined class map criteria to this QoS class.

 
           		 [bookmark: pgfId-598044]All—Assigns only traffic matching all of the defined class map criteria to this QoS class.

 
          

  
        

 
         
         		[bookmark: pgfId-598050]Protocol

  
         		[bookmark: pgfId-598052]One or more protocols included in this class map. Click Add to display a selector. Select one or more items from the Available Protocols list, then click >> to add them to the Selected Protocols list.

 [bookmark: pgfId-598054]The only protocol available for the control plane is ARP; ARP and CDP are not available for input classes configured on an interface.

 [bookmark: pgfId-598056]When you finish, click OK to return to the QoS Class dialog box. Your selections are displayed in the Protocol field.

 .

  
        

 
         
         		[bookmark: pgfId-598064]Precedence

  
         		[bookmark: pgfId-598069]One or more IP Precedence (IPP) values included in this class map. Click Add to display a selector. Select one or more items from the Available Precedences list, then click >> to add them to the Selected Precedences list. For more information about IP precedence values, see Table 65-1.

 [bookmark: pgfId-598071]When you finish, click OK to return to the QoS Class dialog box. Your selections are displayed in the Precedence field.

 .

  
        

 
         
         		[bookmark: pgfId-598079]DSCP

  
         		[bookmark: pgfId-598081]One or more Differentiated Services Code Point (DSCP) values included in this class map. Click Add to display a selector. Select one or more items (up to eight) from the Available DSCPs list, then click >> to add them to the Selected DSCPs list.

 [bookmark: pgfId-598083]When you finish, click OK to return to the QoS Class dialog box. Your selections are displayed in the DSCP field.

 .

  
        

 
         
         		[bookmark: pgfId-598091]ACL

  
         		[bookmark: pgfId-598093]The ACLs that are used for defining which traffic requires QoS. Click Edit to add or remove ACL objects.

 [bookmark: pgfId-598095]Use the up and down arrows to order the ACLs in the list. We recommend that you place frequently used ACLs at the top of the list to optimize the matching process.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-600623][bookmark: 148011][bookmark: rtpage_cncpt_EditACLsDialogBoxQoSClasses]Edit ACLs Dialog Box—QoS Classes[bookmark: marker-600621]

 
     [bookmark: pgfId-600625]When configuring a QoS policy on a Cisco IOS router, use the Edit ACLs dialog box to specify which ACLs should be included in the matching criteria for the selected QoS class. Traffic matching this criteria is included as part of the class.

 
     [bookmark: pgfId-600627]Enter the names of the extended ACLs or click Select to select an ACL object from a list or to create a new one. Separate multiple ACL objects with commas and place them in priority order.

 
     [bookmark: pgfId-600632]For more information, see Creating Extended Access Control List Objects.

 
     [bookmark: pgfId-600634]Navigation Path

 
     [bookmark: pgfId-600639]Go to the QoS Class Dialog Box—Matching Tab, then click Edit in the ACL field.

 
     [bookmark: pgfId-600641]Related Topics

 
      
      		 [bookmark: pgfId-600646]Defining QoS Class Matching Parameters

 
      		 [bookmark: pgfId-600651]Defining QoS on Interfaces

 
      		 [bookmark: pgfId-600656]Defining QoS on the Control Plane

 
      		 [bookmark: pgfId-600661]Quality of Service Policy Page

 
      		 [bookmark: pgfId-600666]Selecting Objects for Policies

 
     

 
    
 
     
      [bookmark: pgfId-600676][bookmark: 148046][bookmark: rtpage_cncpt_QoSClassDialogBoxMarkingTab]QoS Class Dialog Box—Marking Tab[bookmark: marker-600674]

 
     [bookmark: pgfId-600678]Use the Marking tab of the QoS Class dialog box to classify packets. Traffic policers and shapers use these classifications to ensure adherence to the contracted level of service. Downstream devices use this classification to identify the packets and apply the appropriate QoS functions to them.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-600680]Note The Marking tab is unavailable when you define a QoS policy on the control plane.


     
      

     

     

 
     [bookmark: pgfId-600682]Navigation Path

 
     [bookmark: pgfId-600687]Go to the QoS Class Dialog Box, then click the Marking tab.

 
     [bookmark: pgfId-600689]Related Topics

 
      
      		 [bookmark: pgfId-600694]Defining QoS Class Marking Parameters

 
      		 [bookmark: pgfId-600699]Defining QoS on Interfaces

 
      		 [bookmark: pgfId-600704]Defining QoS on the Control Plane

 
      		 [bookmark: pgfId-600709]Quality of Service Policy Page

 
     

 
     [bookmark: pgfId-600711]Field Reference

 
     [bookmark: pgfId-600714] 

 
      
       
        
        [bookmark: pgfId-598108]Table 65-7 [bookmark: 148077]QoS Class Dialog Box—Marking Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-598114]Element
          
  
         		
           
           [bookmark: pgfId-598116]Description
          
  
        

 
         
         		[bookmark: pgfId-598122]Enable Marking

  
         		[bookmark: pgfId-598124]When selected, enables you to mark the traffic in this QoS class with a specific precedence or DSCP value (regardless of any value the traffic might have had when it first entered the device). This mark enables downstream devices to identify the traffic and apply the appropriate QoS features to it.

 [bookmark: pgfId-598126]When deselected, disables all marking options for the selected QoS class. The traffic in this QoS class maintains its original precedence or DSCP value, if any.

  
        

 
         
         		[bookmark: pgfId-598132]Precedence

  
         		[bookmark: pgfId-598134]The precedence value with which to mark the traffic in this class:

 
           
           		 [bookmark: pgfId-598136]network (7)

 
           		 [bookmark: pgfId-598138]internet match (6)

 
           		 [bookmark: pgfId-598140]critical (5)

 
           		 [bookmark: pgfId-598142]flash-override (4)

 
           		 [bookmark: pgfId-598144]flash (3)

 
           		 [bookmark: pgfId-598146]immediate (2)

 
           		 [bookmark: pgfId-598148]priority (1)

 
           		 [bookmark: pgfId-598150]routine (0)

 
          

  
        

 
         
         		[bookmark: pgfId-598156]DSCP

  
         		[bookmark: pgfId-598158]The DSCP value (0 to 63) with which to mark the traffic in this class.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-600724][bookmark: 148121][bookmark: rtpage_cncpt_QoSClassDialogBoxQueuingandCongestionAvoidanceTab]QoS Class Dialog Box—Queuing and Congestion Avoidance Tab[bookmark: marker-600722]

 
     [bookmark: pgfId-600726]Use the Queuing and Congestion Avoidance tab of the QoS Class dialog box to perform Class-Based Weighted Fair Queuing (CBWFQ) on the output traffic in the selected QoS class. Queuing prioritizes traffic and manages congestion on your network by determining the order in which packets are sent out over an interface. Queuing and congestion avoidance applies only to interface classes for output traffic.

 
     [bookmark: pgfId-600728]The fields displayed in the Queuing tab depend on whether you are defining a specific QoS class or the default class (by selecting Set as Default Class), and also by the type of router and the Cisco IOS software version.

 
     [bookmark: pgfId-600730]Navigation Path

 
     [bookmark: pgfId-600735]Go to the QoS Class Dialog Box, then click the Queuing and Congestion Avoidance tab.

 
     [bookmark: pgfId-600737]Related Topics

 
      
      		 [bookmark: pgfId-600742]Defining QoS Class Queuing Parameters

 
      		 [bookmark: pgfId-600747]Defining QoS on Interfaces

 
      		 [bookmark: pgfId-600752]Defining QoS on the Control Plane

 
      		 [bookmark: pgfId-600757]Quality of Service Policy Page

 
     

 
     [bookmark: pgfId-600759]Field Reference

 
     [bookmark: pgfId-600762] 

 
      
       
        
        [bookmark: pgfId-598171]Table 65-8 [bookmark: 148153]QoS Class Dialog Box—Queuing and Congestion Avoidance Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-598177]Element
          
  
         		
           
           [bookmark: pgfId-598179]Description
          
  
        

 
         
         		[bookmark: pgfId-598185]Enable Queuing and Congestion Avoidance

  
         		[bookmark: pgfId-598187]Whether to configure queuing and congestion avoidance properties in the QoS class.

  
        

 
         
         		[bookmark: pgfId-598193]Priority

 [bookmark: pgfId-598195](Non-default classes only.)

  
         		[bookmark: pgfId-598200]Configure low-latency queuing (LLQ) in this class to ensure that priority traffic, such as voice traffic, receives the defined bandwidth (see Low-Latency Queuing). Specify the amount of bandwidth allocated to high-priority traffic on this interface by:

 
           
           		 [bookmark: pgfId-598202]Percentage—Valid values range from 1 to 100%.

 
           		 [bookmark: pgfId-598204]Kbit/sec—Valid values range from 8-2000000 kilobits per second.

 
          

 [bookmark: pgfId-598206]Note You can define this option for one class only per interface. If you select this option, the Shaping tab is disabled.

  
        

 
         
         		[bookmark: pgfId-598212]Fair Queue

 [bookmark: pgfId-598214]Number of Dynamic Queues

 [bookmark: pgfId-598216](Default class only.)

  
         		[bookmark: pgfId-598218]Configure class-based weighted fair queuing in this class.

 [bookmark: pgfId-598223]If the device is running an IOS software version lower than 12.4(20)T, you must specify the number of dynamic queues to reserve for this class. You should base your number on the available bandwidth of the interface. You can specify a number between 16 and 4096 that is a power to 2. For information on the default number of queues the device uses, see Default Class Queuing. Available bandwidth is evenly distributed among the queues unless you configure a queue limit.

 [bookmark: pgfId-598225]Tip Failure to provide a sufficient number of queues for the default class (a condition known as starvation) could result in the traffic not being sent.  
        

 
         
         		[bookmark: pgfId-598231]Bandwidth

  
         		[bookmark: pgfId-598233]Configure the minimum bandwidth to guarantee to this class. You can define this amount by:

 
           
           		 [bookmark: pgfId-598235]Percentage—Valid values range from 1 to 100% of the total available bandwidth.

 
           		 [bookmark: pgfId-598237]Kbit/sec—Valid values range from 8-2000000 kilobits per second.

 
          

  
        

 
         
         		[bookmark: pgfId-598243]Enable Fair Queue

 [bookmark: pgfId-598245](Non-default class only.)

  
         		[bookmark: pgfId-598247]When you configure bandwidth for a non-default class, whether to also enable class-based weighted fair queuing (CBWFQ). The device calculates the number of queues to configure based on the available bandwidth, and distributes the bandwidth evenly among the queues unless you configure a queue limit.

 [bookmark: pgfId-598249]This option is available only for Aggregation Services Routers (ASR) and for routers running 12.4(20)T and higher.

  
        

 
         
         		[bookmark: pgfId-598255]Queue Limit

  
         		[bookmark: pgfId-598257]The maximum number of packets that can be queued for the class. Any additional packets are dropped using tail drop until the congestion is gone.

 [bookmark: pgfId-598259]This is the default option for limiting queue size unless Weighted Random Early Detection (WRED) is configured.

  
        

 
         
         		[bookmark: pgfId-598265]WRED Weight for Mean Queue Depth

  
         		[bookmark: pgfId-598267]The exponential weight factor to use to calculate the average queue size. Use this option when defining WRED instead of tail drop (queue limit) for this class. When the queue size exceeds the value determined by this weight factor, WRED randomly discards packets until the transmitting protocol decreases its transmission rate to ease congestion. Exponent values range from 1 to 16. The default is 9.

 [bookmark: pgfId-598269]This option is best suited for protocols like TCP, which respond to dropped packets by decreasing the transmission rate. We recommend that you do not change the default unless you determine that your applications would benefit from the change.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-600772][bookmark: 148221][bookmark: rtpage_cncpt_QoSClassDialogBoxPolicingTab]QoS Class Dialog Box—Policing Tab[bookmark: marker-600770]

 
     [bookmark: pgfId-600774]Use the Policing tab of the QoS Class dialog box to configure rate limits on the traffic in a selected QoS class. Excess traffic is either dropped or transmitted with a different (typically lower) priority.

 
     [bookmark: pgfId-600776]Navigation Path

 
     [bookmark: pgfId-600781]Go to the QoS Class Dialog Box, then click the Policing tab.

 
     [bookmark: pgfId-600783]Related Topics

 
      
      		 [bookmark: pgfId-600788]Defining QoS Class Policing Parameters

 
      		 [bookmark: pgfId-600793]Defining QoS on Interfaces

 
      		 [bookmark: pgfId-600798]Defining QoS on the Control Plane

 
      		 [bookmark: pgfId-600803]Quality of Service Policy Page

 
     

 
     [bookmark: pgfId-600805]Field Reference

 
     [bookmark: pgfId-600808] 

 
      
       
        
        [bookmark: pgfId-598282]Table 65-9 [bookmark: 148251]QoS Class Dialog Box—Policing Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-598288]Element
          
  
         		
           
           [bookmark: pgfId-598290]Description
          
  
        

 
         
         		[bookmark: pgfId-598296]Enable Policing

  
         		[bookmark: pgfId-598298]When selected, enables you to configure Class-Based Policing to control the maximum rate of traffic for this class. Security Manager uses a two-token bucket algorithm, which includes a defined violate action that is performed when neither bucket can accommodate the incoming packet.

 [bookmark: pgfId-598300]When deselected, disables all policing options for the selected QoS class.

  
        

 
         
         		[bookmark: pgfId-598306]CIR

  
         		[bookmark: pgfId-598308]The average data rate (also known as the committed information rate or CIR). You can define this amount by:

 
           
           		 [bookmark: pgfId-598310]Percentage—Valid values range from 0 to 100% of the overall available bandwidth.

 
           		 [bookmark: pgfId-598312]Bit/sec—Valid values range from 8000 to 2000000000 bits per second.

 
          

 [bookmark: pgfId-598314]In the token bucket algorithm, this rate represents the token arrival rate for filling both token buckets. Traffic that falls under this rate always conforms.

 [bookmark: pgfId-598319]Note When you configure Understanding Control Plane Policing, you must define the CIR in bits per second.

  
        

 
         
         		[bookmark: pgfId-598325]Conform Burst

  
         		[bookmark: pgfId-598327]The normal burst size, which determines how large traffic bursts can be before some traffic exceeds the rate limit. In the token bucket algorithm, it represents the full size of the first (conform) token bucket.

 [bookmark: pgfId-598329]The range of valid values is determined by the CIR:

 
           
           		 [bookmark: pgfId-598331]When the CIR is defined by percentage—Valid values range from 1 to 2000 milliseconds.

 
           		 [bookmark: pgfId-598333]When the CIR is defined by an absolute value—Valid values range from 1000-512000000 bytes.

 
          

  
        

 
         
         		[bookmark: pgfId-598339]Excess Burst

  
         		[bookmark: pgfId-598341]The excess burst size, which determines how large traffic bursts can be before all traffic exceeds the rate limit. In the token bucket algorithm, it represents the full size of the second (exceed) token bucket.

 [bookmark: pgfId-598343]The range of valid values is determined by the CIR:

 
           
           		 [bookmark: pgfId-598345]When the CIR is defined by percentage—Valid values range from 1 to 2000 milliseconds.

 
           		 [bookmark: pgfId-598347]When the CIR is defined by an absolute value—Valid values range from 1000-512000000 bytes.

 
          

  
        

 
         
         		[bookmark: pgfId-598353]Conform action

  
         		[bookmark: pgfId-598355]The action to take on packets that conform to the rate limit:

 
           
           		 [bookmark: pgfId-598357]transmit—Transmits the packet.

 
           		 [bookmark: pgfId-598359]set-prec-transmit—Sets the IP precedence to a value you specify (0 to 7) and then sends the packet. Not available on the control plane.

 
           		 [bookmark: pgfId-598361]set-dscp-transmit—Sets the DSCP to a value you specify (0 to 63) and then sends the packet. Not available on the control plane.

 
           		 [bookmark: pgfId-598363]drop—Drops the packet.

 
          

  
        

 
         
         		[bookmark: pgfId-598369]Exceed action

  
         		[bookmark: pgfId-598371]The action to take on packets that exceed the rate limit, but can be handled using the second (exceed) token bucket.

 [bookmark: pgfId-598373]The actions available for selection depend on the defined conform action. For example, if you select one of the set options as the conform action, you cannot select transmit as the exceed action. If you select drop as the conform action, then you must also select drop as the exceed action.

  
        

 
         
         		[bookmark: pgfId-598379]Violate action

  
         		[bookmark: pgfId-598381]The action to take on packets that cannot be serviced by either the conform bucket or the exceed bucket.

 [bookmark: pgfId-598383]The actions available for selection depend on the defined exceed action. For example, if you select one of the set options as the exceed action, you cannot select transmit as the violate action. If you select drop as the exceed action, then you must also select drop as the violate action.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-600818][bookmark: 148329][bookmark: rtpage_cncpt_QoSClassDialogBoxShapingTab]QoS Class Dialog Box—Shaping Tab[bookmark: marker-600816]

 
     [bookmark: pgfId-600820]Use the Shaping tab of the QoS Class dialog box to control the rate of output traffic for the selected QoS class. Shaping typically delays excess traffic by using a buffer, or queuing mechanism, to hold packets and shape the flow when the data rate of the source is higher than expected.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-600822]Note The Shaping tab is unavailable when you define a QoS policy on the control plane, use hierarchical shaping on the interface, define a QoS class for input traffic, or perform queuing on priority traffic.


     
      

     

     

 
     [bookmark: pgfId-600824]Navigation Path

 
     [bookmark: pgfId-600829]Go to the QoS Class Dialog Box, then click the Shaping tab.

 
     [bookmark: pgfId-600831]Related Topics

 
      
      		 [bookmark: pgfId-600836]Defining QoS Class Shaping Parameters

 
      		 [bookmark: pgfId-600841]Defining QoS on Interfaces

 
      		 [bookmark: pgfId-600846]Defining QoS on the Control Plane

 
      		 [bookmark: pgfId-600851]Quality of Service Policy Page

 
     

 
     [bookmark: pgfId-600853]Field Reference

 
     [bookmark: pgfId-600856] 

 
      
       
        
        [bookmark: pgfId-598396]Table 65-10 [bookmark: 148360]QoS Class Dialog Box—Shaping Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-598402]Element
          
  
         		
           
           [bookmark: pgfId-598404]Description
          
  
        

 
         
         		[bookmark: pgfId-598410]Enable Shaping

  
         		[bookmark: pgfId-598412]When selected, enables you to configure Distributed Traffic Shaping (DTS) to control the rate of traffic for this class. DTS uses queues to buffer traffic surges that can congest the network.

 [bookmark: pgfId-598414]When deselected, disables all shaping options for the selected QoS class.

 [bookmark: pgfId-598416]Note Shaping can be performed only on output traffic.

  
        

 
         
         		[bookmark: pgfId-598422]Type

  
         		[bookmark: pgfId-598424]The type of shaping to perform:

 
           
           		 [bookmark: pgfId-598426]Average—Limits the data rate for each interval to the sustained burst rate (also known as the committed burst rate or Bc), achieving an average rate no higher than the committed information rate (CIR). Additional packets are buffered until they can be sent.

 
           		 [bookmark: pgfId-598428]Peak—Limits the data rate for each interval to the sustained burst rate plus the excess burst rate (Be). Additional packets are buffered until they can be sent.

 
          

  
        

 
         
         		[bookmark: pgfId-598434]CIR

  
         		[bookmark: pgfId-598436]The average data rate (also known as the committed information rate or CIR). You can define this amount by:

 
           
           		 [bookmark: pgfId-598438]Percentage—Valid values range from 0 to 100% of the overall available bandwidth.

 
           		 [bookmark: pgfId-598440]Bit/sec—Valid values range from 8000 to 1000000000 bits per second, and must be in multiples of 8000.

 
          

 [bookmark: pgfId-598442]Although data bursts during an interval may exceed this rate, the average data rate over any multiple integral of the interval will not exceed this rate.

  
        

 
         
         		[bookmark: pgfId-598448]Sustained Burst

  
         		[bookmark: pgfId-598450]The normal burst size. If you select average as the shaping type, data bursts during an interval are limited to this value.

 [bookmark: pgfId-598452]The range of valid values is determined by the CIR:

 
           
           		 [bookmark: pgfId-598454]When the CIR is defined by percentage—Valid values range from 10 to 2000 milliseconds.

 
           		 [bookmark: pgfId-598456]When the CIR is defined by an absolute value—Valid values range from 1000 to 154400000 bytes, in multiples of 128 bytes.

 
          

 [bookmark: pgfId-598458]Note We recommend that you leave this field blank when the CIR is defined by an absolute value. This allows the algorithms used by the device to determine the optimal sustained burst value.

  
        

 
         
         		[bookmark: pgfId-598464]Excess Burst

  
         		[bookmark: pgfId-598466]The excess burst size. If you select peak as the shaping type, data bursts during an interval can equal the sum of the sustained burst value plus this value. The average data rate over multiple intervals, however, will continue to conform to the CIR.

 [bookmark: pgfId-598468]The range of valid values is determined by the CIR:

 
           
           		 [bookmark: pgfId-598470]When the CIR is defined by percentage—Valid values range from 10 to 2000 milliseconds.

 
           		 [bookmark: pgfId-598472]When the CIR is defined by an absolute value—Valid values range from 1000 to 154400000 bytes, in multiples of 128 bytes.

 
          

 [bookmark: pgfId-598474]Note If you do not configure this field when the CIR is defined by an absolute value, the sustained burst value is used.
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     [bookmark: pgfId-111273][bookmark: 112414][bookmark: pxchap_cncpt_ConfiguringFailover]Configuring Failover[bookmark: marker-111269][bookmark: marker-111271]
      
      
 
     
 

 
    [bookmark: pgfId-111275]The Failover page provides access to failover settings for the selected security appliance. The available settings and the overall appearance of the Failover page may change slightly, depending upon the type of device selected, its mode of operation (routed or transparent), and its context mode (single or multiple).

 
    [bookmark: pgfId-111277]In other words, how you configure failover depends upon both the operating mode and the security context of the security appliance.

 
    [bookmark: pgfId-111279]Please note the following caveats when assigning an interface as a failover link:

 
     
     		 [bookmark: pgfId-111284]You can define the interface in the Add/Edit Interface dialog box, but do not configure it. In particular,  do not specify an interface Name , as this parameter disqualifies the interface from being used as the failover link. See Managing Device Interfaces, Hardware Ports, and Bridge Groups for more information.

 
     		 [bookmark: pgfId-111286]IPv6 addresses are not supported for failover links.

 
     		 [bookmark: pgfId-111288]On an ASA 5505, an interface assigned as the backup for another interface cannot be used as a failover link (although no checking is performed to prevent this).

 
     		 [bookmark: pgfId-111290]Do not assign a PPPoE-enabled interface as a failover link. PPPoE and Failover should not be configured on the same device interface (although no checking is performed to prevent this).

 
     		 [bookmark: pgfId-111292]A failover interface cannot use the same IP address as another interface, especially the Management IP address (although no checking is performed to prevent this).

 
    

 
    [bookmark: pgfId-111294]Note also that after you assign an interface as a failover link, the interface is listed on the Interfaces page, but you cannot edit or delete the interface from that page. The only exception is if you set a physical interface to be the stateful failover link—you can configure its speed and duplex.

 
    [bookmark: pgfId-111296]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-111301]Understanding Failover

 
     		 [bookmark: pgfId-111306]Basic Failover Configuration

 
     		 [bookmark: pgfId-111311]Additional Steps for an Active/Standby Failover Configuration

 
     		 [bookmark: pgfId-111316]Failover Policies

 
    

 
   
 
    
     [bookmark: pgfId-111326][bookmark: 112441][bookmark: pxchap_cncpt_UnderstandingFailover]Understanding Failover [bookmark: marker-111322][bookmark: marker-111324]

 
    [bookmark: pgfId-111328]Failover lets you configure two identical security appliances such that one will take over firewall operations if the other fails. Using a pair of security appliances, you can provide high system availability without operator intervention.

 
    [bookmark: pgfId-111330]The linked security appliances communicate failover information over a dedicated link. This failover link can be either a LAN-based connection or, on PIX security appliances, a dedicated serial failover cable. The following information is communicated over the failover link:

 
     
     		 [bookmark: pgfId-111332]Current failover state (active or standby)

 
     		 [bookmark: pgfId-111334]“Hello” messages (also called “keep-alives”)

 
     		 [bookmark: pgfId-111336]Network link status

 
     		 [bookmark: pgfId-111338]MAC address exchange

 
     		 [bookmark: pgfId-111340]Configuration replication

 
     		 [bookmark: pgfId-111342]Per-connection state information, in the case of Stateful failover

 
    

 
     
     [image: ] 
    
 
    
 
    
     [bookmark: pgfId-111344]
     Caution All information sent over the failover link is sent in clear text unless you secure the communication with a failover key. If the security appliance is used to terminate VPN tunnels, this information includes any user names, passwords, and preshared keys used for establishing the tunnels. Transmitting this sensitive data in clear text could pose a significant security risk. We recommend securing failover communications with a failover key, particularly if you are using the security appliance to terminate VPN tunnels.
      
      
 
     

    
 
    [bookmark: pgfId-111348][bookmark: marker-111346] Cisco security appliances support two types of failover:

 
     
     		 [bookmark: pgfId-111354][bookmark: marker-111350][bookmark: marker-111352] Active/Standby – The  active security appliance inspects all network traffic, while the  standby security appliance remains idle until a failure occurs on the active appliance. Changes to the configuration of the active security appliance are transmitted over the failover link to the standby security appliance.

 
    

 
    [bookmark: pgfId-111356]When failover occurs, the standby security appliance becomes the active unit, and it assumes the IP and MAC addresses of the previously active unit. Because other devices on the network do not see any changes in the IP or MAC addresses, ARP entries do not change or time-out anywhere on the network.

 
    [bookmark: pgfId-111358]Active/Standby failover is available to security appliances operating in single- or multiple-context mode. In single-context mode, only Active/Standby failover is available, and all failover configuration is by means of the Failover page.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-111363]Note When using Active/Standby failover, you must make all configuration changes on the active unit. The active unit automatically replicates the changes to the standby unit. The standby unit should not be imported or added to the Security Manager device list.
 
Also, you must manually copy the authentication certificate from the active device to the standby device. See Additional Steps for an Active/Standby Failover Configuration for additional information.


    
     

    

    

 
     
     		 [bookmark: pgfId-111369][bookmark: marker-111365][bookmark: marker-111367] Active/Active – Both security appliances inspect network traffic by alternating their roles—such that one is active and one is standby—on a per context basis. This means Active/Active failover is available only on security appliances operating in multiple-context mode.

 
    

 
    [bookmark: pgfId-111371]However, Active/Active failover is not required in multiple-context mode. That is, on a device operating in multiple-context mode, you can configure Active/Standby or Active/Active failover. In either case, you provide system-level failover settings in the system context, and context-level failover settings in the individual security contexts.

 
    [bookmark: pgfId-111376]See Active/Active Failover for additional information about this topic.

 
    [bookmark: pgfId-111378]In addition, failover can be stateless or stateful:

 
     
     		 [bookmark: pgfId-111384][bookmark: marker-111380][bookmark: marker-111382] Stateless – Also referred to as “regular” failover. With stateless failover, all active connections are dropped when failover occurs. Clients need to re-establish connections when the new active unit takes over.

 
     		 [bookmark: pgfId-111390][bookmark: marker-111386][bookmark: marker-111388] Stateful – The active unit in the failover pair continually passes per-connection state information to the standby unit. When failover occurs, the same connection information is available on the new active unit. Supported end-user applications are not required to reconnect to maintain the current communication session.

 
    

 
    [bookmark: pgfId-111395]See Stateful Failover for more information.

 
    [bookmark: pgfId-111397]Related Topics

 
     
     		 [bookmark: pgfId-111402]Chapter 50, “Configuring Failover”

 
     		 [bookmark: pgfId-111407]Basic Failover Configuration

 
     		 [bookmark: pgfId-111412]Failover Policies

 
    

 
     
      [bookmark: pgfId-111422][bookmark: 112538][bookmark: pxchap_cncpt_ActiveActiveFailover]Active/Active Failover [bookmark: marker-111418][bookmark: marker-111420]

 
     [bookmark: pgfId-111424]Active/Active failover is available only on security appliances operating in multiple-context mode. In an Active/Active failover configuration, both security appliances inspect network traffic, on a per-context basis. That is, for each context, one of the appliances is the active device, while the other is the standby device.

 
     [bookmark: pgfId-111426]The active and standby roles are assigned over the complete set of security contexts, more or less arbitrarily.

 
     [bookmark: pgfId-111428]To enable Active/Active failover on the security appliance, you must assign the security contexts to one of two failover groups. A failover group is a simply a logical group of one or more security contexts. You should specify failover group assignments on the unit that will have failover group 1 in the active state. The admin context is always a member of failover group 1. Any unassigned security contexts are also members of failover group 1 by default.

 
     [bookmark: pgfId-111430]As in Active/Standby failover, each unit in an Active/Active failover pair is given a primary or secondary designation. Unlike Active/Standby failover, this designation does not indicate which unit is active when both units start simultaneously. Each failover group in the configuration is given a primary or secondary role preference. This preference determines the unit on which the contexts in the failover group appear in the active state when both units start simultaneously. You can have both failover groups be in the active state on a single unit in the pair, with the other unit containing the failover groups in the standby state. However, a more typical configuration is to assign each failover group a different role preference to make each one active on a different unit, balancing the traffic across the devices.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-111432]Note To reliably manage security contexts in Active/Active failover mode, Cisco Security Manager requires an IP address for the management interface of each context so that it can communicate directly with the active security context of a failover pair.


     
      

     

     

 
     [bookmark: pgfId-111438][bookmark: marker-111434][bookmark: marker-111436]Initial configuration synchronization occurs when one or both units start. This synchronization occurs as follows:

 
      
      		 [bookmark: pgfId-111440]When both units start simultaneously, the configuration is synchronized from the primary unit to the secondary unit.

 
      		 [bookmark: pgfId-111442]When one unit starts while the other unit is already active, the unit that is starting up receives the configuration from the already active unit.

 
     

 
     [bookmark: pgfId-111448][bookmark: marker-111444][bookmark: marker-111446]After both units are running, commands are replicated from one unit to the other as follows:

 
      
      		 [bookmark: pgfId-111450]Commands entered within a security context are replicated from the unit on which the security context is in the active state to the peer unit.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-111452]Note A context is considered in the active state on a unit if the failover group to which it belongs is in the active state on that unit.


     
      

     

     

 
      
      		 [bookmark: pgfId-111454]Commands entered in the system execution space are replicated from the unit on which failover group 1 is in the active state to the unit on which failover group 1 is in the standby state.

 
      		 [bookmark: pgfId-111456]Commands entered in the admin context are replicated from the unit on which failover group 1 is in the active state to the unit on which failover group 1 is in the standby state.

 
     

 
     [bookmark: pgfId-111458]Failure to enter the commands on the appropriate unit for command replication to occur will cause the configurations to be out of synchronization. Those changes may be lost the next time the initial configuration synchronization occurs.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-111460]Note When bootstrapping the peer devices in an Active/Active Failover configuration, the bootstrap configurations are only applied to the system contexts of the respective failover peer devices.


     
      

     

     

 
     [bookmark: pgfId-111462]In an Active/Active failover configuration, failover occurs on a failover group basis, not a system basis. For example, if you designate both failover groups as active on the primary unit, and failover group 1 fails, failover group 2 remains active on the primary unit, while failover group 1 becomes active on the secondary unit.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-111464]Note When configuring Active/Active failover, make sure that the combined traffic for both units is within the capacity of each unit.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-111476][bookmark: 112587][bookmark: pxchap_cncpt_StatefulFailover]Stateful Failover[bookmark: marker-111470][bookmark: marker-111472][bookmark: marker-111474]

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-111478]Note Stateful failover is not supported on the ASA 5505 appliance.


     
      

     

     

 
     [bookmark: pgfId-111480]When stateful failover is enabled, the active unit in the failover pair continually updates the current connection-state information on the standby unit. When failover occurs, supported end-user applications are not required to reconnect to maintain the current communication session.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-111482]Note The IP and MAC addresses for the state and LAN failover links do not change at failover.


     
      

     

     

 
     [bookmark: pgfId-111484]To employ stateful failover, you must configure a link to pass all state information to the standby unit. If you are using a LAN failover connection rather than the serial failover interface (which is available only on the PIX platform), you can use the same interface for the state link and the failover link. However, we recommend that you use a dedicated interface for passing state information to the standby unit.

 
     [bookmark: pgfId-111486]The following information is passed to the standby unit when stateful failover is enabled:

 
      
      		 [bookmark: pgfId-111488]NAT translation table

 
      		 [bookmark: pgfId-111490]TCP connection table (except for HTTP), including the timeout connection

 
      		 [bookmark: pgfId-111492]HTTP connection states (if HTTP replication is enabled)

 
      		 [bookmark: pgfId-111494]H.323, SIP and MGCP UDP media connections

 
      		 [bookmark: pgfId-111496]The system clock

 
      		 [bookmark: pgfId-111498]The ISAKMP and IPsec SA table

 
     

 
     [bookmark: pgfId-111500]The following information is not copied to the standby unit when stateful failover is enabled:

 
      
      		 [bookmark: pgfId-111502]HTTP connection table (unless HTTP replication is enabled)

 
      		 [bookmark: pgfId-111504]The user authentication (UAUTH) table

 
      		 [bookmark: pgfId-111506]The ARP table

 
      		 [bookmark: pgfId-111508]Routing tables

 
     

 
    
 
   
 
    
     [bookmark: pgfId-111518][bookmark: 112629][bookmark: pxchap_proc_ConfiguringBasicFailover]Basic Failover Configuration[bookmark: marker-111514][bookmark: marker-111516]

 
    [bookmark: pgfId-111520]The following steps describe basic failover configuration. Please note the following caveats when assigning an interface as a failover link:

 
     
     		 [bookmark: pgfId-111522]You can define the interface in the Add/Edit Interface dialog box, but do not configure it. In particular,  do not specify an interface Name , as this parameter disqualifies the interface from being used as the failover link.

 
     		 [bookmark: pgfId-111524]On an ASA 5505, an interface assigned as the backup for another interface cannot be used as a failover link (although no checking is performed to prevent this).

 
     		 [bookmark: pgfId-111526]Do not assign a PPPoE-enabled interface as a failover link. PPPoE and Failover should not be configured on the same device interface (although no checking is performed to prevent this).

 
     		 [bookmark: pgfId-111528]A Failover interface cannot use the same IP address as another interface, especially the Management IP address (although no checking is performed to prevent this).

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-111530]Note When you save a failover configuration, it is applied to both the security appliance and the failover peer.


    
     

    

    

 
    [bookmark: pgfId-111532]Before You Begin

 
    [bookmark: pgfId-111534]Licenses installed on the device must allow failover configurations. On ASA 5505 and 5510 devices, this failover license is an optional license. You must install the failover license outside of Security Manager, using ASDM or the device CLI, and ensure that the License Supports Failover option is selected in the General page of the device properties (right-click the device and select Device Properties). If the license is installed when you add the device to the inventory, or you install the license and then rediscover device policies, Security Manager can identify the license and set this option appropriately.

 
    [bookmark: pgfId-111536]If the option is selected and the license is not in fact installed, you will see deployment failures. If the option is not selected, Security Manager will not deploy the failover policy to the device even if you configure the policy.

 
    [bookmark: pgfId-111538]Related Topics

 
     
     		 [bookmark: pgfId-111543]Managing Device Interfaces, Hardware Ports, and Bridge Groups

 
     		 [bookmark: pgfId-111548]Understanding Failover

 
     		 [bookmark: pgfId-111553]Additional Steps for an Active/Standby Failover Configuration

 
     		 [bookmark: pgfId-111558]Failover Policies

 
    

 
    
 
    [bookmark: pgfId-111560]Step 1 Ensure Device View is your present application view; if necessary, click the Device View button on the toolbar.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-111565]Note For more information on using the Device View to configure device policies, see Managing Policies in Device View and the Site-to-Site VPN Manager.


    
     

    

    

 
    [bookmark: pgfId-111567]Step 2 Select the appliance you want to configure.

 
    [bookmark: pgfId-111569]Step 3 Expand the Platform entry in the Device Policy selector, then expand Device Admin and select Failover.

 
    [bookmark: pgfId-111571]The Failover page is displayed.

 
    [bookmark: pgfId-111573]Step 4 (PIX only) Choose the Failover Method: Serial Cable or LAN Based. If you choose Serial Cable, the LAN Failover settings are disabled; be sure the cable connecting the two devices is in place.

 
    [bookmark: pgfId-111575]Step 5 Select Enable Failover to enable failover on this appliance.

 
    [bookmark: pgfId-111577]Step 6 (Optional) Click the Settings button to open the Settings dialog box for the selected device. The contents of the Settings dialog box depend on the type of device, and whether it is operating in single or multiple mode—some options may not be available. Refer to the following sections:

 
     
     		 [bookmark: pgfId-111582]Settings Dialog Box (ASA/PIX 7+)

 
     		 [bookmark: pgfId-111587]Advanced Settings Dialog Box (FWSM)

 
    

 
    [bookmark: pgfId-111592]Step 7 Click the Bootstrap button to open the Bootstrap configuration for LAN failover dialog box, which provides bootstrap configurations that can be applied to the primary and secondary devices in a LAN failover configuration. See Bootstrap Configuration for LAN Failover Dialog Box for more information.

 
    [bookmark: pgfId-111594]Step 8 (Multiple-context devices only) In the Configuration section, select the failover mode: Active/Active or Active/Standby.

 
    [bookmark: pgfId-111596]Step 9 (Optional) Follow these steps to configure an interface for LAN Failover communications between the two devices:

 
    [bookmark: pgfId-111598] a. Assign a device Interface for LAN-based communications, and then press the Tab key on your keyboard to update the page.

 
    [bookmark: pgfId-111600]On PIX and ASA devices, this drop-down list displays the interfaces defined on the device. You can type in a port ID (e.g., gigabitethernet1), or you can choose the port if you have already defined the interface.

 
    [bookmark: pgfId-111602]On an FWSM, the Interface list is not populated with VLAN IDs; you must enter the numeric ID of the VLAN you wish to use.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-111604]Note In both cases, this cannot be a Named interface, nor can the interface be configured for PPPoE.


    
     

    

    

 
    [bookmark: pgfId-111606] b. Provide a Logical Name for this failover interface.

 
    [bookmark: pgfId-111608] c. Enter the Active IP address for failover communications.

 
    [bookmark: pgfId-111610] d. Enter a Standby IP address for failover communications. The Standby IP address is used on the security appliance that is currently the standby unit.

 
    [bookmark: pgfId-111612] e. Enter the Subnet Mask for both IP addresses. Both must be on the same subnet.

 
    [bookmark: pgfId-111614]Step 10 (Optional) Follow these steps to enable and configure an interface for Stateful Failover communications between the two devices:

 
    [bookmark: pgfId-111616] a. Assign a device Interface for update communications, and then press the Tab key on your keyboard to update the page.

 
    [bookmark: pgfId-111618]You can type in a port ID (e.g., gigabitethernet1), or you can choose the port if you have already defined the interface; note that this cannot be a Named interface.
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    [bookmark: pgfId-111620]Note On an FWSM, this is a VLAN interface.


    
     

    

    

 
    [bookmark: pgfId-111622] b. Provide a Logical Name for this interface.

 
    [bookmark: pgfId-111624] c. Enter the Active IP address for connection updates.

 
    [bookmark: pgfId-111626] d. Enter a Standby IP address for update communications.

 
    [bookmark: pgfId-111628] e. Enter the Subnet Mask for both IP addresses. Both must be on the same subnet.

 
    [bookmark: pgfId-111630] f. Select Enable HTTP Replication to preserve HTTP connection information.

 
    [bookmark: pgfId-111632]Connection information is communicated to the standby unit for all TCP protocols except HTTP, because HTTP connections are generally short-lived. Select this option to maintain HTTP connections during failover.

 
    [bookmark: pgfId-111634]Step 11 Provide a communications-encryption key: enter a Shared Key and then repeat it in the Confirm field. Be sure to enter the same key on both devices. (Not available on FWSM versions prior to 3.1)

 
    [bookmark: pgfId-111636]The Shared Key can be any arbitrary string of up to 63 alphanumeric characters. If HEX is checked, the Shared Key is an arbitrary string of exactly 32 hexadecimal characters. (The HEX option is available only on PIX/ASA version 7.0.5 and later, and FWSM versions 3.1.3 and later.)
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    [bookmark: pgfId-111638]Note This step is optional, but we strongly recommend encrypting failover communications.


    
     

    

    

 
    [bookmark: pgfId-111640]Step 12 To specify a failover reconnect timeout value for asymmetrically routed sessions, enter a length of time in the Timeout field, in the form hh:mm:ss (the minutes and seconds values are optional). If the field is blank (the default), or contains a zero, reconnections are prevented. Setting this value to -1 disables the timeout, allowing connections to reconnect after any amount of time.

 
    [bookmark: pgfId-111645]Step 13 (FWSM only) – Configured interfaces are listed in the Interface Configuration table. To edit the failover configuration for a listed interface, select it and click the Edit Row button to open the Edit Failover Interface Configuration Dialog Box.

 
    [bookmark: pgfId-111647]


    
     

    
 
    

 
     
      [bookmark: pgfId-111657][bookmark: 112775][bookmark: pxchap_cncpt_AddingAContexttoFailoverGroup2]Adding A Security Context to Failover Group 2[bookmark: marker-111653][bookmark: marker-111655]

 
     [bookmark: pgfId-111659]To add a new security context to an existing failover group 2, you must save the new context configuration to a deployment file and then manually add it to the appropriate device. Otherwise, until the first successful deployment, Security Manager will attempt to communicate with the new context through the device’s Admin context. This will fail since group 2 cannot be reached through the Admin context (unless both group 1 and 2 are active on the same device).

 
     [bookmark: pgfId-111661]The following steps outline creating a new security context and adding it to failover group 2.

 
     [bookmark: pgfId-111663] 1. Create the new security context.

 
     [bookmark: pgfId-111668]Be sure to define: context Name, Configuration URL, assign an Interface, choose Failover Group 2, and provide a Management IP Address. See Managing Security Contexts for more information.

 
     [bookmark: pgfId-111670] 2. Save and submit these changes.

 
     [bookmark: pgfId-111672] 3. Provide the following context-configuration information, saving each change as you go:

 
     [bookmark: pgfId-111677] – On the Credentials page of the Device Properties window for the new context, provide Username and Password. See Viewing or Changing Device Properties for additional information.

 
     [bookmark: pgfId-111682] – On the context’s Interfaces page, edit the assigned interface, providing a Name, IP address and Subnet Mask. See Managing Device Interfaces, Hardware Ports, and Bridge Groups for additional information.

 
     [bookmark: pgfId-111687] – On the context’s Failover Page (ASA/PIX 7.0+), edit the interface configuration to provide a Standby IP Address.

 
     [bookmark: pgfId-111692] – On the HTTP Page, check Enable HTTP Server and then define HTTP access.

 
     [bookmark: pgfId-111697] – On the Credentials page, provide the Username and Password to be used when contacting the context. See Configuring Device Credentials for additional information.

 
     [bookmark: pgfId-111699] 4. Choose Deploy from the Configuration Manager’s File menu. Submit your changes, and then in the Deploy Saved Changes dialog box, be sure only this new context is selected, and then click Edit Deploy method. In the Edit Deploy Method dialog box, change the Method to File and then specify the Destination and a file name. Click OK to close the Edit Deploy Method dialog box, and then click Deploy the Deploy Saved Changes dialog box.

 
     [bookmark: pgfId-111704]The context configuration is saved to the specified file. See Deploying to a File for more information about this step.

 
     [bookmark: pgfId-111706] 5. After uploading the configuration file to the device, use the CLI to enable HTTP access for the context. For example:

 
     
      [bookmark: pgfId-111708]ciscoasa/group2(config-if)# int g3/0
     

     
      [bookmark: pgfId-111710]ciscoasa/group2(config-if)# nameif man
     

     
      [bookmark: pgfId-111712]ciscoasa/group2(config-if)# security-level 100
     

     
      [bookmark: pgfId-111714]ciscoasa/group2(config-if)# ip add 203.0.113.176 255.255.254.0 st 203.0.113.177
     

     
      [bookmark: pgfId-111716]ciscoasa/group2(config-if)# exit
     

     
      [bookmark: pgfId-111718]ciscoasa/group2(config)# http serv ena
     

     
      [bookmark: pgfId-111720]ciscoasa/group2(config)# http 0.0.0.0 0.0.0.0 man
     

     
      [bookmark: pgfId-111722]ciscoasa/group2(config)# username cisco pass cisco
     

     
      [bookmark: pgfId-111724]ciscoasa/group2(config)#wr
     

     [bookmark: pgfId-111726]Following this process, any new changes to the context can be successfully deployed to the context with Security Manager (attempts to reach the context will not go through the Admin context’s management IP address).

 
     [bookmark: pgfId-111728]Alternative

 
     [bookmark: pgfId-111730]Another approach to this issue is to add the new context to failover group 1 first, and then perform the configuration via Security Manager. However, in order to then move this context to failover group 2, both groups (1 and 2) must be active on the same device. Otherwise, this error will be reported:

 
     
      [bookmark: pgfId-111732]"join-failover-group 2
     

     
      [bookmark: pgfId-111734]ERROR: Command requires failover-group 2 and 1 to be in the same state or no nameif comand for all interfaces in this context"
     

    
 
   
 
    
     [bookmark: pgfId-111740][bookmark: 112834][bookmark: pxchap_cncpt_AdditionalStepsforanActiveStandyFailoverConfiguration]Additional Steps for an Active/Standby Failover Configuration

 
    [bookmark: pgfId-111742]Cisco Security Manager lets you authenticate a PIX/ASA/FWSM device by validating the certificate installed on the device. When configuring firewalls in an active/standby failover configuration, you must manually copy the certificate from the active device to the standby device so that Security Manager can communicate with the standby device after a failover occurs.

 
    [bookmark: pgfId-111744]The following procedures describe how to export or display the identity certificate, CA certificate, and keys for a security appliances in your network using ASDM, and then import that information onto a standby device using ASDM.

 
     
     		 [bookmark: pgfId-111749]Exporting the Certificate to a File or PKCS12 data

 
     		 [bookmark: pgfId-111754]Importing the Certificate onto the Standby Device

 
    

 
     
      [bookmark: pgfId-111760][bookmark: 112845][bookmark: pxchap_proc_ExportingtheCertificatetoaFileorPKCSdata]Exporting the Certificate to a File or PKCS12 data

 
     [bookmark: pgfId-111762]To export a trustpoint configuration, follow these steps using ASDM:

 
     
 
     [bookmark: pgfId-111764]Step 1 Go to Configuration > Features > Device Administration > Certificate > Trustpoint > Export.

 
     [bookmark: pgfId-111766]Step 2 Fill in the Trustpoint Name, Encryption Passphrase, and Confirm Passphrase fields. For information on these fields, click Help.

 
     [bookmark: pgfId-111768]Step 3 Select a method for exporting the trustpoint configuration.

 
      
      		 [bookmark: pgfId-111770]Export to a File—Type the filename or browse for the file.

 
      		 [bookmark: pgfId-111772]Display the trustpoint configuration in PKCS12 format—Display the entire trustpoint configuration in a text box and then copy it for importing. For more information, click Help.

 
     

 
     [bookmark: pgfId-111774]Step 4 Click Export.

 
     [bookmark: pgfId-111776]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-111782][bookmark: 112866][bookmark: pxchap_proc_ImportingtheCertificateontotheStandbyDevice]Importing the Certificate onto the Standby Device

 
     [bookmark: pgfId-111784]To import a trustpoint configuration, follow these steps using ASDM:

 
     
 
     [bookmark: pgfId-111786]Step 1 Go to Configuration > Features > Device Administration > Certificate > Trustpoint > Import.

 
     [bookmark: pgfId-111788]Step 2 Fill in the Trustpoint Name, Decryption Passphrase, and Confirm Passphrase fields. For information on these fields, click Help. The decryption passphrase is the same as the encryption passphrase used when the trustpoint configuration was exported.

 
     [bookmark: pgfId-111790]Step 3 Select a method for importing the trustpoint configuration.

 
      
      		 [bookmark: pgfId-111792]Import from a File—Type the filename or browse for the file.

 
      		 [bookmark: pgfId-111794]Enter the trustpoint configuration in PKCS12 format—Paste the entire trustpoint configuration from the exported source into a text box. For more information, click Help.

 
     

 
     [bookmark: pgfId-111796]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-111806][bookmark: 112885][bookmark: pxpage_cncpt_FailoverPolicies]Failover Policies[bookmark: marker-111802][bookmark: marker-111804]

 
    [bookmark: pgfId-111808]This section lists the pages that describe configuring failover on various types of security appliances; the pages are organized by device type.

 
    [bookmark: pgfId-111810]PIX 6.x Firewalls

 
     
     		 [bookmark: pgfId-111815]Failover Page (PIX 6.3)

 
    

 
    [bookmark: pgfId-111820] – Edit Failover Interface Configuration Dialog Box (PIX 6.3)

 
    [bookmark: pgfId-111825] – Bootstrap Configuration for LAN Failover Dialog Box

 
    [bookmark: pgfId-111827]Firewall Services Modules

 
     
     		 [bookmark: pgfId-111832]Failover Page (FWSM)

 
    

 
    [bookmark: pgfId-111837] – Advanced Settings Dialog Box

 
    [bookmark: pgfId-111842] – Add/Edit Interface MAC Address Dialog Box

 
    [bookmark: pgfId-111847] – Edit Failover Interface Configuration Dialog Box

 
    [bookmark: pgfId-111852] – Bootstrap Configuration for LAN Failover Dialog Box

 
    [bookmark: pgfId-111854]Adaptive Security Appliances and PIX 7.0 Firewalls

 
     
     		 [bookmark: pgfId-111859]Failover Page (ASA/PIX 7.0+)

 
    

 
    [bookmark: pgfId-111864] – Settings Dialog Box

 
    [bookmark: pgfId-111869] – Edit Failover Group Dialog Box

 
    [bookmark: pgfId-111874] – Edit Failover Interface Configuration Dialog Box

 
    [bookmark: pgfId-111879] – Add/Edit Interface MAC Address Dialog Box

 
    [bookmark: pgfId-111884] – Bootstrap Configuration for LAN Failover Dialog Box

 
     
      [bookmark: pgfId-111896][bookmark: 112948][bookmark: pxpage_cncpt_FailoverPagePIXx]Failover Page (PIX 6.3)[bookmark: marker-111892][bookmark: marker-111894]

 
     [bookmark: pgfId-111898]Use the Failover page to configure failover settings for a PIX 6.3.x Firewall.

 
     [bookmark: pgfId-111900]Navigation Path

 
     [bookmark: pgfId-111902]Select a PIX 6.3.x device in Device View and then select Platform > Device Admin > Failover from the Device Policy selector.

 
     [bookmark: pgfId-111904]Related Topics

 
      
      		 [bookmark: pgfId-111909]Understanding Failover

 
      		 [bookmark: pgfId-111914]Failover Policies

 
     

 
     [bookmark: pgfId-111916]Field Reference

 
     [bookmark: pgfId-111919] 

 
      
       
        
        [bookmark: pgfId-109303]Table 50-1 [bookmark: 112974]Failover Page (PIX 6.3) 

 
        
       
         
         		
           
           [bookmark: pgfId-109309]Element
          
  
         		
           
           [bookmark: pgfId-109311]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-109317]Failover
          
  
        

 
         
         		[bookmark: pgfId-109325]Failover Method

  
         		[bookmark: pgfId-109327]Choose the type of failover link: Serial Cable or LAN Based. If you choose Serial Cable, ensure the physical cable is connected to both devices.

  
        

 
         
         		[bookmark: pgfId-109333]Enable Failover

  
         		[bookmark: pgfId-109335]Check this box to enable failover on this device. Ensure that both devices have the same software version, activation key type, flash memory, and RAM.

 [bookmark: pgfId-109337]On PIX devices with LAN Based chosen as the Failover Method, you must next configure the logical LAN Failover interface and, optionally, the stateful failover interface.

  
        

 
         
         		[bookmark: pgfId-109343]Bootstrap button

  
         		[bookmark: pgfId-109348]Click to display the Bootstrap Configuration for LAN Failover dialog box. See Bootstrap Configuration for LAN Failover Dialog Box for more information.

  
        

 
         
         		[bookmark: pgfId-109354]Failover Poll Time

  
         		[bookmark: pgfId-109356]Specify the amount of time between hello messages among units. Values can range from 3 to 15 seconds; default is 15.

  
        

 
         
         		 [bookmark: pgfId-109362]LAN-Based Failover

 [bookmark: pgfId-109364]These fields are available when LAN Based is the chosen Failover Method.

  
        

 
         
         		[bookmark: pgfId-109372]Interface

  
         		[bookmark: pgfId-109374]Choose the interface to be used for LAN-based failover. If “Not Selected” is chosen, LAN-based failover is disabled.

  
        

 
         
         		[bookmark: pgfId-109380]Shared Key

 [bookmark: pgfId-109382]Confirm

  
         		[bookmark: pgfId-109384]Used to encrypt communications between the primary and standby devices. Value can be any alphanumeric string.

 [bookmark: pgfId-109386]Re-enter the Shared Key in the Confirm field.

  
        

 
         
         		 [bookmark: pgfId-109392]Stateful Failover

 [bookmark: pgfId-109397](Optional) To configure Stateful Failover, provide the following parameters.

  
        

 
         
         		[bookmark: pgfId-109405]Interface

  
         		[bookmark: pgfId-109407]Choose the interface to be used for Stateful Failover. If “Not Selected” is chosen, Stateful Failover is disabled.

 [bookmark: pgfId-109409]Note You must choose a fast LAN link from the list (for example, 100full, 1000full, or 1000sxfull).

  
        

 
         
         		[bookmark: pgfId-109415]Enable HTTP Replication

  
         		[bookmark: pgfId-109417]When selected, active HTTP sessions are copied to the standby firewall. Otherwise, HTTP connections are disconnected at failover. Disabling HTTP replication reduces the amount of traffic on the state link.

  
        

 
         
         		 [bookmark: pgfId-109423]Interface Configuration

 [bookmark: pgfId-109428]The table lists all available named interfaces. To define a Standby IP address and Active and Standby MAC addresses for an interface, select it in the list and click the Edit Row button to open the Edit Failover Interface Configuration Dialog Box (PIX 6.3).

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-111933][bookmark: 113056][bookmark: pxpage_cncpt_EditFailoverInterfaceConfigurationDialogBoxPIXx]Edit Failover Interface Configuration Dialog Box (PIX 6.3)[bookmark: marker-111927][bookmark: marker-111929][bookmark: marker-111931]

 
     [bookmark: pgfId-111935]Use the Edit Failover Interface Configuration dialog box to configure failover interfaces for the selected PIX 6.3.x device.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-111937]Note The failover interface cannot be configured for PPPoE.


     
      

     

     

 
     [bookmark: pgfId-111939]Navigation Path

 
     [bookmark: pgfId-111944]You can access the Edit Failover Interface Configuration dialog box from the Interface Configuration table on the Failover Page (PIX 6.3).

 
     [bookmark: pgfId-111946]Related Topics

 
      
      		 [bookmark: pgfId-111951]Failover Policies

 
     

 
     [bookmark: pgfId-111953]Field Reference

 
     [bookmark: pgfId-111956] 

 
      
       
        
        [bookmark: pgfId-109443]Table 50-2 [bookmark: 113086]Edit Failover Interface Configuration Dialog Box (PIX 6.3) 

 
        
       
         
         		
           
           [bookmark: pgfId-109449]Element
          
  
         		
           
           [bookmark: pgfId-109451]Description
          
  
        

 
         
         		[bookmark: pgfId-109457]Interface

  
         		[bookmark: pgfId-109459]The name of the interface; read-only.

  
        

 
         
         		[bookmark: pgfId-109465]Active IP Address

  
         		[bookmark: pgfId-109467]Displays the IP address of the active interface. This address is used by the standby device to communicate with the active device. The address must be on the same network as the system IP address.

 [bookmark: pgfId-109469]The active IP address of this interface; read-only. This address is used by the standby device to communicate with the active device. This field is blank if an IP address has not been assigned to the interface.

 [bookmark: pgfId-109471]Tip You can use this IP address with the ping tool to check the status of the active device.  
        

 
         
         		[bookmark: pgfId-109477]Netmask

  
         		[bookmark: pgfId-109479]The subnet mask for the active IP address; read-only. This field is blank if an IP address has not been assigned to the interface.

  
        

 
         
         		[bookmark: pgfId-109485]Standby IP Address

  
         		[bookmark: pgfId-109487]Specify the IP address of the corresponding interface on the standby failover unit. This address is used by the active device to communicate with the standby device. The address must be on the same network as the system IP address.

 [bookmark: pgfId-109489]This field does not appear if an IP address has not been assigned to the interface.

 [bookmark: pgfId-109491]Tip You can use this IP address with the ping tool to check the status of the standby device.  
        

 
         
         		 [bookmark: pgfId-109497]Failover MAC Addresses

 [bookmark: pgfId-109499]These parameters let you define virtual MAC addresses for a physical interface that is configured for failover; these addresses are optional.

  
        

 
         
         		[bookmark: pgfId-109507]Active MAC Address

  
         		[bookmark: pgfId-109509]Specify a MAC address for the active interface in hexadecimal format (for example, 0123.4567.89ab).

  
        

 
         
         		[bookmark: pgfId-109515]Standby MAC Address

  
         		[bookmark: pgfId-109517]Specify a MAC address for the standby interface in hexadecimal format (for example, 0123.4567.89ab).

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-111968][bookmark: 113138][bookmark: pxpage_cncpt_FailoverPageFWSM]Failover Page (FWSM)[bookmark: marker-111964][bookmark: marker-111966]

 
     [bookmark: pgfId-111970]Use the Failover page to configure basic failover settings for the selected Firewall Services Module (FWSM).

 
     [bookmark: pgfId-111972]Navigation Path

 
     [bookmark: pgfId-111974]To access this feature, select a FWSM in Device View and then select Platform > Device Admin > Failover from the Device Policy selector.

 
     [bookmark: pgfId-111976]Related Topics

 
      
      		 [bookmark: pgfId-111981]Failover Policies

 
      		 [bookmark: pgfId-111986]Additional Steps for an Active/Standby Failover Configuration

 
      		 [bookmark: pgfId-111991]Bootstrap Configuration for LAN Failover Dialog Box

 
     

 
     [bookmark: pgfId-111993]Field Reference

 
     [bookmark: pgfId-111996] 

 
      
       
        
        [bookmark: pgfId-109530]Table 50-3 [bookmark: 113167]Failover Page (FWSM) 

 
        
       
         
         		
           
           [bookmark: pgfId-109536]Element
          
  
         		
           
           [bookmark: pgfId-109538]Description
          
  
        

 
         
         		[bookmark: pgfId-109544]Enable Failover

  
         		[bookmark: pgfId-109546]Check this box to enable failover on this device. Ensure that both devices have the same software version, activation key, flash memory, and RAM.

 [bookmark: pgfId-109548]You must next configure the logical LAN Failover interface and, optionally, the stateful failover interface.

  
        

 
         
         		[bookmark: pgfId-109554]Settings button

  
         		[bookmark: pgfId-109559]Click to display the Advanced Settings Dialog Box, used to define when failover should occur.

  
        

 
         
         		 [bookmark: pgfId-109565]Configuration

 [bookmark: pgfId-109567]This section is presented only for FWSM 3.1.1+ devices operating in multiple-context mode.

  
        

 
         
         		[bookmark: pgfId-109575]Active/Active

  
         		[bookmark: pgfId-109577]In an Active/Active failover configuration, both security appliances inspect network traffic, on a per-context basis. That is, for each context, one of the appliances is the active device, while the other is the standby device.

 [bookmark: pgfId-109582]To enable Active/Active failover on the device, you must assign the security contexts to one of two failover groups. A failover group is a simply a logical group of one or more security contexts. You should specify failover group assignments on the unit that will have failover group 1 in the active state. The admin context is always a member of failover group 1. Any unassigned security contexts are also members of failover group 1 by default. See Add/Edit Security Context Dialog Box (FWSM) for information about assigning a context to a failover group.

  
        

 
         
         		[bookmark: pgfId-109588]Active/Standby

  
         		[bookmark: pgfId-109590]In an Active/Standby configuration, the active security appliance handles all network traffic passing through the failover pair. The standby security appliance does not handle network traffic until a failure occurs on the active security appliance. Whenever the configuration of the active security appliance changes, it sends configuration information over the failover link to the standby security appliance.

 [bookmark: pgfId-109592]When a failover occurs, the standby security appliance becomes the active unit. It assumes the IP and MAC addresses of the previously active unit. Because the other devices on the network do not see any changes in the IP or MAC addresses, ARP entries do not change or time out.

  
        

 
         
         		 
           
           [bookmark: pgfId-109598]LAN Failover
          
  
        

 
         
         		[bookmark: pgfId-109606]VLAN

  
         		[bookmark: pgfId-109608]Enter the numeric ID of the VLAN interface you are using for the failover link; for example, 11. This list is not automatically populated with VLAN IDs—you must highlight “Not Selected” and type the desired VLAN ID number; press your keyboard’s Tab key to activate the related fields.

 [bookmark: pgfId-109610]When configured for failover, the interface is directly connected to the standby device.

  
        

 
         
         		[bookmark: pgfId-109616]Logical Name

  
         		[bookmark: pgfId-109618]Enter a logical name for the failover VLAN interface.

  
        

 
         
         		[bookmark: pgfId-109624]Active IP Address

  
         		[bookmark: pgfId-109626]Specify the active IP address for this interface.

  
        

 
         
         		[bookmark: pgfId-109632]Standby IP Address

  
         		[bookmark: pgfId-109634]Specify a standby IP address for this interface.

 [bookmark: pgfId-109636]To receive packets from both units in a failover pair, standby IP addresses need to be configured on all interfaces. The Standby IP address is used on the security appliance that is currently the standby unit, and it must be in the same subnet as the active IP address.

  
        

 
         
         		[bookmark: pgfId-109642]Subnet Mask

  
         		[bookmark: pgfId-109644]Enter the Subnet Netmask for the Active and Standby IP addresses.

  
        

 
         
         		[bookmark: pgfId-109650]Bootstrap button

  
         		[bookmark: pgfId-109655]Click to display the Bootstrap Configuration for LAN Failover dialog box. See Bootstrap Configuration for LAN Failover Dialog Box for more information.

  
        

 
         
         		 [bookmark: pgfId-109661]Stateful Failover

 [bookmark: pgfId-109666](Optional) To configure Stateful Failover, provide the following parameters.

  
        

 
         
         		[bookmark: pgfId-109674]VLAN

  
         		[bookmark: pgfId-109676]Enter the numeric ID of the VLAN interface you are using for the failover link; for example, 12. This list is not automatically populated with VLAN IDs—you must highlight “Not Selected” and type the desired VLAN ID number; press your keyboard’s Tab key to activate the related fields.

 [bookmark: pgfId-109678]When configured for failover, the interface is directly connected to the standby device.

  
        

 
         
         		[bookmark: pgfId-109684]Logical Name

  
         		[bookmark: pgfId-109686]Enter a logical name for the Stateful failover VLAN interface.

  
        

 
         
         		[bookmark: pgfId-109692]Active IP Address

  
         		[bookmark: pgfId-109694]Specify the active IP address for this interface.

  
        

 
         
         		[bookmark: pgfId-109700]Standby IP Address

  
         		[bookmark: pgfId-109702]Specify a standby IP address for this interface.

 [bookmark: pgfId-109704]To receive packets from both units in a failover pair, standby IP addresses need to be configured on all interfaces. The Standby IP address is used on the security appliance that is currently the standby unit, and it must be in the same subnet as the active IP address.

  
        

 
         
         		[bookmark: pgfId-109710]Subnet Mask

  
         		[bookmark: pgfId-109712]Enter the Subnet Netmask for the Active and Standby IP addresses.

  
        

 
         
         		[bookmark: pgfId-109718]Enable HTTP Replication

  
         		[bookmark: pgfId-109720]When selected, allows stateful failover to copy active HTTP sessions to the standby firewall. Otherwise, HTTP connections are disconnected at failover. Disabling HTTP replication reduces the amount of traffic on the state link.

  
        

 
         
         		 [bookmark: pgfId-109726]Shared Key (FWSM 3.1.1+ only)

 [bookmark: pgfId-109728]The options in this section let you encrypt the communications between the active and standby devices by providing a shared encryption key.

 
           
           [image: ] 
          
 
          
 
          
           [bookmark: pgfId-109730]Caution All information sent over the failover and Stateful Failover links is sent in clear text unless you secure the communication with a failover key. If this device is used to terminate VPN tunnels, this information includes any user names, passwords and shared keys used for establishing the tunnels. Transmitting this sensitive data in clear text could pose a significant security risk. We recommend securing the failover communications with a shared key.
            
            
 
           

          
  
        

 
         
         		[bookmark: pgfId-109738]Shared Key

 [bookmark: pgfId-109740]Confirm

  
         		[bookmark: pgfId-109742]Enter any string of characters up to 63 numbers, letters and punctuation characters. This string is used to generate the encryption key.

 [bookmark: pgfId-109744]Re-enter this string the Confirm field.

 [bookmark: pgfId-109746]If you select HEX, the entry in the Shared Key and Confirm fields must be exactly 32 hexadecimal characters (0-9, a-f).

  
        

 
         
         		 [bookmark: pgfId-109752]Interface Configuration

 [bookmark: pgfId-109754]This table is presented on the Failover page for devices operating in single-context mode, or for individual security contexts only.

 [bookmark: pgfId-109759]The table lists all available named interfaces. To enable or disable monitoring of an interface, select it in the list and click the Edit Row button to open the Edit Failover Interface Configuration Dialog Box. Select or deselect Monitor this interface for failure.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-112008][bookmark: 113311][bookmark: pxpage_cncpt_AdvancedSettingsDialogBox]Advanced Settings Dialog Box[bookmark: marker-112004][bookmark: marker-112006]

 
     [bookmark: pgfId-112010]The Advanced Settings dialog box lets you configure additional failover settings for the selected FWSM.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-112012]Note The following reference table describes all fields that can be presented in the Advanced Settings dialog box. The fields actually presented depend on operating mode (routed or transparent) and whether the device is hosting single or multiple contexts.


     
      

     

     

 
     [bookmark: pgfId-112014]Navigation Path

 
     [bookmark: pgfId-112019]You can access the Advanced Settings dialog box by clicking the Settings button on the Failover Page (FWSM).

 
     [bookmark: pgfId-112021]Related Topics

 
      
      		 [bookmark: pgfId-112026]Failover Policies

 
     

 
     [bookmark: pgfId-112028]Field Reference

 
     [bookmark: pgfId-112031] 

 
      
       
        
        [bookmark: pgfId-109774]Table 50-4 [bookmark: 113337]Advanced Settings Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-109780]Element
          
  
         		
           
           [bookmark: pgfId-109782]Description
          
  
        

 
         
         		 [bookmark: pgfId-109788]Interface Policy

 [bookmark: pgfId-109790]Select a failed-interfaces option and provide an appropriate value.

  
        

 
         
         		[bookmark: pgfId-109798]Number of failed interfaces

  
         		[bookmark: pgfId-109800]When the number of failed monitored interfaces exceeds this value, the security appliance fails over. Valid values range from 1 to 250.

  
        

 
         
         		[bookmark: pgfId-109806]Percentage of failed interfaces

  
         		[bookmark: pgfId-109808]When the number of failed monitored interfaces exceeds this percentage, the security appliance fails over.

  
        

 
         
         		 [bookmark: pgfId-109814]Failover Poll Time

 [bookmark: pgfId-109816]These fields define how often hello messages are sent on the failover link, and how long to wait before testing the peer for failure if no hello messages are received.

  
        

 
         
         		[bookmark: pgfId-109824]Unit Failover

  
         		[bookmark: pgfId-109826]The amount of time between hello messages between failover units. Enter a value between 1 and 15 seconds, or if msec is checked, between 500 and 999 milliseconds.

  
        

 
         
         		[bookmark: pgfId-109832]Unit Hold Time

  
         		[bookmark: pgfId-109834]The amount of time to wait for a hello message on the failover link, after which the unit begins testing for peer failure. Enter a value between 3 and 45 seconds. This value must be at least three times the Unit Failover value.

  
        

 
         
         		[bookmark: pgfId-109840]Monitored Interface

  
         		[bookmark: pgfId-109842]The amount of time between polls among interfaces. Enter a value between 3 and 15 seconds.

  
        

 
         
         		 [bookmark: pgfId-109848]MAC Address Mapping

 [bookmark: pgfId-109853]In Active/Standby mode, this table lists interface-virtual MAC address mappings. This is a standard Security Manager table, with Add Row, Edit Row and Delete Row buttons, which are described in Using Tables.

 [bookmark: pgfId-109858]To add or edit interface mappings, click the Add Row or Edit Row button to open the Add/Edit Interface MAC Address Dialog Box.

  
        

 
         
         		 [bookmark: pgfId-109866]Failover Groups

 [bookmark: pgfId-109871]In Active/Active mode, this table lists both failover groups. To edit failover parameters for either group, select it in the list and click the Edit Row button to open the Edit Failover Group Dialog Box.

  
        

 
         
         		 [bookmark: pgfId-109879]Bridge Group Configuration

 [bookmark: pgfId-109887]In single-context transparent mode, this table lists all currently defined bridge groups (see Managing Device Interfaces, Hardware Ports, and Bridge Groups). To add a standby IP address to a bridge group, select it in the list and click the Edit Row button to open the Edit Failover Bridge Group Configuration Dialog Box.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-112047][bookmark: 113409][bookmark: pxpage_cncpt_EditFailoverBridgeGroupConfigurationDialogBoxFWSM]Edit Failover Bridge Group Configuration Dialog Box [bookmark: marker-112039][bookmark: marker-112041][bookmark: marker-112043][bookmark: marker-112045]

 
     [bookmark: pgfId-112049]Use this dialog box to add a standby IP address to a failover bridge group.

 
     [bookmark: pgfId-112051]Navigation Path

 
     [bookmark: pgfId-112053]You can access the Edit Failover Bridge Group Configuration dialog box as follows:

 
      
      		 [bookmark: pgfId-112055]On the Failover page presented for an individual security context in transparent mode on an ASA.

 
      		 [bookmark: pgfId-112060]From the Bridge Group Configuration table in the Advanced Settings Dialog Box presented by an FWSM in transparent mode.

 
     

 
     [bookmark: pgfId-112062]Related Topics

 
      
      		 [bookmark: pgfId-112067]Failover Policies

 
      		 [bookmark: pgfId-112072]Failover Page (ASA/PIX 7.0+)

 
      		 [bookmark: pgfId-112077]Failover Page (FWSM)

 
     

 
     [bookmark: pgfId-112079]Field Reference

 
     [bookmark: pgfId-112082] 

 
      
       
        
        [bookmark: pgfId-109902]Table 50-5 [bookmark: 113452]Edit Failover Bridge Group Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-109908]Element
          
  
         		
           
           [bookmark: pgfId-109910]Description
          
  
        

 
         
         		[bookmark: pgfId-109916]Name

  
         		[bookmark: pgfId-109918]Identifies the bridge group; not editable.

  
        

 
         
         		[bookmark: pgfId-109924]IP Address

  
         		[bookmark: pgfId-109926]Identifies the IP address assigned to the bridge group; not editable.

  
        

 
         
         		[bookmark: pgfId-109932]Network Mask

  
         		[bookmark: pgfId-109934]Identifies the subnet mask for the IP Address; not editable.

  
        

 
         
         		[bookmark: pgfId-109940]Standby Address

  
         		[bookmark: pgfId-109942]Enter the IP address of the standby bridge group; this address must be on the same subnet as the primary address.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-112094][bookmark: 113485][bookmark: pxpage_cncpt_FailoverPageASAPIXx]Failover Page (ASA/PIX 7.0+)[bookmark: marker-112090][bookmark: marker-112092]

 
     [bookmark: pgfId-112096]Use the Failover page to configure basic failover settings for ASA and PIX 7.0+ security devices

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-112098]Note The features and options presented on the Failover page vary according to type of device selected, operating system version, firewall mode (routed or transparent), and security contexts (single or multiple). Thus, some of the elements described in the following table may not appear on the Failover page for your currently selected device.


     
      

     

     

 
     [bookmark: pgfId-112100]Navigation Path

 
     [bookmark: pgfId-112102]Select an ASA or PIX 7.0+ in Device View and then select Platform > Device Admin > Failover from the Device Policy selector.

 
     [bookmark: pgfId-112104]Related Topics

 
      
      		 [bookmark: pgfId-112109]Understanding Failover

 
      		 [bookmark: pgfId-112114]Failover Policies

 
      		 [bookmark: pgfId-112119]Additional Steps for an Active/Standby Failover Configuration

 
     

 
     [bookmark: pgfId-112121]Field Reference

 
     [bookmark: pgfId-112124] 

 
      
       
        
        [bookmark: pgfId-109955]Table 50-6 [bookmark: 113515]Failover Page (ASA/PIX 7.0+) 

 
        
       
         
         		
           
           [bookmark: pgfId-109961]Element
          
  
         		
           
           [bookmark: pgfId-109963]Description
          
  
        

 
         
         		[bookmark: pgfId-109969]Failover Method

  
         		[bookmark: pgfId-109971]Choose the type of failover link: Serial Cable or LAN Based. If you choose Serial Cable, ensure the physical cable is connected to both devices.

 [bookmark: pgfId-109973]Note This option is available only on PIX devices.

  
        

 
         
         		[bookmark: pgfId-109979]Enable Failover

  
         		[bookmark: pgfId-109981]Check this box to enable failover on this device. Ensure that both devices have the same software version, activation key type, flash memory, and RAM.

 [bookmark: pgfId-109983]On PIX devices with LAN Based chosen as the Failover Method, and on all ASAs, you must next configure the logical LAN Failover interface and, optionally, the stateful failover interface.

  
        

 
         
         		[bookmark: pgfId-109989]Bootstrap button

  
         		[bookmark: pgfId-109994]Click to display the Bootstrap Configuration for LAN Failover dialog box. See Bootstrap Configuration for LAN Failover Dialog Box for more information.

  
        

 
         
         		[bookmark: pgfId-110000]Settings button

  
         		[bookmark: pgfId-110005]Click to display the Settings Dialog Box, used to define when failover should occur.

  
        

 
         
         		[bookmark: pgfId-110011]Timeout

  
         		[bookmark: pgfId-110016]The failover Timeout specifies the amount of time after a system boots or becomes active that “nailed” sessions are accepted; used in conjunction with static translation rules (see Static Rules Tab for more information).

 [bookmark: pgfId-110018]Enter a value in this field to specify the failover reconnect timeout value for asymmetrically routed sessions. The value is in the form hh:mm:ss (hours:minutes:seconds); both minutes and seconds are optional.

 [bookmark: pgfId-110020]Valid values for the number of hours are -1 to 1193; the default value is 0, which means connections cannot be re-established. Setting this value to -1 disables the timeout, allowing reconnections after any amount of time.

  
        

 
         
         		 [bookmark: pgfId-110026]Configuration

 [bookmark: pgfId-110028]This section is presented only for devices operating in multiple-context mode.

  
        

 
         
         		[bookmark: pgfId-110036]Active/Active

  
         		[bookmark: pgfId-110038]In an Active/Active failover configuration, both security appliances inspect network traffic, on a per-context basis. That is, for each context, one of the appliances is the active device, while the other is the standby device.

 [bookmark: pgfId-110043]To enable Active/Active failover on the security appliance, you must assign the security contexts to one of two failover groups. A failover group is a simply a logical group of one or more security contexts. You should specify failover group assignments on the unit that will have failover group 1 in the active state. The admin context is always a member of failover group 1. Any unassigned security contexts are also members of failover group 1 by default. See Add/Edit Security Context Dialog Box (PIX/ASA) for information about assigning a context to a failover group.

  
        

 
         
         		[bookmark: pgfId-110049]Active/Standby

  
         		[bookmark: pgfId-110051]In an Active/Standby configuration, the active security appliance handles all network traffic passing through the failover pair. The standby security appliance does not handle network traffic until a failure occurs on the active security appliance. Whenever the configuration of the active security appliance changes, it sends configuration information over the failover link to the standby security appliance.

 [bookmark: pgfId-110053]When a failover occurs, the standby security appliance becomes the active unit. It assumes the IP and MAC addresses of the previously active unit. Because the other devices on the network do not see any changes in the IP or MAC addresses, ARP entries do not change or time out.

  
        

 
         
         		 
           
           [bookmark: pgfId-110059]LAN Failover
          
  
        

 
         
         		[bookmark: pgfId-110067]Interface

  
         		[bookmark: pgfId-110069]Choose the interface to use as the failover link; all interfaces available on the device are listed.

 [bookmark: pgfId-110071]When configured for failover, the interface is directly connected to the standby device.

 [bookmark: pgfId-110076]Note You can choose an EtherChannel interface as the failover link. As with any other type of interface assigned as a failover link, the EtherChannel interface cannot be named, and none of the EtherChannel’s member interfaces can be named. Further, while being used as an active failover link, changes to the interface configuration are not allowed. Refer to Configuring EtherChannels for more information.

  
        

 
         
         		[bookmark: pgfId-110082]Logical Name

  
         		[bookmark: pgfId-110084]Enter a logical name for the failover interface.

  
        

 
         
         		[bookmark: pgfId-110090]Active IP Address

  
         		[bookmark: pgfId-110092]Specify the active IP address for this interface.

  
        

 
         
         		[bookmark: pgfId-110098]Standby IP Address

  
         		[bookmark: pgfId-110100]Specify a standby IP address for this interface.

 [bookmark: pgfId-110102]To receive packets from both units in a failover pair, standby IP addresses need to be configured on all interfaces. The Standby IP address is used on the security appliance that is currently the standby unit, and it must be in the same subnet as the active IP address.

  
        

 
         
         		[bookmark: pgfId-110108]Subnet Mask

  
         		[bookmark: pgfId-110110]Enter the Subnet Netmask for the active and standby IP addresses.

  
        

 
         
         		 [bookmark: pgfId-110116]Stateful Failover

 [bookmark: pgfId-110121](Optional) To configure Stateful Failover, provide the following parameters.

  
        

 
         
         		[bookmark: pgfId-110129]Interface

  
         		[bookmark: pgfId-110131]Choose the interface to use for the stateful failover link; all interfaces available on the device are listed.

 [bookmark: pgfId-110136]Note You can choose an EtherChannel interface as the stateful failover link. As with any other type of interface assigned as a failover link, the EtherChannel interface cannot be named, and none of the EtherChannel’s member interfaces can be named. Further, while being used as an active failover link, changes to the interface configuration are not allowed. Refer to Configuring EtherChannels for more information.

  
        

 
         
         		[bookmark: pgfId-110142]Logical Name

  
         		[bookmark: pgfId-110144]Enter the logical name of the interface on the active firewall device to communicate with standby device for failover. When configured for stateful failover, the interface is directly connected to the standby device.

  
        

 
         
         		[bookmark: pgfId-110150]Active IP Address

  
         		[bookmark: pgfId-110152]Specify the IP address of the active interface.

  
        

 
         
         		[bookmark: pgfId-110158]Standby IP Address

  
         		[bookmark: pgfId-110160]Specify the IP address of the standby interface.

  
        

 
         
         		[bookmark: pgfId-110166]Subnet Mask

  
         		[bookmark: pgfId-110168]Enter the Subnet Netmask for the active and standby IP addresses.

  
        

 
         
         		[bookmark: pgfId-110174]Enable HTTP Replication

  
         		[bookmark: pgfId-110176]When selected, active HTTP sessions are copied to the standby firewall. Otherwise, HTTP connections are disconnected at failover. Disabling HTTP replication reduces the amount of traffic on the state link.

  
        

 
         
         		 [bookmark: pgfId-110182]Key

 [bookmark: pgfId-110184]The options in this section let you encrypt the communications between the active and standby devices. Select the type and provide a string of characters to produce the shared encryption key.

 
           
           [image: ] 
          
 
          
 
          
           [bookmark: pgfId-110186]Caution All information sent over the failover and Stateful Failover links is sent in clear text unless you secure the communication with a failover key. If this device is used to terminate VPN tunnels, this information includes any user names, passwords and shared keys used for establishing the tunnels. Transmitting this sensitive data in clear text could pose a significant security risk. We recommend securing the failover communications with a shared key.
            
            
 
           

          
  
        

 
         
         		[bookmark: pgfId-110194]Any string

 [bookmark: pgfId-110196]HEX

  
         		[bookmark: pgfId-110198]If you select Any string, the entry in the Shared Key field can be any combination of up to 63 numbers, letters and punctuation characters. This string is used to generate the encryption key.

 [bookmark: pgfId-110200]If you select HEX, the entry in the Shared Key and Confirm fields must be exactly 32 hexadecimal characters (0-9, a-f). This string is used as the encryption key.

  
        

 
         
         		[bookmark: pgfId-110206]Shared Key

 [bookmark: pgfId-110208]Confirm

  
         		[bookmark: pgfId-110210]Enter any string of characters appropriate to the selected key type: Any string or HEX.

 [bookmark: pgfId-110212]Re-enter the string the Confirm field.

  
        

 
         
         		 [bookmark: pgfId-110218]Interface Configuration
(in some instances, labeled Monitor Interface Configuration)

 [bookmark: pgfId-110223]This table is presented on the Failover page for ASA 8.4.1+ devices operating in single-context, transparent mode, and for individual contexts on PIX/ASA devices. Otherwise, it appears in the Settings Dialog Box.

 [bookmark: pgfId-110228]The table lists all available named interfaces. To enable or disable monitoring of an interface, select it in the list and click the Edit Row button to open the Edit Failover Interface Configuration Dialog Box. Select or deselect Monitor this interface for failure.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-112140][bookmark: 113686][bookmark: pxpage_cncpt_SettingsDialogBox]Settings Dialog Box[bookmark: marker-112136][bookmark: marker-112138]

 
     [bookmark: pgfId-112142]The Settings dialog box lets you define criteria for when failover should occur on the selected ASA or PIX 7.x appliance.

 
     [bookmark: pgfId-112144]Navigation Path

 
     [bookmark: pgfId-112149]You can access the Settings dialog box by clicking the Settings button on the Failover Page (ASA/PIX 7.0+).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-112151]Note The following reference table presents all fields that can be presented in the Settings dialog box. The fields actually presented depend on operating mode (routed or transparent) and whether the device is hosting single or multiple contexts.


     
      

     

     

 
     [bookmark: pgfId-112153]Related Topics

 
      
      		 [bookmark: pgfId-112158]Failover Policies

 
      		 [bookmark: pgfId-112163]Edit Failover Interface Configuration Dialog Box

 
      		 [bookmark: pgfId-112168]Add/Edit Interface MAC Address Dialog Box

 
      		 [bookmark: pgfId-112173]Bootstrap Configuration for LAN Failover Dialog Box

 
     

 
     [bookmark: pgfId-112175]Field Reference

 
     [bookmark: pgfId-112178] 

 
      
       
        
        [bookmark: pgfId-110243]Table 50-7 [bookmark: 113723]Settings Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-110249]Element
          
  
         		
           
           [bookmark: pgfId-110251]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-110257]Interface Policy
          
  
        

 
         
         		[bookmark: pgfId-110265]Number of failed interfaces

  
         		[bookmark: pgfId-110267]When the number of failed monitored interfaces exceeds this value, the security appliance fails over. The range is between 1 and 250 failures.

  
        

 
         
         		[bookmark: pgfId-110273]Percentage of failed interfaces

  
         		[bookmark: pgfId-110275]When the number of failed monitored interfaces exceeds this percentage, the security appliance fails over.

  
        

 
         
         		 
           
           [bookmark: pgfId-110281]Failover Poll Time
          
  
        

 
         
         		[bookmark: pgfId-110289]Unit Failover

  
         		[bookmark: pgfId-110291]The amount of time between hello messages among units. The range is between 1 and 15 seconds, or between 200 and 999 milliseconds if the Change units to msec option is checked.

  
        

 
         
         		[bookmark: pgfId-110297]Unit Hold Time

  
         		[bookmark: pgfId-110299]Sets the time during which a unit must receive a hello message on the failover link, or the unit begins the testing process for peer failure. The range is between 3 and 45 seconds, or between 800 and 999 milliseconds if the msec option is checked. You cannot enter a value that is less than three times the Unit Failover value.

  
        

 
         
         		[bookmark: pgfId-110305]Monitored Interface

  
         		[bookmark: pgfId-110307]The amount of time between polls among interfaces. The range is between 3 and 15 seconds, or between 500 and 999 milliseconds if the msec option is checked.

  
        

 
         
         		[bookmark: pgfId-110313]Interface Hold Time

  
         		[bookmark: pgfId-110315]Sets the time during which a data interface must receive a hello message, after which the peer is declared failed. Valid values are from 5 to 75 seconds. This value must be at least five times the Unit Failover value.

  
        

 
         
         		 [bookmark: pgfId-110321]Failover Groups

 [bookmark: pgfId-110326]In Active/Active mode, this table lists both failover groups. To edit failover parameters for either group, select it in the list and click the Edit Row button to open the Edit Failover Group Dialog Box.

  
        

 
         
         		 [bookmark: pgfId-110334]MAC Address Mapping

 [bookmark: pgfId-110339]In Active/Standby mode, this table lists interface-virtual MAC address mappings. This is a standard Security Manager table, with Add Row, Edit Row and Delete Row buttons, which are described in Using Tables.

 [bookmark: pgfId-110344]To add or edit interface mappings, click the Add Row or Edit Row button to open the Add/Edit Interface MAC Address Dialog Box.

  
        

 
         
         		 [bookmark: pgfId-110352]Monitor Interface Configuration

 [bookmark: pgfId-110357]In single-context mode, this table lists all available named interfaces. To define a Standby IP address for, and enable or disable monitoring of an interface, select it in the list and click the Edit Row button to open the Edit Failover Interface Configuration Dialog Box.

  
        

 
         
         		 [bookmark: pgfId-110365]Management IP Address

 [bookmark: pgfId-110370]In single-context transparent mode, this section presents the management IP address and netmask defined for the device (on the Management IP Page); you cannot change these values.

  
        

 
         
         		[bookmark: pgfId-110378]Standby

  
         		[bookmark: pgfId-110380]Enter the management IP address of the standby unit; this address must be on the same subnet as the primary address.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-112194][bookmark: 113810][bookmark: pxpage_cncpt_AddInterfaceMACAddressDialogBox]Add/Edit Interface MAC Address Dialog Box[bookmark: marker-112186][bookmark: marker-112188][bookmark: marker-112190][bookmark: marker-112192]

 
     [bookmark: pgfId-112196]The Add/Edit Interface MAC Address dialog box lets you define virtual MAC addresses for a physical interface on ASA, FWSM 3.x and PIX 7.x security appliances that are configured for failover (not available on ASA 5505 devices).

 
     [bookmark: pgfId-112198]In Active/Standby failover, the MAC addresses for the primary unit are always associated with the active IP addresses. If the secondary unit boots first and becomes active, it uses the burned-in MAC address for its interfaces. When the primary unit comes online, the secondary unit obtains the MAC addresses from the primary unit. This change can disrupt network traffic. You can configure virtual MAC addresses for each interface to ensure that the secondary unit uses the correct MAC addresses when it is the active unit, even if it comes online before the primary unit. If you do not specify virtual MAC addresses, the failover pair uses the burned-in MAC addresses.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-112200]Note You cannot configure a virtual MAC address for the failover or Stateful Failover links. The MAC and IP addresses for those links do not change during failover.


     
      

     

     

 
     [bookmark: pgfId-112202]Navigation Path

 
     [bookmark: pgfId-112207]You can open the Add/Edit Interface MAC Address dialog box from the Settings Dialog Box.

 
     [bookmark: pgfId-112209]Related Topics

 
      
      		 [bookmark: pgfId-112214]Failover Policies

 
      		 [bookmark: pgfId-112219]Failover Page (ASA/PIX 7.0+)

 
      		 [bookmark: pgfId-112224]Edit Failover Group Dialog Box

 
     

 
     [bookmark: pgfId-112226]Field Reference

 
     [bookmark: pgfId-112229] 

 
      
       
        
        [bookmark: pgfId-110393]Table 50-8 [bookmark: 113851]Add/Edit Interface MAC Address Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-110399]Element
          
  
         		
           
           [bookmark: pgfId-110401]Description
          
  
        

 
         
         		[bookmark: pgfId-110407]Physical Interface

  
         		[bookmark: pgfId-110409]Choose the physical interface on which failover virtual MAC addresses are to be configured.

  
        

 
         
         		 
           
           [bookmark: pgfId-110415]MAC Address
          
  
        

 
         
         		[bookmark: pgfId-110423]Active Interface

  
         		[bookmark: pgfId-110425]Enter a virtual MAC address for the active interface in hexadecimal format (for example, 0023.4567.89ab).

  
        

 
         
         		[bookmark: pgfId-110431]Standby Interface

  
         		[bookmark: pgfId-110433]Enter a virtual MAC address for the standby interface in hexadecimal format (for example, 0023.4567.89ab).

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-112245][bookmark: 113882][bookmark: pxpage_cncpt_EditFailoverInterfaceConfigurationDialogBoxASAPIXx]Edit Failover Interface Configuration Dialog Box [bookmark: marker-112239][bookmark: marker-112241][bookmark: marker-112243]

 
     [bookmark: pgfId-112247]Use the Edit Failover Interface Configuration dialog box to define a standby IP address for an interface, and to specify whether the status of the interface should be monitored.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-112249]Note A failover interface cannot be configured for PPPoE.


     
      

     

     

 
     [bookmark: pgfId-112251]Navigation Path

 
     [bookmark: pgfId-112259]You can access the Edit Failover Interface Configuration dialog box from the Settings Dialog Box (ASA/PIX 7.0+), Advanced Settings Dialog Box (FWSM), and from the Failover page itself for ASA 8.4.1+ devices operating in single-context transparent mode, and for individual ASA/PIX security contexts.

 
     [bookmark: pgfId-112261]Related Topics

 
      
      		 [bookmark: pgfId-112266]Failover Policies

 
      		 [bookmark: pgfId-112271]Failover Page (ASA/PIX 7.0+)

 
      		 [bookmark: pgfId-112276]Failover Page (FWSM)

 
      		 [bookmark: pgfId-112281]Edit Failover Group Dialog Box

 
     

 
     [bookmark: pgfId-112283]Field Reference

 
     [bookmark: pgfId-112286] 

 
      
       
        
        [bookmark: pgfId-110446]Table 50-9 [bookmark: 113923]Edit Failover Interface Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-110452]Element
          
  
         		
           
           [bookmark: pgfId-110454]Description
          
  
        

 
         
         		[bookmark: pgfId-110460]Interface Name

  
         		[bookmark: pgfId-110462]The name of the interface; read-only.

  
        

 
         
         		[bookmark: pgfId-110468]Active IP Address

  
         		[bookmark: pgfId-110470]The active IP address of this interface; read-only. This field is blank if an IP address has not been assigned to the interface; for example if DHCP is enabled on the interface.

  
        

 
         
         		[bookmark: pgfId-110476]Mask

  
         		[bookmark: pgfId-110478]The subnet mask for the active IP address; read-only. This field is blank if an IP address has not been assigned to the interface; for example, if DHCP is enabled on the interface.

  
        

 
         
         		[bookmark: pgfId-110484]Standby IP Address

  
         		[bookmark: pgfId-110486]Specify the IP address of the corresponding interface on the standby failover unit. This field does not appear if an IP address has not been assigned to the interface.

  
        

 
         
         		[bookmark: pgfId-110492]Monitor this interface for failure

  
         		[bookmark: pgfId-110494]Specifies whether this interface is monitored for failure: check this box to enable monitoring. The number of interfaces that can be monitored for the security appliance is 250.

 [bookmark: pgfId-110496]Hello messages are exchanged between the security appliance failover pair during every interface poll time period. The failover interface poll time is 3 to 15 seconds. For example, if the poll time is set to 5 seconds, testing begins on an interface if 5 consecutive hellos are not heard on that interface (25 seconds). Monitored failover interfaces can have the following status:

 
           
           		 [bookmark: pgfId-110498]Unknown—Initial status. This status can also mean the status cannot be determined.

 
           		 [bookmark: pgfId-110500]Normal—The interface is receiving traffic.

 
           		 [bookmark: pgfId-110502]Testing—Hello messages are not heard on the interface for five poll times.

 
           		 [bookmark: pgfId-110504]Link Down—The interface is administratively down.

 
           		 [bookmark: pgfId-110506]No Link—The physical link for the interface is down.

 
           		 [bookmark: pgfId-110508]Failed—No traffic is received on the interface, yet traffic is heard on the peer interface.

 
          

  
        

 
         
         		[bookmark: pgfId-110514]ASR Group Number

  
         		[bookmark: pgfId-110516]If this interface is part of an asymmetric routing group, provide its ASR group number. Valid values for ASR group numbers are 1 through 32.

 [bookmark: pgfId-110518]Stateful failover must be enabled for asymmetric routing support to function properly between units in failover configurations.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-112300][bookmark: 113979][bookmark: pxpage_cncpt_AddFailoverGroupDialogBox]Edit Failover Group Dialog Box[bookmark: marker-112294][bookmark: marker-112296][bookmark: marker-112298]

 
     [bookmark: pgfId-112308]Use the Edit Failover Group dialog box to configure failover parameters for groups of security contexts in an Active/Active failover configuration. See Add/Edit Security Context Dialog Box (PIX/ASA), or Add/Edit Security Context Dialog Box (FWSM), for information about assigning a context to a failover group.

 
     [bookmark: pgfId-112310]Navigation Path

 
     [bookmark: pgfId-112318]You can access the Add Failover Group dialog box from the PIX/ASA Settings Dialog Box, or the FWSM Advanced Settings Dialog Box.

 
     [bookmark: pgfId-112320]Related Topics

 
      
      		 [bookmark: pgfId-112325]Failover Policies

 
      		 [bookmark: pgfId-112330]Failover Page (ASA/PIX 7.0+)

 
      		 [bookmark: pgfId-112335]Failover Page (FWSM)

 
     

 
     [bookmark: pgfId-112337]Field Reference

 
     [bookmark: pgfId-112340] 

 
      
       
        
        [bookmark: pgfId-110531]Table 50-10 [bookmark: 114017]Edit Failover Group Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-110537]Element
          
  
         		
           
           [bookmark: pgfId-110539]Description
          
  
        

 
         
         		[bookmark: pgfId-110545]Preferred Role

  
         		[bookmark: pgfId-110547]Specifies the unit in the failover pair, primary or secondary, on which this failover group appears in the active state when both units start up simultaneously, or when the Preempt option is selected. Choose Primary or Secondary.

 [bookmark: pgfId-110549]You can have both failover groups in the active state on a single unit in the pair; however, a more typical configuration is to assign each failover group a different role to make each one active on a different unit, balancing the traffic across the devices.

  
        

 
         
         		[bookmark: pgfId-110555]Poll time interval for monitored interfaces

  
         		[bookmark: pgfId-110557]Specify the amount of time between polling of monitored interfaces. Valid values are from 3 to 15 seconds (or 500 to 999 milliseconds if msec is checked).

  
        

 
         
         		[bookmark: pgfId-110563]Hold Time

  
         		[bookmark: pgfId-110565]Specify the time period within which the group must receive a hello message, after which the other group is declared failed. Valid values are from 5 to 75 seconds.

  
        

 
         
         		[bookmark: pgfId-110571]Preempt after Reboot

  
         		[bookmark: pgfId-110573]Specifies the number of seconds that the preferred failover device should wait after rebooting before taking over as the active unit for this failover group. Valid values are from 0 to 1200 seconds.

  
        

 
         
         		[bookmark: pgfId-110579]Enable HTTP Replication

  
         		[bookmark: pgfId-110581]Indicates whether active HTTP sessions are copied to the standby device for this failover group as part of Stateful failover. If you do not allow HTTP replication, HTTP connections are disconnected at failover. Disabling HTTP replication reduces the amount of traffic on the state link. This setting overrides the HTTP replication setting on the Failover page.

  
        

 
         
         		[bookmark: pgfId-110587]Failover Criteria

  
         		[bookmark: pgfId-110589]Select a failed-interfaces criterion for this group and specify the appropriate value:

 
           
           		 [bookmark: pgfId-110591] Number of failed interfaces – When this number of interfaces have failed, failover is triggered. Valid values are 1 to 250.

 
           		 [bookmark: pgfId-110593] Percentage of failed interfaces – When this percentage of the total number of interfaces have failed, failover is triggered. Valid values are 1 to 100.

 
          

  
        

 
         
         		 [bookmark: pgfId-110599]MAC Address Mapping

 [bookmark: pgfId-110601]This table displays interfaces to which active and standby MAC addresses are mapped.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-112354][bookmark: 114078][bookmark: pxpage_cncpt_FailoverPageSecurityContext]Failover Page (Security Context)[bookmark: marker-112348][bookmark: marker-112350][bookmark: marker-112352]

 
     [bookmark: pgfId-112356]The Failover page for individual ASA and PIX 7.0+ security contexts presents the Interface Configuration table, which lists all available named interfaces.

 
     [bookmark: pgfId-112361]You can select an interface in the table and click the Edit Row button to open the Edit Failover Interface Configuration Dialog Box, where you can specify a standby IP address and an ASR group number, and enable or disable monitoring of the interface.

 
     [bookmark: pgfId-112363]For individual transparent-mode contexts on ASA 8.4.1+ devices, the Failover page also presents the Bridge Group Configuration table, which lists all currently defined failover bridge groups.

 
     [bookmark: pgfId-112368]You can select an entry in the table and click the Edit Row button to open the Edit Failover Bridge Group Configuration Dialog Box, where you can specify a standby IP address for the selected bridge group.

 
     [bookmark: pgfId-112370]Navigation Path

 
     [bookmark: pgfId-112372]Select a security context in Device View and then select Platform > Device Admin > Failover from the Device Policy selector.

 
     [bookmark: pgfId-112374]Related Topics

 
      
      		 [bookmark: pgfId-112379]Understanding Failover

 
      		 [bookmark: pgfId-112384]Failover Policies

 
      		 [bookmark: pgfId-112389]About Bridging on Firewall Devices

 
     

 
    
 
     
      [bookmark: pgfId-112407][bookmark: 114117][bookmark: pxpage_cncpt_BootstrapConfigurationforLANFailoverDialogBox]Bootstrap Configuration for LAN Failover Dialog Box[bookmark: marker-112401][bookmark: marker-112403][bookmark: marker-112405]

 
     [bookmark: pgfId-112409]The Bootstrap Configuration for LAN Failover dialog box provides you with bootstrap configuration that can be applied to the primary and secondary devices in a LAN failover configuration.

 
     [bookmark: pgfId-112411]Navigation Path

 
     [bookmark: pgfId-112413]You can access the Bootstrap Configuration for LAN Failover dialog box from the Failover page. For more information about the Failover page, see:

 
      
      		 [bookmark: pgfId-112418]Failover Page (PIX 6.3)

 
      		 [bookmark: pgfId-112423]Failover Page (FWSM)

 
      		 [bookmark: pgfId-112428]Failover Page (ASA/PIX 7.0+)

 
     

 
     [bookmark: pgfId-112430]Related Topics

 
      
      		 [bookmark: pgfId-112435]Failover Policies

 
      		 [bookmark: pgfId-112440]Additional Steps for an Active/Standby Failover Configuration

 
     

 
     [bookmark: pgfId-112442]Field Reference

 
     [bookmark: pgfId-112445] 

 
      
       
        
        [bookmark: pgfId-110616]Table 50-11 [bookmark: 114159]Bootstrap Configuration for LAN Failover Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-110622]Element
          
  
         		
           
           [bookmark: pgfId-110624]Description
          
  
        

 
         
         		[bookmark: pgfId-110630]Primary

  
         		[bookmark: pgfId-110632]Contains the bootstrap configuration for the primary device. Open a console connection to the primary device and then paste this configuration to activate failover on the device.

  
        

 
         
         		[bookmark: pgfId-110638]Secondary

  
         		[bookmark: pgfId-110640]Contains the bootstrap configuration for the secondary device. After the primary device becomes active, open a console connection to the secondary device and then paste this configuration to activate failover on the device.

  
        

 
       
      

 
     
 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-112447]Note For Active/Active Failover, the bootstrap configurations are only applied to the system contexts of the respective failover peer devices.
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     [bookmark: pgfId-116375][bookmark: 100403][bookmark: ipsvchap_cncpt_ConfiguringEventActions]Configuring Event Action Rules[bookmark: marker-116365][bookmark: marker-116367][bookmark: marker-116369][bookmark: marker-116371][bookmark: marker-116373]
      
      
 
     
 

 
    [bookmark: pgfId-116377]An IPS event is an IPS message that contains an alert, a block request, a status message, or an error message. An event action is the sensor’s response to an event. An event action happens only if the event is not filtered. Possible event actions are TCP reset, block host, block connection, IP logging, and capturing the alert trigger packet. Event actions were known as alarms in Cisco IPS versions earlier than 5.x.

 
    [bookmark: pgfId-116379]The IPS Event Actions folder is where you configure settings for the event action processing component of the sensor. These settings define the actions for the sensor to take when an event is detected.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-116384]Note You cannot use IPv6 addresses in Event Action policies in Security Manager. For more information on IPv6 support in Security Manager, see IPv6 Support in Security Manager.


    
     

    

    

 
    [bookmark: pgfId-116386]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-116391]Understanding the IPS Event Action Process

 
     		 [bookmark: pgfId-116396]Understanding IPS Event Actions

 
     		 [bookmark: pgfId-116401]Configuring Event Action Filters

 
     		 [bookmark: pgfId-116406]Configuring Event Action Overrides

 
     		 [bookmark: pgfId-116411]Configuring IPS Event Action Network Information

 
     		 [bookmark: pgfId-116416]Configuring Settings for Event Actions

 
    

 
   
 
    
     [bookmark: pgfId-116430][bookmark: 100427][bookmark: ipsvchap_cncpt_UnderstandingtheIPSEventActionProcess]Understanding the IPS Event Action Process[bookmark: marker-116422][bookmark: marker-116424][bookmark: marker-116426][bookmark: marker-116428]

 
    [bookmark: pgfId-116432]The IPS event action rules dictate the actions that the sensor performs when an event occurs. Although each signature is configured with specific actions that should be taken, the actual actions performed also depend on other factors.

 
    [bookmark: pgfId-116434]Following is the general process that occurs when inspection identifies a signature event:

 
    [bookmark: pgfId-116436] 1. A signature alert occurs with actions specified by the signature. A risk rating for the alert is calculated.

 
    [bookmark: pgfId-116440]For a detailed explanation of how risk rating is calculated, see Calculating the Risk Rating in Installing and Using Cisco Intrusion Prevention System Device Manager 7.0 on Cisco.com.

 
    [bookmark: pgfId-116445]You can influence risk ratings by configuring target value ratings and OS mappings; see Configuring IPS Event Action Network Information.

 
    [bookmark: pgfId-116447] 2. The Event Action Overrides policy is processed. If the risk rating of the event matches an override rule, the actions identified in the override rule are added to the actions defined in the signature. The overrides do not replace the actions specified in the signature.

 
    [bookmark: pgfId-116452]For information on configuring overrides, see Configuring Event Action Overrides.

 
    [bookmark: pgfId-116454] 3. The Event Action Filters policy is processed. If rules apply to the event, the rules subtract actions from the event. Thus, an action you added in a signature policy or override rule might be removed by one of your filter rules.

 
    [bookmark: pgfId-116459]For information on creating filter rules, see Configuring Event Action Filters.

 
    [bookmark: pgfId-116464] 4. Event summarization occurs, unless you turn off the summarization feature as described in Configuring Settings for Event Actions.

 
    [bookmark: pgfId-116469] 5. The actions are performed. For an explanation of possible actions, see Edit, Add, Replace Action Dialog Boxes.

 
    [bookmark: pgfId-116474] 6. A list of denied attackers is maintained, and subsequent access prevented, based on configurable settings. To change the default settings, see Configuring Settings for Event Actions.

 
   
 
    
     [bookmark: pgfId-116488][bookmark: 100476][bookmark: ipsvchap_cncpt_UnderstandingIPSEventActions]Understanding IPS Event Actions[bookmark: marker-116480][bookmark: marker-116482][bookmark: marker-116484][bookmark: marker-116486]

 
    [bookmark: pgfId-116490]When you configure an event action filter or override, or a signature, you specify an action for events that meet the rule. For signatures and overrides, you are specifying an action to add to the event; for filters, you are specifying an action to remove from the event.

 
    [bookmark: pgfId-116492]The most common action is Produce Alert, which generates an alert that you can view in your network management system, such as the Security Manager Event Viewer or CS MARS. However, there are a wide variety of actions that you can assign to an event. When looking over the possible actions, keep the following in mind:

 
     
     		 [bookmark: pgfId-116494]Many actions produce alerts in addition to the other action performed. The description for each action explains whether an alert is also produced.

 
     		 [bookmark: pgfId-116496]Cisco IOS IPS supports fewer actions for event action override or filter rules. The actions supported are Deny Attacker Inline, Deny Connection Inline, Deny Packet Inline, Product Alert, and Reset TCP Connection.

 
     		 [bookmark: pgfId-116498]Not all actions are necessarily available on all combinations of IPS software version and device type. Whenever you need to select an action, only those actions that are valid are available for selection.

 
     		 [bookmark: pgfId-116503]For deny and block actions, use the event actions settings policy to set the period of time for which addresses or packets are denied. For more information, see Configuring Settings for Event Actions.

 
    

 
     
      
       
       [bookmark: pgfId-114614]Table 40-1 [bookmark: 100507]IPS Event Actions 

 
       
      
        
        		
          
          [bookmark: pgfId-114620]Menu Command
         
  
        		
          
          [bookmark: pgfId-114622]Description
         
  
       

 
        
        		[bookmark: pgfId-114628]Deny Attacker Inline

  
        		[bookmark: pgfId-114630]Terminates the current packet and future packets from this attacker address for a specified period of time.

 [bookmark: pgfId-114632]The IPS must be operating in inline mode.

 [bookmark: pgfId-114634]For Cisco IOS IPS devices, no connection can be established from the attacker to the router until the shun time expires.

 [bookmark: pgfId-114636]Tip This is the most severe of the deny actions. It denies current and future packets from a single attacker address. For IPS appliances and service modules, you can use the IPS Device Manager to see a list of denied attackers and clear the list if necessary.  
       

 
        
        		[bookmark: pgfId-114642]Deny Attacker/Service Pair Inline

  
        		[bookmark: pgfId-114644]Does not transmit this packet and future packets on the attacker address victim port pair for a specified period of time.

 [bookmark: pgfId-114646]The IPS must be operating in inline mode.

  
       

 
        
        		[bookmark: pgfId-114652]Deny Attacker/Victim Pair Inline

  
        		[bookmark: pgfId-114654]Does not transmit this packet and future packets on the attacker/victim address pair for a specified period of time.

 [bookmark: pgfId-114656]The IPS must be operating in inline mode.

  
       

 
        
        		[bookmark: pgfId-114662]Deny Connection Inline

  
        		[bookmark: pgfId-114664]Terminates the current packet and future packets on this TCP flow. Other connections from the attacker can be established.

 [bookmark: pgfId-114666]The IPS must be operating in inline mode.

  
       

 
        
        		[bookmark: pgfId-114672]Deny Packet Inline

  
        		[bookmark: pgfId-114674]Terminates the packet.

 [bookmark: pgfId-114676]The IPS must be operating in inline mode.

 [bookmark: pgfId-114678]For Cisco IOS IPS devices, this action discards the packet without sending a reset. Cisco recommends using “drop and reset” in conjunction with alarm.

 [bookmark: pgfId-114683]Tip For IPS appliances and service modules, there is an event action override that adds this action to high risk events. You cannot delete the override. If you do not want to use it, disable the override. For more information, see Configuring Event Action Overrides.  
       

 
        
        		[bookmark: pgfId-114689]Log Attacker Packets

  
        		[bookmark: pgfId-114691]Starts IP logging on packets that contain the attacker address and sends an alert. This action causes an alert to be written to the Event Store, even if Produce Alert is not selected.

  
       

 
        
        		[bookmark: pgfId-114697]Log Pair Packets

  
        		[bookmark: pgfId-114699]Starts IP Logging on packets that contain the attacker/victim address pair. This action causes an alert to be written to the Event Store, even if Produce Alert is not selected.

  
       

 
        
        		[bookmark: pgfId-114705]Log Victim Packets

  
        		[bookmark: pgfId-114707]Starts IP Logging on packets that contain the victim address and sends an alert. This action causes an alert to be written to the Event Store, even if Produce Alert is not selected.

  
       

 
        
        		[bookmark: pgfId-114713]Modify Packet Inline

  
        		[bookmark: pgfId-114715]Modifies packet data to remove ambiguity about what the endpoint might do with the packet.

 [bookmark: pgfId-114717]Tip This option is not available for event action override or filter rules. It is available in signatures.  
       

 
        
        		[bookmark: pgfId-114723]Product Alert

  
        		[bookmark: pgfId-114725]Writes the event to the Event Store as an alert. For Cisco IOS IPS devices, the notification is sent through syslog or SDEE.

 [bookmark: pgfId-114727]Note A Produce Alert event action is added for an event when global correlation has increased the risk rating of an event, and has added either the Deny Packet Inline or Deny Attacker Inline event action.

  
       

 
        
        		[bookmark: pgfId-114733]Produce Verbose Alert

  
        		[bookmark: pgfId-114735]Includes an encoded dump of the offending packet in the alert. This action causes an alert to be written to the Event Store, even if Produce Alert is not selected.

  
       

 
        
        		[bookmark: pgfId-114741]Request Block Connection

  
        		[bookmark: pgfId-114746]Sends a request to block this connection. You must have blocking devices configured to implement this action. For more information, see Configuring IPS Blocking and Rate Limiting.

  
       

 
        
        		[bookmark: pgfId-114752]Request Block Host

  
        		[bookmark: pgfId-114754]Sends a request to block this attacker host. You must have blocking devices configured to implement this action.

  
       

 
        
        		[bookmark: pgfId-114760]Request Rate Limit

  
        		[bookmark: pgfId-114762]Sends a rate limit request to perform rate limiting. You must have rate limiting devices configured to implement this action.

  
       

 
        
        		[bookmark: pgfId-114768]Request SNMP Trap

  
        		[bookmark: pgfId-114773]Requests that the sensor send an SNMP trap notification to the configured trap destinations. This action causes an alert to be written even if Produce Alert is not selected. You must have SNMP configured on the sensor for traps to actually be sent. For more information, see Configuring SNMP.

  
       

 
        
        		[bookmark: pgfId-114779]Reset TCP Connection

  
        		[bookmark: pgfId-114781]Sends TCP resets to hijack and terminate the TCP flow, sending a reset to both the source and destination addresses. Reset TCP Connection works only on TCP signatures that analyze a single connection, for example, half-open SYN attacks. It does not work for sweeps or floods.

  
       

 
      
     

 
    
 
    [bookmark: pgfId-116510]Related Topics

 
     
     		 [bookmark: pgfId-116515]Configuring Event Action Filters

 
     		 [bookmark: pgfId-116520]Configuring Event Action Overrides

 
     		 [bookmark: pgfId-116525]Configuring Signatures

 
    

 
   
 
    
     [bookmark: pgfId-116545][bookmark: 100624][bookmark: ipsvchap_cncpt_ConfiguringEventActionFilters]Configuring Event Action Filters[bookmark: marker-116531][bookmark: marker-116533][bookmark: marker-116535][bookmark: marker-116537][bookmark: marker-116539][bookmark: marker-116541][bookmark: marker-116543]

 
    [bookmark: pgfId-116547]You can configure event action filters to remove specific actions from an event or to discard an entire event and prevent further processing by the sensor.

 
    [bookmark: pgfId-116552]Filters let the sensor perform certain actions in response to the event without requiring the sensor to perform all actions or remove the entire event. Filters work by removing actions from an event. A filter that removes all actions from an event effectively consumes the event. Before configuring filter rules, read Tips for Managing Event Action Filter Rules.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-116554]Note When filtering sweep signatures, we recommend that you do not filter the destination addresses. If there are multiple destination addresses, only the last address is used for matching the filter.


    
     

    

    

 
    [bookmark: pgfId-116556]Related Topics

 
     
     		 [bookmark: pgfId-116561]Understanding the IPS Event Action Process

 
    

 
    
 
    [bookmark: pgfId-116563]Step 1 Do one of the following to open the Event Action Filters policy:

 
     
     		 [bookmark: pgfId-116565](Device view) Select  IPS > Event Actions > Event Action Filters from the Policy selector.

 
     		 [bookmark: pgfId-116567](Policy view, IPS appliances and service modules) Select  IPS > Event Actions > Event Action Filters , then select an existing policy or create a new one.

 
     		 [bookmark: pgfId-116569](Policy view, Cisco IOS IPS devices) Select  IPS (Router) > Event Actions > Event Action Filters , then select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-116574]The table shows the existing filter rules organized into sections. The Local section is for rules defined specifically for a selected device (in Device view). For shared or inherited policies, there are also sections for mandatory and default rules. For more information about the contents of this policy, see Event Action Filters Page.

 
    [bookmark: pgfId-116579]Step 2 Select the row after which you want to create the filter rule and click the Add Row button or right-click and select Add Row. This opens the Add Filter Item dialog box. For detailed information about the options in this dialog box, see Filter Item Dialog Box.

 
    [bookmark: pgfId-116581]Tips

 
     
     		 [bookmark: pgfId-116583]If you do not select a row, the new rule is added at the end of the local scope.

 
     		 [bookmark: pgfId-116585]You can also select an existing row and edit either the entire row (by clicking the  Edit Row button) or specific cells. To edit a specific cell, right-click the cell and select the  Edit command related to the cell from the top of the context menu.

 
     		 [bookmark: pgfId-116587]You can delete a rule by selecting it and clicking the  Delete Row button.

 
     		 [bookmark: pgfId-116589]You can export the entire list of filter rules to a comma-separated values (CSV) file. Click  Export to File , navigate to an appropriate folder on the Security Manager server, change the file name if you do not like the default name, and click  Save .

 
    

 
    [bookmark: pgfId-116594]Step 3 Configure the filter rule. Following are the highlights of what you typically need to configure. For specific information on configuring the fields, and for information on fields not mentioned here, see Filter Item Dialog Box.

 
     
     		 [bookmark: pgfId-116596]Name—You must enter a name for the rule. Use a name that is meaningful to you.

 
     		 [bookmark: pgfId-116601]Signature, Subsignature ID—If the filter should apply to all signatures, use the default values. If you are targeting a specific signature, enter its signature and subsignature identifiers. You can obtain these values by finding the signature in the Signatures policy (see Signatures Page).

 
     		 [bookmark: pgfId-116603]Attacker and Victim Addresses and Ports—If the filter should apply no matter who is attacking, or who is the victim, use the default values. If you are creating a filter specific to an attacker or victim, update these fields to match the appropriate address and port.

 
     		 [bookmark: pgfId-116605]Risk Rating—You are most likely to want to change this value. The filter is applied to events that are within the minimum-maximum range you configure here. The default value, 0-100, will apply the filter rule to all events. If you configure a specific signature ID, the rating applies only to events for that signature (in which case the default risk rating might be acceptable).

 
    

 
    [bookmark: pgfId-116607]For example, you might want to target only high-risk events, such as 90-100.

 
     
     		 [bookmark: pgfId-116612]Actions to Subtract—Select the actions that you want to subtract from the event. Use Ctrl+click to select more than one action. If you select an action that is not actually assigned to an event, the filter rule essentially has no effect on the event. For more information about the actions, see Edit, Add, Replace Action Dialog Boxes.

 
     		 [bookmark: pgfId-116614]Stop on Match—Whether to define this filter rule as a stop rule. This setting determines how the remaining rules in the event action filter rules table are processed:

 
    

 
    [bookmark: pgfId-116616] – If you select this option, and an event meets the conditions of the rule, this rule is the final rule tested for the event. The actions identified by this rule are removed from the event, and the device moves on to perform all remaining actions assigned to the event.

 
    [bookmark: pgfId-116618] – If you do not select this option, then events that meet the conditions of this filter rule are also compared to subsequent rules in the event actions filters table. Subsequent rules are tested until either all rules are tested, or the event matches a stop rule.

 
    [bookmark: pgfId-116620]Click OK when you are finished defining your filter rule.

 
    [bookmark: pgfId-116622]Step 4 If you did not select the right row before adding the rule, select the new rule and use the up and down arrow buttons to position the rule appropriately. Ensure that stop rules are placed after other rules that you want applied prior to the stop.

 
    [bookmark: pgfId-116624]


    
     

    
 
    

 
     
      [bookmark: pgfId-116640][bookmark: 100726][bookmark: ipsvchap_cncpt_TipsforManagingEventActionFilterRules]Tips for Managing Event Action Filter Rules[bookmark: marker-116630][bookmark: marker-116632][bookmark: marker-116634][bookmark: marker-116636][bookmark: marker-116638]

 
     [bookmark: pgfId-116642]Following are some tips that might help you effectively manage your event action filter rules:

 
      
      		 [bookmark: pgfId-116644]Disabled rules are shown with hash marks covering the table row. To change the enabled/disabled status of a rule, right click the rule and select  Enable or  Disable as appropriate. You can also change the status when editing the rule.

 
     

 
     [bookmark: pgfId-116646]Disabling a rule is useful if you want to stop using the rule, but you might want to start using it again in the future. Disabled rules remain in the table so that you do not need to recreate them.

 
      
      		 [bookmark: pgfId-116648]For existing rules, you can edit most of the fields directly from the event actions filter rules table by right-clicking the cell and selecting the appropriate Edit command from the top portion of the context menu. For example, you can right click the Attacker Ports cell and select  Edit Attacker Ports .

 
     

 
     [bookmark: pgfId-116650]Many of these right-click commands open a version of the Edit Filter Item dialog box that contains only the selected property. Other commands simply change a value, or open a sub-menu from which you can select a value to add or remove. For example, right-clicking the Action cell provides four commands:

 
     [bookmark: pgfId-116652] – Add to Actions—Select from a list of actions to add to those already defined in the rule.

 
     [bookmark: pgfId-116654] – Delete from Actions—Select from a list of actions defined in the rule to remove from the rule.

 
     [bookmark: pgfId-116656] – Replace Actions With—Select from a list the action that you want to completely replace those defined in the rule.

 
     [bookmark: pgfId-116658] – Edit Actions—Opens a dialog box where you can select all actions for the rule. Your selection replaces the cell contents.

 
      
      		 [bookmark: pgfId-116660]Although filter rules are configured as an ordered list, the rules are not processed as a “first match wins” list, even through they are processed and applied top to bottom. Instead, each rule has a Stop property: the rule is either a stop rule or it is not a stop rule. Processing ends only if an event matches a stop rule. If an event matches a non-stop rule, the event is compared to subsequent filter rules. Thus, more than one filter rule can apply to an event. If you decide to create stop rules, ensure that you place them below all other rules that you want processed for an event.

 
     

 
     [bookmark: pgfId-116662]If you define no stop rules, each event is compared to all filter rules, and all matching rules are applied to the event in top-to-bottom order.

 
      
      		 [bookmark: pgfId-116664]You can inherit event action filter rules policies. Thus, you could configure a shared policy in Policy view that includes filter rules that you want to share among all of your devices, inherit that rule for each device (in Device view), and in Device view configure local filter rules that are unique to each device. For more information on inheriting policies, see:

 
     

 
     [bookmark: pgfId-116669] – Creating a New Shared Policy

 
     [bookmark: pgfId-116674] – Inheritance vs. Assignment

 
     [bookmark: pgfId-116679] – Inheriting or Uninheriting Rules

 
     [bookmark: pgfId-116681]Related Topics

 
      
      		 [bookmark: pgfId-116686]Configuring Event Action Filters

 
      		 [bookmark: pgfId-116691]Event Action Filters Page

 
     

 
    
 
     
      [bookmark: pgfId-116713][bookmark: 100795][bookmark: ipspage_cncpt_EventActionFiltersPage]Event Action Filters Page[bookmark: marker-116699][bookmark: marker-116701][bookmark: marker-116703][bookmark: marker-116705][bookmark: marker-116707][bookmark: marker-116709][bookmark: marker-116711]

 
     [bookmark: pgfId-116715]Use the Event Actions Filters page to configure event action filter rules. Filter rules can remove specific actions from an event or they can discard an entire event and prevent further processing by the sensor.

 
     [bookmark: pgfId-116717]Event action filters are processed as an ordered list and you can move filters up or down in the list. Filters let the sensor perform certain actions in response to the event without requiring the sensor to perform all actions or remove the entire event. Filters work by removing actions from an event. A filter that removes all actions from an event effectively consumes the event.

 
     [bookmark: pgfId-116719]Before configuring event action filter rules, read the following topics:

 
      
      		 [bookmark: pgfId-116724]Configuring Event Action Filters

 
      		 [bookmark: pgfId-116729]Tips for Managing Event Action Filter Rules

 
      		 [bookmark: pgfId-116734]Understanding the IPS Event Action Process

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-116736]Tip Disabled rules are shown with hash marks covering the table row. To change the enabled/disabled status of a rule, right click the rule and select Enable or Disable as appropriate. You can also change the status when editing the rule.


     
      

     

     

 
     [bookmark: pgfId-116738]Navigation Path

 
      
      		 [bookmark: pgfId-116740](Device view) Select  IPS > Event Actions > Event Action Filters from the Policy selector.

 
      		 [bookmark: pgfId-116742](Policy view, IPS appliances and service modules) Select  IPS > Event Actions > Event Action Filters , then select an existing policy or create a new one.

 
      		 [bookmark: pgfId-116744](Policy view, Cisco IOS IPS devices) Select  IPS (Router) > Event Actions > Event Action Filters , then select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-116746]Field Reference

 
     [bookmark: pgfId-116749] 

 
      
       
        
        [bookmark: pgfId-114794]Table 40-2 [bookmark: 100853]Event Action Filters Page 

 
        
       
         
         		
           
           [bookmark: pgfId-114800]Element
          
  
         		
           
           [bookmark: pgfId-114802]Description
          
  
        

 
         
         		[bookmark: pgfId-114808]Name

  
         		[bookmark: pgfId-114810]The name of the filter rule.

  
        

 
         
         		[bookmark: pgfId-114816]Active

  
         		[bookmark: pgfId-114818]Whether the signature is active.

 [bookmark: pgfId-114820]This cell is not available for Cisco IOS IPS policies.

  
        

 
         
         		[bookmark: pgfId-114826]IDs

  
         		[bookmark: pgfId-114828]The signature identifiers to which this rule applies.

  
        

 
         
         		[bookmark: pgfId-114834]Subs

  
         		[bookmark: pgfId-114836]The subsignature identifiers.

  
        

 
         
         		[bookmark: pgfId-114842]Attackers

  
         		[bookmark: pgfId-114844]The IP address of the attacker that triggers the filter rule, which can be a host address, an address range (such as 0.0.0.0-255.255.255.255 in the case of IPv4 or ::0-FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF in the case of IPv6), or a network/host policy object.

 . [bookmark: pgfId-114848]Note Do not create an IPv4 object and an IPv6 object with the same name; doing so leads to deployment failure.

  
        

 
         
         		[bookmark: pgfId-114854]Attack Ports

  
         		[bookmark: pgfId-114856]The port used by the attacker host that triggers the filter.

  
        

 
         
         		[bookmark: pgfId-114862]Victims

  
         		[bookmark: pgfId-114864]The IP address of the victim that triggers the filter rule, which can be a host address, an address range (such as 0.0.0.0-255.255.255.255 in the case of IPv4 or ::0-FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF in the case of IPv6), or a network/host policy object.

 . [bookmark: pgfId-114868]Note Do not create an IPv4 object and an IPv6 object with the same name; doing so leads to deployment failure.

  
        

 
         
         		[bookmark: pgfId-114874]Victim Ports

  
         		[bookmark: pgfId-114876]The port targeted by the attacker host that triggers the filter.

  
        

 
         
         		[bookmark: pgfId-114882]Actions

  
         		[bookmark: pgfId-114884]The actions that should be removed from the event when the filter is triggered.

  
        

 
         
         		[bookmark: pgfId-114890]RR

  
         		[bookmark: pgfId-114892]The risk rating range that triggers this event action filter.

 [bookmark: pgfId-114896]For a detailed explanation of how risk rating is calculated, see Calculating the Risk Rating in Installing and Using Cisco Intrusion Prevention System Device Manager 7.0 on Cisco.com.

  
        

 
         
         		[bookmark: pgfId-114902]Stop

  
         		[bookmark: pgfId-114904]Whether this is a stop rule. If Yes, then when an event meets the conditions of this rule, the filter is applied to the event but the event is not tested against the remaining rules in the event action filter rules policy.

  
        

 
         
         		[bookmark: pgfId-114910]Export to File button

  
         		[bookmark: pgfId-114912]Click this button to export the event action filters summary to a comma-separated values (CSV) file. You are prompted to select the folder on the Security Manager server and to specify a file name.

  
        

 
         
         		[bookmark: pgfId-114918]Up Row and Down Row buttons (arrow icons)

  
         		[bookmark: pgfId-114920]Click these buttons to move the selected rules up or down within a scope.

 [bookmark: pgfId-114922]Filter rules are processed in order top to bottom for each event. If the conditions of an event match those defined for a filter, and the filter has the Stop field set to Yes, that filter is applied and no additional filters are considered. Ensure that stop rules are placed after the other rules you want applied to an event.

 [bookmark: pgfId-114924]You should order the more restrictive rules before general rules in the table.

  
        

 
         
         		[bookmark: pgfId-114930]Add Row button

  
         		[bookmark: pgfId-114935]Click this button to add a filter rule to the table after the selected row using the Add Filter Item dialog box (see Filter Item Dialog Box). If you do not select a row, the rule is added at the end of the local scope.

  
        

 
         
         		[bookmark: pgfId-114941]Edit Row button

  
         		[bookmark: pgfId-114943]Click this button to edit the selected rule. You can also edit individual cells by right-clicking the cell and selecting the appropriate Edit command.

  
        

 
         
         		[bookmark: pgfId-114949]Delete Row button

  
         		[bookmark: pgfId-114951]Click this button to delete the selected rule.

 . This prevents the rule from being used, but leaves it in the table in case you want to use it again at a later time.  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-116787][bookmark: 100959][bookmark: ipspage_cncpt_FilterItemDialogBox]Filter Item Dialog Box[bookmark: marker-116775][bookmark: marker-116777][bookmark: marker-116779][bookmark: marker-116781][bookmark: marker-116783][bookmark: marker-116785]

 
     [bookmark: pgfId-116789]Use the Add or Edit Filter Item dialog box to configure an event action filter rule.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-116791]Tip For existing rules, you can edit most of these fields directly from the event actions filter rules table by right-clicking the cell and selecting the appropriate command from the top portion of the context menu. For example, you can right click the Attacker Ports cell and select Edit Attacker Ports. Many of these right-click commands open a version of the Edit Filter Item dialog box that contains only the selected property. When seeking help for these context-editing dialog boxes, look for the property description in the table below.


     
      

     

     

 
     [bookmark: pgfId-116793]Navigation Path

 
     [bookmark: pgfId-116798]From the Event Action Filters page (see Event Action Filters Page), click the Add Row button, or select a filter rule and click the Edit Row button.

 
     [bookmark: pgfId-116800]Related Topics

 
      
      		 [bookmark: pgfId-116805]Configuring Event Action Filters

 
      		 [bookmark: pgfId-116810]Tips for Managing Event Action Filter Rules

 
     

 
     [bookmark: pgfId-116812]Field Reference

 
     [bookmark: pgfId-116815] 

 
      
       
        
        [bookmark: pgfId-114966]Table 40-3 [bookmark: 101013]Filter Item Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-114972]Element
          
  
         		
           
           [bookmark: pgfId-114974]Description
          
  
        

 
         
         		[bookmark: pgfId-114980]Active

 [bookmark: pgfId-114982]Enabled

 [bookmark: pgfId-114984](Active does not apply to Cisco IOS IPS devices.)

  
         		[bookmark: pgfId-114986]Whether the filter rule is active and enabled. Active means that the filter has been put into the filter list and will take effect on filtering events. The default is that the rule is both active and enabled, which means that the rule is used when events are processed.

 [bookmark: pgfId-114988]Tips

 
           
           		 [bookmark: pgfId-114990]If a filter is active but not enabled, it will still be included in the ordering list; it will be processed, but it will not be used.

 
           		 [bookmark: pgfId-114992]If a filter is not active, then it will not be included at all in the ordering of the filters; it will not be processed at all.

 
           		 [bookmark: pgfId-114994]Disabled rules are shown in the event action filters table with cross-hatching.

 
          

  
        

 
         
         		[bookmark: pgfId-115000]Name

  
         		[bookmark: pgfId-115002]The name of the filter rule. The following characters are allowed in filter names:

 [bookmark: pgfId-115004]a-z, A-Z, 0-9, -, . (dot or period), : (colon), and _ (underscore).

  
        

 
         
         		[bookmark: pgfId-115010]Signature IDs

  
         		[bookmark: pgfId-115012]The numerical signature IDs to which the filter rule applies. You can enter a single signature ID, a comma-separated list, or a range of IDs. The default is to apply the rule to signatures in the range 900-65535.

  
        

 
         
         		[bookmark: pgfId-115018]SubSignature ID

  
         		[bookmark: pgfId-115020]The subsignature ID for the specified signature to which the filter rule applies. The subsignature ID identifies a more granular version of a broad signature, but it is not used for all signatures.

 [bookmark: pgfId-115022]Enter a subsignature ID appropriate for the signature ID you specified, or enter a range of subsignature IDs. The default value is the range of 0-255.

  
        

 
         
         		[bookmark: pgfId-115028]Attacker IPv4 Address

  
         		[bookmark: pgfId-115030]The IP address of the host that sent the offending packet. You can specify a single host IP address, a range of addresses, or the name of a network/host policy object that identifies the address or address range. Click Select to select a network/host object from a list or to create a new object.

 [bookmark: pgfId-115032]Note Do not create an IPv4 object and an IPv6 object with the same name; doing so leads to deployment failure.

 [bookmark: pgfId-115034]The default value is a range of all IPv4 addresses (0.0.0.0-255.255.255.255).

  
        

 
         
         		[bookmark: pgfId-115040]Attacker IPv6 Address

  
         		[bookmark: pgfId-115042]The IP address of the host that sent the offending packet. You can specify a single host IP address, a range of addresses, or the name of a network/host policy object that identifies the address or address range. Click Select to select a network/host object from a list or to create a new object.

 [bookmark: pgfId-115044]Note Do not create an IPv4 object and an IPv6 object with the same name; doing so leads to deployment failure.

 [bookmark: pgfId-115046]The default value is a range of all IPv6 addresses (::0-FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF).

  
        

 
         
         		[bookmark: pgfId-115052]Attacker Port

  
         		[bookmark: pgfId-115054]The port used by the attacker host. This is the port from which the offending packet originated. You can also enter a range of ports.

 [bookmark: pgfId-115056]The default value is a range of all ports (0-65535).

  
        

 
         
         		[bookmark: pgfId-115062]Victim IPv4 Address

  
         		[bookmark: pgfId-115064]The IP address of the host being attacked (the recipient of the offending packet). You can specify a single host IP address, a range of addresses, or the name of a network/host policy object that identifies the address or address range. Click Select to select a network/host object from a list or to create a new object.

 [bookmark: pgfId-115066]Note Do not create an IPv4 object and an IPv6 object with the same name; doing so leads to deployment failure.

 [bookmark: pgfId-115068]The default value is a range of all IPv4 addresses (0.0.0.0-255.255.255.255).

  
        

 
         
         		[bookmark: pgfId-115074]Victim IPv6 Address

  
         		[bookmark: pgfId-115076]The IP address of the host being attacked (the recipient of the offending packet). You can specify a single host IP address, a range of addresses, or the name of a network/host policy object that identifies the address or address range. Click Select to select a network/host object from a list or to create a new object.

 [bookmark: pgfId-115078]Note Do not create an IPv4 object and an IPv6 object with the same name; doing so leads to deployment failure.

 [bookmark: pgfId-115080]The default value is a range of all IPv6 addresses (::0-FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF).

  
        

 
         
         		[bookmark: pgfId-115086]Victim Port

  
         		[bookmark: pgfId-115088]The port of the host being attacked (the recipient of the offending packet). This is the port to which the offending packet was sent. You can also enter a range of ports.

 [bookmark: pgfId-115090]The default value is a range of all ports (0-65535).

  
        

 
         
         		[bookmark: pgfId-115096]Risk Rating Min. and Max.

  
         		[bookmark: pgfId-115098]The risk rating range, between 0 and 100, that should be used to trigger this event action filter. The default value is the complete range (0-100).

 [bookmark: pgfId-115100]If an event occurs with a risk rating that falls within the minimum-maximum range you configure here, the event is processed against the rules of this event filter.

  
        

 
         
         		[bookmark: pgfId-115106]OS Relevance

  
         		[bookmark: pgfId-115108]Indicates whether the alert is relevant to the OS that has been identified for the victim. Possible values include one or more of the following: Not Relevant, Relevant, Unknown. Use Ctrl+click to select multiple values. The default is all values selected.

 [bookmark: pgfId-115110]Note OS Relevance is applicable only to appliances and service modules running IPS 6.x+ software. For Cisco IOS IPS devices, this field is read-only and cannot be edited, and for IPS 5.x devices, this field is blank.

  
        

 
         
         		[bookmark: pgfId-115116]Comments

  
         		[bookmark: pgfId-115118]The user comments associated with this filter, such as an explanation of the purpose of the rule.

  
        

 
         
         		[bookmark: pgfId-115124]Actions to Subtract

  
         		[bookmark: pgfId-115129]The actions that should be removed from the event, should the conditions of the event meet the criteria of the event action filter. You can select one or more actions in this list box. All selected actions are removed from the event. Use Ctrl+click to select multiple values. For more information about the possible actions, see Edit, Add, Replace Action Dialog Boxes.

 [bookmark: pgfId-115131]For IOS IPS devices, the possible values are restricted to the following:

 
           
           		 [bookmark: pgfId-115136] Deny Attacker Inline blocks the attacker’s source IP address completely. No connection can be established from the attacker to the router until the shun time expires. You can configure this time in the Event Actions Settings policy as described in Configuring Settings for Event Actions.

 
           		 [bookmark: pgfId-115138] Deny Connection Inline blocks the appropriate TCP flow from the attacker. Other connections from the attacker can be established to the router.

 
           		 [bookmark: pgfId-115140] Deny Packet Inline discards the packet without sending a reset. Cisco recommends using “drop and reset” in conjunction with alarm.

 
           		 [bookmark: pgfId-115142] Produce Alert sends a notification about the attack through syslog or SDEE.

 
           		 [bookmark: pgfId-115144] Reset TCP Connection is effective for TCP-based connections and sends a reset to both the source and destination addresses. For example, in case of a half-open SYN attack, Cisco IOS IPS can reset the TCP connections.

 
          

  
        

 
         
         		[bookmark: pgfId-115150]% to Deny

  
         		[bookmark: pgfId-115152]The percentage of packets to deny for deny attacker features. The range is 0 to 100. The default is 100 percent.

 [bookmark: pgfId-115154]Note For IOS IPS devices, this field is read only and cannot be edited.

  
        

 
         
         		[bookmark: pgfId-115160]Stop on Match

  
         		[bookmark: pgfId-115162]Whether to define this filter rule as a stop rule. This setting determines how the remaining rules in the event action filter rules table are processed:

 
           
           		 [bookmark: pgfId-115164]If you select this option, and an event meets the conditions of the rule, this rule is the final rule tested for the event. The actions identified by this rule are removed from the event, and the device moves on to perform all remaining actions assigned to the event.

 
           		 [bookmark: pgfId-115166]If you do not select this option, then events that meet the conditions of this filter rule are also compared to subsequent rules in the event actions filters table. Subsequent rules are tested until either all rules are tested, or the event matches a stop rule.

 
          

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-116835][bookmark: 101159][bookmark: ipsvchap_cncpt_ConfiguringEventActionOverrides]Configuring Event Action Overrides[bookmark: marker-116823][bookmark: marker-116825][bookmark: marker-116827][bookmark: marker-116829][bookmark: marker-116831][bookmark: marker-116833]

 
    [bookmark: pgfId-116837]You can add an event action override to change the actions associated with an event based on the risk rating of that event. Event action overrides are a way to add event actions globally without having to configure each signature individually.

 
    [bookmark: pgfId-116839]Each event action has an associated risk rating range. If a signature event occurs and the risk rating for that event falls within the range for an event action, that action is added to the event. For example, if you want any event with a risk rating of 85 or more to generate an SNMP trap, you can create an event action override for Request SNMP Trap with the risk rating 85-100.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-116844]Tip If you want to prevent the use of action overrides, you can disable the entire event action override component as described in Configuring Settings for Event Actions.


    
     

    

    

 
    [bookmark: pgfId-116846]Related Topics

 
     
     		 [bookmark: pgfId-116851]Understanding the IPS Event Action Process

 
    

 
    
 
    [bookmark: pgfId-116853]Step 1 Do one of the following to open the Event Action Overrides policy:

 
     
     		 [bookmark: pgfId-116855](Device view) Select  IPS > Event Actions > Event Action Overrides from the Policy selector.

 
     		 [bookmark: pgfId-116857](Policy view, IPS appliances and service modules) Select  IPS > Event Actions > Event Action Overrides , then select an existing policy or create a new one.

 
     		 [bookmark: pgfId-116859](Policy view, Cisco IOS IPS devices) Select  IPS (Router) > Event Actions > Event Action Overrides , then select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-116861]The table shows the existing overrides, including the action, the risk rating of the alerts the action will be added to, and whether the rule is enabled. The order of the rules does not matter: all overrides that apply to an alert add the associated actions.

 
    [bookmark: pgfId-116863]The table can have at most a single entry for each possible action.

 
    [bookmark: pgfId-116865]Step 2 Configure the desired overrides:

 
     
     		 [bookmark: pgfId-116870]To add a new override, click the  Add Row (+) button beneath the table and fill in the Add Event Action Rule dialog box. In the dialog box, select the action you want to add, enter the rating range of the alerts to which you are adding the action (for example, 90-100), and click  OK . For more information, see Add or Edit Event Action Rule Dialog Box.

 
    

 
    [bookmark: pgfId-116872]The risk rating range must be between 0 and 100. Separate the low and high of the range with a hyphen, for example, 80-90.

 
    [bookmark: pgfId-116874]When adding a new override, you can define your own risk rating, or you can use a pre-defined Risk Rating policy object; beginning with Version 4.5, Security Manager has several pre-defined Risk Rating policy objects:

 
    [bookmark: pgfId-116876] – Extreme Risk (90-100)

 
    [bookmark: pgfId-116878] – High Risk (76-90)

 
    [bookmark: pgfId-116880] – Medium-High Risk (61-75)

 
    [bookmark: pgfId-116882] – Medium Risk (46-60)

 
    [bookmark: pgfId-116884] – Medium-Low Risk (30-45)

 
    [bookmark: pgfId-116886] – Low Risk (16-30)

 
    [bookmark: pgfId-116888] – Very Low Risk (1-15)

 
    [bookmark: pgfId-116893]For more information on these pre-defined policy objects, refer to Configuring Risk Rating Policy Objects.

 
    [bookmark: pgfId-116895]These pre-defined policy objects cannot be edited, but you can add and edit any of your own policy objects that you have defined.

 
     
     		 [bookmark: pgfId-116897]To edit an override, to disable it or to change the risk rating, select the override and click the  Edit Row (pencil) button. You cannot change the event action.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-116899]Note Re-discovery of an IPS device will replace the Risk Rating policy object’s value with its inline value. For example, if you assign the High Risk policy object (80-89) to any of the event actions and deploy it to the device, then after re-discovery that policy object’s value will be replaced with its inline value of 80-89.


    
     

    

    

 
     
     		 [bookmark: pgfId-116901]To remove an override, select it and click the  Delete Row button.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-116903]Note Policies for IPS appliances and service modules include a default override for Deny Packet Inline, which you cannot delete. If you do not want to use that override, disable it.


    
     

    

    

 
     
     		 [bookmark: pgfId-116905]To export the entire list of overrides to a comma-separated values (CSV) file, click  Export to File , navigate to an appropriate folder on the Security Manager server, change the file name if you do not like the default name, and click  Save .

 
    

 
    [bookmark: pgfId-116907]


    
     

    
 
    

 
     
      [bookmark: pgfId-116915][bookmark: 101250][bookmark: ipspage_cncpt_AddEditEventActionRuleDialogBox]Add or Edit Event Action Rule Dialog Box

 
     [bookmark: pgfId-116917]Use the Add or Edit Event Action Rule dialog box to add an event action rule based on one of the pre-defined Risk Rating policy objects that are available in Security Manager beginning with Version 4.5.

 
     [bookmark: pgfId-116919]Navigation Path

 
     [bookmark: pgfId-116924]From the Event Action Overrides policy, click the Add Row button beneath the overrides table, or select a row in the table and click the Edit Row button. For information on opening the Event Action Overrides policy, see Configuring Event Action Overrides.

 
     [bookmark: pgfId-116926]Field Reference

 
     [bookmark: pgfId-116929] 

 
      
       
        
        [bookmark: pgfId-115179]Table 40-4 [bookmark: 101263]Add or Edit Event Action Rule Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-115185]Element
          
  
         		
           
           [bookmark: pgfId-115187]Description
          
  
        

 
         
         		[bookmark: pgfId-115193]Risk Rating

  
         		[bookmark: pgfId-115195]One of several pre-defined Risk Rating policy objects that are available in Security Manager beginning with Version 4.5:

 
           
           		 [bookmark: pgfId-115197]Extreme Risk (90-100)

 
           		 [bookmark: pgfId-115199]High Risk (76-90)

 
           		 [bookmark: pgfId-115201]Medium-High Risk (61-75)

 
           		 [bookmark: pgfId-115203]Medium Risk (46-60)

 
           		 [bookmark: pgfId-115205]Medium-Low Risk (30-45)

 
           		 [bookmark: pgfId-115207]Low Risk (16-30)

 
           		 [bookmark: pgfId-115209]Very Low Risk (1-15)

 
          

 [bookmark: pgfId-115214]For more information on using one of these pre-defined Risk Rating policy objects, or defining your own, refer to Configuring Event Action Overrides.

  
        

 
         
         		[bookmark: pgfId-115220]Assigned

  
         		[bookmark: pgfId-115222]Whether a particular action is assigned to at least one of the Risk Rating policy objects.

  
        

 
         
         		[bookmark: pgfId-115228]Action Name

  
         		[bookmark: pgfId-115230]The action to be taken for a particular Risk Rating when assigned.

  
        

 
         
         		[bookmark: pgfId-115236]Enabled

  
         		[bookmark: pgfId-115238]Whether a particular action is enabled. Deselect this option to temporarily disable an action without deleting it.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-116937][bookmark: 101311][bookmark: pobjpage_cncpt_AddEditRiskRating]Configuring Risk Rating Policy Objects

 
     [bookmark: pgfId-116939]Use the Risk Rating Policy Object Dialog Box to configure policy objects for IPS. Seven pre-defined policy objects are available for risk rating; you can also define your own.

 
     [bookmark: pgfId-116941]Navigation Path

 
     [bookmark: pgfId-116943]Select Manage > Policy Objects > All Object Types, then select Risk Rating from the Object Type selector. Right-click inside the work area, then select New Object or right-click a row and select Edit Object. You cannot edit the pre-defined policy objects, however.

 
     [bookmark: pgfId-116948]Depending upon whether you selected New Object or Edit Object, the Add Risk Rating or Edit Risk Rating dialog box appears: refer to Add or Edit Event Action Rule Dialog Box

 
     [bookmark: pgfId-116950]The remainder of this topic describes the fields that you see in the Risk Rating Policy Object dialog box.

 
     [bookmark: pgfId-116952]Related Topics

 
      
      		 [bookmark: pgfId-116957]Configuring Event Action Overrides

 
      		 [bookmark: pgfId-116962]Add or Edit Event Action Rule Dialog Box

 
     

 
     [bookmark: pgfId-116964]Field Reference

 
     [bookmark: pgfId-116967] 

 
      
       
        
        [bookmark: pgfId-115251]Table 40-5 [bookmark: 101339]Risk Rating Policy Object Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-115257]Element
          
  
         		
           
           [bookmark: pgfId-115259]Description
          
  
        

 
         
         		[bookmark: pgfId-115265]Name

  
         		[bookmark: pgfId-115267]The name of a pre-defined policy object, such as "High Risk," or the name of a policy object that you have defined.

  
        

 
         
         		[bookmark: pgfId-115273]Range

  
         		[bookmark: pgfId-115275]The Risk Rating of a particular policy object, expressed as a numerical range.

  
        

 
         
         		[bookmark: pgfId-115281]Category

  
         		[bookmark: pgfId-115283]Allows you to select Cat-A through Cat-G.

 [bookmark: pgfId-115288]This is the category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-115294]Overrides

  
         		[bookmark: pgfId-115296]Whether any IPS event action overrides have been configured for this policy object

  
        

 
         
         		[bookmark: pgfId-115302]Description

  
         		[bookmark: pgfId-115304]A text description that you can provide; applies to policy objects that you have defined, not to pre-defined policy objects.

  
        

 
         
         		[bookmark: pgfId-115310]Last Ticket(s)

  
         		[bookmark: pgfId-115312]The last ticket used for this policy object.

  
        

 
         
         		[bookmark: pgfId-115318]Last Modified Date

  
         		[bookmark: pgfId-115320]The last date on which this policy object was modified.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-116977][bookmark: 101387][bookmark: ipsvchap_cncpt_AddEditRiskRatingDialogBox]Add or Edit Risk Rating Dialog Box

 
     [bookmark: pgfId-116979]Use the Add or Edit Risk Rating dialog box to define policy objects for IPS Risk Rating.

 
     [bookmark: pgfId-116981]Navigation Path

 
     [bookmark: pgfId-116983]Select Manage > Policy Objects > All Object Types, then select Risk Rating from the Object Type selector. Right-click inside the work area, then select New Object or right-click a row and select Edit Object. You cannot edit the pre-defined policy objects, however.

 
     [bookmark: pgfId-116985]Related Topics

 
      
      		 [bookmark: pgfId-116990]Configuring Event Action Overrides

 
      		 [bookmark: pgfId-116995]Add or Edit Event Action Rule Dialog Box

 
     

 
     [bookmark: pgfId-116997]Field Reference

 
     [bookmark: pgfId-117000] 

 
      
       
        
        [bookmark: pgfId-115333]Table 40-6 [bookmark: 101411]Add or Edit Risk Rating Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-115339]Element
          
  
         		
           
           [bookmark: pgfId-115341]Description
          
  
        

 
         
         		[bookmark: pgfId-115347]Name

  
         		[bookmark: pgfId-115349]The name of a pre-defined policy object, such as "High Risk," or the name of a policy object that you have defined.

  
        

 
         
         		[bookmark: pgfId-115355]Description

  
         		[bookmark: pgfId-115357]A text description that you can provide; applies to policy objects that you have defined, not to pre-defined policy objects.

  
        

 
         
         		[bookmark: pgfId-115363]Range

  
         		[bookmark: pgfId-115365]The Risk Rating of a particular policy object, expressed as a numerical range.

  
        

 
         
         		[bookmark: pgfId-115371]Category

  
         		[bookmark: pgfId-115376]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-115382]Allow Value Override per Device

 [bookmark: pgfId-115384]Overrides

 [bookmark: pgfId-115386]Edit button

  
         		[bookmark: pgfId-115394]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-115396]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-117018][bookmark: 101456][bookmark: ipsvchap_cncpt_ConfiguringNetworkInformation]Configuring IPS Event Action Network Information[bookmark: marker-117008][bookmark: marker-117010][bookmark: marker-117012][bookmark: marker-117014][bookmark: marker-117016]

 
    [bookmark: pgfId-117020]Use the Event Actions Network Information policy to configure these features:

 
     
     		 [bookmark: pgfId-117022] Target value ratings (IPv4 Target Value Ratings tab and IPv6 Target Value Ratings tab) —You can configure the target value ratings of your network assets. The sensor uses these ratings when calculating the overall risk rating of an alert. By identifying your mission-critical assets, you can trigger more severe signature event actions. As the names indicate, you can use IPv4 or IPv6 by selecting the appropriate tab.

 
    

 
    [bookmark: pgfId-117024]Target value rating is available on IPS appliances, service modules, and Cisco IOS IPS devices.

 
    [bookmark: pgfId-117029]For more information, see Configuring Target Value Ratings.

 
     
     		 [bookmark: pgfId-117031] Passive OS fingerprinting and OS mappings (OS Identification tab) —You can enable the sensor to use information about the operating system running on a device to determine the attack relevance rating, which is a component of the overall risk rating.

 
    

 
    [bookmark: pgfId-117033]Passive OS fingerprinting and OS mappings are available on devices running IPS 6.x+ software only, and are not available on Cisco IOS IPS devices.

 
    [bookmark: pgfId-117035]For more information, see:

 
    [bookmark: pgfId-117040] – Understanding Passive OS Fingerprinting

 
    [bookmark: pgfId-117045] – Configuring OS Identification (Cisco IPS 6.x and Later Sensors Only)

 
    [bookmark: pgfId-117047]To open the Network Information policy, do one of the following:

 
     
     		 [bookmark: pgfId-117049](Device view) Select  IPS > Event Actions > Network Information from the Policy selector.

 
     		 [bookmark: pgfId-117051](Policy view, IPS appliances and service modules) Select  IPS > Event Actions > Network Information , then select an existing policy or create a new one.

 
     		 [bookmark: pgfId-117053](Policy view, Cisco IOS IPS devices) Select  IPS (Router) > Event Actions > Network Information , then select an existing policy or create a new one.

 
    

 
     
      [bookmark: pgfId-117071][bookmark: 101508][bookmark: ipsvchap_cncpt_ConfiguringTargetValueRatings]Configuring Target Value Ratings[bookmark: marker-117059][bookmark: marker-117061][bookmark: marker-117063][bookmark: marker-117065][bookmark: marker-117067][bookmark: marker-117069]

 
     [bookmark: pgfId-117073]You can assign target value ratings to your network assets. The target value rating is one of the factors used to calculate the risk rating value for each alert. It identifies the perceived importance of a network asset, which you identify by its IP address.

 
     [bookmark: pgfId-117075]You can develop a security policy that is more stringent for valuable corporate resources and looser for less important resources. For example, you could assign a target value rating to the company web server that is higher than the target value rating you assign to a desktop node. In this example, attacks against the company web server have a higher risk rating than attacks against the desktop node. Events with a higher risk rating trigger more severe signature event actions.

 
     [bookmark: pgfId-117077]You can configure four value ratings. From highest value to lowest: Mission Critical, High, Medium, Low, No Value (zero value).

 
     [bookmark: pgfId-117081]For a detailed explanation of how risk rating is calculated, see Calculating the Risk Rating in Installing and Using Cisco Intrusion Prevention System Device Manager 7.0 on Cisco.com.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-117086]Tip If you are configuring target value ratings on a device that uses IPS 6.0 software lower than 6.0(5), you might also want to update the OS Identification tab of the Network Information policy to get around a software bug, even if you do not need to create OS maps. For detailed information, see Configuring OS Identification (Cisco IPS 6.x and Later Sensors Only).


     
      

     

     

 
     [bookmark: pgfId-117088]Related Topics

 
      
      		 [bookmark: pgfId-117093]Configuring IPS Event Action Network Information

 
      		 [bookmark: pgfId-117098]Understanding the IPS Event Action Process

 
     

 
     
 
     [bookmark: pgfId-117100]Step 1 Do one of the following to open the Network Information policy:

 
      
      		 [bookmark: pgfId-117102](Device view) Select  IPS > Event Actions > Network Information from the Policy selector, then click the  IPv4 Target Value Ratings tab or the  IPv6 Target Value Ratings tab.

 
      		 [bookmark: pgfId-117104](Policy view, IPS appliances and service modules) Select  IPS > Event Actions > Network Information , then select an existing policy or create a new one. Click the  IPv4 Target Value Ratings tab or the  IPv6 Target Value Ratings tab.

 
      		 [bookmark: pgfId-117106](Policy view, Cisco IOS IPS devices) Select  IPS (Router) > Event Actions > Network Information , then select an existing policy or create a new one. Click the  IPv4 Target Value Ratings tab.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-117108]Note Cisco IOS IPS devices do not support IPv6.


     
      

     

     

 
     [bookmark: pgfId-117110]The tab shows the target value ratings that are already configured, showing the IP addresses associated with each configured ratings category. The table can have at most five entries, one per rating category.

 
     [bookmark: pgfId-117112]Step 2 Configure the desired target value ratings categories:

 
      
      		 [bookmark: pgfId-117117]To add a new ratings category, click the  Add Row (+) button beneath the table and fill in the Add Target Value Rating dialog box. In the dialog box, select the rating you want to add, enter the host, network, and address ranges to associate with the category, and click  OK . For more information, see Target Value Rating Dialog Box.

 
     

 
     [bookmark: pgfId-117119]For IPv4 addresses, you can specify a single network/host object, or a comma-separated list of host, network, or address ranges, such as 10.10.10.10, 10.10.10.0/24, or 10.10.10.2-10.10.10.254. Addresses that you enter in the network format are converted to address ranges. For IPv6 addresses, use IPv6 addressing conventions.

 
      
      		 [bookmark: pgfId-117121]To edit the IP addresses in an existing ratings category, select the category and click the  Edit Row (pencil) button. You cannot change the value rating.

 
      		 [bookmark: pgfId-117123]To remove a rating, select it and click the  Delete Row button.

 
     

 
     [bookmark: pgfId-117125]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-117135][bookmark: 101580][bookmark: ipspage_cncpt_TargetValueRatingDialogBox]Target Value Rating Dialog Box[bookmark: marker-117133]

 
     [bookmark: pgfId-117137]Use the Add or Edit Target Value Rating dialog box to associate the IP addresses of your assets to a ratings category. IP addresses are IPv4 when you open the Target Value Rating dialog box from the IPv4 Target Value Ratings tab; they are IPv6 from the IPv6 tab.

 
     [bookmark: pgfId-117139]Navigation Path

 
     [bookmark: pgfId-117144]From the IPv4 Target Value Rating tab or the IPv6 Target Value Rating tab of the IPS Event Actions Network Information policy, click the Add Row button beneath the Target Value Ratings table, or select a row in the table and click the Edit Row button. For information on opening the IPv4 Target Value Rating tab or the IPv6 Target Value Rating tab, see Configuring Target Value Ratings.

 
     [bookmark: pgfId-117146]Field Reference

 
     [bookmark: pgfId-117149] 

 
      
       
        
        [bookmark: pgfId-115409]Table 40-7 [bookmark: 101596]Target Value Rating Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-115415]Element
          
  
         		
           
           [bookmark: pgfId-115417]Description
          
  
        

 
         
         		[bookmark: pgfId-115423]Value

  
         		[bookmark: pgfId-115425]The target value rating to associate with the specified addresses. From highest to lowest importance: Mission Critical, High, Medium, Low, No Value.

 [bookmark: pgfId-115427]This list includes only those value ratings that you have not already configured in the target value ratings table.

 [bookmark: pgfId-115429]You change this option when editing a ratings category.

  
        

 
         
         		[bookmark: pgfId-115435]target-address

  
         		[bookmark: pgfId-115437]The IP addresses of the network assets assigned to this value rating. You can specify addresses using the following techniques:

 
           
           		 [bookmark: pgfId-115439]Enter the name of a single network/host object, or click  Select to select an object from a list or to create a new one. The object can contain a group of networks, hosts, and address ranges.

 
           		 [bookmark: pgfId-115441]A comma-separated list of host or network addresses or address ranges. For example, using IPv4, 10.10.10.0/24, 10.10.10.10, 10.10.10.2-10.10.10.254. Addresses that you enter in the network format are converted to address ranges; for example, 10.10.10.0/24 is converted to 10.10.10.0-10.10.10.255.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-117161][bookmark: 101626][bookmark: ipsvchap_cncpt_UnderstandingPassiveOSFingerprinting]Understanding Passive OS Fingerprinting[bookmark: marker-117155][bookmark: marker-117157][bookmark: marker-117159]

 
     [bookmark: pgfId-117163]Passive operating system (OS) fingerprinting is enabled by default on IPS 6.0+ sensors and the IPS contains a default vulnerable OS list for each signature.

 
     [bookmark: pgfId-117165]Passive OS fingerprinting lets the sensor determine the OS that hosts are running. The sensor analyzes network traffic between hosts and stores the OS of these hosts with their IP addresses. The sensor inspects TCP SYN and SYNACK packets exchanged on the network to determine the OS type.

 
     [bookmark: pgfId-117167]The sensor then uses the OS of the target host OS to determine the relevance of the attack to the victim by computing the attack relevance rating component of the risk rating. Based on the relevance of the attack, the sensor may alter the risk rating of the alert for the attack or the sensor may filter the alert for the attack. You can then use the risk rating to reduce the number of false positive alerts (a benefit in IDS mode) or definitively drop suspicious packets (a benefit in IPS mode). Passive OS fingerprinting also enhances the alert output by reporting the victim OS, the source of the OS identification, and the relevance to the victim OS in the alert.

 
     [bookmark: pgfId-117169]Passive OS fingerprinting consists of three components:

 
      
      		 [bookmark: pgfId-117171]Passive OS learning.

 
     

 
     [bookmark: pgfId-117173]Passive OS learning occurs as the sensor observes traffic on the network. Based on the characteristics of TCP SYN and SYNACK packets, the sensor makes a determination of the OS running on the host of the source IP address.

 
      
      		 [bookmark: pgfId-117175]User-configurable OS identification.

 
     

 
     [bookmark: pgfId-117177]You can configure OS host mappings, which take precedence over learned OS mappings.

 
      
      		 [bookmark: pgfId-117179]Computation of attack relevance rating and risk rating.

 
     

 
     [bookmark: pgfId-117181]The sensor uses OS information to determine the relevance of the attack signature to the targeted host. The attack relevance is the attack relevance rating component of the risk rating value for the attack alert.

 
     [bookmark: pgfId-117183]There are three sources of OS information. The sensor ranks the sources of OS information in the following order:

 
     [bookmark: pgfId-117188] 1. Configured OS mappings—OS mappings that you enter on the OS Identification tab of the Event Actions Network Information policy. You can configure different mappings for each virtual sensor. For more information, see Configuring OS Identification (Cisco IPS 6.x and Later Sensors Only).

 
     [bookmark: pgfId-117190]We recommend configuring OS mappings to define the identity of the OS running on critical systems. It is best to configure OS mappings when the OS and IP address of the critical systems are unlikely to change.

 
     [bookmark: pgfId-117192] 2. Imported OS mappings—OS mappings imported from Management Center for Cisco Security Agents (CSA MC).

 
     [bookmark: pgfId-117197]Imported OS mappings are global and apply to all virtual sensors. For information on configuring the sensor to use CSA MC, see Configuring the External Product Interface.

 
     [bookmark: pgfId-117199] 3. Learned OS mappings—OS mappings observed by the sensor through the fingerprinting of TCP packets with the SYN control bit set.

 
     [bookmark: pgfId-117201]Learned OS mappings are local to the virtual sensor that sees the traffic.

 
     [bookmark: pgfId-117203]When the sensor needs to determine the OS for a target IP address, it consults the configured OS mappings. If the target IP address is not in the configured OS mappings, the sensor looks in the imported OS mappings. If the target IP address is not in the imported OS mappings, the sensor looks in the learned OS mappings. If it cannot find it there, the sensor treats the OS of the target IP address as unknown.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-117205]Tip You can configure Event Action Filter rules to use the OS relevancy value of the target, and configure signatures to identify the OSes vulnerable to a signature.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-117221][bookmark: 101667][bookmark: ipsvchap_cncpt_ConfiguringOSIdentificationCiscoIPSxSensorsOnly]Configuring OS Identification (Cisco IPS 6.x and Later Sensors Only)[bookmark: marker-117211][bookmark: marker-117213][bookmark: marker-117215][bookmark: marker-117217][bookmark: marker-117219]

 
     [bookmark: pgfId-117223]Use the OS Identification tab on the Event Actions Network Information policy to configure operating system (OS) host mappings, which take precedence over learned OS mappings. On the OS Identifications tab you can add, edit, and delete configured OS maps. You can move them up and down in the list to change the order in which the sensor computes the attack relevance rating and risk rating for that particular IP address and OS type combination.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-117225]Note OS Identification applies to IPS 6.0+ sensors only and does not apply to Cisco IOS IPS devices.


     
      

     

     

 
     [bookmark: pgfId-117228]You can also move them up and down in the list to change the order in which the sensor resolves the OS associated with a particular IP address. Configured OS mappings allow for ranges, so for network 192.168.1.0/24 you might define the following:

 
      
       
       
         
         		 
           
           [bookmark: pgfId-115448]IP Address Range Set
          
  
         		 
           
           [bookmark: pgfId-115450]OS
          
  
        

 
         
         		[bookmark: pgfId-115456]192.168.1.1

  
         		[bookmark: pgfId-115458]IOS

  
        

 
         
         		[bookmark: pgfId-115464]192.168.1.2-192.168.1.10,192.168.1.25

  
         		[bookmark: pgfId-115466]UNIX

  
        

 
         
         		[bookmark: pgfId-115472]192.168.1.1-192.168.1.255

  
         		[bookmark: pgfId-115474]Windows

  
        

 
       
      

 
     
 
     [bookmark: pgfId-117230]More specific mappings should be at the beginning of the list. Overlap in the IP address range sets is allowed, but the entry closest to the beginning of the list takes precedence.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-117232]Tip There is a bug in IPS 6.0 versions lower than 6.0(5) related to the Network Information policy. Even if you change nothing on the OS Identification tab, but you make configuration changes to the Threat Value Ratings tab, Security Manager configures the device to use the any variable for restricting OS mappings to addresses. This can result in your monitoring application showing “any” as the event locality for all events. The solution is to upgrade the IPS version on your sensor. The workaround is to enter a non-default value in the Restrict to these IP Addresses field on the OS Identification tab, even if you are not configuring specific OS mappings. For example, enter 0.0.0.1-255.255.255.255 instead of “any” or 0.0.0.0-255.255.255.255.


     
      

     

     

 
     [bookmark: pgfId-117234]Navigation Path

 
      
      		 [bookmark: pgfId-117236](Device view) Select  IPS > Event Actions > Network Information from the Policy selector, then click the  OS Identification tab.

 
      		 [bookmark: pgfId-117238](Policy view, IPS appliances and service modules) Select  IPS > Event Actions > Network Information , then select an existing policy or create a new one. Click the  OS Identification tab.

 
     

 
     [bookmark: pgfId-117240]Related Topics

 
      
      		 [bookmark: pgfId-117245]Configuring IPS Event Action Network Information

 
      		 [bookmark: pgfId-117250]Understanding the IPS Event Action Process

 
     

 
     [bookmark: pgfId-117252]Field Reference

 
     [bookmark: pgfId-117255] 

 
      
       
        
        [bookmark: pgfId-115487]Table 40-8 [bookmark: 101738]OS Identification Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-115493]Element
          
  
         		
           
           [bookmark: pgfId-115495]Description
          
  
        

 
         
         		[bookmark: pgfId-115501]Enable Passive OS Fingerprinting

  
         		[bookmark: pgfId-115503]When selected, lets the sensor perform passive OS analysis. You must enable this option for any of the maps configured on this page to be used.

 [bookmark: pgfId-115505]Passive OS fingerprinting functions as part of the sensor. As the sensor analyzes network traffic between hosts, the sensor stores the identity of the OS running on the hosts alongside the IP addresses of the hosts. The sensor determines the identity of the OSes on the hosts by inspecting characteristics of the packets exchanged on the network. The sensor then uses the target system’s OS information to compute the ARR (Attack Relevance Rating) component for the RR (Risk Rating). The RR can then be used to drop suspicious packets.

 [bookmark: pgfId-115510]For more information about passive OS fingerprinting, see Understanding Passive OS Fingerprinting.

  
        

 
         
         		[bookmark: pgfId-115516]Restricted to these IP Addresses

  
         		[bookmark: pgfId-115518]Restricts attack relevance rating calculation to the specified addresses. You can specify addresses using the following techniques:

 
           
           		 [bookmark: pgfId-115520]Enter the name of a single network/host object, or click  Select to select an object from a list or to create a new one. The object can contain a group of networks, hosts, and address ranges.

 
           		 [bookmark: pgfId-115522]A comma-separated list of host or network addresses or address ranges. For example, 10.10.10.0/24, 10.10.10.10, 10.10.10.2-10.10.10.254.

 
          

  
        

 
         
         		[bookmark: pgfId-115528]OS Maps table

  
         		[bookmark: pgfId-115530]The list of OS mappings, showing the IP addresses of the hosts and the operating systems to which they are mapped. When looking for a match, the sensor goes from top to bottom and selects the first rule that matches the IP address.

 
           
           		 [bookmark: pgfId-115535]To add a mapping, click the  Add Row button and fill in the Add OS Map dialog box (see OS Map Dialog Box).

 
           		 [bookmark: pgfId-115537]To edit a mapping, select the rule and click the  Edit Row button.

 
           		 [bookmark: pgfId-115539]To delete a map, select it and click the  Delete Row button.

 
           		 [bookmark: pgfId-115541]To change the priority of a rule, select it and click the  Up or  Down arrow buttons until the rule is positioned correctly.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-117265][bookmark: 101786][bookmark: ipspage_cncpt_OSMapDialogBox]OS Map Dialog Box[bookmark: marker-117263]

 
     [bookmark: pgfId-117267]Use the Add or Edit OS Map dialog box to map a host through its IP address to an OS type. Create mappings only if you want to statically assign an OS type to an IP address. Because the sensor uses passive OS fingerprinting to discover the OS associated with an IP address, you might not want to create any mappings, or create mappings only for mission-critical devices that have static IP addresses. Update any mappings that you create if you install devices with different operating systems on the address.

 
     [bookmark: pgfId-117269]Navigation Path

 
     [bookmark: pgfId-117274]From the OS Identification tab of the IPS Event Actions Network Information policy, click the Add Row button beneath the OS Maps table, or select a row in the table and click the Edit Row button. For information on opening the OS Identification tab, see Configuring OS Identification (Cisco IPS 6.x and Later Sensors Only).

 
     [bookmark: pgfId-117276]Field Reference

 
     [bookmark: pgfId-117279] 

 
      
       
        
        [bookmark: pgfId-115554]Table 40-9 [bookmark: 101802]OS Map Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-115560]Element
          
  
         		
           
           [bookmark: pgfId-115562]Description
          
  
        

 
         
         		[bookmark: pgfId-115568]IP Addresses

  
         		[bookmark: pgfId-115570]The IP addresses for this mapping. You can specify addresses using the following techniques:

 
           
           		 [bookmark: pgfId-115572]Enter the name of a single network/host object, or click  Select to select an object from a list or to create a new one. The object can contain a group of networks, hosts, and address ranges.

 
           		 [bookmark: pgfId-115574]A comma-separated list of host or network addresses or address ranges. For example, 10.10.10.0/24, 10.10.10.10, 10.10.10.2-10.10.10.254.

 
          

  
        

 
         
         		[bookmark: pgfId-115580]OS Type

  
         		[bookmark: pgfId-115582]The operating system running on the identified hosts. Select the most appropriate option from the list. You can select multiple options (using Ctrl+click) to indicate that there is more than one possible OS.

 [bookmark: pgfId-115587]Tip Because these mappings take precedence over learned mappings, you probably are better off not assigning General OS, Other, or Unknown OS. The sensor might be able to learn the actual OS through passive OS fingerprinting and provide a better matching. For more information, see Understanding Passive OS Fingerprinting.  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-117297][bookmark: 101833][bookmark: ipsvchap_cncpt_ConfiguringSettingsforEventActions]Configuring Settings for Event Actions[bookmark: marker-117287][bookmark: marker-117289][bookmark: marker-117291][bookmark: marker-117293][bookmark: marker-117295]

 
    [bookmark: pgfId-117299]Use the Event Actions Settings policy to configure general settings that apply globally to event action rules. The defaults for these options are appropriate for most situations, so change them only if you are certain that your situation requires non-default behavior.

 
    [bookmark: pgfId-117301]To configure the Event Actions Settings policy, do one of the following:

 
     
     		 [bookmark: pgfId-117303](Device view) Select  IPS > Event Actions > Settings from the Policy selector.

 
     		 [bookmark: pgfId-117305](Policy view, IPS appliances and service modules) Select  IPS > Event Actions > Settings , then select an existing policy or create a new one.

 
     		 [bookmark: pgfId-117307](Policy view, Cisco IOS IPS devices) Select  IPS (Router) > Event Actions > Event Action Settings , then select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-117309]The following table describes the options you can configure. Note that the options available for Cisco IOS IPS devices are more limited than those available for IPS appliances and service modules.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-117311]Tip Do not disable the Summarizer or Meta Event Generator except for troubleshooting purposes. If you disable the Summarizer, every signature is set to Fire All with no summarization. If you disable the Meta Event Generator, all Meta engine signatures are disabled.


    
     

    

    

 
    [bookmark: pgfId-117314] 

 
     
      
       
       [bookmark: pgfId-115600]Table 40-10 [bookmark: 101869]Event Actions Settings Policy 

 
       
      
        
        		
          
          [bookmark: pgfId-115606]Element
         
  
        		
          
          [bookmark: pgfId-115608]Description
         
  
       

 
        
        		[bookmark: pgfId-115614]Enable Event Action Override

 [bookmark: pgfId-115616](All device types.)

  
        		[bookmark: pgfId-115621]When selected, enables override rules as defined on the Event Action Overrides page. You can add an event action override to add actions to an event based on specific details about that event. For configuring override rules, see Configuring Event Action Overrides.

  
       

 
        
        		[bookmark: pgfId-115627]Enable Event Action Filters

 [bookmark: pgfId-115629](All device types.)

  
        		[bookmark: pgfId-115634]When selected, enables the filter rules as defined on the Event Action Filters page. You can configure event action filters to remove specific actions from an event or to discard an entire event and prevent further processing by the sensor. For configuring event action filters rules, see Configuring Event Action Filters.

  
       

 
        
        		[bookmark: pgfId-115640]Enable Event Action Summarizer

 [bookmark: pgfId-115642](IPS appliances and service modules only.)

  
        		[bookmark: pgfId-115644]When selected, enables the Summarizer component. The Summarizer groups events into a single alert, thus decreasing the number of alerts the sensor sends out.

 [bookmark: pgfId-115646]By default, the Summarizer is enabled. If you disable it, all signatures are set to Fire All with no summarization. If you configure individual signatures to summarize, this configuration is ignored when the Summarizer is not enabled.

 [bookmark: pgfId-115648]The Report Manager component of Cisco Security Manager reports events individually. The Event Viewer component of Cisco Security Manager displays alerts. As stated above, the Summarizer groups events into a single alert, thus decreasing the number of alerts the sensor sends out.

 [bookmark: pgfId-115650]Tip Cisco IPS Manager Express (IME) and Cisco Security Manager do not summarize events in precisely the same way.  
       

 
        
        		[bookmark: pgfId-115656]Enable Meta Event Generator

 [bookmark: pgfId-115658](IPS appliances and service modules only.)

  
        		[bookmark: pgfId-115660]When selected, enables the Meta Event Generator. The Meta Event Generator processes the component events, which lets the sensor watch for suspicious activity transpiring over a series of events.

 [bookmark: pgfId-115662]By default, the Meta Event Generator is enabled. If you disable the Meta Event Generator, all Meta engine signatures are disabled.

  
       

 
        
        		[bookmark: pgfId-115668]Enable Threat Rating Adjustment

 [bookmark: pgfId-115670](IPS appliances and service modules only.)

  
        		[bookmark: pgfId-115672]When selected, enables threat rating adjustment, which adjusts the risk rating. If disabled, risk rating is equal to threat rating. Available in sensors running IPS 6.0+ software only.

 [bookmark: pgfId-115674]The Threat Rating feature provides a single view of the threat environment of the network. Threat Rating minimizes alarms and events through a customized view that shows only events with a high Threat Rating value. The Threat Rating value is derived as follows:

 
          
          		 [bookmark: pgfId-115676]Dynamic adjustment of event Risk Rating based on success of response action

 
          		 [bookmark: pgfId-115678]If response action was applied, Risk Rating is deprecated (Threat Rating < Risk Rating)

 
          		 [bookmark: pgfId-115680]If response action was not applied, Risk Rating remains unchanged (Threat Rating = Risk Rating)

 
         

 [bookmark: pgfId-115682]The result is a single value by which the threat risk is determined.

  
       

 
        
        		[bookmark: pgfId-115688]Deny Attacker Duration in seconds

 [bookmark: pgfId-115690](All device types.)

  
        		[bookmark: pgfId-115692]The number of seconds to deny the attacker inline.

 [bookmark: pgfId-115694]The range is 0 to 518400. The default is 3600.

  
       

 
        
        		[bookmark: pgfId-115700]Block Attack Duration in minutes

 [bookmark: pgfId-115702](IPS appliances and service modules only.)

  
        		[bookmark: pgfId-115704]The number of minutes to block a host or connection.

 [bookmark: pgfId-115706]The range is 0 to 10000000. The default is 30.

  
       

 
        
        		[bookmark: pgfId-115712]Maximum Number of Denied Attackers

 [bookmark: pgfId-115714](IPS appliances and service modules only.)

  
        		[bookmark: pgfId-115716]Limits the number of denied attackers possible in the system at any one time.

 [bookmark: pgfId-115718]The range is 0 to 100000000. The default is 10000.

  
       

 
        
        		[bookmark: pgfId-115724]Enable One Way TCP Reset

 [bookmark: pgfId-115726](IPS appliances and service modules only.)

  
        		[bookmark: pgfId-115728]When selected, enables a one-way TCP reset for deny packet inline actions for TCP-based alerts. Available only for sensors running IPS 6.1+ software.

 [bookmark: pgfId-115730]The one-way TCP reset operates for inline mode only and is an automatic addition to the deny packet inline actions. It sends a TCP reset to the victim of the alert, thus creating a black hole for the attacker and clearing the TCP resources of the victim.

 [bookmark: pgfId-115732]Tips

 
          
          		 [bookmark: pgfId-115734]In inline mode, all packets entering or leaving the network must pass through the sensor.

 
          		 [bookmark: pgfId-115736]An inline sensor denies packets for any alert with a risk rating of greater than or equal to 90. It also issues a one-way TCP reset on TCP alerts with a risk rating of greater than or equal to 90.
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     [bookmark: pgfId-804770][bookmark: 145615][bookmark: rtlogng_intro_ConfiguringLogging]Configuring Logging Policies
      
      
 
     
 

 
    [bookmark: pgfId-804772]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-804777]Logging on Cisco IOS Routers

 
     		 [bookmark: pgfId-804782]Syslog Logging Setup Policy Page

 
     		 [bookmark: pgfId-804787]Syslog Servers Policy Page

 
     		 [bookmark: pgfId-804792]NetFlow Policy Page

 
    

 
   
 
    
     [bookmark: pgfId-804812][bookmark: 145617][bookmark: rtchap_cncpt_LoggingonCiscoIOSRouters]Logging on Cisco IOS Routers[bookmark: marker-804798][bookmark: marker-804800][bookmark: marker-804802][bookmark: marker-804804][bookmark: marker-804806][bookmark: marker-804808][bookmark: marker-804810]

 
    [bookmark: pgfId-804814]Security Manager provides the following policies for configuring logging on a Cisco IOS router:

 
     
     		 [bookmark: pgfId-804819]Syslog Logging Setup—Enable the syslog-logging feature, and define basic logging parameters. For more information, see Defining Syslog Logging Setup Parameters.

 
     		 [bookmark: pgfId-804824]Syslog Servers—Define the remote servers to which syslog messages are sent. For more information, see Defining Syslog Servers.

 
     		 [bookmark: pgfId-804829]NetFlow—Enable NetFlow logging by providing parameters and interfaces. See Defining NetFlow Parameters for more information.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-804831]Note We strongly recommend configuring a Network Time Protocol (NTP) policy on all routers on which logging is enabled. NTP synchronization provides accurate timestamps for syslog messages, which is essential for comparing logs on multiple devices.


    
     

    

    

 
     
      [bookmark: pgfId-804839][bookmark: 145653][bookmark: rtchap_proc_DefiningLoggingSetupParameters]Defining Syslog Logging Setup Parameters[bookmark: marker-804837]

 
     [bookmark: pgfId-804841]This procedure describes enabling syslog logging on the router, and defining which messages are sent to a syslog server. In addition, you can optionally define:

 
      
      		 [bookmark: pgfId-804843]The source interface for all syslog messages sent from this device.

 
      		 [bookmark: pgfId-804845]The messages that are saved to a local buffer.

 
      		 [bookmark: pgfId-804847]An origin identifier added to each message.

 
      		 [bookmark: pgfId-804849]A rate limit on the number of messages that can be sent.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-804854]Note To send syslog messages from the router to a syslog server, you must also define the IP address of the syslog server. For more information, see Defining Syslog Servers.


     
      

     

     

 
     [bookmark: pgfId-804856]Related Topics

 
      
      		 [bookmark: pgfId-804861]Defining Syslog Servers

 
      		 [bookmark: pgfId-804866]Understanding Log Message Severity Levels

 
      		 [bookmark: pgfId-804871]Logging on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-804873]Step 1 Do one of the following to access the router’s Syslog Logging Setup page:

 
      
      		 [bookmark: pgfId-804875](Device view) Select  Platform > Logging > Syslog Logging Setup from the Policy selector.

 
      		 [bookmark: pgfId-804877](Policy view) Select  Router Platform > Logging > Syslog Logging Setup from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-804882]The Syslog Logging Setup page is displayed. See Table 64-2 for a description of the fields on this page.

 
     [bookmark: pgfId-804884]Step 2 Select Enable Logging to turn on the syslog logging feature. If this option is not selected, no log messages are created.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-804886]Tip To use the device’s default logging settings, or to restore the default settings, simply select Enable Logging, ensure all other fields are blank, then click Save. The default settings vary by device. See your router documentation for more details.


     
      

     

     

 
     [bookmark: pgfId-804888]Step 3 (Optional) In the Source Interface field, enter the name of the interface or interface role whose address should be used as the source interface for all log messages sent to a syslog server; or click Select to select an interface role from a list or to create a new one. The source interface must have an IP address.

 
     [bookmark: pgfId-804890]This option is useful when the syslog server cannot reach the address from which the connection originated (for example, due to a firewall). If you do not enter a value in this field, the address of the outgoing interface is used.

 
     [bookmark: pgfId-804892]Step 4 (Optional) To send log messages to a syslog server:

 
     [bookmark: pgfId-804894] a. Select Enable Trap. This option is selected by default.

 
     [bookmark: pgfId-804899] b. Select a value from the Trap Level list. All messages of this severity or greater (that is, having the same or a lower severity-level number) are sent to the syslog server; messages of a lesser severity are ignored. For more information about severity levels, see Table 64-1.

 
     [bookmark: pgfId-804901]Step 5 (Optional) To save log messages locally to a buffer on the router:

 
     [bookmark: pgfId-804903] a. Select Enable Buffer. This option is selected by default.

 
     [bookmark: pgfId-804905] b. Enter the Buffer Size in bytes.

 
     [bookmark: pgfId-804907] c. Select the lowest severity level for messages to be saved to the buffer. All messages of that severity level or greater are saved to the buffer.

 
     [bookmark: pgfId-804909] d. Select Use XML Format to save messages in XML format. (You can configure both the regular buffer and the XML buffer in the same policy.) If you select this option, enter the size of the XML buffer in bytes.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-804911]Note Make sure not to make buffers so large that the router runs out of memory for other tasks. If this happens, deployment may fail.


     
      

     

     

 
     [bookmark: pgfId-804913]Step 6 (Optional) Define a rate limit to prevent a flood of output messages:

 
     [bookmark: pgfId-804915] a. Select Enable Rate Limit. This option is selected by default.

 
     [bookmark: pgfId-804917] b. Enter the maximum number of messages that can be sent per second.

 
     [bookmark: pgfId-804921] c. [bookmark: 145733]Select the severity levels to exclude from the rate limit. For example, if you select 2 (critical), all syslog messages of severity levels 0-2 are sent to the syslog server regardless of the defined rate limit.

 
     [bookmark: pgfId-804923] d. Select All Messages to apply the rate limit to all syslog messages except console messages (and excepting those severity levels specifically excluded above).

 
     [bookmark: pgfId-804925] e. Select Console Messages to apply the rate limit to console messages only.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-804927]Note If you enable rate limiting without specifying any options, the default settings (10 messages per second, applied to console messages only) are applied.


     
      

     

     

 
     [bookmark: pgfId-804929]Step 7 (Optional) To add an origin identifier to the beginning of each syslog message:

 
     [bookmark: pgfId-804931] a. Select the type of origin ID to send—the IP address of the router, its host name, or a text string that you provide.

 
     [bookmark: pgfId-804933] b. If you select String, enter the desired text in the field provided. Spaces are permitted.

 
     [bookmark: pgfId-804935]The origin identifier is useful for identifying the source of syslog messages in cases where you send output from multiple devices to a single syslog server.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-804937]Note The origin identifier is not added to messages sent to local destinations, such as the buffer, the console, and the monitor.


     
      

     

     

 
     [bookmark: pgfId-804939]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-804947][bookmark: 145758][bookmark: rtchap_proc_DefiningSyslogServers-1]Defining Syslog Servers[bookmark: marker-804945]

 
     [bookmark: pgfId-804949]This procedure describes how to define the servers to which the router should send syslog messages. When you define a syslog server, you can choose whether the logging messages it receives should be forwarded as plain text or in XML format.

 
     [bookmark: pgfId-804951]If you define multiple syslog servers, logging messages are sent to all of them.

 
     [bookmark: pgfId-804953]Before You Begin

 
      
      		 [bookmark: pgfId-804958]Enable syslog logging and define basic logging parameters on the Syslog Logging Setup page. For more information, see Defining Syslog Logging Setup Parameters.

 
     

 
     [bookmark: pgfId-804960]Related Topics

 
      
      		 [bookmark: pgfId-804965]Defining Syslog Logging Setup Parameters

 
      		 [bookmark: pgfId-804970]Understanding Log Message Severity Levels

 
      		 [bookmark: pgfId-804975]Logging on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-804977]Step 1 Do one of the following to access the router’s Syslog Servers page:

 
      
      		 [bookmark: pgfId-804979](Device view) Select  Platform > Logging > Syslog Servers from the Policy selector.

 
      		 [bookmark: pgfId-804981](Policy view) Select  Router Platform > Logging > Syslog Servers from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-804986]The Syslog Servers page is displayed. See Table 64-3 for a description of the fields on this page.

 
     [bookmark: pgfId-804991]Step 2 To define a server to receive syslog messages from this router, click the Add button below the table to open the Syslog Server dialog box. See Table 64-4 for more about this dialog box.

 
     [bookmark: pgfId-804996]Step 3 In the IP Address field, enter the address of the desired syslog server, or click Select to select a network/host object from a list or to create a new one. For more information, see Specifying IP Addresses During Policy Definition.

 
     [bookmark: pgfId-804998]Step 4 (Optional) Select Forward Messages in XML Format to forward received syslog messages in XML format instead of plain text.

 
     [bookmark: pgfId-805000]Step 5 Click OK to save your definition and close the dialog box. The syslog server you defined is displayed in the table.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-805002]Note To edit a syslog server, select it from the table, then click Edit. To remove a syslog server, select it, then click Delete.


     
      

     

     

 
     [bookmark: pgfId-805004]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-805012][bookmark: 145816][bookmark: rtchap_cncpt_UnderstandingLogMessageSeverityLevels]Understanding Log Message Severity Levels[bookmark: marker-805010]

 
     [bookmark: pgfId-805014]Syslog messages on Cisco IOS routers are classified into eight severity levels. Each severity level is identified by a number and a corresponding name. The lower the number, the greater the severity, as shown in the following table.

 
     [bookmark: pgfId-805017] 

 
      
       
        
        [bookmark: pgfId-803605]Table 64-1 [bookmark: 145825]Syslog Message Severity Levels 

 
        
       
         
         		
           
           [bookmark: pgfId-803613]Level Number
          
  
         		
           
           [bookmark: pgfId-803615]Level Name
          
  
         		
           
           [bookmark: pgfId-803617]Description
          
  
        

 
         
         		[bookmark: pgfId-803625]0

  
         		[bookmark: pgfId-803627]emergency

  
         		[bookmark: pgfId-803629]System unusable

  
        

 
         
         		[bookmark: pgfId-803637]1

  
         		[bookmark: pgfId-803639]alert

  
         		[bookmark: pgfId-803641]Immediate action needed

  
        

 
         
         		[bookmark: pgfId-803649]2

  
         		[bookmark: pgfId-803651]critical

  
         		[bookmark: pgfId-803653]Critical conditions

  
        

 
         
         		[bookmark: pgfId-803661]3

  
         		[bookmark: pgfId-803663]errors

  
         		[bookmark: pgfId-803665]Error conditions

  
        

 
         
         		[bookmark: pgfId-803673]4

  
         		[bookmark: pgfId-803675]warnings

  
         		[bookmark: pgfId-803677]Warning conditions

  
        

 
         
         		[bookmark: pgfId-803685]5

  
         		[bookmark: pgfId-803687]notifications

  
         		[bookmark: pgfId-803689]Normal but significant condition

  
        

 
         
         		[bookmark: pgfId-803697]6

  
         		[bookmark: pgfId-803699]informational

  
         		[bookmark: pgfId-803701]Informational messages only

  
        

 
         
         		[bookmark: pgfId-803709]7

  
         		[bookmark: pgfId-803711]debugging

  
         		[bookmark: pgfId-803713]Debug messages

  
        

 
       
      

 
     
 
     [bookmark: pgfId-805019]Related Topics

 
      
      		 [bookmark: pgfId-805024]Defining Syslog Logging Setup Parameters

 
      		 [bookmark: pgfId-805029]Defining Syslog Servers

 
      		 [bookmark: pgfId-805034]Logging on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-805046][bookmark: 145906][bookmark: rtchap_cncpt_AboutNetFlowonIOSRouters]NetFlow on Cisco IOS Routers[bookmark: marker-805040][bookmark: marker-805042][bookmark: marker-805044]

 
     [bookmark: pgfId-805048]The ability to characterize IP traffic and understand how and where it flows is critical for network availability, performance and troubleshooting. Monitoring IP traffic flows facilitates accurate capacity planning, and ensures that network resources are used appropriately in support of organizational goals.

 
     [bookmark: pgfId-805050]NetFlow is a logging feature available on IOS devices for recording, caching and transmitting IP traffic-flow information on a per-interface basis. The basic output of NetFlow is a flow record, where a “flow” is defined as a unidirectional stream of packets between a given source and destination—both defined by a network-layer IP address and transport-layer source and destination port numbers.

 
     [bookmark: pgfId-805052]On the IOS device, NetFlow consists of two key components—a NetFlow cache which stores IP flow data, and the NetFlow export mechanism that transmits the NetFlow records to a collection server for data reporting. Thus, when enabled, NetFlow records and caches statistics for incoming and outgoing traffic flows, periodically transmitting these records from the device to a NetFlow collector, in the form of User Datagram Protocol (UDP) datagrams.

 
     [bookmark: pgfId-805054]Several different formats for the export packet, or flow record, have evolved as NetFlow has matured, and these formats are commonly referred to as the NetFlow version. These versions are well documented, and include versions 1, 5, 7, and 9. The most commonly used format is NetFlow version 5, but version 9 is the latest format and has some advantages for extensibility, security, traffic analysis and multicasting.

 
     [bookmark: pgfId-805056]Security Manager currently supports Traditional NetFlow on IOS devices. Traditional NetFlow provides a fixed flow record, even for version 9, meaning the device will use certain flags and predefined record combinations in generating the flow. The device configuration settings define export destinations, export interface, and certain version-specific transmission options.

 
     [bookmark: pgfId-805058]More About Traffic Flows and NetFlow

 
     [bookmark: pgfId-805060]Each packet that passes into or out of a router or switch is examined for a set of IP packet attributes. These attributes are the IP packet identity or “fingerprint,” and they define whether the packet is unique, or related to other packets.

 
     [bookmark: pgfId-805062]All packets with the same source/destination IP address, source/destination ports, protocol interface, and class of service are grouped into a flow and the packets and bytes are tallied. This method of flow determination (or “fingerprinting”) is scalable because a large amount of network information can be condensed into a database of NetFlow information called the NetFlow cache.

 
     [bookmark: pgfId-805064]In general, the NetFlow cache is constantly filling with flows, and software in the router or switch is searching the cache for flows that have terminated or expired, and these flows are exported to the NetFlow collector. (Unlike SNMP polling, NetFlow export periodically transmits information to the NetFlow collector.) The NetFlow collector has the job of assembling and organizing the exported flows to produce the real-time or historical reports used for traffic and security analysis.

 
     [bookmark: pgfId-805066]NetFlow Summary

 
     [bookmark: pgfId-805068]To summarize, the following steps outline NetFlow:

 
      
      		 [bookmark: pgfId-805070]NetFlow is configured on the router or switch to capture IP traffic flows

 
      		 [bookmark: pgfId-805072]Flow records are stored in the local NetFlow cache

 
      		 [bookmark: pgfId-805074]Periodically, approximately 30 to 50 flow records are bundled together and exported to a NetFlow collector server

 
      		 [bookmark: pgfId-805076]The collector software creates reports from the NetFlow data

 
     

 
     [bookmark: pgfId-805078]Related Topics

 
      
      		 [bookmark: pgfId-805083]Logging on Cisco IOS Routers

 
      		 [bookmark: pgfId-805088]Defining NetFlow Parameters

 
      		 [bookmark: pgfId-805093]NetFlow Policy Page

 
     

 
    
 
     
      [bookmark: pgfId-805103][bookmark: 145951][bookmark: rtchap_proc_DefiningNetFlowParameters]Defining NetFlow Parameters[bookmark: marker-805099][bookmark: marker-805101]

 
     [bookmark: pgfId-805105]This procedure describes enabling NetFlow logging on the router.

 
     [bookmark: pgfId-805107]Related Topics

 
      
      		 [bookmark: pgfId-805112]NetFlow on Cisco IOS Routers

 
      		 [bookmark: pgfId-805117]NetFlow Policy Page

 
      		 [bookmark: pgfId-805122]Logging on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-805124]Step 1 To access the router’s NetFlow page, do one of the following:

 
      
      		 [bookmark: pgfId-805126](Device view) Select  Platform > Logging > NetFlow from the Policy selector.

 
      		 [bookmark: pgfId-805128](Policy view) Select  Router Platform > Logging > NetFlow from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-805133]The router’s NetFlow page is displayed. See NetFlow Policy Page for complete descriptions of the fields on this page.

 
     [bookmark: pgfId-805135]Step 2 On the Setup tab of the NetFlow page, specify global NetFlow parameters for the router:

 
      
      		 [bookmark: pgfId-805137] Primary Destination – Choose IP Address or Hostname from this list to enable NetFlow collection and to specify how the primary NetFlow collector will be defined. You can choose the blank entry to disable this option.

 
     

 
     [bookmark: pgfId-805139] – IP Address – Enter the IP address of the device hosting the primary NetFlow Collection Engine, and then enter the number of the UDP Port monitored by that flow collector (port numbers can range from 1 to 65535)

 
     [bookmark: pgfId-805141] – Hostname – Enter the fully qualified domain name of the device hosting the primary NetFlow Collection Engine, and then enter the number of the UDP Port monitored by that flow collector (port numbers can range from 1 to 65535)

 
      
      		 [bookmark: pgfId-805143] Redundant Destination – Choose IP Address or Hostname from this list to specify how the back-up NetFlow collector will be defined. You can choose the blank entry to disable this option.

 
     

 
     [bookmark: pgfId-805145] – IP Address – Enter the IP address of the device hosting the secondary NetFlow Collection Engine, and then enter the number of the UDP Port monitored by that flow collector (port numbers can range from 1 to 65535)

 
     [bookmark: pgfId-805147] – Hostname – Enter the fully qualified domain name of the device hosting the secondary NetFlow Collection Engine, and then enter the number of the UDP Port monitored by that flow collector (port numbers can range from 1 to 65535)

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-805149]Note If you define a Primary and a Redundant Destination, flow data is transmitted to both.


     
      

     

     

 
      
      		 [bookmark: pgfId-805151] Source Interface – Specify the router interface through which flow data will be transmitted to the collector destination(s).

 
      		 [bookmark: pgfId-805153] Version – Define the record format to be used for flow data by choosing the appropriate NetFlow version number from this drop-down list. You can choose the blank entry to disable this option.

 
     

 
     [bookmark: pgfId-805155] – 1 – The original record format. No additional parameters are required.

 
     [bookmark: pgfId-805157] – 5 – The most widely adopted format; includes Border Gateway Protocol (BGP) autonomous system (AS) information and flow sequence numbers.

 
     [bookmark: pgfId-805159]If BGP is configured on your network, you can include either origin or peer AS information in the NetFlow records. Choose origin-as or peer-as from the AS Type drop-down list. You can choose the blank entry to disable this option.

 
     [bookmark: pgfId-805161]Check Enable BGP Nexthop to include BGP next hop information in the flow caches. (Note that with version 5, this information is visible in the caches, but it is not exported.)

 
     [bookmark: pgfId-805163] – 9 – The most-recent, template-based version; not yet fully supported.

 
     [bookmark: pgfId-805165]If BGP is configured on your network, you can include either origin or peer AS information in the NetFlow records. Choose origin-as or peer-as from the AS Type drop-down list. You can choose the blank entry to disable this option.

 
     [bookmark: pgfId-805167]Check Enable BGP Nexthop to include BGP next hop information in the flow records.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-805169]Note AS information collection is resource intensive, especially for origin-as. If you are not interested in monitoring peering arrangements, disabling AS collection may improve performance.


     
      

     

     

 
     [bookmark: pgfId-805171]Step 3 On the Interfaces tab, define the interfaces for which traffic flows are to be reported.

 
      
      		 [bookmark: pgfId-805176]To add an interface, click the Add Row button to open the Add NetFlow Interface Settings dialog box. This dialog box is described in Adding and Editing NetFlow Interface Settings.

 
      		 [bookmark: pgfId-805181]To edit an existing interface, select the appropriate entry in the Interfaces table and then click the Edit Row button to open the Edit NetFlow Interface Settings dialog box (described in Adding and Editing NetFlow Interface Settings).

 
      		 [bookmark: pgfId-805183]To delete an existing interface, select that entry in the Interfaces table and then click the Delete Row button, and then confirm the deletion.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-805188]Note You can disable NetFlow data collection on an interface without deleting it. Refer to Adding and Editing NetFlow Interface Settings for more information.


     
      

     

     

 
     [bookmark: pgfId-805190]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-805202][bookmark: 146061][bookmark: rtpage_cncpt_LoggingSetupPolicyPage]Syslog Logging Setup Policy Page[bookmark: marker-805198][bookmark: marker-805200]

 
    [bookmark: pgfId-805204]Use the Syslog Logging Setup page to enable syslog logging and define basic logging parameters on the selected Cisco IOS router.

 
    [bookmark: pgfId-805209]For more information, see Defining Syslog Logging Setup Parameters.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-805214]Note We strongly recommend that you define an NTP policy on all routers on which logging is enabled in order to create accurate timestamps for each log message. For more information, see NTP Policy Page.


    
     

    

    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-805216]Note If you unassign a logging setup policy, the default logging configuration is restored on the device upon deployment.


    
     

    

    

 
    [bookmark: pgfId-805218]Navigation Path

 
     
     		 [bookmark: pgfId-805220](Device view) Select  Platform > Logging > Syslog Logging Setup from the Policy selector.

 
     		 [bookmark: pgfId-805222](Policy view) Select  Router Platform > Logging > Syslog Logging Setup from the Policy Type selector. Right-click  Syslog Logging Setup to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-805224]Related Topics

 
     
     		 [bookmark: pgfId-805229]Logging on Cisco IOS Routers

 
     		 [bookmark: pgfId-805234]Syslog Servers Policy Page

 
     		 [bookmark: pgfId-805239]NTP on Cisco IOS Routers

 
     		 [bookmark: pgfId-805244]Understanding Interface Role Objects

 
    

 
    [bookmark: pgfId-805246]Field Reference

 
    [bookmark: pgfId-805249] 

 
     
      
       
       [bookmark: pgfId-803726]Table 64-2 [bookmark: 146106]Syslog Logging Setup Page 

 
       
      
        
        		
          
          [bookmark: pgfId-803732]Element
         
  
        		
          
          [bookmark: pgfId-803734]Description
         
  
       

 
        
        		[bookmark: pgfId-803740]Enable Logging

  
        		[bookmark: pgfId-803742]When selected, syslog logging is enabled on the device.

 [bookmark: pgfId-803744]When deselected, logging is disabled on the device. This is the default.

 , without entering additional values.  
       

 
        
        		[bookmark: pgfId-803752]Source Interface

  
        		[bookmark: pgfId-803754]The source address for all outgoing log messages sent to a syslog server. This setting may be necessary when the syslog server cannot respond to the address from which the log message originated (for example, due to a firewall).

 [bookmark: pgfId-803756]If you do not define a value in this field, the address of the outgoing interface is used.

 [bookmark: pgfId-803758]Enter the name of an interface or interface role, or click Select to select an object from a list or to create a new one.

  
       

 
        
        		[bookmark: pgfId-803764]Trap

  
        		[bookmark: pgfId-803766]Defines which log messages are forwarded to a syslog server:

 
          
          		 [bookmark: pgfId-803768]Enable Trap—When selected, log messages are sent to the syslog server. This is the default. When deselected, log messages are not sent.

 
          		 [bookmark: pgfId-803773]Trap Level—The lowest severity level of messages that are logged and sent to the syslog server. All messages of this severity and greater are logged. Severity levels are identified by a name and a number. For more information, see Table 64-1.

 
         

 , then select the blank setting from the Trap Level list.  
       

 
        
        		[bookmark: pgfId-803781]Logging Buffer

  
        		[bookmark: pgfId-803783]Defines whether log messages are saved locally to a buffer on the device.

 
          
          		 [bookmark: pgfId-803785]Enable Buffer—When selected, log messages are saved to a buffer on the device. This is the default. When deselected, a log buffer is not maintained on the device.

 
          		 [bookmark: pgfId-803787]Buffer Size—The size of the buffer in bytes. Valid values range from 4096 to 4294967295 bytes (4 kilobytes to 4 gigabytes). The default size varies by platform. Make sure not to make the buffer so large that the router runs out of memory for other tasks; otherwise, deployment might fail.

 
         

 [bookmark: pgfId-803789]Note The maximum buffer size might be smaller on some devices.

 
          
          		 [bookmark: pgfId-803794]Severity Level—The lowest severity level of messages that are saved in the buffer. All messages of this severity and greater are saved. On most Cisco IOS routers, the default severity level is 7 (debugging). Severity levels are identified by a name and a number. For more information, see Table 64-1.

 
          		 [bookmark: pgfId-803796]Use XML Format—When selected, log messages are saved to a buffer in XML format. (You can configure both the regular buffer and the XML buffer in the same policy.) When deselected, an XML buffer is not maintained on the device.

 
          		 [bookmark: pgfId-803798]Buffer Size—The size of the XML buffer in bytes. Valid values range from 4096 to 4294967295 bytes (4 kilobytes to 4 gigabytes).

 
         

 [bookmark: pgfId-803800]Note The maximum buffer size might be smaller on some devices.

 , erase the buffer size setting, then select the blank setting from the Severity Level list.  
       

 
        
        		[bookmark: pgfId-803808]Rate Limit

  
        		[bookmark: pgfId-803810]Limits the rate of log messages sent to the syslog server.

 
          
          		 [bookmark: pgfId-803812]Enable Rate Limit—When selected, the rate limit is enabled. When deselected, the rate limit is disabled.

 
          		 [bookmark: pgfId-803814]Messages per Sec.—The maximum number of logging messages that can be sent per second. Valid values range from 1 to 10000. The default is 10 messages per second.

 
          		 [bookmark: pgfId-803819]Exclude—The types of messages to  exclude from the rate limit. This setting excludes the severity level you select as well as all messages with a lower severity level number (that is, more severe). The default is 3 (errors), which excludes all log messages with a severity level of 3, 2 (critical), 1 (alerts), or 0 (emergencies) from the rate limit. For more information about severity levels, see Table 64-1.

 
          		 [bookmark: pgfId-803821]All Messages—When selected, the rate limit applies to all messages except console messages.

 
          		 [bookmark: pgfId-803823]Console Messages—When selected, the rate limit applies to console messages only.

 
         

 check box, then erase the rate limit value setting.  
       

 
        
        		[bookmark: pgfId-803831]Origin ID

  
        		[bookmark: pgfId-803833]The origin identifier that is added to the beginning of all syslog messages sent from this device to the remote syslog server. The origin identifier is useful in cases where you send output from multiple devices to a single syslog server.

 
          
          		 [bookmark: pgfId-803835]ID Type—The type of origin identifier added to the beginning of each syslog message. Options are:

 
         

 [bookmark: pgfId-803837] – IP Address—The IP address of the source device.

 [bookmark: pgfId-803839] – Hostname—The hostname of the source device.

 [bookmark: pgfId-803841] – String—User-defined text.

 
          
          		 [bookmark: pgfId-803843]Value—Applies only when you select String as the ID type. Enter the text of the user-defined string. Spaces are permitted, except for the first character.

 
         

 [bookmark: pgfId-803845]Note The origin identifier is not added to messages sent to local destinations, such as the buffer, the console, and the monitor.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-805261][bookmark: 146205][bookmark: rtpage_cncpt_SyslogServersPolicyPage]Syslog Servers Policy Page[bookmark: marker-805257][bookmark: marker-805259]

 
    [bookmark: pgfId-805263]Use the Syslog Servers page to create, edit, and delete servers that collect log messages from the router.

 
    [bookmark: pgfId-805268]For more information, see Defining Syslog Servers.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-805273]Note To enable logging to the syslog servers defined on this page, you must enable logging and define basic parameters on the Syslog Logging Setup Policy Page.


    
     

    

    

 
    [bookmark: pgfId-805275]Navigation Path

 
     
     		 [bookmark: pgfId-805277](Device view) Select  Platform > Logging > Syslog Servers from the Policy selector.

 
     		 [bookmark: pgfId-805279](Policy view) Select  Router Platform > Logging > Syslog Servers from the Policy Type selector. Right-click  Syslog Servers to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-805281]Related Topics

 
     
     		 [bookmark: pgfId-805286]Logging on Cisco IOS Routers

 
     		 [bookmark: pgfId-805291]Syslog Server Dialog Box

 
     		 [bookmark: pgfId-805296]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-805301]Filtering Tables

 
    

 
    [bookmark: pgfId-805303]Field Reference

 
    [bookmark: pgfId-805306] 

 
     
      
       
       [bookmark: pgfId-803858]Table 64-3 [bookmark: 146249]Syslog Servers Page 

 
       
      
        
        		
          
          [bookmark: pgfId-803864]Element
         
  
        		
          
          [bookmark: pgfId-803866]Description
         
  
       

 
        
        		[bookmark: pgfId-803872]IP Address

  
        		[bookmark: pgfId-803874]The name of the syslog server, as represented by a network/host object, or its IP address.

  
       

 
        
        		[bookmark: pgfId-803880]XML

  
        		[bookmark: pgfId-803882]Indicates whether the syslog server receives log messages in XML format.

  
       

 
        
        		[bookmark: pgfId-803888]Add button

  
        		[bookmark: pgfId-803893]Opens the Syslog Server Dialog Box. From here you can define a syslog server.

  
       

 
        
        		[bookmark: pgfId-803899]Edit button

  
        		[bookmark: pgfId-803904]Opens the Syslog Server Dialog Box. From here you can edit the selected syslog server.

  
       

 
        
        		[bookmark: pgfId-803910]Delete button

  
        		[bookmark: pgfId-803912]Deletes the selected syslog server from the table.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-805318][bookmark: 146286][bookmark: rtpage_cncpt_SyslogServerDialogBox]Syslog Server Dialog Box[bookmark: marker-805314][bookmark: marker-805316]

 
     [bookmark: pgfId-805320]Use the Syslog Server dialog box to define the server that collects syslog messages from the router. You can also define whether the log messages it receives are in XML format or plain text.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-805325]Note To enable logging to the syslog servers defined on this page, you must enable logging and define basic parameters on the Syslog Logging Setup Policy Page.


     
      

     

     

 
     [bookmark: pgfId-805327]Navigation Path

 
     [bookmark: pgfId-805332]Go to the Syslog Servers Policy Page, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-805334]Related Topics

 
      
      		 [bookmark: pgfId-805339]Defining Syslog Servers

 
      		 [bookmark: pgfId-805344]Logging on Cisco IOS Routers

 
      		 [bookmark: pgfId-805349]Understanding Networks/Hosts Objects

 
     

 
     [bookmark: pgfId-805351]Field Reference

 
     [bookmark: pgfId-805354] 

 
      
       
        
        [bookmark: pgfId-803925]Table 64-4 [bookmark: 146321]Syslog Server Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-803931]Element
          
  
         		
           
           [bookmark: pgfId-803933]Description
          
  
        

 
         
         		[bookmark: pgfId-803939]IP Address

  
         		[bookmark: pgfId-803941]The IP address of the syslog server. Enter an IP address or the name of a network/host object, or click Select to select the object from a list or to create a new one.

  
        

 
         
         		[bookmark: pgfId-803947]Forward Messages in XML Format

  
         		[bookmark: pgfId-803949]When selected, log messages are sent to the syslog server in XML format.

 [bookmark: pgfId-803951]When deselected, log messages are sent to the syslog server as plain text.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-805370][bookmark: 146345][bookmark: rtpage_cncpt_NetFlowPolicyPage]NetFlow Policy Page[bookmark: marker-805362][bookmark: marker-805364][bookmark: marker-805366][bookmark: marker-805368]

 
    [bookmark: pgfId-805372]Use the NetFlow page to enable NetFlow recording and define its parameters on the selected Cisco IOS router.

 
    [bookmark: pgfId-805374]The NetFlow page consists of two tabbed panels: Setup and Interfaces. The Setup tab provides global configuration parameters for NetFlow collection on the router. The Interfaces tab lists router interfaces for which NetFlow data collection is configured, and allows enabling and disabling ingress and egress accounting on a per-interface basis.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-805379]Note We strongly recommend that you define an NTP policy on all routers on which logging is enabled in order to create accurate timestamps for each log message. For more information, see NTP Policy Page.


    
     

    

    

 
    [bookmark: pgfId-805381]Navigation Path

 
     
     		 [bookmark: pgfId-805383](Device view) Select  Platform > Logging > NetFlow from the Policy selector.

 
     		 [bookmark: pgfId-805385](Policy view) Select  Router Platform > Logging > NetFlow from the Policy Type selector. Select an existing policy from the Shared Policy selector, or right-click  NetFlow to create a new policy.

 
    

 
    [bookmark: pgfId-805387]Related Topics

 
     
     		 [bookmark: pgfId-805392]NetFlow on Cisco IOS Routers

 
     		 [bookmark: pgfId-805397]Defining NetFlow Parameters

 
     		 [bookmark: pgfId-805402]Adding and Editing NetFlow Interface Settings

 
     		 [bookmark: pgfId-805407]Logging on Cisco IOS Routers

 
     		 [bookmark: pgfId-805412]NTP on Cisco IOS Routers

 
    

 
    [bookmark: pgfId-805414]Field Reference

 
    [bookmark: pgfId-805417] 

 
     
      
       
       [bookmark: pgfId-803964]Table 64-5 [bookmark: 146396]NetFlow Page 

 
       
      
        
        		
          
          [bookmark: pgfId-803970]Element
         
  
        		
          
          [bookmark: pgfId-803972]Description
         
  
       

 
        
        		 
          
          [bookmark: pgfId-803978]Setup tab
         
  
       

 
        
        		[bookmark: pgfId-803986]Primary Destination

 [bookmark: pgfId-803988]Redundant Destination

  
        		[bookmark: pgfId-803990]The primary and secondary NetFlow collector. You must select a primary collector to enable NetFlow data collection on this device. To disable transmission of NetFlow data to either of these collectors, choose the blank entry from the drop-down list.

 [bookmark: pgfId-803992]Select whether to identify the NetFlow collector using its IP address or host name, then configure the required fields for each option:

 
          
          		 [bookmark: pgfId-803994] IP Address —Enter the IP address of the device hosting the primary NetFlow Collection Engine. You can also specify a network/host object that specifies the IP address, or click  Select to select the object from a list or to create a new one.

 
         

 [bookmark: pgfId-803996]In the UDP Port field, enter the port number monitored by the flow collector (port numbers can range from 1 to 65535). You can enter a number or the name of a port list object, or click Select to select an object from a list or to create a new one.

 
          
          		 [bookmark: pgfId-803998] Hostname —Enter the fully qualified domain name of the device hosting the primary NetFlow Collection Engine. You also must specify the UDP port as you do when specifying the IP address.

 
         

  
       

 
        
        		[bookmark: pgfId-804004]Source Interface

  
        		[bookmark: pgfId-804006]The router interface through which flow data will be transmitted to the collector destinations. Enter an interface or interface role name, or click Select to select an object from a list or to create a new one.

  
       

 
        
        		[bookmark: pgfId-804012]Version

  
        		[bookmark: pgfId-804014]The NetFlow version number, which defines the record format to be used for flow. You can choose the blank entry to disable this option.

 
          
          		 [bookmark: pgfId-804016] 1 —The original record format. No additional parameters are required.

 
          		 [bookmark: pgfId-804018] 5 —The most widely adopted format; includes Border Gateway Protocol (BGP) autonomous system (AS) information and flow sequence numbers.

 
         

 [bookmark: pgfId-804020]If BGP is configured on your network, you can include either origin or peer AS information in the NetFlow records. Choose origin-as or peer-as from the AS Type drop-down list. You can choose the blank entry to disable this option.

 [bookmark: pgfId-804022]Check Enable BGP Nexthop to include BGP next hop information in the flow caches. (Note that with version 5, this information is visible in the caches, but it is not exported.)

 
          
          		 [bookmark: pgfId-804024] 9 —The most-recent, template-based version; not yet fully supported.

 
         

 [bookmark: pgfId-804026]If BGP is configured on your network, you can include either origin or peer AS information in the NetFlow records. Choose origin-as or peer-as from the AS Type drop-down list. You can choose the blank entry to disable this option.

 [bookmark: pgfId-804028]Check Enable BGP Nexthop to include BGP next hop information in the flow records.

 [bookmark: pgfId-804030]Note AS information collection is resource intensive, especially for origin-as. If you are not interested in monitoring peering arrangements, disabling AS collection might improve performance.

  
       

 
        
        		 
          
          [bookmark: pgfId-804036]Interfaces tab
         
  
       

 
        
        		[bookmark: pgfId-804044]Interface

  
        		[bookmark: pgfId-804046]The names of the interfaces on which NetFlow collection is configured.

  
       

 
        
        		[bookmark: pgfId-804052]Enable Ingress

  
        		[bookmark: pgfId-804054]“Enabled” indicates flow recording is enabled on this interface for incoming traffic; “Disabled” indicates incoming traffic is not recorded for this interface.

  
       

 
        
        		[bookmark: pgfId-804060]Enable Egress

  
        		[bookmark: pgfId-804062]“Enabled” indicates flow recording is enabled on this interface for outgoing traffic; “Disabled” indicates outgoing traffic is not recorded for this interface.

  
       

 
        
        		[bookmark: pgfId-804068]Add Row

  
        		[bookmark: pgfId-804073]Click this button to open the Add NetFlow Interface Settings dialog box. Adding a NetFlow interface is described in Adding and Editing NetFlow Interface Settings.

  
       

 
        
        		[bookmark: pgfId-804079]Edit Row

  
        		[bookmark: pgfId-804084]Click this button to open the Edit NetFlow Interface Settings dialog box for the selected interface. Editing NetFlow interfaces is described in Adding and Editing NetFlow Interface Settings.

  
       

 
        
        		[bookmark: pgfId-804090]Delete Row

  
        		[bookmark: pgfId-804092]Click this button to delete the selected interface. You will be asked to confirm the deletion.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-805429][bookmark: 146498][bookmark: rtpage_cncpt_AddEditNetFlowInterfaces]Adding and Editing NetFlow Interface Settings[bookmark: marker-805425][bookmark: marker-805427]

 
     [bookmark: pgfId-805431]Use the Add NetFlow Interface Settings and Edit NetFlow Interface Settings dialog boxes to enable and disable NetFlow ingress and egress reporting for specific router interfaces.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-805433]Note Except for their titles, these two dialog boxes are identical. The following information applies to both.


     
      

     

     

 
     [bookmark: pgfId-805435]Navigation Path

 
     [bookmark: pgfId-805440]Go to the NetFlow Policy Page, then click the Add Row or Edit Row button beneath the table.

 
     [bookmark: pgfId-805442]Related Topics

 
      
      		 [bookmark: pgfId-805447]Defining NetFlow Parameters

 
      		 [bookmark: pgfId-805452]Logging on Cisco IOS Routers

 
     

 
     [bookmark: pgfId-805454]Field Reference

 
     [bookmark: pgfId-805457] 

 
      
       
        
        [bookmark: pgfId-804105]Table 64-6 [bookmark: 146529]Add/Edit NetFlow Interface Settings Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-804111]Element
          
  
         		
           
           [bookmark: pgfId-804113]Description
          
  
        

 
         
         		[bookmark: pgfId-804119]Interface

  
         		[bookmark: pgfId-804121]The name of the interface or interface role. Enter a name or click Select to select an interface role from a list or to create a new one.

  
        

 
         
         		[bookmark: pgfId-804127]Enable Ingress Accounting

  
         		[bookmark: pgfId-804129]When this option is selected, NetFlow records are collected for traffic arriving on this interface.

 [bookmark: pgfId-804131]Deselect this option to halt data collection on this interface for incoming traffic.

  
        

 
         
         		[bookmark: pgfId-804137]Enable Egress Accounting

  
         		[bookmark: pgfId-804139]When this option is selected, NetFlow records are collected for traffic departing from this interface.

 [bookmark: pgfId-804141]Deselect this option to halt data collection on this interface for outgoing traffic.
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     [bookmark: pgfId-838430][bookmark: 104404][bookmark: ipdvchap_cncpt_ManagingIPSSensors]Managing IPS Sensors[bookmark: marker-838426][bookmark: marker-838428]
      
      
 
     
 

 
    [bookmark: pgfId-838432]To perform day-to-day sensor management, you typically need to use a device manager such as the IPS Device Manager (IDM). Security Manager is focused on policy and event management.

 
    [bookmark: pgfId-838434]However, the following topics describe some management activities that you can perform using Security Manager:

 
     
     		 [bookmark: pgfId-838439]Managing IPS Licenses

 
     		 [bookmark: pgfId-838444]Managing IPS Updates

 
     		 [bookmark: pgfId-838449]Managing IPS Certificates

 
     		 [bookmark: pgfId-838454]Rebooting IPS Sensors

 
    

 
   
 
    
     [bookmark: pgfId-838466][bookmark: 104427][bookmark: defapset_cncpt_AdministeringLicenses]Managing IPS Licenses [bookmark: marker-838460][bookmark: marker-838462][bookmark: marker-838464]

 
    [bookmark: pgfId-838468]The following topics explain how to manage licenses for IPS devices:

 
     
     		 [bookmark: pgfId-838473]Updating IPS License Files

 
     		 [bookmark: pgfId-838478]Redeploying IPS License Files

 
     		 [bookmark: pgfId-838483]Automating IPS License File Updates

 
    

 
     
      [bookmark: pgfId-838495][bookmark: 104452][bookmark: defapset_proc_UpdatingIPSLicenseFiles]Updating IPS License Files[bookmark: marker-838489][bookmark: marker-838491][bookmark: marker-838493]

 
     [bookmark: pgfId-838500]You can use Security Manager to update the licenses for IPS devices. This procedure explains how to update the licenses manually by retrieving them from Cisco.com or from a license file on the Security Manager server. For information about setting up automatic license updates, see Automating IPS License File Updates.

 
     [bookmark: pgfId-838502]Before You Begin

 
     [bookmark: pgfId-838507]If you use Cisco.com, you must first configure the IPS Update server to be Cisco.com, so that you can specify the username and password. You must use Cisco.com for licensing if you are using a device that requires it; for example, an IPS 4270 or an AIP SSM-40 in an ASA device requires a Cisco.com account. For information on configuring Cisco.com as the IPS Update server, see Configuring the IPS Update Server.

 
     [bookmark: pgfId-838509]If you use local licenses, you must download them directly to the Security Manager server file system. You cannot do this through Security Manager; you must log into Windows on the server to download the licenses.

 
     [bookmark: pgfId-838511]Related Topics

 
      
      		 [bookmark: pgfId-838516]Redeploying IPS License Files

 
     

 
     
 
     [bookmark: pgfId-838518]Step 1 Select Tools > Security Manager Administration and select Licensing from the table of contents.

 
     [bookmark: pgfId-838523]Step 2 Click the IPS tab (see IPS Tab, Licensing Page).

 
     [bookmark: pgfId-838525]The table lists all IPS devices in the device inventory and displays the status of their licenses. The status can be valid, invalid, expired, no license, or trial license. The expiration date for the license is also shown. Click Refresh License to update the table with the latest license information from the devices (you can select one or more devices to limit the scope of the refresh).

 
     [bookmark: pgfId-838527]To update licenses, do one of the following:

 
      
      		 [bookmark: pgfId-838532]To update devices with licenses obtained directly from Cisco.com—Select the devices you want to update and click  Update Selected via CCO . A dialog box opens that lists the devices that can be updated from Cisco.com, which might not be all of the devices you selected. Review the list and click  OK . The status of the update task is shown in the License Update Status Details dialog box (see License Update Status Details Dialog Box).

 
     

 
     [bookmark: pgfId-838534]To successfully update the license using this method, you must have a Cisco.com support contract that includes the serial numbers of the selected devices.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-838536]Tip The Cisco software license server (SWIFT) that contains the licenses might block requests from the same server for more than 9 licenses within a three minute period. Thus, you should select fewer than 9 devices at a time when performing manual license updates.


     
      

     

     

 
      
      		 [bookmark: pgfId-838538]To update devices with licenses that you have copied to the Security Manager server—Click  Update from License File . A dialog box opens where you can select the license files. Click  Browse to select them from the Security Manager local file system. You can select more than one license file. When you have selected the desired files, click  OK to have them applied to the devices.

 
     

 
     [bookmark: pgfId-838540]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-838552][bookmark: 104507][bookmark: defapset_proc_RedeployingIPSLicenseFiles]Redeploying IPS License Files[bookmark: marker-838546][bookmark: marker-838548][bookmark: marker-838550]

 
     [bookmark: pgfId-838554]If an attempt to apply an IPS license update to a device fails, you can redeploy the update. Redeployment works only if you have already attempted to apply an update and a license file is associated with the IPS device.

 
     [bookmark: pgfId-838556]Related Topics

 
      
      		 [bookmark: pgfId-838561]Updating IPS License Files

 
      		 [bookmark: pgfId-838566]Automating IPS License File Updates

 
     

 
     
 
     [bookmark: pgfId-838568]Step 1 Select Tools > Security Manager Administration and select Licensing from the table of contents.

 
     [bookmark: pgfId-838573]Step 2 Click the IPS tab (see IPS Tab, Licensing Page).

 
     [bookmark: pgfId-838575]Step 3 Select the devices to which you want to redeploy licenses and click Redeploy Selected Licenses. A dialog box opens listing devices whose licenses you are redeploying. Click OK to perform the update.

 
     [bookmark: pgfId-838580]The status of the update task is shown in the License Update Status Details dialog box (see License Update Status Details Dialog Box).

 
     [bookmark: pgfId-838582]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-838594][bookmark: 104549][bookmark: defapset_proc_AutomatingIPSLicenseFileUpdates]Automating IPS License File Updates[bookmark: marker-838588][bookmark: marker-838590][bookmark: marker-838592]

 
     [bookmark: pgfId-838596]Security Manager can automatically apply IPS license updates to your IPS devices on a regular schedule. To successfully configure automatic updates, you must have a Cisco.com support contract that includes the serial numbers of your IPS devices.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-838598]Tip Security Manager applies new licenses only if the downloaded license has an expiration date further into the future than the one replaced or if the license information is different.


     
      

     

     

 
     [bookmark: pgfId-838600]Before You Begin

 
     [bookmark: pgfId-838605]You must first configure the IPS Update server to be Cisco.com, so that you can specify the Cisco.com username and password. For information on configuring Cisco.com as the IPS Update server, see Configuring the IPS Update Server.

 
     [bookmark: pgfId-838607]Related Topics

 
      
      		 [bookmark: pgfId-838612]Updating IPS License Files

 
      		 [bookmark: pgfId-838617]Redeploying IPS License Files

 
     

 
     
 
     [bookmark: pgfId-838619]Step 1 Select Tools > Security Manager Administration and select Licensing from the table of contents.

 
     [bookmark: pgfId-838624]Step 2 Click the IPS tab (see IPS Tab, Licensing Page).

 
     [bookmark: pgfId-838626]Step 3 Select Download and apply licenses and configure the following settings:

 
      
      		 [bookmark: pgfId-838628] Days before the expiration date —Select the number of days before a license expires that Security Manager should download an updated license. The default is 1 day.

 
      		 [bookmark: pgfId-838630] Discover devices daily at —Select the time of day when Security Manager should download licenses. At this time, Security Manager will check the license status on the devices, and contact Cisco.com for new licenses for devices that have no license, have expired licenses, or that have licenses that will expire within the number of days you selected.

 
      		 [bookmark: pgfId-838632] Email License Update Results —Select whether Security Manager should send e-mail notification of license update results. E-mails are sent with license expiration status and for license update job results. If you select this option, enter one or more e-mail addresses in the  Email Notification field. Separate multiple addresses with commas.

 
     

 
     [bookmark: pgfId-838637]For the e-mails to be sent, you must configure an SMTP server as described in Configuring an SMTP Server and Default Addresses for E-Mail Notifications.

 
     [bookmark: pgfId-838639]Step 4 Click Save to save your changes.

 
     [bookmark: pgfId-838641]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-838653][bookmark: 104610][bookmark: defapset_cncpt_AdministeringIPSUpdateSettings]Managing IPS Updates[bookmark: marker-838647][bookmark: marker-838649][bookmark: marker-838651]

 
    [bookmark: pgfId-838655]You can use Security Manager to apply sensor and signature updates to your IPS devices and shared policies. Through Security Manager, you can download updates and either set up automatic updates or apply them manually.

 
    [bookmark: pgfId-838657]Signature updates are available only for IPS 5.1(4) and higher.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-838662]Tip If you have problems applying patches, service packs, or signature updates, check the time on your IPS sensor. If the time on the sensor is ahead of the time on the associated certificate, the certificate is rejected and the update may fail. Use the Network Time Protocol (NTP) to maintain accurate time on an IPS sensor. For information on configuring NTP on the sensor, see Identifying an NTP Server.


    
     

    

    

 
    [bookmark: pgfId-838664]The IPS packages included with Security Manager do not include the package files that are required for updating IPS devices. You must download IPS packages from Cisco.com or your local update server before you can apply any updates. The downloaded versions include all required package files and replace the partial files that are included in the Security Manager initial installation.

 
    [bookmark: pgfId-838666]The following topics describe how to use Security Manager to manage IPS updates:

 
     
     		 [bookmark: pgfId-838671]Configuring the IPS Update Server

 
     		 [bookmark: pgfId-838676]Checking for IPS Updates and Downloading Them

 
     		 [bookmark: pgfId-838681]Automating IPS Updates

 
     		 [bookmark: pgfId-838686]Manually Applying IPS Updates

 
    

 
     
      [bookmark: pgfId-838700][bookmark: 104643][bookmark: defapset_proc_EstablishingtheIPSUpdateServer]Configuring the IPS Update Server [bookmark: marker-838692][bookmark: marker-838694][bookmark: marker-838696][bookmark: marker-838698]

 
     [bookmark: pgfId-838702]To apply IPS sensor and signature updates, Security Manager must download the updates to the Security Manager server from an identified IPS Update server.

 
     [bookmark: pgfId-838704]You can use Cisco.com as the IPS Update server. Using Cisco.com ensures that the latest updates are available to you at their earliest availability. However, if you cannot use Cisco.com for some reason, you can set up your own local IPS Update web server, manually download updates to it, and configure Security Manager to obtain the updates from your local server.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-838706]Tip If you are using a device that requires a Cisco.com login for updating licenses, such as an IPS 4270 or an AIP SSM-40 in an ASA device, you must configure the IPS Update server as Cisco.com. You cannot use a local server.


     
      

     

     

 
     [bookmark: pgfId-838708]Related Topics

 
      
      		 [bookmark: pgfId-838713]Automating IPS Updates

 
      		 [bookmark: pgfId-838718]Manually Applying IPS Updates

 
     

 
     
 
     [bookmark: pgfId-838723]Step 1 Select Tools > Security Manager Administration and select IPS Updates from the table of contents to open the IPS Updates page (see IPS Updates Page).

 
     [bookmark: pgfId-838728]Step 2 In the Update Server area, click Edit Settings to open the Edit Update Server Settings dialog box (see Edit Update Server Settings Dialog Box).

 
     [bookmark: pgfId-838730]Step 3 Enter the identifying information for your server. Based on the server type selected in the Update From field:

 
      
      		 [bookmark: pgfId-838732]Cisco.com—Enter a Cisco.com username and password. The user account you specify must have applied for eligibility to download strong encryption software. To verify the account has the appropriate permissions, go to Cisco.com and try to download an IPS update package. You will be prompted to accept the appropriate agreements if the account is not already qualified.

 
      		 [bookmark: pgfId-838734]Local server—Enter the IP address or DNS host name of your server, a username and password if you require a log in before allowing access, and the path to the folder that contains the files. For the path, do not enter the entire URL; enter only the path portion of the URL (for example, the path in http://servername/IPSpath is IPSpath). Also add IIS configuration settings:

 
     

 
     [bookmark: pgfId-838736] – Home Directory should have listing enabled.

 
     [bookmark: pgfId-838738] – Documents should have Default Content Page disabled.

 
     [bookmark: pgfId-838743]Enter certificate information. Before you can download an IPS package, you must accept the Cisco.com certificate. You must accept the certificate from both the "Image Meta-data locator" site and the download site of the IPS packages to start downloading images successfully (see Edit Update Server Settings Dialog Box).

 
     [bookmark: pgfId-838745]If your network requires a proxy server to get from the Security Manager server to the IPS Update server, select Enable Proxy Server and enter the information for the proxy server.

 
     [bookmark: pgfId-838747]Click OK to save your changes.

 
     [bookmark: pgfId-838749]Step 4 Click Save on the IPS Updates page. Your changes are not completely saved unless you click Save.

 
     [bookmark: pgfId-838751]Step 5 Test the connectivity to the IPS Update server by clicking Download Latest Updates. A dialog box opens. Click Start to have Security Manager log into the update server, check for new updates, and download them. The dialog box displays the results of the operation.

 
     [bookmark: pgfId-838753]If you are using Cisco.com and experience a download failure, double-check the user account to ensure it has the required permissions for downloading strong encryption software.

 
     [bookmark: pgfId-838755]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-838767][bookmark: 104712][bookmark: defapset_proc_AdministeringIPSUpdates]Checking for IPS Updates and Downloading Them[bookmark: marker-838761][bookmark: marker-838763][bookmark: marker-838765]

 
     [bookmark: pgfId-838769]You can use Security Manager to check for IPS sensor and signature updates and download them to the Security Manager server, where you can apply them to your IPS devices and policies.

 
     [bookmark: pgfId-838777]You can manually download IPS updates, automate IPS update downloads, or download them when you try to manually apply them to a device. The following procedure explains how to manually check for updates and download them. For information on configuring automatic downloads, see Automating IPS Updates. For information on downloading updates while manually applying them to devices or policies, see Manually Applying IPS Updates.

 
     [bookmark: pgfId-838779]Before You Begin

 
     [bookmark: pgfId-838784]You must configure the IPS Update server as described in Configuring the IPS Update Server.

 
     [bookmark: pgfId-838786]Related Topics

 
      
      		 [bookmark: pgfId-838791]Automating IPS Updates

 
      		 [bookmark: pgfId-838796]Manually Applying IPS Updates

 
     

 
     
 
     [bookmark: pgfId-838801]Step 1 Select Tools > Security Manager Administration and select IPS Updates from the table of contents to open the IPS Updates page (see IPS Updates Page).

 
     [bookmark: pgfId-838803]Step 2 Review the status information in the Update Status group, and do any of the following:

 
      
      		 [bookmark: pgfId-838805]Click  Check for Updates . A dialog box opens to display the results of the operation. Click  Start to have Security Manager log into the IPS Update server and check for updates.

 
      		 [bookmark: pgfId-838807]Click  Download Latest Updates . A dialog box opens to display the results of the operation. Click  Start to have Security Manager log into the IPS Update server, check for updates, and download them to the Security Manager server.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-838812]Tip If a Cisco.com download fails, ensure that the account you are using has applied for eligibility to download strong encryption software. For details, see the description of User Name in Edit Update Server Settings Dialog Box.


     
      

     

     

 
     [bookmark: pgfId-838814]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-838826][bookmark: 104765][bookmark: defapset_proc_AutomatingIPSUpdates]Automating IPS Updates[bookmark: marker-838820][bookmark: marker-838822][bookmark: marker-838824]

 
     [bookmark: pgfId-838828]You can automatically apply sensor image and signature updates to compatible IPS devices to ensure that they are up to date. If desired, you can partially automate the updates to maintain the desired level of control over the process.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-838830]Tip If you later decide that you did not want to apply a signature update, you can revert to the previous update level by selecting the Signatures policy on the device, clicking the View Update Level button, and clicking Revert.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-838838]Tip [bookmark: marker-838832][bookmark: marker-838834]If you do not manage IPS devices, consider taking the following performance tuning step. In $NMSROOT\MDC\ips\etc\sensorupdate.properties, change the value of [bookmark: marker-838836]packageMonitorInterval from its initial default value of 30,000 milliseconds to a less-frequent value of 600,000 milliseconds. Taking this step will improve performance somewhat. [$NMSROOT is the full pathname of the Common Services installation directory (the default is C:\Program Files\CSCOpx).]


     
      

     

     

 
     [bookmark: pgfId-838840]Before You Begin

 
     [bookmark: pgfId-838845]You must configure the IPS Update server as described in Configuring the IPS Update Server.

 
     [bookmark: pgfId-838847]Related Topics

 
      
      		 [bookmark: pgfId-838852]Checking for IPS Updates and Downloading Them

 
      		 [bookmark: pgfId-838857]Manually Applying IPS Updates

 
      		 [bookmark: pgfId-838862]Understanding IPS Network Sensing

 
      		 [bookmark: pgfId-838867]Deploying Configurations in Non-Workflow Mode

 
      		 [bookmark: pgfId-838872]Deploying Configurations in Workflow Mode

 
     

 
     
 
     [bookmark: pgfId-838877]Step 1 Select Tools > Security Manager Administration and select IPS Updates from the table of contents to open the IPS Updates page (see IPS Updates Page).

 
     [bookmark: pgfId-838879]Step 2 In the Auto Update Settings group in the lower portion of the page, select an auto update mode to establish the extent of automation. Choices include:

 
      
      		 [bookmark: pgfId-838881]Download, Apply, and Deploy Updates—Security Manager checks for updates according to your schedule, downloads them to the Security Manager server, applies them to the selected devices and policies, and starts a deployment job to update the affected devices. This choice ensures that your devices are running the latest updates with minimal effort for your operations staff.

 
      		 [bookmark: pgfId-838883]Disable Auto Update—Security Manager does not perform any automatic actions for IPS updates.

 
      		 [bookmark: pgfId-838885]Check for Updates—Security Manager checks for updates according to your schedule and updates the information in the Update Status group. No devices or policies are updated.

 
      		 [bookmark: pgfId-838887]Download Updates—Security Manager checks for updates according to your schedule and downloads any new updates to the Security Manager server.

 
      		 [bookmark: pgfId-838889]Download and Apply Updates—Security Manager checks for updates according to your schedule, downloads them, and applies them to the selected devices and policies. You must separately create a deployment job to deploy the changes to the affected devices.

 
     

 
     [bookmark: pgfId-838891]Step 3 Click Edit Update Schedule to open a dialog box where you can specify the schedule for the operation. Select the starting date, enter the starting time in 24-hour format (hh:mm), and select whether the schedule should be by the hour, day, week, month, or a one-time event. Click OK to save the schedule.

 
     [bookmark: pgfId-838893]Step 4 (Optional) Enter an e-mail address in the Notify Email field. Security Manager will notify this user when a package is available for download or has been downloaded, applied, or deployed. You can enter more than one address by separating the addresses with commas.

 
     [bookmark: pgfId-838895]Step 5 Select the devices and shared policies you want to automatically update in the Apply Update To selector. Use the Type field to toggle between local policies (for devices) and shared policies.

 
     [bookmark: pgfId-838897]To select a device or policy, click it in the selector and click the Edit Row button (the pencil icon below the selector). This action opens the Edit Auto Update Settings dialog box. Select the types of updates you want to apply: minor sensor updates and service packs or service packs only, and the signature update level. Click OK to save your changes. The devices to which the policy apply are added to the Devices to be Auto Updated list. A message will indicate if you need to submit your changes for the change to take effect.

 
     [bookmark: pgfId-838899]Step 6 Click Save.

 
     [bookmark: pgfId-838901]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-838917][bookmark: 104850][bookmark: adman_proc_ManuallyApplyingIPSUpdates]Manually Applying IPS Updates[bookmark: marker-838909][bookmark: marker-838911][bookmark: marker-838913][bookmark: marker-838915]

 
     [bookmark: pgfId-838922]You can manually apply image and signature updates to compatible IPS devices using the Apply IPS Update wizard. Use this procedure with policies and devices that you did not configure for automatic updates (as described in Automating IPS Updates).

 
     [bookmark: pgfId-838924]When applying signature updates, the wizard displays those signatures in the update that are not configured on the target IPS devices. You can configure the new signatures before they are applied.

 
     [bookmark: pgfId-838926]When applying image and signature updates, only those devices to which the updates can be applied are available for selection. Inapplicable devices are grayed out. If you hover the mouse pointer over a grayed out device, a tooltip displays the reason for graying out the device. A device can be grayed out even if a signature update applies to it but if the required engine upgrade or generic packages are not available. Following are some of the instances when devices might be grayed out and the corresponding tooltip labels:

 
      
      		 [bookmark: pgfId-838928]If the version of the selected signature or sensor package is lower than the version of the target IPS device, Security Manager grays out the device and a mouse-over tooltip displays the message "Selected package is inapplicable".

 
      		 [bookmark: pgfId-838930]If you try to use Security Manager to upgrade an IPS device from version 7.2.2, with SNMP policy configured, to version 7.3.1, a mouse-over tooltip displays the message "Selected upgrade is not recommended. Unassign the SNMP policy on the device and deploy it to continue with the upgrade to 7.3.1". This is because SNMPv3 is not supported in IPS version 7.3.1.

 
      		 [bookmark: pgfId-838932]If you try to use Security Manager to perform a signature update that does not contain one or more threat profiles applied to the device, Security Manager grays out the device and a mouse-over tooltip displays the message "Currently applied threat profile is not applicable to this signature version". It does not allow the signature update to be successfully applied. You must remove the existing threat profile and then proceed with the signature update.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-838934]Tip If you later decide that you did not want to apply a signature update, you can revert to the previous update level by selecting the Signatures policy on the device, clicking the View Update Level button, and clicking Revert.


     
      

     

     

 
     [bookmark: pgfId-838936]Before You Begin

 
     [bookmark: pgfId-838941]Configure the IPS Update server as described in Configuring the IPS Update Server.

 
     [bookmark: pgfId-838943]Related Topics

 
      
      		 [bookmark: pgfId-838948]Checking for IPS Updates and Downloading Them

 
      		 [bookmark: pgfId-838953]Selecting a Signature Category for Cisco IOS IPS

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-838955]Note This note describes a difference between the update packages for IPS 7.1.3 and those used for earlier versions. When you open the Apply IPS Update wizard (Tools > Apply IPS Update), the first page of the wizard lists the sensor and signature update packages that are available. Beginning with IPS 7.1.3, a single update package is used for all supported platforms, such as IPS-4270 and ASA-SSE-AIP-85; example: IPS-CSM-K9-7.1.3.zip. Prior to IPS 7.1.3, a separate package was used for each supported platform; example: IPS-CS-MGR-SSC_5-K9-6.2-4-E4.zip.


     
      

     

     

 
     
 
     [bookmark: pgfId-838957]Step 1 Select Tools > Apply IPS Update to open the Apply IPS Update wizard.

 
     [bookmark: pgfId-838959]Step 2 On the first page of the wizard, select the update that you want to apply. This page lists the sensor and signature updates that are available. Do the following on this page:

 
      
      		 [bookmark: pgfId-838964]To update the list of packages, click  Download Latest Updates . Security Manager logs into the IPS Update server and downloads the updates that have become available since the last download. This works only if you have configured an update server as described in Configuring the IPS Update Server. You can also update the list of packages by doing the following:

 
     

 
     [bookmark: pgfId-838969] – Configure automatic downloads on the IPS Updates page (select Tools > Security Manager Administration > IPS Updates). For more information, see IPS Updates Page.

 
     [bookmark: pgfId-838971] – Manually download the updates to the CSCOpx\MDC\ips\updates folder in the product installation folder (typically Program Files) on the Security Manager server.

 
     [bookmark: pgfId-838976]You can also check for updates without downloading them by clicking Check for Updates. The Update Status information is the same as described in IPS Updates Page.

 
      
      		 [bookmark: pgfId-838978]Select the signature or sensor update you want to apply to your IPS devices in the Updates Downloaded table. Use the  Type field to toggle between the types of updates (you can select only one update to apply):

 
     

 
     [bookmark: pgfId-838980] – Sensor Updates—Displays the filename, the major, minor, service pack, and patch versions, as well as the supported engine release. You must apply all major sensor updates, however, minor updates are cumulative.

 
     [bookmark: pgfId-838982] – Signature Updates—Displays the filename, the signature number, and the supported engine release. Signature updates are cumulative; however, applying them as separate packages allows you to separate your work into more manageable units if you intend to tune the updates to match the specific needs of your network.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-838984]Note The engine package is not listed on the update page, but Security Manager implicitly pushes the engine package automatically in the case of a signature update that requires a higher engine version. (This occurs only when updating a device with the particular version that the engine package requires.)


     
      

     

     

 
     [bookmark: pgfId-838986]Click Next to continue.

 
     [bookmark: pgfId-838988]Step 3 On the second page of the wizard, select the local signature policies (representing devices not assigned to any shared signature policy) and shared signature policies you want to update from the Apply Updates To list. Use the Type field to toggle between the types of policies. You can select any combination of local and shared policies. When you select a policy, the devices that use the policy are selected for update.

 
     [bookmark: pgfId-838990]To select all applicable devices or shared policies, click Select All. To erase your selection and start over, click Deselect All. These buttons apply only to the displayed list.

 
     [bookmark: pgfId-838992]IPS devices to which the update does not apply are grayed out in the Apply Updates To list, and you cannot select them. When you select a device that can be updated, it is listed in the Devices Assigned to Selected Policies list; these are the only devices that will be updated. If you select a shared policy, all devices that are using the policy appear in the selected policies list, but the devices to which the update does not apply are grayed out.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-838994]Tip The engine release controls which devices you can select for sensor updates; you can apply the update only to devices that use the same engine version, regardless of the release version. For example, if your device is running 6.0(5) E3, you can update to 6.1(1) E3 but not to 6.1(1) E2. You also cannot apply a 6.1(1) E3 update to a device running 6.1(1) E2. If you want to update the engine version, select a signature update with the higher engine version, and Security Manager will update the engine level automatically while updating the signatures. For example, if the device has the 6.1(1) E2 version and needs to have the E3 engine package applied, choose the signature package that requires the E3 engine and apply it to the device; doing so applies the engine package automatically to the device while updating the signatures. Thus, if the device you want to update is grayed out, click Back and change your update selection.


     
      

     

     

 
     [bookmark: pgfId-838996]If you are applying a signature update, and you want to edit the signatures before applying them, click Next to continue. Otherwise, click Finish to apply your update to the policies.

 
     [bookmark: pgfId-838998]Step 4 (Optional) On the third page of the wizard, modify the signatures as desired.

 
     [bookmark: pgfId-839000]The signatures list displays the new and modified signatures between the signature level of the selected update and the lowest signature level among the selected devices. If the selected devices include both IPS sensors and Cisco IOS IPS devices, the signatures for these devices appear on separate tabs.

 
     [bookmark: pgfId-839002]Click the link in the ID number to read the description for the signature on Cisco.com. The Status column indicates whether the signature is new or modified (see the visual description of the icons on the wizard page).

 
     [bookmark: pgfId-839004]To edit a signature, select it in the table and click the Edit button below the table (the pencil icon). For help in understanding the signature, click Help in the dialog box that the Edit button opens.

 
     [bookmark: pgfId-839009]For details on available signature information, see Signatures Page. In the Signature Summary Table, you can also add custom signatures and delete signatures, but you cannot do that on this page of the Apply IPS Update Wizard.

 
     [bookmark: pgfId-839011]Click Finish to apply your update to the policies and to save your edits.

 
     [bookmark: pgfId-839013]Step 5 Submit your changes and deploy them to the devices. For information on creating deployment jobs, see these topics:

 
      
      		 [bookmark: pgfId-839018]Deploying Configurations in Non-Workflow Mode

 
      		 [bookmark: pgfId-839023]Deploying Configurations in Workflow Mode

 
     

 
     [bookmark: pgfId-839025]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-839041][bookmark: 104965][bookmark: ipdvchap_proc_ManagingIPSCertificates]Managing IPS Certificates[bookmark: marker-839033][bookmark: marker-839035][bookmark: marker-839037][bookmark: marker-839039]

 
    [bookmark: pgfId-839043]When you configure Security Manager to use SSL (HTTPS) to communicate with your IPS devices, the certificate configured on the device must match the certificate stored in Security Manager’s certificate store. Mismatched certificates will result in communication failures during policy discovery or deployment.

 
    [bookmark: pgfId-839045]IPS devices use self-signed certificates that have a fixed validity period of about 2 years. When the certificate expires, you need to regenerate the certificate and update the certificate store with the new certificate.

 
    [bookmark: pgfId-839047]Security Manager includes a utility that you can use to synchronize the certificate store with the certificate defined on the device, to regenerate expired certificates, and to view the status of certificates (including expiration dates) on the IPS devices that you manage.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-839052]Tip If you are using HTTP for communication with the IPS devices, certificates are not used and you cannot manage them. IPS device communication settings are configured in the Security Manager Administration Device Communication page (see Device Communication Page).


    
     

    

    

 
    [bookmark: pgfId-839054]The following procedure explains how to manage your IPS certificates with Security Manager.

 
    [bookmark: pgfId-839056]Related Topics

 
     
     		 [bookmark: pgfId-839061]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-839066]Filtering Tables

 
     		 [bookmark: pgfId-839071]Manually Adding SSL Certificates for Devices that Use HTTPS Communications

 
     		 [bookmark: pgfId-839076]Security Certificate Rejected When Discovering Device

 
     		 [bookmark: pgfId-839081]Invalid Certificate Error During Device Discovery

 
    

 
    
 
    [bookmark: pgfId-839083]Step 1 Select Manage > IPS > IPS Certificates to open the IPS Certificates dialog box.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-839085]Tip The list shown in this dialog box is not automatically refreshed. Click Refresh whenever you open the dialog box to ensure that you are looking at the most current certificate expiration information.


    
     

    

    

 
    [bookmark: pgfId-839087]The dialog box lists all IPS sensors that are in the inventory according to their Security Manager display name. Not all columns are displayed (right-click any cell heading to select additional columns). The main columns of interest are the following:

 
     
     		 [bookmark: pgfId-839089] Certificate Mismatch? —Whether the certificate defined on the device is the same as that in Security Manager. This field is blank if the certificate is unavailable or non-retrievable; otherwise, it can have these values:

 
    

 
    [bookmark: pgfId-839091] – No—The device and Security Manager have the same certificate. No action is required.

 
    [bookmark: pgfId-839093] – Yes—The device and Security Manager have different certificates. If the certificate has not expired, select the device and click Sync Certificates to replace the certificate in the Security Manager certificate store with the certificate from the device.

 
     
     		 [bookmark: pgfId-839095] Valid Until on Device, Valid From on Device —These two separate columns show the date range within which the certificate is valid. The certificate expires after the Valid Until date is reached. Consider regenerating the certificate as this date approaches.

 
     		 [bookmark: pgfId-839097] Certificate Status on Device —Shows the current status of the certificate as it exists on the device:

 
    

 
    [bookmark: pgfId-839099] – Valid Certificate—The certificate is good and within the validity date range.

 
    [bookmark: pgfId-839101] – Expired Certificate—The certificate has passed its Valid Until date and is now expired. Select the device and click Regenerate Certificate to create a new valid certificate on the device and to have the certificate loaded into the Security Manager certificate store.

 
    [bookmark: pgfId-839103] – Certificate Not Yet Valid—The certificate has not yet reached its Valid From date and cannot be used yet. This might indicate a mismatch between the time settings on the device and on the Security Manager server. Ensure that the time settings are the same (consider using an NTP server). Consider regenerating the certificate.

 
    [bookmark: pgfId-839105] – Unavailable – Refresh to get Cert Info—The certificate is not currently in the Security Manager certificate store. Click Refresh to have Security Manager retrieve the certificate from the device and load it into the certificate store.

 
    [bookmark: pgfId-839107] – Nonretrievable – Cert Info not available—Security Manager was not able to log into the device and retrieve the certificate, or you are using HTTP for communications. Select the device and click Refresh.

 
    [bookmark: pgfId-839115]If refresh does not resolve the problem, ensure that the device is operating normally (that it is not down), and then check the device properties to ensure that correct credentials are configured for access (see Viewing or Changing Device Properties). If credentials are not the problem, also check the Allowed Hosts policy configured on the device and ensure that the Security Manager server is included as an allowed host (see Identifying Allowed Hosts). You can also log into Windows on the Security Manager server and use ping to see if there is a route between the server and the IPS device.

 
     
     		 [bookmark: pgfId-839117] Thumbprint on CSM, Thumbprint on Device —These separate columns show the thumbprint for the certificate in the certificate store and on the device.

 
    

 
    [bookmark: pgfId-839119]Step 2 Use any of the following buttons to perform the indicated actions. Except where indicated, if you do not select one or more devices before clicking the button, the action is performed on all listed devices, which can be time-consuming if there are a lot of IPS devices. You are warned before an operation is performed on all devices and given the option to stop it.

 
     
     		 [bookmark: pgfId-839121] Sync Certificate —Synchronize the certificate information in the Security Manager certificate store with the certificate on the device. The device certificate replaces the one in the certificate store.

 
     		 [bookmark: pgfId-839123] Regenerate Certificate —Generate a new certificate on the device and then load the new certificate into the certificate store.

 
     		 [bookmark: pgfId-839125] Refresh —Refresh the status information by having Security Manager contact the devices and retrieve certificate information, such as validity dates, and compare the certificate with the one in the certificate store. This action updates the Certificate Status on Device column and also determines whether there is a certificate mismatch.

 
     		 [bookmark: pgfId-839127] Export —Exports the entire certificates table to a comma-separated values (CSV) file. You cannot export less than the entire table. You are prompted for a file name and folder on the Security Manager server.

 
    

 
    [bookmark: pgfId-839129]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-839139][bookmark: 105072][bookmark: ipdvchap_proc_RebootingIPSSensors]Rebooting IPS Sensors[bookmark: marker-839135][bookmark: marker-839137]

 
    [bookmark: pgfId-839141]You can reboot an IPS sensor from Security Manager.

 
    [bookmark: pgfId-839143]To reboot the sensor, select it in Device view, right-click and select Reboot Device. You are asked to confirm that you want to reboot.

 
    [bookmark: pgfId-839145]Security Manager does not provide status information on the reboot process.
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     [bookmark: pgfId-740616][bookmark: 96783][bookmark: ipsvchap_cncpt_ManagingIPSDeviceInterfaces]Managing IPS Device Interfaces[bookmark: marker-740610][bookmark: marker-740612][bookmark: marker-740614]
      
      
 
     
 

 
    [bookmark: pgfId-740618]Dedicated IPS appliances and service modules have their own interface configuration, whereas Cisco IOS IPS devices are configured using the regular router interface policies. This chapter explains how to configure interfaces for dedicated IPS appliances and service modules only.

 
    [bookmark: pgfId-740620]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-740625]Understanding Interfaces

 
     		 [bookmark: pgfId-740630]Understanding Interface Modes

 
     		 [bookmark: pgfId-740635]Configuring Interfaces

 
    

 
   
 
    
     [bookmark: pgfId-740647][bookmark: 96798][bookmark: ipsvchap_cncpt_UnderstandingInterfaces]Understanding Interfaces[bookmark: marker-740641][bookmark: marker-740643][bookmark: marker-740645]

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-740653]Tip This topic is an overview of IPS interfaces. For more detailed information, including the specific interface names and locations for each type of appliance and service module, supported roles, configuration restrictions, and hardware considerations, refer to the “Configuring Interfaces” chapter of the Installing and Using Cisco Intrusion Prevention System Device Manager for the IPS software version you are using on Cisco.com. The information is also in the IME and CLI guides. For general information, see http://www.cisco.com/go/ips.


    
     

    

    

 
    [bookmark: pgfId-740655]The sensor interfaces are named according to the maximum speed and physical location of the interface. For example, GigabitEthernet2/1 supports a maximum speed of 1 Gigabit and is the second-from-the-right interface in the second-from-the bottom expansion slot.

 
    [bookmark: pgfId-740663]There are three interface roles:[bookmark: marker-740657][bookmark: marker-740659][bookmark: marker-740661]

 
     
     		 [bookmark: pgfId-740665] Command and control —The command and control interface has an IP address and is used for configuring the sensor. It receives security and status events from the sensor and queries the sensor for statistics.

 
    

 
    [bookmark: pgfId-740667]The command and control interface is permanently enabled. It is permanently mapped to a specific physical interface, which depends on the specific model of sensor. You cannot use the command and control interface as either a sensing or alternate TCP reset interface. See the IPS document cited above for a list of command and control interfaces by device type.

 
     
     		 [bookmark: pgfId-740672] Sensing —Sensing interfaces are used by the sensor to analyze traffic for security violations. A sensor has one or more sensing interfaces depending on the sensor. Sensing interfaces can operate individually in promiscuous mode or you can pair them to create inline interfaces. In promiscuous mode, packets do not flow through the sensor; the sensor analyzes a copy of the monitored traffic. In inline mode, the IPS is in the traffic flow and can directly affect the traffic. For more information about sensing modes, see Understanding Interface Modes.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-740674]Note On appliances, all sensing interfaces are disabled by default. You must enable them to use them. On modules, the sensing interfaces are permanently enabled. See the IPS document cited above for a list of sensing interfaces by device type.


    
     

    

    

 
     
     		 [bookmark: pgfId-740676] Alternate TCP reset —You can configure sensors to send TCP reset packets to try to reset a network connection between an attacker host and its intended target host. In some installations when the interface is operating in promiscuous mode, the sensor may not be able to send the TCP reset packets over the same sensing interface on which the attack was detected. In such cases, you can associate the sensing interface with an alternate TCP reset interface and any TCP resets that would otherwise be sent on the sensing interface when it is operating in promiscuous mode are instead sent out on the associated alternate TCP reset interface.

 
    

 
    [bookmark: pgfId-740678]If a sensing interface is associated with an alternate TCP reset interface, that association applies when the sensor is configured for promiscuous mode but is ignored when the sensing interface is configured for inline mode (interface or VLAN pair), because TCP resets are always sent on the sensing interfaces in those modes.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-740680]Note With the exception of IDSM-2, any sensing interface can serve as the alternate TCP reset interface for another sensing interface. The alternate TCP reset interface on IDSM-2 is fixed because of hardware limitation. However, there is only one sensing interface on IPS modules (on routers or ASA devices), so you cannot specify an alternate TCP reset interface on them. See the IPS document cited above for a list of eligible alternate TCP reset interfaces by device type, and for more information about the conditions under which you would use one.


    
     

    

    

 
   
 
    
     [bookmark: pgfId-740692][bookmark: 96846][bookmark: ipsvchap_cncpt_UnderstandingInterfaceModes]Understanding Interface Modes[bookmark: marker-740686][bookmark: marker-740688][bookmark: marker-740690]

 
    [bookmark: pgfId-740694]Sensing interfaces can operate in various modes. The mode configured for an interface determines the traffic it can inspect and how it can respond to events.

 
    [bookmark: pgfId-740696]This section contains the following topics:

 
     
     		 [bookmark: pgfId-740701]Promiscuous Mode

 
     		 [bookmark: pgfId-740706]Inline Interface Mode

 
     		 [bookmark: pgfId-740711]Inline VLAN Pair Mode

 
     		 [bookmark: pgfId-740716]VLAN Group Mode

 
    

 
     
      [bookmark: pgfId-740728][bookmark: 96861][bookmark: ipsvchap_cncpt_PromiscuousMode]Promiscuous Mode[bookmark: marker-740722][bookmark: marker-740724][bookmark: marker-740726]

 
     [bookmark: pgfId-740730]In promiscuous mode, packets do not flow through the sensor. The sensor analyzes a copy of the monitored traffic rather than the actual forwarded packet. The advantage of operating in promiscuous mode is that the sensor does not affect the packet flow with the forwarded traffic. The disadvantage of operating in promiscuous mode, however, is the sensor cannot stop malicious traffic from reaching its intended target for certain types of attacks, such as atomic attacks (single-packet attacks). The response actions implemented by promiscuous sensor devices are post-event responses and often require assistance from other networking devices, for example, routers and firewalls, to respond to an attack. While such response actions can prevent some classes of attacks, in atomic attacks the single packet has the chance of reaching the target system before the promiscuous-based sensor can apply an ACL modification on a managed device (such as a firewall, switch, or router).

 
     [bookmark: pgfId-740732]By default, all sensing interfaces are in promiscuous mode. To change an interface from inline interface mode to promiscuous mode, delete any inline interface that contains that interface and delete any inline VLAN pair subinterfaces of that interface from the interface configuration.

 
     [bookmark: pgfId-740734]Related Topics

 
      
      		 [bookmark: pgfId-740739]Understanding Interfaces

 
      		 [bookmark: pgfId-740744]Configuring Physical Interfaces

 
     

 
    
 
     
      [bookmark: pgfId-740756][bookmark: 96887][bookmark: ipsvchap_cncpt_InlineInterfaceMode]Inline Interface Mode[bookmark: marker-740750][bookmark: marker-740752][bookmark: marker-740754]

 
     [bookmark: pgfId-740758]Operating in inline interface pair mode puts the IPS directly into the traffic flow and affects packet-forwarding rates making them slower by adding latency. This allows the sensor to stop attacks by dropping malicious traffic before it reaches the intended target, thus providing a protective service. Not only is the inline device processing information on Layers 3 and 4, but it is also analyzing the contents and payload of the packets for more sophisticated embedded attacks (Layers 3 to 7). This deeper analysis lets the system identify and stop or block attacks that would normally pass through a traditional firewall device.

 
     [bookmark: pgfId-740760]In inline interface pair mode, a packet comes in through the first interface of the pair on the sensor and out the second interface of the pair. The packet is sent to the second interface of the pair unless that packet is being denied or modified by a signature.

 
     [bookmark: pgfId-740762]Notes:

 
      
      		 [bookmark: pgfId-740764]If the paired interfaces are connected to the same switch, you should configure them on the switch as access ports with different access VLANs for the two ports. Otherwise, traffic does not flow through the inline interface.

 
      		 [bookmark: pgfId-740766]You can configure IPS modules for routers and ASA devices to operate inline even though these modules have only one sensing interface.

 
     

 
     [bookmark: pgfId-740768]Related Topics

 
      
      		 [bookmark: pgfId-740773]Understanding Interfaces

 
      		 [bookmark: pgfId-740778]Configuring Inline Interface Pairs

 
     

 
    
 
     
      [bookmark: pgfId-740790][bookmark: 96920][bookmark: ipsvchap_cncpt_InlineVLANPairMode]Inline VLAN Pair Mode[bookmark: marker-740784][bookmark: marker-740786][bookmark: marker-740788]

 
     [bookmark: pgfId-740792]You can associate VLANs in pairs on a physical interface. This is known as inline VLAN pair mode. Packets received on one of the paired VLANs are analyzed and then forwarded to the other VLAN in the pair.

 
     [bookmark: pgfId-740794]Inline VLAN pair mode is an active sensing mode where a sensing interface acts as an 802.1q trunk port, and the sensor performs VLAN bridging between pairs of VLANs on the trunk. The sensor inspects the traffic it receives on each VLAN in each pair, and can either forward the packets on the other VLAN in the pair, or drop the packet if an intrusion attempt is detected. You can configure an IPS sensor to simultaneously bridge up to 255 VLAN pairs on each sensing interface. The sensor replaces the VLAN ID field in the 802.1q header of each received packet with the ID of the egress VLAN on which the sensor forwards the packet. The sensor drops all packets received on any VLANs that are not assigned to inline VLAN pairs.

 
     [bookmark: pgfId-740796]Notes:

 
      
      		 [bookmark: pgfId-740798]You cannot use the default VLAN as one of the paired VLANs in an inline VLAN pair.

 
      		 [bookmark: pgfId-740800]Inline VLAN pairs are not supported on IPS modules for routers or ASA devices.

 
     

 
     [bookmark: pgfId-740802]Related Topics

 
      
      		 [bookmark: pgfId-740807]Understanding Interfaces

 
      		 [bookmark: pgfId-740812]Configuring Inline VLAN Pairs

 
     

 
    
 
     
      [bookmark: pgfId-740824][bookmark: 96953][bookmark: ipsvchap_cncpt_VLANGroupMode]VLAN Group Mode[bookmark: marker-740818][bookmark: marker-740820][bookmark: marker-740822]

 
     [bookmark: pgfId-740826]You can divide each physical interface or inline interface into VLAN group subinterfaces, each of which consists of a group of VLANs on that interface. If you configure multiple virtual sensors, each of them can monitor one or more of these interfaces. This lets you apply multiple policies to the same sensor. The advantage is that now you can use a sensor with only a few interfaces as if it had many interfaces.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-740828]Note You cannot divide physical interfaces that are in inline VLAN pairs into VLAN groups.


     
      

     

     

 
     [bookmark: pgfId-740830]VLAN group subinterfaces associate a set of VLANs with a physical or inline interface. No VLAN can be a member of more than one VLAN group subinterface. Each VLAN group subinterface is identified by a number between 1 and 255. Subinterface 0 is a reserved subinterface number used to represent the entire unvirtualized physical or logical interface. You cannot create, delete, or modify subinterface 0 and no statistics are reported for it.

 
     [bookmark: pgfId-740832]When you create a VLAN group, it is either promiscuous or inline:

 
      
      		 [bookmark: pgfId-740837]Promiscuous VLAN group—If you configure a VLAN group on a physical interface, the VLAN group is promiscuous, as described in Promiscuous Mode.

 
      		 [bookmark: pgfId-740842]Inline VLAN group—If you configure a VLAN group on an inline interface pair (a logical interface), the VLAN group is inline, as described in Inline Interface Mode.

 
     

 
     [bookmark: pgfId-740844]Thus, VLAN groups augment the operation of promiscuous mode interfaces or inline interfaces by confining their operation to selected VLANs. Once you assign a VLAN group to an interface (physical or inline interface), the interface is no longer a plain promiscuous or inline interface pair and can only be used for inline VLAN groups.

 
     [bookmark: pgfId-740846]An unassigned VLAN group is maintained that contains all VLANs that are not specifically assigned to another VLAN group. You cannot directly specify the VLANs that are in the unassigned group. When a VLAN is added to or deleted from another VLAN group subinterface, the unassigned group is updated.

 
     [bookmark: pgfId-740848]Packets in the native VLAN of an 802.1q trunk do not normally have 802.1q encapsulation headers to identify the VLAN number to which the packets belong. A default VLAN variable is associated with each physical interface and you should set this variable to the VLAN number of the native VLAN or to 0. The value 0 indicates that the native VLAN is either unknown or you do not care if it is specified. If the default VLAN setting is 0, the following occurs:

 
      
      		 [bookmark: pgfId-740850]Any alerts triggered by packets without 802.1q encapsulation have a VLAN value of 0 reported in the alert.

 
      		 [bookmark: pgfId-740852]Non-802.1q encapsulated traffic is associated with the unassigned VLAN group and it is not possible to assign the native VLAN to any other VLAN group.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-740854]Note You can configure a port on a switch as either an access port or a trunk port. On an access port, all traffic is in a single VLAN is called the access VLAN. On a trunk port, multiple VLANs can be carried over the port, and each packet has a special header attached called the 802.1q header that contains the VLAN ID. This header is commonly referred as the VLAN tag. However, a trunk port has a special VLAN called the native VLAN. Packets in the native VLAN do not have the 802.1q headers attached. IDSM-2 can read the 802.1q headers for all nonnative traffic to determine the VLAN ID for that packet. However, IDSM-2 does not know which VLAN is configured as the native VLAN for the port in the switch configuration, so it does not know what VLAN the native packets are in. Therefore, you must tell IDSM-2 which VLAN is the native VLAN for that port. Then IDSM-2 treats any untagged packets as if they were tagged with the native VLAN ID.


     
      

     

     

 
     [bookmark: pgfId-740856]Related Topics

 
      
      		 [bookmark: pgfId-740861]Deploying VLAN Groups

 
      		 [bookmark: pgfId-740866]Understanding Interfaces

 
      		 [bookmark: pgfId-740871]Configuring VLAN Groups

 
     

 
    
 
     
      [bookmark: pgfId-740883][bookmark: 96999][bookmark: ipsvchap_cncpt_DeployingVLANGroups]Deploying VLAN Groups[bookmark: marker-740877][bookmark: marker-740879][bookmark: marker-740881]

 
     [bookmark: pgfId-740885]Because a VLAN group of an inline pair does not translate the VLAN ID, an inline paired interface must exist between two switches to use VLAN groups on a logical interface. For an appliance, you can connect the two pairs to the same switch, make them access ports, and then set the access VLANs for the two ports differently. In this configuration, the sensor connects between two VLANs, because each of the two ports is in access mode and carries only one VLAN. In this case the two ports must be in different VLANs, and the sensor bridges the two VLANs, monitoring any traffic that flows between the two VLANs. IDSM-2 also operates in this manner, because its two data ports are always connected to the same switch.

 
     [bookmark: pgfId-740887]You can also connect appliances between two switches. There are two variations. In the first variation, the two ports are configured as access ports, so they carry a single VLAN. In this way, the sensor bridges a single VLAN between the two switches.

 
     [bookmark: pgfId-740889]In the second variation, the two ports are configured as trunk ports, so they can carry multiple VLANs. In this configuration, the sensor bridges multiple VLANs between the two switches. Because multiple VLANs are carried over the inline interface pair, the VLANs can be divided into groups and each group can be assigned to a virtual sensor. The second variation does not apply to IDSM-2 because it cannot be connected in this way.

 
     [bookmark: pgfId-740891]Related Topics

 
      
      		 [bookmark: pgfId-740896]Understanding Interfaces

 
      		 [bookmark: pgfId-740901]VLAN Group Mode

 
      		 [bookmark: pgfId-740906]Configuring VLAN Groups

 
     

 
    
 
   
 
    
     [bookmark: pgfId-740918][bookmark: 97031][bookmark: ipsvchap_cncpt_ConfiguringInterfaces]Configuring Interfaces[bookmark: marker-740912][bookmark: marker-740914][bookmark: marker-740916]

 
    [bookmark: pgfId-740920]Use the Interfaces policy for IPS appliances and service modules to configure the interface settings for the device. The following topics explain how to configure the various types of settings. These topics do not apply to Cisco IOS IPS devices, which use the standard router interface policies.

 
     
     		 [bookmark: pgfId-740925]Understanding the IPS Interfaces Policy

 
     		 [bookmark: pgfId-740930]Configuring Physical Interfaces

 
     		 [bookmark: pgfId-740935]Configuring Bypass Mode

 
     		 [bookmark: pgfId-740940]Configuring CDP Mode

 
     		 [bookmark: pgfId-740945]Configuring Inline Interface Pairs

 
     		 [bookmark: pgfId-740950]Configuring Inline VLAN Pairs

 
     		 [bookmark: pgfId-740955]Configuring VLAN Groups

 
     		 [bookmark: pgfId-740960]Viewing a Summary of IPS Interface Configuration

 
    

 
     
      [bookmark: pgfId-740976][bookmark: 97071][bookmark: ipspage_cncpt_InterfacesPage-2]Understanding the IPS Interfaces Policy[bookmark: marker-740968][bookmark: marker-740970][bookmark: marker-740972][bookmark: marker-740974]

 
     [bookmark: pgfId-740978]Use the Interfaces policy to configure the physical interfaces, inline pairs, VLAN pairs, and VLAN groups on IPS appliances and service modules. This policy does not apply to Cisco IOS IPS devices.

 
     [bookmark: pgfId-740980]You can configure any single physical interface to run in promiscuous mode, inline pair mode, inline VLAN pair mode, promiscuous VLAN group, or inline VLAN group, but you cannot configure an interface in a combination of these modes.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-740982]Tip The contents of this policy differ depending on the device type and IPS software version. For example, some devices display the physical interfaces tab only; creating the other types of configurations is not supported. If a tab or option described below does not appear on the policy you are configuring, it does not apply to the device.


     
      

     

     

 
     [bookmark: pgfId-740984]Navigation Path

 
     [bookmark: pgfId-740986](Device view only) Select IPS > Interfaces from the Policy selector.

 
     [bookmark: pgfId-740988]Related Topics

 
      
      		 [bookmark: pgfId-740993]Understanding Interfaces

 
      		 [bookmark: pgfId-740998]Understanding Interface Modes

 
      		 [bookmark: pgfId-741003]Discovering Policies on Devices Already in Security Manager

 
     

 
     [bookmark: pgfId-741005]Field Reference

 
     [bookmark: pgfId-741008] 

 
      
       
        
        [bookmark: pgfId-739652]Table 37-1 [bookmark: 97111]IPS Interfaces Policy 

 
        
       
         
         		
           
           [bookmark: pgfId-739658]Element
          
  
         		
           
           [bookmark: pgfId-739660]Description
          
  
        

 
         
         		[bookmark: pgfId-739666]Physical Interfaces tab

  
         		[bookmark: pgfId-739668]The physical interfaces that are available on the device. You can edit these interfaces only (select the device and click the Edit Row button); you must perform inventory discovery on the device to obtain the correct list of physical interfaces, for example, if you add an interface card to the device.

 [bookmark: pgfId-739673]The columns displayed on the tab show the configuration of each interface and are explained in Modify Physical Interface Map Dialog Box. Note that the Administrative State column indicates whether the interface is enabled (Yes or No); you must enable an interface for it to function.

 [bookmark: pgfId-739678]For more information, see Configuring Physical Interfaces.

  
        

 
         
         		[bookmark: pgfId-739684]Inline Pairs tab

  
         		[bookmark: pgfId-739692]The inline interface pairs that allow inline mode processing, as described in Inline Interface Mode. The table shows the name of the pair, the interfaces that are part it, and a description, if any. For more information, see Configuring Inline Interface Pairs.

 
           
           		 [bookmark: pgfId-739694]To add a pair, click the  Add Row button and fill in the Add Interface Pair dialog box.

 
           		 [bookmark: pgfId-739696]To edit a pair, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-739698]To delete a pair, select it and click the  Delete Row button.

 
          

  
        

 
         
         		[bookmark: pgfId-739704]VLAN Pairs tab

  
         		[bookmark: pgfId-739712]The VLAN pairs for each physical interface, as described in Inline VLAN Pair Mode. The table shows the interface and subinterface, with the two VLANs that are paired, and a description, if any. For more information, see Configuring Inline VLAN Pairs.

 
           
           		 [bookmark: pgfId-739714]To add a pair, click the  Add Row button and fill in the Add VLAN Pair dialog box.

 
           		 [bookmark: pgfId-739716]To edit a pair, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-739718]To delete a pair, select it and click the  Delete Row button.

 
          

  
        

 
         
         		[bookmark: pgfId-739724]VLAN Groups tab

  
         		[bookmark: pgfId-739732]The VLAN groups defined for a physical interface or inline pair, as described in VLAN Group Mode. The table shows the name of the interface or pair, the VLAN group (empty means all unassigned VLANs), and a description, if any. For more information, see Configuring VLAN Groups.

 
           
           		 [bookmark: pgfId-739734]To add a group, click the  Add Row button and fill in the Add VLAN Group dialog box.

 
           		 [bookmark: pgfId-739736]To edit a group, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-739738]To delete a group, select it and click the  Delete Row button.

 
          

  
        

 
         
         		[bookmark: pgfId-739744]Summary tab

  
         		[bookmark: pgfId-739746]A summary of how you have configured the sensing interfaces—the interfaces you have configured for promiscuous mode, the interfaces you have configured as inline pairs, and the interfaces you have configured as inline VLAN pairs.

 [bookmark: pgfId-739751]For more information, see Viewing a Summary of IPS Interface Configuration.

  
        

 
         
         		[bookmark: pgfId-739757]Bypass Mode

  
         		[bookmark: pgfId-739762]The bypass mode for the device, which determines how the sensor should handle inline mode traffic when the sensor processes are temporarily stopped for upgrades or when the sensor monitoring processes fail. This is a global setting that applies to all inline mode interfaces on the device. Select the desired option; for a detailed explanation of how each of these options affect inline traffic, see Configuring Bypass Mode.

 
           
           		 [bookmark: pgfId-739764] Off (Always inspect inline traffic) —Disables bypass mode. Traffic is always inspected, and if the monitoring process of the sensor is down, traffic stops flowing.

 
           		 [bookmark: pgfId-739766] On (Never inspect inline traffic) —Traffic bypasses the Analysis Engine and is never inspected.

 
           		 [bookmark: pgfId-739768] Auto (Bypass inspection when analysis engine is stopped) —Traffic is inspected unless the monitoring process of the sensor is down, in which case traffic continues to flow through the sensor uninspected. This is the default. Auto mode is useful during sensor upgrades to ensure that traffic is still flowing while the sensor is being upgraded.

 
          

  
        

 
         
         		[bookmark: pgfId-739774]CDP Mode

  
         		[bookmark: pgfId-739779]How to handle Cisco Discovery Protocol (CDP) packets. The CDP configuration applies globally to all interfaces on the device, however, it has an effect only on inline interfaces (both inline interfaces and inline VLAN pairs). For more information, see Configuring CDP Mode. Select the desired option:

 
           
           		 [bookmark: pgfId-739781] Forward CDP packets —To allow CDP packets to pass through the sensor.

 
           		 [bookmark: pgfId-739783] Drop CDP packets —To have the sensor drop all CDP packets and not allow them to pass through the sensor. This is the default setting.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-741020][bookmark: 97219][bookmark: ipsvchap_cncpt_InterfaceSummary]Viewing a Summary of IPS Interface Configuration[bookmark: marker-741014][bookmark: marker-741016][bookmark: marker-741018]

 
     [bookmark: pgfId-741022]The Summary tab of the Interfaces policy contains a table summarizing how you have configured the sensing interfaces—the interfaces you have configured for promiscuous mode, the interfaces you have configured as inline pairs, the interfaces you have configured as inline VLAN pairs, inline VLAN groups, and promiscuous VLAN groups. The content of this table changes when you change your interface configuration.

 
     [bookmark: pgfId-741024]You can configure any single physical interface to run in promiscuous mode, inline pair mode, or inline VLAN pair mode, but you cannot configure an interface in a combination of these modes.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-741026]Tip Not all service modules have a summary tab.


     
      

     

     

 
     [bookmark: pgfId-741028]Navigation Path

 
     [bookmark: pgfId-741030](Device view) Select Interfaces from the Policy selector. Click the Summary tab.

 
     [bookmark: pgfId-741032]Related Topics

 
      
      		 [bookmark: pgfId-741037]Understanding Interfaces

 
      		 [bookmark: pgfId-741042]Understanding the IPS Interfaces Policy

 
      		 [bookmark: pgfId-741047]Configuring Physical Interfaces

 
      		 [bookmark: pgfId-741052]Configuring Bypass Mode

 
      		 [bookmark: pgfId-741057]Configuring CDP Mode

 
      		 [bookmark: pgfId-741062]Configuring Inline Interface Pairs

 
      		 [bookmark: pgfId-741067]Configuring Inline VLAN Pairs

 
      		 [bookmark: pgfId-741072]Configuring VLAN Groups

 
     

 
     [bookmark: pgfId-741074]Field Reference

 
     [bookmark: pgfId-741077] 

 
      
       
        
        [bookmark: pgfId-739796]Table 37-2 [bookmark: 97271]IPS Interface Summary Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-739802]Element
          
  
         		
           
           [bookmark: pgfId-739804]Description
          
  
        

 
         
         		[bookmark: pgfId-739810]Name

  
         		[bookmark: pgfId-739812]The name of the interface.

 [bookmark: pgfId-739814]The names are FastEthernet or GigabitEthernet for promiscuous interfaces. For inline interfaces, the name is whatever you assigned to the pair.

  
        

 
         
         		[bookmark: pgfId-739820]Subinterface Number

  
         		[bookmark: pgfId-739822]The subinterface number of the inline VLAN pair or VLAN group. Subinterface numbers can be from 1 to 255.

  
        

 
         
         		[bookmark: pgfId-739828]Inline Interface Name

  
         		[bookmark: pgfId-739830]The name of the inline interface pair.

  
        

 
         
         		[bookmark: pgfId-739836]Mode

  
         		[bookmark: pgfId-739841]The mode for the interface: promiscuous, inline, promiscuous VLAN group, or inline VLAN group and whether there are VLAN pairs. For an explanation of interface modes, see Understanding Interface Modes.

  
        

 
         
         		[bookmark: pgfId-739847]VLAN A

 [bookmark: pgfId-739849]VLAN B

  
         		[bookmark: pgfId-739851]The VLAN ID for the first and second VLANs for VLAN pairs. VLAN numbers can be from 1 to 4095.

  
        

 
         
         		[bookmark: pgfId-739857]VLAN Range

  
         		[bookmark: pgfId-739859]The range of VLAN IDs belonging to the VLAN group, for example, 100-200.

 [bookmark: pgfId-739861]If the VLAN group is configured to apply to all unassigned VLANs, the field is empty.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-741089][bookmark: 97316][bookmark: ipsvchap_proc_ConfiguringPhysicalInterfaces]Configuring Physical Interfaces[bookmark: marker-741083][bookmark: marker-741085][bookmark: marker-741087]

 
     [bookmark: pgfId-741094]The Physical Interfaces tab of the IPS Interfaces policy lists the existing physical interfaces on your sensor and their associated settings. You cannot add or delete physical interfaces in this policy; instead, you must use policy discovery to obtain the current list of interfaces from the device. Thus, if you add or remove interface cards (available for some appliances), you must rediscover the device as described in Discovering Policies on Devices Already in Security Manager.

 
     [bookmark: pgfId-741096]To configure the sensor to monitor traffic, you must enable the interface using this procedure. When you initialized the sensor using the setup command (using the command line interface on the IPS), you assigned the interface or the inline pair to a virtual sensor, and enabled the interface or inline pair. If you need to change your interfaces settings, you can do so on the Physical Interfaces tab. To assign an interface to a virtual sensor, select the Virtual Sensors policy and add or edit the virtual sensor, as appropriate.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-741101]Tip Each physical interface can be divided into VLAN group subinterfaces, each of which consists of a group of VLANs on that interface. For more information, see Configuring VLAN Groups.


     
      

     

     

 
     [bookmark: pgfId-741103]Related Topics

 
      
      		 [bookmark: pgfId-741108]Understanding Interfaces

 
      		 [bookmark: pgfId-741113]Defining A Virtual Sensor

 
      		 [bookmark: pgfId-741118]Editing Policies for a Virtual Sensor

 
      		 [bookmark: pgfId-741123]Assigning Interfaces to Virtual Sensors

 
      		 [bookmark: pgfId-741128]Configuring Bypass Mode

 
      		 [bookmark: pgfId-741133]Configuring CDP Mode

 
      		 [bookmark: pgfId-741138]Configuring Inline Interface Pairs

 
     

 
     
 
     [bookmark: pgfId-741140]Step 1 (Device view) Select Interfaces from the Policy selector, then click the Physical Interfaces tab (if necessary).

 
     [bookmark: pgfId-741142]Step 2 Select the interface whose configuration you want to change and click the Edit Row button. The Modify Physical Interface Map dialog box appears.

 
     [bookmark: pgfId-741147]Step 3 Make the desired configuration changes and click OK. Following are the settings you are most likely to want to change; for a description of all options, see Modify Physical Interface Map Dialog Box.

 
      
      		 [bookmark: pgfId-741149] Enabled —Whether the interface is enabled ( Yes or  No ). Select Yes to make the interface functional. The value of this option is shown in the Administrative State column in the Physical Interfaces tab.

 
      		 [bookmark: pgfId-741151] Default VLAN —The VLAN to which the interface is assigned.

 
      		 [bookmark: pgfId-741156] Specify Interface for TCP Reset —If you want to assign an alternate TCP reset interface, as described in Understanding Interfaces, select this option, then select the alternate interface from the  interface-name list.

 
     

 
     [bookmark: pgfId-741158]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-741174][bookmark: 97388][bookmark: ipspage_cncpt_ModifyPhysicalInterfaceMapDialogBox]Modify Physical Interface Map Dialog Box[bookmark: marker-741166][bookmark: marker-741168][bookmark: marker-741170][bookmark: marker-741172]

 
     [bookmark: pgfId-741179]Use the Modify Physical Interface Map dialog box to change the configuration of the physical interfaces of an IPS sensor. For the procedure, see Configuring Physical Interfaces.

 
     [bookmark: pgfId-741181]Navigation Path

 
     [bookmark: pgfId-741183](Device view) Select Interfaces from the Policy selector. On the Physical Interfaces tab, select an interface and click the Edit Row button.

 
     [bookmark: pgfId-741185]Related Topics

 
      
      		 [bookmark: pgfId-741190]Understanding Interfaces

 
      		 [bookmark: pgfId-741195]Understanding the IPS Interfaces Policy

 
     

 
     [bookmark: pgfId-741197]Field Reference

 
     [bookmark: pgfId-741200] 

 
      
       
        
        [bookmark: pgfId-739874]Table 37-3 [bookmark: 97426]Modify Physical Interface Map Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-739880]Element
          
  
         		
           
           [bookmark: pgfId-739882]Description
          
  
        

 
         
         		[bookmark: pgfId-739888]Name

  
         		[bookmark: pgfId-739890]The name of the physical interface.

  
        

 
         
         		[bookmark: pgfId-739896]Media Type

  
         		[bookmark: pgfId-739898]The type of media for the physical interface. The media types are the following:

 
           
           		 [bookmark: pgfId-739900]TX—Copper media.

 
           		 [bookmark: pgfId-739902]SX—Fiber media.

 
           		 [bookmark: pgfId-739904]XL—Network accelerator card.

 
           		 [bookmark: pgfId-739906]Backplane interface—An internal interface that connects the module to the backplane of the parent chassis.

 
          

  
        

 
         
         		[bookmark: pgfId-739912]Description

  
         		[bookmark: pgfId-739914]A description of the interface.

  
        

 
         
         		[bookmark: pgfId-739920]Enabled

  
         		[bookmark: pgfId-739922]Whether the interface is enabled, Yes or No.

 [bookmark: pgfId-739924]You must select Yes for the interface to be functional. You also have to assign the interface to a virtual sensor for it to monitor traffic; use the Virtual Sensors policy.

  
        

 
         
         		[bookmark: pgfId-739930]Duplex

  
         		[bookmark: pgfId-739932]The duplex setting of the interface. The duplex types are the following:

 
           
           		 [bookmark: pgfId-739934]Auto—Sets the interface to auto negotiate duplex.

 
           		 [bookmark: pgfId-739936]Full—Sets the interface to full duplex.

 
           		 [bookmark: pgfId-739938]Half—Sets the interface to half duplex.

 
          

  
        

 
         
         		[bookmark: pgfId-739944]Speed

  
         		[bookmark: pgfId-739946]The speed setting of the interface. The speed options are the following:

 
           
           		 [bookmark: pgfId-739948]Auto—Sets the interface to auto negotiate speed.

 
           		 [bookmark: pgfId-739950]10 MB—Sets the interface to 10 MB (for TX interfaces only).

 
           		 [bookmark: pgfId-739952]100 MB—Sets the interface to 100 MB (for TX interfaces only).

 
           		 [bookmark: pgfId-739954]1 GB—Sets the interface to 1 GB (for gigabit interfaces only).

 
           		 [bookmark: pgfId-739956]10 GB—Sets the interface to 10 GB (for 10 gigabit interfaces only).

 
          

  
        

 
         
         		[bookmark: pgfId-739962]Default VLAN

  
         		[bookmark: pgfId-739964]The VLAN ID associated with native traffic, or 0 if unknown or if you do not care which VLAN it is.

  
        

 
         
         		[bookmark: pgfId-739970]Specify Interface for TCP Reset

 [bookmark: pgfId-739972]interface-name

  
         		[bookmark: pgfId-739974]Whether to send TCP resets on an alternate interface when this interface is used for promiscuous monitoring and the reset action is triggered by a signature firing.

 [bookmark: pgfId-739976]If you select this option, select the alternate TCP reset interface from the interface-name list.

 [bookmark: pgfId-739981]For more information about alternate TCP reset, see Understanding Interfaces.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-741214][bookmark: 97511][bookmark: ipsvchap_proc_ConfiguringBypassMode]Configuring Bypass Mode[bookmark: marker-741206][bookmark: marker-741208][bookmark: marker-741210][bookmark: marker-741212]

 
     [bookmark: pgfId-741216]You can use inline bypass as a diagnostic tool and a failover protection mechanism. Normally, the sensor Analysis Engine performs packet analysis. When inline bypass is activated, Analysis Engine is bypassed, allowing traffic to flow through the inline interfaces and inline VLAN pairs without inspection. Inline bypass ensures that packets continue to flow through the sensor when the sensor processes are temporarily stopped for upgrades or when the sensor monitoring processes fail. There are three modes: on, off, and automatic. By default, bypass mode is set to automatic.

 
     [bookmark: pgfId-741218]Keep the following factors in mind before deciding which bypass mode to use:

 
      
      		 [bookmark: pgfId-741220]There are security consequences when you put the sensor in bypass mode. When bypass mode is on, the traffic bypasses the sensor and is not inspected; therefore, the sensor cannot prevent malicious attacks.

 
      		 [bookmark: pgfId-741222]The inline bypass functionality is implemented in software, so it functions only when the operating system is running. If the sensor is powered off or shut down, inline bypass does not work—traffic does not flow through the sensor.

 
      		 [bookmark: pgfId-741224]When the sensor applies a signature or global correlation update, it might trigger bypass. Whether bypass is triggered depends on the traffic load of the sensor and the size of the signature or global correlation update. If bypass mode is turned off, an inline sensor stops passing traffic while the update is being applied.

 
     

 
     [bookmark: pgfId-741226]To change the bypass mode setting, follow these steps:

 
     
 
     [bookmark: pgfId-741228]Step 1 (Device view) Select the Interfaces policy from the Policy selector.

 
     [bookmark: pgfId-741230]Step 2 In the Bypass Mode field at the bottom of the policy, select the desired option:

 
      
      		 [bookmark: pgfId-741232] Off (Always inspect inline traffic) —Disables bypass mode.

 
     

 
     [bookmark: pgfId-741234]Traffic flows through the sensor for inspection. If the monitoring process of the sensor is down, traffic stops flowing. This means that inline traffic is always inspected.

 
      
      		 [bookmark: pgfId-741236] On (Never inspect inline traffic) —Traffic bypasses the Analysis Engine and is not inspected. This means that inline traffic is never inspected.

 
      		 [bookmark: pgfId-741238] Auto (Bypass inspection when analysis engine is stopped) —Traffic flows through the sensor for inspection unless the monitoring process of the sensor is down. This is the default.

 
     

 
     [bookmark: pgfId-741240]If the monitoring process of the sensor is down, traffic bypasses the sensor until the sensor is running again. The sensor then inspects the traffic. Auto mode is useful during sensor upgrades to ensure that traffic is still flowing while the sensor is being upgraded. Auto mode also helps to ensure traffic continues to pass through the sensor if the monitoring process fails.

 
     [bookmark: pgfId-741242]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-741256][bookmark: 97560][bookmark: ipsvchap_proc_ConfiguringCDPMode]Configuring CDP Mode[bookmark: marker-741248][bookmark: marker-741250][bookmark: marker-741252][bookmark: marker-741254]

 
     [bookmark: pgfId-741258]You can configure the IPS sensor to enable or disable the forwarding of Cisco Discovery Protocol (CDP) packets. The CDP configuration applies globally to all interfaces on the device, however, it has an effect only on inline interfaces (both inline interfaces and inline VLAN pairs).

 
     [bookmark: pgfId-741260]Cisco Discovery Protocol is a media- and protocol-independent device-discovery protocol that runs on all Cisco-manufactured equipment, including routers, access servers, bridges, and switches. Using CDP, a device can advertise its existence to other devices and receive information about other devices on the same LAN or on the remote side of a WAN. CDP runs on all media that support SNAP, including LANs, Frame Relay, and ATM media.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-741262]Tip The CDP Mode setting is not available on all IPS appliances and service modules. If the CDP Mode field does not appear on the Interfaces policy, the setting does not apply to the device you are configuring.


     
      

     

     

 
     [bookmark: pgfId-741264]To change the CDP mode setting on a device, follow these steps:

 
     
 
     [bookmark: pgfId-741266]Step 1 (Device view) Select the Interfaces policy from the Policy selector.

 
     [bookmark: pgfId-741268]Step 2 In the CDP Mode field at the bottom of the policy, select the desired option:

 
      
      		 [bookmark: pgfId-741270] Forward CDP packets —To allow CDP packets to pass through the sensor.

 
      		 [bookmark: pgfId-741272] Drop CDP packets —To have the sensor drop all CDP packets and not allow them to pass through the sensor. This is the default setting.

 
     

 
     [bookmark: pgfId-741274]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-741288][bookmark: 97598][bookmark: ipsvchap_proc_ConfiguringInlinePairs]Configuring Inline Interface Pairs[bookmark: marker-741282][bookmark: marker-741284][bookmark: marker-741286]

 
     [bookmark: pgfId-741293]You can pair interfaces on your sensor if your sensor is capable of inline monitoring. For more information about inline pairs, see Inline Interface Mode.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-741295]Tip IPS modules for routers and ASA devices do not need an inline pair for monitoring. You only need to add the physical interface to a virtual sensor.


     
      

     

     

 
     [bookmark: pgfId-741297]Related Topics

 
      
      		 [bookmark: pgfId-741302]Understanding Interfaces

 
      		 [bookmark: pgfId-741307]Configuring Bypass Mode

 
      		 [bookmark: pgfId-741312]Configuring CDP Mode

 
      		 [bookmark: pgfId-741317]Configuring Physical Interfaces

 
      		 [bookmark: pgfId-741322]Configuring VLAN Groups

 
      		 [bookmark: pgfId-741327]Defining A Virtual Sensor

 
      		 [bookmark: pgfId-741332]Editing Policies for a Virtual Sensor

 
      		 [bookmark: pgfId-741337]Assigning Interfaces to Virtual Sensors

 
     

 
     
 
     [bookmark: pgfId-741339]Step 1 (Device view) Select Interfaces from the Policy selector, then click the Inline Pairs tab.

 
     [bookmark: pgfId-741341]Step 2 Do one of the following:

 
      
      		 [bookmark: pgfId-741343]To add a pair, click the  Add Row button. The Add Interface Pair dialog box opens.

 
      		 [bookmark: pgfId-741345]To edit a pair, select it and click the  Edit Row button. The Edit Interface Pair dialog box opens.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-741347]Tip You can also delete a pair by selecting it and clicking the Delete Row button. You cannot delete an inline pair if there is an inline VLAN group. First delete the inline VLAN group from the VLAN Groups tab, and then delete the inline pair.


     
      

     

     

 
     [bookmark: pgfId-741349]Step 3 In the Add or Edit Inline Pairs dialog box, configure the following options:

 
      
      		 [bookmark: pgfId-741351] Inline Interface Name —The name you want to give to this inline pair. The name cannot be longer than 32 characters; alphanumeric and underscore characters are allowed. You cannot edit this name after you create the pair.

 
      		 [bookmark: pgfId-741353] Interface 1 and 2 —Select the two physical interfaces that you want to form a pair. The lists include only those interfaces that are defined on the Physical Interfaces tab and that are not already part of an inline pair, VLAN pair, or VLAN group.

 
      		 [bookmark: pgfId-741355] Description —An optional description for the pair.

 
     

 
     [bookmark: pgfId-741357]Step 4 Click OK to save your changes.

 
     [bookmark: pgfId-741359]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-741375][bookmark: 97678][bookmark: ipsvchap_proc_ConfiguringVLANPairs]Configuring Inline VLAN Pairs[bookmark: marker-741367][bookmark: marker-741369][bookmark: marker-741371][bookmark: marker-741373]

 
     [bookmark: pgfId-741380]Use the VLAN Pairs tab of the IPS Interfaces policy to configure the VLAN pairs for physical interfaces. The summary table displays the existing VLAN pairs for each physical interface. You can create multiple VLAN pairs on a single physical interface. For more information about inline VLAN pair mode, see Inline VLAN Pair Mode.

 
     [bookmark: pgfId-741382]Tips

 
      
      		 [bookmark: pgfId-741384]You cannot create a VLAN pair for an interface if it is already part of an inline interface pair; create VLAN groups for inline interface pairs.

 
      		 [bookmark: pgfId-741386]To create an inline VLAN pair for an interface that is in promiscuous mode and assigned to a virtual sensor, you must first remove the interface from the virtual sensor (using the Virtual Sensors policy) and then create the inline VLAN pair.

 
      		 [bookmark: pgfId-741388]You cannot use the default VLAN as one of the paired VLANs in an inline VLAN pair.

 
      		 [bookmark: pgfId-741390]If your sensor does not support inline VLAN pairs, the VLAN Pairs pane is not displayed. IPS modules on routers and ASA devices do not support inline VLAN pairs.

 
      		 [bookmark: pgfId-741396]When using inline VLAN pairs, you should configure UniDirectional Link Detection (UDLD) on the connected switch that is hosting the VLANs. UDLD can help switches prevent spanning-tree forwarding loops and single direction links. For detailed information, see  Configuring UDLD in    Installing and Using Intrusion Prevention System Device Manager .

 
     

 
     [bookmark: pgfId-741398]Related Topics

 
      
      		 [bookmark: pgfId-741403]Understanding Interfaces

 
      		 [bookmark: pgfId-741408]Configuring Bypass Mode

 
      		 [bookmark: pgfId-741413]Configuring CDP Mode

 
      		 [bookmark: pgfId-741418]Configuring Physical Interfaces

 
      		 [bookmark: pgfId-741423]Configuring VLAN Groups

 
     

 
     
 
     [bookmark: pgfId-741425]Step 1 (Device view) Select Interfaces from the Policy selector, then click the VLAN Pairs tab.

 
     [bookmark: pgfId-741427]Step 2 Do one of the following:

 
      
      		 [bookmark: pgfId-741429]To add a pair, click the  Add Row button. The Add VLAN Pair dialog box opens.

 
      		 [bookmark: pgfId-741431]To edit a pair, select it and click the  Edit Row button. The Edit VLAN Pair dialog box opens.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-741433]Tip You can also delete a pair by selecting it and clicking the Delete Row button. You cannot delete an inline VLAN pair if it is assigned to a virtual sensor. First remove the assignment to the virtual sensor using the Virtual Sensors policy, and then delete the inline VLAN pair.


     
      

     

     

 
     [bookmark: pgfId-741435]Step 3 In the Add or Edit VLAN Pairs dialog box, configure the following options:

 
      
      		 [bookmark: pgfId-741437] Physical Interfaces —Select the physical interface on which you are creating this VLAN pair. The list includes only those interfaces that are defined on the Physical Interfaces tab and that are not already part of an inline interface pair or VLAN group. However, you can create multiple VLAN pairs on a single interface.

 
      		 [bookmark: pgfId-741439] Subinterface Number —Enter a number to assign as a subinterface. The number must be unique on the interface, that is, it cannot already be assigned to another VLAN pair on the selected physical interface. Subinterface numbers can be from 1 to 255.

 
      		 [bookmark: pgfId-741441] Description —An optional description for the pair.

 
      		 [bookmark: pgfId-741443] VLAN A, B —The numbers of the two VLANs that you want to join as a pair. VLAN numbers are from 1 to 4095. You must enter different numbers, and the numbers must not already be part of another VLAN pair on the selected physical interface.

 
     

 
     [bookmark: pgfId-741445]Step 4 Click OK to save your changes.

 
     [bookmark: pgfId-741447]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-741463][bookmark: 97770][bookmark: ipsvchap_proc_ConfiguringVLANGroups]Configuring VLAN Groups[bookmark: marker-741455][bookmark: marker-741457][bookmark: marker-741459][bookmark: marker-741461]

 
     [bookmark: pgfId-741468]Use the VLAN Groups tab of the IPS Interfaces policy to configure the VLAN groups for physical interfaces and inline interface pairs (logical interfaces). The summary table displays the existing VLAN groups. You can create multiple VLAN groups on a single physical interface or inline interface pair. For more information about VLAN group mode, see VLAN Group Mode.

 
     [bookmark: pgfId-741470]A VLAN group consists of a group of VLAN IDs that exist on an interface. Each VLAN group consists of at least one VLAN ID. You can have up to 255 VLAN groups per interface (logical or physical). Each group can contain any number of VLAN IDs.

 
     [bookmark: pgfId-741472]After you assign the VLAN IDs to the VLAN group, you must assign the VLAN group to a virtual sensor for it to be operational. You can assign a single group to at most one virtual sensor. Use the Virtual Sensors policy to make the assignment.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-741474]Note VLAN groups are supported in IPS 6.0 and later only. Not all IPS appliances or service modules support VLAN groups. If the VLAN Groups tab does not appear in the Interfaces policy, the device you are configuring does not support the feature.


     
      

     

     

 
     [bookmark: pgfId-741476]Related Topics

 
      
      		 [bookmark: pgfId-741481]Understanding Interfaces

 
      		 [bookmark: pgfId-741486]Configuring Bypass Mode

 
      		 [bookmark: pgfId-741491]Configuring CDP Mode

 
      		 [bookmark: pgfId-741496]Configuring Physical Interfaces

 
      		 [bookmark: pgfId-741501]Defining A Virtual Sensor

 
      		 [bookmark: pgfId-741506]Editing Policies for a Virtual Sensor

 
      		 [bookmark: pgfId-741511]Assigning Interfaces to Virtual Sensors

 
     

 
     
 
     [bookmark: pgfId-741513]Step 1 (Device view) Select Interfaces from the Policy selector, then click the VLAN Groups tab.

 
     [bookmark: pgfId-741515]The table shows the existing VLAN groups, including the interface for which the group is defined, the subinterface number, description (if any), and the VLANs assigned to the group. If the VLANs cell is empty, the group is defined for all unassigned VLANs on the interface.

 
     [bookmark: pgfId-741517]Step 2 Do one of the following:

 
      
      		 [bookmark: pgfId-741519]To add a pair, click the  Add Row button. The Add VLAN Group dialog box opens.

 
      		 [bookmark: pgfId-741521]To edit a pair, select it and click the  Edit Row button. The Edit VLAN Group dialog box opens.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-741523]Tip You can also delete a group by selecting it and clicking the Delete Row button. You cannot delete a VLAN group if it is assigned to a virtual sensor. First remove the assignment to the virtual sensor using the Virtual Sensors policy, and then delete the VLAN group.


     
      

     

     

 
     [bookmark: pgfId-741525]Step 3 In the Add or Edit VLAN Group dialog box, configure the following options:

 
      
      		 [bookmark: pgfId-741527] Physical and Logical Interfaces —Select the physical interface or inline interface pair for which you are creating this VLAN group. The list includes only unpaired physical interfaces (defined on the Physical Interfaces tab) that do not already have inline VLAN pairs defined, or inline interface pairs that are defined on the Inline Pairs tab. You can create multiple VLAN groups on a single interface. Keep the following in mind:

 
     

 
     [bookmark: pgfId-741529] – If you select a physical interface, you are creating a promiscuous VLAN group.

 
     [bookmark: pgfId-741531] – If you select a logical interface, you are creating an inline VLAN group.

 
      
      		 [bookmark: pgfId-741533] Subinterface Number —Enter a number to assign as a subinterface. The number must be unique on the interface, that is, it cannot already be assigned to another VLAN group on the selected interface. Subinterface numbers can be from 1 to 255.

 
      		 [bookmark: pgfId-741535] Description —An optional description for the group.

 
      		 [bookmark: pgfId-741537]VLAN assignment—Select one of the following options:

 
     

 
     [bookmark: pgfId-741539] – All Unassigned VLAN IDs—The group contains all VLANs that are not assigned to other VLAN groups. This is the default option

 
     [bookmark: pgfId-741541] – Range of free VLAN IDs—The group contains specific VLANs. In the Range box, enter any combination of single VLAN IDs or ranges (separate starting and ending ID with a hyphen), and separate multiple entries with commas. For example, 10, 12-25, 33-49. VLAN numbers are from 1 to 4095.

 
     [bookmark: pgfId-741543]The VLAN ID cannot already be in another VLAN group for the selected interface. The VLANs also must be configured on the connected switch or there will be no traffic to inspect.

 
     [bookmark: pgfId-741545]Step 4 Click OK to save your changes.

 
     [bookmark: pgfId-741547]
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     [bookmark: pgfId-471829][bookmark: 10089][bookmark: poman_cncpt_ManagingPolicies]Managing Policies[bookmark: marker-471827]
      
      
 
     
 

 
    [bookmark: pgfId-471831]The following topics describe the concept of policies in Cisco Security Manager and how to use and manage them.

 
     
     		 [bookmark: pgfId-471836]Understanding Policies

 
     		 [bookmark: pgfId-471841]Discovering Policies

 
     		 [bookmark: pgfId-471846]Managing Policies in Device View and the Site-to-Site VPN Manager

 
     		 [bookmark: pgfId-471851]Working with Shared Policies in Device View or the Site-to-Site VPN Manager

 
     		 [bookmark: pgfId-471856]Managing Shared Policies in Policy View

 
     		 [bookmark: pgfId-471861]Managing Policy Bundles

 
    

 
   
 
    
     [bookmark: pgfId-471869][bookmark: 10114][bookmark: poman_cncpt_UnderstandingPolicies]Understanding Policies[bookmark: marker-471867]

 
    [bookmark: pgfId-471871]In Security Manager, a policy is a set of rules or parameters that define a particular aspect of network configuration. You configure your network by defining policies on devices (which includes individual devices, service modules, security contexts, and virtual sensors) and VPN topologies (which are made up of multiple devices), and then deploying the configurations defined by these policies to these devices.

 
    [bookmark: pgfId-471873]Several types of policies might be required to configure a particular solution. For example, to configure a site-to-site VPN, you might need to configure multiple policies, such as IPsec, IKE, GRE, and so forth.

 
    [bookmark: pgfId-471875]Policies are assigned to one or more devices. After a policy is assigned to a device, any changes to the policy definition change the behavior of the device.

 
    [bookmark: pgfId-471877]The following topics describe policies in more detail:

 
     
     		 [bookmark: pgfId-471882]Settings-Based Policies vs. Rule-Based Policies

 
     		 [bookmark: pgfId-471887]Service Policies vs. Platform-Specific Policies

 
     		 [bookmark: pgfId-471892]Local Policies vs. Shared Policies

 
     		 [bookmark: pgfId-471897]Understanding Rule Inheritance

 
     		 [bookmark: pgfId-471902]Policy Management and Objects

 
     		 [bookmark: pgfId-471907]Understanding Policy Locking

 
     		 [bookmark: pgfId-471912]Customizing Policy Management for Routers and Firewall Devices

 
    

 
     
      [bookmark: pgfId-471920][bookmark: 10146][bookmark: poman_cncpt_SettingsBasedPoliciesvsRuleBasedPolicies]Settings-Based Policies vs. Rule-Based Policies[bookmark: marker-471918]

 
     [bookmark: pgfId-471922]Security Manager policies are structured as either rule-based policies or settings-based policies.

 
     [bookmark: pgfId-471924]Rule-Based Policies

 
     [bookmark: pgfId-471926]Rule-based policies contain one or more rules that govern how to handle traffic on a selected device, such as the access rules and inspection rules defined as part of a firewall service. Rule-based policies can contain hundreds or even thousands of rules arranged in a table, each defining different values for the same set of parameters. The ordering of the rules is very important, as traffic flows are assigned the first rule whose definition matches the flow (known as first matching).

 
     [bookmark: pgfId-471931]The structure of the rules table depends on whether you configure a local policy or a shared policy (see Local Policies vs. Shared Policies). If you configure a local rule-based policy for a single device, the policy contains a flat table of local rules. If you configure a shared rule-based policy (either in Device view or Policy view), the table is divided into two sections, Mandatory and Default. Mandatory rules always precede the default rules, and cannot be overridden by local or default rules. The Default section contains rules that can be overridden by mandatory and local rules. You can define rules in either the Mandatory or Default section and move rules between sections using cut-and-paste.

 
     [bookmark: pgfId-471936]When you define certain types of rule-based policies, such as firewall service policies, you can create a policy hierarchy in which rules located at lower levels in the hierarchy acquire properties from the rules located above them. This is known as rule inheritance. For example, you can define a set of inspection rules that apply globally to all firewalls, while supplementing these rules with additional rules that can be applied to a subset of devices. By maintaining common rules in a parent policy, inheritance enables you to reduce the chance of introducing configuration errors that will cause deployment to fail. For more information, see Understanding Rule Inheritance.

 
     [bookmark: pgfId-471938]Settings-Based Policies

 
     [bookmark: pgfId-471940]Settings-based policies contain sets of related parameters that together define one aspect of security or device operation. For example, when you configure a Cisco IOS router, you can define a quality of service (QoS) policy that defines which interfaces are included in the policy, the type of traffic on which QoS is applied, and the definition of how this traffic should be queued and shaped. Unlike rule-based policies, which can contain hundreds of rules containing values for the same set of parameters, you can define only one set of parameters for each settings-based policy defined on a device.

 
     [bookmark: pgfId-471942]Related Topics

 
      
      		 [bookmark: pgfId-471947]Understanding Policies

 
     

 
    
 
     
      [bookmark: pgfId-471955][bookmark: 10170][bookmark: poman_cncpt_ServicePoliciesvsPlatformSpecificPolicies]Service Policies vs. Platform-Specific Policies[bookmark: marker-471953]

 
     [bookmark: pgfId-471957]Security Manager policies are divided into several domains, each of which represents a major policy category. These domains can be divided into two categories: service policies and platform-specific policies.

 
     [bookmark: pgfId-471959]Service policies are divided into the following policy domains:

 
      
      		 [bookmark: pgfId-471961]Firewall.

 
      		 [bookmark: pgfId-471963]Site-to-site VPN.

 
      		 [bookmark: pgfId-471965]Remote Access VPN.

 
      		 [bookmark: pgfId-471967]IPS service policies.

 
     

 
     [bookmark: pgfId-471969]For example, the firewall policy domain contains policies for access rules, inspection rules, and transparent rules, among others. The site-to-site VPN policy domain contains policies for IKE proposals, IPsec proposals, and preshared keys, among others. Service policies can be applied to any kind of device, regardless of platform, although there may be some variation in policy definition depending on the device type.

 
     [bookmark: pgfId-471971]Platform-specific policy domains contain policies that configure features that are specific to the selected platform. Not all platform-specific policies are directly related to security. For example, the Router policy domain contains routing policies, identity policies (Network Admission Control and 802.1x), policies related to device administration (DHCP, SNMP, device access), and other policies such as QoS and NAT.

 
     [bookmark: pgfId-471976]For routers and firewalls (ASA, PIX, FWSM), you can choose which platform-specific policies to manage. For more information, see Customizing Policy Management for Routers and Firewall Devices.

 
    
 
     
      [bookmark: pgfId-471984][bookmark: 10192][bookmark: poman_cncpt_LocalPoliciesvsSharedPolicies]Local Policies vs. Shared Policies[bookmark: marker-471982]

 
     [bookmark: pgfId-471989]The policies that you configure on devices can either be local or shared. Local policies refer to policies that are defined for a single device. Any changes that you make to a local policy affect only that device. Local policies are well-suited to smaller networks and to devices requiring nonstandard configurations. For example, you might configure a local policy on a router that requires a different OSPF routing policy than the one used by the other routers in your network. For more information about the actions you can perform on local policies, see Performing Basic Policy Management.

 
     [bookmark: pgfId-471994]As your network grows, maintaining local policies on each device greatly increases the effort required to manage these policies in a comprehensive and efficient manner. To meet this challenge, Security Manager features policy sharing. With policy sharing, you can create a single policy and assign it to multiple devices. For more information, see Sharing a Local Policy.

 
     [bookmark: pgfId-471998]Figure 5-1 [bookmark: 10202]Local vs. Shared Policies

 
     [bookmark: pgfId-472001] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-472006]For example, if you want all the Cisco IOS routers in your network to implement the same Network Admission Control (NAC) policy, you need only define a single NAC policy and share it. You can then assign the shared policy to all the routers in your network with a single action. For more information, see Modifying Shared Policy Assignments in Device View or the Site-to-Site VPN Manager.

 
     [bookmark: pgfId-472008]Any changes that you make to a shared policy are automatically applied to all the devices to which it is assigned. As a result, shared policies both streamline the process of policy creation and help maintain consistency and uniformity in your device configurations.

 
     [bookmark: pgfId-472013]For more information about the actions you can perform on shared policies, see Working with Shared Policies in Device View or the Site-to-Site VPN Manager.

 
     [bookmark: pgfId-472015]Tips

 
      
      		 [bookmark: pgfId-472020]Shared policies can be grouped together to form policy bundles. Policy bundles make managing the assignment of shared policies easier especially when working with a large number of devices. For more information, see Managing Policy Bundles.

 
      		 [bookmark: pgfId-472025]In addition to sharing policies, you can choose to inherit the rules of a rule-based policy when defining another policy of the same type. This makes it possible, for example, to maintain a set of corporate access rules that apply to all firewall devices while providing the flexibility to define additional rules on individual devices as required. For more information, see Understanding Rule Inheritance.

 
      		 [bookmark: pgfId-472033]If you use more than one Security Manager server, you can maintain a consistent set of policies among the servers by regularly exporting shared policies from your master server and importing them into the other servers. You must decide which server to use as the official policy source. For more information, see Exporting Shared Policies and Importing Policies or Devices

 
      		 [bookmark: pgfId-472035]In Version 4.7, Cisco Security Manager has added a new option to the available filtering choices in the Device Filter. This new option provides a filter for devices that have shared policies applied. To see this in the Security Manager GUI, navigate to View > Device View > Filter: > Create Filter... [in the dropdown list]. When the Create Filter dialog box appears, use the dropdown lists to select "Device," "has," and "Shared Policy," for a resulting filter of "Device has ’Shared Policy.’"

 
     

 
     [bookmark: pgfId-472039]Shared Policies and VPNs[bookmark: marker-472037]

 
     [bookmark: pgfId-472041]In the same way that shared policies facilitate device configuration, they also facilitate the configuration of VPNs. For example, you can create a shared IPsec proposal policy and assign it to multiple site-to-site VPNs. Any changes that you make to the shared policy affect all the VPNs to which the policy is assigned.

 
     [bookmark: pgfId-472046]You can assign the shared policies to an existing VPN using the Site-to-Site VPN Manager; right-click a shareable policy and select Assign Shared Policy. This is done in much the same way as assigning shared policies in Device view. You can also configure shared policies as the default policies to use in the Create VPN wizard, as described in Understanding and Configuring VPN Default Policies.

 
     [bookmark: pgfId-472048]Related Topics

 
      
      		 [bookmark: pgfId-472053]Understanding Policies

 
     

 
    
 
     
      [bookmark: pgfId-472063][bookmark: 10241][bookmark: poman_cncpt_UnderstandingRuleInheritance]Understanding Rule Inheritance[bookmark: marker-472059][bookmark: marker-472061]

 
     [bookmark: pgfId-472068]As described in Local Policies vs. Shared Policies, shared policies enable you to configure and assign a common policy definition to multiple devices. Rule inheritance takes this feature one step further by enabling a device to contain the rules defined in a shared policy in addition to local rules that are specific to that particular device. Using inheritance, Security Manager can enforce a hierarchy where policies at a lower level (called child policies) inherit the rules of policies defined above them in the hierarchy (called parent policies).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-472070]Note If a policy bundle includes a shared policy that inherits from other shared policies, those inherited rules are also applied to any devices on which the policy bundle is applied.


     
      

     

     

 
     [bookmark: pgfId-472072]Rule Order When Using Inheritance

 
     [bookmark: pgfId-472077]As described in Understanding Access Rules, an access list (ACL) consists of rules (also called access control entries or ACEs) arranged in a table. An incoming packet is compared against the first rule in the ACL. If the packet matches the rule, the packet is permitted or denied, depending on the rule. If the packet does not match, the packet is compared against the next rule in the table and so forth, until a matching rule is found and executed.

 
     [bookmark: pgfId-472083]This first-match system means that the order of rules in the table is of critical importance. When you create a shared access rule policy, Security Manager divides the rules table into multiple sections, Mandatory and Default. The Mandatory section contains rules that cannot be overridden by the local rules defined in a child policy. The Default section contains rules that can be overridden by local rules.[bookmark: marker-472079][bookmark: marker-472081]

 
     [bookmark: pgfId-472088]Figure 5-2 describes how rules are ordered in the rules table when using inheritance.

 
     [bookmark: pgfId-472092]Figure 5-2 [bookmark: 10268]Order of Rules When Using Inheritance

 
     [bookmark: pgfId-472095] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-472097]Benefits of Using Inheritance

 
     [bookmark: pgfId-472099]The ability to define rule-based policies in a hierarchical manner gives you great flexibility when defining your rule sets, and the hierarchy can extend as many levels as required. For example, you can define an access rule policy for the device at a branch office that inherits rules from a parent policy that determines access at the regional level. This policy, in turn, can inherit rules from a global access rules policy at the top of the hierarchy that sets rules at the corporate level.

 
     [bookmark: pgfId-472101]In this example, the rules are ordered in the rules table as follows:

 
     
      [bookmark: pgfId-472103]Mandatory corporate access rules
     

     
      [bookmark: pgfId-472105] Mandatory regional access rules
     

     
      [bookmark: pgfId-472107] Local rules on branch device
     

     
      [bookmark: pgfId-472109] Default regional access rules
     

     
      [bookmark: pgfId-472111]Default corporate access rules
     

     
      [bookmark: pgfId-472113] 
     

     
      [bookmark: pgfId-472115] 
     

     [bookmark: pgfId-472117]The policy defined on the branch device is a child of the regional policy and a grandchild of the corporate policy. Structuring inheritance in this manner enables you to define mandatory rules at the corporate level that apply to all devices and that cannot be overridden by rules at a lower level in the hierarchy. At the same time, rule inheritance provides the flexibility to add local rules for specific devices where needed.

 
     [bookmark: pgfId-472119]Having default rules makes it possible to define a global default rule, such as “deny any any”, that appears at the end of all access rule lists and provides a final measure of security should gaps exist in the mandatory rules and default rules that appear above it in the rules table.

 
     [bookmark: pgfId-472121]Inheritance Example

 
     [bookmark: pgfId-472123]For example, you can define a mandatory worm mitigation rule in the corporate access rules policy that mitigates or blocks the worm to all devices with a single entry. Devices configured with the regional access rules policy can inherit the worm mitigation rule from the corporate policy while adding rules that apply at the regional level. For example, you can create a rule that allows FTP traffic to all devices in one region while blocking FTP to devices in all other regions. However, the mandatory rule at the corporate level always appears at the top of the access rules list. Any mandatory rules that you define in a child policy are placed after the mandatory rules defined in the parent policy.

 
     [bookmark: pgfId-472125]With default rules, the order is reversed—default rules defined in a child policy appear before default rules inherited from the parent policy. Default rules appear after any local rules that are defined on the device, which makes it possible to define a local rule that overrides a default rule. For example, if a regional default rule denies FTP traffic to a list of destinations, you can define a local rule that permits one of those destinations.

 
     [bookmark: pgfId-472127]IPS Policy Inheritance

 
     [bookmark: pgfId-472129]Event action filter policies for IPS devices can also use inheritance to add rules defined in a parent policy to the local rules defined on a particular device. The only difference is that although active and inactive rules are displayed together in the Security Manager interface, all inactive rules are deployed last, after the inherited default rules.

 
     [bookmark: pgfId-472134]Signature policies for IPS devices use a different type of inheritance that can be applied on a per-signature basis. See Configuring Signatures.

 
     [bookmark: pgfId-472136]Related Topics

 
      
      		 [bookmark: pgfId-472141]Settings-Based Policies vs. Rule-Based Policies

 
      		 [bookmark: pgfId-472146]Understanding Access Rules

 
      		 [bookmark: pgfId-472151]Understanding Global Access Rules

 
      		 [bookmark: pgfId-472156]Inheritance vs. Assignment

 
      		 [bookmark: pgfId-472161]Inheriting or Uninheriting Rules

 
     

 
    
 
     
      [bookmark: pgfId-472171][bookmark: 10310][bookmark: poman_cncpt_InheritancevsAssignment]Inheritance vs. Assignment[bookmark: marker-472167][bookmark: marker-472169]

 
     [bookmark: pgfId-472173]It is important to understand the difference between rule inheritance and policy assignment:

 
      
      		 [bookmark: pgfId-472175]Inheritance—When you inherit the rules from a selected policy, you do not overwrite the local rules that are already configured on the device. Instead, the inherited rules are  added to the local rules. If the inherited rules are mandatory rules, they are added before the local rules. If the inherited rules are default rules, they are added  after the local rules. Any changes that you make to the inherited rules in the parent policy are reflected in the policy that inherits those rules.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-472180]Note Inheritance works differently for IPS signature policies and signature event actions. For more information, see Understanding Signature Inheritance.


     
      

     

     

 
      
      		 [bookmark: pgfId-472182]Assignment—When you assign a shared policy to a device, you  replace whatever was already configured on the device with the selected policy. This holds true whether the device previously had a local policy or a different shared policy of that type.

 
     

 
     [bookmark: pgfId-472184]Therefore, when working with rule-based policies such as access rules, you must use discretion when choosing these options. Use inheritance to supplement the local rules on the device with additional rules from a parent policy. Use assignment to replace the policy on the device with a selected shared policy.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-472186]Tip To prevent overwriting your local rules by mistake, Security Manager displays a warning message when you select the Assigned Shared Policy option for a rule-based policy. The message provides you the option of inheriting the rules of the policy instead of assigning it. Choose the inheritance option if you want to preserve your local rules.


     
      

     

     

 
     [bookmark: pgfId-472188]Related Topics

 
      
      		 [bookmark: pgfId-472193]Understanding Rule Inheritance

 
      		 [bookmark: pgfId-472198]Inheriting or Uninheriting Rules

 
      		 [bookmark: pgfId-472203]Local Policies vs. Shared Policies

 
      		 [bookmark: pgfId-472208]Settings-Based Policies vs. Rule-Based Policies

 
     

 
    
 
     
      [bookmark: pgfId-472218][bookmark: 10349][bookmark: poman_cncpt_PolicyManagementandObjects]Policy Management and Objects[bookmark: marker-472214][bookmark: marker-472216]

 
     [bookmark: pgfId-472220]Objects make it easier to configure policies in Security Manager by providing a set of values with a logical, easy-to-remember name that can be applied wherever it is needed. For example, you can define a network/host object called MyNetwork that contains a set of IP addresses in your network. Whenever you configure a policy requiring these addresses, you can simply refer to the MyNetwork object instead of manually entering the addresses each time.

 
     [bookmark: pgfId-472228]When you define a policy, you can create objects on the fly by clicking the Select button next to any field that accepts an object as a value. For more information, see Selecting Objects for Policies. You can also create and manage objects system-wide from the Policy Object Manager.

 
     [bookmark: pgfId-472236]Policy objects also are created when you discover policies that already exist on a device. You can discover policies when you add a device to the Security Manager inventory, or you can discover policies on devices that are already in the inventory, as described in Discovering Policies. You can configure Security Manager to reuse already-defined policy objects for newly-discovered policies. For more information on configuring policy object settings for discovery, see Discovery Page.

 
     [bookmark: pgfId-472241]Certain types of objects enable you to override their predefined values at the device level, which enables you to use an object in a policy while retaining the ability to customize particular values. For more information, see Understanding Policy Object Overrides for Individual Devices.

 
     [bookmark: pgfId-472246]For more information about objects and how to use them when defining policies, see Chapter 6, “Managing Policy Objects”.

 
     [bookmark: pgfId-472248]Related Topics

 
      
      		 [bookmark: pgfId-472253]Understanding Policies

 
     

 
    
 
     
      [bookmark: pgfId-472263][bookmark: 10376][bookmark: poman_cncpt_UnderstandingLocking]Understanding Policy Locking[bookmark: marker-472259][bookmark: marker-472261]

 
     [bookmark: pgfId-472265]Security Manager has a policy locking mechanism that is useful in organizations where several people have the authority to make configuration changes. It prevents a potential situation in which two or more people are making changes to the same device, policy, policy assignment, or object at the same time. When a lock is applied, a message is displayed across the top of the work area to other users who access that device or policy.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-472270]Tip Security Manager also obtains activity (or configuration session) locks, which are broader in scope than policy locks, when users perform some actions. For more information, see Activities and Locking.


     
      

     

     

 
     [bookmark: pgfId-472272]Lock Types

 
     [bookmark: pgfId-472274]Security Manager uses two different types of locks:

 
      
      		 [bookmark: pgfId-472276]Policy content locks—Locks the content of a particular policy. The banner displayed above the work area reads:

 
     

 
     [bookmark: pgfId-472278]This data for this policy is locked by activity/user: <name>.

 
     [bookmark: pgfId-472280]The content lock prevents other users from making any changes to the configuration of the locked policy.

 
      
      		 [bookmark: pgfId-472282]Assignment locks—Locks the assignment of a policy type to a particular device. The banner displayed above the work area reads:

 
     

 
     [bookmark: pgfId-472284]The assignment of this policy is locked by activity/user: <name>.

 
     [bookmark: pgfId-472286]For a local policy, an assignment lock prevents other users from unassigning the policy or assigning a shared policy of the same type in place of the local policy. For a shared policy, an assignment lock prevents other users from assigning a different shared policy of the same type in place of one already assigned.

 
     [bookmark: pgfId-472288]These locks can either work together or independently of one another, depending on the actions being performed by the user. If both locks are active at the same time, the banner displayed above the work area reads:

 
     [bookmark: pgfId-472290]This policy is locked by activity/user: <name>.

 
     [bookmark: pgfId-472295]See Understanding Locking and Policies for a summary of the effects locking has on the actions you can perform.

 
     [bookmark: pgfId-472297]Releasing Locks

 
     [bookmark: pgfId-472302]After is locked is enabled, it remains in place until you either submit your changes (when working in non-Workflow mode) or submit and approve the activity (when working in Workflow mode). If you discard the activity, any locks generated by the activity are also discarded. For more information about workflow modes, see Workflow and Activities Overview.

 
     [bookmark: pgfId-472304]Keep in mind that:

 
      
      		 [bookmark: pgfId-472306]Locks are based on the device name, not the IP address of the device. Therefore, we recommend that you avoid defining two devices with different names but the same IP address in Security Manager. Any attempt to deploy to both devices, especially at the same time, leads to unpredictable results.

 
      		 [bookmark: pgfId-472308]In addition, locks do not extend across different operations. For example, locking does not prevent one user from deploying to the same device that is being discovered by a different user.

 
     

 
     [bookmark: pgfId-472310]Additional details about locking can be found in the following sections:

 
      
      		 [bookmark: pgfId-472315]Understanding Locking and Policies

 
      		 [bookmark: pgfId-472320]Understanding Locking and VPN Topologies

 
      		 [bookmark: pgfId-472325]Understanding Locking and Objects

 
     

 
    
 
     
      [bookmark: pgfId-472333][bookmark: 10427][bookmark: poman_cncpt_UnderstandingLockingandPolicies]Understanding Locking and Policies[bookmark: marker-472331]

 
     [bookmark: pgfId-472338]Table 5-1 summarizes the effects of policy locks in Security Manager.
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     [bookmark: pgfId-472342]Note The ability to modify policies and policy assignments is dependent on the user permissions assigned to the user. See the Installation Guide for Cisco Security Manager.


     
      

     

     

 
     [bookmark: pgfId-472345] 

 
      
       
        
        [bookmark: pgfId-469964]Table 5-1 [bookmark: 10439]Locking Summary 

 
        
       
         
         		
           
           [bookmark: pgfId-469972]If Another User or Activity...
          
  
         		
           
           [bookmark: pgfId-469974]You Cannot...
          
  
         		
           
           [bookmark: pgfId-469976]You Can...
          
  
        

 
         
         		[bookmark: pgfId-469984]Changes a policy definition

  
         		
           
           		 [bookmark: pgfId-469986]Modify the policy or assign it to other devices.

 
           		 [bookmark: pgfId-469988]Unassign the policy (if it is a local policy)

 
          

  
         		[bookmark: pgfId-469990]Unassign the policy from any device (if it is shared).

  
        

 
         
         		[bookmark: pgfId-469998]Changes the definition of a rule-based policy with descendants

  
         		
           
           		 [bookmark: pgfId-470000]Modify the parent policy or any of the descendants.

 
           		 [bookmark: pgfId-470002]Assign the parent policy or any of its descendants to additional devices.

 
           		 [bookmark: pgfId-470004]Change the rule inheritance of the parent policy or any of the descendants.

 
          

  
         		[bookmark: pgfId-470006]Unassign the policy from any device.

  
        

 
         
         		[bookmark: pgfId-470014]Changes a policy assignment without changing its definition

  
         		[bookmark: pgfId-470016]Modify the policy.

 [bookmark: pgfId-470018]Note In Policy view, a content lock is placed on the policy. In Device view, an assignment lock is placed on those devices whose assignment is being changed by the other user.

  
         		[bookmark: pgfId-470020]Assign and unassign the policy from other devices.

  
        

 
         
         		[bookmark: pgfId-470028]Changes a policy definition and changes its assignment

  
         		[bookmark: pgfId-470030]Modify the policy or assign it to other devices.

  
         		[bookmark: pgfId-470032]Unassign the policy from any device.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-472347]Related Topics

 
      
      		 [bookmark: pgfId-472352]Understanding Policy Locking

 
      		 [bookmark: pgfId-472357]Understanding Policies

 
     

 
    
 
     
      [bookmark: pgfId-472367][bookmark: 10500][bookmark: poman_cncpt_UnderstandingLockingandVPNTopologies]Understanding Locking and VPN Topologies[bookmark: marker-472363][bookmark: marker-472365]

 
     [bookmark: pgfId-472369]If you change the device assignment for a VPN topology, or make changes to a specific VPN policy, a lock is placed on the whole VPN topology, and on any other topologies in which the policy is shared. This means that other users cannot make changes to the device assignment, nor can they make changes to any of the VPN policies defined for those VPN topologies.

 
     [bookmark: pgfId-472373]In order to view and modify site-to-site VPN policies, you must have the required permissions for each device in the VPN topology. You also need permissions to add a device to a VPN topology. If you have different levels of permissions to the devices in the VPN topology, the lowest permission level is applied to the entire topology. For example, if you have read/write permissions to the spokes in a hub-and-spoke topology, but read-only permissions to the device serving as the hub, you are granted read-only permission to the policies and devices in the hub-and-spoke topology. For more information about permissions, see Installation Guide for Cisco Security Manager.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-472375]Note Unassigning devices from a VPN topology also creates device locks in the VPN topology, which means that these devices cannot be deleted from the inventory. Other users cannot edit the device assignments for the topology until you deploy configurations to all affected devices, including those you remove. The device is not actually removed from the topology until you deploy configurations.


     
      

     

     

 
     [bookmark: pgfId-472377]Related Topics

 
      
      		 [bookmark: pgfId-472382]Understanding Policy Locking

 
      		 [bookmark: pgfId-472387]Chapter 25, “Managing Site-to-Site VPNs: The Basics”

 
     

 
    
 
     
      [bookmark: pgfId-472395][bookmark: 10523][bookmark: poman_cncpt_UnderstandingLockingandObjects]Understanding Locking and Objects[bookmark: marker-472393]

 
     [bookmark: pgfId-472397]When you create or modify a reusable object, that object is locked to prevent other users from modifying or deleting the same object. Additional rules for object locking include:

 
      
      		 [bookmark: pgfId-472399]An object lock does not prevent you from modifying the definition or assignment of a policy that uses that object.

 
      		 [bookmark: pgfId-472401]The lock placed on a policy does not prevent you from making changes to an object that is included in the policy definition.

 
      		 [bookmark: pgfId-472403]You can change the definition of any object even if it is part of a policy assigned to a device to which you do  not have permissions.

 
      		 [bookmark: pgfId-472405]When an object makes use of other objects (such as network/host objects and AAA server group objects), the lock on the object does not prevent another user from modifying those other objects. For example, when you modify a AAA server group object, the lock on that object does not prevent another user from modifying any of the AAA servers that make up the AAA server group.

 
     

 
     [bookmark: pgfId-472407]When an object is locked, users who try to modify that object see a read-only version of the relevant dialog box. When you are working in Workflow mode, a message indicates which activity has locked the object.

 
     [bookmark: pgfId-472409]Related Topics

 
      
      		 [bookmark: pgfId-472414]Understanding Policy Locking

 
      		 [bookmark: pgfId-472419]Chapter 6, “Managing Policy Objects”

 
     

 
    
 
     
      [bookmark: pgfId-472439][bookmark: 10551][bookmark: poman_cncpt_CustomizingPolicyManagement]Customizing Policy Management for Routers and Firewall Devices[bookmark: marker-472425][bookmark: marker-472427][bookmark: marker-472429][bookmark: marker-472431][bookmark: marker-472433][bookmark: marker-472435][bookmark: marker-472437]

 
     [bookmark: pgfId-472441]When you manage Cisco IOS routers or ASA, PIX, or FWSM firewall devices, you have the option of selecting which policy types to manage with Security Manager and which policy types to leave unmanaged. Managing a policy type means that Security Manager controls the configuration of the policy and considers the information that it stores in its database about that policy to be the desired configuration. Security Manager does not configure unmanaged policy types, nor does it track configurations of these types that were configured using other methods. For example, if you decide not to manage SNMP policies, any SNMP configurations that you configured using CLI commands are unknown to Security Manager.

 
      
      [image: ] 
     
 
     
 
     
      [bookmark: pgfId-472443]
      Caution If you use AUS or CNS to deploy configurations to ASA or PIX devices, be aware that the device downloads a full configuration from AUS or CNS. Thus, reducing the policies managed by Security Manager actually removes the configurations from the device. If you intend to deselect some ASA/PIX policies for management to use other applications along with Security Manager to configure devices, do not use AUS or CNS.
       
       
 
      

     
 
     [bookmark: pgfId-472445]The ability to customize policy management on routers and firewalls makes it possible, for example, to use Security Manager to manage DHCP and NAT policies while leaving routing protocol policies, such as EIGRP and RIP, unmanaged. These settings, which can be modified only by a user with administrative permissions, affect all Security Manager users.

 
     [bookmark: pgfId-472447]Unmanaged policies are removed from both Device view and Policy view. Any existing policies of that type, local or shared, are removed from the Security Manager database.

 
     [bookmark: pgfId-472452]To customize policy management for routers and firewalls, select Tools > Security Manager Administration > Policy Management to open the Policy Management Page. The policy types are organized in folders, with router and firewall (which includes all ASA, PIX, and FWSM devices) handled separately. Select or deselect policy types as desired and click Save. Subsequent processing depends on whether you are changing a policy type to be managed or unmanaged:

 
      
      		 [bookmark: pgfId-472454] Unmanaging a policy type —If you unmanage a policy type, and any device of that type has that policy configured, you must unassign the policies before unmanaging them. Security Manager displays a list of all devices that have assigned policies of that type, including the policy name, device name, and the user or activity that has a lock on the policy. If you click  Yes to continue unmanaging the policy, Security Manager obtains the required locks, unassigns the policies, and then unmanages the policy type.

 
     

 
     [bookmark: pgfId-472456]If a lock could not be obtained for even one device, no policies are unassigned, the policy type is not unmanaged, and you are told of the problem. You can then either manually unassign the policies from the affected devices, or release the user or activity locks, and try again to unmanage the policy type.
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     [bookmark: pgfId-472458]Note Unmanaging a policy has no effect on the active configuration running on the device; Security Manager does not remove the configuration from the device. Instead, unmanaging the policy removes it from the database, and Security Manager no longer considers that part of the device configuration.


     
      

     

     

 
      
      		 [bookmark: pgfId-472460] Managing a previously-unmanaged policy type —If you start managing a policy type that you previously did not manage using Security Manager, it is possible that the active configuration on the device has commands controlled by the newly-managed policy type.  It is therefore important that you rediscover policies on all devices of that type (either all routers or all ASA, PIX, FWSM devices) . This ensures that Security Manager has the current configuration for these policies.

 
     

 
     [bookmark: pgfId-472465]If you do not rediscover policies and leave the newly-managed policies unconfigured, on the next deployment to the device, the existing settings configured on the device are removed. For more information on discovering policies on devices already managed, see Discovering Policies on Devices Already in Security Manager.
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     [bookmark: pgfId-472470]Note Features that are unmanaged by Security Manager can still be modified manually with CLI commands or FlexConfigs. For more information about FlexConfigs, see Chapter 7, “Managing FlexConfigs”.


     
      

     

     

 
    
 
   
 
    
     [bookmark: pgfId-472482][bookmark: 10599][bookmark: poman_cncpt_DiscoveringPolicies]Discovering Policies[bookmark: marker-472476][bookmark: marker-472478][bookmark: marker-472480]

 
    [bookmark: pgfId-472484]Policy discovery enables you to bring your existing network configuration into Security Manager to be managed. Policy discovery can be performed by importing the configuration of a live device or by importing a configuration file. If you import a configuration file, the file must have been generated by the device (for example, by using the show run command on Cisco IOS Software devices); you cannot discover configuration files in any other format.

 
    [bookmark: pgfId-472489]You can initiate policy discovery when you add a device by selecting the relevant options in the New Device wizard. For more information, see Adding Devices to the Device Inventory.

 
    [bookmark: pgfId-472494]You can also initiate policy discovery on existing devices from Device view. For more information, see Discovering Policies on Devices Already in Security Manager.

 
    [bookmark: pgfId-472496]When you initiate policy discovery on a device, the system analyzes the configuration on the device and then translates this configuration into Security Manager policies and policy objects so that the device can be managed. Warnings are displayed if the imported configuration completes only a partial policy definition. If additional settings are required, you must go to the relevant page in the Security Manager interface to complete the policy definition. Warnings and errors are also displayed if the imported configuration is invalid.

 
    [bookmark: pgfId-472501]After performing policy discovery, you must submit your changes (or approve your activity when working in Workflow mode) to have the information included in change reports and to make the information available to other users. If you make any changes to the discovered policies, you must deploy the changes to the device for them to take effect. For more information, see Chapter 8, “Managing Deployment”.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-472506]Tip Use the Security Manager Administration window to configure discovery-related settings that apply to all devices. For more information, see Discovery Page.


    
     

    

    

 
    [bookmark: pgfId-472512]Policy Discovery and VPNs[bookmark: marker-472508][bookmark: marker-472510]

 
    [bookmark: pgfId-472514]In addition to performing discovery on individual devices, Security Manager allows you to discover the VPNs that are already deployed in your network. How you discover VPNs depends on the type of VPN being discovered:

 
     
     		 [bookmark: pgfId-472519]Site-to-Site VPNs—A wizard walks you through the discovery procedure step by step. For more information, see Site-To-Site VPN Discovery.
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    [bookmark: pgfId-472521]Tip We recommend that you deploy to a file immediately after discovering a Site-to-Site VPN. This enables Security Manager to assume full management of the relevant CLI commands that are configured on the device.


    
     

    

    

 
     
     		 [bookmark: pgfId-472532]IPSec and SSL Remote Access VPNs—You can discover IPSec and SSL VPNs when you discover policies on the device, either when you add the device to the inventory or if you discover policies on a device already in the inventory. Policies related to these VPNs are treated as regular device policies. However, when selecting discovery options, you must specifically select to discover RA VPN policies. For more information about remote access VPN policy discovery, see Discovering Remote Access VPN Policies. For more information about performing policy discovery, see Adding Devices to the Device Inventory and Discovering Policies on Devices Already in Security Manager.
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    [bookmark: pgfId-472534]Note If you add a device using a configuration file, and discover security policies while adding the device, Security Manager cannot successfully discover policies that require that files be downloaded from the discovered device. This especially affects devices that include the svc image command in an SSL VPN configuration. Because Security Manager does not have the referenced file in its database, the no form of the command is generated for the discovered configuration.


    
     

    

    

 
    [bookmark: pgfId-472544]Policy Discovery and Cisco IOS Routers and Catalyst Devices[bookmark: marker-472536][bookmark: marker-472538][bookmark: marker-472540][bookmark: marker-472542]

 
    [bookmark: pgfId-472552]Security Manager supports a subset of the complete list of commands available in the Cisco IOS software, mostly centered on security-related commands. You can discover all supported Cisco IOS commands. Commands that are not supported are left in place unless they conflict directly with a policy configured in Security Manager. For more information about performing policy discovery on Cisco IOS routers, see Discovering Router Policies. For more information about performing policy discovery on Catalyst devices, see Discovering Policies on Cisco Catalyst Switches and Cisco 7600 Series Routers.
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    [bookmark: pgfId-472554]Tip We recommend that you deploy to a file immediately after discovering a Cisco IOS router or Catalyst device. This enables Security Manager to assume full management of the relevant CLI commands that are configured on the device.


    
     

    

    

 
    [bookmark: pgfId-472568]Policy Discovery and Firewall Security Contents[bookmark: marker-472556][bookmark: marker-472558][bookmark: marker-472560][bookmark: marker-472562][bookmark: marker-472564][bookmark: marker-472566]

 
    [bookmark: pgfId-472573]When you add a device that has security contexts, you should discover all contexts and policies at the same time; otherwise, you will have to discover policies for each context separately. When you add the device, select MULTI for Context and do not select Security Context of Unmanaged Device. (If you select this option, only the admin context is imported, and it has no relationship to other security contexts on the device; select this option only if you want to manage the security context independently from the parent device.) Depending on how you add the device, you might need to select the option to discover security contexts. During discovery, Security Manager identifies each security context and adds it as a separate device to the device list, appending the security context name to the end of the parent’s name; for example, if the parent is pix_141, the admin context would be pix_141_admin. (You can control the naming convention for security contexts; for more information, see Discovery Page). You can create new security contexts, or delete existing contexts, as well as create and delete policies for those contexts.

 
    [bookmark: pgfId-472575]If you create multiple security contexts on FWSM, which are contained in Catalyst 6500 devices, and you are running IOS software on the chassis, add the chassis device using the SSH credentials for the chassis. Then Security Manager can identify each FWSM on the chassis, and give you the option to add each of them. During FWSM discovery, Security Manager discovers the security contexts for each FWSM, including the policies for the FWSM and for each context. However, if you are using the Catalyst OS on the device, you must discover each FWSM individually.

 
    [bookmark: pgfId-472580]For more information about adding devices to the inventory, see Adding Devices to the Device Inventory.

 
    [bookmark: pgfId-472588]Policy Discovery and IPS Devices[bookmark: marker-472582][bookmark: marker-472584][bookmark: marker-472586]

 
    [bookmark: pgfId-472590]When you discover policies on an IPS device, the virtual sensors defined on the device are also discovered along with the policies defined for the virtual sensors. If more than one virtual sensor uses the same policy, that policy is created as a shared policy and is assigned to the virtual sensors. Policies defined for a single virtual sensor, or only for the parent device, are created as local policies. You cannot discover policies just for an individual virtual sensor; you can discover policies only on the parent device. If policies are discovered on the parent device that are not assigned to any virtual sensors, those policies are created as shared policies that are not assigned to any device or virtual sensor.

 
    [bookmark: pgfId-472592]After discovering an IPS device that contains virtual sensors, you must submit your changes to the database for the virtual sensors to appear in the device selector.

 
    [bookmark: pgfId-472598]Policy Discovery and Object Groups[bookmark: marker-472594][bookmark: marker-472596]

 
    [bookmark: pgfId-472603]When you perform policy discovery, any object groups already configured on PIX, ASA, FWSM, and IOS 12.4(20)T+ devices are brought into Security Manager as policy objects. For more information about how Security Manager policy objects are translated into object groups and vice-versa, see How Policy Objects are Provisioned as Object Groups.

 
    [bookmark: pgfId-472605]In addition, object network and object service configurations on ASA 8.3+ devices are brought into Security Manager as host, network, or address range network/host objects, or service objects (as opposed to service group objects). The only exception is that address range objects that have the same address for the start and end range are instead created as host network/host objects.
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    [bookmark: pgfId-472607]Note For IOS devices, any objects discovered that are used by access control lists that are discovered as ACL objects are subsequently replaced during deployment by the contents of the object. Object groups used with ACL objects are not preserved, although they are discovered as Security Manager policy objects.


    
     

    

    

 
    [bookmark: pgfId-472613]Policy Discovery and Security Manager Policy Objects[bookmark: marker-472609][bookmark: marker-472611]

 
    [bookmark: pgfId-472615]When you perform policy discovery, Security Manager tries to reuse the policy objects that you have already created in Security Manager. Based on the contents of the device configuration, the following are the possible actions:

 
     
     		 [bookmark: pgfId-472617]Named policy objects in the configuration—Existing policy objects are reused if their content matches the configuration on the device.

 
    

 
    [bookmark: pgfId-472619]If the contents of the named policy object does not match, the policy object is reused and a device-level override is created if Allow Device Override for Discovered Policy Objects is selected on the Discovery administration page. For more information, see these topics:

 
    [bookmark: pgfId-472624] – Understanding Policy Object Overrides for Individual Devices

 
    [bookmark: pgfId-472629] – Discovery Page

 
     
     		 [bookmark: pgfId-472631]Unnamed policy objects in the configuration—Existing policy objects are used if their content matches the configuration on the device. You can control this behavior by changing the value of the  Reuse Policy Objects for Inline Values setting on the Discovery administration page.

 
     		 [bookmark: pgfId-472636]You can discover objects that have the same definition as existing objects, regardless of the setting you have defined for detecting redundant objects. For more information about this setting, see Policy Objects Page.

 
    

 
    [bookmark: pgfId-472641]For more information on policy objects, see Chapter 6, “Managing Policy Objects”.

 
    [bookmark: pgfId-472647]Policy Discovery and Access Control Lists[bookmark: marker-472643][bookmark: marker-472645]

 
    [bookmark: pgfId-472649]Certain policies in Security Manager support only standard or only extended ACLs, even if both types are supported by the CLI. In such cases, policy discovery works as follows:

 
     
     		 [bookmark: pgfId-472651]If the Security Manager policy supports only extended ACLs (for example, firewall service policies), any standard ACLs configured on the device for that policy are imported as extended ACLs.

 
     		 [bookmark: pgfId-472653]If the Security Manager policy supports only standard ACLs (for example, SNMP traps on IOS routers), any extended ACLs configured on the device for that policy are imported as standard ACLs.

 
    

 
    [bookmark: pgfId-472655]During the discovery process, Security Manager will show any inactive ACLs that are imported as disabled. If you later deploy these disabled ACLs, they are removed from the device configuration.

 
    [bookmark: pgfId-472657]Related Topics

 
     
     		 [bookmark: pgfId-472662]Frequently Asked Questions about Policy Discovery

 
     		 [bookmark: pgfId-472667]Viewing Policy Discovery Task Status

 
     		 [bookmark: pgfId-472672]Understanding Policy Object Overrides for Individual Devices

 
    

 
     
      [bookmark: pgfId-472688][bookmark: 10770][bookmark: poman_proc_DiscoveringPoliciesonDevicesAlreadyinSecurityManager]Discovering Policies on Devices Already in Security Manager[bookmark: marker-472680][bookmark: marker-472682][bookmark: marker-472684][bookmark: marker-472686]

 
     [bookmark: pgfId-472690]When you add a device to the inventory, you can discover policies at the same time that you add the device. However, you can skip policy discovery and do it later, or rediscover policies after adding the device.

 
     [bookmark: pgfId-472692]You might initiate policy discovery on existing devices when:

 
      
      		 [bookmark: pgfId-472694]You discover out-of-band changes in the network, for example, changes to device configurations using CLI commands. In such a situation, you can rediscover existing policies on the device to make sure that the Security Manager database has the most current information. However, we recommend that you enter out-of-band changes in Security Manager rather than perform rediscovery.

 
      		 [bookmark: pgfId-472696]You want to discover a subset of policies (for example, platform-specific settings) that was not discovered when you first added the device to Security Manager.

 
      		 [bookmark: pgfId-472701]You want to import the factory-default configuration of a firewall device. For more information, see Default Firewall Configurations.
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      [bookmark: pgfId-472703]
      Caution If you perform policy discovery on a device 
      after configuring policies in Security Manager but before you deploy your changes, the discovered policies overwrite the undeployed changes. For example, if you select the option to discover platform-specific settings, the discovered configuration overwrites any platform-specific undeployed policies you configured in Security Manager. This is true even if the discovered configuration does not include the specific platform policy you configured. For example, discovering platform-specific settings overwrites any routing policies that you have configured for the device in Security Manager, even if the configuration you discover does not contain any routing information. Another result of rediscovery is that any shared policies that were configured on the device are replaced by the local policies that are discovered.
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      [bookmark: pgfId-472705]
      Caution Under certain conditions, Security Manager may fail to discover ASA interfaces in system context. Specifically, if a rediscovery/deployment is done on the system context of a multiple context ASA without checking (selecting) "inventory," then Security Manager may fail to discover the interfaces on other security contexts. This can potentially result in Security Manager altering or altogether deleting interface configurations of other contexts in a subsequent deployment. To avoid this problem, simply be sure to select "inventory" when doing a rediscovery of the system context.
       
       
 
      

     
 
     [bookmark: pgfId-472707]Before You Begin

 
     [bookmark: pgfId-472709]Ensure that no one is configuring policies on the device or deploying configurations to the device. If you rediscover policies on a device while a deployment job is deploying configurations to the device, you might not be able to see the deployed changes after the rediscovery. Use the Deployment Manager to determine if there are active jobs that include the device before you rediscover policies (select Manage > Deployments). If you inadvertently rediscover policies during a deployment job, wait until the deployment job is completed and then discover policies again to ensure that Security Manager is synchronized with the device.

 
     [bookmark: pgfId-472711]Related Topics

 
      
      		 [bookmark: pgfId-472716]Viewing Policy Discovery Task Status

 
      		 [bookmark: pgfId-472721]Discovering Policies

 
      		 [bookmark: pgfId-472726]Frequently Asked Questions about Policy Discovery

 
      		 [bookmark: pgfId-472731]Understanding Policies

 
      		 [bookmark: pgfId-472736]Managing Policies in Device View and the Site-to-Site VPN Manager

 
      		 [bookmark: pgfId-472741]Managing Shared Policies in Policy View

 
     

 
     
 
     [bookmark: pgfId-472743]Step 1 Decide whether you need to discover policies on a single device or if you want to discover policies on more than one device at a time. Policy discovery options vary based on how you start the discovery process.

 
      
      		 [bookmark: pgfId-472745] Single device discovery —If you need to discover policies related to any of the following, you can do it using only single-device discovery. (Note that single-device discovery is the type of discovery performed when you add a device to the inventory.)

 
     

 
     [bookmark: pgfId-472747] – Security context configurations for ASA, PIX, and FWSM devices running in multiple context mode.

 
     [bookmark: pgfId-472749] – Virtual sensor configurations for IPS devices.

 
     [bookmark: pgfId-472751] – Service module information for Catalyst devices.

 
     [bookmark: pgfId-472753] – Policy discovery from a configuration file.

 
     [bookmark: pgfId-472755] – Policy discovery from the factory default configuration.

 
      
      		 [bookmark: pgfId-472757] Bulk rediscovery —If you need to discover policies for more than one device, you can perform bulk rediscovery. However, bulk rediscovery can be performed only on live devices (that is, devices currently running and accessible in your network), and you cannot discover security context, virtual sensor, or Catalyst service module configurations. (You can discover service modules if you select them directly instead of selecting the device that contains them.)

 
     

 
     [bookmark: pgfId-472759]Step 2 If you want to perform single-device discovery, do the following:

 
     [bookmark: pgfId-472761] a. In device view or map view, ensure that only one device is selected, then right-click and select Discover Policies on Device. This opens the Create Discovery Task dialog box.

 
     [bookmark: pgfId-472763]Tip: If the dialog box is called Bulk Rediscovery, you need to close the dialog box and try again. Ensure that only a single device is selected and reissue the command. You must use the right-click menu; it is the only way to perform single-device discovery.

 
     [bookmark: pgfId-472768] b. Modify the discovery task name, if desired, and select the following discovery options. For detailed information, see Create Discovery Task and Bulk Rediscovery Dialog Boxes.

 
      
      		 [bookmark: pgfId-472770] Discover From —Whether you are discovering from a live device (which is active and accessible in the network), a configuration file (click  Browse to select the file on the Security Manager server), or factory default configuration (for ASA, PIX, and FWSM devices running an OS version for which a factory default configuration exists). You can discover the default configuration only for devices that run in single-context mode or for individual security contexts.

 
     

 
     [bookmark: pgfId-472778]Tip: We recommend that you use the Factory Default Configuration settings when you add PIX, ASA, and FWSM devices manually (as described in Adding Devices by Manual Definition). You should discover the default configuration for single-context mode devices and for each security context on a multiple-context mode device. For more information about factory-default policies, see Default Firewall Configurations.

 
      
      		 [bookmark: pgfId-472780] Discover Policies for Security Contexts —Select this option for firewall devices running in multiple-context mode if you want to discover policies for the security contexts defined on them.

 
     

 
     [bookmark: pgfId-472785] c. Select the types of policies you want to discover. For more information about the difference between different types of policies, see Service Policies vs. Platform-Specific Policies.

 
      
      		 [bookmark: pgfId-472790]Detect ASA-CX/FirePOWER Module—Determines if a CX or FirePOWER module is installed; see Detecting ASA CX and FirePOWER Modules for more information.

 
      		 [bookmark: pgfId-472792]Inventory—Discovers basic device information (such as hostname and domain name), interfaces, and security contexts on devices running in multiple-context mode. On Cisco IOS routers, this option also discovers all interface-related policies, such as DSL, PPP, and PVC policies.

 
      		 [bookmark: pgfId-472794]Platform Settings—Discovers platform-specific policies, such as routing policies.

 
      		 [bookmark: pgfId-472796]Firewall Services—Discovers firewall services policies, such as access rules and inspection rules, on all platforms.

 
      		 [bookmark: pgfId-472798]NAT Policies—Discovers network address translation (NAT) policies, such as address pools, static translation rules, and dynamic NAT/PAT. Discovery of NAT policies is supported on ASA, ASA-SM, PIX and FWSM devices.

 
      		 [bookmark: pgfId-472800]Routing Policies—Discovers routing policies for ASA devices.

 
      		 [bookmark: pgfId-472802]SSL Policy—Discovers SSL policy for ASA devices.

 
      		 [bookmark: pgfId-472804]RA VPN Policies—Discovers IPSec and SSL remote access VPN policies, such as IKE proposals and IPsec proposals.

 
      		 [bookmark: pgfId-472806]IPS—Discovers IPS policies, such as signatures and virtual sensors.

 
     

 
     [bookmark: pgfId-472811]For more information, see Create Discovery Task and Bulk Rediscovery Dialog Boxes

 
     [bookmark: pgfId-472816] d. Click OK. The discovery task is initiated and the Discovery Status dialog box opens so you can view the task status (see Discovery Status Dialog Box). You cannot perform other tasks in Security Manager while discovery is in progress.

 
     [bookmark: pgfId-472818]Step 3 If you want to perform bulk rediscovery, do the following:

 
     [bookmark: pgfId-472820] a. In device view, do one of the following:

 
      
      		 [bookmark: pgfId-472822]Select a device group, or multiple devices, then right-click and select  Discover Policies on Device . Ensure that the Bulk Rediscovery dialog box opens.

 
     

 
     [bookmark: pgfId-472824]Tip: If the dialog box is called Create Discovery Task, you need to close the dialog box and try again. Ensure that a device group or more than one device is selected and reissue the command.

 
      
      		 [bookmark: pgfId-472826]Select  Policy > Discover Policies on Device . This opens the Device Selector dialog box. Select the devices you want to discover from the Available Devices list and click  >> to move them to the Selected Devices list. Click  Next .
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     [bookmark: pgfId-472828]Note If you use the right-click command, Security Manager assumes you have selected the desired devices. You can always click the Back button to go to the Device Selector screen and change the device list.


     
      

     

     

 
     [bookmark: pgfId-472833] b. Modify the discovery task name, if desired, and select discovery options. For detailed information, see Create Discovery Task and Bulk Rediscovery Dialog Boxes.

 
     [bookmark: pgfId-472835]The devices are organized in groups according to device type, with your device groups (if any) shown within each type:

 
      
      		 [bookmark: pgfId-472837]To change options for all devices of a given type, select the device type folder and modify the Discover Device Settings options. If the Discover drop-down list shows Multiple Values, then there are different discovery options selected for devices of that type. If you change the value, it changes for all devices. The check boxes for the policy types (explained above for single-device discovery) are available only if you select Policies and Inventory. Only options available for all devices in the selected group are shown, so you might need to select individual devices separately to select the most appropriate set of options.

 
      		 [bookmark: pgfId-472839]To change options for a single device, click the + icons next to folders to open them until you find the device, select the device, and then select the discovery options.
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     [bookmark: pgfId-472841]Note When the list of options is not expanded, all policies, namely the Platform Settings, Firewall Policies, NAT Policies and RA VPN, are discovered. However, when you expand the list of options, the discovery will be based on the options that you select from the available list.


     
      

     

     

 
     [bookmark: pgfId-472846] c. Click Finish. The discovery task is initiated and the Discovery Status dialog box opens so you can view the task status (see Discovery Status Dialog Box). You cannot perform other tasks in Security Manager while discovery is in progress.

 
     [bookmark: pgfId-472848]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-472858][bookmark: 10934][bookmark: polpage_cncpt_CreateDiscoveryTaskDialogBox]Create Discovery Task and Bulk Rediscovery Dialog Boxes[bookmark: marker-472856]

 
     [bookmark: pgfId-472863]Use the Create Discovery Task dialog box to have Security Manager discover the policies for a device that is already in the device inventory. Use the Bulk Rediscovery dialog box to discover policies on more than one device at a time. Your options for policy discover differ based on which dialog box you use. For detailed information on the procedure, including how to get to each of these dialog boxes, see Discovering Policies on Devices Already in Security Manager.

 
     [bookmark: pgfId-472868]You can also discover policies when you add the device to the inventory. For more information about adding devices, see Adding Devices to the Device Inventory.

 
     [bookmark: pgfId-472870]Navigation Path

 
     [bookmark: pgfId-472872]In Device view, select a device from the Device selector and do one of the following:

 
      
      		 [bookmark: pgfId-472874]Select  Policy > Discover Policies on Device to perform bulk rediscovery.

 
      		 [bookmark: pgfId-472876]Right-click the device in the Device selector and select  Discover Policies on Device . If a single device is selected, you get the Create Discovery Task dialog box. Otherwise, you are performing bulk rediscovery.
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     [bookmark: pgfId-472878]Tip You can also right click a device in Map view and select Discover Policies on Device.


     
      

     

     

 
     [bookmark: pgfId-472880]Related Topics

 
      
      		 [bookmark: pgfId-472885]Discovering Policies

 
      		 [bookmark: pgfId-472890]Viewing Policy Discovery Task Status

 
      		 [bookmark: pgfId-472895]Selecting or Specifying a File or Directory in Security Manager

 
      		 [bookmark: pgfId-472900]Discovery Status Dialog Box

 
     

 
     [bookmark: pgfId-472902]Field Reference

 
     [bookmark: pgfId-472905] 

 
      
       
        
        [bookmark: pgfId-470045]Table 5-2 [bookmark: 10974]Create Discovery Task Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-470051]Element
          
  
         		
           
           [bookmark: pgfId-470053]Description
          
  
        

 
         
         		[bookmark: pgfId-470059]Discovery Task Name

  
         		[bookmark: pgfId-470061]The name assigned to the discovery task. Security Manager automatically generates a name for the task based on the current date and time, but you can modify this name as desired.

  
        

 
         
         		[bookmark: pgfId-470067]Selected Devices table

 [bookmark: pgfId-470069](Bulk rediscovery only)

  
         		[bookmark: pgfId-470071]The devices you selected for rediscovery. The devices are organized in groups according to device type, with your device groups (if any) shown within each type:

 
           
           		 [bookmark: pgfId-470073]To change options for all devices of a given type, select the device type folder and modify the Discover Device Settings options. If the Discover drop-down list shows Multiple Values, then there are different discovery options selected for devices of that type. If you change the value, it changes for all devices. The check boxes for the policy types (explained above for single-device discovery) are available only if you select Policies and Inventory. Only options available for all devices in the selected group are shown, so you might need to select individual devices separately to select the most appropriate set of options.

 
           		 [bookmark: pgfId-470075]To change options for a single device, click the + icons next to folders to open them until you find the device, select the device, and then select the discovery options.

 
          

 [bookmark: pgfId-470077]Tip: To change which devices are selected for rediscovery, click Back to go to the Device Selector dialog box.

  
        

 
         
         		[bookmark: pgfId-470083]Discover From

 [bookmark: pgfId-470085]Config. File

 [bookmark: pgfId-470087](Not available for bulk rediscovery)

  
         		[bookmark: pgfId-470089]The source of policy information to be discovered:

 
           
           		 [bookmark: pgfId-470091]Live Device—Discover policies directly from the device.

 
           		 [bookmark: pgfId-470093]Config File—Discover policies from a configuration file. Specify the location of the file in the  Config File field. Click  Browse to select the file on the Security Manager server.

 
          

 [bookmark: pgfId-470098]You can discover policies only from configuration files that were generated from the device (for example, with the show run command). For more information, see Adding Devices from Configuration Files.

 
           
           		 [bookmark: pgfId-470103]Factory Default Configuration—Performs discovery on a firewall device using a file containing the factory-default settings for that device. Security Manager automatically chooses the appropriate file for the selected device (shown in the Config File edit box). This option is available only if Security Manager has a default configuration for the OS version running on an ASA, PIX, or FWSM device. You can discover the default configuration only for devices that run in single-context mode or for individual security contexts. For more information, see Default Firewall Configurations.

 
          

  
        

 
         
         		[bookmark: pgfId-470109]Discover Policies for Security Contexts

 [bookmark: pgfId-470111](Not available for bulk rediscovery)

  
         		[bookmark: pgfId-470113]Whether to discover policies for each security context that is configured on a firewall device running in multiple-context mode. This field applies only to PIX, ASA, and FWSM devices.

 [bookmark: pgfId-470115]When deselected, Security Manager treats the entire device as having a single set of policies configured in single-context mode.

 [bookmark: pgfId-470120]For more information about security contexts, see Chapter 58, “Configuring Security Contexts on Firewall Devices”.

  
        

 
         
         		[bookmark: pgfId-470126]Policies to Discover (for single-device discovery)

 [bookmark: pgfId-470128]Discover Device Settings (for bulk rediscovery)

  
         		[bookmark: pgfId-470130]The policy types to discover on the selected device.

 selected, this means that the devices in the selected group have different discovery options selected. If you change the selection, your change applies to all the devices in the group.

 [bookmark: pgfId-470134]The discovery options are:

 
           
           		 [bookmark: pgfId-470139]Detect ASA-CX/FirePOWER Module—Determines if a CX module or FirePOWER module is installed; see Detecting ASA CX and FirePOWER Modules for more information.

 
           		 [bookmark: pgfId-470141]Inventory—Includes device information such as the hostname and domain name, interfaces, and security contexts (for firewall devices running in multiple-context mode). On Cisco IOS routers, this option also discovers all interface-related policies, such as DSL, PPP, and PVC policies.

 
           		 [bookmark: pgfId-470143]Platform Settings—Includes all platform-specific policies that can be configured on the selected device.

 
           		 [bookmark: pgfId-470148]Firewall Services—Includes all firewall service policies. For more information, see Chapter 12, “Introduction to Firewall Services”.

 
           		 [bookmark: pgfId-470153]NAT Policies—Includes all network address translation (NAT) policies that are configured on the selected device, such as address pools, static translation rules, and dynamic NAT/PAT. Discovery of NAT policies is supported on ASA, ASA-SM, PIX and FWSM devices. For more information, see Chapter 24, “Configuring Network Address Translation”.

 
           		 [bookmark: pgfId-470158]Routing Policies—Discovers routing policies for ASA devices. For more information, see Chapter 55, “Configuring Routing Policies on Firewall Devices”.

 
           		 [bookmark: pgfId-470160]SSL Policy—Discovers SSL policy for ASA devices.

 
           		 [bookmark: pgfId-470165]RA VPN Policies—Includes all IPSec and SSL remote access VPN policies that are configured on the selected device. This option is disabled if the device does not support remote access VPN configuration. For more information, see Chapter 30, “Managing Remote Access VPNs: The Basics”.

 
           		 [bookmark: pgfId-470173]IPS Policies—Includes all IPS policies that are configured on the selected device. For more information, see Overview of IPS Configuration or Overview of Cisco IOS IPS Configuration.

 
          

 [bookmark: pgfId-470175]Notes:

 
           
           		 [bookmark: pgfId-470177]Routing Policies and SSL Policy options are applicable for Adaptive Security Appliance (ASA) devices only.

 
           		 [bookmark: pgfId-470179]If you select Platform Settings as the policies to discover, the Routing Policies and SSL Policy which are sub options of Platform Settings, cannot be deselected.

 
           		 [bookmark: pgfId-470181]To discover either Routing Policies or SSL Policy or both, you can deselect the Platform Settings option and then select either Routing Policies or SSL policy or both to discover only those policies.

 
           		 [bookmark: pgfId-470183]For non-ASA devices, the Routing Policies and SSL Policy options may be listed but will always be unavailable for selection.

 
          

 [bookmark: pgfId-470185]In bulk rediscovery, for transparent mode and system context you can select the Routing Policies option but no discovery will happen.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-472917][bookmark: 11084][bookmark: poman_cncpt_ViewingPolicyDiscoveryTaskStatus]Viewing Policy Discovery Task Status[bookmark: marker-472911][bookmark: marker-472913][bookmark: marker-472915]

 
     [bookmark: pgfId-472919]When you initiate policy discovery a discovery task is created. For each policy discovery initiation, only one task is created regardless of the number of devices being discovered.

 
     [bookmark: pgfId-472921]You can view the status of the current policy discovery task in the Discovery Status dialog box, which opens automatically when the task is initiated. This dialog box provides updated status information about the discovery task, including summary information about the task and details about each device being discovered.

 
     [bookmark: pgfId-472923]You can abort a discovery task, if required. When you perform policy discovery on a single device, aborting the task results in partial discovery. In such cases, we recommend deleting the information and starting again. When you perform policy discovery on multiple devices, any devices for which discovery was completed before you aborted the operation are fully discovered. Security Manager automatically discards the information for any partially discovered device.

 
     [bookmark: pgfId-472925]The Discovery Status dialog box also displays the appropriate warning and error messages if any problems are encountered during the discovery process. For example, if the CLI commands in a configuration file do not define a complete Security Manager policy, a warning message is displayed that you must complete the policy definition in the relevant Security Manager policy page.

 
     [bookmark: pgfId-472930]For more information, see Discovery Status Dialog Box.

 
     [bookmark: pgfId-472935]To view information about previous discovery tasks, select Manage > Policy Discovery Status to open the Policy Discovery Status window. Select the discovery task in the top pane of the window, and the results of the task are displayed in the lower panes. For more information about using the Policy Discovery Status window, see Policy Discovery Status Page.

 
     [bookmark: pgfId-472937]Related Topics

 
      
      		 [bookmark: pgfId-472942]Discovering Policies on Devices Already in Security Manager

 
      		 [bookmark: pgfId-472947]Frequently Asked Questions about Policy Discovery

 
      		 [bookmark: pgfId-472952]Discovering Policies

 
     

 
    
 
     
      [bookmark: pgfId-472962][bookmark: 11116][bookmark: polpage_cncpt_DiscoveryStatusDialogBox]Discovery Status Dialog Box[bookmark: marker-472960]

 
     [bookmark: pgfId-472964]Use the Discovery Status dialog box to view detailed information about the current policy discovery task. The dialog box includes general information about the status of the task, as well as detailed information about any warnings or errors generated by the device being discovered.

 
     [bookmark: pgfId-472969]The Discovery Status dialog box opens automatically when you initiate a discovery task on existing devices and when you add devices from the network, from a configuration file, or from an export file. For more information about initiating a discovery task, see Discovering Policies on Devices Already in Security Manager.

 
     [bookmark: pgfId-472971]Related Topics

 
      
      		 [bookmark: pgfId-472976]Viewing Policy Discovery Task Status

 
      		 [bookmark: pgfId-472981]Discovering Policies

 
      		 [bookmark: pgfId-472986]Adding Devices from the Network

 
      		 [bookmark: pgfId-472991]Adding Devices from Configuration Files

 
      		 [bookmark: pgfId-472996]Adding Devices from an Inventory File

 
     

 
     [bookmark: pgfId-472998]Field Reference

 
     [bookmark: pgfId-473001] 

 
      
       
        
        [bookmark: pgfId-470198]Table 5-3 [bookmark: 11146]Discovery Status Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-470204]Element
          
  
         		
           
           [bookmark: pgfId-470206]Description
          
  
        

 
         
         		[bookmark: pgfId-470212]Progress bar

  
         		[bookmark: pgfId-470214]Indicates what percentage of the discovery task on the current device has been completed.

  
        

 
         
         		[bookmark: pgfId-470220]Status

  
         		[bookmark: pgfId-470222]The current state of the discovery task.

  
        

 
         
         		[bookmark: pgfId-470228]Devices to be discovered

  
         		[bookmark: pgfId-470230]The total number of devices being discovered during this task. The number includes service modules, security contexts, and virtual sensors.

  
        

 
         
         		[bookmark: pgfId-470236]Devices discovered successfully

  
         		[bookmark: pgfId-470238]The number of devices discovered without errors.

  
        

 
         
         		[bookmark: pgfId-470244]Devices discovered with errors

  
         		[bookmark: pgfId-470246]The number of devices that generated errors during discovery.

  
        

 
         
         		[bookmark: pgfId-470252]Discovery Details table

  
         		[bookmark: pgfId-470254]The devices that are being discovered. Select a device to see the messages generated during the discovery of that device in the message list below the summary list. Besides the device name, information in the table includes:

 
           
           		 [bookmark: pgfId-470256]Severity—The overall severity level of the discovery task. For example, if the discovery task completed successfully, an Information icon is displayed. If the task failed, an Error icon is displayed.

 
           		 [bookmark: pgfId-470258]State—The current state of the policy discovery task for the selected device:

 
          

 [bookmark: pgfId-470260] – Device Added—The device has been added to Security Manager, but policy discovery has not yet started.

 [bookmark: pgfId-470262] – Discovery Started—Policy discovery has started.

 [bookmark: pgfId-470264] – Reading and Parsing Device Config—The policy discovery task is interpreting the device configuration.

 [bookmark: pgfId-470266] – Importing Objects—The policy discovery task is importing objects from the configuration.

 [bookmark: pgfId-470268] – Importing Policies—The policy discovery task is importing policies from the configuration.

 [bookmark: pgfId-470270] – Discovery Complete—Policy discovery has been completed successfully.

 [bookmark: pgfId-470272] – Discovery Failed—Policy discovery failed due to errors.

 
           
           		 [bookmark: pgfId-470274]Discovered From—The source of policy information. For example, when discovering from a configuration file, this field displays the name and path of the file.

 
          

  
        

 
         
         		[bookmark: pgfId-470280]Messages list

  
         		[bookmark: pgfId-470282]The messages generated during the discovery for the selected device. Select a message to see detailed information in the fields to the right of the list.

  
        

 
         
         		[bookmark: pgfId-470288]Description

  
         		[bookmark: pgfId-470290]Additional information about the message selected in the message list.

  
        

 
         
         		[bookmark: pgfId-470296]Action

  
         		[bookmark: pgfId-470298]The steps you should take to resolve the described problem.

  
        

 
         
         		[bookmark: pgfId-470304]Generate Report button

  
         		[bookmark: pgfId-470309]Click this button to create a discovery status report for this job. The report is a PDF file, saved to your client system, that includes a summary of the job. You can use this report for your own purposes or to aid in troubleshooting a problem with Cisco TAC. For more information, see Generating Deployment or Discovery Status Reports.

  
        

 
         
         		[bookmark: pgfId-470315]Abort button

  
         		[bookmark: pgfId-470317]Aborts the discovery task.

 [bookmark: pgfId-470319]If you abort the task when performing policy discovery on a single device, the result is partial discovery of that device. In such cases, we recommend deleting the information (for example, by discarding the activity) and starting again.

 [bookmark: pgfId-470321]If you abort the task when performing policy discovery on multiple devices, Security Manager automatically discards the information for any partially discovered device. Devices for which discovery was completed before you aborted the operation are fully discovered.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-473011][bookmark: 11237][bookmark: toolpage_cncpt_PolicyDiscoveryStatusPage]Policy Discovery Status Page[bookmark: marker-473009]

 
     [bookmark: pgfId-473013]Use the Policy Discovery Status page to view the status of previous policy discovery and device addition tasks.

 
     [bookmark: pgfId-473015]Navigation Path

 
     [bookmark: pgfId-473017]Select Manage > Policy Discovery Status.

 
     [bookmark: pgfId-473019]Related Topics

 
      
      		 [bookmark: pgfId-473024]Viewing Policy Discovery Task Status

 
     

 
     [bookmark: pgfId-473026]Field Reference

 
     [bookmark: pgfId-473029] 

 
      
       
        
        [bookmark: pgfId-470334]Table 5-4 [bookmark: 11257]Policy Discovery Status Page 

 
        
       
         
         		
           
           [bookmark: pgfId-470340]Element
          
  
         		
           
           [bookmark: pgfId-470342]Description
          
  
        

 
         
         		 [bookmark: pgfId-470348]Task Table

 [bookmark: pgfId-470350]The upper portion of the window lists the previous policy discovery or device addition tasks. Select a task to view detailed information about it in the lower portion of the window. The columns in the table provide overall status information for the task.

 [bookmark: pgfId-470352]When adding devices that contain security contexts, the context discovery appears as a separate Policy Discovery task.

  
        

 
         
         		[bookmark: pgfId-470360]Name

  
         		[bookmark: pgfId-470362]The name of the discovery or device addition task. This might be a system generated name or a name you specified when rediscovering device policies.

  
        

 
         
         		[bookmark: pgfId-470368]Type

  
         		[bookmark: pgfId-470370]The type of task, either Policy Discovery (when you rediscover device policies) or Add Device (when you add a device using the New Device wizard and elect to discover policies).

  
        

 
         
         		[bookmark: pgfId-470376]Start Time

  
         		[bookmark: pgfId-470378]The time the task started.

  
        

 
         
         		[bookmark: pgfId-470384]End Time

  
         		[bookmark: pgfId-470386]The time the task stopped.

  
        

 
         
         		[bookmark: pgfId-470392]Status

  
         		[bookmark: pgfId-470394]The overall status of the task. One of the following:

 
           
           		 [bookmark: pgfId-470396]Completed successfully—The task succeeded.

 
           		 [bookmark: pgfId-470398]Completed with errors—The task was partially successful. This could occur if all policies were not discovered or if the device was added but no policies were discovered.

 
           		 [bookmark: pgfId-470400]Completed with warnings—The task was successful but a minor problem occurred.

 
           		 [bookmark: pgfId-470402]Failed—The task failed. No polices were discovered or no device was added because of errors or because you stopped discovery.

 
          

  
        

 
         
         		[bookmark: pgfId-470408]Generate Report button

  
         		[bookmark: pgfId-470410]Click this button to create a discovery status report for the selected job.

 [bookmark: pgfId-470415]The report is a PDF file, saved to your client system, that includes a summary of the job. You can use this report for your own purposes or to aid in troubleshooting a problem with Cisco TAC. For more information, see Generating Deployment or Discovery Status Reports.

  
        

 
         
         		[bookmark: pgfId-470421]Refresh button

  
         		[bookmark: pgfId-470423]Click this button to refresh the task list to update the information if there are tasks running in the background or if new tasks were created.

  
        

 
         
         		[bookmark: pgfId-470429]Delete button

  
         		[bookmark: pgfId-470431]Click this button to delete the selected task from the database. Deleting old tasks does not affect the related devices or discovered policies.

  
        

 
         
         		 [bookmark: pgfId-470437]Discovery Details or Import Details Tables

 [bookmark: pgfId-470439]These tables display the devices included in the selected task. The name differs depending on the type of task (Discovery Details for Policy Discovery tasks, Import Details for Add Device tasks).

 [bookmark: pgfId-470441]Select a device to see the messages generated during the task for that device in the message list below the table.

  
        

 
         
         		[bookmark: pgfId-470449]Device

  
         		[bookmark: pgfId-470451]The name of the device. If the name is followed by (deleted), the device is no longer in the Security Manager inventory.

  
        

 
         
         		[bookmark: pgfId-470457]Config File

 [bookmark: pgfId-470459](Import Details only)

  
         		[bookmark: pgfId-470461]The location of the configuration file. This field is displayed only if you are importing from a configuration file.

  
        

 
         
         		[bookmark: pgfId-470467]Task Type

 [bookmark: pgfId-470469](Import Details only)

  
         		[bookmark: pgfId-470471]One of the following:

 
           
           		 [bookmark: pgfId-470473]Import only—Adding devices to Security Manager.

 
           		 [bookmark: pgfId-470475]Import and Discover—Adding devices and discovering policies and inventory, or adding devices and discovering policies.

 
          

  
        

 
         
         		[bookmark: pgfId-470481]Severity

  
         		[bookmark: pgfId-470483]An icon for one of the following is displayed:

 
           
           		 [bookmark: pgfId-470485]Error—The device addition or policy discovery failed.

 
           		 [bookmark: pgfId-470487]Information—The device was added successfully or policy discovery was successful.

 
          

  
        

 
         
         		[bookmark: pgfId-470493]State

 [bookmark: pgfId-470495]Details

  
         		[bookmark: pgfId-470497]These fields have the same meaning, although different names are used in the Discovery Details and Import Details tables. The fields describe the status of the task for the device:

 
           
           		 [bookmark: pgfId-470499]Device Added—The device was successfully added to the inventory.

 
           		 [bookmark: pgfId-470501]Device Add Failed—The device was not added to the inventory.

 
           		 [bookmark: pgfId-470503]Discovery Completed—Discovery succeeded and the discovered policies are added to the Security Manager database.

 
           		 [bookmark: pgfId-470505]Discovery Failed—No polices were discovered because errors occurred.

 
          

  
        

 
         
         		[bookmark: pgfId-470511]Discovered From

 [bookmark: pgfId-470513](Discovery Details only)

  
         		[bookmark: pgfId-470515]One of the following:

 
           
           		 [bookmark: pgfId-470517]Live Device—Security Manager contacted the device to obtain configuration and policy information.

 
           		 [bookmark: pgfId-470519]File—Security Manager obtained the configuration and policy information from a configuration file.

 
          

  
        

 
         
         		[bookmark: pgfId-470525]Messages list

  
         		[bookmark: pgfId-470527]The messages generated during the task for the selected device. Select a message to see detailed information in the fields to the right of the list. The severity icons have these meanings:

 
           
           		 [bookmark: pgfId-470529]Error—A problem was detected.

 
           		 [bookmark: pgfId-470531]Warning—A minor problem occurred during discovery.

 
           		 [bookmark: pgfId-470533]Information—An informational message about the selected device.

 
          

  
        

 
         
         		[bookmark: pgfId-470539]Description

  
         		[bookmark: pgfId-470541]Additional information about the message selected in the message list.

  
        

 
         
         		[bookmark: pgfId-470547]Action

  
         		[bookmark: pgfId-470549]The steps you should take to resolve the described problem.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-473043][bookmark: 11414][bookmark: poman_cncpt_FrequentlyAskedQuestionsaboutPolicyDiscovery]Frequently Asked Questions about Policy Discovery[bookmark: marker-473035][bookmark: marker-473037][bookmark: marker-473039][bookmark: marker-473041]

 
     [bookmark: pgfId-473045]These questions and answers describe how policy discovery processes your device configurations into Security Manager policies.

 
     [bookmark: pgfId-473047]Question: How does policy discovery work?

 
     [bookmark: pgfId-473049]Answer: After you select the device whose policies, settings, and interfaces (inventory) you want to discover, Security Manager obtains the running configuration (from live devices) or the supplied configuration (when discovering from configuration files) and translates the CLI into Security Manager policies and objects. The imported configuration is added to the Configuration Archive as the initial configuration for the device. After discovery, you can review the discovered policies and objects and decide whether to commit them to the database. If you dislike them, you can discard them instead. Please note that commit and discard affect all discovered devices as a group and cannot be implemented on a per-device basis.

 
     [bookmark: pgfId-473051]Question: When should I discover policies?

 
     [bookmark: pgfId-473053]Answer: Typically, you should discover policies when you add devices to Security Manager. However, if you are creating devices in Security Manager (instead of importing live devices or configuration files), you must perform policy discovery after adding the device. You should also perform policy discovery in order to synchronize Security Manager with any out-of-band changes that have been made to the device, for example through the CLI.

 
     [bookmark: pgfId-473055]Question: How can I determine the results of the discovery?

 
     [bookmark: pgfId-473057]Answer: When you initiate a discovery task, a window opens that shows you the discovery status and results. You can also view a history of discovery task results on the Policy Discovery Status page (select Manage > Policy Discovery Status).

 
     [bookmark: pgfId-473059]Question: Does Security Manager show which commands are not discovered, and what can I do about them?

 
     [bookmark: pgfId-473061]Answer: In the discovery status window, go to the Message Summary section, then select Commands Not Discovered. Any undiscovered commands are listed in the Description field. You can either remove the command from the device and repeat the discovery process, or continue. If you continue, Security Manager will remove the unsupported command in the next deployment.

 
     [bookmark: pgfId-473063]If Security Manager does not support a command found on a device, the discovery is generally not aborted; however, if the device has any access control entries (ACEs) that refer to unsupported object groups, the discovery is aborted. Other error messages, such as User groups not supported, might also provide details about undiscovered commands. Read the information in the Action box for suggestions.

 
     [bookmark: pgfId-473065]Question: How are discovered policies reflected in the user interface?

 
     [bookmark: pgfId-473067]Answer: Security Manager converts the device commands into policies. There is no difference in appearance between a policy discovered from a device configuration and one defined directly in Security Manager.

 
     [bookmark: pgfId-473069]Question: I am using Auto Update Server for my PIX or ASA devices. How do I discover policies?

 
     [bookmark: pgfId-473071]Answer: If a device has a static IP address, you can discover policies from the device. If it has a dynamic IP address, you must discover policies from the device’s configuration file (offline).

 
     [bookmark: pgfId-473073]Question: I am using Cisco Secure ACS to manage authentication and authorization to Security Manager. How does this affect policy discovery?

 
     [bookmark: pgfId-473077]Answer: You must add all managed devices to Cisco Secure ACS before you can perform policy discovery and manage these devices in Security Manager. This includes security contexts on PIX/ASA/FWSM devices. For more information, see the Installation Guide for Cisco Security Manager.

 
     [bookmark: pgfId-473079]Question: What should I do after discovering VPN or router platform policies?

 
     [bookmark: pgfId-473081]Answer: Due to the way these features are discovered, Security Manager does not assume management of discovered VPN and router platform policies until after it deploys them. This means that if you discover a router, unassign one of its policies and deploy, no commands are removed from the router’s configuration. We recommend, therefore, that you perform deployment to a file immediately after discovering VPN or router platform policies, before you make any changes to those policies. After this initial deployment, you can reconfigure these policies and deploy your changes as required.

 
     [bookmark: pgfId-473083]Question: If I discover policies on a device and then deploy the policies from Security Manager without changing them, what is the difference between the original configuration on the device and the one that exists after the deployment?

 
     [bookmark: pgfId-473088]Answer: Typically, there will be no differences between the new configuration and your original one, assuming you set up FlexConfigs for any unsupported CLI commands. However, in certain cases minor changes might occur in your ACL or object-group naming schemes. For more information, see How Policy Objects are Provisioned as Object Groups. In addition, any discovered objects that are not being used by a policy are removed from the configuration. There can also be instances where the new configuration is functionally equivalent to the old one but does not use the same commands.

 
     [bookmark: pgfId-473090]Question: How does Security Manager handle my current CLI naming schemes for ACLs and object groups?

 
     [bookmark: pgfId-473092]Answer: When you discover policies from a device, Security Manager tries to use the same names you have used. However, depending on your naming scheme, some minor differences might occur between what you defined on your device and the policies created through discovery. Additionally, there is a possibility that a naming conflict can occur between an existing ACL or object on the device and the name required for the new policy or object; in this case, Security Manager generates a different name so as not to misconfigure the device. For example, if the name of a discovered object conflicts with an object of the same type that already exists in Security Manager, a suffix is added to the name of the new object to make it unique or a device-level override is created.

 
     [bookmark: pgfId-473094]Question: Are all configuration commands discovered and brought into Security Manager?

 
     [bookmark: pgfId-473096]Answer: No. Security Manager does not discover all device configuration commands. Instead, it discovers security policies. For any configuration commands not discovered, use the FlexConfig feature to include the commands that Security Manager does not support.

 
     [bookmark: pgfId-473098]Question: If I rediscover policies on a device already in Security Manager, what happens to the policies assigned to the device?

 
     [bookmark: pgfId-473100]Answer: If you rediscover policies on a device that you are already managing with Security Manager, the newly discovered policies replace the ones assigned to the device. All policies within the selected policy domain (firewall services, platform settings, or both) are replaced, not just the ones that are different on the device compared to the ones in the Security Manager database. If you assigned shared policies to the device, the assignment is removed and the shared policy is left unchanged (so that other devices that use the shared policy are not affected). After policy discovery, all policies assigned to the device are specific to that device; none of them are shared with other devices. If you want to use shared policies with the device, you must redo the assignments after policy discovery.

 
     [bookmark: pgfId-473102]In addition, any customizations done to local policies are also lost. For example, if you used sections to organize rules-based firewall policies, the sections are removed and the rediscovered policy is a flat list of entries.

 
     [bookmark: pgfId-473104]Question: Does Security Manager use existing policies and objects during policy discovery?

 
     [bookmark: pgfId-473106]Answer: During policy discovery, Security Manager uses existing policy objects (ones that you already defined in Security Manager) when creating policies for the device. However, Security Manager does not reuse existing policies; all policies created during discovery are local to the device being discovered. Thus, you might find it beneficial to define your policy objects (such as network objects) before adding devices to Security Manager.

 
     [bookmark: pgfId-473108]Question: After adding a device and discovering policies, I cannot submit my changes to the database; instead I get warnings such as “Connection Policies Not Set.” What must I do to complete the device addition?

 
     [bookmark: pgfId-473110]Answer: When you add a device and discover policies (particularly when you add devices from configuration files), Security Manager warns you if the resulting configuration is incomplete in ways that will prevent it from successfully managing the device. Connection policies, for example, are simply the device credentials (user names and passwords) required to log into the device, as well as other connection-related configuration settings (such as HTTP settings). Because these missing settings result in an invalid configuration or prevent Security Manager from contacting and managing the device later, you are prevented from submitting the changes to the database. Ensure that you have complete and valid configurations for these settings, then resubmit your changes to the database.

 
     [bookmark: pgfId-473114]Question: Why does the AAA policy not show the AAA configuration that I discovered on the device?[bookmark: marker-473112]

 
     [bookmark: pgfId-473116]Answer: The AAA policy contains the default configurations for authentication, authorization, and accounting. Other AAA commands that specify a particular list name are mapped to the policies that reference them. If the list name is not referenced by a policy, it is not discovered.

 
     [bookmark: pgfId-473118]Question: Why are parts of the AAA method list definitions configured on my router not discovered?

 
     [bookmark: pgfId-473120]Answer: Security Manager does not support certain keywords, such as if-needed. Method lists containing these keywords are discovered without the keyword. If the default AAA definitions on the device contain unsupported keywords, the entire command is not discovered.

 
     [bookmark: pgfId-473122]Question: Can I discover AAA servers on devices running IOS software that were configured using the server-private command?

 
     [bookmark: pgfId-473124]Answer: Yes, you can discover these servers. However, Security Manager converts them into standard AAA servers that can be used globally or in multiple AAA server groups. The server-private command is not supported.

 
     [bookmark: pgfId-473126]Question: What do I need to know about discovery and device hostnames?

 
     [bookmark: pgfId-473131]Answer: When you discover a device, the hostname policy is populated with the hostname discovered on the device. However, the hostname listed in Device Properties is not updated with this value. Ensure that the hostname defined in the device properties is the correct DNS name for the device. For more information, see Understanding Device Properties.

 
    
 
   
 
    
     [bookmark: pgfId-473145][bookmark: 11516][bookmark: poman_cncpt_ManagingPoliciesinDeviceView]Managing Policies in Device View and the Site-to-Site VPN Manager[bookmark: marker-473137][bookmark: marker-473139][bookmark: marker-473141][bookmark: marker-473143]

 
    [bookmark: pgfId-473147]You can use Device view or the Site-to-Site VPN Manager to manage both local policies and shared policies, as described in the following sections:

 
     
     		 [bookmark: pgfId-473152]Policy Status Icons

 
     		 [bookmark: pgfId-473157]Performing Basic Policy Management

 
     		 [bookmark: pgfId-473162]Working with Shared Policies in Device View or the Site-to-Site VPN Manager

 
    

 
    [bookmark: pgfId-473164]To access Device view, select View > Device View or click the Device View button on the toolbar. To access the Site-to-Site VPN Manager, select Manage > Site-to-Site VPNs or click the Site-to-Site VPN Manager button on the toolbar.

 
    [bookmark: pgfId-473166]Related Topics

 
     
     		 [bookmark: pgfId-473171]Understanding the Device View

 
     		 [bookmark: pgfId-473176]Managing Shared Policies in Policy View

 
     		 [bookmark: pgfId-473181]Understanding Policies

 
    

 
     
      [bookmark: pgfId-473193][bookmark: 11560][bookmark: poman_cncpt_PolicyStatusIcons]Policy Status Icons[bookmark: marker-473187][bookmark: marker-473189][bookmark: marker-473191]

 
      
      


      


      


      


       
        
        [bookmark: pgfId-470562]Table 5-5 [bookmark: 11574]Policy Status Icons 

 
        
       
         
         		
           
           [bookmark: pgfId-470568]Icon
          
  
         		
           
           [bookmark: pgfId-470570]Status
          
  
        

 
        
             
         		[bookmark: pgfId-470579]The policy is not configured. Upon deployment, any policy of this type already present on the device is effectively removed.

  
        

 
        
             
         		[bookmark: pgfId-470588]A local policy is configured. The definition of this policy affects only the device or VPN topology on which it is configured.

  
        

 
        
             
         		[bookmark: pgfId-470597]A shared policy is configured. Any changes to the definition of this policy affect all of the devices or VPN topologies to which this policy is assigned.

  
        

 
        
             
         		[bookmark: pgfId-470606]A policy bundle is configured. Any changes to the definition of this policy affect all of the devices or VPN topologies to which this policy is assigned, whether those policies are assigned using the same policy bundle, another policy bundle that includes the shared policy, or are assigned the shared policy directly and not through a policy bundle.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-473200]Related Topics

 
      
      		 [bookmark: pgfId-473205]Understanding Policies

 
     

 
    
 
     
      [bookmark: pgfId-473215][bookmark: 11615][bookmark: poman_cncpt_PerformingBasicPolicyManagement]Performing Basic Policy Management[bookmark: marker-473211][bookmark: marker-473213]

 
     [bookmark: pgfId-473217]The following topics describe the operations you can perform on local policies in Device view. Local policies are policies that are specific to the device or VPN topology on which they are configured. They are not shared by other network elements.

 
      
      		 [bookmark: pgfId-473222]Configuring Local Policies in Device View

 
      		 [bookmark: pgfId-473227]Copying Policies Between Devices

 
      		 [bookmark: pgfId-473232]Unassigning a Policy. (This topic also applies to the Site-to-Site VPN Manager.)

 
     

 
     [bookmark: pgfId-473234]Related Topics

 
      
      		 [bookmark: pgfId-473239]Working with Shared Policies in Device View or the Site-to-Site VPN Manager

 
      		 [bookmark: pgfId-473244]Managing Shared Policies in Policy View

 
      		 [bookmark: pgfId-473249]Understanding Policies

 
     

 
    
 
     
      [bookmark: pgfId-473263][bookmark: 11647][bookmark: poman_proc_ConfiguringLocalPoliciesinDeviceView]Configuring Local Policies in Device View[bookmark: marker-473257][bookmark: marker-473259][bookmark: marker-473261]

 
     [bookmark: pgfId-473265]Use Device view to configure local platform and service policies on individual devices. Each policy defines a particular configuration or security task that the device can perform, such as NAT, OSPF routing or inspection rules. Local policies are unnamed and are particular to the individual device on which they have been defined. Any changes that you make to a local policy do not affect other devices that Security Manager is managing.

 
     [bookmark: pgfId-473270]When you configure a policy, a lock is placed on that policy to prevent other users from making changes to the same policy at the same time. See Understanding Policy Locking.

 
     [bookmark: pgfId-473274]You can modify any local policy assigned to a particular device provided you have permissions to modify policies and to access that device. For more information about permissions, see the Installation Guide for Cisco Security Manager.

 
     [bookmark: pgfId-473279]After configuring a policy, you must deploy the changes to the device in order to make them active on that device. For more information, see Chapter 8, “Managing Deployment”

 
     [bookmark: pgfId-473281]Related Topics

 
      
      		 [bookmark: pgfId-473286]Understanding the Device View

 
      		 [bookmark: pgfId-473291]Managing Policies in Device View and the Site-to-Site VPN Manager

 
      		 [bookmark: pgfId-473296]Copying Policies Between Devices

 
      		 [bookmark: pgfId-473301]Working with Shared Policies in Device View or the Site-to-Site VPN Manager

 
     

 
     
 
     [bookmark: pgfId-473303]Step 1 In Device view, select a device from the Device selector, then select a policy for that device from the Device Policies selector. The details of the policy appear in the work area.

 
     [bookmark: pgfId-473305]Step 2 Modify the definition of the policy as required. Click the Help button to access information specific to the selected policy. For more information, see:

 
      
      		 [bookmark: pgfId-473310]Chapter 25, “Managing Site-to-Site VPNs: The Basics”

 
      		 [bookmark: pgfId-473315]Chapter 30, “Managing Remote Access VPNs: The Basics”

 
      		 [bookmark: pgfId-473320]Chapter 12, “Introduction to Firewall Services”

 
      		 [bookmark: pgfId-473325]Overview of IPS Configuration

 
      		 [bookmark: pgfId-473330]Overview of Cisco IOS IPS Configuration

 
      		 [bookmark: pgfId-473335]Chapter 60, “Managing Routers”

 
      		 [bookmark: pgfId-473340]Chapter 46, “Managing Firewall Devices”

 
      		 [bookmark: pgfId-473345]Chapter 67, “Managing Cisco Catalyst Switches and Cisco 7600 Series Routers”

 
     

 
     [bookmark: pgfId-473347]Step 3 Click Save to save your changes.

 
     [bookmark: pgfId-473352]If this is the first time you are configuring this policy on this particular device, the icon next to the selected policy changes to indicate that the policy is configured and assigned locally to the device. For more information about policy status icons, see Policy Status Icons.

 
     [bookmark: pgfId-473354]After you save the policy, the policy is configured but you are the only one who can view the changes. There are additional steps to take to commit your changes and to deploy them to the device. The exact changes depend on whether you are working in Workflow or non-Workflow mode. Before taking the additional steps, configure all of the policies that you want to deploy; you are not required to deploy policy changes one at a time.

 
     [bookmark: pgfId-473356]Following is a summary of the additional steps you need to take:

 
      
      		 [bookmark: pgfId-473358]Submit your changes. Submission updates the database on the Security Manager server with your changes.

 
     

 
     [bookmark: pgfId-473360] – In non-Workflow mode, you submit changes by selecting File > Submit. You can also submit your changes and deploy them in a single step by selecting File > Submit and Deploy.

 
     [bookmark: pgfId-473368] – In Workflow mode, if you are working with an activity approver, you submit your activity, and the changes are committed when the activity is approved. If you are not working with an activity approver, your changes are committed when you approve your own activity. For more information, see Submitting an Activity for Approval (Workflow Mode with Activity Approver) and Approving or Rejecting an Activity (Workflow Mode).

 
     [bookmark: pgfId-473373]In both Workflow and non-Workflow mode, policies are validated when you submit them. For more information on validation, see Validating an Activity/Ticket.

 
      
      		 [bookmark: pgfId-473378]Deploy your changes. Deployment either updates the devices directly with the new configuration, creates configuration files that you can deploy yourself, or copies the configuration files to an intermediate server (Auto Update Server, Configuration Engine, or Token Management Server) from which the device retrieves the updates. The method you use depends on the requirements of your organization, and you can select different methods for each device. For general information about deployment, see Working with Deployment and the Configuration Archive. For the specific steps based on workflow mode, and information on the deployment methods, see the following topics:

 
     

 
     [bookmark: pgfId-473383] – Deploying Configurations in Non-Workflow Mode

 
     [bookmark: pgfId-473388] – Deploying Configurations in Workflow Mode

 
     [bookmark: pgfId-473393] – Deploying Configurations Using an Auto Update Server or CNS Configuration Engine

 
     [bookmark: pgfId-473398] – Deploying Configurations to a Token Management Server

 
     [bookmark: pgfId-473403] – Deploying Directly to a Device

 
     [bookmark: pgfId-473408] – Deploying to a Device through an Intermediate Server

 
     [bookmark: pgfId-473413] – Deploying to a File

 
     [bookmark: pgfId-473415]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-473439][bookmark: 11762][bookmark: poman_proc_CopyingPoliciesBetweenDevices]Copying Policies Between Devices[bookmark: marker-473429][bookmark: marker-473431][bookmark: marker-473433][bookmark: marker-473435][bookmark: marker-473437]

 
     [bookmark: pgfId-473441]You can streamline device configuration by copying multiple policies, or even a complete set of policies, from one device to other devices that support the selected policies. This makes it easy, for example, to quickly configure a new firewall device with the same policies configured on an existing firewall device.

 
     [bookmark: pgfId-473443]When you copy policies between devices, those policies that are local on the source device are copied locally to the target device. Shared policies assigned to the source device are copied as shared policies to the target device as well.

 
     [bookmark: pgfId-473445]Tips

 
      
      		 [bookmark: pgfId-473450]If your intention is to assign a single shared policy to additional devices, we recommend that you use the assignment feature, rather than copying the policies. For more information about sharing policies in Device view, see Modifying Shared Policy Assignments in Device View or the Site-to-Site VPN Manager.

 
      		 [bookmark: pgfId-473455]To create a new device of the same type that shares the same configuration and properties (including the operating system version, credentials, and grouping attributes) as the source device, use the Clone Device feature. For more information, see Cloning a Device.

 
     

 
     [bookmark: pgfId-473457]Related Topics

 
      
      		 [bookmark: pgfId-473462]Managing Policies in Device View and the Site-to-Site VPN Manager

 
      		 [bookmark: pgfId-473467]Configuring Local Policies in Device View

 
      		 [bookmark: pgfId-473472]Understanding the Device View

 
      		 [bookmark: pgfId-473477]Policy Status Icons

 
      		 [bookmark: pgfId-473482]Filtering Items in Selectors

 
     

 
     
 
     [bookmark: pgfId-473484]Step 1 In Device view, do one of the following:

 
      
      		 [bookmark: pgfId-473486]Select  Policy > Copy Policies Between Devices . The Copy Policies wizard starts at step 1, the Copy Policies from this Device page. Select the device that has the policies you want to copy and click  Next .

 
      		 [bookmark: pgfId-473488]Right-click the device in the Device selector, then select  Copy Policies Between Devices . The Copy Policies wizard selects the device as the source device and starts at step 2, the Select Policies to Copy page. You can change the source device by clicking  Back .

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-473490]Tip You can also right click a device in Map view and select Copy Policies Between Devices.


     
      

     

     

 
     [bookmark: pgfId-473492]Step 2 Select the policies you want to copy on the Select Policies to Copy page. Initially, most policies from the source device (both local and shared) that can be copied are selected. You can change the selection, however, if you select a policy that depends on another policy, you must select the dependant policies. Security Manager will prompt you if your selections are not valid.

 
     [bookmark: pgfId-473494]Consider the following when selecting policies:

 
      
      		 [bookmark: pgfId-473496]Selecting the check box for a policy group selects all of the policies in that group.

 
      		 [bookmark: pgfId-473498]When you copy policies between firewall devices (ASA, PIX, FWSM), copying the failover policy automatically copies the interface policy and vice-versa.

 
      		 [bookmark: pgfId-473500]It is usually not a good idea to copy interface policies, because these policies can have specific IP addresses. Other types of policies that you should carefully consider before copying them include NAT, routing, or the IPS policy on IOS devices.

 
      		 [bookmark: pgfId-473502]If you select the security contexts policy (for FWSM, PIX Firewall, or ASA devices), you must submit your changes after copying the devices for the contexts to appear in the device selector. In non-Workflow mode, select  File > Submit . In Workflow mode, submit your activity.

 
     

 
     [bookmark: pgfId-473504]Step 3 Use the policy object copy options to determine how policy objects are handled. These options are not mutually exclusive, and the combination you select has important implications on how the policies are defined on the target devices.

 
     [bookmark: pgfId-473506]These are the possible combinations and their meanings:

 
      
      		 [bookmark: pgfId-473508]To ensure that the target devices have the same policy object settings as the source device, select both  Copy the Global Values of Policy Objects and  Copy the Overridden Values of Policy Objects .

 
      		 [bookmark: pgfId-473510]To ensure that if a policy object is used on the target device, its value is not overridden, select  neither option. If a selected policy uses a policy object, and an equivalent policy on the target device uses the same policy object, the policy object’s value defined on the target device is preserved. If the target device does not use the policy object, it is copied to the target using the policy object’s global value (any overrides on the source device are ignored).

 
      		 [bookmark: pgfId-473512]To ensure that any policy objects on the target device use the policy object’s global values, select  Copy the Global Values of Policy Objects but deselect  Copy the Overridden Values of Policy Objects . If the source device includes policies that use policy objects, only policies that use global values for the policy objects are copied. If the target device has an equivalent policy that uses local values for the policy object, the local values are replaced by the policy object’s global values.

 
      		 [bookmark: pgfId-473514]To ensure that only policy objects with local values on the source device are copied to the target device, deselect  Copy the Global Values of Policy Objects but select  Copy the Overridden Values of Policy Objects . If the source device includes policies that use policy objects, only policies that override the policy object’s global values are copied. The target devices get the source device’s override value for the policy object.

 
     

 
     [bookmark: pgfId-473517]The following table shows the possible outcomes when copying policy objects depending on which of the two options are selected:

 
      
       
       
         
         		 
           
           [bookmark: pgfId-470617]Source Device
          
  
         		 
           
           [bookmark: pgfId-470619]Target Device
          
  
         		 
           
           [bookmark: pgfId-470621]User Option
          
  
         		 
           
           [bookmark: pgfId-470623]Target device (copy result)
          
  
        

 
         
         		[bookmark: pgfId-470633]Global Definition

  
         		[bookmark: pgfId-470635]No reference

  
         		[bookmark: pgfId-470637]Any

  
         		[bookmark: pgfId-470639]Global Definition

  
        

 
         
         		[bookmark: pgfId-470649]Global Definition

  
         		[bookmark: pgfId-470651]Global Definition

  
         		[bookmark: pgfId-470653]Any

  
         		[bookmark: pgfId-470655]Global Definition

  
        

 
         
         		 [bookmark: pgfId-470665]Global Definition

  
         		 [bookmark: pgfId-470667]Device-level override

  
         		[bookmark: pgfId-470669]Neither option selected

  
         		[bookmark: pgfId-470671]Retains target device’s override

  
        

 
         
         		[bookmark: pgfId-470685]Copy the Global Values of Policy Objects only

  
         		[bookmark: pgfId-470687]Global Definition

  
        

 
         
         		[bookmark: pgfId-470701]Copy the Overridden Values of Policy Objects only

  
         		[bookmark: pgfId-470703]Retains target device’s override

  
        

 
         
         		[bookmark: pgfId-470717]Both options selected

  
         		[bookmark: pgfId-470719]Global Definition

  
        

 
         
         		 [bookmark: pgfId-470729]Device-level override

  
         		 [bookmark: pgfId-470731]No reference

  
         		[bookmark: pgfId-470733]Neither option selected

  
         		[bookmark: pgfId-470735]Global Definition

  
        

 
         
         		[bookmark: pgfId-470749]Copy the Global Values of Policy Objects only

  
         		[bookmark: pgfId-470751]Global Definition

  
        

 
         
         		[bookmark: pgfId-470765]Copy the Overridden Values of Policy Objects only

  
         		[bookmark: pgfId-470767]Uses source device’s override

  
        

 
         
         		[bookmark: pgfId-470781]Both options selected

  
         		[bookmark: pgfId-470783]Uses source device’s override

  
        

 
         
         		 [bookmark: pgfId-470793]Device-level override

  
         		 [bookmark: pgfId-470795]Global Definition

  
         		[bookmark: pgfId-470797]Neither option selected

  
         		[bookmark: pgfId-470799]Global Definition

  
        

 
         
         		[bookmark: pgfId-470813]Copy the Global Values of Policy Objects only

  
         		[bookmark: pgfId-470815]Global Definition

  
        

 
         
         		[bookmark: pgfId-470829]Copy the Overridden Values of Policy Objects only

  
         		[bookmark: pgfId-470831]Uses source device’s override

  
        

 
         
         		[bookmark: pgfId-470845]Both options selected

  
         		[bookmark: pgfId-470847]Uses source device’s override

  
        

 
         
         		 [bookmark: pgfId-470857]Device-level override

  
         		 [bookmark: pgfId-470859]Device-level override

  
         		[bookmark: pgfId-470861]Neither option selected

  
         		[bookmark: pgfId-470863]Retains target device’s override

  
        

 
         
         		[bookmark: pgfId-470877]Copy the Global Values of Policy Objects only

  
         		[bookmark: pgfId-470879]Retains target device’s override

  
        

 
         
         		[bookmark: pgfId-470893]Copy the Overridden Values of Policy Objects only

  
         		[bookmark: pgfId-470895]Uses source device’s override

  
        

 
         
         		[bookmark: pgfId-470909]Both options selected

  
         		[bookmark: pgfId-470911]Uses source device’s override

  
        

 
       
      

 
     
 
     [bookmark: pgfId-473519]Click Next.

 
     [bookmark: pgfId-473521]Step 4 Select the target devices to which you want to copy policies on the Copy Policies to these Devices page. Selecting the check box for a device group selects all of the devices in that group.

 
     [bookmark: pgfId-473523]The device selector displays only those devices that support all of the policies you selected to copy. If you do not see all of the devices to which you want to copy policies, you can return to the policy selection page and deselect the more restrictive policies, and use the wizard a second time to copy the restrictive policies to the subset of devices that support them.

 
     [bookmark: pgfId-473525]The device list is empty if no other device in the inventory can support all selected policies.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-473527]Tip After selecting devices, Click the Preview button to view a summary of the policies that will be copied. The summary shows the selected devices, the policies that will be copied to them, and any overrides that will be created, updated, or deleted due to the copied policies.


     
      

     

     

 
     [bookmark: pgfId-473529]Step 5 Click Finish. You are asked to confirm that you want to copy policies.

 
     [bookmark: pgfId-473531]The policies are copied to the target devices. If the copy operation fails for any target device, the copy is undone for successful devices, and you are shown a list of reasons why the copy failed for each problem device. Typically, copy failures are because someone else has a lock on a policy or device, or you do not have the required permissions to a device.

 
     [bookmark: pgfId-473533]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-473549][bookmark: 12028][bookmark: poman_proc_UnassigningaPolicy]Unassigning a Policy[bookmark: marker-473539][bookmark: marker-473541][bookmark: marker-473543][bookmark: marker-473545][bookmark: marker-473547]

 
     [bookmark: pgfId-473551]If you unassign a policy that has already been deployed to a device, in most cases the values that are defined for the policy are erased, effectively removing the policy from the device’s planned configuration. When you perform deployment, the configuration for this feature that already exists on the device is removed.

 
     [bookmark: pgfId-473553]The exact behavior depends on the type of policy that you unassign:

 
      
      		 [bookmark: pgfId-473555]Firewall service policies—If you unassign a policy, Security Manager erases the policy from the device.

 
      		 [bookmark: pgfId-473557]VPN policies:

 
     

 
     [bookmark: pgfId-473562] – Site-to-site VPN policies—You cannot unassign mandatory site-to-site VPN policies from the devices in the topology. If you unshare a mandatory policy, Security Manager assigns default values to the affected device. If you unassign an optional policy, Security Manager erases the configuration from the device. For more information, see Understanding Mandatory and Optional Policies for Site-to-Site VPNs.

 
     [bookmark: pgfId-473564] – IPSec remote access VPN policies—If you unassign a policy, Security Manager erases the policy from the device, even if it is a mandatory policy. In most cases, deployment fails if you do not create a new definition for the mandatory policy. In those cases where deployment does not fail, the device will fail to establish VPN tunnels.

 
     [bookmark: pgfId-473566] – SSL VPN policies—If you unassign a policy, Security Manager erases the policy from the device.

 
      
      		 [bookmark: pgfId-473568]Catalyst 6500/7600 or Catalyst switch policies—Interface and VLAN policies cannot be shared or unassigned. If you unassign a platform policy (such as IDSM settings or VLAN access lists) Security Manager removes the policy from the device.

 
      		 [bookmark: pgfId-473570]IPS policies—For all IPS device and service policies, a default policy is assigned to the device.

 
      		 [bookmark: pgfId-473572]PIX/ASA/FWSM policies—Policies that you cannot share with other devices cannot be unassigned from the device on which they are created. This includes interface, failover, security context, and resource policies. For other policy types (such as timeout policies), Security Manager makes a best effort to restore the system default configuration on the device.

 
      		 [bookmark: pgfId-473577]IOS router policies—Core connectivity policies, such as basic interface settings and accounts and credentials policies cannot be unassigned from the device on which they are created. If you unassign a device access policy that was used to define the password for configuring the device, you might prevent Security Manager from configuring that device in the future. For more information, see User Accounts and Device Credentials on Cisco IOS Routers.

 
     

 
     [bookmark: pgfId-473579]If you unassign a VTY or console policy, Security Manager restores a default configuration to ensure continued communication with the device. For all other policy types, if you unassign the policy, Security Manager erases the configuration from the device.

 
     [bookmark: pgfId-473581]Related Topics

 
      
      		 [bookmark: pgfId-473586]Configuring Local Policies in Device View

 
      		 [bookmark: pgfId-473591]Copying Policies Between Devices

 
      		 [bookmark: pgfId-473596]Managing Policies in Device View and the Site-to-Site VPN Manager

 
     

 
     
 
     [bookmark: pgfId-473598]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-473600](Device view) Select the device that has a policy you want to unassign.

 
      		 [bookmark: pgfId-473602](Site-to-Site VPN Manager) Select the VPN topology that has a policy you want to unassign.

 
     

 
     [bookmark: pgfId-473604]Step 2 Right-click the local policy and select Unassign Policy.

 
     [bookmark: pgfId-473606]You are asked to confirm that you want to unassign the current policy.

 
     [bookmark: pgfId-473608]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-473626][bookmark: 12098][bookmark: poman_cncpt_WorkingwithSharedPoliciesinDeviceView]Working with Shared Policies in Device View or the Site-to-Site VPN Manager[bookmark: marker-473616][bookmark: marker-473618][bookmark: marker-473620][bookmark: marker-473622][bookmark: marker-473624]

 
     [bookmark: pgfId-473628]Sharing policies makes it possible to configure multiple devices with common policies, which provides greater consistency in your policy definitions and streamlines your management efforts. Any changes to a shared policy affect all the devices and VPN topologies to which the policy is assigned. This makes it easy, for example, to update all of your Cisco IOS routers with new quality of service policies by updating the shared Quality of Service policy assigned to these devices.

 
     [bookmark: pgfId-473636]When working in Device view or the Site-to-Site VPN Manager, you can take a local policy (such as a policy created during device discovery) and share it. You can then assign the shared policy to as many devices or VPN topologies as you want (provided they are not locked by another user; see Understanding Policy Locking), and you can change these assignments at any time. You can also take these shared policies that were created from the local policy and add them to a policy bundle. For more information on policy bundles, see Managing Policy Bundles.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-473641]Tip If you have a device that you are using as a template for the creation of other devices, you can quickly create a policy bundle that can be used for device configuration based on the template device. To do so, first make all policies on the device shared policies (see Sharing Multiple Policies of a Selected Device), then create a policy bundle from those shared policies.


     
      

     

     

 
     [bookmark: pgfId-473643]In addition, you can take a shared policy that is assigned to a device or VPN topology and turn it into a local policy for that particular device or topology. This enables you to create a special configuration that affects only that device or topology. Other devices or topologies assigned the shared policy continue to use the shared policy as before.

 
     [bookmark: pgfId-473648]As an alternative to sharing local policies, you can create new shared policies and manage them at the network level using Policy view. For more information, see Managing Shared Policies in Policy View. After creating the shared policy and assigning it to devices or VPN topologies in Policy view, you can return to Device view or the Site-to-Site VPN Manager and perform additional operations on the policy as described in the sections that follow. Note that all shared policies that you create in Device view or the Site-to-Site VPN Manager automatically appear as shared policies in Policy view.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-473653]Tip In Device view or the Site-to-Site VPN Manager, if you edit a shared policy, your changes are applied to all devices or VPN topologies that share the policy. Thus, you do not need to go to Policy view to edit shared policies. You are warned when you try to edit a shared policy that this will happen, to ensure you do not inadvertently make a change to more devices or topologies than what you intend. If you need to change the policy for just one device or topology, you can unshare the policy before editing it, as described in Unsharing a Policy.


     
      

     

     

 
     [bookmark: pgfId-473655]The following topics describe how to share policies and the operations that can be performed on them in Device view or the Site-to-Site VPN Manager:

 
      
      		 [bookmark: pgfId-473660]Using the Policy Banner

 
      		 [bookmark: pgfId-473665]Policy Shortcut Menu Commands in Device View and the Site-to-Site VPN Manager

 
      		 [bookmark: pgfId-473670]Sharing a Local Policy

 
      		 [bookmark: pgfId-473675]Sharing Multiple Policies of a Selected Device

 
      		 [bookmark: pgfId-473680]Unsharing a Policy

 
      		 [bookmark: pgfId-473685]Assigning a Shared Policy to a Device or VPN Topology

 
      		 [bookmark: pgfId-473690]Adding Local Rules to a Shared Policy

 
      		 [bookmark: pgfId-473695]Inheriting or Uninheriting Rules

 
      		 [bookmark: pgfId-473700]Cloning (Copying) a Shared Policy

 
      		 [bookmark: pgfId-473705]Renaming a Shared Policy

 
      		 [bookmark: pgfId-473710]Modifying Shared Policy Definitions in Device View or the Site-to-Site VPN Manager

 
      		 [bookmark: pgfId-473715]Modifying Shared Policy Assignments in Device View or the Site-to-Site VPN Manager

 
     

 
     [bookmark: pgfId-473717]Related Topics

 
      
      		 [bookmark: pgfId-473722]Importing Policies or Devices

 
      		 [bookmark: pgfId-473727]Understanding Policies

 
      		 [bookmark: pgfId-473732]Managing Policies in Device View and the Site-to-Site VPN Manager

 
     

 
    
 
     
      [bookmark: pgfId-473746][bookmark: 12180][bookmark: poman_cncpt_UsingthePolicyBanner]Using the Policy Banner[bookmark: marker-473738][bookmark: marker-473740][bookmark: marker-473742][bookmark: marker-473744]

 
     [bookmark: pgfId-473748]When you view a device policy in Device view, or a site-to-site VPN policy in the Site-to-Site VPN Manager, there is a banner above the content of the policy in the work area. The banner provides information about whether the policy is local to the device or a shared policy. For shared policies, the banner also indicates the number of devices that use the policy. For policies that allow inheritance, the banner includes information about inheritance.

 
     [bookmark: pgfId-473750]Messages might appear below the banner to indicate the following:

 
      
      		 [bookmark: pgfId-473752]That the policy is locked by another user. You cannot save changes to the policy until the other user submits (and approves) the changes, cancels an edit, or discards the changes.

 
      		 [bookmark: pgfId-473757]That the shared policy was imported. Imported policies might be re-imported at some point if the policy is managed on a different server. Any changes that you make are eliminated if the policy is imported again. Before editing the policy, ensure that you understand the protocols used in your organization for policy management and importation. You can control whether this message appears using an option on the Tools > Security Manager Administration > Policy Management page (see Policy Management Page).

 
     

 
     [bookmark: pgfId-473759]You can use the links in the banner to create shared policies, assign a shared policy, and configure policy inheritance. The following illustration shows an example of a device policy banner.

 
     [bookmark: pgfId-473763]Figure 5-3 [bookmark: 12204]Policy Banner Example

 
     [bookmark: pgfId-473766] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-473768]The fields in the policy banner have the following meanings and uses:

 
      
      		 [bookmark: pgfId-473770]Policy Assigned—The name of the policy assigned to this device or VPN. If the name has a link, you can assign a shared policy to the element by clicking the link. If there is no link, a shared policy cannot be assigned to this particular type of policy.

 
     

 
     [bookmark: pgfId-473772] – Local—The policy is a local policy (configured on this device only) rather than a shared policy.

 
     [bookmark: pgfId-473774] – Specific policy name—The shared policy is assigned to the device policy.

 
      
      		 [bookmark: pgfId-473776]Assigned To—If a shared policy is assigned, the number of devices or VPNs to which the policy is assigned. If no shared policy is assigned,  local device or  this VPN is indicated. If the name has a link, you can do the following:

 
     

 
     [bookmark: pgfId-473778] – Local Device or This VPN links—Click the link to create a shared policy from this local policy. You can then assign the shared policy to other devices or VPNs.

 
     [bookmark: pgfId-473780] – Number of Devices or VPNs links—Click the link to change the devices or VPNs assigned to the shared policy.

 
      
      		 [bookmark: pgfId-473785]Inherits From—The name of the policy from which this policy inherits rules. This field appears only for policies that allow inheritance. Click the link to specify a policy or set of policies from which the policy will inherit rules. For more information about inheritance, see Understanding Rule Inheritance.

 
     

 
     [bookmark: pgfId-473787]The field can contain these entries:

 
     [bookmark: pgfId-473789] – None—The policy does not inherit rules from any other policy.

 
     [bookmark: pgfId-473791] – Single policy name—The policy inherits rules from this policy.

 
     [bookmark: pgfId-473793] – Multiple policy names separated by > signs—The policy inherits rules from the indicated hierarchy of policies.

 
      
      		 [bookmark: pgfId-473795]Policy Bundle Assigned—The name of the policy bundle assigned to this device or VPN.

 
     

 
     [bookmark: pgfId-473797]Related Topics

 
      
      		 [bookmark: pgfId-473802]Understanding Policies

 
      		 [bookmark: pgfId-473807]Managing Policies in Device View and the Site-to-Site VPN Manager

 
      		 [bookmark: pgfId-473812]Sharing a Local Policy

 
      		 [bookmark: pgfId-473817]Assigning a Shared Policy to a Device or VPN Topology

 
      		 [bookmark: pgfId-473822]Adding Local Rules to a Shared Policy

 
      		 [bookmark: pgfId-473827]Modifying Shared Policy Definitions in Device View or the Site-to-Site VPN Manager

 
      		 [bookmark: pgfId-473832]Modifying Shared Policy Assignments in Device View or the Site-to-Site VPN Manager

 
      		 [bookmark: pgfId-473837]Inheritance vs. Assignment

 
      		 [bookmark: pgfId-473842]Understanding Policy Locking

 
      		 [bookmark: pgfId-473847]Importing Policies or Devices

 
     

 
    
 
     
      [bookmark: pgfId-473859][bookmark: 12272][bookmark: poman_cncpt_DeviceS2SPolicyShortcutMenu]Policy Shortcut Menu Commands in Device View and the Site-to-Site VPN Manager[bookmark: marker-473853][bookmark: marker-473855][bookmark: marker-473857]

 
     [bookmark: pgfId-473861]When you right-click a policy in Device view or the Site-to-Site VPN manager, you get a list of commands that you can use on the policy. The shortcut command list includes only those commands available for the selected policy, so the list differs according to your selection.

 
     [bookmark: pgfId-473863]The available commands depend on whether the policy:

 
      
      		 [bookmark: pgfId-473865]Is unassigned.

 
      		 [bookmark: pgfId-473867]Contains a local policy for that specific device or VPN topology.

 
      		 [bookmark: pgfId-473869]Contains a shared policy that might be assigned to multiple devices or VPN topologies.

 
      		 [bookmark: pgfId-473871]Can be shared. There are no shortcut commands for policies that cannot be shared between devices or topologies.

 
     

 
     [bookmark: pgfId-473876]The current status of each policy type is indicated by the icon displayed next to the policy name. See Policy Status Icons.

 
     [bookmark: pgfId-473878]The following table provides a comprehensive list of the possible commands.

 
     [bookmark: pgfId-473881] 

 
      
       
        
        [bookmark: pgfId-470924]Table 5-6 [bookmark: 12298]Policy Shortcut Commands 

 
        
       
         
         		
           
           [bookmark: pgfId-470930]Menu Command
          
  
         		
           
           [bookmark: pgfId-470932]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-470938]Commands available for both local and shared policies
          
  
        

 
         
         		[bookmark: pgfId-470946]Assign Shared Policy

  
         		[bookmark: pgfId-470951]Assigns an existing shared policy to the selected device or VPN topology. If the policy is already assigned a shared policy, your selection assigns a new shared policy, replacing the existing selection. See Assigning a Shared Policy to a Device or VPN Topology.

  
        

 
         
         		[bookmark: pgfId-470957]Inherit Rules

  
         		[bookmark: pgfId-470962]Enables you to identify a shared policy from which to inherit rules, or to remove any inheritance from the child policy. Child policies inherit both the mandatory rules and default rules that are defined in the parent policy. See Inheriting or Uninheriting Rules.

  
        

 
         
         		 
           
           [bookmark: pgfId-470968]Additional local policy commands
          
  
        

 
         
         		[bookmark: pgfId-470976]Share Policy

  
         		[bookmark: pgfId-470981]Shares the local policy so that it can be assigned to other devices or VPN topologies. See Sharing a Local Policy.

  
        

 
         
         		[bookmark: pgfId-470987]Unassign Policy

  
         		[bookmark: pgfId-470992]Unassigns the policy from the device or VPN topology. When deployed, the configuration that corresponds to the settings defined in this policy is removed from the device or the devices in the topology. See Unassigning a Policy.

  
        

 
         
         		 
           
           [bookmark: pgfId-470998]Additional shared policy commands
          
  
        

 
         
         		[bookmark: pgfId-471006]Unshare Policy

  
         		[bookmark: pgfId-471011]Creates a local copy of the shared policy and assigns it to the device or VPN topology in place of the shared policy. See Unsharing a Policy.

  
        

 
         
         		[bookmark: pgfId-471017]Edit Policy Assignments

  
         		[bookmark: pgfId-471022]Enables you to change which devices or VPN topologies are assigned to this policy, not just the device or VPN topology you are currently viewing. See Modifying Shared Policy Assignments in Device View or the Site-to-Site VPN Manager.

  
        

 
         
         		[bookmark: pgfId-471028]Clone Policy

  
         		[bookmark: pgfId-471033]Creates a copy of a policy with a new name. Use this option to create a new policy with the same definition as the policy from which it was created, which you can then edit. See Cloning (Copying) a Shared Policy.

  
        

 
         
         		[bookmark: pgfId-471039]Rename Policy

  
         		[bookmark: pgfId-471044]Renames the selected policy. See Renaming a Shared Policy.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-473903][bookmark: 12371][bookmark: poman_proc_SharingaLocalPolicy]Sharing a Local Policy[bookmark: marker-473891][bookmark: marker-473893][bookmark: marker-473895][bookmark: marker-473897][bookmark: marker-473899][bookmark: marker-473901]

 
     [bookmark: pgfId-473911]As your network grows, you might decide to convert a local policy into a shared policy that you can assign to multiple devices or VPN topologies (see Local Policies vs. Shared Policies). Sharing a policy provides a streamlined management approach that ensures that all devices or topologies assigned to the policy are configured in a consistent manner. For example, if you configure a set of firewall inspection rules on a particular device, sharing that device’s inspection rules policy makes it possible to assign that policy to other devices, eliminating the need to configure each device individually. See Assigning a Shared Policy to a Device or VPN Topology.

 
     [bookmark: pgfId-473913]In addition, having a shared policy enables you to update the configurations of each assigned device or topology at one time, saving time and promoting greater consistency across your set of managed devices.

 
     [bookmark: pgfId-473915]When you share a policy, you must name the policy. (Local policies do not have names, because they are associated with only a single device or topology.) This enables you to identify this policy when managing shared policies in Policy view.

 
     [bookmark: pgfId-473917]Related Topics

 
      
      		 [bookmark: pgfId-473922]Understanding the Device View

 
      		 [bookmark: pgfId-473927]Policy Status Icons

 
      		 [bookmark: pgfId-473932]Using the Policy Banner

 
      		 [bookmark: pgfId-473937]Assigning a Shared Policy to a Device or VPN Topology

 
      		 [bookmark: pgfId-473942]Unsharing a Policy

 
      		 [bookmark: pgfId-473947]Adding Local Rules to a Shared Policy

 
      		 [bookmark: pgfId-473952]Sharing Multiple Policies of a Selected Device

 
      		 [bookmark: pgfId-473957]Inheriting or Uninheriting Rules

 
      		 [bookmark: pgfId-473962]Working with Shared Policies in Device View or the Site-to-Site VPN Manager

 
     

 
     
 
     [bookmark: pgfId-473964]Step 1 In Device view or the Site-to-Site VPN Manager, select a policy from the Policies selector, then do one of the following:

 
      
      		 [bookmark: pgfId-473966](Device view only) Select  Policy > Share Policy .

 
      		 [bookmark: pgfId-473968]Right-click the policy and select  Share Policy .

 
      		 [bookmark: pgfId-473970]Click the  local device/this VPN link in the Assigned To field in the policy banner. A warning dialog box called Local Policies Cannot Be Assigned to Multiple Devices opens to inform you that you are viewing a local policy. Click  Share Policy to continue.

 
     

 
     [bookmark: pgfId-473972]The Share Policy dialog box is displayed.

 
     [bookmark: pgfId-473974]Step 2 Enter a name for the shared policy and click OK.

 
     [bookmark: pgfId-473976]Policy names can contain up to 255 characters, including spaces and special characters.

 
     [bookmark: pgfId-473978]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-474002][bookmark: 12452][bookmark: poman_proc_SharingMultiplePoliciesofaSelectedDevice]Sharing Multiple Policies of a Selected Device[bookmark: marker-473990][bookmark: marker-473992][bookmark: marker-473994][bookmark: marker-473996][bookmark: marker-473998][bookmark: marker-474000]

 
     [bookmark: pgfId-474004]With one procedure, you can share multiple policies configured on a particular device. When you perform this procedure, you can choose to share all the policies configured on the device or only some of them. For example, you can take all the firewall service policies defined on an ASA device and share them.

 
     [bookmark: pgfId-474009]Initially, the resulting shared policies are assigned only to the device from which the procedure was performed. However, you can then assign these shared policies to additional devices as required. See Modifying Shared Policy Assignments in Device View or the Site-to-Site VPN Manager.

 
     [bookmark: pgfId-474011]This feature provides a convenient way to take the policies configured on a single device and use them as a template for configuring similar devices. For example, after you discover the devices at your branch offices, you can take all the local access rules that you have configured on a similar device and share them with a single procedure so that you can assign them to the branch office devices.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-474013]Tip You can use this procedure to make all policies on the device shared policies and then create a policy bundle from those shared policies. This policy bundle can then be used to quickly configure new devices based on the template device.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-474018]Tip To create a new device of the same type that shares the same configuration and properties (including device operating system version, credentials, and grouping attributes) as the source device, create a clone of the device. For more information, see Cloning a Device.


     
      

     

     

 
     [bookmark: pgfId-474020]Related Topics

 
      
      		 [bookmark: pgfId-474025]Understanding the Device View

 
      		 [bookmark: pgfId-474030]Copying Policies Between Devices

 
      		 [bookmark: pgfId-474035]Sharing a Local Policy

 
      		 [bookmark: pgfId-474040]Unsharing a Policy

 
      		 [bookmark: pgfId-474045]Working with Shared Policies in Device View or the Site-to-Site VPN Manager

 
      		 [bookmark: pgfId-474050]Filtering Items in Selectors

 
     

 
     
 
     [bookmark: pgfId-474052]Step 1 In Device view, do one of the following:

 
      
      		 [bookmark: pgfId-474054]Select  Policy > Share Device Policies . The Share Policies wizard opens at the Share Policies from this Device page (step 1). Select the device whose policies you want to share and click  Next .

 
      		 [bookmark: pgfId-474056]Right-click the device and select  Share Device Policies . The Share Policies wizard opens at the Select Policies to Share page (step 2); you can click  Back to go to step 1 and select a different device, if desired.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-474058]Tip You can also right click a device in Map view and select Share Device Policies.


     
      

     

     

 
     [bookmark: pgfId-474060]Step 2 On the Select Policies to Share page, select all policies that you want to share. Initially, all shareable policies configured on the device, whether local or shared, are selected. Deselect the check box next to each policy that you do not want to share.

 
     [bookmark: pgfId-474062]Following are some tips:

 
      
      		 [bookmark: pgfId-474064]Local policies that are not checked remain local to the selected device.

 
      		 [bookmark: pgfId-474066]If you select a policy that is already shared, Security Manager creates a copy of that policy using the name that you define in the wizard.

 
      		 [bookmark: pgfId-474068]Selecting the check box for a policy group selects all of the policies in that group.

 
      		 [bookmark: pgfId-474070]If a policy is configured on the device, but you cannot select it (the check box is solid grey), it is an unshareable policy.

 
     

 
     [bookmark: pgfId-474077]Step 3 [bookmark: 12530]Enter a name for the shared policies. All policies are given the same name. You can later rename the individual policies. For more information, see Renaming a Shared Policy.

 
     [bookmark: pgfId-474079]If you select a policy that is already shared, Security Manager creates a copy of that policy using this name.

 
     [bookmark: pgfId-474084]Step 4 Click Finish. The selected policies become shared policies, which you can then assign to additional devices as needed. For more information, see Modifying Shared Policy Assignments in Device View or the Site-to-Site VPN Manager.

 
     [bookmark: pgfId-474086]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-474106][bookmark: 12541][bookmark: poman_proc_UnsharingaPolicy]Unsharing a Policy[bookmark: marker-474092][bookmark: marker-474094][bookmark: marker-474096][bookmark: marker-474098][bookmark: marker-474100][bookmark: marker-474102][bookmark: marker-474104]

 
     [bookmark: pgfId-474108]When you unshare a shared policy assigned to a particular device or VPN topology, you create a copy that becomes a local policy for that device or topology. This means that any subsequent changes made to the local policy affect only this particular device or topology. Other devices or topologies assigned the original shared policy continue to use the shared policy as before.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-474110]Note You cannot unshare a policy that is assigned to a device as part of a policy bundle. You must either unassign the policy bundle from the device or remove the shared policy from the policy bundle that is assigned to the device.


     
      

     

     

 
     [bookmark: pgfId-474112]For example, Security Manager might be managing a BGP routing policy called MyBGP, which is assigned to 20 routers. If you decide that one of the routers (Router1) requires a variation of this policy, you can select the device, unshare the policy, and make the changes you need for that router. From that point on, Router1 has a local BGP policy while the other 19 routers continue to use the original shared policy, MyBGP.

 
     [bookmark: pgfId-474114]Related Topics

 
      
      		 [bookmark: pgfId-474119]Understanding the Device View

 
      		 [bookmark: pgfId-474124]Sharing a Local Policy

 
      		 [bookmark: pgfId-474129]Managing Policies in Device View and the Site-to-Site VPN Manager

 
      		 [bookmark: pgfId-474134]Working with Shared Policies in Device View or the Site-to-Site VPN Manager

 
      		 [bookmark: pgfId-474139]Policy Status Icons

 
     

 
     
 
     [bookmark: pgfId-474141]Step 1 In Device view or the Site-to-Site VPN Manager, select a policy from the Policies selector, then do one of the following:

 
      
      		 [bookmark: pgfId-474143](Device view only) Select  Policy > Unshare Policy .

 
      		 [bookmark: pgfId-474145]Right-click the selected shared policy, then select  Unshare Policy .

 
     

 
     [bookmark: pgfId-474147]Step 2 Click OK. The shared policy is converted into a local policy for the selected device or VPN topology. The shared policy icon in the Policies selector is replaced by the local policy icon.

 
     [bookmark: pgfId-474149]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-474179][bookmark: 12603][bookmark: poman_proc_AssigningaSharedPolicytoaSelectedDevice]Assigning a Shared Policy to a Device or VPN Topology[bookmark: marker-474159][bookmark: marker-474161][bookmark: marker-474163][bookmark: marker-474165][bookmark: marker-474167][bookmark: marker-474169][bookmark: marker-474171][bookmark: marker-474173][bookmark: marker-474175][bookmark: marker-474177]

 
     [bookmark: pgfId-474181]You can replace any shareable policy (local or shared) assigned in Device view or the Site-to-Site VPN Manager with an existing shared policy of the same type. For example, if you have a local NAT policy assigned to a Cisco IOS router, you can assign a shared NAT policy in its place. Similarly, if a shared NAT policy was assigned to the router, you can replace it with a different shared NAT policy.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-474186]Tip You can use bundle shared policies together to make assigning those policies easier. For more information, see Managing Policy Bundles.


     
      

     

     

 
     [bookmark: pgfId-474191]If you are assigning a shared policy to replace a local, rule-based policy (for example, an inspection rules policy), any local rules that you configured are replaced by the rules defined in the shared policy. A warning message gives you the opportunity to preserve the local rules by inheriting the rules of the shared policy instead of assigning the shared policy in place of the local policy. For more information, see Inheritance vs. Assignment.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-474196]Tip If you want to use the rules defined in the shared policy and still keep your local rules, we recommend that you select the Inherit Rules option instead of assigning the policy. For more information, see Inheriting or Uninheriting Rules.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-474201]Note You can also inherit IPS signature policies and signature event actions, but inheritance works differently than for rules-based policies. For more information, see Understanding Signature Inheritance.


     
      

     

     

 
     [bookmark: pgfId-474203]Related Topics

 
      
      		 [bookmark: pgfId-474208]Understanding the Device View

 
      		 [bookmark: pgfId-474213]Using the Policy Banner

 
      		 [bookmark: pgfId-474218]Unassigning a Policy

 
      		 [bookmark: pgfId-474223]Adding Local Rules to a Shared Policy

 
      		 [bookmark: pgfId-474228]Copying Policies Between Devices

 
      		 [bookmark: pgfId-474233]Working with Shared Policies in Device View or the Site-to-Site VPN Manager

 
     

 
     
 
     [bookmark: pgfId-474235]Step 1 In Device view or the Site-to-Site VPN Manager, select a policy from the Policies selector, then do one of the following:

 
      
      		 [bookmark: pgfId-474237](Device view only) Select  Policy > Assign Shared Policy .

 
      		 [bookmark: pgfId-474239]Right-click the policy in the Policies selector, then select  Assign Shared Policy .

 
      		 [bookmark: pgfId-474241]Click the link in the Policy Assigned field in the policy banner.

 
     

 
     [bookmark: pgfId-474243]The Assign Shared Policy dialog box is displayed if there are any shared policies available for assignment.

 
     [bookmark: pgfId-474245]Step 2 Select a shared policy from the displayed list to assign to the device or VPN topology and click OK. If the policy does not allow inheritance, the shared policy is assigned to the selected device and you are finished.

 
     [bookmark: pgfId-474247]Step 3 If the policy allows inheritance, you are warned that the shared policy will replace the current policy and given the option to inherit the rules instead with the Local Policy Will Be Replaced dialog box.

 
     [bookmark: pgfId-474249]Your options are:

 
      
      		 [bookmark: pgfId-474251]Assign Policy—Assign the shared policy to replace the existing local policy. If you choose to assign, all local rules are removed and they cannot be retrieved.

 
      		 [bookmark: pgfId-474253]Inherit From Policy—Inherit the rules of the shared policy. If you choose to inherit, the inherited rules are added to the local rules that are already defined in the device’s local policy. Use inheritance instead of assignment when the device needs to maintain the set of local rules already defined for it.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-474258]Tip You can select Do not show this again to save your selection and have it applied to all future times that you assign rule-based policies. Otherwise, you are prompted each time you assign policies so that you can make different selections based on the circumstances. If you select this option, you can turn it off by resetting it on the Customize Desktop administration settings page (see Customize Desktop Page).


     
      

     

     

 
     [bookmark: pgfId-474260]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-474274][bookmark: 12698][bookmark: poman_proc_AddingLocalRulestoaSharedPolicy]Adding Local Rules to a Shared Policy [bookmark: marker-474266][bookmark: marker-474268][bookmark: marker-474270][bookmark: marker-474272]

 
     [bookmark: pgfId-474279]After you assign a shared rule-based policy, such as access rules, to a device, you can define additional rules in the policy that are local to that device. Selecting this option creates an inheritance relationship, where the policy defined on the device inherits rules from the shared policy while adding rules that affect only this particular device. For more information about inheritance, see Understanding Rule Inheritance.

 
     [bookmark: pgfId-474281]Local rules that you add to a device do not affect the shared policy from which the device inherits its remaining rules. For example, if the shared policy Access_Rules_South is assigned to five devices and you define local rules on one of those devices, the access rules policy on that device consists of the rules defined in Access_Rules_South plus the local rules; the other four devices continue to use only the rules defined Access_Rules_South.

 
     [bookmark: pgfId-474283]Before You Begin

 
     [bookmark: pgfId-474288]Assign a shared, rule-based policy to the device as described in Assigning a Shared Policy to a Device or VPN Topology.

 
     [bookmark: pgfId-474290]Related Topics

 
      
      		 [bookmark: pgfId-474295]Understanding the Device View

 
      		 [bookmark: pgfId-474300]Cloning (Copying) a Shared Policy

 
      		 [bookmark: pgfId-474305]Assigning a Shared Policy to a Device or VPN Topology

 
      		 [bookmark: pgfId-474310]Unsharing a Policy

 
      		 [bookmark: pgfId-474315]Working with Shared Policies in Device View or the Site-to-Site VPN Manager

 
     

 
     
 
     [bookmark: pgfId-474317]Step 1 In Device view, select a device from the Device selector, then select a shared policy assigned to that device from the Device Policies selector. You must select a rule-based policy, such as access rules. The details of the policy appear in the work area.

 
     [bookmark: pgfId-474319]Step 2 Do one of the following:

 
      
      		 [bookmark: pgfId-474321]Select  Policy > Add Local Rules .

 
      		 [bookmark: pgfId-474323]Right-click the policy, then select  Add Local Rules .

 
     

 
     [bookmark: pgfId-474325]A message is displayed indicating that the policy on this device is now defined as a child policy that inherits rules from the shared policy. If the shared policy in turn inherits rules from a different shared policy, those rules are automatically inherited as well.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-474330]Note To change the parent policy from which this policy inherits rules, see Inheriting or Uninheriting Rules.


     
      

     

     

 
     [bookmark: pgfId-474332]Step 3 Click OK to confirm. In the work area, headings are added for local mandatory and default rules in addition to the mandatory and default rules inherited from the shared policy.

 
     [bookmark: pgfId-474337]In the Device Policies selector, the status icon changes to the icon for a local policy. For more information, see Policy Status Icons.

 
     [bookmark: pgfId-474339]Step 4 Define local rules as required.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-474341]Tip If you assign a shared policy after adding local rules, both the inherited rules and your local rules are replaced with the selected shared policy.


     
      

     

     

 
     [bookmark: pgfId-474343]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-474363][bookmark: 12764][bookmark: poman_proc_InheritingRules]Inheriting or Uninheriting Rules[bookmark: marker-474351][bookmark: marker-474353][bookmark: marker-474355][bookmark: marker-474357][bookmark: marker-474359][bookmark: marker-474361]

 
     [bookmark: pgfId-474365]This procedure describes how certain types of rule-based policies, such as access rules, can inherit rules from shared policies of the same type. Child policies inherit both the mandatory rules and default rules that are defined in the parent policy.

 
     [bookmark: pgfId-474370]When working in Device view, you can then define additional rules that are local to the selected device. For more information, see Adding Local Rules to a Shared Policy.

 
     [bookmark: pgfId-474372]You can edit rule inheritance from either Device view or Policy view.

 
     [bookmark: pgfId-474374]Related Topics

 
      
      		 [bookmark: pgfId-474379]Understanding the Device View

 
      		 [bookmark: pgfId-474384]Managing Shared Policies in Policy View

 
      		 [bookmark: pgfId-474389]Assigning a Shared Policy to a Device or VPN Topology

 
      		 [bookmark: pgfId-474394]Understanding Rule Inheritance

 
      		 [bookmark: pgfId-474399]Inheritance vs. Assignment

 
      		 [bookmark: pgfId-474404]Understanding Policies

 
      		 [bookmark: pgfId-474409]Using the Policy Banner

 
     

 
     
 
     [bookmark: pgfId-474411]Step 1 Select a local or shared rule-based policy in either Device view or Policy view, then do one of the following:

 
      
      		 [bookmark: pgfId-474413]Select  Policy > Inherit Rules .

 
      		 [bookmark: pgfId-474415]Right-click the policy, then select  Inherit Rules .

 
      		 [bookmark: pgfId-474417](Device view only) Click the link in the Inherits From field in the policy banner.

 
     

 
     [bookmark: pgfId-474419]The Inherit Rules dialog box is displayed, containing a list of all shared policies of the selected type, including any inheritance relationships among them.

 
     [bookmark: pgfId-474421]Step 2 Select the policy from which to inherit rules, or select No Inheritance to remove any inheritance from the child policy. The name of the parent policy is displayed below the selector.

 
     [bookmark: pgfId-474423]For example, if you select an access rules policy called West Coast, your access policy inherits the rules of the West Coast policy. If the West Coast policy is a child policy of another access rules policy called US, your policy inherits the properties of the West Coast policy, which in turn inherits the properties of the US policy.

 
     [bookmark: pgfId-474425]Step 3 Click OK to save your definitions. The work area displays the inherited rules under the name of the parent policy and any local rules, if defined, under the name of the original shared policy.

 
     [bookmark: pgfId-474427]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-474449][bookmark: 12836][bookmark: poman_proc_CopyingaSharedPolicy]Cloning (Copying) a Shared Policy[bookmark: marker-474435][bookmark: marker-474437][bookmark: marker-474439][bookmark: marker-474441][bookmark: marker-474443][bookmark: marker-474445][bookmark: marker-474447]

 
     [bookmark: pgfId-474451]You can clone an existing shared policy. This provides a useful shortcut for creating a new policy that is similar to an existing one; after creating the clone, you can modify it as required.

 
     [bookmark: pgfId-474456]If you clone a rule-based policy with inheritance, the new policy contains the same inheritance properties as the policy from which it was created. For more information, see Understanding Rule Inheritance.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-474458]Tip If you clone a policy in Device view or the Site-to-Site VPN Manager, the new policy is assigned to the selected device or VPN topology. If you want to clone a policy without changing policy assignments, make the clone in Policy view.


     
      

     

     

 
     [bookmark: pgfId-474460]Related Topics

 
      
      		 [bookmark: pgfId-474465]Understanding the Device View

 
      		 [bookmark: pgfId-474470]Managing Shared Policies in Policy View

 
      		 [bookmark: pgfId-474475]Renaming a Shared Policy

 
      		 [bookmark: pgfId-474480]Deleting a Shared Policy

 
     

 
     
 
     [bookmark: pgfId-474482]Step 1 Select a shared policy in Device view, Policy view, or the Site-to-Site VPN Manager, then do one of the following:

 
      
      		 [bookmark: pgfId-474484](Device or Policy view only) Select  Policy > Clone Policy .

 
      		 [bookmark: pgfId-474486]Right-click the shared policy, then select  Clone Policy .

 
     

 
     [bookmark: pgfId-474488]The Clone Policy dialog box is displayed.

 
     [bookmark: pgfId-474490]Step 2 Enter a name for the new policy and click OK.

 
     [bookmark: pgfId-474492]Names can contain up to 255 characters, including spaces and special characters.

 
     [bookmark: pgfId-474494]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-474516][bookmark: 12897][bookmark: poman_proc_RenamingaSharedPolicy]Renaming a Shared Policy[bookmark: marker-474502][bookmark: marker-474504][bookmark: marker-474506][bookmark: marker-474508][bookmark: marker-474510][bookmark: marker-474512][bookmark: marker-474514]

 
     [bookmark: pgfId-474518]You can rename a shared policy. The new name is immediately reflected in all devices and VPN topologies to which the policy is assigned.

 
     [bookmark: pgfId-474520]Related Topics

 
      
      		 [bookmark: pgfId-474525]Understanding the Device View

 
      		 [bookmark: pgfId-474530]Managing Shared Policies in Policy View

 
      		 [bookmark: pgfId-474535]Cloning (Copying) a Shared Policy

 
      		 [bookmark: pgfId-474540]Deleting a Shared Policy

 
     

 
     
 
     [bookmark: pgfId-474542]Step 1 Select a shared policy in Device view, Policy view, or the Site-to-Site VPN Manager, then do one of the following:

 
      
      		 [bookmark: pgfId-474544](Device or Policy view) Select  Policy > Rename Policy .

 
      		 [bookmark: pgfId-474546]Right-click the policy, then select  Rename Policy .

 
     

 
     [bookmark: pgfId-474548]The Rename Policy dialog box is displayed.

 
     [bookmark: pgfId-474550]Step 2 Enter a new name for the selected policy and click OK.

 
     [bookmark: pgfId-474552]Names can contain up to 255 characters, including spaces and special characters.

 
     [bookmark: pgfId-474554]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-474568][bookmark: 12955][bookmark: poman_proc_ModifyingSharedPolicyDefinitionsinDeviceView]Modifying Shared Policy Definitions in Device View or the Site-to-Site VPN Manager[bookmark: marker-474560][bookmark: marker-474562][bookmark: marker-474564][bookmark: marker-474566]

 
     [bookmark: pgfId-474570]You can modify any shared policy in Device view or the Site-to-Site VPN Manager by selecting one of the devices or VPN topologies to which the policy is assigned, making the necessary changes, and then saving these changes to the Security Manager server. Any changes made to a shared policy in Device view or the Site-to-Site VPN Manager automatically affect all devices to which the shared policy is assigned.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-474575]Tip To apply your changes only to the device or VPN topology that you are modifying, you must first unshare the policy (see Unsharing a Policy). This action converts the policy to a local policy and prevents your changes from affecting other devices or topologies.


     
      

     

     

 
     [bookmark: pgfId-474577]Related Topics

 
      
      		 [bookmark: pgfId-474582]Understanding the Device View

 
      		 [bookmark: pgfId-474587]Using the Policy Banner

 
      		 [bookmark: pgfId-474592]Modifying Shared Policy Assignments in Device View or the Site-to-Site VPN Manager

 
      		 [bookmark: pgfId-474597]Configuring Local Policies in Device View

 
      		 [bookmark: pgfId-474602]Managing Policies in Device View and the Site-to-Site VPN Manager

 
     

 
     
 
     [bookmark: pgfId-474604]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-474606](Device view) Select the device that has a shared policy you want to modify.

 
      		 [bookmark: pgfId-474608](Site-to-Site VPN Manager) Select the VPN topology that has a shared policy you want to modify.

 
     

 
     [bookmark: pgfId-474610]Step 2 Redefine the policy as required.

 
     [bookmark: pgfId-474612]Step 3 Click Save. You are asked to confirm that you want to save your changes, reminding you that the changes you made will be applied to all devices or topologies to which the policy is assigned.

 
     [bookmark: pgfId-474614]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-474642][bookmark: 13008][bookmark: poman_proc_ModifyingSharedPolicyAssignmentsinDeviceView]Modifying Shared Policy Assignments in Device View or the Site-to-Site VPN Manager[bookmark: marker-474622][bookmark: marker-474624][bookmark: marker-474626][bookmark: marker-474628][bookmark: marker-474630][bookmark: marker-474632][bookmark: marker-474634][bookmark: marker-474636][bookmark: marker-474638][bookmark: marker-474640]

 
     [bookmark: pgfId-474647]You can modify the list of devices or VPN topologies assigned a particular shared policy as required. If you remove a device or topology from a policy assignment, that policy is effectively removed from the device’s or topology’s planned configuration. Upon deployment, any configuration of that type that exists on the device or topology is removed. For more information about the implications of unassigning a policy, see Unassigning a Policy.

 
      
      [image: ] 
     
 
     
 
     
      [bookmark: pgfId-474652]
      Caution Use the policy assignment feature with care, as unassigning a policy removes that configuration from the device or topology and can have unintended consequences. For example, if you unassign a device access policy from a Cisco IOS router and then deploy that change, you might prevent Security Manager from configuring that device in the future (see 
      User Accounts and Device Credentials on Cisco IOS Routers).
       
       
 
      

     
 
     [bookmark: pgfId-474657]Policy assignment can also be modified from Policy view. For more information, see Modifying Policy Assignments in Policy View.

 
     [bookmark: pgfId-474659]Related Topics

 
      
      		 [bookmark: pgfId-474664]Understanding the Device View

 
      		 [bookmark: pgfId-474669]Using the Policy Banner

 
      		 [bookmark: pgfId-474674]Assigning a Shared Policy to a Device or VPN Topology

 
      		 [bookmark: pgfId-474679]Unassigning a Policy

 
      		 [bookmark: pgfId-474684]Copying Policies Between Devices

 
      		 [bookmark: pgfId-474689]Working with Shared Policies in Device View or the Site-to-Site VPN Manager

 
      		 [bookmark: pgfId-474694]Inheriting or Uninheriting Rules

 
      		 [bookmark: pgfId-474699]Inheritance vs. Assignment

 
     

 
     
 
     [bookmark: pgfId-474701]Step 1 In Device view or the Site-to-Site VPN Manager, select a shared policy from the Policies selector, then do one of the following:

 
      
      		 [bookmark: pgfId-474703](Device view only) Select  Policy > Edit Policy Assignments .

 
      		 [bookmark: pgfId-474705]Right-click the policy and select  Edit Policy Assignments .

 
      		 [bookmark: pgfId-474707]Click the  n device/VPN link in the Assigned To field in the policy banner.

 
     

 
     [bookmark: pgfId-474709]Step 2 Modify the list of devices or VPN topologies to which the policy is assigned, as follows:

 
      
      		 [bookmark: pgfId-474711]To assign the selected policy to additional devices or topologies, select them from the Available Devices/VPNs list, then click  >> to move them to the Assigned Devices list.

 
      		 [bookmark: pgfId-474713]To unassign the selected policy from devices or topologies, select them from the Assigned Devices/VPNs list, then click  << to return them to the Available Devices/VPNs list. Devices or topologies that are unassigned from the policy remove this policy from their running configuration during deployment.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-474715]Tip To assign a policy to all the devices in a device group, select the name of the device group, then click >>.


     
      

     

     

 
     [bookmark: pgfId-474717]Step 3 Click OK to save your assignment changes.

 
     [bookmark: pgfId-474719]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-474735][bookmark: 13111][bookmark: poman_cncpt_ManagingSharedPoliciesinPolicyView]Managing Shared Policies in Policy View[bookmark: marker-474729][bookmark: marker-474731][bookmark: marker-474733]

 
    [bookmark: pgfId-474737]Use Policy view to globally manage all the shared policies configured in Security Manager. Unlike Device view, which you use to manage all the policies configured on a selected device, Policy view enables you to manage all shared policies of a particular type regardless of device.

 
    [bookmark: pgfId-474739]Policy view enables you to:

 
     
     		 [bookmark: pgfId-474741]Create new shared policies.

 
     		 [bookmark: pgfId-474743]Edit any policy configuration.

 
     		 [bookmark: pgfId-474745]Modify the list of devices or VPNs to which shared policies are assigned.

 
     		 [bookmark: pgfId-474747]Delete shared policies that are not assigned to any devices or VPNs.

 
    

 
    [bookmark: pgfId-474749]To access Policy view, select View > Policy View or click the Policy View button on the toolbar.

 
    [bookmark: pgfId-474754]Figure 5-4 shows the main areas of Policy view.

 
    [bookmark: pgfId-474758]Figure 5-4 [bookmark: 13143]Policy View

 
    [bookmark: pgfId-474762] 
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     		 [bookmark: pgfId-474767] (7) Policy Type Selector —Lists the policy types available in Security Manager, divided by category. Clicking a policy type in the selector displays all the shared policies defined for that type in the Shared Policy selector. To create a new policy, right click the policy type and select  New [policy type] Policy or click the Create a Policy button in the shared policy selector. For more information, see Policy View Selectors.

 
     		 [bookmark: pgfId-474772] (4, 5, 6) Shared Policy Selector —Lists the shared policies that are defined for the selected type. Clicking a policy in the selector displays the definition of the policy and its assignments in the work area. For more information, see Policy View Selectors.

 
    

 
    [bookmark: pgfId-474777]Right-click a policy in the selector to perform actions on the policy. For more information on the available commands, see Policy View—Shared Policy Selector Options.

 
    [bookmark: pgfId-474782]Use the Filter field to filter the list of policies displayed in the selector. For more information about creating filters, see Filtering Items in Selectors.

 
     
     		 [bookmark: pgfId-474784] (1, 2, 3) Work Area —Contains two tabs:

 
    

 
    [bookmark: pgfId-474789] – Details—Use this tab to view and edit the definition of the selected policy. You can modify the definition as required; click Save in the work area to save your changes. Changes affect all devices or VPN topologies to which the policy is assigned. The information displayed on the Details tab is identical to the information displayed in Device view or the Site-to-Site VPN Manager and can be modified in exactly the same way. See Policy View Selectors.

 
    [bookmark: pgfId-474794] – Assignments—Use this tab to view and edit the list of devices or VPNs to which a shared policy is assigned. For more information, see Modifying Policy Assignments in Policy View.

 
    [bookmark: pgfId-474796]Related Topics

 
     
     		 [bookmark: pgfId-474801]Importing Policies or Devices

 
     		 [bookmark: pgfId-474806]Managing Policies in Device View and the Site-to-Site VPN Manager

 
     		 [bookmark: pgfId-474811]Working with Shared Policies in Device View or the Site-to-Site VPN Manager

 
    

 
     
      [bookmark: pgfId-474819][bookmark: 13234][bookmark: poman_cncpt_PolicyViewSelectors]Policy View Selectors[bookmark: marker-474817]

 
     [bookmark: pgfId-474821]Policy view contains two selectors. The upper selector displays all the policy types available for a selected policy domain. The root of the policy type selector is the policy domain name. To display the policy types for a different policy domain, click the root of the tree and select a different domain from the list.

 
     [bookmark: pgfId-474823]Policy domains include:

 
      
      		 [bookmark: pgfId-474828]Firewall—Lists all policy types for configuring firewall services. See Chapter 12, “Introduction to Firewall Services”.

 
      		 [bookmark: pgfId-474833]NAT (PIX/ASA/FWSM)—Lists all NAT policies configured on PIX, ASA, and FWSM devices. See NAT Policies on Security Devices.

 
      		 [bookmark: pgfId-474838]NAT (Router)—Lists all NAT policies configured on Cisco IOS routers. See NAT Policies on Cisco IOS Routers.

 
      		 [bookmark: pgfId-474843]Site-to-Site VPN—Lists all policy types for configuring site-to-site VPNs. See Chapter 25, “Managing Site-to-Site VPNs: The Basics”.

 
      		 [bookmark: pgfId-474848]Remote Access VPN—Lists all policy types for configuring remote-access IPSec and SSL VPNs. See Chapter 30, “Managing Remote Access VPNs: The Basics”.

 
      		 [bookmark: pgfId-474853]Catalyst Platform—Lists all policy types for configuring Catalyst switches and 7600 routers. See Chapter 67, “Managing Cisco Catalyst Switches and Cisco 7600 Series Routers”.

 
      		 [bookmark: pgfId-474858]IPS—Lists all policy types for configuring IPS devices. See Overview of IPS Configuration.

 
      		 [bookmark: pgfId-474863]IPS (Router)—Lists all policy types for configuring Cisco IOS IPS policies on IOS routers. See Overview of Cisco IOS IPS Configuration.

 
      		 [bookmark: pgfId-474868]PIX/ASA/FWSM Platform—Lists all policy types for configuring PIX/ASA/FWSM platform-specific policies. See Chapter 46, “Managing Firewall Devices”.

 
      		 [bookmark: pgfId-474873]Router Interfaces—Lists all policy types for configuring platform-specific Cisco IOS router interface policies. See Chapter 60, “Managing Routers”.

 
      		 [bookmark: pgfId-474878]Router Platform—Lists all policy types for configuring platform-specific Cisco IOS router policies. See Chapter 60, “Managing Routers”.

 
      		 [bookmark: pgfId-474883]FlexConfigs—Lists all FlexConfig policies. See Chapter 7, “Managing FlexConfigs”.

 
     

 
     [bookmark: pgfId-474885]You can expand and collapse the selector as required to view all the available policy types and subtypes. To create a new policy, right click the policy type and select New [policy type] Policy or click the Create a Policy button in the shared policy selector.

 
     [bookmark: pgfId-474887]Selecting a policy type from the Policy Type selector displays all the shared policies of that type in the Shared Policy selector. Local policies configured in Device view are not displayed.

 
     [bookmark: pgfId-474889]For example, when you select a configuration policy type, such as NAT translation rules, the Shared Policy selector displays a flat list of each shared policy of that type. If you select a rule-based policy type, such as firewall access rules, the Shared Policy selector displays a hierarchical tree of shared policies. This enables you to view the inheritance relationships among the various policies. The Shared Policy selector includes a shortcut menu with options for actions that can be performed on that policy, such as renaming it.
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     [bookmark: pgfId-474894]Tip You can create and apply a filter to shorten the list of policies displayed in the Shared Policy selector. For more information about filters, see Filtering Items in Selectors.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-474902][bookmark: 13285][bookmark: polpage_cncpt_PolicyViewSharedPolicySelectorOptions]Policy View—Shared Policy Selector Options[bookmark: marker-474900]

 
     [bookmark: pgfId-474904]Right-click a policy in the Shared Policy selector of Policy view to display a shortcut menu for performing functions on the selected policy.

 
     [bookmark: pgfId-474906]Related Topics

 
      
      		 [bookmark: pgfId-474911]Policy View Selectors

 
      		 [bookmark: pgfId-474916]Managing Shared Policies in Policy View

 
     

 
     [bookmark: pgfId-474918]Field Reference

 
     [bookmark: pgfId-474921] 

 
      
       
        
        [bookmark: pgfId-471122]Table 5-7 [bookmark: 13303]Shared Policy Selector Options 

 
        
       
         
         		
           
           [bookmark: pgfId-471128]Menu Command
          
  
         		
           
           [bookmark: pgfId-471130]Description
          
  
        

 
         
         		[bookmark: pgfId-471136]Clone Policy

  
         		[bookmark: pgfId-471141]Creates a new shared policy with the same definition as the policy from which it was cloned. See Cloning (Copying) a Shared Policy.

  
        

 
         
         		[bookmark: pgfId-471147]Rename Policy

  
         		[bookmark: pgfId-471152]Renames the selected policy. See Renaming a Shared Policy.

  
        

 
         
         		[bookmark: pgfId-471158]Add to Policy Bundle

  
         		[bookmark: pgfId-471163]Allows you to add the selected shared policy to a policy bundle. See Managing Policy Bundles.

  
        

 
         
         		[bookmark: pgfId-471169]Inherit Rules

  
         		[bookmark: pgfId-471171]Applies only to rule-based policies such as access rules.

 [bookmark: pgfId-471176]Causes a rule-based policy to inherit the rules of a different shared policy of the same type. See Inheriting or Uninheriting Rules.

  
        

 
         
         		[bookmark: pgfId-471182]New [policy type] Policy

  
         		[bookmark: pgfId-471187]Creates a new shared policy of the selected type. See Creating a New Shared Policy.

  
        

 
         
         		[bookmark: pgfId-471193]Delete Policy

  
         		[bookmark: pgfId-471198]Deletes the selected shared policy. See Deleting a Shared Policy

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-474937][bookmark: 13351][bookmark: poman_proc_CreatingaNewSharedPolicy]Creating a New Shared Policy[bookmark: marker-474929][bookmark: marker-474931][bookmark: marker-474933][bookmark: marker-474935]

 
     [bookmark: pgfId-474942]Use Policy view to create a new shared policy. In most cases, the new policy starts out undefined, but in certain cases (for example, many site-to-site VPN policies, such as IPsec proposals and GRE modes) default values are supplied. In all cases, the new policy is not initially assigned to any devices. If the new policy is a rule-based policy that supports inheritance, it can be created as a child of an existing shared policy of the same type. For more information, see Understanding Rule Inheritance.
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     [bookmark: pgfId-474947]Tip You can also create shared policies by converting local policies in Device view. For more information, see Sharing a Local Policy.


     
      

     

     

 
     [bookmark: pgfId-474949]Related Topics

 
      
      		 [bookmark: pgfId-474954]Importing Policies or Devices

 
      		 [bookmark: pgfId-474959]Managing Shared Policies in Policy View

 
      		 [bookmark: pgfId-474964]Deleting a Shared Policy

 
     

 
     
 
     [bookmark: pgfId-474966]Step 1 In Policy view, select a policy type in the Policy Type selector.

 
     [bookmark: pgfId-474968]Step 2 Do one of the following:

 
      
      		 [bookmark: pgfId-474970]Right-click the policy type in the Policy Type selector, then select  New [policy type] Policy .

 
      		 [bookmark: pgfId-474972]Right-click a policy in the Shared Policy selector, then select  New [policy type] Policy .

 
      		 [bookmark: pgfId-474974]Click the  Create a Policy button beneath the Shared Policy selector.

 
     

 
     [bookmark: pgfId-474976]The Create a Policy dialog box is displayed.

 
     [bookmark: pgfId-474978]Step 3 Enter a name for the new policy. Policy names can contain up to 255 characters, including spaces and special characters.

 
     [bookmark: pgfId-474980]When creating a Translation Rules policy for NAT rules on security devices (PIX/ASA/FWSM), you must also choose a device software Version: PIX/ASA 6.3-8.2 or ASA 8.3 & Later.

 
     [bookmark: pgfId-474982]Step 4 Click OK. The new policy appears in the Shared Policy selector.

 
     [bookmark: pgfId-474987]To configure a definition for the new shared policy, click the Help button in the toolbar with the Details tab open to see information specific to the type of policy you are creating. To assign the new shared policy, see Modifying Policy Assignments in Policy View.

 
     [bookmark: pgfId-474989]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-475009][bookmark: 13412][bookmark: poman_proc_ModifyingPolicyAssignmentsinPolicyView]Modifying Policy Assignments in Policy View[bookmark: marker-474997][bookmark: marker-474999][bookmark: marker-475001][bookmark: marker-475003][bookmark: marker-475005][bookmark: marker-475007]

 
     [bookmark: pgfId-475011]Use the Assignments tab in Policy view to modify the list of devices or VPN topologies to which you assigned a selected shared policy. The Assignments tab shows a list of all devices that are currently assigned the selected shared policy. It also shows devices that are assigned the policy through inheritance.

 
     [bookmark: pgfId-475013]Assigning a policy to a device or VPN overwrites any policy of the same type (local or shared) that was previously assigned to the device in Security Manager. When deployed, the newly assigned policy overrides any policy of the same type that is already configured on the device, whether it was configured using Security Manager or using another method, such as the CLI.

 
     [bookmark: pgfId-475018]When you unassign a shared policy from a device or VPN topology, Security Manager removes the policy from the planned configuration of that device or VPN topology. When the configuration defined by the policy is deployed, any configuration of the same type that is already configured on the device (including the devices in the VPN topology) is removed. For more information, see Unassigning a Policy.

 
     [bookmark: pgfId-475020]Therefore, if your intention when performing unassign is to assign a different shared policy to a particular device or VPN topology, it is important to select the replacement policy and perform the assignment before performing deployment.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-475025]Tip Assigning a replacement policy is particularly important when you use a device access policy to configure the enable password or enable secret password on a Cisco IOS router. If you unassign this policy and fail to define a different password in its place before deployment, Security Manager might be unable to configure this device in the future. For more information, see User Accounts and Device Credentials on Cisco IOS Routers.


     
      

     

     

 
     [bookmark: pgfId-475030]Alternatively, you can return to Device view and replace the shared policy assigned to the device with a different shared policy. For more information, see Assigning a Shared Policy to a Device or VPN Topology.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-475032]Note If you unassign a mandatory site-to-site VPN policy, such as an IKE proposal policy, Security Manager automatically replaces it with a default policy. If you unassign a mandatory remote access VPN policy, you must manually configure a new policy of that same type or deployment will fail.


     
      

     

     

 
     [bookmark: pgfId-475034]Related Topics

 
      
      		 [bookmark: pgfId-475039]Modifying Shared Policy Assignments in Device View or the Site-to-Site VPN Manager

 
      		 [bookmark: pgfId-475044]Managing Shared Policies in Policy View

 
     

 
     
 
     [bookmark: pgfId-475049]Step 1 In Policy view, select a policy type from the Policy Type selector, then select a policy from the Shared Policy selector. For more information about using these selectors, see Policy View Selectors.

 
     [bookmark: pgfId-475051]Step 2 Click the Assignments tab in the work area.

 
     [bookmark: pgfId-475053]The Assignments tab shows a list of all devices that are currently assigned the selected shared policy. It also shows devices that are assigned the policy through inheritance.

 
     [bookmark: pgfId-475055]Step 3 Modify the list of devices or VPNs to which the policy is assigned, as follows:

 
      
      		 [bookmark: pgfId-475057]To assign the selected policy to additional devices or VPNs, select one or more items from the Available Devices/VPNs list, then click  >> to move them to the Assigned Devices/VPNs list.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-475059]Tip To assign a policy to all the devices in a device group, select the name of the device group, then click >>.


     
      

     

     

 
      
      		 [bookmark: pgfId-475061]To unassign the selected policy from devices or VPNs, select one or more items from the Assigned Devices/VPNs list, then click  << to return them to the Available Devices/VPNs list.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-475063]Note Prior to the release of Security Manager 4.4 and versions 9.0 and higher of the ASA, separate pages, policies and policy objects were provided for configuring IPv4 and IPv6 firewall rules and policies. With Security Manager 4.4 and ASA 9.0+, these policies and policy objects were combined or unified. However, for the earlier ASA versions, a separate page for IPv6 access rules is still provided in Device view, while in Policy view, IPv4 and unified versions of the AAA-, access- and inspection-rule policy types are provided.

If you assign an IPv4 AAA-, access-, or inspection-rule shared policy to a 9.0+ device, you will no longer be able to assign unified versions of those policies to that device. Likewise, if you assign a unified AAA-, access-, or inspection-rule shared policy to a 9.0+ device, you will no longer be able to assign IPv4 versions of those shared policies to that device--the device will not be included in the list of available devices on the Assignments tab for the shared policy.


     
      

     

     

 
     [bookmark: pgfId-475065]Step 4 Click Save to save your assignment changes.

 
     [bookmark: pgfId-475067]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-475079][bookmark: 13482][bookmark: poman_proc_DeletingaSharedPolicy]Deleting a Shared Policy[bookmark: marker-475073][bookmark: marker-475075][bookmark: marker-475077]

 
     [bookmark: pgfId-475081]Use Policy view to delete a shared policy from Security Manager.

 
     [bookmark: pgfId-475086]Before you delete a shared policy, you should unassign it from any devices that use it, and configure replacement policies for those devices. If a shared policy is assigned to a device, when the policy is deleted the device no longer has a policy configured for the deleted shared policy, other than whatever defaults might exist for the policy type. For more information about removing assignments, see Modifying Policy Assignments in Policy View.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-475088]Note If a shared policy is part of a policy bundle that is assigned to a device, you must remove the assignment before you can delete the shared policy.


     
      

     

     

 
     [bookmark: pgfId-475090]Related Topics

 
      
      		 [bookmark: pgfId-475095]Creating a New Shared Policy

 
      		 [bookmark: pgfId-475100]Cloning (Copying) a Shared Policy

 
      		 [bookmark: pgfId-475105]Managing Shared Policies in Policy View

 
     

 
     
 
     [bookmark: pgfId-475110]Step 1 In Policy view, select a policy type from the Policy Type selector, then select the policy to delete from the Shared Policy selector. For more information about using these selectors, see Policy View Selectors.

 
     [bookmark: pgfId-475112]Step 2 Do one of the following:

 
      
      		 [bookmark: pgfId-475114]Right-click the policy, then select  Delete Policy .

 
      		 [bookmark: pgfId-475116]Click the  Delete a Policy button beneath the Shared Policy selector.

 
     

 
     [bookmark: pgfId-475118]You are asked to confirm the deletion.

 
     [bookmark: pgfId-475120]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-475132][bookmark: 13528][bookmark: polbndl_intro_PolicyBundle]Managing Policy Bundles[bookmark: marker-475130]

 
    [bookmark: pgfId-475134]Policy bundles are collections of shared policies that can be managed as a group. Policy bundles make managing shared policies easier by allowing you to create the bundle one time and then assign all of the policies in the bundle to a new device at once. The shared policies that are part of the bundle function in the same way as other shared policies and modifying any of the shared policies that are part of a bundle affects all devices that are assigned that policy either directly or through a policy bundle.

 
    [bookmark: pgfId-475136]When creating a policy bundle, you can only assign one shared policy of each type to the policy bundle. Multiple policy bundles can be assigned to a device as long as the policy types in those policy bundles do not overlap.

 
    [bookmark: pgfId-475138]When assigning a policy bundle to a device, if local policies on that device are the same policy type as those contained in the policy bundle, you are given the option to inherit or replace the existing policies.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-475140]Note When you unassign a policy bundle, all policies that are part of that bundle are removed from the device. Local policies will be lost and cannot be retrieved.


    
     

    

    

 
    [bookmark: pgfId-475142]This section contains the following topics:

 
     
     		 [bookmark: pgfId-475147]Creating a New Policy Bundle

 
     		 [bookmark: pgfId-475152]Cloning a Policy Bundle

 
     		 [bookmark: pgfId-475157]Renaming a Policy Bundle

 
     		 [bookmark: pgfId-475162]Assigning Policy Bundles to Devices

 
    

 
     
      [bookmark: pgfId-475180][bookmark: 13539][bookmark: polbndl_proc_CreatingaPolicyBundle]Creating a New Policy Bundle[bookmark: marker-475172][bookmark: marker-475174][bookmark: marker-475176][bookmark: marker-475178]

 
     [bookmark: pgfId-475182]You can use the Policy Bundle view to create new policy bundles. When creating a policy bundle, you can only assign one shared policy of each type to the policy bundle.

 
     [bookmark: pgfId-475184]Related Topics

 
      
      		 [bookmark: pgfId-475189]Managing Policy Bundles

 
      		 [bookmark: pgfId-475194]Cloning a Policy Bundle

 
      		 [bookmark: pgfId-475199]Renaming a Policy Bundle

 
      		 [bookmark: pgfId-475204]Assigning Policy Bundles to Devices

 
     

 
     
 
     [bookmark: pgfId-475206]Step 1 Use one of the following methods to create a policy bundle:

 
      
      		 [bookmark: pgfId-475208]In Policy Bundle view, do one of the following:

 
     

 
     [bookmark: pgfId-475210] – From the All Shared Policies view, select the shared policies that you would like to bundle, then right-click on a selected shared policy and select Create Policy Bundle.

 
     [bookmark: pgfId-475212] – Right-click an existing policy bundle in the Policy Bundle selector, then select Create Policy Bundle.

 
     [bookmark: pgfId-475214] – Click the Create a Policy Bundle button beneath the Policy Bundle selector.

 
      
      		 [bookmark: pgfId-475216]To create a new policy bundle that includes all of the shared policies on a device, right-click a device in the Device selector in Device view, then select  Create Policy Bundle .

 
     

 
     [bookmark: pgfId-475218]The Create Policy Bundle dialog box is displayed.

 
     [bookmark: pgfId-475220]Step 2 Enter a name for the new policy bundle.

 
     [bookmark: pgfId-475222]Step 3 Click OK.

 
     [bookmark: pgfId-475224]The policy bundle is added to the list of policy bundles in Policy Bundle view.

 
     [bookmark: pgfId-475226]Step 4 To configure the definition for a policy bundle, do any of the following:

 
      
      		 [bookmark: pgfId-475228]In Policy Bundle view:

 
     

 
     [bookmark: pgfId-475230] – To add shared policies to the bundle, select All Shared Policies in the Policy Bundle selector and then drag and drop the required shared policies onto the policy bundle.

 
     [bookmark: pgfId-475232] – To remove shared policies from the bundle, select the bundle in the Policy Bundle selector. Select the shared policy you want to remove on the Details tab of the Policy Bundle View window, and then click Delete.

 
      
      		 [bookmark: pgfId-475234]In Policy view, right-click the shared policy you want to add to a policy bundle, select  Add to Policy Bundle , and then select the bundle to which you want to add the shared policy.

 
     

 
     [bookmark: pgfId-475236]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-475252][bookmark: 13616][bookmark: polbndl_proc_CloningaPolicyBundle]Cloning a Policy Bundle[bookmark: marker-475244][bookmark: marker-475246][bookmark: marker-475248][bookmark: marker-475250]

 
     [bookmark: pgfId-475254]You can use Policy Bundle view to create a new policy bundle by cloning an existing bundle.

 
     [bookmark: pgfId-475256]Related Topics

 
      
      		 [bookmark: pgfId-475261]Managing Policy Bundles

 
      		 [bookmark: pgfId-475266]Creating a New Policy Bundle

 
      		 [bookmark: pgfId-475271]Renaming a Policy Bundle

 
      		 [bookmark: pgfId-475276]Assigning Policy Bundles to Devices

 
     

 
     
 
     [bookmark: pgfId-475278]Step 1 In Policy Bundle view, right-click an existing policy bundle in the Policy Bundle selector, then select Clone Policy Bundle.

 
     [bookmark: pgfId-475280]The Clone Policy Bundle dialog box is displayed.

 
     [bookmark: pgfId-475282]Step 2 Enter a name for the new policy bundle.

 
     [bookmark: pgfId-475284]Step 3 Click OK.

 
     [bookmark: pgfId-475286]The new policy bundle appears in the Policy Bundle selector.

 
     [bookmark: pgfId-475288]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-475304][bookmark: 13664][bookmark: polbndl_proc_RenamingaPolicyBundle]Renaming a Policy Bundle[bookmark: marker-475296][bookmark: marker-475298][bookmark: marker-475300][bookmark: marker-475302]

 
     [bookmark: pgfId-475306]You can rename existing policy bundles from the Policy Bundle view. Renaming a policy bundle will not affect device assignments.

 
     [bookmark: pgfId-475308]Related Topics

 
      
      		 [bookmark: pgfId-475313]Managing Policy Bundles

 
      		 [bookmark: pgfId-475318]Creating a New Policy Bundle

 
      		 [bookmark: pgfId-475323]Cloning a Policy Bundle

 
      		 [bookmark: pgfId-475328]Assigning Policy Bundles to Devices

 
     

 
     
 
     [bookmark: pgfId-475330]Step 1 In Policy Bundle view, right-click an existing policy bundle in the Policy Bundle selector, then select Rename Policy Bundle.

 
     [bookmark: pgfId-475332]The Rename Policy Bundle dialog box is displayed.

 
     [bookmark: pgfId-475334]Step 2 Enter a new name for the policy bundle.

 
     [bookmark: pgfId-475336]Step 3 Click OK.

 
     [bookmark: pgfId-475338]The policy bundle name is updated in the Policy Bundle selector.

 
     [bookmark: pgfId-475340]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-475356][bookmark: 13712][bookmark: polbndl_proc_AssigningPolicyBundles]Assigning Policy Bundles to Devices[bookmark: marker-475348][bookmark: marker-475350][bookmark: marker-475352][bookmark: marker-475354]

 
     [bookmark: pgfId-475358]You can modify the list of devices assigned a particular policy bundle as required. Multiple policy bundles can be assigned to a device as long as the policy types in those policy bundles do not overlap. When assigning a policy bundle to a device, if local policies on that device are the same policy type as those contained in the policy bundle, you are given the option to inherit or replace the existing policies.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-475360]Note If any of the policies that are part of a policy bundle are not compatible with the device to which you are assigning it, the bundle cannot be assigned.


     
      

     

     

 
     [bookmark: pgfId-475365]If you remove a device from a policy bundle assignment, all policies that are part of that bundle are effectively removed from the device’s planned configuration. Local policies will be lost and cannot be retrieved. Upon deployment, any configuration of that type that exists on the device is removed. For more information about the implications of unassigning a policy, see Unassigning a Policy.

 
      
      [image: ] 
     
 
     
 
     
      [bookmark: pgfId-475370]
      Caution Use the policy bundle assignment feature with care, as unassigning a policy bundle removes that configuration from the device and can have unintended consequences. For example, if you unassign a device access policy from a Cisco IOS router and then deploy that change, you might prevent Security Manager from configuring that device in the future (see 
      User Accounts and Device Credentials on Cisco IOS Routers).
       
       
 
      

     
 
     [bookmark: pgfId-475372]Related Topics

 
      
      		 [bookmark: pgfId-475377]Managing Policy Bundles

 
      		 [bookmark: pgfId-475382]Creating a New Policy Bundle

 
      		 [bookmark: pgfId-475387]Cloning a Policy Bundle

 
      		 [bookmark: pgfId-475392]Renaming a Policy Bundle

 
     

 
     
 
     [bookmark: pgfId-475394]Step 1 In Policy Bundle view, select an existing policy bundle in the Policy Bundle selector.

 
     [bookmark: pgfId-475396]The policy bundle details are displayed in the Policy Bundle main window.

 
     [bookmark: pgfId-475398]Step 2 Click the Assignments tab.

 
     [bookmark: pgfId-475400]Step 3 Modify the list of devices to which the policy bundle is assigned, as follows:

 
      
      		 [bookmark: pgfId-475402]To assign the selected policy bundle to additional devices, select them from the Available Devices list, then click  >> to move them to the Assigned Devices list.

 
      		 [bookmark: pgfId-475404]To unassign the selected policy bundle from devices, select them from the Assigned Devices list, then click  << to return them to the Available Devices/VPNs list. Devices or topologies that are unassigned from the policy remove this policy from their running configuration during deployment.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-475406]Tip To assign a policy to all the devices in a device group, select the name of the device group, then click >>.


     
      

     

     

 
     [bookmark: pgfId-475408]Step 4 Click OK to save your assignment changes.

 
     [bookmark: pgfId-475410]The policy bundle name is updated in the Policy Bundle selector.

 
     [bookmark: pgfId-475412]
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     [bookmark: pgfId-532785][bookmark: 144392][bookmark: rtidnty_intro_ConfiguringIdentity]Configuring Identity Policies
      
      
 
     
 

 
    [bookmark: pgfId-532787]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-532792]802.1x on Cisco IOS Routers

 
     		 [bookmark: pgfId-532797]802.1x Policy Page

 
     		 [bookmark: pgfId-532802]Network Admission Control on Cisco IOS Routers

 
     		 [bookmark: pgfId-532807]Network Admission Control Policy Page

 
    

 
   
 
    
     [bookmark: pgfId-532819][bookmark: 144394][bookmark: rtchap_cncpt_xonCiscoIOSRouters]802.1x on Cisco IOS Routers[bookmark: marker-532813][bookmark: marker-532815][bookmark: marker-532817]

 
    [bookmark: pgfId-532821]The IEEE 802.1x standard defines 802.1x port-based authentication as a client-server based access control and authentication protocol that restricts unauthorized clients from connecting to a LAN through public ports. The authentication server validates each client connected to an interface before making available any services offered by the router or the LAN.

 
    [bookmark: pgfId-532823]Until the client is authenticated, 802.1x access control allows only Extensible Authentication Protocol over LAN (EAPOL) traffic through the interface to which the client is connected. If authentication is successful, normal traffic can pass through the interface.

 
    [bookmark: pgfId-532825]802.1x authentication provides VPN access control, enabling unauthenticated traffic to access the Internet while preventing it from accessing the VPN tunnel. This solution is especially useful for enterprises whose workers access the corporate VPN through a home access router that other family members use to access the Internet. When you use 802.1x, you create a virtual interface to carry unauthenticated traffic while authenticated traffic continues to pass through the physical interface.

 
    [bookmark: pgfId-532830]802.1x requires that you use DHCP to provide IP addresses to the clients that request authentication. We recommend that you use two IP address pools, one for authenticated traffic and the other for unauthenticated traffic. If you use two pools, the DNS server in the corporate DHCP pool should point to the corporate DNS server. The DNS server for the noncorporate DHCP pool should use the DNS server provided by the ISP on the public interface. You configure DHCP by selecting a DHCP policy. See DHCP on Cisco IOS Routers for more information.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-532832]Note 802.1x is supported on the following platforms—Cisco 800, 1700, 1800, 1900, 2600, 2800, 2900, 3600, 3700, 3800, 3900 Series Routers.


    
     

    

    

 
    [bookmark: pgfId-532834]For more information about 802.1x, see:

 
     
     		 [bookmark: pgfId-532839]Understanding 802.1x Device Roles

 
     		 [bookmark: pgfId-532844]802.1x Interface Authorization States

 
     		 [bookmark: pgfId-532849]Topologies Supported by 802.1x

 
     		 [bookmark: pgfId-532854]Defining 802.1x Policies

 
    

 
     
      [bookmark: pgfId-532862][bookmark: 144426][bookmark: rtchap_cncpt_UnderstandingxDeviceRoles]Understanding 802.1x Device Roles[bookmark: marker-532860]

 
     [bookmark: pgfId-532864]802.1x port-based authentication uses the following device roles:

 
      
      		 [bookmark: pgfId-532866]Client—The workstation requesting access to the VPN. It must be running 802.1x-compliant client software, such as that offered with the Microsoft Windows XP operating system.

 
      		 [bookmark: pgfId-532868]Authentication server—Authenticates clients. The authentication server validates the client’s identity and notifies the router whether the client is authorized to access the network. The Remote Authentication Dial-In User Service (RADIUS) security system with EAP extensions is the only supported authentication server. In Security Manager, a AAA (authentication, authorization, and accounting) server, as defined in a AAA server object, is the authentication server for 802.1x policies.

 
      		 [bookmark: pgfId-532870]Router (edge router or wireless access point)—Controls physical access to the network based on the authentication status of the client. The router is an intermediary (proxy) between the client and the authentication server, requesting identity information from the client, verifying that information with the authentication server, and relaying a response to the client. In Security Manager, the router on which you configure an 802.1x policy acts as the switch.

 
     

 
     [bookmark: pgfId-532872]Related Topics

 
      
      		 [bookmark: pgfId-532877]802.1x Interface Authorization States

 
      		 [bookmark: pgfId-532882]Topologies Supported by 802.1x

 
      		 [bookmark: pgfId-532887]Defining 802.1x Policies

 
      		 [bookmark: pgfId-532892]802.1x on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-532900][bookmark: 144455][bookmark: rtchap_cncpt_xInterfaceAuthorizationStates]802.1x Interface Authorization States[bookmark: marker-532898]

 
     [bookmark: pgfId-532902]When you use 802.1x, the interface state determines whether to grant the client network access. By default, the interface starts in the unauthorized state. While in this state, the interface disallows all traffic in both directions, except for EAPOL packets. After a client is authenticated, the interface transitions to the authorized state, enabling all client traffic to flow normally.

 
     [bookmark: pgfId-532904]If a client that does not support 802.1x is connected to an unauthorized 802.1x interface, the router requests the client’s identity. In this situation, the client does not respond to the request, the interface remains in the unauthorized state, and the client is not granted access to the network. In contrast, when an 802.1x-enabled client connects to an interface that is not running the 802.1x protocol, the client initiates the authentication process by sending the EAPOL-Start frame. If no response is received, the client sends the request a fixed number of times. Because no response is received, the client begins sending frames as if the interface were in the authorized state.

 
     [bookmark: pgfId-532906]You can control the interface authorization state by selecting one of the following options:

 
      
      		 [bookmark: pgfId-532908]Auto—Enables 802.1x authentication, which causes the interface to start in the unauthorized state. Only EAPOL frames are sent and received through the interface. Authentication begins when the link state of the interface transitions from down to up or when an EAPOL-Start frame is received. The router requests the client’s identity and begins relaying authentication messages between the client and the authentication server. The router uses the MAC address of each client trying to access the network as unique client identifiers.

 
      		 [bookmark: pgfId-532910]Force authorized—Disables 802.1x authentication, which causes the interface to move to the authorized state without authenticating the client.

 
     

 
     [bookmark: pgfId-532912]After a client is successfully authenticated, the interface state changes to authorized, which enables all frames from the client to enter the network. If authentication fails, the interface remains in the unauthorized state, but authentication can be retried. If the authentication server cannot be reached, the router can retransmit the request. If the authentication server does not respond after the defined number of attempts, authentication fails and network access is denied to the client.

 
     [bookmark: pgfId-532914]When a client logs off, it sends an EAPOL-Logoff message, which causes the interface to return to the unauthorized state.

 
     [bookmark: pgfId-532916]Related Topics

 
      
      		 [bookmark: pgfId-532921]Understanding 802.1x Device Roles

 
      		 [bookmark: pgfId-532926]Topologies Supported by 802.1x

 
      		 [bookmark: pgfId-532931]Defining 802.1x Policies

 
      		 [bookmark: pgfId-532936]802.1x on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-532944][bookmark: 144486][bookmark: rtchap_cncpt_TopologiesSupportedbyx]Topologies Supported by 802.1x[bookmark: marker-532942]

 
     [bookmark: pgfId-532946]802.1x port-based authentication supports two topologies:

 
      
      		 [bookmark: pgfId-532948]Point-to-point

 
      		 [bookmark: pgfId-532950]Wireless LAN

 
     

 
     [bookmark: pgfId-532952]In a point-to-point configuration, only one client can be connected to the 802.1x-enabled interface. The router detects the client when the interface state changes from down to up. If a client leaves the network or is replaced by another client, the interface state changes from up to down, which returns the interface to the unauthorized state.

 
     [bookmark: pgfId-532956]Figure 63-1 [bookmark: 144498]802.1x Topology

 
     [bookmark: pgfId-532959] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-532961]In a wireless LAN configuration, the 802.1x interface is configured in multihost mode, which is authorized as soon as one client is authenticated. After the interface is authorized, all other clients indirectly attached to the interface are granted access to the network. If the port becomes unauthorized (either because reauthentication fails or an EAPOL-Logoff message is received), the router denies access to the network to all attached clients. In this topology, the wireless access point is a client to the router and is responsible for authenticating the clients attached to it.

 
     [bookmark: pgfId-532963]Related Topics

 
      
      		 [bookmark: pgfId-532968]Understanding 802.1x Device Roles

 
      		 [bookmark: pgfId-532973]802.1x Interface Authorization States

 
      		 [bookmark: pgfId-532978]Defining 802.1x Policies

 
      		 [bookmark: pgfId-532983]802.1x on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-532991][bookmark: 144518][bookmark: rtchap_proc_DefiningxPolicies]Defining 802.1x Policies[bookmark: marker-532989]

 
     [bookmark: pgfId-532993]You configure an 802.1x policy by defining:

 
      
      		 [bookmark: pgfId-532995]The AAA server group containing the AAA server that authenticates hosts that are trying to connect to the network.

 
      		 [bookmark: pgfId-532997]The virtual interface that carries unauthenticated traffic and the physical interface that carries authenticated traffic.

 
      		 [bookmark: pgfId-532999](Optional) Properties of the physical interface, including the control type, automatic reauthentication, and several timeout values.

 
     

 
     [bookmark: pgfId-533004]If the router on which you are defining the 802.1x policy is not part of a VPN (for example, if it is directly connected to the corporate network to which you want to restrict access), you must manually define an access list. You can do this by defining an access rules policy (see Chapter 16, “Managing Firewall Access Rules”).

 
     [bookmark: pgfId-533006]Before You Begin

 
      
      		 [bookmark: pgfId-533011]Configure the selected router with a DHCP policy that contains two IP address pools, one for authenticated clients and one for unauthenticated clients. See Defining DHCP Policies.

 
      		 [bookmark: pgfId-533013]Make sure the router can route packets to the configured AAA (RADIUS) server. You can verify this by pinging the server from the router.

 
     

 
     [bookmark: pgfId-533015]Related Topics

 
      
      		 [bookmark: pgfId-533020]Understanding 802.1x Device Roles

 
      		 [bookmark: pgfId-533025]802.1x Interface Authorization States

 
      		 [bookmark: pgfId-533030]Topologies Supported by 802.1x

 
      		 [bookmark: pgfId-533035]802.1x on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-533037]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-533039](Device view) Select  Platform > Identity > 802.1x from the Policy selector.

 
      		 [bookmark: pgfId-533041](Policy view) Select  Router Platform > Identity > 802.1x from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-533046]The 802.1x page is displayed. See Table 63-1 for a description of the fields on this page.

 
     [bookmark: pgfId-533048]Step 2 Enter the name of the AAA server group containing the AAA server to use for authenticating clients using 802.1x, or click Select to select a server group from a list or to create a new one. The selected AAA server must use RADIUS with EAP extensions.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-533050]Note Each AAA server in the selected group must be configured to communicate with an interface that exists on the router; otherwise, validation fails.


     
      

     

     

 
     [bookmark: pgfId-533055]Step 3 In the Virtual Template field, enter the name of the interface or interface role that serves as the untrusted, virtual interface for carrying unauthenticated traffic, or click Select to select an interface role from a list or to create a new role. For more information, see Specifying Interfaces During Policy Definition.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-533057]Note Integrated Services Routers (ISRs), such as the Cisco 800, 1800, 1900, 2800, 2900, 3800, and 3900 Series, automatically use VLANs to carry unauthenticated traffic. If you define a virtual template, however, it is used in place of the VLAN.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-533062]Note Deployment might fail if PPP is defined on the virtual template defined here. See Defining PPP Connections.


     
      

     

     

 
     [bookmark: pgfId-533064]Step 4 Enter the name of the interface or interface role that serves as the trusted, physical interface for carrying authenticated traffic, or click Select to select a role from a list.

 
     [bookmark: pgfId-533069]The interface role you select should represent the internal protected interface that was configured as part of the VPN topology and no other physical interface on the selected router. For more information, see Defining the Endpoints and Protected Networks.

 
     [bookmark: pgfId-533076]Step 5 [bookmark: 144584](Optional) Modify the defaults of the physical interface used for 802.1x authentication. See Table 63-1 for details.

 
     [bookmark: pgfId-533078]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-533090][bookmark: 144591][bookmark: rtpage_cncpt_xPolicyPage]802.1x Policy Page[bookmark: marker-533086][bookmark: marker-533088]

 
    [bookmark: pgfId-533092]Use the 802.1x policy page to create policies that limit VPN access to authorized users. Authenticated traffic is allowed to pass through a designated physical interface on the router. Unauthenticated traffic is allowed to pass through a virtual interface to the Internet but is not allowed to access the VPN.

 
    [bookmark: pgfId-533097]For more information, see Defining 802.1x Policies.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-533102]Note 802.1x policies require DHCP address pools in order to assign IP addresses to clients. You define these pools by defining a DHCP policy on the same router. See DHCP Policy Page.


    
     

    

    

 
    [bookmark: pgfId-533104]Navigation Path

 
     
     		 [bookmark: pgfId-533106](Device view) Select  Platform > Identity > 802.1x from the Policy selector.

 
     		 [bookmark: pgfId-533108](Policy view) Select  Router Platform > Identity > 802.1x from the Policy Type selector. Right-click  802.1x to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-533110]Related Topics

 
     
     		 [bookmark: pgfId-533115]802.1x on Cisco IOS Routers

 
     		 [bookmark: pgfId-533120]Understanding AAA Server and Server Group Objects

 
     		 [bookmark: pgfId-533125]Basic Interface Settings on Cisco IOS Routers

 
     		 [bookmark: pgfId-533130]Understanding Interface Role Objects

 
    

 
    [bookmark: pgfId-533132]Field Reference

 
    [bookmark: pgfId-533135] 

 
     
      
       
       [bookmark: pgfId-531505]Table 63-1 [bookmark: 144633]802.1x Page 

 
       
      
        
        		
          
          [bookmark: pgfId-531511]Element
         
  
        		
          
          [bookmark: pgfId-531513]Description
         
  
       

 
        
        		[bookmark: pgfId-531519]AAA Server Group

  
        		[bookmark: pgfId-531521]The RADIUS AAA server group that authenticates the credentials of users trying to access a VPN tunnel. Enter the name of a AAA server group object, or click Add to select one from a list or to create a new AAA server group object.

 [bookmark: pgfId-531523]Note Each AAA server in the selected group must be configured to communicate with an interface that exists on the router; otherwise, validation fails.

  
       

 
        
        		[bookmark: pgfId-531529]Virtual Template

  
        		[bookmark: pgfId-531531]Mandatory for all routers except Integrated Services Routers (ISRs).

 [bookmark: pgfId-531533]The untrusted, virtual interface that provides Internet access to unauthenticated traffic. Enter the name of an interface or interface role, or click Select to select one from a list or to create a new group object.

 [bookmark: pgfId-531535]Note You do not need to configure a virtual template for ISRs, because they automatically use VLANs to provide access. If you do define a virtual template, however, it is used instead of the VLAN.

 [bookmark: pgfId-531540]Note Deployment might fail if PPP is defined on the virtual template defined here. See PPP Dialog Box.

  
       

 
        
        		[bookmark: pgfId-531546]Interface

  
        		[bookmark: pgfId-531548]The trusted, physical interface that provides VPN access to authenticated traffic. Enter the name of an interface or interface role, or click Select to select one from a list or to create a new group object.

 [bookmark: pgfId-531553]If you use an interface role, the pattern defined in the interface role must represent only one physical interface on the selected device. This interface should be the internal protected interface that you configured as part of the VPN topology. For more information, see Defining the Endpoints and Protected Networks.

  
       

 
        
        		[bookmark: pgfId-531559]Number of retries

  
        		[bookmark: pgfId-531561]The number of times the physical interface resends an Extensible Authentication Protocol (EAP) request/identity frame to a client if a response is not received before restarting authentication.

 [bookmark: pgfId-531563]Valid values range from 1 to 10. The default is 2.

 [bookmark: pgfId-531565]Note You should change the default only to adjust for unusual circumstances, such as unreliable links or specific problems with certain clients and authentication servers.

  
       

 
        
        		[bookmark: pgfId-531571]Control type

  
        		[bookmark: pgfId-531573]The control state of the interface, which determines whether the host is granted access to the network. Options are:

 
          
          		 [bookmark: pgfId-531575]Force Authorize—Disables 802.1x authentication and causes the interface to move to the authorized state without requiring any authentication exchange. This means the interface transmits and receives normal traffic without 802.1x-based authentication of the host. This is the default.

 
          		 [bookmark: pgfId-531577]Auto—Enables 802.1x authentication and causes the interface to begin in the unauthorized state, allowing only EAPOL frames to be sent and received through the interface. If a host is successfully authenticated, the interface state changes to authorized, which enables all frames from the host through the interface.

 
         

  
       

 
        
        		[bookmark: pgfId-531583]Enable client reauthentication

  
        		[bookmark: pgfId-531585]When selected, enables periodic reauthentication of client PCs on the 802.1x interface. Reauthentication is performed after the interval defined in the Client reauthentication period timeout field. The default period is 3600 seconds (1 hour).

 [bookmark: pgfId-531587]When deselected, periodic reauthentication is not performed.

  
       

 
        
        		[bookmark: pgfId-531593]Client reauthentication period timeout

  
        		[bookmark: pgfId-531595]Applies only when the Enable client reauthentication check box is selected.

 [bookmark: pgfId-531597]The number of seconds between client reauthentication attempts. Valid values range from 1 to 65535 seconds. The default is 3600 seconds (1 hour).

  
       

 
        
        		[bookmark: pgfId-531603]Quiet period

  
        		[bookmark: pgfId-531605]The amount of time the router remains in a quiet state after a failed authentication exchange with the client. Authentication exchanges might fail, for example, because the client provided an invalid password.

 [bookmark: pgfId-531607]Valid values range from 1 to 65535 seconds. The default is 120 seconds.

 [bookmark: pgfId-531609]Note Entering a value smaller than the default provides a faster response time to the user.

  
       

 
        
        		[bookmark: pgfId-531615]Rate Limit period

  
        		[bookmark: pgfId-531617]The interval after which the interface throttles the EAP-Start packets it receives from malfunctioning client PCs. Use this setting, called rate limiting, to prevent these clients from wasting router processing power.

 [bookmark: pgfId-531619]Valid values range from 1 to 65535 seconds. By default, rate limiting is disabled.

 [bookmark: pgfId-531621]Note To disable an existing rate limit, delete the value defined in this field and leave the field blank.

  
       

 
        
        		[bookmark: pgfId-531627]AAA Server timeout

  
        		[bookmark: pgfId-531629]The number of seconds the router waits before retransmitting packets to the AAA server. If the router sends an 802.1x packet to the AAA server and the server does not respond, the router sends another packet after this interval elapses.

 [bookmark: pgfId-531631]Valid values range from 1 to 65535 seconds. The default is 30 seconds.

  
       

 
        
        		[bookmark: pgfId-531637]Supplicant period

  
        		[bookmark: pgfId-531639]The number of seconds the router waits before retransmitting EAP-Request/Identity packets to the supplicant (client PC). If the router sends an EAP-Request/Identity packet to the client PC (supplicant) and the supplicant does not respond, the router sends the packet again after this interval elapses.

 [bookmark: pgfId-531641]Valid values range from 1 to 65535 seconds. The default is 30 seconds.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-533147][bookmark: 144724][bookmark: rtchap_cncpt_NetworkAdmissionControlonCiscoIOSRouters]Network Admission Control on Cisco IOS Routers[bookmark: marker-533141][bookmark: marker-533143][bookmark: marker-533145]

 
    [bookmark: pgfId-533149]Network Admission Control (NAC), an industry initiative sponsored by Cisco Systems, uses the network infrastructure to enforce security-policy compliance on all devices seeking to access network computing resources, thereby limiting damage from viruses and worms. By using NAC, organizations can provide network access to endpoint devices such as PCs, PDAs, and servers that are verified to be fully compliant with established security policy. NAC can also identify noncompliant devices and deny them access, place them in a quarantined area, or give them restricted access to computing resources.

 
    [bookmark: pgfId-533151]Network access decisions are made through a process of posture validation, which evaluates the posture credentials presented by the endpoint device. These credentials can include such information as the endpoint’s antivirus state, operating system version, operating system patch level, or Cisco Security Agent version and settings.

 
    [bookmark: pgfId-533153]You can use NAC to enforce security policy compliance in many types of deployments, including branch offices, remote access, and dial-in access.

 
    [bookmark: pgfId-533155]NAC policies in Security Manager enable a Cisco IOS router to act as a Network Access Device (NAD) for enforcing policy compliance on devices seeking to access the network. The following topics describe additional details about NAC:

 
     
     		 [bookmark: pgfId-533160]Understanding NAC Components

 
     		 [bookmark: pgfId-533165]Understanding NAC System Flow

 
    

 
    [bookmark: pgfId-533167]The following topics describe the tasks you perform to create NAC policies on Cisco IOS routers:

 
     
     		 [bookmark: pgfId-533172]Defining NAC Setup Parameters

 
     		 [bookmark: pgfId-533177]Defining NAC Interface Parameters

 
     		 [bookmark: pgfId-533182]Defining NAC Identity Parameters

 
    

 
     
      [bookmark: pgfId-533190][bookmark: 144758][bookmark: rtchap_cncpt_RouterPlatformsSupportingNAC]Router Platforms Supporting NAC[bookmark: marker-533188]

 
     [bookmark: pgfId-533192]To configure NAC policies on a router, the router must be running Cisco IOS Software Release 12.3(8)T images and higher (with the Advanced Security feature set). However, the following routers do not support NAC:

 
      
      		 [bookmark: pgfId-533194]Cisco 7600 Series (7603, 7604, 7606, 7609, 7613)

 
      		 [bookmark: pgfId-533196]Cisco 7300 Series (7301, 7304)

 
      		 [bookmark: pgfId-533198]Cisco 7100 Series VPN Routers (7120, 7140, 7160)

 
      		 [bookmark: pgfId-533200]Cisco 3600 Series Multiservice Platforms (3620, 3631, 3661, 3662)

 
      		 [bookmark: pgfId-533202]Cisco 1700 Series Modular Access Routers (1710, 1720, 1750)

 
      		 [bookmark: pgfId-533204]Cisco 1600 Series (1601, 1602, 1603, 1604, 1605)

 
      		 [bookmark: pgfId-533206]Cisco ASR 1000 Series Aggregation Services Routers (all models)

 
      		 [bookmark: pgfId-533208]Cisco 800 Series (801, 803, 805, 811, 813, 828, 851, 857, 871, 876, 877, 878)

 
      		 [bookmark: pgfId-533210]Cisco SOHO 90 Series Secure Broadband Routers (91, 96, 97)

 
      		 [bookmark: pgfId-533212]Cisco SOHO 77 Series (71, 76, 77 ADSL, 77 H ADSL, 78)

 
     

 
    
 
     
      [bookmark: pgfId-533220][bookmark: 144786][bookmark: rtchap_cncpt_UnderstandingNACComponents]Understanding NAC Components[bookmark: marker-533218]

 
     [bookmark: pgfId-533222]NAC contains the following components:

 
      
      		 [bookmark: pgfId-533228][bookmark: marker-533224][bookmark: marker-533226] Cisco Trust Agent (CTA)—The CTA acts as the NAC client. It provides posture credentials for the endpoint device on which it is installed, including the type of operating system and the version of antivirus software installed.

 
      		 [bookmark: pgfId-533234][bookmark: marker-533230][bookmark: marker-533232] Network access device (NAD)—The NAD initiates posture validation with the CTA when its Intercept ACL is triggered. It relays posture credentials received from the CTA to a AAA server. In return, the NAD receives configuration information from the AAA server, which it enforces on the selected interface. The NAD also:

 
     

 
     [bookmark: pgfId-533236] – Periodically polls the CTA to confirm that it is communicating with the same client at this IP address.

 
     [bookmark: pgfId-533238] – Revalidates all current sessions.

 
     [bookmark: pgfId-533240] – Sends username and password information from devices lacking a CTA (clientless hosts) to the AAA server for authentication.

 
     [bookmark: pgfId-533242] – Supports an exception list of predefined actions applied to specific devices, based on the device IP address or MAC address.

 
     [bookmark: pgfId-533244]When you configure NAC policies in Security Manager, you are configuring the behavior of the Cisco IOS router acting as the NAD.

 
      
      		 [bookmark: pgfId-533246]AAA server—The AAA server obtains and validates posture credentials received from the CTA and returns the access policy to be enforced on the NAD. The AAA server must be a Cisco Secure Access Control Server (ACS), running the RADIUS protocol. Existing ACS authorization support can be used to provide access to clientless hosts. Posture validation rules and the access policies resulting from those rules are configured on the ACS.

 
     

 
     [bookmark: pgfId-533248]Related Topics

 
      
      		 [bookmark: pgfId-533253]Understanding NAC System Flow

 
      		 [bookmark: pgfId-533258]Network Admission Control on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-533266][bookmark: 144830][bookmark: rtchap_cncpt_UnderstandingNACSystemFlow]Understanding NAC System Flow[bookmark: marker-533264]

 
     [bookmark: pgfId-533271]As shown in Figure 63-2, the system flow for NAC is:

 
     [bookmark: pgfId-533273] 1. An IP packet from a connecting device triggers the Intercept ACL configured on the NAD.

 
     [bookmark: pgfId-533275] 2. The NAD triggers posture validation with the CTA configured on the device using the Extensible Authentication Protocol over User Datagram Protocol, otherwise known as EAP over UDP, or simply EoU.

 
     [bookmark: pgfId-533277] 3. The CTA sends its posture credentials to the NAD using EAP over UDP.

 
     [bookmark: pgfId-533279] 4. The NAD sends these posture credentials to the ACS using RADIUS.

 
     [bookmark: pgfId-533281] 5. The ACS performs posture validation, which determines whether to allow the device to access the network. (If necessary, the ACS requests additional posture validation from a third-party server. For example, if the CTA forwards credentials that are specific to a particular antivirus application, the ACS forwards this information via the HCAP protocol to a vendor server for validation.) If the device is a clientless host, the ACS checks the username and password it receives against its locally stored list.

 
     [bookmark: pgfId-533283] 6. The ACS directs the NAD to enforce the appropriate access policy on the requesting device. Access may be granted, denied, redirected, or restricted.

 
     [bookmark: pgfId-533287]Figure 63-2 [bookmark: 144850]NAC System Flow

 
     [bookmark: pgfId-533290] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-533292]Related Topics

 
      
      		 [bookmark: pgfId-533297]Understanding NAC Components

 
      		 [bookmark: pgfId-533302]Network Admission Control on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-533310][bookmark: 144863][bookmark: rtchap_proc_DefiningNACSetupParameters]Defining NAC Setup Parameters[bookmark: marker-533308]

 
     [bookmark: pgfId-533312]You configure NAC setup parameters by selecting the AAA server groups that obtain and validate the posture credentials received from devices trying to connect to the network. You can configure an option that allows devices lacking the Cisco Trust Agent (CTA) to be authenticated by a predefined username and password stored on a Cisco Secure Access Control Server (ACS). Additionally, you can modify default settings for EAP over UDP. This is the protocol used for posture validation communications between the Cisco IOS router serving as the network access device (NAD) and the device trying to access your network.

 
     [bookmark: pgfId-533314]Related Topics

 
      
      		 [bookmark: pgfId-533319]Defining NAC Interface Parameters

 
      		 [bookmark: pgfId-533324]Defining NAC Identity Parameters

 
      		 [bookmark: pgfId-533329]Network Admission Control on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-533331]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-533333](Device view) Select  Platform > Identity > Network Admission Control from the Policy selector, then click the  Setup tab in the work area.

 
      		 [bookmark: pgfId-533335](Policy view) Select  Router Platform > Identity > Network Admission Control from the Policy Type selector. Select an existing policy or create a new one, and then click the  Setup tab.

 
     

 
     [bookmark: pgfId-533340]The NAC Setup tab is displayed. See Table 63-2 for a description of the fields on this tab.

 
     [bookmark: pgfId-533342]Step 2 Enter the name of the AAA server group containing the AAA server that performs posture validation, or click Select to select the server group from a list or to create a new one. The selected AAA server group must contain ACS devices running RADIUS.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-533344]Note Each AAA server in the selected group must be configured to communicate with an interface that exists on the router; otherwise, validation fails.


     
      

     

     

 
     [bookmark: pgfId-533346]Step 3 (Optional) Select up to two AAA server groups as backups to the main server group. If all the servers in the main server group go down, the servers in the backup server group perform NAC.

 
     [bookmark: pgfId-533348]Both backup server groups must consist of ACS devices running RADIUS.

 
     [bookmark: pgfId-533350]Step 4 (Optional) Under EAP over UDP, select one or both of the following Allow parameters:

 
     [bookmark: pgfId-533352] a. Select the Allow IP Station ID check box to include IP addresses in the RADIUS requests sent to the ACS.

 
     [bookmark: pgfId-533354] b. Select the Allow Clientless check box to provide access to devices that do not have the CTA installed. In such cases, the ACS authenticates these devices by checking the username and password against a predefined list.

 
     [bookmark: pgfId-533356]If you do not select this check box, devices without CTA are prevented from accessing the network if their traffic matches the Intercept ACL. This is because without CTA, posture validation cannot be performed.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-533358]Note This feature is not supported on routers running Cisco IOS Software Release 12.4(6)T or later.


     
      

     

     

 
     [bookmark: pgfId-533363]Step 5 (Optional) Under EAP over UDP, modify the default settings related to the EAP over UDP (EoU) protocol, if required. See Table 63-2 for details.

 
     [bookmark: pgfId-533365]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-533373][bookmark: 144919][bookmark: rtchap_proc_DefiningNACInterfaceParameters]Defining NAC Interface Parameters[bookmark: marker-533371]

 
     [bookmark: pgfId-533378]You configure NAC interface parameters by selecting the interfaces on which NAC is performed. You must also define the Intercept ACL, which determines which traffic on these interfaces is subject to posture validation. Additionally, you can optionally override the device-level setting for initiating EAP over UDP sessions and subject all sessions to periodic revalidation (see Defining NAC Setup Parameters).

 
     [bookmark: pgfId-533380]A NAC policy must include at least one interface definition to function.

 
     [bookmark: pgfId-533382]Before You Begin

 
      
      		 [bookmark: pgfId-533387]Select the AAA server group containing the ACS device performing posture validation. See Defining NAC Setup Parameters.

 
      		 [bookmark: pgfId-533392]Define an ACL object that defines the traffic to subject to posture validation in NAC policies. See Creating Access Control List Objects.

 
      		 [bookmark: pgfId-533397]Define an ACL object that defines the default access on the selected interface (default ACL). See Creating Access Control List Objects.

 
     

 
     [bookmark: pgfId-533399]Related Topics

 
      
      		 [bookmark: pgfId-533404]Defining NAC Setup Parameters

 
      		 [bookmark: pgfId-533409]Defining NAC Identity Parameters

 
      		 [bookmark: pgfId-533414]Network Admission Control on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-533416]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-533418](Device view) Select  Platform > Identity > Network Admission Control from the Policy selector, then click the  Interfaces tab in the work area.

 
      		 [bookmark: pgfId-533420](Policy view) Select  Router Platform > Identity > Network Admission Control from the Policy Type selector. Select an existing policy or create a new one, and then click the  Interfaces tab.

 
     

 
     [bookmark: pgfId-533425]The NAC Interfaces tab is displayed. See Table 63-3 for a description of the fields on this tab.

 
     [bookmark: pgfId-533430]Step 2 On the NAC Interfaces tab, select an interface definition from the table, then click Edit, or click Add to create a definition. The NAC Interface Configuration dialog box appears. See Table 63-4 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-533435]Step 3 Enter the name of the interface or interface role on which NAC is performed, or click Select to select an interface role from a list or to create a new one. For more information, see Specifying Interfaces During Policy Definition.

 
     [bookmark: pgfId-533437]Step 4 (Optional) Enter the name of the ACL object that acts as the intercept ACL, or click Select to select it from a list or to create a new object.

 
     [bookmark: pgfId-533439]The intercept ACL determines which traffic on the selected interfaces is subject to posture validation before being granted access to the network. If you do not select an ACL, all traffic on the selected interfaces is subject to posture validation.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-533444]Note If you defined an authentication proxy on the same interface as a NAC interface, you must use the same intercept ACL in both policies. Otherwise, deployment might fail. For more information about authentication proxies, see Configuring AAA Rules for IOS Devices.


     
      

     

     

 
     [bookmark: pgfId-533448]Step 5 [bookmark: 144980](Optional) To override the device-level value defined for maximum attempts to initiate an EAP over UDP session, enter a new value in the EAP over UDP Max Retries field.

 
     [bookmark: pgfId-533452]Step 6 [bookmark: 144982](Optional) Deselect the Enable EOU Session Revalidation check box if you do not want the NAD to periodically revalidate all EAP over UDP sessions.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-533460]Note Subinterfaces support default values only for the options described in Step 5 and Step 6.


     
      

     

     

 
     [bookmark: pgfId-533462]Step 7 Click OK to save your definitions locally on the client and close the dialog box. Your interface definitions appear in the table on the NAC Interfaces tab.

 
     [bookmark: pgfId-533464]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-533472][bookmark: 144994][bookmark: rtchap_proc_DefiningNACIdentityParameters]Defining NAC Identity Parameters[bookmark: marker-533470]

 
     [bookmark: pgfId-533474]By default, any traffic over the selected interfaces that match the intercept ACL is subjected to posture validation before it is permitted to enter the network. However, you can create an exception list of predefined actions to apply to specific devices. You use identity profiles to create this exception list. Each profile contains two elements:

 
      
      		 [bookmark: pgfId-533476]A profile definition, identifies the device to which the profile applies. Devices can be identified by their IP addresses, MAC addresses, or types (for Cisco IP phones).

 
      		 [bookmark: pgfId-533478]An action, which defines the result when this device tries to access the network. Each action can include an ACL, a redirect URL, or both. If you do not specify an action, the default ACL is applied.

 
     

 
     [bookmark: pgfId-533480]When you configure NAC identity parameters, you first define one or more identity actions and then create the identity profiles to which these actions apply. You can apply each action to multiple profiles.

 
     [bookmark: pgfId-533482]Related Topics

 
      
      		 [bookmark: pgfId-533487]Defining NAC Setup Parameters

 
      		 [bookmark: pgfId-533492]Defining NAC Interface Parameters

 
      		 [bookmark: pgfId-533497]Network Admission Control on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-533499]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-533501](Device view) Select  Platform > Identity > Network Admission Control from the Policy selector, then click the  Identities tab in the work area.

 
      		 [bookmark: pgfId-533503](Policy view) Select  Router Platform > Identity > Network Admission Control from the Policy Type selector. Select an existing policy or create a new one, and then click the  Identities tab.

 
     

 
     [bookmark: pgfId-533508]The NAC Identities tab is displayed. See Table 63-5 for a description of the fields on this tab.

 
     [bookmark: pgfId-533512]Step 2 [bookmark: 145032]Define one or more identity actions:

 
     [bookmark: pgfId-533516] a. [bookmark: 145033]On the NAC Identities tab, select an identity action from the lower table, then click Add. The NAC Identity Action dialog box appears.

 
     [bookmark: pgfId-533521] b. Define an identity action. See Table 63-7 for a description of the available fields.

 
     [bookmark: pgfId-533525] c. [bookmark: 145039]Click OK to save your definitions and close the dialog box. The action appears in the Identity Actions table in the NAC Identities tab.

 
     [bookmark: pgfId-533533] d. (Optional) Repeat a.through c. to define additional identity actions, as required.

 
     [bookmark: pgfId-533535]Step 3 Define identity profiles:

 
     [bookmark: pgfId-533542] a. [bookmark: 145049]Select an identity profile from the upper table on the NAC Identities tab, then click Add. The NAC Identity Profile dialog box appears. See Table 63-6 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-533547] b. Enter the name of an identity action (as defined in Step 2) or click Select to display a selector.

 
     [bookmark: pgfId-533549] c. Select and define a profile definition, which identifies the device to which the profile should apply.

 
     [bookmark: pgfId-533553] d. [bookmark: 145059]Click OK to save your definitions and close the dialog box. The profile appears in the Identity Profiles table in the NAC Identities tab.

 
     [bookmark: pgfId-533561] e. (Optional) Repeat a. through d. to define additional identity profiles, as required.

 
     [bookmark: pgfId-533563]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-533575][bookmark: 145072][bookmark: rtpage_cncpt_NetworkAdmissionControlPolicyPage]Network Admission Control Policy Page[bookmark: marker-533571][bookmark: marker-533573]

 
    [bookmark: pgfId-533577]Network Admission Control (NAC) policies enable Cisco IOS routers acting as network access devices (NADs) to enforce access privileges when an endpoint tries to connect to a network. Access decisions are made on the basis of information provided by the endpoint device, such as its current antivirus state, thus keeping insecure nodes from infecting the network.

 
    [bookmark: pgfId-533579]You can configure NAC policies on a Cisco IOS router from the following tabs on the Network Admission Control policy page:

 
     
     		 [bookmark: pgfId-533584]Network Admission Control Page—Setup Tab

 
     		 [bookmark: pgfId-533589]Network Admission Control Page—Interfaces Tab

 
     		 [bookmark: pgfId-533594]Network Admission Control Page—Identities Tab

 
    

 
    [bookmark: pgfId-533599]For more information, see Network Admission Control on Cisco IOS Routers.

 
    [bookmark: pgfId-533601]Navigation Path

 
     
     		 [bookmark: pgfId-533603](Device view) Select  Platform > Identity > Network Admission Control from the Policy selector.

 
     		 [bookmark: pgfId-533605](Policy view) Select  Router Platform > Identity > Network Admission Control from the Policy Type selector. Right-click  Network Admission Control to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
     
      [bookmark: pgfId-533617][bookmark: 145106][bookmark: rtpage_cncpt_NetworkAdmissionControlPageSetupTab]Network Admission Control Page—Setup Tab[bookmark: marker-533613][bookmark: marker-533615]

 
     [bookmark: pgfId-533619]Use the Network Admission Control Setup tab to select the Cisco Secure Access Control Servers used for authentication during the NAC process, as well as to define the EAP over UDP settings for communications between the NAD and the client seeking access to the network.

 
     [bookmark: pgfId-533621]Navigation Path

 
     [bookmark: pgfId-533626]Go to the Network Admission Control Policy Page, then click the Setup tab.

 
     [bookmark: pgfId-533628]Related Topics

 
      
      		 [bookmark: pgfId-533633]Defining NAC Setup Parameters

 
      		 [bookmark: pgfId-533638]Network Admission Control Page—Interfaces Tab

 
      		 [bookmark: pgfId-533643]Network Admission Control Page—Identities Tab

 
      		 [bookmark: pgfId-533648]Understanding AAA Server and Server Group Objects

 
     

 
     [bookmark: pgfId-533650]Field Reference

 
     [bookmark: pgfId-533653] 

 
      
       
        
        [bookmark: pgfId-531654]Table 63-2 [bookmark: 145140]Network Admission Control Setup Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-531660]Element
          
  
         		
           
           [bookmark: pgfId-531662]Description
          
  
        

 
         
         		[bookmark: pgfId-531668]AAA Server Group

  
         		[bookmark: pgfId-531670]The AAA server group used for NAC authentication. You must select a server group consisting of Cisco Secure Access Control Server (ACS) devices running the RADIUS protocol. Enter the name of a AAA server group object, or click Select to select the object from a list or to create a new one.

 [bookmark: pgfId-531672]Note Each AAA server in the selected group must be configured to communicate with an interface that exists on the router; otherwise, validation fails.

  
        

 
         
         		[bookmark: pgfId-531678]Backup AAA Server Group 1

  
         		[bookmark: pgfId-531680]The backup AAA server group in case the AAA servers in the main group are down.

  
        

 
         
         		[bookmark: pgfId-531686]Backup AAA Server Group 2

  
         		[bookmark: pgfId-531688]The secondary backup AAA server group in case the AAA servers in the main group and the first backup group are down.

  
        

 
         
         		 [bookmark: pgfId-531694]EAP over UDP (EoU) settings

  
        

 
         
         		[bookmark: pgfId-531702]Allow IP Station ID

  
         		[bookmark: pgfId-531704]When selected, enables an IP address to be included in the calling-station-id field of RADIUS requests sent to the ACS.

 [bookmark: pgfId-531706]When deselected, IP addresses are not included in the calling-station-id field of RADIUS requests sent to the ACS.

  
        

 
         
         		[bookmark: pgfId-531712]Allow Clientless

  
         		[bookmark: pgfId-531714]When selected, enables devices that do not have the Cisco Trust Agent (CTA) installed to be authenticated through the use of a username and password configured on the ACS.

 [bookmark: pgfId-531716]If you select this check box, enter the username and password (including confirmation) in the fields provided.

 [bookmark: pgfId-531721]When deselected, NAC prevents devices lacking the CTA from accessing the network, if their traffic matches the intercept ACL (see NAC Interface Configuration Dialog Box).

 [bookmark: pgfId-531723]Note This feature is not supported on routers running Cisco IOS Software Release 12.4(6)T or later.

  
        

 
         
         		[bookmark: pgfId-531729]Max Retry

  
         		[bookmark: pgfId-531731]The maximum number of retries that all NAC interfaces on this router should make when initiating an EAP over UDP session with a connecting device.

 [bookmark: pgfId-531733]Valid values range from 1 to 3. The default is 3.

 [bookmark: pgfId-531738]Note You can override this global value on a specific interface, if required. See Network Admission Control Page—Interfaces Tab.

  
        

 
         
         		[bookmark: pgfId-531744]Rate Limit

  
         		[bookmark: pgfId-531746]The number of EAP over UDP posture validations that the router can handle simultaneously. Additional devices cannot be validated until one or more devices drop off.

 [bookmark: pgfId-531748]Valid values range from 1 to 200. The default is 20. If you set this value to 0, rate limiting is turned off.

  
        

 
         
         		[bookmark: pgfId-531754]Port

  
         		[bookmark: pgfId-531756]The UDP port to use for EAP over UDP sessions.

 [bookmark: pgfId-531758]Valid values range from 1 to 65535. The default is 21862.

 [bookmark: pgfId-531763]Note For NAC to work, the default ACL on this router must permit UDP traffic over the port designated here for EAP over UDP traffic. For more information, see Chapter 16, “Managing Firewall Access Rules”.

  
        

 
         
         		[bookmark: pgfId-531769]Enable Logging

  
         		[bookmark: pgfId-531771]When selected, EAP over UDP events on this router are logged to the device.

 [bookmark: pgfId-531773]When deselected, EAP over UDP logging is disabled. This is the default.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-533665][bookmark: 145215][bookmark: rtpage_cncpt_NetworkAdmissionControlPageInterfacesTab]Network Admission Control Page—Interfaces Tab[bookmark: marker-533661][bookmark: marker-533663]

 
     [bookmark: pgfId-533667]Use the Network Admission Control Interfaces tab to select and configure the router interfaces on which to perform NAC. This includes configuring the Intercept ACL and selected EoU interface parameters. A NAC policy must include at least one interface definition in order to function.

 
     [bookmark: pgfId-533669]Navigation Path

 
     [bookmark: pgfId-533674]Go to the Network Admission Control Policy Page, then click the Interfaces tab.

 
     [bookmark: pgfId-533676]Related Topics

 
      
      		 [bookmark: pgfId-533681]Defining NAC Interface Parameters

 
      		 [bookmark: pgfId-533686]Network Admission Control Page—Setup Tab

 
      		 [bookmark: pgfId-533691]Network Admission Control Page—Identities Tab

 
      		 [bookmark: pgfId-533696]Table Columns and Column Heading Features

 
      		 [bookmark: pgfId-533701]Filtering Tables

 
     

 
     [bookmark: pgfId-533703]Field Reference

 
     [bookmark: pgfId-533706] 

 
      
       
        
        [bookmark: pgfId-531786]Table 63-3 [bookmark: 145252]Network Admission Control Interfaces Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-531792]Element
          
  
         		
           
           [bookmark: pgfId-531794]Description
          
  
        

 
         
         		[bookmark: pgfId-531800]Interfaces

  
         		[bookmark: pgfId-531802]The name of the interface on which NAC is being performed.

  
        

 
         
         		[bookmark: pgfId-531808]Intercept ACL

  
         		[bookmark: pgfId-531810]The name of the Intercept ACL, which determines the incoming traffic that triggers the interface to make a posture validation check.

  
        

 
         
         		[bookmark: pgfId-531816]EoU Max Retries

  
         		[bookmark: pgfId-531818]The maximum number of retries that this interface should perform when it initializes an EoU session with a connecting device.

  
        

 
         
         		[bookmark: pgfId-531824]Revalidate

  
         		[bookmark: pgfId-531826]Indicates whether the interface revalidates its EoU sessions to make sure they are still active.

  
        

 
         
         		[bookmark: pgfId-531832]Add button

  
         		[bookmark: pgfId-531837]Opens the NAC Interface Configuration Dialog Box. From here you can define a NAC interface.

  
        

 
         
         		[bookmark: pgfId-531843]Edit button

  
         		[bookmark: pgfId-531848]Opens the NAC Interface Configuration Dialog Box. From here you can edit the selected NAC interface.

  
        

 
         
         		[bookmark: pgfId-531854]Delete button

  
         		[bookmark: pgfId-531856]Deletes the selected NAC interfaces from the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-533718][bookmark: 145299][bookmark: rtpage_cncpt_NACInterfaceConfigurationDialogBox]NAC Interface Configuration Dialog Box[bookmark: marker-533714][bookmark: marker-533716]

 
     [bookmark: pgfId-533720]Use the NAC Interface Configuration dialog box to add or edit the router interfaces on which NAC is being performed.

 
     [bookmark: pgfId-533722]Navigation Path

 
     [bookmark: pgfId-533727]Go to the Network Admission Control Page—Interfaces Tab, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-533729]Related Topics

 
      
      		 [bookmark: pgfId-533734]Defining NAC Interface Parameters

 
      		 [bookmark: pgfId-533739]Basic Interface Settings on Cisco IOS Routers

 
      		 [bookmark: pgfId-533744]Creating Interface Role Objects

 
      		 [bookmark: pgfId-533749]Creating Access Control List Objects

 
     

 
     [bookmark: pgfId-533751]Field Reference

 
     [bookmark: pgfId-533754] 

 
      
       
        
        [bookmark: pgfId-531869]Table 63-4 [bookmark: 145334]NAC Interface Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-531875]Element
          
  
         		
           
           [bookmark: pgfId-531877]Description
          
  
        

 
         
         		[bookmark: pgfId-531883]Interface

  
         		[bookmark: pgfId-531885]The interface that will perform NAC on connecting devices. Enter the name of an interface or interface role, or click Select to select an object from a list or to create a new one.

  
        

 
         
         		[bookmark: pgfId-531891]Intercept ACL

  
         		[bookmark: pgfId-531893]The ACL that defines the traffic requiring posture validation. Enter the name of an ACL object, or click Add to select an object from a list or to create a new one.

 [bookmark: pgfId-531898]Note If an authentication proxy is configured on the same interface as NAC, the same Intercept ACL must be used in both policies. Otherwise, deployment may fail. For more information about authentication proxies, see Configuring AAA Rules for IOS Devices.

  
        

 
         
         		[bookmark: pgfId-531904]EAP over UDP Max Retries

  
         		[bookmark: pgfId-531906]The maximum number of times that the router should try to initiate an EoU session with a connecting device. Valid values range from 1 to 3. The default is 3.

 [bookmark: pgfId-531908]Note Subinterfaces support the default value only.

  
        

 
         
         		[bookmark: pgfId-531914]Enable EoU Session Revalidation

  
         		[bookmark: pgfId-531916]When selected, the router revalidates its EoU sessions as required. This is the default.

 [bookmark: pgfId-531918]When deselected, EoU session revalidation is not performed.

 [bookmark: pgfId-531920]Note Subinterfaces support the default value only.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-533766][bookmark: 145373][bookmark: rtpage_cncpt_NetworkAdmissionControlPageIdentitiesTab]Network Admission Control Page—Identities Tab[bookmark: marker-533762][bookmark: marker-533764]

 
     [bookmark: pgfId-533768]Use the Network Admission Control Identities tab to view, create, edit, and delete NAC identity profiles and identity actions. Identity profiles define a specific action to perform on traffic received from selected devices, as identified by their IP address, MAC address, or device type. In this way, devices with identity profiles are handled by NAC without having to undergo posture validation against an ACS.

 
     [bookmark: pgfId-533770]Navigation Path

 
     [bookmark: pgfId-533775]Go to the Network Admission Control Policy Page, then click the Interfaces tab.

 
     [bookmark: pgfId-533777]Related Topics

 
      
      		 [bookmark: pgfId-533782]Defining NAC Identity Parameters

 
      		 [bookmark: pgfId-533787]Network Admission Control Page—Setup Tab

 
      		 [bookmark: pgfId-533792]Network Admission Control Page—Interfaces Tab

 
      		 [bookmark: pgfId-533797]Table Columns and Column Heading Features

 
      		 [bookmark: pgfId-533802]Filtering Tables

 
     

 
     [bookmark: pgfId-533804]Field Reference

 
     [bookmark: pgfId-533807] 

 
      
       
        
        [bookmark: pgfId-531933]Table 63-5 [bookmark: 145410]Network Admission Control Identities Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-531939]Element
          
  
         		
           
           [bookmark: pgfId-531941]Description
          
  
        

 
         
         		 [bookmark: pgfId-531947]Identity Profiles Table

  
        

 
         
         		[bookmark: pgfId-531955]Profile Definition

  
         		[bookmark: pgfId-531957]The type of identity profile—device IP address, MAC address, or device type (IP phone).

  
        

 
         
         		[bookmark: pgfId-531963]Action Name

  
         		[bookmark: pgfId-531965]The name of the action (defined in the Identity Actions table) that is assigned to this NAC identity profile.

  
        

 
         
         		[bookmark: pgfId-531971]Add button

  
         		[bookmark: pgfId-531976]Opens the NAC Identity Profile Dialog Box. From here you can define an identity profile.

  
        

 
         
         		[bookmark: pgfId-531982]Edit button

  
         		[bookmark: pgfId-531987]Opens the NAC Identity Profile Dialog Box. From here you can edit a selected identity profile.

  
        

 
         
         		[bookmark: pgfId-531993]Delete button

  
         		[bookmark: pgfId-531995]Deletes the selected identity profiles from the table.

  
        

 
         
         		 [bookmark: pgfId-532001]Identity Actions Table

  
        

 
         
         		[bookmark: pgfId-532009]Action Name

  
         		[bookmark: pgfId-532011]The name of the identity action.

  
        

 
         
         		[bookmark: pgfId-532017]ACL

  
         		[bookmark: pgfId-532019]The ACL applied to profiles to which this identity action is assigned.

  
        

 
         
         		[bookmark: pgfId-532025]Redirect URL

  
         		[bookmark: pgfId-532027]The URL to which traffic from devices to which this identity action is assigned are redirected.

  
        

 
         
         		[bookmark: pgfId-532033]Add button

  
         		[bookmark: pgfId-532038]Opens the NAC Identity Action Dialog Box for defining a NAC identity action.

  
        

 
         
         		[bookmark: pgfId-532044]Edit button

  
         		[bookmark: pgfId-532049]Opens the NAC Identity Action Dialog Box for editing a selected NAC identity action.

  
        

 
         
         		[bookmark: pgfId-532055]Delete button

  
         		[bookmark: pgfId-532057]Deletes the selected identity actions from the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-533819][bookmark: 145487][bookmark: rtpage_cncpt_NACIdentityProfileDialogBox]NAC Identity Profile Dialog Box[bookmark: marker-533815][bookmark: marker-533817]

 
     [bookmark: pgfId-533821]Use the NAC Identity Profile dialog box to add or edit the NAC profiles assigned to devices that match a specific identity. Identity profiles define a NAC action to apply to all traffic coming from a specific device, based on its IP address, MAC address, or device type (for IP phones).

 
     [bookmark: pgfId-533823]Navigation Path

 
     [bookmark: pgfId-533828]Go to the Network Admission Control Page—Identities Tab, then click the Add or Edit button beneath the Identity Profiles table.

 
     [bookmark: pgfId-533830]Related Topics

 
      
      		 [bookmark: pgfId-533835]NAC Identity Action Dialog Box

 
      		 [bookmark: pgfId-533840]Defining NAC Identity Parameters

 
     

 
     [bookmark: pgfId-533842]Field Reference

 
     [bookmark: pgfId-533845] 

 
      
       
        
        [bookmark: pgfId-532070]Table 63-6 [bookmark: 145516]NAC Identity Profile Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-532076]Element
          
  
         		
           
           [bookmark: pgfId-532078]Description
          
  
        

 
         
         		[bookmark: pgfId-532084]Action Name

  
         		[bookmark: pgfId-532089]The name of the action to assign to the profile. Enter the name of an action, or click Select to display a selector. For more information about creating actions, see NAC Identity Action Dialog Box.

  
        

 
         
         		[bookmark: pgfId-532095]Profile Definition

  
         		[bookmark: pgfId-532097]The device to which this profile is assigned:

 
           
           		 [bookmark: pgfId-532099]IP Address—The IP address of the device to which this profile should be assigned. The same IP address cannot be used in more than one profile.

 
           		 [bookmark: pgfId-532101]MAC Address—The MAC address of the device to which this profile should be assigned.

 
           		 [bookmark: pgfId-532103]Cisco IP Phone—Used when defining a NAC identity profile for Cisco IP phones.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-533857][bookmark: 145546][bookmark: rtpage_cncpt_NACIdentityActionDialogBox]NAC Identity Action Dialog Box[bookmark: marker-533853][bookmark: marker-533855]

 
     [bookmark: pgfId-533859]Use the NAC Identity Action dialog box to add or edit the actions assigned to NAC identity profiles.

 
     [bookmark: pgfId-533861]Navigation Path

 
     [bookmark: pgfId-533866]Go to the Network Admission Control Page—Identities Tab, then click the Add or Edit button beneath the Identity Actions table.

 
     [bookmark: pgfId-533868]Related Topics

 
      
      		 [bookmark: pgfId-533873]NAC Identity Profile Dialog Box

 
      		 [bookmark: pgfId-533878]Defining NAC Identity Parameters

 
      		 [bookmark: pgfId-533883]Creating Access Control List Objects

 
     

 
     [bookmark: pgfId-533885]Field Reference

 
     [bookmark: pgfId-533888] 

 
      
       
        
        [bookmark: pgfId-532116]Table 63-7 [bookmark: 145578]NAC Identity Action Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-532122]Element
          
  
         		
           
           [bookmark: pgfId-532124]Description
          
  
        

 
         
         		[bookmark: pgfId-532130]Name

  
         		[bookmark: pgfId-532135]A descriptive name for the identity action. Use this name when you select an action to assign to a NAC identity profile. See NAC Identity Profile Dialog Box.

  
        

 
         
         		[bookmark: pgfId-532141]Access Control Lists

  
         		[bookmark: pgfId-532143]The ACL that defines how to handle traffic received from a device which is assigned a profile that includes this action. Enter the name of an ACL object, or click Add to select an object from a list or to create a new one.

 [bookmark: pgfId-532148]Note You cannot select the same ACL object that is being used for the intercept ACL. See NAC Interface Configuration Dialog Box.

  
        

 
         
         		[bookmark: pgfId-532154]Redirect URL

  
         		[bookmark: pgfId-532156]The address of the remediation server to which traffic from the device should be redirected. Redirect URLs are usually of the form http://URL or https://URL.
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     [bookmark: pgfId-362658][bookmark: 42574][bookmark: porules_cncpt_WorkingwithAccessRules]Managing Firewall Access Rules[bookmark: marker-362654][bookmark: marker-362656]
      
      
 
     
 

 
    [bookmark: pgfId-362660]Access rules define the rules that traffic must meet to pass through an interface. When you define rules for incoming traffic, they are applied to the traffic before any other policies are applied (with the exception of less common AAA rules). In that sense, they are your first line of defense.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-362665]Tip For some types of devices, you can configure IPv6 access rules in addition to IPv4 access rules. For information on supported device types, see IPv6 Support in Security Manager.


    
     

    

    

 
    [bookmark: pgfId-362667]The following topics help you understand and work with access rules:

 
     
     		 [bookmark: pgfId-362672]Understanding Access Rules

 
     		 [bookmark: pgfId-362677]Understanding Global Access Rules

 
     		 [bookmark: pgfId-362682]Understanding Device Specific Access Rule Behavior

 
     		 [bookmark: pgfId-362687]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
     		 [bookmark: pgfId-362692]Configuring Access Rules

 
     		 [bookmark: pgfId-362697]Configuring Expiration Dates for Access Rules

 
     		 [bookmark: pgfId-362702]Configuring Settings for Access Control

 
     		 [bookmark: pgfId-362707]Using Automatic Conflict Detection

 
     		 [bookmark: pgfId-362712]Viewing Hit Count Details

 
     		 [bookmark: pgfId-362717]Importing Rules

 
     		 [bookmark: pgfId-362722]Optimizing Access Rules Automatically During Deployment

 
    

 
    [bookmark: pgfId-362724]The following topics can help you with general rule table usage:

 
     
     		 [bookmark: pgfId-362729]Adding and Removing Rules

 
     		 [bookmark: pgfId-362734]Editing Rules

 
     		 [bookmark: pgfId-362739]Enabling and Disabling Rules

 
     		 [bookmark: pgfId-362744]Moving Rules and the Importance of Rule Order

 
    

 
   
 
    
     [bookmark: pgfId-362754][bookmark: 42635][bookmark: porules_cncpt_UnderstandingAccessRules]Understanding Access Rules[bookmark: marker-362750][bookmark: marker-362752]

 
    [bookmark: pgfId-362756]Access rules policies define the rules that allow or deny traffic to transit an interface. Typically, you create access rules for traffic entering an interface, because if you are going to deny specific types of packets, it is better to do it before the device spends a lot of time processing them.

 
    [bookmark: pgfId-362758]When you deploy access rules to devices, they become one or more entries (ACEs) to access control lists (ACLs) that are attached to interfaces. Typically, these rules are the first security policy applied to packets; they are your first line of defense. You use access rules to filter out undesired traffic based on service (protocol and port numbers) and source and destination addresses, either permitting the traffic or denying (dropping) it. Each packet that arrives at an interface is examined to determine whether to forward or drop the packet based on criteria you specify. If you define access rules in the out direction, packets are also analyzed before they are allowed to leave an interface.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-362763]Tip For ASA 8.3+ devices, you can augment interface-specific access rules with global access rules. For more information, see Understanding Global Access Rules.


    
     

    

    

 
    [bookmark: pgfId-362765]When you permit traffic in an access rule, subsequent policies might end up dropping it. For example, inspection rules, web filter rules, and zone-based firewall rules are applied after a packet makes it through the interface’s access rules. These subsequent rules might then drop the traffic based on a deeper analysis of the traffic; for example, the packet header might not meet your inspection requirements, or the URL for a web request might be for an undesired web site.

 
    [bookmark: pgfId-362767]Thus, you should carefully consider the other types of firewall rules you intend to create when you define access rules. Do not create a blanket denial in an access rule for traffic that you really want to inspect. On the other hand, if you know that you will never allow a service from or to a specific host or network, use an access rule to deny the traffic.

 
    [bookmark: pgfId-362775]Keep in mind that access rules are ordered. That is, when the device compares a packet against the rules, it searches from top to bottom and applies the policy for the first rule that matches it, and ignores all subsequent rules (even if a later rule is a better match). Thus, you should place specific rules above more general rules to ensure those rules are not ignored. To help you identify cases where IPv4 rules will never be matched, and to identify redundant rules, you can use the automatic conflict detection and policy query tools. For more information, see Using Automatic Conflict Detection and Generating Policy Query Reports.

 
    [bookmark: pgfId-362777]The following are additional ways in which you can evaluate your access rules:

 
     
     		 [bookmark: pgfId-362782]Combine rules—You can use a tool to evaluate your IPv4 rules and combine them into a smaller number of rules that perform the same functions. This can leave you with a smaller, easier to manage list of rules. For more information, see Combining Rules.

 
     		 [bookmark: pgfId-362787]Generate hit counts—You can use a tool to view the hit count statistics maintained by the device for IPv4 and IPv6 ACLs. This can tell you how often a rule has permitted or denied traffic. For more information, see Viewing Hit Count Details.

 
     		 [bookmark: pgfId-362792]View events collected by CS-MARS—You can analyze real time or historical events related to an IPv4 rule using the Cisco Security Monitoring, Analysis and Response System application if you configured it to monitor the device and you configure the rule to generate syslog messages. For more information, see Viewing CS-MARS Events for an Access Rule.

 
    

 
    [bookmark: pgfId-362794]For more conceptual information on access rules, see the following topics:

 
     
     		 [bookmark: pgfId-362799]Understanding Global Access Rules

 
     		 [bookmark: pgfId-362804]Understanding Device Specific Access Rule Behavior

 
     		 [bookmark: pgfId-362809]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
    

 
    [bookmark: pgfId-362811]Related Topics

 
     
     		 [bookmark: pgfId-362816]Configuring Access Rules

 
     		 [bookmark: pgfId-362821]Configuring Expiration Dates for Access Rules

 
     		 [bookmark: pgfId-362826]Configuring Settings for Access Control

 
     		 [bookmark: pgfId-362831]Expanding Object Groups During Discovery

 
     		 [bookmark: pgfId-362836]Importing Rules

 
     		 [bookmark: pgfId-362841]Adding and Removing Rules

 
     		 [bookmark: pgfId-362846]Editing Rules

 
     		 [bookmark: pgfId-362851]Enabling and Disabling Rules

 
     		 [bookmark: pgfId-362856]Moving Rules and the Importance of Rule Order

 
    

 
     
      [bookmark: pgfId-362872][bookmark: 42705][bookmark: porules_cncpt_UnderstandingGlobalAccessRules]Understanding Global Access Rules[bookmark: marker-362862][bookmark: marker-362864][bookmark: marker-362866][bookmark: marker-362868][bookmark: marker-362870]

 
     [bookmark: pgfId-362874]Traditionally, access rules (ACLs), which control which traffic can flow through a device, are applied to device interfaces. However, with ASA devices running software release 8.3+, you have the option to create global access rules for IPv4 and IPv6.

 
     [bookmark: pgfId-362876]Global access rules are defined as a special ACL that is processed for every interface on the device for traffic entering the interface. Thus, although the ACL is configured once on the device, it acts like a secondary interface-specific ACL defined for the In direction. (Global rules are always for the In direction, never the Out direction.)

 
     [bookmark: pgfId-362881]When traffic enters an interface on an ASA 8.3+ device, when applying ACLs, the device first applies any interface-specific access rules to the traffic. It then applies global rules. (Overall processing is explained in Understanding the Processing Order of Firewall Rules.)

 
     [bookmark: pgfId-362883]Global rules are best used for rules that you want to apply to all traffic that enters a device regardless of which interface it enters. For example, there might be a specific host or subnet that you always want to deny or permit. You can create these as global rules, so they are configured once on the device instead of configured again for each interface (although functionally the same as an interface-specific rule configured for the All-Interfaces role, All-Interfaces rules are repeated for each interface rather than being configured once on the device).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-362891]Tip If you want to configure the same set of global rules for more than one device, create a shared policy and inherit it in the IPv4 or IPv6 access rules policy for each device. Ensure that all global rules are in the Default section of the shared policy. If you put any global rules in the Mandatory section, you will not be able to inherit it on devices that have local interface-specific access rules defined. For more information on shared and inherited policies, see Local Policies vs. Shared Policies and Understanding Rule Inheritance.


     
      

     

     

 
     [bookmark: pgfId-362893]When you configure access rules for an ASA 8.3+ device in Security Manager, interface-specific and global rules are configured in the same policy. However, because the device always processes interface-specific rules first, Security Manager prevents you from intermixing these different types of rules. Therefore, if you configure both interface-specific and global rules on a device, keep the following in mind:

 
      
      		 [bookmark: pgfId-362895]Global rules always come last in the access rules policy. All interface-specific rules come before global rules.

 
      		 [bookmark: pgfId-362897]You cannot move rules in a way that violates the required order. For example, you cannot move an interface-specific rule below a global rule, or a global rule above an interface-specific rule.

 
      		 [bookmark: pgfId-362899]You cannot create rules in a location that violates the required order. For example, if you select an interface-specific rule, and another interface-specific rule follows it in the table, you cannot create a global rule. If you try to create the wrong kind of rule, when you save the rule, Security Manager will ask you if the rule can be created at the nearest valid location. You must accept the suggestion or the rule will not be added to the table. You can always move the rule after creating it if the suggested location is not ideal (but without violating the rules on order).

 
      		 [bookmark: pgfId-362901]You cannot inherit a policy if the rules in the inherited policy will violate the required order. For example, if you create global rules in the device policy, and try to inherit a shared policy that contains interface-specific rules in the Default section, Security Manager will prevent you from inheriting the policy.

 
      		 [bookmark: pgfId-362903]After assigning or inheriting a shared policy, you cannot edit the policy in a way that will violate rule order on any device that uses the policy.

 
      		 [bookmark: pgfId-362905]If you assign or inherit a policy that contains global rules on a device that does not support them, all global rules are ignored and not configured on the device. For example, if you permit all traffic from host 10.100.10.10 in a global rule in a shared policy, and assign that policy to an IOS device, the rule permitting 10.100.10.10 access is not configured on the IOS device, and traffic from that host is handled either by another interface-specific policy, or the default deny all policy. As a good practice, you should not assign shared policies that contain global rules to devices that do not support them, to ensure that you do not mistakenly believe the policy defined in a global rule is being configured on the unsupported device.

 
     

 
     [bookmark: pgfId-362907]There are also some changes in how certain tools work with global rules:

 
      
      		 [bookmark: pgfId-362909]Find/Replace—You can search for global rules by using the Global interface name. However, there is no way to convert between global and interface-specific rules. Although you can find global rules using the Global interface name, if you try to replace an interface name with the name “Global,” you are actually creating an interface-specific access rule that uses a policy object named Global.

 
      		 [bookmark: pgfId-362911]Rule Combiner—Interface-specific and global rules are never combined.

 
     

 
     [bookmark: pgfId-362913]Related Topics

 
      
      		 [bookmark: pgfId-362918]Understanding Access Rules

 
      		 [bookmark: pgfId-362923]Understanding Device Specific Access Rule Behavior

 
      		 [bookmark: pgfId-362928]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
      		 [bookmark: pgfId-362933]Configuring Access Rules

 
      		 [bookmark: pgfId-362938]Moving Rules and the Importance of Rule Order

 
     

 
    
 
     
      [bookmark: pgfId-362948][bookmark: 42771][bookmark: porules_cncpt_UnderstandingDeviceSpecificAccessRuleBehavior]Understanding Device Specific Access Rule Behavior [bookmark: marker-362944][bookmark: marker-362946]

 
     [bookmark: pgfId-362950]If you do not create an access rule policy, the following is the default behavior based on the type of device, and what happens when you create an access rule:

 
      
      		 [bookmark: pgfId-362952]IOS devices—Permit all traffic through an interface.

 
     

 
     [bookmark: pgfId-362954]When you create an access rule permitting source A to destination B without configuring TCP/UDP inspection on the inspection rule table, or configuring the established advanced option on the rule, the device permits any packet from A to B. However, for any returning packet from B to A, the packet is not allowed, unless there is a corresponding access rule permitting that packet. If you configure TCP/UDP inspection on the traffic the inspection rule table, a rule permitting B to A is not needed in the access rule, as any returning packet from B to A automatically passes the device.

 
      
      		 [bookmark: pgfId-362956]ASA and PIX devices—Permit traffic from a higher-security interface to a lower-security interface. Otherwise, all traffic is denied.

 
     

 
     [bookmark: pgfId-362958]If an access rule allows TCP/UDP traffic in one direction, the appliance automatically allows return traffic (you do not need to configure a corresponding rule for the return traffic), except for ICMP traffic, which does require a return rule (where you permit the reverse source and destination), or you must create an inspection rule for ICMP.

 
      
      		 [bookmark: pgfId-362960]FWSM devices—Deny all traffic entering an interface, permit all traffic leaving an interface.

 
     

 
     [bookmark: pgfId-362962]You must configure access rules to allow any traffic to enter the device.

 
     [bookmark: pgfId-362967]If you create any rules for an interface for any type of device, the device adds an implicit deny any rule at the end of the policy. It is a good practice for you to add this rule yourself so that you remember it is there. Adding the rule also allows you to get hit count information for the rule. For more information, see Viewing Hit Count Details.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-362969]Tip When you create the access rule policy, ensure that you include a rule that will permit access to the device from the Security Manager server, or you will not be able to manage the device using the product.


     
      

     

     

 
     [bookmark: pgfId-362971]Related Topics

 
      
      		 [bookmark: pgfId-362976]Understanding Access Rules

 
      		 [bookmark: pgfId-362981]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
     

 
    
 
     
      [bookmark: pgfId-362995][bookmark: 42806][bookmark: porules_cncpt_UnderstandingAccessRuleAddressRequirementsandHowRulesAreDeployed]Understanding Access Rule Address Requirements and How Rules Are Deployed [bookmark: marker-362987][bookmark: marker-362989][bookmark: marker-362991][bookmark: marker-362993]

 
     [bookmark: pgfId-362997]One of the complexities of creating access control lists using the operating system commands on the command line interface (CLI) is the fact that different operating systems have different IP address formats for source and destination addresses.

 
     [bookmark: pgfId-362999]For example, Cisco IOS Software requires that you enter addresses using wildcard masks instead of subnet masks. To create a rule for the 10.100.10.0/24 network (subnet mask 255.255.255.0), you are required to enter the address as 10.100.10.0 0.0.0.255. The 0 and 1 have the reverse meaning in a wildcard mask that they have in a subnet mask. In ASA, PIX, and FWSM software, however, you use subnet masks, so you enter 10.100.10.0 255.255.255.0.

 
     [bookmark: pgfId-363001]Security Manager simplifies addressing requirements for access rules: you always use the subnet mask. You are not even allowed to enter a wildcard mask. When you deploy the access rules to a device, Security Manager considers the operating system of the device and converts subnet masks to wildcard masks automatically when needed.

 
     [bookmark: pgfId-363003]This makes it possible for you to create shared rules based on logical policies and to apply those rules to all of your devices. For example, there might be a set of access rules that you want all devices to use, in which case you can create the shared policy and assign it as the inherited policy for all devices. You do not have to worry about defining rules using the “right” syntax for the device type. You can use the same network/host objects that you use in other types of policies to identify targeted hosts and networks.

 
     [bookmark: pgfId-363005]The specific CLI commands generated in deployed configurations are also based on the type of device. For IOS devices, the ip access-list command is used. For ASA, PIX, FWSM devices, the access-list or ipv6 access-list command is used and the access-group command binds it to the interface. With ASA, PIX, FWSM, and IOS 12.4(20)T+ devices, if you use network/host objects to identify the source or destination addresses for a rule, the object-group command is used to create object groups for those network/host objects. Object groups are also created for service objects.

 
     [bookmark: pgfId-363007]Tips

 
      
      		 [bookmark: pgfId-363009]Because you can use network/host objects to identify a source or destination, and you can configure deployment optimization for rules, there is not always a one-to-one relationship between an access rule and ACEs in the CLI definition of an ACL.

 
      		 [bookmark: pgfId-363014]All access lists created from firewall rules are extended access lists (rather than standard). Security Manager applies a system-generated name to the ACL unless you specify a name for the ACL on the Access Control Settings Page. The name applies to the ACL that includes all of the rules related to the interface and direction for which the name is defined.

 
      		 [bookmark: pgfId-363022]There are several deployment options that control how object groups are deployed. This topic describes the default behavior. On the Deployment Page (select  Tools > Security Manager Administration > Deployment ), you can deselect the option to create object groups from network/host objects. You can also optimize object groups during deployment (see Optimizing Network Object Groups When Deploying Firewall Rules), create new object groups from rules with multiple services or source and destination addresses, or remove unused object groups.

 
      		 [bookmark: pgfId-363024]The deployment options also include settings that control the names of ACLs generated from access rules and how many ACLs are created. By default, Security Manager creates a unique ACL for each interface, even if this means that several duplicate ACLs are created.

 
     

 
     [bookmark: pgfId-363026]If you select Enable ACL Sharing for Firewall Rules, Security Manager can create a single ACL and apply it to multiple interfaces, thus avoiding the creation of unnecessary duplicate ACLs. However, ACL sharing occurs only if it can be done while preserving your ACL naming requirements:

 
     [bookmark: pgfId-363031] – If you specify an ACL name for an interface and direction, that name is always used, even if it means a duplicate ACL must be created. For more information, see Configuring Settings for Access Control.

 
     [bookmark: pgfId-363033] – If you select Reuse existing names for the Firewall Access-List Names property, the existing names are preserved (unless you override them in the access control settings policy). This means that you might end up with duplicate ACLs under different names if duplicate ACLs already exist on the device.

 
     [bookmark: pgfId-363035]Tip: To maximize ACL sharing, ensure that you select Reset to CS-Manager Generated Names for the Firewall Access-List Names property, select Speed for the Optimize the Deployment of Access Rules For property, and that you do not configure ACL names in the access control settings policy.

 
     [bookmark: pgfId-363040]For more detailed information about the Enable ACL Sharing for Firewall Rules property, see Deployment Page.

 
      
      		 [bookmark: pgfId-363042]IPv4 and IPv6 ACLs cannot have the same name.

 
     

 
     [bookmark: pgfId-363044]Related Topics

 
      
      		 [bookmark: pgfId-363049]Understanding Access Rules

 
      		 [bookmark: pgfId-363054]Configuring Access Rules

 
      		 [bookmark: pgfId-363059]Configuring Settings for Access Control

 
      		 [bookmark: pgfId-363064]Expanding Object Groups During Discovery

 
     

 
    
 
   
 
    
     [bookmark: pgfId-363074][bookmark: 42882][bookmark: porules_proc_AddingAccessRules]Configuring Access Rules [bookmark: marker-363070][bookmark: marker-363072]

 
    [bookmark: pgfId-363079]Access rules policies define the rules for allowing traffic to pass through an interface. If you do not configure an access rules policy, the device behavior differs based on device type as explained in Understanding Device Specific Access Rule Behavior.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-363087]Note Prior to the release of Security Manager 4.4 and versions 9.0 and higher of the ASA, separate pages, policies and policy objects were provided for configuring IPv4 and IPv6 firewall rules and policies. With Security Manager 4.4 and ASA 9.0+, these policies and policy objects were “unified,” meaning one set of rules in which you can use either IPv4 or IPv6 addresses, or a mixture of both. (See Policy Object Changes in Security Manager 4.4 for additional information.) However, for the earlier ASA versions, a separate page for IPv6 access rules is still provided in Device view, while in Policy view, IPv4 and unified versions of the access-rule policy types are provided. In addition, a utility that you can use to convert existing IPv4 policies is provided (see Converting IPv4 Rules to Unified Rules). The following descriptions apply to all versions of the access rule table, except where noted.

If you assign an IPv4 access-rule shared policy to a 9.0+ device, you will no longer be able to assign unified versions of those policies to that device. Likewise, if you assign a unified access-rule shared policy to a 9.0+ device, you will no longer be able to assign IPv4 versions of those shared policies to that device--the device will not be included in the list of available devices on the Assignments tab for the shared policy.


    
     

    

    

 
    [bookmark: pgfId-363089]Before you configure access rules, consider the other types of firewall rules you will configure. Access rules are processed before all other types of rules except AAA rules. See the following topics for more information about things you should consider:

 
     
     		 [bookmark: pgfId-363094]Understanding Access Rules

 
     		 [bookmark: pgfId-363099]Understanding Global Access Rules

 
     		 [bookmark: pgfId-363104]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
    

 
    [bookmark: pgfId-363106]Before You Begin

 
    [bookmark: pgfId-363114]You might have a set of access rules that you want to apply to all devices. To do this, you can create a shared rule and inherit its rules to each device’s access rules policy. For more information, see Creating a New Shared Policy and Inheriting or Uninheriting Rules.

 
    [bookmark: pgfId-363116]Related Topics

 
     
     		 [bookmark: pgfId-363121]Using Sections to Organize Rules Tables

 
     		 [bookmark: pgfId-363126]Copying Policies Between Devices

 
     		 [bookmark: pgfId-363131]Working with Shared Policies in Device View or the Site-to-Site VPN Manager

 
     		 [bookmark: pgfId-363136]Understanding Networks/Hosts Objects

 
     		 [bookmark: pgfId-363141]Understanding Interface Role Objects

 
     		 [bookmark: pgfId-363146]Understanding and Specifying Services and Service and Port List Objects

 
    

 
    
 
    [bookmark: pgfId-363151]Step 1 Do one of the following to open the Access Rules Page:

 
     
     		 [bookmark: pgfId-363153](Device view) Select  Firewall > Access Rules (or  Firewall > Settings > IPv6 Access Rules ) from the Policies selector.

 
     		 [bookmark: pgfId-363155](Policy view) Select  Firewall > Access Rules (or  Firewall > Settings > IPv6 Access Rules ) from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-363160]Step 2 Select the row after which you want to create the rule and click the Add Row button or right-click and select Add Row. This opens the Add and Edit Access Rule Dialog Boxes.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-363168]Tip If you do not select a row, the new rule is added at the end of the local scope. You can also select an existing row and edit either the entire row or specific cells. For more information, see Editing Rules. Special rules apply if you mix interface-specific and global rules in a policy; for more information, see Understanding Global Access Rules.


    
     

    

    

 
    [bookmark: pgfId-363173]Step 3 Configure the rule. Following are the highlights of what you typically need to decide. For specific information on configuring the fields, see Add and Edit Access Rule Dialog Boxes.

 
     
     		 [bookmark: pgfId-363175]Permit or Deny—Whether you are allowing traffic that matches the rule or dropping it.

 
     		 [bookmark: pgfId-363180]Source and Destination addresses—If the rule should apply no matter which addresses generated the traffic or their destinations, use “All-Addresses” as the source or destination. If the rule is specific to a host or network, enter the addresses or network/host objects. For information on the accepted address formats, see Specifying IP Addresses During Policy Definition.

 
     		 [bookmark: pgfId-363191]Source and Destination Security Groups (ASA 9.0+ only)—You can specify TrustSec security groups used to filter traffic in addition to the source and destination addresses. See Selecting Security Groups in Policies, Configuring TrustSec-Based Firewall Rules and Creating Security Group Objects for more information about security groups.

 
     		 [bookmark: pgfId-363199]Source Users (ASA 8.4.2+ only)—You can further define the traffic source by specifying Active Directory (AD) user names (in the format NetBIOS_DOMAIN\username), user groups (NetBIOS_DOMAIN\\user_group), or identity user group objects that define the names and groups. The user specification is conjoined to the source address to limit the match to user addresses within the source address range. For more information, see Configuring Identity-Based Firewall Rules and Creating Identity User Group Objects.

 
     		 [bookmark: pgfId-363201]Services—Use the IP service to apply to any traffic (for example, if you want to deny all traffic from a specific source). Otherwise, select the more specific service, which is a protocol and port combination, that you are targeting.

 
     		 [bookmark: pgfId-363206]Interfaces or Global—The interface or interface role for which you are configuring the rule, or Global to create global access rules on ASA 8.3+ devices (see Understanding Global Access Rules).

 
     		 [bookmark: pgfId-363211]Advanced settings—Click  Advanced to open the Advanced dialog box for configuring additional settings. You can configure the following options; for detailed information, see Advanced and Edit Options Dialog Boxes.

 
    

 
    [bookmark: pgfId-363213] – Logging options. If you are using Security Manager or CS-MARS to monitor the device, ensure that you enable logging.

 
    [bookmark: pgfId-363215] – The direction of traffic to which this rule should apply (in or out). The default is in. You cannot change this setting for global rules.

 
    [bookmark: pgfId-363220] – The time range for the rule, which allows you to configure rules that work only for specific periods of time, such as during working hours. For more information, see Configuring Time Range Objects.

 
    [bookmark: pgfId-363222] – IOS device options for fragmentation and allowing the return of traffic for established outbound sessions.

 
    [bookmark: pgfId-363227] – Rule expiration dates and notification settings. For more information, see Configuring Expiration Dates for Access Rules.

 
    [bookmark: pgfId-363229]Click OK when you are finished defining your rule.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-363234]Note If you have conflict detection enabled, Security Manager will analyze the new rule to see if it conflicts or overlaps with other rules. For more information, see Using Automatic Conflict Detection.


    
     

    

    

 
    [bookmark: pgfId-363242]Step 4 If you did not select the right row before adding the rule, select the new rule and use the up and down arrow buttons to position the rule appropriately. For more information, see Moving Rules and the Importance of Rule Order. There are special restrictions for moving rules when you mix interface-specific and global rules; see Understanding Global Access Rules.

 
    [bookmark: pgfId-363250]Step 5 If you already have a large number of rules, consider analyzing and combining them before deploying the new rules. You can use the conflict detection tool to analyze your rules (see Using Automatic Conflict Detection). If analysis shows that you have a lot of redundant rules, right-click anywhere in the rules table and choose Combine Rules to combine them. You can either allow Security Manager to evaluate all rules for combination, or just the rules you select before starting the rule combination tool. For more information, see Combining Rules.

 
    [bookmark: pgfId-363252]


    
     

    
 
    

 
     
      [bookmark: pgfId-363262][bookmark: 43011][bookmark: fwlsvcpg_cncpt_AccessRulesPage]Access Rules Page [bookmark: marker-363260]

 
     [bookmark: pgfId-363264]Use the Access Rules page to configure access control rules for device interfaces. Access rules policies define the rules that allow or deny traffic to transit an interface. Typically, you create access rules for traffic entering an interface, because if you are going to deny specific types of packets, it is better to do it before the device spends a lot of time processing them. Access rules are processed before other types of firewall rules.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-363272]Note With the release of Security Manager 4.4 and versions 9.0 and higher of the ASA, the separate policies and objects for configuring IPv4 and IPv6 access rules were “unified,” meaning one set of access rules in which you can use either IPv4 or IPv6 addresses, or a mixture of both. (See Policy Object Changes in Security Manager 4.4 for additional information.) In Policy view, IPv4 and unified versions of the access policy type are provided. In addition, a utility that you can use to convert existing IPv4 policies is provided (see Converting IPv4 Rules to Unified Rules). The following descriptions apply to apply to all versions of the access rule table, except where noted.


     
      

     

     

 
     [bookmark: pgfId-363274]Read the following topics before you configure access rules:

 
      
      		 [bookmark: pgfId-363279]Understanding Access Rules

 
      		 [bookmark: pgfId-363284]Understanding Global Access Rules

 
      		 [bookmark: pgfId-363289]Understanding Device Specific Access Rule Behavior

 
      		 [bookmark: pgfId-363294]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
      		 [bookmark: pgfId-363299]Configuring Access Rules

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-363304]Tip Disabled rules are grayed out. When you deploy the configuration, disabled rules are removed from the device. For more information, see Enabling and Disabling Rules.


     
      

     

     

 
     [bookmark: pgfId-363306]Navigation Path

 
     [bookmark: pgfId-363308]To open the Access Rules page, do one of the following:

 
      
      		 [bookmark: pgfId-363310](Device view) Select a device, then select  Firewall > Access Rules (or  Firewall > Settings > IPv6 Access Rules ) from the Policies selector.

 
      		 [bookmark: pgfId-363312](Policy view) Select  Firewall > Access Rules (or  Firewall > Settings > IPv6 Access Rules ) from the Policy Type selector. Create a new policy or select an existing one.

 
      		 [bookmark: pgfId-363314](Map view) Right-click a device and select  Edit Firewall Policies > Access Rules (or  Edit Firewall Policies > IPv6 Access Rules ).

 
     

 
     [bookmark: pgfId-363316]Related Topics

 
      
      		 [bookmark: pgfId-363321]Configuring Expiration Dates for Access Rules

 
      		 [bookmark: pgfId-363326]Configuring Settings for Access Control

 
      		 [bookmark: pgfId-363331]Adding and Removing Rules

 
      		 [bookmark: pgfId-363336]Editing Rules

 
      		 [bookmark: pgfId-363341]Enabling and Disabling Rules

 
      		 [bookmark: pgfId-363346]Moving Rules and the Importance of Rule Order

 
      		 [bookmark: pgfId-363351]Using Sections to Organize Rules Tables

 
      		 [bookmark: pgfId-363356]Using Rules Tables

 
      		 [bookmark: pgfId-363361]Filtering Tables

 
     

 
     [bookmark: pgfId-363363]Field Reference

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-363368]Note For details on the fields and user interface elements available as part of the automatic conflict detection feature, see Understanding the Automatic Conflict Detection User Interface.


     
      

     

     

 
     [bookmark: pgfId-363371] 

 
      
       
        
        [bookmark: pgfId-360744]Table 16-1 [bookmark: 43091]Access Rules Page 

 
        
       
         
         		
           
           [bookmark: pgfId-360750]Element
          
  
         		
           
           [bookmark: pgfId-360752]Description
          
  
        

 
         
         		[bookmark: pgfId-360758]Expand all rows/Collapse all rows

  
         		[bookmark: pgfId-360760]Use these buttons to expand or collapse all sections in the rules table.

 [bookmark: pgfId-360762]Note The buttons are located in the upper-right corner of the Filter area above the access rules table.

  
        

 
         
         		[bookmark: pgfId-360768]Conflict Indicator icons

  
         		[bookmark: pgfId-360773]Identifies conflicts and provides a quick visual representation of the type of conflict. For more details, including types of conflicts and the actions you can take from this column, see Understanding the Automatic Conflict Detection User Interface.

  
        

 
         
         		[bookmark: pgfId-360779]No.

  
         		[bookmark: pgfId-360781]The ordered rule number.

  
        

 
         
         		[bookmark: pgfId-360787]Permit

  
         		[bookmark: pgfId-360789]Whether a rule permits or denies traffic based on the conditions set:

 
           
           		 [bookmark: pgfId-360791]Permit—Shown as a green check mark.

 
           		 [bookmark: pgfId-360793]Deny—Shown as a red circle with slash.

 
          

  
        

 
         
         		[bookmark: pgfId-360799]Sources

  
         		[bookmark: pgfId-360801]The sources of traffic for this rule; can be networks, security groups (ASA 9.0+ only), and users. Multiple entries are displayed on separate lines within the table cell.

  
        

 
         
         		[bookmark: pgfId-360807]Destinations

  
         		[bookmark: pgfId-360809]The destinations for this rule; can be networks and security groups (ASA 9.0+ only). Multiple entries are displayed on separate lines within the table cell.

  
        

 
         
         		[bookmark: pgfId-360815]Service

  
         		[bookmark: pgfId-360820]The services or service objects that specify the protocol and port of the traffic to which the rule applies. Multiple entries are displayed on separate lines within the table cell. See Understanding and Specifying Services and Service and Port List Objects.

  
        

 
         
         		[bookmark: pgfId-360826]Hit Count

  
         		[bookmark: pgfId-360828]Number of times this rule has been “hit”; that is, number of times it has permitted or denied traffic; it is actually the sum of the hit counts for all accesss control entries (ACEs) created by the rule. This information is useful in debugging the deployed policies.

 [bookmark: pgfId-360833]Use the Refresh Hit Count button at the bottom of this page to update the hit information; opens the Hit Count Selection Summary Dialog Box.

 [bookmark: pgfId-360838]You can right-click this cell and choose Show Hit Count Details to open the Hit Count Details pane at the bottom of the Configuration Manager window. See Viewing Hit Count Details for more information.

  
        

 
         
         		[bookmark: pgfId-360844]Last Hit Time

  
         		[bookmark: pgfId-360846]Timestamp for the most-recent hit.

  
        

 
         
         		[bookmark: pgfId-360852]Interface

  
         		[bookmark: pgfId-360857]The interfaces or interface roles to which the rule is assigned. Interface role objects are replaced with the actual interface names when the configuration is generated for each device. Multiple entries are displayed on separate lines within the table cell. See Understanding Interface Role Objects.

 [bookmark: pgfId-360862]For ASA 8.3+ devices, global rules are indicated with the name Global and a special icon to distinguish them from rules that use interface or interface role names (for an explanation of the icons, see Specifying Interfaces During Policy Definition).

  
        

 
         
         		[bookmark: pgfId-360868]Dir.

  
         		[bookmark: pgfId-360870]The direction of the traffic to which this rule applies:

 
           
           		 [bookmark: pgfId-360872]In—Packets entering the interface.

 
           		 [bookmark: pgfId-360874]Out—Packets exiting the interface.

 
          

  
        

 
         
         		[bookmark: pgfId-360880]Options

  
         		[bookmark: pgfId-360885]Any additional options configured for the rule. These include logging, time range, and some additional IOS rule options. See Advanced and Edit Options Dialog Boxes.

  
        

 
         
         		[bookmark: pgfId-360891]Category

  
         		[bookmark: pgfId-360896]The category assigned to the rule. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-360902]Description

  
         		[bookmark: pgfId-360904]The description of the rule, if any.

  
        

 
         
         		[bookmark: pgfId-360910]Expiration Date

  
         		[bookmark: pgfId-360912]The date on which the rule expires. Expired rules show Expired in bold text. Expired rules are not automatically deleted.

  
        

 
         
         		[bookmark: pgfId-360918]Last Ticket(s)

  
         		[bookmark: pgfId-360923]Shows the ticket(s) associated with last modification to the rule. You can click the ticket ID in the Last Ticket(s) column to view details of the ticket and to navigate to the ticket. If linkage to an external ticket management system has been configured, you can also navigate to that system from the ticket details (see Ticket Management Page).

  
        

 
         
         		 [bookmark: pgfId-360929]Page elements below the rules table

  
        

 
         
         		[bookmark: pgfId-360937]Enable conflict detection

 [bookmark: pgfId-360939]Generate Report

 [bookmark: pgfId-360941](neither option presented on the IPv6 Access Control page)

  
         		[bookmark: pgfId-360943]Enable or disable automatic conflict detection. This feature is enabled by default and the setting is managed per user. Disabling conflict detection for one access rules table will also disable the feature for other access rules tables.

 [bookmark: pgfId-360948]You can disable conflict detection while creating your rule table or making large modifications and then re-enable it when you are ready to verify your changes. See Using Automatic Conflict Detection.

 [bookmark: pgfId-360953]Note For details on the fields and user interface elements available as part of the automatic conflict detection feature, see Understanding the Automatic Conflict Detection User Interface.

 [bookmark: pgfId-360955]If conflict detection is enabled, you can click the Generate Report button to create an HTML report of any rule conflicts detected. This report can be printed or exported to another application.

  
        

 
         
         		[bookmark: pgfId-360961]Refresh Hit Count

 [bookmark: pgfId-360963](not presented on the IPv6 Access Control page)

  
         		[bookmark: pgfId-360968]Click this button to update the hit information displayed in the table; opens the Hit Count Selection Summary Dialog Box.

  
        

 
         
         		[bookmark: pgfId-360974]Query

 [bookmark: pgfId-360976](not presented on the IPv6 Access Control page)

  
         		[bookmark: pgfId-360981]Click this button to run a policy query, which can help you evaluate your rules and identify ineffective rules. See Generating Policy Query Reports

  
        

 
         
         		[bookmark: pgfId-360987]Find and Replace button (binoculars icon)

  
         		[bookmark: pgfId-360992]Click this button to search for various types of items within the table and to optionally replace them. See Finding and Replacing Items in Rules Tables.

  
        

 
         
         		[bookmark: pgfId-360998]Up Row and Down Row buttons (arrow icons)

  
         		[bookmark: pgfId-361003]Click these buttons to move the selected rules up or down within a scope or section. For more information, see Moving Rules and the Importance of Rule Order.

  
        

 
         
         		[bookmark: pgfId-361009]Add Row button

  
         		[bookmark: pgfId-361017]Click this button to add a rule to the table after the selected row using the Add and Edit Access Rule Dialog Boxes. If you do not select a row, the rule is added at the end of the local scope. For more information about adding rules, see Adding and Removing Rules.

  
        

 
         
         		[bookmark: pgfId-361023]Edit Row button

  
         		[bookmark: pgfId-361028]Click this button to edit the selected rule. You can also edit individual cells. For more information, see Editing Rules.

  
        

 
         
         		[bookmark: pgfId-361034]Delete Row button

  
         		[bookmark: pgfId-361036]Click this button to delete the selected rule.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-363373]Right-click Menu

 
     [bookmark: pgfId-363375]A right-click menu is also available. This menu provides access to many of the functions listed above; the options presented depend on the location right-clicked:

 
      
      		 [bookmark: pgfId-363380]If you right-click a rule in the table, the options may include editing functions relative to the specific table cell right-clicked. For example, the command “Show Hit Count Details” is included when you right-click a Hit Count cell. See Editing Rules for more information.

 
      		 [bookmark: pgfId-363388]You can also navigate from a rule to events associated with that rule in either Event Viewer or CS MARS. For more information, see Viewing Events for an Access Rule and Viewing CS-MARS Events for an Access Rule.

 
      		 [bookmark: pgfId-363396]The Import Rules and Combine Rules options are also included in the right-click menu. See Importing Rules and Combining Rules for more information about these options.

 
     

 
    
 
     
      [bookmark: pgfId-363410][bookmark: 43282][bookmark: fwlsvcpg_cncpt_AddandEditAccessRuleDialogBoxes]Add and Edit Access Rule Dialog Boxes [bookmark: marker-363404][bookmark: marker-363406][bookmark: marker-363408]

 
     [bookmark: pgfId-363412]Use the Add and Edit Access Rule dialog boxes to add and edit security-device access rules.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-363414]Note With the release of Security Manager 4.4 and versions 9.0 and higher of the ASA, the separate pages for configuring IPv4 and IPv6 access rules were unified. However, for the earlier ASA versions, a separate page for IPv6 access rules is still provided. The following descriptions apply to apply to all versions of the page, except where noted.


     
      

     

     

 
     [bookmark: pgfId-363416]Read the following topics before you configure access rules:

 
      
      		 [bookmark: pgfId-363421]Understanding Access Rules

 
      		 [bookmark: pgfId-363426]Understanding Global Access Rules

 
      		 [bookmark: pgfId-363431]Understanding Device Specific Access Rule Behavior

 
      		 [bookmark: pgfId-363436]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
      		 [bookmark: pgfId-363441]Configuring Access Rules

 
     

 
     [bookmark: pgfId-363443]Navigation Path

 
     [bookmark: pgfId-363448]On the Access Rules Page, click the Add Row button or select a row and click the Edit Row button.

 
     [bookmark: pgfId-363450]Related Topics

 
      
      		 [bookmark: pgfId-363455]Configuring Expiration Dates for Access Rules

 
      		 [bookmark: pgfId-363460]Editing Rules

 
      		 [bookmark: pgfId-363465]Adding and Removing Rules

 
      		 [bookmark: pgfId-363470]Importing Rules

 
      		 [bookmark: pgfId-363475]Understanding Networks/Hosts Objects

 
      		 [bookmark: pgfId-363480]Understanding and Specifying Services and Service and Port List Objects

 
     

 
     [bookmark: pgfId-363482]Field Reference

 
     [bookmark: pgfId-363485] 

 
      
       
        
        [bookmark: pgfId-361049]Table 16-2 [bookmark: 43341]Add and Edit Access Rule Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-361055]Element
          
  
         		
           
           [bookmark: pgfId-361057]Description
          
  
        

 
         
         		[bookmark: pgfId-361063]Enable Rule

  
         		[bookmark: pgfId-361068]Check this box to enable this rule, which means the rule becomes active when you deploy the configuration to the device. Deselect to disable the rule while keeping the rule definition. Disabled rules are shown overlaid with hash marks in the rule table. See Enabling and Disabling Rules for more information.

  
        

 
         
         		[bookmark: pgfId-361074]Action

  
         		[bookmark: pgfId-361076]Whether the rule permits or denies traffic based on the conditions you define.

  
        

 
         
         		[bookmark: pgfId-361082]Sources

  
         		[bookmark: pgfId-361084]Provide traffic sources for this rule; can be networks, security groups, and users. You can enter values or object names, or Select objects, for one or more of the following types of sources:

 
           
           		 [bookmark: pgfId-361086]Network – You can specify a various network, host and interface definitions, either individually or as objects. If you Select an interface object as a source, the dialog box displays tabs to differentiate between hosts/networks and interfaces.

 
          

 [bookmark: pgfId-361088]The “All-Address” objects do not restrict the rule to specific hosts, networks, or interfaces. These addresses are IPv4 or IPv6 addresses for hosts or networks, network/host objects, interfaces, or interface roles.

 [bookmark: pgfId-361090]Note You can only specify a fully qualified domain name (FQDN) by providing an FQDN network/host object, or a group object that includes an FQDN object. You cannot directly type in an FQDN.

 [bookmark: pgfId-361101]See Understanding Networks/Hosts Objects, Specifying IP Addresses During Policy Definition and Understanding Interface Role Objects for additional information about these definitions.

 
           
           		 [bookmark: pgfId-361112]Security Groups (ASA 9.0+) – Enter or Select the name or tag number for one or more source security groups for the rule, if any. See Selecting Security Groups in Policies, Configuring TrustSec-Based Firewall Rules and Creating Security Group Objects for more information about security groups.

 
           		 [bookmark: pgfId-361114]Users – Enter or Select the Active Directory (AD) user names, user groups, or identity user group objects for the rule, if any. You can enter any combination of the following:

 
          

 [bookmark: pgfId-361116] – Individual user names: NetBIOS_DOMAIN\username

 [bookmark: pgfId-361118] – User groups (note the double \): NetBIOS_DOMAIN\\user_group

 [bookmark: pgfId-361120] – Identity user group object names.

 [bookmark: pgfId-361122]For more information, see:

 [bookmark: pgfId-361127] – Selecting Identity Users in Policies

 [bookmark: pgfId-361132] – Configuring Identity-Based Firewall Rules

 [bookmark: pgfId-361137] – Creating Identity User Group Objects

 [bookmark: pgfId-361139]Note Enter more than one value in any of these fields by separating the items with commas.

 [bookmark: pgfId-361141]Each specification is combined with any others to limit traffic matches to only those flows that include all definitions. For example, specified user traffic originating from within a specified source address range.

  
        

 
         
         		[bookmark: pgfId-361147]Destinations

  
         		[bookmark: pgfId-361149]Provide traffic destinations for this rule; can be networks or security groups. As with Sources, you can enter values or object names, or Select objects, for one or more destinations of Network and Security Group (ASA 9.0+) type.

  
        

 
         
         		[bookmark: pgfId-361155]Services

  
         		[bookmark: pgfId-361157]The services that define the type of traffic upon which to act. You can enter or Select any combination of service objects and service types (which are typically a protocol and port combination).

 [bookmark: pgfId-361159]Enter more than one value by separating the items with commas.

 [bookmark: pgfId-361164]For complete information on how to specify services, see Understanding and Specifying Services and Service and Port List Objects.

  
        

 
         
         		[bookmark: pgfId-361170]Interfaces

 [bookmark: pgfId-361172]Global (ASA 8.3+)

  
         		[bookmark: pgfId-361177]Specify whether you are creating an interface-specific or global rule. Global rules are available only for ASA 8.3+ devices, and are handled according to special rules (for detailed information, see Understanding Global Access Rules).

 [bookmark: pgfId-361179]If you select Interfaces, enter or Select the name of the interface or the interface role to which the rule is assigned, or click Select to select the interface or role from a list. An interface must already be defined to appear on the list.

 [bookmark: pgfId-361184]Interface role objects are replaced with the actual interface names when the configuration is generated for each device. See Understanding Interface Role Objects. Global rules are created as a special global ACL that is not attached to specific interfaces, but are processed for all interfaces in the In direction after interface-specific rules.

  
        

 
         
         		[bookmark: pgfId-361190]Description

  
         		[bookmark: pgfId-361192]An optional description of the rule (up to 1024 characters).

  
        

 
         
         		[bookmark: pgfId-361198]Category

  
         		[bookmark: pgfId-361203]The category assigned to the rule. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-361209]Advanced button

  
         		[bookmark: pgfId-361214]Click this button to configure other settings for the rule, including logging configuration, traffic direction, time ranges, and rule expiration dates. For more information, see Advanced and Edit Options Dialog Boxes.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-363503][bookmark: 43446][bookmark: fwlsvcpg_cncpt_AdvancedDialogBox]Advanced and Edit Options Dialog Boxes [bookmark: marker-363497][bookmark: marker-363499][bookmark: marker-363501]

 
     [bookmark: pgfId-363505]Use the Advanced dialog box to configure additional settings for an access rule. These settings are displayed in three different cells of the access-rule table: direction, options, and rule expiration. You can then edit those settings directly by right-clicking the appropriate cell.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-363507]Note With the release of Security Manager 4.4 and versions 9.0 and higher of the ASA, the separate pages for configuring IPv4 and IPv6 access rules were unified. However, for the earlier ASA versions, a separate page for IPv6 access rules is still provided. The following descriptions apply to apply to all versions of the page, except where noted.


     
      

     

     

 
     [bookmark: pgfId-363509]Navigation Path

 
     [bookmark: pgfId-363511]To access the Advanced dialog box:

 
      
      		 [bookmark: pgfId-363516]In the Add and Edit Access Rule Dialog Boxes, click the  Advanced button.

 
     

 
     [bookmark: pgfId-363518]To access one of the Edit options dialog boxes:

 
      
      		 [bookmark: pgfId-363523]Right-click the Options or Expiration Date cell in an access rule (on the Access Rules Page) and choose the related Edit command. To change the rule direction, right-click the Dir. cell and choose the opposite direction (in or out).

 
     

 
     [bookmark: pgfId-363525]If you select multiple rows, your changes replace those options for all selected rules.

 
     [bookmark: pgfId-363527]Related Topics

 
      
      		 [bookmark: pgfId-363532]Configuring Access Rules

 
      		 [bookmark: pgfId-363537]Editing Rules

 
      		 [bookmark: pgfId-363542]Understanding Access Rules

 
      		 [bookmark: pgfId-363547]Chapter 16, “Managing Firewall Access Rules”

 
      		 [bookmark: pgfId-363552]Configuring Time Range Objects

 
     

 
     [bookmark: pgfId-363554]Field Reference

 
     [bookmark: pgfId-363557] 

 
      
       
        
        [bookmark: pgfId-361227]Table 16-3 [bookmark: 43496]Advanced Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-361233]Element
          
  
         		
           
           [bookmark: pgfId-361235]Description
          
  
        

 
         
         		[bookmark: pgfId-361241]Enable Logging (PIX, ASA, FWSM)

  
         		[bookmark: pgfId-361243]Whether to generate syslog messages for the rule entries (also known as access-control entries, or ACEs), for PIX, ASA, and FWSM devices. When selected, these additional options are enabled:

 
           
           		 [bookmark: pgfId-361245]Default Logging—Use the default logging behavior. If a packet is denied, message 106023 is generated. If a packet is permitted, no syslog message is generated. The default logging interval is 300 seconds.

 
           		 [bookmark: pgfId-361247]Per ACE Logging—Configure logging specific to this entry. Choose the logging Level you want to use to log events for the ACE, and provide a logging Interval, which can range from 1 to 600 seconds. Syslog message 106100 is generated for the ACE.

 
          

 [bookmark: pgfId-361249]Available logging levels:

 [bookmark: pgfId-361251] – Emergency—(0) System is unstable

 [bookmark: pgfId-361253] – Alert—(1) Immediate action is needed

 [bookmark: pgfId-361255] – Critical—(2) Critical conditions

 [bookmark: pgfId-361257] – Error—(3) Error conditions

 [bookmark: pgfId-361259] – Warning—(4) Warning conditions

 [bookmark: pgfId-361261] – Notification—(5) Normal but significant condition

 [bookmark: pgfId-361263] – Informational—(6) Informational messages only

 [bookmark: pgfId-361265] – Debugging—(7) Debugging messages

 [bookmark: pgfId-361270]Note You can change the firewall and IOS logging options for an existing rule in the table on the Access Rules Page by right-clicking the Options cell and choosing Edit Options.

  
        

 
         
         		[bookmark: pgfId-361276]Enable Logging (IOS)

 [bookmark: pgfId-361278]Log Input

 [bookmark: pgfId-361280](IPv4 only; neither option presented on the IPv6 Access Control page)

  
         		[bookmark: pgfId-361282]Whether to generate an informational logging message about the packet that matches the entry; the message will be sent to the console for IOS devices.

 [bookmark: pgfId-361284]Select Log Input to include the input interface and source MAC address or virtual circuit in the logging output.

  
        

 
         
         		[bookmark: pgfId-361290]Traffic Direction

  
         		[bookmark: pgfId-361292]For interface-specific access rules, the direction of the traffic to which this rule applies:

 
           
           		 [bookmark: pgfId-361294]In—Packets entering an interface.

 
           		 [bookmark: pgfId-361296]Out—Packets exiting an interface.

 
          

 [bookmark: pgfId-361301]Note You can change the direction for an existing rule in the table on the Access Rules Page by right-clicking the Dir. cell and choosing the opposite direction.

 [bookmark: pgfId-361303]Global rules are always applied in the In direction, so you cannot change this setting when configuring a global rule.

  
        

 
         
         		[bookmark: pgfId-361309]Time Range

  
         		[bookmark: pgfId-361311]The name of a time range policy object that defines the times when this rule applies. The time is based on the system clock of the device. The feature works best if you use NTP to configure the system clock.

 [bookmark: pgfId-361313]Enter the name or Select the object. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-361315]Note Time range is not supported on FWSM 2.x or PIX 6.3 devices.

  
        

 
         
         		[bookmark: pgfId-361321]Options (IOS)

 [bookmark: pgfId-361323](IPv4 only; not presented on the IPv6 Access Control page)

  
         		[bookmark: pgfId-361325]Additional options for IOS devices:

 
           
           		 [bookmark: pgfId-361327]none—Do not apply.

 
           		 [bookmark: pgfId-361329]Fragment—Allow fragmentation, which provides additional management of packet fragmentation and improves compatibility with NFS.

 
          

 [bookmark: pgfId-361331]By default, a maximum of 24 fragments is accepted to reconstruct a full IP packet. However, based on your network security policy, you might want to consider configuring the device to prevent fragmented packets from traversing the firewall.

 
           
           		 [bookmark: pgfId-361333]Established—Allow outbound TCP connections return access through the device. This option works with two connections: an original connection outbound from a network protected by the device, and a return connection inbound between the same two devices on an external host.

 
          

  
        

 
         
         		[bookmark: pgfId-361339]Rule Expiration

  
         		[bookmark: pgfId-361344]Lets you configure an expiration date for the rule. Click the calendar icon to select a date. For more information, see Configuring Expiration Dates for Access Rules.

 [bookmark: pgfId-361346]If you configure an expiration date, you can also configure the number of days before the rule expires to send out a notification of the pending expiration, and e-mail addresses to which to send the notifications. These fields are initially filled with the information configured on the Rule Expiration administrative settings page (select Tools > Security Manager Administration > Rule Expiration).

 [bookmark: pgfId-361351]You can change these options for an existing rule in the table on the Access Rules Page by right-clicking the Expiration Date cell and choosing Edit Rule Expiration.

 [bookmark: pgfId-361353]Note Expired rules are not automatically deleted. You must delete them yourself and redeploy the configuration to the device.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-363567][bookmark: 43590][bookmark: fwlsvcpg_cncpt_HitCountSelectionSummaryDialogBox]Hit Count Selection Summary Dialog Box[bookmark: marker-363565]

 
     [bookmark: pgfId-363569]Use the Hit Count Selection Summary dialog box to select the rules for which you want to refresh hit count information. Your options are limited by the rules you selected before clicking the Refresh Hit Count button. When you click OK in this dialog box, updated hit count information is obtained from the device, which can take some time, so you are given the option to abort the operation.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-363577]Tip You can view detailed hit count information for a rule by right-clicking the Hit Count cell for that rule on the Access Rules Page. Detailed hit count information is displayed in the Hit Count Details window, as described in Viewing Hit Count Details.


     
      

     

     

 
     [bookmark: pgfId-363579]Navigation Path

 
     [bookmark: pgfId-363584](Device view only) On the Access Rules Page, select one access rule in the table for which you want detailed hit count information, then right-click the Hit Count column and choose Show Hit Count Details.

 
     [bookmark: pgfId-363586]Related Topics

 
      
      		 [bookmark: pgfId-363591]Viewing Hit Count Details

 
      		 [bookmark: pgfId-363596]Understanding Access Rules

 
     

 
     [bookmark: pgfId-363598]Field Reference

 
     [bookmark: pgfId-363601] 

 
      
       
        
        [bookmark: pgfId-361366]Table 16-4 [bookmark: 43616]Hit Count Selection Summary Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-361372]Element
          
  
         		
           
           [bookmark: pgfId-361374]Description
          
  
        

 
         
         		[bookmark: pgfId-361380]Policy Selected

  
         		[bookmark: pgfId-361382]Identifies the selected policy. If you do not select a policy, this is Local, which means the rules defined specifically for the device. The policy might also be a scope within a shared or inherited policy.

 [bookmark: pgfId-361384]The indication in this field does not actually limit the scope of your hit count report.

  
        

 
         
         		[bookmark: pgfId-361390]Rules Selected

  
         		[bookmark: pgfId-361392]The rules for which you want to obtain hit count details; choose:

 
           
           		 [bookmark: pgfId-361394]Select the  rules option to obtain information for only those rules you selected. You can select the rows related to the name of a scope, a section name, multiple individual rules, or create a filter and select all filtered rules. This is the default if any row is selected when you initiate the hit count report.

 
           		 [bookmark: pgfId-361396]Select  All Rules to get hit counts for all inherited, shared, and local rules. The option is not restricted to the scope indicated in the Policy Selected field.

 
          

 [bookmark: pgfId-361398]This is the only available option if you do not select any rules before initiating the hit count report.

  
        

 
         
         		[bookmark: pgfId-361404]Fetch Data From

  
         		[bookmark: pgfId-361406]Select one of the following options and then click Refresh Hit Count:

 
           
           		 [bookmark: pgfId-361408]Device—Security Manager fetches the Hit Count information from the device and displays the same on the Access Rules policy page. Beginning from version 4.9, Security Manager stores the Hit Count information in its database for ASA and ASASM devices.

 
           		 [bookmark: pgfId-361410]History—Security Manager fetches the latest Hit Count information for the particular ACEs from its database (the Hit Count history) and displays the same on the Access Rules policy page.

 
          

 [bookmark: pgfId-361412]NOTE:

 [bookmark: pgfId-361414]If there is an open activity the Hit Count data will not be persisted in the Security Manager database. This feature is supported in IPv4 Access Rules starting from ASASM/ASA version 8.3 and Unified Access Rules starting from ASASM/ASA version 9.0.

 [bookmark: pgfId-361416]If the Fetch Data From Device is based on Rules Selected option, the Hit Count persistence support will not be enabled. The support of Hit Count persistence will be enabled only if you choose the All Rules option within Fetch Data from Device.

 [bookmark: pgfId-361418]While fetching data From history, if the value of Hit Count is zero, Security Manager checks whether the rule was hit earlier based on the Hit Count History of the rule and displays its corresponding values. If Security Manager is not able to find the values of previous Hit from History, it displays the value of Hit Count as zero.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-363619][bookmark: 43664][bookmark: porules_cncpt_UsingRuleExpiry]Configuring Expiration Dates for Access Rules [bookmark: marker-363607][bookmark: marker-363609][bookmark: marker-363611][bookmark: marker-363613][bookmark: marker-363615][bookmark: marker-363617]

 
    [bookmark: pgfId-363621]A frequent use of access rules is to provide temporary access to a network. For example, you might configure an access rule to allow a partner access for the duration of a specific project. Ideally, you want to remove the access rule at the completion of the project. However, as access rule lists grow, it is hard to manage them and to remember which rules were meant to be temporary.

 
    [bookmark: pgfId-363623]To help you deal with this problem, you can configure expiration dates for access rules. By configuring an expiration date, you can project when you believe the rule will no longer be needed.

 
    [bookmark: pgfId-363625]Expiration dates are not hard and fast dates; Security Manager does not delete rules that reach their expiration date. Instead, when an expiration date is reached, Security Manager displays “Expired” in bold letters in the Expiration Date column for the rule. You can filter the access rules page based on the expiration date field, for example, filtering for “expiration date has passed” to see all expired rules.

 
    [bookmark: pgfId-363627]If the rule is no longer needed, you can delete it (right-click and select Delete Row), or disable it (right-click and select Disable), and then redeploy the configuration to the device. You might want to initially disable the rule, which leaves the rule in the table (overlain with hash marks), in case you discover the rule really was still needed after all, saving you the time of recreating the rule. You then just need to re-enable the rule (right-click and select Enable) and redeploy the configuration.

 
    [bookmark: pgfId-363629]When you configure an expiration date, you can also configure notification settings, specifying an e-mail address that should be notified when an expiration date is approaching. You can specify how many days before the expiration date to send the notification e-mail message to allow you time to evaluate the rule. The notification settings are initially filled with the values configured in the administration settings (select Tools > Security Manager Administration > Rule Expiration); you can enter different settings for a given rule.

 
    [bookmark: pgfId-363631]To configure rule expiration:

 
     
     		 [bookmark: pgfId-363636]When creating a new rule, or editing an entire rule, click the Advanced button in the Add and Edit Access Rule Dialog Boxes to get to the rule expiration settings.

 
     		 [bookmark: pgfId-363641]For existing rules, you can add or edit expiration settings without editing the entire rule. Right-click the Expiration Date cell for the rule and select  Edit Rule Expiration . You can select multiple rows to configure the same rule expiration settings. For more information, see Advanced and Edit Options Dialog Boxes.

 
    

 
    [bookmark: pgfId-363643]Related Topics

 
     
     		 [bookmark: pgfId-363648]Rule Expiration Page

 
     		 [bookmark: pgfId-363653]Configuring Access Rules

 
    

 
   
 
    
     [bookmark: pgfId-363669][bookmark: 43714][bookmark: porules_proc_ConfiguringSettingsforAccessControl]Configuring Settings for Access Control [bookmark: marker-363659][bookmark: marker-363661][bookmark: marker-363663][bookmark: marker-363665][bookmark: marker-363667]

 
    [bookmark: pgfId-363671]You can configure various settings that apply to security-device access control lists. These settings work in conjunction with your access rules policy. The main setting of interest is that you can configure your own ACL names for each interface/traffic direction combination, or for the global ACL on ASA 8.3+ devices. For PIX, ASA, and FWSM devices, you can also control the maximum number of concurrent flows and the related syslog interval.

 
    [bookmark: pgfId-363673]You can also configure an interface to allow per-user downloadable ACLs for PIX, ASA, and FWSM devices. This allows you to configure user-based ACLs in your AAA server to override the ACLs defined on a device.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-363675]Note With the release of Security Manager 4.4 and versions 9.0 and higher of the ASA, the separate pages for configuring IPv4 and IPv6 access control were unified. However, for the earlier ASA versions, a separate page for IPv6 settings is still provided. The following descriptions apply to apply to all versions of the page, except where noted.


    
     

    

    

 
    [bookmark: pgfId-363677]Related Topics

 
     
     		 [bookmark: pgfId-363682]Configuring Access Rules

 
    

 
    
 
    [bookmark: pgfId-363687]Step 1 Do one of the following to open the Access Control Settings Page:

 
     
     		 [bookmark: pgfId-363689](Device view) Select  Firewall > Settings > Access Control (or  Firewall > Settings > IPv6 Access Control ) from the Policies selector.

 
     		 [bookmark: pgfId-363691](Policy view) Select  Firewall > Settings > Access Control (or  Firewall > Settings > IPv6 Access Control ) from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-363693]Step 2 Configure the global settings in the top part of the page. For PIX, ASA, and FWSM devices, you can define the maximum number of concurrent deny flows and the related syslog interval. For ASA 8.3+ devices, you can enable object group search to optimize ACL performance when converting from Checkpoint, but this setting is not recommended unless you have a memory-constrained device. (Not available on the IPv6 Access Control page.)

 
    [bookmark: pgfId-363698]For specific information about these settings, and the platforms that support ACL compilation, see Access Control Settings Page.

 
    [bookmark: pgfId-363703]Step 3 For each interface on which you want to configure an ACL name, or enable per-user ACLs, add the interface to the interfaces table by clicking the Add Row button beneath the table and filling in the Firewall ACL Setting Dialog Box. Keep the following in mind:

 
     
     		 [bookmark: pgfId-363705]If you configure an ACL name, the name is applied to the specific interface and direction. Security Manager creates system-generated names for any interface/direction combinations that you do not specifically name.

 
     		 [bookmark: pgfId-363707]You can also specify the name of the global ACL for ASA 8.3+ devices.

 
    

 
    [bookmark: pgfId-363709]You can edit existing entries in the list by selecting them and clicking Edit Row, or delete them by clicking Delete Row.

 
    [bookmark: pgfId-363711]


    
     

    
 
    

 
     
      [bookmark: pgfId-363725][bookmark: 43773][bookmark: fwlsvcpg_cncpt_AccessControlPage]Access Control Settings Page[bookmark: marker-363719][bookmark: marker-363721][bookmark: marker-363723]

 
     [bookmark: pgfId-363727]Use the Access Control Settings page to configure settings to use in conjunction with your access rules policy. You can control some performance and logging features, and configure ACL names for individual interfaces.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-363732]Note With the release of Security Manager 4.4 and versions 9.0 and higher of the ASA, the separate policies and objects for configuring IPv4 and IPv6 access control were “unified,” meaning one set of rules in which you can use either IPv4 or IPv6 addresses, or a mixture of both. However, for the earlier ASA versions, a separate page for IPv6 settings is still provided. (See Policy Object Changes in Security Manager 4.4 for additional information.) The following descriptions apply to apply to all versions of the page, except where noted.


     
      

     

     

 
     [bookmark: pgfId-363734]Thus, many of these settings apply only to specific device types or software versions. If you configure an option and apply the policy to unsupported device types, the option is ignored for those unsupported devices.

 
     [bookmark: pgfId-363736]Navigation Path

 
     [bookmark: pgfId-363738]To open the Access Control Page, do one of the following:

 
      
      		 [bookmark: pgfId-363740](Device view) Select a device, then select  Firewall > Settings > Access Control (or  Firewall > Settings > IPv6 Access Control ) from the Policies selector.

 
      		 [bookmark: pgfId-363742](Policy view) Select  Firewall > Settings > Access Control (or  Firewall > Settings > IPv6 Access Control ) from the Policy Type selector. Create a new policy or select an existing policy.

 
      		 [bookmark: pgfId-363744](Map view) Right-click a device and select  Edit Firewall Settings > Access Control (or  Edit Firewall Settings > IPv6 Access Control ).

 
     

 
     [bookmark: pgfId-363746]Related Topics

 
      
      		 [bookmark: pgfId-363751]Configuring Settings for Access Control

 
      		 [bookmark: pgfId-363756]Understanding Access Rules

 
      		 [bookmark: pgfId-363761]Understanding Device Specific Access Rule Behavior

 
      		 [bookmark: pgfId-363766]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
      		 [bookmark: pgfId-363771]Understanding Access Rules

 
      		 [bookmark: pgfId-363776]Understanding Interface Role Objects

 
     

 
     [bookmark: pgfId-363778]Field Reference

 
     [bookmark: pgfId-363781] 

 
      
       
        
        [bookmark: pgfId-361431]Table 16-5 [bookmark: 43828]Access Control Settings Page 

 
        
       
         
         		
           
           [bookmark: pgfId-361437]Element
          
  
         		
           
           [bookmark: pgfId-361439]Description
          
  
        

 
         
         		[bookmark: pgfId-361445]Maximum number of concurrent flows (PIX, ASA, FWSM)

 [bookmark: pgfId-361447](not presented on the IPv6 Access Control page)

  
         		[bookmark: pgfId-361449]The maximum number of concurrent deny flows that the device is allowed to create. Syslog message 106101 is generated when the device reaches the number. The range you should use depends on the amount of flash memory available in the device:

 
           
           		 [bookmark: pgfId-361451]More than 64 MB—Values are 1-4096. The default is 4096.

 
           		 [bookmark: pgfId-361453]More than 16 MB—Values are 1-1024. The default is 1024.

 
           		 [bookmark: pgfId-361455]Less than or equal to 16 MB—Values are 1-256. The default is 256.

 
          

  
        

 
         
         		[bookmark: pgfId-361461]Syslog interval (PIX, ASA, FWSM)

 [bookmark: pgfId-361463](not presented on the IPv6 Access Control page)

  
         		[bookmark: pgfId-361465]The interval of time for generating syslog message 106101, which alerts you that the security appliance has reached a deny flow maximum. When the deny flow maximum is reached, another 106101 message is generated if the specified number of seconds has passed since the last 106101 message. Values are 1-3600 milliseconds. The default is 300.

  
        

 
         
         		[bookmark: pgfId-361471]Enable Access List Compilation (Global)

 [bookmark: pgfId-361473](IPv4 only; also not presented on the IPv6 Access Control page)

  
         		[bookmark: pgfId-361475]Whether to compile access lists, which speeds up the processing of large rules tables. Compilation optimizes your policy rules and performance for all ACLs, but is supported on a limited number of older platforms:

 
           
           		 [bookmark: pgfId-361477]Routers (global configuration only): 7120, 7140, 7200, 7304, and 7500.

 
           		 [bookmark: pgfId-361479]PIX 6.3 firewalls, in global mode or per interface.

 
          

 [bookmark: pgfId-361481]An ACL is compiled only if the number of access list elements is greater than or equal to 19. The maximum recommended number of entries is 16,000.

 [bookmark: pgfId-361483]To compile access lists, the device must have a minimum of 2.1 MB of memory. Access list compilation is also known as Turbo ACL.

  
        

 
         
         		[bookmark: pgfId-361495]Enable Object Group Search (ASA 8.3+)[bookmark: marker-361489][bookmark: marker-361491][bookmark: marker-361493]

 [bookmark: pgfId-361497](not presented on the IPv6 Access Control page)

  
         		[bookmark: pgfId-361499]Whether to enable object group search on ASA 8.3+ devices, which optimizes ACL performance without expanding object groups. Object group search is mainly for use when migrating from Checkpoint to ASA, which can result in a large increase in the number of access rules, when you have a memory-constrained device (that is, you find during operations that memory runs low).

 [bookmark: pgfId-361501]If you enable object group search, you cannot use the Hit Count tool to analyze your rules. In most cases, you should not enable this feature. Instead, use the rule combination tool to simplify your access rules, and consider using global rules for rules you want to enforce on all interfaces.

  
        

 
         
         		[bookmark: pgfId-361507]Access Control settings table

  
         		[bookmark: pgfId-361509]The table lists the interfaces for which you want to configure special processing. The interface name can be a specific interface or an interface role (which can apply settings to more than one interface at a time), or Global for global ACL settings on ASA 8.3+ devices.

 [bookmark: pgfId-361511]The main use of this table is to configure names for ACLs if you do not want Security Manager to configure system-generated names. The name applies to the ACL generated for an interface in a specific direction.

 [bookmark: pgfId-361513]You can also configure interface-level settings for per user downloadable ACLs, object group search, and ACL compilation.

 
           
           		 [bookmark: pgfId-361518]To add an Access Control interface setting, click the Add Row button and fill in the Firewall ACL Setting Dialog Box.

 
           		 [bookmark: pgfId-361520]To edit an Access Control interface setting, select it and click the Edit Row button.

 
           		 [bookmark: pgfId-361522]To delete an Access Control interface setting, select it and click the Delete Row button.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-363795][bookmark: 43901][bookmark: fwlsvcpg_cncpt_FirewallACLSettingDialogBox]Firewall ACL Setting Dialog Box[bookmark: marker-363789][bookmark: marker-363791][bookmark: marker-363793]

 
     [bookmark: pgfId-363797]Use the Firewall ACL Setting dialog box to configure settings for specific interfaces, interface roles, or global rules for use with security-device access rules policies.

 
     [bookmark: pgfId-363799]Navigation Path

 
     [bookmark: pgfId-363804]Go to the Access Control Settings Page and click the Add Row button below the interface table, or select a row in the table and click the Edit Row button.

 
     [bookmark: pgfId-363806]Related Topics

 
      
      		 [bookmark: pgfId-363811]Configuring Settings for Access Control

 
      		 [bookmark: pgfId-363816]Understanding Access Rules

 
      		 [bookmark: pgfId-363821]Understanding Global Access Rules

 
      		 [bookmark: pgfId-363826]Understanding Device Specific Access Rule Behavior

 
      		 [bookmark: pgfId-363831]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
      		 [bookmark: pgfId-363836]Understanding Interface Role Objects

 
     

 
     [bookmark: pgfId-363838]Field Reference

 
     [bookmark: pgfId-363841] 

 
      
       
        
        [bookmark: pgfId-361535]Table 16-6 [bookmark: 43943]Firewall ACL Setting Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-361541]Element
          
  
         		
           
           [bookmark: pgfId-361543]Description
          
  
        

 
         
         		[bookmark: pgfId-361549]Interface

 [bookmark: pgfId-361551]Global (ASA 8.3+)

  
         		[bookmark: pgfId-361553]Specify whether you are configuring settings for specific interfaces (or interface roles), or for global rules on ASA 8.3+ devices.

 [bookmark: pgfId-361555]If you select Interface, specify the name of the interface or interface role for which you are configuring settings. Enter the name or click Select to select it from a list or to create a new object.

 [bookmark: pgfId-361557]If you select Global, your only option is to specify the name of the global ACL.

  
        

 
         
         		[bookmark: pgfId-361563]Traffic Direction

  
         		[bookmark: pgfId-361565]The direction of the traffic through the interface, In or Out. The settings you configure apply only to this direction, if direction matters.

 [bookmark: pgfId-361567]For global ACLs on ASA 8.3+ devices, the direction is always in.

  
        

 
         
         		[bookmark: pgfId-361573]User Defined ACL Name (checkbox not presented on the IPv6 Access Control page)

 [bookmark: pgfId-361575]ACL Name

  
         		[bookmark: pgfId-361577]Whether you want to supply the name for the ACL. If you select this option, enter the name you want to use, which is applied to the ACL generated for the interface and direction combination. The name must be unique on the device.

 [bookmark: pgfId-361579]If you are configuring the name for the global ACL on ASA 8.3+ devices, the option is automatically selected; simply enter the desired name.

 [bookmark: pgfId-1054083]Note Make sure that the firewall rules ACL name is unique and is not the same name as the ACL object defined in the Policy Object Manager. For more information see Creating Access Control List Objects.

 [bookmark: pgfId-361581]If you do not configure a name, Security Manager generates a name for you.

  
        

 
         
         		[bookmark: pgfId-361587]Enable Per User Downloadable ACLs (PIX, ASA, FWSM)

 [bookmark: pgfId-361589](not presented on the IPv6 Access Control page)

  
         		[bookmark: pgfId-361595]Whether to enable the download of per-user ACLs to override the ACLs on the interface. User ACLs are configured in a AAA server; they are not configured in Security Manager. If there are no per-user ACLs, the access rules configured for the interface are applied to the traffic.[bookmark: marker-361591][bookmark: marker-361593]

 [bookmark: pgfId-361597]The option is configured on the device for the specified interface only when the Traffic Direction is in.

  
        

 
         
         		[bookmark: pgfId-361603]Enable Object Group Search (PIX 6.x)

 [bookmark: pgfId-361605](not presented on the IPv6 Access Control page)

  
         		[bookmark: pgfId-361611]Whether to enable object group search on a PIX 6.x interface, which reduces the memory requirement on the device to hold large ACLs. However, object group search impacts performance by making ACL processing slower for each packet.[bookmark: marker-361607][bookmark: marker-361609]

 [bookmark: pgfId-361613]Object group search is recommended when you have very large object groups.

 [bookmark: pgfId-361618]Tip If you are trying to configure object group search on ASA 8.3+ devices, the setting is on the Access Control Settings Page.  
        

 
         
         		[bookmark: pgfId-361624]Enable Access List Compilation (PIX 6.x)

 [bookmark: pgfId-361626](not presented on the IPv6 Access Control page)

  
         		[bookmark: pgfId-361630]Whether to compile access lists on this interface for PIX 6.x devices. This setting overrides the equivalent global setting that you configure on the Access Control Settings page.[bookmark: marker-361628]

 [bookmark: pgfId-361632]ACL compilation speeds the processing of large rules tables and optimizes your policy rules and performance for the interface. An ACL is compiled only if the number of access list elements is greater than or equal to 19. The maximum recommended number of entries is 16,000.

 [bookmark: pgfId-361634]To compile access lists, the device must have a minimum of 2.1 MB of memory.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-363857][bookmark: 44022][bookmark: porules_intro_UsingAutoConflictDetection]Using Automatic Conflict Detection[bookmark: marker-363849][bookmark: marker-363851][bookmark: marker-363853][bookmark: marker-363855]

 
    [bookmark: pgfId-363859]Security Manager provides an Automatic Conflict Detection feature for access rules. You can use Automatic Conflict Detection to evaluate the logic of your access rules. When enabled, Automatic Conflict Detection identifies rules that overlap or conflict with other rules in the access rule policy. Use this information to identify rules that need to be deleted, moved, or edited.

 
    [bookmark: pgfId-363861]This section contains the following topics:

 
     
     		 [bookmark: pgfId-363866]Understanding Automatic Conflict Detection

 
     		 [bookmark: pgfId-363871]Understanding the Automatic Conflict Detection User Interface

 
     		 [bookmark: pgfId-363876]Resolving Conflicts

 
    

 
     
      [bookmark: pgfId-363886][bookmark: 44039][bookmark: porules_cncpt_UnderstandingAutoConflictDetection]Understanding Automatic Conflict Detection[bookmark: marker-363882][bookmark: marker-363884]

 
     [bookmark: pgfId-363888]Security Manager provides an automatic conflict detection feature to help identify unnecessary redundant or duplicate rules. Certain conflicting rules might have no effect on a device after they are deployed; however, they create unnecessary clusters in the rules table. By detecting these rules, you can clean up the rule set to develop an easier to use and more efficient access rules policy.

 
     [bookmark: pgfId-363890]Other conflicting rules, can create unwanted results to your network. By detecting these conflicting rules, you can identify rules that need to be deleted, moved, or edited to implement your security needs as intended.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-363892]Note The conflict detection feature will report on the first conflict between two rules. If there are additional rules in the table that also conflict with a rule, they will not be reported until the first conflict is resolved.


     
      

     

     

 
     
      [bookmark: pgfId-363916]access-list acl permit ip 2.1.1.1 255.255.255.255 any
     

     
      [bookmark: pgfId-363918]access-list acl permit ip 2.1.1.0 255.255.255.0 any
     

     
      [bookmark: pgfId-363920] 
     

     
      [bookmark: pgfId-363922] 
     

      
      		 [bookmark: pgfId-363924]Partially Redundant Rule—A portion of a compound rule is redundant to a rule or a portion of a compound rule that follows it.

 
      		 [bookmark: pgfId-363926]Shadowed Rule—This is the reverse of a redundant rule. In this case, one rule will match the same traffic as another rule such that the second rule will never be applied to any traffic because it comes later in the access list. If the action for both rules are the same, you can delete the shadowed rule. If the two rules specify different actions for traffic, you might need to move the shadowed rule or edit one of the two rules to implement your desired policy. For example, the base rule might deny IP traffic, and the shadowed rule might permit FTP traffic, for a given source or destination.

 
     

 
      
      		 [bookmark: pgfId-363942]Partially Shadowed Rule—A portion of a compound rule is shadowed by a rule before it. If the action for both rules are the same, you can delete the portion of the rule that is shadowed. If the two rules specify different actions for traffic, you might need to move the shadowed rule or edit one of the two rules to implement your desired policy.

 
     

 
     [bookmark: pgfId-363944]Scope of Automatic Conflict Detection

 
     [bookmark: pgfId-363946]When detecting conflicts, Security Manager evaluates the following pieces of information in your access rules:

 
      
      		 [bookmark: pgfId-363948]source

 
      		 [bookmark: pgfId-363950]destination

 
      		 [bookmark: pgfId-363952]services

 
      		 [bookmark: pgfId-363954]users

 
      		 [bookmark: pgfId-363956]interfaces

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-363958]Note Conflict detection is only available for access rules in the Access Rules policy for a device or shared policy. Conflict detection is not available for access rules that are part of other policies, such as AAA or inspection rules.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-363960]Note If a rule contains an FQDN network/host object, the FQDN object is ignored, but the rule is otherwise included in the analysis.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-363962]Note Disabled rules are not evaluated during conflict detection.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-363964]Note Conflict detection does not consider time ranges when evaluating access rules. Make sure that such rules truly conflict before removing any rules flagged during conflict detection.


     
      

     

     

 
     [bookmark: pgfId-363966]Related Topics

 
      
      		 [bookmark: pgfId-363971]Understanding the Automatic Conflict Detection User Interface

 
      		 [bookmark: pgfId-363976]Resolving Conflicts

 
      		 [bookmark: pgfId-363981]Understanding Access Rules

 
      		 [bookmark: pgfId-363986]Understanding Device Specific Access Rule Behavior

 
      		 [bookmark: pgfId-363991]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
      		 [bookmark: pgfId-363996]Configuring Access Rules

 
     

 
    
 
     
      [bookmark: pgfId-364008][bookmark: 44124][bookmark: porules_cncpt_UnderstandingAutoConflictDetectionUserInterface]Understanding the Automatic Conflict Detection User Interface[bookmark: marker-364002][bookmark: marker-364004][bookmark: marker-364006]

 
     [bookmark: pgfId-364010]The Automatic Conflict Detection feature is tightly coupled with the access rules table to make identifying conflicts and then resolving those conflicts faster and easier. When conflict detection is enabled, additional user interface elements are available for navigating between the conflicts and for resolving those conflicts.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-364015]Note For information on the standard elements of the Access Rules page, see Access Rules Page.


     
      

     

     

 
     [bookmark: pgfId-364019]Figure 16-1 [bookmark: 44138]Automatic Conflict Detection

 
     [bookmark: pgfId-364023] 

 
      
      [image: ] 
     
 
      
       
       
         
         		
           
           [bookmark: pgfId-361645]1
          
  
         		[bookmark: pgfId-361647]Conflict Indicator icons

  
         		
           
           [bookmark: pgfId-361649]2
          
  
         		[bookmark: pgfId-361651]Enable Conflict Detection

  
        

 
         
         		
           
           [bookmark: pgfId-361661]3
          
  
         		[bookmark: pgfId-361663]Generate Report button

  
         		
           
           [bookmark: pgfId-361665]4
          
  
         		[bookmark: pgfId-361667]Annotation Display Options

  
        

 
         
         		
           
           [bookmark: pgfId-361677]5
          
  
         		[bookmark: pgfId-361679]Conflict navigation bar

  
         		
           
           [bookmark: pgfId-361681]6
          
  
         		[bookmark: pgfId-361683]Conflict Details area

  
        

 
         
         		
           
           [bookmark: pgfId-361693]7
          
  
         		[bookmark: pgfId-361695]Conflict Navigation buttons

  
         		[bookmark: pgfId-361697] 

  
         		[bookmark: pgfId-361699] 

  
        

 
       
      

 
     
 
     [bookmark: pgfId-364025]Conflict Indicator Icons

 
     [bookmark: pgfId-364027]The Conflict Indicator icons are used to identify conflicts and to provide a quick visual representation of the type of conflict. The following table details the available icons:

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-364033]Note For an explanation of the types of conflicts, see Understanding Automatic Conflict Detection.


     
      

     

     

 
      
      


      


      


      


      


       
       
        
             
         		[bookmark: pgfId-361709]Redundant Object

  
        

 
        
             
         		[bookmark: pgfId-361718]Redundant Rule

  
        

 
        
             
         		[bookmark: pgfId-361727]Partially Redundant Rule

  
        

 
        
             
         		[bookmark: pgfId-361736]Shadowed Rule

  
        

 
        
             
         		[bookmark: pgfId-361745]Partially Shadowed Rule

  
        

 
         
         		 [bookmark: pgfId-361751]Note If an access rule has multiple conflicts or if it has a user note attached to it, the conflict indicator icon for that rule will have a small plus sign (+) on it.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-364035]You can perform the following actions using the Conflict Indicator icon:

 
      
      		 [bookmark: pgfId-364037]Hover the mouse pointer over the  Conflict Indicator icon to view a description of the conflict including any user notes attached to the conflict.

 
      		 [bookmark: pgfId-364039]Click the  Conflict Indicator icon, or right-click the icon and select  Show Conflict Detail , to open the Conflict Details pane for the selected conflict.

 
      		 [bookmark: pgfId-364041]Right-click the  Conflict Indicator icon for a redundant object and select  Remove Redundant Object to remove the redundant object from a rule.

 
      		 [bookmark: pgfId-364043]Right-click the  Conflict Indicator icon and select  Add User Note to open the Add User Note dialog box for the selected conflict. You can use the Add User Note dialog box to enter a note about the conflict that can later be included in the Rule Analysis Detail Report.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-364045]Note User notes are not saved when leaving the access rules page or after editing a rule that has a user note.


     
      

     

     

 
     [bookmark: pgfId-364047]Enable Conflict Detection

 
     [bookmark: pgfId-364049]The Enable Conflict Detection option controls whether automatic conflict detection is enabled. Conflict detection is enabled by default but can be disabled by deselecting this option. The setting is managed per user and enabling or disabling conflict detection for one access rules table, will also enable or disable the feature for other access rules tables.

 
     [bookmark: pgfId-364051]Generate Report button

 
     [bookmark: pgfId-364053]If conflict detection is enabled, you can click the Generate Report button to create an HTML report of the conflicts that can be printed or exported to another tool. The Rule Analysis Detail Report shows details of all the conflicts in your rules table and includes any user notes that were entered for the conflicts. It does not use the settings you selected in the Annotation Display Options dialog box and does not consider the filter settings defined for the table.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-364055]Note User notes are not saved when leaving the access rules page or after editing a rule that has a user note.


     
      

     

     

 
     [bookmark: pgfId-364057]When you first open the Access Rules page, the Generate Report button is replaced with a progress bar. After conflict analysis has completed, the Generate Report button becomes available along with the other conflict detection features.

 
     [bookmark: pgfId-364059]Annotation Display Options button

 
     [bookmark: pgfId-364064]Click the Annotation Display Options button to open the Annotation Display Options dialog box, which is used for selecting the types of conflicts that should be reported. For an explanation of the types of conflicts, see Understanding Automatic Conflict Detection.

 
     [bookmark: pgfId-364066]Disabling a certain type of conflict does not remove those rules from the access rules table; it only turns off the rule conflict notification for those types of conflicts. To hide or show only conflicting rules of a certain type, you can use the table filter feature. For example, if you only wanted to see redundant and partially redundant rule conflicts, you could set up the following advanced filter:

 
     [bookmark: pgfId-364069] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-364071]You can hover the mouse pointer over the Annotation Display Options button to view a summary of the conflicts for each type and also to see which conflict types are disabled.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-364073]Note The Annotation Display Options that you select remain in effect until those options are changed. Be sure to verify these settings whenever you are working on resolving conflicts.


     
      

     

     

 
     [bookmark: pgfId-364075]Conflict Navigation Bar

 
     [bookmark: pgfId-364077]Use the Conflict navigation bar to navigate to a conflict. You can use the Previous Conflict and Next Conflict buttons on the Conflict navigation bar to step through the conflicts. You can also click on one of the conflict locators in the Conflict navigation bar to move directly to a specific conflict. This is particularly helpful when working with large rules tables.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-364079]Tip Hovering over a conflict locator provides a quick summary of the conflict.


     
      

     

     

 
     [bookmark: pgfId-364081]The conflict locators are color-coded as follows:

 
      
      		 [bookmark: pgfId-364083] Red locators —Redundant objects

 
      		 [bookmark: pgfId-364085] Blue locators —Redundant and partially redundant rules

 
      		 [bookmark: pgfId-364087] Black locators —Shadowed and partially shadowed rules

 
     

 
     [bookmark: pgfId-364089]Conflict Details Area

 
     [bookmark: pgfId-364091]The Conflict Details pane shows details for the selected conflict. The pane can be docked and undocked as needed. If the Conflict Details pane is docked while the Policy Object Manager pane is also docked, you can navigate between the two features using the tabs at the bottom of the window.

 
     [bookmark: pgfId-364093]The conflicting rules are shown together in a table for easier direct comparison. The type of conflict is shown above the table. A suggested action is shown below the table for all conflicts except partially redundant rules and partially shadowed rules, which must be resolved manually. Links are provided for direct navigation to the rules involved. Policy objects that are part of the conflicting rules can be expanded by clicking on them to see the object contents. Click again to collapse the policy object.

 
     [bookmark: pgfId-364095]You can use the links provided to navigate to the conflicting rules. You can also click the link under Action to have Security Manager perform the suggested action automatically.

 
     [bookmark: pgfId-364097]Conflict Navigation Buttons

 
     [bookmark: pgfId-364099]The Previous Conflict and Next Conflict buttons at the top of the Conflict Details pane allow you to step through the conflicts that need to be resolved without leaving the Conflict Details pane.

 
     [bookmark: pgfId-364101]Related Topics

 
      
      		 [bookmark: pgfId-364106]Understanding Automatic Conflict Detection

 
      		 [bookmark: pgfId-364111]Resolving Conflicts

 
      		 [bookmark: pgfId-364116]Understanding Access Rules

 
      		 [bookmark: pgfId-364121]Understanding Device Specific Access Rule Behavior

 
      		 [bookmark: pgfId-364126]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
      		 [bookmark: pgfId-364131]Configuring Access Rules

 
     

 
    
 
     
      [bookmark: pgfId-364157][bookmark: 44320][bookmark: porules_proc_ResolvingConflicts]Resolving Conflicts[bookmark: marker-364137][bookmark: marker-364139][bookmark: marker-364141][bookmark: marker-364143][bookmark: marker-364145][bookmark: marker-364147][bookmark: marker-364149][bookmark: marker-364151][bookmark: marker-364153][bookmark: marker-364155]

 
     [bookmark: pgfId-364159]The following procedure explains how to use the Automatic Conflict Detection feature to resolve conflicts in your access rules.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-364164]Tip You can use the Combine Rules tool to have Security Manager evaluate your rules and find ways to combine them into more efficient rules. For more information, see Combining Rules.


     
      

     

     

 
     [bookmark: pgfId-364166]Related Topics

 
      
      		 [bookmark: pgfId-364171]Understanding Automatic Conflict Detection

 
      		 [bookmark: pgfId-364176]Understanding the Automatic Conflict Detection User Interface

 
      		 [bookmark: pgfId-364181]Understanding Access Rules

 
      		 [bookmark: pgfId-364186]Understanding Device Specific Access Rule Behavior

 
      		 [bookmark: pgfId-364191]Understanding Access Rule Address Requirements and How Rules Are Deployed

 
      		 [bookmark: pgfId-364196]Configuring Access Rules

 
     

 
     
 
     [bookmark: pgfId-364198]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-364200](Device view) Select  Firewall > Access Rules from the Policy selector.

 
      		 [bookmark: pgfId-364202](Policy view) Select  Firewall > Access Rules from the Policy Type selector and select an existing policy.

 
     

 
     [bookmark: pgfId-364207]This opens the Access Rules Page. If conflict detection is enabled, the access rules will be analyzed for conflicts after the table has been loaded. If conflict detection is not enabled, select Enable conflict detection to begin the conflict analysis.

 
     [bookmark: pgfId-364209]The analysis progress is shown below the rules table. With the exception of the conflict detection features, you can perform functions on the rules table while the rules are being analyzed. After analysis has completed, the conflict detection features are enabled.

 
     [bookmark: pgfId-364211]Step 2 Make sure that the rules you are interested in analyzing are being shown in the rules table. This includes expanding sections and making sure that if you are using filters that they are set correctly. Any rules that are being filtered or are in a section that is collapsed will not be included in the conflict detection analysis.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-364213]Tip You can use the Expand all rows/Collapse all rows buttons located in the upper-right corner of the Filter area above the access rules table, to quickly expand or collapse all sections in the rules table.


     
      

     

     

 
     [bookmark: pgfId-364215]Step 3 Click the Annotation Display Options button, which is located above the Conflict navigation bar to the right of the vertical scroll bar, to open the Annotation Display Options dialog box. Verify that the types of conflicts you want detected are all enabled, and then click OK.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-364217]Tip You can hover the mouse pointer over the Annotation Display Options button to view a summary of the conflicts for each type and also to see which conflict types are disabled.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-364219]Note The Annotation Display Options that you select remain in effect until those options are changed. Be sure to verify these settings whenever you are working on resolving conflicts.


     
      

     

     

 
     [bookmark: pgfId-364221]Step 4 If you would like to print or save a copy of the conflicts that are found in the rule table, click Generate Report.

 
     [bookmark: pgfId-364223]The Rule Analysis Detail Report is opened in your browser. The Rule Analysis Detail Report shows details of all the conflicts in your rules table. It does not use the settings you selected in the Annotation Display Options dialog box and does not consider the filter settings defined for the table. You can save the report or print it as needed.

 
     [bookmark: pgfId-364225]Step 5 Use the Conflict navigation bar to navigate to a conflict. You can use the Previous Conflict and Next Conflict buttons on the Conflict navigation bar to step through the conflicts. You can also click on one of the conflict locators in the Conflict navigation bar to move directly to a specific conflict. This is particularly helpful when working with large rules tables.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-364227]Tip Hovering over a conflict locator provides a quick summary of the conflict.


     
      

     

     

 
     [bookmark: pgfId-364229]The conflict locators are color-coded as follows:

 
      
      		 [bookmark: pgfId-364231] Red locators —Redundant objects

 
      		 [bookmark: pgfId-364233] Blue locators —Redundant and partially redundant rules

 
      		 [bookmark: pgfId-364235] Grey locators —Shadowed and partially shadowed rules

 
     

 
     [bookmark: pgfId-364240]Step 6 Click on the Conflict Indicator icon for the selected conflict to open the Conflict Details pane. For more information on the Conflict Indicator icons, see Understanding the Automatic Conflict Detection User Interface.

 
     [bookmark: pgfId-364242]The Conflict Details pane shows details for the selected conflict. The conflicting rules are shown together in a table for easier direct comparison. The type of conflict is shown above the table. A suggested action is shown below the table for all conflicts except partially redundant rules and partially shadowed rules, which must be resolved manually. Links are provided for direct navigation to the rules involved. Policy objects that are part of the conflicting rules can be expanded by clicking on them to see the object contents. Click again to collapse the policy object.

 
     [bookmark: pgfId-364244]Step 7 Use the links provided to navigate to the rules and resolve the conflict as needed or click the link under Action to have Security Manager perform the suggested action automatically.
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     [bookmark: pgfId-364246]Note If you do not want to resolve the conflict at this time, you can enter a note about the conflict by right-clicking the Conflict Indicator icon to the left of the conflict in the access rule table and then selecting Add User Note. User notes are included in the Rule Analysis Detail Report, but are not saved when leaving the access rules page or after editing a rule that has a user note.


     
      

     

     

 
     [bookmark: pgfId-364248]Step 8 Use the Conflict navigation bar or the Previous Conflict and Next Conflict buttons at the top of the Conflict Details pane to access additional conflicts that need to be resolved.

 
     [bookmark: pgfId-364250]Step 9 If there are any remaining conflicts that you do not want to resolve at this time, you can click Generate Report to print or save a copy of the remaining conflicts, if desired.

 
     [bookmark: pgfId-364252]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-364264][bookmark: 44441][bookmark: fwlsvcpg_cncpt_HitCountSummaryResultsPage]Viewing Hit Count Details[bookmark: marker-364260][bookmark: marker-364262]

 
    [bookmark: pgfId-364266]Use Hit Count Details window to view information about the number of times an access rule was applied to traffic. These rules are the ones that become interface ACLs on the device. The hit count results do not show counts for any other type of ACL (for example, those used with class maps or AAA rules).

 
    [bookmark: pgfId-364268]For access rules on ASA 8.3(1) devices and later, the detailed hit count report also shows the last time the access rule policy was applied to traffic. This information is helpful for determining rules that might have been superseded by other policy changes.

 
    [bookmark: pgfId-364270]Use the hit count information to help you debug your access rules. The information can help you identify rules that are never hit (which might mean you do not need them, or that they are duplicates of rules higher in the ACL), and rules that are hit often (which means you might want to refine the rules).

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-364275]Tip You can click the Refresh Hit Count button at the bottom of the page to update hit count information before viewing the details for a rule. See Hit Count Selection Summary Dialog Box for more information.


    
     

    

    

 
    [bookmark: pgfId-364277]Consider the following points when analyzing the hit count details:

 
     
     		 [bookmark: pgfId-364279]You get best results if you deploy policies to the device before viewing hit counts. If you discover a device and then generate a hit count report before deployment, the results might be incomplete or hard to interpret. For example, an access rule might not have any hit count information.

 
     		 [bookmark: pgfId-364284]Hit count statistics are based on ACL, not on interface. If you select  Enable ACL Sharing for Firewall Rules on the Security Manager Administration Deployment page (see Deployment Page), any shared ACL provides statistics that are combined from all interfaces that share the ACL.

 
     		 [bookmark: pgfId-364289]If you enable network object group optimization, as described in Optimizing Network Object Groups When Deploying Firewall Rules, you might not get good hit count information.

 
     		 [bookmark: pgfId-364294]If you enable ACL optimization, as described in Optimizing Access Rules Automatically During Deployment, the hit count results might have problems matching ACEs from the device to access rules. Thus, when you select an access rule, you might not get any hit count results for it.

 
     		 [bookmark: pgfId-364296]FQDN network/host objects are ignored. You cannot obtain hit count information on these objects.

 
     		 [bookmark: pgfId-364298]Hit count and last hit time information is cleared when a device is restarted.

 
    

 
    [bookmark: pgfId-364300]Before You Begin

 
    [bookmark: pgfId-364302]Hit count reports are subject to the following limitations:

 
     
     		 [bookmark: pgfId-364304]Hit count reports are device-specific. You can generate the report for one device at a time from Device view only. Ensure that you deploy policies to the device before generating the reports.

 
     		 [bookmark: pgfId-364309]If you enable object group search on an ASA 8.3+ device, you cannot use the Hit Count tool. Object group search is configured on the Access Control Settings Page.

 
     		 [bookmark: pgfId-364311]Although you can select rules that include FQDN network/host objects, the objects are ignored in the hit count results.

 
    

 
    [bookmark: pgfId-364313]Navigation Path

 
    [bookmark: pgfId-364318](Device view only) From the Access Rules Page, right-click the Hit Count cell for a rule in the table and choose Show Hit Count Details.

 
    [bookmark: pgfId-364320]The Hit Count Details window opens as a pane at the bottom of the access rules table. Click the expand button on the right side of its title bar to view the hit count details in a separate window.

 
    [bookmark: pgfId-364322]Related Topics

 
     
     		 [bookmark: pgfId-364327]Understanding Access Rules

 
     		 [bookmark: pgfId-364332]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-364337]Using Category Objects

 
    

 
    [bookmark: pgfId-364339]Field Reference

 
    [bookmark: pgfId-364342] 

 
     
      
       
       [bookmark: pgfId-361766]Table 16-7 [bookmark: 44507]ACE Hit Count Details Window 

 
       
      
        
        		
          
          [bookmark: pgfId-361772]Element
         
  
        		
          
          [bookmark: pgfId-361774]Description
         
  
       

 
        
        		[bookmark: pgfId-361780]Choose

  
        		[bookmark: pgfId-361782]You can choose how to view the hit count information: Expanded Table or Raw ACE (both are explained below).

  
       

 
        
        		[bookmark: pgfId-361788]Expanded Table

  
        		[bookmark: pgfId-361793]This view lists hit count information for the access control list entry (ACE) for the rule selected in the Access Rules table (on the Access Rules Page) when you opened this window. The list contains more than one ACE if the access rule generated more than one ACE when you deployed the policy to the device.

 [bookmark: pgfId-361795]Most of the columns in this table match those of the Access Rules table; many contain the specific data configured in the ACE in place of any network/host, service, or interface role objects contained in the rule, with the exception of IOS 12.4(20)T+ devices, which show data only at the object level. Also, the name of the ACL that contains the ACE is listed.

 [bookmark: pgfId-361797]The Delta column the difference in hit count for the ACE since the last refresh. The Hit Count column shows the hits for the specific ACE rather than the overall rule.

 [bookmark: pgfId-361802]See Sample Hit Count Details Window for an example of this table.

 key while you click the column headings. You can sort on all columns except Interface, Direction, and ACL Name.  
       

 
        
        		[bookmark: pgfId-361810]Raw ACE

  
        		[bookmark: pgfId-361812]This view shows the actual CLI for the access control entry, along with the Hit Count and Last Hit Time. Use this information if you are more comfortable evaluating device commands.

 [bookmark: pgfId-361817]See Sample Hit Count Details Window for an example of this table.

  
       

 
        
        		 link to view the Hit Count history in a new window. This new Hit Count History Details window displays the Hit Count and the Last Hit Time information.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-364352][bookmark: 44548][bookmark: fwlsvcpg_cncpt_ExampleHitCountDetails]Sample Hit Count Details Window[bookmark: marker-364350]

 
     [bookmark: pgfId-364354]You can generate hit count reports to determine how often each rule in your access rule policy is matched to traffic. If an access rule is deployed as multiple access control entries (ACEs), for example, when you use interface roles to define rules and the roles apply to more than one interface, you can see the separate hit count information for each ACE deployed. The hit count results do not show counts for any other type of ACL (for example, those used with class maps or AAA rules).

 
     [bookmark: pgfId-364356]For access rules on ASA 8.3(1) devices and later, the hit count report also shows the last time the access rule policy was applied to traffic. This information is helpful for determining rules that might have been superseded by other policy changes.

 
     [bookmark: pgfId-364358]Use the hit count information to help you debug your access rules. The information can help you identify rules that are never hit (which might mean you do not need them, or that they are duplicates of rules higher in the ACL), and rules that are hit often (which means you might want to refine the rules).

 
     [bookmark: pgfId-364360]The following figures show an example of a hit count report and how to use the information.

 
      
      		 [bookmark: pgfId-364365]Figure 16-2 shows the default view. The upper table lists the rules as they exist in your access rules policy, either all rules or just the ones you selected before generating the report. When you select a rule, the ACEs created on the device for that rule are listed in the expanded table in the lower half of the window. When you initially open the report, the expanded table shows the ACEs for all policies listed in the upper table.

 
     

 
     [bookmark: pgfId-364367]Hit counts in the expanded table are for each ACE, whereas the count in the rules table is the sum of the hit counts for all ACEs created by the rule. Note that the expanded table for ASA/PIX/FWSM devices, and IOS devices lower than 12.4(20)T, shows hit counts for each element within any policy objects used in the rule, whereas for IOS 12.4(20)T+ devices, the information is only provided at the object group level.

 
      
      		 [bookmark: pgfId-364372]Figure 16-3 shows the same ACEs in CLI format. These are the ACEs as they exist in the device configuration.

 
     

 
     [bookmark: pgfId-364377]For more information about how to read and interpret hit count reports, see Viewing Hit Count Details.

 
     [bookmark: pgfId-364381]Figure 16-2 [bookmark: 44568]Expanded Table

 
     [bookmark: pgfId-364384] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-364388]Figure 16-3 [bookmark: 44571]Raw ACE Table

 
     [bookmark: pgfId-364391] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-364393]Related Topics

 
      
      		 [bookmark: pgfId-364398]Understanding Access Rules

 
      		 [bookmark: pgfId-364403]Configuring Access Rules

 
     

 
    
 
   
 
    
     [bookmark: pgfId-364413][bookmark: 44585][bookmark: porules_cncpt_ImportingRules]Importing Rules[bookmark: marker-364409][bookmark: marker-364411]

 
    [bookmark: pgfId-364415]Typically, when you add a device to Security Manager, you discover policies from the device. This action populates your access rules policy with the access control entries (ACEs) from all active ACLs on the device.

 
    [bookmark: pgfId-364417]If you find there are other ACLs that have ACEs you want included in your policy, you can define them directly in Security Manager.

 
    [bookmark: pgfId-364419]Another alternative, however, is to import them by copying and pasting the CLI entries from a device running-configuration, or by typing in the desired commands. Using the Import Rules wizard, you can quickly create ACEs and associated policy objects from ACLs that you know already work. You might also want to use this method if you are more comfortable using CLI commands to define your rules.

 
    [bookmark: pgfId-364421]The following steps describe using the Import Rules wizard to add CLI-based rules and preview the results.

 
    
 
    [bookmark: pgfId-364426]Step 1 (Device view only) Select Firewall > Access Rules to open the Access Rules Page.

 
    [bookmark: pgfId-364428]Step 2 Select the row after which you want to add the rules. The row must be within the Local scope. If you do not select a row, the rules are added at the end of the Local scope.

 
    [bookmark: pgfId-364430]Step 3 Right-click anywhere in the rules table and choose Import Rules to start the wizard.

 
    [bookmark: pgfId-364432]The first page—Enter Parameters—of the three-page wizard appears.

 
    [bookmark: pgfId-364437]Step 4 On the Import Rules Wizard—Enter Parameters Page:

 
     
     		 [bookmark: pgfId-364442]Enter the desired CLI information in the  running-configuration format appropriate for the selected device. For examples of importable CLI-based rules, see Examples of Imported Rules.

 
     		 [bookmark: pgfId-364447]Specify whether you are creating an interface-specific rule (and enter the interface or interface role to which you want the rules to apply), or for ASA 8.3+ devices, a global rule (see Understanding Global Access Rules).

 
     		 [bookmark: pgfId-364449]Specify the traffic direction with respect to the interface (the direction is always In for global rules).

 
    

 
    [bookmark: pgfId-364451]Beside access control rules, you should also include the CLI information for the following items if they are referred to by the rules. If you do not include these items, the named objects must already be defined in Security Manager for the import to be successful.

 
     
     		 [bookmark: pgfId-364453]Time range objects (the  time-range command with its subcommands), which can create time range policy objects.

 
     		 [bookmark: pgfId-364455]Object groups for PIX, ASA, FWSM, and IOS 12.4(20)T+ devices (the  object-group command with its subcommands), which can create network/host policy objects.

 
    

 
    [bookmark: pgfId-364457]For ASA 8.3+ devices, you can also include the object network and object service commands. However, any object NAT configuration is not imported.

 
    [bookmark: pgfId-364462]Step 5 Click Next to process the rules and open the Import Rules Wizard—Status Page.

 
    [bookmark: pgfId-364467]You are notified if your CLI input contains errors when you click the Next button. For some detailed tips about what commands you can enter, see Import Rules Wizard—Enter Parameters Page.

 
    [bookmark: pgfId-364469]The CLI is evaluated and if importable, you are told the types of objects that were created from the CLI.

 
    [bookmark: pgfId-364474]Step 6 Click Next to view the rules and objects on the Import Rules Wizard—Preview Page, or click Finish to import the rules without previewing them.

 
    [bookmark: pgfId-364476]The information on the Preview page is read-only. If the rules are acceptable, click Finish.

 
    [bookmark: pgfId-364478]If you want to make changes, you can click the Back button to return to the Enter Parameters page of the wizard, or you can click Finish and edit the rules on the Access Rules page.

 
    [bookmark: pgfId-364480]


    
     

    
 
    

 
     
      [bookmark: pgfId-364490][bookmark: 44651][bookmark: fwlsvcpg_cncpt_ImportRulesEnterParametersDialogBox]Import Rules Wizard—Enter Parameters Page [bookmark: marker-364488]

 
     [bookmark: pgfId-364492]Use the Import Rules wizard to import a set of access control entries from an ACL in device running-configuration format to your access rules policy. The command syntax you can enter is controlled by the type of device to which you are importing rules.

 
     [bookmark: pgfId-364494]Beside access control rules, you should also include the CLI for the following items if they are referred to by the rules. If you do not include these items, the named objects must already be defined in Security Manager for the import to be successful.

 
      
      		 [bookmark: pgfId-364496]Time range objects (the  time-range command with its subcommands).

 
      		 [bookmark: pgfId-364498]Object groups for PIX, ASA, FWSM, and IOS 12.4(20)T devices (the  object-group command with its subcommands).

 
     

 
     [bookmark: pgfId-364500]For ASA 8.3+ devices, you can also include object network and object service commands. However, any object NAT configuration is not imported.

 
     [bookmark: pgfId-364502]Navigation Path

 
     [bookmark: pgfId-364507](Device view only) Right-click anywhere in the rules table on the Access Rules Page and choose Import Rules.

 
     [bookmark: pgfId-364509]Related Topics

 
      
      		 [bookmark: pgfId-364514]Importing Rules

 
      		 [bookmark: pgfId-364519]Understanding Interface Role Objects

 
     

 
     [bookmark: pgfId-364521]Field Reference

 
     [bookmark: pgfId-364524] 

 
      
       
        
        [bookmark: pgfId-361838]Table 16-8 [bookmark: 44687]Import Rules - Enter Parameters Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-361844]Element
          
  
         		
           
           [bookmark: pgfId-361846]Description
          
  
        

 
         
         		[bookmark: pgfId-361852]CLI

  
         		[bookmark: pgfId-361854]The OS commands that define the rules and related objects that you want to import. These rules must be in running-configuration format, so they are best copied and pasted from a configuration (use Ctrl+V to paste into the field). You can also type in the commands; you will be prompted if they cannot be interpreted.

 [bookmark: pgfId-361856]You can import only one ACL at a time.

 [bookmark: pgfId-361861]To see some examples of the CLI you can import, see Examples of Imported Rules.

 [bookmark: pgfId-361863]Tips

 
           
           		 [bookmark: pgfId-361865]If you refer to an object but do not include the CLI, the rule might be created but it will not use the object.

 
           		 [bookmark: pgfId-361867]For PIX, FWSM, ASA, and IOS 12.4(20)T+, you can include object group and name commands.

 
           		 [bookmark: pgfId-361869]If you import an ACL that is inactive, it is shown as disabled in Security Manager. If you deploy the configuration, it is removed from the device.

 
           		 [bookmark: pgfId-361871]You can import extended ACLs for all device types, and standard ACLs for IOS devices. However, standard ACLs are converted to extended ACLs.

 
          

  
        

 
         
         		[bookmark: pgfId-361877]Interface

 [bookmark: pgfId-361879]Global (ASA 8.3+)

  
         		[bookmark: pgfId-361884]Select whether you are importing an interface-specific or global rule. Global rules are available only for ASA 8.3+ devices, and are handled according to special rules (for detailed information, see Understanding Global Access Rules).

 [bookmark: pgfId-361886]If you select Interfaces, enter the name of the interface or the interface role for which you are defining this rule, or click Select to select the interface or role from a list, or to create a new role. An interface must already be defined to appear on the list. You can enter any combination of interface or interface role names, separated by commas.

  
        

 
         
         		[bookmark: pgfId-361892]Traffic Direction

  
         		[bookmark: pgfId-361894]The direction of the traffic with respect to the interface, in or out.

  
        

 
         
         		[bookmark: pgfId-361900]Category

  
         		[bookmark: pgfId-361905]The category assigned to the rules. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-364534][bookmark: 44738][bookmark: fwlsvcpg_cncpt_ImportRulesStatusPage]Import Rules Wizard—Status Page [bookmark: marker-364532]

 
     [bookmark: pgfId-364536]Use the Status page of the Import Rules wizard to view information about the results of the import process.

 
     [bookmark: pgfId-364538]Navigation Path

 
     [bookmark: pgfId-364543]For information on starting the Import Rules wizard, see Import Rules Wizard—Enter Parameters Page

 
     [bookmark: pgfId-364545]Related Topics

 
      
      		 [bookmark: pgfId-364550]Importing Rules

 
     

 
     [bookmark: pgfId-364552]Field Reference

 
     [bookmark: pgfId-364555] 

 
      
       
        
        [bookmark: pgfId-361918]Table 16-9 [bookmark: 44759]Import Rules Wizard—Status Page 

 
        
       
         
         		
           
           [bookmark: pgfId-361924]Element
          
  
         		
           
           [bookmark: pgfId-361926]Description
          
  
        

 
         
         		[bookmark: pgfId-361932]Progress bar

  
         		[bookmark: pgfId-361934]Shows the status of the import process.

  
        

 
         
         		[bookmark: pgfId-361940]Status

  
         		[bookmark: pgfId-361942]The status of the imported configuration.

  
        

 
         
         		[bookmark: pgfId-361948]Rules Imported

  
         		[bookmark: pgfId-361950]The number of rules that will be imported.

  
        

 
         
         		[bookmark: pgfId-361956]Policy Objects Created

  
         		[bookmark: pgfId-361958]The number of policy objects that will be created.

  
        

 
         
         		[bookmark: pgfId-361964]Messages

  
         		[bookmark: pgfId-361966]The warning, error, and informational messages, as indicated by the severity icon. Typical informational messages describe the policy objects created during the operation or the existing policy objects that were reused.

 [bookmark: pgfId-361968]When you select an item, the Description box to the right describes the message in detail. The Action box to the right provides information on how you can correct the problem.

  
        

 
         
         		[bookmark: pgfId-361974]Abort button

  
         		[bookmark: pgfId-361976]Click this button to stop the import operation.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-364565][bookmark: 44801][bookmark: fwlsvcpg_cncpt_ImportRulesPreviewPage]Import Rules Wizard—Preview Page[bookmark: marker-364563]

 
     [bookmark: pgfId-364567]Use the Preview page of the Import Rules wizard to view the rules and objects that will be imported if you click Finish.

 
     [bookmark: pgfId-364569]This preview is read-only; you cannot edit the rules or objects. If the rules or objects are not exactly what you want, you can click Finish to add the rules and objects, and then edit them from the access rules page. For example, you cannot import rule expiration dates, because those dates have meaning only in Security Manager.

 
     [bookmark: pgfId-364571]The tabs on this dialog box appear only if the data you are importing includes items to be displayed on the tab.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-364573]Tip If your CLI refers to an object that does not exist, such as a time range, the object is not included in the rule. You can either go back and add the CLI for the object, or you can click Finish, create the object yourself, and edit the rule.


     
      

     

     

 
     [bookmark: pgfId-364575]Navigation Path

 
     [bookmark: pgfId-364580]For information on starting the Import Rules wizard, see Import Rules Wizard—Enter Parameters Page.

 
     [bookmark: pgfId-364582]Related Topics

 
      
      		 [bookmark: pgfId-364587]Importing Rules

 
      		 [bookmark: pgfId-364592]Access Rules Page

 
      		 [bookmark: pgfId-364597]Understanding Networks/Hosts Objects

 
      		 [bookmark: pgfId-364602]Understanding Interface Role Objects

 
      		 [bookmark: pgfId-364607]Understanding and Specifying Services and Service and Port List Objects

 
      		 [bookmark: pgfId-364612]Filtering Tables

 
     

 
     [bookmark: pgfId-364614]Field Reference

 
     [bookmark: pgfId-364617] 

 
      
       
        
        [bookmark: pgfId-361989]Table 16-10 [bookmark: 44840]Import Rules Wizard—Preview Page 

 
        
       
         
         		
           
           [bookmark: pgfId-361995]Element
          
  
         		
           
           [bookmark: pgfId-361997]Description
          
  
        

 
         
         		[bookmark: pgfId-362003]Rules tab

  
         		[bookmark: pgfId-362005]The rules that were created from your CLI and that will be imported to the access rules policy. All rules are converted to extended format, even if your CLI was for a standard ACL.

 [bookmark: pgfId-362007]Icons indicate the permit and deny status:

 
           
           		 [bookmark: pgfId-362009]Permit—Shown as a green check mark.

 
           		 [bookmark: pgfId-362011]Deny—Shown as a red circle with slash.

 
          

 [bookmark: pgfId-362013]You can right-click the source, destination, services, and interfaces cells and select Show Contents to see the detailed information in the cell.

 [bookmark: pgfId-362015]You can also right-click and select Copy to copy a rule to the clipboard in HTML format, which you can paste into a text editor.

  
        

 
         
         		[bookmark: pgfId-362021]Objects tab

  
         		[bookmark: pgfId-362023]The policy objects created from your CLI, if any. Depending on the CLI, Security Manager might create time range, network/host, service, or port list objects.

 [bookmark: pgfId-362025]Right-click an object and select View Object to see the object definition in read-only format.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-364627][bookmark: 44873][bookmark: porules_cncpt_ExamplesofImportedRules]Examples of Imported Rules [bookmark: marker-364623][bookmark: marker-364625]

 
     [bookmark: pgfId-364632]The following are some examples of CLI that you can import and the rules and policy objects that are created from them. For information on how to import rules, see Importing Rules.

 
     [bookmark: pgfId-364634]Example 1: Restrict a network from accessing FTP servers (ASA devices)

 
     [bookmark: pgfId-364655] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-364657]Example 2: Restrict web access during working hours (ASA devices)

 
     [bookmark: pgfId-364672] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-364674]Example 3: Filtering on TCP and ICMP using port numbers (IOS devices)

 
     [bookmark: pgfId-364693] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-364695]Example 4: Standard ACLs restricting hosts (IOS devices)

 
     [bookmark: pgfId-364714] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-364716]For more examples of ACLs in command language format, see the following:

 
      
      		 [bookmark: pgfId-364720]IOS Devices— http://www.cisco.com/en/US/docs/ios/sec_data_plane/configuration/guide/sec_create_IP_apply.html#wp1027258 .

 
      		 [bookmark: pgfId-364724]ASA Devices— http://www.cisco.com/en/US/docs/security/asa/asa82/configuration/guide/acl_extended.html .

 
     

 
    
 
   
 
    
     [bookmark: pgfId-364736][bookmark: 44937][bookmark: porules_cncpt_OptimizingACLsinRules]Optimizing Access Rules Automatically During Deployment [bookmark: marker-364730][bookmark: marker-364732][bookmark: marker-364734]

 
    [bookmark: pgfId-364738]You can configure the system to optimize the access control lists (ACLs) that are created from your access rules policies when they are deployed to specific devices or to all devices. This optimization affects only the deployed policies, it does not make any changes to your access rules policy.

 
     
     		 [bookmark: pgfId-364754]Superset ACE—Where one entry is a superset of another and the order of the rules does not matter, the redundant rule is removed. Consider the following example:

 
    

 
    
     [bookmark: pgfId-364756]access-list acl_mdc_inside_access permit tcp any any range 110 120
    

    
     [bookmark: pgfId-364758]access-list acl_mdc_inside_access deny tcp any any range 115
    

    
     [bookmark: pgfId-364760] 
    

    
     [bookmark: pgfId-364762] 
    

    [bookmark: pgfId-364764]The second ACE will never be hit. ACL optimization will remove the second ACE and deploy only the first one.

 
     
     		 [bookmark: pgfId-364766]Adjacent ACEs—Where two entries are similar enough that a single entry can do the same job. There can be no intervening rules that change which packets will hit each rule. Consider the following example:

 
    

 
    
     [bookmark: pgfId-364768]access-list myacl permit ip 1.1.1.0 255.255.255.128 any
    

    
     [bookmark: pgfId-364770]access-list myacl permit ip 1.1.1.128 255.255.255.128 any
    

    
     [bookmark: pgfId-364772] 
    

    
     [bookmark: pgfId-364774] 
    

    [bookmark: pgfId-364776]The two ACEs are merged into one: access-list myacl permit ip 1.1.1.0 255.255.255.0 any.

 
    [bookmark: pgfId-364778]By configuring ACL deployment optimization, you can create smaller ACLs that are more efficient, which can improve performance on devices with limited, non-expandable memory, such as the FWSM, which can be shared among multiple virtual contexts.

 
    [bookmark: pgfId-364780]However, there are down sides to configuring ACL deployment optimization:

 
     
     		 [bookmark: pgfId-364788]Because optimization changes what would normally be deployed for your access rules, it is hard to correlate those rules to the actual deployed ACEs. This can make the results of the hit count tool unusable, and make it very difficult to correlate events in the Cisco Security Monitoring, Analysis and Response System application. If it is important to you that you can monitor your access rules using these tools, do not enable optimization. For more information, see Viewing Hit Count Details and Viewing CS-MARS Events for an Access Rule.

 
     		 [bookmark: pgfId-364796]Optimization does not address inherent problems in your access rules policy. It is typically better to address redundancies and conflicts proactively by using the automatic conflict detection tool (see Using Automatic Conflict Detection). You can also use the combine rules tool to optimize your rules in the access rules policy before you deploy them (see Combining Rules).

 
    

 
    [bookmark: pgfId-364798]If you decide to configure ACL deployment optimization, consider enabling it only for those devices that are memory constrained.

 
    
 
    [bookmark: pgfId-364800]Step 1 Log into Windows on the Security Manager server.

 
    [bookmark: pgfId-364802]Step 2 Use a text editor such as NotePad to open the C:\Program Files\CSCOpx\MDC\athena\config\csm.properties file. Locate the optimization section and read the instructions.

 
     
     		 [bookmark: pgfId-364804]To turn on full optimization for all devices, enter the following:

 
    

 
    [bookmark: pgfId-364806]OPTIMIZE.*=full

 
     
     		 [bookmark: pgfId-364808]To turn on full optimization for a specific device, replace the asterisk with the Security Manager display name for the device. For example, if the display name is west_coast.cisco.com, enter the following:

 
    

 
    [bookmark: pgfId-364810]OPTIMIZE.west_coast.cisco.com=full

 
     
     		 [bookmark: pgfId-364812]To turn on optimization but preserve the object groups used in the ACE, replace the full keyword with preserve_og. For example:

 
    

 
    [bookmark: pgfId-364814]OPTIMIZE.west_coast.cisco.com=preserve_og

 
     
     		 [bookmark: pgfId-364816]If you do not want to allow the merger of adjacent entries, enter the following:

 
    

 
    [bookmark: pgfId-364818]AclOptimization.doMerge=false

 
    [bookmark: pgfId-364820]Step 3 Save the file. The settings take effect immediately and will be applied to all subsequent deployment jobs.

 
    [bookmark: pgfId-364822]You can generate optimization reports for deployment jobs by selecting Capture Discovery/Deployment Debugging Snapshots to File, which is located in Tools > Security Manager Administration > Debug Options.

 
    [bookmark: pgfId-364824]The deployment results will show optimization results summarized as an informational message that includes the original number of ACEs before optimization and the number of ACEs after optimization. The results are saved to a file on the server in the C:\Program Files\CSCOpx\MDC\temp folder. A job ID is used as part of the file name.

 
    [bookmark: pgfId-364826]
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     [bookmark: pgfId-471266][bookmark: 52234][bookmark: porules_cncpt_WorkingwithWebFilterRules]Managing Firewall Web Filter Rules[bookmark: marker-471262][bookmark: marker-471264]
      
      
 
     
 

 
    [bookmark: pgfId-471268]Web filter rules policies define policies for allowing or preventing web traffic based on the requested URL or the applet content of the traffic. For ASA, PIX, and FWSM devices, you can also filter FTP and HTTPS traffic.

 
    [bookmark: pgfId-471270]How you configure web filter rules is different depending on whether the device uses ASA, PIX or FWSM software as opposed to Cisco IOS Software.

 
    [bookmark: pgfId-471272]The following topics help you work with web filter rules:

 
     
     		 [bookmark: pgfId-471277]Understanding Web Filter Rules

 
     		 [bookmark: pgfId-471282]Configuring Web Filter Rules for ASA, PIX, and FWSM Devices

 
     		 [bookmark: pgfId-471287]Configuring Web Filter Rules for IOS Devices

 
     		 [bookmark: pgfId-471292]Configuring Settings for Web Filter Servers

 
    

 
   
 
    
     [bookmark: pgfId-471304][bookmark: 52259][bookmark: porules_cncpt_UnderstandingWebFilterRules]Understanding Web Filter Rules[bookmark: marker-471300][bookmark: marker-471302]

 
    [bookmark: pgfId-471306]Web filter rules policies define policies for allowing or preventing web traffic based on the requested URL or the applet content of the traffic. For ASA, PIX, and FWSM devices, you can also filter FTP and HTTPS traffic.

 
    [bookmark: pgfId-471308]Web, or URL, filtering allows you to control which web sites and web content your users have access to. For example, you might consider some types of content to create a hostile work environment for the people in your organization (for example, web sites that provide pornography). You might consider some web sites to be unsafe and a source of potential viral applications. Using web filter rules, you can block access to these objectionable or unsafe sites.

 
    [bookmark: pgfId-471313]To filter web requests, you should install an external web filtering server, either Websense or SmartFilter (N2H2). For ASA, PIX, and FWSM devices, these external servers are required for URL, FTP, or HTTPS filtering. For IOS devices, you can also use these servers, but additionally you can create local lists of whitelisted (always allowed) or blacklisted (always denied) URLs. You configure the filtering servers in the web filter settings policy; see Configuring Settings for Web Filter Servers.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-471318]Tip For IOS devices, you have the option of configuring web filtering using zone-based firewall rules instead of web filter rules, which allows you the additional option of using Trend Micro web filtering servers. For more information, see Chapter 21, “Managing Zone-based Firewall Rules”.


    
     

    

    

 
    [bookmark: pgfId-471320]Beside filtering requests based on URL, you can do some applet filtering, stripping out ActiveX or Java applets. You might want to do this to prevent applet downloads from sites you otherwise want to allow if you do not fully trust the site. You can configure your rules to block these applets from specific sites while allowing them from trusted sites.

 
    [bookmark: pgfId-471322]The policies and procedures for configuring web filter rules differs based on the device type. See the following topics for more information:

 
     
     		 [bookmark: pgfId-471327]Configuring Web Filter Rules for ASA, PIX, and FWSM Devices

 
     		 [bookmark: pgfId-471332]Configuring Web Filter Rules for IOS Devices

 
    

 
   
 
    
     [bookmark: pgfId-471342][bookmark: 52285][bookmark: porules_proc_AddingWebFilterRulesPIXASA]Configuring Web Filter Rules for ASA, PIX, and FWSM Devices [bookmark: marker-471338][bookmark: marker-471340]

 
    [bookmark: pgfId-471344]Web filter rules policies for ASA, PIX, and FWSM devices define how you want to handle HTTP, FTP, and HTTPS traffic. You can also filter ActiveX and Java applets. Web filter rules permit or deny traffic based on the Universal Resource Locator (URL) address in the web request. If you allow HTTP traffic in your access rules, you can subsequently deny (or drop) traffic if it is directed at an objectionable web or FTP site, or you can strip out ActiveX or Java applets from untrusted sources.

 
    [bookmark: pgfId-471346]To configure web filtering rules for ASA, PIX, and FWSM devices:

 
    [bookmark: pgfId-471348] 1. Configure the rules that identify traffic that should be subject to filtering, and the traffic that should be exempt from filtering rules (see below for the procedure).

 
    [bookmark: pgfId-471353] 2. Configure web filter settings to identify the URL filtering server and other settings. For more information, see Configuring Settings for Web Filter Servers.

 
    [bookmark: pgfId-471355]Related Topics

 
     
     		 [bookmark: pgfId-471360]Understanding Web Filter Rules

 
     		 [bookmark: pgfId-471365]Using Sections to Organize Rules Tables

 
     		 [bookmark: pgfId-471370]Adding and Removing Rules

 
     		 [bookmark: pgfId-471375]Editing Rules

 
     		 [bookmark: pgfId-471380]Enabling and Disabling Rules

 
     		 [bookmark: pgfId-471385]Moving Rules and the Importance of Rule Order

 
     		 [bookmark: pgfId-471390]Understanding Networks/Hosts Objects

 
     		 [bookmark: pgfId-471395]Understanding and Specifying Services and Service and Port List Objects

 
    

 
    
 
    [bookmark: pgfId-471400]Step 1 Do one of the following to open the Web Filter Rules Page (ASA/PIX/FWSM):

 
     
     		 [bookmark: pgfId-471402]Device view—Select  Firewall > Web Filter Rules from the Policy selector.

 
     		 [bookmark: pgfId-471404]Policy view—Select  Firewall > Web Filter Rules (PIX/FWSM/ASA) from the Policy Type select. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-471409]Step 2 Select the row after which you want to create the rule and click the Add Row button or right-click and select Add Row. This opens the Add and Edit PIX/ASA/FWSM Web Filter Rule Dialog Boxes.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-471414]Tip If you do not select a row, the new rule is added at the end of the local scope. You can also select an existing row and edit either the entire row or specific cells. For more information, see Editing Rules.


    
     

    

    

 
    [bookmark: pgfId-471419]Step 3 Configure the rule. Following are the highlights of what you typically need to decide. For specific information on configuring the fields, see Add and Edit PIX/ASA/FWSM Web Filter Rule Dialog Boxes.

 
     
     		 [bookmark: pgfId-471421]Filtering and Type—Whether you are creating a rule that identifies traffic to be filtered (Filter) or exempted from an existing filter rule (Filter Except), and the type of filtering to be done:

 
    

 
    [bookmark: pgfId-471423] – URL—To filter traffic based on web address.

 
    [bookmark: pgfId-471425] – HTTPS—To filter web traffic to secure sites. This does not include SSL VPN traffic.

 
    [bookmark: pgfId-471427] – FTP—To filter FTP traffic.

 
    [bookmark: pgfId-471429] – ActiveX or Java—To remove ActiveX or Java applets. These options delete all entities within applet or object tags, so you might remove more than just ActiveX or Java applets.

 
     
     		 [bookmark: pgfId-471434]Source and Destination addresses—If the rule should apply no matter which addresses generated the traffic or their destinations, use “any” as the source or destination. If the rule is specific to a host or network, enter the addresses or network/host objects. For information on the accepted address formats, see Specifying IP Addresses During Policy Definition.

 
     		 [bookmark: pgfId-471436]Service—Primarily defines the port that should be monitored. You must specify some type of TCP service. Typically, you would use the pre-defined services HTTP, HTTPS, or FTP, which should be the same as the type of filtering you are performing, but you can specify any TCP port on your network that might contain the traffic to be filtered.

 
     		 [bookmark: pgfId-471438]Options—The options you want to include, if any. The main options of interest are whether you want to allow traffic if the filtering servers are unavailable, and whether you want to truncate long URLs or URLs that have parameters. Truncating URLs that have parameters is typically a good idea, because if you are going to drop a URL, it is not normally because of a parameter value.

 
    

 
    [bookmark: pgfId-471440]Click OK when you are finished defining your rule.

 
    [bookmark: pgfId-471445]Step 4 If you did not select the desired row before adding the rule, select the new rule and use the up and down arrow buttons to position the rule appropriately. Order is not as important for web filtering rules, however, because filter except rules always create exceptions to the related filter rule, whether they come before or after the filter rule. For more information, see Moving Rules and the Importance of Rule Order.

 
    [bookmark: pgfId-471447]


    
     

    
 
    

 
     
      [bookmark: pgfId-471459][bookmark: 52376][bookmark: fwlsvcpg_cncpt_WebFilterRulesPagePIXASA]Web Filter Rules Page (ASA/PIX/FWSM)[bookmark: marker-471455][bookmark: marker-471457]

 
     [bookmark: pgfId-471461]Use the Web Filter Rules page for ASA, PIX, and FWSM devices to configure web, or URL, filtering rules. Web filtering is a type of HTTP inspection. If your access rules allow HTTP traffic, you can configure rules to apply server-based web filtering to prevent users from accessing undesirable web servers.

 
     [bookmark: pgfId-471466]When you configure web filter rules, also configure web filter settings in the Firewall > Settings > Web Filter policy. The settings identify the web filtering server and contain other settings that control the overall functioning of the policy. You must configure a web filtering server for your URL, FTP, or HTTPS filter rules to be deployed. For more information, see Web Filter Settings Page.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-471468]Tip Rules cannot overlap. For example, if you create two rules with the same, or overlapping, source, destination, and service, you cannot deploy them. Also, you should order any filter-except rules below the filter rule to which they are creating an exemption.


     
      

     

     

 
     [bookmark: pgfId-471470]Navigation Path

 
     [bookmark: pgfId-471472]To access the Web Filter Rules page for ASA, PIX, and FWSM devices, do one of the following:

 
      
      		 [bookmark: pgfId-471474](Device view) Select an ASA, PIX, or FWSM device, then select  Firewall > Web Filter Rules from the Policy selector.

 
      		 [bookmark: pgfId-471476](Policy view) Select  Firewall > Web Filter Rules (PIX/FWSM/ASA) from the Policy Type selector. Create a new policy or select an existing one.

 
      		 [bookmark: pgfId-471478](Map view) Right-click an ASA, PIX, or FWSM device and select  Edit Firewall Policies > Web Filter Rules .

 
     

 
     [bookmark: pgfId-471480]Related Topics

 
      
      		 [bookmark: pgfId-471485]Understanding Web Filter Rules

 
      		 [bookmark: pgfId-471490]Configuring Web Filter Rules for ASA, PIX, and FWSM Devices

 
      		 [bookmark: pgfId-471495]Configuring Settings for Web Filter Servers

 
      		 [bookmark: pgfId-471500]Adding and Removing Rules

 
      		 [bookmark: pgfId-471505]Editing Rules

 
      		 [bookmark: pgfId-471510]Using Sections to Organize Rules Tables

 
      		 [bookmark: pgfId-471515]Enabling and Disabling Rules

 
      		 [bookmark: pgfId-471520]Moving Rules and the Importance of Rule Order

 
      		 [bookmark: pgfId-471525]Filtering Tables

 
     

 
     [bookmark: pgfId-471527]Field Reference

 
     [bookmark: pgfId-471530] 

 
      
       
        
        [bookmark: pgfId-469679]Table 18-1 [bookmark: 52435]Web Filter Rules Page (ASA, PIX, FWSM) 

 
        
       
         
         		
           
           [bookmark: pgfId-469685]Element
          
  
         		
           
           [bookmark: pgfId-469687]Description
          
  
        

 
         
         		[bookmark: pgfId-469693]No.

  
         		[bookmark: pgfId-469695]The ordered rule number.

  
        

 
         
         		[bookmark: pgfId-469701]Source

 [bookmark: pgfId-469703]Destination

  
         		[bookmark: pgfId-469708]The source and destination addresses for the rule. The “any” address does not restrict the rule to specific hosts, networks, or interfaces. These addresses are IP addresses for hosts or networks, network/host objects, interfaces, or interface roles. Multiple entries are displayed as separate subfields within the table cell. See Understanding Networks/Hosts Objects.

  
        

 
         
         		[bookmark: pgfId-469714]Service

  
         		[bookmark: pgfId-469719]The services or service objects that specify the protocol and port of the traffic to which the rule applies. Multiple entries are displayed as separate subfields within the table cell. See Understanding and Specifying Services and Service and Port List Objects.

  
        

 
         
         		[bookmark: pgfId-469725]Type

  
         		[bookmark: pgfId-469730]The type of filtering action for the rule, either filtering the identified traffic, or exempting the identified traffic from filtering (Filter Except). For a full explanation, see Edit Web Filter Type Dialog Box.

  
        

 
         
         		[bookmark: pgfId-469736]Options

  
         		[bookmark: pgfId-469741]Additional configuration options for the selected protocol, if any. For detailed descriptions, see Edit Web Filter Options Dialog Box.

  
        

 
         
         		[bookmark: pgfId-469747]Category

  
         		[bookmark: pgfId-469752]The category assigned to the rule. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-469758]Description

  
         		[bookmark: pgfId-469760]The description of the rule, if any.

  
        

 
         
         		[bookmark: pgfId-469766]Last Ticket(s)

  
         		[bookmark: pgfId-469771]Shows the ticket(s) associated with last modification to the rule. You can click the ticket ID in the Last Ticket(s) column to view details of the ticket and to navigate to the ticket. If linkage to an external ticket management system has been configured, you can also navigate to that system from the ticket details (see Ticket Management Page).

  
        

 
         
         		[bookmark: pgfId-469777]Query

  
         		[bookmark: pgfId-469782]Click this button to run a policy query, which can help you evaluate your rules and identify ineffective rules. See Generating Policy Query Reports

  
        

 
         
         		[bookmark: pgfId-469788]Find and Replace button (binoculars icon)

  
         		[bookmark: pgfId-469793]Click this button to search for various types of items within the table and to optionally replace them. See Finding and Replacing Items in Rules Tables.

  
        

 
         
         		[bookmark: pgfId-469799]Up Row and Down Row buttons (arrow icons)

  
         		[bookmark: pgfId-469804]Click these buttons to move the selected rules up or down within a scope or section. For more information, see Moving Rules and the Importance of Rule Order.

  
        

 
         
         		[bookmark: pgfId-469810]Add Row button

  
         		[bookmark: pgfId-469818]Click this button to add a rule to the table after the selected row using the Add and Edit PIX/ASA/FWSM Web Filter Rule Dialog Boxes. If you do not select a row, the rule is added at the end of the local scope. For more information about adding rules, see Adding and Removing Rules.

  
        

 
         
         		[bookmark: pgfId-469824]Edit Row button

  
         		[bookmark: pgfId-469829]Click this button to edit the selected rule. You can also edit individual cells. For more information, see Editing Rules.

  
        

 
         
         		[bookmark: pgfId-469835]Delete Row button

  
         		[bookmark: pgfId-469837]Click this button to delete the selected rule.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-471542][bookmark: 52528][bookmark: fwlsvcpg_cncpt_AddandEditPIXFWSMASARulesDialogBoxes]Add and Edit PIX/ASA/FWSM Web Filter Rule Dialog Boxes[bookmark: marker-471538][bookmark: marker-471540]

 
     [bookmark: pgfId-471544]Use the Add and Edit PIX/ASA/FWSM Web Filter Rule dialog boxes to configuring web filtering rules for these types of devices.

 
     [bookmark: pgfId-471546]Navigation Path

 
     [bookmark: pgfId-471551]From the Web Filter Rules Page (ASA/PIX/FWSM), click the Add Row button or select a row and click the Edit Row button.

 
     [bookmark: pgfId-471553]Related Topics

 
      
      		 [bookmark: pgfId-471558]Configuring Web Filter Rules for ASA, PIX, and FWSM Devices

 
      		 [bookmark: pgfId-471563]Understanding Web Filter Rules

 
      		 [bookmark: pgfId-471568]Configuring Settings for Web Filter Servers

 
     

 
     [bookmark: pgfId-471570]Field Reference

 
     [bookmark: pgfId-471573] 

 
      
       
        
        [bookmark: pgfId-469850]Table 18-2 [bookmark: 52557]Add and Edit PIX/ASA/FWSM Web Filter Rule Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-469856]Element
          
  
         		
           
           [bookmark: pgfId-469858]Description
          
  
        

 
         
         		[bookmark: pgfId-469864]Enable Rule

  
         		[bookmark: pgfId-469869]Whether to enable the rule, which means the rule becomes active when you deploy the configuration to the device. Disabled rules are shown overlain with hash marks in the rule table. For more information, see Enabling and Disabling Rules.

  
        

 
         
         		[bookmark: pgfId-469875]Filtering

  
         		[bookmark: pgfId-469877]The type of rule you are defining:

 
           
           		 [bookmark: pgfId-469879]Filter—The rule filters the identified type of traffic between source and destination.

 
           		 [bookmark: pgfId-469881]Filter Except—The rule creates an exemption to a filter rule. The identified traffic between the source and destination is not filtered.

 
          

  
        

 
         
         		[bookmark: pgfId-469887]Type

  
         		[bookmark: pgfId-469892]The type of traffic that should be filtered (or exempted from filtering) for this rule. For filtering that uses an external server, consult the documentation for your version of the server to determine if it supports that type of filtering. Configure the filtering server on the Web Filter Settings Page.

 
           
           		 [bookmark: pgfId-469894]URL—HTTP traffic. Filtering is done using an external filtering server.

 
           		 [bookmark: pgfId-469896]HTTPS—HTTPS traffic. This does not include traffic associated with an SSL VPN. Filtering is done using an external filtering server.

 
           		 [bookmark: pgfId-469898]Java—Remove Java applets from HTTP traffic if they are identified on applet tags. The rule does not remove Java applets from SSL VPN traffic. If the applet tag spans packets, or the code in the tags is larger than the MTU, the Java applet is not removed.

 
           		 [bookmark: pgfId-469900]ActiveX—Remove ActiveX or Java applets from HTTP traffic. The rule removes any item within object or applet tags, which might also remove images and multimedia objects. The rule might not remove applets from SSL VPN traffic. If the object tag spans packets, or the code in the tags is larger than the MTU, the object is not removed.

 
           		 [bookmark: pgfId-469902]FTP—FTP traffic. Filtering is done using an external filtering server.

 
          

  
        

 
         
         		[bookmark: pgfId-469908]Sources

 [bookmark: pgfId-469910]Destinations

  
         		[bookmark: pgfId-469912]The source or destination of the traffic. You can enter more than one value by separating the items with commas.

 [bookmark: pgfId-469917]You can enter any combination of the following address types to define the source or destination of the traffic. For more information, see Specifying IP Addresses During Policy Definition.

 
           
           		 [bookmark: pgfId-469919]Network/host object. Enter the name of the object or click  Select to select it from a list. You can also create new network/host objects from the selection list.

 
           		 [bookmark: pgfId-469921]Host IP address, for example, 10.10.10.100.

 
           		 [bookmark: pgfId-469923]Network address, including subnet mask, in either the format 10.10.10.0/24 or 10.10.10.0/255.255.255.0.

 
           		 [bookmark: pgfId-469925]A range of IP addresses, for example, 10.10.10.100-10.10.10.200.

 
           		 [bookmark: pgfId-469930]An IP address pattern in the format 10.10.0.10/255.255.0.255, where the mask is a discontiguous bit mask (see Contiguous and Discontiguous Network Masks for IPv4 Addresses).

 
          

  
        

 
         
         		[bookmark: pgfId-469936]Services

  
         		[bookmark: pgfId-469938]The services that define the port number of the traffic to act on. You can enter more than one value by separating the items with commas.

 [bookmark: pgfId-469940]The service must use TCP. Your specification defines the port that you want filtered (the service name has no meaning). For example, if you want to filter port 80, use the HTTP service object. If HTTP traffic on your network uses a different port, specify TCP/port number (for example, TCP/8080). You can enter TCP by itself to filter all ports.

 [bookmark: pgfId-469942]You can enter any combination of service objects and service types (which are typically a protocol and port combination). If you type in a service, you are prompted as you type with valid values. You can select a value from the list and press Enter or Tab.

 [bookmark: pgfId-469947]For complete information on how to specify services, see Understanding and Specifying Services and Service and Port List Objects.

  
        

 
         
         		[bookmark: pgfId-469953]Allow traffic if URL Filter Server unavailable

 [bookmark: pgfId-469955](URL, FTP, HTTPS only)

  
         		[bookmark: pgfId-469957]Whether to permit unfiltered traffic on outbound connections if all of the URL filtering servers are unavailable. If you do not select this option, all affected outbound traffic (HTTP, FTP, or HTTPS) is blocked until at least one filtering server becomes available.

  
        

 
         
         		[bookmark: pgfId-469963]Block connection to HTTP Proxy Server

 [bookmark: pgfId-469965](URL only)

  
         		[bookmark: pgfId-469967]Whether to prevent users from connecting to an HTTP proxy server.

  
        

 
         
         		[bookmark: pgfId-469973]Truncate CGI request by removing CGI parameters

 [bookmark: pgfId-469975](URL only)

  
         		[bookmark: pgfId-469977]When a URL has a parameter list starting with a question mark (?), such as a CGI script, whether to truncate the URL sent to the filtering server by removing all characters after and including the question mark.

  
        

 
         
         		[bookmark: pgfId-469983]Block outbound requests if absolute FTP path is not provided

 [bookmark: pgfId-469985](FTP only)

  
         		[bookmark: pgfId-469987]Whether to prevent interactive FTP sessions that do not provide the entire directory path when the user tries to change directories.

  
        

 
         
         		[bookmark: pgfId-469993]Long URL

 [bookmark: pgfId-469995](URL only)

  
         		[bookmark: pgfId-469997]How to handle URLs that are longer than the maximum allowed by the filtering server: 4 KB for Websense, 3 KB for Smartfilter (N2H2). Many times, long URLs are due to parameter lists, and you can use the Truncate CGI request by removing CGI parameters option to handle those URLs. For other long URLs, select from the following options:

 
           
           		 [bookmark: pgfId-469999]Drop—Drop the long URL request.

 
           		 [bookmark: pgfId-470001]Truncate—Truncate the URL request to only the hostname or IP address portion of the URL.

 
           		 [bookmark: pgfId-470003]Deny—Deny the URL request.

 
          

  
        

 
         
         		[bookmark: pgfId-470009]Category

  
         		[bookmark: pgfId-470014]The category assigned to the rule. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-470020]Description

  
         		[bookmark: pgfId-470022]An optional description of the rule (up to 1024 characters).

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-471583][bookmark: 52680][bookmark: fwlsvcpg_cncpt_EditWebFilterTypeDialogBox]Edit Web Filter Type Dialog Box[bookmark: marker-471581]

 
     [bookmark: pgfId-471585]Use the Edit Web Filter Type dialog box to edit the type of filtering to be done by a web filter rule for ASA, PIX, and FWSM devices.

 
     [bookmark: pgfId-471587]Navigation Path

 
     [bookmark: pgfId-471592]Right-click the Type cell in a web filter rule for ASA/PIX/FWSM (on the Web Filter Rules Page (ASA/PIX/FWSM)) and select Edit Web Filter Type. You can edit the type for one row at a time.

 
     [bookmark: pgfId-471594]Field Reference

 
     [bookmark: pgfId-471597] 

 
      
       
        
        [bookmark: pgfId-470035]Table 18-3 [bookmark: 52694]Edit Web Filter Type Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-470041]Element
          
  
         		
           
           [bookmark: pgfId-470043]Description
          
  
        

 
         
         		[bookmark: pgfId-470049]Filtering

  
         		[bookmark: pgfId-470051]The type of rule you are defining:

 
           
           		 [bookmark: pgfId-470053]Filter—The rule filters the identified type of traffic between source and destination.

 
           		 [bookmark: pgfId-470055]Filter Except—The rule creates an exemption to a filter rule. The identified traffic between the source and destination is not filtered.

 
          

  
        

 
         
         		[bookmark: pgfId-470061]Type

  
         		[bookmark: pgfId-470066]The type of traffic that should be filtered (or exempted from filtering) for this rule. For filtering that uses an external server, consult the documentation for your version of the server to determine if it supports that type of filtering. Configure the filtering server on the Web Filter Settings Page.

 
           
           		 [bookmark: pgfId-470068]URL—HTTP traffic. Filtering is done using an external filtering server.

 
           		 [bookmark: pgfId-470070]HTTPS—HTTPS traffic. This does not include traffic associated with an SSL VPN. Filtering is done using an external filtering server.

 
           		 [bookmark: pgfId-470072]Java—Remove Java applets from HTTP traffic if they are identified on applet tags. The rule does not remove Java applets from SSL VPN traffic. If the applet tag spans packets, or the code in the tags is larger than the MTU, the Java applet is not removed.

 
           		 [bookmark: pgfId-470074]ActiveX—Remove ActiveX or Java applets from HTTP traffic. The rule removes any item within object or applet tags, which might also remove images and multimedia objects. The rule might not remove applets from SSL VPN traffic. If the object tag spans packets, or the code in the tags is larger than the MTU, the object is not removed.

 
           		 [bookmark: pgfId-470076]FTP—FTP traffic. Filtering is done using an external filtering server.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-471607][bookmark: 52732][bookmark: fwlsvcpg_cncpt_EditWebFilterOptionsDialogBox]Edit Web Filter Options Dialog Box[bookmark: marker-471605]

 
     [bookmark: pgfId-471609]Use the Edit Web Filter Options dialog box to edit the filtering options defined for a web filter rule for ASA, PIX, and FWSM devices.

 
     [bookmark: pgfId-471611]The options displayed on this dialog box differ depending on the type of filtering configured for the rule. For some types, there are no options and the dialog box is empty. The reference table below includes all possible options.

 
     [bookmark: pgfId-471613]Navigation Path

 
     [bookmark: pgfId-471618]Right-click the Options cell in a web filter rule for ASA/PIX/FWSM (on the Web Filter Rules Page (ASA/PIX/FWSM)) and select Edit Web Filter Type. You can edit the type for one row at a time.

 
     [bookmark: pgfId-471620]Field Reference

 
     [bookmark: pgfId-471623] 

 
      
       
        
        [bookmark: pgfId-470089]Table 18-4 [bookmark: 52747]Edit Web Filter Options Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-470095]Element
          
  
         		
           
           [bookmark: pgfId-470097]Description
          
  
        

 
         
         		[bookmark: pgfId-470103]Allow traffic if URL Filter Server unavailable

 [bookmark: pgfId-470105](URL, FTP, HTTPS only)

  
         		[bookmark: pgfId-470107]Whether to permit unfiltered traffic on outbound connections if all of the URL filtering servers are unavailable. If you do not select this option, all affected outbound traffic (HTTP, FTP, or HTTPS) is blocked until at least one filtering server becomes available.

  
        

 
         
         		[bookmark: pgfId-470113]Block connection to HTTP Proxy Server

 [bookmark: pgfId-470115](URL only)

  
         		[bookmark: pgfId-470117]Whether to prevent users from connecting to an HTTP proxy server.

  
        

 
         
         		[bookmark: pgfId-470123]Truncate CGI request by removing CGI parameters

 [bookmark: pgfId-470125](URL only)

  
         		[bookmark: pgfId-470127]When a URL has a parameter list starting with a question mark (?), such as a CGI script, whether to truncate the URL sent to the filtering server by removing all characters after and including the question mark.

  
        

 
         
         		[bookmark: pgfId-470133]Block outbound requests if absolute FTP path is not provided

 [bookmark: pgfId-470135](FTP only)

  
         		[bookmark: pgfId-470137]Whether to prevent interactive FTP sessions that do not provide the entire directory path when the user tries to change directories.

  
        

 
         
         		[bookmark: pgfId-470143]Long URL

 [bookmark: pgfId-470145](URL only)

  
         		[bookmark: pgfId-470147]How to handle URLs that are longer than the maximum allowed by the filtering server: 4 KB for Websense, 3 KB for Smartfilter (N2H2). Many times, long URLs are due to parameter lists, and you can use the Truncate CGI request by removing CGI parameters option to handle those URLs. For other long URLs, select from the following options:

 
           
           		 [bookmark: pgfId-470149]Drop—Drop the long URL request.

 
           		 [bookmark: pgfId-470151]Truncate—Truncate the URL request to only the hostname or IP address portion of the URL.

 
           		 [bookmark: pgfId-470153]Deny—Deny the URL request.

 
          

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-471637][bookmark: 52798][bookmark: porules_proc_AddingWebFilterRulesIOS]Configuring Web Filter Rules for IOS Devices [bookmark: marker-471629][bookmark: marker-471631][bookmark: marker-471633][bookmark: marker-471635]

 
    [bookmark: pgfId-471639]Web filter rules policies for IOS devices define how you want to handle HTTP traffic. The web filter rules are a type of inspection rule that permits or denies traffic based on the Universal Resource Locator (URL) address in the web request. If you allow HTTP traffic on an interface in your access rules, you can subsequently deny (or drop) traffic if it is directed at an objectionable web site.

 
    [bookmark: pgfId-471641]To configure web filtering rules for IOS devices:

 
    [bookmark: pgfId-471643] 1. Configure the interfaces that should filter web traffic (see below for the procedure).

 
    [bookmark: pgfId-471645] 2. Configure the local web filtering list to identify web sites that should always be permitted or denied (see below for the procedure).

 
    [bookmark: pgfId-471650] 3. Configure web filter settings to identify the URL filtering server and other settings. For more information, see Configuring Settings for Web Filter Servers.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-471655]Tip You can also configure web filtering as a zone based firewall rule. For more information, see Adding Zone-Based Firewall Rules.


    
     

    

    

 
    [bookmark: pgfId-471657]Related Topics

 
     
     		 [bookmark: pgfId-471662]Understanding Web Filter Rules

 
     		 [bookmark: pgfId-471667]Understanding Interface Role Objects

 
     		 [bookmark: pgfId-471672]Understanding Networks/Hosts Objects

 
    

 
    
 
    [bookmark: pgfId-471677]Step 1 Do one of the following to open the Web Filter Rules Page (IOS):

 
     
     		 [bookmark: pgfId-471679]Device view—Select  Firewall > Web Filter Rules from the Policy selector.

 
     		 [bookmark: pgfId-471681]Policy view—Select  Firewall > Web Filter Rules (IOS) from the Policy Type select. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-471683]Step 2 Configure the interfaces on which you will filter HTTP traffic. Create rules for each interface on which you will enable filtering:

 
    [bookmark: pgfId-471688] a. Select the Web Filter Rules tab if it is not already selected and do one of the following to open the IOS Web Filter Rule and Applet Scanner Dialog Box:

 
     
     		 [bookmark: pgfId-471690]To create a new rule, right-click inside the work area and select  Add Row .

 
     		 [bookmark: pgfId-471692]To edit an existing rule, right-click the rule and select  Edit Row .

 
    

 
    [bookmark: pgfId-471694] b. Identify the interface for which this rule applies. You can either enter the interface name or click Select to select it or an interface role from the list. Also configure the following:

 
     
     		 [bookmark: pgfId-471696]Traffic direction with respect to the interface—Typically, you want to select  In so that undesired traffic is dropped before the device spends more time processing the packet.

 
     		 [bookmark: pgfId-471698]Java applet scanning—If you enable web filtering on an interface, Java applets are inspected, which can affect performance. Typically, you want to enable Java applet scanning so that you can identify permitted and denied sources and avoid the scanning of denied applets. If you want to configure both permitted and denied sources for an interface, you must configure two rules for the interface.

 
    

 
    [bookmark: pgfId-471700] c. Click OK to add the rule to the web filtering rules table.

 
    [bookmark: pgfId-471705]Step 3 (Optional) Configure the list of exclusive domains, which define the local filtering list. This list is applied before web requests are sent to the external web filtering server (defined on the Web Filter Settings Page). If you know there are web sites that you will always permit (such as your organization’s web site) or deny, configure them in the local list. Configure as many rules as needed to define the complete list.

 
    [bookmark: pgfId-471710] a. Click the Exclusive Domains tab and do one of the following to open the IOS Web Filter Exclusive Domain Name Dialog Box.

 
     
     		 [bookmark: pgfId-471712]To create a new rule, right-click inside the work area and select  Add Row .

 
     		 [bookmark: pgfId-471714]To edit an existing rule, right-click the rule and select  Edit Row .

 
    

 
    [bookmark: pgfId-471716] b. Select whether you are permitting or denying the specified domains, and enter the domain names or host IP addresses. You can enter either full domain names (the names of specific web sites) or partial names (for entire domains you want to treat the same way).

 
    [bookmark: pgfId-471718] c. Click OK to add your exclusive domain rule to the policy.

 
    [bookmark: pgfId-471720]


    
     

    
 
    

 
     
      [bookmark: pgfId-471734][bookmark: 52895][bookmark: fwlsvcpg_cncpt_WebFilterRulesPageIOS]Web Filter Rules Page (IOS)[bookmark: marker-471730][bookmark: marker-471732]

 
     [bookmark: pgfId-471736]Use the Web Filter Rules page for IOS devices to configure web, or URL, filtering rules. Web filtering is a type of HTTP inspection. If your access rules allow HTTP traffic on an interface, you can configure rules to apply local and server-based web filtering to prevent users from accessing undesirable web servers.

 
     [bookmark: pgfId-471741]When you configure web filter rules, also configure web filter settings in the Firewall > Settings > Web Filter policy. The settings identify the web filtering server and contain other settings that control the overall functioning of the policy. For example, you can use the settings policy to allow all web traffic if the filtering server becomes unavailable. For more information, see Web Filter Settings Page.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-471746]Tip You can also configure web filtering as a zone based firewall rule. For more information, see Zone-based Firewall Rules Page.


     
      

     

     

 
     [bookmark: pgfId-471748]Navigation Path

 
     [bookmark: pgfId-471750]To access the Web Filter Rules page for IOS devices, do one of the following:

 
      
      		 [bookmark: pgfId-471752](Device view) Select an IOS device and select  Firewall > Web Filter Rules from the Policy selector.

 
      		 [bookmark: pgfId-471754](Policy view) Select  Firewall > Web Filter Rules (IOS) from the Policy Type selector. Create a new policy or select an existing one.

 
      		 [bookmark: pgfId-471756](Map view) Right-click an IOS device and select  Edit Firewall Policies > Web Filter Rules .

 
     

 
     [bookmark: pgfId-471758]Related Topics

 
      
      		 [bookmark: pgfId-471763]Understanding Web Filter Rules

 
      		 [bookmark: pgfId-471768]Configuring Web Filter Rules for IOS Devices

 
      		 [bookmark: pgfId-471773]Chapter 18, “Managing Firewall Web Filter Rules”

 
     

 
     [bookmark: pgfId-471775]Field Reference

 
     [bookmark: pgfId-471778] 

 
      
       
        
        [bookmark: pgfId-470166]Table 18-5 [bookmark: 52938]Web Filter Rules Page (IOS) 

 
        
       
         
         		
           
           [bookmark: pgfId-470172]Element
          
  
         		
           
           [bookmark: pgfId-470174]Description
          
  
        

 
         
         		[bookmark: pgfId-470180]Web Filter Rules tab

  
         		[bookmark: pgfId-470182]The URL filtering rules defined for the policy. Each rule shows the interface on which it is defined, whether the rule is applied to incoming or outgoing traffic, and the permitted or denied Java applet sources if Java applet scanning is enabled. You might have more than one rule for an interface if you configure both a permit and deny list for Java applet scanning.

 
           
           		 [bookmark: pgfId-470187]To add a rule, click the Add Row button and fill in the IOS Web Filter Rule and Applet Scanner Dialog Box.

 
           		 [bookmark: pgfId-470189]To edit a rule, select it and click the Edit Row button.

 
           		 [bookmark: pgfId-470191]To delete a rule, select it and click the Delete Row button.

 
          

  
        

 
         
         		[bookmark: pgfId-470197]Exclusive Domains tab

  
         		[bookmark: pgfId-470199]The local web filter list. This list is checked before web requests are sent to the filtering server and applies to all interfaces on which you configure web filtering.

 [bookmark: pgfId-470201]If you know there are specific domains that you will always allow (such as your organization’s own domain name), or disallow, you can list them here. By configuring a local filter list, you can improve performance because the device does not need to wait for a response from the filtering server.

 
           
           		 [bookmark: pgfId-470206]To add a domain, click the Add Row button and fill in the IOS Web Filter Exclusive Domain Name Dialog Box.

 
           		 [bookmark: pgfId-470208]To edit a domain, select it and click the Edit Row button.

 
           		 [bookmark: pgfId-470210]To delete a domain, select it and click the Delete Row button.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-471790][bookmark: 52975][bookmark: fwlsvcpg_cncpt_IOSWebFilterRuleandAppletScannerDialogBox]IOS Web Filter Rule and Applet Scanner Dialog Box [bookmark: marker-471786][bookmark: marker-471788]

 
     [bookmark: pgfId-471792]Use the IOS Web Filter Rule and Applet Scanner dialog box to create web filtering rules for IOS devices.

 
     [bookmark: pgfId-471794]Navigation Path

 
     [bookmark: pgfId-471799]To open this dialog box, select the Web Filter Rules tab on the Web Filter Rules Page (IOS), click Add Row to create a new rule, or select a row and click Edit Row to edit an existing rule.

 
     [bookmark: pgfId-471801]Related Topics

 
      
      		 [bookmark: pgfId-471806]Configuring Web Filter Rules for IOS Devices

 
      		 [bookmark: pgfId-471811]Understanding Web Filter Rules

 
      		 [bookmark: pgfId-471816]Chapter 18, “Managing Firewall Web Filter Rules”

 
      		 [bookmark: pgfId-471821]Configuring Settings for Web Filter Servers

 
     

 
     [bookmark: pgfId-471823]Field Reference

 
     [bookmark: pgfId-471826] 

 
      
       
        
        [bookmark: pgfId-470223]Table 18-6 [bookmark: 53008]IOS Web Filter Rule and Applet Scanner Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-470229]Element
          
  
         		
           
           [bookmark: pgfId-470231]Description
          
  
        

 
         
         		[bookmark: pgfId-470237]Enable Web Filtering

  
         		[bookmark: pgfId-470239]Whether to enable the web filtering rule.

  
        

 
         
         		[bookmark: pgfId-470245]Interface

  
         		[bookmark: pgfId-470247]The interface or interface role to which the rule is assigned. Enter the name of the interface or the interface role, or click Select to select the interface or role from a list, or to create a new role. An interface must already be defined to appear on the list.

 [bookmark: pgfId-470252]Interface role objects are replaced with the actual interface names when the configuration is generated for each device. See Understanding Interface Role Objects.

  
        

 
         
         		[bookmark: pgfId-470258]Traffic Direction

  
         		[bookmark: pgfId-470260]The direction of the traffic to which this rule applies:

 
           
           		 [bookmark: pgfId-470262]In—Packets entering an interface.

 
           		 [bookmark: pgfId-470264]Out—Packets exiting an interface.

 
          

  
        

 
         
         		[bookmark: pgfId-470270]Java Applet Scanning

 [bookmark: pgfId-470272]Enable Java Applet Scanner

  
         		[bookmark: pgfId-470274]If you select Enable Java Applet Scanning, the device checks for the presence of Java applets in HTTP traffic coming from web servers to internal hosts. If a Java applet is present and the web server (applet source) is in the list of permitted sources, the Java applet is left unmodified in the HTTP traffic. Otherwise, the Java applets are removed from HTTP pages.

 source.  
        

 
         
         		[bookmark: pgfId-470282]Permit Traffic

 [bookmark: pgfId-470284]Applet Sources

  
         		[bookmark: pgfId-470286]The list of permitted or denied source addresses for Java applets. To configure a list of permitted or denied sources:

 
           
           		 [bookmark: pgfId-470288]Select either  Permit from Specified Sources or  Deny from Specified Sources . If you want to create both a permit and deny list, create two separate web filter rules. If you do not configure a permit list, all sources are denied.

 
           		 [bookmark: pgfId-470293]Enter the list of permitted or denied addresses in the  Applet Sources field. The list can include host IP addresses, network addresses, address ranges, or network/host objects, but cannot include domain names. Separate multiple addresses with commas. For more information on entering addresses, see Specifying IP Addresses During Policy Definition.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-471838][bookmark: 53066][bookmark: fwlsvcpg_cncpt_ExclusiveDomainNameDialogBox]IOS Web Filter Exclusive Domain Name Dialog Box[bookmark: marker-471834][bookmark: marker-471836]

 
     [bookmark: pgfId-471840]Use the IOS Web Filter Exclusive Domain Name dialog box to configure local web filtering rules for IOS devices. You can create a list of permitted or denied domain names or IP addresses. The device checks this list before forwarding web requests to your web filtering server.

 
     [bookmark: pgfId-471842]Using local filtering saves the wait time for getting a response from the server when a user requests a web site that you know you will either always permit or always deny.

 
     [bookmark: pgfId-471844]Navigation Path

 
     [bookmark: pgfId-471849]To open this dialog box, select the Exclusive Domains tab on the Web Filter Rules Page (IOS), click Add Row to create a new rule, or select a row and click Edit Row to edit an existing rule.

 
     [bookmark: pgfId-471851]Related Topics

 
      
      		 [bookmark: pgfId-471856]Configuring Web Filter Rules for IOS Devices

 
      		 [bookmark: pgfId-471861]Understanding Web Filter Rules

 
      		 [bookmark: pgfId-471866]Chapter 18, “Managing Firewall Web Filter Rules”

 
     

 
     [bookmark: pgfId-471868]Field Reference

 
     [bookmark: pgfId-471871] 

 
      
       
        
        [bookmark: pgfId-470306]Table 18-7 [bookmark: 53097]IOS Web Filter Exclusive Domain Name Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-470312]Element
          
  
         		
           
           [bookmark: pgfId-470314]Description
          
  
        

 
         
         		[bookmark: pgfId-470320]Traffic

  
         		[bookmark: pgfId-470322]Whether you want to permit access to the listed web sites or deny access to them.

  
        

 
         
         		[bookmark: pgfId-470328]Domain Name

  
         		[bookmark: pgfId-470330]The domain names or host IP addresses of web sites that you are permitting or denying. Separate multiple entries with commas.

 [bookmark: pgfId-470332]For domain names, you can enter a full or partial name. For example, cisco.com covers all web servers on the cisco.com domain, whereas www.cisco.com specifies only the www web server.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-471887][bookmark: 53121][bookmark: porules_proc_ConfiguringSettingsforWebFilterServers]Configuring Settings for Web Filter Servers[bookmark: marker-471877][bookmark: marker-471879][bookmark: marker-471881][bookmark: marker-471883][bookmark: marker-471885]

 
    [bookmark: pgfId-471889]Use the Web Filter settings policy to configure the web filter servers and other settings to use with your web filter rules policy. You can use Websense or Smartfilter (N2H2) filtering servers, or no external servers (for IOS devices).

 
    [bookmark: pgfId-471891]You must install and configure the web filter servers as directed by the documentation for the server before configuring and deploying this policy. Security Manager cannot confirm that the servers exist or that they are configured correctly.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-471893]Tip These settings work only with the web filter rules policy. The web servers you configure here are not used with zone based firewall rules policies that configure web content filtering.


    
     

    

    

 
    [bookmark: pgfId-471895]Related Topics

 
     
     		 [bookmark: pgfId-471900]Understanding Web Filter Rules

 
     		 [bookmark: pgfId-471905]Configuring Web Filter Rules for ASA, PIX, and FWSM Devices

 
     		 [bookmark: pgfId-471910]Configuring Web Filter Rules for IOS Devices

 
    

 
    
 
    [bookmark: pgfId-471915]Step 1 Do one of the following to open the Web Filter Settings Page:

 
     
     		 [bookmark: pgfId-471917](Device view) Select  Firewall > Settings > Web Filter from the Policy selector.

 
     		 [bookmark: pgfId-471919](Policy view) Select  Firewall > Settings > Web Filter from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-471921]Step 2 Select the type of web filtering server you use in the Web Filter Server Type field, and then add the servers to the table of web filtering servers. If you have more than one server, add them in priority order; the first server in the list is the primary server.

 
     
     		 [bookmark: pgfId-471926]To add a server, click the Add Row button and fill in the Web Filter Server Configuration Dialog Box.

 
     		 [bookmark: pgfId-471928]To edit a server, select it and click the Edit Row button.

 
     		 [bookmark: pgfId-471930]To delete a server, select it and click the Delete Row button.

 
    

 
    [bookmark: pgfId-471935]Step 3 The bottom half of the settings policy includes device-specific options that you can also configure. For specific information on each setting, see Web Filter Settings Page. The following is an overview of the settings:

 
     
     		 [bookmark: pgfId-471937]IOS devices—The most interesting setting is  Allow Traffic when Servers Unreachable , which determines whether you allow any web connections if the filtering servers are unavailable. If you do not select this option, all web traffic is cut off if the servers go offline for any reason.

 
    

 
    [bookmark: pgfId-471939]The remaining settings configure logging and cache size options.

 
     
     		 [bookmark: pgfId-471941]ASA, PIX, FWSM devices—These options configure the cache size and buffer limits used with the filtering servers. You can also control whether the cached responses include both source and destination (if you have different filtering policies per user) or destination only (one policy for all), as configured in the filtering server.

 
    

 
    [bookmark: pgfId-471943]


    
     

    
 
    

 
     
      [bookmark: pgfId-471955][bookmark: 53187][bookmark: fwlsvcpg_cncpt_WebFilterPage]Web Filter Settings Page[bookmark: marker-471951][bookmark: marker-471953]

 
     [bookmark: pgfId-471957]Use the Web Filter settings page to configure the web filter servers and other settings to use with your web filter rules policy.

 
     [bookmark: pgfId-471959]You must install and configure the web filter servers as directed by the documentation for the server before configuring and deploying this policy. Security Manager cannot confirm that the servers exist or that they are configured correctly.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-471961]Tip These settings work only with the web filter rules policy. The web servers you configure here are not used with zone based firewall rules policies that configure web content filtering.


     
      

     

     

 
     [bookmark: pgfId-471963]Navigation Path

 
     [bookmark: pgfId-471965]To access the Web Filter settings page, do one of the following:

 
      
      		 [bookmark: pgfId-471967](Device view) Select a device, then select  Firewall > Settings > Web Filter from the Policy selector.

 
      		 [bookmark: pgfId-471969](Policy view) Select  Firewall > Settings > Web Filter from the Policy Type selector. Create a new policy or select an existing one.

 
      		 [bookmark: pgfId-471971](Map view) Right-click a device and select  Edit Firewall Settings > Web Filter .

 
     

 
     [bookmark: pgfId-471973]Related Topics

 
      
      		 [bookmark: pgfId-471978]Understanding Web Filter Rules

 
      		 [bookmark: pgfId-471983]Configuring Settings for Web Filter Servers

 
      		 [bookmark: pgfId-471988]Configuring Web Filter Rules for ASA, PIX, and FWSM Devices

 
      		 [bookmark: pgfId-471993]Configuring Web Filter Rules for IOS Devices

 
     

 
     [bookmark: pgfId-471995]Field Reference

 
     [bookmark: pgfId-471998] 

 
      
       
        
        [bookmark: pgfId-470345]Table 18-8 [bookmark: 53229]Web Filter Page 

 
        
       
         
         		
           
           [bookmark: pgfId-470351]Element
          
  
         		
           
           [bookmark: pgfId-470353]Description
          
  
        

 
         
         		[bookmark: pgfId-470359]Web Filter Server Type

  
         		[bookmark: pgfId-470361]The type of web filter server you are using:

 
           
           		 [bookmark: pgfId-470363]None—You are not using web filter servers.

 
           		 [bookmark: pgfId-470365]Websense—You use Websense servers.

 
           		 [bookmark: pgfId-470367]Secure Computing SmartFilter/N2H2—You use Smartfilter servers. If you select this option, you can specify the server port to use for communication in the  Port field.

 
          

 does not clear the table. The prompt is to remind you that the list might contain the wrong type of servers.  
        

 
         
         		[bookmark: pgfId-470375]Web Filter Servers table

  
         		[bookmark: pgfId-470377]The servers that the device should use for web filtering. Enter the servers in priority order; the device uses the first one in the list until it fails to respond, and moves to the next server in the list until it gets a response.

 [bookmark: pgfId-470379]If you select None for filter type, this list is ignored.

 
           
           		 [bookmark: pgfId-470384]To add a server, click the  Add Row button and fill in the Web Filter Server Configuration Dialog Box.

 
           		 [bookmark: pgfId-470386]To edit a server, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-470388]To delete a server, select it and click the  Delete Row button.

 
          

  
        

 
         
         		 
           
           [bookmark: pgfId-470394]IOS Specific Settings
          
  
        

 
         
         		[bookmark: pgfId-470402]Allow Traffic when Servers Unreachable

  
         		[bookmark: pgfId-470404]Whether the device should allow web traffic if the web filter servers are not responding. If you do not select this option, all web access is prevented until the servers come back online.

 [bookmark: pgfId-470406]If you allow web traffic when the servers are down, the web requests are not filtered and access to all web servers is allowed.

  
        

 
         
         		[bookmark: pgfId-470412]Enable Alerts

  
         		[bookmark: pgfId-470414]Whether to generate stateful packet inspection alert messages on the console.

  
        

 
         
         		[bookmark: pgfId-470420]Enable Audit Trail

  
         		[bookmark: pgfId-470422]Whether audit trail messages are logged to the syslog server or router.

  
        

 
         
         		[bookmark: pgfId-470428]Enable Web Filter Server Logging

  
         		[bookmark: pgfId-470430]Whether to send system messages to the URL filtering server for logging. The device sends a log request immediately after the URL lookup request. The log request contains the URL, hostname, source IP address, and the destination IP address. The server records the log request into its own log server so you can view this information as necessary.

  
        

 
         
         		[bookmark: pgfId-470436]Cache Size

  
         		[bookmark: pgfId-470438]The maximum number of destination IP addresses (and their authorization status) that can be cached in the device. The default value is 5000.

 [bookmark: pgfId-470440]When the cache reaches 80% full, the device starts removing older inactive entries.

  
        

 
         
         		[bookmark: pgfId-470446]Maximum Requests

  
         		[bookmark: pgfId-470448]The maximum number of outstanding requests that can exist at any given time. If the specified number is exceeded, new requests are dropped. The default is 1000.

  
        

 
         
         		[bookmark: pgfId-470454]Packet Buffer

  
         		[bookmark: pgfId-470456]The maximum number of HTTP responses that can be stored in the packet buffer of the device while it waits for the web filter server to allow or deny the request. The device drops responses when the maximum is reached. The default (and maximum) value is 200.

 [bookmark: pgfId-470458]When users make web requests, the device simultaneously sends the request to the web site and to the web filtering server. If the response from the web site is received before the server provides a permit or deny response, the device keeps the request in the packet buffer until it gets a response from the server.

 [bookmark: pgfId-470460]The response is removed from the buffer when the server responds or if the device determines that the server is unavailable and you also selected Allow Traffic when Servers Unreachable.

  
        

 
         
         		 
           
           [bookmark: pgfId-470466]PIX/ASA/FWSM Specific Settings
          
  
        

 
         
         		[bookmark: pgfId-470474]Cache Match Criteria

  
         		[bookmark: pgfId-470476]How to cache web requests:

 
           
           		 [bookmark: pgfId-470478]Source and Destination—Cache entries are based on both the address initiating the request and the destination web address. Select this mode if users do not share the same filtering policy on the filtering server.

 
           		 [bookmark: pgfId-470480]Destination—Cache entries are based on the destination web address. Select this mode if all users share the same filtering policy on the filtering server.

 
          

  
        

 
         
         		[bookmark: pgfId-470486]URL Buffer Memory

 [bookmark: pgfId-470488](ASA 7.2+, PIX 7.2+ only.)

  
         		[bookmark: pgfId-470490]The size of the URL buffer memory pool in KB. Values are 2 to 10240.

  
        

 
         
         		[bookmark: pgfId-470496]Maximum Allowed URL Size

 [bookmark: pgfId-470498](ASA 7.2+, PIX 7.2+ only.)

  
         		[bookmark: pgfId-470500]The maximum allowed URL size in KB for each URL being buffered. The possible values differ depending on server type:

 
           
           		 [bookmark: pgfId-470502]Websense—From 2 to 4.

 
           		 [bookmark: pgfId-470504]Smartfilter (N2H2)—2 or 3.

 
          

  
        

 
         
         		[bookmark: pgfId-470510]Cache Size

  
         		[bookmark: pgfId-470512]The size of the cache, in KB, for storing responses from the filtering server. Values are 1 to 128.

 [bookmark: pgfId-470514]Caching stores URL access privileges in memory on the security appliance. When a host requests a connection, the security appliance first looks in the URL cache for matching access privileges instead of forwarding the request to the Websense server.

  
        

 
         
         		[bookmark: pgfId-470520]URL Block Buffer Limit

  
         		[bookmark: pgfId-470522]The size of the buffer for storing web server responses while waiting for a filtering decision from the filtering server. The values are 1 to 128, which specifies the number of 1550-byte blocks.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-472018][bookmark: 53359][bookmark: fwlsvcpg_cncpt_WebFilterServerConfigurationDialogBox]Web Filter Server Configuration Dialog Box [bookmark: marker-472006][bookmark: marker-472008][bookmark: marker-472010][bookmark: marker-472012][bookmark: marker-472014][bookmark: marker-472016]

 
     [bookmark: pgfId-472020]Use the Web Filter Server Configuration dialog box to configure the external web filter servers you want to use with your Web Filter Rules policies. You can configure Websense or Smartfilter (N2H2) servers.

 
     [bookmark: pgfId-472022]Navigation Path

 
     [bookmark: pgfId-472027]From the Web Filter Settings Page, click Add Row beneath the Web Filter Servers table, or select a row and click Edit Row.

 
     [bookmark: pgfId-472029]Related Topics

 
      
      		 [bookmark: pgfId-472034]Configuring Settings for Web Filter Servers

 
      		 [bookmark: pgfId-472039]Understanding Web Filter Rules

 
      		 [bookmark: pgfId-472044]Chapter 18, “Managing Firewall Web Filter Rules”

 
     

 
     [bookmark: pgfId-472046]Field Reference

 
     [bookmark: pgfId-472049] 

 
      
       
        
        [bookmark: pgfId-470535]Table 18-9 [bookmark: 53401]Web Filter Server Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-470541]Element
          
  
         		
           
           [bookmark: pgfId-470543]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-470549]Common
          
  
        

 
         
         		[bookmark: pgfId-470557]IP Address

  
         		[bookmark: pgfId-470559]The IP address of the web filter server.

  
        

 
         
         		[bookmark: pgfId-470565]Timeout

  
         		[bookmark: pgfId-470567]The length of time, in seconds, that the device will wait for a response from the web filter server. The default is 5 seconds.

 [bookmark: pgfId-470569]If the request times out, the device tries the next server, if you configure more than one.

  
        

 
         
         		 
           
           [bookmark: pgfId-470575]PIX/ASA/FWSM Specific Settings
          
  
        

 
         
         		[bookmark: pgfId-470583]Interface

  
         		[bookmark: pgfId-470585]The network interface where the authentication server resides, for example, FastEthernet0. If not specified, the default is inside.

 [bookmark: pgfId-470587]Enter the name of the interface or the interface role that identifies it, or click Select to select the interface or role from a list, or to create a new role. An interface must already be defined to appear on the list.

  
        

 
         
         		[bookmark: pgfId-470593]Protocol

  
         		[bookmark: pgfId-470595]The protocol to use when communicating with the web filtering server. Select the option for which the server is configured:

 
           
           		 [bookmark: pgfId-470597]TCP (version 1)

 
           		 [bookmark: pgfId-470599]TCP version 4

 
           		 [bookmark: pgfId-470601]UDP version 4

 
          

  
        

 
         
         		[bookmark: pgfId-470607]Connection Number

  
         		[bookmark: pgfId-470609](Optional) The maximum number of TCP connections allowed between the device and the server.

  
        

 
         
         		 
           
           [bookmark: pgfId-470615]IOS Specific Settings
          
  
        

 
         
         		[bookmark: pgfId-470623]Retransmit

  
         		[bookmark: pgfId-470625]The number of times the device will retransmit a request when the server does not respond. The default value is two times.

  
        

 
         
         		[bookmark: pgfId-470631]Port

  
         		[bookmark: pgfId-470633]The port number that the server listens on. The default port is 15868.
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     [bookmark: pgfId-72530][bookmark: 120341][bookmark: pxchap_cncpt_ConfiguringRoutingPoliciesonFirewallDevices]Configuring Routing Policies on Firewall Devices[bookmark: marker-72526][bookmark: marker-72528]
      
      
 
     
 

 
    [bookmark: pgfId-72532]The Routing section in Security Manager contains pages for defining and managing routing settings for security appliances.

 
    [bookmark: pgfId-72534]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-72539]Configuring No Proxy ARP

 
     		 [bookmark: pgfId-72544]Configuring BGP

 
     		 [bookmark: pgfId-72549]Configuring EIGRP

 
     		 [bookmark: pgfId-72554]Configuring OSPF

 
     		 [bookmark: pgfId-72559]Configuring OSPFv3

 
     		 [bookmark: pgfId-72564]Configuring RIP

 
     		 [bookmark: pgfId-72569]Configuring Static Routes

 
     		 [bookmark: pgfId-72574]Configuring Policy Objects for ASA Routing Policies

 
    

 
   
 
    
     [bookmark: pgfId-72592][bookmark: 120351][bookmark: pxpage_cncpt_NoProxyARPPage]Configuring No Proxy ARP[bookmark: marker-72586][bookmark: marker-72588][bookmark: marker-72590]

 
    [bookmark: pgfId-72594]When a host sends IP traffic to another device on the same Ethernet network, the host needs to know the MAC address of the device. Address Resolution Protocol (ARP) is a Layer 2 protocol that resolves an IP address to a MAC address: a host sends an ARP request asking “Who is this IP address?” The device owning the IP address replies, “I own that IP address; here is my MAC address.”

 
    [bookmark: pgfId-72596]With Proxy ARP, a device responds to an ARP request with its own MAC address, even though the device does not own the IP address. Serving as an ARP Proxy for another host effectively directs network traffic to the proxy, in this case your security appliance. Traffic that passes through the appliance is then routed to the appropriate destination.

 
    [bookmark: pgfId-72598]For example, the security appliance uses proxy ARP when you configure NAT and specify a global address that is on the same network as the appliance interface. The only way traffic can reach the destination hosts is if the appliance claims and subsequently routes traffic to the destination global addresses.

 
    [bookmark: pgfId-72600]By default, proxy ARP is enabled for all interfaces. Use the No Proxy ARP page to disable proxy ARP for global addresses:

 
     
     		 [bookmark: pgfId-72602]To disable proxy ARP for one or more interfaces, enter their names in the Interfaces field. Separate multiple interfaces with commas. You can click Select to choose the interfaces from a list of interfaces defined on the device, and interface roles defined in Security Manager.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-72606]Note On ASA 8.4.2 and later devices operating in routed mode, you can disable Proxy ARP on the egress interface for a Manual NAT rule. See Do not proxy ARP on Destination Interface for more information.


    
     

    

    

 
    [bookmark: pgfId-72608]Navigation Path

 
     
     		 [bookmark: pgfId-72610](Device view) Select  Platform > Routing > No Proxy ARP from the Device Policy selector.

 
     		 [bookmark: pgfId-72612](Policy view) Select  PIX/ASA/FWSM Platform > Routing > No Proxy ARP from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-72614]Related Topics

 
     
     		 [bookmark: pgfId-72619]Configuring Static Routes

 
     		 [bookmark: pgfId-72624]Configuring RIP

 
     		 [bookmark: pgfId-72629]Configuring OSPF

 
    

 
   
 
    
     [bookmark: pgfId-72643][bookmark: 120398][bookmark: pxpage_cncpt_BGPPage]Configuring BGP[bookmark: marker-72637][bookmark: marker-72639][bookmark: marker-72641]

 
    [bookmark: pgfId-72645]Border Gateway Protocol (BGP) is an inter autonomous system routing protocol. An autonomous system is a network or group of networks under a common administration and with common routing policies. BGP is used to exchange routing information for the Internet and is the protocol used between Internet service providers (ISP).

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-72647]Note BGP configuration is supported on ASA 9.2(1)+ only. Also, beginning with ASA 9.3(1), BGP is supported in L2 (EtherChannel Type) and L3 (Individual Interface Type) clustering modes.


    
     

    

    

 
    [bookmark: pgfId-72649]Navigation Path

 
     
     		 [bookmark: pgfId-72651](Device view) Select  Platform > Routing > BGP from the Device Policy selector.

 
     		 [bookmark: pgfId-72653](Policy view) Select  PIX/ASA/FWSM Platform > Routing > BGP from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-72655]The BGP page provides two tabbed panels for configuring BGP routing on a firewall device. This is the basic procedure for configuring the BGP process:

 
    [bookmark: pgfId-72657] 1. Enable the BGP routing process by checking the Enable BGP check box on the BGP page.

 
    [bookmark: pgfId-72659] 2. In the AS Number field, enter the autonomous system (AS) number for the BGP process. The AS number internally includes multiple autonomous numbers. The AS number can be from 1 to 4294967295 or from 1.0 to 65535.65535.

 
    [bookmark: pgfId-72664] 3. On the General Tab:

 
    [bookmark: pgfId-72666] – (Optional) Check the Limit the number of AS numbers in AS_PATH attribute of received routes check box to restrict the number of AS numbers in AS_PATH attribute to a specific number. Valid values are from 1 to 254.

 
    [bookmark: pgfId-72668] – (Optional) Check the Log Neighbor Changes check box to enable logging of BGP neighbor changes (up or down) and resets. This helps in troubleshooting network connectivity problems and measuring network stability.

 
    [bookmark: pgfId-72670] – (Optional) Check the Use TCP path MTU Discovery check box to use the Path MTU Discovery technique to determine the maximum transmission unit (MTU) size on the network path between two IP hosts. This avoids IP fragmentation.

 
    [bookmark: pgfId-72672] – (Optional) Check the Enable fast external failover check box to reset the external BGP session immediately upon link failure.

 
    [bookmark: pgfId-72674] – (Optional) Check the Enforce that the first AS is peer’s AS for EBGP routes check box to discard incoming updates received from external BGP peers that do not list their AS number as the first segment in the AS_PATH attribute. This prevents a mis-configured or unauthorized peer from misdirecting traffic by advertising a route as if it was sourced from another autonomous system.

 
    [bookmark: pgfId-72676] – (Optional) Check the Use dot notation for AS numbers check box to split the full binary 4-byte AS number into two words of 16 bits each, separated by a dot. AS numbers from 0-65553 are represented as decimal numbers and AS numbers larger than 65535 are represented using the dot notation.

 
    [bookmark: pgfId-72681] – Define the configuration related to the best path selection process for BGP routing (see General Tab).

 
    [bookmark: pgfId-72686] – Specify the timer information in the Neighbor timers area (see General Tab).

 
    [bookmark: pgfId-72691] – (Optional) Configure Graceful Restart (see General Tab).

 
    [bookmark: pgfId-72696] 4. On the IPv4 Family tab, select the Enable IPv4 Family check box and then use the tabs provided to configure IPv4 Address Family settings. For more information, see IPv4 Family Tab.

 
    [bookmark: pgfId-72701] 5. On the IPv6 Family tab, select the Enable IPv6 Family check box and then use the tabs provided to configure IPv6 Address Family settings. For more information, see IPv6 Family Tab

 
    [bookmark: pgfId-72703]Related Topics

 
     
     		 [bookmark: pgfId-72708]About BGP

 
    

 
     
      [bookmark: pgfId-72720][bookmark: 120466][bookmark: pxpage_cncpt_BGPAbout]About BGP[bookmark: marker-72714][bookmark: marker-72716][bookmark: marker-72718]

 
     [bookmark: pgfId-72722]BGP is an inter autonomous system routing protocol. An autonomous system is a network or group of networks under a common administration and with common routing policies. BGP is used to exchange routing information for the Internet and is the protocol used between Internet service providers (ISP).

 
     [bookmark: pgfId-72724]When to Use BGP

 
     [bookmark: pgfId-72726]Customer networks, such as universities and corporations, usually employ an Interior Gateway Protocol (IGP) such as OSPF for the exchange of routing information within their networks. Customers connect to ISPs, and ISPs use BGP to exchange customer and ISP routes. When BGP is used between autonomous systems (AS), the protocol is referred to as External BGP (EBGP). If a service provider is using BGP to exchange routes within an AS, then the protocol is referred to as Interior BGP (IBGP).

 
     [bookmark: pgfId-72728]Routing Table Changes

 
     [bookmark: pgfId-72730]BGP neighbors exchange full routing information when the TCP connection between neighbors is first established. When changes to the routing table are detected, the BGP routers send to their neighbors only those routes that have changed. BGP routers do not send periodic routing updates, and BGP routing updates advertise only the optimal path to a destination network.

 
     [bookmark: pgfId-72732]Routes learned via BGP have properties that are used to determine the best route to a destination, when multiple paths exist to a particular destination. These properties are referred to as BGP attributes and are used in the route selection process:

 
      
      		 [bookmark: pgfId-72734]Weight -- This is a Cisco-defined attribute that is local to a router. The weight attribute is not advertised to neighboring routers. If the router learns about more than one route to the same destination, the route with the highest weight is preferred.

 
      		 [bookmark: pgfId-72736]Local preference -- The local preference attribute is used to select an exit point from the local AS. Unlike the weight attribute, the local preference attribute is propagated throughout the local AS. If there are multiple exit points from the AS, the exit point with the highest local preference attribute is used as an exit point for a specific route.

 
      		 [bookmark: pgfId-72738]Multi-exit discriminator -- The multi-exit discriminator (MED) or metric attribute is used as a suggestion to an external AS regarding the preferred route into the AS that is advertising the metric. It is referred to as a suggestion because the external AS that is receiving the MEDs may also be using other BGP attributes for route selection. The route with the lower MED metric is preferred.

 
      		 [bookmark: pgfId-72740]Origin -- The origin attribute indicates how BGP learned about a particular route. The origin attribute can have one of three possible values and is used in route selection.

 
     

 
     [bookmark: pgfId-72742] – IGP- The route is interior to the originating AS. This value is set when the network router configuration command is used to inject the route into BGP.

 
     [bookmark: pgfId-72744] – EGP-The route is learned via the Exterior Border Gateway Protocol (EBGP).

 
     [bookmark: pgfId-72746] – Incomplete- The origin of the route is unknown or learned in some other way. An origin of incomplete occurs when a route is redistributed into BGP.

 
      
      		 [bookmark: pgfId-72748]AS_path -- When a route advertisement passes through an autonomous system, the AS number is added to an ordered list of AS numbers that the route advertisement has traversed. Only the route with the shortest AS_path list is installed in the IP routing table.

 
      		 [bookmark: pgfId-72750]Next hop -- The EBGP next-hop attribute is the IP address that is used to reach the advertising router. For EBGP peers, the next-hop address is the IP address of the connection between the peers. For IBGP, the EBGP next-hop address is carried into the local AS.

 
      		 [bookmark: pgfId-72752]Community -- The community attribute provides a way of grouping destinations, called communities, to which routing decisions (such as acceptance, preference, and redistribution) can be applied. Route maps are used to set the community attribute. The predefined community attributes are as follows:

 
     

 
     [bookmark: pgfId-72754] – no-export- Do not advertise this route to EBGP peers.

 
     [bookmark: pgfId-72756] – no-advertise- Do not advertise this route to any peer.

 
     [bookmark: pgfId-72758] – internet- Advertise this route to the Internet community; all routers in the network belong to it.

 
     [bookmark: pgfId-72760]BGP Path Selection

 
     [bookmark: pgfId-72762]BGP may receive multiple advertisements for the same route from different sources. BGP selects only one path as the best path. When this path is selected, BGP puts the selected path in the IP routing table and propagates the path to its neighbors. BGP uses the following criteria, in the order presented, to select a path for a destination:

 
      
      		 [bookmark: pgfId-72764]If the path specifies a next hop that is inaccessible, drop the update.

 
      		 [bookmark: pgfId-72766]Prefer the path with the largest weight.

 
      		 [bookmark: pgfId-72768]If the weights are the same, prefer the path with the largest local preference.

 
      		 [bookmark: pgfId-72770]If the local preferences are the same, prefer the path that was originated by BGP running on this router.

 
      		 [bookmark: pgfId-72772]If no route was originated, prefer the route that has the shortest AS_path.

 
      		 [bookmark: pgfId-72774]If all paths have the same AS_path length, prefer the path with the lowest origin type (where IGP is lower than EGP, and EGP is lower than incomplete).

 
      		 [bookmark: pgfId-72776]If the origin codes are the same, prefer the path with the lowest MED attribute.

 
      		 [bookmark: pgfId-72778]If the paths have the same MED, prefer the external path over the internal path.

 
      		 [bookmark: pgfId-72780]If the paths are still the same, prefer the path through the closest IGP neighbor.

 
      		 [bookmark: pgfId-72782]If both paths are external, prefer the path that was received first (the oldest one).

 
      		 [bookmark: pgfId-72784]Prefer the path with the lowest IP address, as specified by the BGP router ID.

 
      		 [bookmark: pgfId-72786]If the originator or router ID is the same for multiple paths, prefer the path with the minimum cluster list length.

 
      		 [bookmark: pgfId-72788]Prefer the path that comes from the lowest neighbor address.

 
     

 
    
 
     
      [bookmark: pgfId-72800][bookmark: 120547][bookmark: pxpage_cncpt_BGPGeneralTab]General Tab[bookmark: marker-72794][bookmark: marker-72796][bookmark: marker-72798]

 
     [bookmark: pgfId-72802]Use the General tab to configure BGP settings such as Best Path Selection, Neighbor Timers, and Graceful Restart.

 
     [bookmark: pgfId-72804]Navigation Path

 
     [bookmark: pgfId-72809]You can access the Neighbors tab from the BGP page (see Configuring BGP).

 
     [bookmark: pgfId-72811]Related Topics

 
      
      		 [bookmark: pgfId-72816]Configuring BGP

 
      		 [bookmark: pgfId-72821]About BGP

 
      		 [bookmark: pgfId-72826]IPv4 Family Tab

 
     

 
     [bookmark: pgfId-72828]Field Reference

 
     [bookmark: pgfId-72831] 

 
      
       
        
        [bookmark: pgfId-63825]Table 55-1 [bookmark: 120581]General Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-63831]Element
          
  
         		
           
           [bookmark: pgfId-63833]Description
          
  
        

 
         
         		[bookmark: pgfId-63839]Limit the number of AS numbers in AS_PATH attribute of received routes

  
         		[bookmark: pgfId-63841]Restricts the number of AS numbers in AS_PATH attribute to a specific number. Valid values are from 1 to 254.

  
        

 
         
         		[bookmark: pgfId-63847]Log Neighbor Changes

  
         		[bookmark: pgfId-63849]Enables logging of BGP neighbor changes (up or down) and resets. This helps in troubleshooting network connectivity problems and measuring network stability.

  
        

 
         
         		[bookmark: pgfId-63855]Use TCP path MTU Discovery

  
         		[bookmark: pgfId-63857]Enables the use of the Path MTU Discovery technique to determine the maximum transmission unit (MTU) size on the network path between two IP hosts. This avoids IP fragmentation.

  
        

 
         
         		[bookmark: pgfId-63863]Enable fast external failover

  
         		[bookmark: pgfId-63865]Resets the external BGP session immediately upon link failure.

  
        

 
         
         		[bookmark: pgfId-63871]Enforce that the first AS is peer’s AS for EBGP routes

  
         		[bookmark: pgfId-63873]Discards incoming updates received from external BGP peers that do not list their AS number as the first segment in the AS_PATH attribute. This prevents a mis-configured or unauthorized peer from misdirecting traffic by advertising a route as if it was sourced from another autonomous system.

  
        

 
         
         		[bookmark: pgfId-63879]Use dot notation for AS numbers

  
         		[bookmark: pgfId-63881]Splits the full binary 4-byte AS number into two words of 16 bits each, separated by a dot. AS numbers from 0-65553 are represented as decimal numbers and AS numbers larger than 65535 are represented using the dot notation.

  
        

 
         
         		 
           
           [bookmark: pgfId-63887]Best Path Selection
          
  
        

 
         
         		[bookmark: pgfId-63895]Default local preference

  
         		[bookmark: pgfId-63897]Specify a value between 0 and 4294967295. The default value is 100. Higher values indicate higher preference. This preference is sent to all routers and access servers in the local autonomous system.

  
        

 
         
         		[bookmark: pgfId-63903]Allow comparing MED from different neighbors

  
         		[bookmark: pgfId-63905]Allows the comparison of Multi Exit Discriminator (MED) for paths from neighbors in different autonomous systems.

  
        

 
         
         		[bookmark: pgfId-63911]Compare Router-id for identical EBGP paths

  
         		[bookmark: pgfId-63913]Compares similar paths received from external BGP peers during the best path selection process and switches the best path to the route with the lowest router ID.

  
        

 
         
         		[bookmark: pgfId-63919]Pick the best MED path among paths advertised from the neighboring AS

  
         		[bookmark: pgfId-63921]Enables MED comparison among paths learned from confederation peers. The comparison between MEDs is made only if no external autonomous systems are there in the path.

  
        

 
         
         		[bookmark: pgfId-63927]Treat missing MED as the least preferred one

  
         		[bookmark: pgfId-63929]Considers the missing MED attribute as having a value of infinity, making the path the least desirable; therefore, a path with a missing MED is least preferred.

  
        

 
         
         		 [bookmark: pgfId-63935]Neighbor Timers

  
        

 
         
         		[bookmark: pgfId-63943]Keepalive Interval

  
         		[bookmark: pgfId-63945]Enter the time interval for which the BGP neighbor remains active after not sending a keepalive message. At the end of this keepalive interval, the BGP peer is declared dead, if no messages are sent. The default value is 60 seconds.

  
        

 
         
         		[bookmark: pgfId-63951]Hold Time

  
         		[bookmark: pgfId-63953]Enter the time interval for which the BGP neighbor remains active while a BGP connection is being initiated and configured. The default values is 180 seconds.

  
        

 
         
         		[bookmark: pgfId-63959]Min Hold Time

  
         		[bookmark: pgfId-63961](Optional) Enter the minimum time interval for which the BGP neighbor remains active while a BGP connection is being initiated and configured. Specify a value from 0 to 65535.

  
        

 
         
         		 [bookmark: pgfId-63967]Graceful Restart (Use in failover or spanned cluster mode)

 [bookmark: pgfId-63969](ASA 9.3.1+ only)

  
        

 
         
         		[bookmark: pgfId-63977]Enable Graceful Restart

  
         		[bookmark: pgfId-63979]Enables ASA peers to avoid a routing flap following a switchover.

  
        

 
         
         		[bookmark: pgfId-63985]Restart Time

  
         		[bookmark: pgfId-63987]Specify the time duration that ASA peers will wait to delete stale routes before a BGP open message is received. The default value is 120 seconds. Valid values are between 1 and 3600 seconds.

  
        

 
         
         		[bookmark: pgfId-63993]Stalepath Time

  
         		[bookmark: pgfId-63995]Enter the time duration that the ASA will wait before deleting stale routes after an end of record (EOR) message is received from the restarting ASA. The default value is 360 seconds. Valid values are between 1 and 3600 seconds.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-72843][bookmark: 120692][bookmark: pxpage_cncpt_BGPIPv4FamilyTab]IPv4 Family Tab[bookmark: marker-72837][bookmark: marker-72839][bookmark: marker-72841]

 
     [bookmark: pgfId-72845]Use the IPv4 Family tab on the BGP page to enable and configure IPv4 settings for BGP.

 
     [bookmark: pgfId-72847]Navigation Path

 
     [bookmark: pgfId-72852]You can access the IPv4 Family tab from the BGP page. For more information about the BGP page, see Configuring BGP.

 
     [bookmark: pgfId-72854]Related Topics

 
      
      		 [bookmark: pgfId-72859]About BGP

 
      		 [bookmark: pgfId-72864]General Tab

 
     

 
     [bookmark: pgfId-72866]Field Reference

 
     [bookmark: pgfId-72869] 

 
      
       
        
        [bookmark: pgfId-64008]Table 55-2 [bookmark: 120723]IPv4 Family - Aggregate Address Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-64014]Element
          
  
         		
           
           [bookmark: pgfId-64016]Description
          
  
        

 
         
         		[bookmark: pgfId-64022]Enable IPv4 Family

  
         		[bookmark: pgfId-64024]Enables configuration of routing sessions that use standard IPv4 address prefixes.

  
        

 
         
         		[bookmark: pgfId-64030]General

  
         		[bookmark: pgfId-64035]Use this panel to configure general IPv4 settings such as Best Path Selection, Neighbor Timers, and Graceful Restart. See IPv4 Family - General Tab for more about these definitions.

  
        

 
         
         		[bookmark: pgfId-64041]Aggregate Address

  
         		[bookmark: pgfId-64043]Use this panel to define the aggregation of specific routes into one route.

 [bookmark: pgfId-64045]Specify a value for the aggregate timer (in seconds) in the Aggregate Timer field. Valid values are 0 or any value between 6 and 60. The default value is 30.

 [bookmark: pgfId-64050]See Add/Edit Aggregate Address Dialog Box for more about these definitions.

  
        

 
         
         		[bookmark: pgfId-64056]Filtering

  
         		[bookmark: pgfId-64061]Use this panel to filter routes or networks received in incoming BGP updates. See Add/Edit Filter Dialog Box for more about these definitions.

  
        

 
         
         		[bookmark: pgfId-64067]Neighbor

  
         		[bookmark: pgfId-64072]Use this panel to define BGP neighbors and neighbor settings. See Add/Edit Neighbor Dialog Box for more about these definitions.

  
        

 
         
         		[bookmark: pgfId-64078]Networks

  
         		[bookmark: pgfId-64083]Use this panel to define the networks to be advertised by the BGP routing process. See Add/Edit Network Dialog Box for more about these definitions.

  
        

 
         
         		[bookmark: pgfId-64089]Redistribution

  
         		[bookmark: pgfId-64094]Use this panel to define the conditions for redistributing routes from another routing domain into BGP. See Add/Edit Redistribution Dialog Box for more about these definitions.

  
        

 
         
         		[bookmark: pgfId-64100]Route Injection

  
         		[bookmark: pgfId-64105]Use this panel to define the routes to be conditionally injected into the BGP routing table. See Add/Edit Route Injection Dialog Box for more about these definitions.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-72881][bookmark: 120782][bookmark: pxpage_cncpt_BGPIPv4FamilyGeneralTab]IPv4 Family - General Tab[bookmark: marker-72875][bookmark: marker-72877][bookmark: marker-72879]

 
     [bookmark: pgfId-72883]Use the IPv4 Family - General tab to configure the general IPv4 settings.

 
     [bookmark: pgfId-72885]Navigation Path

 
     [bookmark: pgfId-72890]You can access the General tab from the IPv4 Family Tab on the BGP page. For more information about the IPv4 Family tab, see IPv4 Family Tab.

 
     [bookmark: pgfId-72892]Related Topics

 
      
      		 [bookmark: pgfId-72897]Configuring BGP

 
      		 [bookmark: pgfId-72902]About BGP

 
     

 
     [bookmark: pgfId-72904]Field Reference

 
     [bookmark: pgfId-72907] 

 
      
       
        
        [bookmark: pgfId-64118]Table 55-3 [bookmark: 120813]IPv4 Family - General Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-64124]Element
          
  
         		
           
           [bookmark: pgfId-64126]Description
          
  
        

 
         
         		[bookmark: pgfId-64132]Router ID

  
         		[bookmark: pgfId-64134]On a single device, choose Automatic or IP Address. (An address field appears when you choose IP Address.)

 [bookmark: pgfId-64136]If you choose Automatic, the highest-level IP address on the security appliance is used as the router ID. To use a fixed router ID, choose IP Address and enter an IPv4 address in the Router ID field.

 [bookmark: pgfId-64138]On a device cluster, choose Automatic or Cluster Pool. (An IPv4 Pool object ID field appears when you choose Cluster Pool.)

 [bookmark: pgfId-64143]If you choose Cluster Pool, enter or Select the name of the IPv4 Pool object that is to supply the Router ID address. For more information, see Add or Edit IPv4 Pool Dialog Box.

  
        

 
         
         		[bookmark: pgfId-64149]Learned Route Map

  
         		[bookmark: pgfId-64151]Enter or Select the name of a route map object.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-64162]Scanning Interval

  
         		[bookmark: pgfId-64164]Enter a scanning interval (in seconds) for BGP routers for next-hop validation. Valid values are from 5 to 60 seconds. The default value is 60.

  
        

 
         
         		 
           
           [bookmark: pgfId-64170]Routes and Synchronization
          
  
        

 
         
         		[bookmark: pgfId-64178]Generate Default Route

  
         		[bookmark: pgfId-64180](Optional) Configures a BGP routing process to distribute a default route (network 0.0.0.0).

  
        

 
         
         		[bookmark: pgfId-64186]Summarize subnet routes into network-level routes

  
         		[bookmark: pgfId-64188](Optional) Configures automatic summarization of subnet routes into network-level routes.

  
        

 
         
         		[bookmark: pgfId-64194]Advertise inactive routes

  
         		[bookmark: pgfId-64196](Optional) Advertises routes that are not installed in the routing information base (RIB).

  
        

 
         
         		[bookmark: pgfId-64202]Synchronize between BGP and the Interior Gateway Protocol (IGP) system

  
         		[bookmark: pgfId-64204]Enables synchronization between BGP and your Interior Gateway Protocol (IGP) system. To enable the Cisco IOS software to advertise a network route without waiting for the IGP, deselect this option.

 [bookmark: pgfId-64206]Usually, a BGP speaker does not advertise a route to an external neighbor unless that route is local or exists in the IGP. By default, synchronization between BGP and the IGP is turned off to allow the Cisco IOS software to advertise a network route without waiting for route validation from the IGP. This feature allows routers and access servers within an autonomous system to have the route before BGP makes it available to other autonomous systems. Use synchronization if routers in the autonomous system do not speak BGP.

  
        

 
         
         		[bookmark: pgfId-64212]Redistribute iBGP into an IGP

  
         		[bookmark: pgfId-64214](Optional) Configures iBGP redistribution into an interior gateway protocol (IGP), such as IS-IS or OSPF.

  
        

 
         
         		 
           
           [bookmark: pgfId-64220]Administrative Route Distances
          
  
        

 
         
         		[bookmark: pgfId-64228]External

  
         		[bookmark: pgfId-64230]Specifies the administrative distance for external BGP routes. Routes are external when learned from an external autonomous system. The range of values for this argument are from 1 to 255. The default value is 20.

  
        

 
         
         		[bookmark: pgfId-64236]Internal

  
         		[bookmark: pgfId-64238]Specifies administrative distance for internal BGP routes. Routes are internal when learned from peer in the local autonomous system. The range of values for this argument are from 1 to 255. The default value is 200.

  
        

 
         
         		[bookmark: pgfId-64244]Local

  
         		[bookmark: pgfId-64246]Specifies administrative distance for local BGP routes. Local routes are those networks listed with a network router configuration command, often as back doors, for the router or for the networks that is being redistributed from another process. The range of values for this argument are from 1 to 255. The default value is 200.

  
        

 
         
         		 
           
           [bookmark: pgfId-64252]Next Hop
          
  
        

 
         
         		[bookmark: pgfId-64260]Enable address tracking

  
         		[bookmark: pgfId-64262](Optional) Enables BGP next hop address tracking.

  
        

 
         
         		[bookmark: pgfId-64268]Delay Interval

  
         		[bookmark: pgfId-64270]Specify the delay interval between checks on updated next-hop routes installed in the routing table.

  
        

 
         
         		 
           
           [bookmark: pgfId-64276]Forward packets over Multiple Paths
          
  
        

 
         
         		[bookmark: pgfId-64284]Number of Paths

  
         		[bookmark: pgfId-64286](Optional) Specify the maximum number of external BGP routes that can be installed to the routing table.

  
        

 
         
         		[bookmark: pgfId-64292]IBGP Number of Paths

  
         		[bookmark: pgfId-64294](Optional) Specify the maximum number of internal BGP routes that can be installed to the routing table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-72921][bookmark: 120931][bookmark: pxpage_cncpt_BGPIPv4AddEditAggregateAddressDialogBox]Add/Edit Aggregate Address Dialog Box[bookmark: marker-72915][bookmark: marker-72917][bookmark: marker-72919]

 
     [bookmark: pgfId-72923]Use the Add/Edit Aggregate Address dialog box to define the aggregation of specific routes into one route.

 
     [bookmark: pgfId-72925]Navigation Path

 
     [bookmark: pgfId-72930]You can access the Add/Edit Aggregate Address dialog box from the IPv4 Family Tab.

 
     [bookmark: pgfId-72932]Related Topics

 
      
      		 [bookmark: pgfId-72937]Configuring BGP

 
      		 [bookmark: pgfId-72942]About BGP

 
      		 [bookmark: pgfId-72947]IPv4 Family - General Tab

 
      		 [bookmark: pgfId-72952]Add/Edit Filter Dialog Box

 
      		 [bookmark: pgfId-72957]Add/Edit Neighbor Dialog Box

 
      		 [bookmark: pgfId-72962]Add/Edit Network Dialog Box

 
      		 [bookmark: pgfId-72967]Add/Edit Redistribution Dialog Box

 
      		 [bookmark: pgfId-72972]Add/Edit Route Injection Dialog Box

 
     

 
     [bookmark: pgfId-72974]Field Reference

 
     [bookmark: pgfId-72977] 

 
      
       
        
        [bookmark: pgfId-64307]Table 55-4 [bookmark: 120981]Add/Edit Aggregate Address Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-64313]Element
          
  
         		
           
           [bookmark: pgfId-64315]Description
          
  
        

 
         
         		[bookmark: pgfId-64321]Network

  
         		[bookmark: pgfId-64323]Enter an IP address, or enter or Select the desired Network/Hosts objects.

  
        

 
         
         		[bookmark: pgfId-64329]Attribute Map

  
         		[bookmark: pgfId-64331](Optional) Enter or Select the route map used to set the attribute of the aggregate route.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-64342]Advertise Map

  
         		[bookmark: pgfId-64344](Optional) Enter or Select the route map used to select the routes to create AS_SET origin communities.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-64355]Suppress Map

  
         		[bookmark: pgfId-64357](Optional) Enter or Select the route map used to select the routes to be suppressed.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-64368]Generate AS Set Path Information

  
         		[bookmark: pgfId-64370]Enables generation of autonomous system set path information.

  
        

 
         
         		[bookmark: pgfId-64376]Filter all more-specific routes from updates

  
         		[bookmark: pgfId-64378]Filters all more-specific routes from updates.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-72991][bookmark: 121031][bookmark: pxpage_cncpt_BGPIPv4AddEditFilterDialogBox]Add/Edit Filter Dialog Box[bookmark: marker-72985][bookmark: marker-72987][bookmark: marker-72989]

 
     [bookmark: pgfId-72993]Use the Add/Edit Filter dialog box to filter routes or networks received in incoming BGP updates.

 
     [bookmark: pgfId-72995]Navigation Path

 
     [bookmark: pgfId-73000]You can access the Add/Edit Filter dialog box from the IPv4 Family Tab.

 
     [bookmark: pgfId-73002]Related Topics

 
      
      		 [bookmark: pgfId-73007]Configuring BGP

 
      		 [bookmark: pgfId-73012]About BGP

 
      		 [bookmark: pgfId-73017]IPv4 Family - General Tab

 
      		 [bookmark: pgfId-73022]Add/Edit Aggregate Address Dialog Box

 
      		 [bookmark: pgfId-73027]Add/Edit Neighbor Dialog Box

 
      		 [bookmark: pgfId-73032]Add/Edit Network Dialog Box

 
      		 [bookmark: pgfId-73037]Add/Edit Redistribution Dialog Box

 
      		 [bookmark: pgfId-73042]Add/Edit Route Injection Dialog Box

 
     

 
     [bookmark: pgfId-73044]Field Reference

 
     [bookmark: pgfId-73047] 

 
      
       
        
        [bookmark: pgfId-64391]Table 55-5 [bookmark: 121081]Add/Edit Filter Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-64397]Element
          
  
         		
           
           [bookmark: pgfId-64399]Description
          
  
        

 
         
         		[bookmark: pgfId-64405]ACL

  
         		[bookmark: pgfId-64407]Select an Access Control List that defines which networks are to be received and which are to be suppressed in routing updates.

  
        

 
         
         		[bookmark: pgfId-64413]Direction

  
         		[bookmark: pgfId-64415]Choose a direction from the Direction drop-down list. The direction will specify if the filter should be applied to inbound updates or outbound updates.

  
        

 
         
         		[bookmark: pgfId-64421]Protocol

  
         		[bookmark: pgfId-64423]Select the routing process for which you want to filter: None, BGP, Connected, EIGRP, OSPF, RIP, or Static.

  
        

 
         
         		[bookmark: pgfId-64429]AS Number

  
         		[bookmark: pgfId-64434]Shows the autonomous system number of the BGP routing process. This value is specified on the BGP page (see Configuring BGP).

  
        

 
         
         		[bookmark: pgfId-64440]Process ID

  
         		[bookmark: pgfId-64442]Enter the identifier for the routing process. Applies to EIGRP and OSPF routing protocols.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-73061][bookmark: 121118][bookmark: pxpage_cncpt_BGPIPv4AddEditNeighborDialogBox]Add/Edit Neighbor Dialog Box[bookmark: marker-73055][bookmark: marker-73057][bookmark: marker-73059]

 
     [bookmark: pgfId-73063]Use the Add/Edit Neighbor dialog box to define BGP neighbors and neighbor settings.

 
     [bookmark: pgfId-73065]Navigation Path

 
     [bookmark: pgfId-73070]You can access the Add/Edit Neighbor dialog box from the IPv4 Family Tab.

 
     [bookmark: pgfId-73072]Related Topics

 
      
      		 [bookmark: pgfId-73077]Configuring BGP

 
      		 [bookmark: pgfId-73082]About BGP

 
      		 [bookmark: pgfId-73087]IPv4 Family - General Tab

 
      		 [bookmark: pgfId-73092]Add/Edit Aggregate Address Dialog Box

 
      		 [bookmark: pgfId-73097]Add/Edit Filter Dialog Box

 
      		 [bookmark: pgfId-73102]Add/Edit Network Dialog Box

 
      		 [bookmark: pgfId-73107]Add/Edit Redistribution Dialog Box

 
      		 [bookmark: pgfId-73112]Add/Edit Route Injection Dialog Box

 
     

 
     [bookmark: pgfId-73114]Field Reference

 
     [bookmark: pgfId-73117] 

 
      
       
        
        [bookmark: pgfId-64455]Table 55-6 [bookmark: 121168]Add/Edit Neighbor Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-64461]Element
          
  
         		
           
           [bookmark: pgfId-64463]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-64469]General
          
  
        

 
         
         		[bookmark: pgfId-64477]IP Address

  
         		[bookmark: pgfId-64479]Enter the BGP neighbor IP address. This IP address is added to the BGP neighbor table.

  
        

 
         
         		[bookmark: pgfId-64485]Remote AS

  
         		[bookmark: pgfId-64487]Enter the autonomous system to which the BGP neighbor belongs.

  
        

 
         
         		[bookmark: pgfId-64493]Enable Address Family

  
         		[bookmark: pgfId-64495](Optional) Enables communication with the BGP neighbor.

  
        

 
         
         		[bookmark: pgfId-64501]Shutdown neighbor administratively

  
         		[bookmark: pgfId-64503](Optional) Disable a neighbor or peer group.

  
        

 
         
         		[bookmark: pgfId-64509]Configure Graceful Restart per neighbor

 [bookmark: pgfId-64511](ASA 9.3.1+ only)

  
         		[bookmark: pgfId-64513](Optional) Enables configuration of the Border Gateway Protocol (BGP) graceful restart capability for this neighbor. After selecting this option, you must use the Graceful Restart (Use in failover or spanned cluster mode) option to specify whether graceful restart should be enabled or disabled for this neighbor.

  
        

 
         
         		[bookmark: pgfId-64519]Graceful Restart (Use in failover or spanned cluster mode)

 [bookmark: pgfId-64521](ASA 9.3.1+ only)

  
         		[bookmark: pgfId-64523](Optional) Enables the Border Gateway Protocol (BGP) graceful restart capability for this neighbor.

  
        

 
         
         		[bookmark: pgfId-64529]Description

  
         		[bookmark: pgfId-64531](Optional) Enter a description for the BGP neighbor.

  
        

 
         
         		 
           
           [bookmark: pgfId-64537]Filtering
          
  
        

 
         
         		[bookmark: pgfId-64545]Filter routes using an access list

  
         		[bookmark: pgfId-64547](Optional) Enter or Select the appropriate incoming or outgoing access control list to distribute BGP neighbor information.

  
        

 
         
         		[bookmark: pgfId-64553]Filter routes using route map

  
         		[bookmark: pgfId-64555](Optional) Enter or Select the appropriate incoming or outgoing route maps to apply a route map to incoming or outgoing routes.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-64566]Filter routes using a Prefix list

  
         		[bookmark: pgfId-64568](Optional) Enter or Select the appropriate incoming or outgoing prefix list to distribute BGP neighbor information.

 to open the Prefix List Object Selector from which you can select a prefix list object. You can also create new objects from the object Prefix List Object selector. For more information, see Add or Edit Prefix List Object Dialog Box.  
        

 
         
         		[bookmark: pgfId-64579]Filter routes using AS Path filter

  
         		[bookmark: pgfId-64581](Optional) Enter or Select the appropriate incoming or outgoing AS path filter to distribute BGP neighbor information.

 to open the AS Path Object Selector from which you can select an AS path object. You can also create new AS path objects from the AS Path Object Selector. For more information, see Add or Edit As Path Object Dialog Boxes.  
        

 
         
         		[bookmark: pgfId-64592]Limit the number of prefixes allowed from the neighbor

  
         		[bookmark: pgfId-64594](Optional) Select to control the number of prefixes that can be received from a neighbor.

 
           
           		 [bookmark: pgfId-64596]Enter the maximum number of prefixes allowed from a specific neighbor in the  Maximum Prefixes field.

 
           		 [bookmark: pgfId-64598]Enter the percentage (of maximum) at which the router starts to generate a warning message in the  Threshold Level field. Valid values are integers between 1 and 100. The default value is 75.

 
           		 [bookmark: pgfId-64600](Optional) Check the  Control prefixes received from the peer check box to specify additional controls for the prefixes received from a peer. Do one of the following:

 
          

 [bookmark: pgfId-64602] – Select Terminate peering when prefix limit is exceeded to stop the BGP neighbor when the prefix limit is reached. Specify the interval after which the BGP neighbor will restart in the Restart interval field.

 [bookmark: pgfId-64604] – Select Give only warning message when prefix limit is exceeded to generate a log message when the maximum prefix limit is exceeded. Here, the BGP neighbor will not be terminated.

  
        

 
         
         		 
           
           [bookmark: pgfId-64610]Routes
          
  
        

 
         
         		[bookmark: pgfId-64618]Advertisement Interval

  
         		[bookmark: pgfId-64620]Enter the minimum interval (in seconds) between the sending of BGP routing updates. Valid values are between 1 and 600.

  
        

 
         
         		[bookmark: pgfId-64626]Remove private AS numbers from outbound routing updates

  
         		[bookmark: pgfId-64628](Optional) Excludes the private AS numbers from being advertised on outbound routes.

  
        

 
         
         		[bookmark: pgfId-64634]Generate Default route

  
         		[bookmark: pgfId-64636](Optional) Select to allow the local router to send the default route 0.0.0.0 to a neighbor to use as a default route. Enter or Select the route map that allows the route 0.0.0.0 to be injected conditionally in the Route map field.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-64647]Conditionally Advertised Routes

  
         		[bookmark: pgfId-64649](Optional) To add or edit conditionally advertised routes, click the Add Row (+)button, or select a row in the table and click the Edit Row(pencil)button.

 [bookmark: pgfId-64651]In the Add/Edit Advertised Route dialog box, do the following:

 
           
           		 [bookmark: pgfId-64656]Click  Select to open the Route Map Object Selector from which you can select a route map that will be advertised if the conditions of the exist map or the non-exist map are met. For more information about route maps, see Understanding Route Map Objects

 
           		 [bookmark: pgfId-64658]Do one of the following:

 
          

 [bookmark: pgfId-64660] – Select Set Exist Map and choose a route map from the Route Map Object Selector. This route map will be compared with the routes in the BGP table, to determine whether or not the advertise map route is advertised.

 [bookmark: pgfId-64662] – Select Non-Exist Map and choose a route map from the Route Map Object Selector. This route map will be compared with the routes in the BGP table, to determine whether or not the advertise map route is advertised.

  
        

 
         
         		 
           
           [bookmark: pgfId-64668]Timers
          
  
        

 
         
         		[bookmark: pgfId-64676]Set timers for the BGP peer

  
         		[bookmark: pgfId-64678](Optional) Select to set the keepalive frequency, hold time and minimum hold time.

  
        

 
         
         		[bookmark: pgfId-64684]Keepalive Interval

  
         		[bookmark: pgfId-64686]Enter the frequency (in seconds) with which the ASA sends keepalive messages to the neighbor. Valid values are between 0 and 65535. The default value is 60 seconds.

  
        

 
         
         		[bookmark: pgfId-64692]Hold Time

  
         		[bookmark: pgfId-64694]Enter the interval (in seconds) after not receiving a keepalive message that the ASA declares a peer dead. Valid values are between 0 and 65535. The default value is 180 seconds.

  
        

 
         
         		[bookmark: pgfId-64700]Min Hold Time

  
         		[bookmark: pgfId-64702](Optional) Enter the minimum interval (in seconds) after not receiving a keepalive message that the ASA declares a peer dead. Valid values are between 0 and 65535. The default value is 0 seconds.

  
        

 
         
         		 
           
           [bookmark: pgfId-64708]Advanced
          
  
        

 
         
         		[bookmark: pgfId-64716]Enable Authentication

  
         		[bookmark: pgfId-64718](Optional) Select to enable MD5 authentication on a TCP connection between two BGP peers.

 
           
           		 [bookmark: pgfId-64720]Choose an encryption type from the Enable Encryption drop-down list.

 
           		 [bookmark: pgfId-64722]Enter a password in the Password field. Reenter the password in the Confirm field.

 
          

 [bookmark: pgfId-64724]The password is case-sensitive and can be up to 25 characters long when the service password-encryption command is enabled and up to 81 characters long when the service password-encryption command is not enabled. The first character cannot be a number. The string can contain any alphanumeric characters, including spaces.

 [bookmark: pgfId-64726]Note You cannot specify a password in the format number-space-anything. The space after the number can cause authentication to fail.

  
        

 
         
         		[bookmark: pgfId-64732]Send Community attribute to this neighbor

  
         		[bookmark: pgfId-64734](Optional) Specifies that communities attributes should be sent to the BGP neighbor.

  
        

 
         
         		[bookmark: pgfId-64740]Use ASA as next hop for neighbor

  
         		[bookmark: pgfId-64742](Optional) Select to configure the router as the next-hop for a BGP speaking neighbor or peer group.

  
        

 
         
         		[bookmark: pgfId-64748]Disable connection verification

  
         		[bookmark: pgfId-64750](Optional) Select to disable the connection verification process for eBGP peering sessions that are reachable by a single hop but are configured on a loopback interface or otherwise configured with a non-directly connected IP address.

 [bookmark: pgfId-64752]This command is required only when the neighbor ebgp-multihop command is configured with a TTL value of 1. The address of the single-hop eBGP peer must be reachable. The neighbor update-source command must be configured to allow the BGP routing process to use the loopback interface for the peering session.

 [bookmark: pgfId-64754]When deselected (default), a BGP routing process will verify the connection of single-hop eBGP peering session (TTL=254) to determine if the eBGP peer is directly connected to the same network segment by default. If the peer is not directly connected to same network segment, connection verification will prevent the peering session from being established.

  
        

 
         
         		[bookmark: pgfId-64760]Allow connections with neighbor that is not directly connected

  
         		[bookmark: pgfId-64762]Select to accept and attempt BGP connections to external peers residing on networks that are not directly connected.

 [bookmark: pgfId-64764](Optional) Enter the time-to-live in the TTL hops field. Valid values are between 1 and 255.

 [bookmark: pgfId-64766]Note This feature should be used only under the guidance of Cisco technical support staff. To prevent the creation of loops through oscillating routes, the multihop will not be established if the only route to the multihop peer is the default route (0.0.0.0).

  
        

 
         
         		[bookmark: pgfId-64772]Limit number of TTL hops to neighbor

  
         		[bookmark: pgfId-64774]Select this option to secure a BGP peering session. Enter the maximum number of hops that separate eBGP peers in the TTL hops field. Valid values are between 1 and 254.

 [bookmark: pgfId-64776]This feature provides a lightweight security mechanism to protect BGP peering sessions from CPU utilization-based attacks. These types of attacks are typically brute force Denial of Service (DoS) attacks that attempt to disable the network by flooding the network with IP packets that contain forged source and destination IP addresses in the packet headers.

 [bookmark: pgfId-64778]This feature leverages designed behavior of IP packets by accepting only IP packets with a TTL count that is equal to or greater than the locally configured value. Accurately forging the TTL count in an IP packet is generally considered to be impossible. Accurately forging a packet to match the TTL count from a trusted peer is not possible without internal access to the source or destination network.

 [bookmark: pgfId-64780]This feature should be configured on each participating router. It secures the BGP session in the incoming direction only and has no effect on outgoing IP packets or the remote router. When this feature is enabled, BGP will establish or maintain a session only if the TTL value in the IP packet header is equal to or greater than the TTL value configured for the peering session. This feature has no effect on the BGP peering session, and the peering session can still expire if keepalive packets are not received. If the TTL value in a received packet is less than the locally configured value, the packet is silently discarded and no Internet Control Message Protocol (ICMP) message is generated. This is designed behavior; a response to a forged packet is not necessary.

 [bookmark: pgfId-64782]To maximize the effectiveness of this feature, the hop-count value should be strictly configured to match the number of hops between the local and external network. However, you should also take path variation into account when configuring this feature for a multihop peering session.

 [bookmark: pgfId-64784]The following restrictions apply to the configuration of this command:

 
           
           		 [bookmark: pgfId-64786]This feature is not supported for internal BGP (iBGP) peers.

 
           		 [bookmark: pgfId-64788]The effectiveness of this feature is reduced in large-diameter multihop peerings. In the event of a CPU utilization-based attack against a BGP router that is configured for large-diameter peering, you may still need to shut down the affected peering sessions to handle the attack.

 
           		 [bookmark: pgfId-64790]This feature is not effective against attacks from a peer that has been compromised inside of your network. This restriction also includes peers that are on the network segment between the source and destination network.

 
          

  
        

 
         
         		[bookmark: pgfId-64796]Use TCP Path MTU Discovery

  
         		[bookmark: pgfId-64798](Optional) Select to enable a TCP transport session for a BGP session.

  
        

 
         
         		[bookmark: pgfId-64804]TCP transport mode

  
         		[bookmark: pgfId-64806]Choose the TCP connection mode from the drop-down list. Options are Default, Active, or Passive.

  
        

 
         
         		[bookmark: pgfId-64812]Weight

  
         		[bookmark: pgfId-64814](Optional) Enter a weight for the BGP neighbor connection.

  
        

 
         
         		[bookmark: pgfId-64820]BGP Version

  
         		[bookmark: pgfId-64822]Choose the BGP version that the ASA will accept from the drop-down list. The version can be set to 4-Only to force the software to use only Version 4 with the specified neighbor. The default is to use Version 4 and dynamically negotiate down to Version 2 if requested.

  
        

 
         
         		 [bookmark: pgfId-64828]Migration

 [bookmark: pgfId-64830]Note This customization should only be used for AS migration, and should be removed after the transition has been completed. The procedure should be attempted only by an experienced network operator. Routing loops can be created through improper configuration.

  
        

 
         
         		[bookmark: pgfId-64838]Customize the AS number for routes received from the neighbor

  
         		[bookmark: pgfId-64840](Optional) Select to customize the AS_PATH attribute for routes received from an eBGP neighbor.

  
        

 
         
         		[bookmark: pgfId-64846]Local AS Number

  
         		[bookmark: pgfId-64848]Enter the local autonomous system number. Valid values are any valid autonomous system number from 1 to 4294967295 or 1.0 to 65535.65535.

  
        

 
         
         		[bookmark: pgfId-64854]Do not prepend local AS number to routes received from neighbor

  
         		[bookmark: pgfId-64856](Optional) Select to prevent the local AS number from being prepended to any routes received from eBGP peer.

  
        

 
         
         		[bookmark: pgfId-64862]Replace real AS number with local AS number in routes received from neighbor

  
         		[bookmark: pgfId-64864](Optional) Select to replace the real autonomous system number with the local autonomous system number in the eBGP updates. The autonomous system number from the local BGP routing process is not prepended.

  
        

 
         
         		[bookmark: pgfId-64870]Accept either real AS number or local AS number in routes received from neighbor

  
         		[bookmark: pgfId-64872](Optional) Configures the eBGP neighbor to establish a peering session using the real autonomous system number (from the local BGP routing process) or by using the local autonomous system number.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-73131][bookmark: 121455][bookmark: pxpage_cncpt_BGPIPv4AddEditNetworkDialogBox]Add/Edit Network Dialog Box[bookmark: marker-73125][bookmark: marker-73127][bookmark: marker-73129]

 
     [bookmark: pgfId-73133]Use the Add/Edit Network dialog box to define the networks to be advertised by the BGP routing process.

 
     [bookmark: pgfId-73135]Navigation Path

 
     [bookmark: pgfId-73140]You can access the Add/Edit Network dialog box from the IPv4 Family Tab.

 
     [bookmark: pgfId-73142]Related Topics

 
      
      		 [bookmark: pgfId-73147]Configuring BGP

 
      		 [bookmark: pgfId-73152]About BGP

 
      		 [bookmark: pgfId-73157]IPv4 Family - General Tab

 
      		 [bookmark: pgfId-73162]Add/Edit Aggregate Address Dialog Box

 
      		 [bookmark: pgfId-73167]Add/Edit Filter Dialog Box

 
      		 [bookmark: pgfId-73172]Add/Edit Neighbor Dialog Box

 
      		 [bookmark: pgfId-73177]Add/Edit Redistribution Dialog Box

 
      		 [bookmark: pgfId-73182]Add/Edit Route Injection Dialog Box

 
     

 
     [bookmark: pgfId-73184]Field Reference

 
     [bookmark: pgfId-73187] 

 
      
       
        
        [bookmark: pgfId-64885]Table 55-7 [bookmark: 121505]Add/Edit Network Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-64891]Element
          
  
         		
           
           [bookmark: pgfId-64893]Description
          
  
        

 
         
         		[bookmark: pgfId-64899]Network

  
         		[bookmark: pgfId-64901]Specifies the network to be advertised by the BGP routing processes.

  
        

 
         
         		[bookmark: pgfId-64907]Route Map

  
         		[bookmark: pgfId-64909](Optional) Enter or Select a route map that should be examined to filter the networks to be advertised. If not specified, all networks are redistributed.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-73201][bookmark: 121529][bookmark: pxpage_cncpt_BGPIPv4AddEditRedistributionDialogBox]Add/Edit Redistribution Dialog Box[bookmark: marker-73195][bookmark: marker-73197][bookmark: marker-73199]

 
     [bookmark: pgfId-73203]Use the Add/Edit Redistribution dialog box to define the conditions for redistributing routes from another routing domain into BGP.

 
     [bookmark: pgfId-73205]Navigation Path

 
     [bookmark: pgfId-73210]You can access the Add/Edit Redistribution dialog box from the IPv4 Family Tab.

 
     [bookmark: pgfId-73212]Related Topics

 
      
      		 [bookmark: pgfId-73217]Configuring BGP

 
      		 [bookmark: pgfId-73222]About BGP

 
      		 [bookmark: pgfId-73227]IPv4 Family - General Tab

 
      		 [bookmark: pgfId-73232]Add/Edit Aggregate Address Dialog Box

 
      		 [bookmark: pgfId-73237]Add/Edit Filter Dialog Box

 
      		 [bookmark: pgfId-73242]Add/Edit Neighbor Dialog Box

 
      		 [bookmark: pgfId-73247]Add/Edit Network Dialog Box

 
      		 [bookmark: pgfId-73252]Add/Edit Route Injection Dialog Box

 
     

 
     [bookmark: pgfId-73254]Field Reference

 
     [bookmark: pgfId-73257] 

 
      
       
        
        [bookmark: pgfId-64927]Table 55-8 [bookmark: 121579]Add/Edit Redistribution Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-64933]Element
          
  
         		
           
           [bookmark: pgfId-64935]Description
          
  
        

 
         
         		[bookmark: pgfId-64941]Source Protocol

  
         		[bookmark: pgfId-64943]Choose the protocol from which you want to redistribute routes into the BGP domain from the Source Protocol drop-down list.

  
        

 
         
         		[bookmark: pgfId-64949]Process ID

  
         		[bookmark: pgfId-64951]Enter the identifier for the routing process. Applies to EIGRP and OSPF routing protocols.

  
        

 
         
         		[bookmark: pgfId-64957]Metric

  
         		[bookmark: pgfId-64959](Optional) Enter a metric for the redistributed route.

  
        

 
         
         		[bookmark: pgfId-64965]Route Map

  
         		[bookmark: pgfId-64967]Enter or Select a route map that should be examined to filter the networks to be redistributed. If not specified, all networks are redistributed.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-64978]Match

  
         		[bookmark: pgfId-64980]The conditions used for redistributing routes from one routing protocol to another. The routes must match the selected condition to be redistributed. You can choose one or more of the following match conditions. These options are enabled only when OSPF is chosen as the Source Protocol.

 
           
           		 [bookmark: pgfId-64982]Internal

 
           		 [bookmark: pgfId-64984]External 1

 
           		 [bookmark: pgfId-64986]External 2

 
           		 [bookmark: pgfId-64988]NSSA External 1

 
           		 [bookmark: pgfId-64990]NSSA External 2

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-73271][bookmark: 121629][bookmark: pxpage_cncpt_BGPIPv4AddEditRouteInjectionDialogBox]Add/Edit Route Injection Dialog Box[bookmark: marker-73265][bookmark: marker-73267][bookmark: marker-73269]

 
     [bookmark: pgfId-73273]Use the Add/Edit Route Injection dialog box to define the routes to be conditionally injected into the BGP routing table.

 
     [bookmark: pgfId-73275]Navigation Path

 
     [bookmark: pgfId-73280]You can access the Add/Edit Route Injection dialog box from the IPv4 Family Tab.

 
     [bookmark: pgfId-73282]Related Topics

 
      
      		 [bookmark: pgfId-73287]Configuring BGP

 
      		 [bookmark: pgfId-73292]About BGP

 
      		 [bookmark: pgfId-73297]IPv4 Family - General Tab

 
      		 [bookmark: pgfId-73302]Add/Edit Aggregate Address Dialog Box

 
      		 [bookmark: pgfId-73307]Add/Edit Filter Dialog Box

 
      		 [bookmark: pgfId-73312]Add/Edit Neighbor Dialog Box

 
      		 [bookmark: pgfId-73317]Add/Edit Network Dialog Box

 
      		 [bookmark: pgfId-73322]Add/Edit Redistribution Dialog Box

 
     

 
     [bookmark: pgfId-73324]Field Reference

 
     [bookmark: pgfId-73327] 

 
      
       
        
        [bookmark: pgfId-65003]Table 55-9 [bookmark: 121679]Add/Edit Route Injection Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-65009]Element
          
  
         		
           
           [bookmark: pgfId-65011]Description
          
  
        

 
         
         		[bookmark: pgfId-65017]Inject Map

  
         		[bookmark: pgfId-65019]Enter or Select the route map that specifies the prefixes to inject into the local BGP routing table.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-65030]Exist Map

  
         		[bookmark: pgfId-65032]Enter or Select the route map containing the prefixes that the BGP speaker will track.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-65043]Injected routes will inherit the attributes of the aggregate route

  
         		[bookmark: pgfId-65045]Configures the injected route to inherit attributes of the aggregate route.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-73339][bookmark: 121712][bookmark: pxpage_cncpt_BGPIPv6FamilyTab]IPv6 Family Tab[bookmark: marker-73333][bookmark: marker-73335][bookmark: marker-73337]

 
     [bookmark: pgfId-73341]Use the IPv6 Family tab on the BGP page to enable and configure IPv6 settings for BGP.

 
     [bookmark: pgfId-73343]Navigation Path

 
     [bookmark: pgfId-73348]You can access the IPv6 Family tab from the BGP page. For more information about the BGP page, see Configuring BGP.

 
     [bookmark: pgfId-73350]Related Topics

 
      
      		 [bookmark: pgfId-73355]About BGP

 
      		 [bookmark: pgfId-73360]General Tab

 
     

 
     [bookmark: pgfId-73362]Field Reference

 
     [bookmark: pgfId-73365] 

 
      
       
        
        [bookmark: pgfId-65058]Table 55-10 [bookmark: 121743]IPv6 Family - Aggregate Address Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-65064]Element
          
  
         		
           
           [bookmark: pgfId-65066]Description
          
  
        

 
         
         		[bookmark: pgfId-65072]Enable IPv6 Family

  
         		[bookmark: pgfId-65074]Enables configuration of routing sessions that use standard IPv6 address prefixes.

  
        

 
         
         		[bookmark: pgfId-65080]General

  
         		[bookmark: pgfId-65085]Use this panel to configure general IPv6 settings. See IPv6 Family - General Tab for more about these definitions.

  
        

 
         
         		[bookmark: pgfId-65091]Aggregate Address

  
         		[bookmark: pgfId-65093]Use this panel to define the aggregation of specific routes into one route.

 [bookmark: pgfId-65095]Specify a value for the aggregate timer (in seconds) in the Aggregate Timer field. Valid values are 0 or any value between 6 and 60. The default value is 30.

 [bookmark: pgfId-65100]See Add/Edit Aggregate Address Dialog Box for more about these definitions.

  
        

 
         
         		[bookmark: pgfId-65106]Neighbor

  
         		[bookmark: pgfId-65111]Use this panel to define BGP neighbors and neighbor settings. See Add/Edit Neighbor Dialog Box for more about these definitions.

  
        

 
         
         		[bookmark: pgfId-65117]Networks

  
         		[bookmark: pgfId-65122]Use this panel to define the networks to be advertised by the BGP routing process. See Add/Edit Network Dialog Box for more about these definitions.

  
        

 
         
         		[bookmark: pgfId-65128]Redistribution

  
         		[bookmark: pgfId-65133]Use this panel to define the conditions for redistributing routes from another routing domain into BGP. See Add/Edit Redistribution Dialog Box for more about these definitions.

  
        

 
         
         		[bookmark: pgfId-65139]Route Injection

  
         		[bookmark: pgfId-65144]Use this panel to define the routes to be conditionally injected into the BGP routing table. See Add/Edit Route Injection Dialog Box for more about these definitions.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-73377][bookmark: 121796][bookmark: pxpage_cncpt_BGPIPv6FamilyGeneralTab]IPv6 Family - General Tab[bookmark: marker-73371][bookmark: marker-73373][bookmark: marker-73375]

 
     [bookmark: pgfId-73379]Use the IPv6 Family - General tab to configure the general IPv6 settings.

 
     [bookmark: pgfId-73381]Navigation Path

 
     [bookmark: pgfId-73386]You can access the General tab from the IPv6 Family Tab on the BGP page. For more information about the IPv6 Family tab, see IPv6 Family Tab.

 
     [bookmark: pgfId-73388]Related Topics

 
      
      		 [bookmark: pgfId-73393]Configuring BGP

 
      		 [bookmark: pgfId-73398]About BGP

 
     

 
     [bookmark: pgfId-73400]Field Reference

 
     [bookmark: pgfId-73403] 

 
      
       
        
        [bookmark: pgfId-65157]Table 55-11 [bookmark: 121827]IPv6 Family - General Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-65163]Element
          
  
         		
           
           [bookmark: pgfId-65165]Description
          
  
        

 
         
         		[bookmark: pgfId-65171]Scanning Interval

  
         		[bookmark: pgfId-65173]Enter a scanning interval (in seconds) for BGP routers for next-hop validation. Valid values are from 5 to 60 seconds. The default value is 60.

  
        

 
         
         		 
           
           [bookmark: pgfId-65179]Routes and Synchronization
          
  
        

 
         
         		[bookmark: pgfId-65187]Generate Default Routes

  
         		[bookmark: pgfId-65189](Optional) Configures a BGP routing process to distribute a default route (network 0.0.0.0).

  
        

 
         
         		[bookmark: pgfId-65195]Advertise inactive routes

  
         		[bookmark: pgfId-65197](Optional) Advertises routes that are not installed in the routing information base (RIB).

  
        

 
         
         		[bookmark: pgfId-65203]Synchronize between BGP and the Interior Gateway Protocol (IGP) system

  
         		[bookmark: pgfId-65205]Enables synchronization between BGP and your Interior Gateway Protocol (IGP) system. To enable the Cisco IOS software to advertise a network route without waiting for the IGP, deselect this option.

 [bookmark: pgfId-65207]Usually, a BGP speaker does not advertise a route to an external neighbor unless that route is local or exists in the IGP. By default, synchronization between BGP and the IGP is turned off to allow the Cisco IOS software to advertise a network route without waiting for route validation from the IGP. This feature allows routers and access servers within an autonomous system to have the route before BGP makes it available to other autonomous systems. Use synchronization if routers in the autonomous system do not speak BGP.

  
        

 
         
         		[bookmark: pgfId-65213]Redistribute iBGP into an IGP (use filtering to limit the number of prefixes that are redistributed)

  
         		[bookmark: pgfId-65215](Optional) Configures iBGP redistribution into an interior gateway protocol (IGP), such as IS-IS or OSPF.

  
        

 
         
         		 
           
           [bookmark: pgfId-65221]Administrative Route Distances
          
  
        

 
         
         		[bookmark: pgfId-65229]External

  
         		[bookmark: pgfId-65231]Specifies the administrative distance for external BGP routes. Routes are external when learned from an external autonomous system. The range of values for this argument are from 1 to 255. The default value is 20.

  
        

 
         
         		[bookmark: pgfId-65237]Internal

  
         		[bookmark: pgfId-65239]Specifies administrative distance for internal BGP routes. Routes are internal when learned from peer in the local autonomous system. The range of values for this argument are from 1 to 255. The default value is 200.

  
        

 
         
         		[bookmark: pgfId-65245]Local

  
         		[bookmark: pgfId-65247]Specifies administrative distance for local BGP routes. Local routes are those networks listed with a network router configuration command, often as back doors, for the router or for the networks that is being redistributed from another process. The range of values for this argument are from 1 to 255. The default value is 200.

  
        

 
         
         		 
           
           [bookmark: pgfId-65253]Forward packets over Multiple Paths
          
  
        

 
         
         		[bookmark: pgfId-65261]Number of Paths

  
         		[bookmark: pgfId-65263](Optional) Specify the maximum number of Border Gateway Protocol routes that can be installed in a routing table. The range of values are from 1 to 8. The default value is 1.

  
        

 
         
         		[bookmark: pgfId-65269]IBGP Number of Paths

  
         		[bookmark: pgfId-65271](Optional) Specify the maximum number of parallel internal Border Gateway Protocol (iBGP) routes that can be installed in a routing table. The range of values are from 1 to 8. The default value is 1.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-73417][bookmark: 121904][bookmark: pxpage_cncpt_BGPIPv6AddEditAggregateAddressDialogBox]Add/Edit Aggregate Address Dialog Box[bookmark: marker-73411][bookmark: marker-73413][bookmark: marker-73415]

 
     [bookmark: pgfId-73419]Use the Add/Edit Aggregate Address dialog box to define the aggregation of specific routes into one route.

 
     [bookmark: pgfId-73421]Navigation Path

 
     [bookmark: pgfId-73426]You can access the Add/Edit Aggregate Address dialog box from the IPv6 Family Tab.

 
     [bookmark: pgfId-73428]Click the Add Row (+)button, or select a row in the table and click the Edit Row(pencil)button.

 
     [bookmark: pgfId-73430]Related Topics

 
      
      		 [bookmark: pgfId-73435]Configuring BGP

 
      		 [bookmark: pgfId-73440]About BGP

 
      		 [bookmark: pgfId-73445]IPv6 Family - General Tab

 
      		 [bookmark: pgfId-73450]Add/Edit Neighbor Dialog Box

 
      		 [bookmark: pgfId-73455]Add/Edit Network Dialog Box

 
      		 [bookmark: pgfId-73460]Add/Edit Redistribution Dialog Box

 
      		 [bookmark: pgfId-73465]Add/Edit Route Injection Dialog Box

 
     

 
     [bookmark: pgfId-73467]Field Reference

 
     [bookmark: pgfId-73470] 

 
      
       
        
        [bookmark: pgfId-65284]Table 55-12 [bookmark: 121955]Add/Edit Aggregate Address Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-65290]Element
          
  
         		
           
           [bookmark: pgfId-65292]Description
          
  
        

 
         
         		[bookmark: pgfId-65298]Aggregate Timer

  
         		[bookmark: pgfId-65300]Specify a value for the aggregate timer (in seconds). Valid values are 0 or any value between 6 and 60. This specifies the interval at which the routes will be aggregated. The default value is 30 seconds.

  
        

 
         
         		[bookmark: pgfId-65306]Network

  
         		[bookmark: pgfId-65308]Enter an IPv6 address, or enter or Select the desired Network/Hosts objects.

  
        

 
         
         		[bookmark: pgfId-65314]Attribute Map

  
         		[bookmark: pgfId-65316](Optional) Enter or Select the route map used to set the attribute of the aggregate route.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-65327]Advertise Map

  
         		[bookmark: pgfId-65329](Optional) Enter or Select the route map used to select the routes to create AS_SET origin communities.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-65340]Suppress Map

  
         		[bookmark: pgfId-65342](Optional) Enter or Select the route map used to select the routes to be suppressed.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-65353]Generate AS Set Path Information

  
         		[bookmark: pgfId-65355]Enables generation of autonomous system set path information.

  
        

 
         
         		[bookmark: pgfId-65361]Filter all more-specific routes from updates

  
         		[bookmark: pgfId-65363]Filters all more-specific routes from updates.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-73484][bookmark: 122010][bookmark: pxpage_cncpt_BGPIPv6AddEditNeighborDialogBox]Add/Edit Neighbor Dialog Box[bookmark: marker-73478][bookmark: marker-73480][bookmark: marker-73482]

 
     [bookmark: pgfId-73486]Use the Add/Edit Neighbor dialog box to define BGP neighbors and neighbor settings.

 
     [bookmark: pgfId-73488]Navigation Path

 
     [bookmark: pgfId-73493]You can access the Add/Edit Neighbor dialog box from the IPv6 Family Tab.

 
     [bookmark: pgfId-73495]Click the Add Row (+)button, or select a row in the table and click the Edit Row(pencil)button.

 
     [bookmark: pgfId-73497]Related Topics

 
      
      		 [bookmark: pgfId-73502]Configuring BGP

 
      		 [bookmark: pgfId-73507]About BGP

 
      		 [bookmark: pgfId-73512]IPv6 Family - General Tab

 
      		 [bookmark: pgfId-73517]Add/Edit Aggregate Address Dialog Box

 
      		 [bookmark: pgfId-73522]Add/Edit Network Dialog Box

 
      		 [bookmark: pgfId-73527]Add/Edit Redistribution Dialog Box

 
      		 [bookmark: pgfId-73532]Add/Edit Route Injection Dialog Box

 
     

 
     [bookmark: pgfId-73534]Field Reference

 
     [bookmark: pgfId-73537] 

 
      
       
        
        [bookmark: pgfId-65376]Table 55-13 [bookmark: 122061]Add/Edit Neighbor Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-65382]Element
          
  
         		
           
           [bookmark: pgfId-65384]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-65390]General
          
  
        

 
         
         		[bookmark: pgfId-65398]IP Address

  
         		[bookmark: pgfId-65400]Enter the BGP neighbor IPv6 address in one of the following formats:

 
           
           		 [bookmark: pgfId-65402]IPv6 address

 
           		 [bookmark: pgfId-65404]<IPv6 address>%<Interface name>

 
          

 [bookmark: pgfId-65406]This IPv6 address is added to the BGP neighbor table.

  
        

 
         
         		[bookmark: pgfId-65412]Remote AS

  
         		[bookmark: pgfId-65414]Enter the autonomous system to which the BGP neighbor belongs.

  
        

 
         
         		[bookmark: pgfId-65420]Enable Address Family

  
         		[bookmark: pgfId-65422](Optional) Enables communication with the BGP neighbor.

  
        

 
         
         		[bookmark: pgfId-65428]Shutdown neighbor administratively

  
         		[bookmark: pgfId-65430](Optional) Disable a neighbor or peer group.

  
        

 
         
         		[bookmark: pgfId-65436]Description

  
         		[bookmark: pgfId-65438](Optional) Enter a description for the BGP neighbor.

  
        

 
         
         		 
           
           [bookmark: pgfId-65444]Filtering
          
  
        

 
         
         		[bookmark: pgfId-65452]Filter routes using route map

  
         		[bookmark: pgfId-65454](Optional) Enter or Select the appropriate incoming or outgoing route maps to apply a route map to incoming or outgoing routes.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-65465]Filter routes using a Prefix list

  
         		[bookmark: pgfId-65467](Optional) Enter or Select the appropriate incoming or outgoing prefix list to distribute BGP neighbor information.

 to open the Prefix List Object Selector from which you can select a prefix list object. You can also create new objects from the object Prefix List Object selector. For more information, see Add or Edit Prefix List Object Dialog Box.  
        

 
         
         		[bookmark: pgfId-65478]Filter routes using AS Path filter

  
         		[bookmark: pgfId-65480](Optional) Enter or Select the appropriate incoming or outgoing AS path filter to distribute BGP neighbor information.

 to open the AS Path Object Selector from which you can select an AS path object. You can also create new AS path objects from the AS Path Object Selector. For more information, see Add or Edit As Path Object Dialog Boxes.  
        

 
         
         		[bookmark: pgfId-65491]Limit the number of prefixes allowed from the neighbor

  
         		[bookmark: pgfId-65493](Optional) Select to control the number of prefixes that can be received from a neighbor.

 
           
           		 [bookmark: pgfId-65495]Enter the maximum number of prefixes allowed from a specific neighbor in the  Maximum Prefixes field.

 
           		 [bookmark: pgfId-65497]Enter the percentage (of maximum) at which the router starts to generate a warning message in the  Threshold Level field. Valid values are integers between 1 and 100. The default value is 75.

 
           		 [bookmark: pgfId-65499](Optional) Check the  Control prefixes received from the peer check box to specify additional controls for the prefixes received from a peer. Do one of the following:

 
          

 [bookmark: pgfId-65501] – Select Terminate peering when prefix limit is exceeded to stop the BGP neighbor when the prefix limit is reached. Specify the interval after which the BGP neighbor will restart in the Restart interval field.

 [bookmark: pgfId-65503] – Select Give only warning message when prefix limit is exceeded to generate a log message when the maximum prefix limit is exceeded. Here, the BGP neighbor will not be terminated.

  
        

 
         
         		 
           
           [bookmark: pgfId-65509]Routes
          
  
        

 
         
         		[bookmark: pgfId-65517]Advertisement Interval

  
         		[bookmark: pgfId-65519]Enter the minimum interval (in seconds) between the sending of BGP routing updates. Valid values are between 0 and 600.

  
        

 
         
         		[bookmark: pgfId-65525]Remove private AS numbers from outbound routing updates

  
         		[bookmark: pgfId-65527](Optional) Excludes the private AS numbers from being advertised on outbound routes.

  
        

 
         
         		[bookmark: pgfId-65533]Generate Default route

  
         		[bookmark: pgfId-65535](Optional) Select to allow the local router to send the default route 0.0.0.0 to a neighbor to use as a default route. Enter or Select the route map that allows the route 0.0.0.0 to be injected conditionally in the Route map field.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-65546]Conditionally Advertised Routes

 [bookmark: pgfId-65552]In the Add/Edit Advertised Route dialog box, do the following:

 
           
           		 [bookmark: pgfId-65557]Click  Select to open the Route Map Object Selector from which you can select a route map that will be advertised if the conditions of the exist map or the non-exist map are met. For more information about route maps, see Understanding Route Map Objects

 
           		 [bookmark: pgfId-65559]Do one of the following:

 
          

 [bookmark: pgfId-65561] – Select Set Exist Map and choose a route map from the Route Map Object Selector. This route map will be compared with the routes in the BGP table, to determine whether or not the advertise map route is advertised.

 [bookmark: pgfId-65563] – Select Non-Exist Map and choose a route map from the Route Map Object Selector. This route map will be compared with the routes in the BGP table, to determine whether or not the advertise map route is advertised.

  
        

 
         
         		 
           
           [bookmark: pgfId-65569]Timers
          
  
        

 
         
         		[bookmark: pgfId-65577]Set timers for the BGP peer

  
         		[bookmark: pgfId-65579](Optional) Select to set the keepalive frequency, hold time and minimum hold time.

  
        

 
         
         		[bookmark: pgfId-65585]Keepalive Interval

  
         		[bookmark: pgfId-65587]Enter the frequency (in seconds) with which the ASA sends keepalive messages to the neighbor. Valid values are between 0 and 65535. The default value is 60 seconds.

  
        

 
         
         		[bookmark: pgfId-65593]Hold Time

  
         		[bookmark: pgfId-65595]Enter the interval (in seconds) after not receiving a keepalive message that the ASA declares a peer dead. Valid values are between 0 and 65535. The default value is 180 seconds.

  
        

 
         
         		[bookmark: pgfId-65601]Min Hold Time

  
         		[bookmark: pgfId-65603](Optional) Enter the minimum interval (in seconds) after not receiving a keepalive message that the ASA declares a peer dead. Valid values are between 0 and 65535. The default value is 0 seconds.

  
        

 
         
         		 
           
           [bookmark: pgfId-65609]Advanced
          
  
        

 
         
         		[bookmark: pgfId-65617]Enable Authentication

  
         		[bookmark: pgfId-65619](Optional) Select to enable MD5 authentication on a TCP connection between two BGP peers.

 
           
           		 [bookmark: pgfId-65621]Choose an encryption type from the Enable Encryption drop-down list.

 
           		 [bookmark: pgfId-65623]Enter a password in the Password field. Reenter the password in the Confirm field.

 
          

 [bookmark: pgfId-65625]The password is case-sensitive and can be up to 25 characters long when the service password-encryption command is enabled and up to 81 characters long when the service password-encryption command is not enabled. The first character cannot be a number. The string can contain any alphanumeric characters, including spaces.

 [bookmark: pgfId-65627]Note You cannot specify a password in the format number-space-anything. The space after the number can cause authentication to fail.

  
        

 
         
         		[bookmark: pgfId-65633]Send Community attribute to this neighbor

  
         		[bookmark: pgfId-65635](Optional) Specifies that communities attributes should be sent to the BGP neighbor.

  
        

 
         
         		[bookmark: pgfId-65641]Use ASA as next hop for neighbor

  
         		[bookmark: pgfId-65643](Optional) Select to configure the router as the next-hop for a BGP speaking neighbor or peer group.

  
        

 
         
         		[bookmark: pgfId-65649]Disable connection verification

  
         		[bookmark: pgfId-65651](Optional) Select to disable the connection verification process for eBGP peering sessions that are reachable by a single hop but are configured on a loopback interface or otherwise configured with a non-directly connected IPv6 address.

 [bookmark: pgfId-65653]This command is required only when the neighbor ebgp-multihop command is configured with a TTL value of 1. The address of the single-hop eBGP peer must be reachable. The neighbor update-source command must be configured to allow the BGP routing process to use the loopback interface for the peering session.

 [bookmark: pgfId-65655]When deselected (default), a BGP routing process will verify the connection of single-hop eBGP peering session (TTL=254) to determine if the eBGP peer is directly connected to the same network segment by default. If the peer is not directly connected to same network segment, connection verification will prevent the peering session from being established.

  
        

 
         
         		[bookmark: pgfId-65661]Allow connections with neighbor that is not directly connected

  
         		[bookmark: pgfId-65663]Select to accept and attempt BGP connections to external peers residing on networks that are not directly connected.

 [bookmark: pgfId-65665](Optional) Enter the time-to-live in the TTL hops field. Valid values are between 1 and 255.

 [bookmark: pgfId-65667]Note This feature should be used only under the guidance of Cisco technical support staff. To prevent the creation of loops through oscillating routes, the multihop will not be established if the only route to the multihop peer is the default route (0.0.0.0).

  
        

 
         
         		[bookmark: pgfId-65673]Limit number of TTL hops to neighbor

  
         		[bookmark: pgfId-65675]Select this option to secure a BGP peering session. Enter the maximum number of hops that separate eBGP peers in the TTL hops field. Valid values are between 1 and 254.

 [bookmark: pgfId-65677]This feature provides a lightweight security mechanism to protect BGP peering sessions from CPU utilization-based attacks. These types of attacks are typically brute force Denial of Service (DoS) attacks that attempt to disable the network by flooding the network with IP packets that contain forged source and destination IP addresses in the packet headers.

 [bookmark: pgfId-65679]This feature leverages designed behavior of IP packets by accepting only IP packets with a TTL count that is equal to or greater than the locally configured value. Accurately forging the TTL count in an IP packet is generally considered to be impossible. Accurately forging a packet to match the TTL count from a trusted peer is not possible without internal access to the source or destination network.

 [bookmark: pgfId-65681]This feature should be configured on each participating router. It secures the BGP session in the incoming direction only and has no effect on outgoing IP packets or the remote router. When this feature is enabled, BGP will establish or maintain a session only if the TTL value in the IP packet header is equal to or greater than the TTL value configured for the peering session. This feature has no effect on the BGP peering session, and the peering session can still expire if keepalive packets are not received. If the TTL value in a received packet is less than the locally configured value, the packet is silently discarded and no Internet Control Message Protocol (ICMP) message is generated. This is designed behavior; a response to a forged packet is not necessary.

 [bookmark: pgfId-65683]To maximize the effectiveness of this feature, the hop-count value should be strictly configured to match the number of hops between the local and external network. However, you should also take path variation into account when configuring this feature for a multihop peering session.

 [bookmark: pgfId-65685]The following restrictions apply to the configuration of this command:

 
           
           		 [bookmark: pgfId-65687]This feature is not supported for internal BGP (iBGP) peers.

 
           		 [bookmark: pgfId-65689]The effectiveness of this feature is reduced in large-diameter multihop peerings. In the event of a CPU utilization-based attack against a BGP router that is configured for large-diameter peering, you may still need to shut down the affected peering sessions to handle the attack.

 
           		 [bookmark: pgfId-65691]This feature is not effective against attacks from a peer that has been compromised inside of your network. This restriction also includes peers that are on the network segment between the source and destination network.

 
          

  
        

 
         
         		[bookmark: pgfId-65697]Use TCP Path MTU Discovery

  
         		[bookmark: pgfId-65699](Optional) Select to enable a TCP transport session for a BGP session.

  
        

 
         
         		[bookmark: pgfId-65705]TCP transport mode

  
         		[bookmark: pgfId-65707]Choose the TCP connection mode from the drop-down list. Options are Default, Active, or Passive.

  
        

 
         
         		[bookmark: pgfId-65713]Weight

  
         		[bookmark: pgfId-65715](Optional) Enter a weight for the BGP neighbor connection.

  
        

 
         
         		[bookmark: pgfId-65721]BGP Version

  
         		[bookmark: pgfId-65723]Choose the BGP version that the ASA will accept from the drop-down list. The version can be set to 4-Only to force the software to use only Version 4 with the specified neighbor. The default is to use Version 4 and dynamically negotiate down to Version 2 if requested.

  
        

 
         
         		 [bookmark: pgfId-65729]Migration

 [bookmark: pgfId-65731]Note This customization should only be used for AS migration, and should be removed after the transition has been completed. The procedure should be attempted only by an experienced network operator. Routing loops can be created through improper configuration.

  
        

 
         
         		[bookmark: pgfId-65739]Customize the AS number for routes received from the neighbor

  
         		[bookmark: pgfId-65741](Optional) Select to customize the AS_PATH attribute for routes received from an eBGP neighbor.

  
        

 
         
         		[bookmark: pgfId-65747]Local AS Number

  
         		[bookmark: pgfId-65749]Enter the local autonomous system number. Valid values are any valid autonomous system number from 1 to 4294967295 or 1.0 to 65535.65535.

  
        

 
         
         		[bookmark: pgfId-65755]Do not prepend local AS number to routes received from neighbor

  
         		[bookmark: pgfId-65757](Optional) Select to prevent the local AS number from being prepended to any routes received from eBGP peer.

  
        

 
         
         		[bookmark: pgfId-65763]Replace real AS number with local AS number in routes received from neighbor

  
         		[bookmark: pgfId-65765](Optional) Select to replace the real autonomous system number with the local autonomous system number in the eBGP updates. The autonomous system number from the local BGP routing process is not prepended.

  
        

 
         
         		[bookmark: pgfId-65771]Accept either real AS number or local AS number in routes received from neighbor

  
         		[bookmark: pgfId-65773](Optional) Configures the eBGP neighbor to establish a peering session using the real autonomous system number (from the local BGP routing process) or by using the local autonomous system number.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-73551][bookmark: 122338][bookmark: pxpage_cncpt_BGPIPv6AddEditNetworkDialogBox]Add/Edit Network Dialog Box[bookmark: marker-73545][bookmark: marker-73547][bookmark: marker-73549]

 
     [bookmark: pgfId-73553]Use the Add/Edit Network dialog box to define the networks to be advertised by the BGP routing process.

 
     [bookmark: pgfId-73555]Navigation Path

 
     [bookmark: pgfId-73560]You can access the Add/Edit Network dialog box from the IPv6 Family Tab.

 
     [bookmark: pgfId-73562]Click the Add Row (+)button, or select a row in the table and click the Edit Row(pencil)button.

 
     [bookmark: pgfId-73564]Related Topics

 
      
      		 [bookmark: pgfId-73569]Configuring BGP

 
      		 [bookmark: pgfId-73574]About BGP

 
      		 [bookmark: pgfId-73579]IPv6 Family - General Tab

 
      		 [bookmark: pgfId-73584]Add/Edit Aggregate Address Dialog Box

 
      		 [bookmark: pgfId-73589]Add/Edit Neighbor Dialog Box

 
      		 [bookmark: pgfId-73594]Add/Edit Redistribution Dialog Box

 
      		 [bookmark: pgfId-73599]Add/Edit Route Injection Dialog Box

 
     

 
     [bookmark: pgfId-73601]Field Reference

 
     [bookmark: pgfId-73604] 

 
      
       
        
        [bookmark: pgfId-65786]Table 55-14 [bookmark: 122389]Add/Edit Network Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-65792]Element
          
  
         		
           
           [bookmark: pgfId-65794]Description
          
  
        

 
         
         		[bookmark: pgfId-65800]Network

  
         		[bookmark: pgfId-65802]Specifies the network to be advertised by the BGP routing processes.

  
        

 
         
         		[bookmark: pgfId-65808]Route Map

  
         		[bookmark: pgfId-65810](Optional) Enter or Select a route map that should be examined to filter the networks to be advertised. If not specified, all networks are redistributed.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-73618][bookmark: 122413][bookmark: pxpage_cncpt_BGPIPv6AddEditRedistributionDialogBox]Add/Edit Redistribution Dialog Box[bookmark: marker-73612][bookmark: marker-73614][bookmark: marker-73616]

 
     [bookmark: pgfId-73620]Use the Add/Edit Redistribution dialog box to define the conditions for redistributing routes from another routing domain into BGP.

 
     [bookmark: pgfId-73622]Navigation Path

 
     [bookmark: pgfId-73627]You can access the Add/Edit Redistribution dialog box from the IPv6 Family Tab.

 
     [bookmark: pgfId-73629]Click the Add Row (+)button, or select a row in the table and click the Edit Row(pencil)button.

 
     [bookmark: pgfId-73631]Related Topics

 
      
      		 [bookmark: pgfId-73636]Configuring BGP

 
      		 [bookmark: pgfId-73641]About BGP

 
      		 [bookmark: pgfId-73646]IPv6 Family - General Tab

 
      		 [bookmark: pgfId-73651]Add/Edit Aggregate Address Dialog Box

 
      		 [bookmark: pgfId-73656]Add/Edit Neighbor Dialog Box

 
      		 [bookmark: pgfId-73661]Add/Edit Network Dialog Box

 
      		 [bookmark: pgfId-73666]Add/Edit Route Injection Dialog Box

 
     

 
     [bookmark: pgfId-73668]Field Reference

 
     [bookmark: pgfId-73671] 

 
      
       
        
        [bookmark: pgfId-65828]Table 55-15 [bookmark: 122464]Add/Edit Redistribution Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-65834]Element
          
  
         		
           
           [bookmark: pgfId-65836]Description
          
  
        

 
         
         		[bookmark: pgfId-65842]Source Protocol

  
         		[bookmark: pgfId-65844]Choose the protocol from which you want to redistribute routes into the BGP domain from the Source Protocol drop-down list.

  
        

 
         
         		[bookmark: pgfId-65850]Process ID

  
         		[bookmark: pgfId-65852]Enter the identifier for the routing process. Applies to EIGRP and OSPF routing protocols.

  
        

 
         
         		[bookmark: pgfId-65858]Metric

  
         		[bookmark: pgfId-65860](Optional) Enter a metric for the redistributed route.

  
        

 
         
         		[bookmark: pgfId-65866]Route Map

  
         		[bookmark: pgfId-65868]Enter or Select a route map that should be examined to filter the networks to be redistributed. If not specified, all networks are redistributed.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-65879]Include Connected

  
         		[bookmark: pgfId-65881]To include connected routes in the redistribution, check the Include Connected check box. This option is enabled only when OSPF is chosen as the Source Protocol.

  
        

 
         
         		[bookmark: pgfId-65887]Match

  
         		[bookmark: pgfId-65889]The conditions used for redistributing routes from one routing protocol to another. The routes must match the selected condition to be redistributed. You can choose one or more of the following match conditions. These options are enabled only when OSPF is chosen as the Source Protocol.

 
           
           		 [bookmark: pgfId-65891]Internal

 
           		 [bookmark: pgfId-65893]External 1

 
           		 [bookmark: pgfId-65895]External 2

 
           		 [bookmark: pgfId-65897]NSSA External 1

 
           		 [bookmark: pgfId-65899]NSSA External 2

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-73685][bookmark: 122519][bookmark: pxpage_cncpt_BGPIPv6AddEditRouteInjectionDialogBox]Add/Edit Route Injection Dialog Box[bookmark: marker-73679][bookmark: marker-73681][bookmark: marker-73683]

 
     [bookmark: pgfId-73687]Use the Add/Edit Route Injection dialog box to define the routes to be conditionally injected into the BGP routing table.

 
     [bookmark: pgfId-73689]Navigation Path

 
     [bookmark: pgfId-73694]You can access the Add/Edit Route Injection dialog box from the IPv6 Family Tab.

 
     [bookmark: pgfId-73696]Click the Add Row (+)button, or select a row in the table and click the Edit Row(pencil)button.

 
     [bookmark: pgfId-73698]Related Topics

 
      
      		 [bookmark: pgfId-73703]Configuring BGP

 
      		 [bookmark: pgfId-73708]About BGP

 
      		 [bookmark: pgfId-73713]IPv6 Family - General Tab

 
      		 [bookmark: pgfId-73718]Add/Edit Aggregate Address Dialog Box

 
      		 [bookmark: pgfId-73723]Add/Edit Neighbor Dialog Box

 
      		 [bookmark: pgfId-73728]Add/Edit Network Dialog Box

 
      		 [bookmark: pgfId-73733]Add/Edit Redistribution Dialog Box

 
     

 
     [bookmark: pgfId-73735]Field Reference

 
     [bookmark: pgfId-73738] 

 
      
       
        
        [bookmark: pgfId-65912]Table 55-16 [bookmark: 122570]Add/Edit Route Injection Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-65918]Element
          
  
         		
           
           [bookmark: pgfId-65920]Description
          
  
        

 
         
         		[bookmark: pgfId-65926]Inject Map

  
         		[bookmark: pgfId-65928]Enter or Select the route map that specifies the prefixes to inject into the local BGP routing table.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-65939]Exist Map

  
         		[bookmark: pgfId-65941]Enter or Select the route map containing the prefixes that the BGP speaker will track.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-65952]Injected routes will inherit the attributes of the aggregate route

  
         		[bookmark: pgfId-65954]Configures the injected route to inherit attributes of the aggregate route.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-73754][bookmark: 122604][bookmark: pxpage_cncpt_EIGRPPage]Configuring EIGRP[bookmark: marker-73748][bookmark: marker-73750][bookmark: marker-73752]

 
    [bookmark: pgfId-73756]The EIGRP page provides six tabbed panels for configuring Enhanced Interior Gateway Routing Protocol (EIGRP) routing on a firewall device. The following topics provide detailed information about enabling and configuring EIGRP:

 
     
     		 [bookmark: pgfId-73761]About EIGRP

 
     		 [bookmark: pgfId-73766]EIGRP Advanced Dialog Box

 
     		 [bookmark: pgfId-73771]Setup Tab

 
     		 [bookmark: pgfId-73776]Filter Rules Tab

 
     		 [bookmark: pgfId-73781]Neighbors Tab

 
     		 [bookmark: pgfId-73786]Redistribution Tab

 
     		 [bookmark: pgfId-73791]Summary Address Tab

 
     		 [bookmark: pgfId-73796]Interfaces Tab

 
    

 
    [bookmark: pgfId-73798]Navigation Path

 
     
     		 [bookmark: pgfId-73800](Device view) Select  Platform > Routing > EIGRP from the Device Policy selector.

 
     		 [bookmark: pgfId-73802](Policy view) Select  PIX/ASA/FWSM Platform > Routing > EIGRP from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-73804]Field Reference

 
    [bookmark: pgfId-73807] 

 
     
      
       
       [bookmark: pgfId-65967]Table 55-17 [bookmark: 122658]EIGRP Page 

 
       
      
        
        		
          
          [bookmark: pgfId-65973]Element
         
  
        		
          
          [bookmark: pgfId-65975]Description
         
  
       

 
        
        		[bookmark: pgfId-65981]Enable EIGRP

  
        		[bookmark: pgfId-65983]Check this box to enable the EIGRP routing process.

  
       

 
        
        		[bookmark: pgfId-65989]AS Number

  
        		[bookmark: pgfId-65991]Enter the autonomous system (AS) number for the EIGRP process. The AS number can be from 1 to 65535.

  
       

 
        
        		[bookmark: pgfId-65997]Advanced button

  
        		[bookmark: pgfId-66002]Opens the EIGRP Advanced Dialog Box, in which you can configure additional EIGRP process settings, such as the router ID, stub routing, and adjacency changes.

  
       

 
        
        		[bookmark: pgfId-66008]Setup tab

  
        		[bookmark: pgfId-66010]Use the Setup tab to configure the networks used by the EIGRP routing process, passive interfaces, default route information, administrative distances, and default metrics.

 [bookmark: pgfId-66015]For more information, see Setup Tab.

  
       

 
        
        		[bookmark: pgfId-66021]Filter Rules tab

  
        		[bookmark: pgfId-66023]Use the Filter Rules tab to define filter rules that let you control which routes are accepted or advertised by the EIGRP routing process.

 [bookmark: pgfId-66028]For more information, see Filter Rules Tab.

  
       

 
        
        		[bookmark: pgfId-66034]Neighbors tab

  
        		[bookmark: pgfId-66036]Use the Neighbors tab to manually define EIGRP neighbors.

 [bookmark: pgfId-66041]For more information, see Neighbors Tab.

  
       

 
        
        		[bookmark: pgfId-66047]Redistribution tab

  
        		[bookmark: pgfId-66049]Use the Redistribution tab to define the rules for redistributing routes from other routing protocols to the EIGRP routing process.

 [bookmark: pgfId-66054]For more information, see Redistribution Tab.

  
       

 
        
        		[bookmark: pgfId-66060]Summary Address tab

  
        		[bookmark: pgfId-66062]Use the Summary Address tab to create statically defined EIGRP summary addresses.

 [bookmark: pgfId-66067]For more information, see Summary Address Tab.

  
       

 
        
        		[bookmark: pgfId-66073]Interfaces tab

  
        		[bookmark: pgfId-66075]Use the Interfaces tab to configure interfaces for EIGRP.

 [bookmark: pgfId-66080]For more information, see Interfaces Tab.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-73815][bookmark: 122726][bookmark: pxpage_cncpt_EIGRPAbout]About EIGRP[bookmark: marker-73813]

 
     [bookmark: pgfId-73817]EIGRP is an enhanced version of IGRP developed by Cisco. Unlike IGRP and RIP, EIGRP does not send out periodic route updates. EIGRP updates are sent out only when the network topology changes. Key capabilities that distinguish EIGRP from other routing protocols include fast convergence, support for variable-length subnet mask, support for partial updates, and support for multiple network layer protocols.

 
     [bookmark: pgfId-73819]A router running EIGRP stores all the neighbor routing tables so that it can quickly adapt to alternate routes. If no appropriate route exists, EIGRP queries its neighbors to discover an alternate route. These queries propagate until an alternate route is found. Its support for variable-length subnet masks permits routes to be automatically summarized on a network number boundary. In addition, EIGRP can be configured to summarize on any bit boundary at any interface. EIGRP does not make periodic updates. Instead, it sends partial updates only when the metric for a route changes. Propagation of partial updates is automatically bounded so that only those routers that need the information are updated. As a result of these two capabilities, EIGRP consumes significantly less bandwidth than IGRP.

 
     [bookmark: pgfId-73821]Neighbor discovery is the process that the ASA uses to dynamically learn of other routers on directly attached networks. EIGRP routers send out multicast hello packets to announce their presence on the network. When the ASA receives a hello packet from a new neighbor, it sends its topology table to the neighbor with an initialization bit set. When the neighbor receives the topology update with the initialization bit set, the neighbor sends its topology table back to the ASA.

 
     [bookmark: pgfId-73823]The hello packets are sent out as multicast messages. No response is expected to a hello message. The exception to this is for statically defined neighbors. If you manually configure a neighbor, the hello messages sent to that neighbor are sent as unicast messages. Routing updates and acknowledgments are sent out as unicast messages.

 
     [bookmark: pgfId-73825]Once this neighbor relationship is established, routing updates are not exchanged unless there is a change in the network topology. The neighbor relationship is maintained through the hello packets. Each hello packet received from a neighbor includes a hold time. This is the time in which the ASA can expect to receive a hello packet from that neighbor. If the ASA does not receive a hello packet from that neighbor within the hold time advertised by that neighbor, the ASA considers that neighbor to be unavailable.

 
     [bookmark: pgfId-73827]The EIGRP protocol uses four key algorithm technologies, four key technologies, including neighbor discovery/recovery, Reliable Transport Protocol (RTP), and DUAL, which is important for route computations. DUAL saves all routes to a destination in the topology table, not just the least-cost route. The least-cost route is inserted into the routing table. The other routes remain in the topology table. If the main route fails, another route is chosen from the feasible successors. A successor is a neighboring router used for packet forwarding that has a least-cost path to a destination. The feasibility calculation guarantees that the path is not part of a routing loop.

 
     [bookmark: pgfId-73829]If a feasible successor is not found in the topology table, a route recomputation must occur. During route recomputation, DUAL queries the EIGRP neighbors for a route, who in turn query their neighbors. Routers that do no have a feasible successor for the route return an unreachable message.

 
     [bookmark: pgfId-73831]During route recomputation, DUAL marks the route as active. By default, the ASA waits for three minutes to receive a response from its neighbors. If the ASA does not receive a response from a neighbor, the route is marked as stuck-in-active. All routes in the topology table that point to the unresponsive neighbor as a feasibility successor are removed.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-73833]Note EIGRP neighbor relationships are not supported through the IPsec tunnel without a GRE tunnel.


     
      

     

     

 
     [bookmark: pgfId-73835]Related Topics

 
      
      		 [bookmark: pgfId-73840]Configuring EIGRP

 
     

 
    
 
     
      [bookmark: pgfId-73854][bookmark: 122748][bookmark: pxpage_cncpt_EIGRPAdvancedDialogBox]EIGRP Advanced Dialog Box[bookmark: marker-73848][bookmark: marker-73850][bookmark: marker-73852]

 
     [bookmark: pgfId-73856]Use the EIGRP Advanced dialog box to configure settings such as the router ID, stub routing, and adjacency changes.

 
     [bookmark: pgfId-73858]Navigation Path

 
     [bookmark: pgfId-73863]You can access the EIGRP Advanced dialog box from the EIGRP page (see Configuring EIGRP).

 
     [bookmark: pgfId-73865]Related Topics

 
      
      		 [bookmark: pgfId-73870]Configuring EIGRP

 
     

 
     [bookmark: pgfId-73872]Field Reference

 
     [bookmark: pgfId-73875] 

 
      
       
        
        [bookmark: pgfId-66093]Table 55-18 [bookmark: 122777]EIGRP Advanced Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-66099]Element
          
  
         		
           
           [bookmark: pgfId-66101]Description
          
  
        

 
         
         		[bookmark: pgfId-66107]Router ID

  
         		[bookmark: pgfId-66109]The router ID is used to identify the originating router for external routes. If an external route is received with the local router ID, the route is discarded. To prevent this, specify a global address for the router ID. A unique value should be configured for each EIGRP router.

 [bookmark: pgfId-66111]On a single device, choose Automatic or IP Address. (An address field appears when you choose IP Address.)

 [bookmark: pgfId-66113]If you choose Automatic, the highest-level IP address on the security appliance is used as the router ID. To use a fixed router ID, choose IP Address and enter an IPv4 address in the Router ID field.

 [bookmark: pgfId-66115]On a device cluster, choose Automatic or Cluster Pool. (An IPv4 Pool object ID field appears when you choose Cluster Pool.)

 [bookmark: pgfId-66120]If you choose Cluster Pool, enter or Select the name of the IPv4 Pool object that is to supply the Router ID address. For more information, see Add or Edit IPv4 Pool Dialog Box.

  
        

 
         
         		[bookmark: pgfId-66126]Stub

  
         		[bookmark: pgfId-66128]You can enable, and configure the ASA as an EIGRP stub router. Stub routing decreases memory and processing requirements on the ASA. As a stub router, the ASA does not need to maintain a complete EIGRP routing table because it forwards all nonlocal traffic to a distribution router. Generally, the distribution router need not send anything more than a default route to the stub router.

 [bookmark: pgfId-66130]Only specified routes are propagated from the stub router to the distribution router. As a stub router, the ASA responds to all queries for summaries, connected routes, redistributed static routes, external routes, and internal routes with the message “inaccessible.” When the ASA is configured as a stub, it sends a special peer information packet to all neighboring routers to report its status as a stub router. Any neighbor that receives a packet informing it of the stub status will not query the stub router for any routes, and a router that has a stub peer will not query that peer. The stub router depends on the distribution router to send the correct updates to all peers.

 [bookmark: pgfId-66132]To enable the ASA as an EIGRP stub routing process, choose one or more of the following EIGRP stub routing processes:

 
           
           		 [bookmark: pgfId-66134]Receive only—Configures the EIGRP stub routing process to receive route information from the neighbor routers but does not send route information to the neighbors. If this option is selected, you cannot select any of the other stub routing options.

 
           		 [bookmark: pgfId-66136]Connected—Advertises connected routes.

 
           		 [bookmark: pgfId-66138]Redistributed—Advertises redistributed routes.

 
           		 [bookmark: pgfId-66140]Static—Advertises static routes.

 
           		 [bookmark: pgfId-66142]Summary—Advertises summary routes.

 
          

  
        

 
         
         		[bookmark: pgfId-66148]Adjacency Changes

  
         		[bookmark: pgfId-66150]These options specify the syslog messages sent when adjacency changes occur.

 
           
           		 [bookmark: pgfId-66152]Log Neighbor Changes – enables the logging of EIGRP neighbor adjacency changes. This option is selected by default.

 
           		 [bookmark: pgfId-66154]Log Neighbor Warnings – enables the logging of EIGRP neighbor warning messages. This option is selected by default.

 
          

 [bookmark: pgfId-66156](Optional) The time interval (in seconds) between repeated neighbor warning messages. Valid values are from 1 to 65535. Repeated warnings are not logged if they occur during this interval.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-73887][bookmark: 122831][bookmark: pxpage_cncpt_EIGRPSetupTab]Setup Tab[bookmark: marker-73881][bookmark: marker-73883][bookmark: marker-73885]

 
     [bookmark: pgfId-73889]Use the Setup tab on the EIGRP page to configure the networks used by the EIGRP routing process, passive interfaces, default route information, administrative distances, and default metrics.

 
     [bookmark: pgfId-73891]Navigation Path

 
     [bookmark: pgfId-73896]You can access the Setup tab from the EIGRP Page; see Configuring EIGRP for more information.

 
     [bookmark: pgfId-73898]Related Topics

 
      
      		 [bookmark: pgfId-73903]Configuring EIGRP

 
      		 [bookmark: pgfId-73908]About EIGRP

 
      		 [bookmark: pgfId-73913]Setup Tab

 
      		 [bookmark: pgfId-73918]Filter Rules Tab

 
      		 [bookmark: pgfId-73923]Neighbors Tab

 
      		 [bookmark: pgfId-73928]Redistribution Tab

 
      		 [bookmark: pgfId-73933]Summary Address Tab

 
      		 [bookmark: pgfId-73938]Interfaces Tab

 
     

 
     [bookmark: pgfId-73940]Field Reference

 
     [bookmark: pgfId-73943] 

 
      
       
        
        [bookmark: pgfId-66169]Table 55-19 [bookmark: 122880]EIGRP - Setup Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-66175]Element
          
  
         		
           
           [bookmark: pgfId-66177]Description
          
  
        

 
         
         		[bookmark: pgfId-66183]Auto Summary

  
         		[bookmark: pgfId-66185]Check this box to enable automatic route summarization. Auto summary is enabled by default for ASA versions earlier than 9.2.1 and is disabled by default for ASA 9.2(1) and later.

 [bookmark: pgfId-66187]When enabled, the EIGRP routing process summarizes on network number boundaries. This can cause routing problems if you have noncontiguous networks.

 [bookmark: pgfId-66189]For example, if you have a router with the networks 192.168.1.0, 192.168.2.0, and 192.168.3.0 connected to it, and those networks all participate in EIGRP, the EIGRP routing process creates the summary address 192.168.0.0 for those routes. If an additional router is added to the network with the networks 192.168.10.0 and 192.168.11.0, and those networks participate in EIGRP, they will also be summarized as 192.168.0.0. To prevent the possibility of traffic being routed to the wrong location, you should disable automatic route summarization on the routers creating the conflicting summary addresses.

  
        

 
         
         		[bookmark: pgfId-66195]Networks

  
         		[bookmark: pgfId-66197]Enter the IP addresses of the networks to participate in the EIGRP routing process.

 to select the networks from a list of network/host objects.  
        

 
         
         		[bookmark: pgfId-66205]Passive Interface

  
         		[bookmark: pgfId-66207]You can configure one or more interfaces as passive interfaces. In EIGRP, a passive interface does not send or receive routing updates.

 [bookmark: pgfId-66209]By deafult, all interfaces are enabled for active routing (sending and receiving routing updates) when routing is enabled for that interface.

 [bookmark: pgfId-66211]To configure passive interfaces, do one of the following:

 
           
           		 [bookmark: pgfId-66213]To enable all interfaces for active routing (sending and receiving routing updates) when routing is enabled for that interface, select  None .

 
           		 [bookmark: pgfId-66215]To configure all interfaces as passive, select  All Interfaces .

 
           		 [bookmark: pgfId-66217]To configure specific interfaces as passive, select  Specified Interfaces and then enter or select the interfaces that you want to make passive.

 
          

  
        

 
         
         		[bookmark: pgfId-66223]Default Route Information

  
         		[bookmark: pgfId-66225]You can control the sending and receiving of default route information in EIGRP updates. By default, default routes are sent and accepted. Configuring the ASA to disallow default information to be received causes the candidate default route bit to be blocked on received routes. Configuring the ASA to disallow default information to be sent disables the setting of the default route bit in advertised routes.

 
           
           		 [bookmark: pgfId-66227]Accept Default Route Info—configures EIGRP to accept exterior default routing information. Optionally, you can specify a standard access list that define which networks are allowed and which are not when receiving default route information.

 
           		 [bookmark: pgfId-66229]Send Default Route Info—configures EIGRP to advertise external routing information. Optionally, you can specify a standard access list that defines which networks are allowed and which are not when sending default route information.

 
          

  
        

 
         
         		[bookmark: pgfId-66235]Administrative Distance

  
         		[bookmark: pgfId-66237]Because every routing protocol has metrics based on algorithms that are different from the other routing protocols, it is not always possible to determine the “best path” for two routes to the same destination that were generated by different routing protocols. Administrative distance is a route parameter that the ASA uses to select the best path when there are two or more different routes to the same destination from two different routing protocols.

 [bookmark: pgfId-66239]If you have more than one routing protocol running on the ASA, you can use the distance eigrp command to adjust the default administrative distances of routes discovered by the EIGRP routing protocol in relation to the other routing protocols.:

 [bookmark: pgfId-66241]Internal Distance—Administrative distance for EIGRP internal routes. Internal routes are those that are learned from another entity within the same autonomous system. Valid values are from 1 to 255. The default value is 90.

 [bookmark: pgfId-66243]External Distance—Administrative distance for EIGRP external routes. External routes are those for which the best path is learned from a neighbor external to the autonomous system. Valid values are from 1 to 255.The default value is 170.

  
        

 
         
         		[bookmark: pgfId-66249]Default Metrics

  
         		[bookmark: pgfId-66251]You can define the default metrics for routes redistributed into the EIGRP routing process:

 
           
           		 [bookmark: pgfId-66253]Bandwidth—the minimum bandwidth of the route in kilobits per second. Valid values range from 1 to 4294967295.

 
           		 [bookmark: pgfId-66255]Delay Time—the route delay in tens of microseconds. Valid values range from 0 to 4294967295.

 
           		 [bookmark: pgfId-66257]Reliability—the likelihood of successful packet transmission expressed as a number 0 through 255. The value 255 indicates 100 percent reliability; 0 means no reliability.

 
           		 [bookmark: pgfId-66259]Loading—the effective bandwidth of the route. Valid values range from 1 to 255; 255 indicates 100 percent loaded.

 
           		 [bookmark: pgfId-66261]MTU—the smallest allowed value for the maximum transmission unit of the path. Valid values range from 1 to 65535.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-73957][bookmark: 122956][bookmark: pxpage_cncpt_EIGRPFilterRulesTab]Filter Rules Tab[bookmark: marker-73951][bookmark: marker-73953][bookmark: marker-73955]

 
     [bookmark: pgfId-73959]The Filter Rules tab contains the Filter Rules table which displays the route filtering rules configured for the EIGRP routing process. Filter rules let you control which routes are accepted or advertised by the EIGRP routing process.

 
     [bookmark: pgfId-73961]Navigation Path

 
     [bookmark: pgfId-73966]You can access the Filter Rules tab from the EIGRP Page; see Configuring EIGRP for more information.

 
     [bookmark: pgfId-73968]Related Topics

 
      
      		 [bookmark: pgfId-73973]Add/Edit EIGRP Filter Rule Dialog Box

 
      		 [bookmark: pgfId-73978]Configuring EIGRP

 
      		 [bookmark: pgfId-73983]About EIGRP

 
      		 [bookmark: pgfId-73988]Setup Tab

 
      		 [bookmark: pgfId-73993]Neighbors Tab

 
      		 [bookmark: pgfId-73998]Redistribution Tab

 
      		 [bookmark: pgfId-74003]Summary Address Tab

 
      		 [bookmark: pgfId-74008]Interfaces Tab

 
     

 
     [bookmark: pgfId-74010]Field Reference

 
     [bookmark: pgfId-74013] 

 
      
       
        
        [bookmark: pgfId-66274]Table 55-20 [bookmark: 123006]EIGRP - Filter Rules Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-66280]Element
          
  
         		
           
           [bookmark: pgfId-66282]Description
          
  
        

 
         
         		[bookmark: pgfId-66288]Direction

  
         		[bookmark: pgfId-66290]The direction for the filter rule:

 
           
           		 [bookmark: pgfId-66292]Inbound—The rule filters default route information from incoming EIGRP routing updates.

 
           		 [bookmark: pgfId-66294]Outbound—The rule filters default route information from outgoing EIGRP routing updates.

 
          

  
        

 
         
         		[bookmark: pgfId-66300]Interface

  
         		[bookmark: pgfId-66302](Optional) The interface to which the filter rule applies.

  
        

 
         
         		[bookmark: pgfId-66308]Protocol

  
         		[bookmark: pgfId-66310]The routing protocol being filtered: BGP, Connected, OSPF, RIP, or Static.

  
        

 
         
         		[bookmark: pgfId-66316]ACL

  
         		[bookmark: pgfId-66318]Standard IP access list name. The list defines which networks are to be received and which are to be suppressed in routing updates.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-74027][bookmark: 123041][bookmark: pxpage_cncpt_EIGRPAddEditFilterRuleDialogBox]Add/Edit EIGRP Filter Rule Dialog Box[bookmark: marker-74021][bookmark: marker-74023][bookmark: marker-74025]

 
     [bookmark: pgfId-74029]Use the Add/Edit EIGRP Filter Rule dialog box to add new filter rules to the Filter Rules table or to modify an existing filter rule.

 
     [bookmark: pgfId-74031]Navigation Path

 
     [bookmark: pgfId-74036]You can access the Add/Edit EIGRP Filter Rule dialog box from the Filter Rules Tab.

 
     [bookmark: pgfId-74038]Related Topics

 
      
      		 [bookmark: pgfId-74043]Configuring EIGRP

 
      		 [bookmark: pgfId-74048]About EIGRP

 
      		 [bookmark: pgfId-74053]Filter Rules Tab

 
     

 
     [bookmark: pgfId-74055]Field Reference

 
     [bookmark: pgfId-74058] 

 
      
       
        
        [bookmark: pgfId-66331]Table 55-21 [bookmark: 123076]Add/Edit EIGRP Filter Rule Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-66337]Element
          
  
         		
           
           [bookmark: pgfId-66339]Description
          
  
        

 
         
         		[bookmark: pgfId-66345]EIGRP Filter Direction

  
         		[bookmark: pgfId-66347]Specify the direction for the filter rule:

 
           
           		 [bookmark: pgfId-66349]Inbound—The rule filters default route information from incoming EIGRP routing updates.

 
           		 [bookmark: pgfId-66351]Outbound—The rule filters default route information from outgoing EIGRP routing updates.

 
          

  
        

 
         
         		[bookmark: pgfId-66357]Type

  
         		[bookmark: pgfId-66359]Specify the type of filter rule:

 
           
           		 [bookmark: pgfId-66361](Optional) Interface—Specify the interface on which to apply the routing updates. Specifying an interface causes the access list to be applied only to routing updates for that interface. If no interface is specified, the access list will be applied to all updates.

 
           		 [bookmark: pgfId-66363](Optional) Routing Protocol—For outbound EIGRP routing updates, select the routing protocol for which you want to filter: BGP, Connected, OSPF, RIP, or Static.

 
          

 [bookmark: pgfId-66365]Routing Protocol ID—Enter the identifier for the routing process. Applies to BGP and OSPF routing protocols.

  
        

 
         
         		[bookmark: pgfId-66371]ACL

  
         		[bookmark: pgfId-66373]Select an Access Control List that defines which networks are to be received and which are to be suppressed in routing updates.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-74072][bookmark: 123114][bookmark: pxpage_cncpt_EIGRPNeighborsTab]Neighbors Tab[bookmark: marker-74066][bookmark: marker-74068][bookmark: marker-74070]

 
     [bookmark: pgfId-74074]The Neighbors tab contains the Neighbors table, through which you can define static neighbors. When you manually define an EIGRP neighbor, hello packets are sent to that neighbor as unicast messages.

 
     [bookmark: pgfId-74076]Navigation Path

 
     [bookmark: pgfId-74081]You can access the Neighbors tab from the EIGRP Page; see Configuring EIGRP for more information.

 
     [bookmark: pgfId-74083]Related Topics

 
      
      		 [bookmark: pgfId-74088]Add/Edit EIGRP Neighbor Dialog Box

 
      		 [bookmark: pgfId-74093]Configuring EIGRP

 
      		 [bookmark: pgfId-74098]About EIGRP

 
      		 [bookmark: pgfId-74103]Setup Tab

 
      		 [bookmark: pgfId-74108]Filter Rules Tab

 
      		 [bookmark: pgfId-74113]Redistribution Tab

 
      		 [bookmark: pgfId-74118]Summary Address Tab

 
      		 [bookmark: pgfId-74123]Interfaces Tab

 
     

 
     [bookmark: pgfId-74125]Field Reference

 
     [bookmark: pgfId-74128] 

 
      
       
        
        [bookmark: pgfId-66386]Table 55-22 [bookmark: 123164]EIGRP - Neighbors Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-66392]Element
          
  
         		
           
           [bookmark: pgfId-66394]Description
          
  
        

 
         
         		[bookmark: pgfId-66400]Interface

  
         		[bookmark: pgfId-66402]The interface through which the neighbor is available.

  
        

 
         
         		[bookmark: pgfId-66408]Neighbor

  
         		[bookmark: pgfId-66410]The IP address of the static neighbor.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-74142][bookmark: 123184][bookmark: pxpage_cncpt_EIGRPAddEditNeighborDialogBox]Add/Edit EIGRP Neighbor Dialog Box[bookmark: marker-74136][bookmark: marker-74138][bookmark: marker-74140]

 
     [bookmark: pgfId-74144]EIGRP hello packets are sent as multicast packets. If an EIGRP neighbor is located across a non broadcast network, such as a tunnel, you must manually define that neighbor. When you manually define an EIGRP neighbor, hello packets are sent to that neighbor as unicast messages.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-74146]Note Configuring the passive-interface command for an interface suppresses all incoming and outgoing routing updates and hello messages on that interface. EIGRP neighbor adjacencies cannot be established or maintained over an interface that is configured as passive.


     
      

     

     

 
     [bookmark: pgfId-74148]Use the Add/Edit EIGRP Neighbor dialog box to define a static neighbor or change information for an existing static neighbor.

 
     [bookmark: pgfId-74150]Navigation Path

 
     [bookmark: pgfId-74155]You can access the Add/Edit EIGRP Neighbor dialog box from the Neighbors Tab.

 
     [bookmark: pgfId-74157]Related Topics

 
      
      		 [bookmark: pgfId-74162]Configuring EIGRP

 
      		 [bookmark: pgfId-74167]About EIGRP

 
      		 [bookmark: pgfId-74172]Neighbors Tab

 
     

 
     [bookmark: pgfId-74174]Field Reference

 
     [bookmark: pgfId-74177] 

 
      
       
        
        [bookmark: pgfId-66423]Table 55-23 [bookmark: 123221]Add/Edit EIGRP Neighbor Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-66429]Element
          
  
         		
           
           [bookmark: pgfId-66431]Description
          
  
        

 
         
         		[bookmark: pgfId-66437]Interface

  
         		[bookmark: pgfId-66439]The interface through which the neighbor is available.

 to select the interface from a list of interface objects.  
        

 
         
         		[bookmark: pgfId-66447]Neighbor

  
         		[bookmark: pgfId-66449]The IP address of the static neighbor.

 to select the neighbor from a list of host objects.  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-74191][bookmark: 123247][bookmark: pxpage_cncpt_EIGRPRedistributionTab]Redistribution Tab[bookmark: marker-74185][bookmark: marker-74187][bookmark: marker-74189]

 
     [bookmark: pgfId-74193]Use the Redistribution tab to define the rules for redistributing routes from other routing protocols to the EIGRP routing process.

 
     [bookmark: pgfId-74195]Navigation Path

 
     [bookmark: pgfId-74200]You can access the Redistribution tab from the EIGRP Page; see Configuring EIGRP for more information.

 
     [bookmark: pgfId-74202]Related Topics

 
      
      		 [bookmark: pgfId-74207]Add/Edit EIGRP Redistribution Dialog Box

 
      		 [bookmark: pgfId-74212]Configuring EIGRP

 
      		 [bookmark: pgfId-74217]About EIGRP

 
      		 [bookmark: pgfId-74222]Setup Tab

 
      		 [bookmark: pgfId-74227]Filter Rules Tab

 
      		 [bookmark: pgfId-74232]Neighbors Tab

 
      		 [bookmark: pgfId-74237]Summary Address Tab

 
      		 [bookmark: pgfId-74242]Interfaces Tab

 
     

 
     [bookmark: pgfId-74244]Field Reference

 
     [bookmark: pgfId-74247] 

 
      
       
        
        [bookmark: pgfId-66464]Table 55-24 [bookmark: 123297]EIGRP - Redistribution Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-66470]Element
          
  
         		
           
           [bookmark: pgfId-66472]Description
          
  
        

 
         
         		[bookmark: pgfId-66478]Protocol

  
         		[bookmark: pgfId-66480]The source protocol from which the routes are being redistributed:

 
           
           		 [bookmark: pgfId-66482]BGP—Redistribute routes discovered by the BGP routing process to EIGRP.

 
           		 [bookmark: pgfId-66484]RIP—Redistributes routes discovered by the RIP routing process to EIGRP.

 
           		 [bookmark: pgfId-66486]Static—Redistributes static routes to the EIGRP routing process. Static routes that fall within the scope of a network statement are automatically redistributed into EIGRP; you do not need to define a redistribution rule for them.

 
           		 [bookmark: pgfId-66488]Connected—Redistributes connected routes (routes established automatically by virtue of having IP address enabled on the interface) to the EIGRP routing process. Connected routes that fall within the scope of a network statement are automatically redistributed into EIGRP; you do not need to define a redistribution rule for them.

 
           		 [bookmark: pgfId-66490]OSPF—Redistributes routes discovered by the OSPF routing process to EIGRP. If you choose this protocol, the Match options on this dialog box become visible. These options are not available when redistributing static, connected, RIP, or BGP routes.

 
          

  
        

 
         
         		[bookmark: pgfId-66496]ID

  
         		[bookmark: pgfId-66498]The autonomous system (AS) number for the BGP or OSPF routing process.

  
        

 
         
         		[bookmark: pgfId-66504]Bandwidth

  
         		[bookmark: pgfId-66506]The minimum bandwidth of the route in kilobits per second. Valid values range from 1 to 4294967295.

  
        

 
         
         		[bookmark: pgfId-66512]Delay Time

  
         		[bookmark: pgfId-66514]The route delay in tens of microseconds. Valid values range from 0 to 4294967295.

  
        

 
         
         		[bookmark: pgfId-66520]Reliability

  
         		[bookmark: pgfId-66522]The likelihood of successful packet transmission expressed as a number 0 through 255. The value 255 indicates 100 percent reliability; 0 means no reliability.

  
        

 
         
         		[bookmark: pgfId-66528]Loading

  
         		[bookmark: pgfId-66530]The effective bandwidth of the route. Valid values range from 1 to 255; 255 indicates 100 percent loaded.

  
        

 
         
         		[bookmark: pgfId-66536]MTU

  
         		[bookmark: pgfId-66538]The smallest allowed value for the maximum transmission unit of the path. Valid values range from 1 to 65535.

  
        

 
         
         		[bookmark: pgfId-66544]Route Map

  
         		[bookmark: pgfId-66546]The name of the route map object to apply to the redistribution entry.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-74261][bookmark: 123358][bookmark: pxpage_cncpt_EIGRPRedistributionDialogBox]Add/Edit EIGRP Redistribution Dialog Box[bookmark: marker-74255][bookmark: marker-74257][bookmark: marker-74259]

 
     [bookmark: pgfId-74263]Use the Add/Edit Redistribution dialog box to add a redistribution rule or to edit an existing redistribution rule in the Redistribution table.

 
     [bookmark: pgfId-74265]Navigation Path

 
     [bookmark: pgfId-74270]You can access the Add/Edit EIGRP Redistribution dialog box from the Redistribution Tab.

 
     [bookmark: pgfId-74272]Related Topics

 
      
      		 [bookmark: pgfId-74277]Configuring EIGRP

 
      		 [bookmark: pgfId-74282]About EIGRP

 
      		 [bookmark: pgfId-74287]Redistribution Tab

 
     

 
     [bookmark: pgfId-74289]Field Reference

 
     [bookmark: pgfId-74292] 

 
      
       
        
        [bookmark: pgfId-66559]Table 55-25 [bookmark: 123393]Add/Edit EIGRP Redistribution Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-66565]Element
          
  
         		
           
           [bookmark: pgfId-66567]Description
          
  
        

 
         
         		[bookmark: pgfId-66573]Protocol

  
         		[bookmark: pgfId-66575]Select the source protocol from which the routes are being redistributed. You can choose one of the following options:

 
           
           		 [bookmark: pgfId-66577]BGP—Redistribute routes discovered by the BGP routing process to EIGRP.

 
           		 [bookmark: pgfId-66579]RIP—Redistributes routes discovered by the RIP routing process to EIGRP.

 
           		 [bookmark: pgfId-66581]Static—Redistributes static routes to the EIGRP routing process. Static routes that fall within the scope of a network statement are automatically redistributed into EIGRP; you do not need to define a redistribution rule for them.

 
           		 [bookmark: pgfId-66583]Connected—Redistributes connected routes (routes established automatically by virtue of having IP address enabled on the interface) to the EIGRP routing process. Connected routes that fall within the scope of a network statement are automatically redistributed into EIGRP; you do not need to define a redistribution rule for them.

 
           		 [bookmark: pgfId-66585]OSPF—Redistributes routes discovered by the OSPF routing process to EIGRP. If you choose this protocol, the Match options on this dialog box become visible. These options are not available when redistributing static, connected, RIP, or BGP routes.

 
          

  
        

 
         
         		[bookmark: pgfId-66591]Routing Process ID

  
         		[bookmark: pgfId-66593]The autonomous system (AS) number for the BGP or OSPF routing process.

  
        

 
         
         		[bookmark: pgfId-66599]Optional Metrics

  
         		[bookmark: pgfId-66601]You can define the following metrics for routes redistributed into the EIGRP routing process:

 
           
           		 [bookmark: pgfId-66603]Bandwidth—the minimum bandwidth of the route in kilobits per second. Valid values range from 1 to 4294967295.

 
           		 [bookmark: pgfId-66605]Delay Time—the route delay in tens of microseconds. Valid values range from 0 to 4294967295.

 
           		 [bookmark: pgfId-66607]Reliability—the likelihood of successful packet transmission expressed as a number 0 through 255. The value 255 indicates 100 percent reliability; 0 means no reliability.

 
           		 [bookmark: pgfId-66609]Loading—the effective bandwidth of the route. Valid values range from 1 to 255; 255 indicates 100 percent loaded.

 
           		 [bookmark: pgfId-66611]MTU—the smallest allowed value for the maximum transmission unit of the path. Valid values range from 1 to 65535.

 
          

  
        

 
         
         		[bookmark: pgfId-66617]Route Map

  
         		[bookmark: pgfId-66619]Enter or Select a route map object to define which routes are redistributed into the EIGRP routing process.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-66630]Optional OSPF Redistribution

  
         		[bookmark: pgfId-66632]If you have chosen OSPF as the Route Type, choose the conditions used for redistributing routes from one routing protocol to another. The routes must match the selected condition to be redistributed. You can choose one or more of the following match conditions:

 
           
           		 [bookmark: pgfId-66634]Internal—The route is internal to a specific AS.

 
           		 [bookmark: pgfId-66636]External 1—Routes that are external to the autonomous system, but are imported into OSPF as Type 1 external routes.

 
           		 [bookmark: pgfId-66638]External 2—Routes that are external to the autonomous system, but are imported into OSPF as Type 2 external routes.

 
           		 [bookmark: pgfId-66640]NSSA External 1—Routes that are external to the autonomous system, but are imported into OSPF as Type 2 NSSA routes.

 
           		 [bookmark: pgfId-66642]NSSA External 2—Routes that are external to the autonomous system, but are imported into OSPF as Type 2 NSSA routes.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-74306][bookmark: 123466][bookmark: pxpage_cncpt_EIGRPSummaryAddressTab]Summary Address Tab[bookmark: marker-74300][bookmark: marker-74302][bookmark: marker-74304]

 
     [bookmark: pgfId-74308]Use the Summary Address tab to configure a summary for EIGRP on a specific interface. You can configure summary addresses on a per-interface basis. You need to manually define summary addresses if you want to create summary addresses that do not occur at a network number boundary or if you want to use summary addresses on an ASA with automatic route summarization disabled. If any more specific routes are in the routing table, EIGRP will advertise the summary address out the interface with a metric equal to the minimum of all more specific routes.

 
     [bookmark: pgfId-74310]Navigation Path

 
     [bookmark: pgfId-74315]You can access the Summary Address tab from the EIGRP Page; see Configuring EIGRP for more information.

 
     [bookmark: pgfId-74317]Related Topics

 
      
      		 [bookmark: pgfId-74322]Add/Edit EIGRP Summary Address Dialog Box

 
      		 [bookmark: pgfId-74327]Configuring EIGRP

 
      		 [bookmark: pgfId-74332]About EIGRP

 
      		 [bookmark: pgfId-74337]Setup Tab

 
      		 [bookmark: pgfId-74342]Filter Rules Tab

 
      		 [bookmark: pgfId-74347]Neighbors Tab

 
      		 [bookmark: pgfId-74352]Redistribution Tab

 
      		 [bookmark: pgfId-74357]Interfaces Tab

 
     

 
     [bookmark: pgfId-74359]Field Reference

 
     [bookmark: pgfId-74362] 

 
      
       
        
        [bookmark: pgfId-66655]Table 55-26 [bookmark: 123516]EIGRP - Summary Address Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-66661]Element
          
  
         		
           
           [bookmark: pgfId-66663]Description
          
  
        

 
         
         		[bookmark: pgfId-66669]Interface

  
         		[bookmark: pgfId-66671]The interface from which the summary address is advertised.

  
        

 
         
         		[bookmark: pgfId-66677]Network

  
         		[bookmark: pgfId-66679]The IP address and network mask of the summary address.

  
        

 
         
         		[bookmark: pgfId-66685]Administrative Distance

  
         		[bookmark: pgfId-66687]The administrative distance of the summary route.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-74376][bookmark: 123541][bookmark: pxpage_cncpt_EIGRPAddEditSummaryAddressDialogBox]Add/Edit EIGRP Summary Address Dialog Box[bookmark: marker-74370][bookmark: marker-74372][bookmark: marker-74374]

 
     [bookmark: pgfId-74378]Use the Add/Edit EIGRP Summary Address dialog box to add new entries or to modify existing entries in the Summary Address table. You can configure summary addresses on a per-interface basis. You need to manually define summary addresses if you want to create summary addresses that do not occur at a network number boundary or if you want to use summary addresses on an ASA with automatic route summarization disabled. If any more specific routes are in the routing table, EIGRP will advertise the summary address out the interface with a metric equal to the minimum of all more specific routes.

 
     [bookmark: pgfId-74380]Navigation Path

 
     [bookmark: pgfId-74385]You can access the Add/Edit EIGRP Summary Address dialog box from the Summary Address Tab.

 
     [bookmark: pgfId-74387]Related Topics

 
      
      		 [bookmark: pgfId-74392]Configuring EIGRP

 
      		 [bookmark: pgfId-74397]About EIGRP

 
      		 [bookmark: pgfId-74402]Summary Address Tab

 
     

 
     [bookmark: pgfId-74404]Field Reference

 
     [bookmark: pgfId-74407] 

 
      
       
        
        [bookmark: pgfId-66700]Table 55-27 [bookmark: 123576]Add/Edit EIGRP Summary Address Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-66706]Element
          
  
         		
           
           [bookmark: pgfId-66708]Description
          
  
        

 
         
         		[bookmark: pgfId-66714]Interface

  
         		[bookmark: pgfId-66716]The interface from which the summary address is advertised.

 to select the interface from a list of interface objects.  
        

 
         
         		[bookmark: pgfId-66724]Networks

  
         		[bookmark: pgfId-66726]The IP address and network mask of the summary address.

 to select the network from a list of network objects.  
        

 
         
         		[bookmark: pgfId-66734]Administrative Distance

  
         		[bookmark: pgfId-66736](Optional) The administrative distance of the summary route. Valid values are from 1 to 255. The default value is 5.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-74421][bookmark: 123607][bookmark: pxpage_cncpt_EIGRPInterfacesTab]Interfaces Tab[bookmark: marker-74415][bookmark: marker-74417][bookmark: marker-74419]

 
     [bookmark: pgfId-74423]Use the Interfaces tab to configure interface-specific EIGRP routing properties.

 
     [bookmark: pgfId-74425]Navigation Path

 
     [bookmark: pgfId-74430]You can access the Interfaces tab from the EIGRP Page; see Configuring EIGRP for more information.

 
     [bookmark: pgfId-74432]Related Topics

 
      
      		 [bookmark: pgfId-74437]Add/Edit EIGRP Interface Dialog Box

 
      		 [bookmark: pgfId-74442]Configuring EIGRP

 
      		 [bookmark: pgfId-74447]About EIGRP

 
      		 [bookmark: pgfId-74452]Setup Tab

 
      		 [bookmark: pgfId-74457]Filter Rules Tab

 
      		 [bookmark: pgfId-74462]Neighbors Tab

 
      		 [bookmark: pgfId-74467]Redistribution Tab

 
      		 [bookmark: pgfId-74472]Summary Address Tab

 
     

 
     [bookmark: pgfId-74474]Field Reference

 
     [bookmark: pgfId-74477] 

 
      
       
        
        [bookmark: pgfId-66749]Table 55-28 [bookmark: 123657]EIGRP - Interfaces Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-66755]Element
          
  
         		
           
           [bookmark: pgfId-66757]Description
          
  
        

 
         
         		[bookmark: pgfId-66763]Interface

  
         		[bookmark: pgfId-66765]The name of the interface to which the configuration applies.

  
        

 
         
         		[bookmark: pgfId-66771]Hello Interval

  
         		[bookmark: pgfId-66773]The interval, in seconds, between EIGRP hello packets sent on an interface. Valid values range from 1 to 65535 seconds. The default value is 5 seconds.

  
        

 
         
         		[bookmark: pgfId-66779]Hold Time

  
         		[bookmark: pgfId-66781]The hold time advertised by the ASA in EIGRP hello packets. Valid values range from 1 to 65535 seconds. The default value is 15 seconds.

  
        

 
         
         		[bookmark: pgfId-66787]Split Horizon

  
         		[bookmark: pgfId-66789]Whether EIGRP split-horizon is enabled (true) or disabled (false) on an interface.

  
        

 
         
         		[bookmark: pgfId-66795]Delay

  
         		[bookmark: pgfId-66797]The delay time in tens of microseconds. Valid values are from 1 to 16777215. This option is not supported for devices in multi-context mode.

  
        

 
         
         		[bookmark: pgfId-66803]Key ID

  
         		[bookmark: pgfId-66805]The ID of the key used to authenticate EIGRP updates.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-74491][bookmark: 123697][bookmark: pxpage_cncpt_EIGRPAddEditInterfaceDialogBox]Add/Edit EIGRP Interface Dialog Box[bookmark: marker-74485][bookmark: marker-74487][bookmark: marker-74489]

 
     [bookmark: pgfId-74493]Use the Add/Edit EIGRP Interface dialog box to configure interface-specific EIGRP routing parameters.

 
     [bookmark: pgfId-74495]Navigation Path

 
     [bookmark: pgfId-74500]You can access the Add/Edit EIGRP Interface dialog box from the Interfaces Tab.

 
     [bookmark: pgfId-74502]Related Topics

 
      
      		 [bookmark: pgfId-74507]Configuring EIGRP

 
      		 [bookmark: pgfId-74512]About EIGRP

 
      		 [bookmark: pgfId-74517]Interfaces Tab

 
     

 
     [bookmark: pgfId-74519]Field Reference

 
     [bookmark: pgfId-74522] 

 
      
       
        
        [bookmark: pgfId-66818]Table 55-29 [bookmark: 123732]Add/Edit EIGRP Interface Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-66824]Element
          
  
         		
           
           [bookmark: pgfId-66826]Description
          
  
        

 
         
         		[bookmark: pgfId-66832]Interface

  
         		[bookmark: pgfId-66834]The name of the interface to which the configuration applies.

  
        

 
         
         		[bookmark: pgfId-66840]Hello Interval

  
         		[bookmark: pgfId-66842]The interval, in seconds, between EIGRP hello packets sent on an interface. Valid values range from 1 to 65535 seconds. The default value is 5 seconds.

  
        

 
         
         		[bookmark: pgfId-66848]Hold Time

  
         		[bookmark: pgfId-66850]The hold time advertised by the ASA in EIGRP hello packets. Valid values range from 1 to 65535 seconds. The default value is 15 seconds.

  
        

 
         
         		[bookmark: pgfId-66856]Split Horizon

  
         		[bookmark: pgfId-66858]Enable/disable EIGRP split-horizon on an interface.

  
        

 
         
         		[bookmark: pgfId-66864]Delay Time

  
         		[bookmark: pgfId-66866]The delay time in tens of microseconds. Valid values are from 1 to 16777215. This option is not supported for devices in multi-context mode and will be disabled.

  
        

 
         
         		[bookmark: pgfId-66872]Enable MD5 Authentication

  
         		[bookmark: pgfId-66874]Enables MD5 authentication of EIGRP packets.

  
        

 
         
         		[bookmark: pgfId-66880]Key Type

  
         		[bookmark: pgfId-66882]Select Clear Text to indicate that the key you will be entering is in clear text. Select Encrypted to indicate that the key you will be entering is already encrypted.

  
        

 
         
         		[bookmark: pgfId-66888]Key ID and Key

  
         		[bookmark: pgfId-66890]Specify the key to authenticate EIGRP updates:

 
           
           		 [bookmark: pgfId-66892]Key ID—Enter a numerical key identifier. Valid values range from 0to 255.

 
           		 [bookmark: pgfId-66894]Key—An alphanumeric character string of up to 16 bytes.

 
           		 [bookmark: pgfId-66896]Confirm—Re-enter the key.

 
          

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-74538][bookmark: 123792][bookmark: pxpage_cncpt_OSPFPage]Configuring OSPF[bookmark: marker-74532][bookmark: marker-74534][bookmark: marker-74536]

 
    [bookmark: pgfId-74540]The OSPF page provides ten tabbed panels for configuring OSPF (Open Shortest Path First) routing on a firewall device. The following topics provide detailed information about enabling and configuring OSPF:

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-74542]Note Depending on the device version that you are configuring, some tabs might not be available.


    
     

    

    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-74544]Note Beginning with ASA version 9.2(1), certain OSPF settings have changed. If you configure a shared policy that uses settings specific to ASA 9.2(1)+, you will receive a validation error if that policy is assigned to a device whose version is earlier than 9.2(1). Likewise, if you configure a shared policy that uses settings that no longer apply to ASA 9.2(1)+, you will receive a validation error if that policy is assigned to an 9.2(1)+ device.


    
     

    

    

 
     
     		 [bookmark: pgfId-74549]About OSPF

 
     		 [bookmark: pgfId-74554]General Tab

 
     		 [bookmark: pgfId-74559]Area Tab

 
     		 [bookmark: pgfId-74564]Range Tab

 
     		 [bookmark: pgfId-74569]Neighbors Tab

 
     		 [bookmark: pgfId-74574]Redistribution Tab

 
     		 [bookmark: pgfId-74579]Virtual Link Tab

 
     		 [bookmark: pgfId-74584]Filtering Tab

 
     		 [bookmark: pgfId-74589]Filter Rule Tab

 
     		 [bookmark: pgfId-74594]Summary Address Tab

 
     		 [bookmark: pgfId-74599]Interface Tab

 
    

 
    [bookmark: pgfId-74601]Navigation Path

 
     
     		 [bookmark: pgfId-74603](Device view) Select  Platform > Routing > OSPF from the Device Policy selector.

 
     		 [bookmark: pgfId-74605](Policy view) Select  PIX/ASA/FWSM Platform > Routing > OSPF from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
     
      [bookmark: pgfId-74627][bookmark: 123854][bookmark: pxchap_cncpt_AboutOSPF]About OSPF [bookmark: marker-74611][bookmark: marker-74613][bookmark: marker-74615][bookmark: marker-74617][bookmark: marker-74619][bookmark: marker-74621][bookmark: marker-74623][bookmark: marker-74625]

 
     [bookmark: pgfId-74629]Open Shortest Path First (OSPF) is an interior gateway routing protocol that uses link states rather than distance vectors for path selection. OSPF propagates link-state advertisements (LSAs) rather than routing table updates. Because only LSAs are exchanged, rather than entire routing tables, OSPF networks converge more quickly than RIP networks.

 
     [bookmark: pgfId-74631]OSPF supports MD5 and clear-text neighbor authentication. Authentication should be used with all routing protocols whenever possible, because route redistribution between OSPF and other protocols (like RIP) can potentially be used by attackers to subvert routing information.

 
     [bookmark: pgfId-74633]If NAT is used when OSPF is operating on public and private areas, and if address filtering is required, you need to run two OSPF processes—one process for the public areas and one for the private areas.

 
     [bookmark: pgfId-74635]A router that has interfaces in multiple areas is called an Area Border Router (ABR). A router that acts as a gateway to redistribute traffic between routers using OSPF and routers using other routing protocols is called an Autonomous System Boundary Router (ASBR).

 
     [bookmark: pgfId-74637]An ABR uses LSAs to send information about available routes to other OSPF routers. Using ABR type 3 LSA filtering, you can have separate private and public areas with the security appliance acting as an ABR. Type 3 LSAs (inter-area routes) can be filtered from one area to other. This lets you use NAT and OSPF together without advertising private networks.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-74639]Note Only type 3 LSAs can be filtered. If you configure the security appliance as an ASBR in a private network, it will send type 5 LSAs describing private networks, which will be broadcast to the entire autonomous system (AS) including public areas.


     
      

     

     

 
     [bookmark: pgfId-74641]If NAT is employed but OSPF is only running in public areas, routes to public networks can be redistributed inside the private network, either as default or type 5 AS External LSAs. However, you need to configure static routes for the private networks protected by the security appliance. Also, you should not mix public and private networks on the same security appliance interface.

 
     [bookmark: pgfId-74643]Related Topics

 
      
      		 [bookmark: pgfId-74648]Configuring OSPF

 
     

 
    
 
     
      [bookmark: pgfId-74660][bookmark: 123896][bookmark: pxpage_cncpt_GeneralTab-3]General Tab[bookmark: marker-74654][bookmark: marker-74656][bookmark: marker-74658]

 
     [bookmark: pgfId-74662]Use the General panel on the OSPF page to enable up to two OSPF process instances. Each OSPF process has its own associated areas and networks.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-74664]Note You cannot enable OSPF if you have RIP enabled.


     
      

     

     

 
     [bookmark: pgfId-74666]Navigation Path

 
     [bookmark: pgfId-74671]You can access the General panel from the OSPF Page; see Configuring OSPF for more information.

 
     [bookmark: pgfId-74673]Related Topics

 
      
      		 [bookmark: pgfId-74678]Area Tab

 
      		 [bookmark: pgfId-74683]Range Tab

 
      		 [bookmark: pgfId-74688]Neighbors Tab

 
      		 [bookmark: pgfId-74693]Redistribution Tab

 
      		 [bookmark: pgfId-74698]Virtual Link Tab

 
      		 [bookmark: pgfId-74703]Filtering Tab

 
      		 [bookmark: pgfId-74708]Summary Address Tab

 
      		 [bookmark: pgfId-74713]Interface Tab

 
     

 
     [bookmark: pgfId-74715]Field Reference

 
     [bookmark: pgfId-74718] 

 
      
       
        
        [bookmark: pgfId-66909]Table 55-30 [bookmark: 123946]OSPF General Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-66915]Element
          
  
         		
           
           [bookmark: pgfId-66917]Description
          
  
        

 
         
         		 [bookmark: pgfId-66923]The General tab provides two identical sections; each is used to enable one OSPF process. The following options are available in each section.

  
        

 
         
         		[bookmark: pgfId-66931]Enable this OSPF Process

  
         		[bookmark: pgfId-66933]Check this box to enable an OSPF process. You cannot enable an OSPF process if you have RIP enabled on the security appliance. Deselect this option to remove the OSPF process.

  
        

 
         
         		[bookmark: pgfId-66939]OSPF Process ID

  
         		[bookmark: pgfId-66941]Enter a unique numeric identifier for the OSPF process. This process ID is used internally and does not need to match the OSPF process ID on any other OSPF devices. Valid values are from 1 to 65535.

  
        

 
         
         		[bookmark: pgfId-66947]Advanced button

  
         		[bookmark: pgfId-66952]Opens the OSPF Advanced Dialog Box, in which you can configure additional process-related parameters, such as Router ID, Adjacency Changes, Administrative Route Distances, Timers, and Default Information Originate settings.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-74732][bookmark: 123976][bookmark: pxpage_cncpt_OSPFAdvancedDialogBox]OSPF Advanced Dialog Box[bookmark: marker-74726][bookmark: marker-74728][bookmark: marker-74730]

 
     [bookmark: pgfId-74734]Use the OSPF Advanced dialog box to configure settings such as the Router ID, Adjacency Changes, Administrative Route Distances, Timers, and Default Information Originate settings for an OSPF process.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-74736]Note Beginning with ASA version 9.2(1), certain OSPF settings have changed. If you configure a shared policy that uses settings specific to ASA 9.2(1)+, you will receive a validation error if that policy is assigned to a device whose version is earlier than 9.2(1). Likewise, if you configure a shared policy that uses settings that no longer apply to ASA 9.2(1)+, you will receive a validation error if that policy is assigned to an 9.2(1)+ device.


     
      

     

     

 
     [bookmark: pgfId-74738]Navigation Path

 
     [bookmark: pgfId-74743]You can access the OSPF Advanced dialog box from the General Tab.

 
     [bookmark: pgfId-74745]Related Topics

 
      
      		 [bookmark: pgfId-74750]Configuring OSPF

 
     

 
     [bookmark: pgfId-74752]Field Reference

 
     [bookmark: pgfId-74755] 

 
      
       
        
        [bookmark: pgfId-66965]Table 55-31 [bookmark: 124006]OSPF Advanced Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-66971]Element
          
  
         		
           
           [bookmark: pgfId-66973]Description
          
  
        

 
         
         		[bookmark: pgfId-66979]OSPF Process

  
         		[bookmark: pgfId-66981]Displays the ID of the OSPF process you are configuring. You cannot change this value in this dialog box.

  
        

 
         
         		 
           
           [bookmark: pgfId-66987]General Tab
          
  
        

 
         
         		[bookmark: pgfId-66995]Router ID

  
         		[bookmark: pgfId-66997]To use a fixed router ID, select IP Address and then enter a router ID in IP address format in the Router ID field. To have the router ID automatically generated (the highest-level IP address on the security appliance is used as the router ID), select Automatic.

  
        

 
         
         		[bookmark: pgfId-67003]Ignore LSA MOSPF

  
         		[bookmark: pgfId-67005]Select this option to suppress transmission of syslog messages when the security appliance receives Type 6 (MOSPF) LSA packets.

  
        

 
         
         		[bookmark: pgfId-67011]RFC 1583 Compatible

  
         		[bookmark: pgfId-67013]Select this option to calculate summary route costs per RFC 1583. Deselect this option to calculate summary route costs per RFC 2328. To minimize the chance of routing loops, all OSPF devices in an OSPF routing domain should have RFC compatibility set identically. This option is selected by default.

  
        

 
         
         		[bookmark: pgfId-67019]Adjacency Changes

  
         		[bookmark: pgfId-67021]These options specify the syslog messages sent when adjacency changes occur.

 
           
           		 [bookmark: pgfId-67023]Log Adjacency Changes – When selected, the security appliance sends a syslog message whenever an OSPF neighbor goes up or down. This option is selected by default.

 
           		 [bookmark: pgfId-67025]Log Adjacency Changes Detail – When selected, the security appliance sends a syslog message whenever any state change occurs, not just when a neighbor goes up or down. This option is not selected by default.

 
          

  
        

 
         
         		[bookmark: pgfId-67031]Administrative Route Distances

  
         		[bookmark: pgfId-67033]Settings for the administrative route distances, according to the route type.

 
           
           		 [bookmark: pgfId-67035]Inter Area – The administrative distance for all routes from one area to another. Valid values range from 1 to 255; the default value is 110.

 
           		 [bookmark: pgfId-67037]Intra Area – The administrative distance for all routes within an area. Valid values range from 1 to 255; the default value is 110.

 
           		 [bookmark: pgfId-67039]External – The administrative distance for all routes from other routing domains that are learned through redistribution. Valid values range from 1 to 255; the default value is 110.

 
          

  
        

 
         
         		[bookmark: pgfId-67045]Timers

  
         		[bookmark: pgfId-67047]Settings used to configure LSA arrival, LSA pacing, and throttling for ASA 9.2(1)+ devices:

 
           
           		 [bookmark: pgfId-67049]LSA Arrival – The minimum delay in milliseconds that must pass between acceptance of the same LSA arriving from neighbors. The range is from 0 to 600,000 milliseconds. The default is 1000 milliseconds.

 
           		 [bookmark: pgfId-67051]LSA Flood Pacing – The time in milliseconds at which LSAs in the flooding queue are paced in between updates. The configurable range is from 5 to 100 milliseconds. The default value is 33 milliseconds.

 
           		 [bookmark: pgfId-67053]LSA Group Pacing – The interval at which LSAs are collected into a group and refreshed, checksummed, or aged. Valid values range from 10 to 1800; the default value is 240 seconds.

 
           		 [bookmark: pgfId-67055]LSA Retransmission Pacing - The time in milliseconds at which LSAs in the retransmission queue are paced. The configurable range is from 5 to 200 milliseconds. The default value is 66 milliseconds.

 
           		 [bookmark: pgfId-67057]LSA Throttle – The delay in milliseconds to generate the first occurrence of the LSA. Valid values range from 0 to 600000 milliseconds. When you enter a value in this field, the Min and Max fields are enabled:

 
          

 [bookmark: pgfId-67059] – Min – The minimum delay for originating the same LSA. Valid values range from 1 to 600000 milliseconds.

 [bookmark: pgfId-67061] – Max – The maximum delay for originating the same LSA. Valid values range from 1 to 600000 milliseconds.

 [bookmark: pgfId-67063]Note For LSA throttling, the first occurrence value must be equal to or less than the minimum value and the minimum value must be equal to or less than the maximum value.

 
           
           		 [bookmark: pgfId-67065]SPF Throttle – The delay to receive a change to the SPF calculation. Valid values range from 1 to 600000 milliseconds. When you enter a value in this field, the Min and Max fields are enabled:

 
          

 [bookmark: pgfId-67067] – Min – The delay between the first and second SPF calculations. Valid values range from 1 to 600000 milliseconds.

 [bookmark: pgfId-67069] – Max – The maximum wait time for SPF calculations. Valid values range from 1 to 600000 milliseconds.

 [bookmark: pgfId-67071]Note For SPF throttling, the first occurrence value must be equal to or less than the minimum value and the minimum value must be equal to or less than the maximum value.

 [bookmark: pgfId-67073]Settings used to configure LSA pacing and SPF calculation timers for device versions earlier than 9.2(1):

 
           
           		 [bookmark: pgfId-67075]SPF Delay – The time between receipt of a topology change and the start of shortest path first (SPF) calculations. Valid values range from 0 to 65535; the default value is 5 seconds.

 
           		 [bookmark: pgfId-67077]SPF Hold – The hold time between consecutive SPF calculations. Valid values range from 1 to 65534; the default value is 10 seconds.

 
           		 [bookmark: pgfId-67079]LSA Group Pacing – The interval at which LSAs are collected into a group and refreshed, checksummed, or aged. Valid values range from 10 to 1800; the default value is 240 seconds.

 
          

  
        

 
         
         		[bookmark: pgfId-67085]Default Information Originate

  
         		[bookmark: pgfId-67087]Settings used by an ASBR to generate a default external route into an OSPF routing domain.

 
           
           		 [bookmark: pgfId-67089]Enable Default Information Originate – Check this box to enable generation of a default route into the OSPF routing domain; the following options become available:

 
          

 [bookmark: pgfId-67091] – Always advertise the default route – Check this box to always advertise the default route.

 [bookmark: pgfId-67093] – Metric Value – Enter the OSPF metric for the default route. Valid values range from 0 to 16777214; the default value is 1.

 [bookmark: pgfId-67095] – Metric Type – Choose the external link type associated with the default route advertised into the OSPF routing domain. The choices are 1 or 2, indicating a Type 1 or a Type 2 external route. The default value is 2.

 [bookmark: pgfId-67097] – Route Map – (Optional) Enter or Select a route map object to apply. The routing process generates the default route if the route map is satisfied.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		 [bookmark: pgfId-67108]Non Stop Forwarding Tab

 [bookmark: pgfId-67110]Note Non Stop Forwarding (NSF) is supported on ASA 9.3(1)+ devices in Spanned Cluster mode or Failover mode only.

  
        

 
         
         		[bookmark: pgfId-67118]Enable Cisco Non Stop Forwarding Capability

  
         		[bookmark: pgfId-67120]Enables configuration of Cisco nonstop forwarding (NSF) operations.

  
        

 
         
         		[bookmark: pgfId-67126]Enable Cisco Non Stop Forwarding Helper mode

  
         		[bookmark: pgfId-67128]Enables Cisco nonstop forwarding (NSF) helper mode.

 [bookmark: pgfId-67130]When an ASA has NSF enabled, it is said to be NSF-capable and will operate in graceful restart mode--the OSPF router process performs nonstop forwarding recovery due to a Route Processor (RP) switchover. By default, the neighboring ASAs of the NSF-capable ASA will be NSF-aware and will operate in NSF helper mode. When the NSF-capable ASA is performing graceful restart, the helper ASAs assist in the nonstop forwarding recovery process.

 [bookmark: pgfId-67132]If you do not want the ASA to help the restarting neighbor with nonstop forwarding recovery, clear the Enable Cisco Non Stop Forwarding Helper mode option.

  
        

 
         
         		[bookmark: pgfId-67138]Enable Cisco Non Stop Forwarding

  
         		[bookmark: pgfId-67140]Enables Cisco nonstop forwarding (NSF).

  
        

 
         
         		[bookmark: pgfId-67146]Cancel NSF restart when non-NSF-aware neighboring networking devices are detected (Enforce Global)

  
         		[bookmark: pgfId-67148]If neighbors that are not NSF-aware are detected on a network interface during an NSF graceful restart, restart is aborted on that interface only and graceful restart will continue on other interfaces. To cancel restart for the entire OSPF process when neighbors that are not NSF-aware are detected during restart, select the Cancel NSF restart when non-NSF-aware neighboring networking devices are detected (Enforce Global) option.

 [bookmark: pgfId-67150]Note The NSF graceful restart will also be canceled for the entire process when a neighbor adjacency reset is detected on any interface or when an OSPF interface goes down.

  
        

 
         
         		[bookmark: pgfId-67156]Enable IETF Non Stop Forwarding Capability

  
         		[bookmark: pgfId-67158]Enables configuration of Internet Engineering Task Force (IETF) NSF operations.

  
        

 
         
         		[bookmark: pgfId-67164]Enable IETF Non Stop Forwarding Helper mode

  
         		[bookmark: pgfId-67166]Enables IETF nonstop forwarding (NSF) helper mode.

 [bookmark: pgfId-67168]When an ASA has NSF enabled, it is said to be NSF-capable and will operate in graceful restart mode--the OSPF router process performs nonstop forwarding recovery due to a Route Processor (RP) switchover. By default, the neighboring ASAs of the NSF-capable ASA will be NSF-aware and will operate in NSF helper mode. When the NSF-capable ASA is performing graceful restart, the helper ASAs assist in the nonstop forwarding recovery process.

 [bookmark: pgfId-67170]If you do not want the ASA to help the restarting neighbor with nonstop forwarding recovery, clear the Enable IETF Non Stop Forwarding Helper mode option.

  
        

 
         
         		[bookmark: pgfId-67176]Enable Strict Link State advertisement checking

  
         		[bookmark: pgfId-67178]Enables strict link-state advertisement (LSA) checking for IETF NSF helper mode.

  
        

 
         
         		[bookmark: pgfId-67184]Enable IETF Non Stop Forwarding

  
         		[bookmark: pgfId-67186]Enables IETF nonstop forwarding (NSF).

  
        

 
         
         		[bookmark: pgfId-67192]Length of graceful restart interval

  
         		[bookmark: pgfId-67194](Optional) Specifies the length of the graceful restart interval, in seconds. The range is from 1 to 1800. The default is 120.

 [bookmark: pgfId-67196]Note For a restart interval below 30 seconds, graceful restart will be terminated.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-74769][bookmark: 124184][bookmark: pxpage_cncpt_AreaTab]Area Tab[bookmark: marker-74763][bookmark: marker-74765][bookmark: marker-74767]

 
     [bookmark: pgfId-74771]Use the Area tab on the OSPF page to configure OSPF areas and networks.

 
     [bookmark: pgfId-74773]Navigation Path

 
     [bookmark: pgfId-74778]You can access the Area tab from the OSPF page. For more information about the OSPF page, see Configuring OSPF.

 
     [bookmark: pgfId-74780]Related Topics

 
      
      		 [bookmark: pgfId-74785]Add/Edit Area/Area Networks Dialog Box

 
      		 [bookmark: pgfId-74790]Configuring OSPF

 
      		 [bookmark: pgfId-74795]General Tab

 
      		 [bookmark: pgfId-74800]Range Tab

 
      		 [bookmark: pgfId-74805]Neighbors Tab

 
      		 [bookmark: pgfId-74810]Redistribution Tab

 
      		 [bookmark: pgfId-74815]Virtual Link Tab

 
      		 [bookmark: pgfId-74820]Filtering Tab

 
      		 [bookmark: pgfId-74825]Summary Address Tab

 
      		 [bookmark: pgfId-74830]Interface Tab

 
     

 
     [bookmark: pgfId-74832]Field Reference

 
     [bookmark: pgfId-74835] 

 
      
       
        
        [bookmark: pgfId-67209]Table 55-32 [bookmark: 124240]Area Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-67215]Element
          
  
         		
           
           [bookmark: pgfId-67217]Description
          
  
        

 
         
         		[bookmark: pgfId-67223]OSPF Process

  
         		[bookmark: pgfId-67225]The OSPF process the area applies to.

  
        

 
         
         		[bookmark: pgfId-67231]Area ID

  
         		[bookmark: pgfId-67233]The area ID.

  
        

 
         
         		[bookmark: pgfId-67239]Area Type

  
         		[bookmark: pgfId-67241]The area type (Normal, Stub, or NSSA).

  
        

 
         
         		[bookmark: pgfId-67247]Networks

  
         		[bookmark: pgfId-67249]The area networks.

  
        

 
         
         		[bookmark: pgfId-67255]Options

  
         		[bookmark: pgfId-67257]The options, if any, set for the area type.

  
        

 
         
         		[bookmark: pgfId-67263]Authentication

  
         		[bookmark: pgfId-67265]The type of authentication set for the area (None, Password, or MD5).

  
        

 
         
         		[bookmark: pgfId-67271]Cost

  
         		[bookmark: pgfId-67273]The default cost for the area.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-74849][bookmark: 124285][bookmark: pxpage_cncpt_AddEditAreaAreaNetworksDialogBox]Add/Edit Area/Area Networks Dialog Box[bookmark: marker-74843][bookmark: marker-74845][bookmark: marker-74847]

 
     [bookmark: pgfId-74851]Use the Add/Edit Area/Area Networks dialog box to define area parameters, the networks contained by the area, and the OSPF process associated with the area.

 
     [bookmark: pgfId-74853]Navigation Path

 
     [bookmark: pgfId-74858]You can access the Add/Edit Area/Area Networks dialog box from the Area Tab.

 
     [bookmark: pgfId-74860]Related Topics

 
      
      		 [bookmark: pgfId-74865]Configuring OSPF

 
     

 
     [bookmark: pgfId-74867]Field Reference

 
     [bookmark: pgfId-74870] 

 
      
       
        
        [bookmark: pgfId-67286]Table 55-33 [bookmark: 124314]Add/Edit Area/Area Networks Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-67292]Element
          
  
         		
           
           [bookmark: pgfId-67294]Description
          
  
        

 
         
         		[bookmark: pgfId-67300]OSPF Process

  
         		[bookmark: pgfId-67302]When adding a new area, choose the OSPF process ID for the OSPF process for which the area is being added. If there is only one OSPF process enabled on the security appliance, that process is selected by default. When editing an existing area, you cannot change the OSPF process ID.

  
        

 
         
         		[bookmark: pgfId-67308]Area ID

  
         		[bookmark: pgfId-67310]When adding a new area, enter the area ID. You can specify the area ID as either a decimal number or an IP address. Valid decimal values range from 0 to 4294967295. You cannot change the area ID when editing an existing area.

  
        

 
         
         		 
           
           [bookmark: pgfId-67316]Area Type
          
  
        

 
         
         		[bookmark: pgfId-67324]Normal

  
         		[bookmark: pgfId-67326]Choose this option to make the area a standard OSPF area. This option is selected by default when you first create an area.

  
        

 
         
         		[bookmark: pgfId-67332]Stub

  
         		[bookmark: pgfId-67334]Choosing this option makes the area a stub area. Stub areas do not have any routers or areas beyond it. Stub areas prevent AS External LSAs (Type 5 LSAs) from being flooded into the stub area. When you create a stub area, you can prevent summary LSAs (Type 3 and 4) from being flooded into the area by deselecting the Summary check box.

  
        

 
         
         		[bookmark: pgfId-67340]Summary (allows sending LSAs into the stub area)

  
         		[bookmark: pgfId-67342]When the area being defined is a stub area, deselecting this check box prevents LSAs from being sent into the stub area. This check box is selected by default for stub areas.

  
        

 
         
         		[bookmark: pgfId-67348]NSSA

  
         		[bookmark: pgfId-67350]Choose this option to make the area a not-so-stubby area. NSSAs accept Type 7 LSAs. When you create a NSSA, you can prevent summary LSAs from being flooded into the area by deselecting the Summary check box. You can also disable route redistribution by deselecting the Redistribute check box and enabling Default Information Originate.

  
        

 
         
         		[bookmark: pgfId-67356]Redistribute (imports routes to normal and NSSA areas)

  
         		[bookmark: pgfId-67358]Deselect this check box to prevent routes from being imported into the NSSA. This check box is selected by default.

  
        

 
         
         		[bookmark: pgfId-67364]Summary (allows sending LSAs into the NSSA area)

  
         		[bookmark: pgfId-67366]When the area being defined is a NSSA, deselecting this check box prevents LSAs from being sent into the stub area. This check box is selected by default for NSSAs.

  
        

 
         
         		[bookmark: pgfId-67372]Default Information Originate (generate a Type 7 default)

  
         		[bookmark: pgfId-67374]Select this check box to generate a Type 7 default into the NSSA. This check box is deselected by default.

  
        

 
         
         		[bookmark: pgfId-67380]Metric Value

  
         		[bookmark: pgfId-67382]Specifies the OSPF metric value for the default route. Valid values range from 0 to 16777214. The default value is 1.

  
        

 
         
         		[bookmark: pgfId-67388]Metric Type

  
         		[bookmark: pgfId-67390]The OSPF metric type for the default route. The choices are 1 (Type 1) or 2 (Type 2). The default value is 2.

  
        

 
         
         		[bookmark: pgfId-67396]Network

  
         		[bookmark: pgfId-67398]The IP address and network mask of the network or host to be added to the area. Use 0.0.0.0 with a netmask of 0.0.0.0 to create the default area. You can only use 0.0.0.0 in one area.

 to select the interfaces from a list of interface objects.  
        

 
         
         		[bookmark: pgfId-67406]Authentication

  
         		[bookmark: pgfId-67408]Contains the settings for OSPF area authentication.

 
           
           		 [bookmark: pgfId-67410]None—Choose this option to disable OSPF area authentication. This is the default setting.

 
           		 [bookmark: pgfId-67412]Password—Choose this option to use a clear text password for area authentication. This option is not recommended where security is a concern.

 
           		 [bookmark: pgfId-67414]MD5—Choose this option to use MD5 authentication.

 
          

  
        

 
         
         		[bookmark: pgfId-67420]Default Cost

  
         		[bookmark: pgfId-67422]Specify a default cost for the area. Valid values range from 0 to 65535 for ASA devices earlier than 9.2(1) and from 0 to 16777214 for ASA 9.2(1)+. The default value is 1.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-74884][bookmark: 124410][bookmark: pxpage_cncpt_RangeTab]Range Tab[bookmark: marker-74878][bookmark: marker-74880][bookmark: marker-74882]

 
     [bookmark: pgfId-74886]Use the Range tab to summarize routes between areas.

 
     [bookmark: pgfId-74888]Navigation Path

 
     [bookmark: pgfId-74893]You can access the Range tab from the OSPF page. For more information about the OSPF page, see Configuring OSPF.

 
     [bookmark: pgfId-74895]Related Topics

 
      
      		 [bookmark: pgfId-74900]Add/Edit Area Range Network Dialog Box

 
     

 
     [bookmark: pgfId-74902]Field Reference

 
     [bookmark: pgfId-74905] 

 
      
       
        
        [bookmark: pgfId-67435]Table 55-34 [bookmark: 124439]Range Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-67441]Element
          
  
         		
           
           [bookmark: pgfId-67443]Description
          
  
        

 
         
         		[bookmark: pgfId-67449]Process ID

  
         		[bookmark: pgfId-67451]The ID of the OSPF process associated with the route summary.

  
        

 
         
         		[bookmark: pgfId-67457]Area ID

  
         		[bookmark: pgfId-67459]The ID of the area associated with the route summary.

  
        

 
         
         		[bookmark: pgfId-67465]Network

  
         		[bookmark: pgfId-67467]The summary IP address and network mask.

  
        

 
         
         		[bookmark: pgfId-67473]Advertise

  
         		[bookmark: pgfId-67475]Displays “true” if the route summaries are advertised when they match the address/mask pair or “false” if the route summaries are suppressed when they match the address/mask pair.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-74919][bookmark: 124469][bookmark: pxpage_cncpt_AddEditAreaRangeNetworkDialogBox]Add/Edit Area Range Network Dialog Box[bookmark: marker-74913][bookmark: marker-74915][bookmark: marker-74917]

 
     [bookmark: pgfId-74921]Use the Add/Edit Area Range Network dialog box to add a new entry to the Route Summarization table or to change an existing entry.

 
     [bookmark: pgfId-74923]Navigation Path

 
     [bookmark: pgfId-74928]You can access the Add/Edit Area Range Network dialog box from the Range Tab.

 
     [bookmark: pgfId-74930]Related Topics

 
      
      		 [bookmark: pgfId-74935]Configuring OSPF

 
     

 
     [bookmark: pgfId-74937]Field Reference

 
     [bookmark: pgfId-74940] 

 
      
       
        
        [bookmark: pgfId-67488]Table 55-35 [bookmark: 124498]Add/Edit Area Range Network Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-67494]Element
          
  
         		
           
           [bookmark: pgfId-67496]Description
          
  
        

 
         
         		[bookmark: pgfId-67502]OSPF Process

  
         		[bookmark: pgfId-67504]Select the OSPF process to which the route summary applies. You cannot change this value when editing an existing route summary entry.

  
        

 
         
         		[bookmark: pgfId-67510]Area

  
         		[bookmark: pgfId-67512]Select the area ID of the area to which the route summary applies. You cannot change this value when editing an existing route summary entry.

  
        

 
         
         		[bookmark: pgfId-67518]Network

  
         		[bookmark: pgfId-67520]The IP address and mask of the network for the routes being summarized.

 to select the networks from a list of network objects.  
        

 
         
         		[bookmark: pgfId-67528]Advertise

  
         		[bookmark: pgfId-67530]Select this check box to set the address range status to “advertise”. This causes Type 3 summary LSAs to be generated. Deselect this check box to suppress the Type 3 summary LSA for the specified networks.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-74954][bookmark: 124532][bookmark: pxpage_cncpt_NeighborsTab]Neighbors Tab[bookmark: marker-74948][bookmark: marker-74950][bookmark: marker-74952]

 
     [bookmark: pgfId-74956]Use the Neighbors tab to define static neighbors. You need to define a static neighbor for each point-to-point, non-broadcast interface. You also need to define a static route for each static neighbor in the Neighbors table.

 
     [bookmark: pgfId-74958]Navigation Path

 
     [bookmark: pgfId-74963]You can access the Neighbors tab from the OSPF page. For more information about the OSPF page, see Configuring OSPF.

 
     [bookmark: pgfId-74965]Related Topics

 
      
      		 [bookmark: pgfId-74970]Add/Edit Static Neighbor Dialog Box

 
     

 
     [bookmark: pgfId-74972]Field Reference

 
     [bookmark: pgfId-74975] 

 
      
       
        
        [bookmark: pgfId-67543]Table 55-36 [bookmark: 124561]Neighbors Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-67549]Element
          
  
         		
           
           [bookmark: pgfId-67551]Description
          
  
        

 
         
         		[bookmark: pgfId-67557]OSPF Process

  
         		[bookmark: pgfId-67559]The OSPF process associated with the static neighbor.

  
        

 
         
         		[bookmark: pgfId-67565]Neighbor

  
         		[bookmark: pgfId-67567]The IP address of the static neighbor.

  
        

 
         
         		[bookmark: pgfId-67573]Interface

  
         		[bookmark: pgfId-67575]The interface associated with the static neighbor.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-74989][bookmark: 124586][bookmark: pxpage_cncpt_AddEditStaticNeighborDialogBox]Add/Edit Static Neighbor Dialog Box[bookmark: marker-74983][bookmark: marker-74985][bookmark: marker-74987]

 
     [bookmark: pgfId-74991]Use the Add/Edit Static Neighbor dialog box to define a static neighbor or change information for an existing static neighbor. You must define a static neighbor for each point-to-point, non-broadcast interface.

 
     [bookmark: pgfId-74993]Navigation Path

 
     [bookmark: pgfId-74998]You can access the Add/Edit Static Neighbor dialog box from the Neighbors Tab.

 
     [bookmark: pgfId-75000]Related Topics

 
      
      		 [bookmark: pgfId-75005]Configuring OSPF

 
     

 
     [bookmark: pgfId-75007]Field Reference

 
     [bookmark: pgfId-75010] 

 
      
       
        
        [bookmark: pgfId-67588]Table 55-37 [bookmark: 124615]Add/Edit Static Neighbor Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-67594]Element
          
  
         		
           
           [bookmark: pgfId-67596]Description
          
  
        

 
         
         		[bookmark: pgfId-67602]OSPF Process

  
         		[bookmark: pgfId-67604]The OSPF process associated with the static neighbor.

  
        

 
         
         		[bookmark: pgfId-67610]Neighbor

  
         		[bookmark: pgfId-67612]The IP address of the static neighbor.

 to select the neighbor from a list of host objects.  
        

 
         
         		[bookmark: pgfId-67620]Interface

  
         		[bookmark: pgfId-67622]The interface associated with the static neighbor.

 to select the interface from a list of interface objects.  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-75024][bookmark: 124646][bookmark: pxpage_cncpt_RedistributionTab]Redistribution Tab[bookmark: marker-75018][bookmark: marker-75020][bookmark: marker-75022]

 
     [bookmark: pgfId-75026]Use the Redistribution tab to define the rules for redistributing routes from one routing domain to another.

 
     [bookmark: pgfId-75028]Navigation Path

 
     [bookmark: pgfId-75033]You can access the Redistribution tab from the OSPF page. For more information about the OSPF page, see Configuring OSPF.

 
     [bookmark: pgfId-75035]Related Topics

 
      
      		 [bookmark: pgfId-75040]Redistribution Dialog Box

 
     

 
     [bookmark: pgfId-75042]Field Reference

 
     [bookmark: pgfId-75045] 

 
      
       
        
        [bookmark: pgfId-67637]Table 55-38 [bookmark: 124675]Redistribution Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-67643]Element
          
  
         		
           
           [bookmark: pgfId-67645]Description
          
  
        

 
         
         		[bookmark: pgfId-67651]OSPF Process

  
         		[bookmark: pgfId-67653]The OSPF process associated with the route redistribution entry.

  
        

 
         
         		[bookmark: pgfId-67659]Route Type

  
         		[bookmark: pgfId-67661]The source protocol the routes are being redistributed from. Valid entries are the following:

 
           
           		 [bookmark: pgfId-67663]BGP—Redistribute routes from the BGP routing process.

 
           		 [bookmark: pgfId-67665]Connected—Redistributes connected routes (routes established automatically by virtue of having IP address enabled on the interface) to the OSPF routing process. Connected routes are redistributed as external to the AS.

 
           		 [bookmark: pgfId-67667]EIGRP—Redistributes routes from the EIGRP routing process. Choose the autonomous system number of the EIGRP routing process from the list.

 
           		 [bookmark: pgfId-67669]OSPF—Redistributes routes from another OSPF routing process.

 
           		 [bookmark: pgfId-67671]RIP—Redistributes routes from the RIP routing process.

 
           		 [bookmark: pgfId-67673]Static—Redistributes static routes to the OSPF routing process.

 
          

  
        

 
         
         		[bookmark: pgfId-67679]Match

  
         		[bookmark: pgfId-67681]The conditions used for redistributing routes from one routing protocol to another. These options are not available when redistributing static, connected, RIP, BGP, or EIGRP routes.

  
        

 
         
         		[bookmark: pgfId-67687]Subnets

  
         		[bookmark: pgfId-67689]Displays “true” if subnetted routes are redistributed. Does not display anything if only routes that are not subnetted are redistributed.

  
        

 
         
         		[bookmark: pgfId-67695]Metric Value

  
         		[bookmark: pgfId-67697]The metric that is used for the route. This column is blank for redistribution entries if the default metric is used.

  
        

 
         
         		[bookmark: pgfId-67703]Metric Type

  
         		[bookmark: pgfId-67705]Displays “1” if the metric is a Type 1 external route, “2” if the metric is Type 2 external route.

  
        

 
         
         		[bookmark: pgfId-67711]Tag Value

  
         		[bookmark: pgfId-67713]A 32-bit decimal value attached to each external route. This value is not used by OSPF itself. It may be used to communicate information between ASBRs. Valid values range from 0 to 4294967295.

  
        

 
         
         		[bookmark: pgfId-67719]Route Map

  
         		[bookmark: pgfId-67721]The name of the route map object to apply to the redistribution entry.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-75059][bookmark: 124738][bookmark: pxpage_cncpt_RedistributionDialogBox]Redistribution Dialog Box[bookmark: marker-75053][bookmark: marker-75055][bookmark: marker-75057]

 
     [bookmark: pgfId-75061]Use the Redistribution dialog box to add a redistribution rule or to edit an existing redistribution rule in the Redistribution table.

 
     [bookmark: pgfId-75063]Navigation Path

 
     [bookmark: pgfId-75068]You can access the Redistribution dialog box from the Redistribution Tab.

 
     [bookmark: pgfId-75070]Related Topics

 
      
      		 [bookmark: pgfId-75075]Configuring OSPF

 
     

 
     [bookmark: pgfId-75077]Field Reference

 
     [bookmark: pgfId-75080] 

 
      
       
        
        [bookmark: pgfId-67734]Table 55-39 [bookmark: 124767]OSPF Redistribution Settings Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-67740]Element
          
  
         		
           
           [bookmark: pgfId-67742]Description
          
  
        

 
         
         		[bookmark: pgfId-67748]OSPF Process

  
         		[bookmark: pgfId-67750]Select the OSPF process associated with the route redistribution entry.

  
        

 
         
         		[bookmark: pgfId-67756]Route Type

  
         		[bookmark: pgfId-67758]Select the source protocol from which the routes are being redistributed. You can choose one of the following options:

 
           
           		 [bookmark: pgfId-67760]BGP—Redistribute routes from the BGP routing process.

 
           		 [bookmark: pgfId-67762]Connected—Redistributes connected routes (routes established automatically by virtue of having IP address enabled on the interface) to the OSPF routing process. Connected routes are redistributed as external to the AS.

 
           		 [bookmark: pgfId-67764]EIGRP—Redistributes routes from the EIGRP routing process. Choose the autonomous system number of the EIGRP routing process from the list.

 
           		 [bookmark: pgfId-67766]OSPF—Redistributes routes from another OSPF routing process. If you choose this protocol, the Match options on this dialog box become visible. These options are not available when redistributing static, connected, RIP, BGP, or EIGRP routes.

 
           		 [bookmark: pgfId-67768]RIP—Redistributes routes from the RIP routing process.

 
           		 [bookmark: pgfId-67770]Static—Redistributes static routes to the OSPF routing process.

 
          

  
        

 
         
         		[bookmark: pgfId-67776]Routing Process ID

  
         		[bookmark: pgfId-67778]The autonomous system (AS) number for the BGP or EIGRP routing process.

  
        

 
         
         		[bookmark: pgfId-67784]Match

  
         		[bookmark: pgfId-67786]If you have chosen OSPF as the Route Type, choose the conditions used for redistributing routes from one routing protocol to another. The routes must match the selected condition to be redistributed. You can choose one or more of the following match conditions:

 
           
           		 [bookmark: pgfId-67788]Internal—The route is internal to a specific AS.

 
           		 [bookmark: pgfId-67790]External 1—Routes that are external to the autonomous system, but are imported into OSPF as Type 1 external routes.

 
           		 [bookmark: pgfId-67792]External 2—Routes that are external to the autonomous system, but are imported into OSPF as Type 2 external routes.

 
           		 [bookmark: pgfId-67794]NSSA External 1—Routes that are external to the autonomous system, but are imported into OSPF as Type 2 NSSA routes.

 
           		 [bookmark: pgfId-67796]NSSA External 2—Routes that are external to the autonomous system, but are imported into OSPF as Type 2 NSSA routes.

 
          

  
        

 
         
         		[bookmark: pgfId-67802]Metric Value

  
         		[bookmark: pgfId-67804]The metric value for the routes being redistributed. Valid values range from 1 to 16777214. When redistributing from one OSPF process to another OSPF process on the same device, the metric will be carried through from one process to the other if no metric value is specified. When redistributing other processes to an OSPF process, the default metric is 20 when no metric value is specified.

  
        

 
         
         		[bookmark: pgfId-67810]Metric Type

  
         		[bookmark: pgfId-67812]Select “1” if the metric is a Type 1 external route, “2” if the metric is a Type 2 external route.

  
        

 
         
         		[bookmark: pgfId-67818]Tag Value

  
         		[bookmark: pgfId-67820]The tag value is a 32-bit decimal value attached to each external route. This is not used by OSPF itself. It may be used to communicate information between ASBRs. Valid values range from 0 to 4294967295.

  
        

 
         
         		[bookmark: pgfId-67826]Use Subnets

  
         		[bookmark: pgfId-67828]When selected, redistribution of subnetted routes is enabled. Deselect this check box to cause only routes that are not subnetted to be redistributed.

  
        

 
         
         		[bookmark: pgfId-67834]Route Map

  
         		[bookmark: pgfId-67836]Enter or Select a route map object to apply to the redistribution entry.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-75094][bookmark: 124851][bookmark: pxpage_cncpt_VirtualLinkTab]Virtual Link Tab[bookmark: marker-75088][bookmark: marker-75090][bookmark: marker-75092]

 
     [bookmark: pgfId-75096]Use the Virtual Link tab to create virtual links. If you add an area to an OSPF network, and it is not possible to connect the area directly to the backbone area, you need to create a virtual link. A virtual link connects two OSPF devices that have a common area, called the transit area. One of the OSPF devices must be connected to the backbone area.

 
     [bookmark: pgfId-75098]Navigation Path

 
     [bookmark: pgfId-75103]You can access the Virtual Link tab from the OSPF page. For more information about the OSPF page, see Configuring OSPF.

 
     [bookmark: pgfId-75105]Related Topics

 
      
      		 [bookmark: pgfId-75110]Add/Edit OSPF Virtual Link Configuration Dialog Box

 
     

 
     [bookmark: pgfId-75112]Field Reference

 
     [bookmark: pgfId-75115] 

 
      
       
        
        [bookmark: pgfId-67854]Table 55-40 [bookmark: 124880]Virtual Link Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-67860]Element
          
  
         		
           
           [bookmark: pgfId-67862]Description
          
  
        

 
         
         		[bookmark: pgfId-67868]OSPF Process

  
         		[bookmark: pgfId-67870]The OSPF process associated with the virtual link.

  
        

 
         
         		[bookmark: pgfId-67876]Area ID

  
         		[bookmark: pgfId-67878]The ID of the transit area.

  
        

 
         
         		[bookmark: pgfId-67884]Peer Router

  
         		[bookmark: pgfId-67886]The IP address of the virtual link neighbor.

  
        

 
         
         		[bookmark: pgfId-67892]Authentication

  
         		[bookmark: pgfId-67894]Displays the type of authentication used by the virtual link:

 
           
           		 [bookmark: pgfId-67896]None—No authentication is used.

 
           		 [bookmark: pgfId-67898]Password—Clear text password authentication is used.

 
           		 [bookmark: pgfId-67900]MD5—MD5 authentication is used.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-75131][bookmark: 124917][bookmark: pxpage_cncpt_AddEditOSPFVirtualLinkConfigurationDialogBox]Add/Edit OSPF Virtual Link Configuration Dialog Box[bookmark: marker-75125][bookmark: marker-75127][bookmark: marker-75129]

 
     [bookmark: pgfId-75133]Use the Add/Edit OSPF Virtual Link Configuration dialog box to define virtual links or change the properties of existing virtual links.

 
     [bookmark: pgfId-75135]Navigation Path

 
     [bookmark: pgfId-75140]You can access the Add/Edit OSPF Virtual Link Configuration dialog box from the Virtual Link Tab.

 
     [bookmark: pgfId-75142]Related Topics

 
      
      		 [bookmark: pgfId-75147]Add/Edit OSPF Virtual Link MD5 Configuration Dialog Box

 
      		 [bookmark: pgfId-75152]Configuring OSPF

 
     

 
     [bookmark: pgfId-75154]Field Reference

 
     [bookmark: pgfId-75157] 

 
      
       
        
        [bookmark: pgfId-67913]Table 55-41 [bookmark: 124950]Add/Edit OSPF Virtual Link Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-67919]Element
          
  
         		
           
           [bookmark: pgfId-67921]Description
          
  
        

 
         
         		[bookmark: pgfId-67927]OSPF Process

  
         		[bookmark: pgfId-67929]Select the OSPF process associated with the virtual link.

  
        

 
         
         		[bookmark: pgfId-67935]Area ID

  
         		[bookmark: pgfId-67937]Select the area shared by the neighbor OSPF devices. The selected area cannot be an NSSA or a stub area.

  
        

 
         
         		[bookmark: pgfId-67943]Peer Router

  
         		[bookmark: pgfId-67945]Enter the IP address of the virtual link neighbor.

  
        

 
         
         		[bookmark: pgfId-67951]Hello Interval

  
         		[bookmark: pgfId-67953]The interval, in seconds, between hello packets sent on an interface. The smaller the hello interval, the faster topological changes are detected but the more traffic is sent on the interface. This value must be the same for all routers and access servers on a specific interface. Valid values range from 1 to 65535 seconds for ASA devices earlier than 9.2(1) and from 1 to 8192 seconds for ASA 9.2(1)+. The default value is 10 seconds.

  
        

 
         
         		[bookmark: pgfId-67959]Retransmit Interval

  
         		[bookmark: pgfId-67961]The time, in seconds, between LSA retransmissions for adjacencies belonging to the interface. When a router sends an LSA to its neighbor, it keeps the LSA until it receives the acknowledgement message. If the router receives no acknowledgement, it will resend the LSA. Be conservative when setting this value, or needless retransmission can result. The value should be larger for serial lines and virtual links. Valid values range from 1 to 65535 seconds for ASA devices earlier than 9.2(1) and from 1 to 8192 seconds for ASA 9.2(1)+. The default value is 5 seconds.

  
        

 
         
         		[bookmark: pgfId-67967]Transmit Delay

  
         		[bookmark: pgfId-67969]The estimated time, in seconds, required to send an LSA packet on the interface. LSAs in the update packet have their ages increased by the amount specified by this field before transmission. If the delay is not added before transmission over a link, the time in which the LSA propagates over the link is not considered. The value assigned should take into account the transmission and propagation delays for the interface. This setting has more significance on very low-speed links. Valid values range from 1 to 65535 seconds for ASA devices earlier than 9.2(1) and from 1 to 8192 seconds for ASA 9.2(1)+. The default value is 1 second.

  
        

 
         
         		[bookmark: pgfId-67975]Dead Interval

  
         		[bookmark: pgfId-67977]The interval, in seconds, in which no hello packets are received, causing neighbors to declare a router down. Valid values range from 1 to 65535 seconds for ASA devices earlier than 9.2(1) and from 1 to 8192 seconds for ASA 9.2(1)+. The default value of this field is four times the interval set by the Hello Interval field.

  
        

 
         
         		[bookmark: pgfId-67983]Authentication

  
         		[bookmark: pgfId-67985]Contains the OSPF authentication options.

 
           
           		 [bookmark: pgfId-67987]None—Choose this option to disable OSPF authentication.

 
           		 [bookmark: pgfId-67992]Area—Choose this option to use the authentication type specified for the area. See Add/Edit Area/Area Networks Dialog Box for information about configuring area authentication. Area authentication is disabled by default. Therefore, unless you have previously specified an area authentication type, interfaces set to area authentication have authentication disabled until you configure this setting.

 
           		 [bookmark: pgfId-67994]Password—Choose this option to use clear text password authentication. This is not recommended where security is a concern.

 
           		 [bookmark: pgfId-67996]MD5—Choose this option to use MD5 authentication (recommended).

 
          

  
        

 
         
         		[bookmark: pgfId-68002]Authentication Password

  
         		[bookmark: pgfId-68004]Contains the settings for entering the password when password authentication is enabled.

 
           
           		 [bookmark: pgfId-68006]Password—Enter a text string of up to 8 characters.

 
           		 [bookmark: pgfId-68008]Confirm—Re-enter the password.

 
          

  
        

 
         
         		[bookmark: pgfId-68014]MD5 IDs and Keys

  
         		[bookmark: pgfId-68016]Contains the settings for entering the MD5 keys and parameters when MD5 authentication is enabled. All devices on the interface using OSPF authentication must use the same MD5 key and ID.

 
           
           		 [bookmark: pgfId-68018]MD5 Key ID and MD5 Key Table

 
          

 [bookmark: pgfId-68020] – MD5 Key ID—A numerical key identifier. Valid values range from 1 to 255.

 [bookmark: pgfId-68022] – MD5 Key—An alphanumeric character string of up to 16 bytes.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-75171][bookmark: 125034][bookmark: pxpage_cncpt_AddEditOSPFVirtualLinkMDConfigurationDialogBox]Add/Edit OSPF Virtual Link MD5 Configuration Dialog Box[bookmark: marker-75165][bookmark: marker-75167][bookmark: marker-75169]

 
     [bookmark: pgfId-75173]Use the Add/Edit OSPF Virtual Link MD5 Configuration dialog box to define MD5 keys for authentication of virtual links.

 
     [bookmark: pgfId-75175]Navigation Path

 
     [bookmark: pgfId-75180]You can access the Add/Edit OSPF Virtual Link MD5 Configuration dialog box from the Add/Edit OSPF Virtual Link Configuration Dialog Box.

 
     [bookmark: pgfId-75182]Related Topics

 
      
      		 [bookmark: pgfId-75187]Add/Edit OSPF Virtual Link Configuration Dialog Box

 
      		 [bookmark: pgfId-75192]Virtual Link Tab

 
      		 [bookmark: pgfId-75197]Configuring OSPF

 
     

 
     [bookmark: pgfId-75199]Field Reference

 
     [bookmark: pgfId-75202] 

 
      
       
        
        [bookmark: pgfId-68035]Table 55-42 [bookmark: 125069]Add/Edit OSPF Virtual Link MD5 Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-68041]Element
          
  
         		
           
           [bookmark: pgfId-68043]Description
          
  
        

 
         
         		[bookmark: pgfId-68049]MD5 Key ID

  
         		[bookmark: pgfId-68051]A numerical key identifier. Valid values range from 1 to 255.

  
        

 
         
         		[bookmark: pgfId-68057]MD5 Key

  
         		[bookmark: pgfId-68059]An alphanumeric character string of up to 16 bytes.

  
        

 
         
         		[bookmark: pgfId-68065]Confirm

  
         		[bookmark: pgfId-68067]Re-enter the MD5 key.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-75216][bookmark: 125096][bookmark: pxpage_cncpt_FilteringTab]Filtering Tab[bookmark: marker-75210][bookmark: marker-75212][bookmark: marker-75214]

 
     [bookmark: pgfId-75218]Use the Filtering tab to configure the ABR Type 3 LSA filters for each OSPF process. ABR Type 3 LSA filters allow only specified prefixes to be sent from one area to another area and restricts all other prefixes. This type of area filtering can be applied out of a specific OSPF area, into a specific OSPF area, or into and out of the same OSPF areas at the same time.

 
     [bookmark: pgfId-75220]Benefits

 
     [bookmark: pgfId-75222]OSPF ABR Type 3 LSA filtering improves your control of route distribution between OSPF areas.

 
     [bookmark: pgfId-75224]Restrictions

 
     [bookmark: pgfId-75226]Only type-3 LSAs that originate from an ABR are filtered.

 
     [bookmark: pgfId-75228]Navigation Path

 
     [bookmark: pgfId-75233]You can access the Filtering tab from the OSPF page. For more information about the OSPF page, see Configuring OSPF.

 
     [bookmark: pgfId-75235]Related Topics

 
      
      		 [bookmark: pgfId-75240]Add/Edit Filtering Dialog Box

 
     

 
     [bookmark: pgfId-75242]Field Reference

 
     [bookmark: pgfId-75245] 

 
      
       
        
        [bookmark: pgfId-68080]Table 55-43 [bookmark: 125131]Filtering Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-68086]Element
          
  
         		
           
           [bookmark: pgfId-68088]Description
          
  
        

 
         
         		[bookmark: pgfId-68094]OSPF Process

  
         		[bookmark: pgfId-68096]The OSPF process associated with the filter entry.

  
        

 
         
         		[bookmark: pgfId-68102]Area ID

  
         		[bookmark: pgfId-68104]The ID of the area associated with the filter entry.

  
        

 
         
         		[bookmark: pgfId-68110]Prefix List Name

  
         		[bookmark: pgfId-68112]The name of the prefix list.

  
        

 
         
         		[bookmark: pgfId-68118]Filtered Network

  
         		[bookmark: pgfId-68120]The IP address and mask of the network being filtered.

  
        

 
         
         		[bookmark: pgfId-68126]Traffic Direction

  
         		[bookmark: pgfId-68128]Displays “Inbound” if the filter entry applies to LSAs coming in to an OSPF area or “Outbound” if it applies to LSAs going out of an OSPF area.

  
        

 
         
         		[bookmark: pgfId-68134]Sequence #

  
         		[bookmark: pgfId-68136]The sequence number for the filter entry. When multiple filters apply to an LSA, the filter with the lowest sequence number is used.

  
        

 
         
         		[bookmark: pgfId-68142]Action

  
         		[bookmark: pgfId-68144]Displays “Permit” if LSAs matching the filter are allowed or “Deny” if LSAs matching the filter are denied.

  
        

 
         
         		[bookmark: pgfId-68150]Lower Range

  
         		[bookmark: pgfId-68152]The minimum prefix length to be matched.

  
        

 
         
         		[bookmark: pgfId-68158]Upper Range

  
         		[bookmark: pgfId-68160]The maximum prefix length to be matched.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-75259][bookmark: 125186][bookmark: pxpage_cncpt_AddEditFilteringDialogBox]Add/Edit Filtering Dialog Box[bookmark: marker-75253][bookmark: marker-75255][bookmark: marker-75257]

 
     [bookmark: pgfId-75261]Use the Add/Edit Filtering dialog box to add new filters to the Filter table or to modify an existing filter.

 
     [bookmark: pgfId-75263]Navigation Path

 
     [bookmark: pgfId-75268]You can access the Add/Edit Filtering dialog box from the Filtering Tab.

 
     [bookmark: pgfId-75270]Related Topics

 
      
      		 [bookmark: pgfId-75275]Configuring OSPF

 
     

 
     [bookmark: pgfId-75277]Field Reference

 
     [bookmark: pgfId-75280] 

 
      
       
        
        [bookmark: pgfId-68173]Table 55-44 [bookmark: 125215]Add/Edit Filtering Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-68179]Element
          
  
         		
           
           [bookmark: pgfId-68181]Description
          
  
        

 
         
         		[bookmark: pgfId-68187]OSPF Process

  
         		[bookmark: pgfId-68189]Select the OSPF process associated with the filter entry.

  
        

 
         
         		[bookmark: pgfId-68195]Area ID

  
         		[bookmark: pgfId-68197]Select the ID of the area associated with the filter entry.

  
        

 
         
         		[bookmark: pgfId-68203]Prefix List Name

  
         		[bookmark: pgfId-68205]Enter or Select the appropriate prefix list object.

 to open the Prefix List Object Selector from which you can select a prefix list object. You can also create new objects from the object Prefix List Object selector. For more information, see Add or Edit Prefix List Object Dialog Box.  
        

 
         
         		[bookmark: pgfId-68216]Filtered Network

  
         		[bookmark: pgfId-68218]Enter the IP address and mask of the network being filtered.

  
        

 
         
         		[bookmark: pgfId-68224]Traffic Direction

  
         		[bookmark: pgfId-68226]Select the traffic direction to filter. Choose “Inbound” to filter LSAs coming into an OSPF area or “Outbound” to filter LSAs going out of an OSPF area.

  
        

 
         
         		[bookmark: pgfId-68232]Sequence Number

  
         		[bookmark: pgfId-68234]Enter a sequence number for the filter. Valid values range from 1 to 4294967294. When multiple filters apply to an LSA, the filter with the lowest sequence number is used.

  
        

 
         
         		[bookmark: pgfId-68240]Action

  
         		[bookmark: pgfId-68242]Select “Permit” to allow the LSA traffic or “Deny” to block the LSA traffic.

  
        

 
         
         		[bookmark: pgfId-68248]Lower Range

  
         		[bookmark: pgfId-68250]Specify the minimum prefix length to be matched. The value of this setting must be greater than the length of the network mask entered in the Filtered Network field and less than or equal to the value, if present, entered in the Upper Range field.

  
        

 
         
         		[bookmark: pgfId-68256]Upper Range

  
         		[bookmark: pgfId-68258]Enter the maximum prefix length to be matched. The value of this setting must be greater than or equal to the value, if present, entered in the Lower Range field, or, if the Lower Range field is left blank, greater than the length of the network mask length entered in the Filtered Network field.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-75294][bookmark: 125275][bookmark: pxpage_cncpt_FilterRuleTab]Filter Rule Tab[bookmark: marker-75288][bookmark: marker-75290][bookmark: marker-75292]

 
     [bookmark: pgfId-75296]Use the Filter Rule tab to configure rules to filter networks received or transmitted in Open Shortest Path First (OSPF) updates.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-75298]Note Filter rules are supported on ASA 9.2(1)+ only.


     
      

     

     

 
     [bookmark: pgfId-75300]Navigation Path

 
     [bookmark: pgfId-75305]You can access the Filter Rule tab from the OSPF page. For more information about the OSPF page, see Configuring OSPF.

 
     [bookmark: pgfId-75307]Related Topics

 
      
      		 [bookmark: pgfId-75312]Add/Edit Filter Rule Dialog Box

 
     

 
     [bookmark: pgfId-75314]Field Reference

 
     [bookmark: pgfId-75317] 

 
      
       
        
        [bookmark: pgfId-68271]Table 55-45 [bookmark: 125305]Filter Rule Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-68277]Element
          
  
         		
           
           [bookmark: pgfId-68279]Description
          
  
        

 
         
         		[bookmark: pgfId-68285]Process ID

  
         		[bookmark: pgfId-68287]The OSPF process associated with the filter rule.

  
        

 
         
         		[bookmark: pgfId-68293]ACL

  
         		[bookmark: pgfId-68295]Standard IP access list name. The list defines which networks are to be received and which are to be suppressed in routing updates.

  
        

 
         
         		[bookmark: pgfId-68301]Direction

  
         		[bookmark: pgfId-68303]The direction for the filter rule:

 
           
           		 [bookmark: pgfId-68305]in—The rule filters default route information from incoming routing updates.

 
           		 [bookmark: pgfId-68307]out—The rule filters default route information from outgoing routing updates.

 
          

  
        

 
         
         		[bookmark: pgfId-68313]Interface

  
         		[bookmark: pgfId-68315](Optional) The interface to which the filter rule applies.

  
        

 
         
         		[bookmark: pgfId-68321]Routing Process

  
         		[bookmark: pgfId-68323]The routing process: None, BGP, Connected, EIGRP, OSPF, RIP, or Static.

  
        

 
         
         		[bookmark: pgfId-68329]Routing Process ID

  
         		[bookmark: pgfId-68331]The identifier for the routing process.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-75331][bookmark: 125350][bookmark: pxpage_cncpt_AddEditFilterRuleDialogBox]Add/Edit Filter Rule Dialog Box[bookmark: marker-75325][bookmark: marker-75327][bookmark: marker-75329]

 
     [bookmark: pgfId-75333]Use the Add/Edit Filter Rule dialog box to add new filter rules to the Filter Rules table or to modify an existing filter rule.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-75335]Note Filter rules are supported on ASA 9.2(1)+ only.


     
      

     

     

 
     [bookmark: pgfId-75337]Navigation Path

 
     [bookmark: pgfId-75342]You can access the Add/Edit Filter Rule dialog box from the Filter Rule Tab.

 
     [bookmark: pgfId-75344]Related Topics

 
      
      		 [bookmark: pgfId-75349]Configuring OSPF

 
     

 
     [bookmark: pgfId-75351]Field Reference

 
     [bookmark: pgfId-75354] 

 
      
       
        
        [bookmark: pgfId-68344]Table 55-46 [bookmark: 125380]Add/Edit Filter Rule Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-68350]Element
          
  
         		
           
           [bookmark: pgfId-68352]Description
          
  
        

 
         
         		[bookmark: pgfId-68358]OSPF Process

  
         		[bookmark: pgfId-68360]Select the OSPF process associated with the filter rule.

  
        

 
         
         		[bookmark: pgfId-68366]ACL

  
         		[bookmark: pgfId-68368]Select an Access Control List that defines which networks are to be received and which are to be suppressed in routing updates.

  
        

 
         
         		[bookmark: pgfId-68374]Direction

  
         		[bookmark: pgfId-68376]Specify the direction for the filter rule:

 
           
           		 [bookmark: pgfId-68378]in—The rule filters default route information from incoming routing updates.

 
           		 [bookmark: pgfId-68380]out—The rule filters default route information from outgoing routing updates.

 
          

  
        

 
         
         		[bookmark: pgfId-68386]Interface

  
         		[bookmark: pgfId-68388](Optional) Specify the interface on which to apply the routing updates. Specifying an interface causes the access list to be applied only to routing updates received on that interface.

  
        

 
         
         		[bookmark: pgfId-68394]Routing Process

  
         		[bookmark: pgfId-68396]Select the routing process for which you want to filter: None, BGP, Connected, EIGRP, OSPF, RIP, or Static.

  
        

 
         
         		[bookmark: pgfId-68402]Routing Process ID

  
         		[bookmark: pgfId-68404]Enter the identifier for the routing process. Applies to BGP, EIGRP, and OSPF routing protocols.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-75368][bookmark: 125427][bookmark: pxpage_cncpt_SummaryAddressTab]Summary Address Tab[bookmark: marker-75362][bookmark: marker-75364][bookmark: marker-75366]

 
     [bookmark: pgfId-75370]Use the Summary Address tab to configure summary addresses for each OSPF routing process.

 
     [bookmark: pgfId-75372]Routes learned from other routing protocols can be summarized. The metric used to advertise the summary is the smallest metric of all the more specific routes. Summary routes help reduce the size of the routing table.

 
     [bookmark: pgfId-75374]Using summary routes for OSPF causes an OSPF ASBR to advertise one external route as an aggregate for all redistributed routes that are covered by the address. Only routes from other routing protocols that are being redistributed into OSPF can be summarized.

 
     [bookmark: pgfId-75376]Navigation Path

 
     [bookmark: pgfId-75381]You can access the Summary Address tab from the OSPF page. For more information about the OSPF page, see Configuring OSPF.

 
     [bookmark: pgfId-75383]Related Topics

 
      
      		 [bookmark: pgfId-75388]Table 55-48

 
     

 
     [bookmark: pgfId-75390]Field Reference

 
     [bookmark: pgfId-75393] 

 
      
       
        
        [bookmark: pgfId-68417]Table 55-47 [bookmark: 125458]Summary Address Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-68423]Element
          
  
         		
           
           [bookmark: pgfId-68425]Description
          
  
        

 
         
         		[bookmark: pgfId-68431]Process ID

  
         		[bookmark: pgfId-68433]The OSPF process associated with the summary address.

  
        

 
         
         		[bookmark: pgfId-68439]Network

  
         		[bookmark: pgfId-68441]The IP address and network mask of the summary address.

  
        

 
         
         		[bookmark: pgfId-68447]Tag

  
         		[bookmark: pgfId-68449]A 32-bit decimal value attached to each external route. This value is not used by OSPF itself. It may be used to communicate information between ASBRs.

  
        

 
         
         		[bookmark: pgfId-68455]Advertise

  
         		[bookmark: pgfId-68457]Displays “true” if the summary routes are advertised. Displays “false” if the summary route is not advertised.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-75407][bookmark: 125488][bookmark: pxpage_cncpt_AddEditSummaryAddressDialogBox]Add/Edit Summary Address Dialog Box[bookmark: marker-75401][bookmark: marker-75403][bookmark: marker-75405]

 
     [bookmark: pgfId-75409]Use the Add/Edit Summary Address dialog box to add new entries or to modify existing entries in the Summary Address table.

 
     [bookmark: pgfId-75411]Navigation Path

 
     [bookmark: pgfId-75416]You can access the Add/Edit Summary Address dialog box from the Summary Address Tab.

 
     [bookmark: pgfId-75418]Related Topics

 
      
      		 [bookmark: pgfId-75423]Configuring OSPF

 
     

 
     [bookmark: pgfId-75425]Field Reference

 
     [bookmark: pgfId-75428] 

 
      
       
        
        [bookmark: pgfId-68470]Table 55-48 [bookmark: 125517]Add/Edit Summary Address Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-68476]Element
          
  
         		
           
           [bookmark: pgfId-68478]Description
          
  
        

 
         
         		[bookmark: pgfId-68484]OSPF Process

  
         		[bookmark: pgfId-68486]Choose the OSPF process associated with the summary address. You cannot change this information when editing an existing entry.

  
        

 
         
         		[bookmark: pgfId-68492]Network

  
         		[bookmark: pgfId-68494]The IP address and network mask of the summary address.

  
        

 
         
         		[bookmark: pgfId-68500]Tag

  
         		[bookmark: pgfId-68502]The tag value is a 32-bit decimal value attached to each external route. This is not used by OSPF itself. It may be used to communicate information between ASBRs. Valid values range from 0 to 4294967295.

  
        

 
         
         		[bookmark: pgfId-68508]Advertise

  
         		[bookmark: pgfId-68510]When selected, summary routes are advertised. Deselect this check box to suppress routes that fall under the summary address. By default, this check box is selected.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-75442][bookmark: 125549][bookmark: pxpage_cncpt_InterfaceTab]Interface Tab[bookmark: marker-75436][bookmark: marker-75438][bookmark: marker-75440]

 
     [bookmark: pgfId-75444]Use the Interface tab to configure interface-specific OSPF authentication routing properties.

 
     [bookmark: pgfId-75446]Navigation Path

 
     [bookmark: pgfId-75451]You can access the Interface tab from the OSPF page. For more information about the OSPF page, see Configuring OSPF.

 
     [bookmark: pgfId-75453]Related Topics

 
      
      		 [bookmark: pgfId-75458]Table 55-50

 
     

 
     [bookmark: pgfId-75460]Field Reference

 
     [bookmark: pgfId-75463] 

 
      
       
        
        [bookmark: pgfId-68523]Table 55-49 [bookmark: 125578]Interface Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-68529]Element
          
  
         		
           
           [bookmark: pgfId-68531]Description
          
  
        

 
         
         		[bookmark: pgfId-68537]Interface

  
         		[bookmark: pgfId-68539]The name of the interface to which the configuration applies.

  
        

 
         
         		[bookmark: pgfId-68545]Authentication

  
         		[bookmark: pgfId-68547]The type of OSPF authentication enabled on the interface. The authentication type can be one of the following values:

 
           
           		 [bookmark: pgfId-68549]None—OSPF authentication is disabled.

 
           		 [bookmark: pgfId-68551]Password—Clear text password authentication is enabled.

 
           		 [bookmark: pgfId-68553]MD5—MD5 authentication is enabled.

 
           		 [bookmark: pgfId-68555]Area—The authentication type specified for the area is enabled on the interface. Area authentication is the default value for interfaces. However, area authentication is disabled by default. So, unless you previously specified an area authentication type, interfaces showing Area authentication have authentication disabled.

 
          

  
        

 
         
         		[bookmark: pgfId-68561]Point-to-Point

  
         		[bookmark: pgfId-68563]Displays “true” if the interface is set to non-broadcast (point-to-point). Displays “false” if the interface is set to broadcast.

  
        

 
         
         		[bookmark: pgfId-68569]Cost

  
         		[bookmark: pgfId-68571]The cost of sending a packet through the interface.

  
        

 
         
         		[bookmark: pgfId-68577]Priority

  
         		[bookmark: pgfId-68579]The OSPF priority assigned to the interface.

  
        

 
         
         		[bookmark: pgfId-68585]MTU Ignore

  
         		[bookmark: pgfId-68587]Displays “false” if MTU mismatch detection is enabled. Displays “true” if the MTU mismatch detection is disabled.

  
        

 
         
         		[bookmark: pgfId-68593]Database Filter

  
         		[bookmark: pgfId-68595]Displays “true” if outgoing LSAs are filtered during synchronization and flooding. Displays “false” if filtering is not enabled.

  
        

 
         
         		[bookmark: pgfId-68601]Hello Interval

  
         		[bookmark: pgfId-68603]The interval, in seconds, between hello packets sent on an interface. The smaller the hello interval, the faster topological changes are detected but the more traffic is sent on the interface. This value must be the same for all routers and access servers on a specific interface. Valid values range from 1 to 65535 seconds. The default value is 10 seconds.

  
        

 
         
         		[bookmark: pgfId-68609]Transmit Delay

  
         		[bookmark: pgfId-68611]The estimated time, in seconds, required to send an LSA packet on the interface. LSAs in the update packet have their ages increased by the amount specified by this field before transmission. If the delay is not added before transmission over a link, the time in which the LSA propagates over the link is not considered. The value assigned should take into account the transmission and propagation delays for the interface. This setting has more significance on very low-speed links. Valid values range from 1 to 65535 seconds. The default value is 1 second.

  
        

 
         
         		[bookmark: pgfId-68617]Retransmit Interval

  
         		[bookmark: pgfId-68619]The time, in seconds, between LSA retransmissions for adjacencies belonging to the interface. When a router sends an LSA to its neighbor, it keeps the LSA until it receives the acknowledgement message. If the router receives no acknowledgement, it resends the LSA. Be conservative when setting this value, or needless retransmission can result. The value should be larger for serial lines and virtual links. Valid values range from 1 to 65535 seconds. The default value is 5 seconds.

  
        

 
         
         		[bookmark: pgfId-68625]Dead Interval

  
         		[bookmark: pgfId-68627]The interval, in seconds, in which no hello packets are received, causing neighbors to declare a router down. Valid values range from 1 to 65535. The default value of this setting is four times the interval set by the Hello Interval field.

  
        

 
         
         		[bookmark: pgfId-68633]Hello Multiplier

 [bookmark: pgfId-68635](ASA 9.2(1)+ only)

  
         		[bookmark: pgfId-68637]The number of hello packets to be sent per second. Valid values are between 3 and 20.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-75477][bookmark: 125658][bookmark: pxpage_cncpt_AddEditInterfaceDialogBox-2]Add/Edit Interface Dialog Box[bookmark: marker-75471][bookmark: marker-75473][bookmark: marker-75475]

 
     [bookmark: pgfId-75479]Use the Add/Edit Interface dialog box to add OSPF authentication routing properties for an interface or to change an existing entry.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-75481]Note Beginning with ASA version 9.2(1), the upper limit for acceptable entries for Hello Interval, Transmit Delay, Retransmit Interval, and Dead Interval has been reduced from 65535 seconds to 8192 seconds. If you configure a shared policy that uses a value over 8192, you will receive a validation error if that policy is assigned to an 9.2(1)+ device.


     
      

     

     

 
     [bookmark: pgfId-75483]Navigation Path

 
     [bookmark: pgfId-75488]You can access the Add/Edit Interface dialog box from the Interface Tab.

 
     [bookmark: pgfId-75490]Related Topics

 
      
      		 [bookmark: pgfId-75495]Configuring OSPF

 
     

 
     [bookmark: pgfId-75497]Field Reference

 
     [bookmark: pgfId-75500] 

 
      
       
        
        [bookmark: pgfId-68650]Table 55-50 [bookmark: 125688]Add/Edit Interface Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-68656]Element
          
  
         		
           
           [bookmark: pgfId-68658]Description
          
  
        

 
         
         		[bookmark: pgfId-68664]Interface

  
         		[bookmark: pgfId-68666]The name of the interface to which the configuration applies.

  
        

 
         
         		[bookmark: pgfId-68672]Authentication

  
         		[bookmark: pgfId-68674]The type of OSPF authentication enabled on the interface. The authentication type can be one of the following values:

 
           
           		 [bookmark: pgfId-68676]No Authentication—OSPF authentication is disabled.

 
           		 [bookmark: pgfId-68678]Area Authentication—The authentication type specified for the area is enabled on the interface. Area authentication is the default value for interfaces. However, area authentication is disabled by default. So, unless you previously specified an area authentication type, interfaces showing Area authentication have authentication disabled.

 
           		 [bookmark: pgfId-68680]Password Authentication—Clear text password authentication is enabled.

 
           		 [bookmark: pgfId-68682]MD5 Authentication—MD5 authentication is enabled.

 
          

  
        

 
         
         		[bookmark: pgfId-68688]Authentication Password

  
         		[bookmark: pgfId-68690]Contains the settings for entering the password when password authentication is enabled.

 
           
           		 [bookmark: pgfId-68692]Enter Password—Enter a text string of up to 8 characters.

 
           		 [bookmark: pgfId-68694]Confirm—Re-enter the password.

 
          

  
        

 
         
         		[bookmark: pgfId-68700]MD5 Key IDs and Keys

  
         		[bookmark: pgfId-68702]Contains the settings for entering the MD5 keys and parameters when MD5 authentication is enabled. All devices on the interface using OSPF authentication must use the same MD5 key and ID.

 
           
           		 [bookmark: pgfId-68704]Key ID—Enter a numerical key identifier. Valid values range from 1 to 255.

 
           		 [bookmark: pgfId-68706]Key—An alphanumeric character string of up to 16 bytes.

 
           		 [bookmark: pgfId-68708]Confirm—Re-enter the MD5 key.

 
          

 [bookmark: pgfId-68710]Enter the above values, then click >> to add the key information to the Keys table. Select a key entry and then click << to remove it from the Keys table.

  
        

 
         
         		[bookmark: pgfId-68716]Cost

  
         		[bookmark: pgfId-68718]The cost of sending a packet through the interface.

  
        

 
         
         		[bookmark: pgfId-68724]Priority

  
         		[bookmark: pgfId-68726]The OSPF priority assigned to the interface.

  
        

 
         
         		[bookmark: pgfId-68732]MTU Ignore

  
         		[bookmark: pgfId-68734]When selected, MTU mismatch detection is disabled. Clear this check box to enable MTU mismatch detection.

  
        

 
         
         		[bookmark: pgfId-68740]Database Filter All Out

  
         		[bookmark: pgfId-68742]When selected, outgoing LSAs are filtered during synchronization and flooding. Deselect this check box to disable filtering.

  
        

 
         
         		[bookmark: pgfId-68750][bookmark: marker-68748]Hello Interval (sec)

  
         		[bookmark: pgfId-68752]The interval, in seconds, between hello packets sent on an interface. The smaller the hello interval, the faster topological changes are detected but the more traffic is sent on the interface. This value must be the same for all routers and access servers on a specific interface.

 [bookmark: pgfId-68754]For ASA 9.2(1)+ devices, valid values range from 1 to 8192 seconds. For all other devices, valid values range from 1 to 65535 seconds. The default value is 10 seconds.

  
        

 
         
         		[bookmark: pgfId-68762][bookmark: marker-68760]Transmit Delay (sec)

  
         		[bookmark: pgfId-68764]The estimated time, in seconds, required to send an LSA packet on the interface. LSAs in the update packet have their ages increased by the amount specified by this field before transmission. If the delay is not added before transmission over a link, the time in which the LSA propagates over the link is not considered. The value assigned should take into account the transmission and propagation delays for the interface. This setting has more significance on very low-speed links.

 [bookmark: pgfId-68766]For ASA 9.2(1)+ devices, valid values range from 1 to 8192 seconds. For all other devices, valid values range from 1 to 65535 seconds. The default value is 1 second.

  
        

 
         
         		[bookmark: pgfId-68774][bookmark: marker-68772] Retransmit Interval (sec)

  
         		[bookmark: pgfId-68776]The time, in seconds, between LSA retransmissions for adjacencies belonging to the interface. When a router sends an LSA to its neighbor, it keeps the LSA until it receives the acknowledgment message. If the router receives no acknowledgment, it will resend the LSA. Be conservative when setting this value, or needless retransmission can result. The value should be larger for serial lines and virtual links.

 [bookmark: pgfId-68778]For ASA 9.2(1)+ devices, valid values range from 1 to 8192 seconds. For all other devices, valid values range from 1 to 65535 seconds. The default value is 5 seconds.

  
        

 
         
         		[bookmark: pgfId-68786][bookmark: marker-68784] Dead Interval (sec)

  
         		[bookmark: pgfId-68788]The interval, in seconds, in which no hello packets are received, causing neighbors to declare a router down.

 [bookmark: pgfId-68790]For ASA 9.2(1)+ devices, valid values range from 1 to 8192 seconds. For all other devices, valid values range from 1 to 65535 seconds. The default value of this setting is four times the interval set by the Hello Interval field.

  
        

 
         
         		[bookmark: pgfId-68798][bookmark: marker-68796]Hello Multiplier (Hello/Sec)

 [bookmark: pgfId-68800](ASA 9.2(1)+ only)

  
         		[bookmark: pgfId-68802]The number of hello packets to be sent per second. Valid values are between 3 and 20.

 [bookmark: pgfId-68804]Note If you specify a Hello Multiplier, the Hello Interval and Dead Interval values will be ignored. If you entered a value for Hello Interval or Dead Interval, you will be asked to confirm that you want to use the Hello Multiplier instead of the Hello Interval and Dead Interval settings.

  
        

 
         
         		[bookmark: pgfId-68810]Point-to-Point

  
         		[bookmark: pgfId-68812]Displays “true” if the interface is set to non-broadcast (point-to-point). Displays “false” if the interface is set to broadcast.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-75516][bookmark: 125816][bookmark: pxpage_cncpt_OSPFv3Page]Configuring OSPFv3[bookmark: marker-75510][bookmark: marker-75512][bookmark: marker-75514]

 
    [bookmark: pgfId-75518]The OSPFv3 page provides two tabbed panels for configuring OSPF (Open Shortest Path First) version 3 routing on a firewall device.

 
    [bookmark: pgfId-75520]Navigation Path

 
     
     		 [bookmark: pgfId-75522](Device view) Select  Platform > Routing > OSPFv3 from the Device Policy selector.

 
     		 [bookmark: pgfId-75524](Policy view) Select  PIX/ASA/FWSM Platform > Routing > OSPFv3 from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-75526]This is the basic procedure for configuring an OSPFv3 process and assigning it to an interface on the OSPFv3 page:

 
    [bookmark: pgfId-75531] 1. On the Process Tab:

 
    [bookmark: pgfId-75533] – Specify which of the two processes you are configuring by choosing Process 1 or Process 2 from the OSPFv3 Process drop-down list.

 
    [bookmark: pgfId-75535] – Check Enable OSPFv3 Process.

 
    [bookmark: pgfId-75537] – Assign a Process ID; any positive integer between 1 and 65535.

 
    [bookmark: pgfId-75539] – Use the following features as needed to define the process:

 
    [bookmark: pgfId-75544] – Advanced button, opening the OSPFv3 Advanced Properties Dialog Box.

 
    [bookmark: pgfId-75558] – Area Tab (OSPFv3), for managing area, range, and virtual-link definitions, by means of the Add/Edit Area Dialog Box (OSPFv3), Add/Edit Range Dialog Box (OSPFv3), and Add/Edit Virtual Link Dialog Box (OSPFv3).

 
    [bookmark: pgfId-75563] – Redistribution panel, for managing route redistribution definitions by means of the Add/Edit Redistribution Dialog Box (OSPFv3).

 
    [bookmark: pgfId-75568] – Summary Prefix panel, for managing summary-prefix definitions by means of the Add/Edit Summary Prefix Dialog Box (OSPFv3).

 
    [bookmark: pgfId-75573] 2. On the OSPFv3 Interface Tab:

 
    [bookmark: pgfId-75581] a. Use the Interface and Neighbor panels to assign the process to a specific interface, using the Add/Edit Interface Dialog Box (OSPFv3) and the Add/Edit Neighbor Dialog Box (OSPFv3).

 
    [bookmark: pgfId-75583]Related Topics

 
     
     		 [bookmark: pgfId-75588]About OSPFv3

 
    

 
     
      [bookmark: pgfId-75600][bookmark: 125894][bookmark: pxchap_cncpt_AboutOSPFv3]About OSPFv3 [bookmark: marker-75594][bookmark: marker-75596][bookmark: marker-75598]

 
     [bookmark: pgfId-75605]Open Shortest Path First (OSPF) is an interior gateway routing protocol that uses link states rather than distance vectors for path selection. Version 3 is basically OSPFv2 enhanced for IPv6. It is similar to OSPFv2 (see About OSPF), but it is not backward compatible. To use OSPF to route both IPv4 and IPv6v packets, it will be necessary to run both OSPFv2 and OSPFv3 concurrently. They co-exist with each other, but do not interact.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-75607]Note OSPFv3 is supported on ASA 9.0+ devices operating in single-context, routed mode only. That is, multiple contexts and transparent mode are not supported.


     
      

     

     

 
     [bookmark: pgfId-75609]Think of a link as being an interface on a networking device. A link-state protocol makes its routing decisions based on the states of the links that connect source and destination devices. The state of a link is a description of that interface and its relationship to its neighboring networking devices. This interface information includes the IPv6 prefix/length of the interface, the type of network it is connected to, the devices connected to that network, and so on. This information is propagated in various type of link-state advertisements (LSAs). Because only LSAs are exchanged, rather than entire routing tables, OSPF networks converge more quickly than RIP networks.

 
     [bookmark: pgfId-75611]The ASA can run two processes of the OSPFv3 protocol simultaneously on different sets of interfaces. You might want to run two processes if you have interfaces that use the same IP addresses (NAT allows these interfaces to co-exist, but OSPFv3 does not allow overlapping addresses). Or you might want to run one process on the inside interface and another on the outside, redistributing a subset of routes between the two processes. Similarly, you might need to segregate private addresses from public addresses.

 
     [bookmark: pgfId-75613]You can redistribute routes into an OSPFv3 routing process from another OSPFv3 routing process, a RIP routing process, or from static and connected routes configured on OSPFv3-enabled interfaces.

 
     [bookmark: pgfId-75615]If NAT is employed but OSPFv3 is only running in public areas, routes to public networks can be redistributed inside the private network, either as default or type 5 AS External LSAs. However, you need to configure static routes for the private networks protected by the security appliance. Also, you should not mix public and private networks on the same security appliance interface.

 
     [bookmark: pgfId-75617]Differences Between OSPFv2 and OSPFv3

 
     [bookmark: pgfId-75619]The additional features provided by OSPFv3 over OSPFv2 include the following:

 
      
      		 [bookmark: pgfId-75621]Use of the IPv6 link-local address for neighbor discovery and other features.

 
      		 [bookmark: pgfId-75623]LSAs expressed as prefix and prefix length.

 
      		 [bookmark: pgfId-75625]Addition of two LSA types.

 
      		 [bookmark: pgfId-75627]Handling of unknown LSA types.

 
      		 [bookmark: pgfId-75629]Protocol processing per link.

 
      		 [bookmark: pgfId-75631]Removal of addressing semantics.

 
      		 [bookmark: pgfId-75633]Addition of flooding scope.

 
      		 [bookmark: pgfId-75635]Support for multiple instances per link.

 
      		 [bookmark: pgfId-75637]Authentication support using the IPSec ESP standard for OSPFv3 routing protocol traffic, as specified by RFC-4552.

 
     

 
     [bookmark: pgfId-75639]Configuration Restrictions

 
     [bookmark: pgfId-75641]The following are ASA OSPFv3 configuration restrictions:

 
      
      		 [bookmark: pgfId-75643]To enable OSPFv3 on a specific interface, IPv6 should be enabled on the interface and it must be named.

 
      		 [bookmark: pgfId-75645]Only one OSPFv3 process, with one area and one instance, can be assigned to an interface.

 
      		 [bookmark: pgfId-75647]The Interface neighbor entries take effect only when the OSPFv3 is enabled, and network type should be point-to-point on the specified interface.

 
      		 [bookmark: pgfId-75649]Interface neighbor address must be a link-local address.

 
      		 [bookmark: pgfId-75651]Range value in area Range table should be unique across the area.

 
      		 [bookmark: pgfId-75653]If the area is set to NSSA or stub, the same area cannot be set for virtual-link.

 
      		 [bookmark: pgfId-75655]OSPFv3 redistribution not applicable on the same OSPFv3 process.

 
      		 [bookmark: pgfId-75657]If used in an ASA cluster, OSPFv3 encryption should be disabled.

 
      		 [bookmark: pgfId-75659]The Layer 3 cluster pool is not shared between OSPFv3 and the interface.

 
     

 
     [bookmark: pgfId-75661]Related Topics

 
      
      		 [bookmark: pgfId-75666]Configuring OSPFv3

 
      		 [bookmark: pgfId-75671]Process Tab

 
      		 [bookmark: pgfId-75676]OSPFv3 Interface Tab

 
     

 
    
 
     
      [bookmark: pgfId-75690][bookmark: 125973][bookmark: pxpage_cncpt_ProcessTab]Process Tab[bookmark: marker-75684][bookmark: marker-75686][bookmark: marker-75688]

 
     [bookmark: pgfId-75692]Use the Process tab on the OSPFv3 page to enable and configure up to two OSPFv3 routing processes. Each OSPF process has its own associated areas and networks. For each, at minimum, create an area for OSPFv3, enable an interface for OSPFv3, then redistribute the route into the targeted OSPFv3 routing processes. Note that only single-context mode is supported.

 
     [bookmark: pgfId-75694]Navigation Path

 
     [bookmark: pgfId-75696]The Process tab is on the OSPFv3 page.

 
      
      		 [bookmark: pgfId-75698](Device view) Select  Platform > Routing > OSPFv3 from the Device Policy selector.

 
      		 [bookmark: pgfId-75700](Policy view) Select  PIX/ASA/FWSM Platform > Routing > OSPFv3 from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
     

 
     [bookmark: pgfId-75702]Related Topics

 
      
      		 [bookmark: pgfId-75707]Configuring OSPFv3

 
      		 [bookmark: pgfId-75712]About OSPFv3

 
      		 [bookmark: pgfId-75717]Area Tab (OSPFv3)

 
      		 [bookmark: pgfId-75722]OSPFv3 Interface Tab

 
     

 
     [bookmark: pgfId-75724]Field Reference

 
     [bookmark: pgfId-75727] 

 
      
       
        
        [bookmark: pgfId-68825]Table 55-51 [bookmark: 126017]Process Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-68831]Element
          
  
         		
           
           [bookmark: pgfId-68833]Description
          
  
        

 
         
         		[bookmark: pgfId-68839]OSPFv3 Process

  
         		[bookmark: pgfId-68841]Identify which OSPFv3 process you are configuring: choose Process 1 or Process 2. You can enable one or both.

  
        

 
         
         		[bookmark: pgfId-68847]Enable OSPFv3 Process

  
         		[bookmark: pgfId-68849]Check this box to enable the chosen OSPFv3 process. Deselect this option to disable the OSPFv3 process; the process configuration information is retained should you wish to re-enable it later.

  
        

 
         
         		[bookmark: pgfId-68855]Process ID

  
         		[bookmark: pgfId-68857]Enter a unique numeric identifier for this process. The ID can be any positive integer between 1 and 65535.

 [bookmark: pgfId-68859]This process ID is used internally and does not need to match the OSPFv3 process ID on any other OSPFv3 devices.

  
        

 
         
         		[bookmark: pgfId-68865]Advanced

  
         		[bookmark: pgfId-68870]Opens the OSPFv3 Advanced Properties Dialog Box, in which you can configure additional process-related parameters, such Router ID, Adjacency Changes, Administrative Route Distances, Timers, Default Information Originate, and Passive Interface settings.

  
        

 
         
         		[bookmark: pgfId-68876]Area

  
         		[bookmark: pgfId-68881]Use the tabs and tables in this panel to manage area, range and virtual-link definitions. See Area Tab (OSPFv3) for more about these definitions.

  
        

 
         
         		[bookmark: pgfId-68887]Redistribution

  
         		[bookmark: pgfId-68892]Use this panel to manage redistribution definitions. See Add/Edit Redistribution Dialog Box (OSPFv3) for more about these definitions.

  
        

 
         
         		[bookmark: pgfId-68898]Summary Prefix

  
         		[bookmark: pgfId-68903]Use this panel to manage summary prefix definitions. See Add/Edit Summary Prefix Dialog Box (OSPFv3) for more about these definitions.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-75741][bookmark: 126069][bookmark: pxpage_cncpt_OSPFv3AdvancedProperties]OSPFv3 Advanced Properties Dialog Box[bookmark: marker-75735][bookmark: marker-75737][bookmark: marker-75739]

 
     [bookmark: pgfId-75743]Use the OSPF Advanced dialog box to configure settings such as the Router ID, Adjacency Changes, Administrative Route Distances, Timers, and Default Information Originate settings for an OSPF process.

 
     [bookmark: pgfId-75745]Navigation Path

 
     [bookmark: pgfId-75750]You can access the OSPF Advanced dialog box from the Process Tab.

 
     [bookmark: pgfId-75752]Related Topics

 
      
      		 [bookmark: pgfId-75757]Configuring OSPFv3

 
      		 [bookmark: pgfId-75762]About OSPFv3

 
     

 
     [bookmark: pgfId-75764]Field Reference

 
     [bookmark: pgfId-75767] 

 
      
       
        
        [bookmark: pgfId-68916]Table 55-52 [bookmark: 126101]OSPF Advanced Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-68922]Element
          
  
         		
           
           [bookmark: pgfId-68924]Description
          
  
        

 
         
         		[bookmark: pgfId-68930]OSPF Process

  
         		[bookmark: pgfId-68932]This read-only field displays the ID of the OSPF process you are configuring.

  
        

 
         
         		[bookmark: pgfId-68938]Router ID

  
         		[bookmark: pgfId-68940]On a single device, choose Automatic or IP Address. (An address field appears when you choose IP Address.)

 [bookmark: pgfId-68942]If you choose Automatic, the highest-level IP address on the security appliance is used as the router ID. To use a fixed router ID, choose IP Address and enter an IPv4 address in the Router ID field.

 [bookmark: pgfId-68944]On a device cluster, choose Automatic or Cluster Pool. (An IPv4 Pool object ID field appears when you choose Cluster Pool.)

 [bookmark: pgfId-68949]If you choose Cluster Pool, enter or Select the name of the IPv4 Pool object that is to supply the Router ID address. For more information, see Add or Edit IPv4 Pool Dialog Box.

  
        

 
         
         		[bookmark: pgfId-68955]Ignore LSA MOSPF

  
         		[bookmark: pgfId-68957]Select this option to suppress transmission of syslog messages when the security appliance receives Type 6 (MOSPF) LSA packets.

  
        

 
         
         		[bookmark: pgfId-68963]Adjacency Changes

  
         		[bookmark: pgfId-68965]These options specify the syslog messages sent when adjacency changes occur:

 
           
           		 [bookmark: pgfId-68967]Log Adjacency Changes – When selected, the security appliance sends a syslog message whenever an OSPF neighbor goes up or down. Checking this box enables the Include Details option.

 
           		 [bookmark: pgfId-68969]Include Details – When selected, the security appliance sends a syslog message whenever any state change occurs, not just when a neighbor goes up or down. This option is available only when Log Adjacency Changes is checked.

 
          

  
        

 
         
         		[bookmark: pgfId-68975]Administrative Route Distances

  
         		[bookmark: pgfId-68977]Settings for the administrative route distances, according to the route type.

 
           
           		 [bookmark: pgfId-68979]Inter Area – The administrative distance for all routes from one area to another. Valid values range from 1 to 254; the default value is 110.

 
           		 [bookmark: pgfId-68981]Intra Area – The administrative distance for all routes within an area. Valid values range from 1 to 254; the default value is 110.

 
           		 [bookmark: pgfId-68983]External – The administrative distance for all routes from other routing domains that are learned through redistribution. Valid values range from 1 to 254; the default value is 110.

 
          

  
        

 
         
         		[bookmark: pgfId-68989]Timers (in milliseconds)

  
         		[bookmark: pgfId-68991]LSA and SPF throttling provide a dynamic mechanism to slow LSA updates in OSPFv3 during times of network instability, and allow faster OSPFv3 convergence by providing LSA rate limiting. The settings used to configure LSA pacing and SPF calculation timers are:

 
           
           		 [bookmark: pgfId-68993]LSA Arrival – The minimum delay between acceptance of the same LSA arriving from neighbors. Valid values range from 0 to 600000 milliseconds. The default is 1000.

 
           		 [bookmark: pgfId-68995]LSA Flood Pacing – The amount of time LSAs in the flooding queue are paced in between updates. Valid values range from 5 to 100 milliseconds. The default value is 33.

 
           		 [bookmark: pgfId-68997]LSA Group Pacing – The interval at which LSAs are collected into a group and refreshed, check summed, or aged. Valid values range from 10 to 1800; the default value is 240 milliseconds.

 
           		 [bookmark: pgfId-68999]LSA Retransmission Pacing – The length of time at which LSAs in the retransmission queue are paced. Valid values range from 5 to 200 milliseconds. The default value is 66.

 
           		 [bookmark: pgfId-69001]LSA Throttle – The delay in milliseconds to generate the first occurrence of the LSA. Valid values range from 0 to 600000 milliseconds. When you enter a value in this field, the min and max fields are enabled:

 
          

 [bookmark: pgfId-69003] – min – The minimum delay for originating the same LSA. Valid values range from 1 to 600000 milliseconds.

 [bookmark: pgfId-69005] – max – The maximum delay for originating the same LSA. Valid values range from 1 to 600000 milliseconds.

 
           
           		 [bookmark: pgfId-69007]SPF Throttle – The delay to receive a change to the SPF calculation. Valid values range from 1 to 600000 milliseconds. When you enter a value in this field, the min and max fields are enabled:

 
          

 [bookmark: pgfId-69009] – min – The delay between the first and second SPF calculations. Valid values range from 1 to 600000 milliseconds.

 [bookmark: pgfId-69011] – max – The maximum wait time for SPF calculations. Valid values range from 1 to 600000 milliseconds.

 [bookmark: pgfId-69013]Note For LSA throttling, if the minimum or maximum time is less than the first occurrence value, then OSPFv3 automatically corrects to the first occurrence value. Similarly, if the maximum delay specified is less than the minimum delay, then OSPFv3 automatically corrects to the minimum delay value.

  
        

 
         
         		[bookmark: pgfId-69019]Default Information Originate

  
         		[bookmark: pgfId-69021]Settings used by an ASBR to generate a default external route into an OSPFv3 routing domain:

 
           
           		 [bookmark: pgfId-69023]Enable Default Information Originate – Check this box to enable generation of a default route into the OSPFv3 routing domain; the following options become available:

 
          

 [bookmark: pgfId-69025] – Always advertise the default route – Check this box to always advertise the default route.

 [bookmark: pgfId-69027] – Metric Value – The OSPFv3 metric used to generate the default route. Valid values range from 0 to 16777214.

 [bookmark: pgfId-69029] – Metric Type – The external link type associated with the default route advertised into the OSPFv3 routing domain. Choose 1 or 2, indicating a Type 1 or a Type 2 external route. The default value is 1.

 [bookmark: pgfId-69031] – Route Map – (Optional) Enter or Select the name of a route map object to apply. The routing process generates the default route if the route map is satisfied.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-69042]Passive Interface

  
         		[bookmark: pgfId-69044]Passive routing helps control the advertisement of OSPFv3 routing information, and disables sending and receiving OSPFv3 routing updates on an interface.

 [bookmark: pgfId-69046]Enter or Select one or more interfaces, or interface objects, to enable passive OSPFv3 routing on those interfaces. IPv4 and IPv6 addresses are supported.

  
        

 
         
         		 [bookmark: pgfId-69052]Non Stop Forwarding Tab

 [bookmark: pgfId-69054]Note Non Stop Forwarding (NSF) is supported on ASA 9.3(1)+ only.

  
        

 
         
         		[bookmark: pgfId-69062]Enable graceful-restart helper

  
         		[bookmark: pgfId-69064]Enables graceful restart helper mode.

 [bookmark: pgfId-69066]When an ASA has NSF enabled, it is said to be NSF-capable and will operate in graceful restart mode. By default, the neighboring ASAs of the NSF-capable ASA will be NSF-aware and will operate in NSF helper mode. When the NSF-capable ASA is performing graceful restart, the helper ASAs assist in the nonstop forwarding recovery process.

 [bookmark: pgfId-69068]If you do not want the ASA to help the restarting neighbor with nonstop forwarding recovery, clear the Enable graceful-restart helper option.

  
        

 
         
         		[bookmark: pgfId-69074]Enable Link State Advertisement

  
         		[bookmark: pgfId-69076]Enables strict link-state advertisement (LSA) checking.

 [bookmark: pgfId-69078]Note When enabled, it indicates that the helper router will terminate the process of restarting the router if it detects that there is a change to a LSA that would be flooded to the restarting router, or if there is a changed LSA on the retransmission list of the restarting router when the graceful restart process is initiated.

  
        

 
         
         		[bookmark: pgfId-69084]Enable graceful-restart (Use when Spanned Cluster or Failover configured)

  
         		[bookmark: pgfId-69086]Enables graceful restart on the ASA.

  
        

 
         
         		[bookmark: pgfId-69092]Length of graceful restart interval

  
         		[bookmark: pgfId-69094](Optional) Specifies the length of the graceful restart interval, in seconds. The range is from 1 to 1800. The default is 120.

 [bookmark: pgfId-69096]Note For a restart interval below 30 seconds, graceful restart will be terminated.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-75781][bookmark: 126244][bookmark: pxpage_cncpt_AreaTabOSPFv3]Area Tab (OSPFv3) [bookmark: marker-75775][bookmark: marker-75777][bookmark: marker-75779]

 
     [bookmark: pgfId-75786]Use the Area panel on the Process Tab of the OSPFv3 page to configure OSPFv3 areas, ranges and virtual links. The Area panel consists of three definition tables—Area, Range, and Virtual Link:

 
      
      		 [bookmark: pgfId-75791]Refer to Add/Edit Area Dialog Box (OSPFv3) for information about adding and editing Area table entries.

 
      		 [bookmark: pgfId-75796]Refer to Add/Edit Range Dialog Box (OSPFv3) for information about adding and editing Range table entries.

 
      		 [bookmark: pgfId-75801]Refer to Add/Edit Virtual Link Dialog Box (OSPFv3) for information about adding and editing Virtual Link table entries.

 
     

 
     [bookmark: pgfId-75806]Refer to Using Tables for basic information about working with Security Manager tables.

 
     [bookmark: pgfId-75808]Navigation Path

 
     [bookmark: pgfId-75816]You can access the Area tab from the Process Tab of the OSPFv3 page. For more information about the OSPFv3 page, see Configuring OSPFv3.

 
     [bookmark: pgfId-75818]Related Topics

 
      
      		 [bookmark: pgfId-75823]About OSPFv3

 
      		 [bookmark: pgfId-75828]OSPFv3 Interface Tab

 
     

 
    
 
     
      [bookmark: pgfId-75842][bookmark: 126287][bookmark: pxpage_cncpt_AddEditAreaDialogBoxOSPFv3]Add/Edit Area Dialog Box (OSPFv3) [bookmark: marker-75836][bookmark: marker-75838][bookmark: marker-75840]

 
     [bookmark: pgfId-75844]Use the Add/Edit Area dialog box to define parameters for the area.

 
     [bookmark: pgfId-75846]Navigation Path

 
     [bookmark: pgfId-75851]You can access the Add/Edit Area dialog box from the Area Tab (OSPFv3).

 
     [bookmark: pgfId-75853]Related Topics

 
      
      		 [bookmark: pgfId-75858]Configuring OSPFv3

 
      		 [bookmark: pgfId-75863]About OSPFv3

 
      		 [bookmark: pgfId-75868]Process Tab

 
     

 
     [bookmark: pgfId-75870]Field Reference

 
     [bookmark: pgfId-75873] 

 
      
       
        
        [bookmark: pgfId-69109]Table 55-53 [bookmark: 126322]Add/Edit Area Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-69115]Element
          
  
         		
           
           [bookmark: pgfId-69117]Description
          
  
        

 
         
         		[bookmark: pgfId-69123]Area ID

  
         		[bookmark: pgfId-69125]Enter an identifier for the area as either a decimal number or an IP address. Valid decimal values range from 0 to 4294967295.

  
        

 
         
         		[bookmark: pgfId-69131]Cost

  
         		[bookmark: pgfId-69133]The cost of sending a packet on an interface. Valid values are 0 to 65535.

 [bookmark: pgfId-69135]Routing decisions are based on cost, which is an indication of the overhead required to send packets across a certain interface. The ASA calculates the cost of an interface based on link bandwidth rather than the number of hops to the destination. The cost can be configured to specify preferred paths.

  
        

 
         
         		[bookmark: pgfId-69141]Type

  
         		[bookmark: pgfId-69143]Define the area type by choosing one of the following:

 
           
           		 [bookmark: pgfId-69145]Normal – Make the area a standard OSPFv3 area. This option is selected by default when you first create an area.

 
           		 [bookmark: pgfId-69147]NSSA – Make the area a “not-so-stubby area.” NSSAs accept Type 7 LSAs. When you choose this option, the Default Information Originate options are enabled.

 
          

 [bookmark: pgfId-69149]When you create a NSSA, you can prevent summary LSAs from being flooded into the area by deselecting Allow sending summary LSA into this area. You can also disable route redistribution by deselecting Redistribute, and enabling Default information originate.

 
           
           		 [bookmark: pgfId-69151]Stub – Make the area a stub area. Stub areas do not have any routers or areas beyond it. Stub areas prevent AS External LSAs (Type 5 LSAs) from being flooded into the stub area. When you choose this option,  Allow sending summary LSA into this area is enabled.

 
          

 [bookmark: pgfId-69153]When you create a stub area, you can prevent summary LSAs (Type 3 and 4) from being flooded into the area by deselecting Allow sending summary LSA into this area.

  
        

 
         
         		 [bookmark: pgfId-69159]Default Information Originate

 [bookmark: pgfId-69161]These options are enabled when you choose NSSA as the area Type. The first option is enabled when you choose Stub as the area Type.

  
        

 
         
         		[bookmark: pgfId-69169]Allow sending summary LSA into this area

  
         		[bookmark: pgfId-69171]Select to allow flooding of summary LSAs into the area.

  
        

 
         
         		[bookmark: pgfId-69177]Redistribute (imports routes to normal and NSSA areas)

  
         		[bookmark: pgfId-69179]Select to allow route redistribution.

  
        

 
         
         		[bookmark: pgfId-69185]Default information originate

  
         		[bookmark: pgfId-69187]Check this box to generate a Type 7 default into the NSSA. Selecting this option enables the following metric options:

 
           
           		 [bookmark: pgfId-69189]Metric – The OSPF metric value for the default route. Valid values range from 1 to 16777214. The default is 1.

 
           		 [bookmark: pgfId-69191]Metric Type – The OSPF metric type for the default route. Choose 1 (Type 1) or 2 (Type 2). The default is 1.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-75887][bookmark: 126389][bookmark: pxpage_cncpt_AddEditAreaRangeOSPFv3]Add/Edit Range Dialog Box (OSPFv3) [bookmark: marker-75881][bookmark: marker-75883][bookmark: marker-75885]

 
     [bookmark: pgfId-75889]Use the Add/Edit Area Range Network dialog box to add a new range to the area selected in the Area table, or to change an existing entry.

 
     [bookmark: pgfId-75891]Navigation Path

 
     [bookmark: pgfId-75896]You can access the Add/Edit Range dialog box from the Range panel under the Area Tab (OSPFv3).

 
     [bookmark: pgfId-75898]Related Topics

 
      
      		 [bookmark: pgfId-75903]Configuring OSPFv3

 
      		 [bookmark: pgfId-75908]About OSPFv3

 
      		 [bookmark: pgfId-75913]Process Tab

 
     

 
     [bookmark: pgfId-75915]Field Reference

 
     [bookmark: pgfId-75918] 

 
      
       
        
        [bookmark: pgfId-69204]Table 55-54 [bookmark: 126424]Add/Edit Range Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-69210]Element
          
  
         		
           
           [bookmark: pgfId-69212]Description
          
  
        

 
         
         		[bookmark: pgfId-69218]Area ID

  
         		[bookmark: pgfId-69220]This read-only entry is the ID of the area to which this range applies.

  
        

 
         
         		[bookmark: pgfId-69226]IPv6 Prefix/Length

  
         		[bookmark: pgfId-69228]The IPv6 address(es) for the routes being summarized.

 to select the networks from a list of network objects.  
        

 
         
         		[bookmark: pgfId-69236]Cost

  
         		[bookmark: pgfId-69238]The cost for the summary route, which is used during OSPF SPF calculations to determine the shortest paths to the destination. Valid values are 0 to 16777215.

 [bookmark: pgfId-69240]Routing decisions are based on cost, which is an indication of the overhead required to send packets across a certain interface. The ASA calculates the cost of an interface based on link bandwidth rather than the number of hops to the destination. The cost can be configured to specify preferred paths.

  
        

 
         
         		[bookmark: pgfId-69246]Advertise

  
         		[bookmark: pgfId-69248]Select this option to set the address range status to advertise. This causes Type 3 summary LSAs to be generated (this is the default). Deselect this optionn to suppress the Type 3 summary LSAs for the specified networks.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-75932][bookmark: 126458][bookmark: pxpage_cncpt_AddEditVirtualLinkDialogOSPFv3]Add/Edit Virtual Link Dialog Box (OSPFv3) [bookmark: marker-75926][bookmark: marker-75928][bookmark: marker-75930]

 
     [bookmark: pgfId-75934]Use the Add/Edit Virtual Link dialog box to define virtual links for the area selected in the Area table, or change the properties of existing virtual links.

 
     [bookmark: pgfId-75936]Navigation Path

 
     [bookmark: pgfId-75941]You can access the Add/Edit Virtual Link dialog box from the Virtual Link panel under the Area Tab (OSPFv3).

 
     [bookmark: pgfId-75943]Related Topics

 
      
      		 [bookmark: pgfId-75948]Configuring OSPFv3

 
      		 [bookmark: pgfId-75953]About OSPFv3

 
      		 [bookmark: pgfId-75958]Process Tab

 
     

 
     [bookmark: pgfId-75960]Field Reference

 
     [bookmark: pgfId-75963] 

 
      
       
        
        [bookmark: pgfId-69261]Table 55-55 [bookmark: 126493]Add/Edit Virtual Link Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-69267]Element
          
  
         		
           
           [bookmark: pgfId-69269]Description
          
  
        

 
         
         		[bookmark: pgfId-69275]Area ID

  
         		[bookmark: pgfId-69277]This read-only entry is the ID of the area to which this virtual link applies.

  
        

 
         
         		[bookmark: pgfId-69283]Peer Router ID

  
         		[bookmark: pgfId-69285]Enter the IP address of the virtual link neighbor.

 to select from a list of network objects.  
        

 
         
         		[bookmark: pgfId-69293]TTL Security

  
         		[bookmark: pgfId-69295]The time-to-live (TTL) security hop count on a virtual link. The hop count value can range from 1 to 254.

  
        

 
         
         		[bookmark: pgfId-69301]Dead Interval

  
         		[bookmark: pgfId-69303]The interval, in seconds, if no hello packets are received, neighbors declare the device down. Valid values range from 1 to 8192. The default value of this field is four times the Hello Interval.

  
        

 
         
         		[bookmark: pgfId-69309]Hello Interval

  
         		[bookmark: pgfId-69311]The interval, in seconds, between hello packets sent on an interface. The smaller the hello interval, the faster topological changes are detected but the more traffic is sent on the interface. This value must be the same for all routers and access servers on a specific interface. Valid values range from 1 to 8192 seconds. The default value is 10 seconds.

  
        

 
         
         		[bookmark: pgfId-69317]Transmit Interval

  
         		[bookmark: pgfId-69319]The time, in seconds, between LSA retransmissions for adjacencies belonging to the interface. When a device sends an LSA to its neighbor, it keeps the LSA until it receives the acknowledgment message. If the device does not receive an acknowledgment, it will resend the LSA. Be conservative when setting this value, or needless retransmission can result. The value should be larger for serial lines and virtual links. Valid values range from 1 to 8192 seconds. The default value is 5 seconds.

  
        

 
         
         		[bookmark: pgfId-69325]Transmit Delay

  
         		[bookmark: pgfId-69327]The estimated time, in seconds, required to send an LSA packet on the interface. LSAs in the update packet have their ages increased by the amount specified by this field before transmission. If the delay is not added before transmission over a link, the time in which the LSA propagates over the link is not considered. The value assigned should take into account the transmission and propagation delays for the interface. This setting has more significance on very low-speed links. Valid values range from 1 to 8192 seconds. The default value is 1 second.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-75977][bookmark: 126542][bookmark: pxpage_cncpt_AddEditRedistributionOSPFv3]Add/Edit Redistribution Dialog Box (OSPFv3) [bookmark: marker-75971][bookmark: marker-75973][bookmark: marker-75975]

 
     [bookmark: pgfId-75979]Use the Add/Edit Redistribution dialog box to add a redistribution rule to this process, or to edit an existing redistribution rule.

 
     [bookmark: pgfId-75981]Navigation Path

 
     [bookmark: pgfId-75986]You can access the Redistribution dialog box from the Redistribution panel under the Process Tab.

 
     [bookmark: pgfId-75988]Related Topics

 
      
      		 [bookmark: pgfId-75993]Configuring OSPFv3

 
      		 [bookmark: pgfId-75998]About OSPFv3

 
     

 
     [bookmark: pgfId-76000]Field Reference

 
     [bookmark: pgfId-76003] 

 
      
       
        
        [bookmark: pgfId-69340]Table 55-56 [bookmark: 126574]Add/Edit Redistribution Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-69346]Element
          
  
         		
           
           [bookmark: pgfId-69348]Description
          
  
        

 
         
         		[bookmark: pgfId-69354]Source Protocol

  
         		[bookmark: pgfId-69356]Choose the source protocol for route redistribution:

 
           
           		 [bookmark: pgfId-69358]Connected – Redistributes connected routes (routes established automatically by virtue of having an IP address enabled on the interface) to the OSPFv3 routing process. Connected routes are redistributed as external to the autonomous system.

 
           		 [bookmark: pgfId-69360]OSPF – Redistributes routes from another OSPF routing process. The Routing PID and the Match options are enabled when you choose this option.

 
           		 [bookmark: pgfId-69362]Static – Redistributes static routes to the OSPFv3 routing process.

 
          

  
        

 
         
         		[bookmark: pgfId-69368]Metric

  
         		[bookmark: pgfId-69370]The metric value for the routes being redistributed. Valid values range from 1 to 16777214; the default is 20.

 [bookmark: pgfId-69372]When redistributing from one OSPF process to another OSPF process on the same device, the metric will be carried through from one process to the other if no metric value is specified.

  
        

 
         
         		[bookmark: pgfId-69378]Metric Type

  
         		[bookmark: pgfId-69380]The metric type is the external link type associated with the default route that is advertised into the OSPFv3 routing domain.

 [bookmark: pgfId-69382]Choose None, 1, or 2, where None indicates there is no default route, 1 indicates the metric is a Type 1 external route, and 2 is a Type 2 external route.

  
        

 
         
         		[bookmark: pgfId-69388]Tag (optional)

  
         		[bookmark: pgfId-69390]The tag is a 32-bit decimal value attached to each external route. This is not used by OSPF itself. It may be used to communicate information between other border devices. Valid values range from 0 to 4294967295.

  
        

 
         
         		[bookmark: pgfId-69396]Route Map

  
         		[bookmark: pgfId-69398]Enter or Select the name of the route map object to apply to the redistribution entry.

 to open the Route Map Object Selector from which you can select a route map object. You can also create new route map objects from the Route Map Object Selector. For more information, see Understanding Route Map Objects.  
        

 
         
         		[bookmark: pgfId-69409]Routing PID

  
         		[bookmark: pgfId-69414]The ID of the process to which redistribution is directed. (The Process ID is defined on the Process Tab.)

 [bookmark: pgfId-69416]This option is enabled only when OSPF is chosen as the Source Protocol.

  
        

 
         
         		[bookmark: pgfId-69422]Include Connected

  
         		[bookmark: pgfId-69424]Check this box to include connected routes in the redistribution.

  
        

 
         
         		 [bookmark: pgfId-69430]Match

 [bookmark: pgfId-69432]The conditions used for redistributing routes from one routing protocol to another. The routes must match the selected condition to be redistributed. You can choose one or more of the following match conditions. These options are enabled only when OSPF is chosen as the Source Protocol.

  
        

 
         
         		[bookmark: pgfId-69440]Internal

  
         		[bookmark: pgfId-69442]The route is internal to a specific autonomous system.

  
        

 
         
         		[bookmark: pgfId-69448]External 1

  
         		[bookmark: pgfId-69450]Routes that are external to the autonomous system, but are imported into OSPF as Type 1 external routes.

  
        

 
         
         		[bookmark: pgfId-69456]External 2

  
         		[bookmark: pgfId-69458]Routes that are external to the autonomous system, but are imported into OSPF as Type 2 external routes.

  
        

 
         
         		[bookmark: pgfId-69464]NSSA External 1

  
         		[bookmark: pgfId-69466]Routes that are external to the autonomous system, but are imported into OSPF as Type 2 NSSA routes.

  
        

 
         
         		[bookmark: pgfId-69472]NSSA External 2

  
         		[bookmark: pgfId-69474]Routes that are external to the autonomous system, but are imported into OSPF as Type 2 NSSA routes.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-76017][bookmark: 126665][bookmark: pxpage_cncpt_AddEditSummaryPrefixOSPFv3]Add/Edit Summary Prefix Dialog Box (OSPFv3) [bookmark: marker-76011][bookmark: marker-76013][bookmark: marker-76015]

 
     [bookmark: pgfId-76019]Use the Add/Edit Summary Prefix dialog box to add new route-summarization entries to the selected process, or to modify existing entries.

 
     [bookmark: pgfId-76021]Navigation Path

 
     [bookmark: pgfId-76026]You can access the Add/Edit Summary Prefix dialog box from the Summary Prefix panel under the Process Tab.

 
     [bookmark: pgfId-76028]Related Topics

 
      
      		 [bookmark: pgfId-76033]Configuring OSPFv3

 
      		 [bookmark: pgfId-76038]About OSPFv3

 
     

 
     [bookmark: pgfId-76040]Field Reference

 
     [bookmark: pgfId-76043] 

 
      
       
        
        [bookmark: pgfId-69487]Table 55-57 [bookmark: 126697]Add/Edit Summary Prefix Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-69493]Element
          
  
         		
           
           [bookmark: pgfId-69495]Description
          
  
        

 
         
         		[bookmark: pgfId-69501]Process ID

  
         		[bookmark: pgfId-69503]This read-only value identifies the process to which this rule applies.

  
        

 
         
         		[bookmark: pgfId-69509]IPv6 Prefix/Length

  
         		[bookmark: pgfId-69511]Enter an IPv6 prefix/length for external route summarization.

 to select from a list of network objects.  
        

 
         
         		[bookmark: pgfId-69519]Advertise

  
         		[bookmark: pgfId-69521]When selected, summary routes that match the specified prefix and mask pair are advertised. When deselected, routes that match the specified prefix and mask pair are suppressed. By default, this check box is selected.

  
        

 
         
         		[bookmark: pgfId-69527]Tag (optional)

  
         		[bookmark: pgfId-69529]The tag is a 32-bit decimal value attached to each external route. This is not used by OSPF itself. It may be used to communicate information between border devices. Valid values range from 0 to 4294967295.

 [bookmark: pgfId-69531]This field is enabled when you check Advertise.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-76057][bookmark: 126732][bookmark: pxpage_cncpt_OSPFv3InterfaceTab]OSPFv3 Interface Tab[bookmark: marker-76051][bookmark: marker-76053][bookmark: marker-76055]

 
     [bookmark: pgfId-76059]Use the Interface panel to configure interface-and neighbor-specific OSPFv3 routing properties. The Interface panel consists of two definition tables, Interface and Neighbor:

 
      
      		 [bookmark: pgfId-76064]Refer to Add/Edit Interface Dialog Box (OSPFv3) for information about adding and editing Interface table entries.

 
      		 [bookmark: pgfId-76069]Refer to Add/Edit Neighbor Dialog Box (OSPFv3) for information about adding and editing Neighbor table entries.

 
     

 
     [bookmark: pgfId-76074]Refer to Using Tables for basic information about working with Security Manager tables.

 
     [bookmark: pgfId-76076]Navigation Path

 
     [bookmark: pgfId-76081]Click the Interface tab on the OSPFv3 page to display this panel. For more information about the OSPFv3 page, see Configuring OSPFv3.

 
     [bookmark: pgfId-76083]Related Topics

 
      
      		 [bookmark: pgfId-76088]About OSPFv3

 
      		 [bookmark: pgfId-76093]Process Tab

 
     

 
    
 
     
      [bookmark: pgfId-76107][bookmark: 126770][bookmark: pxpage_cncpt_AddEditInterfaceOSPFv3]Add/Edit Interface Dialog Box (OSPFv3)[bookmark: marker-76101][bookmark: marker-76103][bookmark: marker-76105]

 
     [bookmark: pgfId-76109]Use the Add/Edit Interface dialog box to define OSPFv3 routing properties for an individual interface, or to change an existing entry.

 
     [bookmark: pgfId-76111]Navigation Path

 
     [bookmark: pgfId-76116]You can access the Add/Edit Interface dialog box from the Interface panel under the OSPFv3 Interface Tab.

 
     [bookmark: pgfId-76118]Related Topics

 
      
      		 [bookmark: pgfId-76123]Configuring OSPFv3

 
      		 [bookmark: pgfId-76128]About OSPFv3

 
      		 [bookmark: pgfId-76133]Process Tab

 
     

 
     [bookmark: pgfId-76135]Field Reference

 
     [bookmark: pgfId-76138] 

 
      
       
        
        [bookmark: pgfId-69544]Table 55-58 [bookmark: 126805]Add/Edit Interface Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-69550]Element
          
  
         		
           
           [bookmark: pgfId-69552]Description
          
  
        

 
         
         		[bookmark: pgfId-69558]Interface

  
         		[bookmark: pgfId-69560]The name of the interface to which this routing configuration applies.

 to select from a list of interface objects.  
        

 
         
         		[bookmark: pgfId-69568]Enable OSPFv3 on this interface

  
         		[bookmark: pgfId-69570]Check this box to enable OSPFv3 on the specified interface, and activate the following fields:

 
           
           		 [bookmark: pgfId-69575]Process ID – Choose the process to apply to this interface; defined on the OSPFv3 Process Tab.

 
           		 [bookmark: pgfId-69580]Area ID – Identify the area to be assigned; areas are also defined on the OSPFv3 Process Tab.

 
           		 [bookmark: pgfId-69582]Instance ID – (Optional) Specify an ID for this process instance. Valid values for this setting range from 0 to 255.

 
          

 [bookmark: pgfId-69584]This feature lets you have multiple OSPFv3 processes on a single link. Received packets with other instance IDs are then ignored by this process.

  
        

 
         
         		 
           
           [bookmark: pgfId-69590]Properties
          
  
        

 
         
         		[bookmark: pgfId-69598]Filter outgoing link-state advertisements

  
         		[bookmark: pgfId-69600]Check this box to filter outgoing LSAs. All outgoing LSAs are flooded to the interface by default.

  
        

 
         
         		[bookmark: pgfId-69606]Disable MTU mismatch detection

  
         		[bookmark: pgfId-69608]Check this box to disable the OSPFv3 MTU mismatch detection when database description (DBD) packets are received.

  
        

 
         
         		[bookmark: pgfId-69614]Flood Reduction

  
         		[bookmark: pgfId-69616]Check this box to suppress unnecessary flooding of LSAs in stable topologies.

  
        

 
         
         		[bookmark: pgfId-69622]Point-to-point Network

  
         		[bookmark: pgfId-69624]Check this box to define this as a link to a point-to-point network; that is, a network between two routing devices. All neighbors on a point-to-point network establish adjacency and there is no designated router.

 [bookmark: pgfId-69626]This option is unavailable when the Broadcast option is selected.

  
        

 
         
         		[bookmark: pgfId-69632]Broadcast

  
         		[bookmark: pgfId-69634]Check this box to define this as a link to a network with multiple routing devices. Such networks establish a designated router (DR), as well as a backup designated router (BDR), that controls LSA flooding on the network.

 [bookmark: pgfId-69636]This option is unavailable when the Point-to-point Network option is selected.

  
        

 
         
         		[bookmark: pgfId-69642]Cost

  
         		[bookmark: pgfId-69644]The cost of sending a packet through the interface. Link cost is an arbitrary number used in shortest path first calculations. If you do not assign a value, the configured reference bandwidth divided by the interface port speed is used. (The default reference bandwidth is 40 Gb/sec.)

  
        

 
         
         		[bookmark: pgfId-69650]Priority

  
         		[bookmark: pgfId-69652]Assign an OSPFv3 priority to this interface. Valid values for this setting range from 0 to 255. Entering 0 for this setting makes the device ineligible to become the designated router or backup designated router. This setting does not apply to interfaces that are configured as point-to-point, non-broadcast interfaces.

 [bookmark: pgfId-69654]When two routing devices connect to a network, both attempt to become the designated router. The device with the higher priority becomes the designated router. If there is a tie, the router with the higher router ID becomes the designated router.

  
        

 
         
         		[bookmark: pgfId-69662][bookmark: marker-69660]Dead Interval

  
         		[bookmark: pgfId-69664]If no hello packets are received from a neighbor within this interval, that device is designated as inactive. Valid values range from 1 to 65535. The default value for this setting is four times the hello interval.

  
        

 
         
         		[bookmark: pgfId-69670]Poll Interval

  
         		[bookmark: pgfId-69672]If a neighboring device is inactive, it may be necessary to continue sending hello packets to that neighbor. The hello packets are sent at this reduced interval, which should be larger than the hello interval.

  
        

 
         
         		[bookmark: pgfId-69680][bookmark: marker-69678]Retransmit Interval

  
         		[bookmark: pgfId-69682]The time, in seconds, between LSA retransmissions for adjacent neighbors. When a router sends an LSA to a neighbor, it keeps the LSA until it receives an acknowledgment. If an acknowledgment is not received within this interval, it will resend the LSA. Be conservative when setting this value, or needless retransmission can result. The value should be larger for serial lines and virtual links. Valid values range from 1 to 65535 seconds.

  
        

 
         
         		[bookmark: pgfId-69690][bookmark: marker-69688]Transmit Delay

  
         		[bookmark: pgfId-69692]The estimated time, in seconds, required to send an LSA packet on the interface. LSAs in the update packet have their ages increased by the amount specified by this field before transmission. If the delay is not added before transmission over a link, the time in which the LSA propagates over the link is not considered. The value assigned should take into account the transmission and propagation delays for the interface. This setting has more significance on very low-speed links. Valid values range from 1 to 65535 seconds.

  
        

 
         
         		 
           
           [bookmark: pgfId-69698]Authentication
          
  
        

 
         
         		[bookmark: pgfId-69706]Type

  
         		[bookmark: pgfId-69708]The type of authentication enabled on this interface. Choose one of the following:

 
           
           		 [bookmark: pgfId-69710]Area – OSPFv3 does not provide “built-in” authentication, instead relying on IPv6/IPSec protocols. Choose this option to use those protocols to authenticate OSPFv3 traffic on all interfaces in the area; this means all routing devices in the area must use this option. This is the default.

 
           		 [bookmark: pgfId-69712]Interface – Choose this option to secure this interface and protect OSPFv3 virtual links. The additional parameters in this section are enabled when you choose this option.

 
           		 [bookmark: pgfId-69714]None – OSPFv3 authentication is disabled.

 
          

  
        

 
         
         		[bookmark: pgfId-69720]Security Parameter Index

  
         		[bookmark: pgfId-69722]Enter an IPSec identification tag used to distinguish this particular OSPFv3 interface; used in conjunction with the specified authentication and encryption rules. Valid values range from 256 to 4294967295.

  
        

 
         
         		[bookmark: pgfId-69728]Authentication Algorithm

  
         		[bookmark: pgfId-69730]Choose the type of authentication algorithm to use:

 
           
           		 [bookmark: pgfId-69732]md5 – Message Digest 5; produces a 128-bit hash value.

 
           		 [bookmark: pgfId-69734]sha1 – Secure Hash Algorithm version 1; produces a 160-bit hash value.

 
          

  
        

 
         
         		[bookmark: pgfId-69740]Authentication Key

  
         		[bookmark: pgfId-69742]Enter an authentication key. The length of the key entered depends on the type of authentication chosen as the Authentication Algorithm, and whether the key is to be encrypted (when you check the Encrypt Authentication Key box):

 
           
           		 [bookmark: pgfId-69744]md5 – 32 characters.

 
           		 [bookmark: pgfId-69746]md5 (encrypted) – 66 characters.

 
           		 [bookmark: pgfId-69748]sha1 – 40 characters.

 
           		 [bookmark: pgfId-69750]sha1 (encrypted) – 82 characters.

 
          

  
        

 
         
         		[bookmark: pgfId-69756]Encrypt Authentication Key

  
         		[bookmark: pgfId-69758]Check this box to require encryption of the specified Authentication Key for transmission.

  
        

 
         
         		[bookmark: pgfId-69764]Include Encryption

  
         		[bookmark: pgfId-69766]Check this box to require encryption of OSPFv3 packets. The following options are enabled.

  
        

 
         
         		[bookmark: pgfId-69772]Encryption Algorithm

  
         		[bookmark: pgfId-69774]Choose the type of encryption to use:

 
           
           		 [bookmark: pgfId-69776]3des – Triple DES; the Data Encryption Standard cipher algorithm is applied three times to each packet.

 
           		 [bookmark: pgfId-69778]aes-cbc – Encryption is based on the Advanced Encryption Standard with Cipher Block Chaining, to produce a key of the size chosen with the Key Type parameter.

 
          

 [bookmark: pgfId-69780]The Key Type list is enabled only when you choose this encryption option. Choose one of these options:

 [bookmark: pgfId-69782] – 128 – For 128-bit keys.

 [bookmark: pgfId-69784] – 192 – For 192-bit keys.

 [bookmark: pgfId-69786] – 256 – For 256-bit keys.

 
           
           		 [bookmark: pgfId-69788]des – Encryption is based on the Data Encryption Standard, using 56-bit keys.

 
          

  
        

 
         
         		[bookmark: pgfId-69794]Encryption Key

  
         		[bookmark: pgfId-69796]Enter an encryption key. The length of the key entered depends on the type of encryption chosen as the Encryption Algorithm, and whether the key is to be encrypted (when you check the Encrypt Key box):

 
           
           		 [bookmark: pgfId-69798]3des – 48 characters (192 bits).

 
           		 [bookmark: pgfId-69800]3des (encrypted) – 98 characters (192 bits).

 
           		 [bookmark: pgfId-69802]aes-cbc/128 – 32 characters (128 bits).

 
           		 [bookmark: pgfId-69804]aes-cbc/128 (encrypted) – 66 characters (128 bits).

 
           		 [bookmark: pgfId-69806]aes-cbc/192 – 48 characters (192 bits).

 
           		 [bookmark: pgfId-69808]aes-cbc/192 (encrypted) – 98 characters (192 bits).

 
           		 [bookmark: pgfId-69810]aes-cbc/256 – 64 characters (256 bits).

 
           		 [bookmark: pgfId-69812]aes-cbc/256 (encrypted) – 130 characters (256 bits).

 
           		 [bookmark: pgfId-69814]des – 16 characters (64 bits).

 
           		 [bookmark: pgfId-69816]des (encrypted) – 34 characters (64 bits).

 
          

  
        

 
         
         		[bookmark: pgfId-69822]Encrypt Key

  
         		[bookmark: pgfId-69824]Check this box to require encryption of the specified Encryption Key for transmission.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-76152][bookmark: 127017][bookmark: pxpage_cncpt_AddEditNeighborOSPFv3]Add/Edit Neighbor Dialog Box (OSPFv3)[bookmark: marker-76146][bookmark: marker-76148][bookmark: marker-76150]

 
     [bookmark: pgfId-76154]You must define a static neighbor for each point-to-point, non-broadcast interface. This feature lets you broadcast OSPFv3 advertisements across an existing VPN connection without having to encapsulate the advertisements in a GRE tunnel. Note the following restrictions:

 
      
      		 [bookmark: pgfId-76156]You cannot define the same static neighbor for two different OSPFv3 processes.

 
      		 [bookmark: pgfId-76158]You must define a static route for each static neighbor.

 
     

 
     [bookmark: pgfId-76160]Use the Add/Edit Neighbor dialog box to define a static neighbor for the interface selected in the Interface table, or to change information for an existing static neighbor.

 
     [bookmark: pgfId-76162]Navigation Path

 
     [bookmark: pgfId-76167]You can access the Add/Edit Neighbor dialog box from the Neighbor panel under the OSPFv3 Interface Tab.

 
     [bookmark: pgfId-76169]Related Topics

 
      
      		 [bookmark: pgfId-76174]Configuring OSPFv3

 
      		 [bookmark: pgfId-76179]About OSPFv3

 
      		 [bookmark: pgfId-76184]Process Tab

 
     

 
     [bookmark: pgfId-76186]Field Reference

 
     [bookmark: pgfId-76189] 

 
      
       
        
        [bookmark: pgfId-69837]Table 55-59 [bookmark: 127058]Add/Edit Neighbor Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-69843]Element
          
  
         		
           
           [bookmark: pgfId-69845]Description
          
  
        

 
         
         		[bookmark: pgfId-69851]Interface

  
         		[bookmark: pgfId-69853]The interface associated with this neighbor definition (read-only).

  
        

 
         
         		[bookmark: pgfId-69859]Link-local Address

  
         		[bookmark: pgfId-69861]Enter the IPv6 address of the static neighbor.

  
        

 
         
         		[bookmark: pgfId-69867]Cost and Database Filter

  
         		[bookmark: pgfId-69869]Check this box to enable filtering of the outgoing LSAs on the interface during synchronization and flooding. The following options are enabled:

 
           
           		 [bookmark: pgfId-69871]Cost – Use this field to assign an arbitrary cost to this neighbor. If a value is not assigned, the cost of the interface is used (this value is based on the port speed of the interface, and is calculated as reference bandwith divided by interface speed). Valid values range from 1 to 65535.

 
           		 [bookmark: pgfId-69873]Filter outgoing link-state advertisements – Check this box to disable forwarding of outgoing LSAs to this neighbor.

 
          

 [bookmark: pgfId-69875]Note The Cost and Database Filter options and the Poll-Interval options are mutually exclusive.

  
        

 
         
         		[bookmark: pgfId-69881]Poll-Interval

  
         		[bookmark: pgfId-69883]Check this box to enable the following options:

 
           
           		 [bookmark: pgfId-69885]Poll Interval – Time interval in seconds between transmission of hello packets to a “dead” neighbor. The default is 120.

 
          

 [bookmark: pgfId-69887]If a neighboring device becomes inactive (hello packets have not been received for the dead interval period), it may be necessary to continue sending hello packets to the dead neighbor at a reduced rate. Thus this value should be larger than the interface hello interval.

 
           
           		 [bookmark: pgfId-69889]Priority – The router priority value of this neighbor. The default is 0; valid values range from 1 to 255.

 
          

 [bookmark: pgfId-69891]The priority value helps determine the designated router for an OSPFv3 link. A value of zero means the device is ineligible to become the designated router, or backup designated router.

 [bookmark: pgfId-69893]Note The Poll-Interval options and the Cost and Database Filter options are mutually exclusive. Also, these values do not apply to point-to-multipoint interfaces.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-76201][bookmark: 127105][bookmark: pxpage_cncpt_RIPPage]Configuring RIP[bookmark: marker-76195][bookmark: marker-76197][bookmark: marker-76199]

 
    [bookmark: pgfId-76203]Routing Information Protocol (RIP) is a dynamic routing protocol, or more precisely, an interior gateway protocol that is based on distance vectors. RIP uses hop count as the metric for path selection. When RIP is enabled on an interface, the interface exchanges RIP broadcast packets with neighboring devices to dynamically learn about and advertise routes. These RIP packets contain information about the destination networks that the gateways can reach, and the number of gateways that a packet must travel through to reach those destinations.

 
    [bookmark: pgfId-76205]Cisco Security Manager supports both RIP version 1 and RIP version 2. Version 1 does not send the subnet mask with the routing update; RIP version 2 sends the subnet mask with the routing update, and supports variable-length subnet masks. Additionally, RIP version 2 supports neighbor authentication when routing updates are exchanged. This authentication ensures that the security appliance receives reliable routing information from a trusted source.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-76207]Note You cannot enable RIP if you have OSPF processes running.


    
     

    

    

 
    [bookmark: pgfId-76209]Limitations

 
    [bookmark: pgfId-76211]RIP has the following limitations:

 
     
     		 [bookmark: pgfId-76213]Cisco Security Manager cannot pass RIP updates between interfaces.

 
     		 [bookmark: pgfId-76215]RIP Version 1 does not support variable-length subnet masks.

 
     		 [bookmark: pgfId-76217]RIP has a maximum hop count of 15. A route with a hop count greater than 15 is considered unreachable.

 
     		 [bookmark: pgfId-76219]RIP convergence is relatively slow compared to other routing protocols.

 
    

 
    [bookmark: pgfId-76221]RIP Version 2 Notes

 
    [bookmark: pgfId-76223]The following information applies to RIP Version 2 only:

 
     
     		 [bookmark: pgfId-76225]If using neighbor authentication, the authentication key and key ID must be the same on all neighbor devices that provide RIP version 2 updates to the interface.

 
     		 [bookmark: pgfId-76227]With RIP version 2, the security appliance transmits and receives default route updates using the multicast address 224.0.0.9. In passive mode, it receives route updates at that address.

 
     		 [bookmark: pgfId-76229]When RIP version 2 is configured on an interface, the multicast address 224.0.0.9 is registered on that interface. When a RIP version 2 configuration is removed from an interface, that multicast address is unregistered.

 
    

 
    [bookmark: pgfId-76231]Using Security Manager to Configure RIP on Security Appliances

 
    [bookmark: pgfId-76233]Use the RIP page to enable the Routing Information Protocol on an interface. The settings and features available when configuring RIP depend on the type of device and OS version that you are configuring:

 
     
     		 [bookmark: pgfId-76238]To configure RIP on a PIX Firewall or ASA running an OS version earlier than 7.2, or on any FWSM, see RIP Page for PIX/ASA 6.3–7.1 and FWSM.

 
     		 [bookmark: pgfId-76243]To configure RIP on a PIX Firewall or ASA running OS version 7.2 or later, see RIP Page for PIX/ASA 7.2 and Later.

 
    

 
    [bookmark: pgfId-76245]Related Topics

 
     
     		 [bookmark: pgfId-76250]Configuring Static Routes

 
     		 [bookmark: pgfId-76255]Configuring OSPF

 
     		 [bookmark: pgfId-76260]Configuring No Proxy ARP

 
     		 [bookmark: pgfId-76264] Configuring Routing Information Protocol – a chapter from the “Cisco IOS IP Configuration Guide, Release 12.2,” providing additional detailed information about RIP

 
    

 
     
      [bookmark: pgfId-76278][bookmark: 127168][bookmark: pxpage_cncpt_RIPPage_PIX6_3-7_1andFWSM]RIP Page for PIX/ASA 6.3–7.1 and FWSM[bookmark: marker-76272][bookmark: marker-76274][bookmark: marker-76276]

 
     [bookmark: pgfId-76280]Use this RIP page to enable the Routing Information Protocol (RIP) on an interface in any FWSM, or in a PIX/ASA running a pre-7.2 version operating system.

 
     [bookmark: pgfId-76285]The RIP table on this page lists all interfaces on which RIP is currently defined. Use the Add RIP Configuration and Edit RIP Configuration dialog boxes to create and maintain these entries. See RIP Page for PIX/ASA 6.3–7.1 and FWSM for more information.

 
     [bookmark: pgfId-76287]Navigation Path

 
      
      		 [bookmark: pgfId-76289](Device view) Select  Platform > Routing > RIP from the Device Policy selector.

 
      		 [bookmark: pgfId-76291](Policy view) Select  PIX/ASA/FWSM Platform > Routing > RIP from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
     

 
     [bookmark: pgfId-76293]When creating a shared RIP policy, you must choose a Version in the Create a Policy dialog box, as follows:

 
     [bookmark: pgfId-76295] – PIX/ASA 6.3-7.1 and FWSM

 
     [bookmark: pgfId-76297] – PIX/ASA 7.2 and Later

 
     [bookmark: pgfId-76299]When assigning a shared RIP policy, be sure to assign the appropriate RIP policy for the device. For example, you cannot assign a PIX/ASA 7.2+ RIP policy to an FWSM.

 
     [bookmark: pgfId-76301]Related Topics

 
      
      		 [bookmark: pgfId-76306]Configuring Static Routes

 
      		 [bookmark: pgfId-76311]Configuring OSPF

 
      		 [bookmark: pgfId-76316]Configuring No Proxy ARP

 
      		 [bookmark: pgfId-76321]RIP Page for PIX/ASA 7.2 and Later

 
      		 [bookmark: pgfId-76323]Standard rules table topics:

 
     

 
     [bookmark: pgfId-76328] – Using Rules Tables

 
     [bookmark: pgfId-76333] – Table Columns and Column Heading Features

 
    
 
     
      [bookmark: pgfId-76347][bookmark: 127228][bookmark: pxpage_cncpt_AddEditRIPConfigurationDialogBox]Add/Edit RIP Configuration (PIX/ASA 6.3–7.1 and FWSM) Dialog Boxes[bookmark: marker-76341][bookmark: marker-76343][bookmark: marker-76345]

 
     [bookmark: pgfId-76349]Use the Add RIP Configuration and Edit RIP Configuration dialog boxes to add a RIP configuration to the security appliance, or to make changes to an existing RIP configuration. By adding a RIP configuration, you enable RIP on the specified interface. Except for their titles, the two dialog boxes are identical.

 
     [bookmark: pgfId-76351]Navigation Path

 
     [bookmark: pgfId-76356]You can access the Add and Edit RIP Configuration dialog boxes from the RIP Page for PIX/ASA 6.3–7.1 and FWSM.

 
     [bookmark: pgfId-76358]Field Reference

 
     [bookmark: pgfId-76361] 

 
      
       
        
        [bookmark: pgfId-69906]Table 55-60 [bookmark: 127251]Add/Edit RIP Configuration (PIX/ASA 6.3-7.1 and FWSM) Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-69912]Element
          
  
         		
           
           [bookmark: pgfId-69914]Description
          
  
        

 
         
         		[bookmark: pgfId-69920]Interface

  
         		[bookmark: pgfId-69922]Enter or Select the interface for the RIP configuration. You cannot configure two different RIP configurations on the same interface.

  
        

 
         
         		[bookmark: pgfId-69928]Mode

  
         		[bookmark: pgfId-69930]Select the interface behavior regarding RIP updates:

 
           
           		 [bookmark: pgfId-69932] Send default routes – The interface will transmit RIP routing updates only.

 
           		 [bookmark: pgfId-69934] Receive routes – The interface will listen for RIP routing broadcasts and use that information to populate its routing table, but it will not send RIP routing updates.

 
           		 [bookmark: pgfId-69936] Send default routes and receive routes – The interface will send and receive RIP routing updates.

 
          

  
        

 
         
         		[bookmark: pgfId-69942]Version

  
         		[bookmark: pgfId-69944]Select the RIP version to enable on the interface:

 
           
           		 [bookmark: pgfId-69946] RIP Version 1 – Enables RIP Version 1 on the interface.

 
           		 [bookmark: pgfId-69948] RIP Version 2 – Enables RIP Version 2 on the interface. Configuring RIP Version 2 registers the multicast address 224.0.0.9 on the interface.

 
          

  
        

 
         
         		[bookmark: pgfId-69954]Version 2 Authentication

  
         		[bookmark: pgfId-69956]These options let you enable and select the type of authentication used with RIP Version 2.

 
           
           		 [bookmark: pgfId-69958] Enable Authentication – This option is available when you select RIP Version 2 above. When this box is checked, RIP neighbor authentication is enabled and the following options become available:

 
          

 [bookmark: pgfId-69960] – Type – Select MD5 to use the MD5 hash algorithm for authentication (recommended), or select Clear text to use clear text for authentication.

 [bookmark: pgfId-69962] – Key ID – The identification number of the authentication key. This number must be shared with all other devices sending updates to and receiving updates from the security appliance. Valid values range from 1 to 255.

 [bookmark: pgfId-69964] – Key – The shared key used for authentication. This key must be shared with all other devices sending updates to and receiving updates from the security appliance. The key can be up to 16 characters.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-76375][bookmark: 127316][bookmark: pxpage_cncpt_RIPPage_PIX_ASA-7_2]RIP Page for PIX/ASA 7.2 and Later[bookmark: marker-76369][bookmark: marker-76371][bookmark: marker-76373]

 
     [bookmark: pgfId-76377]Use this RIP page to enable and configure the Routing Information Protocol (RIP) on PIX and ASA devices running operating system 7.2 or later. The RIP page consists of these tabbed panels:

 
      
      		 [bookmark: pgfId-76382]RIP - Setup Tab

 
      		 [bookmark: pgfId-76387]RIP - Redistribution Tab

 
      		 [bookmark: pgfId-76392]RIP - Filtering Tab

 
      		 [bookmark: pgfId-76397]RIP - Interface Tab

 
     

 
     [bookmark: pgfId-76399]Navigation Path

 
      
      		 [bookmark: pgfId-76401](Device view) Select  Platform > Routing > RIP from the Device Policy selector.

 
      		 [bookmark: pgfId-76403](Policy view) Select  PIX/ASA/FWSM Platform > Routing > RIP from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
     

 
     [bookmark: pgfId-76405]When creating a shared RIP policy, you must choose a Version in the Create a Policy dialog box, as follows:

 
     [bookmark: pgfId-76407] – PIX/ASA 6.3-7.1 and FWSM

 
     [bookmark: pgfId-76409] – PIX/ASA 7.2 and Later

 
     [bookmark: pgfId-76411]When assigning a shared RIP policy, be sure to assign the appropriate RIP policy for the device. For example, you cannot assign a PIX/ASA 7.2+ RIP policy to an FWSM.

 
     [bookmark: pgfId-76413]Related Topics

 
      
      		 [bookmark: pgfId-76418]Configuring Static Routes

 
      		 [bookmark: pgfId-76423]Configuring OSPF

 
      		 [bookmark: pgfId-76428]Configuring No Proxy ARP

 
      		 [bookmark: pgfId-76433]RIP Page for PIX/ASA 6.3–7.1 and FWSM

 
     

 
    
 
     
      [bookmark: pgfId-76447][bookmark: 127378][bookmark: pxpage_cncpt_RIPPage_PIX_ASA-7_2_SetupTab]RIP - Setup Tab[bookmark: marker-76441][bookmark: marker-76443][bookmark: marker-76445]

 
     [bookmark: pgfId-76449]Use the Setup panel to define RIP on the security appliance, and to configure global RIP protocol parameters. You can only enable a single RIP process on the security appliance.

 
     [bookmark: pgfId-76451]Navigation Path

 
     [bookmark: pgfId-76456]You can access the Setup tab from the RIP Page for PIX/ASA 7.2 and Later.

 
     [bookmark: pgfId-76458]Related Topics

 
      
      		 [bookmark: pgfId-76463]RIP - Redistribution Tab

 
      		 [bookmark: pgfId-76468]RIP - Filtering Tab

 
      		 [bookmark: pgfId-76473]RIP - Interface Tab

 
      		 [bookmark: pgfId-76478]Chapter 55, “Configuring Routing Policies on Firewall Devices”

 
     

 
     [bookmark: pgfId-76480]Field Reference

 
     [bookmark: pgfId-76483] 

 
      
       
        
        [bookmark: pgfId-69977]Table 55-61 [bookmark: 127416]Setup Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-69983]Element
          
  
         		
           
           [bookmark: pgfId-69985]Description
          
  
        

 
         
         		[bookmark: pgfId-69991]Networks

  
         		[bookmark: pgfId-69996]Define one or more networks for RIP routing. Enter IP address(es), or enter or Select the desired Network/Hosts objects (see Understanding Networks/Hosts Objects); IP addresses must not contain any subnet information. There is no limit to the number of networks you can add to the security appliance configuration.

 [bookmark: pgfId-69998]The RIP routing updates will be sent and received only through interfaces on the specified networks. Also, if the network of an interface is not specified, the interface will not be advertised in any RIP updates.

  
        

 
         
         		[bookmark: pgfId-70004]Passive Interface

  
         		[bookmark: pgfId-70006]Use this option to specify passive interfaces on the security appliance, and by extension the active interfaces. The device listens for RIP routing broadcasts on passive interfaces, using that information to populate its routing tables, but does not broadcast routing updates on passive interfaces. Interfaces that are not designated as passive, receive and send updates. Choose one of these options:

 [bookmark: pgfId-70008] 1. None – No interfaces are designated as passive.

 [bookmark: pgfId-70010] 2. All Interfaces – All interfaces on the device are designated as passive, except those entered the Excluded Interfaces field below.

 [bookmark: pgfId-70012] 3. Specified Interfaces – Only those interfaces explicitly specified in the Interfaces field below are designated as passive.

  
        

 
         
         		[bookmark: pgfId-70018]Interfaces/Excluded Interfaces

  
         		[bookmark: pgfId-70020]Use this field to specify the interfaces excluded from the passive list, or those explicitly designated as passive, depending on your choice from the Passive Interface list above:

 
           
           		 [bookmark: pgfId-70022]If you chose All Interfaces, this field is labeled  Excluded Interfaces : enter or Select only those interfaces to be excluded (that is, those that are to be active not passive).

 
           		 [bookmark: pgfId-70024]If you chose Specified Interfaces in the Passive Interface list, enter or Select those interfaces that are to be designated as passive.

 
          

 [bookmark: pgfId-70026]Note You cannot specify two different RIP configurations for the same interface.

  
        

 
         
         		[bookmark: pgfId-70032]RIP Version

  
         		[bookmark: pgfId-70034]Choose the RIP versions for sending and receiving RIP updates:

 
           
           		 [bookmark: pgfId-70036]Receive Version 1 and 2, Send Version 1

 
           		 [bookmark: pgfId-70038]Send and Receive Version 1

 
           		 [bookmark: pgfId-70040]Send and Receive Version 2

 
          

  
        

 
         
         		[bookmark: pgfId-70046]Generate Default Route

  
         		[bookmark: pgfId-70048]When selected, a default route is generated for distribution, based on the Route Map you specify.

  
        

 
         
         		[bookmark: pgfId-70054]Route Map

  
         		[bookmark: pgfId-70056]Specify the route map to use for generating default routes.

 [bookmark: pgfId-70061]Note This field contains only the Route Map name. The Route Map is created and contained within a FlexConfig; see Chapter 7, “Managing FlexConfigs” for more information.

  
        

 
         
         		[bookmark: pgfId-70067]Enable Auto-Summary

  
         		[bookmark: pgfId-70069]When Send and Receive Version 2 is the chosen RIP Version, this option is available. When checked, automatic route summarization is enabled. Disable automatic summarization if you must perform routing between disconnected subnets. When automatic summarization is disabled, subnets are advertised.

 [bookmark: pgfId-70071]Note RIP Version 1 always uses automatic summarization—you cannot disable it.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-76497][bookmark: 127491][bookmark: pxpage_cncpt_RIPPage_PIX_ASA-7_2_RedistributionTab]RIP - Redistribution Tab[bookmark: marker-76491][bookmark: marker-76493][bookmark: marker-76495]

 
     [bookmark: pgfId-76502]Use the Redistribution panel to manage redistribution routes. These are the routes that are being redistributed from other routing processes into the RIP routing process. See Add/Edit Redistribution Dialog Box for more information.

 
     [bookmark: pgfId-76504]Navigation Path

 
     [bookmark: pgfId-76509]You can access the Redistribution tab from the RIP Page for PIX/ASA 7.2 and Later.

 
     [bookmark: pgfId-76511]Related Topics

 
      
      		 [bookmark: pgfId-76516]RIP - Setup Tab

 
      		 [bookmark: pgfId-76521]RIP - Filtering Tab

 
      		 [bookmark: pgfId-76526]RIP - Interface Tab

 
      		 [bookmark: pgfId-76531]Chapter 55, “Configuring Routing Policies on Firewall Devices”

 
     

 
    
 
     
      [bookmark: pgfId-76545][bookmark: 127527][bookmark: pxpage_cncpt_RIPPage_PIX_ASA-7_2_AddEditRedistributionDlgBox]Add/Edit Redistribution Dialog Box[bookmark: marker-76539][bookmark: marker-76541][bookmark: marker-76543]

 
     [bookmark: pgfId-76550]Use the Add Redistribution and Edit Redistribution dialog boxes to add and edit redistribution routes on the RIP - Redistribution Tab. These are the routes that are being redistributed from other routing processes into the RIP routing process. Except for their titles, these two dialog boxes are identical.

 
     [bookmark: pgfId-76552]Navigation Path

 
     [bookmark: pgfId-76557]You can access the Add and Edit Redistribution dialog boxes from the Redistribution tab on the RIP Page for PIX/ASA 7.2 and Later.

 
     [bookmark: pgfId-76559]Field Reference

 
     [bookmark: pgfId-76562] 

 
      
       
        
        [bookmark: pgfId-70084]Table 55-62 [bookmark: 127551]Add/Edit Redistribution Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-70090]Element
          
  
         		
           
           [bookmark: pgfId-70092]Description
          
  
        

 
         
         		[bookmark: pgfId-70098]Protocol to Redistribute

  
         		[bookmark: pgfId-70100]Choose the routing protocol to redistribute into the RIP routing process:

 
           
           		 [bookmark: pgfId-70102] Static – Static routes.

 
           		 [bookmark: pgfId-70104] Connected – Directly connected networks.

 
           		 [bookmark: pgfId-70106] OSPF – Routes discovered by the OSPF routing process.

 
          

 [bookmark: pgfId-70108]If you choose OSPF, you must also enter the OSPF Process ID and, optionally, Match criteria.

  
        

 
         
         		[bookmark: pgfId-70114]Process ID

  
         		[bookmark: pgfId-70116]Enter the process ID when the OSPF protocol is chosen.

  
        

 
         
         		[bookmark: pgfId-70122]Match

  
         		[bookmark: pgfId-70124]If you are redistributing OSPF routes into the RIP routing process, you can select specific types of OSPF routes to redistribute. Ctrl-click to select multiple types:

 
           
           		 [bookmark: pgfId-70126]Internal – Routes internal to the autonomous system (AS) are redistributed.

 
           		 [bookmark: pgfId-70128]External 1 – Type 1 routes external to the AS are redistributed.

 
           		 [bookmark: pgfId-70130]External 2 – Type 2 routes external to the AS are redistributed.

 
           		 [bookmark: pgfId-70132]NSSA External 1 – Type 1 routes external to a not-so-stubby area (NSSA) are redistributed.

 
           		 [bookmark: pgfId-70134]NSSA External 2 – Type 2 routes external to an NSSA are redistributed.

 
          

 [bookmark: pgfId-70136]Match criteria are optional. The default is match Internal, External 1, and External 2.

  
        

 
         
         		[bookmark: pgfId-70142]Metric

  
         		[bookmark: pgfId-70144]The RIP metric type to apply to the redistributed routes. The two choices are:

 
           
           		 [bookmark: pgfId-70146] Transparent – Use the current route metric.

 
           		 [bookmark: pgfId-70148] Specified Value – Assign a specific metric value.

 
          

  
        

 
         
         		[bookmark: pgfId-70154]Metric Value

  
         		[bookmark: pgfId-70156]The metric value to be assigned; enter a value from 0 to 16.

  
        

 
         
         		[bookmark: pgfId-70162]Route Map

  
         		[bookmark: pgfId-70164]The name of a route map that must be satisfied before the route can be redistributed into the RIP routing process.

 [bookmark: pgfId-70169]Note This field contains only the route Map name. The contents of the route map are created and contained within a FlexConfig. See Chapter 7, “Managing FlexConfigs” for more information.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-76576][bookmark: 127625][bookmark: pxpage_cncpt_RIPPage_PIX_ASA-7_2_FilteringTab]RIP - Filtering Tab[bookmark: marker-76570][bookmark: marker-76572][bookmark: marker-76574]

 
     [bookmark: pgfId-76581]Use the Filtering panel to manage filters for the RIP policy. Filters are used to limit network information in incoming and outgoing RIP advertisements. See Add/Edit Filter Dialog Box for more information.

 
     [bookmark: pgfId-76583]Navigation Path

 
     [bookmark: pgfId-76588]You can access the Filtering tab from the RIP Page for PIX/ASA 7.2 and Later.

 
     [bookmark: pgfId-76590]Related Topics

 
      
      		 [bookmark: pgfId-76595]RIP - Setup Tab

 
      		 [bookmark: pgfId-76600]RIP - Redistribution Tab

 
      		 [bookmark: pgfId-76605]RIP - Interface Tab

 
      		 [bookmark: pgfId-76610]Chapter 55, “Configuring Routing Policies on Firewall Devices”

 
     

 
    
 
     
      [bookmark: pgfId-76624][bookmark: 127661][bookmark: pxpage_cncpt_RIPPage_PIX_ASA-7_2_AddEditFilterDlgBox]Add/Edit Filter Dialog Box[bookmark: marker-76618][bookmark: marker-76620][bookmark: marker-76622]

 
     [bookmark: pgfId-76629]Use the Add Filter and Edit Filter dialog boxes to add and edit RIP filters on the RIP - Filtering Tab. Filters are used to limit network information in incoming and outgoing RIP advertisements. Except for their titles, these two dialog boxes are identical.

 
     [bookmark: pgfId-76631]Navigation Path

 
     [bookmark: pgfId-76636]You can access the Add and Edit Filter dialog boxes from the Filtering tab on the RIP Page for PIX/ASA 7.2 and Later.

 
     [bookmark: pgfId-76638]Field Reference

 
     [bookmark: pgfId-76641] 

 
      
       
        
        [bookmark: pgfId-70182]Table 55-63 [bookmark: 127685]Add/Edit Filter Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-70188]Element
          
  
         		
           
           [bookmark: pgfId-70190]Description
          
  
        

 
         
         		[bookmark: pgfId-70196]Traffic Direction

  
         		[bookmark: pgfId-70198]Choose the type of traffic to be filtered: Inbound or Outbound.

 [bookmark: pgfId-70200]Note If Traffic Direction is Inbound, you can define an Interface filter only.

  
        

 
         
         		[bookmark: pgfId-70206]Filter On

  
         		[bookmark: pgfId-70208]Specify whether the filter is based on an Interface or a Route.

 [bookmark: pgfId-70210]If you select Interface, enter or Select the name of the interface on which routing updates are to be filtered.

 [bookmark: pgfId-70212]If you select Route, choose the route type:

 
           
           		 [bookmark: pgfId-70214] Static – Only static routes are filtered.

 
           		 [bookmark: pgfId-70216] Connected – Only connected routes are filtered.

 
           		 [bookmark: pgfId-70218] OSPF – Only OSPF routes discovered by the specified OSPF process are filtered. Enter the Process ID of the OSPF process to be filtered.

 
          

  
        

 
         
         		[bookmark: pgfId-70224]Filter ACLs

  
         		[bookmark: pgfId-70226]Enter or Select the name of one or more access control lists (ACLs) that define the networks to be allowed or removed from RIP route advertisements.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-76655][bookmark: 127729][bookmark: pxpage_cncpt_RIPPage_PIX_ASA-7_2_InterfaceTab]RIP - Interface Tab[bookmark: marker-76649][bookmark: marker-76651][bookmark: marker-76653]

 
     [bookmark: pgfId-76660]Use the Interface panel to manage the interfaces configured to send and receive RIP broadcasts. See Add/Edit Interface Dialog Box for more information.

 
     [bookmark: pgfId-76662]Navigation Path

 
     [bookmark: pgfId-76667]You can access the Interface tab from the RIP Page for PIX/ASA 7.2 and Later.

 
     [bookmark: pgfId-76669]Related Topics

 
      
      		 [bookmark: pgfId-76674]RIP - Setup Tab

 
      		 [bookmark: pgfId-76679]RIP - Redistribution Tab

 
      		 [bookmark: pgfId-76684]RIP - Filtering Tab

 
      		 [bookmark: pgfId-76689]Chapter 55, “Configuring Routing Policies on Firewall Devices”

 
     

 
    
 
     
      [bookmark: pgfId-76703][bookmark: 127765][bookmark: pxpage_cncpt_RIPPage_PIX_ASA-7_2_AddEditInterfaceDlgBox]Add/Edit Interface Dialog Box[bookmark: marker-76697][bookmark: marker-76699][bookmark: marker-76701]

 
     [bookmark: pgfId-76708]Use the Add Interface and Edit Interface dialog boxes to add and edit RIP interface configurations on the RIP - Interface Tab. Except for their titles, these two dialog boxes are identical.

 
     [bookmark: pgfId-76710]Navigation Path

 
     [bookmark: pgfId-76715]You can access the Add and Edit Interface dialog boxes from the Interface tab on the RIP Page for PIX/ASA 7.2 and Later.

 
     [bookmark: pgfId-76717]Field Reference

 
     [bookmark: pgfId-76720] 

 
      
       
        
        [bookmark: pgfId-70239]Table 55-64 [bookmark: 127789]Add/Edit Interface Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-70245]Element
          
  
         		
           
           [bookmark: pgfId-70247]Description
          
  
        

 
         
         		[bookmark: pgfId-70253]Interface

  
         		[bookmark: pgfId-70255]Enter or Select an interface defined on this appliance.

  
        

 
         
         		[bookmark: pgfId-70261]Send (Version)

  
         		[bookmark: pgfId-70266]These options let you override, for this interface, the global Send versions specified on the RIP - Setup Tab. Select the appropriate boxes to specify sending updates using RIP Version 1, Version 2, or both.

  
        

 
         
         		[bookmark: pgfId-70272]Receive (Version)

  
         		[bookmark: pgfId-70274]These options let you override the global Receive versions. Select the appropriate boxes to specify accepting updates using RIP Version 1 only, Version 2 only, or both.

  
        

 
         
         		[bookmark: pgfId-70280]Authentication type

  
         		[bookmark: pgfId-70282]Choose the authentication used on this interface for RIP broadcasts:

 
           
           		 [bookmark: pgfId-70284] None – No authentication.

 
           		 [bookmark: pgfId-70286] MD5 – Employ MD5.

 
           		 [bookmark: pgfId-70288] Clear Text – Employ clear-text authentication.

 
          

 [bookmark: pgfId-70290]If you choose MD5 or Clear Text, you must also provide the following authentication parameters:

 
           
           		 [bookmark: pgfId-70292] Key ID – The ID of the authentication key. Valid values are from 0 to 255.

 
           		 [bookmark: pgfId-70294] Key – The key used by the chosen authentication method. Can contain up to 16 characters.

 
           		 [bookmark: pgfId-70296] Confirm – Enter the authentication key again, to confirm.

 
          

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-76744][bookmark: 127845][bookmark: pxchap_proc_ConfiguringStaticRoutes]Configuring Static Routes[bookmark: marker-76730][bookmark: marker-76732][bookmark: marker-76734][bookmark: marker-76736][bookmark: marker-76738][bookmark: marker-76740][bookmark: marker-76742]

 
    [bookmark: pgfId-76746]A static route is a specific path to a particular destination network that is manually defined on the current device. Static routes are used in a variety of situations, and can be a quick and effective way to route data from one network to another when there is no dynamic route to the destination, or when use of a dynamic routing protocol is not feasible.

 
    [bookmark: pgfId-76748]All routes have a value or “metric” that represents its priority of use. (This metric is also referred to as “administrative distance.”) When two or more routes to the same destination are available, devices use administrative distance to decide which route to use.

 
    [bookmark: pgfId-76750]For static routes, the default metric value is one, which gives them precedence over routes from dynamic routing protocols. If you increase the metric to a value greater than that of a dynamic route, the static route operates as a back-up in the event that dynamic routing fails. For example, Open Shortest Path First (OSPF)-derived routes have a default administrative distance of 100. To configure a back-up static route that is overridden by an OSPF route, specify a metric value for the static route that is greater than 100. This is referred to as a “floating” static route.

 
    [bookmark: pgfId-76752]There is a special kind of static route known as a default route, or a “zero-zero” route because all zeroes are used for both the destination address and subnet mask. The default static route serves as a catch-all gateway: if there are no matches for a particular destination in the device’s routing table, the default route is used. The default route generally includes a next-hop IP address or local exit interface.

 
    [bookmark: pgfId-76760]Use the Static Route page to maintain manually defined static routes. The Static Route table on this page lists all currently defined static routes, showing for each, the name of the interface or interface role for which the route is defined, the destination network(s), the next hop gateway, the route metric, whether the route is tunneled, and whether there is service-level agreement tracking for the route. For a detailed explanation of these fields, see Add/Edit Static Route Dialog Box or Add/Edit IPv6 Static Route Dialog Box.

 
    [bookmark: pgfId-76762]Static null0 Route Configuration

 
    [bookmark: pgfId-76764]Typically ACLs are used for traffic filtering and they enable you to filter packets based on the information contained in their headers. In packet filtering, the ASA firewall examines packet headers to make a filtering decision, thus adding some overhead to the processing of the packets and affecting performance.

 
    [bookmark: pgfId-76766]Static null 0 routing is a complementary solution to filtering. A static null0 route is used to forward unwanted or undesirable traffic into a black hole. The null interface null0, is used to create the black hole. Static routes are created for destinations that are not desirable, and the static route configuration points to the null interface. Any traffic that has a destination address that has a best match of the black hole static route is automatically dropped. Unlike with ACLs, static null0 routes do not cause any performance degradation.

 
    [bookmark: pgfId-76768]The static null0 route configuration is used to prevent routing loops. BGP leverages the static null0 configuration for Remotely Triggered Black Hole routing.

 
    [bookmark: pgfId-76770]Navigation Path

 
     
     		 [bookmark: pgfId-76772](Device view) Select  Platform > Routing > Static Route or  Platform > Routing > IPv6 Static Route from the Device Policy selector.

 
     		 [bookmark: pgfId-76774](Policy view) Select  PIX/ASA/FWSM Platform > Routing > Static Route or  PIX/ASA/FWSM Platform > Routing > IPv6 Static Route from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-76776]Related Topics

 
     
     		 [bookmark: pgfId-76781]Chapter 55, “Configuring Routing Policies on Firewall Devices”

 
     		 [bookmark: pgfId-76786]Add/Edit Static Route Dialog Box

 
     		 [bookmark: pgfId-76791]Add/Edit IPv6 Static Route Dialog Box

 
     		 [bookmark: pgfId-76796]Monitoring Service Level Agreements (SLAs) To Maintain Connectivity

 
     		 [bookmark: pgfId-76798]Standard rules table topics:

 
    

 
    [bookmark: pgfId-76803] – Using Rules Tables

 
    [bookmark: pgfId-76808] – Table Columns and Column Heading Features

 
     
      [bookmark: pgfId-76824][bookmark: 127919][bookmark: pxpage_cncpt_AddEditStaticRouteDialogBox]Add/Edit Static Route Dialog Box[bookmark: marker-76816][bookmark: marker-76818][bookmark: marker-76820][bookmark: marker-76822]

 
     [bookmark: pgfId-76826]The Add/Edit Static Route dialog box lets you add or edit a static route.

 
     [bookmark: pgfId-76828]Navigation Path

 
     [bookmark: pgfId-76830]You can access the Add/Edit Static Route dialog box from the Static Routes page. Click the Add Row button to add a new static route; select an existing static route and click the Edit Row button to edit that route.

 
     [bookmark: pgfId-76832]Related Topics

 
      
      		 [bookmark: pgfId-76837]Configuring Static Routes

 
      		 [bookmark: pgfId-76842]Chapter 55, “Configuring Routing Policies on Firewall Devices”

 
     

 
     [bookmark: pgfId-76844]Field Reference

 
     [bookmark: pgfId-76847] 

 
      
       
        
        [bookmark: pgfId-70309]Table 55-65 [bookmark: 127954]Add/Edit Static Route Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-70315]Element
          
  
         		
           
           [bookmark: pgfId-70317]Description
          
  
        

 
         
         		[bookmark: pgfId-70323]Interface

  
         		[bookmark: pgfId-70325]Enter or Select the interface to which this static route applies.

 [bookmark: pgfId-70330]Sending traffic to a Null0 interface results in dropping the packets destined to the specified network. This feature is useful in configuring Remotely Triggered Black Hole (RTBH) for BGP. For more information, see Configuring Static Routes.

 [bookmark: pgfId-70332]Note If Null0 is selected as the interface, the Gateway and Tunneled options are disabled.

  
        

 
         
         		[bookmark: pgfId-70338]Network

  
         		[bookmark: pgfId-70340]Enter or Select the destination network(s). You can provide one or more IP address/netmask entries, one or more Networks/Hosts objects, or a combination of both; separate the entries with commas.

 [bookmark: pgfId-70342]Enter “0.0.0.0/0” or “any” to specify a default route.

  
        

 
         
         		[bookmark: pgfId-70348]Gateway

  
         		[bookmark: pgfId-70350]Enter or Select the gateway router which is the next hop for this route. You can provide an IP address, or a Networks/Hosts object.

 [bookmark: pgfId-70352]Note If an IP address from one of the security appliance’s interfaces is used as the Gateway IP address, the security appliance will resolve the designated IP address in the packet instead of resolving the Gateway IP address.

  
        

 
         
         		[bookmark: pgfId-70358]Metric

  
         		[bookmark: pgfId-70360]The Metric is a measurement of the “expense” of a route, based on the number of hops (hop count) to the network on which a specific host resides. Hop count is the number of networks that a network packet must traverse, including the destination network, before it reaches its final destination. Because the hop count includes the destination network, all directly connected networks have a metric of 1.

 [bookmark: pgfId-70362]Enter the number of hops to the destination network. Valid values range from 1 to 255; the default value is 1.

 [bookmark: pgfId-70364]The maximum number of equal-cost (equal-metric) routes that can be defined per interface is three. You cannot add a route with the same metric on different interfaces that are on the same network.

  
        

 
         
         		[bookmark: pgfId-70370]Tunneled

  
         		[bookmark: pgfId-70372]Select this option to make this a tunnel route; can be used only for a default route. You can configure only one default tunneled gateway per device. The Tunneled option is not supported in transparent mode. Available only on PIX/ASA 7.0+ devices.

  
        

 
         
         		[bookmark: pgfId-70378]Route Tracking

  
         		[bookmark: pgfId-70380]To monitor route availability, enter or Select name of an SLA (service level agreement) object that defines the monitoring policy. Available only on PIX/ASA 7.2+ devices.

 [bookmark: pgfId-70385]For more information on route tracking, see Monitoring Service Level Agreements (SLAs) To Maintain Connectivity.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-76863][bookmark: 128004][bookmark: pxpage_cncpt_AddEditIPv6StaticRouteDialogBox]Add/Edit IPv6 Static Route Dialog Box[bookmark: marker-76855][bookmark: marker-76857][bookmark: marker-76859][bookmark: marker-76861]

 
     [bookmark: pgfId-76865]The Add/Edit IPv6 Static Route dialog box lets you add or edit an IPv6 static route. IPv6 static routes are only supported on the following devices:

 
      
      		 [bookmark: pgfId-76867]ASA 7.0 and later (Routed mode)

 
      		 [bookmark: pgfId-76869]ASA 8.2 and later (Transparent mode)

 
      		 [bookmark: pgfId-76871]FWSM 3.1 and later (Routed mode)

 
     

 
     [bookmark: pgfId-76873]Navigation Path

 
     [bookmark: pgfId-76875]You can access the Add/Edit IPv6 Static Route dialog box from the IPv6 Static Route page. Click the Add Row button to add a new static route; select an existing static route and click the Edit Row button to edit that route.

 
     [bookmark: pgfId-76877]Related Topics

 
      
      		 [bookmark: pgfId-76882]Configuring Static Routes

 
      		 [bookmark: pgfId-76887]Chapter 55, “Configuring Routing Policies on Firewall Devices”

 
     

 
     [bookmark: pgfId-76889]Field Reference

 
     [bookmark: pgfId-76892] 

 
      
       
        
        [bookmark: pgfId-70398]Table 55-66 [bookmark: 128048]Add/Edit IPv6 Static Route Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-70404]Element
          
  
         		
           
           [bookmark: pgfId-70406]Description
          
  
        

 
         
         		[bookmark: pgfId-70412]Interface

  
         		[bookmark: pgfId-70414]Enter or Select the interface to which this static route applies.

  
        

 
         
         		[bookmark: pgfId-70420]IPv6 Network

  
         		[bookmark: pgfId-70422]Enter or Select the destination network(s). You can provide one or more IP address entries, one or more Networks/Hosts objects, or a combination of both; separate the entries with commas.

 [bookmark: pgfId-70424]Enter two colons (::) to specify a default route.

  
        

 
         
         		[bookmark: pgfId-70430]IPv6 Gateway

  
         		[bookmark: pgfId-70432]Enter or Select the gateway router which is the next hop for this route. You can provide an IP address, or a Networks/Hosts object.

 [bookmark: pgfId-70434]Note If an IP address from one of the security appliance’s interfaces is used as the Gateway IP address, the security appliance will resolve the designated IP address in the packet instead of resolving the Gateway IP address.

  
        

 
         
         		[bookmark: pgfId-70440]Metric

  
         		[bookmark: pgfId-70442]The Metric is a measurement of the “expense” of a route, based on the number of hops (hop count) to the network on which a specific host resides. Hop count is the number of networks that a network packet must traverse, including the destination network, before it reaches its final destination. Because the hop count includes the destination network, all directly connected networks have a metric of 1.

 [bookmark: pgfId-70444]Enter the number of hops to the destination network. Valid values range from 1 to 255; the default value is 1.

 [bookmark: pgfId-70446]The maximum number of equal-cost (equal-metric) routes that can be defined per interface is three. You cannot add a route with the same metric on different interfaces that are on the same network.

  
        

 
         
         		[bookmark: pgfId-70452]Tunneled

  
         		[bookmark: pgfId-70454]Select this option to specify the route as the default tunnel gateway for VPN traffic. You can configure only one default tunneled gateway per device. Available only on ASA 7.0+ devices in routed mode.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-76902][bookmark: 128089][bookmark: pobjpage_cncpt_ASARoutingPolicyObjects]Configuring Policy Objects for ASA Routing Policies[bookmark: marker-76898][bookmark: marker-76900]

 
    [bookmark: pgfId-76904]There are several policy objects that you use with ASA routing policies. This reference explains the configuration of these policy objects.

 
    [bookmark: pgfId-76906]This section contains the following topics:

 
     
     		 [bookmark: pgfId-76911]Understanding Route Map Objects

 
     		 [bookmark: pgfId-76916]Add or Edit Policy List Object Dialog Box

 
     		 [bookmark: pgfId-76921]Add or Edit Prefix List Object Dialog Box

 
     		 [bookmark: pgfId-76926]Add or Edit Prefix List IPv6 Object Dialog Box

 
     		 [bookmark: pgfId-76931]Add or Edit As Path Object Dialog Boxes

 
     		 [bookmark: pgfId-76936]Add or Edit Community List Object Dialog Box

 
    

 
     
      [bookmark: pgfId-76956][bookmark: 128098][bookmark: pobjpage_cncpt_RouteMapObjects]Understanding Route Map Objects[bookmark: marker-76944][bookmark: marker-76946][bookmark: marker-76948][bookmark: marker-76950][bookmark: marker-76952][bookmark: marker-76954]

 
     [bookmark: pgfId-76958]You can use route maps to define the conditions for redistributing routes from one routing protocol into another, or to enable policy routing.

 
     [bookmark: pgfId-76960]Route maps have many features in common with widely known ACLs. These are some of the traits common to both:

 
      
      		 [bookmark: pgfId-76962]They are an ordered sequence of individual statements, each has a permit or deny result. Evaluation of ACL or route maps consists of a list scan, in a predetermined order, and an evaluation of the criteria of each statement that matches. A list scan is aborted once the first statement match is found and an action associated with the statement match is performed.

 
      		 [bookmark: pgfId-76964]They are generic mechanisms—Criteria matches and match interpretation are dictated by the way that they are applied. The same route map applied to different tasks might be interpreted differently.

 
     

 
     [bookmark: pgfId-76966]These are some of the differences between route maps and ACLs:

 
      
      		 [bookmark: pgfId-76968]Route maps frequently use ACLs as matching criteria.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-76970]Note Route maps do not support ACLs that include a user, user group, security group tag, or fully qualified domain name objects.


     
      

     

     

 
      
      		 [bookmark: pgfId-76972]The main result from the evaluation of an ACL is a yes or no answer—An ACL either permits or denies input data. Applied to redistribution, an ACL determines if a particular route can (route matches ACLs permit statement) or can not (matches deny statement) be redistributed. Typical route maps not only permit (some) redistributed routes but also modify information associated with the route, when it is redistributed into another protocol.

 
      		 [bookmark: pgfId-76974]Route maps are more flexible than ACLs and can verify routes based on criteria which ACLs can not verify. For example, a route map can verify if the type of route is internal.

 
      		 [bookmark: pgfId-76976]Each ACL ends with an implicit deny statement, by design convention; there is no similar convention for route maps. If the end of a route map is reached during matching attempts, the result depends on the specific application of the route map. Fortunately, route maps that are applied to redistribution behave the same way as ACLs: if the route does not match any clause in a route map then the route redistribution is denied, as if the route map contained deny statement at the end.

 
     

 
     [bookmark: pgfId-76978]Route maps are preferred if you intend to either modify route information during redistribution or if you need more powerful matching capability than an ACL can provide. If you simply need to selectively permit some routes based on their prefix or mask, we recommend that you use a route map to map to an ACL (or equivalent prefix list).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-76980]Note You must use a standard ACL as the match criterion for your route map. Using an extended ACL will not work, and your routes will never be redistributed. We recommend that you number clauses in intervals of 10 to reserve numbering space in case you need to insert clauses in the future.


     
      

     

     

 
     [bookmark: pgfId-76982]Permit and Deny Clauses

 
     [bookmark: pgfId-76984]Route maps can have permit and deny clauses. If the match criteria are met for this route map, and the permit keyword is specified, the route is redistributed as controlled by the set actions. If the match criteria are not met, and the permit keyword is specified, the next route map with the same map tag is tested. If a route passes none of the match criteria for the set of route maps sharing the same name, it is not redistributed by that set. If the match criteria are met for the route map and the deny keyword is specified, the route is not redistributed.

 
     [bookmark: pgfId-76986]The following rules apply:

 
      
      		 [bookmark: pgfId-76988]If you use an ACL in a route map using a permit clause, routes that are permitted by the ACL are redistributed.

 
      		 [bookmark: pgfId-76990]If you use an ACL in a route map deny clause, routes that are permitted by the ACL are not redistributed.

 
      		 [bookmark: pgfId-76992]If you use an ACL in a route map permit or deny clause, and the ACL denies a route, then the route map clause match is not found and the next route-map clause is evaluated.

 
     

 
     [bookmark: pgfId-76994]Match and Set Clause Values

 
     [bookmark: pgfId-76996]Each entry in a route map statement contains a combination of match and set clauses. The match clause defines the criteria for whether appropriate packets meet the particular policy (that is, the conditions to be met). The set clause explains how the packets should be routed once they have met the match criteria.

 
     [bookmark: pgfId-76998]For each route that is being redistributed, the router first evaluates the match criteria of a clause in the route map. If the match criteria succeed, then the route is redistributed or rejected as dictated by the permit or deny clause, and some of its attributes might be modified as defined by the set clause. If the match criteria fail, then this clause is not applicable to the route, and the software proceeds to evaluate the route against the next clause in the route map. Scanning of the route map continues until a clause is found whose match clause matches the route or until the end of the route map is reached.

 
     [bookmark: pgfId-77000]A match or set value in each clause can be missed or repeated several times, if one of these conditions exists:

 
      
      		 [bookmark: pgfId-77002]If several Match Clause values are present in a clause, all must succeed for a given route in order for that route to match the clause (in other words, the logical AND algorithm is applied for multiple match commands).

 
      		 [bookmark: pgfId-77004]If a Match Clause value refers to several objects in one command, any of the objects should match (the logical OR algorithm is applied).

 
      		 [bookmark: pgfId-77006]If a Match Clause value is not present, all routes match the clause.

 
      		 [bookmark: pgfId-77008]If a Set Value is not present in a route map permit clause, then the route is redistributed without modification of its current attributes.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-77010]Note Do not configure a Set Value in a route map deny clause because the deny clause prohibits route redistribution—there is no information to modify.


     
      

     

     

 
     [bookmark: pgfId-77012]A route map clause without a Match or Set value performs an action. An empty permit clause allows a redistribution of the remaining routes without modification. An empty deny clause does not allow a redistribution of other routes (this is the default action if a route map is completely scanned, but no explicit match is found).

 
     [bookmark: pgfId-77014]BGP Match and BGP Set Clauses

 
     [bookmark: pgfId-77016]In addition to the match and set values described above, BGP provides additional match and set capabilities to route maps.

 
     [bookmark: pgfId-77018]The following route-map match clauses are supported with BGP:

 
      
      		 [bookmark: pgfId-77020]match AS path access list

 
      		 [bookmark: pgfId-77022]match community

 
      		 [bookmark: pgfId-77024]match policy list

 
     

 
     [bookmark: pgfId-77026]The following route-map set clauses are supported with BGP:

 
      
      		 [bookmark: pgfId-77028]set AS path

 
      		 [bookmark: pgfId-77030]set community

 
      		 [bookmark: pgfId-77032]set automatic tag

 
      		 [bookmark: pgfId-77034]set local preference

 
      		 [bookmark: pgfId-77036]set weight

 
      		 [bookmark: pgfId-77038]set origin

 
      		 [bookmark: pgfId-77040]set next hop

 
      		 [bookmark: pgfId-77042]set IP prefix list

 
     

 
     [bookmark: pgfId-77044]Creating and Using Route Map Objects

 
     [bookmark: pgfId-77052]When configuring a policy that requires that you identify a route map, you can select or create route map objects by clicking the Select button next to the Route Map field. To create a new route map from the Route Map Object Selector dialog box, click the Create button beneath the route map list. You can also create route map objects from the Policy Object Manager by selecting Route Map from the Object Type Selector and then clicking the New Object button. For information on the specific fields available when creating a route map object, see Add or Edit Route Map Object Dialog Boxes.

 
     [bookmark: pgfId-77054]Note about the use of Route Map Objects in BGP Policies

 
     [bookmark: pgfId-77056]Some of the match and set criteria used in route maps are not supported in all BGP subcommands. For example:

 
     [bookmark: pgfId-77058]The following route map match criteria:

 
      
      		 [bookmark: pgfId-77060]Match Clause tab > Match first hop interface of route, Match Next Hop (IPv4 and IPv6), Match Route Source (IPv4 and IPv6), Match Metric Route Value, and Match Tag

 
      		 [bookmark: pgfId-77062]BGP Match Clause tab > Match AS path access lists

 
     

 
     [bookmark: pgfId-77064]and the following route map set criteria:

 
      
      		 [bookmark: pgfId-77066]Set Clause tab > Metric Values (all fields) and Metric Type

 
      		 [bookmark: pgfId-77068]BGP Set Clause tab > Set AS path, Prepend AS path, and Prepend last AS to the AS path

 
     

 
     [bookmark: pgfId-77070]are not supported in the following places:

 
      
      		 [bookmark: pgfId-77072]BGP policy > IPv4 Address Family:

 
     

 
     [bookmark: pgfId-77074] – Aggregate Address tab > Attribute Map, Advertise Map, and Suppress Map

 
     [bookmark: pgfId-77076] – Neighbor tab > Filtering tab

 
     [bookmark: pgfId-77078] – Route Injection tab > Inject Map and Exist Map

 
     [bookmark: pgfId-77080]Security Manager allows you to use route maps in your BGP configuration even if the route map contains unsupported match or set criteria and you will not receive a warning or error during validation. In such cases, deployment will fail and you will receive an error from the device in the following format: …%"My-Route-map" used as BGP inbound route-map, nexthop match not supported….

 
     [bookmark: pgfId-77082]Please refer to the ASA documentation for guidelines on the match/set criteria supported in route maps used in BGP configuration.

 
     [bookmark: pgfId-77084]Related Topics

 
      
      		 [bookmark: pgfId-77089]Add or Edit Route Map Object Dialog Boxes

 
      		 [bookmark: pgfId-77094]Add or Edit Route Map Entry Dialog Box

 
      		 [bookmark: pgfId-77099]Selecting Objects for Policies

 
      		 [bookmark: pgfId-77104]Creating Policy Objects

 
      		 [bookmark: pgfId-77109]Editing Objects

 
      		 [bookmark: pgfId-77114]Using Category Objects

 
      		 [bookmark: pgfId-77119]Managing Object Overrides

 
      		 [bookmark: pgfId-77124]Allowing a Policy Object to Be Overridden

 
     

 
    
 
     
      [bookmark: pgfId-77142][bookmark: 128264][bookmark: pobjpage_cncpt_AddEditRouteMapObjectDialogBox]Add or Edit Route Map Object Dialog Boxes[bookmark: marker-77132][bookmark: marker-77134][bookmark: marker-77136][bookmark: marker-77138][bookmark: marker-77140]

 
     [bookmark: pgfId-77144]Use the Add/Edit Route Map Object dialog box to create, copy and edit route map policy objects. You can use route maps to define the conditions for redistributing routes from one routing protocol into another, or to enable policy routing.

 
     [bookmark: pgfId-77146]Navigation Path

 
     [bookmark: pgfId-77148]Select Manage > Policy Objects, then select Route Map from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-77150]Related Topics

 
      
      		 [bookmark: pgfId-77155]Understanding Route Map Objects

 
      		 [bookmark: pgfId-77160]Add or Edit Route Map Entry Dialog Box

 
      		 [bookmark: pgfId-77165]Policy Object Manager

 
      		 [bookmark: pgfId-77170]Selecting Objects for Policies

 
      		 [bookmark: pgfId-77175]Creating Policy Objects

 
      		 [bookmark: pgfId-77180]Editing Objects

 
      		 [bookmark: pgfId-77185]Using Category Objects

 
      		 [bookmark: pgfId-77190]Managing Object Overrides

 
      		 [bookmark: pgfId-77195]Allowing a Policy Object to Be Overridden

 
     

 
     [bookmark: pgfId-77197]Field Reference

 
     [bookmark: pgfId-77200] 

 
      
       
        
        [bookmark: pgfId-70467]Table 55-67 [bookmark: 128321]Add/Edit Route Map Object Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-70473]Element
          
  
         		
           
           [bookmark: pgfId-70475]Description
          
  
        

 
         
         		[bookmark: pgfId-70481]Name

  
         		[bookmark: pgfId-70483]Enter a meaningful name for the route map object. The route map object name cannot be more than 58 characters.

 
           
           [image: ] 
          
 
          
 
          
           [bookmark: pgfId-70485]Caution Security Manager allows you to rename these objects even though you cannot rename them on the device. When you rename these objects in Security Manager, the name change is accomplished by negating the existing CLI, and then issuing new CLI to create and assign the object using the new name. This initial negation may cause routing/network issues in your environment. Security Manager will not provide a warning message about these consequences when you rename the object.
            
            
 
           

          
  
        

 
         
         		[bookmark: pgfId-70491]Description

  
         		[bookmark: pgfId-70493]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-70499]Route Map table

  
         		[bookmark: pgfId-70501]The Route Map entries that are defined in the object.

 
           
           		 [bookmark: pgfId-70506]To add a Route Map entry, click the  Add button to open the Add or Edit Route Map Entry Dialog Box.

 
           		 [bookmark: pgfId-70508]To edit a Route Map entry, select it and click the  Edit button.

 
           		 [bookmark: pgfId-70510]To delete a Route Map entry, select it and click the  Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-70516]Category

  
         		[bookmark: pgfId-70521]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-70527]Allow Value Override per Device

 [bookmark: pgfId-70529]Overrides

 [bookmark: pgfId-70531]Edit button

  
         		[bookmark: pgfId-70539]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-70541]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-77212][bookmark: 128376][bookmark: pobjpage_cncpt_AddEditRouteMapEntryDialogBox]Add or Edit Route Map Entry Dialog Box[bookmark: marker-77208][bookmark: marker-77210]

 
     [bookmark: pgfId-77214]Use the Add/Edit Route Map Entry dialog box to create a new route map entry for a Route Map object or to edit an existing one.

 
     [bookmark: pgfId-77216]Navigation Path

 
     [bookmark: pgfId-77221]From the Add or Edit Route Map Object Dialog Boxes, click the Add button beneath the Route Map table or select an entry in the table and click the Edit button.

 
     [bookmark: pgfId-77223]Related Topics

 
      
      		 [bookmark: pgfId-77228]Understanding Route Map Objects

 
      		 [bookmark: pgfId-77233]Add or Edit Route Map Object Dialog Boxes

 
      		 [bookmark: pgfId-77238]Policy Object Manager

 
      		 [bookmark: pgfId-77243]Selecting Objects for Policies

 
      		 [bookmark: pgfId-77248]Creating Policy Objects

 
      		 [bookmark: pgfId-77253]Editing Objects

 
      		 [bookmark: pgfId-77258]Using Category Objects

 
      		 [bookmark: pgfId-77263]Managing Object Overrides

 
      		 [bookmark: pgfId-77268]Allowing a Policy Object to Be Overridden

 
     

 
     [bookmark: pgfId-77270]Field Reference

 
     [bookmark: pgfId-77273] 

 
      
       
        
        [bookmark: pgfId-70554]Table 55-68 [bookmark: 128423]Add/Edit Route Map Entry Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-70560]Element
          
  
         		
           
           [bookmark: pgfId-70562]Description
          
  
        

 
         
         		[bookmark: pgfId-70568]Sequence Number

  
         		[bookmark: pgfId-70570]A number, between 0 and 65535, that indicates the position a new route map entry will have in the list of route maps entries already configured for this route map object.

 [bookmark: pgfId-70572]Tip We recommend that you number clauses in intervals of at least 10 to reserve numbering space in case you need to insert clauses in the future.  
        

 
         
         		[bookmark: pgfId-70578]Redistribution

  
         		[bookmark: pgfId-70580]Whether to redistribute a route or not. To allow redistribution for route matches, click Permit. To reject route matches from redistribution, select Deny.

 [bookmark: pgfId-70582]If you use an ACL in a route map Permit clause, routes that are permitted by the ACL are redistributed. If you use an ACL in a route map Deny clause, routes that are permitted by the ACL are not redistributed. In addition, if you use an ACL in a route map Permit or Deny clause, and the ACL denies a route, then the route map clause match is not found and the next route map clause is evaluated.

  
        

 
         
         		 [bookmark: pgfId-70588]Match Clause Tab

 [bookmark: pgfId-70590]Select the Match Clause tab to choose routes to which this clause should be applied, and set the following parameters:

  
        

 
         
         		[bookmark: pgfId-70598]Match first hop interface of route

  
         		[bookmark: pgfId-70600]Enable or disable matching routes that have their next hop out one of the interfaces specified. Enter or select the interfaces to match. Separate multiple entries with a comma. If you specify more than one interface, then the route can match either interface.

 [bookmark: pgfId-70605]Use the ellipsis to open the Interfaces Selector from which you can select one or more interfaces. You can also create new interface roles from the Interfaces Selector. For more information, see Understanding Interface Role Objects.

  
        

 
         
         		 
           
           [bookmark: pgfId-70611]IPv4
          
  
        

 
         
         		[bookmark: pgfId-70619]Match Address

  
         		[bookmark: pgfId-70621]Enable or disable matching of any routes that have a route address or match packet that is passed by one of the access lists specified.

 [bookmark: pgfId-70623]For IPv4 addresses, choose whether to use an access list or Prefix list for matching from the drop-down list and then enter or select the ACL objects or Prefix list objects you want to use for matching.

 [bookmark: pgfId-70631]Use the ellipsis to open the Access Control List Object Selector or Prefix List Object Selector from which you can select one or more objects. You can also create new objects from the object selector. For more information, see Add or Edit Access List Dialog Boxes or Add or Edit Prefix List Object Dialog Box.

  
        

 
         
         		[bookmark: pgfId-70637]Match Next Hop

  
         		[bookmark: pgfId-70639]Enable or disable matching of the next hop address of a route.

 [bookmark: pgfId-70641]For IPv4 addresses, choose whether to use an access list or Prefix list for matching from the drop-down list and then enter or select the ACL objects or Prefix list objects you want to use for matching.

 [bookmark: pgfId-70649]Use the ellipsis to open the Access Control List Object Selector or Prefix List Object Selector from which you can select one or more objects. You can also create new objects from the object selector. For more information, see Add or Edit Access List Dialog Boxes or Add or Edit Prefix List Object Dialog Box.

  
        

 
         
         		[bookmark: pgfId-70655]Match Route Source

  
         		[bookmark: pgfId-70657]Enable or disable matching of the advertising source address of the route.

 [bookmark: pgfId-70659]For IPv4 addresses, choose whether to use an access list or Prefix list for matching from the drop-down list and then enter or select the ACL objects or Prefix list objects you want to use for matching.

 [bookmark: pgfId-70667]Use the ellipsis to open the Access Control List Object Selector or Prefix List Object Selector from which you can select one or more objects. You can also create new objects from the object selector. For more information, see Add or Edit Access List Dialog Boxes or Add or Edit Prefix List Object Dialog Box.

  
        

 
         
         		 
           
           [bookmark: pgfId-70673]IPv6
          
  
        

 
         
         		[bookmark: pgfId-70681]Match Address

  
         		[bookmark: pgfId-70683]Enable or disable matching of any routes that have a route address or match packet that is passed by one of the access lists specified.

 [bookmark: pgfId-70685]For IPv6 addresses, choose whether to use an access list or IPv6 Prefix list for matching from the drop-down list and then enter or select the ACL objects or IPv6 Prefix list objects you want to use for matching.

 [bookmark: pgfId-70693]Use the ellipsis to open the Access Control List Object Selector or IPv6 Prefix List Object Selector from which you can select one or more objects. You can also create new objects from the object selector. For more information, see Add or Edit Access List Dialog Boxes or Add or Edit Prefix List IPv6 Object Dialog Box.

  
        

 
         
         		[bookmark: pgfId-70699]Match Next Hop

  
         		[bookmark: pgfId-70701]Enable or disable matching of the next hop address of a route.

 [bookmark: pgfId-70703]For IPv6 addresses, choose whether to use an access list or Prefix list for matching from the drop-down list and then enter or select the ACL objects or IPv6 Prefix list objects you want to use for matching.

 [bookmark: pgfId-70711]Use the ellipsis to open the Access Control List Object Selector or IPv6 Prefix List Object Selector from which you can select one or more objects. You can also create new objects from the object selector. For more information, see Add or Edit Access List Dialog Boxes or Add or Edit Prefix List IPv6 Object Dialog Box.

  
        

 
         
         		[bookmark: pgfId-70717]Match Route Source

  
         		[bookmark: pgfId-70719]Enable or disable matching of the advertising source address of the route.

 [bookmark: pgfId-70721]For IPv6 addresses, choose whether to use an access list or IPv6 Prefix list for matching from the drop-down list and then enter or select the ACL objects or IPv6 Prefix list objects you want to use for matching.

 [bookmark: pgfId-70729]Use the ellipsis to open the Access Control List Object Selector or IPv6 Prefix List Object Selector from which you can select one or more objects. You can also create new objects from the object selector. For more information, see Add or Edit Access List Dialog Boxes or Add or Edit Prefix List IPv6 Object Dialog Box.

  
        

 
         
         		[bookmark: pgfId-70735]Match Metric Route Value

  
         		[bookmark: pgfId-70737]Enable or disable matching the metric of a route. Type the metric values to use for matching in the Match Metric Route Value field. You can enter multiple values separated by commas. This setting allows you to match any routes that have a specified metric. The metric values can range from 0 to 4294967295.

  
        

 
         
         		[bookmark: pgfId-70743]Match Tag

  
         		[bookmark: pgfId-70745]Enable or disable matching the security group tag of a route. Type the tag values to use for matching in the Match Tag field. You can enter multiple values separated by commas. This setting allows you to match any routes that have a specified security group tag. The tag values can range from 0 to 4294967295.

  
        

 
         
         		[bookmark: pgfId-70751]Match Route Type

  
         		[bookmark: pgfId-70753]Enable or disable matching of the route type. Valid route types are External1, External2, Internal, Local, NSSA-External1, and NSSA-External2. When enabled, you can choose more than one route type from the list.

  
        

 
         
         		 [bookmark: pgfId-70759]Set Clause Tab

 [bookmark: pgfId-70761]Select the Set Clause tab to modify the following information, which will be redistributed to the target protocol:

 [bookmark: pgfId-70763]Note You can specify just the Bandwidth value, all of the values, or none of the values.

  
        

 
         
         		[bookmark: pgfId-70771]Bandwidth

  
         		[bookmark: pgfId-70773]Metric value or Bandwidth in Kbits per second; an integer value from 0 to 4294967295.

  
        

 
         
         		[bookmark: pgfId-70779]EIGRP Delay

  
         		[bookmark: pgfId-70781]EIGRP route delay, in tens of microseconds. Valid values range from 1 to 4294967295.

  
        

 
         
         		[bookmark: pgfId-70787]EIGRP Reliability

  
         		[bookmark: pgfId-70789]Likelihood of successful packet transmission for EIGRP expressed as a number from 0 to 255. The value 255 means 100 percent reliability; 0 means no reliability.

  
        

 
         
         		[bookmark: pgfId-70795]EIGRP Effective

  
         		[bookmark: pgfId-70797]Effective EIGRP bandwidth of a route expressed as a number from 1 to 255. The value 255 means 100 percent loading.

  
        

 
         
         		[bookmark: pgfId-70803]EIGRP MTU

  
         		[bookmark: pgfId-70805]Minimum MTU size of a route for EIGRP, in bytes. Valid values range from 1 to 4294967295.

  
        

 
         
         		[bookmark: pgfId-70811]Set Metric Type

  
         		[bookmark: pgfId-70813]Select to specify the type of metric for the destination routing protocol, and choose the metric type from the drop-down list: internal, type-1, or type-2.

  
        

 
         
         		 
           
           [bookmark: pgfId-70819]BGP Match Clause Tab
          
  
        

 
         
         		[bookmark: pgfId-70827]Match AS path access lists

  
         		[bookmark: pgfId-70829]Select to enable matching the BGP autonomous system path access list with the specified path access list. If you specify more than one path access list, then the route can match either path access list.

 [bookmark: pgfId-70834]Use the ellipsis to open the AS Path Object Selector from which you can select one or more AS path objects. You can also create new AS path objects from the AS Path Object Selector. For more information, see Add or Edit As Path Object Dialog Boxes.

  
        

 
         
         		[bookmark: pgfId-70840]Match community

  
         		[bookmark: pgfId-70842]Select to enable matching the BGP community with the specified community. If you specify more than one community, then the route can match either community. Any route that does not match at least one Match community will not be advertised for outbound route maps.

 [bookmark: pgfId-70847]Use the ellipsis to open the Community List Object Selector from which you can select one or more Community List objects. You can also create new Community List objects from the Community List Object Selector. For more information, see Add or Edit Community List Object Dialog Box.

 [bookmark: pgfId-70849]To enable matching the BGP community exactly with the specified community, check the Match the specified community exactly check box.

  
        

 
         
         		[bookmark: pgfId-70855]Match policy list

  
         		[bookmark: pgfId-70857]Select to configure a route map to evaluate and process a BGP policy. When multiple policy lists perform matching within a route map entry, all policy lists match on the incoming attribute only.

 [bookmark: pgfId-70862]Use the ellipsis to open the Policy List Object Selector from which you can select one or more Policy List objects. You can also create new Policy List objects from the Policy List Object Selector. For more information, see Add or Edit Policy List Object Dialog Box.

  
        

 
         
         		 [bookmark: pgfId-70868]BGP Set Clause Tab

 [bookmark: pgfId-70870]Select the BGP Set Clause tab to modify the following information, which will be redistributed to the BGP protocol:

  
        

 
         
         		[bookmark: pgfId-70878]Set AS path

  
         		[bookmark: pgfId-70880]Select to modify an autonomous system path for BGP routes.

 
           
           		 [bookmark: pgfId-70882]Select  Prepend AS path to prepend an arbitrary autonomous system path string to BGP routes. Usually the local AS number is prepended multiple times, increasing the autonomous system path length. If you specify more than one AS path number then the route can prepend either AS number.

 
           		 [bookmark: pgfId-70884]Select  Prepend last AS to the AS path to prepend the AS path with the last AS number. Enter a value for the AS number from 1 to 10.

 
           		 [bookmark: pgfId-70886]Select  Convert route tag into AS path to convert the tag of a route into an autonomous system path.

 
          

  
        

 
         
         		[bookmark: pgfId-70892]Set community

  
         		[bookmark: pgfId-70894]Select to set the BGP communities attributes.

 
           
           		 [bookmark: pgfId-70896]Select  None to remove the community attribute from the prefixes that pass the route map.

 
           		 [bookmark: pgfId-70898]Select  Specify community to enter a community number, if applicable. Valid values are from 1 to 4294967295.

 
          

 [bookmark: pgfId-70900]Select Add to the existing communities to add the community to the already existing communities.

 
           
           		 [bookmark: pgfId-70902]Select  Internet ,  no-advertise or  no-export to use one of the well-known communities.

 
          

  
        

 
         
         		[bookmark: pgfId-70908]Set Automatic-tag

  
         		[bookmark: pgfId-70910]Select to automatically compute the tag value.

  
        

 
         
         		[bookmark: pgfId-70916]Set local preference

  
         		[bookmark: pgfId-70918]Select to specify a preference value for the autonomous system path. Enter a value between 0 and 4294967295.

  
        

 
         
         		[bookmark: pgfId-70924]Set weight

  
         		[bookmark: pgfId-70926]Select to specify the BGP weight for the routing table. Enter a value between 0 and 65535.

  
        

 
         
         		[bookmark: pgfId-70932]Set origin

  
         		[bookmark: pgfId-70934]Select to specify the BGP origin code. Valid values are Local IGP and Incomplete.

  
        

 
         
         		 
           
           [bookmark: pgfId-70940]Next hop IPv4
          
  
        

 
         
         		[bookmark: pgfId-70948]Set next hop

  
         		 
        

 
         
         		[bookmark: pgfId-70968]Set next hop

  
         		[bookmark: pgfId-70970]Select to specify the output address of packets that fulfill the match clause of a route map:

 
           
           		 [bookmark: pgfId-70972]Select  Specify IPv6 address to enter the IPv6 address of the next hop to which packets are output. It need not be an adjacent router. If you specify more than one IPv6 address then the packets can output at either IP address. You can enter multiple values separated by commas.

 
           		 [bookmark: pgfId-70974]Select  Use peer address to set the next hop to be the BGP peer address.

 
          

  
        

 
         
         		
           
           [bookmark: pgfId-70980]Prefix List
          
  
         		 
         		[bookmark: pgfId-70990]Select to set an IPv4 prefix list.

 [bookmark: pgfId-70995]Use the ellipsis to open the Prefix List Object Selector from which you can select one or more Prefix List objects. You can also create new Prefix List objects from the Prefix List Object Selector. For more information, see Add or Edit Prefix List Object Dialog Box.

  
        

 
         
         		[bookmark: pgfId-71001]Set IPv6 prefix list

  
         		[bookmark: pgfId-71003]Select to set an IPv6 prefix list.

 [bookmark: pgfId-71008]Use the ellipsis to open the Prefix List Object IPv6 Selector from which you can select one or more IPv6 Prefix List objects. You can also create new IPv6 Prefix List objects from the Prefix List Object Selector. For more information, see Add or Edit Prefix List IPv6 Object Dialog Box.

  
        

 
         
         		 [bookmark: pgfId-71014]Policy Based Routing (PBR) Tab

 [bookmark: pgfId-71016]Click the Policy Based Routing tab to define policy for traffic flows, and lessening reliance on routes derived from routing protocols. PBR gives you more control over routing by extending and complementing the existing mechanisms provided by routing protocols. PBR allows you to set the IP precedence. It also allows you to specify a path for certain traffic, such as priority traffic over a high-cost link. However, the SLA monitor (Set IP Next-Hop Verify-Availability) is not supported.

  
        

 
         
         		[bookmark: pgfId-71024]Set Default Next-Hop IPv4 Address

  
         		[bookmark: pgfId-71026]Check the Set default next-hop IPv4 address check box to indicate where to output packets that pass a match clause of a route map for policy routing. In the IPv4 Address enter the destination address.

  
        

 
         
         		[bookmark: pgfId-71032]Set Default Next-Hop IPv6 Address

  
         		[bookmark: pgfId-71034]Check the Set default next-hop IPv6 address check box to indicate where to output packets that pass a match clause of a route map for policy routing. In the IPv6 Address enter the destination address.

  
        

 
         
         		[bookmark: pgfId-71040]Recursively find and set Next-Hop IPv4 Address

  
         		[bookmark: pgfId-71042]Check the Recursively find and set next-hop IP address check box and specify an IP address in the IPv4 Address field. In this case, the next-hop IP address need not be on a directly connected subnet.

  
        

 
         
         		[bookmark: pgfId-71048]Set Interfaces

  
         		[bookmark: pgfId-71050]Check the Set interfaces check box and select a destination interface from the Interfaces Selector dialog box.

  
        

 
         
         		[bookmark: pgfId-71056]Set Null0 Interfaces as Default Interface

  
         		[bookmark: pgfId-71058]Check the Set null0 interface as the default interface check box, if there is a need to completely black hole or drop some traffic.

  
        

 
         
         		[bookmark: pgfId-71064]Set do-not-fragment bit to either 0 or 1

  
         		[bookmark: pgfId-71066]Check the Set do-not-fragment bit to either 1or 0 and then select the appropriate radio button.

  
        

 
         
         		[bookmark: pgfId-71072]Set Differential Service Code point (DSCP) value in Q...

  
         		[bookmark: pgfId-71074]Check the Set differential service code point (DSCP) value in QoS bits for IPv4 packets check box and either enter a value between 0 and 63 or select a value from the Select Value drop-down list.

  
        

 
         
         		[bookmark: pgfId-71080]Set Differential Service Code point (DSCP) value in QOS bits for IPv6 packets

  
         		[bookmark: pgfId-71082]Check the Set differential service code point (DSCP) value in QoS bits for IPv6 packets check box and either enter a value between 0 and 63 or select a value from the Select Value drop-down list.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-77293][bookmark: 128768][bookmark: pobjpage_cncpt_AddEditPolicyListObjectDialogBox]Add or Edit Policy List Object Dialog Box[bookmark: marker-77283][bookmark: marker-77285][bookmark: marker-77287][bookmark: marker-77289][bookmark: marker-77291]

 
     [bookmark: pgfId-77298]Use the Add/Edit Policy List Object dialog box to create, copy, and edit policy list policy objects. You can create policy list objects to use when you are configuring route maps (see Understanding Route Map Objects).

 
     [bookmark: pgfId-77300]When a policy list is referenced within a route map, all of the match statements within the policy list are evaluated and processed. Two or more policy lists can be configured with a route map. A policy list can also coexist with any other preexisting match and set statements that are configured within the same route map but outside of the policy list. When multiple policy lists perform matching within a route map entry, all policy lists match on the incoming attribute only.

 
     [bookmark: pgfId-77302]Navigation Path

 
     [bookmark: pgfId-77304]Select Manage > Policy Objects, then select Policy List from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-77306]Related Topics

 
      
      		 [bookmark: pgfId-77311]Understanding Route Map Objects

 
      		 [bookmark: pgfId-77316]Policy Object Manager

 
      		 [bookmark: pgfId-77321]Selecting Objects for Policies

 
      		 [bookmark: pgfId-77326]Creating Policy Objects

 
      		 [bookmark: pgfId-77331]Editing Objects

 
      		 [bookmark: pgfId-77336]Using Category Objects

 
      		 [bookmark: pgfId-77341]Managing Object Overrides

 
      		 [bookmark: pgfId-77346]Allowing a Policy Object to Be Overridden

 
     

 
     [bookmark: pgfId-77348]Field Reference

 
     [bookmark: pgfId-77351] 

 
      
       
        
        [bookmark: pgfId-71095]Table 55-69 [bookmark: 128827]Add/Edit Policy List Object Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-71101]Element
          
  
         		
           
           [bookmark: pgfId-71103]Description
          
  
        

 
         
         		[bookmark: pgfId-71109]Name

  
         		[bookmark: pgfId-71114]The name of the object. Object names are not case-sensitive. For more information, see Creating Policy Objects.

 
           
           [image: ] 
          
 
          
 
          
           [bookmark: pgfId-71116]Caution Security Manager allows you to rename these objects even though you cannot rename them on the device. When you rename these objects in Security Manager, the name change is accomplished by negating the existing CLI, and then issuing new CLI to create and assign the object using the new name. This initial negation may cause routing/network issues in your environment. Security Manager will not provide a warning message about these consequences when you rename the object.
            
            
 
           

          
  
        

 
         
         		[bookmark: pgfId-71122]Description

  
         		[bookmark: pgfId-71124]An optional description of the object.

  
        

 
         
         		 
           
           [bookmark: pgfId-71130]Basic Tab
          
  
        

 
         
         		[bookmark: pgfId-71138]Action

  
         		[bookmark: pgfId-71140]Whether to permit access for matching conditions or not.

 [bookmark: pgfId-71142]Note The Action for a policy list object cannot be changed after the initial creation of the policy list object.

  
        

 
         
         		[bookmark: pgfId-71148]Match Interface

  
         		[bookmark: pgfId-71150]Select to distribute routes that have their next hop out of one of the interfaces specified. Enter or select the interfaces to match. Separate multiple entries with a comma. If you specify more than one interface, then the route can match either interface.

 [bookmark: pgfId-71155]Use the ellipsis to open the Interfaces Selector from which you can select one or more interfaces. You can also create new interface roles from the Interfaces Selector. For more information, see Understanding Interface Role Objects.

  
        

 
         
         		[bookmark: pgfId-71161]Match Address

  
         		[bookmark: pgfId-71163]Select to redistribute any routes that have a destination address that is permitted by a standard access list or prefix list. Choose whether to use an Access List or Prefix List for matching from the drop-down list and then enter or select the ACL objects or Prefix list objects you want to use for matching.

 [bookmark: pgfId-71171]Use the ellipsis to open the Access Control List Object Selector or Prefix List Object Selector from which you can select one or more objects. You can also create new objects from the object selector. For more information, see Add or Edit Access List Dialog Boxes or Add or Edit Prefix List Object Dialog Box.

  
        

 
         
         		[bookmark: pgfId-71177]Match Next-Hop

  
         		[bookmark: pgfId-71179]Select to redistribute any routes that have a next hop router address passed by one of the access lists or prefix lists specified. Choose whether to use an Access List or Prefix List for matching from the drop-down list and then enter or select the ACL objects or Prefix list objects you want to use for matching.

 [bookmark: pgfId-71187]Use the ellipsis to open the Access Control List Object Selector or Prefix List Object Selector from which you can select one or more objects. You can also create new objects from the object selector. For more information, see Add or Edit Access List Dialog Boxes or Add or Edit Prefix List Object Dialog Box.

  
        

 
         
         		[bookmark: pgfId-71193]Match Route Source

  
         		[bookmark: pgfId-71195]Select to redistribute routes that have been advertised by routers and access servers at the address specified by the access lists or prefix list. Choose whether to use an Access List or Prefix List for matching from the drop-down list and then enter or select the ACL objects or Prefix list objects you want to use for matching.

 [bookmark: pgfId-71203]Use the ellipsis to open the Access Control List Object Selector or Prefix List Object Selector from which you can select one or more objects. You can also create new objects from the object selector. For more information, see Add or Edit Access List Dialog Boxes or Add or Edit Prefix List Object Dialog Box.

  
        

 
         
         		 
           
           [bookmark: pgfId-71209]Advanced Tab
          
  
        

 
         
         		[bookmark: pgfId-71217]Match AS Path

  
         		[bookmark: pgfId-71219]Select to match a BGP autonomous system path. If you specify more than one AS path, then the route can match either AS path.

 [bookmark: pgfId-71224]Use the ellipsis to open the AS Path Object Selector from which you can select one or more AS path objects. You can also create new AS path objects from the AS Path Object Selector. For more information, see Add or Edit As Path Object Dialog Boxes.

  
        

 
         
         		[bookmark: pgfId-71230]Match Community Rules

  
         		[bookmark: pgfId-71232]Select to enable matching the BGP community with the specified community. If you specify more than one community, then the route can match either community.

 [bookmark: pgfId-71237]Use the ellipsis to open the Community List Object Selector from which you can select one or more Community List objects. You can also create new Community List objects from the Community List Object Selector. For more information, see Add or Edit Community List Object Dialog Box.

 [bookmark: pgfId-71239]To enable matching the BGP community exactly with the specified community, check the exact-match check box.

  
        

 
         
         		[bookmark: pgfId-71245]Match Metric

  
         		[bookmark: pgfId-71247]Enable or disable matching the metric of a route. Type the metric values to use for matching in the Match Metric field. You can enter multiple values separated by commas. This setting allows you to match any routes that have a specified metric. The metric values can range from 0 to 4294967295.

  
        

 
         
         		[bookmark: pgfId-71253]Match Tag

  
         		[bookmark: pgfId-71255]Enable or disable matching the security group tag of a route. Type the tag values to use for matching in the Match Tag field. You can enter multiple values separated by commas. This setting allows you to match any routes that have a specified security group tag. The tag values can range from 0 to 4294967295.

  
        

 
         
         		[bookmark: pgfId-71261]Category

  
         		[bookmark: pgfId-71266]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-71272]Allow Value Override per Device

 [bookmark: pgfId-71274]Overrides

 [bookmark: pgfId-71276]Edit button

  
         		[bookmark: pgfId-71284]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-71286]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-77371][bookmark: 128941][bookmark: pobjpage_cncpt_AddEditPrefixListObjectDialogBox]Add or Edit Prefix List Object Dialog Box[bookmark: marker-77361][bookmark: marker-77363][bookmark: marker-77365][bookmark: marker-77367][bookmark: marker-77369]

 
     [bookmark: pgfId-77385]Use the Add/Edit Prefix List Object dialog box to create, copy and edit prefix list policy objects. You can create prefix list objects to use when you are configuring route maps (see Understanding Route Map Objects), policy maps (see Add or Edit Policy List Object Dialog Box), OSPF Filtering (see Add/Edit Filtering Dialog Box), or BGP Neighbor Filtering (see Add/Edit Neighbor Dialog Box).

 
     [bookmark: pgfId-77387]Area Border Router (ABR) type 3 link-state advertisement (LSA) filtering extends the capability of an ABR that is running OSPF to filter type 3 LSAs between different OSPF areas. Once a prefix list is configured, only the specified prefixes are sent from one OSPF area to another OSPF area. All other prefixes are restricted to their OSPF area. You can apply this type of area filtering to traffic going into or coming out of an OSPF area, or to both the incoming and outgoing traffic for that area.

 
     [bookmark: pgfId-77389]When multiple entries of a prefix list match a given prefix, the entry with the lowest sequence number is used. For efficiency, you may want to put the most common matches or denials near the top of the list by manually assigning them a lower sequence number.

 
     [bookmark: pgfId-77391]Navigation Path

 
     [bookmark: pgfId-77393]Select Manage > Policy Objects, then select Prefix List from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-77395]Related Topics

 
      
      		 [bookmark: pgfId-77400]Add or Edit Prefix List Entry Dialog Box

 
      		 [bookmark: pgfId-77405]Understanding Route Map Objects

 
      		 [bookmark: pgfId-77410]Add or Edit Policy List Object Dialog Box

 
      		 [bookmark: pgfId-77415]Policy Object Manager

 
      		 [bookmark: pgfId-77420]Selecting Objects for Policies

 
      		 [bookmark: pgfId-77425]Creating Policy Objects

 
      		 [bookmark: pgfId-77430]Editing Objects

 
      		 [bookmark: pgfId-77435]Using Category Objects

 
      		 [bookmark: pgfId-77440]Managing Object Overrides

 
      		 [bookmark: pgfId-77445]Allowing a Policy Object to Be Overridden

 
     

 
     [bookmark: pgfId-77447]Field Reference

 
     [bookmark: pgfId-77450] 

 
      
       
        
        [bookmark: pgfId-71299]Table 55-70 [bookmark: 129010]Add/Edit Prefix List Object Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-71305]Element
          
  
         		
           
           [bookmark: pgfId-71307]Description
          
  
        

 
         
         		[bookmark: pgfId-71313]Name

  
         		[bookmark: pgfId-71318]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

 
           
           [image: ] 
          
 
          
 
          
           [bookmark: pgfId-71320]Caution Security Manager allows you to rename these objects even though you cannot rename them on the device. When you rename these objects in Security Manager, the name change is accomplished by negating the existing CLI, and then issuing new CLI to create and assign the object using the new name. This initial negation may cause routing/network issues in your environment. Security Manager will not provide a warning message about these consequences when you rename the object.
            
            
 
           

          
  
        

 
         
         		[bookmark: pgfId-71326]Description

  
         		[bookmark: pgfId-71328]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-71334]Prefix List table

  
         		[bookmark: pgfId-71336]The prefix list entries that are defined in the object.

 
           
           		 [bookmark: pgfId-71341]To add a prefix list entry, click the  Add button to open the Add or Edit Prefix List Entry Dialog Box.

 
           		 [bookmark: pgfId-71343]To edit a prefix list entry, select it and click the  Edit button.

 
           		 [bookmark: pgfId-71345]To delete a prefix list entry, select it and click the  Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-71351]Category

  
         		[bookmark: pgfId-71356]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-71362]Allow Value Override per Device

 [bookmark: pgfId-71364]Overrides

 [bookmark: pgfId-71366]Edit button

  
         		[bookmark: pgfId-71374]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-71376]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-77462][bookmark: 129066][bookmark: pobjpage_cncpt_AddEditPrefixListEntryDialogBox]Add or Edit Prefix List Entry Dialog Box[bookmark: marker-77458][bookmark: marker-77460]

 
     [bookmark: pgfId-77464]Use the Add/Edit Prefix List Entry dialog box to create a new prefix list entry or edit an existing one.

 
     [bookmark: pgfId-77466]Navigation Path

 
     [bookmark: pgfId-77471]From the Add or Edit Prefix List Object Dialog Box, click the Add button beneath the Prefix List table or select an entry in the table and click the Edit button.

 
     [bookmark: pgfId-77473]Field Reference

 
     [bookmark: pgfId-77476] 

 
      
       
        
        [bookmark: pgfId-71389]Table 55-71 [bookmark: 129083]Add/Edit Prefix List Entry Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-71395]Element
          
  
         		
           
           [bookmark: pgfId-71397]Description
          
  
        

 
         
         		[bookmark: pgfId-71403]Action

  
         		[bookmark: pgfId-71405]Select the Permit or Deny radio button to indicate the redistribution access.

  
        

 
         
         		[bookmark: pgfId-71411]Sequence No

  
         		[bookmark: pgfId-71413](Optional) Unique number that indicates the position a new prefix list entry will have in the list of prefix list entries already configured for this object. If left blank, the sequence number will default to five more than the largest sequence number currently in use.

  
        

 
         
         		[bookmark: pgfId-71419]IP Address

  
         		[bookmark: pgfId-71421]Specify the prefix number in the format of IP address/mask length.

  
        

 
         
         		[bookmark: pgfId-71427]Minimum Prefix Length

  
         		[bookmark: pgfId-71429](Optional) Enter the minimum prefix length.

 [bookmark: pgfId-71431]The value must be greater than the mask length and less than or equal to the Maximum Prefix Length, if specified.

  
        

 
         
         		[bookmark: pgfId-71437]Maximum Prefix Length

  
         		[bookmark: pgfId-71439](Optional) Enter the maximum prefix length.

 [bookmark: pgfId-71441]The value must be greater than or equal to the Minimum Prefix Length, if present, or greater than the mask length if the Minimum Prefix Length is not specified.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-77496][bookmark: 129122][bookmark: pobjpage_cncpt_AddEditPrefixListIPv6ObjectDialogBox]Add or Edit Prefix List IPv6 Object Dialog Box[bookmark: marker-77486][bookmark: marker-77488][bookmark: marker-77490][bookmark: marker-77492][bookmark: marker-77494]

 
     [bookmark: pgfId-77510]Use the Add/Edit Prefix List IPv6 Object dialog box to create, copy and edit IPv6 prefix list policy objects. You can create IPv6 prefix list objects to use when you are configuring route maps (see Understanding Route Map Objects), policy maps (see Add or Edit Policy List Object Dialog Box), OSPF Filtering (see Add/Edit Filtering Dialog Box), or BGP Neighbor Filtering (see Add/Edit Neighbor Dialog Box).

 
     [bookmark: pgfId-77512]Area Border Router (ABR) type 3 link-state advertisement (LSA) filtering extends the capability of an ABR that is running OSPF to filter type 3 LSAs between different OSPF areas. Once a prefix list is configured, only the specified prefixes are sent from one OSPF area to another OSPF area. All other prefixes are restricted to their OSPF area. You can apply this type of area filtering to traffic going into or coming out of an OSPF area, or to both the incoming and outgoing traffic for that area.

 
     [bookmark: pgfId-77514]When multiple entries of a prefix list match a given prefix, the entry with the lowest sequence number is used. For efficiency, you may want to put the most common matches or denials near the top of the list by manually assigning them a lower sequence number.

 
     [bookmark: pgfId-77516]Navigation Path

 
     [bookmark: pgfId-77518]Select Manage > Policy Objects, then select Prefix ListIPv6 from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-77520]Related Topics

 
      
      		 [bookmark: pgfId-77525]Add or Edit IPv6 Prefix List Entry Dialog Box

 
      		 [bookmark: pgfId-77530]Understanding Route Map Objects

 
      		 [bookmark: pgfId-77535]Add or Edit Policy List Object Dialog Box

 
      		 [bookmark: pgfId-77540]Policy Object Manager

 
      		 [bookmark: pgfId-77545]Selecting Objects for Policies

 
      		 [bookmark: pgfId-77550]Creating Policy Objects

 
      		 [bookmark: pgfId-77555]Editing Objects

 
      		 [bookmark: pgfId-77560]Using Category Objects

 
      		 [bookmark: pgfId-77565]Managing Object Overrides

 
      		 [bookmark: pgfId-77570]Allowing a Policy Object to Be Overridden

 
     

 
     [bookmark: pgfId-77572]Field Reference

 
     [bookmark: pgfId-77575] 

 
      
       
        
        [bookmark: pgfId-71454]Table 55-72 [bookmark: 129192]Add/Edit IPv6 Prefix List Object Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-71460]Element
          
  
         		
           
           [bookmark: pgfId-71462]Description
          
  
        

 
         
         		[bookmark: pgfId-71468]Name

  
         		[bookmark: pgfId-71473]The IPv6 Prefix List object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

 
           
           [image: ] 
          
 
          
 
          
           [bookmark: pgfId-71475]Caution Security Manager allows you to rename these objects even though you cannot rename them on the device. When you rename these objects in Security Manager, the name change is accomplished by negating the existing CLI, and then issuing new CLI to create and assign the object using the new name. This initial negation may cause routing/network issues in your environment. Security Manager will not provide a warning message about these consequences when you rename the object.
            
            
 
           

          
  
        

 
         
         		[bookmark: pgfId-71481]Description

  
         		[bookmark: pgfId-71483]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-71489]IPv6 Prefix List table

  
         		[bookmark: pgfId-71491]The IPv6 prefix list entries that are defined in the object.

 
           
           		 [bookmark: pgfId-71496]To add an IPv6 prefix list entry, click the  Add button to open the Add or Edit IPv6 Prefix List Entry Dialog Box.

 
           		 [bookmark: pgfId-71498]To edit an IPv6 prefix list entry, select it and click the  Edit button.

 
           		 [bookmark: pgfId-71500]To delete an IPv6 prefix list entry, select it and click the  Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-71506]Category

  
         		[bookmark: pgfId-71511]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-71517]Allow Value Override per Device

 [bookmark: pgfId-71519]Overrides

 [bookmark: pgfId-71521]Edit button

  
         		[bookmark: pgfId-71529]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-71531]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-77587][bookmark: 129248][bookmark: pobjpage_cncpt_AddEditPrefixListIPv6EntryDialogBox]Add or Edit IPv6 Prefix List Entry Dialog Box[bookmark: marker-77583][bookmark: marker-77585]

 
     [bookmark: pgfId-77589]Use the Add/Edit IPv6 Prefix List Entry dialog box to create a new IPv6 prefix list entry or edit an existing one.

 
     [bookmark: pgfId-77591]Navigation Path

 
     [bookmark: pgfId-77596]From the Add or Edit Prefix List IPv6 Object Dialog Box, click the Add button beneath the Prefix List table or select an entry in the table and click the Edit button.

 
     [bookmark: pgfId-77598]Field Reference

 
     [bookmark: pgfId-77601] 

 
      
       
        
        [bookmark: pgfId-71544]Table 55-73 [bookmark: 129265]Add/Edit Prefix List Entry Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-71550]Element
          
  
         		
           
           [bookmark: pgfId-71552]Description
          
  
        

 
         
         		[bookmark: pgfId-71558]Action

  
         		[bookmark: pgfId-71560]Select the Permit or Deny radio button to indicate the redistribution access.

  
        

 
         
         		[bookmark: pgfId-71566]Sequence No

  
         		[bookmark: pgfId-71568](Optional) Unique number that indicates the position a new IPv6 prefix list entry will have in the list of IPv6 prefix list entries already configured for this object. If left blank, the sequence number will default to five more than the largest sequence number currently in use.

 [bookmark: pgfId-71570]Note Sequence Number must be in the range of 1 to 4294967295

  
        

 
         
         		[bookmark: pgfId-71576]IPv6 Address

  
         		[bookmark: pgfId-71578]Specify the prefix number in the format: IPv6 address/mask length where mask length is less than or equal to 128.

  
        

 
         
         		[bookmark: pgfId-71584]Minimum Prefix Length

  
         		[bookmark: pgfId-71586](Optional) Enter the minimum prefix length in the range of 1 to 128.

 [bookmark: pgfId-71588]The value must be greater than the mask length and less than or equal to the Maximum Prefix Length, if specified.

  
        

 
         
         		[bookmark: pgfId-71594]Maximum Prefix Length

  
         		[bookmark: pgfId-71596](Optional) Enter the maximum prefix length in the range of 1 to 128.

 [bookmark: pgfId-71598]The value must be greater than or equal to the Minimum Prefix Length, if present, or greater than the mask length if the Minimum Prefix Length is not specified.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-77623][bookmark: 129305][bookmark: pobjpage_cncpt_AddEditAsPathObjectDialogBox]Add or Edit As Path Object Dialog Boxes[bookmark: marker-77611][bookmark: marker-77613][bookmark: marker-77615][bookmark: marker-77617][bookmark: marker-77619][bookmark: marker-77621]

 
     [bookmark: pgfId-77634]Use the Add/Edit As Path Object dialog box to create, copy and edit autonomous system (AS) path policy objects. You can create AS path objects to use when you are configuring route maps (see Understanding Route Map Objects), policy maps (see Add or Edit Policy List Object Dialog Box), or BGP Neighbor Filtering (see Add/Edit Neighbor Dialog Box).

 
     [bookmark: pgfId-77636]An AS path filter allows you to filter the routing update message by using access lists and look at the individual prefixes within an update message. If a prefix within the update message matches the filter criteria then that individual prefix is filtered out or accepted depending on what action the filter entry has been configured to carry out.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-77638]Note AS path object names must be a unique integer from 1-500. If an AS path object is discovered from a device or configuration file that uses the same name as an existing AS path object, the AS path object on Security Manager will be overwritten regardless of the Allow Device Override for Discovered Policy Objects setting on the Security Manager Administration - Discovery page.


     
      

     

     

 
     [bookmark: pgfId-77640]Navigation Path

 
     [bookmark: pgfId-77642]Select Manage > Policy Objects, then select As Path from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-77644]Related Topics

 
      
      		 [bookmark: pgfId-77649]Add or Edit As Path Entry Dialog Box

 
      		 [bookmark: pgfId-77654]Understanding Route Map Objects

 
      		 [bookmark: pgfId-77659]Add or Edit Policy List Object Dialog Box

 
      		 [bookmark: pgfId-77664]Policy Object Manager

 
      		 [bookmark: pgfId-77669]Selecting Objects for Policies

 
      		 [bookmark: pgfId-77674]Creating Policy Objects

 
      		 [bookmark: pgfId-77679]Editing Objects

 
      		 [bookmark: pgfId-77684]Using Category Objects

 
      		 [bookmark: pgfId-77689]Managing Object Overrides

 
      		 [bookmark: pgfId-77694]Allowing a Policy Object to Be Overridden

 
     

 
     [bookmark: pgfId-77696]Field Reference

 
     [bookmark: pgfId-77699] 

 
      
       
        
        [bookmark: pgfId-71611]Table 55-74 [bookmark: 129376]Add/Edit As Path Object Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-71617]Element
          
  
         		
           
           [bookmark: pgfId-71619]Description
          
  
        

 
         
         		[bookmark: pgfId-71625]Name

  
         		[bookmark: pgfId-71627]Enter a name for the AS Path Filter. Specify a unique value between 1 and 500.

  
        

 
         
         		[bookmark: pgfId-71633]Description

  
         		[bookmark: pgfId-71635]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-71641]AS Path table

  
         		[bookmark: pgfId-71643]The AS path entries that are defined in the object.

 
           
           		 [bookmark: pgfId-71648]To add an AS path entry, click the  Add button to open the Add or Edit As Path Entry Dialog Box.

 
           		 [bookmark: pgfId-71650]To edit an AS path entry, select it and click the  Edit button.

 
           		 [bookmark: pgfId-71652]To delete an AS path entry, select it and click the  Delete button.

 
           		 [bookmark: pgfId-71654]To rearrange the entries, select an entry and then click the  Move Up or  Move Down button.

 
          

  
        

 
         
         		[bookmark: pgfId-71660]Category

  
         		[bookmark: pgfId-71665]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-71671]Allow Value Override per Device

 [bookmark: pgfId-71673]Overrides

 [bookmark: pgfId-71675]Edit button

  
         		[bookmark: pgfId-71683]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-71685]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-77711][bookmark: 129434][bookmark: pobjpage_cncpt_AddEditAsPathEntryDialogBox]Add or Edit As Path Entry Dialog Box[bookmark: marker-77707][bookmark: marker-77709]

 
     [bookmark: pgfId-77713]Use the Add/Edit As Path Entry dialog box to create a new autonomous system (AS) path entry or edit an existing one.

 
     [bookmark: pgfId-77715]Navigation Path

 
     [bookmark: pgfId-77720]From the Add or Edit As Path Object Dialog Boxes, click the Add Row button beneath the As Path table or select an entry and click the Edit Row button.

 
     [bookmark: pgfId-77722]Field Reference

 
     [bookmark: pgfId-77725] 

 
      
       
        
        [bookmark: pgfId-71698]Table 55-75 [bookmark: 129451]Add/Edit As Path Entry Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-71704]Element
          
  
         		
           
           [bookmark: pgfId-71706]Description
          
  
        

 
         
         		[bookmark: pgfId-71712]Action

  
         		[bookmark: pgfId-71714]Select the Permit or Deny radio button to indicate the redistribution access.

  
        

 
         
         		[bookmark: pgfId-71720]Reg Exp

  
         		[bookmark: pgfId-71725]Specify the regular expression that defines the AS path filter. For information on the metacharacters you can use to build regular expressions, see Metacharacters Used to Build Regular Expressions.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-77745][bookmark: 129476][bookmark: pobjpage_cncpt_AddEditCommunityListObjectDialogBox]Add or Edit Community List Object Dialog Box[bookmark: marker-77735][bookmark: marker-77737][bookmark: marker-77739][bookmark: marker-77741][bookmark: marker-77743]

 
     [bookmark: pgfId-77753]Use the Add/Edit Community List Object dialog box to create, copy and edit community list policy objects. You can create community list objects to use when you are configuring route maps (see Understanding Route Map Objects) or policy maps (see Add or Edit Policy List Object Dialog Box).

 
     [bookmark: pgfId-77755]A community is a group of destinations that share some common attribute. You can use community lists to create groups of communities to use in a match clause of a route map. Just like an access list, a series of community lists can be created. Statements are checked until a match is found. As soon as one statement is satisfied, the test is concluded.

 
     [bookmark: pgfId-77757]Navigation Path

 
     [bookmark: pgfId-77759]Select Manage > Policy Objects, then select Community List from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-77761]Related Topics

 
      
      		 [bookmark: pgfId-77766]Add or Edit Community List Entry Dialog Box

 
      		 [bookmark: pgfId-77771]Understanding Route Map Objects

 
      		 [bookmark: pgfId-77776]Add or Edit Policy List Object Dialog Box

 
      		 [bookmark: pgfId-77781]Policy Object Manager

 
      		 [bookmark: pgfId-77786]Selecting Objects for Policies

 
      		 [bookmark: pgfId-77791]Creating Policy Objects

 
      		 [bookmark: pgfId-77796]Editing Objects

 
      		 [bookmark: pgfId-77801]Using Category Objects

 
      		 [bookmark: pgfId-77806]Managing Object Overrides

 
      		 [bookmark: pgfId-77811]Allowing a Policy Object to Be Overridden

 
     

 
     [bookmark: pgfId-77813]Field Reference

 
     [bookmark: pgfId-77816] 

 
      
       
        
        [bookmark: pgfId-71738]Table 55-76 [bookmark: 129542]Add/Edit Community List Object Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-71744]Element
          
  
         		
           
           [bookmark: pgfId-71746]Description
          
  
        

 
         
         		[bookmark: pgfId-71752]Name

  
         		[bookmark: pgfId-71757]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
        

 
         
         		[bookmark: pgfId-71763]Description

  
         		[bookmark: pgfId-71765]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-71771]Community List table

  
         		[bookmark: pgfId-71773]The community list entries that are defined in the object.

 
           
           		 [bookmark: pgfId-71778]To add a community list entry, click the  Add button to open the Add or Edit Community List Entry Dialog Box.

 
           		 [bookmark: pgfId-71780]To edit a community list entry, select it and click the  Edit button.

 
           		 [bookmark: pgfId-71782]To delete a community list entry, select it and click the  Delete button.

 
           		 [bookmark: pgfId-71784]To rearrange the entries, select an entry and then click the  Move Up or  Move Down button.

 
          

  
        

 
         
         		[bookmark: pgfId-71790]Category

  
         		[bookmark: pgfId-71795]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-71801]Allow Value Override per Device

 [bookmark: pgfId-71803]Overrides

 [bookmark: pgfId-71805]Edit button

  
         		[bookmark: pgfId-71813]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-71815]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-77828][bookmark: 129601][bookmark: pobjpage_cncpt_AddEditCommunityListEntryDialogBox]Add or Edit Community List Entry Dialog Box[bookmark: marker-77824][bookmark: marker-77826]

 
     [bookmark: pgfId-77830]Use the Add/Edit Community List Entry dialog box to create a new community list entry or edit an existing one.

 
     [bookmark: pgfId-77832]Navigation Path

 
     [bookmark: pgfId-77837]From the Add or Edit Community List Object Dialog Box, click the Add button beneath the Community List table or select an entry in the table and click the Edit button.

 
     [bookmark: pgfId-77839]Field Reference

 
     [bookmark: pgfId-77842] 

 
      
       
        
        [bookmark: pgfId-71828]Table 55-77 [bookmark: 129618]Add/Edit Community List Entry Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-71834]Element
          
  
         		
           
           [bookmark: pgfId-71836]Description
          
  
        

 
         
         		[bookmark: pgfId-71842]Type

  
         		[bookmark: pgfId-71844]Select the Standard or Expanded radio button to indicate the community rule type.

 [bookmark: pgfId-71846]Note You cannot have entries using Standard and entries using Expanded community rule types in the same Community List object.

  
        

 
         
         		[bookmark: pgfId-71852]Action

  
         		[bookmark: pgfId-71854]Select the Permit or Deny radio button to indicate the redistribution access.

  
        

 
         
         		[bookmark: pgfId-71860]Communities

  
         		[bookmark: pgfId-71862]Specify a community number. Valid values can be from 1 to 4294967295 or from 0:1 to 65534:65535.

  
        

 
         
         		[bookmark: pgfId-71868]internet

  
         		[bookmark: pgfId-71870]Select to specify the Internet well-known community. Routes with this community are advertised to all peers (internal and external).

  
        

 
         
         		[bookmark: pgfId-71876]no-advertise

  
         		[bookmark: pgfId-71878]Select to specify the no-advertise well-known community. Routes with this community are not advertised to any peer (internal or external).

  
        

 
         
         		[bookmark: pgfId-71884]no-export

  
         		[bookmark: pgfId-71886]Select to specify the no-export well-known community. Routes with this community are advertised to only peers in the same autonomous system or to only other sub-autonomous systems within a confederation. These routes are not advertised to external peers.

  
        

 
         
         		[bookmark: pgfId-71892]Expressions

  
         		[bookmark: pgfId-71897]For an expanded community list, specify the regular expression. For information on the metacharacters you can use to build regular expressions, see Metacharacters Used to Build Regular Expressions.
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     [bookmark: pgfId-418975][bookmark: 73655][bookmark: vpchap_intro_GroupEncryptedTransportGETVPNs]Group Encrypted Transport (GET) VPNs[bookmark: marker-418973]
      
      
 
     
 

 
    [bookmark: pgfId-418977]Cisco Group Encrypted Transport virtual private network (GET VPN) is a full-mesh VPN technology that can be used in a variety of WAN environments, including IP and Multiprotocol Label Switching (MPLS). GET VPN comprises a set of features that are necessary to secure IP multicast group traffic or unicast traffic over a private WAN that originates on or flows through a Cisco IOS device. GET VPN combines the keying protocol Group Domain of Interpretation (GDOI) with IP security (IPsec) encryption to provide users with an efficient method to secure IP multicast or unicast traffic. GET VPN enables the router to apply encryption to nontunneled (that is, “native”) IP multicast and unicast packets and eliminates the requirement to configure tunnels to protect multicast and unicast traffic.

 
    [bookmark: pgfId-418979]Cisco Group Encrypted Transport VPN provides the following benefits:

 
     
     		 [bookmark: pgfId-418981]Provides data security and transport authentication, helping to meet security compliance and internal regulation by encrypting all WAN traffic.

 
     		 [bookmark: pgfId-418983]Enables high-scale network meshes and eliminates complex peer-to-peer key management with group encryption keys.

 
     		 [bookmark: pgfId-418985]For Multiprotocol Label Switching (MPLS) networks, maintains network intelligence such as full-mesh connectivity, natural routing path, and Quality of Service (QoS).

 
     		 [bookmark: pgfId-418987]Grants easy membership control with a centralized key server.

 
     		 [bookmark: pgfId-418989]Helps ensure low latency and jitter by enabling full-time, direct communications between sites, without requiring transport through a central hub.

 
     		 [bookmark: pgfId-418991]Reduces traffic loads on customer premises equipment (CPE) and provider-edge (PE) encryption devices by using the core network for replication of multicast traffic, avoiding packet replication at each individual peer site.
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    [bookmark: pgfId-418995]Tip For information about the CLI configuration of GET VPN, see Cisco Group Encrypted Transport VPN on Cisco.com.


    
     

    

    

 
    [bookmark: pgfId-418997]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-419002]Understanding Group Encrypted Transport (GET) VPNs

 
     		 [bookmark: pgfId-419007]Understanding the GET VPN Registration Process

 
     		 [bookmark: pgfId-419012]Understanding the GET VPN Security Policy and Security Associations

 
     		 [bookmark: pgfId-419017]Configuring GET VPN

 
     		 [bookmark: pgfId-419022]Generating and Synchronizing RSA Keys

 
     		 [bookmark: pgfId-419027]Configuring the IKE Proposal for GET VPN

 
     		 [bookmark: pgfId-419032]Configuring Global Settings for GET VPN

 
     		 [bookmark: pgfId-419037]Configuring GET VPN Key Servers

 
     		 [bookmark: pgfId-419042]Configuring GET VPN Group Members

 
     		 [bookmark: pgfId-419047]Using Passive Mode to Migrate to GET VPN

 
     		 [bookmark: pgfId-419052]Troubleshooting GET VPN Configurations

 
    

 
   
 
    
     [bookmark: pgfId-419064][bookmark: 73678][bookmark: vpchap_cncpt_UnderstandingGETVPN]Understanding Group Encrypted Transport (GET) VPNs[bookmark: marker-419058][bookmark: marker-419060][bookmark: marker-419062]

 
    [bookmark: pgfId-419066]Networked applications such as voice and video increase the need for instantaneous, branch-interconnected, and QoS-enabled WANs. The distributed nature of these applications results in increased demands for scale. At the same time, enterprise WAN technologies force businesses to trade off between QoS-enabled branch interconnectivity and transport security. As network security risks increase and regulatory compliance becomes essential, Group Encrypted Transport VPN (GET VPN), a WAN encryption technology, eliminates the need to compromise between network intelligence and data privacy.

 
    [bookmark: pgfId-419068]With GET, Cisco provides tunnelless VPN, which eliminates the need for IPsec tunnels. By removing the need for point-to-point tunnels, meshed networks can scale higher while maintaining network-intelligence features critical to voice and video quality. GET is a standards-based security model that is based on the concept of a trusted group to eliminate point-to-point IPsec tunnels and their associated overlay routing. Trusted group members share a common security association (SA), also known as a group SA. This enables group members to decrypt traffic that was encrypted by any other group member. By using trusted groups instead of point-to-point tunnels, full-mesh networks can scale higher while maintaining network-intelligence features (such as QoS, routing, and multicast), which are critical to voice and video quality.

 
    [bookmark: pgfId-419070]GET-based networks can be used in a variety of WAN environments, including IP and Multiprotocol Label Switching (MPLS). MPLS VPNs that use this encryption technology are highly scalable, manageable, and cost-effective, and they meet government-mandated encryption requirements. The flexible nature of GET allows security-conscious enterprises either to manage their own network security over a service provider WAN service or to offload encryption services to their providers. GET simplifies securing large Layer 2 or MPLS networks that require partial or full-mesh connectivity.

 
    [bookmark: pgfId-419072]In addition to leveraging the existing IKE, IPsec and multicast technologies, a GET VPN topology includes these key elements and features:

 
     
     		 [bookmark: pgfId-419074]Group members—The routers that exchange the actual traffic within the VPN are called group members. Group members provide encryption services to the traffic. Encryption policies are defined centrally on the key server and downloaded to the group member at the time of registration. Based on these downloaded policies, a group member decides whether traffic needs to be encrypted or decrypted and what keys to use.

 
    

 
    [bookmark: pgfId-419079]Although group members primarily obtain encryption policies from the key server, you can configure local service policy ACLs on the group members to exclude traffic from encryption based on local requirements. For more information, see Understanding the GET VPN Security Policy and Security Associations.
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    [bookmark: pgfId-419081]Note A device can be a group member of more than one group.


    
     

    

    

 
     
     		 [bookmark: pgfId-419086]Key servers—The routers that act as key servers are the gatekeepers to the topology. The group member must successfully register with a key server before becoming an active member of the VPN. The key servers control the shared service policy, and generate and transmit keys to group members. Key servers cannot be group members themselves, but a single key server can service more than one topology. For more information, see Understanding the GET VPN Registration Process.

 
     		 [bookmark: pgfId-419090]The Group Domain of Interpretation (GDOI) group key management protocol is used to provide a set of cryptographic keys and policies to a group of devices. In a GET VPN network, GDOI is used to distribute common IPsec keys to a group of enterprise VPN gateways (group members) that must communicate securely. Devices designated as key servers periodically refresh and send out the updated keys to the group members using a process called “rekeying.”[bookmark: marker-419088]

 
    

 
    [bookmark: pgfId-419092]The GDOI protocol uses the Phase 1 Internet Key Exchange (IKE) SA. All participating VPN gateways authenticate themselves to the device providing keys using IKE. All IKE authentication methods, for example, pre-shared keys (PSKs) and public key infrastructure (PKI), are supported for initial authentication. After the VPN gateways are authenticated and provided with the appropriate security keys using the IKE SA, the IKE SA expires and GDOI is used to update the group members in a more scalable and efficient manner. For more information about GDOI, refer to RFC 3547.

 
     
     		 [bookmark: pgfId-419094]Address preservation—IPsec-protected data packets carry the original source and destination in the outer IP header rather than replacing them with tunnel endpoint addresses. Address preservation allows GET VPN to use the routing functionality present within the core network. Address preservation allows routing to deliver the packets to any customer-edge (CE) device in the network that advertises a route to the destination address. Any source and destination matching the policy for the group will be treated in a similar manner. In the situation where a link between IPsec peers is not available, address preservation also helps combat traffic “black-hole” situations.

 
    

 
    [bookmark: pgfId-419096]Header preservation also maintains routing continuity throughout the enterprise address space and in the WAN. As a result, end host addresses of the campus are exposed in the WAN (for MPLS, this applies to the edge of the WAN). For this reason, GET VPN is applicable only when the WAN network acts as a “private” network (for example, in an MPLS network).

 
    [bookmark: pgfId-419098]The following figure shows the general operation of a GET VPN topology.

 
    [bookmark: pgfId-419102]Figure 29-1 [bookmark: 73711]General GET VPN Operation

 
    [bookmark: pgfId-419105] 
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    [bookmark: pgfId-419107] 1. Group members register with the key server using the Group Domain of Interpretation (GDOI) protocol. The key server authenticates and authorizes the group members and downloads the IPsec policy and keys that are necessary for them to encrypt and decrypt IP multicast and unicast packets. The registration process can use unicast or multicast communications.

 
    [bookmark: pgfId-419109] 2. Group members exchange IP packets that are encrypted using IPsec. Only the group members are an active part of the VPN.

 
    [bookmark: pgfId-419111] 3. As needed, the key server pushes a rekey message to the group members. The rekey message contains new IPsec policy and keys to use when old IPsec security associations (SAs) expire. Rekey messages are sent in advance of the SA expiration time to ensure that valid group keys are always available.

 
    [bookmark: pgfId-419113]GET VPN is provisioned using Security Manager with the following caveats:

 
     
     		 [bookmark: pgfId-419115]GET VPN-aware VRF is not supported.

 
     		 [bookmark: pgfId-419117]DMVPN with GET is not supported, because there is no way to define DMVPN without tunnel protection in Security Manager.

 
     		 [bookmark: pgfId-419119]Manual configuration of a group member to join a multicast group (ip igmp join-group) is not supported. Security Manager only provisions static source-specific multicast (SSM) mappings.

 
    

 
    [bookmark: pgfId-419121]Related Topics

 
     
     		 [bookmark: pgfId-419126]Understanding the GET VPN Registration Process

 
     		 [bookmark: pgfId-419131]Understanding the GET VPN Security Policy and Security Associations

 
     		 [bookmark: pgfId-419136]Configuring GET VPN

 
    

 
   
 
    
     [bookmark: pgfId-419152][bookmark: 73742][bookmark: vpchap_cncpt_UnderstandingtheGETVPNRegistrationProcess]Understanding the GET VPN Registration Process[bookmark: marker-419142][bookmark: marker-419144][bookmark: marker-419146][bookmark: marker-419148][bookmark: marker-419150]

 
    [bookmark: pgfId-419154]In GET VPN, group members comprise the VPN topology. Traffic in the VPN is traffic between group members. For a device to become a group member, the device must successfully register with a key server. Key servers maintain the security association (SA) policy and create and maintain the keys for the group. When a group member registers, the key server downloads the policy and the keys to the group member. The key server also rekeys the group before existing keys expire.

 
    [bookmark: pgfId-419156]The key server has two responsibilities: servicing registration requests and sending rekeys. A group member can register at any time and receive the most current policy and keys. When a group member registers with the key server, the key server verifies the group ID that the group member is attempting to join. If the group ID is valid, the key server sends the security association policy to the group member. After the group member acknowledges that it can handle the downloaded policy, the key server downloads the respective keys.

 
    [bookmark: pgfId-419158]Communication among the key server and group members is encrypted and secured using two types of keys: the traffic encryption key (TEK) and the key encryption key (KEK). The TEK is downloaded by the key server to all the group members. The downloaded TEK is used by all the group members to communicate securely among each other. This key is essentially the group key that is shared by all the group members. The group policies and IPsec SAs are refreshed by the key server using periodic rekey messages to the group members. The KEK is also downloaded by the key server and is used by the group members to decrypt the incoming rekey messages from the key server.

 
    [bookmark: pgfId-419160]The key server sends out rekey messages either because of an impending IPsec SA expiration or because the security policy has changed on the key server. A rekey can also happen if the KEK timer has expired (the key server sends out a KEK rekey). Rekey messages might also be retransmitted periodically to account for possible packet loss. If the rekey mechanism is multicast, there is no efficient feedback mechanism by which receivers can indicate that they did not receive a rekey message, so retransmission seeks to bring all receivers up to date. If the rekey mechanism is unicast, the receivers send an acknowledgment message.

 
    [bookmark: pgfId-419165]The key server generates the group policy and IPsec security associations (SAs) for the GDOI group. The information generated by the key server includes multiple TEK attributes, traffic encryption policy, lifetime, source and destination, a Security Parameter Index (SPI) ID that is associated with each TEK, and the rekey policy (one KEK). Note that the group member might also have a local security policy configured that is merged with the one downloaded; for complete information see Understanding the GET VPN Security Policy and Security Associations.

 
    [bookmark: pgfId-419167]The following figure illustrates the communication flow between group members and the key server. The key server, after receiving registration messages from a group member, generates the information that contains the group policy and new IPsec SAs. The new IPsec SA is then downloaded to the group member. The key server maintains a table that contains the IP address of each group member per group. When a group member registers, the key server adds its IP address in its associated group table, thus allowing the key server to monitor an active group member. A key server can support multiple groups. A group member can be part of multiple groups.

 
    [bookmark: pgfId-419171]Figure 29-2 [bookmark: 73765]Communication Flow Between Group Members and the Key Server

 
    [bookmark: pgfId-419174] 
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    [bookmark: pgfId-419176]When you configure the GET VPN topology, you can configure the following registration-related features:

 
     
     		 [bookmark: pgfId-419181]Decide whether to use unicast or multicast for group registration and rekeying. For more information, see Choosing the Rekey Transport Mechanism.
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    [bookmark: pgfId-419183]Note If you use multicast, you need to enable multicast on the key servers and group members manually. Security Manager does not provision multicast commands.


    
     

    

    

 
     
     		 [bookmark: pgfId-419188]Decide whether to configure more than one key server to provide redundancy and load balancing. For more information, see Configuring Redundancy Using Cooperative Key Servers.

 
     		 [bookmark: pgfId-419193]Decide whether to configure fail-close mode on group members to protect their traffic prior to successful registration with the key server. For more information, see Configuring Fail-Close to Protect Registration Failures.

 
     		 [bookmark: pgfId-419198]Decide whether to require authorization for group members to join the group. You can use certificate authorization (which requires that you also configure the Public Key Infrastructure policy) or preshared keys. Configuring authorization is required if the key server serves more than one group. For information about the configuration options, see the Authorization Type setting described in Defining GET VPN Group Encryption.

 
    

 
    [bookmark: pgfId-419200]Related Topics

 
     
     		 [bookmark: pgfId-419205]Generating and Synchronizing RSA Keys

 
     		 [bookmark: pgfId-419210]Configuring GET VPN

 
    

 
     
      [bookmark: pgfId-419224][bookmark: 73792][bookmark: vpchap_cncpt_ChoosingtheRekeyTransportType]Choosing the Rekey Transport Mechanism[bookmark: marker-419216][bookmark: marker-419218][bookmark: marker-419220][bookmark: marker-419222]

 
     [bookmark: pgfId-419229]When you configure the rekey settings in the Group Encryption Policy (as described in Defining GET VPN Group Encryption), you must select whether to use multicast or unicast as the rekey transport mechanism. The key server uses this method whenever sending new keys and IPsec security associations (SAs) to group members or each other. There are advantages and disadvantages to each method.

 
     [bookmark: pgfId-419231]Multicast is the standard choice. Using multicast, the key server sends one copy of each rekey message to all group members at once using a multicast group address, so there is no rekey delay and group members can install the updated security policy essentially simultaneously (not accounting for regular network delay). However, in some networks, multicast is either an extra cost feature, or it is simply not allowed. If you configure multicast, you must supply the multicast address that will be used by the GET VPN topology.

 
     [bookmark: pgfId-419233]Unicast can be used when multicast is unavailable or undesirable. Using unicast, the key server sends directed rekey and IPsec SAs to group members, and the group member sends an acknowledgment that the message was received. Because unicast requires sending direct messages and receiving acknowledgments, the key server sends the unicast messages to a subset of the group members at a time (unless you have a relatively small VPN, perhaps fewer than 30 group members, in which case all group members might be sent messages at the same time).

 
     [bookmark: pgfId-419235]Thus, the relative benefits of multicast and unicast include the following:

 
      
      		 [bookmark: pgfId-419237]With multicast, the key server does not know if a group member receives a message, whereas with unicast, there are acknowledgments. With unicast, if the key server does not receive the acknowledgment, it resends the message.

 
      		 [bookmark: pgfId-419239]Multicast is faster than unicast, especially for large topologies with hundreds of group members. Multicast rekey uses the same low CPU overhead whether there is one group member in the group or a few thousand.

 
      		 [bookmark: pgfId-419241]With unicast, if a group member continuously fails to send acknowledgments, the key server decides the group member is no longer there and stops sending rekey messages. Thus, the key server always has a list of active group members. The unresponsive group member must reregister to rejoin the GET VPN topology. Because multicast does not use acknowledgments, the key server does not know if a group member becomes unresponsive, and it does not maintain a list of active group members.
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     [bookmark: pgfId-419246]Tip To use multicast, you must enable multicast on the key servers and group members. Security Manager does not provision these commands; it only enables multicast rekey, it does not enable the router to send and receive multicast traffic. Therefore, you must manually enable multicast on the device, or use the FlexConfig policy to provision the commands (see Creating FlexConfig Policy Objects).


     
      

     

     

 
     [bookmark: pgfId-419248]Fortunately, it is possible to mix multicast and unicast in a single GET VPN topology so long as all key servers support multicast. When deciding which transport mechanism to use, consider the following recommendations:

 
      
      		 [bookmark: pgfId-419250]If all key servers and group members, and the network, support multicast, use multicast.

 
      		 [bookmark: pgfId-419252]If all of the key servers and most of the group members support multicast, but a small number of group members do not support multicast, use multicast. Group members that do not support multicast will not receive rekey and IPsec SA updates. However, when the lifetime settings for these items are about to expire, unicast group members will reregister with the key server and obtain the new keys and IPsec SAs.

 
      		 [bookmark: pgfId-419254]If no group members, or only a few, support multicast, use unicast. The group members will then receive rekeys and IPsec SA updates from the key server and not need to reregister to get them.

 
     

 
     [bookmark: pgfId-419256]Related Topics

 
      
      		 [bookmark: pgfId-419261]Understanding the GET VPN Registration Process

 
      		 [bookmark: pgfId-419266]Generating and Synchronizing RSA Keys

 
      		 [bookmark: pgfId-419271]Configuring GET VPN

 
     

 
    
 
     
      [bookmark: pgfId-419281][bookmark: 73842][bookmark: vpchap_cncpt_COOPKeyServers]Configuring Redundancy Using Cooperative Key Servers[bookmark: marker-419277][bookmark: marker-419279]

 
     [bookmark: pgfId-419283]The key server is the most important entity in the GET VPN network because the key server maintains the control plane. Therefore, a single key server is a single point of failure for an entire GET VPN network. Because redundancy is an important consideration for key servers, GET VPN supports multiple key servers, called cooperative (COOP) key servers, to ensure seamless fault recovery if a key server fails or becomes unreachable.

 
     [bookmark: pgfId-419291]You can configure a group member to register to any available key server from a list of all COOP key servers. The group member configuration determines the registration order (see Configuring GET VPN Group Members and Edit Group Member Dialog Box). The key server defined first is contacted first, followed by the second defined key server, and so on. It is a best practice to distribute group member registration to all available COOP key servers to reduce the IKE processing load on a single key server. Note that only the primary key server sends rekey messages.

 
     [bookmark: pgfId-419293]When COOP key servers boot, all key servers assume a secondary role and begin an election process. One key server, typically the one having the highest priority, is elected as a primary key server. The other key servers remain in the secondary state. The primary key server is responsible for creating and distributing group policies to all group members and to periodically synchronize the COOP key servers.

 
     [bookmark: pgfId-419295]Cooperative key servers exchange one-way announcement messages (primary to secondary). If a secondary key server does not hear from the primary key server for a certain length of time, the secondary key server tries to contact the primary key server and request updated information. If the primary key server does not respond, or if the secondary key server does not hear from the primary key server, a COOP key server reelection is triggered and a new primary key server is elected.

 
     [bookmark: pgfId-419297]Up to eight key servers can be defined as COOP key servers, but more than four COOP key servers are seldom required. Because rekey information is generated and distributed from a single primary key server, the advantage of deploying more than two key servers is the ability to handle registration load in case of a network failure and reregistration taking place at the same time. This is especially important when using Public Key Infrastructure (PKI) group member authorization because IKE negotiation using PKI requires a lot more CPU power compared to IKE negotiation using pre-shared keys (PSKs).

 
     [bookmark: pgfId-419299]Tips

 
      
      		 [bookmark: pgfId-419304]The RSA key must be the same on all cooperative key servers. For information on synchronizing the RSA key, see Generating and Synchronizing RSA Keys.

 
      		 [bookmark: pgfId-419309]It is a best practice to enable periodic ISAKMP keepalives between key servers so that the primary key server can track and display the state of the other secondary key servers. IKE Keepalives between group members and the key server is not required and is not supported. For information on configuring keepalives, see Configuring Global Settings for GET VPN.

 
      		 [bookmark: pgfId-419311]The COOP protocol is configured on a per GDOI group basis. A key server that is configured with multiple GDOI groups can maintain multiple unique COOP relationships with disparate key servers.

 
     

 
    
 
     
      [bookmark: pgfId-419323][bookmark: 73871][bookmark: vpchap_cncpt_ConfiguringFailClosetoProtectRegistrationFailures]Configuring Fail-Close to Protect Registration Failures[bookmark: marker-419317][bookmark: marker-419319][bookmark: marker-419321]

 
     [bookmark: pgfId-419325]Group members must register with the key server to become members of the GET VPN. Before a group member successfully registers with the key server, traffic passing through the group member’s GET VPN interface is not encrypted. The period of time in which clear-text transmissions occur can be short (if registration succeeds) or potentially long, if the group member fails to register for any reason.

 
     [bookmark: pgfId-419330]This default behavior is known as fail-open. If you consider it a violation of your security standards that traffic is sent in clear text at any time, you can configure fail-close mode to protect traffic before (or during) registration. With fail-close mode, all traffic on the interface is dropped except for the traffic you specifically identify in the fail-close ACL. Fail-close mode essentially shuts down the interface until the group member successfully registers with the key server and downloads the required keys and security policy and associations. Note that the use of fail-close mode requires as a minimum Cisco IOS Software release 12.4(22)T or 15.0; you can also configure it on all supported ASRs (see Understanding Devices Supported by Each IPsec Technology).

 
     [bookmark: pgfId-419332]Fail-close mode is used only during the initial registration. If a group member has already successfully registered, the group member keeps the downloaded policy from the key server even if future registrations fail. However, if you use the clear crypto gdoi command on the group member, the subsequent registration attempt is considered a first-time attempt and fail-close mode is enforced.

 
     [bookmark: pgfId-419337]You configure fail-close mode on the individual group members as described in Configuring GET VPN Group Members. Thus, you can enable the mode on selected group members rather than on all of them. You must specify a fail-close ACL to ensure that you do not lock yourself (and Security Manager) out of the device, preventing configuration updates and maintenance until registration succeeds.

 
     [bookmark: pgfId-419339]The fail-close ACL is an extended ACL policy object and is configured as part of a crypto map on the device. You configure the rules from the perspective of the group member. Use the following tips to help you create an appropriate fail-close ACL:

 
      
      		 [bookmark: pgfId-419341]You can configure both  permit and  deny statements. In the fail-close ACL, “permit” means “do not send this traffic,” whereas “deny” means “send this traffic in clear text.” This behavior is different from that of the typical crypto map ACL, where the statements have the following meaning:

 
     

 
     [bookmark: pgfId-419343] – Permit—Means “encrypt this traffic.” Because the group member does not have the IPsec security association required to encrypt the traffic prior to registration, the result is that the traffic is dropped.

 
     [bookmark: pgfId-419345] – Deny—Means “do not encrypt this traffic.” In a typical crypto map ACL, a deny statement results in the matching packet being compared to the next crypto map ACL configured on the device (if any). However, if traffic matches a deny statement in the fail-close ACL, all crypto map ACL processing ends and the traffic is allowed in clear text.

 
     [bookmark: pgfId-419347]The reason deny works this way in fail-close mode is because fail-close includes an implicit ACL statement that gets added at the bottom of the list of crypto map ACLs. This statement is permit ip any any, which matches all traffic. Because there is no IPsec security association due to the fact that registration has yet to occur, there is no way to encrypt the remaining traffic and it is dropped.

 
     [bookmark: pgfId-419349]Note that because of this final permit ip any any statement, you might be able to limit yourself to deny statements in your fail-close ACL.

 
      
      		 [bookmark: pgfId-419351]The fail-close ACL is processed sequentially after the optional group member security policy ACL. However, all statements in the group member security policy ACL must be deny statements, which indicate that matching traffic should be sent in clear text. Because the security policy is processed according to normal crypto map rules, traffic that matches deny statements is subsequently compared to the fail-close ACL. If the fail-close ACL does not have matching deny statements, the traffic will subsequently be dropped by the implicit final fail-close permit ip any any statement.

 
     

 
     [bookmark: pgfId-419353]Therefore, if you use a group member security policy ACL, and you want the identified traffic to be sent in clear text regardless of the registration status of the group member, your fail-close ACL should contain all of the same statements contained in the security policy ACL at the least. It might even be possible to use the same ACL object for both ACLs.

 
     [bookmark: pgfId-419358]For more information about group member security policies, see Understanding the GET VPN Security Policy and Security Associations.

 
      
      		 [bookmark: pgfId-419362]The fail-close ACL is inserted as the final crypto map ACL. Thus, if you configure other features on the GET VPN interface that use crypto maps, any traffic identified on deny statements in those other ACLs will also get trapped (and dropped) by the fail-close ACL and the implicit final permit ip any any statement. Thus, configuring fail-close mode for GET VPN can influence the non-GET VPN services you configure on the interface.[bookmark: marker-419360]

 
      		 [bookmark: pgfId-419364]Upon successful registration, the fail-close ACL and the implicit final permit ip any any statement are removed from the crypto maps. These policies are not persistent.

 
      		 [bookmark: pgfId-419366]You should consider including the following rules in the fail-close ACL policy object. Remember that these rules are from the perspective of the group member:

 
     

 
     [bookmark: pgfId-419368] – SSH, SSL (HTTPS) traffic—You, and Security Manager, need to be able to access the device to configure it. To ensure that you do not lock down the device, include deny statements for SSH and SSL. For SSH, deny tcp any eq 22 <host or network address>. For SSL, deny tcp any eq 443 <host or network address>. If you specify host addresses, ensure that the Security Manager server is one of the hosts.

 
     [bookmark: pgfId-419370] – Routing traffic—To enable routing, allow the traffic for your routing process. For example, if you are using OSPF, deny ospf any any.

 
     [bookmark: pgfId-419374] – GDOI traffic—Regardless of the contents of the fail-close ACL, the device looks for GDOI registration messages, so you do not need to explicitly allow them to enable successful registration. However, if a group member (1) is in the path between the key server and another group member (2), a registration failure by group member (1) will prevent successful registration by the blocked group member (2). For registration on group member (2) to succeed, the fail-close ACL on group member (1) would have to allow GDOI traffic to pass. Thus, you might want to make it a general practice to allow GDOI traffic in the fail-close ACL: deny udp any eq 848 any eq 848.[bookmark: marker-419372]

 
     [bookmark: pgfId-419376]Related Topics

 
      
      		 [bookmark: pgfId-419381]Configuring GET VPN

 
      		 [bookmark: pgfId-419386]Creating Access Control List Objects

 
      		 [bookmark: pgfId-419391]Creating Extended Access Control List Objects

 
     

 
    
 
   
 
    
     [bookmark: pgfId-419405][bookmark: 73948][bookmark: vpchap_cncpt_UnderstandingtheGETVPNSecurityPolicyandSecurityAssociations]Understanding the GET VPN Security Policy and Security Associations[bookmark: marker-419397][bookmark: marker-419399][bookmark: marker-419401][bookmark: marker-419403]

 
    [bookmark: pgfId-419407]GET VPN uses crypto map access control lists (ACLs) to identify the traffic that needs to be encrypted in the VPN. These ACLs also identify traffic that should be sent as clear text instead of being encrypted (essentially, traffic that lies outside of the VPN). The collection of these ACLs define the security policy for the VPN.

 
    [bookmark: pgfId-419409]GET VPN provides a multi-layered security policy. You define the general policy for the entire VPN on the key server, but you can also define a separate security policy on group members to account for local variations. The group member security policy always takes priority over the policy received from the key server. When the group member registers with the key server, the group member downloads the key server’s security policy and associations and the group member creates a new, single security policy crypto map ACL by concatenating the individual security policies in this order: first, the group member’s ACL; second, the key server’s first ACL; third, and so forth, any additional ACLs from the key server in the order defined on the key server. It is important to understand that these merged ACLs are treated as a single ACL; they are not searched as separate ACLs. Thus, if traffic matches a deny statement from the group member’s ACL, that traffic is never tested against any ACL rules downloaded from the key server.
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    [bookmark: pgfId-419411]Tip If a group member leaves the GET VPN, the ACLs downloaded from the key server are removed, but the group member security policy ACL is retained and remains configured on the device.


    
     

    

    

 
    [bookmark: pgfId-419413]In GET VPN security policy ACLs (and crypto map ACLs in general), the permit and deny keywords have special meaning:

 
     
     		 [bookmark: pgfId-419415] Permit —Means “encrypt this traffic.” Permit entries are allowed only in the security policy ACLs defined on the key server (in the  Group Encryption Policy ), because encrypted traffic needs to have a full IPsec security association, which includes the transform set used for encrypting traffic, and anti-replay and IPsec lifetime configurations. If a packet matches a permit entry, but no IPsec SA exists for that packet, the packet is dropped.

 
    

 
    [bookmark: pgfId-419417]Normally, your permit rules should be symmetric, that is, the source and destination addresses should be the same. If you need to specify different source and destination addresses, you must create two rules; the second rule should be a mirror image of the first rule, with the source and destination address switched.

 
     
     		 [bookmark: pgfId-419419] Deny —Means “do not encrypt this traffic.” In practice, this typically means that the traffic that matches the deny statement is sent in the clear. However, if you configure other features that use crypto maps, “denied” traffic is actually compared to subsequent (lower priority) crypto map ACLs to see if there is a match. IPsec security associations (SAs) are not generated for deny rules.

 
    

 
    [bookmark: pgfId-419421]Following is a summary of the security policies that you can configure, in priority order:

 
     
     		 [bookmark: pgfId-419426] Group member security policy —When you configure the group member, as described in Configuring GET VPN Group Members, you can optionally select an ACL policy object that defines the local group member security policy.

 
    

 
    [bookmark: pgfId-419428]This group member ACL policy object is allowed to have deny statements only. You use this ACL to identify any traffic that you want to exclude from encryption and send in the clear. For example, if a handful of group members in the group are running a different routing protocol than the usual one, you can configure a local entry to these group members’ security policy ACL to bypass encryption of the routing protocol traffic instead of defining the policy globally at the key server level.

 
     
     		 [bookmark: pgfId-419433] Key server security policies and security associations —When you configure the Group Encryption Policy for the GET VPN, as described in Defining GET VPN Group Encryption, you configure ACLs that identify the traffic that should be encrypted and protected in the VPN.

 
    

 
    [bookmark: pgfId-419435]The security policies on the key server are coupled with transform sets and other settings to define security associations; two IPsec security associations (SAs) are actually configured for every rule within the ACL, and these SAs define how the selected traffic should be encrypted. Thus, all group members use the same group SAs and they do not need to negotiate them with each other.

 
    [bookmark: pgfId-419437]Because the key server policy is appended to the group member policy, the policy might be as simple as permit ip any any, that is, encrypt all traffic that has not been excluded by the group member policy.

 
    [bookmark: pgfId-419439]However, you can create more complex sets of security policies and associations, setting up several separate ACL policy objects that are coupled to different transform sets to define different types of encryption.

 
    [bookmark: pgfId-419441]If you create more than one security association, you must identify their order, and they are appended to the group policy in that order. Remember, the end result is a single ACL, so if you include a deny statement in the first ACL, any permit rules for the same traffic in subsequent security associations are ignored, and the traffic is sent in clear text rather than being encrypted.
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    [bookmark: pgfId-419443]Note When you consider the security associations defined in the Group Encryption Policy as a whole, you can define up to 100 ACL permit entries. Each permit entry results in a pair of IPsec SAs; the maximum number of IPsec SAs in a group can not exceed 200. It is a best practice to summarize interesting traffic to as few permit entries as possible, and to build symmetric policies, where the source and destination addresses are the same. Unlike traditional IPSec policies, where source and destination address ranges must be uniquely defined, GET VPN is optimized when the source and destination address range are the same. If you configure a rule that has different source and destination addresses, you must also configure the mirrored rule (where the source and destination address are flipped), meaning that four SAs are consumed.


    
     

    

    

 
    [bookmark: pgfId-419448]In addition to these security policies, there is an additional fail-close ACL that influences traffic patterns if you configure fail-close mode on a group member. For a complete discussion, see Configuring Fail-Close to Protect Registration Failures.

 
    [bookmark: pgfId-419450]Related Topics

 
     
     		 [bookmark: pgfId-419455]Configuring GET VPN

 
     		 [bookmark: pgfId-419460]Creating Access Control List Objects

 
     		 [bookmark: pgfId-419465]Creating Extended Access Control List Objects

 
    

 
     
      [bookmark: pgfId-419473][bookmark: 74007][bookmark: vpchap_cncpt_TimeBasedAntiReplay]Understanding Time-Based Anti-Replay[bookmark: marker-419471]

 
     [bookmark: pgfId-419475]Anti-replay is an important feature in a data encryption protocol such as IPSec (RFC 2401). Anti-replay prevents a third party from eavesdropping on an IPsec conversation, stealing packets, and injecting those packets into a session at a later time. The time-based anti-replay mechanism helps ensure that invalid packets are discarded by detecting the replayed packets that have already arrived at an earlier time.

 
     [bookmark: pgfId-419477]GET VPN uses the Synchronous Anti-Replay (SAR) mechanism to provide anti-replay protection for multisender traffic. SAR is independent of real-world Network Time Protocol (NTP) clock or sequential-counter mechanisms (which guarantee packets are received and processed in order). A SAR clock advances regularly. The time tracked by this clock is called pseudotime. The pseudotime is maintained on the key server and is sent periodically to the group members within a rekey message as a timestamp field called pseudoTimeStamp. Group members have to be resynchronized to the pseudotime of the key server periodically. The pseudotime of the key server starts ticking from when the first group member registers. Initially, the key server sends the current pseudotime value of the key server and window size to group members during the registration process. New attributes, such as time-based replay-enabled information, window size, and the pseudotime of the key server, is sent under the SA payload (TEK).

 
     [bookmark: pgfId-419479]The group members use the pseudotime to prevent replay as follows: the pseudoTimeStamp contains the pseudotime value at which a sender created a packet. A receiver compares the pseudotime value of senders with its own pseudotime value to determine whether a packet is a replayed packet. The receiver uses a time-based anti-replay window to accept packets that contain a timestamp value within that window. The window size is configured on the key server and is sent to all group members.

 
     [bookmark: pgfId-419481]The following figure illustrates an anti-replay window in which the value PTr denotes the local pseudotime of the receiver, and W is the window size.

 
     [bookmark: pgfId-419489]You configure anti-replay in the security association definitions in the Group Encryption Policy. For more information, see Defining GET VPN Group Encryption and Add New or Edit Security Association Dialog Box.

 
     [bookmark: pgfId-419493]Figure 29-3 [bookmark: 74019]Anti-Replay Window

 
     [bookmark: pgfId-419496] 
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     [bookmark: pgfId-419504][bookmark: 74024][bookmark: vpchap_proc_ConfiguringGETVPN]Configuring GET VPN[bookmark: marker-419502]

 
    [bookmark: pgfId-419512]To configure a full mesh VPN with group encrypted transport (GET), use the Create VPN wizard as described in Creating or Editing VPN Topologies. When you finish the wizard, you are asked if you want to synchronize RSA keys, which is required for normal VPN functioning; for detailed information, see Generating and Synchronizing RSA Keys.

 
    [bookmark: pgfId-419517]If you select multicast as the rekey transport mechanism, you must enable multicast on all key servers and the desired group members. For more information, see Choosing the Rekey Transport Mechanism.

 
    [bookmark: pgfId-419519]You can change only the name and description of a GET VPN using the Edit VPN wizard. If you need to make changes to other policies and settings, open the policies from the Site-to-Site Manager page, as follows:

 
     
     		 [bookmark: pgfId-419524]For ISAKMP and IPSec settings, select  Global Settings for GET VPN . See Configuring Global Settings for GET VPN.

 
     		 [bookmark: pgfId-419529]For IKE proposal policies, select  IKE Proposal Policy for GET VPN . See Configuring the IKE Proposal for GET VPN.

 
     		 [bookmark: pgfId-419534]For security associations (ACL rules) and IPSec policies, select  Group Encryption Policy > Security Associations . See Defining GET VPN Group Encryption.

 
     		 [bookmark: pgfId-419539]For preshared key policies, select  IKEv1 Preshared Key . See Configuring IKEv1 Preshared Key Policies.

 
     		 [bookmark: pgfId-419544]For public key (PKI) policies, select  Public Key Infrastructure . See Configuring IKEv1 Public Key Infrastructure Policies in Site-to-Site VPNs.

 
     		 [bookmark: pgfId-419552]For rekey settings, select  Group Encryption Policy > Group Settings . See Defining GET VPN Group Encryption and Generating and Synchronizing RSA Keys.

 
     		 [bookmark: pgfId-419560]For key server configuration, including RSA key synchronization, select  Key Servers . See Configuring GET VPN Key Servers and Generating and Synchronizing RSA Keys.

 
     		 [bookmark: pgfId-419565]For group membership and endpoint settings, select  Group Members . See Configuring GET VPN Group Members.

 
    

 
    [bookmark: pgfId-419567]Related Topics

 
     
     		 [bookmark: pgfId-419572]Understanding Group Encrypted Transport (GET) VPNs

 
     		 [bookmark: pgfId-419577]Understanding the GET VPN Registration Process

 
     		 [bookmark: pgfId-419582]Understanding the GET VPN Security Policy and Security Associations

 
     		 [bookmark: pgfId-419587]Troubleshooting GET VPN Configurations

 
     		 [bookmark: pgfId-419592]Understanding IKEv1 Preshared Key Policies in Site-to-Site VPNs

 
    

 
   
 
    
     [bookmark: pgfId-419606][bookmark: 74089][bookmark: vpchap_cncpt_GeneratingandSynchronizingRSAKeys]Generating and Synchronizing RSA Keys[bookmark: marker-419600][bookmark: marker-419602][bookmark: marker-419604]

 
    [bookmark: pgfId-419611]When you specify the RSA key label in the Group Encryption Policy (as described in Defining GET VPN Group Encryption), the corresponding RSA key (public and private keys) needs to be configured on all key servers in the GET VPN topology. The key can either be a pre-existing key that you defined on the device, or it could be a new key label, and Security Manager can generate the key for you and synchronize all key servers to use the same key.

 
    [bookmark: pgfId-419613]You can use the following methods to have Security Manager generate and synchronize the RSA key:

 
     
     		 [bookmark: pgfId-419618]When creating a new GET VPN using the Create VPN wizard, you are asked at the end of the wizard if you want to synchronize the keys. If you click  Yes , Security Manager does the key synchronization immediately, and generates a new key if the key does not already exist. For information on using the Create VPN wizard, see Creating or Editing VPN Topologies.

 
     		 [bookmark: pgfId-419623]For an existing GET VPN, you can click the  Synchronize Keys button on the Key Servers policy. Use this process whenever you add key servers or generate a new key on the primary key server. For information on configuring key server settings for existing topologies, see Configuring GET VPN Key Servers.
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    [bookmark: pgfId-419625]Tip For existing GET VPN topologies, if you want to generate a new RSA key, it might be easiest to update the Group Encryption Policy to specify a new, unused RSA key label, then click the Synchronize Keys button in the Key Servers policy. Because the key will not exist on any key server, Security Manager will generate the new key and import it into all key servers. You can then manually delete the old key from each key server.


    
     

    

    

 
    [bookmark: pgfId-419627]Following are the uses for the RSA key:

 
     
     		 [bookmark: pgfId-419629]The key server uses the private RSA key to authenticate rekey messages from the group members.

 
     		 [bookmark: pgfId-419631]The key server provides the public RSA key to group members during registration.

 
     		 [bookmark: pgfId-419633]The key server uses the private key to sign the key encryption key (KEK) and traffic encryption key (TEK). The absence of an RSA key prevents the key server from creating the KEK and TEK.

 
     		 [bookmark: pgfId-419635]The RSA key is also used to sign messages between cooperative key servers.

 
    

 
    [bookmark: pgfId-419637]When you start the RSA key synchronization process, the Synchronize Keys dialog box opens and shows you the overall progress as well as the results for each key server. (You can click the Abort button at any time to stop the process.) Security Manager performs the following steps:

 
    [bookmark: pgfId-419639] 1. Logs into all key servers and retrieves the RSA key information from each of them for the RSA key label configured for the VPN.

 
    [bookmark: pgfId-419641] 2. Determines whether any key server has a key with the required label:

 
    [bookmark: pgfId-419643] – If no key server has an RSA key with the required label, Security Manager generates the key on the primary key server (the one with the highest priority).

 
    [bookmark: pgfId-419645] – If one or more key server does not have the key, but all of the key servers that do have the key have the identical keys, Security Manager uses the existing key on any key server that has it.

 
    [bookmark: pgfId-419647] – If more than one key server has the key, but the contents of the key is different among the servers, you are asked if Security Manager can overwrite the keys. If you click Yes, Security Manager uses the existing key on the primary key server.

 
    [bookmark: pgfId-419649]If you click No, you can log into the key servers outside of Security Manager and manually adjust the keys according to your requirements. However, all key servers must have the same key contents for the RSA key. See below for an explanation of the process.

 
    [bookmark: pgfId-419651] 3. Creates an exportable version of the key.

 
    [bookmark: pgfId-419653] 4. Imports the key into each of the remaining key servers.
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    [bookmark: pgfId-419655]Tip For the synchronization process to succeed, the devices must be online and reachable and you must have Deploy authorization. If the device connection fails or times out, ensure that you can ping the key server from the Security Manager server. If it is your practice to deploy to file instead of to live devices, you might need to manually generate and synchronize the keys as described below. If you do not have sufficient authorization, you are prevented from initiating the process; someone else must do it.


    
     

    

    

 
    [bookmark: pgfId-419657]Manually Generating and Synchronizing the RSA Key

 
    [bookmark: pgfId-419659]If you do not want Security Manager to generate and synchronize keys, or if for some reason Security Manager cannot complete the process, you can manually generate and synchronize keys using the following sequence in Privileged EXEC (enable) configuration mode:

 
    [bookmark: pgfId-419661] 1. Generate the key on a key server using the following command, where rekeyrsa is the name of the key (you can specify a name of your choosing). You must make the key exportable.

 
    [bookmark: pgfId-419663]crypto key generate rsa general-keys label rekeyrsa modulus 1024 exportable

 
    [bookmark: pgfId-419665] 2. Create an exportable copy of the key using the following command, where passphrase is a string used to encrypt the key for import (you can specify your own pass phrase):

 
    [bookmark: pgfId-419667]crypto key export rsa rekeyrsa pem terminal 3des passphrase

 
    [bookmark: pgfId-419669]This command prints out the public and private keys to the terminal, where you can copy them to the clipboard for import into the other key servers. The keys are demarcated by ----BEGIN/END PUBLIC KEY---- and ----BEGIN/END RSA PRIVATE KEY----.Note that you can also export to a URL; see the Cisco IOS Security Command Reference on Cisco.com for detailed usage information.

 
    [bookmark: pgfId-419671] 3. Import the key into each of the other key servers using the following command:

 
    [bookmark: pgfId-419673]crypto key import rsa rekeyrsa pem exportable terminal passphrase

 
    [bookmark: pgfId-419675]When copying and pasting the keys, include the begin/end lines.

 
   
 
    
     [bookmark: pgfId-419687][bookmark: 74171][bookmark: vpnpage_cncpt_IKEProposalGETVPN]Configuring the IKE Proposal for GET VPN[bookmark: marker-419683][bookmark: marker-419685]

 
    [bookmark: pgfId-419689]Use the IKE Proposal for GET VPN page to define the IKE proposal to be used by the GET VPN topology. The IKE proposal is configured on the key servers and the group members.

 
    [bookmark: pgfId-419691]These settings are for the ISAKMP security association (SA). If you are using a single key server, the ISAKMP SA is not used after initial group member registration. If you are using more than one key server (cooperative key servers), the ISAKMP SA is needed for communications among the key servers.

 
    [bookmark: pgfId-419693]To open the IKE Proposal for GET VPN page:

 
     
     		 [bookmark: pgfId-419698](Site-to-Site VPN Manager Window) Select an existing GET VPN topology and then select  IKE Proposal for GET VPN in the Policies selector.

 
     		 [bookmark: pgfId-419700](Policy view) Select  Site-to-Site VPN > IKE Proposal for GET VPN , and then select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-419702]The following table explains the settings you can configure in this policy.

 
    [bookmark: pgfId-419705] 

 
     
      
       
       [bookmark: pgfId-418072]Table 29-1 [bookmark: 74194]IKE Proposal for GET VPN Policy 

 
       
      
        
        		
          
          [bookmark: pgfId-418078]Element
         
  
        		
          
          [bookmark: pgfId-418080]Description
         
  
       

 
        
        		[bookmark: pgfId-418086]IKE Proposal

  
        		[bookmark: pgfId-418088]The IKE proposal policy object that defines the settings you want to use. There are several predefined objects that you might be able to use as is.

 [bookmark: pgfId-418090]Click Select to open the list of existing IKE proposal objects. The object you select needs to use the same authorization method you are configuring for the group (for example, an object name with the prefix preshared when using preshared keys, or with the prefix cert when using Public Key Infrastructure (PKI) certificates).

 [bookmark: pgfId-418095]When you select an object and click OK, the settings defined in the object are displayed in the IKE Proposal Settings display fields. You can also see the settings by editing them in the selection list. If you do not find an appropriate pre-existing object, click the Add (+) button in the selection list and create a new object (see Configuring IKEv1 Proposal Policy Objects for more information and detailed descriptions of the options).

  
       

 
        
        		[bookmark: pgfId-418101]IKE Proposal Overrides

  
        		[bookmark: pgfId-418103]The number of seconds that the ISAKMP SA for key servers and group members is valid. When the lifetime is exceeded, the SA expires and must be renegotiated between the peers. Values can be 1 to 86400.

 
          
          		 [bookmark: pgfId-418105]If you are using cooperative key servers (more than one key server), set the key server lifetime high. The default 86400 is appropriate.

 
          		 [bookmark: pgfId-418107]If you are using a single key server, you can set the lifetime low (but not less than 60 seconds) so that the ISAKMP SA is not retained unnecessarily. It is not used after a group member registers.

 
          		 [bookmark: pgfId-418109]We recommend that you set the group member lifetime low as compared to the key server lifetime, especially when cooperative key servers are configured.

 
         

  
       

 
      
     

 
    
 
    [bookmark: pgfId-419707]Related Topics

 
     
     		 [bookmark: pgfId-419712]Understanding IKE

 
     		 [bookmark: pgfId-419717]Understanding IKEv1 Preshared Key Policies in Site-to-Site VPNs

 
     		 [bookmark: pgfId-419722]Defining GET VPN Group Encryption

 
     		 [bookmark: pgfId-419727]Understanding Group Encrypted Transport (GET) VPNs

 
     		 [bookmark: pgfId-419732]Configuring GET VPN

 
    

 
   
 
    
     [bookmark: pgfId-419744][bookmark: 74248][bookmark: vpnpage_cncpt_VPNGlobalSettingsGETVPN]Configuring Global Settings for GET VPN[bookmark: marker-419740][bookmark: marker-419742]

 
    [bookmark: pgfId-419746]Use the Global Settings for GET VPN page to define global settings for ISAKMP and IPsec that apply to devices in your GET VPN topology.
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    [bookmark: pgfId-419751]Note The lifetime settings in this policy do not apply to the ISAKMP security association lifetime for the key server and group members. Those lifetime values are configured in the IKE Proposal for GET VPN policy. For more information, see Configuring the IKE Proposal for GET VPN.


    
     

    

    

 
    [bookmark: pgfId-419753]To open the Global Settings for GET VPN page:

 
     
     		 [bookmark: pgfId-419758](Site-to-Site VPN Manager Window) Select an existing GET VPN topology and then select  Global Settings for GET VPN in the Policies selector.

 
     		 [bookmark: pgfId-419760](Policy view) Select  Site-to-Site VPN > Global Settings for GET VPN , and then select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-419762]The following table explains the settings you can configure in this policy.

 
    [bookmark: pgfId-419765] 

 
     
      
       
       [bookmark: pgfId-418122]Table 29-2 [bookmark: 74273]Global Settings for GET VPN 

 
       
      
        
        		
          
          [bookmark: pgfId-418128]Element
         
  
        		
          
          [bookmark: pgfId-418130]Description
         
  
       

 
        
        		[bookmark: pgfId-418136]Enable Keepalive (Key Servers Only)

  
        		[bookmark: pgfId-418138]Whether to enable dead peer detection (DPD) keepalive messages between key servers. If there is more than one key server (cooperative key servers), you should enable periodic keepalive so the servers know each other’s status and can elect a new primary server when necessary. Configure the following settings:

 
          
          		 [bookmark: pgfId-418140] Interval —When you also select  Periodic , the number of seconds between DPD messages. If you do not select Periodic, it is the number of seconds during which traffic is not received from the peer before DPD retry messages are sent. The range is from 10 to 3600 seconds.

 
          		 [bookmark: pgfId-418142] Retry —The number of seconds between DPD retry messages if the DPD retry message is missed by the peer; the range is from 2 to 60 seconds. The default DPD retry message is sent every 2 seconds. Five aggressive DPD retry messages can be missed before the key server is marked as down.

 
          		 [bookmark: pgfId-418144] Periodic —Whether to send DPD messages at regular intervals (regardless of traffic received from the other key servers). For GET VPN, you should select Periodic.

 
         

  
       

 
        
        		[bookmark: pgfId-418150]Identity

  
        		[bookmark: pgfId-418152]During Phase I IKE negotiations, peers must identify themselves to each other. Select the ISAKMP identity to use:

 
          
          		 [bookmark: pgfId-418154]Address—(Default) The IP address of the interface that participates in IKE negotiations. Use the address if only one interface participates in negotiations, and its IP address is known (static).

 
          		 [bookmark: pgfId-418156]Hostname—The fully-qualified host name (for example, router1.example.com).

 
          		 [bookmark: pgfId-418158]Distinguished Name

 
         

  
       

 
        
        		[bookmark: pgfId-418164]SA Requests System Limit

  
        		[bookmark: pgfId-418166]The maximum number of SA requests allowed before IKE starts rejecting them. The specified value must equal or exceed the number of peers, or the VPN tunnels might be disconnected.

 [bookmark: pgfId-418168]You can enter a value in the range of 0-99999.

  
       

 
        
        		[bookmark: pgfId-418174]SA Requests System Threshold

  
        		[bookmark: pgfId-418176]The percentage of system resources that can be used before IKE starts rejecting new SA requests. The default is 75 percent.

  
       

 
        
        		[bookmark: pgfId-418182]IPsec Settings

  
        		[bookmark: pgfId-418184]Select Enable Lifetime if you want to change the default lifetime settings for IPsec SAs. You can configure a lifetime based on the volume of traffic (in kilobytes) between group members, seconds, or both. The key expires when either of the values is reached. The defaults (which are configured even if you do not select this option) are:

 
          
          		 [bookmark: pgfId-418186] Lifetime (secs) —3600 seconds (one hour).

 
          		 [bookmark: pgfId-418188] Lifetime (kbytes) —4,608,000 kilobytes.

 
         

 [bookmark: pgfId-418196]Tip You can override these values for the traffic encryption key when configuring a security association. See Defining GET VPN Group Encryption and Add New or Edit Security Association Dialog Box.  
       

 
      
     

 
    
 
    [bookmark: pgfId-419767]Related Topics

 
     
     		 [bookmark: pgfId-419772]Understanding IKE

 
     		 [bookmark: pgfId-419777]Understanding IPsec Proposals for Site-to-Site VPNs

 
     		 [bookmark: pgfId-419782]Understanding Group Encrypted Transport (GET) VPNs

 
     		 [bookmark: pgfId-419787]Configuring GET VPN

 
    

 
   
 
    
     [bookmark: pgfId-419799][bookmark: 74354][bookmark: vpnpage_cncpt_KeyServersPage]Configuring GET VPN Key Servers[bookmark: marker-419795][bookmark: marker-419797]

 
    [bookmark: pgfId-419801]Use the Key Servers policy to define key servers to be used by a GET VPN topology.

 
    [bookmark: pgfId-419806]To open the Key Servers policy, in the Site-to-Site VPN Manager Window, select an existing GET VPN topology, then select Key Servers from the Policies list.

 
    [bookmark: pgfId-419811]The table lists the key servers used in the VPN, showing the device name, identity, priority, and registration interface. For detailed information about these attributes, see Edit Key Server Dialog Box.

 
     
     		 [bookmark: pgfId-419813]To add a key server to the table, click the  Add Row button and select the device from the list presented. Only devices that can be included as key servers are shown.

 
     		 [bookmark: pgfId-419818]To edit the characteristics of a key server, select it and click the  Edit Row button. Fill in the Edit Key Server dialog box (see Edit Key Server Dialog Box).

 
     		 [bookmark: pgfId-419820]To delete a key server, select it and click the  Delete Row button.

 
     		 [bookmark: pgfId-419825]To synchronize the RSA keys among the key servers, so that they all use the identical key, click the  Synchronize Keys button. For detailed information about the key synchronization process, including when and why you would do it, see Generating and Synchronizing RSA Keys.

 
     		 [bookmark: pgfId-419827]To change the order of a key server when using cooperative key servers, select it and click the up or down arrow button. This order does not define which server is the primary key server (this is determined by the Priority value, the higher the value, the higher the likelihood that the server will be elected the primary key server).

 
    

 
    [bookmark: pgfId-419838]Instead, the order determines the default order in which group members will try to register with a key server. Group members register with the first key server in the list. If the first key server cannot be reached, group members register with the second key server, and so on. For more information about key server redundancy, see Configuring Redundancy Using Cooperative Key Servers. Note that you can override this order for individual group members; see Configuring GET VPN Group Members and Edit Group Member Dialog Box.
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    [bookmark: pgfId-419840]Tip You can toggle between showing the interface roles or the actual interfaces defined by those roles in the Identity and interfaces columns using the Show field below the table.


    
     

    

    

 
    [bookmark: pgfId-419842]Related Topics

 
     
     		 [bookmark: pgfId-419847]Understanding the GET VPN Registration Process

 
     		 [bookmark: pgfId-419852]Understanding Group Encrypted Transport (GET) VPNs

 
     		 [bookmark: pgfId-419857]Configuring GET VPN

 
     		 [bookmark: pgfId-419862]Configuring VPN Topologies in Device View

 
     		 [bookmark: pgfId-419867]Filtering Tables

 
    

 
     
      [bookmark: pgfId-419889][bookmark: 74410][bookmark: vpnpage_cncpt_AddKeyServerGroupMemberDialogBox]Add Key Server, Group Member Dialog Box[bookmark: marker-419877][bookmark: marker-419879][bookmark: marker-419881][bookmark: marker-419883][bookmark: marker-419885][bookmark: marker-419887]

 
     [bookmark: pgfId-419891]Use the Add Key Server and Add Group Member dialog boxes to select key servers or group members to be used in the GET VPN topology. Select the check box next to the desired devices and click OK.

 
     [bookmark: pgfId-419893]Navigation Path

 
     [bookmark: pgfId-419895]To add key servers or group members to a GET VPN topology, click the Add Row (+) button beneath the Key Server or Group Member table in the GET VPN Peers page of the Create VPN wizard, or for existing topologies, the Key Servers or Group Members policies. For detailed information, see the following topics:

 
      
      		 [bookmark: pgfId-419900]Defining GET VPN Peers

 
      		 [bookmark: pgfId-419905]Configuring GET VPN Key Servers

 
      		 [bookmark: pgfId-419910]Configuring GET VPN Group Members

 
     

 
    
 
     
      [bookmark: pgfId-419924][bookmark: 74453][bookmark: vpnpage_cncpt_EditKeyServerDialogBox]Edit Key Server Dialog Box[bookmark: marker-419918][bookmark: marker-419920][bookmark: marker-419922]

 
     [bookmark: pgfId-419926]Use the Edit Key Servers dialog box to change the attributes defined for a key server in a GET VPN topology.

 
     [bookmark: pgfId-419928]Navigation Path

 
      
      		 [bookmark: pgfId-419933](Create VPN Wizard) Go to the GET VPN Peers Page, select a key server and click the  Edit Row button. See Defining GET VPN Peers.

 
      		 [bookmark: pgfId-419941](Site-to-Site VPN Manager Window) Select the  Key Servers policy, select a key server and click the  Edit Row button. See Configuring GET VPN Key Servers.

 
     

 
     [bookmark: pgfId-419943]Related Topics

 
      
      		 [bookmark: pgfId-419948]Understanding Group Encrypted Transport (GET) VPNs

 
      		 [bookmark: pgfId-419953]Configuring GET VPN

 
     

 
     [bookmark: pgfId-419955]Field Reference

 
     [bookmark: pgfId-419958] 

 
      
       
        
        [bookmark: pgfId-418209]Table 29-3 [bookmark: 74492]Edit Key Server Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-418215]Element
          
  
         		
           
           [bookmark: pgfId-418217]Description
          
  
        

 
         
         		[bookmark: pgfId-418223]Identity Interface

  
         		[bookmark: pgfId-418225]The interface that group members use to identify the key server and register with it. The default is the Loopback interface role, which identifies all Loopback interfaces.

  
        

 
         
         		[bookmark: pgfId-418231]Priority

  
         		[bookmark: pgfId-418233]A number between 1-100 that designates the role of the key server, either primary or secondary. The key server with the highest number becomes the primary key server. If two or more key servers are assigned the same priority, the device with the highest IP address is used. The default priority is 100 for the first key server, 95 for the second, and so on.

 [bookmark: pgfId-418235]Note There can be more than one primary key server if the network is partitioned.

  
        

 
         
         		[bookmark: pgfId-418241]Registration Interface

  
         		[bookmark: pgfId-418243]The interface on which group domain of interpretation (GDOI) registrations can be accepted. If you do not specify a registration interface, GDOI registrations can occur on any interface.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-419972][bookmark: 74520][bookmark: vpnpage_cncpt_GroupMembersPage]Configuring GET VPN Group Members[bookmark: marker-419966][bookmark: marker-419968][bookmark: marker-419970]

 
    [bookmark: pgfId-419974]Use the Group Members policy to define the group members in a GET VPN topology.

 
    [bookmark: pgfId-419979]To open the Group Members policy, in the Site-to-Site VPN Manager Window, select an existing GET VPN topology, then select Group Members from the Policies list.

 
    [bookmark: pgfId-419984]The group members table lists the members of the GET VPN, showing the device name, GET-enabled interface, local interface, and security policy. For detailed information about these attributes, see Edit Group Member Dialog Box.

 
     
     		 [bookmark: pgfId-419986]To add a group member to the table, click the  Add Row button and select the device from the list presented. Only devices that can be included as group members are shown.

 
     		 [bookmark: pgfId-419991]To edit the endpoint characteristics of a group member, select it and click the  Edit Row button. Fill in the Edit Group Member dialog box (see Edit Group Member Dialog Box).

 
    

 
    [bookmark: pgfId-419993]If you select multiple group members in the table, you can also right-click and select the following commands to edit just these attributes:

 
    [bookmark: pgfId-419995] – Edit Key Server Order—To change the key server list and priority order for the selected group members.

 
    [bookmark: pgfId-419997] – Edit Passive SA Mode—To change whether the selected group members use passive SA mode.

 
     
     		 [bookmark: pgfId-419999]To delete a group member, select it and click the  Delete Row button.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-420001]Tip You can toggle between showing the interface roles or the actual interfaces defined by those roles in the interfaces columns using the Show field below the table.


    
     

    

    

 
    [bookmark: pgfId-420003]Related Topics

 
     
     		 [bookmark: pgfId-420008]Configuring Fail-Close to Protect Registration Failures

 
     		 [bookmark: pgfId-420013]Using Passive Mode to Migrate to GET VPN

 
     		 [bookmark: pgfId-420018]Understanding Group Encrypted Transport (GET) VPNs

 
     		 [bookmark: pgfId-420023]Configuring GET VPN

 
     		 [bookmark: pgfId-420028]Configuring VPN Topologies in Device View

 
     		 [bookmark: pgfId-420033]Filtering Tables

 
    

 
     
      [bookmark: pgfId-420051][bookmark: 74580][bookmark: vpnpage_cncpt_EditGroupMemberDialogBox]Edit Group Member Dialog Box[bookmark: marker-420043][bookmark: marker-420045][bookmark: marker-420047][bookmark: marker-420049]

 
     [bookmark: pgfId-420053]Use the Edit Group Members dialog box to change the attributes defined for a group member of a GET VPN topology.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-420055]Tip If you selected multiple devices and chose an edit command from the right-click menu, this dialog box shows only those options related to the edit command you chose.


     
      

     

     

 
     [bookmark: pgfId-420057]Navigation Path

 
      
      		 [bookmark: pgfId-420062](Create VPN Wizard) Go to the GET VPN Peers page, select a group member and click the  Edit Row button. See Defining GET VPN Peers.

 
      		 [bookmark: pgfId-420070](Site-to-Site VPN Manager Window) Select a GET VPN topology, then select the  Group Members policy. Select a group member and click the  Edit Row button. See Configuring GET VPN Group Members.

 
     

 
     [bookmark: pgfId-420072]Related Topics

 
      
      		 [bookmark: pgfId-420077]Understanding Group Encrypted Transport (GET) VPNs

 
      		 [bookmark: pgfId-420082]Configuring GET VPN

 
     

 
     [bookmark: pgfId-420084]Field Reference

 
     [bookmark: pgfId-420087] 

 
      
       
        
        [bookmark: pgfId-418256]Table 29-4 [bookmark: 74623]Edit Group Member Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-418262]Element
          
  
         		
           
           [bookmark: pgfId-418264]Description
          
  
        

 
         
         		[bookmark: pgfId-418270]GET-Enabled Interface

  
         		[bookmark: pgfId-418272]The VPN-enabled outside interface to the provider edge (PE). Traffic originating or terminating on this interface is evaluated for encryption or decryption, as appropriate. You can configure multiple interfaces.

 [bookmark: pgfId-418274]Enter the name of the interface or interface role, or click Select to select it from a list or to create a new interface role.

  
        

 
         
         		[bookmark: pgfId-418280]Interface to be used as local address

  
         		[bookmark: pgfId-418282]The interface whose IP address is used to identify the group member to the key server for sending data, such as rekey information. If GET is enabled on only one interface, you do not need to specify the interface to be used as the local address. If GET is enabled on more than one interface, you must specify the interface to be used as the local address.

 [bookmark: pgfId-418284]Enter the name of the interface or interface role, or click Select to select it from a list or to create a new interface role.

  
        

 
         
         		[bookmark: pgfId-418290]Security Policy

  
         		[bookmark: pgfId-418295]The local group member security ACL used to deny some group member-specific traffic over and above the security ACL downloaded from the key server. Denied traffic is sent in clear text rather than encrypted. For detailed information, see Understanding the GET VPN Security Policy and Security Associations.

 [bookmark: pgfId-418297]Enter the name of the ACL object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-418303]Enable Fail Close

 [bookmark: pgfId-418305]Fail Close ACL

  
         		[bookmark: pgfId-418307]Whether to enable fail-close mode on the device, which prevents the device from transmitting clear text traffic before the device successfully registers with the key server. Fail-close mode requires as a minimum Cisco IOS Software release 12.4(22)T or 15.0; you can also configure it on all supported ASRs.

 [bookmark: pgfId-418312]Tip Fail-close mode is a complex feature, and you must carefully construct the fail-close ACL or you might lock yourself out of the device. Before enabling fail-close mode, read Configuring Fail-Close to Protect Registration Failures. [bookmark: pgfId-418314]You must select an ACL policy object that identifies allowable clear text traffic (using deny statements), such as SSH and SSL communications with the Security Manager server to allow for configuration updates. Enter then name of the object or click Select to select it or to create a new object.

  
        

 
         
         		[bookmark: pgfId-418320]Override Key Servers

  
         		[bookmark: pgfId-418322]Whether to override the key server list configured for the GET VPN topology as a whole for this particular group member.

 [bookmark: pgfId-418327]If you select this option, you can choose a subset of the key servers configured for the topology to be used by the selected group member, and change their priority order. This can help you load-balance registration activity among a group of cooperative key servers. For more information, see Configuring Redundancy Using Cooperative Key Servers.

 [bookmark: pgfId-418329]Click Select to change the key server list and priority order of the key servers using the Key Servers Selection dialog box. A key server must be defined for the GET VPN topology before you can modify its use for a group member.

  
        

 
         
         		[bookmark: pgfId-418335]Enable Passive SA Mode

  
         		[bookmark: pgfId-418337]Whether to put the group member into passive security association (SA) mode, which means the group member installs the SA in the inbound direction only. This means the group member can receive encrypted data, but it sends clear text data only. This mode is useful for testing the VPN only, primarily when you are migrating from an existing VPN to a GET VPN. (The group member must be running Cisco IOS Software version 12.4(22)T or 15.0 at minimum, or be a supported ASR, to use this mode.)

 [bookmark: pgfId-418339]This setting is similar to the Receive Only setting in the Group Encryption Policy, which applies to the topology as a whole. This group member option overrides the setting in the Group Encryption Policy.

 [bookmark: pgfId-418344]For detailed information on how you can use these passive mode features to migrate or test a GET VPN, see Using Passive Mode to Migrate to GET VPN.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-420103][bookmark: 74685][bookmark: vpchap_proc_UsingPassiveModetoMigratetoGETVPN]Using Passive Mode to Migrate to GET VPN[bookmark: marker-420093][bookmark: marker-420095][bookmark: marker-420097][bookmark: marker-420099][bookmark: marker-420101]

 
    [bookmark: pgfId-420105]If you are migrating an existing VPN to the GET VPN technology, especially a clear-text VPN, you can use two features to help you migrate in a phased approach to help prevent network down-time. The features are essentially the same, and involve the passive acceptance of encrypted traffic, but you configure them on different devices in the GET VPN.

 
    [bookmark: pgfId-420107]Normally, in a fully-deployed GET VPN, traffic is encrypted in both directions (bidirectional security associations, or SAs). However, during testing, you can use passive mode. In passive mode, the group member installs the SA in the inbound direction only, so that the group member receives encrypted traffic but sends traffic in clear text. You can then test the VPN to ensure that it is performing as expected before turning on full encryption.

 
    [bookmark: pgfId-420109]Use the following features to configure passive mode in a GET VPN:

 
     
     		 [bookmark: pgfId-420111] SA Receive-only mode —You configure receive-only mode for security associations on the key servers in the topology using the Group Encryption Policy. Thus, the setting applies to the entire topology.

 
     		 [bookmark: pgfId-420113] Passive SA mode —You configure passive security association mode on individual group members. This setting overrides the SA receive-only setting; thus, you can turn on full encryption for the entire topology, but leave some group members in passive mode. This lets you test the group members in stages and enable full encryption after you verify each member device.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-420115]Tip Passive SA mode on group members requires Cisco IOS Software release 12.4(22)T+ or 15.0+, or Release 2.3 (12.2(33)XNC)+ on ASRs.


    
     

    

    

 
    [bookmark: pgfId-420117]The following procedure shows an example of the end-to-end migration process you might follow to convert to GET VPN using these passive mode features.

 
    [bookmark: pgfId-420119]Related Topics

 
     
     		 [bookmark: pgfId-420124]Understanding Group Encrypted Transport (GET) VPNs

 
     		 [bookmark: pgfId-420129]Configuring GET VPN

 
    

 
    
 
    [bookmark: pgfId-420131]Step 1 Create the new GET VPN topology in Security Manager using the Create VPN wizard. When you are in the wizard, ensure that you make these selections:

 
     
     		 [bookmark: pgfId-420136]When selecting devices, choose the key servers for the topology, but for group members, select the first set of group members that will be migrated. For more information, see Selecting Devices for Your VPN Topology.

 
     		 [bookmark: pgfId-420141]When configuring the group encryption settings, select  Receive Only . This enables the SA receive-only feature for the entire topology. For more information, see Defining GET VPN Group Encryption.

 
    

 
    [bookmark: pgfId-420146]For information about creating VPNs, see Creating or Editing VPN Topologies.

 
    [bookmark: pgfId-420148]Step 2 Deploy the configurations to all devices in the VPN. The group members should now be able to receive encrypted traffic but not send it. For information on the deployment process, see the following topics based on the Workflow mode you are using:

 
     
     		 [bookmark: pgfId-420153]Deploying Configurations in Non-Workflow Mode

 
     		 [bookmark: pgfId-420158]Deploying Configurations in Workflow Mode

 
    

 
    [bookmark: pgfId-420160]Step 3 Outside of Security Manager, verify that all of the group members are functioning properly.

 
    [bookmark: pgfId-420162]For example, you can test whether the group members are able to send and receive encrypted packets using some CLI commands on the group member devices:

 
     
     		 [bookmark: pgfId-420164]On group member 1, configure the following command, where “groupexample” is the name of the GDOI group for the VPN. This command sets the device to accept encrypted or clear text, but to send only clear text.

 
    

 
    [bookmark: pgfId-420166]crypto gdoi gm group groupexample ipsec direction inbound only

 
     
     		 [bookmark: pgfId-420168]On group member 2, configure the following command. This command sets the device to accept encrypted or clear text, but to send encrypted text.

 
    

 
    [bookmark: pgfId-420170]crypto gdoi gm group groupexample ipsec direction inbound optional

 
     
     		 [bookmark: pgfId-420172]Ping group member 1 from group member 2. Group member 2 should encrypt the packet before sending it, and group member 1 should accept it and decrypt it. If you ping member 2 from member 1, the ping should be sent in clear text and accepted by member 2. Ensure that your ACLs allow pings.

 
    

 
    [bookmark: pgfId-420177]Step 4 In Security Manager, select Manage > Site-to-Site VPNs (see Site-to-Site VPN Manager Window).

 
    [bookmark: pgfId-420179]Select the GET VPN topology, then select Group Members.

 
    [bookmark: pgfId-420181]Add the remaining group members that you want to add to the topology (click the Add Group Member (+) button, select the devices, and click OK).

 
    [bookmark: pgfId-420183]If you want to use passive mode to test the new group members before enabling full encryption, ensure that you select Enable Passive SA Mode when configuring the group members:

 
     
     		 [bookmark: pgfId-420185]To configure an individual group member, select it and click the  Edit Group Member (pencil) button.

 
     		 [bookmark: pgfId-420187]To enable passive mode on more than one device at a time, use Shift+click or Ctrl+click to select multiple devices, then right-click and select  Edit Passive SA Mode . You can then select the option and click  OK .

 
    

 
    [bookmark: pgfId-420192]For more information on configuring group members, see Configuring GET VPN Group Members.

 
    [bookmark: pgfId-420194]Step 5 Deploy the configuration changes to all devices in the VPN. All devices should be operating in passive mode at this point.

 
    [bookmark: pgfId-420196]Step 6 In the Site-to-Site VPN Manager, select the GET VPN topology, then select Group Encryption Policy.

 
    [bookmark: pgfId-420198]Deselect Receive Only. This turns off SA receive-only mode at the topology level.

 
    [bookmark: pgfId-420200]Step 7 Deploy the configuration changes to all devices in the VPN. Now the GET VPN should be operating in fully encrypted mode for the original group members that you tested. Any new members that you added with passive SA mode enabled should be receiving encrypted traffic and sending clear text traffic.

 
    [bookmark: pgfId-420202]Step 8 Use the following process to verify the new devices and to turn off passive mode. You can follow this process for all new devices at once, or you can do smaller groups of them at a time. You can also use this process for new group members as you extend your network. Iterate the following steps as appropriate:

 
    [bookmark: pgfId-420204] a. Verify that the new group members are functioning properly using the same techniques that you used to verify the original group members.

 
    [bookmark: pgfId-420206] b. When you are ready to move a set of group members to fully-encrypted mode, in the Site-to-Site VPN Manager, select the GET VPN topology and select Group Members.

 
    [bookmark: pgfId-420208] c. Select all passive mode group members that should use full encryption, right-click and select Edit Passive SA Mode. Deselect the Enable Passive SA Mode option and click OK.

 
    [bookmark: pgfId-420210] d. Deploy configurations to all devices in the VPN, not just the ones whose passive mode you changed. Normally, you should not deploy to less than all devices in a VPN.

 
    [bookmark: pgfId-420212]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-420220][bookmark: 74810][bookmark: vpchap_cncpt_TroubleshootingGETVPNConfigurations]Troubleshooting GET VPN Configurations [bookmark: marker-420218]

 
    [bookmark: pgfId-420222]If after provisioning and deploying GET VPN using Security Manager, the GET VPN is not working, check the following:

 
     
     		 [bookmark: pgfId-420227]Ensure that the RSA key is synchronized among all cooperative key servers (that is, the RSA key is the same). For information on how to synchronize keys, see Generating and Synchronizing RSA Keys.

 
     		 [bookmark: pgfId-420232]If desired traffic is not being encrypted, make sure the key server security policy ACL (security association) has a permit ACE for the desired traffic. For asymmetric ACEs (where the source and destination addresses are different), ensure that there is a mirrored ACE (with the source and destination addresses reversed). For more information, see Understanding the GET VPN Security Policy and Security Associations.

 
     		 [bookmark: pgfId-420237]For multicast rekey, make sure that the network is multicast enabled and that all key servers and most group members are configured to enable multicast. You must enable multicast on the devices directly; Security Manager does not provision the commands required to enable multicast. For more information, see Choosing the Rekey Transport Mechanism.

 
     		 [bookmark: pgfId-420239]When using multicast rekey, check whether there is a deny ACE in the key server security ACL for the multicast group address to prevent encryption of multicast rekey messages.

 
     		 [bookmark: pgfId-420244]Check that the local security ACL on the group member has only deny ACEs. If you include a permit statement in an attempt to identify traffic that should be encrypted, the matching traffic is actually dropped because there is no corresponding IPsec SA. Because the permit entry is defined in the group member, the key server is not aware of it and cannot generate the required IPsec SA. For more information, see Understanding the GET VPN Security Policy and Security Associations.

 
     		 [bookmark: pgfId-420246]For group member authorization using certificates, check that the ISAKMP authentication uses certificates and that a PKI policy is configured. ISAKMP identity on the group member and key server should be set to use the distinguished name (dn).

 
     		 [bookmark: pgfId-420248]Normally, network address translation (NAT) is not used in the type of WAN environments where GET VPN is deployed. However, if you use NAT, ensure that the security policy ACL has permit statements for the translated addresses. Also, if you are using Network Address Translation-Traversal (NAT-T), the GDOI protocol port changes to 4500.

 
     		 [bookmark: pgfId-420250]A control plane replay protection mechanism was added to Cisco IOS Software releases 12.4(15)T10, 12.4(22)T3, 12.4(24)T2, 15.0(1)M, and 12.2(33)XNE. This mechanism is not backward-compatible, so if any GET VPN group member in the network is running any of these (or later) releases, you must also upgrade all key servers to one of these (or newer) releases. Otherwise, network disruption might occur because of a failed rekey, which causes one of the following system logging (syslog) messages to appear:

 
    

 
    [bookmark: pgfId-420252] – %GDOI-3-GDOI_REKEY_SEQ_FAILURE: Failed to process rekey seq # 2 in seq payload for group get-group, last seq # 6

 
    [bookmark: pgfId-420254] – %GDOI-3-PSEUDO_TIME_TOO_OLD: Rekey received in group get-group is too old and failed PST check: my_pst is 184 sec, peer_pst is 25 sec, allowable_skew is 10 sec

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-420258]Tip For additional troubleshooting tips from the CLI configuration perspective, including information about valuable show commands, see Cisco Group Encrypted Transport VPN on Cisco.com.


    
     

    

    

 
    [bookmark: pgfId-420260]Related Topics

 
     
     		 [bookmark: pgfId-420265]Understanding Group Encrypted Transport (GET) VPNs

 
     		 [bookmark: pgfId-420270]Configuring GET VPN
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     [bookmark: pgfId-799600][bookmark: 38495][bookmark: porules_intro_ManagingIdentityAwareFirewallPolicies]Managing Identity-Aware Firewall Policies[bookmark: marker-799596][bookmark: marker-799598]
      
      
 
     
 

 
    [bookmark: pgfId-799602]Identity-aware firewall policies allow you to control traffic based on user identity or a host’s fully-qualified domain name. For example, you can selectively allow a specific type of traffic for one user group while disallowing it for another user group, instead of allowing or disallowing all of that traffic. With fully-qualified domain names, you could disallow HTTP access to a specific server while allowing HTTP traffic to all other servers.

 
    [bookmark: pgfId-799604]Identity awareness is integrated into several existing firewall rules; there is no unique identity-aware firewall policy. This chapter explains identity-aware firewall policies and how to implement them in the various policies that support identity awareness.

 
    [bookmark: pgfId-799606]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-799611]Overview of Identity-Aware Firewall Policies

 
     		 [bookmark: pgfId-799616]Configuring Identity-Aware Firewall Policies

 
     		 [bookmark: pgfId-799621]Monitoring Identity Firewall Policies

 
    

 
   
 
    
     [bookmark: pgfId-799631][bookmark: 38506][bookmark: porules_intro_OverviewofIdentityAwareFirewallPolicies]Overview of Identity-Aware Firewall Policies[bookmark: marker-799627][bookmark: marker-799629]

 
    [bookmark: pgfId-799633]In traditional firewall policies, decisions are made based on source and destination IP addresses, ports, and services. The Identity Firewall in the ASA provides more granular control based on either or both of the following:

 
     
     		 [bookmark: pgfId-799635]User identity—You can configure access rules and security policies based on user names and user group names rather than through source IP addresses alone. The ASA applies the security policies based on an association of IP addresses to Windows Active Directory login information and reports events based on the mapped user names instead of network IP addresses.

 
    

 
    [bookmark: pgfId-799639]The Identity Firewall integrates with Microsoft Active Directory in conjunction with an external Active Directory (AD) agent that provides the actual identity mapping. The ASA uses Windows Active Directory as the source to retrieve the current user identity information for specific IP addresses and allows transparent authentication for Active Directory users. For information on setting up and configuring the AD agent, see Installation and Setup Guide for the Active Directory Agent on Cisco.com at http://www.cisco.com/en/US/products/ps6120/prod_installation_guides_list.html.

 
     
     		 [bookmark: pgfId-799641]FQDN network objects—You can use a host’s fully-qualified domain name (FQDN) in a rule instead of its IP address. Thus, if the host’s address changes (for example, because it acquires the address through DHCP), the rule will still apply.

 
    

 
    [bookmark: pgfId-799643]Identity-based firewall services enhance the existing access control and security policy mechanisms by allowing users or groups to be specified as sources, and FQDNs in place of source or destination IP addresses. Identity-based security policies can be interleaved without restriction between traditional IP address based rules.

 
    [bookmark: pgfId-799645]The key benefits of the Identity Firewall include:

 
     
     		 [bookmark: pgfId-799647]Decoupling network topology from security policies. The rules will apply to a user regardless of where the user connects in the network.

 
     		 [bookmark: pgfId-799649]Simplifying the creation of security policies.

 
     		 [bookmark: pgfId-799651]Providing the ability to easily identify user activities on network resources.

 
     		 [bookmark: pgfId-799653]Simplify user activity monitoring.

 
    

 
    [bookmark: pgfId-799655]This section contains the following topics:

 
     
     		 [bookmark: pgfId-799660]User Identity Acquisition

 
     		 [bookmark: pgfId-799665]Requirements for Identity-Aware Firewall Policies

 
     		 [bookmark: pgfId-799670]Configuring the Firewall to Provide Identity-Aware Services

 
    

 
     
      [bookmark: pgfId-799688][bookmark: 38535][bookmark: porules_cncpt_UserIdentityAcquisition]User Identity Acquisition[bookmark: marker-799676][bookmark: marker-799678][bookmark: marker-799680][bookmark: marker-799682][bookmark: marker-799684][bookmark: marker-799686]

 
     [bookmark: pgfId-799690]When you specify Active Directory user names or user group names in a firewall policy, the ASA eventually needs to map the name to an IP address to process packets. The ASA uses two primary sources for this information:

 
      
      		 [bookmark: pgfId-799692]User group membership—If you specify a user group in a rule, the ASA contacts the configured Active Directory (AD) server to obtain group membership.

 
      		 [bookmark: pgfId-799694]User-to-IP address mappings—For users who log into the network domain on your standard (non-VPN) network, the AD agent, in communication with the AD server, obtains the login information and creates a user-to-IP address mapping table. This information is supplied to the ASA.

 
     

 
     [bookmark: pgfId-799698]You must install and configure the required AD servers and agents before you can configure user-based identity firewall policies. For an explanation of the various deployment scenarios, see the ASA configuration guide for ASDM or CLI at http://www.cisco.com/en/US/products/ps6120/products_installation_and_configuration_guides_list.html.

 
     [bookmark: pgfId-799700]User names are acquired for the following types of traffic, and include the AD domain unless noted otherwise:

 
      
      		 [bookmark: pgfId-799702]Standard traffic.

 
      		 [bookmark: pgfId-799704]Remote access VPN, including IPsec IKEv1 and IKEv2, AnyConnect clients, and L2TP VPN. If you use LDAP authentication for the VPN, and use the same server group for a domain for the VPN and identity firewall, the users are associated with the domain used for authentication. For all other authorization mechanisms, users acquired through VPN are considered to be in the LOCAL domain. The ASA reports these users to the AD agent, which distributes them to other ASAs or clients registered with the AD agent.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-799706]Note User names are not acquired for clientless SSL VPN.


     
      

     

     

 
      
      		 [bookmark: pgfId-799711]IPv4 cut-through proxy. User names are not acquired for IPv6 cut-through proxy. If the user includes the domain name during authentication, the user is associated with the domain name. Otherwise, the domain is the default domain as configured in the Identity Options policy. See Configuring Cut-Through Proxy.

 
     

 
    
 
     
      [bookmark: pgfId-799727][bookmark: 38576][bookmark: porules_cncpt_RequirementsforIdentityAwareFirewallPolicies]Requirements for Identity-Aware Firewall Policies[bookmark: marker-799717][bookmark: marker-799719][bookmark: marker-799721][bookmark: marker-799723][bookmark: marker-799725]

 
      
       
        
        [bookmark: pgfId-798310]Table 13-1 [bookmark: 38598]Requirements for Identity-Aware Firewall Policies 

 
        
       
         
         		
           
           [bookmark: pgfId-798316]Requirement
          
  
         		
           
           [bookmark: pgfId-798318]Description
          
  
        

 
         
         		[bookmark: pgfId-798324]Firewall device

  
         		[bookmark: pgfId-798326]ASA running ASA Software version 8.4(2) or higher, but not including the ASA-SM running 8.5(1). Single or multiple context configurations.

 command. The output should include “Encryption hardware device.” [bookmark: pgfId-798330]You can register up to 100 ASAs with a single Active Directory agent.

  
        

 
         
         		[bookmark: pgfId-798336]Active Directory (AD)

  
         		[bookmark: pgfId-798338]You must use Active Directory to define users and user groups. The ASA obtains user group information directly from the AD server, which runs the LDAP protocol. You cannot use other types of LDAP servers.

 [bookmark: pgfId-798342]For detailed information on the types of AD servers supported, and their configuration requirements, see Installation and Setup Guide for the Active Directory Agent on Cisco.com at http://www.cisco.com/en/US/products/ps6120/prod_installation_guides_list.html.

 [bookmark: pgfId-798344]Tip You can have multiple AD servers, but they must have unique IP addresses among all domains. No other type of LDAP server is supported.  
        

 
         
         		[bookmark: pgfId-798350]AD agent

  
         		[bookmark: pgfId-798352]You must configure off-box AD agents to act as an intermediary between the ASA and the AD servers. The AD agent maintains an active mapping of users to IP address.

 [bookmark: pgfId-798354]By default, except for the 5505, the ASA obtains this list when it boots or reloads, and the AD agent sends new mappings as they are collected. The 5505 queries the AD agent on an as-needed basis in response to traffic matching rules that include identity criteria. We recommend that you use this default behavior, although you can change it using the Identity Options policy.

 [bookmark: pgfId-798356]The AD agent uses the RADIUS protocol.

 [bookmark: pgfId-798360]For information on setting up and configuring the AD agent, see Installation and Setup Guide for the Active Directory Agent on Cisco.com at http://www.cisco.com/en/US/products/ps6120/prod_installation_guides_list.html.

  
        

 
         
         		[bookmark: pgfId-798366]Client systems

  
         		[bookmark: pgfId-798368]Users who pass traffic through the device must use one of the following client platforms:

 
           
           		 [bookmark: pgfId-798370]Windows XP SP3.

 
           		 [bookmark: pgfId-798372]Windows Vista.

 
           		 [bookmark: pgfId-798374]Windows 7.

 
           		 [bookmark: pgfId-798376]Other systems that use Active Directory in a manner consistent with the explicitly supported platforms.

 
          

  
        

 
         
         		[bookmark: pgfId-798382]IPv6

  
         		[bookmark: pgfId-798384]IPv6 is supported with the following exceptions:

 
           
           		 [bookmark: pgfId-798386]NetBIOS over IPv6 is not supported.

 
           		 [bookmark: pgfId-798388]Multiple IPv6 addresses on user workstations is not supported. Windows 64-bit systems can use temporary IPv6 addresses when initiating some communications. If a user registers with the AD agent using one IPv6 address, then initiates communication with another address, an identity-aware firewall rule for the user would not be applied and instead a rule that matches the second IPv6 address would be applied.

 
          

 [bookmark: pgfId-798390]There are two options for disabling the use of these temporary addresses:

 [bookmark: pgfId-798392] – Disable IPv6 routing advertisements on all interfaces on all networking devices in the network.

 [bookmark: pgfId-798394] – On each Windows machine, open a command window, enter the following commands, and reboot the workstation:

 [bookmark: pgfId-798396]netsh interface ipv6 set privacy state=disable

 [bookmark: pgfId-798398]netsh interface ipv6 set global randomizeidentifiers=disabled

  
        

 
         
         		[bookmark: pgfId-798406]NetBIOS logout probing[bookmark: marker-798404]

 [bookmark: pgfId-798408](Optional.)

  
         		[bookmark: pgfId-798410]If you enable NetBIOS logout probing, the ASA can use NetBIOS to determine if an inactive user is logged off so the user can be removed from the database. The probe uses UDP-encapsulated NetBIOS traffic. Thus, you must ensure that access rules allow the following traffic on the networks between the ASA, AD agent, and user workstations:

 
           
           		 [bookmark: pgfId-798412]Query packets: any UDP source port to UDP port 137 (UDP/137).

 
           		 [bookmark: pgfId-798414]Query responses: UDP/137 source to any UDP port.

 
          

 [bookmark: pgfId-798416]In addition, you must configure workstations to provide user name information in NetBIOS reply packets. For Windows workstations, you need to enable the messenger service and configure WINS. If the messenger service is not turned on, the response from the workstation is the same whether the user is logged on or off.

 [bookmark: pgfId-798418]Tips

 
           
           		 [bookmark: pgfId-798420]The NetBIOS logout probe is never used with VPN or cut-through proxy users.

 
           		 [bookmark: pgfId-798422]The ASA has an inactive user timeout that is also used to remove users from the database. The timer applies to all user types. Thus, implementing NetBIOS probing is not required to remove inactive users from the database.

 
          

  
        

 
         
         		[bookmark: pgfId-798428]DNS configuration

 [bookmark: pgfId-798430](Required for fully-qualified domain name usage.)

  
         		[bookmark: pgfId-798435]If you use fully-qualified domain name (FQDN) network/host objects in firewall rules, you must configure the domain name system (DNS) settings as described in DNS Page. These settings identify the DNS servers used for looking up the names to determine the associated IP address. All processing is ultimately based on the IP address.

 [bookmark: pgfId-798437]When configuring DNS for FQDN usage, consider the following points:

 
           
           		 [bookmark: pgfId-798439]DNS replies can be spoofed, which can open a security hole in your network. Specify only trusted DNS servers, ideally only those inside your network.

 
           		 [bookmark: pgfId-798441]Some hosts can have constantly changing multiple IP addresses, so the ASA might not always have all valid IP addresses at any one time.

 
           		 [bookmark: pgfId-798443]Host names with short time to live values will require frequent DNS lookups; this can impact the performance of the ASA.

 
           		 [bookmark: pgfId-798445]Multiple host names can resolve to the same IP address. Ultimately, the firewall rules are applied based on IP address. Thus, if two names map to the same address, and your rules specify different services for those names, the service that is actually provided will be those specified on the first matched rule.

 
          

 [bookmark: pgfId-798447]Looked at another way, this means that you do not need to specify every version of an FQDN host name in your rules. When you know that several names always point to the same host, you can configure rules for the most commonly-used name and they will apply to all synonyms of that name.

  
        

 
         
         		[bookmark: pgfId-798453]Maximum limits

  
         		[bookmark: pgfId-798455]There are limits to the number of users, user groups, and IP addresses per user. If these limits are exceeded, identity-aware processing will not occur for the additional traffic:

 
           
           		 [bookmark: pgfId-798457]IP address limits—A user can be associated with at most 8 IP addresses across all domains.

 
           		 [bookmark: pgfId-798459]User group limits—Policies can be applied to up to 256 user groups. Users can be in multiple user groups.

 
           		 [bookmark: pgfId-798461]User limits—Policies can be applied to up to the following number of users. This number is the total aggregate across all contexts defined on the device.

 
          

 [bookmark: pgfId-798463] – ASA 5505—1024 users.

 [bookmark: pgfId-798465] – Other ASA 5500 series—64,000 users.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-799744][bookmark: 38727][bookmark: porules_proc_ConfiguringtheFirewalltoProvideIdentityAwareServices]Configuring the Firewall to Provide Identity-Aware Services[bookmark: marker-799738][bookmark: marker-799740][bookmark: marker-799742]

 
     [bookmark: pgfId-799746]To provide identity-aware firewall services to your network, you need to configure several policies to enable the firewall to process user-based or fully-qualified domain name (FQDN)-based rules. The ASA depends on other servers in your network to provide the user, user group, and FQDN name resolution services required to implement your identity-aware policies.

 
     [bookmark: pgfId-799748]The required configuration depends on which aspects of identity awareness that you will use:

 
      
      		 [bookmark: pgfId-799750]User, user group resolution—To use identity user group objects in your firewall rules, you must configure several objects and policies to identify the Active Directory servers that will supply user and user group information.

 
      		 [bookmark: pgfId-799752]FQDN resolution—To use FQDN network/host objects in your firewall rules, you must configure DNS servers to resolve FQDNs to IP addresses.

 
     

 
     [bookmark: pgfId-799754]This procedure explains the overall process for implementing identity-aware policies.

 
     [bookmark: pgfId-799756]Before You Begin

 
     [bookmark: pgfId-799761]Your network must meet the requirements explained in Requirements for Identity-Aware Firewall Policies. The following procedure assumes that you are already using Active Directory (AD), that you have installed and configured the AD agents, and that these services are working correctly.

 
     
 
     [bookmark: pgfId-799763]Step 1 Enable AD user and user group resolution.

 
     [bookmark: pgfId-799768] a. Create the policy objects needed to identify the AD servers and agents and configure the NetBIOS domain for the server groups. For detailed information, see Identifying Active Directory Servers and Agents.

 
     [bookmark: pgfId-799773] b. If you want non-default settings, change the identity options. Use these options to enable the NetBIOS logout probe and to configure various timers and error handling. For detailed information, see Configuring Identity Options.

 
     [bookmark: pgfId-799778] c. If you want to create user groups defined on the ASA (in addition to AD-defined user groups), create the required identity user group policy objects. See Creating Identity User Group Objects.

 
     [bookmark: pgfId-799780]Step 2 Enable FQDN network/host object resolution.

 
     [bookmark: pgfId-799785] a. Configure DNS servers in the DefaultDNS group. DNS is required to resolve FQDNs to IP addresses. For information on configuring DNS, see DNS Page.

 
     [bookmark: pgfId-799790] b. Create FQDN network/host objects as described in Creating Networks/Hosts Objects.

 
     [bookmark: pgfId-799795]Step 3 Configure firewall rules to use FQDN objects, usernames, user group names, or identity user group objects. See Configuring Identity-Based Firewall Rules.

 
     [bookmark: pgfId-799800]Step 4 Monitor the identity firewall system. See Monitoring Identity Firewall Policies.

 
     [bookmark: pgfId-799802]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-799812][bookmark: 38784][bookmark: porules_intro_ConfiguringIdentityAwareFirewallPolicies]Configuring Identity-Aware Firewall Policies[bookmark: marker-799808][bookmark: marker-799810]

 
    [bookmark: pgfId-799814]Identity awareness is integrated into several existing firewall rules; there is no unique identity-aware firewall policy. The topics in this section explain the various procedures for integrating identity awareness into firewall policies.

 
    [bookmark: pgfId-799816]This section contains the following topics:

 
     
     		 [bookmark: pgfId-799821]Enabling Identity-Aware Firewall Services

 
     		 [bookmark: pgfId-799826]Creating Identity User Group Objects

 
     		 [bookmark: pgfId-799831]Selecting Identity Users in Policies

 
     		 [bookmark: pgfId-799836]Configuring Identity-Based Firewall Rules

 
     		 [bookmark: pgfId-799841]Configuring Cut-Through Proxy

 
     		 [bookmark: pgfId-799846]Collecting User Statistics

 
     		 [bookmark: pgfId-799851]Filtering VPN Traffic with Identity-Based Rules

 
    

 
     
      [bookmark: pgfId-799863][bookmark: 38794][bookmark: porules_cncpt_EnablingIdentityAwareFirewallServices]Enabling Identity-Aware Firewall Services[bookmark: marker-799857][bookmark: marker-799859][bookmark: marker-799861]

 
     [bookmark: pgfId-799865]Use the Identity Options policy to enable identity-aware firewall services. To configure the policy, do one of the following:

 
      
      		 [bookmark: pgfId-799867](Device view) Select an ASA device, then select  Identity Options from the Policy selector.

 
      		 [bookmark: pgfId-799869](Policy view) Select  Identity Options (ASA) from the Policy selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-799871]The policy includes the following tabs:

 
      
      		 [bookmark: pgfId-799876] AD Setup —Configure the Active Directory servers that define the users and user groups for the network, and the AD agent used to collect the information and provide it to the ASA. See Identifying Active Directory Servers and Agents.

 
      		 [bookmark: pgfId-799881] Advanced —Enable or disable user identity services and configure options for error handling, the NetBIOS logout probe, idle timeout, and AD agent communication settings. See Configuring Identity Options.

 
     

 
    
 
     
      [bookmark: pgfId-799895][bookmark: 38824][bookmark: porules_proc_IdentifyingADServersandAgents]Identifying Active Directory Servers and Agents[bookmark: marker-799889][bookmark: marker-799891][bookmark: marker-799893]

 
     [bookmark: pgfId-799897]Use the AD Setup tab of the Identity Options policy to identify the Active Directory servers and agents to use for user identity information. You must configure at least one AD server and one AD agent to enable identity-aware firewall policies that include user specifications (such as identity user group objects).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-799899]Note ASA Software 8.4(2+) is required for identity-aware firewall.


     
      

     

     

 
     [bookmark: pgfId-799901]Before You Begin

 
     [bookmark: pgfId-799903]The configuration uses AAA server group policy objects, and the server group objects incorporate AAA server objects. You can create these objects through the Policy Object Manager (by selecting Manage > Policy Objects), or you can create them while completing this procedure (by using the configuration wizard or by clicking the Add Object + button in the object selector dialog box).

 
     [bookmark: pgfId-799905]The objects need to meet these requirements:

 
      
      		 [bookmark: pgfId-799907]AD servers—Must use the LDAP protocol. If you select Microsoft as the LDAP server type, you can also specify the LDAP Group Base DN to identify the base directory for user group searches, to reduce search time. If you select Auto Detect, you cannot configure the group base DN, even though Microsoft AD servers are the only type of LDAP server that you can use in the identity firewall configuration. You must also abide by the following limitations for communications between Security Manager and Active Directory:

 
     

 
     [bookmark: pgfId-799909] – Do not select the Enable LDAP over SSL option.

 
     [bookmark: pgfId-799911] – Do not select the SASL Kerberos Authentication option. Only simple and SASL MD5 authentication mechanisms are supported. The simple mechanism, in which usernames and passwords are transmitted in clear text, is used if you do not select one of the SASL options.

 
      
      		 [bookmark: pgfId-799913]AD agents—Must use the RADIUS protocol. In the AAA server group object, select the  AD Agent Mode option.

 
     

 
     [bookmark: pgfId-799915]You should install the AD agents and configure them prior to configuring this policy. You can configure at most two AD agents in the server group: the second agent is used only if the first agent ceases to respond to queries. Any agents defined after the first two are ignored.

 
     [bookmark: pgfId-799919]Obtain the AD agent software from http://www.cisco.com/go/asa. For information on setting up and configuring the AD agent, see Installation and Setup Guide for the Active Directory Agent on Cisco.com.

 
     [bookmark: pgfId-799921]Related Topics

 
      
      		 [bookmark: pgfId-799926]Requirements for Identity-Aware Firewall Policies

 
      		 [bookmark: pgfId-799931]Understanding AAA Server and Server Group Objects

 
      		 [bookmark: pgfId-799936]Creating AAA Server Objects

 
      		 [bookmark: pgfId-799941]AAA Server Dialog Box—LDAP Settings

 
      		 [bookmark: pgfId-799946]Creating AAA Server Group Objects

 
      		 [bookmark: pgfId-799951]Configuring Identity Options

 
     

 
     
 
     [bookmark: pgfId-799953]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-799955](Device view) Select an ASA device, then select  Identity Options from the Policy selector. Select the  AD Setup tab.

 
      		 [bookmark: pgfId-799957](Policy view) Select  Identity Options (ASA) from the Policy selector. Select an existing policy or create a new one. Select the  AD Setup tab.

 
     

 
     [bookmark: pgfId-799959]Step 2 If you want to be guided through the AD setup, click the Configure Identity button to start the Identity configuration wizard. The wizard walks you through the process of configuring the AD servers for a domain, and the AD agents, and can create the required AAA server and AAA server group objects for you.

 
     [bookmark: pgfId-799961]The wizard goes through the following steps:

 
      
      		 [bookmark: pgfId-799966]AD Server Settings—To configure the AD servers for a domain. See Identity Configuration Wizard Active Directory Settings.

 
      		 [bookmark: pgfId-799971]AD Agent Settings—To configure the AD agents for the ASA. See Identity Configuration Wizard Active Directory Agent.

 
      		 [bookmark: pgfId-799976]Preview—To show you which objects will be created. See Identity Configuration Wizard Preview.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-799978]Tip You can use the wizard multiple times to configure different NetBIOS domains. However, the wizard always prompts for AD agent information. Because you can configure a single group for AD agents, not a separate group per domain, the selection overwrites any AD agent configuration that you have already made. So be sure to select the same AAA server group for the AD agents each time you run the wizard.


     
      

     

     

 
     [bookmark: pgfId-799980]Step 3 If not using the wizard, configure the AD servers. The AD servers are used for obtaining user membership information for any AD user groups that you use in identity-aware firewall policies.

 
     [bookmark: pgfId-799982]The table lists the AD servers for the network. You need to add an entry for each NetBIOS domain name. Each row defines the AAA server group used to identify the AD LDAP servers for the domain, and whether identity-aware firewall rules for the domain are active or inactive if the AD server group is unavailable.

 
     [bookmark: pgfId-799984]You can do the following:

 
      
      		 [bookmark: pgfId-799989]To add an entry, click the  Add Row (+) button and fill in the Add AD Domain Server dialog box. See Domain AD Server Dialog Box.

 
      		 [bookmark: pgfId-799991]To edit an entry, select it and click the  Edit Row (pencil) button.

 
      		 [bookmark: pgfId-799993]To delete an entry, select it and click the  Delete Row (trash can) button.

 
     

 
     [bookmark: pgfId-799995]Step 4 If not using the wizard, configure the AD agents. The AD agents obtain user login/logoff and IP address mappings from the AD servers. The ASA then obtains the information from the AD agent.

 
     [bookmark: pgfId-799997]In Active Directory Agent Group, enter the name of the AAA server group object that defines the list of AD agents, or click Select to select it from a list or to create a new group object.

 
     [bookmark: pgfId-799999]Step 5 In Default Domain, select the domain to configure as the default domain on the device. You must add the domain to the AD server table before you can select it as the default domain.

 
     [bookmark: pgfId-800004]The default is LOCAL, which applies to user groups defined on the device or to VPN users who authenticate using a method other than an AD server configured for identity services. This setting is also used if you configure cut-through proxy (see Configuring Cut-Through Proxy).

 
     [bookmark: pgfId-800006]Step 6 Click Save to save your changes.

 
     [bookmark: pgfId-800008]You are asked if the identity settings page in the administrative settings should be updated with the domain-to-AD server mappings. The identity settings determine which servers are used when you use the Find feature when specifying users or user groups in a firewall policy or an identity user group object. The identity administrative settings do not affect the configuration of the ASA.

 
     [bookmark: pgfId-800010]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-800020][bookmark: 38938][bookmark: fwlsvcpg_cncpt_DomainADServerDialogBox]Domain AD Server Dialog Box[bookmark: marker-800018]

 
     [bookmark: pgfId-800022]Use the Add or Edit Domain AD Server dialog box to define the Active Directory server group for a NetBIOS domain. If you configure firewall rules for a user group in the NetBIOS domain, the user membership is determined by querying the AD servers defined for the domain.

 
     [bookmark: pgfId-800024]Navigation Path

 
     [bookmark: pgfId-800026]Do one of the following:

 
      
      		 [bookmark: pgfId-800031]From the AD Setup tab of the Identity Options page, click the Add or Edit buttons for the domain table. See Identifying Active Directory Servers and Agents.

 
      		 [bookmark: pgfId-800036]From the Identity Settings Security Manager Administration page, click the Add or Edit buttons for the settings table. These settings determine which servers are used when using Find to locate a user or user group name when configuring firewall rules or identity user group objects. See Identity Settings Page.

 
     

 
     [bookmark: pgfId-800038]Field Reference

 
     [bookmark: pgfId-800041] 

 
      
       
        
        [bookmark: pgfId-798478]Table 13-2 [bookmark: 38958]Domain AD Server Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-798484]Element
          
  
         		
           
           [bookmark: pgfId-798486]Description
          
  
        

 
         
         		[bookmark: pgfId-798492]Domain

  
         		[bookmark: pgfId-798494]The NetBIOS domain for this AD server group. The domain name can be up to 32 characters, typically in all uppercase. For example, if the user specification is DOMAIN\user1, DOMAIN is the NetBIOS domain name.

  
        

 
         
         		[bookmark: pgfId-798500]AD Server Group

  
         		[bookmark: pgfId-798502]The name of the AAA server group policy object that identifies the AD servers for this domain. The object must use the LDAP protocol.

 [bookmark: pgfId-798504]Click Select to select the object or to create a new one.

  
        

 
         
         		[bookmark: pgfId-798510]Disable Rules When Server Is Down

 [bookmark: pgfId-798512](Identity Options policy only.)

  
         		[bookmark: pgfId-798514]Whether to disable all identity-aware firewall rules for this domain if the domain controller is down. If you select this option, all users for a domain are marked as disabled until the server becomes available.

  
        

 
         
         		[bookmark: pgfId-798520]Update Administrative Settings

 [bookmark: pgfId-798522](Identity Options policy only.)

  
         		[bookmark: pgfId-798527]Whether to add the domain and server mapping to the Security Manager Administration Identity Settings page. This administrative page determines which AD servers are queried when you try to find users or user groups when adding them to firewall policies or to identity user group objects. For more information, see Identity Settings Page.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-800051][bookmark: 38994][bookmark: fwlsvcpg_cncpt_IdentityConfigurationWizardActiveDirectorySettings]Identity Configuration Wizard Active Directory Settings[bookmark: marker-800049]

 
     [bookmark: pgfId-800053]Use the Active Directory Settings page of the Identity Configuration wizard to identify the Active Directory (AD) servers for a NetBIOS domain. These settings are required to enable user-identity-aware firewall policies for users in the domain.

 
     [bookmark: pgfId-800055]Navigation Path

 
     [bookmark: pgfId-800057]Do one of the following:

 
      
      		 [bookmark: pgfId-800062]From the AD Setup tab of the Identity Options page, click the  Configure Identity button. See Identifying Active Directory Servers and Agents.

 
      		 [bookmark: pgfId-800064]If the Identity Options policy is not already configured, you can start the wizard from the AAA Rules, Access Rules, or Inspection Rules policies by clicking the Select button for the User field and then clicking Yes when asked if you want to configure identity.

 
     

 
     [bookmark: pgfId-800066]Field Reference

 
     [bookmark: pgfId-800069] 

 
      
       
        
        [bookmark: pgfId-798540]Table 13-3 [bookmark: 39015]Identity Configuration Wizard Active Directory Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-798546]Element
          
  
         		
           
           [bookmark: pgfId-798548]Description
          
  
        

 
         
         		[bookmark: pgfId-798554]NetBIOS Domain

  
         		[bookmark: pgfId-798556]The NetBIOS domain for this AD server group. The domain name can be up to 32 characters, typically in all uppercase. For example, if the user specification is DOMAIN\user1, DOMAIN is the NetBIOS domain name.

  
        

 
         
         		[bookmark: pgfId-798562]Select Existing AD Server Group

  
         		[bookmark: pgfId-798564]Select this option if the AAA server group policy object that identifies the required AD servers already exists. The object must use the LDAP protocol.

 [bookmark: pgfId-798566]Click Select next to the Group Name field to select the object.

  
        

 
         
         		[bookmark: pgfId-798572]Create New AD Server Group

  
         		[bookmark: pgfId-798574]Select this option if the AAA server group policy object does not already exist, or you want the wizard to create a new object.

 [bookmark: pgfId-798576]Configure the remaining options to identify the group and the servers that it contains.

  
        

 
         
         		 
           
           [bookmark: pgfId-798582]Create AD Server Group Properties
          
  
        

 
         
         		[bookmark: pgfId-798590]Group Name

 [bookmark: pgfId-798592](When creating the group in the wizard.)

  
         		[bookmark: pgfId-798594]The name of the AAA server group object that you want to create. The name can be up to 16 characters.

  
        

 
         
         		[bookmark: pgfId-798600]AD Server Name/IP

  
         		[bookmark: pgfId-798602]One of the following:

 
           
           		 [bookmark: pgfId-798604]The name of an existing AAA server object that defines the AD server. Click  Select to select the object from a list.

 
          

 [bookmark: pgfId-798606]If you select an object, you cannot configure the remaining properties.

 
           
           		 [bookmark: pgfId-798608]The IP address of the AD server.

 
          

  
        

 
         
         		[bookmark: pgfId-798614]Username

  
         		[bookmark: pgfId-798616]The name of the user or the directory object in the LDAP hierarchy used for authenticated binding (maximum of 128 characters). Authenticated binding is required by some LDAP servers (including the Microsoft Active Directory server) before other LDAP operations can be performed. This field describes the authentication characteristics of the device. These characteristics should correspond to those of a user with administrator privileges.

 [bookmark: pgfId-798618]This string is case-sensitive. Spaces are not permitted in the string, but other special characters are allowed.

 [bookmark: pgfId-798620]Typically, this is a username such as DOMAIN\Administrator. However, you can use the more traditional format too, for example, cn=Administrator,OU=Employees,DN=example,DN=com.

  
        

 
         
         		[bookmark: pgfId-798626]Password

 [bookmark: pgfId-798628]Confirm

  
         		[bookmark: pgfId-798630]The case-sensitive, alphanumeric password for accessing the LDAP server (maximum of 64 characters). Spaces are not allowed.

  
        

 
         
         		[bookmark: pgfId-798636]Interface

  
         		[bookmark: pgfId-798638]The interface whose IP address should be used for all outgoing packets (known as the source interface). Enter the name of an interface or interface role, or click Select to select it from a list or to create a new interface role.

 [bookmark: pgfId-798640]Tips

 
           
           		 [bookmark: pgfId-798642]If you enter the name of an interface, make sure the policy that uses this AAA object is assigned to a device containing an interface with this name.

 
           		 [bookmark: pgfId-798644]If you enter the name of an interface role, make sure the role represents a single interface, not multiple interfaces.

 
           		 [bookmark: pgfId-798646]Only one source interface can be defined for the AAA servers in a AAA server group, so if you specify more than one server, ensure that they all use the same interface.

 
          

  
        

 
         
         		[bookmark: pgfId-798652]Add Another AD Server

  
         		[bookmark: pgfId-798654]Click this button only if you want to create an additional server.

 [bookmark: pgfId-798656]When you click the button, the information in the server fields is saved and the fields are cleared so that you can add information about the next server. You can add up to 16 servers in single-context mode and 4 servers in multiple-context mode.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-800079][bookmark: 39101][bookmark: fwlsvcpg_cncpt_IdentityConfigurationWizardActiveDirectoryAgentSettings]Identity Configuration Wizard Active Directory Agent[bookmark: marker-800077]

 
     [bookmark: pgfId-800081]Use the Active Directory Agent Settings page of the Identity Configuration wizard to identify the Active Directory (AD) agents for a NetBIOS domain. These settings are required to enable user-identity-aware firewall policies for users in the domain.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-800083]Tip You can configure a single AD agent group for an ASA; you do not configure a different group for each NetBIOS domain. Thus, if you already configured the correct AD agent group in the Identity Options policy, select the same group on this wizard page. Your selection here will replace the group defined in the policy.


     
      

     

     

 
     [bookmark: pgfId-800085]Navigation Path

 
     [bookmark: pgfId-800087]Do one of the following:

 
      
      		 [bookmark: pgfId-800092]From the AD Setup tab of the Identity Options page, click the  Configure Identity button and proceed to this page. See Identifying Active Directory Servers and Agents.

 
      		 [bookmark: pgfId-800094]If the Identity Options policy is not already configured, you can start the wizard from the AAA Rules, Access Rules, or Inspection Rules policies by clicking the Select button for the User field and then clicking Yes when asked if you want to configure identity.

 
     

 
     [bookmark: pgfId-800096]Field Reference

 
     [bookmark: pgfId-800099] 

 
      
       
        
        [bookmark: pgfId-798669]Table 13-4 [bookmark: 39123]Identity Configuration Wizard Active Directory Agent Settings 

 
        
       
         
         		
           
           [bookmark: pgfId-798675]Element
          
  
         		
           
           [bookmark: pgfId-798677]Description
          
  
        

 
         
         		[bookmark: pgfId-798683]Select Existing AD Agent Group

  
         		[bookmark: pgfId-798685]Select this option if the AAA server group policy object that identifies the required AD agents already exists. The object must use the RADIUS protocol, and should have the option AD Agent Mode selected.

 [bookmark: pgfId-798687]Click Select next to the Group Name field to select the object.

  
        

 
         
         		[bookmark: pgfId-798693]Create New AD Agent Group

  
         		[bookmark: pgfId-798695]Select this option if the AAA server group policy object does not already exist, or you want the wizard to create a new object.

 [bookmark: pgfId-798697]Configure the remaining options to identify the group and the servers that it contains.

  
        

 
         
         		 
           
           [bookmark: pgfId-798703]Create AD Agent Group Properties
          
  
        

 
         
         		[bookmark: pgfId-798711]Group Name

 [bookmark: pgfId-798713](When creating the group in the wizard.)

  
         		[bookmark: pgfId-798715]The name of the AAA server group object that you want to create. The name can be up to 16 characters.

  
        

 
         
         		[bookmark: pgfId-798721]AD Agent Name/IP

  
         		[bookmark: pgfId-798723]One of the following:

 
           
           		 [bookmark: pgfId-798725]The name of an existing AAA server object that defines the AD agent. Click  Select to select the object from a list.

 
          

 [bookmark: pgfId-798727]If you select an object, you cannot configure the remaining properties.

 
           
           		 [bookmark: pgfId-798729]The IP address of the AD agent.

 
          

  
        

 
         
         		[bookmark: pgfId-798735]Secret Key

 [bookmark: pgfId-798737]Confirm

  
         		[bookmark: pgfId-798739]The shared secret that is used to encrypt data between the network device (client) and AAA server. The key is a case-sensitive, alphanumeric string of up to 127 characters. Special characters are permitted.

 [bookmark: pgfId-798741]The key you define in this field must match the key on the RADIUS server. Enter the key again in the Confirm field.

 [bookmark: pgfId-798743]If you do not define a key, all traffic between the AAA server and its AAA clients is sent unencrypted.

  
        

 
         
         		[bookmark: pgfId-798749]Interface

  
         		[bookmark: pgfId-798751]The interface whose IP address should be used for all outgoing packets (known as the source interface). Enter the name of an interface or interface role, or click Select to select it from a list or to create a new interface role.

 [bookmark: pgfId-798753]Tips

 
           
           		 [bookmark: pgfId-798755]If you enter the name of an interface, make sure the policy that uses this AAA object is assigned to a device containing an interface with this name.

 
           		 [bookmark: pgfId-798757]If you enter the name of an interface role, make sure the role represents a single interface, not multiple interfaces.

 
           		 [bookmark: pgfId-798759]Only one source interface can be defined for the AAA servers in a AAA server group, so if you specify more than one server, ensure that they all use the same interface.

 
          

  
        

 
         
         		[bookmark: pgfId-798765]Add Secondary AD Agent

  
         		[bookmark: pgfId-798767]Click this button only if you want to create an additional agent. The agent is used in case the first agent becomes unavailable.

 [bookmark: pgfId-798769]When you click the button, the information in the agent fields is saved and added to the preview pane, and the fields are cleared so that you can add information about the secondary agent.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-800109][bookmark: 39200][bookmark: fwlsvcpg_cncpt_IdentityConfigurationWizardPreview]Identity Configuration Wizard Preview[bookmark: marker-800107]

 
     [bookmark: pgfId-800111]Use the Preview page of the Identity Configuration wizard to verify the information you entered into the wizard.

 
     [bookmark: pgfId-800113]The preview summarizes the objects that will be created or used for the Active Directory configuration for the NetBIOS domain.

 
      
      		 [bookmark: pgfId-800115]AD server group shows the name of the AAA server group object for the AD servers used in the domain. The table shows the AAA server objects that define each of the AD servers.

 
      		 [bookmark: pgfId-800117]AD Agent shows the name of the AAA server group object for the AD agents. The primary and secondary agent shows the AAA server object that defines the agents.

 
     

 
     [bookmark: pgfId-800119]For objects that the wizard will create, names are automatically generated for the AAA server objects, either adding ldap_ or radius_ as a prefix to the server IP address.

 
     [bookmark: pgfId-800121]To make changes, click Back. Otherwise, click Finish to save the settings.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-800123]Tip After you complete the wizard, you can edit the properties of the newly-created objects to configure settings that the wizard left as default settings.


     
      

     

     

 
     [bookmark: pgfId-800125]Navigation Path

 
     [bookmark: pgfId-800127]Do one of the following:

 
      
      		 [bookmark: pgfId-800132]From the AD Setup tab of the Identity Options page, click the  Configure Identity button and proceed to this page. See Identifying Active Directory Servers and Agents.

 
      		 [bookmark: pgfId-800134]If the Identity Options policy is not already configured, you can start the wizard from the AAA Rules, Access Rules, or Inspection Rules policies by clicking the Select button for the User field and then clicking Yes when asked if you want to configure identity.

 
     

 
    
 
     
      [bookmark: pgfId-800150][bookmark: 39233][bookmark: porules_cncpt_ConfiguringIdentityOptions]Configuring Identity Options[bookmark: marker-800142][bookmark: marker-800144][bookmark: marker-800146][bookmark: marker-800148]

 
     [bookmark: pgfId-800152]Use the Advanced tab of the Identity Options policy to enable or disable user identity services and configure options for error handling, the NetBIOS logout probe, idle timeout, and AD agent communication settings. The options on this tab have default values, so you need to change them only if you want to fine-tune the settings for your network.

 
     [bookmark: pgfId-800154]Navigation Path

 
      
      		 [bookmark: pgfId-800156](Device view) Select an ASA device, then select  Identity Options from the Policy selector. Select the  Advanced tab.

 
      		 [bookmark: pgfId-800158](Policy view) Select  Identity Options (ASA) from the Policy selector. Select an existing policy or create a new one. Select the  Advanced tab.

 
     

 
     [bookmark: pgfId-800160]Related Topics

 
      
      		 [bookmark: pgfId-800165]Identifying Active Directory Servers and Agents

 
      		 [bookmark: pgfId-800170]Requirements for Identity-Aware Firewall Policies

 
     

 
     [bookmark: pgfId-800172]Field Reference

 
     [bookmark: pgfId-800175] 

 
      
       
        
        [bookmark: pgfId-798782]Table 13-5 [bookmark: 39274]Identity Options Advanced Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-798788]Element
          
  
         		
           
           [bookmark: pgfId-798790]Description
          
  
        

 
         
         		[bookmark: pgfId-798796]Enable User Identity

  
         		[bookmark: pgfId-798798]Whether to enable the device to obtain user identity information from the AD agent and AD servers, if they are configured on the AD Setup tab. The default is enabled.

 [bookmark: pgfId-798800]If you change this option and deploy, the change has the following effect based on the new setting:

 
           
           		 [bookmark: pgfId-798802]Disabled—The entire IP address to user mapping database is flushed and all users without activated user-specific rules are released. The AD agent and servers are no longer queried for updates, and all activated user-identity-based rules will have no effect on traffic.

 
           		 [bookmark: pgfId-798804]Enabled—Activated users are recreated gradually through communications with the AD agent. VPN users might need to reauthenticate. Queries to the AD agent and AD server recommence.

 
          

  
        

 
         
         		 
           
           [bookmark: pgfId-798810]Error Conditions
          
  
        

 
         
         		[bookmark: pgfId-798818]Disable Rules When Active Directory Agent Is Down

  
         		[bookmark: pgfId-798820]Whether to disable all rules that include user identity if the connection to the AD agent is unavailable. If you select this option, all user-to-IP address mappings are marked disabled and all rules that include user specifications are not applied to traffic. By default the option is disabled.

  
        

 
         
         		[bookmark: pgfId-798826]Remove User IP When NetBIOS Probe Fails

  
         		[bookmark: pgfId-798828]Whether to remove the User’s IP address mapping from the database if the NetBIOS probe for the user fails for any reason, whether the probe is somehow blocked in the network or the probe fails because the user is not in operation. The user must log into the workstation again. This option has effect only if you enable the NetBIOS logout probe on this page. By default the option is disabled.

  
        

 
         
         		[bookmark: pgfId-798834]Remove User IP When User’s MAC Address is Inconsistent

  
         		[bookmark: pgfId-798836]Whether to check the Media Access Control (MAC) address in each request from a user-mapped IP address to the MAC address in the previous packet.

 [bookmark: pgfId-798838]If you select this option, and the MAC address changes between packets, the user-to-IP address mapping is removed from the database, subsequent packets are dropped, and the user must reauthenticate to Active Directory. The AD agent is notified if the user-to-IP mapping is removed due to MAC mismatch. By default this option is enabled.

 [bookmark: pgfId-798840]MAC checking occurs only on packets from IP addresses on networks that are directly attached to the ASA. VPN users are not checked.

  
        

 
         
         		[bookmark: pgfId-798846]Track User Not Found

  
         		[bookmark: pgfId-798848]Whether to enable user-not-found tracking. By default, the option is disabled.

  
        

 
         
         		 
           
           [bookmark: pgfId-798854]NetBIOS Logout Probe
          
  
        

 
         
         		[bookmark: pgfId-798862]Enable (NetBIOS Logout Probe)

  
         		[bookmark: pgfId-798864]Whether to enable the NetBIOS logout probe.

 [bookmark: pgfId-798866]You can use the probe to proactively determine if a user has logged out of the network, allowing the device to remove the user-to-IP address mapping more quickly than if idle timeout is the only mechanism used for this purpose. By default the probe is disabled, and users are removed only if they are idle for longer than the Idle Timeout value.

 [bookmark: pgfId-798868]Users are probed only if they are in the active state and they are used in at least one activated rule. VPN and cut-through proxy users are not probed. The AD agent is notified if the user-to-IP mapping is removed by the NetBIOS logout probe.

 [bookmark: pgfId-798873]In addition to configuring the following options, see Requirements for Identity-Aware Firewall Policies.

  
        

 
         
         		[bookmark: pgfId-798879]Probe Timer

  
         		[bookmark: pgfId-798881]The frequency of sending NetBIOS probes to activated users, regardless of whether the user is idle. The default is 15 minutes, the range is 1 to 65535 minutes.

  
        

 
         
         		[bookmark: pgfId-798887]Retry Interval

  
         		[bookmark: pgfId-798889]The frequency of retrying the probe if a response is not received from an IP address, and the number of times the probe should be retried. The default is 3 seconds and 3 retries. The range is 1 to 65535 seconds, for retry count, 1 to 256.

 [bookmark: pgfId-798891]If there is no response from the final retry, the user-to-IP address mapping is removed if you selected the Remove User IP When NetBIOS Probe Fails option; otherwise, the address is probed during the next interval.

  
        

 
         
         		[bookmark: pgfId-798897]User Name

  
         		[bookmark: pgfId-798899]When a NetBIOS response is received, how to handle the response based on the usernames returned:

 
           
           		 [bookmark: pgfId-798901] Match Any (the default)—Any username in the response can match the username in the database for the IP address. If there are multiple names in the response (that is, more than one user is logged into the workstation), if any user in the response matches a user in the database, the probe is considered successful and the mapping is retained.

 
           		 [bookmark: pgfId-798903] User Not Needed —The usernames in the NetBIOS response are ignored; the query response is sufficient to maintain the user-to-IP address mapping. This option is useful if the messenger service is not turned on in the workstation, in which case the NetBIOS response will not contain usernames. The option is also useful when multiple users log into a workstation.

 
           		 [bookmark: pgfId-798905] Exact Match —There must be one username in the NetBIOS response, and it must exactly match the username in the user-to-IP address mapping database. If there is more than one user, or if the username does not match, the mapping is removed from the database and the IP address is marked as inactive.

 
          

  
        

 
         
         		 
           
           [bookmark: pgfId-798911]Users
          
  
        

 
         
         		[bookmark: pgfId-798919]Idle Timeout

  
         		[bookmark: pgfId-798921]The amount of time, in minutes, to allow the user to be idle before removing the user-to-IP address mapping in the database. Once removed, the user must log in again to update the mapping (for example, by using Ctrl+Alt+Delete to lock the workstation, then log in again). The default is 60 minutes, the range is 1 to 65535 minutes.

 [bookmark: pgfId-798923]You can deselect the option to disable idle timeout checking, in which case user-to-IP mappings are not removed due to idleness.

 [bookmark: pgfId-798925]VPN and cut-through proxy users are not subject to this timer. The AD agent is not notified if the user-to-IP address mapping is removed due to idle timeout.

  
        

 
         
         		 
           
           [bookmark: pgfId-798931]Active Directory Agent
          
  
        

 
         
         		[bookmark: pgfId-798939]Hello Timer

  
         		[bookmark: pgfId-798941]The frequency of sending Hello packets to the AD agent. The ASA uses Hello packets to obtain ASA replication status and domain status. If the ASA does not receive a response after the final retry, the AD agent is considered down, and the ASA switches to the backup AD agent, if you configure one.

 [bookmark: pgfId-798943]By default, Hello packets are sent every 30 seconds, and up to 5 retries are attempted if no response is received. The range is 10 to 65535 seconds and 1 to 65535 retries.

  
        

 
         
         		[bookmark: pgfId-798949]Poll Groups Timer

  
         		[bookmark: pgfId-798951]How often the Active Directory server should be queried to obtain user membership lists for user groups that you have specified in firewall rules. The ASA queries the server for membership in a group only if you have used the group; it does not query every group defined in the AD server. The default is 8 hours, the range is 1 to 65535 hours.

 [bookmark: pgfId-798953]Tip If group membership changes, the changes are not reflected in rule processing until this timer expires and the ASA polls the AD server for updated information. Thus, you should configure the timer based on the frequency of changes to group membership in your network, balancing the need to update group membership in the ASA with the desire to reduce the amount of polling.  
        

 
         
         		[bookmark: pgfId-798959]Retrieve User Information

  
         		[bookmark: pgfId-798961]How the ASA should retrieve user-to-IP address mappings from the AD agent.

 
           
           		 [bookmark: pgfId-798963] Full Download (default for ASA non-5505 devices)—On boot, the ASA obtains the full user-to-IP address mapping database from the AD agent, and then gets incremental updates as users log into and out of the network.

 
          

 [bookmark: pgfId-798965]Use this option on the 5505 only if there are fewer than 1024 users in the network, because the 5505 is limited to 1024 user-to-IP mappings. For the 5505, the default On Demand setting is appropriate if only a few users will pass traffic through the device.

 
           
           		 [bookmark: pgfId-798967] On Demand (default for ASA 5505 devices)—The ASA queries the AD agent for user-to-IP mappings only when a new packet requires a connection and no mapping exists. This option uses less memory, but there can be a delay in getting the mapping, and the packets are initially evaluated based on traditional source and destination IP address and service information, which might result in the wrong action. The potential delay can be increased if a large number of users log in at the same time, either due to corporate culture or to a malicious attack.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-800189][bookmark: 39408][bookmark: obman_proc_CreatingIdentityUserGroupObjects]Creating Identity User Group Objects[bookmark: marker-800183][bookmark: marker-800185][bookmark: marker-800187]

 
     [bookmark: pgfId-800191]You can create identity user group objects to identify individual users, user groups, or a combination of users and groups. These users and groups must be defined in Active Directory (AD), you cannot define other types of users.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-800193]Tip Identity user groups are defined on the ASA. You do not need to create these groups to duplicate groups that are already defined in AD. You can directly specify AD groups in firewall rules. Identity user group objects are needed only to define collections of users and user groups that do not otherwise exist in AD.


     
      

     

     

 
     [bookmark: pgfId-800198]There are two pre-defined identity user groups. These groups are used when configuring cut-through proxy, as described in Configuring Cut-Through Proxy.

 
      
      		 [bookmark: pgfId-800200]all-auth-users—To match any IP address that has been associated with an authenticated user.

 
      		 [bookmark: pgfId-800202]all-unauth-users—To match only IP addresses that have  not been associated with authenticated users.

 
     

 
     [bookmark: pgfId-800204]Tips

 
      
      		 [bookmark: pgfId-800206]Use of these objects is supported on ASA 8.4(2+) only.

 
      		 [bookmark: pgfId-800208]You must configure the Identity Options policy on the ASA to enable the use of these objects.

 
      		 [bookmark: pgfId-800213]You can create identity user group objects when defining policies or objects that use this object type. For more information, see Selecting Identity Users in Policies.

 
     

 
     [bookmark: pgfId-800215]Related Topics

 
      
      		 [bookmark: pgfId-800220]Configuring Identity-Based Firewall Rules

 
      		 [bookmark: pgfId-800225]Requirements for Identity-Aware Firewall Policies

 
      		 [bookmark: pgfId-800230]Identity Settings Page

 
      		 [bookmark: pgfId-800235]Creating Policy Objects

 
     

 
     
 
     [bookmark: pgfId-800240]Step 1 Select Manage > Policy Objects to open the Policy Object Manager (see Policy Object Manager).

 
     [bookmark: pgfId-800242]Step 2 Select Identity User Group from the Object Type selector.

 
     [bookmark: pgfId-800244]Step 3 Right-click in the work area, then select New Object to open the Identity User Group dialog box.

 
     [bookmark: pgfId-800246]Step 4 Enter a name for the object and optionally a description of the object.

 
     [bookmark: pgfId-800248]Step 5 Add and remove items in the Members in Group list to identify the users and user groups defined in the object.

 
     [bookmark: pgfId-800250]To populate the list, do any combination of the following:

 
      
      		 [bookmark: pgfId-800252]In  Available Identity User Group , select an existing object and click the  Add >> button between the lists.

 
      		 [bookmark: pgfId-800254]In  Search User/User Group , select a user or user group from the Active Directory server configured for the domain in the Identity Settings administration options. You must configure the settings before you can select users or user groups, so that Security Manager knows which AD server to use.

 
     

 
     [bookmark: pgfId-800256]To find a user or user group, select the NetBIOS domain, indicate whether you are searching for a user or user group, and enter a search string. Then, click Search to find matches. A name is considered a match if the string appears anywhere within the name (first, middle initial, last), user ID, CN, or for groups, user group name.

 
     [bookmark: pgfId-800258]To add the user or group, select it in the list and click the Add >> button between the lists.

 
      
      		 [bookmark: pgfId-800260]In  Type in comma separated identity user or user group , type in a valid name, then click the  Add >> button between the lists. Separate multiple names with commas; they are added as separate lines in the members list.

 
     

 
     [bookmark: pgfId-800262]You can enter names in the following formats:

 
     [bookmark: pgfId-800264] – Individual users: NETBIOS_DOMAIN\user

 
     [bookmark: pgfId-800266] – User groups (note the double \): NETBIOS_DOMAIN\\user_group

 
     [bookmark: pgfId-800268]If you do not include the domain name, one is added for you based on the options selected in the Security Manager Administration Identity Settings page. If you precede the name with \ or \\, the default domain defined on the Identity Settings page is automatically added.

 
      
      		 [bookmark: pgfId-800270]To remove an item from the object, select it in the Members list and click the  << Remove button between the lists.

 
     

 
     [bookmark: pgfId-800275]Step 6 (Optional) Under Category, select a category to help you identify this object in the Objects table. See Using Category Objects.

 
     [bookmark: pgfId-800280]Step 7 (Optional) Select Allow Value Override per Device to allow the properties of this object to be redefined on individual devices. See Allowing a Policy Object to Be Overridden.

 
     [bookmark: pgfId-800282]Step 8 Click OK to save the object.

 
     [bookmark: pgfId-800284]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-800298][bookmark: 39514][bookmark: obman_cncpt_SelectingIdentityUsersinPolicies]Selecting Identity Users in Policies[bookmark: marker-800292][bookmark: marker-800294][bookmark: marker-800296]

 
     [bookmark: pgfId-800300]In any policy or policy object that allows the specification of identity users, whether directly or through the selection of an identity user group object, you can click the Select button next to the User field to help you enter the information.

 
     [bookmark: pgfId-800302]In the Identity User Group Selector dialog box, you can define the content of the User field by populating the Members in Group list. To populate the list, do any combination of the following:

 
      
      		 [bookmark: pgfId-800304]In  Available Identity User Group , select an existing object and click the  Add >> button between the lists. If the desired object does not exist, you can click the  Add (+) button below the list to create a new object. You can also select an object and click the  Edit (pencil) button to modify it or to examine its contents.

 
     

 
     [bookmark: pgfId-800309]There are two pre-defined identity user groups. These groups are used when configuring cut-through proxy, as described in Configuring Cut-Through Proxy.

 
     [bookmark: pgfId-800311] – all-auth-users—To match any IP address that has been associated with an authenticated user.

 
     [bookmark: pgfId-800313] – all-unauth-users—To match only IP addresses that have not been associated with authenticated users.

 
      
      		 [bookmark: pgfId-800315]In  Search User/User Group , select a user or user group from the Active Directory server configured for the domain in the Identity Settings administrative options. You must configure the settings before you can select users or user groups, so that Security Manager knows which AD server to use.

 
     

 
     [bookmark: pgfId-800317]To find a user or user group, select the NetBIOS domain, indicate whether you are searching for a user or user group, and enter a search string. Then, click Search to find matches. A name is considered a match if the string appears anywhere within the name (first, middle initial, last), user ID, CN, or for groups, user group name.

 
     [bookmark: pgfId-800319]To add the user or group, select it in the list and click the Add >> button between the lists.

 
      
      		 [bookmark: pgfId-800321]In  Type in comma separated identity user or user group , type in a valid name, then click the  Add >> button between the lists. Separate multiple names with commas; they are added as separate lines in the members list.

 
     

 
     [bookmark: pgfId-800323]You can enter names in the following formats:

 
     [bookmark: pgfId-800325] – Individual users: NETBIOS_DOMAIN\user

 
     [bookmark: pgfId-800327] – User groups (note the double \): NETBIOS_DOMAIN\\user_group

 
     [bookmark: pgfId-800332]If you do not include the domain name, one is added for you based on the options selected in the Security Manager Administration Identity Settings page as explained in Identity Settings Page. If you precede the name with \ or \\, the default domain defined on the Identity Settings page is automatically added.

 
      
      		 [bookmark: pgfId-800334]To remove an item from the object, select it in the Members list and click the  << Remove button between the lists.

 
     

 
    
 
     
      [bookmark: pgfId-800370][bookmark: 39570][bookmark: porules_cncpt_ConfiguringIdentityBasedFirewallRules]Configuring Identity-Based Firewall Rules [bookmark: marker-800340][bookmark: marker-800342][bookmark: marker-800344][bookmark: marker-800346][bookmark: marker-800348][bookmark: marker-800350][bookmark: marker-800352][bookmark: marker-800354][bookmark: marker-800356][bookmark: marker-800358][bookmark: marker-800360][bookmark: marker-800362][bookmark: marker-800364][bookmark: marker-800366][bookmark: marker-800368]

 
     [bookmark: pgfId-800372]Identity awareness is integrated into the access control entries, or rules, in the ACLs used to provide firewall services. Because the feature is integrated into the ACL, the techniques for adding identity-based rules to a firewall policy are the same for all types of firewall policy. This topic provides general guidance on how to incorporate identity-based rules into your existing policies, and directs you to more specific information on configuring each type of policy that allows identity-based rules.

 
     [bookmark: pgfId-800374]Guidelines For Adding Identity-Based Rules

 
     [bookmark: pgfId-800376]Following are some general guidelines and recommendations for adding identity-based rules:

 
      
      		 [bookmark: pgfId-800381]FQDN (fully-qualified domain name) network/host objects are allowed in both Source and Destination fields. For information on configuring these objects, see Creating Networks/Hosts Objects.

 
      		 [bookmark: pgfId-800386]User, user group, and identity user group objects, which specify Active Directory (AD) user or user group names, are defined in a separate field: User. If you configure a rule with one or more user names, user group names, or identity user group objects, the specifications modify the Source address configuration only. They never apply to the addresses specified in the Destination field. For information on configuring these identity user group objects, see Creating Identity User Group Objects.

 
     

 
     [bookmark: pgfId-800388]You must always configure a source address in a rule, even if you want the rule to primarily operate based on the specified users or user groups. The source and user specifications conjoin to control the scope of the rule. Based on the value of the Source field, the rules operate as follows:

 
     [bookmark: pgfId-800390] – Source = any—Use “any” as the source if you want the rule to apply based solely on the user specifications. These rules will match the user specification regardless of the workstation IP address from which the user sends traffic.

 
     [bookmark: pgfId-800392] – Source = anything else—If you specify anything other than “any” as the source address, the rule applies only if the user sends traffic from an IP address that matches the source address specification. Use this technique if you want to provide variable services based on the source network.

 
     [bookmark: pgfId-800394]For example, you might have an internal trusted network from which you would allow access to a sensitive destination for users in a particular user group, although you would deny access even to those users if they were outside of the trusted network. In this case, you would create a permit rule that specified the trusted network as the source, the trusted user group as the user, and the sensitive server as the destination. You could also create a specific deny rule with just the source and destination specified, or allow the default deny any rule to capture the non-matching traffic.

 
      
      		 [bookmark: pgfId-800396]Evaluate whether there are classes of traffic that will never be sensitive to user identity. For example, you might allow DNS traffic for all users. Place these types of rules above identity-based rules so that matching traffic can be quickly allowed before the device needs to evaluate identity-based rules.

 
      		 [bookmark: pgfId-800398]When troubleshooting rules, keep in mind that ultimately rules are applied based on IP address. FQDN rule matching is based on DNS lookups, and the IP address of a host can change between a successful lookup and the next time the lookup is refreshed. For users, IP address mappings are obtained from the AD agent configured in the network or by authentications conducted by the ASA itself.

 
      		 [bookmark: pgfId-800400]FQDN and user specifications are completely independent. You can use one without the other.

 
     

 
     [bookmark: pgfId-800402]Firewall Policies That Allow Identity-Based Rules

 
     [bookmark: pgfId-800404]Identity-based rules are allowed on ASA 8.4.2+ only. The following policies allow you to configure identity-based rules:

 
      
      		 [bookmark: pgfId-800409]AAA Rules—Select  Firewall > AAA Rules and see Configuring AAA Rules for ASA, PIX, and FWSM Devices.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-800414]Tip You can use AAA rules to configure cut-through proxy, which allows users whose IP address mappings have become invalid, resulting in denied network access, to authenticate directly to the ASA to resolve the mapping problem. See Configuring Cut-Through Proxy.


     
      

     

     

 
      
      		 [bookmark: pgfId-800419]Access Rules—Select  Firewall > Access Rules and see Configuring Access Rules.

 
      		 [bookmark: pgfId-800424]Inspection Rules—Select  Firewall > Inspection Rules and see Configuring Inspection Rules.

 
      		 [bookmark: pgfId-800429]Policies that use extended ACL policy objects—Several firewall policies use extended ACL policy objects to define traffic matching criteria instead of incorporating a rule table directly in the policy. You can configure extended ACL policy objects to include FQDN objects or user specifications (see Creating Extended Access Control List Objects). You can then use these identity-based extended ACL objects in the following policies:

 
     

 
     [bookmark: pgfId-800434] – Botnet Traffic Filter Rules—Select Firewall > Botnet Traffic Filter Rules and see Enabling Traffic Classification and Actions for the Botnet Traffic Filter. You can use identity-based ACLs as traffic classification for Enable and Drop rules.

 
     [bookmark: pgfId-800439] – IPS, QoS, and Connection Rules (service policy rules)—Select Platform > Service Policy Rules > IPS, QoS, and Connection Rules and see Service Policy Rules Page.

 
     [bookmark: pgfId-800444]Traffic match criteria in this policy is based on extended ACL policy objects that are incorporated into traffic flow policy objects. You must select one of the options for specifying an ACL in the traffic flow object to incorporate identity-based traffic classification. You can use identity-based ACLs for all service types. For more information, see Configuring Traffic Flow Objects.

 
     [bookmark: pgfId-800449]One of the services available in this policy, User Statistics, is specifically designed to collect accounting information for identity-based firewall users. See Collecting User Statistics.

 
     [bookmark: pgfId-800457] – VPN filter in remote access group policies—The VPN filter ACL is applied to VPN traffic. You can configure a VPN filter on the Connection Settings page in an ASA Group Policy object, which you use in a remote access connection policy. See ASA Group Policies Connection Settings and Filtering VPN Traffic with Identity-Based Rules.

 
     [bookmark: pgfId-800459]Policies That Do Not Allow Identity-Based Rules or Objects

 
     [bookmark: pgfId-800461]There are several types of policy where you can specify network/host objects or extended ACL objects, but where the policy does not allow FQDN network/host objects or ACLs that use those objects or identity user group objects. Following are some examples where you cannot use these types of objects:

 
      
      		 [bookmark: pgfId-800463]Routing policies, including route maps.

 
      		 [bookmark: pgfId-800465]Network address translation (NAT).

 
      		 [bookmark: pgfId-800467]WCCP (web cache control protocol).

 
      		 [bookmark: pgfId-800469]Crypto maps in VPN configurations.

 
      		 [bookmark: pgfId-800471]Dynamic access policies in remote access VPN configurations.

 
     

 
    
 
     
      [bookmark: pgfId-800487][bookmark: 39704][bookmark: porules_proc_ConfiguringCutThroughProxy]Configuring Cut-Through Proxy[bookmark: marker-800477][bookmark: marker-800479][bookmark: marker-800481][bookmark: marker-800483][bookmark: marker-800485]

 
     [bookmark: pgfId-800489]When you use identity-aware firewall policies, user-to-IP address mappings are obtained from various facilities, primarily from the AD agent in the network. Although mappings are updated regularly, there can occur instances where a firewall rule blocks a legitimate user because the user-to-IP address mapping is not synchronized.

 
     [bookmark: pgfId-800491]You can configure cut-through proxy to account for this possibility. With cut-through proxy, if a user is blocked, the user can sign on directly to the ASA, and the ASA will update the user-to-IP mapping to correctly reflect the current IP address for the user. The new mapping is forwarded to all contexts that contain the interface where the HTTP/HTTPS packets are received and authenticated.

 
     [bookmark: pgfId-800493]You use AAA rules to configure cut-through proxy. You have two configuration choices, based on whether there is one or more NetBIOS domains in the network:

 
      
      		 [bookmark: pgfId-800495]Single domain—Configure a regular AAA rule for authentication and specify the LDAP server group that identifies the Active Directory servers for the domain. Use “any” for the source, and the IP address of the ASA for the destination. For service, you can include HTTP and HTTPS. Then, when the user needs to authenticate to the server, the user enters one of the standard authentication URLs, where  interface_ip is the IP address of the interface and  port is optionally the port number, if you specify a non-default port for the protocol in the interactive authentication table:  http://  interface_ip [ :  port ] /netaccess/connstatus.html or  https://  interface_ip [ :  port ] /netaccess/connstatus.html .

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-800497]Tip The user-to-IP mapping is put under the same domain as configured for the selected AD server group. If you use another means for authentication, the mapping is placed under the LOCAL domain.


     
      

     

     

 
      
      		 [bookmark: pgfId-800499]Multiple domains—Configure two authentication rules that use the User-Identity option instead of a specific AAA server group. The following procedure explains this setup. Note that this setup also works for single domain networks. Users authenticate to the ASA using the same URLs mentioned above.

 
     

 
     [bookmark: pgfId-800501]When you use the User-Identity option, authentication is handled as follows:

 
     [bookmark: pgfId-800503] – If the user includes the domain in the login credentials, in the format DOMAIN\username, the ASA uses the domain to determine which AD server to use for authentication based on the domain mappings in the Identity Options policy. If no AAA server is mapped to the domain, the authentication attempt is rejected.

 
     [bookmark: pgfId-800505] – If the login credentials do not include an identifiable domain name (typically, if the \ character is not included in the username string), the ASA uses the AD server assigned to the default domain selected in the Identity Options policy. If no AAA server is mapped to the default domain, the authentication attempt will be rejected.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-800507]Tip Cut-through proxy works for IPv4 addresses only; IPv6 is not supported.


     
      

     

     

 
     [bookmark: pgfId-800509]Related Topics

 
      
      		 [bookmark: pgfId-800514]Requirements for Identity-Aware Firewall Policies

 
      		 [bookmark: pgfId-800519]Configuring the Firewall to Provide Identity-Aware Services

 
      		 [bookmark: pgfId-800524]Configuring AAA Rules for ASA, PIX, and FWSM Devices

 
      		 [bookmark: pgfId-800529]Understanding How Users Authenticate

 
     

 
     
 
     [bookmark: pgfId-800534]Step 1 Configure the Identity Options policy to specify all of the NetBIOS domains and their AD server groups, and the AD agent group, for the network, as described in Identifying Active Directory Servers and Agents.

 
     [bookmark: pgfId-800539]Step 2 Do one of the following to open the AAA Rules Page:

 
      
      		 [bookmark: pgfId-800541](Device view) Select  Firewall > AAA Rules from the Policy selector.

 
      		 [bookmark: pgfId-800543](Policy view) Select  Firewall > AAA Rules from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-800548]Step 3 Create the following rules using the Add Row button. For detailed information about the fields in the Add AAA Rules dialog box, see Add and Edit AAA Rule Dialog Boxes.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-800550]Tip You can use more specific source, destination, or service specifications than the ones shown here.


     
      

     

     

 
      
      		 [bookmark: pgfId-800552] Rule 1: Do not force users who have already authenticated to authenticate again. 

 
     

 
     [bookmark: pgfId-800554] – Select the Authentication Action and User-Identity options.

 
     [bookmark: pgfId-800556] – Action = Deny. For AAA authentication rules, “deny” means the user is not prompted for authentication, it does not mean the user’s traffic is dropped.

 
     [bookmark: pgfId-800558] – Sources = any.

 
     [bookmark: pgfId-800560] – Users = all-auth-users.

 
     [bookmark: pgfId-800562]For users, all-auth-users means any user who has already authenticated to Active Directory, for which there is an IP mapping.

 
     [bookmark: pgfId-800564] – Destination = any.

 
     [bookmark: pgfId-800566] – Services = IP.

 
     [bookmark: pgfId-800568] – AAA Server Group = (no selection).

 
     [bookmark: pgfId-800570] – Interface = (your choice, typically inside interfaces).

 
      
      		 [bookmark: pgfId-800572] Rule 2: Authenticate users who have not been authenticated yet. 

 
     

 
     [bookmark: pgfId-800574] – Select the Authentication Action and User-Identity options.

 
     [bookmark: pgfId-800576] – Action = Permit. This action requires matching users to authenticate.

 
     [bookmark: pgfId-800578] – User = all-unauth-users.

 
     [bookmark: pgfId-800580]In this case, all-unauth-users means any user who has not already authenticated to Active Directory.

 
     [bookmark: pgfId-800582] – All other options are identical to the first rule.

 
     [bookmark: pgfId-800584]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-800598][bookmark: 39828][bookmark: porules_proc_CollectingUserStatistics]Collecting User Statistics[bookmark: marker-800590][bookmark: marker-800592][bookmark: marker-800594][bookmark: marker-800596]

 
     [bookmark: pgfId-800600]You can collect user statistics accounting information for identity-based firewall policies. These statistics are kept for users to which a firewall policy is applied based on username or user group membership.

 
     [bookmark: pgfId-800602]Related Topics

 
      
      		 [bookmark: pgfId-800607]Requirements for Identity-Aware Firewall Policies

 
      		 [bookmark: pgfId-800612]Configuring the Firewall to Provide Identity-Aware Services

 
      		 [bookmark: pgfId-800617]Service Policy Rules Page

 
      		 [bookmark: pgfId-800622]Configuring Traffic Flow Objects

 
     

 
     
 
     [bookmark: pgfId-800624]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-800626](Device view) Select an ASA device, then select  Platform > Service Policy Rules > IPS, QoS, and Connection Rules from the Policy selector.

 
      		 [bookmark: pgfId-800628](Policy view) Select  PIX/ASA/FWSM Platform > Service Policy Rules > IPS, QoS, and Connection Rules from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-800630]Step 2 Select the row after which you want to add the rule, then click the Add Row (+) button below the table to start the Insert Service Policy Rule wizard.

 
     [bookmark: pgfId-800632]Step 3 In step 1 of the wizard, select whether the rule will be Global or it will apply to specific interfaces or interface roles. Select Global if you want to collect statistics for users regardless of which interface their traffic passes through.

 
     [bookmark: pgfId-800634]Click Next.

 
     [bookmark: pgfId-800636]Step 4 In step 2, select the traffic class that defines the traffic for which you are collecting statistics. Select Use class-default if you want to collect statistics on all traffic. Otherwise, select Traffic Class and select the traffic flow object that defines the traffic matching attributes.

 
     [bookmark: pgfId-800638]Click Next.

 
     [bookmark: pgfId-800640]Step 5 In step 3, select the User Statistics tab.

 
      
      		 [bookmark: pgfId-800642]Select  Enable user statistics accounting .

 
      		 [bookmark: pgfId-800644]Select the type of information you want to collect:

 
     

 
     [bookmark: pgfId-800646] – Account for sent drop count

 
     [bookmark: pgfId-800648] – Account for sent packet, sent drop and received packet count

 
     [bookmark: pgfId-800650]Step 6 Click Finish to save your rule.

 
     [bookmark: pgfId-800652]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-800662][bookmark: 39901][bookmark: porules_cncpt_FilteringVPNTrafficWithIdentityBasedRules]Filtering VPN Traffic with Identity-Based Rules[bookmark: marker-800658][bookmark: marker-800660]

 
     [bookmark: pgfId-800664]When you support remote access VPNs on an ASA, you configure user-sensitive access. You can also use identity-based rules to filter the traffic after validating the remote user access.

 
     [bookmark: pgfId-800666]Before creating identity-based rules for VPN, understand the rules for VPN user names, to ensure that the rules use the correct domain name:

 
      
      		 [bookmark: pgfId-800668]If you use an Active Directory LDAP server group for authorization, and you configured that domain/server group in the Identity Options policy, the username is associated with the NetBIOS domain.

 
      		 [bookmark: pgfId-800670]For all other authorization mechanisms, the domain name for VPN users is LOCAL.

 
     

 
     [bookmark: pgfId-800672]With this in mind, there are two methods you can use to filter the traffic on the VPN with identity-based ACL rules:

 
      
      		 [bookmark: pgfId-800677]Apply a VPN filter in the ASA Group Policy object. The filter applies to all users in the group. You can configure a VPN filter on the Connection Settings page in an ASA Group Policy object, which you use in a remote access connection policy. See ASA Group Policies Connection Settings.

 
      		 [bookmark: pgfId-800682]By default, VPN traffic bypasses interface access rules. You can change this behavior so that all VPN traffic must also pass through the interface access rules. If you take this approach, you must ensure that the interface rules are sensitive to your VPN traffic. To force VPN traffic to go through interface access rules, deselect the  Enable IPsec over Sysopt option on the ISAKMP/IPsec tab of the RA VPN Global Settings policy. See Configuring VPN Global ISAKMP/IPsec Settings.

 
     

 
    
 
   
 
    
     [bookmark: pgfId-800696][bookmark: 39928][bookmark: porules_cncpt_MonitoringIdentityFirewallPolicies]Monitoring Identity Firewall Policies[bookmark: marker-800688][bookmark: marker-800690][bookmark: marker-800692][bookmark: marker-800694]

 
    [bookmark: pgfId-800701]You can use Event Viewer to monitor identity-aware firewall policies the same way you would monitor other types of policies and events. The following are some tips to help you effectively monitor identity policies. For general information on using Event Viewer, see Chapter 68, “Viewing Events”.

 
     
     		 [bookmark: pgfId-800705]There is a group of syslog messages that relate specifically to identity firewall: 746001-746019. You can find descriptions of these messages in the Syslog Message document for your ASA software version at  http://www.cisco.com/en/US/products/ps6120/products_system_message_guides_list.html .

 
    

 
    [bookmark: pgfId-800707]The following messages are of particular concern:

 
    [bookmark: pgfId-800712] – 746004 and 746011—These syslogs indicate that you have exceeded the supported number of references to user groups or users. You should consider changing your policies. For more information on these restrictions, see Requirements for Identity-Aware Firewall Policies.

 
    [bookmark: pgfId-800714] – 746003—There was a failure in downloading user group or user mappings to IP address. The message explains the reason for the failure.

 
    [bookmark: pgfId-800716] – 746005—The AD agent could not be reached. Ensure that the agent is functioning correctly and that there is a network path between the ASA and the agent.

 
    [bookmark: pgfId-800718] – 746010—An update to the imported user or user group failed for the stated reason.

 
    [bookmark: pgfId-800720] – 746016—DNS lookup for the fully-qualified domain name (FQDN) failed for the stated reason.

 
     
     		 [bookmark: pgfId-800722]Several existing syslog messages now include username or FQDN information. Event Viewer has two columns to display the information: Destination User Identity / FQDN and Source User Identity. Updated messages include:

 
    

 
    [bookmark: pgfId-800724] – 302005, 302006, 302013, 302014, 302016-302018, 302020, 302021.

 
    [bookmark: pgfId-800726] – 305005, 305006, 305009-305013.

 
    [bookmark: pgfId-800728] – 304001-304002 include identity information, but they are not parsed.

 
     
     		 [bookmark: pgfId-800730]You can filter on all identity-related syslog messages by creating a filter on Event Type and selecting the Identity Firewall Events folder.

 
     		 [bookmark: pgfId-800735]When you use the Go to Policy command on an event, as described in Looking Up a Security Manager Policy from Event Viewer, identity information is included in the lookup criteria. Note that identity information is not included in 106100, so policy lookup on that message cannot be sensitive to user identity.
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     [bookmark: pgfId-840522][bookmark: 68039][bookmark: vpchap_cncpt_WorkingwithSitetoSiteVPNPolicies]Configuring IKE and IPsec Policies[bookmark: marker-840506][bookmark: marker-840508][bookmark: marker-840510][bookmark: marker-840512][bookmark: marker-840514][bookmark: marker-840516][bookmark: marker-840518][bookmark: marker-840520]
      
      
 
     
 

 
    [bookmark: pgfId-840524]This chapter describes how to configure Internet Protocol Security (IPsec) and the Internet Security Association and Key Management Protocol (ISAKMP, or IKE) standards to build site-to-site and remote access IPsec Virtual Private Networks (VPNs). These policies are used in regular IPsec and other types of IPsec-based VPN technologies to build VPN tunnels.

 
    [bookmark: pgfId-840526]Tunneling makes it possible to use a public TCP/IP network, such as the Internet, to create secure connections between remote users and a private corporate network. Each secure connection is called a tunnel.

 
    [bookmark: pgfId-840528]IPsec-based VPN technologies use the ISAKMP and IPsec tunneling standards to build and manage tunnels. ISAKMP and IPsec accomplish the following:

 
     
     		 [bookmark: pgfId-840530]Negotiate tunnel parameters.

 
     		 [bookmark: pgfId-840532]Establish tunnels.

 
     		 [bookmark: pgfId-840534]Authenticate users and data.

 
     		 [bookmark: pgfId-840536]Manage security keys.

 
     		 [bookmark: pgfId-840538]Encrypt and decrypt data.

 
     		 [bookmark: pgfId-840540]Manage data transfer across the tunnel.

 
     		 [bookmark: pgfId-840542]Manage data transfer inbound and outbound as a tunnel endpoint or router.

 
    

 
    [bookmark: pgfId-840544]A device in a VPN functions as a bidirectional tunnel endpoint. It can receive plain packets from the private network, encapsulate them, create a tunnel, and send them to the other end of the tunnel where they are unencapsulated and sent to their final destination. It can also receive encapsulated packets from the public network, unencapsulate them, and send them to their final destination on the private network.

 
    [bookmark: pgfId-840546]The following topics explain the basic IKE and IPsec policies and how to configure them:

 
     
     		 [bookmark: pgfId-840551]Overview of IKE and IPsec Configurations

 
     		 [bookmark: pgfId-840556]Understanding IKE

 
     		 [bookmark: pgfId-840561]Understanding IPsec Proposals

 
     		 [bookmark: pgfId-840566]Configuring VPN Global Settings

 
     		 [bookmark: pgfId-840571]Understanding IKEv1 Preshared Key Policies in Site-to-Site VPNs

 
     		 [bookmark: pgfId-840576]Understanding Public Key Infrastructure Policies

 
     		 [bookmark: pgfId-840581]Configuring IKEv2 Authentication in Site-to-Site VPNs

 
    

 
   
 
    
     [bookmark: pgfId-840591][bookmark: 68111][bookmark: vpchap_cncpt_OverviewofIKEandIPsecConfigurations]Overview of IKE and IPsec Configurations[bookmark: marker-840587][bookmark: marker-840589]

 
    [bookmark: pgfId-840593]Internet Key Exchange (IKE) is a key management protocol that is used to authenticate IPsec peers, negotiate and distribute IPsec encryption keys, and to automatically establish IPsec security associations (SAs).

 
    [bookmark: pgfId-840595]The IKE negotiation comprises two phases. Phase 1 negotiates a security association between two IKE peers, which enables the peers to communicate securely in Phase 2. During Phase 2 negotiation, IKE establishes SAs for other applications, such as IPsec. Both phases use proposals when they negotiate a connection.

 
    [bookmark: pgfId-840597]An IKE proposal is a set of algorithms that two peers use to secure the IKE negotiation between them. IKE negotiation begins by each peer agreeing on a common (shared) IKE policy. This policy states which security parameters will be used to protect subsequent IKE negotiations. For IKE version 1 (IKEv1), IKE proposals contain a single set of algorithms and a modulus group. You can create multiple, prioritized policies at each peer to ensure that at least one policy matches a remote peer’s policy. Unlike IKEv1, in an IKEv2 proposal, you can select multiple algorithms and modulus groups from which peers can choose during the Phase 1 negotiation, potentially making it possible to create a single IKE proposal (although you might want different proposals to give higher priority to your most desired options). You can define several IKE proposals per VPN.

 
    [bookmark: pgfId-840599]You must configure several policies to define the settings required to make successful regular IPsec connections in a site-to-site or remote access VPN. The following procedure provides an overview of the steps required to complete the configuration, and points to other topics that provide detailed information for each step.

 
    [bookmark: pgfId-840601]Related Topics

 
     
     		 [bookmark: pgfId-840606]Understanding IKE

 
     		 [bookmark: pgfId-840611]Understanding IPsec Proposals

 
     		 [bookmark: pgfId-840616]Understanding IKEv1 Preshared Key Policies in Site-to-Site VPNs

 
     		 [bookmark: pgfId-840621]Understanding Public Key Infrastructure Policies

 
    

 
    
 
    [bookmark: pgfId-840623]Step 1 Configure the IKE Proposal policy.

 
    [bookmark: pgfId-840625]In the IKE Proposal policy, you define the IKE proposal policy objects to use for making VPN connections. When defining the IKE proposal object, you select the algorithms to use for encrypting the IKE negotiation and for integrity checking, and the Diffie-Hellman group to use to operate the encryption algorithm. For IKEv1, you also determine whether you are using preshared keys or Public Key Infrastructure, whereas in IKEv2, the IKE proposal does not include a specification for authentication mode.

 
    [bookmark: pgfId-840627]The following topics explain how to configure the IKE Proposal policy:

 
     
     		 [bookmark: pgfId-840632]Configuring an IKE Proposal

 
    

 
    [bookmark: pgfId-840637] – Configuring IKEv1 Proposal Policy Objects

 
    [bookmark: pgfId-840642] – Configuring IKEv2 Proposal Policy Objects

 
     
     		 [bookmark: pgfId-840647]Configuring the IKE Proposal for GET VPN

 
    

 
    [bookmark: pgfId-840649]Step 2 Complete the authentication mode configuration.

 
    [bookmark: pgfId-840651]Your selection for authentication mode in the IKEv1 proposal, and your decision on which mode to use for IKEv2, controls what other policies are required to complete the authentication mode configuration:

 
     
     		 [bookmark: pgfId-840653]Preshared keys—For remote access IKEv1 IPsec VPNs, you define the preshared keys in the  Connection Profiles policy; preshared keys are not supported for IKEv2 in remote access VPNs. For site-to-site VPNs, you define the keys in the  IKEv1 Preshared Keys or the  IKEv2 Authentication policy based on the IKE version you are using.

 
    

 
    [bookmark: pgfId-840655]The following topics explain preshared key configuration:

 
    [bookmark: pgfId-840660] – IPSec Tab (Connection Profiles)

 
    [bookmark: pgfId-840665] – Configuring IKEv1 Preshared Key Policies

 
    [bookmark: pgfId-840670] – Configuring IKEv2 Authentication in Site-to-Site VPNs

 
     
     		 [bookmark: pgfId-840672]Public Key Infrastructure Certificate Authority servers—If you configure IKE to use Certificate Authority (CA) servers, you must configure the  Public Key Infrastructure policy. You also use this policy to define the Public Key Infrastructure for SSL VPNs. For site-to-site VPNs, the policy is  IKEv1 Public Key Infrastructure or  IKEv2 Authentication , based on the IKE version you are using.

 
    

 
    [bookmark: pgfId-840674]The Public Key Infrastructure policy identifies the PKI enrollment object that identifies the Certificate Authority server. For site-to-site VPNs, you can select a single PKI enrollment object; for remote access VPNs, you can select all objects needed for your remote access connections. These trustpoints are then identified in the remote access Connection Profiles policy (on the IPsec tab).

 
    [bookmark: pgfId-840676]The following topics explain public key infrastructure configuration:

 
    [bookmark: pgfId-840681] – Understanding Public Key Infrastructure Policies

 
    [bookmark: pgfId-840686] – Configuring IKEv1 Public Key Infrastructure Policies in Site-to-Site VPNs

 
    [bookmark: pgfId-840691] – Defining Multiple IKEv1 CA Servers for Site-to-Site VPNs

 
    [bookmark: pgfId-840696] – Configuring Public Key Infrastructure Policies for Remote Access VPNs

 
    [bookmark: pgfId-840701] – IPSec Tab (Connection Profiles)

 
    [bookmark: pgfId-840706] – Configuring IKEv2 Authentication in Site-to-Site VPNs

 
    [bookmark: pgfId-840708]Step 3 Configure the IPsec Proposal policy. The IPsec Proposal policy defines the IPsec transform set policy objects used to create a secure IPsec tunnel for the VPN.

 
    [bookmark: pgfId-840710]The following topics explain how to configure the IPsec Proposal policy:

 
     
     		 [bookmark: pgfId-840715]Configuring IPsec Proposals in Site-to-Site VPNs

 
    

 
    [bookmark: pgfId-840720] – Selecting the IKE Version for Devices in Site-to-Site VPNs

 
    [bookmark: pgfId-840725] – Configuring IPSec IKEv1 or IKEv2 Transform Set Policy Objects

 
     
     		 [bookmark: pgfId-840730]Configuring an IPsec Proposal for Easy VPN

 
     		 [bookmark: pgfId-840735]Configuring an IPsec Proposal on a Remote Access VPN Server (ASA, PIX 7.0+ Devices)

 
     		 [bookmark: pgfId-840740]Configuring an IPsec Proposal on a Remote Access VPN Server (IOS, PIX 6.3 Devices)

 
    

 
    [bookmark: pgfId-840742]Step 4 Configure the Global Settings policy.

 
    [bookmark: pgfId-840744]The Global Settings (remote access) and VPN Global Settings (site-to-site) policies define various ISAKMP, IKEv1, IKEv2, IPsec, NAT, fragmentation, and other settings. These settings have default values that are frequently adequate, so normally you need to configure the Global Settings policy only if you want non-default behavior. However, you must configure the policy for remote access IKEv2 IPsec VPNs, because you must specify a remote access global trustpoint on the IKEv2 Settings tab.

 
    [bookmark: pgfId-840746]The following topics explain how to configure the Global Settings policy:

 
     
     		 [bookmark: pgfId-840751]Configuring VPN Global Settings

 
    

 
    [bookmark: pgfId-840756] – Configuring VPN Global ISAKMP/IPsec Settings

 
    [bookmark: pgfId-840761] – Configuring VPN Global IKEv2 Settings

 
    [bookmark: pgfId-840766] – Configuring VPN Global NAT Settings

 
    [bookmark: pgfId-840771] – Configuring VPN Global General Settings

 
     
     		 [bookmark: pgfId-840776]Configuring Global Settings for GET VPN

 
    

 
    [bookmark: pgfId-840781]Step 5 If you are configuring a remote access IKEv2 IPsec VPN, you must also configure several policies for SSL VPN. IKEv2 shares several configuration settings with SSL VPNs. For information on the other policies you need to configure, see Creating IPSec VPNs Using the Remote Access VPN Configuration Wizard (ASA and PIX 7.0+ Devices).

 
    [bookmark: pgfId-840783]


    
     

    
 
    

 
     
      [bookmark: pgfId-840791][bookmark: 68263][bookmark: vpchap_cncpt_ComparingIKEVersion1and2]Comparing IKE Version 1 and 2[bookmark: marker-840789]

 
     [bookmark: pgfId-840793]There are two versions of IKE: version 1 (IKEv1) and version 2 (IKEv2). When you configure IKE on a device that supports IKEv2, you have the option of configuring either version alone, or both versions together. When the device attempts to negotiate a connection with another peer, it uses whichever versions you allow and that the other peer accepts. If you allow both versions, the device automatically falls back to the other version if negotiations are unsuccessful with the initially chosen version (IKEv2 is always tried first if it is configured). Both peers must support IKEv2 to use it in a negotiation.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-840798]Tip Security Manager supports IKEv2 on ASA 8.4(1)+ only. For remote access IPsec VPNs, users must use the AnyConnect 3.0+ client to complete IKEv2 connections, and IKEv2 connections use the same license pool that is used for SSL VPN connections. The legacy VPN Client is used for IKEv1 remote access connections on ASAs. For more information about device support in VPNs, see Understanding Devices Supported by Each IPsec Technology.


     
      

     

     

 
     [bookmark: pgfId-840800]IKEv2 differs from IKEv1 in the following ways:

 
      
      		 [bookmark: pgfId-840802]IKEv2 fixes the Photuris style cookie mechanism.

 
      		 [bookmark: pgfId-840804]IKEv2 has fewer round trips in a negotiation than IKEv1, two round trips versus five for IKEv1 for a basic exchange.

 
      		 [bookmark: pgfId-840806]Transform options are OR’ed, which means that you can specify multiple options in a single proposal rather than creating separate unique proposals for each allowed combination.

 
      		 [bookmark: pgfId-840808]Built-in dead peer detection (DPD).

 
      		 [bookmark: pgfId-840810]Built-in configuration payload and user authentication mode.

 
      		 [bookmark: pgfId-840812]Built-in NAT traversal (NAT-T). IKEv2 uses ports 500 and 4500 for NAT-T.

 
      		 [bookmark: pgfId-840814]Improved re-keying and collision handling.

 
      		 [bookmark: pgfId-840816]A single security association (SA) can protect multiple subnets, which improves scalability.

 
      		 [bookmark: pgfId-840818]Asymmetric authentication in site-to-site VPNs, where each side of a tunnel can have different preshared keys, different certificates, or one side a key and the other side a certificate.

 
      		 [bookmark: pgfId-840820]For remote access IPsec VPNs, you can configure double authentication for IKEv2 connections in the same way that you configure them for remote access SSL VPNs. IKEv1 does not support double authentication.

 
     

 
     [bookmark: pgfId-840822]Related Topics

 
      
      		 [bookmark: pgfId-840827]Overview of IKE and IPsec Configurations

 
      		 [bookmark: pgfId-840832]Configuring an IKE Proposal

 
     

 
    
 
   
 
    
     [bookmark: pgfId-840848][bookmark: 68304][bookmark: vpchap_cncpt_UnderstandingIKE]Understanding IKE[bookmark: marker-840838][bookmark: marker-840840][bookmark: marker-840842][bookmark: marker-840844][bookmark: marker-840846]

 
    [bookmark: pgfId-840850]Internet Key Exchange (IKE), also called Internet Security Association and Key Management Protocol (ISAKMP), is the negotiation protocol that lets two hosts agree on how to build an IPsec security association (SA). It provides a common framework for agreeing on the format of SA attributes. This includes negotiating with the peer about the SA, and modifying or deleting the SA. IKE creates the cryptographic keys used to authenticate IPsec peers, negotiates and distributes IPsec encryption keys, and automatically establishes IPsec security associations.

 
    [bookmark: pgfId-840852]The IKE negotiation comprises two phases. Phase 1 negotiates a security association between two IKE peers, creating the first tunnel that enables the peers to communicate securely in Phase 2, protecting later ISAKMP negotiation messages. During Phase 2 negotiation, IKE establishes SAs for other applications, such as IPsec, which protects the data sent between peers. Both phases use proposals when they negotiate a connection.

 
    [bookmark: pgfId-840854]An IKE proposal is a set of algorithms that two peers use to secure the IKE negotiation between them. IKE negotiation begins by each peer agreeing on a common (shared) IKE policy. This policy states which security parameters will be used to protect subsequent IKE negotiations. In remote access IPsec VPNs, you can define several IKE proposals per VPN to create multiple, prioritized policies at each peer to ensure that at least one policy matches a remote peer’s policy. For site-to-site VPNs, you can create a single IKE proposal.

 
    [bookmark: pgfId-840856]To define an IKE proposal, you must specify:

 
     
     		 [bookmark: pgfId-840858]A unique priority (1 through 65,543, with 1 the highest priority).

 
     		 [bookmark: pgfId-840863]An encryption method for the IKE negotiation, to protect the data and ensure privacy. See Deciding Which Encryption Algorithm to Use.

 
     		 [bookmark: pgfId-840868]A Hashed Message Authentication Codes (HMAC) method (called  integrity algorithm in IKEv2) to ensure the identity of the sender, and to ensure that the message has not been modified in transit. See Deciding Which Hash Algorithm to Use.

 
     		 [bookmark: pgfId-840873]For IKEv2, a separate pseudo-random function (PRF) used as the algorithm to derive keying material and hashing operations required for the IKEv2 tunnel encryption. The options are the same as those used for the hash algorithm; see Deciding Which Hash Algorithm to Use.

 
     		 [bookmark: pgfId-840878]A Diffie-Hellman group to determine the strength of the encryption-key-determination algorithm. The device uses this algorithm to derive the encryption and hash keys. See Deciding Which Diffie-Hellman Modulus Group to Use.

 
     		 [bookmark: pgfId-840883]An authentication method, to ensure the identity of the peers. See Deciding Which Authentication Method to Use.

 
     		 [bookmark: pgfId-840885]A limit to the time the device uses an encryption key before replacing it.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-840887]Tip (ASA devices only.) With IKEv1 policies, for each parameter, you set one value. For IKEv2, you can configure multiple encryption, integrity, PRF, and Diffie-Hellman options. The ASA orders the settings from the most secure to the least secure and negotiates with the peer using that order. This allows you to potentially send a single proposal to convey all the allowed transforms instead of the need to send each allowed combination as with IKEv1.


    
     

    

    

 
    [bookmark: pgfId-840889]When IKE negotiation begins, the peer that initiates the negotiation sends all of its policies to the remote peer, and the remote peer searches for a match with its own policies, in priority order.

 
    [bookmark: pgfId-840891]A match between IKE policies exists if they have the same encryption, hash (integrity and PRF for IKEv2), authentication, and Diffie-Hellman values, and an SA lifetime less than or equal to the lifetime in the policy sent. If the lifetimes are not identical, the shorter lifetime—from the remote peer policy—applies. If no match exists, IKE refuses negotiation and the IKE SA is not established.

 
    [bookmark: pgfId-840893]The following topics explain how to configure IKE proposals:

 
     
     		 [bookmark: pgfId-840898]Configuring an IKE Proposal

 
     		 [bookmark: pgfId-840903]Configuring IKEv1 Proposal Policy Objects

 
     		 [bookmark: pgfId-840908]Configuring IKEv2 Proposal Policy Objects

 
     		 [bookmark: pgfId-840913]Configuring the IKE Proposal for GET VPN

 
    

 
     
      [bookmark: pgfId-840923][bookmark: 68367][bookmark: vpchap_cncpt_DecidingWhichEncryptionAlgorithmtoUse]Deciding Which Encryption Algorithm to Use[bookmark: marker-840919][bookmark: marker-840921]

 
     [bookmark: pgfId-840925]When deciding which encryption and hash algorithms to use for the IKE proposal, your choice is limited to algorithms that are supported by the devices in the VPN.

 
     [bookmark: pgfId-840927]You can choose from the following encryption algorithms:

 
      
      		 [bookmark: pgfId-840933]DES (Data Encryption Standard) is a symmetric secret-key block algorithm. It is faster than 3DES and uses less system resources, but it is also less secure. If you do not need strong data confidentiality, and if system resources or speed is a concern, you should choose DES.[bookmark: marker-840929][bookmark: marker-840931]

 
      		 [bookmark: pgfId-840939]3DES (Triple DES) is more secure because it processes each block of data three times, each time with a different key. However, it uses more system resources and is slower than DES. 3DES is the recommended encryption algorithm, assuming that the devices support it.[bookmark: marker-840935][bookmark: marker-840937]

 
      		 [bookmark: pgfId-840945]AES (Advanced Encryption Standard) provides greater security than DES and is computationally more efficient than 3DES. AES offers three different key strengths: 128-, 192- and 256-bit keys. A longer key provides higher security but a reduction in performance. When you configure IKE on a router, the router must use Cisco IOS Software 12.3T or later to use AES.[bookmark: marker-840941][bookmark: marker-840943]

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-840947]Note AES cannot be used in conjunction with a hardware encryption card.


     
      

     

     

 
     [bookmark: pgfId-840949]Related Topics

 
      
      		 [bookmark: pgfId-840954]Understanding IKE

 
      		 [bookmark: pgfId-840959]Configuring an IKE Proposal

 
     

 
    
 
     
      [bookmark: pgfId-840969][bookmark: 68413][bookmark: vpchap_cncpt_DecidingWhichHashAlgorithmtoUse]Deciding Which Hash Algorithm to Use[bookmark: marker-840965][bookmark: marker-840967]

 
     [bookmark: pgfId-840971]You can choose from the following hash algorithms. In IKEv2, the hash algorithm is separated into two options, one for the integrity algorithm, and one for the pseudo-random function (PRF).

 
      
      		 [bookmark: pgfId-840977]SHA (Secure Hash Algorithm) is more resistant to brute-force attacks than MD5. However, it is also more resource intensive than MD5. For implementations that require the highest level of security, use the SHA hash algorithm.[bookmark: marker-840973][bookmark: marker-840975]

 
     

 
     [bookmark: pgfId-840979]Standard SHA produces a 160-bit digest.

 
     [bookmark: pgfId-840981]The following options, which are even more secure, are available for IKEv2 configurations on ASA 8.4(2+) devices:

 
     [bookmark: pgfId-840983] – SHA512—A 512-bit key.

 
     [bookmark: pgfId-840985] – SHA384—A 384-bit key.

 
     [bookmark: pgfId-840987] – SHA256—A 256-bit key.

 
      
      		 [bookmark: pgfId-840993]MD5 (Message Digest 5) produces a 128-bit digest and uses less processing time for an overall faster performance than SHA, but it is considered to be weaker than SHA.[bookmark: marker-840989][bookmark: marker-840991]

 
     

 
     [bookmark: pgfId-840995]Related Topics

 
      
      		 [bookmark: pgfId-841000]Understanding IKE

 
      		 [bookmark: pgfId-841005]Configuring an IKE Proposal

 
     

 
    
 
     
      [bookmark: pgfId-841015][bookmark: 68456][bookmark: vpchap_cncpt_DecidingWhichDiffieHellmanGrouptoUse]Deciding Which Diffie-Hellman Modulus Group to Use[bookmark: marker-841011][bookmark: marker-841013]

 
     [bookmark: pgfId-841017]Security Manager supports the following Diffie-Hellman key derivation algorithms to generate IPsec security association (SA) keys. Each group has a different size modulus. A larger modulus provides higher security, but requires more processing time. You must have a matching modulus group on both peers.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-841019]Tip If you select AES encryption, to support the large key sizes required by AES, ISAKMP negotiation should use Diffie-Hellman (DH) Group 5 or higher. For IKEv1, ASA devices support groups 2 and 5 only.


     
      

     

     

 
      
      		 [bookmark: pgfId-841021]Diffie-Hellman Group 1: 768-bit modulus. Use to generate IPsec SA keys where the prime and generator numbers are 768 bits.

 
      		 [bookmark: pgfId-841023]Diffie-Hellman Group 2: 1024-bit modulus. Use to generate IPsec SA keys where the prime and generator numbers are 1024 bits. Cisco VPN Client Version 3.x or higher requires a minimum of Group 2.

 
      		 [bookmark: pgfId-841025]Diffie-Hellman Group 5: 1536-bit modulus. Use to generate IPsec SA keys where the prime and generator numbers are 2048 bits. Considered good protection for 128-bit keys, but group 14 is better.

 
      		 [bookmark: pgfId-841027]Diffie-Hellman Group 7: Use to generate IPsec SA keys when the elliptical curve field size is 163 characters. Group 7 is not supported on a Catalyst 6500/7600 device with VPNSM or VPN SPA configuration.

 
      		 [bookmark: pgfId-841029]Diffie-Hellman Group 14: 2048-bit modulus. Considered good protection for 128-bit keys. (ASA 9.0.1+ devices only).

 
      		 [bookmark: pgfId-841031]Diffie-Hellman Group 15: 3072-bit modulus. Considered good protection for 192-bit keys.

 
      		 [bookmark: pgfId-841033]Diffie-Hellman Group 16: 4096-bit modulus. Considered good protection for 256-bit keys.

 
      		 [bookmark: pgfId-841035]Diffie-Hellman Group 19: (256-bit elliptical curve field size). (ASA 9.0.1+ devices only).

 
      		 [bookmark: pgfId-841037]Diffie-Hellman Group 20: (384-bit elliptical curve field size). (ASA 9.0.1+ devices only).

 
      		 [bookmark: pgfId-841039]Diffie-Hellman Group 21: (521-bit elliptical curve field size). (ASA 9.0.1+ devices only).

 
      		 [bookmark: pgfId-841041]Diffie-Hellman Group 24: ( 2048-bit modulus and 256-bit prime order subgroup). (ASA 9.0.1+ devices only).

 
     

 
     [bookmark: pgfId-841043]Related Topics

 
      
      		 [bookmark: pgfId-841048]Understanding IKE

 
      		 [bookmark: pgfId-841053]Configuring an IKE Proposal

 
     

 
    
 
     
      [bookmark: pgfId-841069][bookmark: 68499][bookmark: vpchap_cncpt_DecidingWhichAuthenticationMethodtoUse]Deciding Which Authentication Method to Use[bookmark: marker-841059][bookmark: marker-841061][bookmark: marker-841063][bookmark: marker-841065][bookmark: marker-841067]

 
     [bookmark: pgfId-841071]Security Manager supports two methods for peer device authentication in a VPN communication:

 
      
      		 [bookmark: pgfId-841073] Preshared Key —Preshared keys allow for a secret key to be shared between two peers and to be used by IKE during the authentication phase. The same shared key must be configured at each peer or the IKE SA cannot be established.

 
     

 
     [bookmark: pgfId-841075]To use IKE successfully with this device authentication method, you must define various preshared key parameters. For more information, see the appropriate topic:

 
     [bookmark: pgfId-841080] – Site-to-site VPN, IKEv1 configuration—See Configuring IKEv1 Preshared Key Policies.

 
     [bookmark: pgfId-841085] – Site-to-site VPN, IKEv2 configuration—See Configuring IKEv2 Authentication in Site-to-Site VPNs.

 
     [bookmark: pgfId-841090] – Remote access IPsec VPN, IKEv1—Configured on the IPsec tab of the connection profile. See IPSec Tab (Connection Profiles).

 
     [bookmark: pgfId-841092] – Remote access IPsec VPN, IKEv2—You cannot use preshared keys when using IKEv2 in a remote access IPSec VPN. You must use certificates.

 
      
      		 [bookmark: pgfId-841094] Certificate —An authentication method in which RSA key pairs are used to sign and encrypt IKE key management messages. Certificates provide non-repudiation of communication between two peers, meaning that it can be proved that the communication actually took place. When using this authentication method, peers are configured to obtain digital certificates from a Certification Authority (CA). CAs manage certificate requests and issue certificates to participating IPsec network devices. These services provide centralized key management for the participating devices.

 
     

 
     [bookmark: pgfId-841096]While the use of preshared keys does not scale well, using a CA does improve the manageability and scalability of your IPsec network. With a CA, you do not need to configure keys between all encrypting devices. Instead, each participating device is registered with the CA, and requests a certificate from the CA. Each device that has its own certificate and the public key of the CA can authenticate every other device within a given CA’s domain.

 
     [bookmark: pgfId-841098]To use IKE successfully with the Certificate authentication method, you must define parameters for CA authentication and enrollment. For more information, see the appropriate topic:

 
     [bookmark: pgfId-841103] – Site-to-site VPN, IKEv1 configuration—See Understanding Public Key Infrastructure Policies.

 
     [bookmark: pgfId-841108] – Site-to-site VPN, IKEv2 configuration—Configuring IKEv2 Authentication in Site-to-Site VPNs.

 
     [bookmark: pgfId-841116] – Remote access IPsec VPN, IKEv1—Configured on the IPsec tab of the connection profile as explained in IPSec Tab (Connection Profiles). You must also configure the Public Key Infrastructure policy with the same trustpoint; see Understanding Public Key Infrastructure Policies.

 
     [bookmark: pgfId-841124] – Remote access IPsec VPN, IKEv2—Configure the global trustpoint on the IKEv2 Settings tab of the Global Settings policy as explained in Configuring VPN Global IKEv2 Settings. You must also configure the Public Key Infrastructure policy with the same trustpoint; see Understanding Public Key Infrastructure Policies.

 
     [bookmark: pgfId-841126]Related Topics

 
      
      		 [bookmark: pgfId-841131]Understanding IKE

 
      		 [bookmark: pgfId-841136]Configuring an IKE Proposal

 
     

 
    
 
     
      [bookmark: pgfId-841156][bookmark: 68565][bookmark: vpchap_proc_ConfiguringanIKEProposal]Configuring an IKE Proposal[bookmark: marker-841146][bookmark: marker-841148][bookmark: marker-841150][bookmark: marker-841152][bookmark: marker-841154]

 
     [bookmark: pgfId-841161]In Security Manager, an IKE proposal is a mandatory policy when you configure a site-to-site or remote access IPsec VPN. When you use the configuration wizard to create a new IPsec VPN, an IKE Proposal policy is automatically assigned to the VPN; the policy might be the factory default, or it might be a shared policy specifically selected for the VPN. For more information about the IKE (Internet Key Exchange) key management protocol, see Understanding IKE.

 
     [bookmark: pgfId-841166]Use the IKE Proposal policy to examine the current IKE proposals and to configure new proposals except for GET VPN topologies. For GET VPN, see Configuring the IKE Proposal for GET VPN.

 
     [bookmark: pgfId-841168]Tips

 
      
      		 [bookmark: pgfId-841170]For site-to-site VPNs, you can select at most one IKE proposal per IKE version. For remote access IPsec VPNs, you can select multiple proposals for each IKE version; select all IKE proposals that are allowed in the remote access VPN.

 
      		 [bookmark: pgfId-841172]To configure IKEv2 (version 2), the device must be an ASA running ASA Software release 8.4(1) or higher.

 
      		 [bookmark: pgfId-841177]The IPsec Proposal policy must enable IKEv1, IKEv2, or both, to match the IKE proposals you configure in this policy. In cases where you cannot configure IKEv2 in the IPsec proposal, such as in Easy VPN topologies, IKEv2 is not supported. For more information, see Understanding IPsec Proposals.

 
      		 [bookmark: pgfId-841182]The IKEv1 Proposal objects specify whether preshared keys or certificates are used for authentication. You must configure the appropriate policies to configure preshared keys or Public Key Infrastructure settings. For IKEv2, the object does not specify whether preshared keys or certificates are used, but other policies must define the authentication requirements. For more information, see Deciding Which Authentication Method to Use.

 
     

 
     [bookmark: pgfId-841184]Related Topics

 
      
      		 [bookmark: pgfId-841189]Deciding Which Hash Algorithm to Use

 
      		 [bookmark: pgfId-841194]Deciding Which Diffie-Hellman Modulus Group to Use

 
      		 [bookmark: pgfId-841199]Deciding Which Authentication Method to Use

 
     

 
     
 
     [bookmark: pgfId-841201]Step 1 Do one of the following to open the IKE Proposal policy based on the type of VPN you are configuring:

 
      
      		 [bookmark: pgfId-841203]For remote access VPNs, do one of the following:

 
     

 
     [bookmark: pgfId-841205] – (Device View) Select Remote Access VPN > IPSec VPN > IKE Proposal from the Policy selector.

 
     [bookmark: pgfId-841207] – (Policy View) Select Remote Access VPN > IPSec VPN > IKE Proposal from the Policy Type selector. Select an existing policy or create a new one.

 
      
      		 [bookmark: pgfId-841209]For site-to-site VPNs, do one of the following:

 
     

 
     [bookmark: pgfId-841214] – Open the Site-to-Site VPN Manager Window, select a topology (other than GET VPN) in the VPNs selector, then select IKE Proposal in the Policies selector.

 
     [bookmark: pgfId-841216] – (Policy view) Select Site-to-Site VPN > IKE Proposal from the Policy Types selector. Select an existing shared policy or create a new one.

 
     [bookmark: pgfId-841218]Step 2 In each of the IKEv1 Proposals and IKEv2 Proposals fields, click Select to choose the policy objects that define the settings for an IKE version 1 or version 2 proposal. Configure proposals only for those IKE versions supported in the VPN.

 
      
      		 [bookmark: pgfId-841220]To select an IKE proposal for site-to-site VPNs, simply highlight it in the available proposals list. For remote access IPsec VPNs, highlight the desired objects in the available proposals list and click  >> to move them to the selected proposals list.

 
      		 [bookmark: pgfId-841222]To remove an IKE proposal for remote access IPsec VPNs, highlight it in the selected proposals list and click  << to move it to the available proposals list.

 
      		 [bookmark: pgfId-841224]To create a new IKE proposal, click the  Create (+) button beneath the available proposals list. The Add IKEv1 or IKEv2 Proposal dialog box opens. For instructions on creating the object, see the following topics:

 
     

 
     [bookmark: pgfId-841229] – Configuring IKEv1 Proposal Policy Objects

 
     [bookmark: pgfId-841234] – Configuring IKEv2 Proposal Policy Objects

 
      
      		 [bookmark: pgfId-841236]To edit an object, or to view its settings, select it and click the  Edit (pencil) button beneath the list.

 
     

 
     [bookmark: pgfId-841238]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-841256][bookmark: 68669][bookmark: pobjpage_cncpt_IKEProposalDialogBox]Configuring IKEv1 Proposal Policy Objects[bookmark: marker-841246][bookmark: marker-841248][bookmark: marker-841250][bookmark: marker-841252][bookmark: marker-841254]

 
     [bookmark: pgfId-841258]Use the IKEv1 Proposal dialog box to create, copy, and edit an IKEv1 proposal object.

 
     [bookmark: pgfId-841260]Internet Key Exchange (IKE) version 1 proposal objects contain the parameters required for IKEv1 proposals when defining remote access and site-to-site VPN policies. IKE is a key management protocol that facilitates the management of IPsec-based communications. It is used to authenticate IPsec peers, negotiate and distribute IPsec encryption keys, and automatically establish IPsec security associations (SAs).

 
     [bookmark: pgfId-841262]The IKE negotiation comprises two phases. Phase 1 negotiates a security association between two IKE peers, which enables the peers to communicate securely in Phase 2. During Phase 2 negotiation, IKE establishes security associations (SAs) for other applications, such as IPsec. Both phases use proposals when they negotiate a connection. For more information about IKE proposals, see the following topics:

 
      
      		 [bookmark: pgfId-841267]Overview of IKE and IPsec Configurations

 
      		 [bookmark: pgfId-841272]Comparing IKE Version 1 and 2

 
      		 [bookmark: pgfId-841277]Understanding IKE

 
      		 [bookmark: pgfId-841282]Deciding Which Encryption Algorithm to Use

 
      		 [bookmark: pgfId-841287]Deciding Which Hash Algorithm to Use

 
      		 [bookmark: pgfId-841292]Deciding Which Diffie-Hellman Modulus Group to Use

 
      		 [bookmark: pgfId-841297]Deciding Which Authentication Method to Use

 
     

 
     [bookmark: pgfId-841299]Navigation Path

 
     [bookmark: pgfId-841301]Select Manage > Policy Objects, then select IKE Proposals > IKEv1 Proposals from the Object Type Selector. Right-click inside the work area, then select New Object or right-click a row, then select Edit Object.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-841306]Tip You can also access this dialog box when configuring the IKE Proposal policy as explained in Configuring an IKE Proposal.


     
      

     

     

 
     [bookmark: pgfId-841308]Related Topics

 
      
      		 [bookmark: pgfId-841313]Configuring IKEv2 Proposal Policy Objects

 
      		 [bookmark: pgfId-841318]Creating Policy Objects

 
      		 [bookmark: pgfId-841323]Policy Object Manager

 
      		 [bookmark: pgfId-841328]Configuring IPSec IKEv1 or IKEv2 Transform Set Policy Objects

 
     

 
     [bookmark: pgfId-841330]Field Reference

 
     [bookmark: pgfId-841333] 

 
      
       
        
        [bookmark: pgfId-837871]Table 26-1 [bookmark: 68740]IKEv1 Proposal Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-837877]Element
          
  
         		
           
           [bookmark: pgfId-837879]Description
          
  
        

 
         
         		[bookmark: pgfId-837885]Name

  
         		[bookmark: pgfId-837887]The name of the policy object. A maximum of 128 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-837893]Description

  
         		[bookmark: pgfId-837895]A description of the policy object. A maximum of 1024 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-837901]Priority

  
         		[bookmark: pgfId-837903]The priority value of the IKE proposal. The priority value determines the order of the IKE proposals compared by the two negotiating peers when attempting to find a common security association (SA). If the remote IPsec peer does not support the parameters selected in your first priority policy, the device tries to use the parameters defined in the policy with the next lowest priority number.

 [bookmark: pgfId-837905]Valid values range from 1 to 10000. The lower the number, the higher the priority. If you leave this field blank, Security Manager assigns the lowest unassigned value starting with 1, then 5, then continuing in increments of 5.

  
        

 
         
         		[bookmark: pgfId-837911]Encryption Algorithm

  
         		[bookmark: pgfId-837913]The encryption algorithm used to establish the Phase 1 SA for protecting Phase 2 negotiations:

 
           
           		 [bookmark: pgfId-837915]AES-128—Encrypts according to the Advanced Encryption Standard using 128-bit keys.

 
           		 [bookmark: pgfId-837917]AES-192—Encrypts according to the Advanced Encryption Standard using 192-bit keys.

 
           		 [bookmark: pgfId-837919]AES-256—Encrypts according to the Advanced Encryption Standard using 256-bit keys.

 
           		 [bookmark: pgfId-837921]DES—Encrypts according to the Data Encryption Standard using 56-bit keys.

 
           		 [bookmark: pgfId-837923]3DES—Encrypts three times using 56-bit keys. 3DES is more secure than DES, but requires more processing for encryption and decryption. It is less secure than AES. A 3DES license is required to use this option.

 
          

  
        

 
         
         		[bookmark: pgfId-837929]Hash Algorithm

  
         		[bookmark: pgfId-837931]The hash algorithm used in the IKE proposal. The hash algorithm creates a message digest, which is used to ensure message integrity. Options are:

 
           
           		 [bookmark: pgfId-837933]SHA (Secure Hash Algorithm)—Produces a 160-bit digest. SHA is more resistant to brute-force attacks than MD5.

 
           		 [bookmark: pgfId-837935]MD5 (Message Digest 5)—Produces a 128-bit digest. MD5 uses less processing time than SHA.

 
          

  
        

 
         
         		[bookmark: pgfId-837941]Modulus Group

  
         		[bookmark: pgfId-837943]The Diffie-Hellman group to use for deriving a shared secret between the two IPsec peers without transmitting it to each other. A larger modulus provides higher security but requires more processing time. The two peers must have a matching modulus group. Options are:

 [bookmark: pgfId-837945]Tip For IKEv1, ASA devices support groups 2 and 5 only. 
           
           		 [bookmark: pgfId-837947]1—Diffie-Hellman Group 1 (768-bit modulus).

 
           		 [bookmark: pgfId-837949]2—Diffie-Hellman Group 2 (1024-bit modulus).

 
           		 [bookmark: pgfId-837951]5—Diffie-Hellman Group 5 (1536-bit modulus, considered good protection for 128-bit keys, but group 14 is better). If you are using AES encryption, use this group (or higher).

 
           		 [bookmark: pgfId-837953]7—Diffie-Hellman Group 7 (163-bit elliptical curve field size).

 
           		 [bookmark: pgfId-837955]14—Diffie-Hellman Group 14 (2048-bit modulus, considered good protection for 128-bit keys).

 
           		 [bookmark: pgfId-837957]15—Diffie-Hellman Group 15 (3072-bit modulus, considered good protection for 192-bit keys).

 
           		 [bookmark: pgfId-837959]16—Diffie-Hellman Group 16 (4096-bit modulus, considered good protection for 256-bit keys).

 
          

 [bookmark: pgfId-837961]Note Although Diffie-Hellman groups 19-24 are listed, they are not supported for IKEv1 and will cause a validation error if selected for IKEv1 policies.

  
        

 
         
         		[bookmark: pgfId-837967]Lifetime

  
         		[bookmark: pgfId-837969]The lifetime of the security association (SA), in seconds. When the lifetime is exceeded, the SA expires and must be renegotiated between the two peers. As a general rule, the shorter the lifetime (up to a point), the more secure your IKE negotiations will be. However, with longer lifetimes, future IPsec security associations can be set up more quickly than with shorter lifetimes.

 [bookmark: pgfId-837971]You can specify a value from 60 to 2147483647 seconds. The default is 86400.

  
        

 
         
         		[bookmark: pgfId-837977]Authentication Method

  
         		[bookmark: pgfId-837982]The method of authentication to use between the two peers. For information on how this selection determines which other policies you must configure, see Deciding Which Authentication Method to Use. Select one of the following:

 
           
           		 [bookmark: pgfId-837984]Preshared Key—Preshared keys allow for a secret key to be shared between two peers and to be used by IKE during the authentication phase. If one of the participating peers is not configured with the same preshared key, the IKE SA cannot be established.

 
           		 [bookmark: pgfId-837986]Certificate—An authentication method in which RSA key pairs are used to sign and encrypt IKE key management messages. This method provides non-repudiation of communication between two peers, meaning that it can be proved that the communication actually took place. When you use this authentication method, the peers are configured to obtain digital certificates from a Certification Authority (CA).

 
          

  
        

 
         
         		[bookmark: pgfId-837992]Category

  
         		[bookmark: pgfId-837997]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-841359][bookmark: 68838][bookmark: pobjpage_cncpt_IKEv2ProposalDialogBox]Configuring IKEv2 Proposal Policy Objects[bookmark: marker-841349][bookmark: marker-841351][bookmark: marker-841353][bookmark: marker-841355][bookmark: marker-841357]

 
     [bookmark: pgfId-841361]Use the IKEv2 Proposal dialog box to create, copy, and edit an IKEv2 proposal object. You can use IKEv2 proposals with ASA Software release 8.4(1)+ only.

 
     [bookmark: pgfId-841363]Internet Key Exchange (IKE) version 2 proposal objects contain the parameters required for IKEv2 proposals when defining remote access and site-to-site VPN policies. IKE is a key management protocol that facilitates the management of IPsec-based communications. It is used to authenticate IPsec peers, negotiate and distribute IPsec encryption keys, and automatically establish IPsec security associations (SAs).

 
     [bookmark: pgfId-841365]The IKE negotiation comprises two phases. Phase 1 negotiates a security association between two IKE peers, which enables the peers to communicate securely in Phase 2. During Phase 2 negotiation, IKE establishes security associations (SAs) for other applications, such as IPsec. Both phases use proposals when they negotiate a connection. Unlike IKEv1, in an IKEv2 proposal, you can select multiple algorithms and modulus groups from which peers can choose during the Phase 1 negotiation. For more information about IKE proposals, see the following topics:

 
      
      		 [bookmark: pgfId-841370]Overview of IKE and IPsec Configurations

 
      		 [bookmark: pgfId-841375]Comparing IKE Version 1 and 2

 
      		 [bookmark: pgfId-841380]Understanding IKE

 
      		 [bookmark: pgfId-841385]Deciding Which Encryption Algorithm to Use

 
      		 [bookmark: pgfId-841390]Deciding Which Hash Algorithm to Use

 
      		 [bookmark: pgfId-841395]Deciding Which Diffie-Hellman Modulus Group to Use

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-841400]Tip Unlike IKEv1, you do not specify the authentication method in the IKE proposal. For more information on how to configure the authentication method in IKEv2, see Deciding Which Authentication Method to Use.


     
      

     

     

 
     [bookmark: pgfId-841402]Navigation Path

 
     [bookmark: pgfId-841404]Select Manage > Policy Objects, then select IKE Proposals > IKEv2 Proposals from the Object Type Selector. Right-click inside the work area, then select New Object or right-click a row, then select Edit Object.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-841409]Tip You can also access this dialog box when configuring the IKE Proposal policy as explained in Configuring an IKE Proposal.


     
      

     

     

 
     [bookmark: pgfId-841411]Related Topics

 
      
      		 [bookmark: pgfId-841416]Configuring IKEv1 Proposal Policy Objects

 
      		 [bookmark: pgfId-841421]Creating Policy Objects

 
      		 [bookmark: pgfId-841426]Policy Object Manager

 
      		 [bookmark: pgfId-841431]Configuring IPSec IKEv1 or IKEv2 Transform Set Policy Objects

 
     

 
     [bookmark: pgfId-841433]Field Reference

 
     [bookmark: pgfId-841436] 

 
      
       
        
        [bookmark: pgfId-838010]Table 26-2 [bookmark: 68912]IKEv2 Proposal Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-838016]Element
          
  
         		
           
           [bookmark: pgfId-838018]Description
          
  
        

 
         
         		[bookmark: pgfId-838024]Name

  
         		[bookmark: pgfId-838026]The name of the policy object. A maximum of 128 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-838032]Description

  
         		[bookmark: pgfId-838034]A description of the policy object. A maximum of 1024 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-838040]Priority

  
         		[bookmark: pgfId-838042]The priority value of the IKE proposal. The priority value determines the order of the IKE proposals compared by the two negotiating peers when attempting to find a common security association (SA). If the remote IPsec peer does not support the parameters selected in your first priority policy, the device tries to use the parameters defined in the policy with the next lowest priority number.

 [bookmark: pgfId-838044]Valid values range from 1 to 65535. The lower the number, the higher the priority. If you leave this field blank, Security Manager assigns the lowest unassigned value starting with 1, then 5, then continuing in increments of 5.

  
        

 
         
         		[bookmark: pgfId-838050]Encryption Algorithm

  
         		[bookmark: pgfId-838052]The encryption algorithm used to establish the Phase 1 SA for protecting Phase 2 negotiations. Click Select and select all of the algorithms that you want to allow in the VPN:

 
           
           		 [bookmark: pgfId-838054]AES-GCM-256—Encrypts according to the Advanced Encryption Standard in Galois/Counter Mode using 256-bit keys. (ASA 5580 and ASA 5500-X Series devices running 9.0.1+ only).

 
           		 [bookmark: pgfId-838056]AES-GCM-192—Encrypts according to the Advanced Encryption Standard in Galois/Counter Mode using 192-bit keys. (ASA 5580 and ASA 5500-X Series devices running 9.0.1+ only).

 
           		 [bookmark: pgfId-838058]AES-GCM—Encrypts according to the Advanced Encryption Standard in Galois/Counter Mode using 128-bit keys. (ASA 5580 and ASA 5500-X Series devices running 9.0.1+ only).

 
           		 [bookmark: pgfId-838060]AES-256—Encrypts according to the Advanced Encryption Standard using 256-bit keys.

 
           		 [bookmark: pgfId-838062]AES-192—Encrypts according to the Advanced Encryption Standard using 192-bit keys.

 
           		 [bookmark: pgfId-838064]AES—Encrypts according to the Advanced Encryption Standard using 128-bit keys.

 
           		 [bookmark: pgfId-838066]3DES—Encrypts three times using 56-bit keys. 3DES is more secure than DES, but requires more processing for encryption and decryption. It is less secure than AES. A 3DES license is required to use this option.

 
           		 [bookmark: pgfId-838068]DES—Encrypts according to the Data Encryption Standard using 56-bit keys.

 
           		 [bookmark: pgfId-838070]Null—No encryption algorithm.

 
          

  
        

 
         
         		[bookmark: pgfId-838076]Integrity (Hash) Algorithm

  
         		[bookmark: pgfId-838078]The integrity portion of the hash algorithm used in the IKE proposal. The hash algorithm creates a message digest, which is used to ensure message integrity. Click Select and select all of the algorithms that you want to allow in the VPN:

 [bookmark: pgfId-838080]Note If using AES-GCM, AES-GCM-192, or AES-GCM-256, you must select Null as the Integrity Algorithm.

 
           
           		 [bookmark: pgfId-838082]SHA (Secure Hash Algorithm)—SHA is more resistant to brute-force attacks than MD5.

 
          

 [bookmark: pgfId-838084]Standard SHA produces a 160-bit digest.

 [bookmark: pgfId-838086]The following options, which are even more secure, are available for IKEv2 configurations on ASA 8.4(2+) devices:

 [bookmark: pgfId-838088] – SHA512—A 512-bit key.

 [bookmark: pgfId-838090] – SHA384—A 384-bit key.

 [bookmark: pgfId-838092] – SHA256—A 256-bit key.

 
           
           		 [bookmark: pgfId-838094]MD5 (Message Digest 5)—Produces a 128-bit digest. MD5 uses less processing time than SHA.

 
           		 [bookmark: pgfId-838096]Null—No encryption algorithm. For use with AES-GCM, AES-GCM-192, and AES-GCM-256 only.

 
          

  
        

 
         
         		[bookmark: pgfId-838102]Prf Algorithm

  
         		[bookmark: pgfId-838104]The pseudo-random function (PRF) portion of the hash algorithm used in the IKE proposal. In IKEv1, the Integrity and PRF algorithms are not separated, but in IKEv2, you can specify different algorithms for these elements. Click Select and select all of the algorithms that you want to allow in the VPN. The options are described above under Integrity Algorithm.

  
        

 
         
         		[bookmark: pgfId-838110]Modulus Group

  
         		[bookmark: pgfId-838112]The Diffie-Hellman group to use for deriving a shared secret between the two IPsec peers without transmitting it to each other. A larger modulus provides higher security but requires more processing time. The two peers must have a matching modulus group. Click Select and select all of the groups that you want to allow in the VPN:

 
           
           		 [bookmark: pgfId-838114]1—Diffie-Hellman Group 1 (768-bit modulus).

 
           		 [bookmark: pgfId-838116]2—Diffie-Hellman Group 2 (1024-bit modulus).

 
           		 [bookmark: pgfId-838118]5—Diffie-Hellman Group 5 (1536-bit modulus, considered good protection for 128-bit keys, but group 14 is better). If you are using AES encryption, use this group (or higher).

 
           		 [bookmark: pgfId-838120]14—Diffie-Hellman Group 14 (2048-bit modulus, considered good protection for 128-bit keys). (ASA 9.0.1+ devices only).

 
           		 [bookmark: pgfId-838122]19—Diffie-Hellman Group 19 (256-bit elliptical curve field size). (ASA 9.0.1+ devices only).

 
           		 [bookmark: pgfId-838124]20—Diffie-Hellman Group 20 (384-bit elliptical curve field size). (ASA 9.0.1+ devices only).

 
           		 [bookmark: pgfId-838126]21—Diffie-Hellman Group 21 (521-bit elliptical curve field size). (ASA 9.0.1+ devices only).

 
           		 [bookmark: pgfId-838128]24—Diffie-Hellman Group 24 ( 2048-bit modulus and 256-bit prime order subgroup). (ASA 9.0.1+ devices only).

 
          

  
        

 
         
         		[bookmark: pgfId-838134]Lifetime

  
         		[bookmark: pgfId-838136]The lifetime of the security association (SA), in seconds. When the lifetime is exceeded, the SA expires and must be renegotiated between the two peers. As a general rule, the shorter the lifetime (up to a point), the more secure your IKE negotiations will be. However, with longer lifetimes, future IPsec security associations can be set up more quickly than with shorter lifetimes.

 [bookmark: pgfId-838138]You can specify a value from 120 to 2147483647 seconds. The default is 86400.

  
        

 
         
         		[bookmark: pgfId-838144]Category

  
         		[bookmark: pgfId-838149]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-841444][bookmark: 69029][bookmark: vpchap_cncpt_UnderstandingIPsecProposals]Understanding IPsec Proposals[bookmark: marker-841442]

 
    [bookmark: pgfId-841446]IPsec is one of the most secure methods for setting up a VPN. IPsec provides data encryption at the IP packet level, offering a robust security solution that is standards-based. With IPsec, data is transmitted over a public network through tunnels. A tunnel is a secure, logical communication path between two peers, which can be devices in a site-to-site VPN or a device and user in remote access IPsec VPNs. Traffic that enters an IPsec tunnel is secured by a combination of security protocols and algorithms called a transform set.

 
    [bookmark: pgfId-841451]An IPsec proposal is used in Phase 2 of an IKE negotiation, as explained in Understanding IKE. The specific content of the proposal varies according to topology type (site-to-site or remote access) and device type, although the proposals are broadly similar and contain many of the same elements, such as IPsec transform sets.

 
    [bookmark: pgfId-841453]The following topics explain IPsec proposal concepts and procedures in more detail:

 
     
     		 [bookmark: pgfId-841458]Understanding IPsec Proposals for Site-to-Site VPNs

 
    

 
    [bookmark: pgfId-841463] – Understanding Crypto Maps

 
    [bookmark: pgfId-841468] – Understanding Transform Sets

 
    [bookmark: pgfId-841473] – Understanding Reverse Route Injection

 
     
     		 [bookmark: pgfId-841478]Configuring IPsec Proposals in Site-to-Site VPNs

 
     		 [bookmark: pgfId-841483]Configuring IPSec IKEv1 or IKEv2 Transform Set Policy Objects

 
     		 [bookmark: pgfId-841488]Configuring an IPsec Proposal for Easy VPN

 
     		 [bookmark: pgfId-841493]Configuring an IPsec Proposal on a Remote Access VPN Server (ASA, PIX 7.0+ Devices)

 
     		 [bookmark: pgfId-841498]Configuring an IPsec Proposal on a Remote Access VPN Server (IOS, PIX 6.3 Devices)

 
    

 
     
      [bookmark: pgfId-841506][bookmark: 69067][bookmark: vpchap_cncpt_UnderstandingIPsecTunnelPolicies]Understanding IPsec Proposals for Site-to-Site VPNs[bookmark: marker-841504]

 
     [bookmark: pgfId-841508]IPsec is one of the most secure methods for setting up a VPN. IPsec provides data encryption at the IP packet level, offering a robust security solution that is standards-based. Pure IPsec configurations cannot use routing protocols—the policy created is used for pure IPsec provisioning. You can configure pure IPsec on Cisco IOS routers, PIX Firewalls, Catalyst VPN Service Modules, and Adaptive Security Appliance (ASA) devices.

 
     [bookmark: pgfId-841510]With IPsec, data is transmitted over a public network through tunnels. A tunnel is a secure, logical communication path between two peers. Traffic that enters an IPsec tunnel is secured by a combination of security protocols and algorithms called a transform set.

 
     [bookmark: pgfId-841512]In Security Manager, you use an IPsec Proposal policy to define the settings required for a IPsec tunnels. An IPsec proposal is a collection of one or more crypto maps that are applied to the VPN interfaces on the devices. A crypto map combines all the components required to set up IPsec security associations, including transform sets. A crypto map can also be configured with Reverse Route Injection (RRI).

 
     [bookmark: pgfId-841514]The following topics provide more information:

 
      
      		 [bookmark: pgfId-841519]Understanding Crypto Maps

 
      		 [bookmark: pgfId-841524]Understanding Transform Sets

 
      		 [bookmark: pgfId-841529]Understanding Reverse Route Injection

 
     

 
     [bookmark: pgfId-841531]Related Topics

 
      
      		 [bookmark: pgfId-841536]Configuring IPsec Proposals in Site-to-Site VPNs

 
     

 
    
 
     
      [bookmark: pgfId-841550][bookmark: 69092][bookmark: vpchap_cncpt_AboutCryptoMaps]Understanding Crypto Maps[bookmark: marker-841542][bookmark: marker-841544][bookmark: marker-841546][bookmark: marker-841548]

 
     [bookmark: pgfId-841552]A crypto map combines all components required to set up IPsec security associations (SA), including IPsec rules, transform sets, remote peers, and other parameters that might be necessary to define an IPsec SA. A crypto map entry is a named series of CLI commands. Crypto map entries with the same crypto map name (but different map sequence numbers) are grouped into a crypto map set, which is applied to the VPN interfaces on relevant devices. All IP traffic passing through the interface is evaluated against the applied crypto map set.

 
     [bookmark: pgfId-841554]When two peers try to establish an SA, they must each have at least one compatible crypto map entry. The transform set defined in the crypto map entry is used in the IPsec security negotiation to protect the data flows specified by that crypto map’s IPsec rules.

 
     [bookmark: pgfId-841556]Dynamic crypto map policies are used in site-to-site VPNs when an unknown remote peer tries to initiate an IPsec security association with the local hub. The hub cannot be the initiator of the security association negotiation. Dynamic crypto policies allow remote peers to exchange IPsec traffic with a local hub even if the hub does not know the remote peer’s identity. You can create a dynamic crypto policy on individual hubs or on a device group that contains hubs. The policy is written only to the hubs, not to any spokes that might be contained in the group. A dynamic crypto map policy essentially creates a crypto map entry without all the parameters configured. The missing parameters are later dynamically configured (as the result of an IPsec negotiation) to match a remote peer’s requirements. The peer addresses for dynamic or static crypto maps are deduced from the VPN topology.

 
     [bookmark: pgfId-841558]Dynamic crypto map policies apply only in a hub-and-spoke VPN configuration—in a point-to-point or full mesh VPN topology, you can apply only static crypto map policies.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-841560]Note (Site-to-site VPNs.) Except for Extranet VPNs, Security Manager can manage an existing VPN tunnel only if the tunnel’s peers are managed by Security Manager. In such a case, Security Manager uses the same crypto map name for the tunnel on the peers. On subsequent deployments, only Security Manager tunnels are managed (Security Manager maintains a log of all tunnels that were configured).


     
      

     

     

 
     [bookmark: pgfId-841562]Related Topics

 
      
      		 [bookmark: pgfId-841567]Understanding IPsec Proposals

 
      		 [bookmark: pgfId-841572]Understanding Transform Sets

 
      		 [bookmark: pgfId-841577]Configuring IPsec Proposals in Site-to-Site VPNs

 
     

 
    
 
     
      [bookmark: pgfId-841593][bookmark: 69122][bookmark: vpchap_cncpt_AboutTransformSets]Understanding Transform Sets[bookmark: marker-841583][bookmark: marker-841585][bookmark: marker-841587][bookmark: marker-841589][bookmark: marker-841591]

 
     [bookmark: pgfId-841595]A transform set is a combination of security protocols and algorithms that secure traffic in an IPsec tunnel. During the IPsec security association (SA) negotiation, peers search for a transform set that is the same at both peers. When such a transform set is found, it is applied to create an SA that protects data flows in the access list for that crypto map, protecting the traffic in the VPN.

 
     [bookmark: pgfId-841597]There are separate IPsec transform sets for IKEv1 and IKEv2. With IKEv1 transform sets, for each parameter, you set one value. For IKEv2 transform sets, you can configure multiple encryption and integration algorithms for a single proposal. ASA devices order the settings from the most secure to the least secure and negotiate with the peer using that order. This allows you to potentially send a single proposal to convey all the allowed combinations instead of the need to send each allowed combination individually as with IKEv1.

 
     [bookmark: pgfId-841599]You can specify a number of transform sets per IPsec proposal policy. If you are defining the policy on a spoke or a group of spokes, you do not usually have to specify more than one transform set. This is because the spoke’s assigned hub would typically be a higher performance router capable of supporting any transform set that the spoke supports. However, if you are defining the policy on a hub for dynamic crypto, you should specify more than one transform set to ensure that there will be a transform set match between the hub and the unknown spoke. If more than one of your selected transform sets is supported by both peers, the transform set that provides the highest security is used.

 
     [bookmark: pgfId-841604]Security Manager provides predefined transform sets that you can use in your tunnel policies. You can also create your own transform sets. For more information, see Configuring IPSec IKEv1 or IKEv2 Transform Set Policy Objects.

 
     [bookmark: pgfId-841606]Selecting Tunnel Mode for IKEv1 Transform Sets

 
     [bookmark: pgfId-841608]When defining an IKEv1 transform set, you must specify which IPsec mode of operation to use—tunnel mode or transport mode. You can use the AH and ESP protocols to protect an entire IP payload (Tunnel mode) or just the upper-layer protocols of an IP payload (Transport mode).

 
     [bookmark: pgfId-841610]In tunnel mode (the default), the entire original IP datagram is encrypted, and it becomes the payload in a new IP packet. This mode allows a router to act as an IPsec proxy. That is, the router performs encryption on behalf of the hosts. The source’s router encrypts packets and forwards them along the IPsec tunnel. The destination’s router decrypts the original IP datagram and forwards it on to the destination system. The major advantage of tunnel mode is that the end systems do not need to be modified to enjoy the benefits of IPsec. Tunnel mode also protects against traffic analysis. With tunnel mode, an attacker can only determine the tunnel endpoints and not the true source and destination of the tunneled packets, even if they are the same as the tunnel endpoints.

 
     [bookmark: pgfId-841612]In transport mode, only the IP payload is encrypted, and the original IP headers are left intact. This mode has the advantage of adding only a few bytes to each packet. It also allows devices on the public network to see the final source and destination of the packet. However, by passing the IP header in the clear, transport mode allows an attacker to perform some traffic analysis. For example, an attacker could see when a company’s CEO sent many packets to another senior executive. However, the attacker would only know that IP packets were sent; the attacker would not be able to decipher the contents of the packets. With transport mode, the destination of the flow must be an IPsec termination device.
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     [bookmark: pgfId-841614]Note You cannot use transport mode for VPN topologies using regular IPsec or Easy VPN.


     
      

     

     

 
     [bookmark: pgfId-841616]Related Topics

 
      
      		 [bookmark: pgfId-841621]Understanding IPsec Proposals

 
      		 [bookmark: pgfId-841626]Understanding Crypto Maps

 
      		 [bookmark: pgfId-841631]Configuring IPsec Proposals in Site-to-Site VPNs

 
     

 
    
 
     
      [bookmark: pgfId-841641][bookmark: 69165][bookmark: vpchap_cncpt_AboutReverseRouteInjection]Understanding Reverse Route Injection[bookmark: marker-841637][bookmark: marker-841639]

 
     [bookmark: pgfId-841643]Reverse Route Injection (RRI) enables static routes to be automatically inserted into the routing process for those networks and hosts protected by a remote tunnel endpoint. These protected hosts and networks are known as remote proxy identities. Each route is created on the basis of the remote proxy network and mask, with the next hop to this network being the remote tunnel endpoint. By using the remote VPN router as the next hop, the traffic is forced through the crypto process to be encrypted.

 
     [bookmark: pgfId-841645]After the static route is created on the VPN router, this information is propagated to upstream devices, allowing them to determine the appropriate VPN router to which to send returning traffic in order to maintain IPsec state flows. This is particularly useful if multiple VPN routers are used at a site to provide load balancing or failover, or if the remote VPN devices are not accessible through a default route. Routes are created in either the global routing table or the appropriate virtual route forwarding (VRF) table.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-841653]Note Security Manager automatically configures RRI on devices with High Availability (HA) or on the IPsec Aggregator when VRF-Aware IPsec is configured. You can also configure RRI on a device’s crypto map in a remote access VPN. See Configuring an IPsec Proposal on a Remote Access VPN Server (ASA, PIX 7.0+ Devices) and Configuring an IPsec Proposal on a Remote Access VPN Server (IOS, PIX 6.3 Devices).


     
      

     

     

 
     [bookmark: pgfId-841655]In Security Manager, the following options are available for configuring Reverse Route Injection:

 
      
      		 [bookmark: pgfId-841657]For dynamic crypto maps, routes are created upon the successful establishment of IPsec security associations (SAs) for those remote proxies. The next hop back to those remote proxies is through the remote VPN router whose address is learned and applied during the creation of the dynamic crypto map template. The routes are deleted after the SAs are deleted.

 
      		 [bookmark: pgfId-841659]The Remote Peer option (available for IOS devices only) enables you to specify an interface or address as the explicit next hop to the remote VPN device. Two routes are created. One route is the standard remote proxy ID and the next hop is the remote VPN client tunnel address. The second route is the actual route to the remote tunnel endpoint, when a recursive lookup is forced to impose that the remote endpoint is reachable via “next-hop.” Creation of the second route for the actual next hop is very important for VRF-Aware IPsec when a default route must be overridden by a more explicit route.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-841661]Note For devices using a VPN Services Module (VPNSM), the next hop is the interface or subinterface/VLAN on which the crypto map is applied.


     
      

     

     

 
      
      		 [bookmark: pgfId-841663]In the case of Remote Peer IP (available for IOS devices only), one route is created to a remote proxy by way of a user-defined next hop. The next hop can be used to override a default route to properly direct outgoing encrypted packets. This option reduces the number of routes created and supports those platforms that do not readily facilitate route recursion.

 
     

 
     [bookmark: pgfId-841665]Related Topics

 
      
      		 [bookmark: pgfId-841670]Understanding IPsec Proposals

 
      		 [bookmark: pgfId-841675]Understanding Crypto Maps

 
      		 [bookmark: pgfId-841680]Configuring IPsec Proposals in Site-to-Site VPNs

 
     

 
    
 
     
      [bookmark: pgfId-841690][bookmark: 69200][bookmark: vpchap_proc_ConfiguringIPsecProposals]Configuring IPsec Proposals in Site-to-Site VPNs[bookmark: marker-841688]

 
     [bookmark: pgfId-841692]Use the IPsec Proposal page to configure the IPsec proposal used during IKE Phase 2 negotiations for site-to-site VPN topologies with the exception of Easy VPN topologies.

 
     [bookmark: pgfId-841694]IPsec proposals used with Easy VPN topologies, and with remote access VPNs, are significantly different than the basic site-to-site proposal explained in this topic. For information on IPsec proposals in these other topologies, see the following topics:

 
      
      		 [bookmark: pgfId-841699]Configuring an IPsec Proposal for Easy VPN

 
      		 [bookmark: pgfId-841704]Configuring an IPsec Proposal on a Remote Access VPN Server (ASA, PIX 7.0+ Devices)

 
      		 [bookmark: pgfId-841709]Configuring an IPsec Proposal on a Remote Access VPN Server (IOS, PIX 6.3 Devices)

 
     

 
     [bookmark: pgfId-841711]Navigation Path

 
      
      		 [bookmark: pgfId-841716](Site-to-Site VPN Manager Window) Select a non-Easy VPN topology in the VPNs selector, then select  IPsec Proposal in the Policies selector. If necessary, click the  IPsec Proposal tab.

 
      		 [bookmark: pgfId-841718](Policy view) Select  Site-to-Site VPN > IPsec Proposal from the Policy Types selector. Select an existing shared policy or create a new one.

 
     

 
     [bookmark: pgfId-841720]Related Topics

 
      
      		 [bookmark: pgfId-841725]Understanding IKE

 
      		 [bookmark: pgfId-841730]Understanding IPsec Proposals for Site-to-Site VPNs

 
     

 
     [bookmark: pgfId-841732]Field Reference

 
     [bookmark: pgfId-841735] 

 
      
       
        
        [bookmark: pgfId-838162]Table 26-3 [bookmark: 69242]IPsec Proposal Page, Site-to-Site VPNs (except Easy VPN) 

 
        
       
         
         		
           
           [bookmark: pgfId-838168]Element
          
  
         		
           
           [bookmark: pgfId-838170]Description
          
  
        

 
         
         		[bookmark: pgfId-838176]Crypto Map Type

 [bookmark: pgfId-838178](Hub and spoke and full mesh topologies only.)

  
         		[bookmark: pgfId-838183]A crypto map combines all the components required to set up IPsec security associations (SA). When two peers try to establish an SA, they must each have at least one compatible crypto map entry. For more information, see Understanding Crypto Maps.

 [bookmark: pgfId-838185]Select the type of crypto map you want to generate:

 
           
           		 [bookmark: pgfId-838187]Static—Use a static crypto map in a point-to-point or full mesh VPN topology.

 
           		 [bookmark: pgfId-838189]Dynamic—Dynamic crypto maps can only be used in a hub-and-spoke VPN topology. Dynamic crypto map policies allow remote peers to exchange IPsec traffic with a local hub, even if the hub does not know the remote peer’s identity.

 
          

  
        

 
         
         		[bookmark: pgfId-838195]Enable IKEv1

 [bookmark: pgfId-838197]Enable IKEv2

  
         		[bookmark: pgfId-838199]The IKE versions to use during IKE negotiations. IKEv2 is supported on ASA Software release 8.4(x) only. Select either or both options as appropriate; you must select IKEv1 if any device in the topology does not support IKEv2.

 [bookmark: pgfId-838204]When you select both options in hub-and-spoke or full mesh topologies, Security Manager automatically assigns the IKE version to devices based on the OS type and version used by the device. You can change these assignments by clicking the IKE Version tab, then click the Select button beneath the IKEv1 Enabled Peers or IKEv2 Enabled Peers to change which version is assigned to the device. You can change the assignments for devices that support each version only; other devices are not selectable. For more information, see Selecting the IKE Version for Devices in Site-to-Site VPNs.

  
        

 
         
         		[bookmark: pgfId-838210]Transform Sets

 [bookmark: pgfId-838212]IKEv2 Transform Sets

  
         		[bookmark: pgfId-838217]The transform sets to use for your tunnel policy. Transform sets specify which authentication and encryption algorithms will be used to secure the traffic in the tunnel. The transform sets are different for each IKE version; select objects for each supported version. You can select up to 11 transform sets for each. For more information, see Understanding Transform Sets.

 [bookmark: pgfId-838219]If more than one of your selected transform sets is supported by both peers, the transform set that provides the highest security will be used.

 [bookmark: pgfId-838224]Click Select to select the IPsec transform set policy objects to use in the topology. If the required object is not yet defined, you can click the Create (+) button beneath the available objects list in the selection dialog box to create a new one. For more information, see Configuring IPSec IKEv1 or IKEv2 Transform Set Policy Objects.

 [bookmark: pgfId-838226]Note IKEv1 Transform sets can use tunnel mode or transport mode of IPsec operation. However, you cannot use transport mode in IPsec or Easy VPN topologies.

  
        

 
         
         		[bookmark: pgfId-838232]Enable Perfect Forward Secrecy

 [bookmark: pgfId-838234]Modulus Group

  
         		[bookmark: pgfId-838236]Whether to use Perfect Forward Secrecy (PFS) to generate and use a unique session key for each encrypted exchange. The unique session key protects the exchange from subsequent decryption, even if the entire exchange was recorded and the attacker has obtained the preshared or private keys used by the endpoint devices.

 [bookmark: pgfId-838241]If you select this option, also select the Diffie-Hellman key derivation algorithm to use when generating the PFS session key in the Modulus Group list. For an explanation of the options, see Deciding Which Diffie-Hellman Modulus Group to Use.

  
        

 
         
         		[bookmark: pgfId-838247]Lifetime (sec)

 [bookmark: pgfId-838249]Lifetime (kbytes)

  
         		[bookmark: pgfId-838251]The global lifetime settings for the crypto IPsec security association (SA). You can specify the IPsec lifetime in seconds, in kilobytes, or both.

 
           
           		 [bookmark: pgfId-838253]Seconds (sec)—The number of seconds an SA will exist before expiring. The default is 3600 seconds (one hour).

 
           		 [bookmark: pgfId-838255]Kilobytes (kbytes)—The volume of traffic (in kilobytes) that can pass between IPsec peers using a given SA before it expires. Valid values depend on the device type. Enter a value within the range 10-2147483647 for an IOS router, and 2560-536870912 for an ASA/PIX7.0+ device.

 
          

 [bookmark: pgfId-838257]The default value is 4,608,000 kilobytes.

  
        

 
         
         		[bookmark: pgfId-838263]QoS Preclassify

  
         		[bookmark: pgfId-838265]Supported on Cisco IOS routers, except 7600 devices.

 [bookmark: pgfId-838267]When selected, enables the classification of packets before tunneling and encryption occur.

 [bookmark: pgfId-838269]The Quality of Service (QoS) for VPNs feature enables Cisco IOS QoS services to operate with tunneling and encryption on an interface. The QoS features on the output interface classify packets and apply the appropriate QoS service before the data is encrypted and tunneled, enabling traffic flows to be adjusted in congested environments, and resulting in more effective packet tunneling.

  
        

 
         
         		[bookmark: pgfId-838275]Reverse Route

  
         		[bookmark: pgfId-838277]Supported on ASA devices, PIX 7.0+ devices, and Cisco IOS routers except 7600 devices.

 [bookmark: pgfId-838282]Reverse Route Injection (RRI) enables static routes to be automatically inserted into the routing process for those networks and hosts protected by a remote tunnel endpoint. For more information, see Understanding Reverse Route Injection.

 [bookmark: pgfId-838284]Select one of the following options to configure RRI on the crypto map:

 
           
           		 [bookmark: pgfId-838286] None —Disables the configuration of RRI on the crypto map.

 
           		 [bookmark: pgfId-838288] Standard —(ASA, PIX 7.0+, IOS devices) Creates routes based on the destination information defined in the crypto map access control list (ACL). This is the default option.

 
           		 [bookmark: pgfId-838290] Remote Peer —(IOS devices only) Creates two routes, one for the remote endpoint and one for route recursion to the remote endpoint via the interface to which the crypto map is applied.

 
           		 [bookmark: pgfId-838292] Remote Peer IP —(IOS devices only) Specifies an address as the explicit next hop to the remote VPN device. Enter the IP address or a network/host object that specifies the address, or click  Select to select the network/host object from a list or to create a new object.

 
          

 option in the object to override the IP address, if required, for specific devices that use this object.

  
        

 
         
         		 [bookmark: pgfId-838300]ESPv3 Settings (ASA 9.0.1+ only)

 [bookmark: pgfId-838302]Specify whether incoming ICMP error messages are validated for cryptography and dynamic cryptography maps, set the per-security association policy, or enable traffic flow packets:

  
        

 
         
         		[bookmark: pgfId-838310]Validate Incoming ICMP error messages

  
         		[bookmark: pgfId-838312]Whether to validate those ICMP error messages received through an IPsec tunnel and destined for an interior host on the private network.

  
        

 
         
         		[bookmark: pgfId-838318]Enable Do Not Fragment (DF) Policy

  
         		[bookmark: pgfId-838320]Define how the IPsec subsystem handles large packets that have the do-not-fragment (DF) bit set in the IP header. Choose one of the following:

 
           
           		 [bookmark: pgfId-838322]Set—Sets and uses the DF bit.

 
           		 [bookmark: pgfId-838324]Copy—Maintains the DF bit.

 
           		 [bookmark: pgfId-838326]Clear—Ignores the DF bit.

 
          

  
        

 
         
         		[bookmark: pgfId-838332]Enable Traffic Flow Confidentiality (TFC) Packets

  
         		[bookmark: pgfId-838334]Enable dummy TFC packets that mask the traffic profile which traverses the tunnel.

 [bookmark: pgfId-838336]Note You must have an IKEv2 IPsec proposal set on the Tunnel Policy (Crypto Map) Basic tab before enabling TFC. Traffic Flow Confidentiality is not available when IKEv1 is enabled.

 [bookmark: pgfId-838338]Use the Burst, Payload Size, and Timeout parameters to generate random length packets at random intervals across the specified SA.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-841751][bookmark: 69369][bookmark: vpchap_proc_SelectingtheIKEVersionforDevicesinSitetoSiteVPNs]Selecting the IKE Version for Devices in Site-to-Site VPNs[bookmark: marker-841747][bookmark: marker-841749]

 
     [bookmark: pgfId-841753]Use the IKE Version tab in the IPsec Proposal page to select which version of IKE to use for each device in a hub-and-spoke or full mesh site-to-site VPN. This tab appears only in the Site-to-Site VPN Manager; you cannot configure the options in Policy view, because they are specific to the actual devices in a VPN topology.

 
     [bookmark: pgfId-841758]The IKE Version tab contains two lists: IKEv1 Enabled Peers and IKEv2 Enabled Peers. When you configure the IPsec proposal, as described in Configuring IPsec Proposals in Site-to-Site VPNs, you select which IKE versions to allow in the VPN (version 1, version 2, or both). Security Manager automatically chooses which IKE version to use for a device based on the OS version used by the device. For example, IOS routers always appear in the IKEv1 Enabled Peers list. If a device supports both IKEv1 and IKEv2, it appears in both lists.

 
     [bookmark: pgfId-841760]You need to alter the selection only if you are allowing both IKE versions in a VPN and you want to specifically prevent some IKEv2-capable devices from using one of the IKE versions.

 
     [bookmark: pgfId-841762]To change which IKE version is allowed for a device, click the Select button beneath the list from which you want to remove the device (or to add the device after previously removing it). A selection dialog box opens where you can do the following (click OK to confirm your choices):

 
      
      		 [bookmark: pgfId-841764]To remove a device, so that it cannot use the IKE version, highlight it in the Selected Peers list and click  << to move it to the Available Peers list.

 
      		 [bookmark: pgfId-841766]To add a device, so that it is allowed to use the IKE version, highlight it in the Available Peers list and click  >> to move it to the Selected Peers list.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-841768]Tip The selection lists include only those devices that support both IKE versions, because you cannot change the version selection for devices that support a single version. IKEv2 is supported on ASA Software 8.4(1)+.


     
      

     

     

 
     [bookmark: pgfId-841770]Navigation Path

 
     [bookmark: pgfId-841775](Site-to-Site VPN Manager Window) Select a non-Easy VPN topology in the VPNs selector, then select IPsec Proposal in the Policies selector. Click the IKE Version tab.

 
     [bookmark: pgfId-841777]Related Topics

 
      
      		 [bookmark: pgfId-841782]Understanding IKE

 
      		 [bookmark: pgfId-841787]Understanding IPsec Proposals for Site-to-Site VPNs

 
     

 
    
 
     
      [bookmark: pgfId-841813][bookmark: 69413][bookmark: pobjpage_cncpt_IPsecTransformSetDialogBox]Configuring IPSec IKEv1 or IKEv2 Transform Set Policy Objects[bookmark: marker-841801][bookmark: marker-841803][bookmark: marker-841805][bookmark: marker-841807][bookmark: marker-841809][bookmark: marker-841811]

 
     [bookmark: pgfId-841815]Use the Add or Edit IPSec Transform Set dialog box to configure IPSec transform sets for use in IKE negotiations.

 
     [bookmark: pgfId-841817]You can create IPSec transform set objects for use in IPSec proposals when defining IPSec-protected traffic in site-to-site and remote access VPNs. During IPSec security association negotiation, the peers agree to use a particular transform set when protecting a particular data flow.

 
     [bookmark: pgfId-841819]Two different security protocols are included within the IPSec standard:

 
      
      		 [bookmark: pgfId-841821]Encapsulating Security Protocol (ESP)—Provides authentication, encryption, and anti-replay services. ESP is IP protocol type 50.

 
      		 [bookmark: pgfId-841823]Authentication Header (AH)—Provides authentication and anti-replay services. AH does not provide encryption and has largely been superseded by ESP. It is also supported on routers only. AH is IP protocol type 51.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-841825]Note We recommend using both encryption and authentication on IPSec tunnels.


     
      

     

     

 
     [bookmark: pgfId-841827]There are separate IPsec transform set objects based on the IKE version, IKEv1 or IKEv2:

 
      
      		 [bookmark: pgfId-841829]When you create an IPSec IKEv1 transform set object, you select the mode in which IPSec should operate, as well as define the required encryption and authentication types. Additionally, you can select whether to include compression in the transform set. You can select single options for the algorithms, so if you want to support multiple combinations in a VPN, you must create multiple IPsec IKEv1 transform set objects.

 
      		 [bookmark: pgfId-841831]When you create an IPSec IKEv2 transform set object, you can select all of the encryption and hash algorithms that you will allow in a VPN. During IKEv2 negotiations, the peers select the most appropriate options that each support.

 
     

 
     [bookmark: pgfId-841833]Navigation Path

 
     [bookmark: pgfId-841835]Select Manage > Policy Objects, then select IPSec Transform Sets > IPSec IKEv1 Transform Sets or IPSec Transform Sets > IPSec IKEv2 Transform Sets from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-841837]Related Topics

 
      
      		 [bookmark: pgfId-841842]Understanding Transform Sets

 
      		 [bookmark: pgfId-841847]Overview of IKE and IPsec Configurations

 
      		 [bookmark: pgfId-841852]Comparing IKE Version 1 and 2

 
      		 [bookmark: pgfId-841857]Understanding IKE

 
      		 [bookmark: pgfId-841862]Understanding IPsec Proposals

 
      		 [bookmark: pgfId-841867]IPsec Proposal Editor (ASA, PIX 7.0+ Devices)

 
      		 [bookmark: pgfId-841872]IPsec Proposal Editor (IOS, PIX 6.3 Devices)

 
      		 [bookmark: pgfId-841877]Configuring an IPsec Proposal on a Remote Access VPN Server (ASA, PIX 7.0+ Devices)

 
      		 [bookmark: pgfId-841882]Configuring an IPsec Proposal on a Remote Access VPN Server (IOS, PIX 6.3 Devices)

 
      		 [bookmark: pgfId-841887]Configuring IPsec Proposals in Site-to-Site VPNs

 
      		 [bookmark: pgfId-841892]Configuring an IPsec Proposal for Easy VPN

 
      		 [bookmark: pgfId-841897]Configuring IKEv1 Proposal Policy Objects

 
      		 [bookmark: pgfId-841902]Creating Policy Objects

 
      		 [bookmark: pgfId-841907]Policy Object Manager

 
     

 
     [bookmark: pgfId-841909]Field Reference

 
     [bookmark: pgfId-841912] 

 
      
       
        
        [bookmark: pgfId-838351]Table 26-4 [bookmark: 69510]IPSec IKEv1 or IKEv2 Transform Set Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-838357]Element
          
  
         		
           
           [bookmark: pgfId-838359]Description
          
  
        

 
         
         		[bookmark: pgfId-838365]Name

  
         		[bookmark: pgfId-838367]The name of the policy object. A maximum of 128 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-838373]Description

  
         		[bookmark: pgfId-838375]A description of the policy object. A maximum of 1024 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-838381]Mode

 [bookmark: pgfId-838383](IKEv1 only.)

  
         		[bookmark: pgfId-838385]The mode in which the IPSec tunnel operates:

 
           
           		 [bookmark: pgfId-838387]Tunnel—Tunnel mode encapsulates the entire IP packet. The IPSec header is added between the original IP header and a new IP header. This is the default.

 
          

 [bookmark: pgfId-838389]Use tunnel mode when the firewall is protecting traffic to and from hosts positioned behind the firewall. Tunnel mode is the normal way regular IPSec is implemented between two firewalls (or other security gateways) that are connected over an untrusted network, such as the Internet.

 
           
           		 [bookmark: pgfId-838391]Transport—Transport mode encapsulates only the upper-layer protocols of an IP packet. The IPSec header is inserted between the IP header and the upper-layer protocol header (such as TCP).

 
          

 [bookmark: pgfId-838393]Transport mode requires that both the source and destination hosts support IPSec, and can only be used when the destination peer of the tunnel is the final destination of the IP packet. Transport mode is generally used only when protecting a Layer 2 or Layer 3 tunneling protocol such as GRE, L2TP, and DLSW.

  
        

 
         
         		[bookmark: pgfId-838399]ESP Encryption

  
         		[bookmark: pgfId-838406]The Encapsulating Security Protocol (ESP) encryption algorithm that the transform set should use. For more information on the following options, see Deciding Which Encryption Algorithm to Use.[bookmark: marker-838404]

 [bookmark: pgfId-838408]For IKEv1, select one of the following options. For IKEv2, click Select to open a dialog box where you can select all of the options you want to support:

 [bookmark: pgfId-838410]Note AES-GCM/GMAC can only be configured on 5580 and newer ASA platforms.

 
           
           		 [bookmark: pgfId-838412](Blank)—Do not use ESP encryption.

 
           		 [bookmark: pgfId-838414]DES—Encrypts according to the Data Encryption Standard using 56-bit keys.

 
           		 [bookmark: pgfId-838416]3DES—Encrypts three times using 56-bit keys. 3DES is more secure than DES, but requires more processing for encryption and decryption. It is less secure than AES. A 3DES license is required to use this option.

 
           		 [bookmark: pgfId-838418]AES-128 (AES)—Encrypts according to the Advanced Encryption Standard using 128-bit keys.

 
           		 [bookmark: pgfId-838420]AES-192—Encrypts according to the Advanced Encryption Standard using 192-bit keys.

 
           		 [bookmark: pgfId-838422]AES-256—Encrypts according to the Advanced Encryption Standard using 256-bit keys.

 
           		 [bookmark: pgfId-838424]ESP-Null (NULL)—A null encryption algorithm. Transform sets defined with ESP-Null provide authentication without encryption; this is typically used for testing purposes only.

 
           		 [bookmark: pgfId-838426]AES-GCM (IKEv2 only)—Encrypts according to the Advanced Encryption Standard in Galois/Counter Mode using 128-bit keys. (ASA 9.0.1+ devices only).

 
           		 [bookmark: pgfId-838428]AES-GCM-192 (IKEv2 only)—Encrypts according to the Advanced Encryption Standard in Galois/Counter Mode using 192-bit keys. (ASA 9.0.1+ devices only).

 
           		 [bookmark: pgfId-838430]AES-GCM-256 (IKEv2 only)—Encrypts according to the Advanced Encryption Standard in Galois/Counter Mode using 256-bit keys. (ASA 9.0.1+ devices only).

 
           		 [bookmark: pgfId-838432]AES-GMAC (IKEv2 only)—Encrypts according to the Advanced Encryption Standard Galois Message Authentication Codeusing 128-bit keys.

 
           		 [bookmark: pgfId-838434]AES-GMAC-192 (IKEv2 only)—Encrypts according to the Advanced Encryption Standard Galois Message Authentication Codeusing 192-bit keys.

 
           		 [bookmark: pgfId-838436]AES-GMAC-256 (IKEv2 only)—Encrypts according to the Advanced Encryption Standard Galois Message Authentication Code using 256-bit keys.

 
          

  
        

 
         
         		[bookmark: pgfId-838442]ESP Hash Algorithm (IKEv1)

 [bookmark: pgfId-838444]ESP Integration Algorithm (IKEv2)

 [bookmark: pgfId-838446]AH Hash Algorithm (IKEv1 only)

  
         		[bookmark: pgfId-838450]The hash or integrity algorithm to use in the transform set for authentication. For IKEv1, the default is to use SHA for ESP authentication and to not use AH authentication. For IKEv2, there is no default. The AH hash algorithm is used on routers only. [bookmark: marker-838448]

 [bookmark: pgfId-838452]For IKEv1, select one of the following options. For IKEv2, click Select to open a dialog box where you can select all of the options you want to support.

 
           
           		 [bookmark: pgfId-838454]None—Does not perform ESP or AH authentication.

 
           		 [bookmark: pgfId-838456]SHA, SHA-1 (Secure Hash Algorithm version 1)—Produces a 160-bit digest. SHA is more resistant to brute-force attacks than MD5, but requires more processing time.

 
          

 [bookmark: pgfId-838458]The following options, which are even more secure, are available for IKEv2 configurations on ASA 8.4(2+) devices:

 [bookmark: pgfId-838460] – SHA512—A 512-bit key.

 [bookmark: pgfId-838462] – SHA384—A 384-bit key.

 [bookmark: pgfId-838464] – SHA256—A 256-bit key.

 
           
           		 [bookmark: pgfId-838466]MD5 (Message Digest 5)—Produces a 128-bit digest. MD5 uses less processing time than SHA, but is less secure.

 
           		 [bookmark: pgfId-838468]Null—No encryption algorithm. For use with AES-GCM, AES-GCM-192, AES-GCM-256, AES-GMAC, AES-GMAC-192, and AES-GMAC-256 only.

 
          

  
        

 
         
         		[bookmark: pgfId-838474]Compression

 [bookmark: pgfId-838476](IKEv1 only, IOS devices only.)

  
         		[bookmark: pgfId-838478]Whether to compress the data in the IPSec tunnel using the Lempel-Ziv-Stac (LZS) algorithm.

  
        

 
         
         		[bookmark: pgfId-838484]Category

  
         		[bookmark: pgfId-838489]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-841936][bookmark: 69623][bookmark: vpchap_proc_ConfiguringVPNGlobalSettings]Configuring VPN Global Settings[bookmark: marker-841920][bookmark: marker-841922][bookmark: marker-841924][bookmark: marker-841926][bookmark: marker-841928][bookmark: marker-841930][bookmark: marker-841932][bookmark: marker-841934]

 
    [bookmark: pgfId-841938]You can define global settings that apply to all devices in your remote access or site-to-site VPN topology. These settings include Internet Key Exchange (IKE), IKEv2, IPsec, NAT, and fragmentation definitions. The global settings typically have defaults that work in most situations, so configuring the Global Settings policy is optional in most cases; configure it only if you need non-default behavior or if you are supporting IKEv2 negotiations in a remote access IPsec VPN.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-841943]Note The VPN Global Settings policy for site-to-site VPNs applies to all technologies except GET VPN. For an explanation of global settings for GET VPN, see Configuring Global Settings for GET VPN.


    
     

    

    

 
    
 
    [bookmark: pgfId-841945]Step 1 Do one of the following to open the global settings policy based on the type of VPN you are configuring:

 
     
     		 [bookmark: pgfId-841947]For remote access VPNs, do one of the following:

 
    

 
    [bookmark: pgfId-841949] – (Device View) Select Remote Access VPN > Global Settings from the Policy selector.

 
    [bookmark: pgfId-841951] – (Policy View) Select Remote Access VPN > Global Settings from the Policy Type selector. Select an existing policy or create a new one.

 
     
     		 [bookmark: pgfId-841953]For site-to-site VPNs, do one of the following:

 
    

 
    [bookmark: pgfId-841958] – Open the Site-to-Site VPN Manager Window, select a topology in the VPNs selector, then select VPN Global Settings in the Policies selector.

 
    [bookmark: pgfId-841960] – (Policy view) Select Site-to-Site VPN > VPN Global Settings from the Policy Types selector. Select an existing shared policy or create a new one.

 
    [bookmark: pgfId-841962]Step 2 Select the desired tab and configure the settings as needed:

 
     
     		 [bookmark: pgfId-841967] ISAKMP/IPsec Settings —To configure global settings for IKE and IPsec. For detailed information about the options, see Configuring VPN Global ISAKMP/IPsec Settings.

 
     		 [bookmark: pgfId-841972] IKEv2 Settings —To configure global settings for IKE version 2 negotiations. For detailed information about the options, see Configuring VPN Global IKEv2 Settings.

 
     		 [bookmark: pgfId-841980] NAT Settings —To configure NAT behavior. For detailed information about the options, see Configuring VPN Global NAT Settings. Also see Understanding NAT in VPNs.

 
     		 [bookmark: pgfId-841985] Address Assignment —To specify one or more methods of address assignment to remote clients, see Configuring VPN Global Address Assignment Settings. The address assignment applies only to remote access VPN.

 
     		 [bookmark: pgfId-841990] General Settings —To configure fragmentation behavior and some other miscellaneous options. For detailed information about the options, see Configuring VPN Global General Settings.

 
    

 
    [bookmark: pgfId-841992]


    
     

    
 
    

 
     
      [bookmark: pgfId-842018][bookmark: 69711][bookmark: vpnpage_cncpt_AddressAssignment]Configuring VPN Global Address Assignment Settings[bookmark: marker-841998][bookmark: marker-842000][bookmark: marker-842002][bookmark: marker-842004][bookmark: marker-842006][bookmark: marker-842008][bookmark: marker-842010][bookmark: marker-842012][bookmark: marker-842014][bookmark: marker-842016]

 
     [bookmark: pgfId-842020]Use the Address Assignment tab of the VPN Global Settings page to specify one or more methods of address assignment to remote clients. The available methods are:

 
      
      		 [bookmark: pgfId-842022]Obtain IP addresses from an authentication server.

 
      		 [bookmark: pgfId-842024]Obtain IP addresses from a DHCP server.

 
      		 [bookmark: pgfId-842026]Obtain IP addresses from an internally configured pool.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-842028]Note You can configure address assignment on devices running the ASA software version 7.0(1) or higher. By default all the methods are enabled.


     
      

     

     

 
     [bookmark: pgfId-842030]Navigation Path

 
      
      		 [bookmark: pgfId-842032]For remote access VPNs, do one of the following:

 
     

 
     [bookmark: pgfId-842034] – (Device View) Select Remote Access VPN > Global Settings from the Policy selector. Click the Address Assignment tab.

 
     [bookmark: pgfId-842036] – (Policy View) Select Remote Access VPN > Global Settings from the Policy Type selector. Select an existing policy or create a new one, then click the Address Assignment tab.

 
     [bookmark: pgfId-842038]Related Topics

 
      
      		 [bookmark: pgfId-842043]Configuring VPN Global Settings

 
     

 
     [bookmark: pgfId-842045]Field Reference

 
     [bookmark: pgfId-842048] 

 
      
       
        
        [bookmark: pgfId-838502]Table 26-5 [bookmark: 69783]VPN Global Settings Page, Address Assignment Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-838508]Element
          
  
         		
           
           [bookmark: pgfId-838510]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-838516]IPv4 Address Assignment Priority
          
  
        

 
         
         		[bookmark: pgfId-838524]Use Authentication Server

  
         		[bookmark: pgfId-838526]Choose to assign IP addresses retrieved from an authentication server on a per-user basis. If you are using an authentication server (external or internal) that has IP addresses configured, we recommend using this method. If you select this option, use the Platform > Device Admin > AAA policy to define the AAA server groups to use for authenticating user access. This method is available for IPv4 and IPv6 assignment policies.

  
        

 
         
         		[bookmark: pgfId-838532]Use DHCP

  
         		[bookmark: pgfId-838534]Choose to obtain IP addresses from a DHCP server. If you use DHCP, you must configure the server using the Platform > Device Admin > Server Access > DHCP Server from the Device Policy selector. You must also define the range of IP addresses that the DHCP server can use. This method is available for IPv4 assignment policies.

  
        

 
         
         		[bookmark: pgfId-838540]Use internal address pools

  
         		[bookmark: pgfId-838542]Choose to have the ASA assign IP addresses from an internally configured pool. Internally configured address pools are the easiest method of address pool assignment to configure. If you use this method, you must configure the IP address pools. To configure IP address pools, on the Device view, select NAT > Address Pools from the Device Policy Selector. Or on the Policy view, select NAT (PIX/ASA/FWSM) > Address Pools from the Policy Type selector, then select an existing policy from the Shared Policy selector, or right-click Address Pools to create a new policy.

  
        

 
         
         		[bookmark: pgfId-838548]Allow the reuse of an IP address - minutes after it is released

  
         		[bookmark: pgfId-838550]Delays the reuse of an IP address after its return to the address pool. Adding a delay helps to prevent problems firewalls can experience when an IP address is reassigned quickly. By default, this is unchecked, meaning the ASA does not impose a delay. To add a delay, check the box and enter the number of minutes in the range 0 - 480 to delay IP address reassignment.

 [bookmark: pgfId-838552]Note This feature is available on devices running the ASA software version 8.0(3) or higher.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-842078][bookmark: 69832][bookmark: vpnpage_cncpt_ISAKMPIPsecSettingsTab-1]Configuring VPN Global ISAKMP/IPsec Settings[bookmark: marker-842058][bookmark: marker-842060][bookmark: marker-842062][bookmark: marker-842064][bookmark: marker-842066][bookmark: marker-842068][bookmark: marker-842070][bookmark: marker-842072][bookmark: marker-842074][bookmark: marker-842076]

 
     [bookmark: pgfId-842080]Use the ISAKMP/IPsec Settings tab of the VPN Global Settings page to specify global settings for Internet Key Exchange (IKE) and IPsec.

 
     [bookmark: pgfId-842082]The Internet Key Exchange (IKE) protocol, also called the Internet Security Association and Key Management Protocol (ISAKMP) is the negotiation protocol that lets two hosts agree on how to build an IPsec security association. Each ISAKMP negotiation is divided into a Phase 1 and Phase 2. Phase 1 creates the first tunnel, which protects ISAKMP negotiation messages. Phase 2 creates the tunnel that protects data.

 
     [bookmark: pgfId-842087]To set terms for ISAKMP negotiations, you create an IKE proposal. For more information, see Configuring an IKE Proposal.

 
     [bookmark: pgfId-842093]About IKE Keepalive[bookmark: marker-842089][bookmark: marker-842091]

 
     [bookmark: pgfId-842095]With IKE keepalive, tunnel peers exchange messages that demonstrate they are available to send and receive data in the tunnel. Keepalive messages transmit at set intervals, and any disruption in that interval results in the creation of a new tunnel, using a backup device.

 
     [bookmark: pgfId-842097]Devices that rely on IKE keepalive for resiliency transmit their keepalive messages regardless of whether they are exchanging other information. These keepalive messages can therefore create a small but additional demand on your network.

 
     [bookmark: pgfId-842099]A variation on IKE keepalive called keepalive dead-peer detection (DPD) sends keepalive messages between peer devices only when no incoming traffic is received and outbound traffic needs to be sent. If you want to send DPD keepalive messages when no incoming traffic is received regardless of whether there is any outbound traffic, you can specify this using the Periodic option.

 
     [bookmark: pgfId-842101]Navigation Path

 
      
      		 [bookmark: pgfId-842103]For remote access VPNs, do one of the following:

 
     

 
     [bookmark: pgfId-842105] – (Device View) Select Remote Access VPN > Global Settings from the Policy selector. Click the ISAKMP/IPsec Settings tab.

 
     [bookmark: pgfId-842107] – (Policy View) Select Remote Access VPN > Global Settings from the Policy Type selector. Select an existing policy or create a new one, then click the ISAKMP/IPsec Settings tab.

 
      
      		 [bookmark: pgfId-842109]For site-to-site VPNs, do one of the following:

 
     

 
     [bookmark: pgfId-842114] – Open the Site-to-Site VPN Manager Window, select a topology in the VPNs selector, then select VPN Global Settings in the Policies selector. Click the ISAKMP/IPsec Settings tab.

 
     [bookmark: pgfId-842116] – (Policy view) Select Site-to-Site VPN > VPN Global Settings from the Policy Types selector. Select an existing shared policy or create a new one, then click the ISAKMP/IPsec Settings tab.

 
     [bookmark: pgfId-842118]Related Topics

 
      
      		 [bookmark: pgfId-842123]Configuring VPN Global Settings

 
      		 [bookmark: pgfId-842128]Understanding IKE

 
      		 [bookmark: pgfId-842133]Understanding IPsec Proposals

 
     

 
     [bookmark: pgfId-842135]Field Reference

 
     [bookmark: pgfId-842138] 

 
      
       
        
        [bookmark: pgfId-838565]Table 26-6 [bookmark: 69930]VPN Global Settings Page, ISAKMP/IPsec Settings Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-838571]Element
          
  
         		
           
           [bookmark: pgfId-838573]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-838579]ISAKMP Settings
          
  
        

 
         
         		[bookmark: pgfId-838587]Enable Keepalive

  
         		[bookmark: pgfId-838589]Whether to configure dead-peer detection (DPD) settings. If the peer fails to respond, a new tunnel is constructed on the assumption that the peer is no longer available. IKE keepalive is defined on the spokes in a hub-and-spoke VPN topology, on both devices in a point-to-point VPN topology, or in remote access VPN configurations.

 [bookmark: pgfId-838591]Configure the following options:

 
           
           		 [bookmark: pgfId-838593]Interval—The number of seconds the peer can be idle before beginning keepalive monitoring. The range is 10-3600 seconds. The default is 10, although the ASA device default for remote access groups is 300.

 
           		 [bookmark: pgfId-838595]Retry—The interval in seconds between retries after a keepalive response has not been received. The range is 2-10 seconds for ASA, 2-60 for IOS devices. The default is 2 seconds.

 
           		 [bookmark: pgfId-838597]Periodic—(Routers running IOS Software version 12.3(7)T and later, except 7600 devices.) Whether to send DPD keepalive messages at regular intervals regardless of IPsec traffic. This changes how the interval value is used.

 
           		 [bookmark: pgfId-838599]Infinite—(ASA only.) Whether to ignore the interval and retry settings and allow the peer to be idle indefinitely.

 
          

  
        

 
         
         		[bookmark: pgfId-838605]Identity

  
         		[bookmark: pgfId-838607]During Phase I IKE negotiations, peers must identify themselves to each other. Select one of the following:

 
           
           		 [bookmark: pgfId-838609]Address—Use the IP address of the host exchanging ISAKMP identity information. This is the default.

 
           		 [bookmark: pgfId-838611]Hostname—Use the fully-qualified domain name of the host exchanging ISAKMP identity information.

 
           		 [bookmark: pgfId-838613]Auto/DN—Use automatic selection or distinguished name based on device type:

 
          

 [bookmark: pgfId-838615] – Distinguished Name (IOS devices only)—Use a distinguished name (DN) to identify a user group name.

 [bookmark: pgfId-838617] – Auto (ASA devices only)—Determine ISAKMP negotiation by connection type; IP address for preshared key or certificate distinguished name for certificate authentication.

  
        

 
         
         		[bookmark: pgfId-838623]SA Requests System Limit

  
         		[bookmark: pgfId-838625]Supported on routers running Cisco IOS Software Release 12.3(8)T and later, except 7600 routers.

 [bookmark: pgfId-838627]The maximum number of SA requests allowed before IKE starts rejecting them, from 0 to 99999. The number must equal or exceed the number of peers, or the VPN tunnels might be disconnected.

  
        

 
         
         		[bookmark: pgfId-838633]SA Requests System Threshold

  
         		[bookmark: pgfId-838635]Supported on Cisco IOS routers and Catalyst 6500/7600 devices.

 [bookmark: pgfId-838637]The percentage of system resources that can be used before IKE starts rejecting new SA requests. The default is 75 percent.

  
        

 
         
         		[bookmark: pgfId-838643]Enable Aggressive Mode

 [bookmark: pgfId-838645](Site to site VPNs only.)

  
         		[bookmark: pgfId-838647]Supported on ASA devices and PIX 7.0+ devices.

 [bookmark: pgfId-838649]When selected, enables you to use aggressive mode in ISAKMP negotiations. Aggressive mode is enabled by default.

  
        

 
         
         		 
           
           [bookmark: pgfId-838655]IPsec Settings
          
  
        

 
         
         		[bookmark: pgfId-838663]Enable Lifetime

  
         		[bookmark: pgfId-838665]Select to enable you to configure the global lifetime settings for the crypto IPsec security associations (SAs) on the devices in your site-to-site or remote access VPN. Configure the following:

 
           
           		 [bookmark: pgfId-838667]Lifetime (secs)—The number of seconds a security association will exist before expiring. The default is 3,600 seconds (1 hour).

 
           		 [bookmark: pgfId-838669]Lifetime (kbytes)—The volume of traffic (in kilobytes) that can pass between IPsec peers using a given security association before it expires. The default is 4,608,000 kilobytes.

 
          

  
        

 
         
         		[bookmark: pgfId-838675]Xauth Timeout

  
         		[bookmark: pgfId-838677]Supported on Cisco IOS routers and Catalyst 6500/7600 devices in remote access VPN and Easy VPN topologies only.

 [bookmark: pgfId-838679]The number of seconds the device will wait for a system response to the Xauth challenge.

 [bookmark: pgfId-838681]When negotiating tunnel parameters for establishing IPsec tunnels in a remote access or Easy VPN configuration, Xauth adds another level of authentication that identifies the user who requests the IPsec connection. Using the Xauth feature, the client waits for a username/password (Xauth) challenge after the IKE SA has been established. When the end user responds to the challenge, the response is forwarded to the IPsec peers for an additional level of authentication.

  
        

 
         
         		[bookmark: pgfId-838687]Max Sessions

  
         		[bookmark: pgfId-838689]Supported on ASA devices and PIX 7.0+ devices.

 [bookmark: pgfId-838691]The maximum number of security associations (SAs) that can be enabled simultaneously on the device. The maximum number differs based on device model. For ASA devices, the limits are:

 
           
           		 [bookmark: pgfId-838693]5505—10 sessions.

 
           		 [bookmark: pgfId-838695]5510—250 sessions.

 
           		 [bookmark: pgfId-838697]5520—750 sessions.

 
           		 [bookmark: pgfId-838699]5540, 5550, 5585-X with SSP-10—5000 sessions.

 
           		 [bookmark: pgfId-838701]5580, 5585-X (other models)—10000 sessions.

 
          

  
        

 
         
         		[bookmark: pgfId-838707]Enable IPsec via Sysopt

  
         		[bookmark: pgfId-838709]Supported on ASA devices, and PIX Firewalls versions 6.3 or 7.0+.

 [bookmark: pgfId-838711]Whether to bypass the access rules defined on the VPN interface for VPN traffic.

 [bookmark: pgfId-838713]By default, the device allows VPN traffic to terminate on an interface; you do not need to allow IKE or ESP (or other types of VPN packets) in an interface access list. By default, you also do not need an interface access list for local IP addresses of decrypted VPN packets. Because the VPN tunnel was terminated successfully using VPN security mechanisms, this feature simplifies configuration and maximizes the device performance without any security risks. (Group policy and per-user authorization access lists still apply to the traffic.)

 [bookmark: pgfId-838715]If you deselect this option, the interface access rules are also applied to VPN traffic. The access list applies to the local IP address and not to the original client IP address used before the VPN packet was decrypted. The command applied is no sysopt connection permit-vpn.

  
        

 
         
         		[bookmark: pgfId-838721]Enable SPI Recovery

 [bookmark: pgfId-838723](Site-to-site VPNs only.)

  
         		[bookmark: pgfId-838725]Supported on routers running IOS version 12.3(2)T and later, in addition to Catalyst 6500/7600 devices running version 12.2(18)SXE and later.

 [bookmark: pgfId-838727]When selected, enables the SPI recovery feature to configure your device so that if an invalid SPI (Security Parameter Index) occurs, an IKE SA will be initiated.

 [bookmark: pgfId-838729]SPI is a number which, together with a destination IP address and security protocol, uniquely identifies a particular security association. When using IKE to establish security associations, the SPI for each security association is a pseudo-randomly derived number. Without IKE, the SPI is manually specified for each security association. When an invalid SPI occurs during IPsec packet processing, the SPI recovery feature enables an IKE SA to be established.

  
        

 
         
         		 
           
           [bookmark: pgfId-838735]ESPv3 Settings
          
  
        

 
         
         		[bookmark: pgfId-838743]Enable PMTU (Path Maximum Transmission Unit) Aging

  
         		[bookmark: pgfId-838745]Supported for IKEv2 on ASA devices versions 9.0.1+.

 [bookmark: pgfId-838747]Whether to enable Path Maximum Transmission Unit aging.

 [bookmark: pgfId-838749]If you select this option, configure the interval, in minutes, at which the PMTU value is reset to its original value. The value can be from 10 to 30 minutes. The default is 10 minutes.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-842168][bookmark: 70065][bookmark: vpnpage_cncpt_IKEv2SettingsTab]Configuring VPN Global IKEv2 Settings[bookmark: marker-842148][bookmark: marker-842150][bookmark: marker-842152][bookmark: marker-842154][bookmark: marker-842156][bookmark: marker-842158][bookmark: marker-842160][bookmark: marker-842162][bookmark: marker-842164][bookmark: marker-842166]

 
     [bookmark: pgfId-842170]Use the IKEv2 Settings tab of the VPN Global Settings page to specify global settings for Internet Key Exchange (IKE) version 2. These settings apply to ASA 8.4(x) devices only.

 
     [bookmark: pgfId-842172]Internet Key Exchange (IKE), also called Internet Security Association and Key Management Protocol (ISAKMP), is the negotiation protocol that lets two hosts agree on how to build an IPsec security association (SA).

 
     [bookmark: pgfId-842180]Preventing DoS Attacks by Limiting IKEv2 Open SAs[bookmark: marker-842174][bookmark: marker-842176][bookmark: marker-842178]

 
     [bookmark: pgfId-842182]You can prevent denial-of-service (DoS) attacks for IPsec IKEv2 connections by always cookie challenging incoming security associations (SAs) or by limiting the number of open SAs and cookie challenging any additional connections. By default, the ASA does not limit the number of open SAs and never cookie challenges SAs.

 
     [bookmark: pgfId-842184]You can also limit the number of SAs allowed, which stops further connections from negotiating to protect against memory or CPU attacks that the cookie-challenge feature may be unable to thwart. Limiting the maximum number of SAs can protect the current connections.

 
     [bookmark: pgfId-842186]With a DoS attack, an attacker initiates the attack when the peer device sends an SA initiate packet and the ASA sends its response, but the peer device does not respond further. If the peer device does this continually, all the allowed SA requests on the ASA can be used up until it stops responding.

 
     [bookmark: pgfId-842188]Enabling a threshold percentage for cookie challenges limits the number of open SA negotiations. For example, with the default setting of 50%, when 50% of the allowed SAs are in-negotiation (open), the ASA cookie challenges any additional SA initiate packets that arrive. For the Cisco ASA 5580 with 10,000 allowed IKEv2 SAs, after 5000 SAs become open, any more incoming SAs are cookie-challenged.

 
     [bookmark: pgfId-842190]If used in conjunction with the Maximum SAs in Negotiation option, configure a lower cookie-challenge threshold.

 
     [bookmark: pgfId-842192]Navigation Path

 
      
      		 [bookmark: pgfId-842194]For remote access VPNs, do one of the following:

 
     

 
     [bookmark: pgfId-842196] – (Device View) Select Remote Access VPN > Global Settings from the Policy selector. Click the IKEv2 Settings tab.

 
     [bookmark: pgfId-842198] – (Policy View) Select Remote Access VPN > Global Settings from the Policy Type selector. Select an existing policy or create a new one, then click the IKEv2 Settings tab.

 
      
      		 [bookmark: pgfId-842200]For site-to-site VPNs, do one of the following:

 
     

 
     [bookmark: pgfId-842205] – Open the Site-to-Site VPN Manager Window, select a topology in the VPNs selector, then select VPN Global Settings in the Policies selector. Click the IKEv2 Settings tab.

 
     [bookmark: pgfId-842207] – (Policy view) Select Site-to-Site VPN > VPN Global Settings from the Policy Types selector. Select an existing shared policy or create a new one, then click the IKEv2 Settings tab.

 
     [bookmark: pgfId-842209]Related Topics

 
      
      		 [bookmark: pgfId-842214]Configuring VPN Global Settings

 
      		 [bookmark: pgfId-842219]Understanding IKE

 
      		 [bookmark: pgfId-842224]Understanding IPsec Proposals

 
      		 [bookmark: pgfId-842229]Configuring Cluster Load Balance Policies (ASA)

 
     

 
     [bookmark: pgfId-842231]Field Reference

 
     [bookmark: pgfId-842234] 

 
      
       
        
        [bookmark: pgfId-838762]Table 26-7 [bookmark: 70170]VPN Global Settings Page, IKEv2 Settings Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-838768]Element
          
  
         		
           
           [bookmark: pgfId-838770]Description
          
  
        

 
         
         		[bookmark: pgfId-838776]Maximum SAs

  
         		[bookmark: pgfId-838778]The number of allowed IKEv2 connections (security associations) on the device. The default limit is the maximum number of connections specified by the device license, which differs by device model.

 [bookmark: pgfId-838780]Specify a number only if you want to create a limit that is lower than the device license. The range is 1 to 10000.

  
        

 
         
         		[bookmark: pgfId-838786]Maximum SAs in Negotiation

  
         		[bookmark: pgfId-838788]The maximum number of IKEv2 security associations (SAs) that can be in negotiation at any time as a percentage of the maximum allowed SAs. The default is no limit on SAs in negotiation, so it is possible for all available SAs to be in negotiation. The range is 1 to 100%.

 [bookmark: pgfId-838790]If you configure this option and also enable custom cookie challenge, configure the cookie challenge threshold lower than this limit.

  
        

 
         
         		[bookmark: pgfId-838796]Enable Cookie Challenge

  
         		[bookmark: pgfId-838798]Whether to send cookie challenges to peer devices in response to SA initiate packets, which can help thwart denial of service (DoS) attacks. The default is to use cookie challenges when 50% of the available SAs are in negotiation. Select one of these options:

 
           
           		 [bookmark: pgfId-838800] Custom —Cookie challenge when the number of SAs in negotiation exceeds the total number of allowed SAs on the device based on percentage (SAs in negotiation as a percentage of total allowed SAs). In Custom Cookie Challenge, enter the percentage that triggers cookie challenges for any future SA negotiations. The range is 1 to 100%. The default is 50%.

 
           		 [bookmark: pgfId-838802] Never —The device never uses cookie challenge.

 
           		 [bookmark: pgfId-838804] Always —The device always uses cookie challenge, regardless of the percentage of SAs in negotiation.

 
          

  
        

 
         
         		[bookmark: pgfId-838810]Remote Access Authentication

 [bookmark: pgfId-838812]RA Trustpoint

 [bookmark: pgfId-838814](Remote access VPN only.)

  
         		[bookmark: pgfId-838816](Required when supporting IKEv2 negotiations.) The PKI enrollment object that identifies the Certificate Authority (CA) server that the device can use to authenticate itself to the remote user. This authorization is required before the user can select a connection profile and log into the VPN. This CA server is used in remote access IKEv2 IPsec VPNs only. Click Select to select the object or to create a new one.

 [bookmark: pgfId-838818]Tip You must also select this PKI enrollment object in the Remote Access VPN > Public Key Infrastructure policy.  
        

 
         
         		[bookmark: pgfId-838824]Load Balancing Settings

 [bookmark: pgfId-838826]Redirect Connections During

 [bookmark: pgfId-838828](Remote access VPNs only.)

  
         		[bookmark: pgfId-838830]If you configure load balancing, using the ASA Cluster Load Balance policy, you can specify the IKEv2 negotiation phase in which a user can be redirected to another device in the cluster. Select one of these options:

 
           
           		 [bookmark: pgfId-838832] INIT —Redirect at unauthenticated initiation requests (the first IKEv2 message IKE_SA_INIT), before any group or user authentication.

 
          

 [bookmark: pgfId-838834] – Pros—This option allows the master server to do minimal processing and state keeping (using CPU and memory) prior to redirecting the connection.

 [bookmark: pgfId-838836] – Cons—This option is not as secure as AUTH (even though security risks are minimal) because anyone can get a redirected IP address without authenticating at all.

 
           
           		 [bookmark: pgfId-838838] AUTH (the default)—Redirect during authentication (during IKE_AUTH). The device still has not identified or authenticated the user at this point, but it allows the client to authenticate the server to make sure it can trust the redirection that it receives.

 
          

 [bookmark: pgfId-838840] – Pros—This option is more secure as the reply is encrypted in the IKEv2 tunnel and it allows the client side to authenticate the server before retrying with the redirected IP address, providing better DoS protection than the INIT option.

 [bookmark: pgfId-838842] – Cons—This option requires more processing as the IKEv2 tunnel needs to be almost brought up before redirecting, although child SAs and data tunnels do not need to be brought up. The client is not authenticated at all. Note that IKEv1 redirection occurs after group authentication of both sides of the tunnel.

  
        

 
         
         		[bookmark: pgfId-838848]Enable Invalid Selectors Notification

  
         		[bookmark: pgfId-838850]Whether to enable sending an IKE notification to the peer when an inbound packet is received on an SA that does not match the traffic selectors for that SA. This feature is available in Security Manager version 4.9 onwards for ASA devices version 9.4(1) or higher.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-842258][bookmark: 70246][bookmark: vpchap_cncpt_UnderstandingNAT-1]Understanding NAT in VPNs[bookmark: marker-842240][bookmark: marker-842242][bookmark: marker-842244][bookmark: marker-842246][bookmark: marker-842248][bookmark: marker-842250][bookmark: marker-842252][bookmark: marker-842254][bookmark: marker-842256]

 
     [bookmark: pgfId-842260]Network Address Translation (NAT) enables devices that use internal IP addresses to send and receive data through the Internet. It converts private, internal LAN addresses into globally routable IP addresses when they try to access data on the Internet. In this way, NAT enables a small number of public IP addresses to provide global connectivity for a large number of hosts.

 
     [bookmark: pgfId-842262]NAT enhances the stability of your hub-and-spoke VPN tunnels or remote access connections because resources required for VPN connections are not used for other purposes, and the VPN tunnel is kept available for traffic requiring complete security. Sites inside the VPN can use NAT through a split tunnel to exchange non secure traffic with outside devices, and they do not squander VPN bandwidth or overwhelm the hub at the tunnel head-end by directing nonessential traffic through it.

 
     [bookmark: pgfId-842264]Security Manager supports NAT with dynamic IP addressing only, and applies to it an overload feature that permits what is known as port-level NAT or Port Address Translation (PAT). PAT uses port addressing to associate thousands of private NAT addresses with a small group of public IP address. PAT is used if the addressing requirements of your network exceed the available addresses in your dynamic NAT pool.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-842269]Note When you enable PAT on Cisco IOS routers, an additional NAT rule is implicitly created for split-tunneled traffic on deployment. This NAT rule, which denies VPN-tunneled traffic and permits all other traffic (using the external interface as the IP address pool), is not reflected as a router platform policy. You can remove the NAT rule by disabling this feature. For more information, see NAT Page: Dynamic Rules.


     
      

     

     

 
     [bookmark: pgfId-842277]You can configure traffic to bypass NAT configuration on site-to-site VPN traffic. To bypass NAT configuration on Cisco IOS routers, make sure the Do Not Translate VPN Traffic option is selected in the NAT Dynamic Rule platform policy (see NAT Dynamic Rule Dialog Box). To exclude NAT on PIX Firewalls or ASA devices, make sure this option is selected in the NAT Translation Options platform policy (see Translation Options Page).

 
     [bookmark: pgfId-842281]About NAT Traversal[bookmark: marker-842279]

 
     [bookmark: pgfId-842283]NAT traversal is used for the transmission of keepalive messages when there is a device (middle device) located between a VPN-connected hub and spoke, and that device performs NAT on the IPsec flow.

 
     [bookmark: pgfId-842285]If the IP address of the VPN interface on the spoke is not globally routable, the NAT on the middle device replaces it with a new globally routable IP address. This change is made in the IPsec header, and violates the checksum of the spoke causing a mismatch with the hub’s checksum calculation. This results in loss of connectivity between the hub and the spoke.

 
     [bookmark: pgfId-842287]With NAT traversal, the spoke adds a UDP header to the payload. The NAT on the middle device changes the IP address in the UDP header, leaving the IPsec header and checksum intact. On a middle device that uses static NAT, you must provide the static NAT IP address (globally routable) on the inside interface. The static NAT IP address is provided for all traffic through that interface that requires NAT. However, if the middle device uses dynamic NAT where the NAT IP address is unknown, you must define dynamic crypto on the hub to serve any connection request from the spoke. Security Manager generates the required tunnel configuration for the spoke.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-842292]Note NAT traversal is enabled by default on routers running IOS version 12.3T and later. If you want to disable the NAT traversal feature, you must do this manually on the device or using a FlexConfig (see Chapter 7, “Managing FlexConfigs”).


     
      

     

     

 
     [bookmark: pgfId-842297]You can define global NAT settings on the NAT Settings tab of the Global VPN Settings page as described in Configuring VPN Global NAT Settings.

 
    
 
     
      [bookmark: pgfId-842327][bookmark: 70305][bookmark: vpnpage_cncpt_NATSettingsTab-1]Configuring VPN Global NAT Settings[bookmark: marker-842307][bookmark: marker-842309][bookmark: marker-842311][bookmark: marker-842313][bookmark: marker-842315][bookmark: marker-842317][bookmark: marker-842319][bookmark: marker-842321][bookmark: marker-842323][bookmark: marker-842325]

 
     [bookmark: pgfId-842329]Use the NAT Settings tab of the Global Settings page to define global Network Address Translation (NAT) settings that enable devices that use internal IP addresses to send and receive data through the Internet.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-842337]Note For site-to-site VPNs, if you want to bypass NAT configuration on IOS routers, make sure that the Do Not Translate VPN Traffic option is selected in the NAT Dynamic Rule platform policy (see NAT Dynamic Rule Dialog Box). To exclude NAT on PIX Firewalls or ASA devices, make sure this option is selected in the NAT Translation Options platform policy (see Translation Options Page).


     
      

     

     

 
     [bookmark: pgfId-842339]Navigation Path

 
      
      		 [bookmark: pgfId-842341]For remote access VPNs, do one of the following:

 
     

 
     [bookmark: pgfId-842343] – (Device View) Select Remote Access VPN > Global Settings from the Policy selector. Click the NAT Settings tab.

 
     [bookmark: pgfId-842345] – (Policy View) Select Remote Access VPN > Global Settings from the Policy Type selector. Select an existing policy or create a new one, then click the NAT Settings tab.

 
      
      		 [bookmark: pgfId-842347]For site-to-site VPNs, do one of the following:

 
     

 
     [bookmark: pgfId-842352] – Open the Site-to-Site VPN Manager Window, select a topology in the VPNs selector, then select VPN Global Settings in the Policies selector. Click the NAT Settings tab.

 
     [bookmark: pgfId-842354] – (Policy view) Select Site-to-Site VPN > VPN Global Settings from the Policy Types selector. Select an existing shared policy or create a new one, then click the NAT Settings tab.

 
     [bookmark: pgfId-842356]Related Topics

 
      
      		 [bookmark: pgfId-842361]Understanding NAT in VPNs

 
      		 [bookmark: pgfId-842366]Configuring VPN Global Settings

 
     

 
     [bookmark: pgfId-842368]Field Reference

 
     [bookmark: pgfId-842371] 

 
      
       
        
        [bookmark: pgfId-838863]Table 26-8 [bookmark: 70391]VPN Global Settings Page, NAT Settings Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-838869]Element
          
  
         		
           
           [bookmark: pgfId-838871]Description
          
  
        

 
         
         		[bookmark: pgfId-838877]Enable Traversal Keepalive

 [bookmark: pgfId-838879]Interval

  
         		[bookmark: pgfId-838881]Whether to enable NAT traversal keepalive. NAT traversal keepalive is used for the transmission of keepalive messages when there is a device (middle device) located between a VPN-connected hub and spoke, and that device performs NAT on the IPsec flow.

 [bookmark: pgfId-838883]If you select this option, configure the interval, in seconds, between the keepalive signals sent between the spoke and the middle device to indicate that the session is active. The value can be from 5 to 3600 seconds. The default is 10 seconds.

 [bookmark: pgfId-838888]Note On Cisco IOS routers, NAT traversal is enabled by default. If you want to disable the NAT traversal feature, you must do this manually on the device or by using a FlexConfig (see Chapter 7, “Managing FlexConfigs”).

  
        

 
         
         		[bookmark: pgfId-838894]Enable Traversal over TCP

 [bookmark: pgfId-838896]TCP Ports

 [bookmark: pgfId-838898](Remote access VPNs only.)

  
         		[bookmark: pgfId-838900]Supported on ASA and PIX 7.0+ devices.

 [bookmark: pgfId-838902]When selected, encapsulates both the IKE and IPsec protocols within a TCP packet and enables secure tunneling through both NAT and PAT devices and firewalls.

 [bookmark: pgfId-838904]If you select this option, specify the TCP ports for which you want to enable NAT traversal (NAT-T). You must configure TCP ports on the remote clients and on the VPN device. The client configuration must include at least one of the ports you set for the security appliance. You can enter up to 10 ports.

 [bookmark: pgfId-838906]Tip These ports are used for IKEv1 connections only. IKEv2 uses ports 500 and 4500 for NAT-T. Ensure that any ports that you specify are opened in the access rules for the applicable interface.  
        

 
         
         		[bookmark: pgfId-838912]Enable PAT (Port Address Translation) on Split Tunneling for Spokes

 [bookmark: pgfId-838914](Site-to-site VPNs only.)

  
         		[bookmark: pgfId-838916]Supported on Cisco IOS routers and Catalyst 6500/7600 devices.

 [bookmark: pgfId-838918]When selected, enables Port Address Translation (PAT) to be used for split-tunneled traffic on spokes in your VPN topology.

 [bookmark: pgfId-838920]PAT can associate thousands of private NAT addresses with a small group of public IP address through the use of port addressing. PAT is used if the addressing requirements of your network exceed the available addresses in your dynamic NAT pool.

 [bookmark: pgfId-838922]Note When you select this option, Security Manager implicitly creates an additional NAT rule for split-tunneled traffic on deployment. This NAT rule, which denies VPN-tunneled traffic and permits all other traffic (using the external interface as the IP address pool), is not reflected as a router platform policy.

 [bookmark: pgfId-838927]For information on creating or editing a dynamic NAT rule as a router platform policy, see NAT Page: Dynamic Rules.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-842401][bookmark: 70432][bookmark: vpnpage_cncpt_GeneralSettingsTab-1]Configuring VPN Global General Settings[bookmark: marker-842381][bookmark: marker-842383][bookmark: marker-842385][bookmark: marker-842387][bookmark: marker-842389][bookmark: marker-842391][bookmark: marker-842393][bookmark: marker-842395][bookmark: marker-842397][bookmark: marker-842399]

 
     [bookmark: pgfId-842403]Use the General Settings tab of the VPN Global Settings page to define fragmentation settings including maximum transmission unit (MTU) handling parameters for site-to-site and remote access VPNs.

 
     [bookmark: pgfId-842405]Fragmentation breaks a packet into smaller units when it is transmitted over a physical interface that cannot support the original size of the packet. Fragmentation minimizes packet loss in a VPN tunnel, because it enables transmission of secured packets that might otherwise be too large to transmit. This is particularly relevant when using GRE, because any packet of more than 1420 bytes will not have enough room in its header for the additional 80 bytes that the combined use of IPsec and GRE adds to the packet payload.

 
     [bookmark: pgfId-842407]The maximum transmission unit (MTU) specifies the maximum packet size, in bytes, that an interface can handle. If a packet exceeds the MTU, it is fragmented, typically after encryption. If the DF (Do Not Fragment) bit is set, the packet is dropped. A DF bit is a bit within the IP header that indicates if a device can fragment a packet. You must specify whether the device can clear, set, or copy the DF bit from the encapsulated header.

 
     [bookmark: pgfId-842409]Because reassembly of an encrypted packet is difficult, fragmentation can degrade network performance. To prevent network performance problems, you can select Enable Fragmentation Before Encryption so that fragmentation occurs before encryption.

 
     [bookmark: pgfId-842411]Navigation Path

 
      
      		 [bookmark: pgfId-842413]For remote access VPNs, do one of the following:

 
     

 
     [bookmark: pgfId-842415] – (Device View) Select Remote Access VPN > Global Settings from the Policy selector. Click the General Settings tab.

 
     [bookmark: pgfId-842417] – (Policy View) Select Remote Access VPN > Global Settings from the Policy Type selector. Select an existing policy or create a new one, then click the General Settings tab.

 
      
      		 [bookmark: pgfId-842419]For site-to-site VPNs, do one of the following:

 
     

 
     [bookmark: pgfId-842424] – Open the Site-to-Site VPN Manager Window, select a topology in the VPNs selector, then select VPN Global Settings in the Policies selector. Click the General Settings tab.

 
     [bookmark: pgfId-842426] – (Policy view) Select Site-to-Site VPN > VPN Global Settings from the Policy Types selector. Select an existing shared policy or create a new one, then click the General Settings tab.

 
     [bookmark: pgfId-842428]Related Topics

 
      
      		 [bookmark: pgfId-842433]Configuring VPN Global Settings

 
     

 
     [bookmark: pgfId-842435]Field Reference

 
     [bookmark: pgfId-842438] 

 
      
       
        
        [bookmark: pgfId-838940]Table 26-9 [bookmark: 70516]VPN Global Settings Page, General Settings Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-838946]Element
          
  
         		
           
           [bookmark: pgfId-838948]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-838954]Fragmentation Settings
          
  
        

 
         
         		[bookmark: pgfId-838962]Fragmentation Mode

 [bookmark: pgfId-838964]Local MTU Size

  
         		[bookmark: pgfId-838966]Supported on Cisco IOS routers and Catalyst 6500/7600 devices.

 [bookmark: pgfId-838968]Fragmentation minimizes packet loss in a VPN tunnel when packets are transmitted over a physical interface that cannot support the original size of the packet. Select the fragmentation mode:

 
           
           		 [bookmark: pgfId-838970] No Fragmentation —Do not fragment before IPsec encapsulation. After encapsulation, the device fragments packets that exceed the MTU setting before transmitting them through the public interface.

 
           		 [bookmark: pgfId-838972] End to End MTU Discovery —Use ICMP messages to determine the maximum MTU. Use this option with IPsec VPNs.

 
          

 [bookmark: pgfId-838974]End-to-end MTU discovery uses Internet Control Message Protocol (ICMP) messages to determine the maximum MTU that a host can use to send a packet through the VPN tunnel without causing fragmentation. The MTU setting for each link in a transmission path is checked to ensure that no transmitted packet exceeds the smallest MTU in that path. The discovered MTU is used to decide whether fragmentation is necessary. If ICMP is blocked, MTU discovery fails and packets are either lost (if the DF bit is set) or fragmented after encryption (if the DF bit is not set).

 [bookmark: pgfId-838976]Note (Site-to-site VPNs) For Catalyst 6500/7600 devices, end-to-end path MTU discovery is supported only on images 12.2(33)SRA, 12.2(33)SRB, 12.2(33)SXH, 12.2(33)SXI or above.

 
           
           		 [bookmark: pgfId-838978] Local MTU Handling —Set the MTU locally on the devices. This option is typically used when ICMP is blocked or in site-to-site IPsec/GRE VPNs. If you select this option, specify the local MTU size, which can be between 68 and 65535 bytes depending on the VPN interface.

 
          

  
        

 
         
         		[bookmark: pgfId-838984]DF Bit

  
         		[bookmark: pgfId-838986]Supported on Cisco IOS routers, Catalyst 6500/7600 devices, PIX 7.0+ and ASA devices.

 [bookmark: pgfId-838988]A Do Not Fragment (DF) bit within an IP header determines whether a device is allowed to fragment a packet. Select how to handle the DF bit:

 
           
           		 [bookmark: pgfId-838990] Copy —Copy the DF bit from the encapsulated header in the current packet to all the device’s packets. If the packet’s DF bit is set to fragment, all future packets are fragmented. This is the default option.

 
           		 [bookmark: pgfId-838992] Set —Set the DF bit in the packet you are sending. A large packet that exceeds the MTU is dropped and an ICMP message is sent to the packet’s initiator.

 
           		 [bookmark: pgfId-838994] Clear —Fragment packets regardless of the original DF bit setting. If ICMP is blocked, MTU discovery fails and packets are fragmented only after encryption.

 
          

  
        

 
         
         		[bookmark: pgfId-839000]Enable Fragmentation Before Encryption

  
         		[bookmark: pgfId-839002]Supported on Cisco IOS routers, Catalyst 6500/7600 devices, PIX 7.0+ and ASA devices.

 [bookmark: pgfId-839004]When selected, enables fragmentation to occur before encryption if the expected packet size exceeds the MTU.

 [bookmark: pgfId-839006]Look ahead Fragmentation (LAF) is used before encryption takes place to calculate the packet size that would result after encryption, depending on the transform sets configured on the IPsec SA. If the packet size exceeds the specified MTU, the packet will be fragmented before encryption.

  
        

 
         
         		[bookmark: pgfId-839012]Enable Notification on Disconnection

  
         		[bookmark: pgfId-839014]Supported on ASA and PIX 7.0+ devices.

 [bookmark: pgfId-839016]When selected, enables the device to notify qualified peers of sessions that are about to be disconnected. The peer receiving the alert decodes the reason and displays it in the event log or in a pop-up window. This feature is disabled by default.

 [bookmark: pgfId-839018]IPsec sessions might be dropped for several reasons, such as a security appliance shutdown or reboot, session idle timeout, maximum connection time exceeded, or administrator cut-off.

  
        

 
         
         		[bookmark: pgfId-839024]Enable Split Tunneling

 [bookmark: pgfId-839026](Site-to-site VPN only.)

  
         		[bookmark: pgfId-839028]When selected (the default), enables you to configure split tunneling in your site-to-site VPN topology.

 [bookmark: pgfId-839030]Split tunneling allows you to transmit both secured and unsecured traffic on the same interface. Split tunneling requires that you specify exactly which traffic will be secured and what the destination of that traffic is, so that only the specified traffic enters the IPsec tunnel, while the rest is transmitted unencrypted across the public network.

  
        

 
         
         		[bookmark: pgfId-839036]Enable Spoke-to-Spoke Connectivity through the Hub

  
         		[bookmark: pgfId-839038]Supported on ASA and PIX 7.0+ devices.

 [bookmark: pgfId-839040]When selected, enables direct communication between spokes in a hub-and-spoke VPN topology in which the hub is an ASA or PIX 7.0+ device.

  
        

 
         
         		[bookmark: pgfId-839046]Enable Default Route

  
         		[bookmark: pgfId-839048]Supported on Cisco IOS routers and Catalyst 6500/7600 devices.

 [bookmark: pgfId-839050]When selected, the device uses the configured external interface as the default outbound route for all incoming traffic.

  
        

 
         
         		[bookmark: pgfId-839056]Do not reboot until all the sessions are terminated (ASA)

  
         		[bookmark: pgfId-839058]Select this option if you want the ASA to postpone a scheduled reboot until all active sessions terminate. This feature is disabled by default.

 command to work on devices that are on multiple context mode. FlexConfig policies allow you to configure device commands that are not otherwise supported by Security Manager. For more information, see Chapter 7, “Managing FlexConfigs”.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-842448][bookmark: 70610][bookmark: vpchap_cncpt_UnderstandingPresharedKeyPolicies]Understanding IKEv1 Preshared Key Policies in Site-to-Site VPNs[bookmark: marker-842444][bookmark: marker-842446]

 
    [bookmark: pgfId-842450]If you want to use preshared key as your authentication method for IKEv1 negotiations, you must define a shared key for each tunnel between two peers that will be their shared secret for authenticating the connection. The key will be configured on each peer. If the key is not the same on both peers of the tunnel, the connection cannot be established. The peer addresses that are required for configuring the preshared key are deduced from the VPN topology.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-842455]Tip You can also use preshared keys for IKEv2 negotiations, but the configuration is different from the one used for IKEv1, as are the rules and requirements. For information on configuring preshared keys for IKEv2 negotiations, see Configuring IKEv2 Authentication in Site-to-Site VPNs.


    
     

    

    

 
    [bookmark: pgfId-842457]Preshared keys are configured on spokes. In a hub-and-spoke VPN topology, Security Manager mirrors the spoke’s preshared key and configures it on its assigned hub, so that the key on the spoke and hub are the same. In a point-to-point VPN topology, you must configure the same preshared key on both peers. In a full mesh VPN topology, any two devices that are connected must have the same preshared key.

 
    [bookmark: pgfId-842459]In a preshared key policy, you can use a specific key, or you can use automatically generated keys for peers participating in each communication session. Using automatically generated keys (the default method) is preferred, because security can be compromised if all connections in a VPN use the same preshared key.

 
    [bookmark: pgfId-842461]There are three methods for negotiating key information and setting up IKE security associations (SAs):

 
     
     		 [bookmark: pgfId-842465]Main mode address—Negotiation is based on IP address. Main mode provides the highest security because it has three two-way exchanges between the initiator and receiver. This is the default negotiation method.[bookmark: marker-842463]

 
    

 
    [bookmark: pgfId-842467]This method has three options for creating keys:

 
    [bookmark: pgfId-842469] – You can create a key for each peer, based on the unique IP address of each peer, providing high security.

 
    [bookmark: pgfId-842471] – You can create a group preshared key on a hub in a hub-and-spoke VPN topology, to be used for communication with any device in a specified subnet. Each peer is identified by its subnet, even if the IP address of the device is unknown. In a point-to-point or full mesh VPN topology, a group preshared key is created on the peers.

 
    [bookmark: pgfId-842473] – You can create a wildcard key on a hub in a hub-and-spoke VPN topology, or on a group containing hubs, to be used for dynamic crypto where a spoke does not have a fixed IP address or belong to a specific subnet. All spokes connecting to the hub have the same preshared key, which could compromise security. In a point-to-point or full mesh VPN topology, a wildcard key is created on the peers.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-842475]Note If you are configuring DMVPN with direct spoke-to-spoke connectivity, you create a wildcard key on the spokes.


    
     

    

    

 
     
     		 [bookmark: pgfId-842479]Main mode fully qualified domain name (FQDN)—Negotiation is based on DNS resolution, with no reliance on IP address. This option can only be used if the DNS resolution service is available for the host. It is useful when managing devices with dynamic IP addresses that have DNS resolution capabilities.[bookmark: marker-842477]

 
     		 [bookmark: pgfId-842483]Aggressive mode—Negotiation is based on hostname (without DNS resolution) and domain name. Aggressive mode is less secure than main mode. However, it provides more security than using group preshared keys if the IP address of the VPN interface on the host is unknown, and the FQDN of the dynamic IP peer is not DNS resolvable. This negotiation method is recommended for use with a GRE Dynamic IP or DMVPN failover and routing policy.[bookmark: marker-842481]

 
    

 
    [bookmark: pgfId-842485]Related Topics

 
     
     		 [bookmark: pgfId-842490]Deciding Which Authentication Method to Use

 
     		 [bookmark: pgfId-842495]Configuring IKEv1 Preshared Key Policies

 
    

 
     
      [bookmark: pgfId-842505][bookmark: 70658][bookmark: vpchap_proc_ConfiguringPresharedKeyPolicies]Configuring IKEv1 Preshared Key Policies[bookmark: marker-842503]

 
     [bookmark: pgfId-842510]Use the IKEv1 Preshared Key page to define the preshared key configuration when using IKEv1 in a site-to-site VPN topology. For information on configuring preshared keys when using IKEv2, see Configuring IKEv2 Authentication in Site-to-Site VPNs.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-842512]Note The preshared key policy does not apply to Easy VPN topologies.


     
      

     

     

 
     [bookmark: pgfId-842514]To open the IKEv1 Preshared Key page:

 
      
      		 [bookmark: pgfId-842519](Site-to-Site VPN Manager Window) Select a topology in the VPNs selector, then select  IKEv1 Preshared Key in the Policies selector.

 
      		 [bookmark: pgfId-842521](Policy view) Select  Site-to-Site VPN > IKEv1 Preshared Key from the Policy Types selector. Select an existing shared policy or create a new one.

 
     

 
     [bookmark: pgfId-842523]The following table explains the settings you can configure in this policy.

 
     [bookmark: pgfId-842526] 

 
      
       
        
        [bookmark: pgfId-839076]Table 26-10 [bookmark: 70679]IKEv1 Preshared Key Page 

 
        
       
         
         		
           
           [bookmark: pgfId-839082]Element
          
  
         		
           
           [bookmark: pgfId-839084]Description
          
  
        

 
         
         		 [bookmark: pgfId-839090]Key Specification

 [bookmark: pgfId-839092]Select whether to manually define the key (User Defined) or to have the key automatically generated. There are additional options you can configure when using auto generated keys.

  
        

 
         
         		[bookmark: pgfId-839100]User Defined

  
         		[bookmark: pgfId-839102]When selected, enables you to use a manually defined preshared key.

 [bookmark: pgfId-839104]Enter the required preshared key in the Key field, then enter it again in the Confirm field.

  
        

 
         
         		[bookmark: pgfId-839110]Auto Generated

  
         		[bookmark: pgfId-839112]When selected, allocates a random key to the participating peers. This ensures security because a different key is generated for every hub-spoke connection. Auto Generated is the default selection.

 [bookmark: pgfId-839114]Auto generated is not a useful option when you do not manage all nodes in the VPN, for example, in the case of an Extranet VPN.

 [bookmark: pgfId-839116]Note The key is allocated during the first deployment to the devices and is used in all subsequent deployments to the same devices, until you select the Regenerate Key (Only in Next Deployment) check box.

  
        

 
         
         		[bookmark: pgfId-839122]Key Length

  
         		[bookmark: pgfId-839124]The required length of the preshared key to be automatically generated, from 1 to 127. The default is 24.

  
        

 
         
         		[bookmark: pgfId-839130]Same Key for All Tunnels

  
         		[bookmark: pgfId-839132]Unavailable in a point-to-point VPN topology.

 [bookmark: pgfId-839134]When selected, enables you to use the same auto-generated key for all tunnels.

 [bookmark: pgfId-839136]Note If you do not select this option, different keys are used for the tunnels, except in cases, such as DMVPN configuration, when different multipoint GRE interfaces in the same network must use the same preshared key.

  
        

 
         
         		[bookmark: pgfId-839142]Regenerate Key (Only in Next Deployment)

  
         		[bookmark: pgfId-839144]When selected, enables Security Manager to generate a new key for the next deployment to the devices. This is useful if it is possible that the secrecy of the keys might be compromised.

 [bookmark: pgfId-839146]When you submit the job for deployment, this check box is cleared. It does not remain selected because the new key will only be generated for the upcoming deployment, and not for subsequent deployments (unless you select it again).

  
        

 
         
         		 [bookmark: pgfId-839152]Negotiation Method

 [bookmark: pgfId-839157]Select the type of negotiation method. The methods are explained in more detail in Understanding IKEv1 Preshared Key Policies in Site-to-Site VPNs.

  
        

 
         
         		[bookmark: pgfId-839165]Main Mode Address

  
         		[bookmark: pgfId-839167]Use this negotiation method for exchanging key information if the IP address of the devices is known. Negotiation is based on IP address. Main mode provides the highest security because it has three two-way exchanges between the initiator and receiver. Main mode address is the default negotiation method.

 [bookmark: pgfId-839169]Select one of the following options to define the negotiation address type:

 
           
           		 [bookmark: pgfId-839171] Peer Address —Negotiation is based on the unique IP address of each peer. A key is created for each peer, providing high security. This is the default.

 
           		 [bookmark: pgfId-839173] Subnet —Creates a group preshared key on a hub in a hub-and-spoke topology to use for communication with any device in a specified subnet, even if the IP address of the device is unknown. Each peer is identified by its subnet. In a point-to-point or full mesh VPN topology, a group preshared key is created on the peers. Enter the subnet in the field provided, for example, 10.10.10.0/24.

 
           		 [bookmark: pgfId-839175] Wildcard —Creates a wildcard key on a hub or on a group of hubs in a hub-and-spoke topology to use when a spoke does not have a fixed IP address or belong to a specific subnet. In this case, all spokes connecting to the hub have the same preshared key, which could compromise security. Use this option if a spoke in your hub-and-spoke VPN topology has a dynamic IP address. In a point-to-point or full mesh VPN topology, a wildcard key is created on the peers.

 
          

 [bookmark: pgfId-839177]Note When configuring DMVPN with direct spoke-to-spoke connectivity, you create a wildcard key on the spokes.

  
        

 
         
         		[bookmark: pgfId-839183]Main Mode FQDN

  
         		[bookmark: pgfId-839185]Select this negotiation method for exchanging key information if the IP address is not known and DNS resolution is available for the devices. Negotiation is based on DNS resolution, with no reliance on IP address.

  
        

 
         
         		[bookmark: pgfId-839191]Aggressive Mode

  
         		[bookmark: pgfId-839193]Available only in a hub-and-spoke VPN topology.

 [bookmark: pgfId-839195]Select this negotiation method for exchanging key information if the IP address is not known and DNS resolution might not be available on the devices. Negotiation is based on hostname and domain name.

 [bookmark: pgfId-839197]Note If direct spoke to spoke tunneling is enabled, you cannot use aggressive mode.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-842528]Related Topics

 
      
      		 [bookmark: pgfId-842533]Understanding IKEv1 Preshared Key Policies in Site-to-Site VPNs

 
     

 
    
 
   
 
    
     [bookmark: pgfId-842543][bookmark: 70772][bookmark: vpchap_cncpt_UnderstandingPublicKeyInfrastructurePolicies]Understanding Public Key Infrastructure Policies[bookmark: marker-842539][bookmark: marker-842541]

 
    [bookmark: pgfId-842545]Security Manager supports IPsec configuration with Certification Authority (CA) servers that manage certificate requests and issue certificates to devices in your VPN topology. You can create a Public Key Infrastructure (PKI) policy to generate enrollment requests for CA certificates and RSA keys, and manage keys and certificates, providing centralized key management for the participating devices.

 
    [bookmark: pgfId-842547]CA servers, also known as trustpoints, manage public CA certificate requests and issue certificates to participating IPsec network devices. When you use Certificates as the authentication method for IKE and IPsec proposal policies, peers are configured to obtain digital certificates from a CA server. With a CA server, you do not have to configure keys between all the encrypting devices. Instead, you individually enroll each participating device with the CA server, which is explicitly trusted to validate identities and create a digital certificate for the device. When this has been accomplished, each participating peer can validate the identities of the other participating peers and establish encrypted sessions with the public keys contained in the certificates.

 
    [bookmark: pgfId-842549]CAs can also revoke certificates for peers that no longer participate in an IPsec VPN topology. Revoked certificates are either managed by an Online Certificate Status Protocol (OCSP) server or are listed in a certificate revocation list (CRL) stored on an LDAP server, which each peer can check before accepting a certificate from another peer.

 
    [bookmark: pgfId-842551]PKI enrollment can be set up in a hierarchical framework consisting of multiple CAs. At the top of the hierarchy is a root CA, which holds a self-signed certificate. The trust within the entire hierarchy is derived from the RSA key pair of the root CA. Subordinate CAs within the hierarchy can enroll with either the root CA or with another subordinate CA. Within a hierarchical PKI, all enrolled peers can validate each other’s certificate if the peers share a trusted root CA certificate or a common subordinate CA.

 
    [bookmark: pgfId-842553]Keep the following in mind:

 
     
     		 [bookmark: pgfId-842555]PKI policies can be configured on Cisco IOS routers running version 12.3(7)T and later, PIX Firewalls, and Adaptive Security Appliance (ASA) devices for site-to-site and remote access VPNs.

 
     		 [bookmark: pgfId-842560]In site-to-site VPNs, you use the IKEv1 Public Key Infrastructure policy to identify CA servers for IKEv1 negotiations only. For IKEv2 negotiations, you identify the CA servers in the IKEv2 Authentication policy as described in Configuring IKEv2 Authentication in Site-to-Site VPNs.

 
     		 [bookmark: pgfId-842565]To save the RSA key pairs and the CA certificates between reloads permanently to Flash memory on a PIX Firewall release 6.3, you must configure the  ca save all command. You can do this manually on the device or using a FlexConfig (see Chapter 7, “Managing FlexConfigs”).

 
    

 
    [bookmark: pgfId-842573]CA Server Authentication Methods[bookmark: marker-842567][bookmark: marker-842569][bookmark: marker-842571]

 
    [bookmark: pgfId-842575]You can authenticate the CA server using one of the following methods:

 
     
     		 [bookmark: pgfId-842577]Using the Simple Certificate Enrollment Protocol (SCEP) to retrieve the CA’s certificates from the CA server. Using SCEP, you establish a direct connection between your device and the CA server. Be sure your device is connected to the CA server before beginning the enrollment process. Because this method of retrieving CA certificates for routers is interactive, you can deploy your PKI policy to live devices only, not to files.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-842579]Note When using SCEP, you must enter the fingerprint for the CA server. If the value you enter does not match the fingerprint on the certificate, the certificate is rejected. You can obtain the CA’s fingerprint by contacting the server directly, or by entering the following address in a web browser: http://<URLHostName>/certsrv/mscep/mscep.dll.


    
     

    

    

 
     
     		 [bookmark: pgfId-842581]Manually creating an enrollment request that you can submit to a CA server offline, by copying the CA server’s certificates from another device.

 
    

 
    [bookmark: pgfId-842583]Use this method if your device cannot establish a direct connection to the CA server or if you want to generate an enrollment request and send it to the server at a later time.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-842585]Note This method enables you to deploy the PKI policy either to devices or to files.


    
     

    

    

 
    [bookmark: pgfId-842590]For more information, see PKI Enrollment Dialog Box.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-842595]Note You can also use Cisco Secure Device Provisioning (SDP) to enroll for a certificate for a router. For more information about using SDP for certificate enrollment, see Secure Device Provisioning on Cisco IOS Routers.


    
     

    

    

 
    [bookmark: pgfId-842597]The following topics explain Public Key Infrastructure configuration in more detail:

 
     
     		 [bookmark: pgfId-842602]Requirements for Successful PKI Enrollment

 
     		 [bookmark: pgfId-842607]Configuring IKEv1 Public Key Infrastructure Policies in Site-to-Site VPNs

 
     		 [bookmark: pgfId-842612]Defining Multiple IKEv1 CA Servers for Site-to-Site VPNs

 
     		 [bookmark: pgfId-842617]Configuring Public Key Infrastructure Policies for Remote Access VPNs

 
     		 [bookmark: pgfId-842622]PKI Enrollment Dialog Box

 
    

 
     
      [bookmark: pgfId-842632][bookmark: 70837][bookmark: vpchap_cncpt_PrerequisitesforSuccessfulPKIEnrollment]Requirements for Successful PKI Enrollment[bookmark: marker-842628][bookmark: marker-842630]

 
     [bookmark: pgfId-842634]The following are prerequisites for configuring a PKI policy in your network:

 
      
      		 [bookmark: pgfId-842639]For IKEv1, the IKE proposal must specify Certificate for the IKE authentication method. See Configuring IKEv1 Proposal Policy Objects.

 
      		 [bookmark: pgfId-842641]The domain name must be defined on the devices for PKI enrollment to be successful (unless you specify the CA server nickname).

 
      		 [bookmark: pgfId-842643]To enroll with the CA server directly, you must specify the server’s enrollment URL.

 
      		 [bookmark: pgfId-842645]To enroll with the CA server by means of a TFTP server, you must ensure that the CA certificates file is saved to the TFTP server. After deployment of the PKI policy, you must copy the certificate request from your TFTP server to the CA server.

 
      		 [bookmark: pgfId-842647]You may specify an RSA public key to use in the enrollment request. If you do not specify an RSA key pair, the Fully Qualified domain Name (FQDN) key will be used.

 
     

 
     [bookmark: pgfId-842649]If using RSA keys, once the certificate has been granted, the public key is included in the certificate so that peers can use it to encrypt data sent to the device. The private key is kept on the device and used to decrypt data sent by peers, and to digitally sign transactions when negotiating with peers. You can use an existing key pair or generate a new one. If you want to generate a new key pair to use in the certificate for router devices, you must also specify the modulus to determine the size of the key.

 
     [bookmark: pgfId-842654]For more information, see PKI Enrollment Dialog Box—Enrollment Parameters Tab.

 
      
      		 [bookmark: pgfId-842656]If you are making a PKI enrollment request on a Cisco Easy VPN IPsec remote access system, you must configure each remote component (spoke) with the name of the user group to which it connects. You specify this information in the Organization Unit (OU) field in the Certificate Subject Name tab of the PKI Enrollment Editor dialog box.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-842658]Note You do not need to configure the name of the user group on the hub (Easy VPN server).


     
      

     

     

 
     [bookmark: pgfId-842663]For more information, see PKI Enrollment Dialog Box—Certificate Subject Name Tab.

 
      
      		 [bookmark: pgfId-842665]To deploy PKI policies to files (not to live devices), the following prerequisites must be met:

 
     

 
     [bookmark: pgfId-842667] – Routers must run Cisco IOS Software 12.3(7)T or later.

 
     [bookmark: pgfId-842669] – CA authentication certificates must be cut and pasted into the Security Manager user interface (so that CA authentication is not interactive and does not require communication with the live device).

 
      
      		 [bookmark: pgfId-842671]If you are deploying to live devices, the PKI server must be online.

 
      		 [bookmark: pgfId-842673]Security Manager supports the Microsoft, Verisign, and Entrust PKIs.

 
      		 [bookmark: pgfId-842678]Security Manager supports Cisco IOS Certificate Servers. The Cisco IOS Certificate Server feature embeds a simple certificate server, with limited CA functionality, into the Cisco IOS software. An IOS Certificate Server can be configured as a FlexConfig policy. For more information, see Chapter 7, “Managing FlexConfigs”.

 
      		 [bookmark: pgfId-842680]To configure PKI with AAA authorization that uses the entire subject name on an IOS router, use the predefined FlexConfig object named IOS_PKI_WITH_AAA.

 
     

 
     [bookmark: pgfId-842686]Prerequisites for PKI Enrollment Using TFTP[bookmark: marker-842682][bookmark: marker-842684]

 
     [bookmark: pgfId-842688]If you do not have constant direct access to the CA server, you can enroll using TFTP if your devices are routers running Cisco IOS Software 12.3(7)T or later.

 
     [bookmark: pgfId-842690]On deployment, Security Manager generates the corresponding CA trustpoint command and authenticate command. The trustpoint command is configured with the enrollment URL tftp://<certserver> <file_specification> entry to retrieve the CA certificate using TFTP. If file_specification is not specified, the FQDN of the router is used.

 
     [bookmark: pgfId-842692]Before using this option, you must make sure that the CA certificates file (.ca) is saved on the TFTP server. To do this, use this procedure:

 
     [bookmark: pgfId-842694] 1. Connect to http://servername/certsrv, where servername is the name of the Windows 2000 web server on which the CA you want to access is located.

 
     [bookmark: pgfId-842696] 2. Select Retrieve the CA certificate or certificate revocation list, then click Next.

 
     [bookmark: pgfId-842698] 3. Select Base64 encoded, then click Download CA certificate.

 
     [bookmark: pgfId-842700] 4. Save the .crt file as a .ca file on the TFTP server using your browser’s Save As function.

 
     [bookmark: pgfId-842702]After deployment, you must transfer the certificate request generated by Security Manager on the TFTP server to the CA, and then transfer the device’s certificates from the CA to the device.

 
     [bookmark: pgfId-842704]Transferring the Certificate Request from the TFTP Server to the CA Server

 
     [bookmark: pgfId-842706]Security Manager creates a PKCS#10 formatted enrollment request (.req) on the TFTP server. You must transfer it to the PKI server using this procedure:

 
     [bookmark: pgfId-842708] 1. Connect to http://servername/certsrv, where servername is the name of the Windows 2000 web server where the CA you want to access is located.

 
     [bookmark: pgfId-842710] 2. Select Request a certificate, then click Next.

 
     [bookmark: pgfId-842712] 3. Select Advanced request, then click Next.

 
     [bookmark: pgfId-842714] 4. Select Submit a certificate request using a base64 encoded PKCS #10 file or a renewal request using a base64 encoded PKCS #7 file, then click Next.

 
     [bookmark: pgfId-842716] 5. Either select browse for a file (and browse to the TFTP server and select the .req file) or open the just received by TFTP .req file with WordPad/Notepad and copy/paste the contents in the first window.

 
     [bookmark: pgfId-842718] 6. Export the .crt file from the CA and put it on the TFTP server.

 
     [bookmark: pgfId-842720] 7. Configure the ‘crypto ca import <label> certificate’ to import the device’s certificates from the tftp server.

 
     [bookmark: pgfId-842722]Related Topics

 
      
      		 [bookmark: pgfId-842727]Configuring IKEv1 Public Key Infrastructure Policies in Site-to-Site VPNs

 
      		 [bookmark: pgfId-842732]Configuring Public Key Infrastructure Policies for Remote Access VPNs

 
      		 [bookmark: pgfId-842737]PKI Enrollment Dialog Box

 
      		 [bookmark: pgfId-842742]Configuring a User Group Policy for Easy VPN

 
     

 
    
 
     
      [bookmark: pgfId-842752][bookmark: 70946][bookmark: vpchap_proc_ConfiguringPublicKeyInfrastructurePolicies]Configuring IKEv1 Public Key Infrastructure Policies in Site-to-Site VPNs[bookmark: marker-842750]

 
     [bookmark: pgfId-842754]You can create a Public Key Infrastructure (PKI) policy to generate enrollment requests for CA certificates and RSA keys, and to manage keys and certificates. Certification Authority (CA) servers are used to manage these certificate requests and issue certificates to the participating devices in your VPN topology.

 
     [bookmark: pgfId-842756]In Security Manager, CA servers are predefined as PKI enrollment objects that you can use in your PKI policies. A PKI enrollment object contains the server information and enrollment parameters that are required for creating enrollment requests for CA certificates.

 
     [bookmark: pgfId-842761]For more information about Public Key Infrastructure policies, see Understanding Public Key Infrastructure Policies.

 
     [bookmark: pgfId-842763]This procedure describes how to specify the CA server that will be used to create an IKEv1 Public Key Infrastructure (PKI) policy in your VPN topology.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-842768]Tip For information on specifying CA servers for use in IKEv2 negotiations, see Configuring IKEv2 Authentication in Site-to-Site VPNs.


     
      

     

     

 
     [bookmark: pgfId-842770]Before You Begin

 
     [bookmark: pgfId-842775]For important information about successfully configuring PKI, see Requirements for Successful PKI Enrollment.

 
     [bookmark: pgfId-842777]Related Topics

 
      
      		 [bookmark: pgfId-842782]Defining Multiple IKEv1 CA Servers for Site-to-Site VPNs

 
      		 [bookmark: pgfId-842787]Deciding Which Authentication Method to Use

 
      		 [bookmark: pgfId-842792]Filtering Items in Selectors

 
     

 
     
 
     [bookmark: pgfId-842794]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-842799](Site-to-Site VPN Manager Window) Select an existing topology and then select  IKEv1 Public Key Infrastructure in the Policies selector.

 
      		 [bookmark: pgfId-842801](Policy view) Select  Site-to-Site VPN > IKEv1 Public Key Infrastructure , and then select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-842803]The Public Key Infrastructure page opens, displaying the currently selected CA server, if any, in the Selected field.

 
     [bookmark: pgfId-842805]Step 2 Select the PKI enrollment policy object that defines the desired CA server in the Available CA Servers list. You can do the following to modify the listed objects:

 
      
      		 [bookmark: pgfId-842810]To add a new PKI enrollment object, click the  Create (+) button. The Add PKI Enrollment dialog box opens. For detailed information about the attributes of a PKI enrollment object, see PKI Enrollment Dialog Box.

 
      		 [bookmark: pgfId-842812]To change the configuration of an existing object, select it and click the  Edit (pencil) button.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-842817]Note If you are making a PKI enrollment request on an Easy VPN topology, you must configure each remote component (spoke) with the name of the user group to which it connects. You specify this information in the Organization Unit (OU) field in the Certificate Subject Name tab of the PKI Enrollment dialog box. You do not need to configure the name of the user group on the hub (Easy VPN server). For more information, see PKI Enrollment Dialog Box—Certificate Subject Name Tab.


     
      

     

     

 
     [bookmark: pgfId-842819]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-842827][bookmark: 71004][bookmark: vpchap_proc_DefiningMultipleCAServersforSitetoSiteVPNs]Defining Multiple IKEv1 CA Servers for Site-to-Site VPNs[bookmark: marker-842825]

 
     [bookmark: pgfId-842829]You can select only one CA server when defining an IKEv1 Public Key Infrastructure (PKI) policy on a site-to-site VPN. This creates a problem when the devices in the VPN enroll with different CA servers when using IKEv1. For example, the spoke devices might enroll with a different CA server than the hub, or the spokes in one part of the VPN might enroll with a different CA server than the spokes in another part of the VPN.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-842834]Tip When using IKEv2, you can configure different CA servers for various devices by creating overrides for the IKEv2 Authentication policy global settings rather than creating device-level overrides for PKI enrollment policy objects. However, you can also use device-level overrides for IKEv2 as described in this topic. For information on configuring CA servers for IKEv2, see Configuring IKEv2 Authentication in Site-to-Site VPNs.


     
      

     

     

 
     [bookmark: pgfId-842836]To define an IKEv1 PKI policy, you select a PKI enrollment object that specifies the CA server to which the devices should enroll. Although by default the policy object refers globally to a single CA server, you can use device-level overrides to have the object refer to a different CA server on selected devices.

 
     [bookmark: pgfId-842838]For example, if PKI enrollment object PKI_1 refers to a CA server named CA_1, you can create a device-level override for selected devices that has PKI_1 refer to a different CA server, for example, CA_2. Theoretically, you can use overrides to define a different CA server for each device in the VPN.

 
     [bookmark: pgfId-842840]This procedure describes the basic steps for creating overrides for PKI enrollment objects.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-842845]Note You can also use device-level overrides when the CA servers are arranged in a PKI hierarchy beneath a common, trusted CA server. To do this, you must ensure that both the global definition of the object and the device-level override specify the trusted CA server in the Trusted CA Hierarchy tab of the PKI Enrollment dialog box. See PKI Enrollment Dialog Box—Trusted CA Hierarchy Tab.


     
      

     

     

 
     [bookmark: pgfId-842847]Related Topics

 
      
      		 [bookmark: pgfId-842852]Understanding Public Key Infrastructure Policies

 
      		 [bookmark: pgfId-842857]Deciding Which Authentication Method to Use

 
     

 
     
 
     [bookmark: pgfId-842859]Step 1 To create the PKI enrollment object, open the PKI Enrollment dialog box. You can access this dialog box in two ways:

 
      
      		 [bookmark: pgfId-842864]From the Public Key Infrastructure policy—Click the  Create (+) button beneath the Selected field. See Configuring IKEv1 Public Key Infrastructure Policies in Site-to-Site VPNs.

 
      		 [bookmark: pgfId-842866]From the Policy Object Manager (select  Manage > Policy Objects )—Select PKI Enrollments from the Object Type selector, then click the  New Object (+) button.

 
     

 
     [bookmark: pgfId-842871]Step 2 Define the global definition of the PKI enrollment object, including the CA server to which the object refers. Be sure to select Allow Value Override per Device. This option makes the object overridable on individual devices. See PKI Enrollment Dialog Box.

 
     [bookmark: pgfId-842873]Base the global definition of the object on the CA server that is used by the most devices in the VPN. Doing this reduces the number of device-level overrides that are required.

 
     [bookmark: pgfId-842875]Step 3 When you finish defining the PKI enrollment object, click OK. As a result:

 
      
      		 [bookmark: pgfId-842877]If you accessed the dialog box through the PKI policy, the new object appears in the Selected field of the policy page.

 
      		 [bookmark: pgfId-842879]If you accessed the dialog box using the Policy Object Manager, the new object appears in the work area of the Policy Object Manager window. A green check mark in the Overridable column indicates that device-level overrides can be created for this object. (The check mark does not indicate whether any overrides actually exist.)

 
     

 
     [bookmark: pgfId-842881]Step 4 Create the device-level overrides for the PKI enrollment object. You can do this in one of two ways:

 
      
      		 [bookmark: pgfId-842883]From Device Properties (with the device selected in Device view, select  Tools > Device Properties )—This option is recommended when you want to create a device-level override for a single device. In the device properties, select  Policy Object Overrides > PKI Enrollments , select the PKI enrollment object that you want to override, then click the  Create Override button. You can then define the content of the override, including the CA server defined by the object.

 
     

 
     [bookmark: pgfId-842888]For more information, see Creating or Editing Object Overrides for a Single Device.

 
      
      		 [bookmark: pgfId-842890]From the Policy Object Manager—This option is recommended when you want to create a device-level override for multiple devices at the same time. Double-click the green check mark in the Overridable column, select the devices to which the override should apply, then define the content of the override, including the CA server defined by the object.

 
     

 
     [bookmark: pgfId-842895]For more information, see Creating or Editing Object Overrides for Multiple Devices At A Time.

 
     [bookmark: pgfId-842897]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-842921][bookmark: 71068][bookmark: ravpnch_proc_ConfiguringaPKIPolicyinaRemoteAccessVPN]Configuring Public Key Infrastructure Policies for Remote Access VPNs[bookmark: marker-842905][bookmark: marker-842907][bookmark: marker-842909][bookmark: marker-842911][bookmark: marker-842913][bookmark: marker-842915][bookmark: marker-842917][bookmark: marker-842919]

 
     [bookmark: pgfId-842923]You can create a Public Key Infrastructure (PKI) policy to generate enrollment requests for CA certificates and RSA keys, and to manage keys and certificates. Certification Authority (CA) servers are used to manage these certificate requests and issue certificates to users who connect to your IPsec or SSL remote access VPN.

 
     [bookmark: pgfId-842925]In Security Manager, CA servers are predefined as PKI enrollment objects that you can use in your PKI policies. A PKI enrollment object contains the server information and enrollment parameters that are required for creating enrollment requests for CA certificates.

 
     [bookmark: pgfId-842930]For more information about Public Key Infrastructure policies, see Understanding Public Key Infrastructure Policies.

 
     [bookmark: pgfId-842932]This procedure describes how to specify the CA servers that will be used to create a Public Key Infrastructure (PKI) policy in your remote access VPN.

 
     [bookmark: pgfId-842934]Before You Begin

 
     [bookmark: pgfId-842936]Keep the following in mind:

 
      
      		 [bookmark: pgfId-842941]For important information about successfully configuring PKI, see Requirements for Successful PKI Enrollment.

 
      		 [bookmark: pgfId-842943]The  IKE Proposal policy for IPsec remote access VPNs should use an IKE Proposal object that requires certificate authorization when configuring IKEv1.

 
      		 [bookmark: pgfId-842945]For remote access VPNs defined on an ASA or PIX 7.x+ device, be aware that the Public Key Infrastructure policy is directly related to the following policies. Any trustpoints defined in these policies must also be selected in the Public Key Infrastructure policy; they are not automatically added to the policy. You might want to first configure these policies to determine which PKI enrollment objects are required in your remote access VPNs.

 
     

 
     [bookmark: pgfId-842947] – Connection Profiles—When you create a IPsec connection profile for which CA trustpoints should be used, you select the PKI enrollment object that identifies the trustpoint on the IPsec tab.

 
     [bookmark: pgfId-842949] – SSL VPN Access—You can configure trustpoints for each interface and also a fallback trustpoint.

 
     [bookmark: pgfId-842951] – Global Settings, IKEv2 Settings tab—For IKEv2 IPsec, you must specify a global trustpoint.

 
     [bookmark: pgfId-842953]Related Topics

 
      
      		 [bookmark: pgfId-842958]Deciding Which Authentication Method to Use

 
      		 [bookmark: pgfId-842963]Filtering Items in Selectors

 
     

 
     
 
     [bookmark: pgfId-842965]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-842967](Device view) Select  Remote Access VPN > Public Key Infrastructure from the Policy selector.

 
      		 [bookmark: pgfId-842969](Policy view) Select  Remote Access VPN > Public Key Infrastructure from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-842971]The Public Key Infrastructure page opens, displaying the currently available and selected CA servers (PKI enrollment objects), if any.

 
     [bookmark: pgfId-842973]Step 2 Select the PKI enrollment policy objects that define the desired CA servers in the Available CA Servers list and click >> to move them to the Selected CA Servers list. You can remove undesired objects by selecting them in the selected list and clicking <<.

 
     [bookmark: pgfId-842981]For ASA and PIX 7.x+ devices, the list of selected PKI enrollment objects must include all objects that are specified in the connection profiles defined for the remote access VPN. For more information on connection profiles, see Configuring Connection Profiles (ASA, PIX 7.0+). Also, any trustpoints configured for IKEv2 on the Global Settings policy must be included; see Configuring VPN Global IKEv2 Settings.

 
     [bookmark: pgfId-842983]You can do the following to modify the listed objects:

 
      
      		 [bookmark: pgfId-842988]To add a new PKI enrollment object, click the  Create (+) button below the list of available servers. The Add PKI Enrollment dialog box opens. For detailed information about the attributes of a PKI enrollment object, see PKI Enrollment Dialog Box.

 
      		 [bookmark: pgfId-842990]To change the configuration of an existing object, select it in either list and click the  Edit (pencil) button.

 
     

 
     [bookmark: pgfId-842992]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-843018][bookmark: 71169][bookmark: pobjpage_cncpt_PKIEnrollmentDialogBox]PKI Enrollment Dialog Box[bookmark: marker-843008][bookmark: marker-843010][bookmark: marker-843012][bookmark: marker-843014][bookmark: marker-843016]

 
     [bookmark: pgfId-843020]Use the PKI Enrollment dialog box to view, create, copy, or edit Public-Key Infrastructure (PKI) enrollment objects. A PKI enrollment object represents an external certification authority (CA) server that responds to certificate requests from devices in the network.

 
     [bookmark: pgfId-843022]You can create PKI enrollment objects to define the properties of a CA server used when devices exchange certificates as part of an IPsec network. When you create a PKI enrollment object, you define a name for the server and the URL for enrollment. You must specify whether the devices you wish to enroll with this server should retrieve the CA server’s own certificate using the Simple Certificate Enrollment Process (SCEP) or use a certificate that you have entered manually into the device configuration. You must also select the method of support used by the CA server for revocation checking.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-843024]Note You do not have to define enrollment parameters in order to create or import a trustpoint in Security Manager.


     
      

     

     

 
     [bookmark: pgfId-843026]In addition, you can optionally define the following:

 
      
      		 [bookmark: pgfId-843028]Whether the CA server is acting as a Registration Authority (RA) server.

 
      		 [bookmark: pgfId-843030]Enrollment parameters, including retry settings and RSA key pair settings.

 
      		 [bookmark: pgfId-843032]Additional attributes to include in the certificate request.

 
      		 [bookmark: pgfId-843034]The list of trusted CA servers located above this server in the PKI hierarchy.

 
     

 
     [bookmark: pgfId-843036]Navigation Path

 
     [bookmark: pgfId-843038]Select Manage > Policy Objects, then select PKI Enrollments from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-843040]Tip You can also open this dialog box from the Public Key Infrastructure policy for remote access or site-to-site VPNs.


     
      

     

     

 
     [bookmark: pgfId-843042]Related Topics

 
      
      		 [bookmark: pgfId-843047]Understanding Public Key Infrastructure Policies

 
      		 [bookmark: pgfId-843052]Requirements for Successful PKI Enrollment

 
      		 [bookmark: pgfId-843057]Configuring IKEv1 Public Key Infrastructure Policies in Site-to-Site VPNs

 
      		 [bookmark: pgfId-843062]Configuring IKEv2 Authentication in Site-to-Site VPNs

 
      		 [bookmark: pgfId-843067]Configuring Public Key Infrastructure Policies for Remote Access VPNs

 
      		 [bookmark: pgfId-843072]Policy Object Manager

 
     

 
     [bookmark: pgfId-843074]Field Reference

 
     [bookmark: pgfId-843077] 

 
      
       
        
        [bookmark: pgfId-839210]Table 26-11 [bookmark: 71239]PKI Enrollment Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-839216]Element
          
  
         		
           
           [bookmark: pgfId-839218]Description
          
  
        

 
         
         		[bookmark: pgfId-839224]Name

  
         		[bookmark: pgfId-839229]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
        

 
         
         		[bookmark: pgfId-839235]Description

  
         		[bookmark: pgfId-839237]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-839243]CA Information tab

  
         		[bookmark: pgfId-839248]Use this tab to enter settings related to the Certificate Authority server, its certificate, and its level of revocation checking support. For information on the specific settings, see PKI Enrollment Dialog Box—CA Information Tab.

  
        

 
         
         		[bookmark: pgfId-839254]Enrollment Parameters tab

  
         		[bookmark: pgfId-839259]Use this tab to enter settings related to PKI enrollment. For information on the specific settings, see PKI Enrollment Dialog Box—Enrollment Parameters Tab.

 [bookmark: pgfId-839261]Note You do not have to define enrollment parameters in order to create or import a trustpoint in Security Manager.

  
        

 
         
         		[bookmark: pgfId-839267]Certificate Subject Name tab

  
         		[bookmark: pgfId-839272]Use this tab to enter optional information to be included in the certificate, including subject attributes. For information on the specific settings, see PKI Enrollment Dialog Box—Certificate Subject Name Tab.

  
        

 
         
         		[bookmark: pgfId-839278]Trusted CA Hierarchy tab

  
         		[bookmark: pgfId-839283]Use this tab to define trusted CA servers that are arranged in a hierarchical framework. For information on the specific settings, see PKI Enrollment Dialog Box—Trusted CA Hierarchy Tab.

  
        

 
         
         		[bookmark: pgfId-839289]Category

  
         		[bookmark: pgfId-839294]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-839300]Allow Value Override per Device

 [bookmark: pgfId-839302]Overrides

 [bookmark: pgfId-839304]Edit button

  
         		[bookmark: pgfId-839312]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-839314]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-843093][bookmark: 71303][bookmark: pobjpage_cncpt_PKIEnrollmentDialogBoxCAInformationTab]PKI Enrollment Dialog Box—CA Information Tab [bookmark: marker-843083][bookmark: marker-843085][bookmark: marker-843087][bookmark: marker-843089][bookmark: marker-843091]

 
     [bookmark: pgfId-843095]Use the CA Information tab of the PKI Enrollment dialog box to:

 
      
      		 [bookmark: pgfId-843097]Define the name and location of the external certificate authority (CA) server.

 
      		 [bookmark: pgfId-843099]Manually paste the certificate, if known.

 
      		 [bookmark: pgfId-843101]Define the server’s level of support for revocation checking.

 
     

 
     [bookmark: pgfId-843103]Navigation Path

 
     [bookmark: pgfId-843108]Go to the PKI Enrollment dialog box and click the CA Information tab. For information on opening the dialog box, see PKI Enrollment Dialog Box.

 
     [bookmark: pgfId-843110]Related Topics

 
      
      		 [bookmark: pgfId-843115]PKI Enrollment Dialog Box—Enrollment Parameters Tab

 
      		 [bookmark: pgfId-843120]PKI Enrollment Dialog Box—Certificate Subject Name Tab

 
      		 [bookmark: pgfId-843125]PKI Enrollment Dialog Box—Trusted CA Hierarchy Tab

 
     

 
     [bookmark: pgfId-843127]Field Reference

 
     [bookmark: pgfId-843130] 

 
      
       
        
        [bookmark: pgfId-839327]Table 26-12 [bookmark: 71350]PKI Enrollment Dialog Box—CA Information Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-839333]Element
          
  
         		
           
           [bookmark: pgfId-839335]Description
          
  
        

 
         
         		[bookmark: pgfId-839341]CA Server Nickname

  
         		[bookmark: pgfId-839343]The name used to identify the CA server in the certificate request. If you leave this field blank, the domain name is used. You must leave this field blank for Verisign CAs. Also, keep the following in mind:

 
           
           		 [bookmark: pgfId-839345]You cannot configure two CA servers with the same name but different URLs on the same device.

 
           		 [bookmark: pgfId-839350]The CA name cannot match the name of a trusted CA configured as part of the same PKI enrollment object (as defined on the PKI Enrollment Dialog Box—Trusted CA Hierarchy Tab).

 
           		 [bookmark: pgfId-839352]When the device is configured as part of a VPN, do not configure a device-level override that uses the same CA name as that of the CA server used by any of the peers. (This is not a problem when the device and its peers use a tiered PKI hierarchy.)

 
          

  
        

 
         
         		[bookmark: pgfId-839358]Enrollment Type

  
         		[bookmark: pgfId-839360]The type of enrollment you want to perform. Security Manager completes the enrollment only if you configure URL enrollment. If you select another type, you must complete the enrollment using your own methods.

 
           
           		 [bookmark: pgfId-839362]Self-Signed Certificate (ASA only)—To configure the  enrollment self command.

 
           		 [bookmark: pgfId-839364]Terminal (ASA only)—To configure the  enrollment terminal command.

 
           		 [bookmark: pgfId-839366]URL—To configure the URL for the CA server so that you can complete automatic enrollment.

 
           		 [bookmark: pgfId-839368]None—Do not configure any enrollment command.

 
          

  
        

 
         
         		[bookmark: pgfId-839374]Enrollment URL

 [bookmark: pgfId-839376](URL enrollment only.)

  
         		[bookmark: pgfId-839378]The URL of the CA server to which devices should attempt to enroll. The URL can be in the following formats:

 
           
           		 [bookmark: pgfId-839380]SCEP—Uses an HTTP URL in the form of  http://CA_name:port , where CA_name is the host DNS name or IP address of the CA server. The port number is mandatory.

 
           		 [bookmark: pgfId-839382]TFTP—Uses the format  tftp://certserver/file_specification . Use this option when you do not have direct access to the CA server. The TFTP server transfers certificate requests and certificates.

 
           		 [bookmark: pgfId-839384]Other supported formats include: bootflash, cns, flash, ftp, null, nvram, rcp, scp, system.

 
          

 , where script_location is the full path to the CA scripts.

  
        

 
         
         		[bookmark: pgfId-839392]CA Certificate Source

 [bookmark: pgfId-839394]Fingerprint

 [bookmark: pgfId-839396]Certificate

 [bookmark: pgfId-839398](URL enrollment only.)

  
         		[bookmark: pgfId-839400]How to obtain the certificate:

 
           
           		 [bookmark: pgfId-839402] Retrieve CA Certificate Using SCEP (the default)—Have the router retrieve the certificate from the CA server using the Simple Certificate Enrollment Process (SCEP). Enter the fingerprint for the CA server in hexadecimal format. If the value you enter does not match the fingerprint on the certificate, the certificate is rejected.

 
          

 [bookmark: pgfId-839404]Using the fingerprint to verify the authenticity of the CA’s certificate helps prevent an unauthorized party from substituting a fake certificate in place of the real one.

 . Using the fingerprint is supported only on Cisco IOS software releases 12.3(12) or higher, 12.3(14)T or higher, 12.4 or higher (including 15.x), 12.2(33)XNA or higher. 
           
           		 [bookmark: pgfId-839408] Enter CA Certificate from CA Server Manually —Copy and Paste up to three certificates from another device into the  Certificate field (using your browser’s Paste function or the Ctrl-V keyboard shortcut). Each certificate must begin with the word “certificate” and end with the word “quit”. Use this option when you want the PKI enrollment object to represent predefined certificates.

 
          

  
        

 
         
         		[bookmark: pgfId-839414]CA Certificate Check

  
         		[bookmark: pgfId-839416]Certificates without the CA flag now cannot be installed on the ASA as CA certificates by default. The basic constraints extension identifies whether the subject of the certificate is a CA and the maximum depth of valid certification paths that include this certificate. Beginning with version 4.9, you can use Security Manager to configure the ASA to allow installation of these certificates if desired. This feature is supported only in devices running ASA software version 9.4(1) or higher.

 [bookmark: pgfId-839418]CA Certificate check is enabled by default.

  
        

 
         
         		[bookmark: pgfId-839424]Revocation Check Support

  
         		[bookmark: pgfId-839426]The type of certificate revocation checking to be performed:

 
           
           		 [bookmark: pgfId-839428]Checking Not Performed—This is the default. The device does not perform any revocation checking, even if a CRL is on the device.

 
           		 [bookmark: pgfId-839430]CRL Check Required—The device must check a CRL. If no CRL exists on the device and the device cannot obtain one, certificates are rejected and a tunnel cannot be established.

 
           		 [bookmark: pgfId-839432]OCSP Check Required—The device must check revocation status from an OCSP server. If this check fails, certificates are rejected.

 
           		 [bookmark: pgfId-839434]CRL Check Attempted—The device tries to download the latest CRL from the specified LDAP server. If the download fails, however, certificates are accepted.

 
           		 [bookmark: pgfId-839436]OCSP Check Attempted—The device tries to check revocation status from an OCSP server. If this fails, however, certificates are accepted.

 
           		 [bookmark: pgfId-839438]CRL or OCSP Check Required—The device first checks for a CRL. If a CRL does not exist or cannot be obtained, the device tries to check revocation status from an OCSP server. If both options fail, certificates are rejected.

 
           		 [bookmark: pgfId-839440]OCSP or CRL Check Required—The device first tries to check revocation status from an OCSP server. If this fails, the device checks for a CRL. If both options fail, certificates are rejected.

 
           		 [bookmark: pgfId-839442]CRL and OCSP Checks Attempted—The device first checks for a CRL. If a CRL does not exist or cannot be obtained, the device tries to check revocation status from an OCSP server. If both options fail, however, certificates are accepted.

 
           		 [bookmark: pgfId-839444]OCSP and CRL Checks Attempted—The device first tries to check revocation status from an OCSP server. If this fails, the device tries to download the latest CRL. If both options fail, however, certificates are accepted.

 
          

  
        

 
         
         		[bookmark: pgfId-839450]OCSP Server URL

  
         		[bookmark: pgfId-839452]The URL of the OCSP server checking for revocation if you require OCSP checks. This URL must start with http://

  
        

 
         
         		[bookmark: pgfId-839458]CRL Server URL

  
         		[bookmark: pgfId-839460]The URL of the LDAP server from which the CRL can be downloaded if you require CRL checks. This URL must start with ldap://

 [bookmark: pgfId-839462]Note You must include a port number in the URL when using this AAA server on ASA devices, otherwise LDAP will fail.

  
        

 
         
         		[bookmark: pgfId-839468]Enable Registration Authority Mode (PIX 6.3)

  
         		[bookmark: pgfId-839470]For PIX 6.3 devices, whether the CA server operates in RA (Registration Authority) mode. A Registration Authority is a server that acts as a proxy for the actual CA so that CA operations can continue when the CA server is offline.

 [bookmark: pgfId-839472]Note Cisco IOS routers configure RA mode automatically, if required.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-843146][bookmark: 71475][bookmark: pobjpage_cncpt_PKIEnrollmentDialogBoxEnrollmentParametersTab]PKI Enrollment Dialog Box—Enrollment Parameters Tab [bookmark: marker-843136][bookmark: marker-843138][bookmark: marker-843140][bookmark: marker-843142][bookmark: marker-843144]

 
     [bookmark: pgfId-843148]Use the Enrollment Parameters tab of the PKI Enrollment dialog box to define the retry settings to use when the device contacts the CA server as well as the settings for generating the RSA key pair to associate with the certificate.

 
     [bookmark: pgfId-843150]If the PKI enrollment object represents a Microsoft CA, you can define the challenge password required to validate the router’s identity.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-843152]Note You do not have to define enrollment parameters in order to create or import a trustpoint in Security Manager.


     
      

     

     

 
     [bookmark: pgfId-843154]Navigation Path

 
     [bookmark: pgfId-843159]Go to the PKI Enrollment dialog box and click the Enrollment Parameters tab. For information on opening the dialog box, see PKI Enrollment Dialog Box.

 
     [bookmark: pgfId-843161]Related Topics

 
      
      		 [bookmark: pgfId-843166]PKI Enrollment Dialog Box—CA Information Tab

 
      		 [bookmark: pgfId-843171]PKI Enrollment Dialog Box—Certificate Subject Name Tab

 
      		 [bookmark: pgfId-843176]PKI Enrollment Dialog Box—Trusted CA Hierarchy Tab

 
     

 
     [bookmark: pgfId-843178]Field Reference

 
     [bookmark: pgfId-843181] 

 
      
       
        
        [bookmark: pgfId-839485]Table 26-13 [bookmark: 71517]PKI Enrollment Dialog Box—Enrollment Parameters Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-839491]Element
          
  
         		
           
           [bookmark: pgfId-839493]Description
          
  
        

 
         
         		[bookmark: pgfId-839499]Challenge Password

  
         		[bookmark: pgfId-839501]The password used by the CA server to validate the identity of the device. This password is mandatory for PIX 6.3 devices, but optional for PIX/ASA 7.0+ devices and Cisco IOS routers.

 [bookmark: pgfId-839503]You can obtain the password by contacting the CA server directly or by entering the following address in a web browser: http://URLHostName/certsrv/mscep/mscep.dll. The password is good for 60 minutes from the time you obtain it from the CA server. Therefore, it is important that you deploy the password as soon as possible after you create it.

 [bookmark: pgfId-839508]Note Each password is valid for a single enrollment by a single device. Therefore, we do not recommend that you assign a PKI enrollment object where this field is defined to a VPN, unless you first configure a device-level override for each device in the VPN. For more information, see Understanding Policy Object Overrides for Individual Devices.

  
        

 
         
         		[bookmark: pgfId-839514]Retry Period

  
         		[bookmark: pgfId-839516]The interval between certificate request attempts, in minutes. Values can be 1 to 60 minutes. The default is 1 minute.

  
        

 
         
         		[bookmark: pgfId-839522]Retry Count

  
         		[bookmark: pgfId-839524]The number of retries that should be made if no certificate is issued upon the first request. Values can be 1 to 100. The default is 10.

  
        

 
         
         		[bookmark: pgfId-839530]Certificate Auto-Enrollment

 [bookmark: pgfId-839532](IOS devices only.)

  
         		[bookmark: pgfId-839534]The percentage of the current certificate’s lifetime after which the router requests a new certificate. For example, if you enter 70, the router requests a new certificate after 70% of the lifetime of the current certificate has been reached. Values range from 10% to 100%.

 [bookmark: pgfId-839536]If you do not specify a value, the router requests a new certificate after the old certificate expires.

  
        

 
         
         		[bookmark: pgfId-839542]Include Device’s Serial Number

  
         		[bookmark: pgfId-839544]Whether to include the serial number of the device in the certificate.

 [bookmark: pgfId-839546]Tip The CA uses the serial number to either authenticate certificates or to later associate a certificate with a particular device. If you are in doubt, include the serial number, as it is useful for debugging purposes.  
        

 
         
         		[bookmark: pgfId-839552]RSA Key Pair Name

 [bookmark: pgfId-839554](PIX 7.0+, ASA, IOS devices only.)

  
         		[bookmark: pgfId-839556]If the key pair you want to associate with the certificate already exists, this field specifies the name of that key pair.

 [bookmark: pgfId-839558]If the key pair does not exist, this field specifies the name to assign to the key pair that will be generated during enrollment.

 [bookmark: pgfId-839560]Note If you do not specify an RSA key pair, the fully qualified domain name (FQDN) key pair is used instead. On PIX and ASA devices, the key pair must exist on the device before deployment.

  
        

 
         
         		[bookmark: pgfId-839566]RSA Key Size

 [bookmark: pgfId-839568](IOS devices only.)

  
         		[bookmark: pgfId-839570]If the key pair does not exist, defines the desired key size (modulus), in bits. If you want a modulus between 512 and 1024, enter an integer that is a multiple of 64. If you want a value higher than 1024, enter 1536 or 2048. The recommended size is 1024.

 [bookmark: pgfId-839572]Note The larger the modulus size, the more secure the key. However, keys with larger modulus sizes take longer to generate (a minute or more when larger than 512 bits) and longer to process when exchanged.

  
        

 
         
         		[bookmark: pgfId-839578]RSA Encryption Key Size

 [bookmark: pgfId-839580](IOS devices only.)

  
         		[bookmark: pgfId-839582]The size of the second key, which is used to request separate encryption, signature keys, and certificates.

  
        

 
         
         		[bookmark: pgfId-839588]Source Interface

 [bookmark: pgfId-839590](IOS devices and ASA 9.5(1) or higher)

  
         		[bookmark: pgfId-839592]The source address for all outgoing connections sent to a CA or LDAP server during authentication, enrollment, and when obtaining a revocation list. This parameter may be necessary when the CA server or LDAP server cannot respond to the address from which the connection originated (for example, due to a firewall).

 [bookmark: pgfId-839594]If you do not define a value in this field, the address of the outgoing interface is used.

 [bookmark: pgfId-839596]Enter the name of an interface or interface role, or click Select to select it. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-839598]Note Security Manager 4.9 supports separate routing table for Management traffic on devices running ASA 9.5(1) or higher. This functionality enables to completely segregate management traffic from other data traffic on the ASA. Apart from IOS devices you can now select ASA devices running the software version 9.5(1) or higher.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-843197][bookmark: 71592][bookmark: pobjpage_cncpt_PKIEnrollmentDialogBoxCertificateSubjectNameTab]PKI Enrollment Dialog Box—Certificate Subject Name Tab [bookmark: marker-843187][bookmark: marker-843189][bookmark: marker-843191][bookmark: marker-843193][bookmark: marker-843195]

 
     [bookmark: pgfId-843199]Use the Certificate Subject Name tab of the PKI Enrollment dialog box to optionally define additional information about the device in certificate requests sent to the CA server. This information is placed in the certificate and can be viewed by any party who receives the certificate from the router.

 
     [bookmark: pgfId-843201]Enter all information using the standard LDAP X.500 format.

 
     [bookmark: pgfId-843203]Navigation Path

 
     [bookmark: pgfId-843208]Go to the PKI Enrollment dialog box and click the Certificate Subject Name tab. For information on opening the dialog box, see PKI Enrollment Dialog Box.

 
     [bookmark: pgfId-843210]Related Topics

 
      
      		 [bookmark: pgfId-843215]PKI Enrollment Dialog Box—CA Information Tab

 
      		 [bookmark: pgfId-843220]PKI Enrollment Dialog Box—Enrollment Parameters Tab

 
      		 [bookmark: pgfId-843225]PKI Enrollment Dialog Box—Trusted CA Hierarchy Tab

 
     

 
     [bookmark: pgfId-843227]Field Reference

 
     [bookmark: pgfId-843230] 

 
      
       
        
        [bookmark: pgfId-839611]Table 26-14 [bookmark: 71633]PKI Enrollment Dialog Box—Certificate Subject Name Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-839617]Element
          
  
         		
           
           [bookmark: pgfId-839619]Description
          
  
        

 
         
         		[bookmark: pgfId-839625]Include Device’s FQDN

  
         		[bookmark: pgfId-839627]Whether to include the device’s fully qualified domain name (FQDN) in the certificate request.

 [bookmark: pgfId-839629]The name is taken from the Hostname policy (ensure that you specify both the hostname and domain name in the policy to get a valid fully-qualified domain name). If you do not configure the Hostname policy, the name is derived from the display name for the device in Security Manager, display_name.null, which is unlikely to give you the desired results.

  
        

 
         
         		[bookmark: pgfId-839635]Include Device’s IP Address

  
         		[bookmark: pgfId-839637]The interface whose IP address is included in the certificate request.

 [bookmark: pgfId-839639]Enter the name of the interface or interface role, or click Select to select it. If the object that you want is not listed, click the Create button to create it.

  
        

 
         
         		[bookmark: pgfId-839645]Common Name (CN)

  
         		[bookmark: pgfId-839647]The X.500 common name to include in the certificate.

  
        

 
         
         		[bookmark: pgfId-839653]Organization Unit (OU)

  
         		[bookmark: pgfId-839655]The name of the organization unit (for example, a department name) to include in the certificate.

 [bookmark: pgfId-839660]Note When you configure PKI enrollment objects for Cisco Easy VPN Remote components, this field must contain the name of the client group to which the component connects. Otherwise, the component will not be able to connect. Although this information is not required for the Easy VPN Server, including it does not create configuration problems. For more information about Easy VPN, see Understanding Easy VPN.

  
        

 
         
         		[bookmark: pgfId-839666]Organization (O)

  
         		[bookmark: pgfId-839668]The organization or company name to include in the certificate.

  
        

 
         
         		[bookmark: pgfId-839674]Locality (L)

  
         		[bookmark: pgfId-839676]The locality to include in the certificate.

  
        

 
         
         		[bookmark: pgfId-839682]State (ST)

  
         		[bookmark: pgfId-839684]The state or province to include in the certificate.

  
        

 
         
         		[bookmark: pgfId-839690]Country (C)

  
         		[bookmark: pgfId-839692]The country to include in the certificate.

  
        

 
         
         		[bookmark: pgfId-839698]Email (E)

  
         		[bookmark: pgfId-839700]The email address to include in the certificate.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-843246][bookmark: 71697][bookmark: pobjpage_cncpt_PKIEnrollmentDialogBoxTrustedCAHierarchyTab]PKI Enrollment Dialog Box—Trusted CA Hierarchy Tab [bookmark: marker-843236][bookmark: marker-843238][bookmark: marker-843240][bookmark: marker-843242][bookmark: marker-843244]

 
     [bookmark: pgfId-843248]Use the Trusted CA Hierarchy tab of the PKI Enrollment dialog box to define the trusted CA servers within an hierarchical PKI framework. Within this framework, all enrolled peers can validate each other’s certificates if they share a trusted root CA certificate or a common subordinate CA.

 
     [bookmark: pgfId-843250]Select the CA servers (as defined as PKI enrollment objects) to include in the hierarchy in the Available Servers list and click >> to move them to the selected list. You can do the reverse to remove servers.

 
     [bookmark: pgfId-843252]If the PKI enrollment object you need is not yet defined, click the Create (+) button beneath the available servers list to create the object. You can also select an object and click the Edit button to change its definition, if needed.

 
     [bookmark: pgfId-843254]Navigation Path

 
     [bookmark: pgfId-843259]Go to the PKI Enrollment dialog box and click the Trusted CA Hierarchy tab. For information on opening the dialog box, see PKI Enrollment Dialog Box.

 
     [bookmark: pgfId-843261]Related Topics

 
      
      		 [bookmark: pgfId-843266]PKI Enrollment Dialog Box—CA Information Tab

 
      		 [bookmark: pgfId-843271]PKI Enrollment Dialog Box—Enrollment Parameters Tab

 
      		 [bookmark: pgfId-843276]PKI Enrollment Dialog Box—Certificate Subject Name Tab

 
     

 
    
 
   
 
    
     [bookmark: pgfId-843288][bookmark: 71741][bookmark: vpchap_proc_ConfiguringIKEv2Authentication]Configuring IKEv2 Authentication in Site-to-Site VPNs[bookmark: marker-843282][bookmark: marker-843284][bookmark: marker-843286]

 
    [bookmark: pgfId-843290]When you configure IKE version 2 (IKEv2) in a site-to-site VPN, you must configure the IKEv2 Authentication policy to define authentication settings. Unlike IKEv1, authentication settings are not part of the IKEv2 proposal.

 
    [bookmark: pgfId-843292]In Security Manager, when you configure IKEv2 authentication for a site-to-site VPN, you configure default settings that will be used in the VPN topology. You can then configure exceptions to the default, specifying different preshared keys or trustpoints for specific segments of the VPN. You can use a mixture of preshared keys and trustpoints, for example, configuring a global preshared key, but trustpoints for selected members of the VPN.

 
    [bookmark: pgfId-843294]Configuring asymmetric authentication for IKEv2 tunnels

 
    [bookmark: pgfId-843296]IKEv2 allows you to use asymmetric authentication, unlike IKEv1. This means that two peers can have different preshared keys, different trustpoints, or one peer could use a preshared key and the other peer could use a trustpoint. In Security Manager, you can configure asymmetric authentication by doing any of the following:

 
     
     		 [bookmark: pgfId-843298]On the Global IKEv2 Authentication Settings tab, you can configure different preshared keys if you elect to auto-generate keys and  do not select the Same Keys for All Tunnels or the Same Key at Tunnel Endpoints option. A different preshared key is generated for each end of each tunnel.

 
     		 [bookmark: pgfId-843300]On the Override IKEv2 Authentication Settings tab, you can create overrides for the global settings. You add overrides that specify different keys or trustpoints for subsets of local and remote peers. Because you can create more than one override for a device or a specific tunnel, you can configure a set of preshared keys and trustpoints from which peers will authenticate.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-843302]Tip The IKEv2 Authentication policy is not a shared policy. You must configure the policy for each VPN topology in which you support IKEv2 negotiations. You cannot configure global IKEv2 authentication options for use by all of your VPN topologies. When using the Create VPN wizard, even if you elect to support IKEv2, the IKEv2 Authentication policy is never configured.


    
     

    

    

 
    [bookmark: pgfId-843304]Before You Begin

 
    [bookmark: pgfId-843306]The IKEv2 Authentication policy is used only if you enable IKEv2 in the VPN in the IKE Proposal and IPsec Proposal policies, and if at least some of the devices in the topology support IKEv2.

 
    [bookmark: pgfId-843311]To configure IKEv2, the device must be an ASA running ASA Software release 8.4(1) or higher. For more information on device support, see Understanding Devices Supported by Each IPsec Technology.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-843313]Tip If you support only IKEv2 in the topology, ensure that you unassign the IKEv1 Preshared Keys and IKEv1 Public Key Infrastructure policies to avoid validation warnings.


    
     

    

    

 
    [bookmark: pgfId-843315]Related Topics

 
     
     		 [bookmark: pgfId-843320]Understanding IKE

 
     		 [bookmark: pgfId-843325]Deciding Which Authentication Method to Use

 
    

 
    
 
    [bookmark: pgfId-843330]Step 1 Open the Site-to-Site VPN Manager Window, select a regular IPsec topology (that supports IKEv2) in the VPNs selector, then select IKEv2 Authentication in the Policies selector.

 
    [bookmark: pgfId-843335]For reference information on the policy, see IKEv2 Authentication Policy.

 
    [bookmark: pgfId-843337]Step 2 On the Global IKEv2 Authentication Settings tab, configure the authentication type that should be used for devices in the VPN for which no override is configured on the Override IKEv2 Authentication Settings tab. Select the option that is used by most devices in the VPN. You can configure a global preshared key or trustpoint:

 
     
     		 [bookmark: pgfId-843339] Global Preshared Keys —To configure a global preshared key, select  Key Specification and then configure one of the following options:

 
    

 
    [bookmark: pgfId-843341] – User Defined—Enter the desired global key and enter it again in the Confirm field.

 
    [bookmark: pgfId-843343] – Auto Generated—Enter the length of the key that should be generated and select whether you want to use the same key for all tunnels or the same key at both ends of a single tunnel. If you select neither of these options, unique keys are generated for every end point.

 
    [bookmark: pgfId-843345]You can also select Regenerate Key (On Next Deployment) to have new keys generated. This allows you to periodically re-key the VPN. The check box is cleared after the next successful deployment.

 
     
     		 [bookmark: pgfId-843347] Global Trustpoint (CA Servers) —To configure trustpoint certificate authorization, select  PKI Specification and enter the name of the PKI enrollment object that identifies the Certificate Authority (CA) server. Click  Select to select the object from a list or to create a new object.

 
    

 
    [bookmark: pgfId-843349]Step 3 If you want to override the global IKEv2 authentication configuration for specific devices, click the Override IKEv2 Authentication Settings tab and do any of the following:

 
     
     		 [bookmark: pgfId-843354]To add an override, click the  Add Row (+) button and fill in the IKEv2 Authentication dialog box. You select the local and remote peers for which to create the override, and then specify the preshared key or CA server that should be used. See IKEv2 Authentication (Override) Dialog Box.

 
     		 [bookmark: pgfId-843356]To edit an override, select it in the table and click the  Edit Row (pencil) button.

 
     		 [bookmark: pgfId-843358]To delete an override, select it in the table and click the  Delete Row (trash can) button.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-843363]Note You can configure asymmetric authentication in site-to-site VPNs, where each side of a tunnel can have different preshared keys. To create asymmetric keys for IKEv2 authentication, for each peer device that is part of the site-to-site topology, you must add two rows on the Override IKEv2 Authentication Settings tab. For more information, see IKEv2 Authentication (Override) Dialog Box


    
     

    

    

 
    [bookmark: pgfId-843365]


    
     

    
 
    

 
     
      [bookmark: pgfId-843381][bookmark: 71825][bookmark: vpnpage_cncpt_IKEv2AuthenticationPage]IKEv2 Authentication Policy[bookmark: marker-843375][bookmark: marker-843377][bookmark: marker-843379]

 
     [bookmark: pgfId-843386]Use the IKEv2 Authentication policy to configure the device authentication settings for Internet Key Exchange (IKE) version 2 in site-to-site VPNs. These settings apply to ASA 8.4(1)+ devices only. For more information about configuring IKEv2 authentication, see Configuring IKEv2 Authentication in Site-to-Site VPNs.

 
     [bookmark: pgfId-843388]The policy contains two tabs:

 
      
      		 [bookmark: pgfId-843390]Global IKEv2 Authentication Settings—The global settings apply to all devices in the VPN unless overrides are configured on the Overrides tab. Configure the global settings to represent the authentication scheme used by most devices in the VPN.

 
      		 [bookmark: pgfId-843392]Override IKEv2 Authentication Settings—The override settings apply unique authentication settings to specific tunnels, allowing you to create unique preshared key and trustpoint combinations that are required by various tunnels in the VPN. The settings you configure on this tab are used first and always take precedence over the global settings.

 
     

 
     [bookmark: pgfId-843394]Navigation Path

 
     [bookmark: pgfId-843399]Open the Site-to-Site VPN Manager Window, select a regular IPsec topology (that supports IKEv2) in the VPNs selector, then select IKEv2 Authentication in the Policies selector.

 
     [bookmark: pgfId-843401]This policy is not available as a shared policy.

 
     [bookmark: pgfId-843403]Related Topics

 
      
      		 [bookmark: pgfId-843408]Understanding IKE

 
      		 [bookmark: pgfId-843413]Understanding IPsec Proposals for Site-to-Site VPNs

 
      		 [bookmark: pgfId-843418]Filtering Tables

 
      		 [bookmark: pgfId-843423]Table Columns and Column Heading Features

 
     

 
     [bookmark: pgfId-843425]Field Reference

 
     [bookmark: pgfId-843428] 

 
      
       
        
        [bookmark: pgfId-839713]Table 26-15 [bookmark: 71871]IKEv2 Authentication Policy 

 
        
       
         
         		
           
           [bookmark: pgfId-839719]Element
          
  
         		
           
           [bookmark: pgfId-839721]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-839727]Global IKEv2 Authentication Settings Tab
          
  
        

 
         
         		[bookmark: pgfId-839735]Key Specification

  
         		[bookmark: pgfId-839737]Use a preshared key for authentication in the VPN. Configure one of the following:

 
           
           		 [bookmark: pgfId-839739] User Defined —Enter the desired global key and enter it again in the Confirm field. The key can be 1 to 128 characters.

 
           		 [bookmark: pgfId-839741] Auto Generated —Have Security Manager generate a key for you. Specify the following options to indicate how the key should be generated:

 
          

 [bookmark: pgfId-839743] – Key Length—The length of the key that should be generated, from 1 to 128.

 [bookmark: pgfId-839745] – Same Keys for All Tunnels—Select this option to generate the same keys for all tunnels in the VPN. If you do not select this option, different keys or pair of keys (if you select Same Key for Tunnel Endpoints) are used for each tunnel.

 [bookmark: pgfId-839747] – Same Key for Tunnel Endpoints—Select this option to generate the same key on each end of each tunnel within the VPN. If you do not select this option, different keys are generated on each end of the tunnel.

 [bookmark: pgfId-839749] – Regenerate Key (On Next Deployment)—Select this option to generate new keys for the next deployment to the devices. This allows you to easily re-key the VPN.

 [bookmark: pgfId-839751]After a successful deployment, this check box is cleared so that keys are not regenerated on the subsequent deployment. Select the option each time you want to re-key the VPN.

  
        

 
         
         		[bookmark: pgfId-839757]PKI Specification

  
         		[bookmark: pgfId-839759]The name of the PKI enrollment policy object that defines the trustpoint for IKEv2 connections. A trustpoint represents a Certificate Authority (CA)/identity pair and contains the identity of the CA, CA-specific configuration parameters, and an association with one enrolled identity certificate. Click Select to select the PKI enrollment object or to create a new object.

  
        

 
         
         		[bookmark: pgfId-839765]Override IKEv2 Authentication Settings tab

  
         		[bookmark: pgfId-839767]The table lists the IKEv2 authentication overrides defined for the VPN. These policies take precedence over the preshared key/PKI configuration defined in the global settings. Do any of the following to configure overrides:

 
           
           		 [bookmark: pgfId-839772]To add an override, click the  Add Row (+) button and fill in the IKEv2 Authentication dialog box. You select the local and remote peers for which to create the override, and then specify the preshared key or CA server that should be used. See IKEv2 Authentication (Override) Dialog Box.

 
           		 [bookmark: pgfId-839774]To edit an override, select it in the table and click the  Edit Row (pencil) button.

 
           		 [bookmark: pgfId-839776]To delete an override, select it in the table and click the  Delete Row (trash can) button.

 
          

 [bookmark: pgfId-839781]Note You can configure asymmetric authentication in site-to-site VPNs, where each side of a tunnel can have different preshared keys. To create asymmetric keys for IKEv2 authentication, for each peer device that is part of the site-to-site topology, you must add two rows on the Override IKEv2 Authentication Settings tab. For more information, see IKEv2 Authentication (Override) Dialog Box

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-843446][bookmark: 71938][bookmark: vpnpage_cncpt_IKEv2AuthenticationDialogBox]IKEv2 Authentication (Override) Dialog Box[bookmark: marker-843440][bookmark: marker-843442][bookmark: marker-843444]

 
     [bookmark: pgfId-843451]Use the IKEv2 Authentication dialog box to configure overrides to the IKEv2 authentication global settings for a site-to-site VPN. For more information about IKEv2 global and override authentication settings, see Configuring IKEv2 Authentication in Site-to-Site VPNs.

 
     [bookmark: pgfId-843453]Navigation Path

 
     [bookmark: pgfId-843458]From the Override IKEv2 Authentication Settings tab of the IKEv2 Authentication policy (see IKEv2 Authentication Policy), click the Add Row (+) button or select an override in the table and click Edit Row (pencil).

 
     [bookmark: pgfId-843460]Field Reference

 
     [bookmark: pgfId-843463] 

 
      
       
        
        [bookmark: pgfId-839794]Table 26-16 [bookmark: 71964]IKEv2 Authentication Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-839800]Element
          
  
         		
           
           [bookmark: pgfId-839802]Description
          
  
        

 
         
         		[bookmark: pgfId-839808]Local Peers

 [bookmark: pgfId-839810]Remote Peers

  
         		[bookmark: pgfId-839812]The local and remote sides of the tunnels for which you are defining this override.

 [bookmark: pgfId-839814]To add devices to the list, click the Select button to the right of the list to open the Local or Remote Peer Selection dialog box. In that dialog box, select the desired peers in the Available list and click >> to move them to the Selected list. You can deselect a device by doing the reverse (using the << button).

 [bookmark: pgfId-839816]The list of available devices includes only those devices that support IKEv2 connections, which might not be all of the devices in the VPN.

  
        

 
         
         		[bookmark: pgfId-839822]IKEv2 Authentication Mode

  
         		[bookmark: pgfId-839824]The IKEv2 authentication mode to use between the selected local and remote peers. Select one of the following:

 
           
           		 [bookmark: pgfId-839826]Key Specification—A user-defined preshared key, from 1 to 128 characters. Enter the desired key and enter it again in the Confirm field.

 
           		 [bookmark: pgfId-839828]PKI Specification—The name of the PKI enrollment policy object that defines the trustpoint for IKEv2 connections. Click  Select to select the PKI enrollment object or to create a new object.

 
          

  
        

 
       
      

 
     
 
     [bookmark: pgfId-843465]Configuring Asymmetric keys for IKEv2 Authentication

 
     [bookmark: pgfId-843467]You can configure asymmetric authentication in site-to-site VPNs, where each side of a tunnel can have different preshared keys. To create asymmetric keys for IKEv2 authentication, for each peer device that is part of the site-to-site topology, you must add two rows on the Override IKEv2 Authentication Settings tab. Perform the following:

 
     [bookmark: pgfId-843469] 1. Click the Override IKEv2 Authentication Settings tab and then click theAdd Row (+) button. The IKEv2 Authentication dialog box opens. On Peers specification, select the Local Peer device and the Remote Peer device that are part of the site-to-site VPN topology. On IKEv2 Authentication Mode select Key Specification and then specify a key and confirm. Security Manager considers this key as the local preshared key for the selected local peer device and the same key as the remote preshared key for the selected remote peer device. Click OK to return to the Override IKEv2 Authentication Settings tab.

 
     [bookmark: pgfId-843471] 2. With the Override IKEv2 Authentication Settings tab selected, click the Add Row (+) button. The IKEv2 Authentication dialog box opens. On Peers specification, for Local Peer, select the Remote Peer device of Step 1 and for Remote Peer, select the Local Peer device of Step 1. On IKEv2 Authentication Mode select Key Specification and then specify a key and confirm. This key must be different from the key that you specified in Step 1.

 
     [bookmark: pgfId-843474]The following table illustrates the configuration of asymmetric keys for IKEv2 authentication:

 
      
       
       
         
         		 
           
           [bookmark: pgfId-839839] 
          
  
         		 
           
           [bookmark: pgfId-839841]Local Peer Device
          
  
         		 
           
           [bookmark: pgfId-839843]Remote Peer Device
          
  
         		 
           
           [bookmark: pgfId-839845]Authentication method (Preshared Key)
          
  
        

 
         
         		[bookmark: pgfId-839855]Add Row 1

  
         		[bookmark: pgfId-839857]Peer1

  
         		[bookmark: pgfId-839859]Peer2

  
         		[bookmark: pgfId-839861]test123

  
        

 
         
         		[bookmark: pgfId-839871]Add Row 2

  
         		[bookmark: pgfId-839873]Peer2

  
         		[bookmark: pgfId-839875]Peer1

  
         		[bookmark: pgfId-839877]sample123
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     [bookmark: pgfId-40708][bookmark: 114185][bookmark: pxchap_proc_ConfiguringResourcesonFirewallServicesModules]Configuring Hostname, Resources, User Accounts, and SLAs
      
      
 
     
 

 
    [bookmark: pgfId-40710]The following topics describe configuring the host name on a security appliance, defining and managing Resource classes on Firewall Services Modules (FWSMs) in multiple-context mode, managing user accounts in the Local user database, and monitoring service level agreements (SLAs) to perform route tracking.

 
    [bookmark: pgfId-40712]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-40717]Hostname Page

 
     		 [bookmark: pgfId-40722]Resource Management on Multi-context FWSMs

 
     		 [bookmark: pgfId-40727]Configuring User Accounts

 
     		 [bookmark: pgfId-40732]Monitoring Service Level Agreements (SLAs) To Maintain Connectivity

 
    

 
   
 
    
     [bookmark: pgfId-40746][bookmark: 114188][bookmark: pxpage_cncpt_HostnamePage]Hostname Page [bookmark: marker-40740][bookmark: marker-40742][bookmark: marker-40744]

 
    [bookmark: pgfId-40748]You can use the Hostname page to specify a host name for your security device, and to specify a default domain. After the configuration file is deployed, the device uses this domain name when you do not enter a fully-qualified domain name in other commands. It also uses this domain name in RSA key generation.

 
    [bookmark: pgfId-40750]The device appends this domain name to unqualified names. For example, if you set the domain name to “example.com,” and specify a syslog server by the unqualified name “jupiter,” the security appliance completes the name to “jupiter.example.com.”

 
    [bookmark: pgfId-40752]When you set a host name for the security appliance, that name appears in the command line prompt. If you establish sessions to multiple devices, the host name helps you keep track of where you enter commands. The default host name depends on your platform.

 
    [bookmark: pgfId-40754]In multiple-context mode, you can specify a domain name for each context, as well as the system execution space. The host name you specify in the system execution space appears in the command line prompt for all contexts. The host name that you optionally set within a context does not appear in the command line, but can be used by the banner command $(hostname) token.

 
    [bookmark: pgfId-40756]Navigation Path

 
    [bookmark: pgfId-40758]In Device View, select a security device and then select Platform > Device Admin > Hostname from the Device Policy selector.

 
    [bookmark: pgfId-40760]Field Reference

 
    [bookmark: pgfId-40763] 

 
     
      
       
       [bookmark: pgfId-39663]Table 51-1 [bookmark: 114214]Hostname Page 

 
       
      
        
        		
          
          [bookmark: pgfId-39669]Element
         
  
        		
          
          [bookmark: pgfId-39671]Description
         
  
       

 
        
        		[bookmark: pgfId-39677]Host Name

  
        		[bookmark: pgfId-39679]Enter a unique device name to help you differentiate among devices; for example, PIX-510-A.

 [bookmark: pgfId-39681]Note We recommend that you use a unique host name for each device you manage. The device name can be up to 63 alphanumeric (U.S. English) characters and can include any of the following special characters: ` ( ) + - , . / : =.

  
       

 
        
        		[bookmark: pgfId-39687]Domain Name

  
        		[bookmark: pgfId-39689]Optionally, enter a valid Domain Name System (DNS) domain name for the device; for example, cisco.com.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-40777][bookmark: 114238][bookmark: pxchap_cncpt_AboutFWSMResourceMgmt]Resource Management on Multi-context FWSMs [bookmark: marker-40771][bookmark: marker-40773][bookmark: marker-40775]

 
    [bookmark: pgfId-40779]By default, all security contexts on a multiple-context Firewall Services Module (FWSM) have unlimited access to the resources of the FWSM, except where maximum limits per context are enforced. However, if you find that one or more contexts use too many resources, and they cause other contexts to be denied connections, for example, then you can configure resource management to limit the use of resources per context.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-40781]Note The FWSM does not limit the bandwidth per context; however, the switch containing the FWSM can limit bandwidth per VLAN. See the switch documentation for more information.


    
     

    

    

 
    [bookmark: pgfId-40783]The FWSM manages resources by assigning contexts to resource classes. Each context uses the resource limits set by its class. When you create a class, the FWSM does not set aside a portion of the resources for each context assigned to the class; rather, the FWSM sets the maximum limit for a context. If you oversubscribe resources, or allow some resources to be unlimited, a few contexts can “use up” those resources, potentially affecting service to other contexts.

 
    [bookmark: pgfId-40785]You can set the limit for all resources together as a percentage of the total available for the device. Also, you can set the limit for individual resources as a percentage or as an absolute value.

 
    [bookmark: pgfId-40787]You can oversubscribe the FWSM by assigning more than 100 percent of the resources across all contexts. For example, you can set up a class to limit connections to 20 percent per context, and then assign 10 contexts to the class for a total of 200 percent. If contexts concurrently use more than the system limit, then each context gets less than the 20 percent you intended.

 
    [bookmark: pgfId-40789]The FWSM also lets you assign unlimited access to one or more resources in a class, instead of a percentage or absolute number. When a resource is unlimited, contexts can use as much of the resource as the system has available. For example, contexts A, B, and C are assigned to class “Onepercent,” which limits each class member to one percent of the system inspections per second, for a total of three percent; but the three contexts are currently only using two percent combined. On the other hand, class “Nolimit” has unlimited access to inspections. The contexts in Nolimit can use more than the 97 percent of “unassigned” inspections; they can also use the one percent of inspections not currently in use by contexts A, B, and C, even if that means that contexts A, B, and C are unable to reach their three percent combined limit. Setting unlimited access is similar to oversubscribing the FWSM, except that you have less control over how much you oversubscribe the system.

 
    [bookmark: pgfId-40791]Default Class

 
    [bookmark: pgfId-40793]All contexts belong to the default class if they are not assigned to another class; you do not have to actively assign a context to the default class.

 
    [bookmark: pgfId-40795]If a context belongs to a class other than the default class, those class settings always override the default class settings. However, if the other class has any settings that are not defined, then the member context uses the default class for those limits. For example, if you create a class with a two percent limit for all concurrent connections, but no other limits, then all other limits are inherited from the default class. Conversely, if you create a class with a two percent limit for all resources, the class uses no settings from the default class.

 
    [bookmark: pgfId-40797]As initially configured, the default class provides unlimited access to resources for all contexts, except for the following limits, which are by default set to the maximum allowed per context:

 
     
     		 [bookmark: pgfId-40799]Telnet sessions – 5 sessions

 
     		 [bookmark: pgfId-40801]SSH sessions – 5 sessions

 
     		 [bookmark: pgfId-40803]IPSec sessions – 5 sessions

 
     		 [bookmark: pgfId-40805]MAC addresses – 65,535 entries

 
    

 
    [bookmark: pgfId-40807]Note that you can edit the default class.

 
    [bookmark: pgfId-40809]Related Topics

 
     
     		 [bookmark: pgfId-40814]Resources Page

 
     		 [bookmark: pgfId-40819]Add/Edit Security Context Dialog Box (FWSM)

 
    

 
     
      [bookmark: pgfId-40835][bookmark: 114283][bookmark: pxpage_cncpt_ResourcesPage]Resources Page [bookmark: marker-40827][bookmark: marker-40829][bookmark: marker-40831][bookmark: marker-40833]

 
     [bookmark: pgfId-40837]Use the Resources page to configure and manage resource-management classes.

 
     [bookmark: pgfId-40839]The table on this page lists all currently defined resource classes. Use the buttons below the table to manage this list:

 
      
      		 [bookmark: pgfId-40844]Add Row – Opens the Add Resource dialog box, where you can define a new class, and assign it to security contexts. See Add and Edit Resource Dialog Boxes for more information.

 
      		 [bookmark: pgfId-40849]Edit Row – For the currently selected row, opens the Edit Resource dialog box, so you can edit that class and its context assignments. See Add and Edit Resource Dialog Boxes for more information.

 
      		 [bookmark: pgfId-40851]Delete Row – Deletes the currently selected row(s); confirmation may be required.

 
     

 
     [bookmark: pgfId-40853]Navigation Path

 
     [bookmark: pgfId-40855]In Device View, select the system context of an ASA or FWSM in multiple-context mode, and then select Platform > Device Admin > Resources from the Device Policy selector.

 
     [bookmark: pgfId-40857]Related Topics

 
      
      		 [bookmark: pgfId-40862]Resource Management on Multi-context FWSMs

 
     

 
    
 
     
      [bookmark: pgfId-40876][bookmark: 114322][bookmark: pxpage_cncpt_AddEditResourceDialogBox]Add and Edit Resource Dialog Boxes [bookmark: marker-40870][bookmark: marker-40872][bookmark: marker-40874]

 
     [bookmark: pgfId-40878]Use the Add Resource and Edit Resource dialog boxes to add or edit resource classes and assignments for FWSM and ASA security contexts.

 
     [bookmark: pgfId-40880]Except for their titles, both dialog boxes are identical; the following descriptions apply to both.

 
     [bookmark: pgfId-40882]Navigation Path

 
     [bookmark: pgfId-40887]You can access the Add Resource and Edit Resource dialog boxes from the Resources Page.

 
     [bookmark: pgfId-40889]Related Topics

 
      
      		 [bookmark: pgfId-40894]Resource Management on Multi-context FWSMs

 
     

 
     [bookmark: pgfId-40896]Field Reference

 
     [bookmark: pgfId-40899] 

 
      
       
        
        [bookmark: pgfId-39702]Table 51-2 [bookmark: 114352]Add and Edit Resource Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-39708]Element
          
  
         		
           
           [bookmark: pgfId-39710]Description
          
  
        

 
         
         		[bookmark: pgfId-39716]Class Name

  
         		[bookmark: pgfId-39718]Enter a name for this class; can be a string of up to 20 alphanumeric characters, and may include any of the following special characters: ` ( ) + - , . / : =.

  
        

 
         
         		 
           
           [bookmark: pgfId-39724]Limits Tab
          
  
        

 
         
         		 box, in which case the value is that percentage of the total resource.

  
        

 
         
         		[bookmark: pgfId-39740]TCP or UDP Connections

  
         		[bookmark: pgfId-39742]Sets a Rate Limit for TCP or UDP connections between any two hosts, including connections between one host and multiple other hosts. You can set the limit as an absolute value by entering an integer between 0 (system limit) and 102400, or you can assign more than 100 percent if you want to oversubscribe the device.

  
        

 
         
         		[bookmark: pgfId-39748]Inspections (Fixups)

  
         		[bookmark: pgfId-39750]Sets a Rate Limit for application inspections. You can set the limit as an absolute value by entering an integer between 0 (system limit) and 10000 per second, or you can assign more than 100 percent if you want to oversubscribe the device.

  
        

 
         
         		[bookmark: pgfId-39756]Syslog Messages

  
         		[bookmark: pgfId-39758]Sets a Rate Limit for system log messages. You can set the limit as an absolute value, or you can assign more than 100 percent if you want to oversubscribe the device.

 [bookmark: pgfId-39760]The FWSM can support 30,000 messages per second for messages sent to the FWSM terminal or buffer. If you send messages to a syslog server, the FWSM supports 25,000 per second.

  
        

 
         
         		[bookmark: pgfId-39766]Connections

  
         		[bookmark: pgfId-39768]Sets the Absolute Limit for concurrent TCP or UDP connections. You can set the limit as an absolute value by entering an integer between 0 (system limit) and 999900, or you can assign more than 100 percent if you want to oversubscribe the device.

 on cisco.com), or you can adjust the connection limit upward to account for the inequity.

  
        

 
         
         		[bookmark: pgfId-39778]Hosts

  
         		[bookmark: pgfId-39780]Sets the limit for concurrent hosts that can connect through the FWSM. You can set the limit as an absolute value by entering an integer between 0 (system limit) and 262144, or you can assign more than 100 percent if you want to oversubscribe the device.

  
        

 
         
         		[bookmark: pgfId-39786]IPsec Sessions

  
         		[bookmark: pgfId-39788]Sets the limit for IPsec sessions. You can set the limit as an absolute value by entering an integer between 1 and 5, or you can assign more than 100 percent if you want to oversubscribe the device. The system allows a maximum of 10 concurrent sessions divided between all contexts.

  
        

 
         
         		[bookmark: pgfId-39794]SSH Sessions

  
         		[bookmark: pgfId-39796]Sets the limit for SSH sessions. You can set the limit as an absolute value by entering an integer between 1 and 5, or you can assign more than 100 percent if you want to oversubscribe the device. The system allows a maximum of 100 concurrent sessions divided between all contexts.

  
        

 
         
         		[bookmark: pgfId-39802]Telnet Sessions

  
         		[bookmark: pgfId-39804]Sets the limit for concurrent Telnet sessions. You can set the limit as an absolute value by entering an integer between 1 and 5, or you can assign more than 100 percent if you want to oversubscribe the device. The system allows a maximum of 100 concurrent sessions divided between all contexts.

  
        

 
         
         		[bookmark: pgfId-39810]NAT Translations

  
         		[bookmark: pgfId-39812]Sets the limit for concurrent address translations. You can set the limit as an absolute value by entering an integer between 0 (system limit) and 266144, or you can assign more than 100 percent if you want to oversubscribe the device.

  
        

 
         
         		[bookmark: pgfId-39818]MAC Address

  
         		[bookmark: pgfId-39820](Transparent mode only) Sets the limit for concurrent MAC address entries allowed in the MAC address table. You can set the limit as an absolute value by entering an integer between 0 (system limit) and 65535, or you can assign more than 100 percent if you want to oversubscribe the device.

  
        

 
         
         		[bookmark: pgfId-39826]ASDM

  
         		[bookmark: pgfId-39828]Sets the limit for ASDM management sessions (the default is 5). You can set the limit as an absolute value by entering an integer between 1 and 5, or you can enter a percentage between 3.0 and 15.0. The system allows a maximum of 80 concurrent sessions divided between all contexts.

 [bookmark: pgfId-39830]ASDM sessions use two HTTPS connections: one for monitoring that is always present, and one for making configuration changes that is present only when you make changes. For example, the system limit of 80 ASDM sessions represents a limit of 160 HTTPS sessions, divided between all contexts.

  
        

 
         
         		[bookmark: pgfId-39836]Other VPN

  
         		[bookmark: pgfId-39838]Sets the limit for Site-to-site VPN sessions. You cannot oversubscribe this resource; all context assignments combined cannot exceed the model limit. The sessions you assign for this resource are guaranteed to the context.

  
        

 
         
         		[bookmark: pgfId-39844]Other VPN Burst

  
         		[bookmark: pgfId-39846]Sets the limit for the number of site-to-site VPN sessions allowed beyond the amount assigned to a context with vpn other. For example, if your model supports 5000 sessions, and you assign 4000 sessions across all contexts with vpn other, then the remaining 1000 sessions are available for other vpn burst. Unlike other vpn, which guarantees the sessions to the context, other vpn burst can be oversubscribed; the burst pool is available to all contexts on a first-come, first-served basis.

  
        

 
         
         		[bookmark: pgfId-39852]All Resources Limit

  
         		[bookmark: pgfId-39854]Sets a limit for all resources. If you also set the limit for a specific resource, then that limit overrides the limit you set here for all resources. You can set the limit as a percentage, or as unlimited by setting the value to 0 (when percent is not checked). You cannot set any other absolute value. You can assign more than 100 percent if you want to oversubscribe the device.

  
        

 
         
         		 
           
           [bookmark: pgfId-39860]Contexts Tab
          
  
        

 
         
         		[bookmark: pgfId-39868]Available Contexts

  
         		[bookmark: pgfId-39870]Lists all contexts available for class assignments; contexts which already have class assignments are not displayed.

 [bookmark: pgfId-39872]Select one or more contexts and click the >> button to add the contexts to the Selected Contexts list.

  
        

 
         
         		[bookmark: pgfId-39878]Selected Contexts

  
         		[bookmark: pgfId-39880]Lists all contexts assigned to this class.

 [bookmark: pgfId-39882]Select one or more contexts and click the << button to return the contexts to the Available Contexts list.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-40915][bookmark: 114477][bookmark: pxchap_proc_ConfiguringUserAccounts]Configuring User Accounts [bookmark: marker-40907][bookmark: marker-40909][bookmark: marker-40911][bookmark: marker-40913]

 
    [bookmark: pgfId-40920]The User Accounts page lets you manage the Local user database. User accounts in the Local database can be used in conjunction with the Authentication, Authorization, Accounting (AAA) functions to determine “who is allowed to do what” on a device. Refer to About AAA on Security Devices for more information.

 
    [bookmark: pgfId-40925]The table on this page lists all currently defined Local user accounts, showing for each, the name of the user and the assigned privilege level. For a detailed explanation of these fields, see Add/Edit User Account Dialog Boxes.

 
     
     		 [bookmark: pgfId-40927]To add a user account, click the Add Row button.

 
     		 [bookmark: pgfId-40929]To edit the settings for an account, select it and click the Edit Row button.

 
     		 [bookmark: pgfId-40931]To delete a user account, select it and click the Delete Row button.

 
    

 
    [bookmark: pgfId-40933]Navigation Path

 
     
     		 [bookmark: pgfId-40935](Device view) Select  Platform > Device Admin > User Accounts from the Device Policy selector.

 
     		 [bookmark: pgfId-40937](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > User Accounts from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-40939]Related Topics

 
     
     		 [bookmark: pgfId-40944]Local Database

 
     		 [bookmark: pgfId-40949]Preparing for AAA

 
    

 
     
      [bookmark: pgfId-40967][bookmark: 114524][bookmark: pxpage_cncpt_AddEditUserAccountDialogBox]Add/Edit User Account Dialog Boxes [bookmark: marker-40959][bookmark: marker-40961][bookmark: marker-40963][bookmark: marker-40965]

 
     [bookmark: pgfId-40969]Use the Add and Edit User Account dialog boxes to add a local user account or to modify an existing user account.

 
     [bookmark: pgfId-40971]Navigation Path

 
     [bookmark: pgfId-40976]You can access the Add and Edit User Account dialog boxes from the User Accounts page, as described in Configuring User Accounts.

 
     [bookmark: pgfId-40978]Field Reference

 
     [bookmark: pgfId-40981] 

 
      
       
        
        [bookmark: pgfId-39895]Table 51-3 [bookmark: 114552]Add/Edit User Account Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-39901]Element
          
  
         		
           
           [bookmark: pgfId-39903]Description
          
  
        

 
         
         		[bookmark: pgfId-39909]Username

  
         		[bookmark: pgfId-39911]Enter a name for this user account: must be at least four characters; the maximum is 64 characters. Entries are case-sensitive.

  
        

 
         
         		[bookmark: pgfId-39917]Password

  
         		[bookmark: pgfId-39919]Enter a unique password for this user account: must be at least three characters; the maximum is 32 characters. Entries are case-sensitive.

 [bookmark: pgfId-39921]Note To protect security, we recommend a password length of at least 8 characters.

  
        

 
         
         		[bookmark: pgfId-39927]Confirm

  
         		[bookmark: pgfId-39929]Re-enter the user password to confirm it.

  
        

 
         
         		[bookmark: pgfId-39935]Privilege Level

  
         		[bookmark: pgfId-39937]Choose a privilege level for this user; defines local command authorization. The range is 0 (lowest) to 15 (highest). The default privilege level is 2.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-40997][bookmark: 114585][bookmark: obman_cncpt_UnderstandingSLAMonitorObjects]Monitoring Service Level Agreements (SLAs) To Maintain Connectivity [bookmark: marker-40987][bookmark: marker-40989][bookmark: marker-40991][bookmark: marker-40993][bookmark: marker-40995]

 
    [bookmark: pgfId-40999]You can configure ASA or PIX devices that run version 7.2 or higher to perform route tracking by monitoring service level agreements. By monitoring the connectivity to a device on another network, you can track the availability of a primary route and install a backup route if the primary route fails. For example, you can define a default route to an Internet service provider (ISP) gateway and a backup default route to a secondary ISP in case the primary ISP becomes unavailable. This technique, called Dual ISP, provides security appliances with a form of high availability, which is a vital part of providing customers with the services to which they are entitled.

 
    [bookmark: pgfId-41001]Without route tracking, there is no inherent mechanism for determining if the route is up or down. A static route remains in the routing table even if the next hop gateway becomes unavailable, and is removed only if the associated interface on the security appliance goes down.

 
    [bookmark: pgfId-41003]The security appliance performs route tracking by associating a route with a monitoring target that you define in an SLA monitor policy object. It monitors the target using ICMP echo requests, according to the parameters configured in the object. If an echo reply is not received within a specified time period, the SLA monitor is considered down and the associated route is removed from the routing table. A previously configured backup route is used in place of the removed route.

 
    [bookmark: pgfId-41005]SLA monitoring jobs start immediately after deployment and continue to run unless you remove the SLA monitor from the device configuration (that is, they do not age out).

 
    [bookmark: pgfId-41007]Related Topics

 
     
     		 [bookmark: pgfId-41012]Configuring Static Routes

 
     		 [bookmark: pgfId-41017]Configuring Firewall Device Interfaces

 
     		 [bookmark: pgfId-41022]Creating Policy Objects

 
    

 
    [bookmark: pgfId-41024]This section contains the following topics:

 
     
     		 [bookmark: pgfId-41029]Creating Service Level Agreements

 
    

 
     
      [bookmark: pgfId-41041][bookmark: 114620][bookmark: obman_proc_CreatingSLAMonitorObjects]Creating Service Level Agreements [bookmark: marker-41035][bookmark: marker-41037][bookmark: marker-41039]

 
     [bookmark: pgfId-41043]The following procedure explains how to configure SLA monitor objects and associate them with routes and interfaces in an ASA or PIX configuration.

 
     [bookmark: pgfId-41045]Related Topics

 
      
      		 [bookmark: pgfId-41050]Monitoring Service Level Agreements (SLAs) To Maintain Connectivity

 
      		 [bookmark: pgfId-41055]Configuring Static Routes

 
      		 [bookmark: pgfId-41060]Configuring Firewall Device Interfaces

 
      		 [bookmark: pgfId-41065]Creating Policy Objects

 
     

 
     
 
     [bookmark: pgfId-41067]Step 1 Create the SLA monitor policy object:

 
     [bookmark: pgfId-41072] a. Select Manage > Policy Objects to open the Policy Object Manager (see Policy Object Manager) and select SLA Monitors from the table of contents.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-41077]Tip You can also create SLA monitor objects when defining policies that use this object type. For more information, see Selecting Objects for Policies.


     
      

     

     

 
     [bookmark: pgfId-41082] b. Right-click in the work area and select New Object to open the Add SLA Monitor dialog box. For more information, see Configuring SLA Monitor Objects.

 
     [bookmark: pgfId-41084] c. The monitoring options are appropriate for most connections, so you need only configure the following:

 
      
      		 [bookmark: pgfId-41086]Name—The name of the object.

 
      		 [bookmark: pgfId-41088]SLA Monitor ID—An identifying number for the monitoring process. The number must be unique within a device configuration.

 
      		 [bookmark: pgfId-41090]Monitored Address—The address that you are monitoring. When you select a monitoring target, make sure that it can respond to ICMP echo requests (pings). The target can be any network address that you choose, but consider the use of:

 
      		 [bookmark: pgfId-41092]The ISP gateway address.

 
      		 [bookmark: pgfId-41094]The next hop gateway address (if you are concerned about the availability of the ISP gateway).

 
      		 [bookmark: pgfId-41096]A server on the target network, such as an AAA server, with which the security appliance needs to communicate.

 
      		 [bookmark: pgfId-41098]A persistent network device on the destination network. (A desktop or notebook computer that gets shut down at night is not a good choice.)

 
      		 [bookmark: pgfId-41100]Interface—The interface name, or interface role that identifies an interface, that will be the source of the ICMP messages. The device pings the monitored address from this interface’s IP address.

 
     

 
     [bookmark: pgfId-41102] d. Click OK to save the object.

 
     [bookmark: pgfId-41104]Step 2 Configure ASA/PIX policies to use the object to monitor routes. You can configure the following policies to monitor SLAs:

 
      
      		 [bookmark: pgfId-41112] Platform > Routing > Static Route —When you define a static route, you can select an SLA monitor object to do route tracking for the route. For more information, see Configuring Static Routes and Add/Edit Static Route Dialog Box.

 
      		 [bookmark: pgfId-41117] Interfaces —When you define an interface that uses DHCP or PPPoE, you can configure the DHCP or PPPoE learned default routes to be tracked. For more information, see Device Interface: IP Type (PIX/ASA 7.0+).

 
     

 
     [bookmark: pgfId-41119]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-41137][bookmark: 114701][bookmark: pobjpage_cncpt_SLAMonitorDialogBox]Configuring SLA Monitor Objects[bookmark: marker-41127][bookmark: marker-41129][bookmark: marker-41131][bookmark: marker-41133][bookmark: marker-41135]

 
     [bookmark: pgfId-41139]Use the Add or Edit SLA (Service Level Agreement) Monitor dialog box to create, edit, and copy SLA monitor objects. Each SLA monitor defines a connectivity policy to a monitored address and tracks the availability of a route to the address. The route is periodically checked for availability by sending ICMP echo requests and waiting for the response. If the requests time out, the route is removed from the routing table and replaced with a backup route.

 
     [bookmark: pgfId-41141]You can configure SLA monitors only for security appliances running PIX/ASA version 7.2 or higher. SLA monitoring jobs start immediately after deployment and continue to run unless you remove the SLA monitor from the device configuration (that is, they do not age out).

 
     [bookmark: pgfId-41146]For more information about configuring and using SLA monitor objects, see Monitoring Service Level Agreements (SLAs) To Maintain Connectivity.

 
     [bookmark: pgfId-41148]Navigation Path

 
     [bookmark: pgfId-41150]Select Manage > Policy Objects, then select SLA Monitors from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-41152]Related Topics

 
      
      		 [bookmark: pgfId-41157]Monitoring Service Level Agreements (SLAs) To Maintain Connectivity

 
      		 [bookmark: pgfId-41162]Policy Object Manager

 
     

 
     [bookmark: pgfId-41164]Field Reference

 
     [bookmark: pgfId-41167] 

 
      
       
        
        [bookmark: pgfId-39950]Table 51-4 [bookmark: 114743]SLA Monitor Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-39956]Element
          
  
         		
           
           [bookmark: pgfId-39958]Description
          
  
        

 
         
         		[bookmark: pgfId-39964]Name

  
         		[bookmark: pgfId-39969]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
        

 
         
         		[bookmark: pgfId-39975]Description

  
         		[bookmark: pgfId-39977]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-39983]SLA Monitor ID

  
         		[bookmark: pgfId-39985]The ID number of the SLA operation. Values range from 1 to 2147483647. You can create a maximum of 2000 SLA operations on a device. Each ID number must be unique to the policy and the device configuration.

  
        

 
         
         		[bookmark: pgfId-39991]Monitored Address

  
         		[bookmark: pgfId-39996]The IP address that is being monitored for availability by the SLA operation. For recommendations on selecting an address to monitor, see Monitoring Service Level Agreements (SLAs) To Maintain Connectivity.

  
        

 
         
         		[bookmark: pgfId-40002]Interface

  
         		[bookmark: pgfId-40004]The source interface for all ICMP echo requests sent to the monitored address to test its availability. Enter the name of an interface or interface role, or click Select to select an it from a list or to create a new interface role.

  
        

 
         
         		[bookmark: pgfId-40010]Frequency

  
         		[bookmark: pgfId-40012]The frequency of ICMP echo request transmissions, in seconds. Values range from 1 to 604800 seconds (7 days). The default is 60 seconds.

 [bookmark: pgfId-40014]Note The frequency cannot be less than the timeout value; you must convert frequency to milliseconds to compare the values.

  
        

 
         
         		[bookmark: pgfId-40020]Threshold

  
         		[bookmark: pgfId-40022]The amount of time that must pass after an ICMP echo request before a rising threshold is declared, in milliseconds. Values range from 0 to 2147483647 milliseconds. The default is 5000 milliseconds.

 [bookmark: pgfId-40024]The threshold value is used only to indicate events that exceed the defined value. You can use these events to evaluate the proper timeout value. It is not a direct indicator of the reachability of the monitored address.

 [bookmark: pgfId-40026]Note The threshold value should not exceed the timeout value.

  
        

 
         
         		[bookmark: pgfId-40032]Time out

  
         		[bookmark: pgfId-40034]The amount of time that the SLA operation waits for a response to the ICMP echo requests, in milliseconds. Values range from 0 to 604800000 milliseconds (7 days). The default is 5000 milliseconds.

 [bookmark: pgfId-40036]If a response is not received from the monitored address within the amount of time defined in this field, the static route is removed from the routing table and replaced by the backup route.

 [bookmark: pgfId-40038]Note The timeout value cannot exceed the frequency value (adjust the frequency value to milliseconds to compare the numbers).

  
        

 
         
         		[bookmark: pgfId-40044]Request Data Size

  
         		[bookmark: pgfId-40046]The size of the ICMP request packet payload, in bytes. Values range from 0 to 16384 bytes. The default is 28 bytes, which creates a total ICMP packet of 64 bytes. Do not set this value higher than the maximum allowed by the protocol or the Path Maximum Transmission Unit (PMTU).

 [bookmark: pgfId-40048]For purposes of reachability, you might need to increase the default data size to detect PMTU changes between the source and the target. A low PMTU can affect session performance and, if detected, might indicate that the secondary path should be used.

  
        

 
         
         		[bookmark: pgfId-40054]ToS

  
         		[bookmark: pgfId-40056]The type of service (ToS) defined in the IP header of the ICMP request packet. Values range from 0 to 255. The default is 0.

 [bookmark: pgfId-40058]This field contains information such as delay, precedence, reliability, and so on. It can be used by other devices on the network for policy routing and features such as committed access rate.

  
        

 
         
         		[bookmark: pgfId-40064]Number of Packets

  
         		[bookmark: pgfId-40066]The number of packets that are sent. Values range from 1 to 100. The default is 1 packet.

 [bookmark: pgfId-40068]Tip Increase the default number of packets if you are concerned that packet loss might falsely cause the security appliance to believe that the monitored address cannot be reached.  
        

 
         
         		[bookmark: pgfId-40074]Category

  
         		[bookmark: pgfId-40079]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.
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     [bookmark: pgfId-57404][bookmark: 23569][bookmark: dpman_cncpt_ManagingDeployment]Managing Deployment[bookmark: marker-57402]
      
      
 
     
 

 
    [bookmark: pgfId-57406]The settings and policies you define in Security Manager must be deployed to your devices so that you can implement them in your network. The steps you take to deploy configurations to devices depend on whether you are using Workflow mode or non-Workflow mode.

 
    [bookmark: pgfId-57411]Although non-Workflow mode is the default mode of operation for Security Manager, you can use Workflow mode if your company requires it. For more information, see Workflow and Activities Overview.

 
    [bookmark: pgfId-57413]The following topics provide information about deploying configurations to devices, in each workflow mode:

 
     
     		 [bookmark: pgfId-57418]Understanding Deployment

 
     		 [bookmark: pgfId-57423]Working with Deployment and the Configuration Archive

 
     		 [bookmark: pgfId-57428]Rolling Back Configurations

 
    

 
   
 
    
     [bookmark: pgfId-57436][bookmark: 23588][bookmark: dpman_cncpt_UnderstandingDeployment]Understanding Deployment[bookmark: marker-57434]

 
    [bookmark: pgfId-57438]A deployment job defines how configuration changes are sent to devices. In a deployment job, you can define several parameters, such as the devices to which you want to deploy configurations and the method used to deploy configurations to devices. You can also create deployment schedules to automatically spawn deployment jobs at regular intervals.

 
    [bookmark: pgfId-57440]The following topics will help you better understand and use deployment jobs:

 
     
     		 [bookmark: pgfId-57445]Overview of the Deployment Process

 
     		 [bookmark: pgfId-57450]Deployment in Non-Workflow Mode

 
     		 [bookmark: pgfId-57455]Deployment in Workflow Mode

 
     		 [bookmark: pgfId-57460]Including Devices in Deployment Jobs or Schedules

 
     		 [bookmark: pgfId-57465]Understanding Deployment Methods

 
     		 [bookmark: pgfId-57470]Handling Device OS Version Mismatches

 
    

 
     
      [bookmark: pgfId-57480][bookmark: 23614][bookmark: dpman_cncpt_OverviewoftheDeploymentProcess]Overview of the Deployment Process [bookmark: marker-57476][bookmark: marker-57478]

 
     [bookmark: pgfId-57482]Broadly speaking, deployment is a three-step process, as described in the following table.

 
     [bookmark: pgfId-57485] 

 
      
       
        
        [bookmark: pgfId-54576]Table 8-1 [bookmark: 23624]Overview of the Deployment Process 

 
        
       
         
         		
           
           [bookmark: pgfId-54582]Steps
          
  
         		
           
           [bookmark: pgfId-54584]Deployment Steps
          
  
        

 
         
         		[bookmark: pgfId-54590]Step 1

  
         		[bookmark: pgfId-54592]Security Manager obtains the current configuration for the device and compares it to the latest saved policies for the device in Security Manager. What Security Manager considers to be the current configuration depends on the type of device, the deployment method, and the settings for deployment preferences. These are the possible sources and the conditions under which they are used:

 
           
           		 [bookmark: pgfId-54594]Obtain the running configuration from the device.

 
          

 [bookmark: pgfId-54596]The running configuration is used when deploying to the device unless the deployment method is AUS, TMS, or CNS. You can force Security Manager to use Configuration Archive by selecting When Deploying to Device Get Reference Config from: Config Archive as the deployment preference (select Tools > Security Manager Administration, then select Deployment).

 
           
           		 [bookmark: pgfId-54598]Obtain the last full configuration from the Security Manager Configuration Archive. The Configuration Archive is used when:

 
          

 [bookmark: pgfId-54600] – Deploying to file, unless you select When Deploying to File Get Reference Config from: Device as the deployment preference.

 [bookmark: pgfId-54602] – The deployment method is TMS or CNS.

 [bookmark: pgfId-54604] – The device is not managed by Security Manager.

 [bookmark: pgfId-54606] – Deploying to a device if uploading the configuration from the device failed. Configuration Archive is used as a backup to obtaining the configuration from the live device.

 [bookmark: pgfId-54608] – You preview configurations.

 
           
           		 [bookmark: pgfId-54610]Use the factory default configuration.

 
          

 [bookmark: pgfId-54612]The factory default configuration is used with PIX or ASA devices if you use the AUS deployment method. It is used for deployment and for configuration preview.

  
        

 
         
         		[bookmark: pgfId-54618]Step 2

  
         		[bookmark: pgfId-54620]Security Manager builds a delta configuration that contains the commands needed to update the device configuration to make it consistent with the assigned policies. It also builds a full device configuration.

  
        

 
         
         		[bookmark: pgfId-54626]Step 3

  
         		[bookmark: pgfId-54628]If you are deploying to the device, Security Manager deploys either the delta configuration or the full configuration, depending on which deployment method you use. If you are deploying to file, Security Manager creates two files: device_name_delta.cfg for the delta configuration, and device_name_full.cfg for the full configuration. In both cases, the configurations are also added to Configuration Archive. These are the actions based on deployment method:

 
           
           		 [bookmark: pgfId-54630]SSL (HTTPS), SSH, or Telnet—Security Manager contacts the device directly and sends the delta configuration to it.

 
           		 [bookmark: pgfId-54632]Auto Update Server (standalone or running on Configuration Engine) for PIX and ASA devices—Security Manager sends the full configuration to Auto Update Server, where the device retrieves it. The delta configuration is not sent.

 
           		 [bookmark: pgfId-54634]Configuration Engine for IOS devices—Security Manager sends the delta configuration to Configuration Engine, where the device retrieves it.

 
           		 [bookmark: pgfId-54636]TMS—Security Manager sends the delta configuration to the TMS server, from which it can be downloaded to an eToken to be loaded onto the device.

 
          

  
        

 
       
      

 
     
 
     [bookmark: pgfId-57487]During deployment, if Security Manager determines that the configuration on the device differs from the last-deployed configuration, Security Manager overwrites the changes by default. You can control this behavior using the deployment preferences; select Tools > Security Manager Administration, then select Deployment, and look for the When Out of Band Changes Detected setting. You can also control this for a specific deployment job by editing the deployment method for the job.

 
     [bookmark: pgfId-57489]If you make changes to the device configuration outside of Security Manager, you have two choices for bringing those changes into Security Manager:

 
     [bookmark: pgfId-57491] 1. You can rediscover policies on the device, in which case all policies for the device become local policies, and any assignments of shared policies to the device are removed.

 
     [bookmark: pgfId-57493] 2. You can make the required changes in Security Manager and redeploy them to the device. During deployment, do not select the option to force an error if out-of-band changes are found on the device. This is the recommended approach.

 
     [bookmark: pgfId-57498]For more information on how out-of-band changes affect deployment, see Understanding How Out-of-Band Changes are Handled.

 
     [bookmark: pgfId-57500]After configurations are deployed, you should make changes only through Security Manager for configurations that Security Manager controls. This varies based on operating system. For IPS devices, Security Manager controls the entire configuration. For IOS, ASA, PIX, and FWSM devices, you have more control over which aspects of the device configuration Security Manager controls. If you do not create policies for a feature in Security Manager, such as routing policies, Security Manager does not control those features on the device. If you do create policies for these features, Security Manager overwrites the settings on the device with the settings you defined in Security Manager. Through administration settings, you can control the types of policies that will be available for these devices, thereby preventing Security Manager from displaying or changing policies for these features. To see the available features and control whether they are available for management in Security Manager, select Tools > Security Manager Administration, then select Policy Management. Security Manager does manage VPN-related policies.

 
     [bookmark: pgfId-57502]Related Topics

 
      
      		 [bookmark: pgfId-57507]Deployment in Non-Workflow Mode

 
      		 [bookmark: pgfId-57512]Deployment in Workflow Mode

 
      		 [bookmark: pgfId-57517]Deployment Page

 
      		 [bookmark: pgfId-57522]Policy Management Page

 
     

 
    
 
     
      [bookmark: pgfId-57532][bookmark: 23722][bookmark: dpman_cncpt_DeploymentinNonWorkflowMode]Deployment in Non-Workflow Mode[bookmark: marker-57528][bookmark: marker-57530]

 
     [bookmark: pgfId-57534]These topics help you understand deployment in non-Workflow mode:

 
      
      		 [bookmark: pgfId-57539]Deployment Task Flow in Non-Workflow Mode

 
      		 [bookmark: pgfId-57544]Job States in Non-Workflow Mode

 
     

 
    
 
     
      [bookmark: pgfId-57554][bookmark: 23738][bookmark: dpman_cncpt_DeploymentTaskFlowinNonWorkflowMode]Deployment Task Flow in Non-Workflow Mode[bookmark: marker-57550][bookmark: marker-57552]

 
     [bookmark: pgfId-57556]The deployment task flow in non-Workflow mode consists of three simple steps:

 
     [bookmark: pgfId-57558] 1. Create the job: A deployment job is created for you when you do one of the following:

 
     [bookmark: pgfId-57560] – Click the Submit and Deploy Changes button on the main toolbar, or select File > Submit and Deploy.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-57562]Note These options are not available when Ticket Management is enabled.


     
      

     

     

 
     [bookmark: pgfId-57564] – Select File > Deploy.

 
     [bookmark: pgfId-57566] – Select Manage > Deployments and click Deploy.

 
     [bookmark: pgfId-57568] 

 
     [bookmark: pgfId-57570] 2. Define the job: You specify parameters, such as the devices to which you want to deploy the configurations and whether you want to deploy directly to the devices or to a file.

 
     [bookmark: pgfId-57572]During this step, you can also preview configurations and compare them to the previously deployed configurations or the configuration currently running on the device.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-57574]Note Devices selected for one job cannot be included in any other job. This measure ensures that the order in which policies are deployed is correct. However, you can include devices that are specified in deployment schedules.


     
      

     

     

 
     [bookmark: pgfId-57579] 3. Deploy the job: Deploying the job sends the generated CLI to devices, either directly or through an intermediary transport server (such as AUS, CNS, or TMS) or to output files. You select the destination (device or file) when defining a job. The transport server is specified in the device properties. For more details about defining deployment methods and transport servers, see Understanding Deployment Methods.

 
    
 
     
      [bookmark: pgfId-57587][bookmark: 23778][bookmark: dpman_cncpt_JobStatesinNonWorkflowMode]Job States in Non-Workflow Mode[bookmark: marker-57585]

 
      
       
        
        [bookmark: pgfId-54649]Table 8-2 [bookmark: 23787]Job States in Non-Workflow Mode 

 
        
       
         
         		
           
           [bookmark: pgfId-54655]State
          
  
         		
           
           [bookmark: pgfId-54657]Description
          
  
        

 
         
         		[bookmark: pgfId-54663]Deployed

  
         		[bookmark: pgfId-54665]Configurations for all the devices in the job were successfully deployed to the devices or to configuration files. Devices in the job can now be included in another job.

  
        

 
         
         		[bookmark: pgfId-54671]Deploying

  
         		[bookmark: pgfId-54673]Configurations generated for the job are being deployed to the devices or to a directory on the Security Manager server. You can monitor the job progress in the Deployment Manager window if the Deployment Status window is not already open.

  
        

 
         
         		[bookmark: pgfId-54679]Aborted

  
         		[bookmark: pgfId-54681]The job was manually halted. Devices in the job can now be included in another job.

  
        

 
         
         		[bookmark: pgfId-54687]Failed

  
         		[bookmark: pgfId-54689]The deployment to one or more devices in the job failed. Devices in the job can now be included in another job.

  
        

 
         
         		[bookmark: pgfId-54695]Rolling Back

  
         		[bookmark: pgfId-54697]Security Manager is in the process of reverting to and deploying previous configurations for the devices within the deployment job. You can abort a job that is in the Rolling Back state.

  
        

 
         
         		[bookmark: pgfId-54703]Rolled Back

  
         		[bookmark: pgfId-54705]Security Manager has successfully reverted to and deployed previous configurations for the devices within the deployment job.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-57603][bookmark: 23829][bookmark: dpman_cncpt_DeploymentinWorkflowMode]Deployment in Workflow Mode[bookmark: marker-57601]

 
     [bookmark: pgfId-57605]These topics help you understand deployment in Workflow mode:

 
      
      		 [bookmark: pgfId-57610]Deployment Task Flow in Workflow Mode

 
      		 [bookmark: pgfId-57615]Job States in Workflow Mode

 
      		 [bookmark: pgfId-57620]Deployment Job Approval

 
      		 [bookmark: pgfId-57625]Deployment Jobs and Multiple Users

 
     

 
    
 
     
      [bookmark: pgfId-57635][bookmark: 23848][bookmark: dpman_cncpt_DeploymentTaskFlowinWorkflowMode]Deployment Task Flow in Workflow Mode[bookmark: marker-57631][bookmark: marker-57633]

 
     [bookmark: pgfId-57640]The following is a typical task flow in Workflow mode (see Figure 8-1):

 
     [bookmark: pgfId-57642] 1. Create the job: Before you deploy configurations to your devices, you must create a deployment job.

 
     [bookmark: pgfId-57644] 2. Define the job: When you create a job, you specify parameters, such as the devices to which you want to deploy the configurations, whether you want to deploy directly to the devices or to a file, and when you want the job to take place.

 
     [bookmark: pgfId-57646] 3. Submit the job: In some organizations, before jobs can be deployed, they must be approved by a separate user with the appropriate permissions. In this case, Workflow mode is enabled with a deployment job approver, and you must submit the job to this user for review. The user reviews the job and either approves or rejects it.

 
     [bookmark: pgfId-57648] 4. Approve or reject the job: If you are working in Workflow mode with a deployment job approver, the approver reviews it, and can then either approve or reject the job. If the job is approved, the submitter can then deploy the job. If the job is rejected, the submitter can discard the job and start over or modify the job and resubmit it.

 
     [bookmark: pgfId-57650]If you are working in workflow mode without an approver, you can approve the job yourself.

 
     [bookmark: pgfId-57655] 5. Deploy the job: Deploying the job sends the generated CLI to either devices, intermediary transport servers (such as AUS, CNS, or TMS), or files. You select the destination (device or file) when defining the job. The transport server is specified in the device properties. For more details about defining deployment methods and transport servers, see Understanding Deployment Methods.

 
     [bookmark: pgfId-57663]For descriptions of job states (shown in red in Figure 8-1), see Job States in Workflow Mode.

 
     [bookmark: pgfId-57667]Figure 8-1 [bookmark: 23882]Deployment Task Flow in Workflow Mode

 
     [bookmark: pgfId-57670] 

 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-57682][bookmark: 23886][bookmark: dpman_cncpt_JobStatesinWorkflowMode]Job States in Workflow Mode[bookmark: marker-57676][bookmark: marker-57678][bookmark: marker-57680]

 
      
       
        
        [bookmark: pgfId-54718]Table 8-3 [bookmark: 23903]Job States in Workflow Mode 

 
        
       
         
         		
           
           [bookmark: pgfId-54724]State
          
  
         		
           
           [bookmark: pgfId-54726]Description
          
  
        

 
         
         		[bookmark: pgfId-54732]Edit

  
         		[bookmark: pgfId-54734]The job was created, but it is not currently being edited. The job can be opened, approved (in auto-approval mode), or discarded while it is in the Edit state.

  
        

 
         
         		[bookmark: pgfId-54740]Edit-In Use

  
         		[bookmark: pgfId-54742]The job is open for editing. The job can be closed, approved, discarded, or submitted while it is in the Edit Open state.

  
        

 
         
         		[bookmark: pgfId-54748]Submitted

  
         		[bookmark: pgfId-54750]The job was submitted for review. It can be viewed but not edited while it is in the Submitted state. The job can be opened for viewing, discarded, rejected, or approved while it is in the Submitted state. This state occurs only when Workflow mode is enabled with deployment job approval required.

  
        

 
         
         		[bookmark: pgfId-54756]Approved

  
         		[bookmark: pgfId-54758]The job was approved and is ready to be deployed. The job can be deployed while it is in the Approved state.

  
        

 
         
         		[bookmark: pgfId-54764]Rejected

  
         		[bookmark: pgfId-54766]The job was rejected. You can open the job for editing or discard the job while it is in the Rejected state. This state occurs only when Workflow mode is enabled with deployment job approval required.

  
        

 
         
         		[bookmark: pgfId-54772]Discarded

  
         		[bookmark: pgfId-54774]The job was discarded. No further changes to the job are not allowed. The job remains in the Deployment table showing a Discarded state until it is purged from the system. Devices in the job can be included in another job.

  
        

 
         
         		[bookmark: pgfId-54780]Deployed

  
         		[bookmark: pgfId-54782]Configurations for all the devices in the job were successfully deployed to the devices or to configuration files. Devices in the job can now be included in another job.

  
        

 
         
         		[bookmark: pgfId-54788]Deploying

  
         		[bookmark: pgfId-54790]Configurations generated for the job are being deployed to the devices or to a directory on the Security Manager server. You can monitor the job progress in the Deployment Manager window.

  
        

 
         
         		[bookmark: pgfId-54796]Aborted

  
         		[bookmark: pgfId-54798]The job was manually halted. Devices in the job can now be included in another job.

  
        

 
         
         		[bookmark: pgfId-54804]Failed

  
         		[bookmark: pgfId-54806]The deployment to one or more devices in the job failed. Devices in the job can now be included in another job.

  
        

 
         
         		[bookmark: pgfId-54812]Scheduled to run at [date]

  
         		[bookmark: pgfId-54814]The job is scheduled to be deployed at the date and time specified.

  
        

 
         
         		[bookmark: pgfId-54820]Rolling Back

  
         		[bookmark: pgfId-54822]Security Manager is in the process of reverting to and deploying previous configurations for the devices within the deployment job. You can abort a job that is in the Rolling Back state.

  
        

 
         
         		[bookmark: pgfId-54828]Rolled Back

  
         		[bookmark: pgfId-54830]Security Manager has successfully reverted to and deployed previous configurations for the devices within the deployment job.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-57698][bookmark: 23979][bookmark: dpman_cncpt_DeploymentJobApproval]Deployment Job Approval[bookmark: marker-57696]

 
     [bookmark: pgfId-57700]By default, Security Manager operates in non-Workflow mode; deployment jobs are handled behind the scenes and the user does not need to be aware of jobs or their approval. When using Workflow mode, you can choose to operate with or without a deployment job approver.

 
     [bookmark: pgfId-57702]If you choose to operate without an approver, you have the permissions to define and approve jobs.

 
     [bookmark: pgfId-57704]If your organization requires a different person with higher permissions to approve deployment of new or changed configurations to devices, use Workflow mode with a deployment job approver. When using Workflow mode with a deployment job approver, the job must be reviewed by a person with the appropriate permissions to approve or reject the job. This approval process helps to ensure that no inappropriate configurations reach the network devices and that deployment jobs are scheduled effectively.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-57709]Note You enable and disable deployment job approval under Tools > Security Manager Administration > Workflow. For more information, see Workflow Page.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-57717][bookmark: 23990][bookmark: dpman_cncpt_DeploymentJobsandMultipleUsers]Deployment Jobs and Multiple Users[bookmark: marker-57715]

 
     [bookmark: pgfId-57719]Only one user can define or change parameters or devices within an individual deployment job at one time. However, multiple users can work on the same deployment job in sequence: if a deployment job is closed, another user can open it and make changes to it. Multiple users can work in parallel on different deployment jobs.

 
    
 
     
      [bookmark: pgfId-57733][bookmark: 23998][bookmark: dpman_cncpt_IncludingDevicesinDeploymentJobs]Including Devices in Deployment Jobs or Schedules[bookmark: marker-57725][bookmark: marker-57727][bookmark: marker-57729][bookmark: marker-57731]

 
     [bookmark: pgfId-57735]When you create a deployment job or schedule, you select the devices to include in it. The inclusion of a device influences how the device can be used in other jobs or schedules. When you select a device for a specific job, it cannot be selected for any other job until the original job is deployed, rejected (in Workflow mode), discarded, or aborted. This mechanism prevents two or more people from deploying changes to the same device at the same time and ensures that policies are deployed to devices in the correct order.

 
     [bookmark: pgfId-57737]However, a device can be part of a deployment schedule and still be selected for specific deployment jobs. While a deployment job is running, the device is locked. The device cannot be included in other jobs while the deployment job is running.

 
     [bookmark: pgfId-57739]When you create a deployment job, Security Manager displays the devices on which policy changes were made but were not yet deployed. You can deploy to these devices, and you can select additional devices for the job. Although you can add as many devices to a deployment job as you desire (there is no limitation), as a practical matter, you should limit the number of devices per job. The deployment job might fail if you select a large number of devices or several devices that have large configuration files. If you encounter deployment failures, resubmit the job with fewer devices selected.

 
     [bookmark: pgfId-57741]For VPNs, Security Manager must generate commands for devices that are affected by the policies defined for the devices you select for the job. So, if you select a device that is part of a VPN, Security Manager adds the other relevant devices to the job. For example, if you define a tunnel policy on a spoke, and you select the spoke for the job, Security Manager adds the spoke’s assigned hub to the job. During job generation, Security Manager generates commands for both peers so that the VPN configuration is complete and the tunnel can be established. If you deselect one of the devices associated with the VPN, Security Manager warns that removing the device might result in the VPN not functioning property.

 
    
 
     
      [bookmark: pgfId-57751][bookmark: 24017][bookmark: dpman_cncpt_UnderstandingDeploymentMethods]Understanding Deployment Methods[bookmark: marker-57747][bookmark: marker-57749]

 
     [bookmark: pgfId-57753]Security Manager lets you deploy configurations to devices using three main methods: deploying directly to the device, deploying to a configuration file (which you must then manually apply to the device), and deploying to an intermediate server (which is treated like deploying directly to the device). The system default deployment method is to deploy directly to the device.

 
     [bookmark: pgfId-57764]When you add devices to Security Manager, you select the deployment method to be used by that device. This determines the method used for deploying to the device (instead of a file). When you create a deployment job, an additional deployment method default applies to the job as a whole, which determines whether deployment creates configuration files or whether it sends the configuration to the device using the method selected for the device. You control this default in the administration settings (select Tools > Security Manager Administration, then select Deployment; see Deployment Page). When you create a deployment job, you can also change whether the deployment is to a file or to the device for each device by clicking Edit Deploy Method in the Create Job window. If you are using non-Workflow mode, see Deploying Configurations in Non-Workflow Mode. If you are using Workflow mode, see Creating and Editing Deployment Jobs.

 
     [bookmark: pgfId-57766]The method you choose to use depends on the processes and procedures of your organization and the transport protocols supported by a particular type of device. If you are using Configuration Engine (CNS) or Auto Update Server (AUS), use those deployment methods. You must use one of these for devices that use dynamic IP addresses. Otherwise, for devices with static IP addresses, use SSL (HTTPS) for IOS, PIX, ASA, IPS, and standalone FWSM devices, and SSH for FWSM through the Catalyst chassis. If you are using a Token Management Server (TMS) for some devices, you can also use that method with Security Manager.

 
     [bookmark: pgfId-57768]The following topics describe the deployment methods in more detail:

 
      
      		 [bookmark: pgfId-57773]Deploying Directly to a Device

 
      		 [bookmark: pgfId-57778]Deploying to a Device through an Intermediate Server

 
      		 [bookmark: pgfId-57783]Deploying to a File

 
      		 [bookmark: pgfId-57788]Understanding How Out-of-Band Changes are Handled

 
     

 
    
 
     
      [bookmark: pgfId-57800][bookmark: 24048][bookmark: dpman_cncpt_DeployingtoaDevice]Deploying Directly to a Device[bookmark: marker-57796][bookmark: marker-57798]

 
     [bookmark: pgfId-57808]If you choose to deploy directly to a device, Security Manager uses the transport protocol defined in the device properties for the device (right click the device, select Device Properties, and click General). The protocol is typically the default protocol defined in the Device Communication page in the Security Manager Administration settings (see Device Communication Page). Table 8-4 lists some of the default transport protocol settings.

 
     [bookmark: pgfId-57813]When you select Device as the deployment method, deployment is affected if you configure a transport server for the device, such as an AUS or Configuration Engine. When using an intermediate transport server, configuration deployment goes through the server. For more information on using an intermediate server, see Deploying to a Device through an Intermediate Server.

 
     [bookmark: pgfId-57818]Deployment can also be affected if you made out-of-band changes to the device since the last deployment. For more information, see Understanding How Out-of-Band Changes are Handled.

 
      
       
        
        [bookmark: pgfId-54845]Table 8-4 [bookmark: 24070]Default Deployment Transport Protocols 

 
        
       
         
         		
           
           [bookmark: pgfId-54853]Device Type
          
  
         		
           
           [bookmark: pgfId-54855]Transport Protocol
          
  
         		
           
           [bookmark: pgfId-54857]Description
          
  
        

 
         
         		[bookmark: pgfId-54865]ASA, IOS 12.3 and higher routers, FWSM, PIX Firewall, IPS sensors

  
         		[bookmark: pgfId-54867]SSL (HTTPS) (Default)

  
         		[bookmark: pgfId-54869]Security Manager deploys the configuration to the device using the Secure Socket Layer (SSL) protocol, otherwise known as HTTPS. With this protocol, Security Manager encrypts the configuration file and sends it to the device.

  
        

 
         
         		[bookmark: pgfId-54877]Catalyst 6500/7600 and other Catalyst switches

  
         		[bookmark: pgfId-54879]SSH

  
         		[bookmark: pgfId-54881]Security Manager deploys the configuration to the device using a Secure Shell (SSH). This provides strong authentication and secure communications over insecure channels. Security Manager supports both SSHv1.5 and SSHv2. Once connected to the device, Security Manager determines which version to use and downloads using that version.

  
        

 
         
         		[bookmark: pgfId-54889]IOS 12.2 and 12.1 routers

  
         		[bookmark: pgfId-54891]Telnet

  
         		[bookmark: pgfId-54893]Security Manager deploys the configuration to the device using the Telnet protocol.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-57827]Related Topics

 
      
      		 [bookmark: pgfId-57832]Managing Device Communication Settings and Certificates

 
      		 [bookmark: pgfId-57837]Handling Device OS Version Mismatches

 
     

 
    
 
     
      [bookmark: pgfId-57855][bookmark: 24113][bookmark: dpman_cncpt_DeployingtoaDevicethroughanIntermediateServer]Deploying to a Device through an Intermediate Server[bookmark: marker-57845][bookmark: marker-57847][bookmark: marker-57849][bookmark: marker-57851][bookmark: marker-57853]

 
     [bookmark: pgfId-57857]Deploying configurations through an intermediate server, such as an Auto Update Server (AUS), Cisco Networking Services (CNS) Configuration Engine, or Token Management Server (TMS), is a version of deploying directly to device. When selecting the deployment method, select Device. Security Manager sends the configuration updates to the intermediate server, where the device retrieves it (for AUS and CNS), or where you can download it to an eToken (for TMS).

 
     [bookmark: pgfId-57859]You must use an intermediate server if you are using dynamic IP addresses for your device interfaces (that is, the IP addresses are provided by a DHCP server). You can also use them with static IP addresses. However, you cannot use Configuration Engine to manage IOS devices with dynamic IP addresses if you configure features that use interactive CLI commands. The following features are affected:

 
      
      		 [bookmark: pgfId-57861]Certificate Enrollment:

 
     

 
     [bookmark: pgfId-57863] – crypto pki trustpoint

 
     [bookmark: pgfId-57865] – crypto isakmp client configuration group

 
     [bookmark: pgfId-57867] – crypto key generate rsa

 
      
      		 [bookmark: pgfId-57869]IPS signature configuration ( ip ips signature-category )

 
      		 [bookmark: pgfId-57871]IP Authproxy Banner ( ip auth-proxy-banner )

 
      		 [bookmark: pgfId-57873]Catalyst device interface switchport ( interface switchport )

 
     

 
     [bookmark: pgfId-57875]Security Manager uses an intermediate server if you have configured the device to use one. The following topics describe the required configuration steps when using an intermediate server:

 
      
      		 [bookmark: pgfId-57880]Deploying Configurations Using an Auto Update Server or CNS Configuration Engine

 
      		 [bookmark: pgfId-57885]Deploying Configurations to a Token Management Server

 
     

 
     [bookmark: pgfId-57890]Deployment can be affected if you made out-of-band changes to the device since the last deployment. For more information, see Understanding How Out-of-Band Changes are Handled.

 
     [bookmark: pgfId-57892]During deployment, Security Manager sends configuration changes based on the type of server:

 
      
      		 [bookmark: pgfId-57894]Auto Update Server (standalone or running on Configuration Engine) for PIX and ASA devices—Security Manager sends the full configuration to Auto Update Server, where the device retrieves it. The delta configuration is not sent.

 
      		 [bookmark: pgfId-57896]Configuration Engine for IOS devices—Security Manager sends the delta configuration to Configuration Engine, where the device retrieves it.

 
      		 [bookmark: pgfId-57898]TMS—Security Manager sends the delta configuration to the TMS server, from which it can be downloaded to an eToken to be loaded onto the device.

 
     

 
     [bookmark: pgfId-57900]Related Topics

 
      
      		 [bookmark: pgfId-57905]Managing Device Communication Settings and Certificates

 
      		 [bookmark: pgfId-57910]Device Communication Page

 
     

 
    
 
     
      [bookmark: pgfId-57924][bookmark: 24183][bookmark: dpman_cncpt_DeployingtoaFile]Deploying to a File[bookmark: marker-57918][bookmark: marker-57920][bookmark: marker-57922]

 
     [bookmark: pgfId-57926]If you choose to deploy configurations to configuration files, Security Manager creates two files: device_name _delta.cfg for the delta configuration, and device_name _full.cfg for the full configuration. If the files are created by a job that was generated from a deployment schedule, the name includes a time stamp. Configuration files are in TFTP format so that you can upload them to your devices using TFTP.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-57928]Tip You cannot deploy configurations to file for IPS devices.


     
      

     

     

 
     [bookmark: pgfId-57930]If you deploy to file, you are responsible for transferring the configurations to your devices. Security Manager assumes that you have done this, so the next time you deploy to the same devices, the generated incremental commands are based on the configurations from the previous deployment. If for some reason the last change was not applied to the device, the new delta configuration will not bring the device configuration up to the one reflected in Security Manager.

 
      
      [image: ] 
     
 
     
 
     
      [bookmark: pgfId-57935]
      Caution Although Security Manager in one sense assumes that you applied the delta configuration, in another sense, it assumes that it cannot know if the delta was deployed. Thus, Security Manager maintains an internal view of the configuration based on the last deployment made directly to the device. So, when you apply the delta, those delta changes will be considered out-of-band changes. On next deployment to the device, your out-of-band change setting might cancel the deployment. If you mix deployments to file with deployments to device, you should rediscover policies after applying file deployments to the device. For more information, see 
      Understanding How Out-of-Band Changes are Handled.
       
       
 
      

     
 
     [bookmark: pgfId-57940]To set a default directory for file deployments, select Tools > Security Manager Administration, then select Deployment (see Deployment Page). If you select File for the default deployment method, you also select the default directory. When you create a deployment job, you can change this directory for that job.

 
     [bookmark: pgfId-57942]Deploying configurations to a file is useful when the devices are not yet in place in your network (known as green field deployment), if you have your own mechanisms in place to transfer configurations to your devices, or if you want to delay deployment. When deploying to a file, the deployment job might fail if you select a large number of devices or several devices that have large configuration files. If you encounter deployment failures, resubmit the job with fewer devices selected.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-57947]Tip Do not use commands that require interaction with the device during deployment when deploying to file. We recommend previewing your configuration before deployment to make sure there are no such commands in the file. For more information, see Previewing Configurations.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-57963][bookmark: 24210][bookmark: dpman_cncpt_UnderstandingHowOutOfBandChangesAreHandled]Understanding How Out-of-Band Changes are Handled [bookmark: marker-57953][bookmark: marker-57955][bookmark: marker-57957][bookmark: marker-57959][bookmark: marker-57961]

 
     [bookmark: pgfId-57965]Security Manager considers an out-of-band change to be any change made to a device manually or outside of Security Manager control, for example, by logging into the device directly and entering configuration commands through the CLI. Paradoxically, this includes the application of delta changes that Security Manager creates when you deploy configurations to file rather than to the device.

 
     [bookmark: pgfId-57967]If you are deploying to the device (rather than to file), and the deploy to device method is configured to compare the new configuration to the current configuration on the device, you can specify how to handle out-of-band changes when they are detected using the Out of Band Change Behavior setting. The setting does not apply when deploying to file.

 
     [bookmark: pgfId-57972]This setting is ignored if you are comparing the new device configuration with the latest version stored in the Security Manager Configuration Archive. The default way to handle out-of-band changes, is set in Tools > Security Manager Administration > Deployment; for more information see Deployment Page. Look for the Deploy to Device Reference Configuration and When Out of Band Changes Detected settings.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-57974]Tip When the deployment method is configured to use the reference configuration in Configuration Archive, out-of-band changes are always removed. This is equivalent to selecting Do not check for changes.


     
      

     

     

 
     [bookmark: pgfId-57976]Your options for handling out-of-band changes are:

 
      
      		 [bookmark: pgfId-57978] Overwrite changes and show warning —When configurations are deployed, Security Manager uploads the device’s current configuration and compares it against the configuration it has in its database. If changes were made to the device manually, Security Manager continues with the deployment and displays a warning notifying you of this action. Out-of-band changes are removed from the device.

 
      		 [bookmark: pgfId-57980] Cancel deployment —When configurations are deployed, Security Manager uploads the device’s current configuration and compares it against the configuration it has in its database. If changes were made to the device manually, Security Manager cancels the deployment and displays a warning notifying you of this action. You must either manually remove the out-of-band changes, or configure the same settings in Security Manager, before you can deploy configuration changes to the device.

 
      		 [bookmark: pgfId-57982] Do not check for changes —Security Manager does not check for changes and deploys the changes to the device. No warnings are issued, and any out-of-band changes are removed from the device configuration.

 
     

 
     [bookmark: pgfId-57987]Before you deploy configurations, you might want to detect whether there are out of band changes on a device and analyze whether you want to recreate those changes in Security Manager policies, or allow Security Manager to overwrite the changes. For more information, see Detecting and Analyzing Out of Band Changes.

 
     [bookmark: pgfId-57989]Related Topics

 
      
      		 [bookmark: pgfId-57994]Deploying Directly to a Device

 
      		 [bookmark: pgfId-57999]Deploying to a Device through an Intermediate Server

 
      		 [bookmark: pgfId-58004]Deploying to a File

 
     

 
    
 
     
      [bookmark: pgfId-58016][bookmark: 24264][bookmark: dpman_cncpt_HandlingDeviceOSVersionMismatches]Handling Device OS Version Mismatches[bookmark: marker-58010][bookmark: marker-58012][bookmark: marker-58014]

 
     [bookmark: pgfId-58018]Before deploying a changed configuration file directly to a device, Security Manager normally uploads the current running configuration file from the device and checks the OS version running on the device with the OS version stored in the Security Manager database (you can configure it so that the archived configuration is used instead of the configuration from the device). Security Manager takes action depending on whether the OS versions match or differ from each other.

 
     [bookmark: pgfId-58020]In some cases, Security Manager deploys the configuration and issues a warning, but in other cases, Security Manager cannot deploy the configuration. Security Manager deploys the configuration when:

 
      
      		 [bookmark: pgfId-58022]The device has a newer minor version, for example, ASA 8.1(2) instead of the 8.1(1), indicated in Security Manager.

 
      		 [bookmark: pgfId-58024]The device has a down-level minor version, for example, ASA 8.1(1) instead of 8.1(2).

 
     

 
     [bookmark: pgfId-58026]Security Manager does not deploy the configuration when the device is running a new major version of the OS (for example, ASA 8.0 instead of the 7.2 indicated in Security Manager) or if the device is running a down-level major version (7.2 instead of 8.0).

 
     [bookmark: pgfId-58028]The following table lists the possible actions Security Manager takes depending on the whether the OS versions match or differ from each other. The table uses the ASA device as an example; however, the actions apply to all supported device types.

 
     [bookmark: pgfId-58031] 

 
      
       
        
        [bookmark: pgfId-54912]Table 8-5 [bookmark: 24289]Deployment Action Based on OS Version Match or Mismatch 

 
        
       
         
         		
           
           [bookmark: pgfId-54924]Scenario
          
  
         		
           
           [bookmark: pgfId-54926]OS Version in Security Manager Database
          
  
         		
           
           [bookmark: pgfId-54928]OS Version On Device
          
  
         		
           
           [bookmark: pgfId-54930]OS Version Used In Deployment
          
  
         		
           
           [bookmark: pgfId-54932]Action
          
  
        

 
         
         		[bookmark: pgfId-54944]Versions match

  
         		[bookmark: pgfId-54946]ASA 8.2(1)

  
         		[bookmark: pgfId-54948]ASA 8.2(1)

  
         		[bookmark: pgfId-54950]ASA 8.2(1)

  
         		[bookmark: pgfId-54952]Deployment proceeds with no warnings.

  
        

 
         
         		[bookmark: pgfId-54964]Device has newer minor OS version.

  
         		[bookmark: pgfId-54966]ASA 8.1(1)

  
         		[bookmark: pgfId-54968]ASA 8.1(2)

  
         		[bookmark: pgfId-54970]ASA 8.1(2)

  
         		[bookmark: pgfId-54972]Security Manager warns that it has detected a different OS version on the device than the one in the Security Manager database.

 [bookmark: pgfId-54974]Security Manager generates the CLI based on the OS version running on the device.

  
        

 
         
         		[bookmark: pgfId-54986]Device has newer minor OS version, one that is not directly supported by Security Manager.

  
         		[bookmark: pgfId-54988]ASA 8.0(2)

  
         		[bookmark: pgfId-54990]ASA 8.0(4)

  
         		[bookmark: pgfId-54992]ASA 8.0(3)

  
         		[bookmark: pgfId-54994]Security Manager warns that it has detected a different OS version on the device than the one in the Security Manager database.

 [bookmark: pgfId-54996]Security Manager generates the CLI based on the OS version that it supports to which the running OS version is downward-compatible.

  
        

 
         
         		[bookmark: pgfId-55008]Device has a new major OS version.

  
         		[bookmark: pgfId-55010]ASA 7.2(4)

  
         		[bookmark: pgfId-55012]ASA 8.2(1)

  
         		[bookmark: pgfId-55014]None. Deployment fails.

  
         		[bookmark: pgfId-55016]Security Manager reports an error indicating that it has detected a different OS version on the device than the one in the Security Manager database.

 [bookmark: pgfId-55018]Security Manager cannot proceed until you correct this mismatch. Remove the device from the inventory, add it again, and discover the device policies.

  
        

 
         
         		[bookmark: pgfId-55030]Device has an older minor OS version.

  
         		[bookmark: pgfId-55032]ASA 8.1(2)

  
         		[bookmark: pgfId-55034]ASA 8.1(1)

  
         		[bookmark: pgfId-55036]ASA 8.1(1)

  
         		[bookmark: pgfId-55038]Security Manager warns that it has detected a different OS version on the device than the one in the Security Manager database.

 [bookmark: pgfId-55040]Security Manager generates the CLI based on the OS version running on the device.

  
        

 
         
         		[bookmark: pgfId-55052]Device has an older major OS version

  
         		[bookmark: pgfId-55054]ASA 8.2(1)

  
         		[bookmark: pgfId-55056]ASA 7.2(4)

  
         		[bookmark: pgfId-55058]None. Deployment fails.

  
         		[bookmark: pgfId-55060]Security Manager reports an error indicating that it has detected a different OS version on the device than the one in the Security Manager database.

 [bookmark: pgfId-55062]Security Manager cannot proceed until you correct this mismatch. Remove the device from the inventory, add it again, and discover the device policies.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-58041][bookmark: 24378][bookmark: dpman_cncpt_OverviewofDeploymentManagerandConfigurationArchive]Overview of the Deployment Manager and Configuration Archive[bookmark: marker-58037][bookmark: marker-58039]

 
    [bookmark: pgfId-58043]The Deployment Manager and Configuration Archive are the main tools that you can use to manage deployment and device configurations. The following topics provide an overview of these tools:

 
     
     		 [bookmark: pgfId-58048]Understanding What You Can Do with the Deployment Manager

 
     		 [bookmark: pgfId-58053]Deployment Manager Window

 
     		 [bookmark: pgfId-58058]Deployment Schedules Tab, Deployment Manager

 
     		 [bookmark: pgfId-58063]Configuration Archive Window

 
    

 
     
      [bookmark: pgfId-58075][bookmark: 24400][bookmark: dpman_cncpt_BenefitsofDeploymentJobs]Understanding What You Can Do with the Deployment Manager [bookmark: marker-58069][bookmark: marker-58071][bookmark: marker-58073]

 
     [bookmark: pgfId-58077]The Deployment Manager, where you create and manage deployment jobs and schedules, provides the following benefits:

 
      
      		 [bookmark: pgfId-58079]Previewing and comparing configurations—Before you deploy a configuration file to a device, you can preview the proposed configuration file. You can also compare the proposed configuration file to what was last imported from the device or what is currently running on the device.

 
     

 
     [bookmark: pgfId-58084]After successful deployment to a device, you can view a transcript of the configuration commands downloaded and the device’s responses. For more information, see Previewing Configurations.

 
      
      		 [bookmark: pgfId-58089]Aborting deployment jobs—You can stop a deployment job even if it is currently running. However, aborting a job that is in process does not roll back the configuration on devices that have already been reconfigured, or on devices that are in the process of being reconfigured. Only devices for which deployment has not started are prevented from being reconfigured. For more information, see Aborting Deployment Jobs.

 
      		 [bookmark: pgfId-58094]Rolling back to a previous configuration—If you deploy configurations to devices, and then determine that there is something wrong with the new configurations, you can revert to and deploy the previous configurations for those devices. For more information, see Rolling Back Configurations to Devices Using the Deployment Manager.

 
      		 [bookmark: pgfId-58099]Viewing deployment job status—You can display information about the deployment to specific devices, including information about errors, the proposed configuration, and the transcript of the download. For more information, see Viewing Deployment Status and History for Jobs and Schedules.

 
      		 [bookmark: pgfId-58101]Scheduling deployment jobs—You can create deployment schedules to spawn deployment jobs at regular intervals. In Workflow mode, you can also schedule a deployment job to start at a future time when you deploy the job. Scheduling jobs lets you plan deployments for times when traffic on devices is low. For more information, see these topics:

 
     

 
     [bookmark: pgfId-58106] – Creating or Editing Deployment Schedules

 
     [bookmark: pgfId-58111] – Deploying Configurations in Workflow Mode

 
      
      		 [bookmark: pgfId-58116]Logging deployment job history (Workflow mode only)—You can view the history of transactions for a job. The transactions show the changes in job status initiated by various users, such as job approval, and the comments related to those status changes. For more information, see Viewing Deployment Status and History for Jobs and Schedules.

 
     

 
    
 
     
      [bookmark: pgfId-58130][bookmark: 24439][bookmark: dppage_cncpt_DeploymentManagerWindow]Deployment Manager Window[bookmark: marker-58126][bookmark: marker-58128]

 
     [bookmark: pgfId-58132]Use the Deployment Manager window to manage deployment jobs and schedules. You can display a list of deployment jobs, view job details, deploy and redeploy configurations to devices, abort deployment jobs, roll back to previous configurations on selected devices, and create schedules to automatically generate deployment jobs. You can also track changes made to deployment jobs and schedules.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-58134]Note The buttons available in the Deployment Manager depend on the Workflow mode you are using.


     
      

     

     

 
     [bookmark: pgfId-58136]Navigation Path

 
     [bookmark: pgfId-58138]Click the Deployment Manager button on the Main toolbar or select Manage > Deployments.

 
     [bookmark: pgfId-58140]Related Topics

 
      
      		 [bookmark: pgfId-58145]Overview of the Deployment Process

 
      		 [bookmark: pgfId-58150]Viewing Deployment Status and History for Jobs and Schedules

 
      		 [bookmark: pgfId-58155]Deploying Configurations in Non-Workflow Mode

 
      		 [bookmark: pgfId-58160]Deploying Configurations in Workflow Mode

 
      		 [bookmark: pgfId-58165]Deploying Configurations Using an Auto Update Server or CNS Configuration Engine

 
      		 [bookmark: pgfId-58170]Deploying Configurations to a Token Management Server

 
      		 [bookmark: pgfId-58175]Managing Device Communication Settings and Certificates

 
     

 
     [bookmark: pgfId-58177]Field Reference

 
     [bookmark: pgfId-58180] 

 
      
       
        
        [bookmark: pgfId-55075]Table 8-6 [bookmark: 24483]Deployment Manager Window (Workflow Mode) 

 
        
       
         
         		
           
           [bookmark: pgfId-55081]Element
          
  
         		
           
           [bookmark: pgfId-55083]Description
          
  
        

 
         
         		 [bookmark: pgfId-55089]Deployment Jobs Tab

 [bookmark: pgfId-55091]This tab shows individual deployment jobs. Select a job in the upper pane to view its details in the tabs in the lower pane.

  
        

 
         
         		[bookmark: pgfId-55099]Name

  
         		[bookmark: pgfId-55101]The name of the job.

  
        

 
         
         		[bookmark: pgfId-55107]Last Action

  
         		[bookmark: pgfId-55109]The date and time that the job or status was changed based on the time zone of the server, not the time zone of the client.

  
        

 
         
         		[bookmark: pgfId-55115]Status

  
         		[bookmark: pgfId-55117]The state of each job. The possible states differ based on workflow mode. For a description of the states, see the following topics:

 
           
           		 [bookmark: pgfId-55122]Job States in Non-Workflow Mode

 
           		 [bookmark: pgfId-55127]Job States in Workflow Mode

 
          

  
        

 
         
         		[bookmark: pgfId-55133]Changed By

  
         		[bookmark: pgfId-55135]The name of the user who modified the job.

  
        

 
         
         		[bookmark: pgfId-55141]Description

  
         		[bookmark: pgfId-55143]The description of the job. Double-click the icon to see the description in a separate dialog box.

  
        

 
         
         		[bookmark: pgfId-55149]Job Type

  
         		[bookmark: pgfId-55151]The type of job with respect to scheduling. A one time job was not created from a regularly recurring job, whereas a recurring job was.

  
        

 
         
         		[bookmark: pgfId-55157]Create button

 [bookmark: pgfId-55159](Workflow mode only.)

  
         		[bookmark: pgfId-55164]In Workflow mode, click this button to create a new job. The Create a Job dialog box opens. See Creating and Editing Deployment Jobs.

  
        

 
         
         		[bookmark: pgfId-55170]Open button

 [bookmark: pgfId-55172](Workflow mode only.)

  
         		[bookmark: pgfId-55177]In Workflow mode, click this button to open the selected job. The Edit a Job dialog box opens. See Creating and Editing Deployment Jobs.

  
        

 
         
         		[bookmark: pgfId-55183]Close button

 [bookmark: pgfId-55185](Workflow mode only.)

  
         		[bookmark: pgfId-55187]In Workflow mode, click this button to close and save all changes made while the selected job was open. You can close a job when it is in the Edit Open or the Submit Open state. Normally, you do not need to close a job, because you will typically submit, approve, deploy, or schedule the job for deployment. However, if the Security Manager server is suddenly unavailable or your login session times out, a job might be left in the Edit Open state. If this happens, you can close it manually by selecting it and clicking Close.

  
        

 
         
         		[bookmark: pgfId-55193]Submit button

 [bookmark: pgfId-55195](Workflow mode only.)

  
         		[bookmark: pgfId-55200]In Workflow mode, click this button to submit the selected job for approval. You can submit a job when it is in the Edit or the Edit Open state. The Submit Deployment Job dialog box opens. See Submitting Deployment Jobs.

 [bookmark: pgfId-55202]This button is active only if you are using Workflow mode with a deployment job approver.

  
        

 
         
         		[bookmark: pgfId-55208]Reject button

 [bookmark: pgfId-55210](Workflow mode only.)

  
         		[bookmark: pgfId-55215]In Workflow mode, click this button to reject the selected job if you are not satisfied with the configurations generated for the devices. You can reject jobs only in workflow mode with a deployment job approver. After a job is rejected, it can be opened for editing or discarded. See Approving and Rejecting Deployment Jobs.

 [bookmark: pgfId-55217]You are prompted to enter an optional comment to explain why you are rejecting the job.

  
        

 
         
         		[bookmark: pgfId-55223]Approve button

 [bookmark: pgfId-55225](Workflow mode only.)

  
         		[bookmark: pgfId-55230]In Workflow mode, click this button to approve the selected job. After a job is approved, it can be deployed. See Approving and Rejecting Deployment Jobs.

 [bookmark: pgfId-55232]You are prompted to enter an optional comment to explain why you are approving the job.

  
        

 
         
         		[bookmark: pgfId-55238]Discard button

 [bookmark: pgfId-55240](Workflow mode only.)

  
         		[bookmark: pgfId-55245]In Workflow mode, click this button to discard the selected job. You can discard a job when it is in any state except Deployed, Deployment Failed, or Aborted. Once discarded, the job cannot be edited, submitted, approved, or deployed. The job state is shown as discarded until the job is purged from the system either automatically as set on the Workflow settings page or manually (for more information, see Workflow Page).

 [bookmark: pgfId-55250]You are prompted to enter an optional comment to explain why you are discarding the job. See Discarding Deployment Jobs.

  
        

 
         
         		[bookmark: pgfId-55256]Deploy button

 [bookmark: pgfId-55258](All modes.)

  
         		[bookmark: pgfId-55260]Click this button to deploy generated CLI commands devices or files. The behavior of this button differs depending on Workflow mode:

 
           
           		 [bookmark: pgfId-55265](Non-Workflow mode.) Click this button to create a deployment job. If you have unsubmitted changes, you are first prompted to submit them. The Deploy Saved Changes dialog box opens, where you can select which devices to include in the job. Note that this button does not act on the deployment job selected in the table, if any; instead, it creates a new deployment job. See Deploying Configurations in Non-Workflow Mode.

 
           		 [bookmark: pgfId-55270](Workflow mode.) Click this button to deploy the selected job. If the job is in the Approved state, the Deploy Job dialog box opens (see Deploying a Deployment Job in Workflow Mode).

 
          

 [bookmark: pgfId-55275]If the job is in the deployed, failed, or aborted state then the Redeploy Job dialog box opens. See Redeploying Configurations to Devices.

  
        

 
         
         		[bookmark: pgfId-55281]Generate Report button

 [bookmark: pgfId-55283](All modes.)

  
         		[bookmark: pgfId-55285]Click this button to create a deployment status report for the selected job. You can generate the report in HTML and PDF formats. Jobs must be in deployed, failed, rolled back, or aborted state.

 [bookmark: pgfId-55290]The deployment status report includes a summary of the job plus the full and delta configurations and the job transcript. You can use this report for your own purposes or to aid in troubleshooting a problem with Cisco TAC. For more information, see Generating Deployment or Discovery Status Reports.

  
        

 
         
         		[bookmark: pgfId-55296]Refresh button

 [bookmark: pgfId-55298](All modes.)

  
         		[bookmark: pgfId-55300]Click this button to reload job information from the Security Manager server. If the message Auto Refresh is On is displayed beneath the table, the job list is automatically refreshed periodically.

 .

  
        

 
         
         		[bookmark: pgfId-55308]Redeploy button

 [bookmark: pgfId-55310](Non-Workflow mode only.)

  
         		[bookmark: pgfId-55315]In Non-Workflow mode, click this button to redeploy the selected job, which deploys the same generated CLI commands to the same devices or files selected in the original job. The Redeploy Job dialog box opens. See Redeploying Configurations to Devices.

 [bookmark: pgfId-55317](In Workflow mode, click the Deploy button to redeploy configurations for the selected job.)

  
        

 
         
         		[bookmark: pgfId-55323]Abort button

 [bookmark: pgfId-55325](All modes.)

  
         		[bookmark: pgfId-55330]Click this button to abort the selected job if it is in the Deploying, Scheduled, or Rolling Back state. A warning asks you to confirm the action. See Aborting Deployment Jobs.

  
        

 
         
         		[bookmark: pgfId-55336]Rollback button

 [bookmark: pgfId-55338](All modes.)

  
         		[bookmark: pgfId-55343]Click this button to deploy the previously deployed configuration to the devices in the selected job. The Deployment Rollback dialog box opens (see Rolling Back Configurations to Devices Using the Deployment Manager).

  
        

 
         
         		[bookmark: pgfId-55349]Summary tab

  
         		[bookmark: pgfId-55351]Displays summary information about the status of the selected deployment job, such as the status of the job, the name of the deployment job, the number of devices included in the job, the number of devices deployed successfully, and the number of devices deployed with errors.

  
        

 
         
         		[bookmark: pgfId-55357]Details tab

  
         		[bookmark: pgfId-55359]Displays detailed information for the selected job. The table lists each device included in the job, whether deployment succeeded or failed, the tickets containing changes that are part of the job for the device, and a summary of the number of warnings, errors, or failures for the device. Select a device in the table to view the results for that device:

 
           
           		 [bookmark: pgfId-55364]Double-click the icon in the Config column to view the configuration (see Previewing Configurations). If you deleted the device from the inventory, the configuration and transcript might not be available.

 
           		 [bookmark: pgfId-55369]If you were deploying to the device, double-click the icon in the Transcripts column to view a transcript of the commands sent to the device and the device’s responses. See Viewing Deployment Transcripts.

 
           		 [bookmark: pgfId-55374]If Ticket Management is enabled, the Last Ticket(s) column displays the ticket IDs of the tickets containing changes that are part of the deployment for the device. You can click on the Ticket IDs to view additional information about the ticket, such as Creator and Last Modified date. If linkage to an external ticket management system has been configured, you can also navigate to that system from the ticket details (see Ticket Management Page).

 
           		 [bookmark: pgfId-55376]When you select a device, the Messages box in the lower left contains a summary of the messages generated for the deployment. Select an item to view its description to the right. You might have to enlarge the window to make the Description box visible. If applicable, there might also be information on the actions you can take to resolve the problems.

 
          

  
        

 
         
         		[bookmark: pgfId-55382]History tab

 [bookmark: pgfId-55384](Workflow mode only.)

  
         		[bookmark: pgfId-55386]Displays a log of the changes that have been made to the selected job. The information includes the state changes, the user who made the change, the date and time of the change (based on the Security Manager server time), and any comments the user entered to document the change.

  
        

 
         
         		 [bookmark: pgfId-55392]Deployment Schedules Tab

 [bookmark: pgfId-55397]Use this tab to schedule regular deployment jobs. For detailed information about this tab, see Deployment Schedules Tab, Deployment Manager.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-58204][bookmark: 24680][bookmark: dppage_cncpt_DeploymentWorkflowCommentaryDialogBox]Deployment Workflow Commentary Dialog Box[bookmark: marker-58192][bookmark: marker-58194][bookmark: marker-58196][bookmark: marker-58198][bookmark: marker-58200][bookmark: marker-58202]

 
     [bookmark: pgfId-58206]When you perform an action in the Deployment Manager while working in Workflow mode, you are prompted to enter a comment to describe the action. The comments are preserved in the history for the job or schedule.

 
     [bookmark: pgfId-58208]The title of the dialog box indicates the action you are taking. Enter an optional comment and click OK to perform the action.

 
     [bookmark: pgfId-58210]Navigation Path

 
     [bookmark: pgfId-58212]In Workflow mode, select a job or schedule in the Deployment Manager and click the appropriate button to perform the desired action.

 
    
 
     
      [bookmark: pgfId-58222][bookmark: 24706][bookmark: dppage_cncpt_DeploymentSchedulesTabDeploymentManager]Deployment Schedules Tab, Deployment Manager[bookmark: marker-58218][bookmark: marker-58220]

 
     [bookmark: pgfId-58224]Use the Deployment Schedules tab on the Deployment Manager window to create regularly recurring deployment jobs. Whenever the scheduled deployment time occurs, Security Manager creates a specific deployment job based on the scheduled job.

 
     [bookmark: pgfId-58226]Navigation Path

 
     [bookmark: pgfId-58228]Click the Deployment Manager button on the Main toolbar or select Manage > Deployments, and then click the Deployment Schedules tab in the upper pane.

 
     [bookmark: pgfId-58230]Related Topics

 
      
      		 [bookmark: pgfId-58235]Overview of the Deployment Process

 
      		 [bookmark: pgfId-58240]Creating or Editing Deployment Schedules

 
      		 [bookmark: pgfId-58245]Suspending or Resuming Deployment Schedules

 
     

 
     [bookmark: pgfId-58247]Field Reference

 
     [bookmark: pgfId-58250] 

 
      
       
        
        [bookmark: pgfId-55412]Table 8-7 [bookmark: 24735]Deployment Schedules Tab, Deployment Manager Window 

 
        
       
         
         		
           
           [bookmark: pgfId-55418]Element
          
  
         		
           
           [bookmark: pgfId-55420]Description
          
  
        

 
         
         		 [bookmark: pgfId-55426]Deployment Schedule Table

 [bookmark: pgfId-55428]This table shows deployment job schedules. Select a schedule in the table to view its details in the tabs in the lower pane.

  
        

 
         
         		[bookmark: pgfId-55436]Name

  
         		[bookmark: pgfId-55438]Name of the job schedule. Jobs created from this schedule use this name plus a time stamp.

  
        

 
         
         		[bookmark: pgfId-55444]Status

  
         		[bookmark: pgfId-55446]The status of the schedule:

 
           
           		 [bookmark: pgfId-55448]Edit—In Workflow mode, the schedule is being created. You can open it and change its settings. No jobs are created from schedules that are being edited.

 
           		 [bookmark: pgfId-55450]Active—Deployment jobs will be created according to this schedule.

 
           		 [bookmark: pgfId-55452]Suspended—The schedule was suspended and no jobs are being created by it. You can restart the schedule by selecting it and clicking  Resume .

 
          

  
        

 
         
         		[bookmark: pgfId-55458]Recurrence

  
         		[bookmark: pgfId-55460]How often deployment jobs will be created from this schedule.

  
        

 
         
         		[bookmark: pgfId-55466]Next Run

  
         		[bookmark: pgfId-55468]The date and time a deployment job will next be created from this schedule.

  
        

 
         
         		[bookmark: pgfId-55474]Last Run

  
         		[bookmark: pgfId-55476]The date and time of the most recent deployment job created from this schedule.

  
        

 
         
         		[bookmark: pgfId-55482]Schedule End

  
         		[bookmark: pgfId-55484]The date and time the schedule is no longer active. If the schedule has no end date, Active Indefinitely is indicated.

  
        

 
         
         		[bookmark: pgfId-55490]Description

  
         		[bookmark: pgfId-55492]The description of the job schedule. Double-click the icon to see the description.

  
        

 
         
         		[bookmark: pgfId-55498]Create button

  
         		[bookmark: pgfId-55503]Click this button to create a deployment job schedule. The Schedule dialog box opens where you can create the schedule (see Schedule Dialog Box.

  
        

 
         
         		[bookmark: pgfId-55509]Open button

  
         		[bookmark: pgfId-55514]Click this button to open the selected schedule. The Schedule dialog box opens where you can view or modify the schedule (see Schedule Dialog Box).

 [bookmark: pgfId-55516]In non-Workflow mode, modifying the schedule does not change its status. In Workflow mode, the status changes to Edit, and you must resubmit it for approval.

  
        

 
         
         		[bookmark: pgfId-55522]Close button

 [bookmark: pgfId-55524](Workflow mode only)

  
         		[bookmark: pgfId-55526]Click this button to close and save all changes made while the schedule was open. You can close a schedule when it is in the Edit Open or the Submit Open state. Typically, you will have to close schedules only if the Security Manager server becomes unavailable while you have a schedule open.

  
        

 
         
         		[bookmark: pgfId-55532]Submit button

 [bookmark: pgfId-55534](Workflow mode only)

  
         		[bookmark: pgfId-55536]Click this button to submit the selected schedule for approval if you are operating in Workflow mode with an approver. You can submit a schedule when it is in the Edit or the Edit Open state. You are prompted for an optional comment to explain the submission, and an e-mail is generated to the approver in Workflow mode.

  
        

 
         
         		[bookmark: pgfId-55542]Reject button

 [bookmark: pgfId-55544](Workflow mode only)

  
         		[bookmark: pgfId-55546]Click this button to reject the selected schedule. You are prompted for an optional comment to explain the rejection, and an e-mail is generated to the approver and submitter in Workflow mode.

  
        

 
         
         		[bookmark: pgfId-55552]Approve button

 [bookmark: pgfId-55554](Workflow mode only)

  
         		[bookmark: pgfId-55556]Click this button to approve the selected schedule. You are prompted for an optional comment to explain the approval, and an e-mail is generated to the approver and submitter in Workflow mode.

  
        

 
         
         		[bookmark: pgfId-55562]Discard button

  
         		[bookmark: pgfId-55564]Click this button to discard the selected schedule. You can discard a schedule unless there is an active deployment job that was created from the schedule. (You can wait for the job to finish, or abort the job and then discard the schedule.)

 [bookmark: pgfId-55566]You are prompted for an optional comment to explain the discard, and an e-mail is generated to the approver and submitter in Workflow mode.

  
        

 
         
         		[bookmark: pgfId-55572]Refresh button

  
         		[bookmark: pgfId-55574]Click this button to reload schedule information from the Security Manager server. If the message Auto Refresh is On is displayed beneath the table, the schedule list is automatically refreshed periodically.

 .

  
        

 
         
         		[bookmark: pgfId-55582]Suspend button

  
         		[bookmark: pgfId-55584]Click this button to suspend the selected schedule. Suspending the schedule does not delete the schedule, but it prevents the creation of deployment jobs based on it. You are prompted for a comment to explain the suspension, and an e-mail is generated to the approver in Workflow mode.

  
        

 
         
         		[bookmark: pgfId-55590]Resume button

  
         		[bookmark: pgfId-55592]Click this button to reactivate a suspended schedule. You are prompted for a comment to explain the suspension, and an e-mail is generated to the approver in Workflow mode.

  
        

 
         
         		[bookmark: pgfId-55598]Summary tab

  
         		[bookmark: pgfId-55600]Displays summary information about the selected schedule. Besides the fields shown in the table, summary information includes the number of devices included in the schedule and the user ID of the person who last changed the schedule.

  
        

 
         
         		[bookmark: pgfId-55606]Devices tab

  
         		[bookmark: pgfId-55608]Displays the devices that are included in the selected schedule. These are the devices to which configurations are deployed when a deployment job is created from the schedule. To change the device list, click Open, then click Add Devices on the Schedule dialog box.

  
        

 
         
         		[bookmark: pgfId-55614]History tab

  
         		[bookmark: pgfId-55616]Displays a log of the changes that have been made to the selected schedule. The information includes the state changes, the user who made the change, the date and time of the change (based on the Security Manager server time), and any comments the user entered to document the change.

  
        

 
         
         		[bookmark: pgfId-55622]Jobs tab

  
         		[bookmark: pgfId-55624]Displays a list of the deployment jobs that have been created based on the selected schedule. Information includes the name of the job, the date and time the job was created based on server time (not the client time), and the job status. If you select a job, and click the Deployment Job tab, the selected job is highlighted and you can view the job details.

 [bookmark: pgfId-55626]For information on job status, see these topics:

 
           
           		 [bookmark: pgfId-55631]Job States in Workflow Mode

 
           		 [bookmark: pgfId-55636]Job States in Non-Workflow Mode

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-58260][bookmark: 24887][bookmark: toolpage_cncpt_ConfigurationArchiveWindow]Configuration Archive Window[bookmark: marker-58258]

 
     [bookmark: pgfId-58262]The Configuration Archive stores configuration versions for each device managed by Security Manager. If you delete a device from Security Manager, all of the device’s configurations are also deleted from the Configuration Archive.

 
     [bookmark: pgfId-58264]You can use Configuration Archive to:

 
      
      		 [bookmark: pgfId-58266]View the transcript of a configuration deployment for a selected device.

 
      		 [bookmark: pgfId-58268]View and compare configuration versions.

 
      		 [bookmark: pgfId-58270]View CLI differences between deployed configuration versions.

 
      		 [bookmark: pgfId-58272]Roll back to an earlier configuration version, provided that the configuration originated from the device. You should roll back configurations only under extreme circumstances. For more information, see these topics:

 
     

 
     [bookmark: pgfId-58277] – Understanding Configuration Rollback

 
     [bookmark: pgfId-58282] – Using Rollback to Deploy Archived Configurations

 
      
      		 [bookmark: pgfId-58284]Add the current running configuration for a device to the archive.

 
     

 
     [bookmark: pgfId-58286]You can sort the list of configuration versions for a device by clicking on the column heading that you want to sort on. Clicking the column heading toggles between sorting the rows in ascending or descending order. You can also control the fields displayed by right-clicking on any column heading and selecting or deselecting the desired column names under the Show Columns command.

 
     [bookmark: pgfId-58288]Navigation Path

 
     [bookmark: pgfId-58290]Select Manage > Configuration Archive.

 
     [bookmark: pgfId-58292]Related Topics

 
      
      		 [bookmark: pgfId-58297]Configuration Archive Page

 
      		 [bookmark: pgfId-58302]Viewing and Comparing Archived Configuration Versions

 
      		 [bookmark: pgfId-58307]Understanding Configuration Rollback

 
      		 [bookmark: pgfId-58312]Using Rollback to Deploy Archived Configurations

 
      		 [bookmark: pgfId-58317]Understanding Rollback for Devices in Multiple Context Mode

 
      		 [bookmark: pgfId-58322]Understanding Rollback for Failover Devices

 
      		 [bookmark: pgfId-58327]Understanding Rollback for Catalyst 6500/7600 Devices

 
      		 [bookmark: pgfId-58332]Understanding Rollback for IPS and IOS IPS

 
      		 [bookmark: pgfId-58337]Adding Configuration Versions from a Device to the Configuration Archive

 
      		 [bookmark: pgfId-58342]Filtering Items in Selectors

 
     

 
     [bookmark: pgfId-58344]Field Reference

 
     [bookmark: pgfId-58347] 

 
      
       
        
        [bookmark: pgfId-55649]Table 8-8 [bookmark: 24955]Configuration Archive Window 

 
        
       
         
         		
           
           [bookmark: pgfId-55655]Element
          
  
         		
           
           [bookmark: pgfId-55657]Description
          
  
        

 
         
         		[bookmark: pgfId-55663]Device Selector

  
         		[bookmark: pgfId-55665]Lists the devices in the device inventory. Select a device to see the configuration versions for the device that are available in the archive. These are displayed in the right pane.

  
        

 
         
         		[bookmark: pgfId-55671]Version ID

  
         		[bookmark: pgfId-55673]The version number of the configuration version. By default, this column is not displayed. To display it, right click any column heading and select Show Columns > Version ID.

  
        

 
         
         		[bookmark: pgfId-55679]Created On

  
         		[bookmark: pgfId-55681]The date and time that the configuration version was archived.

  
        

 
         
         		[bookmark: pgfId-55687]Created By

  
         		[bookmark: pgfId-55689]The user ID or system ID associated with adding the configuration version to the archive.

 [bookmark: pgfId-55693]If there are two names in the form username1(username2), the first name is the user who initiated the request, and the name in parentheses is the system identity user. For more information on the system identity trust user, see the Installation Guide for Cisco Security Manager.

  
        

 
         
         		[bookmark: pgfId-55699]Archival Source

  
         		[bookmark: pgfId-55701]The origin of the archiving event (for example, User Request, Deployment or Provision, Discovery).

  
        

 
         
         		[bookmark: pgfId-55707]Creation Comment

  
         		[bookmark: pgfId-55709]A description about how or why the configuration version was created.

  
        

 
         
         		[bookmark: pgfId-55715]Transcript Icon

  
         		[bookmark: pgfId-55717]When double-clicked, displays a transcript of a configuration version that was deployed to a device.

 [bookmark: pgfId-55719]A transcript is the log file of transactions between Security Manager and a device captured during a deployment or rollback operation. It includes commands sent and received between server and device from the time of the deployment or rollback request, but it does not include communication that occurs during the initial discovery phase of deployment, when Security Manager obtains the current configuration from the device.

  
        

 
         
         		[bookmark: pgfId-55725]View button

  
         		[bookmark: pgfId-55730]Click this button to display the selected configuration in the Config Version Viewer window (see Configuration Version Viewer), where you can also compare the configuration to other configuration versions.

  
        

 
         
         		[bookmark: pgfId-55736]Rollback button

  
         		[bookmark: pgfId-55738]Click this button to roll the device configuration back to the selected configuration version, provided that the configuration originated from the device. You should roll back configurations only under extreme circumstances. For more information see these topics:

 
           
           		 [bookmark: pgfId-55743]Understanding Configuration Rollback

 
           		 [bookmark: pgfId-55748]Using Rollback to Deploy Archived Configurations

 
          

  
        

 
         
         		[bookmark: pgfId-55754]Add from Device button

  
         		[bookmark: pgfId-55756]Click this button to have Security Manager retrieve the current running configuration from the device and add it as a configuration version to the archive. This is useful for any device whose configuration might have been changed directly in its CLI.

 [bookmark: pgfId-55761]For more information on adding configuration versions, see Adding Configuration Versions from a Device to the Configuration Archive.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-58355][bookmark: 25034][bookmark: dpman_cncpt_WorkingwithDeployment]Working with Deployment and the Configuration Archive[bookmark: marker-58353]

 
    [bookmark: pgfId-58357]The following topics provide information about managing deployment and using the Configuration Archive:

 
     
     		 [bookmark: pgfId-58362]Viewing Deployment Status and History for Jobs and Schedules

 
     		 [bookmark: pgfId-58367]Tips for Successful Deployment Jobs

 
     		 [bookmark: pgfId-58372]Deploying Configurations in Non-Workflow Mode

 
     		 [bookmark: pgfId-58377]Deploying Configurations in Workflow Mode

 
     		 [bookmark: pgfId-58382]Deploying Configurations Using an Auto Update Server or CNS Configuration Engine

 
     		 [bookmark: pgfId-58387]Deploying Configurations to a Token Management Server

 
     		 [bookmark: pgfId-58392]Previewing Configurations

 
     		 [bookmark: pgfId-58397]Detecting and Analyzing Out of Band Changes

 
     		 [bookmark: pgfId-58402]Redeploying Configurations to Devices

 
     		 [bookmark: pgfId-58407]Aborting Deployment Jobs

 
     		 [bookmark: pgfId-58412]Creating or Editing Deployment Schedules

 
     		 [bookmark: pgfId-58417]Suspending or Resuming Deployment Schedules

 
     		 [bookmark: pgfId-58422]Adding Configuration Versions from a Device to the Configuration Archive

 
     		 [bookmark: pgfId-58427]Viewing and Comparing Archived Configuration Versions

 
     		 [bookmark: pgfId-58432]Viewing Deployment Transcripts

 
    

 
     
      [bookmark: pgfId-58442][bookmark: 25086][bookmark: dpman_cncpt_ViewingDeploymentStatusInformation]Viewing Deployment Status and History for Jobs and Schedules [bookmark: marker-58438][bookmark: marker-58440]

 
     [bookmark: pgfId-58444]Using the Deployment Manager, you can view status and history information for deployment jobs and schedules, as well as create and manage them. To open the Deployment Manager window, select Manage > Deployments.

 
     [bookmark: pgfId-58446]Jobs and schedules are displayed on separate tabs. However, as jobs are created based on a deployment schedule, those jobs appear in the regular jobs list. Click the appropriate tab to view the list of jobs or schedules, where you can see this information:

 
      
      		 [bookmark: pgfId-58448]Deployment Jobs—The top pane displays a list of the deployment jobs. If you select a job, more detailed information appears in the lower pane:

 
     

 
     [bookmark: pgfId-58452] – Summary tab—The Summary tab shows information such as the job status, number of devices deployed successfully, and number of devices deployed with errors.[bookmark: marker-58450]

 
     [bookmark: pgfId-58460] – Details tab—The Details tab shows the status details for each device in the deployment.[bookmark: marker-58454][bookmark: marker-58456][bookmark: marker-58458]

 
     [bookmark: pgfId-58466] – History tab (Workflow mode only)—The History tab displays transactions that occurred to the selected job since it was created. Each row in the table shows the action that occurred, the user who performed the action, the date and time it occurred, and comments, if any, that the user entered.[bookmark: marker-58462][bookmark: marker-58464]

 
      
      		 [bookmark: pgfId-58468]Deployment Schedules—The top pane displays a list of the deployment schedules. If you select a schedule, more detailed information appears in the lower pane:

 
     

 
     [bookmark: pgfId-58470] – Summary tab—The Summary tab shows information such as the schedule, the time of the next job to be created from the schedule, the time a job was last run based on the schedule, the number of devices included in the schedule and the user ID of the person who last changed the schedule.

 
     [bookmark: pgfId-58472] – Devices tab—The Devices tab shows the list of devices that are included in the schedule.

 
     [bookmark: pgfId-58474] – History tab—The History tab shows the state changes and related comments of the schedule. You can track which user performed each action.

 
     [bookmark: pgfId-58476] – Jobs tab—The Jobs tab shows a list of deployment jobs that were created from the schedule and their statuses. You can also view these jobs on the Deployment Jobs tab.

 
     [bookmark: pgfId-58478]The status information in the Deployment Manager window refreshes automatically unless you turned off automatic refresh in the Security Manager Administration Deployment page (Tools > Security Manager Administration > Deployment). A message below the job or schedule table indicates whether automatic refresh is on. If it is off, refresh status information by clicking Refresh.

 
     [bookmark: pgfId-58480]Related Topics

 
      
      		 [bookmark: pgfId-58485]Overview of the Deployment Process

 
      		 [bookmark: pgfId-58490]Deploying Configurations in Non-Workflow Mode

 
      		 [bookmark: pgfId-58495]Deploying Configurations in Workflow Mode

 
      		 [bookmark: pgfId-58500]Deploying Configurations Using an Auto Update Server or CNS Configuration Engine

 
      		 [bookmark: pgfId-58505]Deploying Configurations to a Token Management Server

 
      		 [bookmark: pgfId-58510]Previewing Configurations

 
      		 [bookmark: pgfId-58515]Redeploying Configurations to Devices

 
      		 [bookmark: pgfId-58520]Aborting Deployment Jobs

 
      		 [bookmark: pgfId-58525]Rolling Back Configurations to Devices Using the Deployment Manager

 
      		 [bookmark: pgfId-58530]Creating or Editing Deployment Schedules

 
      		 [bookmark: pgfId-58535]Suspending or Resuming Deployment Schedules

 
     

 
    
 
     
      [bookmark: pgfId-58543][bookmark: 25178][bookmark: dpman_cncpt_TipsforSuccessfulDeploymentJobs]Tips for Successful Deployment Jobs[bookmark: marker-58541]

 
     [bookmark: pgfId-58548]Successful deployment depends on many things, as explained in Troubleshooting Deployment. In addition to factors involving network communications and the proper functioning of the device, you can also improve the results of deployment by keeping the following tips in mind when you select devices for a deployment job or start the job:

 
      
      		 [bookmark: pgfId-58550]You must configure at least one policy on a device before deploying to that device. If you deploy to a device without assigning at least one policy, the device’s current configuration is overwritten with a blank configuration and the device will be non-functional.

 
      		 [bookmark: pgfId-58561]Firewall devices only—If you manually added a firewall device (as described in Adding Devices by Manual Definition), we highly recommend that you discover (import) the factory-default policies for that device before deploying to that device. Bringing these policies into Security Manager prevents you from unintentionally removing them the first time you deploy to that device. For more information about factory-default policies for firewall devices, see Default Firewall Configurations. For more information about importing policies, see Discovering Policies.

 
      		 [bookmark: pgfId-58563]Deployment might take from a few minutes to an hour or more, depending on the number of devices in the deployment job.

 
      		 [bookmark: pgfId-58568]Modifying a subset of devices that are part of a VPN might make the VPN inoperable. If you select a subset of devices that are part of a VPN when creating a deployment job, you are warned and given the opportunity to select the other devices in the VPN. See Warning - Partial VPN Deployment Dialog Box.

 
      		 [bookmark: pgfId-58570]You cannot select devices that were included in other deployment jobs that are in an active state (Edit, Edit Open, and Approved). You can select devices that were included in other deployment jobs that are in the Deployed, Failed, Discarded, or Aborted states.

 
      		 [bookmark: pgfId-58574]Firewall service modules (FWSMs) and Intrusion Detection System service modules (IDSMs) contain virtual devices. Security Manager considers the module and the virtual devices to be separate devices.[bookmark: marker-58572]

 
      		 [bookmark: pgfId-58578]Some changes to the FWSM might require the Catalyst Multiservice function card (MSFC) to be updated as well. If you select an FWSM that has these types of changes, Security Manager notifies you that you must include the MSFC in the deployment job, and it will select the MSFC device for you automatically. However, if the MSFC is already included in another active deployment job, you cannot include the MSFC in the current deployment job. You must remove the MSFC from the other deployment job, discard the other deployment job, or include the FWSM in the other deployment job.[bookmark: marker-58576]

 
      		 [bookmark: pgfId-58584]The status of deployments to Catalyst 6500/7600 devices shows deployment to the device as well as its interface contexts when policy changes contain interface commands that affect the interface contexts (child devices). This can occur when you deploy a policy change that affects a VLAN in which the switch participates or when you update inventory, for example, by adding or deleting interface contexts.[bookmark: marker-58580][bookmark: marker-58582]

 
     

 
     [bookmark: pgfId-58586]Related Topics

 
      
      		 [bookmark: pgfId-58591]Overview of the Deployment Process

 
      		 [bookmark: pgfId-58596]Deploying Configurations in Non-Workflow Mode

 
      		 [bookmark: pgfId-58601]Creating and Editing Deployment Jobs

 
      		 [bookmark: pgfId-58606]Managing Device Communication Settings and Certificates

 
      		 [bookmark: pgfId-58611]Detecting and Analyzing Out of Band Changes

 
      		 [bookmark: pgfId-58616]Job States in Non-Workflow Mode

 
      		 [bookmark: pgfId-58621]Job States in Workflow Mode

 
     

 
    
 
     
      [bookmark: pgfId-58641][bookmark: 25243][bookmark: dpman_proc_DeployingConfigurationsinNonWorkflowMode]Deploying Configurations in Non-Workflow Mode[bookmark: marker-58629][bookmark: marker-58631][bookmark: marker-58633][bookmark: marker-58635][bookmark: marker-58637][bookmark: marker-58639]

 
     [bookmark: pgfId-58646]When you deploy configurations, you can transfer them to devices either directly or to another transport server (such as AUS, CNS, or TMS) in the network or create them as configuration files in a directory on the Security Manager server. See Understanding Deployment Methods for more information.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-58651]Tip Before creating the deployment job, read Tips for Successful Deployment Jobs. That topic includes tips and cautions you should keep in mind when creating deployment jobs.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     
      [bookmark: pgfId-58653]
      Caution You must configure at least one policy on a device before deploying to that device. If you deploy to a device without assigning at least one policy, the device’s current configuration is overwritten with a blank configuration.
       
       
 
      

     
 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-58655]Note When using virtual sensors: An IPS device and all of the virtual sensors on it must be deployed as a group. If you make changes to a virtual sensor and then deploy it, Security Manager deploys the parent device and all virtual sensors associated with it.


     
      

     

     

 
     [bookmark: pgfId-58657]Before You Begin

 
      
      		 [bookmark: pgfId-58662]Make sure that devices have been bootstrapped. For more information, see Chapter 2, “Preparing Devices for Management”.

 
      		 [bookmark: pgfId-58664]If you are deploying to a transport server, such as AUS, CNS, or TMS, make sure the server, Security Manager settings, and device have been set up properly.

 
     

 
     [bookmark: pgfId-58666]Related Topics

 
      
      		 [bookmark: pgfId-58671]Overview of the Deployment Process

 
      		 [bookmark: pgfId-58676]Including Devices in Deployment Jobs or Schedules

 
      		 [bookmark: pgfId-58681]Understanding Deployment Methods

 
      		 [bookmark: pgfId-58686]Deploying Configurations Using an Auto Update Server or CNS Configuration Engine

 
      		 [bookmark: pgfId-58691]Deploying Configurations to a Token Management Server

 
      		 [bookmark: pgfId-58696]Managing Device Communication Settings and Certificates

 
      		 [bookmark: pgfId-58701]Understanding How Out-of-Band Changes are Handled

 
     

 
     
 
     [bookmark: pgfId-58703]Step 1 Do one of the following in non-Workflow mode:

 
      
      		 [bookmark: pgfId-58705]Select  File > Submit and Deploy or click the  Submit and Deploy Changes button on the toolbar.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-58707]Note These options are not available when Ticket Management is enabled.


     
      

     

     

 
      
      		 [bookmark: pgfId-58709]Select  File > Deploy .

 
      		 [bookmark: pgfId-58711]Click the  Deployment Manager button on the Main toolbar and click the  Deployment Jobs tab if it is not active. Click  Deploy .

 
     

 
     [bookmark: pgfId-58713]Security Manager validates all of the policy changes that were made since the last deployment. If the validation results in errors, resolve the errors before attempting to deploy again. If there are only warnings or informational messages, click OK to proceed to the Deploy Saved Changes dialog box.

 
     [bookmark: pgfId-58715]Step 2 In the Deploy Saved Changes dialog box, do the following:

 
      
      		 [bookmark: pgfId-58717]Select the devices to which you want to deploy configurations. The device selector lists all devices for which policy changes were made but not yet deployed, and initially all changed devices are selected for deployment.

 
     

 
     [bookmark: pgfId-58719]All device groups that contain changed devices are shown, and you can select or deselect the devices using the device group folder. If you select or deselect a device that appears in more than one group, it is selected or deselected in all groups; however, a device is deployed to only once in the job. Right-click and select Expand All to open all of the folders.

 
     [bookmark: pgfId-58724]The Deploy Saved Changes dialog box shows the date, time, and user associated with the changes that will be included in the deployment for the selected devices. This information changes based on the devices you select for deployment. If you have Ticket Management enabled, the tickets associated with the changes to be deployed are also displayed. You can click a ticket ID to view details of the ticket and to navigate to an external ticket management system if configured (see Ticket Management Page).

 
     [bookmark: pgfId-58726]If you detect out of band changes, when you close the OOB Changes dialog box, the device names are color-coded based on the results: green indicates out of band change; red indicates an error during the detection process; no color change indicates no out of band changes.

 
      
      		 [bookmark: pgfId-58731]If you want to add devices that do not have policy changes to the deployment job, click  Add other devices to open the Add Other Devices dialog box (see Add Other Devices Dialog Box). You might want to add unchanged devices if a device was manually modified and you want to return the device to its previous configuration (the one stored in the Security Manager database).

 
      		 [bookmark: pgfId-58736](Optional) To change the method used to deploy configurations, click  Edit Deploy Method to open the Edit Deployment Method dialog box (see Edit Deploy Method Dialog Box). There is a system default deployment method (which your organization chooses), so you might not need to change the method. You can select these methods:

 
     

 
     [bookmark: pgfId-58744] – Device—Deploys the configuration directly to the device or to the transport mechanism specified for the device. For more information, see Deploying Directly to a Device or Deploying to a Device through an Intermediate Server.

 
     [bookmark: pgfId-58749] – File—Deploys the configuration file to a directory you select on the Security Manager server. For more information, see Deploying to a File.

 
     [bookmark: pgfId-58751]Before proceeding with the deployment, you can do the following:

 
      
      		 [bookmark: pgfId-58756]Preview proposed configurations and compare them against last deployed configurations or current running configurations. Right-click the device and select  Preview Config . For more information, see Previewing Configurations.

 
      		 [bookmark: pgfId-58764]Analyze the devices for out of band changes by clicking the  Detect OOB Changes button. For more information, see Detecting and Analyzing Out of Band Changes and OOB (Out of Band) Changes Dialog Box.

 
     

 
     [bookmark: pgfId-58766]Step 3 Click Deploy to start the deployment job for the selected devices, which generates the required configuration files and applies them according to your selected deployment method.

 
     [bookmark: pgfId-58768]The Deployment Status Details dialog box opens so that you can view the status of the deployment. It displays summary information about the job, status about the deployment to each device, and messages indicating why the deployment failed.

 
     [bookmark: pgfId-58773]In the Deployment Details table, select a row corresponding to a device to display deployment status messages specifically for that device. For more information, see Deployment Status Details Dialog Box.

 
     [bookmark: pgfId-58778]If deployment to any device failed, you can redeploy configurations to the failed devices. For more information, see Redeploying Configurations to Devices.

 
     [bookmark: pgfId-58780]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-58798][bookmark: 25369][bookmark: dppage_cncpt_EditDeployMethodDialogBox]Edit Deploy Method Dialog Box[bookmark: marker-58790][bookmark: marker-58792][bookmark: marker-58794][bookmark: marker-58796]

 
     [bookmark: pgfId-58800]Use the Edit Deploy Method dialog box to specify whether to deploy the generated configurations directly to the devices in the network or to create configuration files in a directory on the Security Manager server.

 
     [bookmark: pgfId-58802]Navigation Path

 
     [bookmark: pgfId-58804]Click Edit Deploy Method in the Deployment—Create or Edit a Job dialog box (Workflow mode) or Deploy Saved Changes dialog box (non-Workflow mode). For the procedures, see:

 
      
      		 [bookmark: pgfId-58809]Creating and Editing Deployment Jobs

 
      		 [bookmark: pgfId-58814]Deploying Configurations in Non-Workflow Mode

 
     

 
     [bookmark: pgfId-58816]Related Topics

 
      
      		 [bookmark: pgfId-58821]Understanding Deployment Methods

 
      		 [bookmark: pgfId-58826]Deploying Configurations in Workflow Mode

 
      		 [bookmark: pgfId-58831]Deploying Configurations Using an Auto Update Server or CNS Configuration Engine

 
      		 [bookmark: pgfId-58836]Deploying Configurations to a Token Management Server

 
      		 [bookmark: pgfId-58841]Managing Device Communication Settings and Certificates

 
     

 
     [bookmark: pgfId-58843]Field Reference

 
     [bookmark: pgfId-58846] 

 
      
       
        
        [bookmark: pgfId-55774]Table 8-9 [bookmark: 25417]Edit Deploy Method Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-55780]Element
          
  
         		
           
           [bookmark: pgfId-55782]Description
          
  
        

 
         
         		[bookmark: pgfId-55788]Device

  
         		[bookmark: pgfId-55790]The name of the device.

  
        

 
         
         		[bookmark: pgfId-55796]Method

  
         		[bookmark: pgfId-55798]The deployment method to use:

 
           
           		 [bookmark: pgfId-55806]Device—Deploys the configuration directly to the device or to the transport mechanism specified for the device. For more information, see Deploying Directly to a Device or Deploying to a Device through an Intermediate Server.

 
           		 [bookmark: pgfId-55811]File—Deploys the configuration file to a directory on the Security Manager server. If you select File, specify the directory to which you want to deploy the configuration file in the Destination column. You cannot use file deployment with IPS devices. For more information, see Deploying to a File.

 
          

 . The Edit Selected Deploy Method dialog box opens where you can make your selections.

  
        

 
         
         		[bookmark: pgfId-55819]Destination

  
         		[bookmark: pgfId-55821]If you selected File in the Method field, enter the directory to which you want to deploy the configuration file. Click Browse to select from a list of available directories.

  
        

 
         
         		[bookmark: pgfId-55827]Preview Config button

  
         		[bookmark: pgfId-55832]Click this button to display the proposed configuration changes for the selected device. You can compare it to the last deployed configuration or the current running configuration. For more information, see Previewing Configurations.

  
        

 
         
         		[bookmark: pgfId-55838]Out of Band Change Behavior

  
         		[bookmark: pgfId-55843]Click the radio button corresponding to the action you want Security Manager to take regarding changes made directly on the device using the CLI. For a complete explanation of how to handle out-of-band changes, including the meaning of the available options, see Understanding How Out-of-Band Changes are Handled.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-58858][bookmark: 25466][bookmark: dppage_cncpt_WarningPartialVPNDeploymentDialogBox]Warning - Partial VPN Deployment Dialog Box[bookmark: marker-58854][bookmark: marker-58856]

 
     [bookmark: pgfId-58860]Use the Partial VPN Deployment dialog box to select other devices that are part of a VPN to which you are deploying configurations.

 
     [bookmark: pgfId-58862]When you create a deployment job and the job contains devices in a VPN, you must select all of the devices in the VPN. If you select a subset of devices and try to deploy to only those devices, this dialog box appears so that you can select the other devices that are part of the VPN.

 
     [bookmark: pgfId-58864]Navigation Path

 
      
      		 [bookmark: pgfId-58866]Non-Workflow mode—If you select a subset of devices in a VPN in the Deploy Saved Changes dialog box, this dialog box appears when you click  Deploy .

 
      		 [bookmark: pgfId-58868]Workflow mode—If you select a subset of devices in a VPN in the Create or Edit a Job dialog box, this dialog box appears when you click  OK .

 
     

 
     [bookmark: pgfId-58870]Related Topics

 
      
      		 [bookmark: pgfId-58875]Creating and Editing Deployment Jobs

 
      		 [bookmark: pgfId-58880]Deploying Configurations in Non-Workflow Mode

 
      		 [bookmark: pgfId-58885]Deploying Configurations in Workflow Mode

 
     

 
     [bookmark: pgfId-58887]Field Reference

 
     [bookmark: pgfId-58890] 

 
      
       
        
        [bookmark: pgfId-55856]Table 8-10 [bookmark: 25501]Partial VPN Deployment Warning Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-55862]Element
          
  
         		
           
           [bookmark: pgfId-55864]Description
          
  
        

 
         
         		[bookmark: pgfId-55870]VPN

  
         		[bookmark: pgfId-55872]The name of the VPN.

  
        

 
         
         		[bookmark: pgfId-55878]Missing Devices

  
         		[bookmark: pgfId-55880]All the devices in the VPN that were not selected for deployment.

  
        

 
         
         		[bookmark: pgfId-55886]Is Device in Other Job

  
         		[bookmark: pgfId-55888]Whether the missing device is part of another deployment job.

  
        

 
         
         		[bookmark: pgfId-55894]Deploy to All Devices in VPN button

  
         		[bookmark: pgfId-55896]Click this button to deploy to all devices in the VPN.

 [bookmark: pgfId-55898]You can deploy to all devices in the VPN only if the devices are not in other deployment jobs.

  
        

 
         
         		[bookmark: pgfId-55904]Deploy to Selected Devices button

  
         		[bookmark: pgfId-55906]Click this button to deploy only to the devices selected in the Create or Edit a Job or Deploy Saved Changes dialog boxes.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-58902][bookmark: 25538][bookmark: dppage_cncpt_DeploymentStatusDetailsDialogBox]Deployment Status Details Dialog Box[bookmark: marker-58898][bookmark: marker-58900]

 
     [bookmark: pgfId-58904]The Deployment Status Details dialog box appears while configurations are being deployed to selected devices. It displays summary information about the job, status about the deployment to each device, and messages indicating why the deployment failed.

 
     [bookmark: pgfId-58906]In the Deployment Details table, select a row corresponding to a device to display deployment status messages for that device.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-58908]Note You can click Close to close this dialog box and continue working in Security Manager while deployment continues.


     
      

     

     

 
     [bookmark: pgfId-58910]Navigation Path

 
     [bookmark: pgfId-58912]From the Deploy Saved Changes dialog box, click Deploy.

 
     [bookmark: pgfId-58914]Related Topics

 
      
      		 [bookmark: pgfId-58919]Overview of the Deployment Process

 
      		 [bookmark: pgfId-58924]Deploying Configurations in Non-Workflow Mode

 
      		 [bookmark: pgfId-58929]Tips for Successful Deployment Jobs

 
      		 [bookmark: pgfId-58934]Managing Device Communication Settings and Certificates

 
      		 [bookmark: pgfId-58939]Device Communication Page

 
     

 
     [bookmark: pgfId-58941]Field Reference

 
     [bookmark: pgfId-58944] 

 
      
       
        
        [bookmark: pgfId-55919]Table 8-11 [bookmark: 25576]Deployment Status Details Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-55925]Element
          
  
         		
           
           [bookmark: pgfId-55927]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-55933]Deployment Status Details
          
  
        

 
         
         		[bookmark: pgfId-55941]Progress Status Bar

  
         		[bookmark: pgfId-55943]A visual representation and percentage of devices that were successfully updated.

  
        

 
         
         		[bookmark: pgfId-55949]Status

  
         		[bookmark: pgfId-55954]The status of the deployment. The possible states are Deploying, Aborted, Successful, and Failed. For descriptions of these states, see Job States in Non-Workflow Mode.

  
        

 
         
         		[bookmark: pgfId-55960]Deployment Job Name

  
         		[bookmark: pgfId-55962]The name of the deployment job.

  
        

 
         
         		[bookmark: pgfId-55968]Devices To Be Deployed

  
         		[bookmark: pgfId-55970]The total number of devices in the deployment job.

  
        

 
         
         		[bookmark: pgfId-55976]Devices Deployed Successfully

  
         		[bookmark: pgfId-55978]The number of devices that were updated successfully.

  
        

 
         
         		[bookmark: pgfId-55984]Devices Deployed With Errors

  
         		[bookmark: pgfId-55986]The number of devices that failed to be updated.

  
        

 
         
         		 [bookmark: pgfId-55992]Deployment Details

 [bookmark: pgfId-55994]This table lists the devices that are included in the deployment job.

  
        

 
         
         		[bookmark: pgfId-56002]Device

  
         		[bookmark: pgfId-56004]The name of the device.

  
        

 
         
         		[bookmark: pgfId-56010]Status

  
         		[bookmark: pgfId-56015]The status of the deployment to the device. For descriptions of these states, see Job States in Non-Workflow Mode.

  
        

 
         
         		[bookmark: pgfId-56021]Summary

  
         		[bookmark: pgfId-56023]The number of warnings, errors, and failures for the device.

  
        

 
         
         		[bookmark: pgfId-56029]Method

  
         		[bookmark: pgfId-56031]The method of deployment to the device. Possible methods are File and Device.

  
        

 
         
         		[bookmark: pgfId-56037]Config

  
         		[bookmark: pgfId-56042]The device configuration file. Double click the icon to preview the configuration for a device. For more information, see Previewing Configurations.

  
        

 
         
         		[bookmark: pgfId-56048]Transcript

  
         		[bookmark: pgfId-56050]The commands Security Manager issued to the device and the responses from the device during deployment if you are deploying to the device (instead of deploying to a file). Double-click the icon to see the transcript for a device.

  
        

 
         
         		[bookmark: pgfId-56056]Last Ticket(s)

  
         		[bookmark: pgfId-56061]The tickets containing changes that are part of the deployment for the device. You can click on the Ticket IDs to view additional information about the ticket, such as Creator and Last Modified date. If linkage to an external ticket management system has been configured, you can also navigate to that system from the ticket details (see Ticket Management Page).

  
        

 
         
         		[bookmark: pgfId-56067]Messages

  
         		[bookmark: pgfId-56069]The warning, error, and failure messages, as indicated by the severity icon.

 [bookmark: pgfId-56071]When you select an item, the Description box to the right describes the message in detail. The Action box to the right provides information on how you can correct the problem.

  
        

 
         
         		[bookmark: pgfId-56077]Generate Report button

  
         		[bookmark: pgfId-56082]Click this button to create a deployment status report for this job. You can generate the report in HTML and PDF formats. The report includes a summary of the job plus the full and delta configurations and the job transcript. You can use this report for your own purposes or to aid in troubleshooting a problem with Cisco TAC. For more information, see Generating Deployment or Discovery Status Reports.

  
        

 
         
         		[bookmark: pgfId-56088]Refresh button

  
         		[bookmark: pgfId-56090]Click this button to update the status information.

  
        

 
         
         		[bookmark: pgfId-56096]Abort button

  
         		[bookmark: pgfId-56098]Click this button to abort the deployment job. You can abort deployment jobs only while they are in the Deploying, Scheduled, or Rolling Back state. Aborting a job stops deployment of configuration files to pending devices, but has no effect on devices to which deployments are in progress (commands are being written to a device) or to which deployment has already completed successfully.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-58956][bookmark: 25690][bookmark: dpman_proc_DeployingConfigurationsinWorkflowMode]Deploying Configurations in Workflow Mode[bookmark: marker-58950][bookmark: marker-58952][bookmark: marker-58954]

 
     [bookmark: pgfId-58958]The task of deploying configurations in Workflow mode is a multiple step process. You must create a deployment job, get it approved, and then deploy the job. This process ensures that organizations that separate task authorizations among personnel can implement their control processes.

 
     [bookmark: pgfId-58963]When you deploy configurations, you can transfer them to devices either directly or to another transport server (such as AUS, CNS, or TMS) in the network or create them as configuration files in a directory on the Security Manager server. See Understanding Deployment Methods for more information.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-58968]Tip Before creating the deployment job, read Tips for Successful Deployment Jobs. That topic includes tips and cautions you should keep in mind when creating deployment jobs.


     
      

     

     

 
     [bookmark: pgfId-58970]Before You Begin

 
      
      		 [bookmark: pgfId-58975]Make sure that devices have been bootstrapped. For more information, see Chapter 2, “Preparing Devices for Management”.

 
      		 [bookmark: pgfId-58977]If you are deploying to a transport server, such as AUS, CNS, or TMS, make sure the server, Security Manager settings, and device have been set up properly.

 
     

 
     [bookmark: pgfId-58979]Related Topics

 
      
      		 [bookmark: pgfId-58984]Overview of the Deployment Process

 
      		 [bookmark: pgfId-58989]Including Devices in Deployment Jobs or Schedules

 
      		 [bookmark: pgfId-58994]Understanding Deployment Methods

 
      		 [bookmark: pgfId-58999]Deploying Configurations Using an Auto Update Server or CNS Configuration Engine

 
      		 [bookmark: pgfId-59004]Deploying Configurations to a Token Management Server

 
      		 [bookmark: pgfId-59009]Managing Device Communication Settings and Certificates

 
      		 [bookmark: pgfId-59014]Understanding How Out-of-Band Changes are Handled

 
     

 
     
 
     [bookmark: pgfId-59016]Step 1 Click the Deployment Manager button in the Main toolbar.

 
     [bookmark: pgfId-59018]The Deployment Manager window appears. Click the Deployment Jobs tab if it is not active.

 
     [bookmark: pgfId-59023]Step 2 Create the deployment job. Click Create and enter the job properties. For the procedure, see Creating and Editing Deployment Jobs.

 
     [bookmark: pgfId-59025]When you finish creating a job, you can select whether to submit it. If you are not using a deployment job approver, you can also automatically submit, approve, and deploy the job, in which case you do not need to complete the other steps in this procedure.

 
     [bookmark: pgfId-59030]Step 3 (Workflow with approver) Submit the job. If you did not submit the job, select it in the Deployment Manager window and click Submit. An e-mail is sent to the approver. For more information, see Submitting Deployment Jobs.

 
     [bookmark: pgfId-59035]Step 4 (Workflow with or without an approver) Approve the job. If you did not approve the job when you created it, select it in the Deployment Manager window and click Approve. If there is a separate person who approves jobs, that person must perform this step. For more information, see Approving and Rejecting Deployment Jobs.

 
     [bookmark: pgfId-59040]Step 5 (Workflow with or without an approver) Deploy the job. If you did not deploy the job when you created it, select it in the Deployment Manager window and click Deploy. You can specify a future time to start the job, or start it immediately, and configurations are deployed according to the properties of the job. For more information, see Deploying a Deployment Job in Workflow Mode

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59045]Note You can discard a deployment job at any time before you deploy it. For more information, see Discarding Deployment Jobs.


     
      

     

     

 
     [bookmark: pgfId-59047]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-59063][bookmark: 25766][bookmark: dpman_proc_CreatingDeploymentJobs]Creating and Editing Deployment Jobs[bookmark: marker-59055][bookmark: marker-59057][bookmark: marker-59059][bookmark: marker-59061]

 
     [bookmark: pgfId-59065]In Workflow mode, before you deploy policy configurations to your devices, you must create a deployment job. When you create a job, you select the devices to which you want to deploy the configurations, whether you want to deploy directly to the devices or to an output file, and when you want the job to take place.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59070]Tip Before creating the deployment job, read Tips for Successful Deployment Jobs. That topic includes tips and cautions you should keep in mind when creating deployment jobs.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     
      [bookmark: pgfId-59072]
      Caution You must configure at least one policy on a device before deploying to that device. If you deploy to a device without assigning at least one policy, the device’s current configuration is overwritten with a blank configuration.
       
       
 
      

     
 
     [bookmark: pgfId-59074]Before You Begin

 
      
      		 [bookmark: pgfId-59079]Make sure that devices have been bootstrapped. For more information, see Chapter 2, “Preparing Devices for Management”.

 
      		 [bookmark: pgfId-59081]If you are deploying to a transport server, such as AUS, CNS, or TMS, make sure the server, Security Manager settings, and device have been set up properly.

 
     

 
     [bookmark: pgfId-59083]Related Topics

 
      
      		 [bookmark: pgfId-59088]Overview of the Deployment Process

 
      		 [bookmark: pgfId-59093]Including Devices in Deployment Jobs or Schedules

 
      		 [bookmark: pgfId-59098]Understanding Deployment Methods

 
      		 [bookmark: pgfId-59103]Understanding How Out-of-Band Changes are Handled

 
      		 [bookmark: pgfId-59108]Job States in Workflow Mode

 
     

 
     
 
     [bookmark: pgfId-59110]Step 1 Click the Deployment Manager button in the Main toolbar.

 
     [bookmark: pgfId-59112]The Deployment Manager window appears. Click the Deployment Jobs tab if it is not active.

 
     [bookmark: pgfId-59114]Step 2 Do one of the following:

 
      
      		 [bookmark: pgfId-59116]Click  Create to create a new job.

 
      		 [bookmark: pgfId-59118]Select an editable job and click  Open to edit the job. You cannot edit a job that has already been deployed.

 
     

 
     [bookmark: pgfId-59120]The Create a Job or Edit a Job dialog box opens.

 
     [bookmark: pgfId-59122]Step 3 In the dialog box, do the following to define the contents of the job:

 
      
      		 [bookmark: pgfId-59124] Job Name and Description —Keep the default job name or enter a more meaningful name. Because the job name enables you to distinguish one job from another, you should assign a name that reflects the contents of the job. You cannot change the name after you create the job. Optionally, enter a description of the job.

 
      		 [bookmark: pgfId-59126]Select the devices to which you want to deploy configurations. The device selector lists all devices for which policy changes were made but not yet deployed, and initially all changed devices are selected for deployment.

 
     

 
     [bookmark: pgfId-59128]All device groups that contain changed devices are shown, and you can select or deselect the devices using the device group folder. If you select or deselect a device that appears in more than one group, it is selected or deselected in all groups; however, a device is deployed to only once in the job. Right-click and select Expand All to open all of the folders.

 
     [bookmark: pgfId-59130]If you detect out of band changes, when you close the OOB Changes dialog box, the device names are color-coded based on the results: green indicates out of band change; red indicates an error during the detection process; no color change indicates no out of band changes.

 
      
      		 [bookmark: pgfId-59135]If you want to add devices that do not have policy changes to the deployment job, click  Add other devices to open the Add Other Devices dialog box (see Add Other Devices Dialog Box). You might want to add unchanged devices if a device was manually modified and you want to return the device to its previous configuration (the one stored in the Security Manager database).

 
      		 [bookmark: pgfId-59140](Optional) To change the method used to deploy configurations, click  Edit Deploy Method to open the Edit Deployment Method dialog box (see Edit Deploy Method Dialog Box). There is a system default deployment method (which your organization chooses), so you might not need to change the method. You can select these methods:

 
     

 
     [bookmark: pgfId-59148] – Device—Deploys the configuration directly to the device or to the transport mechanism specified for the device. For more information, see Deploying Directly to a Device or Deploying to a Device through an Intermediate Server.

 
     [bookmark: pgfId-59153] – File—Deploys the configuration file to a directory you select on the Security Manager server. For more information, see Deploying to a File.

 
     [bookmark: pgfId-59155]Before proceeding with the deployment, you can do the following:

 
      
      		 [bookmark: pgfId-59160]Preview proposed configurations and compare them against last deployed configurations or current running configurations. Right-click the device and select  Preview Config . For more information, see Previewing Configurations.

 
      		 [bookmark: pgfId-59168]Analyze the devices for out of band changes by clicking the  Detect OOB Changes button. For more information, see Detecting and Analyzing Out of Band Changes and OOB (Out of Band) Changes Dialog Box.

 
     

 
     [bookmark: pgfId-59170]Step 4 Select how you want the job handled when you close the dialog box. The options available to you depend on whether you are using Workflow mode with a deployment job approver:

 
      
      		 [bookmark: pgfId-59172] Without an approver —If you are not using a separate approver, you have these options:

 
     

 
     [bookmark: pgfId-59174] – Close the job—Close the job and leave it in the edit state. Select this option if you know you want to make additional modifications to the job.

 
     [bookmark: pgfId-59176] – Approve the job—Close the job and approve it but do not deploy it. Configure the following:

 
     [bookmark: pgfId-59178] – Comments—(Optional) Comments about the job approval.

 
     [bookmark: pgfId-59180] – Submitter—The e-mail address of the person submitting the job for approval. Notifications of job state changes are sent to this address, which is initially the e-mail address associated with the user account you used to log into Security Manager. Ensure that the address is the correct one so that you receive the notifications.

 
     [bookmark: pgfId-59182] – Deploy the job—Close the job, approve it, and deploy it. Configure the following:

 
     [bookmark: pgfId-59184] – Options—Whether to Deploy Now or Schedule. If you select Schedule, additional fields appear where you can specify the date and time when the job should be run. The time is in 24-hour format and is based on the time zone of the Security Manager server, which is not necessarily the same time zone that you are currently in. The target time must be at least five minutes in the future.

 
     [bookmark: pgfId-59186] – Comments—(Optional) Comments about the deployment job.

 
     [bookmark: pgfId-59188] – Send Deployment Status Notification—Whether Security Manager should send e-mail notifications whenever the job status changes.

 
     [bookmark: pgfId-59190]If you select this option, enter the e-mail addresses of the people who should receive notifications in the Job Completion Recipients field. If you enter multiple addresses, separate them with commas. The field initially contains the default approver and your e-mail addresses.

 
      
      		 [bookmark: pgfId-59192] With an approver —If you are using a separate approver, you can configure the following options:

 
     

 
     [bookmark: pgfId-59194] – Submit the job—Whether to submit the job for approval. By default this check box is selected.

 
     [bookmark: pgfId-59196] – Approver E-mail—The e-mail address of the approver if you are submitting the job for approval. The default approver e-mail address is entered in the field, but you can change it.

 
     [bookmark: pgfId-59198] – Comments—(Optional) Comments you want to send to the approver, if any.

 
     [bookmark: pgfId-59200] – Submitter E-mail—The e-mail address of the submitter. The field initially contains the e-mail address associated with the user account you used to log in, but you can change it to another address.

 
     [bookmark: pgfId-59202]Step 5 Click OK.

 
     [bookmark: pgfId-59204]Depending on your selection for how to handle the job, you might still need to submit, approve, and deploy the job. See these topics for more information:

 
      
      		 [bookmark: pgfId-59209]Submitting Deployment Jobs

 
      		 [bookmark: pgfId-59214]Approving and Rejecting Deployment Jobs

 
      		 [bookmark: pgfId-59219]Deploying a Deployment Job in Workflow Mode

 
     

 
     [bookmark: pgfId-59221]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-59237][bookmark: 25932][bookmark: dpman_proc_SubmittingDeploymentJobs]Submitting Deployment Jobs[bookmark: marker-59229][bookmark: marker-59231][bookmark: marker-59233][bookmark: marker-59235]

 
     [bookmark: pgfId-59239]In some organizations, before jobs can be deployed, they must be approved by a separate user with the appropriate permissions. In this case, Workflow mode is enabled with a deployment job approver, and you must submit the job to this user for review. The user reviews the job and either approves or rejects it.

 
     [bookmark: pgfId-59244]If you are using Workflow mode without a deployment job approver, you can review and approve the job yourself. You do not submit jobs in this mode. For more information, see Approving and Rejecting Deployment Jobs.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59249]Note You enable and disable deployment job approval under Tools > Security Manager Administration > Workflow. For more information, see Workflow Page.


     
      

     

     

 
     [bookmark: pgfId-59251]This procedure assumes that you already created the job. You can also submit the job when you create it by selecting the Submit the job checkbox in the Create a Job dialog box.

 
     [bookmark: pgfId-59253]Related Topics

 
      
      		 [bookmark: pgfId-59258]Deployment Manager Window

 
      		 [bookmark: pgfId-59263]Job States in Workflow Mode

 
     

 
     
 
     [bookmark: pgfId-59265]Step 1 Click the Deployment Manager button in the Main toolbar.

 
     [bookmark: pgfId-59267]The Deployment Status window appears. Click the Deployment Jobs tab if it is not active.

 
     [bookmark: pgfId-59269]Step 2 Select the job to submit.

 
     [bookmark: pgfId-59271]Step 3 Click Submit.

 
     [bookmark: pgfId-59273]The Submit Deployment Job dialog box opens.

 
     [bookmark: pgfId-59275]Step 4 Enter the following information:

 
      
      		 [bookmark: pgfId-59277] Approver —The e-mail address of the person to be notified of your submission. The default approver e-mail address is entered in the field, but you can change it.

 
      		 [bookmark: pgfId-59279] Comment —(Optional) Comments you want to send to the approver, if any.

 
      		 [bookmark: pgfId-59281] Submitter —The e-mail address of the person submitting the deployment job. The field initially contains the e-mail address associated with the username you used to log into Security Manager, but you can change it to another e-mail address.

 
     

 
     [bookmark: pgfId-59283]Step 5 Click OK.

 
     [bookmark: pgfId-59285]The job status changes to Submitted. The approver must approve the job before you can deploy it.

 
     [bookmark: pgfId-59287]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-59309][bookmark: 25997][bookmark: dpman_proc_ApprovingandRejectingDeploymentJobs]Approving and Rejecting Deployment Jobs[bookmark: marker-59293][bookmark: marker-59295][bookmark: marker-59297][bookmark: marker-59299][bookmark: marker-59301][bookmark: marker-59303][bookmark: marker-59305][bookmark: marker-59307]

 
     [bookmark: pgfId-59311]In some organizations, before jobs can be deployed, they must be approved by a separate user with the appropriate permissions. In Workflow mode with a deployment job approver, one user submits a job, and another one previews the job and either approves or rejects it.

 
     [bookmark: pgfId-59316]In Workflow mode without a deployment job approver, you can create and approve the job at the same time. For more information, see Creating and Editing Deployment Jobs.

 
     [bookmark: pgfId-59318]When you reject a job, the devices in the job immediately become available for inclusion in other jobs. A rejected job cannot be deployed, but it can be opened for viewing and editing.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59323]Note You enable and disable deployment job approval under Tools > Security Manager Administration > Workflow. For more information, see Workflow Page


     
      

     

     

 
     [bookmark: pgfId-59325]Related Topics

 
      
      		 [bookmark: pgfId-59330]Deployment Manager Window

 
      		 [bookmark: pgfId-59335]Job States in Workflow Mode

 
     

 
     
 
     [bookmark: pgfId-59337]Step 1 Click the Deployment Manager button in the Main toolbar.

 
     [bookmark: pgfId-59339]The Deployment Manager window appears. Click the Deployment Jobs tab if it is not active.

 
     [bookmark: pgfId-59341]Step 2 Select a submitted job and do one of the following:

 
      
      		 [bookmark: pgfId-59343]Click  Approve .

 
      		 [bookmark: pgfId-59345]Click  Reject .

 
     

 
     [bookmark: pgfId-59350]You are prompted for an optional comment for your action. The comments are preserved in the history for the job. After submitting your comment, an e-mail notification is sent (if e-mail notifications are configured) and the job status changes to Approved or Rejected, as appropriate. The job can now be deployed (see Deploying a Deployment Job in Workflow Mode).

 
     [bookmark: pgfId-59352]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-59368][bookmark: 26059][bookmark: dpman_proc_DeployingaDeploymentJobinWorkflowMode]Deploying a Deployment Job in Workflow Mode[bookmark: marker-59360][bookmark: marker-59362][bookmark: marker-59364][bookmark: marker-59366]

 
     [bookmark: pgfId-59370]When you work in Workflow mode, to deploy configurations to devices you must create a deployment job and have it approved. If you are working without a separate approver, you can approve and deploy the job yourself. Otherwise, you must submit it to an approver.

 
     [bookmark: pgfId-59372]Deploying a deployment job in workflow mode simply starts a job. You cannot change the contents of a job during deployment.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59374]Note Deployment might take from a few minutes to an hour or more, depending on the number of devices in the deployment job.


     
      

     

     

 
     [bookmark: pgfId-59376]Before You Begin

 
      
      		 [bookmark: pgfId-59381]Make sure that devices have been bootstrapped. For more information, see Chapter 2, “Preparing Devices for Management”.

 
      		 [bookmark: pgfId-59383]If you are deploying to a transport server, such as AUS, CNS, or TMS, make sure the server, Security Manager settings, and device have been set up properly.

 
      		 [bookmark: pgfId-59388]Create a job. For more information, see Creating and Editing Deployment Jobs.

 
      		 [bookmark: pgfId-59393]If using Workflow mode with a deployment job approver, submit the job. For more information, see Submitting Deployment Jobs.

 
      		 [bookmark: pgfId-59398]Approve the job. For more information, see Approving and Rejecting Deployment Jobs.

 
     

 
     [bookmark: pgfId-59400]Related Topics

 
      
      		 [bookmark: pgfId-59405]Overview of the Deployment Process

 
      		 [bookmark: pgfId-59410]Deployment Manager Window

 
      		 [bookmark: pgfId-59415]Including Devices in Deployment Jobs or Schedules

 
      		 [bookmark: pgfId-59420]Understanding Deployment Methods

 
      		 [bookmark: pgfId-59425]Managing Device Communication Settings and Certificates

 
     

 
     
 
     [bookmark: pgfId-59427]Step 1 Click the Deployment Manager button in the Main toolbar.

 
     [bookmark: pgfId-59429]The Deployment Manager window appears. Click the Deployment Jobs tab if it is not active.

 
     [bookmark: pgfId-59431]Step 2 Select the job to deploy.

 
     [bookmark: pgfId-59433]Step 3 Click Deploy.

 
     [bookmark: pgfId-59435]The Deploy Job dialog box opens.

 
     [bookmark: pgfId-59437]Step 4 In the Deploy Job dialog box, make these selections:

 
      
      		 [bookmark: pgfId-59439] Options —How you want to run the job. Select  Schedule to run the job at some point in the future. Select  Deploy Now to run the job immediately. If you schedule the job for a future time, the changes deployed in the job are based on the changes that existed when the job was created, not when the job is run.

 
     

 
     [bookmark: pgfId-59441]If you select Schedule, date and time fields appear.

 
     [bookmark: pgfId-59443] – Click the calendar icon to pick the day on which to run the job.

 
     [bookmark: pgfId-59445] – In the Time field, enter the time to start the job in 24-hour clock format. The time must be in time zone of the Security Manager server, which is not necessarily the same as your time zone. The time must be at least 5 minutes in the future.

 
      
      		 [bookmark: pgfId-59447] Comments —(Optional) An explanation of why you are deploying the job.

 
      		 [bookmark: pgfId-59449] Require Deployment Status Notifications, Job Completion Recipients — Whether Security Manager should send an e-mail when the job status changes.

 
     

 
     [bookmark: pgfId-59451]If you elect to send status notifications, enter the recipient’s e-mail address. The field initially contains the e-mail address associated with the user account you used to log in. You can enter multiple addresses by separating them with commas.

 
     [bookmark: pgfId-59453]Step 5 Click OK.

 
     [bookmark: pgfId-59455]You are returned to the Deployment Manager window. The job status changes to Deploying. When the deployment is complete, the job status changes to Deployed.

 
     [bookmark: pgfId-59457]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-59469][bookmark: 26153][bookmark: dpman_proc_DiscardingDeploymentJobs]Discarding Deployment Jobs[bookmark: marker-59463][bookmark: marker-59465][bookmark: marker-59467]

 
     [bookmark: pgfId-59471]In Workflow mode, you can discard a job when it is in any state except Deployed, Deployment Failed, or Aborted. The job state is shown as discarded until the job is purged from the system, either automatically as set on the Workflow Management page or manually.

 
     [bookmark: pgfId-59473]Related Topics

 
      
      		 [bookmark: pgfId-59478]Deployment Manager Window

 
      		 [bookmark: pgfId-59483]Job States in Workflow Mode

 
     

 
     
 
     [bookmark: pgfId-59485]Step 1 Click the Deployment Manager button in the Main toolbar.

 
     [bookmark: pgfId-59487]The Deployment Manager window appears. Click the Deployment Jobs tab if it is not active.

 
     [bookmark: pgfId-59489]Step 2 Select the job to discard.

 
     [bookmark: pgfId-59491]Step 3 Click Discard. You are prompted for an optional comment to explain why you are discarding the job.

 
     [bookmark: pgfId-59493]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-59511][bookmark: 26190][bookmark: dpman_proc_DeployingConfigurationsUsinganAutoUpdateServerorConfigurationEngine]Deploying Configurations Using an Auto Update Server or CNS Configuration Engine[bookmark: marker-59499][bookmark: marker-59501][bookmark: marker-59503][bookmark: marker-59505][bookmark: marker-59507][bookmark: marker-59509]

 
     [bookmark: pgfId-59513]If your organization uses Auto Update Server (AUS) or Cisco Networking Services (CNS) Configuration Engine to manage the deployment of configurations to your network devices, you can use these intermediate servers with Security Manager. To perform this type of deployment, you need to set up the device, the AUS or Configuration Engine, and Security Manager properly. This procedure explains the tasks that you need to perform.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59515]Tip You cannot successfully deploy a configuration to AUS that requires Security Manager to download other files to the device. For example, some remote access VPN policies allow you to configure plug-ins, Anyconnect clients, and Cisco Secure Desktop configurations. These files are not sent to AUS. Do not use AUS if you want to configure these types of policy.


     
      

     

     

 
     [bookmark: pgfId-59517]Related Topics

 
      
      		 [bookmark: pgfId-59522]Overview of the Deployment Process

 
      		 [bookmark: pgfId-59527]Chapter 2, “Preparing Devices for Management”

 
      		 [bookmark: pgfId-59532]Including Devices in Deployment Jobs or Schedules

 
      		 [bookmark: pgfId-59537]Understanding Deployment Methods

 
      		 [bookmark: pgfId-59542]Managing Device Communication Settings and Certificates

 
     

 
     
 
     [bookmark: pgfId-59544]Step 1 Set up the AUS or Configuration Engine using the documentation for those products.

 
     [bookmark: pgfId-59546]Step 2 Configure the devices to use the server. The following topics describe the configuration steps depending on the type of server and the desired setup:

 
      
      		 [bookmark: pgfId-59551]Setting Up AUS on PIX Firewall and ASA Devices

 
      		 [bookmark: pgfId-59556]Setting Up CNS on Cisco IOS Routers in Event-Bus Mode

 
      		 [bookmark: pgfId-59561]Setting Up CNS on Cisco IOS Routers in Call-Home Mode

 
     

 
     [bookmark: pgfId-59563]Step 3 When you add the device to Security Manager, select the AUS or Configuration Engine for the device if your chosen method allows it. If the AUS or Configuration Engine is not already defined in Security Manager, you can identify it to Security Manager as you add the network device. For detailed procedures, see these topics:

 
      
      		 [bookmark: pgfId-59568]Adding Devices from the Network

 
      		 [bookmark: pgfId-59573]Adding Devices from Configuration Files

 
      		 [bookmark: pgfId-59578]Adding Devices by Manual Definition

 
      		 [bookmark: pgfId-59583]Adding Devices from an Inventory File

 
      		 [bookmark: pgfId-59588]Adding, Editing, or Deleting Auto Update Servers or Configuration Engines

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59590]Tip After you add a device to the Security Manager inventory, you can change the assigned server in the device properties. Right-click the device and select Device Properties. Configure the server using the device properties if you could not identify it while adding the device.


     
      

     

     

 
     [bookmark: pgfId-59592]Step 4 For devices that are using AUS, configure the AUS policy for the device in Security Manager. Do one of the following:

 
      
      		 [bookmark: pgfId-59594]Configure the policy for a single device. In Device view, select the device, and then select  Platform > Device Admin > Server Access > AUS from the Device Policy selector.

 
      		 [bookmark: pgfId-59596]Configure a shared policy that you can assign to many devices that share the same AUS. In Policy view, select  PIX/ASA/FWSM Platform > Device Admin > Server Access > AUS from the Policy Types selector. Right-click  AUS and select  New AUS Policy to create a policy, or select an existing policy from the Policies selector to change the policy. Select the Assignments tab to assign the policy to specific devices.

 
     

 
     [bookmark: pgfId-59598]The server you identify in this policy must also be the server you identify in the device properties. The device properties identify the server to which Security Manager will send the configuration, whereas the AUS policy defines the server the device will contact.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59600]Tip If you change AUS servers, keep in mind that the device will continue to use the AUS server defined in its current configuration until it receives a new configuration. Thus, you should change the AUS policy but deploy the configuration using the previous AUS server. After deployment is successful, change the device properties to point to the new server.


     
      

     

     

 
     [bookmark: pgfId-59602]Step 5 In Security Manager, deploy your configurations using the Deploy to Device deployment method. Security Manager sends the configuration to the AUS or Configuration Engine, where the network device retrieves it.

 
     [bookmark: pgfId-59604]Depending on the Workflow mode you are using, follow these procedures:

 
      
      		 [bookmark: pgfId-59609]Deploying Configurations in Non-Workflow Mode

 
      		 [bookmark: pgfId-59614]Deploying Configurations in Workflow Mode

 
     

 
     [bookmark: pgfId-59616]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-59632][bookmark: 26292][bookmark: dpman_proc_DeployingConfigurationstoaTokenManagementServer]Deploying Configurations to a Token Management Server[bookmark: marker-59622][bookmark: marker-59624][bookmark: marker-59626][bookmark: marker-59628][bookmark: marker-59630]

 
     [bookmark: pgfId-59634]If your organization requires the use of a Token Management Server (TMS) for applying configuration updates to routers, you can use Security Manager in conjunction with your TMS processes. To perform this type of deployment, you need to set up the device, TMS, and Security Manager properly. This procedure explains the tasks that you need to perform.

 
     [bookmark: pgfId-59636]Related Topics

 
      
      		 [bookmark: pgfId-59641]Overview of the Deployment Process

 
      		 [bookmark: pgfId-59646]Chapter 2, “Preparing Devices for Management”

 
      		 [bookmark: pgfId-59651]Including Devices in Deployment Jobs or Schedules

 
      		 [bookmark: pgfId-59656]Understanding Deployment Methods

 
      		 [bookmark: pgfId-59661]Managing Device Communication Settings and Certificates

 
     

 
     
 
     [bookmark: pgfId-59663]Step 1 Set up the TMS as an FTP server. Security Manager uses FTP to deploy the configuration file to the TMS, from which it can be downloaded and encrypted onto an eToken. The eToken can then be connected to the USB port of a router and the configuration downloaded. See the TMS product documentation for more information.

 
     [bookmark: pgfId-59665]Step 2 In Security Manager, select Tools > Security Manager Administration > Token Management to identify the TMS server to Security Manager.

 
     [bookmark: pgfId-59670]By default, Security Manager uses the Security Manager server as the TMS, but you can specify a different server. You must enter the hostname or IP address, a username and password for the TMS, the directory to which configuration files should be copied, and the public key file location in Security Manager. For more information, see Token Management Page.

 
     [bookmark: pgfId-59672]Step 3 Specify TMS as the transport protocol to be used for Cisco IOS routers.

 
     [bookmark: pgfId-59674]You can set this parameter globally for all Cisco IOS routers or for a specific device:

 
      
      		 [bookmark: pgfId-59676]Globally—Select  Tools > Security Manager Administration > Device Communication and select TMS in  Transport Protocol (IOS Routers 12.3 and above) .

 
      		 [bookmark: pgfId-59678]Device—Right click the device in the Device selector and select  Device Properties . On the General tab, select TMS as the transport protocol in the Device Communications Group. Because not all routers support TMS, you might not be able to configure TMS for specific devices.

 
     

 
     [bookmark: pgfId-59680]Step 4 In Security Manager, deploy your configurations using the Deploy to Device deployment method. Security Manager sends the delta configuration to the TMS server.

 
     [bookmark: pgfId-59682]Depending on the Workflow mode you are using, follow these procedures:

 
      
      		 [bookmark: pgfId-59687]Deploying Configurations in Non-Workflow Mode

 
      		 [bookmark: pgfId-59692]Deploying Configurations in Workflow Mode

 
     

 
     [bookmark: pgfId-59694]Step 5 Using the TMS, download the configuration to the eToken. See the TMS product documentation for more information.

 
     [bookmark: pgfId-59696]Step 6 Download the configuration from the eToken to the router and save the configuration to the device. Plug the eToken into the router, then enter the following commands to download the configuration to the router, where usb_token_id is either usbtoken0 or usbtoken1, depending on which USB port you used. The default PIN is 1234567890.

 
     
      [bookmark: pgfId-59698] 
     

     
      [bookmark: pgfId-59700]router# crypto pki token usb_token_id login PIN 
     

     
      [bookmark: pgfId-59702]router# config terminal 
     

     
      [bookmark: pgfId-59704]router(config)# crypto pki token default secondary config CCCD 
     

     
      [bookmark: pgfId-59706]router(config)# exit 
     

     
      [bookmark: pgfId-59708]router# write memory
     

     
      [bookmark: pgfId-59710] 
     

      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59712]Tip CCCD is the private sector on the eToken where the configuration file resides. When you enter the crypto pki token default secondary config CCCD command, the CLI on the e-token merges with the CLI on the router.


     
      

     

     

 
     [bookmark: pgfId-59714]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-59734][bookmark: 26384][bookmark: dpman_cncpt_PreviewingConfigurations]Previewing Configurations[bookmark: marker-59726][bookmark: marker-59728][bookmark: marker-59730][bookmark: marker-59732]

 
     [bookmark: pgfId-59736]There are many ways to preview a device configuration. You can select a device from the Device selector and select Tools > Preview Configuration, or you can click the Preview Config button in several dialog boxes.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59738]Tip You can also right click a device in Map view and select Preview Configuration.


     
      

     

     

 
     [bookmark: pgfId-59740]When you preview a configuration, the configuration is displayed in the Config Version Viewer dialog box. The proposed configuration is on the left. You can select to view the delta configuration (which shows the changes since the last deployment) or the full configuration. You can also compare the configuration to the last one deployed to the device or the current running configuration in the right pane.

 
     [bookmark: pgfId-59742]The contents of the proposed configuration can differ depending on where you view it from:

 
      
      		 [bookmark: pgfId-59744]If you use  Tools > Preview Configuration , or right click the device in the Device selector and select  Preview Configuration , the proposed configuration includes changes that you have not yet submitted to the database.

 
      		 [bookmark: pgfId-59746]If you preview the configuration while creating a deployment job, the proposed configuration includes only those changes that you have submitted to the database. These are the changes that will be deployed to the device if you start the deployment job.

 
     

 
     [bookmark: pgfId-59748]The value of previewing configurations is that it lets you see the actual device commands that will be used to configure the device. If you are a CLI expert, this can help you verify that you are getting the configuration you expect. Even if you are not a CLI expert, you can use the information to look for more information in the command reference for the operating system on Cisco.com.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1071343]Note New objects are created when you rediscover ASA 8.2.3 devices through Cisco Security Manager after configuring network objects on them. Ignore the CLIs for these new objects that are generated in preview configuration.


     
      

     

     

 
     [bookmark: pgfId-59750]Following are some tips for previewing configurations:

 
      
      		 [bookmark: pgfId-59752]Many configuration options are specific to one or more interfaces. If you must specify an interface name in a policy, the previewed configuration will include the commands for the policy only if the Interfaces policy defines the interface that you specify. Ensure that you configure the Interfaces policy before previewing configurations.

 
      		 [bookmark: pgfId-59754]If you preview the configuration for a virtual sensor, the preview that you see is for the parent device, not the virtual sensor, because the configuration for a virtual sensor is stored on the parent device.

 
      		 [bookmark: pgfId-59759]If you are just curious about what commands a policy will configure, consider adding a dummy device and configure the policy for that device. This will help prevent unintended configuration changes in your real devices. To add a dummy device, use the procedure described in Adding Devices by Manual Definition.

 
      		 [bookmark: pgfId-59761]Policies are validated before you can view the configuration. The validation happens for all devices, not just the device you are previewing. Thus, you might see errors and warnings that apply to different devices. If any errors or warnings occur, the Preview Messages dialog box appears. The dialog box lists all of the messages, including their severity and possible solutions. Click  OK to continue to the Config Version Viewer dialog box. Click  Details to see detailed information on the problems.

 
     

 
     [bookmark: pgfId-59763]The following table explains the fields in the Config Version Viewer window used for previewing configurations.

 
     [bookmark: pgfId-59766] 

 
      
       
        
        [bookmark: pgfId-56111]Table 8-12 [bookmark: 26433]Config Version Viewer (Preview Configuration) Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-56117]Element
          
  
         		
           
           [bookmark: pgfId-56119]Description
          
  
        

 
         
         		[bookmark: pgfId-56125]Proposed Config Type

  
         		[bookmark: pgfId-56127]The type of configuration you want to view. For example, you can view the full configuration or just the delta (the changes from the last deployed configuration). The proposed configuration is displayed in the left pane.

  
        

 
         
         		[bookmark: pgfId-56133]Compare to Version

  
         		[bookmark: pgfId-56135]Choose a configuration to compare against the proposed configuration. The selected configuration is displayed in the right pane.

 
           
           		 [bookmark: pgfId-56137]None—Leaves the reference configuration blank.

 
           		 [bookmark: pgfId-56139]Last Deployed—Displays the last configuration that was deployed to the device and compares it with the proposed configuration.

 
           		 [bookmark: pgfId-56141]Running Config—Displays the current configuration running on the device and compares it with the proposed configuration. The device must be accessible to obtain the running configuration.

 
          

  
        

 
         
         		[bookmark: pgfId-56147]First Difference button

  
         		[bookmark: pgfId-56149]Moves the cursor to the first difference noted between the proposed and reference configurations.

  
        

 
         
         		[bookmark: pgfId-56155]Previous Difference button

  
         		[bookmark: pgfId-56157]Moves the cursor to the previous difference noted between the proposed and reference configurations.

  
        

 
         
         		[bookmark: pgfId-56163]Current Difference button

  
         		[bookmark: pgfId-56165]Centers the currently selected difference on the page.

  
        

 
         
         		[bookmark: pgfId-56171]Next Difference button

  
         		[bookmark: pgfId-56173]Moves the cursor to the next difference noted between the proposed and reference configurations.

  
        

 
         
         		[bookmark: pgfId-56179]Last Difference button

  
         		[bookmark: pgfId-56181]Moves the cursor to the last difference noted between the proposed and reference configurations.

  
        

 
         
         		[bookmark: pgfId-56187]Print button

  
         		[bookmark: pgfId-56189]Prints the configuration.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-59784][bookmark: 26491][bookmark: dpman_cncpt_DetectingandAnalyzingOutofBandChanges]Detecting and Analyzing Out of Band Changes[bookmark: marker-59774][bookmark: marker-59776][bookmark: marker-59778][bookmark: marker-59780][bookmark: marker-59782]

 
     [bookmark: pgfId-59789]When you deploy configurations to devices, Security Manager either removes out of band changes or cancels the deployment based on your deployment settings. (For a detailed explanation of out of band changes and how they are handled during deployment, see Understanding How Out-of-Band Changes are Handled.)

 
     [bookmark: pgfId-59791]In the most typical scenario, Security Manager removes any out of band changes during deployment. However, there might have been good reason for those changes to have been made to the device outside of Security Manager. Thus, it is good practice to analyze a device for out of band changes before deploying configurations, so that you have the opportunity to proactively recreate any configuration changes that should be preserved.

 
     [bookmark: pgfId-59793]There are many ways to detect whether there have been out of band changes to a device configuration since the last deployment to the device. If there have been changes (by another device management application or by direct CLI updates), you can preview the changes and determine whether to update the device policies before deployment, or to deploy and overwrite those out of band changes. (Out of band changes are sometimes called OOB changes in Security Manager.)

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59795]Tip Out of band change detection is available only for IOS, ASA, PIX, FWSM devices, and security contexts; it is not available for IPS devices. However, the settings for handling out of band changes during deployment also apply to IPS devices; the difference is that you cannot proactively analyze these changes in IPS devices prior to deployment.


     
      

     

     

 
     [bookmark: pgfId-59797]To determine whether there have been out of band changes on one or more device, do any of the following in Device view:

 
      
      		 [bookmark: pgfId-59802]Select  Tools > Detect Out of Band Changes . You are prompted to select the devices to evaluate for out of band changes. Select the devices or device groups, click  >> to move them to the selected list, and click  OK . For more information on selecting devices, see Using Selectors.

 
      		 [bookmark: pgfId-59804]Select one or more devices or device groups, right-click and select  Detect Out of Band Changes . The selected devices are evaluated for changes.

 
      		 [bookmark: pgfId-59806]During deployment, select the devices to include in deployment and click the  Detect OOB Changes button. (The button is available on the Deploy Saved Changes dialog box and the Deployment—Create or Edit a Job dialog box, depending on the workflow mode you are using.) The selected devices are evaluated for changes.

 
     

 
     [bookmark: pgfId-59808]For information on the deployment procedure, see:

 
     [bookmark: pgfId-59813] – Deploying Configurations in Non-Workflow Mode

 
     [bookmark: pgfId-59818] – Creating and Editing Deployment Jobs

 
     [bookmark: pgfId-59823]When you start the detection process, the OOB (Out of Band) Changes Dialog Box is opened so that you can view the results. Each selected device is evaluated by retrieving the current running configuration and comparing it to the most recent configuration stored in Configuration Archive. Security Manager does not consider any unmanaged policy types when evaluating differences between the configurations.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59828]Tip Note that if you are in the process of deployment, the running configuration is not compared to the one you are proposing to deploy, so if you detect out of band changes, you might also want to preview the proposed configuration to see if you already implemented the same change in Security Manager policies. Right-click the device in the deployment dialog box and select Preview Config. You can compare the proposed configuration to the current running configuration. For more information, see Previewing Configurations.


     
      

     

     

 
     [bookmark: pgfId-59830]The OOB Changes dialog box shows the results of change detection. If a device has out of band changes, the icon for the device in the device selector changes to green. Select a device in the left pane of the OOB Detail tab to view the changes from the latest configuration in configuration archive. Use the buttons at the bottom of the window to move from change to change. The legend at the bottom explains the color coding used to describe the changes.

 
     [bookmark: pgfId-59832]When evaluating changes, consider the following:

 
      
      		 [bookmark: pgfId-59834]If you want to keep the change, update the relevant policy in Security Manager to recreate the policy. Use preview config to ensure that your policy changes produce the desired results. Security Manager might use different naming conventions, so consider whether the policy results in the same thing, rather than being exactly the same text. Keep in mind that out of band change detection looks for syntactic differences, not semantic differences.

 
      		 [bookmark: pgfId-59849]If you use another application to configure certain types of policies, consider unmanaging that policy type in Security Manager. Security Manager ignores any configuration commands related to policies that it is not managing. For more information, see Policy Management Page.[bookmark: marker-59839][bookmark: marker-59841][bookmark: marker-59843][bookmark: marker-59845][bookmark: marker-59847]

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59851]Tip If you are detecting changes during deployment, when you close the OOB Changes dialog box, the device names in the deployment dialog box are color-coded based on the results: green indicates out of band change; red indicates an error during the detection process; no color change indicates no out of band changes.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-59861][bookmark: 26569][bookmark: dppage_cncpt_OOBChanges]OOB (Out of Band) Changes Dialog Box[bookmark: marker-59859]

 
     [bookmark: pgfId-59863]Use the OOB Changes dialog box to view and analyze out of band changes on a device. An out of band change is any difference between the running configuration on a device and the most recent configuration for the device stored in Configuration Archive. Note that Security Manager considers only managed policy types when evaluating whether there is a difference between the configurations.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59865]Tip Configurations are compared for syntactic differences, not semantic differences. Thus, functionally equivalent configurations might be identified as out of band changes.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59867]Tip As an example, consider a simple case in which configuration lines are swapped in the device configuration without making any changes to the semantics. In this simple example case: 1) if there is an object group in Security Manager at line number 100, and 2) the same object group exists in the ASA configuration at any line number except 100, then 3) Security Manager detects and reports the change as OOB. To summarize this simple example case, Security Manager reports an OOB change even though this change in the order of a few configuration lines did not result in any changes to the semantics.


     
      

     

     

 
     [bookmark: pgfId-59869]There are two tabs on this dialog box:

 
      
      		 [bookmark: pgfId-59871] OOB Detail —This tab shows the detailed results and progress of the detection process. The fields are described below.

 
      		 [bookmark: pgfId-59873] OOB Summary —This tab shows a summary of the detection results, and becomes available only after the detection process is completed on all selected devices. The information is by device and includes a time stamp (date, time, time zone) and difference data that indicates the additions, subtractions, and changes with the associated configuration line number. You can select text on this tab, use Ctrl+click to copy it to the clipboard, and paste it in another application (such as NotePad).

 
     

 
     [bookmark: pgfId-59881]For more information on detecting and analyzing out of band changes, see Detecting and Analyzing Out of Band Changes. For more information on handling out of band changes during deployment, see Understanding How Out-of-Band Changes are Handled.

 
     [bookmark: pgfId-59886]Beginning with Version 4.7, Security Manager has a tool to help you re-sync out of band changes. For more information on this new tool, see OOB Re-sync. Tool

 
     [bookmark: pgfId-59888]Navigation Path

 
     [bookmark: pgfId-59890]There are several ways to start the out of band change detection process. You can use the Tools > Detect Out of Band Changes command, or select one or more devices right-click and select Detect Out of Band Changes. You can also click the Detect OOB Changes button in Deploy Saved Changes dialog box and Deployment—Create or Edit a Job dialog box as explained in the following procedures:

 
      
      		 [bookmark: pgfId-59895]Deploying Configurations in Non-Workflow Mode

 
      		 [bookmark: pgfId-59900]Creating and Editing Deployment Jobs

 
     

 
     [bookmark: pgfId-59902]Related Topics

 
      
      		 [bookmark: pgfId-59907]Previewing Configurations

 
      		 [bookmark: pgfId-59912]Filtering Items in Selectors

 
     

 
     [bookmark: pgfId-59914]Field Reference

 
     [bookmark: pgfId-59917] 

 
      
       
        
        [bookmark: pgfId-56202]Table 8-13 [bookmark: 26617]OOB Changes Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-56208]Element
          
  
         		
           
           [bookmark: pgfId-56210]Description
          
  
        

 
         
         		[bookmark: pgfId-56216]Selected Devices list (left pane)

  
         		[bookmark: pgfId-56218]This list contains all devices you selected to evaluate for out of band changes, organized in device groups (if any).

 [bookmark: pgfId-56220]Select a device to see the results in the right pane.

 [bookmark: pgfId-56222]The icons for the devices change color based on the results of the detection process:

 
           
           		 [bookmark: pgfId-56224]Green—There are out of band changes.

 
           		 [bookmark: pgfId-56226]Red—The out of band detection process failed for some reason.

 
           		 [bookmark: pgfId-56228]No color change—No out of band changes.

 
          

  
        

 
         
         		[bookmark: pgfId-56234]Configuration Comparison (right pane)

  
         		[bookmark: pgfId-56236]The right pane shows the results of the change detection process for the selected device. Messages will indicate if OOB detection is still in progress, if there are no changes, or if there was an error that prevented change detection from completing.

 [bookmark: pgfId-56238]If there are changes, the right pane shows both the running configuration retrieved from the device and the latest configuration for the device stored in Configuration Archive. The legend at the bottom of the window describes the color coding used to indicate changes, and you can use the following buttons to move from change to change.

  
        

 
         
         		[bookmark: pgfId-56244]First Difference button

  
         		[bookmark: pgfId-56246]Moves the cursor to the first difference noted between the configurations.

  
        

 
         
         		[bookmark: pgfId-56252]Previous Difference button

  
         		[bookmark: pgfId-56254]Moves the cursor to the previous difference noted between the configurations.

  
        

 
         
         		[bookmark: pgfId-56260]Current Difference button

  
         		[bookmark: pgfId-56262]Centers the currently selected difference on the page.

  
        

 
         
         		[bookmark: pgfId-56268]Next Difference button

  
         		[bookmark: pgfId-56270]Moves the cursor to the next difference noted between the configurations.

  
        

 
         
         		[bookmark: pgfId-56276]Last Difference button

  
         		[bookmark: pgfId-56278]Moves the cursor to the last difference noted between the configurations.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-59923][bookmark: 26673][bookmark: dppage_cncpt_OOBRe-syncTool]OOB Re-sync. Tool

 
     [bookmark: pgfId-59925]The OOB Re-sync Tool, which is new in Security Manager 4.7, helps you re-sync, or reconcile, out of band data. The OOB Re-sync Tool is an extension of the OOB Detection Tool available in Security Manager 4.6 and earlier versions and continued into 4.7.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59927]Tip Out of band (OOB) data is the difference between the last archived configuration of Security Manager and the latest configuration running on the device. OOB data comes into existence—with the result that you need to update the device CLI—for reasons such as these: 1) emergency requirements (primarily for ACLs) mean that there is no time to use Security Manager and complete its workflow process because an unknown validation error is blocking deployment; 2) the use of management applications other than Security Manager to manage the same devices; and 3) <100% feature support by Security Manager for ASAs means that some ASA features need to be managed by using the CLI. Any changes made to a device using a third-party tool together with any CLI changes made to a device sum up as OOB data.


     
      

     

     

 
     [bookmark: pgfId-59929]The OOB Re-sync Tool aims to automate the process of bringing OOB data on a device into your Security Manager installation while retaining the policy structures that you previously established.

 
     [bookmark: pgfId-59931]Without the OOB Re-sync Tool, Security Manager (versions 4.6 and earlier) has only the following administrative options when OOB data is detected during deployment:

 
      
      		 [bookmark: pgfId-59933]Warn and override the OOB changes (Default)—CSM detects for OOB changes during deployment, warns the user of the OOB changes but goes ahead and negates/wipes out the OOB changes.

 
      		 [bookmark: pgfId-59935]Stop deployment—Aborts the deployment when OOB changes are detected.

 
      		 [bookmark: pgfId-59937]Do not check for OOB changes—OOB changes are not even detected during deployment and are overridden on the device.

 
     

 
     [bookmark: pgfId-59939]The following objects are supported by the OOB Re-sync Tool:

 
      
      		 [bookmark: pgfId-59941]Network Object/Object-Group(s)

 
      		 [bookmark: pgfId-59943]Security Group(s)

 
      		 [bookmark: pgfId-59945]Service Object Group(s)

 
      		 [bookmark: pgfId-59947]User Group(s)

 
      		 [bookmark: pgfId-59949]Time Range Object(s)

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59951]Note The OOB Re-sync Tool does not support OOB changes for routers.


     
      

     

     

 
     [bookmark: pgfId-59953]The OOB Re-sync Tool does not re-sync all objects/ACLs. It re-syncs access rules and unified access rules; it does not, for example, re-sync IPv6 access rules. Note the details for policies in the following list:

 
      
      		 [bookmark: pgfId-59955]Access rules (unified) are supported

 
      		 [bookmark: pgfId-59957]IPv4 access rules are supported

 
      		 [bookmark: pgfId-59959]IPv6-only access rules are  not supported

 
      		 [bookmark: pgfId-59961]Ethertype ACLs are  not supported

 
      		 [bookmark: pgfId-59963]Standard ACLs are  not supported

 
     

 
     [bookmark: pgfId-59965]The OOB Re-sync Tool has a straightforward work flow:

 
     [bookmark: pgfId-59967] 1. Detect OOB changes by using one of the following methods to run the existing tool:

 
     [bookmark: pgfId-59969] – Configuration Manager > Tools > Detect Out Of Band Changes... .

 
     [bookmark: pgfId-59971] – Configuration Manager > [tool bar] > Detect OOB Changes icon

 
     [bookmark: pgfId-59973] – Configuration Manager > Device View > right-click a device > click Detect Out Of Band Changes.

 
     [bookmark: pgfId-59975] – In the Deploy Saved Changes dialog box, click Detect OOB.

 
     [bookmark: pgfId-59977] 2. If out of band changes are detected, they appear in the right pane of the OOB (Out of Band) Changes Dialog Box on the OOB Details tab. The OOB Details tab displays a report of the changes and the target rule number, shared policy, sections, affected devices, and CLI.

 
     [bookmark: pgfId-59979]Also if out of band changes are detected, the Re-Sync Summary tab in the right pane of the OOB (Out of Band) Changes Dialog Box becomes active.

 
     [bookmark: pgfId-59981]After OOB changes are detected by the existing OOB detection tool, click Evaluate; after you do, Security Manager will further analyze the differences in the configuration running on the device and the configuration available in Security Manager. After this analysis, the Re-Sync Summary Tab becomes active. On this tab, Security Manager displays other details, such as ACE, object(s) that will be added or deleted, and rule location(s).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59983]Note Security Manager also will annotate the policy rule table, both in Device and Policy View and for objects in the Policy Object Manager.


     
      

     

     

 
     [bookmark: pgfId-59985] 3. After the Re-Sync Summary Tab becomes active, you have the option of generating a report and checking to see if there is any CLI that is not supported by OOB functionality. After checking the report, you can opt to accept the changes by clicking Accept, and if the operation of persisting ACL or object changes in the device went through fine, you will be prompted with a "success" message.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59987]Note If you modify access rules that are part of a shared policy, the OOB Re-sync Tool in this particular case will annotate both the rule that has actually been modified and the rule just above it. This occurs when you 1) modify at least two access rules that are part of a shared policy; 2) run the OOB Re-sync Tool; and 3) accept the changes. In this case, the OOB Re-sync Tool reports an OOB condition for some rules in addition to the ones that you modified. It is important to understand that the rules themselves and the shared policy are not adversely affected.


     
      

     

     

 
     [bookmark: pgfId-59989] 4. On the OOB Detail tab in the left pane, you can request a report in .pdf format. To do this click the Generate Report button. Cisco recommends that you always generate this report and save it to help with troubleshooting if needed.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-59991]Tip The following example is a brief description of a scenario in which you use the OOB Re-sync Tool and find some changes in a device that are not supported by the OOB Re-sync Tool along with access-rule changes that are supported. In this scenario, you have an ASA that uses both IPv4 and IPv6. If you use Tools > Detect Out Of Band Changes.. and find OOB changes, you will need to manually reconcile the IPv6 changes before you can elect to re-sync. the OOB changes by using the OOB Re-sync Tool.


     
      

     

     

 
      
       
        
        [bookmark: pgfId-56291]Table 8-14 [bookmark: 26751]Caveats 

 
        
       
         
         		[bookmark: pgfId-56297]Interface Role

  
         		[bookmark: pgfId-56299]Access rules tied to interface roles and multiple interfaces rules will not be absorbed. However, the rules will be annotated to help the user copy the OOB rules from the OOB re-sync report and run "Import Rules" at the right rule location to absorb the OOB CLIs.

  
        

 
         
         		[bookmark: pgfId-56305]Shared Policies

  
         		[bookmark: pgfId-56307]OOB changes that affect shared policies will not be re-synced since doing so would affect other devices. Rules will be annotated to help the user import rules.

  
        

 
         
         		[bookmark: pgfId-56313]Objects

  
         		[bookmark: pgfId-56315]The OOB re-sync process always creates overrides for objects. However, if object override is selectively disabled for that object, then re-sync will not be allowed until the user enables the device overrides for that object.

  
        

 
         
         		[bookmark: pgfId-56321]Unsupported Access List

  
         		[bookmark: pgfId-56323]IPv6 only access-list that existed before the introduction of unified access-list is not supported for resync

 [bookmark: pgfId-56325]Ether Type Access List re-sync is not supported

  
        

 
         
         		[bookmark: pgfId-56331]OOB Access-Group CLI

  
         		[bookmark: pgfId-56333]OOB changes on access-group CLI cannot be absorbed. To explain this caveat further:

 
           
           		 [bookmark: pgfId-56335]Under these circumstances (OOB changes on access-group CLI), you cannot choose evaluation; that is, you cannot elect to re-sync. the OOB changes.

 
           		 [bookmark: pgfId-56337]In a case involving both 1) OOB changes that the OOB Re-sync Tool can re-sync and 2) changes in access-group CLIs, you must resolve the changes with respect to the access-group command before you can elect to re-sync the OOB changes.

 
          

  
        

 
         
         		[bookmark: pgfId-56343]Conditional Re-sync of Remarks

  
         		[bookmark: pgfId-56345]ACL remarks added to an access-list CLI created out-of-band will be absorbed during re-sync as part of re-sync of the rule. However, any random OOB change in an ACL remark alone will not be absorbed during re-sync

  
        

 
         
         		[bookmark: pgfId-56351]Rule Split

  
         		[bookmark: pgfId-56353]Rules get split during re-sync of OOB changes done within combined rules. User needs to run "Combine Rules" on the flattened rules thus re-synced to restore to the original rule if possible

  
        

 
       
      

 
     
 
     [bookmark: pgfId-59998]Related Topics

 
      
      		 [bookmark: pgfId-60003]Detecting and Analyzing Out of Band Changes

 
      		 [bookmark: pgfId-60008]Understanding How Out-of-Band Changes are Handled

 
     

 
    
 
     
      [bookmark: pgfId-60024][bookmark: 26807][bookmark: dpman_proc_RedeployingConfigurationstoDevices]Redeploying Configurations to Devices[bookmark: marker-60016][bookmark: marker-60018][bookmark: marker-60020][bookmark: marker-60022]

 
     [bookmark: pgfId-60026]You can redeploy a deployment job if you want to. This is especially valuable for jobs in the Failed or Aborted states. You can redeploy to all devices in the job, or you can select specific devices (such as the devices to which deployment failed).

 
     [bookmark: pgfId-60030]Tips on Redeploying a Configuration to a Replacement Device[bookmark: marker-60028]

 
     [bookmark: pgfId-60032]If you have to replace a device, for example, due to hardware failure, you cannot simply redeploy the last deployment job from the device, because Security Manager does not know that the device is actually a new one. To deploy the old device’s configuration to the new device, you have these options:

 
      
      		 [bookmark: pgfId-60034]If the new device is the exact same model and operating system version as the replaced device, you can select the old device in the device selector, right-click and select  Preview Configuration , and copy and paste the full configuration to the new device. However, this does not migrate certificates from the old device to the new one. You must re-enroll the device or renew the certificate yourself.

 
      		 [bookmark: pgfId-60039]If the new device is not exactly identical to the old device, follow the procedure described in Changes That Change the Feature Set in Security Manager.

 
     

 
     [bookmark: pgfId-60041]Before You Begin

 
      
      		 [bookmark: pgfId-60046]Make sure that devices have been bootstrapped. For more information, see Chapter 2, “Preparing Devices for Management”.

 
      		 [bookmark: pgfId-60048]If you are deploying to a transport server, such as AUS, CNS, or TMS, make sure the server, Security Manager settings, and device have been set up properly.

 
     

 
     [bookmark: pgfId-60050]Related Topics

 
      
      		 [bookmark: pgfId-60055]Overview of the Deployment Process

 
      		 [bookmark: pgfId-60060]Deploying Configurations in Non-Workflow Mode

 
      		 [bookmark: pgfId-60065]Deploying Configurations in Workflow Mode

 
      		 [bookmark: pgfId-60070]Deploying Configurations Using an Auto Update Server or CNS Configuration Engine

 
      		 [bookmark: pgfId-60075]Deploying Configurations to a Token Management Server

 
      		 [bookmark: pgfId-60080]Managing Device Communication Settings and Certificates

 
      		 [bookmark: pgfId-60085]Understanding Deployment Methods

 
      		 [bookmark: pgfId-60090]Job States in Non-Workflow Mode

 
      		 [bookmark: pgfId-60095]Job States in Workflow Mode

 
     

 
     
 
     [bookmark: pgfId-60097]Step 1 Click the Deployment Manager button in the Main toolbar.

 
     [bookmark: pgfId-60099]The Deployment Manager window appears. Click the Deployment Jobs tab if it is not active.

 
     [bookmark: pgfId-60101]Step 2 Select the job that contains the devices to which you want to redeploy configurations, then do one of the following:

 
      
      		 [bookmark: pgfId-60103]In non-Workflow mode, click  Redeploy .

 
      		 [bookmark: pgfId-60105]In Workflow mode, click  Deploy .

 
     

 
     [bookmark: pgfId-60107]The Redeploy a Job dialog box opens. The dialog box lists the devices in the deployment job, showing the device name, the deployment method used, the status of the previous deployment, and the name of the deployment job that updated the device.

 
     [bookmark: pgfId-60109]Step 3 In the Redeploy a Job dialog box, do the following:

 
      
      		 [bookmark: pgfId-60111] Selection column —Select the devices to which you want to redeploy configurations by putting checkmarks in the checkboxes in the Selection column. Initially all failed devices are selected.

 
      		 [bookmark: pgfId-60113] Deployment Method, Destination —(Optional) You can change the method used to deploy configurations for individual devices. The initially selected method is the one used in the job. You can select these methods

 
     

 
     [bookmark: pgfId-60121] – Device—Deploys the configuration directly to the device or to the transport mechanism specified for the device. For more information, see Deploying Directly to a Device or Deploying to a Device through an Intermediate Server.

 
     [bookmark: pgfId-60126] – File—Deploys the configuration file to a directory on the Security Manager server. If you select File, specify the directory to which you want to deploy the configuration file in the Destination column. Click Browse to select from a list of available directories. You cannot use file deployment with IPS devices. For more information, see Deploying to a File.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-60128]Note To set the deployment method for more than one device at a time, select the devices, right-click and select Edit Selected Deploy Method. The Edit Selected Deploy Method dialog box opens where you can make your selections.


     
      

     

     

 
      
      		 [bookmark: pgfId-60133] Out of Band Change Behavior —(Optional) Select how you want Security Manager to respond if it detects that changes were made on the device by someone other than Security Manager (these are called out of band changes). For a complete explanation of how to handle out-of-band changes, including the meaning of the available options, see Understanding How Out-of-Band Changes are Handled.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-60138]Note Before proceeding with the deployment, you can preview proposed configurations and compare them against last deployed configurations or current running configurations. Highlight the row for a device and click Preview Config. For more information, see Previewing Configurations.


     
      

     

     

 
     [bookmark: pgfId-60140]Step 4 Click OK.

 
     [bookmark: pgfId-60142]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-60160][bookmark: 26925][bookmark: dpman_proc_AbortingDeploymentJobs]Aborting Deployment Jobs[bookmark: marker-60150][bookmark: marker-60152][bookmark: marker-60154][bookmark: marker-60156][bookmark: marker-60158]

 
     [bookmark: pgfId-60162]You can stop a deployment job if you do not want to deploy the configurations or you want to postpone deployment.

 
     [bookmark: pgfId-60164]You can abort deployment jobs only while they are in the Deploying, Scheduled, or Rolling Back state. Aborting a job stops deployment of configurations to pending devices, but has no effect on devices to which deployments are in progress (commands are being written to a device) or to which deployment has already completed successfully.

 
     [bookmark: pgfId-60166]To abort a job, do either of the following:

 
      
      		 [bookmark: pgfId-60171]Click Abort on the Deployment Status dialog box while you are viewing the running status of an active job. See Deployment Status Details Dialog Box.

 
      		 [bookmark: pgfId-60173]Select  Manage > Deployments to open the Deployment Manager window, then select the job on the Deployment Jobs tab and click  Abort .

 
     

 
     [bookmark: pgfId-60175]The Abort the Job dialog box opens and asks you to confirm that you want to abort the job. Click OK to confirm.

 
     [bookmark: pgfId-60177]After you abort a job, the deployment status of pending devices changes to Aborted.

 
     [bookmark: pgfId-60182]To resume deployment, redeploy the job. See Redeploying Configurations to Devices for more information.

 
     [bookmark: pgfId-60184]Related Topics

 
      
      		 [bookmark: pgfId-60189]Viewing Deployment Status and History for Jobs and Schedules

 
      		 [bookmark: pgfId-60194]Job States in Non-Workflow Mode

 
      		 [bookmark: pgfId-60199]Job States in Workflow Mode

 
     

 
    
 
     
      [bookmark: pgfId-60209][bookmark: 26974][bookmark: dpman_proc_CreatingorEditingDeploymentSchedules]Creating or Editing Deployment Schedules[bookmark: marker-60205][bookmark: marker-60207]

 
     [bookmark: pgfId-60211]You can create deployment schedules to create deployment jobs at regular intervals. Schedules can help you ensure that the selected devices get regular configuration updates.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-60217]Tip When you include a device in a schedule, the device is included in deployment jobs that are generated from the schedule only if changes have been made to the device configuration and those changes were committed to the database. Thus, you might see changes when previewing the device configuration even though the device was not included in a scheduled deployment, if you have not submitted those changes (or if they have been submitted by not yet approved, when using a separate approver in Workflow mode).[bookmark: marker-60213][bookmark: marker-60215]


     
      

     

     

 
     [bookmark: pgfId-60219]Related Topics

 
      
      		 [bookmark: pgfId-60224]Overview of the Deployment Process

 
      		 [bookmark: pgfId-60229]Viewing Deployment Status and History for Jobs and Schedules

 
      		 [bookmark: pgfId-60234]Suspending or Resuming Deployment Schedules

 
     

 
     
 
     [bookmark: pgfId-60236]Step 1 Click the Deployment Manager button in the Main toolbar.

 
     [bookmark: pgfId-60241]The Deployment Manager window appears. Click the Deployment Schedules tab if it is not active (see Deployment Schedules Tab, Deployment Manager).

 
     [bookmark: pgfId-60243]Step 2 Do one of the following:

 
      
      		 [bookmark: pgfId-60245]If you are creating a new schedule, click  Create .

 
      		 [bookmark: pgfId-60247]If you are editing an existing schedule, select it in the Deployment Schedule table and click  Open .

 
     

 
     [bookmark: pgfId-60252]The Schedule dialog box opens (see Schedule Dialog Box).

 
     [bookmark: pgfId-60254]Step 3 Enter at least this information in the Schedule dialog box:

 
      
      		 [bookmark: pgfId-60256]The name of the schedule.

 
      		 [bookmark: pgfId-60258]If you are using Workflow mode with an approver, ensure that the approver e-mail address is correct. Also verify your e-mail address (in the Submitter field), and choose whether you want to get notifications whenever the status of the job changes.

 
      		 [bookmark: pgfId-60260]Define the first date and time the schedule should start, and select how often deployment jobs will be generated based on the schedule. Also determine whether the schedule should have an end date, after which no new jobs are created from it.

 
      		 [bookmark: pgfId-60262]Click  Add Devices and select all the devices that should be included in the deployment job. Including devices does not lock them from being modified by users or included in other deployment jobs or schedules.

 
     

 
     [bookmark: pgfId-60264]If Security Manager is configured to use user-login credentials for accessing devices, your username and password are captured during schedule creation. If you change your password, you will need to recreate the schedule.

 
     [bookmark: pgfId-60266]Step 4 Click OK. The schedule is added to the Deployment Schedule table.

 
     [bookmark: pgfId-60268]Step 5 (Workflow mode only) If you are operating in Workflow mode, you must complete these additional steps:

 
      
      		 [bookmark: pgfId-60270]If you are using an approver for deployment jobs, select the schedule in the table and click  Submit to submit the schedule to the approver. You are prompted to verify the approver’s e-mail address and to enter comments to help the approver evaluate the schedule. The approver will have to approve the schedule before it becomes active.

 
      		 [bookmark: pgfId-60272]If you are not using an approver, select the schedule in the table and click  Approve to approve it yourself and to activate the schedule.

 
     

 
     [bookmark: pgfId-60274]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-60284][bookmark: 27047][bookmark: dppage_cncpt_ScheduleDialogBox]Schedule Dialog Box[bookmark: marker-60282]

 
     [bookmark: pgfId-60286]Use the Schedule dialog box to create a regularly recurring deployment job.

 
     [bookmark: pgfId-60288]Navigation Path

 
     [bookmark: pgfId-60290]Select Manage > Deployments to open the Deployment Manager window, click the Deployment Schedules tab in the upper pane, and do one of the following:

 
      
      		 [bookmark: pgfId-60292]Click  Create to create a new schedule.

 
      		 [bookmark: pgfId-60294]Select a schedule and click  Open to view or modify its properties.

 
     

 
     [bookmark: pgfId-60296]Related Topics

 
      
      		 [bookmark: pgfId-60301]Creating or Editing Deployment Schedules

 
      		 [bookmark: pgfId-60306]Suspending or Resuming Deployment Schedules

 
     

 
     [bookmark: pgfId-60308]Field Reference

 
     [bookmark: pgfId-60311] 

 
      
       
        
        [bookmark: pgfId-56366]Table 8-15 [bookmark: 27077]Schedule Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-56372]Element
          
  
         		
           
           [bookmark: pgfId-56374]Description
          
  
        

 
         
         		 [bookmark: pgfId-56380]Schedule Name Group

 [bookmark: pgfId-56382]This group defines the name of the job and the job’s notification requirements.

  
        

 
         
         		[bookmark: pgfId-56390]Name

  
         		[bookmark: pgfId-56392]The name of the job. When individual deployment jobs are created from this schedule, a time stamp is added to the job name.

  
        

 
         
         		[bookmark: pgfId-56398]Description

  
         		[bookmark: pgfId-56400]The description of the purpose of the job.

  
        

 
         
         		[bookmark: pgfId-56406]Approver Email

 [bookmark: pgfId-56408](Workflow only)

  
         		[bookmark: pgfId-56410]The e-mail address of the person who should approve the schedule.

  
        

 
         
         		[bookmark: pgfId-56416]Comments

 [bookmark: pgfId-56418](Workflow only)

  
         		[bookmark: pgfId-56420](Optional) Information to help the approver evaluate the schedule when you save this schedule.

  
        

 
         
         		[bookmark: pgfId-56426]Submitter Email

 [bookmark: pgfId-56428](Workflow only)

  
         		[bookmark: pgfId-56430]The e-mail address of the person who is submitting this schedule for approval. This field initially contains the e-mail address associated with the user account you used to log into Security Manager, but you can change it.

  
        

 
         
         		[bookmark: pgfId-56436]Require Deployment Status Notifications

 [bookmark: pgfId-56438](Workflow only)

  
         		[bookmark: pgfId-56440]Whether to send e-mail messages for any change in the job status for the job schedule or any job created from it. Messages are sent to the approver and the submitter.

  
        

 
         
         		 [bookmark: pgfId-56446]Recurrence Pattern Group

 [bookmark: pgfId-56448]The fields in this group define the job schedule.

  
        

 
         
         		[bookmark: pgfId-56456]Start Date

  
         		[bookmark: pgfId-56458]The first day of the schedule. Click the calendar icon to select the date from a calendar.

  
        

 
         
         		[bookmark: pgfId-56464]Time (Start)

  
         		[bookmark: pgfId-56466]The time of day to run the schedule. The time is in 24-hour format and is based on the server time zone, not the client time zone.

  
        

 
         
         		[bookmark: pgfId-56472]Recurrence

  
         		[bookmark: pgfId-56474]How often to create a deployment job based on this schedule:

 
           
           		 [bookmark: pgfId-56476]One time—Run this job once on the day specified as the start date at the specified start time.

 
           		 [bookmark: pgfId-56478]Hourly—Run this job on an hourly schedule. Specify the number of hours between deployment jobs.

 
           		 [bookmark: pgfId-56480]Daily—Run this job on a daily schedule. Specify the number of days between deployment jobs.

 
           		 [bookmark: pgfId-56482]Weekly—Run this job on the specified days of the week.

 
           		 [bookmark: pgfId-56484]Monthly—Run this job on a monthly schedule. Select the day of the month to run the job, and the number of months between deployment jobs.

 
          

  
        

 
         
         		[bookmark: pgfId-56490]Run Indefinitely

 [bookmark: pgfId-56492]End Date and Time

  
         		[bookmark: pgfId-56494]The expiration date and time for the schedule. Deployment jobs are not created after this time. Select Run Indefinitely if you do not want the schedule to expire.

  
        

 
         
         		 [bookmark: pgfId-56500]Devices To Deploy Group

 [bookmark: pgfId-56505]This table lists the devices that are included in the deployment job. To add devices to the list, or to remove them from it, click Add devices, which opens the Add Other Devices dialog box (see Add Other Devices Dialog Box).

 [bookmark: pgfId-56507]If Security Manager is configured to use user-login credentials for accessing devices, your username and password are captured during schedule creation. If you change your password, you will need to recreate the schedule.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-60323][bookmark: 27175][bookmark: dppage_cncpt_AddOtherDevicesDialogBox]Add Other Devices Dialog Box[bookmark: marker-60319][bookmark: marker-60321]

 
     [bookmark: pgfId-60325]Use the Add Other Devices dialog box to select devices for the deployment job or schedule. The devices in the list might not have active policy changes. When you are creating a job, you might want to add devices that do not have policy changes if a device was manually modified and you want to return the device to its previous configuration (the configuration stored in the Security Manager database).

 
      
      		 [bookmark: pgfId-60327]Select the devices to include in the job or schedule in the Available Devices list and click  >> to move the devices to the Selected Devices list.

 
      		 [bookmark: pgfId-60329]To remove devices, select them in the Selected Devices list and click  << .

 
     

 
     [bookmark: pgfId-60331]Navigation Path

 
     [bookmark: pgfId-60333]To open this dialog box, do one of the following:

 
      
      		 [bookmark: pgfId-60338](Non-Workflow mode) From the Deploy Saved Changes dialog box, click  Add other devices . See Deploying Configurations in Non-Workflow Mode.

 
      		 [bookmark: pgfId-60343](Workflow mode) From the Deployment—Create or Edit a Job Dialog Box, click  Add other devices . See Creating and Editing Deployment Jobs.

 
      		 [bookmark: pgfId-60348](All modes) From the Schedule Dialog Box, click  Add devices .

 
     

 
     [bookmark: pgfId-60350]Related Topics

 
      
      		 [bookmark: pgfId-60355]Including Devices in Deployment Jobs or Schedules

 
      		 [bookmark: pgfId-60360]Creating or Editing Deployment Schedules

 
      		 [bookmark: pgfId-60365]Filtering Items in Selectors

 
     

 
    
 
     
      [bookmark: pgfId-60379][bookmark: 27222][bookmark: dpman_proc_SuspendingorResumingDeploymentSchedules]Suspending or Resuming Deployment Schedules[bookmark: marker-60371][bookmark: marker-60373][bookmark: marker-60375][bookmark: marker-60377]

 
     [bookmark: pgfId-60381]You can suspend an active deployment schedule without discarding it and then reactivate it later when you want to resume creating jobs based on the schedule. This allows you to turn off a schedule temporarily.

 
     [bookmark: pgfId-60383]Related Topics

 
      
      		 [bookmark: pgfId-60388]Viewing Deployment Status and History for Jobs and Schedules

 
      		 [bookmark: pgfId-60393]Creating or Editing Deployment Schedules

 
     

 
     
 
     [bookmark: pgfId-60395]Step 1 Click the Deployment Manager button in the Main toolbar.

 
     [bookmark: pgfId-60400]The Deployment Manager window appears. Click the Deployment Schedules tab if it is not active (see Deployment Schedules Tab, Deployment Manager).

 
     [bookmark: pgfId-60402]Step 2 Do one of the following:

 
      
      		 [bookmark: pgfId-60404]To suspend an active schedule, select it and click  Suspend .

 
      		 [bookmark: pgfId-60406]To resume a suspended schedule, select it and click  Resume .

 
     

 
     [bookmark: pgfId-60408]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-60420][bookmark: 27263][bookmark: adman_proc_AddingConfigurationVersionsfromaDevicetotheArchive]Adding Configuration Versions from a Device to the Configuration Archive [bookmark: marker-60414][bookmark: marker-60416][bookmark: marker-60418]

 
     [bookmark: pgfId-60422]The Configuration Archive is updated with a new configuration version any time a configuration is deployed to the device or a file, including when you roll back a configuration to a device.

 
     [bookmark: pgfId-60424]You can also retrieve a configuration directly from the device to add to the Configuration Archive. This is useful when changes have been made directly to device configurations, which are called out-of-band changes.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-60426]Note You cannot retrieve configurations from devices that are managed by AUS and that have been configured with dynamic IP addresses.


     
      

     

     

 
     [bookmark: pgfId-60428]This procedure will help you retrieve a configuration from a device and add it to the archive.

 
     [bookmark: pgfId-60430]Related Topics

 
      
      		 [bookmark: pgfId-60435]Viewing and Comparing Archived Configuration Versions

 
     

 
     
 
     [bookmark: pgfId-60440]Step 1 Select Manage > Configuration Archive to open the Configuration Archive (see Configuration Archive Window).

 
     [bookmark: pgfId-60442]Step 2 In the Device selector, select the device from which you want to retrieve the configuration. The archived configurations appear in the right pane.

 
     [bookmark: pgfId-60444]Step 3 Click Add from Device. Security Manager logs into the device, retrieves the running configuration, and adds it to the archive.

 
     [bookmark: pgfId-60446]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-60458][bookmark: 27297][bookmark: adman_proc_ViewingandComparingConfigurations]Viewing and Comparing Archived Configuration Versions[bookmark: marker-60452][bookmark: marker-60454][bookmark: marker-60456]

 
     [bookmark: pgfId-60460]Using the Configuration Archive, you can view the previous configurations for a device, compare versions of the configuration, and view the transcripts related to configuration deployment. To open the Configuration Archive window, select Manage > Configuration Archive.

 
     [bookmark: pgfId-60462]To view the configuration versions for a device, select the device in the device selector. All archived versions are listed in the right pane. You can do the following:

 
      
      		 [bookmark: pgfId-60467]To view a configuration, select it and click  View , which opens the Config Version Viewer dialog box with the configuration displayed in the left pane (for information about the dialog box, see Configuration Version Viewer).

 
     

 
     [bookmark: pgfId-60469]If there is more than one type of configuration available for the selected version, you can choose which type to view using the Config Type field. A Full version is a complete configuration, whereas a Delta version is just the commands that were different between this version and the device’s previous full configuration. Delta configurations might include negative commands.

 
      
      		 [bookmark: pgfId-60471]To compare configurations, select one and click  View . In the Config Version Viewer window, select the configuration you want to compare in the  Compare with Version field. The second version appears in the right pane with differences color-coded according to the caption below the display area.

 
      		 [bookmark: pgfId-60473]To view the transcript associated with the deployment of a configuration, do one of the following:

 
     

 
     [bookmark: pgfId-60475] – From the Configuration Archive window, double-click the icon in the Transcript column for the desired configuration.

 
     [bookmark: pgfId-60477] – When viewing a configuration in the left pane of the Config Version Viewer dialog box, click Transcript View.

 
     [bookmark: pgfId-60482]A transcript is the log file of transactions between Security Manager and a device captured during a deployment or rollback operation. It includes commands sent and received between server and device from the time of the deployment or rollback request, but it does not include communication that occurs during the initial discovery phase of deployment, when Security Manager obtains the current configuration from the device. If rollback is unsuccessful, there might be a partial transcript generated depending on which stage rollback or deployment failed. The transcript is displayed in the Transcript Viewer window (see Viewing Deployment Transcripts).

 
     [bookmark: pgfId-60487]You can configure the number of configuration versions to archive on the Configuration Archive settings page (see Configuration Archive Page).

 
     [bookmark: pgfId-60489]Related Topics

 
      
      		 [bookmark: pgfId-60494]Adding Configuration Versions from a Device to the Configuration Archive

 
     

 
    
 
     
      [bookmark: pgfId-60504][bookmark: 27340][bookmark: toolpage_cncpt_ConfigurationVersionViewer]Configuration Version Viewer[bookmark: marker-60502]

 
     [bookmark: pgfId-60509]Use the Config Version Viewer window (when opened from the Configuration Archive) to view previous configurations for a device and to compare them to other archived configurations. You can compare any version to any other version in the archive for a selected device. The selected version appears in the left pane, and you can select another version for comparison from the list on the upper right of this window. For more information on viewing and comparing versions, see Viewing and Comparing Archived Configuration Versions.

 
     [bookmark: pgfId-60511]Navigation Path

 
     [bookmark: pgfId-60513]Select Manage > Configuration Archive, select a device whose configuration you want to view, select the configuration, and click View.

 
     [bookmark: pgfId-60515]Related Topics

 
      
      		 [bookmark: pgfId-60520]Configuration Archive Window

 
      		 [bookmark: pgfId-60525]Viewing Deployment Transcripts

 
      		 [bookmark: pgfId-60530]Viewing and Comparing Archived Configuration Versions

 
      		 [bookmark: pgfId-60535]Adding Configuration Versions from a Device to the Configuration Archive

 
     

 
     [bookmark: pgfId-60537]Field Reference

 
     [bookmark: pgfId-60540] 

 
      
       
        
        [bookmark: pgfId-56522]Table 8-16 [bookmark: 27372]Configuration Version Viewer Window (Configuration Archive) 

 
        
       
         
         		
           
           [bookmark: pgfId-56528]Element
          
  
         		
           
           [bookmark: pgfId-56530]Description
          
  
        

 
         
         		[bookmark: pgfId-56536]Version ID

  
         		[bookmark: pgfId-56538]The configuration version to display in the left pane:

 
           
           		 [bookmark: pgfId-56540]Previous—Display the version in the sequence before the one currently selected.

 
           		 [bookmark: pgfId-56542]Next—Display the version in the sequence after the one currently selected.

 
           		 [bookmark: pgfId-56544]Last—Display the last version in the list.

 
           		 [bookmark: pgfId-56546]Specific Date and Time—Display the version created on that date and time.

 
          

  
        

 
         
         		[bookmark: pgfId-56552]Compare with version

  
         		[bookmark: pgfId-56554]The configuration version to compare to the version selected in the left pane, if you want to compare versions. The configuration is displayed in the right pane, with differences summarized and color coded as explained by the caption below the pane.

  
        

 
         
         		[bookmark: pgfId-56560]Config Type

  
         		[bookmark: pgfId-56562]The types of configurations that are available for viewing. The types differ based on the type of device. The types might indicate Full or Delta, which have the following meaning:

 
           
           		 [bookmark: pgfId-56564]Full Configuration—The full configuration for the selected device as saved in the Configuration Archive. You can compare full configurations for a device.

 
           		 [bookmark: pgfId-56566]Delta Configuration—The file that is generated by Security Manager during deployment and that represents policy changes between the configuration selected in the Version ID field and the most recently deployed version.

 
          

 , but no delta configuration file is generated.

  
        

 
         
         		[bookmark: pgfId-56574]First Difference button

  
         		[bookmark: pgfId-56576]Moves the cursor to the first difference noted between the configuration versions.

  
        

 
         
         		[bookmark: pgfId-56582]Previous Difference button

  
         		[bookmark: pgfId-56584]Moves the cursor to the previous difference noted between the configuration versions.

  
        

 
         
         		[bookmark: pgfId-56590]Current Difference button

  
         		[bookmark: pgfId-56592]Using the cursor, focuses on the currently selected difference in the window.

  
        

 
         
         		[bookmark: pgfId-56598]Next Difference button

  
         		[bookmark: pgfId-56600]Moves the cursor to the next difference noted between the configuration versions.

  
        

 
         
         		[bookmark: pgfId-56606]Last Difference button

  
         		[bookmark: pgfId-56608]Moves the cursor to the last difference noted between the configuration versions.

  
        

 
         
         		[bookmark: pgfId-56614]Transcript View button

  
         		[bookmark: pgfId-56616]Click this button to open the transcript viewer window, which displays the device communication transcript associated with this configuration.

  
        

 
         
         		[bookmark: pgfId-56622]Print button

  
         		[bookmark: pgfId-56624]Click this button to print the configuration.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-60554][bookmark: 27450][bookmark: toolpage_cncpt_TranscriptViewerWindow]Viewing Deployment Transcripts[bookmark: marker-60548][bookmark: marker-60550][bookmark: marker-60552]

 
     [bookmark: pgfId-60559]Use the Transcript Viewer window to view the record of messages exchanged between Security Manager and a device. A transcript is the log file of transactions between Security Manager and a device captured during a deployment or rollback operation. It includes commands sent and received between server and device from the time of the deployment or rollback request, but it does not include communication that occurs during the initial discovery phase of deployment, when Security Manager obtains the current configuration from the device. For more information, see Viewing and Comparing Archived Configuration Versions.

 
     [bookmark: pgfId-60561]Navigation Path

 
      
      		 [bookmark: pgfId-60563]Configuration Archive—Select  Manage > Configuration Archive to open the Configuration Archive, select the device for which you want to view a transcript and double-click the  Transcript icon in the row for the desired configuration version.

 
     

 
     [bookmark: pgfId-60568]You can also click the Transcript View button from the Configuration Version Viewer window when examining an archived configuration (see Configuration Version Viewer).

 
      
      		 [bookmark: pgfId-60570]Deployment Manager—Select  Manage > Deployments to open the Deployment Manager, select the deployment job that includes the desired device deployment, select the Details tab in the lower pane, and double-click the  Transcript icon in the row for the desired device.

 
     

 
     [bookmark: pgfId-60572]Related Topics

 
      
      		 [bookmark: pgfId-60577]Configuration Archive Window

 
      		 [bookmark: pgfId-60582]Deployment Manager Window

 
     

 
     [bookmark: pgfId-60584]Field Reference

 
     [bookmark: pgfId-60587] 

 
      
       
        
        [bookmark: pgfId-56637]Table 8-17 [bookmark: 27490]Transcript Viewer Window 

 
        
       
         
         		
           
           [bookmark: pgfId-56643]Element
          
  
         		
           
           [bookmark: pgfId-56645]Description
          
  
        

 
         
         		[bookmark: pgfId-56651]Version ID

  
         		[bookmark: pgfId-56653]The configuration version for which you are viewing transcripts:

 
           
           		 [bookmark: pgfId-56655]Previous—Display the transcripts for the version in the sequence before the one currently selected.

 
           		 [bookmark: pgfId-56657]Next—Display the transcripts for the version in the sequence after the one currently selected.

 
           		 [bookmark: pgfId-56659]Last—Display the transcripts for the last version in the list.

 
           		 [bookmark: pgfId-56661]Specific Date and Time—Display the transcripts for the version created on that date and time.

 
          

  
        

 
         
         		[bookmark: pgfId-56667]Transcript Type

  
         		[bookmark: pgfId-56669]The type of transcript that you want to view. Some configuration versions have more than one transcript associated with them. Use this field to select which transcript to view.

  
        

 
         
         		[bookmark: pgfId-56675]Transcript Window

  
         		[bookmark: pgfId-56677]Displays the selected transcript. You can select text and copy it to the clipboard (Ctrl+C) for pasting in a text editor.

  
        

 
         
         		[bookmark: pgfId-56683]View button

  
         		[bookmark: pgfId-56688]Click this button to display the related configuration in the Config Version Viewer window (see Configuration Version Viewer).

  
        

 
         
         		[bookmark: pgfId-56694]Print button

  
         		[bookmark: pgfId-56696]Click this button to print the transcript.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-60597][bookmark: 27537][bookmark: dpman_cncpt_RollingBackConfigurations]Rolling Back Configurations [bookmark: marker-60593][bookmark: marker-60595]

 
    [bookmark: pgfId-60599]After you deploy a new configuration to a device, you can roll back the configuration to an older version if you find that the new configuration does not work correctly. However, it is usually a better idea to fix the configuration in Security Manager and deploy the fixed configuration, because rolling back a configuration creates a situation where the configuration defined in Security Manager is not the same one running on the device. Roll back configurations only in extreme circumstances.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1071890]Note The Rollback feature is not supported with ASA clusters. Hence, do not attempt to rollback ASA cluster configurations.


    
     

    

    

 
    [bookmark: pgfId-60601]The following topics will help you better understand and use configuration rollback:

 
     
     		 [bookmark: pgfId-60606]Understanding Configuration Rollback

 
     		 [bookmark: pgfId-60611]Rolling Back Configurations to Devices Using the Deployment Manager

 
     		 [bookmark: pgfId-60616]Using Rollback to Deploy Archived Configurations

 
     		 [bookmark: pgfId-60621]Performing Rollback When Deploying to a File

 
    

 
     
      [bookmark: pgfId-60631][bookmark: 27560][bookmark: dpman_cncpt_UnderstandingConfigurationRollback]Understanding Configuration Rollback [bookmark: marker-60627][bookmark: marker-60629]

 
     [bookmark: pgfId-60633]If you deploy configurations to devices using the Device method, either to deploy the configuration directly to the device or to an intermediate server, you can roll back the configuration to an older version if you find that the new configuration does not work correctly. You cannot roll back to a configuration that was deployed to a file.

 
      
      [image: ] 
     
 
     
 
     
      [bookmark: pgfId-60635]
      Caution It is usually a better idea to fix the configuration in Security Manager and deploy the fixed configuration, because rolling back a configuration creates a situation where the configuration defined in Security Manager is not the same one running on the device. After rollback, you should rediscover policies on the device to make the device configuration and its configuration in Security Manager consistent. Roll back configurations only in extreme circumstances.
       
       
 
      

     
 
     [bookmark: pgfId-60637]You can roll back configurations using these tools:

 
      
      		 [bookmark: pgfId-60639]Deployment Manager—You can roll back a deployment to the last good configuration if that configuration was deployed to the device rather than to a file. To open the Deployment Manager, select  Manage > Deployments .

 
      		 [bookmark: pgfId-60641]Configuration Archive—You can roll back deployment to any archived configuration that was deployed to the device or that originated from the device. To open the Configuration Archive, select  Manage > Configuration Archive .

 
     

 
     [bookmark: pgfId-60643]When you roll back a configuration, Security Manager does the following:

 
      
      		 [bookmark: pgfId-60645]On PIX Firewalls and ASA and FWSM devices, Security Manager uses the  replace config option on the device’s SSL interface to perform the equivalent of a reload (xlates are cleared, IPsec tunnels are torn down, and so on).

 
      		 [bookmark: pgfId-60647]For devices running IOS 12.3(7)T or later, Security Manager uses the  configure replace command to replace the running configuration with the contents of a configuration file. Support for this command is dependent on the IOS version installed on the device:

 
     

 
     [bookmark: pgfId-60649] – On devices running IOS 12.3(7)T or later, Security Manager copies the configuration file to the startup configuration before executing the configure replace command. If the configure replace operation fails, Security Manager issues the reload command to reload the operating system using the contents of the startup configuration. The reload command restarts the system, which might result in a temporary network outage.

 
     [bookmark: pgfId-60654] – On routers running a version prior to 12.3(7)T, Security Manager copies the configuration file to the startup configuration and issues the reload command, which restarts the system. Security Manager uses the TFTP server and directory specified in the Configuration Archive settings page (see Configuration Archive Page) when using this method.

 
      
      		 [bookmark: pgfId-60656]The rolled-back configuration becomes another archived version in the Configuration Archive for that device.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-60660]Tip Configuration rollback does not include user account policies. When you roll back a configuration, the existing state of user accounts is not changed. This helps ensure that users can continue to log into the device.[bookmark: marker-60658]


     
      

     

     

 
     [bookmark: pgfId-60662]Special considerations apply to the rollback of certain device types and configurations. See the following sections for more information:

 
      
      		 [bookmark: pgfId-60667]Understanding Rollback for Devices in Multiple Context Mode

 
      		 [bookmark: pgfId-60672]Understanding Rollback for Failover Devices

 
      		 [bookmark: pgfId-60677]Understanding Rollback for Catalyst 6500/7600 Devices

 
      		 [bookmark: pgfId-60682]Understanding Rollback for IPS and IOS IPS

 
      		 [bookmark: pgfId-60687]Commands that Can Cause Conflicts after Rollback

 
      		 [bookmark: pgfId-60692]Commands to Recover from Failover Misconfiguration after Rollback

 
     

 
     [bookmark: pgfId-60694]Related Topics

 
      
      		 [bookmark: pgfId-60699]Rolling Back Configurations to Devices Using the Deployment Manager

 
      		 [bookmark: pgfId-60704]Using Rollback to Deploy Archived Configurations

 
     

 
    
 
     
      [bookmark: pgfId-60722][bookmark: 27630][bookmark: adman_cncpt_UnderstandingRollbackforDevicesinMultipleContextMode]Understanding Rollback for Devices in Multiple Context Mode [bookmark: marker-60710][bookmark: marker-60712][bookmark: marker-60714][bookmark: marker-60716][bookmark: marker-60718][bookmark: marker-60720]

 
     [bookmark: pgfId-60724]If the configuration of the system execution space to which you are rolling back specifies connectivity options to security contexts (for example, vlan config) and there is a mismatch between the configuration selected for rollback and the current running configurations of the security contexts, Security Manager might not be able to connect to the security contexts. In such cases. we recommend that you roll back configurations for the security contexts before rolling back a configuration for the system execution space.

 
     [bookmark: pgfId-60726]If you roll back a configuration for the system execution space of a device in multiple context mode to one that includes a different set of security contexts, after rollback the security contexts on the device might not match the security contexts managed by Security Manager that appear in the Device selector.

 
     [bookmark: pgfId-60728]Related Topics

 
      
      		 [bookmark: pgfId-60733]Rolling Back Configurations to Devices Using the Deployment Manager

 
      		 [bookmark: pgfId-60738]Using Rollback to Deploy Archived Configurations

 
      		 [bookmark: pgfId-60743]Commands that Can Cause Conflicts after Rollback

 
      		 [bookmark: pgfId-60748]Commands to Recover from Failover Misconfiguration after Rollback

 
     

 
    
 
     
      [bookmark: pgfId-60766][bookmark: 27668][bookmark: adman_cncpt_UnderstandingRollbackforFailoverDevices]Understanding Rollback for Failover Devices [bookmark: marker-60754][bookmark: marker-60756][bookmark: marker-60758][bookmark: marker-60760][bookmark: marker-60762][bookmark: marker-60764]

 
     [bookmark: pgfId-60768]If you roll back a configuration for a security context that contains a failover policy, Security Manager initially disables failover in the system execution space and both devices become active. After the rollback is completed, the devices should return to their failover configuration.

 
     [bookmark: pgfId-60773]If a switchover occurs during rollback or connectivity between the active and standby units is lost, copy the bootstrap configuration to the standby unit after rollback completes. For more information, see Bootstrap Configuration for LAN Failover Dialog Box.

 
     [bookmark: pgfId-60775]Related Topics

 
      
      		 [bookmark: pgfId-60780]Rolling Back Configurations to Devices Using the Deployment Manager

 
      		 [bookmark: pgfId-60785]Using Rollback to Deploy Archived Configurations

 
      		 [bookmark: pgfId-60790]Commands that Can Cause Conflicts after Rollback

 
      		 [bookmark: pgfId-60795]Commands to Recover from Failover Misconfiguration after Rollback

 
     

 
    
 
     
      [bookmark: pgfId-60807][bookmark: 27707][bookmark: adman_cncpt_UnderstandingRollbackforCatalyst]Understanding Rollback for Catalyst 6500/7600 Devices [bookmark: marker-60801][bookmark: marker-60803][bookmark: marker-60805]

 
     [bookmark: pgfId-60809]If you roll back a configuration to a Catalyst 6500/7600 device that specifies connectivity options to service modules (for example, vlan config) and there is a mismatch between the configuration selected for rollback and the current running configuration, Security Manager might not be able to connect to the service modules. We recommend that you roll back configurations for the service modules before rolling back a configuration to the Catalyst 6500/7600 chassis.

 
     [bookmark: pgfId-60811]Thus, the proper order for performing rollback on Catalyst 6500/7600 devices is:

 
     [bookmark: pgfId-60813] 1. Security contexts.

 
     [bookmark: pgfId-60815] 2. Service modules.

 
     [bookmark: pgfId-60817] 3. Chassis.

 
     [bookmark: pgfId-60819]We recommend performing rediscovery after the rollback operation is complete.

 
     [bookmark: pgfId-60821]If you are rolling back an FWSM deployment and the system is configured to retrieve security certificates when adding devices, you might need to retrieve the certificate after the rollback operation is complete. This can be done using either of the following methods:

 
      
      		 [bookmark: pgfId-60823]Retrieving the certificate on a per-device basis from Device Properties.

 
      		 [bookmark: pgfId-60825]Configuring Security Manager to automatically retrieve certificates after rollback. To do this, select  Tools > Security Manager Administration > Device Communication , then select  Retrieve while adding devices in the PIX/ASA/FWSM Device Authentication Certificates field (in SSL Certificate Parameters).

 
     

 
     [bookmark: pgfId-60827]Related Topics

 
      
      		 [bookmark: pgfId-60832]Rolling Back Configurations to Devices Using the Deployment Manager

 
      		 [bookmark: pgfId-60837]Using Rollback to Deploy Archived Configurations

 
      		 [bookmark: pgfId-60842]Commands that Can Cause Conflicts after Rollback

 
      		 [bookmark: pgfId-60847]Commands to Recover from Failover Misconfiguration after Rollback

 
     

 
    
 
     
      [bookmark: pgfId-60859][bookmark: 27752][bookmark: adman_cncpt_UnderstandingRollbackforIPSandIOSIPS]Understanding Rollback for IPS and IOS IPS [bookmark: marker-60853][bookmark: marker-60855][bookmark: marker-60857]

 
     [bookmark: pgfId-60861]Special considerations apply to the rollback of IPS devices and IOS IPS devices. For IPS devices and IOS IPS devices, rollback could possibly include rolling back sensor updates or signature updates. The reason for this is that for IPS devices and IOS IPS devices, Security Manager supports not only the management of configuration but also the support of image management in the form of manual and automatic upgrades and signature updates. Keep in mind that when you do a rollback, you are rolling back the configuration, not the sensor updates or signature updates. These updates are downgraded only if the configuration cannot be rolled back without downgrading the updates.

 
     [bookmark: pgfId-60863]Rollback is accomplished through Configuration Archive. For IPS devices and IOS IPS devices, only the current configuration is archived. The current configuration for one device version (say, Version X) may not be valid for a different device version (say, Version Y). Security Manager rolls back a configuration of Version X to a sensor with Version Y as long as the configuration for X is valid for Y.

 
     [bookmark: pgfId-60865]If the configuration for X is valid for Y, rollback proceeds and Security Manager displays a confirmation dialog box to you. If the configuration for X is not valid for Y, Security Manager displays a warning dialog box to you and provides you with the option of downgrading the sensor during rollback if such a downgrade will help accomplish the rollback.

 
      
      [image: ] 
     
 
     
 
     
      [bookmark: pgfId-60867]
      Caution Downgrading an IPS device removes certain capabilities of the IPS device. For example, downgrading the engine prevents you from applying the latest signature updates. Operation of an IPS device without the latest signature updates diminishes the effectiveness of the IPS device.
       
       
 
      

     
 
     [bookmark: pgfId-60869]For rollback of a deployment job, the warning dialog box contains one or more of the following types of warnings:

 
      
      		 [bookmark: pgfId-60871]Security Manager warns you about IPS devices that need to have their sensor version downgraded before a rollback can be performed.

 
      		 [bookmark: pgfId-60873]Security Manager warns you about IOS IPS devices whose signature level has changed. For these devices, only the non-IPS sections of the configuration can be rolled back.

 
      		 [bookmark: pgfId-60875]Security Manager warns you about IPS devices that must be downgraded more than one level, and as a result, Security Manager cannot do it. You must use the Cisco IPS CLI for such downgrades. The warning dialog box displays the version to which the device must be reimaged or downgraded.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-60877]Note The option of downgrading an IOS IPS device during rollback is not available, because IOS IPS devices do not support downgrade.


     
      

     

     

 
     [bookmark: pgfId-60879]If the option of downgrading the sensor during rollback will not help accomplish the rollback, you receive an error message stating that rollback cannot occur and that you need to manually reinstall the image on the device to roll back. Only the update package most recently installed on a device can be downgraded, so downgrade does not help in the following cases:

 
      
      		 [bookmark: pgfId-60881]Rollback of a deployment (signature update) that involves downloading more than one update package to the device.

 
      		 [bookmark: pgfId-60883]Selection of an old deployment or configuration for rollback subsequent to which several upgrades occurred.

 
      		 [bookmark: pgfId-60888]Rollback of an upgrade that cannot be downgraded. Major, minor, and most service pack upgrades cannot be downgraded, as shown in Table 8-18

 
     

 
     [bookmark: pgfId-60890]For rollback of a configuration that requires a downgrade to a version prior to Cisco IPS 5.1(4), Security Manager does not support automatic downgrade. You must manually downgrade the device to the specified version and then proceed with rollback.

 
     [bookmark: pgfId-60893] 

 
      
       
        
        [bookmark: pgfId-56709]Table 8-18 [bookmark: 27787]Downgrade Support for Possible Sensor Upgrade Types 

 
        
       
         
         		
           
           [bookmark: pgfId-56715]Upgrade Type
          
  
         		
           
           [bookmark: pgfId-56717]Downgrade Support
          
  
        

 
         
         		[bookmark: pgfId-56723]Major Upgrade

  
         		[bookmark: pgfId-56725]Downgrade is not supported.

  
        

 
         
         		[bookmark: pgfId-56731]Minor Upgrade

  
         		[bookmark: pgfId-56733]Downgrade is not supported.

  
        

 
         
         		[bookmark: pgfId-56739]Service Pack Update

  
         		[bookmark: pgfId-56741]Downgrade from Cisco IPS 5.1(4) onward is not supported.

  
        

 
         
         		[bookmark: pgfId-56747]Patch update

  
         		[bookmark: pgfId-56749]Downgrade is supported.

  
        

 
         
         		[bookmark: pgfId-56755]Signature Update

  
         		[bookmark: pgfId-56757]Downgrade is supported.

  
        

 
         
         		[bookmark: pgfId-56763]Engine Update

  
         		[bookmark: pgfId-56765]Downgrade is supported.

  
        

 
         
         		[bookmark: pgfId-56771]Repackage (applicable to major, minor, and service pack updates).

  
         		[bookmark: pgfId-56773]Repackages for service packs prior to 5.1(4) can be downgraded.

  
        

 
       
      

 
     
 
      
      [image: ] 
     
 
     
 
     
      [bookmark: pgfId-60895]
      Caution Outbreak Prevention updates on a particular device may be lost if that device is downgraded.
       
       
 
      

     
 
     [bookmark: pgfId-60897]During rollback, if Security Manager discovers that there have been out-of-band changes to the device that prevent rollback, you will receive an error message stating that rollback is prevented.

 
     [bookmark: pgfId-60899]Related Topics

 
      
      		 [bookmark: pgfId-60904]Rolling Back Configurations to Devices Using the Deployment Manager

 
      		 [bookmark: pgfId-60909]Using Rollback to Deploy Archived Configurations

 
     

 
    
 
     
      [bookmark: pgfId-60927][bookmark: 27844][bookmark: adman_cncpt_CommandsthatCanCauseConflictsafterRollback]Commands that Can Cause Conflicts after Rollback [bookmark: marker-60915][bookmark: marker-60917][bookmark: marker-60919][bookmark: marker-60921][bookmark: marker-60923][bookmark: marker-60925]

 
     [bookmark: pgfId-60929]The following commands can potentially cause conflicts after rollback is performed:

 
      
      		 [bookmark: pgfId-60931] http server enable  port
   http  ip_address net_mask interface_name 

 
     

 
     [bookmark: pgfId-60933]Applicable only to security contexts (not the system execution space).

 
      
      		 [bookmark: pgfId-60935] allocate-interface { physical_interface |  subinterface }  [map_name] [visible | invisible] 

 
     

 
     [bookmark: pgfId-60937]Applicable only to the system execution space under the context subcommand.

 
      
      		 [bookmark: pgfId-60939] config-url  diskX:/path/filename 

 
     

 
     [bookmark: pgfId-60941]Applicable only to the system execution space under the context subcommand.

 
      
      		 [bookmark: pgfId-60943] join -failover-group  group_number 

 
     

 
     [bookmark: pgfId-60945]Applicable only for active/active failover and only to the system execution space under the context subcommand. The failover group defaults to group 1 if not specified.

 
      
      		 [bookmark: pgfId-60947] failover 

 
     

 
     [bookmark: pgfId-60949]Applicable only to the system execution space. Enabling failover causes configuration synchronization to trigger between peers.

 
      
      		 [bookmark: pgfId-60951] failover lan enable 

 
     

 
     [bookmark: pgfId-60953]Applicable only to the system execution space. If this command is omitted, this implies serial cable failover on a PIX platform or warrants an incomplete failover configuration warning on ASA and FWSM.

 
      
      		 [bookmark: pgfId-60955] failover lan unit { primary |  secondary }

 
     

 
     [bookmark: pgfId-60957]Applicable only to the system execution space. If this command is not specified, both units are secondary by default. If rollback takes place on the wrong unit, both can become primary, which impacts which unit becomes active initially.

 
      
      		 [bookmark: pgfId-60959] failover group  group_number 

 
     

 
     [bookmark: pgfId-60961]Applicable only to the system execution space. This command enables active/active failover. If this command is omitted, active/standby is enabled.

 
      
      		 [bookmark: pgfId-60963] preempt  delay 

 
     

 
     [bookmark: pgfId-60965]Applicable only to the system execution space and under the failover group subcommand to force which failover group becomes active if both units are booted up at the same time, or the primary does not boot up within the delay specified.

 
      
      		 [bookmark: pgfId-60967] monitor-interface  interface_name 

 
     

 
     [bookmark: pgfId-60969]Applicable only to security contexts and used to enable health monitoring of critical interfaces. If this interface is ‘bounced’ or fails, a switchover could occur.

 
     [bookmark: pgfId-60971]Related Topics

 
      
      		 [bookmark: pgfId-60976]Rolling Back Configurations to Devices Using the Deployment Manager

 
      		 [bookmark: pgfId-60981]Using Rollback to Deploy Archived Configurations

 
      		 [bookmark: pgfId-60986]Commands to Recover from Failover Misconfiguration after Rollback

 
     

 
    
 
     
      [bookmark: pgfId-61004][bookmark: 27940][bookmark: adman_cncpt_CommandstoRecoverfromFailoverMisconfigurationafterRollback]Commands to Recover from Failover Misconfiguration after Rollback [bookmark: marker-60992][bookmark: marker-60994][bookmark: marker-60996][bookmark: marker-60998][bookmark: marker-61000][bookmark: marker-61002]

 
     [bookmark: pgfId-61006]If a switchover happens during rollback and the two units are no longer synchronized, you might need to use the following commands to recover:

 
      
      		 [bookmark: pgfId-61008] failover active  group_number 

 
      		 [bookmark: pgfId-61010] failover reset  group_number 

 
      		 [bookmark: pgfId-61012] failover reload-standby 

 
      		 [bookmark: pgfId-61014] clear configure failover 

 
     

 
     [bookmark: pgfId-61016]For more information on these commands, please refer to the command reference for your security appliance.

 
     [bookmark: pgfId-61018]Related Topics

 
      
      		 [bookmark: pgfId-61023]Rolling Back Configurations to Devices Using the Deployment Manager

 
      		 [bookmark: pgfId-61028]Using Rollback to Deploy Archived Configurations

 
      		 [bookmark: pgfId-61033]Commands that Can Cause Conflicts after Rollback

 
     

 
    
 
     
      [bookmark: pgfId-61057][bookmark: 27993][bookmark: dpman_proc_RollingBackConfigurationstoDevices]Rolling Back Configurations to Devices Using the Deployment Manager[bookmark: marker-61043][bookmark: marker-61045][bookmark: marker-61047][bookmark: marker-61049][bookmark: marker-61051][bookmark: marker-61053][bookmark: marker-61055]

 
     [bookmark: pgfId-61059]If you deploy configurations to devices and then determine that there is something wrong with the new configurations, you can revert to and deploy the previous configurations for those devices. You cannot roll back to a previous configuration if there are no previous configurations in the Configuration Archive.

 
     [bookmark: pgfId-61064]You can roll back configurations only to configurations that were deployed to the device, not to a file. For information on how to roll back a configuration that was deployed to a file, see Performing Rollback When Deploying to a File.

 
     [bookmark: pgfId-61069]You can also use the Configuration Archive tool to roll back to any configuration archived from a device. For more information, see Using Rollback to Deploy Archived Configurations.

 
      
      [image: ] 
     
 
     
 
     
      [bookmark: pgfId-61071]
      Caution Roll back configurations only in extreme circumstances. It is usually a better idea to fix the configuration in Security Manager and deploy the fixed configuration, because rolling back a configuration creates a situation where the configuration defined in Security Manager is not the same one running on the device. After rollback, you should rediscover policies on the device to make the device configuration and its configuration in Security Manager consistent. Roll back configurations only in extreme circumstances. Before proceeding, read the following topics.
       
       
 
      

     
 
      
      		 [bookmark: pgfId-61076]Understanding Configuration Rollback

 
      		 [bookmark: pgfId-61081]Understanding Rollback for Devices in Multiple Context Mode

 
      		 [bookmark: pgfId-61086]Understanding Rollback for Failover Devices

 
      		 [bookmark: pgfId-61091]Understanding Rollback for Catalyst 6500/7600 Devices

 
      		 [bookmark: pgfId-61096]Understanding Rollback for IPS and IOS IPS

 
      		 [bookmark: pgfId-61101]Commands that Can Cause Conflicts after Rollback

 
      		 [bookmark: pgfId-61106]Commands to Recover from Failover Misconfiguration after Rollback

 
     

 
     [bookmark: pgfId-61108]Before You Begin

 
     [bookmark: pgfId-61110]When you roll back a configuration, the action is not done as part of an activity or configuration session, which means the device is not locked. Thus, it is possible that two users might roll back configurations simultaneously on a device, which can generate unexpected problems. Before rolling back a configuration, ensure that there are no active deployment jobs for the device listed in the Deployment Manager window.

 
     [bookmark: pgfId-61112]Related Topics

 
      
      		 [bookmark: pgfId-61117]Viewing Deployment Status and History for Jobs and Schedules

 
      		 [bookmark: pgfId-61122]Job States in Non-Workflow Mode

 
      		 [bookmark: pgfId-61127]Job States in Workflow Mode

 
     

 
     
 
     [bookmark: pgfId-61129]Step 1 Click the Deployment Manager button in the Main toolbar. Click the Deployment Jobs tab if it is not active.

 
     [bookmark: pgfId-61131]Step 2 Select the deployment job (which must be in the Deployed or Failed states) and click Rollback.

 
     [bookmark: pgfId-61133]The Rollback a Job dialog box opens. The dialog box lists all of the devices included in the job, including the name of the device, the deployment method (file or device), the status of the previous deployment, and the name of the deployment job that last updated the device.

 
     [bookmark: pgfId-61135]Step 3 Select the devices for which you want to roll back configurations by checking the check box in the Selection column. You can select only devices that used the deploy to device method. By default, all the devices with the status Succeeded are selected.

 
     [bookmark: pgfId-61140]You can view the configuration that will be deployed to a device by highlighting the row for a device and clicking the Preview Config button. You can compare it to the last deployed configuration or the current running configuration. For more information, see Previewing Configurations.

 
     [bookmark: pgfId-61142]Step 4 Click OK. You are asked to confirm the action.

 
     [bookmark: pgfId-61147]Step 5 (Optional) To make the configuration defined in Security Manager consistent with the one running on the device, rediscover the device policies as described in Discovering Policies on Devices Already in Security Manager.

 
     [bookmark: pgfId-61149]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-61165][bookmark: 28086][bookmark: adman_proc_UsingRollbacktoDeployArchivedConfigurations]Using Rollback to Deploy Archived Configurations[bookmark: marker-61155][bookmark: marker-61157][bookmark: marker-61159][bookmark: marker-61161][bookmark: marker-61163]

 
     [bookmark: pgfId-61170]You can roll back any configuration version from Configuration Archive to the device for which it is archived, provided that the configuration was deployed to the device or originated from the device. The rolled-back configuration then becomes another archived version in the list for that device. For information on how to roll back a configuration that was deployed to a file, see Performing Rollback When Deploying to a File.

 
     [bookmark: pgfId-61172]Before You Begin

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-61174]Tip When you roll back a configuration, the action is not done as part of an activity or configuration session, which means the device is not locked. Thus, it is possible that two users might roll back configurations simultaneously on a device, which can generate unexpected problems. Before rolling back a configuration, check the Deployment Manager to ensure that there are no active deployment jobs for the device (select Manage > Deployments).


     
      

     

     

 
     [bookmark: pgfId-61176]Roll back configurations only in extreme circumstances. Before rolling back configurations, carefully read these topics:

 
      
      		 [bookmark: pgfId-61181]Understanding Configuration Rollback

 
      		 [bookmark: pgfId-61186]Understanding Rollback for Devices in Multiple Context Mode

 
      		 [bookmark: pgfId-61191]Understanding Rollback for Failover Devices

 
      		 [bookmark: pgfId-61196]Understanding Rollback for Catalyst 6500/7600 Devices

 
      		 [bookmark: pgfId-61201]Understanding Rollback for IPS and IOS IPS

 
      		 [bookmark: pgfId-61206]Commands that Can Cause Conflicts after Rollback

 
      		 [bookmark: pgfId-61211]Commands to Recover from Failover Misconfiguration after Rollback

 
     

 
     [bookmark: pgfId-61213]Related Topics

 
      
      		 [bookmark: pgfId-61218]Rolling Back Configurations to Devices Using the Deployment Manager

 
      		 [bookmark: pgfId-61223]Adding Configuration Versions from a Device to the Configuration Archive

 
      		 [bookmark: pgfId-61228]Chapter 8, “Managing Deployment”

 
      		 [bookmark: pgfId-61233]Viewing and Comparing Archived Configuration Versions

 
     

 
     
 
     [bookmark: pgfId-61238]Step 1 Select Manage > Configuration Archive to open the Configuration Archive (see Configuration Archive Window).

 
     [bookmark: pgfId-61240]Step 2 In the Device selector, select the device for which you want to roll back to a different configuration version. The archived configurations appear in the right pane.

 
     [bookmark: pgfId-61242]Step 3 Select the configuration version to which you want to roll back. You can roll back only to a configuration that was deployed to the device or that originated from the device. You cannot roll back to a configuration that was deployed to a file.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-61244]Tip To view the configuration version before rollback, click View.


     
      

     

     

 
     [bookmark: pgfId-61246]Step 4 Click Rollback to deploy the selected configuration version to the device. A progress box appears, followed by a notification message when the configuration version is successfully deployed.

 
     [bookmark: pgfId-61251]Step 5 (Optional) To make the configuration defined in Security Manager consistent with the one running on the device, rediscover the device policies as described in Discovering Policies on Devices Already in Security Manager.

 
     [bookmark: pgfId-61253]However, it is usually better to correct the policies for the device and to then redeploy the updated configuration. This preserves your changes and shared-policy configuration for the device, which would otherwise be removed if you rediscover policies.

 
     [bookmark: pgfId-61255]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-61271][bookmark: 28168][bookmark: dpman_proc_PerformingRollbackWhenDeployingtoaFile]Performing Rollback When Deploying to a File[bookmark: marker-61261][bookmark: marker-61263][bookmark: marker-61265][bookmark: marker-61267][bookmark: marker-61269]

 
     [bookmark: pgfId-61273]You cannot directly perform rollback when deploying to a file instead of to a device. Use this procedure to revert to a previously stored configuration when deploying to file.

 
     [bookmark: pgfId-61275]Related Topics

 
      
      		 [bookmark: pgfId-61280]Understanding Configuration Rollback

 
      		 [bookmark: pgfId-61285]Understanding Rollback for Devices in Multiple Context Mode

 
      		 [bookmark: pgfId-61290]Understanding Rollback for Failover Devices

 
      		 [bookmark: pgfId-61295]Understanding Rollback for Catalyst 6500/7600 Devices

 
      		 [bookmark: pgfId-61300]Understanding Rollback for IPS and IOS IPS

 
      		 [bookmark: pgfId-61305]Commands that Can Cause Conflicts after Rollback

 
      		 [bookmark: pgfId-61310]Commands to Recover from Failover Misconfiguration after Rollback

 
     

 
     
 
     [bookmark: pgfId-61315]Step 1 Select Manage > Configuration Archive to open the Configuration Archive (see Configuration Archive Window).

 
     [bookmark: pgfId-61317]Step 2 In the Device selector, select the device for which you want to roll back to a different configuration version. The archived configurations appear in the right pane.

 
     [bookmark: pgfId-61319]Step 3 Select the configuration version to which you want to roll back and click View.

 
     [bookmark: pgfId-61321]Step 4 In the Configuration Version Viewer window, make sure the Config Type is set to Full.

 
     [bookmark: pgfId-61323]Step 5 Click in the left-hand pane, then press Ctrl+A followed by Ctrl+C to copy the selected configuration to the Windows clipboard.

 
     [bookmark: pgfId-61325]Step 6 Open a text editor such as NotePad, then press Ctrl+V to paste the contents of the clipboard into the text file.

 
     [bookmark: pgfId-61327]Step 7 Save the file. You can use this file to perform manual rollback.

 
     [bookmark: pgfId-61329]
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     [bookmark: pgfId-329272][bookmark: 20540][bookmark: tmplchap_cncpt_ManagingFlexConfigs]Managing FlexConfigs[bookmark: marker-329270]
      
      
 
     
 

 
    [bookmark: pgfId-329274]FlexConfig policies allow you to configure device commands that are not otherwise supported by Security Manager. By using Flexconfigs, you can extend Security Manager’s control over a device configuration and take advantage of new device features before upgrading the product.

 
    [bookmark: pgfId-329276]FlexConfig policies are made up of FlexConfig objects. These objects are essentially subroutines that can include scripting language commands, device commands, and variables. You can configure an object to be processed prior to applying the Security Manager configuration to a device, or you can have it processed after the configuration. Security Manager processes your objects in the order you specify so that you can create objects whose processing depends on the processing of another object. A FlexConfig policy object’s contents can range from a single simple command string to elaborate CLI command structures that incorporate scripting and variables.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-329281]Note Security Manager can be configured to deploy FlexConfigs only one time after creation or modification of a FlexConfig, or to deploy FlexConfigs with each deployment. By default, Security Manager deploys FlexConfigs one time. If you have FlexConfigs that need to be deployed with each deployment, then you will need disable the "Deploy only new or modified Flexconfigs" setting on the Tools > Security Manager Administration > Deployment page. After changing this setting, you will need manage one-time FlexConfigs by deleting them after they have been deployed. For more information, see Deployment Page.


    
     

    

    

 
    [bookmark: pgfId-329289]Understanding policies and objects is central to understanding and using FlexConfig policy objects. For more information on how Security Manager defines and uses polices, see Chapter 5, “Managing Policies” and for information on how Security Manager defines and uses objects, see Chapter 6, “Managing Policy Objects”.

 
    [bookmark: pgfId-329291]The following topics describe FlexConfig policies and policy objects and how to use them:

 
     
     		 [bookmark: pgfId-329296]Understanding FlexConfig Policies and Policy Objects

 
     		 [bookmark: pgfId-329301]Configuring FlexConfig Policies and Policy Objects

 
     		 [bookmark: pgfId-329306]FlexConfig Policy Page

 
    

 
   
 
    
     [bookmark: pgfId-329322][bookmark: 20563][bookmark: tmplchap_cncpt_UnderstandingFlexConfigPolicyObjects]Understanding FlexConfig Policies and Policy Objects[bookmark: marker-329312][bookmark: marker-329314][bookmark: marker-329316][bookmark: marker-329318][bookmark: marker-329320]

 
    [bookmark: pgfId-329324]FlexConfig policy objects are used in FlexConfig policies. They allow you to configure device features that are not otherwise supported by Security Manager, or to otherwise fine-tune your device configurations. These policy objects include device configuration commands, variables, and optionally, scripting language instructions to control processing. FlexConfig objects are essentially programming routines to add content to the device configurations that Security Manager generates.

 
    [bookmark: pgfId-329326]You can create FlexConfig policy objects from scratch or you can duplicate one of the objects that are included with Security Manager.

 
    [bookmark: pgfId-329328]FlexConfig policies are simply an ordered list of FlexConfig policy objects. Your objects are processed in the order that you specify.

 
    [bookmark: pgfId-329333]The following topics help you understand FlexConfig policy objects and by extension, FlexConfig policies. For more information about policy objects in general, see Chapter 6, “Managing Policy Objects”.

 
     
     		 [bookmark: pgfId-329338]Using CLI Commands in FlexConfig Policy Objects

 
     		 [bookmark: pgfId-329343]Using Scripting Language Instructions

 
     		 [bookmark: pgfId-329348]Understanding FlexConfig Object Variables

 
     		 [bookmark: pgfId-329353]Predefined FlexConfig Policy Objects

 
    

 
     
      [bookmark: pgfId-329363][bookmark: 20601][bookmark: tmplchap_cncpt_CLICommands]Using CLI Commands in FlexConfig Policy Objects[bookmark: marker-329359][bookmark: marker-329361]

 
     [bookmark: pgfId-329365]The configuration commands that you enter into the FlexConfig Editor are actual CLI commands used to configure devices, such as PIX Firewalls and Cisco IOS Routers. You can include CLI commands that are not supported in Security Manager. You are responsible for knowing and implementing the command according to the proper syntax for the device type. See the command reference for the particular operating system for more information.

 
     [bookmark: pgfId-329367]When you create a Flexconfig policy object, you determine whether the commands and instructions should be added to the beginning or end of the configuration that is generated from regular Security Manager policies:

 
      
      		 [bookmark: pgfId-329369]Prepended objects—FlexConfig objects that are processed at the beginning of the configurations. If Security Manager policies configure any of the same commands included in the object, the prepended commands are replaced when configuration files are deployed.

 
      		 [bookmark: pgfId-329371]Appended objects—FlexConfig objects that are processed at the end of the configurations, after all other commands in the configuration file and before the  write mem command.

 
     

 
     [bookmark: pgfId-329373]If the appended commands are already configured on the device, the device generates an error when you try to add them again. To resolve this, two workarounds are available:

 
     [bookmark: pgfId-329375] – Enter the command that removes the configuration in question as an appended command. For example, if the command is xyz, enter the following two lines:

 
     
      [bookmark: pgfId-329377]no xyz
     

     
      [bookmark: pgfId-329379]xyz
     

     [bookmark: pgfId-329381] – Change the setting that controls the action that the device will take to “warn.” This is set under Tools > Security Administration > Deployment.

 
     [bookmark: pgfId-329383]The setting change will affect the behavior of devices for all commands being deployed, not just those designated as appended commands.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-329385]Note If you are deploying to a device, you should remove most appended commands after the initial deployment. This is especially true for object groups, where any unbound object group is replaced in the Ending Command section during command generation, then re-sent each time the configuration is deployed to a device. The device displays an error because the firewall device shows that the object group already exists. If you are deploying to a file or AUS, the appended commands should remain.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-329397][bookmark: 20630][bookmark: tmplchap_cncpt_ScriptingLanguageInstructions]Using Scripting Language Instructions[bookmark: marker-329391][bookmark: marker-329393][bookmark: marker-329395]

 
     [bookmark: pgfId-329399]You can use scripting language instructions in a FlexConfig policy object to control how the commands in the object are processed. Scripting language instructions are a subset of commands supported in the Velocity Template Engine, a Java-based scripting language that supports looping, if/else statements, and variables.

 
     [bookmark: pgfId-329401]Security Manager supports all Velocity Template Engine commands except the include and parse commands. For information about additional supported commands supported, see the Velocity Template Engine documentation.

 
     [bookmark: pgfId-329403]The following topics provide examples of the most commonly used functions:

 
      
      		 [bookmark: pgfId-329408]Scripting Language Example 1: Looping

 
      		 [bookmark: pgfId-329413]Scripting Language Example 2: Looping with Two-Dimensional Arrays

 
      		 [bookmark: pgfId-329418]Example 3: Looping with If/Else Statements

 
     

 
    
 
     
      [bookmark: pgfId-329428][bookmark: 20657][bookmark: tmplchap_cncpt_ExampleLooping]Scripting Language Example 1: Looping[bookmark: marker-329424][bookmark: marker-329426]

 
     [bookmark: pgfId-329430]A plain old telephone service (POTS) dial peer enables incoming calls to be received by a telephony device by associating a telephone number to a voice port. The following example enables caller ID for a set of POTS dial peers.

 
     [bookmark: pgfId-329432]Object Body

 
     
      [bookmark: pgfId-329434]#foreach ($peer_id in ["2", "3", "4"])
     

     
      [bookmark: pgfId-329436] dial-peer voice $peer_id pots
     

     
      [bookmark: pgfId-329438] caller-id
     

     
      [bookmark: pgfId-329440]#end
     

     
      [bookmark: pgfId-329442] 
     

     [bookmark: pgfId-329444]CLI Output

 
     
      [bookmark: pgfId-329446]dial-peer voice 2 pots
     

     
      [bookmark: pgfId-329448]caller-id
     

     
      [bookmark: pgfId-329450] 
     

     
      [bookmark: pgfId-329452]dial-peer voice 3 pots
     

     
      [bookmark: pgfId-329454]caller-id
     

     
      [bookmark: pgfId-329456] 
     

     
      [bookmark: pgfId-329458]dial-peer voice 4 pots
     

     
      [bookmark: pgfId-329460]caller-id
     

    
 
     
      [bookmark: pgfId-329470][bookmark: 20685][bookmark: tmplchap_cncpt_ExampleLoopingwithTwoDimensionalArrays]Scripting Language Example 2: Looping with Two-Dimensional Arrays [bookmark: marker-329466][bookmark: marker-329468]

 
     [bookmark: pgfId-329472]In this example, a set of phone numbers is associated to voice ports so that incoming calls can be received at a router.

 
     [bookmark: pgfId-329474]Object Body

 
     
      [bookmark: pgfId-329476]#foreach ($phone in [ [ "2000", "15105552000", "1/0/0" ], [ "2100", 
     

     
      [bookmark: pgfId-329478]"15105552100", "1/0/1" ], [ "2200", "15105552200", "1/0/2" ] ] )
     

     
      [bookmark: pgfId-329480] dial-peer voice $phone.get(0) pots
     

     
      [bookmark: pgfId-329482] destination-pattern $phone.get(1)
     

     
      [bookmark: pgfId-329484] port $phone.get(2)
     

     
      [bookmark: pgfId-329486]#end
     

     
      [bookmark: pgfId-329488] 
     

     [bookmark: pgfId-329490]CLI Output

 
     
      [bookmark: pgfId-329492]dial-peer voice 2000 pots
     

     
      [bookmark: pgfId-329494]destination-pattern 15105552000
     

     
      [bookmark: pgfId-329496]port 1/0/0 
     

     
      [bookmark: pgfId-329498] 
     

     
      [bookmark: pgfId-329500]dial-peer voice 2100 pots
     

     
      [bookmark: pgfId-329502]destination-pattern 15105552100
     

     
      [bookmark: pgfId-329504]port 1/0/1
     

     
      [bookmark: pgfId-329506] 
     

     
      [bookmark: pgfId-329508]dial-peer voice 2200 pots
     

     
      [bookmark: pgfId-329510]destination-pattern 15105552200
     

     
      [bookmark: pgfId-329512]port 1/0/2
     

    
 
     
      [bookmark: pgfId-329522][bookmark: 20718][bookmark: tmplchap_cncpt_ExampleLoopingwithIfElseStatements]Example 3: Looping with If/Else Statements [bookmark: marker-329518][bookmark: marker-329520]

 
     [bookmark: pgfId-329524]In this example, a set of phone numbers is associated to voice ports so that incoming calls can be received at a router. In addition, another set of phone numbers is associated to IP addresses to enable Voice Over IP outgoing calls from the router.

 
     [bookmark: pgfId-329526]Object Body

 
     
      [bookmark: pgfId-329528]#foreach ( $phone in [ [ "2000", "15105552000", "1/0/0", "" ],
     

     
      [bookmark: pgfId-329530][ "2100", "15105552100", "1/0/1", "" ],
     

     
      [bookmark: pgfId-329532][ "2200", "15105552200", "", "ipv4:150.50.55.55"]
     

     
      [bookmark: pgfId-329534][ "2300", "15105552300", "", "ipv4:150.50.55.55"] ] )
     

     
      [bookmark: pgfId-329536] dial-peer voice $phone.get(0) pots
     

     
      [bookmark: pgfId-329538] destination-pattern $phone.get(1)
     

     
      [bookmark: pgfId-329540] #if ( $phone.get(2) == "" )
     

     
      [bookmark: pgfId-329542] session target $phone.get(3)
     

     
      [bookmark: pgfId-329544] #else
     

     
      [bookmark: pgfId-329546] port $phone.get(2)
     

     
      [bookmark: pgfId-329548] #end
     

     
      [bookmark: pgfId-329550]  
     

     
      [bookmark: pgfId-329552]#end
     

     
      [bookmark: pgfId-329554] 
     

     [bookmark: pgfId-329556]CLI Output

 
     
      [bookmark: pgfId-329558]dial-peer voice 2000 pots
     

     
      [bookmark: pgfId-329560] destination-pattern 15105552000
     

     
      [bookmark: pgfId-329562] port 1/0/0
     

     
      [bookmark: pgfId-329564]  
     

     
      [bookmark: pgfId-329566]dial-peer voice 2100 pots
     

     
      [bookmark: pgfId-329568] destination-pattern 15105552100
     

     
      [bookmark: pgfId-329570] port 1/0/1
     

     
      [bookmark: pgfId-329572]  
     

     
      [bookmark: pgfId-329574]dial-peer voice 2200 pots
     

     
      [bookmark: pgfId-329576] destination-pattern 15105552000
     

     
      [bookmark: pgfId-329578] session target ipv4:150.50.55.55
     

     
      [bookmark: pgfId-329580]  
     

     
      [bookmark: pgfId-329582]dial-peer voice 2300 pots
     

     
      [bookmark: pgfId-329584] destination-pattern 15105552300
     

     
      [bookmark: pgfId-329586] session target ipv4:150.50.55.55
     

    
 
     
      [bookmark: pgfId-329600][bookmark: 20763][bookmark: tmplchap_cncpt_ObjectVariables]Understanding FlexConfig Object Variables [bookmark: marker-329592][bookmark: marker-329594][bookmark: marker-329596][bookmark: marker-329598]

 
     [bookmark: pgfId-329602]Variables in FlexConfig policy objects start with the $ character. For example, in the following line, $inside is a variable:

 
     
      [bookmark: pgfId-329604]interface $inside
     

     
      [bookmark: pgfId-329606] 
     

     
      [bookmark: pgfId-329608] 
     

     [bookmark: pgfId-329610]There are three types of variables you can use in a FlexConfig policy object:

 
      
      		 [bookmark: pgfId-329612]Policy object variables—Static variables that reference a specific property. For example, Text objects are a type of policy object variable. They are a name and value pair, and the value can be a single string, a list of strings, or a table of strings. Their flexibility allows you to enter any type of textual data to be referenced and acted upon by any policy object.

 
     

 
     [bookmark: pgfId-329614]There are three ways to add policy object variables to a FlexConfig policy object. First, move the cursor to the desired location, and then:

 
     [bookmark: pgfId-329619] – Right-click and select Create Text Object. This command opens a dialog box where you can create a simple single-value text object and assign it a value. When you click OK, the variable is added to the object, and it is added to the list of defined Text objects in the Policy Object Manager window so that you can use it in other objects or edit its definition. For an example of creating simple text variables, see Example of FlexConfig Policy Object Variables.

 
     [bookmark: pgfId-329621] – Right-click and select a policy object type from the Insert Policy Object sub-menu. These commands open a selector dialog box where you can select the specific policy object that contains the variable that you want to insert. After selecting the policy object, you are presented with the Property Selector dialog box, where you choose the specific property of the object that you want to use and optionally change the name of the variable associated with the property.

 
     [bookmark: pgfId-329623]By using this technique, you can add a property from an existing policy object when you know that the property has the value that you want to use. For example, if you want to insert a variable that specifies the RADIUS protocol from the AAA Server Group policy object named RADIUS, you would right-click, select Insert Policy Object > AAA Server Group, select RADIUS in the AAA Server Group Selector dialog box, click OK, and then select Protocol in the Object Property field on the AAA Server Group Property Selector dialog box and click OK. The $protocol variable is inserted at the cursor, and the value for the property as defined in the selected object is added to the variables list.

 
     [bookmark: pgfId-329625] – Type in a variable name. If you type in a variable, you cannot assign it a value until you click OK on the Add or Edit FlexConfig dialog box. You will be prompted that a variable is undefined, and given the opportunity to define its value. In the FlexConfig Undefined Variable dialog box, you can select the object type of the policy object that contains the desired value, which will prompt you to select the specific policy object and variable. This is essentially identical to the process for inserting policy object variables described above. The technique you use is a matter of personal preference; the end result is the same.

 
      
      		 [bookmark: pgfId-329627]System variables—Dynamic variables that reference a value during deployment when the configuration is generated. The values are obtained from either the target device or policies configured for the target device. You can declare system variables to be optional in FlexConfig policy objects, which means that the variables do not need to be assigned a value for it to be deployed to the device.

 
     

 
     [bookmark: pgfId-329632]To insert a system variable into a FlexConfig policy object, move the cursor to the desired location, right-click, and select the variable from the Insert System Variable sub-menus. For a description of the available system variables, see FlexConfig System Variables.

 
      
      		 [bookmark: pgfId-329634]Local Variables—Variables that are local in the looping and assignment derivatives (the  for each and  set statements). Local variables get their values directly from the Velocity Template Engine. There is no need to supply values for the local variables.

 
     

 
     [bookmark: pgfId-329636]To insert a local variable, simply type it in. When you click OK on the Add or Edit FlexConfig dialog box, you will be asked if you want to define the undefined variable. You can click No, or if you click Yes to define other variables, you can leave the object type of the local variable as Undefined.

 
    
 
     
      [bookmark: pgfId-329650][bookmark: 20809][bookmark: tmplchap_cncpt_FlexConfigPolicyObjectExample]Example of FlexConfig Policy Object Variables [bookmark: marker-329642][bookmark: marker-329644][bookmark: marker-329646][bookmark: marker-329648]

 
     [bookmark: pgfId-329652]Using CLI commands and variables, you can create a FlexConfig policy object to name the inside interface and crypto map on a Cisco router:

 
     
      [bookmark: pgfId-329654]interface $inside
     

     
      [bookmark: pgfId-329656]crypto map $mapname
     

     
      [bookmark: pgfId-329658] 
     

     [bookmark: pgfId-329660]The following example shows how to create a FlexConfig policy object that adds these commands and configures the value of $inside as serial0 and $mapname as my_crypto.

 
     [bookmark: pgfId-329662]When you add the FlexConfig policy object to a device, and the configuration is generated, the following output is created:

 
     
      [bookmark: pgfId-329664]interface serial0
     

     
      [bookmark: pgfId-329666]crypto map my_crypto
     

     
 
     [bookmark: pgfId-329671]Step 1 Select Manage > Policy Objects to open the Policy Object Manager (see Policy Object Manager).

 
     [bookmark: pgfId-329673]Step 2 Select FlexConfigs from the table of contents. The table in the right pane lists the existing FlexConfig objects.

 
     [bookmark: pgfId-329678]Step 3 Right-click in the table and select New Object. The Add FlexConfig dialog box appears (see Add or Edit FlexConfig Dialog Box).

 
     [bookmark: pgfId-329680]Step 4 Enter a name and optionally a description for the object.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-329682]Tip You can also enter a group name. Groups help you find FlexConfig objects if you create a lot of them. Either type in a group name, or select an existing one from the drop-down list.


     
      

     

     

 
     [bookmark: pgfId-329684]Step 5 Keep Appended for Type so that the commands are added at the end of the device configuration.

 
     [bookmark: pgfId-329686]Step 6 Create the content of the object:

 
     [bookmark: pgfId-329688] a. Click in the FlexConfig edit box (the large white box) and type in interface followed by a space.

 
     [bookmark: pgfId-329690] b. Right-click and select Create Text Object.

 
     [bookmark: pgfId-329692] c. In the Create Text Object dialog box, enter inside as the name and serial0 as the value. Click OK to add the variable.

 
     [bookmark: pgfId-329694] d. Press Enter to move to the next line and type crypto map followed by a space.

 
     [bookmark: pgfId-329696] e. Right-click and select Create Text Object.

 
     [bookmark: pgfId-329698] f. In the Create Text Object dialog box, enter mapname as the name and my_crypto as the value. Click OK to add the variable.

 
     [bookmark: pgfId-329700]Step 7 Click the Validate FlexConfig icon button above the edit box to check the integrity and deployability of the object. If any errors are identified, fix them.

 
     [bookmark: pgfId-329702]Step 8 Click OK to save the policy object. You can now add the object to a device’s local or shared FlexConfig policy.

 
     [bookmark: pgfId-329704]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-329718][bookmark: 20886][bookmark: tmplchap_cncpt_FlexConfigSystemVariables]FlexConfig System Variables[bookmark: marker-329710][bookmark: marker-329712][bookmark: marker-329714][bookmark: marker-329716]

 
     [bookmark: pgfId-329720]System variables reference values during deployment when commands are generated. Security Manager provides a set of defined system variables for you to use in defining FlexConfig policy objects. The values come from the policies you create for the target devices. The values for these variables are required unless otherwise noted. For information about these variables, see the following tables:

 
      
      		 [bookmark: pgfId-329728]Device system variables—Table 7-1. For more information about discovering or configuring devices to obtain values for these variables, see Chapter 3, “Managing the Device Inventory”.

 
      		 [bookmark: pgfId-329739]Firewall system variables—Table 7-2. For more information about firewall policies, see Chapter 46, “Managing Firewall Devices” and Chapter 12, “Introduction to Firewall Services”.

 
      		 [bookmark: pgfId-329747]Router platform system variables—Table 7-3. For more information about router policies, see Chapter 60, “Managing Routers”.

 
      		 [bookmark: pgfId-329755]VPN system variables—Table 7-4. For more information about VPN policies, see Chapter 25, “Managing Site-to-Site VPNs: The Basics”.

 
      		 [bookmark: pgfId-329763]Remote access system variables—Table 7-5. For more information about remote access policies, see Chapter 30, “Managing Remote Access VPNs: The Basics”.

 
     

 
     [bookmark: pgfId-329766] 

 
      
       
        
        [bookmark: pgfId-325635]Table 7-1 [bookmark: 20928]Device System Variables (Applying to All Device Types) 

 
        
       
         
         		
           
           [bookmark: pgfId-325649]Name
           [bookmark: marker-325643]
           [bookmark: marker-325645]
           [bookmark: marker-325647]
          
  
         		
           
           [bookmark: pgfId-325651]Dimension
          
  
         		
           
           [bookmark: pgfId-325653]Description
          
  
        

 
         
         		[bookmark: pgfId-325661]SYS_DEVICE_IDENTITY

  
         		[bookmark: pgfId-325663]0

  
         		[bookmark: pgfId-325665]Unique device identity for devices managed by a Configuration Engine or Auto Update Server (AUS) as defined on the Tools > Device Properties > General tab. There must be a device identity for devices managed by these servers.

  
        

 
         
         		[bookmark: pgfId-325673]SYS_DOMAIN_NAME

  
         		[bookmark: pgfId-325675]0

  
         		[bookmark: pgfId-325677]DNS domain name as defined on the Tools > Device Properties > General tab. This is not necessarily the same value that is defined in the Platform > Device Admin > Hostname policy.

  
        

 
         
         		[bookmark: pgfId-325685]SYS_FW_OS_MODE

  
         		[bookmark: pgfId-325687]0

  
         		[bookmark: pgfId-325689]Operating system mode of the FWSM or ASA device as defined on the Tools > Device Properties > General tab. Possible values are ROUTER (routed mode), TRANSPARENT, or NOT_APPLICABLE.

  
        

 
         
         		[bookmark: pgfId-325697]SYS_FW_OS_MULTI

  
         		[bookmark: pgfId-325699]0

  
         		[bookmark: pgfId-325701]Whether the FWSM or ASA is running in single- or multiple-context mode as defined on the Tools > Device Properties > General tab. Possible values are SINGLE, MULTI, or NOT_APPLICABLE.

  
        

 
         
         		[bookmark: pgfId-325709]SYS_HOSTNAME

  
         		[bookmark: pgfId-325711]0

  
         		[bookmark: pgfId-325713]Device hostname as defined on the Tools > Device Properties > General tab. This is not necessarily the same value that is defined in the Platform > Device Admin > Hostname policy.

  
        

 
         
         		[bookmark: pgfId-325721]SYS_IMAGE_NAME

  
         		[bookmark: pgfId-325723]0

  
         		[bookmark: pgfId-325725]Device image name as defined on the Tools > Device Properties > General tab.

  
        

 
         
         		[bookmark: pgfId-325733]SYS_INTERFACE_IP_LIST

  
         		[bookmark: pgfId-325735]1

  
         		[bookmark: pgfId-325737]IP addresses and masks of the interfaces configured in the Interfaces policy.

 [bookmark: pgfId-325739]The IP address and mask are in the x.x.x.x/nn format (for example, 10.20.1.2/24). If there are no interfaces defined on the device, no list is returned.

 [bookmark: pgfId-325741]Each element in SYS_INTERFACE_NAME_LIST and SYS_INTERFACE_IP_LIST share the same index for the interface. For example, if element 3 in SYS_INTERFACE_NAME_LIST is for Ethernet1, element 3 in SYS_INTERFACE_IP_LIST is the IP address for Ethernet1. If Ethernet1 has no IP address, element 3 in the SYS_INTERFACE_IP_LIST is empty.

 [bookmark: pgfId-325743]This variable is optional.

  
        

 
         
         		[bookmark: pgfId-325751]SYS_INTERFACE_NAME_LIST

  
         		[bookmark: pgfId-325753]1

  
         		[bookmark: pgfId-325755]Names of the interfaces on the device configured in the Interfaces policy. If no interfaces are defined on the device, no list is returned. See the explanation above for SYS_INTERFACE_IP_LIST for additional information.

 [bookmark: pgfId-325757]This variable is optional.

  
        

 
         
         		[bookmark: pgfId-325765]SYS_MANAGEMENT_IP

  
         		[bookmark: pgfId-325767]0

  
         		[bookmark: pgfId-325769]Management IP address of the device as defined on the Tools > Device Properties > General tab.

  
        

 
         
         		[bookmark: pgfId-325777]SYS_MDF_TYPE

  
         		[bookmark: pgfId-325779]0

  
         		[bookmark: pgfId-325781]Cisco MDF (MetaData Framework) device type, which indicates the device model. This value is displayed on the Tools > Device Properties > General tab, and is determined when you add the device to Security Manager.

  
        

 
         
         		[bookmark: pgfId-325789]SYS_OS_RUNNING_VERSION

  
         		[bookmark: pgfId-325791]0

  
         		[bookmark: pgfId-325793]Software version of the operating system running on the device as displayed on the Tools > Device Properties > General tab. For example, 12.1, 12.2S, and so on, on an IOS platform. This value is determined when you discover policies from the device.

  
        

 
         
         		[bookmark: pgfId-325801]SYS_OS_TARGET_VERSION

  
         		[bookmark: pgfId-325803]0

  
         		[bookmark: pgfId-325805]Operating system version to be used when generating the device configuration as defined on the Tools > Device Properties > General tab.

  
        

 
         
         		[bookmark: pgfId-325813]SYS_OS_TYPE

  
         		[bookmark: pgfId-325815]0

  
         		[bookmark: pgfId-325817]Operating system for the device as defined on the Tools > Device Properties > General tab. Possible values are IOS, PIX, ASA, FWSM, IPS. You configure this value when you add the device to Security Manager.

  
        

 
         
         		[bookmark: pgfId-325825]SYS_SYS_OID

  
         		[bookmark: pgfId-325827]0

  
         		[bookmark: pgfId-325829]System object ID (SysObjId) of the device, which is determined when you add the device to Security Manager.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-329769] 

 
      
       
        
        [bookmark: pgfId-325844]Table 7-2 [bookmark: 21054]Firewall System Variables 

 
        
       
         
         		
           
           [bookmark: pgfId-325858]Name
           [bookmark: marker-325852]
           [bookmark: marker-325854]
           [bookmark: marker-325856]
          
  
         		
           
           [bookmark: pgfId-325860]Dimension
          
  
         		
           
           [bookmark: pgfId-325862]Description
          
  
        

 
         
         		[bookmark: pgfId-325870]SYS_FPM_INPUT_SP

  
         		[bookmark: pgfId-325872]1

  
         		[bookmark: pgfId-325874]FPM policy map names applied on the interface corresponding to the entry in the SYS_FPM_INTERFACE list in the “in” direction.

 [bookmark: pgfId-325876]This data is not configured in Security Manager. It is obtained from a router’s running configuration and is used by the IOS_FPM FlexConfig.

  
        

 
         
         		[bookmark: pgfId-325884]SYS_FPM_INTERFACE

  
         		[bookmark: pgfId-325886]1

  
         		[bookmark: pgfId-325888]Interface names.

 [bookmark: pgfId-325890]This data is not configured in Security Manager. It is obtained from a router’s running configuration and is used by the IOS_FPM FlexConfig.

  
        

 
         
         		[bookmark: pgfId-325898]SYS_FPM_OUTPUT_SP

  
         		[bookmark: pgfId-325900]1

  
         		[bookmark: pgfId-325902]FPM policy map names applied on the interface corresponding to the entry in the SYS_FPM_INTERFACE list in the “out” direction.

 [bookmark: pgfId-325904]This data is not configured in Security Manager. It is obtained from a router’s running configuration and is used by the IOS_FPM FlexConfig.

  
        

 
         
         		[bookmark: pgfId-325912]SYS_FW_ACL_IN_NAME

  
         		[bookmark: pgfId-325914]1

  
         		[bookmark: pgfId-325916]Names of ACLs applied to interfaces for traffic filtering in the inbound direction. Each element has a one-to-one correspondence with the SYS_INTERFACE_NAME_LIST variable for Cisco IOS routers, PIX Firewalls, Firewall Service Modules, and ASA devices.

 [bookmark: pgfId-325918]Configure firewall access rules to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-325926]SYS_FW_ACL_OUT_NAME

  
         		[bookmark: pgfId-325928]1

  
         		[bookmark: pgfId-325930]Names of ACLs applied to interfaces for traffic filtering in the outbound direction. Each element of this array has a one-to-one correspondence with SYS_INTERFACE_NAME_LIST variable for Cisco IOS routers, PIX Firewalls, Firewall Service Modules, and ASA devices.

 [bookmark: pgfId-325932]Configure Access Rules policies to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-325940]SYS_FW_BRIDGE_INTERFACE_NAMES

  
         		[bookmark: pgfId-325942]1

  
         		[bookmark: pgfId-325944]Names of bridge interfaces.

 [bookmark: pgfId-325946]This variable applies only to IOS transparent firewalls.

 [bookmark: pgfId-325948]Configure the Firewall > Transparent Rules policies to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-325956]SYS_FW_ETHERTYPERULE_ ACL_NAMES

  
         		[bookmark: pgfId-325958]1

  
         		[bookmark: pgfId-325960]Names of ethertype access-lists applied to interfaces for traffic filtering coming in or going out. Each element of this array has a one-to-one correspondence with the elements in the SYS_FW_ETHERTYPERULE_INTERFACE_NAMES and SYS_FW_ETHERTYPERULE_DIRECTION_NAMES variables.

 [bookmark: pgfId-325962]Configure Firewall > Transparent Rules policies to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-325970]SYS_FW_ETHERTYPERULE_ DIRECTION_NAMES

  
         		[bookmark: pgfId-325972]1

  
         		[bookmark: pgfId-325974]Direction that ethertype access-lists are applied. The value is either “in” or “out.” Each element has a one-to-one correspondence with the elements in the SYS_FW_ETHERTYPERULE_ACL_NAMES and SYS_FW_ETHERTYPERULE_INTERFACE_NAMES variables.

 [bookmark: pgfId-325976]Configure Firewall > Transparent Rules policies to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-325984]SYS_FW_ETHERTYPERULE_ INTERFACE_NAMES

  
         		[bookmark: pgfId-325986]1

  
         		[bookmark: pgfId-325988]Interface names to which ethertype access-lists are applied. Each element has a one-to-one correspondence with the SYS_FW_ETHERTYPERULE_ACL_NAMES and SYS_FW_ETHERTYPERULE_DIRECTION_NAMES variables.

 [bookmark: pgfId-325990]Configure Firewall > Transparent Rules policies to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-325998]SYS_FW_INSPECT_IN_NAME

  
         		[bookmark: pgfId-326000]1

  
         		[bookmark: pgfId-326002]Names of Inspect Rules applied to Cisco IOS router interfaces in the inbound direction. Each element of this array has a one-to-one correspondence with the SYS_INTERFACE_NAME_LIST variable for Cisco IOS routers.

 [bookmark: pgfId-326004]Configure Inspection Rules policies to generate values for this variable.

 [bookmark: pgfId-326006]This variable is optional.

  
        

 
         
         		[bookmark: pgfId-326014]SYS_FW_INSPECT_OUT_NAME

  
         		[bookmark: pgfId-326016]1

  
         		[bookmark: pgfId-326018]Names of Inspect rules applied to Cisco IOS router interfaces in the outbound direction. Each element of this array has a one-to-one correspondence with the SYS_INTERFACE_NAME_LIST variable for Cisco IOS routers.

 [bookmark: pgfId-326020]Configure Inspection Rules policies as values for this variable.

 [bookmark: pgfId-326022]This variable is optional.

  
        

 
         
         		[bookmark: pgfId-326030]SYS_FW_INTERFACE_HARDWARE_ ID_ LIST

  
         		[bookmark: pgfId-326032]1

  
         		[bookmark: pgfId-326034]Hardware IDs for the device.

 [bookmark: pgfId-326036]Configure Interface policies on the device to generate values for this variable.

 [bookmark: pgfId-326038]This variable is optional.

  
        

 
         
         		[bookmark: pgfId-326046]SYS_FW_INTERFACE_NETWORK_LIST

  
         		[bookmark: pgfId-326048]1

  
         		[bookmark: pgfId-326050]Interface networks on the device.

 [bookmark: pgfId-326052]Configure Interface policies on the device to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-326060]SYS_FW_INTERFACE_SECURITY_ LEVEL_LIST

  
         		[bookmark: pgfId-326062]1

  
         		[bookmark: pgfId-326064]Interface security levels on the device.

 [bookmark: pgfId-326066]Configure Interface policies on the device to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-326074]SYS_FW_INTERFACE_STATE_LIST

  
         		[bookmark: pgfId-326076]1

  
         		[bookmark: pgfId-326078]Interface states on the device.

 [bookmark: pgfId-326080]Configure Interface policies on the device to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-326088]SYS_FW_INTERFACE_VLAN_ID_LIST

  
         		[bookmark: pgfId-326090]0

  
         		[bookmark: pgfId-326092]VLAN IDs on the device.

 [bookmark: pgfId-326094]Configure Interface policies on the device to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-326102]SYS_FW_IPV6_ACL_IN_NAME

  
         		[bookmark: pgfId-326104]1

  
         		[bookmark: pgfId-326106]A list of all IPv6 ACLs in the In direction on the device.

 [bookmark: pgfId-326108]Configure IPv6 Access Rules policies in the In direction on the device to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-326116]SYS_FW_IPV6_ACL_OUT_NAME

  
         		[bookmark: pgfId-326118]1

  
         		[bookmark: pgfId-326120]A list of all IPv6 ACLs in the Out direction on the device.

 [bookmark: pgfId-326122]Configure IPv6 Access Rules policies in the Out direction on the device to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-326130]SYS_FW_MPCRULE_TRAFFICFLOW_ TUNNELGROUPNAME

  
         		[bookmark: pgfId-326132]1

  
         		[bookmark: pgfId-326134]Names of tunnel groups specified in Traffic Flow objects.

 [bookmark: pgfId-326136]Traffic Flow objects configure class-map commands on PIX/ASA devices, and the names of the tunnel groups listed in Traffic Flow objects populate this variable. This variable is used by the ASA_define_traffic_flow_tunnel_group FlexConfig object to create tunnel groups on PIX/ASA devices.

 [bookmark: pgfId-326138]This variable is optional.

  
        

 
         
         		[bookmark: pgfId-326146]SYS_FW_MULTICAST_PIM_ACCEPT_ REG_ROUTEMAP

  
         		[bookmark: pgfId-326148]0

  
         		[bookmark: pgfId-326150]Route-map name used in the pim accept-register route-map command.

 [bookmark: pgfId-326152]Enter a name for the route-map (Platform > Multicast > PIM > Request Filter), then configure its features using FlexConfig to generate values for this variable.

 [bookmark: pgfId-326154]This variable is optional.

  
        

 
         
         		[bookmark: pgfId-326162]SYS_FW_NAT0_ACL_NAMES

  
         		[bookmark: pgfId-326164]1

  
         		[bookmark: pgfId-326166]Names of ACLs used in the nat interface_name 0 access-list acl_name command.

 [bookmark: pgfId-326168]This variable is optional.

  
        

 
         
         		[bookmark: pgfId-326176]SYS_FW_OSPF_PROCESS_ID_LIST

  
         		[bookmark: pgfId-326178]1

  
         		[bookmark: pgfId-326180]IDs for OSPF routing processes globally configured on PIX Firewalls, Firewall Service Modules, and ASA devices.

 [bookmark: pgfId-326182]Configure Platform > Routing > OSPF policies to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-326190]SYS_FW_OSPF_REDISTRIBUTION_ ROUTE_MAP_LIST

  
         		[bookmark: pgfId-326192]1

  
         		[bookmark: pgfId-326194]Names for the route maps to apply to the OSPF redistribute commands configured on PIX Firewalls, Firewall Service Modules, and ASA devices.

 [bookmark: pgfId-326196]Configure Platform > Routing > OSPF policies to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-326204]SYS_FW_POLICY_NAT_ACL_NAMES

  
         		[bookmark: pgfId-326206]1

  
         		[bookmark: pgfId-326208]Names of ACLs used in the policy nat commands (nat commands with non-0 pool id).

 [bookmark: pgfId-326210]Configure NAT (NAT > Translation Rules > Policy NAT) to generate values for this variable. This variable applies to only PIX 6.3(3) and higher, PIX/ASA 7.x, 8.0(x), 8.1(x), and 8.2(x), and FWSM devices. This variable does not apply to Cisco IOS routers.

 [bookmark: pgfId-326212]This variable is optional.

  
        

 
         
         		[bookmark: pgfId-326220]SYS_FW_POLICY_STATIC_ ACL_NAMES

  
         		[bookmark: pgfId-326222]1

  
         		[bookmark: pgfId-326224]Names of ACLs used in the policy static commands that include access lists.

 [bookmark: pgfId-326226]Configure NAT 0 (NAT > Translation Rules > Policy NAT) to generate values for this variable. The variable contains the access-list names used by the nat-0, policy nat, and policy static commands.

 [bookmark: pgfId-326228]This variable applies to only PIX 6.3(3) and higher, PIX/ASA 7.x, 8.0(x), 8.1(x), and 8.2(x), and FWSM devices. This variable does not apply to Cisco IOS routers.

 [bookmark: pgfId-326230]This variable is optional.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-329772] 

 
      
       
        
        [bookmark: pgfId-326245]Table 7-3 [bookmark: 21299]Router Platform System Variables 

 
        
       
         
         		
           
           [bookmark: pgfId-326259]Name
           [bookmark: marker-326253]
           [bookmark: marker-326255]
           [bookmark: marker-326257]
          
  
         		
           
           [bookmark: pgfId-326261]Dimension
          
  
         		
           
           [bookmark: pgfId-326263]Description
          
  
        

 
         
         		[bookmark: pgfId-326271]SYS_ROUTER_BGP_AS_NUMBERS_LIST

  
         		[bookmark: pgfId-326273]1

  
         		[bookmark: pgfId-326275]Autonomous system (AS) number of the border gateway protocol (BGP) and exterior gateway protocol (EGP) on the device.

 [bookmark: pgfId-326277]Configure Router Platform > Routing > BGP policies to generate values for this variable.

 [bookmark: pgfId-326279]This variable is optional.

  
        

 
         
         		[bookmark: pgfId-326287]SYS_ROUTER_EIGRP_AS_ NUMBERS_LIST

  
         		[bookmark: pgfId-326289]1

  
         		[bookmark: pgfId-326291]Autonomous system (AS) numbers of the different enhanced Internet gateway routing protocols (EIGRP) and interior gateway protocols (IGP) on the device.

 [bookmark: pgfId-326293]Configure Router Platform > Routing > EIGRP policies to generate values for this variable.

 [bookmark: pgfId-326295]This variable is optional.

  
        

 
         
         		[bookmark: pgfId-326303]SYS_ROUTER_OSPF_PROCESS_ IDS_LIST

  
         		[bookmark: pgfId-326305]1

  
         		[bookmark: pgfId-326307]Open shortest path first (OSPF) interior gateway protocol (IGP) process numbers on the device.

 [bookmark: pgfId-326309]Configure Router Platform > Routing > OSPF Process policies to generate values for this variable.

 [bookmark: pgfId-326311]This variable is optional.

  
        

 
         
         		[bookmark: pgfId-326319]SYS_ROUTER_QOS_CLASS_MAP_LIST

  
         		[bookmark: pgfId-326321]1

  
         		[bookmark: pgfId-326323]Names of QoS class maps on the device.

 [bookmark: pgfId-326325]Configure Quality of Service policies to generate values for this variable.

 [bookmark: pgfId-326327]This variable is optional.

  
        

 
         
         		[bookmark: pgfId-326335]SYS_ROUTER_QOS_POLICY_MAP_LIST

  
         		[bookmark: pgfId-326337]1

  
         		[bookmark: pgfId-326339]Names of the QoS policy-maps on the device.

 [bookmark: pgfId-326341]Configure Quality of Service policies to generate values for this variable.

 [bookmark: pgfId-326343]This variable is optional.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-329775] 

 
      
       
        
        [bookmark: pgfId-326358]Table 7-4 [bookmark: 21368]VPN System Variables 

 
        
       
         
         		
           
           [bookmark: pgfId-326372]Name
           [bookmark: marker-326366]
           [bookmark: marker-326368]
           [bookmark: marker-326370]
          
  
         		
           
           [bookmark: pgfId-326374]Dimension
          
  
         		
           
           [bookmark: pgfId-326376]Description
          
  
        

 
         
         		 [bookmark: pgfId-326384]Topology

 [bookmark: pgfId-326386]Variables related to the VPN in which a device participates. Configure VPNs to generate values for these variables.

  
        

 
         
         		[bookmark: pgfId-326398]SYS_VPN_TOPOLOGY

  
         		[bookmark: pgfId-326400]1

  
         		[bookmark: pgfId-326402]Virtual private network (VPN) topology type. Possible values are HUB_AND_SPOKE, POINT_TO_POINT, and FULL_MESH.

  
        

 
         
         		[bookmark: pgfId-326410]SYS_VPN_TOPOLOGY_NAME

  
         		[bookmark: pgfId-326412]1

  
         		[bookmark: pgfId-326414]Name of the VPN topology in which the device participates.

  
        

 
         
         		[bookmark: pgfId-326422]SYS_VPN_TOPOLOGY_ROLE

  
         		[bookmark: pgfId-326424]1

  
         		[bookmark: pgfId-326426]Details about the role of the device in the VPN. Possible values are PEER, HUB, and SPOKE.

  
        

 
         
         		 [bookmark: pgfId-326434]Devices

 [bookmark: pgfId-326436]Variables related to devices in the VPN in which a device participates. Configure VPNs to generate values for these variables.

  
        

 
         
         		[bookmark: pgfId-326448]SYS_VPN_HOST_NAME

  
         		[bookmark: pgfId-326450]1

  
         		[bookmark: pgfId-326452]Device hostname.

  
        

 
         
         		[bookmark: pgfId-326460]SYS_VPN_LOCAL_PREFIXES

  
         		[bookmark: pgfId-326462]2

  
         		[bookmark: pgfId-326464]Interface and network IP addresses of protected networks.

  
        

 
         
         		[bookmark: pgfId-326472]SYS_VPN_PRIVATE_INTERFACES

  
         		[bookmark: pgfId-326474]2

  
         		[bookmark: pgfId-326476]Private interface names.

  
        

 
         
         		[bookmark: pgfId-326484]SYS_VPN_PRIVATE_TUNNEL_ENDPT_IP

  
         		[bookmark: pgfId-326486]1

  
         		[bookmark: pgfId-326488]Interface tunnel IP address.

  
        

 
         
         		[bookmark: pgfId-326496]SYS_VPN_PUBLIC_INTERFACES

  
         		[bookmark: pgfId-326498]2

  
         		[bookmark: pgfId-326500]Public interface names.

  
        

 
         
         		[bookmark: pgfId-326508]SYS_VPN_TUNNEL_ENDPT_INTERFACE_IP

  
         		[bookmark: pgfId-326510]1

  
         		[bookmark: pgfId-326512]IP address of the VPN endpoint. In IPSec, the endpoint is the VPN interface; in GRE, it is the tunnel source.

  
        

 
         
         		[bookmark: pgfId-326520]SYS_VPN_TUNNEL_ENDPT_ INTERFACE_NAME

  
         		[bookmark: pgfId-326522]1

  
         		[bookmark: pgfId-326524]Name of the VPN endpoint. In IPSec, the endpoint is the VPN interface; in GRE, it is the tunnel source.

  
        

 
         
         		[bookmark: pgfId-326532]SYS_VPN_VPNSM_PUBLIC_IFC

  
         		[bookmark: pgfId-326534]2

  
         		[bookmark: pgfId-326536]Export port names for Catalyst 6000 series switches.

  
        

 
         
         		 [bookmark: pgfId-326544]Remote Peers

 [bookmark: pgfId-326546]Variables related to remote peers in which a device participates. Configure VPNs to generate values for these variables.

  
        

 
         
         		[bookmark: pgfId-326558]SYS_VPN_REM_PEER_BAK_ LOGICAL_PRIVATE_IP

  
         		[bookmark: pgfId-326560]3

  
         		[bookmark: pgfId-326562]Interface tunnel IP addresses of remote peers of failover hubs. This value is used in DMVPN for next hop resolution protocol (NHRP).

  
        

 
         
         		[bookmark: pgfId-326570]SYS_VPN_REM_PEER_BAK_PREFIX

  
         		[bookmark: pgfId-326572]3

  
         		[bookmark: pgfId-326574]Protected networks (interface and network IP addresses) of remote peers of failover hubs.

  
        

 
         
         		[bookmark: pgfId-326582]SYS_VPN_REM_PEER_BAK_PUBLIC_IP

  
         		[bookmark: pgfId-326584]3

  
         		[bookmark: pgfId-326586]Public interface names of remote peers of failover hubs.

  
        

 
         
         		[bookmark: pgfId-326594]SYS_VPN_REM_PEER_BAK_TUNNEL_SRC

  
         		[bookmark: pgfId-326596]3

  
         		[bookmark: pgfId-326598]IP address of the VPN endpoint of remote peers. In IPSec, the endpoint is the VPN interface; in GRE, it is the tunnel source.

  
        

 
         
         		[bookmark: pgfId-326606]SYS_VPN_REM_PEER_DEVICE_NAME

  
         		[bookmark: pgfId-326608]2

  
         		[bookmark: pgfId-326610]Device hostnames of remote peers.

  
        

 
         
         		[bookmark: pgfId-326618]SYS_VPN_REM_PEER_LOGICAL_ PRIVATE_IP

  
         		[bookmark: pgfId-326620]2

  
         		[bookmark: pgfId-326622]Interface tunnel IP addresses of remote peers. This value is used in DMVPN for next hop resolution protocol (NHRP).

  
        

 
         
         		[bookmark: pgfId-326630]SYS_VPN_REM_PEER_PREFIX

  
         		[bookmark: pgfId-326632]3

  
         		[bookmark: pgfId-326634]Protected networks (interface and network IP addresses) of remote peers.

  
        

 
         
         		[bookmark: pgfId-326642]SYS_VPN_REM_PEER_PRIVATE_IP

  
         		[bookmark: pgfId-326644]2

  
         		[bookmark: pgfId-326646]Private interface names of remote peers.

  
        

 
         
         		[bookmark: pgfId-326654]SYS_VPN_REM_PEER_PUBLIC_IP

  
         		[bookmark: pgfId-326656]2

  
         		[bookmark: pgfId-326658]Public interface names of remote peers.

  
        

 
         
         		[bookmark: pgfId-326666]SYS_VPN_REM_PEER_TUNNEL_SRC

  
         		[bookmark: pgfId-326668]2

  
         		[bookmark: pgfId-326670]Tunnel sources (if included in the interface tunnel of remote peers).

  
        

 
         
         		 [bookmark: pgfId-326678]IPSec Proposal

 [bookmark: pgfId-326686]Variables related to IPSec Proposal policies. For more information, see Configuring IPsec Proposals in Site-to-Site VPNs and Configuring High Availability in Your VPN Topology.

 [bookmark: pgfId-326688]Configure the IPSec Proposal policy to generate values for these variables.

  
        

 
         
         		[bookmark: pgfId-326700]SYS_VPN_CRYPTO_MAP_TYPE

  
         		[bookmark: pgfId-326702]1

  
         		[bookmark: pgfId-326704]Crypto map type. Possible values are STATIC and DYNAMIC.

  
        

 
         
         		[bookmark: pgfId-326712]SYS_VPN_DYNAMIC_CRYPTO_NAME

  
         		[bookmark: pgfId-326714]1

  
         		[bookmark: pgfId-326716]Dynamic crypto map name.

  
        

 
         
         		[bookmark: pgfId-326724]SYS_VPN_DYNAMIC_CRYPTO_NUM

  
         		[bookmark: pgfId-326726]1

  
         		[bookmark: pgfId-326728]Dynamic crypto map number.

  
        

 
         
         		[bookmark: pgfId-326736]SYS_VPN_STATIC_CRYPTO_NAME

  
         		[bookmark: pgfId-326738]1

  
         		[bookmark: pgfId-326740]Static crypto map name.

  
        

 
         
         		[bookmark: pgfId-326748]SYS_VPN_STATIC_CRYPTO_NAME_BAK

  
         		[bookmark: pgfId-326750]1

  
         		[bookmark: pgfId-326752]Static crypto map name of failover hubs.

  
        

 
         
         		[bookmark: pgfId-326760]SYS_VPN_STATIC_CRYPTO_NUM

  
         		[bookmark: pgfId-326762]2

  
         		[bookmark: pgfId-326764]Static crypto map number.

  
        

 
         
         		[bookmark: pgfId-326772]SYS_VPN_STATIC_CRYPTO_NUM_BAK

  
         		[bookmark: pgfId-326774]2

  
         		[bookmark: pgfId-326776]Static crypto map number of failover hubs.

  
        

 
         
         		 [bookmark: pgfId-326784]Preshared Keys

 [bookmark: pgfId-326789]Variables related to Preshared Key and IKE Proposal policies. For more information, see Configuring IKEv1 Preshared Key Policies.

  
        

 
         
         		[bookmark: pgfId-326801]SYS_VPN_IKE_AUTHENTICATION_MODE

  
         		[bookmark: pgfId-326803]1

  
         		[bookmark: pgfId-326805]Authentication method of the IKE policy. Possible values are pre-share, rsa-sig, rsa-encr, dsa-sig.

 [bookmark: pgfId-326807]Configure an IKE Proposal policy to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-326815]SYS_VPN_IKE_PRIORITY

  
         		[bookmark: pgfId-326817]1

  
         		[bookmark: pgfId-326819]Priority number of the IKE policy

 [bookmark: pgfId-326821]Configure an IKE Proposal policy to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-326829]SYS_VPN_NEGOTIATION_MODE

  
         		[bookmark: pgfId-326831]1

  
         		[bookmark: pgfId-326833]Negotiation method. Possible values are MAIN_ADDRESS, MAIN_HOST, and AGGRESSIVE.

 [bookmark: pgfId-326835]Configure a Preshared Key policy to generate values for this variable.

  
        

 
         
         		 [bookmark: pgfId-326843]GRE Modes

 [bookmark: pgfId-326848]Variables related to GRE Modes policies. For more information, see Understanding the GRE Modes Page.

  
        

 
         
         		[bookmark: pgfId-326860]SYS_VPN_BAK_TUNNEL_IFC

  
         		[bookmark: pgfId-326862]2

  
         		[bookmark: pgfId-326864]Interface tunnel number of remote peers of failover hubs, for example, tunnel0.

 [bookmark: pgfId-326866]Configure VPNs to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-326874]SYS_VPN_SIGP_PROCESS_NUMBER

  
         		[bookmark: pgfId-326876]1

  
         		[bookmark: pgfId-326878]Process number of the interior gateway protocol (IGP).

 [bookmark: pgfId-326880]Configure GRE Modes policies to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-326888]SYS_VPN_SIGP_ROUTING_PROTOCOL

  
         		[bookmark: pgfId-326890]1

  
         		[bookmark: pgfId-326892]Type of secured interior gateway protocol (IGP) used. Possible values are STATIC, OSPF, EIGRP, RIPV2, BGP, and ODR.

 [bookmark: pgfId-326894]Configure GRE Modes policies to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-326902]SYS_VPN_SPOKE_TO_SPOKE_ CONN

  
         		[bookmark: pgfId-326904]1

  
         		[bookmark: pgfId-326906]Whether DMVPN is configured for spoke-to-spoke connectivity. Possible values are true or false.

 [bookmark: pgfId-326908]Configure GRE Modes policies to generate values for this variable.

  
        

 
         
         		[bookmark: pgfId-326916]SYS_VPN_TUNNEL_IFC

  
         		[bookmark: pgfId-326918]2

  
         		[bookmark: pgfId-326920]Interface tunnel number of remote peers, for example, tunnel0.

 [bookmark: pgfId-326922]Configure VPNs to generate values for this variable.

  
        

 
         
         		 [bookmark: pgfId-326930]VRF

 [bookmark: pgfId-326935]Variables related to virtual routing and forwarding (VRF). For more information, see Configuring VRF Aware IPsec Settings.

 [bookmark: pgfId-326937]Configure VPN VRF settings to generate values for these variables.

  
        

 
         
         		[bookmark: pgfId-326949]SYS_VPN_VRF_AREA_ID

  
         		[bookmark: pgfId-326951]1

  
         		[bookmark: pgfId-326953]Area ID numbers if the OSPF process number was chosen.

  
        

 
         
         		[bookmark: pgfId-326961]SYS_VPN_VRF_MPLS_INTERFACE_IP

  
         		[bookmark: pgfId-326963]1

  
         		[bookmark: pgfId-326965]Multiprotocol label switching (MPLS) interface IP addresses.

  
        

 
         
         		[bookmark: pgfId-326973]SYS_VPN_VRF_MPLS_INTERFACE_NAME

  
         		[bookmark: pgfId-326975]1

  
         		[bookmark: pgfId-326977]Multiprotocol label switching (MPLS) interface names.

  
        

 
         
         		[bookmark: pgfId-326985]SYS_VPN_VRF_NAME

  
         		[bookmark: pgfId-326987]1

  
         		[bookmark: pgfId-326989]VRF names.

  
        

 
         
         		[bookmark: pgfId-326997]SYS_VPN_VRF_PROCESS_NUMBER

  
         		[bookmark: pgfId-326999]1

  
         		[bookmark: pgfId-327001]Interior gateway protocol (IGP) process numbers.

  
        

 
         
         		[bookmark: pgfId-327009]SYS_VPN_VRF_RD

  
         		[bookmark: pgfId-327011]1

  
         		[bookmark: pgfId-327013]RD values.

  
        

 
         
         		[bookmark: pgfId-327021]SYS_VPN_VRF_ROUTING_PROTOCOL

  
         		[bookmark: pgfId-327023]1

  
         		[bookmark: pgfId-327025]Interior gateway protocol (IGP) values. IGP is used for routing the IPSec aggregator toward the Provider Edge (PE)/Multiprotocol Label Switching (MPLS) network.

 [bookmark: pgfId-327027]Possible values are STATIC, OSPF, EIGRP, RIPV2, and BGP.

  
        

 
         
         		[bookmark: pgfId-327035]SYS_VPN_VRF_SOLUTION

  
         		[bookmark: pgfId-327037]1

  
         		[bookmark: pgfId-327039]Virtual routing and forwarding (VRF) solution. Possible values are 1BOX and 2BOX.

  
        

 
         
         		 [bookmark: pgfId-327047]CA

 [bookmark: pgfId-327052]Variables related to certificate authority policies. For more information, see Configuring IKEv1 Public Key Infrastructure Policies in Site-to-Site VPNs.

  
        

 
         
         		[bookmark: pgfId-327064]SYS_VPN_CA_NAME

  
         		[bookmark: pgfId-327066]2

  
         		[bookmark: pgfId-327068]Certificate authority (CA) names.

 [bookmark: pgfId-327070]Configure PKI policies to generate values for this variable.

  
        

 
         
         		 [bookmark: pgfId-327078]EZVPN

 [bookmark: pgfId-327083]Variables related to EZVPN. For more information, see Understanding Easy VPN.

  
        

 
         
         		[bookmark: pgfId-327095]SYS_VPN_EZVPN_GROUP_NAME

  
         		[bookmark: pgfId-327097]2

  
         		[bookmark: pgfId-327099]User group names.

 [bookmark: pgfId-327101]Configure User Group policies to generate values for this variable.

  
        

 
         
         		 [bookmark: pgfId-327109]Dial Backup

 [bookmark: pgfId-327114]Variables related to dial backup configurations. For more information, see Configuring Dial Backup.

  
        

 
         
         		[bookmark: pgfId-327126]SYS_VPN_RTR_WATCH

  
         		[bookmark: pgfId-327128]1

  
         		[bookmark: pgfId-327130]The rtr/watch number.

 [bookmark: pgfId-327132]Configure dial backup to generate values for this variable.

  
        

 
         
         		 [bookmark: pgfId-327140]GETVPN

 [bookmark: pgfId-327145]Variables related to Group Encrypted Transport (GET) VPN. For more information, see Understanding Group Encrypted Transport (GET) VPNs.

  
        

 
         
         		[bookmark: pgfId-327157]SYS_GDOI_GROUP_NAME

  
         		[bookmark: pgfId-327159]1

  
         		[bookmark: pgfId-327161]Name of the Group Domain of Interpretation (GDOI) group.

 [bookmark: pgfId-327163]Configure the Group Encryption policy to generate values for this variable (Manage > Site-to-Site VPNs > Group Encryption Policy > Group Settings).

  
        

 
         
         		[bookmark: pgfId-327171]SYS_GM_GET_ENABLED_INTF_NAME

  
         		[bookmark: pgfId-327173]1

  
         		[bookmark: pgfId-327175]VPN-enabled outside interface to the provider edge (PE). Traffic originating or terminating on this interface is evaluated for encryption or decryption, as appropriate.

 [bookmark: pgfId-327177]Configure group members to generate values for this variable (Manage > Site-to-Site VPNs > Group Members).

  
        

 
         
         		[bookmark: pgfId-327185]SYS_IPSEC_PROFILE_NAME

  
         		[bookmark: pgfId-327187]1

  
         		[bookmark: pgfId-327189]Name of the profile that defines the parameters to be used for IPsec encryption between two group members.

 [bookmark: pgfId-327191]Configure the Group Encryption policy to generate values for this variable (Manage > Site-to-Site VPNs > Group Encryption Policy > Security Associations).

  
        

 
         
         		[bookmark: pgfId-327199]SYS_KS_REG_INTERFACE

  
         		[bookmark: pgfId-327201]0

  
         		[bookmark: pgfId-327203]Interface on the key server assigned to handle group domain of interpretation (GDOI) registrations. If no registration interface is specified, GDOI registrations can occur on any interface.

 [bookmark: pgfId-327205]Configure key servers to generate values for this variable (Manage > Site-to-Site VPNs > Key Servers).
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        [bookmark: pgfId-327220]Table 7-5 [bookmark: 21853]Remote Access System Variables 

 
        
       
         
         		
           
           [bookmark: pgfId-327234]Name
           [bookmark: marker-327228]
           [bookmark: marker-327230]
           [bookmark: marker-327232]
          
  
         		
           
           [bookmark: pgfId-327236]Dimension
          
  
         		
           
           [bookmark: pgfId-327238]Description
          
  
        

 
         
         		[bookmark: pgfId-327246]SYS_ASA_RA_TUNNEL_GROUP_NAME

  
         		[bookmark: pgfId-327248]2

  
         		[bookmark: pgfId-327250]Tunnel group name for ASA devices.

  
        

 
         
         		[bookmark: pgfId-327258]SYS_ASA_RA_USER_GROUP_NAME

  
         		[bookmark: pgfId-327260]2

  
         		[bookmark: pgfId-327262]Name of the ASA user group.

  
        

 
         
         		[bookmark: pgfId-327270]SYS_EZVPN_RA_DYNAMIC_CRYPTO_ MAP_NAME

  
         		[bookmark: pgfId-327272]1

  
         		[bookmark: pgfId-327274]Dynamic Crypto map name for EZVPN.

  
        

 
         
         		[bookmark: pgfId-327282]SYS_EZVPN_RA_DYNAMIC_CRYPTO_ MAP_SEQ_NUM

  
         		[bookmark: pgfId-327284]1

  
         		[bookmark: pgfId-327286]Dynamic Crypto map number for EZVPN.

  
        

 
         
         		[bookmark: pgfId-327294]SYS_EZVPN_RA_PUBLIC_INTERFACE_PIX

  
         		[bookmark: pgfId-327296]2

  
         		[bookmark: pgfId-327298]External interface names for EZVPN for PIX firewall and ASA devices only.

  
        

 
         
         		[bookmark: pgfId-327306]SYS_EZVPN_RA_STATIC_CRYPTO_ MAP_NAME

  
         		[bookmark: pgfId-327308]1

  
         		[bookmark: pgfId-327310]Static crypto map names for EZVPN.

  
        

 
         
         		[bookmark: pgfId-327318]SYS_EZVPN_RA_STATIC_CRYPTO_ MAP_SEQ_NUM

  
         		[bookmark: pgfId-327320]1

  
         		[bookmark: pgfId-327322]Static crypto map numbers for EZVPN.

  
        

 
         
         		[bookmark: pgfId-327330]SYS_IOS_RA_CA_NAME

  
         		[bookmark: pgfId-327332]1

  
         		[bookmark: pgfId-327334]Certificate authority (CA) names for Cisco IOS devices.

  
        

 
         
         		[bookmark: pgfId-327342]SYS_IOS_RA_PUBLIC_INTERFACE

  
         		[bookmark: pgfId-327344]1

  
         		[bookmark: pgfId-327346]External interface names for Cisco IOS devices.

  
        

 
         
         		[bookmark: pgfId-327354]SYS_IOS_RA_USER_GROUP

  
         		[bookmark: pgfId-327356]1

  
         		[bookmark: pgfId-327358]User group names for Cisco IOS devices.

  
        

 
         
         		[bookmark: pgfId-327366]SYS_IOS_RA_VRF_NAME

  
         		[bookmark: pgfId-327368]1

  
         		[bookmark: pgfId-327370]Virtual routing and forwarding (VRF) names for Cisco IOS devices.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-329786][bookmark: 21954][bookmark: tmplchap_cncpt_PredefinedFlexConfigPolicyObjects]Predefined FlexConfig Policy Objects[bookmark: marker-329784]

 
     [bookmark: pgfId-329788]Security Manager provides predefined FlexConfig policy objects for you to use. These policy objects have predefined commands and scripting.

 
     [bookmark: pgfId-329790]Predefined FlexConfig policy objects are read-only objects. To edit these predefined FlexConfig policy objects, duplicate the desired object, make changes to the copy, and save it with a new name. This way, the original predefined FlexConfigs remain unchanged. For lists of these predefined policy objects and further information on each, see the following tables:

 
      
      		 [bookmark: pgfId-329795]Predefined ASA FlexConfig Policy Objects—Table 7-8

 
      		 [bookmark: pgfId-329800]Predefined Catalyst FlexConfig Policy Objects—Table 7-7

 
      		 [bookmark: pgfId-329805]Predefined Cisco IOS FlexConfig Policy Objects—Table 7-8

 
      		 [bookmark: pgfId-329810]Predefined PIX Firewall FlexConfig Policy Objects—Table 7-9

 
      		 [bookmark: pgfId-329815]Predefined Router FlexConfig Policy Objects—Table 7-10

 
     

 
     [bookmark: pgfId-329818] 

 
      
       
        
        [bookmark: pgfId-327383]Table 7-6 [bookmark: 21978]Predefined ASA FlexConfig Policy Objects 

 
        
       
         
         		
           
           [bookmark: pgfId-327393]Name
           [bookmark: marker-327389]
           [bookmark: marker-327391]
          
  
         		
           
           [bookmark: pgfId-327395]Description
          
  
        

 
         
         		[bookmark: pgfId-327401]ASA_add_ACEs

  
         		[bookmark: pgfId-327403]Adds an access control entry (ACE) to all access control lists on the device.

  
        

 
         
         		[bookmark: pgfId-327409]ASA_add_EtherType_ACL_remark

  
         		[bookmark: pgfId-327411]Loops through a list of ethertype access-list names and adds ACEs or remarks to them. The ethertype access list is the same as Transparent Rules for Firewalls in Security Manager. The remarks set by the CLI in this FlexConfig will be shown in the description field of a transparent rule.

  
        

 
         
         		[bookmark: pgfId-327417]ASA_add_IPv6_ACEs

  
         		[bookmark: pgfId-327419]Loops through a list of IPv6 access lists and adds a deny ip any any log entry to the end of the ACL.

  
        

 
         
         		[bookmark: pgfId-327425]ASA_command_alias

  
         		[bookmark: pgfId-327427]Creates a command alias named “save” for the copy running-config and copy startup_config commands.

  
        

 
         
         		[bookmark: pgfId-327433]ASA_copy_image

  
         		[bookmark: pgfId-327435]Copies an image package from a TFTP server to flash.

  
        

 
         
         		[bookmark: pgfId-327441]ASA_csd_image

  
         		[bookmark: pgfId-327443]Provides an ASA Cisco Secure Desktop image. It copies the CSD image from /CSCOpx/tftpboot/device-hostname on the CSM server to the device, then configures the CSD image path. Make sure you fill out the device’s hostname in Device Properties. If the image name is different than the default, you can override it in Device Properties > Policy Object Overrides > Text Objects > AsaCsdImageName. Unassign this FlexConfig from the device after the image has been copied and configured.

  
        

 
         
         		[bookmark: pgfId-327449]ASA_define_traffic_flow_tunnel _group

  
         		[bookmark: pgfId-327451]Defines site-to-site VPN tunnel groups listed in the SYS_FW_MPCRULE_TRAFFICFLOW_TUNNELGROUPNAME system variable. This variable is populated with tunnel group names defined in Traffic Flow objects.

  
        

 
         
         		[bookmark: pgfId-327457]ASA_established

  
         		[bookmark: pgfId-327459]Permits return access for outbound connections through the security appliance. This command works with an original connection that is outbound from a network and protected by the security appliance and a return connection that is inbound between the same two devices on an external host.

 [bookmark: pgfId-327461]Uses the established command to specify the destination port that is used for connection lookups, which gives you more control over the command and supports protocols where the destination port is known, but the source port is unknown. The permitto and permitfrom keywords define the return inbound connection.

  
        

 
         
         		[bookmark: pgfId-327467]ASA_FTP_mode_passive

  
         		[bookmark: pgfId-327469]Sets the FTP mode to passive.

  
        

 
         
         		[bookmark: pgfId-327475]ASA_generate_route_map

  
         		[bookmark: pgfId-327477]Generates a route map to be used by the pim accept-register route-map command configured under Platform > Multicast > PIM > Request Filter. Security Manager exports the route-map name used in the pim command so that you can configure it as desired.

  
        

 
         
         		[bookmark: pgfId-327483]ASA_IP_audit

  
         		[bookmark: pgfId-327485]Uses the ip-audit command to provide the following:

 
           
           		 [bookmark: pgfId-327487]Sets the default actions (alarm, drop, reset) for packets that match an attack signature.

 
           		 [bookmark: pgfId-327489]Sets the default actions (alarm, drop, reset) for packets that match an informational signature.

 
           		 [bookmark: pgfId-327491]Creates a named audit policy that identifies the actions to take (alarm, drop, reset) when a packet matches a defined attack signature or an informational signature.

 
           		 [bookmark: pgfId-327493]Disables a signature for an audit policy.

 
           		 [bookmark: pgfId-327495]Assigns an audit policy to an interface.

 
          

  
        

 
         
         		[bookmark: pgfId-327501]ASA_MGCP

  
         		[bookmark: pgfId-327503]Identifies a specific map for defining the parameters for Media Gateway Control Protocol (MGCP) inspection.

  
        

 
         
         		[bookmark: pgfId-327509]ASA_no_router_Id

  
         		[bookmark: pgfId-327511]Removes the router ID for each OSPF process.

  
        

 
         
         		[bookmark: pgfId-327517]ASA_no_shut_Intf

  
         		[bookmark: pgfId-327519]Loops through and enables all interfaces on a device.

  
        

 
         
         		[bookmark: pgfId-327525]ASA_privilege

  
         		[bookmark: pgfId-327527]Sets the privilege levels for the configuration, show and clear commands.

  
        

 
         
         		[bookmark: pgfId-327533]ASA_route_map

  
         		[bookmark: pgfId-327535]Defines a route map for each OSPF process redistribution route map name.

  
        

 
         
         		[bookmark: pgfId-327541]ASA_RSA_KeyPair_generation

  
         		[bookmark: pgfId-327543]Resets and generates RSA key pairs for certificates.

  
        

 
         
         		[bookmark: pgfId-327549]ASA_svc_image

  
         		[bookmark: pgfId-327551]Provides an ASA SSL VPN Client image. It copies the SVC image from /CSCOpx/tftpboot/device-hostname on the CSM server to the device, then configures the SVC image path. Make sure you fill out the device’s hostname in Device Properties. If the image name is different than the default, you can override it in Device Properties > Policy Object Overrides > Text Objects > AsaSvcImageName. Unassign this FlexConfig from the device after the image has been copied and configured.

  
        

 
         
         		[bookmark: pgfId-327557]ASA_sysopt

  
         		[bookmark: pgfId-327559]Uses the sysopt command to provide the following examples:

 
           
           		 [bookmark: pgfId-327561]Ensures that the maximum TCP segment size does not exceed the value you set or that the minimum is not less than a specified size.

 
           		 [bookmark: pgfId-327563]Forces each TCP connection to remain in a shortened TIME_WAIT state of at least 15 seconds after the final normal TCP close-down sequence.

 
           		 [bookmark: pgfId-327565]Disables DNS inspection that alters the DNS A record address.

 
           		 [bookmark: pgfId-327567]Ignores the authentication key in RADIUS accounting responses.

 
           		 [bookmark: pgfId-327569]Enables the web browser to supply a username and password from its cache when it reauthenticates with the virtual HTTP server on the security appliance.

 
          

  
        

 
         
         		[bookmark: pgfId-327575]ASA_virtual

  
         		[bookmark: pgfId-327577]Configures virtual HTTP and Telnet servers.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-329821] 

 
      
       
        
        [bookmark: pgfId-327590]Table 7-7 [bookmark: 22133]Predefined Catalyst 6500/7600 FlexConfig Policy Objects 

 
        
       
         
         		
           
           [bookmark: pgfId-327600]Name
           [bookmark: marker-327596]
           [bookmark: marker-327598]
          
  
         		
           
           [bookmark: pgfId-327602]Description
          
  
        

 
         
         		[bookmark: pgfId-327608]Cat6K_ECLB_algorithm

  
         		[bookmark: pgfId-327610]Sets the Ether Channel load balance algorithm for modules.

  
        

 
         
         		[bookmark: pgfId-327616]Cat6K_ECLB_port_mode

  
         		[bookmark: pgfId-327618]Applies an Ether Channel to the Catalyst trunk ports where IPS sensors are plugged in. Make sure the ports are configure in trunk mode.

  
        

 
         
         		[bookmark: pgfId-327624]Cat6K_ECLB_portchannel

  
         		[bookmark: pgfId-327626]Sets the port channel to trunk mode and add trunk-allowed VLANs.

  
        

 
         
         		[bookmark: pgfId-327632]Cat6K_firewall_multiple_vlan_interfaces

  
         		[bookmark: pgfId-327634]Sets multiple VLAN interfaces mode if multiple SVIs need to be provisioned.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-329824] 

 
      
       
        
        [bookmark: pgfId-327647]Table 7-8 [bookmark: 22170]Predefined Cisco IOS FlexConfig Policy Objects 

 
        
       
         
         		
           
           [bookmark: pgfId-327657]Name
           [bookmark: marker-327653]
           [bookmark: marker-327655]
          
  
         		
           
           [bookmark: pgfId-327659]Description
          
  
        

 
         
         		[bookmark: pgfId-327665]IOS_add_bridge_interface_desc

  
         		[bookmark: pgfId-327667]Loops through a list of bridge interfaces and adds the description “this is a bridge interface.”

  
        

 
         
         		[bookmark: pgfId-327673]IOS_CA_server

  
         		[bookmark: pgfId-327675]Configures a certificate authority server.

  
        

 
         
         		[bookmark: pgfId-327681]IOS_compress_config

  
         		[bookmark: pgfId-327683]Compresses large Cisco IOS configurations.

  
        

 
         
         		[bookmark: pgfId-327689]IOS_config_root_wireless_station

  
         		[bookmark: pgfId-327691]Creates and configures the root radio station for a wireless LAN on Cisco IOS routers such as the 851 and 871.

  
        

 
         
         		[bookmark: pgfId-327697]IOS_console_AAA_bypass

  
         		[bookmark: pgfId-327699]Provides examples of the following scenarios:

 
           
           		 [bookmark: pgfId-327701]Enables the authentication, authorization, and accounting (AAA) access-control model.

 
           		 [bookmark: pgfId-327703]Sets AAA at login.

 
           		 [bookmark: pgfId-327705]Enables AAA authentication for logins.

 
          

  
        

 
         
         		[bookmark: pgfId-327711]IOS_Copy_Image

  
         		[bookmark: pgfId-327713]Copies the an SVC image from the Security Manager server to the device, then configures the SVC image path. Unassign this FlexConfig from the device after the image has been copied and configured.

  
        

 
         
         		[bookmark: pgfId-327719]IOS_enable_SSL

  
         		[bookmark: pgfId-327721]Enables SSL.

  
        

 
         
         		[bookmark: pgfId-327727]IOS_FPM

  
         		[bookmark: pgfId-327729]Copies traffic class definition files to a router and applies policy-maps.

  
        

 
         
         		[bookmark: pgfId-327735]IOS_IPS_PUBLIC_KEY

  
         		[bookmark: pgfId-327737]Defines public keys on an IOS IPS device. Public keys are required for Security Manager to perform signature updates.

  
        

 
         
         		[bookmark: pgfId-327743]IOS_IPS_SIGNATURE_CATEGORY

  
         		[bookmark: pgfId-327745]Retires all signatures except those in the ios_ips basic category.

  
        

 
         
         		[bookmark: pgfId-327751]IOS_PKI_with_AAA

  
         		[bookmark: pgfId-327753]Configures a PKI AAA authorization using the entire subject name.

  
        

 
         
         		[bookmark: pgfId-327759]IOS_set_clock

  
         		[bookmark: pgfId-327761]Sets the clock to the current time on the Security Manager server.

  
        

 
         
         		[bookmark: pgfId-327767]IOS_VOIP_advance

  
         		[bookmark: pgfId-327769]Loops through and associates a POTS port number to a telephone number and port or IP address number.

  
        

 
         
         		[bookmark: pgfId-327775]IOS_VOIP_simple

  
         		[bookmark: pgfId-327777]Associates a POTS port number to a telephone number and port number.

  
        

 
         
         		[bookmark: pgfId-327783]IOS_VPN_config_gre_tunnel

  
         		[bookmark: pgfId-327785]Uses VPN variables to configure the GRE tunnel for each VPN in which the device participates.

  
        

 
         
         		[bookmark: pgfId-327791]IOS_VPN_set_interface_desc

  
         		[bookmark: pgfId-327793]Using VPN variables, updates the description of the public interface for each VPN in which the device participates.

  
        

 
         
         		[bookmark: pgfId-327799]IOS_VPN_shutdown_inside_interface

  
         		[bookmark: pgfId-327801]Using VPN variables, shuts down all inside interfaces for each VPN in which the device participates.

  
        

 
         
         		[bookmark: pgfId-327807]IOS_VRF_on_vFW

  
         		[bookmark: pgfId-327809]Configures virtual routing and forwarding (VRF) on virtual firewall interfaces.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-329827] 

 
      
       
        
        [bookmark: pgfId-327822]Table 7-9 [bookmark: 22284]Predefined PIX 6.3 Firewall FlexConfig Policy Objects 

 
        
       
         
         		
           
           [bookmark: pgfId-327832]Name
           [bookmark: marker-327828]
           [bookmark: marker-327830]
          
  
         		
           
           [bookmark: pgfId-327834]Description
          
  
        

 
         
         		[bookmark: pgfId-327840]PIX6.3_nat0_acl_compiled

  
         		[bookmark: pgfId-327842]Generates a compiled access list for NAT 0 access-control lists.

  
        

 
         
         		[bookmark: pgfId-327848]PIX6.3_policy_nat_acl_compiled

  
         		[bookmark: pgfId-327850]Generates a compiled access list for Policy NAT ACLs

  
        

 
         
         		[bookmark: pgfId-327856]PIX6.3_policy_static_acl_compiled

  
         		[bookmark: pgfId-327858]Generates a compiled access list for Policy Static ACLs.

  
        

 
         
         		[bookmark: pgfId-327864]PIX_VPDN

  
         		[bookmark: pgfId-327866]Configures a virtual private dialup network (VPDN).

  
        

 
       
      

 
     
 
     [bookmark: pgfId-329830] 

 
      
       
        
        [bookmark: pgfId-327879]Table 7-10 [bookmark: 22321]Predefined Router FlexConfig Policy Objects 

 
        
       
         
         		
           
           [bookmark: pgfId-327889]Name
           [bookmark: marker-327885]
           [bookmark: marker-327887]
          
  
         		
           
           [bookmark: pgfId-327891]Description
          
  
        

 
         
         		[bookmark: pgfId-327897]ROUTER_add_inspect_rules

  
         		[bookmark: pgfId-327899]Loops through and appends inspect rules.

  
        

 
         
         		[bookmark: pgfId-327905]ROUTER_BGP_no_auto_summary

  
         		[bookmark: pgfId-327907]Disables the auto route summary for each BGP process by using the no auto-summary sub-command.

 [bookmark: pgfId-327909]This FlexConfig policy object uses the list of border gateway protocol (BGP) numbers from the SYS_ROUTER_BGP_AS_NUMBERS_LIST system variable.

  
        

 
         
         		[bookmark: pgfId-327915]ROUTER_BGP_untrusted_info

  
         		[bookmark: pgfId-327917]Uses the distance bgp 255 255 255 sub-command to make the border gateway protocol (BGP) routing information untrusted for each BGP.

 [bookmark: pgfId-327919]This FlexConfig policy object uses the list of BGP numbers from the SYS_ROUTER_BGP_AS_NUMBERS_LIST system variable.

  
        

 
         
         		[bookmark: pgfId-327925]ROUTER_EIGRP_min_cost_routes

  
         		[bookmark: pgfId-327927]Configures traffic to use minimum cost routes when multiple routes have different cost routes to the same destination network. This is done using multi-interface load splitting on different interfaces with equal cost paths.

 [bookmark: pgfId-327929]This FlexConfig policy object uses the list of router enhanced interior gateway routing protocol (EIGRP) numbers from the SYS_ROUTER_EIGRP_AS_NUMBERS_LIST system variable.

  
        

 
         
         		[bookmark: pgfId-327935]Router_EIGRP_no_auto_summary

  
         		[bookmark: pgfId-327937]Disables the auto route summary for each router enhanced interior gateway routing protocol (EIGRP) processes by using the no auto-summary sub-command. This FlexConfig policy object uses the list of EIGRP numbers from the SYS_ROUTER_EIGRP_AS_NUMBERS_LIST system variable.

  
        

 
         
         		[bookmark: pgfId-327943]ROUTER_interface_prevent_dos _attacks

  
         		[bookmark: pgfId-327945]Prevents denial-of-service (DOS) attacks on all device interfaces.

 [bookmark: pgfId-327947]This FlexConfig policy object uses the list of interface names from the SYS_INTERFACE_NAME_LIST system variable.

  
        

 
         
         		[bookmark: pgfId-327953]ROUTER_OSPF_no_router_Id

  
         		[bookmark: pgfId-327955]Removes the router OSPF ID for each OSPF process.

 [bookmark: pgfId-327957]This FlexConfig policy uses the list of OSPF IDs from the SYS_ROUTER_OSPF_PROCESS_IDS_LIST system variable.

  
        

 
         
         		[bookmark: pgfId-327963]ROUTER_QoS_Class_Map _description

  
         		[bookmark: pgfId-327965]Sets QoS class map descriptions.

 [bookmark: pgfId-327967]This FlexConfig policy object uses the list of router QoS class names from the SYS_ROUTER_QOS_CLASS_MAP_LIST system variable.

  
        

 
         
         		[bookmark: pgfId-327973]ROUTER_QoS_Policy_Map _description

  
         		[bookmark: pgfId-327975]Sets QoS policy descriptions.

 [bookmark: pgfId-327977]This FlexConfig policy object uses the list of router QoS policy names from the SYS_ROUTER_QOS_POLICY_MAP_LIST system variable.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-329846][bookmark: 22394][bookmark: tmplchap_cncpt_ConfiguringFlexConfigPolicyObjects]Configuring FlexConfig Policies and Policy Objects[bookmark: marker-329836][bookmark: marker-329838][bookmark: marker-329840][bookmark: marker-329842][bookmark: marker-329844]

 
    [bookmark: pgfId-329851]You create and manage FlexConfig policy objects in the same way that you create other policy objects. The following topics describe how to create FlexConfig policies and policy objects. For information on other tasks you can perform with FlexConfig policy objects (such as deleting them), see Working with Policy Objects—Basic Procedures.

 
     
     		 [bookmark: pgfId-329856]A FlexConfig Creation Scenario

 
     		 [bookmark: pgfId-329861]Creating FlexConfig Policy Objects

 
     		 [bookmark: pgfId-329866]Editing FlexConfig Policies

 
    

 
     
      [bookmark: pgfId-329876][bookmark: 22426][bookmark: tmplchap_proc_AFlexConfigCreationScenario]A FlexConfig Creation Scenario[bookmark: marker-329872][bookmark: marker-329874]

 
     [bookmark: pgfId-329878]This scenario takes you through the steps to set up Media Gateway Control Protocol (MGCP) for an ASA device using one of the predefined FlexConfig policy objects that are shipped with Security Manager. MGCP is used by the call agent application to control media gateways (devices that convert telephone circuit audio to data packets). Security Manager does not support MGCP configuration, but you can use a FlexConfig policy object to provide a configuration. This illustrates how FlexConfigs enable you to customize, for your network, what is not otherwise supported in Security Manager.

 
     [bookmark: pgfId-329880]In this scenario, you do the following:

 
     [bookmark: pgfId-329882] 1. Create a policy object by duplicating an existing policy object.

 
     [bookmark: pgfId-329884] 2. Assign the policy object to a device.

 
     [bookmark: pgfId-329886] 3. Preview the configuration to verify that it is correct.

 
     [bookmark: pgfId-329888] 4. Share the policy object with another device.

 
     [bookmark: pgfId-329890] 5. Deploy the configuration to the devices.

 
     [bookmark: pgfId-329892]You can use this scenario as an example to implement other features by creating copies of and modifying predefined FlexConfig policy objects or by creating your own objects.

 
     [bookmark: pgfId-329894]Before You Begin

 
     [bookmark: pgfId-329896]Add two ASA devices to Security Manager for this scenario.

 
     
 
     [bookmark: pgfId-329898]Step 1 Duplicate the FlexConfig policy object by doing the following:

 
     [bookmark: pgfId-329903] a. Select Manage > Policy Objects to open the Policy Object Manager (see Policy Object Manager).

 
     [bookmark: pgfId-329905] b. Select FlexConfigs from the table of contents. The table in the right pane lists the existing FlexConfig objects.

 
     [bookmark: pgfId-329910] c. Right-click ASA_MGCP FlexConfig and select Clone Object. The Add FlexConfig dialog box appears (see Add or Edit FlexConfig Dialog Box).

 
     [bookmark: pgfId-329912] d. Enter a name for the new FlexConfig object, for this example, MyASA_MGCP.

 
     [bookmark: pgfId-329914] e. Enter a new group name and a description of the object.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-329916]Tip The group name and description are optional. We recommend you establish descriptions and groups for objects you create.


     
      

     

     

 
     [bookmark: pgfId-329918] f. Click OK. The new FlexConfig object appears in the list.

 
     [bookmark: pgfId-329920]Step 2 Duplicate and edit the $callAgentList text object.

 
     [bookmark: pgfId-329922]The original ASA_MGCP FlexConfig object uses the variable $callAgentList, which is a text object. The text object is read-only and cannot be edited. Duplicating the text object enables you to edit the duplicate object to apply to your network settings.

 
     [bookmark: pgfId-329924] a. Select Text Objects from the table of contents.

 
     [bookmark: pgfId-329926] b. Right-click callAgentList and select Clone Object. The Add Text Object dialog box appears.

 
     [bookmark: pgfId-329928] c. Edit the name of the text object. For this example change it to mycallAgentList.

 
     [bookmark: pgfId-329930] d. Double-click the first value in column A and enter the IP address for a call agent in your network. For this example, change the value to 10.10.10.10.

 
     [bookmark: pgfId-329932] e. Double-click the first value in column B and enter the port number for a call agent in your network. For this example, change the value to 105.

 
     [bookmark: pgfId-329934] f. Change the IP address and port number values for another call agent. For this example, change the IP address to 20.20.20.20 and the port number to 106. Or, if you have only one call agent in your network, you could remove the second row in the table by decreasing the number in the Number of Rows field. Similarly, if you have more than two call agents, you can add rows by increasing the number in this field.

 
     [bookmark: pgfId-329936]This concept is similar for increasing and decreasing the number of columns by increasing or decreasing the Number of Columns field.

 
     [bookmark: pgfId-329938] g. Click OK. The new text object appears in the list of text objects.

 
     [bookmark: pgfId-329940]Step 3 Edit the new FlexConfig policy object to use the new variable by doing the following:

 
     [bookmark: pgfId-329942] a. Select FlexConfigs from the table of contents.

 
     [bookmark: pgfId-329944] b. Double-click MyASA_MGCP. The Edit FlexConfig dialog box appears.

 
     [bookmark: pgfId-329946] c. Edit $callAgentList to read $mycallAgentList.

 
     [bookmark: pgfId-329948] d. Click OK.

 
     [bookmark: pgfId-329950]A warning appears that reads: “The following variables are undefined: mycallAgentList Define them now?”

 
     [bookmark: pgfId-329952] e. Click Yes to the warning.

 
     [bookmark: pgfId-329954]The FlexConfig Undefined Variables dialog box appears with mycallAgentList listed in the Variable Name column.

 
     [bookmark: pgfId-329956] f. From the Object Type list, select Text Objects. The Text Objects window appears.

 
     [bookmark: pgfId-329958] g. Select mycallAgentList from the Available Text Objects list and click OK.

 
     [bookmark: pgfId-329960] h. In the FlexConfig Undefined Variables window, click OK.

 
     [bookmark: pgfId-329962]The mycallAgentList variable appears in the Variables list of the Edit FlexConfig dialog box.

 
     [bookmark: pgfId-329964] i. In the Edit FlexConfig dialog box, click OK.

 
     [bookmark: pgfId-329966] j. Close the Policy Object Manager window.

 
     [bookmark: pgfId-329968]Step 4 Assign the new FlexConfig policy object to a device by doing the following:

 
     [bookmark: pgfId-329970] a. From the Device view, select the device for which you want to set up MGCP.

 
     [bookmark: pgfId-329972] b. Select FlexConfigs from the Policy selector. The FlexConfigs Policy page appears.

 
     [bookmark: pgfId-329974] c. Click the Add button. The FlexConfigs Selector dialog box appears.

 
     [bookmark: pgfId-329976] d. Select the new MyASA_MGCP FlexConfig policy object and click >> to add the policy object to the Selected FlexConfigs column.

 
     [bookmark: pgfId-329978]You can select multiple policy objects at one time by holding either the Ctrl (for multiple selections) or Shift (for multiple continuous selections) keys while selecting.

 
     [bookmark: pgfId-329980] e. Click OK.

 
     [bookmark: pgfId-329982]The MyASA_MGCP policy object is added to the Appended FlexConfigs table, because the object is set to be appended to the configuration. You configure FlexConfig policy objects that you want added to the beginning of the configuration as prepended policy objects.

 
     [bookmark: pgfId-329984] f. Click Save.

 
     [bookmark: pgfId-329986]Step 5 Preview the commands before they are generated and sent to the device by doing the following:

 
     [bookmark: pgfId-329988] a. From the FlexConfigs Policy page, select the MyASA_MGCP policy object.

 
     [bookmark: pgfId-329990] b. Click Preview.

 
     [bookmark: pgfId-329992]The commands that are generated with this FlexConfig policy object and the values assigned to the selected device appear. Note the changed values:

 
     
      [bookmark: pgfId-329994]class-map sj_mgcp_class
     

     
      [bookmark: pgfId-329996] match access-list mgcp_list
     

     
      [bookmark: pgfId-329998] exit 
     

     
      [bookmark: pgfId-330000] 
     

     
      [bookmark: pgfId-330002]mgcp-map inbound_mgcp 
     

     
      [bookmark: pgfId-330004] call-agent 10.10.10.10 105
     

     
      [bookmark: pgfId-330006] call-agent 20.20.20.20 106
     

     
      [bookmark: pgfId-330008] 
     

     
      [bookmark: pgfId-330010] gateway 10.10.10.115 101
     

     
      [bookmark: pgfId-330012] gateway 10.10.10.116 102
     

     
      [bookmark: pgfId-330014] 
     

     
      [bookmark: pgfId-330016] command-queue 150
     

     
      [bookmark: pgfId-330018] exit
     

     
      [bookmark: pgfId-330020] 
     

     
      [bookmark: pgfId-330022]policy-map inbound_policy
     

     
      [bookmark: pgfId-330024] class sj_mgcp_class
     

     
      [bookmark: pgfId-330026] inspect mgcp inbound_mgcp
     

     
      [bookmark: pgfId-330028] exit
     

     
      [bookmark: pgfId-330030]exit
     

     
      [bookmark: pgfId-330032] 
     

     
      [bookmark: pgfId-330034]service-policy inbound_policy interface outside
     

     
      [bookmark: pgfId-330036] 
     

     [bookmark: pgfId-330038]Step 6 If you have additional ASA devices that require MGCP, you can share this policy with them by doing the following:

 
     [bookmark: pgfId-330040] a. Right-click FlexConfigs in the Policy selector and select Share Policy.

 
     [bookmark: pgfId-330042]The Share Policy dialog box appears.

 
     [bookmark: pgfId-330044] b. Enter a name for the policy and click OK. For this example, enter MyShared_ASA_MGCP.

 
     [bookmark: pgfId-330046]The banner above the FlexConfigs policy now shows that the device is using a shared policy and displays the name of the policy.

 
     [bookmark: pgfId-330048] c. In the FlexConfigs banner, click the link in the Assigned To field. In this example, the link should be labeled 1 Device, which indicates that this shared policy is assigned to one device (the device you are viewing).

 
     [bookmark: pgfId-330050]Clicking the link opens the Shared Policy Assignments dialog box. Using this dialog box, you can select the other devices that should use this policy in the Available Devices list, and click >> to add them to the list of devices that are assigned the policy.

 
     [bookmark: pgfId-330052] d. Click OK. The Shared Policy Assignments dialog box closes, and the additional devices you selected are configured to use the shared policy. The link in the banner changes to indicate the number of devices that now use this policy (in this example, 2 Devices).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-330054]Tip You can also share policies from Policy view. Select View > Policy View, select FlexConfigs in the policy type selector, select the MyShared_ASA_MGCP policy, click the Assignments tab, select the devices to which you want to assign the policy, click>>, and then Save.


     
      

     

     

 
     [bookmark: pgfId-330059]Step 7 Submit your changes and deploy the configurations to the devices. For information about deploying configurations, see Working with Deployment and the Configuration Archive.

 
     [bookmark: pgfId-330061]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-330077][bookmark: 22620][bookmark: tmplchap_proc_CreatingFlexConfigPolicyObjects]Creating FlexConfig Policy Objects[bookmark: marker-330067][bookmark: marker-330069][bookmark: marker-330071][bookmark: marker-330073][bookmark: marker-330075]

 
     [bookmark: pgfId-330082]You can create FlexConfig policy objects to configure features on devices that are not supported by Security Manager. For more information about FlexConfig objects, see Understanding FlexConfig Policies and Policy Objects.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-330087]Tip You can also create FlexConfig policy objects when defining policies or objects that use this object type. For more information, see Selecting Objects for Policies.


     
      

     

     

 
     [bookmark: pgfId-330089]Before You Begin

 
     [bookmark: pgfId-330091]Ensure that your commands do not conflict in any way with the VPN or firewall configuration on the devices.

 
     [bookmark: pgfId-330093]Keep the following in mind:

 
      
      		 [bookmark: pgfId-330095]Security Manager does not manipulate or validate your commands; it simply deploys them to the devices.

 
      		 [bookmark: pgfId-330097]If there is more than one set of commands for an interface, only the last set of commands is deployed. Therefore, we recommend you not use beginning and ending commands to configure interfaces.

 
      		 [bookmark: pgfId-330099]When editing FlexConfig objects that involve route-maps (for example, OSPF or multicast route-maps), you must define the corresponding access control lists (ACLs) before the route-maps. This is a device requirement. If you do not define ACLs before route-maps, you will get a deployment error.

 
     

 
     [bookmark: pgfId-330101]Related Topics

 
      
      		 [bookmark: pgfId-330106]A FlexConfig Creation Scenario

 
      		 [bookmark: pgfId-330111]Working with Policy Objects—Basic Procedures

 
      		 [bookmark: pgfId-330116]Creating Policy Objects

 
      		 [bookmark: pgfId-330121]Chapter 5, “Managing Policies”

 
     

 
     
 
     [bookmark: pgfId-330126]Step 1 Select Manage > Policy Objects to open the Policy Object Manager window (see Policy Object Manager).

 
     [bookmark: pgfId-330128]Step 2 Select FlexConfigs from the Policy Object Type selector.

 
     [bookmark: pgfId-330130]Step 3 Right-click inside the work area and select New Object.

 
     [bookmark: pgfId-330135]The Add FlexConfig Object dialog box appears (see Add or Edit FlexConfig Dialog Box).

 
     [bookmark: pgfId-330137]Step 4 Enter a name for the object and optionally a description. Other optional informational fields include:

 
      
      		 [bookmark: pgfId-330139]Group—Select an existing group name or type in a new one. These names can help you identify the use of an object.

 
      		 [bookmark: pgfId-330141]Negate For—If this FlexConfig object is designed to negate another, enter the name of the FlexConfig object whose commands are undone by this object.

 
     

 
     [bookmark: pgfId-330143]Step 5 In the Type field, select whether commands in the object are to be prepended (put at the beginning) or appended (put at the end) of the configurations generated from Security Manager policies.

 
     [bookmark: pgfId-330145]Step 6 In the object body area, enter the commands and instructions to produce the desired configuration file output. You can type in the following types of data:

 
      
      		 [bookmark: pgfId-330150]Scripting commands to control processing. For more information, see Using Scripting Language Instructions.

 
      		 [bookmark: pgfId-330155]CLI commands that are supported by the operating system running on the devices to which you will deploy the FlexConfig policy object. For more information, see Using CLI Commands in FlexConfig Policy Objects.

 
      		 [bookmark: pgfId-330160]Variables. You can insert variables using the right-click menu, which allows you to create simple single-value text variables ( Create Text Object ), select variables from existing policy objects ( Insert Policy Object ), or select system variables ( Insert System Variable ). For more information, see Understanding FlexConfig Object Variables.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-330162]Tip If you want to remove a variable, select it in the object body and click the Cut button or press the Backspace or Delete key. When you click OK to save your changes, the variable is removed from the list of variables.


     
      

     

     

 
     [bookmark: pgfId-330164]Step 7 Click the Validate FlexConfig icon button above the object body to check the integrity and deployability of the object.

 
     [bookmark: pgfId-330166]Step 8 Click OK to save the object.

 
     [bookmark: pgfId-330168]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-330186][bookmark: 22717][bookmark: flexpage_cncpt_FlexConfigEditorDialogBox]Add or Edit FlexConfig Dialog Box[bookmark: marker-330176][bookmark: marker-330178][bookmark: marker-330180][bookmark: marker-330182][bookmark: marker-330184]

 
     [bookmark: pgfId-330188]Use the Add or Edit FlexConfig dialog box to create or edit FlexConfig policy objects. FlexConfig objects are small programs that allow you to add configuration commands before or after the configurations generated from Security Manager policies, so that you can extend the abilities of the product to configure your devices. You use these policy objects in FlexConfig device or shared policies.

 
     [bookmark: pgfId-330193]Before creating FlexConfig policy objects, read the sections in Understanding FlexConfig Policies and Policy Objects.

 
     [bookmark: pgfId-330195]Navigation Path

 
     [bookmark: pgfId-330197]Select Manage > Policy Objects, then select FlexConfigs from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-330199]Related Topics

 
      
      		 [bookmark: pgfId-330204]Creating FlexConfig Policy Objects

 
      		 [bookmark: pgfId-330209]Editing FlexConfig Policies

 
      		 [bookmark: pgfId-330214]Chapter 7, “Managing FlexConfigs”

 
     

 
     [bookmark: pgfId-330216]Field Reference

 
     [bookmark: pgfId-330219] 

 
      
       
        
        [bookmark: pgfId-327990]Table 7-11 [bookmark: 22761]FlexConfigs Editor Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-327996]Element
          
  
         		
           
           [bookmark: pgfId-327998]Description
          
  
        

 
         
         		[bookmark: pgfId-328004]Name

  
         		[bookmark: pgfId-328009]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
        

 
         
         		[bookmark: pgfId-328015]Description

  
         		[bookmark: pgfId-328017]An optional description of the object.

  
        

 
         
         		[bookmark: pgfId-328023]Group

  
         		[bookmark: pgfId-328025]The name of the group of FlexConfig objects to which this object belongs, if any. You can type in a name, or select an existing name from the list. This field is for informational purposes only, and can help you find a FlexConfig object in the FlexConfig Objects page in the Policy Object Manager.

  
        

 
         
         		[bookmark: pgfId-328031]Type

  
         		[bookmark: pgfId-328033]Whether the commands in the object are prepended (put at the beginning) or appended (put at the end) of configurations.

  
        

 
         
         		[bookmark: pgfId-328039]Negate For

  
         		[bookmark: pgfId-328041]The name of the FlexConfig object whose commands are undone in this FlexConfig object. This field is for informational purposes only and does not affect the processing of the object.

 [bookmark: pgfId-328043]For example, if FlexConfig A has the command banner login, and FlexConfig B has the command no banner login, FlexConfig B negates the configuration for FlexConfig A.

  
        

 
         
         		 
           
           [bookmark: pgfId-328049]FlexConfig Object Body
          
  
        

 
         
         		[bookmark: pgfId-328057]Object Body edit box

  
         		[bookmark: pgfId-328059]The commands and instructions to produce the desired configuration file output. You can type in the following types of data:

 
           
           		 [bookmark: pgfId-328064]Scripting commands to control processing. For more information, see Using Scripting Language Instructions.

 
           		 [bookmark: pgfId-328069]CLI commands that are supported by the operating system running on the devices to which you will deploy the FlexConfig policy object. For more information, see Using CLI Commands in FlexConfig Policy Objects.

 
           		 [bookmark: pgfId-328074]Variables. You can insert variables using the right-click menu, which allows you to create simple single-value text variables ( Create Text Object ), select variables from existing policy objects ( Insert Policy Object ), or select system variables ( Insert System Variable ). For more information, see Understanding FlexConfig Object Variables.

 
          

  
        

 
         
         		[bookmark: pgfId-328080]Undo button

  
         		[bookmark: pgfId-328082]Deletes the previous action.

  
        

 
         
         		[bookmark: pgfId-328088]Redo button

  
         		[bookmark: pgfId-328090]Performs the previously undone action.

  
        

 
         
         		[bookmark: pgfId-328096]Cut button

  
         		[bookmark: pgfId-328098]Deletes the highlighted text and copies it to the clipboard.

  
        

 
         
         		[bookmark: pgfId-328104]Copy button

  
         		[bookmark: pgfId-328106]Copies the highlighted text to the clipboard.

  
        

 
         
         		[bookmark: pgfId-328112]Paste button

  
         		[bookmark: pgfId-328114]Pastes previously cut or copied text.

  
        

 
         
         		[bookmark: pgfId-328120]Find button

  
         		[bookmark: pgfId-328122]Locates the specified text string in the object body.

  
        

 
         
         		[bookmark: pgfId-328128]Validate FlexConfig button

  
         		[bookmark: pgfId-328130]Checks the integrity and deployability of the FlexConfig object.

  
        

 
         
         		 [bookmark: pgfId-328136]FlexConfig Object Variables

 [bookmark: pgfId-328138]This table lists the variables that are used in the FlexConfig object.

  
        

 
         
         		[bookmark: pgfId-328146]Name

  
         		[bookmark: pgfId-328148]The name of the variable. Click the cell to edit the name, which also changes the name in the FlexConfig object body.

  
        

 
         
         		[bookmark: pgfId-328154]Default Value

  
         		[bookmark: pgfId-328156]The value to use when one is not provided. Click the cell to edit the value for user-defined variables. You cannot edit system-defined variables.

 [bookmark: pgfId-328158]Note Except for optional variables, if a default value is not provided, you must provide a value for the variable.

  
        

 
         
         		[bookmark: pgfId-328164]Object Property

  
         		[bookmark: pgfId-328166]The property of the object. The object property name is in the following format:

 [bookmark: pgfId-328168]type.name.data.property

 [bookmark: pgfId-328170]where

 
           
           		 [bookmark: pgfId-328172] Type —The type of object, for example Text, Network, AAA Server, and so on.

 
           		 [bookmark: pgfId-328174] Name —The name of the object.

 
           		 [bookmark: pgfId-328176]Data—Indicates that the property of the object is data.

 
           		 [bookmark: pgfId-328178] Property —The property of the data.

 
          

  
        

 
         
         		[bookmark: pgfId-328184]Dimension

  
         		[bookmark: pgfId-328186]The structure of the data in the variable. Possible values are:

 
           
           		 [bookmark: pgfId-328188]0—scaler (a single string)

 
           		 [bookmark: pgfId-328190]1—one-dimensional array (a list of strings)

 
           		 [bookmark: pgfId-328192]2—two-dimensional table (a table of strings)

 
          

  
        

 
         
         		[bookmark: pgfId-328198]Optional

  
         		[bookmark: pgfId-328200]Whether the variable is required to have a value.

  
        

 
         
         		[bookmark: pgfId-328206]Description

  
         		[bookmark: pgfId-328208]A description of the contents of the object. Click the cell to edit the description.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-330235][bookmark: 22918][bookmark: flexpage_cncpt_CreateTextObjectDialogBox]Create Text Object Dialog Box[bookmark: marker-330227][bookmark: marker-330229][bookmark: marker-330231][bookmark: marker-330233]

 
     [bookmark: pgfId-330237]Use the Create Text Object dialog box as a shortcut to create text objects of dimension 0, which are single-value variables, for use in FlexConfig policy objects. Enter the name of the variable and the value to assign to it. When you click OK, the variable is added to the FlexConfig object at the cursor location and it is added to the list of variables for the object.

 
     [bookmark: pgfId-330239]Navigation Path

 
     [bookmark: pgfId-330244]In the Add or Edit FlexConfig Dialog Box, right-click in the object body field and select Create Text Object.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-330249]Tip If you want to create a multiple-value text object, right-click and select Insert Policy Object > Text Objects, and click the Add button under the available objects list. For more information, see Add or Edit Text Object Dialog Box.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-330267][bookmark: 22947][bookmark: pobjpage_cncpt_TextObjectDialogBox]Add or Edit Text Object Dialog Box[bookmark: marker-330257][bookmark: marker-330259][bookmark: marker-330261][bookmark: marker-330263][bookmark: marker-330265]

 
     [bookmark: pgfId-330269]Use the Add or Edit Text Object dialog box to create, edit, duplicate, and view text objects. Create a text object if you need textual data to be referenced and acted upon by another policy object that accepts text objects.

 
     [bookmark: pgfId-330274]Text objects are a type of policy object variable. They are a name and value pair, where the value can be a single string, a list of strings, or a table of strings. You can enter any type of textual data to be referenced and acted upon by FlexConfig policies. For more information about FlexConfigs, see Chapter 7, “Managing FlexConfigs”.

 
     [bookmark: pgfId-330276]Create the variable by first selecting the dimension: a simple single-value variable (dimension 0), a list of variables (dimension 1) or a table or variables (dimension 2). After you create the desired grid by selecting the dimension and if applicable, the number of rows and columns, enter the data into each cell by first clicking in the cell.

 
     [bookmark: pgfId-330278]Navigation Path

 
     [bookmark: pgfId-330280]Select Manage > Policy Objects, then select Text Objects from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-330282]Field Reference

 
     [bookmark: pgfId-330285] 

 
      
       
        
        [bookmark: pgfId-328221]Table 7-12 [bookmark: 22980]Text Object Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-328227]Element
          
  
         		
           
           [bookmark: pgfId-328229]Description
          
  
        

 
         
         		[bookmark: pgfId-328235]Name

  
         		[bookmark: pgfId-328240]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
        

 
         
         		[bookmark: pgfId-328246]Description

  
         		[bookmark: pgfId-328248]An optional description of the object (up to 1024 characters).

  
        

 
         
         		[bookmark: pgfId-328254]Dimension

  
         		[bookmark: pgfId-328256]The structure of the data in the variable:

 
           
           		 [bookmark: pgfId-328258]0—scalar (a single string)

 
           		 [bookmark: pgfId-328260]1—one-dimensional array (a list of strings)

 
           		 [bookmark: pgfId-328262]2—two-dimensional table (a table of strings)

 
          

  
        

 
         
         		[bookmark: pgfId-328268]Number of Rows

  
         		[bookmark: pgfId-328270]The number of data rows in the variable if the dimension is 1 or 2.

  
        

 
         
         		[bookmark: pgfId-328276]Number of Columns

  
         		[bookmark: pgfId-328278]The number of data columns in the variable if the dimension is 2.

  
        

 
         
         		[bookmark: pgfId-328284][text field]

  
         		[bookmark: pgfId-328286]The content of the text object. Click the cell and enter the data.

  
        

 
         
         		[bookmark: pgfId-328292]Category

  
         		[bookmark: pgfId-328297]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-328303]Allow Value Override per Device

 [bookmark: pgfId-328305]Overrides

 [bookmark: pgfId-328307]Edit button

  
         		[bookmark: pgfId-328315]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-328317]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-330301][bookmark: 23047][bookmark: flexpage_cncpt_FlexConfigUndefinedVariablesDialogBox]FlexConfig Undefined Variables Dialog Box[bookmark: marker-330293][bookmark: marker-330295][bookmark: marker-330297][bookmark: marker-330299]

 
     [bookmark: pgfId-330303]Use the FlexConfig Undefined Variables dialog box to define variables used in the FlexConfig object that have not yet been defined. You can choose from a list of policy object types or add a new policy object to use.

 
     [bookmark: pgfId-330305]Each row in the table represents a single undefined variable.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-330310]Tip You do not need to define local variables, those used by the scripting language for processing control. For more information about variables, see Understanding FlexConfig Object Variables.


     
      

     

     

 
     [bookmark: pgfId-330312]Navigation Path

 
     [bookmark: pgfId-330317]In the Add or Edit FlexConfig Dialog Box, if you enter a variable name but do not define its values, when you click OK, Security Manager displays a warning and asks if you want to define the variables. If you click Yes, this dialog box is opened.

 
     [bookmark: pgfId-330319]Field Reference

 
     [bookmark: pgfId-330322] 

 
      
       
        
        [bookmark: pgfId-328330]Table 7-13 [bookmark: 23077]FlexConfig Undefined Variables Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-328336]Element
          
  
         		
           
           [bookmark: pgfId-328338]Description
          
  
        

 
         
         		[bookmark: pgfId-328344]Variable Name

  
         		[bookmark: pgfId-328346]The name of the undefined variable that you used in the FlexConfig object.

  
        

 
         
         		[bookmark: pgfId-328352]Object Type

  
         		[bookmark: pgfId-328354]The type of policy object that contains the value you want to assign to the variable. For local variables, use the Undefined object type.

 [bookmark: pgfId-328356]For variables you want to define, you must select the specific policy object and value within that object to assign to the selected variable.

 [bookmark: pgfId-328361]You start by selecting the type of policy object from this list. You are then prompted to select the specific policy object. When you click OK, you are prompted to select the specific property within that object that contains the desired value (see Property Selector Dialog Box). When you select the value on the Property Selector dialog box and click OK, the value is assigned to the variable.

  
        

 
         
         		[bookmark: pgfId-328367]Object Property

  
         		[bookmark: pgfId-328372]The property of the object. For a detailed explanation, see Add or Edit FlexConfig Dialog Box.

  
        

 
         
         		[bookmark: pgfId-328378]Optional

  
         		[bookmark: pgfId-328380]Whether the variable is required to have a value.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-330338][bookmark: 23114][bookmark: flexpage_cncpt_PropertySelectorDialogBox]Property Selector Dialog Box [bookmark: marker-330330][bookmark: marker-330332][bookmark: marker-330334][bookmark: marker-330336]

 
     [bookmark: pgfId-330340]Use the Property Selector dialog box to select the specific property within a selected policy object that you want to assign to a variable within a FlexConfig policy object. The title of the dialog box indicates the type of policy object that you selected (for example, AAA Server Groups Property Selector).

 
     [bookmark: pgfId-330345]For more information on variables, see Understanding FlexConfig Object Variables.

 
     [bookmark: pgfId-330347]Navigation Path

 
      
      		 [bookmark: pgfId-330352]In the Add or Edit FlexConfig Dialog Box, right-click and select a specific policy object group type from the  Insert Policy Object menu, select a specific policy object when prompted, and click  OK .

 
      		 [bookmark: pgfId-330357]In the FlexConfig Undefined Variables Dialog Box, select a policy object type from the Object Type field, select a specific policy object when prompted, and click  OK .

 
     

 
     [bookmark: pgfId-330359]Field Reference

 
     [bookmark: pgfId-330362] 

 
      
       
        
        [bookmark: pgfId-328393]Table 7-14 [bookmark: 23149]Property Selector Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-328399]Element
          
  
         		
           
           [bookmark: pgfId-328401]Description
          
  
        

 
         
         		[bookmark: pgfId-328407]Object Property

  
         		[bookmark: pgfId-328409]The property of the object that contains the value you want to assign to the variable. For specific information on the properties, see topics related to the configuration of those objects.

  
        

 
         
         		[bookmark: pgfId-328415]Name

  
         		[bookmark: pgfId-328417]The name of variable. This field is not available when you are defining undefined variables.

  
        

 
         
         		[bookmark: pgfId-328423]Description

  
         		[bookmark: pgfId-328425]An optional description of the variable. This field is not available when you are defining undefined variables.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-330372][bookmark: 23176][bookmark: tmplchap_cncpt_UnderstandingFlexConfigPolicies]Editing FlexConfig Policies[bookmark: marker-330368][bookmark: marker-330370]

 
     [bookmark: pgfId-330377]You can assign FlexConfig policies to devices using either Device view or Policy view (for shared policies) by selecting FlexConfigs from the policy selector. You can deploy configurations containing these policies as you would deploy any configuration generated by Security Manager. For a scenario that takes you through setting up a FlexConfig policy object and creating a shared FlexConfig policy, see A FlexConfig Creation Scenario.

 
     [bookmark: pgfId-330379]When you edit a FlexConfig policy, you can perform the following actions:

 
      
      		 [bookmark: pgfId-330391] Add FlexConfig objects —To add a FlexConfig object to a policy, click the Add icon button and select the desired object. You can also create new objects from the object selector dialog box. The objects are added to the prepended or appended list depending on how the objects themselves are defined.[bookmark: marker-330381][bookmark: marker-330383][bookmark: marker-330385][bookmark: marker-330387][bookmark: marker-330389]

 
      		 [bookmark: pgfId-330406] Remove FlexConfig objects —If you no longer want to include an object in the policy, select it and click the Remove icon button. This action removes the object from the policy, but it does not delete the object from Security Manager. For information on deleting objects, see Deleting Objects.[bookmark: marker-330396][bookmark: marker-330398][bookmark: marker-330400][bookmark: marker-330402][bookmark: marker-330404]

 
      		 [bookmark: pgfId-330418] Change the order of the objects —Objects are processed in the order you specify. If an object depends on the processing of another object, it is important that you order them correctly. Select the object whose order you want to change and click the Up or Down arrow buttons until the object is in the desired location.[bookmark: marker-330408][bookmark: marker-330410][bookmark: marker-330412][bookmark: marker-330414][bookmark: marker-330416]

 
     

 
     [bookmark: pgfId-330420]When changing the order of FlexConfig objects that involve route-maps (for example, OSPF or multicast route-maps), make sure that the corresponding access control lists (ACLs) are defined before the route-maps. This is a device requirement. If you do not define ACLs before route-maps, you will get a deployment error.

 
      
      		 [bookmark: pgfId-330437] Change the values assigned to the variables used in a policy object —If you want to configure a variable with a different value for a particular device, creating a device-level override for the object, select the object and click  Values . In the Values Assignment dialog box, click in the Values cell to change the value. For more information, see Values Assignment Dialog Box.[bookmark: marker-330425][bookmark: marker-330427][bookmark: marker-330429][bookmark: marker-330431][bookmark: marker-330433][bookmark: marker-330435]

 
      		 [bookmark: pgfId-330449] Preview the CLI that will be generated for a policy object —In Device view, you can view the CLI that will be generated for a policy object by selecting the object and clicking  Preview . This is especially useful for checking that the CLI commands generated are what you intend to implement on the device.[bookmark: marker-330439][bookmark: marker-330441][bookmark: marker-330443][bookmark: marker-330445][bookmark: marker-330447]

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-330451]Note During deployment, when the FlexConfig policy objects are compiled on the Security Manager server, the correct system variable values and settings are used to generate commands. However, because the Preview function does not have access to these values the way it normally would during deployment, it might not display some CLI commands. In addition, because the Preview function generates CLI commands on the client, some macros used in FlexConfig policy objects reflect client settings instead of server settings.


     
      

     

     

 
     [bookmark: pgfId-330453]Related Topics

 
      
      		 [bookmark: pgfId-330458]Understanding FlexConfig Policies and Policy Objects

 
      		 [bookmark: pgfId-330463]Creating FlexConfig Policy Objects

 
      		 [bookmark: pgfId-330468]Chapter 5, “Managing Policies”

 
      		 [bookmark: pgfId-330473]Chapter 8, “Managing Deployment”

 
     

 
    
 
   
 
    
     [bookmark: pgfId-330485][bookmark: 23322][bookmark: flexpage_cncpt_FlexConfigPolicyPage]FlexConfig Policy Page[bookmark: marker-330481][bookmark: marker-330483]

 
    [bookmark: pgfId-330490]Use the FlexConfig Policy page to create FlexConfig policies. FlexConfig policies contain ordered lists of FlexConfig policy objects, which are subroutines that allow you to extend the ability of Security Manager to configure your devices. For more information on FlexConfig policy objects, see Understanding FlexConfig Policies and Policy Objects.

 
    [bookmark: pgfId-330492]Navigation Path

 
     
     		 [bookmark: pgfId-330494](Device view) Select  FlexConfigs from the Policy selector.

 
     		 [bookmark: pgfId-330496](Policy view) Select  FlexConfigs from the Policy Type selector and select an existing policy or click the Create a Policy button to create a new one.

 
    

 
    [bookmark: pgfId-330498]Related Topics

 
     
     		 [bookmark: pgfId-330503]Creating FlexConfig Policy Objects

 
     		 [bookmark: pgfId-330508]Chapter 7, “Managing FlexConfigs”

 
    

 
    [bookmark: pgfId-330510]Field Reference

 
    [bookmark: pgfId-330513] 

 
     
      
       
       [bookmark: pgfId-328438]Table 7-15 [bookmark: 23354]FlexConfigs Policy Page 

 
       
      
        
        		
          
          [bookmark: pgfId-328444]Element
         
  
        		
          
          [bookmark: pgfId-328446]Description
         
  
       

 
        
        		[bookmark: pgfId-328452]Prepended FlexConfigs

  
        		[bookmark: pgfId-328454]The FlexConfig policy objects that are added to the beginning of the configuration. The objects are processed in the order shown.

  
       

 
        
        		[bookmark: pgfId-328460]Appended FlexConfigs

  
        		[bookmark: pgfId-328462]The FlexConfig policy objects that are added to the end of the configuration. The objects are processed in the order shown.

  
       

 
        
        		[bookmark: pgfId-328468]Values button

  
        		[bookmark: pgfId-328473]Click this button to view, modify, or validate the values assigned to the variables used in the selected FlexConfig policy object using the Values Assignment Dialog Box.

  
       

 
        
        		[bookmark: pgfId-328479]Preview button

 [bookmark: pgfId-328481](Device view only.)

  
        		[bookmark: pgfId-328483]Click this button to view the CLI commands that will be generated for the selected FlexConfig policy object.

 [bookmark: pgfId-328485]In Policy view, you can preview CLI by first clicking Values, selecting a device in the Values Assignment dialog box, and clicking Preview.

  
       

 
        
        		[bookmark: pgfId-328491]Up/Down arrow buttons

  
        		[bookmark: pgfId-328493]Click these buttons to move the selected object up or down in the list. The objects are processed in the displayed order, so it is important that an object whose processing depends on the processing of another object comes after the object it depends on.

  
       

 
        
        		[bookmark: pgfId-328499]Add button

  
        		[bookmark: pgfId-328501]Click this button to add a FlexConfig policy object to the policy. The object itself defines whether it will be added to the prepended or appended list. You can create new FlexConfig objects or select existing ones.

  
       

 
        
        		[bookmark: pgfId-328507]Edit button

  
        		[bookmark: pgfId-328509]Click this button to edit the selected FlexConfig policy object. Your changes affect all devices that use the edited object; your changes are not local policy object overrides for the device.

 [bookmark: pgfId-328511]Note If you selected a predefined FlexConfig policy object packaged with Security Manager, or an object for which you do not have edit permission, you are allowed only to view the object definition.

  
       

 
        
        		[bookmark: pgfId-328517]Remove button

  
        		[bookmark: pgfId-328519]Click this button to remove the selected object from the policy The object is not deleted from Security Manager; it is simply removed from the FlexConfig policy.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-330523][bookmark: 23410][bookmark: flexpage_cncpt_ValuesAssignmentDialogBox]Values Assignment Dialog Box [bookmark: marker-330521]

 
     [bookmark: pgfId-330528]Use the Values Assignment dialog box to view the variables used in a FlexConfig policy object, validate the object, or preview the CLI generated from the object. For more information, see Understanding FlexConfig Object Variables.

 
     [bookmark: pgfId-330530]Navigation Path

 
     [bookmark: pgfId-330535]Select an object and click Values from the FlexConfig Policy Page.

 
     [bookmark: pgfId-330537]Field Reference

 
     [bookmark: pgfId-330540] 

 
      
       
        
        [bookmark: pgfId-328532]Table 7-16 [bookmark: 23425]Values Assignment Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-328538]Element
          
  
         		
           
           [bookmark: pgfId-328540]Description
          
  
        

 
         
         		[bookmark: pgfId-328546]Assigned Devices

 [bookmark: pgfId-328548](Policy view only)

  
         		[bookmark: pgfId-328550]The devices to which the shared FlexConfig policy has been assigned. Select the device for which you want to display variable values.

  
        

 
         
         		[bookmark: pgfId-328556]Name

  
         		[bookmark: pgfId-328558]The name of the variable.

  
        

 
         
         		[bookmark: pgfId-328564]Value

  
         		[bookmark: pgfId-328566]The value to use for the variable. To change the value, double-click the cell. When you change this value, Security Manager creates a device-level override for the policy object. If the policy object is configured so that its values cannot be overridden, you cannot edit the value.

 [bookmark: pgfId-328568]If there is no default value for the variable, you must provide a value unless it is an optional variable.

  
        

 
         
         		[bookmark: pgfId-328574]Default Value

  
         		[bookmark: pgfId-328576]The value assigned to the variable in the policy object. Double-click this cell to view the definition of the policy object that defines the variable’s value.

  
        

 
         
         		[bookmark: pgfId-328582]Override

  
         		[bookmark: pgfId-328584]Whether you can override the value of the variable. You can edit the value of only those variables that have a checkmark in this column.

  
        

 
         
         		[bookmark: pgfId-328590]Object Property

  
         		[bookmark: pgfId-328595]The property of the object. For a detailed explanation, see Add or Edit FlexConfig Dialog Box.

  
        

 
         
         		[bookmark: pgfId-328601]Dimension

  
         		[bookmark: pgfId-328603]The structure of the data in the variable:

 
           
           		 [bookmark: pgfId-328605]0—scalar (a single string)

 
           		 [bookmark: pgfId-328607]1—one-dimensional array (a list of strings)

 
           		 [bookmark: pgfId-328609]2—two-dimensional table (a table of strings)

 
          

  
        

 
         
         		[bookmark: pgfId-328615]Optional

  
         		[bookmark: pgfId-328617]Whether the variable value can be empty.

  
        

 
         
         		[bookmark: pgfId-328623]Description

  
         		[bookmark: pgfId-328625]A description of the variable.

  
        

 
         
         		[bookmark: pgfId-328631]Validate button

  
         		[bookmark: pgfId-328633]Click this button to validate the Velocity Template Language syntax and make sure that all required variables have values, that variables do not start with SYS_, and that referenced policy objects exist.

  
        

 
         
         		[bookmark: pgfId-328639]Preview button

  
         		[bookmark: pgfId-328641]Click this button to display the generated CLI commands for the selected FlexConfig policy object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-330550][bookmark: 23501][bookmark: flexpage_cncpt_FlexConfigPolicyPreviewDialogBox]FlexConfig Preview Dialog Box[bookmark: marker-330548]

 
     [bookmark: pgfId-330552]Use the FlexConfig Preview dialog box to view the generated CLI commands based on the variables of the selected object defined in the FlexConfig policy.

 
     [bookmark: pgfId-330554]Navigation Path

 
     [bookmark: pgfId-330556]To open the FlexConfig Policy Preview dialog box, do one of the following:

 
      
      		 [bookmark: pgfId-330561]In the Values Assignment Dialog Box, click  Preview . In Policy view, you must first select a device.

 
      		 [bookmark: pgfId-330566](Device view) Select a device and click  FlexConfig (see FlexConfig Policy Page). Select an object in the FlexConfig policy and click  Preview .

 
     

 
    
 
   
 
    
     [bookmark: pgfId-330578][bookmark: 23522][bookmark: tmplchap_cncpt_TroubleshootingFlexConfigs]Troubleshooting FlexConfigs[bookmark: marker-330572][bookmark: marker-330574][bookmark: marker-330576]

 
    [bookmark: pgfId-330580]Problem: When adding a FlexConfig using the Cisco Security Manager client, you might receive the following error message:

 
    
     [bookmark: pgfId-330582]Syntax Error: Failed to setup Velocity Engine to validate syntax.
    

    
     [bookmark: pgfId-330584] 
    

    [bookmark: pgfId-330586]This problem is due to administrator privilege rights on Microsoft Windows. In Microsoft Windows Vista and Microsoft Windows 7, Security Manager requires administrator privileges in order to use the FlexConfig feature.

 
    [bookmark: pgfId-330588]Solution: To resolve this issue, launch the Security Manager client with administrator privileges in either of the following ways:

 
     
     		 [bookmark: pgfId-330590]To launch the Security Manager client with administrator privileges, right-click the  Configuration Manager shortcut and select  Run as administrator .

 
     		 [bookmark: pgfId-330592]To permanently enable administrator privileges for the Security Manager client, right-click the  Configuration Manager shortcut and select  Properties . On the Compatibility tab, select  Run this program as an administrator , and then select  OK .

 
    

 
    [bookmark: pgfId-330594]Problem: When using FlexConfigs to deploy to an ASA firewall the following two commands in one job: reload in x noconfirm, reload cancel, you will receive the following error message:

 
    
     [bookmark: pgfId-330596]An error response from the device prevented successful completion of this
    

    
     [bookmark: pgfId-330598]operation. The device provided the following description: reload cancel No
    

    
     [bookmark: pgfId-330600]reload is scheduled
    

    
     [bookmark: pgfId-330602] 
    

    [bookmark: pgfId-330604]Unfortunately, deployment always fails due to fact that both commands are pushed too fast, such that the reload cancel is sent before the reload schedule is activated on the device.

 
    [bookmark: pgfId-330606]Solution: To work around this problem, the commands must be sent in two separate deployments created manually.

 
    [bookmark: pgfId-330608]Problem: When a FlexConfig is assigned and deployed to a device, the FlexConfig is sometimes shown in subsequent Full configuration previews even after the FlexConfig is deleted from a device.

 
    [bookmark: pgfId-330610]Solution: No workaround is needed. The FlexConfig will not be included in the deployment because only the delta configuration is pushed to the device during deployment.
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     [bookmark: pgfId-365340][bookmark: 148428][bookmark: rtroutng_intro_ConfiguringRouting]Configuring Routing Policies
      
      
 
     
 

 
    [bookmark: pgfId-365342]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-365347]BGP Routing on Cisco IOS Routers

 
     		 [bookmark: pgfId-365352]BGP Routing Policy Page

 
     		 [bookmark: pgfId-365357]EIGRP Routing on Cisco IOS Routers

 
     		 [bookmark: pgfId-365362]EIGRP Routing Policy Page

 
     		 [bookmark: pgfId-365367]OSPF Routing on Cisco IOS Routers

 
     		 [bookmark: pgfId-365372]OSPF Interface Policy Page

 
     		 [bookmark: pgfId-365377]OSPF Process Policy Page

 
     		 [bookmark: pgfId-365382]RIP Routing on Cisco IOS Routers

 
     		 [bookmark: pgfId-365387]RIP Routing Policy Page

 
     		 [bookmark: pgfId-365392]Static Routing on Cisco IOS Routers

 
     		 [bookmark: pgfId-365397]Static Routing Policy Page

 
    

 
   
 
    
     [bookmark: pgfId-365409][bookmark: 148430][bookmark: rtchap_cncpt_BGPRoutingonCiscoIOSRouters]BGP Routing on Cisco IOS Routers[bookmark: marker-365403][bookmark: marker-365405][bookmark: marker-365407]

 
    [bookmark: pgfId-365411]BGP is an Exterior Gateway Protocol (EGP) that guarantees the loop-free exchange of routing information between autonomous systems (ASs). The primary function of a BGP system is to exchange information with other BGP systems about the networks it can reach, including AS path information. This information can be used to construct a graph of AS connectivity from which routing loops can be pruned and with which AS-level policy decisions can be enforced.

 
    [bookmark: pgfId-365413]BGP is the routing protocol used on the Internet and is commonly used between Internet service providers. To achieve scalability at this level, BGP uses several route parameters (attributes) to define routing policies and maintain a stable routing environment. Additionally, BGP uses classless interdomain routing (CIDR) to greatly reduce the size of Internet routing tables.

 
    [bookmark: pgfId-365415]A BGP route consists of a network number, a list of ASs through which information has passed (called the autonomous system path), and the defined path attributes.

 
    [bookmark: pgfId-365417]A BGP router exchanges routing information only with those routers that you define as its neighbors. BGP neighbors exchange complete routing information when the TCP connection between them is established. Updates are sent to neighbors only when changes to the routing table are detected. BGP routers do not send regular, periodic updates.

 
    [bookmark: pgfId-365419]The following topics describe the tasks you perform to create a BGP routing policy:

 
     
     		 [bookmark: pgfId-365424]Defining BGP Routes

 
     		 [bookmark: pgfId-365429]Redistributing Routes into BGP

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-365431]Note Security Manager supports versions 2, 3 and 4 of BGP, as defined in RFCs 1163, 1267 and 1771.


    
     

    

    

 
    [bookmark: pgfId-365433]Related Topics

 
     
     		 [bookmark: pgfId-365438]Static Routing on Cisco IOS Routers

 
     		 [bookmark: pgfId-365443]RIP Routing on Cisco IOS Routers

 
     		 [bookmark: pgfId-365448]OSPF Routing on Cisco IOS Routers

 
     		 [bookmark: pgfId-365453]EIGRP Routing on Cisco IOS Routers

 
    

 
     
      [bookmark: pgfId-365461][bookmark: 148472][bookmark: rtchap_proc_DefiningBGPRoutes]Defining BGP Routes[bookmark: marker-365459]

 
     [bookmark: pgfId-365463]As with all EGPs, when you configure a BGP routing policy, you must define the relationship the router has with its neighbors. BGP supports two kinds of neighbors: internal (located in the same AS) and external (located in a different AS). Typically, external neighbors are adjacent to each other and share a subnet; internal neighbors can be anywhere in the same AS.

 
     [bookmark: pgfId-365465]In addition, you can select whether to enable the following optional features:

 
      
      		 [bookmark: pgfId-365467]Auto-summarization

 
      		 [bookmark: pgfId-365469]Synchronization

 
      		 [bookmark: pgfId-365471]Neighbor logging

 
     

 
     [bookmark: pgfId-365473]If enabled, auto-summarization injects only the network route when a subnet is redistributed from an Interior Gateway Protocol (IGP) such as OSPF or EIGRP into BGP. Synchronization is useful if your AS acts as an intermediary, passing traffic from one AS to another AS, because it ensures that your AS is consistent about the routes it advertises. For example, if BGP were to advertise a route before all routers in your network had learned about the route through your IGP, your AS might receive traffic that some routers cannot yet route. Neighbor logging enables the router to keep track of messages issued by BGP neighbors when they reset, become unreachable, or restore their connection to the network.

 
     [bookmark: pgfId-365475]This procedure describes how to define a BGP route. You can define only one BGP route on each router.

 
     [bookmark: pgfId-365477]Related Topics

 
      
      		 [bookmark: pgfId-365482]Redistributing Routes into BGP

 
      		 [bookmark: pgfId-365487]BGP Routing on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-365489]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-365491](Device view) Select  Platform > Routing > BGP from the Policy selector, then click the  Setup tab in the work area.

 
      		 [bookmark: pgfId-365493](Policy view) Select  Router Platform > Routing > BGP from the Policy Type selector. Select an existing policy or create a new one, and then click the  Setup tab.

 
     

 
     [bookmark: pgfId-365498]The BGP Setup is displayed. See Table 66-1 for a description of the fields on this tab.

 
     [bookmark: pgfId-365500]Step 2 On the BGP Setup tab, enter the AS number to which the router belongs.

 
     [bookmark: pgfId-365505]Step 3 (Optional) Enter the addresses of the networks that are local to this AS. You can use a combination of addresses and network/host objects, or click Select to select an object from a list or to create a new one. For more information, see Specifying IP Addresses During Policy Definition.

 
     [bookmark: pgfId-365507]Step 4 Define external and internal BGP neighbors for the routers:

 
     [bookmark: pgfId-365512] a. Click Add under Neighbors to display the BGP Neighbors dialog box. See Table 66-2 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-365516] b. [bookmark: 148525]Enter an AS number and then click Select to select the hosts that are neighbors within the defined AS. Internal neighbors are located in the same AS as the router; external neighbors are located in a different AS.

 
     [bookmark: pgfId-365520] c. [bookmark: 148528]Click OK to save your definitions and return to the BGP Neighbors dialog box.

 
     [bookmark: pgfId-365528] d. (Optional) Repeat b. and c. to define neighbors in additional ASs.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-365530]Note When you define BGP neighbors, the IP addresses cannot belong to an interface on the selected router. In addition, you cannot define the same IP address in more than one AS.


     
      

     

     

 
     [bookmark: pgfId-365532]When you finish, click OK in the BGP Neighbors dialog box to return to the BGP Setup tab. Your selections are displayed in the Neighbors field.

 
     [bookmark: pgfId-365534]Step 5 (Optional) Select the Auto-Summary check box to enable automatic summarization. If automatic summarization is enabled, only the network route is injected into the BGP table when a subnet is redistributed from an IGP (such as OSPF or EIGRP) into BGP.

 
     [bookmark: pgfId-365536]Step 6 (Optional) Select the Synchronization check box to synchronize BGP with the IGP. Enabling this feature causes BGP to wait until the IGP propagates routing information across the AS.

 
     [bookmark: pgfId-365538]You do not need synchronization if your AS does not pass traffic it receives from one AS to another AS, or if all the routers in your AS run BGP. Disabling synchronization enables BGP to converge more quickly.

 
     [bookmark: pgfId-365540]Step 7 (Optional) Select the Log-Neighbor check box to enable the logging of messages generated when a BGP neighbors resets, comes up, or goes down.

 
     [bookmark: pgfId-365542]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-365552][bookmark: 148552][bookmark: rtchap_proc_RedistributingRoutesintoBGP]Redistributing Routes into BGP[bookmark: marker-365548][bookmark: marker-365550]

 
     [bookmark: pgfId-365554]Redistribution refers to using a routing protocol, such as BGP, to advertise routes that are learned by some other means, such as a different routing protocol, static routes, or directly connected routes. For example, you can redistribute routes from the OSPF routing protocol into your BGP autonomous system (AS). Redistribution is necessary in networks that operate in multiple-protocol environments and can be applied to all IP-based routing protocols.

 
     [bookmark: pgfId-365556]Before You Begin

 
      
      		 [bookmark: pgfId-365561]Define a BGP AS. See Defining BGP Routes.

 
     

 
     [bookmark: pgfId-365563]Related Topics

 
      
      		 [bookmark: pgfId-365568]Defining BGP Routes

 
      		 [bookmark: pgfId-365573]BGP Routing on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-365575]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-365577](Device view) Select  Platform > Routing > BGP from the Policy selector, then click the  Redistribution tab in the work area.

 
      		 [bookmark: pgfId-365579](Policy view) Select  Router Platform > Routing > BGP from the Policy Type selector. Select an existing policy or create a new one, and then click the  Redistribution tab.

 
     

 
     [bookmark: pgfId-365584]The BGP Redistribution tab is displayed. See Table 66-3 for a description of the fields on this tab.

 
     [bookmark: pgfId-365589]Step 2 On the BGP Redistribution tab, select a row from the BGP Redistribution Mappings table, then click Edit, or click Add to create a mapping. The BGP Redistribution Mapping dialog box appears. See Table 66-4 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-365591]Step 3 Select the protocol whose routes you want to redistribute into BGP.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-365593]Note You can create a single mapping for each static route, RIP route, EIGRP AS, and OSPF process.


     
      

     

     

 
     [bookmark: pgfId-365595]Step 4 (Optional) Modify the default metric (cost) of the redistributed routes. The metric determines the priority of the routes.

 
     [bookmark: pgfId-365597]Step 5 Click OK to save your definitions locally on the client and close the dialog box. The redistribution mapping appears in the Redistribution Mapping table in the BGP Redistribution tab.

 
     [bookmark: pgfId-365599]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-365609][bookmark: 148607][bookmark: rtpage_cncpt_BGPRoutingPolicyPage]BGP Routing Policy Page[bookmark: marker-365605][bookmark: marker-365607]

 
    [bookmark: pgfId-365611]Border Gateway Protocol (BGP) is an exterior gateway protocol (EGP) that performs routing between multiple autonomous systems or domains and exchanges routing and reachability information with other BGP systems. BGP is used to exchange routing information on the Internet and is the protocol used between Internet service providers.

 
    [bookmark: pgfId-365613]You can configure BGP routing policies from the following tabs on the BGP Routing page:

 
     
     		 [bookmark: pgfId-365618]BGP Pageâ��Setup Tab

 
     		 [bookmark: pgfId-365623]BGP Pageâ��Redistribution Tab

 
    

 
    [bookmark: pgfId-365628]For more information, see BGP Routing on Cisco IOS Routers.

 
    [bookmark: pgfId-365630]Navigation Path

 
     
     		 [bookmark: pgfId-365632](Device view) Select  Platform > Routing > BGP from the Policy selector.

 
     		 [bookmark: pgfId-365634](Policy view) Select  Router Platform > Routing > BGP from the Policy Type selector. Right-click  BGP to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
     
      [bookmark: pgfId-365646][bookmark: 148637][bookmark: rtpage_cncpt_BGPPageSetupTab]BGP Pageâ��Setup Tab[bookmark: marker-365642][bookmark: marker-365644]

 
     [bookmark: pgfId-365648]Use the BGP Setup tab to define the number of the autonomous system (AS) in which the selected router is located. You must then define which networks are included in the AS and which networks are the internal and external neighbors of the router. Additionally, you can enable or disable options that govern the interaction between BGP and Interior Gateway Protocols (IGPs), such as OSPF and EIGRP. Use a third option to enable the logging of messages from BGP neighbors.

 
     [bookmark: pgfId-365650]Navigation Path

 
     [bookmark: pgfId-365655]Go to the BGP Routing Policy Page, then click the Setup tab.

 
     [bookmark: pgfId-365657]Related Topics

 
      
      		 [bookmark: pgfId-365662]Defining BGP Routes

 
      		 [bookmark: pgfId-365667]BGP Pageâ��Redistribution Tab

 
      		 [bookmark: pgfId-365672]Specifying IP Addresses During Policy Definition

 
      		 [bookmark: pgfId-365677]Understanding Networks/Hosts Objects

 
     

 
     [bookmark: pgfId-365679]Field Reference

 
     [bookmark: pgfId-365682] 

 
      
       
        
        [bookmark: pgfId-362507]Table 66-1 [bookmark: 148671]BGP Setup Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-362513]Element
          
  
         		
           
           [bookmark: pgfId-362515]Description
          
  
        

 
         
         		[bookmark: pgfId-362521]AS Number

  
         		[bookmark: pgfId-362523]The number of the autonomous system in which the router is located. Valid values range from 1 to 65535. This number enables a BGP routing process.

 [bookmark: pgfId-362525]If BGP is already configured on the device, you cannot successfully change and deploy this number. If you need to change the AS number, first unassign the BGP policy, deploy your change (thus removing the BGP configuration from the device), then configure the BGP policy with the new number and redeploy the configuration.

  
        

 
         
         		[bookmark: pgfId-362531]Networks

  
         		[bookmark: pgfId-362533]The networks associated with the BGP route. Enter one or more network addresses or network/host objects, or click Select to select the object from a list or to create a new one.

 .

  
        

 
         
         		[bookmark: pgfId-362541]Neighbors

  
         		[bookmark: pgfId-362546]The internal neighbors (those located in the same AS as the router) and external neighbors (located in different ASs) of the router. See Neighbors Dialog Box.

  
        

 
         
         		[bookmark: pgfId-362552]Auto-Summary

  
         		[bookmark: pgfId-362554]When selected, automatic summarization is enabled. When a subnet is redistributed from an IGP (such as RIP, OSPF or EIGRP) into BGP, this BGP version 3 feature injects only the network route into the BGP table. Automatic summarization reduces the size and complexity of the routing table that the router must maintain.

 [bookmark: pgfId-362556]When deselected, automatic summarization is disabled. This is the default.

  
        

 
         
         		[bookmark: pgfId-362562]Synchronization

  
         		[bookmark: pgfId-362564]When selected, synchronization is enabled. Use this feature to ensure that all routers in your network are consistent about the routes they advertise. Synchronization forces BGP to wait until the IGP propagates routing information across the AS.

 [bookmark: pgfId-362566]When deselected, synchronization is disabled. You can disable synchronization if this router does not pass traffic from a different AS to a third AS, or if all the routers in the AS are running BGP. Disabling this feature has the benefit of reducing the number of routes the IGP must carry, which improves convergence times. This is the default.

  
        

 
         
         		[bookmark: pgfId-362572]Log-Neighbor

  
         		[bookmark: pgfId-362574]When selected, enables the logging of messages that are generated when a BGP neighbors resets, connects to the network, or is disconnected. This is the default.

 [bookmark: pgfId-362576]When deselected, message logging is disabled.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-365694][bookmark: 148721][bookmark: rtpage_cncpt_NeighborsDialogBox]Neighbors Dialog Box[bookmark: marker-365690][bookmark: marker-365692]

 
     [bookmark: pgfId-365696]Use the Neighbors dialog box to define the internal and external neighbors of the selected router.

 
     [bookmark: pgfId-365698]Navigation Path

 
     [bookmark: pgfId-365703]Go to the BGP Pageâ��Setup Tab, then click the Add or Edit button in the Neighbors field.

 
     [bookmark: pgfId-365705]Related Topics

 
      
      		 [bookmark: pgfId-365710]Defining BGP Routes

 
      		 [bookmark: pgfId-365715]Specifying IP Addresses During Policy Definition

 
      		 [bookmark: pgfId-365720]Understanding Networks/Hosts Objects

 
     

 
     [bookmark: pgfId-365722]Field Reference

 
     [bookmark: pgfId-365725] 

 
      
       
        
        [bookmark: pgfId-362589]Table 66-2 [bookmark: 148753]Neighbors Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-362595]Element
          
  
         		
           
           [bookmark: pgfId-362597]Description
          
  
        

 
         
         		[bookmark: pgfId-362603]AS Number

  
         		[bookmark: pgfId-362605]The number of the AS containing BGP neighbors. Internal neighbors have the same AS number as the network of the selected router. External neighbors have a different AS number.

  
        

 
         
         		[bookmark: pgfId-362611]IP Address

  
         		[bookmark: pgfId-362613]The IP addresses of the hosts that are neighbors of the router. BGP neighbors exchange routing information with each other whenever changes to the routing table are detected.

 [bookmark: pgfId-362615]When you define BGP neighbors, the IP addresses cannot belong to an interface on the selected router. In addition, you cannot define the same IP address in more than one AS.

 [bookmark: pgfId-362617]Enter one or more addresses or network/host objects, or click Select to select an object from a list or to create a new one.

 .

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-365739][bookmark: 148780][bookmark: rtpage_cncpt_BGPPageRedistributionTab]BGP Pageâ��Redistribution Tab[bookmark: marker-365733][bookmark: marker-365735][bookmark: marker-365737]

 
     [bookmark: pgfId-365741]Use the BGP Redistribution tab to view, create, edit, and delete redistribution settings when performing redistribution into a BGP autonomous system (AS).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-365746]Note You must define BGP setup parameters before you can access the BGP Redistribution tab. See BGP Pageâ��Setup Tab.


     
      

     

     

 
     [bookmark: pgfId-365748]Navigation Path

 
     [bookmark: pgfId-365753]Go to the BGP Routing Policy Page, then click the Redistribution tab.

 
     [bookmark: pgfId-365755]Related Topics

 
      
      		 [bookmark: pgfId-365760]Redistributing Routes into BGP

 
      		 [bookmark: pgfId-365765]BGP Pageâ��Setup Tab

 
      		 [bookmark: pgfId-365770]Table Columns and Column Heading Features

 
      		 [bookmark: pgfId-365775]Filtering Tables

 
     

 
     [bookmark: pgfId-365777]Field Reference

 
     [bookmark: pgfId-365780] 

 
      
       
        
        [bookmark: pgfId-362632]Table 66-3 [bookmark: 148819]BGP Redistribution Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-362638]Element
          
  
         		
           
           [bookmark: pgfId-362640]Description
          
  
        

 
         
         		[bookmark: pgfId-362646]Protocol

  
         		[bookmark: pgfId-362648]The protocol that is being redistributed.

  
        

 
         
         		[bookmark: pgfId-362654]AS/Process ID

  
         		[bookmark: pgfId-362656]The AS number or process ID of the route being redistributed.

  
        

 
         
         		[bookmark: pgfId-362662]Metric

  
         		[bookmark: pgfId-362664]The value that determines the priority of the redistributed route.

  
        

 
         
         		[bookmark: pgfId-362670]Match

  
         		[bookmark: pgfId-362672]When redistributing an OSPF process, indicates the types of OSPF routes that are being redistributed.

  
        

 
         
         		[bookmark: pgfId-362678]Static Type

  
         		[bookmark: pgfId-362680]When redistributing static routes, indicates the type of static route, IP or OSI.

  
        

 
         
         		[bookmark: pgfId-362686]Add button

  
         		[bookmark: pgfId-362691]Opens the BGP Redistribution Mapping Dialog Box. From here you can define BGP redistribution mappings.

  
        

 
         
         		[bookmark: pgfId-362697]Edit button

  
         		[bookmark: pgfId-362702]Opens the BGP Redistribution Mapping Dialog Box. From here you can edit the selected BGP redistribution mapping.

  
        

 
         
         		[bookmark: pgfId-362708]Delete button

  
         		[bookmark: pgfId-362710]Deletes the selected BGP redistribution mappings from the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-365794][bookmark: 148871][bookmark: rtpage_cncpt_BGPRedistributionMappingDialogBox]BGP Redistribution Mapping Dialog Box[bookmark: marker-365788][bookmark: marker-365790][bookmark: marker-365792]

 
     [bookmark: pgfId-365796]Use the BGP Redistribution Mapping dialog box to add or edit the properties of a BGP redistribution mapping.

 
     [bookmark: pgfId-365798]Navigation Path

 
     [bookmark: pgfId-365803]Go to the BGP Pageâ��Redistribution Tab, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-365805]Related Topics

 
      
      		 [bookmark: pgfId-365810]Redistributing Routes into BGP

 
     

 
     [bookmark: pgfId-365812]Field Reference

 
     [bookmark: pgfId-365815] 

 
      
       
        
        [bookmark: pgfId-362723]Table 66-4 [bookmark: 148900]BGP Redistribution Mapping Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-362729]Element
          
  
         		
           
           [bookmark: pgfId-362731]Description
          
  
        

 
         
         		[bookmark: pgfId-362737]Protocol to Redistribute

  
         		[bookmark: pgfId-362739]The routing protocol that is being redistributed:

 
           
           		 [bookmark: pgfId-362741]Staticâ��Redistributes IP or OSI static routes. You can define a single mapping for each route.

 
           		 [bookmark: pgfId-362743]EIGRPâ��Redistributes an EIGRP autonomous system. Enter the AS number in the displayed field. You can define a single mapping for each AS.

 
           		 [bookmark: pgfId-362745]RIPâ��Redistributes RIP routes. You can define a single mapping for each route.

 
           		 [bookmark: pgfId-362747]OSPFâ��Redistributes a different OSPF process. You can define a single mapping for each process. Select a process from the displayed list, then select one or more match criteria:

 
          

 [bookmark: pgfId-362749] â�� Internalâ��Routes that are internal to a specific AS.

 [bookmark: pgfId-362751] â�� External1â��Routes that are external to the AS and imported into OSPF as a Type 1 external route.

 [bookmark: pgfId-362753] â�� External2â��Routes that are external to the AS and imported into the selected process as a Type 2 external route.

 [bookmark: pgfId-362755] â�� NSAAExternal1â��Not-So-Stubby Area (NSSA) routes that are external to the AS and imported into the selected process as Type 1 external routes.

 [bookmark: pgfId-362757] â�� NSAAExternal2â��(NSSA) routes that are external to the AS and imported into the selected process as Type 2 external routes.

 
           
           		 [bookmark: pgfId-362759]Connectedâ��Redistributes routes that are established automatically by virtue of having enabled IP on an interface. These routes are redistributed as external to the AS.

 
          

  
        

 
         
         		[bookmark: pgfId-362765]Metric

  
         		[bookmark: pgfId-362767]A value representing the cost of the redistributed route. Valid values range from 0 to 4294967295.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-365827][bookmark: 148945][bookmark: rtchap_cncpt_EIGRPRoutingonCiscoIOSRouters]EIGRP Routing on Cisco IOS Routers[bookmark: marker-365821][bookmark: marker-365823][bookmark: marker-365825]

 
    [bookmark: pgfId-365829]Enhanced Interior Gateway Routing Protocol (EIGRP) is an enhanced distance vector protocol developed by Cisco Systems that integrates the capabilities of link-state protocols. EIGRP is suited for many different topologies and media. Key capabilities that distinguish EIGRP from other routing protocols are fast convergence, support for variable-length subnet masks, partial updates, and multiple network-layer protocols.

 
    [bookmark: pgfId-365831]The metric that the router uses to reach the destination, and to advertise to other routers, is the sum of the best-advertised metrics from all neighbors and the link cost to the best neighbor.

 
    [bookmark: pgfId-365833]EIGRP uses neighbor tables to store address and interface information about each of the routerâ��s neighbors. Hello packets advertise hold times, which is the length of time a neighbor can be considered reachable and operational. Topology tables contain all destinations advertised by neighboring routers. For each neighbor, the entry records the advertised metric, which the neighbor stores in its routing table.

 
    [bookmark: pgfId-365835]A router running EIGRP stores all its neighborsâ�� routing tables so that it can quickly adapt to alternate routes. If no appropriate route exists, EIGRP queries its neighbors to discover an alternate route. These queries propagate until an alternate route is found. EIGRP sends incremental updates when the state of a destination changes, instead of sending the entire contents of the routing table. EIGRP ensures that only those routers needing the information are updated. This feature minimizes the bandwidth required for EIGRP packets.

 
    [bookmark: pgfId-365837]EIGRP supports both internal and external routes. Internal routes originate within an EIGRP Autonomous System (AS). Therefore, a directly attached network that is configured to run EIGRP is considered an internal route and is propagated with this information throughout the AS. External routes are learned by another routing protocol or reside in the routing table as static routes. These routes are tagged individually with the identity of their origin.

 
    [bookmark: pgfId-365839]The following topics describe the tasks you perform to create an EIGRP routing policy:

 
     
     		 [bookmark: pgfId-365844]Defining EIGRP Routes

 
     		 [bookmark: pgfId-365849]Defining EIGRP Interface Properties

 
     		 [bookmark: pgfId-365854]Redistributing Routes into EIGRP

 
    

 
    [bookmark: pgfId-365856]Related Topics

 
     
     		 [bookmark: pgfId-365861]Static Routing on Cisco IOS Routers

 
     		 [bookmark: pgfId-365866]RIP Routing on Cisco IOS Routers

 
     		 [bookmark: pgfId-365871]OSPF Routing on Cisco IOS Routers

 
     		 [bookmark: pgfId-365876]BGP Routing on Cisco IOS Routers

 
    

 
     
      [bookmark: pgfId-365884][bookmark: 148988][bookmark: rtchap_proc_DefiningEIGRPRoutes]Defining EIGRP Routes[bookmark: marker-365882]

 
     [bookmark: pgfId-365886]To configure an EIGRP routing policy, you must assign each autonomous system a number, which identifies the autonomous system to other routers. You then must select the networks to which routes will be created. In addition, you can select which interfaces should be passive. Unlike other routing protocols, passive interfaces in EIGRP neither send nor receive routing updates from their neighbors, resulting in the loss of their neighbor relationship.

 
     [bookmark: pgfId-365888]When you configure EIGRP routing policies, you can also decide whether to enable auto-summarization, which greatly simplifies routing tables and the exchange of routing information by having many subnets represented by a single network entry.

 
     [bookmark: pgfId-365890]Related Topics

 
      
      		 [bookmark: pgfId-365895]Defining EIGRP Interface Properties

 
      		 [bookmark: pgfId-365900]Redistributing Routes into EIGRP

 
      		 [bookmark: pgfId-365905]EIGRP Routing on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-365907]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-365909](Device view) Select  Platform > Routing > EIGRP from the Policy selector, then click the  Setup tab in the work area.

 
      		 [bookmark: pgfId-365911](Policy view) Select  Router Platform > Routing > EIGRP from the Policy Type selector. Select an existing policy or create a new one, and then click the  Setup tab.

 
     

 
     [bookmark: pgfId-365916]The EIGRP Setup tab is displayed (see EIGRP Pageâ��Setup Tab).

 
     [bookmark: pgfId-365921]Step 2 On the EIGRP Setup tab, select an EIGRP route from the table, then click Edit, or click Add to create a route. The EIGRP Setup dialog box appears. See Table 66-6 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-365923]Step 3 Enter the autonomous system number for the route. This number identifies the autonomous system to other routers.

 
     [bookmark: pgfId-365928]Step 4 Enter the addresses of the networks to include in the EIGRP route. You can use a combination of addresses and network/host objects; separate addresses with commas. Click Select to select network/host objects from a list of existing objects, or to create new network/host objects. For more information, see Specifying IP Addresses During Policy Definition.

 
     [bookmark: pgfId-365933]Step 5 Enter the addresses of the passive interfaces, which are interfaces that should not send routing updates to their neighbors, if any. Enter the names of one or more interfaces or interface roles; separate addresses with commas. Click Select to select interface names or roles from a list of existing objects, or to create new interface role objects. For more information, see Specifying Interfaces During Policy Definition.

 
     [bookmark: pgfId-365935]Step 6 (Optional) Select Auto-Summary to enable the auto summarization of subnet routes into network-level routes. Summarization reduces the size of routing tables, thereby reducing the complexity of the network.

 
     [bookmark: pgfId-365937]Step 7 Click OK to save your definitions. The EIGRP route appears in the table displayed in the EIGRP Setup tab.

 
     [bookmark: pgfId-365939]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-365947][bookmark: 149045][bookmark: rtchap_proc_DefiningEIGRPInterfaceProperties]Defining EIGRP Interface Properties[bookmark: marker-365945]

 
     [bookmark: pgfId-365949]You can optionally modify the default values of the following two interface properties in a selected EIGRP autonomous system:

 
      
      		 [bookmark: pgfId-365951]Hello interval.

 
      		 [bookmark: pgfId-365953]Split horizon.

 
     

 
     [bookmark: pgfId-365955]The hello interval defines the interval between hello packets. Routing devices periodically send these packets to each other to dynamically learn of other routers on their directly attached networks. This information is used to discover neighbors and to learn when neighbors become unreachable or inoperative. By default, hello packets are sent every 5 seconds. The default interval for low speed (T1 or slower), nonbroadcast multiaccess (NBMA) media is every 60 seconds.

 
     [bookmark: pgfId-365957]Split horizon is a feature that prevents route information from being sent back in the direction from which that information originated. If you enable split horizon on an interface (this is the default), update and query packets are not sent to destinations for which this interface is the next hop. This helps to prevent routing loops.

 
     [bookmark: pgfId-365962]For example, as shown in Figure 66-1, if Router One is connected to Routers Two and Three through a single multipoint interface, and Router One learned about Network A from Router Two, Router One does not advertise the route to Network A over that same multipoint interface to Router Three. Router One assumes that Router Three would learn about Network A directly from Router Two.

 
     [bookmark: pgfId-365966]Figure 66-1 [bookmark: 149060]EIGRP Split Horizon Example

 
     [bookmark: pgfId-365969] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-365971]Split horizon is enabled by default on all EIGRP interfaces, because it typically optimizes communications among multiple routing devices. However, in certain cases with nonbroadcast networks (such as Frame Relay and SMDS), you might want to disable split horizon.

 
     [bookmark: pgfId-365973]If you decide to disable split horizon on an EIGRP interface, keep the following in mind:

 
      
      		 [bookmark: pgfId-365975]In a hub-and-spoke network, you should disable split horizon only at the hub. This is because disabling split horizon on the spokes greatly increases EIGRP memory consumption on the hub router, as well as the amount of traffic generated on the spoke routers.

 
      		 [bookmark: pgfId-365977]Changing the split horizon setting on an interface resets all adjacencies with the EIGRP neighbors that are reachable over that interface.

 
     

 
     [bookmark: pgfId-365979]Before You Begin

 
      
      		 [bookmark: pgfId-365984]Define at least one EIGRP autonomous system. See Defining EIGRP Routes.

 
     

 
     [bookmark: pgfId-365986]Related Topics

 
      
      		 [bookmark: pgfId-365991]Defining EIGRP Routes

 
      		 [bookmark: pgfId-365996]Redistributing Routes into EIGRP

 
      		 [bookmark: pgfId-366001]EIGRP Routing on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-366003]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-366005](Device view) Select  Platform > Routing > EIGRP from the Policy selector, then click the  Interfaces tab in the work area.

 
      		 [bookmark: pgfId-366007](Policy view) Select  Router Platform > Routing > EIGRP from the Policy Type selector. Select an existing policy or create a new one, and then click the  Interfaces tab.

 
     

 
     [bookmark: pgfId-366012]The EIGRP Interfaces tab is displayed. See Table 66-7 for a description of the fields on this tab.

 
     [bookmark: pgfId-366017]Step 2 On the EIGRP Interfaces tab, select an interface from the table, then click Edit, or click Add to create an interface definition. The EIGRP Interface dialog box appears. See Table 66-8 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-366022]Step 3 Select the AS number of the autonomous system whose interface properties you want to modify. See Defining EIGRP Routes for more information about defining an autonomous system.

 
     [bookmark: pgfId-366027]Step 4 Enter the name of the interface or interface role to define, or click Select to select an interface role from a list or to create a new one. For more information, see Specifying Interfaces During Policy Definition.

 
     [bookmark: pgfId-366029]Step 5 (Optional) In the Hello Interval field, modify the default interval between hello packets sent over the selected interfaces.

 
     [bookmark: pgfId-366031]The default is 5 seconds for all interfaces, except for low-speed (T1 or less) NBMA media, for which the default interval is 60 seconds.

 
     [bookmark: pgfId-366033]Step 6 (Optional) Deselect the Split Horizon check box to disable the split horizon feature. If you disable this feature, the selected interfaces can advertise a route out of the interface from which they learned the route.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-366035]Note In general, we recommend that you not disable split horizon unless you are certain that your application requires the change to properly advertise routes. If you disable split horizon on a serial interface, and that interface is attached to a packet-switched network, you must disable split horizon for all routers and access servers in all relevant multicast groups on that network.


     
      

     

     

 
     [bookmark: pgfId-366037]Step 7 Click OK to save your definitions locally on the client and close the dialog box. The interface definition appears in the table on the EIGRP Interfaces tab.

 
     [bookmark: pgfId-366039]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-366049][bookmark: 149127][bookmark: rtchap_proc_RedistributingRoutesintoEIGRP]Redistributing Routes into EIGRP[bookmark: marker-366045][bookmark: marker-366047]

 
     [bookmark: pgfId-366051]Redistribution refers to using a routing protocol, such as EIGRP, to advertise routes that are learned by some other means, such as a different routing protocol, static routes, or directly connected routes. For example, you can redistribute routes from the RIP routing protocol into your EIGRP autonomous system (AS). Redistribution is necessary in networks that operate in multiple-protocol environments and can be applied to all IP-based routing protocols.

 
     [bookmark: pgfId-366053]Before You Begin

 
      
      		 [bookmark: pgfId-366058]Define at least one EIGRP autonomous system. See Defining EIGRP Routes.

 
     

 
     [bookmark: pgfId-366060]Related Topics

 
      
      		 [bookmark: pgfId-366065]Defining EIGRP Routes

 
      		 [bookmark: pgfId-366070]Defining EIGRP Interface Properties

 
      		 [bookmark: pgfId-366075]EIGRP Routing on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-366077]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-366079](Device view) Select  Platform > Routing > EIGRP from the Policy selector, then click the  Redistribution tab in the work area.

 
      		 [bookmark: pgfId-366081](Policy view) Select  Router Platform > Routing > EIGRP from the Policy Type selector. Select an existing policy or create a new one, and then click the  Redistribution tab.

 
     

 
     [bookmark: pgfId-366086]The EIGRP Redistribution tab is displayed. See Table 66-9 for a description of the fields on this tab.

 
     [bookmark: pgfId-366091]Step 2 On the EIGRP Redistribution tab, select a row from the EIGRP Redistribution Mappings table, then click Edit, or click Add to create a mapping. The EIGRP Redistribution Mapping dialog box appears. See Table 66-10 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-366093]Step 3 Select an existing EIGRP AS from the displayed list.

 
     [bookmark: pgfId-366095]Step 4 Select the protocol whose routes you want to redistribute into the selected EIGRP AS.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-366097]Note You can create a single mapping for each static route, RIP route, BGP AS, EIGRP AS, and OSPF process.


     
      

     

     

 
     [bookmark: pgfId-366099]Step 5 (Optional) Under Metrics, modify the default metric (cost) of the redistributed routes by entering values in the fields used to calculate the metric. The metric determines the priority of the routes.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-366101]Note Entering a metric is optional, but if you do specify a value, you must enter values for all five parameters. You need not define metric values when redistributing one EIGRP process into another.


     
      

     

     

 
     [bookmark: pgfId-366103]Step 6 Click OK to save your definitions locally on the client and close the dialog box. The redistribution mapping appears in the Redistribution Mapping table in the EIGRP Redistribution tab.

 
     [bookmark: pgfId-366105]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-366117][bookmark: 149188][bookmark: rtpage_cncpt_EIGRPRoutingPolicyPage]EIGRP Routing Policy Page[bookmark: marker-366113][bookmark: marker-366115]

 
    [bookmark: pgfId-366119]Enhanced Interior Gateway Routing Protocol (EIGRP) is a scalable interior gateway protocol that provides extremely quick convergence times with minimal network traffic.

 
    [bookmark: pgfId-366121]You can configure EIGRP routing policies from the following tabs on the EIGRP Routing page:

 
     
     		 [bookmark: pgfId-366126]EIGRP Pageâ��Setup Tab

 
     		 [bookmark: pgfId-366131]EIGRP Pageâ��Interfaces Tab

 
     		 [bookmark: pgfId-366136]EIGRP Pageâ��Redistribution Tab

 
    

 
    [bookmark: pgfId-366141]For more information, see EIGRP Routing on Cisco IOS Routers.

 
    [bookmark: pgfId-366143]Navigation Path

 
     
     		 [bookmark: pgfId-366145](Device view) Select  Platform > Routing > EIGRP from the Policy selector.

 
     		 [bookmark: pgfId-366147](Policy view) Select  Router Platform > Routing > EIGRP from the Policy Type selector. Right-click  EIGRP to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
     
      [bookmark: pgfId-366159][bookmark: 149222][bookmark: rtpage_cncpt_EIGRPPageSetupTab]EIGRP Pageâ��Setup Tab[bookmark: marker-366155][bookmark: marker-366157]

 
     [bookmark: pgfId-366161]Use the EIGRP Setup tab to view, create, edit, and delete EIGRP routes.

 
     [bookmark: pgfId-366163]Navigation Path

 
     [bookmark: pgfId-366168]Go to the EIGRP Routing Policy Page, then click the Setup tab.

 
     [bookmark: pgfId-366170]Related Topics

 
      
      		 [bookmark: pgfId-366175]Defining EIGRP Routes

 
      		 [bookmark: pgfId-366180]EIGRP Pageâ��Interfaces Tab

 
      		 [bookmark: pgfId-366185]EIGRP Pageâ��Redistribution Tab

 
      		 [bookmark: pgfId-366190]Table Columns and Column Heading Features

 
      		 [bookmark: pgfId-366195]Filtering Tables

 
     

 
     [bookmark: pgfId-366197]Field Reference

 
     [bookmark: pgfId-366200] 

 
      
       
        
        [bookmark: pgfId-362780]Table 66-5 [bookmark: 149259]EIGRP Setup Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-362786]Element
          
  
         		
           
           [bookmark: pgfId-362788]Description
          
  
        

 
         
         		[bookmark: pgfId-362794]AS Number

  
         		[bookmark: pgfId-362796]The autonomous system number that identifies the autonomous system to other routers.

  
        

 
         
         		[bookmark: pgfId-362802]Networks

  
         		[bookmark: pgfId-362804]The names of the networks included in the route.

  
        

 
         
         		[bookmark: pgfId-362810]Passive Interfaces

  
         		[bookmark: pgfId-362812]The interfaces that neither send nor receive routing updates from their neighbors.

  
        

 
         
         		[bookmark: pgfId-362818]Auto-Summary

  
         		[bookmark: pgfId-362820]Indicates whether auto summarization is activated on the selected route.

  
        

 
         
         		[bookmark: pgfId-362826]Add button

  
         		[bookmark: pgfId-362831]Opens the EIGRP Setup Dialog Box. From here you can create an EIGRP route.

  
        

 
         
         		[bookmark: pgfId-362837]Edit button

  
         		[bookmark: pgfId-362842]Opens the EIGRP Setup Dialog Box. From here you can edit the selected EIGRP route.

  
        

 
         
         		[bookmark: pgfId-362848]Delete button

  
         		[bookmark: pgfId-362850]Deletes the selected EIGRP routes from the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-366212][bookmark: 149306][bookmark: rtpage_cncpt_EIGRPSetupDialogBox]EIGRP Setup Dialog Box[bookmark: marker-366208][bookmark: marker-366210]

 
     [bookmark: pgfId-366214]Use the EIGRP Setup dialog box to add or edit EIGRP routes.

 
     [bookmark: pgfId-366216]Navigation Path

 
     [bookmark: pgfId-366221]Go to the EIGRP Pageâ��Setup Tab, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-366223]Related Topics

 
      
      		 [bookmark: pgfId-366228]Defining EIGRP Routes

 
      		 [bookmark: pgfId-366233]Specifying IP Addresses During Policy Definition

 
      		 [bookmark: pgfId-366238]Understanding Networks/Hosts Objects

 
     

 
     [bookmark: pgfId-366240]Field Reference

 
     [bookmark: pgfId-366243] 

 
      
       
        
        [bookmark: pgfId-362863]Table 66-6 [bookmark: 149338]EIGRP Setup Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-362869]Element
          
  
         		
           
           [bookmark: pgfId-362871]Description
          
  
        

 
         
         		[bookmark: pgfId-362877]AS Number

  
         		[bookmark: pgfId-362879]The autonomous system number for the EIGRP route. This number is used to identify the autonomous system to other routers. Valid values are from 1 to 65535.

  
        

 
         
         		[bookmark: pgfId-362885]Networks

  
         		[bookmark: pgfId-362887]The networks associated with the EIGRP route. Enter one or more network addresses or network/host objects, separated by commas. Click Select to select network/host objects from a list of existing objects, or to create new objects.

  
        

 
         
         		[bookmark: pgfId-362893]Passive Interfaces

  
         		[bookmark: pgfId-362895]The interfaces that do not send updates to their routing neighbors. Enter one or more interface names or roles, separated by commas. Click Select to select interface names or roles from a list of existing objects, or to create new interface role objects.

 [bookmark: pgfId-362897]Note When you make an interface passive, EIGRP suppresses the exchange of hello packets between routers, resulting in the loss of their neighbor relationship. This not only stops routing updates from being advertised but also suppresses incoming routing updates.

  
        

 
         
         		[bookmark: pgfId-362903]Auto-Summary

  
         		[bookmark: pgfId-362905]When selected, enables the automatic summarization of subnet routes into network-level routes. Summarization reduces the size of routing tables, thereby reducing the complexity of the network.

 [bookmark: pgfId-362907]When deselected, automatic summarization is disabled.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-366255][bookmark: 149374][bookmark: rtpage_cncpt_EIGRPPageInterfacesTab]EIGRP Pageâ��Interfaces Tab[bookmark: marker-366251][bookmark: marker-366253]

 
     [bookmark: pgfId-366257]Use the EIGRP Interfaces tab to create, edit, and delete interface properties for selected EIGRP autonomous systems. This includes modifying the default hello interval and disabling split horizon.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-366262]Note You can access the EIGRP Interfaces tab only after defining at least one EIGRP autonomous system in the Setup tab. See EIGRP Pageâ��Setup Tab.


     
      

     

     

 
     [bookmark: pgfId-366264]Navigation Path

 
     [bookmark: pgfId-366269]Go to the EIGRP Routing Policy Page, then click the Interfaces tab.

 
     [bookmark: pgfId-366271]Related Topics

 
      
      		 [bookmark: pgfId-366276]Defining EIGRP Interface Properties

 
      		 [bookmark: pgfId-366281]EIGRP Pageâ��Setup Tab

 
      		 [bookmark: pgfId-366286]EIGRP Pageâ��Redistribution Tab

 
      		 [bookmark: pgfId-366291]Table Columns and Column Heading Features

 
      		 [bookmark: pgfId-366296]Filtering Tables

 
     

 
     [bookmark: pgfId-366298]Field Reference

 
     [bookmark: pgfId-366301] 

 
      
       
        
        [bookmark: pgfId-362920]Table 66-7 [bookmark: 149413]EIGRP Interfaces Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-362926]Element
          
  
         		
           
           [bookmark: pgfId-362928]Description
          
  
        

 
         
         		[bookmark: pgfId-362934]AS Number

  
         		[bookmark: pgfId-362936]The EIGRP autonomous system number for which interface properties are defined.

  
        

 
         
         		[bookmark: pgfId-362942]Interfaces

  
         		[bookmark: pgfId-362944]The interfaces related to the selected EIGRP autonomous system that have specially defined values.

  
        

 
         
         		[bookmark: pgfId-362950]Split Horizon

  
         		[bookmark: pgfId-362952]Indicates whether the split horizon feature is enabled or disabled for the selected interface.

  
        

 
         
         		[bookmark: pgfId-362958]Hello Interval

  
         		[bookmark: pgfId-362960]The defined interval between hello packets sent to neighboring routers.

  
        

 
         
         		[bookmark: pgfId-362966]Add button

  
         		[bookmark: pgfId-362971]Opens the EIGRP Interface Dialog Box. From here you can create an EIGRP interface definition.

  
        

 
         
         		[bookmark: pgfId-362977]Edit button

  
         		[bookmark: pgfId-362982]Opens the EIGRP Interface Dialog Box. From here you can edit the selected EIGRP interface definition.

  
        

 
         
         		[bookmark: pgfId-362988]Delete button

  
         		[bookmark: pgfId-362990]Deletes the selected EIGRP interface definitions from the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-366313][bookmark: 149460][bookmark: rtpage_cncpt_EIGRPInterfaceDialogBox]EIGRP Interface Dialog Box[bookmark: marker-366309][bookmark: marker-366311]

 
     [bookmark: pgfId-366315]Use the EIGRP Interface dialog box to add or edit interface definitions for a selected EIGRP autonomous system.

 
     [bookmark: pgfId-366317]Navigation Path

 
     [bookmark: pgfId-366322]Go to the EIGRP Pageâ��Interfaces Tab, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-366324]Related Topics

 
      
      		 [bookmark: pgfId-366329]Defining EIGRP Interface Properties

 
      		 [bookmark: pgfId-366334]Basic Interface Settings on Cisco IOS Routers

 
      		 [bookmark: pgfId-366339]Understanding Interface Role Objects

 
     

 
     [bookmark: pgfId-366341]Field Reference

 
     [bookmark: pgfId-366344] 

 
      
       
        
        [bookmark: pgfId-363003]Table 66-8 [bookmark: 149492]EIGRP Interface Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-363009]Element
          
  
         		
           
           [bookmark: pgfId-363011]Description
          
  
        

 
         
         		[bookmark: pgfId-363017]AS Number

  
         		[bookmark: pgfId-363022]Selects the EIGRP autonomous system number whose interface properties you want to modify. For more information about EIGRP autonomous systems, see EIGRP Setup Dialog Box.

  
        

 
         
         		[bookmark: pgfId-363028]Interface

  
         		[bookmark: pgfId-363030]Specifies the EIGRP interface you wish to configure. Enter the name of an interface or interface role, or click Select to select an interface role object from a list or to create a new one.

  
        

 
         
         		[bookmark: pgfId-363036]Hello Interval

  
         		[bookmark: pgfId-363038]The default interval between hello packets sent by the router to its neighbors. Routers send hello packets to each other to dynamically learn of other routers on their directly attached networks. Valid values range from 1 to 65535 seconds. The default is 5 seconds.

  
        

 
         
         		[bookmark: pgfId-363044]Split Horizon

  
         		[bookmark: pgfId-363046]When selected, the split horizon feature is used to prevent routing loops.

 [bookmark: pgfId-363048]When deselected, split horizon is disabled. When split horizon is disabled, the router can advertise a route out of the same interface through which it learned the route.

 [bookmark: pgfId-363050]Disabling split horizon is often useful when dealing with nonbroadcast networks, such as Frame Relay and SMDS.

 [bookmark: pgfId-363052]Note Changing the split horizon setting on an interface resets all adjacencies with EIGRP neighbors that are reachable over that interface.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-366358][bookmark: 149529][bookmark: rtpage_cncpt_EIGRPPageRedistributionTab]EIGRP Pageâ��Redistribution Tab[bookmark: marker-366352][bookmark: marker-366354][bookmark: marker-366356]

 
     [bookmark: pgfId-366360]Use the EIGRP Redistribution tab to create, edit, and delete EIGRP redistribution mappings.

 
     [bookmark: pgfId-366362]Navigation Path

 
     [bookmark: pgfId-366367]Go to the EIGRP Routing Policy Page, then click the Redistribution tab.

 
     [bookmark: pgfId-366369]Related Topics

 
      
      		 [bookmark: pgfId-366374]Redistributing Routes into EIGRP

 
      		 [bookmark: pgfId-366379]EIGRP Pageâ��Setup Tab

 
      		 [bookmark: pgfId-366384]EIGRP Pageâ��Interfaces Tab

 
      		 [bookmark: pgfId-366389]Table Columns and Column Heading Features

 
      		 [bookmark: pgfId-366394]Filtering Tables

 
     

 
     [bookmark: pgfId-366396]Field Reference

 
     [bookmark: pgfId-366399] 

 
      
       
        
        [bookmark: pgfId-363065]Table 66-9 [bookmark: 149569]EIGRP Redistribution Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-363071]Element
          
  
         		
           
           [bookmark: pgfId-363073]Description
          
  
        

 
         
         		[bookmark: pgfId-363079]EIGRP AS Number

  
         		[bookmark: pgfId-363081]The area ID of the EIGRP route into which other routes are being redistributed.

  
        

 
         
         		[bookmark: pgfId-363087]Protocol

  
         		[bookmark: pgfId-363089]The protocol that is being redistributed.

  
        

 
         
         		[bookmark: pgfId-363095]AS/Process ID

  
         		[bookmark: pgfId-363097]The AS number or process ID of the route being redistributed.

  
        

 
         
         		[bookmark: pgfId-363103]Bandwidth

  
         		[bookmark: pgfId-363105]The minimum bandwidth of the path for the EIGRP route, as defined for the route metric.

  
        

 
         
         		[bookmark: pgfId-363111]Delay

  
         		[bookmark: pgfId-363113]The mean latency of the path, as defined for the route metric.

  
        

 
         
         		[bookmark: pgfId-363119]Reliability

  
         		[bookmark: pgfId-363121]A value representing the estimated reliability of the path, as defined for the route metric.

  
        

 
         
         		[bookmark: pgfId-363127]Effective Bandwidth

  
         		[bookmark: pgfId-363129]A value representing the effective load on the link, as defined for the route metric.

  
        

 
         
         		[bookmark: pgfId-363135]MTU

  
         		[bookmark: pgfId-363137]The minimum MTU of the path, as defined for the route metric.

  
        

 
         
         		[bookmark: pgfId-363143]Match

  
         		[bookmark: pgfId-363145]When redistributing an OSPF process, indicates the types of OSPF routes that are being redistributed.

  
        

 
         
         		[bookmark: pgfId-363151]Add button

  
         		[bookmark: pgfId-363156]Opens the EIGRP Redistribution Mapping Dialog Box. From here you can define EIGRP redistribution mappings.

  
        

 
         
         		[bookmark: pgfId-363162]Edit button

  
         		[bookmark: pgfId-363167]Opens the EIGRP Redistribution Mapping Dialog Box. From here you can edit the selected EIGRP redistribution mapping.

  
        

 
         
         		[bookmark: pgfId-363173]Delete button

  
         		[bookmark: pgfId-363175]Deletes the selected EIGRP redistribution mappings from the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-366413][bookmark: 149641][bookmark: rtpage_cncpt_EIGRPRedistributionMappingDialogBox]EIGRP Redistribution Mapping Dialog Box[bookmark: marker-366407][bookmark: marker-366409][bookmark: marker-366411]

 
     [bookmark: pgfId-366415]Use the EIGRP Redistribution Mapping dialog box to add or edit the properties of an EIGRP redistribution mapping.

 
     [bookmark: pgfId-366417]Navigation Path

 
     [bookmark: pgfId-366422]Go to the EIGRP Pageâ��Redistribution Tab, then click the Add or Edit button beneath the table.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-366427]Note You must create at least one EIGRP AS before you can access the EIGRP Redistribution dialog box. See EIGRP Pageâ��Setup Tab.


     
      

     

     

 
     [bookmark: pgfId-366429]Related Topics

 
      
      		 [bookmark: pgfId-366434]Redistributing Routes into EIGRP

 
     

 
     [bookmark: pgfId-366436]Field Reference

 
     [bookmark: pgfId-366439] 

 
      
       
        
        [bookmark: pgfId-363188]Table 66-10 [bookmark: 149672]EIGRP Redistribution Mapping Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-363194]Element
          
  
         		
           
           [bookmark: pgfId-363196]Description
          
  
        

 
         
         		[bookmark: pgfId-363202]EIGRP AS Numbers

  
         		[bookmark: pgfId-363207]The EIGRP AS into which other routes are being redistributed. You must select an ID number from the list of EIGRP autonomous systems defined in the EIGRP Pageâ��Setup Tab.

  
        

 
         
         		[bookmark: pgfId-363213]Protocol to Redistribute

  
         		[bookmark: pgfId-363215]The routing protocol that is being redistributed:

 
           
           		 [bookmark: pgfId-363217]Staticâ��Redistributes static routes. You can define a single mapping for each route.

 
           		 [bookmark: pgfId-363219]EIGRPâ��Redistributes an EIGRP autonomous system. Enter the AS number in the displayed field. You can define a single mapping for each AS.

 
           		 [bookmark: pgfId-363224]BGPâ��Redistributes a BGP autonomous system. You can define a single BGP mapping on each device. If you configured a BGP AS in the BGP Setup tab, the AS number is displayed. Otherwise, a message is displayed indicating that no BGP AS was defined. See BGP Pageâ��Redistribution Tab.

 
          

  
        

 
         
         		[bookmark: pgfId-363230]Protocol to Redistribute (continued)

  
         		
           
           		 [bookmark: pgfId-363232]OSPFâ��Redistributes a different OSPF process. You can define a single mapping for each process. Select a process from the displayed list, then select one or more match criteria:

 
          

 [bookmark: pgfId-363234] â�� Internalâ��Routes that are internal to a specific AS.

 [bookmark: pgfId-363236] â�� External1â��Routes that are external to the AS and imported into OSPF as a Type 1 external route.

 [bookmark: pgfId-363238] â�� External2â��Routes that are external to the AS and imported into the selected process as a Type 2 external route.

 [bookmark: pgfId-363240] â�� NSAAExternal1â��Not-So-Stubby Area (NSSA) routes that are external to the AS and imported into the selected process as Type 1 external routes.

 [bookmark: pgfId-363242] â�� NSAAExternal2â��(NSSA) routes that are external to the AS and imported into the selected process as Type 2 external routes.

 
           
           		 [bookmark: pgfId-363244]RIPâ��Redistributes RIP routes.

 
           		 [bookmark: pgfId-363246]Connectedâ��Redistributes routes that are established automatically by virtue of having enabled IP on an interface. These routes are redistributed as external to the AS.

 
          

  
        

 
         
         		[bookmark: pgfId-363252]Metrics

  
         		[bookmark: pgfId-363254]The default metric (cost) of the redistributed route. Metric parameters include:

 
           
           		 [bookmark: pgfId-363256]Bandwidthâ��The minimum bandwidth of the path in kilobits per second. Valid values range from 1 to 4294967295.

 
           		 [bookmark: pgfId-363258]Delayâ��The mean latency of the path in units of 10 microseconds. Valid values range from 0 to 4294967295.

 
           		 [bookmark: pgfId-363260]Reliabilityâ��A value expressing the estimated reliability of the link. Valid values range from 0 to 255, where 255 represents 100% reliability.

 
           		 [bookmark: pgfId-363262]Effective Bandwidthâ��A value expressing the effective load on the link. Valid values range from 1 to 255, where 255 represents 100% utilization.

 
           		 [bookmark: pgfId-363264]MTU of Pathâ��The maximum transmission unit of the path. Valid values range from 1 to 65535 bytes.

 
          

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-366451][bookmark: 149742][bookmark: rtchap_cncpt_OSPFRoutingonCiscoIOSRouters]OSPF Routing on Cisco IOS Routers[bookmark: marker-366445][bookmark: marker-366447][bookmark: marker-366449]

 
    [bookmark: pgfId-366453]Open Shortest Path First (OSPF) is an interior gateway routing protocol that uses link states instead of distance vectors to distribute routing information within a single autonomous system (AS). OSPF propagates link-state advertisements (LSAs) instead of routing table updates, which allows OSPF networks to converge more quickly than RIP networks. You define areas to limit the number of LSAs that need to be propagated to changes that occur within the area.

 
    [bookmark: pgfId-366455]A router that has interfaces in multiple OSPF areas is called an Area Border Router (ABR). An ABR uses LSAs to send information about available routes to other OSPF routers. A router that acts as a gateway to redistribute traffic between routers using OSPF and routers using other routing protocols is called an Autonomous System Boundary Router (ASBR). Any router can act as an ABR or ASBR.

 
    [bookmark: pgfId-366457]The following topics describe the tasks you perform to create an OSPF routing policy:

 
     
     		 [bookmark: pgfId-366462]Defining OSPF Process Settings

 
     		 [bookmark: pgfId-366467]Defining OSPF Area Settings

 
     		 [bookmark: pgfId-366472]Redistributing Routes into OSPF

 
     		 [bookmark: pgfId-366477]Defining OSPF Interface Settings

 
    

 
    [bookmark: pgfId-366479]Related Topics

 
     
     		 [bookmark: pgfId-366484]Static Routing on Cisco IOS Routers

 
     		 [bookmark: pgfId-366489]RIP Routing on Cisco IOS Routers

 
     		 [bookmark: pgfId-366494]EIGRP Routing on Cisco IOS Routers

 
     		 [bookmark: pgfId-366499]BGP Routing on Cisco IOS Routers

 
    

 
     
      [bookmark: pgfId-366507][bookmark: 149786][bookmark: rtchap_proc_DefiningOSPFProcessSettings]Defining OSPF Process Settings[bookmark: marker-366505]

 
     [bookmark: pgfId-366509]You configure OSPF process parameters by specifying a process ID number, which identifies the OSPF process to other routers, and by deciding whether any interfaces should be passive. Passive interfaces do not send routing updates to their neighbors.

 
     [bookmark: pgfId-366511]Related Topics

 
      
      		 [bookmark: pgfId-366516]Defining OSPF Area Settings

 
      		 [bookmark: pgfId-366521]Defining OSPF Interface Settings

 
      		 [bookmark: pgfId-366526]Redistributing Routes into OSPF

 
      		 [bookmark: pgfId-366531]OSPF Routing on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-366533]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-366535](Device view) Select  Platform > Routing > OSPF Process from the Policy selector, then click the  Setup tab in the work area.

 
      		 [bookmark: pgfId-366537](Policy view) Select  Router Platform > Routing > OSPF Process from the Policy Type selector. Select an existing policy or create a new one, and then click the  Setup tab.

 
     

 
     [bookmark: pgfId-366542]The OSPF Process Setup tab is displayed. See Table 66-13 for a description of the fields on this tab.

 
     [bookmark: pgfId-366547]Step 2 On the OSPF Process Setup tab, select an OSPF process from the table, then click Edit, or click Add to create a process. The OSPF Setup dialog box appears. See Table 66-14 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-366549]Step 3 Enter the process ID number in the field provided. The process ID defined here does not need to match the process ID on any other devices.

 
     [bookmark: pgfId-366551]Step 4 Define which interfaces should not send routing updates to its neighbors:

 
     [bookmark: pgfId-366553] a. Click Edit under Passive Interfaces to display the Edit Interfaces dialog box. Use this dialog box to define which interfaces should not send routing updates to its neighbors.

 
     [bookmark: pgfId-366558] b. Enter the names of one or more interfaces or interface roles, or click Select to select an interface role from a list or to create a new one. For more information, see Specifying Interfaces During Policy Definition.

 
     [bookmark: pgfId-366560] c. Click OK to save your changes and return to the OSPF Setup dialog box.

 
     [bookmark: pgfId-366562]Step 5 Click OK to save your definitions locally on the client and close the dialog box.

 
     [bookmark: pgfId-366564]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-366572][bookmark: 149849][bookmark: rtchap_proc_DefiningOSPFAreaSettings]Defining OSPF Area Settings[bookmark: marker-366570]

 
     [bookmark: pgfId-366574]You configure OSPF area settings by associating an area ID with a particular OSPF process, selecting the networks included in the area, and selecting the type of authentication used by the routers in the area.

 
     [bookmark: pgfId-366576]Each OSPF process that you define should contain at least one defined area. If you define more than one area, one area must be area 0. This is called the backbone. All other areas must be physically connected to the backbone. This enables other areas to inject routing information into the backbone, which the backbone distributes to the remaining areas.

 
     [bookmark: pgfId-366578]You must configure at least one OSPF process before defining OSPF area/network settings for that process.

 
     [bookmark: pgfId-366580]Related Topics

 
      
      		 [bookmark: pgfId-366585]Defining OSPF Process Settings

 
      		 [bookmark: pgfId-366590]Defining OSPF Interface Settings

 
      		 [bookmark: pgfId-366595]Redistributing Routes into OSPF

 
      		 [bookmark: pgfId-366600]OSPF Routing on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-366602]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-366604](Device view) Select  Platform > Routing > OSPF Process from the Policy selector, then click the  Area tab in the work area.

 
      		 [bookmark: pgfId-366606](Policy view) Select  Router Platform > Routing > OSPF Process from the Policy Type selector. Select an existing policy or create a new one, and then click the  Area tab.

 
     

 
     [bookmark: pgfId-366611]The OSPF Process Area tab is displayed. See Table 66-15 for a description of the fields on this tab.

 
     [bookmark: pgfId-366616]Step 2 On the OSPF Process Area tab, select an OSPF area from the table, then click Edit, or click Add to create an area. The OSPF Area dialog box appears. See Table 66-16 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-366618]Step 3 Select a process ID from the displayed list.

 
     [bookmark: pgfId-366620]Step 4 Enter an area ID to associate with the selected OSPF process.

 
     [bookmark: pgfId-366625]Step 5 Enter the addresses of the networks to include in the OSPF area. You can enter a combination of addresses and network/host objects, or click Select to select a network/host object from a list or to create a new one. For more information, see Specifying IP Addresses During Policy Definition.

 
     [bookmark: pgfId-366627]Step 6 Select the authentication type to use in the OSPF area: MD5, clear text, or none. We recommend MD5 when security is of concern. Please note the following:

 
      
      		 [bookmark: pgfId-366629]The authentication type must be the same for all routers and access servers in the same area.

 
      		 [bookmark: pgfId-366631]Specifying clear-text authentication for an area sets the authentication to Type 1 (simple password). All routers on a network must use the same clear-text password to communicate with each other using OSPF.

 
      		 [bookmark: pgfId-366633]MD5 passwords need not be the same throughout an area, but they must be the same between neighbors.

 
      		 [bookmark: pgfId-366638]If you use interface authentication (see Defining OSPF Interface Settings), the authentication type used for the area must match the authentication type used for the interface.

 
     

 
     [bookmark: pgfId-366640]Step 7 Click OK to save your definitions. The OSPF area appears in the table displayed on the OSPF Area tab.

 
     [bookmark: pgfId-366642]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-366654][bookmark: 149918][bookmark: rtchap_cncpt_RedistributingRoutesintoOSPF]Redistributing Routes into OSPF[bookmark: marker-366648][bookmark: marker-366650][bookmark: marker-366652]

 
     [bookmark: pgfId-366656]Redistribution refers to using a routing protocol, such as OSPF, to advertise routes that are learned by some other means, such as a different routing protocol, static routes, or directly connected routes. For example, you can redistribute routes from the RIP routing protocol into your OSPF domain. Redistribution is necessary in networks that operate in multiple-protocol environments and can be applied to all IP-based routing protocols.

 
     [bookmark: pgfId-366658]Redistributing routes into OSPF from other routing protocols or from static routes causes these routes to become OSPF external routes (Type 1 or Type 2).

 
     [bookmark: pgfId-366660]Redistributing routes into OSPF involves:

 
      
      		 [bookmark: pgfId-366665]Defining OSPF Redistribution Mappings

 
      		 [bookmark: pgfId-366670]Defining OSPF Maximum Prefix Values

 
     

 
     [bookmark: pgfId-366672]Related Topics

 
      
      		 [bookmark: pgfId-366677]Defining OSPF Process Settings

 
      		 [bookmark: pgfId-366682]Defining OSPF Area Settings

 
      		 [bookmark: pgfId-366687]Defining OSPF Interface Settings

 
      		 [bookmark: pgfId-366692]OSPF Routing on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-366700][bookmark: 149955][bookmark: rtchap_proc_DefiningOSPFRedistributionMappings]Defining OSPF Redistribution Mappings[bookmark: marker-366698]

 
     [bookmark: pgfId-366702]When you define OSPF redistribution mappings, you must select the protocol to redistribute and the OSPF process into which routes from that protocol are redistributed. Additionally, you can manually define the metric, which determines the priority of the redistributed routes, and the type of external OSPF route to create, Type 1 or Type 2.

 
     [bookmark: pgfId-366704]You can create multiple mappings to the same OSPF process. For example, you can redistribute both RIP and EIGRP routes into the same OSPF process. You can also redistribute routes from other OSPF processes.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-366706]Note Redistribution into an OSPF Not-So-Stubby Area (NSSA) creates a special type of link-state advertisement (LSA) called type 7, which can exist only in an NSSA area. An NSSA autonomous system router (ASBR) generates this LSA, and an NSSA area border router (ABR) translates it into a type 5 LSA, which is propagated into the OSPF domain.


     
      

     

     

 
     [bookmark: pgfId-366708]Type 1 versus Type 2 External Routes

 
     [bookmark: pgfId-366710]Two types of OSPF external routes exist, Type 1 and Type 2. The difference between the two is related to how the cost (metric) of the route is calculated. The cost of a Type 1 route is the sum of the external cost and the internal cost used to reach that route. The cost of a Type 2 route is based on the external cost only. By default, external routes are defined as Type 2. However, a Type 1 route is always preferred over a Type 2 route to the same destination.

 
     [bookmark: pgfId-366712]Before You Begin

 
      
      		 [bookmark: pgfId-366717]Define at least one OSPF process. See Defining OSPF Process Settings.

 
     

 
     [bookmark: pgfId-366719]Related Topics

 
      
      		 [bookmark: pgfId-366724]Defining OSPF Maximum Prefix Values

 
      		 [bookmark: pgfId-366729]Redistributing Routes into OSPF

 
     

 
     
 
     [bookmark: pgfId-366731]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-366733](Device view) Select  Platform > Routing > OSPF Process from the Policy selector, then click the  Redistribution tab in the work area.

 
      		 [bookmark: pgfId-366735](Policy view) Select  Router Platform > Routing > OSPF Process from the Policy Type selector. Select an existing policy or create a new one, and then click the  Redistribution tab.

 
     

 
     [bookmark: pgfId-366740]The OSPF Process Redistribution tab is displayed. See Table 66-17 for a description of the fields on this tab.

 
     [bookmark: pgfId-366745]Step 2 On the OSPF Process Redistribution tab, select a row from the OSPF Redistribution Mappings table, then click Edit, or click Add to create a mapping. The OSPF Redistribution Mapping dialog box is displayed. See Table 66-18 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-366747]Step 3 Select an existing OSPF process from the displayed list.

 
     [bookmark: pgfId-366749]Step 4 Select the protocol whose routes you want to redistribute into the selected OSPF process.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-366751]Note You can create a single mapping for each static route, RIP route, BGP AS, EIGRP AS, and OSPF process.


     
      

     

     

 
     [bookmark: pgfId-366753]Step 5 (Optional) Modify the default metric (cost) of the redistributed routes. The metric determines the priority of the routes.

 
     [bookmark: pgfId-366755]Step 6 Select the Metric Type of external route to create, Type 1 or Type 2. The default is Type 2.

 
     [bookmark: pgfId-366757]Step 7 (Optional) Select the Limit to Subnets check box to redistribute only subnetted routes. By default, this option is not selected.

 
     [bookmark: pgfId-366759]Step 8 Click OK to save your definitions. The redistribution mapping appears in the Redistribution Mapping table on the OSPF Process Redistribution tab.

 
     [bookmark: pgfId-366761]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-366769][bookmark: 150018][bookmark: rtchap_proc_DefiningOSPFMaximumPrefixValues]Defining OSPF Maximum Prefix Values[bookmark: marker-366767]

 
     [bookmark: pgfId-366771]You can define a maximum number of prefixes (routes) that may be redistributed from other protocols or OSPF processes into a selected OSPF process. Setting a limit helps prevent the router from being flooded by too many redistributed routes. For example, without a defined maximum, flooding can occur when BGP is redistributed into OSPF.

 
     [bookmark: pgfId-366773]When you define a maximum prefix value, you can decide whether to prevent additional routes from being redistributed once this maximum is reached, or whether to only issue a warning.

 
     [bookmark: pgfId-366775]The redistribution limit applies to all IP redistributed prefixes, including summarized ones. The limit does not apply to default routes or prefixes that are generated as a result of type 7 to type 5 translations.

 
     [bookmark: pgfId-366777]Before You Begin

 
      
      		 [bookmark: pgfId-366782]Define at least one OSPF process. Define at least one OSPF process. See Defining OSPF Process Settings.

 
      		 [bookmark: pgfId-366787]Define at least one OSPF redistribution mapping. See Defining OSPF Redistribution Mappings.

 
     

 
     [bookmark: pgfId-366789]Related Topics

 
      
      		 [bookmark: pgfId-366794]Defining OSPF Redistribution Mappings

 
      		 [bookmark: pgfId-366799]Redistributing Routes into OSPF

 
     

 
     
 
     [bookmark: pgfId-366801]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-366803](Device view) Select  Platform > Routing > OSPF Process from the Policy selector, then click the  Redistribution tab in the work area.

 
      		 [bookmark: pgfId-366805](Policy view) Select  Router Platform > Routing > OSPF Process from the Policy Type selector. Select an existing policy or create a new one, and then click the  Redistribution tab.

 
     

 
     [bookmark: pgfId-366810]The OSPF Process Redistribution tab is displayed. See Table 66-17 for a description of the fields on this tab.

 
     [bookmark: pgfId-366815]Step 2 On the OSPF Process Redistribution tab, select a row from the Max Prefix Mapping table, then click Edit, or click Add to create a definition. The Max Prefix Mapping dialog box appears. See Table 66-19 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-366817]Step 3 Select an existing OSPF process from the displayed list.

 
     [bookmark: pgfId-366819]Step 4 In the Max Prefix field, enter the maximum number of routes that can be redistributed into the selected OSPF process.

 
     [bookmark: pgfId-366821]Step 5 (Optional) Modify the default threshold percentage. When the number of redistributed routes reaches this threshold, a warning is issued. By default, the threshold value is 75% of the defined maximum prefix value.

 
     [bookmark: pgfId-366823]Step 6 (Optional) Select what should happen when the maximum prefix value is reached:

 
      
      		 [bookmark: pgfId-366825]Enforce Maximum Routeâ��Prevents additional routes from being redistributed to the selected process.

 
      		 [bookmark: pgfId-366827]Warning Onlyâ��Issues an additional warning, but allows route redistribution to continue even after the maximum prefix value is reached.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-366829]Note Flooding can result if you allow route redistribution to continue after exceeding the maximum prefix value.


     
      

     

     

 
     [bookmark: pgfId-366831]Step 7 Click OK to save your definitions. The maximum prefix definition appears in the Maximum Prefix table on the OSPF Process Redistribution tab.

 
     [bookmark: pgfId-366833]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-366843][bookmark: 150084][bookmark: rtchap_proc_DefiningOSPFInterfaceSettings]Defining OSPF Interface Settings[bookmark: marker-366839][bookmark: marker-366841]

 
     [bookmark: pgfId-366845]You can modify a variety of interface-specific OSPF parameters. This procedure describes how to define these parameters. For more information about a particular parameter, see the following topics:

 
      
      		 [bookmark: pgfId-366850]Understanding Interface Cost

 
      		 [bookmark: pgfId-366855]Understanding Interface Priority

 
      		 [bookmark: pgfId-366860]Disabling MTU Mismatch Detection

 
      		 [bookmark: pgfId-366865]Understanding OSPF Timer Settings

 
      		 [bookmark: pgfId-366870]Blocking LSA Flooding

 
      		 [bookmark: pgfId-366875]Understanding the OSPF Network Type

 
      		 [bookmark: pgfId-366880]Understanding OSPF Interface Authentication

 
     

 
     [bookmark: pgfId-366882]Related Topics

 
      
      		 [bookmark: pgfId-366887]Defining OSPF Process Settings

 
      		 [bookmark: pgfId-366892]Defining OSPF Area Settings

 
      		 [bookmark: pgfId-366897]Redistributing Routes into OSPF

 
      		 [bookmark: pgfId-366902]OSPF Routing on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-366904]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-366906](Device view) Select  Platform > Routing > OSPF Interface from the Policy selector.

 
      		 [bookmark: pgfId-366908](Policy view) Select  Router Platform > Routing > OSPF Interface from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-366913]The OSPF Interface page is displayed. See Table 66-11 for a description of the fields on this page.

 
     [bookmark: pgfId-366920]Step 2 [bookmark: 150143]On the OSPF Interface page, select an interface definition from the table, then click Edit, or click Add to create a definition. The OSPF Interface dialog box appears. See Table 66-12 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-366925]Step 3 Enter the name of the interface or interface role to define, or click Select to select an interface role from a list or to create a new one. For more information, see Specifying Interfaces During Policy Definition.

 
     [bookmark: pgfId-366930]Step 4 Define interface authentication. The authentication type you select for the interface must match the authentication type you select for the area (see Defining OSPF Area Settings).

 
     [bookmark: pgfId-366935]All neighboring routers on the same network must have the same password to be able to exchange OSPF information. For more information, see Understanding OSPF Interface Authentication.

 
     [bookmark: pgfId-366937]The key ID number can be associated with multiple passwords. This is an easy and secure way to migrate passwords. For example, to migrate from one password to another, configure a password under a different key ID, then remove the first key.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-366939]Tip The key ID number can be associated with multiple passwords. This is an easy and secure way to migrate passwords. For example, to migrate from one password to another, configure a password under a different key ID, then remove the first key.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-366941]Note Do not use clear text authentication in OSPF packets for security purposes, because the unencrypted authentication key is sent in every packet. Use clear text authentication only when security is not an issue, for example, to ensure that misconfigured hosts do not participate in routing.


     
      

     

     

 
     [bookmark: pgfId-366946]Step 5 (Optional) Under Properties, configure interface parameters as required. See Table 66-12 for information about each parameter.

 
     [bookmark: pgfId-366950]Step 6 [bookmark: 150164]Click OK to save your definitions. The defined interfaces appear on the OSPF Interface page.

 
     [bookmark: pgfId-366952]Step 7 Repeat the process to define interface-specific parameters on additional OSPF interfaces.

 
     [bookmark: pgfId-366954]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-366962][bookmark: 150171][bookmark: rtchap_cncpt_UnderstandingInterfaceCost]Understanding Interface Cost[bookmark: marker-366960]

 
     [bookmark: pgfId-366964]The cost of an OSPF interface is a metric representing the cost of sending a packet over that interface. By default, this cost is calculated using this formula:

 
     [bookmark: pgfId-366966]10 8 / bandwidth [bits per second]

 
     [bookmark: pgfId-366968]For example, if the bandwidth of a Fast Ethernet interface is 10 Mbps (equal to 10 7), the cost of sending packets over that interface is calculated as 10 8 /10 7 or 10. This formula establishes an inverse relationship between the bandwidth of an interface and its cost; the greater the bandwidth, the lower the cost.

 
     [bookmark: pgfId-366970]Although cost is a calculated value, you can manually enter the cost of a selected interface.

 
     [bookmark: pgfId-366972]Related Topics

 
      
      		 [bookmark: pgfId-366977]Understanding Interface Priority

 
      		 [bookmark: pgfId-366982]Disabling MTU Mismatch Detection

 
      		 [bookmark: pgfId-366987]Blocking LSA Flooding

 
      		 [bookmark: pgfId-366992]Understanding OSPF Timer Settings

 
      		 [bookmark: pgfId-366997]Understanding the OSPF Network Type

 
      		 [bookmark: pgfId-367002]Understanding OSPF Interface Authentication

 
      		 [bookmark: pgfId-367007]Defining OSPF Interface Settings

 
     

 
    
 
     
      [bookmark: pgfId-367015][bookmark: 150210][bookmark: rtchap_cncpt_UnderstandingInterfacePriority]Understanding Interface Priority[bookmark: marker-367013]

 
     [bookmark: pgfId-367017]Routers that share a common segment are elected through the Hello protocol to be neighbors on that segment. Election occurs as soon as the routers see themselves listed in their neighborâ��s hello packet. Adjacency is the next step. Adjacent routers are routers that proceed beyond the simple Hello exchange to a database exchange.

 
     [bookmark: pgfId-367019]On each multiaccess (as opposed to point-to-point) segment, OSPF elects one router as the designated router (DR) for that segment. The DR acts as a central point of contact to minimize information exchange. Each router in the segment sends updates to the DR, which in turn relays the information to the other routers. A second router is elected as the backup designated router (BDR) in case the DR goes down.

 
     [bookmark: pgfId-367021]DR and BDR election is performed via the Hello protocol. The router with the highest OSPF priority becomes the DR for that segment. The same process is then repeated for the BDR. In the case of a tie, the router with the higher router ID (RID) is elected. By default, each interface is given a priority of 1, but you can assign a higher priority to selected interfaces, as required.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-367023]Note The priority setting does not apply to point-to-point, nonbroadcast interfaces.


     
      

     

     

 
     [bookmark: pgfId-367025]Related Topics

 
      
      		 [bookmark: pgfId-367030]Understanding Interface Cost

 
      		 [bookmark: pgfId-367035]Disabling MTU Mismatch Detection

 
      		 [bookmark: pgfId-367040]Blocking LSA Flooding

 
      		 [bookmark: pgfId-367045]Understanding OSPF Timer Settings

 
      		 [bookmark: pgfId-367050]Understanding the OSPF Network Type

 
      		 [bookmark: pgfId-367055]Understanding OSPF Interface Authentication

 
      		 [bookmark: pgfId-367060]Defining OSPF Interface Settings

 
     

 
    
 
     
      [bookmark: pgfId-367068][bookmark: 150245][bookmark: rtchap_cncpt_DisablingMTUMismatchDetection]Disabling MTU Mismatch Detection[bookmark: marker-367066]

 
     [bookmark: pgfId-367070]The MTU is the largest packet size that a particular interface can handle. If one router sends a DBD packet that is larger than the MTU setting on a neighboring router, the neighboring router ignores the packet. In many cases, an MTU mismatch causes the two routers to become stuck in exstart/exchange state, which prevents OSPF adjacency from being established. This is why it is important that all neighboring routers share the same MTU setting and that MTU mismatch detection be enabled.

 
     [bookmark: pgfId-367072]You can, however, disable MTU mismatch detection. This is useful in cases where mismatch detection is preventing adjacency from taking place in an otherwise valid setup between two devices with different MTUs.

 
     [bookmark: pgfId-367074]Related Topics

 
      
      		 [bookmark: pgfId-367079]Understanding Interface Cost

 
      		 [bookmark: pgfId-367084]Understanding Interface Priority

 
      		 [bookmark: pgfId-367089]Blocking LSA Flooding

 
      		 [bookmark: pgfId-367094]Understanding OSPF Timer Settings

 
      		 [bookmark: pgfId-367099]Understanding the OSPF Network Type

 
      		 [bookmark: pgfId-367104]Understanding OSPF Interface Authentication

 
      		 [bookmark: pgfId-367109]Defining OSPF Interface Settings

 
     

 
    
 
     
      [bookmark: pgfId-367117][bookmark: 150277][bookmark: rtchap_cncpt_BlockingLSAFlooding]Blocking LSA Flooding[bookmark: marker-367115]

 
     [bookmark: pgfId-367119]By default, OSPF floods new LSAs over all interfaces in the same area, except the interface on which the LSA arrives. Although some redundancy is desirable, too much redundancy can waste bandwidth. In certain topologies, such as full mesh, LSA flooding can destabilize the network because of excessive link and CPU usage. Therefore, you can block LSA flooding to selected interfaces on broadcast, nonbroadcast, and point-to-point networks.

 
     [bookmark: pgfId-367121]Related Topics

 
      
      		 [bookmark: pgfId-367126]Understanding Interface Cost

 
      		 [bookmark: pgfId-367131]Understanding Interface Priority

 
      		 [bookmark: pgfId-367136]Disabling MTU Mismatch Detection

 
      		 [bookmark: pgfId-367141]Understanding OSPF Timer Settings

 
      		 [bookmark: pgfId-367146]Understanding the OSPF Network Type

 
      		 [bookmark: pgfId-367151]Understanding OSPF Interface Authentication

 
      		 [bookmark: pgfId-367156]Defining OSPF Interface Settings

 
     

 
    
 
     
      [bookmark: pgfId-367164][bookmark: 150308][bookmark: rtchap_cncpt_UnderstandingOSPFTimerSettings]Understanding OSPF Timer Settings[bookmark: marker-367162]

 
     [bookmark: pgfId-367166]OSPF uses a series of timers during operation:

 
      
      		 [bookmark: pgfId-367168]Hello Intervalâ��Determines how often an interface sends hello packets, which are used to acquire neighbors and act as indicators that the router is still functioning. The smaller the interval, the faster topological changes on the network are detected. However, a smaller interval also results in more traffic being sent over the interface. The hello interval must be the same on all routers and access servers on a specific network.

 
      		 [bookmark: pgfId-367170]Transmit Delayâ��Determines the delay before an LSA is flooded over the link. The transmit delay setting should take into account the transmission and propagation delays for the interface. These factors are particularly important when configuring low-speed and on-demand links.

 
      		 [bookmark: pgfId-367172]Retransmit Intervalâ��Determines how long to wait before retransmitting an unacknowledged database description (DBD) packet to its neighbors. The retransmit interval setting should be low enough to prevent excessive retransmissions.
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     [bookmark: pgfId-367174]Note You should increase the retransmit interval for serial lines and virtual links.


     
      

     

     

 
      
      		 [bookmark: pgfId-367176]Dead Intervalâ��Determines how long an interface should wait before declaring its neighbor to be down. This declaration is caused by an absence of hello packets from the neighbor during this interval. The dead interval setting must be the same for all routers and access servers on a specific network. By default, this interval is four times the hello interval.

 
     

 
     [bookmark: pgfId-367178]Related Topics

 
      
      		 [bookmark: pgfId-367183]Understanding Interface Cost

 
      		 [bookmark: pgfId-367188]Understanding Interface Priority

 
      		 [bookmark: pgfId-367193]Disabling MTU Mismatch Detection

 
      		 [bookmark: pgfId-367198]Blocking LSA Flooding

 
      		 [bookmark: pgfId-367203]Understanding the OSPF Network Type

 
      		 [bookmark: pgfId-367208]Understanding OSPF Interface Authentication

 
      		 [bookmark: pgfId-367213]Defining OSPF Interface Settings

 
     

 
    
 
     
      [bookmark: pgfId-367221][bookmark: 150350][bookmark: rtchap_cncpt_UnderstandingtheOSPFNetworkType]Understanding the OSPF Network Type[bookmark: marker-367219]

 
     [bookmark: pgfId-367223]You can manually configure the OSPF network type on an interface as either broadcast or nonbroadcast multiaccess (NBMA), regardless of the default media type. For example, you can use this feature to configure broadcast networks (such as Ethernet, Token Ring, and FDDI) as NBMA when your network contains routers that do not support multicast addressing. You can also configure NBMA networks (such as X.25, Frame Relay, and SMDS) as broadcast networks, which eliminates the need to configure neighbors.

 
     [bookmark: pgfId-367225]Configuring NBMA networks as either broadcast or nonbroadcast assumes the existence of virtual circuits (VCs) from every router to every router (fully meshed network). If VCs do not exist between each router, due to cost constraints or the existence of an only partially meshed network, you can configure the OSPF network type as point-to-multipoint. An OSPF point-to-multipoint interface is defined as a numbered point-to-point interface having one or more neighbors. It creates multiple host routes.

 
     [bookmark: pgfId-367227]If you use the point-to-multipoint network type, routing between two routers that are not directly connected go through a third router that has VCs to both routers. You do not need to configure neighbors when using this feature. OSPF point-to-multipoint networks have the following benefits compared to NBMA and point-to-point networks:

 
      
      		 [bookmark: pgfId-367229]Point-to-multipoint is easier to configure because it consumes only one IP subnet and does not require neighbor configuration or designated router election.

 
      		 [bookmark: pgfId-367231]It costs less because it does not require a fully meshed topology.

 
      		 [bookmark: pgfId-367233]It is more reliable because it maintains connectivity in the event of VC failure.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-367238]Note For point-to-multipoint, broadcast networks, you can optionally define neighbors, in which case you should specify the cost to each neighbor. For point-to-multipoint, nonbroadcast networks, you must identify neighbors, but specifying a cost to each neighbor is optional. In both cases, you define neighbors using FlexConfig. See Chapter 7, â��Managing FlexConfigsâ�� for more information.


     
      

     

     

 
     [bookmark: pgfId-367240]Related Topics

 
      
      		 [bookmark: pgfId-367245]Understanding Interface Cost

 
      		 [bookmark: pgfId-367250]Understanding Interface Priority

 
      		 [bookmark: pgfId-367255]Disabling MTU Mismatch Detection

 
      		 [bookmark: pgfId-367260]Blocking LSA Flooding

 
      		 [bookmark: pgfId-367265]Understanding OSPF Timer Settings

 
      		 [bookmark: pgfId-367270]Understanding OSPF Interface Authentication

 
      		 [bookmark: pgfId-367275]Defining OSPF Interface Settings

 
     

 
    
 
     
      [bookmark: pgfId-367283][bookmark: 150393][bookmark: rtchap_cncpt_UnderstandingOSPFInterfaceAuthentication]Understanding OSPF Interface Authentication[bookmark: marker-367281]

 
     [bookmark: pgfId-367285]You define neighbor authentication settings for OSPF interfaces by selecting the interfaces and selecting an authentication type, either MD5 or clear text.

 
     [bookmark: pgfId-367287]When you use MD5 authentication, neighboring routers must share the same password. When you use clear-text authentication, all routers on the network using OSPF must share the same password.

 
     [bookmark: pgfId-367289]Whenever you configure an interface with a new key, the router sends multiple copies of the same packet, each authenticated by different keys. The router stops sending duplicate packets when it detects that all of its neighbors have adopted the new key.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-367291]Note You should use authentication with all routing protocols when possible, because attackers can use route redistribution between OSPF and other protocols (such as RIP) to subvert routing information.


     
      

     

     

 
     [bookmark: pgfId-367293]Related Topics

 
      
      		 [bookmark: pgfId-367298]Understanding Interface Cost

 
      		 [bookmark: pgfId-367303]Understanding Interface Priority

 
      		 [bookmark: pgfId-367308]Disabling MTU Mismatch Detection

 
      		 [bookmark: pgfId-367313]Blocking LSA Flooding

 
      		 [bookmark: pgfId-367318]Understanding OSPF Timer Settings

 
      		 [bookmark: pgfId-367323]Understanding the OSPF Network Type

 
      		 [bookmark: pgfId-367328]Understanding OSPF Interface Authentication

 
     

 
    
 
   
 
    
     [bookmark: pgfId-367340][bookmark: 150430][bookmark: rtpage_cncpt_OSPFInterfacePolicyPage]OSPF Interface Policy Page[bookmark: marker-367336][bookmark: marker-367338]

 
    [bookmark: pgfId-367345]Use the OSPF Interface page to view, create, edit, and delete interface-specific OSPF settings. For more information, see Defining OSPF Interface Settings.

 
    [bookmark: pgfId-367347]Navigation Path

 
     
     		 [bookmark: pgfId-367349](Device view) Select  Platform > Routing > OSPF Interface from the Policy selector.

 
     		 [bookmark: pgfId-367351](Policy view) Select  Router Platform > Routing > OSPF Interface from the Policy Type selector. Right-click  OSPF Interface to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-367353]Related Topics

 
     
     		 [bookmark: pgfId-367358]OSPF Process Policy Page

 
     		 [bookmark: pgfId-367363]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-367368]Filtering Tables

 
    

 
    [bookmark: pgfId-367370]Field Reference

 
    [bookmark: pgfId-367373] 

 
     
      
       
       [bookmark: pgfId-363277]Table 66-11 [bookmark: 150467]OSPF Interface Page 

 
       
      
        
        		
          
          [bookmark: pgfId-363283]Element
         
  
        		
          
          [bookmark: pgfId-363285]Description
         
  
       

 
        
        		[bookmark: pgfId-363291]Interfaces

  
        		[bookmark: pgfId-363293]The name of an interface (as defined by an interface role) on which OSPF is enabled.

  
       

 
        
        		[bookmark: pgfId-363299]Authentication

  
        		[bookmark: pgfId-363301]The type of OSPF neighbor authentication enabled for the selected interface.

  
       

 
        
        		[bookmark: pgfId-363307]Key ID

  
        		[bookmark: pgfId-363309]The identification number of the authentication key used for MD5 authentication.

  
       

 
        
        		[bookmark: pgfId-363315]Cost

  
        		[bookmark: pgfId-363317]The cost of sending packets over the selected interface, if this value is different from the cost as normally calculated.

  
       

 
        
        		[bookmark: pgfId-363323]Priority

  
        		[bookmark: pgfId-363325]The priority of the selected interface.

  
       

 
        
        		[bookmark: pgfId-363331]MTU Ignore

  
        		[bookmark: pgfId-363333]Indicates whether Maximum Transmission Rate (MTU) detection is disabled on the selected interface.

  
       

 
        
        		[bookmark: pgfId-363339]Database Filter

  
        		[bookmark: pgfId-363341]Indicates whether link-state advertisement (LSA) flooding is disabled on the selected interface.

  
       

 
        
        		[bookmark: pgfId-363347]Hello Interval

  
        		[bookmark: pgfId-363349]The interval between hello packets (in seconds) sent over this interface.

  
       

 
        
        		[bookmark: pgfId-363355]Transmit Delay

  
        		[bookmark: pgfId-363357]The amount of time OSPF waits (in seconds) before flooding an LSA over the link.

  
       

 
        
        		[bookmark: pgfId-363363]Retransmit Interval

  
        		[bookmark: pgfId-363365]The interval between LSA retransmissions (in seconds) over the selected interface.

  
       

 
        
        		[bookmark: pgfId-363371]Dead Interval

  
        		[bookmark: pgfId-363373]The interval OSPF waits (in seconds) before declaring a neighboring router dead because of an absence of hello packets.

  
       

 
        
        		[bookmark: pgfId-363379]Network Type

  
        		[bookmark: pgfId-363381]The network type configured for the selected interface, if it differs from the default medium.

  
       

 
        
        		[bookmark: pgfId-363387]Add button

  
        		[bookmark: pgfId-363392]Opens the OSPF Interface Dialog Box. From here you can define the properties of an OSPF interface.

  
       

 
        
        		[bookmark: pgfId-363398]Edit button

  
        		[bookmark: pgfId-363403]Opens the OSPF Interface Dialog Box. From here you can edit the properties of the selected OSPF interface.

  
       

 
        
        		[bookmark: pgfId-363409]Delete button

  
        		[bookmark: pgfId-363411]Deletes the selected OSPF interface definitions from the table.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-367385][bookmark: 150554][bookmark: rtpage_cncpt_OSPFInterfaceDialogBox]OSPF Interface Dialog Box[bookmark: marker-367381][bookmark: marker-367383]

 
     [bookmark: pgfId-367387]Use the OSPF Interface dialog box to add or edit the properties of OSPF interfaces.

 
     [bookmark: pgfId-367389]Navigation Path

 
     [bookmark: pgfId-367394]Go to the OSPF Interface Policy Page, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-367396]Related Topics

 
      
      		 [bookmark: pgfId-367401]Defining OSPF Interface Settings

 
      		 [bookmark: pgfId-367406]OSPF Routing on Cisco IOS Routers

 
      		 [bookmark: pgfId-367411]Basic Interface Settings on Cisco IOS Routers

 
      		 [bookmark: pgfId-367416]Understanding Interface Role Objects

 
     

 
     [bookmark: pgfId-367418]Field Reference

 
     [bookmark: pgfId-367421] 

 
      
       
        
        [bookmark: pgfId-363424]Table 66-12 [bookmark: 150589]OSPF Interface Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-363430]Element
          
  
         		
           
           [bookmark: pgfId-363432]Description
          
  
        

 
         
         		[bookmark: pgfId-363438]Interface

  
         		[bookmark: pgfId-363440]The OSPF interface to configure. Enter the name of an interface or interface role, or click Select to select the object from a list or to create a new one.

  
        

 
         
         		[bookmark: pgfId-363446]Authentication

  
         		[bookmark: pgfId-363448]Typeâ��The authentication type used by the selected interface:

 
           
           		 [bookmark: pgfId-363450]MD5â��Uses the MD5 hash algorithm for authentication. This is the default.

 
           		 [bookmark: pgfId-363452]Clear Textâ��Uses a clear text password for authentication.

 
           		 [bookmark: pgfId-363454]Noneâ��Uses no authentication.

 
          

 [bookmark: pgfId-363456]Note The authentication type used on an interface must match the authentication type defined for the area.

 [bookmark: pgfId-363458]Note Use plain text authentication only when security is not an issue, for example, to ensure that misconfigured hosts do not participate in routing.

 
           
           		 [bookmark: pgfId-363460]Key IDâ��Available only when MD5 is selected as the authentication type.

 
          

 [bookmark: pgfId-363462]The identification number of the authentication key. This number must be shared with all other devices sending updates to, and receiving updates from, the selected device. Valid values range from 1 to 255.

 
           
           		 [bookmark: pgfId-363464]Keyâ��The shared key used for authentication (MD5 or clear text). This key must be shared with all other devices sending updates to, and receiving updates from, the selected device. Enter this key again in the Confirm field.

 
          

 [bookmark: pgfId-363466]When using clear text, the key can include any continuous string of characters that can be entered from the keyboard (up to 8 bytes).

 [bookmark: pgfId-363468]When using MD5, the key can include alphanumeric characters only (up to 16 bytes).

  
        

 
         
         		[bookmark: pgfId-363474]Cost

  
         		[bookmark: pgfId-363476]The cost of sending packets over this interface. A value entered here overrides the default calculated cost (10 8 /bandwidth in bits per second).

 [bookmark: pgfId-363478]Valid values range from 1 to 65535.

  
        

 
         
         		[bookmark: pgfId-363484]Priority

  
         		[bookmark: pgfId-363486]The default priority of the interface. The priority is used to determine which routers become the designated router (DR) and backup designated router (BDR) for that segment. The higher the number, the higher the priority.

 [bookmark: pgfId-363488]The default priority is 1. Valid values range from 0 to 255.

 [bookmark: pgfId-363490]Note To exclude the interface from election as DR or BDR, assign a priority of 0. Configure router priority only for interfaces to multiaccess networks, not point-to-point networks.

  
        

 
         
         		[bookmark: pgfId-363496]MTU Ignore

  
         		[bookmark: pgfId-363498]When selected, ignores MTU mismatches between neighboring routers.

 [bookmark: pgfId-363500]When deselected, MTU mismatch detection is enabled.

 [bookmark: pgfId-363502]Note Typically, this option is not used, because it can cause routers to become stuck in exstart/exchange state, which prevents OSPF adjacency from being established.

  
        

 
         
         		[bookmark: pgfId-363508]Database Filter

  
         		[bookmark: pgfId-363510]When selected, blocks link-state advertisement (LSA) flooding to the selected interface.

 [bookmark: pgfId-363512]When deselected, LSA flooding is permitted.

 [bookmark: pgfId-363514]Note We recommend that you enable this option on fully-meshed networks. This option is not available for point-to-multipoint networks.

  
        

 
         
         		[bookmark: pgfId-363520]Hello Interval

  
         		[bookmark: pgfId-363522]The default interval (in seconds) between hello packets sent over the selected interface. These packets are used by neighboring routers to confirm the router sending the packets is still operating. Valid values range 1 to 65535 seconds.

 [bookmark: pgfId-363524]Note The hello interval must be the same for all routers and access servers in the network.

  
        

 
         
         		[bookmark: pgfId-363530]Transmit Delay

  
         		[bookmark: pgfId-363532]The amount of time OSPF waits (in seconds) before flooding an LSA over the link.

 [bookmark: pgfId-363534]The default is 1 second. Valid values range from 1 to 65535 seconds.

 [bookmark: pgfId-363536]Note When you configure slow links or on-demand links that queue traffic before sending it in bursts, we recommend that you take these link delays into account when defining this value.

  
        

 
         
         		[bookmark: pgfId-363542]Retransmit Interval

  
         		[bookmark: pgfId-363544]The interval between LSA retransmissions (in seconds) over the selected interface.

 [bookmark: pgfId-363546]The default is 5 seconds. Valid values range from 1 to 65535 seconds.

 [bookmark: pgfId-363548]Note We recommend that you increase this value for serial lines and virtual links.

  
        

 
         
         		[bookmark: pgfId-363554]Dead Interval

  
         		[bookmark: pgfId-363556]The interval (in seconds) after which an interface declares its neighbor dead if no hello packets are received. Valid values range from 1 to 655335 seconds.

 [bookmark: pgfId-363558]Note The value of the dead interval is typically the hello interval value multiplied by 4. The dead interval must be the same for all routers and access servers in the network.

  
        

 
         
         		[bookmark: pgfId-363564]Configure Network Type

  
         		[bookmark: pgfId-363566]When selected, enables you to select a network type that differs from the default medium used by the interface.

 [bookmark: pgfId-363568]When deselected, the network type is equivalent to the default medium used by the interface.

 [bookmark: pgfId-363570]For nonbroadcast multiaccess (NBMA) networks (such as ATM and Frame Relay), options are:

 
           
           		 [bookmark: pgfId-363572]Broadcastâ��Treats the NBMA network as a broadcast network, which eliminates the need to configure neighbors. Use this option when there are virtual circuits from every router to every router (fully meshed network).

 
           		 [bookmark: pgfId-363574]Point-to-Multipointâ��Treats the nonbroadcast network as a series of point-to-point links. This option is easier to configure, less costly, and more reliable than NBMA or point-to-point networks.

 
           		 [bookmark: pgfId-363576]Point-to-Multipoint Non-Broadcastâ��Statically maintains the known neighbors of the network. Selecting this option helps avoid the problem of losing neighbors that were learned dynamically through the reception of hello packets.

 
          

 [bookmark: pgfId-363581]Note Another option for NBMA networks is to configure neighbors manually using FlexConfigs. See Understanding FlexConfig Policies and Policy Objects.

 [bookmark: pgfId-363583]For broadcast networks (such as Ethernet, Token Ring, and FDDI), you can select:

 
           
           		 [bookmark: pgfId-363585]Non-Broadcastâ��Treats the broadcast network as a nonbroadcast network.

 
           		 [bookmark: pgfId-363587]Point-to-Pointâ��Treats the broadcast network as a point-to-point network. You can use this option, for example, to configure a broadcast network (such as Ethernet) as a nonbroadcast multiaccess (NBMA) network if not all routers in the network support multicast addressing.

 
          

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-367433][bookmark: 150704][bookmark: rtpage_cncpt_OSPFProcessPolicyPage]OSPF Process Policy Page[bookmark: marker-367429][bookmark: marker-367431]

 
    [bookmark: pgfId-367435]OSPF is an interior gateway routing protocol that uses link states instead of distance vectors for path selection. OSPF propagates link-state advertisements (LSAs) instead of routing table updates, which enables OSPF networks to converge quickly.

 
    [bookmark: pgfId-367437]You can configure OSPF process policies from the following tabs on the OSPF Process page:

 
     
     		 [bookmark: pgfId-367442]OSPF Process Pageâ��Setup Tab

 
     		 [bookmark: pgfId-367447]OSPF Process Pageâ��Area Tab

 
     		 [bookmark: pgfId-367452]OSPF Process Pageâ��Redistribution Tab

 
    

 
    [bookmark: pgfId-367457]For more information, see OSPF Routing on Cisco IOS Routers.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-367462]Note For more information about OSPF interface policies, see OSPF Interface Policy Page.


    
     

    

    

 
    [bookmark: pgfId-367464]Navigation Path

 
     
     		 [bookmark: pgfId-367466](Device view) Select  Platform > Routing > OSPF Process from the Policy selector.

 
     		 [bookmark: pgfId-367468](Policy view) Select  Router Platform > Routing > OSPF Process from the Policy Type selector. Right-click  OSPF Process to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
     
      [bookmark: pgfId-367480][bookmark: 150741][bookmark: rtpage_cncpt_OSPFProcessPageSetupTab]OSPF Process Pageâ��Setup Tab[bookmark: marker-367476][bookmark: marker-367478]

 
     [bookmark: pgfId-367482]Use the OSPF Process Setup tab to create, edit, and delete OSPF processes. This includes selecting those interfaces that will remain passive, which means that they will not send routing updates to their neighbors. You can create as many processes for each router as required.

 
     [bookmark: pgfId-367484]Navigation Path

 
     [bookmark: pgfId-367489]Go to the OSPF Process Policy Page, then click the Setup tab.

 
     [bookmark: pgfId-367491]Related Topics

 
      
      		 [bookmark: pgfId-367496]Defining OSPF Process Settings

 
      		 [bookmark: pgfId-367501]OSPF Process Pageâ��Area Tab

 
      		 [bookmark: pgfId-367506]OSPF Process Pageâ��Redistribution Tab

 
      		 [bookmark: pgfId-367511]OSPF Interface Policy Page

 
      		 [bookmark: pgfId-367516]Table Columns and Column Heading Features

 
      		 [bookmark: pgfId-367521]Filtering Tables

 
     

 
     [bookmark: pgfId-367523]Field Reference

 
     [bookmark: pgfId-367526] 

 
      
       
        
        [bookmark: pgfId-363600]Table 66-13 [bookmark: 150782]OSPF Process Setup Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-363606]Element
          
  
         		
           
           [bookmark: pgfId-363608]Description
          
  
        

 
         
         		[bookmark: pgfId-363614]Process ID

  
         		[bookmark: pgfId-363616]The process ID that identifies the OSPF routing process to other routers.

  
        

 
         
         		[bookmark: pgfId-363622]Passive Interfaces

  
         		[bookmark: pgfId-363624]The interfaces that do not send out routing updates.

  
        

 
         
         		[bookmark: pgfId-363630]Add button

  
         		[bookmark: pgfId-363635]Opens the OSPF Setup Dialog Box. From here you can define an OSPF process.

  
        

 
         
         		[bookmark: pgfId-363641]Edit button

  
         		[bookmark: pgfId-363646]Opens the OSPF Setup Dialog Box. From here you can edit the selected OSPF process.

  
        

 
         
         		[bookmark: pgfId-363652]Delete button

  
         		[bookmark: pgfId-363654]Deletes the selected OSPF processes from the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-367538][bookmark: 150819][bookmark: rtpage_cncpt_OSPFSetupDialogBox]OSPF Setup Dialog Box[bookmark: marker-367534][bookmark: marker-367536]

 
     [bookmark: pgfId-367540]Use the OSPF Setup dialog box to add or edit an OSPF process.

 
     [bookmark: pgfId-367542]Navigation Path

 
     [bookmark: pgfId-367547]Go to the OSPF Process Pageâ��Setup Tab, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-367549]Related Topics

 
      
      		 [bookmark: pgfId-367554]Defining OSPF Process Settings

 
     

 
     [bookmark: pgfId-367556]Field Reference

 
     [bookmark: pgfId-367559] 

 
      
       
        
        [bookmark: pgfId-363667]Table 66-14 [bookmark: 150846]OSPF Setup Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-363673]Element
          
  
         		
           
           [bookmark: pgfId-363675]Description
          
  
        

 
         
         		[bookmark: pgfId-363681]Process ID

  
         		[bookmark: pgfId-363683]The process ID number for the OSPF process. This number identifies the OSPF process to other routers. It does not need to match the process ID on other devices. Valid values are from 1 to 65535.

  
        

 
         
         		[bookmark: pgfId-363689]Passive Interfaces

  
         		[bookmark: pgfId-363694]The interfaces that do not send updates to their routing neighbors. Click Edit to display the Edit Interfaces Dialog Boxâ��OSPF Passive Interfaces. From here you can define these interfaces.

 [bookmark: pgfId-363696]Note When you make an interface passive, OSPF suppresses the sending of hello packets to neighboring routers. The interface will continue to receive routing updates, however.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-367569][bookmark: 150870][bookmark: rtpage_cncpt_EditInterfacesDialogBoxOSPFPassiveInterfaces]Edit Interfaces Dialog Boxâ��OSPF Passive Interfaces[bookmark: marker-367567]

 
     [bookmark: pgfId-367571]When you configure an OSPF routing policy on a Cisco IOS router, use the Edit Interfaces dialog box to specify which interfaces will not send updates to their routing neighbors. Separate multiple names or roles with commas. Click Select to select interface names or roles from a list of existing objects, or to create new interface role objects.

 
     [bookmark: pgfId-367573]Navigation Path

 
     [bookmark: pgfId-367578]Go to the OSPF Setup Dialog Box, then click the Edit button in the Passive Interfaces field.

 
     [bookmark: pgfId-367580]Related Topics

 
      
      		 [bookmark: pgfId-367585]OSPF Process Pageâ��Setup Tab

 
      		 [bookmark: pgfId-367590]Defining OSPF Process Settings

 
     

 
    
 
     
      [bookmark: pgfId-367602][bookmark: 150895][bookmark: rtpage_cncpt_OSPFProcessPageAreaTab]OSPF Process Pageâ��Area Tab[bookmark: marker-367598][bookmark: marker-367600]

 
     [bookmark: pgfId-367604]Use the OSPF Area tab to create, edit, and delete the areas and networks contained in each OSPF process. This includes selecting the type of authentication used by each area.

 
     [bookmark: pgfId-367606]Navigation Path

 
     [bookmark: pgfId-367611]Go to the OSPF Process Policy Page, then click the Area tab.

 
     [bookmark: pgfId-367613]Related Topics

 
      
      		 [bookmark: pgfId-367618]Defining OSPF Area Settings

 
      		 [bookmark: pgfId-367623]OSPF Process Pageâ��Setup Tab

 
      		 [bookmark: pgfId-367628]OSPF Process Pageâ��Redistribution Tab

 
      		 [bookmark: pgfId-367633]OSPF Interface Policy Page

 
      		 [bookmark: pgfId-367638]Table Columns and Column Heading Features

 
      		 [bookmark: pgfId-367643]Filtering Tables

 
     

 
     [bookmark: pgfId-367645]Field Reference

 
     [bookmark: pgfId-367648] 

 
      
       
        
        [bookmark: pgfId-363709]Table 66-15 [bookmark: 150936]OSPF Process Area Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-363715]Element
          
  
         		
           
           [bookmark: pgfId-363717]Description
          
  
        

 
         
         		[bookmark: pgfId-363723]Area ID

  
         		[bookmark: pgfId-363725]The ID number of the area associated with the process.

  
        

 
         
         		[bookmark: pgfId-363731]Process ID

  
         		[bookmark: pgfId-363733]The process ID that identifies the OSPF routing process to other routers.

  
        

 
         
         		[bookmark: pgfId-363739]Networks

  
         		[bookmark: pgfId-363741]The networks included in the area.

  
        

 
         
         		[bookmark: pgfId-363747]Authentication

  
         		[bookmark: pgfId-363749]The authentication type used by the areaâ��MD5, clear text, or none.

  
        

 
         
         		[bookmark: pgfId-363755]Add button

  
         		[bookmark: pgfId-363760]Open the OSPF Area Dialog Box. From here you can define an OSPF area.

  
        

 
         
         		[bookmark: pgfId-363766]Edit button

  
         		[bookmark: pgfId-363771]Opens the OSPF Area Dialog Box. From here you can edit the selected OSPF area.

  
        

 
         
         		[bookmark: pgfId-363777]Delete button

  
         		[bookmark: pgfId-363779]Deletes the selected OSPF areas from the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-367660][bookmark: 150983][bookmark: rtpage_cncpt_OSPFAreaDialogBox]OSPF Area Dialog Box[bookmark: marker-367656][bookmark: marker-367658]

 
     [bookmark: pgfId-367665]Use the OSPF Area dialog box to add or edit the properties of an OSPF area. You should define at least one area for each OSPF process (see OSPF Setup Dialog Box), but deployment will not fail if you do not.

 
     [bookmark: pgfId-367667]Navigation Path

 
     [bookmark: pgfId-367672]Go to the OSPF Process Pageâ��Area Tab, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-367674]Related Topics

 
      
      		 [bookmark: pgfId-367679]Defining OSPF Area Settings

 
      		 [bookmark: pgfId-367684]Specifying IP Addresses During Policy Definition

 
      		 [bookmark: pgfId-367689]Understanding Networks/Hosts Objects

 
     

 
     [bookmark: pgfId-367691]Field Reference

 
     [bookmark: pgfId-367694] 

 
      
       
        
        [bookmark: pgfId-363792]Table 66-16 [bookmark: 151017]OSPF Area Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-363798]Element
          
  
         		
           
           [bookmark: pgfId-363800]Description
          
  
        

 
         
         		[bookmark: pgfId-363806]Process ID

  
         		[bookmark: pgfId-363811]The process ID associated with the OSPF area. The list contains the OSPF processes defined in the OSPF Process Pageâ��Setup Tab.

  
        

 
         
         		[bookmark: pgfId-363817]Area ID

  
         		[bookmark: pgfId-363819]The area ID number associated with the selected process. Valid values range from 0 to 4294967295.

  
        

 
         
         		[bookmark: pgfId-363825]Networks

  
         		[bookmark: pgfId-363827]The networks to add to the OSPF area. Enter one or more network addresses or network/host objects, or click Select to select the object from a list or to create a new one.

  
        

 
         
         		[bookmark: pgfId-363833]Authentication

  
         		[bookmark: pgfId-363835]The type of authentication used for the area:

 
           
           		 [bookmark: pgfId-363837]MD5â��(Recommended) Uses the MD5 hash algorithm for authentication.

 
           		 [bookmark: pgfId-363839]Clear Textâ��Uses clear text for authentication.

 
           		 [bookmark: pgfId-363841]Noneâ��No authentication is used.

 
          

 [bookmark: pgfId-363843]Note The authentication type must be the same for all routers and access servers in an area.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-367708][bookmark: 151059][bookmark: rtpage_cncpt_OSPFProcessPageRedistributionTab]OSPF Process Pageâ��Redistribution Tab[bookmark: marker-367702][bookmark: marker-367704][bookmark: marker-367706]

 
     [bookmark: pgfId-367710]Use the OSPF Process Redistribution tab to create, edit, and delete OSPF redistribution mappings. This includes defining the maximum number of routes that can be redistributed into OSPF from other protocols or other OSPF processes.

 
     [bookmark: pgfId-367712]Navigation Path

 
     [bookmark: pgfId-367717]Go to the OSPF Process Policy Page, then click the Redistribution tab.

 
     [bookmark: pgfId-367719]Related Topics

 
      
      		 [bookmark: pgfId-367724]Redistributing Routes into OSPF

 
      		 [bookmark: pgfId-367729]OSPF Process Pageâ��Setup Tab

 
      		 [bookmark: pgfId-367734]OSPF Process Pageâ��Area Tab

 
      		 [bookmark: pgfId-367739]OSPF Interface Policy Page

 
      		 [bookmark: pgfId-367744]Table Columns and Column Heading Features

 
      		 [bookmark: pgfId-367749]Filtering Tables

 
     

 
     [bookmark: pgfId-367751]Field Reference

 
     [bookmark: pgfId-367754] 

 
      
       
        
        [bookmark: pgfId-363856]Table 66-17 [bookmark: 151103]OSPF Process Redistribution Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-363862]Element
          
  
         		
           
           [bookmark: pgfId-363864]Description
          
  
        

 
         
         		 [bookmark: pgfId-363870]OSPF Redistribution Mapping Table

  
        

 
         
         		[bookmark: pgfId-363878]OSPF Process ID

  
         		[bookmark: pgfId-363880]The ID of the OSPF routing domain into which other routes are being redistributed.

  
        

 
         
         		[bookmark: pgfId-363886]Protocol

  
         		[bookmark: pgfId-363888]The protocol that is being redistributed.

  
        

 
         
         		[bookmark: pgfId-363894]AS/Process ID

  
         		[bookmark: pgfId-363896]The AS number or process ID of the route that is being redistributed.

  
        

 
         
         		[bookmark: pgfId-363902]Match

  
         		[bookmark: pgfId-363904]When redistributing an OSPF process, indicates the types of OSPF routes that are being redistributed.

  
        

 
         
         		[bookmark: pgfId-363910]Metric

  
         		[bookmark: pgfId-363912]The value that determines the priority of the redistributed route.

  
        

 
         
         		[bookmark: pgfId-363918]Metric Type

  
         		[bookmark: pgfId-363920]The external link type associated with the default route advertised into the OSPF routing domain.

  
        

 
         
         		[bookmark: pgfId-363926]Subnets

  
         		[bookmark: pgfId-363928]Indicates whether routes that are subnetted are also being redistributed.

  
        

 
         
         		[bookmark: pgfId-363934]Add button

  
         		[bookmark: pgfId-363939]Opens the OSPF Redistribution Mapping Dialog Box. From here you can define OSPF redistribution mappings.

  
        

 
         
         		[bookmark: pgfId-363945]Edit button

  
         		[bookmark: pgfId-363950]Opens the OSPF Redistribution Mapping Dialog Box. From here you can edit the selected OSPF redistribution mapping.

  
        

 
         
         		[bookmark: pgfId-363956]Delete button

  
         		[bookmark: pgfId-363958]Deletes the selected redistribution mappings from the table.

  
        

 
         
         		 [bookmark: pgfId-363964]OSPF Max Prefix Mapping Table

  
        

 
         
         		[bookmark: pgfId-363972]OSPF Process ID

  
         		[bookmark: pgfId-363974]The ID of the OSPF routing domain for which a maximum prefix values has been defined.

  
        

 
         
         		[bookmark: pgfId-363980]Max Prefix

  
         		[bookmark: pgfId-363982]The maximum number of prefixes (routes) that may be redistributed to the selected OSPF process.

  
        

 
         
         		[bookmark: pgfId-363988]Threshold

  
         		[bookmark: pgfId-363990]The percentage of the maximum prefix value that acts as a threshold for triggering a warning message.

  
        

 
         
         		[bookmark: pgfId-363996]Action

  
         		[bookmark: pgfId-363998]Indicates whether redistribution to this OSPF process will stop when the maximum is reached, or whether only a warning is displayed.

  
        

 
         
         		[bookmark: pgfId-364004]Add button

  
         		[bookmark: pgfId-364009]Opens the OSPF Max Prefix Mapping Dialog Box. From here you can define maximum prefix values for OSPF processes.

  
        

 
         
         		[bookmark: pgfId-364015]Edit button

  
         		[bookmark: pgfId-364020]Opens the OSPF Max Prefix Mapping Dialog Box. From here you can edit the maximum prefix value defined for the selected OSPF process.

  
        

 
         
         		[bookmark: pgfId-364026]Delete button

  
         		[bookmark: pgfId-364028]Deletes the selected max prefix mappings from the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-367768][bookmark: 151210][bookmark: rtpage_cncpt_OSPFRedistributionMappingDialogBox]OSPF Redistribution Mapping Dialog Box[bookmark: marker-367762][bookmark: marker-367764][bookmark: marker-367766]

 
     [bookmark: pgfId-367770]Use the OSPF Redistribution Mapping dialog box to add or edit the properties of an OSPF redistribution mapping.

 
     [bookmark: pgfId-367772]Navigation Path

 
     [bookmark: pgfId-367777]Go to the OSPF Process Pageâ��Redistribution Tab, then click the Add or Edit button beneath the Redistribution Mapping table.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-367782]Note You must create at least one OSPF process before you can access the OSPF Redistribution dialog box. See OSPF Process Pageâ��Setup Tab.


     
      

     

     

 
     [bookmark: pgfId-367784]Related Topics

 
      
      		 [bookmark: pgfId-367789]OSPF Max Prefix Mapping Dialog Box

 
      		 [bookmark: pgfId-367794]Redistributing Routes into OSPF

 
     

 
     [bookmark: pgfId-367796]Field Reference

 
     [bookmark: pgfId-367799] 

 
      
       
        
        [bookmark: pgfId-364041]Table 66-18 [bookmark: 151245]OSPF Redistribution Mapping Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-364047]Element
          
  
         		
           
           [bookmark: pgfId-364049]Description
          
  
        

 
         
         		[bookmark: pgfId-364055]Process ID

  
         		[bookmark: pgfId-364060]The OSPF process into which other routes are being redistributed. You must select a process ID number from the list of OSPF processes defined in the OSPF Process Pageâ��Setup Tab.

  
        

 
         
         		[bookmark: pgfId-364066]Protocol to Redistribute

  
         		[bookmark: pgfId-364068]The routing protocol that is being redistributed:

 
           
           		 [bookmark: pgfId-364070]Staticâ��Redistributes static routes. You can define a single mapping for each route.

 
           		 [bookmark: pgfId-364072]EIGRPâ��Redistributes an EIGRP autonomous system. Enter the AS number in the displayed field. You can define a single mapping for each AS.

 
           		 [bookmark: pgfId-364077]BGPâ��Redistributes a BGP autonomous system. You can define a single BGP mapping on each device. If you configured a BGP AS in the BGP Setup tab, the AS number is displayed. Otherwise, a message is displayed indicating that no BGP AS was defined. See BGP Pageâ��Redistribution Tab.

 
          

  
        

 
         
         		[bookmark: pgfId-364083]Protocol to Redistribute (continued)

  
         		
           
           		 [bookmark: pgfId-364085]OSPFâ��Redistributes a different OSPF process. You can define a single mapping for each process. Select a process from the displayed list, then select one or more match criteria:

 
          

 [bookmark: pgfId-364087] â�� Internalâ��Routes that are internal to a specific AS.

 [bookmark: pgfId-364089] â�� External1â��Routes that are external to the AS and imported into OSPF as a Type 1 external route.

 [bookmark: pgfId-364091] â�� External2â��Routes that are external to the AS and imported into the selected process as a Type 2 external route.

 [bookmark: pgfId-364093] â�� NSAAExternal1â��Not-So-Stubby Area (NSSA) routes that are external to the AS and imported into the selected process as Type 1 external routes.

 [bookmark: pgfId-364095] â�� NSAAExternal2â��(NSSA) routes that are external to the AS and imported into the selected process as Type 2 external routes.

 
           
           		 [bookmark: pgfId-364097]RIPâ��Redistributes RIP routes. You can define a single mapping for each route.

 
           		 [bookmark: pgfId-364099]Connectedâ��Redistributes routes that are established automatically by virtue of having enabled IP on an interface. These routes are redistributed as external to the AS.

 
          

  
        

 
         
         		[bookmark: pgfId-364105]Default Metric

  
         		[bookmark: pgfId-364107]A value representing the cost of the redistributed route.

  
        

 
         
         		[bookmark: pgfId-364113]Metric Type

  
         		[bookmark: pgfId-364115]The external link type that is associated with the route being redistributed into the OSPF routing domain:

 
           
           		 [bookmark: pgfId-364117]1â��Type 1 external route. The metric is the sum of the external redistributed cost and the internal OSPF cost.

 
           		 [bookmark: pgfId-364119]2â��Type 2 external route. The metric is equal to the external redistributed cost, as defined in the Metric field. This is the default.

 
          

  
        

 
         
         		[bookmark: pgfId-364125]Limit to Subnets

  
         		[bookmark: pgfId-364127]When selected, only subnetted routes are redistributed.

 [bookmark: pgfId-364129]When deselected, subnetted routes are not redistributed.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-367813][bookmark: 151318][bookmark: rtpage_cncpt_OSPFMaxPrefixMappingDialogBox]OSPF Max Prefix Mapping Dialog Box[bookmark: marker-367807][bookmark: marker-367809][bookmark: marker-367811]

 
     [bookmark: pgfId-367815]Use the OSPF Max Prefix Mapping dialog box to add or edit the maximum number of routes that can be redistributed into an OSPF process.

 
     [bookmark: pgfId-367817]Navigation Path

 
     [bookmark: pgfId-367822]Go to the OSPF Process Pageâ��Redistribution Tab, then click the Add or Edit button beneath the Prefix Mapping table.

 
     [bookmark: pgfId-367824]Related Topics

 
      
      		 [bookmark: pgfId-367829]OSPF Redistribution Mapping Dialog Box

 
      		 [bookmark: pgfId-367834]Redistributing Routes into OSPF

 
     

 
     [bookmark: pgfId-367836]Field Reference

 
     [bookmark: pgfId-367839] 

 
      
       
        
        [bookmark: pgfId-364142]Table 66-19 [bookmark: 151351]OSPF Max Prefix Mapping Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-364148]Element
          
  
         		
           
           [bookmark: pgfId-364150]Description
          
  
        

 
         
         		[bookmark: pgfId-364156]Process ID

  
         		[bookmark: pgfId-364161]The OSPF process into which other routes are being redistributed. The list contains the OSPF processes defined in the OSPF Process Pageâ��Setup Tab.

  
        

 
         
         		[bookmark: pgfId-364167]Max Prefix

  
         		[bookmark: pgfId-364169]The maximum number of prefixes (routes) that can be redistributed into the selected OSPF process. Limiting the number of redistributed routes helps prevent the router from being flooded by an excessive number of routes.

  
        

 
         
         		[bookmark: pgfId-364175]Threshold

  
         		[bookmark: pgfId-364177]The percentage of the maximum prefix value that acts as a threshold for triggering warning messages. The default is 75%.

 [bookmark: pgfId-364179]Note This warning is triggered whether or not the Warning-Only check box is selected.

  
        

 
         
         		[bookmark: pgfId-364185]When maximum routes reached

  
         		[bookmark: pgfId-364187]The action to take when the maximum number of redistributed routes is reached:

 
           
           		 [bookmark: pgfId-364189]Enforce Maximum Routeâ��Prevents additional routes from being redistributed when the defined maximum prefix value is reached. This is the default.

 
           		 [bookmark: pgfId-364191]Warning Onlyâ��Issues a warning when the maximum number of routes is reached, but does not prevent additional routes from being redistributed.

 
          

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-367851][bookmark: 151391][bookmark: rtchap_cncpt_RIPRoutingonCiscoIOSRouters]RIP Routing on Cisco IOS Routers[bookmark: marker-367845][bookmark: marker-367847][bookmark: marker-367849]

 
    [bookmark: pgfId-367853]Routing Information Protocol (RIP) is an Interior Gateway Protocol (IGP) that was created for use in small, homogeneous networks. RIP is a distance-vector protocol that sends routing-update messages at regular intervals (in a process called advertising) and whenever the network topology changes. When a router receives a routing update that includes changes to an entry, it updates its routing table to reflect the new route. If a router does not receive an update from another router for 180 seconds or more, it marks the routes served by the non-updating router as being unusable. If there is still no update after 240 seconds, the router removes all routing table entries for the non-updating router. Routing information is exchanged using UDP packets.

 
    [bookmark: pgfId-367855]RIP evaluates routes by measuring the number of hops (the number of routers traversed) from the source to the destination. A directly connected network has a metric of zero. The maximum hop count allowed by RIP is 15. Any route with a hop count greater than 15 is considered unreachable.

 
    [bookmark: pgfId-367857]Security Manager supports RIP version 2 only, which is described in RFC 1723. RIP 2 improves on the original RIP by enabling RIP messages to carry more information, which permits the use of a simple authentication mechanism (clear text or MD5) to secure table updates. RIP 2 also supports subnet masks, a critical feature that was not available in the original version of RIP.

 
    [bookmark: pgfId-367859]The following topics describe the tasks you perform to create a RIP routing policy:

 
     
     		 [bookmark: pgfId-367864]Defining RIP Setup Parameters

 
     		 [bookmark: pgfId-367869]Defining RIP Interface Authentication Settings

 
     		 [bookmark: pgfId-367874]Redistributing Routes into RIP

 
    

 
    [bookmark: pgfId-367876]Related Topics

 
     
     		 [bookmark: pgfId-367881]Static Routing on Cisco IOS Routers

 
     		 [bookmark: pgfId-367886]OSPF Routing on Cisco IOS Routers

 
     		 [bookmark: pgfId-367891]EIGRP Routing on Cisco IOS Routers

 
     		 [bookmark: pgfId-367896]BGP Routing on Cisco IOS Routers

 
    

 
     
      [bookmark: pgfId-367904][bookmark: 151434][bookmark: rtchap_proc_DefiningRIPSetupParameters]Defining RIP Setup Parameters[bookmark: marker-367902]

 
     [bookmark: pgfId-367906]You configure RIP setup parameters by selecting the networks to include in the route and deciding whether any interfaces should be passive. These interfaces do not send routing updates to their neighbors. Additionally, you can enable auto-summarization, which reduces the size and complexity of the routing tables the router must maintain.

 
     [bookmark: pgfId-367908]Related Topics

 
      
      		 [bookmark: pgfId-367913]Defining RIP Interface Authentication Settings

 
      		 [bookmark: pgfId-367918]Redistributing Routes into RIP

 
      		 [bookmark: pgfId-367923]RIP Routing on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-367925]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-367927](Device view) Select  Platform > Routing > RIP from the Policy selector, then click the  Setup tab in the work area.

 
      		 [bookmark: pgfId-367929](Policy view) Select  Router Platform > Routing > RIP from the Policy Type selector. Select an existing policy or create a new one, and then click the  Setup tab.

 
     

 
     [bookmark: pgfId-367934]The RIP Setup tab is displayed (see RIP Pageâ��Setup Tab).

 
     [bookmark: pgfId-367939]Step 2 Enter the addresses of the directly connected networks whose interfaces are to receive RIP updates. You can use a combination of addresses and network/host objects; separate addresses with commas. Click Select to select network/host objects from a list of existing objects, or to create new network/host objects. For more information, see Specifying IP Addresses During Policy Definition.

 
     [bookmark: pgfId-367944]Step 3 Enter the addresses of the passive interfaces, which are interfaces that should not send routing updates to their neighbors, if any. These interfaces continue to receive RIP routing broadcasts, which they use to populate their routing tables. Enter the names of one or more interfaces or interface roles; separate addresses with commas. Click Select to select interface names or roles from a list of existing objects, or to create new interface role objects. For more information, see Specifying Interfaces During Policy Definition.

 
     [bookmark: pgfId-367946]Step 4 (Optional) Select the Auto Summary check box to enable the automatic summarization of subnet routes into network-level routes. Summarization reduces the size of routing tables, thereby reducing the complexity of the network.

 
     [bookmark: pgfId-367948]Disable automatic summarization when you perform routing between disconnected subnets. When automatic summarization is turned off, subnets are advertised.

 
     [bookmark: pgfId-367950]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-367958][bookmark: 151482][bookmark: rtchap_proc_DefiningRIPInterfaceAuthenticationSettings]Defining RIP Interface Authentication Settings[bookmark: marker-367956]

 
     [bookmark: pgfId-367960]You define neighbor authentication settings for RIP interfaces by selecting the interfaces and then selecting an authentication type, either MD5 or clear text.

 
     [bookmark: pgfId-367962]Related Topics

 
      
      		 [bookmark: pgfId-367967]Defining RIP Setup Parameters

 
      		 [bookmark: pgfId-367972]Redistributing Routes into RIP

 
      		 [bookmark: pgfId-367977]RIP Routing on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-367979]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-367981](Device view) Select  Platform > Routing > RIP from the Policy selector, then click the  Authentication tab in the work area.

 
      		 [bookmark: pgfId-367983](Policy view) Select  Router Platform > Routing > RIP from the Policy Type selector. Select an existing policy or create a new one, and then click the  Authentication tab.

 
     

 
     [bookmark: pgfId-367988]The RIP Authentication tab is displayed. See Table 66-21 for a description of the fields on this tab.

 
     [bookmark: pgfId-367993]Step 2 On the RIP Authentication tab, select an interface definition from the table, then click Edit, or click Add to create a definition. The RIP Authentication dialog box appears. See Table 66-22 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-367998]Step 3 Enter the name of the interface or interface role for which authentication is defined, or click Select to select an interface role from a list or to create a new one. For more information, see Specifying Interfaces During Policy Definition.

 
     [bookmark: pgfId-368000]Step 4 Define interface authentication (MD5 or clear text).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-368002]Note We do not recommend that you use clear text authentication in RIP packets, because the unencrypted authentication key is sent in every packet. Use plain text authentication only when security is not an issue, for example, to ensure that misconfigured hosts do not participate in routing.


     
      

     

     

 
     [bookmark: pgfId-368004]Step 5 Click OK to save your definitions locally on the client and close the dialog box. The defined interface appears on the RIP Authentication tab.

 
     [bookmark: pgfId-368006]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-368016][bookmark: 151533][bookmark: rtchap_proc_RedistributingRoutesintoRIP]Redistributing Routes into RIP[bookmark: marker-368012][bookmark: marker-368014]

 
     [bookmark: pgfId-368018]Redistribution refers to using a routing protocol, such as RIP, to advertise routes that are learned by some other means, such as a different routing protocol, static routes, or directly connected routes. For example, you can redistribute routes from the OSPF routing protocol into your RIP route. Redistribution is necessary in networks that operate in multiple-protocol environments and can be applied to all IP-based routing protocols.

 
     [bookmark: pgfId-368020]When you redistribute into RIP, you can maintain the original metric of the route by redistributing it transparently.

 
     [bookmark: pgfId-368022]Before You Begin

 
      
      		 [bookmark: pgfId-368027]Define at least one RIP route. See Defining RIP Setup Parameters.

 
     

 
     [bookmark: pgfId-368029]Related Topics

 
      
      		 [bookmark: pgfId-368034]Defining RIP Setup Parameters

 
      		 [bookmark: pgfId-368039]Defining RIP Interface Authentication Settings

 
      		 [bookmark: pgfId-368044]RIP Routing on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-368046]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-368048](Device view) Select  Platform > Routing > RIP from the Policy selector, then click the  Redistribution tab in the work area.

 
      		 [bookmark: pgfId-368050](Policy view) Select  Router Platform > Routing > RIP from the Policy Type selector. Select an existing policy or create a new one, and then click the  Redistribution tab.

 
     

 
     [bookmark: pgfId-368055]The RIP Redistribution tab is displayed. See Table 66-23 for a description of the fields on this tab.

 
     [bookmark: pgfId-368060]Step 2 On the RIP Redistribution tab, select a row from the RIP Redistribution Mappings table, then click Edit, or click Add to create a mapping. The RIP Redistribution Mapping dialog box appears. See Table 66-24 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-368062]Step 3 Select the protocol whose routes you want to redistribute into RIP.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-368064]Note You can create a single mapping for each static route, BGP AS, EIGRP AS, and OSPF process.


     
      

     

     

 
     [bookmark: pgfId-368066]Step 4 Define the metric (cost) of the redistributed routes by doing one of the following:

 
      
      		 [bookmark: pgfId-368068]Select the  Default Metric check box, then enter the default metric of the redistributed routes. The metric determines the priority of the routes.

 
      		 [bookmark: pgfId-368070]Select the  Transparent check box to maintain the original metric of the routes being redistributed into RIP.

 
     

 
     [bookmark: pgfId-368072]Step 5 Click OK to save your definitions locally on the client and close the dialog box. The redistribution mapping appears in the Redistribution Mapping table on the RIP Redistribution tab.

 
     [bookmark: pgfId-368074]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-368086][bookmark: 151600][bookmark: rtpage_cncpt_RIPRoutingPolicyPage]RIP Routing Policy Page[bookmark: marker-368082][bookmark: marker-368084]

 
    [bookmark: pgfId-368088]RIP is a distance-vector routing protocol that uses hop count as the metric for path selection. Security Manager supports RIP version 2 only, which includes support for neighbor authentication when routing updates are exchanged.

 
    [bookmark: pgfId-368090]You can configure RIP routing policies from the following tabs on the RIP Routing page:

 
     
     		 [bookmark: pgfId-368095]RIP Pageâ��Setup Tab

 
     		 [bookmark: pgfId-368100]RIP Pageâ��Authentication Tab

 
     		 [bookmark: pgfId-368105]RIP Pageâ��Redistribution Tab

 
    

 
    [bookmark: pgfId-368110]For more information, see RIP Routing on Cisco IOS Routers.

 
    [bookmark: pgfId-368112]Navigation Path

 
     
     		 [bookmark: pgfId-368114](Device view) Select  Platform > Routing > RIP from the Policy selector.

 
     		 [bookmark: pgfId-368116](Policy view) Select  Router Platform > Routing > RIP from the Policy Type selector. Right-click  RIP to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
     
      [bookmark: pgfId-368128][bookmark: 151635][bookmark: rtpage_cncpt_RIPPageSetupTab]RIP Pageâ��Setup Tab[bookmark: marker-368124][bookmark: marker-368126]

 
     [bookmark: pgfId-368130]Use the RIP Setup tab to create, edit, and delete RIP routes.

 
     [bookmark: pgfId-368132]Navigation Path

 
     [bookmark: pgfId-368137]Go to the RIP Routing Policy Page, then click the Setup tab.

 
     [bookmark: pgfId-368139]Related Topics

 
      
      		 [bookmark: pgfId-368144]Defining RIP Setup Parameters

 
      		 [bookmark: pgfId-368149]RIP Pageâ��Authentication Tab

 
      		 [bookmark: pgfId-368154]RIP Pageâ��Redistribution Tab

 
      		 [bookmark: pgfId-368159]Specifying IP Addresses During Policy Definition

 
      		 [bookmark: pgfId-368164]Understanding Networks/Hosts Objects

 
     

 
     [bookmark: pgfId-368166]Field Reference

 
     [bookmark: pgfId-368169] 

 
      
       
        
        [bookmark: pgfId-364204]Table 66-20 [bookmark: 151673]RIP Setup Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-364210]Element
          
  
         		
           
           [bookmark: pgfId-364212]Description
          
  
        

 
         
         		[bookmark: pgfId-364218]Networks

  
         		[bookmark: pgfId-364220]The directly connected networks associated with the RIP route. Enter one or more network addresses or network/host objects, separated by commas. Click Select to select network/host objects from a list of existing objects, or to create new objects.

  
        

 
         
         		[bookmark: pgfId-364226]Passive Interfaces

  
         		[bookmark: pgfId-364228]The interfaces that do not send updates to their routing neighbors. Enter one or more interface names or roles, separated by commas. Click Select to select interface names or roles from a list of existing objects, or to create new interface role objects.

  
        

 
         
         		[bookmark: pgfId-364234]Auto-Summary

  
         		[bookmark: pgfId-364236]When selected, enables the automatic summarization of subnet routes into network-level routes. Summarization reduces the size of routing tables, thereby reducing the complexity of the network.

 [bookmark: pgfId-364238]When deselected, automatic summarization is disabled.

 [bookmark: pgfId-364240]Note Disable automatic summarization when performing routing between disconnected subnets. When this feature is disabled, subnets are advertised.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-368181][bookmark: 151703][bookmark: rtpage_cncpt_RIPPageAuthenticationTab]RIP Pageâ��Authentication Tab[bookmark: marker-368177][bookmark: marker-368179]

 
     [bookmark: pgfId-368183]Use the RIP Authentication tab to view, create, edit, and delete the neighbor authentication settings of RIP interfaces.

 
     [bookmark: pgfId-368185]Navigation Path

 
     [bookmark: pgfId-368190]Go to the RIP Routing Policy Page, then click the Authentication tab.

 
     [bookmark: pgfId-368192]Related Topics

 
      
      		 [bookmark: pgfId-368197]Defining RIP Interface Authentication Settings

 
      		 [bookmark: pgfId-368202]RIP Pageâ��Setup Tab

 
      		 [bookmark: pgfId-368207]RIP Pageâ��Redistribution Tab

 
      		 [bookmark: pgfId-368212]RIP Routing Policy Page

 
      		 [bookmark: pgfId-368217]Table Columns and Column Heading Features

 
      		 [bookmark: pgfId-368222]Filtering Tables

 
     

 
     [bookmark: pgfId-368224]Field Reference

 
     [bookmark: pgfId-368227] 

 
      
       
        
        [bookmark: pgfId-364253]Table 66-21 [bookmark: 151744]RIP Authentication Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-364259]Element
          
  
         		
           
           [bookmark: pgfId-364261]Description
          
  
        

 
         
         		[bookmark: pgfId-364267]Interfaces

  
         		[bookmark: pgfId-364269]The name of an interface (as defined by an interface role) on which RIP is enabled.

  
        

 
         
         		[bookmark: pgfId-364275]Authentication

  
         		[bookmark: pgfId-364277]The type of RIP neighbor authentication that is enabled for the selected interface roleâ��clear text or MD5.

  
        

 
         
         		[bookmark: pgfId-364283]Key ID

  
         		[bookmark: pgfId-364285]The identification number of the authentication key used for MD5 authentication.

  
        

 
         
         		[bookmark: pgfId-364291]Add button

  
         		[bookmark: pgfId-364296]Opens the RIP Authentication Dialog Box. From here you can define authentication for an additional RIP interface.

  
        

 
         
         		[bookmark: pgfId-364302]Edit button

  
         		[bookmark: pgfId-364307]Opens the RIP Authentication Dialog Box. From here you can edit the authentication properties of the selected RIP interface.

  
        

 
         
         		[bookmark: pgfId-364313]Delete button

  
         		[bookmark: pgfId-364315]Deletes the selected authentication definitions from the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-368239][bookmark: 151786][bookmark: rtpage_cncpt_RIPAuthenticationDialogBox]RIP Authentication Dialog Box[bookmark: marker-368235][bookmark: marker-368237]

 
     [bookmark: pgfId-368241]Use the RIP Authentication dialog box to add or edit the neighbor authentication properties of RIP interfaces.

 
     [bookmark: pgfId-368243]Navigation Path

 
     [bookmark: pgfId-368248]Go to the RIP Pageâ��Authentication Tab, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-368250]Related Topics

 
      
      		 [bookmark: pgfId-368255]Defining RIP Interface Authentication Settings

 
     

 
     [bookmark: pgfId-368257]Field Reference

 
     [bookmark: pgfId-368260] 

 
      
       
        
        [bookmark: pgfId-364328]Table 66-22 [bookmark: 151813]RIP Authentication Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-364334]Element
          
  
         		
           
           [bookmark: pgfId-364336]Description
          
  
        

 
         
         		[bookmark: pgfId-364342]Interface

  
         		[bookmark: pgfId-364344]The interface for which you want to define authentication properties. Enter the name of an interface or interface role, or click Select to select the object from a list or to create a new one.

 [bookmark: pgfId-364346]Note You cannot specify two different authentication configurations for the same interface.

  
        

 
         
         		[bookmark: pgfId-364352]Authentication

  
         		[bookmark: pgfId-364354]The type of authentication to apply to the interface:

 
           
           		 [bookmark: pgfId-364356]MD5â��(Recommended) Uses the MD5 hash algorithm for authentication.

 
           		 [bookmark: pgfId-364358]Clear Textâ��Uses clear text for authentication.

 
          

 [bookmark: pgfId-364360]Note Use plain text authentication only when security is not an issue, for example, to ensure that misconfigured hosts do not participate in routing.

  
        

 
         
         		[bookmark: pgfId-364366]Key ID

  
         		[bookmark: pgfId-364368]Available only when MD5 is selected as the authentication type.

 [bookmark: pgfId-364370]The identification number of the authentication key. This number must be shared with all other devices sending updates to, and receiving updates from, the selected device. Valid values range from 0 to 2147483647.

  
        

 
         
         		[bookmark: pgfId-364376]Key

  
         		[bookmark: pgfId-364378]The shared key used for authentication (MD5 or clear text). This key must be shared with all other devices sending updates to, and receiving updates from, the selected device.

 [bookmark: pgfId-364380]The key can contain up to 80 alphanumeric characters; the first character cannot be a number. Spaces are allowed. Enter the key again in the Confirm field.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-368274][bookmark: 151855][bookmark: rtpage_cncpt_RIPPageRedistributionTab]RIP Pageâ��Redistribution Tab[bookmark: marker-368268][bookmark: marker-368270][bookmark: marker-368272]

 
     [bookmark: pgfId-368276]Use the RIP Redistribution tab to view, create, edit, and delete redistribution settings when performing redistribution into an RIP routing domain.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-368281]Note You must define RIP setup parameters before you can access the RIP Redistribution tab. See RIP Pageâ��Setup Tab.


     
      

     

     

 
     [bookmark: pgfId-368283]Navigation Path

 
     [bookmark: pgfId-368288]Go to the RIP Routing Policy Page, then click the Redistribution tab.

 
     [bookmark: pgfId-368290]Related Topics

 
      
      		 [bookmark: pgfId-368295]Redistributing Routes into RIP

 
      		 [bookmark: pgfId-368300]RIP Pageâ��Authentication Tab

 
      		 [bookmark: pgfId-368305]Filtering Tables

 
     

 
     [bookmark: pgfId-368307]Field Reference

 
     [bookmark: pgfId-368310] 

 
      
       
        
        [bookmark: pgfId-364393]Table 66-23 [bookmark: 151892]RIP Redistribution Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-364399]Element
          
  
         		
           
           [bookmark: pgfId-364401]Description
          
  
        

 
         
         		[bookmark: pgfId-364407]Protocol

  
         		[bookmark: pgfId-364409]The protocol that is being redistributed.

  
        

 
         
         		[bookmark: pgfId-364415]AS/Process ID

  
         		[bookmark: pgfId-364417]The autonomous system (AS) number or process ID of the route being redistributed.

  
        

 
         
         		[bookmark: pgfId-364423]Metric

  
         		[bookmark: pgfId-364425]The value that determines the priority of the redistributed route.

  
        

 
         
         		[bookmark: pgfId-364431]Match

  
         		[bookmark: pgfId-364433]When redistributing an OSPF process, indicates which types of OSPF routes are being redistributed.

  
        

 
         
         		[bookmark: pgfId-364439]Add button

  
         		[bookmark: pgfId-364444]Opens the RIP Redistribution Mapping Dialog Box. From here you can define a RIP redistribution mapping.

  
        

 
         
         		[bookmark: pgfId-364450]Edit button

  
         		[bookmark: pgfId-364455]Opens the RIP Redistribution Mapping Dialog Box. From here you can edit the selected RIP redistribution mapping.

  
        

 
         
         		[bookmark: pgfId-364461]Delete button

  
         		[bookmark: pgfId-364463]Deletes the selected redistribution mappings from the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-368324][bookmark: 151939][bookmark: rtpage_cncpt_RIPRedistributionMappingDialogBox]RIP Redistribution Mapping Dialog Box[bookmark: marker-368318][bookmark: marker-368320][bookmark: marker-368322]

 
     [bookmark: pgfId-368326]Use the RIP Redistribution Mapping dialog box to add or edit the properties of an RIP redistribution mapping.

 
     [bookmark: pgfId-368328]Navigation Path

 
     [bookmark: pgfId-368333]Go to the RIP Pageâ��Redistribution Tab, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-368335]Related Topics

 
      
      		 [bookmark: pgfId-368340]Redistributing Routes into RIP

 
     

 
     [bookmark: pgfId-368342]Field Reference

 
     [bookmark: pgfId-368345] 

 
      
       
        
        [bookmark: pgfId-364476]Table 66-24 [bookmark: 151969]RIP Redistribution Mapping Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-364482]Element
          
  
         		
           
           [bookmark: pgfId-364484]Description
          
  
        

 
         
         		[bookmark: pgfId-364490]Protocol to Redistribute

  
         		[bookmark: pgfId-364492]The routing protocol that is being redistributed:

 
           
           		 [bookmark: pgfId-364494]Staticâ��Redistributes static routes. You can define a single mapping for each route.

 
           		 [bookmark: pgfId-364496]EIGRPâ��Redistributes an EIGRP autonomous system. Enter the AS number in the displayed field. You can define a single mapping for each AS.

 
           		 [bookmark: pgfId-364501]BGPâ��Redistributes a BGP autonomous system. You can define a single BGP mapping on each device. If you configured a BGP AS in the BGP Setup tab, the AS number is displayed. Otherwise, a message is displayed indicating that no BGP AS was defined. See BGP Pageâ��Redistribution Tab.

 
          

  
        

 
         
         		[bookmark: pgfId-364507]Protocol to Redistribute (continued)

  
         		
           
           		 [bookmark: pgfId-364509]OSPFâ��Redistributes a different OSPF process. You can define a single mapping for each process. Select a process from the displayed list, then select one or more match criteria:

 
          

 [bookmark: pgfId-364511] â�� Internalâ��Routes that are internal to a specific AS.

 [bookmark: pgfId-364513] â�� External1â��Routes that are external to the AS and imported into OSPF as a Type 1 external route.

 [bookmark: pgfId-364515] â�� External2â��Routes that are external to the AS and imported into the selected process as a Type 2 external route.

 [bookmark: pgfId-364517] â�� NSAAExternal1â��Not-So-Stubby Area (NSSA) routes that are external to the AS and imported into the selected process as Type 1 external routes.

 [bookmark: pgfId-364519] â�� NSAAExternal2â��(NSSA) routes that are external to the AS and imported into the selected process as Type 2 external routes.

 
           
           		 [bookmark: pgfId-364521]Connectedâ��Redistributes routes that are established automatically by virtue of having enabled IP on an interface. These routes are redistributed as external to the AS.

 
          

  
        

 
         
         		[bookmark: pgfId-364527]Default Metric

  
         		[bookmark: pgfId-364529]Establishes a default value for the redistributed route. Valid values range from 0 to 16.

  
        

 
         
         		[bookmark: pgfId-364535]Transparent Metric

  
         		[bookmark: pgfId-364537]When selected, maintains the original metric of the route being redistributed. When deselected, the value specified in the Metric field is used.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-368357][bookmark: 152025][bookmark: rtchap_cncpt_StaticRoutingonCiscoIOSRouters]Static Routing on Cisco IOS Routers[bookmark: marker-368351][bookmark: marker-368353][bookmark: marker-368355]

 
    [bookmark: pgfId-368359]You can configure static routing policies to ensure that the router correctly forwards packets to their destination when a route cannot be built dynamically. By default, static routes have a default administrative distance of 1 (implying a directly connected network), which causes them to override any dynamic routes discovered for the same host or network. You can, however, define a larger administrative distance to a static route so that it does not take precedence over a corresponding dynamic route.

 
    [bookmark: pgfId-368361]For example, EIGRP routes have a default administrative distance of 5. To have a static route that can be overridden by an EIGRP route, you must specify an administrative distance greater than 5. This feature is useful when you define the static route as a â��floatingâ�� route, which is inserted into the routing table only when the preferred route is unavailable.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-368365]Tip When you use the static route as a backup, â��floatingâ�� route, specify the interface through which the next hop IP address can be reached instead of entering a specific IP address. Otherwise, the â��floatingâ�� route is not inserted in the routing table if the primary link fails. For more information, see Specifying a Next Hop IP Address for Static Routes on Cisco.com at this URL: http://www.cisco.com/en/US/tech/tk365/technologies_tech_note09186a00800ef7b2.shtml


    
     

    

    

 
    [bookmark: pgfId-368367]Related Topics

 
     
     		 [bookmark: pgfId-368372]Defining Static Routes

 
    

 
     
      [bookmark: pgfId-368380][bookmark: 152049][bookmark: rtchap_proc_DefiningStaticRoutes]Defining Static Routes[bookmark: marker-368378]

 
     [bookmark: pgfId-368382]To define a static route, you must define the IP address (and optionally, the metric) of the hop gateway to which the router forwards packets destined to the selected host or network. You can define as many static routes as required.

 
     [bookmark: pgfId-368384]Related Topics

 
      
      		 [bookmark: pgfId-368389]Static Routing on Cisco IOS Routers

 
      		 [bookmark: pgfId-368394]RIP Routing on Cisco IOS Routers

 
      		 [bookmark: pgfId-368399]OSPF Routing on Cisco IOS Routers

 
      		 [bookmark: pgfId-368404]EIGRP Routing on Cisco IOS Routers

 
      		 [bookmark: pgfId-368409]BGP Routing on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-368411]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-368413](Device view) Select  Platform > Routing > Static Routing from the Policy selector.

 
      		 [bookmark: pgfId-368415](Policy view) Select  Router Platform > Routing > Static Routing from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-368420]The Static Routing page is displayed. See Table 66-25 for a description of the fields on this page.

 
     [bookmark: pgfId-368425]Step 2 On the Static Routing page, select a static route from the table, then click Edit, or click Add to create a route. The Static Routing dialog box appears. See Table 66-26 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-368427]Step 3 (Optional) Select the Use as Default Route check box to make this route the default route for all unknown outbound packets.

 
     [bookmark: pgfId-368432]Step 4 In the Prefix field, enter the address for the destination network, or click Select to select a network/host object from a list or to create a new one. For more information, see Specifying IP Addresses During Policy Definition.

 
     [bookmark: pgfId-368434]Step 5 Select a forwarding option:

 
      
      		 [bookmark: pgfId-368442]To define the router interface that forwards packets to the remote network, select  Forwarding Interface and enter the name of an interface or interface role. You can click Select to select an interface role from a list or to create a new one. See Understanding Interface Role Objects and Selecting Objects for Policies.

 
      		 [bookmark: pgfId-368447]To specify the next hop router that receives and forwards packets to the remote network, select  Forwarding IP , then enter the address in the field provided, or click  Select to select a network/host object from a list or to create a new one. For more information, see Specifying IP Addresses During Policy Definition.

 
     

 
     [bookmark: pgfId-368449]Step 6 (Optional) In the Distance Metric field, enter the number of hops to the next hop address for this router. This metric identifies the priority of the static route. If two routing entries specify the same network, the route with the lower metric value (that is, the lower cost) is given a higher priority and is selected.

 
     [bookmark: pgfId-368451]If no value is specified, the default is 1, which implies a directly connected network.

 
     [bookmark: pgfId-368453]Step 7 (Optional) Select the Permanent route check box to prevent this static route entry from being deleted, even in cases in which the interface is shut down or the router cannot communicate with the next router.

 
     [bookmark: pgfId-368455]Step 8 Click OK to save your definitions locally on the client and close the dialog box. The static route appears in the table on the Static Routing page.

 
     [bookmark: pgfId-368457]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-368469][bookmark: 152124][bookmark: rtpage_cncpt_StaticRoutingPolicyPage]Static Routing Policy Page[bookmark: marker-368465][bookmark: marker-368467]

 
    [bookmark: pgfId-368474]Use the Static Routing page to create, edit, and delete static routes. For more information, see Defining Static Routes.

 
    [bookmark: pgfId-368476]Navigation Path

 
     
     		 [bookmark: pgfId-368478](Device view) Select  Platform > Routing > Static Routing from the Policy selector.

 
     		 [bookmark: pgfId-368480](Policy view) Select  Router Platform > Routing > Static Routing from the Policy Type selector. Right-click  Static Routing to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-368482]Related Topics

 
     
     		 [bookmark: pgfId-368487]Static Routing on Cisco IOS Routers

 
     		 [bookmark: pgfId-368492]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-368497]Filtering Tables

 
    

 
    [bookmark: pgfId-368499]Field Reference

 
    [bookmark: pgfId-368502] 

 
     
      
       
       [bookmark: pgfId-364550]Table 66-25 [bookmark: 152162]Static Routing Page 

 
       
      
        
        		
          
          [bookmark: pgfId-364556]Element
         
  
        		
          
          [bookmark: pgfId-364558]Description
         
  
       

 
        
        		[bookmark: pgfId-364564]Prefix

  
        		[bookmark: pgfId-364566]The destination IP address of the static route.

  
       

 
        
        		[bookmark: pgfId-364572]Prefix Mask

  
        		[bookmark: pgfId-364574]The net mask of the selected IP address.

  
       

 
        
        		[bookmark: pgfId-364580]Default Route

  
        		[bookmark: pgfId-364582]Indicates whether the static route is the default route for unknown packets being forwarded by this router.

  
       

 
        
        		[bookmark: pgfId-364588]Interface or IP Address

  
        		[bookmark: pgfId-364590]The IP address or the interface name associated with the gateway router that is the next hop address for this router.

  
       

 
        
        		[bookmark: pgfId-364596]Distance

  
        		[bookmark: pgfId-364598]The number of hops from the gateway IP to the destination. The metric determines the priority of this route. The fewer the hops, the higher the priority assigned to the route, based on lower costs.

 [bookmark: pgfId-364600]When two routing entries specify the same network, the entry with the lower metric (that is, the higher priority) is selected.

  
       

 
        
        		[bookmark: pgfId-364606]Permanent Route

  
        		[bookmark: pgfId-364608]Indicates whether the static route is defined as a permanent route, which means that it will not be removed even if the interface is shut down or if the router is unable to communicate with the next router.

  
       

 
        
        		[bookmark: pgfId-364614]Add button

  
        		[bookmark: pgfId-364619]Opens the Static Routing Dialog Box. From here you can create a static route.

  
       

 
        
        		[bookmark: pgfId-364625]Edit button

  
        		[bookmark: pgfId-364630]Opens the Static Routing Dialog Box. From here you can edit the selected static route.

  
       

 
        
        		[bookmark: pgfId-364636]Delete button

  
        		[bookmark: pgfId-364638]Deletes the selected static routes from the table.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-368514][bookmark: 152220][bookmark: rtpage_cncpt_StaticRoutingDialogBox]Static Routing Dialog Box[bookmark: marker-368510][bookmark: marker-368512]

 
     [bookmark: pgfId-368516]Use the Static Routing dialog box to add or edit static routes.

 
     [bookmark: pgfId-368518]Navigation Path

 
     [bookmark: pgfId-368523]Go to the Static Routing Policy Page, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-368525]Related Topics

 
      
      		 [bookmark: pgfId-368530]Defining Static Routes

 
      		 [bookmark: pgfId-368535]Static Routing on Cisco IOS Routers

 
     

 
     [bookmark: pgfId-368537]Field Reference

 
     [bookmark: pgfId-368540] 

 
      
       
        
        [bookmark: pgfId-364651]Table 66-26 [bookmark: 152250]Static Routing Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-364657]Element
          
  
         		
           
           [bookmark: pgfId-364659]Description
          
  
        

 
         
         		[bookmark: pgfId-364665]Destination Network

  
         		[bookmark: pgfId-364667]Address information for the destination network defined by this static route.

 
           
           		 [bookmark: pgfId-364669]Use as Default Routeâ��When selected, makes this the default route on this router. A default route is used when the route from a source to a destination is unknown or when it is not feasible for the router to maintain many routes in its routing table. All unknown outbound packets are forwarded over the default route.

 
          

 [bookmark: pgfId-364671]When deselected, this static route is not the default route.

 
           
           		 [bookmark: pgfId-364673]Prefixâ��The IP address of the destination network. Enter an IP address or the name of a network/host object, or click  Select to select the object from a list or to create a new one.

 
          

 [bookmark: pgfId-364675]The prefix must be a class A, B, or C network or host IP. A host IP can begin with 0 unless it contains a discontiguous mask. All subnet addresses are valid.

  
        

 
         
         		[bookmark: pgfId-364681]Forwarding (Next Hop)

  
         		[bookmark: pgfId-364683]The method of forwarding data to the destination network:

 
           
           		 [bookmark: pgfId-364685]Forwarding Interfaceâ��The router interface that forwards packets to the remote network. Enter the name of an interface or interface role, or click  Select to select the object from a list or to create a new one.

 
           		 [bookmark: pgfId-364687]Forwarding IPâ��The IP address of the next hop router that receives and forwards packets to the remote network. Enter an IP address or the name of a network/host object, or click  Select to select the object from a list or to create a new one.

 
          

  
        

 
         
         		[bookmark: pgfId-364693]Distance Metric

  
         		[bookmark: pgfId-364695]The number of hops to the destination network (gateway IP). The default is 1 if no value is specified. The range is from 1 to 255.

 [bookmark: pgfId-364697]This metric (also known as administrative distance) is a measurement of route expense based on the number of hops to the network on which a specified host resides. This hop count includes all the networks a packet must traverse, including the destination network. Therefore, all directly connected networks have a metric of 1.

 [bookmark: pgfId-364699]Because the metric is based on expense, it is used to identify the priority of the static route. If two routing entries specify the same network, the route with the lower metric value (that is, the lower cost) is given a higher priority and is selected.

 [bookmark: pgfId-364701]Note Under certain circumstances, it is useful to assign a static route a lower priority (larger distance metric) than a dynamic route. This enables the static route to act as a backup, â��floating,â�� route when the dynamic route is unavailable.

  
        

 
         
         		[bookmark: pgfId-364707]Permanent route

  
         		[bookmark: pgfId-364709]When selected, prevents this static route entry from being deleted, even in cases where the interface is shut down or the router cannot communicate with the next router.

 [bookmark: pgfId-364711]When deselected, this static route can be deleted.
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     [bookmark: pgfId-250330][bookmark: 60946][bookmark: NATchap_cncpt_ConfiguringNetworkAddressTranslation]Configuring Network Address Translation
      
      
 
     
 

 
    [bookmark: pgfId-250332]These topics provide conceptual information about network address translation (NAT) in general, and about translation types and various implementations:

 
     
     		 [bookmark: pgfId-250337]Understanding Network Address Translation

 
    

 
    [bookmark: pgfId-250342] – Types of Address Translation

 
    [bookmark: pgfId-250347] – About “Simplified” NAT on ASA 8.3+ Devices

 
    [bookmark: pgfId-250349]The following topics describe configuration and management of NAT rules on various Cisco devices:

 
    [bookmark: pgfId-250351]Cisco IOS routers

 
     
     		 [bookmark: pgfId-250356]NAT Policies on Cisco IOS Routers

 
    

 
    [bookmark: pgfId-250361] – NAT Page: Interface Specification

 
    [bookmark: pgfId-250366] – NAT Page: Static Rules

 
    [bookmark: pgfId-250371] – NAT Page: Dynamic Rules

 
    [bookmark: pgfId-250376] – NAT Page: Timeouts

 
    [bookmark: pgfId-250378]PIX, FWSM, and ASA security devices

 
     
     		 [bookmark: pgfId-250383]NAT Policies on Security Devices

 
     		 [bookmark: pgfId-250388]NAT in Transparent Mode

 
     		 [bookmark: pgfId-250393]Translation Options Page

 
     		 [bookmark: pgfId-250395] PIX, FWSM, and pre-8.3 ASA devices 

 
    

 
    [bookmark: pgfId-250400] – Configuring NAT on PIX, FWSM, and pre-8.3 ASA Devices

 
    [bookmark: pgfId-250405] – Address Pools

 
    [bookmark: pgfId-250410] – Translation Rules: PIX, FWSM, and pre-8.3 ASA

 
     
     		 [bookmark: pgfId-250412] ASA 8.3+ devices 

 
    

 
    [bookmark: pgfId-250417] – Configuring NAT on ASA 8.3+ Devices

 
    [bookmark: pgfId-250422] – Translation Rules: ASA 8.3+

 
    [bookmark: pgfId-250427] – Add and Edit NAT Rule Dialog Boxes

 
    [bookmark: pgfId-250432] – Add or Edit Network/Host Dialog Box: NAT Tab

 
    [bookmark: pgfId-250436] – Per-Session NAT Rules: ASA 9.0(1)+

 
    [bookmark: pgfId-250441] – Add and Edit Per Session NAT Rule Dialog Boxes

 
   
 
    
     [bookmark: pgfId-250449][bookmark: 61031][bookmark: pxchap_cncpt_UnderstandingNAT-2]Understanding Network Address Translation[bookmark: marker-250447]

 
    [bookmark: pgfId-250451]Address translation substitutes the real address in a packet with a mapped address that is routable on the destination network. As part of the process, the device also records the substitution in a translation database; these records are known as “xlate” entries. The appropriate xlate entry must exist to allow address translation on return packets—the substitution of the original real address for the mapped address; this procedure is sometimes referred to as “untranslation.” Thus, network address translation (NAT) actually consists of two steps: the translation of a real address into a mapped address, and the reverse translation for returning traffic.

 
    [bookmark: pgfId-250453]One of the main functions of NAT is to enable private IP networks to connect to the Internet. Network address translation replaces a private IP address with a public IP address, translating the private addresses in the internal network into legal, routable addresses that can be used on the public Internet. In this way, NAT conserves public addresses; for example, NAT rules can be configured to utilize only one public address for the entire network in communications with the outside world.

 
    [bookmark: pgfId-250455]Other functions of NAT include:

 
     
     		 [bookmark: pgfId-250457]Security – Keeping internal IP addresses hidden discourages direct attacks.

 
     		 [bookmark: pgfId-250459]IP routing solutions – Overlapping IP addresses are not a problem.

 
     		 [bookmark: pgfId-250461]Flexibility – You can change internal IP addressing schemes without affecting the public addresses available externally. For example, for a server accessible to the Internet, you can maintain a fixed IP address for Internet use, but internally, you can change the server address.

 
    

 
    [bookmark: pgfId-250463]Cisco devices support both NAT, which provides a globally unique address for each outbound host session, and Port Address Translation (PAT), which provides the same single address combined with a unique port number, for up to 64,000 simultaneous outbound or inbound host sessions. The global addresses used for NAT come from a pool of addresses specifically designated for address translation. The unique global address that is used for PAT can be either one global address, or the IP address of a given interface.

 
    [bookmark: pgfId-250465]The device translates an address when an existing NAT rule matches the specific traffic. If no NAT rule matches, processing for the packet continues. The exception is when you enable NAT control. NAT control requires that packets traversing from a higher security interface (inside) to a lower security interface (outside) match a NAT rule, or processing for the packet stops.

 
    [bookmark: pgfId-250467]Cisco devices can perform NAT or PAT on both inbound and outbound connections. This ability to translate inbound addresses is called “Outside NAT” because addresses on the outside, or less secure, interface are translated to a usable inside IP address. Just as when you translate outbound traffic, you may choose dynamic NAT, static NAT, dynamic PAT, or static PAT. If necessary, you can use outside NAT together with inside NAT to translate the both source and destination IP addresses of a packet.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-250472]Note In this document, all types of translation are generally referred to as NAT; see Types of Address Translation for descriptions of the various types. When describing NAT, the terms inside and outside represent the security relationship between any two interfaces. The higher security level is inside and the lower security level is outside.


    
     

    

    

 
    [bookmark: pgfId-250477]The release of ASA version 8.3 provides a simplified, interface-independent approach to configuring network address translation, as compared to earlier ASA versions and other devices. See About “Simplified” NAT on ASA 8.3+ Devices for more information.

 
    [bookmark: pgfId-250479]Related Topics

 
     
     		 [bookmark: pgfId-250484]Types of Address Translation

 
     		 [bookmark: pgfId-250489]About “Simplified” NAT on ASA 8.3+ Devices

 
    

 
     
      [bookmark: pgfId-250497][bookmark: 61063][bookmark: pxchap_cncpt_NATTypes]Types of Address Translation[bookmark: marker-250495]

 
      
       
        
        [bookmark: pgfId-247641]Table 24-1 [bookmark: 61071]Types of Address Translation 

 
        
       
         
         		[bookmark: pgfId-247647]Static NAT

  
         		[bookmark: pgfId-247649]Fixed translation of real source addresses to specific mapped addresses—each source address is always translated to the same mapped address, regardless of IP protocol and port number.

  
        

 
         
         		[bookmark: pgfId-247655]Static PAT

  
         		[bookmark: pgfId-247657]Fixed translation of real source addresses with specific TCP or UDP port numbers, to specific mapped addresses and ports. That is, each source address/port is always translated to the same mapped address/port.

  
        

 
         
         		[bookmark: pgfId-247663]Policy Static NAT

  
         		[bookmark: pgfId-247665]Fixed translation of real source addresses to specific mapped addresses. Destination networks/hosts are also specified, and the service is always IP.

  
        

 
         
         		[bookmark: pgfId-247671]Policy Static PAT

  
         		[bookmark: pgfId-247673]Fixed translation of real source addresses with specific TCP or UDP port numbers, to specific mapped addresses and ports. Destination networks/hosts and services are also specified.

  
        

 
         
         		[bookmark: pgfId-247679]Dynamic NAT

  
         		[bookmark: pgfId-247681]Dynamic translation of real source addresses to mapped addresses obtained from a pool of shared addresses. Each source address can be mapped to any available address in the pool.

  
        

 
         
         		[bookmark: pgfId-247687]Dynamic PAT

  
         		[bookmark: pgfId-247689]Translation of real source addresses to a single mapped address; singularity is provided by dynamic translation of related port numbers. That is, each real address/port combination is translated to the same mapped address, but assigned a unique port. This is sometimes referred to as “overloading.”

  
        

 
         
         		[bookmark: pgfId-247695]Policy Dynamic NAT

  
         		[bookmark: pgfId-247697]Dynamic translation of specific source-address/destination-address/service combinations on a given interface, using a pool of shared addresses. Translation direction—outbound or inbound—is also specified.

  
        

 
         
         		[bookmark: pgfId-247703]Identity NAT

  
         		[bookmark: pgfId-247705]The specified address is translated to itself—that is, it is effectively not translated; applies to outbound connections only. Identity NAT is a particular type of Static NAT.

  
        

 
         
         		[bookmark: pgfId-247711]NAT Exempt

  
         		[bookmark: pgfId-247713]Translation is bypassed for specified source/destination address combinations; connections can be initiated in both the outbound and inbound directions.
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     [bookmark: pgfId-250504]Note While certain of these types do not apply to ASA 8.3 and later devices, the ASA 8.3+ devices do provide a Dynamic NAT and PAT option, which is Dynamic NAT with a Dynamic PAT back-up feature.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-250512][bookmark: 61122][bookmark: NATchap_cncpt_AboutSimplifiedNAT]About “Simplified” NAT on ASA 8.3+ Devices[bookmark: marker-250510]

 
     [bookmark: pgfId-250514]The release of ASA version 8.3 provides a simplified approach to configuring network address translation (NAT), as compared to earlier ASA versions and other devices. Configuration of NAT was simplified by replacing the earlier flow-based scheme with an “original packet” to “translated packet” approach.

 
     [bookmark: pgfId-250516]All NAT rules on the device—static NAT, dynamic PAT, and dynamic NAT—are presented in a single table, and essentially the same dialog box is used to configure all NAT rules. The NAT rules are interface independent (that is, interfaces are optional), meaning the rules are independent of security levels also.

 
     [bookmark: pgfId-250518]NAT rules are no longer dependent on security levels. A global address space consisting of all interfaces is available, and is specified using the keyword “any.” All Interface fields default to any, so unless a specific interface is provided, the rule is applicable to all interfaces.

 
     [bookmark: pgfId-250520]Network Object NAT

 
     [bookmark: pgfId-250525]You also can define NAT properties on Host, Address Range, and Network objects, such that corresponding NAT rules are applied automatically to the designated security device. Using these objects means you need enter the necessary IP addresses, services, ports, and optional interfaces only once. These automatically generated, object-based rules are referred to as “Network Object NAT” rules. Note that these rules cannot be created or deleted from the rules table; you must edit the appropriate objects in the Policy Object Manager. You can, however, edit these rules from the rules table after they have been defined for the network object. For more information, see Add or Edit Network/Host Dialog Box: NAT Tab.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-250527]Note Network Object NAT rules are not displayed in the Translation Rules table in Policy View because these rules are device-specific.


     
      

     

     

 
     [bookmark: pgfId-250529]The NAT Table

 
     [bookmark: pgfId-250531]As mentioned, all NAT rules on a device are presented in a single table, which is divided into three sections: a “manual” section, the Network Object NAT rules section, and another manual-rules section. You can add, edit and order rules in both manual sections; the Network Object NAT rules are added and ordered automatically, and as mentioned, to edit these rules you must edit the related objects.

 
     [bookmark: pgfId-250533]The NAT rules in the table are applied on a top-down, first-match basis. That is, a packet is translated only when it matches a NAT rule, and as soon as a match is made, regardless of its location or section, NAT rule processing stops.

 
     [bookmark: pgfId-250535]You can use this table to organize and manage the manual rules—you can insert rules in any order, and you can re-order them. The two sections of manual rules are provided to let you order manual rules both before and after the automatic object rules.

 
     [bookmark: pgfId-250537]Network Object NAT rules are automatically ordered such that static rules appear before dynamic rules. These two types are each further ordered as follows:

 
      
      		 [bookmark: pgfId-250539]Fewest number of IP addresses – Rules for objects with one IP address are listed before those for objects with two addresses, which are before those with three addresses, and so on.

 
      		 [bookmark: pgfId-250541]IP address numbers – For objects having the same number of IP addresses, the rules are arranged such that the IP addresses themselves are in numerical order, from lower to higher. For example, 10.1.1.1 rules are listed before 11.1.1.1 rules.

 
      		 [bookmark: pgfId-250543]Object names – If the IP address is the same, the rules are ordered by alphabetizing the object names.

 
     

 
     [bookmark: pgfId-250545]And remember, translation is based on the first matching rule.

 
     [bookmark: pgfId-250547]Destination Translation

 
     [bookmark: pgfId-250549]With manual static rules, in addition to source address translation, you also can configure destination address translation. Source and destination translation are defined at the same time, in the same dialog box. Again, while source translation can be static or dynamic, destination translation is always static, and is only available with manual rules.

 
     [bookmark: pgfId-250551]Bi-directional or Twice NAT

 
     [bookmark: pgfId-250553]When creating a manual static rule, you can select the “Bi-directional” option, which will produce an entry in the rules table that actually represents two static NAT rules, encompassing both translation directions. That is, a static rule is created for the specified source/translated address pairing, along with a mirror rule for the translated address/source pairing.

 
     [bookmark: pgfId-250555]For example, if Bi-directional is chosen when you create a static rule with Host1 in the Source field and Host2 in the Translated field, two lines are added to the rules table: one with Host1 being translated to Host2, and one with Host2 being translated to Host1.

 
     [bookmark: pgfId-250557]This is sometimes referred to as “Twice NAT” because only one look-up is required to fetch and process what is in effect two rules.

 
     [bookmark: pgfId-250559]Many-to-one Addressing

 
     [bookmark: pgfId-250561]Generally, static NAT rules are configured with one-to-one address mapping. However, you can now define static NAT rules in which many IP addresses map to a few or one IP address. Functionally, many-to-few is the same as many-to-one, but because the configuration is more complicated, we recommend creating a many-to-one rule for each address as needed.

 
     [bookmark: pgfId-250563]Many-to-one addressing might be useful, for example, in a situation where a range of public IP addresses is used to reach a load balancer which redirects requests to an internal network.

 
     [bookmark: pgfId-250565]Related Topics

 
      
      		 [bookmark: pgfId-250570]Configuring NAT on ASA 8.3+ Devices

 
      		 [bookmark: pgfId-250575]Add and Edit NAT Rule Dialog Boxes

 
      		 [bookmark: pgfId-250580]Add or Edit Network/Host Dialog Box: NAT Tab

 
     

 
    
 
   
 
    
     [bookmark: pgfId-250594][bookmark: 61177][bookmark: rtpage_cncpt_NATPolicyPage]NAT Policies on Cisco IOS Routers [bookmark: marker-250588][bookmark: marker-250590][bookmark: marker-250592]

 
    [bookmark: pgfId-250596]You can configure NAT policies on a Cisco IOS router from the following tabs on the NAT policy page:

 
     
     		 [bookmark: pgfId-250601]NAT Page: Interface Specification

 
     		 [bookmark: pgfId-250606]NAT Page: Static Rules

 
     		 [bookmark: pgfId-250611]NAT Page: Dynamic Rules

 
     		 [bookmark: pgfId-250616]NAT Page: Timeouts

 
    

 
    [bookmark: pgfId-250618]Network Address Translation (NAT) converts private, internal LAN addresses into globally routable IP addresses. NAT enables a small number of public IP addresses to provide global connectivity for a large number of hosts.

 
    [bookmark: pgfId-250623]For more information, see Understanding Network Address Translation.

 
    [bookmark: pgfId-250625]Navigation Path

 
     
     		 [bookmark: pgfId-250627](Device view) Select  NAT from the Policy selector.

 
     		 [bookmark: pgfId-250629](Policy view) Select  NAT (Router) from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
     
      [bookmark: pgfId-250643][bookmark: 61215][bookmark: rtpage_cncpt_NATPageInterfaceSpecificationTab]NAT Page: Interface Specification[bookmark: marker-250637][bookmark: marker-250639][bookmark: marker-250641]

 
     [bookmark: pgfId-250645]Before creating NAT rules, you must define the “direction” of the traffic to be translated by specifying the Inside and Outside interfaces. Inside interfaces typically connect to a LAN that the router serves. Outside interfaces typically connect to your organization’s WAN or to the Internet. You must designate at least one Inside interface and one Outside interface to enable the router to perform network address translation.

 
     [bookmark: pgfId-250647]The Inside and Outside designations are used when interpreting translation rules: addresses connected to the Inside interface are translated to addresses on the Outside interface. After these interfaces are defined, they are used in all static and dynamic NAT translation rules.

 
     [bookmark: pgfId-250649]Use the Interface Specification tab of the NAT policy page to specify the Inside and Outside interfaces.

 
     [bookmark: pgfId-250651]Navigation Path

 
      
      		 [bookmark: pgfId-250653](Device view) Select  NAT from the Policy selector, then click the  Interface Specification tab.

 
      		 [bookmark: pgfId-250655](Policy view) Select  NAT (Router) > Translation Rules from the Policy Type selector. Select an existing policy or create a new one, and then click the  Interface Specification tab.

 
     

 
     [bookmark: pgfId-250657]Defining the Inside and Outside Interfaces

 
     [bookmark: pgfId-250659]In the NAT Inside Interfaces and NAT Outside Interfaces fields, enter or Select the names of the interfaces or interface roles for the Inside and Outside interfaces, respectively. Separate multiple names or roles with commas (for example, Ethernet1/1, Ethernet1/2). Note that you cannot enter the same name in both fields.

 
     [bookmark: pgfId-250661]Related Topics

 
      
      		 [bookmark: pgfId-250666]NAT Policies on Cisco IOS Routers

 
      		 [bookmark: pgfId-250671]NAT Page: Static Rules

 
      		 [bookmark: pgfId-250676]NAT Page: Dynamic Rules

 
      		 [bookmark: pgfId-250681]NAT Page: Timeouts

 
      		 [bookmark: pgfId-250686]NAT Page: Timeouts

 
     

 
    
 
     
      [bookmark: pgfId-250706][bookmark: 61268][bookmark: rtpage_cncpt_NATPageStaticRulesTab]NAT Page: Static Rules[bookmark: marker-250694][bookmark: marker-250696][bookmark: marker-250698][bookmark: marker-250700][bookmark: marker-250702][bookmark: marker-250704]

 
     [bookmark: pgfId-250708]You define a static NAT rule by specifying a local address that must be translated, as well as the global address to which it is translated. This is a static or fixed mapping—the local address is always translated to the same global address.

 
     [bookmark: pgfId-250710]You can define static NAT rules that translate the addresses of single hosts, as well as static rules that translate multiple addresses in a subnet. When multiple local addresses must use the same global address, you must define the necessary port redirection information, which defines a different port for each local address using the global address.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-250712]Note We strongly recommend that you do not perform NAT on traffic that will be transmitted over a VPN. Translating addresses on this traffic causes it to be sent out unencrypted instead of encrypted over the VPN.


     
      

     

     

 
     [bookmark: pgfId-250714]The procedure for creating a static rule depends on whether the address being translated represents a port, a single host, or an entire subnet:

 
      
      		 [bookmark: pgfId-250716]You define a  static NAT rule for a single host by entering the original address to translate and the global address to which it is translated. The global address may be taken from an interface on the device.

 
      		 [bookmark: pgfId-250718]You define a  static NAT rule for a subnet by entering one of the addresses in the subnet (including the subnet mask) as the original address, and one of the global addresses that you want to use as the translated address. The router configures the remaining addresses based on the subnet mask you provide.

 
      		 [bookmark: pgfId-250720]You define a  static NAT rule for a port by entering the original IP address and the global address to which it should be translated. The global address may be taken from an interface on the device. In addition, you must select the protocol used by the port, as well as the local and global port numbers.

 
     

 
     [bookmark: pgfId-250725]The Add Static NAT Rule and Edit Static NAT Rule dialog boxes are used to add and edit these rules. Refer to NAT Static Rule Dialog Boxes for descriptions of the fields displayed in the table on this page.

 
     [bookmark: pgfId-250727]Before You Begin

 
      
      		 [bookmark: pgfId-250732]Define the inside and outside interfaces used for NAT. See NAT Page: Interface Specification.

 
     

 
     [bookmark: pgfId-250734]Navigation Path

 
      
      		 [bookmark: pgfId-250736](Device view) Select  NAT from the Policy selector, then click the  Static Rules tab.

 
      		 [bookmark: pgfId-250738](Policy view) Select  NAT (Router) > Translation Rules from the Policy Type selector. Select an existing policy or create a new one, and then click the  Static Rules tab.

 
     

 
     [bookmark: pgfId-250740]Related Topics

 
      
      		 [bookmark: pgfId-250745]NAT Policies on Cisco IOS Routers

 
      		 [bookmark: pgfId-250750]NAT Page: Dynamic Rules

 
      		 [bookmark: pgfId-250755]NAT Page: Timeouts

 
      		 [bookmark: pgfId-250757]Standard Security Manager rules table topics:

 
     

 
     [bookmark: pgfId-250762] – Using Rules Tables

 
     [bookmark: pgfId-250767] – Filtering Tables

 
     [bookmark: pgfId-250772] – Table Columns and Column Heading Features

 
    
 
     
      [bookmark: pgfId-250786][bookmark: 61351][bookmark: rtpage_cncpt_NATStaticRuleDialogBox]NAT Static Rule Dialog Boxes[bookmark: marker-250780][bookmark: marker-250782][bookmark: marker-250784]

 
     [bookmark: pgfId-250788]Use the Add/Edit NAT Static Rule dialog boxes to add or edit static address translation rules. Except for their titles, the two dialog boxes are identical.

 
     [bookmark: pgfId-250790]Navigation Path

 
     [bookmark: pgfId-250795]Go to the NAT Page: Static Rules tab; click the Add button beneath the table to add a new rule, or select a rule in the table and click Edit to update that rule.

 
     [bookmark: pgfId-250797]Related Topics

 
      
      		 [bookmark: pgfId-250802]Understanding Interface Role Objects

 
     

 
     [bookmark: pgfId-250804]Field Reference

 
     [bookmark: pgfId-250807] 

 
      
       
        
        [bookmark: pgfId-247726]Table 24-2 [bookmark: 61382]Add/Edit NAT Static Rule Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-247732]Element
          
  
         		
           
           [bookmark: pgfId-247734]Description
          
  
        

 
         
         		[bookmark: pgfId-247740]Static Rule Type

  
         		[bookmark: pgfId-247742]The type of local address to be translated by this static rule:

 
           
           		 [bookmark: pgfId-247744]Static Host – A single host requiring static address translation.

 
           		 [bookmark: pgfId-247746]Static Network – A subnet requiring static address translation.

 
           		 [bookmark: pgfId-247748]Static Port – A single port requiring static address translation. If you select this option, you must define the Port Redirection parameters.

 
          

  
        

 
         
         		[bookmark: pgfId-247754]Original Address

  
         		[bookmark: pgfId-247756]An IP address, or the name of a network/host object representing the address(es) to be translated. You can enter or Select the object name.

 [bookmark: pgfId-247761]Network/host objects are logical collections of IP addresses that represent networks, hosts, or both. See Understanding Networks/Hosts Objects for more information.

 [bookmark: pgfId-247763]Note Do not enter a local address belonging to this router, as it could cause Security Manager management traffic to be translated. Translating this traffic will cause a loss of communication between the router and Security Manager.

  
        

 
         
         		[bookmark: pgfId-247769]Translated Address

  
         		[bookmark: pgfId-247771]Use the options in this section of the dialog box to specify the address(es) to which the Original Address(es) are translated:

 
           
           		 [bookmark: pgfId-247773] Specify IP – Select this option to specify an IP address, or the name of a network/host object that provides the translated address(es). Add an IP address, or the name of a network/host object, in the  Translated IP/Network field. You can enter or Select the object name.

 
           		 [bookmark: pgfId-247775] Use Interface IP – Select this option to specify that the IP address assigned to a particular interface be used as the translated address. Enter or Select the name of the desired  Interface . (This is typically the interface from which translated packets leave the router.)

 
          

 [bookmark: pgfId-247777]Note This option is not available when Static Network is the chosen rule type. Only one static rule may be defined per interface.

  
        

 
         
         		[bookmark: pgfId-247783]Port Redirection

  
         		[bookmark: pgfId-247785]These parameters specify port information for the address translations. Port address translation lets you to use the same public IP address for multiple devices as long as the port specified for each device is different.

 [bookmark: pgfId-247787]Note These parameters are available only when Static Port is the chosen rule type.

 [bookmark: pgfId-247789]Redirect Port – When Static Port is chosen as the rule type, this box is automatically checked; it cannot be changed. Enter the appropriate information in the following fields:

 
           
           		 [bookmark: pgfId-247791] Protocol – The communications protocol used for these ports: TCP or UDP.

 
           		 [bookmark: pgfId-247793] Local Port – The port number on the source network. Valid values range from 1 to 65535.

 
           		 [bookmark: pgfId-247795] Global Port – The port number on the destination network that the router is to use for this translation. Valid values range from 1 to 65535.

 
          

  
        

 
         
         		[bookmark: pgfId-247801]Advanced

  
         		[bookmark: pgfId-247803]This section contains optional, advanced translation options.

 [bookmark: pgfId-247805]Note The Advanced options are available only when the Specify IP option is the selected method for defining the translated address(es).

 
           
           		 [bookmark: pgfId-247807]No Alias – When selected, disables automatic aliasing for the global IP address translation.

 
          

 [bookmark: pgfId-247809]If the NAT pool used as an inside global pool consists of addresses on an attached subnet, an alias is generated for that address so that the router can answer Address Resolution Protocol (ARP) requests for those addresses.

 [bookmark: pgfId-247811]When deselected, global address aliases are permitted.

 
           
           		 [bookmark: pgfId-247813]No Payload – When selected, prohibits an embedded address or port in the payload from being translated.

 
          

 [bookmark: pgfId-247815]The payload option performs NAT between devices on overlapping networks that share the same IP address. When an outside device sends a DNS query to reach an inside device, the local address inside the payload of the DNS reply is translated to a global address according to the relevant NAT rule.

 [bookmark: pgfId-247820]You can disable this feature by selecting the No Payload option. Otherwise, embedded addresses and ports in the payload may be translated. See Disabling the Payload Option for Overlapping Networks for more information.

 
           
           		 [bookmark: pgfId-247822]Create Extended Translation Entry – When checked, extended translation entries (addresses and ports) are created in the translation table. This lets you associate multiple global addresses with a single local address. This is the default.

 
          

 [bookmark: pgfId-247824]When this option is deselected, simple translation entries are created, allowing association of a single global address with the local address.

 [bookmark: pgfId-247826]Note This option is not available when Static Port is the chosen rule type.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-250815][bookmark: 61468][bookmark: rtchap_cncpt_DisablingthePayloadOptionforOverlappingNetworks]Disabling the Payload Option for Overlapping Networks[bookmark: marker-250813]

 
     [bookmark: pgfId-250817]Overlapping networks result when you assign an IP address to a device on your network that is already legally owned and assigned to a different device on the Internet or outside network. Overlapping networks can also result after the merger of two companies using RFC 1918 IP addresses in their networks. These two networks need to communicate, preferably without your having to re-address all their devices.

 
     [bookmark: pgfId-250819]This communication is achieved as follows. The outside device cannot use the IP address of the inside device because it is the same as the address assigned to itself (the outside device). Instead, the outside device sends a Domain Name System (DNS) query for the inside device’s domain name. The source of this query is the IP address of the outside device, which is translated to an address from a designated address pool. The DNS server located on the inside network replies with the IP address associated with the inside device’s domain name in the data portion of the packet. The destination address of the reply packet is translated back to the outside device’s address, and the address in the data portion of the reply packet is translated to an address from a different address pool. In this way, the outside device learns that the IP address for the inside device is one of the addresses from that second address pool, and it uses this address when it communicates with the inside device. The router running NAT takes care of the translations at this point.

 
     [bookmark: pgfId-250821]To disable the translation of the address inside the payload, check the No Payload option when you create a static NAT rule based on a global IP translation.

 
    
 
     
      [bookmark: pgfId-250837][bookmark: 61481][bookmark: rtpage_cncpt_NATPageDynamicRulesTab]NAT Page: Dynamic Rules [bookmark: marker-250829][bookmark: marker-250831][bookmark: marker-250833][bookmark: marker-250835]

 
     [bookmark: pgfId-250839]Use the NAT Dynamic Rules tab of the router’s NAT page to manage dynamic address translation rules. A dynamic address translation rule dynamically maps hosts to addresses, using either the IP address of a specific interface (with dynamic port translation), or the addresses included in an address pool that are globally unique in the destination network.

 
     [bookmark: pgfId-250841]Defining Dynamic NAT Rules

 
     [bookmark: pgfId-250843]You define a dynamic NAT rule by first selecting an access control list (ACL) whose rules specify the traffic requiring translation.

 
     [bookmark: pgfId-250845]Then, you must either select an interface with an IP address to which the addresses should be translated, or define a pool of addresses to be used. You define the pool by specifying a range of addresses and giving the range a unique name; you can specify multiple ranges. The router uses the available addresses in the pool (those not used for static translations, or for its own WAN IP address) for connections to the Internet or another outside network. When an address is no longer in use, it is returned to the address pool to be dynamically assigned later to another device.

 
     [bookmark: pgfId-250847]If the addressing requirements of your network exceed the available addresses in your dynamic NAT pool, you can use the Port Address Translation (PAT) feature (also called Overloading) to associate many private addresses with one or a small group of public IP address, using port addressing to make each translation unique. With PAT enabled, the router chooses a unique port number for the IP address of each outbound translation slot. This feature is useful if you cannot allocate enough unique IP addresses for your outbound connections. Note that Port Address Translation does not occur until the address pool is depleted.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-250849]Note By default, Security Manager does not perform NAT on traffic that is meant to be transmitted over a VPN. Otherwise, any traffic appearing in both the NAT ACL and the crypto ACL defined on an interface would be sent out unencrypted because NAT is always performed before encryption. However, you can change this default setting.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-250854]Tip You can perform PAT on split-tunneled traffic on the spokes of your VPN topology directly from the Global VPN Settings page. There is no need to create a dynamic NAT rule for each spoke. Any NAT rules that you define on an individual device override the VPN setting. For more information, see Configuring VPN Global NAT Settings.


     
      

     

     

 
     [bookmark: pgfId-250859]The Add Dynamic NAT Rule and Edit Static NAT Rule dialog boxes are used to add and edit these rules. Refer to NAT Dynamic Rule Dialog Box for descriptions of the fields displayed in the table on this page.

 
     [bookmark: pgfId-250861]Before You Begin

 
      
      		 [bookmark: pgfId-250866]Define the inside and outside interfaces used for NAT. See NAT Page: Interface Specification.

 
     

 
     [bookmark: pgfId-250868]Navigation Path

 
      
      		 [bookmark: pgfId-250870](Device view) Select  NAT from the Policy selector, then click the  Dynamic Rules tab.

 
      		 [bookmark: pgfId-250872](Policy view) Select  NAT (Router) > Translation Rules from the Policy Type selector. Select an existing policy or create a new one, and then click the  Dynamic Rules tab.

 
     

 
     [bookmark: pgfId-250874]Related Topics

 
      
      		 [bookmark: pgfId-250879]NAT Policies on Cisco IOS Routers

 
      		 [bookmark: pgfId-250884]NAT Page: Static Rules

 
      		 [bookmark: pgfId-250889]NAT Page: Timeouts

 
      		 [bookmark: pgfId-250891]Standard Security Manager rules table topics:

 
     

 
     [bookmark: pgfId-250896] – Using Rules Tables

 
     [bookmark: pgfId-250901] – Filtering Tables

 
     [bookmark: pgfId-250906] – Table Columns and Column Heading Features

 
    
 
     
      [bookmark: pgfId-250918][bookmark: 61551][bookmark: rtpage_cncpt_NATDynamicRuleDialogBox]NAT Dynamic Rule Dialog Box[bookmark: marker-250914][bookmark: marker-250916]

 
     [bookmark: pgfId-250920]Use the Add/Edit NAT Dynamic Rule dialog boxes to add or edit dynamic address translation rules. Except for their titles, the two dialog boxes are identical.

 
     [bookmark: pgfId-250922]Navigation Path

 
     [bookmark: pgfId-250927]Go to the NAT Page: Dynamic Rules tab; click the Add button beneath the table to add a new rule, or select a rule in the table and click Edit to update that rule.

 
     [bookmark: pgfId-250929]Related Topics

 
      
      		 [bookmark: pgfId-250934]Creating Access Control List Objects

 
      		 [bookmark: pgfId-250939]Understanding Interface Role Objects

 
     

 
     [bookmark: pgfId-250941]Field Reference

 
     [bookmark: pgfId-250944] 

 
      
       
        
        [bookmark: pgfId-247839]Table 24-3 [bookmark: 61581]NAT Dynamic Rule Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-247845]Element
          
  
         		
           
           [bookmark: pgfId-247847]Description
          
  
        

 
         
         		[bookmark: pgfId-247853]Traffic Flow

  
         		[bookmark: pgfId-247855]In the Access List field, enter or Select the name of the access control list (ACL) object whose entries define the addresses requiring dynamic translation.

 [bookmark: pgfId-247857]Note Make sure that the specified ACL does not permit the translation of Security Manager management traffic over any device address on this router. Translating this traffic will cause a loss of communication between the router and Security Manager.

  
        

 
         
         		[bookmark: pgfId-247863]Translated Address

  
         		[bookmark: pgfId-247865]Use the options in this section of the dialog box to specify the method and address(es) used for dynamic translation:

 
           
           		 [bookmark: pgfId-247867] Use Interface IP – Select this option to specify that the globally registered IP address assigned to a particular interface be used as the translated address; port addressing ensures each translation is unique. (The Enable Port Translation (Overload) option is checked automatically when you select Use Interface IP.)

 
          

 [bookmark: pgfId-247872]Enter or Select the name of the desired Interface. This is typically the interface from which translated packets leave the router, meaning the interface or interface role must represent an outside interface on the router (see NAT Page: Interface Specification).

 
           
           		 [bookmark: pgfId-247874] Address Pool – Select this option to base address translation on the addresses you specify in the  Network Ranges pool.

 
          

 [bookmark: pgfId-247876]Enter one or more address ranges, including the prefix, using the format min1-max1/prefix (in CIDR notation), where “prefix” represents a valid netmask. For example, 172.16.0.0-172.31.0.223/12.

 [bookmark: pgfId-247878]You can add as many address ranges to the address pool as required, but all ranges must share the same prefix. Separate multiple entries with commas.

  
        

 
         
         		[bookmark: pgfId-247884]Settings

  
         		[bookmark: pgfId-247886]This section contains two options

 
           
           		 [bookmark: pgfId-247888] Enable Port Translation (Overload) – When selected, the router uses port addressing (PAT) if supply of global addresses in the address pool is depleted; when deselected, PAT is not used.

 
          

 [bookmark: pgfId-247890]Note When you use select Use Interface IP in the Translated Address section, this box is checked automatically; it cannot be changed.

 
           
           		 [bookmark: pgfId-247892] Do Not Translate VPN Traffic (Site-to-Site VPN only) – Deselect this option to allow address translation on traffic intended for a site-to-site VPN.

 
          

 [bookmark: pgfId-247894]When selected, address translation is not performed on VPN traffic. When deselected, the router performs address translation on VPN traffic in cases of overlapping addresses between the NAT ACL and the crypto ACL.

 [bookmark: pgfId-247896]Note We strongly recommend that you not deselect this option, or any traffic defined in both the NAT ACL and the crypto ACL will be sent unencrypted. When you perform NAT into IPsec, we also recommend that you leave this option selected; it does not interfere with the translation of addresses arriving from overlapping networks.

 [bookmark: pgfId-247898]This setting applies only in situations where the NAT ACL overlaps the crypto ACL used by the site-to-site VPN. Because the interface performs NAT first, any traffic arriving from an address within this overlap would get translated, causing the traffic to be sent unencrypted. Leaving this box checked prevents that from happening.

 [bookmark: pgfId-247900]Note This option does not apply to remote access VPNs.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-250960][bookmark: 61637][bookmark: rtpage_cncpt_NATPageTimeoutsTab]NAT Page: Timeouts [bookmark: marker-250952][bookmark: marker-250954][bookmark: marker-250956][bookmark: marker-250958]

 
     [bookmark: pgfId-250962]Use the NAT Timeouts tab of the router’s NAT page to manage the timeout values for port address (overload) translations. These timeouts cause a dynamic translation to expire after a specified period of inactivity. In addition, you can use options on this page to place a limit on the number of entries allowed in the dynamic NAT table, and to modify the default timeout on all dynamic translations that do not include PAT processing.

 
     [bookmark: pgfId-250964]About Dynamic NAT Timeouts

 
     [bookmark: pgfId-250966]Dynamic NAT translations have a timeout period for non-use, after which they expire and are purged from the translation table. If you enable the Overload feature for performing PAT, you can specify a variety of values that provide finer control over these timeouts, because each translation entry contains additional contextual information about the traffic using it.

 
     [bookmark: pgfId-250968]For example, non-DNS translations time out by default after five minutes, but DNS translations time out after 1 minute. Further, TCP translations time out after 24 hours, unless an RST or FIN is seen on the stream, in which case they time out after one minute. You can change any of these timeout values.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-250973]Note If you disable the Port Translation (Overload) feature for all dynamic rules, you need not enter any PAT-related timeout values. However, you can still modify the default timeout value for non-PAT dynamic translations. (By default, all dynamic translations expire after 24 hours.) For more information about the Overload feature, see NAT Dynamic Rule Dialog Box.


     
      

     

     

 
     [bookmark: pgfId-250975]Navigation Path

 
      
      		 [bookmark: pgfId-250977](Device view) Select  NAT from the Policy selector, then click the  Timeouts tab.

 
      		 [bookmark: pgfId-250979](Policy view) Select  NAT (Router) > Translation Rules from the Policy Type selector. Select an existing policy or create a new one, and then click the  Timeouts tab.

 
     

 
     [bookmark: pgfId-250981]Related Topics

 
      
      		 [bookmark: pgfId-250986]NAT Page: Interface Specification

 
      		 [bookmark: pgfId-250991]NAT Page: Static Rules

 
      		 [bookmark: pgfId-250996]NAT Page: Dynamic Rules

 
     

 
     [bookmark: pgfId-250998]Field Reference

 
     [bookmark: pgfId-251001] 

 
      
       
        
        [bookmark: pgfId-247913]Table 24-4 [bookmark: 61688]NAT Timeouts Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-247919]Element
          
  
         		
           
           [bookmark: pgfId-247921]Description
          
  
        

 
         
         		[bookmark: pgfId-247927]Max Entries

  
         		[bookmark: pgfId-247929]The maximum number of entries allowed in the dynamic NAT table. You can enter a value between 1 and 2147483647, or you can leave the field blank (the default), which means that the number of entries in the table is unlimited.

  
        

 
         
         		[bookmark: pgfId-247935]Timeout (sec.)

  
         		[bookmark: pgfId-247937]The number of seconds after which dynamic translations expire; this does not apply to PAT (overload) translations. The default is 86400 seconds (24 hours).

  
        

 
         
         		[bookmark: pgfId-247943]UDP Timeout (sec.)

  
         		[bookmark: pgfId-247945]The timeout value applied to User Datagram Protocol (UDP) ports. The default is 300 seconds (5 minutes).

 [bookmark: pgfId-247950]Note This value applies only when Port Translation (Overload) is enabled for a dynamic NAT rule; see NAT Dynamic Rule Dialog Box.

  
        

 
         
         		[bookmark: pgfId-247956]DNS Timeout (sec.)

  
         		[bookmark: pgfId-247958]The timeout value applied to Domain Naming System (DNS) server connections. The default is 60 seconds.

 [bookmark: pgfId-247963]Note This value applies only when Port Translation (Overload) is enabled for a dynamic NAT rule; see NAT Dynamic Rule Dialog Box.

  
        

 
         
         		[bookmark: pgfId-247969]TCP Timeout (sec.)

  
         		[bookmark: pgfId-247971]The timeout value applied to Transmission Control Protocol (TCP) ports. The default is 86400 seconds (24 hours).

 [bookmark: pgfId-247976]Note This value applies only when Port Translation (Overload) is enabled for a dynamic NAT rule; see NAT Dynamic Rule Dialog Box.

  
        

 
         
         		[bookmark: pgfId-247982]FINRST Timeout (sec.)

  
         		[bookmark: pgfId-247984]The timeout value applied when a Finish (FIN) packet or Reset (RST) packet (both of which terminate connections) is found in the TCP stream. The default is 60 seconds.

 [bookmark: pgfId-247989]Note This value applies only when Port Translation (Overload) is enabled for a dynamic NAT rule; see NAT Dynamic Rule Dialog Box.

  
        

 
         
         		[bookmark: pgfId-247995]ICMP Timeout (sec.)

  
         		[bookmark: pgfId-247997]The timeout value applied to Internet Control Message Protocol (ICMP) flows. The default is 60 seconds.

 [bookmark: pgfId-248002]Note This value applies only when Port Translation (Overload) is enabled for a dynamic NAT rule; see NAT Dynamic Rule Dialog Box.

  
        

 
         
         		[bookmark: pgfId-248008]PPTP Timeout (sec.)

  
         		[bookmark: pgfId-248010]The timeout value applied to NAT Point-to-Point Tunneling Protocol (PPTP) flows. The default is 86400 seconds (24 hours).

 [bookmark: pgfId-248015]Note This value applies only when Port Translation (Overload) is enabled for a dynamic NAT rule; see NAT Dynamic Rule Dialog Box.

  
        

 
         
         		[bookmark: pgfId-248021]SYN Timeout (sec.)

  
         		[bookmark: pgfId-248023]The timeout value applied to TCP flows after a synchronous transmission (SYN) message (used for precise clocking) is encountered. The default is 60 seconds.

 [bookmark: pgfId-248028]Note This value applies only when Port Translation (Overload) is enabled for a dynamic NAT rule; see NAT Dynamic Rule Dialog Box.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-251011][bookmark: 61759][bookmark: pxchap_cncpt_ConfiguringNATPoliciesonFirewallDevices]NAT Policies on Security Devices[bookmark: marker-251007][bookmark: marker-251009]

 
    [bookmark: pgfId-251013]The following topics describe configuring network address translation (NAT) options on managed security appliances: PIX firewalls, Firewall Service Modules (FWSMs) on Catalyst switches, pre-version-8.3 Adaptive Security Appliances (ASAs), and ASA 8.3+ devices. The topics are arranged as follows:

 
     
     		 [bookmark: pgfId-251018]NAT in Transparent Mode

 
     		 [bookmark: pgfId-251023]Translation Options Page

 
     		 [bookmark: pgfId-251025] PIX, FWSM, and pre-8.3 ASA 

 
    

 
    [bookmark: pgfId-251030] – Configuring NAT on PIX, FWSM, and pre-8.3 ASA Devices

 
    [bookmark: pgfId-251035] – Address Pools

 
    [bookmark: pgfId-251040] – Translation Rules: PIX, FWSM, and pre-8.3 ASA

 
     
     		 [bookmark: pgfId-251042] ASA 8.3+ 

 
    

 
    [bookmark: pgfId-251047] – Configuring NAT on ASA 8.3+ Devices

 
    [bookmark: pgfId-251052] – Translation Rules: ASA 8.3+

 
     
      [bookmark: pgfId-251064][bookmark: 61801][bookmark: NATchap_cncpt_NATinTransparentMode]NAT in Transparent Mode[bookmark: marker-251058][bookmark: marker-251060][bookmark: marker-251062]

 
     [bookmark: pgfId-251066]Using NAT on a security appliance operating in transparent mode eliminates the need for upstream or downstream routers to perform NAT for their networks. NAT in transparent mode has the following requirements and limitations:

 
      
      		 [bookmark: pgfId-251068]When the mapped addresses are not on the same network as the transparent firewall, you need to add a static route for the mapped addresses on the upstream router that points to the downstream router (through the security appliance).

 
      		 [bookmark: pgfId-251070]If the real destination address is not directly connected to the security appliance, you also need to add a static route on the security appliance for the real destination address that points to the downstream router. Without NAT, traffic from the upstream router to the downstream router does not need any routes on the security appliance because it uses the MAC address table. Using NAT, however, causes the security appliance to use a route look-up instead of a MAC address look-up, so it needs a static route to the downstream router.

 
      		 [bookmark: pgfId-251072]Because the transparent firewall does not have any interface IP addresses, you cannot use interface PAT.

 
      		 [bookmark: pgfId-251074]ARP inspection is not supported. Moreover, if for some reason a host on one side of the security appliance sends an ARP request to a host on the other side of the security appliance, and the initiating host real address is mapped to a different address on the same subnet, then the real address remains visible in the ARP request.

 
     

 
    
 
     
      [bookmark: pgfId-251088][bookmark: 61825][bookmark: pxpage_cncpt_GlobalOptionsPage]Global Options Page[bookmark: marker-251082][bookmark: marker-251084][bookmark: marker-251086]

 
     [bookmark: pgfId-251090]Security Manager version 4.9 supports Carrier Grade NAT to configure the block size and maximum blocks per host limit for port block allocation, for ASA devices 9.5(1) or higher. Use the Global Options page to configure these options.

 
     [bookmark: pgfId-251092]Navigation Path

 
      
      		 [bookmark: pgfId-251094](Device view) Select  NAT > Global Options from the Device Policy selector.

 
      		 [bookmark: pgfId-251096](Policy view) Select  NAT (PIX/ASA/FWSM) > Global Options from the Policy Type selector. Select an existing policy from the Shared Policy selector, or right-click  Global Options to create a new policy.

 
     

 
     [bookmark: pgfId-251098]Related Topics

 
      
      		 [bookmark: pgfId-251103]NAT Policies on Security Devices

 
      		 [bookmark: pgfId-251108]Add and Edit NAT Rule Dialog Boxes

 
     

 
     [bookmark: pgfId-251110]Field Reference

 
     [bookmark: pgfId-251113] 

 
      
       
        
        [bookmark: pgfId-248041]Table 24-5 [bookmark: 61862]Global Options Page 

 
        
       
         
         		
           
           [bookmark: pgfId-248047]Element
          
  
         		
           
           [bookmark: pgfId-248049]Description
          
  
        

 
         
         		[bookmark: pgfId-248055]xlate block-allocation size

  
         		[bookmark: pgfId-248057]Enter a value between 32 and 4096. The default value is 512.

  
        

 
         
         		[bookmark: pgfId-248063]xlate block-allocation maximum-per-host

  
         		[bookmark: pgfId-248065]Enter a value between 1 to 8. The default value is 4.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-251127][bookmark: 61883][bookmark: pxpage_cncpt_TranslationOptionsPage]Translation Options Page[bookmark: marker-251121][bookmark: marker-251123][bookmark: marker-251125]

 
     [bookmark: pgfId-251129]Use the Translation Options page to set options that affect network address translation for the selected security appliance. These settings apply to all interfaces on the device.

 
     [bookmark: pgfId-251131]Navigation Path

 
      
      		 [bookmark: pgfId-251133](Device view) Select  NAT > Translation Options from the Device Policy selector.

 
      		 [bookmark: pgfId-251135](Policy view) Select  NAT (PIX/ASA/FWSM) > Translation Options from the Policy Type selector. Select an existing policy from the Shared Policy selector, or right-click  Translation Options to create a new policy.

 
     

 
     [bookmark: pgfId-251137]Related Topics

 
      
      		 [bookmark: pgfId-251142]NAT Policies on Security Devices

 
     

 
     [bookmark: pgfId-251144]Field Reference

 
     [bookmark: pgfId-251147] 

 
      
       
        
        [bookmark: pgfId-248078]Table 24-6 [bookmark: 61917]Translation Options Page 

 
        
       
         
         		
           
           [bookmark: pgfId-248084]Element
          
  
         		
           
           [bookmark: pgfId-248086]Description
          
  
        

 
         
         		[bookmark: pgfId-248092]Enable traffic through the firewall without address translation

  
         		[bookmark: pgfId-248094]When selected, lets traffic pass through the security appliance without address translation. If this option is not selected, any traffic that does not match a translation rule will be dropped.

 [bookmark: pgfId-248096]Note This option is available only on PIX 7.x, FWSM 3.x, and ASA devices.

  
        

 
         
         		[bookmark: pgfId-248102]Enable xlate bypass

  
         		[bookmark: pgfId-248104]When selected, establishment of NAT sessions for untranslated traffic is disabled (this feature is called “xlate bypass”).

 [bookmark: pgfId-248106]Note This option is available only on FWSM 3.2 and higher.

 [bookmark: pgfId-248108]By default, the FWSM creates NAT sessions for all connections even if NAT is not used. For example, a session is created for each untranslated connection even if NAT control is not enabled, if NAT exemption or identity NAT is used, or if you use same-security interfaces and do not configure NAT. Because there is a maximum number of NAT sessions (266,144 concurrent), these kinds of NAT sessions might cause you to run into the limit. To avoid reaching the limit, enable xlate bypass.

 [bookmark: pgfId-248110]If you disable NAT control and have untranslated traffic or use NAT exemption, or if you enable NAT control and use NAT exemption, then with xlate bypass, the FWSM does not create a session for those types of untranslated traffic. However, NAT sessions are still created in the following instances:

 
           
           		 [bookmark: pgfId-248112]You configure identity NAT (with or without NAT control)—identity NAT is considered to be a translation.

 
           		 [bookmark: pgfId-248114]You use same-security interfaces with NAT control. Traffic between same-security interfaces create NAT sessions even when you do not configure NAT for the traffic. To avoid NAT sessions in this case, disable NAT control, or use NAT exemption as well as xlate bypass.

 
          

  
        

 
         
         		[bookmark: pgfId-248120]Do not translate VPN traffic

  
         		[bookmark: pgfId-248122]When selected, VPN traffic passes through the security appliance without address translation.

  
        

 
         
         		[bookmark: pgfId-248128]Clear translates for existing connections

  
         		[bookmark: pgfId-248130]When selected, the translation slots assigned to dynamic translations and any associated connections are cleared following each session.

 [bookmark: pgfId-248132]Each session connecting through the security appliance, and undergoing some form of NAT or PAT, is assigned a translation slot known as an “xlate.” These translation slots can persist after the session is complete, which can lead to a depletion of translation slots, unexpected traffic behavior, or both.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-251159][bookmark: 61958][bookmark: NATchap_cncpt_NATpreASA83]Configuring NAT on PIX, FWSM, and pre-8.3 ASA Devices [bookmark: marker-251153][bookmark: marker-251155][bookmark: marker-251157]

 
     [bookmark: pgfId-251164]The following sections describe configuring network address translation on PIX and FWSM devices, and on pre-8.3-version ASAs. (See Configuring NAT on ASA 8.3+ Devices for information about configuring NAT on ASA 8.3+ devices.)

 
      
      		 [bookmark: pgfId-251169]Address Pools

 
      		 [bookmark: pgfId-251174]Translation Rules: PIX, FWSM, and pre-8.3 ASA

 
     

 
     [bookmark: pgfId-251179] – Translation Exemptions (NAT 0 ACL)

 
     [bookmark: pgfId-251184] – Dynamic Rules Tab

 
     [bookmark: pgfId-251189] – Policy Dynamic Rules Tab

 
     [bookmark: pgfId-251194] – Static Rules Tab

 
     [bookmark: pgfId-251199] – General Tab

 
    
 
     
      [bookmark: pgfId-251213][bookmark: 61995][bookmark: pxpage_cncpt_AddressPoolsPage]Address Pools[bookmark: marker-251207][bookmark: marker-251209][bookmark: marker-251211]

 
     [bookmark: pgfId-251215]Use the Address Pools page to view and manage the global address pools used in dynamic NAT rules.

 
     [bookmark: pgfId-251220]The Address Pool dialog box is used to add and edit these address pools. Refer to Address Pool Dialog Box for descriptions of the fields displayed in the Global Address Pools table on this page.

 
     [bookmark: pgfId-251222]Navigation Path

 
      
      		 [bookmark: pgfId-251224](Device view) Select  NAT > Address Pools from the Device Policy selector.

 
      		 [bookmark: pgfId-251226](Policy view) Select  NAT (PIX/ASA/FWSM) > Address Pools from the Policy Type selector. Select an existing policy from the Shared Policy selector, or right-click  Address Pools to create a new policy.

 
     

 
     [bookmark: pgfId-251228]Related Topics

 
      
      		 [bookmark: pgfId-251233]Configuring NAT on PIX, FWSM, and pre-8.3 ASA Devices

 
     

 
    
 
     
      [bookmark: pgfId-251247][bookmark: 62028][bookmark: pxpage_cncpt_AddressPoolDialogBox]Address Pool Dialog Box[bookmark: marker-251241][bookmark: marker-251243][bookmark: marker-251245]

 
     [bookmark: pgfId-251249]Use the Address Pool dialog box to add or edit a global address pool for use in dynamic NAT rules.

 
     [bookmark: pgfId-251251]Navigation Path

 
     [bookmark: pgfId-251256]You open the Address Pool dialog box by clicking the Add Row or Edit Row buttons on the Address Pools.

 
     [bookmark: pgfId-251258]Related Topics

 
      
      		 [bookmark: pgfId-251263]Configuring NAT on PIX, FWSM, and pre-8.3 ASA Devices

 
     

 
     [bookmark: pgfId-251265]Field Reference

 
     [bookmark: pgfId-251268] 

 
      
       
        
        [bookmark: pgfId-248145]Table 24-7 [bookmark: 62057]Address Pools Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-248151]Element
          
  
         		
           
           [bookmark: pgfId-248153]Description
          
  
        

 
         
         		[bookmark: pgfId-248159]Interface Name

  
         		[bookmark: pgfId-248161]Enter or Select the name of the device interface on which the mapped IP addresses will be used.

  
        

 
         
         		[bookmark: pgfId-248167]Pool ID

  
         		[bookmark: pgfId-248169]Enter a unique identification number for this address pool, an integer between 1 and 2147483647. When configuring a dynamic NAT rule, you select a Pool ID to specify the pool of addresses to be used for translation.

  
        

 
         
         		[bookmark: pgfId-248175]IP address ranges

  
         		[bookmark: pgfId-248177]Enter or Select the addresses to be assigned to this address pool. You can specify these addresses as follows:

 
           
           		 [bookmark: pgfId-248179]Address range for dynamic NAT (e.g., 192.168.1.1-192.168.1.15)

 
           		 [bookmark: pgfId-248181]Subnetwork (e.g., 192.168.1.0/24)

 
           		 [bookmark: pgfId-248183]List of addresses separated by commas (e.g., 192.168.1.1, 192.168.1.2, 192.168.1.3)

 
           		 [bookmark: pgfId-248185]Single address to use for PAT (e.g., 192.168.1.1)

 
           		 [bookmark: pgfId-248187]Combinations of the above (e.g., 192.168.1.1-192.168.1.15, 192.168.1.25)

 
           		 [bookmark: pgfId-248189]Names of hosts on the connected network; these will be resolved to IP addresses.

 
          

  
        

 
         
         		[bookmark: pgfId-248195]Description

  
         		[bookmark: pgfId-248197]Enter a description for the address pool.

  
        

 
         
         		[bookmark: pgfId-248203]Enable Interface PAT

  
         		[bookmark: pgfId-248205]When checked, port address translation is enabled on the specified interface.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-251282][bookmark: 62107][bookmark: pxpage_cncpt_TranslationRulesPage]Translation Rules: PIX, FWSM, and pre-8.3 ASA [bookmark: marker-251274][bookmark: marker-251276][bookmark: marker-251278][bookmark: marker-251280]

 
     [bookmark: pgfId-251284]Use the Translation Rules page to define network address translation (NAT) rules on the selected device. The Translation Rules page consists of the following tabs:

 
      
      		 [bookmark: pgfId-251289]Translation Exemptions (NAT 0 ACL) – Use this tab to configure rules specifying traffic that is exempt from address translation.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-251291]Note Translation exemptions are only supported by PIX, ASA and FWSM devices in router mode, and FWSM 3.2 devices in transparent mode. Other devices in transparent mode support only static translation rules.


     
      

     

     

 
      
      		 [bookmark: pgfId-251296]Dynamic Rules Tab – Use this tab to configure dynamic NAT and PAT rules.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-251298]Note Dynamic translation rules are only supported by PIX, ASA and FWSM devices in router mode, and FWSM 3.2 devices in transparent mode. Other devices in transparent mode support only static translation rules.


     
      

     

     

 
      
      		 [bookmark: pgfId-251303]Policy Dynamic Rules Tab – Use this tab to configure dynamic translation rules based on source and destination addresses and services.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-251305]Note Policy dynamic rules are only supported by PIX, ASA and FWSM devices in router mode, and FWSM 3.2 devices in transparent mode. Other devices in transparent mode support only static translation rules.


     
      

     

     

 
      
      		 [bookmark: pgfId-251310]Static Rules Tab – Use this tab to configure static translation rules for a security appliance or shared policy.

 
      		 [bookmark: pgfId-251315]General Tab – Use this tab to view all current translation rules, listed in the order that they will be evaluated on the device.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-251317]Note The General tab is visible only for PIX, ASA and FWSM devices in router mode, and FWSM 3.2 devices in transparent mode. Other devices in transparent mode support only static translation rules and do not need to display summary information.


     
      

     

     

 
     [bookmark: pgfId-251319]Navigation Path

 
     [bookmark: pgfId-251321]To access the Translation Rules page, do one of the following:

 
      
      		 [bookmark: pgfId-251323](Device view) Select  NAT > Translation Rules from the Device Policy selector.

 
      		 [bookmark: pgfId-251325](Policy view) Select  NAT (PIX/ASA/FWSM) > Translation Rules from the Policy Type selector. Select an existing policy from the Shared Policy selector, or right-click  Translation Rules to create a new policy.

 
     

 
    
 
     
      [bookmark: pgfId-251339][bookmark: 62157][bookmark: pxpage_cncpt_TranslationExemptionsNATACLTab]Translation Exemptions (NAT 0 ACL) [bookmark: marker-251333][bookmark: marker-251335][bookmark: marker-251337]

 
     [bookmark: pgfId-251341]Use the Translation Exemptions (NAT 0 ACL) tab of the Translation Rules page to view and specify rules that exempt traffic from address translation. Rules are evaluated sequentially in the order listed. The row number indicates the rule’s position in the ordering of the list. You can use the Up Row and Down Row buttons to change the position of the selected rule.

 
     [bookmark: pgfId-251346]The Add/Edit Translation Exemption (NAT-0 ACL) Rule dialog box is used to add and edit these rules. Refer to Add/Edit Translation Exemption (NAT-0 ACL) Rule Dialog Box for descriptions of the fields displayed in the table on this page.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-251348]Note Translation exemptions are only supported by PIX, ASA and FWSM devices in router mode, and FWSM 3.2 devices in transparent mode. Other devices in transparent mode support only static translation rules.


     
      

     

     

 
     [bookmark: pgfId-251350]Navigation Path

 
     [bookmark: pgfId-251355]You can access the Translation Exemptions (NAT 0 ACL) tab from the Translation Rules: PIX, FWSM, and pre-8.3 ASA page.

 
     [bookmark: pgfId-251357]Related Topics

 
      
      		 [bookmark: pgfId-251362]Configuring NAT on PIX, FWSM, and pre-8.3 ASA Devices

 
      		 [bookmark: pgfId-251367]Advanced NAT Options Dialog Box

 
      		 [bookmark: pgfId-251372]General Tab

 
      		 [bookmark: pgfId-251374]Standard Security Manager rules table topics:

 
     

 
     [bookmark: pgfId-251379] – Using Rules Tables

 
     [bookmark: pgfId-251384] – Filtering Tables

 
     [bookmark: pgfId-251389] – Table Columns and Column Heading Features

 
    
 
     
      [bookmark: pgfId-251403][bookmark: 62203][bookmark: pxpage_cncpt_AddEditTranslationExemptionNATACLRuleDialogBox]Add/Edit Translation Exemption (NAT-0 ACL) Rule Dialog Box[bookmark: marker-251397][bookmark: marker-251399][bookmark: marker-251401]

 
     [bookmark: pgfId-251405]Use the Add/Edit Translation Exemption (NAT-0 ACL) Rule dialog box to define and edit translation exemption rules on PIX, FWSM and pre-8.3 ASA devices in router mode, and FWSM 3.2 devices in transparent mode.

 
     [bookmark: pgfId-251407]Navigation Path

 
     [bookmark: pgfId-251412]You can access the Add/Edit Translation Exemption (NAT-0 ACL) Rule dialog box from the Translation Exemptions (NAT 0 ACL) tab. See Translation Exemptions (NAT 0 ACL) for more information.

 
     [bookmark: pgfId-251414]Related Topics

 
      
      		 [bookmark: pgfId-251419]Configuring NAT on PIX, FWSM, and pre-8.3 ASA Devices

 
      		 [bookmark: pgfId-251424]Translation Rules: PIX, FWSM, and pre-8.3 ASA

 
      		 [bookmark: pgfId-251429]Advanced NAT Options Dialog Box

 
     

 
     [bookmark: pgfId-251431]Field Reference

 
     [bookmark: pgfId-251434] 

 
      
       
        
        [bookmark: pgfId-248218]Table 24-8 [bookmark: 62238]Add/Edit Translation Exemption (NAT-0 ACL) Rule Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-248224]Element
          
  
         		
           
           [bookmark: pgfId-248226]Description
          
  
        

 
         
         		[bookmark: pgfId-248232]Enable Rule

  
         		[bookmark: pgfId-248234]If checked, the rule is enabled. Deselect this option to disable the rule without deleting it.

  
        

 
         
         		[bookmark: pgfId-248240]Action

  
         		[bookmark: pgfId-248242]Select the action for this rule:

 
           
           		 [bookmark: pgfId-248244]exempt – The rule identifies traffic that is exempt from NAT.

 
           		 [bookmark: pgfId-248246]do not exempt – The rule identifies traffic that is not exempt from NAT.

 
          

  
        

 
         
         		[bookmark: pgfId-248252]Original: Interface

  
         		[bookmark: pgfId-248254]Enter the name of (or Select) the device interface to which the rule applies.

  
        

 
         
         		[bookmark: pgfId-248260]Original: Sources

  
         		[bookmark: pgfId-248262]Enter IP addresses for (or Select) the source hosts and network objects to which the rule applies. Multiple entries must be separated by commas.

 [bookmark: pgfId-248264]Note that this parameter is displayed in the Translation Exemptions (NAT 0 ACL) table under the column heading “Original Address.”

  
        

 
         
         		[bookmark: pgfId-248270]Translated: Direction

  
         		[bookmark: pgfId-248272]The rule can be applied to Inbound or Outbound traffic, as specified with this option.

  
        

 
         
         		[bookmark: pgfId-248278]Traffic flow: Destinations

  
         		[bookmark: pgfId-248280]Enter IP addresses for (or Select) the destination hosts and network objects to which the rule applies. Multiple entries must be separated by commas.

  
        

 
         
         		[bookmark: pgfId-248286]Category

  
         		[bookmark: pgfId-248291]To assign the rule to a category, choose the category from this list. Categories can help identify rules and objects using labels and color-coding. See Using Category Objects for more information.

 [bookmark: pgfId-248293]Note No commands are generated for the Category attribute.

  
        

 
         
         		[bookmark: pgfId-248299]Description

  
         		[bookmark: pgfId-248301]Enter a description of the rule.

  
        

 
         
         		[bookmark: pgfId-248307]Advanced button (FWSM only)

  
         		[bookmark: pgfId-248312]Click to open the Advanced NAT Options Dialog Box to configure advanced settings for this rule.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-251448][bookmark: 62304][bookmark: pxpage_cncpt_DynamicRulesTab]Dynamic Rules Tab[bookmark: marker-251442][bookmark: marker-251444][bookmark: marker-251446]

 
     [bookmark: pgfId-251450]Use the Dynamic Rules tab of the Translation Rules page to view and configure dynamic NAT and PAT rules. Rules are evaluated sequentially in the order listed. The row number indicates the rule’s position in the ordering of the list. You can use the Up Row and Down Row buttons to change the position of the selected rule.

 
     [bookmark: pgfId-251452]With dynamic NAT, internal IP addresses are dynamically translated using IP addresses from a pool of global addresses. With dynamic PAT, internal IP addresses are translated to a single mapped address by using dynamically assigned port numbers with the mapped address. Dynamic translations are often used to map local RFC 1918 IP addresses to addresses that are Internet-routable.

 
     [bookmark: pgfId-251457]The Add/Edit Dynamic Translation Rule dialog box is used to add and edit these rules. Refer to Add/Edit Dynamic Translation Rule Dialog Box for descriptions of the fields displayed in the table on this page.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-251459]Note Dynamic translation rules are only supported by PIX, ASA and FWSM devices in router mode, and FWSM 3.2 devices in transparent mode. Other devices in transparent mode support only static translation rules.


     
      

     

     

 
     [bookmark: pgfId-251461]Navigation Path

 
     [bookmark: pgfId-251466]You can access the Dynamic Rules tab from the Translation Rules page. For more information about the Translation Rules page, see Translation Rules: PIX, FWSM, and pre-8.3 ASA.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-251471]Note By default, only standard Dynamic Rule elements are displayed in this table. Additional columns for elements defined in the Advanced NAT Options dialog box can be displayed by right-clicking any column heading. (All columns are displayed by default on the General Tab.)


     
      

     

     

 
     [bookmark: pgfId-251473]Related Topics

 
      
      		 [bookmark: pgfId-251478]Configuring NAT on PIX, FWSM, and pre-8.3 ASA Devices

 
      		 [bookmark: pgfId-251483]Advanced NAT Options Dialog Box

 
      		 [bookmark: pgfId-251488]Select Address Pool Dialog Box

 
      		 [bookmark: pgfId-251493]General Tab

 
      		 [bookmark: pgfId-251495]Standard rules table topics:

 
     

 
     [bookmark: pgfId-251500] – Using Rules Tables

 
     [bookmark: pgfId-251505] – Filtering Tables

 
     [bookmark: pgfId-251510] – Table Columns and Column Heading Features

 
    
 
     
      [bookmark: pgfId-251524][bookmark: 62356][bookmark: pxpage_cncpt_AddEditDynamicTranslationRuleDialogBox]Add/Edit Dynamic Translation Rule Dialog Box[bookmark: marker-251518][bookmark: marker-251520][bookmark: marker-251522]

 
     [bookmark: pgfId-251526]Use the Add/Edit Dynamic Translation Rule dialog box to define and edit dynamic NAT and PAT rules.

 
     [bookmark: pgfId-251528]Navigation Path

 
     [bookmark: pgfId-251533]You can access the Add/Edit Dynamic Translation Rule dialog box from the Dynamic Rules tab. See Dynamic Rules Tab for more information.

 
     [bookmark: pgfId-251535]Related Topics

 
      
      		 [bookmark: pgfId-251540]Configuring NAT on PIX, FWSM, and pre-8.3 ASA Devices

 
      		 [bookmark: pgfId-251545]Translation Rules: PIX, FWSM, and pre-8.3 ASA

 
      		 [bookmark: pgfId-251550]Advanced NAT Options Dialog Box

 
      		 [bookmark: pgfId-251555]Select Address Pool Dialog Box

 
     

 
     [bookmark: pgfId-251557]Field Reference

 
     [bookmark: pgfId-251560] 

 
      
       
        
        [bookmark: pgfId-248325]Table 24-9 [bookmark: 62394]Add/Edit Dynamic Translation Rule Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-248331]Element
          
  
         		
           
           [bookmark: pgfId-248333]Description
          
  
        

 
         
         		[bookmark: pgfId-248339]Enable Rule

  
         		[bookmark: pgfId-248341]If checked, the rule is enabled. Deselect this option to disable the rule without deleting it.

  
        

 
         
         		[bookmark: pgfId-248347]Original: Interface

  
         		[bookmark: pgfId-248349]Enter the name or Select the device interface to which the rule applies.

  
        

 
         
         		[bookmark: pgfId-248355]Original: Address

  
         		[bookmark: pgfId-248357]Enter IP addresses for (or Select) the source hosts and network objects to which the rule applies. Multiple entries must be separated by commas.

  
        

 
         
         		[bookmark: pgfId-248363]Translated: Pool

  
         		[bookmark: pgfId-248368]Enter (or Select) the ID number of the pool of addresses used for translation; clicking Select opens the Select Address Pool Dialog Box.

 [bookmark: pgfId-248370]Enter a value of zero to specify this as an identity NAT rule.

  
        

 
         
         		[bookmark: pgfId-248376]Translated: Direction

  
         		[bookmark: pgfId-248378]The rule can be applied to Inbound or Outbound traffic, as specified with this option.

  
        

 
         
         		[bookmark: pgfId-248384]Advanced button

  
         		[bookmark: pgfId-248389]Click to open the Advanced NAT Options Dialog Box to configure advanced settings for this rule.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-251574][bookmark: 62438][bookmark: pxpage_cncpt_SelectAddressPoolDialogBox]Select Address Pool Dialog Box[bookmark: marker-251568][bookmark: marker-251570][bookmark: marker-251572]

 
     [bookmark: pgfId-251579]The Select Address Pool dialog box presents a list of global address pools; these pools are defined and managed via the Address Pools. Use this dialog box to select an address pool for use by a dynamic translation rule, or a policy dynamic translation rule.

 
     [bookmark: pgfId-251581]Navigation Path

 
     [bookmark: pgfId-251589]You can access the Select Address Pool dialog box from the Add/Edit Dynamic Translation Rule Dialog Box when adding or editing a dynamic translation rule, or from the Add/Edit Policy Dynamic Rules Dialog Box when adding or editing a policy dynamic translation rule.

 
     [bookmark: pgfId-251591]Related Topics

 
      
      		 [bookmark: pgfId-251596]Configuring NAT on PIX, FWSM, and pre-8.3 ASA Devices

 
      		 [bookmark: pgfId-251601]Translation Rules: PIX, FWSM, and pre-8.3 ASA

 
      		 [bookmark: pgfId-251606]Address Pools

 
     

 
     [bookmark: pgfId-251608]Field Reference

 
     [bookmark: pgfId-251611] 

 
      
       
        
        [bookmark: pgfId-248402]Table 24-10 [bookmark: 62474]Select Address Pool Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-248408]Element
          
  
         		
           
           [bookmark: pgfId-248410]Description
          
  
        

 
         
         		[bookmark: pgfId-248416]Pool ID

  
         		[bookmark: pgfId-248418]The identification number of the address pool.

  
        

 
         
         		[bookmark: pgfId-248424]Interface

  
         		[bookmark: pgfId-248426]The name of the device interface to which the address pool applies.

  
        

 
         
         		[bookmark: pgfId-248432]IP Address Ranges

  
         		[bookmark: pgfId-248434]The IP addresses assigned to the pool; “interface” in this list indicates PAT is enabled on the specified Interface.

  
        

 
         
         		[bookmark: pgfId-248440]Description

  
         		[bookmark: pgfId-248442]The description provided for the address pool.

  
        

 
         
         		[bookmark: pgfId-248448]Selected Row

  
         		[bookmark: pgfId-248450]This field identifies the pool currently selected in the list. When you click OK to close the dialog box, this pool is assigned to the translation rule.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-251625][bookmark: 62511][bookmark: pxpage_cncpt_PolicyDynamicRulesTab]Policy Dynamic Rules Tab[bookmark: marker-251619][bookmark: marker-251621][bookmark: marker-251623]

 
     [bookmark: pgfId-251627]Use the Policy Dynamic Rules tab of the Translation Rules page to view and configure dynamic translation rules based on source and destination addresses and services. Rules are evaluated sequentially in the order listed. The row number indicates the rule’s position in the ordering of the list. You can use the Up Row and Down Row buttons to change the position of the selected rule.

 
     [bookmark: pgfId-251632]The Add/Edit Policy Dynamic Rule dialog box is used to add and edit these rules. Refer to Add/Edit Policy Dynamic Rules Dialog Box for a description of the fields displayed in the table on this page.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-251634]Note Policy dynamic rules are only supported by PIX, ASA and FWSM devices in router mode, and FWSM 3.2 devices in transparent mode. Other devices in transparent mode support only static translation rules.


     
      

     

     

 
     [bookmark: pgfId-251636]Navigation Path

 
     [bookmark: pgfId-251641]You can access the Policy Dynamic Rules tab from the Translation Rules page. See Translation Rules: PIX, FWSM, and pre-8.3 ASA for more information.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-251646]Note By default, only standard Policy Dynamic Rule elements are displayed in this table. Additional columns for elements defined in the Advanced NAT Options dialog box can be displayed by right-clicking any column heading. (All columns are displayed by default on the General Tab.)


     
      

     

     

 
     [bookmark: pgfId-251648]Related Topics

 
      
      		 [bookmark: pgfId-251653]Configuring NAT on PIX, FWSM, and pre-8.3 ASA Devices

 
      		 [bookmark: pgfId-251658]Add/Edit Policy Dynamic Rules Dialog Box

 
      		 [bookmark: pgfId-251663]Advanced NAT Options Dialog Box

 
      		 [bookmark: pgfId-251668]Select Address Pool Dialog Box

 
      		 [bookmark: pgfId-251673]General Tab

 
      		 [bookmark: pgfId-251675]Standard rules table topics:

 
     

 
     [bookmark: pgfId-251680] – Using Rules Tables

 
     [bookmark: pgfId-251685] – Filtering Tables

 
     [bookmark: pgfId-251690] – Table Columns and Column Heading Features

 
    
 
     
      [bookmark: pgfId-251704][bookmark: 62565][bookmark: pxpage_cncpt_AddEditPolicyDynamicRulesDialogBox]Add/Edit Policy Dynamic Rules Dialog Box[bookmark: marker-251698][bookmark: marker-251700][bookmark: marker-251702]

 
     [bookmark: pgfId-251706]Use the Add/Edit Policy Dynamic Rules dialog box to define and edit dynamic translation rules based on source and destination addresses and services.

 
     [bookmark: pgfId-251708]Navigation Path

 
     [bookmark: pgfId-251713]You can access the Add/Edit Policy Dynamic Rules dialog box from the Policy Dynamic Rules tab. See Policy Dynamic Rules Tab for more information.

 
     [bookmark: pgfId-251715]Related Topics

 
      
      		 [bookmark: pgfId-251720]Configuring NAT on PIX, FWSM, and pre-8.3 ASA Devices

 
      		 [bookmark: pgfId-251725]Translation Rules: PIX, FWSM, and pre-8.3 ASA

 
      		 [bookmark: pgfId-251730]Policy Dynamic Rules Tab

 
      		 [bookmark: pgfId-251735]Advanced NAT Options Dialog Box

 
      		 [bookmark: pgfId-251740]Select Address Pool Dialog Box

 
     

 
     [bookmark: pgfId-251742]Field Reference

 
     [bookmark: pgfId-251745] 

 
      
       
        
        [bookmark: pgfId-248463]Table 24-11 [bookmark: 62606]Add/Edit Policy Dynamic Rules Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-248469]Element
          
  
         		
           
           [bookmark: pgfId-248471]Description
          
  
        

 
         
         		[bookmark: pgfId-248477]Enable Rule

  
         		[bookmark: pgfId-248479]If checked, the rule is enabled. Deselect this option to disable the rule without deleting it.

  
        

 
         
         		[bookmark: pgfId-248485]Original: Interface

  
         		[bookmark: pgfId-248487]Enter the name of (or Select) the device interface to which the rule applies.

  
        

 
         
         		[bookmark: pgfId-248493]Original: Sources

  
         		[bookmark: pgfId-248495]Enter IP addresses for (or Select) the source hosts and network objects to which the rule applies. Multiple entries must be separated by commas.

 [bookmark: pgfId-248497]Note that this parameter is displayed in the Policy Dynamic Rules table under the column heading “Original Address.”

  
        

 
         
         		[bookmark: pgfId-248503]Translated: Pool

  
         		[bookmark: pgfId-248508]Enter (or Select) the ID number of the pool of addresses used for translation; clicking Select opens the Select Address Pool Dialog Box.

 [bookmark: pgfId-248510]Enter a value of zero to specify this as an identity NAT rule.

  
        

 
         
         		[bookmark: pgfId-248516]Translated: Direction

  
         		[bookmark: pgfId-248518]The rule can be applied to Inbound or Outbound traffic, as specified with this option.

  
        

 
         
         		[bookmark: pgfId-248524]Traffic flow: Destinations

  
         		[bookmark: pgfId-248526]Enter IP addresses for (or Select) the destination hosts and network objects to which the rule applies. Multiple entries must be separated by commas.

  
        

 
         
         		[bookmark: pgfId-248532]Traffic flow: Services

  
         		[bookmark: pgfId-248534]Enter (or Select) the services to which the rule applies. Multiple entries must be separated by commas.

  
        

 
         
         		[bookmark: pgfId-248540]Category

  
         		[bookmark: pgfId-248545]To assign the rule to a category, choose the category from this list. Categories can help identify rules and objects using labels and color-coding. See Using Category Objects for more information.

 [bookmark: pgfId-248547]Note No commands are generated for the Category attribute.

  
        

 
         
         		[bookmark: pgfId-248553]Description

  
         		[bookmark: pgfId-248555]Enter a description of the rule.

  
        

 
         
         		[bookmark: pgfId-248561]Advanced button

  
         		[bookmark: pgfId-248566]Click to open the Advanced NAT Options Dialog Box to configure advanced settings for this rule.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-251759][bookmark: 62674][bookmark: pxpage_cncpt_StaticRulesTab]Static Rules Tab[bookmark: marker-251753][bookmark: marker-251755][bookmark: marker-251757]

 
     [bookmark: pgfId-251761]Use the Static Rules tab of the Translation Rules page to view and configure static translation rules for a security appliance or shared policy. Rules are evaluated sequentially in the order listed. The row number indicates the rule’s position in the ordering of the list. You can use the Up Row and Down Row buttons to change the position of the selected rule.

 
     [bookmark: pgfId-251763]With static translation, internal IP addresses are permanently mapped to a global IP address. These rules map a host address on a lower security-level interface to a global address on a higher security-level interface. For example, a static rule would be used for mapping the local address of a web server on a perimeter network to a global address that hosts on the outside interface would use to access the web server.

 
      
      [image: ] 
     
 
     
 
     
      [bookmark: pgfId-251765]
      Caution The order of Static NAT rules on a security device is important, and Security Manager preserves this ordering during deployment. However, security appliances do not support in-line editing of Static NAT rules. This means that if you move, edit, or insert a rule anywhere above the end of the list, Security Manager will remove from the device all Static NAT rules that follow the new or modified rule, and then re-send the updated list from that point. Depending on the length of the list, this can require substantial overhead, and may result in traffic interruption. Whenever possible, add any new Static NAT rules to the end of the list.
       
       
 
      

     
 
     [bookmark: pgfId-251770]The Add/Edit Static Rule dialog box is used to add and edit these rules. Refer to Add/Edit Static Rule Dialog Box for descriptions of the fields displayed in the table on this page.

 
     [bookmark: pgfId-251772]The “Nailed”Column in the Static Rules Table

 
     [bookmark: pgfId-251777]In addition to the columns representing parameters specified in the Add/Edit Static Rule Dialog Box, the Static Rules table displays a column labeled “Nailed.” This value is a product of device discovery; it cannot be changed in Security Manager.

 
     [bookmark: pgfId-251779]The entry in the “Nailed” Column indicates whether TCP state tracking and sequence checking is skipped for the connection: true or false.

 
     [bookmark: pgfId-251781]Navigation Path

 
     [bookmark: pgfId-251786]You can access the Static Rules tab from the Translation Rules page. See Translation Rules: PIX, FWSM, and pre-8.3 ASA for more information.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-251791]Note By default, only standard Static Rules elements are displayed in this table. Additional columns for elements defined in the Advanced NAT Options dialog box can be displayed by right-clicking any column heading. (All columns are displayed by default on the General Tab.)


     
      

     

     

 
     [bookmark: pgfId-251793]Related Topics

 
      
      		 [bookmark: pgfId-251798]Configuring NAT on PIX, FWSM, and pre-8.3 ASA Devices

 
      		 [bookmark: pgfId-251803]Add/Edit Static Rule Dialog Box

 
      		 [bookmark: pgfId-251808]Advanced NAT Options Dialog Box

 
      		 [bookmark: pgfId-251813]General Tab

 
      		 [bookmark: pgfId-251815]Standard rules table topics:

 
     

 
     [bookmark: pgfId-251820] – Using Rules Tables

 
     [bookmark: pgfId-251825] – Filtering Tables

 
     [bookmark: pgfId-251830] – Table Columns and Column Heading Features

 
    
 
     
      [bookmark: pgfId-251844][bookmark: 62731][bookmark: pxpage_cncpt_AddEditStaticRuleDialogBox]Add/Edit Static Rule Dialog Box[bookmark: marker-251838][bookmark: marker-251840][bookmark: marker-251842]

 
     [bookmark: pgfId-251846]Use the Add/Edit Static Rule dialog box to add or edit static translation rules for a firewall device or shared policy.

 
     [bookmark: pgfId-251848]Navigation Path

 
     [bookmark: pgfId-251853]You can access the Add/Edit Static Rule dialog box from the Static Rules Tab.

 
     [bookmark: pgfId-251855]Related Topics

 
      
      		 [bookmark: pgfId-251860]Configuring NAT on PIX, FWSM, and pre-8.3 ASA Devices

 
      		 [bookmark: pgfId-251865]Translation Rules: PIX, FWSM, and pre-8.3 ASA

 
      		 [bookmark: pgfId-251870]Advanced NAT Options Dialog Box

 
     

 
     [bookmark: pgfId-251872]Field Reference

 
     [bookmark: pgfId-251875] 

 
      
       
        
        [bookmark: pgfId-248579]Table 24-12 [bookmark: 62766]Add/Edit Static Rule Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-248585]Element
          
  
         		
           
           [bookmark: pgfId-248587]Description
          
  
        

 
         
         		[bookmark: pgfId-248593]Enable Rule

  
         		[bookmark: pgfId-248595]If checked, the rule is enabled. Deselect this option to disable the rule without deleting it.

  
        

 
         
         		[bookmark: pgfId-248601]Translation Type

  
         		[bookmark: pgfId-248603]Select the type of translation for this rule: NAT or PAT.

  
        

 
         
         		[bookmark: pgfId-248609]Original Interface

  
         		[bookmark: pgfId-248611]Enter (or Select) the device interface connected to the host or network with original addresses to be translated.

  
        

 
         
         		[bookmark: pgfId-248617]Original Address

  
         		[bookmark: pgfId-248619]Enter (or Select) the source address to be translated.

  
        

 
         
         		[bookmark: pgfId-248625]Translated Interface

  
         		[bookmark: pgfId-248627]Enter (or Select) the interface on which the translated addresses are to be used.

 [bookmark: pgfId-248629]To specify this as an identity NAT rule, enter the same interface in both this and the Original Interface fields.

  
        

 
         
         		[bookmark: pgfId-248635]Use Interface IP/Use Selected Address

  
         		[bookmark: pgfId-248637]Specify the address used for the Translated Interface: select Use Interface IP (address), or select Use Selected Address and enter an address, or Select a network/host object.

  
        

 
         
         		[bookmark: pgfId-248643]Enable Policy NAT

  
         		[bookmark: pgfId-248645]Select this option to enable Policy NAT for this translation rule.

  
        

 
         
         		[bookmark: pgfId-248651]Dest Address

  
         		[bookmark: pgfId-248653]If Policy NAT is enabled, specify the destination addresses of the hosts or networks to which the rule applies.

  
        

 
         
         		[bookmark: pgfId-248659]Services

  
         		[bookmark: pgfId-248661]If Policy NAT is enabled, enter or Select the Services to which the rule applies.

 [bookmark: pgfId-248663]Note For Static Policy NAT, IP is the only Service that can be specified.

 [bookmark: pgfId-248665]The syntax for service and service-object specification is:

 [bookmark: pgfId-248667]{tcp | udp | tcp&udp}/{source_port_number | port_list_object}/ {destination_port_number | port_list_object}

 [bookmark: pgfId-248669]Note that if you enter only one port parameter, it is interpreted as the destination port (with a source port of “any”). For example, tcp/4443 means tcp, source port any, destination port 4443, while tcp/4443/Default Range means tcp, source port 4443, and destination port Default Range (generally 1-65535).

 [bookmark: pgfId-248671]As with all text-entry fields, Security Manager may display auto-complete options. For example, if you type tcp/ in this field, an auto-complete list of all Port Lists objects defined in Security Manager is displayed. This list will include system-generated objects such as DEFAULT RANGE, HTTPS and WEBPORTS.

 [bookmark: pgfId-248679]Refer to Configuring Port List Objects for more information about Port Lists, and Configuring Service Objects for more information about defining Services.

  
        

 
         
         		[bookmark: pgfId-248685]Protocol

  
         		[bookmark: pgfId-248687]If PAT is the selected Translation Type, select the protocol, TCP or UDP, to which the rule applies.

  
        

 
         
         		[bookmark: pgfId-248693]Original Port

  
         		[bookmark: pgfId-248695]If PAT is the selected Translation Type, enter the port number to be translated.

 [bookmark: pgfId-248697]Note that this parameter is displayed in the Static Rules table under the column heading “Local Port.”

  
        

 
         
         		[bookmark: pgfId-248703]Translated Port

  
         		[bookmark: pgfId-248705]If PAT is the selected Translation Type, enter the port number to which the original port number will be translated.

 [bookmark: pgfId-248707]Note that this parameter is displayed in the Static Rules table under the column heading “Global Port.”

  
        

 
         
         		[bookmark: pgfId-248713]Category

  
         		[bookmark: pgfId-248718]To assign the rule to a category, choose the category from this list. Categories can help identify rules and objects using labels and color-coding. See Using Category Objects for more information.

 [bookmark: pgfId-248720]Note No commands are generated for the Category attribute.

  
        

 
         
         		[bookmark: pgfId-248726]Description

  
         		[bookmark: pgfId-248728]Enter a description of the rule.

  
        

 
         
         		[bookmark: pgfId-248734]Advanced button

  
         		[bookmark: pgfId-248739]Click to open the Advanced NAT Options Dialog Box to configure advanced settings for this rule.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-251885][bookmark: 62876][bookmark: pxpage_cncpt_EditTranslatedAddress]Edit Translated Address Dialog Box[bookmark: marker-251883]

 
     [bookmark: pgfId-251890]Use the Edit Translated Address dialog box to change just the translated address assigned to a static translation rule. The translated address is the address to which the original address is changed. The interface’s IP address can be used, or you can enter a specific IP address. See Static Rules Tab for more information about static rules and translated addresses.

 
     [bookmark: pgfId-251895]For detailed information on editing firewall rules cells, see Editing Rules.

 
     [bookmark: pgfId-251897]Navigation Path

 
     [bookmark: pgfId-251899]Right-click the Translated Address cell in the Static Rules table (on the NAT > Translation Rules page) and choose Edit Translated Address.

 
    
 
     
      [bookmark: pgfId-251913][bookmark: 62890][bookmark: pxpage_cncpt_AdvancedNATOptionsDialogBox]Advanced NAT Options Dialog Box[bookmark: marker-251907][bookmark: marker-251909][bookmark: marker-251911]

 
     [bookmark: pgfId-251915]Use the Advanced NAT Options dialog box to configure the advanced connection settings—DNS Rewrite, Maximum TCP and Maximum UDP Connections, Embryonic Limit, Timeout (PIX 6.x), and Randomize Sequence Number—for NAT and Policy NAT. You can also configure these options for Translation Exemption (NAT 0 ACL) rules on an FWSM.

 
     [bookmark: pgfId-251917]Navigation Path

 
     [bookmark: pgfId-251919]You can access the Advanced NAT Options dialog box by clicking the Advanced button when adding or editing a translation rule. See the following topics for more information:

 
      
      		 [bookmark: pgfId-251924]Add/Edit Translation Exemption (NAT-0 ACL) Rule Dialog Box

 
      		 [bookmark: pgfId-251929]Add/Edit Dynamic Translation Rule Dialog Box

 
      		 [bookmark: pgfId-251934]Add/Edit Policy Dynamic Rules Dialog Box

 
      		 [bookmark: pgfId-251939]Add/Edit Static Rule Dialog Box

 
     

 
     [bookmark: pgfId-251941]Related Topics

 
      
      		 [bookmark: pgfId-251946]Configuring NAT on PIX, FWSM, and pre-8.3 ASA Devices

 
      		 [bookmark: pgfId-251951]Translation Rules: PIX, FWSM, and pre-8.3 ASA

 
     

 
     [bookmark: pgfId-251953]Field Reference

 
     [bookmark: pgfId-251956] 

 
      
       
        
        [bookmark: pgfId-248752]Table 24-13 [bookmark: 62935]Advanced NAT Options Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-248758]Element
          
  
         		
           
           [bookmark: pgfId-248760]Description
          
  
        

 
         
         		[bookmark: pgfId-248766]Translate the DNS replies that match the translation rule

  
         		[bookmark: pgfId-248768]If checked, the security appliance rewrites DNS replies so an outside client can resolve the name of an inside host using an inside DNS server, and vice versa. For instance, if your NAT rule includes the real address of a host with an entry in a DNS server, and the DNS server is on a different interface from a client, then the client and the DNS server need different addresses for the host: one needs the mapped address and one needs the real address. This option rewrites the address in the DNS reply to the client.

 [bookmark: pgfId-248770]As an example, assume an inside web server, www.example.com, has the IP address 192.168.1.1, which is translated to 10.1.1.1 on the outside interface of the appliance. An outside client sends a DNS request to an inside DNS server, which will resolve www.example.com to 192.168.1.1. When the reply comes to the security appliance with DNS Rewrite enabled, the security appliance will translate the IP address in the payload to 10.1.1.1, so that the outside client will get the correct IP address.

 [bookmark: pgfId-248772]Note that the mapped host needs to be on the same interface as either the client or the DNS server. Typically, hosts that need to allow access from other interfaces use a static translation, so this option is more likely to be used with a static rule.

  
        

 
         
         		[bookmark: pgfId-248778]Max TCP Connections per Rule

  
         		[bookmark: pgfId-248780]Enter the maximum number of TCP connections allowed; valid values are 0 through 65,535. If this value is set to zero, the number of connections is unlimited.

  
        

 
         
         		[bookmark: pgfId-248786]Max UDP Connections per Rule

  
         		[bookmark: pgfId-248788]Enter the maximum number of UDP connections allowed; valid values are 0 through 65,535. If this value is set to zero, the number of connections is unlimited.

  
        

 
         
         		[bookmark: pgfId-248794]Max Embryonic Connections

  
         		[bookmark: pgfId-248796]Enter the number of embryonic connections allowed to form before the security appliance begins to deny these connections. An embryonic connection is a connection request that has not finished the necessary handshake between source and destination. Set this limit to prevent attack by a flood of embryonic connections. Valid values are 0 through 65,535. If this value is set to zero, the number of connections is unlimited.

 [bookmark: pgfId-248798]Any positive value enables the TCP Intercept feature. TCP Intercept protects inside systems from a DoS attack perpetrated by flooding an interface with TCP SYN packets. When the embryonic limit has been surpassed, the TCP Intercept feature intercepts TCP SYN packets from clients to servers on a higher security level. SYN cookies are used during the validation process and help to minimize the amount of valid traffic being dropped. Thus, connection attempts from unreachable hosts will never reach the server.

  
        

 
         
         		[bookmark: pgfId-248804]Timeout

  
         		[bookmark: pgfId-248806]For PIX 6.x devices, enter a timeout value for this translation rule, in the format hh:mm:ss. This value overrides the default translation timeout specified in Platform > Security > Timeouts, unless this value is 00:00:00, in which case translations matching this rule use the default translation timeout (specified in Platform > Security > Timeouts).

  
        

 
         
         		[bookmark: pgfId-248812]Randomize Sequence Number

  
         		[bookmark: pgfId-248814]If checked, the security appliance randomizes the sequence numbers of TCP packets. Each TCP connection has two Initial Sequence Numbers (ISNs): one generated by the client and one generated by the server. The security appliance randomizes the ISN of the TCP SYN in both the inbound and outbound directions. Randomizing the ISN of the protected host prevents an attacker from predicting the next ISN for a new connection and potentially hijacking the new session.

 [bookmark: pgfId-248816]Disable this feature only if:

 
           
           		 [bookmark: pgfId-248818]Another in-line security appliance is also randomizing initial sequence numbers and data is being scrambled.

 
           		 [bookmark: pgfId-248820]You are using eBGP multi-hop through the security appliance, and the eBGP peers are using MD5. Randomization breaks the MD5 checksum.

 
           		 [bookmark: pgfId-248822]You are using a WAAS device which requires that the security appliance not randomize the sequence numbers of connections.

 
          

 [bookmark: pgfId-248824]Disabling this option opens a security hole in the security appliance.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-251970][bookmark: 62990][bookmark: pxpage_cncpt_GeneralTab-2]General Tab[bookmark: marker-251964][bookmark: marker-251966][bookmark: marker-251968]

 
     [bookmark: pgfId-251972]Use the General tab of the Translation Rules page to view a summary of all translation rules defined for the current device or shared policy. The translation rules are listed in the order that they will be evaluated on the device.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-251974]Note The General tab is only visible for PIX, ASA and FWSM devices in router mode, and FWSM 3.2 devices in transparent mode. Other devices in transparent mode support only static translation rules and do not need to display summary information.


     
      

     

     

 
     [bookmark: pgfId-251976]Navigation Path

 
     [bookmark: pgfId-251981]You can access the General tab from the Translation Rules page. See Translation Rules: PIX, FWSM, and pre-8.3 ASA for more information.

 
     [bookmark: pgfId-251983]Related Topics

 
      
      		 [bookmark: pgfId-251988]Configuring NAT on PIX, FWSM, and pre-8.3 ASA Devices

 
      		 [bookmark: pgfId-251993]Translation Exemptions (NAT 0 ACL)

 
      		 [bookmark: pgfId-251998]Dynamic Rules Tab

 
      		 [bookmark: pgfId-252003]Policy Dynamic Rules Tab

 
      		 [bookmark: pgfId-252008]Static Rules Tab

 
      		 [bookmark: pgfId-252010]Standard rules table topics:

 
     

 
     [bookmark: pgfId-252015] – Using Rules Tables

 
     [bookmark: pgfId-252020] – Filtering Tables

 
     [bookmark: pgfId-252025] – Table Columns and Column Heading Features

 
     [bookmark: pgfId-252027]Field Reference

 
     [bookmark: pgfId-252030] 

 
      
       
        
        [bookmark: pgfId-248837]Table 24-14 [bookmark: 63043]General Tab - Translation Rules Summary Table 

 
        
       
         
         		
           
           [bookmark: pgfId-248843]Element
          
  
         		
           
           [bookmark: pgfId-248845]Description
          
  
        

 
         
         		 [bookmark: pgfId-248854]Note Hatching (a series of slanted lines) across an entry in the table indicates that rule is currently disabled. (See Enable Rule in Add/Edit Dynamic Translation Rule Dialog Box for information about enabling and disabling these rules.)

  
        

 
         
         		[bookmark: pgfId-248862]No.

  
         		[bookmark: pgfId-248864]Rules are evaluated sequentially in the order listed. This number indicates the rule’s position in the ordering of the list.

  
        

 
         
         		[bookmark: pgfId-248870]Type

  
         		[bookmark: pgfId-248872]The type of translation rule; for example, Static, Dynamic, Exemption, etc.

  
        

 
         
         		[bookmark: pgfId-248878]Action

  
         		[bookmark: pgfId-248880]Displays “exempt” if the rule is exempt from NAT.

  
        

 
         
         		[bookmark: pgfId-248886]Original Interface

  
         		[bookmark: pgfId-248888]The ID of the device interface to which the rule is applied.

  
        

 
         
         		[bookmark: pgfId-248894]Original Address

  
         		[bookmark: pgfId-248896]The object names or IP addresses of the source hosts and networks to which the rule applies.

  
        

 
         
         		[bookmark: pgfId-248902]Local Port

  
         		[bookmark: pgfId-248904]The port number supplied by the host or network (for static PAT).

  
        

 
         
         		[bookmark: pgfId-248910]Translated Pool

  
         		[bookmark: pgfId-248912]The ID number of the address pool used for translation.

  
        

 
         
         		[bookmark: pgfId-248918]Translated Interface

  
         		[bookmark: pgfId-248920]The interface on which the translated addresses are to be used.

  
        

 
         
         		[bookmark: pgfId-248926]Translated Address

  
         		[bookmark: pgfId-248928]The translated addresses.

  
        

 
         
         		[bookmark: pgfId-248934]Global Port

  
         		[bookmark: pgfId-248936]The port number to which the original port number will be translated (for static PAT).

  
        

 
         
         		[bookmark: pgfId-248942]Destination

  
         		[bookmark: pgfId-248944]The object names and IP addresses of the destination hosts or networks to which the rule applies.

  
        

 
         
         		[bookmark: pgfId-248950]Protocol

  
         		[bookmark: pgfId-248952]The protocol to which the rule applies.

  
        

 
         
         		[bookmark: pgfId-248958]Service

  
         		[bookmark: pgfId-248960]The services to which the rule applies.

  
        

 
         
         		[bookmark: pgfId-248966]Direction

  
         		[bookmark: pgfId-248968]The traffic direction (Inbound or Outbound) on which the rule is applied.

  
        

 
         
         		[bookmark: pgfId-248974]DNS Rewrite

  
         		[bookmark: pgfId-248979]Whether the DNS Rewrite option is enabled: Yes or No. This option is set in the Advanced NAT Options Dialog Box.

  
        

 
         
         		[bookmark: pgfId-248985]Maximum TCP Connections

  
         		[bookmark: pgfId-248990]The maximum number of TCP connections allowed to connect to the statically translated IP address. If zero, the number of connections is unlimited. This option is set in the Advanced NAT Options Dialog Box.

  
        

 
         
         		[bookmark: pgfId-248996]Embryonic Limit

  
         		[bookmark: pgfId-248998]The number of embryonic connections allowed to form before the security appliance begins to deny these connections. If zero, the number of connections is unlimited. A positive number enables the TCP Intercept feature.

 [bookmark: pgfId-249003]This option is set in the Advanced NAT Options Dialog Box.

  
        

 
         
         		[bookmark: pgfId-249009]Maximum UDP Connections

  
         		[bookmark: pgfId-249014]The maximum number of UDP connections allowed to connect to the statically translated IP address. If zero, the number of connections is unlimited. This option is set in the Advanced NAT Options Dialog Box.

  
        

 
         
         		[bookmark: pgfId-249020]Timeout

  
         		[bookmark: pgfId-249022]For PIX 6.x devices, this is the timeout value for a static translation rule. This value overrides the default translation timeout specified in Platform > Security > Timeouts. A Timeout value of 00:00:00 here means that translations matching this rule should use the default translation timeout specified in Platform > Security > Timeouts.

  
        

 
         
         		[bookmark: pgfId-249028]Randomize Sequence Number

  
         		[bookmark: pgfId-249033]Whether the security appliance will randomize the sequence number of TCP packets: Yes or No. This option is set in the Advanced NAT Options Dialog Box, and is enabled by default.

  
        

 
         
         		[bookmark: pgfId-249039]Category

  
         		[bookmark: pgfId-249044]The category to which the rule is assigned. Categories use labels and color-coding to help identify rules and objects. See Using Category Objects for more information.

 [bookmark: pgfId-249046]Note No commands are generated for the Category attribute.

  
        

 
         
         		[bookmark: pgfId-249052]Description

  
         		[bookmark: pgfId-249054]The description of the rule, if provided.

  
        

 
         
         		[bookmark: pgfId-249060]Last Ticket(s)

  
         		[bookmark: pgfId-249065]Shows the ticket(s) associated with last modification to the rule. You can click the ticket ID in the Last Ticket(s) column to view details of the ticket and to navigate to the ticket. If linkage to an external ticket management system has been configured, you can also navigate to that system from the ticket details (see Ticket Management Page).

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-252038][bookmark: 63184][bookmark: NATchap_cncpt_NATASA83]Configuring NAT on ASA 8.3+ Devices[bookmark: marker-252036]

 
     [bookmark: pgfId-252040]The following section describes configuring network address translation on version 8.3 or later ASA devices:

 
      
      		 [bookmark: pgfId-252045]Translation Rules: ASA 8.3+

 
     

 
     [bookmark: pgfId-252050] – Add and Edit NAT Rule Dialog Boxes

 
     [bookmark: pgfId-252055] – Add or Edit Network/Host Dialog Box: NAT Tab

 
      
      		 [bookmark: pgfId-252059] Per-Session NAT Rules: ASA 9.0(1)+ 

 
     

 
     [bookmark: pgfId-252067]See Configuring NAT on PIX, FWSM, and pre-8.3 ASA Devices for information about configuring NAT on other security appliances. Refer to About “Simplified” NAT on ASA 8.3+ Devices for general information about NAT rules, and the changes to NAT configuration implemented on the ASA 8.3.

 
    
 
     
      [bookmark: pgfId-252085][bookmark: 63207][bookmark: NATpage_cncpt_TranslationRulesPage]Translation Rules: ASA 8.3+[bookmark: marker-252075][bookmark: marker-252077][bookmark: marker-252079][bookmark: marker-252081][bookmark: marker-252083]

 
     [bookmark: pgfId-252090]Use the Translation Rules page to manage network address translation (NAT) rules on the selected ASA 8.3+ device. See NAT Policies on Security Devices for information about configuring Translation Rules on other security devices.

 
     [bookmark: pgfId-252092]Two types of NAT rules are displayed in this table: “manual” rules added by you and any other users, and “automatic” rules generated and applied by Security Manager when an object with NAT properties is assigned to the device. These are referred to as “NAT rules” and “Network Object NAT rules,” respectively.

 
     [bookmark: pgfId-252094]Some Features of the Translation Rules Table

 
     [bookmark: pgfId-252099]This Translation Rules table is a standard Security Manager rules table, as described in Using Rules Tables. For example, you can move, show and hide columns; you can re-order the manual rules; and you can right-click certain table cells to edit that parameter. In addition, the following features are specific to this Translation Rules table:

 
      
      		 [bookmark: pgfId-252101]All rules are assigned to one of three pre-defined sections in the table:

 
     

 
     [bookmark: pgfId-252103] – NAT Rules Before – These are rules you or another user have “manually” defined on the device. You can specify that a rule be added to this section by clicking the section heading before adding the rule, although if you do not specify a section, the new rule will be added to this section by default.

 
     [bookmark: pgfId-252111] – Network Object NAT Rules – These are rules generated and ordered automatically by Security Manager when network objects that include NAT properties are assigned to the device. See Add or Edit Network/Host Dialog Box: NAT Tab for information about assigning NAT properties to objects. See the section “The NAT Table” in About “Simplified” NAT on ASA 8.3+ Devices for information about how these rules are ordered.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-252113]Note This section is not displayed in the Translation Rules table in Policy View because these rules are device-specific.


     
      

     

     

 
     [bookmark: pgfId-252115] – NAT Rules After – These also are rules you or another user have manually defined on the device. You can specify that a rule is added to this section by clicking the section heading before adding the rule.

 
     [bookmark: pgfId-252117]The NAT rules listed in this table are processed on a first-match basis; therefore, order is important. Providing a manual section both before and after the automatic rules lets you ensure all your rules are in the appropriate order, since you can re-order rules only within their section. The rules in each section take precedence over the rules in the section below it. For example, the rules in the top, “Before” section take precedence over the rules in the Network Object NAT section, and so on.

 
      
      		 [bookmark: pgfId-252119]The type of each rule—Static, Dynamic PAT, or Dynamic NAT and PAT— is indicated visually in the table by presenting  (S) ,  (DP) , or  (DNP) in blue following the Source parameter in the “Translated” column.

 
      		 [bookmark: pgfId-252121]A Bi-directional rule is a static rule that actually consists of two paired rules, one each for outgoing and incoming translation of the specified source and destination values. Each Bi-directional rule entry in the rules table is presented as two lines.

 
     

 
     [bookmark: pgfId-252123]For example, if Bi-directional is chosen when you create a static rule with Host1 in the Source field and Host2 in the Translated field, two lines are added to the rules table: one with Host1 being translated to Host2, and one with Host2 being translated to Host1.

 
     [bookmark: pgfId-252125]Related Topics

 
      
      		 [bookmark: pgfId-252130]NAT Policies on Security Devices

 
      		 [bookmark: pgfId-252135]About “Simplified” NAT on ASA 8.3+ Devices

 
      		 [bookmark: pgfId-252137]Standard rules table topics:

 
     

 
     [bookmark: pgfId-252142] – Using Rules Tables

 
     [bookmark: pgfId-252147] – Filtering Tables

 
     [bookmark: pgfId-252152] – Table Columns and Column Heading Features

 
     [bookmark: pgfId-252154]Navigation Path

 
      
      		 [bookmark: pgfId-252156](Device view) Select  NAT > Translation Rules from the Device Policy selector.

 
      		 [bookmark: pgfId-252158](Policy view) Select  NAT (PIX/ASA/FWSM) > Translation Rules from the Policy Type selector. Select an existing policy from the Shared Policy selector, or right-click  Translation Rules to create a new policy.

 
     

 
     [bookmark: pgfId-252160]The Translation Rules page is displayed. Note that in Policy View, the Network Object NAT Rules section is not displayed because those rules are device-specific.

 
     [bookmark: pgfId-252162]Adding, Editing and Deleting Rules

 
     [bookmark: pgfId-252164]To add a NAT rule:

 
     [bookmark: pgfId-252166] 1. Select the heading of the section to which the rule is to be added. If you do not select a heading, the rule will be added to NAT Rules Before by default.

 
     [bookmark: pgfId-252168] 2. Open the Add NAT Rule dialog box: either click the Add Row button at the bottom of the table, or right-click anywhere in the table (except on an existing rule entry) and choose Add Row from the pop-up menu.

 
     [bookmark: pgfId-252170] 3. Define the rule and then click OK to close the dialog box, adding the rule to the table.

 
     [bookmark: pgfId-252172]To edit a NAT rule:

 
     [bookmark: pgfId-252174] 1. Open the Edit NAT Rule dialog box for the desired rule: either select the rule in the NAT rules table and then click the Edit Row button at the bottom of the table, or simply right-click the desired rule entry and choose Edit Row from the pop-up menu.

 
     [bookmark: pgfId-252176] 2. Edit the rule and then click OK to close the dialog box.

 
     [bookmark: pgfId-252181]See Add and Edit NAT Rule Dialog Boxes for a complete description of the Add NAT Rule dialog box.

 
     [bookmark: pgfId-252183]To delete a NAT rule, select the rule in the table and click the Delete Row button at the bottom of the table, or simply right-click the desired rule entry and choose Delete Row from the pop-up menu.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-252188]Note To remove a Network Object NAT rule from this table, you must uncheck the Add Automatic Address Translation NAT Rule option, or change the device to which the rule is assigned, in the related Edit Network Host dialog box. See Add or Edit Network/Host Dialog Box: NAT Tab for additional information.


     
      

     

     

 
     [bookmark: pgfId-252190]Enabling and Disabling Rules

 
     [bookmark: pgfId-252192]You can disable one or more consecutive rules without removing them from the table, as follows:

 
     [bookmark: pgfId-252194] 1. Select the rule(s) to be disabled. If selecting a contiguous block of rules, click the first and then Shift-click the last rule of the block.

 
     [bookmark: pgfId-252196] 2. Right-click a selected rule, and choose Disable from the pop-up menu.

 
     [bookmark: pgfId-252198]Disabled rules are grayed-out in the table.

 
     [bookmark: pgfId-252200]To re-enable one or one or more consecutive disabled rules, repeat this process, choosing Enable from the pop-up menu.

 
    
 
     
      [bookmark: pgfId-252218][bookmark: 63329][bookmark: NATpage_cncpt_AddEditManualNATRule]Add and Edit NAT Rule Dialog Boxes[bookmark: marker-252208][bookmark: marker-252210][bookmark: marker-252212][bookmark: marker-252214][bookmark: marker-252216]

 
     [bookmark: pgfId-252223]Use the Add NAT Rule dialog box to add a NAT rule to the selected ASA 8.3+ device; this dialog box is not available on earlier-version ASAs, nor on PIX or FWSM devices. Refer to Configuring NAT on PIX, FWSM, and pre-8.3 ASA Devices for information about adding and editing NAT rules on those devices.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-252225]Note Except for their titles, the Add NAT Rule and Edit NAT Rule dialog boxes are identical, and the following descriptions apply to both.


     
      

     

     

 
     [bookmark: pgfId-252227]Navigation Path

 
     [bookmark: pgfId-252229]To add a rule, select the section to which you want the rule added (NAT Rules Before or NAT Rules After), and then click the Add Row button below the rules table, or right-click anywhere inside the table and choose Add Row to open the Add NAT Rule dialog box. Note that if you do not select a section, the new rule is added to the NAT Rules Before section.

 
     [bookmark: pgfId-252231]To edit a rule, select the rule and click the Edit Row button, or simply right-click the rule and choose the Edit Row command, to open the Edit NAT Rule dialog box for that rule.

 
     [bookmark: pgfId-252233]Related Topics

 
      
      		 [bookmark: pgfId-252238]Chapter 24, “Configuring Network Address Translation”

 
      		 [bookmark: pgfId-252243]Translation Rules: ASA 8.3+

 
      		 [bookmark: pgfId-252248]Add or Edit Network/Host Dialog Box: NAT Tab

 
     

 
     [bookmark: pgfId-252250]Field Reference

 
     [bookmark: pgfId-252253] 

 
      
       
        
        [bookmark: pgfId-249078]Table 24-15 [bookmark: 63373]Add and Edit NAT Rule Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-249084]Element
          
  
         		
           
           [bookmark: pgfId-249086]Description
          
  
        

 
         
         		[bookmark: pgfId-249092]Source Interface

  
         		[bookmark: pgfId-249094]The name of the interface on which a packet may originate; this is the “real” interface. Defaults to “any,” which represents all interfaces. Enter or Select the desired interface.

 [bookmark: pgfId-249096]Note In transparent firewall mode, you must set specific interfaces.

  
        

 
         
         		[bookmark: pgfId-249102]Destination Interface

  
         		[bookmark: pgfId-249104]Destination Interface – The name of the interface on which a packet may terminate; this is the “mapped” interface. Defaults to “any,” which represents all interfaces. Enter or Select the desired interface.

 [bookmark: pgfId-249106]Note In transparent firewall mode, you must set specific interfaces.

  
        

 
         
         		[bookmark: pgfId-249112]Source NAT Type

  
         		[bookmark: pgfId-249114]The type of translation rule you are creating:

 
           
           		 [bookmark: pgfId-249116] Static – Provides static assignment of real addresses to mapped addresses.

 
           		 [bookmark: pgfId-249118] Dynamic PAT (Hide) – Provides dynamic assignment of multiple local addresses to a single global IP address and a unique port number, in effect “hiding” the local addresses behind the one global address.

 
           		 [bookmark: pgfId-249120] Dynamic NAT and PAT – Provides dynamic assignment of real addresses to mapped addresses, and real ports to mapped ports.

 
          

 [bookmark: pgfId-249122]Selecting this option adds the PAT Pool Address Translation options to the dialog box. On devices operating in routed mode, this option also provides the fallthrough option described below.

 [bookmark: pgfId-249124]Note This selection applies only to the specified source translation; destination translation is always static.

  
        

 
         
         		 
           
           [bookmark: pgfId-249130]Source Translation
          
  
        

 
         
         		[bookmark: pgfId-249138]Original Source

  
         		[bookmark: pgfId-249140]The source address the NAT rule will translate. If this is a range or network, all addresses in the range or network are translated.

  
        

 
         
         		[bookmark: pgfId-249146]Translated Source

 [bookmark: pgfId-249148]Address

 [bookmark: pgfId-249150]Interface

  
         		[bookmark: pgfId-249152]Whether the translation is based on an address or an interface on the device. Select either:

 
           
           		 [bookmark: pgfId-249154] Address – Translate the original address using the Networks/Hosts object specified in the Translated Source field. This entry represents the pool of translation addresses: enter or Select the desired Networks/Hosts; defaults to the Original Source (which will produce an Identity NAT rule).

 
           		 [bookmark: pgfId-249156] Interface – Translate the original address based on the interface specified in the Destination Interface field.

 
          

 [bookmark: pgfId-249158]For port address translation based on this interface, be sure to configure the options in the Service Translation section (in the Advanced panel of this dialog box).

 [bookmark: pgfId-249160]If the Destination Interface is not defined, the Address/Interface selection reverts to Address and the Original Source is inserted into the Address field. This produces an Identity NAT rule, meaning the specified address(es) are translated to themselves (effectively not translated); Identity NAT applies to outbound connections only.

 [bookmark: pgfId-249162]Note These options are not available when Dynamic NAT and PAT is the selected Type, nor are they available on devices operating in transparent mode.

  
        

 
         
         		[bookmark: pgfId-249168]PAT Pool Address Translation

  
         		[bookmark: pgfId-249173]This option is available when Dynamic NAT and PAT is the selected Type. The related parameters let you specify a “pool” of IP addresses to be used for specifically for port address translation, as well as change the algorithm used for PAT mapping. Refer to PAT Pools and Round Robin Allocation for additional information about these features.

 [bookmark: pgfId-249175]Check the PAT Pool Address Translation box to enable the following options:

 
           
           		 [bookmark: pgfId-249177] Address or  Interface – Select Address to indicate that the PAT Pool Address field contains networks/hosts (or networks/hosts objects) for use as the PAT pool. Select Interface to provide a Fallthrough Interface.

 
           		 [bookmark: pgfId-249179] Address – Enter or Select the desired Networks/Hosts or desired Interface according to your Address or Interface selection above.

 
           		 [bookmark: pgfId-249184] Use Round Robin Allocation – Check this box to map addresses/ports using a “round-robin” approach. See PAT Pools and Round Robin Allocation for more information about this option.

 
           		 [bookmark: pgfId-249186] Extended PAT Table (Available for ASA 8.4(3) and later, not including 8.5(1) or 8.6(1)) - Check this box to enable extended PAT. Extended PAT uses 65535 ports per service, as opposed to per IP address, by including the destination address and port in the translation information. Normally, the destination port and address are not considered when creating PAT translations, so you are limited to 65535 ports per PAT address. For example, with extended PAT, you can create a translation of 10.1.1.1:1027 when going to 192.168.1.7:23 as well as a translation of 10.1.1.1:1027 when going to 192.168.1.7:80. This option is available for ASA 8.4(3) and later, not including 8.5(1) or 8.6(1).

 
           		 [bookmark: pgfId-249188] Flat Port Range (Available for ASA 8.4(3) and later, not including 8.5(1) or 8.6(1)) - Check this box to enable use of the entire 1024 to 65535 port range when allocating ports. When choosing the mapped port number for a translation, the ASA uses the real source port number if it is available. However, without this option, if the real port is not available, by default the mapped ports are chosen from the same range of ports as the real port number: 1 to 511, 512 to 1023, and 1024 to 65535. To avoid running out of ports at the low ranges, configure this setting. To use the entire range of 1 to 65535, also select  Include Reserve Ports .

 
           		 [bookmark: pgfId-249190] Include Reserve Ports (Available for ASA 8.4(3) and later, not including 8.5(1) or 8.6(1)) - Check this box to include the reserve ports, 1-1023, in the PAT range.

 
           		 [bookmark: pgfId-249192] Block Allocation (Available for ASA 9.5(1) and later) – Check this box to allocate a block of ports per host. This feature is supported from Security Manager version 4.9 onwards for ASA devices 9.5(1) or higher.

 
          

  
        

 
         
         		 [bookmark: pgfId-249198]Destination Translation

 [bookmark: pgfId-249200]Use the options in this section to configure optional static translation of destination addresses:

 [bookmark: pgfId-249202]Note If defined, Destination Translation is always static, regardless of the rule Type.

 [bookmark: pgfId-249204]Note These options are not available on devices operating in transparent mode.

  
        

 
         
         		[bookmark: pgfId-249212]Original Destination

 [bookmark: pgfId-249214]Address

 [bookmark: pgfId-249216]Interface

  
         		[bookmark: pgfId-249218]Whether the translation is based on an address or an interface on the device. Select either:

 
           
           		 [bookmark: pgfId-249220] Address - Translate the original destination using the Networks/Hosts object specified in the Translated Destination field.

 
          

 [bookmark: pgfId-249222]If Address is selected, specify the Networks/Hosts object, whose original destination addresses should be translated, in the Original Destination entry field.

 
           
           		 [bookmark: pgfId-249224] Interface – Translate the original destination using the Networks/Hosts object specified in the Translated Destination field.

 
          

 [bookmark: pgfId-249226]If Interface is selected, enter or select the desired interface in the Destination Interface field. The Interface Selector list contains all interfaces currently defined on the device.

  
        

 
         
         		[bookmark: pgfId-249232]Translated Destination

  
         		[bookmark: pgfId-249234]This entry represents the pool of destination addresses to use for translation: enter or select the desired Networks/Hosts object.

  
        

 
         
         		 [bookmark: pgfId-249240]Service Translation

 [bookmark: pgfId-249242]Use the options in this section to configure port address translation.

 [bookmark: pgfId-249247]These service objects represent a service protocol (TCP or UDP), and one or more ports. The mapping of original ports to translated port is circular. That is, the first original value is mapped to the first translated value, and the second original value is mapped to the second translated value, and so on until all original values are translated. If the pool of translated port is exhausted before that point, mapping continues using the first translated value again. See Understanding and Specifying Services and Service and Port List Objects for information about configuring service objects.

 option cannot be used together.

  
        

 
         
         		[bookmark: pgfId-249257]Original Service

  
         		[bookmark: pgfId-249259]Enter or select the Service object that defines the service(s) to be translated. Leave the Original Service field blank to configure translation of any service to the specified Translated Service.

 [bookmark: pgfId-249261]Note The protocol specified in both Service objects must be the same.

  
        

 
         
         		[bookmark: pgfId-249267]Translated Service

  
         		[bookmark: pgfId-249269]Enter or select the Service object that provides the service(s) to be used for translation.

  
        

 
         
         		 [bookmark: pgfId-249281][bookmark: NATpage_cncpt_AddEditManualNATRule_noproxyarp][bookmark: marker-249277][bookmark: marker-249279]Options

  
        

 
         
         		[bookmark: pgfId-249289]Translate DNS replies that match this rule

  
         		[bookmark: pgfId-249291]When checked, addresses embedded in DNS replies that match this rule are rewritten.

 [bookmark: pgfId-249293]For DNS replies traversing from a mapped interface to a real interface, the Address (or “A”) record is rewritten from the mapped value to the real value. Conversely, for DNS replies traversing from a real interface to a mapped interface, the A record is rewritten from the real value to the mapped value. Note that DNS inspection must be enabled to support this functionality.

  
        

 
         
         		[bookmark: pgfId-249299]Fallthrough to Interface PAT (Destination Interface)

  
         		[bookmark: pgfId-249301]When checked, dynamic PAT back-up is enabled. When the pool of dynamic NAT addresses is depleted, port address translation is performed, using the address pool specified in the Use Address field. This option is available only when Dynamic NAT and PAT is the chosen Type on devices operating in routed mode.

  
        

 
         
         		[bookmark: pgfId-249307]IPv6

  
         		[bookmark: pgfId-249309]When selected, the IPv6 address of the interface is used.

  
        

 
         
         		[bookmark: pgfId-249315]Net to net mapping of IPv4 to IPv6

  
         		[bookmark: pgfId-249317]When checked, translates the first IPv4 address to the first IPv6 address, the second to the second, and so on. Without this option, the IPv4-embedded method is used where the 32-bits of the IPv4 address is embedded after the IPv6 prefix. For a one-to-one translation, you must select this option.

  
        

 
         
         		[bookmark: pgfId-249323]Do not proxy ARP on Destination Interface

  
         		[bookmark: pgfId-249325]Check this box to disable proxy ARP on the specified Destination Interface. This option is available only when Static is the chosen rule Type.

 [bookmark: pgfId-249327]Note This option is available on ASA 8.4.2+ devices, only when Bidirectional is the chosen Direction.

 [bookmark: pgfId-249329]By default, all NAT rules include proxy ARP on the egress interface. A NAT Exempt rule is used to bypass NAT for both ingress and egress traffic, relying on route look-up to locate the egress interface. Thus, Proxy ARP should be disabled for NAT Exempt rules. (The NAT Exempt rules always take priority and appear above all other NAT rules in the Translation Rules table.)

 [bookmark: pgfId-249334]Note You also can disable Proxy ARP on individual interfaces, as described in Configuring No Proxy ARP.

  
        

 
         
         		[bookmark: pgfId-249340]Perform route lookup for Destination Interface

  
         		[bookmark: pgfId-249342]If this option is selected, the egress interface is determined using route look-up instead of using the specified Destination Interface. Be sure this box is checked for a NAT Exempt rule. This option is supported only for Static Identity NAT.

 [bookmark: pgfId-249344]Note This option is available on ASA 8.4.2+ devices, only when Bidirectional is the chosen Direction. The option is not available on devices operating in transparent mode.

  
        

 
         
         		[bookmark: pgfId-249350]Unidirectional

  
         		[bookmark: pgfId-249352]This feature lets you configure a static NAT rule in a single direction only; or dual rules, one each for both directions (forward and reverse).

 [bookmark: pgfId-249354]When selected, a single static NAT is created, as specified by the other options in this dialog box. Dynamic rules are uni-directional by default.

 [bookmark: pgfId-249356]If deselected, two linked static NAT rules are created, encompassing both directions of the translation, as specified by the other options in this dialog box. Note that each bi-directional rule entry in the rules table consists of two lines.

  
        

 
         
         		[bookmark: pgfId-249362]Description

  
         		[bookmark: pgfId-249364](Optional) Provide a description of the rule.

  
        

 
         
         		[bookmark: pgfId-249370]Category

  
         		[bookmark: pgfId-249375](Optional) Choose a category to assign to the rule. Categories can help you organize and identify rules and objects; see Using Category Objects for more information.

 [bookmark: pgfId-249377]Note This option is not available when Dynamic NAT and PAT is the chosen rule Type.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-252267][bookmark: 63591][bookmark: NATchap_cncpt_PATPoolsRoundRobin]PAT Pools and Round Robin Allocation [bookmark: marker-252259][bookmark: marker-252261][bookmark: marker-252263][bookmark: marker-252265]

 
     [bookmark: pgfId-252269]Adaptive Security Appliances, version 8.4.2 and later, include two features that let you alter how port address translation (PAT) occurs: you can explicitly define a pool of IP addresses specifically for PAT, and you can select a “round robin” algorithm for port allocation during PAT.

 
     [bookmark: pgfId-252271]These features simplify configuration of large numbers of PAT addresses, and help prevent a large number of connections from a single PAT address, which can appear to be part of a DoS attack.

 
     [bookmark: pgfId-252273]Explicit PAT Pool Definition

 
     [bookmark: pgfId-252275]Prior to version 8.4.2, when you defined a Dynamic NAT and PAT rule, you provided a “pool” of IP addresses (in the Translated Source field of the Add/Edit NAT Rule dialog boxes) to be used for translation. This pool could consist of individual IP addresses, ranges of addresses, Networks/Hosts objects, or Network/Host group objects, and combinations thereof.

 
     [bookmark: pgfId-252277]Ranges and objects with more than one IP address were considered to be in the “NAT Pool,” while individual IP addresses and group objects consisting of one or more individual addresses were considered to be part of the “PAT Pool.”

 
     [bookmark: pgfId-252279]Address translation on the device would work its way through the NAT Pool until all available addresses were exhausted. Port address translation would then begin using the PAT Pool—assigning ports on the first IP address in the PAT Pool until all ports (approximately 64,000) are assigned, then assigning ports on the next address in the pool, and so on. When all ports are fully subscribed on all IP addresses in the PAT Pool, no further translation could occur.

 
     [bookmark: pgfId-252281]On version 8.4.2 and later ASA devices, you can explicitly define a separate PAT Pool for a Dynamic NAT and PAT rule. If you do so, the first collection of addresses (defined in the Translated Source field) is considered the NAT Pool, while the PAT Pool addresses are specified in the PAT Pool Address Translation field.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-252283]Note If you do not explicitly specify a PAT Pool, address translation takes place as described for pre-8.4.2 devices.


     
      

     

     

 
     [bookmark: pgfId-252288]Refer to Add and Edit NAT Rule Dialog Boxes for more information about the defining translation rules.

 
     [bookmark: pgfId-252290]Round Robin Port Assignment

 
     [bookmark: pgfId-252292]On version 8.4.2 and later ASA devices, you also can specify an alternate method of port assignment during PAT processing. As mentioned earlier, PAT port numbers are assigned to a single IP address in succession until the final port number is assigned, and then the process begins again with the next available IP address in the pool.

 
     [bookmark: pgfId-252294]However, a new parameter on 8.4.2 and later devices—Use Round Robin Allocation for PAT Pool—lets you specify “round robin” cycling through available IP addresses and port numbers. This method assigns an address/port combination using each successive address in the pool; it then uses the first address again with a different port, proceeds to the second address again, and so on.

 
     [bookmark: pgfId-252296]Further, the round-robin algorithm incorporates two additional principles it will attempt to adhere to when assigning address/port combinations during PAT processing:

 
      
      		 [bookmark: pgfId-252298]If a specific source-to-destination mapping already exists, the algorithm attempts to use the existing translation for the new connection. If this is not possible (for example, when all ports for that IP address have been exhausted), the algorithm proceeds with standard round-robin cycling.

 
      		 [bookmark: pgfId-252300]If possible, the original source port number is used as the mapped port number. That is, if the port number of the address/port combination to be translated is 4904, for example, and 4904 is available with the next IP address in the PAT Pool, the translated address will be  PAT_address /4904. Note if this is not possible (that port is not available with the next PAT address), the algorithm proceeds with standard round-robin cycling.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-252302]Note If you do not explicitly specify Round Robin Allocation, port-allocation cycling occurs as described for pre-8.4.2 devices.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-252318][bookmark: 63629][bookmark: pobjpage_cncpt_NetworkHostDialogBoxNATTab]Add or Edit Network/Host Dialog Box: NAT Tab[bookmark: marker-252312][bookmark: marker-252314][bookmark: marker-252316]

 
     [bookmark: pgfId-252320]Use the NAT tab in any of the dialog boxes used to add or edit host, network, or address range objects to create or update object NAT rules. This NAT configuration is used only for ASA 8.3+ devices; if you use the object on any other type of device, the NAT configuration is ignored.

 
     [bookmark: pgfId-252322]The NAT configuration is created as a device override and is not kept in the global object. Therefore, you must select the Allow Value Override per Device option if you configure these NAT options. (This option is selected automatically when you close the dialog box.)

 
     [bookmark: pgfId-252327]This topic describes the fields on the NAT tab. For information about the fields on the General tab, see Add or Edit Network/Host Dialog Box.

 
     [bookmark: pgfId-252329]Navigation Path

 
     [bookmark: pgfId-252334]Select the NAT tab on the Add or Edit Network/Host Dialog Box when creating or editing a host, network, or address range object.

 
     [bookmark: pgfId-252336]Related Topics

 
      
      		 [bookmark: pgfId-252341]Chapter 24, “Configuring Network Address Translation”

 
      		 [bookmark: pgfId-252346]Creating Networks/Hosts Objects

 
      		 [bookmark: pgfId-252351]Understanding Networks/Hosts Objects

 
      		 [bookmark: pgfId-252356]Specifying IP Addresses During Policy Definition

 
      		 [bookmark: pgfId-252361]Policy Object Manager

 
     

 
     [bookmark: pgfId-252363]Field Reference

 
     [bookmark: pgfId-252366] 

 
      
       
        
        [bookmark: pgfId-249390]Table 24-16 [bookmark: 63673]Network/Host Dialog Box NAT Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-249396]Element
          
  
         		
           
           [bookmark: pgfId-249398]Description
          
  
        

 
         
         		[bookmark: pgfId-249404]Add Automatic Address Translation NAT Rule

  
         		[bookmark: pgfId-249409]If checked, a network address translation (NAT) rule, as defined here, will be applied to the device specified in the Translated By field. The rule will appear in the Network Object NAT Rule section of the Translation Rules table for that device (see Translation Rules: ASA 8.3+).

  
        

 
         
         		[bookmark: pgfId-249415]Translated By

  
         		[bookmark: pgfId-249417]The device on which you are configuring the NAT rule. Click Select to select the device from a list. The list is filtered to show only ASA 8.3+ devices.

  
        

 
         
         		[bookmark: pgfId-249423]Source Interface

  
         		[bookmark: pgfId-249425]The name of the interface on which a packet may originate; this is the “real” interface. Defaults to any, which represents all interfaces.

  
        

 
         
         		[bookmark: pgfId-249431]Destination Interface

  
         		[bookmark: pgfId-249433]The name of the interface on which a packet may terminate; this is the “mapped” interface. Defaults to any, which represents all interfaces.

  
        

 
         
         		[bookmark: pgfId-249439]Type

  
         		[bookmark: pgfId-249441]The type of translation rule you are creating:

 
           
           		 [bookmark: pgfId-249443] Static – Enables static assignment of real addresses to mapped addresses.

 
           		 [bookmark: pgfId-249445] PAT (Hide) – Enables dynamic assignment of multiple local addresses to a single global IP address and a unique port number.

 
           		 [bookmark: pgfId-249447] Dynamic NAT and PAT – Enables dynamic assignment of real addresses to mapped addresses, and real ports to mapped ports.

 
          

  
        

 
         
         		 
           
           [bookmark: pgfId-249453]Source Translation
          
  
        

 
         
         		[bookmark: pgfId-249461]Original value

  
         		[bookmark: pgfId-249463]Shows the address configured on the General tab of this dialog box. This is the source address the NAT rule will translate. If it is a range or network, all addresses in the range or network will be translated.

  
        

 
         
         		[bookmark: pgfId-249469]Translated Source

 [bookmark: pgfId-249471]Use Address

 [bookmark: pgfId-249473]Use Interface (available only for Static and PAT)

  
         		[bookmark: pgfId-249475]Whether the translation is based on an address or an interface on the device:

 
           
           		 [bookmark: pgfId-249477] Use Address —Translate the original address using the specified address or network/host object. Enter the address or object name in the  Address field, or click Select to select the object from a list.

 
           		 [bookmark: pgfId-249479] Use Interface – Translate the original address based on the interface specified in the Destination Interface field.

 
          

 [bookmark: pgfId-249481]Note The Use Interface options are available only when either Static or PAT (Hide) is chosen as the Type.

  
        

 
         
         		[bookmark: pgfId-249487]PAT Pool Address Translation

  
         		[bookmark: pgfId-249492]This option is available when Dynamic NAT and PAT is the selected Type. The related parameters let you specify a “pool” of IP addresses to be used for specifically for port address translation, as well as change the algorithm used for PAT mapping. Refer to PAT Pools and Round Robin Allocation for additional information about these features.

 [bookmark: pgfId-249494]Check the PAT Pool Address Translation box to enable the following options:

 
           
           		 [bookmark: pgfId-249496] Use Address or  Use Interface – Select Use Address to indicate that the PAT Pool Address field contains networks/hosts (or networks/hosts objects) for use as the PAT pool. Select Use Interface to provide a Fallthrough Interface.

 
           		 [bookmark: pgfId-249498] PAT Pool Address – Enter or Select the desired Networks/Hosts or desired Interface according to your Address or Interface selection above.

 
           		 [bookmark: pgfId-249503] Use Round Robin Allocation for PAT Pool – Check this box to map addresses/ports using a “round-robin” approach. See PAT Pools and Round Robin Allocation for more information about this option.

 
           		 [bookmark: pgfId-249505] Extended PAT Table (Available for ASA 8.4(3) and later, not including 8.5(1) or 8.6(1)) - Check this box to enable extended PAT. Extended PAT uses 65535 ports per service, as opposed to per IP address, by including the destination address and port in the translation information. Normally, the destination port and address are not considered when creating PAT translations, so you are limited to 65535 ports per PAT address. For example, with extended PAT, you can create a translation of 10.1.1.1:1027 when going to 192.168.1.7:23 as well as a translation of 10.1.1.1:1027 when going to 192.168.1.7:80. This option is available for ASA 8.4(3) and later, not including 8.5(1) or 8.6(1).

 
           		 [bookmark: pgfId-249507] Flat Port Range (Available for ASA 8.4(3) and later, not including 8.5(1) or 8.6(1)) - Check this box to enable use of the entire 1024 to 65535 port range when allocating ports. When choosing the mapped port number for a translation, the ASA uses the real source port number if it is available. However, without this option, if the real port is not available, by default the mapped ports are chosen from the same range of ports as the real port number: 1 to 511, 512 to 1023, and 1024 to 65535. To avoid running out of ports at the low ranges, configure this setting. To use the entire range of 1 to 65535, also select  Include Reserve Ports .

 
           		 [bookmark: pgfId-249509] Include Reserve Ports (Available for ASA 8.4(3) and later, not including 8.5(1) or 8.6(1)) - Check this box to include the reserve ports, 1-1023, in the PAT range.

 
          

  
        

 
         
         		 [bookmark: pgfId-249515]Service Translation

 [bookmark: pgfId-249517]Use the options in this section of the Advanced panel to configure static port address translation:

 [bookmark: pgfId-249519](Available for Static rules only.)

 option cannot be used together.

  
        

 
         
         		[bookmark: pgfId-249529]Protocol

  
         		[bookmark: pgfId-249531]Whether a TCP or UDP port.

  
        

 
         
         		[bookmark: pgfId-249537]Original Port

  
         		[bookmark: pgfId-249539]The port on which the traffic enters the device.

  
        

 
         
         		[bookmark: pgfId-249545]Translated Port

  
         		[bookmark: pgfId-249547]The port number which is to replace the original port number.

  
        

 
         
         		 [bookmark: pgfId-249557][bookmark: marker-249553][bookmark: marker-249555]Options

  
        

 
         
         		[bookmark: pgfId-249565]Translate DNS replies that match this rule

  
         		[bookmark: pgfId-249567]When checked, addresses embedded in DNS replies that match this rule are rewritten.

 [bookmark: pgfId-249569]For DNS replies traversing from a mapped interface to a real interface, the Address (or “A”) record is rewritten from the mapped value to the real value. Conversely, for DNS replies traversing from a real interface to a mapped interface, the A record is rewritten from the real value to the mapped value. Note that DNS inspection must be enabled to support this functionality.

 [bookmark: pgfId-249571]Note This option and Service Translation cannot be used together.

  
        

 
         
         		[bookmark: pgfId-249577]Fallthrough to Interface PAT (Destination Interface)

  
         		[bookmark: pgfId-249579]When checked, dynamic PAT back-up is enabled. When the pool of dynamic NAT addresses is depleted, port address translation is performed, using the address pool specified in the Use Address field. This option is available only when Dynamic NAT and PAT is the chosen Type on devices operating in routed mode.

  
        

 
         
         		[bookmark: pgfId-249585]IPv6

  
         		[bookmark: pgfId-249587]When selected, the IPv6 address of the interface is used.

  
        

 
         
         		[bookmark: pgfId-249593]Net to net mapping of IPv4 to IPv6

  
         		[bookmark: pgfId-249595]When checked, translates the first IPv4 address to the first IPv6 address, the second to the second, and so on. Without this option, the IPv4-embedded method is used where the 32-bits of the IPv4 address is embedded after the IPv6 prefix. For a one-to-one translation, you must select this option.

  
        

 
         
         		[bookmark: pgfId-249601]Do not proxy ARP on Destination Interface

  
         		[bookmark: pgfId-249603]Check this box to disable proxy ARP on the specified Destination Interface. This option is available only when Static is the chosen rule Type.

 [bookmark: pgfId-249605]By default, all NAT rules include proxy ARP on the egress interface. A NAT Exempt rule is used to bypass NAT for both ingress and egress traffic, relying on route look-up to locate the egress interface. Thus, Proxy ARP should be disabled for NAT Exempt rules. (The NAT Exempt rules always take priority and appear above all other NAT rules in the Translation Rules table.)

 [bookmark: pgfId-249610]Note You also can disable Proxy ARP on individual interfaces, as described in Configuring No Proxy ARP.

  
        

 
         
         		[bookmark: pgfId-249616]Perform route lookup for Destination Interface

  
         		[bookmark: pgfId-249618]If this option is selected, the egress interface is determined using route look-up instead of using the specified Destination Interface. Be sure this box is checked for a NAT Exempt rule. This option is supported only for Static Identity NAT.

 [bookmark: pgfId-249620]Note This option is not available on devices operating in transparent mode.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-252384][bookmark: 63851][bookmark: NATpage_cncpt_PerSessionNATRulesPage]Per-Session NAT Rules: ASA 9.0(1)+[bookmark: marker-252374][bookmark: marker-252376][bookmark: marker-252378][bookmark: marker-252380][bookmark: marker-252382]

 
     [bookmark: pgfId-252386]Use the Per-Session NAT Rules page to configure per-session PAT rules on the selected ASA 9.0(1)+ device. By default, all TCP PAT traffic and all UDP DNS traffic uses per-session PAT. You can configure per-session rules to use multi-session PAT for specific traffic.

 
     [bookmark: pgfId-252388]Per-Session PAT vs. Multi-Session PAT (Version 9.0(1) and Later)

 
     [bookmark: pgfId-252390]The per-session PAT feature improves the scalability of PAT and, for clustering, allows each member unit to own PAT connections; multi-session PAT connections have to be forwarded to and owned by the master unit. At the end of a per-session PAT session, the ASA sends a reset and immediately removes the xlate. This reset causes the end node to immediately release the connection, avoiding the TIME_WAIT state. Multi-session PAT, on the other hand, uses the PAT timeout, by default 30 seconds. For "hit-and-run" traffic, such as HTTP or HTTPS, the per-session feature can dramatically increase the connection rate supported by one address. Without the per-session feature, the maximum connection rate for one address for an IP protocol is approximately 2000 per second. With the per-session feature, the connection rate for one address for an IP protocol is 65535/average-lifetime.

 
     [bookmark: pgfId-252392]By default, all TCP traffic and UDP DNS traffic use a per-session PAT xlate. For traffic that can benefit from multi-session PAT, such as H.323, SIP, or Skinny, you can disable per-session PAT by creating a per-session deny rule.

 
     [bookmark: pgfId-252394]Some Features of the Per-Session NAT Rules Table

 
     [bookmark: pgfId-252399]This Translation Rules table is a standard Security Manager rules table, as described in Using Rules Tables. For example, you can move, show and hide columns; you can re-order the rules; and you can right-click certain table cells to edit that parameter.

 
     [bookmark: pgfId-252401]The NAT rules listed in this table are processed on a first-match basis; therefore, order is important.

 
     [bookmark: pgfId-252403]Related Topics

 
      
      		 [bookmark: pgfId-252408]Add and Edit Per Session NAT Rule Dialog Boxes

 
      		 [bookmark: pgfId-252413]NAT Policies on Security Devices

 
      		 [bookmark: pgfId-252418]About “Simplified” NAT on ASA 8.3+ Devices

 
      		 [bookmark: pgfId-252420]Standard rules table topics:

 
     

 
     [bookmark: pgfId-252425] – Using Rules Tables

 
     [bookmark: pgfId-252430] – Filtering Tables

 
     [bookmark: pgfId-252435] – Table Columns and Column Heading Features

 
     [bookmark: pgfId-252437]Navigation Path

 
      
      		 [bookmark: pgfId-252439](Device view) Select  NAT > Per-Session NAT Rules from the Device Policy selector.

 
      		 [bookmark: pgfId-252441](Policy view) Select  NAT (PIX/ASA/FWSM) > Per-Session NAT Rules from the Policy Type selector. Select an existing policy from the Shared Policy selector, or right-click  Translation Rules to create a new policy.

 
     

 
     [bookmark: pgfId-252443]The Per-Session NAT Rules page is displayed.

 
     [bookmark: pgfId-252445]Adding, Editing and Deleting Rules

 
     [bookmark: pgfId-252447]To add a per-session NAT rule:

 
     [bookmark: pgfId-252449] 1. Select the rule under which the rule is to be added. If you do not select a heading, the rule will be added to the end of the table by default.

 
     [bookmark: pgfId-252451] 2. Open the Add Per-Session NAT Rule dialog box: either click the Add Row button at the bottom of the table, or right-click anywhere in the table and choose Add Row from the pop-up menu.

 
     [bookmark: pgfId-252453] 3. Define the rule and then click OK to close the dialog box, adding the rule to the table.

 
     [bookmark: pgfId-252458]See Add and Edit Per Session NAT Rule Dialog Boxes for a complete description of the Add Per-Session NAT Rule dialog box.

 
     [bookmark: pgfId-252460]To edit a per-session NAT rule:

 
     [bookmark: pgfId-252462] 1. Open the Edit Per-Session NAT Rule dialog box for the desired rule: either select the rule in the Per-Session NAT rules table and then click the Edit Row button at the bottom of the table, or simply right-click the desired rule entry and choose Edit Row from the pop-up menu.

 
     [bookmark: pgfId-252464] 2. Edit the rule and then click OK to close the dialog box.

 
     [bookmark: pgfId-252469]See Add and Edit Per Session NAT Rule Dialog Boxes for a complete description of the Edit Per-Session NAT Rule dialog box.

 
     [bookmark: pgfId-252471]To delete a per-session NAT rule, select the rule in the table and click the Delete Row button at the bottom of the table, or simply right-click the desired rule entry and choose Delete Row from the pop-up menu.

 
     [bookmark: pgfId-252473]Enabling and Disabling Rules

 
     [bookmark: pgfId-252475]You can disable one or more consecutive rules without removing them from the table, as follows:

 
     [bookmark: pgfId-252477] 1. Select the rule(s) to be disabled. If selecting a contiguous block of rules, click the first and then Shift-click the last rule of the block.

 
     [bookmark: pgfId-252479] 2. Right-click a selected rule, and choose Disable from the pop-up menu.

 
     [bookmark: pgfId-252481]Disabled rules are grayed-out in the table.

 
     [bookmark: pgfId-252483]To re-enable one or one or more consecutive disabled rules, repeat this process, choosing Enable from the pop-up menu.

 
    
 
     
      [bookmark: pgfId-252503][bookmark: 63955][bookmark: NATpage_cncpt_AddEditPerSessionNATRule]Add and Edit Per Session NAT Rule Dialog Boxes[bookmark: marker-252491][bookmark: marker-252493][bookmark: marker-252495][bookmark: marker-252497][bookmark: marker-252499][bookmark: marker-252501]

 
     [bookmark: pgfId-252505]By default, all TCP PAT traffic and all UDP DNS traffic uses per-session PAT. To use multi-session PAT for traffic, you can configure per-session PAT rules: a permit rule uses per-session PAT, and a deny rule uses multi-session PAT.

 
     [bookmark: pgfId-252509]For more information about per-session vs. multi-session PAT, see Per-Session NAT Rules: ASA 9.0(1)+.

 
     [bookmark: pgfId-252511]Defaults

 
     [bookmark: pgfId-252513]By default, the following rules are installed:

 
      
      		 [bookmark: pgfId-252515]Permit TCP from any (IPv4 and IPv6) to any (IPv4 and IPv6)

 
      		 [bookmark: pgfId-252517]Permit UDP from any (IPv4 and IPv6) to domain

 
     

 
     [bookmark: pgfId-252519]These rules do not appear in the rule table.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-252521]Note You cannot remove these rules, and they always exist after any manually-created rules. Because rules are evaluated in order, you can override the default rules. For example, to completely negate these rules, you could add the following:

Deny TCP from any (IPv4 and IPv6) to any (IPv4 and IPv6)
Deny UDP from any (IPv4 and IPv6) to domain


     
      

     

     

 
     [bookmark: pgfId-252523]Navigation Path

 
     [bookmark: pgfId-252527]From the Per-Session NAT Rules: ASA 9.0(1)+ page, do one of the following:

 
      
      		 [bookmark: pgfId-252529]To add a rule, select the rule under which you want the rule added, and then click the  Add Row button below the rules table, or right-click anywhere inside the table and choose  Add Row to open the Add Per-Session NAT Rule dialog box.

 
      		 [bookmark: pgfId-252531]To edit a rule, select the rule and click the  Edit Row button, or simply right-click the rule and choose  Edit Row to open the Edit Per-Session NAT Rule dialog box for that rule.

 
     

 
     [bookmark: pgfId-252533]Related Topics

 
      
      		 [bookmark: pgfId-252537] Per-Session NAT Rules 

 
      		 [bookmark: pgfId-252542]Chapter 24, “Configuring Network Address Translation”

 
      		 [bookmark: pgfId-252547]Translation Rules: ASA 8.3+

 
      		 [bookmark: pgfId-252552]Add or Edit Network/Host Dialog Box: NAT Tab

 
     

 
     [bookmark: pgfId-252554]Field Reference

 
     [bookmark: pgfId-252557] 

 
      
       
        
        [bookmark: pgfId-249633]Table 24-17 [bookmark: 64021]Add and Edit NAT Rule Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-249639]Element
          
  
         		
           
           [bookmark: pgfId-249641]Description
          
  
        

 
         
         		[bookmark: pgfId-249647]Action

  
         		[bookmark: pgfId-249649]The action for this rule: Permit or Deny.

 [bookmark: pgfId-249651]A permit rule uses per-session PAT; a deny rule uses multi-session PAT.

  
        

 
         
         		[bookmark: pgfId-249657]Original Network

  
         		[bookmark: pgfId-249659]The source address or addresses (or Networks/Hosts objects) to which the rule applies. If this is a range or network, all addresses in the range or network are translated.

  
        

 
         
         		[bookmark: pgfId-249665]Destination Network

  
         		[bookmark: pgfId-249667]The destination address or addresses (or Networks/Hosts objects) to which the rule applies.

  
        

 
         
         		[bookmark: pgfId-249673]Service (tcp/udp Only)

  
         		[bookmark: pgfId-249675]Enter or Select the Service object that defines the service(s) to be translated.

 [bookmark: pgfId-249680]These service objects represent a service protocol (TCP or UDP), and one or more ports. See Understanding and Specifying Services and Service and Port List Objects for information about configuring service objects.

  
        

 
         
         		[bookmark: pgfId-249686]Category

  
         		[bookmark: pgfId-249691](Optional) Choose a category to assign to the rule. Categories can help you organize and identify rules and objects; see Using Category Objects for more information.

 [bookmark: pgfId-249693]Note This option is not available when Dynamic NAT and PAT is the chosen rule Type.

  
        

 
         
         		[bookmark: pgfId-249699]Description

  
         		[bookmark: pgfId-249701](Optional) Provide a description of the rule.
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     [bookmark: pgfId-644384][bookmark: 45017][bookmark: porules_cncpt_WorkingwithInspectionRules]Managing Firewall Inspection Rules[bookmark: marker-644380][bookmark: marker-644382]
      
      
 
     
 

 
    [bookmark: pgfId-644386]Inspection rules configure protocol inspection on a device. Inspection opens temporary holes in your access rules to allow return traffic for connections initiated within your trusted network. When traffic is inspected, the device also implements additional controls to eliminate mal-formed packets based on the inspected protocols.

 
    [bookmark: pgfId-644388]The device commands generated for inspection rules vary based on device type. For devices running ASA, PIX 7.0+, and FWSM 3.x+, access-list, policy-map, and class-map commands are used. For older FWSM and PIX 6.3 devices, fixup commands are used. For IOS devices, ip-inspect commands are used.

 
    [bookmark: pgfId-644390]The following topics will help you work with inspection rules:

 
     
     		 [bookmark: pgfId-644395]Understanding Inspection Rules

 
    

 
    [bookmark: pgfId-644400] – Choosing the Interfaces for Inspection Rules

 
    [bookmark: pgfId-644405] – Selecting Which Protocols To Inspect

 
    [bookmark: pgfId-644410] – Understanding Access Rule Requirements for Inspection Rules

 
    [bookmark: pgfId-644415] – Using Inspection To Prevent Denial of Service (DoS) Attacks on IOS Devices

 
     
     		 [bookmark: pgfId-644420]Configuring Inspection Rules

 
     		 [bookmark: pgfId-644425]Inspection Rules Page

 
     		 [bookmark: pgfId-644430]Configuring Protocols and Maps for Inspection

 
     		 [bookmark: pgfId-644435]Configuring Settings for Inspection Rules for IOS Devices

 
    

 
    [bookmark: pgfId-644437]The following topics can help you with general rule table usage:

 
     
     		 [bookmark: pgfId-644442]Adding and Removing Rules

 
     		 [bookmark: pgfId-644447]Editing Rules

 
     		 [bookmark: pgfId-644452]Enabling and Disabling Rules

 
     		 [bookmark: pgfId-644457]Moving Rules and the Importance of Rule Order

 
    

 
   
 
    
     [bookmark: pgfId-644471][bookmark: 45072][bookmark: porules_cncpt_UnderstandingInspectionRules]Understanding Inspection Rules[bookmark: marker-644465][bookmark: marker-644467][bookmark: marker-644469]

 
    [bookmark: pgfId-644473]Inspection rules configure Context-Based Access Control (CBAC) inspection commands. CBAC inspects traffic that travels through the device to discover and manage state information for TCP and UDP sessions. The device uses this state information to create temporary openings to allow return traffic and additional data connections for permissible sessions.

 
    [bookmark: pgfId-644475]CBAC creates temporary openings in access lists at firewall interfaces. These openings are created when inspected traffic exits your internal network through the firewall. The openings allow returning traffic (that would normally be blocked) and additional data channels to enter your internal network back through the firewall. The traffic is allowed back through the firewall only if it is part of the same session as the original traffic that triggered inspection when exiting through the firewall.

 
    [bookmark: pgfId-644477]Inspection rules are applied after your access rules, so any traffic that you deny in the access rule is not inspected. The traffic must be allowed by the access rules at both the input and output interfaces to be inspected. Whereas access rules allow you to control connections at layer 3 (network, IP) or 4 (transport, TCP or UDP protocol), you can use inspection rules to control traffic using application-layer protocol session information.

 
    [bookmark: pgfId-644479]For all protocols, when you inspect the protocol, the device provides the following functions:

 
     
     		 [bookmark: pgfId-644481]Automatically opens a return path for the traffic (reversing the source and destination addresses), so that you do not need to create an access rule to allow the return traffic. Each connection is considered a session, and the device maintains session state information and allows return traffic only for valid sessions. Protocols that use TCP contain explicit session information, whereas for UDP applications, the device models the equivalent of a session based on the source and destination addresses and the closeness in time of a sequence of UDP packets.

 
    

 
    [bookmark: pgfId-644483]These temporary access lists are created dynamically and are removed at the end of a session.

 
     
     		 [bookmark: pgfId-644485]Tracks sequence numbers in all TCP packets and drops those packets with sequence numbers that are not within expected ranges.

 
     		 [bookmark: pgfId-644487]Uses timeout and threshold values to manage session state information, helping to determine when to drop sessions that do not become fully established. When a session is dropped, or reset, the device informs both the source and destination of the session to reset the connection, freeing up resources and helping to mitigate potential Denial of Service (DoS) attacks.

 
    

 
    [bookmark: pgfId-644489]The following topics provide more information about inspection:

 
     
     		 [bookmark: pgfId-644494]Choosing the Interfaces for Inspection Rules

 
     		 [bookmark: pgfId-644499]Selecting Which Protocols To Inspect

 
     		 [bookmark: pgfId-644504]Understanding Access Rule Requirements for Inspection Rules

 
     		 [bookmark: pgfId-644509]Using Inspection To Prevent Denial of Service (DoS) Attacks on IOS Devices

 
     		 [bookmark: pgfId-644514]Configuring Protocols and Maps for Inspection

 
     		 [bookmark: pgfId-644519]Configuring Inspection Rules

 
     		 [bookmark: pgfId-644524]Configuring Settings for Inspection Rules for IOS Devices

 
    

 
     
      [bookmark: pgfId-644536][bookmark: 45120][bookmark: porules_cncpt_ChoosingtheInterfacesforInspectionRules]Choosing the Interfaces for Inspection Rules[bookmark: marker-644530][bookmark: marker-644532][bookmark: marker-644534]

 
     [bookmark: pgfId-644538]Configure inspection on devices that protect internal networks. Use it with TCP, UDP, or more specific protocols. Inspect these applications if you want the application’s traffic to be permitted through the device only when the traffic session is initiated from a particular side of the device (usually from the protected internal network).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-644540]Tip For IOS devices, you need to configure inspection explicitly, and you can identify the direction of traffic to be inspected. For ASA, PIX, and FWSM devices, you cannot identify the direction, and you need to configure inspection only if you do not want the inspection defaults. In the remaining discussion, statements concerning direction apply only to IOS devices. For ASA, PIX, and FWSM, simply configure inspection on the identified interface.


     
      

     

     

 
     [bookmark: pgfId-644542]In many cases, you will configure inspection in one direction only at a single interface, which causes traffic to be permitted back into the internal network only if the traffic is part of a permissible (valid, existing) session. This is a typical configuration for protecting your internal networks from traffic that originates on the Internet.

 
     [bookmark: pgfId-644544]You can also configure inspection in two directions at one or more interfaces. Configure inspection in two directions when the networks on both sides of the firewall should be protected, such as with extranet or intranet configurations, and to protect against DoS attacks. For example, if the device is situated between two partner companies’ networks, you might want to restrict traffic in one direction for certain applications, and restrict traffic in the opposite direction for other applications. If you are protecting a web server in the DMZ zone, you might want to configure deep inspection on HTTP traffic to identify and reset connections that have undesirable characteristics.

 
     [bookmark: pgfId-644546]You might want to configure your inspection rules on the outbound interfaces of your network, those that connect to the Internet or another uncontrolled network, while allowing unfiltered connections within the trusted network. Thus, your devices use resources for inspection only on sessions that travel over unsecured and therefore potentially dangerous networks.

 
     [bookmark: pgfId-644548]Related Topics

 
      
      		 [bookmark: pgfId-644553]Selecting Which Protocols To Inspect

 
      		 [bookmark: pgfId-644558]Understanding Access Rule Requirements for Inspection Rules

 
      		 [bookmark: pgfId-644563]Using Inspection To Prevent Denial of Service (DoS) Attacks on IOS Devices

 
      		 [bookmark: pgfId-644568]Configuring Protocols and Maps for Inspection

 
      		 [bookmark: pgfId-644573]Configuring Inspection Rules

 
     

 
    
 
     
      [bookmark: pgfId-644587][bookmark: 45156][bookmark: porules_cncpt_SelectingWhichProtocolsToInspect]Selecting Which Protocols To Inspect [bookmark: marker-644579][bookmark: marker-644581][bookmark: marker-644583][bookmark: marker-644585]

 
     [bookmark: pgfId-644589]You can generically inspect TCP and UDP, which covers all applications that use these protocols. However, you can also inspect more specific protocols. In some cases, inspecting a specific protocol provides better service than generic TCP/UDP inspection. TCP and UDP inspection do not recognize application-specific commands, and therefore might not permit all return packets for an application, particularly if the return packets have a different port number than the previous exiting packet.

 
     [bookmark: pgfId-644591]For example:

 
      
      		 [bookmark: pgfId-644596]Some protocols allow you to configure deep inspection. Deep inspection allows you to configure more specific rules for a traffic stream. For example, you can drop HTTP connections where the content type of the request and response do not match. For information on deep inspection and your configuration options, see Configuring Protocols and Maps for Inspection.

 
      		 [bookmark: pgfId-644598]Protocols that negotiate return channels, such as FTP, should be specifically inspected. If you use simple generic TCP inspection of FTP traffic, the negotiated channels are not opened, and the connection will fail. If you want to allow FTP, ensure that you create a specific inspection rule for it.

 
     

 
     [bookmark: pgfId-644600]Multimedia protocols also negotiate return channels and should be specifically inspected. These include H.323, RTSP (Real Time Streaming Protocol), and other application-specific protocols. Some applications also use a generic TCP channel, so you might also need to configure generic TCP inspection. Any generic TCP inspection rule should appear below a more specific inspection rule in the table (that is, any rule that specifies TCP or UDP should appear at the end of the inspection rule table).

 
     [bookmark: pgfId-644602]Related Topics

 
      
      		 [bookmark: pgfId-644607]Choosing the Interfaces for Inspection Rules

 
      		 [bookmark: pgfId-644612]Understanding Access Rule Requirements for Inspection Rules

 
      		 [bookmark: pgfId-644617]Using Inspection To Prevent Denial of Service (DoS) Attacks on IOS Devices

 
      		 [bookmark: pgfId-644622]Configuring Inspection Rules

 
     

 
    
 
     
      [bookmark: pgfId-644638][bookmark: 45196][bookmark: porules_cncpt_UnderstandingAccessRuleRequirementsforInspectionRules]Understanding Access Rule Requirements for Inspection Rules[bookmark: marker-644628][bookmark: marker-644630][bookmark: marker-644632][bookmark: marker-644634][bookmark: marker-644636]

 
     [bookmark: pgfId-644640]Access rules are applied before inspection rules. Therefore, you must ensure that your access rules do not prohibit traffic that you want inspected. Use the following guidelines:

 
      
      		 [bookmark: pgfId-644642]Permit inspected traffic to leave the network through the firewall.

 
     

 
     [bookmark: pgfId-644644]All access rules that evaluate traffic leaving the protected network should permit traffic that will be inspected. For example, if Telnet will be inspected, then Telnet traffic should be permitted on all access rules that apply to traffic leaving the network.

 
      
      		 [bookmark: pgfId-644646]Deny inspected return traffic entering the network through the firewall.

 
     

 
     [bookmark: pgfId-644648]For temporary openings to be created in an access list, the access list should deny inspected return traffic because the inspection engine will open up temporary holes in the access lists for this traffic. (You want traffic to be normally blocked when it enters your network.)

 
      
      		 [bookmark: pgfId-644650]Permit or deny traffic that cannot be inspected, or that you do not want to inspect, as required by your network.

 
     

 
     [bookmark: pgfId-644652]For example, if you do not want to inspect ICMP traffic, but you want to allow some ICMP traffic, configure your access rules to allow the traffic in both directions. Consider permitting at least these ICMP message types: echo reply (for ping commands), time-exceeded (for trace route), packet-too-big (for path MTU discovery), traceroute (for trace route), and unreachable (to notify that a host cannot be found).

 
      
      		 [bookmark: pgfId-644658]Add an access rule entry denying any network traffic from a source address matching an address on the protected network.[bookmark: marker-644654][bookmark: marker-644656]

 
     

 
     [bookmark: pgfId-644660]This is known as anti-spoofing protection because it prevents traffic from an unprotected network from assuming the identity of a device on the protected network.

 
      
      		 [bookmark: pgfId-644666]Add an entry denying broadcast messages with a source address of 255.255.255.255.[bookmark: marker-644662][bookmark: marker-644664]

 
     

 
     [bookmark: pgfId-644668]This entry helps to prevent broadcast attacks.

 
     [bookmark: pgfId-644670]Related Topics

 
      
      		 [bookmark: pgfId-644675]Understanding Access Rules

 
      		 [bookmark: pgfId-644680]Choosing the Interfaces for Inspection Rules

 
      		 [bookmark: pgfId-644685]Selecting Which Protocols To Inspect

 
      		 [bookmark: pgfId-644690]Configuring Inspection Rules

 
     

 
    
 
     
      [bookmark: pgfId-644710][bookmark: 45258][bookmark: porules_cncpt_UsingInspectionToPreventDenialofServiceAttacks]Using Inspection To Prevent Denial of Service (DoS) Attacks on IOS Devices[bookmark: marker-644696][bookmark: marker-644698][bookmark: marker-644700][bookmark: marker-644702][bookmark: marker-644704][bookmark: marker-644706][bookmark: marker-644708]

 
     [bookmark: pgfId-644712]Inspecting packets at the application layer, and maintaining TCP and UDP session information, provides a device with the ability to detect and prevent certain types of network attacks such as SYN-flooding. A SYN-flood attack occurs when a network attacker floods a server with a barrage of requests for connection and does not complete the connection. The resulting volume of half-open connections can overwhelm the server, causing it to deny service to valid requests. Network attacks that deny access to a network device are called denial-of-service (DoS) attacks.

 
     [bookmark: pgfId-644714]Inspection helps to protect against DoS attacks in other ways. Inspection looks at packet sequence numbers in TCP connections to see if they are within expected ranges and drops any suspicious packets. You can also configure inspection to drop half-open connections, which require firewall processing and memory resources to maintain. Additionally, inspection can detect unusually high rates of new connections and issue alert messages.

 
     [bookmark: pgfId-644719]For IOS devices, you can configure several inspection setting parameters to fine-tune your defenses against SYN flooding and half-open connections. Configure the Firewall > Settings > Inspection policy. For details about each setting, see Configuring Settings for Inspection Rules for IOS Devices.

 
     [bookmark: pgfId-644721]Inspection can also help by protecting against certain DoS attacks involving fragmented IP packets. Even though the firewall prevents an attacker from making actual connections to a given host, the attacker can disrupt services provided by that host. This is done by sending many non-initial IP fragments or by sending complete fragmented packets through a router with an ACL that filters the first fragment of a fragmented packet. These fragments can tie up resources on the target host as it tries to reassemble the incomplete packets. To fine-tune fragment inspection, configure an inspection rule for the fragment protocol and configure the maximum number of fragments you want to allow and a timeout value.

 
     [bookmark: pgfId-644723]Related Topics

 
      
      		 [bookmark: pgfId-644728]Understanding Inspection Rules

 
      		 [bookmark: pgfId-644733]Selecting Which Protocols To Inspect

 
      		 [bookmark: pgfId-644738]Configuring Protocols and Maps for Inspection

 
      		 [bookmark: pgfId-644743]Configuring Inspection Rules

 
     

 
    
 
   
 
    
     [bookmark: pgfId-644755][bookmark: 45305][bookmark: porules_proc_AddingInspectionRules]Configuring Inspection Rules [bookmark: marker-644749][bookmark: marker-644751][bookmark: marker-644753]

 
    [bookmark: pgfId-644757]Inspection rules policies identify the traffic that will be inspected through an interface. Inspection tracks permitted sessions and opens temporary holes in your access rules to allow return traffic.

 
    [bookmark: pgfId-644763][bookmark: marker-644759][bookmark: marker-644761]Inspection rules are processed after access rules, so any traffic dropped by an access rule is not inspected. You can also use deny rules to selectively exclude certain types of traffic from inspection. For example, you might create a deny inspection rule to prevent a specific class of DNS traffic from being inspected, while all other DNS traffic is inspected. The basic procedure is:

 
     
     		 [bookmark: pgfId-644765]Add a new deny rule before the default inspection rule for the specific protocol. For the Match Traffic By option, select Source and Destination Address and Port. Next, define the specific type of traffic by providing Source and Destination Network IP addresses, and selecting the desired Service type (for example, DNS-TCP). Finally, in the third screen of the inspection-rule wizard, select the appropriate protocol (for example, DNS).

 
     		 [bookmark: pgfId-644767]Now edit the default inspection rule (below your new deny rule in the table). Again select Source and Destination Address and Port for the Match Traffic By option. Be sure this is a Permit rule, provide an all-addresses option as the source and destination addresses, and enter IP as the Service type. In the third screen, keep the selected protocol; configure or remove the related map, as necessary.

 
    

 
    [bookmark: pgfId-644775]See Inspection Rules Page and Add or Edit Inspect/Application FW Rule Wizard for additional information about this process.

 
    [bookmark: pgfId-644777]See the following topics for more information about things you should consider when creating inspection rules:

 
     
     		 [bookmark: pgfId-644782]Understanding Inspection Rules

 
     		 [bookmark: pgfId-644787]Choosing the Interfaces for Inspection Rules

 
     		 [bookmark: pgfId-644792]Selecting Which Protocols To Inspect

 
     		 [bookmark: pgfId-644797]Understanding Access Rule Requirements for Inspection Rules

 
     		 [bookmark: pgfId-644802]Using Inspection To Prevent Denial of Service (DoS) Attacks on IOS Devices

 
     		 [bookmark: pgfId-644807]Configuring Protocols and Maps for Inspection

 
     		 [bookmark: pgfId-644812]Understanding Map Objects

 
    

 
    [bookmark: pgfId-644814]Before You Begin

 
    [bookmark: pgfId-644822]You might have a set of inspection rules that you want to apply to all devices. To do this, you can create a shared rule and inherit its rules to each device’s inspection rules policy. For more information, see Creating a New Shared Policy and Inheriting or Uninheriting Rules.

 
    
 
    [bookmark: pgfId-644827]Step 1 Do one of the following to open the Inspection Rules Page:

 
     
     		 [bookmark: pgfId-644829](Device view) Select  Firewall > Inspection Rules from the Policy selector.

 
     		 [bookmark: pgfId-644831](Policy view) Select  Firewall > Inspection Rules from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-644836]Step 2 Select the row after which you want to create the rule and click the Add Row button or right-click and select Add Row. This opens the Add or Edit Inspect/Application FW Rule Wizard.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-644841]Tip If you do not select a row, the new rule is added at the end of the local scope. You can also select an existing row and edit either the entire row or specific cells. For more information, see Editing Rules.


    
     

    

    

 
    [bookmark: pgfId-644843]Step 3 Select whether to apply the rule to all interfaces on the device or to only the interfaces you specify.

 
    [bookmark: pgfId-644845]If you elect to specify interfaces, enter the interface name or interface role, or click Select to select it from a list. For IOS devices, you also can select whether the rule applies in the Out direction (traffic leaving the interface). Use the In direction for all other device types.

 
    [bookmark: pgfId-644847]Step 4 Select the criteria you want to use for matching traffic. This determines what gets inspected based on this rule.

 
     
     		 [bookmark: pgfId-644849] Default Protocol Ports —Select this option if the protocol you are inspecting uses the default ports on your network.

 
    

 
    [bookmark: pgfId-644851]If you want to constrain the inspection based on the source or destination address, also select Limit inspection between source and destination IP addresses (available only for ASA, PIX 7.x+, and FWSM 3.x+ devices). When you click Next, you are prompted for the source and destination addresses. You can specify any for source or destination if you are interested only in configuring the other value.

 
     
     		 [bookmark: pgfId-644853] Custom Destination Ports —Select this option if you want to associate additional non-default TCP or UDP ports with a given protocol, for example, treating TCP traffic on destination port 8080 as HTTP traffic. When you click  Next , you are prompted for the port or port range.

 
     		 [bookmark: pgfId-644855] Destination Address and Port (IOS devices only) —Select this option if you want to associate additional non-default TCP or UDP ports with a given protocol only when the traffic is going to certain destinations, for example, if you want to treat TCP traffic on destination port 8080 as HTTP only when the traffic is going to server 192.168.1.10. When you click  Next , you are prompted for the destination address and the port information.

 
     		 [bookmark: pgfId-644857] Source and Destination Address and Port (PIX 7.x+, ASA, FWSM 3.x+) —Select this option for the same reason you would select Destination Address and Port for IOS devices, although you have the additional option of identifying the source of the traffic. When you click  Next , you are prompted for the source and destination addresses and the service port information.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-644859]Note For FWSM 2.x and PIX 6.3(x), you can select either Default Inspection Traffic or Custom Destination Ports only.


    
     

    

    

 
    [bookmark: pgfId-644864]Step 5 Click Next. If you selected anything other than Default Protocol Ports, fill in the required addressing and port information explained above and click Next. See Add or Edit Inspect/Application FW Rule Wizard, Step 2.

 
    [bookmark: pgfId-644869]Step 6 On the Add or Edit Inspect/Application FW Rule Wizard, Inspected Protocol Page, select the protocol you want to inspect from the list. Ensure that the Device Type field indicates that inspection is supported for that protocol on the devices to which you are assigning the rule. (If you assign a rule to an unsupported device type, the rule is ignored but you will get a validation warning).

 
    [bookmark: pgfId-644874]If the protocol you select allows additional configuration, the Configure button becomes active. Click it to view and select your options. For more information, see Configuring Protocols and Maps for Inspection.

 
    [bookmark: pgfId-644876]For IOS devices only:

 
     
     		 [bookmark: pgfId-644878]If you selected  Custom Destination Ports or  Destination Address and Port as the traffic match, you can select  custom protocol as the protocol name and click  Configure to assign a name to the configuration.

 
     		 [bookmark: pgfId-644883]You can configure additional alert, audit, and timeout settings that override those set in the inspection settings policy. You can also specify whether to inspect router generated traffic for a limited number of protocols. For more information about inspection settings, see Configuring Settings for Inspection Rules for IOS Devices.

 
    

 
    [bookmark: pgfId-644885]Step 7 Click Finish to save the rule.

 
    [bookmark: pgfId-644890]Step 8 If you did not select the right row before adding the rule, select the new rule and use the up and down arrow buttons to position the rule appropriately. For more information, see Moving Rules and the Importance of Rule Order.

 
    [bookmark: pgfId-644892]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-644904][bookmark: 45438][bookmark: fwlsvcpg_cncpt_InspectionRulesPage]Inspection Rules Page[bookmark: marker-644900][bookmark: marker-644902]

 
    [bookmark: pgfId-644906]Use the Inspection Rules page to configure inspection rules for device interfaces. Inspection examines traffic that travels through the device to discover and manage state information for TCP and UDP sessions. The device uses this state information to create temporary openings to allow return traffic and additional data connections for permissible sessions.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-644914]Note With the release of Security Manager 4.4 and versions 9.0 and higher of the ASA, the separate policies and objects for configuring IPv4 and IPv6 inspection rules were “unified,” meaning one set of inspection rules in which you can use either IPv4 or IPv6 addresses, or a mixture of both. (See Policy Object Changes in Security Manager 4.4 for additional information.) In Policy view, IPv4 and unified versions of the inspection policy type are provided. In addition, a utility that you can use to convert existing IPv4 policies is provided (see Converting IPv4 Rules to Unified Rules). The following descriptions apply to all versions of the inspection rule table, except where noted.

If you assign an IPv4 inspection-rule shared policy to a 9.0+ device, you will no longer be able to assign unified versions of those policies to that device. Likewise, if you assign a unified inspection-rule shared policy to a 9.0+ device, you will no longer be able to assign IPv4 versions of those shared policies to that device--the device will not be included in the list of available devices on the Assignments tab for the shared policy.


    
     

    

    

 
    [bookmark: pgfId-644916]Inspection rules are processed after your access rules. Thus, any traffic denied by an access rule is never inspected.

 
    [bookmark: pgfId-644918]Read the following topics before you configure inspection rules:

 
     
     		 [bookmark: pgfId-644923]Understanding Inspection Rules

 
     		 [bookmark: pgfId-644928]Choosing the Interfaces for Inspection Rules

 
     		 [bookmark: pgfId-644933]Selecting Which Protocols To Inspect

 
     		 [bookmark: pgfId-644938]Understanding Access Rule Requirements for Inspection Rules

 
     		 [bookmark: pgfId-644943]Using Inspection To Prevent Denial of Service (DoS) Attacks on IOS Devices

 
     		 [bookmark: pgfId-644948]Configuring Inspection Rules

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-644953]Tip Disabled rules are shown with hash marks covering the table row. When you deploy the configuration, disabled rules are removed from the device. For more information, see Enabling and Disabling Rules.


    
     

    

    

 
    [bookmark: pgfId-644955]Navigation Path

 
    [bookmark: pgfId-644957]To access the Inspection Rules page, do one of the following:

 
     
     		 [bookmark: pgfId-644959](Device view) Select a device, then select  Firewall > Inspection Rules from the Policy selector.

 
     		 [bookmark: pgfId-644961](Policy view) Select  Firewall > Inspection Rules from the Policy Type selector. Create a new policy or select an existing one.

 
     		 [bookmark: pgfId-644963](Map view) Right-click a device and select  Edit Firewall Policies > Inspection Rules .

 
    

 
    [bookmark: pgfId-644965]Related Topics

 
     
     		 [bookmark: pgfId-644970]Adding and Removing Rules

 
     		 [bookmark: pgfId-644975]Editing Rules

 
     		 [bookmark: pgfId-644980]Enabling and Disabling Rules

 
     		 [bookmark: pgfId-644985]Moving Rules and the Importance of Rule Order

 
     		 [bookmark: pgfId-644990]Using Sections to Organize Rules Tables

 
     		 [bookmark: pgfId-644995]Using Rules Tables

 
     		 [bookmark: pgfId-645000]Filtering Tables

 
    

 
    [bookmark: pgfId-645002]Field Reference

 
    [bookmark: pgfId-645005] 

 
     
      
       
       [bookmark: pgfId-637474]Table 17-1 [bookmark: 45515]Inspection Rules Page 

 
       
      
        
        		
          
          [bookmark: pgfId-637480]Element
         
  
        		
          
          [bookmark: pgfId-637482]Description
         
  
       

 
        
        		[bookmark: pgfId-637488]Expand all rows/Collapse all rows

  
        		[bookmark: pgfId-637490]Use these buttons to expand or collapse all sections in the rules table.

 [bookmark: pgfId-637492]Note The buttons are located in the upper-right corner of the Filter area above the inspection rules table.

  
       

 
        
        		[bookmark: pgfId-637498]Conflict Indicator icons

  
        		[bookmark: pgfId-637503]Identifies conflicts and provides a quick visual representation of the type of conflict. For more details, including types of conflicts and the actions you can take from this column, see Understanding the Automatic Conflict Detection User Interface.

  
       

 
        
        		[bookmark: pgfId-637509]No.

  
        		[bookmark: pgfId-637511]The ordered rule number.

  
       

 
        
        		[bookmark: pgfId-637517]Permit

  
        		[bookmark: pgfId-637519]Whether a rule identifies traffic that should be inspected based on the conditions set:

 
          
          		 [bookmark: pgfId-637521]Permit—Identifies traffic that will be inspected. Shown as a green check mark.

 
          		 [bookmark: pgfId-637523]Deny—Exempts the traffic from inspection. Your access rules will determine if the traffic is allowed or blocked. Shown as a red circle with slash.

 
         

  
       

 
        
        		[bookmark: pgfId-637529]Sources

  
        		[bookmark: pgfId-637531]The sources of traffic for this rule; can be networks, security groups (ASA 9.0+ only), and users. Multiple entries are displayed on separate lines within the table cell.

  
       

 
        
        		[bookmark: pgfId-637537]Destinations

  
        		[bookmark: pgfId-637539]The destinations for this rule; can be networks and security groups (ASA 9.0+ only). Multiple entries are displayed on separate lines within the table cell.

  
       

 
        
        		[bookmark: pgfId-637545]Traffic Match

  
        		[bookmark: pgfId-637547]The type of matching used in the rule:

 
          
          		 [bookmark: pgfId-637549] default-inspection —The rule inspects traffic based on the default port.

 
          		 [bookmark: pgfId-637551]TCP,UDP/port number—The rule inspects traffic based on a custom port number.

 
          		 [bookmark: pgfId-637556]Service—The rule inspects traffic based on a service specification or service object. Multiple entries are displayed as separate subfields within the table cell. See Understanding and Specifying Services and Service and Port List Objects.

 
         

  
       

 
        
        		[bookmark: pgfId-637562]Interface

  
        		[bookmark: pgfId-637567]The interfaces or interface roles to which the rule is assigned. Global indicates that the rule is assigned to all interfaces. Interface role objects are replaced with the actual interface names when the configuration is generated for each device. Multiple entries are displayed as separate subfields within the table cell. See Understanding Interface Role Objects.

  
       

 
        
        		[bookmark: pgfId-637573]Dir.

  
        		[bookmark: pgfId-637575]The direction of the traffic to which this rule applies:

 
          
          		 [bookmark: pgfId-637577]In—Packets entering the interface.

 
          		 [bookmark: pgfId-637579]Out—Packets exiting the interface.

 
         

  
       

 
        
        		[bookmark: pgfId-637585]Inspected Protocol

  
        		[bookmark: pgfId-637590]The protocol to be inspected and possibly some configuration settings for the protocol. You can right-click this cell and choose Edit Inspected Protocol to edit this; see Add or Edit Inspect/Application FW Rule Wizard, Inspected Protocol Page for more information.

  
       

 
        
        		[bookmark: pgfId-637596]Time Range

  
        		[bookmark: pgfId-637598]The time range policy object assigned to the rule. This object defines the time window within which inspection occurs.

  
       

 
        
        		[bookmark: pgfId-637604]Category

  
        		[bookmark: pgfId-637609]The category assigned to the rule. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
        
        		[bookmark: pgfId-637615]Description

  
        		[bookmark: pgfId-637617]The description of the rule, if any.

  
       

 
        
        		[bookmark: pgfId-637623]Last Ticket(s)

  
        		[bookmark: pgfId-637628]Shows the ticket(s) associated with last modification to the rule. You can click the ticket ID in the Last Ticket(s) column to view details of the ticket and to navigate to the ticket. If linkage to an external ticket management system has been configured, you can also navigate to that system from the ticket details (see Ticket Management Page).

  
       

 
        
        		 [bookmark: pgfId-637634]Page elements below the rules table

  
       

 
        
        		[bookmark: pgfId-637642]Query

  
        		[bookmark: pgfId-637647]Click this button to run a policy query, which can help you evaluate your rules and identify ineffective rules. See Generating Policy Query Reports

  
       

 
        
        		[bookmark: pgfId-637653]Find and Replace button (binoculars icon)

  
        		[bookmark: pgfId-637658]Click this button to search for various types of items within the table and to optionally replace them. See Finding and Replacing Items in Rules Tables.

  
       

 
        
        		[bookmark: pgfId-637664]Up Row and Down Row buttons (arrow icons)

  
        		[bookmark: pgfId-637669]Click these buttons to move the selected rules up or down within a scope or section. For more information, see Moving Rules and the Importance of Rule Order.

  
       

 
        
        		[bookmark: pgfId-637675]Add Row button

  
        		[bookmark: pgfId-637683]Click this button to add a rule to the table after the selected row using the Add or Edit Inspect/Application FW Rule Wizard. If you do not select a row, the rule is added at the end of the local scope. For more information about adding rules, see Adding and Removing Rules.

  
       

 
        
        		[bookmark: pgfId-637689]Edit Row button

  
        		[bookmark: pgfId-637694]Click this button to edit the selected rule. You can also edit individual cells. For more information, see Editing Rules.

  
       

 
        
        		[bookmark: pgfId-637700]Delete Row button

  
        		[bookmark: pgfId-637702]Click this button to delete the selected rule.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-645023][bookmark: 45661][bookmark: fwlsvcpg_cncpt_AddandEditInspectionRuleDialogBoxes]Add or Edit Inspect/Application FW Rule Wizard [bookmark: marker-645013][bookmark: marker-645015][bookmark: marker-645017][bookmark: marker-645019][bookmark: marker-645021]

 
     [bookmark: pgfId-645025]Use the Add or Edit Inspect/Application FW Rule wizard to add and edit inspection rules. The wizard steps you through the process of configuring an inspection rule based on your selection in the Match Traffic By group on this page.

 
     [bookmark: pgfId-645027]Read the following topics before you configure inspection rules:

 
      
      		 [bookmark: pgfId-645032]Understanding Inspection Rules

 
      		 [bookmark: pgfId-645037]Choosing the Interfaces for Inspection Rules

 
      		 [bookmark: pgfId-645042]Selecting Which Protocols To Inspect

 
      		 [bookmark: pgfId-645047]Understanding Access Rule Requirements for Inspection Rules

 
      		 [bookmark: pgfId-645052]Using Inspection To Prevent Denial of Service (DoS) Attacks on IOS Devices

 
      		 [bookmark: pgfId-645057]Configuring Inspection Rules

 
     

 
     [bookmark: pgfId-645059]Navigation Path

 
     [bookmark: pgfId-645064]From the Inspection Rules Page, click the Add Row button or select a row and click the Edit Row button.

 
     [bookmark: pgfId-645066]Related Topics

 
      
      		 [bookmark: pgfId-645071]Add or Edit Inspect/Application FW Rule Wizard, Step 2

 
      		 [bookmark: pgfId-645076]Add or Edit Inspect/Application FW Rule Wizard, Inspected Protocol Page

 
      		 [bookmark: pgfId-645081]Understanding Interface Role Objects

 
      		 [bookmark: pgfId-645086]Editing Rules

 
     

 
     [bookmark: pgfId-645088]Field Reference

 
     [bookmark: pgfId-645091] 

 
      
       
        
        [bookmark: pgfId-637715]Table 17-2 [bookmark: 45726]Add and Edit Inspect/Application FW Rule Wizard Step 1: Traffic Match Method 

 
        
       
         
         		
           
           [bookmark: pgfId-637721]Element
          
  
         		
           
           [bookmark: pgfId-637723]Description
          
  
        

 
         
         		[bookmark: pgfId-637729]Enable Rule

  
         		[bookmark: pgfId-637734]Whether to enable the rule, which means the rule becomes active when you deploy the configuration to the device. Disabled rules are shown overlain with hash marks in the rule table. For more information, see Enabling and Disabling Rules.

  
        

 
         
         		[bookmark: pgfId-637740]Apply the Rule to

  
         		[bookmark: pgfId-637742]The interface to which the rule applies:

 
           
           		 [bookmark: pgfId-637744]All Interfaces—Apply the rule to all interfaces. The rule becomes a global rule on ASA, PIX, and FWSM devices. For IOS devices, the rule is configured for each interface in the In direction.

 
           		 [bookmark: pgfId-637746]Interface (PIX 7.x+, ASA, FWSM 3.x+, IOS)—Apply the rule only to those interfaces identified in the Interfaces field. Enter the name of the interface or the interface role, or click  Select to select the interface or role from a list, or to create a new role. An interface must already be defined to appear on the list.

 
          

 [bookmark: pgfId-637748]For IOS devices only, you can select the direction of the traffic to which this rule applies, either traffic entering an interface (In) or exiting it (Out). For other devices, leave In as the direction.

  
        

 
         
         		 [bookmark: pgfId-637754]Match Traffic By

 [bookmark: pgfId-637756]How you want to identify the traffic to inspect. If you select something other than Default Protocol Ports (by itself), you are prompted for the other port or address information when you click Next.

  
        

 
         
         		[bookmark: pgfId-637764]Default Protocol Ports

 [bookmark: pgfId-637766]Limit inspection between source and destination IP addresses (PIX 7.x+, ASA, FWSM 3.x+)

  
         		[bookmark: pgfId-637771]Inspect traffic based on the default ports assigned to a protocol. You will select a protocol on the next page (Add or Edit Inspect/Application FW Rule Wizard, Inspected Protocol Page).

 [bookmark: pgfId-637773]You can also select Limit inspection between source and destination IP addresses to configure the inspection to occur only between a specified source and destination. Do not select this option if you want to inspect a protocol without applying any constraints to the inspected traffic.

 [bookmark: pgfId-637778]If you also select this option, the next page of the wizard is described in Add or Edit Inspect/Application FW Rule Wizard, Step 2.

  
        

 
         
         		[bookmark: pgfId-637784]Custom Destination Ports

  
         		[bookmark: pgfId-637786]Inspect traffic based on specified non-default TCP or UDP destination ports. Select this option if you want to associate additional TCP or UDP traffic with a given protocol, for example, treating TCP traffic on destination port 8080 as HTTP traffic.

 [bookmark: pgfId-637791]You will specify the protocol and port(s) on the next page of the wizard; see Add or Edit Inspect/Application FW Rule Wizard, Step 2.

  
        

 
         
         		[bookmark: pgfId-637797]Destination Address and Port (IOS devices only)

  
         		[bookmark: pgfId-637799]Inspect traffic on IOS devices based on destination IP address and port. Select this option if you want to associate additional non-default TCP or UDP ports with a given protocol only when the traffic is going to certain destinations, for example, if you want to treat TCP traffic on destination port 8080 as HTTP only when the traffic is going to server 192.168.1.10.

  
        

 
         
         		[bookmark: pgfId-637805]Source and Destination Address and Port (PIX 7.x, ASA, FWSM 3.x)

  
         		[bookmark: pgfId-637807]Inspect traffic on PIX 7.x+, ASA, and FWSM 3.x+ devices based on source and destination IP addresses and services. Select this option for the same reason you would select Destination Address and Port for IOS devices, although you have the additional option of identifying the source of the traffic.

 [bookmark: pgfId-637812]You will specify the action, sources, destinations, and Services on the next page of the wizard; see Add or Edit Inspect/Application FW Rule Wizard, Step 2.

  
        

 
         
         		[bookmark: pgfId-637818]Category

  
         		[bookmark: pgfId-637823]The category assigned to the rule. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-637829]Description

  
         		[bookmark: pgfId-637831]An optional description of the rule (up to 1024 characters).

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-645115][bookmark: 45806][bookmark: fwlsvcpg_cncpt_InspectionRuleWizardAddressPortPage]Add or Edit Inspect/Application FW Rule Wizard, Step 2 [bookmark: marker-645105][bookmark: marker-645107][bookmark: marker-645109][bookmark: marker-645111][bookmark: marker-645113]

 
     [bookmark: pgfId-645120]The options presented on the second page of the Inspect/Application FW Rule Wizard depend on your Match Traffic By selection on the first page (see Add or Edit Inspect/Application FW Rule Wizard). The possibilities are as follows:

 
      
      		 [bookmark: pgfId-645125]If you select Default Protocol Ports on the first page and  do not select Limit inspection between source and destination IP addresses, the second page consists of the options described in Add or Edit Inspect/Application FW Rule Wizard, Inspected Protocol Page.

 
      		 [bookmark: pgfId-645130]If you select Default Protocol Ports on the first page and  do select Limit inspection between source and destination IP addresses, the second page consists of the options described in the second table in this section. (The third page will consist of the options described in Add or Edit Inspect/Application FW Rule Wizard, Inspected Protocol Page.)

 
      		 [bookmark: pgfId-645135]If you select Custom Destination Ports on the first page, the second page consists of the options described in the first table in this section. (The third page will consist of the options described in Add or Edit Inspect/Application FW Rule Wizard, Inspected Protocol Page.)

 
      		 [bookmark: pgfId-645140]If you select Source and Destination Address and Port on the first page, the second page consists of the options described in the second table in this section. (The third page will consist of the options described in Add or Edit Inspect/Application FW Rule Wizard, Inspected Protocol Page.)

 
     

 
     [bookmark: pgfId-645142]Navigation Path

 
     [bookmark: pgfId-645147]From the Add or Edit Inspect/Application FW Rule Wizard, select a Match Traffic By option and click Next.

 
     [bookmark: pgfId-645149]Related Topics

 
      
      		 [bookmark: pgfId-645154]Understanding Inspection Rules

 
      		 [bookmark: pgfId-645159]Choosing the Interfaces for Inspection Rules

 
      		 [bookmark: pgfId-645164]Selecting Which Protocols To Inspect

 
      		 [bookmark: pgfId-645169]Understanding Access Rule Requirements for Inspection Rules

 
      		 [bookmark: pgfId-645174]Using Inspection To Prevent Denial of Service (DoS) Attacks on IOS Devices

 
      		 [bookmark: pgfId-645179]Configuring Inspection Rules

 
      		 [bookmark: pgfId-645184]Understanding Interface Role Objects

 
      		 [bookmark: pgfId-645189]Editing Rules

 
     

 
     [bookmark: pgfId-645191]Field Reference

 
      
       
        
        [bookmark: pgfId-637844]Table 17-3 [bookmark: 45883]Add and Edit Inspect/Application FW Rule Wizard Step 2: Protocol and Port Page 

 
        
       
         
         		
           
           [bookmark: pgfId-637850]Element
          
  
         		
           
           [bookmark: pgfId-637852]Description
          
  
        

 
         
         		[bookmark: pgfId-637858]Protocol

  
         		[bookmark: pgfId-637860]The protocol for the ports you are specifying, either TCP, UDP, or both TCP/UDP.

 [bookmark: pgfId-637862]When configuring Custom Destination Ports for an IOS device, you must select TCP/UDP.

  
        

 
         
         		[bookmark: pgfId-637868]Ports

  
         		[bookmark: pgfId-637870]The port(s) used by the traffic you want to inspect. Valid values range from 1 to 65535.

 
           
           		 [bookmark: pgfId-637872]Single—Specify one port number only.

 
           		 [bookmark: pgfId-637874]Range—Specify a range of ports, for example, 10000-11000.

 
          

 [bookmark: pgfId-637876]When configuring custom ports, be aware that port ranges might not be supported on all platforms or OS versions. Any conflicts are identified during policy validation, not while you are editing this rule.

 [bookmark: pgfId-637878]Tip If you specify a port or port range that conflicts with a pre-defined port mapping, the device does not allow the port to be remapped.  
        

 
       
      

 
     
 
     [bookmark: pgfId-645204]The following table describes the options presented on page 2 of the Inspect/Application FW Rule Wizard after you have selected Default Protocol Ports and Limit inspection between source and destination IP addresses on the first page of the wizard, and when you select Source and Destination Address and Port on the first page. The first page of the wizard is described in Add or Edit Inspect/Application FW Rule Wizard.

 
     [bookmark: pgfId-645207] 

 
      
       
        
        [bookmark: pgfId-637891]Table 17-4 [bookmark: 45917]Add and Edit Inspect/Application FW Rule Wizard Step 2: Action, Sources, Destinations, and Services Page 

 
        
       
         
         		
           
           [bookmark: pgfId-637897]Element
          
  
         		
           
           [bookmark: pgfId-637899]Description
          
  
        

 
         
         		[bookmark: pgfId-637905]Action

  
         		[bookmark: pgfId-637907]Whether you are identifying traffic that should be inspected based on the conditions set. Typically, you will create Permit rules.

 
           
           		 [bookmark: pgfId-637909]Permit—Identifies traffic that will be inspected.

 
           		 [bookmark: pgfId-637911]Deny—Exempts the traffic from inspection. Your access rules will determine if the traffic is allowed or blocked.

 
          

  
        

 
         
         		[bookmark: pgfId-637917]Sources

  
         		[bookmark: pgfId-637919]Provide traffic sources for this rule; can be networks, security groups, and users. You can enter values or object names, or Select objects, for one or more of the following types of sources:

 
           
           		 [bookmark: pgfId-637921]Network – You can specify a various network, host and interface definitions, either individually or as objects. If you Select an interface object as a source, the dialog box displays tabs to differentiate between hosts/networks and interfaces.

 
          

 [bookmark: pgfId-637923]The “All-Address” objects do not restrict the rule to specific hosts, networks, or interfaces. These addresses are IPv4 or IPv6 addresses for hosts or networks, network/host objects, interfaces, or interface roles.

 [bookmark: pgfId-637925]Note You can only specify a fully qualified domain name (FQDN) by providing an FQDN network/host object, or a group object that includes an FQDN object. You cannot directly type in an FQDN.

 [bookmark: pgfId-637936]See Understanding Networks/Hosts Objects, Specifying IP Addresses During Policy Definition and Understanding Interface Role Objects for additional information about these definitions.

 
           
           		 [bookmark: pgfId-637947]Security Groups (ASA 9.0+) – Enter or Select the name or tag number for one or more source security groups for the rule, if any. See Selecting Security Groups in Policies, Configuring TrustSec-Based Firewall Rules and Creating Security Group Objects for more information about security groups.

 
           		 [bookmark: pgfId-637949]Users – Enter or Select the Active Directory (AD) user names, user groups, or identity user group objects for the rule, if any. You can enter any combination of the following:

 
          

 [bookmark: pgfId-637951] – Individual user names: NetBIOS_DOMAIN\username

 [bookmark: pgfId-637953] – User groups (note the double \): NetBIOS_DOMAIN\\user_group

 [bookmark: pgfId-637955] – Identity user group object names.

 [bookmark: pgfId-637957]For more information, see:

 [bookmark: pgfId-637962] – Selecting Identity Users in Policies

 [bookmark: pgfId-637967] – Configuring Identity-Based Firewall Rules

 [bookmark: pgfId-637972] – Creating Identity User Group Objects

 [bookmark: pgfId-637974]Note Enter more than one value in any of these fields by separating the items with commas.

 [bookmark: pgfId-637976]Each specification is combined with any others to limit traffic matches to only those flows that include all definitions. For example, specified user traffic originating from within a specified source address range.

  
        

 
         
         		[bookmark: pgfId-637982]Destinations

  
         		[bookmark: pgfId-637984]Provide traffic destinations for this rule; can be networks or security groups. As with Sources, you can enter values or object names, or Select objects, for one or more destinations of Network and Security Group (ASA 9.0+) type.

  
        

 
         
         		[bookmark: pgfId-637990]Services

  
         		[bookmark: pgfId-637992]The services that define the type of traffic upon which to act. You can enter or Select any combination of service objects and service types (which are typically a protocol and port combination).

 [bookmark: pgfId-637994]Enter more than one value by separating the items with commas.

 [bookmark: pgfId-637999]For complete information on how to specify services, see Understanding and Specifying Services and Service and Port List Objects.

  
        

 
         
         		[bookmark: pgfId-638005]Time Range

  
         		[bookmark: pgfId-638007]The name of a time range policy object that defines the times when this rule applies. The time is based on the system clock of the device. The feature works best if you use NTP to configure the system clock.

 [bookmark: pgfId-638009]Enter the name or click Select to select the object. If the object that you want is not listed, click the Create button to create it.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-645231][bookmark: 46000][bookmark: fwlsvcpg_cncpt_AddInspectApplicationFWRuleMatchTraffictoProtocolPage]Add or Edit Inspect/Application FW Rule Wizard, Inspected Protocol Page [bookmark: marker-645217][bookmark: marker-645219][bookmark: marker-645221][bookmark: marker-645223][bookmark: marker-645225][bookmark: marker-645227][bookmark: marker-645229]

 
     [bookmark: pgfId-645233]Use the Inspect/Application FW Rule wizard’s inspected protocol page to configure the protocol monitored by this inspection rule.

 
     [bookmark: pgfId-645238]The options in this section are presented when you add or edit a firewall inspection rule, and when you right-click the Inspected Protocol cell of an existing rule in the table on the Inspection Rules Page.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-645240]Note Beginning with version 4.9, Security Manager supports SIP protocol for ASA cluster devices running the software version 9.4.0 or higher.


     
      

     

     

 
     [bookmark: pgfId-645242]Navigation Path

 
     [bookmark: pgfId-645244]Do one of the following:

 
      
      		 [bookmark: pgfId-645249]In the Add or Edit Inspect/Application FW Rule Wizard, click Next until you reach this page.

 
      		 [bookmark: pgfId-645251]To open the Edit Inspected Protocols dialog box, right-click the Inspected Protocol cell of an inspection rule and choose  Edit Inspected Protocol . If you select multiple rows, your changes replace the inspected protocol defined for all selected rules.

 
     

 
     [bookmark: pgfId-645253]Related Topics

 
      
      		 [bookmark: pgfId-645258]Add or Edit Inspect/Application FW Rule Wizard, Step 2

 
      		 [bookmark: pgfId-645263]Understanding Inspection Rules

 
      		 [bookmark: pgfId-645268]Choosing the Interfaces for Inspection Rules

 
      		 [bookmark: pgfId-645273]Selecting Which Protocols To Inspect

 
      		 [bookmark: pgfId-645278]Understanding Access Rule Requirements for Inspection Rules

 
      		 [bookmark: pgfId-645283]Using Inspection To Prevent Denial of Service (DoS) Attacks on IOS Devices

 
      		 [bookmark: pgfId-645288]Configuring Inspection Rules

 
      		 [bookmark: pgfId-645293]Editing Rules

 
      		 [bookmark: pgfId-645298]Filtering Tables

 
     

 
     [bookmark: pgfId-645300]Field Reference

 
     [bookmark: pgfId-645303] 

 
      
       
        
        [bookmark: pgfId-638022]Table 17-5 [bookmark: 46074]Inspected Protocol Options 

 
        
       
         
         		
           
           [bookmark: pgfId-638028]Element
          
  
         		
           
           [bookmark: pgfId-638030]Description
          
  
        

 
         
         		[bookmark: pgfId-638036]Protocols table

  
         		[bookmark: pgfId-638038]Lists the protocols that can be inspected. You can select one protocol per rule. The list includes information on the device operating systems that allow inspection of the protocol: do not select protocols that are not supported by the device type to which you will apply the inspection rule.

 and click Configure to give your protocol a name. For other device types, select the protocol that you associate with the ports previously specified. [bookmark: pgfId-638042]The Options column displays configured options for the selected protocol, if any.

 [bookmark: pgfId-638044]The Group column provides additional information on the use of some of the protocols.

  
        

 
         
         		[bookmark: pgfId-638050]Selected Protocol

 [bookmark: pgfId-638052]Configure button

  
         		[bookmark: pgfId-638057]Displays the protocol you selected. If the protocol allows additional configuration, the Configure button becomes active; click it to see your options, and click the Help button in the dialog box that is opened for information about the options. For more information about protocols that allow configuration, see Configuring Protocols and Maps for Inspection.

  
        

 
         
         		[bookmark: pgfId-638063]Rule Settings (IOS)

  
         		[bookmark: pgfId-638068]Additional settings for the rule if it is used on devices running Cisco IOS software. If you select Use Default Inspection settings, the IOS defaults, or the settings defined in the inspection settings policy (see Configuring Settings for Inspection Rules for IOS Devices), are used. These are the settings you can enable or disable:

 
           
           		 [bookmark: pgfId-638070]Alert—Whether to generate stateful packet inspection alert messages on the console.

 
           		 [bookmark: pgfId-638072]Audit—Whether audit trail messages are logged to the syslog server or router.

 
           		 [bookmark: pgfId-638074]Timeout—Whether to configure the length of time, in seconds, for which a session is managed while there is no activity. If you select Specify Timeout, enter the timeout value; the range is 5 to 43200 seconds.

 
           		 [bookmark: pgfId-638076]Inspect Router Generated Traffic—Whether to inspect traffic that is generated by the device itself. This option is available for a limited number of the protocols.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-645321][bookmark: 46115][bookmark: fwlsvcpg_cncpt_ConfigureDNSDialogBox]Configure DNS Dialog Box[bookmark: marker-645311][bookmark: marker-645313][bookmark: marker-645315][bookmark: marker-645317][bookmark: marker-645319]

 
     [bookmark: pgfId-645323]Use the Configure DNS dialog box to configure settings for DNS inspection on PIX 7.0+, ASA, FWSM, and IOS devices.

 
     [bookmark: pgfId-645325]Navigation Path

 
     [bookmark: pgfId-645330]Go to the Add or Edit Inspect/Application FW Rule Wizard, Inspected Protocol Page, select DNS in the protocols table, and click Configure.

 
     [bookmark: pgfId-645332]Field Reference

 
     [bookmark: pgfId-645335] 

 
      
       
        
        [bookmark: pgfId-638089]Table 17-6 [bookmark: 46141]Configure DNS Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-638095]Element
          
  
         		
           
           [bookmark: pgfId-638097]Description
          
  
        

 
         
         		[bookmark: pgfId-638103]Maximum DNS Packet Length

  
         		[bookmark: pgfId-638105]The maximum DNS packet length. Values are 512 to 65535.

  
        

 
         
         		[bookmark: pgfId-638111]DNS Map

  
         		[bookmark: pgfId-638113]The DNS policy map object that defines traffic match conditions and actions, protocol conformance policies, and filter settings. Enter the object name, or click Select to select it. If the object that you want is not listed, click the Create button to create it.

  
        

 
         
         		[bookmark: pgfId-638119]Enable Dynamic Filter Snooping

  
         		[bookmark: pgfId-638121]Whether to allow the security appliance to snoop DNS packets in order to build a database of DNS lookup information. This information is used by botnet traffic filtering to match DNS names to IP addresses.

 [bookmark: pgfId-638126]If you configure a botnet traffic filtering rules policy, select this option. Otherwise, do not select the option. For more information, see Botnet Traffic Filter Rules Page.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-645349][bookmark: 46171][bookmark: fwlsvcpg_cncpt_ConfigureSMTPDialogBox]Configure SMTP Dialog Box[bookmark: marker-645343][bookmark: marker-645345][bookmark: marker-645347]

 
     [bookmark: pgfId-645351]Use the SMTP dialog box to edit settings for Simple Mail Transfer Protocol (SMTP) inspection. SMTP is used to transfer email between servers and clients on the Internet.

 
     [bookmark: pgfId-645353]SMTP inspection drops any packets with illegal commands. You can configure a maximum data length for packets. Enter a length in the range 0-4294967295.

 
     [bookmark: pgfId-645355]Navigation Path

 
     [bookmark: pgfId-645360]Go to the Add or Edit Inspect/Application FW Rule Wizard, Inspected Protocol Page, select SMTP in the protocols table, and click Configure.

 
    
 
     
      [bookmark: pgfId-645374][bookmark: 46190][bookmark: fwlsvcpg_cncpt_ConfigureESMTPDialogBox]Configure ESMTP Dialog Box[bookmark: marker-645368][bookmark: marker-645370][bookmark: marker-645372]

 
     [bookmark: pgfId-645376]Use the Configure ESMTP dialog box to edit settings for Extended Simple Mail Transport Protocol (ESMTP) inspection. You can configure these settings based on platform:

 
      
      		 [bookmark: pgfId-645378]IOS devices—You can configure a maximum data length for packets. Enter a length in the range 0-4294967295.

 
      		 [bookmark: pgfId-645380]ASA/PIX 7.x+ devices—You can specify an ESMTP policy map object to define deep inspection parameters. Enter the name of the object or click  Select to select it from a list or to create a new object.

 
     

 
     [bookmark: pgfId-645382]Navigation Path

 
     [bookmark: pgfId-645387]Go to the Add or Edit Inspect/Application FW Rule Wizard, Inspected Protocol Page, select ESMTP in the protocols table, and click Configure.

 
    
 
     
      [bookmark: pgfId-645399][bookmark: 46214][bookmark: fwlsvcpg_cncpt_ConfigureFragmentsDialogBox]Configure Fragments Dialog Box[bookmark: marker-645395][bookmark: marker-645397]

 
     [bookmark: pgfId-645401]Use the Configure Fragments dialog box to edit settings for fragment inspection on IOS devices.

 
     [bookmark: pgfId-645403]Navigation Path

 
     [bookmark: pgfId-645408]Go to the Add or Edit Inspect/Application FW Rule Wizard, Inspected Protocol Page, select fragment in the protocols table, and click Configure.

 
     [bookmark: pgfId-645410]Field Reference

 
     [bookmark: pgfId-645413] 

 
      
       
        
        [bookmark: pgfId-638139]Table 17-7 [bookmark: 46231]Configure Fragments Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-638145]Element
          
  
         		
           
           [bookmark: pgfId-638147]Description
          
  
        

 
         
         		[bookmark: pgfId-638153]Maximum Fragments

  
         		[bookmark: pgfId-638155]The maximum number of unassembled packets for which state information (structures) is allocated by Cisco IOS software. Unassembled packets are packets that arrive at the router interface before the initial packet for a session. Values are 0-10000 state entries. The default is 256.

 [bookmark: pgfId-638157]Note Memory is allocated for the state structures, and setting this value to a larger number may cause memory resources to be exhausted.

  
        

 
         
         		[bookmark: pgfId-638163]Timeout (sec)

  
         		[bookmark: pgfId-638165]The number of seconds that a packet state structure remains active. When the timeout value expires, the router drops the unassembled packet, freeing that structure for use by another packet. Values are 1-1000. The default timeout value is one second.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-645435][bookmark: 46253][bookmark: fwlsvcpg_cncpt_ConfigureIMAPDialogBox]Configure IMAP or POP3 Dialog Boxes[bookmark: marker-645423][bookmark: marker-645425][bookmark: marker-645427][bookmark: marker-645429][bookmark: marker-645431][bookmark: marker-645433]

 
     [bookmark: pgfId-645437]Use the Configure IMAP or POP3 dialog boxes to edit settings for Internet Message Access Protocol (IMAP) or Post Office Protocol 3 (POP3) inspection on IOS devices.

 
      
      		 [bookmark: pgfId-645439]IMAP is a method for accessing electronic mail or bulletin board messages that are kept on a mail server that may be shared. It permits a client email program to access remote messages as though they were local.

 
      		 [bookmark: pgfId-645441]POP3 is used to receive email that is stored on a mail server. Unlike IMAP, POP retrieves mail only from a remote host.

 
     

 
     [bookmark: pgfId-645443]Navigation Path

 
     [bookmark: pgfId-645448]Go to the Add or Edit Inspect/Application FW Rule Wizard, Inspected Protocol Page, select IMAP or POP3, and click Configure.

 
     [bookmark: pgfId-645450]Field Reference

 
     [bookmark: pgfId-645453] 

 
      
       
        
        [bookmark: pgfId-638178]Table 17-8 [bookmark: 46289]Configure IMAP or POP3 Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-638184]Element
          
  
         		
           
           [bookmark: pgfId-638186]Description
          
  
        

 
         
         		[bookmark: pgfId-638192]Reset Connection on Invalid IMAP/POP3 packet

  
         		[bookmark: pgfId-638194]Whether to reset, or drop, the connection between the client and server if an invalid packet is encountered. The client will have to repeat the validation process to reconnect to the server.

  
        

 
         
         		[bookmark: pgfId-638200]Enforce Secure Authentication

  
         		[bookmark: pgfId-638202]Whether to require that the client use a secure login to the server, that is, so that passwords are not sent in clear text.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-645467][bookmark: 46310][bookmark: fwlsvcpg_cncpt_ConfigureRPCDialogBox]Configure RPC Dialog Box[bookmark: marker-645461][bookmark: marker-645463][bookmark: marker-645465]

 
     [bookmark: pgfId-645469]Use the RPC dialog box to edit settings for RPC inspection on IOS devices. RPC inspection blocks traffic for all RPC programs except for those you specify. To allow more than one RPC program, create a rule for each program number you want to allow.

 
     [bookmark: pgfId-645471]Navigation Path

 
     [bookmark: pgfId-645476]Go to the Add or Edit Inspect/Application FW Rule Wizard, Inspected Protocol Page, select RPC in the protocols table, and click Configure.

 
     [bookmark: pgfId-645478]Field Reference

 
     [bookmark: pgfId-645481] 

 
      
       
        
        [bookmark: pgfId-638215]Table 17-9 [bookmark: 46330]Configure RPC Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-638221]Element
          
  
         		
           
           [bookmark: pgfId-638223]Description
          
  
        

 
         
         		[bookmark: pgfId-638229]Program Number

  
         		[bookmark: pgfId-638231]The program number to permit. Values are 1-4294967295.

  
        

 
         
         		[bookmark: pgfId-638237]Wait Time

  
         		[bookmark: pgfId-638239]The number of minutes to keep a hole in the firewall open to allow subsequent connections from the same source address to the same destination address and port. Values are 0-35791 minutes. The default is 0.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-645493][bookmark: 46351][bookmark: fwlsvcpg_cncpt_CustomProtocolDialogBox]Custom Protocol Dialog Box[bookmark: marker-645489][bookmark: marker-645491]

 
     [bookmark: pgfId-645498]Use the Custom Protocol dialog box to assign a name to the protocol and port specification you made on the Add or Edit Inspect/Application FW Rule Wizard, Step 2 for IOS devices.

 
     [bookmark: pgfId-645500]Navigation Path

 
     [bookmark: pgfId-645505]Go to the Add or Edit Inspect/Application FW Rule Wizard, Inspected Protocol Page, select custom protocol in the protocols table, and click Configure.

 
    
 
     
      [bookmark: pgfId-645515][bookmark: 46367][bookmark: fwlsvcpg_cncpt_ConfiguringProtocolPlatformDialogBox]Configure Dialog Box [bookmark: marker-645513]

 
     [bookmark: pgfId-645517]Use the Configure dialog box to select a policy map object for HTTP or IM inspection. The maps used for these types of inspection differ depending on the operating system version used on the device. Select the desired version and then click Select to select the desired policy map object or to create a new one.

 
     [bookmark: pgfId-645519]Navigation Path

 
     [bookmark: pgfId-645524]Go to the Add or Edit Inspect/Application FW Rule Wizard, Inspected Protocol Page, select HTTP or IM in the protocols table, and click Configure.

 
    
 
   
 
    
     [bookmark: pgfId-645584][bookmark: 46382][bookmark: porules_cncpt_ConfiguringMapsforInspection]Configuring Protocols and Maps for Inspection[bookmark: marker-645530][bookmark: marker-645532][bookmark: marker-645534][bookmark: marker-645536][bookmark: marker-645538][bookmark: marker-645540][bookmark: marker-645542][bookmark: marker-645544][bookmark: marker-645546][bookmark: marker-645548][bookmark: marker-645550][bookmark: marker-645552][bookmark: marker-645554][bookmark: marker-645556][bookmark: marker-645558][bookmark: marker-645560][bookmark: marker-645562][bookmark: marker-645564][bookmark: marker-645566][bookmark: marker-645568][bookmark: marker-645570][bookmark: marker-645572][bookmark: marker-645574][bookmark: marker-645576][bookmark: marker-645578][bookmark: marker-645580][bookmark: marker-645582]

 
    [bookmark: pgfId-645586]When you configure inspection rules for a device, you select the protocols that you want to inspect. Some of these protocols allow additional configuration for deep inspection. Deep inspection allows you to specify additional requirements that packets must meet in order to traverse the device. For example, you can drop HTTP connections where the content type of the request and response do not match. (For a full list of inspectible protocols, click Add Row on the Inspection Rule page and click Next to view the protocols list.)

 
    [bookmark: pgfId-645591]What you can configure depends not only on the protocol but on the device’s operating system and version number. Typically, your ability to fine-tune inspection is higher on an ASA device compared to an IOS device. (If you are configuring an IOS device and you want greater control over inspection, consider configuring zone-based firewall inspection; for more information, see Understanding the Zone-based Firewall Rules.)

 
    [bookmark: pgfId-645593]Some deep inspection configuration is done directly in the inspection rule. However, for some protocols, you can configure the inspection rule to include a policy map that you create as an independent policy object. (You need to configure policy maps only if you want something other than the default inspection options.) You can configure these maps from the policy object selector dialog box while configuring the policy, or from the Policy Object Manager window (select Manage > Policy Objects).

 
     
      
       
       [bookmark: pgfId-638258]Table 17-10 [bookmark: 46486]Configuring Protocols for Deep Inspection in Inspection Rules 

 
       
      
        
        		
          
          [bookmark: pgfId-638270]Protocol
         
  
        		
          
          [bookmark: pgfId-638272]Device Types
         
  
        		
          
          [bookmark: pgfId-638274]Policy Map
         
  
        		
          
          [bookmark: pgfId-638276]Class Map
          
 (ASA, PIX, FWSM only)
         
  
        		
          
          [bookmark: pgfId-638278]Description and Match Criteria Reference
         
  
       

 
        
        		[bookmark: pgfId-638290]DNS

  
        		[bookmark: pgfId-638292]ASA, PIX, FWSM, IOS

  
        		[bookmark: pgfId-638294]DNS

  
        		[bookmark: pgfId-638296]DNS

  
        		[bookmark: pgfId-638298]Inspect traffic based on a wide variety of criteria using the class and policy map, which allow extensive control over DNS packets. In addition, you can configure a maximum length in the inspection rule, and enable dynamic DNS snooping for use with Botnet rules (on ASA devices). See the following topics:

 
          
          		 [bookmark: pgfId-638303]Configuring DNS Maps

 
          		 [bookmark: pgfId-638308]DNS Class and Policy Maps Add or Edit Match Condition (and Action) Dialog Boxes

 
          		 [bookmark: pgfId-638313]Configure DNS Dialog Box

 
         

  
       

 
        
        		[bookmark: pgfId-638325]FTP Strict

  
        		[bookmark: pgfId-638327]ASA, PIX, FWSM, IOS

  
        		[bookmark: pgfId-638329]FTP

  
        		[bookmark: pgfId-638331]FTP

  
        		[bookmark: pgfId-638339]Inspect traffic based on file name, type, server, user, or FTP command. See Configuring FTP Maps and FTP Class and Policy Maps Add or Edit Match Condition (and Action) Dialog Boxes.

  
       

 
        
        		[bookmark: pgfId-638351]GTP

  
        		[bookmark: pgfId-638353]ASA, PIX, FWSM, IOS

  
        		[bookmark: pgfId-638355]GTP

  
        		[bookmark: pgfId-638357]GTP

  
        		[bookmark: pgfId-638365]Inspect traffic based on timeout values, message sizes, tunnel counts, and GTP versions traversing the security appliance. See Configuring GTP Maps and GTP Policy Maps Add or Edit Match Condition and Action Dialog Boxes.

  
       

 
        
        		[bookmark: pgfId-638377]H.323 H.225

 [bookmark: pgfId-638379]H.323 RAS

  
        		[bookmark: pgfId-638381]ASA, PIX, FWSM

  
        		[bookmark: pgfId-638383]H.323 (ASA, PIX, FWSM)

  
        		[bookmark: pgfId-638385]H.323 (ASA, PIX, FWSM)

  
        		[bookmark: pgfId-638393]Inspect traffic based on a wide variety of criteria, including the H.323 message type, calling party, and called party. See Configuring H.323 Maps and H.323 Class and Policy Maps Add or Edit Match Condition (and Action) Dialog Boxes.

  
       

 
        
        		[bookmark: pgfId-638405]HTTP

  
        		[bookmark: pgfId-638407]ASA, PIX, FWSM, IOS

  
        		[bookmark: pgfId-638409]HTTP (ASA 7.1.x, PIX 7.1.x, FWSM 3.x, IOS)

 [bookmark: pgfId-638411]HTTP (ASA 7.2+, PIX 7.2+)

  
        		[bookmark: pgfId-638413]HTTP (ASA, PIX, FWSM)

  
        		[bookmark: pgfId-638415]Inspect traffic based on a wide variety of criteria including the content of the header or body, port misuse, and whether the traffic includes a Java applet. The maps used differ based on the operating system and version.

 [bookmark: pgfId-638423]For ASA/PIX 7.2+, see Configuring HTTP Maps for ASA 7.2+ and PIX 7.2+ Devices and HTTP Class and Policy Map (ASA 7.2+/PIX 7.2+) Add or Edit Match Condition (and Action) Dialog Boxes.

 [bookmark: pgfId-638428]For ASA/PIX 7.1.x, FWSM 3.x+, and IOS, see Configuring HTTP Maps for ASA 7.1.x, PIX 7.1.x, FWSM 3.x and IOS Devices.

  
       

 
        
        		[bookmark: pgfId-638440]SIP

  
        		[bookmark: pgfId-638442]ASA, PIX, FWSM

  
        		[bookmark: pgfId-638444]SIP (ASA, PIX, FWSM)

  
        		[bookmark: pgfId-638446]SIP (ASA, PIX, FWSM)

  
        		[bookmark: pgfId-638454]Inspect traffic based on a wide variety of criteria. See Configuring SIP Maps and SIP Class and Policy Maps Add or Edit Match Condition (and Action) Dialog Boxes.

  
       

 
        
        		[bookmark: pgfId-638466]Skinny

  
        		[bookmark: pgfId-638468]ASA, PIX, FWSM, IOS

  
        		[bookmark: pgfId-638470]Skinny

  
        		[bookmark: pgfId-638472](none)

  
        		[bookmark: pgfId-638480]Inspect traffic based on a wide variety of criteria. See Configuring Skinny Maps and Skinny Policy Maps Add or Edit Match Condition and Action Dialog Boxes.

  
       

 
        
        		[bookmark: pgfId-638492]SMTP

  
        		[bookmark: pgfId-638494]ASA, PIX 7.x+, FWSM 3.x+, IOS

  
        		[bookmark: pgfId-638496](none)

  
        		[bookmark: pgfId-638498](none)

  
        		[bookmark: pgfId-638503]Inspect Simple Mail Transfer Protocol (SMTP) traffic and drop any that use illegal commands. You can configure a maximum data length for packets. See Configure SMTP Dialog Box.

  
       

 
        
        		[bookmark: pgfId-638515]SNMP

  
        		[bookmark: pgfId-638517]ASA, PIX, FWSM 3.x+, IOS

  
        		[bookmark: pgfId-638519]SNMP

  
        		[bookmark: pgfId-638521](none)

  
        		[bookmark: pgfId-638526]Inspect SNMP traffic based on SNMP version. See Configuring SNMP Maps.

  
       

 
        
        		[bookmark: pgfId-638538]NetBIOS

  
        		[bookmark: pgfId-638540]ASA, PIX 7.x+, FWSM

  
        		[bookmark: pgfId-638542]NetBIOS

  
        		[bookmark: pgfId-638544](none)

  
        		[bookmark: pgfId-638549]Inspect NetBIOS traffic to translate IP addresses in the NetBIOS name service (NBNS) packets according to the security appliance NAT configuration. You can drop packets that violate the protocol. See Configuring NetBIOS Maps.

  
       

 
        
        		[bookmark: pgfId-638561]IPSec Pass Through

  
        		[bookmark: pgfId-638563]ASA, PIX 7.x+

  
        		[bookmark: pgfId-638565]IPsec Pass Through

  
        		[bookmark: pgfId-638567](none)

  
        		[bookmark: pgfId-638572]Inspect IPSec traffic and control whether ESP or AH traffic is allowed. See Configuring IPsec Pass Through Maps.

  
       

 
        
        		[bookmark: pgfId-638584]DCE/RPC

  
        		[bookmark: pgfId-638586]ASA 7.2+, PIX 7.2+, FWSM 3.2+

  
        		[bookmark: pgfId-638588]DCE/RPC

  
        		[bookmark: pgfId-638590](none)

  
        		[bookmark: pgfId-638595]Inspect traffic based on timeouts and enforcing the mapper service. See Configuring DCE/RPC Maps.

  
       

 
        
        		[bookmark: pgfId-638607]IP options

  
        		[bookmark: pgfId-638609]ASA 8.2(2)+

  
        		[bookmark: pgfId-638611]IP Options

  
        		[bookmark: pgfId-638613](none)

  
        		[bookmark: pgfId-638618]Allow IP packets that have certain options configured in the Options section of the IP header. In routed mode, packets that contain the router-alert option are allowed. Otherwise, if any option is set, packets are dropped. IP options are unnecessary for most communication, but the NOP (no operation) option might be used for padding, so you might want to allow it. See Configuring IP Options Maps.

  
       

 
        
        		[bookmark: pgfId-638630]IPv6

  
        		[bookmark: pgfId-638632]ASA 8.4(2)+

  
        		[bookmark: pgfId-638634]IPv6

  
        		[bookmark: pgfId-638636](none)

  
        		[bookmark: pgfId-638644]Inspect IPv6 traffic based on the following types of extension headers found anywhere in an IPv6 packet: Hop-by-Hop Options, Routing (Type 0), Fragment, Destination Options, Authentication, and Encapsulating Security Payload. See Configuring IPv6 Maps and IPv6 Policy Maps Add or Edit Match Condition and Action Dialog Boxes.

  
       

 
        
        		[bookmark: pgfId-638656]ESMTP

  
        		[bookmark: pgfId-638658]ASA, PIX 7.x+, FWSM 3.x+, IOS

  
        		[bookmark: pgfId-638660]ESMTP

  
        		[bookmark: pgfId-638662](none)

  
        		[bookmark: pgfId-638667]Inspect ESMTP traffic. For IOS, you can configure only maximum data length. For ASA, PIX, FWSM, you can inspect traffic based on a wide variety of criteria. See Configuring ESMTP Maps.

  
       

 
        
        		[bookmark: pgfId-638679]Fragment

  
        		[bookmark: pgfId-638681]IOS

  
        		[bookmark: pgfId-638683](none)

  
        		[bookmark: pgfId-638685](none)

  
        		[bookmark: pgfId-638690]Inspect traffic based on a maximum allowed number of unassembled packet fragments. See Configure Fragments Dialog Box.

  
       

 
        
        		[bookmark: pgfId-638702]IMAP (Internet Message Access Protocol)

 [bookmark: pgfId-638704]POP3 (Post Office Protocol 3)

  
        		[bookmark: pgfId-638706]IOS

  
        		[bookmark: pgfId-638708](none)

  
        		[bookmark: pgfId-638710](none)

  
        		[bookmark: pgfId-638715]Inspect traffic based on invalid commands or clear text logins. See Configure IMAP or POP3 Dialog Boxes.

  
       

 
        
        		[bookmark: pgfId-638727]RPC (Sun Remote Procedure Call)

  
        		[bookmark: pgfId-638729]FWSM 2.x, IOS

  
        		[bookmark: pgfId-638731](none)

  
        		[bookmark: pgfId-638733](none)

  
        		[bookmark: pgfId-638738]Inspect traffic based on the RPC protocol number. See Configure RPC Dialog Box.

  
       

 
        
        		[bookmark: pgfId-638750]IM

  
        		[bookmark: pgfId-638752]ASA, PIX 7.x+, IOS

  
        		[bookmark: pgfId-638754]IM (ASA 7.2+, PIX 7.2+)

 [bookmark: pgfId-638756]IM (IOS)

  
        		[bookmark: pgfId-638758]IM (only for ASA, PIX)

  
        		[bookmark: pgfId-638760]Inspect traffic based on a wide variety of criteria. The allowed maps differ based on operating system version.

 [bookmark: pgfId-638768]For ASA, PIX, see Configuring IM Maps for ASA 7.2+, PIX 7.2+ Devices and IM Class and Policy Map (ASA 7.2+/PIX 7.2+) Add or Edit Match Condition (and Action) Dialog Boxes.

 [bookmark: pgfId-638773]For IOS, see Configuring IM Maps for IOS Devices.

  
       

 
      
     

 
    
 
    [bookmark: pgfId-645603]Related Topics

 
     
     		 [bookmark: pgfId-645608]Selecting Which Protocols To Inspect

 
     		 [bookmark: pgfId-645613]Understanding Inspection Rules

 
     		 [bookmark: pgfId-645618]Using Inspection To Prevent Denial of Service (DoS) Attacks on IOS Devices

 
     		 [bookmark: pgfId-645623]Configuring Inspection Rules

 
     		 [bookmark: pgfId-645628]Creating Policy Objects

 
     		 [bookmark: pgfId-645633]Understanding Map Objects

 
     		 [bookmark: pgfId-645638]Add/Edit Regular Expressions

 
     		 [bookmark: pgfId-645643]Configuring Regular Expression Groups

 
    

 
     
      [bookmark: pgfId-645757][bookmark: 46789][bookmark: pobjpage_cncpt_ClassMapsDialogBoxes]Configuring Class Maps for Inspection Policies[bookmark: marker-645663][bookmark: marker-645665][bookmark: marker-645667][bookmark: marker-645669][bookmark: marker-645671][bookmark: marker-645673][bookmark: marker-645675][bookmark: marker-645677][bookmark: marker-645679][bookmark: marker-645681][bookmark: marker-645683][bookmark: marker-645685][bookmark: marker-645687][bookmark: marker-645689][bookmark: marker-645691][bookmark: marker-645693][bookmark: marker-645695][bookmark: marker-645697][bookmark: marker-645699][bookmark: marker-645701][bookmark: marker-645703][bookmark: marker-645705][bookmark: marker-645707][bookmark: marker-645709][bookmark: marker-645711][bookmark: marker-645713][bookmark: marker-645715][bookmark: marker-645717][bookmark: marker-645719][bookmark: marker-645721][bookmark: marker-645723][bookmark: marker-645725][bookmark: marker-645727][bookmark: marker-645729][bookmark: marker-645731][bookmark: marker-645733][bookmark: marker-645735][bookmark: marker-645737][bookmark: marker-645739][bookmark: marker-645741][bookmark: marker-645743][bookmark: marker-645745][bookmark: marker-645747][bookmark: marker-645749][bookmark: marker-645751][bookmark: marker-645753][bookmark: marker-645755]

 
     [bookmark: pgfId-645759]Use the Add and Edit Class Map dialog boxes to define class maps to be used in policy maps of the same type. The name of the dialog box indicates the type of map you are creating.

 
     [bookmark: pgfId-645761]A class map defines application traffic based on criteria specific to the application. You then select the class map in the corresponding policy map and configure the action to take for the selected traffic. Thus, each class map must contain traffic that you want to handle in the same way (for example, to allow it or to drop it).

 
     [bookmark: pgfId-645763]When configuring inspection rules for devices running ASA/PIX 7.2 or higher, or FWSM, you can create class maps for the inspection of the following types of traffic: DNS, FTP, H.323, HTTP, IM, SIP, and ScanSafe.

 
     [bookmark: pgfId-645765]You can also define class criteria in the related policy map. However, creating class maps allows you to reuse the map in multiple policy maps.

 
     [bookmark: pgfId-645767]The following topics describe the available match criteria:

 
      
      		 [bookmark: pgfId-645772]DNS Class and Policy Maps Add or Edit Match Condition (and Action) Dialog Boxes

 
      		 [bookmark: pgfId-645777]FTP Class and Policy Maps Add or Edit Match Condition (and Action) Dialog Boxes

 
      		 [bookmark: pgfId-645782]H.323 Class and Policy Maps Add or Edit Match Condition (and Action) Dialog Boxes

 
      		 [bookmark: pgfId-645787]HTTP Class and Policy Map (ASA 7.2+/PIX 7.2+) Add or Edit Match Condition (and Action) Dialog Boxes

 
      		 [bookmark: pgfId-645792]IM Class and Policy Map (ASA 7.2+/PIX 7.2+) Add or Edit Match Condition (and Action) Dialog Boxes

 
      		 [bookmark: pgfId-645797]SIP Class and Policy Maps Add or Edit Match Condition (and Action) Dialog Boxes

 
     

 
     [bookmark: pgfId-645799]Navigation Path

 
     [bookmark: pgfId-645801]Select Manage > Policy Objects, then select DNS, FTP, H.323 (ASA/PIX/FWSM), HTTP (ASA/PIX/FWSM), IM, or SIP (ASA/PIX/FWSM) in the Maps > Class Maps > Inspect folder in the table of contents. Right-click inside the work area, then select New Object, or right-click a row, then select Edit Object.

 
     [bookmark: pgfId-645803]Related Topics

 
      
      		 [bookmark: pgfId-645808]Understanding Map Objects

 
      		 [bookmark: pgfId-645813]Configuring Protocols and Maps for Inspection

 
      		 [bookmark: pgfId-645818]Understanding Inspection Rules

 
     

 
     [bookmark: pgfId-645820]Field Reference

 
     [bookmark: pgfId-645823] 

 
      
       
        
        [bookmark: pgfId-638786]Table 17-11 [bookmark: 46941]Add or Edit Class Maps Dialog Boxes for Inspection Rules 

 
        
       
         
         		
           
           [bookmark: pgfId-638792]Element
          
  
         		
           
           [bookmark: pgfId-638794]Description
          
  
        

 
         
         		[bookmark: pgfId-638800]Name

  
         		[bookmark: pgfId-638802]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-638808]Description

  
         		[bookmark: pgfId-638810]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-638816]Match table

 [bookmark: pgfId-638818]Match Type

  
         		[bookmark: pgfId-638820]The Match table lists the criteria included in the class map. Each row indicates whether the inspection is looking for traffic that matches or does not match each criterion and the criterion and value that is inspected.

 
           
           		 [bookmark: pgfId-638822]To add a criterion, click the Add button and fill in the Match Criterion dialog box. For more information, see the topics referenced above.

 
           		 [bookmark: pgfId-638824]To edit a criterion, select it and click the Edit button.

 
           		 [bookmark: pgfId-638826]To delete a criterion, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-638832]Category

  
         		[bookmark: pgfId-638837]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-638843]Allow Value Override per Device

 [bookmark: pgfId-638845]Overrides

 [bookmark: pgfId-638847]Edit button

  
         		[bookmark: pgfId-638855]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-638857]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-645843][bookmark: 46993][bookmark: pobjpage_cncpt_AddEditDCE_RPC]Configuring DCE/RPC Maps[bookmark: marker-645831][bookmark: marker-645833][bookmark: marker-645835][bookmark: marker-645837][bookmark: marker-645839][bookmark: marker-645841]

 
     [bookmark: pgfId-645845]Use the Add or Edit DCE/RPC Map dialog boxes to define a map for DCE/RPC inspection. A DCE/RPC inspection policy map lets you change the default configuration values used for DCE/RPC inspection.

 
     [bookmark: pgfId-645847]DCE/RPC is a protocol widely used by Microsoft distributed client and server applications that allows software clients to execute programs on a server remotely.

 
     [bookmark: pgfId-645849]This typically involves a client querying a server called the Endpoint Mapper listening on a well-known port number for the dynamically allocated network information of a required service. The client then sets up a secondary connection to the server instance providing the service. The security appliance allows the appropriate port number and network address and also applies NAT, if needed, for the secondary connection.

 
     [bookmark: pgfId-645851]DCE/RPC inspection maps inspect for native TCP communication between the EPM and client on well-known TCP port 135. Map and lookup operations of the EPM are supported for clients. Client and server can be located in any security zone. The embedded server IP address and port number are received from the applicable EPM response messages. Because a client may attempt multiple connections to the server port returned by EPM, multiple use of pinholes are allowed, which have user configurable timeouts.

 
     [bookmark: pgfId-645853]Navigation Path

 
     [bookmark: pgfId-645855]Select Manage > Policy Objects, then select Maps > Policy Maps > Inspect > DCE/RPC from the Object Type selector. Right-click inside the work area, then select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-645857]Related Topics

 
      
      		 [bookmark: pgfId-645862]Understanding Map Objects

 
      		 [bookmark: pgfId-645867]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-645869]Field Reference

 
     [bookmark: pgfId-645872] 

 
      
       
        
        [bookmark: pgfId-638870]Table 17-12 [bookmark: 47039]Add and Edit DCE/RPC Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-638876]Element
          
  
         		
           
           [bookmark: pgfId-638878]Description
          
  
        

 
         
         		[bookmark: pgfId-638884]Name

  
         		[bookmark: pgfId-638886]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-638892]Description

  
         		[bookmark: pgfId-638894]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-638900]Pinhole Timeout

  
         		[bookmark: pgfId-638902]The timeout for DCE/RPC pinholes. The default is 2 minutes (00:02:00). Valid values are between 00:00:01 and 1193:00:00.

  
        

 
         
         		[bookmark: pgfId-638908]Enforce Endpoint Mapper Service

  
         		[bookmark: pgfId-638910]Whether to enforce the endpoint mapper service during binding. Using this service, a client queries a server, called the Endpoint Mapper, for the dynamically allocated network information of a required service.

  
        

 
         
         		[bookmark: pgfId-638916]Enable Endpoint Mapper Service Lookup

 [bookmark: pgfId-638918]Service Lookup Timeout

  
         		[bookmark: pgfId-638920]Whether to enable the lookup operation of the endpoint mapper service. If you select this option, you can enter the time out for the lookup operation. If you do not specify a timeout, the pinhole timeout or default pinhole timeout value is used. Valid values are between 00:00:01 and 1193:00:00.

  
        

 
         
         		[bookmark: pgfId-638926]Category

  
         		[bookmark: pgfId-638931]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-638937]Allow Value Override per Device

 [bookmark: pgfId-638939]Overrides

 [bookmark: pgfId-638941]Edit button

  
         		[bookmark: pgfId-638949]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-638951]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-645898][bookmark: 47094][bookmark: pobjpage_cncpt_AddandEditDNSMapDialogBoxes]Configuring DNS Maps[bookmark: marker-645886][bookmark: marker-645888][bookmark: marker-645890][bookmark: marker-645892][bookmark: marker-645894][bookmark: marker-645896]

 
     [bookmark: pgfId-645900]Use the Add and Edit DNS Map dialog boxes to define DNS Maps for inspection. A DNS map lets you change the default configuration values used for DNS application inspection.

 
     [bookmark: pgfId-645902]DNS application inspection supports DNS message controls that provide protection against DNS spoofing and cache poisoning. You can configure rules for certain DNS types to be allowed, dropped, or logged, while others are blocked. For example, you can restrict zone transfer between servers.

 
     [bookmark: pgfId-645904]The Recursion Desired and Recursion Available flags in the DNS header can be masked to protect a public server from attack if that server only supports a particular internal zone. In addition, DNS randomization can be enabled to avoid spoofing and cache poisoning of servers that either do not support randomization or that use a weak pseudo random number generator. Limiting the domain names that can be queried protects the public server further.

 
     [bookmark: pgfId-645906]You can configure a DNS mismatch alert as notification if an excessive number of mismatching DNS responses are received, which could indicate a cache poisoning attack.

 
     [bookmark: pgfId-645908]Navigation Path

 
     [bookmark: pgfId-645910]Select Manage > Policy Objects, then select Maps > Policy Maps > Inspect > DNS from the Object Type selector. Right-click inside the work area, then select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-645912]Related Topics

 
      
      		 [bookmark: pgfId-645917]Understanding Map Objects

 
      		 [bookmark: pgfId-645922]Configuring Protocols and Maps for Inspection

 
      		 [bookmark: pgfId-645927]Configuring Class Maps for Inspection Policies

 
     

 
     [bookmark: pgfId-645929]Field Reference

 
     [bookmark: pgfId-645932] 

 
      
       
        
        [bookmark: pgfId-638964]Table 17-13 [bookmark: 47148]Add and Edit DNS Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-638970]Element
          
  
         		
           
           [bookmark: pgfId-638972]Description
          
  
        

 
         
         		[bookmark: pgfId-638978]Name

  
         		[bookmark: pgfId-638980]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-638986]Description

  
         		[bookmark: pgfId-638988]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		 [bookmark: pgfId-638994]Protocol Conformance Tab

 [bookmark: pgfId-638999]Defines DNS security settings and actions. For a description of the options on this tab, see DNS Map Protocol Conformance Tab.

  
        

 
         
         		 [bookmark: pgfId-639007]Filtering Tab

 [bookmark: pgfId-639012]Defines the filtering settings for DNS. For a description of the options on this tab, see DNS Map Filtering Tab.

  
        

 
         
         		 [bookmark: pgfId-639020]Mismatch Rate Tab

 [bookmark: pgfId-639022]The Log When DNS ID Mismatch Rate Exceeds option determines whether you want to report excessive instances of DNS identifier mismatches based on the following criteria:

 
           
           		 [bookmark: pgfId-639024]Threshold—The maximum number of mismatch instances before a system message log is sent. Values are 0 to 4294967295.

 
           		 [bookmark: pgfId-639026]Time Interval—The time period to monitor (in seconds). Values are 1 to 31536000.

 
          

  
        

 
         
         		 [bookmark: pgfId-639034]Match Condition and Action Tab

 [bookmark: pgfId-639036]The Match All table lists the criteria included in the policy map. Each row indicates whether the inspection is looking for traffic that matches or does not match each criterion, the criterion and value that is inspected, and the action to be taken for traffic that satisfies the conditions.

 
           
           		 [bookmark: pgfId-639041]To add a criterion, click the Add button and fill in the Match Condition and Action dialog box (see DNS Class and Policy Maps Add or Edit Match Condition (and Action) Dialog Boxes).

 
           		 [bookmark: pgfId-639043]To edit a criterion, select it and click the Edit button.

 
           		 [bookmark: pgfId-639045]To delete a criterion, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-639053]Category

  
         		[bookmark: pgfId-639058]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-639064]Allow Value Override per Device

 [bookmark: pgfId-639066]Overrides

 [bookmark: pgfId-639068]Edit button

  
         		[bookmark: pgfId-639076]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-639078]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-645942][bookmark: 47226][bookmark: pobjpage_cncpt_AddandEditDNSMapProtocolConformance]DNS Map Protocol Conformance Tab [bookmark: marker-645938][bookmark: marker-645940]

 
     [bookmark: pgfId-645944]Use the Protocol Conformance tab to define DNS security settings and actions for a DNS map.

 
     [bookmark: pgfId-645946]Navigation Path

 
     [bookmark: pgfId-645951]Click the Protocol Conformance tab on the Add and Edit DNS Map dialog boxes. See Configuring DNS Maps.

 
     [bookmark: pgfId-645953]Related Topics

 
      
      		 [bookmark: pgfId-645958]Understanding Map Objects

 
      		 [bookmark: pgfId-645963]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-645965]Field Reference

 
     [bookmark: pgfId-645968] 

 
      
       
        
        [bookmark: pgfId-639091]Table 17-14 [bookmark: 47251]DNS Map Protocol Conformance Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-639097]Element
          
  
         		
           
           [bookmark: pgfId-639099]Description
          
  
        

 
         
         		[bookmark: pgfId-639105]Enable DNS Guard Function

  
         		[bookmark: pgfId-639107]Whether to perform a DNS query and response mismatch check using the identification field in the DNS header. One response per query is allowed to go through the security appliance.

  
        

 
         
         		[bookmark: pgfId-639113]Generate Syslog for ID Mismatch

  
         		[bookmark: pgfId-639115]Whether to create syslog entries for excessive instances of DNS identifier mismatches.

  
        

 
         
         		[bookmark: pgfId-639121]Randomize the DNS Identifier for DNS Query

  
         		[bookmark: pgfId-639123]Whether to randomize the DNS identifier in the DNS query message.

  
        

 
         
         		[bookmark: pgfId-639129]Enable NAT Rewrite Function

  
         		[bookmark: pgfId-639131]Whether to enable IP address translation in the A record of the DNS response.

  
        

 
         
         		[bookmark: pgfId-639137]Enable Protocol Enforcement

  
         		[bookmark: pgfId-639139]Whether to enable DNS message format check, including domain name, label length, compression, and looped pointer check.

  
        

 
         
         		[bookmark: pgfId-639145]Require Authentication Between DNS Server (RFC2845)

 [bookmark: pgfId-639147]Action

  
         		[bookmark: pgfId-639149]Whether to require authentication between DNS servers as defined in RFC 2845. If you select this option, select the action to take when there is no authentication.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-645978][bookmark: 47293][bookmark: pobjpage_cncpt_AddandEditDNSMapFiltering]DNS Map Filtering Tab [bookmark: marker-645974][bookmark: marker-645976]

 
     [bookmark: pgfId-645980]Use the Filtering tab to define DNS filtering settings and actions for a DNS map.

 
     [bookmark: pgfId-645982]Navigation Path

 
     [bookmark: pgfId-645987]Click the Filtering tab on the Add and Edit DNS Map dialog boxes. See Configuring DNS Maps.

 
     [bookmark: pgfId-645989]Related Topics

 
      
      		 [bookmark: pgfId-645994]Understanding Map Objects

 
      		 [bookmark: pgfId-645999]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-646001]Field Reference

 
     [bookmark: pgfId-646004] 

 
      
       
        
        [bookmark: pgfId-639162]Table 17-15 [bookmark: 47318]DNS Map Filtering Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-639168]Element
          
  
         		
           
           [bookmark: pgfId-639170]Description
          
  
        

 
         
         		[bookmark: pgfId-639176]Drop Packets that Exceed Specified Length

 [bookmark: pgfId-639178]Maximum Packet Length

  
         		[bookmark: pgfId-639180]Whether to drop packets that exceed the maximum length in bytes that you specify. This is a global setting.

  
        

 
         
         		[bookmark: pgfId-639186]Drop Packets Sent to Server that Exceed Specified Maximum Length

 [bookmark: pgfId-639188]Maximum Length

  
         		[bookmark: pgfId-639190]Whether to drop packets sent to the server that exceed the maximum length in bytes that you specify.

  
        

 
         
         		[bookmark: pgfId-639196]Drop Packets Sent to Server that Exceed Length Indicated by Resource Record

  
         		[bookmark: pgfId-639198]Whether to drop packets sent to the server that exceed the length indicated by the resource record.

  
        

 
         
         		[bookmark: pgfId-639204]Drop Packets Sent to Client that Exceed Specified Length

 [bookmark: pgfId-639206]Maximum Length

  
         		[bookmark: pgfId-639208]Whether to drop packets sent to a client that exceed the maximum length in bytes that you specify.

  
        

 
         
         		[bookmark: pgfId-639214]Drop Packets Sent to Client that Exceed Length Indicated by Resource Record

  
         		[bookmark: pgfId-639216]Whether to drop packets sent to the client that exceed the length indicated by the resource record.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646048][bookmark: 47357][bookmark: pobjpage_cncpt_DNSClassandPolicyMapsAddorEditMatchConditionandActionDialogBoxes]DNS Class and Policy Maps Add or Edit Match Condition (and Action) Dialog Boxes [bookmark: marker-646036][bookmark: marker-646038][bookmark: marker-646040][bookmark: marker-646042][bookmark: marker-646044][bookmark: marker-646046]

 
     [bookmark: pgfId-646050]Use the Add or Edit DNS Match Criterion (for DNS class maps) or Match Condition and Action (for DNS policy maps) dialog boxes to do the following:

 
      
      		 [bookmark: pgfId-646052]Define the match criterion and value for a DNS class map.

 
      		 [bookmark: pgfId-646054]Select a DNS class map when creating a DNS policy map.

 
      		 [bookmark: pgfId-646056]Define the match criterion, value, and action directly in a DNS policy map.

 
     

 
     [bookmark: pgfId-646058]The fields on this dialog box change based on the criterion you select and whether you are creating a class map or policy map.

 
     [bookmark: pgfId-646060]Navigation Path

 
     [bookmark: pgfId-646065]When creating a DNS class map, in the Policy Object Manager, from the Add or Edit Class Maps dialog boxes for DNS, right-click inside the table, then select Add Row or right-click a row, then select Edit Row. See Configuring Class Maps for Inspection Policies.

 
     [bookmark: pgfId-646070]When creating a DNS policy map, in the Policy Object Manager, from the Match Condition and Action tab on the Add and Edit DNS Map dialog boxes, right-click inside the table, then select Add Row or right-click a row, then select Edit Row. See Configuring DNS Maps.

 
     [bookmark: pgfId-646072]Related Topics

 
      
      		 [bookmark: pgfId-646077]Understanding Map Objects

 
      		 [bookmark: pgfId-646082]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-646084]Field Reference

 
     [bookmark: pgfId-646087] 

 
      
       
        
        [bookmark: pgfId-639229]Table 17-16 [bookmark: 47421]DNS Class and Policy Maps Add and Edit Match Condition and Action Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-639235]Element
          
  
         		
           
           [bookmark: pgfId-639237]Description
          
  
        

 
         
         		[bookmark: pgfId-639243]Match Type

 [bookmark: pgfId-639245]Class Name

 [bookmark: pgfId-639247](Policy Map only)

  
         		[bookmark: pgfId-639249]Enables you to use an existing DNS class map or define a new DNS class map.

 
           
           		 [bookmark: pgfId-639251]Use Specified Values—You want to define the class map on this dialog box.

 
           		 [bookmark: pgfId-639253]Use Values in Class Map—You want to select an existing DNS class map policy object. Enter the name of the DNS class map in the  Class Name field. Click  Select to select the map from a list or to create a new class map object.

 
          

  
        

 
         
         		[bookmark: pgfId-639259]Criterion

  
         		[bookmark: pgfId-639261]Specifies which criterion of traffic to match:

 
           
           		 [bookmark: pgfId-639263]DNS Class—Matches a DNS query or resource record class.

 
           		 [bookmark: pgfId-639265]DNS Type—Matches a DNS query or resource record type.

 
           		 [bookmark: pgfId-639267]Domain Name—Matches a domain name from a DNS query or resource record.

 
           		 [bookmark: pgfId-639269]Header Flag—Matches a DNS flag in the header.

 
           		 [bookmark: pgfId-639271]Question—Matches a DNS question.

 
           		 [bookmark: pgfId-639273]Resource Record—Matches a DNS resource record.

 
          

  
        

 
         
         		[bookmark: pgfId-639279]Type

  
         		[bookmark: pgfId-639281]Specifies whether the map includes traffic that matches or does not match the criterion. For example, if Doesn’t Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the map.

 
           
           		 [bookmark: pgfId-639283]Matches—Matches the criterion.

 
           		 [bookmark: pgfId-639285]Doesn’t Match—Does not match the criterion.

 
          

  
        

 
         
         		[bookmark: pgfId-639291]Action

 [bookmark: pgfId-639293](Policy Map only)

  
         		[bookmark: pgfId-639295]The action you want the device to take for traffic that matches the defined criteria.

  
        

 
         
         		 [bookmark: pgfId-639301]Variable Fields

 [bookmark: pgfId-639303]The following fields vary based on what you select in the Criterion field. This list is a super-set of the fields you might see.

  
        

 
         
         		[bookmark: pgfId-639311]Value

 [bookmark: pgfId-639313](for DNS Class criterion)

  
         		[bookmark: pgfId-639315]The DNS class you want to inspect:

 
           
           		 [bookmark: pgfId-639317]Internet—Matches the Internet DNS class.

 
           		 [bookmark: pgfId-639319]DNS Class Field Value—Matches the specified number.

 
           		 [bookmark: pgfId-639321]DNS Class Field Range—Matches the specified range of numbers.

 
          

  
        

 
         
         		[bookmark: pgfId-639327]Value

 [bookmark: pgfId-639329](for DNS Type criterion)

  
         		[bookmark: pgfId-639331]The DNS type you want to inspect:

 
           
           		 [bookmark: pgfId-639333]DNS Type Field Name—Matches the name of a DNS type:

 
          

 [bookmark: pgfId-639335] – A—IPv4 address.

 [bookmark: pgfId-639337] – AXFR—Full (zone) transfer.

 [bookmark: pgfId-639339] – CNAME—Canonical name.

 [bookmark: pgfId-639341] – IXFR—Incremental (zone) transfer.

 [bookmark: pgfId-639343] – NS—Authoritative name server.

 [bookmark: pgfId-639345] – SOA—Start of a zone of authority.

 [bookmark: pgfId-639347] – TSIG—Transaction signature.

 
           
           		 [bookmark: pgfId-639349]DNS Type Field Value—Matches the specified number.

 
           		 [bookmark: pgfId-639351]DNS Type Field Range—Matches the specified range of numbers.

 
          

  
        

 
         
         		[bookmark: pgfId-639357]Value

 [bookmark: pgfId-639359](for Domain Name criterion)

  
         		[bookmark: pgfId-639361]The regular expression you want to evaluate. You can select one of the following:

 
           
           		 [bookmark: pgfId-639363]Regular Expression—The regular expression object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click  Select to choose the object from a list of existing ones or to create a new regular expression object.

 
           		 [bookmark: pgfId-639365]Regular Expression Group—The regular expression group object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click  Select to choose the object from a list of existing ones or to create a new regular expression group object.

 
          

  
        

 
         
         		[bookmark: pgfId-639371]Options

 [bookmark: pgfId-639373]Value

 [bookmark: pgfId-639375](for Header Flag criterion)

  
         		[bookmark: pgfId-639377]The header flag you want to inspect. Use the Options field to indicate whether you want an exact match (Equals) or a partial match (Contains).

 
           
           		 [bookmark: pgfId-639379]Header Flag Name—Matches the selected header flag names:

 
          

 [bookmark: pgfId-639381] – AA (authoritative answer)

 [bookmark: pgfId-639383] – QR (query)

 [bookmark: pgfId-639385] – RA (recursion available)

 [bookmark: pgfId-639387] – RD (recursion denied)

 [bookmark: pgfId-639389] – TC (truncation) flag bits

 
           
           		 [bookmark: pgfId-639391]Header Flag Value—Matches the specified 16-bit hexadecimal value.

 
          

  
        

 
         
         		[bookmark: pgfId-639397]Resource Record

  
         		[bookmark: pgfId-639399]Lists the sections to match:

 
           
           		 [bookmark: pgfId-639401]Additional—DNS additional resource record.

 
           		 [bookmark: pgfId-639403]Answer—DNS answer resource record.

 
           		 [bookmark: pgfId-639405]Authority—DNS authority resource record.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646109][bookmark: 47576][bookmark: pobjpage_cncpt_AddandEditESMTPMapDialogBoxes]Configuring ESMTP Maps[bookmark: marker-646097][bookmark: marker-646099][bookmark: marker-646101][bookmark: marker-646103][bookmark: marker-646105][bookmark: marker-646107]

 
     [bookmark: pgfId-646111]Use the Add and Edit ESMTP Map dialog boxes to define the match criterion and values for the ESMTP inspect map. An ESMTP policy map lets you change the default configuration values used for ESMTP inspection.

 
     [bookmark: pgfId-646113]ESMTP inspection detects attacks, including spam, phising, malformed message attacks, and buffer overflow/underflow attacks. It also provides support for application security and protocol conformance, which enforce the sanity of the ESMTP messages as well as detect several attacks, block senders/receivers, and block mail relay.

 
     [bookmark: pgfId-646115]Navigation Path

 
     [bookmark: pgfId-646117]Select Manage > Policy Objects, then select Maps > Policy Maps > Inspect > ESMTP from the Object Type selector. Right-click inside the table, then select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-646119]Related Topics

 
      
      		 [bookmark: pgfId-646124]Understanding Map Objects

 
      		 [bookmark: pgfId-646129]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-646131]Field Reference

 
     [bookmark: pgfId-646134] 

 
      
       
        
        [bookmark: pgfId-639418]Table 17-17 [bookmark: 47621]Add and Edit ESMTP Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-639424]Element
          
  
         		
           
           [bookmark: pgfId-639426]Description
          
  
        

 
         
         		[bookmark: pgfId-639432]Name

  
         		[bookmark: pgfId-639434]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-639440]Description

  
         		[bookmark: pgfId-639442]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		 
           
           [bookmark: pgfId-639448]Parameters tab
          
  
        

 
         
         		[bookmark: pgfId-639456]Mask Server Banner

  
         		[bookmark: pgfId-639458]Whether to mask the server banner to prevent the client from discovering server information.

  
        

 
         
         		[bookmark: pgfId-639464]Configure Mail Relay

 [bookmark: pgfId-639466]Domain Name

 [bookmark: pgfId-639468]Action

  
         		[bookmark: pgfId-639470]Whether to have ESMTP inspection detect mail relay. When you select this option, enter the domain name you are inspecting and select the action you want to take when mail relay is detected.

  
        

 
         
         		[bookmark: pgfId-639476]Special Character (ASA7.2.3+/PIX7.2.3+)

 [bookmark: pgfId-639478]Action

  
         		[bookmark: pgfId-639480]Whether you want to detect special characters in sender or receiver email addresses. If you select this option, select the action you want to take when special characters are detected.

  
        

 
         
         		[bookmark: pgfId-639486]Allow TLS (ASA7.2.3+, 8.0.3+/PIX7.2.3)

 [bookmark: pgfId-639488]Action Log

  
         		[bookmark: pgfId-639490]Whether to allow a TLS proxy on the security appliance. If you select this option, you can also select Action Log to create a log entry when TLS is detected.

  
        

 
         
         		 [bookmark: pgfId-639496]Match Condition and Action Tab

 [bookmark: pgfId-639498]The Match All table lists the criteria included in the policy map. Each row indicates whether the inspection is looking for traffic that matches or does not match each criterion, the criterion and value that is inspected, and the action to be taken for traffic that satisfies the conditions.

 
           
           		 [bookmark: pgfId-639503]To add a criterion, click the Add button and fill in the Match Condition and Action dialog box (see ESMTP Policy Maps Add or Edit Match Condition and Action Dialog Boxes).

 
           		 [bookmark: pgfId-639505]To edit a criterion, select it and click the Edit button.

 
           		 [bookmark: pgfId-639507]To delete a criterion, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-639515]Category

  
         		[bookmark: pgfId-639520]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-639526]Allow Value Override per Device

 [bookmark: pgfId-639528]Overrides

 [bookmark: pgfId-639530]Edit button

  
         		[bookmark: pgfId-639538]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-639540]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646176][bookmark: 47702][bookmark: pobjpage_cncpt_ESMTPClassandPolicyMapsAddorEditMatchConditionandActionDialogBoxes]ESMTP Policy Maps Add or Edit Match Condition and Action Dialog Boxes [bookmark: marker-646170][bookmark: marker-646172][bookmark: marker-646174]

 
     [bookmark: pgfId-646178]Use the Add or Edit Match Condition and Action dialog boxes to define the match criterion, value, and action for an ESMTP policy map.

 
     [bookmark: pgfId-646180]The fields on this dialog box change based on the criterion you select. You can use the following criteria:

 
      
      		 [bookmark: pgfId-646182]Body Length—Matches the message body length.

 
      		 [bookmark: pgfId-646184]Body Line Length—Matches the length of a line in the message body.

 
      		 [bookmark: pgfId-646186]Commands—Matches ESMTP commands.

 
      		 [bookmark: pgfId-646188]Command Recipient Count—Matches the number of recipient email addresses.

 
      		 [bookmark: pgfId-646190]Command Line Length—Matches the number of characters of a command line.

 
      		 [bookmark: pgfId-646192]EHLO Reply Parameters—Matches the ESMTP EHLO reply parameters.

 
      		 [bookmark: pgfId-646194]Header Length—Matches the number of characters of the header.

 
      		 [bookmark: pgfId-646196]Header Line Length—Matches the number of characters of a line in the message header.

 
      		 [bookmark: pgfId-646198]To Recipients Count—Matches the number of recipients in the To field of the header.

 
      		 [bookmark: pgfId-646200]Invalid Recipients Count—Matches the number of invalid recipients in the header.

 
      		 [bookmark: pgfId-646202]MIME File Type—Matches the MIME file type.

 
      		 [bookmark: pgfId-646204]MIME Filename Length—Matches the number of characters of the filename.

 
      		 [bookmark: pgfId-646206]MIME Encoding—Matches the MIME encoding scheme.

 
      		 [bookmark: pgfId-646208]Sender Address—Matches the address of the sender.

 
      		 [bookmark: pgfId-646210]Sender Address Length—Matches the number of characters of the sender’s address.

 
     

 
     [bookmark: pgfId-646212]Navigation Path

 
     [bookmark: pgfId-646217]In the Policy Object Manager, from the Match Condition and Action tab on the Add and Edit ESMTP Map dialog boxes, right-click inside the table, then select Add Row or right-click a row, then select Edit Row. See Configuring ESMTP Maps.

 
     [bookmark: pgfId-646219]Related Topics

 
      
      		 [bookmark: pgfId-646224]Understanding Map Objects

 
      		 [bookmark: pgfId-646229]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-646231]Field Reference

 
     [bookmark: pgfId-646234] 

 
      
       
        
        [bookmark: pgfId-639553]Table 17-18 [bookmark: 47779]ESMTP Policy Maps Add and Edit Match Condition and Action Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-639559]Element
          
  
         		
           
           [bookmark: pgfId-639561]Description
          
  
        

 
         
         		[bookmark: pgfId-639567]Criterion

  
         		[bookmark: pgfId-639569]Specifies which criterion of ESMTP traffic to match. The criteria are described above.

  
        

 
         
         		[bookmark: pgfId-639575]Type

  
         		[bookmark: pgfId-639577]Specifies whether the map includes traffic that matches or does not match the criterion. For example, if Doesn’t Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the map.

 
           
           		 [bookmark: pgfId-639579]Matches—Matches the criterion.

 
           		 [bookmark: pgfId-639581]Doesn’t Match—Does not match the criterion.

 
          

  
        

 
         
         		[bookmark: pgfId-639587]Action

  
         		[bookmark: pgfId-639589]The action you want the device to take for traffic that matches the defined criteria.

  
        

 
         
         		 [bookmark: pgfId-639595]Variable Fields

 [bookmark: pgfId-639597]The following fields vary based on what you select in the Criterion field. This list is a super-set of the fields you might see.

  
        

 
         
         		[bookmark: pgfId-639605]Greater Than Length

  
         		[bookmark: pgfId-639607]The length in bytes of the evaluated field. The criterion matches if the length is greater than the specified number, and does not match if the field is less than the specified number.

 [bookmark: pgfId-639609]The dialog box indicates the valid range for the length, except for Body Length and Header length, which can be 1 to 4294967295.

  
        

 
         
         		[bookmark: pgfId-639615]Commands

  
         		[bookmark: pgfId-639617]The ESMTP command verbs you want to inspect.

  
        

 
         
         		[bookmark: pgfId-639623]Greater Than Count

  
         		[bookmark: pgfId-639625]The number of evaluated items. The criterion matches if the count is greater than the specified number, and does not match if the count is less than the specified number.

  
        

 
         
         		[bookmark: pgfId-639631]Parameters

  
         		[bookmark: pgfId-639633]The ESMTP EHLO reply parameters you want to inspect.

  
        

 
         
         		[bookmark: pgfId-639639]Value

  
         		[bookmark: pgfId-639641]The regular expression you want to evaluate. You can select one of the following:

 
           
           		 [bookmark: pgfId-639643]Regular Expression—The regular expression object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click  Select to choose the object from a list of existing ones or to create a new regular expression object.

 
           		 [bookmark: pgfId-639645]Regular Expression Group—The regular expression group object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click  Select to choose the object from a list of existing ones or to create a new regular expression group object.

 
          

  
        

 
         
         		[bookmark: pgfId-639651]MIME Encoding

  
         		[bookmark: pgfId-639653]The type of MIME encoding schemes you want to inspect.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646256][bookmark: 47855][bookmark: pobjpage_cncpt_AddandEditFTPMapDialogBoxes]Configuring FTP Maps [bookmark: marker-646244][bookmark: marker-646246][bookmark: marker-646248][bookmark: marker-646250][bookmark: marker-646252][bookmark: marker-646254]

 
     [bookmark: pgfId-646258]Use the Add and Edit FTP Map dialog boxes to define the match criterion and values for an FTP inspect map. You can use an FTP map to block specific FTP protocol methods, such as an FTP PUT, from passing through the security appliance and reaching your FTP server.

 
     [bookmark: pgfId-646260]Navigation Path

 
     [bookmark: pgfId-646262]Select Manage > Policy Objects, then select Maps > Policy Maps > Inspect > FTP from the Object Type selector. Right-click inside the table, then select New Object or right-click a row, then select Edit Object.

 
     [bookmark: pgfId-646264]Related Topics

 
      
      		 [bookmark: pgfId-646269]Understanding Map Objects

 
      		 [bookmark: pgfId-646274]Configuring Protocols and Maps for Inspection

 
      		 [bookmark: pgfId-646279]Configuring Class Maps for Inspection Policies

 
     

 
     [bookmark: pgfId-646281]Field Reference

 
     [bookmark: pgfId-646284] 

 
      
       
        
        [bookmark: pgfId-639666]Table 17-19 [bookmark: 47901]Add and Edit FTP Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-639672]Element
          
  
         		
           
           [bookmark: pgfId-639674]Description
          
  
        

 
         
         		[bookmark: pgfId-639680]Name

  
         		[bookmark: pgfId-639682]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-639688]Description

  
         		[bookmark: pgfId-639690]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		 
           
           [bookmark: pgfId-639696]Parameters tab
          
  
        

 
         
         		[bookmark: pgfId-639704]Mask Greeting Banner from Server

  
         		[bookmark: pgfId-639706]Whether to mask the greeting banner from the FTP server to prevent the client from discovering server information.

  
        

 
         
         		[bookmark: pgfId-639712]Mask Reply to SYST Command

  
         		[bookmark: pgfId-639714]Whether to mask the reply to the syst command to prevent the client from discovering server information.

  
        

 
         
         		 [bookmark: pgfId-639720]Match Condition and Action Tab

 [bookmark: pgfId-639722]The Match All table lists the criteria included in the policy map. Each row indicates whether the inspection is looking for traffic that matches or does not match each criterion, the criterion and value that is inspected, and the action to be taken for traffic that satisfies the conditions.

 
           
           		 [bookmark: pgfId-639727]To add a criterion, click the Add button and fill in the Match Condition and Action dialog box (see FTP Class and Policy Maps Add or Edit Match Condition (and Action) Dialog Boxes).

 
           		 [bookmark: pgfId-639729]To edit a criterion, select it and click the Edit button.

 
           		 [bookmark: pgfId-639731]To delete a criterion, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-639739]Category

  
         		[bookmark: pgfId-639744]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-639750]Allow Value Override per Device

 [bookmark: pgfId-639752]Overrides

 [bookmark: pgfId-639754]Edit button

  
         		[bookmark: pgfId-639762]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-639764]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
         
         		[bookmark: pgfId-639770]Validate For

 [bookmark: pgfId-639772]Validate button

  
         		[bookmark: pgfId-639774]The device platforms for which to validate the object. Select the platform for which you intend to use this object and click Validate to determine if the object is configured in a way that will prevent policy deployment.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646324][bookmark: 47976][bookmark: pobjpage_cncpt_FTPClassandPolicyMapsAddorEditMatchConditionandActionDialogBoxes]FTP Class and Policy Maps Add or Edit Match Condition (and Action) Dialog Boxes [bookmark: marker-646312][bookmark: marker-646314][bookmark: marker-646316][bookmark: marker-646318][bookmark: marker-646320][bookmark: marker-646322]

 
     [bookmark: pgfId-646326]Use the Add or Edit FTP Match Criterion (for FTP class maps) or Match Condition and Action (for FTP policy maps) dialog boxes to do the following:

 
      
      		 [bookmark: pgfId-646328]Define the match criterion and value for an FTP class map.

 
      		 [bookmark: pgfId-646330]Select an FTP class map when creating an FTP policy map.

 
      		 [bookmark: pgfId-646332]Define the match criterion, value, and action directly in an FTP policy map.

 
     

 
     [bookmark: pgfId-646334]The fields on this dialog box change based on the criterion you select and whether you are creating a class map or policy map.

 
     [bookmark: pgfId-646336]Navigation Path

 
     [bookmark: pgfId-646341]When creating an FTP class map, in the Policy Object Manager, from the Add or Edit Class Maps dialog boxes for FTP, right-click inside the table, then select Add Row or right-click a row, then select Edit Row. See Configuring Class Maps for Inspection Policies.

 
     [bookmark: pgfId-646346]When creating an FTP policy map, in the Policy Object Manager, from the Match Condition and Action tab on the Add and Edit FTP Map dialog boxes, right-click inside the table, then select Add Row or right-click a row, then select Edit Row. See Configuring FTP Maps.

 
     [bookmark: pgfId-646348]Related Topics

 
      
      		 [bookmark: pgfId-646353]Understanding Map Objects

 
      		 [bookmark: pgfId-646358]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-646360]Field Reference

 
     [bookmark: pgfId-646363] 

 
      
       
        
        [bookmark: pgfId-639787]Table 17-20 [bookmark: 48038]FTP Class and Policy Maps Add and Edit Match Condition and Action Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-639793]Element
          
  
         		
           
           [bookmark: pgfId-639795]Description
          
  
        

 
         
         		[bookmark: pgfId-639801]Match Type

 [bookmark: pgfId-639803]Class Name

 [bookmark: pgfId-639805](Policy Map only)

  
         		[bookmark: pgfId-639807]Enables you to use an existing FTP class map or define a new FTP class map.

 
           
           		 [bookmark: pgfId-639809]Use Specified Values—You want to define the class map on this dialog box.

 
           		 [bookmark: pgfId-639811]Use Values in Class Map—You want to select an existing FTP class map policy object. Enter the name of the FTP class map in the  Class Name field. Click  Select to select the map from a list or to create a new class map object.

 
          

  
        

 
         
         		[bookmark: pgfId-639817]Criterion

  
         		[bookmark: pgfId-639819]Specifies which criterion of FTP traffic to match:

 
           
           		 [bookmark: pgfId-639821]Request Command—Matches an FTP request command.

 
           		 [bookmark: pgfId-639823]Filename—Matches a filename for FTP transfer.

 
           		 [bookmark: pgfId-639825]File Type—Matches a file type for FTP transfer.

 
           		 [bookmark: pgfId-639827]Server—Matches an FTP server name.

 
           		 [bookmark: pgfId-639829]Username—Matches an FTP username.

 
          

  
        

 
         
         		[bookmark: pgfId-639835]Type

  
         		[bookmark: pgfId-639837]Specifies whether the map includes traffic that matches or does not match the criterion. For example, if Doesn’t Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the map.

 
           
           		 [bookmark: pgfId-639839]Matches—Matches the criterion.

 
           		 [bookmark: pgfId-639841]Doesn’t Match—Does not match the criterion.

 
          

  
        

 
         
         		[bookmark: pgfId-639847]Action

 [bookmark: pgfId-639849](Policy Map only)

  
         		[bookmark: pgfId-639851]The action you want the device to take for traffic that matches the defined criteria.

  
        

 
         
         		 [bookmark: pgfId-639857]Variable Fields

 [bookmark: pgfId-639859]The following fields vary based on what you select in the Criterion field. This list is a super-set of the fields you might see.

  
        

 
         
         		[bookmark: pgfId-639867]Request Commands

  
         		[bookmark: pgfId-639869]The FTP commands you want to inspect:

 
           
           		 [bookmark: pgfId-639871]Append (APPE)—Appends to a file.

 
           		 [bookmark: pgfId-639873]Delete (DELE)—Deletes a file at the server site.

 
           		 [bookmark: pgfId-639875]Help (HELP)—Provides help information from the server.

 
           		 [bookmark: pgfId-639877]Put (PUT)—FTP client command for the stor (store a file) command.

 
           		 [bookmark: pgfId-639879]Rename From (RNFR)—Specifies rename-from filename.

 
           		 [bookmark: pgfId-639881]Server Specific Command (SITE)—Specifies commands that are server specific. Usually used for remote administration.

 
           		 [bookmark: pgfId-639883]Change to Parent (CDUP)—Changes to the parent directory of the current working directory.

 
           		 [bookmark: pgfId-639885]Get (GET)—FTP client command for the retr (retrieve a file) command.

 
           		 [bookmark: pgfId-639887]Create Directory (MKD)—Creates a directory.

 
           		 [bookmark: pgfId-639889]Remove Directory (RMD)—Removes a directory.

 
           		 [bookmark: pgfId-639891]Rename To (RNTO)—Specifies rename-to filename.

 
           		 [bookmark: pgfId-639893]Store File with Unique Name (STOU)—Stores a file with a unique filename.

 
          

  
        

 
         
         		[bookmark: pgfId-639899]Value

  
         		[bookmark: pgfId-639901]The regular expression you want to evaluate. You can select one of the following:

 
           
           		 [bookmark: pgfId-639903]Regular Expression—The regular expression object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click  Select to choose the object from a list of existing ones or to create a new regular expression object.

 
           		 [bookmark: pgfId-639905]Regular Expression Group—The regular expression group object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click  Select to choose the object from a list of existing ones or to create a new regular expression group object.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646385][bookmark: 48144][bookmark: pobjpage_cncpt_AddandEditGTPMapDialogBoxes]Configuring GTP Maps [bookmark: marker-646373][bookmark: marker-646375][bookmark: marker-646377][bookmark: marker-646379][bookmark: marker-646381][bookmark: marker-646383]

 
     [bookmark: pgfId-646387]Use the Add and Edit GTP Map dialog boxes to define the match criterion and values for a GTP inspect map.

 
     [bookmark: pgfId-646389]The GPRS Tunnel Protocol (GTP) provides uninterrupted connectivity for mobile subscribers between GSM networks and corporate networks or the Internet. GTP uses a tunneling mechanism to provide a service for carrying user data packets.

 
     [bookmark: pgfId-646391]A GTP map object lets you change the default configuration values used for GTP application inspection. The GTP protocol is designed to provide security for wireless connections to TCP/IP networks such as the Internet. You can use a GTP map to control timeout values, message sizes, tunnel counts, and GTP versions traversing the security appliance.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-646393]Tip GTP inspection requires a special license. If you do not have the required license, you will see device errors if you try to deploy a GTP map.


     
      

     

     

 
     [bookmark: pgfId-646395]Navigation Path

 
     [bookmark: pgfId-646397]Select Manage > Policy Objects, then select Maps > Policy Maps > Inspect > GTP from the Object Type selector. Right-click inside the work area, then select New Object, or right-click a row and select Edit Object.

 
     [bookmark: pgfId-646399]Related Topics

 
      
      		 [bookmark: pgfId-646404]Understanding Map Objects

 
      		 [bookmark: pgfId-646409]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-646411]Field Reference

 
     [bookmark: pgfId-646414] 

 
      
       
        
        [bookmark: pgfId-639918]Table 17-21 [bookmark: 48191]Add and Edit GTP Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-639924]Element
          
  
         		
           
           [bookmark: pgfId-639926]Description
          
  
        

 
         
         		[bookmark: pgfId-639932]Name

  
         		[bookmark: pgfId-639934]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-639940]Description

  
         		[bookmark: pgfId-639942]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		 
           
           [bookmark: pgfId-639948]Parameters tab
          
  
        

 
         
         		[bookmark: pgfId-639956]Country and Network Codes Table

  
         		[bookmark: pgfId-639958]The three-digit Mobile Country Code (mcc) and Mobile Network Code (mnc) to include in the map. The codes are 000 to 999.

 
           
           		 [bookmark: pgfId-639960]To add codes, click the Add button and fill in the dialog box.

 
           		 [bookmark: pgfId-639962]To edit a row, select it and click the Edit button.

 
           		 [bookmark: pgfId-639964]To delete a row, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-639970]Permit Response Table

  
         		[bookmark: pgfId-639972]The Network/Host policy objects for which you will allow GTP responses from a GSN that is different from the one to which the response was sent.

 
           
           		 [bookmark: pgfId-639977]To add objects, click the Add button and fill in the dialog box. For more information, see Add and Edit Permit Response Dialog Boxes.

 
           		 [bookmark: pgfId-639979]To edit a row, select it and click the Edit button.

 
           		 [bookmark: pgfId-639981]To delete a row, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-639987]Request Queue

  
         		[bookmark: pgfId-639989]The maximum requests allowed in the queue. When the limit has been reached and a new request arrives, the request that has been in the queue for the longest time is removed. Values are 1-9999999. The default is 200.

  
        

 
         
         		[bookmark: pgfId-639995]Tunnel Limit

  
         		[bookmark: pgfId-639997]The maximum number of tunnels allowed.

  
        

 
         
         		[bookmark: pgfId-640003]Permit Errors

  
         		[bookmark: pgfId-640005]Whether to permit packets with errors or different GTP versions. By default, all invalid packets or packets that failed during parsing are dropped.

  
        

 
         
         		[bookmark: pgfId-640011]Edit Timeouts button

  
         		[bookmark: pgfId-640016]Click this button to configure time out values for various operations. For more information about the options, see GTP Map Timeouts Dialog Box.

  
        

 
         
         		 [bookmark: pgfId-640022]Match Condition and Action Tab

 [bookmark: pgfId-640024]The Match All table lists the criteria included in the policy map. Each row indicates whether the inspection is looking for traffic that matches or does not match each criterion, the criterion and value that is inspected, and the action to be taken for traffic that satisfies the conditions.

 
           
           		 [bookmark: pgfId-640029]To add a criterion, click the Add button and fill in the Match Condition and Action dialog box (see GTP Policy Maps Add or Edit Match Condition and Action Dialog Boxes).

 
           		 [bookmark: pgfId-640031]To edit a criterion, select it and click the Edit button.

 
           		 [bookmark: pgfId-640033]To delete a criterion, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-640041]Category

  
         		[bookmark: pgfId-640046]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-640052]Allow Value Override per Device

 [bookmark: pgfId-640054]Overrides

 [bookmark: pgfId-640056]Edit button

  
         		[bookmark: pgfId-640064]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-640066]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
         
         		[bookmark: pgfId-640072]Validate For

 [bookmark: pgfId-640074]Validate button

  
         		[bookmark: pgfId-640076]The device platforms for which to validate the object. Select the platform for which you intend to use this object and click Validate to determine if the object is configured in a way that will prevent policy deployment.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646430][bookmark: 48301][bookmark: pobjpage_cncpt_AddandEditGTPMapParametersAddandEditCountryNetworkCodesDialogBoxes]Add and Edit Country Network Codes Dialog Boxes[bookmark: marker-646422][bookmark: marker-646424][bookmark: marker-646426][bookmark: marker-646428]

 
     [bookmark: pgfId-646432]Use the Add and Edit Country Network Codes dialog boxes to add Mobile Country Code (mcc) and Mobile Network Code (mnc) values to the GTP policy map. The codes can be 000 to 999.

 
     [bookmark: pgfId-646434]Navigation Path

 
     [bookmark: pgfId-646439]From the Add and Edit GTP Map dialog boxes, click the Add button in the Country and Network codes table, or select a row and click the Edit button. See Configuring GTP Maps.

 
    
 
     
      [bookmark: pgfId-646451][bookmark: 48326][bookmark: pobjpage_cncpt_AddandEditGTPMapParametersAddandEditPermitResponseDialogBoxes]Add and Edit Permit Response Dialog Boxes[bookmark: marker-646447][bookmark: marker-646449]

 
     [bookmark: pgfId-646453]Use the Add and Edit Permit Response dialog boxes to permit GTP responses from a GSN that is different from the one to which the response was sent.

 
     [bookmark: pgfId-646455]Enter the name of a Network/Host policy object that defines the destination (To Object Group) and source (From Object Group) of the traffic. You can click Select to select the object from a list, where you can also create an new object by clicking the Create button in the Object Selector dialog box.

 
     [bookmark: pgfId-646457]You cannot use the Network/Host object named “any.”

 
     [bookmark: pgfId-646459]Navigation Path

 
     [bookmark: pgfId-646464]From the Add and Edit GTP Map dialog boxes, click the Add button in the Permit Response table, or select a row and click the Edit button. See Configuring GTP Maps.

 
    
 
     
      [bookmark: pgfId-646474][bookmark: 48347][bookmark: pobjpage_cncpt_AddandEditGTPMapParametersGTPMapTimeoutsDialogBox]GTP Map Timeouts Dialog Box [bookmark: marker-646472]

 
     [bookmark: pgfId-646476]Use the GTP Map Timeouts dialog box to set timeout values for a GTP Map.

 
     [bookmark: pgfId-646478]Navigation Path

 
     [bookmark: pgfId-646483]From the Add and Edit GTP Map dialog boxes, click the Edit Timeouts button on the Parameters tab. See Configuring GTP Maps.

 
     [bookmark: pgfId-646485]Field Reference

 
     [bookmark: pgfId-646488] 

 
      
       
        
        [bookmark: pgfId-640089]Table 17-22 [bookmark: 48361]GTP Map Timeouts Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-640095]Element
          
  
         		
           
           [bookmark: pgfId-640097]Description
          
  
        

 
         
         		[bookmark: pgfId-640103]GSN Timeout (Prior to ASA 9.5(1))

 [bookmark: pgfId-640105]Endpoint Timeout (ASA 9.5(1) or higher)

  
         		[bookmark: pgfId-640107]The period of inactivity (hh:mm:ss) after which a GSN is removed. The default is 30 minutes. Enter 0 to never tear down immediately.

  
        

 
         
         		[bookmark: pgfId-640113]PDP Context Timeout

  
         		[bookmark: pgfId-640115]The maximum period of time allowed (hh:mm:ss) before beginning to receive the PDP context. The default is 30 minutes. Enter 0 to specify no limit.

  
        

 
         
         		[bookmark: pgfId-640121]Request Queue Timeout

  
         		[bookmark: pgfId-640123]The maximum period of time allowed (hh:mm:ss) before beginning to receive the GTP message. The default is 60 seconds. Enter 0 to specify no limit.

  
        

 
         
         		[bookmark: pgfId-640129]Signaling Connections Timeout

  
         		[bookmark: pgfId-640131]The period of inactivity (hh:mm:ss) after which the GTP signaling is removed. The default is 30 minutes. Enter 0 to not remove the signal.

  
        

 
         
         		[bookmark: pgfId-640137]Tunnel Timeout

  
         		[bookmark: pgfId-640139]The period of inactivity (hh:mm:ss) after which the GTP tunnel is torn down. The default is 60 seconds (when a Delete PDP Context Request is not received). Enter 0 to never tear down immediately.

  
        

 
         
         		[bookmark: pgfId-640145]T3 Response Timeout

  
         		[bookmark: pgfId-640147]The maximum wait time for a response before removing the connection.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646508][bookmark: 48403][bookmark: pobjpage_cncpt_GTPMapsAddorEditMatchConditionandActionDialogBoxes]GTP Policy Maps Add or Edit Match Condition and Action Dialog Boxes [bookmark: marker-646502][bookmark: marker-646504][bookmark: marker-646506]

 
     [bookmark: pgfId-646510]Use the Add or Edit Match Condition and Action dialog boxes to define the match criterion, value, and action for a GTP policy map.

 
     [bookmark: pgfId-646512]The fields on this dialog box change based on the criterion you select.

 
     [bookmark: pgfId-646514]Navigation Path

 
     [bookmark: pgfId-646519]In the Policy Object Manager, from the Match Condition and Action tab on the Add and Edit GTP Map dialog box, right-click inside the table, then select Add Row or right-click a row, then select Edit Row. See Configuring GTP Maps.

 
     [bookmark: pgfId-646521]Related Topics

 
      
      		 [bookmark: pgfId-646526]Understanding Map Objects

 
      		 [bookmark: pgfId-646531]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-646533]Field Reference

 
     [bookmark: pgfId-646536] 

 
      
       
        
        [bookmark: pgfId-640160]Table 17-23 [bookmark: 48438]GTP Policy Maps Add and Edit Match Condition and Action Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-640166]Element
          
  
         		
           
           [bookmark: pgfId-640168]Description
          
  
        

 
         
         		[bookmark: pgfId-640174]Criterion

  
         		[bookmark: pgfId-640176]Specifies which criterion of GTP traffic to match:

 
           
           		 [bookmark: pgfId-640178]Access Point Name—Matches the access point name so you can define the access points to drop when GTP application inspection is enabled.

 
           		 [bookmark: pgfId-640180]Message ID—Matches the numeric identifier for the message that you want to drop. By default, all valid message IDs are allowed.

 
           		 [bookmark: pgfId-640182]Message Length—Matches the length of the UDP packet. Use this criterion to change the default for the maximum allowed message length for the UDP payload.

 
           		 [bookmark: pgfId-640184]Version—Matches the GTP version.

 
          

  
        

 
         
         		[bookmark: pgfId-640190]Type

  
         		[bookmark: pgfId-640192]Specifies whether the map includes traffic that matches or does not match the criterion. For example, if Doesn’t Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the map.

 
           
           		 [bookmark: pgfId-640194]Matches—Matches the criterion.

 
           		 [bookmark: pgfId-640196]Doesn’t Match—Does not match the criterion.

 
          

  
        

 
         
         		[bookmark: pgfId-640202]Action

  
         		[bookmark: pgfId-640204]The action you want the device to take for traffic that matches the defined criteria.

 
           
           		 [bookmark: pgfId-640206]Drop Packet—By default, all invalid packets or packets that failed during parsing are dropped.

 
           		 [bookmark: pgfId-640208]Drop Packet and Log

 
           		 [bookmark: pgfId-640210]Rate Limit

 
          

  
        

 
         
         		 [bookmark: pgfId-640216]Variable Fields

 [bookmark: pgfId-640218]The following fields vary based on what you select in the Criterion field. This list is a super-set of the fields you might see.

  
        

 
         
         		[bookmark: pgfId-640226]Access Point Name

  
         		[bookmark: pgfId-640228]The access points to act on when GTP application inspection is enabled.

 
           
           		 [bookmark: pgfId-640230]Specified By—An access point name to be dropped. By default, all messages with valid APNs are inspected, and any APN is allowed.

 
           		 [bookmark: pgfId-640232]Regular Expression—The regular expression object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click  Select to choose the object from a list of existing ones or to create a new regular expression object.

 
           		 [bookmark: pgfId-640234]Regular Expression Group—The regular expression group object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click  Select to choose the object from a list of existing ones or to create a new regular expression group object.

 
          

  
        

 
         
         		[bookmark: pgfId-640240]ID type

  
         		[bookmark: pgfId-640242]The numeric identifier of the message that you want to act on.

 
           
           		 [bookmark: pgfId-640244]Value—A single message ID. The Value can be between 1 and 255.

 
           		 [bookmark: pgfId-640246]Range—A range of message IDs. The Range can be between 1 and 255.

 
          

  
        

 
         
         		[bookmark: pgfId-640252]Minimum Length

  
         		[bookmark: pgfId-640254]The minimum number of bytes in the UDP payload.

  
        

 
         
         		[bookmark: pgfId-640260]Maximum Length

  
         		[bookmark: pgfId-640262]The maximum number of bytes in the UDP payload.

  
        

 
         
         		[bookmark: pgfId-640268]Version

  
         		[bookmark: pgfId-640270]Beginning with version 4.9, Security Manager provides support for GPRS Tunnel Protocol (GTP) v2 and enhanced v1 in the GTP Map Object for ASA devices 9.5(1) or higher. You can now configure separate message ID matching for GTPv1 and GTPv2.

 [bookmark: pgfId-640272]For ASA devices 9.5(1) or higher, if you select Message ID as the Criterion, two options for Version, v1 and v2, are displayed. Select v1 or v2 and enter a single Value between 1 and 255, or a Range of values from 1 to 255.

  
        

 
         
         		[bookmark: pgfId-640278]Version Type

  
         		[bookmark: pgfId-640280]Prior to ASA version 9.5(1)—Use 0 to identify Version 0 and 1 to identify Version 1. Version 0 of GTP uses port 2123, while Version 1 uses port 3386. By default all GTP versions are allowed.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646558][bookmark: 48537][bookmark: pobjpage_cncpt_AddandEditH323MapDialogBoxes]Configuring H.323 Maps[bookmark: marker-646546][bookmark: marker-646548][bookmark: marker-646550][bookmark: marker-646552][bookmark: marker-646554][bookmark: marker-646556]

 
     [bookmark: pgfId-646560]Use the Add and Edit H.323 Map dialog boxes to define the match criterion and values for an H.323 inspect map. An H.323 policy map lets you change the default configuration values used for H.323 inspection.

 
     [bookmark: pgfId-646562]H.323 inspection supports H.323 compliant applications such as Cisco CallManager and VocalTec Gatekeeper. H.323 is a suite of protocols defined by the International Telecommunication Union for multimedia conferences over LANs. The security appliance supports H.323 through Version 4, including H.323 v3 feature Multiple Calls on One Call Signaling Channel.

 
     [bookmark: pgfId-646564]With H.323 inspection enabled, the security appliance supports multiple calls on the same call signaling channel, a feature introduced with H.323 Version 3. This feature reduces call setup time and reduces the use of ports on the security appliance. The two major functions of H.323 inspection are as follows:

 
      
      		 [bookmark: pgfId-646566]NAT the necessary embedded IPv4 addresses in the H.225 and H.245 messages. Because H.323 messages are encoded in PER encoding format, the security appliance uses an ASN.1 decoder to decode the H.323 messages.

 
      		 [bookmark: pgfId-646568]Dynamically allocate the negotiated H.245 and RTP/RTCP connections.

 
     

 
     [bookmark: pgfId-646570]Navigation Path

 
     [bookmark: pgfId-646572]Select Manage > Policy Objects, then select Maps > Policy Maps > Inspect > H.323 (ASA/PIX/FWSM) from the Object Type selector. Right-click inside the work area, then select New Object, or right-click a row and select Edit Object.

 
     [bookmark: pgfId-646574]Related Topics

 
      
      		 [bookmark: pgfId-646579]Understanding Map Objects

 
      		 [bookmark: pgfId-646584]Configuring Protocols and Maps for Inspection

 
      		 [bookmark: pgfId-646589]Configuring Class Maps for Inspection Policies

 
     

 
     [bookmark: pgfId-646591]Field Reference

 
     [bookmark: pgfId-646594] 

 
      
       
        
        [bookmark: pgfId-640293]Table 17-24 [bookmark: 48591]Add and Edit H.323 Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-640299]Element
          
  
         		
           
           [bookmark: pgfId-640301]Description
          
  
        

 
         
         		[bookmark: pgfId-640307]Name

  
         		[bookmark: pgfId-640309]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-640315]Description

  
         		[bookmark: pgfId-640317]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		 
           
           [bookmark: pgfId-640323]Parameters tab
          
  
        

 
         
         		[bookmark: pgfId-640331]HSI Group table

  
         		[bookmark: pgfId-640333]The HSI groups to include in the map. The group number, IP address of the HSI host, and IP addresses and interface names of the clients connected to the security appliance are shown in the table. Up to five HSI hosts per group, and up to ten end points per HSI group, are allowed.

 
           
           		 [bookmark: pgfId-640338]To add a group, click the Add button and fill in the dialog box (see Add or Edit HSI Group Dialog Boxes).

 
           		 [bookmark: pgfId-640340]To edit a group, select it and click the Edit button.

 
           		 [bookmark: pgfId-640342]To delete a group, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-640348]Call Duration Limit

  
         		[bookmark: pgfId-640350]The call duration limit in seconds. The range is from 0:0:0 to 1163:0:0. A value of 0 means never timeout.

  
        

 
         
         		[bookmark: pgfId-640356]Enforce Presence of Calling and Called Party Numbers

  
         		[bookmark: pgfId-640358]Whether to enforce calling and called party numbers used in call setup.

  
        

 
         
         		[bookmark: pgfId-640364]Check State Transition on H.225 Messages

  
         		[bookmark: pgfId-640366]Whether to enable state checking validation on H.225 messages.

  
        

 
         
         		[bookmark: pgfId-640372]Check State Transition on RAS Messages

  
         		[bookmark: pgfId-640374]Whether to enable state checking validation on RAS messages.

  
        

 
         
         		[bookmark: pgfId-640380]Create Pinholes on Seeing RCF Packets

  
         		[bookmark: pgfId-640382]Whether to enable call setup between H.323 endpoints when the Gatekeeper is inside the network. The device opens pinholes for calls based on Registration Request/Registration Confirm (RRQ/RCF) messages. Because these RRQ/RCF messages are sent to and from the Gatekeeper, the calling endpoint’s IP address is unknown and the device opens a pinhole through source IP address/port 0/0.

 [bookmark: pgfId-640384]This option is available for ASA 8.0(5)+ devices.

  
        

 
         
         		[bookmark: pgfId-640390]Check for H.245 Tunneling

 [bookmark: pgfId-640392]Action

  
         		[bookmark: pgfId-640394]Whether to enforce H.245 tunnel blocking and perform the action you select in the Action list box.

  
        

 
         
         		[bookmark: pgfId-640400]Check RTP Packets for Protocol Conformance

  
         		[bookmark: pgfId-640402]Whether to check RTP packets flowing through the pinholes for protocol conformance.

  
        

 
         
         		[bookmark: pgfId-640408]Payload Type must be Audio or Video based on Signaling Exchange

  
         		[bookmark: pgfId-640410]Whether to enforce the payload type to be audio or video based on the signaling exchange.

  
        

 
         
         		 [bookmark: pgfId-640416]Match Condition and Action Tab

 [bookmark: pgfId-640418]The Match All table lists the criteria included in the policy map. Each row indicates whether the inspection is looking for traffic that matches or does not match each criterion, the criterion and value that is inspected, and the action to be taken for traffic that satisfies the conditions.

 
           
           		 [bookmark: pgfId-640423]To add a criterion, click the Add button and fill in the Match Condition and Action dialog box (see H.323 Class and Policy Maps Add or Edit Match Condition (and Action) Dialog Boxes).

 
           		 [bookmark: pgfId-640425]To edit a criterion, select it and click the Edit button.

 
           		 [bookmark: pgfId-640427]To delete a criterion, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-640435]Category

  
         		[bookmark: pgfId-640440]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-640446]Allow Value Override per Device

 [bookmark: pgfId-640448]Overrides

 [bookmark: pgfId-640450]Edit button

  
         		[bookmark: pgfId-640458]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-640460]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646606][bookmark: 48703][bookmark: pobjpage_cncpt_AddEditHSIGroup]Add or Edit HSI Group Dialog Boxes[bookmark: marker-646602][bookmark: marker-646604]

 
     [bookmark: pgfId-646608]Use the Add or Edit HSI group dialog boxes to add HSI groups to an H.323 policy inspection map.

 
     [bookmark: pgfId-646610]Navigation Path

 
     [bookmark: pgfId-646615]From the Parameters tab on the Add and Edit H.323 Map dialog boxes, click the Add Row button in the HSI group table, or select a row and click the Edit Row button. See Configuring H.323 Maps.

 
     [bookmark: pgfId-646617]Field Reference

 
     [bookmark: pgfId-646620] 

 
      
       
        
        [bookmark: pgfId-640473]Table 17-25 [bookmark: 48720]Add and Edit HSI Group Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-640479]Element
          
  
         		
           
           [bookmark: pgfId-640481]Description
          
  
        

 
         
         		[bookmark: pgfId-640487]Group ID

  
         		[bookmark: pgfId-640489]The HSI group ID number (0 to 2147483647).

  
        

 
         
         		[bookmark: pgfId-640495]IP Address

  
         		[bookmark: pgfId-640497]The IP address of the HSI host.

  
        

 
         
         		[bookmark: pgfId-640503]Endpoint table

  
         		[bookmark: pgfId-640505]The end points associated with HSI group. You can add up to 10 end points per group. For each end point, you specify the IP address and interface policy group.

 
           
           		 [bookmark: pgfId-640510]To add an end point, click the Add button and fill in the dialog box (see Add or Edit HSI Endpoint IP Address Dialog Boxes).

 
           		 [bookmark: pgfId-640512]To edit an end point, select it and click the Edit button.

 
           		 [bookmark: pgfId-640514]To delete an end point, select it and click the Delete button.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646632][bookmark: 48754][bookmark: pobjpage_cncpt_AddEditHSIEndpointIPAddress]Add or Edit HSI Endpoint IP Address Dialog Boxes[bookmark: marker-646628][bookmark: marker-646630]

 
     [bookmark: pgfId-646634]Us the Add or Edit HSI Endpoint IP Address dialog box to add end points to an HSI group.

 
     [bookmark: pgfId-646636]Navigation Path

 
     [bookmark: pgfId-646641]From the Add and Edit HSI Group dialog boxes, click the Add Row button in the end point table, or select a row and click the Edit Row button. See Configuring H.323 Maps.

 
     [bookmark: pgfId-646643]Field Reference

 
     [bookmark: pgfId-646646] 

 
      
       
        
        [bookmark: pgfId-640527]Table 17-26 [bookmark: 48771]Add and Edit HSI Endpoint IP Address Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-640533]Element
          
  
         		
           
           [bookmark: pgfId-640535]Description
          
  
        

 
         
         		[bookmark: pgfId-640541]Network/Host

  
         		[bookmark: pgfId-640543]The IP address of the end point host or network.

  
        

 
         
         		[bookmark: pgfId-640549]Interface

  
         		[bookmark: pgfId-640551]The Interface policy group that identifies the interface connected to the security appliance. Enter the name of a policy group, or click Select to select it from a list, where you can also create new policy groups.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646678][bookmark: 48793][bookmark: pobjpage_cncpt_H323ClassandPolicyMapsAddorEditMatchConditionandActionDialogBoxes]H.323 Class and Policy Maps Add or Edit Match Condition (and Action) Dialog Boxes [bookmark: marker-646666][bookmark: marker-646668][bookmark: marker-646670][bookmark: marker-646672][bookmark: marker-646674][bookmark: marker-646676]

 
     [bookmark: pgfId-646680]Use the Add or Edit H.323 Match Criterion (for H.323 class maps) or Match Condition and Action (for H.323 policy maps) dialog boxes to do the following:

 
      
      		 [bookmark: pgfId-646682]Define the match criterion and value for an H.323 class map.

 
      		 [bookmark: pgfId-646684]Select an H.323 class map when creating an H.323 policy map.

 
      		 [bookmark: pgfId-646686]Define the match criterion, value, and action directly in an H.323 policy map.

 
     

 
     [bookmark: pgfId-646688]The fields on this dialog box change based on the criterion you select and whether you are creating a class map or policy map.

 
     [bookmark: pgfId-646690]Navigation Path

 
     [bookmark: pgfId-646695]When creating an H.323 class map, in the Policy Object Manager, from the Add or Edit Class Maps dialog boxes for H.323, right-click inside the table, then select Add Row or right-click a row, then select Edit Row. See Configuring Class Maps for Inspection Policies.

 
     [bookmark: pgfId-646700]When creating an H.323 policy map, in the Policy Object Manager, from the Match Condition and Action tab on the Add and Edit H.323 Map dialog boxes, right-click inside the table, then select Add Row or right-click a row, then select Edit Row. See Configuring H.323 Maps.

 
     [bookmark: pgfId-646702]Related Topics

 
      
      		 [bookmark: pgfId-646707]Understanding Map Objects

 
      		 [bookmark: pgfId-646712]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-646714]Field Reference

 
     [bookmark: pgfId-646717] 

 
      
       
        
        [bookmark: pgfId-640564]Table 17-27 [bookmark: 48851]H.323 Class and Policy Maps Add and Edit Match Condition and Action Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-640570]Element
          
  
         		
           
           [bookmark: pgfId-640572]Description
          
  
        

 
         
         		[bookmark: pgfId-640578]Match Type

 [bookmark: pgfId-640580]Class Name

 [bookmark: pgfId-640582](Policy Map only)

  
         		[bookmark: pgfId-640584]Enables you to use an existing H.323 class map or define a new H.323 class map.

 
           
           		 [bookmark: pgfId-640586]Use Specified Values—You want to define the class map on this dialog box.

 
           		 [bookmark: pgfId-640588]Use Values in Class Map—You want to select an existing H.323 class map policy object. Enter the name of the H.323 class map in the  Class Name field. Click  Select to select the map from a list or to create a new class map object.

 
          

  
        

 
         
         		[bookmark: pgfId-640594]Criterion

  
         		[bookmark: pgfId-640596]Specifies which criterion of H.323 traffic to match:

 
           
           		 [bookmark: pgfId-640598]Called Party—Matches the called party address.

 
           		 [bookmark: pgfId-640600]Calling Party—Matches the calling party address.

 
           		 [bookmark: pgfId-640602]Media Type—Matches the media type.

 
          

  
        

 
         
         		[bookmark: pgfId-640608]Type

  
         		[bookmark: pgfId-640610]Specifies whether the map includes traffic that matches or does not match the criterion. For example, if Doesn’t Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the map.

 
           
           		 [bookmark: pgfId-640612]Matches—Matches the criterion.

 
           		 [bookmark: pgfId-640614]Doesn’t Match—Does not match the criterion.

 
          

  
        

 
         
         		[bookmark: pgfId-640620]Action

 [bookmark: pgfId-640622](Policy Map only)

  
         		[bookmark: pgfId-640624]The action you want the device to take for traffic that matches the defined criteria.

  
        

 
         
         		 [bookmark: pgfId-640630]Variable Fields

 [bookmark: pgfId-640632]The following fields vary based on what you select in the Criterion field. This list is a super-set of the fields you might see.

  
        

 
         
         		[bookmark: pgfId-640640]Value

  
         		[bookmark: pgfId-640642]The regular expression you want to evaluate. You can select one of the following:

 
           
           		 [bookmark: pgfId-640644]Regular Expression—The regular expression object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click  Select to choose the object from a list of existing ones or to create a new regular expression object.

 
           		 [bookmark: pgfId-640646]Regular Expression Group—The regular expression group object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click  Select to choose the object from a list of existing ones or to create a new regular expression group object.

 
          

  
        

 
         
         		[bookmark: pgfId-640652]Media Type

  
         		[bookmark: pgfId-640654]The type of media you want to inspect, audio, video, or data.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646747][bookmark: 48928][bookmark: pobjpage_cncpt_AddandEditHTTPMapDialogBoxes-1]Configuring HTTP Maps for ASA 7.1.x, PIX 7.1.x, FWSM 3.x and IOS Devices[bookmark: marker-646735][bookmark: marker-646737][bookmark: marker-646739][bookmark: marker-646741][bookmark: marker-646743][bookmark: marker-646745]

 
     [bookmark: pgfId-646749]Use the Add and Edit HTTP Map dialog boxes to define HTTP maps for ASA 7.1.x, PIX 7.1.x, FWSM 3.x, and IOS devices.

 
     [bookmark: pgfId-646751]The enhanced HTTP inspection feature, which is also known as an application firewall, verifies that HTTP messages conform to RFC 2616, use RFC-defined methods, and comply with various other criteria. This can help prevent attackers from using HTTP messages for circumventing network security policy.

 
     [bookmark: pgfId-646753]When you enable HTTP inspection with an HTTP map, strict HTTP inspection with the action reset and log is enabled by default. You can change the actions performed in response to inspection failure, but you cannot disable strict inspection as long as the HTTP map remains enabled. Security Manager uses the http-map command to configure the map on the device.

 
     [bookmark: pgfId-646755]Navigation Path

 
     [bookmark: pgfId-646757]Select Manage > Policy Objects, then select Maps > Policy Maps > Inspect > HTTP (ASA 7.1.x/PIX 7.1.x/FWSM3.x/IOS) from the Object Type selector. Right-click inside the work area, then select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-646759]Related Topics

 
      
      		 [bookmark: pgfId-646764]Understanding Map Objects

 
      		 [bookmark: pgfId-646769]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-646771]Field Reference

 
     [bookmark: pgfId-646774] 

 
      
       
        
        [bookmark: pgfId-640667]Table 17-28 [bookmark: 48982]Add and Edit HTTP Map Dialog Boxes for ASA 7.1.x/PIX 7.1.x/FWSM 3.x/IOS Devices 

 
        
       
         
         		
           
           [bookmark: pgfId-640673]Element
          
  
         		
           
           [bookmark: pgfId-640675]Description
          
  
        

 
         
         		[bookmark: pgfId-640681]Name

  
         		[bookmark: pgfId-640683]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-640689]Description

  
         		[bookmark: pgfId-640691]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-640697]General tab

  
         		[bookmark: pgfId-640702]Defines the action taken when non-compliant HTTP requests are received and to enable verification of content type. For a description of the options, see HTTP Map General Tab.

  
        

 
         
         		[bookmark: pgfId-640708]Entity Length tab

  
         		[bookmark: pgfId-640713]Defines the action taken if the length of the HTTP content falls outside of configured targets. For a description of the options, see HTTP Map Entity Length Tab.

  
        

 
         
         		[bookmark: pgfId-640719]RFC Request Method tab

  
         		[bookmark: pgfId-640724]Defines the action that the security appliance should take when specific RFC request methods are used in the HTTP request. For a description of the options, see HTTP Map RFC Request Method Tab.

  
        

 
         
         		[bookmark: pgfId-640730]Extension Request Method tab

  
         		[bookmark: pgfId-640735]Defines the action taken when specific extension request methods are used in the HTTP request. For a description of the options, see HTTP Map Extension Request Method Tab.

  
        

 
         
         		[bookmark: pgfId-640741]Port Misuse tab

  
         		[bookmark: pgfId-640746]Defines the action taken when specific undesirable applications are encountered. For a description of the options, see HTTP Map Port Misuse Tab.

  
        

 
         
         		[bookmark: pgfId-640752]Transfer Encoding tab

  
         		[bookmark: pgfId-640757]Defines the action taken when specific transfer encoding types are used in the HTTP request. For a description of the options, see HTTP Map Transfer Encoding Tab.

  
        

 
         
         		[bookmark: pgfId-640763]Category

  
         		[bookmark: pgfId-640768]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-640774]Allow Value Override per Device

 [bookmark: pgfId-640776]Overrides

 [bookmark: pgfId-640778]Edit button

  
         		[bookmark: pgfId-640786]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-640788]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646784][bookmark: 49056][bookmark: pobjpage_cncpt_AddandEditHTTPMapGeneralTab]HTTP Map General Tab[bookmark: marker-646780][bookmark: marker-646782]

 
     [bookmark: pgfId-646786]Use the General tab to define the action taken when non-compliant HTTP requests are received and to enable verification of content type.

 
     [bookmark: pgfId-646788]Navigation Path

 
     [bookmark: pgfId-646793]Click the General tab on the Add and Edit HTTP Map dialog boxes for ASA 7.1.x/PIX 7.1.x/FWSM 3.x/IOS Devices. See Configuring HTTP Maps for ASA 7.1.x, PIX 7.1.x, FWSM 3.x and IOS Devices.

 
     [bookmark: pgfId-646795]Related Topics

 
      
      		 [bookmark: pgfId-646800]Understanding Map Objects

 
      		 [bookmark: pgfId-646805]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-646807]Field Reference

 
     [bookmark: pgfId-646810] 

 
      
       
        
        [bookmark: pgfId-640801]Table 17-29 [bookmark: 49083]HTTP Map General Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-640807]Element
          
  
         		
           
           [bookmark: pgfId-640809]Description
          
  
        

 
         
         		[bookmark: pgfId-640815]Take action for non-RFC 2616 compliant traffic

  
         		[bookmark: pgfId-640817]Whether you want to configure the action to be taken for traffic that does not comply with RFC 2616. Possible actions are:

 
           
           		 [bookmark: pgfId-640819]Allow Packet—Allow the message.

 
           		 [bookmark: pgfId-640821]Drop Packet—Close the connection.

 
           		 [bookmark: pgfId-640823]Reset Connection (default)—Send a TCP reset message to client and server.

 
          

 [bookmark: pgfId-640825]You can also select Generate Syslog to write a message to the syslog if non-compliant traffic is encountered.

  
        

 
         
         		[bookmark: pgfId-640831]Verify Content-type field belongs to the supported internal content-type list.

  
         		[bookmark: pgfId-640833]Whether you want to configure the action to be taken for traffic whose content type does not belong to the supported internal content-type list. Possible actions are:

 
           
           		 [bookmark: pgfId-640835]Allow Packet—Allow the message.

 
           		 [bookmark: pgfId-640837]Drop Packet—Close the connection.

 
           		 [bookmark: pgfId-640839]Reset Connection (default)—Send a TCP reset message to client and server.

 
          

 [bookmark: pgfId-640841]You can also select these options:

 
           
           		 [bookmark: pgfId-640843] Verify Content-type field for response matches the ACCEPT field of request —To also verify that the content type of the response matches the request.

 
           		 [bookmark: pgfId-640845] Generate Syslog —To write a message to the syslog if non-compliant traffic is encountered.

 
          

  
        

 
         
         		[bookmark: pgfId-640851]Override Global TCP Idle Timeout (IOS only)

  
         		[bookmark: pgfId-640853]Whether to change the TCP idle timeout default setting. An IOS device terminates a connection if there is no communication activity after this length of time. If you select this option, specify the desired timeout value in seconds.

  
        

 
         
         		[bookmark: pgfId-640859]Override Global Audit Trail Setting (IOS only)

 [bookmark: pgfId-640861]Enable Audit Trail

  
         		[bookmark: pgfId-640863]Whether to change the audit trail setting for IOS devices. If you select this option, you can select Enable Audit Trail to generate audit trail messages.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646820][bookmark: 49140][bookmark: pobjpage_cncpt_AddandEditHTTPMapEntityLengthTab]HTTP Map Entity Length Tab[bookmark: marker-646816][bookmark: marker-646818]

 
     [bookmark: pgfId-646822]Use the Entity Length tab to enable inspection based on the length of the HTTP content.

 
     [bookmark: pgfId-646824]Navigation Path

 
     [bookmark: pgfId-646829]Click the Entity Length tab on the Add and Edit HTTP Map dialog boxes for ASA 7.1.x/PIX 7.1.x/FWSM 3.x/IOS Devices. See Configuring HTTP Maps for ASA 7.1.x, PIX 7.1.x, FWSM 3.x and IOS Devices.

 
     [bookmark: pgfId-646831]Related Topics

 
      
      		 [bookmark: pgfId-646836]Understanding Map Objects

 
      		 [bookmark: pgfId-646841]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-646843]Field Reference

 
     [bookmark: pgfId-646846] 

 
      
       
        
        [bookmark: pgfId-640876]Table 17-30 [bookmark: 49167]HTTP Map Entity Length Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-640882]Element
          
  
         		
           
           [bookmark: pgfId-640884]Description
          
  
        

 
         
         		[bookmark: pgfId-640890]Inspect URI Length

  
         		[bookmark: pgfId-640892]Whether to enable inspection based on the length of the URI. If you select this option, configure the following:

 
           
           		 [bookmark: pgfId-640894]Maximum—The desired maximum length, in bytes, of the URI, from 1 to 65535.

 
           		 [bookmark: pgfId-640896]Excessive URI Length Action—The action to take when the length is exceeded:

 
          

 [bookmark: pgfId-640898] – Allow Packet—Allow the message.

 [bookmark: pgfId-640900] – Drop Packet—Close the connection.

 [bookmark: pgfId-640902] – Reset Connection—Send a TCP reset message to client and server.

 
           
           		 [bookmark: pgfId-640904]Generate Syslog—Whether to generate a syslog message when a violation occurs.

 
          

  
        

 
         
         		[bookmark: pgfId-640910]Inspect Maximum Header Length

  
         		[bookmark: pgfId-640912]Whether to enable inspection based on the length of the HTTP header. If you select this option, configure the following:

 
           
           		 [bookmark: pgfId-640914]Request—The desired maximum length, in bytes, of the request header, from 1 to 65535.

 
           		 [bookmark: pgfId-640916]Response—The desired maximum length, in bytes, of the response header, from 1 to 65535.

 
           		 [bookmark: pgfId-640918]Excessive Header Length Action—The action to take when the length is exceeded:

 
          

 [bookmark: pgfId-640920] – Allow Packet—Allow the message.

 [bookmark: pgfId-640922] – Drop Packet—Close the connection.

 [bookmark: pgfId-640924] – Reset Connection—Send a TCP reset message to client and server.

 
           
           		 [bookmark: pgfId-640926]Generate Syslog—Whether to generate a syslog message when a violation occurs.

 
          

  
        

 
         
         		[bookmark: pgfId-640932]Inspect Body Length

  
         		[bookmark: pgfId-640934]Whether to enable inspection based on the length of the message body. If you select this option, configure the following:

 
           
           		 [bookmark: pgfId-640936]Minimum Threshold—The desired minimum length, in bytes, of the message body, from 1 to 65535.

 
           		 [bookmark: pgfId-640938]Maximum Threshold—The desired maximum length, in bytes, of the message body, from 1 to 65535.

 
           		 [bookmark: pgfId-640940]Body Length Threshold Action—The action to take when the message body falls outside of the configured boundaries:

 
          

 [bookmark: pgfId-640942] – Allow Packet—Allow the message.

 [bookmark: pgfId-640944] – Drop Packet—Close the connection.

 [bookmark: pgfId-640946] – Reset Connection—Send a TCP reset message to client and server.

 
           
           		 [bookmark: pgfId-640948]Generate Syslog—Whether to generate a syslog message when a violation occurs.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646856][bookmark: 49239][bookmark: pobjpage_cncpt_AddandEditHTTPMapRFCRequestMethodTab]HTTP Map RFC Request Method Tab[bookmark: marker-646852][bookmark: marker-646854]

 
     [bookmark: pgfId-646858]Use the RFC Request Method tab to define the action to take when specific request methods are used in the HTTP request.

 
     [bookmark: pgfId-646860]Navigation Path

 
     [bookmark: pgfId-646865]Click the RFC Request Method tab on the Add and Edit HTTP Map dialog boxes for ASA 7.1.x/PIX 7.1.x/FWSM 3.x/IOS Devices. See Configuring HTTP Maps for ASA 7.1.x, PIX 7.1.x, FWSM 3.x and IOS Devices.

 
     [bookmark: pgfId-646867]Related Topics

 
      
      		 [bookmark: pgfId-646872]Understanding Map Objects

 
      		 [bookmark: pgfId-646877]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-646879]Field Reference

 
     [bookmark: pgfId-646882] 

 
      
       
        
        [bookmark: pgfId-640961]Table 17-31 [bookmark: 49266]HTTP Map RFC Request Method 

 
        
       
         
         		
           
           [bookmark: pgfId-640967]Element
          
  
         		
           
           [bookmark: pgfId-640969]Description
          
  
        

 
         
         		[bookmark: pgfId-640975]Available and Selected Methods

 [bookmark: pgfId-640977]Action

 [bookmark: pgfId-640979]Generate Syslog

  
         		[bookmark: pgfId-640981]The Available Methods list contains the request methods defined in RFC 2616.

 [bookmark: pgfId-640983]To configure an action for a method, select it, then select an action and optionally select Generate Syslog if you want a message added to the syslog when an HTTP request containing the selected method is encountered. Click the >> button to add it to the Selected Methods list. (To remove a method from the selected list, select it and click the << button.)

 [bookmark: pgfId-640985]Tip You can select multiple methods at a time using Ctrl+click if the action and syslog requests are the same for each. [bookmark: pgfId-640987]The actions you can specify are:

 
           
           		 [bookmark: pgfId-640989]Allow Packet—Allow the message.

 
           		 [bookmark: pgfId-640991]Drop Packet—Close the connection.

 
           		 [bookmark: pgfId-640993]Reset Connection (default)—Send a TCP reset message to client and server.

 
          

  
        

 
         
         		[bookmark: pgfId-640999]Specify the action to be applied for the remaining available methods above.

  
         		[bookmark: pgfId-641001]Whether to define a default action for the methods for which you have not configured specific actions above. If you select this option, select the action and syslog setting to use for the default action.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646892][bookmark: 49302][bookmark: pobjpage_cncpt_AddandEditHTTPMapExtensionRequestMethodTab]HTTP Map Extension Request Method Tab[bookmark: marker-646888][bookmark: marker-646890]

 
     [bookmark: pgfId-646894]Use the Extension Request Method tab to define the action taken when specific extension request methods are used in the HTTP request.

 
     [bookmark: pgfId-646896]Navigation Path

 
     [bookmark: pgfId-646901]Click the Extension Request Method tab on the Add and Edit HTTP Map dialog boxes for ASA 7.1.x/PIX 7.1.x/FWSM 3.x/IOS Devices. See Configuring HTTP Maps for ASA 7.1.x, PIX 7.1.x, FWSM 3.x and IOS Devices.

 
     [bookmark: pgfId-646903]Related Topics

 
      
      		 [bookmark: pgfId-646908]Understanding Map Objects

 
      		 [bookmark: pgfId-646913]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-646915]Field Reference

 
     [bookmark: pgfId-646918] 

 
      
       
        
        [bookmark: pgfId-641014]Table 17-32 [bookmark: 49329]HTTP Map Extension Request Method Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-641020]Element
          
  
         		
           
           [bookmark: pgfId-641022]Description
          
  
        

 
         
         		[bookmark: pgfId-641028]Available and Selected Methods

 [bookmark: pgfId-641030]Action

 [bookmark: pgfId-641032]Generate Syslog

  
         		[bookmark: pgfId-641034]The Available Methods list contains the extension request methods defined in RFC 2616.

 [bookmark: pgfId-641036]To configure an action for a method, select it, then select an action and optionally select Generate Syslog if you want a message added to the syslog when an HTTP request containing the selected method is encountered. Click the >> button to add it to the Selected Methods list. (To remove a method from the selected list, select it and click the << button.)

 [bookmark: pgfId-641038]Tip You can select multiple methods at a time using Ctrl+click if the action and syslog requests are the same for each. [bookmark: pgfId-641040]The actions you can specify are:

 
           
           		 [bookmark: pgfId-641042]Allow Packet—Allow the message.

 
           		 [bookmark: pgfId-641044]Drop Packet—Close the connection.

 
           		 [bookmark: pgfId-641046]Reset Connection (default)—Send a TCP reset message to client and server.

 
          

  
        

 
         
         		[bookmark: pgfId-641052]Specify the action to be applied for the remaining available methods above.

  
         		[bookmark: pgfId-641054]Whether to define a default action for the methods for which you have not configured specific actions above. If you select this option, select the action and syslog setting to use for the default action.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646928][bookmark: 49365][bookmark: pobjpage_cncpt_AddandEditHTTPMapPortMisuseTab]HTTP Map Port Misuse Tab [bookmark: marker-646924][bookmark: marker-646926]

 
     [bookmark: pgfId-646930]Use the Port Misuse tab to enable port misuse application firewall inspection. The application categories you can configure are:

 
      
      		 [bookmark: pgfId-646932]IM—Instant Messaging. The applications checked for are Yahoo! Messenger, AIM, and MSN IM.

 
      		 [bookmark: pgfId-646934]P2P—Peer-to-peer applications. The Kazaa application is checked.

 
      		 [bookmark: pgfId-646936]Tunneling—Tunneling applications. The applications checked for are HTTPort/HTTHost, GNU Httptunnel, GotoMyPC, Firethru, and Http-tunnel.com Client.

 
     

 
     [bookmark: pgfId-646938]Navigation Path

 
     [bookmark: pgfId-646943]Click the Port Misuse tab on the Add and Edit HTTP Map dialog boxes for ASA 7.1.x/PIX 7.1.x/FWSM 3.x/IOS Devices. See Configuring HTTP Maps for ASA 7.1.x, PIX 7.1.x, FWSM 3.x and IOS Devices.

 
     [bookmark: pgfId-646945]Related Topics

 
      
      		 [bookmark: pgfId-646950]Understanding Map Objects

 
      		 [bookmark: pgfId-646955]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-646957]Field Reference

 
     [bookmark: pgfId-646960] 

 
      
       
        
        [bookmark: pgfId-641067]Table 17-33 [bookmark: 49399]HTTP Map Port Misuse Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-641073]Element
          
  
         		
           
           [bookmark: pgfId-641075]Description
          
  
        

 
         
         		[bookmark: pgfId-641081]Available and Selected Application Categories

 [bookmark: pgfId-641083]Action

 [bookmark: pgfId-641085]Generate Syslog

  
         		[bookmark: pgfId-641087]The Available Application Categories list contains the categories for which you can define firewall inspection settings.

 [bookmark: pgfId-641089]To configure an action for a category, select it, then select an action and optionally select Generate Syslog if you want a message added to the syslog when an HTTP request containing the selected application is encountered. Click the >> button to add it to the Selected Categories list. (To remove a category from the selected list, select it and click the << button.)

 [bookmark: pgfId-641091]Tip You can select multiple categories at a time using Ctrl+click if the action and syslog requests are the same for each. [bookmark: pgfId-641093]The actions you can specify are:

 
           
           		 [bookmark: pgfId-641095]Allow Packet—Allow the message.

 
           		 [bookmark: pgfId-641097]Drop Packet—Close the connection.

 
           		 [bookmark: pgfId-641099]Reset Connection (default)—Send a TCP reset message to client and server.

 
          

  
        

 
         
         		[bookmark: pgfId-641105]Specify the action to be applied for the remaining available categories above.

  
         		[bookmark: pgfId-641107]Whether to define a default action for the categories for which you have not configured specific actions above. If you select this option, select the action and syslog setting to use for the default action.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-646970][bookmark: 49435][bookmark: pobjpage_cncpt_AddandEditHTTPMapTransferEncodingTab]HTTP Map Transfer Encoding Tab [bookmark: marker-646966][bookmark: marker-646968]

 
     [bookmark: pgfId-646972]Use the Transfer Encoding tab to enable inspection based on the transfer encoding type. The encoding types that you can configure are:

 
      
      		 [bookmark: pgfId-646974]Chunked—Identifies the transfer encoding type in which the message body is transferred as a series of chunks.

 
      		 [bookmark: pgfId-646976]Compressed—Identifies the transfer encoding type in which the message body is transferred using UNIX file compression.

 
      		 [bookmark: pgfId-646978]Deflate—Identifies the transfer encoding type in which the message body is transferred using zlib format (RFC 1950) and deflate compression (RFC 1951).

 
      		 [bookmark: pgfId-646980]GZIP—Identifies the transfer encoding type in which the message body is transferred using GNU zip (RFC 1952).

 
      		 [bookmark: pgfId-646982]Identity—Identifies connections in which no transfer encoding is performed in the message body.

 
     

 
     [bookmark: pgfId-646984]Navigation Path

 
     [bookmark: pgfId-646989]Click the Transfer Encoding tab on the Add and Edit HTTP Map dialog boxes for ASA 7.1.x/PIX 7.1.x/FWSM 3.x/IOS Devices. See Configuring HTTP Maps for ASA 7.1.x, PIX 7.1.x, FWSM 3.x and IOS Devices.

 
     [bookmark: pgfId-646991]Related Topics

 
      
      		 [bookmark: pgfId-646996]Understanding Map Objects

 
      		 [bookmark: pgfId-647001]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-647003]Field Reference

 
     [bookmark: pgfId-647006] 

 
      
       
        
        [bookmark: pgfId-641120]Table 17-34 [bookmark: 49473]HTTP Map Transfer Encoding Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-641126]Element
          
  
         		
           
           [bookmark: pgfId-641128]Description
          
  
        

 
         
         		[bookmark: pgfId-641134]Available and Selected Encoding Types

 [bookmark: pgfId-641136]Action

 [bookmark: pgfId-641138]Generate Syslog

  
         		[bookmark: pgfId-641140]The Available Encoding Types list contains the types of transfer encoding for which you can define firewall inspection settings.

 [bookmark: pgfId-641142]To configure an action for a type, select it, then select an action and optionally select Generate Syslog if you want a message added to the syslog when an HTTP request containing the selected type is encountered. Click the >> button to add it to the Selected Encoding Types list. (To remove a type from the selected list, select it and click the << button.)

 [bookmark: pgfId-641144]Tip You can select multiple types at a time using Ctrl+click if the action and syslog requests are the same for each. [bookmark: pgfId-641146]The actions you can specify are:

 
           
           		 [bookmark: pgfId-641148]Allow Packet—Allow the message.

 
           		 [bookmark: pgfId-641150]Drop Packet—Close the connection.

 
           		 [bookmark: pgfId-641152]Reset Connection (default)—Send a TCP reset message to client and server.

 
          

  
        

 
         
         		[bookmark: pgfId-641158]Specify the action to be applied for the remaining available encoding types above.

  
         		[bookmark: pgfId-641160]Whether to define a default action for the types for which you have not configured specific actions above. If you select this option, select the action and syslog setting to use for the default action.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-647028][bookmark: 49510][bookmark: pobjpage_cncpt_AddandEditHTTPMapDialogBoxes-2]Configuring HTTP Maps for ASA 7.2+ and PIX 7.2+ Devices[bookmark: marker-647016][bookmark: marker-647018][bookmark: marker-647020][bookmark: marker-647022][bookmark: marker-647024][bookmark: marker-647026]

 
     [bookmark: pgfId-647030]Use the Add and Edit HTTP Map dialog boxes to define the match criterion and values for the HTTP inspect map for ASA and PIX software releases 7.2 and higher.

 
     [bookmark: pgfId-647032]Navigation Path

 
     [bookmark: pgfId-647034]Select Manage > Policy Objects, then select Maps > Policy Maps > Inspect > HTTP (ASA 7.2+/PIX 7.2+) from the Object Type selector. Right-click inside the work area, then select New Object or right-click a row, then select Edit Object.

 
     [bookmark: pgfId-647036]Related Topics

 
      
      		 [bookmark: pgfId-647041]Understanding Map Objects

 
      		 [bookmark: pgfId-647046]Configuring Protocols and Maps for Inspection

 
      		 [bookmark: pgfId-647051]Configuring Class Maps for Inspection Policies

 
     

 
     [bookmark: pgfId-647053]Field Reference

 
     [bookmark: pgfId-647056] 

 
      
       
        
        [bookmark: pgfId-641173]Table 17-35 [bookmark: 49558]Add and Edit HTTP Map Dialog Boxes (ASA 7.2+/PIX 7.2+) 

 
        
       
         
         		
           
           [bookmark: pgfId-641179]Element
          
  
         		
           
           [bookmark: pgfId-641181]Description
          
  
        

 
         
         		[bookmark: pgfId-641187]Name

  
         		[bookmark: pgfId-641189]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-641195]Description

  
         		[bookmark: pgfId-641197]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		 
           
           [bookmark: pgfId-641203]Parameters tab
          
  
        

 
         
         		[bookmark: pgfId-641211]Body Match Maximum

  
         		[bookmark: pgfId-641213]The maximum number of characters in the body of an HTTP message that should be searched in a body match.

 [bookmark: pgfId-641215]Tip A high value can have a significant impact on performance.  
        

 
         
         		[bookmark: pgfId-641221]Check for protocol violations

  
         		[bookmark: pgfId-641223]Whether to check for protocol violations.

  
        

 
         
         		[bookmark: pgfId-641229]Action

  
         		[bookmark: pgfId-641231]The action to take based on the defined settings. You can drop, reset, or log the connection.

  
        

 
         
         		[bookmark: pgfId-641237]Spoof Server

  
         		[bookmark: pgfId-641239]Enables you to replace the server HTTP header value with the specified string.

  
        

 
         
         		 [bookmark: pgfId-641245]Match Condition and Action Tab

 [bookmark: pgfId-641247]The Match All table lists the criteria included in the policy map. Each row indicates whether the inspection is looking for traffic that matches or does not match each criterion, the criterion and value that is inspected, and the action to be taken for traffic that satisfies the conditions.

 
           
           		 [bookmark: pgfId-641252]To add a criterion, click the Add button and fill in the Match Condition and Action dialog box (see HTTP Class and Policy Map (ASA 7.2+/PIX 7.2+) Add or Edit Match Condition (and Action) Dialog Boxes).

 
           		 [bookmark: pgfId-641254]To edit a criterion, select it and click the Edit button.

 
           		 [bookmark: pgfId-641256]To delete a criterion, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-641264]Category

  
         		[bookmark: pgfId-641269]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-641275]Allow Value Override per Device

 [bookmark: pgfId-641277]Overrides

 [bookmark: pgfId-641279]Edit button

  
         		[bookmark: pgfId-641287]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-641289]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
         
         		[bookmark: pgfId-641295]Overrides: None

  
         		[bookmark: pgfId-641300]Shows that no overrides exist on the device. You must manually set overrides in order to change the display. For more information, see Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-641302]Note Selecting Allow Value Override per Device does not automatically set overrides.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-647188][bookmark: 49643][bookmark: pobjpage_cncpt_HTTPClassandPolicyMapsASA7.2PIX7.2AddorEditMatchConditionandActionDialogBoxes]HTTP Class and Policy Map (ASA 7.2+/PIX 7.2+) Add or Edit Match Condition (and Action) Dialog Boxes [bookmark: marker-647176][bookmark: marker-647178][bookmark: marker-647180][bookmark: marker-647182][bookmark: marker-647184][bookmark: marker-647186]

 
     [bookmark: pgfId-647190]Use the Add or Edit HTTP Match Criterion (for HTTP class maps) or Match Condition and Action (for HTTP policy maps) dialog boxes to do the following:

 
      
      		 [bookmark: pgfId-647192]Define the match criterion and value for an HTTP class map.

 
      		 [bookmark: pgfId-647194]Select an HTTP class map when creating an HTTP policy map.

 
      		 [bookmark: pgfId-647196]Define the match criterion, value, and action directly in an HTTP policy map.

 
     

 
     [bookmark: pgfId-647198]These types of maps are used only for devices running ASA 7.2 or higher, or PIX 7.2 or higher, operating systems.

 
     [bookmark: pgfId-647200]The fields on this dialog box change based on the criterion you select and whether you are creating a class map or policy map. You can use the following criteria:

 
      
      		 [bookmark: pgfId-647202]Request/Response Content Type Mismatch—Specifies that the content type in the response must match one of the MIME types in the accept field of the request.

 
      		 [bookmark: pgfId-647204]Request Arguments—Applies the regular expression match to the arguments of the request.

 
      		 [bookmark: pgfId-647206]Request Body—Applies the regular expression match to the body of the request.

 
      		 [bookmark: pgfId-647208]Request Body Length—Specifies that the body length of the request be matched as greater than or less than the specified number of bytes.

 
      		 [bookmark: pgfId-647210]Request Header Count—Specifies that the number of headers in the request be matched as greater than or less than the specified number.

 
      		 [bookmark: pgfId-647212]Request Header Length—Specifies that the header length of the request be matched as greater than or less than the specified number of bytes.

 
      		 [bookmark: pgfId-647214]Request Header Field—Applies the regular expression match to the header of the request.

 
      		 [bookmark: pgfId-647216]Request Header Field Count—Applies the regular expression match to the header of the request based on a specified number of header fields.

 
      		 [bookmark: pgfId-647218]Request Header Field Length—Applies the regular expression match to the header of the request based on a specified field length.

 
      		 [bookmark: pgfId-647220]Request Header Content Type—Specifies the content type to evaluate in the content-type header field of the request.

 
      		 [bookmark: pgfId-647222]Request Header Transfer Encoding—Specifies the transfer encoding to evaluate in the transfer-encoding header field of the request.

 
      		 [bookmark: pgfId-647224]Request Header Non-ASCII—Specifies whether there are non-ASCII characters in the header of the request.

 
      		 [bookmark: pgfId-647226]Request Method—Specifies the method of the request to match.

 
      		 [bookmark: pgfId-647228]Request URI—Applies the regular expression match to the URI of the request.

 
      		 [bookmark: pgfId-647230]Request URI Length—Specifies that the URI length of the request be matched as greater than or less than the specified number of bytes.

 
      		 [bookmark: pgfId-647232]Response Body ActiveX—Specifies whether there is ActiveX content in the body of the request.

 
      		 [bookmark: pgfId-647234]Response Body Java Applet—Specifies whether there is a Java applet in the body of the request.

 
      		 [bookmark: pgfId-647236]Response Body—Applies the regular expression match to the body of the response.

 
      		 [bookmark: pgfId-647238]Response Body Length—Specifies that the body length of the response be matched as greater than or less than the specified number of bytes.

 
      		 [bookmark: pgfId-647240]Response Header Count—Specifies that the number of headers in the response be matched as greater than or less than the specified number.

 
      		 [bookmark: pgfId-647242]Response Header Length—Specifies that the header length of the response be matched as greater than or less than the specified number of bytes.

 
      		 [bookmark: pgfId-647244]Response Header Field—Applies the regular expression match to the header of the response.

 
      		 [bookmark: pgfId-647246]Response Header Field Count—Applies the regular expression match to the header of the response based on a specified number of header fields.

 
      		 [bookmark: pgfId-647248]Response Header Field Length—Applies the regular expression match to the header of the response based on a specified field length.

 
      		 [bookmark: pgfId-647250]Response Header Content Type—Specifies the content type to evaluate in the content-type header field of the response.

 
      		 [bookmark: pgfId-647252]Response Header Transfer Encoding—Specifies the transfer encoding to evaluate in the transfer-encoding header field of the response.

 
      		 [bookmark: pgfId-647254]Response Header Non-ASCII—Specifies whether there are non-ASCII characters in the header of the response.

 
      		 [bookmark: pgfId-647256]Response Status Line—Applies the regular expression match to the status line of the response.

 
     

 
     [bookmark: pgfId-647258]Navigation Path

 
     [bookmark: pgfId-647263]When creating an HTTP class map, in the Policy Object Manager, from the Add or Edit Class Maps dialog boxes for HTTP, right-click inside the table, then select Add Row or right-click a row, then select Edit Row. See Configuring Class Maps for Inspection Policies.

 
     [bookmark: pgfId-647268]When creating an HTTP policy map, in the Policy Object Manager, from the Match Condition and Action tab on the Add and Edit HTTP Map dialog boxes for ASA/PIX 7.2+ devices, right-click inside the table, then select Add Row or right-click a row, then select Edit Row. See Configuring HTTP Maps for ASA 7.2+ and PIX 7.2+ Devices.

 
     [bookmark: pgfId-647270]Related Topics

 
      
      		 [bookmark: pgfId-647275]Understanding Map Objects

 
      		 [bookmark: pgfId-647280]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-647282]Field Reference

 
     [bookmark: pgfId-647285] 

 
      
       
        
        [bookmark: pgfId-641315]Table 17-36 [bookmark: 49809]HTTP Class and Policy Maps (ASA 7.2+/PIX 7.2+) Add and Edit Match Condition and Action Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-641321]Element
          
  
         		
           
           [bookmark: pgfId-641323]Description
          
  
        

 
         
         		[bookmark: pgfId-641329]Match Type

 [bookmark: pgfId-641331]Class Name

 [bookmark: pgfId-641333](Policy Map only)

  
         		[bookmark: pgfId-641335]Enables you to use an existing HTTP class map or define a new HTTP class map.

 
           
           		 [bookmark: pgfId-641337]Use Specified Values—You want to define the class map on this dialog box.

 
           		 [bookmark: pgfId-641339]Use Values in Class Map—You want to select an existing HTTP class map policy object. Enter the name of the HTTP class map in the  Class Name field. Click  Select to select the map from a list or to create a new class map object.

 
          

  
        

 
         
         		[bookmark: pgfId-641345]Criterion

  
         		[bookmark: pgfId-641347]Specifies which criterion of HTTP traffic to match. The criteria are described above.

  
        

 
         
         		[bookmark: pgfId-641353]Type

  
         		[bookmark: pgfId-641355]Specifies whether the map includes traffic that matches or does not match the criterion. For example, if Doesn’t Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the map.

 
           
           		 [bookmark: pgfId-641357]Matches—Matches the criterion. For some criteria, this is the only available option.

 
           		 [bookmark: pgfId-641359]Doesn’t Match—Does not match the criterion.

 
          

  
        

 
         
         		[bookmark: pgfId-641365]Action

 [bookmark: pgfId-641367](Policy Map only)

  
         		[bookmark: pgfId-641369]The action you want the device to take for traffic that matches the defined criteria. The types of action depend on the criterion you select.

  
        

 
         
         		 [bookmark: pgfId-641375]Variable Fields

 [bookmark: pgfId-641377]The following fields vary based on what you select in the Criterion field. This list is a super-set of the fields you might see.

  
        

 
         
         		[bookmark: pgfId-641385]Field Name

  
         		[bookmark: pgfId-641387]The name of the header field to evaluate. You can select one of the following:

 
           
           		 [bookmark: pgfId-641389]Predefined—The predefined HTTP header fields.

 
           		 [bookmark: pgfId-641391]Regular Expression—The regular expression object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click  Select to choose the object from a list of existing ones or to create a new regular expression object.

 
          

  
        

 
         
         		[bookmark: pgfId-641397]Value

  
         		[bookmark: pgfId-641399]The regular expression you want to evaluate. You can select one of the following:

 
           
           		 [bookmark: pgfId-641401]Regular Expression—The regular expression object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click  Select to choose the object from a list of existing ones or to create a new regular expression object.

 
           		 [bookmark: pgfId-641403]Regular Expression Group—The regular expression group object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click  Select to choose the object from a list of existing ones or to create a new regular expression group object.

 
          

 [bookmark: pgfId-641405]When you are evaluating the Request Header Transfer Encoding or Response Header Transfer Encoding criteria, you can also select these options:

 
           
           		 [bookmark: pgfId-641407]Specified By—One of the following predefined types of transfer encoding:

 
          

 [bookmark: pgfId-641409] – Chunked—The message body is transferred as a series of chunks.

 [bookmark: pgfId-641411] – Compressed—The message body is transferred using UNIX file compression.

 [bookmark: pgfId-641413] – Deflate—The message body is transferred using zlib format (RFC 1950) and deflate compression (RFC 1951).

 [bookmark: pgfId-641415] – GZIP—The message body is transferred using GNU zip (RFC 1952).

 [bookmark: pgfId-641417] – Identity—No transfer encoding is performed.

 
           
           		 [bookmark: pgfId-641419]Empty—The transfer-encoding field in request header is empty.

 
          

  
        

 
         
         		[bookmark: pgfId-641425]Greater Than Length

  
         		[bookmark: pgfId-641427]The length in bytes of the evaluated field. The criterion matches if the length is greater than the specified number, and does not match if the field is less than the specified number.

  
        

 
         
         		[bookmark: pgfId-641433]Greater Than Count

  
         		[bookmark: pgfId-641435]The number of evaluated items. The criterion matches if the count is greater than the specified number, and does not match if the count is less than the specified number.

  
        

 
         
         		[bookmark: pgfId-641441]Content Type

  
         		[bookmark: pgfId-641443]The content type to evaluate as specified in the content-type header field. You can select one of the following:

 
           
           		 [bookmark: pgfId-641445]Specified By—A predefined MIME type.

 
           		 [bookmark: pgfId-641447]Unknown—The MIME type is not known. Select Unknown when you want to evaluate the item against all known MIME types.

 
           		 [bookmark: pgfId-641449]Violation—The magic number in the body must correspond to the MIME type in the content-type header field.

 
           		 [bookmark: pgfId-641451]Regular Expression, Regular Expression Group—The regular expression or regular expression group to evaluate. See the explanation for the Value field for an explanation of these options.

 
          

  
        

 
         
         		[bookmark: pgfId-641457]Request Method

  
         		[bookmark: pgfId-641459]The specified request method to match. You can select one of the following:

 
           
           		 [bookmark: pgfId-641461]Specified By—The predefined request method.

 
           		 [bookmark: pgfId-641463]Regular Expression, Regular Expression Group—The regular expression or regular expression group to evaluate. See the explanation for the Value field for an explanation of these options.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-647305][bookmark: 49936][bookmark: pobjpage_cncpt_AddandEditIMMapDialogBoxesforASAPIX]Configuring IM Maps for ASA 7.2+, PIX 7.2+ Devices[bookmark: marker-647293][bookmark: marker-647295][bookmark: marker-647297][bookmark: marker-647299][bookmark: marker-647301][bookmark: marker-647303]

 
     [bookmark: pgfId-647307]Use the Add and Edit IM Map dialog boxes to define settings for define an Instant Messenger (IM) inspect map for devices running ASA/PIX 7.2 or higher. An IM map lets you change the default configuration values used for IM application inspection.

 
     [bookmark: pgfId-647309]Instant Messaging causes concern due to its use of clear text when conducting business and the potential for network attacks and the spreading of viruses. Thus, you might want to block certain types of instant messages from occurring, while allowing others.

 
     [bookmark: pgfId-647311]For ASA and PIX devices, IM application inspection provides detailed access control to control network usage. You can use regular expressions to help stop leakage of confidential data and the propagation of network threats. You can inspect Yahoo! Messenger or MSN Messenger traffic.

 
     [bookmark: pgfId-647313]Navigation Path

 
     [bookmark: pgfId-647315]Select Manage > Policy Objects, then select Maps > Policy Maps > Inspect > IM (ASA 7.2+/PIX 7.2+) from the Object Type selector. Right-click inside the work area, then select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-647317]Related Topics

 
      
      		 [bookmark: pgfId-647322]Understanding Map Objects

 
      		 [bookmark: pgfId-647327]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-647329]Field Reference

 
     [bookmark: pgfId-647332] 

 
      
       
        
        [bookmark: pgfId-641476]Table 17-37 [bookmark: 49982]Add and Edit IM Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-641482]Element
          
  
         		
           
           [bookmark: pgfId-641484]Description
          
  
        

 
         
         		[bookmark: pgfId-641490]Name

  
         		[bookmark: pgfId-641492]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-641498]Description

  
         		[bookmark: pgfId-641500]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		 [bookmark: pgfId-641506]Match Condition and Action Tab

 [bookmark: pgfId-641508]The Match All table lists the criteria included in the policy map. Each row indicates whether the inspection is looking for traffic that matches or does not match each criterion, the criterion and value that is inspected, and the action to be taken for traffic that satisfies the conditions.

 
           
           		 [bookmark: pgfId-641513]To add a criterion, click the Add button and fill in the Match Condition and Action dialog box (see IM Class and Policy Map (ASA 7.2+/PIX 7.2+) Add or Edit Match Condition (and Action) Dialog Boxes).

 
           		 [bookmark: pgfId-641515]To edit a criterion, select it and click the Edit button.

 
           		 [bookmark: pgfId-641517]To delete a criterion, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-641525]Category

  
         		[bookmark: pgfId-641530]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-641536]Allow Value Override per Device

 [bookmark: pgfId-641538]Overrides

 [bookmark: pgfId-641540]Edit button

  
         		[bookmark: pgfId-641548]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-641550]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-647384][bookmark: 50034][bookmark: pobjpage_cncpt_IMClassandPolicyMapsASAPIXAddorEditMatchConditionandActionDialogBoxes]IM Class and Policy Map (ASA 7.2+/PIX 7.2+) Add or Edit Match Condition (and Action) Dialog Boxes [bookmark: marker-647372][bookmark: marker-647374][bookmark: marker-647376][bookmark: marker-647378][bookmark: marker-647380][bookmark: marker-647382]

 
     [bookmark: pgfId-647386]Use the Add or Edit IM Match Criterion (for IM class maps) or Match Condition and Action (for IM policy maps) dialog boxes to do the following:

 
      
      		 [bookmark: pgfId-647388]Define the match criterion and value for an IM class map.

 
      		 [bookmark: pgfId-647390]Select an IM class map when creating an IM policy map.

 
      		 [bookmark: pgfId-647392]Define the match criterion, value, and action directly in an IM policy map.

 
     

 
     [bookmark: pgfId-647394]These types of maps are used only for devices running ASA 7.2 or higher, or PIX 7.2 or higher, operating systems.

 
     [bookmark: pgfId-647396]The fields on this dialog box change based on the criterion you select and whether you are creating a class map or policy map.

 
     [bookmark: pgfId-647398]Navigation Path

 
     [bookmark: pgfId-647403]When creating an IM class map, in the Policy Object Manager, from the Add or Edit Class Maps dialog boxes for IM, right-click inside the table, then select Add Row or right-click a row, then select Edit Row. See Configuring Class Maps for Inspection Policies.

 
     [bookmark: pgfId-647408]When creating an IM policy map, in the Policy Object Manager, from the Match Condition and Action tab on the Add and Edit IM Map dialog boxes for ASA 7.2/PIX 7.2, right-click inside the table, then select Add Row or right-click a row, then select Edit Row. See Configuring IM Maps for ASA 7.2+, PIX 7.2+ Devices.

 
     [bookmark: pgfId-647410]Related Topics

 
      
      		 [bookmark: pgfId-647415]Understanding Map Objects

 
      		 [bookmark: pgfId-647420]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-647422]Field Reference

 
     [bookmark: pgfId-647425] 

 
      
       
        
        [bookmark: pgfId-641563]Table 17-38 [bookmark: 50103]IM Class and Policy Map (ASA 7.2+/PIX 7.2+) Add or Edit Match Condition (and Action) Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-641569]Element
          
  
         		
           
           [bookmark: pgfId-641571]Description
          
  
        

 
         
         		[bookmark: pgfId-641577]Match Type

 [bookmark: pgfId-641579]Class Name

 [bookmark: pgfId-641581](Policy Map only)

  
         		[bookmark: pgfId-641583]Enables you to use an existing IM class map or define a new IM class map.

 
           
           		 [bookmark: pgfId-641585]Use Specified Values—You want to define the class map on this dialog box.

 
           		 [bookmark: pgfId-641587]Use Values in Class Map—You want to select an existing IM class map policy object. Enter the name of the IM class map in the  Class Name field. Click  Select to select the map from a list or to create a new class map object.

 
          

  
        

 
         
         		[bookmark: pgfId-641593]Criterion

  
         		[bookmark: pgfId-641595]Specifies which criterion of IM traffic to match. The criteria are:

 
           
           		 [bookmark: pgfId-641597]Filename—Matches the filename from IM file transfer service.

 
           		 [bookmark: pgfId-641599]Client IP Address—Matches the source client IP address.

 
           		 [bookmark: pgfId-641601]Client Login Name—Matches the client login name from IM service.

 
           		 [bookmark: pgfId-641603]Peer IP Address—Matches the peer, or destination, IP address.

 
           		 [bookmark: pgfId-641605]Peer Login Name—Matches the peer, or destination, login name from IM service.

 
           		 [bookmark: pgfId-641607]Protocol—Matches IM protocols.

 
           		 [bookmark: pgfId-641609]Service—Matches IM services.

 
           		 [bookmark: pgfId-641611]File Transfer Service Version—Matches the IM file transfer service version.

 
          

  
        

 
         
         		[bookmark: pgfId-641617]Type

  
         		[bookmark: pgfId-641619]Specifies whether the map includes traffic that matches or does not match the criterion. For example, if Doesn’t Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the map.

 
           
           		 [bookmark: pgfId-641621]Matches—Matches the criterion.

 
           		 [bookmark: pgfId-641623]Doesn’t Match—Does not match the criterion.

 
          

  
        

 
         
         		[bookmark: pgfId-641629]Action

 [bookmark: pgfId-641631](Policy Map only)

  
         		[bookmark: pgfId-641633]The action you want the device to take for traffic that matches the defined criteria.

  
        

 
         
         		 [bookmark: pgfId-641639]Variable Fields

 [bookmark: pgfId-641641]The following fields vary based on what you select in the Criterion field. This list is a super-set of the fields you might see.

  
        

 
         
         		[bookmark: pgfId-641649]Value

  
         		[bookmark: pgfId-641651]The regular expression you want to evaluate. You can select one of the following:

 
           
           		 [bookmark: pgfId-641653]Regular Expression—The regular expression object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click  Select to choose the object from a list of existing ones or to create a new regular expression object.

 
           		 [bookmark: pgfId-641655]Regular Expression Group—The regular expression group object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click  Select to choose the object from a list of existing ones or to create a new regular expression group object.

 
          

  
        

 
         
         		[bookmark: pgfId-641661]IP Address

  
         		[bookmark: pgfId-641663]The IP address you want to match.

  
        

 
         
         		[bookmark: pgfId-641669]Protocol

  
         		[bookmark: pgfId-641671]The IM protocol, either MSN Messenger or Yahoo! Messenger.

  
        

 
         
         		[bookmark: pgfId-641677]Services

  
         		[bookmark: pgfId-641679]The IM services you want to inspect. Select one or more of the listed services.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-647449][bookmark: 50200][bookmark: pobjpage_cncpt_AddandEditIMMapIOSDialogBoxes]Configuring IM Maps for IOS Devices[bookmark: marker-647437][bookmark: marker-647439][bookmark: marker-647441][bookmark: marker-647443][bookmark: marker-647445][bookmark: marker-647447]

 
     [bookmark: pgfId-647451]Use the Add and Edit IM Map (IOS) dialog boxes to configure Instant Messaging (IM) inspection policy map objects for IOS devices. An IM map lets you change the default configuration values used for IM application inspection.

 
     [bookmark: pgfId-647453]Instant Messaging causes concern due to its use of clear text when conducting business and the potential for network attacks and the spreading of viruses. Thus, you might want to block certain types of instant messages from occurring, while allowing others.

 
     [bookmark: pgfId-647455]IM application inspection provides detailed access control to control network usage. It also helps stop leakage of confidential data and the propagation of network threats. The scope can be limited by identifying permitted or denied servers. Inspection of Yahoo! Messenger, MSN Messenger, and AOL instant messages are supported.

 
     [bookmark: pgfId-647457]Navigation Path

 
     [bookmark: pgfId-647459]Select Manage > Policy Objects, then select Maps > Policy Maps > Inspect > IM (IOS) from the Object Type selector. Right-click inside the work area, then select New Object or right-click a row, then select Edit Object.

 
     [bookmark: pgfId-647461]Related Topics

 
      
      		 [bookmark: pgfId-647466]Understanding Map Objects

 
      		 [bookmark: pgfId-647471]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-647473]Field Reference

 
     [bookmark: pgfId-647476] 

 
      
       
        
        [bookmark: pgfId-641692]Table 17-39 [bookmark: 50248]Add and Edit IM Map (IOS) Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-641698]Element
          
  
         		
           
           [bookmark: pgfId-641700]Description
          
  
        

 
         
         		[bookmark: pgfId-641706]Name

  
         		[bookmark: pgfId-641708]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-641714]Description

  
         		[bookmark: pgfId-641716]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		 [bookmark: pgfId-641722]Service Tabs

 [bookmark: pgfId-641724]The tabs represent different IM service providers. The settings available on each tab are identical. You must configure the settings separately for each service provider. The descriptions of the following fields apply to each of the services: Yahoo!, MSN, and AOL.

  
        

 
         
         		[bookmark: pgfId-641732]Text Chat

  
         		[bookmark: pgfId-641734]How you want the text chat service to be handled, for example, allowed, denied, logged, or some combination.

  
        

 
         
         		[bookmark: pgfId-641740]Other Services

  
         		[bookmark: pgfId-641742]How you want services other than text chat to be handled, for example, allowed, denied, logged, or some combination. IOS software recognizes all services other than text chat, such as voice-chat, video-chat, file sharing and transferring, and gaming as a single group.

  
        

 
         
         		[bookmark: pgfId-641748]Permit Servers

  
         		[bookmark: pgfId-641750]The servers from which to permit traffic. Accepted formats are IP addresses, IP ranges, and hostnames separated by commas.

  
        

 
         
         		[bookmark: pgfId-641756]Deny Servers

  
         		[bookmark: pgfId-641758]The servers from which to deny traffic. Accepted formats are IP addresses, IP ranges, and hostnames separated by commas.

  
        

 
         
         		[bookmark: pgfId-641764]Alert

  
         		[bookmark: pgfId-641766]Whether you want to enable or disable alerts. The default is to use the default inspection settings.

  
        

 
         
         		[bookmark: pgfId-641772]Audit

  
         		[bookmark: pgfId-641774]Whether you want to enable or disable an audit trail. The default is to use the default inspection settings.

  
        

 
         
         		[bookmark: pgfId-641780]Timeout

  
         		[bookmark: pgfId-641782]A timeout for the service. You can use the default inspection settings, or you can elect to specify a timeout. If you select Specify Timeout, enter the timeout value in seconds.

  
        

 
         
         		[bookmark: pgfId-641788]Category

  
         		[bookmark: pgfId-641793]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-641799]Allow Value Override per Device

 [bookmark: pgfId-641801]Overrides

 [bookmark: pgfId-641803]Edit button

  
         		[bookmark: pgfId-641811]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-641813]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-647496][bookmark: 50328][bookmark: pobjpage_cncpt_IPOptionsMapDialogBox]Configuring IP Options Maps[bookmark: marker-647484][bookmark: marker-647486][bookmark: marker-647488][bookmark: marker-647490][bookmark: marker-647492][bookmark: marker-647494]

 
     [bookmark: pgfId-647498]Use the Add and Edit IP Options Map dialog boxes to define maps for the inspection of the options in an IP packet header on ASA 8.2(2)+ devices. The options field provides for control functions that are required in some situations but unnecessary for most common communications.

 
     [bookmark: pgfId-647500]If you do not configure IP options inspection, the ASA device drops packets that have any options configured, with one exception. In routed mode, packets that contain the router alert option are allowed. (To disallow router alert packets, create an IP options map with router alert deselected, and configure an inspection rule to inspect IP Options using the policy map.)

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-647502]Tip Because the no operation (NOP) option might be used as padding to ensure proper packet-header size and alignment, you might want to allow NOP.


     
      

     

     

 
     [bookmark: pgfId-647504]For each option, you can select whether to:

 
      
      		 [bookmark: pgfId-647506] Allow —Allow the packet and do not change the IP header options field.

 
      		 [bookmark: pgfId-647508] Clear —Allow the packet and clear the option from the IP header options field.

 
     

 
     [bookmark: pgfId-647510]If you do not select an option, the option is prohibited, and packets containing the option are dropped. Any option not listed here also results in a dropped packet; you cannot change this behavior.

 
     [bookmark: pgfId-647512]Navigation Path

 
     [bookmark: pgfId-647514]Select Manage > Policy Objects, then select Maps > Policy Maps > Inspect > IP Options from the Object Type selector. Right-click inside the work area, then select New Object, or right-click a row and select Edit Object.

 
     [bookmark: pgfId-647516]Related Topics

 
      
      		 [bookmark: pgfId-647521]Understanding Map Objects

 
      		 [bookmark: pgfId-647526]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-647528]Field Reference

 
     [bookmark: pgfId-647531] 

 
      
       
        
        [bookmark: pgfId-641826]Table 17-40 [bookmark: 50382]Add and Edit IP Options Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-641832]Element
          
  
         		
           
           [bookmark: pgfId-641834]Description
          
  
        

 
         
         		[bookmark: pgfId-641840]Name

  
         		[bookmark: pgfId-641842]The name of the policy object. A maximum of 128 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-641848]Description

  
         		[bookmark: pgfId-641850]A description of the policy object.

  
        

 
         
         		[bookmark: pgfId-641856]End of Options List

  
         		[bookmark: pgfId-641858]End of Options List (EOOL), or IP Option 0, contains just a single zero byte and appears at the end of all options to mark the end of a list of options. This might not coincide with the end of the header according to the header length.

  
        

 
         
         		[bookmark: pgfId-641864]No operation

  
         		[bookmark: pgfId-641866]No Operation (NOP), or IP Option 1, is used for padding. The Options field in the IP header can contain zero, one, or more options, which makes the total length of the field variable. However, the IP header must be a multiple of 32 bits. If the number of bits of all options is not a multiple of 32 bits, the NOP option is used as to align the options on a 32-bit boundary.

  
        

 
         
         		[bookmark: pgfId-641872]Router alert

  
         		[bookmark: pgfId-641874]Router Alert (RTRALT), or IP Option 20, notifies transit routers to inspect the contents of the packet even when the packet is not destined for that router. This inspection is valuable when implementing RSVP and similar protocols require relatively complex processing from the routers along the packet’s delivery path.

  
        

 
         
         		[bookmark: pgfId-641880]Basic Security (ASA devices 9.5(1) or higher)

  
         		[bookmark: pgfId-641882]IP-option Basic Security (number 130) from RFC 1108, default is to drop.

  
        

 
         
         		[bookmark: pgfId-641888]Commercial Security (ASA devices 9.5(1) or higher)

  
         		[bookmark: pgfId-641890]IP-option Commercial Security (number 134), default is to drop.

  
        

 
         
         		[bookmark: pgfId-641896]Default (ASA devices 9.5(1) or higher)

  
         		[bookmark: pgfId-641898]IP-option default configuration, default is drop.

  
        

 
         
         		[bookmark: pgfId-641904]Experimental Flow Control (ASA devices 9.5(1) or higher)

  
         		[bookmark: pgfId-641906]IP-option Experimental Flow Control (number 205), default is to drop.

  
        

 
         
         		[bookmark: pgfId-641912]Experimental Measurement (ASA devices 9.5(1) or higher)

  
         		[bookmark: pgfId-641914]IP-option Experimental Measurement (number 10), default is to drop.

  
        

 
         
         		[bookmark: pgfId-641920]Extended-Security (ASA devices 9.5(1) or higher)

  
         		[bookmark: pgfId-641922]IP-option Extended Security (number 133) from RFC 1108, default is to drop.

  
        

 
         
         		[bookmark: pgfId-641928]IMI Traffic Descriptor (ASA devices 9.5(1) or higher)

  
         		[bookmark: pgfId-641930]IP-option IMI Traffic Descriptor (number 144), default is to drop.

  
        

 
         
         		[bookmark: pgfId-641936]Quick Start (ASA devices 9.5(1) or higher)

  
         		[bookmark: pgfId-641938]IP-option Router Alert (number 25) from RFC 4782, default is to drop.

  
        

 
         
         		[bookmark: pgfId-641944]Record Route (ASA devices 9.5(1) or higher)

  
         		[bookmark: pgfId-641946]IP-option Record Route (number 7) from RFC 791, default is to drop.

  
        

 
         
         		[bookmark: pgfId-641952]Time Stamp (ASA devices 9.5(1) or higher)

  
         		[bookmark: pgfId-641954]IP-option Router Alert (number 68) from RFC 791, default is to drop.

  
        

 
         
         		 

  
        

 
         
         		[bookmark: pgfId-641970]Category

  
         		[bookmark: pgfId-641975]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-641981]Allow Value Override per Device

 [bookmark: pgfId-641983]Overrides

 [bookmark: pgfId-641985]Edit button

  
         		[bookmark: pgfId-641993]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-641995]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-647553][bookmark: 50501][bookmark: pobjpage_cncpt_AddandEditIPv6MapDialogBoxes]Configuring IPv6 Maps[bookmark: marker-647541][bookmark: marker-647543][bookmark: marker-647545][bookmark: marker-647547][bookmark: marker-647549][bookmark: marker-647551]

 
     [bookmark: pgfId-647555]Use the Add and Edit IPv6 Map dialog boxes to define the match criteria and values for an IPv6 inspect map. You can use an IPv6 map to selectively drop IPv6 packets based on following types of extension headers found anywhere in the IPv6 packet:

 
      
      		 [bookmark: pgfId-647557]Hop-by-Hop Options

 
      		 [bookmark: pgfId-647559]Routing (Type 0)

 
      		 [bookmark: pgfId-647561]Fragment

 
      		 [bookmark: pgfId-647563]Destination Options

 
      		 [bookmark: pgfId-647565]Authentication

 
      		 [bookmark: pgfId-647567]Encapsulating Security Payload

 
     

 
     [bookmark: pgfId-647572]Service objects corresponding to these protocols are available in the Services table in the Policy Object Manager.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-647574]Note With the release of Security Manager 4.4 and versions 9.0 and higher of the ASA, the separate policies for configuring IPv4 and IPv6 inspection rules were unified. However, IPv6 maps are still provided in support of earlier versions.


     
      

     

     

 
     [bookmark: pgfId-647576]Navigation Path

 
     [bookmark: pgfId-647578]Select Manage > Policy Objects, then select Maps > Policy Maps > Inspect > IPv6 from the Object Type selector. Right-click inside the table, then select New Object or right-click a row, then select Edit Object.

 
     [bookmark: pgfId-647580]Related Topics

 
      
      		 [bookmark: pgfId-647585]Understanding Map Objects

 
      		 [bookmark: pgfId-647590]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-647592]Field Reference

 
     [bookmark: pgfId-647595] 

 
      
       
        
        [bookmark: pgfId-642008]Table 17-41 [bookmark: 50560]Add and Edit IPv6 Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-642014]Element
          
  
         		
           
           [bookmark: pgfId-642016]Description
          
  
        

 
         
         		[bookmark: pgfId-642022]Name

  
         		[bookmark: pgfId-642024]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-642030]Description

  
         		[bookmark: pgfId-642032]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		 
           
           [bookmark: pgfId-642038]Parameters tab
          
  
        

 
         
         		[bookmark: pgfId-642046]Permit only known Extension Headers

  
         		[bookmark: pgfId-642048]Whether the ASA should verify the IPv6 extension header. When selected and an unknown IPv6 extension header is encountered, the ASA drops the packet and logs the action.

 [bookmark: pgfId-642050]This option is selected by default.

  
        

 
         
         		[bookmark: pgfId-642056]Enforce Extension Header Order

  
         		[bookmark: pgfId-642058]Whether the ASA should enforce extension header order as defined in the RFC 2460 specification. When selected and an error is detected, the ASA drops the packet and logs the action.

 [bookmark: pgfId-642060]This option is selected by default.

  
        

 
         
         		 [bookmark: pgfId-642066]Match Condition and Action Tab

 [bookmark: pgfId-642068]The Match All table lists the criteria included in the policy map. Each row indicates whether the inspection is looking for traffic that matches or does not match each criterion, the criterion and value that is inspected, and the action to be taken for traffic that satisfies the conditions.

 [bookmark: pgfId-642073]These criteria entries are created and edited in the IPv6 Policy Maps Add or Edit Match Condition and Action Dialog Boxes.

  
        

 
         
         		[bookmark: pgfId-642081]Category

  
         		[bookmark: pgfId-642086]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-642092]Allow Value Override per Device

 [bookmark: pgfId-642094]Overrides

 [bookmark: pgfId-642096]Edit button

  
         		[bookmark: pgfId-642104]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-642109]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides in the Policy Object Overrides Window. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-647623][bookmark: 50624][bookmark: pobjpage_cncpt_IPv6PolicyMapsAddorEditMatchConditionandActionDialogBoxes]IPv6 Policy Maps Add or Edit Match Condition and Action Dialog Boxes [bookmark: marker-647617][bookmark: marker-647619][bookmark: marker-647621]

 
     [bookmark: pgfId-647625]Use the Add or Edit Match Condition and Action dialog boxes to define an Extension Header match criterion and action for an IPv6 policy map. The contents of the Extension Headers are not processed; an action is applied based solely on the presence of a specified EH type.

 
     [bookmark: pgfId-647627]The fields in these dialog boxes change based on the criterion you select.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-647629]Note You can apply multiple match definitions to one IPv6 policy map.


     
      

     

     

 
     [bookmark: pgfId-647631]Navigation Path

 
     [bookmark: pgfId-647636]In the Policy Object Manager, from the Match Condition and Action tab on the Add or Edit IPv6 Map dialog boxes, right-click inside the table, then select Add Row or right-click a row, then select Edit Row. See Configuring IPv6 Maps.

 
     [bookmark: pgfId-647638]Related Topics

 
      
      		 [bookmark: pgfId-647643]Understanding Map Objects

 
      		 [bookmark: pgfId-647648]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-647650]Field Reference

 
     [bookmark: pgfId-647653] 

 
      
       
        
        [bookmark: pgfId-642122]Table 17-42 [bookmark: 50664]IPv6 Policy Maps Add or Edit Match Condition and Action Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-642128]Element
          
  
         		
           
           [bookmark: pgfId-642130]Description
          
  
        

 
         
         		[bookmark: pgfId-642136]Criterion

  
         		[bookmark: pgfId-642138]Choose the type of IPv6 Extension Header to match:

 
           
           		 [bookmark: pgfId-642140]Authentication Header (AH)—Provides integrity and data-origin authentication for IP packets.

 
           		 [bookmark: pgfId-642142]Destination Options Header—Used for IPv6 Mobility, as well as in support of certain applications.

 
           		 [bookmark: pgfId-642144]Encapsulating Security Payload Header (ESP)—All information following the ESP header is encrypted and not accessible to intermediate network devices.

 
           		 [bookmark: pgfId-642146]Fragment Header—Supports traffic-source fragmented-packet communications.

 
           		 [bookmark: pgfId-642148]Hop-by-Hop Options Header—Optional information that must be examined by every node in the packet’s delivery path.

 
           		 [bookmark: pgfId-642150]Header Count—The number of headers in the packet. When you choose this option, the following field appears; specify an upper bound for the number of headers:

 
          

 [bookmark: pgfId-642152] – Greater Than Count—Enter a value between 0 and 255.

 [bookmark: pgfId-642154]The packet is considered a match if the Header Count is greater than the specified number; it is not a match if the count is equal to, or less than the specified number.

 
           
           		 [bookmark: pgfId-642156]Routing Header Type—Use this option to match one or EH types based on their header codes. When you choose this type, the following Value options appear; specify one or the other:

 
          

 [bookmark: pgfId-642158] – Routing Type—Enter one Extension Header code; for example, 51 for Authentication Header.

 [bookmark: pgfId-642160] – Routing Type Field Range—Enter a starting value and an ending value to define a range of EH codes.

 
           
           		 [bookmark: pgfId-642162]Routing Header Address Count—The number of IP addresses embedded in the packet. When you choose this option, the following field appears; specify an upper bound for the number of addresses:

 
          

 [bookmark: pgfId-642164] – Greater Than Count—Enter a value between 0 and 255.

 [bookmark: pgfId-642166]The packet is considered a match if the address count is greater than the specified number; it is not a match if the count is equal to, or less than the specified number.

  
        

 
         
         		[bookmark: pgfId-642172]Type

  
         		[bookmark: pgfId-642174]Specifies that the map is applied only to traffic that matches the defined criteria.

  
        

 
         
         		[bookmark: pgfId-642180]Action

  
         		[bookmark: pgfId-642182]Choose the action you want the device to take for traffic that matches the defined criteria:

 
           
           		 [bookmark: pgfId-642184]Drop Packet—Matching packets are dropped without notification.

 
           		 [bookmark: pgfId-642186]Drop Packet and Log—Matching packets are logged and then dropped.

 
           		 [bookmark: pgfId-642188]Log—Matching packets are logged and processing continues.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-647673][bookmark: 50729][bookmark: pobjpage_cncpt_AddEditIPsecPassThrough]Configuring IPsec Pass Through Maps[bookmark: marker-647661][bookmark: marker-647663][bookmark: marker-647665][bookmark: marker-647667][bookmark: marker-647669][bookmark: marker-647671]

 
     [bookmark: pgfId-647675]Use the Add and Edit IPsec Pass Through Map dialog boxes to configure settings for the IPsec Pass Through Map policy object. An IPsec Pass Through policy map lets you change the default configuration values used for IPsec Pass Through inspection.

 
     [bookmark: pgfId-647677]The IPSec Pass Through inspection engine lets the security appliance pass ESP (IP protocol 50) and AH (IP protocol 51) traffic that is formed between two hosts because of successful IKE (UDP port 500) negotiation without the requirement of specific ESP or AH access lists.

 
     [bookmark: pgfId-647679]The ESP or AH traffic is permitted by the inspection engine with the configured idle timeout if there is an existing control flow and it is within the connection limit defined in the MPF framework. A new control flow is created for IKE UDP port 500 traffic with the configured UDP idle timeout if there is not one, or it uses the existing flow.

 
     [bookmark: pgfId-647681]To ensure that the packet arrives into the inspection engine, a hole is punched for all such traffic (ESP and AH). This inspect is attached to the control flow. The control flow is present as long as there is at least one data flow (ESP or AH) established, but the traffic always flows on the same connection. Because this IKE connection is kept open as long as data flows, a rekey would always succeed. The flows are created irrespective of whether NAT is being used. However, PAT is not supported.

 
     [bookmark: pgfId-647683]Navigation Path

 
     [bookmark: pgfId-647685]Select Manage > Policy Objects, then select Maps > Policy Maps > Inspect > IPsec Pass Through from the Object Type selector. Right-click inside the work area, then select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-647687]Related Topics

 
      
      		 [bookmark: pgfId-647692]Understanding Map Objects

 
      		 [bookmark: pgfId-647697]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-647699]Field Reference

 
     [bookmark: pgfId-647702] 

 
      
       
        
        [bookmark: pgfId-642201]Table 17-43 [bookmark: 50774]Add and Edit IPsec Pass Through Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-642207]Element
          
  
         		
           
           [bookmark: pgfId-642209]Description
          
  
        

 
         
         		[bookmark: pgfId-642215]Name

  
         		[bookmark: pgfId-642217]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-642223]Description

  
         		[bookmark: pgfId-642225]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-642231]Allow ESP

 [bookmark: pgfId-642233]Maximum ESP Tunnels per Client

 [bookmark: pgfId-642235]ESP Idle Timeout

  
         		[bookmark: pgfId-642237]Whether to allow ESP traffic. If you select this option, you can configure the maximum number of ESP tunnels that each client can have and the amount of time that an ESP tunnel can be idle before it is closed (in hours:minutes:seconds format). The default timeout is 10 minutes (00:10:00).

  
        

 
         
         		[bookmark: pgfId-642243]Allow AH

 [bookmark: pgfId-642245]Maximum AH Tunnels per Client

 [bookmark: pgfId-642247]AH Idle Timeout

  
         		[bookmark: pgfId-642249]Whether to allow AH traffic. If you select this option, you can configure the maximum number of AH tunnels that each client can have and the amount of time that an AH tunnel can be idle before it is closed (in hours:minutes:seconds format). The default timeout is 10 minutes (00:10:00).

  
        

 
         
         		[bookmark: pgfId-642255]Category

  
         		[bookmark: pgfId-642260]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-642266]Allow Value Override per Device

 [bookmark: pgfId-642268]Overrides

 [bookmark: pgfId-642270]Edit button

  
         		[bookmark: pgfId-642278]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-642280]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-647722][bookmark: 50827][bookmark: pobjpage_cncpt_AddEditNetBIOS]Configuring NetBIOS Maps [bookmark: marker-647710][bookmark: marker-647712][bookmark: marker-647714][bookmark: marker-647716][bookmark: marker-647718][bookmark: marker-647720]

 
     [bookmark: pgfId-647724]Use the Add or Edit NetBIOS Map dialog boxes to define maps for NetBIOS inspection. A NetBIOS policy map lets you change the default configuration values used for NetBIOS inspection.

 
     [bookmark: pgfId-647726]The NetBIOS inspection engine translates IP addresses in the NetBIOS name service (NBNS) packets according to the security appliance NAT configuration.

 
     [bookmark: pgfId-647728]Navigation Path

 
     [bookmark: pgfId-647730]Select Manage > Policy Objects, then select Maps > Policy Maps > Inspect > NetBIOS from the Object Type selector. Right-click inside the work area, then select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-647732]Related Topics

 
      
      		 [bookmark: pgfId-647737]Understanding Map Objects

 
      		 [bookmark: pgfId-647742]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-647744]Field Reference

 
     [bookmark: pgfId-647747] 

 
      
       
        
        [bookmark: pgfId-642293]Table 17-44 [bookmark: 50870]Add or Edit NetBIOS Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-642299]Element
          
  
         		
           
           [bookmark: pgfId-642301]Description
          
  
        

 
         
         		[bookmark: pgfId-642307]Name

  
         		[bookmark: pgfId-642309]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-642315]Description

  
         		[bookmark: pgfId-642317]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-642323]Check for Protocol Violation

 [bookmark: pgfId-642325]Action

  
         		[bookmark: pgfId-642327]Whether to check for NETBIOS protocol violations. If you select this option, select the action you want to take when violations occur.

  
        

 
         
         		[bookmark: pgfId-642333]Category

  
         		[bookmark: pgfId-642338]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-642344]Allow Value Override per Device

 [bookmark: pgfId-642346]Overrides

 [bookmark: pgfId-642348]Edit button

  
         		[bookmark: pgfId-642356]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-642358]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-647759][bookmark: 50915][bookmark: pobjpage_cncpt_AddEditScanSafe]Configuring ScanSafe Maps

 
     [bookmark: pgfId-647761]Use the Add or Edit ScanSafe Map dialog boxes to define maps for ScanSafe inspection. A ScanSafe policy map lets you change the default configuration values used for ScanSafe inspection.

 
     [bookmark: pgfId-647763]The fields on this dialog box change, depending upon whether you are creating a class map or a policy map.

 
     [bookmark: pgfId-647765]Navigation Path

 
     [bookmark: pgfId-647767]Select Manage > Policy Objects, then select Maps > Policy Maps > Inspect > ScanSafe from the Object Type selector. Right-click inside the work area, then select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-647769]Related Topics

 
      
      		 [bookmark: pgfId-647774]Understanding Map Objects

 
      		 [bookmark: pgfId-647779]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-647781]Field Reference

 
     [bookmark: pgfId-647784] 

 
      
       
        
        [bookmark: pgfId-642371]Table 17-45 [bookmark: 50941]ScanSafe Add Match Condition and Action Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-642377]Element
          
  
         		
           
           [bookmark: pgfId-642379]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-642385]Parameters
          
  
        

 
         
         		[bookmark: pgfId-642393]Transport Protocol

  
         		[bookmark: pgfId-642395]Allows you to select either HTTPS or HTTP.

 [bookmark: pgfId-642397]For HTTPS, the allowed range of values is 1-65535.

 [bookmark: pgfId-642399]For HTTP, the allowed range of values is 1-65535. The default value is 8080.

  
        

 
         
         		[bookmark: pgfId-642405]Default User Name

  
         		[bookmark: pgfId-642407]The default user name for the ScanSafe server

  
        

 
         
         		[bookmark: pgfId-642413]Default Group Name

  
         		[bookmark: pgfId-642415]The default group name for the ScanSafe server

  
        

 
         
         		[bookmark: pgfId-642421]Category

  
         		[bookmark: pgfId-642423]Allows you to select Cat-A through Cat-G.

 [bookmark: pgfId-642428]This is the category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-642434]Allow Value Override per Device

 [bookmark: pgfId-642436]Overrides

 [bookmark: pgfId-642438]Edit button

  
         		[bookmark: pgfId-642446]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-642448]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
         
         		 [bookmark: pgfId-642454]Match Condition and Action tab only

  
        

 
         
         		[bookmark: pgfId-642462]Class

  
         		[bookmark: pgfId-642464]The name of the class map

  
        

 
         
         		[bookmark: pgfId-642470]Action

  
         		[bookmark: pgfId-642472]Allows you to select the action you want to take when policy violations occur

  
        

 
         
         		[bookmark: pgfId-642478]+ [the "add" button]

  
         		[bookmark: pgfId-642480]Opens the Add Match Condition and Action dialog box. This dialog box has the following fields:

 
           
           		 [bookmark: pgfId-642482]Match Type

 
           		 [bookmark: pgfId-642484]Class Map

 
           		 [bookmark: pgfId-642486]Action

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-647806][bookmark: 51020][bookmark: pobjpage_cncpt_AddandEditSIPMapDialogBoxes]Configuring SIP Maps[bookmark: marker-647794][bookmark: marker-647796][bookmark: marker-647798][bookmark: marker-647800][bookmark: marker-647802][bookmark: marker-647804]

 
     [bookmark: pgfId-647808]Use the Add and Edit SIP Map dialog boxes to configure values used for SIP application inspection. A SIP inspection map lets you change the default configuration values used for SIP application inspection.

 
     [bookmark: pgfId-647810]SIP is a widely used protocol for Internet conferencing, telephony, presence, events notification, and instant messaging. Partially because of its text-based nature and partially because of its flexibility, SIP networks are subject to a large number of security threats.

 
     [bookmark: pgfId-647812]SIP application inspection provides address translation in message header and body, dynamic opening of ports and basic sanity checks. It also supports application security and protocol conformance, which enforce the sanity of the SIP messages, as well as detect SIP-based attacks.

 
     [bookmark: pgfId-647814]Navigation Path

 
     [bookmark: pgfId-647816]Select Manage > Policy Objects, then select Maps > Policy Maps > Inspect > SIP (ASA/PIX/FWSM) from the Object Type selector. Right-click inside the work area, then select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-647818]Related Topics

 
      
      		 [bookmark: pgfId-647823]Understanding Map Objects

 
      		 [bookmark: pgfId-647828]Configuring Protocols and Maps for Inspection

 
      		 [bookmark: pgfId-647833]Configuring Class Maps for Inspection Policies

 
     

 
     [bookmark: pgfId-647835]Field Reference

 
     [bookmark: pgfId-647838] 

 
      
       
        
        [bookmark: pgfId-642499]Table 17-46 [bookmark: 51068]Add and Edit SIP Map Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-642505]Element
          
  
         		
           
           [bookmark: pgfId-642507]Description
          
  
        

 
         
         		[bookmark: pgfId-642513]Name

  
         		[bookmark: pgfId-642515]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-642521]Description

  
         		[bookmark: pgfId-642523]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		 
           
           [bookmark: pgfId-642529]Parameters tab
          
  
        

 
         
         		[bookmark: pgfId-642537]Enable SIP Instant Messaging Extensions

  
         		[bookmark: pgfId-642539]Whether to enable Instant Messaging extensions.

  
        

 
         
         		[bookmark: pgfId-642545]Permit Non-SIP Traffic on SIP Port

  
         		[bookmark: pgfId-642547]Whether to permit non-SIP traffic on the SIP port.

  
        

 
         
         		[bookmark: pgfId-642553]Hide Server’s and Endpoint’s IP Address

  
         		[bookmark: pgfId-642555]Whether to hide the IP addresses, which enables IP address privacy.

  
        

 
         
         		[bookmark: pgfId-642561]Check RTP Packets for Protocol Conformance

 [bookmark: pgfId-642563]Limit Payload to Audio or Video based on the Signaling Exchange

  
         		[bookmark: pgfId-642565]Whether to check RTP/RTCP packets flowing on the pinholes for protocol conformance. If you select this option, you can also elect to enforce the payload type to be audio/video based on the signaling exchange.

  
        

 
         
         		[bookmark: pgfId-642571]If Number of Hops to Destination is Greater Than 0

  
         		[bookmark: pgfId-642573]Whether to check if the value of Max-Forwards header is zero. When it is greater than zero, the action you select in the Action field is implemented. The default is to drop the packet.

  
        

 
         
         		[bookmark: pgfId-642579]If State Transition is Detected

  
         		[bookmark: pgfId-642581]Whether to check SIP state transitions. When a transition is detected, the action you select in the Action field is implemented. The default is to drop the packet.

  
        

 
         
         		[bookmark: pgfId-642587]If Header Fields Fail Strict Validation

  
         		[bookmark: pgfId-642589]Whether to take the action specified in the Action field if the SIP header fields are invalid. The default is to drop the packet.

  
        

 
         
         		[bookmark: pgfId-642595]Inspect Server’s and Endpoint’s Software Version

  
         		[bookmark: pgfId-642597]Whether to inspect the SIP endpoint software version in User-Agent and Server headers. The default is to mask the information.

  
        

 
         
         		[bookmark: pgfId-642603]If Non-SIP URI is Detected

  
         		[bookmark: pgfId-642605]Whether to take the action specified in the Action field if a non-SIP URI is detected in the Alert-Info and Call-Info headers. The default is to mask the information.

  
        

 
         
         		 [bookmark: pgfId-642611]Match Condition and Action Tab

 [bookmark: pgfId-642613]The Match All table lists the criteria included in the policy map. Each row indicates whether the inspection is looking for traffic that matches or does not match each criterion, the criterion and value that is inspected, and the action to be taken for traffic that satisfies the conditions.

 
           
           		 [bookmark: pgfId-642618]To add a criterion, click the Add button and fill in the Match Condition and Action dialog box (see SIP Class and Policy Maps Add or Edit Match Condition (and Action) Dialog Boxes).

 
           		 [bookmark: pgfId-642620]To edit a criterion, select it and click the Edit button.

 
           		 [bookmark: pgfId-642622]To delete a criterion, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-642630]Category

  
         		[bookmark: pgfId-642635]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-642641]Allow Value Override per Device

 [bookmark: pgfId-642643]Overrides

 [bookmark: pgfId-642645]Edit button

  
         		[bookmark: pgfId-642653]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-642655]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-647894][bookmark: 51171][bookmark: pobjpage_cncpt_SIPClassandPolicyMapsAddorEditMatchConditionandActionDialogBoxes]SIP Class and Policy Maps Add or Edit Match Condition (and Action) Dialog Boxes [bookmark: marker-647882][bookmark: marker-647884][bookmark: marker-647886][bookmark: marker-647888][bookmark: marker-647890][bookmark: marker-647892]

 
     [bookmark: pgfId-647896]Use the Add or Edit SIP Match Criterion (for SIP class maps) or Match Condition and Action (for SIP policy maps) dialog boxes to do the following:

 
      
      		 [bookmark: pgfId-647898]Define the match criterion and value for a SIP class map.

 
      		 [bookmark: pgfId-647900]Select a SIP class map when creating a SIP policy map.

 
      		 [bookmark: pgfId-647902]Define the match criterion, value, and action directly in a SIP policy map.

 
     

 
     [bookmark: pgfId-647904]The fields on this dialog box change based on the criterion you select and whether you are creating a class map or policy map.

 
     [bookmark: pgfId-647906]Navigation Path

 
     [bookmark: pgfId-647911]When creating a SIP class map, in the Policy Object Manager, from the Add or Edit Class Maps dialog boxes for SIP, right-click inside the table, then select Add Row or right-click a row, then select Edit Row. See Configuring Class Maps for Inspection Policies.

 
     [bookmark: pgfId-647916]When creating a SIP policy map, in the Policy Object Manager, from the Match Condition and Action tab on the Add and Edit SIP Map dialog boxes, right-click inside the table, then select Add Row or right-click a row, then select Edit Row. See Configuring SIP Maps.

 
     [bookmark: pgfId-647918]Related Topics

 
      
      		 [bookmark: pgfId-647923]Understanding Map Objects

 
      		 [bookmark: pgfId-647928]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-647930]Field Reference

 
     [bookmark: pgfId-647933] 

 
      
       
        
        [bookmark: pgfId-642668]Table 17-47 [bookmark: 51241]SIP Class and Policy Maps Add and Edit Match Condition and Action Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-642674]Element
          
  
         		
           
           [bookmark: pgfId-642676]Description
          
  
        

 
         
         		[bookmark: pgfId-642682]Match Type

 [bookmark: pgfId-642684]Class Name

 [bookmark: pgfId-642686](Policy Map only)

  
         		[bookmark: pgfId-642688]Enables you to use an existing SIP class map or define a new SIP class map.

 
           
           		 [bookmark: pgfId-642690]Use Specified Values—You want to define the class map on this dialog box.

 
           		 [bookmark: pgfId-642692]Use Values in Class Map—You want to select an existing SIP class map policy object. Enter the name of the SIP class map in the  Class Name field. Click  Select to select the map from a list or to create a new class map object.

 
          

  
        

 
         
         		[bookmark: pgfId-642698]Criterion

  
         		[bookmark: pgfId-642700]Specifies which criterion of SIP traffic to match.

 
           
           		 [bookmark: pgfId-642702]Called Party—Matches the called party as specified in the To header.

 
           		 [bookmark: pgfId-642704]Calling Party—Matches the calling party as specified in the From header.

 
           		 [bookmark: pgfId-642706]Content Length—Matches the Content Length header.

 
           		 [bookmark: pgfId-642708]Content Type—Matches the Content Type header.

 
           		 [bookmark: pgfId-642710]IM Subscriber—Matches the SIP Instant Messenger subscriber.

 
           		 [bookmark: pgfId-642712]Message Path—Matches the SIP Via header.

 
           		 [bookmark: pgfId-642714]Third Party Registration—Matches the requester of a third-party registration.

 
           		 [bookmark: pgfId-642716]URI Length—Matches a URI in the SIP headers.

 
           		 [bookmark: pgfId-642718]Request Method—Matches the SIP request method.

 
          

  
        

 
         
         		[bookmark: pgfId-642724]Type

  
         		[bookmark: pgfId-642726]Specifies whether the map includes traffic that matches or does not match the criterion. For example, if Doesn’t Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the map.

 
           
           		 [bookmark: pgfId-642728]Matches—Matches the criterion.

 
           		 [bookmark: pgfId-642730]Doesn’t Match—Does not match the criterion.

 
          

  
        

 
         
         		[bookmark: pgfId-642736]Action

 [bookmark: pgfId-642738](Policy Map only)

  
         		[bookmark: pgfId-642740]The action you want the device to take for traffic that matches the defined criteria.

  
        

 
         
         		 [bookmark: pgfId-642746]Variable Fields

 [bookmark: pgfId-642748]The following fields vary based on what you select in the Criterion field. This list is a super-set of the fields you might see.

  
        

 
         
         		[bookmark: pgfId-642756]Value

  
         		[bookmark: pgfId-642758]The regular expression you want to evaluate. You can select one of the following:

 
           
           		 [bookmark: pgfId-642760]Regular Expression—The regular expression object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click  Select to choose the object from a list of existing ones or to create a new regular expression object.

 
           		 [bookmark: pgfId-642762]Regular Expression Group—The regular expression group object that defines the regular expression you want to use for pattern matching. Enter the name of the object. You can click  Select to choose the object from a list of existing ones or to create a new regular expression group object.

 
          

  
        

 
         
         		[bookmark: pgfId-642768]URI Type

  
         		[bookmark: pgfId-642770]The type of URI to match, either SIP or TEL.

  
        

 
         
         		[bookmark: pgfId-642776]Greater Than Length

  
         		[bookmark: pgfId-642778]The length in bytes of the evaluated field. The criterion matches if the length is greater than the specified number, and does not match if the field is less than the specified number.

  
        

 
         
         		[bookmark: pgfId-642784]Content Type

  
         		[bookmark: pgfId-642786]The content type to evaluate as specified in the content-type header field. You can select one of the following:

 
           
           		 [bookmark: pgfId-642788]SDP—Matches an SDP SIP content header type.

 
           		 [bookmark: pgfId-642790]Regular Expression, Regular Expression Group—The regular expression or regular expression group to evaluate. See the explanation for the Value field for an explanation of these options.

 
          

  
        

 
         
         		[bookmark: pgfId-642796]Resource Method

  
         		[bookmark: pgfId-642798]The request method you want to inspect:

 
           
           		 [bookmark: pgfId-642800]ack—Confirms that the client has received a final response to an INVITE request.

 
           		 [bookmark: pgfId-642802]bye—Terminates a call and can be sent by either the caller or the called party.

 
           		 [bookmark: pgfId-642804]cancel—Cancels any pending searches but does not terminate a call that has already been accepted.

 
           		 [bookmark: pgfId-642806]info—Communicates mid-session signaling information along the signaling path for the call.

 
           		 [bookmark: pgfId-642808]invite—Indicates a user or service is being invited to participate in a call session.

 
           		 [bookmark: pgfId-642810]message—Sends instant messages where each message is independent of any other message.

 
           		 [bookmark: pgfId-642812]notify—Notifies a SIP node that an event which has been requested by an earlier SUBSCRIBE method has occurred.

 
           		 [bookmark: pgfId-642814]options—Queries the capabilities of servers.

 
           		 [bookmark: pgfId-642816]prack—Provisional response acknowledgment.

 
           		 [bookmark: pgfId-642818]refer—Requests that the recipient REFER to a resource provided in the request.

 
           		 [bookmark: pgfId-642820]register—Registers the address listed in the To header field with a SIP server.

 
           		 [bookmark: pgfId-642822]subscribe—Requests notification of an event or set of events at a later time.

 
           		 [bookmark: pgfId-642824]unknown—Uses a nonstandard extension that could have unknown security impacts on the network.

 
           		 [bookmark: pgfId-642826]update—Permits a client to update parameters of a session but has no impact on the state of a dialog.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-647955][bookmark: 51379][bookmark: pobjpage_cncpt_AddorEditSkinnyMapDialogBoxes]Configuring Skinny Maps[bookmark: marker-647943][bookmark: marker-647945][bookmark: marker-647947][bookmark: marker-647949][bookmark: marker-647951][bookmark: marker-647953]

 
     [bookmark: pgfId-647957]Use the Add or Edit Skinny Map dialog boxes to define Skinny maps for Skinny inspection. A Skinny policy map lets you change the default configuration values used for Skinny inspection.

 
     [bookmark: pgfId-647959]Skinny (SCCP) is a simplified protocol used in VoIP networks. Cisco IP Phones using SCCP can coexist in an H.323 environment. When used with Cisco CallManager, the SCCP client can interoperate with H.323 compliant terminals. Application layer functions in the security appliance recognize SCCP version 3.3. There are 5 versions of the SCCP protocol: 2.4, 3.0.4, 3.1.1, 3.2, and 3.3.2.

 
     [bookmark: pgfId-647961]The security appliance supports all versions through 3.3.2. The security appliance supports PAT and NAT for SCCP. PAT is necessary if you have more IP phones than global IP addresses for the IP phones to use. By supporting NAT and PAT of SCCP Signaling packets, Skinny application inspection ensures that all SCCP signaling and media packets can traverse the security appliance.

 
     [bookmark: pgfId-647963]Normal traffic between Cisco CallManager and Cisco IP Phones uses SCCP and is handled by SCCP inspection without any special configuration. The security appliance also supports DHCP options 150 and 66, which it accomplishes by sending the location of a TFTP server to Cisco IP Phones and other DHCP clients. Cisco IP Phones might also include DHCP option 3 in their requests, which sets the default route.

 
     [bookmark: pgfId-647965]Navigation Path

 
     [bookmark: pgfId-647967]Select Manage > Policy Objects, then select Maps > Policy Maps > Inspect > Skinny from the Object Type selector. Right-click inside the work area, then select New Object or right-click a row, then select Edit Object.

 
     [bookmark: pgfId-647969]Related Topics

 
      
      		 [bookmark: pgfId-647974]Understanding Map Objects

 
      		 [bookmark: pgfId-647979]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-647981]Field Reference

 
     [bookmark: pgfId-647984] 

 
      
       
        
        [bookmark: pgfId-642839]Table 17-48 [bookmark: 51425]Add and Edit Skinny Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-642845]Element
          
  
         		
           
           [bookmark: pgfId-642847]Description
          
  
        

 
         
         		[bookmark: pgfId-642853]Name

  
         		[bookmark: pgfId-642855]The name of the Skinny map. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-642861]Description

  
         		[bookmark: pgfId-642863]A description of the Skinny map, up to 200 characters.

  
        

 
         
         		 
           
           [bookmark: pgfId-642869]Parameters Tab
          
  
        

 
         
         		[bookmark: pgfId-642877]Enforce Endpoint Registration

  
         		[bookmark: pgfId-642879]Whether to enforce registration before calls can be placed.

  
        

 
         
         		[bookmark: pgfId-642885]Maximum SCCP Station Message ID 0x

  
         		[bookmark: pgfId-642887]The maximum SCCP station message ID allowed, in hexadecimal.

  
        

 
         
         		[bookmark: pgfId-642893]Check RTP Packets for Protocol Conformance

 [bookmark: pgfId-642895]Enforce Payload Type to be Audio or Video based on Signaling Exchange

  
         		[bookmark: pgfId-642897]Whether to check RTP packets flowing through the pinholes for protocol conformance. If you select this option, you can also select whether to enforce the payload type.

  
        

 
         
         		[bookmark: pgfId-642903]Minimum SCCP Prefix Length

  
         		[bookmark: pgfId-642905]The minimum SCCP length allowed.

  
        

 
         
         		[bookmark: pgfId-642911]Maximum SCCP Prefix Length

  
         		[bookmark: pgfId-642913]The maximum SCCP length allowed.

  
        

 
         
         		[bookmark: pgfId-642919]Media Timeout

  
         		[bookmark: pgfId-642921]The timeout value for media connections.

  
        

 
         
         		[bookmark: pgfId-642927]Signaling Timeout

  
         		[bookmark: pgfId-642929]The timeout value for signaling connections.

  
        

 
         
         		 [bookmark: pgfId-642935]Match Condition and Action Tab

 [bookmark: pgfId-642937]The Match All table lists the criteria included in the policy map. Each row indicates whether the inspection is looking for traffic that matches or does not match each criterion, the criterion and value that is inspected, and the action to be taken for traffic that satisfies the conditions.

 
           
           		 [bookmark: pgfId-642942]To add a criterion, click the Add button and fill in the Match Condition and Action dialog box (see Skinny Policy Maps Add or Edit Match Condition and Action Dialog Boxes).

 
           		 [bookmark: pgfId-642944]To edit a criterion, select it and click the Edit button.

 
           		 [bookmark: pgfId-642946]To delete a criterion, select it and click the Delete button.

 
          

  
        

 
         
         		[bookmark: pgfId-642954]Category

  
         		[bookmark: pgfId-642959]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-642965]Allow Value Override per Device

 [bookmark: pgfId-642967]Overrides

 [bookmark: pgfId-642969]Edit button

  
         		[bookmark: pgfId-642977]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-642979]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-647998][bookmark: 51518][bookmark: pobjpage_cncpt_AddEditMatchConditionandAction]Skinny Policy Maps Add or Edit Match Condition and Action Dialog Boxes [bookmark: marker-647992][bookmark: marker-647994][bookmark: marker-647996]

 
     [bookmark: pgfId-648000]Use the Add or Edit Match Condition and Action dialog boxes to define the match criterion, value, and action for a Skinny policy map.

 
     [bookmark: pgfId-648002]Navigation Path

 
     [bookmark: pgfId-648007]In the Policy Object Manager, from the Match Condition and Action tab on the Add or Edit Skinny Map dialog boxes, right-click inside the table, then select Add Row or right-click a row, then select Edit Row. See Configuring SIP Maps.

 
     [bookmark: pgfId-648009]Related Topics

 
      
      		 [bookmark: pgfId-648014]Understanding Map Objects

 
      		 [bookmark: pgfId-648019]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-648021]Field Reference

 
     [bookmark: pgfId-648024] 

 
      
       
        
        [bookmark: pgfId-642992]Table 17-49 [bookmark: 51549]Skinny Policy Maps Add and Edit Match Condition and Action Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-642998]Element
          
  
         		
           
           [bookmark: pgfId-643000]Description
          
  
        

 
         
         		[bookmark: pgfId-643006]Criterion

  
         		[bookmark: pgfId-643008]Specifies which criterion of Skinny traffic to match.

  
        

 
         
         		[bookmark: pgfId-643014]Type

  
         		[bookmark: pgfId-643016]Specifies whether the map includes traffic that matches or does not match the criterion. For example, if Doesn’t Match is selected on 0xFFFF, then any traffic that has the message ID 0xFFFF is excluded from the map.

 
           
           		 [bookmark: pgfId-643018]Matches—Matches the criterion.

 
           		 [bookmark: pgfId-643020]Doesn’t Match—Does not match the criterion.

 
          

  
        

 
         
         		[bookmark: pgfId-643026]ID Type

  
         		[bookmark: pgfId-643028]The hexadecimal value for the message ID to inspect:

 
           
           		 [bookmark: pgfId-643030]Value—Matches a single hexadecimal value.

 
           		 [bookmark: pgfId-643032]Range—Matches a range of values.

 
          

  
        

 
         
         		[bookmark: pgfId-643038]Action

  
         		[bookmark: pgfId-643040]The action you want the device to take for traffic that matches the defined criteria.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-648044][bookmark: 51591][bookmark: pobjpage_cncpt_AddEditSNMPMap]Configuring SNMP Maps[bookmark: marker-648032][bookmark: marker-648034][bookmark: marker-648036][bookmark: marker-648038][bookmark: marker-648040][bookmark: marker-648042]

 
     [bookmark: pgfId-648046]Use the Add and Edit SNMP Map dialog boxes to define maps for SNMP inspection. An SNMP policy map lets you change the default configuration values used for SNMP application inspection.

 
     [bookmark: pgfId-648048]SNMP application inspection lets you restrict SNMP traffic to a specific version of SNMP. Earlier versions of SNMP are less secure; therefore, denying certain SNMP versions may be required by your security policy. The security appliance can deny SNMP versions 1, 2, 2c, or 3. You control the versions permitted by creating an SNMP map. You then apply the SNMP map when you enable SNMP inspection.

 
     [bookmark: pgfId-648050]Navigation Path

 
     [bookmark: pgfId-648052]Select Manage > Policy Objects, then select Maps > Policy Maps > Inspect > SNMP from the Object Type selector. Right-click inside the work area, then select New Object, or right-click a row and select Edit Object.

 
     [bookmark: pgfId-648054]Related Topics

 
      
      		 [bookmark: pgfId-648059]Understanding Map Objects

 
      		 [bookmark: pgfId-648064]Configuring Protocols and Maps for Inspection

 
     

 
     [bookmark: pgfId-648066]Field Reference

 
     [bookmark: pgfId-648069] 

 
      
       
        
        [bookmark: pgfId-643053]Table 17-50 [bookmark: 51634]Add and Edit SNNP Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-643059]Element
          
  
         		
           
           [bookmark: pgfId-643061]Description
          
  
        

 
         
         		[bookmark: pgfId-643067]Name

  
         		[bookmark: pgfId-643069]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-643075]Description

  
         		[bookmark: pgfId-643077]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-643083]Disallowed SNMP Versions

  
         		[bookmark: pgfId-643085]The versions of SNMP you want to prohibit.

 
           
           		 [bookmark: pgfId-643087]SNMP Version 1

 
           		 [bookmark: pgfId-643089]SNMP Version 2c (Community Based)

 
           		 [bookmark: pgfId-643091]SNMP Version 2 (Party Based)

 
           		 [bookmark: pgfId-643093]SNMP Version 3

 
          

  
        

 
         
         		[bookmark: pgfId-643099]Category

  
         		[bookmark: pgfId-643104]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-643110]Allow Value Override per Device

 [bookmark: pgfId-643112]Overrides

 [bookmark: pgfId-643114]Edit button

  
         		[bookmark: pgfId-643122]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-643124]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-648089][bookmark: 51687][bookmark: pobjpage_cncpt_AddandEditRegularExpressionGroupDialogBoxes]Configuring Regular Expression Groups[bookmark: marker-648077][bookmark: marker-648079][bookmark: marker-648081][bookmark: marker-648083][bookmark: marker-648085][bookmark: marker-648087]

 
     [bookmark: pgfId-648091]Use the Add and Edit Regular Expression Groups dialog boxes to define regular expression groups, which contain multiple regular expressions. Groups make it possible for you to create modular regular expressions and group them in multiple ways for various uses. The objects can be used in some inspection class maps and inspection policy maps.

 
     [bookmark: pgfId-648093]Navigation Path

 
     [bookmark: pgfId-648095]Select Manage > Policy Objects, then select Maps > Regular Expressions Groups from the Object Type selector. Right-click inside the work area, then select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-648097]Related Topics

 
      
      		 [bookmark: pgfId-648102]Understanding Map Objects

 
      		 [bookmark: pgfId-648107]Configuring Protocols and Maps for Inspection

 
      		 [bookmark: pgfId-648112]Creating Policy Objects

 
     

 
     [bookmark: pgfId-648114]Field Reference

 
     [bookmark: pgfId-648117] 

 
      
       
        
        [bookmark: pgfId-643137]Table 17-51 [bookmark: 51732]Add and Edit Regular Expression Class Map Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-643143]Element
          
  
         		
           
           [bookmark: pgfId-643145]Description
          
  
        

 
         
         		[bookmark: pgfId-643151]Name

  
         		[bookmark: pgfId-643153]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-643159]Description

  
         		[bookmark: pgfId-643161]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-643167]Regular Expressions

  
         		[bookmark: pgfId-643169]The Regular Expression policy objects that include the expressions you want to include in the group. Enter the name of the objects or click Select to select them from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-643175]Category

  
         		[bookmark: pgfId-643180]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-643186]Allow Value Override per Device

 [bookmark: pgfId-643188]Overrides

 [bookmark: pgfId-643190]Edit button

  
         		[bookmark: pgfId-643198]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-643200]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-648137][bookmark: 51777][bookmark: pobjpage_cncpt_AddandEditRegularExpressionDialogBoxes]Add/Edit Regular Expressions [bookmark: marker-648125][bookmark: marker-648127][bookmark: marker-648129][bookmark: marker-648131][bookmark: marker-648133][bookmark: marker-648135]

 
     [bookmark: pgfId-648139]Use the Add and Edit Regular Expression dialog boxes to define regular expressions for use in class and policy inspection maps or in regular expression group policy objects. Regular expressions are also used in remote access SSL VPN client settings.

 
     [bookmark: pgfId-648141]A regular expression matches text strings either literally as an exact string or by using metacharacters so you can match multiple variants of a text string. You can use regular expressions in various type of class and policy inspection maps to match various target items, for example, the content of certain application traffic such as the body text inside an HTTP packet.

 
     [bookmark: pgfId-648143]Navigation Path

 
      
      		 [bookmark: pgfId-648145]Select  Manage > Policy Objects , then select  Maps > Regular Expressions from the Object Type selector. Right-click inside the work area, then select  New Object or right-click a row and select  Edit Object .

 
      		 [bookmark: pgfId-648150]From the Client Settings tab of the SSL VPN Other Settings policy for ASA devices, click the  Add Row button for the AnyConnect Client Image table, or select an image and click the  Edit Row button. For detailed information on opening the tab, see Configuring SSL VPN AnyConnect Client Settings (ASA). On the Add AnyConnect Client Image dialog box, click  Select to open the Regular Expressions Selector dialog box. To add a new regular expression, click the  Add (+) button on the Regular Expressions Selector dialog box.

 
     

 
     [bookmark: pgfId-648152]Related Topics

 
      
      		 [bookmark: pgfId-648157]Understanding Map Objects

 
      		 [bookmark: pgfId-648162]Configuring Protocols and Maps for Inspection

 
      		 [bookmark: pgfId-648167]Creating Policy Objects

 
     

 
     [bookmark: pgfId-648169]Field Reference

 
     [bookmark: pgfId-648172] 

 
      
       
        
        [bookmark: pgfId-643213]Table 17-52 [bookmark: 51833]Add and Edit Regular Expression Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-643219]Element
          
  
         		
           
           [bookmark: pgfId-643221]Description
          
  
        

 
         
         		[bookmark: pgfId-643227]Name

  
         		[bookmark: pgfId-643229]The name of the policy object. A maximum of 40 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-643235]Description

  
         		[bookmark: pgfId-643237]A description of the policy object. A maximum of 200 characters is allowed.

  
        

 
         
         		[bookmark: pgfId-643243]Value

  
         		[bookmark: pgfId-643248]The regular expression, up to 100 characters in length. For information on the metacharacters you can use to build regular expressions, see Metacharacters Used to Build Regular Expressions.

  
        

 
         
         		[bookmark: pgfId-643254]Category

  
         		[bookmark: pgfId-643259]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-643265]Allow Value Override per Device

 [bookmark: pgfId-643267]Overrides

 [bookmark: pgfId-643269]Edit button

  
         		[bookmark: pgfId-643277]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-643279]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-648186][bookmark: 51877][bookmark: obman_cncpt_MetacharactersUsedtoBuildRegularExpressions]Metacharacters Used to Build Regular Expressions[bookmark: marker-648178][bookmark: marker-648180][bookmark: marker-648182][bookmark: marker-648184]

 
     [bookmark: pgfId-648191]The following table explains the metacharacters you can use to build regular expressions in the Add and Edit Regular Expression dialog boxes (see Add/Edit Regular Expressions).

 
     [bookmark: pgfId-648193]Keep the following tips in mind when creating regular expressions:

 
      
      		 [bookmark: pgfId-648195]If you enter any metacharacters in your text string that you want to be used literally, add the backslash (\) escape character before them. For example, “example\.com”.

 
      		 [bookmark: pgfId-648197]If you want to match upper and lower case characters, enter text in both upper- and lowercase. For example, “cats” is entered as “[cC][aA][tT][sS]”.

 
     

 
     [bookmark: pgfId-648200] 

 
      
       
        
        [bookmark: pgfId-643294]Table 17-53 [bookmark: 51904]Metacharacters Used to Build Regular Expressions 

 
        
       
         
         		
           
           [bookmark: pgfId-643302]Character
          
  
         		
           
           [bookmark: pgfId-643304]Description
          
  
         		
           
           [bookmark: pgfId-643306]Notes
          
  
        

 
         
         		[bookmark: pgfId-643314].

  
         		[bookmark: pgfId-643316]Dot

  
         		[bookmark: pgfId-643318]Matches any single character. For example, d.g matches dog, dag, dtg, and any word that contains those characters, such as doggonnit.

  
        

 
         
         		[bookmark: pgfId-643326](exp)

  
         		[bookmark: pgfId-643328]Subexpression

  
         		[bookmark: pgfId-643330]A subexpression segregates characters from surrounding characters, so that you can use other metacharacters on the subexpression. For example, d(o|a)g matches dog and dag, but do|ag matches do and ag. A subexpression can also be used with repeat quantifiers to differentiate the characters meant for repetition. For example, ab(xy){3}z matches abxyxyxyz.

  
        

 
         
         		[bookmark: pgfId-643338]|

  
         		[bookmark: pgfId-643340]Alternation

  
         		[bookmark: pgfId-643342]Matches either expression it separates. For example, dog|cat matches dog or cat.

  
        

 
         
         		[bookmark: pgfId-643350]?

  
         		[bookmark: pgfId-643352]Question mark

  
         		[bookmark: pgfId-643354]A quantifier that indicates that there are 0 or 1 of the previous expression. For example, lo?se matches lse or lose.

  
        

 
         
         		[bookmark: pgfId-643362]*

  
         		[bookmark: pgfId-643364]Asterisk

  
         		[bookmark: pgfId-643366]A quantifier that indicates that there are 0, 1 or any number of the previous expression. For example, lo*se matches lse, lose, loose, etc.

  
        

 
         
         		[bookmark: pgfId-643374]+

  
         		[bookmark: pgfId-643376]Plus

  
         		[bookmark: pgfId-643378]A quantifier that indicates that there is at least 1 of the previous expression. For example, lo+se matches lose and loose, but not lse.

  
        

 
         
         		[bookmark: pgfId-643386]{x}

  
         		[bookmark: pgfId-643388]Repeat Quantifier

  
         		[bookmark: pgfId-643390]Repeat exactly x times. For example, ab(xy){3}z matches abxyxyxyz.

  
        

 
         
         		[bookmark: pgfId-643398] 

  
         		[bookmark: pgfId-643400]Minimum repeat quantifier

  
         		[bookmark: pgfId-643402]Repeat at least x times. For example, ab(xy){2,}z matches abxyxyz, abxyxyxyz, etc.

  
        

 
         
         		[bookmark: pgfId-643410][abc]

  
         		[bookmark: pgfId-643412]Character class

  
         		[bookmark: pgfId-643414]Matches any character in the brackets. For example, [abc] matches a, b, or c.

  
        

 
         
         		[bookmark: pgfId-643422][^abc]

  
         		[bookmark: pgfId-643424]Negated character class

  
         		[bookmark: pgfId-643426]Matches a single character that is not contained within the brackets. For example, [^abc] matches any character other than a, b, or c. [^A-Z] matches any single character that is not an uppercase letter.

  
        

 
         
         		[bookmark: pgfId-643434][a-c]

  
         		[bookmark: pgfId-643436]Character range class

  
         		[bookmark: pgfId-643438]Matches any character in the range. [a-z] matches any lowercase letter. You can mix characters and ranges: [abcq-z] matches a, b, c, q, r, s, t, u, v, w, x, y, z, and so does [a-cq-z].

 [bookmark: pgfId-643440]The dash (-) character is literal only if it is the last or the first character within the brackets: [abc-] or [-abc].

  
        

 
         
         		[bookmark: pgfId-643448]“”

  
         		[bookmark: pgfId-643450]Quotation marks

  
         		[bookmark: pgfId-643452]Preserves trailing or leading spaces in the string. For example, “ test” preserves the leading space when it looks for a match.

  
        

 
         
         		[bookmark: pgfId-643460]^

  
         		[bookmark: pgfId-643462]Caret

  
         		[bookmark: pgfId-643464]Specifies the beginning of a line.

  
        

 
         
         		[bookmark: pgfId-643472]\

  
         		[bookmark: pgfId-643474]Escape character

  
         		[bookmark: pgfId-643476]When used with a metacharacter, matches a literal character. For example, \[ matches the left square bracket.

  
        

 
         
         		[bookmark: pgfId-643484]char

  
         		[bookmark: pgfId-643486]Character

  
         		[bookmark: pgfId-643488]When character is not a metacharacter, matches the literal character.

  
        

 
         
         		[bookmark: pgfId-643496]\r

  
         		[bookmark: pgfId-643498]Carriage return

  
         		[bookmark: pgfId-643500]Matches a carriage return 0x0d.

  
        

 
         
         		[bookmark: pgfId-643508]\n

  
         		[bookmark: pgfId-643510]Newline

  
         		[bookmark: pgfId-643512]Matches a new line 0x0a.

  
        

 
         
         		[bookmark: pgfId-643520]\t

  
         		[bookmark: pgfId-643522]Tab

  
         		[bookmark: pgfId-643524]Matches a tab 0x09.

  
        

 
         
         		[bookmark: pgfId-643532]\f

  
         		[bookmark: pgfId-643534]Formfeed

  
         		[bookmark: pgfId-643536]Matches a form feed 0x0c.

  
        

 
         
         		[bookmark: pgfId-643544]\xNN

  
         		[bookmark: pgfId-643546]Escaped hexadecimal number

  
         		[bookmark: pgfId-643548]Matches an ASCII character using hexadecimal (exactly two digits).

  
        

 
         
         		[bookmark: pgfId-643556]\NNN

  
         		[bookmark: pgfId-643558]Escaped octal number

  
         		[bookmark: pgfId-643560]Matches an ASCII character as octal (exactly three digits). For example, the character 040 represents a space.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-648218][bookmark: 52068][bookmark: porules_proc_ConfiguringSettingsforInspectionRules]Configuring Settings for Inspection Rules for IOS Devices[bookmark: marker-648208][bookmark: marker-648210][bookmark: marker-648212][bookmark: marker-648214][bookmark: marker-648216]

 
    [bookmark: pgfId-648220]If you configure inspection rules, you can also configure inspection settings to change the default settings for some global inspection parameters for IOS devices. Most of the inspection settings relate to preventing or mitigating Denial of Service (DoS) attacks. The default settings for most of these options are appropriate for most networks, so configure this policy only if you need to adjust one or more settings. If you do not change a setting, it is not configured on the device (the default remains configured).

 
    [bookmark: pgfId-648222]To open the Inspection settings page, do one of the following:

 
     
     		 [bookmark: pgfId-648224](Device view) Select a device, then select  Firewall > Settings > Inspection from the Policy selector.

 
     		 [bookmark: pgfId-648226](Policy view) Select  Firewall > Settings > Inspection from the Policy Type selector. Create a new policy or select an existing one.

 
     		 [bookmark: pgfId-648228](Map view) Right-click a device and select  Edit Firewall Settings > Inspection .

 
    

 
    [bookmark: pgfId-648230]The following table explains the available inspection settings.

 
    [bookmark: pgfId-648233] 

 
     
      
       
       [bookmark: pgfId-643573]Table 17-54 [bookmark: 52101]Inspection Page 

 
       
      
        
        		
          
          [bookmark: pgfId-643579]Element
         
  
        		
          
          [bookmark: pgfId-643581]Description
         
  
       

 
        
        		 
          
          [bookmark: pgfId-643587]Global Timeout Values
         
  
       

 
        
        		[bookmark: pgfId-643595]TCP Establish Timeout (seconds)

  
        		[bookmark: pgfId-643597]How long to wait for a TCP session to reach the established state before dropping the session, in seconds, from 1-2147483. The default is 30.

  
       

 
        
        		[bookmark: pgfId-643603]FIN Wait Time (seconds)

  
        		[bookmark: pgfId-643605]How long to maintain TCP session state information after the firewall detects a FIN-exchange, in seconds, from 1-2147483. The FIN-exchange occurs when the TCP session is ready to close. The default is 5.

  
       

 
        
        		[bookmark: pgfId-643611]TCP Idle Time (seconds)

  
        		[bookmark: pgfId-643613]How long to maintain a TCP session while there is no activity in the session, in seconds, from 1-2147483. The default is 3600 (one hour).

  
       

 
        
        		[bookmark: pgfId-643619]UDP Idle Time (seconds)

  
        		[bookmark: pgfId-643621]How long to maintain a UDP session while there is no activity in the session, in seconds, from 1-2147483. The default is 30.

 [bookmark: pgfId-643623]When the software detects a valid UDP packet, the software establishes state information for a new UDP session. Because UDP is a connectionless service, there are no actual sessions, so the software approximates sessions by examining the information in the packet and determining if the packet is similar to other UDP packets (for example, it has similar source or destination addresses) and if the packet was detected soon after another similar UDP packet.

 [bookmark: pgfId-643625]If the software detects no UDP packets for the UDP session for the period of time defined by the UDP idle timeout, the software will not continue to manage state information for the session.

  
       

 
        
        		[bookmark: pgfId-643631]DNS Timeout (seconds)

  
        		[bookmark: pgfId-643633]The length of time for which a DNS lookup session is managed while there is no activity, in seconds, from 1-2147483. The default is 5.

  
       

 
        
        		 
          
          [bookmark: pgfId-643639]SYN Flooding DoS Attack Thresholds
         
  
       

 
        
        		[bookmark: pgfId-643647]Maximum 1 Minute Connection Rate - low

 [bookmark: pgfId-643649]Maximum 1 Minute Connection Rate - high

  
        		[bookmark: pgfId-643651]The number of new unestablished sessions that causes the system to start and stop deleting half-open sessions. Ensure that you enter a lower number in the Low field than you enter in the High field. Possible values are from 1-2147483647 per minute. The default is 400 for low and 500 for high.

  
       

 
        
        		[bookmark: pgfId-643657]Maximum Incomplete Sessions Stop Threshold

 [bookmark: pgfId-643659]Maximum Incomplete Sessions Start Threshold

  
        		[bookmark: pgfId-643661]The number of existing half-open sessions that will cause the software to start and stop deleting half-open sessions. Ensure that you enter a lower number in the stop field than you enter in the start field. Possible values are from 1-2147483647. The default is 400 for low and 500 for high.

  
       

 
        
        		 
          
          [bookmark: pgfId-643667]Thresholds per Host
         
  
       

 
        
        		[bookmark: pgfId-643675]Max Sessions Per Host

  
        		[bookmark: pgfId-643677]The number of half-open TCP sessions with the same host destination address that can exist at a time before the software starts deleting half-open sessions to the host. Possible values are 1-4294967295. The default is 50.

 [bookmark: pgfId-643679]A large number of half-open sessions can indicate there is a Denial of Service attack against the host.

  
       

 
        
        		[bookmark: pgfId-643685]Max Sessions Blocking Interval (min)

  
        		[bookmark: pgfId-643687]If the maximum sessions per host threshold is reached, the blocking time to apply to help mitigate the potential TCP host-specific denial-of-service (DoS) attack. Possible values are 0-35791 minutes. The default is 0.

 
          
          		 [bookmark: pgfId-643689]If the blocking time value is 0, the software deletes the oldest existing half-open session for the host for every new connection request to the host above the maximum session limit. This ensures that the number of half-open sessions to a given host will never exceed the threshold.

 
          		 [bookmark: pgfId-643691]If the blocking time value is greater than 0, the software deletes all existing half-open sessions for the host, then blocks all new connection requests to the host. The software will continue to block all new connection requests until the block-time expires.

 
         

  
       

 
        
        		 
          
          [bookmark: pgfId-643697]Other
         
  
       

 
        
        		[bookmark: pgfId-643705]Session Hash Table Size (buckets)

  
        		[bookmark: pgfId-643707]The size of the hash table in terms of buckets. Possible values for the hash table are 1024, 2048, 4096, and 8192. The default is 1024.

 [bookmark: pgfId-643709]You should increase the hash table size when the total number of sessions running through the device is approximately twice the current hash size; decrease the hash table size when the total number of sessions is reduced to approximately half the current hash size. Essentially, try to maintain a 1:1 ratio between the number of sessions and the size of the hash table.

  
       

 
        
        		[bookmark: pgfId-643715]Enable Alert Messages

  
        		[bookmark: pgfId-643717]Whether to generate stateful packet inspection alert messages on the console.

  
       

 
        
        		[bookmark: pgfId-643723]Enable Audit Trail Messages

  
        		[bookmark: pgfId-643725]Whether audit trail messages are logged to the syslog server or router.

  
       

 
        
        		[bookmark: pgfId-643731]Permit DHCP Passthrough (Transparent Firewall)

  
        		[bookmark: pgfId-643733]Whether to permit a transparent firewall to forward DHCP packets across the bridge without inspection.

 [bookmark: pgfId-643735]Permitting DHCP passthrough overrides an ACL for DHCP packets, so DHCP packets are forwarded even if the ACL is configured to deny all IP packets. Thus, clients on one side of the bridge can get an IP address from a DHCP server on the opposite side of the bridge.

  
       

 
        
        		[bookmark: pgfId-643741]Block Non-SYN Packets

  
        		[bookmark: pgfId-643743]Whether to drop TCP packets that do not belong to an established session. These are TCP packets that do not initiate sessions, that is, the SYN bit is not set in them.

  
       

 
        
        		[bookmark: pgfId-643749]Log Dropped Packets

  
        		[bookmark: pgfId-643751]Whether to create log messages for dropped packets to specify the reason for dropping them.

  
       

 
      
     

 
    
 
    [bookmark: pgfId-648235]Related Topics

 
     
     		 [bookmark: pgfId-648240]Understanding Inspection Rules

 
     		 [bookmark: pgfId-648245]Configuring Inspection Rules

 
     		 [bookmark: pgfId-648250]Using Inspection To Prevent Denial of Service (DoS) Attacks on IOS Devices
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     [bookmark: pgfId-531685][bookmark: 114831][bookmark: pxchap_cncpt_ConfiguringServerAccessSettingsonFirewallDevices]Configuring Server Access Settings on Firewall Devices[bookmark: marker-531679][bookmark: marker-531681][bookmark: marker-531683]
      
      
 
     
 

 
    [bookmark: pgfId-531687]The Server Access section contains pages for configuring server access on firewall devices; Server Access is under Device Admin in the Device or Policy selector.

 
    [bookmark: pgfId-531689]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-531694]AUS Page

 
     		 [bookmark: pgfId-531699]DHCP Relay Page

 
     		 [bookmark: pgfId-531704]DHCP Relay IPv6 Page

 
     		 [bookmark: pgfId-531709]Configuring DHCP Servers

 
     		 [bookmark: pgfId-531714]DNS Page

 
     		 [bookmark: pgfId-531719]Configuring DDNS

 
     		 [bookmark: pgfId-531724]NTP Page

 
     		 [bookmark: pgfId-531729]SMTP Server Page

 
     		 [bookmark: pgfId-531734]TFTP Server Page

 
    

 
   
 
    
     [bookmark: pgfId-531748][bookmark: 114845][bookmark: pxpage_cncpt_AUSPage]AUS Page[bookmark: marker-531742][bookmark: marker-531744][bookmark: marker-531746]

 
    [bookmark: pgfId-531750]The AUS page lets you configure remote updating of a security appliance from a server that supports the Auto Update specification. Auto Update applies configuration changes and software updates to the appliance automatically from the remote server.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-531752]Note The server you identify on this page must be the same server you identify in the Auto Update section of the Device Properties (from the Tools menu, choose Device Properties). The Device Properties information identifies the AUS server to which Security Manager sends configuration updates, whereas the information on this page defines for the server the device will contact for updates. Also, the Device Identity you provide in the Device Properties must match the Device ID on this page.


    
     

    

    

 
    [bookmark: pgfId-531757]If you change AUS servers, note that the device will continue to use the AUS server defined in its current configuration until it receives a new configuration. Thus, you should change the AUS policy but deploy the configuration using the previous AUS server. After deployment is successful, change the Device Properties to point to the new server. For more information on deploying to AUS, see Deploying Configurations Using an Auto Update Server or CNS Configuration Engine.

 
    [bookmark: pgfId-531759]Navigation Path

 
     
     		 [bookmark: pgfId-531761](Device view) Select  Platform > Device Admin > Server Access > AUS from the Device Policy selector.

 
     		 [bookmark: pgfId-531763](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Server Access > AUS from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-531765]Related Topics

 
     
     		 [bookmark: pgfId-531770]Add and Edit Auto Update Server Dialog Boxes

 
    

 
    [bookmark: pgfId-531772]Field Reference

 
    [bookmark: pgfId-531775] 

 
     
      
       
       [bookmark: pgfId-529639]Table 52-1 [bookmark: 114881]AUS Page 

 
       
      
        
        		
          
          [bookmark: pgfId-529645]Element
         
  
        		
          
          [bookmark: pgfId-529647]Description
         
  
       

 
        
        		[bookmark: pgfId-529653]Auto Update Servers table

  
        		[bookmark: pgfId-529655]This table lists currently configured Auto Update servers. Use the buttons below the table to manage these entries.

 [bookmark: pgfId-529657]The entries are listed in order of precedence for contacting AUS servers. Use the Up and Down arrow buttons to change the ordering of the list by moving the selected entry up or down.

 [bookmark: pgfId-529662]Use the Add Row, Edit Row, and Delete Row buttons to add, edit or delete entries. Add Row opens the Add Auto Update Server dialog box, while Edit Row opens the Edit Auto Update Server dialog box for the selected row. See Add and Edit Auto Update Server Dialog Boxes for information about these dialog boxes.

 provided in the Add/Edit Auto Update Server dialog boxes. The Port is included only if you entered a port number other than the default 443.

  
       

 
        
        		[bookmark: pgfId-529670]Device ID Type

  
        		[bookmark: pgfId-529672]Choose the method used for identifying this device to the AUS server:

 
          
          		 [bookmark: pgfId-529674] Host Name – The host name of this device, as provided in the Device Properties window (Tools > Device Properties).

 
          		 [bookmark: pgfId-529676] Serial Number – The serial number of this device.

 
          		 [bookmark: pgfId-529678] IP Address – The IP address of the specified interface. When you choose this option, an Interface field appears; enter or Select the desired device interface.

 
          		 [bookmark: pgfId-529680] MAC Address – The MAC address of the specified interface. When you choose this option, an Interface field appears; enter or Select the desired device interface.

 
          		 [bookmark: pgfId-529682] User Defined – A unique user-specified ID is used. When you choose this option, a User Defined field appears; enter any alphanumeric string. Note that this string must also appear in the Device Identity field in the Device Properties window (Tools > Device Properties).

 
         

  
       

 
        
        		[bookmark: pgfId-529688]Poll Type

  
        		[bookmark: pgfId-529690]Choose the method defining how often the AUS server is polled for updates:

 
          
          		 [bookmark: pgfId-529692] At Specified Frequency – If you choose this option, the Poll Period field is displayed:

 
         

 [bookmark: pgfId-529694] – Poll Period – Specify the number of minutes the device waits between polls of the AUS server; valid values are 1 to 35791.

 
          
          		 [bookmark: pgfId-529696] At Scheduled Time – If you choose this option, the following fields are displayed (available only on ASA/PIX devices running version 7.2 or later):

 
         

 [bookmark: pgfId-529698] – Days of the week – Select one or more days on which the device is to poll the AUS server.

 [bookmark: pgfId-529700] – Polling Start Time in Hours – The hour at which polling is to begin on the selected days; based on a 24-hour clock.

 [bookmark: pgfId-529702] – Polling Start Time in Mins – The minute within the chosen hour when polling is to begin.

 [bookmark: pgfId-529704] – Enable Randomization of the Start Time – Select this option to specify a random polling window; the Randomization Window field is enabled.

 [bookmark: pgfId-529706]Randomization Window – The maximum number of minutes the device can use to randomize the specified polling time; valid values are 1 to 1439.

  
       

 
        
        		[bookmark: pgfId-529712]Retry Count

  
        		[bookmark: pgfId-529714]The number of times the device will try to poll the AUS server for new information. Optional; if you enter zero or leave this field blank, the device will not retry after a failed poll attempt.

  
       

 
        
        		[bookmark: pgfId-529720]Retry Period

  
        		[bookmark: pgfId-529722]If Retry Count is not zero or blank, the number of minutes the device will wait to re-poll the AUS server if the previous attempt failed; valid values are 1 to 35791. If Retry Count is not zero or blank and you leave this field blank, the value defaults to five minutes.

  
       

 
        
        		[bookmark: pgfId-529728]Disable Device After:

  
        		[bookmark: pgfId-529730]Selecting this option ensures that if no response is received from the AUS server within the specified Timeout period, the security appliance will stop passing traffic.

 
          
          		 [bookmark: pgfId-529732] Timeout – The number of minutes the firewall device will wait to timeout if no response is received from the AUS server.

 
         

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-531789][bookmark: 114978][bookmark: pxpage_cncpt_AddEditAUSserverDialogBox]Add and Edit Auto Update Server Dialog Boxes [bookmark: marker-531783][bookmark: marker-531785][bookmark: marker-531787]

 
     [bookmark: pgfId-531791]Use the Add Auto Update Server dialog box to configure a new AUS server definition. The security appliance will automatically poll this server for image and configuration updates.

 
     [bookmark: pgfId-531793]The Auto Update specification allows the Auto Update server to either push configuration information and send requests for information to the security appliance, or to pull configuration information by causing the security appliance to periodically poll the Auto Update server. The Auto Update server can also send a command to the security appliance to send an immediate polling request at any time. Communication between the Auto Update server and the security appliance requires a communications path and local CLI configuration on each security appliance.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-531795]Note The URL for contacting this AUS server is produced by concatenating the Protocol://Username:Password@IP IP Address(:Port)/Path provided in these dialog boxes. The Port is included only if you entered a port number other than the default 443.


     
      

     

     

 
     [bookmark: pgfId-531797]With the exception of the title, the Edit Auto Update Server dialog box is identical to the Add Auto Update Server dialog box. The following descriptions apply to both.

 
     [bookmark: pgfId-531799]Navigation Path

 
     [bookmark: pgfId-531804]You can access the Add and Edit Auto Update Server dialog boxes from the AUS Page.

 
     [bookmark: pgfId-531806]Field Reference

 
     [bookmark: pgfId-531809] 

 
      
       
        
        [bookmark: pgfId-529745]Table 52-2 [bookmark: 115011]Add and Edit Auto Update Server Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-529751]Element
          
  
         		
           
           [bookmark: pgfId-529753]Description
          
  
        

 
         
         		[bookmark: pgfId-529759]Protocol

  
         		[bookmark: pgfId-529761]The protocol used to communicate with the AUS server; choose http or https.

 [bookmark: pgfId-529763]Note If https is selected as the protocol to communicate with the Auto Update server, the security appliance will use SSL. This requires the security appliance to have a DES, 3DES, or AES license.

  
        

 
         
         		[bookmark: pgfId-529769]IP Address

  
         		[bookmark: pgfId-529771]Enter the IP address or Select a Networks/Hosts object representing this AUS server.

  
        

 
         
         		[bookmark: pgfId-529777]Port

  
         		[bookmark: pgfId-529779]Enter the number of the port on which communications with the AUS server take place. Defaults to 80 if http is chosen as the Protocol, and to 443 if https is chosen. If you enter an arbitrary port number, be sure the AUS server is configured to use the same port.

  
        

 
         
         		[bookmark: pgfId-529785]Path

  
         		[bookmark: pgfId-529787]The path to AUS services on the server. The standard path is autoupdate/AutoUpdateServlet; change this to admin/auto-update only if the AUS server host is an ASA.

  
        

 
         
         		[bookmark: pgfId-529793]AUS Interface

  
         		[bookmark: pgfId-529795]Enter or Select the interface to use when polling the Auto Update server.

  
        

 
         
         		[bookmark: pgfId-529801]Verify Certificate

  
         		[bookmark: pgfId-529803]Select this option to require SSL verification from the AUS server. The certificate returned by the server will be checked against Certification Authority (CA) root certificates. This requires that the AUS Server and this device use the same Certification Authority.

  
        

 
         
         		[bookmark: pgfId-529809]Username

  
         		[bookmark: pgfId-529811]Enter a user name to be used for AUS authentication (optional).

  
        

 
         
         		[bookmark: pgfId-529817]Password

  
         		[bookmark: pgfId-529819]Enter the password to be used for AUS authentication (optional).

  
        

 
         
         		[bookmark: pgfId-529825]Confirm

  
         		[bookmark: pgfId-529827]Re-enter the password (optional).

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-531827][bookmark: 115073][bookmark: pxpage_cncpt_DHCPRelayPage]DHCP Relay Page[bookmark: marker-531817][bookmark: marker-531819][bookmark: marker-531821][bookmark: marker-531823][bookmark: marker-531825]

 
    [bookmark: pgfId-531829]Use the DHCP Relay page to configure DHCP relay services for security devices. Dynamic Host Configuration Protocol (DHCP) relay passes DHCP requests received on one interface to an external DHCP server located behind a different interface. To configure DHCP relay, you need to specify at least one DHCP relay server and then enable a DHCP relay agent on the interface receiving DHCP requests.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-531831]Note You cannot enable a DHCP relay agent on an interface where a DHCP relay server is configured. 
The DHCP relay agent works only with external DHCP servers; it will not forward DHCP requests to a security appliance interface configured as a DHCP server.


    
     

    

    

 
    [bookmark: pgfId-531833]Beginning with Security Manager version 4.9, DHCP Relay IPv4 is supported for ASA cluster devices running the software version 9.4.0 or higher.

 
    [bookmark: pgfId-531838]For ASA-SM 9.1.2+ devices, you can configure DHCP relay servers per-interface, so requests that enter a given interface are relayed only to servers specified for that interface. When a DHCP request enters an interface that does not have interface-specific servers configured, the ASA relays the request to all global servers. If the interface has interface-specific servers, then the global servers are not used. IPv6 is not supported for per-interface DHCP relay. For more information, see Add/Edit Interface Dialog Box: Advanced Tab (ASA/PIX 7.0+).

 
    [bookmark: pgfId-531840]Navigation Path

 
     
     		 [bookmark: pgfId-531842](Device view) Select  Platform > Device Admin > Server Access > DHCP Relay from the Device Policy selector.

 
     		 [bookmark: pgfId-531844](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Server Access > DHCP Relay from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-531846]Field Reference

 
    [bookmark: pgfId-531849] 

 
     
      
       
       [bookmark: pgfId-529840]Table 52-3 [bookmark: 115111]DHCP Relay Page 

 
       
      
        
        		
          
          [bookmark: pgfId-529846]Element
         
  
        		
          
          [bookmark: pgfId-529848]Description
         
  
       

 
        
        		[bookmark: pgfId-529854]DHCP Relay Agent table

  
        		[bookmark: pgfId-529856]This table lists the interfaces on which DHCP relay is configured. Use the Add Row, Edit Row, and Delete Row buttons to manage these entries.

 [bookmark: pgfId-529861]The Add Row button opens the Add DHCP Relay Agent Configuration dialog box, while Edit Row opens the Edit DHCP Relay Agent Configuration dialog box. See Add and Edit DHCP Relay Agent Configuration Dialog Boxes for more information.

  
       

 
        
        		[bookmark: pgfId-529867]DHCP Servers table

  
        		[bookmark: pgfId-529869]This table lists the global DHCP servers to which DHCP requests are relayed. Use the Add Row, Edit Row, and Delete Row buttons to manage these entries.

 [bookmark: pgfId-529874]The Add Row button opens the Add DHCP Relay Server Configuration dialog box, while Edit Row opens the Edit DHCP Relay Server Configuration dialog box. See Add and Edit DHCP Relay Server Configuration Dialog Boxes for more information.

  
       

 
        
        		[bookmark: pgfId-529880]Timeout (seconds)

  
        		[bookmark: pgfId-529882]Specify the amount of time, in seconds, allowed for DHCP address negotiation. Valid values range from 1 to 3600 seconds; the default value is 60 seconds.

  
       

 
        
        		[bookmark: pgfId-529888]Trust Info (Option 82)

  
        		[bookmark: pgfId-529890]Specifies that you want to trust all DHCP client interfaces. You can configure interfaces as trusted interfaces to preserve DHCP Option 82.

 [bookmark: pgfId-529895]Note You can also specify interfaces to trust individually. For more information, see Add/Edit Interface Dialog Box: Advanced Tab (ASA/PIX 7.0+).

 [bookmark: pgfId-529897]DHCP Option 82 is used by downstream switches and routers for DHCP snooping and IP Source Guard. Normally, if the ASA DHCP relay agent receives a DHCP packet with Option 82 already set, but the giaddr field (which specifies the DHCP relay agent address that is set by the relay agent before it forwards the packet to the server) is set to 0, then the ASA will drop that packet by default. You can now preserve Option 82 and forward the packet by identifying an interface as a trusted interface.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-531863][bookmark: 115148][bookmark: pxpage_cncpt_ConfigureDHCPRelayAgentParametersDialogBox]Add and Edit DHCP Relay Agent Configuration Dialog Boxes [bookmark: marker-531857][bookmark: marker-531859][bookmark: marker-531861]

 
     [bookmark: pgfId-531865]Use the Add DHCP Relay Agent Configuration dialog box to configure and enable a DHCP relay agent on an interface. Use the Edit DHCP Relay Agent Configuration dialog box to update an existing interface relay agent.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-531867]Note You cannot enable a DHCP relay agent on an interface where a DHCP relay server is configured. 
The DHCP relay agent works only with external DHCP servers; it will not forward DHCP requests to a security appliance interface configured as a DHCP server.


     
      

     

     

 
     [bookmark: pgfId-531869]The Add DHCP Relay Agent Configuration dialog box and the Edit DHCP Relay Agent Configuration dialog box are virtually identical; the following descriptions apply to both.

 
     [bookmark: pgfId-531871]Navigation Path

 
     [bookmark: pgfId-531876]You can access the Add and Edit DHCP Relay Agent Configuration dialog boxes from the DHCP Relay Page.

 
     [bookmark: pgfId-531878]Related Topics

 
      
      		 [bookmark: pgfId-531883]Add and Edit DHCP Relay Server Configuration Dialog Boxes

 
     

 
     [bookmark: pgfId-531885]Field Reference

 
     [bookmark: pgfId-531888] 

 
      
       
        
        [bookmark: pgfId-529910]Table 52-4 [bookmark: 115180]Add and Edit DHCP Relay Agent Configuration Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-529916]Element
          
  
         		
           
           [bookmark: pgfId-529918]Description
          
  
        

 
         
         		[bookmark: pgfId-529924]Interface

  
         		[bookmark: pgfId-529926]Enter or Select the name of the interface on which you want to configure a DHCP relay agent.

  
        

 
         
         		[bookmark: pgfId-529932]Enable DHCP Relay

  
         		[bookmark: pgfId-529934]When checked, the DHCP relay is enabled on the specified interface.

  
        

 
         
         		[bookmark: pgfId-529940]Set Route

  
         		[bookmark: pgfId-529942]Check this box to configure the DHCP relay agent to modify the default router address in the information returned from the DHCP server. When this option is selected, the DHCP relay agent substitutes the address of the selected interface for the default router address in the information returned from the DHCP server.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-531902][bookmark: 115206][bookmark: pxpage_cncpt_ConfigureDHCPServerParametersDialogBox]Add and Edit DHCP Relay Server Configuration Dialog Boxes[bookmark: marker-531896][bookmark: marker-531898][bookmark: marker-531900]

 
     [bookmark: pgfId-531904]Use the Add DHCP Relay Server Configuration dialog box to define a new DHCP relay server; use the Edit DHCP Relay Server Configuration dialog box to update existing server information. You can configure a maximum of 10 DHCPv4 relay servers in single mode and per context, global and interface-specific servers combined, with a maximum of 4 servers per interface.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-531906]Note PIX Firewalls running an OS earlier than 7.2 only support 4 DHCP relay servers.


     
      

     

     

 
     [bookmark: pgfId-531908]The Add DHCP Relay Server Configuration dialog box and the Edit DHCP Relay Server Configuration dialog box are virtually identical; the following descriptions apply to both.

 
     [bookmark: pgfId-531910]Navigation Path

 
     [bookmark: pgfId-531915]You can access the Add and Edit DHCP Relay Server Configuration dialog boxes from the DHCP Relay Page.

 
     [bookmark: pgfId-531917]Related Topics

 
      
      		 [bookmark: pgfId-531922]Add and Edit DHCP Relay Agent Configuration Dialog Boxes

 
     

 
     [bookmark: pgfId-531924]Field Reference

 
     [bookmark: pgfId-531927] 

 
      
       
        
        [bookmark: pgfId-529955]Table 52-5 [bookmark: 115237]Add and Edit DHCP Relay Server Configuration Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-529961]Element
          
  
         		
           
           [bookmark: pgfId-529963]Description
          
  
        

 
         
         		[bookmark: pgfId-529969]Server

  
         		[bookmark: pgfId-529971]Enter the IP address or Select a Networks/Hosts object representing the external DHCP server to which DHCP requests are forwarded.

  
        

 
         
         		[bookmark: pgfId-529977]Interface

  
         		[bookmark: pgfId-529979]Enter or Select the interface through which DHCP requests are forwarded to the external DHCP server.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-531941][bookmark: 115259][bookmark: pxpage_cncpt_DHCPv6RelayPage]DHCP Relay IPv6 Page[bookmark: marker-531935][bookmark: marker-531937][bookmark: marker-531939]

 
    [bookmark: pgfId-531943]Use the DHCP Relay IPv6 page to configure DHCPv6 relay services for security devices. Dynamic Host Configuration Protocol v6 (DHCPv6) relay passes DHCPv6 requests received on one interface to an external DHCPv6 server located behind a different interface. To configure DHCPv6 relay, you need to specify at least one DHCPv6 relay server and then enable a DHCPv6 relay agent on the interface receiving DHCPv6 requests.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-531945]Note You cannot enable a DHCPv6 relay agent on an interface where a DHCPv6 relay server is configured. 
The DHCPv6 relay agent works only with external DHCPv6 servers; it will not forward DHCPv6 requests to a security appliance interface configured as a DHCPv6 server. 
Beginning with Security Manager version 4.9, DHCP Relay IPv6 is supported for ASA cluster devices running the software version 9.4.0 or higher.


    
     

    

    

 
    [bookmark: pgfId-531947]Navigation Path

 
     
     		 [bookmark: pgfId-531949](Device view) Select  Platform > Device Admin > Server Access > DHCP Relay IPv6 from the Device Policy selector.

 
     		 [bookmark: pgfId-531951](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Server Access > DHCP Relay IPv6 from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-531956]Note Two new interface settings have been introduced for DHCPv6: "managed-config-flag" and "other-config-flag." For more information, refer to Configuring IPv6 Interfaces (ASA/FWSM).


    
     

    

    

 
    [bookmark: pgfId-531958]Field Reference

 
    [bookmark: pgfId-531961] 

 
     
      
       
       [bookmark: pgfId-529992]Table 52-6 [bookmark: 115291]DHCP Relay IPv6 Page 

 
       
      
        
        		
          
          [bookmark: pgfId-529998]Element
         
  
        		
          
          [bookmark: pgfId-530000]Description
         
  
       

 
        
        		[bookmark: pgfId-530006]DHCP Relay IPv6 Agent table

  
        		[bookmark: pgfId-530008]This table lists the interfaces on which DHCP relay IPv6 is configured. Use the Add Row, Edit Row, and Delete Row buttons to manage these entries.

 [bookmark: pgfId-530013]The Add Row button opens the Add DHCP Relay IPv6 Agent Configuration dialog box, while Edit Row opens the Edit DHCP Relay IPv6 Agent Configuration dialog box. See Add and Edit DHCP Relay IPv6 Agent Configuration Dialog Boxes for more information.

  
       

 
        
        		[bookmark: pgfId-530019]DHCP Servers table

  
        		[bookmark: pgfId-530021]This table lists the interfaces on which DHCP relay IPv6 is configured. Use the Add Row, Edit Row, and Delete Row buttons to manage these entries.

 [bookmark: pgfId-530026]The Add Row button opens the Add DHCP Relay IPv6 Server Configuration dialog box, while Edit Row opens the Edit DHCP Relay IPv6 Server Configuration dialog box. See Add and Edit DHCP Relay IPv6 Server Configuration Dialog Boxes for more information.

  
       

 
        
        		[bookmark: pgfId-530032]Timeout (seconds)

  
        		[bookmark: pgfId-530034]Specify the amount of time, in seconds, allowed for DHCPv6 address negotiation. Valid values range from 1 to 3600 seconds; the default value is 60 seconds.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-531975][bookmark: 115320][bookmark: pxpage_cncpt_ConfigureDHCPv6RelayAgentParametersDialogBox]Add and Edit DHCP Relay IPv6 Agent Configuration Dialog Boxes [bookmark: marker-531969][bookmark: marker-531971][bookmark: marker-531973]

 
     [bookmark: pgfId-531977]Use the Add DHCP Relay IPv6 Agent Configuration dialog box to configure and enable a DHCPv6 relay agent on an interface. Use the Edit DHCP Relay IPv6 Agent Configuration dialog box to update an existing interface relay agent.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-531979]Note You cannot enable a DHCPv6 relay agent on an interface where a DHCPv6 relay server is configured. 
The DHCPv6 relay agent works only with external DHCPv6 servers; it will not forward DHCPv6 requests to a security appliance interface configured as a DHCPv6 server.


     
      

     

     

 
     [bookmark: pgfId-531981]The Add DHCP Relay IPv6 Agent Configuration dialog box and the Edit DHCP Relay IPv6 Agent Configuration dialog box are virtually identical; the following descriptions apply to both.

 
     [bookmark: pgfId-531983]Navigation Path

 
     [bookmark: pgfId-531988]You can access the Add and Edit DHCP Relay IPv6 Agent Configuration dialog boxes from the DHCP Relay IPv6 Page.

 
     [bookmark: pgfId-531990]Related Topics

 
      
      		 [bookmark: pgfId-531995]Add and Edit DHCP Relay IPv6 Server Configuration Dialog Boxes

 
     

 
     [bookmark: pgfId-531997]Field Reference

 
     [bookmark: pgfId-532000] 

 
      
       
        
        [bookmark: pgfId-530047]Table 52-7 [bookmark: 115352]Add and Edit DHCP Relay IPv6 Agent Configuration Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-530053]Element
          
  
         		
           
           [bookmark: pgfId-530055]Description
          
  
        

 
         
         		[bookmark: pgfId-530061]Interface

  
         		[bookmark: pgfId-530063]Enter or Select the name of the interface on which you want to configure a DHCPv6 relay agent.

  
        

 
         
         		[bookmark: pgfId-530069]Enable DHCPv6 Relay

  
         		[bookmark: pgfId-530071]When checked, the DHCPv6 relay is enabled on the specified interface.

  
        

 
         
         		[bookmark: pgfId-530077]Set Route

  
         		[bookmark: pgfId-530079]Check this box to configure the DHCPv6 relay agent to modify the default router address in the information returned from the DHCPv6 server. When this option is selected, the DHCPv6 relay agent substitutes the address of the selected interface for the default router address in the information returned from the DHCPv6 server.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-532014][bookmark: 115378][bookmark: pxpage_cncpt_ConfigureDHCPv6ServerParametersDialogBox]Add and Edit DHCP Relay IPv6 Server Configuration Dialog Boxes[bookmark: marker-532008][bookmark: marker-532010][bookmark: marker-532012]

 
     [bookmark: pgfId-532016]Use the Add DHCP Relay IPv6 Server Configuration dialog box to define a new DHCPv6 relay server; use the Edit DHCP Relay IPv6 Server Configuration dialog box to update existing server information. You can define up to ten DHCPv6 relay servers.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-532018]Note The Add DHCP Relay IPv6 Server Configuration dialog box and the Edit DHCP Relay IPv6 Server Configuration dialog box are virtually identical; the following descriptions apply to both.


     
      

     

     

 
     [bookmark: pgfId-532020]Navigation Path

 
     [bookmark: pgfId-532025]You can access the Add and Edit DHCP Relay IPv6 Server Configuration dialog boxes from the DHCP Relay IPv6 Page.

 
     [bookmark: pgfId-532027]Related Topics

 
      
      		 [bookmark: pgfId-532032]Add and Edit DHCP Relay IPv6 Agent Configuration Dialog Boxes

 
     

 
     [bookmark: pgfId-532034]Field Reference

 
     [bookmark: pgfId-532037] 

 
      
       
        
        [bookmark: pgfId-530092]Table 52-8 [bookmark: 115408]Add and Edit DHCP Relay IPv6 Server Configuration Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-530098]Element
          
  
         		
           
           [bookmark: pgfId-530100]Description
          
  
        

 
         
         		[bookmark: pgfId-530106]Server

  
         		[bookmark: pgfId-530108]Enter the IP address or Select a Networks/Hosts object representing the external DHCPv6 server to which DHCPv6 requests are forwarded.

  
        

 
         
         		[bookmark: pgfId-530114]Interface

  
         		[bookmark: pgfId-530116]Enter or Select the interface through which DHCPv6 requests are forwarded to the external DHCPv6 server.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-532047][bookmark: 115430][bookmark: pxchap_proc_ConfiguringDHCPServers]Configuring DHCP Servers[bookmark: marker-532043][bookmark: marker-532045]

 
    [bookmark: pgfId-532052]A Dynamic Host Configuration Protocol (DHCP) server provides network configuration parameters, such as IP addresses, to DHCP clients. The security appliance can provide DHCP server or DHCP relay services to DHCP clients attached to the security appliance interfaces. The DHCP server provides network configuration parameters directly to DHCP clients: DHCP relay passes DHCP requests received on one interface to an external DHCP server located behind a different interface. For more information about DHCP relay, see DHCP Relay Page.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-532054]Note The security appliance DHCP server does not support BOOTP requests.

In multiple-context mode, you cannot enable a DHCP server or DHCP relay on an interface that is used by more than one context.


    
     

    

    

 
    [bookmark: pgfId-532056]You can configure a DHCP server on each interface of the security appliance, and each interface can have its own pool of addresses to draw from. However, the other DHCP settings, such as DNS servers, domain name, options, ping timeout, and WINS servers, are configured globally and used by the DHCP server on all interfaces.

 
    [bookmark: pgfId-532058]You cannot configure a DHCP client or DHCP relay services on an interface on which the DHCP server is enabled. Additionally, DHCP clients must be directly connected to the interface on which the server is enabled.

 
    [bookmark: pgfId-532060]If your firewall is also acting as a DHCP client on the outside interface, you can enable auto-negotiated IP configuration. This allows the firewall to pass the DNS, WINS and domain name parameters it gets from the outside interface (as a DHCP client) to hosts on its inside network. Alternatively, you can manually specify the DNS, WINS and domain name parameters. If you specify those parameters manually and auto-configuration is on, your values take precedence over auto-configuration.

 
    [bookmark: pgfId-532065]Use the DHCP Server Page to manage DHCP server definitions.

 
     
      [bookmark: pgfId-532079][bookmark: 115449][bookmark: pxpage_cncpt_DHCPServerPage]DHCP Server Page[bookmark: marker-532073][bookmark: marker-532075][bookmark: marker-532077]

 
     [bookmark: pgfId-532081]Use the DHCP Server page to configure global DHCP server and dynamic DNS (DDNS) update options, to set up a DHCP server on one or more device interfaces, and to configure advanced server options.

 
     [bookmark: pgfId-532083]Navigation Path

 
      
      		 [bookmark: pgfId-532085](Device view) Select  Platform > Device Admin > Server Access > DHCP Server from the Device Policy selector.

 
      		 [bookmark: pgfId-532087](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Server Access > DHCP Server from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
     

 
     [bookmark: pgfId-532089]Related Topics

 
      
      		 [bookmark: pgfId-532094]Configuring DHCP Servers

 
     

 
     [bookmark: pgfId-532096]Field Reference

 
     [bookmark: pgfId-532099] 

 
      
       
        
        [bookmark: pgfId-530129]Table 52-9 [bookmark: 115482]DHCP Server Page 

 
        
       
         
         		
           
           [bookmark: pgfId-530135]Element
          
  
         		
           
           [bookmark: pgfId-530137]Description
          
  
        

 
         
         		[bookmark: pgfId-530143]Ping Timeout

  
         		[bookmark: pgfId-530145]Specify the amount of time, in milliseconds, that the firewall device waits to time out a DHCP ping attempt. To avoid address conflicts, firewall devices send two ICMP ping packets to an address before assigning that address to a DHCP client. Valid values range from 10 to 10000 milliseconds.

  
        

 
         
         		[bookmark: pgfId-530151]Lease Length

  
         		[bookmark: pgfId-530153]Specify the amount of time, in seconds, that the client can use its allocated IP address before the lease expires. Valid values range from 300 to 1048575 seconds. The default value is 3600 seconds (1 hour).

  
        

 
         
         		[bookmark: pgfId-530159]Enable auto-configuration (PIX and ASA only)

  
         		[bookmark: pgfId-530161]Select this option to enable DHCP auto configuration.

 [bookmark: pgfId-530163]DHCP auto configuration causes the DHCP server to provide DHCP clients with DNS server, domain name, and WINS server information obtained from a DHCP client running on the specified interface. If any of the information obtained through auto configuration is also specified manually, the manually specified information takes precedence over the discovered information.

  
        

 
         
         		[bookmark: pgfId-530169]Interface

  
         		[bookmark: pgfId-530171]If Enable auto-configuration is checked, this field is available. Enter or Select the interface running the DHCP client that supplies the DNS, WINS, and domain name parameters.

  
        

 
         
         		 [bookmark: pgfId-530177]Define settings (optional)

  
        

 
         
         		[bookmark: pgfId-530185]Domain Name

  
         		[bookmark: pgfId-530187]Specify the DNS domain name for DHCP clients. Enter a valid DNS domain name; for example, example.com.

  
        

 
         
         		[bookmark: pgfId-530193]Primary DNS Server

  
         		[bookmark: pgfId-530195]Enter the IP address or Select a Networks/Hosts object representing the primary DNS server for a DHCP client.

  
        

 
         
         		[bookmark: pgfId-530201]Primary WINS Server

  
         		[bookmark: pgfId-530203]Enter the IP address or Select a Networks/Hosts object representing the primary WINS server for a DHCP client.

  
        

 
         
         		[bookmark: pgfId-530209]Secondary DNS Server

  
         		[bookmark: pgfId-530211]Enter the IP address or Select a Networks/Hosts object representing the alternate DNS server for a DHCP client.

  
        

 
         
         		[bookmark: pgfId-530217]Secondary WINS Server

  
         		[bookmark: pgfId-530219]Enter the IP address or Select a Networks/Hosts object representing the alternate WINS server for a DHCP client.

  
        

 
         
         		 
           
           [bookmark: pgfId-530225]Dynamic DNS Update
          
  
        

 
         
         		[bookmark: pgfId-530233]Enable Dynamic DNS Update

  
         		[bookmark: pgfId-530235]Check this box to define global DDNS update options:

 
           
           		 [bookmark: pgfId-530237]Select the type of resource-record updating:  PTR Record only, or  A Record and PTR Record .

 
           		 [bookmark: pgfId-530239]You also can select Override DHCP Client Request. If selected, DHCP server updates override any updates requested by DHCP clients.

 
          

 [bookmark: pgfId-530241]These options are available only on ASA/PIX 7.2 and higher.

  
        

 
         
         		 
           
           [bookmark: pgfId-530247]DHCP Server Interface Configuration table
          
  
        

 
         
         		[bookmark: pgfId-530255]Interface table

  
         		[bookmark: pgfId-530257]This table lists device interfaces on which a DHCP server, DDNS updating, or both are configured. Use the Add Row, Edit Row, and Delete Row buttons to manage these entries.

 [bookmark: pgfId-530262]The Add Row button opens the Add DHCP Server Interface Configuration dialog box, while Edit Row opens the Edit DHCP Server Interface Configuration dialog box. See Add and Edit DHCP Server Interface Configuration Dialog Boxes for more information.

  
        

 
         
         		 
           
           [bookmark: pgfId-530268]Advanced Options
          
  
        

 
         
         		[bookmark: pgfId-530276]Advanced button

  
         		[bookmark: pgfId-530281]Opens the Add/Edit DHCP Server Advanced Configuration Dialog Box.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-532113][bookmark: 115585][bookmark: pxpage_cncpt_EditDHCPServerDialogBox]Add and Edit DHCP Server Interface Configuration Dialog Boxes[bookmark: marker-532107][bookmark: marker-532109][bookmark: marker-532111]

 
     [bookmark: pgfId-532115]Use these dialog boxes to enable DHCP and specify a DHCP address pool for a specified interface, and to enable dynamic DNS (DDNS) updating on the interface.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-532117]Note Other than the titles, the two dialog boxes are identical.


     
      

     

     

 
     [bookmark: pgfId-532119]Navigation Path

 
     [bookmark: pgfId-532124]You can access the Add DHCP Server Interface Configuration and Edit DHCP Server Interface Configuration dialog boxes from the DHCP Server Page.

 
     [bookmark: pgfId-532126]Related Topics

 
      
      		 [bookmark: pgfId-532131]Configuring DHCP Servers

 
     

 
     [bookmark: pgfId-532133]Field Reference

 
     [bookmark: pgfId-532136] 

 
      
       
        
        [bookmark: pgfId-530294]Table 52-10 [bookmark: 115615]Add/Edit DHCP Server Interface Configuration Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-530300]Element
          
  
         		
           
           [bookmark: pgfId-530302]Description
          
  
        

 
         
         		[bookmark: pgfId-530308]Interface

  
         		[bookmark: pgfId-530310]Identifies the interface on which you are configuring a DHCP server. Enter an interface name, or select an interface object.

  
        

 
         
         		[bookmark: pgfId-530316]DHCP Address Pool

  
         		[bookmark: pgfId-530318]Enter an IP address or a range of addresses, separated by a hyphen, that the DHCP server will use when assigning IP addresses. The beginning and ending addresses in the range must be in the same subnet, and the beginning address cannot be greater than the ending address.

  
        

 
         
         		[bookmark: pgfId-530324]Enable DHCP Server

  
         		[bookmark: pgfId-530326]Check this box to enable a DHCP server on this interface.

  
        

 
         
         		[bookmark: pgfId-530332]Enable Dynamic DNS Update

  
         		[bookmark: pgfId-530334]Check this box to enable DDNS updating by this DHCP server. Specify the record(s) to be updated:

 
           
           		 [bookmark: pgfId-530336] PTR Record only

 
           		 [bookmark: pgfId-530338] A Record and PTR Record 

 
          

 [bookmark: pgfId-530340]You also can select Override DHCP Client Request. If selected, DHCP server updates override any updates requested by DHCP clients.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-532150][bookmark: 115655][bookmark: pxpage_cncpt_DHCPServerAdvancedDialogBox]Add/Edit DHCP Server Advanced Configuration Dialog Box[bookmark: marker-532144][bookmark: marker-532146][bookmark: marker-532148]

 
     [bookmark: pgfId-532152]The Add/Edit DHCP Server Advanced Configuration dialog box lets you manage DHCP options configured for the DHCP server. These options provide additional information to DHCP clients. For example, DHCP option 150 and DHCP option 66 provide TFTP server information to Cisco IP Phones and Cisco IOS routers.

 
     [bookmark: pgfId-532154]Navigation Path

 
     [bookmark: pgfId-532159]You can access the Add/Edit DHCP Server Advanced Configuration dialog box by clicking the Advanced button on the DHCP Server Page.

 
     [bookmark: pgfId-532161]Related Topics

 
      
      		 [bookmark: pgfId-532166]Configuring DHCP Servers

 
     

 
     [bookmark: pgfId-532168]Field Reference

 
     [bookmark: pgfId-532171] 

 
      
       
        
        [bookmark: pgfId-530353]Table 52-11 [bookmark: 115684]Add/Edit DHCP Server Advanced Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-530359]Element
          
  
         		
           
           [bookmark: pgfId-530361]Description
          
  
        

 
         
         		[bookmark: pgfId-530367]Options table

  
         		[bookmark: pgfId-530369]This table lists configured DHCP server options. Use the Add Row, Edit Row, and Delete Row buttons to manage these entries.

 [bookmark: pgfId-530374]The Add Row button opens the Add DHCP Server Interface Configuration dialog box, while Edit Row opens the Edit DHCP Server Interface Configuration dialog box. See Add/Edit DHCP Server Option Dialog Box for more information.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-532185][bookmark: 115701][bookmark: pxpage_cncpt_AddEditDHCPServerAdvancedOptionsDialogBox]Add/Edit DHCP Server Option Dialog Box[bookmark: marker-532179][bookmark: marker-532181][bookmark: marker-532183]

 
     [bookmark: pgfId-532187]The Add and Edit DHCP Server Option dialog boxes let you configure DHCP server option parameters, to provide additional information to DHCP clients. For example, DHCP option 150 and DHCP option 66 provide TFTP server information to Cisco IP Phones and Cisco IOS routers.

 
     [bookmark: pgfId-532189]Navigation Path

 
     [bookmark: pgfId-532194]You can access the Add and Edit DHCP Server Option dialog boxes from the Add/Edit DHCP Server Advanced Configuration Dialog Box.

 
     [bookmark: pgfId-532196]Related Topics

 
      
      		 [bookmark: pgfId-532201]Configuring DHCP Servers

 
      		 [bookmark: pgfId-532206]DHCP Server Page

 
     

 
     [bookmark: pgfId-532208]Field Reference

 
     [bookmark: pgfId-532211] 

 
      
       
        
        [bookmark: pgfId-530387]Table 52-12 [bookmark: 115733]Add/Edit DHCP Server Option Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-530393]Element
          
  
         		
           
           [bookmark: pgfId-530395]Description
          
  
        

 
         
         		[bookmark: pgfId-530401]Option Code

  
         		[bookmark: pgfId-530403]Choose an option from the list of available option codes. All DHCP options (options 1 through 255) are supported except 1, 12, 50-54, 58-59, 61, 67, and 82.

 [bookmark: pgfId-530407]Detailed information about DHCP option codes is available on cisco.com: DHCP Options Reference.

  
        

 
         
         		[bookmark: pgfId-530413]Type

  
         		[bookmark: pgfId-530415]Choose the type of information the option returns to the DHCP client:

 
           
           		 [bookmark: pgfId-530417] IP – Choosing this type specifies that one or two IP addresses are returned to the DHCP client. Provide up to two IP addresses.

 
           		 [bookmark: pgfId-530419] ASCII – Choosing this type specifies that an ASCII value is returned to the DHCP client. Provide the ASCII character string, which cannot include spaces.

 
           		 [bookmark: pgfId-530421] HEX – Choosing this type specifies that an hexadecimal value is returned to the DHCP client. Provide the HEX string with an even number of digits and no spaces; you do not need to use a 0x prefix.

 
          

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-532225][bookmark: 115769][bookmark: pxpage_cncpt_DNSPage]DNS Page[bookmark: marker-532219][bookmark: marker-532221][bookmark: marker-532223]

 
    [bookmark: pgfId-532227]Use the DNS page to configure DNS server groups. The firewall device uses these DNS servers to resolve fully-qualified domain names (host names) to IP addresses for SSL VPN, certificates, and FQDN network/host objects used in identity-aware firewall policies. Other features that define server names (such as AAA) do not support DNS resolution—you must enter the IP address or manually resolve the name to an IP address.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-532232]Tip The DefaultDNS server group is predefined on the ASA and is used for FQDN network/host object resolution. If you use FQDN objects, ensure that you configure DNS servers for this group; otherwise, the names cannot be resolved. To enhance security, ensure that you specify DNS servers that are trusted and that are preferably inside your network. For more information, see Requirements for Identity-Aware Firewall Policies.


    
     

    

    

 
    [bookmark: pgfId-532234]Navigation Path

 
     
     		 [bookmark: pgfId-532236](Device view) Select  Platform > Device Admin > Server Access > DNS from the Device Policy selector.

 
     		 [bookmark: pgfId-532238](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Server Access > DNS from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-532240]Related Topics

 
     
     		 [bookmark: pgfId-532245]Add DNS Server Dialog Box

 
    

 
    [bookmark: pgfId-532247]Field Reference

 
    [bookmark: pgfId-532250] 

 
     
      
       
       [bookmark: pgfId-530434]Table 52-13 [bookmark: 115805]DNS Page 

 
       
      
        
        		
          
          [bookmark: pgfId-530440]Element
         
  
        		
          
          [bookmark: pgfId-530442]Description
         
  
       

 
        
        		[bookmark: pgfId-530448]DNS Server Groups table

  
        		[bookmark: pgfId-530450]This table lists the currently defined DNS server groups. Use the Add Row, Edit Row and Delete Row buttons below the table to manage these group entries.

 [bookmark: pgfId-530455]The Add Row button opens the Add DNS Server Group dialog box, and the Edit Row button opens the Edit DNS Server Group dialog box; except for the titles these dialog boxes are identical. See Add DNS Server Group Dialog Box for more information.

  
       

 
        
        		[bookmark: pgfId-530461]DNS Lookup Interfaces

  
        		[bookmark: pgfId-530463]Lists the interfaces on which you want to enable DNS lookup. Enter or Select one or more interfaces or interface roles.

  
       

 
        
        		[bookmark: pgfId-530469]Enable DNS Guard (ASA/PIX 7.0(5), 7.2(x) and 8.x only)

  
        		[bookmark: pgfId-530471]Check this box to enable DNS Guard for the selected device or shared policy. DNS Guard tears down the DNS session associated with a DNS query as soon as the DNS reply is forwarded by the security appliance. DNS Guard also monitors the message exchange to ensure that the ID of the DNS reply matches the ID of the DNS query.

 [bookmark: pgfId-530473]This command is effective only on interfaces for which DNS inspection is disabled. When DNS inspection is enabled, the DNS Guard function is always performed.

 [bookmark: pgfId-530475]Note In releases prior to 7.0(5), the DNS Guard functions are always enabled regardless of the configuration of DNS inspection.

  
       

 
        
        		[bookmark: pgfId-530481]DefaultDNS Server Group (ASA 8.4(2)+)

  
        		[bookmark: pgfId-530483]Additional settings that apply to the DefaultDNS server group only. These settings are used when resolving FQDN network/host objects to IP addresses.

 
          
          		 [bookmark: pgfId-530485] Poll Timer —The time, in minutes, of the polling cycle used to resolve FQDN network/host objects to IP addresses. FQDN objects are resolved only if they are used in a firewall policy. The timer determines the maximum time between resolutions; the DNS entry’s time-to-live (TTL) value is also used to determine when to update to IP address resolution, so individual FQDNs might be resolved more frequently than the polling cycle.

 
         

 [bookmark: pgfId-530487]The default is 240 (four hours). The range is 1 to 65535 minutes.

 
          
          		 [bookmark: pgfId-530489] Expire Entry Timer —The number of minutes after a DNS entry expires (that is, the TTL has passed) that the entry is removed from the DNS lookup table. Removing an entry requires that the table be recompiled, so frequent removals can increase the processing load on the device. Because some DNS entries can have very short TTL (as short as three seconds), you can use this setting to virtually extend the TTL.

 
         

 [bookmark: pgfId-530491]The default is 1 minute (that is, the entry is removed one minute after the TTL has passed). The range is 1 to 65535 minutes.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-532264][bookmark: 115848][bookmark: pxpage_cncpt_AddDNSServerGroupDialogBox]Add DNS Server Group Dialog Box [bookmark: marker-532258][bookmark: marker-532260][bookmark: marker-532262]

 
     [bookmark: pgfId-532266]Use the Add DNS Server Group dialog box to define the DNS servers and settings for a DNS server group, used by security devices to resolve server names to IP addresses in policies that support name resolution.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-532268]Note With the exception of its title, the Edit DNS Server Group dialog box is identical to this one, and the following descriptions apply to both.


     
      

     

     

 
     [bookmark: pgfId-532270]Navigation Path

 
     [bookmark: pgfId-532275]You can access the Add DNS Server Group and Edit DNS Server Group dialog boxes from the DNS Page.

 
     [bookmark: pgfId-532277]Field Reference

 
     [bookmark: pgfId-532280] 

 
      
       
        
        [bookmark: pgfId-530504]Table 52-14 [bookmark: 115872]Add/Edit DNS Server Group Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-530510]Element
          
  
         		
           
           [bookmark: pgfId-530512]Description
          
  
        

 
         
         		[bookmark: pgfId-530518]Name

  
         		[bookmark: pgfId-530520]Provide a name for the group of DNS servers.

 [bookmark: pgfId-530522]Tip The name DefaultDNS is predefined on the ASA and includes the servers used for policies that do not allow the selection of a specific group, such as for FQDN network/host object resolution.  
        

 
         
         		[bookmark: pgfId-530528]DNS Servers

  
         		[bookmark: pgfId-530530]Lists the DNS servers in this group. You can specify up to six servers to which DNS requests can be forwarded. The security appliance tries each DNS server in top-to-bottom order until it receives a response.

 [bookmark: pgfId-530535]Note You also must specify at least one interface on which DNS is enabled in the DNS Lookup section of the DNS Page.

 [bookmark: pgfId-530537]Use the buttons next to this list to manage the entries; from the top down, they are:

 
           
           		 [bookmark: pgfId-530542]Add a DNS server to the list; opens the Add DNS Server Dialog Box.

 
           		 [bookmark: pgfId-530544]Delete the currently selected DNS server entry from the list.

 
           		 [bookmark: pgfId-530546]Move the currently selected entry up one row.

 
           		 [bookmark: pgfId-530548]Move the currently selected entry down one row.

 
          

  
        

 
         
         		[bookmark: pgfId-530554]Timeout

  
         		[bookmark: pgfId-530556]Specify the number of seconds, from 1 to 30, to wait before trying the next DNS server; the default is 2 seconds. Each time the security device retries the list of servers, this timeout doubles.

  
        

 
         
         		[bookmark: pgfId-530562]Retries

  
         		[bookmark: pgfId-530564]Specify the number of times, from 0 to 10, to retry the list of DNS servers when the security device does not receive a response.

  
        

 
         
         		[bookmark: pgfId-530570]Domain Name

  
         		[bookmark: pgfId-530572]Optionally, specify a valid DNS domain name for the server; for example, dnsexample.com.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-532294][bookmark: 115922][bookmark: pxpage_cncpt_AddDNSServerDialogBox]Add DNS Server Dialog Box[bookmark: marker-532288][bookmark: marker-532290][bookmark: marker-532292]

 
     [bookmark: pgfId-532296]Use the Add DNS Server dialog box to add a DNS server to the DNS servers list in the Add DNS Server Group or Edit DNS Server Group dialog boxes.

 
     [bookmark: pgfId-532298]Navigation Path

 
     [bookmark: pgfId-532303]You can access the Add DNS Server dialog box from the Add DNS Server Group or Edit DNS Server Group dialog boxes. For more information about these dialog boxes, see Add DNS Server Group Dialog Box.

 
     [bookmark: pgfId-532305]Related Topics

 
      
      		 [bookmark: pgfId-532310]DNS Page

 
     

 
     [bookmark: pgfId-532312]Field Reference

 
     [bookmark: pgfId-532315] 

 
      
       
        
        [bookmark: pgfId-530585]Table 52-15 [bookmark: 115951]Add DNS Server Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-530591]Element
          
  
         		
           
           [bookmark: pgfId-530593]Description
          
  
        

 
         
         		[bookmark: pgfId-530599]DNS Server

  
         		[bookmark: pgfId-530601]The IP address, or the host network/host object that defines the address, of the DNS server. Enter the address or click Select to select the network/host object from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-530607]Interface (ASA 9.5(1) or higher)

  
         		[bookmark: pgfId-530609]Click select to choose an interface. The Interface selector dialog box lists only Interface Roles and not Physical Interfaces. Therefore you must add a Physical Interface to the Interface Role before selecting the Source Interface. There is no default value for the interface.

 [bookmark: pgfId-530611]This feature is available in Security Manager version 4.9 and later for devices running ASA version 9.5(1) or higher.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-532329][bookmark: 115976][bookmark: pxpage_cncpt_DDNSPage]Configuring DDNS[bookmark: marker-532323][bookmark: marker-532325][bookmark: marker-532327]

 
    [bookmark: pgfId-532331]Dynamic DNS (DDNS) provides IP-address and domain-name mapping updates so hosts can find each other even though their DHCP-assigned IP addresses may change frequently. Also, beginning with the version 7.2(3), Cisco security appliances can generate DDNS updates. The DDNS page is where you configure this feature.

 
    [bookmark: pgfId-532333]The DDNS mappings are maintained on the DHCP server in two types of resource records (RRs): the address or A records contain the name-to-IP-address mappings, while the pointer or PTR records map addresses to host names.

 
    [bookmark: pgfId-532335]By automatically recording the association between assigned addresses and host names at defined intervals, DDNS allows frequently changing address-host name associations to be updated frequently. Mobile hosts, for example, can then move freely on a network without user or administrator intervention.

 
    [bookmark: pgfId-532337]Navigation Path

 
     
     		 [bookmark: pgfId-532339](Device view) Select  Platform > Device Admin > Server Access > DDNS from the Device Policy selector.

 
     		 [bookmark: pgfId-532341](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Server Access > DDNS from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-532343]Field Reference

 
    [bookmark: pgfId-532346] 

 
     
      
       
       [bookmark: pgfId-530624]Table 52-16 [bookmark: 116007]DDNS Page 

 
       
      
        
        		
          
          [bookmark: pgfId-530630]Element
         
  
        		
          
          [bookmark: pgfId-530632]Description
         
  
       

 
        
        		[bookmark: pgfId-530638]Dynamic DNS Interface Settings

  
        		[bookmark: pgfId-530643]This table lists currently defined DDNS interface-update methods. Use the Add Row, Edit Row, and Delete Row buttons below the table to manage these methods; the Add Row and Edit Row buttons open the Add/Edit DDNS Interface Rule Dialog Box.

  
       

 
        
        		[bookmark: pgfId-530649]DHCP Client requests DHCP Server to update records

  
        		[bookmark: pgfId-530651]The global setting on the appliance for DHCP client update requests. This option enables the client to send DDNS updates via the DHCP server, and specifies what is updated: the PTR resource record, both the A and PTR resource records, or neither. Choose Not Selected, Only PTR Record, Both A and PTR Record, or No Update.

  
       

 
        
        		[bookmark: pgfId-530657]DHCP Client ID Interface

  
        		[bookmark: pgfId-530659]Specify the interface(s) for global DHCP client update requests: enter an interface name or IP address, or Select an interface object.

  
       

 
        
        		[bookmark: pgfId-530665]Enable DHCP Client Broadcast

  
        		[bookmark: pgfId-530667]Select this option to allow DHCP clients on the device to broadcast DDNS updates. Available on ASA/PIX 7.2(3)+ devices only.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-532362][bookmark: 116042][bookmark: pxpage_cncpt_AddEditDDNSRuleDialogBox]Add/Edit DDNS Interface Rule Dialog Box [bookmark: marker-532354][bookmark: marker-532356][bookmark: marker-532358][bookmark: marker-532360]

 
     [bookmark: pgfId-532364]Use the Add/Edit DDNS Interface Rule dialog box to manage rules for dynamic DNS updates. These rules are defined on a per-interface basis.

 
     [bookmark: pgfId-532366]Navigation Path

 
     [bookmark: pgfId-532371]You access the Add/Edit DDNS Interface Rule dialog box from the Configuring DDNS.

 
     [bookmark: pgfId-532373]Related Topics

 
      
      		 [bookmark: pgfId-532378]DDNS Update Methods Dialog Box

 
      		 [bookmark: pgfId-532383]Add/Edit DDNS Update Methods Dialog Box

 
     

 
     [bookmark: pgfId-532385]Field Reference

 
     [bookmark: pgfId-532388] 

 
      
       
        
        [bookmark: pgfId-530680]Table 52-17 [bookmark: 116078]Add/Edit DDNS Interface Rule Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-530686]Element
          
  
         		
           
           [bookmark: pgfId-530688]Description
          
  
        

 
         
         		[bookmark: pgfId-530694]Interface

  
         		[bookmark: pgfId-530696]Enter or Select the name of the interface on which DDNS is to be configured.

 [bookmark: pgfId-530698]Note DHCP must be enabled on the specified interface.

  
        

 
         
         		[bookmark: pgfId-530704]Method Name

  
         		[bookmark: pgfId-530709]Choose a previously defined method for DDNS update, or choose Add/Edit Update Method to define a new method; the DDNS Update Methods Dialog Box dialog box opens.

  
        

 
         
         		[bookmark: pgfId-530715]Hostname

  
         		[bookmark: pgfId-530717]Enter the name of the DDNS server host to which updates will be sent.

  
        

 
         
         		[bookmark: pgfId-530723]DHCP Client requests DHCP Server to update records

  
         		[bookmark: pgfId-530725]The setting on the interface for DHCP client update requests; specifies whether the DHCP server updates the PTR resource record, both the A and PTR records, or neither.

 [bookmark: pgfId-530730]Choose Not Selected, Only PTR Record, Both A and PTR Record, or No Update. Any choice other than Not Selected overrides the global setting on the Configuring DDNS.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-532402][bookmark: 116117][bookmark: pxpage_cncpt_DDNSUpdateMethodsDialogBox]DDNS Update Methods Dialog Box [bookmark: marker-532396][bookmark: marker-532398][bookmark: marker-532400]

 
     [bookmark: pgfId-532404]Use the DDNS Update Methods dialog box to manage methods for dynamic DNS updates. Each defined method specifies an update interval and the resource record(s) to be updated.

 
     [bookmark: pgfId-532406]Navigation Path

 
     [bookmark: pgfId-532411]You access the DDNS Update Methods dialog box by choosing Add/Edit Update Method from the Method Name drop-down list in the Add/Edit DDNS Interface Rule Dialog Box.

 
     [bookmark: pgfId-532413]Related Topics

 
      
      		 [bookmark: pgfId-532418]Configuring DDNS

 
     

 
     [bookmark: pgfId-532420]Field Reference

 
     [bookmark: pgfId-532423] 

 
      
       
        
        [bookmark: pgfId-530743]Table 52-18 [bookmark: 116147]DDNS Update Methods Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-530749]Element
          
  
         		
           
           [bookmark: pgfId-530751]Description
          
  
        

 
         
         		[bookmark: pgfId-530757]Update Methods

  
         		[bookmark: pgfId-530759]This table lists the currently defined update methods. Use the buttons below the table to manage these entries.

  
        

 
         
         		[bookmark: pgfId-530765]Add Row button

  
         		[bookmark: pgfId-530770]Opens the Add/Edit DDNS Update Methods Dialog Box where you can define a new update method.

  
        

 
         
         		[bookmark: pgfId-530776]Edit Row button

  
         		[bookmark: pgfId-530781]Opens the Add/Edit DDNS Update Methods Dialog Box, where you can edit the method currently selected in the table.

  
        

 
         
         		[bookmark: pgfId-530787]Delete Row button

  
         		[bookmark: pgfId-530789]Deletes the method currently selected in the Update Methods table; confirmation may be required.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-532437][bookmark: 116179][bookmark: pxpage_cncpt_AddEditDDNSUpdateMethodsDialogBox]Add/Edit DDNS Update Methods Dialog Box [bookmark: marker-532431][bookmark: marker-532433][bookmark: marker-532435]

 
     [bookmark: pgfId-532442]Use the Add/Edit DDNS Update Methods dialog box to define or edit a DDNS update method; currently defined methods are listed in the DDNS Update Methods Dialog Box.

 
     [bookmark: pgfId-532444]Navigation Path

 
     [bookmark: pgfId-532449]You access the Add/Edit DDNS Update Methods dialog box by clicking the Add Row or the Edit Row buttons in the DDNS Update Methods Dialog Box.

 
     [bookmark: pgfId-532451]Related Topics

 
      
      		 [bookmark: pgfId-532456]Configuring DDNS

 
     

 
     [bookmark: pgfId-532458]Field Reference

 
     [bookmark: pgfId-532461] 

 
      
       
        
        [bookmark: pgfId-530802]Table 52-19 [bookmark: 116209]Add/Edit DDNS Update Methods Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-530808]Element
          
  
         		
           
           [bookmark: pgfId-530810]Description
          
  
        

 
         
         		[bookmark: pgfId-530816]Method Name

  
         		[bookmark: pgfId-530818]Provide an identifier for this method.

  
        

 
         
         		[bookmark: pgfId-530824]Update Interval

  
         		[bookmark: pgfId-530826]Specify how often records are to be updated for this method: provide a number of days, hours, minutes, and seconds. Note that while zero is the default value for hours, minutes and seconds, there is no default Day value: you must enter a number for Day.

  
        

 
         
         		[bookmark: pgfId-530832]Update Records

  
         		[bookmark: pgfId-530837]Specify the resource record(s) to be updated: select Not Defined, A Records, or Both A and PTR Records. Selecting A Records or Both A and PTR Records overrides the setting in the Add/Edit DDNS Interface Rule Dialog Box.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-532475][bookmark: 116242][bookmark: pxpage_cncpt_NTPPage-1]NTP Page[bookmark: marker-532469][bookmark: marker-532471][bookmark: marker-532473]

 
    [bookmark: pgfId-532477]Network Time Protocol (NTP) is used to implement a hierarchical system of servers that provide precisely synchronized timing for network systems. This kind of accuracy is required for time-sensitive operations, such as validating Certificate Revocation Lists (CRLs), which include a precise time stamp. You can configure multiple NTP servers. The security device chooses the server with the lowest stratum—a measure of how reliable the data is.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-532479]Note This page is not available on Catalyst 6500 service modules (the Firewall Services Module and the Adaptive Security Appliance Service Module).


    
     

    

    

 
    [bookmark: pgfId-532481]Use the NTP page to enable NTP and manage the NTP servers used to dynamically set the time on a security device.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-532483]Note Time derived from an NTP server overrides any time set manually on the Clock page.


    
     

    

    

 
    [bookmark: pgfId-532485]Navigation Path

 
     
     		 [bookmark: pgfId-532487](Device view) Select  Platform > Device Admin > Server Access > NTP from the Device Policy selector.

 
     		 [bookmark: pgfId-532489](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Server Access > NTP from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-532491]Field Reference

 
    [bookmark: pgfId-532494] 

 
     
      
       
       [bookmark: pgfId-530850]Table 52-20 [bookmark: 116272]NTP Page 

 
       
      
        
        		
          
          [bookmark: pgfId-530856]Element
         
  
        		
          
          [bookmark: pgfId-530858]Description
         
  
       

 
        
        		[bookmark: pgfId-530864]Enable NTP Authentication

  
        		[bookmark: pgfId-530866]Enables or disables authentication with an NTP server. Disabling authentication does not alter the list of configured servers.

 [bookmark: pgfId-530868]If you enable authentication, the security appliance only communicates with an NTP server if it uses the correct trusted key in the packets. The security appliance also uses an authentication key to synchronize with the NTP server.

  
       

 
        
        		[bookmark: pgfId-530874]NTP Server Table

  
        		[bookmark: pgfId-530879]Lists the currently configured NTP servers. Use the Add Row, Edit Row and Delete Row buttons to manage this list; the Add Row and Edit Row buttons open the NTP Server Configuration Dialog Box.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-532508][bookmark: 116294][bookmark: pxpage_cncpt_NTPServerConfigurationDialogBox]NTP Server Configuration Dialog Box[bookmark: marker-532502][bookmark: marker-532504][bookmark: marker-532506]

 
     [bookmark: pgfId-532510]Use the NTP Server Configuration dialog box to add or edit an NTP server definition.

 
     [bookmark: pgfId-532512]Navigation Path

 
     [bookmark: pgfId-532517]You can access the NTP Server Configuration dialog box from the NTP Page.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-532519]Note The NTP page is not available on Catalyst 6500 service modules (the Firewall Services Module and the Adaptive Security Appliance Service Module).


     
      

     

     

 
     [bookmark: pgfId-532521]Field Reference

 
     [bookmark: pgfId-532524] 

 
      
       
        
        [bookmark: pgfId-530892]Table 52-21 [bookmark: 116318]NTP Server Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-530898]Element
          
  
         		
           
           [bookmark: pgfId-530900]Description
          
  
        

 
         
         		[bookmark: pgfId-530906]IP Address

  
         		[bookmark: pgfId-530908]Enter or Select the IP address of the NTP server.

  
        

 
         
         		[bookmark: pgfId-530914]Preferred

  
         		[bookmark: pgfId-530916]If checked, this NTP server is the preferred server when multiple servers are similarly accurate.

 [bookmark: pgfId-530918]NTP uses an algorithm to determine which server is the most accurate and synchronizes to that one. If multiple servers are of similar accuracy, then this option specifies which of those servers to use. However, if a server is significantly more accurate than the preferred one, the security appliance uses the more accurate server. For example, the security appliance uses a server of stratum 2 over a server of stratum 3 that is preferred. We recommend that you configure an NTP server as preferred only when multiple servers are likely to have the same stratum.

  
        

 
         
         		[bookmark: pgfId-530924]Interface

  
         		[bookmark: pgfId-530926]Enter or Select the interface used for NTP traffic, if you want to override the default interface in to the routing table.

  
        

 
         
         		 [bookmark: pgfId-530932]Authentication Key The parameters in this section set the authentication key attributes if you want to use MD5 authentication for communicating with the NTP server.

  
        

 
         
         		[bookmark: pgfId-530940]Key Number

  
         		[bookmark: pgfId-530942]Enter the ID for this authentication key. The NTP server packets must also use this key ID. If you previously configured a key ID for another server, you can select it in the list; otherwise, type a number between 1 and 4294967295.

  
        

 
         
         		[bookmark: pgfId-530948]Trusted

  
         		[bookmark: pgfId-530950]Sets this key as a trusted key. You must select this option for authentication to work.

  
        

 
         
         		[bookmark: pgfId-530956]Key Value

  
         		[bookmark: pgfId-530958]Enter the authentication key as a string up to 32 characters in length.

  
        

 
         
         		[bookmark: pgfId-530964]Confirm

  
         		[bookmark: pgfId-530966]Re-enter the authentication key to verify it is correct.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-532538][bookmark: 116371][bookmark: pxpage_cncpt_SMTPServerPage]SMTP Server Page[bookmark: marker-532532][bookmark: marker-532534][bookmark: marker-532536]

 
    [bookmark: pgfId-532540]Use the SMTP Server page to specify the IP address of an SMTP server and optionally, the IP address of a backup server, to which e-mail alerts and notifications are sent in response to specific events.

 
    [bookmark: pgfId-532542]Navigation Path

 
     
     		 [bookmark: pgfId-532544](Device view) Select  Platform > Device Admin > Server Access > SMTP Server from the Device Policy selector.

 
     		 [bookmark: pgfId-532546](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Server Access > SMTP Server from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-532548]Field Reference

 
    [bookmark: pgfId-532551] 

 
     
      
       
       [bookmark: pgfId-530979]Table 52-22 [bookmark: 116398]SMTP Server Page 

 
       
      
        
        		
          
          [bookmark: pgfId-530985]Element
         
  
        		
          
          [bookmark: pgfId-530987]Description
         
  
       

 
        
        		[bookmark: pgfId-530993]Primary Server IP Address

  
        		[bookmark: pgfId-530995]Enter or Select the IP address of the SMTP server.

  
       

 
        
        		[bookmark: pgfId-531001]Secondary Server IP Address

  
        		[bookmark: pgfId-531003]Enter or Select the IP address of a back-up SMTP server.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-532565][bookmark: 116419][bookmark: pxpage_cncpt_TFTPServerPage]TFTP Server Page[bookmark: marker-532559][bookmark: marker-532561][bookmark: marker-532563]

 
    [bookmark: pgfId-532567]The Trivial File Transfer Protocol (TFTP) is a simple client/server file transfer protocol described in RFC783 and RFC1350 Rev. 2. You can use the TFTP Server page to configure the security appliance as a TFTP client so it can transfer a copy of its running configuration file to a TFTP server. In this way, you can back up and propagate configuration files to multiple security appliances. Only one server is supported.

 
    [bookmark: pgfId-532569]Navigation Path

 
     
     		 [bookmark: pgfId-532571](Device view) Select  Platform > Device Admin > Server Access > TFTP Server from the Device Policy selector.

 
     		 [bookmark: pgfId-532573](Policy view) Select  PIX/ASA/FWSM Platform > Device Admin > Server Access > TFTP Server from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-532575]Field Reference

 
    [bookmark: pgfId-532578] 

 
     
      
       
       [bookmark: pgfId-531016]Table 52-23 [bookmark: 116446]TFTP Server Page 

 
       
      
        
        		
          
          [bookmark: pgfId-531022]Element
         
  
        		
          
          [bookmark: pgfId-531024]Description
         
  
       

 
        
        		[bookmark: pgfId-531030]Interface

  
        		[bookmark: pgfId-531032]Enter or Select the name of interface on which the TFTP server is accessed.

  
       

 
        
        		[bookmark: pgfId-531038]IP Address

  
        		[bookmark: pgfId-531040]Enter or Select the IP address of the TFTP server.

  
       

 
        
        		[bookmark: pgfId-531046]Directory

  
        		[bookmark: pgfId-531048]Enter the path on the TFTP server, beginning with a forward slash (/) and ending in the file name, to which the configuration files will be written (for example, /tftpboot/asa/config3).

 [bookmark: pgfId-531050]Note The path must begin with a forward slash (/).

  
       

 
      
     

 
    
 
   
 
  

 
  
   
 

OPS/rptmgmt-7.jpg





OPS/pxbridging.html
  
   
    
     [bookmark: pgfId-476445][bookmark: 108616][bookmark: pxchap_cncpt_ConfiguringBridgingPoliciesonFirewallDevices]Configuring Bridging Policies on Firewall Devices[bookmark: marker-476439][bookmark: marker-476441][bookmark: marker-476443]
      
      
 
     
 

 
    [bookmark: pgfId-476447]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-476452]About Bridging on Firewall Devices

 
     		 [bookmark: pgfId-476457]Bridging Support for FWSM 3.1

 
     		 [bookmark: pgfId-476462]ARP Table Page

 
     		 [bookmark: pgfId-476467]ARP Inspection Page

 
     		 [bookmark: pgfId-476472]Managing the IPv6 Neighbor Cache

 
     		 [bookmark: pgfId-476477]MAC Address Table Page

 
     		 [bookmark: pgfId-476482]MAC Learning Page

 
     		 [bookmark: pgfId-476487]Management IP Page

 
     		 [bookmark: pgfId-476492]Management IPv6 Page (ASA 5505)

 
    

 
   
 
    
     [bookmark: pgfId-476506][bookmark: 108628][bookmark: pxchap_cncpt_AboutBridgingonFirewallDevices]About Bridging on Firewall Devices[bookmark: marker-476498][bookmark: marker-476500][bookmark: marker-476502][bookmark: marker-476504]

 
    [bookmark: pgfId-476508]Traditionally, a firewall is a routed hop and acts as a default gateway for hosts that connect to one of its screened subnets. A transparent firewall, on the other hand, is a Layer 2 device that acts like a “bump in the wire,” or a “stealth firewall,” and is not seen as a router hop to connected devices. The security appliance connects the same network on its inside and outside ports, acting as an access-control bridge; you assign different VLANs to each interface, and IP addressing is not used.

 
    [bookmark: pgfId-476510]Thus, you can easily introduce a transparent firewall into an existing network—IP re-addressing is unnecessary—and maintenance is facilitated because there are no complicated routing patterns to troubleshoot and no NAT configuration.

 
    [bookmark: pgfId-476512]Although the transparent-mode device acts as a bridge, Layer 3 traffic, such as IP traffic, cannot pass through the security appliance unless you explicitly permit it with specific access rules. The only traffic allowed through a firewall without an access list is ARP traffic, which you can control using ARP inspection, and IPv6 neighbor discovery.

 
    [bookmark: pgfId-476514]When the security appliance runs in transparent mode, the outgoing interface of a packet is determined by performing a MAC address lookup instead of a route lookup. Route statements can still be configured, but they apply only to security appliance-originated traffic. For example, if your syslog server is located on a remote network, you must use a static route so the security appliance can reach that subnet.

 
    [bookmark: pgfId-476516]To configure a transparent firewall, use the following policies. When configuring an ASA/PIX/FWSM device in multiple-context mode, configure these policies on each transparent security context.

 
     
     		 [bookmark: pgfId-476518] Firewall > Access Rules —Access rules control layer 3 and higher traffic using extended access control lists. In routed mode, some types of traffic cannot pass through the security appliance even if you allow it in an access list. For example, you can establish routing protocol adjacencies through a transparent firewall; you can allow OSPF, RIP, EIGRP, or BGP traffic through based on access rules. Likewise, protocols like HSRP or VRRP can pass through the security appliance. However, the transparent-mode security appliance does not pass CDP packets.

 
    

 
    [bookmark: pgfId-476520]For features that are not directly supported on the transparent firewall, you can allow traffic to pass through so that upstream and downstream routers can provide those functions. For example, by using access rules, you can allow DHCP traffic to pass (instead of the unsupported DHCP relay feature), or multicast traffic such as that created by IP/TV.

 
    [bookmark: pgfId-476528]For more information, see Understanding Access Rules and Configuring Access Rules.

 
     
     		 [bookmark: pgfId-476533] Firewall > Transparent Rules —Transparent rules control non-IP layer 2 traffic using Ethertype access control lists. For example, you can configure rules to allow AppleTalk, IPX, BPDUs, and MPLS to pass through the device. For more information, see Configuring Transparent Firewall Rules.

 
     		 [bookmark: pgfId-476541] Platform > Bridging > ARP Table ,  ARP Inspection and  IPv6 Neighbor Cache —Use these policies to control the types of ARP and IPv6 traffic allowed through the bridge. If desired, you can configure static ARP and IPv6 neighbor cache entries and drop any traffic not defined by those static rules. Enable ARP inspection so that if a mismatch between the MAC address, the IP address, or the interface occurs, the security appliance drops the packet. This helps prevent ARP spoofing. For more information, see ARP Table Page and ARP Inspection Page.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-476543]Note The ARP Table and IPv6 Neighbor Cache are the only bridging policies available for non-transparent ASA/PIX/FWSM devices.


    
     

    

    

 
     
     		 [bookmark: pgfId-476551] Platform > Bridging > MAC Address Table and  MAC Learning —Use these policies to configure static MAC-IP address mappings and to enable or disable MAC learning. MAC learning is enabled by default, which allows the appliance to add MAC-IP address mappings as traffic passes through the interface. If you want to prevent all traffic except from static entries, you can disable MAC learning. For more information, see MAC Address Table Page and MAC Learning Page.

 
     		 [bookmark: pgfId-476553] Platform > Bridging > Management IP and  Platform > Bridging > Management IPv6 —Use these policies to configure a management IP address that Security Manager can use to communicate with the device.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-476555]Note The Management IP and Management IPv6 pages are not available on Catalyst 6500 service modules (the Firewall Services Module and the Adaptive Security Appliance Service Module).


    
     

    

    

 
    [bookmark: pgfId-476557]If you change the management IP address, you also need to update the device properties for the device or security context. Follow these steps:

 
    [bookmark: pgfId-476559] – Change the management IP address, save and submit your changes.

 
    [bookmark: pgfId-476561] – Deploy your changes to the device.

 
    [bookmark: pgfId-476563] – In Device view, select the device or security context, then select Tools > Device Properties. On the General page, enter the new management IP address in the IP Address field. On the Credentials tab, update the username and password fields with account credentials that can log into the management interface. Security Manager will now use this address and user account for subsequent deployments and device communication.

 
    [bookmark: pgfId-476568]For more information, see Management IP Page.

 
    [bookmark: pgfId-476570]Related Topics

 
     
     		 [bookmark: pgfId-476575]Bridging Support for FWSM 3.1

 
     		 [bookmark: pgfId-476580]Interfaces in Routed and Transparent Modes

 
     		 [bookmark: pgfId-476585]Transparent Rules Page

 
    

 
   
 
    
     [bookmark: pgfId-476595][bookmark: 108703][bookmark: pxchap_cncpt_BridgingSupportforFWSM]Bridging Support for FWSM 3.1[bookmark: marker-476591][bookmark: marker-476593]

 
    [bookmark: pgfId-476597]Although FWSM 3.1 can support multiple L2 interface pairs, Security Manager lets you specify no more than two L2 interfaces (a single interface pair), and one associated management IP address. That means only one bridge group with two named interfaces associated is provisioned with a management IP address. If the device configuration contains a maximum of one bridge group and two named interfaces, it is valid for discovery. All other scenarios result in an error message and the commands are ignored during discovery. Furthermore, discovery will not show any bridge-group information in Security Manager, although the bridge-group commands will be generated during deployment. Bridge group 1 will be deployed and used in transparent rule policies if no bridge group exists in the device configuration.

 
    [bookmark: pgfId-476599]Related Topics

 
     
     		 [bookmark: pgfId-476604]About Bridging on Firewall Devices

 
    

 
   
 
    
     [bookmark: pgfId-476618][bookmark: 108719][bookmark: pxpage_cncpt_ARPTablePage]ARP Table Page[bookmark: marker-476612][bookmark: marker-476614][bookmark: marker-476616]

 
    [bookmark: pgfId-476622][bookmark: marker-476620] Use the ARP Table page to add static ARP entries that map a MAC address to an IP address and identifies the interface through which the host is reached.

 
    [bookmark: pgfId-476624]Navigation Path

 
     
     		 [bookmark: pgfId-476626](Device view) Select  Platform > Bridging > ARP Table from the Device Policy selector.

 
     		 [bookmark: pgfId-476628](Policy view) Select  PIX/ASA/FWSM Platform > Bridging > ARP Table from the Policy Type selector. Right-click  ARP Table to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-476630]Related Topics

 
     
     		 [bookmark: pgfId-476635]Add/Edit ARP Configuration Dialog Box

 
     		 [bookmark: pgfId-476640]About Bridging on Firewall Devices

 
     		 [bookmark: pgfId-476645]ARP Inspection Page

 
     		 [bookmark: pgfId-476650]MAC Address Table Page

 
     		 [bookmark: pgfId-476655]MAC Learning Page

 
     		 [bookmark: pgfId-476660]Management IP Page

 
    

 
    [bookmark: pgfId-476662]Field Reference

 
    [bookmark: pgfId-476665] 

 
     
      
       
       [bookmark: pgfId-475256]Table 47-1 [bookmark: 108771]ARP Table Page 

 
       
      
        
        		
          
          [bookmark: pgfId-475262]Element
         
  
        		
          
          [bookmark: pgfId-475264]Description
         
  
       

 
        
        		[bookmark: pgfId-475270]Timeout (seconds)

  
        		[bookmark: pgfId-475272]The amount of time, between 60 and 4294967 seconds, before the security appliance rebuilds the ARP table. The default is 14400 seconds.

 [bookmark: pgfId-475274]Rebuilding the ARP table automatically updates new host information and removes old host information. You might want to reduce the timeout because the host information changes frequently.

 ARP table, and not the static entries contained in the ARP table.

  
       

 
        
        		 
          
          [bookmark: pgfId-475282]ARP Table
         
  
       

 
        
        		[bookmark: pgfId-475290]Interface

  
        		[bookmark: pgfId-475292]The interface to which the host is attached.

  
       

 
        
        		[bookmark: pgfId-475298]IP Address

  
        		[bookmark: pgfId-475300]The IP address of the host.

  
       

 
        
        		[bookmark: pgfId-475306]MAC Address

  
        		[bookmark: pgfId-475308]The MAC address of the host.

  
       

 
        
        		[bookmark: pgfId-475314]Alias Enabled

  
        		[bookmark: pgfId-475316]Indicates whether the security appliance performs proxy ARP for this mapping. If this setting is enabled and the security appliance receives an ARP request for the specified IP address, it responds with the security appliance MAC address. When the security appliance receives traffic destined for the host belonging to the IP address, the security appliance forwards the traffic to the host MAC address that you specify in this command. This feature is useful if you have devices that do not perform ARP, for example.

 [bookmark: pgfId-475318]Note In transparent firewall mode, this setting is ignored and the security appliance does not perform proxy ARP.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-476679][bookmark: 108815][bookmark: pxpage_cncpt_AddEditARPTableEntryDialogBox]Add/Edit ARP Configuration Dialog Box[bookmark: marker-476673][bookmark: marker-476675][bookmark: marker-476677]

 
     [bookmark: pgfId-476683][bookmark: marker-476681] Use the Add/Edit ARP Configuration dialog box to add a static ARP entry that maps a MAC address to an IP address and identifies the interface through which the host is reached.

 
     [bookmark: pgfId-476685]Navigation Path

 
     [bookmark: pgfId-476690]You can access the Add/Edit ARP Configuration dialog box from the ARP Table page. For more information about the ARP Table page, see ARP Table Page.

 
     [bookmark: pgfId-476692]Related Topics

 
      
      		 [bookmark: pgfId-476697]About Bridging on Firewall Devices

 
      		 [bookmark: pgfId-476702]ARP Table Page

 
     

 
     [bookmark: pgfId-476704]Field Reference

 
     [bookmark: pgfId-476707] 

 
      
       
        
        [bookmark: pgfId-475331]Table 47-2 [bookmark: 108849]Add/Edit ARP Configuration dialog box 

 
        
       
         
         		
           
           [bookmark: pgfId-475337]Element
          
  
         		
           
           [bookmark: pgfId-475339]Description
          
  
        

 
         
         		[bookmark: pgfId-475345]Interface

  
         		[bookmark: pgfId-475347]The name of the interface to which the host network is attached.

  
        

 
         
         		[bookmark: pgfId-475353]IP Address

  
         		[bookmark: pgfId-475355]The IP address of the host.

  
        

 
         
         		[bookmark: pgfId-475361]MAC Address

  
         		[bookmark: pgfId-475363]The MAC address of the host; for example, 00e0.1e4e.3d8b.

  
        

 
         
         		[bookmark: pgfId-475369]Enable Alias

  
         		[bookmark: pgfId-475371]When selected, enables proxy ARP for this mapping. If the security appliance receives an ARP request for the specified IP address, it responds with the security appliance MAC address. When the security appliance receives traffic destined for the host belonging to the IP address, the security appliance forwards the traffic to the host MAC address that you specify in this command. This feature is useful if you have devices that do not perform ARP, for example.

 [bookmark: pgfId-475373]Note In transparent firewall mode, this setting is ignored and the security appliance does not perform proxy ARP.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-476721][bookmark: 108882][bookmark: pxpage_cncpt_ARPInspectionPage]ARP Inspection Page[bookmark: marker-476715][bookmark: marker-476717][bookmark: marker-476719]

 
    [bookmark: pgfId-476723]Use the ARP Inspection page to configure ARP inspection for a transparent firewall. ARP inspection is used to prevent ARP spoofing.

 
    [bookmark: pgfId-476725]Navigation Path

 
     
     		 [bookmark: pgfId-476727](Device view) Select  Platform > Bridging > ARP Inspection from the Device Policy selector.

 
     		 [bookmark: pgfId-476729](Policy view) Select  PIX/ASA/FWSM Platform > Bridging > ARP Inspection from the Policy Type selector. Right-click  ARP Inspection to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-476731]Related Topics

 
     
     		 [bookmark: pgfId-476736]Add/Edit ARP Inspection Dialog Box

 
     		 [bookmark: pgfId-476741]About Bridging on Firewall Devices

 
     		 [bookmark: pgfId-476746]ARP Table Page

 
     		 [bookmark: pgfId-476751]MAC Address Table Page

 
     		 [bookmark: pgfId-476756]MAC Learning Page

 
     		 [bookmark: pgfId-476761]Management IP Page

 
    

 
    [bookmark: pgfId-476763]Field Reference

 
    [bookmark: pgfId-476766] 

 
     
      
       
       [bookmark: pgfId-475386]Table 47-3 [bookmark: 108931]ARP Inspection Page 

 
       
      
        
        		
          
          [bookmark: pgfId-475392]Element
         
  
        		
          
          [bookmark: pgfId-475394]Description
         
  
       

 
        
        		 
          
          [bookmark: pgfId-475400]ARP Inspection Table
         
  
       

 
        
        		[bookmark: pgfId-475408]Interface

  
        		[bookmark: pgfId-475410]The name of the interface to which the ARP inspection setting applies.

  
       

 
        
        		[bookmark: pgfId-475416]ARP Inspection Enabled

  
        		[bookmark: pgfId-475418]Indicates whether ARP inspection is enabled on the specified interface.

  
       

 
        
        		[bookmark: pgfId-475424]Flood Enabled

  
        		[bookmark: pgfId-475426]Indicates whether packets that do not match any element of a static ARP entry should be flooded out all interfaces except the originating interface. If there is a mismatch between the MAC address, the IP address, or the interface, the security appliance drops the packet. If you do not select this check box, all non-matching packets are dropped.

 [bookmark: pgfId-475428]Note The dedicated management interface, if present, never floods packets even if this parameter is set to flood.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-476780][bookmark: 108962][bookmark: pxpage_cncpt_AddEditARPInspectionDialogBox]Add/Edit ARP Inspection Dialog Box[bookmark: marker-476774][bookmark: marker-476776][bookmark: marker-476778]

 
     [bookmark: pgfId-476782]Use the Add/Edit ARP Inspection dialog box to enable or disable ARP inspection for a transparent firewall interface.

 
     [bookmark: pgfId-476784]Navigation Path

 
     [bookmark: pgfId-476789]You can access the Add/Edit ARP Inspection dialog box from the ARP Inspection page. For more information about the ARP Inspection page, see ARP Inspection Page.

 
     [bookmark: pgfId-476791]Related Topics

 
      
      		 [bookmark: pgfId-476796]About Bridging on Firewall Devices

 
      		 [bookmark: pgfId-476801]ARP Inspection Page

 
     

 
     [bookmark: pgfId-476803]Field Reference

 
     [bookmark: pgfId-476806] 

 
      
       
        
        [bookmark: pgfId-475441]Table 47-4 [bookmark: 108994]Add/Edit ARP Inspection dialog box 

 
        
       
         
         		
           
           [bookmark: pgfId-475447]Element
          
  
         		
           
           [bookmark: pgfId-475449]Description
          
  
        

 
         
         		[bookmark: pgfId-475455]Interface

  
         		[bookmark: pgfId-475457]The name of the interface for which you are enabling or disabling ARP inspection.

  
        

 
         
         		[bookmark: pgfId-475463]Enable ARP Inspection on this interface

  
         		[bookmark: pgfId-475465]When selected, enables ARP inspection on the specified interface.

  
        

 
         
         		[bookmark: pgfId-475471]Flood ARP packets

  
         		[bookmark: pgfId-475473]When selected, packets that do not match any element of a static ARP entry are flooded out all interfaces except the originating interface. If there is a mismatch between the MAC address, the IP address, or the interface, the security appliance drops the packet. If you do not select this check box, all non-matching packets are dropped.

 [bookmark: pgfId-475475]Note The dedicated management interface, if present, never floods packets even if this parameter is set to flood.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-476820][bookmark: 109022][bookmark: pxchap_cncpt_IPv6NeighborCache]Managing the IPv6 Neighbor Cache[bookmark: marker-476816][bookmark: marker-476818]

 
    [bookmark: pgfId-476822]Use the IPv6 Neighbor Cache page to manage static IPv6 neighbor entries that map a MAC address to an IPv6 address, and identify the interface through which the neighbor host is reached, to provide address-resolution functions for IPv6. This is available on ASA 7.0+ devices only.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-476827]Note The IPv6 Neighbor Cache entries are the IPv6 equivalent of the static ARP entries, managed on the ARP Table Page.


    
     

    

    

 
    [bookmark: pgfId-476829]If an entry for a specified IPv6 address already exists in the neighbor discovery cache—learned through the IPv6 neighbor discovery process—the entry is automatically converted to a static entry. Static entries in the IPv6 neighbor discovery cache are not modified by the neighbor discovery process.

 
    [bookmark: pgfId-476834]The IPv6 Neighbor Cache page is a standard Security Manager table, with Add Row, Edit Row and Delete Row buttons. (These are standard buttons, as described in Using Tables.) The Add Row button opens the Add IPv6 Neighbor Cache Configuration dialog box, and Edit Row opens the Edit IPv6 Neighbor Cache Configuration dialog box. Other than the titles, the two dialog boxes are identical.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-476836]Note Ensure that IPv6 is enabled on at least one interface before trying to add a neighbor.


    
     

    

    

 
    [bookmark: pgfId-476838]Field Reference

 
    [bookmark: pgfId-476841] 

 
     
      
       
       [bookmark: pgfId-475488]Table 47-5 [bookmark: 109041]Add/Edit IPv6 Neighbor Cache Configuration dialog boxes 

 
       
      
        
        		
          
          [bookmark: pgfId-475494]Element
         
  
        		
          
          [bookmark: pgfId-475496]Description
         
  
       

 
        
        		[bookmark: pgfId-475502]Interface

  
        		[bookmark: pgfId-475504]Enter or Select the name of the interface on which to add the neighbor.

  
       

 
        
        		[bookmark: pgfId-475510]IP Address

  
        		[bookmark: pgfId-475512]Enter the IPv6 address that corresponds to the local data-link address. (If an entry for the specified IPv6 address already exists in the neighbor discovery cache—learned through the IPv6 neighbor discovery process—the entry is automatically converted to a static entry.)

  
       

 
        
        		[bookmark: pgfId-475518]MAC Address

  
        		[bookmark: pgfId-475520]Enter the local data-line (hardware) MAC address of the host; for example, 00e0.1e4e.3d8b.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-476855][bookmark: 109067][bookmark: pxpage_cncpt_MACAddressTablePage]MAC Address Table Page[bookmark: marker-476849][bookmark: marker-476851][bookmark: marker-476853]

 
    [bookmark: pgfId-476857]Use the MAC Address Table page to add static MAC address entries to the MAC Address table. The table associates the MAC address with the source interface so that the security appliance knows to send any packets addressed to the device out the correct interface.

 
    [bookmark: pgfId-476859]Navigation Path

 
     
     		 [bookmark: pgfId-476861](Device view) Select  Platform > Bridging > MAC Address Table from the Device Policy selector.

 
     		 [bookmark: pgfId-476863](Policy view) Select  PIX/ASA/FWSM Platform > Bridging > MAC Address Table from the Policy Type selector. Right-click  MAC Address Table to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-476865]Related Topics

 
     
     		 [bookmark: pgfId-476870]Add/Edit MAC Table Entry Dialog Box

 
     		 [bookmark: pgfId-476875]About Bridging on Firewall Devices

 
     		 [bookmark: pgfId-476880]ARP Table Page

 
     		 [bookmark: pgfId-476885]ARP Inspection Page

 
     		 [bookmark: pgfId-476890]MAC Learning Page

 
     		 [bookmark: pgfId-476895]Management IP Page

 
    

 
    [bookmark: pgfId-476897]Field Reference

 
    [bookmark: pgfId-476900] 

 
     
      
       
       [bookmark: pgfId-475533]Table 47-6 [bookmark: 109116]MAC Address Table Page 

 
       
      
        
        		
          
          [bookmark: pgfId-475539]Element
         
  
        		
          
          [bookmark: pgfId-475541]Description
         
  
       

 
        
        		[bookmark: pgfId-475547]Aging Time (minutes)

  
        		[bookmark: pgfId-475549]Sets the number of minutes, between 5 and 720 (12 hours), that a MAC address entry stays in the MAC address table before timing out. 5 minutes is the default.

  
       

 
        
        		 
          
          [bookmark: pgfId-475555]MAC Address Table
         
  
       

 
        
        		[bookmark: pgfId-475563]Interface

  
        		[bookmark: pgfId-475565]The interface to which the MAC address is associated.

  
       

 
        
        		[bookmark: pgfId-475571]MAC Address

  
        		[bookmark: pgfId-475573]The MAC address; for example, 00e0.1e4e.3d8b.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-476914][bookmark: 109146][bookmark: pxpage_cncpt_AddEditMACTableEntryDialogBox]Add/Edit MAC Table Entry Dialog Box[bookmark: marker-476908][bookmark: marker-476910][bookmark: marker-476912]

 
     [bookmark: pgfId-476916]Use the Add/Edit MAC Table Entry dialog box to add static MAC address entries to the MAC Address table or to modify entries in the MAC Address table.

 
     [bookmark: pgfId-476918]Navigation Path

 
     [bookmark: pgfId-476923]You can access the Add/Edit MAC Table Entry dialog box from the MAC Address Table page. For more information about the MAC Address Table page, see MAC Address Table Page.

 
     [bookmark: pgfId-476925]Related Topics

 
      
      		 [bookmark: pgfId-476930]About Bridging on Firewall Devices

 
      		 [bookmark: pgfId-476935]MAC Address Table Page

 
     

 
     [bookmark: pgfId-476937]Field Reference

 
     [bookmark: pgfId-476940] 

 
      
       
        
        [bookmark: pgfId-475586]Table 47-7 [bookmark: 109178]Add/Edit MAC Table Entry dialog box 

 
        
       
         
         		
           
           [bookmark: pgfId-475592]Element
          
  
         		
           
           [bookmark: pgfId-475594]Description
          
  
        

 
         
         		[bookmark: pgfId-475600]Interface

  
         		[bookmark: pgfId-475602]The interface to which the MAC address is associated.

  
        

 
         
         		[bookmark: pgfId-475608]MAC Address

  
         		[bookmark: pgfId-475610]The MAC address; for example, 00e0.1e4e.3d8b.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-476954][bookmark: 109200][bookmark: pxpage_cncpt_MACLearningPage]MAC Learning Page[bookmark: marker-476948][bookmark: marker-476950][bookmark: marker-476952]

 
    [bookmark: pgfId-476956]Use the MAC Learning page to enable or disable MAC address learning on an interface. By default, each interface learns the MAC addresses of entering traffic, and the security appliance adds corresponding entries to the MAC address table. You can disable MAC address learning if desired; however, unless you statically add MAC addresses to the table, no traffic can pass through the security appliance.

 
    [bookmark: pgfId-476958]Navigation Path

 
     
     		 [bookmark: pgfId-476960](Device view) Select  Platform > Bridging > MAC Learning from the Device Policy selector.

 
     		 [bookmark: pgfId-476962](Policy view) Select  PIX/ASA/FWSM Platform > Bridging > MAC Learning from the Policy Type selector. Right-click  MAC Learning to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-476964]Related Topics

 
     
     		 [bookmark: pgfId-476969]Add/Edit MAC Learning Dialog Box

 
     		 [bookmark: pgfId-476974]About Bridging on Firewall Devices

 
     		 [bookmark: pgfId-476979]ARP Table Page

 
     		 [bookmark: pgfId-476984]ARP Inspection Page

 
     		 [bookmark: pgfId-476989]MAC Address Table Page

 
     		 [bookmark: pgfId-476994]Management IP Page

 
    

 
    [bookmark: pgfId-476996]Field Reference

 
    [bookmark: pgfId-476999] 

 
     
      
       
       [bookmark: pgfId-475623]Table 47-8 [bookmark: 109249]MAC Learning Page 

 
       
      
        
        		
          
          [bookmark: pgfId-475629]Element
         
  
        		
          
          [bookmark: pgfId-475631]Description
         
  
       

 
        
        		 
          
          [bookmark: pgfId-475637]MAC Learning Table
         
  
       

 
        
        		[bookmark: pgfId-475645]Interface

  
        		[bookmark: pgfId-475647]The interface to which the MAC learning setting applies.

  
       

 
        
        		[bookmark: pgfId-475653]MAC Learning Enabled

  
        		[bookmark: pgfId-475655]Indicates whether the security appliance learns MAC addresses from traffic entering the interface.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-477013][bookmark: 109274][bookmark: pxpage_cncpt_AddEditMACLearningDialogBox]Add/Edit MAC Learning Dialog Box[bookmark: marker-477007][bookmark: marker-477009][bookmark: marker-477011]

 
     [bookmark: pgfId-477015]Use the Add/Edit MAC Learning dialog box to enable or disable MAC address learning on an interface.

 
     [bookmark: pgfId-477017]Navigation Path

 
     [bookmark: pgfId-477022]You can access the Add/Edit MAC Learning dialog box from the MAC Learning page. For more information about the MAC Learning page, see MAC Learning Page.

 
     [bookmark: pgfId-477024]Related Topics

 
      
      		 [bookmark: pgfId-477029]About Bridging on Firewall Devices

 
      		 [bookmark: pgfId-477034]MAC Learning Page

 
     

 
     [bookmark: pgfId-477036]Field Reference

 
     [bookmark: pgfId-477039] 

 
      
       
        
        [bookmark: pgfId-475668]Table 47-9 [bookmark: 109306]Add/Edit MAC Learning dialog box 

 
        
       
         
         		
           
           [bookmark: pgfId-475674]Element
          
  
         		
           
           [bookmark: pgfId-475676]Description
          
  
        

 
         
         		[bookmark: pgfId-475682]Interface

  
         		[bookmark: pgfId-475684]The interface to which the MAC learning setting applies.

  
        

 
         
         		[bookmark: pgfId-475690]MAC Learning Enabled

  
         		[bookmark: pgfId-475692]When selected, the security appliance learns MAC addresses from traffic entering the interface.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-477053][bookmark: 109328][bookmark: pxpage_cncpt_ManagementIPPage]Management IP Page[bookmark: marker-477047][bookmark: marker-477049][bookmark: marker-477051]

 
    [bookmark: pgfId-477055]A transparent firewall does not participate in IP routing. The only IP configuration required for the device is specification of a management IP address, which is used as the source address for traffic originating on the device, such as system messages or communications with AAA servers. You can also use this address for remote-management access.

 
    [bookmark: pgfId-477057]For IPv4 traffic, the management IP address is required to pass any traffic.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-477059]Note In addition to the management IP address for the device, you can configure an IP address for the Management 0/0 or 0/1 management-only interface. This IP address can be on a separate subnet from the main management IP address.


    
     

    

    

 
    [bookmark: pgfId-477061]Use the Management IP page to set the management IP address for a security device, or for a context in transparent firewall mode.

 
    [bookmark: pgfId-477063]Navigation Path

 
     
     		 [bookmark: pgfId-477065](Device view) Select  Platform > Bridging > Management IP from the Device Policy selector.

 
     		 [bookmark: pgfId-477067](Policy view) Select  PIX/ASA/FWSM Platform > Bridging > Management IP from the Policy Type selector. Right-click  Management IP to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-477069]Related Topics

 
     
     		 [bookmark: pgfId-477074]About Bridging on Firewall Devices

 
     		 [bookmark: pgfId-477079]ARP Table Page

 
     		 [bookmark: pgfId-477084]ARP Inspection Page

 
     		 [bookmark: pgfId-477089]MAC Address Table Page

 
     		 [bookmark: pgfId-477094]MAC Learning Page

 
    

 
    [bookmark: pgfId-477096]Field Reference

 
    [bookmark: pgfId-477099] 

 
     
      
       
       [bookmark: pgfId-475705]Table 47-10 [bookmark: 109376]Management IP Page 

 
       
      
        
        		
          
          [bookmark: pgfId-475711]Element
         
  
        		
          
          [bookmark: pgfId-475713]Description
         
  
       

 
        
        		[bookmark: pgfId-475719]Management IP Address

  
        		[bookmark: pgfId-475721]The management IP address.

  
       

 
        
        		[bookmark: pgfId-475727]Subnet Mask

  
        		[bookmark: pgfId-475729]The subnet mask that corresponds to the management IP address.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-477113][bookmark: 109397][bookmark: pxpage_cncpt_ManagementIPv6Page]Management IPv6 Page (ASA 5505) [bookmark: marker-477107][bookmark: marker-477109][bookmark: marker-477111]

 
    [bookmark: pgfId-477115]A transparent firewall does not participate in IP routing. The only IP configuration required for the device is specification of a management IP address, which is used as the source address for traffic originating on the device, such as system messages or communications with AAA servers. You can also use this address for remote-management access.

 
    [bookmark: pgfId-477120]For IPv6 traffic, you must, at a minimum, configure the link-local addresses to pass traffic, but a global management address is recommended for full functionality, including remote management and other management operations. If you configure the global address, a link-local address is automatically configured on each interface, so you do not also need to specifically configure a link-local address. However, if you do not configure a global management address, you need to configure interface link-local addresses, as described in Configuring IPv6 Interfaces (ASA/FWSM). Note that you can configure both IPv6 and IPv4 management addresses on a device.

 
    [bookmark: pgfId-477122]On an ASA 5505 in transparent mode, use the Management IPv6 page to enable IPv6, configure neighbor solicitation, and manage IPv6 interface addresses.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-477124]Note This page is available only on ASA 5505 version 8.2 and 8.3 devices in transparent mode.


    
     

    

    

 
    [bookmark: pgfId-477126]Navigation Path

 
     
     		 [bookmark: pgfId-477128](Device view) Select  Platform > Bridging > Management IPv6 from the Device Policy selector.

 
     		 [bookmark: pgfId-477130](Policy view) Select  PIX/ASA/FWSM Platform > Bridging > Management IPv6 from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-477132]Related Topics

 
     
     		 [bookmark: pgfId-477137]About Bridging on Firewall Devices

 
     		 [bookmark: pgfId-477142]ARP Table Page

 
     		 [bookmark: pgfId-477147]ARP Inspection Page

 
     		 [bookmark: pgfId-477152]MAC Address Table Page

 
     		 [bookmark: pgfId-477157]MAC Learning Page

 
    

 
    [bookmark: pgfId-477159]Field Reference

 
    [bookmark: pgfId-477162] 

 
     
      
       
       [bookmark: pgfId-475742]Table 47-11 [bookmark: 109445]Management IPv6 Page 

 
       
      
        
        		
          
          [bookmark: pgfId-475748]Element
         
  
        		
          
          [bookmark: pgfId-475750]Description
         
  
       

 
        
        		[bookmark: pgfId-475756]Enable IPv6

  
        		[bookmark: pgfId-475758]Check this box to enable IPv6 and configure IPv6 management-interface addresses. You can deselect this option to disable IPv6, but retain the configuration information.

  
       

 
        
        		[bookmark: pgfId-475764]DAD Attempts

  
        		[bookmark: pgfId-475766]To specify the number of consecutive neighbor solicitation messages that are sent on an interface during duplicate address detection (DAD), enter a number from 0 to 600 in this field. Entering 0 disables duplicate address detection. Entering 1 configures a single transmission without follow-up transmissions; this is the default.

 [bookmark: pgfId-475768]Duplicate address detection verifies the uniqueness of new unicast IPv6 addresses before the addresses are assigned to interfaces (the new addresses remain in a tentative state while duplicate address detection is performed). Duplicate address detection uses neighbor solicitation messages to verify the uniqueness of unicast IPv6 addresses.

 [bookmark: pgfId-475770]When duplicate address detection identifies a duplicate address, the state of the address is set to DUPLICATE and the address is not used. If the duplicate address is the link-local address of the interface, the processing of IPv6 packets is disabled on the interface and an error message similar to the following is issued:

 [bookmark: pgfId-475772]%PIX-4-DUPLICATE: Duplicate address FE80::1 on outside

 [bookmark: pgfId-475774]If the duplicate address is a global address of the interface, the address is not used and an error message is issued, similar to that shown previously for a duplicate link-local address.

 [bookmark: pgfId-475776]All configuration commands associated with the duplicate address remain as-configured while the state of the address is set to DUPLICATE. If the link-local address for an interface changes, duplicate address detection is performed on the new link-local address, and all other IPv6 address associated with the interface are regenerated (that is, duplicate address detection is performed only on the new link-local address).

  
       

 
        
        		[bookmark: pgfId-475782]NS Interval

  
        		[bookmark: pgfId-475784]The interval between IPv6 neighbor solicitation retransmissions, in milliseconds. Valid values range from 1000 to 3600000 milliseconds; the default value is 1000 milliseconds.

  
       

 
        
        		[bookmark: pgfId-475790]Reachable Time

  
        		[bookmark: pgfId-475792]The amount of time, in milliseconds, within which a remote IPv6 node is considered still reachable, after initial reachability was confirmed. Valid values range from 0 to 3600000 milliseconds, the default value is 0. When 0 is used for the value, the reachable time is set as undetermined—it is up to the receiving devices to set and track reachable time.

 [bookmark: pgfId-475794]A configured time enables detection of unavailable neighbors. A shorter time allows detecting unavailable neighbors more quickly; however, shorter times consume more IPv6 network bandwidth and processing resources in all IPv6 network devices. Very short configured times are not recommended in normal IPv6 operation.

  
       

 
        
        		[bookmark: pgfId-475800]Interface IPv6 Addresses

  
        		[bookmark: pgfId-475805]The IPv6 address(es) assigned to the management interface are listed in this table. Use the Add Row, Edit Row, and Delete Row buttons below this table to manage these entries. (These are standard buttons, as described in Using Tables.)

 [bookmark: pgfId-475810]Add Row and Edit Row open the IPv6 Address for Interface Dialog Box.
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     [bookmark: pgfId-645479][bookmark: 129675][bookmark: pxchap_cncpt_ConfiguringSecurityPoliciesonFirewallDevices]Configuring Security Policies on Firewall Devices[bookmark: marker-645475][bookmark: marker-645477]
      
      
 
     
 

 
    [bookmark: pgfId-645481]You can configure general security settings for the device using the General page and the Timeouts page under Platform > Security. You can enable anti-spoofing on interfaces, configure IP fragment settings, and configure a variety of timeout values for the device.

 
    [bookmark: pgfId-645483]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-645488]General Page

 
     		 [bookmark: pgfId-645493]Configuring Timeouts

 
    

 
   
 
    
     [bookmark: pgfId-645511][bookmark: 129684][bookmark: pxpage_cncpt_GeneralPage-2]General Page[bookmark: marker-645501][bookmark: marker-645503][bookmark: marker-645505][bookmark: marker-645507][bookmark: marker-645509]

 
    [bookmark: pgfId-645516]Use the General page to configure security settings that help protect against malformed packets, spoofed packets, fragmented packets, and denial of service attacks. See Configuring Floodguard, Anti-Spoofing and Fragment Settings for more information about the settings on this page.

 
    [bookmark: pgfId-645518]Navigation Path

 
     
     		 [bookmark: pgfId-645520](Device view) Select  Platform > Security > General from the Device Policy selector.

 
     		 [bookmark: pgfId-645522](Policy view) Select  PIX/ASA/FWSM Platform > Security > General from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-645524]Related Topics

 
     
     		 [bookmark: pgfId-645529]Chapter 56, “Configuring Security Policies on Firewall Devices”

 
     		 [bookmark: pgfId-645534]Add/Edit General Security Configuration Dialog Box

 
     		 [bookmark: pgfId-645539]Configuring Timeouts

 
    

 
    [bookmark: pgfId-645541]Field Reference

 
    [bookmark: pgfId-645544] 

 
     
      
       
       [bookmark: pgfId-644523]Table 56-1 [bookmark: 129729]General Page 

 
       
      
        
        		
          
          [bookmark: pgfId-644529]Element
         
  
        		
          
          [bookmark: pgfId-644531]Description
         
  
       

 
        
        		[bookmark: pgfId-644537]Disable Floodguard (PIX 6.3 and FWSM 2.x only)

  
        		[bookmark: pgfId-644542]Check this box to disable Floodguard on the firewall device. This option is available only on PIX 6.3 and FWSM 2.x devices. See Configuring Floodguard, Anti-Spoofing and Fragment Settings for more information about the Floodguard feature.

  
       

 
        
        		 [bookmark: pgfId-644548]Global Fragment Settings

 [bookmark: pgfId-644553]Use these options to configure global fragment settings for the device. You can override these settings for individual interfaces; see Add/Edit General Security Configuration Dialog Box for more information.

  
       

 
        
        		[bookmark: pgfId-644561]Enable Default Settings

  
        		[bookmark: pgfId-644563]Check this box to enable the default fragment settings fields.

  
       

 
        
        		[bookmark: pgfId-644569]Size

  
        		[bookmark: pgfId-644571]Specify the maximum number of fragments that can be in the IP re-assembly database waiting for re-assembly. The default is 200.

  
       

 
        
        		[bookmark: pgfId-644577]Chain

  
        		[bookmark: pgfId-644579]Specify the maximum number of fragments into which a full IP packet can be fragmented. The default is 24 packets.

  
       

 
        
        		[bookmark: pgfId-644585]Timeout

  
        		[bookmark: pgfId-644587]Specify the maximum number of seconds to wait for an entire fragmented packet to arrive. The timer starts after the first fragment of a packet arrives. If all fragments of the packet do not arrive by the number of seconds specified, all fragments of the packet that were already received will be discarded. The default is 5 seconds.

  
       

 
        
        		 [bookmark: pgfId-644593]Interface Configuration Table

 [bookmark: pgfId-644601]This table lists all interfaces on which individual anti-spoofing and fragment settings have been defined. Refer to Configuring Floodguard, Anti-Spoofing and Fragment Settings for more information about these settings. Refer to Add/Edit General Security Configuration Dialog Box for more information about configuring these settings on individual interfaces.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-645564][bookmark: 129780][bookmark: pxchap_proc_ConfiguringFloodguardAntiSpoofingandFragmentSettings]Configuring Floodguard, Anti-Spoofing and Fragment Settings[bookmark: marker-645550][bookmark: marker-645552][bookmark: marker-645554][bookmark: marker-645556][bookmark: marker-645558][bookmark: marker-645560][bookmark: marker-645562]

 
     [bookmark: pgfId-645566]Use the General page under Platform > Security to enable or disable Floodguard (on a PIX 6.3 or FWSM 2.x device), to enable Unicast Reverse Path Forwarding (anti-spoofing) on individual interfaces, and to configure IP fragment settings for the device, and for each interface of the device.

 
     [bookmark: pgfId-645568]Floodguard

 
     [bookmark: pgfId-645570]Floodguard lets you reclaim firewall resources if the user authentication subsystem runs out of resources. If an inbound or outbound uauth connection is being attacked or overused, the firewall will actively reclaim TCP user resources.

 
     [bookmark: pgfId-645572]If the user authentication subsystem is depleted, TCP user resources in different states are reclaimed in the following order, depending on urgency:

 
     [bookmark: pgfId-645574] 1. Timewait

 
     [bookmark: pgfId-645576] 2. LastAck

 
     [bookmark: pgfId-645578] 3. FinWait

 
     [bookmark: pgfId-645580] 4. Embryonic

 
     [bookmark: pgfId-645582] 5. Idle

 
     [bookmark: pgfId-645584]Floodguard is enabled by default. This option applies only to PIX 6.3 or FWSM 2.x devices.

 
     [bookmark: pgfId-645586]Anti-spoofing

 
     [bookmark: pgfId-645592][bookmark: marker-645588][bookmark: marker-645590]Unicast Reverse Path Forwarding (RPF) guards against IP spoofing—a packet using an incorrect source IP address to obscure its true source—by ensuring that all packets have a source IP address that matches the correct source interface according to the routing table.

 
     [bookmark: pgfId-645594]Normally, the security appliance looks only at the destination address when determining where to forward the packet. Unicast RPF instructs the security appliance to also look at the source address; this is why it is called Reverse Path Forwarding. For any traffic that you want to allow through the security appliance, the security appliance routing table must include a route back to the source address. See RFC 2267 for more information.

 
     [bookmark: pgfId-645596]With outside traffic, for example, the security appliance can use the default route to satisfy the Unicast RPF protection. If traffic enters from an outside interface, and the source address is not known to the routing table, the security appliance uses the default route to correctly identify the outside interface as the source interface.

 
     [bookmark: pgfId-645598]If traffic enters the outside interface from an address that is known to the routing table, but is associated with the inside interface, the security appliance drops the packet. Similarly, if traffic enters the inside interface from an unknown source address, the security appliance drops the packet because the matching route (the default route) indicates the outside interface.

 
     [bookmark: pgfId-645600]Unicast RPF is implemented as follows:

 
      
      		 [bookmark: pgfId-645602]ICMP packets have no session, so each packet is checked.

 
      		 [bookmark: pgfId-645604]UDP and TCP have sessions, so the initial packet requires a reverse route look-up. Subsequent packets arriving during the session are checked using an existing state maintained as part of the session. Non-initial packets are checked to ensure they arrived on the same interface used by the initial packet.

 
     

 
     [bookmark: pgfId-645606]Fragment Settings

 
     [bookmark: pgfId-645608]Fragment settings provide management of packet fragmentation and improve compatibility with the Network File System (NFS). By default, the security appliance allows up to 24 fragments per IP packet, and up to 200 fragments awaiting reassembly. You might need to allow fragments on your network if you have an application that routinely fragments packets, such as NFS over UDP. However, if you do not have an application that fragments traffic, we recommend that you do not allow fragments through the security appliance, as fragmented packets are often used as DoS attacks.

 
     [bookmark: pgfId-645610]Related Topics

 
      
      		 [bookmark: pgfId-645615]General Page

 
      		 [bookmark: pgfId-645620]Add/Edit General Security Configuration Dialog Box

 
     

 
    
 
     
      [bookmark: pgfId-645632][bookmark: 129847][bookmark: pxpage_cncpt_AddEditGeneralSecurityConfigurationDialogBox]Add/Edit General Security Configuration Dialog Box[bookmark: marker-645628][bookmark: marker-645630]

 
     [bookmark: pgfId-645634]Use the Add/Edit General Security Configuration dialog box to enable or disable anti-spoofing, and to configure override fragment settings, for an interface.

 
     [bookmark: pgfId-645636]Navigation Path

 
     [bookmark: pgfId-645641]You can access the Add/Edit General Security Configuration dialog box from the Anti-Spoofing and Fragment Interface Configuration table on the Platform > Security > General Page.

 
     [bookmark: pgfId-645643]Related Topics

 
      
      		 [bookmark: pgfId-645648]Chapter 56, “Configuring Security Policies on Firewall Devices”

 
      		 [bookmark: pgfId-645653]Configuring Floodguard, Anti-Spoofing and Fragment Settings

 
     

 
     [bookmark: pgfId-645655]Field Reference

 
     [bookmark: pgfId-645658] 

 
      
       
        
        [bookmark: pgfId-644616]Table 56-2 [bookmark: 129875]Add/Edit General Security Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-644622]Element
          
  
         		
           
           [bookmark: pgfId-644624]Description
          
  
        

 
         
         		[bookmark: pgfId-644630]Interface

  
         		[bookmark: pgfId-644632]Enter or Select the name of the interface for which you want to configure anti-spoofing or fragment settings.

  
        

 
         
         		[bookmark: pgfId-644638]Enable Anti-Spoofing

  
         		[bookmark: pgfId-644640]Check this box to enable Unicast RPF (anti-spoofing) on the specified interface.

  
        

 
         
         		[bookmark: pgfId-644646]Override Default Fragment Settings

  
         		[bookmark: pgfId-644651]To override the default fragment settings on the specified interface, check this box to enable the following fields, and then enter the new values. See the General Page for the default global fragment settings on the device.

  
        

 
         
         		[bookmark: pgfId-644657]Size

  
         		[bookmark: pgfId-644659]Specify the maximum number of fragments that can be in the IP re-assembly database waiting for re-assembly for the specified interface. The default is 200.

  
        

 
         
         		[bookmark: pgfId-644665]Chain

  
         		[bookmark: pgfId-644667]Specify the maximum number of fragments into which a full IP packet can be fragmented for the specified interface. The default is 24 packets.

  
        

 
         
         		[bookmark: pgfId-644673]Timeout

  
         		[bookmark: pgfId-644675]Specify the maximum number of seconds to wait for an entire fragmented packet to arrive on the specified interface. The timer starts after the first fragment of a packet arrives. If all fragments of the packet do not arrive by the number of seconds specified, all fragments of the packet that were already received will be discarded. The default is 5 seconds.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-645672][bookmark: 129918][bookmark: pxchap_proc_ConfiguringTimeouts]Configuring Timeouts[bookmark: marker-645666][bookmark: marker-645668][bookmark: marker-645670]

 
    [bookmark: pgfId-645674]The Timeouts page lets you set a variety of timeout values on the security appliance. All times are in the format hh:mm:ss.

 
    [bookmark: pgfId-645676]These values represent idle timeouts for the connection and translation slots for various protocols. If a slot has not been used for the idle time specified, the resource is returned to the free pool. TCP connection slots are freed approximately 60 seconds after a normal connection close sequence.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-645678]Warning We recommend that you do not change these values unless advised to do so by Customer Support.


    
     

    

    

 
    [bookmark: pgfId-645680]Navigation Path

 
     
     		 [bookmark: pgfId-645682](Device view) Select  Platform > Security > Timeouts from the Device Policy selector.

 
     		 [bookmark: pgfId-645684](Policy view) Select  PIX/ASA/FWSM Platform > Security > Timeouts from the Policy Types selector. Select an existing policy from the Policies selector, or create a new one.

 
    

 
    [bookmark: pgfId-645686]Related Topics

 
     
     		 [bookmark: pgfId-645691]Chapter 56, “Configuring Security Policies on Firewall Devices”

 
    

 
    [bookmark: pgfId-645693]Field Reference

 
    [bookmark: pgfId-645696] 

 
     
      
       
       [bookmark: pgfId-644688]Table 56-3 [bookmark: 129954]Timeouts Page 

 
       
      
        
        		
          
          [bookmark: pgfId-644694]Element
         
  
        		
          
          [bookmark: pgfId-644696]Description
         
  
       

 
        
        		 [bookmark: pgfId-644702]To change the timeout value for a parameter, click the radio button to the left of the parameter entry to activate it, and then enter the new value in the parameter field. To reset any value to its default, click the related Default button.

 [bookmark: pgfId-644704]Clicking the Disable button, where provided, disables the timeout by setting its value to 0:00:00. Follow either of the procedures in the previous paragraph to re-enable a disabled value.

  
       

 
        
        		[bookmark: pgfId-644712]Translation Slot (xlate)

  
        		[bookmark: pgfId-644714]Length of time idle until a translation slot is freed. This value must be at least 1 minute; the default is 3 hours. Enter 0:00:00 to disable this timeout.

  
       

 
        
        		[bookmark: pgfId-644720]Connection (conn)

  
        		[bookmark: pgfId-644722]Length of time idle until a connection slot is freed. This value must be at least 5 minutes; the default is 1 hour. Click Disable or enter 0:00:00 to disable this timeout.

  
       

 
        
        		[bookmark: pgfId-644728]Half-Closed

  
        		[bookmark: pgfId-644730]Length of time idle until a half-closed TCP connection is closed. For ASA 9.1.2 and later devices, the minimum is 30 seconds. For all other devices, the minimum is 5 minutes. The default is 10 minutes. Click Disable or enter 0:00:00 to disable this timeout.

  
       

 
        
        		[bookmark: pgfId-644736]UDP

  
        		[bookmark: pgfId-644738]Length of time idle until a UDP protocol connection is closed. This value must be at least 1 minute; the default is 2 minutes. Click Disable or enter 0:00:00 to disable this timeout.

  
       

 
        
        		[bookmark: pgfId-644744]ICMP (PIX 7.x+, ASA, FWSM 3.x+)

  
        		[bookmark: pgfId-644746]Length of time idle after which general ICMP states are closed.

  
       

 
        
        		[bookmark: pgfId-644752]RPC/Sun RPC

  
        		[bookmark: pgfId-644754]Length of time idle until a SunRPC slot is freed. This value must be at least 1 minute; the default is 10 minutes. Click Disable or enter 0:00:00 to disable this timeout.

  
       

 
        
        		[bookmark: pgfId-644760]H.225

  
        		[bookmark: pgfId-644762]Length of time idle until an H.225 signaling connection is closed. The H.225 default timeout is 1 hour (01:00:00). Setting the value to 00:00:00 means never close the connection. To close a connection immediately after all calls are cleared, enter 1 second (0:00:01).

  
       

 
        
        		[bookmark: pgfId-644768]H.323

  
        		[bookmark: pgfId-644770]Length of time idle until an H.323 media connection is closed. The default is 5 minutes. Click Disable or enter 0:00:00 to disable this timeout.

  
       

 
        
        		[bookmark: pgfId-644776]MGCP

  
        		[bookmark: pgfId-644778]Length of time idle after which MGCP media ports are closed. The default is 5 minutes (0:05:00). Click Disable or enter 0:00:00 to disable this timeout.

  
       

 
        
        		[bookmark: pgfId-644784]MGCP PAT (PIX 7.x+, ASA, FWSM 3.x+)

  
        		[bookmark: pgfId-644786]Length of time idle after which an MGCP PAT translation is removed. The minimum time is 30 seconds; the default is 5 minutes (0:05:00). Click Disable or enter 0:00:00 to disable this timeout.

  
       

 
        
        		[bookmark: pgfId-644792]SIP

  
        		[bookmark: pgfId-644794]Length of time idle until an SIP signaling port connection is closed. This value must be at least 5 minutes; the default is 30 minutes. Click Disable or enter 0:00:00 to disable this timeout.

  
       

 
        
        		[bookmark: pgfId-644800]SIP Media

  
        		[bookmark: pgfId-644802]Length of time idle until an SIP media port connection is closed. This value must be at least 1 minute; the default is 2 minutes. Click Disable or enter 0:00:00 to disable this timeout.

  
       

 
        
        		[bookmark: pgfId-644808]SIP Disconnect (PIX 6.3(5), PIX/ASA 7.2+, FWSM 3.2+)

  
        		[bookmark: pgfId-644810]Length of time idle after which a SIP session is deleted if the 200 OK is not received for a CANCEL or a BYE message. The minimum value is 0:00:01; the maximum value is 0:10:00. The default value is 0:02:00.

  
       

 
        
        		[bookmark: pgfId-644816]SIP Invite (PIX 6.3(5), PIX/ASA 7.2+, FWSM 3.2+)

  
        		[bookmark: pgfId-644818]Length of time idle after which pinholes for PROVISIONAL responses and media xlates will be closed. The minimum value is 0:01:00; the maximum value is 0:30:00. The default value is 0:03:00.

  
       

 
        
        		[bookmark: pgfId-644824]SIP Provisional Media (PIX/ASA 7.2(3)+)

  
        		[bookmark: pgfId-644826]The timeout value for SIP provisional media connections; must be a value between 0:01:00 and 1193:00:00. The default is 2 minutes.

  
       

 
        
        		[bookmark: pgfId-644832]Auth. (uath) Absolute

  
        		[bookmark: pgfId-644834]Length of time until the authentication cache times out and new connections must be re-authenticated. The system waits until a user starts a new connection to prompt for re-authentication. This time must be shorter than the Translation Slot value. Click Disable or enter 0:00:00 to disable caching and require re-re-authentication on every new connection.

 [bookmark: pgfId-644836]Note Do not set this value to 0:00:00 if passive FTP is used on the connections.

 [bookmark: pgfId-644838]Note If you set this value to 0:00:00; HTTPS authentication may not work. If a browser initiates multiple TCP connections to load a Web page after HTTPS authentication, the first connection is permitted through, but subsequent connections trigger authentication. As a result, users are continuously presented with an authentication page, even after successful authentication. To work around this, set the authentication absolute timeout to 1 second. However, this workaround opens a one-second window of opportunity that might allow non-authenticated users through the firewall if they are coming from the same source IP address.

  
       

 
        
        		[bookmark: pgfId-644844]Auth. (uath) Inactivity

  
        		[bookmark: pgfId-644846]Length of time idle until the authentication cache times out and users have to re-authenticate new connections. This duration must be shorter than the Translation Slot value.
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     [bookmark: pgfId-1051132][bookmark: 85813][bookmark: ravpnch_cncpt_ManagingRemoteAccessVPNsIOSPIX63]Managing Remote Access VPNs on IOS and PIX 6.3 Devices[bookmark: marker-1051133][bookmark: marker-1051134]
      
      
 
     
 

 
    [bookmark: pgfId-294432]You can configure and manage remote access IPsec on devices running Cisco IOS Software or PIX 6.3, and SSL VPNs on IOS 12.4(6)T or higher devices (but not on PIX devices). For more information on the specific device models supported, see Understanding Devices Supported by Each Remote Access VPN Technology.

 
    [bookmark: pgfId-294437]The configuration of these remote access VPNs are the same for these device types. ASA and PIX 7.0+ devices use different configurations for remote access VPNs (as explained in Chapter 31, “Managing Remote Access VPNs on ASA and PIX 7.0+ Devices”).

 
    [bookmark: pgfId-294439]The topics in this chapter explain how to configure policies that are specific to IOS and PIX 6.3 devices. Additionally, review the following topics for more information about remote access VPNs:

 
     
     		 [bookmark: pgfId-294444]Understanding Remote Access VPNs

 
     		 [bookmark: pgfId-294449]Understanding Devices Supported by Each Remote Access VPN Technology

 
     		 [bookmark: pgfId-294454]Discovering Remote Access VPN Policies

 
     		 [bookmark: pgfId-294459]Using the Remote Access VPN Configuration Wizard

 
    

 
    [bookmark: pgfId-294464] – Creating IPSec VPNs Using the Remote Access VPN Configuration Wizard (IOS and PIX 6.3 Devices)

 
    [bookmark: pgfId-294469] – Creating SSL VPNs Using the Remote Access VPN Configuration Wizard (IOS Devices)

 
    [bookmark: pgfId-294471]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-294476]Overview of Remote Access VPN Policies for IOS and PIX 6.3 Devices

 
     		 [bookmark: pgfId-294481]Configuring an IPsec Proposal on a Remote Access VPN Server (IOS, PIX 6.3 Devices)

 
     		 [bookmark: pgfId-294486]Configuring High Availability in Remote Access VPNs (IOS)

 
     		 [bookmark: pgfId-294491]Configuring User Group Policies

 
     		 [bookmark: pgfId-294496]Configuring an SSL VPN Policy (IOS)

 
    

 
   
 
    
     [bookmark: pgfId-294506][bookmark: 85847][bookmark: ravpnch_cncpt_OverviewofRemoteAccessVPNPoliciesforIOSandPIX63Devices]Overview of Remote Access VPN Policies for IOS and PIX 6.3 Devices[bookmark: marker-294502][bookmark: marker-294504]

 
    [bookmark: pgfId-294508]When you configure remote access VPNs on IOS or PIX 6.3 devices, you use the following policies based on the type of VPN you are configuring. Note that you cannot configure SSL VPNs on PIX 6.3 devices.

 
     
     		 [bookmark: pgfId-294510] Policies used with both IPsec and SSL remote access VPNs: 

 
    

 
    [bookmark: pgfId-294515] – Global Settings—You can define global settings that apply to all devices in your remote access VPNs. These settings include Internet Key Exchange (IKE), IPsec, NAT, and fragmentation definitions. The global settings typically have defaults that work in most situations, so configuring the Global Settings policy is optional; configure it only if you need non-default behavior. For more information, see Configuring VPN Global Settings.

 
    [bookmark: pgfId-294523] – Public Key Infrastructure—You can create a Public Key Infrastructure (PKI) policy to generate enrollment requests for CA certificates and RSA keys, and to manage keys and certificates. Certification Authority (CA) servers are used to manage these certificate requests and issue certificates to users who connect to your IPsec or SSL remote access VPN. For more information, see Understanding Public Key Infrastructure Policies and Configuring Public Key Infrastructure Policies for Remote Access VPNs.

 
     
     		 [bookmark: pgfId-294525] Policies used in remote access IPsec VPNs only: 

 
    

 
    [bookmark: pgfId-294530] – IKE Proposal—Internet Key Exchange (IKE), also called ISAKMP, is the negotiation protocol that enables two hosts to agree on how to build an IPsec security association. IKE is used to authenticate IPsec peers, negotiate and distribute IPsec encryption keys, and to automatically establish IPsec security associations (SAs). Use the IKE Proposal policy to define the requirements for phase 1 of the IKE negotiation. For more information, see Configuring an IKE Proposal.

 
    [bookmark: pgfId-294535] – IPsec Proposal (IOS/PIX 6.x)—An IPsec proposal is a collection of one or more crypto maps. A crypto map combines all the components required to set up IPsec security associations (SAs), including IPsec rules, transform sets, remote peers, and other parameters that might be necessary to define an IPsec SA. The policy is used for IKE phase 2 negotiations. For more information, see Configuring an IPsec Proposal on a Remote Access VPN Server (IOS, PIX 6.3 Devices).

 
    [bookmark: pgfId-294540] – High Availability—High Availability (HA) is supported by the creation of an HA group made up of two or more hub devices that use Hot Standby Routing Protocol (HSRP) to provide transparent, automatic device failover. For more information, see Configuring High Availability in Remote Access VPNs (IOS).

 
    [bookmark: pgfId-294545] – User Groups (IOS/PIX 6.x)—A user group policy specifies the attributes that determine user access to and use of the VPN. For more information, see Configuring User Group Policies.

 
     
     		 [bookmark: pgfId-294547] Policies used in remote access SSL VPNs only: 

 
    

 
    [bookmark: pgfId-294552] – SSL VPN—The SSL VPN policy table lists all of the contexts that define the virtual configurations of the SSL VPN. Each context has a gateway, domain or virtual hostname, and user group policies. For more information, see Configuring an SSL VPN Policy (IOS).

 
   
 
    
     [bookmark: pgfId-294566][bookmark: 85901][bookmark: ravpnch_proc_ConfiguringanIPsecProposalonaRemoteAccessVPNServerIOSPIX63]Configuring an IPsec Proposal on a Remote Access VPN Server (IOS, PIX 6.3 Devices)[bookmark: marker-294560][bookmark: marker-294562][bookmark: marker-294564]

 
    [bookmark: pgfId-294568]This procedure describes how to create or edit an IPsec proposal for your remote access VPN server when the server uses Cisco IOS Software or PIX release 6.3.

 
    [bookmark: pgfId-294570]An IPsec proposal is a collection of one or more crypto maps. A crypto map combines all the components required to set up IPsec security associations (SAs), including IPsec rules, transform sets, remote peers, and other parameters that might be necessary to define an IPsec SA.

 
    [bookmark: pgfId-294572]When configuring an IPsec proposal, you must define the external interface through which the remote access clients connect to the server, and the encryption and authentication algorithms that protect the data in the VPN tunnel. You can also select a group authorization (Group Policy Lookup) method that defines the order in which group policies are searched (on the local server or on external AAA servers) and a user authentication (Xauth) method that defines the order in which user accounts are searched.

 
    [bookmark: pgfId-294577]For more information on IPsec tunnel concepts, see Understanding IPsec Proposals.

 
    [bookmark: pgfId-294579]When you create or edit an IPsec proposal, you can also configure:

 
     
     		 [bookmark: pgfId-294584]A VPN Services Module (VPNSM) interface IPsec VPN Shared Port Adapter (VPN SPA) on a Catalyst 6500/7600 device (see VPNSM/VPN SPA/VSPA Settings Dialog Box).

 
     		 [bookmark: pgfId-294589]A dynamic virtual interface on an IOS router running Cisco IOS Software version 12.4(2)T or later, except 7600 device. For more information, see Configuring Dynamic VTI/VRF Aware IPsec in Remote Access VPNs (IOS Devices).

 
     		 [bookmark: pgfId-294594]VRF-Aware IPsec on a router or Catalyst 6500/7600 device (see Configuring Dynamic VTI/VRF Aware IPsec in Remote Access VPNs (IOS Devices)).

 
    

 
    [bookmark: pgfId-294596]Related Topics

 
     
     		 [bookmark: pgfId-294601]Understanding VRF-Aware IPsec

 
     		 [bookmark: pgfId-294606]VPNSM/VPN SPA/VSPA Settings Dialog Box

 
     		 [bookmark: pgfId-294611]Table Columns and Column Heading Features

 
    

 
    
 
    [bookmark: pgfId-294613]Step 1 Do one of the following:

 
     
     		 [bookmark: pgfId-294615](Device view) Select  Remote Access VPN > IPSec VPN > IPsec Proposal (IOS/PIX 6.x) from the Policy selector.

 
     		 [bookmark: pgfId-294617](Policy view) Select  Remote Access VPN > IPSec VPN > IPsec Proposal (IOS/PIX 6.x) from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-294619]The IPsec Proposal page opens and lists the configured proposals, including the VPN endpoint, IPsec transform set, and whether reverse route injection is configured for the proposal. You can add other columns to the default display to show the AAA, VRF, and dVTI configuration.

 
    [bookmark: pgfId-294621]Step 2 Do any of the following:

 
     
     		 [bookmark: pgfId-294626]To add a new IPsec proposal, click the  Add Row (+) button and fill in the IPsec Proposal Editor dialog box. For detailed information on the available options, see IPsec Proposal Editor (IOS, PIX 6.3 Devices).

 
     		 [bookmark: pgfId-294628]To edit an existing proposal, select it and click the  Edit Row (pencil) button.

 
     		 [bookmark: pgfId-294630]To delete a proposal, select it and click the  Delete Row (trash can) button.

 
    

 
    [bookmark: pgfId-294632]


    
     

    
 
    

 
     
      [bookmark: pgfId-294654][bookmark: 85971][bookmark: ravpnpag_cncpt_IPsecProposalEditorDialogBoxforIOSRoutersandCatalystDevices]IPsec Proposal Editor (IOS, PIX 6.3 Devices)[bookmark: marker-294640][bookmark: marker-294642][bookmark: marker-294644][bookmark: marker-294646][bookmark: marker-294648][bookmark: marker-294650][bookmark: marker-294652]

 
     [bookmark: pgfId-294659]Use the IPsec Proposal Editor to create or edit an IPsec proposal for an IOS or PIX 6.3 device, including Catalyst 6500/7600, in your remote access VPN. The editor has two tabs—General and Dynamic VTI/VRF Aware IPsec. This topic explains the basic settings on the General tab. For an explanation of Dynamic VTI/VRF Aware IPsec settings, see Configuring Dynamic VTI/VRF Aware IPsec in Remote Access VPNs (IOS Devices).

 
     [bookmark: pgfId-294661]The elements in this dialog box differ according to the selected device. The table below describes the elements on the General tab in the IPsec Proposal Editor dialog box when a Cisco IOS router, Catalyst 6500/7600, or PIX 6.3 device is selected.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-294666]Note For a description of the elements in the dialog box when a PIX 7.0+ or ASA device is selected is selected, see IPsec Proposal Editor (ASA, PIX 7.0+ Devices).


     
      

     

     

 
     [bookmark: pgfId-294668]Navigation Path

 
      
      		 [bookmark: pgfId-294670](Device view) Select  Remote Access VPN > IPSec VPN > IPsec Proposal (IOS/PIX 6.x) from the Policy selector. Click the Add Row (+) or Edit Row (pencil) buttons.

 
      		 [bookmark: pgfId-294672](Policy view) Select  Remote Access VPN > IPSec VPN > IPsec Proposal (IOS/PIX 6.x) from the Policy Type selector. Select an existing policy or create a new one. Click the Add Row (+) or Edit Row (pencil) buttons.

 
     

 
     [bookmark: pgfId-294674]Related Topics

 
      
      		 [bookmark: pgfId-294679]Configuring an IPsec Proposal on a Remote Access VPN Server (IOS, PIX 6.3 Devices)

 
      		 [bookmark: pgfId-294684]Understanding IPsec Proposals

 
      		 [bookmark: pgfId-294689]Creating Interface Role Objects

 
      		 [bookmark: pgfId-294694]Creating AAA Server Group Objects

 
     

 
     [bookmark: pgfId-294696]Field Reference

 
     [bookmark: pgfId-294699] 

 
      
       
        
        [bookmark: pgfId-293135]Table 33-1 [bookmark: 86034]IPsec Proposal Editor, General Tab, IOS and PIX 6.3 Devices 

 
        
       
         
         		
           
           [bookmark: pgfId-293141]Element
          
  
         		
           
           [bookmark: pgfId-293143]Description
          
  
        

 
         
         		[bookmark: pgfId-293149]External Interface

  
         		[bookmark: pgfId-293151]Note Available only if the selected device is an IOS router.

 [bookmark: pgfId-293153]The external interface through which remote access clients will connect to the server. Enter the name of the interface or interface role object, or click Select to select it or to create a new object.

  
        

 
         
         		[bookmark: pgfId-293159]Inside VLAN

  
         		[bookmark: pgfId-293161]Note Available only if the selected device is a Catalyst 6500/7600.

 [bookmark: pgfId-293166]The inside VLAN that serves as the inside interface to the VPN Services Module (VPNSM), VPN SPA, or VSPA. Click Select to configure the inside VLAN as explained in VPNSM/VPN SPA/VSPA Settings Dialog Box.

  
        

 
         
         		[bookmark: pgfId-293172]IKEv1 Transform Sets

  
         		[bookmark: pgfId-293177]The transform sets to be used for your tunnel policy. Transform sets specify which authentication and encryption algorithms will be used to secure the traffic in the tunnel. You can select up to nine transform sets. For more information, see Understanding Transform Sets.

 [bookmark: pgfId-293179]If more than one of your selected transform sets is supported by both peers, the transform set that provides the highest security will be used.

 [bookmark: pgfId-293184]Click Select to select the IPsec transform set policy objects to use in the topology. If the required object is not yet defined, you can click the Create (+) button beneath the available objects list in the selection dialog box to create a new one. For more information, see Configuring IPSec IKEv1 or IKEv2 Transform Set Policy Objects.

  
        

 
         
         		[bookmark: pgfId-293190]Reverse Route Injection

  
         		[bookmark: pgfId-293195]Reverse Route Injection (RRI) enables static routes to be automatically inserted into the routing process for those networks and hosts protected by a remote tunnel endpoint. For more information, see Understanding Reverse Route Injection.

 [bookmark: pgfId-293197]Select one of the following options to configure RRI on the crypto map:

 
           
           		 [bookmark: pgfId-293199] None —Disables the configuration of RRI on the crypto map.

 
           		 [bookmark: pgfId-293201] Standard —Creates routes based on the destination information defined in the crypto map access control list (ACL). This is the default option.

 
           		 [bookmark: pgfId-293203] Remote Peer —Creates two routes, one for the remote endpoint and one for route recursion to the remote endpoint via the interface to which the crypto map is applied.

 
           		 [bookmark: pgfId-293205] Remote Peer IP —Specifies an address as the explicit next hop to the remote VPN device. Enter the IP address or a network/host object that specifies the address, or click  Select to select the network/host object from a list or to create a new object.

 
          

 option in the object to override the IP address, if required, for specific devices that use this object.

  
        

 
         
         		[bookmark: pgfId-293213]Group Policy Lookup/AAA Authorization Method

  
         		[bookmark: pgfId-293215]The AAA authorization method list that will be used to define the order in which the group policies are searched. Group policies can be configured on both the local server or on an external AAA server. Remote users are grouped, so that when the remote client establishes a successful connection to the VPN server, the group policies for that particular user group are pushed to all clients belonging to the user group.

 [bookmark: pgfId-293217]Click Select to open a dialog box that lists all available AAA group servers, and in which you can create AAA group server objects. Select all that apply and use the up and down arrow buttons to put them in priority order.

  
        

 
         
         		[bookmark: pgfId-293223]User Authentication (Xauth)/AAA Authentication Method

  
         		[bookmark: pgfId-293225]The AAA or Xauth user authentication method that defines the order in which user accounts are searched.

 [bookmark: pgfId-293227]Xauth allows all Cisco IOS software AAA authentication methods to perform user authentication in a separate phase after the IKE authentication phase 1 exchange.

 [bookmark: pgfId-293229]Click Select to open a dialog box that lists all available AAA group servers, and in which you can create AAA group server objects. Select all that apply and use the up and down arrow buttons to put them in priority order.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-294721][bookmark: 86109][bookmark: ravpnpag_cncpt_VPNSMVPNSPASettingsDialogBox]VPNSM/VPN SPA/VSPA Settings Dialog Box[bookmark: marker-294707][bookmark: marker-294709][bookmark: marker-294711][bookmark: marker-294713][bookmark: marker-294715][bookmark: marker-294717][bookmark: marker-294719]

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-294723]Note This dialog box is available only if the selected device is a Catalyst 6500/7600.


     
      

     

     

 
     [bookmark: pgfId-294725]Use the VPNSM/VPN SPA/VSPA Settings dialog box to specify the settings for configuring a VPN Services Module (VPNSM), a VPN Shared Port Adapter (VPN SPA), or a Cisco VPN Service Port Adapters (VSPAs) on a Catalyst 6500/7600 device.

 
     [bookmark: pgfId-294727]Notes

 
      
      		 [bookmark: pgfId-294732]Before you define the settings, you must import your Catalyst 6500/7600 device to the Security Manager inventory and discover its interfaces. For more information, see Configuring VPNSM or VPN SPA/VSPA Endpoint Settings.

 
      		 [bookmark: pgfId-294734]Before you configure VPNSM or VPN SPA with VRF-Aware IPsec on a device, verify that an IPsec proposal with VRF-Aware IPsec and an IPsec proposal without VRF-Aware IPsec were not configured on the device.

 
     

 
     [bookmark: pgfId-294736]Navigation Path

 
     [bookmark: pgfId-294741]In the General tab of the IPsec Proposal Editor Dialog Box (for Catalyst 6500/7600 Devices), click Select next to the Inside VLAN field. For more information about opening the IPsec Proposal Editor, see IPsec Proposal Editor (IOS, PIX 6.3 Devices).

 
     [bookmark: pgfId-294743]Related Topics

 
      
      		 [bookmark: pgfId-294748]Creating Interface Role Objects

 
     

 
     [bookmark: pgfId-294750]Field Reference

 
     [bookmark: pgfId-294753] 

 
      
       
        
        [bookmark: pgfId-293242]Table 33-2 [bookmark: 86161]VPNSM/VPN SPA/VSPA Settings Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-293248]Element
          
  
         		
           
           [bookmark: pgfId-293250]Description
          
  
        

 
         
         		[bookmark: pgfId-293256]Inside VLAN

  
         		[bookmark: pgfId-293258]The inside VLAN that serves as the inside interface to the VPNSM, VPN SPA, or VSPA, and to which the required crypto maps will be applied. Enter the VLAN ID or click Select to select it or to create a new interface role object to identify the VLAN.

  
        

 
         
         		[bookmark: pgfId-293264]Slot

 [bookmark: pgfId-293266]Subslot

  
         		[bookmark: pgfId-293268]The number designating the slot location of the VPNSM or VPNSPA/VSPA. If you are configuring a VPNSPA/VSPA, the subslot number is also required.

 [bookmark: pgfId-293270]Note If you are configuring a VPNSM, select 0.

  
        

 
         
         		[bookmark: pgfId-293276]External Port

  
         		[bookmark: pgfId-293278]The external port or VLAN that connects to the inside VLAN. Enter the name of the VLAN or interface role object, or click Select to select it from a list. You must select an interface or interface role that differs from the one selected for the inside VLAN.

 [bookmark: pgfId-293280]Note If VRF-Aware IPsec is configured on the device, the external port or VLAN must have an IP address. If VRF-Aware IPsec is not configured, the external port or VLAN must not have an IP address.

  
        

 
         
         		[bookmark: pgfId-293286]Enable Failover Blade

  
         		[bookmark: pgfId-293288]Whether to configure a failover VPNSM or VPNSPA/VSPA blade for intra-chassis high availability.

 [bookmark: pgfId-293290]Note A VPNSM and VPNSPA/VSPA blade cannot be used on the same device as primary and failover blades.

 [bookmark: pgfId-293292]Specify the failover blade, as follows:

 
           
           		 [bookmark: pgfId-293294] Slot —The slot number that identifies where the VPNSM blade or VPNSPA/VSPA blade is located.

 
           		 [bookmark: pgfId-293296] Subslot —If you are configuring a VPNSPA/VSPA, select the number of the subslot on which the failover VPN SPA blade is installed.

 
          

 [bookmark: pgfId-293298]Note If you are configuring a VPNSM, select 0.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-294773][bookmark: 86207][bookmark: ravpnpag_cncpt_DynamicVTIVRFAwareIPsecTabIPsecProposalEditor]Configuring Dynamic VTI/VRF Aware IPsec in Remote Access VPNs (IOS Devices)[bookmark: marker-294761][bookmark: marker-294763][bookmark: marker-294765][bookmark: marker-294767][bookmark: marker-294769][bookmark: marker-294771]

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-294775]Note The Dynamic VTI/VRF Aware IPsec tab is available only when the selected device is a Cisco IOS router or Catalyst 6500/7600.


     
      

     

     

 
     [bookmark: pgfId-294777]Use the Dynamic VTI/VRF Aware IPsec tab of the IPsec Proposal Editor to configure VRF Aware IPsec settings (on a Cisco IOS router or Catalyst 6500/7600 device), configure a dynamic virtual interface on a Cisco IOS router, or do both, in your remote access VPN.

 
     [bookmark: pgfId-294779]IOS devices allow dynamic virtual template interfaces (VTIs), which provide highly secure and scalable connectivity for remote-access VPNs, replacing dynamic crypto maps and the dynamic hub-and-spoke method for establishing tunnels. You can use dynamic VTIs for both the server and remote configuration. The tunnels provide an on-demand separate virtual access interface for each VPN session. The configuration of the virtual access interfaces is duplicated from a virtual template configuration, which includes the IPsec configuration and any features configured on the virtual template interface. Dynamic VTIs provide efficiency in the use of IP addresses and provide secure connectivity. They enable dynamically downloadable per-group and per-user policies to be configured on a RADIUS server. Dynamic VTI simplifies VRF-Aware IPsec deployment, as the VRF is configured on the interface.

 
     [bookmark: pgfId-294781]When this feature is enabled, Security Manager implicitly creates the virtual template interface for the selected device in a remote access VPN. All you must do is provide the IP address on the server that will be used as the virtual template interface, or use an existing loopback interface. The virtual template interface is created on the remote client without an IP address.

 
     [bookmark: pgfId-294783]Notes

 
      
      		 [bookmark: pgfId-294785]You can configure dynamic VTI only on routers running Cisco IOS Release 12.4(2)T and later, except 7600 devices.

 
      		 [bookmark: pgfId-294790]You can configure dynamic VTI with or without VRF-Aware IPsec. For more information about VRF-Aware IPsec, see Understanding VRF-Aware IPsec.

 
      		 [bookmark: pgfId-294795]You can also configure dynamic VTI in a site-to-site Easy VPN topology. For more information, see Easy VPN with Dynamic Virtual Tunnel Interfaces.

 
     

 
     [bookmark: pgfId-294797]Navigation Path

 
     [bookmark: pgfId-294802]In the IPsec Proposal Editor Dialog Box (for IOS routers and Catalyst 6500/7600 devices), click the Dynamic VTI/VRF Aware IPsec tab. For more information, see IPsec Proposal Editor (IOS, PIX 6.3 Devices).

 
     [bookmark: pgfId-294804]Related Topics

 
      
      		 [bookmark: pgfId-294809]Configuring an IPsec Proposal on a Remote Access VPN Server (IOS, PIX 6.3 Devices)

 
      		 [bookmark: pgfId-294814]Creating Interface Role Objects

 
     

 
     [bookmark: pgfId-294816]Field Reference

 
     [bookmark: pgfId-294819] 

 
      
       
        
        [bookmark: pgfId-293311]Table 33-3 [bookmark: 86266]IPsec Proposal Editor, Dynamic VTI/VRF Aware IPsec Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-293317]Element
          
  
         		
           
           [bookmark: pgfId-293319]Description
          
  
        

 
         
         		[bookmark: pgfId-293325]Enable Dynamic VTI

  
         		[bookmark: pgfId-293327]When selected, enables Security Manager to implicitly create a dynamic virtual template interface on an IOS router.

 [bookmark: pgfId-293329]Note Dynamic VTI can be configured only on IOS routers running Cisco IOS Release 12.4(2)T and later, except 7600 devices. If the device does not support Dynamic VTI, the option is greyed out.

  
        

 
         
         		[bookmark: pgfId-293335]Enable VRF Settings

  
         		[bookmark: pgfId-293337]When selected, enables you to configure VRF settings on the device for the selected hub-and-spoke topology.

 [bookmark: pgfId-293339]Note To remove VRF settings that were defined for the VPN topology, deselect this check box.

  
        

 
         
         		[bookmark: pgfId-293345]User Group

  
         		[bookmark: pgfId-293347]When you configure a remote access VPN server, remote clients must have the same group name as the user group object configured on the VPN server so that they can connect to the device.

 [bookmark: pgfId-293349]Enter the name of the user group policy object associated with the device, or click Select to select it from a list. You can also create new objects or edit existing ones from the selection list.

  
        

 
         
         		[bookmark: pgfId-293355]CA Server

  
         		[bookmark: pgfId-293360]Select the Certification Authority (CA) server to use for managing certificate requests for the device. Click Select to select the PKI enrollment policy object that defines the CA server, or to create a new object. For more information, see PKI Enrollment Dialog Box.

 [bookmark: pgfId-293365]For more information about IPsec configuration with CA servers, see Understanding Public Key Infrastructure Policies.

  
        

 
         
         		[bookmark: pgfId-293371]Virtual Template IP Type

  
         		[bookmark: pgfId-293373]Available if you selected Enable Dynamic VTI.

 [bookmark: pgfId-293375]Specify the virtual template interface to use:

 
           
           		 [bookmark: pgfId-293377] IP —To use an IP address as the virtual template interface. Specify the private IP address.

 
           		 [bookmark: pgfId-293379] Use Loopback Interface —To use the IP address taken from an existing loopback interface as the virtual template interface. Click  Select to select the interface or interface role object, or to create a new object that identifies the loopback interface.

 
          

  
        

 
         
         		[bookmark: pgfId-293385]VRF Solution

  
         		[bookmark: pgfId-293387]Available if you selected Enable VRF Settings.

 [bookmark: pgfId-293389]Select the VRF solution:

 
           
           		 [bookmark: pgfId-293394] 1-Box (IPsec Aggregator + MPLS PE) —One device serves as the Provider Edge (PE) router that does the MPLS tagging of the packets in addition to IPsec encryption and decryption from the Customer Edge (CE) devices. For more information, see VRF-Aware IPsec One-Box Solution.

 
           		 [bookmark: pgfId-293399] 2-Box (IPsec Aggregator Only) —The PE device does only the MPLS tagging, while the IPsec Aggregator device does the IPsec encryption and decryption from the CEs. For more information, see VRF-Aware IPsec Two-Box Solution.

 
          

  
        

 
         
         		[bookmark: pgfId-293405]VRF Name

  
         		[bookmark: pgfId-293407]The name of the VRF routing table on the IPsec Aggregator. The VRF name is case-sensitive.

  
        

 
         
         		[bookmark: pgfId-293413]Route Distinguisher

  
         		[bookmark: pgfId-293415]The unique identifier of the VRF routing table on the IPsec Aggregator. This unique route distinguisher maintains routing separation for each VPN across the MPLS core to the other PE routers. The identifier can be in either of the following formats:

 
           
           		 [bookmark: pgfId-293417] IP address:X , where  X is in the range of 0-999999999.

 
           		 [bookmark: pgfId-293419] N:X , where  N is in the range of 0-65535, and X is in the range of 0-999999999.

 
          

 [bookmark: pgfId-293421]Note You cannot override the RD identifier after deploying the VRF configuration to your device. To modify the RD identifier after deployment, you must manually remove it through the device CLI and then deploy again.

  
        

 
         
         		[bookmark: pgfId-293427]Interface Towards Provider Edge

  
         		[bookmark: pgfId-293429]Available only for 2-Box VRF.

 [bookmark: pgfId-293431]The VRF forwarding interface on the IPsec Aggregator towards the PE device. Click Select to select the interface or interface role object, or to create a new object that identifies the interface.

 [bookmark: pgfId-293433]Note If the IPsec Aggregator (hub) is a Catalyst VPN service module, you must specify a VLAN.

  
        

 
         
         		[bookmark: pgfId-293439]Routing Protocol

  
         		[bookmark: pgfId-293441]Available only for 2-Box VRF.

 [bookmark: pgfId-293443]Select the routing protocol to use between the IPsec Aggregator and the PE. The options are BGP, EIGRP, OSPF, RIPv2, or Static route.

 [bookmark: pgfId-293445]If the routing protocol for the secured IGP differs from the routing protocol between the IPsec Aggregator and the PE, select the routing protocol for redistributing the routing to the secured IGP.

  
        

 
         
         		[bookmark: pgfId-293451]AS Number

  
         		[bookmark: pgfId-293453]Available only for 2-Box VRF with BGP or EIGRP routing.

 [bookmark: pgfId-293455]The number to use to identify the autonomous system (AS) area between the IPsec Aggregator and the PE. The AS number must be between 1 and 65535.

 [bookmark: pgfId-293457]If the routing protocol for the secured IGP differs from the routing protocol between the IPsec Aggregator and the PE, enter an AS number that identifies the secured IGP into which the routing will be redistributed from the IPsec Aggregator and the PE. This is relevant only if GRE or DMVPN are applied.

  
        

 
         
         		[bookmark: pgfId-293463]Process Number

  
         		[bookmark: pgfId-293465]Available only for 2-Box VRF with OSPF routing.

 [bookmark: pgfId-293467]The routing process ID number to use to configure the routing between the IPsec Aggregator and the PE. The process number must be between 1 and 65535.

  
        

 
         
         		[bookmark: pgfId-293473]OSPF Area ID

  
         		[bookmark: pgfId-293475]Available only for 2-Box VRF with OSPF routing.

 [bookmark: pgfId-293477]The ID number of the area in which the packet belongs. You can enter any number from 0 to 4294967295.

 [bookmark: pgfId-293479]Note All OSPF packets are associated with a single area, so all devices must have the same area ID number.

  
        

 
         
         		[bookmark: pgfId-293485]Redistribute Static Route

  
         		[bookmark: pgfId-293487]Available only for 2-Box VRF with any routing protocol other than Static route.

 [bookmark: pgfId-293489]When selected, enables static routes to be advertised in the routing protocol configured on the IPsec Aggregator towards the PE device.

 [bookmark: pgfId-293491]Note If this check box is deselected and Enable Reverse Route Injection is enabled (default) for the IPsec proposal, static routes are still advertised in the routing protocol on the IPsec Aggregator.

  
        

 
         
         		[bookmark: pgfId-293497]Next Hop IP Address

  
         		[bookmark: pgfId-293499]Available only for 2-Box VRF with Static routing.

 [bookmark: pgfId-293501]The IP address of the provider edge device (or the interface that is connected to the IPSec aggregator).

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-294839][bookmark: 86405][bookmark: ravpnch_proc_ConfiguringaHighAvailabilityPolicy]Configuring High Availability in Remote Access VPNs (IOS)[bookmark: marker-294827][bookmark: marker-294829][bookmark: marker-294831][bookmark: marker-294833][bookmark: marker-294835][bookmark: marker-294837]

 
    [bookmark: pgfId-294841]Use the High Availability page to configure a High Availability (HA) policy on a Cisco IOS router or Cisco Catalyst switch in a remote access VPN.

 
    [bookmark: pgfId-294843]In Security Manager, High Availability (HA) is supported by the creation of an HA group made up of two or more devices that use Hot Standby Routing Protocol (HSRP) to provide transparent, automatic device failover. By sharing a virtual IP address, the devices in the HA group present the appearance of a single virtual device or default gateway to the remote access users. One device in the HA group is always active and assumes the virtual IP address, while the others are standby devices. The devices in the group watch for hello packets from active and standby devices. If the active device becomes unavailable for any reason, a standby device takes ownership of the virtual IP address and takes over the remote access VPN. This transfer is seamless and transparent to remote access users.

 
    [bookmark: pgfId-294845]Stateful SwitchOver (SSO) is used to ensure that state information is shared between the HSRP devices in the HA group. If a device fails, the shared state information enables the standby device to maintain IPsec sessions without having to re-establish the tunnel or renegotiate the security associations.

 
    [bookmark: pgfId-294847]Tips

 
     
     		 [bookmark: pgfId-294852]When configuring an HA group, you must provide an inside virtual IP that matches the subnet of one of the interfaces on the device, in addition to a VPN virtual IP that matches the subnet of one of the device’s interfaces and is configured with an IPsec proposal. See Configuring an IPsec Proposal on a Remote Access VPN Server (IOS, PIX 6.3 Devices).

 
     		 [bookmark: pgfId-294854]A remote access VPN server device on which HA is configured cannot be configured as a hub in a site-to-site VPN topology on which HA is configured, using the same outside interface that was used for the remote access VPN server.

 
    

 
    
 
    [bookmark: pgfId-294856]Step 1 Do one of the following:

 
     
     		 [bookmark: pgfId-294858](Device view) With an IOS device selected, select  Remote Access VPN > IPSec VPN > High Availability from the Policy selector.

 
     		 [bookmark: pgfId-294860](Policy view) Select  Remote Access VPN > IPSec VPN > High Availability from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-294862]The High Availability page opens.

 
    [bookmark: pgfId-294864]Step 2 Configure the options explained in the following table.

 
    [bookmark: pgfId-294867] 

 
     
      
       
       [bookmark: pgfId-293514]Table 33-4 [bookmark: 86457]High Availability Page, Remote Access VPNs 

 
       
      
        
        		
          
          [bookmark: pgfId-293520]Element
         
  
        		
          
          [bookmark: pgfId-293522]Description
         
  
       

 
        
        		[bookmark: pgfId-293528]Inside Virtual IP

  
        		[bookmark: pgfId-293530]The IP address that is shared by the devices in the HA group and that represents the inside interface of the HA group. The virtual IP address must be on the same subnet as the inside interfaces of the devices in the HA group, but must not be identical to the IP address of any of these interfaces.

 [bookmark: pgfId-293532]You must provide an inside virtual IP that matches the subnet of one of the interfaces on the device, in addition to a VPN virtual IP that matches the subnet of one of the device’s interfaces and is configured with an IPsec proposal.

 [bookmark: pgfId-293534]Note If there is an existing standby group on the device, make sure that the IP address you provide is different from the virtual IP address already configured on the device.

  
       

 
        
        		[bookmark: pgfId-293540]Inside Mask

  
        		[bookmark: pgfId-293542]The subnet mask for the inside virtual IP address.

  
       

 
        
        		[bookmark: pgfId-293548]VPN Virtual IP

  
        		[bookmark: pgfId-293550]The IP address that is shared by the devices in the HA group and represents the VPN interface of the HA group. This IP address serves as the endpoint of the VPN tunnel.

 [bookmark: pgfId-293552]Note If there is an existing standby group on the device, make sure that the IP address you provide is different from the virtual IP address already configured on the device.

  
       

 
        
        		[bookmark: pgfId-293558]VPN Mask

  
        		[bookmark: pgfId-293560]The subnet mask for the VPN virtual IP address.

  
       

 
        
        		[bookmark: pgfId-293566]Hello Interval

  
        		[bookmark: pgfId-293568]The duration in seconds (within the range of 1-254) between each hello message sent by a device to the other devices in the group to indicate status and priority. The default is 5 seconds.

  
       

 
        
        		[bookmark: pgfId-293574]Hold Time

  
        		[bookmark: pgfId-293576]The duration in seconds (within the range of 2-255) that a standby device will wait to receive a hello message from the active device before concluding that the device is down. The default is 15 seconds.

  
       

 
        
        		[bookmark: pgfId-293582]Standby Group Number (Inside)

  
        		[bookmark: pgfId-293584]The standby number of the inside device interface that matches the internal virtual IP subnet for the devices in the HA group. The number must be within the range of 0-255. The default is 1.

  
       

 
        
        		[bookmark: pgfId-293590]Standby Group Number (Outside)

  
        		[bookmark: pgfId-293592]The standby number of the outside device interface that matches the external virtual IP subnet for the devices in the HA group. The number must be within the range of 0-255. The default is 2.

 [bookmark: pgfId-293594]Note The outside standby group number must be different to the inside standby group number.

  
       

 
        
        		[bookmark: pgfId-293600]Failover Server

  
        		[bookmark: pgfId-293602]The IP address or network/host policy object that identifies the inside interface of the remote peer failover servers. Enter the IP address or network/host object name, or click Select to select an object or to create a new object.

  
       

 
        
        		[bookmark: pgfId-293608]Enable Stateful Failover

  
        		[bookmark: pgfId-293610]Enables SSO for stateful failover. This option is always selected and you cannot deselect it for remote access VPNs.

  
       

 
      
     

 
    
 
    [bookmark: pgfId-294869]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-294893][bookmark: 86525][bookmark: ravpnch_proc_ConfiguringUserGroupPoliciesIOS]Configuring User Group Policies[bookmark: marker-294877][bookmark: marker-294879][bookmark: marker-294881][bookmark: marker-294883][bookmark: marker-294885][bookmark: marker-294887][bookmark: marker-294889][bookmark: marker-294891]

 
    [bookmark: pgfId-294895]Use the User Groups (IOS/PIX 6.x) policy to specify user groups for your remote access IPSec VPN server. You can configure user groups on a Cisco IOS router, PIX 6.3 Firewall, or Catalyst 6500 /7600 device.

 
    [bookmark: pgfId-294897]When you configure a remote access VPN server, you must create user groups to which remote clients will belong. A user group policy specifies the attributes that determine user access to and use of the VPN. User groups simplify system management, enabling you to quickly configure VPN access for large numbers of users.

 
    [bookmark: pgfId-294899]For example, in a typical remote access VPN, you might allow a finance group to access one part of a private network, a customer support group to access another part, and an MIS group to access other parts. In addition, you might allow specific users within MIS to access systems that other MIS users cannot access. User group policies provide the flexibility to do so securely.

 
    [bookmark: pgfId-294901]Remote clients must have the same group name as the user group configured on the VPN server so that they can connect to the device; otherwise, a connection cannot be established. When a remote client establishes a connection to the VPN server, the group policies for that user group are pushed to all clients belonging to the same user group. You can configure user groups on the local remote access VPN server and external AAA servers.

 
    [bookmark: pgfId-294903]Notes

 
     
     		 [bookmark: pgfId-294908]You can also specify user groups using the Remote Access VPN Configuration Wizard. For more information, see Using the Remote Access VPN Configuration Wizard.

 
     		 [bookmark: pgfId-294913]To specify group policies for an SSL VPN on an IOS device, use the SSL VPN policy as explained in Configuring an SSL VPN Policy (IOS).

 
    

 
    [bookmark: pgfId-294915]Related Topics

 
     
     		 [bookmark: pgfId-294920]Understanding Remote Access IPSec VPNs

 
    

 
    
 
    [bookmark: pgfId-294922]Step 1 Do one of the following:

 
     
     		 [bookmark: pgfId-294924](Device view) With an IOS router, Catalyst 6500/7600, or PIX 6.3 device selected, select  Remote Access VPN > IPSec VPN > User Groups (IOS/PIX 6.x) from the Policy selector.

 
     		 [bookmark: pgfId-294926](Policy view) Select  Remote Access VPN > IPSec VPN > User Groups (IOS/PIX6.x) from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-294928]The User Groups page opens.

 
    [bookmark: pgfId-294930]The page contains two lists: Available User Groups lists all existing User Group policy objects that are configured for remote access IPsec VPNS; Selected User Groups lists all of the User Group policy objects that will be configured on the device.

 
    [bookmark: pgfId-294932]Step 2 Ensure that the list of selected user groups contains the desired User Group policy objects:

 
     
     		 [bookmark: pgfId-294937]To create a new User Group policy object, click the Create (+) button beneath the available user groups list to open the Add User Group dialog box. For instructions on creating the object, see Add or Edit User Group Dialog Box.

 
    

 
    [bookmark: pgfId-294939]After you create the group, it is added to the available list, and you must add it to the selected list if you want to use it.

 
     
     		 [bookmark: pgfId-294941]To add a User Group to the selected list, select it in the available list and click  >> .

 
     		 [bookmark: pgfId-294943]To remove a User Group, select it in the selected list and click  << . If the group is already configured on the device, it will be removed during the next deployment.

 
     		 [bookmark: pgfId-294945]You can edit the properties of a User Group object by selecting it in either list and clicking the  Edit button.

 
    

 
    [bookmark: pgfId-294947]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-294965][bookmark: 86609][bookmark: ravpnch_cncpt_ConfiguringanSSLVPNPolicyIOS]Configuring an SSL VPN Policy (IOS)[bookmark: marker-294955][bookmark: marker-294957][bookmark: marker-294959][bookmark: marker-294961][bookmark: marker-294963]

 
    [bookmark: pgfId-294967]Use the SSL VPN policy to configure the SSL VPN connection policies for an IOS router. From this page, you can create, edit, or delete SSL VPN policies.

 
    [bookmark: pgfId-294969]Related Topics

 
     
     		 [bookmark: pgfId-294974]Understanding Remote Access SSL VPNs

 
     		 [bookmark: pgfId-294979]Creating SSL VPNs Using the Remote Access VPN Configuration Wizard (IOS Devices)

 
     		 [bookmark: pgfId-294984]Filtering Tables

 
    

 
    
 
    [bookmark: pgfId-294986]Step 1 Do one of the following:

 
     
     		 [bookmark: pgfId-294988](Device view) With an IOS device selected, select  Remote Access VPN > SSL VPN from the Policy selector.

 
     		 [bookmark: pgfId-294990](Policy view) Select  Remote Access VPN > SSL VPN > SSL VPN Policy (IOS) from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-294992]The SSL VPN page appears.

 
    [bookmark: pgfId-294994]The table lists all of the contexts that define the virtual configurations of the SSL VPN. Each context has a gateway, domain or virtual hostname, and user group policies. The status of the context is also shown, either In Service or Out of Service.

 
    [bookmark: pgfId-294996]Step 2 Do either of the following:

 
     
     		 [bookmark: pgfId-295001]To add a context, click the  Add Row button to open the SSL VPN Context Editor Dialog Box (IOS).

 
     		 [bookmark: pgfId-295003]To edit a context, select it and click the  Edit Row button.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-295005]Note To delete a context, select it and click the Delete Row button.


    
     

    

    

 
    [bookmark: pgfId-295010]Step 3 Configure at least the following general settings for the policy. For information on other fields, see General Tab.

 
     
     		 [bookmark: pgfId-295012] Name, Domain —For new policies, the name of the context that defines the virtual configuration of the SSL VPN. To simplify the management of multiple context configurations, make the context name the same as the domain or virtual hostname.

 
     		 [bookmark: pgfId-295014] Gateway —The SSL VPN gateway policy object that identifies the gateway device to which users will connect, including interface and port configuration. Click  Select to select the object from a list or to create a new object.

 
    

 
    [bookmark: pgfId-295016]When you select the object, the Portal Page URL field shows the URL to which users connect.

 
     
     		 [bookmark: pgfId-295018] Authentication Server Group —A prioritized list of AAA server group objects that identify the AAA servers to use for authenticating users.

 
     		 [bookmark: pgfId-295020] User Groups — The user groups that will be used in your SSL VPN policy. User groups define the resources available to users when connecting to an SSL VPN gateway.

 
    

 
    [bookmark: pgfId-295025]To add a user group, click Add Row to open a list of existing user group policy objects from which you can select the group. If the desired group does not already exist, click the Create button below the available groups list and create it. For more information about user group objects, see Add or Edit User Group Dialog Box.

 
    [bookmark: pgfId-295027]Step 4 Click the Portal Page tab and customize the design of the login page. You can customize the title, the logo graphic, the message that appears above the login prompt, and the background and text colors.

 
    [bookmark: pgfId-295029]If you want to select a different graphic, you must first copy the graphic onto the Security Manager server. You cannot select it from your workstation’s hard drive.

 
    [bookmark: pgfId-295031]Step 5 Click the Secure Desktop tab to configure Cisco Secure Desktop (CSD) software. CSD policies define entry requirements for client systems and provide a single, secure location for session activity and removal on the client system, ensuring that sensitive data is shared only for the duration of an SSL VPN session.

 
    [bookmark: pgfId-295036]If you want to use CSD, select Enable Cisco Secure Desktop and click Select to select a Secure Desktop Configuration policy object, which defines the rules you want to use to control VPN access and host scanning. You can create a new object from the selection list. For information about configuring these objects, see Creating Cisco Secure Desktop Configuration Objects.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-295038]Note You must install and activate the Secure Desktop Client software on a device for your configuration to work.


    
     

    

    

 
    [bookmark: pgfId-295040]Step 6 Click the Advanced tab to configure a maximum number of simultaneous users for the context or if you are using VRF, the name of the VRF instance that is associated with the SSL VPN context.

 
    [bookmark: pgfId-295042]Step 7 Click OK to save your changes.

 
    [bookmark: pgfId-295044]


    
     

    
 
    

 
     
      [bookmark: pgfId-295068][bookmark: 86710][bookmark: ravpnpg_cncpt_SSLVPNContextEditorDialogBoxIOS]SSL VPN Context Editor Dialog Box (IOS) [bookmark: marker-295058][bookmark: marker-295060][bookmark: marker-295062][bookmark: marker-295064][bookmark: marker-295066]

 
     [bookmark: pgfId-295073]Use this dialog box to create or modify a context that defines the virtual configuration of an SSL VPN. For more information, see Configuring an SSL VPN Policy (IOS).

 
     [bookmark: pgfId-295075]Navigation Path

 
     [bookmark: pgfId-295080]Open the SSL VPN (IOS) policy, then click Add Row (+), or select a context in the table and click Edit Row. For information on opening the SSL VPN policy, see Configuring an SSL VPN Policy (IOS).

 
     [bookmark: pgfId-295082]Field Reference

 
     [bookmark: pgfId-295085] 

 
      
       
        
        [bookmark: pgfId-293623]Table 33-5 [bookmark: 86746]SSL VPN Context Editor Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-293629]Element
          
  
         		
           
           [bookmark: pgfId-293631]Description
          
  
        

 
         
         		[bookmark: pgfId-293637]General tab

  
         		[bookmark: pgfId-293642]Defines the general settings required for an SSL VPN policy. General settings include specifying the gateway, domain, AAA servers for accounting and authentication, and user groups. For a description of the fields on this tab, see General Tab.

  
        

 
         
         		[bookmark: pgfId-293648]Portal Page tab

  
         		[bookmark: pgfId-293650]Defines the design of the login page for the SSL VPN policy. The display box at the bottom of the tab changes to show you how your selections will look. You can configure:

 
           
           		 [bookmark: pgfId-293652]Title—The text displayed at the top of the page. Control the color using the Primary settings in the Title Color and Text Color fields.

 
           		 [bookmark: pgfId-293654]Logo—The graphic displayed next to the title. Select None, Default, or Custom. To configure a custom graphic, you must copy the desired graphic to the Security Manager server, then click  Browse to select the file. Supported graphic types are GIF, JPG, and PNG, with a maximum size of 100 KB.

 
           		 [bookmark: pgfId-293656]Login Message—The text displayed immediately above the login prompt. Control the color using the Secondary settings in the Title Color and Text Color fields.

 
          

  
        

 
         
         		[bookmark: pgfId-293662]Secure Desktop tab

  
         		[bookmark: pgfId-293664]Configures the Cisco Secure Desktop (CSD) software on the router. CSD policies define entry requirements for client systems and provide a single, secure location for session activity and removal on the client system, ensuring that sensitive data is shared only for the duration of an SSL VPN session.

 [bookmark: pgfId-293666]Note You must install and activate the Secure Desktop Client software on a device for your configuration to work.

 [bookmark: pgfId-293671]If you want to use CSD, select Enable Cisco Secure Desktop and click Select to select a Secure Desktop Configuration policy object, which defines the rules you want to use to control VPN access and host scanning. You can create a new object from the selection list. For information about configuring these objects, see Creating Cisco Secure Desktop Configuration Objects.

  
        

 
         
         		[bookmark: pgfId-293677]Advanced tab

  
         		[bookmark: pgfId-293679]Configures these additional settings:

 
           
           		 [bookmark: pgfId-293681]Maximum Number of Users—The maximum number of SSL VPN user sessions allowed at one time, from 1-1000.

 
           		 [bookmark: pgfId-293686]VRF Name—If Virtual Routing Forwarding (VRF) is configured on the device, the name of the VRF instance that is associated with the SSL VPN context. For information about VRF, see Understanding VRF-Aware IPsec.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-295101][bookmark: 86796][bookmark: ravpnpg_cncpt_GeneralTab-1]General Tab[bookmark: marker-295093][bookmark: marker-295095][bookmark: marker-295097][bookmark: marker-295099]

 
     [bookmark: pgfId-295103]Use the General tab of the SSL VPN Context Editor dialog box to define or edit the general settings required for an SSL VPN policy. General settings include specifying the gateway, domain, AAA servers for accounting and authentication, and user groups.

 
     [bookmark: pgfId-295105]Navigation Path

 
     [bookmark: pgfId-295110]Open the SSL VPN Context Editor Dialog Box (IOS), then click the General tab.

 
     [bookmark: pgfId-295112]Related Topics

 
      
      		 [bookmark: pgfId-295117]Configuring an SSL VPN Policy (IOS)

 
      		 [bookmark: pgfId-295122]Add or Edit SSL VPN Gateway Dialog Box

 
      		 [bookmark: pgfId-295127]Understanding AAA Server and Server Group Objects

 
     

 
     [bookmark: pgfId-295129]Field Reference

 
     [bookmark: pgfId-295132] 

 
      
       
        
        [bookmark: pgfId-293699]Table 33-6 [bookmark: 86837]SSL VPN Context Editor General Tab (IOS) 

 
        
       
         
         		
           
           [bookmark: pgfId-293705]Element
          
  
         		
           
           [bookmark: pgfId-293707]Description
          
  
        

 
         
         		[bookmark: pgfId-293713]Enable SSL VPN

  
         		[bookmark: pgfId-293715]Whether to activate the SSL VPN connection, putting it “In Service”.

  
        

 
         
         		[bookmark: pgfId-293721]Name

  
         		[bookmark: pgfId-293723]The name of the context that defines the virtual configuration of the SSL VPN.

 [bookmark: pgfId-293725]Note To simplify the management of multiple context configurations, make the context name the same as the domain or virtual hostname.

  
        

 
         
         		[bookmark: pgfId-293731]Gateway

  
         		[bookmark: pgfId-293733]The name of the SSL VPN gateway policy object that defines the characteristics of the gateway to which users connect when entering the VPN. A gateway object provides the interface and port configuration for an SSL VPN connection.

 [bookmark: pgfId-293735]Enter the name of the object or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-293741]Domain

  
         		[bookmark: pgfId-293743]The domain or virtual hostname of the SSL VPN connection.

  
        

 
         
         		[bookmark: pgfId-293749]Portal Page URL

  
         		[bookmark: pgfId-293751]The URL for the SSL VPN, which is filled in when you select a gateway object. Users connect to this URL to enter the VPN.

  
        

 
         
         		[bookmark: pgfId-293757]Authentication Server Group

  
         		[bookmark: pgfId-293759]The authentication server groups. The list is in prioritized order. Authentication is attempted using the first group and proceeds through the list until the user is successfully authenticated or denied. Use the LOCAL group if the users are defined on the gateway itself.

 [bookmark: pgfId-293761]Enter the names of the AAA server groups; separate multiple entries with commas. You can click Select to select the groups or to create new ones.

  
        

 
         
         		[bookmark: pgfId-293767]Authentication Domain

  
         		[bookmark: pgfId-293769]A list or method for SSL VPN remote user authentication. If you do not specify a list or method, the gateway uses global AAA parameters for remote-user authentication.

  
        

 
         
         		[bookmark: pgfId-293775]Accounting Server Group

  
         		[bookmark: pgfId-293777]The accounting server group. Enter the name of the AAA server group policy object, or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-293783]User Groups

  
         		[bookmark: pgfId-293785]The user groups that will be used in your SSL VPN policy. User groups define the resources available to users when connecting to an SSL VPN gateway. The table shows whether full client, CIFS file access, and thin client is enabled for the group.

 
           
           		 [bookmark: pgfId-293790]To add a user group, click  Add Row to open a list of existing user group policy objects from which you can select the group. If the desired group does not already exist, click the  Create button below the available groups list and create it. For more information about user group objects, see Add or Edit User Group Dialog Box.

 
           		 [bookmark: pgfId-293792]To edit a user group, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-293794]To delete a user group, select it and click the  Delete Row button. This deletes the group only from the policy, it does not delete the user group policy object.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-295144][bookmark: 86912][bookmark: obman_cncpt_UnderstandingSecureDesktopConfigurationObjects]Creating Cisco Secure Desktop Configuration Objects[bookmark: marker-295138][bookmark: marker-295140][bookmark: marker-295142]

 
     [bookmark: pgfId-295155]Cisco Secure Desktop (CSD) Configuration objects define the settings you want to use if you enable Secure Desktop in an SSL VPN policy for an IOS device (see Configuring an SSL VPN Policy (IOS)). For ASA devices, the feature is set up as part of the Dynamic Access Policy (see Understanding Dynamic Access Policies and Configuring Cisco Secure Desktop Policies on ASA Devices).

 
     [bookmark: pgfId-295157]Cisco Secure Desktop (CSD) provides a reliable means of eliminating all traces of sensitive data by providing a single, secure location for session activity and removal on the client system. CSD provides a session-based interface where sensitive data is shared only for the duration of an SSL VPN session. All session information is encrypted, and all traces of the session data are removed from the remote client when the session is terminated, even if the connection terminates abruptly.

 
     [bookmark: pgfId-295159]About Windows Locations

 
     [bookmark: pgfId-295161]Windows locations let you determine how clients connect to your virtual private network, and protect it accordingly. For example, clients connecting from within a workplace LAN on a 10.x.x.x network behind a NAT device are an unlikely risk for exposing confidential information. For these clients, you might set up a CSD Windows Location named Work that is specified by IP addresses on the 10.x.x.x network, and disable both the Cache Cleaner and the Secure Desktop function for this location.

 
     [bookmark: pgfId-295163]In contrast, users’ home PCs might be considered more at risk to viruses due to their mixed use. For these clients, you might set up a location named Home that is specified by a corporate-supplied certificate that employees install on their home PCs. This location would require the presence of antivirus software and specific, supported operating systems to grant full access to the network.

 
     [bookmark: pgfId-295165]Alternatively, for untrusted locations such as Internet cafes, you might set up a location named “Insecure” that has no matching criteria (thus making it the default for clients that do not match other locations). This location would require full Secure Desktop functions, and include a short timeout period to prevent access by unauthorized users. If you create a location and do not specify criteria, make sure it is the last entry in the Locations list.

 
     [bookmark: pgfId-295167]Related Topics

 
      
      		 [bookmark: pgfId-295171]Cisco Secure Desktop on IOS Configuration Example Using SDM,  http://www.cisco.com/en/US/products/ps6496/products_configuration_example09186a008072aa7b.shtml 

 
      		 [bookmark: pgfId-295175]Setting Up CSD for Microsoft Windows Clients,  http://www.cisco.com/en/US/docs/security/csd/csd311/csd_for_vpn3k_cat6k/configuration/guide/CSDwin.html 

 
      		 [bookmark: pgfId-295180]Creating Policy Objects

 
     

 
     
 
     [bookmark: pgfId-295185]Step 1 Select Manage > Policy Objects to open the Policy Object Manager (see Policy Object Manager).

 
     [bookmark: pgfId-295187]Step 2 Select Cisco Secure Desktop Configuration from the Object Type selector.

 
     [bookmark: pgfId-295192]Step 3 Right-click in the work area and select New Object to open the Add or Edit Secure Desktop Configuration Dialog Box.

 
     [bookmark: pgfId-295194]Step 4 Enter a name for the object and optionally a description of the object.

 
     [bookmark: pgfId-295196]Step 5 Select Windows Location Settings to create locations (such as Work, Home, or Insecure), and define the location-based settings (also called adaptive policies) for CSD.

 
     [bookmark: pgfId-295198] a. For each location you want to configure, enter its name in the Location to Add field and click Add to move it to the Locations field. You can reorder the locations using the Move Up and Move Down buttons. When users connect, these locations are evaluated in order and the first one that matches is used to define the policies for the user.

 
     [bookmark: pgfId-295200]When you add a location, a folder for the location is added to the table of contents. The folder and its subfolders define the policies for the location.

 
     [bookmark: pgfId-295202] b. If you want all the open browser windows to close after the Secure Desktop installation, make sure to select the corresponding check box.

 
     [bookmark: pgfId-295204] c. Select the required check boxes to configure a VPN Feature policy that enables web browsing, file access, port forwarding, and full tunneling, if installation or location matching fails.

 
     [bookmark: pgfId-295208]Step 6 Select the folders and subfolders for the Windows locations you added and configure their settings. For detailed information about these settings, see Setting Up CSD for Microsoft Windows Clients at http://www.cisco.com/en/US/docs/security/csd/csd311/csd_for_vpn3k_cat6k/configuration/guide/CSDwin.html.

 
     [bookmark: pgfId-295210]Step 7 Select Windows CE to configure a VPN feature policy to enable or restrict web browsing and remote server file access for remote clients running Microsoft Windows CE.

 
     [bookmark: pgfId-295212]Step 8 Select Mac and Linux Cache Cleaner to configure the Cache Cleaner and a VPN Feature Policy for these clients, such as enabling or restricting web browsing, remote server file access, and port forwarding.

 
     [bookmark: pgfId-295217]Step 9 (Optional) Under Category, select a category to help you identify this object in the Objects table. See Using Category Objects.

 
     [bookmark: pgfId-295219]Step 10 Click OK to save the object.

 
     [bookmark: pgfId-295221]
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     [bookmark: pgfId-979945][bookmark: 116477][bookmark: pxchap_cncpt_ConfiguringLoggingPoliciesonFirewallDevices]Configuring Logging Policies on Firewall Devices[bookmark: marker-979939][bookmark: marker-979941][bookmark: marker-979943]
      
      
 
     
 

 
    [bookmark: pgfId-979947]The Logging feature lets you enable and manage NetFlow “collectors,” and enable system logging, set up logging parameters, configure event lists (syslog filters), apply the filters to a destination, set up syslog messages, configure syslog servers, and specify e-mail notification parameters.

 
    [bookmark: pgfId-979949]After you enable logging and set up the logging parameters using the Logging Setup page, the Event Lists page lets you configure filters (for a set of syslogs) which can be sent to a logging destination. The Logging Filters page lets you specify a logging destination for the syslogs to be sent. Finally, the Syslog and E-Mail pages configure syslog and e-mail setup.

 
    [bookmark: pgfId-979951]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-979956]NetFlow Page

 
     		 [bookmark: pgfId-979961]Embedded Event Manager

 
     		 [bookmark: pgfId-979966]E-Mail Setup Page

 
     		 [bookmark: pgfId-979971]Event Lists Page

 
     		 [bookmark: pgfId-979976]Logging Filters Page

 
     		 [bookmark: pgfId-979981]Configuring Logging Setup

 
     		 [bookmark: pgfId-979986]Configuring Rate Limit Levels

 
     		 [bookmark: pgfId-979991]Configuring Syslog Server Setup

 
     		 [bookmark: pgfId-979996]Defining Syslog Servers

 
    

 
   
 
    
     [bookmark: pgfId-980010][bookmark: 116491][bookmark: pxpage_cncpt_NetFlowPage]NetFlow Page [bookmark: marker-980004][bookmark: marker-980006][bookmark: marker-980008]

 
    [bookmark: pgfId-980012]A device configured for NetFlow data export captures flow-based traffic statistics on the device. This information is periodically transmitted from the device to a NetFlow collection server, in the form of User Datagram Protocol (UDP) datagrams.

 
    [bookmark: pgfId-980014]The NetFlow page lets you enable NetFlow export on the selected device, and define and manage NetFlow “collectors” to which collected flow information is transmitted.

 
    [bookmark: pgfId-980016]Navigation Path

 
     
     		 [bookmark: pgfId-980018](Device view) Select  Platform > Logging > NetFlow from the Device Policy selector.

 
     		 [bookmark: pgfId-980020](Policy view) Select  PIX/ASA/FWSM Platform > Logging > NetFlow from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-980022]Related Topics

 
     
     		 [bookmark: pgfId-980027]Using Rules Tables

 
     		 [bookmark: pgfId-980032]Filtering Tables

 
     		 [bookmark: pgfId-980037]Table Columns and Column Heading Features

 
    

 
    [bookmark: pgfId-980039]Field Reference

 
    [bookmark: pgfId-980042] 

 
     
      
       
       [bookmark: pgfId-977522]Table 53-1 [bookmark: 116532]NetFlow Page 

 
       
      
        
        		
          
          [bookmark: pgfId-977528]Element
         
  
        		
          
          [bookmark: pgfId-977530]Description
         
  
       

 
        
        		[bookmark: pgfId-977536]Enable Flow Export

  
        		[bookmark: pgfId-977538]If checked, NetFlow data export is enabled.

  
       

 
        
        		[bookmark: pgfId-977544]Template Export Interval

  
        		[bookmark: pgfId-977546]Interval (in minutes) between transmissions of flow information to the collectors. The value can be from one to 3600 minutes; the default is 30.

  
       

 
        
        		[bookmark: pgfId-977552]Active Refresh Interval

  
        		[bookmark: pgfId-977554]For active connections, specifies the time interval between flow-update events in minutes. Valid values are from 1 to 60 minutes. The default value is 1 minute.

  
       

 
        
        		[bookmark: pgfId-977560]Delay Flow Create

  
        		[bookmark: pgfId-977562]Delays the sending of a flow-create event by the specified number of seconds. The value can be from one to 180 seconds.

 [bookmark: pgfId-977564]If no value is entered, there is no delay, and the flow-create event is exported as soon as the flow is created. If the flow is torn down before the configured delay, the flow-create event is not sent; an extended flow teardown event is sent instead.

  
       

 
        
        		[bookmark: pgfId-977570]Collectors table

  
        		[bookmark: pgfId-977572]Lists the currently defined NetFlow collectors. Use the Add Row, Edit Row and Delete Row buttons below the table to manage these entries.

 [bookmark: pgfId-977577]The Add Row and Edit Row buttons open the Add and Edit Collector Dialog Boxes (NetFlow).

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-980058][bookmark: 116570][bookmark: pxpage_cncpt_AddEditNetflowCollectorDialogBox]Add and Edit Collector Dialog Boxes (NetFlow) [bookmark: marker-980050][bookmark: marker-980052][bookmark: marker-980054][bookmark: marker-980056]

 
     [bookmark: pgfId-980060]Use the Add Collector and Edit Collector dialog boxes to define and edit NetFlow “collectors.” Except for the title, the two dialog boxes are identical; the following information applies to both.

 
     [bookmark: pgfId-980062]Navigation Path

 
     [bookmark: pgfId-980067]You can open the Add and Edit Collector dialog boxes from the NetFlow Page.

 
     [bookmark: pgfId-980069]Field Reference

 
     [bookmark: pgfId-980072] 

 
      
       
        
        [bookmark: pgfId-977590]Table 53-2 [bookmark: 116595]Add and Edit Collector Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-977596]Element
          
  
         		
           
           [bookmark: pgfId-977598]Description
          
  
        

 
         
         		[bookmark: pgfId-977604]Interface

  
         		[bookmark: pgfId-977606]Enter or Select the name of the device interface through which the collector is contacted.

  
        

 
         
         		[bookmark: pgfId-977612]Collector

  
         		[bookmark: pgfId-977614]Enter the IP address or the network name of the server to which NetFlow packets will be sent. You also can Select a Networks/Hosts object.

  
        

 
         
         		[bookmark: pgfId-977620]UDP Port

  
         		[bookmark: pgfId-977622]Specify the UDP port on the specified Collector to which NetFlow packets will be sent. Values can range from 1 to 65535; the default is 2055.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-980090][bookmark: 116622][bookmark: pxpage_cncpt_EEMPage]Embedded Event Manager[bookmark: marker-980080][bookmark: marker-980082][bookmark: marker-980084][bookmark: marker-980086][bookmark: marker-980088]

 
    [bookmark: pgfId-980092]The Embedded Event Manager (EEM) enables you to debug problems and provides general purpose logging for troubleshooting. There are two components: events to which the EEM responds or listens, and event manager applets that define actions as well as the events to which the EEM responds. You may configure multiple event manager applets to respond to different events and perform different actions.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-980094]Note Embedded Event Manager is supported on ASA 9.2(1)+ only.


    
     

    

    

 
    [bookmark: pgfId-980096]Supported Events

 
    [bookmark: pgfId-980098]The EEM supports the following events:

 
     
     		 [bookmark: pgfId-980100]Syslog—The ASA uses syslog message IDs to identify syslog messages that trigger an event manager applet. You may configure multiple syslog events, but the syslog message IDs may not overlap within a single event manager applet.

 
     		 [bookmark: pgfId-980102]Timers—You may use timers to trigger events. You may configure each timer only once for each event manager applet. Each event manager applet may have up to three timers. The three types of timers are the following:

 
    

 
    [bookmark: pgfId-980104] – Watchdog (periodic) timers trigger an event manager applet after the specified time period following the completion of the applet’s actions and restart automatically.

 
    [bookmark: pgfId-980106] – Countdown (one-shot) timers trigger an event manager applet once after the specified time period and do not restart unless they are removed, then re-added.

 
    [bookmark: pgfId-980108] – Absolute (once-a-day) timers cause an event to occur once a day at a specified time, and restart automatically. The time-of-day format is in hh:mm:ss.

 
    [bookmark: pgfId-980110]You may configure only one timer event of each type for each event manager applet.

 
     
     		 [bookmark: pgfId-980112]None—The none event is triggered when you run an event manager applet manually.

 
     		 [bookmark: pgfId-980114]Crash—The crash event is triggered when the ASA crashes. Regardless of the value of the output command, the action commands are directed to the crashinfo file. The output is generated before the show tech command.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-980116]Note Be careful when using a range of Syslog IDs and when using timers. Incorrect configuration can cause an ASA loop and prevent the applet from executing normally.


    
     

    

    

 
    [bookmark: pgfId-980118]Configuring Actions

 
    [bookmark: pgfId-980120]When an event manager applet is triggered, the actions on the event manager applet are performed. Each action has a number that is used to specify the sequence of the actions. The sequence number must be unique within an event manager applet. You may configure multiple actions for an event manager applet. The commands are typical CLI commands, such as show blocks.

 
    [bookmark: pgfId-980122]Configuring Output Destinations

 
    [bookmark: pgfId-980124]You may send the output of the action CLI commands to one of three locations:

 
     
     		 [bookmark: pgfId-980126]None, which is the default and discards the output

 
     		 [bookmark: pgfId-980128]Console, which sends the output to the ASA console

 
     		 [bookmark: pgfId-980130]File, which sends the output to a file. The following four file options are available:

 
    

 
    [bookmark: pgfId-980132] – new—creates a new, uniquely named file each time that an event manager applet is invoked.

 
    [bookmark: pgfId-980134] – overwrite—overwrites a specified file each time that an event manager applet is invoked.

 
    [bookmark: pgfId-980136] – append—appends to a specified file each time that an event manager applet is invoked. If the file does not yet exist, it is created.

 
    [bookmark: pgfId-980138] – rotate—creates a set of uniquely named files that are rotated each time that an event manager applet is invoked.

 
    [bookmark: pgfId-980140]Guidelines and Limitations

 
     
     		 [bookmark: pgfId-980142]Supported in single mode only. Not supported in multiple context mode.

 
     		 [bookmark: pgfId-980144]Supported in routed and transparent firewall modes.

 
     		 [bookmark: pgfId-980146]EEM will be enabled irrespective of whether logging functionality is enabled on the device or not.

 
     		 [bookmark: pgfId-980148]The EEM functionality on the ASA only contains a subset of the EEM functionality found on Cisco routers.

 
     		 [bookmark: pgfId-980150]During a crash, the state of the ASA is generally unknown. Some commands may not be safe to run during this condition.

 
     		 [bookmark: pgfId-980152]The name of an event manager applet may not contain spaces.

 
     		 [bookmark: pgfId-980154]You cannot modify the None event and Crashinfo event parameters.

 
     		 [bookmark: pgfId-980156]Performance may be affected because syslog messages are sent to the EEM for processing.

 
     		 [bookmark: pgfId-980158]The default output is none for each event manager applet. To change this setting, you must enter a different output value.

 
     		 [bookmark: pgfId-980160]You may have only one output option defined for each event manager applet.

 
    

 
    [bookmark: pgfId-980165]The Embedded Event Manager table lists the currently defined event manager applets. Use the Add Row, Edit Row and Delete Row buttons below the table to manage these entries. The Add Row and Edit Row buttons open the Add and Edit Applet Dialog Boxes.

 
    [bookmark: pgfId-980167]Navigation Path

 
     
     		 [bookmark: pgfId-980169](Device view) Select  Platform > Logging > Embedded Event Manager from the Device Policy selector.

 
     		 [bookmark: pgfId-980171](Policy view) Select  PIX/ASA/FWSM Platform > Logging > Embedded Event Manager from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-980173]Related Topics

 
     
     		 [bookmark: pgfId-980178]Add and Edit Applet Dialog Boxes

 
     		 [bookmark: pgfId-980183]Table Columns and Column Heading Features

 
    

 
     
      [bookmark: pgfId-980197][bookmark: 116730][bookmark: pxpage_cncpt_EEMAddEditAppletDialogBox]Add and Edit Applet Dialog Boxes[bookmark: marker-980191][bookmark: marker-980193][bookmark: marker-980195]

 
     [bookmark: pgfId-980199]Use the Add Applet and Edit Applet dialog boxes to define and edit event manager applets. Except for the title, the two dialog boxes are identical; the following information applies to both.

 
     [bookmark: pgfId-980201]Navigation Path

 
     [bookmark: pgfId-980206]You can open the Add and Edit Applet dialog boxes from the Embedded Event Manager.

 
     [bookmark: pgfId-980208]Field Reference

 
     [bookmark: pgfId-980211] 

 
      
       
        
        [bookmark: pgfId-977635]Table 53-3 [bookmark: 116750]Add and Edit Applet Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-977641]Element
          
  
         		
           
           [bookmark: pgfId-977643]Description
          
  
        

 
         
         		[bookmark: pgfId-977649]Name

  
         		[bookmark: pgfId-977651]Enter a unique name for the event manager applet. The name cannot contain spaces and must be less than 32 characters.

  
        

 
         
         		[bookmark: pgfId-977657]Description

  
         		[bookmark: pgfId-977659]Enter a description for the event manager applet. The description may be up to 256 characters long.

  
        

 
         
         		 
           
           [bookmark: pgfId-977665]Configuration Tab
          
  
        

 
         
         		[bookmark: pgfId-977673]Crashinfo

  
         		[bookmark: pgfId-977675]When selected, the event manager applet is triggered when the ASA crashes. Regardless of the value of the Output field, the action commands are directed to the crashinfo file. The output is generated before the show tech command.

 [bookmark: pgfId-977677]Note The state of the ASA is generally unknown when it crashes. Some CLI commands may not be safe to run during this condition.

  
        

 
         
         		[bookmark: pgfId-977683]None

  
         		[bookmark: pgfId-977685]When selected, you can trigger the event manager applet manually.

 [bookmark: pgfId-977690]Note Manual triggering of the EEM applet is not supported in Cisco Security Manager. To manually trigger an applet, you must use a FlexConfig. See Chapter 7, “Managing FlexConfigs” for more information.

  
        

 
         
         		[bookmark: pgfId-977696]Syslog table

  
         		[bookmark: pgfId-977701]The Syslog table lists the currently defined syslog message IDs for the selected applet. Use the Add Row, Edit Row and Delete Row buttons below the table to manage these entries. The Add Row and Edit Row buttons open the Add and Edit Syslog Configuration Dialog Boxes.

  
        

 
         
         		[bookmark: pgfId-977707]Absolute

  
         		[bookmark: pgfId-977709]Configure an absolute (once-a-day) timer event Absolute timers cause an event to occur once a day at a specified time, and restart automatically.

 [bookmark: pgfId-977711]Use the fields provided to enter the time of day in hours, minutes, and seconds. The time range is from 00:00:00 (midnight) to 23:59:59.

  
        

 
         
         		[bookmark: pgfId-977717]Countdown

  
         		[bookmark: pgfId-977719]Configures a countdown (one-shot) timer event. Countdown timers trigger an event manager applet once after the specified time period and do not restart unless they are removed, then re-added.

 [bookmark: pgfId-977721]Enter the time period in seconds. The number of seconds may range from 1- 604800.

  
        

 
         
         		[bookmark: pgfId-977727]Watchdog

  
         		[bookmark: pgfId-977729]Configures a watchdog (periodic) timer event. Watchdog timers trigger an event manager applet after the specified time period following the completion of the applet’s actions and restart automatically.

 [bookmark: pgfId-977731]Enter the time period in seconds. The number of seconds may range from 1- 604800.

  
        

 
         
         		[bookmark: pgfId-977737]Output

  
         		[bookmark: pgfId-977739]To configure specific destinations for sending output from an action, choose one of the available output destination options:

 
           
           		 [bookmark: pgfId-977741]none—(default) discards the output.

 
           		 [bookmark: pgfId-977743]console—sends the output to the ASA console.

 
           		 [bookmark: pgfId-977745]file—sends the output to a file. Select the file option in the Action list.

 
          

  
        

 
         
         		[bookmark: pgfId-977751]Action

  
         		[bookmark: pgfId-977753]The following four file options are available:

 
           
           		 [bookmark: pgfId-977755]new—creates a new, uniquely named file each time that an event manager applet is invoked. The filename has the format of eem-applet-timestamp.log, in which applet is the name of the event manager applet and timestamp is a dated timestamp in the format of YYYYMMDD-hhmmss.

 
           		 [bookmark: pgfId-977757]overwrite—overwrites a specified file each time that an event manager applet is invoked. Specify the file details using the File Location and File Name fields.

 
           		 [bookmark: pgfId-977759]append—appends to a specified file each time that an event manager applet is invoked. If the file does not yet exist, it is created. Specify the file details using the File Location and File Name fields.

 
           		 [bookmark: pgfId-977761]rotate—creates a set of uniquely named files that are rotated each time that an event manager applet is invoked. Specify the number of files to be rotated in the File Count field (valid values range from 2 - 100).

 
          

 [bookmark: pgfId-977763]When a new file is to be written, the oldest file is deleted, and all subsequent files are renumbered before the first file is written. The newest file is indicated by 0, and the oldest file is indicated by the highest number. The filename format is eem-applet-x.log, in which applet is the name of the applet, and x is the file number.

  
        

 
         
         		[bookmark: pgfId-977769]File Location

  
         		[bookmark: pgfId-977771]Specifies the location of the output file. The location may also use FTP, TFTP, and SMB targeted files.

  
        

 
         
         		[bookmark: pgfId-977777]File Name

  
         		[bookmark: pgfId-977779]Specifies the filename of the output file.

  
        

 
         
         		[bookmark: pgfId-977785]File Count

  
         		[bookmark: pgfId-977787]Specify the number of files to be rotated when "rotate" is the selected Action.

 [bookmark: pgfId-977789]When a new file is to be written, the oldest file is deleted, and all subsequent files are renumbered before the first file is written. The newest file is indicated by 0, and the oldest file is indicated by the highest number. Valid values for the rotate value range from 2 - 100. The filename format is eem-applet-x.log, in which applet is the name of the applet, and x is the file number.

  
        

 
         
         		 
           
           [bookmark: pgfId-977795]Action Tab
          
  
        

 
         
         		[bookmark: pgfId-977803]Action table

  
         		[bookmark: pgfId-977808]The Action table lists the currently defined actions for the selected applet. Use the Add Row, Edit Row and Delete Row buttons below the table to manage these entries. The Add Row and Edit Row buttons open the Add and Edit Action Configuration Dialog Boxes.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-980225][bookmark: 116866][bookmark: pxpage_cncpt_EEMAddEditSyslogConfigurationDialogBox]Add and Edit Syslog Configuration Dialog Boxes[bookmark: marker-980219][bookmark: marker-980221][bookmark: marker-980223]

 
     [bookmark: pgfId-980227]Use the Add Syslog Configuration and Edit Syslog Configuration dialog boxes to configure the syslog message IDs for an event manager applet. Except for the title, the two dialog boxes are identical; the following information applies to both.

 
     [bookmark: pgfId-980229]Navigation Path

 
     [bookmark: pgfId-980234]You can open the Add and Edit Syslog Configuration dialog boxes from the Add and Edit Applet Dialog Boxes.

 
     [bookmark: pgfId-980236]Field Reference

 
     [bookmark: pgfId-980239] 

 
      
       
        
        [bookmark: pgfId-977821]Table 53-4 [bookmark: 116886]Add and Edit Syslog Configuration Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-977827]Element
          
  
         		
           
           [bookmark: pgfId-977829]Description
          
  
        

 
         
         		[bookmark: pgfId-977835]ID

  
         		[bookmark: pgfId-977837]Enter a single syslog message or a range of syslog messages. If a syslog message occurs that matches the specified individual syslog message or range of syslog messages, an event manager applet is triggered.

 [bookmark: pgfId-977839]Note Syslog message IDs may not be entered twice or overlap within a single event manager applet.

  
        

 
         
         		[bookmark: pgfId-977845]Occurs

  
         		[bookmark: pgfId-977847](Optional) In the occurrences field, enter the number of times that the syslog message must occur for an event manager applet to be invoked. The default is 1 occurrence every 0 seconds. Valid values are from 1 - 4294967295.

  
        

 
         
         		[bookmark: pgfId-977853]Period

  
         		[bookmark: pgfId-977855](Optional) In the period field, enter the number of seconds within which the syslog messages must occur to invoke the action. This value limits how frequently an event manager applet is invoked to at most once in the configured period. Valid values are from 0 - 604800. A value of 0 means that no period is defined.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-980253][bookmark: 116913][bookmark: pxpage_cncpt_EEMAddEditActionConfigurationDialogBox]Add and Edit Action Configuration Dialog Boxes[bookmark: marker-980247][bookmark: marker-980249][bookmark: marker-980251]

 
     [bookmark: pgfId-980255]Use the Add Action Configuration and Edit Action Configuration dialog boxes to configure the actions for an event manager applet. Except for the title, the two dialog boxes are identical; the following information applies to both.

 
     [bookmark: pgfId-980257]Navigation Path

 
     [bookmark: pgfId-980262]You can open the Add and Edit Action Configuration dialog boxes from the Add and Edit Applet Dialog Boxes.

 
     [bookmark: pgfId-980264]Field Reference

 
     [bookmark: pgfId-980267] 

 
      
       
        
        [bookmark: pgfId-977868]Table 53-5 [bookmark: 116933]Add and Edit Action Configuration Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-977874]Element
          
  
         		
           
           [bookmark: pgfId-977876]Description
          
  
        

 
         
         		[bookmark: pgfId-977882]Ordinal ID

  
         		[bookmark: pgfId-977884]Enter the unique sequence number in the Ordinal ID field. Valid sequence numbers range from 0 - 4294967295. When adding an action configuration, the Ordinal ID will default to one greater than the highest Ordinal ID used.

  
        

 
         
         		[bookmark: pgfId-977890]CLI

  
         		[bookmark: pgfId-977892]Enter the CLI command in the CLI field. The command runs in global configuration mode as a user with privilege level 15 (the highest). The command may not accept any input, because it is disabled.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-980281][bookmark: 116956][bookmark: pxpage_cncpt_EMailSetupPage]E-Mail Setup Page [bookmark: marker-980275][bookmark: marker-980277][bookmark: marker-980279]

 
    [bookmark: pgfId-980283]The E-Mail Setup page (PIX 7.0/ASA Only) lets you set up a source e-mail address, as well as a list of recipients for specified syslog messages to be sent as e-mails. You can filter the syslog messages sent to a destination e-mail address by severity. The table shows which entries have been set up.

 
    [bookmark: pgfId-980285]The syslog severity filter used for the destination e-mail address will be the higher of the severity selected in this section and the global filter set for all e-mail recipients in the Logging Filters page.

 
    [bookmark: pgfId-980287]Navigation Path

 
     
     		 [bookmark: pgfId-980289](Device view) Select  Platform > Logging > Syslog > E-Mail Setup from the Device Policy selector.

 
     		 [bookmark: pgfId-980291](Policy view) Select  PIX/ASA/FWSM Platform > Logging > Syslog > E-Mail Setup from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-980293]Related Topics

 
     
     		 [bookmark: pgfId-980298]Chapter 53, “Configuring Logging Policies on Firewall Devices”

 
    

 
    [bookmark: pgfId-980300]Field Reference

 
    [bookmark: pgfId-980303] 

 
     
      
       
       [bookmark: pgfId-977905]Table 53-6 [bookmark: 116991]E-Mail Setup Page 

 
       
      
        
        		
          
          [bookmark: pgfId-977911]Element
         
  
        		
          
          [bookmark: pgfId-977913]Description
         
  
       

 
        
        		[bookmark: pgfId-977919]Source Email Address

  
        		[bookmark: pgfId-977921]Enter the email address to be used as the source address when syslogs are sent as emails.

  
       

 
        
        		[bookmark: pgfId-977927]Destination Address table

  
        		[bookmark: pgfId-977929]Lists the currently defined email recipients of syslog messages.

 [bookmark: pgfId-977934]Use the Add Row, Edit Row and Delete Row buttons below the table to manage this list; the Add Row and Edit Row buttons open the Add/Edit Email Recipient Dialog Box.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-980317][bookmark: 117013][bookmark: pxpage_cncpt_AddEditEmailRecipientDialogBox]Add/Edit Email Recipient Dialog Box [bookmark: marker-980311][bookmark: marker-980313][bookmark: marker-980315]

 
     [bookmark: pgfId-980319]The Add/Edit Email Recipient dialog box lets you configure a destination address to be sent emails containing syslog messages; you can limit the messages sent according to severity.

 
     [bookmark: pgfId-980324]The syslog severity filter used for the destination email address will be the higher of the severity selected in this section and the global filter set for all email recipients on the Logging Filters Page.

 
     [bookmark: pgfId-980326]Navigation Path

 
     [bookmark: pgfId-980331]You can access the Add/Edit Email Recipient dialog box from the E-Mail Setup Page.

 
     [bookmark: pgfId-980333]Field Reference

 
     [bookmark: pgfId-980336] 

 
      
       
        
        [bookmark: pgfId-977947]Table 53-7 [bookmark: 117038]Add/Edit Email Recipient Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-977953]Element
          
  
         		
           
           [bookmark: pgfId-977955]Description
          
  
        

 
         
         		[bookmark: pgfId-977961]Destination Email Address

  
         		[bookmark: pgfId-977963]Enter the recipient email address for the chosen type of syslog messages.

  
        

 
         
         		[bookmark: pgfId-977969]Syslog Severity list

  
         		[bookmark: pgfId-977974]Choose the severity of the syslogs to be emailed to this recipient; messages of the chosen severity and higher are sent. Message severity levels are described in Logging Levels.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-980350][bookmark: 117061][bookmark: pxpage_cncpt_EventListsPage]Event Lists Page [bookmark: marker-980344][bookmark: marker-980346][bookmark: marker-980348]

 
    [bookmark: pgfId-980355]The Event Lists page (PIX 7.0+/ASA only) lets you define a set of syslog message filters for logging. After you enable logging and set up global logging parameters on the Logging Setup page, use this page to configure event lists used to filter syslog messages sent to different logging destinations. (The Logging Filters Page lets you specify logging destinations for event lists.)

 
    [bookmark: pgfId-980360]Use the Add Row, Edit Row and Delete Row buttons below the Event Lists table to manage the entries. Add Row and Edit Row open the Add/Edit Event List Dialog Box.

 
    [bookmark: pgfId-980362]Navigation Path

 
     
     		 [bookmark: pgfId-980364](Device view) Select  Platform > Logging > Syslog > Event Lists from the Device Policy selector.

 
     		 [bookmark: pgfId-980366](Policy view) Select  PIX/ASA/FWSM Platform > Logging > Syslog > Event Lists from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
    

 
    [bookmark: pgfId-980368]Related Topics

 
     
     		 [bookmark: pgfId-980373]Logging Setup Page

 
     		 [bookmark: pgfId-980378]Chapter 53, “Configuring Logging Policies on Firewall Devices”

 
    

 
     
      [bookmark: pgfId-980390][bookmark: 117097][bookmark: pxpage_cncpt_MessageClassesandAssociatedMessageIDNumbers]Message Classes and Associated Message ID Numbers [bookmark: marker-980384][bookmark: marker-980386][bookmark: marker-980388]

 
      
       
        
        [bookmark: pgfId-977989]Table 53-8 [bookmark: 117113]Message Classes and Associated Message ID Numbers 

 
        
       
         
         		
           
           [bookmark: pgfId-977997]Class
          
  
         		
           
           [bookmark: pgfId-977999]Definition
          
  
         		
           
           [bookmark: pgfId-978001]Message ID Numbers
          
  
        

 
         
         		[bookmark: pgfId-978009]auth

  
         		[bookmark: pgfId-978011]User Authentication

  
         		[bookmark: pgfId-978013]109, 113

  
        

 
         
         		[bookmark: pgfId-978021]bridge

  
         		[bookmark: pgfId-978023]Transparent Firewall

  
         		[bookmark: pgfId-978025]110, 220

  
        

 
         
         		[bookmark: pgfId-978033]ca

  
         		[bookmark: pgfId-978035]PKI Certification Authority

  
         		[bookmark: pgfId-978037]717

  
        

 
         
         		[bookmark: pgfId-978045]config

  
         		[bookmark: pgfId-978047]Command interface

  
         		[bookmark: pgfId-978049]111, 112, 208, 308

  
        

 
         
         		[bookmark: pgfId-978057]e-mail

  
         		[bookmark: pgfId-978059]E-mail Proxy

  
         		[bookmark: pgfId-978061]719

  
        

 
         
         		[bookmark: pgfId-978069]ha

  
         		[bookmark: pgfId-978071]Failover (High Availability)

  
         		[bookmark: pgfId-978073]101, 102, 103, 104, 210, 311, 709

  
        

 
         
         		[bookmark: pgfId-978081]ids

  
         		[bookmark: pgfId-978083]Intrusion Detection System

  
         		[bookmark: pgfId-978085]400, 401, 415

  
        

 
         
         		[bookmark: pgfId-978093]ip

  
         		[bookmark: pgfId-978095]IP Stack

  
         		[bookmark: pgfId-978097]209, 215, 313, 317, 408

  
        

 
         
         		[bookmark: pgfId-978105]np

  
         		[bookmark: pgfId-978107]Network Processor

  
         		[bookmark: pgfId-978109]319

  
        

 
         
         		[bookmark: pgfId-978117]ospf

  
         		[bookmark: pgfId-978119]OSPF Routing

  
         		[bookmark: pgfId-978121]318, 409, 503, 613

  
        

 
         
         		[bookmark: pgfId-978129]rip

  
         		[bookmark: pgfId-978131]RIP Routing

  
         		[bookmark: pgfId-978133]107, 312

  
        

 
         
         		[bookmark: pgfId-978141]rm

  
         		[bookmark: pgfId-978143]Resource Manager

  
         		[bookmark: pgfId-978145]321

  
        

 
         
         		[bookmark: pgfId-978153]session

  
         		[bookmark: pgfId-978155]User Session

  
         		[bookmark: pgfId-978157]106, 108, 201, 202, 204, 302, 303, 304, 305, 314, 405, 406, 407, 500, 502, 607, 608, 609, 616, 620, 703, 710

  
        

 
         
         		[bookmark: pgfId-978165]snmp

  
         		[bookmark: pgfId-978167]SNMP

  
         		[bookmark: pgfId-978169]212

  
        

 
         
         		[bookmark: pgfId-978177]sys

  
         		[bookmark: pgfId-978179]System

  
         		[bookmark: pgfId-978181]199, 211, 214, 216, 306, 307, 315, 414, 604, 605, 606, 610, 612, 614, 615,701, 711

  
        

 
         
         		[bookmark: pgfId-978189]vpdn

  
         		[bookmark: pgfId-978191]PPTP and L2TP Sessions

  
         		[bookmark: pgfId-978193]213, 403, 603

  
        

 
         
         		[bookmark: pgfId-978201]vpn

  
         		[bookmark: pgfId-978203]IKE and IPsec

  
         		[bookmark: pgfId-978205]316, 320, 402, 404, 501, 602, 702, 713, 714, 715

  
        

 
         
         		[bookmark: pgfId-978213]vpnc

  
         		[bookmark: pgfId-978215]VPN Client

  
         		[bookmark: pgfId-978217]611

  
        

 
         
         		[bookmark: pgfId-978225]vpnfo

  
         		[bookmark: pgfId-978227]VPN Failover

  
         		[bookmark: pgfId-978229]720

  
        

 
         
         		[bookmark: pgfId-978237]vpnlb

  
         		[bookmark: pgfId-978239]VPN Load Balancing

  
         		[bookmark: pgfId-978241]718

  
        

 
         
         		[bookmark: pgfId-978249]webvpn

  
         		[bookmark: pgfId-978251]Web-based VPN

  
         		[bookmark: pgfId-978253]716

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-980409][bookmark: 117273][bookmark: pxpage_cncpt_AddEditEventListDialogBox]Add/Edit Event List Dialog Box [bookmark: marker-980403][bookmark: marker-980405][bookmark: marker-980407]

 
     [bookmark: pgfId-980411]The Add/Edit Event List dialog box lets you create or edit an event list, and specify which syslog messages to include in the event list filter.

 
     [bookmark: pgfId-980413]You can use the following criteria to define an event list:

 
      
      		 [bookmark: pgfId-980415]Class and Severity

 
      		 [bookmark: pgfId-980417]Message ID

 
     

 
     [bookmark: pgfId-980419]Class represents specific types of related syslog messages. For example, the class auth represents all syslog messages related to user authentication.

 
     [bookmark: pgfId-980421]Severity classifies syslogs based on the relative importance of the event in the normal functioning of the network. The highest severity is Emergency, which means the resource is no longer available. The lowest severity is Debugging, which provides detailed information about every network event.

 
     [bookmark: pgfId-980423]The message ID is a numeric value that uniquely identifies each individual message. You can specify a single message ID, or a range of IDs, in an event list.

 
     [bookmark: pgfId-980425]Navigation Path

 
     [bookmark: pgfId-980430]You can access the Add/Edit Event List dialog box from the Event Lists Page.

 
     [bookmark: pgfId-980432]Related Topics

 
      
      		 [bookmark: pgfId-980437]Chapter 53, “Configuring Logging Policies on Firewall Devices”

 
     

 
     [bookmark: pgfId-980439]Field Reference

 
     [bookmark: pgfId-980442] 

 
      
       
        
        [bookmark: pgfId-978266]Table 53-9 [bookmark: 117312]Add/Edit Event List Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-978272]Element
          
  
         		
           
           [bookmark: pgfId-978274]Description
          
  
        

 
         
         		[bookmark: pgfId-978280]Event List Name

  
         		[bookmark: pgfId-978282]Enter a name that uniquely identifies this event list.

  
        

 
         
         		[bookmark: pgfId-978288]Event Class/Severity Filters

  
         		[bookmark: pgfId-978290]This table lists the event class and severity level filters defined for this event list.

 [bookmark: pgfId-978295]Use the Add Row, Edit Row and Delete Row buttons below this table to manage the entries. Add Row and Edit Row open the Add/Edit Syslog Class Dialog Box.

  
        

 
         
         		[bookmark: pgfId-978301]Message ID Filters

  
         		[bookmark: pgfId-978303]This table list the message ID filters defined for this event list.

 [bookmark: pgfId-978308]Use the Add Row, Edit Row and Delete Row buttons below this table to manage the entries. Add Row and Edit Row open the Add/Edit Syslog Message ID Filter Dialog Box.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-980456][bookmark: 117341][bookmark: pxpage_cncpt_AddEditSyslogClassDialogBox]Add/Edit Syslog Class Dialog Box [bookmark: marker-980450][bookmark: marker-980452][bookmark: marker-980454]

 
     [bookmark: pgfId-980458]The Add/Edit Syslog Class dialog box lets you specify an event class and a related severity level as an event list filter.

 
     [bookmark: pgfId-980460]Class represents specific types of related syslog messages, so you do not have to select the syslogs individually. For example, the class auth represents all syslog messages related to user authentication.

 
     [bookmark: pgfId-980462]Severity classifies syslogs based on the relative importance of the event in the normal functioning of the network. The highest severity is Emergency, which means the resource is no longer available. The lowest severity is Debugging, which provides detailed information about every network event.

 
     [bookmark: pgfId-980464]Navigation Path

 
     [bookmark: pgfId-980469]You access the Add/Edit Syslog Class dialog box from the Add/Edit Event List Dialog Box.

 
     [bookmark: pgfId-980471]Related Topics

 
      
      		 [bookmark: pgfId-980476]Add/Edit Syslog Message ID Filter Dialog Box

 
      		 [bookmark: pgfId-980481]Event Lists Page

 
     

 
     [bookmark: pgfId-980483]Field Reference

 
     [bookmark: pgfId-980486] 

 
      
       
        
        [bookmark: pgfId-978321]Table 53-10 [bookmark: 117376]Add/Edit Syslog Class Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-978327]Element
          
  
         		
           
           [bookmark: pgfId-978329]Description
          
  
        

 
         
         		[bookmark: pgfId-978335]Event Class

  
         		[bookmark: pgfId-978340]Choose the desired event class. Event classes are described in Table 53-8.

  
        

 
         
         		[bookmark: pgfId-978346]Severity

  
         		[bookmark: pgfId-978351]Choose the desired message severity level. Severity levels are described in Logging Levels.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-980500][bookmark: 117399][bookmark: pxpage_cncpt_AddEditSyslogMessageIDFilterDialogBox]Add/Edit Syslog Message ID Filter Dialog Box [bookmark: marker-980494][bookmark: marker-980496][bookmark: marker-980498]

 
     [bookmark: pgfId-980502]The Add/Edit Syslog Message ID Filter dialog box lets you specify a syslog message ID, or a range of IDs, as an the event list filter.

 
     [bookmark: pgfId-980504]Navigation Path

 
     [bookmark: pgfId-980509]You can access the Add/Edit Syslog Message ID Filter dialog box from the Add/Edit Event List Dialog Box.

 
     [bookmark: pgfId-980511]Related Topics

 
      
      		 [bookmark: pgfId-980516]Add/Edit Syslog Class Dialog Box

 
      		 [bookmark: pgfId-980521]Event Lists Page

 
     

 
     [bookmark: pgfId-980523]Field Reference

 
     [bookmark: pgfId-980525]Message IDs – Enter a syslog message ID, or a range of IDs. Use a hyphen to specify a range; for example, 101001-101010. Message IDs must be between 100000 and 999999.

 
     [bookmark: pgfId-980527]Message IDs and their corresponding messages are listed in the System Log Message guides for the appropriate product. You can access these guides from cisco.com:

 
     [bookmark: pgfId-980529]PIX Firewall

 
      
      		 [bookmark: pgfId-980533] http://www.cisco.com/en/US/products/sw/secursw/ps2120/products_system_message_guides_list.html 

 
     

 
     [bookmark: pgfId-980535]ASA

 
      
      		 [bookmark: pgfId-980539] http://www.cisco.com/en/US/products/ps6120/products_system_message_guides_list.html 

 
     

 
     [bookmark: pgfId-980541]FWSM

 
      
      		 [bookmark: pgfId-980545] http://www.cisco.com/en/US/products/hw/modules/ps2706/ps4452/tsd_products_support_model_home.html 

 
     

 
    
 
   
 
    
     [bookmark: pgfId-980559][bookmark: 117452][bookmark: pxpage_cncpt_LoggingFiltersPage]Logging Filters Page[bookmark: marker-980553][bookmark: marker-980555][bookmark: marker-980557]

 
    [bookmark: pgfId-980561]The Logging Filters page lets you configure a logging destination for event lists (syslog filters) that have been configured using the Event Lists page, or for only the syslog messages that you specify using the Edit Logging Filters page. Syslog messages from specific or all event classes can be selected using the Edit Logging Filters page.

 
    [bookmark: pgfId-980563]Navigation Path

 
     
     		 [bookmark: pgfId-980565](Device view) Select  Platform > Logging > Syslog > Logging Filters from the Device Policy selector.

 
     		 [bookmark: pgfId-980567](Policy view) Select  PIX/ASA/FWSM Platform > Logging > Syslog > Logging Filters from the Policy Type selector. Right-click  Logging Filters to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-980569]Related Topics

 
     
     		 [bookmark: pgfId-980574]Chapter 53, “Configuring Logging Policies on Firewall Devices”

 
     		 [bookmark: pgfId-980579]Edit Logging Filters Dialog Box

 
    

 
    [bookmark: pgfId-980581]Field Reference

 
    [bookmark: pgfId-980584] 

 
     
      
       
       [bookmark: pgfId-978364]Table 53-11 [bookmark: 117490]Logging Filters Page 

 
       
      
        
        		
          
          [bookmark: pgfId-978370]Element
         
  
        		
          
          [bookmark: pgfId-978372]Description
         
  
       

 
        
        		[bookmark: pgfId-978378]Logging Destination

  
        		[bookmark: pgfId-978380]Lists the name of the logging destination to which messages matching this filter are sent. Logging destinations are as follows:

 
          
          		 [bookmark: pgfId-978382] Internal Buffer . Messages matching this filter are published to the internal buffer of the security appliance.

 
          		 [bookmark: pgfId-978384] Console . Messages matching this filter are published to any console port connections.

 
          		 [bookmark: pgfId-978386] Telnet Sessions . Messages matching this filter are published to any Telnet sessions connected to the security appliance.

 
          		 [bookmark: pgfId-978388] Syslog Servers . Messages matching this filter are published to any syslog servers specified on the  Platform > Logging > Syslog Servers page .

 
          		 [bookmark: pgfId-978390] E-Mail . Messages matching this filter are published to any recipients specified on the  Platform > Logging > E-mail Setup (PIX7.0/ASA Only) page.

 
          		 [bookmark: pgfId-978392] SNMP Trap . Messages matching this filter are published to any SNMP management stations specified on the  Platform > Device Admin > Device Access > SNMP page.

 
          		 [bookmark: pgfId-978394] ASDM . Messages matching this filter are published to any ASDM sessions.

 
         

  
       

 
        
        		[bookmark: pgfId-978400]Syslogs From All Event Classes

  
        		[bookmark: pgfId-978405]Lists the severity on which to filter, the event list to use, or whether logging is disabled from all event classes. Event classes are described in Message Classes and Associated Message ID Numbers.

  
       

 
        
        		[bookmark: pgfId-978411]Syslogs From Specific Event Classes

  
        		[bookmark: pgfId-978419]Lists event class and severity set up as the filter. Event classes are described in Message Classes and Associated Message ID Numbers. Severity levels are described in Logging Levels.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-980598][bookmark: 117543][bookmark: pxpage_cncpt_EditLoggingFiltersDialogBox]Edit Logging Filters Dialog Box[bookmark: marker-980592][bookmark: marker-980594][bookmark: marker-980596]

 
     [bookmark: pgfId-980600]The Edit Logging Filters dialog box lets you edit filters for a logging destination. Syslogs can be configured from all or specific event classes, or disabled for a specific logging destination.

 
     [bookmark: pgfId-980602]Navigation Path

 
     [bookmark: pgfId-980607]You can access the Edit Logging Filters dialog box from the Logging Filters page. For more information about the Logging Filters page, see Logging Filters Page.

 
     [bookmark: pgfId-980609]Related Topics

 
      
      		 [bookmark: pgfId-980614]Chapter 53, “Configuring Logging Policies on Firewall Devices”

 
      		 [bookmark: pgfId-980619]Logging Filters Page

 
     

 
     [bookmark: pgfId-980621]Field Reference

 
     [bookmark: pgfId-980624] 

 
      
       
        
        [bookmark: pgfId-978432]Table 53-12 [bookmark: 117575]Edit Logging Filters Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-978438]Element
          
  
         		
           
           [bookmark: pgfId-978440]Description
          
  
        

 
         
         		[bookmark: pgfId-978446]Logging Destination list

  
         		[bookmark: pgfId-978448]Specifies the logging destination for this filter:

 
           
           		 [bookmark: pgfId-978450] Internal Buffer . Messages matching this filter are published to the internal buffer of the security appliance.

 
           		 [bookmark: pgfId-978452] Console . Messages matching this filter are published to any console port connections.

 
           		 [bookmark: pgfId-978454] Telnet Sessions . Messages matching this filter are published to any Telnet sessions connected to the security appliance.

 
           		 [bookmark: pgfId-978456] Syslog Servers . Messages matching this filter are published to any syslog servers specified on the  Platform > Logging > Syslog Servers page .

 
           		 [bookmark: pgfId-978458] E-Mail . Messages matching this filter are published to any recipients specified on the  Platform > Logging > E-mail Setup (PIX7.0/ASA Only) page.

 
           		 [bookmark: pgfId-978460] SNMP Trap . Messages matching this filter are published to any SNMP management stations specified on the  Platform > Device Admin > Device Access > SNMP page.

 
           		 [bookmark: pgfId-978462] ASDM . Messages matching this filter are published to any ASDM sessions.

 
          

  
        

 
         
         		 
           
           [bookmark: pgfId-978468]Syslog from All Event Classes
          
  
        

 
         
         		[bookmark: pgfId-978476]Filter on severity option

  
         		[bookmark: pgfId-978478]Filters on the severity of the logging messages.

  
        

 
         
         		[bookmark: pgfId-978484]Filter on severity list

  
         		[bookmark: pgfId-978486]Specifies the level of logging messages on which to filter.

  
        

 
         
         		[bookmark: pgfId-978492]Use event list option

  
         		[bookmark: pgfId-978494]Specifies to use an event list.

  
        

 
         
         		[bookmark: pgfId-978500]Use event list

  
         		[bookmark: pgfId-978505]Specifies the event list to use. Event lists are defined on the Event Lists Page.

  
        

 
         
         		[bookmark: pgfId-978511]Disable logging option

  
         		[bookmark: pgfId-978513]Disables all logging to the selected destination.

  
        

 
         
         		 
           
           [bookmark: pgfId-978519]Syslog from Specific Event Classes (PIX7.0)
          
  
        

 
         
         		[bookmark: pgfId-978527]Event Class

  
         		[bookmark: pgfId-978532]Specifies the event class and severity. Event classes include one or all available items. Event classes are described in Table 53-8.

  
        

 
         
         		[bookmark: pgfId-978538]Severity

  
         		[bookmark: pgfId-978543]Specifies the level of logging messages. Severity levels are described in Table 53-18.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-980632][bookmark: 117665][bookmark: pxchap_proc_ConfiguringLoggingSetup]Configuring Logging Setup[bookmark: marker-980630]

 
    [bookmark: pgfId-980634]The Logging Setup page lets you enable system logging on the security appliance and configure other logging options. These options include enabling logging on the security appliance and failover unit, specifying the base log format and detail, and logging to longer-term storage devices, FTP server or Flash, before purging the internal buffer.

 
    [bookmark: pgfId-980636]Related Topics

 
     
     		 [bookmark: pgfId-980641]Logging Setup Page

 
    

 
    
 
    [bookmark: pgfId-980643]Step 1 Select Platform > Logging > Syslog > Logging Setup to display the Logging Setup page.

 
    [bookmark: pgfId-980645]Step 2 Check Enable Logging.

 
    [bookmark: pgfId-980647]This option enables logging on the security appliance.

 
    [bookmark: pgfId-980649]Step 3 To enable logging on the failover unit paired with this security appliance, select the Enable logging on the standby failover unit check box.

 
    [bookmark: pgfId-980651]Step 4 To enable EMBLEM format, or to send debug messages as part of the syslog messages, select the corresponding check boxes.

 
    [bookmark: pgfId-980653]If you enable EMBLEM, you must use the UDP protocol to publish syslog messages. It is not compatible with TCP.

 
    [bookmark: pgfId-980655]Step 5 To write the internal buffer data to an FTP server for future processing prior to clearing the buffer, do the following:

 
    [bookmark: pgfId-980657] a. Check FTP Server Buffer wrap.

 
    [bookmark: pgfId-980659] b. Enter the IP address of the FTP server in the IP Address field.

 
    [bookmark: pgfId-980661] c. Enter the user name of the account used to log into the FTP server in the User Name field.

 
    [bookmark: pgfId-980663] d. Enter the path in the Path field, relative to the FTP root, where the file should be stored.

 
    [bookmark: pgfId-980665] e. Enter and confirm the password used to authenticate the user name.

 
    [bookmark: pgfId-980667]Step 6 To write the internal buffer data to Flash for future processing prior to clearing the buffer, do the following:

 
    [bookmark: pgfId-980669] a. Check Flash.

 
    [bookmark: pgfId-980671] b. Specify the maximum amount of memory to allocate to the storage of internal buffer data.

 
    [bookmark: pgfId-980673] c. Specify the minimum memory that should remain free on the Flash drive. If this minimum value cannot be retained while writing out the data from the internal buffer, the messages will be pruned to meet the space requirements.

 
    [bookmark: pgfId-980675]Step 7 To specify the maximum queue size maintained on the appliance for viewing by an ASDM client, enter that value in the Message Queue Size (Messages) field.

 
    [bookmark: pgfId-980677]


    
     

    
 
    

 
     
      [bookmark: pgfId-980691][bookmark: 117724][bookmark: pxpage_cncpt_LoggingSetupPage]Logging Setup Page[bookmark: marker-980685][bookmark: marker-980687][bookmark: marker-980689]

 
     [bookmark: pgfId-980693]The Logging Setup page lets you enable system logging on the security appliance and configure other logging options.

 
     [bookmark: pgfId-980695]Navigation Path

 
      
      		 [bookmark: pgfId-980697](Device view) Select  Platform > Logging > Syslog > Logging Setup from the Device Policy selector.

 
      		 [bookmark: pgfId-980699](Policy view) Select  PIX/ASA/FWSM Platform > Logging > Syslog > Logging Setup from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new one.

 
     

 
     [bookmark: pgfId-980701]Related Topics

 
      
      		 [bookmark: pgfId-980706]Chapter 53, “Configuring Logging Policies on Firewall Devices”

 
     

 
     [bookmark: pgfId-980708]Field Reference

 
     [bookmark: pgfId-980711] 

 
      
       
        
        [bookmark: pgfId-978556]Table 53-13 [bookmark: 117758]Logging Setup Page 

 
        
       
         
         		
           
           [bookmark: pgfId-978562]Element
          
  
         		
           
           [bookmark: pgfId-978564]Description
          
  
        

 
         
         		[bookmark: pgfId-978570]Enable Logging

  
         		[bookmark: pgfId-978572]Turns on logging for the main security appliance.

  
        

 
         
         		[bookmark: pgfId-978578]Enable Logging on the Failover Standby Unit

  
         		[bookmark: pgfId-978580]Turns on logging for the standby security appliance, if available.

  
        

 
         
         		[bookmark: pgfId-978586]Send syslogs in EMBLEM format (PIX7.x+, ASA, FWSM 3.x+)

  
         		[bookmark: pgfId-978588]Enables EMBLEM format logging for every logging destination. If you enable EMBLEM, you must use the UDP protocol to publish syslog messages; EMBLEM is not compatible with TCP.

 [bookmark: pgfId-978590]Note This setting is not compatible with CS-MARS.

  
        

 
         
         		[bookmark: pgfId-978596]Send debug messages as syslogs (PIX7.x+, ASA, FWSM 3.x+)

  
         		[bookmark: pgfId-978598]Redirects all the debug trace output to the syslog. The syslog message does not appear in the console if this option is enabled. Therefore, to see debug messages, you must enable logging at the console and configure it as the destination for the debug syslog message number and logging level. The syslog message number used is 711011. Default logging level for this syslog is debug.

  
        

 
         
         		[bookmark: pgfId-978604]Memory Size of Internal Buffer (bytes)

  
         		[bookmark: pgfId-978606]Specify the size of the internal buffer to which syslogs is saved if the logging buffer is enabled. When the buffer fills up, it is overwritten. The default is 4096 bytes. The range is 4096 to 1048576.

  
        

 
         
         		 
           
           [bookmark: pgfId-978612]Specify FTP Server Information (PIX7.x+, ASA, FWSM 3.x+)
          
  
        

 
         
         		[bookmark: pgfId-978620]FTP Server Buffer Wrap

  
         		[bookmark: pgfId-978622]To save the buffer contents to the FTP server before it is overwritten, check this box and enter the necessary destination information in the following fields. To remove the FTP configuration, deselect this option.

  
        

 
         
         		[bookmark: pgfId-978628]IP Address

  
         		[bookmark: pgfId-978630]Enter the IP address of the FTP server.

  
        

 
         
         		[bookmark: pgfId-978636]User Name

  
         		[bookmark: pgfId-978638]Enter the user name to use when connecting to the FTP server.

  
        

 
         
         		[bookmark: pgfId-978644]Path

  
         		[bookmark: pgfId-978646]Enter the path, relative to the FTP root, where the buffer contents should be saved.

  
        

 
         
         		[bookmark: pgfId-978652]Password/Confirm

  
         		[bookmark: pgfId-978654]Enter and confirm the password used to authenticate the user name to the FTP server.

  
        

 
         
         		 
           
           [bookmark: pgfId-978660]Specify flash size
          
  
        

 
         
         		[bookmark: pgfId-978668]Flash

  
         		[bookmark: pgfId-978670]To save the buffer contents to the flash memory before it is overwritten, check this box. This option is only available in routed or transparent single mode.

  
        

 
         
         		[bookmark: pgfId-978676]Maximum flash to be used by logging (KB)

  
         		[bookmark: pgfId-978678]Specify the maximum space to be used in the flash memory for logging (in KB). This option is available only in routed or transparent single mode.

  
        

 
         
         		[bookmark: pgfId-978684]Minimum free space to be preserved (KB)

  
         		[bookmark: pgfId-978686]Specifies the minimum free space to be preserved in flash memory (in KB). This option is available only in routed or transparent single mode.

  
        

 
         
         		 
           
           [bookmark: pgfId-978692]ASDM Logging (PIX7.x+, ASA, FWSM 3.x+)
          
  
        

 
         
         		[bookmark: pgfId-978700]Message Queue Size

  
         		[bookmark: pgfId-978702]Specify the queue size for syslogs intended for viewing in ASDM.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-980719][bookmark: 117858][bookmark: pxchap_proc_ConfiguringRateLimitLevels]Configuring Rate Limit Levels[bookmark: marker-980717]

 
    [bookmark: pgfId-980721]The Rate Limit page lets you specify the maximum number of log messages of specific types (e.g., “alert” or “critical”), and messages with specific Syslog IDs, that can be generated within given periods of time. You can specify individual limits for each logging level, and each Syslog message ID. If the settings conflict, the Syslog message ID limits take precedence.

 
    [bookmark: pgfId-980726]The Add/Edit Rate Limited Syslog Message Dialog Box is used to specify the maximum number of messages that can be generated for a particular Syslog message ID within a given period of time.

 
    [bookmark: pgfId-980731]The Add/Edit Rate Limit for Syslog Logging Levels Dialog Box is used to specify the maximum number of messages that can be generated for a particular Syslog logging level within a given period of time.

 
    [bookmark: pgfId-980733]Related Topics

 
     
     		 [bookmark: pgfId-980738]Rate Limit Page

 
    

 
    [bookmark: pgfId-980740]Follow these steps to manage rate limits for message logging:

 
    
 
    [bookmark: pgfId-980742]Step 1 Access the Rate Limit page by doing one of the following:

 
     
     		 [bookmark: pgfId-980744](Device view) Select  Platform > Logging > Syslog > Rate Limit from the Device Policy selector.

 
     		 [bookmark: pgfId-980746](Policy view) Select  PIX/ASA/FWSM Platform > Logging > Syslog > Rate Limit from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new policy.

 
    

 
    [bookmark: pgfId-980748]Step 2 Add, edit and delete rate limits for Syslog logging levels:

 
     
     		 [bookmark: pgfId-980753]To specify the maximum number of messages that can be generated within a given period of time for particular logging level, click the  Add Row button under the Rate Limits for Syslog Logging Levels table to open the Add/Edit Rate Limit for Syslog Logging Levels Dialog Box. Choose a logging level and define a rate limit.

 
     		 [bookmark: pgfId-980758]To edit the rate limit for a particular logging level, select the appropriate entry in the Rate Limits for Syslog Logging Levels table, and then click the  Edit Row button under the table to open the Add/Edit Rate Limit for Syslog Logging Levels Dialog Box. Alter the rate limit as necessary.

 
     		 [bookmark: pgfId-980760]To delete a rate limit entry from the Rate Limits for Syslog Logging Levels table, select it and then click the  Delete Row button under the table. A confirmation dialog box may be displayed; click OK to delete the entry.

 
    

 
    [bookmark: pgfId-980762]Step 3 Add, edit and delete limits for log messages according to message IDs:

 
     
     		 [bookmark: pgfId-980767]To specify the maximum number of messages that can be generated within a given period of time for particular message ID, click the  Add Row button under the Individually Rate Limited Syslog Messages table to open the Add/Edit Rate Limited Syslog Message Dialog Box. Choose a Syslog message ID and define a rate limit.

 
     		 [bookmark: pgfId-980772]To edit the rate limit for a particular Syslog message ID, select the appropriate entry in the Individually Rate Limited Syslog Messages table, and then click the  Edit Row button under the table to open the Add/Edit Rate Limited Syslog Message Dialog Box. Alter the rate limit as necessary.

 
     		 [bookmark: pgfId-980774]To delete a message limit entry from the Individually Rate Limited Syslog Messages table, select it and then click the  Delete Row button under the table. A confirmation dialog box may be displayed; click OK to delete the entry.

 
    

 
    [bookmark: pgfId-980776]


    
     

    
 
    

 
     
      [bookmark: pgfId-980790][bookmark: 117916][bookmark: pxpage_cncpt_RateLimitPage]Rate Limit Page[bookmark: marker-980784][bookmark: marker-980786][bookmark: marker-980788]

 
     [bookmark: pgfId-980792]The Rate Limit page allows you to specify the maximum number of log messages of a particular type (for example, alert or critical) that should be generated within a given period of time. You can specify a limit for each logging level and Syslog message ID. If the settings differ, Syslog message ID limits take precedence.

 
     [bookmark: pgfId-980794]Navigation Path

 
      
      		 [bookmark: pgfId-980796](Device view) Select  Platform > Logging > Syslog > Rate Limit from the Device Policy selector.

 
      		 [bookmark: pgfId-980798](Policy view) Select  PIX/ASA/FWSM Platform > Logging > Syslog > Rate Limit from the Policy Type selector. Select an existing policy from the Shared Policy selector, or create a new policy.

 
     

 
     [bookmark: pgfId-980800]Related Topics

 
      
      		 [bookmark: pgfId-980805]Chapter 53, “Configuring Logging Policies on Firewall Devices”

 
      		 [bookmark: pgfId-980810]Add/Edit Rate Limit for Syslog Logging Levels Dialog Box

 
      		 [bookmark: pgfId-980815]Add/Edit Rate Limited Syslog Message Dialog Box

 
     

 
     [bookmark: pgfId-980817]Field Reference

 
     [bookmark: pgfId-980820] 

 
      
       
        
        [bookmark: pgfId-978715]Table 53-14 [bookmark: 117956]Rate Limit Page 

 
        
       
         
         		
           
           [bookmark: pgfId-978721]Element
          
  
         		
           
           [bookmark: pgfId-978723]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-978729]Rate Limits for Syslog Logging Levels Table
          
  
        

 
         
         		[bookmark: pgfId-978737]Logging Level

  
         		[bookmark: pgfId-978739]The Syslog logging level for which you are specifying a rate limit.

  
        

 
         
         		[bookmark: pgfId-978745]No. of Messages

  
         		[bookmark: pgfId-978747]Maximum number of messages of the specified type allowed in the specified time period.

  
        

 
         
         		[bookmark: pgfId-978753]Interval (seconds)

  
         		[bookmark: pgfId-978755]Number of seconds before the rate limit counter resets.

  
        

 
         
         		 
           
           [bookmark: pgfId-978761]Individually Rate Limited Syslog Messages Table
          
  
        

 
         
         		[bookmark: pgfId-978769]Syslog ID

  
         		[bookmark: pgfId-978771]Identification number of the Syslog message for which you are specifying a rate limit.

  
        

 
         
         		[bookmark: pgfId-978777]No. of Messages

  
         		[bookmark: pgfId-978779]Maximum number of messages with the specified ID allowed in the specified time period.

  
        

 
         
         		[bookmark: pgfId-978785]Interval (seconds)

  
         		[bookmark: pgfId-978787]Number of seconds before the rate limit counter resets.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-980834][bookmark: 118006][bookmark: pxpage_cncpt_AddEditRateLimitforSyslogLoggingLevelsDialogBox]Add/Edit Rate Limit for Syslog Logging Levels Dialog Box[bookmark: marker-980828][bookmark: marker-980830][bookmark: marker-980832]

 
     [bookmark: pgfId-980839]Using the Add/Edit Rate Limit for Syslog Logging Levels dialog box, you can specify the maximum number of log messages for particular log level that should be generated within a given period of time. You can specify a limit for each logging level or syslog message ID (see Add/Edit Rate Limited Syslog Message Dialog Box). If the settings differ, the rate limited syslog message-level settings override rate limit logging level settings.

 
     [bookmark: pgfId-980841]Navigation Path

 
     [bookmark: pgfId-980846]You can access the Add/Edit Rate Limit for Syslog Logging Levels dialog box from the Rate Limit page. For more information, see Rate Limit Page.

 
     [bookmark: pgfId-980848]Related Topics

 
      
      		 [bookmark: pgfId-980853]Chapter 53, “Configuring Logging Policies on Firewall Devices”

 
      		 [bookmark: pgfId-980858]Rate Limit Page

 
      		 [bookmark: pgfId-980863]Add/Edit Rate Limited Syslog Message Dialog Box

 
     

 
     [bookmark: pgfId-980865]Field Reference

 
     [bookmark: pgfId-980868] 

 
      
       
        
        [bookmark: pgfId-978800]Table 53-15 [bookmark: 118042]Add/Edit Rate Limit for Syslog Logging Levels Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-978806]Element
          
  
         		
           
           [bookmark: pgfId-978808]Description
          
  
        

 
         
         		[bookmark: pgfId-978814]Logging Level

  
         		[bookmark: pgfId-978816]The syslog logging level for which you are specifying the rate limit.

  
        

 
         
         		[bookmark: pgfId-978822]Number of Messages

  
         		[bookmark: pgfId-978824]Maximum number of messages of the specified type allowed in the specified time period.

  
        

 
         
         		[bookmark: pgfId-978830]Interval (Seconds)

  
         		[bookmark: pgfId-978832]Number of seconds before the rate limit counter resets.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-980882][bookmark: 118068][bookmark: pxpage_cncpt_AddEditRateLimitedSyslogMessageDialogBox]Add/Edit Rate Limited Syslog Message Dialog Box[bookmark: marker-980876][bookmark: marker-980878][bookmark: marker-980880]

 
     [bookmark: pgfId-980887]Using the Add/Edit Rate Limited Syslog Message dialog box you can specify the maximum number of log messages of a particular Syslog ID that can be generated within a given period of time. You can specify a limit for each syslog message ID or logging level (see Add/Edit Rate Limit for Syslog Logging Levels Dialog Box). If the settings differ, the rate limited syslog message-level settings override rate limit logging level settings.

 
     [bookmark: pgfId-980889]Navigation Path

 
     [bookmark: pgfId-980894]You can access the Add/Edit Rate Limited Syslog Message dialog box from the Rate Limit page. For more information, see Rate Limit Page.

 
     [bookmark: pgfId-980896]Related Topics

 
      
      		 [bookmark: pgfId-980901]Chapter 53, “Configuring Logging Policies on Firewall Devices”

 
      		 [bookmark: pgfId-980906]Rate Limit Page

 
      		 [bookmark: pgfId-980911]Add/Edit Rate Limit for Syslog Logging Levels Dialog Box

 
     

 
     [bookmark: pgfId-980913]Field Reference

 
     [bookmark: pgfId-980916] 

 
      
       
        
        [bookmark: pgfId-978845]Table 53-16 [bookmark: 118104]Add/Edit Rate Limited Syslog Message Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-978851]Element
          
  
         		
           
           [bookmark: pgfId-978853]Description
          
  
        

 
         
         		[bookmark: pgfId-978859]Syslog ID

  
         		[bookmark: pgfId-978861]Identification number of the syslog message for which you are specifying a rate limit.

  
        

 
         
         		[bookmark: pgfId-978867]Number of Messages

  
         		[bookmark: pgfId-978869]Maximum number of messages with the specified ID allowed in the specified time period.

  
        

 
         
         		[bookmark: pgfId-978875]Interval (Seconds)

  
         		[bookmark: pgfId-978877]Number of seconds before the rate limit counter resets.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-980924][bookmark: 118132][bookmark: pxchap_proc_ConfiguringServerSetup]Configuring Syslog Server Setup[bookmark: marker-980922]

 
    [bookmark: pgfId-980926]You can configure general syslog server settings to set the facility code to be included in syslog messages that are sent to syslog servers, specify whether a timestamp is included in each message, specify the device ID to include in messages, view and modify the severity levels for messages, and disable the generation of specific messages.

 
    [bookmark: pgfId-980928]Related Topics

 
     
     		 [bookmark: pgfId-980933]Defining Syslog Servers

 
    

 
    
 
    [bookmark: pgfId-980935]Step 1 Do one of the following:

 
     
     		 [bookmark: pgfId-980940](Device view) Select  Platform > Logging > Syslog > Server Setup to open the Server Setup Page.

 
     		 [bookmark: pgfId-980942](Policy view) Select  PIX/ASA/FWSM Platform > Logging > Syslog > Server Setup from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-980944]Step 2 Change the basic message configuration as required:

 
     
     		 [bookmark: pgfId-980946]If your syslog server expects a different facility than the default, select the required facility in the  Facility list.

 
     		 [bookmark: pgfId-980948]If you want to include the date and time a message was generated in the message, select  Enable Timestamp on Each Syslog Message .

 
     		 [bookmark: pgfId-980950]If you want to add a device identifier to syslog messages (which is placed at the beginning of the message), select  Enable Syslog Device ID and then select the type of ID:

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-980952]Note For an ASA cluster, each unit in the cluster generates its own syslog messages. You can configure logging so that each unit uses either the same or a different device ID in the syslog message header field. For example, the hostname configuration is replicated and shared by all units in the cluster. If you configure logging to use the hostname as the device ID, syslog messages generated by all units look as if they come from a single unit. If you configure logging to use the local-unit name that is assigned in the cluster bootstrap configuration as the device ID (Cluster ID option), syslog messages look as if they come from different units. You can also specify whether or not the interface IP address of the cluster Master should be used for all cluster devices.


    
     

    

    

 
    [bookmark: pgfId-980954] – Interface—To use the IP address of the specified interface, regardless of the interface through which the appliance sends the message. Click Select to select the interface or the interface role that identifies the interface. Interface roles must map to a single interface.

 
    [bookmark: pgfId-980956]For ASA clusters, to specify that the interface IP address of the cluster Master should be used for all cluster devices, select the corresponding option under the Interface Name field.

 
    [bookmark: pgfId-980958] – User Defined ID—To use a text string (up to 16 characters) of your choosing.

 
    [bookmark: pgfId-980960] – Host Name—To use the hostname of the device.

 
    [bookmark: pgfId-980962] – Cluster ID—To use the unique name in the boot configuration of an individual ASA unit in the cluster as the device ID.

 
    [bookmark: pgfId-980964]Step 3 Use the Syslog Message table to alter the default settings for specific syslog messages. You need to configure rules in this table only if you want to change the default settings. You can change the severity assigned to a message, or you can suppress (disable) the generation of a message.

 
     
     		 [bookmark: pgfId-980969]To add a rule, click the  Add Row button and fill in the Add/Edit Syslog Message Dialog Box.

 
    

 
    [bookmark: pgfId-980971]You select the message number whose configuration you want to change, and then select the new severity level, or select Suppressed to disable the generation of the message. Typically, you would not change the severity level and disable the message, but you can make changes to both fields if desired. Click OK to add the rule to the table.

 
    [bookmark: pgfId-980976]For a description of message severity levels, see Logging Levels.

 
     
     		 [bookmark: pgfId-980978]To edit a rule, select it and click the  Edit Row button, make the desired changes, and click  OK .

 
     		 [bookmark: pgfId-980980]To delete a rule, select it and click the  Delete Row button.

 
     		 [bookmark: pgfId-980982]If you are using NetFlow, you can easily disable the generation of syslog messages that have NetFlow equivalents by clicking the  Disable NetFlow Equivalent Syslogs button. This adds the messages to the table as suppressed messages. Note that if any of these syslog equivalents are already in the table, your existing rules are not overwritten.

 
    

 
    [bookmark: pgfId-980984]


    
     

    
 
    

 
     
      [bookmark: pgfId-980998][bookmark: 118208][bookmark: pxpage_cncpt_ServerSetupPage]Server Setup Page[bookmark: marker-980992][bookmark: marker-980994][bookmark: marker-980996]

 
     [bookmark: pgfId-981000]The Server Setup page allows you to set the facility code to be included in syslog messages that are sent to syslog servers, specify whether a timestamp is included in each message, specify the device ID to include in messages, view and modify the severity levels for messages, and disable the generation of specific messages.

 
     [bookmark: pgfId-981002]Navigation Path

 
      
      		 [bookmark: pgfId-981004](Device view) Select  Platform > Logging > Syslog > Server Setup from the Device Policy selector.

 
      		 [bookmark: pgfId-981006](Policy view) Select  PIX/ASA/FWSM Platform > Logging > Syslog > Server Setup from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-981008]Related Topics

 
      
      		 [bookmark: pgfId-981013]Configuring Syslog Server Setup

 
      		 [bookmark: pgfId-981018]Defining Syslog Servers

 
      		 [bookmark: pgfId-981023]Chapter 53, “Configuring Logging Policies on Firewall Devices”

 
      		 [bookmark: pgfId-981028]Logging Levels

 
     

 
     [bookmark: pgfId-981030]Field Reference

 
     [bookmark: pgfId-981033] 

 
      
       
        
        [bookmark: pgfId-978890]Table 53-17 [bookmark: 118251]Server Setup Page 

 
        
       
         
         		
           
           [bookmark: pgfId-978896]Element
          
  
         		
           
           [bookmark: pgfId-978898]Description
          
  
        

 
         
         		[bookmark: pgfId-978904]Facility

  
         		[bookmark: pgfId-978906]The syslog facility code that the appliance includes in messages destined for syslog servers. The default is LOCAL4(20), which is what most UNIX systems expect. You can select a facility between LOCAL0(16) and LOCAL7(23).

 [bookmark: pgfId-978908]Syslog facility is useful when you have a central syslog monitoring system that needs to distinguish among the various network devices that generate syslog data streams. Because your network devices share the eight available facilities, you might need to change this value.

  
        

 
         
         		[bookmark: pgfId-978914]Enable Timestamp on Each Syslog Message

  
         		[bookmark: pgfId-978916]Whether to include the date and time a message was generated in syslog messages. The default is to not include time stamps.

  
        

 
         
         		[bookmark: pgfId-978922]Enable Syslog Device ID

  
         		[bookmark: pgfId-978924]Whether to configure a device ID in non-EMBLEM-format syslog messages. If you select this option, select one of the following to use as the device ID, which is place at the start of all syslog messages:

 [bookmark: pgfId-978926]Note For an ASA cluster, each unit in the cluster generates its own syslog messages. You can configure logging so that each unit uses either the same or a different device ID in the syslog message header field. For example, the hostname configuration is replicated and shared by all units in the cluster. If you configure logging to use the hostname as the device ID, syslog messages generated by all units look as if they come from a single unit. If you configure logging to use the local-unit name that is assigned in the cluster bootstrap configuration as the device ID (Cluster ID option), syslog messages look as if they come from different units. You can also specify whether or not the interface IP address of the cluster Master should be used for all cluster devices.

 
           
           		 [bookmark: pgfId-978928]Interface—The IP address of the selected interface. Enter the name of the interface or click  Select to select it from a list (or to select an interface role that specifies the interface). Messages include the IP address of the interface specified, regardless of which interface the adaptive security appliance uses to send the log data to the external server.

 
          

 [bookmark: pgfId-978930]If you select an interface role, that role must map to a single interface on the device.

 [bookmark: pgfId-978932]For ASA clusters, to specify that the interface IP address of the cluster Master should be used for all cluster devices, select the corresponding option under the Interface Name field.

 
           
           		 [bookmark: pgfId-978934]User Defined ID—A text string you define as the device ID. This string can be up to 16 characters, but cannot contain any of the following special characters:

 
          

 [bookmark: pgfId-978936]& ’ " < > ?

 
           
           		 [bookmark: pgfId-978938]Host Name—The hostname of the security appliance.

 
           		 [bookmark: pgfId-978940]Cluster ID—Use the unique name in the boot configuration of an individual ASA unit in the cluster as the device ID.

 
          

  
        

 
         
         		[bookmark: pgfId-978946]Syslog Message table

  
         		[bookmark: pgfId-978948]Use this table to enable or disable the generation of specific syslog messages, or to change the severity level of a message. If you do not want to constrict which message types are generated, or change any message severity levels, you do not need to configure anything in this table. The table shows the messages you have configured with the message level and whether generation is suppressed (“true” in the table).

 
           
           		 [bookmark: pgfId-978953]To add a rule, click the  Add Row button and fill in the Add/Edit Syslog Message Dialog Box.

 
           		 [bookmark: pgfId-978955]To edit a rule, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-978957]To delete a rule, select it and click the  Delete Row button.

 
          

  
        

 
         
         		[bookmark: pgfId-978963]Disable/Enable NetFlow Equivalent Syslogs

  
         		[bookmark: pgfId-978965]If you are using NetFlow logging, you might want to disable the generation of syslog messages that duplicate NetFlow messages. If you click the Disable button, these duplicate syslog messages are added to the Syslog Message table as suppressed messages, and the button is renamed Enable NetFlow Equivalent Syslogs.

 [bookmark: pgfId-978967]Clicking the Enable button removes the duplicate syslog messages from the table, meaning that they will no longer be suppressed, and the device will start sending them again. However, if you manually edited any message that was added to the list by the Disable button, the Enable button does not remove them.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-981043][bookmark: 118313][bookmark: pxpage_cncpt_LoggingLevels]Logging Levels[bookmark: marker-981039][bookmark: marker-981041]

 
      
       
        
        [bookmark: pgfId-978982]Table 53-18 [bookmark: 118326]Logging Levels 

 
        
       
         
         		
           
           [bookmark: pgfId-978990]Logging Level
          
  
         		
           
           [bookmark: pgfId-978992]Type
          
  
         		
           
           [bookmark: pgfId-978994]Description
          
  
        

 
         
         		[bookmark: pgfId-979002]0

  
         		[bookmark: pgfId-979004]Emergency

  
         		[bookmark: pgfId-979006]System unusable. Generates messages that identify system instabilities.

  
        

 
         
         		[bookmark: pgfId-979014]1

  
         		[bookmark: pgfId-979016]Alerts

  
         		[bookmark: pgfId-979018]Immediate action needed. Generates messages that identify system integrity issues that require immediate administrative action.

  
        

 
         
         		[bookmark: pgfId-979026]2

  
         		[bookmark: pgfId-979028]Critical

  
         		[bookmark: pgfId-979030]Critical condition. Generates messages that identify critical system issues.

  
        

 
         
         		[bookmark: pgfId-979038]3

  
         		[bookmark: pgfId-979040]Errors

  
         		[bookmark: pgfId-979042]Error condition. Generates messages that identify system errors during operation.

  
        

 
         
         		[bookmark: pgfId-979050]4

  
         		[bookmark: pgfId-979052]Warnings

  
         		[bookmark: pgfId-979054]Warning condition. Generates messages that identify system warnings. For example, device might be configured incorrectly.

  
        

 
         
         		[bookmark: pgfId-979062]5

  
         		[bookmark: pgfId-979064]Notifications

  
         		[bookmark: pgfId-979066]Normal but significant condition. Generates messages that identify normal operations that are typically considered significant events.

  
        

 
         
         		[bookmark: pgfId-979074]6

  
         		[bookmark: pgfId-979076]Information

  
         		[bookmark: pgfId-979078]Informational only. Generates messages that identify system information that is typical of day-to-day activity, such as network session records.

  
        

 
         
         		[bookmark: pgfId-979086]7

  
         		[bookmark: pgfId-979088]Debugging

  
         		[bookmark: pgfId-979090]Generates syslog messages that assist you in debugging. Also generates logs that identify the commands issued during FTP sessions and the URLs requested during HTTP sessions. Includes all emergency, alert, critical, error, warning, notification, and information messages.

  
        

 
         
         		[bookmark: pgfId-979098]-

  
         		[bookmark: pgfId-979100]Disabled

  
         		[bookmark: pgfId-979102]No logging.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-981062][bookmark: 118402][bookmark: pxpage_cncpt_AddEditSyslogMessageDialogBox]Add/Edit Syslog Message Dialog Box[bookmark: marker-981056][bookmark: marker-981058][bookmark: marker-981060]

 
     [bookmark: pgfId-981064]The Add/Edit Syslog Message dialog box lets you modify the logging level or suppression setting for a syslog message.

 
     [bookmark: pgfId-981066]Navigation Path

 
     [bookmark: pgfId-981071]You can access the Add/Edit Syslog Message dialog box from the Server Setup Page.

 
     [bookmark: pgfId-981073]Related Topics

 
      
      		 [bookmark: pgfId-981078]Chapter 53, “Configuring Logging Policies on Firewall Devices”

 
     

 
     [bookmark: pgfId-981080]Field Reference

 
     [bookmark: pgfId-981083] 

 
      
       
        
        [bookmark: pgfId-979115]Table 53-19 [bookmark: 118431]Add/Edit Syslog Message Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-979121]Element
          
  
         		
           
           [bookmark: pgfId-979123]Description
          
  
        

 
         
         		[bookmark: pgfId-979129]Syslog ID list

  
         		[bookmark: pgfId-979131]The message log ID of the message whose severity level or suppression setting you want to alter. These values and their corresponding messages are identified in the System Log Message guides for the appropriate product:

 [bookmark: pgfId-979133]PIX Firewall

 [bookmark: pgfId-979137]http://www.cisco.com/en/US/products/sw/secursw/ps2120/products_system_message_guides_list.html

 [bookmark: pgfId-979139]ASA

 [bookmark: pgfId-979143]http://www.cisco.com/en/US/products/ps6120/products_system_message_guides_list.html

 [bookmark: pgfId-979145]FWSM

 [bookmark: pgfId-979149]http://www.cisco.com/en/US/products/hw/modules/ps2706/ps4452/tsd_products_support_model_home.html

  
        

 
         
         		[bookmark: pgfId-979155]Logging Level list

  
         		[bookmark: pgfId-979160]The logging level that you want to assign to the message. For logging levels and descriptions, see Logging Levels.

 [bookmark: pgfId-979162]Select (default) to use the default level assigned to the message.

  
        

 
         
         		[bookmark: pgfId-979168]Suppressed

  
         		[bookmark: pgfId-979170]Whether to suppress the generation of the syslog message. Suppressing a message disables its generation, so you will not see it in syslogs.

  
        

 
         
         		[bookmark: pgfId-979176]Disable Syslogs on Standby

  
         		[bookmark: pgfId-979178]Whether to block specific syslog messages from being generated on standby ASA devices. This feature is available from ASA version 9.4(1) and Security Manager supports this feature starting from version 4.9.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-981091][bookmark: 118478][bookmark: pxchap_proc_DefiningSyslogServers-2]Defining Syslog Servers[bookmark: marker-981089]

 
    [bookmark: pgfId-981093]The Syslog Servers page lets you specify the syslog servers to which the security appliance will send syslog messages. To make use of the syslog servers you define, you must enable logging using the Logging Setup page and set up the appropriate filters for destinations using the Logging Filters page.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-981095]Tip If you want to view events from an ASA device using Security Manager Event Viewer, ensure that you define the Security Manager server as a syslog server. Also, if you use CS-MARS or other applications to manage syslog events, include those servers in this policy.


    
     

    

    

 
    [bookmark: pgfId-981097]By directing syslog records generated by a security appliance to a syslog server, you can process and study the records.

 
    [bookmark: pgfId-981099]Before You Begin

 
    [bookmark: pgfId-981104]Enable logging. See Configuring Logging Setup.

 
    [bookmark: pgfId-981106]Related Topics

 
     
     		 [bookmark: pgfId-981111]Syslog Servers Page

 
     		 [bookmark: pgfId-981116]Add/Edit Syslog Server Dialog Box

 
    

 
    
 
    [bookmark: pgfId-981118]Step 1 Select Platform > Logging > Syslog > Syslog Servers to display the Syslog Servers page.

 
    [bookmark: pgfId-981120]Step 2 Do one of the following:

 
     
     		 [bookmark: pgfId-981122]To add a new syslog target, click the  Add Row button.

 
     		 [bookmark: pgfId-981124]To edit an existing syslog target, select the check box for the row, then click the  Edit Row button.

 
    

 
    [bookmark: pgfId-981126]Step 3 Enter or select the interface name in the Interface field.

 
    [bookmark: pgfId-981128]The list displays all interfaces defined at the current scope.

 
    [bookmark: pgfId-981130]Step 4 Enter or select the IP address of the syslog server in the IP Address field.

 
    [bookmark: pgfId-981132]Step 5 Determine whether to use UDP or TCP, then click the appropriate radio button under Protocol.

 
    [bookmark: pgfId-981134]Step 6 Enter the port from which the security appliance sends either UDP or TCP syslog messages. The port must be the same port on which the syslog server listens.

 
     
     		 [bookmark: pgfId-981136]TCP—1470 (Default). TCP ports work only with a security appliance syslog server.

 
     		 [bookmark: pgfId-981138]UDP—514 (Default).

 
    

 
    [bookmark: pgfId-981140]Step 7 To generate syslog messages using the EMBLEM format, select the Log messages in Cisco EMBLEM format check box.

 
    [bookmark: pgfId-981142]To enable this option, you must select UDP protocol to publish messages to this syslog server.

 
    [bookmark: pgfId-981144]Step 8 Click OK.

 
    [bookmark: pgfId-981146]The definition appears in the Syslog Servers table.

 
    [bookmark: pgfId-981148]


    
     

    
 
    

 
     
      [bookmark: pgfId-981162][bookmark: 118539][bookmark: pxpage_cncpt_SyslogServersPage]Syslog Servers Page[bookmark: marker-981156][bookmark: marker-981158][bookmark: marker-981160]

 
     [bookmark: pgfId-981164]The Syslog Servers page lets you specify the syslog servers to which the security appliance sends syslog messages. To make use of the syslog servers you define, you must enable logging using the Logging Setup page and set up the appropriate filters for destinations using the Logging Filters page.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-981166]Tip If you want to view events from an ASA device using Security Manager Event Viewer, ensure that you define the Security Manager server as a syslog server. Also, if you use CS-MARS or other applications to manage syslog events, include those servers in this policy.


     
      

     

     

 
     [bookmark: pgfId-981168]Navigation Path

 
      
      		 [bookmark: pgfId-981170](Device view) Select  Platform > Logging > Syslog > Syslog Servers from the Device Policy selector.

 
      		 [bookmark: pgfId-981172](Policy view) Select  PIX/ASA/FWSM Platform > Logging > Syslog > Syslog Servers from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-981174]Related Topics

 
      
      		 [bookmark: pgfId-981179]Defining Syslog Servers

 
      		 [bookmark: pgfId-981184]Chapter 53, “Configuring Logging Policies on Firewall Devices”

 
     

 
     [bookmark: pgfId-981186]Field Reference

 
     [bookmark: pgfId-981189] 

 
      
       
        
        [bookmark: pgfId-979191]Table 53-20 [bookmark: 118577]Syslog Servers Page 

 
        
       
         
         		
           
           [bookmark: pgfId-979197]Element
          
  
         		
           
           [bookmark: pgfId-979199]Description
          
  
        

 
         
         		[bookmark: pgfId-979205]Syslog Servers table

  
         		[bookmark: pgfId-979207]The syslog servers to which this device sends syslog messages. The table shows the device interface that publishes messages to the server, the server’s IP address, syslog protocol and port number, and whether the messages are in Cisco EMBLEM syslog format.

 [bookmark: pgfId-979209]There is a limit of four syslog servers that can be set up per context.

 
           
           		 [bookmark: pgfId-979214]To add a server, click the  Add Row button and fill in the Add/Edit Syslog Server Dialog Box.

 
           		 [bookmark: pgfId-979216]To edit a server, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-979218]To delete a server, select it and click the  Delete Row button.

 
          

  
        

 
         
         		[bookmark: pgfId-979224]Queue Size

  
         		[bookmark: pgfId-979226]Specifies the size of the queue for storing syslog messages on the security appliance when syslog server is busy. Minimum is 1 message. Default is 512. Specify 0 to allow an unlimited number of messages to be queued (subject to available block memory).

  
        

 
         
         		[bookmark: pgfId-979232]Allow user traffic to pass when TCP syslog server is down

  
         		[bookmark: pgfId-979234]Whether to restrict all traffic if any syslog server that is using the TCP protocol is down.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-981201][bookmark: 118614][bookmark: pxpage_cncpt_AddEditSyslogServerDialogBox]Add/Edit Syslog Server Dialog Box[bookmark: marker-981197][bookmark: marker-981199]

 
     [bookmark: pgfId-981203]The Add/Edit Syslog Servers dialog box lets you add or edit the syslog servers to which the security appliance will send syslog messages. To make use of the syslog servers you define, you must enable logging using the Logging Setup page and set up the appropriate filters for destinations using the Logging Filters page.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-981205]Note There is a limit of four syslog servers that can be set up per context.


     
      

     

     

 
     [bookmark: pgfId-981207]Navigation Path

 
     [bookmark: pgfId-981212]You can access the Add Syslog Servers dialog box from the Syslog Servers page. For more information about the Syslog Servers page, see Syslog Servers Page.

 
     [bookmark: pgfId-981214]Related Topics

 
      
      		 [bookmark: pgfId-981219]Defining Syslog Servers

 
      		 [bookmark: pgfId-981224]Chapter 53, “Configuring Logging Policies on Firewall Devices”

 
     

 
     [bookmark: pgfId-981226]Field Reference

 
     [bookmark: pgfId-981229] 

 
      
       
        
        [bookmark: pgfId-979247]Table 53-21 [bookmark: 118643]Add/Edit Syslog Server Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-979253]Element
          
  
         		
           
           [bookmark: pgfId-979255]Description
          
  
        

 
         
         		[bookmark: pgfId-979261]Interface

  
         		[bookmark: pgfId-979263]The interface used to communicate with the syslog server. Enter the name of the interface or interface role object, or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-979269]IP Address

  
         		[bookmark: pgfId-979271]The IP address of syslog server. Enter the IP address or the name of the network/host policy object that defines the address, or click Select to select the network/host object.

  
        

 
         
         		[bookmark: pgfId-979277]Protocol

  
         		[bookmark: pgfId-979279]The protocol used by syslog server, either TCP or UDP. UDP is the default. TCP ports work only with a security appliance syslog server.

 [bookmark: pgfId-979281]Note You must select UDP if you intend to use the EMBLEM format.

  
        

 
         
         		[bookmark: pgfId-979287]Port

  
         		[bookmark: pgfId-979289]The TCP or UDP port from which the security appliance sends syslog messages and on which the syslog server receives them. The default ports for each protocol are:

 
           
           		 [bookmark: pgfId-979291]TCP—1470.

 
           		 [bookmark: pgfId-979293]UDP—514.

 
          

 [bookmark: pgfId-979298]Tip If you are defining the Security Manager server as a syslog server, you can find the port number on the Security Manager Administration Event Management Page. [bookmark: pgfId-979300]Note During the installation or upgrade of Security Manager, the Common Services syslog service port is changed from 514 to 49514. Later, if Security Manager is uninstalled, the port is not reverted to 514.

  
        

 
         
         		[bookmark: pgfId-979306]Log messages in Cisco EMBLEM format (UDP only)

  
         		[bookmark: pgfId-979308]Whether to log messages in Cisco EMBLEM format. The syslog server must use UDP.

 [bookmark: pgfId-979310]Note If the syslog server is a Cisco Security MARS appliance, do not select this option. Cisco Security MARS does not process the EMBLEM format.
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     [bookmark: pgfId-856521][bookmark: 131655][bookmark: pxchap_cncpt_ConfiguringSecurityContextsonFirewallDevices]Configuring Security Contexts on Firewall Devices[bookmark: marker-856509][bookmark: marker-856511][bookmark: marker-856513][bookmark: marker-856515][bookmark: marker-856517][bookmark: marker-856519]
      
      
 
     
 

 
    [bookmark: pgfId-856523]You can define multiple security “contexts” on a single security appliance. Each context operates as an independent virtual device, with its own security policy, interfaces and administrators. Multiple contexts are similar to having multiple stand-alone devices. Many features are supported in multiple-context mode, including routing tables, firewall features, IPS, and management. Some features are not supported; for example, VPN, multicast, and dynamic routing protocols; security contexts support only static routes; and you cannot enable OSPF or RIP in multiple-context mode. Also, some features are not directly managed by Cisco Security Manager, such as the IPS feature set for ASA and PIX devices.

 
    [bookmark: pgfId-856525]In multiple-context mode, the security appliance includes a configuration for each context that identifies the security policy, interfaces, and most of the options you can configure on a stand-alone device. The system administrator adds and manages contexts by configuring them in the system configuration, which, like a single-mode configuration, is the start-up configuration. The system configuration identifies basic settings for the security appliance, but it does not include any network interfaces or network settings for itself; rather, when the system needs to access network resources (such as downloading the contexts from the server), it uses the context that is designated as the Admin context. The system configuration is used to add, delete and edit basic context settings, including allocating network interfaces to the various contexts.

 
    [bookmark: pgfId-856527]The Admin context is just like any other context, except that when a user logs in to the Admin context, that user has system administrator rights and can access the system configuration and all other contexts.

 
    [bookmark: pgfId-856529]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-856534]Enabling and Disabling Multiple-Context Mode

 
     		 [bookmark: pgfId-856539]Checklist for Configuring Multiple Security Contexts

 
     		 [bookmark: pgfId-856544]Managing Security Contexts

 
    

 
   
 
    
     [bookmark: pgfId-856554][bookmark: 131679][bookmark: pxchap_cncpt_EnablingDisablingMultiContextMode]Enabling and Disabling Multiple-Context Mode[bookmark: marker-856550][bookmark: marker-856552]

 
    [bookmark: pgfId-856556]Cisco Security Manager does not support switching to multiple-context mode on an existing device. To perform this task, you must delete the device from Security Manager, enable multiple-context mode using a device manager or CLI input, and then add the device again to Security Manager. After the device is added in multiple-context mode, you can add, edit and delete security contexts.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-856558]Note When manually defining a multiple-context device, choose Multi from the Contexts list in the Operating System section of the New Device - Device Information dialog box.


    
     

    

    

 
    [bookmark: pgfId-856560]Similarly, Cisco Security Manager does not support restoring an existing device to single-context mode. To perform this task, you must delete the device and any of its child contexts from Security Manager, restore single-context operation using a device manager or CLI input, and then add the device again to Security Manager.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-856562]Note When manually defining a single-context device, choose Single from the Contexts list in the Operating System section of the New Device - Device Information dialog box.


    
     

    

    

 
    [bookmark: pgfId-856564]Related Topics

 
     
     		 [bookmark: pgfId-856569]Checklist for Configuring Multiple Security Contexts

 
     		 [bookmark: pgfId-856574]Managing Security Contexts

 
    

 
    [bookmark: pgfId-856579] – Add/Edit Security Context Dialog Box (PIX/ASA)

 
    [bookmark: pgfId-856584] – Add/Edit Security Context Dialog Box (FWSM)

 
   
 
    
     [bookmark: pgfId-856594][bookmark: 131712][bookmark: pxchap_cncpt_ChecklistforConfiguringPIXASAInterfacesinMultiContextMode]Checklist for Configuring Multiple Security Contexts[bookmark: marker-856590][bookmark: marker-856592]

 
    [bookmark: pgfId-856596]Security contexts allow a single physical device to act as multiple independent firewalls. Each security context defines a single virtual firewall, complete with its own configuration—and just as with physical devices, each security context must be correctly configured, or overall security can be compromised. Thus, defining and configuring multiple firewalls on the same physical appliance requires special care.

 
    [bookmark: pgfId-856599]The following checklist outlines the basic steps necessary to configure a firewall device with multiple security contexts. Each of these steps may involve multiple substeps; all steps should be performed in the order presented. For example, you must define interfaces before configuring the various contexts.

 
     
      
      
        
        		 
          
          [bookmark: pgfId-855432]Step
         
  
        		 
          
          [bookmark: pgfId-855434]Task
         
  
       

 
        
        		[bookmark: pgfId-855440]Step 1

  
        		[bookmark: pgfId-855442]Define interfaces and subinterfaces, or VLANs, on the physical appliance.

 [bookmark: pgfId-855444]In this task, you define the interfaces and subinterfaces, or VLANs on FWSMs, that will be allocated to the various security contexts when you create them later. Provide physical interface parameters, such as connection type (Ethernet, GigabitEthernet, etc.), hardware Port ID, speed, and duplex mode, as well as VLAN ID if defining a subinterface.

 [bookmark: pgfId-855446]Result: All interfaces and subinterfaces are defined.

 [bookmark: pgfId-855451]For more information, see Configuring Firewall Device Interfaces.

  
       

 
        
        		[bookmark: pgfId-855457]Step 2

  
        		[bookmark: pgfId-855459]Define an Admin context for administering the base security appliance.

 [bookmark: pgfId-855461]This task is called out separately to ensure you define a context and IP address specifically for administration of the security appliance. The process is the same as defining a security context; however, during the process, be sure to check Admin Context to designate this as the administration context.

 [bookmark: pgfId-855463]In addition to being used to administer the appliance, the Admin context is used to publish syslog and SNMP messages to monitoring devices, such as the Cisco Security Monitoring, Analysis and Response System (CS-MARS), for further processing.

 [bookmark: pgfId-855465]Until you associate a specific management IP address with the Admin context, the IP address used to manage the security appliance is the one you specified when defining the device. When you specify a Management IP Address with the Admin context, it takes precedence over the one on the Device Properties page.

 [bookmark: pgfId-855467]Result: The Admin context is defined and associated with a physical interface.

 [bookmark: pgfId-855469]For more information, see:

 
          
          		 [bookmark: pgfId-855474]Add/Edit Security Context Dialog Box (PIX/ASA)

 
          		 [bookmark: pgfId-855479]Add/Edit Security Context Dialog Box (FWSM)

 
         

  
       

 
        
        		[bookmark: pgfId-855485]Step 3

  
        		[bookmark: pgfId-855487]Define each security context, or virtual firewall, on the base appliance.

 [bookmark: pgfId-855489]In this task, you define individual security contexts, naming each, assigning a location for its configuration files, and allocating interfaces. Each security context represents a virtual firewall, and its definition includes the interfaces and range of associated VLAN IDs that are under its control.

 [bookmark: pgfId-855491]Note While the Admin context can operate as a firewall device, it is typically used as such only in single-context mode. Therefore, security contexts are treated as separate entities in this checklist.

 [bookmark: pgfId-855493]You cannot add new interfaces or modify the hardware Port value when defining a security context—you simply select previously defined interfaces for allocation to the context.

 [bookmark: pgfId-855495]Result: Each security context is defined and associated with a physical interface; the VLANs on which the security context will inspect traffic are also specified.

 [bookmark: pgfId-855497]For more information, see:

 
          
          		 [bookmark: pgfId-855502]Add/Edit Security Context Dialog Box (PIX/ASA)

 
          		 [bookmark: pgfId-855507]Add/Edit Security Context Dialog Box (FWSM)

 
         

  
       

 
        
        		[bookmark: pgfId-855513]Step 4

  
        		[bookmark: pgfId-855515]Submit/deploy to generate the virtual firewalls as children of the base appliance.

 [bookmark: pgfId-855517]You must create the desired contexts on the security appliance before you can begin defining the individual settings of each context. To create contexts on the appliance, you must define them, and then either submit changes in Workflow mode, or deploy the changes to the security appliance in non-Workflow mode.

 [bookmark: pgfId-855519]When you create a security context, a “virtual firewall device” appears beneath the original security appliance in the Device View. Each virtual device is indicated by a related device icon with a dotted outline, and its name is the base security appliance name, underscore (_), context name. For example, the virtual device asaMultiRouted_admin would represent the Admin context (named “admin”) on the security appliance named “asaMultiRouted.” Similarly, asaMultiRouted_security1 would represent the security context “security1” on the same base appliance.

 [bookmark: pgfId-855521]Result: Your changes are submitted or deployed (depending on the Workflow mode), which in turn creates the Admin and security contexts as children of the base security appliance.

 [bookmark: pgfId-855523]For more information, see:

 
          
          		 [bookmark: pgfId-855528]Workflow and Activities Overview

 
          		 [bookmark: pgfId-855533]Submitting an Activity for Approval (Workflow Mode with Activity Approver)

 
          		 [bookmark: pgfId-855538]Working with Deployment and the Configuration Archive

 
         

  
       

 
        
        		[bookmark: pgfId-855544]Step 5

  
        		[bookmark: pgfId-855546]Define additional settings for each security context.

 [bookmark: pgfId-855548]You can now complete the definition of each security context by selecting a virtual firewall device in the Device Selector and editing available policies, such as access rules, translation options and so on.

 [bookmark: pgfId-855550]Result: Each security context is fully defined, ready to operate as a virtual firewall.

  
       

 
      
     

 
    
 
   
 
    
     [bookmark: pgfId-856611][bookmark: 131825][bookmark: pxchap_proc_Contexts_Managing]Managing Security Contexts[bookmark: marker-856607][bookmark: marker-856609]

 
    [bookmark: pgfId-856613]The Security Contexts page lists security contexts configured for the selected device. You can add, edit and delete security contexts for an ASA, PIX 7.0+, or FWSM device running in multiple-context mode from this page.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-856621]Tip [bookmark: marker-856615][bookmark: marker-856617][bookmark: marker-856619]Deleting a security context from an FWSM device removes the security context from the running configuration of the device, but it does not delete the associated configuration file. This can cause problems if you later add another security context with the same name as the one previously deleted. This is a known issue for FWSM and is not connected to the behavior of Security Manager. A work-around is to use the CLI to delete the configuration file from the device.


    
     

    

    

 
    [bookmark: pgfId-856626]Remember, the security appliance must be in multiple-context mode in order for you to configure contexts using Security Manager. See Enabling and Disabling Multiple-Context Mode for more information.

 
    [bookmark: pgfId-856628]Follow these steps to manage security contexts:

 
    
 
    [bookmark: pgfId-856630]Step 1 Ensure Device View is your present application view; if necessary, click the Device View button on the toolbar.

 
    [bookmark: pgfId-856635]For more information on using the Device View to configure device policies, see Managing Policies in Device View and the Site-to-Site VPN Manager).

 
    [bookmark: pgfId-856637]Step 2 Select the appliance you want to configure.

 
    [bookmark: pgfId-856639]Step 3 Select Security Contexts in the Device Policy selector to display the Security Contexts page.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-856641]Note The child contexts of a multiple-mode device are represented using a different icon than firewall devices in single mode.


    
     

    

    

 
    [bookmark: pgfId-856643]Step 4 Add, edit and delete contexts, as necessary:

 
     
     		 [bookmark: pgfId-856645]To define a new context, click the  Add Row button at the bottom of the page to open the Add Security Context box.

 
     		 [bookmark: pgfId-856647]To edit an existing context, select the desired entry in the Security Contexts list and then click the  Edit Row button at the bottom of the page to open the Edit Security Context dialog box.

 
     		 [bookmark: pgfId-856649]To delete an existing context, select the desired entry in the list and then click the  Delete Row button.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-856651]Note Deleting a security context here will also cause the security context device to be removed from device inventory.


    
     

    

    

 
    [bookmark: pgfId-856653]Confirm the deletion of the security context and corresponding security context device.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-856661]Note Except for the titles, the Add Security Context dialog box and the Edit Security Context dialog box are identical. For PIX/ASA devices, see Add/Edit Security Context Dialog Box (PIX/ASA) for more information; for FWSMs, see Add/Edit Security Context Dialog Box (FWSM) for more information.


    
     

    

    

 
    [bookmark: pgfId-856663]


    
     

    
 
    

 
     
      [bookmark: pgfId-856677][bookmark: 131881][bookmark: pxpage_cncpt_AddEditSecurityContextDialogBoxFWSM]Add/Edit Security Context Dialog Box (FWSM)[bookmark: marker-856671][bookmark: marker-856673][bookmark: marker-856675]

 
     [bookmark: pgfId-856679]The Add Security Context and Edit Security Context dialog boxes let you define and maintain contexts for the currently selected Firewall Service Module. (Except for their titles, the two dialog boxes are identical.)

 
     [bookmark: pgfId-856681]Note that at least one security context must be designated as the Admin context.

 
      
      [image: ] 
     
 
     
 
     
      [bookmark: pgfId-856683]
      Caution Security Manager does not support mapped (that is, “named” or “aliased”) interfaces for FWSMs. If you discover an FWSM with named interfaces and then change the related configuration, redeployment will fail. Replace any interface aliases with the appropriate VLAN IDs.
       
       
 
      

     
 
     [bookmark: pgfId-856685]Navigation Path

 
     [bookmark: pgfId-856690]You can access the Add Security Context and Edit Security Context dialog boxes from the Security Contexts page, as described in Managing Security Contexts.

 
     [bookmark: pgfId-856692]Field Reference

 
     [bookmark: pgfId-856695] 

 
      
       
        
        [bookmark: pgfId-855563]Table 58-1 [bookmark: 131905]Add/Edit Security Context Dialog Box (FWSM) 

 
        
       
         
         		
           
           [bookmark: pgfId-855569]Element
          
  
         		
           
           [bookmark: pgfId-855571]Description
          
  
        

 
         
         		[bookmark: pgfId-855577]Name

  
         		[bookmark: pgfId-855579]Enter a name of up to 32 characters for the context. The names System and Null (in any combination of upper- and lower-case letters) are reserved, and cannot be used.

 [bookmark: pgfId-855581]Note While context names are case-sensitive on the device, they are not in Security Manager. That is, you cannot have two contexts with the same name but different capitalization in Security Manager.

  
        

 
         
         		[bookmark: pgfId-855587]Mode (FWSM 3.1+)

  
         		[bookmark: pgfId-855589]Choose the mode, Router or Transparent, for this security context.

 [bookmark: pgfId-855591]Note You cannot change the chosen mode in the Edit Security Context dialog box.

  
        

 
         
         		[bookmark: pgfId-855597]Admin Context

  
         		[bookmark: pgfId-855599]Check this box if this context is to be the Admin context for this device.

 [bookmark: pgfId-855601]Note The name of the Admin context for the device is displayed below the Security Contexts table.

  
        

 
         
         		[bookmark: pgfId-855607]VLAN IDs

  
         		[bookmark: pgfId-855609]Enter the VLANs assigned to this context. Use commas to separate multiple VLAN entries.

  
        

 
         
         		[bookmark: pgfId-855615]Config URL

  
         		[bookmark: pgfId-855617]Specify the context configuration location, as a URL-type address, by choosing a file-system protocol and then entering the path and name of the file to access for the context configuration.

 [bookmark: pgfId-855619]That is, choose a protocol type from the drop-down list, and then type the server name (for remote file systems), path, and file name in the related text field. For example, the combined URL for FTP has the following format: ftp://server.example.com/configs/admin.cfg.

 [bookmark: pgfId-855621]Available protocols are:

 
           
           		 [bookmark: pgfId-855623] disk:/ 

 
           		 [bookmark: pgfId-855625] ftp:// 

 
           		 [bookmark: pgfId-855627] http:// 

 
           		 [bookmark: pgfId-855629] https:// 

 
           		 [bookmark: pgfId-855631] tftp:// 

 
          

  
        

 
         
         		[bookmark: pgfId-855637]Failover Group

  
         		[bookmark: pgfId-855639]If this context is part of an active/active failover configuration, choose the failover group to which this context belongs.

  
        

 
         
         		[bookmark: pgfId-855645]Description

  
         		[bookmark: pgfId-855647]Enter an optional description for the context.

  
        

 
         
         		[bookmark: pgfId-855653]Management IP Addr

  
         		[bookmark: pgfId-855655]Enter or Select the IP address that Security Manager is to use for communications with this security context.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-856709][bookmark: 131980][bookmark: pxpage_cncpt_AddEditSecurityContextDialogBoxPIXASA]Add/Edit Security Context Dialog Box (PIX/ASA)[bookmark: marker-856703][bookmark: marker-856705][bookmark: marker-856707]

 
     [bookmark: pgfId-856711]The Add Security Context and Edit Security Context dialog boxes let you define and maintain contexts for the currently selected PIX/ASA security appliance. (Except for their titles, the two dialog boxes are identical.)

 
     [bookmark: pgfId-856713]Note that at least one security context must be designated as the Admin context.

 
     [bookmark: pgfId-856715]Navigation Path

 
     [bookmark: pgfId-856720]You can access the Add Security Context and Edit Security Context dialog boxes from the Security Contexts page, as described in Managing Security Contexts.

 
     [bookmark: pgfId-856722]Field Reference

 
     [bookmark: pgfId-856725] 

 
      
       
        
        [bookmark: pgfId-855668]Table 58-2 [bookmark: 132004]Add/Edit Security Context Dialog Box (PIX/ASA) 

 
        
       
         
         		
           
           [bookmark: pgfId-855674]Element
          
  
         		
           
           [bookmark: pgfId-855676]Description
          
  
        

 
         
         		[bookmark: pgfId-855682]Name

  
         		[bookmark: pgfId-855684]Enter a name of up to 32 characters for the context. The names System and Null (in any combination of upper- and lower-case letters) are reserved, and cannot be used.

 [bookmark: pgfId-855686]Note While context names are case-sensitive on the device, they are not in Security Manager. That is, you cannot have two contexts with the same name but different capitalization in Security Manager.

  
        

 
         
         		[bookmark: pgfId-855692]Description

  
         		[bookmark: pgfId-855694]Enter an optional description for the context.

  
        

 
         
         		[bookmark: pgfId-855700]Mode (ASA 9.0+)

  
         		[bookmark: pgfId-855702]Choose the mode, Router or Transparent, for this security context.

 [bookmark: pgfId-855704]Note You cannot change the chosen mode in the Edit Security Context dialog box.

  
        

 
         
         		[bookmark: pgfId-855710]Admin Context

  
         		[bookmark: pgfId-855712]Check this box if this context is to be the Admin context for this device.

 [bookmark: pgfId-855714]Note The name of the Admin context for the device is displayed below the Security Contexts table.

  
        

 
         
         		[bookmark: pgfId-855720]Config URL

  
         		[bookmark: pgfId-855722]Specify the context configuration location, as a URL-type address, by choosing a file-system protocol and then entering the path and name of the file to access for the context configuration.

 [bookmark: pgfId-855724]That is, choose a protocol type from the drop-down list, and then type the server name (for remote file systems), path, and file name in the related text field. For example, the combined URL for FTP has the following format: ftp://server.example.com/configs/admin.cfg.

 [bookmark: pgfId-855726]Available protocols are:

 
           
           		 [bookmark: pgfId-855728] disk0:/ 

 
           		 [bookmark: pgfId-855730] disk1:/ 

 
           		 [bookmark: pgfId-855732] flash:/ 

 
           		 [bookmark: pgfId-855734] ftp:// 

 
           		 [bookmark: pgfId-855736] http:// 

 
           		 [bookmark: pgfId-855738] https:// 

 
           		 [bookmark: pgfId-855740] tftp:// 

 
          

  
        

 
         
         		[bookmark: pgfId-855746]ScanSafe Settings

  
         		[bookmark: pgfId-855751]To enable ScanSafe inspection in this context, select Enable ScanSafe Web Security. To override the license specified in the system configuration, enter a license ID in the License field; must be 32 hexadecimal characters. See Chapter 20, “Working with ScanSafe Web Security” for more information.

  
        

 
         
         		[bookmark: pgfId-855757]Interfaces

  
         		[bookmark: pgfId-855759]This table lists the interfaces and subinterfaces allocated to this context, and their associated settings. These are the interfaces and subinterfaces for which the security context will inspect traffic.

 [bookmark: pgfId-855764]To add interfaces and subinterfaces to this context, click the Add Row button below the table to open the Allocate Interfaces Dialog Box (PIX/ASA only). You can allocate one or more interfaces, and optionally with each interface, one or a range of subinterfaces.

 [bookmark: pgfId-855769]To edit an allocation entry, select it and then click the Edit Row button below the table to open the Edit Interface dialog box. Note that you can edit only the Alias Name and the Show hardware properties option; you cannot change the interface/subinterface assignments. Refer to Allocate Interfaces Dialog Box (PIX/ASA only) for more information about these options.

 [bookmark: pgfId-855771]To remove an interface/subinterface allocation, select the appropriate row in this table and then click the Delete Row button below the table.

  
        

 
         
         		[bookmark: pgfId-855777]Failover Group

  
         		[bookmark: pgfId-855779]If this context is part of an active/active failover configuration, choose the failover group to which this context belongs.

  
        

 
         
         		[bookmark: pgfId-855785]Management IP Address

  
         		[bookmark: pgfId-855787]Enter or Select the IP address that Security Manager is to use for communications with this security context.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-856741][bookmark: 132095][bookmark: pxpage_cncpt_AllocateInterfacesDialogBox]Allocate Interfaces Dialog Box (PIX/ASA only)[bookmark: marker-856733][bookmark: marker-856735][bookmark: marker-856737][bookmark: marker-856739]

 
     [bookmark: pgfId-856743]The Allocate Interfaces dialog box lets you assign an interface, and optionally one or a range of related subinterfaces, to a context, and set name-aliasing options.

 
     [bookmark: pgfId-856745]Navigation Path

 
     [bookmark: pgfId-856750]You access the Allocate Interfaces dialog box from the Add Security Context and Edit Security Context dialog boxes. See Add/Edit Security Context Dialog Box (PIX/ASA) for more information.

 
     [bookmark: pgfId-856752]Related Topics

 
      
      		 [bookmark: pgfId-856757]Managing Security Contexts

 
     

 
     [bookmark: pgfId-856759]Field Reference

 
     [bookmark: pgfId-856762] 

 
      
       
        
        [bookmark: pgfId-855800]Table 58-3 [bookmark: 132128]Allocate Interfaces Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-855806]Element
          
  
         		
           
           [bookmark: pgfId-855808]Description
          
  
        

 
         
         		[bookmark: pgfId-855814]Physical Interface

  
         		[bookmark: pgfId-855816]Choose a physical interface to assign to this context.

 [bookmark: pgfId-855818]In transparent firewall mode, you can assign only an interface that has not been allocated to another context. If you choose an interface already assigned to another context, you must also specify an subinterface.

  
        

 
         
         		[bookmark: pgfId-855824]Sub Interface ID From/To

  
         		[bookmark: pgfId-855826]Use these drop-down lists to specify a subinterface, or a range of subinterfaces; both lists present the subinterface IDs associated with the chosen Physical Interface.

 [bookmark: pgfId-855828]To specify a single subinterface, choose the desired ID from the first list. To specify a range, if available, choose the ending ID from the second list. (In transparent firewall mode, only subinterfaces that have not been allocated to other contexts are shown.)

  
        

 
         
         		[bookmark: pgfId-855842][bookmark: marker-855834][bookmark: marker-855836][bookmark: marker-855838][bookmark: marker-855840]View Allocation button

  
         		[bookmark: pgfId-855844]Click this button to open the View Interface Allocation dialog box, which presents a read-only list of all physical interfaces defined on this device and the security contexts and failover groups associated with each. You can use this to quickly determine current allocations without closing the Allocate Interfaces dialog box.

  
        

 
         
         		[bookmark: pgfId-855850]Use aliased name in context

  
         		[bookmark: pgfId-855852]To enable name aliasing for this interface/subinterface, check Use aliased names in the security context and then enter an alias in the Alias Name field.

 [bookmark: pgfId-855854]The specified alias replaces the name of this physical interface or subinterface anywhere it would be displayed for this context—for example, the Hardware Port column on the Interfaces Page.

  
        

 
         
         		[bookmark: pgfId-855860]Alias Name

  
         		[bookmark: pgfId-855862]Enter the desired alias. An alias must start with a letter, end with a letter or digit, and have as interior characters only letters, digits, and underscores.

  
        

 
         
         		[bookmark: pgfId-855868]Suffix Range From/To

  
         		[bookmark: pgfId-855870]If you specified a range of subinterfaces, these fields are available to let you specify numeric suffixes for their aliased name. The aliased name for each subinterface consists of its sequence number from this range appended to the Alias Name you provided in the previous field.

 [bookmark: pgfId-855872]These values default to the beginning and ending subinterface ID numbers, but you can enter any valid range of numbers.

  
        

 
         
         		[bookmark: pgfId-855878]Show hardware properties in context

  
         		[bookmark: pgfId-855880]Select this option to allow the show interface CLI command to display of physical interface properties for the context even if you defined an alias. If not selected, the show interface output includes the aliased name.
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     [bookmark: pgfId-54557][bookmark: 103360][bookmark: ipdvchap_cncpt_ConfiguringARCforBlockingandRateLimiting]Configuring Attack Response Controller for Blocking and Rate Limiting[bookmark: marker-54549][bookmark: marker-54551][bookmark: marker-54553][bookmark: marker-54555]
      
      
 
     
 

 
    [bookmark: pgfId-54559]You can configure an IPS device to implement blocks or rate limits to control attacks. Blocking and rate limiting are primarily of use when operating in promiscuous mode. When operating in inline mode, it is much more efficient to have the IPS drop traffic itself. Blocking and rate limiting are actions that other devices implement at the request of the IPS; thus, configuring blocking and rate limiting is a more complex configuration than simple inline denies.

 
    [bookmark: pgfId-54561]To configure blocking or rate limiting, you must identify the network device that performs the blocking. A network device that performs blocking is called a blocking device. Many network devices can be used to support blocking: Cisco IOS routers and Catalyst 6500 switches, Cisco security appliances (ASA, PIX, and FWSM), and Catalyst 6500/7600 devices running the Catalyst operating system. You can also configure another IPS device to act as a master blocking sensor.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-54563]Note IPS blocking and rate limiting works only for IPS appliances and service modules. You cannot configure it for Cisco IOS IPS.


    
     

    

    

 
    [bookmark: pgfId-54565]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-54570]Understanding IPS Blocking

 
     		 [bookmark: pgfId-54575]Configuring IPS Blocking and Rate Limiting

 
     		 [bookmark: pgfId-54580]Blocking Page

 
    

 
   
 
    
     [bookmark: pgfId-54592][bookmark: 103378][bookmark: ipdvchap_cncpt_UnderstandingIPSBlocking]Understanding IPS Blocking[bookmark: marker-54586][bookmark: marker-54588][bookmark: marker-54590]

 
    [bookmark: pgfId-54594]The Attack Response Controller (ARC) component of the IPS is responsible for managing network devices in response to suspicious events by blocking access from attacking hosts and networks. ARC blocks the IP address on the devices it is managing. It sends the same block to all the devices it is managing, including any other master blocking sensors. ARC monitors the time for the block and removes the block after the time has expired.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-54596]Note ARC is formerly known as Network Access Controller. Although the name has been changed, the IPS documentation and configuration interfaces contain references to Network Access Controller, nac, and network-access.


    
     

    

    

 
    [bookmark: pgfId-54598]ARC completes the action response for a new block in no more than 7 seconds. In most cases, it completes the action response in less time. To meet this performance goal, you should not configure the sensor to perform blocks at too high a rate or to manage too many blocking devices and interfaces. We recommend that the maximum number of blocks not exceed 250 and the maximum number of blocking items not exceed 10. To calculate the maximum number of blocking items, a security appliance counts as one blocking item per blocking context. A router counts as one blocking item per blocking interface/direction. A switch running Catalyst software counts as one blocking item per blocking VLAN. If the recommended limits are exceeded, ARC might not apply blocks in a timely manner or might not be able to apply blocks at all.

 
    [bookmark: pgfId-54600]For security appliances configured in multiple-context mode, Cisco IPS does not include VLAN information in the block request. Therefore you must make sure the IP addresses being blocked are correct for each security appliance. For example, the sensor is monitoring packets on a security appliance customer context that is configured for VLAN A, but is blocking on a different security appliance customer context that is configured for VLAN B. Addresses that trigger blocks on VLAN A might refer to a different host on VLAN B.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-54602]Note Blocking is not supported on the FWSM on the admin context in multiple-context mode.


    
     

    

    

 
    [bookmark: pgfId-54604]There are three types of blocks:

 
     
     		 [bookmark: pgfId-54606]Host block—Blocks all traffic from a given IP address.

 
    

 
    [bookmark: pgfId-54614]To configure the IPS to initiate automatic host blocks when a signature is triggered, add the Request Block Host event action to a signature, or add it to events based on risk rating using the event action override policy. See Configuring Event Action Overrides and Configuring Signatures.

 
     
     		 [bookmark: pgfId-54616]Connection block—Blocks traffic from a given source IP address to a given destination IP address and destination port. Multiple connection blocks from the same source IP address to either a different destination IP address or destination port automatically switch the block from a connection block to a host block.

 
    

 
    [bookmark: pgfId-54618]To configure the IPS to initiate automatic connection blocks when a signature is triggered, add the Request Block Connection event action to a signature, or add it to events based on risk rating using the event action override policy.

 
     
     		 [bookmark: pgfId-54620]Network block—Blocks all traffic from a given network.

 
    

 
    [bookmark: pgfId-54622]You can initiate host and connection blocks manually or automatically when a signature is triggered. You can only initiate network blocks manually. You cannot initiate network blocks from within Security Manager; use the IPS Device Manager instead.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-54624]Tip Connection blocks and network blocks are not supported on security appliances (firewalls). Security appliances only support host blocks with additional connection information.


    
     

    

    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-54626]Note Do not confuse blocking with the ability of the sensor to drop packets. The sensor can drop packets when the following actions are configured for a sensor in inline mode: deny packet inline, deny connection inline, and deny attacker inline.


    
     

    

    

 
    [bookmark: pgfId-54628]On Cisco IOS Software devices (routers and Catalyst 6500 series switches), ARC creates blocks by applying ACLs; on Catalyst 6500/7600 devices that run the Catalyst operating system, ARC creates blocks by applying VACLs. ACLs and VACLs permit or deny passage of data packets through interface directions or VLANs. Each ACL or VACL contains permit and deny conditions that apply to IP addresses. The security appliances use the shun command instead of ACLs.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-54632]Tip For a list of the specific devices and operating system versions that you can configure as blocking devices, see the supported device information in the chapter “Configuring Attack Response Controller for Blocking and Rate Limiting” in the Installing and Using Cisco Intrusion Prevention System Device Manager publication for your IPS software version. These publications are available on Cisco.com at http://www.cisco.com/en/US/products/hw/vpndevc/ps4077/products_installation_and_configuration_guides_list.html.


    
     

    

    

 
    [bookmark: pgfId-54634]The following topics explain more about IPS blocking:

 
     
     		 [bookmark: pgfId-54639]Strategies for Applying Blocks

 
     		 [bookmark: pgfId-54644]Understanding Rate Limiting

 
     		 [bookmark: pgfId-54649]Understanding Router and Switch Blocking Devices

 
     		 [bookmark: pgfId-54654]Understanding the Master Blocking Sensor

 
     		 [bookmark: pgfId-54659]Configuring IPS Blocking and Rate Limiting

 
     		 [bookmark: pgfId-54664]Blocking Page

 
    

 
     
      [bookmark: pgfId-54676][bookmark: 103438][bookmark: ipdvchap_cncpt_StrategiesforApplyingBlocks]Strategies for Applying Blocks[bookmark: marker-54670][bookmark: marker-54672][bookmark: marker-54674]

 
     [bookmark: pgfId-54678]Blocking is performed only when an event occurs and the event includes the Request Block Connection or Request Block Host event actions. These event actions are not typically needed when you operate the IPS in inline mode, where you use Deny actions to drop undesired traffic.

 
     [bookmark: pgfId-54680]The following are situations in which you might want to implement blocking actions:

 
      
      		 [bookmark: pgfId-54682]Promiscuous mode—When running in promiscuous mode, the IPS cannot implement Deny actions. Thus, if you want to prevent traffic from a host, you must implement blocking.

 
      		 [bookmark: pgfId-54684]Inline mode—In inline mode, you can implement Deny actions to immediately drop undesired traffic. However, you might want to add blocking actions to protect other segments of your network.

 
     

 
     [bookmark: pgfId-54686]For example, suppose that your network consists of five subnets, A, B, C, D, and E, and that each of these segments has an inline IPS device monitoring it. If the IPS for subnet A identifies an attack, the IPS can use Deny actions to protect subnet A, but also use Request Block actions to configure the firewalls that protect B, C, D, and E to shun the attacker before the attack can target those other subnets. In this example, you would want to designate a single IPS as the master blocking sensor and have the other four IPS sensors perform blocking through the master blocking sensor.

 
     [bookmark: pgfId-54688]Use the following techniques to add the request block actions to an event:

 
      
      		 [bookmark: pgfId-54693]Event Action Override policy—Configure an event action override rule to add the action to all events based on the event’s risk rating. This is a simple approach. You could add the request block action for the same risk ratings used for adding Deny actions. For more information, see Configuring Event Action Overrides.

 
      		 [bookmark: pgfId-54698]Signatures policy—You can add the request block actions to individual signatures. This requires editing each signature to add the action. This can be a time-consuming approach, but it allows you to configure blocking for just the types of events that concern you most. For more information, see Configuring Signatures.

 
     

 
     [bookmark: pgfId-54700]Related Topics

 
      
      		 [bookmark: pgfId-54705]Understanding IPS Blocking

 
      		 [bookmark: pgfId-54710]Understanding the Master Blocking Sensor

 
      		 [bookmark: pgfId-54715]Understanding Interface Modes

 
      		 [bookmark: pgfId-54720]Configuring IPS Blocking and Rate Limiting

 
      		 [bookmark: pgfId-54725]Blocking Page

 
     

 
    
 
     
      [bookmark: pgfId-54739][bookmark: 103486][bookmark: ipdvchap_cncpt_UnderstandingRateLimiting]Understanding Rate Limiting[bookmark: marker-54731][bookmark: marker-54733][bookmark: marker-54735][bookmark: marker-54737]

 
     [bookmark: pgfId-54741]Attack Response Controller (ARC) is responsible for rate limiting traffic in protected networks. Rate limiting lets sensors restrict the rate of specified traffic classes on network devices. Rate limit responses are supported for the Host Flood and Net Flood engines, and the TCP half-open SYN signature. ARC can configure rate limits on network devices running Cisco IOS 12.3 or later. Master blocking sensors can also forward rate limit requests to blocking forwarding sensors.

 
     [bookmark: pgfId-54743]To add a rate limit to a signature, you must add the Request Rate Limit action. You can then edit the signature parameters to set the percentage for these signatures in the Event Actions Settings folder.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-54745]Tip You can also manually implement rate limits, but you cannot do so using Security Manager; use the IPS Device Manager instead.


     
      

     

     

 
     [bookmark: pgfId-54747]On the blocking device, you must not apply a service policy to an interface/direction that is configured for rate limiting. If you do so, the rate limit action will fail. Before configuring rate limits, confirm that there is no service policy on the interface/direction, and remove it if one exists. ARC does not remove the existing rate limit unless it is one that ARC had previously added.

 
     [bookmark: pgfId-54749]Rate limits use ACLs, but not in the same way as blocks. Rate limits use ACLs and class-map entries to identify traffic, and policy-map and service-policy entries to police the traffic.

 
    
 
     
      [bookmark: pgfId-54769][bookmark: 103507][bookmark: ipdvchap_cncpt_UnderstandingRouterandSwitchBlockingDevices]Understanding Router and Switch Blocking Devices[bookmark: marker-54755][bookmark: marker-54757][bookmark: marker-54759][bookmark: marker-54761][bookmark: marker-54763][bookmark: marker-54765][bookmark: marker-54767]

 
     [bookmark: pgfId-54771]You can use routers or Catalyst 6500/7600 devices running Cisco IOS Software, or Catalyst 6500/7600 devices running the Catalyst operating system, to implement IPS blocking in your network. When you use routers or switches, Attack Response Controller (ARC) configures extended ACLs (on IOS devices) or VLAN ACLs (on Catalyst OS devices) to implement the blocks. These ACLs and VACLs are created and managed in the same way.

 
     [bookmark: pgfId-54773]Rate limits also use ACLs, but not in the same way as blocks. Rate limits use ACLs and class-map entries to identify traffic, and policy-map and service-policy entries to police the traffic.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-54775]Tip IPS considers Catalyst 6500/7600 devices that run Cisco IOS Software to be equivalent to routers. When you add these devices as blocking devices, add them as routers.


     
      

     

     

 
     [bookmark: pgfId-54777]When you configure a router interface or switch VLAN as a blocking interface, you can optionally specify the names of pre- and post-ACLs or VACLs. Although specifying ACL or VACL names is optional, if you have configured ACLs or VACLs on the interface or VLAN, you must identify them to the IPS or ARC will remove them from your device configuration.

 
     [bookmark: pgfId-54779]The pre- and post-ACL/VACL have the following uses:

 
      
      		 [bookmark: pgfId-54781]The Pre-Block ACL/VACL is mainly used for permitting what you do not want the sensor to ever block. When a packet is checked against the ACL/VACL, the first line that gets matched determines the action. If the first line matched is a permit line from the Pre-Block ACL/VACL, the packet is permitted even though there may be a deny line (from an automatic block) listed later in the ACL/VACL. The Pre-Block ACL/VACL can override the deny lines resulting from the blocks.

 
      		 [bookmark: pgfId-54783]The Post-Block ACL/VACL is best used for additional blocking or permitting that you want to occur on the same interface or direction. If you have an existing ACL on the interface or direction that the sensor will manage, that existing ACL can be used as a Post-Block ACL/VACL. If you do not have a Post-Block ACL/VACL, the sensor inserts permit ip any any at the end of the new ACL/VACL.

 
     

 
     [bookmark: pgfId-54785]If you are managing the IOS Software blocking device in Security Manager, you can identify the ACL name by selecting the blocking device, then selecting Tools > Preview Config. Look for the ip access-group command in the interface configuration, and check the direction. For example, the following lines show that there is an ACL named CSM_FW_ACL_GigabitEthernet0/1 in the In direction attached to the GigabitEthernet0/1 interface.

 
     
      [bookmark: pgfId-54787]interface GigabitEthernet0/1
     

     
      [bookmark: pgfId-54789] ip access-group CSM_FW_ACL_GigabitEthernet0/1 in
     

     
      [bookmark: pgfId-54791] 
     

     [bookmark: pgfId-54793]In this example, if you configure GigabitEthernet0/1 in the In direction as a blocking interface, ensure that you specify CSM_FW_ACL_GigabitEthernet0/1 as a pre- or post-ACL. In most cases, you should specify the ACL as the post-ACL, so that the relatively short IPS blocking ACL first filters out undesirable traffic before the blocking device implements your other access rules.

 
     [bookmark: pgfId-54795]Because Security Manager does not manage Catalyst OS devices, you must examine a Catalyst OS device configuration outside of Security Manager to determine VACL names. Keep in mind that a Catalyst 6500/7600 device that runs IOS Software can also have VACLs, but the IPS does not do VLAN blocking on Catalyst 6500/7600 VLANs when the device is running IOS Software.

 
     [bookmark: pgfId-54797]When the sensor starts up, it reads the contents of the two ACL/VACLs. It creates a third ACL/VACL with the following entries in this order, and this combined ACL/VACL is applied to the interface or VLAN:

 
     [bookmark: pgfId-54799] 1. A permit line with the sensor IP address or, if specified, the NAT address of the sensor.

 
     [bookmark: pgfId-54804]If you select the Allow Sensor IP address to be Blocked option on the General tab of the Blocking policy, this permit entry is not added. For more information, see General Tab, IPS Blocking Policy.

 
     [bookmark: pgfId-54806] 2. Pre-Block ACL/VACL, if specified.

 
     [bookmark: pgfId-54808] 3. Any active blocks generated by the IPS (deny statements).

 
     [bookmark: pgfId-54810] 4. The Post-Block ACL/VACL, if specified.

 
     [bookmark: pgfId-54812]If you do not specify a Post-Block ACL/VACL, a permit ip any any entry is added to allow all unfiltered traffic. Note that this negates the normal implicit deny any that ends interface ACLs.

 
     [bookmark: pgfId-54814]When using Catalyst OS, IDSM-2 inserts permit ip any any capture at the end of the new VACL.

 
     [bookmark: pgfId-54816]If ARC is managing a device and you need to configure the ACL/VACLs on that device, you should disable blocking first. You want to avoid a situation in which both you and ARC could be making a change at the same time on the same device. This could cause the device or ARC to fail. If you need to modify the Pre-Block or Post-Block ACL/VACL, do the following:

 
     [bookmark: pgfId-54818] 1. Disable blocking on the sensor.

 
     [bookmark: pgfId-54820]Because you are making a temporary change, you can disable and then reenable blocking by using the IPS Device Manager (IDM) on the device. Alternatively, you can deselect the Enable Blocking option on the General tab of the Blocking policy in Security Manager, then deploy the configuration to the IPS sensor. To reenable blocking, select the Enable Blocking option again and deploy the configuration to the IPS sensor.

 
     [bookmark: pgfId-54822] 2. Make the changes to the configuration of the device. For example, if you manage the blocking device in Security Manager, deploy the updated configuration and wait for the device to reload.

 
     [bookmark: pgfId-54824] 3. Reenable blocking on the sensor.

 
    
 
     
      [bookmark: pgfId-54838][bookmark: 103579][bookmark: ipdvchap_cncpt_UnderstandingtheMasterBlockingSensor]Understanding the Master Blocking Sensor[bookmark: marker-54830][bookmark: marker-54832][bookmark: marker-54834][bookmark: marker-54836]

 
     [bookmark: pgfId-54840]Multiple sensors (blocking forwarding sensors) can forward blocking requests to a specified master blocking sensor, which controls one or more devices. The master blocking sensor is the ARC running on a sensor that controls blocking on one or more devices on behalf of one or more other sensors. When a signature fires that has blocking or rate limit requests configured as event actions, the sensor forwards the block or rate limit request to the master blocking sensor, which then performs the block or rate limit.

 
     [bookmark: pgfId-54842]When you add a master blocking sensor, you reduce the number of blocking devices per sensor. For example, if you want to block on 10 firewalls and 10 routers with one blocking interface/direction each, you can assign 10 to the sensor and assign the other 10 to a master blocking sensor.

 
     [bookmark: pgfId-54847]You configure master blocking sensors on the Master Blocking Sensors tab of the Blocking policy, as described in Blocking Page.

 
     [bookmark: pgfId-54849]When configuring master blocking sensors, keep the following tips in mind:

 
      
      		 [bookmark: pgfId-54851]Two sensors cannot control blocking or rate limiting on the same device. If this situation is needed, configure one sensor as the master blocking sensor to manage the devices and the other sensors can forward their requests to the master blocking sensor.

 
      		 [bookmark: pgfId-54856]On the blocking forwarding sensor, identify which remote host serves as the master blocking sensor; on the master blocking sensor you must add the blocking forwarding sensors to its access list using the Allowed Hosts policy. See Identifying Allowed Hosts.

 
      		 [bookmark: pgfId-54861]If the master blocking sensor requires TLS for web connections, you must configure the ARC of the blocking forwarding sensor to accept the X.509 certificate of the master blocking sensor remote host. Sensors by default have TLS enabled, but you can change this option. For more information, see Master Blocking Sensor Dialog Box.

 
      		 [bookmark: pgfId-54863]Typically the master blocking sensor is configured to manage the network devices. Blocking forwarding sensors are not normally configured to manage other network devices, although doing so is permissible.

 
      		 [bookmark: pgfId-54865]Only one sensor should control all blocking interfaces on a device.

 
     

 
    
 
   
 
    
     [bookmark: pgfId-54877][bookmark: 103614][bookmark: ipdvchap_cncpt_ConfiguringBlocking]Configuring IPS Blocking and Rate Limiting[bookmark: marker-54871][bookmark: marker-54873][bookmark: marker-54875]

 
    [bookmark: pgfId-54879]If you use the Request Block Host, Request Block Connection, or Request Rate Limit actions on any signatures, or add them to events using the event action override policy, you must configure blocking devices. If you do not use these actions, there is no need to configure blocking devices.

 
    [bookmark: pgfId-54881]Before you configure blocking, read the following topics:

 
     
     		 [bookmark: pgfId-54886]Understanding IPS Blocking

 
     		 [bookmark: pgfId-54891]Strategies for Applying Blocks

 
     		 [bookmark: pgfId-54896]Understanding Rate Limiting

 
     		 [bookmark: pgfId-54901]Understanding Router and Switch Blocking Devices

 
     		 [bookmark: pgfId-54906]Understanding the Master Blocking Sensor

 
    

 
    
 
    [bookmark: pgfId-54908]Step 1 Do one of the following:

 
     
     		 [bookmark: pgfId-54910](Device view) Select  Platform > Security > Blocking from the Policy selector.

 
     		 [bookmark: pgfId-54912](Policy view) Select  IPS > Platform > Security > Blocking , then select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-54917]For an overview of the blocking policy, see Blocking Page.

 
    [bookmark: pgfId-54922]Step 2 On the General tab, change any settings where you want non-default values. However, the default values are appropriate for most networks. For detailed information about the settings, see General Tab, IPS Blocking Policy.

 
    [bookmark: pgfId-54924]Step 3 Click the User Profiles tab and create the user profiles that are required to log into the blocking devices.

 
     
     		 [bookmark: pgfId-54929]To add a profile, click the  Add Row button and fill in the Add User Profile dialog box (see User Profile Dialog Box).

 
     		 [bookmark: pgfId-54931]To edit a profile, select it and click the  Edit Row button.

 
     		 [bookmark: pgfId-54933]To delete a profile, select it and click the  Delete Row button. Before you delete a profile, ensure that it is not currently being used by a blocking device.

 
    

 
    [bookmark: pgfId-54938]Step 4 If you need to use a master blocking sensor, as described in Understanding the Master Blocking Sensor, click the Master Blocking Sensors tab and do the following:

 
     
     		 [bookmark: pgfId-54943]To add a master blocking sensor, click the  Add Row button and fill in the Add Master Blocking Sensor dialog box (see Master Blocking Sensor Dialog Box).

 
     		 [bookmark: pgfId-54945]To edit a master blocking sensor, select it and click the  Edit Row button.

 
     		 [bookmark: pgfId-54947]To delete a master blocking sensor, select it and click the  Delete Row button.

 
    

 
    [bookmark: pgfId-54949]Step 5 Identify the blocking devices (unless you will use master blocking sensors only). You must add the devices to the correct tab:

 
     
     		 [bookmark: pgfId-54951] Routers tab—For all Cisco IOS Software devices, including Catalyst 6500 switches that are running IOS Software.

 
     		 [bookmark: pgfId-54953] Firewalls tab—For ASA, PIX, and FWSM.

 
     		 [bookmark: pgfId-54955] Catalyst 6K tab—For Catalyst 6500/7600 devices that are running the Catalyst operating system.

 
    

 
    [bookmark: pgfId-54957]On each tab, the configuration steps are the same:

 
     
     		 [bookmark: pgfId-54962]To add a device, click the  Add Row button and fill in the Add Router, Firewall, or Cat6K Device dialog box (see Router, Firewall, Cat6K Device Dialog Box).

 
     		 [bookmark: pgfId-54964]To edit a device, select it and click the  Edit Row button.

 
     		 [bookmark: pgfId-54966]To delete a device, select it and click the  Delete Row button.

 
    

 
    [bookmark: pgfId-54968]Step 6 Click the Never Block Hosts and Networks tab and identify the hosts and networks that should never be blocked. These lists affect blocking actions, but they do not affect limiting actions. Identify your trusted networks and hosts:

 
     
     		 [bookmark: pgfId-54973]To add a host or network, click the  Add Row button beneath the appropriate table and fill in the Add Never Block Host or Network dialog box (see Never Block Host or Network Dialog Boxes).

 
     		 [bookmark: pgfId-54975]To edit a host or network, select it and click the  Edit Row button.

 
     		 [bookmark: pgfId-54977]To delete a host or network, select it and click the  Delete Row button.

 
    

 
    [bookmark: pgfId-54979]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-54995][bookmark: 103730][bookmark: ipspage_cncpt_BlockingPage]Blocking Page[bookmark: marker-54987][bookmark: marker-54989][bookmark: marker-54991][bookmark: marker-54993]

 
    [bookmark: pgfId-54997]Use the Blocking page to configure IPS sensor blocking properties. Configure the blocking policy only if you use the Request Block Connection, Request Block Host, or Request Rate Limit event actions in your signatures or event actions policies. Blocking hosts are used only for events to which these actions are assigned.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-55002]Tip The list of hosts and networks to never block applies only to the Request Block Connection and Request Block Host event actions. The list does not affect rate limiting, nor does it affect any of the Deny actions such as Deny Packet Inline. To exempt hosts and networks from Deny or rate limiting actions, use event action filter rules, specify the hosts and networks as Attackers, and remove the actions from events. For more information, see Configuring Event Action Filters.


    
     

    

    

 
    [bookmark: pgfId-55004]Navigation Path

 
     
     		 [bookmark: pgfId-55006](Device view) Select  Platform > Security > Blocking from the Policy selector.

 
     		 [bookmark: pgfId-55008](Policy view) Select  IPS > Platform > Security > Blocking , then select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-55010]Related Topic

 
     
     		 [bookmark: pgfId-55015]Configuring IPS Blocking and Rate Limiting

 
     		 [bookmark: pgfId-55020]Understanding IPS Blocking

 
     		 [bookmark: pgfId-55025]Strategies for Applying Blocks

 
     		 [bookmark: pgfId-55030]Understanding Rate Limiting

 
     		 [bookmark: pgfId-55035]Understanding Router and Switch Blocking Devices

 
     		 [bookmark: pgfId-55040]Understanding the Master Blocking Sensor

 
     		 [bookmark: pgfId-55045]Understanding IPS Event Actions

 
    

 
    [bookmark: pgfId-55047]Field Reference

 
    [bookmark: pgfId-55050] 

 
     
      
       
       [bookmark: pgfId-53362]Table 43-1 [bookmark: 103786]IPS Blocking Policy 

 
       
      
        
        		
          
          [bookmark: pgfId-53368]Element
         
  
        		
          
          [bookmark: pgfId-53370]Description
         
  
       

 
        
        		[bookmark: pgfId-53376]General tab

  
        		[bookmark: pgfId-53381]The basic settings required to enable blocking and rate limiting. For information about the options on the General tab, see General Tab, IPS Blocking Policy.

  
       

 
        
        		[bookmark: pgfId-53387]User Profiles tab

  
        		[bookmark: pgfId-53389]The connection credential information profiles for logging into the blocking devices. Before you define a blocking device, create the user profile required to log into the device. The table shows the profile name, username, and the passwords, which are masked with a fixed number of asterisks.

 
          
          		 [bookmark: pgfId-53394]To add a profile, click the  Add Row button and fill in the Add User Profile dialog box (see User Profile Dialog Box).

 
          		 [bookmark: pgfId-53396]To edit a profile, select it and click the  Edit Row button.

 
          		 [bookmark: pgfId-53398]To delete a profile, select it and click the  Delete Row button. Before you delete a profile, ensure that it is not currently being used by a blocking device.

 
         

  
       

 
        
        		[bookmark: pgfId-53404]Master Blocking Sensors tab

  
        		[bookmark: pgfId-53409]The master blocking IPS sensors (see Understanding the Master Blocking Sensor). A master blocking sensor manages blocks for other IPS devices. The table shows the IP address (or network/host object) of the master blocking sensor, the username and password for logging into it, the port used for connections, and whether TLS is used for login.

 
          
          		 [bookmark: pgfId-53414]To add a master blocking sensor, click the  Add Row button and fill in the Add Master Blocking Sensor dialog box (see Master Blocking Sensor Dialog Box).

 
          		 [bookmark: pgfId-53416]To edit a master blocking sensor, select it and click the  Edit Row button.

 
          		 [bookmark: pgfId-53418]To delete a master blocking sensor, select it and click the  Delete Row button.

 
         

  
       

 
        
        		[bookmark: pgfId-53424]Router tab

  
        		[bookmark: pgfId-53426]The IOS routers and Catalyst 6500/7600 devices (that are running IOS Software) to be used as blocking or rate limiting devices. The table shows the IP address (or network/host object) of the device, the communication method used to log into it, the NAT address of the sensor (0.0.0.0 if NAT is not used), the name of the profile that is used for logging into the device, and the device’s response capabilities (blocking, rate limiting, or both).

 
          
          		 [bookmark: pgfId-53431]To add a router, click the  Add Row button and fill in the Add Router Device dialog box (see Router, Firewall, Cat6K Device Dialog Box).

 
          		 [bookmark: pgfId-53433]To edit a router, select it and click the  Edit Row button.

 
          		 [bookmark: pgfId-53435]To delete a router, select it and click the  Delete Row button.

 
         

  
       

 
        
        		[bookmark: pgfId-53441]Firewall tab

  
        		[bookmark: pgfId-53443]The ASA, PIX, and FWSM devices to be used as blocking devices. The table shows the IP address (or network/host object) of the device, the communication method used to log into it, the NAT address of the sensor (0.0.0.0 if NAT is not used), and the name of the profile that is used for logging into the device.

 
          
          		 [bookmark: pgfId-53448]To add a firewall, click the  Add Row button and fill in the Add Firewall Device dialog box (see Router, Firewall, Cat6K Device Dialog Box).

 
          		 [bookmark: pgfId-53450]To edit a firewall, select it and click the  Edit Row button.

 
          		 [bookmark: pgfId-53452]To delete a firewall, select it and click the  Delete Row button.

 
         

  
       

 
        
        		[bookmark: pgfId-53458]Catalyst 6K tab

  
        		[bookmark: pgfId-53460]The Catalyst 6500/7600 devices that are using Catalyst software to be used as blocking devices. The table shows the IP address (or network/host object) of the device, the communication method used to log into it, the NAT address of the sensor (0.0.0.0 if NAT is not used), and the name of the profile that is used for logging into the device.

 [bookmark: pgfId-53462]Tip Do not use this tab for Catalyst 6500/7600 devices that run Cisco IOS Software. Instead, use the Router tab. 
          
          		 [bookmark: pgfId-53467]To add a Catalyst OS device, click the  Add Row button and fill in the Add Cat6K Device dialog box (see Router, Firewall, Cat6K Device Dialog Box).

 
          		 [bookmark: pgfId-53469]To edit a Catalyst OS device, select it and click the  Edit Row button.

 
          		 [bookmark: pgfId-53471]To delete a Catalyst OS device, select it and click the  Delete Row button.

 
         

  
       

 
        
        		[bookmark: pgfId-53477]Never Block Hosts and Networks

  
        		[bookmark: pgfId-53479]The hosts and networks that should never be blocked. Hosts and networks are shown in separate tables. The tables show the IP address or network/host object for the host or network. These lists do not affect rate limiting actions, nor do they apply to Deny actions.

 
          
          		 [bookmark: pgfId-53484]To add a host or network, click the  Add Row button beneath the appropriate table and fill in the Add Never Block Host or Network dialog box (see Never Block Host or Network Dialog Boxes).

 
          		 [bookmark: pgfId-53486]To edit a host or network, select it and click the  Edit Row button.

 
          		 [bookmark: pgfId-53488]To delete a host or network, select it and click the  Delete Row button.

 
         

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-55064][bookmark: 103900][bookmark: ipspage_cncpt_BlockingPageGeneralTab]General Tab, IPS Blocking Policy[bookmark: marker-55056][bookmark: marker-55058][bookmark: marker-55060][bookmark: marker-55062]

 
     [bookmark: pgfId-55066]Use the General tab of the Blocking policy to configure the basic settings required to enable blocking and rate limiting.

 
     [bookmark: pgfId-55068]Navigation Path

 
      
      		 [bookmark: pgfId-55070](Device view) Select  Platform > Security > Blocking from the Policy selector. If necessary, select the  General tab.

 
      		 [bookmark: pgfId-55072](Policy view) Select  IPS > Platform > Security > Blocking , then select an existing policy or create a new one. If necessary, select the  General tab.

 
     

 
     [bookmark: pgfId-55074]Related Topic

 
      
      		 [bookmark: pgfId-55079]Understanding IPS Blocking

 
      		 [bookmark: pgfId-55084]Configuring IPS Blocking and Rate Limiting

 
      		 [bookmark: pgfId-55089]Blocking Page

 
     

 
     [bookmark: pgfId-55091]Field Reference

 
     [bookmark: pgfId-55094] 

 
      
       
        
        [bookmark: pgfId-53501]Table 43-2 [bookmark: 103942]General Tab, IPS Blocking Policy 

 
        
       
         
         		
           
           [bookmark: pgfId-53507]Element
          
  
         		
           
           [bookmark: pgfId-53509]Description
          
  
        

 
         
         		[bookmark: pgfId-53515]Log All Block Events and Errors

  
         		[bookmark: pgfId-53517]Whether to log events that follow blocks from start to finish and any error messages that occur. When a block is added to or removed from a device, an event is logged. You may not want all these events and errors to be logged. Disabling this option suppresses new events and errors. The default is enabled.

 [bookmark: pgfId-53519]Note Log all block events and errors also applies to rate limiting.

  
        

 
         
         		[bookmark: pgfId-53525]Enable NVRAM Write

  
         		[bookmark: pgfId-53527]Whether to have the router write to non-volatile RAM (NVRAM) when Attack Response Controller (ARC) first connects. If enabled, NVRAM is written each time the ACLs are updated. The default is disabled.

 [bookmark: pgfId-53529]Enabling NVRAM writing ensures that all changes for blocking and rate limiting are written to NVRAM. If the router is rebooted, the correct blocks and rate limits will still be active. If NVRAM writing is disabled, a short time without blocking or rate limiting occurs after a router reboot. Not enabling NVRAM writing increases the life of the NVRAM and decreases the time for new blocks and rate limits to be configured.

  
        

 
         
         		[bookmark: pgfId-53535]Enable ACL Logging

  
         		[bookmark: pgfId-53537]Whether to have ARC append the log parameter to block entries in the access control list (ACL) or VLAN ACL (VACL). This causes the device to generate syslog events when packets are filtered. This option applies to routers and switches only. The default is disabled.

  
        

 
         
         		[bookmark: pgfId-53543]Allow Sensor IP address to be Blocked

  
         		[bookmark: pgfId-53545]Whether the sensor IP address can be blocked. The default is disabled.

 [bookmark: pgfId-53547]Tip If you allow the sensor address to be blocked, the IPS does not add an explicit permit entry to the interface ACL to allow the IPS address. You must ensure that the IPS address is permitted by the device ACL or the IPS cannot implement blocking on the device.  
        

 
         
         		[bookmark: pgfId-53553]Enable Blocking

  
         		[bookmark: pgfId-53555]Whether to enable the blocking and rate limiting of hosts. The default is enabled.

 [bookmark: pgfId-53557]Note When you enable blocking, you also enable rate limiting. When you disable blocking, you also disable rate limiting. This means that ARC cannot add new or remove existing blocks or rate limits.

  
        

 
         
         		[bookmark: pgfId-53563]Max Blocks

  
         		[bookmark: pgfId-53565]The maximum number of entries to block. The range is 1 to 65535. The default is 250.

  
        

 
         
         		[bookmark: pgfId-53571]Max Interfaces

  
         		[bookmark: pgfId-53573]The maximum number of interfaces for performing blocks. For example, a PIX 500 series security appliance counts as one interface. A router with one interface counts as one, but a router with two interfaces counts as two. The maximum number of interfaces is 250 per device. The default is 250.

 [bookmark: pgfId-53575]You use Max Interfaces to set an upper limit on the number of devices and interfaces that ARC can manage. The total number of blocking devices (not including master blocking sensors) cannot exceed this value. The total number of blocking items also cannot exceed this value, where a blocking item is one security appliance context, one router blocking interface/direction, or one Catalyst Software switch blocking VLAN.

 [bookmark: pgfId-53577]Note In addition, the following maximum limits are fixed and you cannot change them: 100 interfaces per device, 250 security appliances, 250 routers, 250 Catalyst Software switches, and 100 master blocking sensors.

  
        

 
         
         		[bookmark: pgfId-53583]Max Rate Limits

  
         		[bookmark: pgfId-53585]The maximum number of rate limit entries. The maximum rate limit must be equal to or less than the maximum blocking entries. The range is 1 to 32767. The default value is 250.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-55110][bookmark: 103999][bookmark: ipspage_cncpt_UserProfileDialogBox]User Profile Dialog Box[bookmark: marker-55102][bookmark: marker-55104][bookmark: marker-55106][bookmark: marker-55108]

 
     [bookmark: pgfId-55112]Use the Add or Modify User Profile dialog box to add or modify a user profile for an IPS blocking device. The profile defines a username and passwords that the IPS device can use to log into and configure the router, switch, or firewall that will implement IPS blocking.

 
     [bookmark: pgfId-55114]Although you can save a profile that has a profile name only, the requirements for username, password, and enable password are determined by the device. You must specify the items required by the device to enter configuration mode, or the IPS cannot configure blocking on the device.

 
     [bookmark: pgfId-55116]Navigation Path

 
     [bookmark: pgfId-55121]From the IPS Blocking policy, select the User Profiles tab and click the Add Row button or select an existing sensor and click the Edit Row button. For information on opening the Blocking policy, see Blocking Page.

 
     [bookmark: pgfId-55123]Field Reference

 
     [bookmark: pgfId-55126] 

 
      
       
        
        [bookmark: pgfId-53598]Table 43-3 [bookmark: 104027]User Profile Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-53604]Element
          
  
         		
           
           [bookmark: pgfId-53606]Description
          
  
        

 
         
         		[bookmark: pgfId-53612]Profile Name

  
         		[bookmark: pgfId-53614]The name of the profile, up to 64 alphanumeric characters.

  
        

 
         
         		[bookmark: pgfId-53620]Username

  
         		[bookmark: pgfId-53622]The username to use when logging into the blocking device.

  
        

 
         
         		[bookmark: pgfId-53628]Password

  
         		[bookmark: pgfId-53630]The login password for the username, if required.

  
        

 
         
         		[bookmark: pgfId-53636]Enable Password

  
         		[bookmark: pgfId-53638]The enable password for entering Privileged EXEC Mode (enable mode), if required.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-55142][bookmark: 104058][bookmark: ipspage_cncpt_MasterBlockingSensorDialogBox]Master Blocking Sensor Dialog Box[bookmark: marker-55134][bookmark: marker-55136][bookmark: marker-55138][bookmark: marker-55140]

 
     [bookmark: pgfId-55147]Use the Add or Modify Master Blocking Sensor dialog box to configure a master blocking sensor. For more information about master blocking sensors, see Understanding the Master Blocking Sensor.

 
     [bookmark: pgfId-55149]Navigation Path

 
     [bookmark: pgfId-55154]From the IPS Blocking policy, select the Master Blocking Sensors tab and click the Add Row button or select an existing sensor and click the Edit Row button. For information on opening the Blocking policy, see Blocking Page.

 
     [bookmark: pgfId-55156]Field Reference

 
     [bookmark: pgfId-55159] 

 
      
       
        
        [bookmark: pgfId-53651]Table 43-4 [bookmark: 104086]Master Blocking Sensor Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-53657]Element
          
  
         		
           
           [bookmark: pgfId-53659]Description
          
  
        

 
         
         		[bookmark: pgfId-53665]IP Address

  
         		[bookmark: pgfId-53667]The IP address of the master blocking sensor. Enter the IP address or the name of a network/host policy object that contains a single host address, or click Select to select an object from a list or to create a new one.

  
        

 
         
         		[bookmark: pgfId-53673]Username

  
         		[bookmark: pgfId-53675]The username to use to log in to the master blocking sensor. The user account must be an active account configured on the master blocking sensor.

  
        

 
         
         		[bookmark: pgfId-53681]Password

  
         		[bookmark: pgfId-53683]The login password for the username.

  
        

 
         
         		[bookmark: pgfId-53689]Port

  
         		[bookmark: pgfId-53691]The port on which to connect on the master blocking sensor. The default is 443.

  
        

 
         
         		[bookmark: pgfId-53697]TLS

  
         		[bookmark: pgfId-53699]Whether to use TLS.

 [bookmark: pgfId-53701]If you select the TLS option, you must configure the ARC of the blocking forwarding sensor to accept the TLS/SSL X.509 certificate of the master blocking sensor remote host. (The blocking forwarding sensor is any device to which you are assigning this blocking policy.)

 [bookmark: pgfId-53703]The easiest way to configure the blocking forwarding sensor to accept the X.509 certificate is to use the IPS Device Manager (IDM) to log into the sensor, choose Configuration > Sensor Management > Certificates > Trusted Hosts > Add Trusted Host, and add the master blocking sensor as a trusted host. Alternatively, you can log into the sensor CLI, enter configuration mode, and use the tls trusted-host ip-address command.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-55183][bookmark: 104127][bookmark: ipspage_cncpt_RouterDeviceDialogBox]Router, Firewall, Cat6K Device Dialog Box[bookmark: marker-55171][bookmark: marker-55173][bookmark: marker-55175][bookmark: marker-55177][bookmark: marker-55179][bookmark: marker-55181]

 
     [bookmark: pgfId-55185]Use the Add or Modify Router, Firewall, or Cat6K Device dialog box to configure a device as a blocking device for an IPS sensor. The name of the dialog box indicates the type of device you are adding:

 
      
      		 [bookmark: pgfId-55190]Router—IOS Software routers and Catalyst 6500/7600 devices. These devices can do rate limiting as well as blocking. See Understanding Router and Switch Blocking Devices.

 
      		 [bookmark: pgfId-55192]Firewall—ASA and PIX appliances.

 
      		 [bookmark: pgfId-55194]Cat6K—Catalyst 6500/7600 devices that are running Catalyst OS software.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-55196]Tip If the Catalyst 6500/7600 runs Cisco IOS Software, add the device as a router on the Router tab. Do not add the device to the Cat6K tab.


     
      

     

     

 
     [bookmark: pgfId-55198]Navigation Path

 
     [bookmark: pgfId-55203]From the IPS Blocking policy, select the Router, Firewall, or Catalyst 6K tab and click the Add Row button or select an existing row and click the Edit Row button. For information on opening the Blocking policy, see Blocking Page.

 
     [bookmark: pgfId-55205]Field Reference

 
     [bookmark: pgfId-55208] 

 
      
       
        
        [bookmark: pgfId-53716]Table 43-5 [bookmark: 104169]Router, Firewall, Cat6K Device Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-53722]Element
          
  
         		
           
           [bookmark: pgfId-53724]Description
          
  
        

 
         
         		[bookmark: pgfId-53730]IP Address

  
         		[bookmark: pgfId-53732]The IP address of the device. Enter the IP address or the name of a network/host policy object that contains a single host address, or click Select to select an object from a list or to create a new one.

  
        

 
         
         		[bookmark: pgfId-53738]Communication Type

  
         		[bookmark: pgfId-53740]The communication mechanism used to log in to the blocking device (SSH 3DES, SSH DES, Telnet). The default is SSH 3DES.

 [bookmark: pgfId-53742]If you choose SSH 3DES or SSH DES, you must add the device to the known hosts list. The easiest way to add the device to the known hosts list is to use the IPS Device Manager (IDM) to log into the sensor, choose Configuration > Sensor Management > SSH > Known Host Keys > Add Known Host Key, and add the device address. Alternatively, you can log into the sensor CLI, enter configuration mode, and use the ssh host-key command.

  
        

 
         
         		[bookmark: pgfId-53748]NAT Address

  
         		[bookmark: pgfId-53750]The NAT address of the sensor, if any is used between the sensor and the blocking device. Enter the NAT address or the name of a network/host policy object that contains a single host address, or click Select to select an object from a list or to create a new one. Leave the default 0.0.0.0 if NAT is not used.

  
        

 
         
         		[bookmark: pgfId-53756]Profile Name

  
         		[bookmark: pgfId-53758]The login profile used to log in to the blocking device. You must create this profile on the User Profiles tab of the blocking policy or the IPS cannot successfully use this blocking device.

  
        

 
         
         		[bookmark: pgfId-53764]Interfaces and directions where blocks will be applied (table)

 [bookmark: pgfId-53766](Routers only.)

  
         		[bookmark: pgfId-53768]The interfaces on the device that should be used for blocking or rate limiting. The table shows the interface name, direction, and the names of existing ACLs that the IPS device should incorporate into the blocking ACL.

 [bookmark: pgfId-53770]If the interface already has an ACL configured for the specified direction, you must specify that ACL name as a pre- or post-ACL or the IPS removes the ACL. These ACLs are used for blocking only, not for rate limiting.

 
           
           		 [bookmark: pgfId-53775]To add an interface, click the  Add Row button and fill in the Add Router Block Interface dialog box (see Router Block Interface Dialog Box).

 
           		 [bookmark: pgfId-53777]To edit an interface, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-53779]To delete an interface, select it and click the  Delete Row button.

 
          

  
        

 
         
         		[bookmark: pgfId-53785]Response Capabilities

 [bookmark: pgfId-53787](Routers only.)

  
         		[bookmark: pgfId-53789]The actions that this router can implement. Use Ctrl+click to select multiple actions (highlighted actions are selected). Options are:

 
           
           		 [bookmark: pgfId-53791] Block —The router can implement blocks in response to Request Block Connection and Request Block Host actions.

 
           		 [bookmark: pgfId-53793] Rate Limit —The router can implement rate limits in response to Request Rate Limit actions.

 
          

  
        

 
         
         		[bookmark: pgfId-53799]VLANs where blocks will be applied (table)

 [bookmark: pgfId-53801](Catalyst 6500/7600 devices running the Catalyst operating system only.)

  
         		[bookmark: pgfId-53803]The VLANs on the device that should be used for blocking. The table shows the VLAN name and the names of existing VLAN ACLs (VACL) that the IPS device should incorporate into the blocking VACL.

 [bookmark: pgfId-53805]If the VLAN already has a VACL configured, you must specify that VACL name as a pre- or post-VACL or the IPS removes the VACL.

 
           
           		 [bookmark: pgfId-53810]To add a VLAN, click the  Add Row button and fill in the Add Cat6K Block VLAN dialog box (see Cat6k Block VLAN Dialog Box).

 
           		 [bookmark: pgfId-53812]To edit a VLAN, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-53814]To delete a VLAN, select it and click the  Delete Row button.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-55224][bookmark: 104253][bookmark: ipspage_cncpt_RouterBlockInterfaceDialogBox]Router Block Interface Dialog Box[bookmark: marker-55216][bookmark: marker-55218][bookmark: marker-55220][bookmark: marker-55222]

 
     [bookmark: pgfId-55226]Use the Add or Modify Router Block Interface dialog box to configure a blocking interface on a router or IOS Software Catalyst 6500/7600 device that is configured as an IPS blocking device. The IPS sensor uses the interface for blocking actions.

 
     [bookmark: pgfId-55228]Navigation Path

 
     [bookmark: pgfId-55233]From the Add or Modify Router Device dialog box, click the Add Row button beneath the interfaces table, or select a row in the table and click the Edit Row button. For information on opening the Router Device dialog box, see Router, Firewall, Cat6K Device Dialog Box.

 
     [bookmark: pgfId-55235]Field Reference

 
     [bookmark: pgfId-55238] 

 
      
       
        
        [bookmark: pgfId-53827]Table 43-6 [bookmark: 104280]Router Block Interface Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-53833]Element
          
  
         		
           
           [bookmark: pgfId-53835]Description
          
  
        

 
         
         		[bookmark: pgfId-53841]Interface Name

  
         		[bookmark: pgfId-53843]The name of the interface on the router that the IPS should use for blocking. Enter the name exactly as it is configured on the router (for example, GigabitEthernet0/1).

  
        

 
         
         		[bookmark: pgfId-53849]Direction

  
         		[bookmark: pgfId-53851]The direction to apply the blocking ACL, In or Out.

  
        

 
         
         		[bookmark: pgfId-53857]Pre ACL Name

 [bookmark: pgfId-53859]Post ACL Name

  
         		[bookmark: pgfId-53864]The ACLs to combine with the blocking entries that the IPS creates to implement blocking actions. The Pre ACL is added before the blocking ACL, and the Post ACL is added after the blocking ACL. For more information, see Understanding Router and Switch Blocking Devices.

 [bookmark: pgfId-53866]Tip If you have configured an ACL on the interface in the specified direction, you must specify the name of the ACL in the Pre or Post ACL Name field or the ACL will be removed from the interface. When you identify an interface and direction as a blocking interface, the IPS takes control of the ACL on that interface/direction. [bookmark: pgfId-53868]If you are managing the blocking device in Security Manager, you can identify the ACL name by selecting the blocking device, then selecting Tools > Preview Config. Look for the ip access-group command in the interface configuration, and check the direction. For example, the following lines show that there is an ACL named CSM_FW_ACL_GigabitEthernet0/1 in the In direction attached to the GigabitEthernet0/1 interface.

 
           
           [bookmark: pgfId-53870]interface GigabitEthernet0/1
          
 
           
           [bookmark: pgfId-53872] ip access-group CSM_FW_ACL_GigabitEthernet0/1 in
          
 
           
           [bookmark: pgfId-53874] 
          
 [bookmark: pgfId-53876]In this example, if you configure GigabitEthernet0/1 in the In direction as a blocking interface, ensure that you specify CSM_FW_ACL_GigabitEthernet0/1 as a pre- or post-ACL. In most cases, you should specify the ACL as the post-ACL, so that the relatively short IPS blocking ACL first filters out undesirable traffic before the blocking device implements your other access rules.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-55254][bookmark: 104317][bookmark: ipspage_cncpt_CatkBlockVlanDialogBox]Cat6k Block VLAN Dialog Box[bookmark: marker-55246][bookmark: marker-55248][bookmark: marker-55250][bookmark: marker-55252]

 
     [bookmark: pgfId-55256]Use the Add or Modify Cat6k Block VLAN dialog box to configure a blocking VLAN on a Catalyst 6500/7600 device that runs the Catalyst operating system and that is configured as an IPS blocking device. The IPS sensor uses the VLAN for blocking actions.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-55258]Tip If the Catalyst 6500/7600 runs Cisco IOS Software, add the device as a router, not a Cat6K.


     
      

     

     

 
     [bookmark: pgfId-55260]Navigation Path

 
     [bookmark: pgfId-55265]From the Add or Modify Cat6K Device dialog box, click the Add Row button beneath the VLANs table, or select a row in the table and click the Edit Row button. For information on opening the Cat6K Device dialog box, see Router, Firewall, Cat6K Device Dialog Box.

 
     [bookmark: pgfId-55267]Field Reference

 
     [bookmark: pgfId-55270] 

 
      
       
        
        [bookmark: pgfId-53889]Table 43-7 [bookmark: 104345]Cat6k Block VLAN Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-53895]Element
          
  
         		
           
           [bookmark: pgfId-53897]Description
          
  
        

 
         
         		[bookmark: pgfId-53903]VLAN

  
         		[bookmark: pgfId-53905]The number of the VLAN on the Catalyst 6500/7600 device that the IPS should use for blocking. The number can be 1 to 4094 and must be defined on the device.

  
        

 
         
         		[bookmark: pgfId-53911]Pre VACL Name

 [bookmark: pgfId-53913]Post VACL Name

  
         		[bookmark: pgfId-53918]The VLAN ACLs to combine with the blocking entries that the IPS creates to implement blocking actions. The Pre VACL is added before the blocking VACL, and the Post VACL is added after the blocking VACL. For more information, see Understanding Router and Switch Blocking Devices.

 [bookmark: pgfId-53920]Tip If you have configured a VACL on the VLAN, you must specify the name of the VACL in the Pre or Post VACL Name field or the VACL will be removed from the VLAN. When you identify a VLAN as a blocking interface, the IPS takes control of the VACL on that VLAN. Typically, you would specify the VACL name as the post-VACL.  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-55290][bookmark: 104370][bookmark: ipspage_cncpt_NeverBlockHostDialogBox]Never Block Host or Network Dialog Boxes[bookmark: marker-55280][bookmark: marker-55282][bookmark: marker-55284][bookmark: marker-55286][bookmark: marker-55288]

 
     [bookmark: pgfId-55292]Use the Add or Modify Never Block Host or Network dialog boxes to specify a host or network that should never be subject to blocking. The name of the dialog box indicates whether you are adding a host or network address.

 
     [bookmark: pgfId-55294]Enter the IP address or the name of a network/host policy object that specifies the address. You can also click Select to select an object from a list or to create a new object. When selecting objects, the object can contain a single entry of the appropriate type. Host addresses do not have subnet masks (for example, 10.100.10.1), whereas network addresses have masks (for example, 10.100.10.0/24).

 
     [bookmark: pgfId-55296]Navigation Path

 
     [bookmark: pgfId-55301]From the IPS Blocking policy, select the Never Block Hosts or Networks tab and click the Add Row button or select an existing row and click the Edit Row button. Hosts and networks are listed in separate tables, so ensure that you click the buttons associated with the desired table. For information on opening the Blocking policy, see Blocking Page.
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     [bookmark: pgfId-536592][bookmark: 92787][bookmark: tpchap_cncpt_UsingMapView]Using Map View[bookmark: marker-536586][bookmark: marker-536588][bookmark: marker-536590]
      
      
 
     
 

 
    [bookmark: pgfId-536594]The following topics describe how to use the Map view:

 
     
     		 [bookmark: pgfId-536599]Understanding Maps and Map View

 
     		 [bookmark: pgfId-536604]Working With Maps

 
     		 [bookmark: pgfId-536609]Displaying Your Network on the Map

 
     		 [bookmark: pgfId-536614]Managing VPNs in Map View

 
     		 [bookmark: pgfId-536619]Managing Device Policies in Map View

 
    

 
   
 
    
     [bookmark: pgfId-536627][bookmark: 92816][bookmark: tpchap_cncpt_UnderstandingMaps]Understanding Maps and Map View[bookmark: marker-536625]

 
    [bookmark: pgfId-536629]The Security Manager Map view provides a graphical view of your VPN and Layer 3 network topology.

 
    [bookmark: pgfId-536631]Using the map view, you can investigate details of your VPN configuration graphically. Topological display of tunnels enables you to easily derive the relationship among multiple VPN configurations (for example, a hierarchical VPN). You can group devices to achieve a more complete picture of your VPN configuration. This is useful in situations where a hub failover pair is a peer with hundreds of spokes.

 
    [bookmark: pgfId-536633]You can represent your Layer 3 network topology graphically, populating it with managed devices (called device nodes). You can make the picture of the topology more complete by adding unmanaged objects (called map objects) such as devices, clouds, and networks. For large networks, you can choose to simplify the topology graph by incorporating only a portion of the overall topology. You can save the topology maps for future use.

 
    [bookmark: pgfId-536638]You can save multiple topology maps to reflect your network’s geographical or functional organization. You can link a saved map to a node on a parent map, so that from the parent map you can drill down to the linked map with more detailed information (for more information, see Using Linked Maps). Saved maps are shared among all users who have the necessary access privileges.

 
    [bookmark: pgfId-536640]You can launch other Security Manager features from the map view. In some cases, you can simplify the use of features by selecting nodes from the map before you start another feature. For example, you can select multiple nodes, then create a VPN that includes those nodes as members.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-536644]Tip The network data that is displayed on maps is typically updated as this data changes. However, to be certain that a map displays current network data, you can refresh it manually by selecting Map > Refresh Map.[bookmark: marker-536642]


    
     

    

    

 
    [bookmark: pgfId-536646]This section contains the following topics:

 
     
     		 [bookmark: pgfId-536651]Understanding the Map View Main Page

 
     		 [bookmark: pgfId-536656]Map Toolbar

 
     		 [bookmark: pgfId-536661]Using the Navigation Window

 
     		 [bookmark: pgfId-536666]Maps Context Menus

 
     		 [bookmark: pgfId-536671]Access Permissions for Maps

 
    

 
     
      [bookmark: pgfId-536681][bookmark: 92832][bookmark: tppage_cncpt_MapViewMainPage]Understanding the Map View Main Page[bookmark: marker-536679]

 
     [bookmark: pgfId-536683]Map view enables you to create customized, visual topology maps of your network, within which you can view connections between your devices and easily configure VPNs and access control settings. The following figure identifies the functional areas of the Map view.

 
     [bookmark: pgfId-536685]To open the Map view main page, click the Map View button in the toolbar.

 
     [bookmark: pgfId-536691]You can undock the map window, which enables you to use other product features while keeping the map open. To undock the map, select Map > Undock Map View. To dock the map window, select Map > Dock Map View.[bookmark: marker-536687][bookmark: marker-536689]

 
     [bookmark: pgfId-536695]Figure 35-1 [bookmark: 92850]Map View Main Page

 
     [bookmark: pgfId-536699] 

 
      
      [image: ] 
     
 
      
       
       
         
         		
           
           [bookmark: pgfId-534753]1
          
  
         		[bookmark: pgfId-534755]Title bar

  
         		
           
           [bookmark: pgfId-534757]2
          
  
         		[bookmark: pgfId-534762]Navigation window (see Using the Navigation Window)

  
        

 
         
         		
           
           [bookmark: pgfId-534772]3
          
  
         		[bookmark: pgfId-534777]Menu bar (see Map Menu (Configuration Manager))

  
         		
           
           [bookmark: pgfId-534779]4
          
  
         		[bookmark: pgfId-534784]Toolbar (see Toolbar Reference (Configuration Manager))

  
        

 
         
         		
           
           [bookmark: pgfId-534794]5
          
  
         		[bookmark: pgfId-534799]Map toolbar (see Map Toolbar)

  
         		
           
           [bookmark: pgfId-534801]6
          
  
         		[bookmark: pgfId-534806]Map (see Understanding Map Elements)

  
        

 
       
      

 
     
 
     [bookmark: pgfId-536701]Related Topics

 
      
      		 [bookmark: pgfId-536706]Understanding Maps and Map View

 
      		 [bookmark: pgfId-536711]Working With Maps

 
      		 [bookmark: pgfId-536716]Displaying Your Network on the Map

 
      		 [bookmark: pgfId-536721]Managing VPNs in Map View

 
      		 [bookmark: pgfId-536726]Managing Device Policies in Map View

 
     

 
    
 
     
      [bookmark: pgfId-536736][bookmark: 92916][bookmark: tppage_cncpt_MapToolbar]Map Toolbar[bookmark: marker-536732][bookmark: marker-536734]

 
     [bookmark: pgfId-536738]The following table describes the buttons on the map toolbar.

 
     [bookmark: pgfId-536741] 

 
      
      


      


      


      


      


      


      


      


      


      


      


      


      


       
        
        [bookmark: pgfId-534819]Table 35-1 [bookmark: 92926]Map Toolbar 

 
        
       
         
         		
           
           [bookmark: pgfId-534825]Toolbar Button
          
  
         		
           
           [bookmark: pgfId-534827]Description
          
  
        

 
        
             
         		[bookmark: pgfId-534836]Selects objects on the map. Click the button, then click items on the map.

  
        

 
        
             
         		[bookmark: pgfId-534845]Pans the map. Click the button, click and hold on the map, then drag the cursor.

  
        

 
        
             
         		[bookmark: pgfId-534854]Zooms in on the map.

  
        

 
        
             
         		[bookmark: pgfId-534863]Zooms out from the map.

  
        

 
        
             
         		[bookmark: pgfId-534872]Zooms the map to fill a rectangle that you draw.

  
        

 
        
             
         		[bookmark: pgfId-534881]Zooms the map to include the entire map.

  
        

 
        
             
         		[bookmark: pgfId-534890]Zooms the map to actual size.

  
        

 
        
             
         		[bookmark: pgfId-534899]Creates a new Security Manager-managed node. After you create the new device in the inventory, it is added to the active map as a device node.

  
        

 
        
             
         		[bookmark: pgfId-534908]Adds a new map object to the map.

  
        

 
        
             
         		[bookmark: pgfId-534917]Adds a new link to the map.

  
        

 
        
             
         		[bookmark: pgfId-534926]Creates a new VPN connection between nodes on the map.

  
        

 
        
             
         		[bookmark: pgfId-534935]Select devices to show on the map as device nodes.

  
        

 
        
             
         		[bookmark: pgfId-534944]Select VPNs to show on the map.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-536751][bookmark: 93015][bookmark: tpchap_cncpt_UsingtheNavigationWindow]Using the Navigation Window[bookmark: marker-536747][bookmark: marker-536749]

 
     [bookmark: pgfId-536753]The navigation window displays a smaller version of the entire active map. The shaded rectangle defines the area of the map that is currently displayed.

 
     [bookmark: pgfId-536755]Use the navigation window to select the portion of the map to view and to change the map zoom level.

 
      
      		 [bookmark: pgfId-536757]To toggle the display of the navigation window, select  Map > Show/Hide Navigation Window .

 
      		 [bookmark: pgfId-536759]To pan the navigation control to select which portion of the map to display, click within the shaded rectangle and drag it to a new location.

 
      		 [bookmark: pgfId-536761]To change the zoom level, click one of the resizing handles in the corners of the shaded rectangle, then drag it to increase or decrease the area of the map to display. The map zooms to display the area covered by the map indicator.

 
     

 
     [bookmark: pgfId-536763]The title bar in the navigation window displays the name of the map. If the map has unsaved changes, an asterisk (*) appears next to the map name.

 
     [bookmark: pgfId-536768]For information on other ways to pan and zoom maps, see Panning, Centering, and Zooming Maps.

 
    
 
     
      [bookmark: pgfId-536776][bookmark: 93037][bookmark: tppage_cncpt_MapsMenus]Maps Context Menus[bookmark: marker-536774]

 
     [bookmark: pgfId-536778]The following topics describe the menus that contain maps commands. To open the context menus, right-click map elements.

 
      
      		 [bookmark: pgfId-536783]Managed Device Node Context Menu

 
      		 [bookmark: pgfId-536788]Multiple Selected Nodes Context Menu

 
      		 [bookmark: pgfId-536793]VPN Connection Context Menu

 
      		 [bookmark: pgfId-536798]Layer 3 Link Context Menu

 
      		 [bookmark: pgfId-536803]Map Object Context Menu

 
      		 [bookmark: pgfId-536808]Map Background Context Menu

 
     

 
    
 
     
      [bookmark: pgfId-536816][bookmark: 93062][bookmark: tppage_cncpt_ManagedDeviceNodeContextMenu]Managed Device Node Context Menu[bookmark: marker-536814]

 
     [bookmark: pgfId-536818]The Managed Device Node context menu opens when you right-click a map node that represents a managed device. The commands that you see depend on the type of device you select. The following table lists all commands that you might see.

 
     [bookmark: pgfId-536821] 

 
      
       
        
        [bookmark: pgfId-534957]Table 35-2 [bookmark: 93070]Managed Device Node Context Menu 

 
        
       
         
         		
           
           [bookmark: pgfId-534963]Menu Command
          
  
         		
           
           [bookmark: pgfId-534965]Description
          
  
        

 
         
         		[bookmark: pgfId-534971]Edit Firewall Policies

  
         		[bookmark: pgfId-534973]Edits firewall policies on the device.

 [bookmark: pgfId-534975]Select a firewall policy type from the submenu to edit it.

  
        

 
         
         		[bookmark: pgfId-534981]Edit Firewall Settings

  
         		[bookmark: pgfId-534983]Edits firewall settings on the device.

 [bookmark: pgfId-534985]Select a setting from the submenu to edit it.

  
        

 
         
         		[bookmark: pgfId-534991]Edit VPN Peers

  
         		[bookmark: pgfId-534993]Edits peers in VPNs in which the device participates.

  
        

 
         
         		[bookmark: pgfId-534999]Edit VPN Policies

  
         		[bookmark: pgfId-535001]Edits VPN policies on the device.

  
        

 
         
         		[bookmark: pgfId-535007]Device Properties

  
         		[bookmark: pgfId-535009]Displays device properties.

  
        

 
         
         		[bookmark: pgfId-535015]Clone Device

  
         		[bookmark: pgfId-535020]Creates a copy of the device. See Cloning a Device.

  
        

 
         
         		[bookmark: pgfId-535026]Copy Policies Between Devices

  
         		[bookmark: pgfId-535031]Copies policies between the device and other devices. See Copying Policies Between Devices.

  
        

 
         
         		[bookmark: pgfId-535037]Share Device Policies

  
         		[bookmark: pgfId-535039]Shares device local policies.

  
        

 
         
         		[bookmark: pgfId-535045]Catalyst Summary Info

  
         		[bookmark: pgfId-535050]Allows you to view high-level system information, including any service modules, ports, and VLANs that Security Manager has discovered. See Viewing Catalyst Summary Information.

  
        

 
         
         		[bookmark: pgfId-535056]Show in Device View

  
         		[bookmark: pgfId-535058]Opens the Device View for the selected device.

  
        

 
         
         		[bookmark: pgfId-535064]Device Manager

  
         		[bookmark: pgfId-535069]Launches the Device Manager. See Starting Device Managers.

  
        

 
         
         		[bookmark: pgfId-535075]Inventory Status

  
         		[bookmark: pgfId-535080]Displays the Inventory Status window for the device. See Inventory Status Window.

  
        

 
         
         		[bookmark: pgfId-535086]Show VPN Peers

  
         		[bookmark: pgfId-535088]Shows peers in VPNs in which the device participates.

  
        

 
         
         		[bookmark: pgfId-535094]Preview Configuration

  
         		[bookmark: pgfId-535096]Previews the device configuration with all committed changes included.

  
        

 
         
         		[bookmark: pgfId-535102]Show Containment

  
         		[bookmark: pgfId-535104]Shows the security contexts and service modules in devices that have them.

  
        

 
         
         		[bookmark: pgfId-535110]Node Properties

  
         		[bookmark: pgfId-535112]Displays node properties.

  
        

 
         
         		[bookmark: pgfId-535118]Set Linked Map

  
         		[bookmark: pgfId-535120]Creates a link from this node to another map.

  
        

 
         
         		[bookmark: pgfId-535126]Open Linked Map

  
         		[bookmark: pgfId-535128]Opens the map that is linked to the node.

  
        

 
         
         		[bookmark: pgfId-535134]Discover Policies on Device

  
         		[bookmark: pgfId-535136]Discovers policies on the device.

  
        

 
         
         		[bookmark: pgfId-535142]Move To Center

  
         		[bookmark: pgfId-535144]Pans the map to display the node in the center.

  
        

 
         
         		[bookmark: pgfId-535150]Delete Device

  
         		[bookmark: pgfId-535152]Deletes the device from the device inventory.

  
        

 
         
         		[bookmark: pgfId-535158]Remove from Map

  
         		[bookmark: pgfId-535160]Removes the node from the map.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-536829][bookmark: 93198][bookmark: tppage_cncpt_MultipleSelectedNodesContextMenu]Multiple Selected Nodes Context Menu[bookmark: marker-536827]

 
     [bookmark: pgfId-536831]The Multiple Selected Device Node context menu opens when you select more than one map node, then right-click on a selected node.

 
     [bookmark: pgfId-536833]If all of the selected nodes are not VPN-capable, the commands to configure VPNs do not appear.

 
     [bookmark: pgfId-536836] 

 
      
       
        
        [bookmark: pgfId-535173]Table 35-3 [bookmark: 93207]Multiple Selected Nodes Context Menu 

 
        
       
         
         		
           
           [bookmark: pgfId-535179]Menu Command
          
  
         		
           
           [bookmark: pgfId-535181]Description
          
  
        

 
         
         		[bookmark: pgfId-535187]Create Point to Point VPN

  
         		[bookmark: pgfId-535189]Creates a point to point VPN between two selected devices.

 [bookmark: pgfId-535191]All selected nodes must be managed and VPN-capable.

  
        

 
         
         		[bookmark: pgfId-535197]Create Hub and Spoke VPN

  
         		[bookmark: pgfId-535199]Creates a hub and spoke VPN that includes the selected nodes.

 [bookmark: pgfId-535201]The node that you right-click becomes the VPN hub. All selected nodes must be managed and VPN-capable.

  
        

 
         
         		[bookmark: pgfId-535207]Create Meshed VPN

  
         		[bookmark: pgfId-535209]Creates a full mesh VPN that includes the selected nodes.

 [bookmark: pgfId-535211]All selected nodes must be managed and VPN-capable.

  
        

 
         
         		[bookmark: pgfId-535217]Remove Selected Nodes

  
         		[bookmark: pgfId-535219]Removes all selected device nodes. Appears only if you right-click on a selected device node.

  
        

 
         
         		[bookmark: pgfId-535225]Delete Map Objects

  
         		[bookmark: pgfId-535227]Deletes all selected map objects. Appears only if you right-click on a selected map object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-536844][bookmark: 93246][bookmark: tppage_cncpt_VPNConnectionContextMenu]VPN Connection Context Menu[bookmark: marker-536842]

 
     [bookmark: pgfId-536849]The VPN Connection context menu opens when you right-click on a VPN connection on the map. For more information, see Editing VPN Policies or Peers From the Map.

 
     [bookmark: pgfId-536852] 

 
      
       
        
        [bookmark: pgfId-535240]Table 35-4 [bookmark: 93255]VPN Connection Context Menu 

 
        
       
         
         		
           
           [bookmark: pgfId-535246]Menu Command
          
  
         		
           
           [bookmark: pgfId-535248]Description
          
  
        

 
         
         		[bookmark: pgfId-535254]Edit VPN Peers

  
         		[bookmark: pgfId-535256]Edits the peers in the VPN.

  
        

 
         
         		[bookmark: pgfId-535262]Edit VPN Policies

  
         		[bookmark: pgfId-535264]Edits the VPN policies.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-536860][bookmark: 93276][bookmark: tppage_cncpt_LayerLinkContextMenu]Layer 3 Link Context Menu[bookmark: marker-536858]

 
     [bookmark: pgfId-536862]The Layer 3 Link context menu opens when you right-click on a layer 3 link on the map.

 
     [bookmark: pgfId-536865] 

 
      
       
        
        [bookmark: pgfId-535277]Table 35-5 [bookmark: 93284]Layer 3 Link Context Menu 

 
        
       
         
         		
           
           [bookmark: pgfId-535283]Menu Command
          
  
         		
           
           [bookmark: pgfId-535285]Description
          
  
        

 
         
         		[bookmark: pgfId-535291]Link Properties

  
         		[bookmark: pgfId-535293]Displays the link properties.

  
        

 
         
         		[bookmark: pgfId-535299]Delete Link

  
         		[bookmark: pgfId-535301]Deletes the link from the map.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-536873][bookmark: 93305][bookmark: tppage_cncpt_MapObjectContextMenu]Map Object Context Menu[bookmark: marker-536871]

 
     [bookmark: pgfId-536875]The Map Object context menu opens when you right-click a map object that does not represent a managed device.

 
     [bookmark: pgfId-536878] 

 
      
       
        
        [bookmark: pgfId-535314]Table 35-6 [bookmark: 93313]Map Object Context Menu 

 
        
       
         
         		
           
           [bookmark: pgfId-535320]Menu Command
          
  
         		
           
           [bookmark: pgfId-535322]Description
          
  
        

 
         
         		[bookmark: pgfId-535328]Node Properties

  
         		[bookmark: pgfId-535330]Displays the node properties.

  
        

 
         
         		[bookmark: pgfId-535336]Move To Center

  
         		[bookmark: pgfId-535338]Pans the map to display the node in the center.

  
        

 
         
         		[bookmark: pgfId-535344]Set Linked Map

  
         		[bookmark: pgfId-535346]Links the node to a map.

  
        

 
         
         		[bookmark: pgfId-535352]Open Linked Map

  
         		[bookmark: pgfId-535354]Opens the map to which the node is linked.

  
        

 
         
         		[bookmark: pgfId-535360]Delete Map Object

  
         		[bookmark: pgfId-535362]Deletes the map object.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-536886][bookmark: 93349][bookmark: tppage_cncpt_MapBackgroundContextMenu]Map Background Context Menu[bookmark: marker-536884]

 
     [bookmark: pgfId-536888]The Map Background context menu opens when you right-click in the background area of a map, that is, not on any object or link.

 
     [bookmark: pgfId-536891] 

 
      
       
        
        [bookmark: pgfId-535375]Table 35-7 [bookmark: 93357]Map Background Context Menu 

 
        
       
         
         		
           
           [bookmark: pgfId-535381]Menu Command
          
  
         		
           
           [bookmark: pgfId-535383]Description
          
  
        

 
         
         		[bookmark: pgfId-535389]Show Devices on Map

  
         		[bookmark: pgfId-535391]Selects the managed devices to show on the map.

  
        

 
         
         		[bookmark: pgfId-535397]Show VPNs on Map

  
         		[bookmark: pgfId-535399]Selects the VPNs to display on the map.

  
        

 
         
         		[bookmark: pgfId-535405]Add Map Object

  
         		[bookmark: pgfId-535407]Adds a map object to the map.

  
        

 
         
         		[bookmark: pgfId-535413]Add Link

  
         		[bookmark: pgfId-535415]Adds a Layer 3 link to the map.

  
        

 
         
         		[bookmark: pgfId-535421]New Device

  
         		[bookmark: pgfId-535423]Creates a new managed device and adds it to the map as a device node.

  
        

 
         
         		[bookmark: pgfId-535429]New VPN

  
         		[bookmark: pgfId-535431]Creates a new VPN and adds it to the map.

  
        

 
         
         		[bookmark: pgfId-535437]Find Map Node

  
         		[bookmark: pgfId-535439]Finds nodes on the map.

  
        

 
         
         		[bookmark: pgfId-535445]Open Map

  
         		[bookmark: pgfId-535447]Opens a saved map.

  
        

 
         
         		[bookmark: pgfId-535453]Save Map

  
         		[bookmark: pgfId-535455]Saves the open map.

  
        

 
         
         		[bookmark: pgfId-535461]Show/Hide Navigation Window

  
         		[bookmark: pgfId-535463]Toggles the display of the navigation window on the map.

  
        

 
         
         		[bookmark: pgfId-535469]Map Properties

  
         		[bookmark: pgfId-535471]Displays the properties of the map.

  
        

 
         
         		[bookmark: pgfId-535477]Hierarchical layout

  
         		[bookmark: pgfId-535479]Arranges the network nodes in a hierarchical layout.

  
        

 
         
         		[bookmark: pgfId-535485]Radial layout

  
         		[bookmark: pgfId-535487]Arranges the network nodes in a radial layout.

  
        

 
         
         		[bookmark: pgfId-535493]Circular layout

  
         		[bookmark: pgfId-535495]Arranges the network nodes in a circular layout.

  
        

 
         
         		[bookmark: pgfId-535501]Dock/Undock Map

  
         		[bookmark: pgfId-535503]Undocks the Map view.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-536901][bookmark: 93444][bookmark: tpchap_cncpt_AccessPermissionsforMaps]Access Permissions for Maps[bookmark: marker-536897][bookmark: marker-536899]

 
     [bookmark: pgfId-536903]Access to maps is controlled based on two systems of user privileges:

 
      
      		 [bookmark: pgfId-536905]Device privileges—You must have at least read privileges to all the devices in a map to open the map.

 
      		 [bookmark: pgfId-536907]Map privileges—Access to maps is based on your Security Manager user role. There are two levels of map access:

 
     

 
     [bookmark: pgfId-536909] – Read-only—You can open maps, but you cannot modify them. If you have this map privilege level, the features for modifying maps are not available.

 
     [bookmark: pgfId-536911] – Read-write—You can modify maps. All map modification features are available.

 
    
 
   
 
    
     [bookmark: pgfId-536919][bookmark: 93465][bookmark: tpchap_cncpt_WorkingWithMaps]Working With Maps[bookmark: marker-536917]

 
    [bookmark: pgfId-536921]A map is a representation of a portion of your network. You can create and save multiple maps to address your network management needs. To work with any map, you must be in Map view (select View > Map View).

 
    [bookmark: pgfId-536926]After you create and save a map, the map is available to all users on the system that have at least read privileges to all the devices on the map. Users that do not have read privileges to a device on a map do not see the map in the list of existing maps when they try to open a map. For more information, see Access Permissions for Maps.

 
    [bookmark: pgfId-536928]You can only have one map open at a time. If a map is open and you create a new map or open an existing map, you are prompted to save or discard any unsaved changes that you made to the current map.

 
    [bookmark: pgfId-536930]Multiple users can open and modify a map at the same time. When a user saves changes to a map, any other users who are using the map are notified and have the option to do one of the following:

 
     
     		 [bookmark: pgfId-536932]Update their map to the version saved by the other user, losing any changes they have made.

 
     		 [bookmark: pgfId-536934]Save their version of the map as a new map, preserving any changes they made.

 
    

 
    [bookmark: pgfId-536936]This section contains the following topics:

 
     
     		 [bookmark: pgfId-536941]Creating New or Default Maps

 
     		 [bookmark: pgfId-536946]Opening Maps

 
     		 [bookmark: pgfId-536951]Saving Maps

 
     		 [bookmark: pgfId-536956]Deleting Maps

 
     		 [bookmark: pgfId-536961]Exporting Maps

 
     		 [bookmark: pgfId-536966]Arranging Map Elements

 
     		 [bookmark: pgfId-536971]Panning, Centering, and Zooming Maps

 
     		 [bookmark: pgfId-536976]Selecting Map Elements

 
     		 [bookmark: pgfId-536981]Searching for Map Nodes

 
     		 [bookmark: pgfId-536986]Using Linked Maps

 
     		 [bookmark: pgfId-536991]Setting the Map Background Properties

 
    

 
     
      [bookmark: pgfId-537001][bookmark: 93481][bookmark: tpchap_proc_CreatingNeworDefaultMaps]Creating New or Default Maps[bookmark: marker-536997][bookmark: marker-536999]

 
     [bookmark: pgfId-537003]You have two options for creating a new map:

 
      
      		 [bookmark: pgfId-537008]Create an empty map—To create a new empty map, select  Map > New Map . You must already be in Map view (select  View > Map View ). If you currently have a map open with unsaved changes, you are asked if you want to save it. For information about adding elements to a map, see Displaying Your Network on the Map.

 
      		 [bookmark: pgfId-537010]Create a new map containing all managed devices and VPNs in the inventory—This is called the default map. Generating the default map is a good way to create a map. After generating the map, save it with a unique name to make it a standard map and modify it as desired.

 
     

 
     [bookmark: pgfId-537012]You can generate the default map whenever you want to, and it contains the inventory as it exists at the time you generate it. You cannot specifically save the default map as the default map; it is regenerated every time you select it.

 
     [bookmark: pgfId-537014]The following procedure explains how to create a new map using the default map.

 
     [bookmark: pgfId-537016]Tips

 
      
      		 [bookmark: pgfId-537018]If you refresh the map (select  Map > Refresh Map ), items that you added to the inventory after generating the default map are not added to the map. You must reopen the default map to see new devices.

 
     

 
     
 
     [bookmark: pgfId-537020]Step 1 In Map view, select Map > Open Map.

 
     [bookmark: pgfId-537022]Step 2 Select Default Map from the Available Maps list, then click OK.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-537027]Note If you have do not have sufficient access rights to all devices in the inventory, the default map that opens shows only the subset of devices for which you do have access rights. For more information, see Access Permissions for Maps.


     
      

     

     

 
     [bookmark: pgfId-537029]Step 3 To save the default map as a standard map, select Map > Save Map or Map > Save Map As, enter a name for the map and click OK.

 
     [bookmark: pgfId-537031]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-537043][bookmark: 93525][bookmark: tpchap_proc_OpeningMaps]Opening Maps[bookmark: marker-537039][bookmark: marker-537041]

 
     [bookmark: pgfId-537045]To open an existing map, select Map > Open Map, select the desired map from the list of available maps, and click OK. You must already be in Map view (select View > Map View). If you currently have a map open with unsaved changes, you are asked if you want to save it.

 
     [bookmark: pgfId-537050]The list of available maps includes a special map called the Default Map. This map contains all of the managed devices and VPNs in the inventory. You are essentially creating a new map each time you open it. For more information about the default map, see Creating New or Default Maps.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-537055]Tip You can open any map that you have created or the default map. You can also open any map that another user has created provided you have the requisite permission settings with regard to the devices shown on that map (see Access Permissions for Maps).


     
      

     

     

 
     [bookmark: pgfId-537057]Related Topics

 
      
      		 [bookmark: pgfId-537062]Working With Maps

 
      		 [bookmark: pgfId-537067]Understanding Map Elements

 
     

 
    
 
     
      [bookmark: pgfId-537083][bookmark: 93552][bookmark: tpchap_cncpt_SavingMaps]Saving Maps[bookmark: marker-537077][bookmark: marker-537079][bookmark: marker-537081]

 
     [bookmark: pgfId-537085]To save the active map, select Map > Save Map. Any changes that you made since you last saved it are saved. If you did not save the map previously, the Save Map As dialog box opens, enabling you to assign a name to the map and save it.

 
     [bookmark: pgfId-537087]To save a map under a new name, select Map > Save Map As. The map name can be as long as 256 characters, but cannot be the reserved names “Default Map” or “New Map.”

 
     [bookmark: pgfId-537089]If you close a map that contains unsaved changes, you are prompted to save the changes.

 
     [bookmark: pgfId-537091]If your Security Manager session closes automatically because of inactivity when a map is open with unsaved changes, the current version of the map is saved if it has a name. If you have not yet saved the map, the map is discarded. For example, if you generate the default map, or create a new map, and do not save it before your session times out, you cannot retrieve that map.

 
    
 
     
      [bookmark: pgfId-537103][bookmark: 93571][bookmark: tpchap_proc_DeletingMaps]Deleting Maps[bookmark: marker-537099][bookmark: marker-537101]

 
     [bookmark: pgfId-537105]If you no longer need a map, you can delete it (presuming that you have edit permission). Deleting a map does not delete any devices or VPNs shown on the map, nor does it delete or modify their configurations; only the map is deleted.

 
     [bookmark: pgfId-537107]When you delete a map, it is permanently deleted from the server. Other users cannot use the deleted map.

 
     [bookmark: pgfId-537109]To delete a map, select Map > Delete Map, select the map you want to delete from the available maps list and click OK. You are asked to confirm the deletion.

 
     [bookmark: pgfId-537111]You must already be in Map view (select View > Map View) to delete a map.

 
    
 
     
      [bookmark: pgfId-537119][bookmark: 93587][bookmark: tpchap_proc_ExportingMaps]Exporting Maps[bookmark: marker-537117]

 
     [bookmark: pgfId-537121]When viewing a map, you can export the map to a scalable vector graphics (SVG) image file for use outside of Security Manager.

 
     [bookmark: pgfId-537123]Related Topics

 
      
      		 [bookmark: pgfId-537128]Working With Maps

 
      		 [bookmark: pgfId-537133]Understanding Map Elements

 
     

 
     
 
     [bookmark: pgfId-537135]Step 1 Select Map > Export Map. The Export Topology Map to SVG dialog box opens.

 
     [bookmark: pgfId-537137]Step 2 Browse to the location in which to save the file.

 
     [bookmark: pgfId-537139]Step 3 Enter a filename in the File name field. The correct file extension will be added for you.

 
     [bookmark: pgfId-537141]Step 4 Click Save.

 
     [bookmark: pgfId-537143]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-537153][bookmark: 93616][bookmark: tpchap_cncpt_ArrangingMapElements]Arranging Map Elements[bookmark: marker-537149][bookmark: marker-537151]

 
     [bookmark: pgfId-537155]To move a map element, click and hold, then drag it to the desired position. Attached links move automatically, but the other end of the link remains where it is.

 
     [bookmark: pgfId-537157]You can also automatically arrange the network nodes on the map in several predefined layouts. Only nodes that are already displayed on the map are arranged. Any nodes that you later add do not follow the layout.

 
     [bookmark: pgfId-537159]To select a map layout, right-click the map background, then select one of the following layouts from the map context menu:

 
      
      		 [bookmark: pgfId-537161]Hierarchical Layout—Arranges the nodes in a hierarchical layout.

 
      		 [bookmark: pgfId-537163]Radial Layout—Arranges the nodes in a radial layout.

 
      		 [bookmark: pgfId-537165]Circular Layout—Arranges the nodes in a circular layout.

 
     

 
    
 
     
      [bookmark: pgfId-537175][bookmark: 93635][bookmark: tpchap_cncpt_PanningCenteringandZoomingMaps]Panning, Centering, and Zooming Maps[bookmark: marker-537171][bookmark: marker-537173]

 
     [bookmark: pgfId-537177]There are many options for navigating maps. You can pan the map (move around in the map without changing the zoom level), pan a map so that a particular map element is centered in your view, or zoom in or out to see a different map extent.

 
     [bookmark: pgfId-537179]To pan a map without changing the zoom level:

 
      
      		 [bookmark: pgfId-537181]Click the Pan Map toolbar button, then click and hold anywhere on the map and drag the cursor.

 
      		 [bookmark: pgfId-537183]Use the vertical and horizontal scroll bars that are available if the entire map does not fit in the visible page.

 
      		 [bookmark: pgfId-537185]Click and drag the shaded rectangle in the navigation window.

 
      		 [bookmark: pgfId-537189]To center the display of the map on a particular map element, right-click the element, then select  Move to Center .[bookmark: marker-537187]

 
     

 
     [bookmark: pgfId-537191]To zoom in or out of a map:

 
      
      		 [bookmark: pgfId-537193]To change the zoom level of the map in predefined increments:

 
     

 
     [bookmark: pgfId-537195] – To zoom in on the map, select Map > Zoom In, or click the Zoom In toolbar button.

 
     [bookmark: pgfId-537197] – To zoom out from the map, select Map > Zoom Out, or click the Zoom Out toolbar button.

 
      
      		 [bookmark: pgfId-537199]To zoom into a specific area of the map, click  Zoom Rectangle in the map toolbar, then click the map and drag a rectangle around the area. When you release the mouse button, the map zooms to display the area defined by the rectangle.

 
      		 [bookmark: pgfId-537201]Alternatively, to zoom in to or out of a specific area of the map, click and drag the corner of the shaded rectangle in the navigation window.

 
      		 [bookmark: pgfId-537203]To display the entire map, select  Map > Fit to Window .

 
      		 [bookmark: pgfId-537205]To display the map at actual size, select  Map > Display Actual Size .

 
     

 
     [bookmark: pgfId-537207]Related Topics

 
      
      		 [bookmark: pgfId-537212]Using the Navigation Window

 
     

 
    
 
     
      [bookmark: pgfId-537220][bookmark: 93691][bookmark: tpchap_cncpt_SelectingMapElements]Selecting Map Elements[bookmark: marker-537218]

 
     [bookmark: pgfId-537225]The following table describes how to select map elements. If the selected element contains other elements (for example, a Catalyst switch that contains an FWSM), the containment relationship is shown. For more information, see Showing Containment of Catalyst Switches, Firewalls, and Adaptive Security Appliances.

 
     [bookmark: pgfId-537228] 

 
      
       
        
        [bookmark: pgfId-535516]Table 35-8 [bookmark: 93699]Selecting Network Elements 

 
        
       
         
         		
           
           [bookmark: pgfId-535522]To select...
          
  
         		
           
           [bookmark: pgfId-535524]Do the following
          
  
        

 
         
         		[bookmark: pgfId-535530]A single map element

  
         		[bookmark: pgfId-535532]Click the element.

  
        

 
         
         		[bookmark: pgfId-535538]Multiple noncontiguous map elements

  
         		[bookmark: pgfId-535540]Ctrl+click each element.

  
        

 
         
         		[bookmark: pgfId-535546]Multiple contiguous map elements

  
         		[bookmark: pgfId-535548]Click the map and drag a rectangle that includes the elements.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-537240][bookmark: 93725][bookmark: tpchap_proc_SearchingforMapElements]Searching for Map Nodes[bookmark: marker-537236][bookmark: marker-537238]

 
     [bookmark: pgfId-537242]To search for a map node to help you find it in the active map, select Map > Find Map Node. This command opens the Find Node dialog box.

 
     [bookmark: pgfId-537244]The Find Node dialog box initially lists all objects on the map. Use the fields above the list to filter it (the list shows only objects that satisfy all filter criteria). When you find the desired node, select it in the list and click OK to have the node centered and selected in the map.

 
     [bookmark: pgfId-537246]To filter the list, you can:

 
      
      		 [bookmark: pgfId-537248]Select a node type from the  Type list to show only objects of that type.

 
      		 [bookmark: pgfId-537250]Enter the name, or at least the initial characters of the name, in the  Name field. The list is filtered as you type. Your search term must be from the start of the object name. You cannot use wildcard characters.

 
      		 [bookmark: pgfId-537252]Enter all or part of the IP address or subnet mask. The list is filtered as you enter information.

 
     

 
    
 
     
      [bookmark: pgfId-537264][bookmark: 93748][bookmark: tpchap_proc_UsingLinkedMaps]Using Linked Maps[bookmark: marker-537260][bookmark: marker-537262]

 
     [bookmark: pgfId-537266]A linked map is a map that you associate with a map element on another map. Because it is not practical to include all the nodes on a large network in a single map, you can use linked maps to create a hierarchical topology of your network.

 
     [bookmark: pgfId-537268]You cannot link a node to the another node in the same map.

 
     [bookmark: pgfId-537270]Before You Begin

 
     [bookmark: pgfId-537272]You must create the map to link to before you can link to it.

 
     
 
     [bookmark: pgfId-537274]Step 1 Right-click the map element to which to link a map, then select Set Linked Map. The Set Linked Map dialog box opens.

 
     [bookmark: pgfId-537276]Step 2 Select a map to associate with the selected map element, then click OK.

 
     [bookmark: pgfId-537278]Step 3 To open the linked map, right-click the linked node, then select Open Linked Map. The current map closes and the linked map opens.

 
     [bookmark: pgfId-537280]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-537300][bookmark: 93774][bookmark: tpchap_cncpt_SettingtheMapBackground]Setting the Map Background Properties [bookmark: marker-537290][bookmark: marker-537292][bookmark: marker-537294][bookmark: marker-537296][bookmark: marker-537298]

 
     [bookmark: pgfId-537302]You can change the background of a map by changing the color or by configuring an image. A suggested use for a background image is to use an image that represents a geographic area. Then you can position map elements according to their geographic locations.

 
     [bookmark: pgfId-537304]Some background images are included with Security Manager. You can also transfer images to the server to use as background images. You can use background images of the following file formats: JPEG, GIF, PNG, IVL, and SVG. If you want to use a new image, copy the image file to the Security Manager server file system by connecting directly to the server. For security reasons, Security Manager does not provide a method of transferring files to the server.

 
     [bookmark: pgfId-537306]To configure the map background, in Map view, select Map > Map Properties to open the Map Settings dialog box.

 
      
      		 [bookmark: pgfId-537308]To configure a background image, select it in the file list. (Select  none to remove the map’s background image.)

 
     

 
     [bookmark: pgfId-537314]If the image is not listed, click Add and browse to the file you placed on the server using the Import Background Image dialog box. Click OK to have Security Manager add it to the list of available background images.[bookmark: marker-537310][bookmark: marker-537312]

 
     [bookmark: pgfId-537320]If you no longer need a listed image, select it and click Delete.[bookmark: marker-537316][bookmark: marker-537318]

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-537326]Tip You can control the position and scale of the image using the X and Y coordinates and scale settings. The X,Y source point is the upper left corner of the image. You can use positive or negative numbers. You must experiment to get the results you desire. The scale setting is in percentage.[bookmark: marker-537322][bookmark: marker-537324]


     
      

     

     

 
      
      		 [bookmark: pgfId-537330]To change the background color, click  Select next to the background color field and choose the desired color.[bookmark: marker-537328]

 
     

 
    
 
   
 
    
     [bookmark: pgfId-537338][bookmark: 93835][bookmark: tpchap_cncpt_DisplayingYourNetworkontheMap]Displaying Your Network on the Map[bookmark: marker-537336]

 
    [bookmark: pgfId-537343]You use the map view to represent your network topology by creating maps. A map is a visual representation of your network, or a portion of it if it is too large to fit on a single map. Maps consist of map elements that represent devices, links, and other objects in your network. For more information about map, see Working With Maps.

 
    [bookmark: pgfId-537345]The following topics describe how to create maps:

 
     
     		 [bookmark: pgfId-537350]Understanding Map Elements

 
     		 [bookmark: pgfId-537355]Displaying Managed Devices on the Map

 
     		 [bookmark: pgfId-537360]Showing Containment of Catalyst Switches, Firewalls, and Adaptive Security Appliances

 
     		 [bookmark: pgfId-537365]Using Map Objects To Represent Network Topology

 
     		 [bookmark: pgfId-537370]Creating and Managing Layer 3 Links on the Map

 
    

 
     
      [bookmark: pgfId-537386][bookmark: 93859][bookmark: tpchap_cncpt_UnderstandingMapElements]Understanding Map Elements[bookmark: marker-537378][bookmark: marker-537380][bookmark: marker-537382][bookmark: marker-537384]

 
     [bookmark: pgfId-537394]All objects that can appear on a map are map elements. You display map elements on a map to create a representation of a portion of your network. For more information about maps, see Working With Maps. To open a map, see Opening Maps.

 
     [bookmark: pgfId-537396]The following tables describe the elements that can appear on a map:

 
      
      		 [bookmark: pgfId-537401]Table 35-9 describes the device nodes that can appear on a map. These elements are managed by Security Manager.

 
      		 [bookmark: pgfId-537406]Table 35-10 describes the map objects that can appear on a map. These elements are not managed by Security Manager.

 
      		 [bookmark: pgfId-537411]Table 35-11 describes the map element indicators that can appear with a device node.

 
     

 
     [bookmark: pgfId-537414] 

 
      
      


      


      


      


      


      


      


      


      


      


       
        
        [bookmark: pgfId-535563]Table 35-9 [bookmark: 93890]Device Node Types 

 
        
       
         
         		
           
           [bookmark: pgfId-535571]Node Type
          
  
         		
           
           [bookmark: pgfId-535573]Icon
          
  
         		
           
           [bookmark: pgfId-535575]Description
          
  
        

 
         
         		[bookmark: pgfId-535583]Firewall



     
         		[bookmark: pgfId-535588]When you select a device, its security contexts are highlighted.

  
        

 
         
         		[bookmark: pgfId-535596]Firewall security context

     
         		[bookmark: pgfId-535601]When you select a security context, the parent device is highlighted. The dotted outline distinguishes the icon as a security context.

  
        

 
         
         		[bookmark: pgfId-535609]Adaptive Security Appliance



     
         		[bookmark: pgfId-535614]When you select a device, its security contexts are highlighted.

  
        

 
         
         		[bookmark: pgfId-535622]Adaptive Security Appliance security context

     
         		[bookmark: pgfId-535627]When you select a security context, the parent device is highlighted. The dotted outline distinguishes the icon as a security context.

  
        

 
         
         		[bookmark: pgfId-535635]Router



     
         		[bookmark: pgfId-535640]Router or VPN concentrator.

  
        

 
         
         		[bookmark: pgfId-535648]Catalyst 6500/7600 or Catalyst switch

     
         		[bookmark: pgfId-535653]When you select a Catalyst device node, any Firewall Service Modules contained in it are highlighted.

  
        

 
         
         		[bookmark: pgfId-535661]Firewall Services Module (FWSM)

     
         		[bookmark: pgfId-535666]When you select a Firewall Services Module, the security contexts it contains are highlighted on the map.

  
        

 
         
         		[bookmark: pgfId-535674]FWSM security context

     
         		[bookmark: pgfId-535679]When you select a security context, the parent device is highlighted. The dotted outline distinguishes the icon as a security context.

  
        

 
         
         		[bookmark: pgfId-535687]IPS Sensor or Security Service Module

     
         		[bookmark: pgfId-535692]An IPS sensor.

  
        

 
         
         		[bookmark: pgfId-535700]VPN connection

     
         		[bookmark: pgfId-535705]Any type of VPN connection.

 [bookmark: pgfId-535707]For GET VPNs, a dashed line indicates the connection between group members and key servers.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-537417] 

 
      
      


      


      


      


      


       
        
        [bookmark: pgfId-535722]Table 35-10 [bookmark: 93985]Map Object Types 

 
        
       
         
         		
           
           [bookmark: pgfId-535730]Node Type
          
  
         		
           
           [bookmark: pgfId-535732]Icon
          
  
         		
           
           [bookmark: pgfId-535734]Description
          
  
        

 
         
         		[bookmark: pgfId-535742]Unmanaged firewall

 [bookmark: pgfId-1051606] 

     
         		[bookmark: pgfId-535747]Unmanaged firewall device.

  
        

 
         
         		[bookmark: pgfId-535755]Unmanaged router

 [bookmark: pgfId-1051613] 

     
         		[bookmark: pgfId-535760]Unmanaged router.

  
        

 
         
         		[bookmark: pgfId-535768]Network

 [bookmark: pgfId-1051620] 

     
         		[bookmark: pgfId-535773]Network with a specified address space.

  
        

 
         
         		[bookmark: pgfId-535781]Host

     
         		[bookmark: pgfId-535786]Network host.

 [bookmark: pgfId-535788]Examples: CSA, Syslog Server, CA Server, AAA Host

  
        

 
         
         		[bookmark: pgfId-535796]Cloud



     
         		[bookmark: pgfId-535801]An unspecified group of map objects that provides connectivity between specified nodes.

  
        

 
         
         		[bookmark: pgfId-535809]Layer 3 link

  
         		[bookmark: pgfId-535811]—

  
         		[bookmark: pgfId-535813]Layer 3 network connection

  
        

 
       
      

 
     
 
     [bookmark: pgfId-537420] 

 
      
      


       
        
        [bookmark: pgfId-535828]Table 35-11 [bookmark: 94046]Map Element Indicators 

 
        
       
         
         		
           
           [bookmark: pgfId-535836]Indicator
          
  
         		
           
           [bookmark: pgfId-535838]Icon
          
  
         		
           
           [bookmark: pgfId-535840]Description
          
  
        

 
         
         		[bookmark: pgfId-535848]Linked map

     
         		[bookmark: pgfId-535853]Node is linked to another map.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-537422]Related Topics

 
      
      		 [bookmark: pgfId-537427]Using Map Objects To Represent Network Topology

 
      		 [bookmark: pgfId-537432]Creating and Managing Layer 3 Links on the Map

 
     

 
    
 
     
      [bookmark: pgfId-537446][bookmark: 94075][bookmark: tpchap_cncpt_DisplayingManagedDevicesontheMap]Displaying Managed Devices on the Map[bookmark: marker-537440][bookmark: marker-537442][bookmark: marker-537444]

 
     [bookmark: pgfId-537448]A device node represents a device that is managed by Security Manager. You add a device node to a map by selecting the device from the Security Manager inventory.

 
     [bookmark: pgfId-537453]When you add a device node to a map, its layer 3 connectivity to other nodes on the map is created automatically. For more information, see Creating and Managing Layer 3 Links on the Map.

 
     [bookmark: pgfId-537455]You can add, remove, or show managed nodes by the following means:

 
      
      		 [bookmark: pgfId-537461] To add devices that are already in the Security Manager inventory —Select  Map > Show Devices on Map to open a device selector. Select the desired devices from the list of available devices and click  >> to move them to the selected devices list. You can select device groups to move all devices in the group. Click  OK when the list of selected devices has the desired nodes. Only those devices in the selected list are shown on the map.[bookmark: marker-537457][bookmark: marker-537459]

 
     

 
     [bookmark: pgfId-537463]You can remove devices by selecting them in the selected list and clicking <<.

 
      
      		 [bookmark: pgfId-537472] To add a new device to the map and the device inventory —Click the  New Device button in the map toolbar or right-click the map background and select  New Device . The New Device dialog box opens. Follow the procedures for adding new devices described in Adding Devices to the Device Inventory.[bookmark: marker-537468][bookmark: marker-537470]

 
      		 [bookmark: pgfId-537478] To remove a managed node —Right-click the node and select  Remove from Map .[bookmark: marker-537474][bookmark: marker-537476]

 
      		 [bookmark: pgfId-537484] To locate a device on the open map when in Device view —Right-click the device in the device selector and select  Show in Map view . If the device is shown on the active map, it is shown centered and highlighted on the undocked map. You are told that the device cannot be found if the device is not shown on the active map.[bookmark: marker-537480][bookmark: marker-537482]

 
      		 [bookmark: pgfId-537486] To locate a device in Device view from the map —Right-click the device and select  Show in Device View . Device view is opened with the device selected so that you can edit its policies.

 
     

 
     [bookmark: pgfId-537488]Related Topics

 
      
      		 [bookmark: pgfId-537493]Understanding Map Elements

 
      		 [bookmark: pgfId-537498]Showing Containment of Catalyst Switches, Firewalls, and Adaptive Security Appliances

 
     

 
    
 
     
      [bookmark: pgfId-537508][bookmark: 94157][bookmark: tpchap_cncpt_ShowingContainmentofCatalystSwitchesFirewallsandAdaptiveSecurityAppliances]Showing Containment of Catalyst Switches, Firewalls, and Adaptive Security Appliances[bookmark: marker-537504][bookmark: marker-537506]

 
     [bookmark: pgfId-537510]The containment relationship between Catalyst and Adaptive Security Appliance (ASA) devices and their service modules and security contexts, between PIX 7.x+ devices and FWSM and their security contexts, or between IPS devices and their virtual sensors, is displayed in maps as follows:

 
      
      		 [bookmark: pgfId-537512]When you select a Catalyst device, nodes that represent its Firewall Services Modules (FWSM) are highlighted.

 
      		 [bookmark: pgfId-537514]When you select an ASA, nodes that represent its Security Service Modules are highlighted.

 
      		 [bookmark: pgfId-537516]When you select a service module, the device that contains it is highlighted.

 
      		 [bookmark: pgfId-537518]When you select an IPS device, the nodes that represent virtual sensors defined on the device are highlighted.

 
      		 [bookmark: pgfId-537520]You can view a list of the security contexts contained in an ASA, firewall, or FWSM device, or the virtual sensors contained in an IPS device, by right-clicking the node and selecting  Show Containment . This command also shows the service modules in a device that has them.

 
      		 [bookmark: pgfId-537522]When you select a security context node, all its ancestor device nodes are highlighted.

 
      		 [bookmark: pgfId-537524]When you select a virtual sensor, the device on which it is defined is highlighted.

 
     

 
    
 
     
      [bookmark: pgfId-537532][bookmark: 94184][bookmark: tpchap_proc_AddingMapObjects]Using Map Objects To Represent Network Topology[bookmark: marker-537530]

 
     [bookmark: pgfId-537537]You can add map elements to a map that represent objects (such as devices and links) that Security Manager does not manage. These nodes are called map objects. You can use map objects to create a more useful representation of your network topology. (If you want to add a managed device, see Displaying Managed Devices on the Map.)

 
     [bookmark: pgfId-537539]You can add layer 3 links between any map elements, whether they are device nodes, map nodes, or a combination of both types.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-537543]Tip To delete a map object, right-click the object and select Delete Map Object.[bookmark: marker-537541]


     
      

     

     

 
     
 
     [bookmark: pgfId-537548]Step 1 Select Map > Add Map Object. The Add Map Object dialog box appears (see Add Map Object and Node Properties Dialog Boxes).

 
     [bookmark: pgfId-537550]Step 2 Do one of the following:

 
      
      		 [bookmark: pgfId-537555]If you are adding a map object based on the definition of an Security Manager policy object, click  Copy Policy Object to open the Select Policy Object Dialog Box. Then, select the type of object (AAA server, network/host, PKI enrollment), click  Select to choose the object, then click  OK in the Select Policy Object dialog box. Information from the policy object is entered in the Add Map Object dialog box.

 
     

 
     [bookmark: pgfId-537557]The name of the object is used as the map object name, but you can edit this if desired.

 
      
      		 [bookmark: pgfId-537559]If you are adding a map object that is not based on a policy object, enter a name for the map object in the  Name field.

 
     

 
     [bookmark: pgfId-537561]Step 3 Select the type of object that the node represents from the Type list. If you selected a policy object, the type is pre-selected, but you can change the selection.

 
     [bookmark: pgfId-537563]Step 4 (Optional) Add interfaces to the node by doing the following for each interface:

 
     [bookmark: pgfId-537568] a. Click Add to open the Interface Properties Dialog Box. If items already appear in the list, you can select them and click Edit to change them.

 
     [bookmark: pgfId-537570] b. Enter an interface name, IP address, and network mask, then click OK.

 
     [bookmark: pgfId-537572]Step 5 Click OK. The map object is added to the center of the map. Move it to the desired location.

 
     [bookmark: pgfId-537574]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-537590][bookmark: 94236][bookmark: tppage_cncpt_AddMapObjectandNodePropertiesDialogBoxes]Add Map Object and Node Properties Dialog Boxes[bookmark: marker-537586][bookmark: marker-537588]

 
     [bookmark: pgfId-537595]For unmanaged map objects, the Add Map Object and Node Properties dialog boxes are the same. Use the Add Map Object dialog box to add an object to the map. Use the Node Properties dialog box to view or edit map object properties. For more information, see Using Map Objects To Represent Network Topology.

 
     [bookmark: pgfId-537597]For managed map objects (such as a managed device), the Node Properties dialog box is read-only. It displays the object name, type, and list of interface names and IP addresses (if any are defined in Security Manager for the device). The reference information below does not apply to this version of the Node Properties dialog box.

 
     [bookmark: pgfId-537599]Navigation Path

 
      
      		 [bookmark: pgfId-537601]To open the Add Map Object dialog box, select  Map > Add Map Object .

 
      		 [bookmark: pgfId-537603]To open the Node Properties dialog box, right-click a map object or managed device and select  Node Properties .

 
     

 
     [bookmark: pgfId-537605]Field Reference

 
     [bookmark: pgfId-537608] 

 
      
       
        
        [bookmark: pgfId-535866]Table 35-12 [bookmark: 94260]Add Map Object and Node Properties Dialog Boxes for Unmanaged Nodes 

 
        
       
         
         		
           
           [bookmark: pgfId-535872]Element
          
  
         		
           
           [bookmark: pgfId-535874]Description
          
  
        

 
         
         		[bookmark: pgfId-535880]Name

  
         		[bookmark: pgfId-535882]The name of the map object. If you select a policy object, the name of the object is automatically used, but you can change it.

  
        

 
         
         		[bookmark: pgfId-535888]Copy Policy Object button

  
         		[bookmark: pgfId-535893]Click to browse for a policy object to use as the basis for the map object using the Select Policy Object Dialog Box.

  
        

 
         
         		[bookmark: pgfId-535899]Type list

  
         		[bookmark: pgfId-535901]The type of object you are creating. If you select a policy object, a type is selected for you, but you can change it if necessary.

  
        

 
         
         		[bookmark: pgfId-535907]Interfaces table

  
         		[bookmark: pgfId-535909]The interfaces on the node. If you select a policy object, information might have been added to this table.

 
           
           		 [bookmark: pgfId-535914]To add an interface, click the  Add (+) button and fill in the Interface Properties Dialog Box.

 
           		 [bookmark: pgfId-535916]To edit an interface, select it and click the  Edit (pencil) button.

 
           		 [bookmark: pgfId-535918]To delete an interface, select it and click the  Delete (trash can) button.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-537620][bookmark: 94303][bookmark: tppage_cncpt_SelectPolicyObjectDialogBox]Select Policy Object Dialog Box[bookmark: marker-537618]

 
     [bookmark: pgfId-537622]Use the Select Policy Object dialog box to add an object to the map that is defined in a policy object.

 
     [bookmark: pgfId-537624]Select the type of object that defines the node you want to add to the map from the Select a Policy Object list, then click Select to select the specific policy object. If you know the object’s name, you can type it into the text box instead of clicking Select.

 
     [bookmark: pgfId-537629]For more information, see Using Map Objects To Represent Network Topology.

 
     [bookmark: pgfId-537631]Navigation Path

 
     [bookmark: pgfId-537636]To open this dialog box, click Copy Policy Object in the Add Map Object dialog box (see Add Map Object and Node Properties Dialog Boxes).

 
    
 
     
      [bookmark: pgfId-537646][bookmark: 94321][bookmark: tppage_cncpt_InterfacePropertiesDialogBox]Interface Properties Dialog Box[bookmark: marker-537644]

 
     [bookmark: pgfId-537651]Use the Interface Properties dialog box to add and edit interfaces on map objects. For more information, see Using Map Objects To Represent Network Topology.

 
     [bookmark: pgfId-537653]Navigation Path

 
     [bookmark: pgfId-537658]To open this dialog box, click the Add or Edit button in the Add Map Object and Node Properties Dialog Boxes.

 
     [bookmark: pgfId-537660]Field Reference

 
     [bookmark: pgfId-537663] 

 
      
       
        
        [bookmark: pgfId-535931]Table 35-13 [bookmark: 94337]Interface Properties Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-535937]Element
          
  
         		
           
           [bookmark: pgfId-535939]Description
          
  
        

 
         
         		[bookmark: pgfId-535945]Interface Name

  
         		[bookmark: pgfId-535947]The interface name.

  
        

 
         
         		[bookmark: pgfId-535953]Interface IP Addr/Mask

  
         		[bookmark: pgfId-535955]The interface IP address and network mask, for example, 10.100.10.0/24 or 10.100.10.0/255.255.255.0.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-537671][bookmark: 94359][bookmark: tpchap_proc_CreatingandManagingLayer3LinksontheMap]Creating and Managing Layer 3 Links on the Map[bookmark: marker-537669]

 
     [bookmark: pgfId-537673]A layer 3 link is a line on the map that represents a network connection between two device interfaces.

 
     [bookmark: pgfId-537675]Layer 3 connectivity information is automatically added to the map when you add map elements that have interface information. When you add a map element that has interface information, one of the following happens:

 
      
      		 [bookmark: pgfId-537677]If the interface is on a network that is not represented on the map as a network map object, a network map object is added to the map with a layer 3 link to the new map element.

 
      		 [bookmark: pgfId-537679]If the interface is on a network that is represented on the map as a network map object, a layer 3 link is added between the new map element and the network map object.

 
     

 
     [bookmark: pgfId-537681]When you remove a node interface that is a layer 3 link endpoint, the link is also removed.

 
     [bookmark: pgfId-537683]You can add additional layer 3 links between device nodes and map objects to illustrate your network’s connectivity. Adding Layer 3 links to a map does not configure any network devices. Layer 3 links are just visual elements on the map.

 
     [bookmark: pgfId-537685]You create layer 3 links to connect any two interfaces on a map. Depending on the interfaces that you choose, the layer 3 link might include intermediary networks or network clouds. In some cases, you have the option to select which intermediary networks and networks clouds are inserted between the connected interfaces.

 
     [bookmark: pgfId-537687]The following procedure explains how to manually create a new layer 3 link.

 
     [bookmark: pgfId-537689]Tips

 
      
      		 [bookmark: pgfId-537691]The automatic addition of network objects and links is called Autolink. You can configure Autolink to not automatically add private or certain reserved network addresses. To configure these settings, select  Tools > Security Manager Administration , then click  Autolink .

 
      		 [bookmark: pgfId-537693]To view the properties of a link, right-click the layer 3 link and select  Link Properties .

 
      		 [bookmark: pgfId-537697]To delete a layer 3 link, right-click the layer 3 link to be removed and select  Delete Link . Deleting a layer 3 link does not delete any intermediary network or network clouds between map elements.[bookmark: marker-537695]

 
     

 
     
 
     [bookmark: pgfId-537699]Step 1 In Map view, click Map > Add Link or the Add Link button in the toolbar.

 
     [bookmark: pgfId-537701]Step 2 Click one of the map elements to connect, then click the other map element to connect.

 
     [bookmark: pgfId-537706]Step 3 If the map elements contain interfaces, select the source and destination interfaces for the link in the Select Interfaces and Link Properties Dialog Boxes, then click OK.

 
     [bookmark: pgfId-537708]The Add Link dialog box might open, depending on which interfaces you select.

 
     [bookmark: pgfId-537713]Step 4 If the Add Link Dialog Box opens, select which intermediary objects and network clouds to insert, then click OK.

 
     [bookmark: pgfId-537715]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-537729][bookmark: 94410][bookmark: tppage_cncpt_SelectInterfacesDialogBox]Select Interfaces and Link Properties Dialog Boxes[bookmark: marker-537725][bookmark: marker-537727]

 
     [bookmark: pgfId-537731]The Select Interfaces and Link Properties dialog boxes are used with layer 3 links on maps. These dialog boxes show information about the source and destination devices for the link (the source being the first device you clicked when making the link).

 
     [bookmark: pgfId-537733]If you are creating a link, the Select Interfaces dialog box is used. If there are interfaces defined for the device in Security Manager, select the desired source and destination interfaces for the link you are creating from the Source/Destination Interface list.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-537735]Tip When creating a link, if there are no interfaces defined for either device, the Interface lists are greyed out. If one device has interfaces defined, both fields are active, but empty for the device that does not have interfaces defined for it. You cannot change the interface when viewing link properties.


     
      

     

     

 
     [bookmark: pgfId-537737]Navigation Path

 
     [bookmark: pgfId-537742]For information on how to create layer 3 links or view their properties, see Creating and Managing Layer 3 Links on the Map.

 
    
 
     
      [bookmark: pgfId-537752][bookmark: 94427][bookmark: tppage_cncpt_AddLinkDialogBox]Add Link Dialog Box[bookmark: marker-537750]

 
     [bookmark: pgfId-537754]Use the Add Link dialog box to select how to represent the layer 3 link that you are adding to the map.

 
     [bookmark: pgfId-537756]The contents of the Add Link dialog box vary according to which nodes and interfaces you are connecting. Select the check boxes for each intermediary map object (network or cloud) that you want to insert between the connected nodes. If desired, you can change the names of the map objects.

 
     [bookmark: pgfId-537758]Navigation Path

 
     [bookmark: pgfId-537763]This dialog box might open when you add a link between nodes, depending on which interfaces you select to connect. For the procedure, see Creating and Managing Layer 3 Links on the Map.

 
    
 
   
 
    
     [bookmark: pgfId-537773][bookmark: 94441][bookmark: tpchap_cncpt_ManagingVPNsinMapView]Managing VPNs in Map View[bookmark: marker-537769][bookmark: marker-537771]

 
    [bookmark: pgfId-537775]The following topics describe how to manage VPNs in the Map view:

 
     
     		 [bookmark: pgfId-537780]Displaying Existing VPNs on the Map

 
     		 [bookmark: pgfId-537785]Creating VPN Topologies in Map View

 
     		 [bookmark: pgfId-537790]Editing VPN Policies or Peers From the Map

 
    

 
     
      [bookmark: pgfId-537802][bookmark: 94461][bookmark: tpchap_cncpt_DisplayingExistingVPNsontheMap]Displaying Existing VPNs on the Map[bookmark: marker-537798][bookmark: marker-537800]

 
     [bookmark: pgfId-537804]To display an existing VPN on the map, select Map > Show VPNs on Map. You are prompted with a list of existing VPNs. Select the ones you want from the available VPNs list and click >> to move them to the selected list.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-537806]Tip You can also remove a VPN using this command. Select the VPNs you want to remove from the selected VPNs list and click <<. When you remove a VPN, only the VPN tunnels are removed. The device nodes remain on the map.


     
      

     

     

 
     [bookmark: pgfId-537808]When you display a VPN, all of the its member devices are added to the map as device nodes, and all of its tunnels are highlighted. However, devices that you removed from the map previously are not added, even if they are members of a VPN that you display. You can add such devices to the map manually, and their VPN connectivity is displayed.

 
     [bookmark: pgfId-537810]A VPN tunnel is a line on the map that represents a VPN connection between two devices. VPN tunnels are not added to the map automatically when you add a device node that is a member of a VPN. However, if the VPN was already selected to be shown on the map, adding a device in the VPN to the map will also display the tunnel.

 
     [bookmark: pgfId-537815]For an explanation of the icons used in the map, see Understanding Map Elements.

 
    
 
     
      [bookmark: pgfId-537825][bookmark: 94480][bookmark: tpchap_cncpt_CreatingVPNTopologiesMapView]Creating VPN Topologies in Map View[bookmark: marker-537821][bookmark: marker-537823]

 
     [bookmark: pgfId-537827]You can create VPN connections between VPN-capable managed device nodes that are displayed on the map. You cannot create Extranet VPNs, however.

 
     [bookmark: pgfId-537829]To create a VPN, do one of the following:

 
      
      		 [bookmark: pgfId-537831]Click the  New VPN button in the toolbar and select the type of VPN you want to configure: point-to-point, hub and spoke, or full mesh.

 
      		 [bookmark: pgfId-537833]Select the devices that you want to participate in the VPN (use Ctrl+click to select multiple devices), and either right click and select the command for the desired type of VPN, or click the  New VPN button and select the VPN type.

 
     

 
     [bookmark: pgfId-537835]Consider the following tips:

 
     [bookmark: pgfId-537837] – Select only 2 devices to create a point-to-point VPN.

 
     [bookmark: pgfId-537839] – If you create a hub-and-spoke VPN, the device you right-click is initially defined as the hub, but you can change that in the wizard.

 
     [bookmark: pgfId-537841] – While in the wizard, you can add or remove devices. You are not restricted to the devices you selected on the map.

 
     [bookmark: pgfId-537846]Using either technique, the Create VPN wizard opens, where you can create the VPN. For more information, see Creating or Editing VPN Topologies or click the Help button in the wizard.

 
     [bookmark: pgfId-537848]The VPN is displayed on the map when you are finished with the wizard.

 
     [bookmark: pgfId-537850]Related Topics

 
      
      		 [bookmark: pgfId-537855]Selecting Map Elements

 
     

 
    
 
     
      [bookmark: pgfId-537877][bookmark: 94516][bookmark: tpchap_cncpt_EditingVPNPoliciesorPeersFromtheMap]Editing VPN Policies or Peers From the Map[bookmark: marker-537867][bookmark: marker-537869][bookmark: marker-537871][bookmark: marker-537873][bookmark: marker-537875]

 
     [bookmark: pgfId-537879]You can edit VPN policies, or the peers that participate in a VPN, from map view. To edit policies or peers, right-click a VPN tunnel or device node and select one of these commands:

 
      
      		 [bookmark: pgfId-537884] Edit VPN Policies —To open the Site-to-Site VPN Manager, where you can edit the policies that define the VPN. For more information, see Site-to-Site VPN Manager Window.

 
      		 [bookmark: pgfId-537886] Edit VPN Peers —To open a dialog box that allows you to configure the peers that participate in the VPN. Click the  Help button in the dialog box for more information.

 
      		 [bookmark: pgfId-537888] Show VPN Peers —To see which devices participate in a VPN without editing the list (VPN Peers dialog box).

 
     

 
     [bookmark: pgfId-537890]If the device participates in more than one VPN, you are first prompted to select the desired VPN (with the Select VPN to Configure dialog box) before the appropriate dialog box is opened.

 
    
 
   
 
    
     [bookmark: pgfId-537898][bookmark: 94551][bookmark: tpchap_cncpt_ManagingDevicePoliciesinMapView]Managing Device Policies in Map View[bookmark: marker-537896]

 
    [bookmark: pgfId-537900]You can perform only basic policy management and configure firewall services policies in Map view. You cannot configure other types of policies. The following topics describe how to manage policies from the Map view:

 
     
     		 [bookmark: pgfId-537905]Performing Basic Policy Management in Map View

 
     		 [bookmark: pgfId-537910]Managing Firewall Policies in Map View

 
     		 [bookmark: pgfId-537915]Managing Firewall Settings in Map View

 
    

 
     
      [bookmark: pgfId-537925][bookmark: 94567][bookmark: tpchap_cncpt_PerformingBasicPolicyManagementinMapView]Performing Basic Policy Management in Map View[bookmark: marker-537921][bookmark: marker-537923]

 
     [bookmark: pgfId-537927]You can perform some basic policy management tasks in Map view. Right click the device and select one of the following commands:

 
      
      		 [bookmark: pgfId-537934] Copy Policies Between Devices —To copy local device policies from one device to another. For more information on copying policies, see Copying Policies Between Devices.[bookmark: marker-537932]

 
      		 [bookmark: pgfId-537941] Share Device Policies —To create shared policies from local device policies. For more information on sharing policies, see Sharing Multiple Policies of a Selected Device.[bookmark: marker-537939]

 
      		 [bookmark: pgfId-537948] Clone Device —To create a copy of a device, including its policies. For more information on cloning devices, see Cloning a Device.[bookmark: marker-537946]

 
      		 [bookmark: pgfId-537955] Preview Configuration —To view the configuration file that will be generated for the device, including the changes from the previous deployment. For more information on previewing configurations, see Previewing Configurations.[bookmark: marker-537953]

 
      		 [bookmark: pgfId-537962] Discover Policies on Device —To discover the policies defined on the device and configure them in Security Manager, wiping out whatever policies are defined in Security Manager for the device. For more information device discovery, see Discovering Policies on Devices Already in Security Manager.[bookmark: marker-537960]

 
     

 
     [bookmark: pgfId-537964]Related Topics

 
      
      		 [bookmark: pgfId-537969]Chapter 8, “Managing Deployment”

 
      		 [bookmark: pgfId-537974]Chapter 3, “Managing the Device Inventory”

 
      		 [bookmark: pgfId-537979]Chapter 5, “Managing Policies”

 
     

 
    
 
     
      [bookmark: pgfId-537989][bookmark: 94625][bookmark: tpchap_cncpt_ManagingFirewallPoliciesMapView]Managing Firewall Policies in Map View[bookmark: marker-537985][bookmark: marker-537987]

 
     [bookmark: pgfId-537991]You can configure firewall policies on a device in Map view. These policies are local to the device rather than being shared policies (you must use Policy view to configure shared policies).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-537996]Tip If you want to assign a shared policy to a device, see Performing Basic Policy Management in Map View.


     
      

     

     

 
     [bookmark: pgfId-537998]To configure local firewall policies on a device in Map view, right click the device and select one of the following commands:

 
      
      		 [bookmark: pgfId-538005] Edit Firewall Policies > AAA Rules —To configure AAA policies, which control who is allowed access to the device and what services they are allowed to use once they have access. For more information on configuring AAA rules, see AAA Rules Page.[bookmark: marker-538003]

 
      		 [bookmark: pgfId-538012] Edit Firewall Policies > Access Rules —To configure Access Rules policies, which control the traffic that flows through a device. For more information on configuring access rules, see Access Rules Page.[bookmark: marker-538010]

 
      		 [bookmark: pgfId-538019] Edit Firewall Policies > Inspection Rules —To configure Inspection Rules policies, which analyze traffic at the application layer and track TCP and UDP sessions to perform refined access control. For more information on configuring inspection rules, see Inspection Rules Page.[bookmark: marker-538017]

 
      		 [bookmark: pgfId-538026] Edit Firewall Policies > Botnet Traffic Filter Rules —(ASA 8.2 and higher only) To configure Botnet Traffic Filter Rules policies, which monitor web traffic. For more information on configuring botnet traffic filter rules, see Botnet Traffic Filter Rules Page.[bookmark: marker-538024]

 
      		 [bookmark: pgfId-538033] Edit Firewall Policies > Transparent Rules —To configure Transparent Rules policies, which define EtherType rules for transparent firewalls. For more information on configuring inspection rules, see Transparent Rules Page.[bookmark: marker-538031]

 
      		 [bookmark: pgfId-538043] Edit Firewall Policies > Web Filter Rules —To configure Web Filter Rules policies, which define rules for web access. For more information on configuring web filter rules, see Web Filter Rules Page (ASA/PIX/FWSM) or Web Filter Rules Page (IOS).[bookmark: marker-538041]

 
      		 [bookmark: pgfId-538050] Edit Firewall Policies > Zone Based Firewall Rules —(IOS 12.4(6)T and higher only) To configure Zone Based Firewall Rules policies, which configure inspection and web filtering using security zones. For more information on configuring zone based firewall rules, see Zone-based Firewall Rules Page.[bookmark: marker-538048]

 
     

 
     [bookmark: pgfId-538052]Related Topics

 
      
      		 [bookmark: pgfId-538057]Chapter 12, “Introduction to Firewall Services”

 
      		 [bookmark: pgfId-538062]Chapter 5, “Managing Policies”

 
     

 
    
 
     
      [bookmark: pgfId-538072][bookmark: 94698][bookmark: tpchap_cncpt_ManagingFirewallSettingsMapView]Managing Firewall Settings in Map View[bookmark: marker-538068][bookmark: marker-538070]

 
     [bookmark: pgfId-538074]You can configure firewall settings policies on a device in Map view. These policies are local to the device rather than being shared policies (you must use Policy view to configure shared policies).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-538079]Tip If you want to assign a shared policy to a device, see Performing Basic Policy Management in Map View.


     
      

     

     

 
     [bookmark: pgfId-538081]To configure local firewall settings policies on a device in Map view, right click the device and select one of the following commands:

 
      
      		 [bookmark: pgfId-538091] Edit Firewall Settings > AAA Firewall —(ASA/PIX/FWSM only) To configure AAA Firewall settings policies, which configures proxy, authentication challenge, MAC exempt lists, and other general AAA settings. For more information on configuring AAA firewall settings, see AAA Firewall Settings Page, Advanced Setting Tab and AAA Firewall Page, MAC-Exempt List Tab.[bookmark: marker-538089]

 
      		 [bookmark: pgfId-538098] Edit Firewall Settings > Access Control —To configure Access Control settings policies, which configures optimization and other general access control settings. For more information on configuring access control settings, see Access Control Settings Page.[bookmark: marker-538096]

 
      		 [bookmark: pgfId-538107] Edit Firewall Settings > AuthProxy —(IOS devices only) To configure AuthProxy settings policies, which configure general settings for authorization proxies. For more information on configuring authorization proxies, see AAA Page.[bookmark: marker-538103][bookmark: marker-538105]

 
      		 [bookmark: pgfId-538114] Edit Firewall Settings > Inspection —(IOS devices only) To configure Inspection settings policies, which configure timeout and session settings for inspection rules. For more information on configuring inspection settings, see Configuring Settings for Inspection Rules for IOS Devices.[bookmark: marker-538112]

 
      		 [bookmark: pgfId-538121] Edit Firewall Settings > Web Filter —To configure Web Filter settings policies, which configure the server used for web filtering. For more information on configuring web filter settings, see Web Filter Settings Page.[bookmark: marker-538119]

 
      		 [bookmark: pgfId-538127] Edit Firewall Settings > Zone Based Firewall —(IOS 12.4(6)T and higher devices) To configure Zone Based Firewall settings policies, which configure zones and Trend web filter server settings.[bookmark: marker-538123][bookmark: marker-538125]
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     [bookmark: pgfId-581727][bookmark: 132199][bookmark: pxpage_cncpt_UserPreferences]User Preferences[bookmark: marker-581721][bookmark: marker-581723][bookmark: marker-581725]
      
      
 
     
 

 
    [bookmark: pgfId-581729]The User Preferences section consists of the Deployment page and the Transactional Commit page. The Deployment page provides access to the Clear XLATE on deployment option. The Transactional Commit page allows you to enable or disable the transactional commit model for access rules or NAT rules.

 
   
 
    
     [bookmark: pgfId-581755][bookmark: 132212][bookmark: pxchap_proc_ConfiguringUserPreferencesonFirewallDevices]Configuring Deployment Preferences on Firewall Devices[bookmark: marker-581737][bookmark: marker-581739][bookmark: marker-581741][bookmark: marker-581743][bookmark: marker-581745][bookmark: marker-581747][bookmark: marker-581749][bookmark: marker-581751][bookmark: marker-581753]

 
    [bookmark: pgfId-581757]Use the User Preferences Deployment page to specify deployment options for specific firewall devices. You can create a policy with the deployment options you want to use and then apply that policy to all devices that you want using those deployment settings.

 
    
 
    [bookmark: pgfId-581759]Step 1 Do one of the following:

 
     
     		 [bookmark: pgfId-581761](Device view) Select  Platform > User Preferences > Deployment from the Device Policy selector.

 
     		 [bookmark: pgfId-581763](Policy view) Select  PIX/ASA/FWSM Platform > User Preferences > Deployment from the Policy Types selector. Right-click  Deployment and choose  New Deployment Policy to create a policy, or select an existing policy from the Policies selector.

 
    

 
    [bookmark: pgfId-581765]The Deployment page is displayed.

 
    [bookmark: pgfId-581767]Step 2 Check Clear XLATE on deployment if you want the translation table cleared when a configuration is deployed to this device.

 
    [bookmark: pgfId-581769]Select this option to send a clear xlate command to the firewall before changes to access lists are made. This command clears all NAT translations. By default this option is not selected.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-581771]Note This option is necessary for certain commands to take effect. If these commands are changed, you should make sure this option is enabled for the device. However, clearing the translation table disconnects all current connections that use translations.


    
     

    

    

 
    [bookmark: pgfId-581773]Step 3 Click Save at the bottom of the page.

 
    [bookmark: pgfId-581775]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-581793][bookmark: 132273][bookmark: pxchap_proc_prefs_TransCommitPage]Configuring Transactional Commit Preferences on Firewall Devices[bookmark: marker-581783][bookmark: marker-581785][bookmark: marker-581787][bookmark: marker-581789][bookmark: marker-581791]

 
    [bookmark: pgfId-581795]By default, when you change a rule-based policy (such as access rules), the changes become effective immediately. However, this immediacy comes at a slight cost in performance. The performance cost is more noticeable for very large rule lists in a high connections-per-second environment, for example, when you change a policy with 25,000 rules while the ASA is handling 18,000 connections per second.

 
    [bookmark: pgfId-581797]The performance is affected because the rule engine compiles rules to enable faster rule lookup. By default, the system will also search uncompiled rules when evaluating a connection attempt so that new rules can be applied; since the rules are not compiled, the search takes longer.

 
    [bookmark: pgfId-581800]Beginning with ASA 9.1(5), you can change this behavior so that the rule engine uses a transactional model when implementing rule changes, continuing to use the old rules until the new rules are compiled and ready for use. Using the transactional model, performance should not drop during the rule compilation. The following table clarifies the behavioral difference.

 
     
      
      
        
        		 
          
          [bookmark: pgfId-581050]Model
         
  
        		 
          
          [bookmark: pgfId-581052]Before Compilation
         
  
        		 
          
          [bookmark: pgfId-581054]During Compilation
         
  
        		 
          
          [bookmark: pgfId-581056]After Compilation
         
  
       

 
        
        		[bookmark: pgfId-581066]Default

  
        		[bookmark: pgfId-581068]Match old rules.

  
        		[bookmark: pgfId-581070]Match new rules.

 [bookmark: pgfId-581072](Connections per second rate will decrease.)

  
        		[bookmark: pgfId-581074]Match new rules.

  
       

 
        
        		[bookmark: pgfId-581084]Transactional

  
        		[bookmark: pgfId-581086]Match old rules.

  
        		[bookmark: pgfId-581088]Match old rules.

 [bookmark: pgfId-581090](Connections per second rate will be unaffected.)

  
        		[bookmark: pgfId-581092]Match new rules.

  
       

 
      
     

 
    
 
    [bookmark: pgfId-581802]An additional benefit of the transactional model is that, when replacing an ACL on an interface, there is no gap between deleting the old ACL and applying the new one. This reduces the chances that acceptable connections will be dropped during the operation.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-581804]Tip If you enable the transactional model for a rule type, there are syslog messages to mark the beginning and the end of the compilation. These messages are numbered 780001 and following.


    
     

    

    

 
    
 
    [bookmark: pgfId-581806]Step 1 Do one of the following:

 
     
     		 [bookmark: pgfId-581808](Device view) Select  Platform > User Preferences > Transactional Commit from the Device Policy selector.

 
     		 [bookmark: pgfId-581810](Policy view) Select  PIX/ASA/FWSM Platform > User Preferences > Transactional Commit from the Policy Types selector. Right-click  Transactional Commit and choose  New Transactional Commit Policy to create a policy, or select an existing policy from the Policies selector.

 
    

 
    [bookmark: pgfId-581812]The Transactional Commit page is displayed.

 
    [bookmark: pgfId-581814]Step 2 Enable the transactional commit model for the desired features. Options include:

 
     
     		 [bookmark: pgfId-581816]Access Group

 
     		 [bookmark: pgfId-581818]NAT

 
    

 
    [bookmark: pgfId-581820]Step 3 Click Save at the bottom of the page.

 
    [bookmark: pgfId-581822]
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     [bookmark: pgfId-710763][bookmark: 105088][bookmark: ipsvchap_cncpt_ConfiguringPoliciesSpecifictoIOSIPSDevices]Configuring IOS IPS Routers[bookmark: marker-710757][bookmark: marker-710759][bookmark: marker-710761]
      
      
 
     
 

 
    [bookmark: pgfId-710765]Some Cisco IOS routers, such as integrated services routers (ISRs), include native IPS capabilities based on IPS 5.1 software. You can configure some basic IPS inspection on these devices to supplement IPS sensor inspection or to support small networks.

 
    [bookmark: pgfId-710767]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-710772]Understanding Cisco IOS IPS

 
     		 [bookmark: pgfId-710777]Overview of Cisco IOS IPS Configuration

 
    

 
   
 
    
     [bookmark: pgfId-710787][bookmark: 105100][bookmark: ipsvchap_cncpt_UnderstandingCiscoIOSIPS]Understanding Cisco IOS IPS[bookmark: marker-710783][bookmark: marker-710785]

 
    [bookmark: pgfId-710789]You can use Cisco Security Manager with the Cisco IOS Intrusion Prevention System (IOS IPS) to manage intrusion prevention on Cisco routers that use supported Cisco IOS Software releases 12.4(11)T2 and higher.

 
    [bookmark: pgfId-710791]The Cisco IOS IPS acts as an in-line intrusion prevention sensor, watching packets and sessions as they flow through the router and scanning each packet to match any of the Cisco IOS IPS signatures. When it detects suspicious activity, it responds before network security can be compromised and logs the event through Cisco IOS syslog messages or Security Device Event Exchange (SDEE).

 
    [bookmark: pgfId-710793]You can configure Cisco IOS IPS to choose the appropriate response to various threats. The Signature Event Action Processor (SEAP) can dynamically control actions that are to be taken by a signature event on the basis of parameters such as fidelity, severity, or target value rating. You can configure these actions in Security Manager through the Signatures and Event Actions policies.

 
    [bookmark: pgfId-710795]When packets in a session match a signature, Cisco IOS IPS can take any of the following actions, as appropriate:

 
     
     		 [bookmark: pgfId-710797]Send an alarm to a syslog server or a centralized management interface.

 
     		 [bookmark: pgfId-710799]Drop the packet.

 
     		 [bookmark: pgfId-710801]Reset the connection.

 
     		 [bookmark: pgfId-710803]Deny traffic from the source IP address of the attacker for a specified amount of time.

 
     		 [bookmark: pgfId-710805]Deny traffic on the connection for which the signature was seen for a specified amount of time.

 
    

 
    [bookmark: pgfId-710807]Cisco developed its Cisco IOS software-based intrusion-prevention capabilities and Cisco IOS Firewall with flexibility in mind, so that individual signatures could be disabled in case of false positives. Generally, it is preferable to enable both the firewall and Cisco IOS IPS to support network security policies. However, each of these features can be enabled independently and on different router interfaces.

 
    [bookmark: pgfId-710812]For an overall understanding of the Cisco IOS IPS configuration process, see Overview of Cisco IOS IPS Configuration.

 
    [bookmark: pgfId-710814]This section contains the following topics:

 
     
     		 [bookmark: pgfId-710819]Understanding IPS Subsystems and Support of IOS IPS Revisions

 
     		 [bookmark: pgfId-710824]Cisco IOS IPS Signature Scanning with Lightweight Signatures

 
     		 [bookmark: pgfId-710829]Router Configuration Files and Signature Event Action Processor (SEAP)

 
     		 [bookmark: pgfId-710834]Cisco IOS IPS Limitations and Restrictions

 
    

 
     
      [bookmark: pgfId-710844][bookmark: 105126][bookmark: ipsvchap_cncpt_UnderstandingSupportofIOSIPSRevisions]Understanding IPS Subsystems and Support of IOS IPS Revisions[bookmark: marker-710840][bookmark: marker-710842]

 
     [bookmark: pgfId-710846]Cisco Security Manager automatically supports minor revisions of IOS IPS. To identify minor revisions that are supported, the IPS subsystem version is needed.

 
     [bookmark: pgfId-710850]The IPS subsystem version is a version number used to keep track of Cisco IOS IPS feature changes. The subsystem number is show in the device properties (right-click the device and select Device Properties). You can also use the command show subsys name ips at a command line on the router that is running Cisco IOS IPS to show the detailed Cisco IOS IPS subsystem version. The 3.x subsystems are equivalent to IPS 5.x. For a list of the supported subsystems by Cisco IOS Software release, see the Supported Devices and Software Versions for Cisco Security Manager on Cisco.com for this release of Security Manager.

 
     [bookmark: pgfId-710852]An IPS subsystem version is minor if the version difference is limited at postfix. For example, a revision from 3.0.1 to 3.0.2 is considered minor. For another example, 3.0.1 to 3.1.1 is also considered a minor version change. However, minor revisions that include new features are not automatically supported by Cisco Security Manager.

 
    
 
     
      [bookmark: pgfId-710864][bookmark: 105142][bookmark: ipsvchap_cncpt_LWE]Cisco IOS IPS Signature Scanning with Lightweight Signatures[bookmark: marker-710858][bookmark: marker-710860][bookmark: marker-710862]

 
     [bookmark: pgfId-710866]The addition of Cisco IOS IPS signature scanning with lightweight signatures in Cisco IOS Release 15.0(1)M is an enhancement to Cisco IOS IPS that allows loading of larger signatures sets, without consuming significant additional memory or reducing the memory consumed by an existing signature set, by loading equivalent lighter-weight signatures. These signatures are referred to as lightweight signatures.

 
     [bookmark: pgfId-710868]Security Manager can discover and tune custom signatures with LWEs on ISRs and modular access routers. Security Manager supports the following features for signatures with LWEs on ISRs and modular access routers:

 
      
      		 [bookmark: pgfId-710870]New signature types

 
      		 [bookmark: pgfId-710872]Signature categories

 
      		 [bookmark: pgfId-710874]New default signature category recognition

 
      		 [bookmark: pgfId-710876]New engine update levels

 
      		 [bookmark: pgfId-710878]Licensing status—bypassed, expired, or not installed

 
     

 
    
 
     
      [bookmark: pgfId-710888][bookmark: 105167][bookmark: ipsvchap_cncpt_SignatureSetsinPreviousVersionsofIOSIPS]Router Configuration Files and Signature Event Action Processor (SEAP)[bookmark: marker-710884][bookmark: marker-710886]

 
     [bookmark: pgfId-710890]As of Cisco IOS Release 12.4(11)T, signature definition files (SDFs) are no longer used by Cisco IOS IPS. Thus, you cannot not use the deprecated built-in signature sets, 128.sdf, 256.sdf, and attack-drop.sdf, with Security Manager.

 
     [bookmark: pgfId-710892]Instead, routers access signature definition information through a directory that contains three configuration files—the default configuration, the delta configuration, and the SEAP configuration. You configure the location using the IPS > General Settings policy.

 
     [bookmark: pgfId-710894]SEAP is the control unit responsible for coordinating the data flow of a signature event. It allows for advanced filtering and signature overrides on the basis of the Event Risk Rating (ERR) feedback. ERR is used to control the level in which a user chooses to take actions in an effort to minimize false positives.

 
     [bookmark: pgfId-710896]Signatures once stored in NVRAM are now stored in the delta configuration file.

 
    
 
     
      [bookmark: pgfId-710906][bookmark: 105181][bookmark: ipsvchap_cncpt_LimitationsandRestrictions]Cisco IOS IPS Limitations and Restrictions[bookmark: marker-710902][bookmark: marker-710904]

 
     [bookmark: pgfId-710908]Cisco IOS IPS routers do not support all the features that are supported by dedicated IPS sensor appliances and service modules. In addition, routers that support IOS IPS might not allocate as much memory to IPS functionality as an IPS sensor does. The following limitations and restrictions are important:

 
      
      		 [bookmark: pgfId-710910]When configuring an IOS IPS device, select only the signatures that you need. If you select all signatures that are available in Security Manager, you might exceed the memory available on the IOS IPS router and deployment can fail, the device might fail to load all of the signatures, or performance might be significantly degraded. If you encounter deployment failures, select a reduced set of signatures and then redeploy the configuration to the device.

 
      		 [bookmark: pgfId-710912]Security Manager-managed routers being configured to use IOS-IPS for the first time cannot use the auto-update process for signature updates. You must first update the router before you use the auto-update process. Follow these steps:

 
     

 
     [bookmark: pgfId-710914] a. Push an E3 signature, for example, S317.

 
     [bookmark: pgfId-710916] b. Push an intermediate signature, for example, S470.

 
     [bookmark: pgfId-710918] c. Push the first E4 signature, for example, S485.

 
     [bookmark: pgfId-710920] d. Push subsequent E4 signatures until you reach the desired level. Note that each delta should be less than 10 MB in size.

 
     [bookmark: pgfId-710925]After you have updated the router, you can use the auto-update process to update the signatures. The auto-update process will be successful as each incremental change will not exceed the memory available on the router. For information on configuring automatic updates, see Automating IPS Updates.

 
      
      		 [bookmark: pgfId-710927]Virtual sensors are not supported by IOS IPS.

 
      		 [bookmark: pgfId-710935]When using event action filters with an IOS IPS router, only a subset of IPS actions are available for removal from an event that meets the criteria of the event action filter. For more information on available event actions, see Filter Item Dialog Box and Understanding IPS Event Actions.

 
      		 [bookmark: pgfId-710937]IOS IPS is based on IPS Software 5.1. Therefore, features introduced in later versions of IPS Software are typically not available in IOS IPS. For example, you cannot configure the following features:

 
     

 
     [bookmark: pgfId-710939] – Global correlation.

 
     [bookmark: pgfId-710941] – Anomaly detection.

 
     [bookmark: pgfId-710943] – OS identification in the event action network identification policy.

 
    
 
   
 
    
     [bookmark: pgfId-710957][bookmark: 105223][bookmark: ipdvchap_proc_OverviewofCiscoIOSIPSConfiguration]Overview of Cisco IOS IPS Configuration[bookmark: marker-710949][bookmark: marker-710951][bookmark: marker-710953][bookmark: marker-710955]

 
    [bookmark: pgfId-710959]There are a wide variety of devices on which you can configure the Intrusion Prevention System. From a configuration point-of-view, you can separate the devices into two groups: dedicated appliances and service modules (for routers, switches, and ASA devices) that run the full IPS software; and IPS-enabled routers running Cisco IOS Software 12.4(11)T and later (Cisco IOS IPS).

 
    [bookmark: pgfId-710964]The following procedure is an overview of IPS configuration on a Cisco IOS IPS router. For dedicated IPS devices, including IPS service modules installed in a router, see Overview of IPS Configuration.

 
    [bookmark: pgfId-710966]Cisco IOS IPS is a more limited feature meant for branch offices and small to medium sized networks, or to distribute IPS throughout a network. You typically cannot employ as many signatures in a Cisco IOS IPS router compared to a dedicated appliance. You also cannot configure advanced features such as global correlation, because Cisco IOS IPS is based on IPS Software version 5.1. When configuring Cisco IOS IPS devices, you are mostly configuring standard router policies, because the device is a router that is running a few IPS features. In comparison, the platform policies for IPS appliances and service modules are specific to IPS software.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-710970]Tip Before configuring Cisco IOS IPS, read Cisco IOS Intrusion Prevention System Deployment Guide on Cisco.com.


    
     

    

    

 
    
 
    [bookmark: pgfId-710972]Step 1 Install and connect the device to your network. Install the device software and perform basic device configuration. Install the licenses required for all of the services running on the device. The amount of initial configuration that you perform influences what you will need to configure in Security Manager. For information about required basic settings, see:

 
     
     		 [bookmark: pgfId-710977]Setting Up SSL on Cisco IOS Routers

 
     		 [bookmark: pgfId-710982]Setting Up SSH

 
     		 [bookmark: pgfId-710987]Configuring Licenses on Cisco IOS Devices

 
     		 [bookmark: pgfId-710992]Initial Preparation of a Cisco IOS IPS Router

 
     		 [bookmark: pgfId-710997]Selecting a Signature Category for Cisco IOS IPS

 
    

 
    [bookmark: pgfId-711002]Step 2 Add the device to the Security Manager device inventory (see Adding Devices to the Device Inventory). When you add the device be sure to make the following selections:

 
     
     		 [bookmark: pgfId-711004]When adding from Network or Export File, ensure that you select  IPS Policies for policy discovery.

 
     		 [bookmark: pgfId-711006]When adding from Configuration File or by Manual Definition, ensure that you select  IPS from the  Options list, or the device will not be IPS-capable from Security Manager’s point of view.

 
    

 
    [bookmark: pgfId-711011]Step 3 Configure the IPS general settings to specify the location of the IPS files on the router. For more information, see Configuring General Settings for Cisco IOS IPS.

 
    [bookmark: pgfId-711016]Step 4 Configure the IPS interface rules to enable IPS and to identify the interfaces on which traffic will be subject to IPS inspection. For more information, see Configuring IOS IPS Interface Rules.

 
    [bookmark: pgfId-711018]Step 5 Configure IPS signatures and event actions. Event action policies are easier to configure than creating custom signatures, so try to use event action filters and overrides to modify signature behavior before trying to edit specific signatures. For more information, see the following topics:

 
     
     		 [bookmark: pgfId-711023]Chapter 40, “Configuring Event Action Rules”

 
     		 [bookmark: pgfId-711028]Configuring Signatures

 
    

 
    [bookmark: pgfId-711030]Step 6 Maintain the device:

 
     
     		 [bookmark: pgfId-711032]Update and redeploy configurations as necessary.

 
     		 [bookmark: pgfId-711037]Apply updated signature and engine packages. For information about checking for updates, applying them, and setting up regular automated updates, see Managing IPS Updates.

 
    

 
    [bookmark: pgfId-711039]


    
     

    
 
    

 
     
      [bookmark: pgfId-711049][bookmark: 105299][bookmark: ipsvchap_proc_PreparationforUse]Initial Preparation of a Cisco IOS IPS Router[bookmark: marker-711045][bookmark: marker-711047]

 
     [bookmark: pgfId-711053]Before you add a Cisco IOS IPS router to the Security Manager inventory, you need to perform some preparatory steps. The white paper Getting Started with Cisco IOS IPS with 5.x Format Signatures on Cisco.com provides a step-by-step explanation of a basic configuration. Although you could do some of the steps after adding the router to Security Manager, such as configuring interface rules, you should do at least the basic steps.

 
     [bookmark: pgfId-711055]The following procedure explains the steps you are required to complete in the CLI. These steps are required because Security Manager either cannot complete them, or it is simply easier to do it in the CLI (as a one-time configuration). The white paper includes additional steps that you can complete in the CLI, and Security Manager can discover your configuration when you add the device to the inventory. The more you do in CLI, the less you will have to configure in Security Manager.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-711066]Tip You also must complete the basic router configuration steps as explained in Setting Up SSL on Cisco IOS Routers, Setting Up SSH, and Configuring Licenses on Cisco IOS Devices. The following steps apply to the IPS configuration only.


     
      

     

     

 
     
 
     [bookmark: pgfId-711068]Step 1 Create a directory for IPS files on flash. For example, the following command creates a directory named ips:

 
     
      [bookmark: pgfId-711070]router# mkdir ips
     

     
      [bookmark: pgfId-711072]Create directory filename [ips]?
     

     
      [bookmark: pgfId-711074]Created dir flash:ips
     

     
      [bookmark: pgfId-711076] 
     

     [bookmark: pgfId-711078]At this point, you can optionally configure the router to use this directory for IPS, or you can do it later in Security Manager (in the IPS > General Settings policy). Use the following commands to configure it in CLI:

 
     
      [bookmark: pgfId-711080]router# configure terminal
     

     
      [bookmark: pgfId-711082]router(config)# ip ips config location flash:ips
     

     
      [bookmark: pgfId-711084] 
     

     [bookmark: pgfId-711086]Step 2 Configure the Cisco IOS IPS crypto key. The crypto key is used to verify the digital signature for the master signature file (sigdef-default.xml) whose contents are signed by a Cisco private key to guarantee its authenticity and integrity at every release.

 
     [bookmark: pgfId-711090]You can obtain the CLI required for the key from http://download-sj.cisco.com/cisco/ciscosecure/ids/sigup/5.0/ios/realm-cisco.pub.key.txt (login to Cisco.com is required).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-711095]Tip Configuring the key through the CLI is probably the easiest way to do it. Alternatively, you can configure it in Security Manager by assigning the IOS_IPS_PUBLIC_KEY pre-defined FlexConfig object to the router’s FlexConfig policy. For more information about FlexConfigs, see Chapter 7, “Managing FlexConfigs”.


     
      

     

     

 
     [bookmark: pgfId-711097] a. Open the text file and copy its contents to the clipboard (select all text then press Ctrl+C).

 
     [bookmark: pgfId-711099] b. If necessary, enter configure terminal at the router CLI prompt.

 
     [bookmark: pgfId-711101] c. Paste the copied text file at the router prompt.

 
     [bookmark: pgfId-711103] d. Exit configuration mode.

 
     [bookmark: pgfId-711105] e. Enter the show run command to confirm that the key was correctly configured.

 
     [bookmark: pgfId-711107]Step 3 Syslog is configured for IPS notifications by default. If you want to use SDEE for notifications, enable SDEE:

 
     
      [bookmark: pgfId-711109]router# configure terminal
     

     
      [bookmark: pgfId-711111]router(config)# ip ips notify sdee
     

     
      [bookmark: pgfId-711113] 
     

     [bookmark: pgfId-711118]Step 4 Select a signature category to compile. For detailed information, see Selecting a Signature Category for Cisco IOS IPS.

 
     [bookmark: pgfId-711120]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-711132][bookmark: 105357][bookmark: ipsvchap_cncpt_SelectingaSignatureCategoryforCiscoIOSIPS]Selecting a Signature Category for Cisco IOS IPS[bookmark: marker-711126][bookmark: marker-711128][bookmark: marker-711130]

 
     [bookmark: pgfId-711134]Cisco IPS appliances and Cisco IOS IPS with IPS 5.x format signatures operate with signature categories. All signatures are grouped into categories; the categories are hierarchical. An individual signature can belong to more than one category. Top-level categories help to define general types of signatures. Subcategories exist beneath each top-level signature category. (For a list of supported top-level categories, use your router CLI help (?) with the category command.)

 
     [bookmark: pgfId-711136]Router memory and resource constraints prevent a router from loading all Cisco IOS IPS signatures. Thus, it is recommended that you load only a selected set of signatures that are defined by the categories. Because the categories are applied in a “top-down” order, you should first retire all signatures, followed by “unretiring” specific categories. Retiring signatures enables the router to load information for all signatures, but the router does not build the parallel scanning data structure.

 
     [bookmark: pgfId-711138]Retired signatures are not scanned by Cisco IOS IPS, so they do not fire alarms. If a signature is irrelevant to your network or if you want to save router memory, you should retire signatures, as appropriate.

 
     [bookmark: pgfId-711143]Security Manager does not manage the signature category command. You cannot configure it directly with a policy. However, you can configure the FlexConfig policy to include a FlexConfig object that configures the command. There is a pre-defined object, IOS_IPS_SIGNATURE_CATEGORY, that you can use. If you want to configure a different category than basic, make a copy of the object and edit it. For information on how to use FlexConfigs, see Chapter 7, “Managing FlexConfigs”.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-711145]Tip If you do not use the category command to select a subset of IPS signatures that the device will attempt to compile, Security Manager will configure the category command to enable the IOS IPS Basic category to prevent the device resources from being overloaded. You can change the category manually on the device to select another set of signatures to compile. We recommend that you configure the category before adding the device to Security Manager; however, this is not possible if you add the device through manual definition.


     
      

     

     

 
     [bookmark: pgfId-711188]Navigation Path

 
      
      		 [bookmark: pgfId-711190](Device view) Select  IPS > General Settings from the Policy selector.

 
      		 [bookmark: pgfId-711192](Policy view) Select  IPS (Router) > General Settings , then select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-711194]Related Topics

 
      
      		 [bookmark: pgfId-711199]Overview of Cisco IOS IPS Configuration

 
      		 [bookmark: pgfId-711204]Understanding Cisco IOS IPS

 
     

 
     [bookmark: pgfId-711206]Field Reference

 
     [bookmark: pgfId-711209] 

 
      
       
        
        [bookmark: pgfId-709901]Table 45-1 [bookmark: 105432]General Settings Page 

 
        
       
         
         		
           
           [bookmark: pgfId-709907]Element
          
  
         		
           
           [bookmark: pgfId-709909]Description
          
  
        

 
         
         		[bookmark: pgfId-709915]Block Traffic when IPS engine is unavailable

  
         		[bookmark: pgfId-709917]Whether to block all inspected traffic if the IPS engine is not available, for example, when the signature engine is being built or if it fails to build.

 [bookmark: pgfId-709919]If you select this option, any traffic specified for inspection is dropped if IPS cannot process it (also known as fail-closed mode). Otherwise, traffic is allowed to pass in accordance with the other rules in place on the router (the default).

  
        

 
         
         		[bookmark: pgfId-709925]Apply Deny Action On

  
         		[bookmark: pgfId-709927]Where to apply ACL entries to drop traffic for Deny Attacker Inline or Deny Flow Inline events. Select one of the following values:

 
           
           		 [bookmark: pgfId-709929] Ingress Interface (the default)—Enforce the deny action on the interface attached to the network from which the traffic originated.

 
           		 [bookmark: pgfId-709931] IPS enabled interfaces —Enforce the deny action on the interface on which the triggered IPS rule is applied.

 
          

 [bookmark: pgfId-709939]Enabling this option causes IOS IPS to apply the ACLs directly to the IPS interfaces, and not to the interfaces that originally received the attack traffic. If the router is not performing load balancing, do not enable this setting. If the router is performing load balancing, we recommend that you enable this setting.[bookmark: marker-709933][bookmark: marker-709935][bookmark: marker-709937]

  
        

 
         
         		 
           
           [bookmark: pgfId-709945]SDEE Properties
          
  
        

 
         
         		[bookmark: pgfId-709953]Maximum Subscriptions

  
         		[bookmark: pgfId-709957]The maximum number of concurrent SDEE subscriptions allowed, in the range of 1-3. An SDEE subscription is a live feed of SDEE events.[bookmark: marker-709955]

 [bookmark: pgfId-709959]The default is 1.

  
        

 
         
         		[bookmark: pgfId-709965]Maximum Alerts

  
         		[bookmark: pgfId-709967]The maximum number of SDEE alerts that you want the router to store, in the range of 10-2000. Storing more alerts uses more router memory.

 [bookmark: pgfId-709969]The default is 200.

  
        

 
         
         		[bookmark: pgfId-709975]Maximum Messages

  
         		[bookmark: pgfId-709977]The maximum number of SDEE messages that you want the router to store, in the range of 10-500. Storing more messages uses more router memory.

 [bookmark: pgfId-709979]The default is 200.

  
        

 
         
         		 
           
           [bookmark: pgfId-709985]IPS Config Location Properties
          
  
        

 
         
         		[bookmark: pgfId-709993]IPS Config Location

  
         		[bookmark: pgfId-709995]The location where the router will save IOS IPS specific configuration files. These configuration files are automatically updated every time the IOS IPS configuration is changed or updated from Security Manager. When the router reboots, the IOS IPS configuration is retrieved and restored from these configuration files.

 [bookmark: pgfId-709997]To specify a location on the router, enter the name of the directory. The directory must already exist; Security Manager does not create it. For example, flash:ips.

 [bookmark: pgfId-709999]Note If the router has a LEFS-based file system, you will be unable to create a directory in router memory. In this case, flash: is used as the config location.

 [bookmark: pgfId-710001]To specify a location on a remote system, specify the protocol and path of the URL needed to reach the location. For example, if you want to save the config files to an HTTP server, then enter http://172.27.108.5/ips-cfg.

 [bookmark: pgfId-710003]Supported servers for saving the IOS IPS configuration files are: http://, https://, ftp://, rcp://, scp://, and tftp://.

  
        

 
         
         		[bookmark: pgfId-710009]Max retries

  
         		[bookmark: pgfId-710011]When storing configuration files on a remote system, how many times the router is to attempt to contact the remote system.

 [bookmark: pgfId-710013]The default is 1.

  
        

 
         
         		[bookmark: pgfId-710019]Timeout seconds between retries

  
         		[bookmark: pgfId-710021]When storing configuration files on a remote system, how long the router is to wait before attempting to contact the configuration location again.

 [bookmark: pgfId-710023]The default is 1.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-711223][bookmark: 105523][bookmark: ipsvchap_cncpt_InterfaceRules]Configuring IOS IPS Interface Rules[bookmark: marker-711217][bookmark: marker-711219][bookmark: marker-711221]

 
     [bookmark: pgfId-711225]Use the IPS Interface Rules policy to enable IPS inspection on Cisco IOS IPS routers and to specify the interfaces that will be subject to IPS inspection. You can identify a subset of the traffic on the interface that is subject to inspection by configuring an ACL and by specifying the traffic direction relative to the interface.

 
     [bookmark: pgfId-711227]Related Topics

 
      
      		 [bookmark: pgfId-711232]Overview of Cisco IOS IPS Configuration

 
      		 [bookmark: pgfId-711237]Understanding Cisco IOS IPS

 
     

 
     
 
     [bookmark: pgfId-711239]Step 1 Do one of the following to open the Interface Rules policy you want to modify:

 
      
      		 [bookmark: pgfId-711241](Device view) Select  IPS > Interface Rules from the Policy selector.

 
      		 [bookmark: pgfId-711243](Policy view) Select  IPS (Router) > Interface Rules from the Policy selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-711245]The policy shows any existing interface rules, including the rule name, the name of the ACL that defines which traffic is inspected (if any), and the interface and traffic direction that is inspected. If no ACL is specified, all traffic on the interface in the specified direction is inspected.

 
     [bookmark: pgfId-711247]Although the rules are numbered, the sequence of rules has no effect on IPS processing.

 
     [bookmark: pgfId-711249]Step 2 Select Enable IPS to enable the deployment of IOS IPS configuration to the device.

 
     [bookmark: pgfId-711251]If Enable IPS is unchecked, IPS rules are removed from all the router interfaces, which disables IPS. Also, no signature or event action policy will be deployed.

 
     [bookmark: pgfId-711253]Step 3 Configure the interface rules. The rules identify the interfaces, and traffic direction on the interface, that will be inspected by IPS. The rules can optionally include an ACL to identify a subset of traffic for inspection.

 
      
      		 [bookmark: pgfId-711258]To add a rule, click the  Add Row (+) button and fill in the Add IPS Rule dialog box. For detailed information, see IPS Rule Dialog Box.

 
      		 [bookmark: pgfId-711260]To edit a rule, select it and click the  Edit Row (pencil) button.

 
      		 [bookmark: pgfId-711262]To delete a rule, select it and click the  Delete Row (trash can) button.

 
     

 
     [bookmark: pgfId-711264]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-711274][bookmark: 105577][bookmark: ipspage_cncpt_AddIPSRuleDialogBox]IPS Rule Dialog Box[bookmark: marker-711272]

 
     [bookmark: pgfId-711276]Use the Add or Edit IPS Rule dialog box to identify the traffic flows to be inspected using the active signature policy.

 
     [bookmark: pgfId-711278]Navigation Path

 
     [bookmark: pgfId-711283]From the Interface Rules policy, click the Add Row button to add a new rule, or select a rule and click the Edit Row button. For information on opening the Interface Rules policy, see Configuring IOS IPS Interface Rules.

 
     [bookmark: pgfId-711285]Field Reference

 
     [bookmark: pgfId-711288] 

 
      
       
        
        [bookmark: pgfId-710036]Table 45-2 [bookmark: 105593]Add or Edit IPS Rule Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-710042]Element
          
  
         		
           
           [bookmark: pgfId-710044]Description
          
  
        

 
         
         		[bookmark: pgfId-710050]Rule Name

  
         		[bookmark: pgfId-710052]The unique name for this IPS rule.

 [bookmark: pgfId-710054]IPS rule names are not case sensitive. You cannot use a rule name that contains the same characters as another one previously defined but using a different case. For example MYRULE and MyRule are the same.

  
        

 
         
         		[bookmark: pgfId-710060]ACL Name

  
         		[bookmark: pgfId-710062]The name of the ACL policy object that defines which traffic should be subject to IPS inspection. If you do not specify an ACL, all traffic on the interface/direction pairs listed in the Interface Pairs table is subject to inspection.

 [bookmark: pgfId-710064]Tip If you create an ACL, permit entries identify traffic that is subject to inspection, whereas deny entries identify traffic that is exempt from inspection. Remember that there is an implicit deny any any rule at the end of the ACL, so if your intention is simply to identify exempt traffic, be sure to add a permit any any rule at the end of the ACL. [bookmark: pgfId-710066]Enter the name of the ACL policy object, or click Select to select it from a list or to create a new object.

  
        

 
         
         		[bookmark: pgfId-710072]Interface Pairs table

  
         		[bookmark: pgfId-710074]The interfaces and traffic direction pairs that are subject to IPS inspection.

 
           
           		 [bookmark: pgfId-710079]To add a pair, click the  Add Row (+) button and fill in the Adding Pair dialog box. See Pair Dialog Box.

 
           		 [bookmark: pgfId-710081]To edit a pair, select it and click the  Edit Row (pencil) button.

 
           		 [bookmark: pgfId-710083]To delete a pair, select it and click the  Delete Row (trash can) button.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-711298][bookmark: 105634][bookmark: ipspage_cncpt_AddingPairDialogBox]Pair Dialog Box[bookmark: marker-711296]

 
     [bookmark: pgfId-711303]Use the Adding or Editing Pair dialog box to identify the interface and traffic direction pair to add to a Cisco IOS IPS interface rule. For information on configuring interface rules, see Configuring IOS IPS Interface Rules.

 
     [bookmark: pgfId-711305]Navigation Path

 
     [bookmark: pgfId-711310]From the Add or Edit IPS Rule dialog box, click the Add Row button to add a new pair, or select a pair and click the Edit Row button. For information on opening the Add or Edit IPS Rule dialog box, see IPS Rule Dialog Box.

 
     [bookmark: pgfId-711312]Field Reference

 
     [bookmark: pgfId-711315] 

 
      
       
        
        [bookmark: pgfId-710096]Table 45-3 [bookmark: 105651]Adding or Editing Pair Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-710102]Element
          
  
         		
           
           [bookmark: pgfId-710104]Description
          
  
        

 
         
         		[bookmark: pgfId-710110]Direction

  
         		[bookmark: pgfId-710112]The traffic direction, with respect to the interface, on which IPS inspection should be performed. Select one of the following:

 
           
           		 [bookmark: pgfId-710114] In (default)—The IPS rule should be applied to inbound traffic.

 
           		 [bookmark: pgfId-710116] Out —The IPS rule should be applied to outbound traffic.

 
           		 [bookmark: pgfId-710118] Both —The IPS rule should be applied to both inbound and outbound traffic.

 
          

  
        

 
         
         		[bookmark: pgfId-710124]Interfaces

  
         		[bookmark: pgfId-710126]The interface on which to apply this IPS rule. Enter the name of an interface or interface role object, or click Select to select the interface or interface role from a list or to create a new interface role.

 [bookmark: pgfId-710128]If you use interface roles, the rule is applied to all interfaces on the device that are defined by the role. The interfaces that match the role cannot conflict with an existing rule. You cannot specify the same interface for more than one interface rule.
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     [bookmark: pgfId-810994][bookmark: 60468][bookmark: porules_cncpt_ManagingTransparentFirewallRules]Managing Transparent Firewall Rules[bookmark: marker-810990][bookmark: marker-810992]
      
      
 
     
 

 
    [bookmark: pgfId-810996]Transparent firewall rules are access control rules for non-IP layer 2 traffic. You can use these rules to permit or drop traffic based on the Ethertype value in the layer-2 packet.

 
    [bookmark: pgfId-810998]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-811003]Configuring Transparent Firewall Rules

 
     		 [bookmark: pgfId-811008]Transparent Rules Page

 
    

 
   
 
    
     [bookmark: pgfId-811024][bookmark: 60478][bookmark: porules_proc_ConfiguringTransparentFirewallRules]Configuring Transparent Firewall Rules [bookmark: marker-811016][bookmark: marker-811018][bookmark: marker-811020][bookmark: marker-811022]

 
    [bookmark: pgfId-811029]Transparent firewall rules are access control rules for non-IP layer 2 traffic. You can use these rules to permit or drop traffic based on the Ethertype value in the layer-2 packet. These rules create Ethertype access control lists on the device. With transparent rules, you can control the flow of non-IP traffic across the device. (To control IP traffic, use access rules; see Understanding Access Rules.)

 
    [bookmark: pgfId-811031]Transparent firewalls are devices that you place within a single subnet to control traffic flow across a bridge. They allow you to insert a firewall on a subnet without renumbering your networks.

 
    [bookmark: pgfId-811033]You can configure transparent rules only on the following types of interfaces:

 
     
     		 [bookmark: pgfId-811037] IOS 12.3(7)T or higher devices —On layer-3 interfaces that are part of a bridge group:[bookmark: marker-811035]

 
    

 
    [bookmark: pgfId-811039] – Configure the interfaces you want to bridge as layer 3 in the Interfaces > Interfaces policy.

 
    [bookmark: pgfId-811047] – Configure a bridge group with two or more layer 3 interfaces in the Platform > Device Admin > Bridging policy (see Bridging on Cisco IOS Routers and Defining Bridge Groups).

 
    [bookmark: pgfId-811052] – Create a bridge group virtual interface (BVI) using the same number as the bridge group (see Bridge-Group Virtual Interfaces). For example, if you create bridge group 12, create BVI12.

 
     
     		 [bookmark: pgfId-811060] ASA, PIX 7.0+, FWSM devices —On any interface when the device is running in transparent mode. If you are using multiple contexts, configure the rules on the individual security contexts.[bookmark: marker-811054][bookmark: marker-811056][bookmark: marker-811058]

 
    

 
    [bookmark: pgfId-811068]There are several other bridging policies that you can configure in the Platform > Bridging policy group including: ARP table and ARP inspection, MAC table and the ability to disable MAC learning, and the ability to configure a management IP address so that you can remotely manage the device. For more detail about transparent firewalls, see Chapter 47, “Configuring Bridging Policies on Firewall Devices” and Interfaces in Routed and Transparent Modes.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-811070]Tip On ASA, PIX, and FWSM in transparent mode, you must configure access rules to allow any IP traffic to pass through the device. Transparent rules control layer 2 non-IP traffic only.


    
     

    

    

 
    [bookmark: pgfId-811075]Also, see NAT in Transparent Mode for information about using network address translation on security devices.

 
    [bookmark: pgfId-811077]You can also configure other types of firewall rules on these interfaces. The other types of rules apply to layer-3 and higher traffic.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-811079]Tip If you configure any transparent rule, an implicit deny all rule is added at the end of the rule list for each interface. You must ensure that you permit all desired traffic. You might want to include a permit any (for ASA/PIX/FWSM devices) or permit 0x0000 0xFFFF (for IOS devices) rule as the final rule in the table if your desire is simply to deny specific types of traffic, rather than permitting only specific types of traffic.


    
     

    

    

 
    [bookmark: pgfId-811081]Related Topics

 
     
     		 [bookmark: pgfId-811086]Adding and Removing Rules

 
     		 [bookmark: pgfId-811091]Editing Rules

 
     		 [bookmark: pgfId-811096]Enabling and Disabling Rules

 
    

 
    
 
    [bookmark: pgfId-811101]Step 1 Do one of the following to open the Transparent Rules Page:

 
     
     		 [bookmark: pgfId-811103](Device view) Select  Firewall > Transparent Rules from the Policy selector for a supported device type.

 
     		 [bookmark: pgfId-811105](Policy view) Select  Firewall > Transparent Rules from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-811110]Step 2 Select the row after which you want to create the rule and click the Add Row button or right-click and select Add Row. This opens the Add and Edit Transparent Firewall Rule Dialog Boxes.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-811115]Tip If you do not select a row, the new rule is added at the end of the local scope. You can also select an existing row and edit either the entire row or specific cells. For more information, see Editing Rules.


    
     

    

    

 
    [bookmark: pgfId-811120]Step 3 Configure the rule. Following are the highlights of what you typically need to decide. For specific information on configuring the fields, see Add and Edit Transparent Firewall Rule Dialog Boxes.

 
     
     		 [bookmark: pgfId-811122]Permit or Deny—Whether you are allowing traffic that matches the rule or dropping it.

 
     		 [bookmark: pgfId-811124]Interfaces—The interface or interface role for which you are configuring the rule.

 
     		 [bookmark: pgfId-811126]The direction of traffic to which this rule should apply (in or out). The default is in.

 
     		 [bookmark: pgfId-811130]EtherType—The hexadecimal code or keyword (for ASA/PIX/FWSM only) that identifies the traffic. For a list of codes, see RFC 1700 at  http://www.ietf.org/rfc/rfc1700.txt and search for “Ether Type.” For ASA/PIX/FWSM, you can select a keyword to identify some EtherTypes. For ASA/PIX/FWSM, the code must be 0x0600 at minimum.

 
     		 [bookmark: pgfId-811132]Mask—For rules applied to IOS devices, you must also specify a mask to apply to the EtherType. Use 0xFFFF to have the EtherType interpreted literally.

 
    

 
    [bookmark: pgfId-811134]If you want to create a single rule to apply to a group of EtherTypes, convert the EtherTypes to binary and calculate an appropriate mask where 1 means to interpret the EtherType literally, and 0 means that any value should be allowed in the position. You must then convert your mask into hexadecimal.

 
    [bookmark: pgfId-811136]Click OK when you are finished defining your rule.

 
    [bookmark: pgfId-811141]Step 4 If you did not select the right row before adding the rule, select the new rule and use the up and down arrow buttons to position the rule appropriately. For more information, see Moving Rules and the Importance of Rule Order.

 
    [bookmark: pgfId-811149]Step 5 (IOS devices only) If you are configuring transparent rules on an IOS device, you can forward DHCP traffic across the bridge without inspection. To configure this, select the Firewall > Settings > Inspection policy and select the Permit DHCP Passthrough (Transparent Firewall) option. This setting is not supported on all IOS versions, so carefully inspect validation results to see if it will be configured on your device.[bookmark: marker-811143][bookmark: marker-811145][bookmark: marker-811147]

 
    [bookmark: pgfId-811151]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-811165][bookmark: 60609][bookmark: fwlsvcpg_cncpt_TransparentRulesPage]Transparent Rules Page[bookmark: marker-811159][bookmark: marker-811161][bookmark: marker-811163]

 
    [bookmark: pgfId-811170]Use the Transparent Rules page to control access for non-IP layer-2 traffic. (To control IP traffic access, use access rules; see Understanding Access Rules.)

 
    [bookmark: pgfId-811172]Transparent rules are limited to transparent firewalls, which are ASA, PIX 7.0+, and FWSM devices running in transparent mode, or layer-3 interfaces that are part of a bridge group on IOS 12.3(7)T+ devices. When deployed, transparent rules become Ethertype access control lists.

 
    [bookmark: pgfId-811174]Configure the same rules on all bridged interfaces to allow traffic to pass both ways through the device.

 
    [bookmark: pgfId-811179]For more detailed information about configuring transparent firewalls and the device requirements for deploying these rules, see Configuring Transparent Firewall Rules.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-811184]Tip Disabled rules are shown with hash marks covering the table row. When you deploy the configuration, disabled rules are removed from the device. For more information, see Enabling and Disabling Rules.


    
     

    

    

 
    [bookmark: pgfId-811186]Navigation Path

 
    [bookmark: pgfId-811188]To access Transparent Rules, do one of the following:

 
     
     		 [bookmark: pgfId-811190](Device view) Select  Firewall > Transparent Rules from the Policy selector for a supported device type.

 
     		 [bookmark: pgfId-811192](Policy view) Select  Firewall > Transparent Rules from the Policy Type selector. Select an existing policy or create a new one.

 
     		 [bookmark: pgfId-811194](Map view) Right-click a device and select  Edit Firewall Policies > Transparent Rules .

 
    

 
    [bookmark: pgfId-811196]Related Topics

 
     
     		 [bookmark: pgfId-811201]Interfaces in Routed and Transparent Modes.

 
     		 [bookmark: pgfId-811206]Chapter 47, “Configuring Bridging Policies on Firewall Devices”

 
     		 [bookmark: pgfId-811211]Bridging on Cisco IOS Routers

 
     		 [bookmark: pgfId-811216]Defining Bridge Groups

 
     		 [bookmark: pgfId-811221]Bridge-Group Virtual Interfaces

 
     		 [bookmark: pgfId-811226]Filtering Tables

 
    

 
    [bookmark: pgfId-811228]Field Reference

 
    [bookmark: pgfId-811231] 

 
     
      
       
       [bookmark: pgfId-810089]Table 23-1 [bookmark: 60666]Transparent Rules Page 

 
       
      
        
        		
          
          [bookmark: pgfId-810095]Element
         
  
        		
          
          [bookmark: pgfId-810097]Description
         
  
       

 
        
        		[bookmark: pgfId-810103]No.

  
        		[bookmark: pgfId-810105]The ordered rule number.

  
       

 
        
        		[bookmark: pgfId-810111]Permit

  
        		[bookmark: pgfId-810113]Whether a rule permits or denies traffic based on the conditions set:

 
          
          		 [bookmark: pgfId-810115]Permit—Shown as a green check mark.

 
          		 [bookmark: pgfId-810117]Deny—Shown as a red circle with slash.

 
         

  
       

 
        
        		[bookmark: pgfId-810123]EtherType

  
        		[bookmark: pgfId-810125]The Ethernet packet type, which is the EtherType value in the packet. This can be a hexadecimal code or a keyword.

  
       

 
        
        		[bookmark: pgfId-810131]Mask

  
        		[bookmark: pgfId-810133]The 16-bit hexadecimal mask for the EtherType (for IOS devices only). A mask of 0xFFFF indicates the EtherType is literal. Any other mask indicates the corresponding bits in the EtherType to ignore. You must convert the hexadecimal number to binary to fully interpret the mask (binary 1 means interpret the corresponding EtherType value literally, 0 means allow any value at that position).

  
       

 
        
        		[bookmark: pgfId-810139]Interface

  
        		[bookmark: pgfId-810144]The interfaces or interface roles to which the rule is assigned. Interface role objects are replaced with the actual interface names when the configuration is generated for each device. Multiple entries are displayed as separate subfields within the table cell. See Understanding Interface Role Objects.

  
       

 
        
        		[bookmark: pgfId-810150]Dir.

  
        		[bookmark: pgfId-810152]The direction of the traffic to which this rule applies:

 
          
          		 [bookmark: pgfId-810154]In—Packets entering the interface.

 
          		 [bookmark: pgfId-810156]Out—Packets exiting the interface.

 
         

  
       

 
        
        		[bookmark: pgfId-810162]Category

  
        		[bookmark: pgfId-810167]The category assigned to the rule. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
        
        		[bookmark: pgfId-810173]Description

  
        		[bookmark: pgfId-810175]The description of the rule, if any.

  
       

 
        
        		[bookmark: pgfId-810181]Last Ticket(s)

  
        		[bookmark: pgfId-810186]Shows the ticket(s) associated with last modification to the rule. You can click the ticket ID in the Last Ticket(s) column to view details of the ticket and to navigate to the ticket. If linkage to an external ticket management system has been configured, you can also navigate to that system from the ticket details (see Ticket Management Page).

  
       

 
        
        		[bookmark: pgfId-810192]Up Row and Down Row buttons (arrow icons)

  
        		[bookmark: pgfId-810197]Click these buttons to move the selected rules up or down within a scope or section. For more information, see Moving Rules and the Importance of Rule Order.

  
       

 
        
        		[bookmark: pgfId-810203]Add Row button

  
        		[bookmark: pgfId-810211]Click this button to add a rule to the table after the selected row using the Add and Edit Transparent Firewall Rule Dialog Boxes. If you do not select a row, the rule is added at the end of the local scope. For more information about adding rules, see Adding and Removing Rules.

  
       

 
        
        		[bookmark: pgfId-810217]Edit Row button

  
        		[bookmark: pgfId-810222]Click this button to edit the selected rule. You can also edit individual cells. For more information, see Editing Rules.

  
       

 
        
        		[bookmark: pgfId-810228]Delete Row button

  
        		[bookmark: pgfId-810230]Click this button to delete the selected rule.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-811247][bookmark: 60758][bookmark: fwlsvcpg_cncpt_AddandEditTransparentFirewallRuleDialogBoxes]Add and Edit Transparent Firewall Rule Dialog Boxes[bookmark: marker-811239][bookmark: marker-811241][bookmark: marker-811243][bookmark: marker-811245]

 
     [bookmark: pgfId-811252]Use the Add and Edit Transparent Firewall Rule dialog boxes to add and edit transparent firewall rules, which are configured as EtherType access control lists on the device. Before you configure transparent rules, read Configuring Transparent Firewall Rules.

 
     [bookmark: pgfId-811254]Navigation Path

 
     [bookmark: pgfId-811259]From the Transparent Rules Page, click the Add Row button or select a row and click the Edit Row button.

 
     [bookmark: pgfId-811261]Related Topics

 
      
      		 [bookmark: pgfId-811266]Interfaces in Routed and Transparent Modes.

 
      		 [bookmark: pgfId-811271]Chapter 47, “Configuring Bridging Policies on Firewall Devices”

 
      		 [bookmark: pgfId-811276]Bridging on Cisco IOS Routers

 
      		 [bookmark: pgfId-811281]Defining Bridge Groups

 
      		 [bookmark: pgfId-811286]Bridge-Group Virtual Interfaces

 
      		 [bookmark: pgfId-811291]Editing Rules

 
      		 [bookmark: pgfId-811296]Adding and Removing Rules

 
     

 
     [bookmark: pgfId-811298]Field Reference

 
     [bookmark: pgfId-811301] 

 
      
       
        
        [bookmark: pgfId-810243]Table 23-2 [bookmark: 60808]Add and Edit Transparent Firewall Rule Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-810249]Element
          
  
         		
           
           [bookmark: pgfId-810251]Description
          
  
        

 
         
         		[bookmark: pgfId-810257]Enable Rule

  
         		[bookmark: pgfId-810262]Whether to enable the rule, which means the rule becomes active when you deploy the configuration to the device. Disabled rules are shown overlain with hash marks in the rule table. For more information, see Enabling and Disabling Rules.

  
        

 
         
         		[bookmark: pgfId-810268]Action

  
         		[bookmark: pgfId-810270]Whether the rule permits or denies traffic based on the conditions you define.

  
        

 
         
         		[bookmark: pgfId-810276]Interfaces

  
         		[bookmark: pgfId-810281]The interfaces or interface roles to which the rule is assigned. You must select only bridged, transparent interfaces (for more specific information, see Configuring Transparent Firewall Rules).

 [bookmark: pgfId-810283]Enter the name of the interface or the interface role, or click Select to select the interface or role from a list, or to create a new role. An interface must already be defined to appear on the list.

 [bookmark: pgfId-810288]Interface role objects are replaced with the actual interface names when the configuration is generated for each device. See Understanding Interface Role Objects.

  
        

 
         
         		[bookmark: pgfId-810294]Traffic Direction

  
         		[bookmark: pgfId-810296]The direction of the traffic to which this rule applies:

 
           
           		 [bookmark: pgfId-810298]In—Packets entering an interface.

 
           		 [bookmark: pgfId-810300]Out—Packets exiting an interface.

 
          

  
        

 
         
         		[bookmark: pgfId-810306]EtherType

  
         		[bookmark: pgfId-810308]The hexadecimal code or keyword (for ASA/PIX/FWSM only) that identifies the traffic based on the EtherType value in the packet. Enter or select the following:

 
           
           		 [bookmark: pgfId-810312]The hexadecimal EtherType value. For a list of codes, see RFC 1700 at  http://www.ietf.org/rfc/rfc1700.txt and search for “Ether Type.”

 
          

 [bookmark: pgfId-810314] – IOS devices—You can enter any value from 0x0000 to 0xFFFF.

 [bookmark: pgfId-810316] – ASA/PIX/FWSM devices—The value must be 0x0600 or higher.

 
           
           		 [bookmark: pgfId-810318]For ASA/PIX/FWSM devices, you can also select these keywords:

 
          

 [bookmark: pgfId-810320] – bpdu—Spanning Tree Bridge Protocol Data Units

 [bookmark: pgfId-810322] – ipx—Internet Packet Exchange

 [bookmark: pgfId-810324] – mpls-unicast—Multi-Protocol Label Switching, unicast.

 [bookmark: pgfId-810326] – mpls-multicast—MPLS multicast.

 [bookmark: pgfId-810328] – isis

 [bookmark: pgfId-810330] – any—Any packet regardless of EtherType.

 [bookmark: pgfId-810332]Tip The keyword "isis" in the list above refers to IS-IS pass-through support, which is new in Security Manager 4.4. "IS-IS pass-through support" means that IS-IS traffic can flow through the ASA in transparent mode.  
        

 
         
         		[bookmark: pgfId-810338]Wildcard Mask (IOS)

  
         		[bookmark: pgfId-810340]The mask is a 16-bit hexadecimal number that determines how the EtherType code is interpreted.

 [bookmark: pgfId-810342]A mask of 0xFFFF indicates the EtherType is literal. Any other mask indicates the corresponding bits in the EtherType to ignore. You must convert the hexadecimal number to binary to fully interpret the mask (binary 1 means interpret the corresponding EtherType value literally, 0 means allow any value at that position).

  
        

 
         
         		[bookmark: pgfId-810348]Category

  
         		[bookmark: pgfId-810353]The category assigned to the rule. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-810359]Description

  
         		[bookmark: pgfId-810361]An optional description of the rule (up to 1024 characters).

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-811315][bookmark: 60897][bookmark: fwlsvcpg_cncpt_EditTransparentEtherTypeDialogBox]Edit Transparent EtherType Dialog Box [bookmark: marker-811309][bookmark: marker-811311][bookmark: marker-811313]

 
     [bookmark: pgfId-811322]Use the Edit Transparent EtherType dialog box to edit the EtherType in a transparent firewall rule. Enter the hexadecimal code that identifies the traffic. For ASA/PIX/FWSM devices, you can also select the keyword for some types of traffic. For a list of codes, see RFC 1700 at http://www.ietf.org/rfc/rfc1700.txt and search for “Ether Type.” For a more detailed description of EtherType, see Add and Edit Transparent Firewall Rule Dialog Boxes.

 
     [bookmark: pgfId-811327]For more information, see Configuring Transparent Firewall Rules.

 
     [bookmark: pgfId-811329]Navigation Path

 
     [bookmark: pgfId-811334]Right-click the EtherType cell in a transparent rule (on the Transparent Rules Page) and select Edit EtherType. You can edit the EtherType for one row at a time.

 
    
 
     
      [bookmark: pgfId-811348][bookmark: 60920][bookmark: fwlsvcpg_cncpt_EditTransparentMaskDialogBox]Edit Transparent Mask Dialog Box[bookmark: marker-811342][bookmark: marker-811344][bookmark: marker-811346]

 
     [bookmark: pgfId-811350]Use the Edit Transparent Mask dialog box to edit the mask in a transparent firewall rule for an IOS device. The mask is a 16-bit hexadecimal number that determines how the EtherType code is interpreted.

 
     [bookmark: pgfId-811352]A mask of 0xFFFF indicates the EtherType is literal. Any other mask indicates the corresponding bits in the EtherType to ignore. You must convert the hexadecimal number to binary to fully interpret the mask (binary 1 means interpret the corresponding EtherType value literally, 0 means allow any value at that position).

 
     [bookmark: pgfId-811357]For more information, see Configuring Transparent Firewall Rules.

 
     [bookmark: pgfId-811359]Navigation Path

 
     [bookmark: pgfId-811364]Right-click the Mask cell in a transparent rule (on the Transparent Rules Page) and select Edit Mask. You can edit the mask for one row at a time.
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     [bookmark: pgfId-511146][bookmark: 4696][bookmark: ivman_cncpt_ManagingDevices]Managing the Device Inventory[bookmark: marker-511142][bookmark: marker-511144]
      
      
 
     
 

 
    [bookmark: pgfId-511148]Before you can manage devices in Security Manager, you must prepare the devices for management, then add those devices to the Security Manager device inventory. After you add the devices, you can view and edit device information, configure policies on devices, copy and share policies, clone devices, and so on. The following topics describe how to manage the device inventory:

 
     
     		 [bookmark: pgfId-511153]Understanding the Device Inventory

 
     		 [bookmark: pgfId-511158]Adding Devices to the Device Inventory

 
     		 [bookmark: pgfId-511163]Working with the Device Inventory

 
     		 [bookmark: pgfId-511168]Working with Device Groups

 
     		 [bookmark: pgfId-511173]Working with Device Status View

 
    

 
   
 
    
     [bookmark: pgfId-511183][bookmark: 4721][bookmark: ivman_cncpt_UnderstandingtheDeviceInventory]Understanding the Device Inventory[bookmark: marker-511179][bookmark: marker-511181]

 
    [bookmark: pgfId-511185]Security Manager maintains an inventory of the devices that it manages. The inventory includes the information required to locate and log into the device, so that your policies can be deployed to the devices. The following topics describe some general concepts related to the device inventory:

 
     
     		 [bookmark: pgfId-511190]Understanding the Device View

 
     		 [bookmark: pgfId-511195]Understanding Device Names and What Is Considered a Device

 
     		 [bookmark: pgfId-511200]Understanding Device Credentials

 
     		 [bookmark: pgfId-511205]Understanding Device Properties

 
    

 
     
      [bookmark: pgfId-511217][bookmark: 4743][bookmark: ivman_cncpt_UnderstandingtheDeviceView]Understanding the Device View[bookmark: marker-511215]

 
     [bookmark: pgfId-511219]The Device View button opens the Devices page, from which you can add and delete devices from the Security Manager inventory and manage device policies, properties, and interfaces centrally.

 
     [bookmark: pgfId-511221]This is a device-centric view in which you can see all devices that you are managing and you can select specific devices to view their properties and define their settings and policies. You can define security policies locally on specific devices. You can then share those policies to make them globally available to be assigned to other devices.

 
     [bookmark: pgfId-511223]The Devices page contains two panes. The left pane contains two elements: the Device selector, located in the top left pane, and the Policy selector, located in the bottom left pane. The right pane is the main content area. The following illustration shows the Devices page.

 
     [bookmark: pgfId-511227]Figure 3-1 [bookmark: 4753]Devices Page

 
     [bookmark: pgfId-511230] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-511232]Device selector (1, 3, 4, 5)—Contains the following:

 
      
      		 [bookmark: pgfId-511234]Add and Delete buttons (4, 5)—Enables you to add and delete devices from the Security Manager inventory.

 
      		 [bookmark: pgfId-511239]Filter field (3)—Enables you to display a subset of devices based on the filtering criteria you define. For details, see Filtering Items in Selectors.

 
      		 [bookmark: pgfId-511244]Device tree—Lists the device groups and devices that exist in the system. Each device type is represented by an icon. For information about the icons, see Figure 3-2.

 
     

 
     [bookmark: pgfId-511249]If you hover the mouse pointer over a device, detailed information about the device appears in a popup window. The information is a summary of the device properties (see Device Properties: General Page).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-511251]Note Beginning from version 4.8, Security Manager displays the updated version information of a device that has been upgraded using Auto Update Server (AUS). To enable this feature you must configure Security Manager details in the AUS user interface. If you hover the mouse over a device, the following message appears if AUS has successfully updated the device version:


     
      

     

     

 
     [bookmark: pgfId-511259]Figure 3-2 [bookmark: 4772]Device Icons

 
     [bookmark: pgfId-511263] 

 
      
      [image: ] 
     
 
      
       
       
         
         		
           
           [bookmark: pgfId-507979]1
          
  
         		[bookmark: pgfId-507981]Adaptive Security Appliances (ASA)

  
         		
           
           [bookmark: pgfId-507983]5
          
  
         		[bookmark: pgfId-507985]Catalyst Switch

  
        

 
         
         		
           
           [bookmark: pgfId-507995]2
          
  
         		[bookmark: pgfId-507997]PIX Firewall

  
         		
           
           [bookmark: pgfId-507999]6
          
  
         		[bookmark: pgfId-508001]Catalyst 7600 Series Router

  
        

 
         
         		
           
           [bookmark: pgfId-508011]3
          
  
         		[bookmark: pgfId-508013]Catalyst security Services Modules: Firewall Services Module (FWSM) and ASA-SM

  
         		
           
           [bookmark: pgfId-508015]7
          
  
         		[bookmark: pgfId-508017]VPN 3000 Concentrator

  
        

 
         
         		
           
           [bookmark: pgfId-508027]4
          
  
         		[bookmark: pgfId-508029]Cisco IOS Router

  
         		
           
           [bookmark: pgfId-508031]8
          
  
         		[bookmark: pgfId-508033]Intrusion Prevention System (IPS)

  
        

 
       
      

 
     
 
      
      		 [bookmark: pgfId-511265]Shortcut menu options—When you right-click a device or device group, you get a menu of commands related to that device or group. These commands are shortcuts to commands available in the regular menus.

 
     

 
     [bookmark: pgfId-511267]Policy selector (2)—Contains the following:

 
      
      		 [bookmark: pgfId-511269]Policy groups—Lists the policy groups that are supported on the selected device type. The policy groups that are displayed are dependent on four factors:

 
     

 
     [bookmark: pgfId-511271] – The type of device selected in the Device selector.

 
     [bookmark: pgfId-511273] – The operating system running on the device.

 
     [bookmark: pgfId-511275] – The target operating system version selected for determining which commands will be available for generated configurations.

 
     [bookmark: pgfId-511277] – Whether the device contains supported service modules.

 
     [bookmark: pgfId-511282]For more information about policies, see Understanding Policies.

 
      
      		 [bookmark: pgfId-511284]Shortcut menu options—When you right-click a policy, you get a menu of commands related to that policy. These commands are shortcuts to commands available in the regular menus.

 
     

 
     [bookmark: pgfId-511286]Contents pane (6)—The main content area.

 
     [bookmark: pgfId-511288]The information displayed in this area depends on the device you select from the Device selector and the option you select from the Policy selector.

 
    
 
     
      [bookmark: pgfId-511302][bookmark: 4850][bookmark: ivman_cncpt_UnderstandingDeviceNamesandWhatIsConsideredaDevice]Understanding Device Names and What Is Considered a Device[bookmark: marker-511294][bookmark: marker-511296][bookmark: marker-511298][bookmark: marker-511300]

 
     [bookmark: pgfId-511304]Besides managing traditional devices, you can use Security Manager to manage virtual devices that you can define on some types of security devices. These virtual devices are treated as separate devices in the device inventory, and they appear as separate entries in the device selectors. Because these virtual devices actually reside on a host physical device, many actions, such as deployment, will have to include the host device as well as the virtual device.

 
     [bookmark: pgfId-511306]All physical devices appear in the device selectors. In addition, these are the types of virtual devices that appear in the device selectors:

 
      
      		 [bookmark: pgfId-511308]Security Contexts—You can define security contexts on PIX Firewall, FWSM, and ASA devices. Security contexts act as virtual firewalls. By default, security contexts appear in the device selectors using this naming convention:  host-display-name_context-name , where  host-display-name is the display name of the device on which the context is defined, and  context-name is the name of the security context. For example, the admin security context on the device named firewall12 would be called firewall12_admin.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-511313]Tip You can control whether the display name is added to the context name using the Prepend Device Name when Generating Security Context Names property on the Discovery settings page (see Discovery Page). However, if you do not add the display name, it is very difficult to determine the hosting device for a context, and the context names are not sorted with the host device (they do not appear in a folder attached to the host device). If you do not add the display name, Security Manager adds a numeric suffix to the context name if more than one context of the same name is added to the inventory (for example, admin_01, admin_02), and these numbers are not related to the host device.


     
      

     

     

 
      
      		 [bookmark: pgfId-511315]Virtual Sensors—You can define virtual sensors on IPS devices. Virtual sensors appear in device selectors using the  host-display-name_virtual-sensor-name naming convention, and there is not a discovery setting to control this convention.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-511317]Tip You can always change the display name for a virtual sensor, security context, or other type of device in the device’s properties.


     
      

     

     

 
     [bookmark: pgfId-511319]Besides the naming conventions for virtual devices, you also need to understand the relationship between various types of device names:

 
      
      		 [bookmark: pgfId-511321]Display name—The display name is simply the name that appears within Security Manager in device selectors. This name does not have to be related to any name actually defined on the device. When you add devices to the inventory, a display name is suggested based on the DNS name or IP address you enter, but you can use whatever naming convention you want to use.

 
      		 [bookmark: pgfId-511323]DNS name—The DNS name you define for a device must be resolvable by the DNS server configured for the Security Manager server.

 
      		 [bookmark: pgfId-511325]IP address—The IP address you define for a device should be the management IP address for the device.

 
      		 [bookmark: pgfId-511327]Hostname—When you discover a device, the hostname property that is shown in the device properties is taken from the device’s configuration. If you add devices using configuration files, and a file does not contain a hostname command, the initial hostname is the name of the configuration file.

 
     

 
     [bookmark: pgfId-511329]However, the hostname device property is not updated if you change the hostname on the device. There is a Hostname policy in the device platform policy area, and it is this Hostname policy that determines the hostname that is defined on the device.

 
    
 
     
      [bookmark: pgfId-511343][bookmark: 4891][bookmark: ivman_cncpt_UnderstandingDeviceCredentials]Understanding Device Credentials[bookmark: marker-511335][bookmark: marker-511337][bookmark: marker-511339][bookmark: marker-511341]

 
     [bookmark: pgfId-511345]Security Manager requires credentials for logging in to devices. You can provide device credentials in two ways:

 
      
      		 [bookmark: pgfId-511347]When you add a device manually or from network discovery. For more information, see these topics:

 
     

 
     [bookmark: pgfId-511352] – Adding Devices from the Network

 
     [bookmark: pgfId-511357] – Adding Devices by Manual Definition

 
      
      		 [bookmark: pgfId-511362]By editing the device properties. For more information, see Viewing or Changing Device Properties.

 
     

 
     [bookmark: pgfId-511364]You can provide the following device credentials:

 
      
      		 [bookmark: pgfId-511366]Primary Credentials—The username and password for logging into the device using SSH or Telnet. This information is required for device communication.

 
      		 [bookmark: pgfId-511368]HTTP Credentials—Some devices allow HTTP or HTTPS connections, and some devices (such as IPS devices) require it. By default, Security Manager uses the primary credentials for HTTP/HTTPS access, but you can configure unique HTTP/HTTPS credentials.

 
      		 [bookmark: pgfId-511370]RX-Boot Mode—(Optional) Some Cisco routers are designed to run from flash memory where they boot only from the first file in flash. This means that you must run an image other than the one in flash to upgrade the flash image. That image is a reduced command-set image referred to as RX-Boot (a ROM-based image).

 
      		 [bookmark: pgfId-511372]SNMP Credentials—(Optional) The Simple Network Management Protocol (SNMP) facilitates the exchange of management information between network devices. SNMP enables network administrators to manage network performance, find and solve network problems, and plan for network growth.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-511374]Note PIX/ASA/FWSM devices require that user names be at least four characters. Passwords can be three to 32 characters; we recommend that passwords be at least eight characters.


     
      

     

     

 
     [bookmark: pgfId-511376]Rather than using device-based credentials, you can configure Security Manager to use the credentials you use when you log into Security Manager. You can then use the AAA server’s accounting facilities to track configuration changes by user. Using user login credentials is suitable only if your environment is configured according to these standards:

 
      
      		 [bookmark: pgfId-511378]You use TACACS+ or RADIUS for change auditing. User-login credentials will be reflected in these accounting records. If you use device credentials, all changes made through Security Manager will come from the same account, regardless of which user made the change.

 
      		 [bookmark: pgfId-511380]User accounts are configured in the AAA server, and they have appropriate device-level access to perform configuration changes.

 
      		 [bookmark: pgfId-511384]You configure Security Manager and the managed devices to use the AAA server for authorization. For information on configuring Security Manager to use AAA, see the  Installation Guide for Cisco Security Manager .

 
      		 [bookmark: pgfId-511386]You do not use one-time passwords.

 
     

 
     [bookmark: pgfId-511388]If your network setup supports using user-login credentials, you can configure Security Manager to use them by selecting Tools > Security Manager Administration. Select Device Communication from the table of contents, and select Security Manager User Login Credentials in the Connect to Device Using field. The default is to use device credentials for all device access.

 
     [bookmark: pgfId-511390]Related Topics

 
      
      		 [bookmark: pgfId-511395]Device Credentials Page

 
      		 [bookmark: pgfId-511400]Adding Devices to the Device Inventory

 
      		 [bookmark: pgfId-511405]Device Communication Page

 
     

 
    
 
     
      [bookmark: pgfId-511415][bookmark: 4959][bookmark: ivman_cncpt_UnderstandingDeviceProperties]Understanding Device Properties[bookmark: marker-511411][bookmark: marker-511413]

 
     [bookmark: pgfId-511417]You define device properties when you add devices to Security Manager. Device properties are general information about the device, credentials, the group the device is assigned to, and policy overrides. You must provide some device property information, such as device identity and primary credentials, when you add the device, but you can add or edit the properties from the Device Properties dialog box.

 
     [bookmark: pgfId-511419]To view the device properties, do one of the following in the Device selector:

 
      
      		 [bookmark: pgfId-511421]Double-click a device.

 
      		 [bookmark: pgfId-511423]Right-click a device and select  Device Properties .

 
      		 [bookmark: pgfId-511425]Select a device and select  Tools > Device Properties .

 
     

 
     [bookmark: pgfId-511427]The Device Properties dialog box has two panes. The left pane contains a table of contents with these items:

 
      
      		 [bookmark: pgfId-511429]General—Contains general information about the device, such as device identity, the operating system running on the device, and device communication settings.

 
      		 [bookmark: pgfId-511431]Credentials—Contains device primary credentials (username, password, and enable password), SNMP credentials, Rx-Boot Mode credentials, and HTTP credentials.

 
      		 [bookmark: pgfId-511433]Device Groups—Contains the groups to which the device is assigned.

 
      		 [bookmark: pgfId-511435]Cluster Information—Contains detailed informatio for the cluster group, if any.

 
      		 [bookmark: pgfId-511437]Policy Object Overrides—Contains global settings of certain types of reusable policy objects that you can override for this device.

 
     

 
     [bookmark: pgfId-511439]When you select an item in the table of contents, the corresponding information is displayed in the right pane.

 
     [bookmark: pgfId-511441]Notes

 
      
      		 [bookmark: pgfId-511443]Security Manager does not assume that the DNS hostname that appears on the Device Properties page is the same as the hostname that you configured on the device.

 
      		 [bookmark: pgfId-511445]When you add a device to Security Manager, you must enter either the management IP address or the DNS hostname. Because it is not possible to determine the management interface and, therefore, the management IP address when you discover from a configuration file, the hostname in the configuration file is used as the DNS hostname. If the hostname is missing in the CLI of the configuration file, the configuration filename is used as the DNS hostname.

 
      		 [bookmark: pgfId-511447]When you discover a device from the network, the DNS hostname in the Device Properties page is not updated with the hostname configured on the device. Therefore, if you want to specify the DNS hostname for the device, you must specify it manually when you add the device to Security Manager or on the Device Properties page.

 
     

 
     [bookmark: pgfId-511452]For more information about device properties, see Viewing or Changing Device Properties.

 
    
 
   
 
    
     [bookmark: pgfId-511468][bookmark: 5004][bookmark: ivman_cncpt_AddingDevicestotheSecurityManagerInventory]Adding Devices to the Device Inventory[bookmark: marker-511460][bookmark: marker-511462][bookmark: marker-511464][bookmark: marker-511466]

 
    [bookmark: pgfId-511473]When you add a device to Security Manager, you specify the identifying information for the device, such as its DNS name and IP address. This information is added during device discovery. You can also bring in existing network configurations associated with a device by initiating policy discovery. For complete information on policy discovery, see Discovering Policies. Once you add the device, it appears in the Security Manager device inventory.

 
    [bookmark: pgfId-511475]The New Device wizard guides you through the process of adding devices to the inventory. You can add devices from many different sources, and the path through the wizard differs significantly based on the method you are using.

 
    [bookmark: pgfId-511477]To start the New Device wizard, from Device view, select File > New Device, or click the Add button in the device selector.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-511482]Note There is also another way to add devices. If you exported a .dev file from another Security Manager server, which contains not only a device inventory but also the policies and policy objects assigned to them, you can import the file using the File > Import command. For more information, see Importing Policies or Devices.


    
     

    

    

 
    [bookmark: pgfId-511484]Tips on Adding Devices and Service Modules

 
     
     		 [bookmark: pgfId-511488]For PIX Firewalls and FWSM and ASA devices that are configured for failover, add only the active unit to Security Manager. Ensure that the device is configured with a management IP address and use that address for discovery. When discovering Catalyst switches that contain more than one service module (FWSM or ASA-SM) configured for failover, when prompted, select  Do Not Discover Module for the failover modules. Security Manager always manages the active admin context, regardless of whether you added the primary or secondary failover service module.[bookmark: marker-511486]

 
     		 [bookmark: pgfId-511495]Security Manager can manage ASA clusters after they have been configured as a cluster using the CLI bootstrapping as defined in the ASA Configuration Guide (see  http://www.cisco.com/en/US/products/ps6120/products_installation_and_configuration_guides_list.html ). All the members of a cluster are assigned individual IP addresses during the bootstrap process. When adding a cluster to Security Manager, you do so by discovering the cluster using the main cluster IP address. The main cluster IP address is a fixed address for the cluster that always belongs to the current master unit. This is not the master unit’s individual IP Address. For more information about clusters, see Working with Device Clusters.

 
     		 [bookmark: pgfId-511501]Service modules are treated as separate devices. For most modules, you must add the service module separately from its host device. However, Security Manager can automatically discover FWSM or IDSM modules in a Catalyst 6500 device, so you need only add the parent device. (You cannot discover an ASA-SM during discovery of the parent device. You must add the ASA-SM separately.) The only exception is if you configure an FWSM or IDSM module to use a non-default port for HTTPS (SSL), in which case you must add the module separately.[bookmark: marker-511497][bookmark: marker-511499]

 
     		 [bookmark: pgfId-511508]When adding an ASA-SM or FWSM that has multiple security contexts (they are running in multiple-context mode), do not add the security contexts individually using their management IP addresses. Instead, add the device using the admin context management address (this also adds the individual contexts). Then, configure Security Manager to deploy configurations to multiple-context devices serially as described in Changing How Security Manager Deploys Configurations to Multiple-Context FWSM.[bookmark: marker-511506]

 
     		 [bookmark: pgfId-511516]You cannot add devices beyond the device limits defined by your Security Manager license. For example, if you have a license for 50 devices, and there are 45 devices in the inventory, if you try to add a multiple-context ASA with 6 security contents, the device addition and discovery fails.[bookmark: marker-511510][bookmark: marker-511512][bookmark: marker-511514]

 
    

 
    [bookmark: pgfId-511518]The following topics describe the various methods of adding devices:

 
     
     		 [bookmark: pgfId-511523] Add Device from Network —To add devices that are currently active on the network, see Adding Devices from the Network. Security Manager connects directly and securely to the device and discovers its identifying information and properties.

 
    

 
    [bookmark: pgfId-511525] – Pros—You need to specify minimal information about a device, and Security Manager obtains the detailed information directly from the device, ensuring accuracy.

 
    [bookmark: pgfId-511527] – Cons—You can add only one device at a time. You cannot add devices that have dynamic IP addresses, unless you determine the device’s current IP address, add it using that address, and then update the device properties in Security Manager to identify the Configuration Engine that is managing the device.

 
     
     		 [bookmark: pgfId-511532] Add from Configuration File —To add devices by using a copy of the device configuration files, see Adding Devices from Configuration Files.

 
    

 
    [bookmark: pgfId-511534] – Pros—You can add more than one device at a time.

 
    [bookmark: pgfId-511536] – Cons—You cannot use this method to add Catalyst 6500/7600 or IPS devices. When adding groups of configuration files, all files must be for the same device type.

 
    [bookmark: pgfId-511548]Also, you cannot successfully discover policies that require a connection with the device. For example, if a policy points to a file that resides on the device, adding the device using the configuration file will result in a Security Manager configuration that includes the no form of the command, because Security Manager cannot retrieve the referenced file from the device. For example, the svc image command for web VPNs might be negated.[bookmark: marker-511538][bookmark: marker-511540][bookmark: marker-511542][bookmark: marker-511544][bookmark: marker-511546]

 
     
     		 [bookmark: pgfId-511553] Add New Device —To add a device that does not yet exist in the network, so that you can pre-provision it in Security Manager, see Adding Devices by Manual Definition. You can create the device in the system, assign policies to the device, and generate configuration files before installing the device hardware.

 
    

 
    [bookmark: pgfId-511555] – Pros—You can pre-provision devices that do not yet exist in the network.

 
    [bookmark: pgfId-511557] – Cons—You must specify more information than that required by any other method. If you create a Catalyst 6500 device, or a router that contains an IPS module, you should discover its modules by selecting Policy > Discover Policies on Device.

 
     
     		 [bookmark: pgfId-511562] Add Device from File —To add devices from an inventory file in comma-separated values (CSV) format, see Adding Devices from an Inventory File.

 
    

 
    [bookmark: pgfId-511564] – Pros—You can add multiple devices of different types at one time. You can reuse the inventory list from your other network management applications, including CiscoWorks Common Services, Cisco Security Monitoring, Analysis and Response System (CS-MARS), and other Security Manager servers. If you use a file exported from another Security Manager server, you can optionally add the devices without discovering policies, which is convenient for adding offline or standby devices.

 
    [bookmark: pgfId-511566] – Cons—You cannot use this method to update the properties of devices already defined in the inventory. Also, policy discovery can fail if you attempt to import more than 100 devices at one time, and might fail for even fewer devices. In the case of IPS devices, do not add more than four IPS devices at a time to avoid policy discovery failures.

 
     
      [bookmark: pgfId-511578][bookmark: 5132][bookmark: ivman_cncpt_WorkingwithGenericDevices]Working with Generically Supported Devices[bookmark: marker-511572][bookmark: marker-511574][bookmark: marker-511576]

 
     [bookmark: pgfId-511580]Security Manager can manage some device models even if the model does not appear in the supported device list. This type of generic device support relies on the fact that device features are controlled more by the software running on the device than the device model. If you have a device that does not appear in the explicitly supported device list, you can try to manage it as a generic device using the device modules listed in the table below.

 
     [bookmark: pgfId-511582]You can add a generic router using any of the various methods for adding devices:

 
      
      		 [bookmark: pgfId-511584]If you are adding a router directly from the network that is not natively supported and can be generically supported, Security Manager automatically discovers the device as a generic router. You will be prompted whether you want to add the generic device or cancel the operation.

 
      		 [bookmark: pgfId-511589]If you are adding a generic router by manual definition or from a configuration file, you must select the appropriate generic device type according to the OS running on the router (see Table 3-1).

 
      		 [bookmark: pgfId-511591]If you are adding a generic router from an inventory file, you must make sure that you use the correct SYSOBJID in the CSV file. Use 1.0.0.0.0.0.0.0.1 for devices running Cisco IOS Software (Cisco Generic Integrated Services Router) and use 1.0.0.0.0.0.0.0.2 for devices running Cisco IOS XE Software (Cisco Generic Aggregation Services Router).

 
     

 
     [bookmark: pgfId-511593]Tips

 
      
      		 [bookmark: pgfId-511595]Generic router support encompasses ISR and ASR hardware models that are not natively supported. It does not encompass software versions that are not yet supported. In other words, Security Manager allows you to manage unsupported hardware platforms if those platforms are running a supported software release. This type of generic support works best for new models of series that are already explicitly supported. For example, a new model in the ASR 1000 series, or in the ISR 88x or 89x series. Generic support does not work with carrier-class routers (the CRS) or for Catalyst switches.

 
      		 [bookmark: pgfId-511597]Because this support is generic, Security Manager cannot determine if a particular feature is not available on the specific model you are managing. You are responsible for determining if a feature that you are allowed to configure in Security Manager is supported on the device. If you configure an unsupported feature, you will see errors when you deploy the configuration to the device.

 
      		 [bookmark: pgfId-511599]If the device contains an explicitly supported module, such as an AIM-IPS module, the module is also supported. However, the module’s model must be explicitly supported: there is no generic module support.

 
     

 
     [bookmark: pgfId-511602] 

 
      
       
        
        [bookmark: pgfId-508046]Table 3-1 [bookmark: 5162]Cisco Security Manager Generically Supported Devices 

 
        
       
         
         		
           
           [bookmark: pgfId-508052]Generic Device Type
          
  
         		
           
           [bookmark: pgfId-508054]When To Use
          
  
        

 
         
         		[bookmark: pgfId-508060]Cisco Generic Aggregation Services Router

  
         		[bookmark: pgfId-508062]For devices running Cisco IOS XE Software.

  
        

 
         
         		[bookmark: pgfId-508068]Cisco Generic Integration Services Router

  
         		[bookmark: pgfId-508070]For devices running Cisco IOS Software.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-511616][bookmark: 5183][bookmark: ivman_cncpt_WorkingwithDeviceClusters]Working with Device Clusters[bookmark: marker-511608][bookmark: marker-511610][bookmark: marker-511612][bookmark: marker-511614]

 
     [bookmark: pgfId-511618]Clustering lets you group multiple ASAs together as a single logical device. A cluster provides all the convenience of a single device (management, integration into a network) while achieving the increased throughput and redundancy of multiple devices. Clustering is supported on ASA 5580 and 5585 devices running 9.0(1) or later and on ASA 5512-X, 5515-X, 5525-X, 5545-X and 5555-X devices running 9.1(4) or later.

 
     [bookmark: pgfId-511622]Security Manager can manage ASA clusters after they have been configured as a cluster using the CLI bootstrapping as defined in the ASA Configuration Guide (see http://www.cisco.com/en/US/products/ps6120/products_installation_and_configuration_guides_list.html).

 
     [bookmark: pgfId-511624]All the members of a cluster are assigned individual IP addresses during the bootstrap process. When adding a cluster to Security Manager, you do so by discovering the cluster using the main cluster IP address. The main cluster IP address is a fixed address for the cluster that always belongs to the current master unit. This is not the master unit’s individual IP Address.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-511626]Note You cannot convert a standalone device to a cluster in Security Manager by rediscovering the device after performing the necessary CLI bootstrapping. You must first delete the device from Security Manager, and then after performing the necessary CLI bootstrapping, you can add the cluster to Security Manager as a new device.


     
      

     

     

 
     [bookmark: pgfId-511628]The cluster is represented as a single device in Security Manager. After the cluster has been added to Security Manager, you can finish configuring the cluster settings such as cluster interfaces and security policies.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-511632]Note Clustering has specific configuration requirements and restrictions. Please refer to the ASA documentation at http://www.cisco.com/en/US/products/ps6120/products_installation_and_configuration_guides_list.html for detailed information about requirements, configuration recommendations, and performance information.


     
      

     

     

 
     [bookmark: pgfId-511634]Unsupported Features on ASA Clusters

 
     [bookmark: pgfId-511636]These features cannot be configured with clustering enabled, and the commands will be rejected.

 
      
      		 [bookmark: pgfId-511638]Unified Communications

 
      		 [bookmark: pgfId-511640]Remote access VPN (SSL VPN and IPsec VPN)

 
      		 [bookmark: pgfId-511642]The following application inspections:

 
     

 
     [bookmark: pgfId-511644] – CTIQBE

 
     [bookmark: pgfId-511646] – GTP

 
     [bookmark: pgfId-511648] – H323, H225, and RAS

 
     [bookmark: pgfId-511650] – IPsec passthrough

 
     [bookmark: pgfId-511652] – MGCP

 
     [bookmark: pgfId-511654] – MMP

 
     [bookmark: pgfId-511656] – RTSP

 
     [bookmark: pgfId-511658] – SIP

 
     [bookmark: pgfId-511660] – SCCP (Skinny)

 
     [bookmark: pgfId-511662] – WAAS

 
     [bookmark: pgfId-511664] – WCCP

 
      
      		 [bookmark: pgfId-511666]Botnet Traffic Filter

 
      		 [bookmark: pgfId-511668]Auto Update Server

 
      		 [bookmark: pgfId-511670]DHCP client, server, relay, and proxy

 
      		 [bookmark: pgfId-511672]VPN load balancing

 
      		 [bookmark: pgfId-511674]Failover

 
      		 [bookmark: pgfId-511676]ASA CX module

 
     

 
     [bookmark: pgfId-511678]Centralized Features

 
     [bookmark: pgfId-511680]The following features are only supported on the master unit, and are not scaled for the cluster. For example, you have a cluster of eight units (5585-X with SSP-60). The Other VPN license allows a maximum of 10,000 IPsec tunnels for one ASA 5585-X with SSP-60. For the entire cluster of eight units, you can only use 10,000 tunnels; the feature does not scale.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-511684]Note Traffic for centralized features is forwarded from member units to the master unit over the cluster control link; see "Sizing the Cluster Control Link" in the ASA documentation to ensure adequate bandwidth for the cluster control link.

If you use the rebalancing feature, traffic for centralized features may be rebalanced to non-master units before the traffic is classified as a centralized feature; if this occurs, the traffic is then sent back to the master unit. 

For centralized features, if the master unit fails, all connections are dropped, and you have to re-establish the connections on the new master unit.


     
      

     

     

 
      
      		 [bookmark: pgfId-511686]Site-to-site VPN

 
      		 [bookmark: pgfId-511688]The following application inspections:

 
     

 
     [bookmark: pgfId-511690] – DCERPC

 
     [bookmark: pgfId-511692] – NetBios

 
     [bookmark: pgfId-511694] – PPTP

 
     [bookmark: pgfId-511696] – RADIUS

 
     [bookmark: pgfId-511698] – RSH

 
     [bookmark: pgfId-511700] – SUNRPC

 
     [bookmark: pgfId-511702] – TFTP

 
     [bookmark: pgfId-511704] – XDMCP

 
      
      		 [bookmark: pgfId-511706]Dynamic routing (spanned EtherChannel mode only)

 
      		 [bookmark: pgfId-511708]Multicast routing (individual interface mode only)

 
      		 [bookmark: pgfId-511710]Static route monitoring

 
      		 [bookmark: pgfId-511712]IGMP multicast control plane protocol processing (data plane forwarding is distributed across the cluster)

 
      		 [bookmark: pgfId-511714]PIM multicast control plane protocol processing (data plane forwarding is distributed across the cluster)

 
      		 [bookmark: pgfId-511716]Authentication and Authorization for network access. Accounting is decentralized.

 
      		 [bookmark: pgfId-511718]Filtering Services

 
     

 
     [bookmark: pgfId-511720]Features Applied to Individual Units

 
     [bookmark: pgfId-511722]These features are applied to each ASA unit, instead of the cluster as a whole.

 
      
      		 [bookmark: pgfId-511724]QoS—The QoS policy is synced across the cluster as part of configuration replication. However, the policy is enforced on each unit independently. For example, if you configure policing on output, then the conform rate and conform burst values are enforced on traffic exiting a particular ASA. In a cluster with 8 units and with traffic evenly distributed, the conform rate actually becomes 8 times the rate for the cluster.

 
      		 [bookmark: pgfId-511726]Threat detection—Threat detection works on each unit independently; for example, the top statistics is unit-specific. Port scanning detection, for example, does not work because scanning traffic will be load-balanced between all units, and one unit will not see all traffic.

 
      		 [bookmark: pgfId-511728]Resource management—Resource management in multiple context mode is enforced separately on each unit based on local usage.

 
      		 [bookmark: pgfId-511730]IPS module—There is no configuration sync or state sharing between IPS modules. Some IPS signatures require IPS to keep the state across multiple connections. For example, the port scanning signature is used when the IPS module detects that someone is opening many connections to one server but with different ports. In clustering, those connections will be balanced between multiple ASA devices, each of which has its own IPS module. Because these IPS modules do not share state information, the cluster may not be able to detect port scanning as a result.

 
     

 
     [bookmark: pgfId-511732]Related Topics

 
      
      		 [bookmark: pgfId-511737]Cluster Information Page

 
     

 
    
 
     
      [bookmark: pgfId-511749][bookmark: 5312][bookmark: ivman_proc_AddingDevicesfromtheNetwork]Adding Devices from the Network[bookmark: marker-511745][bookmark: marker-511747]

 
     [bookmark: pgfId-511751]One of the easiest and most reliable ways to add devices to the inventory is to identify devices that are active in the network. By providing the IP address (or DNS hostname) of a device, and the credentials required to log into it, Security Manager can obtain much of the information it needs directly from the device, ensuring the accuracy of the information.

 
     [bookmark: pgfId-511753]Before You Begin

 
     [bookmark: pgfId-511755]Before beginning this procedure, ensure the following preparations have been made:

 
      
      		 [bookmark: pgfId-511760]Prepare the devices to be managed by Security Manager. For more information, see Chapter 2, “Preparing Devices for Management”.

 
      		 [bookmark: pgfId-511764]If you are using ACS for authentication, define the devices in ACS. See the  Installation Guide for Cisco Security Manager .

 
     

 
     [bookmark: pgfId-511766]Related Topics

 
      
      		 [bookmark: pgfId-511771]Understanding the Device View

 
      		 [bookmark: pgfId-511776]Working with Device Groups

 
      		 [bookmark: pgfId-511781]Viewing or Changing Device Properties

 
     

 
     
 
     [bookmark: pgfId-511783]Step 1 In Device view, select File > New Device or click the New Device button in the Device selector. The New Device wizard opens to the Choose Method page.

 
     [bookmark: pgfId-511785]Step 2 On the Choose Method page, select Add Device from Network and click Next to open the Device Information page.

 
     [bookmark: pgfId-511790]Step 3 On the Device information page, at minimum fill in the following fields. For a detailed explanation of all fields, see Device Information Page – Add Device from Network.

 
      
      		 [bookmark: pgfId-511792]Enter either a hostname and DNS name, or an IP address (or both).

 
      		 [bookmark: pgfId-511794]Enter a display name, which is the name that will appear in the Security Manager Device selector.

 
      		 [bookmark: pgfId-511796]Select the correct operating system and version. If you are configuring a Catalyst switch or a 7600 router, ensure that you select  IOS - Catalyst Switch/7600 rather than one of the other IOS entries.

 
      		 [bookmark: pgfId-511801]Select the transport protocol that should be used to log into the device, if the device is configured to use a protocol that differs from the default defined in Security Manager. The default is set on the Device Communication administration page (see Device Communication Page).

 
     

 
     [bookmark: pgfId-511803]Click Next.

 
     [bookmark: pgfId-511805]Step 4 On the Device Credentials page, enter the usernames and passwords required to log into the device. Enter at least the primary device credentials, which are the traditional User EXEC mode and Privileged EXEC mode passwords.

 
     [bookmark: pgfId-511810]For information on the different types of credentials, see Device Credentials Page.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-511815]Tip When you click Next or Finished from the Device Credentials page, Security Manager tests whether it can connect to the device. You cannot add the device unless the test succeeds. For more information, see Testing Device Connectivity.


     
      

     

     

 
     [bookmark: pgfId-511820]Step 5 (Optional) Click Next to open the Device Grouping page, and select the device group to which the imported devices should be added (see Device Groups Page).

 
     [bookmark: pgfId-511825]Step 6 Click Finish. Security Manager opens the Discovery Status dialog box where you can view the status of the device discovery and policy analysis (see Discovery Status Dialog Box).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-511830]Note If you are adding a router that is not natively supported and can be generically supported, Security Manager automatically discovers the device as a generic router. You will be prompted whether you want to add the generic device or cancel the operation. For more information about generic device support, see Working with Generically Supported Devices.
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     [bookmark: pgfId-511835]Tip If you are discovering policies while adding a device, carefully read any messages that are presented to you. These messages can contain important recommendations on the next steps you should take. For example, when you add Cisco IOS routers or Catalyst devices, we recommend that you immediately deploy the discovered configuration to a file so that Security Manager can take over ownership of the configuration. For more information about deployment methods, see Understanding Deployment Methods.


     
      

     

     

 
     [bookmark: pgfId-511837]Step 7 If you are adding a device that contains modules, and Security Manager supports discovering modules for that type of device, you are notified when the discovery of the device chassis is complete and you are asked if you want to discover the device’s modules. When you click Yes, you are prompted for this information:

 
      
      		 [bookmark: pgfId-511842]Catalyst 6500 service modules—The Service Module Credentials dialog box opens prompting for the following information, based on the modules contained in the chassis. For more information, see Service Module Credentials Dialog Box.

 
     

 
     [bookmark: pgfId-511844] – FWSM—The management IP address (recommended), the username and passwords, and the type of discovery you want to perform. If the FWSM is the second device in a failover pair, select Do Not Discover Module for the failover module. (Security Manager always manages the active admin context, regardless of whether you added the primary or secondary failover service module.)

 
     [bookmark: pgfId-511846] – IDSM—The username and password and the type of discovery you want to perform.

 
     [bookmark: pgfId-511848] – ASA-SM—Discovering ASA service modules in a Catalyst 6500 through the chassis is not supported. You must directly add the ASA-SM using the management IP address of the ASA-SM.

 
      
      		 [bookmark: pgfId-511853]IPS Router Module—The type of discovery you want to perform, the management IP address, the username and password, and other SSL connection information. For more information, see IPS Module Discovery Dialog Box.

 
     

 
     [bookmark: pgfId-511855]You can skip discovery for any module you do not want to manage in Security Manager.

 
     [bookmark: pgfId-511857]Click OK. You are returned to the Discovery Status dialog box, where you can view the progress of service module discovery. When finished, close the window and the device is added to the inventory list. A message will explain if you need to submit the activity for all devices to appear in the list (for example, individual security contexts defined on an ASA device).

 
     [bookmark: pgfId-511862]Step 8 If you added a device that is managed by an Auto Update Server or Configuration engine, with the device selected in the device selector, select Tools > Device Properties. Select the server used with the device in the Auto Update or Configuration Engine settings. You can add the server if it is not listed. For more information, see Adding, Editing, or Deleting Auto Update Servers or Configuration Engines.

 
     [bookmark: pgfId-511864]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-511876][bookmark: 5415][bookmark: ivpage_cncpt_DeviceInformationPageNetwork]Device Information Page – Add Device from Network[bookmark: marker-511872][bookmark: marker-511874]

 
     [bookmark: pgfId-511878]Use the New Device wizard’s Device Information page for adding devices from the network to specify the device’s identifying information.

 
     [bookmark: pgfId-511880]Navigation Path

 
     [bookmark: pgfId-511882]To start the New Device wizard, from Device view, select File > New Device, or click the Add button in the device selector.

 
     [bookmark: pgfId-511884]Related Topics

 
      
      		 [bookmark: pgfId-511889]Understanding the Device View

 
      		 [bookmark: pgfId-511894]Adding Devices from the Network

 
      		 [bookmark: pgfId-511899]Device Credentials Page

 
      		 [bookmark: pgfId-511904]Device Groups Page

 
      		 [bookmark: pgfId-511909]Discovering Policies

 
      		 [bookmark: pgfId-511914]Device Communication Page

 
     

 
     [bookmark: pgfId-511916]Field Reference

 
     [bookmark: pgfId-511919] 

 
      
       
        
        [bookmark: pgfId-508083]Table 3-2 [bookmark: 5454]New Device Wizard, Device Information Page When Adding Devices from the Network 

 
        
       
         
         		
           
           [bookmark: pgfId-508089]Element
          
  
         		
           
           [bookmark: pgfId-508091]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-508097]Identity
          
  
        

 
         
         		[bookmark: pgfId-508105]IP Type

  
         		[bookmark: pgfId-508107]You can add only devices that have static IP addresses.

 [bookmark: pgfId-508109]If you want to add a device that uses dynamic addresses (supplied by a DHCP server), determine the current IP address for the device, use that address, and after adding the device, update its properties to change the IP Type to Dynamic and to identify the AUS or Configuration Engine that is managing the device.

  
        

 
         
         		[bookmark: pgfId-508115]Hostname

  
         		[bookmark: pgfId-508117]The DNS hostname for the device. Enter the DNS hostname if the IP address is not known.

 [bookmark: pgfId-508119]Note You must enter either the DNS hostname or the IP address, or both.

  
        

 
         
         		[bookmark: pgfId-508125]Domain Name

  
         		[bookmark: pgfId-508127]The DNS domain name for the device.

  
        

 
         
         		[bookmark: pgfId-508133]IP Address

  
         		[bookmark: pgfId-508135]The management IP address of the device. The IP address must be in the dotted quad format, for example, 10.64.3.8.

 [bookmark: pgfId-508137]Note You must enter either the IP address or the DNS hostname, or both.

  
        

 
         
         		[bookmark: pgfId-508143]Display Name

  
         		[bookmark: pgfId-508145]The name to display in the Security Manager Device selector. If you enter a hostname or IP address, it is entered automatically in this field, but you can change it.

 [bookmark: pgfId-508147]The maximum length is 70 characters. Valid characters are: 0-9; uppercase A-Z; lowercase a-z; and the following characters: _ -. : and space.

 [bookmark: pgfId-508149]Note Two devices cannot have the same display name.

  
        

 
         
         		[bookmark: pgfId-508155]OS Type

  
         		[bookmark: pgfId-508157]The family of the operating system running on the device. You must be careful to select the correct type, because your selection affects how Security Manager tries to log into the device and obtain its configuration. The options are:

 
           
           		 [bookmark: pgfId-508159] IOS 12.3+ —For Cisco routers running Cisco IOS Software Release 12.3 or higher. Do not select this for Catalyst 6500/7600 or other Catalyst devices.

 
          

 [bookmark: pgfId-508161]Tip Select this option for Aggregation Services Routers (ASR) even if they are running a version of 12.2. The ASR IOS releases are treated as higher releases. 
           
           		 [bookmark: pgfId-508163] IOS - 12.2, 12.1 —For Cisco routers running Cisco IOS Software Releases 12.2 or 12.1. Do not select this for ASRs, Catalyst 6500/7600, or other Catalyst devices.

 
           		 [bookmark: pgfId-508165] IOS - Catalyst Switch/7600 —For all Catalyst switches and 7600 devices.

 
           		 [bookmark: pgfId-508167] ASA —For all ASA devices.

 
           		 [bookmark: pgfId-508169] FWSM —For all FWSM devices.

 
           		 [bookmark: pgfId-508171] IPS —For all devices running the IPS software.

 
           		 [bookmark: pgfId-508173] PIX —For all PIX devices.

 
          

  
        

 
         
         		[bookmark: pgfId-508179]Transport Protocol

  
         		[bookmark: pgfId-508181]The protocol Security Manager should use when connecting to the device. Select a protocol that is configured on the device and for which you can supply credentials. Each device type has a default protocol that is the method normally used with the device.

  
        

 
         
         		[bookmark: pgfId-508187]System Context

  
         		[bookmark: pgfId-508189]Whether to discover the system execution space of a PIX Firewall 7, ASA, or FWSM device that is running in multiple-context mode. If you are discovering a device that hosts multiple security contexts, whether you select this checkbox has important implications in how you can configure the device in Security Manager. What gets discovered on the device also depends on whether you select the Discover Policies for Security Contexts checkbox.

 
           
           		 [bookmark: pgfId-508194]Both  System Context and  Discover Policies for Security Contexts selected—This is the recommended selection. Security Manager discovers the system execution space and all of the security contexts defined on the device, and lists them in the device selector. The base display name represents the system execution space (for example, 10.10.11.24), whereas the security contexts are represented by nodes with the context name appended to the device name (for example, 10.10.11.24_admin), unless you changed the default naming convention configured on the Discovery page (see Discovery Page).

 
           		 [bookmark: pgfId-508196] System Context selected,  Discover Policies for Security Contexts deselected—The system execution space is discovered and added to the device selector. You can then discover the policies for the security contexts at a later time. This method might be appropriate if you have one group of people who discover inventory and another group that discovers policies.

 
           		 [bookmark: pgfId-508198]Neither checkbox selected—Only the Admin context gets discovered and added to the device selector. You cannot discover the other security contexts or manage them.

 
          

  
        

 
         
         		 
           
           [bookmark: pgfId-508204]Discover Device Settings
          
  
        

 
         
         		[bookmark: pgfId-508212]Discover

  
         		[bookmark: pgfId-508214]The type of elements that should be discovered and added to the inventory. You have these options:

 
           
           		 [bookmark: pgfId-508216]Policies and Inventory—Discover policies, interfaces, and service modules (if applicable). This is the default and recommended option.

 
          

 [bookmark: pgfId-508218]When policy discovery is initiated, the system analyzes the configuration on the device, then imports the configured service and platform policies. When inventory discovery is initiated, the system analyzes the interfaces on the device and then imports the interface list. If the device is a composite device, all the service modules in the device are discovered and imported.

 [bookmark: pgfId-508220]If you select this option, the checkboxes below are activated and you can use them to control the types of policies that are discovered.

 [bookmark: pgfId-508222]Note During discovery, if you import an ACL that is inactive, it is shown as disabled in Security Manager. If you deploy the same ACL, it will be removed by Security Manager.

 
           
           		 [bookmark: pgfId-508224]Inventory Only—Discovers interfaces and service modules (if applicable).

 
           		 [bookmark: pgfId-508226]No Discovery—All discovery is skipped. No policy, interface, or service module information for the device is added to the device inventory.

 
          

  
        

 
         
         		[bookmark: pgfId-508232]Platform Settings

  
         		[bookmark: pgfId-508237]Whether to discover the platform settings, which are also called platform-specific policy domains. Platform-specific policy domains exist on firewall devices and Cisco IOS routers. These domains contain policies that configure features that are specific to the selected platform. For more information, see Service Policies vs. Platform-Specific Policies.

  
        

 
         
         		[bookmark: pgfId-508243]Firewall Policies

  
         		[bookmark: pgfId-508248]Whether to discover firewall policies, which are also called firewall services. Firewall services include policies such as access rules, inspection rules, AAA rules, web filter rules, and transparent rules. For details see, Chapter 12, “Introduction to Firewall Services”

  
        

 
         
         		[bookmark: pgfId-508254]IPS Policies

  
         		[bookmark: pgfId-508262]Whether to discover IPS policies such as signatures and virtual sensors. For more information, see Overview of IPS Configuration or Overview of Cisco IOS IPS Configuration.

  
        

 
         
         		[bookmark: pgfId-508268]RA VPN Policies

  
         		[bookmark: pgfId-508273]Whether to discover IPSec and SSL remote access VPN policies such as IKE proposals and IPsec proposals. This option is disabled if the device does not support remote access VPN configuration. For more information, see Chapter 30, “Managing Remote Access VPNs: The Basics”.

  
        

 
         
         		[bookmark: pgfId-508279]Discover Policies for Security Context

  
         		[bookmark: pgfId-508281]Whether to discover policies for security contexts. Security contexts apply to PIX Firewall, ASA, or FWSM devices. This field is active only if you select Static for IP Type and System Context.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-511935][bookmark: 5603][bookmark: ivpage_cncpt_FWSMCredentialsandVPNSPASlotLocationDialogBox]Service Module Credentials Dialog Box [bookmark: marker-511927][bookmark: marker-511929][bookmark: marker-511931][bookmark: marker-511933]

 
     [bookmark: pgfId-511937]Use the Service Module Credentials dialog box to add the credentials required to log into supported service modules in a Catalyst device.

 
     [bookmark: pgfId-511939]The dialog box includes a group for each slot that contains a supported module, and the type of module is indicated. For example, a group might be called Slot 3 (IDSM) Credentials, which indicates that there is an IDSM in the third slot of the chassis.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-511941]Note Although Security Manager discovers VPN modules, the discovery is done through the chassis and no credentials are required. ASA service modules (ASA-SM) cannot be discovered through the chassis; you must add them individually.


     
      

     

     

 
     [bookmark: pgfId-511943]Navigation Path

 
     [bookmark: pgfId-511945]After you discover policies on a Catalyst chassis that can contain service modules, you are asked if you want to discover its service modules. If you click Yes, this dialog box appears. You can perform policy discovery using any of these methods:

 
      
      		 [bookmark: pgfId-511950]When adding a device from the network. See Adding Devices from the Network.

 
      		 [bookmark: pgfId-511955]When adding devices from an export file. See Adding Devices from an Inventory File.

 
      		 [bookmark: pgfId-511960]When performing policy discovery on a device that is already in the inventory. See Discovering Policies on Devices Already in Security Manager.

 
     

 
     [bookmark: pgfId-511962]Related Topics

 
      
      		 [bookmark: pgfId-511967]Chapter 58, “Configuring Security Contexts on Firewall Devices”

 
     

 
     [bookmark: pgfId-511969]Field Reference

 
     [bookmark: pgfId-511972] 

 
      
       
        
        [bookmark: pgfId-508294]Table 3-3 [bookmark: 5645]Service Module Credentials Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-508300]Element
          
  
         		
           
           [bookmark: pgfId-508302]Description
          
  
        

 
         
         		[bookmark: pgfId-508308]Discovery Mode

  
         		[bookmark: pgfId-508310]The types of policies to discovery for this module:

 
           
           		 [bookmark: pgfId-508312]Discover Inventory and Policies—Discover inventory and security policies. This is the recommended option.

 
           		 [bookmark: pgfId-508314]Discover Inventory Only—Do not discover security policies, but discover inventory, such as VLAN configuration, security contexts, and interfaces. You can discover the policy configuration later by right-clicking the service module and then selecting  Discover Policies on Device .

 
           		 [bookmark: pgfId-508316]Do Not Discover Module—Skip discovery on this module and do not add it to the inventory.

 
          

  
        

 
         
         		[bookmark: pgfId-508322]Connect to FWSM

  
         		[bookmark: pgfId-508324]How Security Manager should access the FWSM:

 
           
           		 [bookmark: pgfId-508326]Directly—Connect to the FWSM using its management IP address. This is the recommended approach. It is the required method if you are connecting to a failover device; otherwise, Security Manager might connect to a standby FWSM after a failover.

 
           		 [bookmark: pgfId-508328]via Chassis—Connect to the FWSM through the chassis. This method has the restriction that there should be fewer than 20 security contexts defined on the FWSM. Security Manager connects to the Catalyst device through SSH and then to the FWSM through the  session command. The number of concurrent SSH sessions is limited on a Catalyst device, with a default of 5. Policy discovery uses one SSH session for each security context, so a large number of contexts might lead to connection failures. If you select  Directly , Security Manager connects to the FWSM through SSL, which has a greater concurrent session limit.

 
          

  
        

 
         
         		[bookmark: pgfId-508334]Management IP

  
         		[bookmark: pgfId-508336]The management IP address for the service module.

 [bookmark: pgfId-508338]For FWSMs, this field is not available if you select via Chassis for the connection method.

  
        

 
         
         		[bookmark: pgfId-508344]Username

  
         		[bookmark: pgfId-508346]The user name for the service module.

 [bookmark: pgfId-508348]For FWSMs running in multiple-context mode, a footnote explains which context’s username and password to enter, either the system or the admin context. If you are connecting to a multiple-context mode device through the switch chassis, you must configure the same username and password for both the system execution space and the admin context, and specify those credentials in this dialog box.

 [bookmark: pgfId-508350]Note User names be at least four characters. Passwords can be three to 32 characters; we recommend that passwords be at least eight characters.

  
        

 
         
         		[bookmark: pgfId-508356]Password

  
         		[bookmark: pgfId-508358]The User EXEC mode password for the service module. In the Confirm field, enter the password again.

  
        

 
         
         		[bookmark: pgfId-508364]Enable Password

 [bookmark: pgfId-508366](FWSM only)

  
         		[bookmark: pgfId-508368]The Privileged EXEC mode password for the service module. In the Confirm field, enter the password again.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-511988][bookmark: 5706][bookmark: ivpage_cncpt_AIMIPSModuleDiscoveryDialogBox]IPS Module Discovery Dialog Box [bookmark: marker-511980][bookmark: marker-511982][bookmark: marker-511984][bookmark: marker-511986]

 
     [bookmark: pgfId-511990]Use the IPS Module Discovery dialog box to add the credentials required to log into an IPS module, such as an AIM-IPS or NME, on a router you are adding to the inventory.

 
     [bookmark: pgfId-511992]Navigation Path

 
     [bookmark: pgfId-511994]After you discover policies on a router chassis that contains an IPS module, you are asked if you want to discover its modules. If you click Yes, this dialog box appears. You can perform policy discovery using any of these methods:

 
      
      		 [bookmark: pgfId-511999]When adding a device from the network. See Adding Devices from the Network.

 
      		 [bookmark: pgfId-512004]When adding devices from an inventory file. See Adding Devices from an Inventory File.

 
      		 [bookmark: pgfId-512009]When performing policy discovery on a device that is already in the network. See Discovering Policies on Devices Already in Security Manager.

 
     

 
     [bookmark: pgfId-512011]Field Reference

 
     [bookmark: pgfId-512014] 

 
      
       
        
        [bookmark: pgfId-508381]Table 3-4 [bookmark: 5739]IPS Module Discovery Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-508387]Element
          
  
         		
           
           [bookmark: pgfId-508389]Description
          
  
        

 
         
         		[bookmark: pgfId-508395]Discovery

  
         		[bookmark: pgfId-508397]The type of discovery for this module:

 
           
           		 [bookmark: pgfId-508399]Discover Inventory and Policies—Discover inventory and security policies. This is the recommended option.

 
           		 [bookmark: pgfId-508401]Discover Inventory Only—Do not discover security policies, but discover inventory, such as virtual sensors and interfaces. You can discover the policy configuration later by right-clicking the module and selecting  Discover Policies on Device .

 
           		 [bookmark: pgfId-508403]Do Not Discover Module—Skip discovery on this module and do not add it to the inventory.

 
          

  
        

 
         
         		[bookmark: pgfId-508409]IP Address

  
         		[bookmark: pgfId-508411]The management IP address for the module.

  
        

 
         
         		 [bookmark: pgfId-508417]HTTP Credentials Group

 [bookmark: pgfId-508419]The credentials required to log into the module.

  
        

 
         
         		[bookmark: pgfId-508427]Username

  
         		[bookmark: pgfId-508429]The username for the module.

  
        

 
         
         		[bookmark: pgfId-508435]Password

  
         		[bookmark: pgfId-508437]The password for the specified username. In the Confirm field, enter the password again.

  
        

 
         
         		[bookmark: pgfId-508443]HTTP Port

  
         		[bookmark: pgfId-508445]The port configured for HTTP access to the module. The default is 80.

  
        

 
         
         		[bookmark: pgfId-508451]HTTPS Port

  
         		[bookmark: pgfId-508456]The port configured for SSL (HTTPS) access to the module. The default is defined on the Device Communication page (Tools > Security Manager Administration > Device Communication, for more information, see Device Communication Page). The port typically used is 443.

 [bookmark: pgfId-508458]To override the default, deselect Use Default and enter the correct port number.

  
        

 
         
         		[bookmark: pgfId-508464]IPS RDEP Mode

  
         		[bookmark: pgfId-508466]The connection method to use for contacting IPS devices when making RDEP or SDEE connections (for event monitoring).

  
        

 
         
         		[bookmark: pgfId-508472]Certificate Common Name

  
         		[bookmark: pgfId-508474]The name assigned to the certificate. The common name can be the name of a person, system, or other entity that was assigned to the certificate. In the Confirm field, enter the common name again.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-512026][bookmark: 5809][bookmark: ivman_proc_AddingDevicesfromConfigurationFiles]Adding Devices from Configuration Files[bookmark: marker-512022][bookmark: marker-512024]

 
     [bookmark: pgfId-512028]You can add devices to the inventory by having Security Manager process the device configurations without logging into the devices. For each device, you must copy the device configuration to a file and put the file on the Security Manager server.

 
     [bookmark: pgfId-512030]You cannot use this procedure to add IPS or Catalyst 6500/7600 devices to the inventory.

 
     [bookmark: pgfId-512032]Before You Begin

 
     [bookmark: pgfId-512034]Before beginning this procedure, ensure the following preparations have been made:

 
      
      		 [bookmark: pgfId-512039]Prepare the devices to be managed by Security Manager. For more information, see Chapter 2, “Preparing Devices for Management”.

 
      		 [bookmark: pgfId-512043]If you are using ACS for authentication, define the devices in ACS. See the  Installation Guide for Cisco Security Manager .

 
      		 [bookmark: pgfId-512045]Copy the device configuration files to a directory on the Security Manager server. You cannot use a mounted drive. Use a naming convention that will help you select the correct device type for each configuration.

 
     

 
     [bookmark: pgfId-512047]Related Topics

 
      
      		 [bookmark: pgfId-512052]Understanding the Device View

 
      		 [bookmark: pgfId-512057]Working with Device Groups

 
      		 [bookmark: pgfId-512062]Viewing or Changing Device Properties

 
     

 
     
 
     [bookmark: pgfId-512064]Step 1 In Device view, select File > New Device or click the New Device button in the Device selector. The New Device wizard opens to the Choose Method page.

 
     [bookmark: pgfId-512069]Step 2 On the Choose Method page, select Add from Configuration File and click Next to open the Device Information page (see Device Information Page—Configuration File).

 
     [bookmark: pgfId-512071]Step 3 Select the device type for the configuration files from the Device Type selector, and select the appropriate system object ID. If you have configuration files for more than one device type, add them in batches based on device type.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-512076]Note If you are adding a router that does not appear in the explicitly supported device list, you can try to manage it as a generic device using the following device types: Cisco Generic Aggregation Services Router—for devices running Cisco IOS XE Software and Cisco Generic Integrated Services Router—for devices running Cisco IOS Software. For more information about generic device support, see Working with Generically Supported Devices.


     
      

     

     

 
     [bookmark: pgfId-512078]Step 4 Click Browse and select the configuration files that contain the devices (of the specified type) that you want to add.

 
     [bookmark: pgfId-512080]Step 5 Select the appropriate discovery options to indicate which types of policies you want to discover, if any.

 
     [bookmark: pgfId-512082]Step 6 (Optional) Click Next and select the device groups to which the new devices should belong.

 
     [bookmark: pgfId-512087]Step 7 Click Finish. Security Manager opens the Discovery Status dialog box where you can view the status of the configuration file analysis (see Discovery Status Dialog Box). When finished, close the window and the device is added to the inventory list.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-512089]Tip If you are discovering policies and get unexpected errors, it might be because the configuration file includes only the major Cisco IOS software version and not the point release information. Some policies defined on the device might use features that became available in a point release, which means that Security Manager might not recognize them as being supported. To resolve the problem, after adding the device, select it in the Device selector, right-click, and select Device Properties. On the General page, update the Target OS Version field with the software version closest to the one running on the device without being higher than it (you can get the version number using the show version command on the device’s CLI). You can then rediscover policies by right-clicking and selecting Discover Policies on Device.


     
      

     

     

 
     [bookmark: pgfId-512094]Step 8 If you added a device that is managed by an Auto Update Server or Configuration engine, with the device selected in the device selector, select Tools > Device Properties. Select the server used with the device in the Auto Update or Configuration Engine settings. You can add the server if it is not listed. For more information, see Adding, Editing, or Deleting Auto Update Servers or Configuration Engines.

 
     [bookmark: pgfId-512096]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-512108][bookmark: 5884][bookmark: ivpage_cncpt_DeviceInformationPageConfigFile]Device Information Page—Configuration File[bookmark: marker-512104][bookmark: marker-512106]

 
     [bookmark: pgfId-512110]Use the New Device wizard’s Device Information page for adding devices from configuration files to select the configuration files and to specify policy discovery options.

 
     [bookmark: pgfId-512112]Navigation Path

 
     [bookmark: pgfId-512114]To start the New Device wizard, from Device view, select File > New Device, or click the Add button in the device selector.

 
     [bookmark: pgfId-512116]Related Topics

 
      
      		 [bookmark: pgfId-512121]Understanding the Device View

 
      		 [bookmark: pgfId-512126]Adding Devices from Configuration Files

 
      		 [bookmark: pgfId-512131]Device Groups Page

 
      		 [bookmark: pgfId-512136]Discovering Policies

 
      		 [bookmark: pgfId-512141]Discovery Status Dialog Box

 
     

 
     [bookmark: pgfId-512143]Field Reference

 
     [bookmark: pgfId-512146] 

 
      
       
        
        [bookmark: pgfId-508487]Table 3-5 [bookmark: 5920]New Device Wizard, Device Information Page When Adding Devices from Configuration Files 

 
        
       
         
         		
           
           [bookmark: pgfId-508493]Element
          
  
         		
           
           [bookmark: pgfId-508495]Description
          
  
        

 
         
         		[bookmark: pgfId-508501]Device Type selector

  
         		[bookmark: pgfId-508503]Organizes the devices by device-type and device-family. Select the device type for the new device. You must select the correct device type for the configuration file you are adding.

 [bookmark: pgfId-508508]Note If you are adding a router that does not appear in the explicitly supported device list, you can try to manage it as a generic device using the following device types: Cisco Generic Aggregation Services Router—for devices running Cisco IOS XE Software and Cisco Generic Integrated Services Router—for devices running Cisco IOS Software. For more information about generic device support, see Working with Generically Supported Devices.

  
        

 
         
         		[bookmark: pgfId-508514]System Object ID

  
         		[bookmark: pgfId-508516]The system object identifiers for the device type you selected from the Device Type selector. Select the correct ID for your device.

  
        

 
         
         		[bookmark: pgfId-508522]Configuration Files

  
         		[bookmark: pgfId-508524]The configuration files from the devices you are adding to the inventory. You can specify more than one configuration file, but they must all be for the same device type. Separate the file names with commas.

 [bookmark: pgfId-508526]For ASA, PIX, and FWSM devices that have multiple security contexts, keep in mind that there are separate configuration files for each security context and the system execution space (the system context). Select the configuration file for the system execution space to add the base device.

 [bookmark: pgfId-508531]Click Browse to select the files from the Security Manager server, or manually type in the file names (including the full path). For information on selecting files, see Selecting or Specifying a File or Directory in Security Manager.

  
        

 
         
         		[bookmark: pgfId-508537]Options

  
         		[bookmark: pgfId-508539]The additional options available on the device. Select IPS if the IPS feature is available on the device.

  
        

 
         
         		[bookmark: pgfId-508545]Target OS Version

 [bookmark: pgfId-508547](Routers only.)

  
         		[bookmark: pgfId-508549]The OS version on which you want to base the router’s configuration.

 
           
           		 [bookmark: pgfId-508551]Select Default to read the OS version from the configuration file.

 
           		 [bookmark: pgfId-508553]Select a specific release number if you want to ensure the desired release is used. If the desired release is not listed, select the release number that is closet but lower than the release running on the device.

 
          

 [bookmark: pgfId-508555]You might have to select a specific release when discovering configuration files for Aggregation Services Routers (ASR) or for configuration files that include zone-based firewall policies.

  
        

 
         
         		[bookmark: pgfId-508561]License Supports Failover

 [bookmark: pgfId-508563](ASA 5505, 5510 only.)

  
         		[bookmark: pgfId-508565]Whether an optional failover license is installed on the device. The option is active for ASA 5505 and 5510 devices only. Security Manager deploys failover policies to the device only if this option is selected.

 [bookmark: pgfId-508567]Tip If you discover policies from the device, Security Manager determines the license status and sets this option appropriately.  
        

 
         
         		 
           
           [bookmark: pgfId-508573]Discover Device Settings
          
  
        

 
         
         		[bookmark: pgfId-508581]Discover

  
         		[bookmark: pgfId-508583]The type of elements that should be discovered and added to the inventory. You have these options:

 
           
           		 [bookmark: pgfId-508585]Policies and Inventory—Discover policies, interfaces, and service modules (if applicable). This is the default and recommended option.

 
          

 [bookmark: pgfId-508587]When policy discovery is initiated, the system analyzes the configuration file, then imports the configured service and platform policies. When inventory discovery is initiated, the system analyzes the interfaces defined in the file and then imports the interface list.

 [bookmark: pgfId-508589]If you select this option, the checkboxes below are activated and you can use them to control the types of policies that are discovered.

 [bookmark: pgfId-508591]Note During discovery, if you import an ACL that is inactive, it is shown as disabled in Security Manager. If you deploy the same ACL, it will be removed by Security Manager.

 
           
           		 [bookmark: pgfId-508593]Inventory Only—Discovers interfaces and service modules (if applicable).

 
           		 [bookmark: pgfId-508595]No Discovery—All discovery is skipped. No policy, interface, or service module information for the device is added to the device inventory.

 
          

  
        

 
         
         		[bookmark: pgfId-508601]Platform Settings

  
         		[bookmark: pgfId-508606]Whether to discover the platform settings, which are also called platform-specific policy domains. Platform-specific policy domains exist on firewall devices and Cisco IOS routers. These domains contain policies that configure features that are specific to the selected platform. For more information, see Service Policies vs. Platform-Specific Policies.

  
        

 
         
         		[bookmark: pgfId-508612]Firewall Policies

  
         		[bookmark: pgfId-508617]Whether to discover firewall policies, which are also called firewall services. Firewall services include policies such as access rules, inspection rules, AAA rules, web filter rules, and transparent rules. For details see, Chapter 12, “Introduction to Firewall Services”

  
        

 
         
         		[bookmark: pgfId-508623]IPS Policies

  
         		[bookmark: pgfId-508631]Whether to discover IPS policies such as signatures and virtual sensors. For more information, see Overview of IPS Configuration or Overview of Cisco IOS IPS Configuration.

  
        

 
         
         		[bookmark: pgfId-508637]RA VPN Policies

  
         		[bookmark: pgfId-508642]Whether to discover IPSec and SSL remote access VPN policies such as IKE proposals and IPsec proposals. This option is disabled if the device does not support remote access VPN configuration. For more information, see Chapter 30, “Managing Remote Access VPNs: The Basics”.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-512160][bookmark: 6024][bookmark: ivman_proc_AddingDevicesbyManualDefinition]Adding Devices by Manual Definition[bookmark: marker-512154][bookmark: marker-512156][bookmark: marker-512158]

 
     [bookmark: pgfId-512162]If a device is not yet active on the network, you can add it to Security Manager and preprovision a configuration for the device. In general, you should not use manual definition for a device that exists in the network, because it is much easier to use one of the other techniques for adding devices.

 
     [bookmark: pgfId-512164]Before You Begin

 
     [bookmark: pgfId-512166]Before beginning this procedure, ensure the following preparations have been made:

 
      
      		 [bookmark: pgfId-512171]Prepare the devices to be managed by Security Manager. For more information, see Chapter 2, “Preparing Devices for Management”.

 
      		 [bookmark: pgfId-512175]If you are using ACS for authentication, define the devices in ACS. See the  Installation Guide for Cisco Security Manager .

 
     

 
     [bookmark: pgfId-512177]Related Topics

 
      
      		 [bookmark: pgfId-512182]Understanding the Device View

 
      		 [bookmark: pgfId-512187]Working with Device Groups

 
      		 [bookmark: pgfId-512192]Viewing or Changing Device Properties

 
     

 
     
 
     [bookmark: pgfId-512194]Step 1 In Device view, select File > New Device or click the New Device button in the Device selector. The New Device wizard opens to the Choose Method page.

 
     [bookmark: pgfId-512196]Step 2 On the Choose Method page, select Add New Device and click Next to open the Device Information page.

 
     [bookmark: pgfId-512201]Step 3 On the Device Information page, at minimum fill in the following fields. For a detailed explanation of all fields, see Device Information Page—New Device.

 
      
      		 [bookmark: pgfId-512203]Select the device type from the Device Type selector at the left of the page, and select the system object ID at the bottom of the selector.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-512208]Note If you are adding a router that does not appear in the explicitly supported device list, you can try to manage it as a generic device using the following device types: Cisco Generic Aggregation Services Router—for devices running Cisco IOS XE Software and Cisco Generic Integrated Services Router—for devices running Cisco IOS Software. For more information about generic device support, see Working with Generically Supported Devices.


     
      

     

     

 
      
      		 [bookmark: pgfId-512210]In the IP Type field, select whether the device uses a static address (the IP address is defined on the device) or a dynamic one (the address is provided by a DHCP server).

 
      		 [bookmark: pgfId-512212]For devices with static addresses, enter either a DNS hostname and domain name, or an IP address (or both).

 
      		 [bookmark: pgfId-512214]Enter a display name, which is the name that will appear in the Security Manager Device selector.

 
      		 [bookmark: pgfId-512216]Ensure that the correct operating system and version are selected.

 
      		 [bookmark: pgfId-512221]If you use a server to manage configurations for the device, which is required for dynamically addressed devices, select the Auto Update Server or Configuration Engine that manages the device and enter the device identity string the server uses for the device. If the server is not listed, select  Add Server and add it to the inventory. For information on adding servers, see Adding, Editing, or Deleting Auto Update Servers or Configuration Engines

 
     

 
     [bookmark: pgfId-512223]When you are finished filling in the device information, click Next to proceed to the Device Credentials page.

 
     [bookmark: pgfId-512225]Step 4 (Optional) On the Device Credentials page, enter the usernames and passwords required to log into the device. Typically, you need to enter the primary device credentials, which are the traditional User EXEC mode and Privileged EXEC mode passwords. If you do not enter credentials, you can add them later on the Device Properties page.

 
     [bookmark: pgfId-512230]For information on the different types of credentials, see Device Credentials Page.

 
     [bookmark: pgfId-512232]Click Next.

 
     [bookmark: pgfId-512237]Step 5 (Optional) On the Device Grouping page, select the group to which the device should belong, if any. See Device Groups Page

 
     [bookmark: pgfId-512239]Step 6 Click Finish. The device is added to the inventory.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-512244]Tip If you are adding a PIX, ASA, or FWSM device, you should discover the factory default settings for the device and its security contexts. For more information, see Discovering Policies on Devices Already in Security Manager.


     
      

     

     

 
     [bookmark: pgfId-512246]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-512258][bookmark: 6108][bookmark: ivpage_cncpt_DeviceInformationPageNewDevice]Device Information Page—New Device[bookmark: marker-512254][bookmark: marker-512256]

 
     [bookmark: pgfId-512260]Use the New Device wizard’s Device Information page for adding new devices (that do not yet exist in the network) to specify the device’s identifying information.

 
     [bookmark: pgfId-512262]Navigation Path

 
     [bookmark: pgfId-512264]To start the New Device wizard, from Device view, select File > New Device, or click the Add button in the device selector.

 
     [bookmark: pgfId-512266]Related Topics

 
      
      		 [bookmark: pgfId-512271]Understanding the Device View

 
      		 [bookmark: pgfId-512276]Adding Devices by Manual Definition

 
      		 [bookmark: pgfId-512281]Device Credentials Page

 
      		 [bookmark: pgfId-512286]Device Groups Page

 
     

 
     [bookmark: pgfId-512288]Field Reference

 
     [bookmark: pgfId-512291] 

 
      
       
        
        [bookmark: pgfId-508655]Table 3-6 [bookmark: 6141]New Device Wizard, Device Information Page When Adding New Devices 

 
        
       
         
         		
           
           [bookmark: pgfId-508661]Element
          
  
         		
           
           [bookmark: pgfId-508663]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-508669]Device Type
          
  
        

 
         
         		[bookmark: pgfId-508677]Device Type selector

  
         		[bookmark: pgfId-508679]Organizes the devices by device-type and device-family. Select the device type for the new device.

 [bookmark: pgfId-508684]Note If you are adding a router that does not appear in the explicitly supported device list, you can try to manage it as a generic device using the following device types: Cisco Generic Aggregation Services Router—for devices running Cisco IOS XE Software and Cisco Generic Integrated Services Router—for devices running Cisco IOS Software. For more information about generic device support, see Working with Generically Supported Devices.

  
        

 
         
         		[bookmark: pgfId-508690]System Object ID

  
         		[bookmark: pgfId-508692]The system object identifiers for the device type you selected from the Device Type selector. Select the correct ID for your device.

  
        

 
         
         		 
           
           [bookmark: pgfId-508698]Identity
          
  
        

 
         
         		[bookmark: pgfId-508706]IP Type

  
         		[bookmark: pgfId-508708]Whether the IP address for the device is static (defined on the device) or dynamic (supplied by a DHCP server). Depending on the IP type you select, the displayed fields differ.

  
        

 
         
         		[bookmark: pgfId-508714]Hostname

 [bookmark: pgfId-508716](Static IP only)

  
         		[bookmark: pgfId-508718]The DNS hostname for the device. Enter the DNS hostname if the IP address is not known.

 [bookmark: pgfId-508720]The maximum length is 70 characters. Valid characters are: 0-9; uppercase A-Z; lowercase a-z; and hyphen (-).

 [bookmark: pgfId-508722]Note You must enter either the DNS hostname or the IP address, or both.

 [bookmark: pgfId-508724]Two devices cannot have the same DNS hostname and domain name combination.

  
        

 
         
         		[bookmark: pgfId-508730]Domain Name

 [bookmark: pgfId-508732](Static IP only)

  
         		[bookmark: pgfId-508734]The DNS domain name for the device.

 [bookmark: pgfId-508736]The maximum length is 70 characters. Valid characters are: 0-9; uppercase A-Z; lowercase a-z; period (.) and hyphen (-).

  
        

 
         
         		[bookmark: pgfId-508742]IP Address

 [bookmark: pgfId-508744](Static IP only)

  
         		[bookmark: pgfId-508746]The management IP address of the device. The IP address must be in the dotted quad format, for example 10.64.3.8.

 [bookmark: pgfId-508748]Note You must enter either the IP address or the DNS hostname, or both.

  
        

 
         
         		[bookmark: pgfId-508754]Display Name

  
         		[bookmark: pgfId-508756]The name to display in the Security Manager Device selector. If you enter a hostname or IP address, it is entered automatically in this field, but you can change it.

 [bookmark: pgfId-508758]The maximum length is 70 characters. Valid characters are: 0-9; uppercase A-Z; lowercase a-z; and the following characters: _ -. : and space.

 [bookmark: pgfId-508760]Note Two devices cannot have the same display name.

  
        

 
         
         		 
           
           [bookmark: pgfId-508766]Operating System
          
  
        

 
         
         		[bookmark: pgfId-508774]OS Type

  
         		[bookmark: pgfId-508776]The type of operating system. Based on the device type, the OS type is selected automatically.

  
        

 
         
         		[bookmark: pgfId-508782]Image Name

  
         		[bookmark: pgfId-508784]The name of the image that will run on the device.

  
        

 
         
         		[bookmark: pgfId-508790]Target OS Version

  
         		[bookmark: pgfId-508792]The target OS version for which you want to apply the configuration. This selection determines the type of commands used when Security Manager generates configuration files.

  
        

 
         
         		[bookmark: pgfId-508798]Options

  
         		[bookmark: pgfId-508800]The additional options available on the device. Select IPS if the IPS feature is available on the device.

  
        

 
         
         		[bookmark: pgfId-508806]Contexts

  
         		[bookmark: pgfId-508808]Whether the device hosts a single security context (Single) or multiple security contexts (Multi). This field is displayed only if the OS type is an FWSM, ASA, or PIX Firewall 7.0.

  
        

 
         
         		[bookmark: pgfId-508814]Operational Mode

  
         		[bookmark: pgfId-508816]The mode in which the device is operating. This field is displayed only if the OS type is FWSM, ASA, or PIX Firewall 7.0+. The options available are: Transparent or Router. If you choose Multi for Contexts, this mode defaults to Mixed. Mixed applies only to ASA 9.0+ and FWSM 3.1+ devices, and ASA-SMs.

  
        

 
         
         		 [bookmark: pgfId-508822]Auto Update or Configuration Engine

 [bookmark: pgfId-508824]This group is named differently depending on the device type you select:

 
           
           		 [bookmark: pgfId-508826]Auto Update—For PIX Firewall and ASA devices.

 
           		 [bookmark: pgfId-508828]Configuration Engine—For Cisco IOS Routers.

 
          

 [bookmark: pgfId-508830]Use these fields to identify the server that manages the device, if any. A server is required for a device with a dynamic IP address. You cannot define a server for Catalyst 6500/7600 or FWSM devices.

  
        

 
         
         		[bookmark: pgfId-508838]Server

  
         		[bookmark: pgfId-508840]The Auto Update Server or Configuration Engine that manages the device.

 [bookmark: pgfId-508848]You can add servers to the list by selecting Add Servers, which opens the Server Properties dialog box (see Server Properties Dialog Box). You can also edit the properties of a server by selecting Edit Server, which opens the Available Servers dialog box (see Available Servers Dialog Box).

 [bookmark: pgfId-508853]For more information on managing this list of servers, see Adding, Editing, or Deleting Auto Update Servers or Configuration Engines

  
        

 
         
         		[bookmark: pgfId-508859]Device Identity

  
         		[bookmark: pgfId-508861]The string value that uniquely identifies the device in Auto Update Server or the Configuration Engine.

  
        

 
         
         		 
           
           [bookmark: pgfId-508867]Additional Fields
          
  
        

 
         
         		[bookmark: pgfId-508875]Manage in Cisco Security Manager

  
         		[bookmark: pgfId-508877]Whether Security Manager manages the device. This check box is selected by default.

 [bookmark: pgfId-508882]If the only function of the device you are adding is to serve as a VPN end point, deselect this check box. Security Manager will not manage configurations nor will it upload or download configurations on this device. For more information, see Including Unmanaged or Non-Cisco Devices in a VPN.

  
        

 
         
         		[bookmark: pgfId-508888]Security Context of Unmanaged Device

  
         		[bookmark: pgfId-508890]Whether to manage a security context whose parent (the PIX Firewall, ASA, or FWSM device) is not managed by Security Manager.

 [bookmark: pgfId-508892]This field is active only if the device you selected in the Device selector is a firewall device, such as PIX Firewall, ASA, or FWSM and that firewall device supports security contexts.

 [bookmark: pgfId-508897]You can partition a PIX Firewall, ASA, or FWSM into multiple security firewalls, also known as security contexts. Each context is an independent system with its own configuration and policies. You can manage these standalone contexts in Security Manager, even though the parent device is not managed by Security Manager. For more information, see Chapter 58, “Configuring Security Contexts on Firewall Devices”.

 [bookmark: pgfId-508899]Note If you select this check box, the available target OS version for the security module is displayed in the Target OS Version field.

  
        

 
         
         		[bookmark: pgfId-508905]License Supports Failover

 [bookmark: pgfId-508907](ASA 5505, 5510 only.)

  
         		[bookmark: pgfId-508909]Whether an optional failover license is installed on the device. The option is active for ASA 5505 and 5510 devices only. Security Manager deploys failover policies to the device only if this option is selected.

 [bookmark: pgfId-508911]Tip If you discover policies from the device, Security Manager determines the license status and sets this option appropriately.  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-512305][bookmark: 6304][bookmark: ivman_proc_AddingDevicesfromanExportFile]Adding Devices from an Inventory File[bookmark: marker-512299][bookmark: marker-512301][bookmark: marker-512303]

 
     [bookmark: pgfId-512310]You can add devices from an inventory file in comma-separated values (CSV) format. For example, an inventory file you exported from CiscoWorks Common Services Device Credential Repository (DCR) or another Security Manager server, or the seed file you used with Cisco Security Monitoring, Analysis and Response System (CS-MARS). For detailed information about the inventory file formats, see Supported CSV Formats for Inventory Import/Export.

 
     [bookmark: pgfId-512312]Tips

 
      
      		 [bookmark: pgfId-512317]This procedure explains how to use a CSV file for importing devices. If you have a .dev file, which includes not only the inventory but the policies and policy objects assigned to the devices, you cannot use this procedure. Instead, use the  File > Import command and follow the instructions in Importing Policies or Devices.

 
      		 [bookmark: pgfId-512319]If you want to build an inventory file by hand, the easiest approach is to export the Security Manager inventory in the desired format and use that file as the basis for your inventory file.

 
      		 [bookmark: pgfId-512321]The devices you import cannot be duplicates of devices already in the device inventory. You cannot, for example, update device information in the inventory by re-importing the device.

 
      		 [bookmark: pgfId-512326]If you are adding a router that does not appear in the explicitly supported device list, you can try to manage it as a generic device. When adding a generic router from an inventory file, you must make sure that you use the correct SYSOBJID in the CSV file. Use 1.0.0.0.0.0.0.0.1 for devices running Cisco IOS Software (Cisco Generic Integrated Services Router) and use 1.0.0.0.0.0.0.0.2 for devices running Cisco IOS XE Software (Cisco Generic Aggregation Services Router). For more information about generic device support, see Working with Generically Supported Devices.

 
     

 
     [bookmark: pgfId-512328]Before You Begin

 
     [bookmark: pgfId-512330]Before beginning this procedure, ensure the following preparations have been made:

 
      
      		 [bookmark: pgfId-512335]Prepare the devices to be managed by Security Manager. For more information, see Chapter 2, “Preparing Devices for Management”.

 
      		 [bookmark: pgfId-512339]If you are using ACS for authentication, define the devices in ACS. See the  Installation Guide for Cisco Security Manager .

 
      		 [bookmark: pgfId-512341]Put the inventory file you want to use on the Security Manager server. You cannot import devices from a file on your client system.

 
      		 [bookmark: pgfId-512346]If you are using a non-standard communication protocol for a type of device, update the global device communication properties to specify the correct protocol. For more information, see Device Communication Page.

 
     

 
     [bookmark: pgfId-512348]Related Topics

 
      
      		 [bookmark: pgfId-512353]Understanding the Device View

 
      		 [bookmark: pgfId-512358]Working with Device Groups

 
      		 [bookmark: pgfId-512363]Viewing or Changing Device Properties

 
     

 
     
 
     [bookmark: pgfId-512365]Step 1 In Device view, select File > New Device or click the New Device button in the Device selector. The New Device wizard opens to the Choose Method page.

 
     [bookmark: pgfId-512370]Step 2 On the Choose Method page, select Add Device from File and click Next to open the Device Information page (see Device Information Page—Add Device from File).

 
     [bookmark: pgfId-512372]Step 3 Click Browse and select the inventory file that contains the devices that you want to import. Make sure that you select the correct file type to indicate how the file is formatted.

 
     [bookmark: pgfId-512374]Security Manager evaluates the contents of the inventory file and displays the list of devices in the import table. All devices that have the status Ready to Import are automatically selected. The list identifies the reasons the unselected devices cannot be imported. You can deselect any devices that you do not want to import.

 
     [bookmark: pgfId-512376]To see detailed information on a device, select it in the import table. The details are displayed in the bottom pane. You can select different discovery options or transport settings per device.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-512378]Tip If you selected an inventory file in the Security Manager format, you have the option to import the devices without performing policy discovery. This makes it possible for you to add devices that are not currently active in the network. If you want to perform policy discovery on a device, select the device, select Perform Device Discovery in the bottom panel, and select your discovery options. You can select policy discovery settings for all devices in a folder by selecting the folder instead of individual devices. The other CSV formats require that you perform policy discovery during import.


     
      

     

     

 
     [bookmark: pgfId-512383]When you are finished analyzing the list and modifying discovery and transport settings, click Next to continue to the optional step of selecting groups, or click Finish to complete the wizard. In either case, Security Manager attempts to log into each device and perform the discovery you selected unless you are using a CSV file in Security Manager format and elected not to perform discovery. For the other formats, Security Manager must be able to log into the device to add it to the inventory. The status is displayed in the Discovery Status dialog box (see Discovery Status Dialog Box).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-512388]Tip If you are discovering policies while adding a device, carefully read any messages that are presented. These messages can contain important recommendations on the next steps you should take. For example, when you add Cisco IOS routers or Catalyst devices, we recommend that you immediately deploy the discovered configuration to a file so that Security Manager can take ownership of the configuration. For more information about deployment methods, see Understanding Deployment Methods.


     
      

     

     

 
     [bookmark: pgfId-512393]Step 4 (Optional) On the Device Grouping page, select the device group to which the imported devices should be added (see Device Groups Page).

 
     [bookmark: pgfId-512395]Click Finish.

 
     [bookmark: pgfId-512397]Step 5 If you are adding a device that contains modules and you are performing device discovery, and Security Manager supports discovering modules for that type of device, you are notified when the discovery of the device chassis is complete and you are asked if you want to discover the device’s modules. When you click Yes, you are prompted for this information:

 
      
      		 [bookmark: pgfId-512402]Catalyst 6500 service modules—The Service Module Credentials dialog box opens prompting for the following information, based on the modules contained in the chassis. For more information, see Service Module Credentials Dialog Box.

 
     

 
     [bookmark: pgfId-512404] – FWSM—The management IP address (recommended), the user name and passwords, and the type of discovery you want to perform. If the FWSM is the second device in a failover pair, select Do Not Discover Module for the failover module. (Security Manager always manages the active admin context, regardless of whether you added the primary or secondary failover service module.)

 
     [bookmark: pgfId-512406] – IDSM—The user name and password and the type of discovery you want to perform.

 
     [bookmark: pgfId-512408] – ASA-SM—Discovering ASA service modules in a Catalyst 6500 through the chassis is not supported. You must directly add the ASA-SM using the management IP address of the ASA-SM.

 
      
      		 [bookmark: pgfId-512413]IPS Router Module—The type of discovery you want to perform, the management IP address, the user name and password, and other SSL connection information. For more information, see IPS Module Discovery Dialog Box.

 
     

 
     [bookmark: pgfId-512415]You can skip discovery for any module you do not want to manage in Security Manager.

 
     [bookmark: pgfId-512417]Click OK. You are returned to the Discovery Status dialog box, where you can view the progress of service module discovery.

 
     [bookmark: pgfId-512419]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-512431][bookmark: 6411][bookmark: ivpage_cncpt_DeviceInformationPageDCR]Device Information Page—Add Device from File [bookmark: marker-512427][bookmark: marker-512429]

 
     [bookmark: pgfId-512433]Use the New Device wizard’s Device Information page for adding devices from an inventory file to select the file and to specify policy discovery options. The inventory file must be on the Security Manager server; you cannot use an inventory file on a client system.

 
     [bookmark: pgfId-512438]The formats you can use for the inventory file are explained in Supported CSV Formats for Inventory Import/Export. Typically, the inventory file will have been exported from another Security Manager server, from a CiscoWorks Common Services server, or it will be the seed file used to populate the inventory of a Cisco Security Monitoring, Analysis and Response System (CS-MARS) server.

 
     [bookmark: pgfId-512443]If you are trying to import devices using a .dev file, you need to use the File > Import command instead of this page. For more information, see Importing Policies or Devices.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-512445]Tip If you are adding devices that contain modules, for example, a Catalyst switch with an FWSM, you are prompted for module discovery information after you click Finish.


     
      

     

     

 
     [bookmark: pgfId-512447]Navigation Path

 
     [bookmark: pgfId-512449]To start the New Device wizard, from Device view, select File > New Device, or click the Add button in the device selector.

 
     [bookmark: pgfId-512451]Related Topics

 
      
      		 [bookmark: pgfId-512456]Understanding the Device View

 
      		 [bookmark: pgfId-512461]Adding Devices from an Inventory File

 
      		 [bookmark: pgfId-512466]Device Groups Page

 
      		 [bookmark: pgfId-512471]Discovering Policies

 
      		 [bookmark: pgfId-512476]Device Communication Page

 
      		 [bookmark: pgfId-512481]Discovery Status Dialog Box

 
     

 
     [bookmark: pgfId-512483]Field Reference

 
     [bookmark: pgfId-512486] 

 
      
       
        
        [bookmark: pgfId-508924]Table 3-7 [bookmark: 6456]New Device Wizard, Device Information Page When Adding Devices from Inventory Files 

 
        
       
         
         		
           
           [bookmark: pgfId-508930]Element
          
  
         		
           
           [bookmark: pgfId-508932]Description
          
  
        

 
         
         		[bookmark: pgfId-508938]Import Devices From

  
         		[bookmark: pgfId-508940]The inventory file that contains the devices you want to import. Click Browse to select the file on the Security Manager server.

 [bookmark: pgfId-508942]When selecting the file, you must also select the correct file type so that Security Manager can correctly evaluate the comma-separated values (CSV) file.

  
        

 
         
         		 [bookmark: pgfId-508948]Device Import Table

 [bookmark: pgfId-508950]After you select a file, Security Manager evaluates its contents and displays the list of devices defined in the file in the table in the upper pane of the page. Security Manager automatically selects all devices whose status is Ready to Import. Typically, these are the devices that do not already exist in the device inventory.

 [bookmark: pgfId-508952]The table contains the following columns.

  
        

 
         
         		[bookmark: pgfId-508960]Import

  
         		[bookmark: pgfId-508962]Select this checkbox to add the device to the inventory. You can select or deselect a folder to select or deselect all devices within the folder.

  
        

 
         
         		[bookmark: pgfId-508968]Display Name

  
         		[bookmark: pgfId-508970]The name that will be displayed in the Security Manager Device selector.

  
        

 
         
         		[bookmark: pgfId-508976]Host Name

  
         		[bookmark: pgfId-508978]The host name defined on the device.

  
        

 
         
         		[bookmark: pgfId-508984]Transport

  
         		[bookmark: pgfId-508986]The transport protocol that should be used to connect to the device.

  
        

 
         
         		[bookmark: pgfId-508992]Status

  
         		[bookmark: pgfId-508994]Whether Security Manager can import the device. Devices can be imported only if they have the status Ready to Import. For detailed information on a device’s status, select it and read the expanded status information in the Status text box in the lower right corner of the page.

  
        

 
         
         		[bookmark: pgfId-509000]Device Type

  
         		[bookmark: pgfId-509002]The type of device.

  
        

 
         
         		 [bookmark: pgfId-509008]Details Pane

 [bookmark: pgfId-509010]Below the device import table is a pane that displays the details for the device selected in the table. The Identity information repeats the table fields. The Status text box displays an extended explanation of the import status.

 [bookmark: pgfId-509012]The Discover Device Settings and Transport groups let you specify how Security Manager should import the device. If you select a folder instead of a device, the settings you select apply to all devices in the folder. The settings are explained below.

  
        

 
         
         		 
           
           [bookmark: pgfId-509020]Discover Device Settings
          
  
        

 
         
         		[bookmark: pgfId-509028]Perform Device Discovery

  
         		[bookmark: pgfId-509030]Whether to discover policies directly from the device:

 
           
           		 [bookmark: pgfId-509032]If the inventory file is in Security Manager format, you must select Perform Device Discovery to discovery inventory and policies (otherwise, the device is added without being evaluated). If you are adding offline or standby devices, you can leave this option deselected to easily add the device to the inventory.

 
           		 [bookmark: pgfId-509034]All other inventory file types require device discovery.

 
          

  
        

 
         
         		[bookmark: pgfId-509040]System Context

  
         		[bookmark: pgfId-509042]Whether the selected device is the system execution space on a device running in multiple context mode (that is, more than one security context is defined on the device). If the device is the system execution space, you must select this option for discovery to complete correctly.

  
        

 
         
         		[bookmark: pgfId-509048]Discover

  
         		[bookmark: pgfId-509050]The type of elements that should be discovered and added to the inventory. You have these options:

 
           
           		 [bookmark: pgfId-509052]Policies and Inventory—Discover policies, interfaces, and service modules (if applicable). This is the default and recommended option.

 
          

 [bookmark: pgfId-509054]When policy discovery is initiated, the system analyzes the configuration on the device, then imports the configured service and platform policies. When inventory discovery is initiated, the system analyzes the interfaces on the device and then imports the interface list. If the device is a composite device, all the service modules in the device are discovered and imported.

 [bookmark: pgfId-509056]If you select this option, the checkboxes below are activated and you can use them to control the types of policies that are discovered.

 [bookmark: pgfId-509058]Note During discovery, if you import an ACL that is inactive, it is shown as disabled in Security Manager. If you deploy the same ACL, it will be removed by Security Manager.

 
           
           		 [bookmark: pgfId-509060]Inventory Only—Discovers interfaces and service modules (if applicable).

 
          

  
        

 
         
         		[bookmark: pgfId-509066]Platform Settings

  
         		[bookmark: pgfId-509071]Whether to discover the platform settings, which are also called platform-specific policy domains. Platform-specific policy domains exist on firewall devices and Cisco IOS routers. These domains contain policies that configure features that are specific to the selected platform. For more information, see Service Policies vs. Platform-Specific Policies.

  
        

 
         
         		[bookmark: pgfId-509077]Firewall Policies

  
         		[bookmark: pgfId-509082]Whether to discover firewall policies, which are also called firewall services. Firewall services include policies such as access rules, inspection rules, AAA rules, web filter rules, and transparent rules. For details see, Chapter 12, “Introduction to Firewall Services”

  
        

 
         
         		[bookmark: pgfId-509088]IPS Policies

  
         		[bookmark: pgfId-509096]Whether to discover IPS policies such as signatures and virtual sensors. For more information, see Overview of IPS Configuration or Overview of Cisco IOS IPS Configuration.

  
        

 
         
         		[bookmark: pgfId-509102]RA VPN Policies

  
         		[bookmark: pgfId-509107]Whether to discover IPSec and SSL remote access VPN policies such as IKE proposals and IPsec proposals. This option is disabled if the device does not support remote access VPN configuration. For more information, see Chapter 30, “Managing Remote Access VPNs: The Basics”.

  
        

 
         
         		[bookmark: pgfId-509113]Discover Policies for Security Contexts

  
         		[bookmark: pgfId-509115]For devices running in multiple-context mode, where more than one security context is defined on the device, whether to discover those security contexts.

  
        

 
         
         		 [bookmark: pgfId-509121]Transport

 [bookmark: pgfId-509123]The transport settings determine the method Security Manager will use to contact the device. Each device type has a default method, but you can select your preferred transport method. The device must be configured to respond to the method you select. If you are not performing device discovery, the device is not contacted.

  
        

 
         
         		[bookmark: pgfId-509131]Protocol

  
         		[bookmark: pgfId-509133]The protocol Security Manager should use when connecting to the device.

  
        

 
         
         		[bookmark: pgfId-509139]Server

  
         		[bookmark: pgfId-509141]For devices that use them, the name of the Auto Update Server (AUS) or Configuration Engine server the device uses to obtain configuration updates. The server must already be defined in Security Manager, or you must select the server from the import list, to import devices that use these servers.

  
        

 
         
         		[bookmark: pgfId-509147]Device Identity

  
         		[bookmark: pgfId-509149]For devices that use servers, the string value that uniquely identifies the device in the Auto Update Server or the Configuration Engine.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-512496][bookmark: 6604][bookmark: ivman_cncpt_WorkingwiththeDeviceInventory]Working with the Device Inventory[bookmark: marker-512492][bookmark: marker-512494]

 
    [bookmark: pgfId-512498]The following topics describe tasks related to managing the device inventory.

 
     
     		 [bookmark: pgfId-512503]Adding, Editing, or Deleting Auto Update Servers or Configuration Engines

 
     		 [bookmark: pgfId-512508]Adding or Changing Interface Modules

 
     		 [bookmark: pgfId-512513]Viewing or Changing Device Properties

 
     		 [bookmark: pgfId-512518]Changing Critical Device Properties

 
     		 [bookmark: pgfId-512523]Showing Device Containment

 
     		 [bookmark: pgfId-512528]Cloning a Device

 
     		 [bookmark: pgfId-512533]Deleting Devices from the Security Manager Inventory

 
    

 
    [bookmark: pgfId-512535]In addition to these topics, see the following related topics:.

 
     
     		 [bookmark: pgfId-512540]Adding Devices to the Device Inventory

 
     		 [bookmark: pgfId-512545]Exporting the Device Inventory

 
     		 [bookmark: pgfId-512550]Importing Policies or Devices

 
    

 
     
      [bookmark: pgfId-512564][bookmark: 6646][bookmark: ivman_proc_AddingEditingorDeletingAutoUpdateServersorConfigurationEngines]Adding, Editing, or Deleting Auto Update Servers or Configuration Engines [bookmark: marker-512556][bookmark: marker-512558][bookmark: marker-512560][bookmark: marker-512562]

 
     [bookmark: pgfId-512566]If you want to use Security Manager to manage devices that use other servers to manage their configuration (for example, devices that have dynamic IP addresses supplied by a DHCP server, an address that might not stay constant between device reboots), you must identify the server in Security Manager. These are the servers you can use:

 
      
      		 [bookmark: pgfId-512568]Auto Update Server (AUS), which is used for upgrading device configuration files on PIX Firewall and ASA devices that use the auto update feature.

 
      		 [bookmark: pgfId-512570]Cisco Configuration Engine, which is used for upgrading device configuration files on Cisco IOS routers, ASA devices, and PIX Firewalls that use the configuration engine feature.

 
     

 
     [bookmark: pgfId-512572]Security Manager cannot initiate direct communication with devices that acquire their interface addresses using DHCP because their IP addresses are not known ahead of time. Furthermore, these devices might not be running, or they might be behind firewalls and NAT boundaries when the management system must make changes. These devices connect to an Auto Update Server or Configuration Engine to get device information.

 
     [bookmark: pgfId-512574]You can add AUS and Configuration Engine servers to the device inventory when you add devices manually or when you view device properties. You do not have to be adding or viewing the properties of a device that uses one of these servers, you just have to get to the appropriate field to access the controls to add, edit, or delete these servers.

 
     [bookmark: pgfId-512579]You can also add these servers if you import them from an inventory file exported from CiscoWorks Common Services Device Credential Repository (DCR) or from another Security Manager server. If you import the server, you bypass the procedure described in this section. For more information about importing devices, see Adding Devices from an Inventory File.

 
     [bookmark: pgfId-512581]Before You Begin

 
     [bookmark: pgfId-512583]If you want to populate the Security Manager inventory with your list of AUS and Configuration Engine servers without respect to adding devices, the best approach is to use the New Device wizard and to select Add New Device as the add method. This approach is described in this procedure.

 
     [bookmark: pgfId-512585]You can also add or edit servers by selecting a device in the Device selector and clicking Tools > Device Properties. Click General in the device properties table of contents. The Server field is in either the Auto Update or Configuration Engine groups. You can add or edit only the type of server identified in the group name.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-512589]Tip Security Manager cannot determine the software version running on a Configuration Engine when you add it. However, Security Manager cannot deploy configurations correctly to all versions of Configuration. Ensure that your Configuration Engines are running a supported release (see the release notes for this version of the product to see which Configuration Engine versions are supported at http://www.cisco.com/en/US/products/ps6498/prod_release_notes_list.html).


     
      

     

     

 
     [bookmark: pgfId-512591]Related Topics

 
      
      		 [bookmark: pgfId-512596]Adding Devices from the Network

 
      		 [bookmark: pgfId-512601]Adding Devices by Manual Definition

 
      		 [bookmark: pgfId-512606]Viewing or Changing Device Properties

 
     

 
     
 
     [bookmark: pgfId-512608]Step 1 Locate the field that allows you to identify and manage either AUS or Configuration Engine entries in the device inventory:

 
     [bookmark: pgfId-512610] a. Select File > New Device to open the New Device wizard, select Add New Device on the Choose Method page, and click Next.

 
     [bookmark: pgfId-512612] b. On the Device Information page, select an ASA device from the Device Type selector, for example, Cisco ASA-5580 Adaptive Security Appliance. The Server field in the Auto Update group should include Add Server in the drop-down list. It will also include Edit Server if there are servers already defined. If these entries have specific server types (for example, Add Auto Update Server or Add Configuration Engine), then you will be limited to adding, editing, or deleting that type of server (in this case, select other types of devices to find the appropriate server type).

 
     [bookmark: pgfId-512617]Step 2 To add a new AUS or Configuration Engine server, select Add Server from the Server drop-down list to open the Server Properties dialog box (see Server Properties Dialog Box).

 
     [bookmark: pgfId-512622]Step 3 To edit a server, select Edit Server from the Server drop-down list to open the Available Servers dialog box (see Available Servers Dialog Box). You can then select the server and click Edit, which opens the Server Properties dialog box where you can make your changes.

 
     [bookmark: pgfId-512624]From the Available Servers dialog box, you can also:

 
      
      		 [bookmark: pgfId-512626]Click  Create to add a server.

 
      		 [bookmark: pgfId-512628]Select a server and click  Delete to remove it from the inventory. You are asked to confirm the deletion. Make sure that the server is not being used by a device in the inventory.

 
     

 
     [bookmark: pgfId-512630]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-512648][bookmark: 6724][bookmark: ivpage_cncpt_ServerPropertiesDialogBox]Server Properties Dialog Box[bookmark: marker-512642][bookmark: marker-512644][bookmark: marker-512646]

 
     [bookmark: pgfId-512650]Use the Server Properties dialog box to specify the properties of an Auto Update Server or Configuration Engine.

 
     [bookmark: pgfId-512652]Depending on how you open this dialog box, the title of the dialog box might specify the type of server (for example, Auto Update Server Properties or Configuration Engine Properties). The dialog boxes are essentially identical.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-512656]Tip Security Manager cannot determine the software version running on a Configuration Engine when you add it. However, Security Manager cannot deploy configurations correctly to all versions of Configuration. Ensure that your Configuration Engines are running a supported release (see the release notes for this version of the product to see which Configuration Engine versions are supported at http://www.cisco.com/en/US/products/ps6498/prod_release_notes_list.html).


     
      

     

     

 
     [bookmark: pgfId-512658]Navigation Path

 
     [bookmark: pgfId-512660]To open this dialog box, do one of the following:

 
      
      		 [bookmark: pgfId-512662]Select  Add Server... from the  Server field in the Auto Update Server or Configuration Engine groups on the Device Information page of the New Device wizard when adding a device manually. The selection might also be named Add Auto Update Server or Add Configuration Engine.

 
      		 [bookmark: pgfId-512664]Select  Add Server... from the  Server field in the Auto Update Server or Configuration Engine groups on the Device Properties—General page. The selection might also be named Add Auto Update Server or Add Configuration Engine.

 
      		 [bookmark: pgfId-512669]Click  Create , or select a server and click  Edit , in the Available Servers dialog box (see Available Servers Dialog Box).

 
     

 
     [bookmark: pgfId-512671]Related Topics

 
      
      		 [bookmark: pgfId-512676]Available Servers Dialog Box

 
      		 [bookmark: pgfId-512681]Device Information Page—New Device

 
      		 [bookmark: pgfId-512686]Device Information Page – Add Device from Network

 
      		 [bookmark: pgfId-512691]Adding, Editing, or Deleting Auto Update Servers or Configuration Engines

 
      		 [bookmark: pgfId-512696]Viewing or Changing Device Properties

 
     

 
     [bookmark: pgfId-512698]Field Reference

 
     [bookmark: pgfId-512701] 

 
      
       
        
        [bookmark: pgfId-509162]Table 3-8 [bookmark: 6778]Server Properties Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-509168]Element
          
  
         		
           
           [bookmark: pgfId-509170]Description
          
  
        

 
         
         		[bookmark: pgfId-509176]Type

  
         		[bookmark: pgfId-509178]The type of server you are defining, either Auto Update Server or Configuration Engine.

 [bookmark: pgfId-509180]This field is displayed only if you are adding a server. You cannot change the type of an existing server.

 [bookmark: pgfId-509182]For new servers, this field is also not displayed if the title of the dialog box specifies the type of server you are adding.

  
        

 
         
         		[bookmark: pgfId-509188]Server Name

  
         		[bookmark: pgfId-509190]The DNS hostname of the server.

  
        

 
         
         		[bookmark: pgfId-509196]Domain Name

  
         		[bookmark: pgfId-509198]The DNS domain name of the server.

  
        

 
         
         		[bookmark: pgfId-509204]IP Address

  
         		[bookmark: pgfId-509206]The IP address of the server.

  
        

 
         
         		[bookmark: pgfId-509212]Display Name

  
         		[bookmark: pgfId-509214]The name to display in Security Manager for the server.

  
        

 
         
         		[bookmark: pgfId-509220]Username

  
         		[bookmark: pgfId-509222]The username for logging into the server.

  
        

 
         
         		[bookmark: pgfId-509228]Password

  
         		[bookmark: pgfId-509230]The password for accessing the server. In the Confirm field, enter the password again.

  
        

 
         
         		[bookmark: pgfId-509236]Port

  
         		[bookmark: pgfId-509238]The port number that the device managed by the Auto Update Server or Configuration Engine uses to communicate with the server. The port number is typically 443.

  
        

 
         
         		[bookmark: pgfId-509244]URN

  
         		[bookmark: pgfId-509246]This field is displayed only for Auto Update Servers.

 [bookmark: pgfId-509248]The uniform resource name for the Auto Update Server. The URN is the name that identifies the resource on the Internet. The URN is part of a URL, for example, /autoupdate/AutoUpdateServlet. The full URL could be: https://: server ip:443/autoupdate/AutoUpdateServlet

 [bookmark: pgfId-509250]where:

 
           
           		 [bookmark: pgfId-509252] server ip is the IP address of the Auto Update Server.

 
           		 [bookmark: pgfId-509254]443 is the port number of the Auto Update Server.

 
           		 [bookmark: pgfId-509256]/autoupdate/AutoUpdateServlet is the URN of the Auto Update Server.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-512715][bookmark: 6847][bookmark: ivpage_cncpt_AvailableServersDialogBox]Available Servers Dialog Box[bookmark: marker-512713]

 
     [bookmark: pgfId-512717]Use the Available Servers dialog box to add, edit, or delete an Auto Update Server or Configuration Engine.

 
     [bookmark: pgfId-512719]Depending on how you open this dialog box, the title of the dialog box might specify the type of servers listed (for example, Available Auto Update Servers or Available Configuration Engines). The dialog boxes are essentially identical.

 
     [bookmark: pgfId-512721]Each row represents a single server, and shows the display name for the server in Security Manager, its IP address, and DNS hostname and domain name. If the dialog box title does not include the server type, the Type field specifies AUS or CE (Configuration Engine).

 
      
      		 [bookmark: pgfId-512726]To add a server, click the  Create button and fill in the Server Properties dialog box (see Server Properties Dialog Box).

 
      		 [bookmark: pgfId-512728]To edit the properties of a server, select it and click the  Edit button.

 
      		 [bookmark: pgfId-512730]To delete a server, select it and click the  Delete button. You are asked to confirm the deletion.

 
     

 
     [bookmark: pgfId-512732]Navigation Path

 
     [bookmark: pgfId-512734]To open this dialog box, do one of the following:

 
      
      		 [bookmark: pgfId-512736]Select  Edit Server... from the  Server field in the Auto Update Server or Configuration Engine groups on the Device Information page of the New Device wizard when adding a device manually. The selection might also be named Edit Auto Update Server or Edit Configuration Engine.

 
      		 [bookmark: pgfId-512738]Select  Edit Server... from the  Server field in the Auto Update Server or Configuration Engine groups on the Device Properties—General page. The selection might also be named Edit Auto Update Server or Edit Configuration Engine.

 
     

 
     [bookmark: pgfId-512740]Related Topics

 
      
      		 [bookmark: pgfId-512745]Device Information Page—New Device

 
      		 [bookmark: pgfId-512750]Device Information Page – Add Device from Network

 
      		 [bookmark: pgfId-512755]Adding, Editing, or Deleting Auto Update Servers or Configuration Engines

 
      		 [bookmark: pgfId-512760]Viewing or Changing Device Properties

 
     

 
    
 
     
      [bookmark: pgfId-512772][bookmark: 6898][bookmark: ivman_proc_AddingorChangingInterfaceModules]Adding or Changing Interface Modules [bookmark: marker-512766][bookmark: marker-512768][bookmark: marker-512770]

 
     [bookmark: pgfId-512774]Many devices allow you to add or change interface modules. When you make a change to the interface modules hosted in a device, you change the device’s inventory.

 
     [bookmark: pgfId-512776]If you add or change an interface card, you should rediscover the inventory on the device. Rediscovering inventory will replace the Interfaces policy (for routers, the Interfaces > Interfaces policy) and ensure that Security Manager has a correct view of the capabilities of the interfaces available on the device.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-512778]Note Inventory rediscovery is especially important for ASA 5580 devices in which you install a 4 GB Ethernet Fiber interface card. For other types of devices, you can usually make manual changes to the Interfaces policy, but rediscovering inventory is the easier and more reliable choice.


     
      

     

     

 
     
 
     [bookmark: pgfId-512780]Step 1 Right-click the device and select Discover Policies on Device.

 
     [bookmark: pgfId-512782]Step 2 In the Create Discovery Task dialog box, make at least these selections and click OK to start rediscovery:

 
      
      		 [bookmark: pgfId-512784]Discover from  Live Device .

 
      		 [bookmark: pgfId-512786]Policies to discover:  Inventory .

 
     

 
     [bookmark: pgfId-512788]Step 3 After discovery completes, edit the Interfaces or Interfaces > Interfaces policy as appropriate and verify that the policy reflects your desired configuration.

 
     [bookmark: pgfId-512790]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-512804][bookmark: 6931][bookmark: ivman_proc_DefiningDeviceProperties]Viewing or Changing Device Properties[bookmark: marker-512798][bookmark: marker-512800][bookmark: marker-512802]

 
     [bookmark: pgfId-512806]When you add a device to the inventory, you specify at least some of the device’s properties, such as names and credentials. For devices that are in the inventory, you can view and change the device properties.

 
     [bookmark: pgfId-512808]Related Topics

 
      
      		 [bookmark: pgfId-512813]Understanding the Device View

 
      		 [bookmark: pgfId-512818]Understanding Device Properties

 
      		 [bookmark: pgfId-512823]Understanding Policies

 
      		 [bookmark: pgfId-512828]Changing Critical Device Properties

 
     

 
     
 
     [bookmark: pgfId-512830]Step 1 In Device view, do one of the following in the Device selector to open the Device Properties dialog box:

 
      
      		 [bookmark: pgfId-512832]Double-click a device.

 
      		 [bookmark: pgfId-512834]Right-click a device and select  Device Properties .

 
      		 [bookmark: pgfId-512836]Select a device and select  Tools > Device Properties .

 
     

 
     [bookmark: pgfId-512838]Step 2 In the Device Properties dialog box, click these entries in the table of contents in the left pane to view or change the properties. You must click Save before moving from one page to another.

 
      
      		 [bookmark: pgfId-512843]General—General information about the device, such as the device identity, the operating system running on the device, and transport settings. For information about the fields, see Device Properties: General Page.

 
      		 [bookmark: pgfId-512848]Credentials—The device credentials required to log into the device. For information about the fields, see Device Credentials Page.

 
      		 [bookmark: pgfId-512853]Device Groups—The groups to which the device belongs. For information about the fields, see Device Groups Page.

 
      		 [bookmark: pgfId-512858]Cluster Information—Cluster details for the cluster group, if any. For information about the fields, see Cluster Information Page.

 
      		 [bookmark: pgfId-512863]Policy Object Overrides—The local overrides to policy objects for the device. Policy Object Overrides is a folder that contains the various policy object types that are available for the device. Click a specific policy object type to view the policy objects of that type used by the device and their overrides, if any. For more information about the fields, see Policy Object Override Pages.

 
     

 
     [bookmark: pgfId-512865]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-512877][bookmark: 6993][bookmark: ivpage_cncpt_GeneralPage-1]Device Properties: General Page[bookmark: marker-512873][bookmark: marker-512875]

 
     [bookmark: pgfId-512879]Use the Device Properties General page to add or edit information about the basic properties of the device.

 
     [bookmark: pgfId-512881]Navigation Path

 
      
      		 [bookmark: pgfId-512883]From the Device selector, right-click a device and select  Device Properties , then click  General .

 
      		 [bookmark: pgfId-512885]From the Device selector, double-click a device, then click  General .

 
      		 [bookmark: pgfId-512887]Select a device and select  Tools > Device Properties , then click  General .

 
     

 
     [bookmark: pgfId-512889]Related Topics

 
      
      		 [bookmark: pgfId-512894]Understanding Device Properties

 
      		 [bookmark: pgfId-512899]Device Credentials Page

 
      		 [bookmark: pgfId-512904]Device Groups Page

 
      		 [bookmark: pgfId-512909]Policy Object Override Pages

 
     

 
     [bookmark: pgfId-512911]Field Reference

 
     [bookmark: pgfId-512914] 

 
      
       
        
        [bookmark: pgfId-509269]Table 3-9 [bookmark: 7035]Device Properties General Page 

 
        
       
         
         		
           
           [bookmark: pgfId-509275]Element
          
  
         		
           
           [bookmark: pgfId-509277]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-509283]Identity
          
  
        

 
         
         		[bookmark: pgfId-509291]Device Type

  
         		[bookmark: pgfId-509293]The type of device.

  
        

 
         
         		[bookmark: pgfId-509299]IP Type

  
         		[bookmark: pgfId-509301]Whether the IP address for the device is static (defined on the device) or dynamic (supplied by a DHCP server). Depending on the IP type you select, the displayed fields differ.

  
        

 
         
         		[bookmark: pgfId-509307]Hostname

 [bookmark: pgfId-509309](Static IP only)

  
         		[bookmark: pgfId-509311]The DNS hostname for the device.

 [bookmark: pgfId-509313]This is not necessarily the same name that is configured as the hostname on the device. This property is not updated with the hostname specified in the Hostname device property. It is also not updated with the name defined in the device configuration if you rediscover the device.

 [bookmark: pgfId-509315]If you added the device to Security Manager by adding its configuration file, the hostname is initially set to the name specified in the configuration file. If no hostname is specified in the configuration, the name of the file is used as the DNS hostname.

  
        

 
         
         		[bookmark: pgfId-509321]Domain Name

 [bookmark: pgfId-509323](Static IP only)

  
         		[bookmark: pgfId-509325]The DNS domain name for the device.

  
        

 
         
         		[bookmark: pgfId-509331]IP Address

 [bookmark: pgfId-509333](Static IP only)

  
         		[bookmark: pgfId-509335]The management IP address of the device, for example 192.168.3.8.

  
        

 
         
         		[bookmark: pgfId-509341]Display Name

  
         		[bookmark: pgfId-509343]The name to display in the Security Manager Device selector.

 [bookmark: pgfId-509345]The maximum length is 70 characters. Valid characters are: 0-9; uppercase A-Z; lowercase a-z; and the following characters: _ -. : and space.

  
        

 
         
         		 
           
           [bookmark: pgfId-509351]Operating System
          
  
        

 
         
         		[bookmark: pgfId-509359]OS Type

  
         		[bookmark: pgfId-509361]The family of the operating system running on the device.

  
        

 
         
         		[bookmark: pgfId-509367]Image Name

  
         		[bookmark: pgfId-509369]The name of the image running on the device. The image name is updated whenever you deploy to the device or rediscover its policies.

  
        

 
         
         		[bookmark: pgfId-509375]Running OS Version

  
         		[bookmark: pgfId-509377]The version of the operating system running on the device.

  
        

 
         
         		[bookmark: pgfId-509383]Target OS Version

  
         		[bookmark: pgfId-509385]The OS version on which you want to base the device’s configuration. When creating a configuration file using the rules you configure, Security Manager uses commands available in the target OS version. This field is read-only for IPS devices.

 [bookmark: pgfId-509390]You cannot change the target OS version to a version that significantly changes the feature set available for the device. For more information, see Changes That Change the Feature Set in Security Manager.

  
        

 
         
         		[bookmark: pgfId-509396]Options

  
         		[bookmark: pgfId-509398]A read-only field whose values are NONE or IPS. The value IPS indicates that the IPS feature is available on the device.

  
        

 
         
         		[bookmark: pgfId-509404]IPS Running OS Version

  
         		[bookmark: pgfId-509406]A read-only field that displays the version of IOS IPS running on the router. This field does not appear if the Options field has the value of NONE.

  
        

 
         
         		[bookmark: pgfId-509412]IPS Target OS Version

  
         		[bookmark: pgfId-509414]A read-only field that displays the target version of IOS IPS running on the router. This field does not appear if the Options field has the value of NONE.

  
        

 
         
         		[bookmark: pgfId-509420]Contexts

  
         		[bookmark: pgfId-509422]Whether the device hosts a single security context (Single) or multiple security contexts (Multi). This field is displayed only if the OS type is an FWSM, ASA, or PIX Firewall 7.0.

  
        

 
         
         		[bookmark: pgfId-509428]Operational Mode

  
         		[bookmark: pgfId-509430]The mode in which the device is operating. This field is displayed only if the OS type is FWSM, ASA, or PIX Firewall 7.0+. The options available are: Transparent or Router. If you choose Multi for Contexts, this mode defaults to Mixed. Mixed applies only to ASA 9.0+ and FWSM 3.1+ devices, and ASA-SMs.

  
        

 
         
         		 
           
           [bookmark: pgfId-509436]Device Communication Settings
          
  
        

 
         
         		[bookmark: pgfId-509444]Transport Protocol

  
         		[bookmark: pgfId-509449]The transport protocol that Security Manager should use when accessing the device or deploying configurations to it. If you select Use Default, the transport protocol set in the Device Communication page (Tools > Security Manager Administration > Device Communication) is used (see Device Communication Page). You can select a different protocol if the device is not configured to use the default protocol.

 [bookmark: pgfId-509451]The available transport protocols differ depending on what the device type supports. For some device types, such as ASA, there is only one option, so the field is grayed out.

  
        

 
         
         		 
           
           [bookmark: pgfId-509457]CS-MARS Monitoring
          
  
        

 
         
         		[bookmark: pgfId-509465]Monitored By

  
         		[bookmark: pgfId-509467]The CS-MARS server that monitors this device, if any.

 [bookmark: pgfId-509469]Click Discover CS-MARS to have Security Manager determine which CS-MARS server is monitoring the device. If only one CS-MARS server is monitoring it, the field is updated with the server name. If there is more than one, you are prompted to select the CS-MARS server to use. Your selection determines which server is accessed when you try to view CS-MARS collected syslogs or events when viewing firewall access rules or IPS signatures in the policy rule tables for the device.

 [bookmark: pgfId-509474]Before you can discover a CS-MARS server for the device, the server must be register with Security Manager on the CS-MARS administration page (Tools > Security Manager Administration > CS-MARS). For more information, see CS-MARS Page.

  
        

 
         
         		 [bookmark: pgfId-509480]Auto Update or Configuration Engine

 [bookmark: pgfId-509482]This group is named differently depending on the device type:

 
           
           		 [bookmark: pgfId-509484]Auto Update—For PIX Firewall and ASA devices.

 
           		 [bookmark: pgfId-509486]Configuration Engine—For Cisco IOS routers.

 
          

 [bookmark: pgfId-509488]Use these fields to identify the server that manages the device, if any. A server is required for a device with a dynamic IP address.

  
        

 
         
         		[bookmark: pgfId-509496]Server

  
         		[bookmark: pgfId-509501]The Auto Update Server or Configuration Engine that manages the device. For AUS, this server should match the one defined in the AUS policy (see AUS Page).

 [bookmark: pgfId-509509]You can add servers to the list by selecting Add Servers, which opens the Server Properties dialog box (see Server Properties Dialog Box. You can also edit the properties of a server by selecting Edit Server, which opens the Available Servers dialog box (see Available Servers Dialog Box).

 [bookmark: pgfId-509514]For more information on managing this list of servers, see Adding, Editing, or Deleting Auto Update Servers or Configuration Engines.

 [bookmark: pgfId-509519]For information on how these servers are used during deployment, see Deploying Configurations Using an Auto Update Server or CNS Configuration Engine.

  
        

 
         
         		[bookmark: pgfId-509525]Device Identity

  
         		[bookmark: pgfId-509530]The string value that uniquely identifies the device in Auto Update Server or the Configuration Engine. For AUS, this ID should match the one defined in the AUS policy (see AUS Page).

  
        

 
         
         		 
           
           [bookmark: pgfId-509536]ASA-CX/FirePOWER Module
          
  
        

 
         
         		[bookmark: pgfId-509544]Management IP

  
         		[bookmark: pgfId-509549]The management IP address of the ASA’s CX or FirePOWER module; detected during device discovery, or after the module is added to the device. See Detecting ASA CX and FirePOWER Modules for more information.

 [bookmark: pgfId-509551]This field is available only for an ASA CX or FirePOWER module already detected by Security Manager.

  
        

 
         
         		[bookmark: pgfId-509557]Manager Address

  
         		[bookmark: pgfId-509562]The IP address of the Cisco Prime Security Manager (PRSM) or FireSIGHT Management Center used to configure and manage the ASA-CX or FirePOWER module; detected during device discovery, or after the module is added to the device. See Launching Cisco Prime Security Manager or FireSIGHT Management Center for more information.

 [bookmark: pgfId-509564]You can edit this address. However, Security Manager will not perform any validation of the address, and rediscovery or re-detection may alter this address.

 [bookmark: pgfId-509566]This field is available only for an ASA CX or FirePOWER module already detected by Security Manager.

  
        

 
         
         		[bookmark: pgfId-509572]Manage in Cisco Security Manager

  
         		[bookmark: pgfId-509574]Whether Security Manager manages the device. Security Manager will not manage configurations nor will it upload or download configurations on this device.

 [bookmark: pgfId-509576]You might want to include an unmanaged device in the inventory for these reasons:

 
           
           		 [bookmark: pgfId-509578]If the only function of the device is to serve as a VPN end point.

 
           		 [bookmark: pgfId-509580]If the device is a security context that you are using for failover. Because you cannot delete security contexts for managed devices without actually deleting the context from the device itself, you must unmanage the failover contexts.

 
          

  
        

 
         
         		[bookmark: pgfId-509586]License Supports Failover

 [bookmark: pgfId-509588](ASA 5505, 5510 only.)

  
         		[bookmark: pgfId-509590]Whether an optional failover license is installed on the device. The option is active for ASA 5505 and 5510 devices only. Security Manager deploys failover policies to the device only if this option is selected.

 [bookmark: pgfId-509592]Tip If you discover policies from the device, Security Manager determines the license status and sets this option appropriately.  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-512934][bookmark: 7237][bookmark: ivpage_cncpt_DeviceCredentialsPage-1]Device Credentials Page[bookmark: marker-512924][bookmark: marker-512926][bookmark: marker-512928][bookmark: marker-512930][bookmark: marker-512932]

 
     [bookmark: pgfId-512939]Use the Device Credentials page to add or change the usernames and passwords that are required for device access. For information about device credentials, see Understanding Device Credentials.

 
     [bookmark: pgfId-512941]The Credentials page is the same whether you are adding a new device (in the New Device wizard), or viewing an existing device’s properties.

 
     [bookmark: pgfId-512943]When adding a new device, you are prompted for credentials only when adding devices manually or from the network.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-512948]Tip In the New Device wizard, when you click Next or Finish when adding a device from the network, Security Manager tests whether it can connect to the device using these credentials. The Device Connectivity Test dialog box stays open while the test is in progress (see Device Connectivity Test Dialog Box). If the test fails, click Details to see detailed error information. If you are adding devices that contain modules, for example, a Catalyst switch with an FWSM, you are then prompted for module discovery information.


     
      

     

     

 
     [bookmark: pgfId-512950]Navigation Path

 
      
      		 [bookmark: pgfId-512952]For new devices, to start the New Device wizard, from Device view, select  File > New Device , or click the  Add button in the device selector.

 
      		 [bookmark: pgfId-512954]For existing devices, to open the device properties, double-click a device in the Device selector, then click  Credentials on the Device Properties Page.

 
     

 
     [bookmark: pgfId-512956]Related Topics

 
      
      		 [bookmark: pgfId-512961]Understanding Device Credentials

 
      		 [bookmark: pgfId-512966]Adding Devices from the Network

 
      		 [bookmark: pgfId-512971]Adding Devices by Manual Definition

 
      		 [bookmark: pgfId-512976]Device Communication Page

 
      		 [bookmark: pgfId-512981]Understanding Device Properties

 
      		 [bookmark: pgfId-512986]Viewing or Changing Device Properties

 
      		 [bookmark: pgfId-512991]Managing Device Communication Settings and Certificates

 
      		 [bookmark: pgfId-512996]Discovery Status Dialog Box

 
     

 
     [bookmark: pgfId-512998]Field Reference

 
     [bookmark: pgfId-513001] 

 
      
       
        
        [bookmark: pgfId-509605]Table 3-10 [bookmark: 7304]Device Credentials Page 

 
        
       
         
         		
           
           [bookmark: pgfId-509611]Element
          
  
         		
           
           [bookmark: pgfId-509613]Description
          
  
        

 
         
         		 [bookmark: pgfId-509619]Primary Credentials

 [bookmark: pgfId-509621]Required for all device types. These credentials are used for SSH and Telnet connections, and for HTTP and HTTPS connections if you select Use Primary Credentials in the HTTP group.

 [bookmark: pgfId-509623]If you change the password for the specified user, or the enable password, in a device policy, Security Manager uses the old password to log in during deployment. After a successful deployment, the passwords in the device credentials are updated to the newly-deployed passwords. For information on updating the device policies related to these passwords, see the following topics:

 
           
           		 [bookmark: pgfId-509628]ASA/PIX/FWSM devices—Configuring Device Credentials

 
           		 [bookmark: pgfId-509633]IPS devices—Configuring IPS User Accounts

 
           		 [bookmark: pgfId-509638]IOS devices—Defining Accounts and Credential Policies

 
          

  
        

 
         
         		[bookmark: pgfId-509646]Username

  
         		[bookmark: pgfId-509648]The user name for logging into the device. The user should have privilege level 15.

 [bookmark: pgfId-509650]If the device requires an enable password only to configure it, you can leave the Username and Password fields blank and enter just the Enable Password.

 [bookmark: pgfId-509652]Note PIX/ASA/FWSM devices require that user names be at least four characters. Passwords can be three to 32 characters; we recommend that passwords be at least eight characters.

  
        

 
         
         		[bookmark: pgfId-509658]Password

  
         		[bookmark: pgfId-509660]The password for logging into the device (User EXEC mode). In the Confirm field, enter the password again.

  
        

 
         
         		[bookmark: pgfId-509666]Enable Password

  
         		[bookmark: pgfId-509668]The password that activates enable mode (Privileged EXEC mode) on the device if the mode is configured on that device. In the Confirm field, enter the password again.

  
        

 
         
         		 [bookmark: pgfId-509674]HTTP Credentials

 [bookmark: pgfId-509676]Credentials for making HTTP or HTTPS connections to a device. Some devices support this type of connection, and other devices (such as IPS devices) require it.

  
        

 
         
         		[bookmark: pgfId-509684]Use Primary Credentials

 [bookmark: pgfId-509686]Username

 [bookmark: pgfId-509688]Password

  
         		[bookmark: pgfId-509690]Whether Security Manager should use the configured primary credentials for HTTP and HTTPS connections. If the device uses different credentials for HTTP/HTTPS connections, deselect Use Primary Credentials and enter the username and password configured for HTTP/HTTPS. Reenter the password in the Confirm field.

 [bookmark: pgfId-509692]Note PIX/ASA/FWSM devices require that user names be at least four characters. Passwords can be three to 32 characters; we recommend that passwords be at least eight characters.

  
        

 
         
         		[bookmark: pgfId-509698]HTTP Port

  
         		[bookmark: pgfId-509700]The port to use for HTTP connections. The default is port 80. Change this setting only if the device is configured to accept HTTP connections on a different port.

  
        

 
         
         		[bookmark: pgfId-509706]HTTPS Port

  
         		[bookmark: pgfId-509708]The port to use for HTTPS connections. The default is port 443 (unless a different default is configured in the Security Manager device communication settings). To change the default, first deselect Use Default. Change this setting only if the device is configured to accept HTTPS connections on a different port.

 [bookmark: pgfId-509716]Note If you configure the local HTTP policy to be a shared policy and assign the HTTP policy to multiple devices, the HTTPS port number setting in the shared policy overrides the port number configured in the Device Credentials page for all devices to which the policy is assigned.[bookmark: marker-509710][bookmark: marker-509712][bookmark: marker-509714]

  
        

 
         
         		[bookmark: pgfId-509722]IPS RDEP Mode

  
         		[bookmark: pgfId-509724]The connection method to use for contacting IPS devices when making RDEP or SDEE connections (for event monitoring).

  
        

 
         
         		[bookmark: pgfId-509730]Certificate Common Name

  
         		[bookmark: pgfId-509732]The name assigned to the certificate. The common name can be the name of a person, system, or other entity that was assigned to the certificate. In the Confirm field, enter the common name again.

  
        

 
         
         		 
           
           [bookmark: pgfId-509738]Additional Fields and Buttons
          
  
        

 
         
         		[bookmark: pgfId-509746]Authentication Certificate Thumbprint

 [bookmark: pgfId-509748](Device properties only.)

  
         		[bookmark: pgfId-509750]The certificate thumbprint for the device that is available in the Security Manager certificate data store. Click Retrieve From Device to obtain the current certificate from the device and to replace the one stored in Security Manager.

 [bookmark: pgfId-509755]For IPS devices, there are additional options for managing the certificate as described in Managing IPS Certificates.

  
        

 
         
         		[bookmark: pgfId-509761]RX-Boot Mode button

  
         		[bookmark: pgfId-509766]Opens the RX-Boot Mode Credentials Dialog Box, where you can enter the credentials for booting the router from a reduced command-set image (RX-Boot).

 [bookmark: pgfId-509768]If these credentials are for a Cisco router that runs from flash memory (where it boots only from the first file in flash), you must run an image other than the one in flash to upgrade the flash image. The RX-Boot credentials are for running this other image.

  
        

 
         
         		[bookmark: pgfId-509774]SNMP button

  
         		[bookmark: pgfId-509779]Opens the SNMP Credentials Dialog Box, where you can specify the SNMP community strings defined on the device.

  
        

 
         
         		[bookmark: pgfId-509785]Test Connectivity button

 [bookmark: pgfId-509787](Device properties and manual device addition only.)

  
         		[bookmark: pgfId-509792]Tests whether Security Manager can connect to the device using the credentials you entered and the configured transport method. For more information about testing device connectivity, see Testing Device Connectivity.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-513011][bookmark: 7431][bookmark: ivpage_cncpt_RxBootModeCredentialsDialogBox]RX-Boot Mode Credentials Dialog Box[bookmark: marker-513009]

 
     [bookmark: pgfId-513013]Use the RX-Boot Mode Credentials dialog box to add RX-Boot mode credentials, which are used for booting the router from a reduced command-set image (RX-Boot). Enter the RX-Boot Mode username and password; in the Confirm field, enter the password again.

 
     [bookmark: pgfId-513015]Navigation Path

 
     [bookmark: pgfId-513020]To open the RX-Boot Mode Credentials dialog box, click RX-Boot Mode in the Device Credentials Page in either the New Device wizard (when adding a device manually or from the network), or the Device Properties page.

 
    
 
     
      [bookmark: pgfId-513030][bookmark: 7443][bookmark: ivpage_cncpt_SNMPCredentialsDialogBox]SNMP Credentials Dialog Box [bookmark: marker-513028]

 
     [bookmark: pgfId-513032]Use the SNMP Credentials dialog box to add SNMP credentials.

 
     [bookmark: pgfId-513034]Navigation Path

 
     [bookmark: pgfId-513039]To open the SNMP Credentials dialog box, click SNMP in the Device Credentials Page in either the New Device wizard (when adding a device manually or from the network), or the Device Properties page.

 
     [bookmark: pgfId-513041]Field Reference

 
     [bookmark: pgfId-513044] 

 
      
       
        
        [bookmark: pgfId-509805]Table 3-11 [bookmark: 7457]SNMP Credentials Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-509811]Element
          
  
         		
           
           [bookmark: pgfId-509813]Description
          
  
        

 
         
         		 [bookmark: pgfId-509819]SNMP V2C

 [bookmark: pgfId-509821]These are the credentials for devices running SNMP version 2.

  
        

 
         
         		[bookmark: pgfId-509829]RO Community String

  
         		[bookmark: pgfId-509831]The read-only community string. In the Confirm field, enter the community string again.

  
        

 
         
         		[bookmark: pgfId-509837]RW Community String

  
         		[bookmark: pgfId-509839]The read-write community string. In the Confirm field, enter the community string again.

  
        

 
         
         		 [bookmark: pgfId-509845]SNMP V3

 [bookmark: pgfId-509847]These are the credentials for devices running SNMP version 3.

  
        

 
         
         		[bookmark: pgfId-509855]Username

  
         		[bookmark: pgfId-509857]The SNMP version 3 authentication user name.

  
        

 
         
         		[bookmark: pgfId-509863]Password

  
         		[bookmark: pgfId-509865]The SNMP version 3 authentication user password. In the Confirm field, enter the password again.

  
        

 
         
         		[bookmark: pgfId-509871]Auth Algorithm

  
         		[bookmark: pgfId-509873]The authorization algorithm for encrypting the password. You can choose MD5 or SHA-1.

  
        

 
         
         		[bookmark: pgfId-509879]Privacy Password

  
         		[bookmark: pgfId-509881]The SNMP version 3 encryption user password. In the Confirm field, enter the password again.

  
        

 
         
         		[bookmark: pgfId-509887]Privacy Algorithm

  
         		[bookmark: pgfId-509889]Specify the encryption level by choosing an encryption algorithm and version:

 
           
           		 [bookmark: pgfId-509891]DES – Apply the Data Encryption Standard cipher algorithm, using 56-bit keys..

 
           		 [bookmark: pgfId-509893]3DES – Use Triple DES; the Data Encryption Standard cipher algorithm is applied three times to each packet.

 
           		 [bookmark: pgfId-509895]AES128 – Use the Advanced Encryption Standard with 128-bit keys.

 
           		 [bookmark: pgfId-509897]AES192 – Use the Advanced Encryption Standard with 192-bit keys.

 
           		 [bookmark: pgfId-509899]AES256 – Use the Advanced Encryption Standard with 256-bit keys.

 
          

  
        

 
         
         		[bookmark: pgfId-509905]Engine ID

  
         		[bookmark: pgfId-509907]Enter the hexadecimal identifier for the SNMP v3 authorization agent in the device.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-513060][bookmark: 7532][bookmark: ivpage_cncpt_DeviceGroupingPage-1]Device Groups Page [bookmark: marker-513054][bookmark: marker-513056][bookmark: marker-513058]

 
     [bookmark: pgfId-513062]Use the Device Groups page to assign the device to device groups. You can also edit or delete device groups from this page.

 
     [bookmark: pgfId-513064]Navigation Path

 
      
      		 [bookmark: pgfId-513066]For new devices, to start the New Device wizard, from Device view, select  File > New Device , or click the  Add button in the device selector.

 
      		 [bookmark: pgfId-513068]For existing devices, to open the device properties, double-click a device in the Device selector, then click  Device Groups on the Device Properties Page.

 
     

 
     [bookmark: pgfId-513070]Related Topics

 
      
      		 [bookmark: pgfId-513075]Understanding Device Grouping

 
      		 [bookmark: pgfId-513080]Adding Devices to the Device Inventory

 
      		 [bookmark: pgfId-513085]Understanding Device Properties

 
      		 [bookmark: pgfId-513090]Discovery Status Dialog Box

 
     

 
     [bookmark: pgfId-513092]Field Reference

 
     [bookmark: pgfId-513095] 

 
      
       
        
        [bookmark: pgfId-509920]Table 3-12 [bookmark: 7574]Device Grouping Page 

 
        
       
         
         		
           
           [bookmark: pgfId-509926]Element
          
  
         		
           
           [bookmark: pgfId-509928]Description
          
  
        

 
         
         		[bookmark: pgfId-509934]Group Types, such as Department and Location

  
         		[bookmark: pgfId-509936]The group types defined in Security Manager, for example, Department or Location. Each field contains a list of the device groups defined within that group type. Select the device groups to which the device should belong.

 [bookmark: pgfId-509941]If you want to create a new device group, or group type, select Edit Groups from the drop-down list for any of the existing group types. This opens the Edit Device Groups page, where you can create new groups and group types or delete them (see Edit Device Groups Dialog Box).

  
        

 
         
         		[bookmark: pgfId-509947]Set values as default

  
         		[bookmark: pgfId-509949]Whether to set the selected groups as the default groups. If you select this option, other devices you add are automatically added to these groups.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-513107][bookmark: 7598][bookmark: ivpage_cncpt_ClusterInformationPage]Cluster Information Page[bookmark: marker-513103][bookmark: marker-513105]

 
     [bookmark: pgfId-513109]Use the Device Properties Cluster Information page to view details for a cluster.

 
     [bookmark: pgfId-513111]Navigation Path

 
      
      		 [bookmark: pgfId-513113]From the Device selector, right-click a device and select  Device Properties , then click  Cluster Information .

 
      		 [bookmark: pgfId-513115]From the Device selector, double-click a device, then click  Cluster Information .

 
      		 [bookmark: pgfId-513117]Select a device and select  Tools > Device Properties , then click  Cluster Information .

 
     

 
     [bookmark: pgfId-513119]Related Topics

 
      
      		 [bookmark: pgfId-513124]Working with Device Clusters

 
      		 [bookmark: pgfId-513129]Understanding Device Properties

 
      		 [bookmark: pgfId-513134]Device Credentials Page

 
      		 [bookmark: pgfId-513139]Device Groups Page

 
      		 [bookmark: pgfId-513144]Policy Object Override Pages

 
     

 
     [bookmark: pgfId-513146]Field Reference

 
     [bookmark: pgfId-513149] 

 
      
       
        
        [bookmark: pgfId-509962]Table 3-13 [bookmark: 7642]Device Properties Cluster Information Page 

 
        
       
         
         		
           
           [bookmark: pgfId-509968]Element
          
  
         		
           
           [bookmark: pgfId-509970]Description
          
  
        

 
         
         		 
           
           [bookmark: pgfId-509976]Cluster Details
          
  
        

 
         
         		[bookmark: pgfId-509984]Device Type

  
         		[bookmark: pgfId-509986]The type of device.

  
        

 
         
         		[bookmark: pgfId-509992]Cluster Group Name

  
         		[bookmark: pgfId-509994]The name assigned to the cluster.

  
        

 
         
         		[bookmark: pgfId-510000]Cluster Master

  
         		[bookmark: pgfId-510002]The cluster member name of the device that is serving as the cluster master.

 [bookmark: pgfId-510004]Note Changes to the cluster master are not automatically reflected in Security Manager.

  
        

 
         
         		[bookmark: pgfId-510010]Retrieve From Device

  
         		[bookmark: pgfId-510012]Use Retrieve From Device to update the cluster master information.

  
        

 
         
         		[bookmark: pgfId-510018]Interface Mode

  
         		[bookmark: pgfId-510020]Whether the interfaces are configured for Layer 2 load balancing (Spanned EtherChannel) or Layer 3 load balancing (Individual).

  
        

 
         
         		[bookmark: pgfId-510026]Management IP Pool Name

  
         		[bookmark: pgfId-510028]The name of the address pool used for cluster management.

  
        

 
         
         		[bookmark: pgfId-510034]Management IP Pool Range

  
         		[bookmark: pgfId-510036]The IP address pool used for cluster management.

  
        

 
         
         		[bookmark: pgfId-510042]Last Update in CSM

  
         		[bookmark: pgfId-510044]The date and time that cluster information was last updated for this cluster by Security Manager.

  
        

 
         
         		 [bookmark: pgfId-510050]Cluster Node Details

 [bookmark: pgfId-510052]The Cluster Node Details table lists details for each device in the cluster.

  
        

 
         
         		[bookmark: pgfId-510060]Cluster ID

  
         		[bookmark: pgfId-510062]The cluster ID of the cluster node.

  
        

 
         
         		[bookmark: pgfId-510068]Node Name

  
         		[bookmark: pgfId-510070]The member name of the cluster node.

  
        

 
         
         		[bookmark: pgfId-510076]Serial Number

  
         		[bookmark: pgfId-510078]The serial number of the cluster node.

  
        

 
         
         		[bookmark: pgfId-510084]CCL IP

  
         		[bookmark: pgfId-510086]The cluster control link IP address for the cluster node.

  
        

 
         
         		[bookmark: pgfId-510092]CCL MAC

  
         		[bookmark: pgfId-510094]The cluster control link MAC address for the cluster node.

  
        

 
         
         		[bookmark: pgfId-1065139]Site ID

  
         		[bookmark: pgfId-1065152]The site that the current cluster member belongs to. Configuring a site ID prevents MAC address flapping.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-513163][bookmark: 7731][bookmark: ivpage_cncpt_PolicyObjectOverridePages]Policy Object Override Pages[bookmark: marker-513159][bookmark: marker-513161]

 
     [bookmark: pgfId-513168]You can override the global settings for many types of policy objects from the Device Properties window of a selected device. This enables you to customize the definition of an object on that device. For more information, see Understanding Policy Object Overrides for Individual Devices.

 
     [bookmark: pgfId-513170]The Policy Object Overrides folder in the table of contents includes all of the types of objects for which you can create overrides for the particular type of device. When you select an object type, the existing policy objects that are configured to allow device overrides appear in the table in the right pane, if any. If an object has an override already defined for the device, the Value Overridden? column contains a check mark.

 
     [bookmark: pgfId-513172]You can create and manage overrides for these objects. Select an object and you can do the following:

 
      
      		 [bookmark: pgfId-513174]To create an override, click the Create Override button. This opens the edit dialog box for that type of object. Click the Help button for object-specific information.

 
      		 [bookmark: pgfId-513176]To edit an existing override, click the Edit Override button.

 
      		 [bookmark: pgfId-513178]To remove an override, click the Delete Override button.

 
     

 
     [bookmark: pgfId-513180]Navigation Path

 
     [bookmark: pgfId-513182]Double-click a device in the Device selector, then click the desired policy object type in the Policy Object Overrides folder in the table of contents in the left pane.

 
     [bookmark: pgfId-513184]Related Topics

 
      
      		 [bookmark: pgfId-513189]Policy Object Overrides Window

 
      		 [bookmark: pgfId-513194]Allowing a Policy Object to Be Overridden

 
      		 [bookmark: pgfId-513199]Creating or Editing Object Overrides for a Single Device

 
      		 [bookmark: pgfId-513204]Deleting Device-Level Object Overrides

 
      		 [bookmark: pgfId-513209]Filtering Tables

 
     

 
    
 
     
      [bookmark: pgfId-513221][bookmark: 7778][bookmark: ivman_cncpt_ChangingCriticalDeviceProperties]Changing Critical Device Properties [bookmark: marker-513215][bookmark: marker-513217][bookmark: marker-513219]

 
     [bookmark: pgfId-513223]You must use caution when changing the image version of a device, the device type, or the security context or operational mode of FWSM and ASA devices that are managed by Security Manager. In certain cases, these changes enable a different set of features for the device. As a result, some of the policies that you configured for the device in Security Manager might no longer apply.

 
     [bookmark: pgfId-513225]The key device changes, their effect on the policies available in Security Manager, and the procedure you should follow to implement these device changes, are described in the following sections:

 
      
      		 [bookmark: pgfId-513230]Image Version Changes That Do Not Change the Feature Set in Security Manager

 
      		 [bookmark: pgfId-513235]Changes That Change the Feature Set in Security Manager

 
     

 
    
 
     
      [bookmark: pgfId-513247][bookmark: 7798][bookmark: ivman_proc_ImageVersionChangesThatDoNotChangetheFeatureSetinSecurityManager]Image Version Changes That Do Not Change the Feature Set in Security Manager [bookmark: marker-513241][bookmark: marker-513243][bookmark: marker-513245]

 
     [bookmark: pgfId-513249]The following image version changes do not affect the types of policies available for that device in Security Manager:

 
      
      		 [bookmark: pgfId-513251]Upgrading from one IOS individual release number to another individual release number within the same Cisco IOS release; for example, upgrading from IOS 12.3(10) to 12.3(13).

 
      		 [bookmark: pgfId-513253]Upgrading from any IOS 12.1 image to any 12.2 image.

 
      		 [bookmark: pgfId-513255]Upgrading from any IOS 12.2 image to any 12.3 image.

 
      		 [bookmark: pgfId-513257]Upgrading from any IOS 15.0 image to any 15.1 image.

 
      		 [bookmark: pgfId-513259]Upgrading from any IOS 15.2 image to any 15.3 image.

 
      		 [bookmark: pgfId-513261]Upgrading from any PIX 6.x image to another PIX 6.x image.

 
      		 [bookmark: pgfId-513263]Upgrading from any PIX 7.x image to another PIX 7.x image, retaining the same security context and mode configuration.

 
      		 [bookmark: pgfId-513265]Upgrading from any ASA 7.x image to another ASA 7.x image, retaining the same security context and mode configuration.

 
      		 [bookmark: pgfId-513267]Upgrading from any ASA 8.0(x)-8.2(x) image to another ASA 8.0(x)-8.2(x) image, retaining the same security context and mode configuration.

 
      		 [bookmark: pgfId-513269]Upgrading from any FWSM 2.x image to another 2.x FWSM image, retaining the same security context and mode configuration.

 
      		 [bookmark: pgfId-513271]Upgrading from any FWSM 3.x image to another 3.x FWSM image, retaining the same security context and mode configuration.

 
      		 [bookmark: pgfId-513273]Upgrading a Catalyst 6500/7600 chassis from any IOS 12.x image to another IOS 12.x image.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-513277]Note This list applies only to images that are supported by Security Manager. For a list of supported images, see Supported Devices and Software Versions for Cisco Security Manager for this version of the product at http://www.cisco.com/en/US/products/ps6498/products_device_support_tables_list.html.


     
      

     

     

 
     [bookmark: pgfId-513279]For these cases, use the following procedure to change the image version.

 
     [bookmark: pgfId-513281]Related Topics

 
      
      		 [bookmark: pgfId-513286]Understanding the Device View

 
      		 [bookmark: pgfId-513291]Understanding Device Properties

 
      		 [bookmark: pgfId-513296]Understanding Policies

 
      		 [bookmark: pgfId-513301]Changes That Change the Feature Set in Security Manager

 
     

 
     
 
     [bookmark: pgfId-513303]Step 1 Upgrade the image version on the device.

 
     [bookmark: pgfId-513305]Step 2 In Device view, do one of the following in the Device selector to open the Device Properties dialog box:

 
      
      		 [bookmark: pgfId-513307]Double-click a device.

 
      		 [bookmark: pgfId-513309]Right-click a device and select  Device Properties .

 
      		 [bookmark: pgfId-513311]Select a device and select  Tools > Device Properties .

 
     

 
     [bookmark: pgfId-513313]Step 3 In the Device Properties dialog box, change the Target OS Version property on the General page to the updated version number and click Save.

 
     [bookmark: pgfId-513315]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-513327][bookmark: 7876][bookmark: ivman_proc_ChangesThatChangetheFeatureSetinSecurityManager]Changes That Change the Feature Set in Security Manager [bookmark: marker-513321][bookmark: marker-513323][bookmark: marker-513325]

 
     [bookmark: pgfId-513329]These are the main types of device changes that affect the policy feature set available for a device:

 
      
      		 [bookmark: pgfId-513331]Image version changes—The following image version changes affect the types of policies available for that device in Security Manager:

 
     

 
     [bookmark: pgfId-513333] – Upgrading to ASA 8.4(x) or higher from an ASA 8.3(x) or lower release.

 
     [bookmark: pgfId-513335] – Upgrading to ASA 8.3(x) or higher from an ASA 8.2(x) or lower release.

 
     [bookmark: pgfId-513337] – Changes in the major version number for ASA, PIX, FWSM, and IPS devices. For example, upgrading an ASA from 8.x to 9.x, or downgrading an IPS device from 7.x to 6.x.

 
     [bookmark: pgfId-513339] – Upgrading from an IOS 12.1 or 12.2 image to an IOS 12.3 or 12.4 image.

 
     [bookmark: pgfId-513341] – Downgrading from an IOS 12.3 or 12.4 image to an IOS 12.1 or 12.2 image.

 
     [bookmark: pgfId-513343] – Upgrading to IOS 15.2 or higher from an IOS 12.3 or lower release.

 
     [bookmark: pgfId-513345]If you make these changes, and you do not have any policies defined that are affected by the change, you might be able to change the target OS version of the device. Security Manager prevents you from changing the target OS version of a managed device to a version that changes the types of policies that are available for that device, and informs you when it cannot make the change (identifying the problem policies). Therefore, you must first delete the device from Security Manager, perform the image change, then add the device back.

 
     [bookmark: pgfId-513347]Certain types of policies, such as access rules, are not affected by changes in image version or changes in platform type.

 
     [bookmark: pgfId-513352]Changes to NAT policies that were introduced in the 8.3 and 9.0.1 ASA releases require that the NAT policies are rediscovered in Security Manager. This can be accomplished by deleting the device and then adding it back in to Security Manager, as described below, or you can rediscover just the NAT policies using the Discover Policies on Device feature. For more information on the Discover Policies on Device feature, see Discovering Policies on Devices Already in Security Manager.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-513354]Note If an ASA device was upgraded or downgraded from the current version to a higher or lower version outside of Security Manager, you should delete the device and then add it back in to Security Manager.


     
      

     

     

 
      
      		 [bookmark: pgfId-513356]Security context and operational mode changes—Changes that you make to the security context and operational mode settings on an FWSM or ASA device enable a different set of features on that device. These changes occur if you change the device from:

 
     

 
     [bookmark: pgfId-513358] – Single context to multiple context (or vice-versa).

 
     [bookmark: pgfId-513360] – Routed mode to transparent mode (or vice-versa).

 
     [bookmark: pgfId-513362]Security Manager prevents you from changing the security context or operational mode settings of a managed device. Therefore, you must first delete the device from Security Manager, change the context or mode, then add the device back.

 
     [bookmark: pgfId-513364]Certain policy types (for example, Banner, Clock, Console Timeout, and HTTP) are not affected by changes in operational mode. Other policy types (for example, ICMP, SSH, and TFTP, in addition to Banner and Clock) are not affected by changes in security context settings.

 
      
      		 [bookmark: pgfId-513366]Replacing device hardware—In some cases, you might replace a particular device but retain the original contact information (such as the IP address), for example:

 
     

 
     [bookmark: pgfId-513368] – Replacing a PIX firewall with a Cisco IOS router.

 
     [bookmark: pgfId-513370] – Replacing a PIX firewall with an ASA device.

 
     [bookmark: pgfId-513372] – Replacing a router with a firewall device.

 
     [bookmark: pgfId-513374] – Replacing a router with a new router of a different model.

 
     [bookmark: pgfId-513376]In all of these cases, the new device changes the types of policies available for that device in Security Manager. Security Manager prevents you from modifying the hardware model of an existing device. Therefore, you must first delete the device from Security Manager, change the physical device, then add the device back.

 
     [bookmark: pgfId-513378]Certain policy types (for example, access rules) are not affected by changes in device type.

 
     [bookmark: pgfId-513380]We recommend that you share the policies configured on your device that will not be affected by the change before you remove it from Security Manager. This provides a useful method for reassigning the policies to the device (with any inheritance and policy object references intact) after you add it back to Security Manager. The following procedure describes how to do this.

 
     [bookmark: pgfId-513382]Related Topics

 
      
      		 [bookmark: pgfId-513387]Understanding the Device View

 
      		 [bookmark: pgfId-513392]Understanding Device Properties

 
      		 [bookmark: pgfId-513397]Understanding Policies

 
      		 [bookmark: pgfId-513402]Image Version Changes That Do Not Change the Feature Set in Security Manager

 
     

 
     
 
     [bookmark: pgfId-513404]Step 1 Submit and deploy all the changes you configured for the device in Security Manager. This ensures that the desired configuration is on the device before the image upgrade.

 
     [bookmark: pgfId-513406]Step 2 Share the local policies defined on the device:

 
     [bookmark: pgfId-513408] a. Right-click the device in the Device selector, then select Share Device Policies. By default, all policies configured on the device (local and shared) are selected for sharing in the Share Policies wizard.

 
     [bookmark: pgfId-513410] b. Deselect the check box next to each existing shared policy, as indicated by the hand in the policy icon. You should do this because there is no need to create a copy of the shared policies that already exist; you will reassign the existing shared policies after the image version upgrade.

 
     [bookmark: pgfId-513412] c. Enter a name for the shared policies. We recommend using the device name as a convenient means of identification. For example, if the device name is MyRouter, each shared policy is given the name MyRouter. Make a note of all the policies you are creating for this purpose.

 
     [bookmark: pgfId-513414] d. Click Finish. The selected local policies become shared policies.

 
     [bookmark: pgfId-513416]Step 3 Delete the device from Security Manager.

 
     [bookmark: pgfId-513418]Step 4 Make the desired change to the device, for example, upgrade the image version, change the operational mode, or replace the device.

 
     [bookmark: pgfId-513420]Step 5 Add the device back to Security Manager and perform policy discovery.

 
     [bookmark: pgfId-513422]Step 6 Reassign the policies to the device:

 
     [bookmark: pgfId-513424] a. Right-click the first policy type displayed in the Device Policies selector, then select Assign Shared Policy.

 
     [bookmark: pgfId-513426] b. In the Assign Shared Policy dialog box, do one of the following:

 
      
      		 [bookmark: pgfId-513428]If a local policy was previously defined on the device, select the shared policy you created for this procedure and click  OK .

 
      		 [bookmark: pgfId-513430]If a shared policy of this type was previously assigned to the device, select it and click  OK .

 
     

 
     [bookmark: pgfId-513432] c. (Local policies only) Right-click the policy type again in the Device Policies selector, then select Unshare Policy.

 
     [bookmark: pgfId-513434] d. Repeat the process for each policy type that is relevant to the device’s configuration. If a shared policy is not available, this indicates that this is a policy type that was not available for the previous image version.

 
     [bookmark: pgfId-513436]Step 7 (Optional) Delete the shared policies created for this procedure from Policy view:

 
     [bookmark: pgfId-513438] a. Select View > Policy View or click the Policy View icon on the toolbar.

 
     [bookmark: pgfId-513440] b. Select one of the policies you want to delete and click the Assignments tab in the work area to verify that the policy is not assigned to any devices.

 
     [bookmark: pgfId-513442] c. Click the Delete Policy button beneath the Shared Policy selector to delete the policy.

 
     [bookmark: pgfId-513444] d. Repeat the process for each policy type that you want to delete.

 
     [bookmark: pgfId-513446]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-513464][bookmark: 8008][bookmark: ivman_proc_UnderstandingShowContainment]Showing Device Containment[bookmark: marker-513452][bookmark: marker-513454][bookmark: marker-513456][bookmark: marker-513458][bookmark: marker-513460][bookmark: marker-513462]

 
     [bookmark: pgfId-513466]You can display the service modules, security contexts, and virtual sensors that are contained in devices that include them. Based on the type of device, you can view these contained elements:

 
      
      		 [bookmark: pgfId-513468]Catalyst 6500 devices—The IDSM and FWSM service modules, security contexts, and virtual sensors.

 
      		 [bookmark: pgfId-513473]For FWSM, PIX Firewall 7.0, and ASA devices—The security contexts defined on the device. For information about security contexts, see Chapter 58, “Configuring Security Contexts on Firewall Devices”.

 
      		 [bookmark: pgfId-513475]IPS devices—The virtual sensors defined on the device.

 
     

 
     [bookmark: pgfId-513477]To view contained items, in Device view, select one of these types of devices and then select Tools > Show Containment, or right-click the device and select Show Containment. The Composite View dialog box opens and displays elements contained in the selected device, if any.

 
    
 
     
      [bookmark: pgfId-513491][bookmark: 8041][bookmark: ivman_proc_CloningaDevice]Cloning a Device[bookmark: marker-513485][bookmark: marker-513487][bookmark: marker-513489]

 
     [bookmark: pgfId-513493]A cloned (duplicate) device shares the configurations and properties of the source device. Cloning a device saves you time because you do not need to re-create configuration and properties on the new device.

 
     [bookmark: pgfId-513495]The cloned device shares the device operating system version, credentials and grouping attributes with the source device, but it has its own unique identity, such as display name, IP address, hostname, and domain name. You can clone only one device at a time.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-513497]Note You cannot clone a Catalyst switch or a Catalyst 6500/7600 device.


     
      

     

     

 
     [bookmark: pgfId-513499]Related Topics

 
      
      		 [bookmark: pgfId-513504]Understanding the Device View

 
      		 [bookmark: pgfId-513509]Copying Policies Between Devices

 
     

 
     
 
     [bookmark: pgfId-513511]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-513513](Device view) Select the device and select  File > Clone Device , or right-click the device in the Device selector and select  Clone Device .

 
      		 [bookmark: pgfId-513515](Map view) Right click a device and select  Clone Device .

 
     

 
     [bookmark: pgfId-513517]The Create a Clone of Device dialog box appears.

 
     [bookmark: pgfId-513519]Step 2 Enter the IP address and names for the clone in the appropriate fields. Following are the available attributes:

 
      
      		 [bookmark: pgfId-513521] IP Type —Whether the device uses a static or dynamic (DHCP-provided) IP address. You cannot change the IP type when cloning a device.

 
      		 [bookmark: pgfId-513523] Hostname —(Static IP only.) The DNS hostname for the cloned device.

 
      		 [bookmark: pgfId-513525] Domain Name —(Static IP only.) The DNS domain name for the cloned device. If you do not provide the domain name, Security Manager uses the default domain name configured on the server.

 
      		 [bookmark: pgfId-513527] IP Address —The management IP address of the cloned device, for example, 10.10.100.1. If you do not know the IP address, enter the DNS hostname in the Hostname field. You must enter either the IP address or the hostname for devices with static IP addresses.

 
      		 [bookmark: pgfId-513529] Display Name —The name that appears in Security Manager device lists. The maximum length is 70 characters. Valid characters are: 0-9; uppercase A-Z; lowercase a-z; and the following characters: _ -. : and space.

 
      		 [bookmark: pgfId-513531] Device Identity —(Dynamic IP only.) The string value that uniquely identifies the device in Auto Update Server or Configuration Engine. This field appears only if the device is configured to use one of these servers.

 
      		 [bookmark: pgfId-513533] Clone VPN Assignments —Whether to copy the VPN assignments defined for the device. This field is displayed only if the device supports VPN assignments.

 
     

 
     [bookmark: pgfId-513535]You can clone the VPN assignments of a device that is a spoke in a hub-and-spoke configuration, or a device that participates in a full mesh topology. If you clone a spoke device, the new device is added to the VPN as a new spoke with the same policies. If you clone a device in a full mesh VPN, the new device is added to the full mesh VPN with the same policies. You cannot clone a device in a point-to-point VPN topology.

 
     [bookmark: pgfId-513537]Step 3 Click OK. A clone of the source device with its unique display name is created in the Device selector.

 
     [bookmark: pgfId-513539]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-513551][bookmark: 8108][bookmark: ivman_proc_DeletingDevicesfromtheSecurityManagerInventory]Deleting Devices from the Security Manager Inventory[bookmark: marker-513547][bookmark: marker-513549]

 
     [bookmark: pgfId-513553]If you do not want to continue managing a device in Security Manager, you can delete it from the inventory. Deleting a device from Security Manager does not change any configuration settings on the device.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-513555]Tip If someone is configuring policies on the device, locks will prevent you from deleting the device.


     
      

     

     

 
     [bookmark: pgfId-513557]There are special considerations when deleting certain types of devices:

 
      
      		 [bookmark: pgfId-513559]If the device participates in a VPN, deleting the device removes it from the VPN. However, if removing the device invalidates the VPN topology, the entire VPN topology is also deleted when you delete the device. You are warned of this and given the opportunity to cancel the device deletion.

 
      		 [bookmark: pgfId-513561]For ASA, PIX, and FWSM devices running in multiple context mode, or for IPS devices that contain virtual sensors, deleting the device also deletes all of its security contexts or virtual sensors. You cannot delete an individual security context or virtual sensor using this procedure: instead, you must modify the appropriate policies on the hosting device to remove them.

 
      		 [bookmark: pgfId-513563]If you delete a device that contains managed service modules, the contained devices are also deleted. For example, if you added a Catalyst switch and its contained FWSM, if you delete the switch, the FWSM is also deleted. You are warned if contained devices will be deleted.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-513565]Tip Device deletion requires the removal of a lot of information from the database. If you delete a lot of devices at one time, it can take a while for the operation to complete. If you have a lot of devices to delete, consider deleting them in smaller groups.


     
      

     

     

 
     
 
     [bookmark: pgfId-513567]Step 1 In Device view, do one of the following:

 
      
      		 [bookmark: pgfId-513569]Select the devices you want to delete, or a device group if you want to delete all devices within the group, right-click and select  Delete Devices . You can also click the  Delete Device button (the trash can icon) above the device selector.

 
      		 [bookmark: pgfId-513571]Select  File > Delete Device , then select the devices to delete in the Device Selector dialog box and click  >> to move them to the selected devices list (which is pre-filled with any devices that were selected in the device tree). You can select a device group to delete all of its member devices. Click  OK when finished.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-513576]Tip When you select a device group, you are deleting only the devices in the group, you are not deleting the group itself. For information on deleting device groups, see Deleting Device Groups or Group Types.


     
      

     

     

 
     [bookmark: pgfId-513578]Step 2 You are asked to confirm that you want to delete the devices.

 
     [bookmark: pgfId-513583]Security Manager then validates whether the device can be deleted. If problems or potential problems are identified, they are listed in the Device Delete Validation Dialog Box. This dialog box shows errors (indicating devices that cannot be deleted) as well as warnings and informational messages.

 
     [bookmark: pgfId-513585]You can elect to confirm the deletion of devices that have warnings or informational messages if you accept the consequences described in the message. The dialog box has an OK button if you can continue deleting all selected devices, or a Continue button if there are any error messages. If you click Continue, you are deleting only those devices without error conditions. You are asked to confirm.

 
     [bookmark: pgfId-513587]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-513597][bookmark: 8154][bookmark: ivpage_cncpt_DeviceDeleteValidationPage]Device Delete Validation Dialog Box [bookmark: marker-513595]

 
     [bookmark: pgfId-513602]Use the Device Delete Validation dialog box to view error, warning, and informational messages during device deletion. For detailed information on deleting devices, see Deleting Devices from the Security Manager Inventory.

 
     [bookmark: pgfId-513604]Each row represents a device for which a validation issue arises when trying to delete it. Displayed are the message severity icon, device display name, and the result of validation, which indicates the reason why you cannot delete the device, or warnings or information about the perhaps unexpected consequences of deleting the device. If there are no messages for a device, it is not listed.

 
     [bookmark: pgfId-513606]Double-click a row or select it and click the Details button to read longer messages. The information is displayed in the Device Delete Validation Details dialog box in a more readable format.

 
     [bookmark: pgfId-513608]The message severity can be one of the following.

 
      
      		 [bookmark: pgfId-513610]Error—A problem was detected that will prevent you from deleting the device. For example, another user has a lock on a device.

 
      		 [bookmark: pgfId-513612]Warning—Proceed with caution. For example, deleting the device will invalidate a VPN topology, and if you continue, the VPN topology will also be deleted.

 
      		 [bookmark: pgfId-513614]Information—A minor problem exists. For example, deleting the device will delete it from a VPN.

 
     

 
     [bookmark: pgfId-513616]To proceed with the device deletion, click the OK or Continue button, which is actually the same button:

 
      
      		 [bookmark: pgfId-513618]If the text says  OK , then when you click it, all devices you selected for deletion are deleted.

 
      		 [bookmark: pgfId-513620]If the text says  Continue , then there are errors for some of the devices you selected. If you click Continue, you will delete only those devices that do not have errors.

 
     

 
     [bookmark: pgfId-513622]If all selected devices have errors, the button is greyed out and you must click Cancel. Resolve any errors before attempting to delete the devices.

 
     [bookmark: pgfId-513624]Navigation Path

 
     [bookmark: pgfId-513626]This dialog box appears only if you try to delete devices and Security Manager determines that there are problems with the deletion.

 
    
 
   
 
    
     [bookmark: pgfId-513638][bookmark: 8188][bookmark: ivman_cncpt_WorkingWithDeviceGroups]Working with Device Groups[bookmark: marker-513632][bookmark: marker-513634][bookmark: marker-513636]

 
    [bookmark: pgfId-513640]You can create device groups to help you organize your devices for more effective device management. The following topics explain device groups and how to use them:

 
     
     		 [bookmark: pgfId-513645]Understanding Device Grouping

 
     		 [bookmark: pgfId-513650]Creating Device Group Types

 
     		 [bookmark: pgfId-513655]Creating Device Groups

 
     		 [bookmark: pgfId-513660]Deleting Device Groups or Group Types

 
     		 [bookmark: pgfId-513665]Adding Devices to or Removing Them From Device Groups

 
    

 
     
      [bookmark: pgfId-513675][bookmark: 8214][bookmark: ivman_cncpt_UnderstandingDeviceGrouping]Understanding Device Grouping [bookmark: marker-513671][bookmark: marker-513673]

 
     [bookmark: pgfId-513680]Device groups are simple, arbitrary, organizational collections of devices that you create for more effective network visualization. They are not policy-sharing entities. They are distinct from the various policy object groups (for example AAA server group objects and user group objects). For information on policy objects, see Chapter 6, “Managing Policy Objects”.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-513685]Tip If you have a large number of devices, grouping them can make it easier to select a subset of devices when you deploy changes to them. For example, if there is a set of devices that you know you will want to deploy changes to simultaneously, if you put them in a single device group, you just have to select the group in the deployment job. For more information about policy deployment, see Chapter 8, “Managing Deployment”.


     
      

     

     

 
     [bookmark: pgfId-513687]Device grouping enables you to view a subset of devices in the inventory. The device group hierarchy has two types of folders:

 
      
      		 [bookmark: pgfId-513689]Device group types—Group types are the highest level in the hierarchy. A group type can contain specific device groups, but it cannot contain devices, except for the All group type, which includes all devices in the inventory. Security Manager comes with the group types Department and Location predefined, but you do not need to use them, and you can delete them. You can create a maximum of 10 group types.

 
      		 [bookmark: pgfId-513694]Device groups—Device groups are subfolders within a group type folder. You can create multiple levels of nested device groups. You can place devices within device groups. However, a device can be in only one group within a group type. For example, in Figure 3-3 under the group type, Location, you can assign routerx to San Jose, but you cannot assign routerx to San Jose and California.

 
     

 
     [bookmark: pgfId-513699]Figure 3-3 shows an example of nested device groups with devices in some of the groups. Notice that an individual device can reside in multiple groups. In this example, routerx is in the Finance group (under the Department group type), and also in the Location > United States > California > San Jose nested group. If you select routerx in any of these places, you are configuring a single device (the configurations are not tied to the grouping).

 
     [bookmark: pgfId-513703]Figure 3-3 [bookmark: 8235]Device Groups

 
     [bookmark: pgfId-513706] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-513708]Security Manager lets you create or delete group and group types, and put devices in groups, in many locations in the interface:

 
      
      		 [bookmark: pgfId-513710]When adding devices to the inventory—The New Device wizard includes a Device Grouping page, where you can create device group types and select a group for the newly-added device. You can also select a default group to which all new devices are added.

 
      		 [bookmark: pgfId-513712]When viewing the device inventory in Device view—The File > Edit Device Groups command opens a dialog box where you can create or delete groups and group types. If you select a group or group type in the Device selector, the File menu and the right-click shortcut menu includes commands for adding groups or adding devices to groups.

 
     

 
     [bookmark: pgfId-513714]To add devices to a group, or remove them from a group, select the group and select File > Add Devices to Group.

 
      
      		 [bookmark: pgfId-513716]When viewing the properties for a device—The Device Grouping page allows you to select the groups to which the device belongs, and to set defaults for devices added to the inventory. This is the only place where you can remove a device from a device group. Double-click a device in the Device selector to open the device properties.

 
      		 [bookmark: pgfId-513718]When using the administration pages—Select  Tools > Security Manager Administration > Device Groups to open the administration page for device groups, where you can create or delete groups and group types, but you cannot add devices to groups here.

 
     

 
     [bookmark: pgfId-513720]Related Topics

 
      
      		 [bookmark: pgfId-513725]Creating Device Group Types

 
      		 [bookmark: pgfId-513730]Creating Device Groups

 
      		 [bookmark: pgfId-513735]Deleting Device Groups or Group Types

 
      		 [bookmark: pgfId-513740]Adding Devices to or Removing Them From Device Groups

 
     

 
    
 
     
      [bookmark: pgfId-513750][bookmark: 8266][bookmark: ivpage_cncpt_EditDeviceGroupsPage]Edit Device Groups Dialog Box[bookmark: marker-513748]

 
     [bookmark: pgfId-513752]Use the Edit Device Groups dialog box to manage the device groups and group types defined in the device inventory.

 
     [bookmark: pgfId-513754]Navigation Path

 
     [bookmark: pgfId-513756]Do one of the following:

 
      
      		 [bookmark: pgfId-513758]Right-click a device group type or a device group in the Device selector and select  Edit Device Groups .

 
      		 [bookmark: pgfId-513760]Select  File > Edit Device Groups .

 
      		 [bookmark: pgfId-513765]From the Device Grouping page in the New Device wizard or for existing devices, the device properties, select  Edit Groups from a group type list. See Device Groups Page.

 
     

 
     [bookmark: pgfId-513767]Related Topics

 
      
      		 [bookmark: pgfId-513772]Understanding Device Grouping

 
      		 [bookmark: pgfId-513777]Working with Device Groups

 
     

 
     [bookmark: pgfId-513779]Field Reference

 
     [bookmark: pgfId-513782] 

 
      
       
        
        [bookmark: pgfId-510107]Table 3-14 [bookmark: 8299]Edit Device Groups Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-510113]Element
          
  
         		
           
           [bookmark: pgfId-510115]Description
          
  
        

 
         
         		[bookmark: pgfId-510121]Groups

  
         		[bookmark: pgfId-510123]Displays the device groups and group types.

 [bookmark: pgfId-510125]To rename a group or type, select it and then click it again to make the text editable. Type in the new name and press Enter.

  
        

 
         
         		[bookmark: pgfId-510131]Add Type button

  
         		[bookmark: pgfId-510133]Click this button to create a new group type. The type is added with a default name. Overtype the name and press Enter.

 [bookmark: pgfId-510135]You can have a maximum of 10 group types.

  
        

 
         
         		[bookmark: pgfId-510141]Add Group to Type button

  
         		[bookmark: pgfId-510143]Click this button to add a device group to the selected device group or group type.

  
        

 
         
         		[bookmark: pgfId-510149]Delete button (trash can)

  
         		[bookmark: pgfId-510151]Click this button to delete the selected device group or group type and all device groups that it contains. Deleting a device group or group type does not delete any devices it contains.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-513792][bookmark: 8333][bookmark: ivman_proc_CreatingDeviceGroupTypes]Creating Device Group Types[bookmark: marker-513788][bookmark: marker-513790]

 
     [bookmark: pgfId-513797]This procedure describes the most direct method to create device group types. For information on other methods of adding group types, see Understanding Device Grouping.

 
     [bookmark: pgfId-513802]Device group types are the top-level categories in your device group hierarchy. If you want add a device group, see Creating Device Groups

 
     [bookmark: pgfId-513804]Related Topics

 
      
      		 [bookmark: pgfId-513809]Understanding Device Grouping

 
      		 [bookmark: pgfId-513814]Deleting Device Groups or Group Types

 
      		 [bookmark: pgfId-513819]Adding Devices to or Removing Them From Device Groups

 
     

 
     
 
     [bookmark: pgfId-513821]Step 1 Select File > Edit Device Groups.

 
     [bookmark: pgfId-513826]The Edit Device Groups page opens (see Edit Device Groups Dialog Box).

 
     [bookmark: pgfId-513828]Step 2 Click Add Type. A new device group type entry is added to the selector.

 
     [bookmark: pgfId-513830]Step 3 Enter a name for the group type and press Enter.

 
     [bookmark: pgfId-513832]Step 4 Click OK to close the Edit Device Groups page.

 
     [bookmark: pgfId-513834]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-513848][bookmark: 8375][bookmark: ivman_proc_CreatingDeviceGroups]Creating Device Groups[bookmark: marker-513842][bookmark: marker-513844][bookmark: marker-513846]

 
     [bookmark: pgfId-513853]This procedure describes the most direct method to create device groups. For information on other methods of adding groups, see Understanding Device Grouping.

 
     [bookmark: pgfId-513858]Device groups are the lower-level categories in your device group hierarchy, and are added either within a device group type (top-level) or within another device group. If you would rather add a device type group, see Creating Device Group Types.

 
     [bookmark: pgfId-513860]Related Topics

 
      
      		 [bookmark: pgfId-513865]Understanding Device Grouping

 
      		 [bookmark: pgfId-513870]Adding Devices to or Removing Them From Device Groups

 
      		 [bookmark: pgfId-513875]Deleting Device Groups or Group Types

 
     

 
     
 
     [bookmark: pgfId-513877]Step 1 Select a device group or group type in the Device selector and select File > New Device Group, or right-click and select New Device Group.

 
     [bookmark: pgfId-513879]The Add Group dialog box appears.

 
     [bookmark: pgfId-513881]Step 2 Enter a name for the device group and click OK. The new device group is added to the Device selector.

 
     [bookmark: pgfId-513883]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-513895][bookmark: 8414][bookmark: ivman_proc_DeletingDeviceGroupTypesDeviceGroupsorSubgroups]Deleting Device Groups or Group Types[bookmark: marker-513889][bookmark: marker-513891][bookmark: marker-513893]

 
     [bookmark: pgfId-513897]If you no longer need a device group or group type, you can delete it. The only group type that you cannot delete is the All group.

 
     [bookmark: pgfId-513899]When you delete a group or group type, you delete any groups that are in it. However, you are not deleting any devices. The devices that are in the group remain in the inventory and can be found in other groups to which they belong (you can find all devices in the All group).

 
     [bookmark: pgfId-513904]There are many ways to delete device groups and group types. This procedure explains the most direct way. For information on other methods of deleting them, see Understanding Device Grouping.

 
     
 
     [bookmark: pgfId-513909]Step 1 In Device view, select File > Edit Device Groups. The Edit Device Groups page opens (see Edit Device Groups Dialog Box).

 
     [bookmark: pgfId-513911]Step 2 Select the group type or group you want to delete and click the Delete button. You are asked to confirm the deletion.

 
     [bookmark: pgfId-513913]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-513927][bookmark: 8440][bookmark: ivman_proc_AddingDevicestoDeviceGroups]Adding Devices to or Removing Them From Device Groups[bookmark: marker-513921][bookmark: marker-513923][bookmark: marker-513925]

 
     [bookmark: pgfId-513932]You must create a device group before you add devices to it. To create groups, see Creating Device Groups.

 
     [bookmark: pgfId-513934]Related Topics

 
      
      		 [bookmark: pgfId-513939]Understanding Device Grouping

 
      		 [bookmark: pgfId-513944]Filtering Items in Selectors

 
     

 
     
 
     [bookmark: pgfId-513946]Step 1 Select the device group in the Device selector, right-click and select Add Devices to Group. The Add Devices to Group dialog box appears.

 
     [bookmark: pgfId-513948]Step 2 To add devices to the group, select the devices in the Available Devices selector and click >> to move them to the Selected Devices list.

 
     [bookmark: pgfId-513950]To remove devices, select them in the Selected Devices list and click <<.

 
     [bookmark: pgfId-513952]Step 3 Click OK. The device group membership is adjusted to include the devices that were in the Selected Devices list.

 
     [bookmark: pgfId-513954]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-513966][bookmark: 8479][bookmark: ivman_cncpt_WorkingWithDeviceStatusView]Working with Device Status View[bookmark: marker-513962][bookmark: marker-513964]

 
    [bookmark: pgfId-513968]You can use the Device Status View to quickly see the status of the devices in the Security Manager inventory. The Device Status View window aggregates information from several applications and tools within Cisco Security Manager. You can use the Device Status View to quickly see the status of all your devices or specific groups of devices and can easily navigate to the areas in Security Manager you need to act on that information.

 
     
     [image: ] 
    
 
    
 
    
     [bookmark: pgfId-513970]
     Caution In some cases, for a particular device, Health and Performance Monitor displays a "critical" device status while Configuration Manager displays a "normal" device status. Restarting the services or the server does not resolve this discrepancy. For this reason, you should monitor device status in HPM in addition to Configuration Manager.
      
      
 
     

    
 
    [bookmark: pgfId-513972]Navigation Path

 
     
     		 [bookmark: pgfId-513974]Select  View > Device Status View . The Device Status View window opens showing information for all devices.

 
     		 [bookmark: pgfId-513976]Select a device group in the Device selector. The Device Status View window opens showing information for the devices that are part of that device group or a subgroup.

 
    

 
    [bookmark: pgfId-513980]Figure 3-4 [bookmark: 8500]Device Status View

 
    [bookmark: pgfId-513983] 
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    [bookmark: pgfId-513985]Field Reference

 
    [bookmark: pgfId-513988] 

 
     
     


     


     


     


     


     


     


     


     


     


     


     


     


      
       
       [bookmark: pgfId-510164]Table 3-15 [bookmark: 8506]Device Status View 

 
       
      
        
        		
          
          [bookmark: pgfId-510170]Element
         
  
        		
          
          [bookmark: pgfId-510172]Description
         
  
       

 
        
        		 [bookmark: pgfId-510178]Device Status Summary Boxes

 [bookmark: pgfId-510180]The Device Status Summary boxes provide a high-level view of the overall status of the devices in the Device Status View. The counts shown in the summary boxes reflect the status for the devices in the currently selected device group. If you select View > Device Status View or select the All devices group, then the summary boxes reflect the counts for all devices.

 [bookmark: pgfId-510182]Note Filtering the device list in the Device Status View window will not affect the counts in the Device Status Summary boxes.

  
       

 
        
        		[bookmark: pgfId-510190]Health and Performance Monitor summary box

  
        		[bookmark: pgfId-510192]Shows the device counts for the Critical (red), Warning (yellow), and Normal (green) alert statuses.

  
       

 
        
        		[bookmark: pgfId-510198]Deployment Manager summary box

  
        		[bookmark: pgfId-510200]Shows the device counts for the Fail (red), Pending (yellow), and Pass green) deployment statuses.

  
       

 
        
        		[bookmark: pgfId-510206]Device State summary box

  
        		[bookmark: pgfId-510208]Shows the device counts for the Critical (red), Warning (yellow), and Normal (green) device states.

  
       

 
        
        		 [bookmark: pgfId-510214]Device Status View Toolbar

 [bookmark: pgfId-510216]The Device Status View toolbar provides the following buttons:

 [bookmark: pgfId-510218]Note These options are all also available from the right-click menu for a device.

  
       

 
       
            
        		[bookmark: pgfId-510229]Allows you to export the device status information to a PDF file.

  
       

 
       
            
        		[bookmark: pgfId-510238]Allows you to print the device status information.

  
       

 
       
            
        		[bookmark: pgfId-510247]Shows alert status information for the selected device in the Health & Performance Monitor application.

 [bookmark: pgfId-510252]For more information, see Chapter 70, “Health and Performance Monitoring”.

  
       

 
       
            
        		[bookmark: pgfId-510261]Shows monitoring information for the selected device in the Health & Performance Monitor application.

 [bookmark: pgfId-510266]For more information, see Chapter 70, “Health and Performance Monitoring”.

  
       

 
       
            
        		[bookmark: pgfId-510275]Opens the Deployment Manager.

 [bookmark: pgfId-510280]For more information, see Chapter 8, “Managing Deployment”.

  
       

 
       
            
        		[bookmark: pgfId-510289]Opens the Image Manager application for the selected device.

 [bookmark: pgfId-510294]For more information, see Chapter 72, “Using Image Manager”.

  
       

 
       
            
        		[bookmark: pgfId-510303]Opens the device manager for the selected device.

 [bookmark: pgfId-510308]For more information, see Starting Device Managers.

  
       

 
       
            
        		[bookmark: pgfId-510320]Launches the Cisco Prime Security Manager (PRSM) application for the selected device. See Launching Cisco Prime Security Manager or FireSIGHT Management Center for more information.

  
       

 
       
            
        		[bookmark: pgfId-510332]Opens the Device Properties dialog box for the selected device. For more information, see Viewing or Changing Device Properties.

  
       

 
       
            
        		[bookmark: pgfId-510344]Allows you to navigate to the selected device from the Device Status View window. For more information, see Understanding the Device View.

  
       

 
       
            
        		[bookmark: pgfId-510353]Opens online help for the current page.

 [bookmark: pgfId-510358]For more information, see Accessing Online Help.

  
       

 
       
            
        		[bookmark: pgfId-510367]Undocks the Device Status View window, which enables you to use other product features while keeping the window open.

  
       

 
       
            
        		[bookmark: pgfId-510376]Docks the Device Status View window.

 [bookmark: pgfId-510378]Note If the selection has changed in the Device Selector, the Work area will reflect the current selection when the Device Status View window is docked.

  
       

 
        
        		 [bookmark: pgfId-510384]Table Filter

 [bookmark: pgfId-510389]You can filter the list of devices displayed in the Device Status View table to help you find items meeting specific criteria. For more information, see Filtering Tables.

  
       

 
        
        		 
          
          [bookmark: pgfId-510397]Device Status Table
         
  
       

 
        
        		[bookmark: pgfId-510405]Display Name

  
        		[bookmark: pgfId-510407]The display name for the device. This is the name used for display in the Security Manager Device selector and is not necessarily the same as the host name for the device.

  
       

 
        
        		[bookmark: pgfId-510413]Managed

  
        		[bookmark: pgfId-510415]Whether Security Manager manages the device.

  
       

 
        
        		[bookmark: pgfId-510421]Monitored

  
        		[bookmark: pgfId-510423]Whether the device is monitored by the Health and Performance Monitor.

  
       

 
        
        		[bookmark: pgfId-510429]Alerts

  
        		[bookmark: pgfId-510431]Indicates current alert level for the device; can be Normal (green), Warning (yellow), or Critical (red). You can hover over the alert indicator to view more details.

  
       

 
        
        		[bookmark: pgfId-510437]Connection

  
        		[bookmark: pgfId-510439]Indicates HPM’s ability to connect to/poll the device: Connected, Authentication Error, Certificate Mismatch Error, Connection error, Timeout during Read operation, or Service unavailable. You can hover over the alert indicator to view more details.

 [bookmark: pgfId-510441]Note If the device is not selected as a Normal or Priority Monitored Device in HPM (Tools > Device Selector), this status will not apply. Changes to Monitored Device selection may take several minutes to become effective and be reflected on screen.

  
       

 
        
        		[bookmark: pgfId-510447]State

  
        		[bookmark: pgfId-510449]Indicates the current state of the device. You can hover over the alert indicator to view more details.

 [bookmark: pgfId-510457]For ASA devices that are being monitored by the Health and Performance Monitor, the State column will also alert when possible out of band changes have been detected. Any out of band changes that occurred prior to monitoring the device in Health and Performance Monitor will not be reflected in the State column. For more information about out of band changes, see Understanding How Out-of-Band Changes are Handled and Detecting and Analyzing Out of Band Changes.

  
       

 
        
        		[bookmark: pgfId-510463]Deployment

  
        		[bookmark: pgfId-510465]Indicates the deployment method and the current deployment status for the device. Deployment status can be Fail (red), Pending (yellow), and Pass (green). You can hover over the alert indicator to view more details.

  
       

 
        
        		[bookmark: pgfId-510471]Additional Information

  
        		[bookmark: pgfId-510473]Shows additional information for the device, such as whether the device is in cluster mode. You can hover over the alert indicator to view more details.

  
       

 
        
        		[bookmark: pgfId-510479]IP Address

  
        		[bookmark: pgfId-510481]The management IP address of the device, for example 192.168.3.8.

  
       

 
        
        		[bookmark: pgfId-510487]Hostname.Domain

  
        		[bookmark: pgfId-510489]The DNS hostname and domain name for the device.

  
       

 
        
        		[bookmark: pgfId-510495]Target OS Version

  
        		[bookmark: pgfId-510497]The OS version on which you the device’s configuration is based.

  
       

 
        
        		[bookmark: pgfId-510503]Running OS Version

  
        		[bookmark: pgfId-510505]The version of the operating system running on the device.

  
       

 
        
        		[bookmark: pgfId-510511]Device Type

  
        		[bookmark: pgfId-510513]The type of device.

  
       

 
      
     

 
    
 
    [bookmark: pgfId-513990]Related Topics

 
     
     		 [bookmark: pgfId-513995]Chapter 70, “Health and Performance Monitoring”

 
     		 [bookmark: pgfId-514000]Chapter 72, “Using Image Manager”

 
     		 [bookmark: pgfId-514005]Chapter 8, “Managing Deployment”
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     [bookmark: pgfId-230495][bookmark: 72969][bookmark: vpchap_intro_EasyVPN]Easy VPN[bookmark: marker-230493]
      
      
 
     
 

 
    [bookmark: pgfId-230497]Easy VPN is a hub-and-spoke VPN topology that can be used with a variety of routers, PIX, and ASA devices. Policies are defined mostly on the hub and pushed to remote spoke VPN devices, ensuring that clients have up-to-date policies in place before establishing a secure connection.

 
    [bookmark: pgfId-230499]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-230504]Understanding Easy VPN

 
     		 [bookmark: pgfId-230509]Configuring Client Connection Characteristics for Easy VPN

 
     		 [bookmark: pgfId-230514]Configuring an IPsec Proposal for Easy VPN

 
     		 [bookmark: pgfId-230519]Configuring a Connection Profile Policy for Easy VPN

 
     		 [bookmark: pgfId-230524]Configuring a User Group Policy for Easy VPN

 
    

 
   
 
    
     [bookmark: pgfId-230532][bookmark: 72975][bookmark: vpchap_cncpt_UnderstandingEasyVPN]Understanding Easy VPN[bookmark: marker-230530]

 
    [bookmark: pgfId-230534]Easy VPN simplifies VPN deployment for remote offices. With Easy VPN, security policies defined at the head end are pushed to remote VPN devices, ensuring that clients have up-to-date policies in place before establishing a secure connection.

 
    [bookmark: pgfId-230536]Security Manager supports the configuration of Easy VPN policies on hub-and-spoke VPN topologies. In such a configuration, most VPN parameters are defined on the Easy VPN server, which acts as the hub device. The centrally managed IPsec policies are pushed to the Easy VPN client devices by the server, minimizing the remote (spoke) devices configuration.

 
    [bookmark: pgfId-230538]The Easy VPN Server can be a Cisco IOS router, a PIX Firewall, or an ASA 5500 series device. The Easy VPN client is supported on PIX 501, 506, 506E Firewalls running PIX 6.3, Cisco 800-3900 Series routers, and ASA 5505 devices running ASA Software release 7.2 or later.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-230540]Note Some of the policies used in Easy VPN topologies are similar to those used in remote access VPNs. In remote access VPNs, policies are configured between servers and mobile remote PCs running VPN client software, whereas, in site-to-site Easy VPN topologies, the clients are hardware devices.


    
     

    

    

 
    [bookmark: pgfId-230542]This section contains the following topics:

 
     
     		 [bookmark: pgfId-230547]Easy VPN with Dial Backup

 
     		 [bookmark: pgfId-230552]Easy VPN with High Availability

 
     		 [bookmark: pgfId-230557]Easy VPN with Dynamic Virtual Tunnel Interfaces

 
     		 [bookmark: pgfId-230562]Easy VPN Configuration Modes

 
     		 [bookmark: pgfId-230567]Easy VPN and IKE Extended Authentication (Xauth)

 
     		 [bookmark: pgfId-230572]Overview of Configuring Easy VPN

 
     		 [bookmark: pgfId-230577]Important Notes About Easy VPN Configuration

 
    

 
     
      [bookmark: pgfId-230587][bookmark: 72984][bookmark: vpchap_cncpt_EasyVPNwithDialBackup]Easy VPN with Dial Backup[bookmark: marker-230583][bookmark: marker-230585]

 
     [bookmark: pgfId-230589]Dial backup for Easy VPN allows you to configure a dial backup tunnel connection on your remote client device. The backup feature is activated only when real traffic is ready to be sent, eliminating the need for expensive dialup or ISDN links that must be created and maintained even when there is no traffic.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-230591]Note Easy VPN dial backup can be configured only on remote clients that are routers running IOS version 12.3(14)T or later.


     
      

     

     

 
     [bookmark: pgfId-230593]In an Easy VPN configuration, when a remote device attempts to connect to the server and the tracked IP is no longer accessible, the primary connection is torn down and a new connection is established over the Easy VPN backup tunnel to the server. If the primary hub cannot be reached, the primary configuration switches to the failover hub with the same primary configuration and not to the backup configuration.

 
     [bookmark: pgfId-230595]Only one backup configuration is supported for each primary Easy VPN configuration. Each inside interface must specify the primary and backup Easy VPN configuration. IP static route tracking must be configured for dial backup to work on an Easy VPN remote device. The object tracking configuration is independent of the Easy VPN remote dial backup configuration. The object tracking details are specified in the spoke’s Edit Endpoints dialog box.

 
     [bookmark: pgfId-230600]For more information about dial backup, see Configuring Dial Backup.

 
    
 
     
      [bookmark: pgfId-230610][bookmark: 72999][bookmark: vpchap_cncpt_EasyVPNwithHighAvailability]Easy VPN with High Availability[bookmark: marker-230606][bookmark: marker-230608]

 
     [bookmark: pgfId-230615]You can configure High Availability (HA) on devices in an Easy VPN topology. High Availability provides automatic device backup when configured on Cisco IOS routers or Catalyst 6500/7600 devices that run IP over LANs. You can create an HA group made up of two or more hub devices in your Easy VPN that use Hot Standby Routing Protocol (HSRP) to provide transparent, automatic device failover. For more information, see Configuring High Availability in Your VPN Topology.

 
    
 
     
      [bookmark: pgfId-230625][bookmark: 73010][bookmark: vpchap_cncpt_EasyVPNwithDynamicVirtualTunnelInterfaces]Easy VPN with Dynamic Virtual Tunnel Interfaces[bookmark: marker-230621][bookmark: marker-230623]

 
     [bookmark: pgfId-230627]The IPsec virtual tunnel interface (VTI) feature simplifies the configuration of GRE tunnels that need to be protected by IPsec for remote access links. A VTI is an interface that supports IPsec tunneling, and allows you to apply interface commands directly to the IPsec tunnels. The configuration of a virtual tunnel interface reduces overhead as it does not require a static mapping of IPsec sessions to a particular physical interface where the crypto map is applied.

 
     [bookmark: pgfId-230629]IPsec VTIs support both unicast and multicast encrypted traffic on any physical interface, such as in the case of multiple paths. Traffic is encrypted or decrypted when it is forwarded from or to the tunnel interface and is managed by the IP routing table. Dynamic or static IP routing can be used to route the traffic to the virtual interface. Using IP routing to forward traffic to the tunnel interface simplifies IPsec VPN configuration compared to the more complex process of using access control lists (ACLs) with a crypto map. Dynamic VTIs function like any other real interface so that you can apply quality of service (QoS), firewall, and other security services as soon as the tunnel is active.

 
     [bookmark: pgfId-230631]Dynamic VTIs use a virtual template infrastructure for dynamic instantiation and management of IPsec interfaces. In an Easy VPN topology, Security Manager implicitly creates the virtual template interface for the device. If the device is a hub, the user must provide the IP address on the hub that will be used as the virtual template interface—this can be a subnet (pool of addresses) or an existing loopback or physical interface. On a spoke, the virtual template interface is created without an IP address.

 
     [bookmark: pgfId-230636]In Security Manager, you configure Dynamic VTI in the Easy VPN IPsec Proposal page. See Configuring Dynamic VTI for Easy VPN.

 
     [bookmark: pgfId-230638]Notes

 
      
      		 [bookmark: pgfId-230640]Dynamic VTI can be configured only in a hub-and-spoke Easy VPN topology on routers running IOS version 12.4(2)T and later, except 7600 devices. It is not supported on PIX Firewalls, ASA devices, or Catalyst 6000 series switches.

 
      		 [bookmark: pgfId-230642]Not all the hubs/spokes require Dynamic VTI configuration during discovery or provision. You can extend the existing Easy VPN topology (including routers not supporting dVTI) to add routers that support dVTI.

 
      		 [bookmark: pgfId-230644]Dynamic VTI is supported on only servers, only clients (if server does not support dVTI), or both clients and servers.

 
      		 [bookmark: pgfId-230646]You cannot configure High Availability on hubs/servers that have been configured with dVTI.

 
      		 [bookmark: pgfId-230651]You can also configure Dynamic VTI in remote access VPNs. For more information, see Configuring Dynamic VTI/VRF Aware IPsec in Remote Access VPNs (IOS Devices).

 
     

 
    
 
     
      [bookmark: pgfId-230661][bookmark: 73038][bookmark: vpchap_cncpt_EasyVPNConfigurationModes]Easy VPN Configuration Modes[bookmark: marker-230657][bookmark: marker-230659]

 
     [bookmark: pgfId-230663]Easy VPN can be configured in three modes—Client, Network Extension, and Network Extension Plus.

 
      
      		 [bookmark: pgfId-230665]Client mode—The default configuration that allows devices at the client site to access resources at the central site, but disallows access to the central site for resources at the client site. In client mode, a single IP address is pushed to the remote client from the server when the VPN connection is established. This address is typically a routable address in the private address space of the customer network. All traffic passing across the Easy VPN tunnel undergoes Port Address Translation (PAT) to that single pushed IP address.

 
      		 [bookmark: pgfId-230667]Network Extension mode—Allows users at the central site to access the network resources at the client site, and allows the client PCs and hosts direct access to the PCs and hosts at the central site. Network Extension mode specifies that the hosts at the client end of the VPN tunnel should be given IP addresses that are fully routable and reachable by the destination network. The devices at both ends of the connection will form one logical network. PAT is not used, so the hosts at the client end have direct access to the hosts at the destination network. In other words, the Easy VPN server (the hub) gives routable addresses to the Easy VPN client (the spoke), while the whole LAN behind the client will not undergo PAT.

 
      		 [bookmark: pgfId-230669]Network Extension Plus mode—An enhancement to Network Extension mode, which can be configured only on IOS routers. It enables an IP address that is received via mode configuration to be automatically assigned to an available loopback interface. This IP address can be used for connecting to your router for remote management and troubleshooting (ping, Telnet, and Secure Shell). If you select this option an some clients are not IOS routers, those clients are configured in Network Extension mode.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-230671]Note All modes of operation can also support split tunneling, which allows secure access to corporate resources through the VPN tunnel while also allowing Internet access through a connection to an ISP or other service (thereby eliminating the corporate network from the path for web access).


     
      

     

     

 
     [bookmark: pgfId-230676]You configure the mode in the Client Connection Characteristics policy as described in Configuring Client Connection Characteristics for Easy VPN.

 
     [bookmark: pgfId-230678]Related Topics

 
      
      		 [bookmark: pgfId-230683]Important Notes About Easy VPN Configuration

 
      		 [bookmark: pgfId-230688]Understanding Easy VPN

 
     

 
    
 
     
      [bookmark: pgfId-230698][bookmark: 73067][bookmark: vpchap_cncpt_EasyVPNandIKEExtendedAuthenticationXauth]Easy VPN and IKE Extended Authentication (Xauth)[bookmark: marker-230694][bookmark: marker-230696]

 
     [bookmark: pgfId-230700]When negotiating tunnel parameters for establishing IPsec tunnels in an Easy VPN configuration, IKE Extended Authentication (Xauth) adds another level of authentication that identifies the user who requests the IPsec connection. If the VPN server is configured for Xauth, the client waits for a username/password challenge after the IKE security association (SA) has been established. When the end user responds to the challenge, the response is forwarded to the IPsec peers for an additional level of authentication.

 
     [bookmark: pgfId-230702]The information that is entered is checked against authentication entities using authentication, authorization, and accounting (AAA) protocols such as RADIUS and TACACS+. Token cards may also be used via AAA proxy. During Xauth, a user-specific attribute can be retrieved if the credentials of that user are validated via RADIUS.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-230704]Note VPN servers that are configured to handle remote clients should always be configured to enforce user authentication.


     
      

     

     

 
     [bookmark: pgfId-230706]Security Manager allows you to save the Xauth username and password on the device itself so you do not need to enter these credentials manually each time the Easy VPN tunnel is established. The information is saved in the device’s configuration file and used each time the tunnel is established. Saving the credentials in the device’s configuration file is typically used if the device is shared between several PCs and you want to keep the VPN tunnel up all the time, or if you want the device to automatically bring up the tunnel whenever there is traffic to be sent.

 
     [bookmark: pgfId-230708]Saving the credentials in the device’s configuration file, however, could create a security risk, because anyone who has access to the device configuration can obtain this information. An alternative method for Xauth authentication is to manually enter the username and password each time Xauth is requested. You can select whether to use a web browser window or the router console to enter the credentials. Using web-based interaction, a login page is returned, in which you can enter the credentials to authenticate the VPN tunnel. After the VPN tunnel comes up, all users behind this remote site can access the corporate LAN without being prompted again for the username and password. Alternatively, you can choose to bypass the VPN tunnel and connect only to the Internet, in which case a password is not required.

 
     [bookmark: pgfId-230710]Easy VPN Tunnel Activation

 
     [bookmark: pgfId-230712]If the device credentials (Xauth username and password) are stored on the device itself, you must select a tunnel activation method for IOS router clients. Two options are available:

 
      
      		 [bookmark: pgfId-230714]Auto—The Easy VPN tunnel is established automatically when the Easy VPN configuration is delivered to the device configuration file. If the tunnel times out or fails, the tunnel automatically reconnects and retries indefinitely. This is the default option.

 
      		 [bookmark: pgfId-230716]Traffic Triggered Activation—The Easy VPN tunnel is established whenever outbound local (LAN side) traffic is detected. Traffic Triggered Activation is recommended for use with the Easy VPN dial backup configuration so that backup is activated only when there is traffic to send across the tunnel. When using this option, you must specify the Access Control List (ACL) that defines the “interesting” traffic.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-230718]Note Manual tunnel activation is configured implicitly if you select to configure the Xauth password interactively. In this case, the device waits for a command before attempting to establish the Easy VPN remote connection. When the tunnel times out or fails, subsequent connections will also have to wait for the command.


     
      

     

     

 
     [bookmark: pgfId-230723]You configure the xauth and tunnel activation mode in the Client Connection Characteristics policy as described in Configuring Client Connection Characteristics for Easy VPN.

 
     [bookmark: pgfId-230725]Related Topics

 
      
      		 [bookmark: pgfId-230730]Important Notes About Easy VPN Configuration

 
      		 [bookmark: pgfId-230735]Understanding Easy VPN

 
      		 [bookmark: pgfId-230740]Configuring Credentials Policy Objects

 
     

 
    
 
     
      [bookmark: pgfId-230748][bookmark: 73104][bookmark: vpchap_cncpt_OverviewofConfiguringEasyVPN]Overview of Configuring Easy VPN[bookmark: marker-230746]

 
     [bookmark: pgfId-230750]When a remote client initiates a connection to a VPN server, device authentication between the peers occurs using IKE, followed by user authentication using IKE Extended Authentication (Xauth), VPN policy push (in Client, Network Extension, or Network Extension Plus mode), and IPsec security association (SA) creation.

 
     [bookmark: pgfId-230752]The following provides an overview of this process:

 
     [bookmark: pgfId-230757] 1. The client initiates IKE Phase 1 via aggressive mode if a preshared key is to be used for authentication, or main mode if digital certificates are used. If the client identifies itself with a preshared key, the accompanying user group name (defined during configuration) is used to identify the group profile associated with this client. If digital certificates are used, the organizational unit (OU) field of a distinguished name (DN) is used to identify the user group name. See PKI Enrollment Dialog Box—Certificate Subject Name Tab.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-230759]Note Because the client may be configured for preshared key authentication, which initiates IKE aggressive mode, the administrator should change the identity of the VPN device via the crypto isakmp identity hostname command. This will not affect certificate authentication via IKE main mode.


     
      

     

     

 
     [bookmark: pgfId-230761] 2. The client attempts to establish an IKE SA between its public IP address and the public IP address of the VPN server. To reduce the amount of manual configuration on the client, every combination of encryption and hash algorithms, in addition to authentication methods and D-H group sizes, is proposed.

 
     [bookmark: pgfId-230763] 3. Depending on its IKE policy configuration, the VPN server determines which proposal is acceptable to continue negotiating Phase 1.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-230765]Note Device authentication ends and user authentication begins at this point.


     
      

     

     

 
     [bookmark: pgfId-230767] 4. After the IKE SA is successfully established, and if the VPN server is configured for Xauth, the client waits for a “username/password” challenge and then responds to the challenge of the peer. The information that is entered is checked against authentication entities using authentication, authorization, and accounting (AAA) protocols such as RADIUS and TACACS+. Token cards may also be used via AAA proxy. During Xauth, a user-specific attribute can be retrieved if the credentials of that user are validated via RADIUS.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-230769]Note VPN servers that are configured to handle remote clients should always be configured to enforce user authentication.


     
      

     

     

 
     [bookmark: pgfId-230771] 5. If the server indicates that authentication was successful, the client requests further configuration parameters from the peer. The remaining system parameters (for example, IP address, DNS, and split tunnel attributes) are pushed to the client using client or network extension mode configuration.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-230773]Note The IP address pool and group preshared key (if Rivest, Shamir, and Adelman [RSA] signatures are not being used) are the only required parameter in a group profile. All other parameters are optional.


     
      

     

     

 
     [bookmark: pgfId-230775] 6. After each client is assigned an internal IP address via mode configuration, Reverse Route Injection (RRI), if configured, ensures that a static route is created on the device for each client internal IP address.

 
     [bookmark: pgfId-230777] 7. IKE quick mode is initiated to negotiate and create IPsec SAs.

 
     [bookmark: pgfId-230779]The connection is complete.

 
    
 
     
      [bookmark: pgfId-230787][bookmark: 73133][bookmark: vpchap_cncpt_ImportantNotesAboutEasyVPNConfiguration]Important Notes About Easy VPN Configuration[bookmark: marker-230785]

 
     [bookmark: pgfId-230789]Before you configure an Easy VPN policy in your topology, you should know the following:

 
      
      		 [bookmark: pgfId-230791]In an Easy VPN topology configuration, deployment fails if a 72xx series router is used as a remote client device. The Easy VPN client is supported on PIX 501, 506, 506E Firewalls running PIX 6.3, Cisco 800-3900 Series routers, and ASA 5505 devices running ASA Software release 7.2 or later.

 
      		 [bookmark: pgfId-230796]If you try to configure a Public Key Infrastructure (PKI) policy on a PIX 6.3 remote client in an Easy VPN topology configuration, deployment fails. For successful deployment on this device, you must first issue the PKI certificate on the CA server, and then try again to deploy the device. For more information about PKI policies, see Understanding Public Key Infrastructure Policies.

 
      		 [bookmark: pgfId-230798]In some cases, deployment fails on a device that serves as an Easy VPN client if the crypto map is configured on the NAT (or PAT) internal interface instead of the external interface. On some platforms, the inside and outside interfaces are fixed. For example, on a Cisco 1700 series router the VPN interface must be the device’s FastEthernet0 interface. On a Cisco 800 series router the VPN interface could be either the device’s Ethernet0 or Dialer1 interface, depending on the configuration. On a Cisco uBR905/uBR925 cable access router, the VPN interface must be the Ethernet0 interface.

 
     

 
    
 
   
 
    
     [bookmark: pgfId-230810][bookmark: 73149][bookmark: vpchap_proc_ConfiguringClientConnectionCharacteristicsforEasyVPN]Configuring Client Connection Characteristics for Easy VPN[bookmark: marker-230806][bookmark: marker-230808]

 
    [bookmark: pgfId-230812]Use the Client Connection Characteristics page to specify how traffic will be routed in the Easy VPN topology and how the VPN tunnel will be established. The characteristics defined in this policy are configured on the remote clients. Before configuring this policy, read the following topics:

 
     
     		 [bookmark: pgfId-230817]Easy VPN Configuration Modes

 
     		 [bookmark: pgfId-230822]Easy VPN and IKE Extended Authentication (Xauth)

 
    

 
    [bookmark: pgfId-230824]Navigation Path

 
     
     		 [bookmark: pgfId-230829](Site-to-Site VPN Manager Window) Select an Easy VPN topology in the VPNs selector, then select  Client Connection Characteristics in the Policies selector.

 
     		 [bookmark: pgfId-230831](Policy view) Select  Site-to-Site VPN > Client Connection Characteristics and create a new policy or edit an existing policy.

 
    

 
    [bookmark: pgfId-230833]Related Topics

 
     
     		 [bookmark: pgfId-230838]Understanding Easy VPN

 
     		 [bookmark: pgfId-230843]Creating Access Control List Objects

 
     		 [bookmark: pgfId-230848]Important Notes About Easy VPN Configuration

 
    

 
    [bookmark: pgfId-230850]Field Reference

 
    [bookmark: pgfId-230853] 

 
     
      
       
       [bookmark: pgfId-229528]Table 28-1 [bookmark: 73192]Easy VPN Client Connection Characteristics Page 

 
       
      
        
        		
          
          [bookmark: pgfId-229534]Element
         
  
        		
          
          [bookmark: pgfId-229536]Description
         
  
       

 
        
        		[bookmark: pgfId-229542]Mode

  
        		[bookmark: pgfId-229544]The configuration mode for the remote devices:

 
          
          		 [bookmark: pgfId-229546] Client —Specifies that all traffic from the remote client’s inside network will undergo Port Address Translation (PAT) to a single IP address which was assigned for the device by the head end server at connect time.

 
          		 [bookmark: pgfId-229548] Network Extension —Specifies that PCs and other hosts at the client end of the VPN tunnel should be given IP addresses that are fully routable and reachable by destination network. PAT is not used, allowing the client PCs and hosts to have direct access to the PCs and hosts at the destination network.

 
          		 [bookmark: pgfId-229550] Network Extension Plus —An enhancement to Network Extension mode, that enables an IP address that is received via mode configuration to be automatically assigned to an available loopback interface. The IPsec SAs for this IP address are automatically created by the Easy VPN client. The IP address is typically used for troubleshooting (using ping, Telnet, and Secure Shell).

 
         

 [bookmark: pgfId-229552]If you select Network Extension Plus, this mode is configured on IOS routers only. Clients that are PIX or ASA devices are configured in Network Extension mode.

 [bookmark: pgfId-229557]For more information, see Easy VPN Configuration Modes.

  
       

 
        
        		[bookmark: pgfId-229563]Xauth Credentials Source

  
        		[bookmark: pgfId-229565]Select how you want to enter the Xauth credentials for user authentication when you establish a VPN connection with the server:

 
          
          		 [bookmark: pgfId-229567]Device Stored Credentials (default)—The username and password are saved on the device itself in the device’s configuration file to be used each time the tunnel is established.

 
          		 [bookmark: pgfId-229569]Interactive Entered Credentials—Enables you to manually enter the username and password each time Xauth is requested, in a web browser window or from the router console.

 
         

 [bookmark: pgfId-229574]For more information, see Easy VPN and IKE Extended Authentication (Xauth).

  
       

 
        
        		[bookmark: pgfId-229580]Xauth Credentials

  
        		[bookmark: pgfId-229582]Available only if you selected Device Stored Credentials as the Xauth Credentials Source.

 [bookmark: pgfId-229587]The credentials policy object that defines the default Xauth credentials. Enter the name of the object or click Select to select it from a list or to create a new object. For more information, see Configuring Credentials Policy Objects.

 in the object definition).

  
       

 
        
        		[bookmark: pgfId-229595]Tunnel Activation (IOS)

  
        		[bookmark: pgfId-229597]Available only if you selected the Device Stored Credentials option for the Xauth password source.

 [bookmark: pgfId-229599]For IOS router clients, select a tunnel activation method:

 
          
          		 [bookmark: pgfId-229601] Auto (default)—The Easy VPN tunnel is established automatically when the Easy VPN configuration is delivered to the device configuration file. If the tunnel times out or fails, the tunnel automatically reconnects and retries indefinitely.

 
          		 [bookmark: pgfId-229603] Traffic Triggered Activation —The Easy VPN tunnel is established whenever outbound local (LAN side) traffic is detected. If you select traffic triggered activation, also enter the name of the Access Control List (ACL) policy object that defines the traffic that should activate the tunnel. Click  Select to select the object or to create a new object.

 
         

 [bookmark: pgfId-229605]Traffic Triggered Activation is recommended for use when Easy VPN dial backup is configured so that backup is activated only when there is traffic to send across the tunnel.

 [bookmark: pgfId-229607]Note Manual tunnel activation is configured implicitly when you select to configure the Xauth password interactively.

  
       

 
        
        		[bookmark: pgfId-229613]User Authentication Method (IOS)

  
        		[bookmark: pgfId-229615]Available only if you selected the Interactive Entered Credentials option for the Xauth credentials source. The option applies to remote IOS routers only.

 [bookmark: pgfId-229617]Select one of these ways to enter the Xauth username and password interactively each time Xauth authentication is requested:

 
          
          		 [bookmark: pgfId-229619]Web Browser (default)—Manually in a web browser window.

 
          		 [bookmark: pgfId-229621]Router Console—Manually from the router’s command line.

 
         

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-230867][bookmark: 73272][bookmark: pobjpage_cncpt_CredentialsDialogBox]Configuring Credentials Policy Objects[bookmark: marker-230861][bookmark: marker-230863][bookmark: marker-230865]

 
     [bookmark: pgfId-230869]Use the Credentials dialog box to create, copy and edit Credential objects.

 
     [bookmark: pgfId-230871]Credential objects are used in Easy VPN configuration during IKE Extended Authentication (Xauth) when authenticating user access to the network and network services. When negotiating tunnel parameters for establishing IPsec tunnels in an Easy VPN configuration, Xauth identifies the user who requests the IPsec connection. If the VPN server is configured for Xauth, the client waits for a “username/password” challenge after the IKE SA has been established. When the end user responds to the challenge, the response is forwarded to the IPsec peers for an additional level of authentication. You can save the Xauth credentials (username and password) on the device itself so you do not need to enter them manually each time the Easy VPN tunnel is established.

 
     [bookmark: pgfId-230873]Navigation Path

 
     [bookmark: pgfId-230875]Select Manage > Policy Objects, then select Credentials from the Object Type Selector. Right-click inside the work area and select New Object or right-click a row and select Edit Object.

 
     [bookmark: pgfId-230877]Related Topics

 
      
      		 [bookmark: pgfId-230882]Easy VPN and IKE Extended Authentication (Xauth)

 
      		 [bookmark: pgfId-230887]Configuring Client Connection Characteristics for Easy VPN

 
      		 [bookmark: pgfId-230892]Policy Object Manager

 
     

 
     [bookmark: pgfId-230894]Field Reference

 
     [bookmark: pgfId-230897] 

 
      
       
        
        [bookmark: pgfId-229634]Table 28-2 [bookmark: 73311]Credentials Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-229640]Element
          
  
         		
           
           [bookmark: pgfId-229642]Description
          
  
        

 
         
         		[bookmark: pgfId-229648]Name

  
         		[bookmark: pgfId-229653]The object name, which can be up to 128 characters. Object names are not case-sensitive. For more information, see Creating Policy Objects.

  
        

 
         
         		[bookmark: pgfId-229659]Description

  
         		[bookmark: pgfId-229661]An optional description of the object (up to 1024 characters).

  
        

 
         
         		[bookmark: pgfId-229667]Username

  
         		[bookmark: pgfId-229669]The name that will be used to identify the user during Xauth authentication.

  
        

 
         
         		[bookmark: pgfId-229675]Password

 [bookmark: pgfId-229677]Confirm

  
         		[bookmark: pgfId-229679]The password for the user, entered in both fields. The password must be alphanumeric and a maximum of 128 characters. Spaces are not allowed.

  
        

 
         
         		[bookmark: pgfId-229685]Category

  
         		[bookmark: pgfId-229690]The category assigned to the object. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-229696]Allow Value Override per Device

 [bookmark: pgfId-229698]Overrides

 [bookmark: pgfId-229700]Edit button

  
         		[bookmark: pgfId-229708]Whether to allow the object definition to be changed at the device level. For more information, see Allowing a Policy Object to Be Overridden and Understanding Policy Object Overrides for Individual Devices.

 [bookmark: pgfId-229710]If you allow device overrides, you can click the Edit button to create, edit, and view the overrides. The Overrides field indicates the number of devices that have overrides for this object.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-230909][bookmark: 73363][bookmark: vpchap_proc_ConfiguringanIPsecProposalforEasyVPN]Configuring an IPsec Proposal for Easy VPN[bookmark: marker-230905][bookmark: marker-230907]

 
    [bookmark: pgfId-230911]Use the Easy VPN IPsec Proposal page to configure the IPsec proposal used during IKE Phase 2 negotiations for Easy VPN topologies. The IPsec proposal is configured on the IPSec Proposal tab; the options are described below.

 
    [bookmark: pgfId-230916]In Easy VPN topologies, you can also configure a dynamic virtual interface on the Dynamic VTI tab. For an explanation of dVTI configuration, see Configuring Dynamic VTI for Easy VPN.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-230921]Note This topic describes the IPsec Proposal page when the site-to-site VPN technology is Easy VPN. For a description of the IPsec Proposal page when the site-to-site VPN technology is something else, see Configuring IPsec Proposals in Site-to-Site VPNs.


    
     

    

    

 
    [bookmark: pgfId-230923]Navigation Path

 
     
     		 [bookmark: pgfId-230928](Site-to-Site VPN Manager Window) Select an Easy VPN topology in the VPNs selector, then select  Easy VPN IPsec Proposal in the Policies selector. Click the  IPSec Proposal tab.

 
     		 [bookmark: pgfId-230930](Policy view) Select  Site-to-Site VPN > Easy VPN IPsec Proposal from the Policy Types selector. Select an existing shared policy or create a new one. Click the  IPSec Proposal tab.

 
    

 
    [bookmark: pgfId-230932]Related Topics

 
     
     		 [bookmark: pgfId-230937]Understanding Easy VPN

 
     		 [bookmark: pgfId-230942]Configuring an IPsec Proposal for Easy VPN

 
     		 [bookmark: pgfId-230947]Understanding AAA Server and Server Group Objects

 
     		 [bookmark: pgfId-230952]Understanding IPsec Proposals

 
    

 
    [bookmark: pgfId-230954]Field Reference

 
    [bookmark: pgfId-230957] 

 
     
      
       
       [bookmark: pgfId-229723]Table 28-3 [bookmark: 73408]Easy VPN IPsec Proposal Tab 

 
       
      
        
        		
          
          [bookmark: pgfId-229729]Element
         
  
        		
          
          [bookmark: pgfId-229731]Description
         
  
       

 
        
        		[bookmark: pgfId-229737]IKEv1 Transform Sets

  
        		[bookmark: pgfId-229742]The transform sets to be used for your tunnel policy. Transform sets specify which authentication and encryption algorithms will be used to secure the traffic in the tunnel. You can select up to 11 transform sets. For more information, see Understanding Transform Sets.

 [bookmark: pgfId-229744]Transform sets may use only tunnel mode IPsec operation.

 [bookmark: pgfId-229746]If more than one of your selected transform sets is supported by both peers, the transform set that provides the highest security will be used.

 [bookmark: pgfId-229751]Click Select to select the IPsec transform set policy objects to use in the topology. If the required object is not yet defined, you can click the Create (+) button beneath the available objects list in the selection dialog box to create a new one. For more information, see Configuring IPSec IKEv1 or IKEv2 Transform Set Policy Objects.

  
       

 
        
        		[bookmark: pgfId-229757]Reverse Route

  
        		[bookmark: pgfId-229759]Supported on ASA 5500 series devices, PIX 7.0+ devices, and Cisco IOS routers except 7600 devices.

 [bookmark: pgfId-229764]Reverse Route Injection (RRI) enables static routes to be automatically inserted into the routing process for those networks and hosts protected by a remote tunnel endpoint. For more information, see Understanding Reverse Route Injection.

 [bookmark: pgfId-229766]Select one of the following options to configure RRI on the crypto map:

 
          
          		 [bookmark: pgfId-229768] None —Disables the configuration of RRI on the crypto map.

 
          		 [bookmark: pgfId-229770] Standard —(ASA, PIX 7.0+, IOS devices) Creates routes based on the destination information defined in the crypto map access control list (ACL). This is the default option.

 
          		 [bookmark: pgfId-229772] Remote Peer —(IOS devices only) Creates two routes, one for the remote endpoint and one for route recursion to the remote endpoint via the interface to which the crypto map is applied.

 
          		 [bookmark: pgfId-229774] Remote Peer IP —(IOS devices only) Specifies an address as the explicit next hop to the remote VPN device. Enter the IP address or a network/host object that specifies the address, or click  Select to select the network/host object from a list or to create a new object.

 
         

 option in the object to override the IP address, if required, for specific devices that use this object.

  
       

 
        
        		[bookmark: pgfId-229782]Enable Network Address Translation Traversal

  
        		[bookmark: pgfId-229784]Supported on PIX 7.0+ and ASA 5500 series devices.

 [bookmark: pgfId-229786]Whether to allow Network Address Translation (NAT) traversal.

 [bookmark: pgfId-229791]Use NAT traversal when there is a device between a VPN-connected hub and spoke, and that performs Network Address Translation (NAT) on the IPsec traffic. For information about NAT traversal, see Understanding NAT in VPNs

  
       

 
        
        		[bookmark: pgfId-229797]Group Policy Lookup/AAA Authorization Method

  
        		[bookmark: pgfId-229799]Supported on Cisco IOS routers only.

 [bookmark: pgfId-229801]The AAA authorization method list that will be used to define the order in which the group policies are searched. Group policies can be configured on both the local server or on an external AAA server. Remote users are grouped, so that when the remote client establishes a successful connection to the VPN server, the group policies for that particular user group are pushed to all clients belonging to the user group.

 [bookmark: pgfId-229803]Click Select to open a dialog box that lists all available AAA group servers, and in which you can create AAA group server objects. Select all that apply and use the up and down arrow buttons to put them in priority order.

  
       

 
        
        		[bookmark: pgfId-229809]User Authentication (Xauth)/AAA Authentication Method

  
        		[bookmark: pgfId-229811]Supported on Cisco IOS routers and PIX 6.3 firewalls only.

 [bookmark: pgfId-229813]The AAA or Xauth user authentication method used to define the order in which user accounts are searched.

 [bookmark: pgfId-229815]Xauth allows all AAA authentication methods to perform user authentication in a separate phase after the IKE authentication phase 1 exchange. The AAA configuration list-name must match the Xauth configuration list-name for user authentication to occur.

 [bookmark: pgfId-229817]After the IKE SA is successfully established, and if the device is configured for Xauth, the client waits for a username/password challenge and then responds to the challenge of the peer. The information that is entered is checked against authentication entities using authentication, authorization, and accounting (AAA) protocols such as RADIUS and TACACS+.

 [bookmark: pgfId-229819]Click Select to open a dialog box that lists all available AAA group servers, and in which you can create AAA group server objects. Select all that apply and use the up and down arrow buttons to put them in priority order.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-230969][bookmark: 73480][bookmark: vpnpage_cncpt_DynamicVTITab]Configuring Dynamic VTI for Easy VPN[bookmark: marker-230965][bookmark: marker-230967]

 
     [bookmark: pgfId-230974]Use the Dynamic VTI tab of the Easy VPN IPSec Proposal policy to configure a dynamic virtual tunnel interface on a device in a hub-and-spoke Easy VPN topology. For more information, see Easy VPN with Dynamic Virtual Tunnel Interfaces.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-230976]Note Dynamic VTI can be configured only on IOS routers running IOS version 12.4(2)T and later, except 7600 devices.


     
      

     

     

 
     [bookmark: pgfId-230978]Navigation Path

 
      
      		 [bookmark: pgfId-230983](Site-to-Site VPN Manager Window) Select an Easy VPN topology in the VPNs selector, then select  Easy VPN IPsec Proposal in the Policies selector. Click the  Dynamic VTI tab.

 
      		 [bookmark: pgfId-230985](Policy view) Select  Site-to-Site VPN > Easy VPN IPsec Proposal from the Policy Types selector. Select an existing shared policy or create a new one. Click the  Dynamic VTI tab.

 
     

 
     [bookmark: pgfId-230987]Related Topics

 
      
      		 [bookmark: pgfId-230992]Understanding Easy VPN

 
      		 [bookmark: pgfId-230997]Configuring an IPsec Proposal for Easy VPN

 
     

 
     [bookmark: pgfId-230999]Field Reference

 
     [bookmark: pgfId-231002] 

 
      
       
        
        [bookmark: pgfId-229832]Table 28-4 [bookmark: 73517]Easy VPN IPSec Proposal, Dynamic VTI Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-229838]Element
          
  
         		
           
           [bookmark: pgfId-229840]Description
          
  
        

 
         
         		[bookmark: pgfId-229846]Enable Dynamic VTI

  
         		[bookmark: pgfId-229848]When selected, enables Security Manager to implicitly create a dynamic virtual template interface on the device.

 [bookmark: pgfId-229850]If the device is a hub server that does not support Dynamic VTI, a warning message is displayed, and a crypto map is deployed without dynamic VTI. In the case of a client device, an error message is displayed.

  
        

 
         
         		[bookmark: pgfId-229856]Virtual Template IP

  
         		[bookmark: pgfId-229858]If you are configuring Dynamic VTI on a hub in the topology, specify either the subnet address or interface role:

 
           
           		 [bookmark: pgfId-229860] Subnet —To use the IP address taken from a pool of addresses. Enter the private IP address including the subnet mask, for example 10.1.1.0/24.

 
           		 [bookmark: pgfId-229862] Interface Role —To use a physical or loopback interface on the device. If required, click  Select to open the Interface selector where you can select the interface role object that identifies the desired interface. If an appropriate object does not already exist, you can create one in the selection dialog box.

 
          

 [bookmark: pgfId-229864]If you are configuring Dynamic VTI on a spoke in the topology, select None.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-231016][bookmark: 73550][bookmark: vpchap_proc_ConfiguringaTunnelGroupPolicyforEasyVPN]Configuring a Connection Profile Policy for Easy VPN[bookmark: marker-231008][bookmark: marker-231010][bookmark: marker-231012][bookmark: marker-231014]

 
    [bookmark: pgfId-231018]A connection profile consists of a set of records that contain IPsec tunnel connection policies. Connection profiles, or tunnel groups, identify the group policy for a specific connection, and include user-oriented attributes. If you do not assign a particular group policy to a user, the default group policy for the connection applies. For a successful connection, the username of the remote client must exist in the database, otherwise the connection is denied.

 
    [bookmark: pgfId-231020]In site-to site VPNs, you configure connection profile policies on an Easy VPN server, which can be a PIX Firewall version 7.0+ or an ASA 5500 series device. The Easy VPN connection profile policy is similar to the one used for remote access VPNs.You can unassign the connection profile policy if none of the Easy VPN servers are ASA or PIX 7.0+ devices.

 
    [bookmark: pgfId-231022]Creating a connection profile policy involves specifying:

 
     
     		 [bookmark: pgfId-231024]The group policy—A collection of user-oriented attributes stored either internally on the device or externally on RADIUS/LDAP server.

 
     		 [bookmark: pgfId-231026]Global AAA settings—Authentication, Authorization, and Accounting servers.

 
     		 [bookmark: pgfId-231028]The DHCP servers to be used for client address assignment, and the address pools from which the IP addresses will be assigned.

 
     		 [bookmark: pgfId-231030]Settings for Internet Key Exchange (IKE) and IPsec (such as preshared key).

 
    

 
    [bookmark: pgfId-231032]On the PIX7.0+/ASA Connection Profiles page, you can connection profiles on your Easy VPN server.

 
    [bookmark: pgfId-231034]Related Topics

 
     
     		 [bookmark: pgfId-231039]Creating or Editing VPN Topologies

 
     		 [bookmark: pgfId-231044]Understanding IPsec Technologies and Policies

 
     		 [bookmark: pgfId-231049]Understanding Easy VPN

 
    

 
    
 
    [bookmark: pgfId-231051]Step 1 Do one of the following:

 
     
     		 [bookmark: pgfId-231056](Site-to-Site VPN Manager Window) Select an Easy VPN topology in the VPNs selector, then select  Connection Profiles (PIX 7.0/ASA) in the Policies selector.

 
     		 [bookmark: pgfId-231058](Policy view) Select  Site-to-Site VPN > Connection Profiles (PIX 7.0/ASA) from the Policy Types selector. Select an existing shared policy or create a new one.

 
    

 
    [bookmark: pgfId-231063]For information on the policy, see Connection Profiles Page.

 
    [bookmark: pgfId-231068]Step 2 On the General tab, specify the connection profile name and group policies and select which method (or methods) of address assignment to use. For a description of the available properties, see General Tab (Connection Profiles).

 
    [bookmark: pgfId-231073]Step 3 Click the AAA tab and specify the AAA authentication parameters for an the connection profile. For a description of the elements on the tab, see AAA Tab (Connection Profiles).

 
    [bookmark: pgfId-231078]Step 4 Click the IPsec tab and specify IPsec and IKE parameters for the connection profile. For a description of the elements on the tab, see IPSec Tab (Connection Profiles).

 
    [bookmark: pgfId-231080]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-231092][bookmark: 73619][bookmark: vpchap_proc_ConfiguringaUserGroupPolicyforEasyVPN]Configuring a User Group Policy for Easy VPN[bookmark: marker-231088][bookmark: marker-231090]

 
    [bookmark: pgfId-231094]Use the User Group Policy page to create or edit a user group policy on your Easy VPN server. When you configure an Easy VPN server, you create a user group to which remote clients belong. An Easy VPN user group policy can be configured on a Cisco IOS security router, PIX 6.3 Firewall, or Catalyst 6500 /7600 device. You can unassign the user group policy if none of the Easy VPN servers are IOS routers, Catalyst 6500/7600 devices, or PIX 6.3 firewalls.

 
    [bookmark: pgfId-231096]Remote clients must have the same group name as the user group configured on the server in order to connect to the device, otherwise no connection is established. When the remote client establishes a successful connection to the VPN server, the group policies for that particular user group are pushed to all clients belonging to the user group.

 
    [bookmark: pgfId-231101]Select the user group policy object that you want to use in the policy from the Available User Groups list. You can create a new user group object by clicking the Create (+) button, or edit an existing group by selecting it and clicking the Edit (pencil icon) button. For information about configuring the user group object, see Add or Edit User Group Dialog Box.

 
    [bookmark: pgfId-231103]Navigation Path

 
     
     		 [bookmark: pgfId-231108](Site-to-Site VPN Manager Window) Select an Easy VPN topology in the VPNs selector, then select  User Group Policy in the Policies selector.

 
     		 [bookmark: pgfId-231110](Policy view) Select  Site-to-Site VPN > User Group Policy from the Policy Types selector. Select an existing shared policy or create a new one.

 
    

 
    [bookmark: pgfId-231112]Related Topics

 
     
     		 [bookmark: pgfId-231117]Understanding Easy VPN
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     [bookmark: pgfId-484697][bookmark: 40892][bookmark: porules_cncpt_WorkingwithAAARules]Managing Firewall AAA Rules[bookmark: marker-484693][bookmark: marker-484695]
      
      
 
     
 

 
    [bookmark: pgfId-484699]You can use Authentication, Authorization, and Accounting (AAA) rules to control access to network resources based on user privileges rather than by IP addresses. If you configure authentication rules, users must enter a username and password whenever they attempt to access a network behind the protected device. Once authenticated, you can further require that the user account be checked to ensure the user is authorized for network access. Finally, you can use accounting rules to track access for billing, security, or resource allocation purposes.

 
    [bookmark: pgfId-484701]AAA rule configuration is complex and requires that you configure more than just the AAA rules policy. The following topics explain AAA rules in greater detail and include procedures that explain not only the AAA rules policy configuration but also what you must configure in related policies:

 
     
     		 [bookmark: pgfId-484706]Understanding AAA Rules

 
     		 [bookmark: pgfId-484711]Understanding How Users Authenticate

 
     		 [bookmark: pgfId-484716]Configuring AAA Rules for ASA, PIX, and FWSM Devices

 
     		 [bookmark: pgfId-484721]Configuring AAA Rules for IOS Devices

 
     		 [bookmark: pgfId-484726]AAA Rules Page

 
     		 [bookmark: pgfId-484731]AAA Firewall Settings Policies

 
    

 
    [bookmark: pgfId-484733]The following topics can help you with general rule table usage:

 
     
     		 [bookmark: pgfId-484738]Adding and Removing Rules

 
     		 [bookmark: pgfId-484743]Editing Rules

 
     		 [bookmark: pgfId-484748]Enabling and Disabling Rules

 
     		 [bookmark: pgfId-484753]Moving Rules and the Importance of Rule Order

 
    

 
   
 
    
     [bookmark: pgfId-484763][bookmark: 40937][bookmark: porules_cncpt_UnderstandingAAARules]Understanding AAA Rules[bookmark: marker-484759][bookmark: marker-484761]

 
    [bookmark: pgfId-484765]You can use Authentication, Authorization, and Accounting (AAA) rules to control access to network resources based on user privileges rather than by IP addresses. AAA rules provide a different type of control compared to traditional access rules; where access rules allow you to control which IP addresses and services are allowed, AAA rules allow you to configure ACLs for each user to define the authorization available on a user basis, regardless of the IP address from which the user connects. (These per-user ACLs are configured in the AAA server, not in the AAA rule defined on the device.)

 
    [bookmark: pgfId-484767]AAA rules policies differ from other device platform AAA policies in that AAA rules apply to traffic that is passing through the device, not to traffic directed specifically at the device. By using AAA rules, you can control entry into, or out of, a network. This might be useful if you have a network segment that is high security, where you want to carefully control access. AAA rules are also useful for circumstances where you need to maintain per-user accounting records for billing, security, or resource allocation purposes.

 
    [bookmark: pgfId-484769]The AAA rules policy actually configures three separate types of rule, and the configuration of these rules differs significantly between IOS devices on the one hand and ASA, PIX, and FWSM devices on the other hand. For IOS devices, these policies define what is called authentication proxy admission control. When creating shared AAA rules, create separate rules for these types of devices. Following are the types of rules you can configure with AAA rules:

 
     
     		 [bookmark: pgfId-484771]Authentication rules—Authentication rules control basic user access. If you configure an authentication rule, users must log in if their connection request goes through the device on which the rule is defined. You can force users to log in for HTTP, HTTPS, FTP, or Telnet connections. For ASA, PIX, and FWSM devices, you can control other types of services, but users must first authenticate using one of the supported protocols before other types of traffic are allowed.

 
    

 
    [bookmark: pgfId-484773]The device recognizes these traffic types only on the default ports: FTP (21), Telnet (23), HTTP (80), HTTPS (443). If you map these types of traffic to other ports, the user will not be prompted, and access will fail.

 
     
     		 [bookmark: pgfId-484775]Authorization rules—You can define an additional level of control over and above authentication. Authentication simply requires that users identify themselves. After authentication is successful, an authorization rule can query the AAA server to determine if the user has sufficient privileges to complete the attempted connection. If authorization fails, the connection is dropped.

 
    

 
    [bookmark: pgfId-484777] – For ASA, PIX, and FWSM devices, you define authorization rules directly in the AAA rules policy; if you require authorization for traffic that does not also require authentication, the unauthenticated traffic is always dropped. If you use RADIUS servers for authentication, authorization is automatically performed and authorization rules are not necessary. If you configure authorization rules, you must use a TACACS+ server.

 
    [bookmark: pgfId-484779] – For IOS devices, to configure authorization, you must configure an authorization server group in the Firewall > Settings > AAA policy; authorization is done for any traffic that is subject to authentication. You can use TACACS+ or RADIUS servers.

 
     
     		 [bookmark: pgfId-484781]Accounting—You can define accounting rules even if you do not configure authentication or authorization. If you do configure authentication, accounting records are created for each user, so that you can identify the specific user who made the connection. Without user authentication, accounting records are based on IP address. You can use TACACS+ or RADIUS servers for accounting.

 
    

 
    [bookmark: pgfId-484783] – For ASA, PIX, and FWSM devices, you define accounting rules directly in the AAA rules policy. You can perform accounting for any TCP or UDP protocol.

 
    [bookmark: pgfId-484785] – For IOS devices, to configure accounting, you must configure an accounting server group in the Firewall > Settings > AAA policy; accounting is done for any traffic that is subject to authentication.

 
   
 
    
     [bookmark: pgfId-484795][bookmark: 40970][bookmark: porules_cncpt_UnderstandingHowUsersAuthenticate]Understanding How Users Authenticate [bookmark: marker-484791][bookmark: marker-484793]

 
    [bookmark: pgfId-484797]When you create AAA rules to require that users authenticate when trying to make connections through a device, users will be prompted to supply credentials: a username and password. These credentials must be defined in a AAA server or in the local database configured on the device.

 
    [bookmark: pgfId-484799]Users are prompted only for HTTP, HTTPS, FTP, and Telnet connections (if you configure those protocols to require authentication). For ASA, PIX, and FWSM devices, you can also require authentication for other protocols; however, users are not prompted for them, and so they must first attempt one of the four supported protocols and successfully authenticate before completing connections of any other protocol that requires authentication.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-484801]Tip For ASA, PIX, and FWSM devices, if you do not want to allow HTTP, HTTPS, Telnet, or FTP through the security appliance but want to authenticate other types of traffic, you can require that the user authenticate with the security appliance directly using HTTP or HTTPS by configuring the interface to use interactive authentication (using the Firewall > Settings > AAA Firewall policy). The user would then authenticate with the appliance before trying other connections, using one of the following URLs, where interface_ip is the IP address of the interface and port is optionally the port number, if you specify a non-default port for the protocol in the interactive authentication table: http://interface_ip[:port]/netaccess/connstatus.html or https://interface_ip[:port]/netaccess/connstatus.html.


    
     

    

    

 
    [bookmark: pgfId-484803]When attempting a connection through the device, the user is prompted based on the protocol:

 
     
     		 [bookmark: pgfId-484805]HTTP—The device prompts the user with a web page to provide username and password. The user is prompted repeatedly until successfully authorized. After the user authenticates correctly, the device redirects the user to the original destination. If the destination server also has its own authentication, the user enters another username and password.

 
    

 
    [bookmark: pgfId-484810]For ASA, PIX, and FWSM devices, the security appliance uses basic HTTP authentication by default, and provides an authentication prompt. You can improve the user experience by configuring the interface for interactive authentication and specifying redirect for HTTP traffic. This redirects the user to a web page hosted on the appliance for authentication. To configure an interface to use interactive authentication, add the interface to the Interactive Authentication table on the Firewall > Settings > AAA Firewall policy (see AAA Firewall Settings Page, Advanced Setting Tab). Ensure that you select the HTTP and Redirect options when adding the interface.

 
    [bookmark: pgfId-484812]You might want to continue to use basic HTTP authentication if: you do not want the security appliance to open listening ports; if you use NAT on a router and you do not want to create a translation rule for the web page served by the security appliance; basic HTTP authentication might work better with your network. For example non-browser applications, like when a URL is embedded in email, might be more compatible with basic authentication.

 
    [bookmark: pgfId-484817]However, when using basic HTTP authentication, if the user is going to an HTTP server that requires authentication, the same username and password used to authenticate with the appliance is sent to the HTTP server. Thus, login to the HTTP server fails unless the same username and password are used by the ASA and HTTP server. To avoid this problem, you must configure a virtual HTTP server on the ASA. You can configure a virtual HTTP server using the Firewall > Settings > AAA Firewall policy (see AAA Firewall Settings Page, Advanced Setting Tab).

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-484819]Tip In HTTP authentication, the username and password are transmitted in clear text. You can prevent this by selecting the Use Secure HTTP Authentication option on the Firewall > Settings > AAA Firewall policy. This option ensures that credentials are encrypted.


    
     

    

    

 
     
     		 [bookmark: pgfId-484821]HTTPS—The user experience for HTTPS is the same as for HTTP; the user is prompted until successfully authorized, and then redirected to the original destination.

 
    

 
    [bookmark: pgfId-484823]For ASA, PIX, and FWSM devices, the security appliance uses a custom login screen. Like with HTTP, you can configure the interface to use interactive authentication, in which case HTTPS connections use the same authentication page as HTTP connections. You must configure the interface separately for HTTPS redirection; use the Firewall > Settings > AAA Firewall policy.

 
    [bookmark: pgfId-484828]For IOS devices, HTTPS connections are authenticated only if you enable SSL on the device and your AAA rules require HTTP authentication proxy. This configuration is explained in Configuring AAA Rules for IOS Devices.

 
     
     		 [bookmark: pgfId-484830]FTP—The device prompts once for authentication. If authentication fails, the user must retry the connection.

 
    

 
    [bookmark: pgfId-484832]When prompted, the user can enter the username required for device authentication followed by an at sign (@) and then the FTP username (name1@name2). For the password, the user would then enter the device authentication password followed by an at sign (@) and then the FTP password (password1@password2). For example, enter the following text.

 
    [bookmark: pgfId-484834]name> asa1@partreq
password> letmein@he110

 
    [bookmark: pgfId-484836]For IOS devices, this method of entering both the device and FTP credentials is required. For ASA, PIX, and FWSM devices, this feature is useful when you have cascaded firewalls that require multiple logins. You can separate several names and passwords by multiple at signs (@).

 
     
     		 [bookmark: pgfId-484841]Telnet—The device prompts several times for authentication. After a number of failed attempts, the user must retry the connection. After authentication, the Telnet server prompts for its username/password. You can configure a virtual Telnet server using the  Firewall > Settings > AAA Firewall policy (see AAA Firewall Settings Page, Advanced Setting Tab).

 
    

 
   
 
    
     [bookmark: pgfId-484851][bookmark: 41026][bookmark: porules_proc_ConfiguringAAARulesforASAPIXFWSMDevices]Configuring AAA Rules for ASA, PIX, and FWSM Devices [bookmark: marker-484847][bookmark: marker-484849]

 
    [bookmark: pgfId-484853]When you configure AAA rules for an ASA, PIX, or FWSM device, you are configuring policies that define who is allowed to make HTTP, HTTPS, FTP, and Telnet connections through (not to) the device. To fully configure network access authentication, you need to configure several policies, not just the AAA rules policy.

 
    [bookmark: pgfId-484855]The following procedure covers all policies you would need to configure to supply full authentication, authorization, and accounting support for network access authentication. You do not need to configure options for features you do not need.

 
    [bookmark: pgfId-484857]Related Topics

 
     
     		 [bookmark: pgfId-484862]Understanding AAA Rules

 
     		 [bookmark: pgfId-484867]Understanding How Users Authenticate

 
     		 [bookmark: pgfId-484872]Creating a New Shared Policy

 
     		 [bookmark: pgfId-484877]Modifying Policy Assignments in Policy View

 
     		 [bookmark: pgfId-484882]Understanding Networks/Hosts Objects

 
     		 [bookmark: pgfId-484887]Understanding Interface Role Objects

 
     		 [bookmark: pgfId-484892]Understanding and Specifying Services and Service and Port List Objects

 
     		 [bookmark: pgfId-484897]Understanding AAA Server and Server Group Objects

 
     		 [bookmark: pgfId-484902]Understanding Interface Role Objects

 
    

 
    
 
    [bookmark: pgfId-484907]Step 1 Do one of the following to open the AAA Rules Page:

 
     
     		 [bookmark: pgfId-484909](Device view) Select  Firewall > AAA Rules from the Policy selector.

 
     		 [bookmark: pgfId-484911](Policy view) Select  Firewall > AAA Rules from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-484916]Step 2 Select the row after which you want to create the rule and click the Add Row button or right-click and select Add Row. This opens the Add and Edit AAA Rule Dialog Boxes.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-484921]Tip If you do not select a row, the new rule is added at the end of the local scope. You can also select an existing row and edit either the entire row or specific cells. For more information, see Editing Rules.


    
     

    

    

 
    [bookmark: pgfId-484926]Step 3 Configure the rule. Following are the highlights of what you typically need to decide. For specific information on configuring the fields, see Add and Edit AAA Rule Dialog Boxes.

 
     
     		 [bookmark: pgfId-484928]Authentication (with or without User-Identity), Authorization, or Accounting Action—Select the options applicable for this rule. Authentication prompts the user for a username and password when attempting HTTP, HTTPS, FTP, or Telnet access. Authorization is an additional level, where after the user authenticates, the AAA server is checked to ensure that the user is authorized for that type of access. Accounting generates usage records in the AAA server and can be used for billing, security, or resource allocation purposes. You can generate accounting information for any TCP or UDP traffic.

 
    

 
    [bookmark: pgfId-484933]When you select Authentication, you can also select User-Identity (ASA 8.4(2+) only). This option indicates that the ASA should use the Active Directory servers configured in the identity-firewall domain mappings to authenticate users (see Identifying Active Directory Servers and Agents). If the user enters a domain name, the AD server associated with the domain is queried. Otherwise, the AD server associated with the default domain is queried. When you select User-Identity, and you do not select Authorization or Accounting, do not specify a AAA server group.

 
     
     		 [bookmark: pgfId-484935]Permit or Deny—Whether you are subjecting the identified traffic to AAA control (permit) or you are exempting it from AAA control (deny). Any denied traffic is not prompted for authentication and is allowed to pass unauthenticated, although your access rules might drop the traffic.

 
     		 [bookmark: pgfId-484940]Source and Destination addresses—If the rule should apply no matter which addresses generated the traffic or their destinations, use “All-Addresses” as the source or destination. If the rule is specific to a host or network, enter the addresses or network/host objects. For information on the accepted address formats, see Specifying IP Addresses During Policy Definition.

 
     		 [bookmark: pgfId-484951]Source and Destination Security Groups (ASA 9.0+ only)—You can specify TrustSec security groups used to filter traffic in addition to the source and destination addresses. See Selecting Security Groups in Policies, Configuring TrustSec-Based Firewall Rules and Creating Security Group Objects for more information about security groups.

 
     		 [bookmark: pgfId-484959]Source Users (ASA 8.4.2+ only)—You can further define the traffic source by specifying Active Directory (AD) user names (in the format NetBIOS_DOMAIN\username), user groups (NetBIOS_DOMAIN\\user_group), or identity user group objects that define the names and groups. The user specification is conjoined to the source address to limit the match to user addresses within the source address range. For more information, see Configuring Identity-Based Firewall Rules and Creating Identity User Group Objects.

 
     		 [bookmark: pgfId-484961]Services—You can specify any type of service for authentication and authorization rules; however, the user is prompted to authenticate only for HTTP, HTTPS, FTP, and Telnet connections. Thus, if you specify something other than these services, the user must first attempt one of these connections and successfully authenticate (and be authorized, if you include that action) before any other types of connections are allowed. For accounting rules, you can specify any TCP or UDP service (or simply TCP and UDP themselves), if you want to account for all types of traffic.

 
     		 [bookmark: pgfId-484963]AAA Server Group—The AAA server group policy object to be used for authentication, authorization, or accounting. If the rule applies more than one of these actions, the server group must support all selected actions. For example, only TACACS+ servers can provide services for authorization rules (although using RADIUS for authentication rules automatically includes RADIUS authorization), and only TACACS+ and RADIUS servers can provide accounting services. If you want to use different server groups for particular actions, define separate rules for each type of action that requires different groups.

 
     		 [bookmark: pgfId-484965]Interfaces—The interface or interface role for which you are configuring the rule.

 
    

 
    [bookmark: pgfId-484967]Click OK when you are finished defining your rule.

 
    [bookmark: pgfId-484972]Step 4 If you did not select the right row before adding the rule, select the new rule and use the up and down arrow buttons to position the rule appropriately. For more information, see Moving Rules and the Importance of Rule Order.

 
    [bookmark: pgfId-484987]Step 5 Select Firewall > Settings > AAA Firewall (in Device or Policy view) to open the AAA Firewall Settings Page, Advanced Setting Tab. Configure the AAA firewall settings:[bookmark: marker-484977][bookmark: marker-484979][bookmark: marker-484981][bookmark: marker-484983][bookmark: marker-484985]

 
     
     		 [bookmark: pgfId-484989]If you configured rules for HTTP authentication, you should select  Use Secure HTTP Authentication . This ensures that the username and password entered for HTTP authentication are encrypted. If you do not select this option, the credentials are sent in clear text, which is insecure.
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    [bookmark: pgfId-484991]Tip If you select this option, ensure that you do not configure 0 for the user authentication timeout (timeout uauth 0, configured in the Platform > Security > Timeouts policy), or users might be repeatedly prompted for authentication, making the feature disruptive to your network.


    
     

    

    

 
     
     		 [bookmark: pgfId-484993]If you configured authentication for HTTP or HTTPS traffic on an interface, you should consider adding the interface to the Interactive Authentication table. When you enable an interface for interactive authentication, users get an improved authorization web page, one that is the same for both HTTP and HTTPS.

 
    

 
    [bookmark: pgfId-484995]Click Add Row to add the interface to the table. Select whether the interface should listen for HTTP or HTTPS traffic (add the interface twice to listen for both protocols), and the port to listen on if not the default port for the protocol (80 and 443, respectively). Select Redirect network users for authentication request so that network access traffic gets the improved authentication prompt; if you do not select the option, only users trying to log into the device get the prompt.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-484997]Note You might want to continue to use basic HTTP authentication if: you do not want the security appliance to open listening ports; if you use NAT on a router and you do not want to create a translation rule for the web page served by the security appliance; basic HTTP authentication might work better with your network. For example non-browser applications, like when a URL is embedded in email, might be more compatible with basic authentication.


    
     

    

    

 
     
     		 [bookmark: pgfId-484999]For FWSM devices, you can also disable the authentication challenge for protocols you have otherwise configured to require authentication. You can also add interfaces to the Clear Connections table to ensure that active connections for users whose authentication has timed out are cleared and do not hang.

 
     		 [bookmark: pgfId-485009]If you want to exempt some devices from your AAA rules based on their media access control (MAC) address, click the  MAC Exempt List tab to open the AAA Firewall Page, MAC-Exempt List Tab. Enter a name for the exemption list, and then click the  Add Row button and fill in the Firewall AAA MAC Exempt Setting Dialog Box to add the MAC address to the table with a permit rule. You might want to do this for secure, trusted devices.[bookmark: marker-485007]

 
    

 
    [bookmark: pgfId-485014]The order of entries matters, so ensure that any specific entries that are covered by broader entries come before the broad entries in the table. The device processes the list in order and the first match is applied to the host. For more detailed information about how the entries on the MAC exempt list are processed, see AAA Firewall Page, MAC-Exempt List Tab.

 
    [bookmark: pgfId-485018]Step 6 If you are configuring authentication rules using a RADIUS server, and you include per-user ACL configurations in the user profiles, enable per-user downloadable ACLs on the interface. (RADIUS authentication automatically includes authorization checking.) For information on configuring per-user ACLs, see the information on configuring RADIUS authorization in the Cisco ASA 5500 Series Configuration Guide Using the CLI at http://www.cisco.com/en/US/docs/security/asa/asa82/configuration/guide/access_fwaaa.html.

 
    [bookmark: pgfId-485023] a. Select Firewall > Settings > Access Control (in Device or Policy view) to open the Access Control Settings Page.

 
    [bookmark: pgfId-485028] b. Click the Add Row button beneath the interface table and fill in the Firewall ACL Setting Dialog Box with at least these options:

 
     
     		 [bookmark: pgfId-485030]Enter the interface or interface role on which you are performing authorization.

 
     		 [bookmark: pgfId-485032]Select  Per User Downloadable ACLs .

 
    

 
    [bookmark: pgfId-485034] c. Click OK to save your changes.

 
    [bookmark: pgfId-485036]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-485048][bookmark: 41190][bookmark: porules_proc_ConfiguringAAARulesforIOSDevices]Configuring AAA Rules for IOS Devices[bookmark: marker-485042][bookmark: marker-485044][bookmark: marker-485046]

 
    [bookmark: pgfId-485050]When you configure AAA rules for an IOS device, you are configuring authentication proxy (AuthProxy) admission control policies. These policies define who is allowed to make HTTP, HTTPS, FTP, and Telnet connections through (not to) the device. To fully configure authentication proxy, you must configure several policies, not just the AAA rules policy.

 
    [bookmark: pgfId-485052]The following procedure covers all policies you would need to configure to supply full authentication, authorization, and accounting support for authorization proxy. You do not need to configure options for features you do not need.

 
    [bookmark: pgfId-485054]Related Topics

 
     
     		 [bookmark: pgfId-485059]Understanding AAA Rules

 
     		 [bookmark: pgfId-485064]Understanding How Users Authenticate

 
     		 [bookmark: pgfId-485069]Creating a New Shared Policy

 
     		 [bookmark: pgfId-485074]Modifying Policy Assignments in Policy View

 
     		 [bookmark: pgfId-485079]Understanding Networks/Hosts Objects

 
     		 [bookmark: pgfId-485084]Understanding Interface Role Objects

 
     		 [bookmark: pgfId-485089]Understanding and Specifying Services and Service and Port List Objects

 
     		 [bookmark: pgfId-485094]Understanding AAA Server and Server Group Objects

 
     		 [bookmark: pgfId-485099]Understanding Interface Role Objects

 
    

 
    
 
    [bookmark: pgfId-485104]Step 1 Do one of the following to open the AAA Rules Page:

 
     
     		 [bookmark: pgfId-485106](Device view) Select  Firewall > AAA Rules from the Policy selector.

 
     		 [bookmark: pgfId-485108](Policy view) Select  Firewall > AAA Rules from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-485113]Step 2 Select the row after which you want to create the rule and click the Add Row button or right-click and select Add Row. This opens the Add and Edit AAA Rule Dialog Boxes.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-485118]Tip If you do not select a row, the new rule is added at the end of the local scope. You can also select an existing row and edit either the entire row or specific cells. For more information, see Editing Rules.


    
     

    

    

 
    [bookmark: pgfId-485123]Step 3 Configure the rule. Following are the highlights of what you typically need to decide. For specific information on configuring the fields, see Add and Edit AAA Rule Dialog Boxes.

 
     
     		 [bookmark: pgfId-485125] Authentication Action —Select this option. Authentication rules are the only type of rule you can configure in the AAA rules policy for IOS devices.

 
     		 [bookmark: pgfId-485127]Permit or Deny—Whether you are subjecting the identified traffic to AAA control (permit) or you are exempting it from AAA control (deny). Any denied traffic is not prompted for authentication and is allowed to pass unauthenticated, although your access rules might drop the traffic.

 
     		 [bookmark: pgfId-485132]Source and Destination addresses—If the rule should apply no matter which addresses generated the traffic or their destinations, use “All-Addresses” as the source or destination. If the rule is specific to a host or network, enter the addresses or network/host objects. For information on the accepted address formats, see Specifying IP Addresses During Policy Definition.

 
     		 [bookmark: pgfId-485143]Source and Destination Security Groups (ASA 9.0+ only)—You can specify TrustSec security groups used to filter traffic in addition to the source and destination addresses. See Selecting Security Groups in Policies, Configuring TrustSec-Based Firewall Rules and Creating Security Group Objects for more information about security groups.

 
     		 [bookmark: pgfId-485151]Source Users (ASA 8.4.2+ only)—You can further define the traffic source by specifying Active Directory (AD) user names (in the format NetBIOS_DOMAIN\username), user groups (NetBIOS_DOMAIN\\user_group), or identity user group objects that define the names and groups. The user specification is conjoined to the source address to limit the match to user addresses within the source address range. For more information, see Configuring Identity-Based Firewall Rules and Creating Identity User Group Objects.

 
     		 [bookmark: pgfId-485153]Services—You can specify any type of service for authentication and authorization rules; however, the user is prompted to authenticate only for HTTP, HTTPS, FTP, and Telnet connections. Thus, if you specify something other than these services, the user must first attempt one of these connections and successfully authenticate (and be authorized, if you include that action) before any other types of connections are allowed. For accounting rules, you can specify any TCP or UDP service (or simply TCP and UDP themselves), if you want to account for all types of traffic.

 
     		 [bookmark: pgfId-485155]Interfaces—The interface or interface role for which you are configuring the rule.

 
     		 [bookmark: pgfId-485157]Service triggering the authentication proxy—Select the checkboxes for the type of traffic you want to trigger user authentication: HTTP, FTP, or Telnet. You can select any combination. If you want to trigger the proxy for HTTPS support, select HTTP and perform the HTTPS configuration that is explained in a subsequent step in this procedure.

 
    

 
    [bookmark: pgfId-485159]Click OK when you are finished defining your rule.

 
    [bookmark: pgfId-485164]Step 4 If you did not select the right row before adding the rule, select the new rule and use the up and down arrow buttons to position the rule appropriately. For more information, see Moving Rules and the Importance of Rule Order.

 
    [bookmark: pgfId-485179]Step 5 Select Firewall > Settings > AuthProxy (in Device or Policy view) to open the AAA Page. Configure the authentication proxy settings:[bookmark: marker-485169][bookmark: marker-485171][bookmark: marker-485173][bookmark: marker-485175][bookmark: marker-485177]

 
     
     		 [bookmark: pgfId-485181] Authorization server groups —If you want all of your authentication rules to also perform user authorization, specify the list of AAA server group policy objects that identify the TACACS+ or RADIUS servers that control authorization. You can also specify LOCAL to use the user database defined on the device. If you do not specify a server group, authorization is not performed.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-485185]Tip You must configure per-user ACLs in your AAA server to define the privileges you want to apply to each user. When configuring authorization, specify auth-proxy as the service (e.g. service = auth-proxy), with a privilege level of 15. For more information on configuring the AAA server, including information on configuring authentication proxy in general, see the “Configuring the Authentication Proxy” section in the Cisco IOS Security Configuration Guide: Securing User Services, Release 12.4T at http://www.cisco.com/en/US/docs/ios/sec_user_services/configuration/guide/sec_cfg_authen_prxy_ps6441_TSD_Products_Configuration_Guide_Chapter.html.


    
     

    

    

 
     
     		 [bookmark: pgfId-485187] Accounting server groups —If you want to perform accounting for all of your authentication rules, specify the list of AAA server group policy objects that identify the TACACS+ or RADIUS servers that perform accounting. If you do not specify a server group, no accounting is performed. When performing accounting, also configure the following options as appropriate:

 
    

 
    [bookmark: pgfId-485189] – If you specify more than one server group, consider selecting Use Broadcast for Accounting. This option sends accounting records to the primary server in each server group.

 
    [bookmark: pgfId-485191] – The Accounting Notice option defines when the server is notified. The default is to notify the server at the start and stop of a connection, but you can select to only send stop notices (or none at all).

 
     
     		 [bookmark: pgfId-485193]You can also customize authentication banners for each service, and on the Timeout tab, you can change the default idle and absolute session timeouts globally or for each interface.

 
    

 
    [bookmark: pgfId-485198]Step 6 Select Platform > Device Admin > AAA (in policy view, this is in the Router Platform folder) to open the AAA Policy Page. Configure these options on the Authentication tab:

 
     
     		 [bookmark: pgfId-485200]Select  Enable Device Login Authentication .

 
     		 [bookmark: pgfId-485205]Enter the list of server groups that will control authentication in priority order. Typically, you will use at least some of the same LDAP, RADIUS, or TACACS+ server groups used in the AuthProxy policy. However, this policy also defines device login control, so you might want to include some other server groups. For more information, see AAA Page—Authentication Tab.

 
    

 
    [bookmark: pgfId-485210]Step 7 If you are using the authentication proxy with HTTP connections, and you also want to use the proxy with HTTPS connections, select Platform > Device Admin > Device Access > HTTP (in policy view, this is in the Router Platform folder) to open the HTTP Policy Page. Configure these options:

 
     
     		 [bookmark: pgfId-485212]Select  Enable HTTP and  Enable SSL if they are not already selected.

 
     		 [bookmark: pgfId-485214]On the AAA tab, ensure that the configuration for login access to the device is appropriate. If you are using AAA to control access through the device, you might want to use it for access to the device.

 
    

 
    [bookmark: pgfId-485216]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-485226][bookmark: 41351][bookmark: fwlsvcpg_cncpt_AAARulesPage]AAA Rules Page[bookmark: marker-485224]

 
    [bookmark: pgfId-485228]Use the AAA Rules page to configure AAA rules for device interfaces. AAA rules configure network access control (called authentication proxy on IOS devices), which forces the user to authenticate when attempting network connections that traverse the device. Authenticated traffic can also be required to undergo authorization (where after the user enters a valid user name and password, the AAA server is checked to verify that the user is authorized for network access). You can also configure accounting rules, even for unauthenticated traffic, to provide information you can use for billing, security, and resource allocation purposes.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-485236]Note With the release of Security Manager 4.4 and versions 9.0 and higher of the ASA, the separate policies and objects for configuring IPv4 and IPv6 AAA rules were “unified,” meaning one set of AAA rules in which you can use either IPv4 or IPv6 addresses, or a mixture of both. (See Policy Object Changes in Security Manager 4.4 for additional information.) In Policy view, IPv4 and unified versions of the AAA policy type are provided. In addition, a utility that you can use to convert existing IPv4 policies is provided (see Converting IPv4 Rules to Unified Rules). The following descriptions apply to all versions of the AAA rule table, except where noted.

If you assign an IPv4 AAA-rule shared policy to a 9.0+ device, you will no longer be able to assign unified versions of those policies to that device. Likewise, if you assign a unified AAA-rule shared policy to a 9.0+ device, you will no longer be able to assign IPv4 versions of those shared policies to that device--the device will not be included in the list of available devices on the Assignments tab for the shared policy.


    
     

    

    

 
    [bookmark: pgfId-485238]AAA rule configuration is complex and differs significantly based on the operating system. Carefully read the following topics before configuring AAA rules:

 
     
     		 [bookmark: pgfId-485243]Understanding AAA Rules

 
     		 [bookmark: pgfId-485248]Understanding How Users Authenticate

 
     		 [bookmark: pgfId-485253]Configuring AAA Rules for ASA, PIX, and FWSM Devices

 
     		 [bookmark: pgfId-485258]Configuring AAA Rules for IOS Devices

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-485263]Tip Disabled rules are shown with hash marks covering the table row. When you deploy the configuration, disabled rules are removed from the device. For more information, see Enabling and Disabling Rules.


    
     

    

    

 
    [bookmark: pgfId-485265]Navigation Path

 
    [bookmark: pgfId-485267]To access the AAA Rules page, do one of the following:

 
     
     		 [bookmark: pgfId-485269](Device view) Select a device, then select  Firewall > AAA Rules from the Policy selector.

 
     		 [bookmark: pgfId-485271](Policy view) Select  Firewall > AAA Rules from the Policy Type selector. Create a new policy or select an existing one.

 
     		 [bookmark: pgfId-485273](Map view) Right-click a device and select  Edit Firewall Policies > AAA Rules .

 
    

 
    [bookmark: pgfId-485275]Related Topics.

 
     
     		 [bookmark: pgfId-485280]Adding and Removing Rules

 
     		 [bookmark: pgfId-485285]Editing Rules

 
     		 [bookmark: pgfId-485290]Moving Rules and the Importance of Rule Order

 
     		 [bookmark: pgfId-485295]Using Sections to Organize Rules Tables

 
     		 [bookmark: pgfId-485300]Using Rules Tables

 
     		 [bookmark: pgfId-485305]Filtering Tables

 
    

 
    [bookmark: pgfId-485307]Field Reference

 
    [bookmark: pgfId-485310] 

 
     
      
       
       [bookmark: pgfId-482892]Table 15-1 [bookmark: 41415]AAA Rules Page 

 
       
      
        
        		
          
          [bookmark: pgfId-482898]Element
         
  
        		
          
          [bookmark: pgfId-482900]Description
         
  
       

 
        
        		[bookmark: pgfId-482906]Expand all rows/Collapse all rows

  
        		[bookmark: pgfId-482908]Use these buttons to expand or collapse all sections in the rules table.

 [bookmark: pgfId-482910]Note The buttons are located in the upper-right corner of the Filter area above the access rules table.

  
       

 
        
        		[bookmark: pgfId-482916]Conflict Indicator icons

  
        		[bookmark: pgfId-482921]Identifies conflicts and provides a quick visual representation of the type of conflict. For more details, including types of conflicts and the actions you can take from this column, see Understanding the Automatic Conflict Detection User Interface.

  
       

 
        
        		[bookmark: pgfId-482927]No.

  
        		[bookmark: pgfId-482929]The ordered rule number.

  
       

 
        
        		[bookmark: pgfId-482935]Permit

  
        		[bookmark: pgfId-482937]Whether the defined traffic will be subject to the rule (Permit) or exempted from the rule (Deny):

 
          
          		 [bookmark: pgfId-482939]Permit—Shown as a green check mark.

 
          		 [bookmark: pgfId-482941]Deny—Shown as a red circle with slash.

 
         

  
       

 
        
        		[bookmark: pgfId-482947]Sources

  
        		[bookmark: pgfId-482949]The sources of traffic for this rule; can be networks, security groups (ASA 9.0+ only), and users. Multiple entries are displayed on separate lines within the table cell.

  
       

 
        
        		[bookmark: pgfId-482955]Destinations

  
        		[bookmark: pgfId-482957]The destinations for this rule; can be networks and security groups (ASA 9.0+ only). Multiple entries are displayed on separate lines within the table cell.

  
       

 
        
        		[bookmark: pgfId-482963]Service

  
        		[bookmark: pgfId-482968]The services or service objects that specify the protocol and port of the traffic to which the rule applies. Multiple entries are displayed on separate lines within the table cell. See Understanding and Specifying Services and Service and Port List Objects.

  
       

 
        
        		[bookmark: pgfId-482974]Interface

  
        		[bookmark: pgfId-482979]The interfaces or interface roles to which the rule is assigned. Interface role objects are replaced with the actual interface names when the configuration is generated for each device. Multiple entries are displayed as separate subfields within the table cell. See Understanding Interface Role Objects.

  
       

 
        
        		[bookmark: pgfId-482985]Action

  
        		[bookmark: pgfId-482987]The type of AAA control defined by this rule:

 
          
          		 [bookmark: pgfId-482989]Authenticate—Users making connections through the device must authenticate with their username and password. Protocols requiring authentication are defined by the Service field (for ASA/PIX/FWSM devices) or the AuthProxy methods (for IOS devices).

 
          		 [bookmark: pgfId-482991]Authorize—Authenticated users are also checked with the AAA server to ensure that they are authorized to make the connection (ASA/PIX/FWSM only).

 
          		 [bookmark: pgfId-482993]Account—Accounting records for the identified traffic are sent to the AAA server (ASA/PIX/FWSM only).

 
         

 [bookmark: pgfId-482998]You can right-click the Action cell in an existing AAA rule and choose Edit Action to change your selections. See Edit AAA Option Dialog Box for more information.

  
       

 
        
        		[bookmark: pgfId-483004]AAA Method (IOS)

 [bookmark: pgfId-483006](not presented for ASA 9.0+ devices)

  
        		[bookmark: pgfId-483008]The authentication method for this rule: Web Authorization Proxy (Auth-Proxy), HTTP Basic, or Windows NT LAN Manager (NTLM)

  
       

 
        
        		[bookmark: pgfId-483014]AuthProxy

  
        		[bookmark: pgfId-483016]The protocols that require authentication using the authentication proxy method. This applies only to IOS devices.

 [bookmark: pgfId-483021]You can right-click the AuthProxy cell in an existing AAA rule and choose Edit AuthProxy to change your selections. See AuthProxy Dialog Box for more information.

  
       

 
        
        		[bookmark: pgfId-483027]Server Group

  
        		[bookmark: pgfId-483032]The AAA server group that provides the authentication, authorization, or accounting support defined in the rule. This group is used for ASA/PIX/FWSM devices only. For information on configuring AAA servers for IOS devices for use with these rules, see Configuring AAA Rules for IOS Devices.

 [bookmark: pgfId-483037]You can right-click the Server Group cell in an existing AAA rule and choose Edit Server Group to change your selections. See Edit Server Group Dialog Box for more information.

  
       

 
        
        		[bookmark: pgfId-483043]Category

  
        		[bookmark: pgfId-483048]The category assigned to the rule. Categories help you organize and identify rules and objects. See Using Category Objects.

  
       

 
        
        		[bookmark: pgfId-483054]Description

  
        		[bookmark: pgfId-483056]The description of the rule, if any.

  
       

 
        
        		[bookmark: pgfId-483062]Last Ticket(s)

  
        		[bookmark: pgfId-483067]Shows the ticket(s) associated with last modification to the rule. You can click the ticket ID in the Last Ticket(s) column to view details of the ticket and to navigate to the ticket. If linkage to an external ticket management system has been configured, you can also navigate to that system from the ticket details (see Ticket Management Page).

  
       

 
        
        		 [bookmark: pgfId-483073]Page elements below the rules table

  
       

 
        
        		[bookmark: pgfId-483081]Query

  
        		[bookmark: pgfId-483086]Click this button to run a policy query, which can help you evaluate your rules and identify ineffective rules. See Generating Policy Query Reports

  
       

 
        
        		[bookmark: pgfId-483092]Find and Replace button (binoculars icon)

  
        		[bookmark: pgfId-483097]Click this button to search for various types of items within the table and to optionally replace them. See Finding and Replacing Items in Rules Tables.

  
       

 
        
        		[bookmark: pgfId-483103]Up Row and Down Row buttons (arrow icons)

  
        		[bookmark: pgfId-483108]Click these buttons to move the selected rules up or down within a scope or section. For more information, see Moving Rules and the Importance of Rule Order.

  
       

 
        
        		[bookmark: pgfId-483114]Add Row button

  
        		[bookmark: pgfId-483122]Click this button to add a rule to the table after the selected row using the Add and Edit AAA Rule Dialog Boxes. If you do not select a row, the rule is added at the end of the local scope. For more information about adding rules, see Adding and Removing Rules.

  
       

 
        
        		[bookmark: pgfId-483128]Edit Row button

  
        		[bookmark: pgfId-483133]Click this button to edit the selected rule. You can also edit individual cells. For more information, see Editing Rules.

  
       

 
        
        		[bookmark: pgfId-483139]Delete Row button

  
        		[bookmark: pgfId-483141]Click this button to delete the selected rule.

  
       

 
      
     

 
    
 
    [bookmark: pgfId-485312]Right-click Menu

 
    [bookmark: pgfId-485314]A right-click menu is also available. This menu provides access to many of the functions listed above; the options presented depend on the location right-clicked:

 
     
     		 [bookmark: pgfId-485319]If you right-click a rule in the table, the options may include editing functions relative to the specific table cell right-clicked. For example, the command “Edit Server Group” is included when you right-click a Server Group cell. See Editing Rules for more information.

 
     		 [bookmark: pgfId-485324]The Combine Rules option is also included in the right-click menu. See Combining Rules for more information.

 
    

 
     
      [bookmark: pgfId-485340][bookmark: 41576][bookmark: fwlsvcpg_cncpt_AddandEditAAARulesDialogBoxes]Add and Edit AAA Rule Dialog Boxes[bookmark: marker-485332][bookmark: marker-485334][bookmark: marker-485336][bookmark: marker-485338]

 
     [bookmark: pgfId-485342]Use the Add and Edit AAA Rules dialog boxes to add and edit AAA rules. AAA rule configuration is more complex than just filling in this dialog box, and differs significantly based on the operating system. Carefully read the following topics before configuring AAA rules:

 
      
      		 [bookmark: pgfId-485347]Understanding AAA Rules

 
      		 [bookmark: pgfId-485352]Understanding How Users Authenticate

 
      		 [bookmark: pgfId-485357]Configuring AAA Rules for ASA, PIX, and FWSM Devices

 
      		 [bookmark: pgfId-485362]Configuring AAA Rules for IOS Devices

 
     

 
     [bookmark: pgfId-485364]Navigation Path

 
     [bookmark: pgfId-485369]From the AAA Rules Page, click the Add Row button or select a row and click the Edit Row button.

 
     [bookmark: pgfId-485371]Related Topics

 
      
      		 [bookmark: pgfId-485376]Adding and Removing Rules

 
      		 [bookmark: pgfId-485381]Editing Rules

 
     

 
     [bookmark: pgfId-485383]Field Reference

 
     [bookmark: pgfId-485386] 

 
      
       
        
        [bookmark: pgfId-483154]Table 15-2 [bookmark: 41622]Add and Edit AAA Rules Dialog Boxes 

 
        
       
         
         		
           
           [bookmark: pgfId-483160]Element
          
  
         		
           
           [bookmark: pgfId-483162]Description
          
  
        

 
         
         		[bookmark: pgfId-483168]Enable Rule

  
         		[bookmark: pgfId-483173]Whether to enable the rule, which means the rule becomes active when you deploy the configuration to the device. Disabled rules are shown overlain with hash marks in the rule table. For more information, see Enabling and Disabling Rules.

  
        

 
         
         		[bookmark: pgfId-483179]Action (Permit/Deny)

  
         		[bookmark: pgfId-483181]Whether the defined traffic will be subject to the rule (Permit) or exempted from the rule (Deny).

 [bookmark: pgfId-483183]For example, if you create an authentication deny rule for the 10.100.10.0/24 network to any destination using the HTTP service, users on this network are not prompted to authenticate with the device when making HTTP requests.

  
        

 
         
         		[bookmark: pgfId-483189]Sources

  
         		[bookmark: pgfId-483191]Provide traffic sources for this rule; can be networks, security groups, and users. You can enter values or object names, or Select objects, for one or more of the following types of sources:

 
           
           		 [bookmark: pgfId-483193]Network – You can specify a various network, host and interface definitions, either individually or as objects. If you Select an interface object as a source, the dialog box displays tabs to differentiate between hosts/networks and interfaces.

 
          

 [bookmark: pgfId-483195]The “All-Address” objects do not restrict the rule to specific hosts, networks, or interfaces. These addresses are IPv4 or IPv6 addresses for hosts or networks, network/host objects, interfaces, or interface roles.

 [bookmark: pgfId-483197]Note You can only specify a fully qualified domain name (FQDN) by providing an FQDN network/host object, or a group object that includes an FQDN object. You cannot directly type in an FQDN.

 [bookmark: pgfId-483208]See Understanding Networks/Hosts Objects, Specifying IP Addresses During Policy Definition and Understanding Interface Role Objects for additional information about these definitions.

 
           
           		 [bookmark: pgfId-483219]Security Groups (ASA 9.0+) – Enter or Select the name or tag number for one or more source security groups for the rule, if any. See Selecting Security Groups in Policies, Configuring TrustSec-Based Firewall Rules and Creating Security Group Objects for more information about security groups.

 
           		 [bookmark: pgfId-483221]Users – Enter or Select the Active Directory (AD) user names, user groups, or identity user group objects for the rule, if any. You can enter any combination of the following:

 
          

 [bookmark: pgfId-483223] – Individual user names: NetBIOS_DOMAIN\username

 [bookmark: pgfId-483225] – User groups (note the double \): NetBIOS_DOMAIN\\user_group

 [bookmark: pgfId-483227] – Identity user group object names.

 [bookmark: pgfId-483229]For more information, see:

 [bookmark: pgfId-483234] – Selecting Identity Users in Policies

 [bookmark: pgfId-483239] – Configuring Identity-Based Firewall Rules

 [bookmark: pgfId-483244] – Creating Identity User Group Objects

 [bookmark: pgfId-483246]Note Enter more than one value in any of these fields by separating the items with commas.

 [bookmark: pgfId-483248]Each specification is combined with any others to limit traffic matches to only those flows that include all definitions. For example, specified user traffic originating from within a specified source address range.

  
        

 
         
         		[bookmark: pgfId-483254]Destinations

  
         		[bookmark: pgfId-483256]Provide traffic destinations for this rule; can be networks or security groups. As with Sources, you can enter values or object names, or Select objects, for one or more destinations of Network and Security Group (ASA 9.0+) type.

  
        

 
         
         		[bookmark: pgfId-483262]Services

  
         		[bookmark: pgfId-483264]The services that define the type of traffic upon which to act. You can enter or Select any combination of service objects and service types (which are typically a protocol and port combination).

 [bookmark: pgfId-483266]Enter more than one value by separating the items with commas.

 [bookmark: pgfId-483268]It is important that you select the service type carefully based on the device type:

 
           
           		 [bookmark: pgfId-483270]For IOS devices, only the protocols you select with the authorization proxy check boxes at the bottom of the dialog box are used for AAA control, so you can use IP as the protocol.

 
           		 [bookmark: pgfId-483272]For ASA, PIX, and FWSM devices, although you can force authentication for any type of traffic, the security appliance prompts only for HTTP/HTTPS, FTP, and Telnet traffic. If you specify a service other than one of these, users are prevented from making any connection through the appliance until they try one of these services and successfully authenticate.

 
          

 [bookmark: pgfId-483274]If the rule is only for accounting, you can specify any TCP or UDP protocols for which you want to create records.

 [bookmark: pgfId-483279]For complete information on how to specify services, see Understanding and Specifying Services and Service and Port List Objects.

 [bookmark: pgfId-483281]Note Due to an issue in PIX 6.3 and FWSM devices, if you specify a service with a source port, no traffic is authenticated. Therefore, source ports are ignored when the CLI is generated from your rule for these device types.

  
        

 
         
         		[bookmark: pgfId-483287]Interface

  
         		[bookmark: pgfId-483289]The interface or interface role object that identifies the interface from which to authenticate, authorize, or account users. Enter the name of the interface or interface role, or click Select to select it from a list or to create a new interface role object.

 [bookmark: pgfId-483297]For authentication rules on ASA and PIX devices, you can modify how this interface authenticates HTTP/HTTPS traffic by using the Firewall > Settings > AAA Firewall policy. Configuring the interface as an HTTP/HTTPS listening port can improve the authentication experience for users. For more information, see Understanding How Users Authenticate and AAA Firewall Settings Page, Advanced Setting Tab.

  
        

 
         
         		[bookmark: pgfId-483303]Description

  
         		[bookmark: pgfId-483305]An optional description of the rule (up to 1024 characters).

  
        

 
         
         		 [bookmark: pgfId-483311]The Authentication Action, Authorization Action, and Accounting Action check boxes define the types of rules that will be generated on the device. Each type generates a separate set of commands, but if you select more than one option, your other selections in this dialog box are limited to those supported by all selected actions.

 [bookmark: pgfId-483316]You can right-click the Action cell in an existing AAA rule and choose Edit Action to change your selections. See Edit AAA Option Dialog Box for more information.

  
        

 
         
         		[bookmark: pgfId-483324]Authentication Action

 [bookmark: pgfId-483326]User-Identity

  
         		
           
           		 [bookmark: pgfId-483328]Authentication—Users must supply a user name and password to make a connection through the device. For ASA, PIX, and FWSM devices, what you enter in the Services field determines which protocols require authentication, although the device will prompt only for HTTP, HTTPS, FTP, and Telnet connections. For IOS devices, the protocols that require authentication are based on the authorization proxy check boxes you select at the bottom of the dialog box.

 
          

 [bookmark: pgfId-483333] – User-Identity (ASA 8.4(2+) only.)—For ASA devices, when you select Authentication Action, you also have the option to select User-Identity. This option indicates that the device should use the identity-firewall domain mappings defined in the Identity Options policy to authenticate users instead of the AAA Server Group setting in the AAA rule. If the user enters a domain name, the AD server associated with the domain is queried. Otherwise, the AD server associated with the default domain is queried. See Identifying Active Directory Servers and Agents.

  
        

 
         
         		[bookmark: pgfId-483339]Authorization Action (PIX/ASA/FWSM)

  
         		[bookmark: pgfId-483341]Authorization—After successful authentication, the AAA server is also checked to determine if the user is authorized to make the requested connection. If you specify a RADIUS server for authentication rules, authorization happens without you having to configure authorization rules. If you are using a TACACS+ server, you must create separate authorization rules.

  
        

 
         
         		[bookmark: pgfId-483347]Accounting Action (PIX/ASA/FWSM)

  
         		[bookmark: pgfId-483349]Accounting—Accounting records will be sent to the TACACS+ or RADIUS server for the TCP and UDP protocols specified in the Services field. If you also configure authentication, these records are per-user; otherwise, they are based on IP address. For IOS devices, accounting is configured in the Firewall > Settings >ScanSafe Web Security policy, not in AAA rules, and applies only to the protocols you select for authentication proxy.

  
        

 
         
         		[bookmark: pgfId-483355]AAA Server Group (PIX, ASA, FWSM)

  
         		[bookmark: pgfId-483357]The AAA server group policy object that defines the AAA server that should provide authentication, authorization, or accounting for the traffic defined in the rule. Enter the name of the policy object or click Select to select it from a list or to create a new object.

 [bookmark: pgfId-483359]You must select a type of server that can perform all actions defined in the rule. For example, the local database (defined on the device) cannot provide authorization services. If you use a RADIUS server for authentication, it automatically provides authorization services, but you cannot define an authorization rule that uses a RADIUS server.

 [bookmark: pgfId-483364]You can use a mix of server groups for different actions for the same source/destination pair by creating separate rules for the desired combination of authentication, authorization, and accounting actions. For more information on AAA server group objects, see Understanding AAA Server and Server Group Objects.

 [bookmark: pgfId-483366]Tips

 
           
           		 [bookmark: pgfId-483368]If you select Authenticate Action and User-Identity, but not the Authorization or Accounting actions, any server you specify here is ignored. Do not select a server to avoid validation warnings.

 
           		 [bookmark: pgfId-483373]AAA server groups for IOS devices are defined in other policies. For a complete explanation of the configuration, see Configuring AAA Rules for IOS Devices.

 
           		 [bookmark: pgfId-483378]You can right-click the Server Group cell in an existing AAA rule and choose Edit Server Group to change your selections. See Edit Server Group Dialog Box for more information.

 
          

  
        

 
         
         		[bookmark: pgfId-483384]Category

  
         		[bookmark: pgfId-483389]The category assigned to the rule. Categories help you organize and identify rules and objects. See Using Category Objects.

  
        

 
         
         		[bookmark: pgfId-483395]Method (IOS)

 [bookmark: pgfId-483397](not presented for ASA 9.0+ devices)

  
         		[bookmark: pgfId-483399]Choose Auth-Proxy, HTTP-basic, or NTLM.

 [bookmark: pgfId-483401]If you choose Auth-Proxy, the following options are available:

 
           
           		 [bookmark: pgfId-483403]HTTP

 
           		 [bookmark: pgfId-483405]FTP

 
           		 [bookmark: pgfId-483407]Telnet

 
          

 [bookmark: pgfId-483412]Specify the protocols for which you want to enforce authentication using the authentication proxy. If you select HTTP, you can also configure HTTPS authentication proxy by enabling SSL on the device. For specific information, see Configuring AAA Rules for IOS Devices.

 [bookmark: pgfId-483417]You can right-click the AuthProxy cell in an existing AAA rule and choose Edit AuthProxy to change your selections. See AuthProxy Dialog Box for more information.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-485396][bookmark: 41795][bookmark: fwlsvcpg_cncpt_EditAAAOptionDialogBox]Edit AAA Option Dialog Box [bookmark: marker-485394]

 
     [bookmark: pgfId-485398]Use the Edit AAA Option dialog box to select whether the rule performs authentication (with or without user identity), authorization, or accounting. Authorization and accounting rules work only on ASA, PIX, and FWSM devices. For a complete explanation of these options, see the related explanations in the following topics:

 
      
      		 [bookmark: pgfId-485403]Add and Edit AAA Rule Dialog Boxes

 
      		 [bookmark: pgfId-485408]Understanding AAA Rules

 
     

 
     [bookmark: pgfId-485410]Navigation Path

 
     [bookmark: pgfId-485415]Right-click the Action cell in a AAA rule (on the AAA Rules Page) and select Edit AAA.

 
    
 
     
      [bookmark: pgfId-485425][bookmark: 41814][bookmark: fwlsvcpg_cncpt_AuthProxyDialogBox]AuthProxy Dialog Box [bookmark: marker-485423]

 
     [bookmark: pgfId-485430]Use the AuthProxy dialog box to edit the authorization proxy settings in a AAA rule. For IOS devices, select the protocols (HTTP, FTP, or Telnet) for which you want to enforce authentication using the authentication proxy. If you select HTTP, you can also configure HTTPS authentication proxy by enabling SSL on the device. For specific information, see Configuring AAA Rules for IOS Devices.

 
     [bookmark: pgfId-485432]Navigation Path

 
     [bookmark: pgfId-485437]Right-click the AuthProxy cell in a AAA rule (on the AAA Rules Page) and select Edit AuthProxy.

 
    
 
     
      [bookmark: pgfId-485447][bookmark: 41827][bookmark: fwlsvcpg_cncpt_EditAAAServerGroupDialogBox]Edit Server Group Dialog Box [bookmark: marker-485445]

 
     [bookmark: pgfId-485452]Use the Edit Server Group dialog box to edit the AAA server group used in a AAA rule, which defines the AAA server that should provide authentication, authorization, or accounting for the traffic defined in the rule. Enter the name of the policy object or click Select to select it from a list or to create a new object. For more information on AAA server group objects, see Understanding AAA Server and Server Group Objects.

 
     [bookmark: pgfId-485457]You must select a type of server that can perform all actions defined in the rule. For example, the local database (defined on the device) cannot provide authorization services. If you use a RADIUS server for authentication, it automatically provides authorization services, but you cannot define an authorization rule that uses a RADIUS server. Unlike the Add and Edit AAA Rule Dialog Boxes, this dialog box does not validate your selection.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-485462]Note This setting applies only to ASA, PIX, and FWSM devices. AAA server groups for IOS devices are defined in other policies. For a complete explanation of the configuration, see Configuring AAA Rules for IOS Devices.


     
      

     

     

 
     [bookmark: pgfId-485464]Navigation Path

 
     [bookmark: pgfId-485469]Right-click the Server Group cell in a AAA rule (on the AAA Rules Page) and select Edit Server Group.

 
    
 
   
 
    
     [bookmark: pgfId-485477][bookmark: 41846][bookmark: fwlsvcpg_cncpt_FirewallSettings]AAA Firewall Settings Policies[bookmark: marker-485475]

 
    [bookmark: pgfId-485479]The AAA firewall settings policy configurations influence the behavior of your AAA rules.

 
    [bookmark: pgfId-485481]This section contains the following topics:

 
     
     		 [bookmark: pgfId-485486]AAA Firewall Settings Page, Advanced Setting Tab

 
     		 [bookmark: pgfId-485491]AAA Firewall Page, MAC-Exempt List Tab

 
     		 [bookmark: pgfId-485496]AAA Page

 
    

 
     
      [bookmark: pgfId-485512][bookmark: 41852][bookmark: fwlsvcpg_cncpt_AAAFirewallAdvancedSettingPage]AAA Firewall Settings Page, Advanced Setting Tab [bookmark: marker-485504][bookmark: marker-485506][bookmark: marker-485508][bookmark: marker-485510]

 
     [bookmark: pgfId-485517]Use the AAA Firewall settings policy to configure optional settings to refine how your AAA rules policy behaves. This topic describes the settings available on the Advanced Setting tab; for information on the MAC Exempt List tab, see AAA Firewall Page, MAC-Exempt List Tab.

 
     [bookmark: pgfId-485519]Navigation Path

 
     [bookmark: pgfId-485521]To access the AAA Firewall settings page, do one of the following:

 
      
      		 [bookmark: pgfId-485523](Device view) Select an ASA, PIX, or FWSM device, select  Firewall > Settings > AAA Firewall ; select the  Advanced Setting tab if necessary.

 
      		 [bookmark: pgfId-485525](Policy view) Select  Firewall > Settings > AAA Firewall from the Policy Type selector. Create a new policy or select and existing one, then select the  Advanced Setting tab if necessary.

 
      		 [bookmark: pgfId-485527](Map view) Right-click an ASA, PIX, or FWSM device and select  Edit Firewall Settings > AAA Firewall , then select the  Advanced Setting tab if necessary.

 
     

 
     [bookmark: pgfId-485529]Related Topics

 
      
      		 [bookmark: pgfId-485534]Understanding AAA Rules

 
      		 [bookmark: pgfId-485539]Understanding How Users Authenticate

 
      		 [bookmark: pgfId-485544]Configuring AAA Rules for ASA, PIX, and FWSM Devices

 
     

 
     [bookmark: pgfId-485546]Field Reference

 
     [bookmark: pgfId-485549] 

 
      
       
        
        [bookmark: pgfId-483430]Table 15-3 [bookmark: 41902]Advanced Setting Tab, AAA Firewall Settings Page 

 
        
       
         
         		
           
           [bookmark: pgfId-483436]Element
          
  
         		
           
           [bookmark: pgfId-483438]Description
          
  
        

 
         
         		[bookmark: pgfId-483444]Use Secure HTTP Authentication

  
         		[bookmark: pgfId-483446]Whether to require users making HTTP requests that traverse the security appliance to first authenticate with the security appliance using SSL (HTTPS). The user is prompted for username and password.

 [bookmark: pgfId-483448]Secure HTTP authentication offers a secure method for user authentication to the security appliance prior to allowing HTTP-based web requests to traverse the security appliance. This is also called HTTP cut-through proxy authentication.

 [bookmark: pgfId-483450]If you select this option, ensure that your access rules do not block HTTPS traffic (port 443), and that any PAT configuration also includes port 443. Also, be aware that a maximum of 16 concurrent authentications are allowed, and that if you configure 0 for the user authentication timeout (timeout uauth 0, configured in the Platform > Security > Timeouts policy) users might be repeatedly prompted for authentication, making the feature disruptive to your network.

 [bookmark: pgfId-483452]Tip If you do not select this option, HTTP authentication sends the username and password in clear text.  
        

 
         
         		[bookmark: pgfId-483458]Enable Proxy Limit

 [bookmark: pgfId-483460]Maximum Concurrent Proxy Limit per User

  
         		[bookmark: pgfId-483462]Whether to allow proxy connections. If you enable proxies, you must set a limit on the number of proxy connections allowed for each user, from 1 to 128. The device default is 16, but you must specify a number.

  
        

 
         
         		[bookmark: pgfId-483468]Enable Virtual HTTP

  
         		[bookmark: pgfId-483473]Whether to configure a virtual HTTP server. This feature redirects all HTTP connections that require AAA authentication to the virtual HTTP server on the ASA. The ASA prompts for the AAA server username and password. After the AAA server authenticates the user, the ASA redirects the HTTP connection back to the original server, but it does not include the AAA server username and password. Because the username and password are not included in the HTTP packet, the HTTP server prompts the user separately for the HTTP server username and password. For more information, see Understanding How Users Authenticate.

 [bookmark: pgfId-483475]For inbound users (from lower security to higher security), you must also include the virtual HTTP address as a destination interface in the access rule applied to the source interface. Moreover, you must add a static NAT rule for the virtual HTTP IP address, even if NAT is not required. An identity NAT rule is typically used (where you translate the address to itself).

 [bookmark: pgfId-483477]For outbound users, there is an explicit permit for traffic, but if you apply an access rule to an inside interface, be sure to allow access to the virtual HTTP address. A static NAT rule is not required.

 [bookmark: pgfId-483479]To configure a virtual HTTP server:

 [bookmark: pgfId-483481] 1. Select the Enable Virtual HTTP check box.

 [bookmark: pgfId-483483] 2. Enter the IP address or select a Networks/Hosts object representing the virtual HTTP server. Make sure this address is an unused address that is routed to the ASA. For example, if you perform NAT for inside addresses accessing an outside server, and you want to provide outside access to the virtual HTTP server, you can use one of the global NAT addresses for the virtual HTTP server address.

 [bookmark: pgfId-483485] 3. (Optional) If you are using text-based browsers, where redirection does not happen automatically, select the Warning check box. This enables an alert to notify users when the HTTP connection is being redirected.

  
        

 
         
         		[bookmark: pgfId-483491]Enable Virtual Telnet

  
         		[bookmark: pgfId-483493]Whether to configure a virtual Telnet server.

 [bookmark: pgfId-483495]When an unauthenticated user connects to the virtual Telnet IP address, the user is challenged for a username and password, and then authenticated by the AAA server. After the user is authenticated, the message “Authentication Successful” appears. Then the user can successfully access other services that require authentication.

 [bookmark: pgfId-483497]For inbound users (from lower security to higher security), you must also include the virtual Telnet address as a destination interface in the access rule applied to the source interface. In addition, you must add a static NAT rule for the virtual Telnet IP address, even if NAT is not required. An identity NAT rule is typically used (where you translate the address to itself).

 [bookmark: pgfId-483499]For outbound users, there is an explicit permit for traffic, but if you apply an access rule to an inside interface, be sure to allow access to the virtual Telnet address. A static NAT rule is not required.

 [bookmark: pgfId-483501]To configure a virtual Telnet server:

 [bookmark: pgfId-483503] 1. Select the Enable Virtual Telnet check box.

 [bookmark: pgfId-483505] 2. Enter the IP address or select a Networks/Hosts object representing the virtual Telnet server. Make sure this address is an unused address that is routed to the ASA. For example, if you perform NAT for inside addresses accessing an outside server, and you want to provide outside access to the virtual Telnet server, you can use one of the global NAT addresses for the virtual Telnet server address.

  
        

 
         
         		[bookmark: pgfId-483511]Interactive Authentication table (ASA/PIX 7.2.2+)

  
         		[bookmark: pgfId-483513]Use this table to identify the interfaces that should listen for HTTP or HTTPS traffic for authentication. If your AAA rules require authentication for these protocols on interfaces designated in this table, the user is presented with an improved authentication web page as opposed to the default authentication pages used by the appliance. These pages are also used for authenticating direct connections to the device.

 
           
           		 [bookmark: pgfId-483518]To add an interface to the table, click the  Add Row button and fill in the Interactive Authentication Configuration Dialog Box.

 
           		 [bookmark: pgfId-483520]To edit a setting, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-483522]To delete a setting, select it and click the  Delete Row button.

 
          

  
        

 
         
         		[bookmark: pgfId-483528]Disable FTP Authentication Challenge

 [bookmark: pgfId-483530]Disable HTTP Authentication Challenge

 [bookmark: pgfId-483532]Disable HTTPS Authentication Challenge

 [bookmark: pgfId-483534]Disable Telnet Authentication Challenge

 [bookmark: pgfId-483536](All options FWSM 3.x+ only.)

  
         		[bookmark: pgfId-483538]Whether to disable authentication challenges for the indicated protocols. By default, the FWSM prompts the user for a username and password when a AAA rule enforces authentication for traffic in a new session and the protocol of the traffic is FTP, Telnet, HTTP, or HTTPS.

 [bookmark: pgfId-483540]In some cases, you might want to disable the authentication challenge for one or more of these protocols. If you disable challenge authentication for a particular protocol, traffic using that protocol is allowed only if the traffic belongs to a session previously authenticated. This authentication can be accomplished by traffic using a protocol whose authentication challenge remains enabled. For example, if you disable challenge authentication for FTP, the FWSM denies a new session using FTP if the traffic is included in an authentication AAA rule. If the user establishes the session with a protocol whose authentication challenge is enabled (such as HTTP), FTP traffic is allowed.

  
        

 
         
         		[bookmark: pgfId-483546]Clear Connections When Uauth Timer Expires table

 [bookmark: pgfId-483548](FWSM 3.2+ only.)

  
         		[bookmark: pgfId-483550]Use this table to identify the interfaces and source addresses where you want to force any active connections to close immediately after the user authentication times out or when you clear the authentication session with the clear uauth command. (User authentication timeouts are defined in the Platform > Security > Timeouts policy.) For any interface/source address pairs not listed in this table, active connections are not terminated even though the user authentication session expired.

 
           
           		 [bookmark: pgfId-483555]To add any interface and source address pair, click the  Add Row button and fill in the Clear Connection Configuration Dialog Box.

 
           		 [bookmark: pgfId-483557]To edit a setting, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-483559]To delete a setting, select it and click the  Delete Row button.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-485559][bookmark: 42003][bookmark: fwlsvcpg_cncpt_AAAFirewallAdvancedSettingInteractiveAuthConfigurationDialogBox]Interactive Authentication Configuration Dialog Box [bookmark: marker-485557]

 
     [bookmark: pgfId-485564]Use the Interactive Authentication Configuration dialog box to configure an interface to listen for HTTP or HTTPS traffic to authenticate network users. The authentication web page used by a listening port provides an improved user experience compared to the default authentication pages used for these protocols. The authentication pages are used for connections directly to the device and if you select the redirection option, also for through traffic if your AAA rules policy requires HTTP/HTTPS network access authentication. For more information, see Understanding How Users Authenticate.

 
     [bookmark: pgfId-485566]Navigation Path

 
     [bookmark: pgfId-485571]Go to the AAA Firewall Settings Page, Advanced Setting Tab and click the Add Row button beneath the Interactive Authentication table, or select an item in the table and click the Edit Row button.

 
     [bookmark: pgfId-485573]Related Topics

 
      
      		 [bookmark: pgfId-485578]Understanding AAA Rules

 
      		 [bookmark: pgfId-485583]Configuring AAA Rules for ASA, PIX, and FWSM Devices

 
     

 
     [bookmark: pgfId-485585]Field Reference

 
     [bookmark: pgfId-485588] 

 
      
       
        
        [bookmark: pgfId-483572]Table 15-4 [bookmark: 42028]Interactive Authentication Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-483578]Element
          
  
         		
           
           [bookmark: pgfId-483580]Description
          
  
        

 
         
         		[bookmark: pgfId-483586]Protocol

  
         		[bookmark: pgfId-483588]The protocol that you want to listen for, either HTTP or HTTPS. If you want to listen for both protocols on an interface, add the interface to the table twice.

  
        

 
         
         		[bookmark: pgfId-483594]Interface

  
         		[bookmark: pgfId-483596]The interface or interface role on which to enable listeners. Enter the name of the interface or interface role, or click Select to select it from a list or to create a new interface role.

  
        

 
         
         		[bookmark: pgfId-483602]Port

  
         		[bookmark: pgfId-483604]The port number that the security appliance listens on for this protocol if other than the default, which is 80 (HTTP) and 443 (HTTPS).

  
        

 
         
         		[bookmark: pgfId-483610]Redirect network users for authentication request

  
         		[bookmark: pgfId-483612]Whether to redirect users who are making requests through the device to the authentication web page served by the security appliance. If you do not select this option, only traffic directed to the interface is prompted with the improved authentication web page.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-485598][bookmark: 42060][bookmark: fwlsvcpg_cncpt_AAAFirewallAdvancedSettingClearConnectionConfigurationDialogBox]Clear Connection Configuration Dialog Box [bookmark: marker-485596]

 
     [bookmark: pgfId-485600]Use the Clear Connection Configuration dialog box to identify the source addresses whose active connections to close immediately after the user authentication times out or when you clear the authentication session with the clear uauth command. You must specify the interfaces on which those sessions should be cleared. These settings are used only for FWSM 3.2+ devices.

 
     [bookmark: pgfId-485602]User authentication timeouts are defined in the Platform > Security > Timeouts policy.

 
     [bookmark: pgfId-485604]Navigation Path

 
     [bookmark: pgfId-485609]Go to the AAA Firewall Settings Page, Advanced Setting Tab and click the Add Row button beneath the Clear Connections When Uauth Timer Expires table, or select an item in the table and click the Edit Row button.

 
     [bookmark: pgfId-485611]Field Reference

 
     [bookmark: pgfId-485614] 

 
      
       
        
        [bookmark: pgfId-483625]Table 15-5 [bookmark: 42078]Clear Connection Configuration Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-483631]Element
          
  
         		
           
           [bookmark: pgfId-483633]Description
          
  
        

 
         
         		[bookmark: pgfId-483639]Interface

  
         		[bookmark: pgfId-483641]The interfaces or interface roles for which you are configuring settings. Enter the name or click Select to select the interface or interface role or to create a new role. Separate multiple entries with commas.

  
        

 
         
         		[bookmark: pgfId-483647]Source IP Address/Netmask

  
         		[bookmark: pgfId-483652]The host or network addresses for which you want to clear connections immediately when the user authentication timer expires. The list can include host IP addresses, network addresses, address ranges, or network/host objects Separate multiple addresses with commas. For more information on entering addresses, see Specifying IP Addresses During Policy Definition.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-485630][bookmark: 42102][bookmark: fwlsvcpg_cncpt_AAAFirewallMACExemptListPage]AAA Firewall Page, MAC-Exempt List Tab [bookmark: marker-485622][bookmark: marker-485624][bookmark: marker-485626][bookmark: marker-485628]

 
     [bookmark: pgfId-485632]Use the MAC Exempt List tab of the AAA Firewall settings policy to identify hosts that should be exempt from authentication and authorization for ASA, PIX, and FWSM 3.x+ devices. For example, if the security appliance authenticates TCP traffic originating on a particular network but you want to allow unauthenticated TCP connections from a specific server, create a rule permitting traffic from the MAC address of the server.

 
     [bookmark: pgfId-485634]You can use masks to create rules for groups of MAC addresses. For example, if you want to exempt all Cisco IP phones whose MAC addresses start with 0003.e3, create a permit rule for 0003.e300.0000 with the mask ffff.ff00.0000. (An f in a mask exactly matches the corresponding number in the address, whereas a 0 matches anything.)

 
     [bookmark: pgfId-485636]Deny rules are necessary only if you are permitting a group of MAC addresses but there are some addresses within the permitted group that you want to require to use authentication and authorization. Deny rules do not prohibit traffic; they simply require the host to go through normal authentication and authorization. For example, if you want to allow all hosts with MAC addresses that start with 00a0.c95d, but you want to force 00a0.c95d.0282 to use authentication and authorization, enter these rules in order:

 
     [bookmark: pgfId-485638] 1. Deny 00a0.c95d.0282 ffff.ffff.ffff

 
     [bookmark: pgfId-485640] 2. Permit 00a0.c95d.0000 ffff.ffff.0000

 
     [bookmark: pgfId-485642]When you deploy the policy to the device, these entries are configured using the mac-list and aaa mac-exempt commands.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-485644]Tip The MAC exempt list is processed on a first match basis. Thus, the order of entries matters. If you want to permit a group of MAC addresses, but deny a subset of them, the deny rule must come before the permit rule. However, Security Manager does not allow you to order MAC exempt rules: they are implemented in the order shown. If you sort the table, your policy changes. If your entries do not depend on each other, this does not matter. Otherwise, ensure that you enter rows in the proper order.


     
      

     

     

 
     [bookmark: pgfId-485646]Navigation Path

 
     [bookmark: pgfId-485648]To access the MAC Exempt List tab, do one of the following:

 
      
      		 [bookmark: pgfId-485650](Device view) Select an ASA, PIX, or FWSM device, then select  Firewall > Settings > AAA Firewall . Select the  MAC-Exempt List tab.

 
      		 [bookmark: pgfId-485652](Policy view) Select  Firewall > Settings > AAA Firewall from the Policy Type selector. Create a new policy or select an existing one, then select the  MAC-Exempt List tab.

 
      		 [bookmark: pgfId-485654](Map view) Right-click an ASA, PIX, or FWSM device and select  Edit Firewall Settings > AAA Firewall , then select the  MAC-Exempt List tab.

 
     

 
     [bookmark: pgfId-485656]Related Topics

 
      
      		 [bookmark: pgfId-485661]Configuring AAA Rules for ASA, PIX, and FWSM Devices

 
      		 [bookmark: pgfId-485666]Filtering Tables

 
     

 
     [bookmark: pgfId-485668]Field Reference

 
     [bookmark: pgfId-485671] 

 
      
       
        
        [bookmark: pgfId-483665]Table 15-6 [bookmark: 42158]MAC-Exempt List Tab, AAA Firewall Settings Page 

 
        
       
         
         		
           
           [bookmark: pgfId-483671]Element
          
  
         		
           
           [bookmark: pgfId-483673]Description
          
  
        

 
         
         		[bookmark: pgfId-483679]MAC-Exempt List Name

  
         		[bookmark: pgfId-483681]The name of the MAC exempt list.

  
        

 
         
         		[bookmark: pgfId-483687]MAC Exempt List table

  
         		[bookmark: pgfId-483689]The MAC exempt rules that you want to implement. The table shows the MAC addresses and masks (in hexadecimal) and whether you are permitting them (exempting them from authentication and authorization) or denying them (making them go through standard authentication and authorization). The device processes the entries in order and uses the first match (not the best match).

 
           
           		 [bookmark: pgfId-483694]To add an exemption rule, click the  Add Row button and fill in the Firewall AAA MAC Exempt Setting Dialog Box.

 
           		 [bookmark: pgfId-483696]To edit an exemption rule, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-483698]To delete an exemption rule, select it and click the  Delete Row button.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-485683][bookmark: 42189][bookmark: fwlsvcpg_cncpt_AAAFirewallMACExemptListFirewallAAAMACExemptSettingDialogBox]Firewall AAA MAC Exempt Setting Dialog Box[bookmark: marker-485679][bookmark: marker-485681]

 
     [bookmark: pgfId-485685]Use the Firewall AAA MAC Exempt Setting dialog box to add and edit exemption entries in the MAC Exempt List table. The security appliance skips authentication and authorization for hosts associated with permitted MAC addresses.

 
     [bookmark: pgfId-485687]Navigation Path

 
     [bookmark: pgfId-485692]Go to the AAA Firewall Page, MAC-Exempt List Tab and click the Add Row button beneath the MAC Exempt List table, or select an item in the table and click the Edit Row button.

 
     [bookmark: pgfId-485694]Field Reference

 
     [bookmark: pgfId-485697] 

 
      
       
        
        [bookmark: pgfId-483711]Table 15-7 [bookmark: 42207]Firewall AAA MAC Exempt Setting Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-483717]Element
          
  
         		
           
           [bookmark: pgfId-483719]Description
          
  
        

 
         
         		[bookmark: pgfId-483725]Action

  
         		[bookmark: pgfId-483727]The action you want to take for the hosts that use the specified MAC addresses:

 
           
           		 [bookmark: pgfId-483729]Permit—Exempts the host from authentication and authorization.

 
           		 [bookmark: pgfId-483731]Deny—Forces the host to go through authentication and authorization.

 
          

  
        

 
         
         		[bookmark: pgfId-483737]MAC Address

  
         		[bookmark: pgfId-483739]The MAC address of the hosts in standard 12-digit hexadecimal format, such as 00a0.cp5d.0282. You can enter complete MAC addresses or partial addresses.

 [bookmark: pgfId-483741]For partial addresses, you can enter 0 for digits you are not matching.

  
        

 
         
         		[bookmark: pgfId-483747]MAC Mask

  
         		[bookmark: pgfId-483749]The mask to apply to the MAC address. Use f to match a digit exactly, 0 to match any digit at that place:

 
           
           		 [bookmark: pgfId-483751]To specify an exact match of the address, enter ffff.ffff.ffff.

 
           		 [bookmark: pgfId-483753]To match an address pattern, enter 0 for any digit for which you want to match any character. For example, ffff.ffff.0000 matches all addresses that have the same first 8 digits.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-485711][bookmark: 42245][bookmark: fwlsvcpg_cncpt_AuthProxyPage]AAA Page[bookmark: marker-485707][bookmark: marker-485709]

 
     [bookmark: pgfId-485713]Use the AAA firewall settings policy to identify the servers and banners to use for the authentication proxy and to configure non-default timeout values. The authentication proxy for IOS devices is a service that forces users to log in and authenticate when trying to make HTTP, Telnet, or FTP connections through an IOS device. The settings you configure here work in conjunction with your AAA rules; only if a AAA rule requires user authentication for one of these services does your AuthProxy settings come into play.

 
     [bookmark: pgfId-485715]Ensure that your configuration of this policy is consistent with your Firewall > AAA Rules policy. Additionally, you must use the Platform > Device Admin > AAA policy to define the AAA server groups to use for authenticating user access; this policy defines only the authorization and accounting server groups. If you also want to use authorization proxy for HTTPS access, you must enable SSL and configure AAA in the Platform > Device Admin > Device Access > HTTP policy in addition to enabling HTTP authorization proxy in your AAA rules policy.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-485719]Tip You must configure per-user ACLs in your AAA server to define the privileges you want to apply to each user. When configuring authorization, specify AAA as the service (e.g. service = AAA), with a privilege level of 15. For more information on configuring the AAA server, including information on configuring authentication proxy in general, see the “Configuring the Authentication Proxy” section in the Cisco IOS Security Configuration Guide: Securing User Services, Release 12.4T at http://www.cisco.com/en/US/docs/ios/sec_user_services/configuration/guide/sec_cfg_authen_prxy_ps6441_TSD_Products_Configuration_Guide_Chapter.html.


     
      

     

     

 
     [bookmark: pgfId-485721]Navigation Path

 
     [bookmark: pgfId-485723]To access the AAA page, do one of the following:

 
      
      		 [bookmark: pgfId-485725](Device view) Select a device, then select  Firewall > Settings > AAA from the Policy selector.

 
      		 [bookmark: pgfId-485727](Policy view) Select  Firewall > Settings > AAA from the Policy Type selector. Create a new policy or select an existing one.

 
      		 [bookmark: pgfId-485729](Map view) Right-click a device and select  Edit Firewall Settings > AAA .

 
     

 
     [bookmark: pgfId-485731]Related Topics

 
      
      		 [bookmark: pgfId-485736]Understanding AAA Rules

 
      		 [bookmark: pgfId-485741]Understanding How Users Authenticate

 
      		 [bookmark: pgfId-485746]Configuring AAA Rules for IOS Devices

 
     

 
     [bookmark: pgfId-485748]Field Reference

 
     [bookmark: pgfId-485751] 

 
      
       
        
        [bookmark: pgfId-483766]Table 15-8 [bookmark: 42291]AAA Firewall Settings Policy 

 
        
       
         
         		
           
           [bookmark: pgfId-483772]Element
          
  
         		
           
           [bookmark: pgfId-483774]Description
          
  
        

 
         
         		[bookmark: pgfId-483780]Virtual IP Address

  
         		[bookmark: pgfId-483782]You use the Virtual IP Address only in communications between the IOS HTTP authentication and clients. For the system to operate correctly, the virtual IP address must be set (it cannot be 0.0.0.0), and no other device on the network can have the same address. Configure with an unassigned and unused gateway IP address, such as 1.1.1.1.

  
        

 
         
         		 
           
           [bookmark: pgfId-483788]General Tab
          
  
        

 
         
         		[bookmark: pgfId-483796]Authorization Server Groups

  
         		[bookmark: pgfId-483798]The AAA server group policy objects that identify the LDAP, TACACS+, or RADIUS servers that will provide per-user authorization control. You can also use the LOCAL user database defined on the device.

 [bookmark: pgfId-483800]Enter the names of the server group objects, or click Select to select them from a list or to create new objects. Ensure that you put the groups in priority order; authorization is attempted with the first group and if that group is not available, with subsequent groups.

  
        

 
         
         		[bookmark: pgfId-483806]Accounting Server Groups

 [bookmark: pgfId-483808]Use Broadcast for Accounting

  
         		[bookmark: pgfId-483810]The AAA server group policy objects that identify the LDAP, TACACS+, or RADIUS servers that will provide accounting services. Accounting collects per-user usage information for billing, security, or resource allocation purposes. Enter the names of the server group objects, or click Select to select them from a list or to create new objects.

 [bookmark: pgfId-483812]Ensure that you put the groups in priority order; if you do not select the broadcast option, accounting is attempted with the first group and if that group is not available, with subsequent groups.

 [bookmark: pgfId-483814]If you select Use Broadcast for Accounting, accounting records are sent simultaneously to the first server in each group. If the first server is unavailable, failover occurs using the backup servers defined within that group.

  
        

 
         
         		[bookmark: pgfId-483820]Accounting Notice

  
         		[bookmark: pgfId-483822]The types of accounting notices to be sent to the accounting server groups:

 
           
           		 [bookmark: pgfId-483824]Start-stop—Sends a start accounting notice at the beginning of a user process and a stop accounting notice at the end of the process. The start accounting record is sent in the background. The requested user process begins regardless of whether the start accounting notice was received by the accounting server.

 
           		 [bookmark: pgfId-483826]Stop-only—Sends a stop accounting notice at the end of the requested user process.

 
           		 [bookmark: pgfId-483828]None—No accounting records are sent.

 
          

  
        

 
         
         		[bookmark: pgfId-483834]HTTP Banner

 [bookmark: pgfId-483836]FTP Banner

 [bookmark: pgfId-483838]Telnet Banner

  
         		[bookmark: pgfId-483840]The banner you want to present on the authentication proxy page to the user when the user is prompted to authenticate for the specified service:

 
           
           		 [bookmark: pgfId-483842]Disable Banner Text—No banner is displayed.

 
           		 [bookmark: pgfId-483844]Use Default Banner Text—Displays the default banner “Cisco Systems,  router hostname Authentication.”

 
           		 [bookmark: pgfId-483846]Use Custom Banner Text—Enter the text you want to present to the user.

 
          

  
        

 
         
         		[bookmark: pgfId-483852]Use HTTP banner from File

 [bookmark: pgfId-483854]URL

  
         		[bookmark: pgfId-483856]Whether you want to use your own web page to authenticate HTTP connections. Enter the URL for your HTTP banner.

 [bookmark: pgfId-483858]If you configure both HTTP banner text and a URL, the URL banner take precedence; however, the banner text is also configured on the device.

  
        

 
         
         		 
           
           [bookmark: pgfId-483864]Advanced Tab
          
  
        

 
         
         		[bookmark: pgfId-483872]Global Inactivity Time

  
         		[bookmark: pgfId-483874]The length of time, in minutes, that the authentication proxy for a user is maintained when there is no user activity in the session. If this timer expires, the user session is cleared along with its dynamic user access control list (ACL), and the user must re-authenticate. The range is 1 to 2,147,483,647. The default is 60 minutes.

 [bookmark: pgfId-483876]Ensure that this timeout value is greater than or equal to the idle timeout values configured in the Firewall > Settings > Inspection policy; otherwise, timed-out user sessions might continue to be monitored and eventually hang.

  
        

 
         
         		[bookmark: pgfId-483882]Global Absolute Time

  
         		[bookmark: pgfId-483884]The length of time, in minutes, that an authentication proxy user session can remain active. After this timer expires, the user session must go through the entire process of establishing its connection as if it were a new request. The range is 0 to 35,791. The default is 0, which means that there is no global absolute timeout; user sessions are maintained as long as they are active.

  
        

 
         
         		[bookmark: pgfId-483890]Interface Timeout Table

  
         		[bookmark: pgfId-483892]This table contains the interfaces for which you want to configure timeout values that differ from the global timeout values. If you want to use the global values for all interfaces, you do not need to configure anything in this table.

 
           
           		 [bookmark: pgfId-483897]To add an interface with customized timeout values, click the  Add Row button and fill in the Firewall AAA IOS Timeout Value Setting.

 
           		 [bookmark: pgfId-483899]To edit a setting, select it and click the  Edit Row button.

 
           		 [bookmark: pgfId-483901]To delete a setting, select it and click the  Delete Row button.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-485765][bookmark: 42395][bookmark: fwlsvcpg_cncpt_FirewallAAAIOSTimeoutValueSettingDialogBox]Firewall AAA IOS Timeout Value Setting[bookmark: marker-485759][bookmark: marker-485761][bookmark: marker-485763]

 
     [bookmark: pgfId-485767]Use the Firewall AAA IOS Timeout Value Setting dialog box to configure idle and absolute timeout values for specific interfaces. These values override the global timeout values configured on the Firewall > Settings > ScanSafe Web Security policy Server Timeout tab.

 
     [bookmark: pgfId-485769]Navigation Path

 
     [bookmark: pgfId-485774]From the Advanced tab of the AAA Page, click the Add Row button beneath the table of interfaces, or select a row and click the Edit Row button.

 
     [bookmark: pgfId-485776]Field Reference

 
     [bookmark: pgfId-485779] 

 
      
       
        
        [bookmark: pgfId-483914]Table 15-9 [bookmark: 42417]Firewall AAA IOS Timeout Value Setting Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-483920]Element
          
  
         		
           
           [bookmark: pgfId-483922]Description
          
  
        

 
         
         		[bookmark: pgfId-483928]Interfaces

  
         		[bookmark: pgfId-483930]The interfaces or interface roles for which you are configuring timeout values. Enter the names of the interfaces or roles, or click Select to select them from a list or to create new interface roles. Separate multiple entries with commas.

  
        

 
         
         		 
           
           [bookmark: pgfId-483936]Auth Proxy Tab
          
  
        

 
         
         		[bookmark: pgfId-483944]Inactivity/Cache Time

  
         		[bookmark: pgfId-483946]The length of time, in minutes, that the authentication proxy for a user is maintained when there is no user activity in the session on the interface. If this timer expires, the user session is cleared along with its dynamic user access control list (ACL), and the user must re-authenticate. The range is 1 to 2,147,483,647. The default is the global inactivity timeout value (whose default is 60 minutes).

  
        

 
         
         		[bookmark: pgfId-483952]Absolute Time

  
         		[bookmark: pgfId-483954]The length of time, in minutes, that an authentication proxy user session can remain active on the interface. After this timer expires, the user session must go through the entire process of establishing its connection as if it were a new request. The range is 1 to 35,791. The default is 0, which means that there is no absolute timeout; user sessions are maintained as long as they are active.

  
        

 
         
         		[bookmark: pgfId-483960]Authentication Proxy Method (IOS)

  
         		[bookmark: pgfId-483962]The protocols to which these timeout values should apply. You can select any combination of HTTP, FTP, or Telnet.

  
        

 
         
         		
           
           [bookmark: pgfId-483968]HTTP/NTLM Tab
          
  
         		[bookmark: pgfId-483970]The HTTP and the NTLM areas contain the same following fields and selections:

 [bookmark: pgfId-483972]Set the Inactivity/Cache Time and the Absolute Time for HTTP/NTLM and then, if desired, select Enable Passive Authentication. Finally, select the Identity Policy that you want to apply.

  
        

 
         
         		
           
           [bookmark: pgfId-483978]Method Order Tab
          
  
         		[bookmark: pgfId-483980]Select the checkbox of each method you want to employ and then use the up and down arrows to arrange the methods in the order you desire.

  
        

 
         
         		
           
           [bookmark: pgfId-483986]AAA Settings Tab
          
  
         		[bookmark: pgfId-483988]Select the AAA Settings tab to specify the Authentication, Authorization, and Account settings as detailed below.

  
        

 
         
         		
           
           [bookmark: pgfId-483994]Authenticate Using
          
  
         		[bookmark: pgfId-483996]In the Authenticate Using section you can select the server group(s) to use for authentication. Choices are:

 
           
           		 [bookmark: pgfId-483998] None —No authentication

 
           		 [bookmark: pgfId-484000] Default —Use the default authentication server group(s).

 
           		 [bookmark: pgfId-484002] Custom —Enable the selection of user specified authentication server group(s). Then click  Select to specify or add a server group.

 
          

  
        

 
         
         		
           
           [bookmark: pgfId-484008]Authorize Exec Operation Using
          
  
         		[bookmark: pgfId-484010]In the Authorize Exec Operation Using section you can select the server group(s) to use for authorization of executive operations. Choices are:

 
           
           		 [bookmark: pgfId-484012] None —No authorization

 
           		 [bookmark: pgfId-484014] Default —Use the default authorization server group(s)

 
           		 [bookmark: pgfId-484016] Custom —Enable the selection of user specified authorization server group(s). Then click  Select to specify or add a server group.

 
          

  
        

 
         
         		
           
           [bookmark: pgfId-484022]Perform Exec Operation Using
          
  
         		[bookmark: pgfId-484024]In the Authorize Exec Operation Using section you can select the server group(s) to use for performing executive operations. Choices are:

 
           
           		 [bookmark: pgfId-484026] None —No authorization

 
           		 [bookmark: pgfId-484028] Default —Use the default server group(s)

 
           		 [bookmark: pgfId-484030] Custom —Enable the selection of user specified server group(s). Then click  Select to specify or add a server group.

 
          

  
        

 
         
         		
           
           [bookmark: pgfId-484036]Accounting Notice
          
  
         		[bookmark: pgfId-484038]Use Accounting Notice to specify accounting operations.

 
           
           		 [bookmark: pgfId-484040] None —No accounting notices

 
           		 [bookmark: pgfId-484042] Start-stop —Accounting notices at the beginning and end of operations

 
           		 [bookmark: pgfId-484044] Stop-only —Accounting notices at the end of operations.

 
          

  
        

 
         
         		
           
           [bookmark: pgfId-484050]Accounting Server Groups
          
  
         		[bookmark: pgfId-484052]Specify what accounting server groups to use. Either enter or select the Accounting Server group.

 [bookmark: pgfId-484054]Note If you choose to select an accounting server group, you are also give the option to add an Accounting Server group.

  
        

 
         
         		
           
           [bookmark: pgfId-484060]Use Broadcast for Accounting
          
  
         		[bookmark: pgfId-484062]Select this checkbox to broadcast accounting notices.
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     [bookmark: pgfId-833751][bookmark: 162638][bookmark: HPMchap_intro_HPM]Health and Performance Monitoring[bookmark: marker-833747][bookmark: marker-833749]
      
      
 
     
 

 
    [bookmark: pgfId-833753]The Health and Performance Monitor (HPM) application lets you monitor key health and performance data for ASA devices, IPS devices, and VPN services by providing network-level visibility into device status and traffic information.

 
    [bookmark: pgfId-833755]A variety of views are provided—All Devices, Firewall Devices, IPS Devices, VPN Summary, and so on—and you can create your own customized views. A configurable listing of device alerts is also available.

 
    [bookmark: pgfId-833757]This ability to monitor key network and device metrics lets you quickly detect and resolve device malfunctions and bottlenecks in the network.

 
    [bookmark: pgfId-833759]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-833764]Health and Performance Monitor Overview

 
     		 [bookmark: pgfId-833769]HPM Access Control

 
     		 [bookmark: pgfId-833774]Preparing for Health and Performance Monitoring

 
     		 [bookmark: pgfId-833779]Launching the Health and Performance Monitor

 
     		 [bookmark: pgfId-833784]Managing Monitored Devices

 
     		 [bookmark: pgfId-833789]HPM Window

 
     		 [bookmark: pgfId-833794]Monitoring Devices

 
     		 [bookmark: pgfId-833799]Alerts and Notifications

 
     		 [bookmark: pgfId-833804]SNMP Trap Forwarding Notification

 
    

 
   
 
    
     [bookmark: pgfId-833816][bookmark: 162650][bookmark: HPMchap_intro_Overview]Health and Performance Monitor Overview [bookmark: marker-833812][bookmark: marker-833814]

 
    [bookmark: pgfId-833818]The Health and Performance Monitor is a stand-alone application that you can launch from the other stand-alone Security Manager applications (Dashboard, Configuration Manager, Event Viewer, Report Manager, and Image Manager) or from the Cisco Security Manager Client login screen accessed from the Windows Start menu.

 
    [bookmark: pgfId-833820]The HPM application complements the Event Viewer and Report Manager applications, as follows:

 
     
     		 [bookmark: pgfId-833825] Event Viewer – Monitors your network for syslog (system log) events from ASA and FWSM devices and their security contexts, and for SDEE (Secure Device Event Exchange) events from IPS devices and virtual sensors. These events include firewall traffic information, NAT events, failover events, IPS alerts, and so on. Event Viewer collects and displays this information, organized into a variety of views. See Chapter 68, “Viewing Events” for more information.

 
     		 [bookmark: pgfId-833830] Report Manager – Collects, displays and exports network usage and security information for ASA and IPS devices, and for remote-access IPsec and SSL VPNs. These reports aggregate security data such as top sources, destinations, attackers, victims, as well as security information such as top bandwidth, duration, and throughput users. Data is also aggregated for hourly, daily, and monthly periods. See Chapter 69, “Managing Reports” for more information.

 
     		 [bookmark: pgfId-833832] Health and Performance Monitor (HPM) – Monitors and displays key health, performance and VPN data for ASA and IPS devices in your network. This information includes critical and non-critical issues, such as memory usage, interface status, dropped packets, tunnel status, and so on. You also can categorize devices for normal or priority monitoring, and set different alert rules for the priority devices.

 
    

 
    [bookmark: pgfId-833837]You can add notes to displayed alerts, you can “acknowledge” them, and you can clear them. When an alert is cleared, it is removed from the Alerts display; however, the alert information is retained in a database for 30 days. See Alerts: Acknowledging and Clearing for more information about adding notes, and acknowledging and clearing alerts.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-833842]Note You can use the Alerts History window to access and view previously cleared alerts, as described in Alerts: History.


    
     

    

    

 
    [bookmark: pgfId-833844]This section contains the following topics:

 
     
     		 [bookmark: pgfId-833849]Trend Information

 
     		 [bookmark: pgfId-833854]Monitoring Multiple Contexts

 
    

 
     
      [bookmark: pgfId-833862][bookmark: 162677][bookmark: HPMchap_cncpt_Trending]Trend Information [bookmark: marker-833860]

 
     [bookmark: pgfId-833864]The Health and Performance Monitor periodically polls monitored devices for status and performance data. This information is used for alert generation, and to display real-time views and historical trends based on aggregated data.

 
     [bookmark: pgfId-833866]Trends are displayed graphically for a specific set of metrics. Each trend for the currently selected device is represented as a graph generated for a chosen time interval. Comparing current values with the weekly averages for CPU and memory usage, for example, can provide an operational context for the selected device. Available trend intervals for monitored devices are one hour, 24 hours, and one week.

 
     [bookmark: pgfId-833868]Metrics used for generating trends include:

 
      
      		 [bookmark: pgfId-833870]CPU usage

 
      		 [bookmark: pgfId-833872]Memory usage (only for single-context devices)

 
      		 [bookmark: pgfId-833874]Connections per second (firewall devices)

 
      		 [bookmark: pgfId-833876]Translations per second (firewall devices)

 
      		 [bookmark: pgfId-833878]Inspection load (IPS devices)

 
      		 [bookmark: pgfId-833880]Missed packets as a percentage (IPS devices)

 
      		 [bookmark: pgfId-833882]Number of VPN tunnels

 
      		 [bookmark: pgfId-833884]Number of RA VPN sessions

 
      		 [bookmark: pgfId-833886]Total VPN throughput

 
      		 [bookmark: pgfId-833888]Firewall throughput

 
      		 [bookmark: pgfId-833890]Total dropped packets (firewall interfaces)

 
     

 
     [bookmark: pgfId-833899][bookmark: marker-833892][bookmark: marker-833894]For additional graphical information about the health and performance of a specific device, you can launch the related device manager by right-clicking the entry for a device, a cluster node, or the system context for a multi-context device, and then choosing Device Manager from the pop-up menu. See Starting Device Managers for more information about the device managers.

 
    
 
     
      [bookmark: pgfId-833907][bookmark: 162722][bookmark: HPMchap_cncpt_MultiContextMonitoring]Monitoring Multiple Contexts [bookmark: marker-833905]

 
     [bookmark: pgfId-833909]The Health and Performance Monitor can monitor single- and multiple-context ASA devices. For multiple-context devices, each context is monitored and displayed as if it was a separate device.

 
     [bookmark: pgfId-833911]Each context will be polled separately for all applicable metrics, with HPM polling a maximum of five contexts at a time from any given device. For devices with more than five contexts, data will be acquired from each successive batch of five contexts, with each batch being polled progressively during successive polling cycles. This means that all contexts may not be updated at the same time.

 
     [bookmark: pgfId-833913]For multiple-context devices, basic device health—memory usage, device status, and so on—is monitored only on the physical device (that is, from the system context), while traffic data—number of connections, number of translations, dropped packets and so on—are monitored at context level.

 
     [bookmark: pgfId-833915]For virtual contexts, CPU usage data are used only for pattern analysis, not for alert generation. Only interface-status alerts will be generated for virtual contexts.

 
    
 
   
 
    
     [bookmark: pgfId-833927][bookmark: 162735][bookmark: HPMchap_cncpt_AccessControl]HPM Access Control[bookmark: marker-833921][bookmark: marker-833923][bookmark: marker-833925]

 
    [bookmark: pgfId-833929]The privileges assigned to your user name control what you can do in Health and Performance Monitor. If you use local users, or other types of non-ACS access control, then all users have access to HPM. However, the following access limits are imposed:

 
     
     		 [bookmark: pgfId-833934]You must have system administrator privileges to enable or disable Health and Performance Monitoring in Security Manager, as described in Health and Performance Monitor Page.

 
     		 [bookmark: pgfId-833939]You must have system administrator, network administrator, or approver privileges to select or deselect devices for monitoring, as described in Managing Monitored Devices.

 
     		 [bookmark: pgfId-833944]You also must have system administrator, network administrator, or approver privileges to configure alerts and notifications, as described in Alerts: Configuring.

 
    

 
    [bookmark: pgfId-833946]If you use ACS to control access to Security Manager, you can also control the following:

 
     
     		 [bookmark: pgfId-833948]You can control access to the Health and Performance Monitor application using the View > Health and Performance Monitor privilege (part of Role Management in ACS). Using this privilege, you could prevent certain users from accessing HPM, or create roles that allow access to HPM without allowing access to Event Viewer or Report Manager. All default ACS roles are permitted to use the Health and Performance Monitor application.

 
     		 [bookmark: pgfId-833959]Use the Modify > Policies > HPM Monitoring privilege to control which users can select and deselect the devices that are monitored (see Managing Monitored Devices), configure alerts and notifications (see Alerts: Configuring), and annotate and acknowledge alerts (see Alerts: Acknowledging and Clearing). All default ACS roles except Help Desk and Super Admin have this permission.

 
     		 [bookmark: pgfId-833961]Users can view health and performance information for a device only if they have at least View privileges for the device.

 
     		 [bookmark: pgfId-833966]You can control access to the Health and Performance Monitoring administrative settings page (in Security Manager’s Configuration Manager) where HPM is enabled or disabled, as described in Health and Performance Monitor Page. The user must have the Modify > Policies > HPM Admin privilege to access this page (or any other administrative settings page). All default ACS roles except Help Desk can view the page, but only System Administrators can change the setting.

 
    

 
    [bookmark: pgfId-833970]For information on integrating Security Manager with Cisco Secure ACS, see the Installation Guide for Cisco Security Manager.

 
   
 
    
     [bookmark: pgfId-833978][bookmark: 162775][bookmark: HPMchap_cncpt_ConfiguringHPM]Preparing for Health and Performance Monitoring [bookmark: marker-833976]

 
    [bookmark: pgfId-833980]In order to use the Health and Performance Monitor (HPM), you must configure Security Manager, enable the HPM application, and configure device monitoring, as follows:

 
     
     		 [bookmark: pgfId-833982]Basic Threat Detection must be enabled on ASA 8.0+ devices in order to monitor metrics such as ACL Dropped Packets, Scanning Threat Dropped Packets, Inspection Dropped Packets, and Syn Attack Dropped Packets. (Basic Threat Detection is enabled by default on these ASA devices.)

 
     		 [bookmark: pgfId-833989]To receive alert notifications via email, you must have configured the SMTP server and administrator email ID on the  System Preferences page of the Security Manager server. See the  Installation Guide for Cisco Security Manager for more information. (Specifying email addresses for alert notifications from the Health and Performance Monitor application is described in Alerts: Configuring.)

 
     		 [bookmark: pgfId-833994]Health and Performance Monitoring must be enabled in Security Manager, as described in Health and Performance Monitor Page.

 
     		 [bookmark: pgfId-833999]In HPM, specify the devices to be monitored, in both Normal and Priority modes, as described in Managing Monitored Devices.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-834006]Note [bookmark: marker-834001]To prevent read time-outs for ASAs, those devices must be configured to use only certain SSL/TLS protocol versions when acting as a server, as described in Setting Up SSL (HTTPS) on PIX Firewall, ASA and FWSM Devices.


    
     

    

    

 
     
     		 [bookmark: pgfId-834011]Enable and configure the device threshold values and state-change rules that define when alerts and email notifications are triggered. This process is described in Alerts: Configuring.
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    [bookmark: pgfId-834016]Note We also recommend configuring monitored devices to use a Network Time Protocol (NTP) server for synchronized timing. See NTP Page for more information.


    
     

    

    

 
    [bookmark: pgfId-834018]After you have completed these steps, HPM begins polling the specified devices and displays health information and alerts.

 
   
 
    
     [bookmark: pgfId-834026][bookmark: 162808][bookmark: HPMchap_cncpt_Launching]Launching the Health and Performance Monitor [bookmark: marker-834024]

 
    [bookmark: pgfId-834031]Use the Health and Performance Monitor (HPM) to view status information and alerts collected from monitored firewall and IPS devices across your network. For more information about selecting devices for monitoring, see Managing Monitored Devices.

 
    [bookmark: pgfId-834033]To launch HPM, do any one of the following:

 
     
     		 [bookmark: pgfId-834035]Choose  All Programs >  Cisco Security Manager Client >  Cisco Security Manager Client from the Windows Start menu (your command path may differ slightly), and then select  Health and Performance Monitor as the Default View during login.

 
     		 [bookmark: pgfId-834037]Choose  Launch >  Health and Performance Monitor from the Configuration Manager, Event Viewer, Image Manager, or Report Manager applications.

 
     		 [bookmark: pgfId-834039]Click the Health and Performance Monitor button on the quick-launch toolbar in the Configuration Manager or Image Manager window.

 
    

 
    [bookmark: pgfId-834047]If you are currently not logged into a Security Manager application, you are prompted to log in. (For more information about starting and logging into a Security Manager client application, see Logging In to and Exiting the Security Manager Client). Otherwise, the HPM Window is opened using the same user account you used to log into the other application.
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    [bookmark: pgfId-834049]Note As described above, you can “cross-launch” HPM from any of the other Security Manager client applications. You can similarly cross-launch any of the other client applications from Health and Performance Monitor by choosing the desired application from the Launch menu, or clicking the appropriate quick-launch button.


    
     

    

    

 
   
 
    
     [bookmark: pgfId-834059][bookmark: 162836][bookmark: HPMchap_proc_ManageMonitoredDevices]Managing Monitored Devices [bookmark: marker-834057]

 
    [bookmark: pgfId-834061]The HPM device selector is used to add and remove devices from both the “normal” and “priority” monitoring lists. You can also use the device selector to transfer devices between the two lists.
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    [bookmark: pgfId-834063]Note After enabling a device for monitoring in HPM, it can take up to 5 minutes for priority devices and 10 minutes for non-priority devices before actual values for HPM parameters can be seen in the device summary.


    
     

    

    

 
    [bookmark: pgfId-834065]To use the HPM device selector:

 
    
 
    [bookmark: pgfId-834067]Step 1 Choose Device Selector from the Tools menu to open the device selector window; the device-management screen is displayed.

 
    [bookmark: pgfId-834069]The All Devices section on the left lists all ASA and IPS devices in the Security Manager inventory that can be monitored. (For example. HPM supports monitoring of version 7.0.1 and later IPS sensors only. Earlier IPS versions are not displayed in the device selector.)

 
    [bookmark: pgfId-834071]All devices currently assigned to the Normal monitoring list and the Priority monitoring list are displayed in the two sections on the right side of the window.

 
    [bookmark: pgfId-834073]Step 2 To add a device to the Normal list, select the device in the All Devices list and then click the > button between the All Devices list and the Normal Monitored Devices list.

 
    [bookmark: pgfId-834075]The procedure for moving a device to the Priority Monitored Devices list is the same: use the > button between the All Devices list and that list.

 
    [bookmark: pgfId-834077]Step 3 To remove a device from either Monitored list, returning it to the All Devices list, select the device and then click the appropriate < button.

 
    [bookmark: pgfId-834079]Step 4 To transfer a device from one Monitored list to the other, highlight that entry and click the Up or Down button to move it to the upper or lower list respectively.

 
    [bookmark: pgfId-834081]Step 5 Click Next at the bottom of the window to display the VPN-selector screen.

 
    [bookmark: pgfId-834083]All monitored devices and their individual contexts, if any, are listed; each entry includes a checkbox for remote-access (RA) and one for site-to-site (S2S) VPN selection. (Remote-access VPNs are not supported in multiple-context mode, so that checkbox is disabled for context entries.)

 
    [bookmark: pgfId-834088]You can use the List Filter field on this page to filter the list, as described in Using The List Filter Fields.

 
    [bookmark: pgfId-834090]Step 6 Select the types of VPN to be monitored on specific devices by checking the appropriate boxes.

 
    [bookmark: pgfId-834092]Step 7 Click Save to save and apply your changes, and close the device selector.

 
    [bookmark: pgfId-834094]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-834104][bookmark: 162875][bookmark: HPMchap_intro_HPMwindow]HPM Window [bookmark: marker-834102]

 
    [bookmark: pgfId-834106]The Health and Performance Monitor (HPM) application window is where you view status information and alerts collected from monitored firewall and IPS devices, as well as remote-access (RA) and site-to-site (S2S) VPN information, across your network.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-834111]Note See Managing Monitored Devices for information about specifying the devices to be monitored.


    
     

    

    

 
    [bookmark: pgfId-834113]The following illustration presents the primary features of the HPM window.

 
    [bookmark: pgfId-834117]Figure 70-1 [bookmark: 162886]Health and Performance Monitor Window

 
    [bookmark: pgfId-834121] 
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          [bookmark: pgfId-831209]1
         
  
        		[bookmark: pgfId-831211]Monitoring button.

  
        		
          
          [bookmark: pgfId-831213]4
         
  
        		[bookmark: pgfId-831215]Quick-launch buttons.

  
       

 
        
        		
          
          [bookmark: pgfId-831225]2
         
  
        		[bookmark: pgfId-831227]Views

  
        		
          
          [bookmark: pgfId-831229]5
         
  
        		[bookmark: pgfId-831231]Monitoring/Alerts display area.

  
       

 
        
        		
          
          [bookmark: pgfId-831241]3
         
  
        		 
        		
          
          		 [bookmark: pgfId-834128] Monitoring button (1) – Click this button to view device and VPN health and performance data. See HPM Window: Monitoring Display for more information.

 
          		 [bookmark: pgfId-834133] Views (2) - When in the Monitoring view, the left pane of the HPM main window displays a list of available views. See Managing Device Views for more information.

 
         

 [bookmark: pgfId-834135]as shown in the following illustration.

 
          
          		 [bookmark: pgfId-834140] Alerts button (3) – Click this button to view a table of alerts in the window’s display area. See HPM Window: Alerts Display for more information.

 
          		 [bookmark: pgfId-834142] Quick-launch buttons (4) – Click any button to cross-launch the related Security Manager client application.

 
          		 [bookmark: pgfId-834144] Monitoring/Alerts display area (5) – This section of the window displays either Monitoring information for devices and VPNs, or a table of alerts generated by monitored devices. The Monitoring and Alerts buttons are used to switch back and forth between these two displays.

 
         

 
          
           [bookmark: pgfId-834154][bookmark: 162948][bookmark: HPMchap_intro_TableColumns]Working with Table Columns[bookmark: marker-834150][bookmark: marker-834152]

 
          [bookmark: pgfId-834156]You can customize the different tables of information presented in HPM as follows:

 
           
           		 [bookmark: pgfId-834158]Sort a table such entries in a particular column are in ascending or descending order.

 
          

 
          [bookmark: pgfId-834160] – Click a column heading—anywhere but on a drop-down menu button—to sort the table such that the column entries are in ascending order (indicated by a small grey up-arrow).

 
          [bookmark: pgfId-834162] – Click the heading again to sort the entries are in descending order (indicated by a small grey down-arrow).

 
          [bookmark: pgfId-834164] – Click the heading again to return the table to its original order of display (the direction icon is removed).

 
           
           		 [bookmark: pgfId-834166]Hide and show various columns; the columns available for display depend on the particular table.

 
           		 [bookmark: pgfId-834168]Apply a column filter, meaning the table displays only entries that fit the specified criteria.

 
          

 
          [bookmark: pgfId-834170]This section contains the following topics:

 
           
           		 [bookmark: pgfId-834175]Showing and Hiding Table Columns

 
           		 [bookmark: pgfId-834180]Column-based Filtering

 
          

 
         
 
          
           [bookmark: pgfId-834190][bookmark: 162973][bookmark: HPMchap_cncpt_ViewsShowHideColumns]Showing and Hiding Table Columns [bookmark: marker-834186][bookmark: marker-834188]

 
          [bookmark: pgfId-834192]You can customize the different tables presented in HPM by hiding and showing various columns of information; the columns available for display depend on the particular table.

 
           
           [image: ] 
          
 
          
 
          [bookmark: pgfId-834197]Note The column headings are menus that you can use to further filter the table by hiding or showing entries according to chosen parameters, as described in Column-based Filtering.


          
           

          

          

 
          [bookmark: pgfId-834199]To show or hide specific columns displayed for a table:

 
          [bookmark: pgfId-834201] 1. Click the Columns button on the right side of the column headings to open the Choose Columns to Display dialog box.

 
          [bookmark: pgfId-834203]All columns available for the current view are listed.

 
          [bookmark: pgfId-834205] 2. Select and deselect the columns to be shown and hidden.

 
          [bookmark: pgfId-834207] 3. Click OK to close the dialog box.

 
          [bookmark: pgfId-834209]Only the selected columns are displayed for this table.

 
          [bookmark: pgfId-834211]The following topics describe the individual columns available for various tables:

 
           
           		 [bookmark: pgfId-834216]Table Columns: Device-related Views

 
           		 [bookmark: pgfId-834221]Table Columns: VPN-related Views

 
           		 [bookmark: pgfId-834226]Alert Table Columns

 
          

 
         
 
          
           [bookmark: pgfId-834236][bookmark: 163009][bookmark: HPMchap_cncpt_ColumnsDevice]Table Columns: Device-related Views [bookmark: marker-834234]

 
          [bookmark: pgfId-834238]You can customize the tables presented in the Monitoring pane for the device-related views by hiding and showing various columns of information; the columns available for display depend on the particular view.

 
          [bookmark: pgfId-834243]The order of the entries in the Choose Columns to Display dialog box reflects the ordering of the columns when displayed. (However, the ordering of the rows in the following table does not necessarily reflect ordering of the columns as displayed.) See Showing and Hiding Table Columns for information about opening the Choose Columns to Display dialog box.

 
           
            
             
             [bookmark: pgfId-831262]Table 70-1 [bookmark: 163026]Available Table Columns for Device-related Views 

 
             
            
              
              		
                
                [bookmark: pgfId-831270]Column Name
               
  
              		
                
                [bookmark: pgfId-831274]Available in View
                 * 
               
  
              		
                
                [bookmark: pgfId-831276]Description
               
  
             

 
              
              		[bookmark: pgfId-831284]Device Name

  
              		[bookmark: pgfId-831286]IPS, Firewall

  
              		[bookmark: pgfId-831294]Name assigned to the device; that is, the Host Name as defined on the Device Properties: General Page of the Device Properties window. Column-based Filtering is available.

 [bookmark: pgfId-831296]The Name is preceded by an icon indicating device type. This icon in turn may be preceded by a device-alerts indicator: a red dot indicates one or more critical alerts (and possibly warnings), while a yellow dot indicates one or more warnings only. The area is blank for a device with no alerts.

 [bookmark: pgfId-831298]You can “hover” the mouse pointer over the dot to view a pop-up displaying the number of critical alerts and the number of warnings on the device.

 [bookmark: pgfId-831300]A gold star is added to the device icon itself to indicate Priority monitoring.

  
             

 
              
              		[bookmark: pgfId-831308]Receive Time

  
              		[bookmark: pgfId-831310]IPS, Firewall

  
              		[bookmark: pgfId-831312]Poll date and time for this entry (format is: day-of-week MMM DD HH:MM:SS your-time-zone YYYY).

  
             

 
              
              		[bookmark: pgfId-831320]IP Address

  
              		[bookmark: pgfId-831322]IPS, Firewall

  
              		[bookmark: pgfId-831327]IP address of this device. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831335]Health Status

  
              		[bookmark: pgfId-831337]IPS, Firewall

  
              		[bookmark: pgfId-831342]Current overall health of the device: Critical, Warning, or Normal. Column-based Filtering is available.

 [bookmark: pgfId-831344]Note Overall health is defined by the most critical of any of the health metrics. For instance, if all the selected metrics on the device are normal except for one that is critical, overall device health becomes critical.

  
             

 
              
              		[bookmark: pgfId-831352]Connection Status

  
              		[bookmark: pgfId-831354]IPS, Firewall

  
              		[bookmark: pgfId-831359]Indicates HPM’s ability to connect to/poll the device: Connected, Authentication Error, Certificate Mismatch Error, Connection error, Timeout during Read operation, or Service unavailable. Column-based Filtering is available.

 [bookmark: pgfId-831361]Note If the device is not selected as a Normal or Priority Monitored Device in HPM (Tools > Device Selector), this status will not apply. Changes to Monitored Device selection may take several minutes to become effective and be reflected on screen.

 [bookmark: pgfId-831363]Any information displayed for a non-"Connected" device is from the indicated Receive Time, prior to connection failure.

  
             

 
              
              		[bookmark: pgfId-831371]Memory (%)

  
              		[bookmark: pgfId-831373]IPS, Firewall

  
              		[bookmark: pgfId-831375]Memory usage as a percentage of the total available.

  
             

 
              
              		[bookmark: pgfId-831383]CPU (%)

  
              		[bookmark: pgfId-831385]IPS, Firewall

  
              		[bookmark: pgfId-831387]CPU usage as a percentage of the total available.

  
             

 
              
              		[bookmark: pgfId-831395]Model

  
              		[bookmark: pgfId-831397]IPS, Firewall

  
              		[bookmark: pgfId-831399]Device type and model number. For example, ASA 5510, or IPS 4270.

  
             

 
              
              		[bookmark: pgfId-831407]Version

  
              		[bookmark: pgfId-831409]IPS, Firewall

  
              		[bookmark: pgfId-831414]Software version running on this device. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831422]Inspection Load (%)

  
              		[bookmark: pgfId-831424]IPS

  
              		[bookmark: pgfId-831426]Inspection load on the device when polled, as a percentage.

  
             

 
              
              		[bookmark: pgfId-831434]Missed Packet(%)

  
              		[bookmark: pgfId-831436]IPS

  
              		[bookmark: pgfId-831438]Dropped packets as a percentage of total packets inspected.

  
             

 
              
              		[bookmark: pgfId-831446]Sensor App Status

  
              		[bookmark: pgfId-831448]IPS

  
              		[bookmark: pgfId-831453]Current Sensor App (Analysis Engine) status: Up or Down. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831461]Main App Status

  
              		[bookmark: pgfId-831463]IPS

  
              		[bookmark: pgfId-831468]Current Main App status: Up or Down. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831476]Collaboration App Status

  
              		[bookmark: pgfId-831478]IPS

  
              		[bookmark: pgfId-831480]Current Collaboration App status: Up or Down.

  
             

 
              
              		[bookmark: pgfId-831488]License Expiration Status

  
              		[bookmark: pgfId-831490]IPS

  
              		[bookmark: pgfId-831495]Status of the sensor’s license, based on red and yellow threshold values set on the sensor: Normal, Warning, or Critical. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831503]In Bypass Mode

  
              		[bookmark: pgfId-831505]IPS

  
              		[bookmark: pgfId-831510]Whether bypass mode is enabled on the sensor: Yes or No. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831518]Event Retrieval Status

  
              		[bookmark: pgfId-831520]IPS

  
              		[bookmark: pgfId-831525]Status of the IPS event retrieval: Normal, Warning, or Critical. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831533]Global Correlation Status

  
              		[bookmark: pgfId-831535]IPS

  
              		[bookmark: pgfId-831540]For a sensor participating in global correlation, its update status: Normal (last update was successful), Warning (no successful update within the past day [86,400 seconds]), or Critical (no successful update within the last three days [259,200 seconds]). Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831548]Signature Update

  
              		[bookmark: pgfId-831550]IPS

  
              		[bookmark: pgfId-831555]The number of the most recent signature update applied to this sensor; for example, S574. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831563]Firewall Mode

  
              		[bookmark: pgfId-831565]Firewall

  
              		[bookmark: pgfId-831570]Operating mode of this device: Routed, Transparent, or Mixed. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831578]Context Mode

  
              		[bookmark: pgfId-831580]Firewall

  
              		[bookmark: pgfId-831585]Context mode of this device: Single or Multiple. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831593]Connections

  
              		[bookmark: pgfId-831595]Firewall

  
              		[bookmark: pgfId-831597]Number of active connections when device was polled.

  
             

 
              
              		[bookmark: pgfId-831605]Xlates

  
              		[bookmark: pgfId-831607]Firewall

  
              		[bookmark: pgfId-831609]Address translation counter.

  
             

 
              
              		[bookmark: pgfId-831617]Connections/second

  
              		[bookmark: pgfId-831619]Firewall

  
              		[bookmark: pgfId-831621]Number of connections established per second.

  
             

 
              
              		[bookmark: pgfId-831629]Translations/second

  
              		[bookmark: pgfId-831631]Firewall

  
              		[bookmark: pgfId-831633]Number of translations per second.

  
             

 
              
              		[bookmark: pgfId-831641]Failover Status

  
              		[bookmark: pgfId-831643]Firewall

  
              		[bookmark: pgfId-831648]If this device is part of a failover pair, its current state: Active or Standby. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831656]Failover Host Role

  
              		[bookmark: pgfId-831658]Firewall

  
              		[bookmark: pgfId-831663]If this device is part of a failover pair, its current role: Primary or Secondary. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831671]Failover Peer Role

  
              		[bookmark: pgfId-831673]Firewall

  
              		[bookmark: pgfId-831678]If this device is part of a failover pair, current role of its peer device: Primary or Secondary. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831686]Failover Peer Status

  
              		[bookmark: pgfId-831688]Firewall

  
              		[bookmark: pgfId-831693]If this device is part of a failover pair, current status of its peer: Active or Standby Ready. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831701]Used Memory (MB)

  
              		[bookmark: pgfId-831703]Firewall

  
              		[bookmark: pgfId-831708]Amount of memory (in megabytes) in use when device was polled. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831716]Free Memory (MB)

  
              		[bookmark: pgfId-831718]Firewall

  
              		[bookmark: pgfId-831723]Amount of memory available (in megabytes) when device was polled. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831731]Max. Connections

  
              		[bookmark: pgfId-831733]Firewall

  
              		[bookmark: pgfId-831735]Peak number of connections. Not available for ASA clusters.

  
             

 
              
              		[bookmark: pgfId-831743]Max. Xlates

  
              		[bookmark: pgfId-831745]Firewall

  
              		[bookmark: pgfId-831747]Peak number of address translations. Not available for ASA clusters.

  
             

 
              
              		[bookmark: pgfId-831755]Throughput (Kbps)

  
              		[bookmark: pgfId-831757]Firewall

  
              		[bookmark: pgfId-831759]Average device throughput in kilobits per second. For an ASA 9.0+ cluster, this the total throughput for all interfaces in the cluster.

  
             

 
              
              		[bookmark: pgfId-831767]ACL Dropped Packets

  
              		[bookmark: pgfId-831769]Firewall

  
              		[bookmark: pgfId-831771]The number of packets dropped because they failed an access control list rule. Available only at cluster level for ASA clusters; not available for individual nodes.

  
             

 
              
              		[bookmark: pgfId-831779]Scanning Threat Dropped Packets

  
              		[bookmark: pgfId-831781]Firewall

  
              		[bookmark: pgfId-831783]If scanning threat detection is enabled, the number of packets dropped because they failed scanning threat inspection. If not enabled, “NA” is displayed. Available only at cluster level for ASA clusters; not available for individual nodes.

  
             

 
              
              		[bookmark: pgfId-831791]Inspection Dropped Packets

  
              		[bookmark: pgfId-831793]Firewall

  
              		[bookmark: pgfId-831795]If application inspection is enabled, the number of packets dropped because they failed application inspection. If not enabled, “NA” is displayed. Available only at cluster level for ASA clusters; not available for individual nodes.

  
             

 
              
              		[bookmark: pgfId-831803]Syn Attack Dropped Packets

  
              		[bookmark: pgfId-831805]Firewall

  
              		[bookmark: pgfId-831807]Number of packets dropped because of SYN flooding. Available only at cluster level for ASA clusters; not available for individual nodes.

  
             

 
              
              		[bookmark: pgfId-831815]Total Interface Dropped Packets

  
              		[bookmark: pgfId-831817]Firewall

  
              		[bookmark: pgfId-831819]Total number of dropped packets on all interfaces. Available only at cluster level for ASA clusters; not available for individual nodes.

 [bookmark: pgfId-831821]Note You can view the number of per-interface dropped packets on the tabbed Interface panel presented in the detail section for the selected device.

  
             

 
              
              		[bookmark: pgfId-831829]Analysis Engine Memory (%)

  
              		[bookmark: pgfId-831831]IPS

  
              		[bookmark: pgfId-831833]Percentage of memory assigned to the Analysis Engine currently in use.

  
             

 
              
              		[bookmark: pgfId-831841]Role in Cluster

  
              		[bookmark: pgfId-831843]Firewall

  
              		[bookmark: pgfId-831845]The role of this member of an ASA load-balancing cluster: Cluster, Master, or Slave.

 [bookmark: pgfId-831847]A cluster is managed by Security Manager as a single device with multiple nodes. Thus, each cluster is displayed in HPM as single entry, which you can expand in order to view a list of nodes.

  
             

 
              
              		 [bookmark: pgfId-831857][bookmark: HPMchap_cncpt_ColumnsDevice_footnote]* All of these columns are available in the All Devices and Priority Devices views.

  
             

 
            
           

 
          
 
         
 
          
           [bookmark: pgfId-834258][bookmark: 163406][bookmark: HPMchap_cncpt_ColumnsVPN]Table Columns: VPN-related Views [bookmark: marker-834256]

 
          [bookmark: pgfId-834260]You can customize the tables presented in the Monitoring pane for the VPN-related views by hiding and showing various columns of information; the columns available for display depend on the particular view.

 
          [bookmark: pgfId-834265]The order of the entries in the Choose Columns to Display dialog box reflects the ordering of the columns when displayed. (However, the ordering of the rows in the following table does not necessarily reflect ordering of the columns as displayed.) See Showing and Hiding Table Columns for information about opening the Choose Columns to Display dialog box.

 
          [bookmark: pgfId-834267]The following table presents all available data columns for the VPN-related Monitoring views: Remote Access Users (RA), Site-to-Site Tunnels (S2S), VPN Summary, and all custom views based on these system views. Some of the listed columns are not available for specific views, as indicated.

 
           
           [image: ] 
          
 
          
 
          [bookmark: pgfId-834269]Note Beginning with Security Manager version 4.9, the Health and Performance Monitoring application monitors and displays the site-to-site tunnels that have IPv6 address configured, in addition to the IPv4 based tunnels. Also the Email and Trap notifications now contain IPv6 addresses in addition to IPv4 addresses.


          
           

          

          

 
          [bookmark: pgfId-834272] 

 
           
            
             
             [bookmark: pgfId-831876]Table 70-2 [bookmark: 163423]Available Table Columns for VPN-related Views 

 
             
            
              
              		
                
                [bookmark: pgfId-831884]Column Name
               
  
              		
                
                [bookmark: pgfId-831886]Available in View
               
  
              		
                
                [bookmark: pgfId-831888]Description
               
  
             

 
              
              		[bookmark: pgfId-831896]Receive Time

  
              		[bookmark: pgfId-831898]RA, S2S, VPN Summary

  
              		[bookmark: pgfId-831900]Poll date and time for this entry (format is: day-of-week MMM DD HH:MM:SS your-time-zone YYYY).

  
             

 
              
              		[bookmark: pgfId-831908]Firewall Name

  
              		[bookmark: pgfId-831910]RA, S2S, VPN Summary

  
              		[bookmark: pgfId-831915]Name of this device, as provided in the Security Manager inventory. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831923]User Name

  
              		[bookmark: pgfId-831925]RA

  
              		[bookmark: pgfId-831930]User log-in name used to establish this session. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831938]User Group Policy

  
              		[bookmark: pgfId-831940]RA

  
              		[bookmark: pgfId-831945]The name of the ASA VPN user group to which this user belongs. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831953]Gateway

  
              		[bookmark: pgfId-831955]RA

  
              		[bookmark: pgfId-831960]IP address of the VPN gateway to which the user is connected. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831968]Assigned IP

  
              		[bookmark: pgfId-831970]RA

  
              		[bookmark: pgfId-831972]Private IP address assigned to the remote client for this session; also known as the “inner” or “virtual” IP address.

  
             

 
              
              		[bookmark: pgfId-831980]Public IP

  
              		[bookmark: pgfId-831982]RA

  
              		[bookmark: pgfId-831987]Publicly routable IP address assigned to the client. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-831995]Connection Initiation Time

  
              		[bookmark: pgfId-831997]RA

  
              		[bookmark: pgfId-831999]Time and date (HH:MM:SS day-of-week MMM DD YYYY) when connection was initiated. Time is displayed in 24-hour Coordinated Universal Time (UTC) notation.

  
             

 
              
              		[bookmark: pgfId-832007]Duration

  
              		[bookmark: pgfId-832009]RA

  
              		[bookmark: pgfId-832011]Elapsed time (HH:MM:SS) between the session initiation and the most-recent device poll.

  
             

 
              
              		[bookmark: pgfId-832019]Client Version

  
              		[bookmark: pgfId-832021]RA

  
              		[bookmark: pgfId-832026]VPN client software, and version, running on the remote peer; for example, AnyConnect Windows 3.0, or Mozilla 4.0. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-832034]EndPoint OS

  
              		[bookmark: pgfId-832036]RA

  
              		[bookmark: pgfId-832041]Operating system in use on remote peer; for example, Windows or Windows NT. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-832049]Authentication Method

  
              		[bookmark: pgfId-832051]RA

  
              		[bookmark: pgfId-832056]User password, certificate, or preshared key. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-832064]Encryption

  
              		[bookmark: pgfId-832066]RA, S2S

  
              		[bookmark: pgfId-832071]Data encryption algorithm this session is using. Column-based Filtering is available..

  
             

 
              
              		[bookmark: pgfId-832079]Tunnel Type

  
              		[bookmark: pgfId-832081]RA, VPN Summary (as “Type” only)

  
              		[bookmark: pgfId-832086]Type of tunnel or connection. These include Clientless, IPsec, and AnyConnect. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-832094]Throughput (Kbps)

  
              		[bookmark: pgfId-832096]RA, S2S

  
              		[bookmark: pgfId-832098]Bytes received plus bytes transmitted, in kilobits per second.

  
             

 
              
              		[bookmark: pgfId-832106]Session ID

  
              		[bookmark: pgfId-832108]RA

  
              		[bookmark: pgfId-832110]Identifier assigned to this session.

  
             

 
              
              		[bookmark: pgfId-832118]Inactive Time

  
              		[bookmark: pgfId-832120]RA

  
              		[bookmark: pgfId-832122]Amount of time this session has been inactive.

  
             

 
              
              		[bookmark: pgfId-832130]IP Address

  
              		[bookmark: pgfId-832132]S2S, VPN Summary

  
              		[bookmark: pgfId-832137]IP address of this device. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-832145]Local Endpoint

  
              		[bookmark: pgfId-832147]S2S

  
              		[bookmark: pgfId-832149]IP address of local tunnel interface.

  
             

 
              
              		[bookmark: pgfId-832157]Remote Endpoint

  
              		[bookmark: pgfId-832159]S2S

  
              		[bookmark: pgfId-832161]IP address of remote tunnel interface.

  
             

 
              
              		[bookmark: pgfId-832169]Local Subnet

  
              		[bookmark: pgfId-832171]S2S

  
              		[bookmark: pgfId-832173]Address of local protected subnet.

  
             

 
              
              		[bookmark: pgfId-832181]Remote Subnet

  
              		[bookmark: pgfId-832183]S2S

  
              		[bookmark: pgfId-832185]Address of remote protected subnet.

  
             

 
              
              		[bookmark: pgfId-832193]Uptime

  
              		[bookmark: pgfId-832195]S2S

  
              		[bookmark: pgfId-832197]Current duration of this tunnel.

  
             

 
              
              		[bookmark: pgfId-832205]Connection Time

  
              		[bookmark: pgfId-832207]S2S

  
              		[bookmark: pgfId-832209]Time and date (HH:MM:SS day-of-week MMM DD YYYY) when connection was initiated. Time is displayed in 24-hour Coordinated Universal Time (UTC) notation.

  
             

 
              
              		[bookmark: pgfId-832217]Status

  
              		[bookmark: pgfId-832219]S2S

  
              		[bookmark: pgfId-832224]Tunnel connection status; this will be Up or Down. An alert is issued when a tunnel goes down a specified number of times; see Alerts: Configuring for more information.

 [bookmark: pgfId-832226]Tip You can click on a Down notification hyperlink in the Status column to view the IPSec VPN Events for that device in Event Viewer. Event Viewer will show IPSec VPN Events for the device within a time range depending on the polling interval for that device. If it is a priority device, the time range will be 5 minutes before until 5 minutes after the first down notification was received. For non-priority devices, the time range will be +/- 10 minutes instead of 5 minutes.  
             

 
              
              		[bookmark: pgfId-832234]Health Status

  
              		[bookmark: pgfId-832236]VPN Summary

  
              		[bookmark: pgfId-832241]Current overall health of the underlying device: Critical, Warning, or Normal. Column-based Filtering is available..

 [bookmark: pgfId-832243]Note Overall health is defined by the most critical of any of the health metrics. For instance, if all the selected metrics on the device are normal except for one that is critical, overall device health becomes critical.

  
             

 
              
              		[bookmark: pgfId-832251]Connection Status

  
              		[bookmark: pgfId-832253]VPN Summary

  
              		[bookmark: pgfId-832258]Remote connection status; this will always be Connected. (HPM cannot present information about previous connections.) Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-832266]Monitoring Type

  
              		[bookmark: pgfId-832268]VPN Summary

  
              		[bookmark: pgfId-832273]Types of VPN connections being monitored. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-832281]Active Sessions

  
              		[bookmark: pgfId-832283]VPN Summary

  
              		[bookmark: pgfId-832285]Current active sessions (S2S, IPSec RA, client-based SSL RA, and clientless SSL RA).

  
             

 
              
              		[bookmark: pgfId-832293]Peak Sessions

  
              		[bookmark: pgfId-832295]VPN Summary

  
              		[bookmark: pgfId-832297]Peak numbers of concurrent sessions (S2S, IPSec RA, client-based SSL RA, and clientless SSL RA).

  
             

 
              
              		[bookmark: pgfId-832305]Total Users

  
              		[bookmark: pgfId-832307]VPN Summary

  
              		[bookmark: pgfId-832309]Current remote user total (S2S, IPSec RA, client-based SSL RA, and clientless SSL RA).

  
             

 
              
              		[bookmark: pgfId-832317]Inactive Sessions

  
              		[bookmark: pgfId-832319]VPN Summary

  
              		[bookmark: pgfId-832321]Number of inactive sessions.

  
             

 
              
              		[bookmark: pgfId-832329]Total VPN Throughput (Kbps)

  
              		[bookmark: pgfId-832331]VPN Summary

  
              		[bookmark: pgfId-832336]Sum of all VPN traffic; that is, sum of RA and S2S throughput values, in kilobits per second. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-832344]ACL Name

  
              		[bookmark: pgfId-832346]Site-to-Site Tunnels

  
              		[bookmark: pgfId-832348]Beginning with version 4.9, Security Manager enables you to view the Access Control List (ACL) name that is associated with the selected Site-to-Site tunnel. This column name is selected by default.

 [bookmark: pgfId-832350]Note In the Health and Performance Alerts Display, Tunnel up/down Alert now also displays the ACL Name in the Description column. Similarly, Email and Trap notifications also display the ACL Name in the Description column.

  
             

 
              
              		[bookmark: pgfId-832358]Remarks

  
              		[bookmark: pgfId-832360]Site-to-Site Tunnels

  
              		[bookmark: pgfId-832362](Optional) This column displays the remarks corresponding to the ACL Name.

 [bookmark: pgfId-832364]Note Alert, Email, and Trap notifications do not contain Remarks as part of the description field.

  
             

 
              
              		 [bookmark: pgfId-832372]Limitation:

 [bookmark: pgfId-832374]When Cisco Security Manager Daemon Manager service is started, the HPM application uses the latest configuration from the Configuration Archive to extract the ACL Name and Remarks associated with the Site-to-Site VPN tunnel. When the VPN tunnel is identified by HPM, it uses the extracted data to display the ACL Name and Remarks columns in the S2S view. If the VPN tunnel comes up before the data is available in HPM, the ACL Name and Remarks columns may not display the data until the next UI refresh. Similarly, the Alerts Display may not show the ACL Name in the Description column if the Alert is generated before the data is extracted by HPM. This might occur during upgrade to Security Manager version 4.9 from a previous version. If the same Alert appears in the next polling, the ACL Name is added to the Description.

 [bookmark: pgfId-832376]Tip:

 [bookmark: pgfId-832378]Sometimes you may notice discrepancy in the content of the Remarks column. Check if the latest configuration from the Configuration Archive contains the Remarks. If the Remarks are added or updated by Out-of-Band changes, you must perform rediscovery of the device.

  
             

 
            
           

 
          
 
         
 
          
           [bookmark: pgfId-834280][bookmark: 163748][bookmark: HPMchap_cncpt_AlertTableColumns]Alert Table Columns [bookmark: marker-834278]

 
          [bookmark: pgfId-834282]You can customize the Alerts table by hiding and showing various columns of information.

 
          [bookmark: pgfId-834287]The order of the entries in the Choose Columns to Display dialog box reflects the ordering of the columns when displayed. (However, the ordering of the rows in the following table does not necessarily reflect ordering of the columns as displayed.) See Showing and Hiding Table Columns for information about opening the Choose Columns to Display dialog box.

 
          [bookmark: pgfId-834290] 

 
           
            
             
             [bookmark: pgfId-832395]Table 70-3 [bookmark: 163758]Available Data Columns for the Alerts Table 

 
             
            
              
              		
                
                [bookmark: pgfId-832401]Column Name
               
  
              		
                
                [bookmark: pgfId-832403]Description
               
  
             

 
              
              		[bookmark: pgfId-832409]Device Name (always selected)

  
              		[bookmark: pgfId-832414]Name of this device on which this alert was triggered, as provided in the Security Manager inventory. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-832420]Node

  
              		[bookmark: pgfId-832425]The Node Name if this alert was generated by a member of an ASA load-balancing cluster Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-832431]Device Type

  
              		[bookmark: pgfId-832436]Type of device: ASA or IPS. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-832442]Severity

  
              		[bookmark: pgfId-832447]Alert severity: Critical, Warning, or Normal. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-832453]Status

  
              		[bookmark: pgfId-832458]Current device status: Active or Acknowledged. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-832464]Description

  
              		[bookmark: pgfId-832466]Description of the alert. For example, “Device Health Critical” or “Device Polling: Authentication Error.”

  
             

 
              
              		[bookmark: pgfId-832472]First Seen

  
              		[bookmark: pgfId-832477]Date and time when this alert was first logged (day-of-week MMM DD, YYYY HH:MM:SS AM/PM). Time is based in your time zone. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-832483]Last Seen

  
              		[bookmark: pgfId-832488]Date and time when this alert was first logged (day-of-week MMM DD, YYYY HH:MM:SS AM/PM). Time is based in your time zone. Column-based Filtering is available.

  
             

 
              
              		[bookmark: pgfId-832494]Notes

  
              		[bookmark: pgfId-832499]You can annotate an alert when you acknowledge it. Any annotations are displayed in this field. See Alerts: Acknowledging and Clearing for more information.

  
             

 
            
           

 
          
 
         
 
          
           [bookmark: pgfId-834302][bookmark: 163832][bookmark: HPMchap_proc_ColumnBasedFilters]Column-based Filtering [bookmark: marker-834296][bookmark: marker-834298][bookmark: marker-834300]

 
          [bookmark: pgfId-834304]You can filter the various tables in HPM based on the contents of specific columns. When you apply a column filter, the table is filtered to include only those entries with the specified criteria in that column.

 
           
           [image: ] 
          
 
          
 
          [bookmark: pgfId-834309]Note See Working with Table Columns for other methods of altering table displays.


          
           

          

          

 
          [bookmark: pgfId-834311]Tips

 
           
           		 [bookmark: pgfId-834313]Column filters are cumulative: for an entry to appear in the filtered table, it must meet all column filter criteria. You cannot create a set of ORed column filters.

 
           		 [bookmark: pgfId-834315]You can filter on the contents of most but not all columns. If a column does not have a down arrow, you cannot filter on it. For example, you cannot filter on Receive Time in All Devices view.

 
           		 [bookmark: pgfId-834317]The filter icon (a funnel) appears in the heading of a filtered column.

 
           		 [bookmark: pgfId-834322]For a description of the available columns, see Showing and Hiding Table Columns.

 
          

 
          [bookmark: pgfId-834324]To filter a table according to a particular column parameter:

 
          
 
          [bookmark: pgfId-834326]Step 1 Click the down-arrow in the heading of a column and choose one of the following from the drop-down menu:

 
           
           		 [bookmark: pgfId-834328] All – Choose  All to remove or “undo” a filter from this column. The table is updated to show all entries for this parameter. For example, if you filtered the Severity column of the Alerts table to display only Critical alerts, choosing this option will re-display all Critical and Warning alerts.

 
           		 [bookmark: pgfId-834333] Custom – Choose  Custom to open the Custom Filter dialog box where you can create a custom filter based on the information in that column. See Custom Filtering for more information.

 
           		 [bookmark: pgfId-834335]A specific entry – The drop-down menu includes all values relevant to the column; choose one to display only that group of entries. For example, choosing  Critical from the Severity column of the Alerts table filters the table to display only Critical alerts.

 
          

 
          [bookmark: pgfId-834337]


          
           

          
 
          

 
         
 
          
           [bookmark: pgfId-834345][bookmark: 163880][bookmark: HPMchap_proc_CustomFilters]Custom Filtering [bookmark: marker-834343]

 
          [bookmark: pgfId-834350]The following procedure explains how to create a custom column-based filter, one in which you are not simply selecting a value from the column’s drop-down list. Refer to Column-based Filtering for information about other column-based filtering options.

 
          
 
          [bookmark: pgfId-834352]Step 1 Click the down-arrow in the heading of a column and choose (Custom) from the drop-down menu.

 
          [bookmark: pgfId-834354]The Custom Filter dialog box for that column opens.

 
          [bookmark: pgfId-834356]Step 2 In the Custom Filter dialog box, select the desired values. The following illustration shows a typical example of this dialog box.

 
          [bookmark: pgfId-834359] 

 
           
           [image: ] 
          
 
          [bookmark: pgfId-834361]These are the controls you might find in the Custom Filter dialog box (not all controls appear for every instance):

 
           
           		 [bookmark: pgfId-834363] Condition – Choose the condition applied to the selected Values.

 
          

 
          [bookmark: pgfId-834365]Typically this is is in, meaning each of the Values you select must be “in” a column in order for that entry to be displayed in the filtered table.

 
           
           		 [bookmark: pgfId-834367] Not – Check this box to create a negative Condition.

 
          

 
          [bookmark: pgfId-834369]With is in as the chosen Condition, this would mean the selected Values cannot be in the column. In other words, the table is filtered such that entries with these Values in the column are not displayed.

 
           
           		 [bookmark: pgfId-834371] Values list – A few instances of the dialog box present one list of Values from which to select: simply check the desired options.

 
          

 
          [bookmark: pgfId-834373]Available and selected Values lists – In most cases, the dialog box presents two Values lists, as shown in the previous illustration. To select a value for the custom filter, highlight it in the left list, which contains available values for the column, and click the right arrow to add it to the list of selected values on the right. You can select multiple values.

 
          [bookmark: pgfId-834375]The items in the available Values list are determined by the values currently present in the selected column of the source table.

 
          [bookmark: pgfId-834380]If there are a lot of available values, you can search for a specific value by typing in the List Filter field above the list. For more information, see Using The List Filter Fields.

 
          [bookmark: pgfId-834382]You can also select, or deselect, values using the following techniques:

 
          [bookmark: pgfId-834384] – Type a Value name into the text field above the selected Values list and click the + button; the Value is added to the selected Values. This technique is useful if there is a large number of available Values, or if you want to filter on a value that is not present in the available Values list.

 
          [bookmark: pgfId-834386] – Double-click an item in either list to move it to the other list.

 
          [bookmark: pgfId-834388] – Click one of the double-arrow buttons to move all items from one list to the other, regardless of any selected values.

 
          [bookmark: pgfId-834390]Step 3 Click OK to close the dialog box.

 
          [bookmark: pgfId-834392]The table is updated to show only those entries that satisfy all currently applied filters.

 
          [bookmark: pgfId-834394]


          
           

          
 
          

 
         
 
          
           [bookmark: pgfId-834402][bookmark: 163934][bookmark: HPMchap_cncpt_SearchFields]Using The List Filter Fields [bookmark: marker-834400]

 
          [bookmark: pgfId-834404]A List Filter field is provided above the devices and VPNs lists in the Monitoring display, above the alerts table in the Alerts display, above the device list on the VPN page of the Device Selector, and in the View Cleared Alerts window. In each case, you can use the List Filter field to quickly locate any entries in the related table that contain a specified text string.

 
           
           [image: ] 
          
 
          
 
          [bookmark: pgfId-834409]Note The found text can be part of any data field associated with an entry. For example, as you type “license” into the Alerts List Filter field, the Alerts table is filtered to show only those alerts related to imminent license expiration. (Any matched entries are listed even if the relevant data column—in this example, Detail—is not displayed, which could cause confusion. See Showing and Hiding Table Columns for more information about hiding table columns.)


          
           

          

          

 
          [bookmark: pgfId-834413]Figure 70-2 [bookmark: 163942]Health and Performance Monitor: List Filter Field

 
          [bookmark: pgfId-834417] 

 
           
           [image: ] 
          
 
           
            
            
              
              		
                
                [bookmark: pgfId-832510]1
               
  
              		[bookmark: pgfId-832512]Filter-parameters button.

  
              		
                
                [bookmark: pgfId-832514]2
               
  
              		[bookmark: pgfId-832516]Clear button.

  
             

 
            
           

 
          
 
          [bookmark: pgfId-834419]To search for a specific text string in the devices list, the VPNs list, the Alerts table, or the View Cleared Alerts window:

 
           
           		 [bookmark: pgfId-834421]Click in the List Filter field to place the text cursor, and then begin typing.

 
          

 
          [bookmark: pgfId-834423]These are “live filter” fields. That is, as you type each character, entries that do not include your current text string are removed from the list or table. For example, suppose in an extensive list of alerts there is one with a Status of “Device Health Critical,” and that none of the other alerts include any text strings containing the letters hea. You want to use the List Filter field to quickly locate that one alert, so you begin to enter the word “health.” That alert is the only one displayed after you have typed the first three letters.

 
          [bookmark: pgfId-834425]To clear a List Filter field:

 
           
           		 [bookmark: pgfId-834427]Click the clear button at the right side of the field.

 
          

 
          [bookmark: pgfId-834429]This button appears when you begin typing in the field. (You also can highlight the characters and press the Delete or Backspace key on your keyboard.)

 
          [bookmark: pgfId-834431]When you clear the List Filter field, all entries in the list are again displayed.

 
          [bookmark: pgfId-834433]You can tune the filter results by specifying the information (columns) searched, by selecting case sensitivity or insensitivity, by allowing wildcards or regular expressions, and by specifying where in a returned string your characters must be located.

 
          [bookmark: pgfId-834435]To change the List Filter criteria:

 
          [bookmark: pgfId-834437] 1. Click the filter-parameters button (magnifying glass) at the left side of the List Filter field to open the parameters menu.

 
          [bookmark: pgfId-834439] 2. Choose an option.

 
          [bookmark: pgfId-834441]The menu consists of four sections:

 
          [bookmark: pgfId-834443] – A list of all available information types—these entries correspond to the columns that can be displayed for that particular list or table. You can choose All, or alternatively you can choose individual entries.

 
          [bookmark: pgfId-834445] – Case sensitive and Case insensitive – Choose one or the other. If you choose Case sensitive, found text must match not only the characters you enter, but also their as-typed case.

 
          [bookmark: pgfId-834447] – Use wildcards and Use regular expression – Choose one or the other. The following wildcards are recognized:

 
          [bookmark: pgfId-834449] – * (asterisk) – Match zero or more characters at that location in the string.

 
          [bookmark: pgfId-834451] – ? (question mark) – Match one character at that location in the string.

 
          [bookmark: pgfId-834453] – Match from start, Match exactly, and Match anywhere – Choose one. Match from start means that the string you enter must be found at the beginning of an entry, although it can be part of a larger set of characters. Match exactly requires that the string you enter exactly match the entire column entry. Match anywhere means the string can be found anywhere within an entry, and it can be part of a larger set of characters.

 
          [bookmark: pgfId-834455] 3. Repeat Steps 1 and 2 to change another parameter.

 
         
  
          
           [bookmark: pgfId-834465][bookmark: 164014][bookmark: HPMchap_intro_MonitoringDevices]Monitoring Devices [bookmark: marker-834463]

 
          [bookmark: pgfId-834470]The HPM Monitoring display presents View controls, view panels, and detailed information about the currently selected device, as described in HPM Window: Monitoring Display.

 
          [bookmark: pgfId-834472]To switch to the Monitoring screen:

 
           
           		 [bookmark: pgfId-834474]Click the  Monitoring button below the HPM menu bar.

 
          

 
          [bookmark: pgfId-834476](Click the Alerts button to return to the Alerts screen.)

 
           
           [image: ] 
          
 
          
 
          [bookmark: pgfId-834481]Note See Managing Monitored Devices for information about specifying the devices to be monitored.


          
           

          

          

 
          [bookmark: pgfId-834483]This section contains the following topics:

 
           
           		 [bookmark: pgfId-834488]Managing Device Views

 
           		 [bookmark: pgfId-834493]HPM Window: Monitoring Display

 
          

 
           
            [bookmark: pgfId-834505][bookmark: 164033][bookmark: HPMchap_intro_DeviceViewsUsing]Managing Device Views [bookmark: marker-834499][bookmark: marker-834501][bookmark: marker-834503]

 
           [bookmark: pgfId-834507]“Views” provide the means to filter and organize the information displayed in the Monitoring pane of the HPM application. Various system views are provided—for example, All Devices, Firewall Devices, Remote Access Users Details, and so on—and you can create custom views that organize the information in other ways, such as geographic device location.

 
           [bookmark: pgfId-834509]The left pane of the HPM main window displays a list of available views as shown in the following illustration.

 
           [bookmark: pgfId-834513]Figure 70-3 [bookmark: 164048]Health and Performance Monitor: Views Pane

 
           [bookmark: pgfId-834516] 

 
            
            [image: ] 
           
 
           [bookmark: pgfId-834518]The Views pane includes the following controls:

 
            
            		 [bookmark: pgfId-834520] (1) Push Pin button – Click the Push Pin button to control display of the Views list. When the list is displayed as a pane of the HPM window (the pin is vertical), click the button to collapse the pane into the left edge of the window, leaving a labeled tab; the Monitoring pane is expanded to fill the HPM window.

 
           

 
           [bookmark: pgfId-834522]You can “hover” your mouse pointer over the tab to “pop out” the Views list; it remains visible as long as the pointer is over the tab or in the list area (the pin is horizontal). You also can click anywhere in the title bar—except on the pin itself—to keep the list “popped out.”

 
           [bookmark: pgfId-834524]Click the pin once again to re-establish the Views list as an open pane; the Monitoring pane contracts to make room for it.

 
            
            		 [bookmark: pgfId-834532] (2) List of views – The list is organized into folders: System Views and My Views. Click an entry in either folder to open that view in the Monitoring pane, as described in Views: Opening and Closing. See Views: Custom for information about creating new views in the My Views folder.

 
            		 [bookmark: pgfId-834534] Right-click shortcut menu – You can right-click any entry in the View list to access a pop-up menu of view-related commands:

 
           

 
           [bookmark: pgfId-834539] – Edit – Edit the name and description of the existing custom view. See Views: Custom.

 
           [bookmark: pgfId-834544] – Save As – Save the view as a new custom view. See Views: Custom.

 
           [bookmark: pgfId-834546] – Delete – Delete that custom view.

 
           [bookmark: pgfId-834548] – Set as default view – Use this command to designate the view that is always displayed whenever you launch the HPM application.

 
           [bookmark: pgfId-834550]This section contains the following topics:

 
            
            		 [bookmark: pgfId-834555]Views: Opening and Closing

 
            		 [bookmark: pgfId-834560]Views: Tiling Horizontally or Vertically

 
            		 [bookmark: pgfId-834565]Views: Floating and Docking

 
            		 [bookmark: pgfId-834570]Views: Custom

 
           

 
          
 
           
            [bookmark: pgfId-834580][bookmark: 164081][bookmark: HPMchap_cncpt_ViewsOpenClose]Views: Opening and Closing [bookmark: marker-834576][bookmark: marker-834578]

 
           [bookmark: pgfId-834585]All available views are listed in the Views pane, on the left side of the HPM window. The Monitoring pane displays open views, with each open view presented as a separate tabbed panel. (See HPM Window: Monitoring Display for more information about this window.)

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-834590]Note You can detach views so they “float” in separate windows. For more information, see Views: Floating and Docking.


           
            

           

           

 
           [bookmark: pgfId-834592]To display a new view in the Monitoring pane:

 
            
            		 [bookmark: pgfId-834594]Click the desired entry in the Views list.

 
           

 
           [bookmark: pgfId-834596]The view appears as a tabbed panel in the Monitoring pane; it is automatically selected and displayed.

 
           [bookmark: pgfId-834598]To switch to another open view:

 
            
            		 [bookmark: pgfId-834600]Click the desired tab in the Monitoring pane; that view is displayed.

 
            		 [bookmark: pgfId-834602]Right-click any tab and choose  Next or  Previous to display the view to the right or left of that tabbed view.

 
            		 [bookmark: pgfId-834604]Click the Scroll Back and Scroll Forward buttons to the right of the tabs to display the view to the left or right of the current view.

 
           

 
           [bookmark: pgfId-834606]To close a view:

 
            
            		 [bookmark: pgfId-834608]Click the close button in that tab.

 
            		 [bookmark: pgfId-834610]Right-click the tab and choose the  Close .

 
            		 [bookmark: pgfId-834612]Right-click the tab and choose  Close Others to close all open views except the one you right-clicked.

 
            		 [bookmark: pgfId-834614]Right-click any tab and choose  Close All to close all open views.

 
           

 
          
 
           
            [bookmark: pgfId-834622][bookmark: 164124][bookmark: HPMchap_cncpt_ViewsTiling]Views: Tiling Horizontally or Vertically [bookmark: marker-834620]

 
           [bookmark: pgfId-834624]Rather than displaying a single view such that it fills the Monitoring pane, you can tile two or more of the views, either horizontally or vertically, for easy comparison.

 
           [bookmark: pgfId-834626]For example, if you tile two views horizontally, one view fills the upper half of the Monitoring pane, while the other fills the lower half. Similarly, tiling two views vertically fills the left-hand half of the pane with one view, with the other view filling the right half. Further, you can tile more than two views—the pane is subdivided equally for each view.

 
           [bookmark: pgfId-834628]To create two horizontal or vertical tiles:

 
            
            		 [bookmark: pgfId-834630]Right-click one of the tabs and choose  New Horizontal Group or  New Vertical Group .

 
           

 
           [bookmark: pgfId-834632]The selected view and the other view(s) are distributed to share the Monitoring pane equally, either horizontally or vertically depending on your choice.

 
           [bookmark: pgfId-834634]Note that if there are more than two views open when you choose one of these commands, the selected view is tiled, with the remaining group of tabbed views displayed as the other tile. You can then repeat this process with the remaining tabbed views, increasing the number of visible tiles, as desired.

 
           [bookmark: pgfId-834636]You can also move an existing tile to another tile:

 
            
            		 [bookmark: pgfId-834638]Right-click the tab and choose  Move to Next Tab Group or  Move to Previous Tab Group .

 
           

 
           [bookmark: pgfId-834640]The selected view is added to the next tile (below or to the right, depending on tile orientation), or to the previous tile (above or to the left). These commands are available only if the tiled views are arranged in a manner where such movement is possible.

 
           [bookmark: pgfId-834642]To change the orientation of the views, switching from horizontal to vertical tiling, or vice versa:

 
            
            		 [bookmark: pgfId-834644]Right-click any tab and choose  Change Tab Groups Orientation .

 
           

 
           [bookmark: pgfId-834646]This command is available only when two or more tiled views are displayed.

 
          
 
           
            [bookmark: pgfId-834656][bookmark: 164155][bookmark: HPMchap_cncpt_ViewsFloatDock]Views: Floating and Docking [bookmark: marker-834652][bookmark: marker-834654]

 
           [bookmark: pgfId-834658]You can detach tabbed views so they “float” as separate windows, and you can “dock” floating views, returning them to the Monitoring pane as tabbed views.

 
           [bookmark: pgfId-834660]To detach a view as a floating window:

 
            
            		 [bookmark: pgfId-834662]Right-click that tab and choose  Floating .

 
           

 
           [bookmark: pgfId-834664]A standard window opens, displaying the selected view.

 
           [bookmark: pgfId-834666]To move another tabbed view from the Monitoring pane to an already-open floating-view window:

 
            
            		 [bookmark: pgfId-834668]Right-click the tab and choose the window from the  Floating to submenu.

 
           

 
           [bookmark: pgfId-834670]The right-clicked view is added to the existing window as another tabbed panel.

 
           [bookmark: pgfId-834672]To return a floating view to the Monitoring pane as a tabbed panel:

 
            
            		 [bookmark: pgfId-834674]Right-click the view’s tab in the window and choose  Docking .

 
           

 
           [bookmark: pgfId-834676]That view is returned to the Monitoring pane.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-834678]Note As a standard window, you can minimize, maximize and close a floating view, as you would any other window.


           
            

           

           

 
          
 
           
            [bookmark: pgfId-834690][bookmark: 164187][bookmark: HPMchap_cncpt_CustomView]Views: Custom [bookmark: marker-834686][bookmark: marker-834688]

 
           [bookmark: pgfId-834692]The Health and Performance Monitor provides seven System Views. In addition, you can create any number of custom views, each of which is based on an existing view. You also can edit and delete custom views.

 
           [bookmark: pgfId-834697]The various views are presented in the Views pane of the Monitoring display, organized into two folders: System Views and My Views (the latter folder contains your custom views). The Monitoring display is described in HPM Window: Monitoring Display.

 
           [bookmark: pgfId-834699]Follow these steps to create a new custom view:

 
           [bookmark: pgfId-834701] 1. In the Views list, select the view on which the new view is to be based.

 
           [bookmark: pgfId-834703]This can be a System View or an existing custom view.

 
           [bookmark: pgfId-834705] 2. Choose Save As from the File menu to open the Save View As dialog box.

 
           [bookmark: pgfId-834707]You also can right-click the selected view and choose Save As from the pop-up menu to open the dialog box.

 
           [bookmark: pgfId-834709] 3. Provide a Name for the new view, and optionally a Description.

 
           [bookmark: pgfId-834711] 4. Specify the devices to be monitored for this view: check and clear entries in the device-selector area of the dialog box.

 
           [bookmark: pgfId-834713] 5. Click Save to close the dialog box and add the new view to the My Views folder.

 
           [bookmark: pgfId-834715] 

 
           [bookmark: pgfId-834717]Follow these steps to edit an existing custom view:

 
           [bookmark: pgfId-834719] 1. Under My Views, select the view.

 
           [bookmark: pgfId-834721] 2. Choose Edit from the File menu to open the Save View As dialog box.

 
           [bookmark: pgfId-834723]You also can right-click the selected view and choose Edit from the pop-up menu.

 
           [bookmark: pgfId-834725] 3. Edit the Name and Description, as necessary.

 
           [bookmark: pgfId-834727] 4. Check and clear entries in the device selector to change the devices monitored for this view.

 
           [bookmark: pgfId-834729] 5. Click Save to close the dialog box.

 
           [bookmark: pgfId-834731] 

 
           [bookmark: pgfId-834733]Follow these steps to delete an existing custom view:

 
           [bookmark: pgfId-834735] 1. Under My Views, select the view.

 
           [bookmark: pgfId-834737] 2. Choose Delete from the File menu.

 
           [bookmark: pgfId-834739]You also can right-click the selected view and choose Delete from the pop-up menu.

 
           [bookmark: pgfId-834741] 3. Confirm that you want the view deleted.

 
           [bookmark: pgfId-834743]That view is removed from the Views list.

 
          
 
           
            [bookmark: pgfId-834751][bookmark: 164256][bookmark: HPMchap_intro_MonitoringDisplay]HPM Window: Monitoring Display [bookmark: marker-834749]

 
           [bookmark: pgfId-834753]The HPM window provides two different information displays: Monitoring and Alerts. Click the Monitoring button to access the Monitoring display.

 
           [bookmark: pgfId-834755]The Monitoring display consists of two primary panes: Views and Monitoring. The Views pane presents a list of available views. Click an entry in this list to open that View as a tabbed panel in the Monitoring pane.

 
           [bookmark: pgfId-834757]The Monitoring pane can present multiple tabbed views, most of which display several sections. Click a tab to bring that view to the front.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-834762]Note The Remote Access Users and the Site-to-Site Tunnels views each display only a single table of information, as described in Monitoring Views: VPN, RA and S2S. The following descriptions focus mainly on the other available system views.


           
            

           

           

 
           [bookmark: pgfId-834764]The following illustration presents the primary features of the Monitoring display and the panel sections.

 
           [bookmark: pgfId-834768]Figure 70-4 [bookmark: 164271]Health and Performance Monitor: the Monitoring Display

 
           [bookmark: pgfId-834772] 
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           [bookmark: pgfId-834774]The Monitoring display consists of five main elements:

 
            
            		 [bookmark: pgfId-834782] Views list (1) – This pane lists all views available—click an entry in this list to open that view in the Monitoring pane. The views are organized into System Views, provided as part of the Health and Performance Monitor, and My Views, which are custom views you have created. See Managing Device Views for information about the Views pane, and Views: Custom for information about managing custom views.

 
            		 [bookmark: pgfId-834784] Monitoring view controls (2) – A labeled tab appears here for each view you open; click any tab to bring that view to the front. You also can use the Scroll Backward and Scroll Forward buttons to step backward or forward through the tabbed views. Alternately, open the Show List drop-down menu on the right and choose a label to make that the active view.

 
            		 [bookmark: pgfId-834789] Summary of all devices or VPNs (3) – Provides aggregate information for all devices or VPNs represented by this view. Expand or collapse this section by clicking the button on the right side. The device-summary section is described in greater detail in Monitoring Views: Devices or VPNs Summary.

 
            		 [bookmark: pgfId-834797] Device-status list (4) – All devices or VPNs included in this view are listed here; see Monitoring Views: Device or VPN Status List for more information about this list. Use the List Filter field in this section to filter the list, as described in Using The List Filter Fields.

 
            		 [bookmark: pgfId-834802] Selected device or VPN details (5) – This section provides detailed information about the device or VPN currently highlighted in the device list. The details section is described in greater detail in Monitoring Views: Device or VPN Details.

 
           

 
           [bookmark: pgfId-834804]This section contains the following topics:

 
            
            		 [bookmark: pgfId-834809]Monitoring Views: Devices or VPNs Summary

 
            		 [bookmark: pgfId-834814]Monitoring Views: Device or VPN Status List

 
            		 [bookmark: pgfId-834819]Monitoring Views: Device or VPN Details

 
            		 [bookmark: pgfId-834824]Monitoring Views: VPN, RA and S2S

 
            		 [bookmark: pgfId-834829]Exporting HPM Data

 
           

 
          
 
           
            [bookmark: pgfId-834837][bookmark: 164338][bookmark: HPMchap_cncpt_MonitoringDevicesSummary]Monitoring Views: Devices or VPNs Summary [bookmark: marker-834835]

 
           [bookmark: pgfId-834842]The HPM Monitoring display presents tabbed views, each of which provides detailed information about the device or VPN currently selected, as described in HPM Window: Monitoring Display. All device-related views (that is, all but the Remote-Access Users and Site-to-Site Tunnels views), include a Summary section, as described here.

 
           [bookmark: pgfId-834844]This devices summary, or VPN Summary, which you can show and hide by clicking the button on the right side of its title bar, displays a snapshot of the aggregate Health Status and Alert Status for all the devices or VPNs relevant to the current view. For example, if you are viewing the Firewall Devices panel, the status summaries are for all monitored firewall devices only.

 
          
 
           
            [bookmark: pgfId-834854][bookmark: 164348][bookmark: HPMchap_cncpt_MonitoringDeviceStatusList]Monitoring Views: Device or VPN Status List[bookmark: marker-834850][bookmark: marker-834852]

 
           [bookmark: pgfId-834859]The HPM Window: Monitoring Display presents detailed information about the device or VPN currently selected (in a specific device view, or the VPN Summary view, respectively). All device-related views and the VPN Summary view include a table of monitored devices or VPNs relevant to the current view.

 
           [bookmark: pgfId-834861]This table displays “at-a-glance” status information for every monitored device or VPN—each is represented by an entry in this table. Note that ASA clusters are presented as expandable entries: click the + icon in front of the cluster entry to expand it and view indented entries for each cluster node.

 
           [bookmark: pgfId-834863]Again, the list includes only those elements relevant to the current view. For example, the list in the Firewall Devices view does not include entries for IPS devices. The Remote-Access Users and Site-to-Site Tunnels views do not include this status display.

 
           [bookmark: pgfId-834868]You can resize the table columns, you can show and hide columns, and the column headings are menus you can use to filter the table by hiding or showing devices according to chosen parameters. See Showing and Hiding Table Columns for more information about these options.

 
           [bookmark: pgfId-834873]When you select an entry in this list, detailed information for that device is displayed in the device-details area below the table, as described in Monitoring Views: Device or VPN Details.
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           [bookmark: pgfId-834882]Tip [bookmark: marker-834875][bookmark: marker-834877]With the All Devices, Firewall Devices, IPS Devices, and Priority Devices views (and any custom device-related views), you can right-click the highlighted entry and choose Device Manager from the pop-up menu to open the appropriate external device manager for that device—that is, ASDM for an ASA, and IDM for an IPS sensor—where you can “drill down” into the health and performance data for that device. See Starting Device Managers for more information about the device managers.


           
            

           

           

 
          
 
           
            [bookmark: pgfId-834892][bookmark: 164377][bookmark: HPMchap_cncpt_MonitoringDeviceDetails]Monitoring Views: Device or VPN Details [bookmark: marker-834888][bookmark: marker-834890]

 
           [bookmark: pgfId-834897]The HPM Window: Monitoring Display presents views and detailed information about the currently selected device or VPN. All device-related views and the VPN Summary view provide three or four tabbed panels of detailed information for the individual device or VPN currently selected in the device-status table above it. (The Remote-Access Users and Site-to-Site Tunnels views do not provide this details panel.)

 
           [bookmark: pgfId-834899]The information presented for each type of view follows.

 
            
            		 [bookmark: pgfId-834901]For the All Devices, Firewall Devices, IPS Devices, Priority Devices, and custom device-related views, the tabbed panels are:

 
           

 
           [bookmark: pgfId-834903] – Summary - The Summary tab consists of four sections that provide information about the device and the device’s status:

 
           [bookmark: pgfId-834905] – Device Information – This section provides a read-only listing of device-specific information such as device name, IP address, device type and model number, and so on. A read-only listing of Failover information is also presented. If an ASA cluster is selected, the Failover listing is replaced with a listing of cluster-related information.

 
           [bookmark: pgfId-834910] – Device Report Card - This section provides a collection of metrics that indicate the current status of the device. For more information about the metrics shown here, see Table Columns: Device-related Views.

 
           [bookmark: pgfId-834912] – Interface Status – This section provides a listing of all interfaces defined on the device, with current status information.

 
           [bookmark: pgfId-834914] – Device Health Graphs - This section provides a “snapshot” of device status using graphic displays for certain metrics such as CPU and memory usage. It also presents device-specific traffic information, for example, average number of connections and number of translations for firewall devices (over the most-recent polling period), and average inspection load and percentage of missed packets for IPS sensors (over the most-recent polling period).

 
           [bookmark: pgfId-834916]You can specify the time frame (Last 1 hour, Last 24 hours, or Last 7 days) to use for these graphs from the Time Frame list. You can focus in on a specific time frame by using the slider bar above the graphs.

 
           [bookmark: pgfId-834918]To view events for the selected device, click the View Events button. Event Viewer opens and the Event Monitoring window lists events filtered by the selected device and the time period specified by the slider bar.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-834923]Note For IPS devices, certain health-metric thresholds must be configured separately on the individual devices—that is, outside of HPM. Therefore, it is possible for the health of an IPS device to be critical, for example, without any indication in HPM. See Alerts Configuration: IPS for additional information.


           
            

           

           

 
           [bookmark: pgfId-834931] – Alerts - The Alerts tab lists all alerts for the selected device. You can show and hide various columns of information for each alert. See Alerts and Notifications for more information about alerts. For information about the fields available on this tab, see HPM Window: Alerts Display.

 
            
            		 [bookmark: pgfId-834933]For the VPN Summary view, the tabbed panels are:

 
           

 
           [bookmark: pgfId-834935] – VPN Usage – Several graphs presenting information such as active site-to-site tunnels, active remote-access sessions, and total throughput. This includes historical trending information for active Site-to-Site tunnels, active IPSec remote-access users, active SSL VPN clientless users, and active SSL VPN with client users.

 
           [bookmark: pgfId-834937] – License Information – A read-only listing of license information by VPN type, or IPSec and SSL license and load information, depending on your selection in the table above. For the System context of a multiple-mode device, VPN Licensing and allocation are shown; for individual contexts, VPN allocation Limits and VPN licensing usage are shown.

 
           [bookmark: pgfId-834939] – Other Details – A listing of certificate and TrustPoint details.

 
           [bookmark: pgfId-834944]See Managing Monitored Devices for information about selecting devices for VPN monitoring.

 
          
 
           
            [bookmark: pgfId-834952][bookmark: 164436][bookmark: HPMchap_cncpt_MonitoringS2SRAViews]Monitoring Views: VPN, RA and S2S [bookmark: marker-834950]

 
           [bookmark: pgfId-834957]The HPM Monitoring display presents a variety of device- and VPN-related data views, as described in HPM Window: Monitoring Display. These include the Remote Access Users and Site-to-Site Tunnels views, which unlike the other views, are simply tables of current users and tunnels.

 
           [bookmark: pgfId-834962]See Managing Monitored Devices for information about selecting devices for VPN monitoring.

 
           [bookmark: pgfId-834967]In both of these views, you can resize the table columns, you can show and hide columns, and the column headings are menus you can use to filter the table by hiding or showing entries according to chosen parameters. See Showing and Hiding Table Columns for more information about these options.

 
           [bookmark: pgfId-834969]The Remote Access Users view lists the remote-access users currently logged into network resources via the devices being monitored by HPM. Note that remote-access user information is updated every 20 minutes (for normal monitoring; for Priority monitoring the interval is 15 minutes), rather than the five minutes that is standard for the other views. Also, no historical or trending data is available for remote-access users.

 
           [bookmark: pgfId-834971]Further, you may notice a mismatch between RA user count in the VPN Summary view and the Remote Access Users view. This is because the VPN Summary is updated at ten-minute/five-minute (normal/Priority) intervals.
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           [bookmark: pgfId-834977]Tip [bookmark: marker-834973][bookmark: marker-834975]In the Remote Access Users view, you can right-click a user entry and choose Log Off User from the pop-up menu to terminate that remote-access connection.


           
            

           

           

 
           [bookmark: pgfId-834982]The Site-to-Site Tunnels view provides current VPN tunnel information through all monitored devices. Note that to enable tunnel Up/Down alerts for a device or context, you must configure SNMPv3 on the device, as described in SNMP Credentials Dialog Box.
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           [bookmark: pgfId-834984]Tip In the Site-to-Site Tunnels view, you can click on a Down notification hyperlink in the Status column to view the IPSec VPN Events for that device in Event Viewer. Event Viewer will show IPSec VPN Events for the device within a time range depending on the polling interval for that device. If it is a priority device, the time range will be 5 minutes before until 5 minutes after the first down notification was received. For non-priority devices, the time range will be +/- 10 minutes instead of 5 minutes.


           
            

           

           

 
           [bookmark: pgfId-834986]For clusters of ASA 9.0+ devices, information is shown for the master device only, since VPN processing is not load-balanced across the nodes and is thus limited to centralized support in the cluster.
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           [bookmark: pgfId-834988]Note VPN polling occurs on a fixed time interval, so it is not possible to log status changes within that time interval. For example, if a site-to-site tunnel goes down immediately after polling and comes back up just before the next poll, that status change cannot be detected.


           
            

           

           

 
          
 
           
            [bookmark: pgfId-835006][bookmark: 164468][bookmark: HPMchap_proc_ExportData]Exporting HPM Data [bookmark: marker-834996][bookmark: marker-834998][bookmark: marker-835000][bookmark: marker-835002][bookmark: marker-835004]

 
           [bookmark: pgfId-835008]You can save a “snapshot” of the device-status information in the current View as a PDF, HTML, or CSV (comma-separated values) file.
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           [bookmark: pgfId-835010]Note Beginning with Security Manager version 4.9, the exported data in PDF, HTML, or CSV format also contain the IPv6 tunnel information.


           
            

           

           

 
           [bookmark: pgfId-835012]The following steps describe exporting the current View data in either a PDF, HTML, or CSV file:

 
           [bookmark: pgfId-835014]Related Topics

 
            
            		 [bookmark: pgfId-835019]HPM Window

 
            		 [bookmark: pgfId-835024]Showing and Hiding Table Columns

 
           

 
           
 
           [bookmark: pgfId-835026]Step 1 Click the appropriate tab to display the View you want to export (that is, Priority Devices, VPN Summary, All Devices, or another).
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           [bookmark: pgfId-835031]Tip To export the data for a subset of all entries in a particular view, create a custom view that includes only the desired devices. See Views: Custom for information.


           
            

           

           

 
           [bookmark: pgfId-835033]Step 2 Click the down-arrow beside the Export button next to the List Filter field (above the device- or VPN-status list) and choose As PDF, As HTML, or As CSV from the drop-down menu.

 
           [bookmark: pgfId-835035]The Export dialog box opens.

 
           [bookmark: pgfId-835037]Step 3 Select the specific information to be exported by checking the appropriate columns in the dialog box.

 
           [bookmark: pgfId-835039]The following topics describe the individual columns available for various views:

 
            
            		 [bookmark: pgfId-835044]Table Columns: Device-related Views

 
            		 [bookmark: pgfId-835049]Table Columns: VPN-related Views

 
           

 
           [bookmark: pgfId-835051]Step 4 If you chose As PDF from the Export drop-down list, at the bottom of the Export dialog box you can choose the desired Page Size for the PDF file: A1, A2, A4, Letter, or Legal.

 
           [bookmark: pgfId-835053]The pages of the PDF file will be the selected size, with the presented information formatted accordingly.

 
           [bookmark: pgfId-835055]Step 5 If you chose As CSV from the Export drop-down list, Security Manager exports the information in a CSV file that you can save as required. Beginning with version 4.8, Security Manager provides the Export Trend Charts checkbox that you can select to export trend information in CSV file format. You can then chose the Time Frame from available time range of last one hour, last 24 hours, and last seven days.

 
           [bookmark: pgfId-835057]Step 6 Click Export to close the Export dialog box.

 
           [bookmark: pgfId-835059]The Save file dialog box opens.

 
           [bookmark: pgfId-835061]Step 7 Provide a name for the file, and specify where it is to be saved.

 
           [bookmark: pgfId-835063]The default file name is the current system time (as a long integer); you can change this to something informative. On Windows systems, the default location is My Documents; you can specify any location.

 
           [bookmark: pgfId-835065]Step 8 Click Save to close the Save dialog box and export the selected data.

 
           [bookmark: pgfId-835067]


           
            

           
 
           

 
          
 
         
 
          
           [bookmark: pgfId-835081][bookmark: 164542][bookmark: HPMchap_intro_Alerts]Alerts and Notifications [bookmark: marker-835075][bookmark: marker-835077][bookmark: marker-835079]

 
          [bookmark: pgfId-835083]The Health and Performance Monitor (HPM) provides trend information, alerts, and notifications regarding the performance and health of monitored devices. You can monitor the overall health of your network—including network user and device resource utilization—by quickly scanning the status of individual devices and groups of devices.

 
          [bookmark: pgfId-835085]Specific device-level trend information is available for hourly, daily and weekly intervals. Alerts are displayed prominently, with easy navigation to the relevant HPM data. You also can acknowledge and annotate individual alerts.

 
           
           [image: ] 
          
 
          
 
          [bookmark: pgfId-835087]Note When a node from a cluster is deleted and then the cluster is rediscovered in Security Manager, the node will be removed from monitoring in HPM if currently enabled. However, any alerts generated on the node will still be shown in HPM. You must manually clear the alerts from HPM.


          
           

          

          

 
          [bookmark: pgfId-835089]These alerts are based on threshold values and state-change rules that you have configured: you specify thresholds that define Critical, Warning, and Normal levels for various metrics, and you can configure rules for certain state changes such as interface failure.

 
          [bookmark: pgfId-835091]Further, there are two levels of device monitoring. Initially all devices are unmonitored. However, you can designate devices to be monitored at a “normal” level, or at a “Priority” level—you define a separate set of alert definitions for each level. Priority devices are polled and reported on more frequently (five-minute intervals versus ten for “normal” devices), and failure parameters are more stringent.

 
          [bookmark: pgfId-835093]You also can enable email alert notifications. If configured, an email is sent to the specified address(es) whenever an alert is generated. You can provide multiple addresses for each category of alerts (Firewall and IPS).

 
           
           [image: ] 
          
 
          
 
          [bookmark: pgfId-835095]Note An email notification is sent the first time an alert is logged, and when the severity of an alert changes from warning to critical (but not vice-versa). No notification is issued if a device returns to the Normal state.


          
           

          

          

 
          [bookmark: pgfId-835097]This section contains the following topics:

 
           
           		 [bookmark: pgfId-835102]HPM Window: Alerts Display

 
           		 [bookmark: pgfId-835107]Alerts: Configuring

 
           		 [bookmark: pgfId-835112]Alerts: Viewing

 
           		 [bookmark: pgfId-835117]Alerts: History

 
          

 
           
            [bookmark: pgfId-835127][bookmark: 164564][bookmark: HPMchap_cncpt_AlertsDisplay]HPM Window: Alerts Display [bookmark: marker-835125]

 
           [bookmark: pgfId-835129]The HPM window provides two different information displays: Monitoring and Alerts. Click the Alerts button to access the Alerts display.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-835134]Note A device-specific view of alert data is available on the Alerts tab when viewing details for a specific device (see Monitoring Views: Device or VPN Details). With a few exceptions, you can perform many of the same functions from the device-specific alert view as you can from the primary Alerts display.


           
            

           

           

 
           [bookmark: pgfId-835136]The following illustration presents the primary features of the Alerts display.

 
           [bookmark: pgfId-835138]Related Topics

 
            
            		 [bookmark: pgfId-835143]Alerts: Configuring

 
           

 
           [bookmark: pgfId-835147]Figure 70-5 [bookmark: 164583]Health and Performance Monitor: Alerts Display

 
           [bookmark: pgfId-835151] 
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                 [bookmark: pgfId-832576]1
                
  
               		[bookmark: pgfId-832578]Alerts button.

  
               		
                 
                 [bookmark: pgfId-832580]5
                
  
               		[bookmark: pgfId-832582]Clear button.

  
              

 
               
               		
                 
                 [bookmark: pgfId-832592]2
                
  
               		[bookmark: pgfId-832594]List Filter field.

  
               		
                 
                 [bookmark: pgfId-832596]6
                
  
               		[bookmark: pgfId-832598]Acknowledge button.

  
              

 
               
               		
                 
                 [bookmark: pgfId-832608]3
                
  
               		[bookmark: pgfId-832610]Alerts table.

  
               		
                 
                 [bookmark: pgfId-832612]7
                
  
               		[bookmark: pgfId-832614]View Cleared Alerts button.

  
              

 
               
               		
                 
                 [bookmark: pgfId-832624]4
                
  
               		[bookmark: pgfId-832626]Refresh button.

  
               		[bookmark: pgfId-832628] 

  
               		[bookmark: pgfId-832630] 

  
              

 
             
            

 
           
 
           [bookmark: pgfId-835153]The Alerts display consists of seven main elements:

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-835158]Note With the exception of the List Filter field and the View Cleared Alerts button, these same elements are available to you on the Alerts tab when viewing details for a specific device (see Monitoring Views: Device or VPN Details).


           
            

           

           

 
            
            		 [bookmark: pgfId-835160] Alerts button (1) – The HPM window displays either Monitoring information for devices and VPNs, or a table of alerts generated by monitored devices. Click the Alerts button to view the alerts table.

 
            		 [bookmark: pgfId-835165] List Filter field (2) – You can use this field to filter the alerts displayed in the table; only those alerts containing the specified text are listed. Refer to Using The List Filter Fields for more information.

 
            		 [bookmark: pgfId-835170] Alerts table (3) – This table lists all alerts for all currently monitored devices. The alerts displayed can be filtered using the List Filter field. You also can show and hide various columns of information for each alert. See Alerts and Notifications for more information.

 
            		 [bookmark: pgfId-835172] Refresh button (4) – Click this button to update all alerts ahead of the normal polling cycles.

 
            		 [bookmark: pgfId-835174] Clear button (5) – When one or more alerts are selected, you can click this button to open the Clear dialog box. Click the Clear button in the dialog box to close it and clear the highlighted alerts from the table.
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           [bookmark: pgfId-835179]Note See Alerts: Acknowledging and Clearing for additional information about clearing and acknowledging alerts.


           
            

           

           

 
            
            		 [bookmark: pgfId-835181] Acknowledge button (6) – When one or more alerts are selected, you can click this button to open the Acknowledge dialog box. If desired, you can enter a note that will be applied to the selected alerts. Click the Acknowledge button to close the dialog box and mark all highlighted alerts as acknowledged.

 
           

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-835183]Tip You can add a note to any previously acknowledged alert. Click the Note field for that alert to open the Enter Notes dialog box. This is the only method of accessing the Enter Notes dialog box.


           
            

           

           

 
            
            		 [bookmark: pgfId-835188] View Cleared Alerts button (7) – Click this button to open the View Cleared Alerts window where you can access and view previously cleared alerts; you specify a set of devices and a time range. See Alerts: History for more information about using this window.

 
           

 
          
 
           
            [bookmark: pgfId-835200][bookmark: 164671][bookmark: HPMchap_proc_AlertsConfiguring]Alerts: Configuring [bookmark: marker-835196][bookmark: marker-835198]

 
           [bookmark: pgfId-835202]The alerts and email notifications provided by HPM are based on threshold values and state-change rules that you configure in the Alerts Configuration dialog box.

 
           [bookmark: pgfId-835204]The Alerts Configuration dialog box consists of three tabbed panels: IPS for IPS sensor-related alerts, FW for firewall-related alerts, and VPN for tunnel-status alerts. Each panel presents groups of options in sections—use the expand/collapse button to show or hide a particular section.
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           [bookmark: pgfId-835206]Note You can enable and disable a particular alert without expanding that section; simply check or clear the box preceding the section heading—the current settings are used and retained.


           
            

           

           

 
           [bookmark: pgfId-835211]There are two levels of device monitoring: normal or “standard” priority and “active” priority. Active priority devices are polled and reported on more frequently, and failure parameters are more stringent. You can designate up to 10% of all monitored devices for Priority monitoring. See Managing Monitored Devices for more information about device selection.

 
           [bookmark: pgfId-835213]Follow these steps to configure alert reporting and notifications for both Standard and Priority devices:

 
           
 
           [bookmark: pgfId-835215]Step 1 Choose Alert Configuration from the Tools menu to open the Alerts Configuration dialog box.

 
           [bookmark: pgfId-835217]Step 2 On the IPS panel, configure IPS-related alerts—if necessary, click the IPS tab to display the panel.

 
           [bookmark: pgfId-835219] 1. To enable email Notifications when IPS alerts are generated, enter one or more valid addresses in the Email Addresses field; separate multiple addresses with commas.

 
           [bookmark: pgfId-835224] 2. Use the checkboxes in the section headings to enable and disable specific alerts. Expand a section to update those alert definitions. The IPS parameters are described in Alerts Configuration: IPS.
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           [bookmark: pgfId-835226]Note An email notification is sent the first time an alert is logged, and when the severity of an alert changes from warning to critical (but not vice-versa). No notification is issued if a device returns to the Normal state.


           
            

           

           

 
           [bookmark: pgfId-835228]Step 3 On the FW panel, configure firewall-related alerts—click the FW tab to display the panel.

 
           [bookmark: pgfId-835230] 1. To enable email Notifications when firewall alerts are generated, enter one or more valid addresses in the Email Addresses field; separate multiple addresses with commas.

 
           [bookmark: pgfId-835235] 2. Use the checkboxes in the section headings to enable and disable specific alerts. Expand a section to update those alert definitions. The FW parameters are described in Alerts Configuration: Firewall.

 
           [bookmark: pgfId-835237]Step 4 On the VPN panel, configure tunnel-status alerts—click the VPN tab to display the panel.

 
           [bookmark: pgfId-835239] 1. To enable email Notifications when tunnel-down alerts are generated, enter one or more valid addresses in the Email Addresses field; separate multiple addresses with commas.

 
           [bookmark: pgfId-835244] 2. Use the checkbox in the section heading to enable and disable tunnel-status alerts. Expand the section to update those alert definitions. The VPN parameters are described in Alerts Configuration: VPN.
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           [bookmark: pgfId-835249]Note To enable these tunnel-status alerts for a device or context, you must first configure SNMP on the device, as described in Configuring SNMP for S2S Polling.


           
            

           

           

 
           [bookmark: pgfId-835251]Step 5 Click Save to save your changes and close the dialog box.

 
           [bookmark: pgfId-835253]


           
            

           
 
           

 
          
 
           
            [bookmark: pgfId-835261][bookmark: 164737][bookmark: HPMchap_cncpt_AlertsConfigIPS]Alerts Configuration: IPS [bookmark: marker-835259]

 
           [bookmark: pgfId-835266]The alerts and status information collected from monitored IPS devices are configured on the IPS panel of the Alerts Configuration dialog box. Refer to Alerts: Configuring for information about opening the dialog box, accessing the IPS panel, and providing email addresses for IPS-related Notifications.

 
           [bookmark: pgfId-835268]The IPS-alert configuration parameters are grouped into sections that can be expanded and collapsed. Each section includes a checkbox next to its heading; use this checkbox to enable or disable that alert. When expanded, each section provides access to the settings used to define the alert.

 
           [bookmark: pgfId-835273]The IPS alert and status configuration parameters are described in the following table. Each parameter can be configured separately for Priority Devices and Standard Devices. (Specifying devices for priority and standard monitoring is described in Managing Monitored Devices.)
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           [bookmark: pgfId-835275]Note Some of the following alert settings require specific related parameters to be configured on the monitored IPS sensors themselves. For example, if license-expiration-policy (health-monitor command) is not enabled on a particular sensor, license-expiration messages are not generated by that sensor and therefore no occurrences are tallied for it by HPM.


           
            

           

           

 
           [bookmark: pgfId-835278] 

 
            
             
              
              [bookmark: pgfId-832643]Table 70-4 [bookmark: 164755]IPS Alerts Configuration 

 
              
             
               
               		[bookmark: pgfId-832649]Setting

  
               		[bookmark: pgfId-832651]Description

  
              

 
               
               		[bookmark: pgfId-832657]Collaboration App Status

  
               		[bookmark: pgfId-832659]Errors generated by the Collaboration App application are tallied. Alerts and Notifications are generated when the number of errors tallied reaches the specified Occurrences value.

  
              

 
               
               		[bookmark: pgfId-832665]Sensor App Status

  
               		[bookmark: pgfId-832667]Errors generated by the Sensor App application are tallied. Alerts and Notifications are generated when the number of events reaches the specified Occurrences value.

  
              

 
               
               		[bookmark: pgfId-832673]Bypass Mode

  
               		[bookmark: pgfId-832675]Any time bypass mode is triggered, one Occurrence is tallied for this setting. Alerts and Notifications are generated when the number of Occurrences reaches the value specified.

  
              

 
               
               		[bookmark: pgfId-832681]Interface Status

  
               		[bookmark: pgfId-832683]The status of each enabled interface is polled periodically. Each “down” result for any given interface is tallied as one Occurrence for that interface. Alerts and Notifications are generated when the number of Occurrences reaches the value specified.

  
              

 
               
               		[bookmark: pgfId-832689]License Expiration

  
               		[bookmark: pgfId-832691]A license-expiration threshold can be configured on each IPS sensor, and whenever this threshold is crossed, a status message is issued.

  
              

 
               
               		[bookmark: pgfId-832697]Memory Usage

  
               		[bookmark: pgfId-832699]A memory-usage threshold can be configured on each IPS sensor, and whenever this threshold is exceeded, a status message is issued.

 [bookmark: pgfId-832701]An Occurrence is tallied for each memory-usage message. Alerts and Notifications are generated when the number of Occurrences reaches the value specified here.

  
              

 
               
               		[bookmark: pgfId-832707]Missed Packets

  
               		[bookmark: pgfId-832709]A missed-packets threshold can be configured on each IPS sensor, and whenever this threshold is exceeded, a status message is issued.

 [bookmark: pgfId-832711]An Occurrence is tallied for each missed-packets message. Alerts and Notifications are generated when the number of Occurrences reaches the value specified here.

  
              

 
               
               		[bookmark: pgfId-832717]Inspection Load

  
               		[bookmark: pgfId-832719]A traffic inspection-load threshold can be configured on each IPS sensor, and whenever this threshold is exceeded, a status message is issued.

 [bookmark: pgfId-832721]An Occurrence is tallied for each load-exceeded message. Alerts and Notifications are generated when the number of Occurrences reaches the value specified.

  
              

 
             
            

 
           
 
          
 
           
            [bookmark: pgfId-835286][bookmark: 164817][bookmark: HPMchap_cncpt_AlertsConfigFW]Alerts Configuration: Firewall [bookmark: marker-835284]

 
           [bookmark: pgfId-835291]The alerts and status information collected from monitored firewall devices are configured on the FW panel of the Alerts Configuration dialog box. Refer to Alerts: Configuring for information about opening the dialog box, accessing the FW panel, expanding and collapsing sections, and providing email addresses for FW-related Notifications.

 
           [bookmark: pgfId-835293]The firewall-alert configuration parameters are grouped into sections that can be expanded and collapsed. Each section includes a checkbox next to its heading; use this checkbox to enable or disable that alert. When expanded, each section provides access to the settings used to define the alert.

 
           [bookmark: pgfId-835295]Some section headings also include Consider for Device Health checkboxes. Checking one of these boxes means that particular information is considered when determining overall health of each device.

 
           [bookmark: pgfId-835297]The FW alert and status configuration parameters are described in the following table.

 
           [bookmark: pgfId-835300] 

 
            
             
              
              [bookmark: pgfId-832734]Table 70-5 [bookmark: 164833]Firewall Alerts Configuration 

 
              
             
               
               		[bookmark: pgfId-832740]Setting

  
               		[bookmark: pgfId-832742]Description

  
              

 
               
               		[bookmark: pgfId-832748]Failover Peer Status

  
               		[bookmark: pgfId-832750]The status of the link to the device’s failover peer is polled periodically. Each failed contact attempt is tallied as one Occurrence. Alerts and notifications are generated when the number of occurrences reaches the values specified here.

 [bookmark: pgfId-832752]For Priority devices and for Standard devices: choose Critical or Warning to specify the type of alert generated, and then specify the number of occurrences necessary to trigger the alert.

  
              

 
               
               		[bookmark: pgfId-832758]Interface Status

  
               		[bookmark: pgfId-832760]The status of each enabled interface is polled periodically. Each “down” result for any given interface is tallied as one Occurrence for that interface. This monitoring is per stand-alone device, and per node of an ASA cluster. Alerts and notifications are generated when the number of occurrences reaches the values specified here.

 [bookmark: pgfId-832762]For Priority devices and for Standard devices: choose Critical or Warning to specify the type of alert generated, and then specify the number of occurrences necessary to trigger the alert.

 in the header to include these data in device-health calculations.

  
              

 
               
               		[bookmark: pgfId-832770]Master Changed

  
               		[bookmark: pgfId-832772]An Occurrence is tallied each time the device designated as master node of an ASA cluster changes. Alerts and notifications are generated when the number of occurrences reaches the values specified here.

 [bookmark: pgfId-832774]For Priority devices and for Standard devices: choose Critical or Warning to specify the type of alert generated, and then specify the number of occurrences necessary to trigger the alert.

  
              

 
               
               		[bookmark: pgfId-832780]Cluster Node Status

  
               		[bookmark: pgfId-832782]An Occurrence is tallied each time the Connection Status of an ASA cluster node changes (comes up or goes down). Alerts and notifications are generated when the number of occurrences reaches the values specified here.

 [bookmark: pgfId-832784]For Priority devices and for Standard devices: choose Critical or Warning to specify the type of alert generated, and then specify the number of occurrences necessary to trigger the alert.

  
              

 
               
               		[bookmark: pgfId-832790]CPU Usage

  
               		[bookmark: pgfId-832792]An Occurrence is tallied each time CPU usage exceeds the specified Threshold percentage. This is per stand-alone device; per node of a single-context cluster; and per node for the system context only in a multi-context cluster. Alerts and notifications are generated when the number of occurrences reaches the values specified here.

 in the header to include these data in device-health calculations.

 [bookmark: pgfId-832796]For Priority devices and for Standard devices, you can enable either or both Critical and Warning CPU Usage alerts:

 [bookmark: pgfId-832798] 1. Check the appropriate box to enable the Threshold and Occurrence fields.

 [bookmark: pgfId-832800] 2. Specify a Threshold percentage by clicking the up or down arrows, or by highlighting the existing value and typing a number.

 [bookmark: pgfId-832802] 3. In the Occurrence field, specify the number of times the specified Threshold must be exceeded before the critical or warning alert is issued.

  
              

 
               
               		[bookmark: pgfId-832808]Memory Usage

  
               		[bookmark: pgfId-832810]An Occurrence is tallied each time memory usage exceeds the specified Threshold percentage. This is per stand-alone device; per node of a single-context cluster; and per node for the system context only in a multi-context cluster. Alerts and notifications are generated when the number of occurrences reaches the values specified here.

 in the header to include these data in device-health calculations.

 [bookmark: pgfId-832814]For Priority devices and for Standard devices, you can enable either or both Critical and Warning Memory Usage alerts:

 [bookmark: pgfId-832816] 1. Check the appropriate box to enable the Threshold and Occurrence fields.

 [bookmark: pgfId-832818] 2. Specify a Threshold percentage by clicking the up or down arrows, or by highlighting the existing value and typing a number.

 [bookmark: pgfId-832820] 3. In the Occurrence field, specify the number of times the specified Threshold must be exceeded before the critical or warning alert is issued.

  
              

 
             
            

 
           
 
          
 
           
            [bookmark: pgfId-835308][bookmark: 164931][bookmark: HPMchap_cncpt_AlertsConfigVPN]Alerts Configuration: VPN [bookmark: marker-835306]

 
           [bookmark: pgfId-835313]The generation of alerts for site-to-site (S2S) tunnels on monitored devices and contexts is enabled and configured on the VPN panel of the Alerts Configuration dialog box. Refer to Alerts: Configuring for information about opening the dialog box, accessing the VPN panel, and providing email addresses for VPN-related Notifications.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-835318]Tip When VPN alerts are enabled, HPM polls the monitored devices and contexts at normal and Priority intervals (ten and five minutes, respectively), according to your normal/Priority designations. You also can enable SNMP monitoring which updates HPM tunnel status immediately upon processing the traps. See Configuring SNMP for S2S Polling for more about enabling SNMP processing for HPM.


           
            

           

           

 
           [bookmark: pgfId-835320]The tunnel-status configuration parameters are grouped into a section that can be expanded and collapsed. When expanded, you have access to the alert settings. The checkbox next to the heading is used to enable or disable the alert.

 
           [bookmark: pgfId-835322]The VPN alert parameters are described in the following table.

 
           [bookmark: pgfId-835325] 

 
            
             
              
              [bookmark: pgfId-832833]Table 70-6 [bookmark: 164947]VPN Alerts Configuration 

 
              
             
               
               		[bookmark: pgfId-832839]Setting

  
               		[bookmark: pgfId-832841]Description

  
              

 
               
               		[bookmark: pgfId-832847]Tunnel Status

  
               		[bookmark: pgfId-832849]The status of each monitored S2S tunnel is updated whenever it comes up or goes down, based on periodic polling or SNMP trap processing. Each “down” result for any given tunnel is tallied as one Occurrence. An alert is generated when the number of occurrences reaches the values specified here.

 [bookmark: pgfId-832851]For Priority Devices and for Standard Devices, you can separately configure both Critical and Warning tunnel-down alerts: choose Critical or Warning to specify the type of alert generated, and then in the Occurrence field, specify the number of times a tunnel is down when polled before the critical or warning alert is issued.

  
              

 
             
            

 
           
 
          
 
           
            [bookmark: pgfId-835335][bookmark: 164968][bookmark: HPMchap_cncpt_ConfiguringSNMPforS2SPolling]Configuring SNMP for S2S Polling [bookmark: marker-835331][bookmark: marker-835333]

 
           [bookmark: pgfId-835340]The Health and Performance Monitor (HPM) application uses SNMP to poll site-to-site (S2S) VPN tunnels for up/down status updates. The generation of alerts for site-to-site (S2S) tunnels on monitored devices and contexts is configured on the VPN panel of the HPM Alerts Configuration dialog box. Refer to Alerts: Configuring for information about opening the dialog box, accessing the VPN panel, and providing email addresses for VPN-related Notifications.

 
           [bookmark: pgfId-835342]Configuring SNMP in Security Manager to provide S2S polling is outlined here. The basic steps are:

 
           [bookmark: pgfId-835347] 1. Enable and configure SNMP on the SNMP Page for the device or individual context; specifically: check Enable SNMP Servers and provide and confirm the Read Community String.

 
           [bookmark: pgfId-835352] 2. In the SNMP Trap Configuration Dialog Box, check IPSEC Start and IPSEC Stop on the Other panel.

 
           [bookmark: pgfId-835357] 3. In the Add/Edit SNMP Host Access Entry Dialog Box, provide Interface Name, IP Address, Community String (and Confirm it), and choose the SNMP Version (1 or 2c).

 
           [bookmark: pgfId-835359]Versions 1, 2c and 3 are supported for S2S polling, but version 3 must be configured separately, as described in the next section.

 
           [bookmark: pgfId-835364] 4. Configure SNMP credentials for the device or individual context in the SNMP Credentials Dialog Box.

 
           [bookmark: pgfId-835366]For versions 1 and 2c, provide and confirm the RO Community String.

 
           [bookmark: pgfId-835368]For version 3, Security Manager supports three modes; which to use is determined from your input:

 
           [bookmark: pgfId-835370] – noauthnopriv (no authentication, no privacy) – User name is mandatory, others are optional.

 
           [bookmark: pgfId-835372] – authnopriv (authentication, no privacy) – User name, Password, Auth Algorithm, and Engine ID are required.

 
           [bookmark: pgfId-835374] – authpriv (authentication and privacy) – User name, Password, Auth Algorithm, Privacy Password, Privacy Algorithm, and Engine ID are required.

 
           [bookmark: pgfId-835376]Again, configuration of SNMP v3 is performed separately, as described in the next section.

 
           [bookmark: pgfId-835378]Configuring SNMP v3 for Security Manager Device

 
           [bookmark: pgfId-835380]You cannot configure SNMP v3 directly in Security Manager; you must use CLI commands or set up a FlexConfig. The steps are:

 
           [bookmark: pgfId-835382] 1. Configure an SNMP server group.

 
           
            [bookmark: pgfId-835384]snmp-server group group-name v3 [auth | noauth | priv]
           

           
            [bookmark: pgfId-835386] 
           

           [bookmark: pgfId-835388]The auth keyword enables packet authentication. The noauth keyword indicates no packet authentication or encryption is being used. The priv keyword enables packet encryption and authentication. There are no default values for the auth or priv keywords.

 
           [bookmark: pgfId-835390] 2. Define a new SNMP user.

 
           
            [bookmark: pgfId-835392]snmp-server user username group-name{v3 [encrypted] 
           

           
            [bookmark: pgfId-835394][auth {md5 | sha]} auth-password 
           

           
            [bookmark: pgfId-835396][priv [des | 3des | aes] [128 | 192 | 256] priv-password]
           

           
            [bookmark: pgfId-835398] 
           

           [bookmark: pgfId-835400]The v3 keyword specifies that the SNMP Version 3 security model is used, and enables the use of the encrypted, priv, and auth keywords. The encrypted keyword indicates the password is in encrypted format. Encrypted passwords must be in hexadecimal format.

 
           [bookmark: pgfId-835402]The auth keyword specifies which authentication level (md5 or sha) is used.

 
           [bookmark: pgfId-835404]The priv keyword specifies the encryption level. There are no default values for the auth or priv keywords.

 
           [bookmark: pgfId-835406]For the encryption algorithm, you can specify either des, 3des, or aes. You can also specify which version of the AES encryption algorithm to use: 128, 192, or 256. The auth-password specifies the authentication user password. The priv-password specifies the encryption user password.

 
           [bookmark: pgfId-835408] 3. Specify the recipient of SNMP notifications.

 
           
            [bookmark: pgfId-835410]snmp-server host interface {hostname | ip_address} [version 3 username]
           

           
            [bookmark: pgfId-835412] 
           

           [bookmark: pgfId-835414]Indicates the interface from which traps are sent. Identifies the name and IP address of the NMS or SNMP manager that can connect to the device.

 
           [bookmark: pgfId-835416]Related Topics

 
            
            		 [bookmark: pgfId-835421]Configuring SNMP

 
           

 
          
 
           
            [bookmark: pgfId-835431][bookmark: 165064][bookmark: HPMchap_cncpt_AlertsViewing]Alerts: Viewing [bookmark: marker-835429]

 
           [bookmark: pgfId-835433]All alerts generated for monitored devices are displayed as a table in an alternate screen of the HPM window. The Alerts table is updated automatically as devices are polled for status information. You can also click the Refresh button, above the table on the right side, to update the table.

 
           [bookmark: pgfId-835438]These alerts are based on the threshold values and state-change rules you have configured. See Alerts: Configuring for more information.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-835443]Note See Managing Monitored Devices for information about specifying the devices to be monitored.


           
            

           

           

 
           [bookmark: pgfId-835445]To switch to the Alerts screen:

 
            
            		 [bookmark: pgfId-835447]Click the  Alerts button below the HPM menu bar.

 
           

 
           [bookmark: pgfId-835449](Click the Monitoring button to return to the Monitoring screen.)

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-835454]Note You can also view alerts that apply to a specific device from the Alerts tab when viewing details for that device (see Monitoring Views: Device or VPN Details).


           
            

           

           

 
           [bookmark: pgfId-835459]The Alerts listing is a basic table, consisting of rows and columns, with each row representing one alert from a given device. Each column provides specific information about that alert: device name, alert severity, time recorded, and so on. (See HPM Window: Alerts Display for more about the Alerts screen.)

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-835464]Note The column headings are menus that you can use to filter the table by hiding or showing alerts according to chosen parameters. For example, you might choose to display alerts for only a particular device, and then choose only critical alerts for that device. See Working with Table Columns for more information.


           
            

           

           

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-835466]Tip You can click on the hyperlink in the Description column for tunnel up/down alerts to view the IPSec VPN Events for that device in Event Viewer. Event Viewer will show IPSec VPN Events for the device within a time range depending on the polling interval for that device. If it is a priority device, the time range will be 5 minutes before until 5 minutes after the first up/down notification was received. For non-priority devices, the time range will be +/- 10 minutes instead of 5 minutes.


           
            

           

           

 
           [bookmark: pgfId-835468]In addition to scrolling the Alerts table, you can view sets of specific alerts:

 
            
            		 [bookmark: pgfId-835473]Use the List Filter field above this table to filter the list. See Using The List Filter Fields for more information.

 
            		 [bookmark: pgfId-835478]Use the View Cleared Alerts window to view previously cleared alerts for a selected set of devices over a specified time range. See Alerts: History for more information.

 
           

 
           [bookmark: pgfId-835480]You also can acknowledge alerts, clear alerts, and edit alert notes:

 
            
            		 [bookmark: pgfId-835485]You can acknowledge an alert, or clear it, as described in Alerts: Acknowledging and Clearing.

 
            		 [bookmark: pgfId-835487]To add to an existing alert note, click Notes field for that entry in the table to open the Enter Notes dialog box—used to view and add notes to an alert. Available only when a single alert with an existing note is selected in the table.

 
           

 
          
 
           
            [bookmark: pgfId-835499][bookmark: 165105][bookmark: HPMchap_cncpt_AlertsAcknowledgeClear]Alerts: Acknowledging and Clearing [bookmark: marker-835495][bookmark: marker-835497]

 
           [bookmark: pgfId-835504]All alerts generated for monitored devices are displayed in the Alerts table, as described in Alerts: Viewing. You can add notes to individual alerts, and you can acknowledge or clear alerts individually or in groups.

 
           [bookmark: pgfId-835506]To select an alert, click that entry in the Alerts table. You can Shift-click another alert to select the group between the two, and you can Ctrl-click various rows to select multiple non-contiguous alerts.

 
           [bookmark: pgfId-835508]When an alert is selected in the table, you can:

 
            
            		 [bookmark: pgfId-835510]Click the  Acknowledge button to open the Acknowledge Alert dialog box, used to add a note to, and then mark the selected alert(s) as acknowledged. You can acknowledge multiple alerts at one time.

 
           

 
           [bookmark: pgfId-835512]Enter text in the Notes field in this dialog box (this is optional), and then click OK. The dialog box closes and the alerts are marked as acknowledged with a timestamp displayed in the Notes column.

 
            
            		 [bookmark: pgfId-835514]Click the  Clear button to open the Clear Alert dialog box, used to add a note to, and then remove the selected entries from the Alerts table.

 
           

 
           [bookmark: pgfId-835516]Enter text in the Notes field in this dialog box (this is optional), and then click OK. The dialog box closes and the selected alerts are removed from the Alerts table.

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-835521]Note Alerts can be cleared automatically by HPM if you change the relevant threshold(s). Like alerts you have cleared, these alerts can be viewed in the View Cleared Alerts window (see Alerts: History).


           
            

           

           

 
           [bookmark: pgfId-835523]Notes and other information for cleared alerts are saved in an Alerts database for 30 days.

 
          
 
           
            [bookmark: pgfId-835533][bookmark: 165136][bookmark: HPMchap_cncpt_AlertsHistory]Alerts: History [bookmark: marker-835531]

 
           [bookmark: pgfId-835538]All alerts generated for monitored devices are displayed as a table in the HPM window. You can filter the table by any visible column parameter, as described in Alerts: Viewing.

 
           [bookmark: pgfId-835543]You also can use the View Cleared Alerts window to access and view previously cleared alerts; you specify a set of devices and a time range. (Clearing alerts is described in Alerts: Acknowledging and Clearing.)

 
            
            [image: ] 
           
 
           
 
           [bookmark: pgfId-835545]Note Notes and other information for cleared alerts is maintained in an Alerts database for 30 days—you cannot access alerts more than 30 days old.


           
            

           

           

 
           [bookmark: pgfId-835547]Follow these steps to open and use the View Cleared Alerts window:

 
           [bookmark: pgfId-835552] 1. In the Alerts screen, click the View Cleared Alerts button next to the List Filter field to open the View Cleared Alerts window. (See Alerts: Viewing for more information about accessing the Alerts screen of the HPM window.)

 
           [bookmark: pgfId-835554] 2. Specify the alert View Settings; these define the set of alerts you wish to view:

 
           [bookmark: pgfId-835556] – Specify the devices of interest; All devices are selected by default. To select a particular set of devices:

 
           [bookmark: pgfId-835558] a. Click the Select button to open the Select Devices dialog box.

 
           [bookmark: pgfId-835560] b. Select the desired device(s); deselect any devices you wish to exclude.

 
           [bookmark: pgfId-835562] c. Click OK to close the Select Devices dialog box.

 
           [bookmark: pgfId-835564] – Specify the types of Alerts to display: select or deselect Critical, Warning and Normal.

 
           [bookmark: pgfId-835566] – Define the desired Time Range by choosing a From date and time, and a To date and time. All alerts with a First Seen time within this range will be displayed.

 
           [bookmark: pgfId-835568]From and To each present a standard drop-down calendar used to select a month and day.

 
           [bookmark: pgfId-835570]Use the time field below each calendar to specify the precise start or end time, respectively. Highlight a digit and click the up or down arrow, or simply type the desired number. You can also click the Now button to specify the present moment.

 
           [bookmark: pgfId-835572] 3. Click the Search button to display the defined set of alerts.

 
           [bookmark: pgfId-835577]Note that the View Cleared Alerts window provides a List Filter field that you can use to filter the cleared-alerts display. Using this field is described in Using The List Filter Fields.

 
           [bookmark: pgfId-835582]Refer to Working with Table Columns for other methods of filtering this table.

 
          
 
         
 
          
           [bookmark: pgfId-835588][bookmark: 165193][bookmark: HPMchap_intro_SNMPtrap]SNMP Trap Forwarding Notification

 
          [bookmark: pgfId-835590]In 4.6 and earlier versions of Security Manager, e-mail notifications were sent to users when Health and Performance Monitor alerts were generated for ASA, IPS, and VPN.

 
          [bookmark: pgfId-835592]This framework has been enhanced for Security Manager 4.7 to send SNMP trap notifications in addition to e-mail notifications. Security Manager 4.7 converts the alerts to traps and sends them to the centralized SNMP trap server. SNMP v1, v2c, and v3 are supported. A trap is generated the first time an alert is seen and again if the severity increases, resulting in a trap being generated a maximum of 2 times, as is done with e-mail notification.

 
          [bookmark: pgfId-835594]SNMP trap forwarding notification has the following pre-requisites:

 
          [bookmark: pgfId-835596] 1. An SNMP trap receiver (server) is available. More than one server can be used for a given Security Manager installation.

 
          [bookmark: pgfId-835598] 2. An ASA device is available.

 
          [bookmark: pgfId-835600] 3. An IPS sensor running IPS 7.0.x or later is available.

 
          [bookmark: pgfId-835602] 4. Health and Performance Monitor is enabled.

 
           
           [image: ] 
          
 
          
 
          [bookmark: pgfId-835604]Tip To verify that Health and Performance Monitor is enabled, navigate to Configuration Manager > Tools > Security Manager Administration... > Health and Performance Monitor.


          
           

          

          

 
          [bookmark: pgfId-835606] 5. Normal or priority monitoring for the ASA device and the IPS sensor Device is enabled in Health and Performance Monitor.

 
          [bookmark: pgfId-835608] 6. The alert settings for firewall, IPS, and VPN are enabled.

 
           
           [image: ] 
          
 
          
 
          [bookmark: pgfId-835610]Tip To enable the alert settings for firewall, IPS, and VPN, navigate to Health and Performance Monitor > Tools > Alert Configuration.


          
           

          

          

 
          [bookmark: pgfId-835612]MIB Documentation

 
          [bookmark: pgfId-835614]The information in this section documents which MIB Security Manager uses to send the trap notification and what OID the user has to look for to get the particular alert information.

 
          [bookmark: pgfId-835616]For the SNMP trap, Security Manager uses "CISCO-DEVICE-EXCEPTION-REPORTING-MIB"

 
          [bookmark: pgfId-835618]The following list contains the OID details and the information that it contains:

 
           
           		 [bookmark: pgfId-835620]iso.org.dod.internet.mgmt.mib-2.system.sysUpTime.0 (shows how long the HPM server has been up and running) – calculated using the formula, System Up time = Current Security Manager server time - HPM Service start up time.

 
           		 [bookmark: pgfId-835622]snmpTrapOID (1.3.6.1.4.1.9.9.224.2.0.1)

 
           		 [bookmark: pgfId-835624].1.3.6.1.4.1.9.9.224.1.1.5.1.2 (lists the alert rule name like memory usage)

 
           		 [bookmark: pgfId-835626].1.3.6.1.4.1.9.9.224.1.1.5.1.3 (constant value of 1, specifies IP address type)

 
           		 [bookmark: pgfId-835628].1.3.6.1.4.1.9.9.224.1.1.5.1.4 (device display name – device type and if any cluster node, then its name)

 
           		 [bookmark: pgfId-835630].1.3.6.1.4.1.9.9.224.1.1.5.1.5 (severity of the alert)

 
           		 [bookmark: pgfId-835632].1.3.6.1.4.1.9.9.224.1.1.5.1.6 (time stamp of the alert) – Current Security Manager server time - Alert first seen time

 
           		 [bookmark: pgfId-835634].1.3.6.1.4.1.9.9.224.1.1.5.1.7 (maximum 1024 char string describing the alert)

 
           		 [bookmark: pgfId-835636].1.3.6.1.4.1.9.9.224.1.1.5.1.8 (Security Manager Server name)

 
          

 
          [bookmark: pgfId-835638]This section contains the following topics:

 
           
           		 [bookmark: pgfId-835643]SNMP Trap Entries Dialog Box

 
           		 [bookmark: pgfId-835648]Add/Edit/Copy SNMP Trap Entries Dialog Box

 
          

 
           
            [bookmark: pgfId-835656][bookmark: 165237][bookmark: HPMchap_SNMPTrapEntriesDialogBox]SNMP Trap Entries Dialog Box

 
           [bookmark: pgfId-835658]Use the SNMP Trap Entries dialog box as your launching point for SNMP trap forwarding notifications.

 
           [bookmark: pgfId-835660]Navigation Path

 
           [bookmark: pgfId-835662]In Health and Performance Monitor, select SNMP Trap Configuration from the Tools menu. The SNMP Trap Entries dialog box contains the following areas:

 
            
            		 [bookmark: pgfId-835664]The Settings table, which displays the traps that are currently configured.

 
            		 [bookmark: pgfId-835666]Add, Edit, and other options for working with SNMP trap entries.

 
           

 
           [bookmark: pgfId-835668]Field Reference

 
           [bookmark: pgfId-835671] 

 
            
             
              
              [bookmark: pgfId-832864]Table 70-7 [bookmark: 165253]The Settings table and other options in the SNMP Trap Entries dialog box 

 
              
             
               
               		
                 
                 [bookmark: pgfId-832870]Field
                
  
               		
                 
                 [bookmark: pgfId-832872]Description
                
  
              

 
               
               		 [bookmark: pgfId-832878]Forward Trap To table

  
              

 
               
               		[bookmark: pgfId-832886]Status column

  
               		[bookmark: pgfId-832888]Enabled or Disabled. A maximum of 5 trap forwarding hosts can be enabled at any given time.

  
              

 
               
               		[bookmark: pgfId-832894]IP/Host column

  
               		[bookmark: pgfId-832896]IP address or hostname of the centralized SNMP trap server. Neither the local host nor the Security Manager server is allowed to be used as the SNMP server, in order to avoid problems with performance.

  
              

 
               
               		[bookmark: pgfId-832902]PORT column

  
               		[bookmark: pgfId-832904]The port used by the centralized SNMP trap server

  
              

 
               
               		[bookmark: pgfId-832910]SNMP Version column

  
               		[bookmark: pgfId-832912]v1, v2c, or v3. The default value is v2c.

  
              

 
               
               		[bookmark: pgfId-832918]Username column

  
               		[bookmark: pgfId-832920]The username for authentication to the SNMP server

  
              

 
               
               		[bookmark: pgfId-832926]Authentication Algorithm column

  
               		[bookmark: pgfId-832928]MD5 or SHA

  
              

 
               
               		[bookmark: pgfId-832934]Encryption Algorithm column

  
               		[bookmark: pgfId-832936]DES, 3DES, AES128, AES192, and AES256

  
              

 
               
               		[bookmark: pgfId-832942]Add

  
               		[bookmark: pgfId-832944]Used to add a new configuration. The Add button opens the Add Trap Settings dialog box.

  
              

 
               
               		[bookmark: pgfId-832950]Edit

  
               		[bookmark: pgfId-832952]Used to edit an existing configuration. The edit button opens the Edit Trap Settings dialog box.

  
              

 
               
               		[bookmark: pgfId-832958]Copy Settings

  
               		[bookmark: pgfId-832960]Used to copy all the settings in an existing configuration. The Copy Settings button opens the Copy SNMP Trap Settings dialog box.

  
              

 
               
               		[bookmark: pgfId-832966]Delete

  
               		[bookmark: pgfId-832968]Used to delete an existing configuration

  
              

 
               
               		[bookmark: pgfId-832974]Enable

  
               		[bookmark: pgfId-832976]Used to enable an existing configuration

  
              

 
               
               		[bookmark: pgfId-832982]Disable

  
               		[bookmark: pgfId-832984]Used to disable an existing configuration

  
              

 
             
            

 
           
 
          
 
           
            [bookmark: pgfId-835679][bookmark: 165333][bookmark: HPMchap_AddEditCopySNMPTrapEntriesDialogBox]Add/Edit/Copy SNMP Trap Entries Dialog Box

 
           [bookmark: pgfId-835681]Use the Add/Edit/Copy SNMP Trap Entries dialog box to add, edit, and otherwise work with and configure SNMP traps.

 
           [bookmark: pgfId-835683]Navigation Path

 
           [bookmark: pgfId-835685]In Health and Performance Monitor, select SNMP Trap Configuration from the Tools menu. Then select Add, Edit, or Copy Settings.

 
           [bookmark: pgfId-835687]The Add/Edit/Copy SNMP Trap Entries dialog box contains the following areas:

 
            
            		 [bookmark: pgfId-835689]The IP/Host and Port area

 
            		 [bookmark: pgfId-835691]The Trap Settings area for FW Alerts, IPS Alerts, and VPN Alerts

 
            		 [bookmark: pgfId-835693]The Trap Settings area for SNMP Options

 
           

 
           [bookmark: pgfId-835695]Field Reference

 
           [bookmark: pgfId-835698] 

 
            
             
              
              [bookmark: pgfId-832997]Table 70-8 [bookmark: 165355]The Trap Settings area and other options in the Add/Edit/Copy SNMP Trap Entries dialog box 

 
              
             
               
               		
                 
                 [bookmark: pgfId-833003]Field
                
  
               		
                 
                 [bookmark: pgfId-833005]Description
                
  
              

 
               
               		[bookmark: pgfId-833011]Trap Settings

  
               		[bookmark: pgfId-833013]Used to select all or only selected alerts for FW, IPS, and VPN, described in the following topics:

 
                 
                 		 [bookmark: pgfId-833018]Alerts Configuration: Firewall

 
                 		 [bookmark: pgfId-833023]Alerts Configuration: IPS

 
                 		 [bookmark: pgfId-833028]Alerts Configuration: VPN

 
                

  
              

 
               
               		 [bookmark: pgfId-833034]SNMP Options

  
              

 
               
               		[bookmark: pgfId-833042]RO Community String

 [bookmark: pgfId-833044](SNMP version v1 and v2c only)

  
               		[bookmark: pgfId-833046]The password used for authentication in SNMP version v1 or v2c.

  
              

 
               
               		[bookmark: pgfId-833052]Group Type

 [bookmark: pgfId-833054](SNMP version v3 only)

  
               		[bookmark: pgfId-833056]NOAUTH, AUTH, or PRIV.

  
              

 
               
               		[bookmark: pgfId-833062]Engine ID

 [bookmark: pgfId-833064](SNMP version v3 only)

  
               		[bookmark: pgfId-833066]The SNMPEngineID identifier used for authentication in v3.

  
              

 
               
               		[bookmark: pgfId-833072]User Name

 [bookmark: pgfId-833074](SNMP version v3 only)

  
               		[bookmark: pgfId-833076]The username for authentication to the SNMP server.

  
              

 
               
               		[bookmark: pgfId-833082]Authentication Password

 [bookmark: pgfId-833084](SNMP version v3 only)

  
               		[bookmark: pgfId-833086]The password for authentication to the SNMP server.

  
              

 
               
               		[bookmark: pgfId-833092]Authentication Protocol

 [bookmark: pgfId-833094](SNMP version v3 only)

  
               		[bookmark: pgfId-833096]MD5 or SHA.

  
              

 
               
               		[bookmark: pgfId-833102]Encryption Password

 [bookmark: pgfId-833104](SNMP version v3 only)

  
               		[bookmark: pgfId-833106]The password for MD5 or SHA encryption.

  
              

 
               
               		[bookmark: pgfId-833112]Encryption Protocol

 [bookmark: pgfId-833114](SNMP version v3 only)

  
               		[bookmark: pgfId-833116]DES, 3DES, AES128, AES192, and AES256.

  
              

 
             
            

 
           
 
           [bookmark: pgfId-835700]NOTE: In order to use AES192, AES256, or 3DES, you must follow these steps:

 
           [bookmark: pgfId-835702] 1. Download the unlimited strength cryptography policy .jar files from http://www.oracle.com/technetwork/ > Downloads > Java SE > Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy Files for JDK/JRE 7. (Click the download button to download the files by accepting the license agreement.)

 
           [bookmark: pgfId-835704] 2. Replace local_policy.jar and US_export_policy.jar on your Security Manager server in the folder CSCOpx\MDC\vms\jre\lib\security.

 
           [bookmark: pgfId-835706] 3. Restart your Security Manager server.
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     [bookmark: pgfId-316214][bookmark: 132565][bookmark: rtintf_intro_ManagingRouterInterfaces]Configuring Router Interfaces
      
      
 
     
 

 
    [bookmark: pgfId-316216]This chapter contains the following topics:

 
     
     		 [bookmark: pgfId-316221]Basic Interface Settings on Cisco IOS Routers

 
     		 [bookmark: pgfId-316226]Router Interfaces Page

 
     		 [bookmark: pgfId-316231]Advanced Interface Settings on Cisco IOS Routers

 
     		 [bookmark: pgfId-316236]Advanced Interface Settings Page

 
     		 [bookmark: pgfId-316241]IPS Module Interface Settings on Cisco IOS Routers

 
     		 [bookmark: pgfId-316246]IPS Module Interface Settings Page

 
     		 [bookmark: pgfId-316251]CEF Interface Settings on Cisco IOS Routers

 
     		 [bookmark: pgfId-316256]CEF Interface Settings Page

 
     		 [bookmark: pgfId-316261]Dialer Interfaces on Cisco IOS Routers

 
     		 [bookmark: pgfId-316266]Dialer Policy Page

 
     		 [bookmark: pgfId-316271]ADSL on Cisco IOS Routers

 
     		 [bookmark: pgfId-316276]ADSL Policy Page

 
     		 [bookmark: pgfId-316281]SHDSL on Cisco IOS Routers

 
     		 [bookmark: pgfId-316286]SHDSL Policy Page

 
     		 [bookmark: pgfId-316291]PVCs on Cisco IOS Routers

 
     		 [bookmark: pgfId-316296]PVC Policy Page

 
     		 [bookmark: pgfId-316301]PPP on Cisco IOS Routers

 
     		 [bookmark: pgfId-316306]PPP/MLP Policy Page

 
    

 
   
 
    
     [bookmark: pgfId-316318][bookmark: 132567][bookmark: rtchap_cncpt_BasicInterfaceSettingsonCiscoIOSRouters]Basic Interface Settings on Cisco IOS Routers[bookmark: marker-316312][bookmark: marker-316314][bookmark: marker-316316]

 
    [bookmark: pgfId-316323]You typically add interfaces to Security Manager by performing discovery, as described in Discovering Policies. After you have discovered the interfaces, you can modify the properties of each interface.

 
    [bookmark: pgfId-316325]You can also use Security Manager to configure physical and virtual interfaces manually. This is useful when you modify interface configurations of existing devices, and makes it possible for you to configure all the interfaces of a device before you physically add the device to the network.

 
    [bookmark: pgfId-316327]Related Topics

 
     
     		 [bookmark: pgfId-316332]Available Interface Types

 
     		 [bookmark: pgfId-316337]Defining Basic Router Interface Settings

 
     		 [bookmark: pgfId-316342]Deleting a Cisco IOS Router Interface

 
    

 
     
      [bookmark: pgfId-316352][bookmark: 132595][bookmark: rtchap_cncpt_AvailableInterfaceTypes]Available Interface Types[bookmark: marker-316348][bookmark: marker-316350]

 
     [bookmark: pgfId-316357]Table 61-1 describes the types of interfaces that can be configured on Cisco IOS routers.

 
     [bookmark: pgfId-316360] 

 
      
       
        
        [bookmark: pgfId-311670]Table 61-1 [bookmark: 132607]Router Interface Types 

 
        
       
         
         		
           
           [bookmark: pgfId-311676]Type
          
  
         		
           
           [bookmark: pgfId-311678]Description
          
  
        

 
         
         		[bookmark: pgfId-311684]Null

  
         		[bookmark: pgfId-311686]Null interface.

  
        

 
         
         		[bookmark: pgfId-311692]Analysis-module

  
         		[bookmark: pgfId-311694]A Fast Ethernet interface that connects to the internal interface on the Network Analysis Module (NAM).

 [bookmark: pgfId-311696]Note You cannot configure parameters such as speed and duplex mode for this type of interface.

  
        

 
         
         		[bookmark: pgfId-311702]Async

  
         		[bookmark: pgfId-311704]Port line used as an asynchronous interface.

  
        

 
         
         		[bookmark: pgfId-311710]ATM

  
         		[bookmark: pgfId-311712]ATM interface.

  
        

 
         
         		[bookmark: pgfId-311718]BRI

  
         		[bookmark: pgfId-311720]ISDN BRI interface. This interface configuration propagates to each B channel. B channels cannot be configured individually.

 [bookmark: pgfId-311725]Note You must configure a dialer interface policy for calls to be placed on a BRI interface. For more information, see Dialer Interfaces on Cisco IOS Routers.

  
        

 
         
         		[bookmark: pgfId-311731]BVI

  
         		[bookmark: pgfId-311733]Bridge-group virtual interface. BVI interfaces are used to route traffic at Layer 3 to the interfaces in a bridge group.

  
        

 
         
         		[bookmark: pgfId-311739]Content-engine

  
         		[bookmark: pgfId-311741]Content engine (CE) network module interface.

 [bookmark: pgfId-311743]Note You cannot configure parameters such as speed and duplex mode for this type of interface. You cannot create subinterfaces for this type of interface.

  
        

 
         
         		[bookmark: pgfId-311749]Dialer

  
         		[bookmark: pgfId-311751]Dialer interface.

  
        

 
         
         		[bookmark: pgfId-311757]Ethernet

  
         		[bookmark: pgfId-311759]Ethernet IEEE 802.3 interface.

  
        

 
         
         		[bookmark: pgfId-311765]Fast Ethernet

  
         		[bookmark: pgfId-311767]100-Mbps Ethernet interface.

  
        

 
         
         		[bookmark: pgfId-311773]FDDI

  
         		[bookmark: pgfId-311775]Fiber Distributed Data Interface.

  
        

 
         
         		[bookmark: pgfId-311781]Gigabit Ethernet

  
         		[bookmark: pgfId-311783]1000-Mbps Ethernet interface.

  
        

 
         
         		[bookmark: pgfId-311789]Group-Async

  
         		[bookmark: pgfId-311791]Master asynchronous interface. This interface type creates a single asynchronous interfaces to which other interfaces are associated. This one-to-many configuration enables you to configure all associated member interfaces by configuring the master interface.

  
        

 
         
         		[bookmark: pgfId-311797]HSSI

  
         		[bookmark: pgfId-311799]High-Speed Serial Interface.

  
        

 
         
         		[bookmark: pgfId-311805]Loopback

  
         		[bookmark: pgfId-311807]A logical interface that emulates an interface that is always up. For example, having a loopback interface on the router prevents a loss of adjacency with neighboring OSPF routers if the physical interfaces on the router go down.

 [bookmark: pgfId-311809]The name of a loopback interface must end with a number ranging from 0-2147483647.

 [bookmark: pgfId-311811]Note This interface type is supported on all platforms. You can create an unlimited number of loopback interfaces.

  
        

 
         
         		[bookmark: pgfId-311817]Multilink

  
         		[bookmark: pgfId-311819]Multilink interface. A logical interface used for multilink PPP (MLP).

  
        

 
         
         		[bookmark: pgfId-311825]Port channel

  
         		[bookmark: pgfId-311827]Port channel interface. This interface type enables you to bundle multiple point-to-point Fast Ethernet links into one logical link. It provides bidirectional bandwidth of up to 800 Mbps.

  
        

 
         
         		[bookmark: pgfId-311833]POS

  
         		[bookmark: pgfId-311835]Packet OC-3 interface on the Packet-over-SONET (POS) interface processor.

  
        

 
         
         		[bookmark: pgfId-311841]PRI

  
         		[bookmark: pgfId-311843]ISDN PRI interface. Includes 23/30 B-channels and one D-channel.

  
        

 
         
         		[bookmark: pgfId-311849]Serial

  
         		[bookmark: pgfId-311851]Serial interface.

  
        

 
         
         		[bookmark: pgfId-311857]Switch

  
         		[bookmark: pgfId-311859]Switch interface.

  
        

 
         
         		[bookmark: pgfId-311865]Ten Gigabit Ethernet

  
         		[bookmark: pgfId-311867]10000-Mbps Ethernet interface.

  
        

 
         
         		[bookmark: pgfId-311873]Token Ring

  
         		[bookmark: pgfId-311875]Token Ring interface.

  
        

 
         
         		[bookmark: pgfId-311881]Tunnel

  
         		[bookmark: pgfId-311883]Tunnel interface.

 [bookmark: pgfId-311885]Note You can create an unlimited number of virtual, tunnel interfaces. Valid values range from 0-2147483647.

  
        

 
         
         		[bookmark: pgfId-311891]VG-AnyLAN

  
         		[bookmark: pgfId-311893]100VG-AnyLAN port adapter.

  
        

 
         
         		[bookmark: pgfId-311899]VLAN

  
         		[bookmark: pgfId-311901]Virtual LAN subinterface.

  
        

 
         
         		[bookmark: pgfId-311907]Virtual Template

  
         		[bookmark: pgfId-311909]Virtual template interface. When a user dials in, a predefined configuration template is used to configure a virtual access interface; when the user is done, the virtual access interface goes down and the resources are freed for other dial-in uses.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-316362]Related Topics

 
      
      		 [bookmark: pgfId-316367]Defining Basic Router Interface Settings

 
      		 [bookmark: pgfId-316372]Deleting a Cisco IOS Router Interface

 
      		 [bookmark: pgfId-316377]Basic Interface Settings on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-316385][bookmark: 132772][bookmark: rtchap_proc_DefiningBasicRouterInterfaceSettings]Defining Basic Router Interface Settings[bookmark: marker-316383]

 
     [bookmark: pgfId-316387]When you define an interface or subinterface for a Cisco IOS router, you name it, specify how it is assigned an IP address, and optionally define other properties, such as the speed, maximum transmission unit (MTU), and the encapsulation type.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-316392]Note Basic interface settings are always local to the device on which they are configured. You cannot share this policy with other devices. You can, however, share advanced interface settings. For more information, see Advanced Interface Settings on Cisco IOS Routers.


     
      

     

     

 
     [bookmark: pgfId-316394]Related Topics

 
      
      		 [bookmark: pgfId-316399]Deleting a Cisco IOS Router Interface

 
     

 
     
 
     [bookmark: pgfId-316401]Step 1 In Device view, select Interfaces > Interfaces from the Policy selector.

 
     [bookmark: pgfId-316406]The Router Interfaces Page is displayed.

 
     [bookmark: pgfId-316408]Step 2 To add a new interface or subinterface, click the Add Row button to open the Create Router Interface dialog box.

 
     [bookmark: pgfId-316413]To edit an existing interface or subinterface, select it in the Interfaces table, and then click the Edit Row button to open the Edit Router Interface dialog box. Refer to Create Router Interface Dialog Box for descriptions of the fields in these dialog boxes.

 
     [bookmark: pgfId-316415]Step 3 Select Enabled to have Security Manager actively manage this interface or subinterface. If this option is deselected, the interface/subinterface definition is retained, but the interface/subinterface itself is disabled (or â��shutdownâ��).

 
     [bookmark: pgfId-316417]Step 4 Choose Interface or Subinterface from the Type list.

 
     [bookmark: pgfId-316426]Step 5 If you are creating an interface, enter a name for the interface. You can click Select to open a dialog box that will help you generate a standard name based on interface type and details about the interfaceâ��s location, such as card, slot, and subinterface. For more information on using the dialog box to generate an interface name, see Interface Auto Name Generator Dialog Box.[bookmark: marker-316422][bookmark: marker-316424]

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-316428]Note When naming a BVI interface, use the bridge group number as the card number. Deployment will fail if you configure a BVI interface without configuring a corresponding bridge group.


     
      

     

     

 
     [bookmark: pgfId-316432]Step 6 [bookmark: 132816]If you are creating a subinterface, provide the following:

 
     [bookmark: pgfId-316434] a. Parentâ��Choose the parent interface for this subinterface.

 
     [bookmark: pgfId-316436] b. Subinterface IDâ��Enter a number to identify the subinterface.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-316438]Note Security Manager configures serial subinterfaces as point-to-point, not multipoint.


     
      

     

     

 
     [bookmark: pgfId-316440]Step 7 To specify a Layer Type, choose a Level 2 (data link) or Level 3 (network) option from this list.

 
     [bookmark: pgfId-316444]Step 8 [bookmark: 132829]Choose a method of IP address assignment for this interface/subinterface, then provide additional information, as required:

 
      
      		 [bookmark: pgfId-316446] Static IP â��Provide an  IP Address and  Subnet Mask .

 
      		 [bookmark: pgfId-316448] DHCP â��No additional information is required.

 
      		 [bookmark: pgfId-316450] PPPoE â��No additional information is required.

 
      		 [bookmark: pgfId-316452] Unnumbered â��Provide the name of the interface from which an IP address is to be â��borrowed.â��

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-316454]Note Layer 2 interfaces do not support IP addresses.


     
      

     

     

 
     [bookmark: pgfId-316456]Step 9 Define additional properties of the interface/subinterface:

 
      
      		 [bookmark: pgfId-316458]Use the  Negotiation check box to enable and disable auto-negotiation for the interface.

 
     

 
     [bookmark: pgfId-316460]Auto-negotiation detects the capabilities of remote devices and negotiates the best possible performance between the two devices. When Negotiation is enabled, the Fast Ethernet Duplex and Speed options are disabled.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-316462]Note Auto-negotiation is available only for Fast Ethernet and Gigabit Ethernet interfaces on ASR devices.


     
      

     

     

 
      
      		 [bookmark: pgfId-316464]Choose a transmission mode from the  Duplex list. If you choose Auto, be sure the network device to which this interface is connected is set to automatically detect the transmission mode. (Auto is not available on ASRs; use auto-negotiation instead.)

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-316466]Note You must configure a fixed speed to define the duplex value. Tunnel and loopback interfaces do not support this setting.


     
      

     

     

 
      
      		 [bookmark: pgfId-316468]Choose a transmission speed from the  Speed list. If you choose Auto, be sure the network device to which this interface is connected is set to automatically detect the transmission speed. (Auto is not available on ASRs; use auto-negotiation instead.)

 
      		 [bookmark: pgfId-316470]Enter the maximum transmission unit ( MTU ), which defines the largest packet size, in bytes, that this interface can support.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-316472]Note Certain interface properties are set automatically, or are unavailable, depending on the interface type and the underlying port type. For example, the Speed options are available for Fast Ethernet and Gigabit Ethernet interfaces only.


     
      

     

     

 
     [bookmark: pgfId-316474]Step 10 Choose an encapsulation method from the Encapsulation list:

 
      
      		 [bookmark: pgfId-316476] None â��No encapsulation; no additional parameters are required.

 
      		 [bookmark: pgfId-316478](Ethernet subinterfaces only)  DOT1Q â��VLAN encapsulation, as defined by the IEEE 802.1Q standard. Provide the following VLAN parameters for this subinterface:

 
     

 
     [bookmark: pgfId-316480] â�� Enter a VLAN ID to associate with this subinterface.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-316482]Note All VLAN IDs must be unique among all subinterfaces configured on the same physical interface.


     
      

     

     

 
     [bookmark: pgfId-316484] â�� If you are defining the 802.1Q trunk interface, select Native VLAN.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-316489]Tip To configure DOT1Q encapsulation on an Ethernet interface without associating a VLAN with the subinterface, enter the vlan-id dot1qcommand using CLI commands or FlexConfigs. See Understanding FlexConfig Policies and Policy Objects. Configuring VLANs on the main interface increases the number of VLANs that can be configured on the router.


     
      

     

     

 
      
      		 [bookmark: pgfId-316491](Serial interfaces only)  Frame Relay â��IETF Frame Relay encapsulation. Provide a data-link connection identifier (DLCI) for the subinterface.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-316493]Note Frame relay must be configured on the parent interface.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-316495]Note IETF Frame Relay encapsulation provides interoperability between a Cisco IOS router and equipment from other vendors. To configure Cisco Frame Relay encapsulation, use CLI commands or FlexConfigs.


     
      

     

     

 
     [bookmark: pgfId-316499]Step 11 [bookmark: 132892](Optional) Enter a description of up to 1024 characters for the interface.

 
     [bookmark: pgfId-316501]Step 12 Click OK to save the interface/subinterface definition and close the dialog box. The new interface is displayed on the Router Interfaces page. Subinterfaces are displayed beneath the parent interface.

 
     [bookmark: pgfId-316503]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-316511][bookmark: 132900][bookmark: rtchap_proc_DeletingaCiscoIOSRouterInterface]Deleting a Cisco IOS Router Interface[bookmark: marker-316509]

 
     [bookmark: pgfId-316513]Although you can delete the definition of a virtual interface at any time, use this option with great care. If the interface is included in any policy definitions that exist for this router, deleting the interface causes these policy definitions to fail when they are deployed to the device.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-316515]Note Deleting the basic interface definition does not delete any advanced settings that are configured under Interface > Settings > Advanced Settings. You must delete these advanced settings separately. If you fail to do so, deployment fails.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-316520]Note Deleting the definition of a physical interface from the Router Interfaces page does not remove the interface from the device. If you perform this operation by mistake, you can perform rediscovery to restore the definition to Security Manager. For more information, see Discovering Policies on Devices Already in Security Manager.


     
      

     

     

 
     [bookmark: pgfId-316522]Related Topics

 
      
      		 [bookmark: pgfId-316527]Defining Basic Router Interface Settings

 
      		 [bookmark: pgfId-316532]Basic Interface Settings on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-316534]Step 1 Click the Device View button on the toolbar.

 
     [bookmark: pgfId-316536]Step 2 Select a router from the Device selector.

 
     [bookmark: pgfId-316541]Step 3 Select Interfaces > Interfaces from the Policy selector. The Router Interfaces page is displayed. See Table 61-2 for an explanation of the fields on this page.

 
     [bookmark: pgfId-316543]Step 4 Select an interface from the table, then click the Delete button. The interface is deleted.

 
     [bookmark: pgfId-316545]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-316557][bookmark: 132937][bookmark: rtpage_cncpt_RouterInterfacesPage]Router Interfaces Page[bookmark: marker-316553][bookmark: marker-316555]

 
    [bookmark: pgfId-316559]Use the Router Interfaces page to view, create, edit, and delete interface definitions (physical and virtual) on a selected Cisco IOS router. The Router Interfaces page displays interfaces that were discovered by Security Manager as well as interfaces added manually after you added the device to the system.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-316564]Note Unlike other router policies, the Interfaces policy cannot be shared among multiple devices. The Advanced Settings policy, however, may be shared. See Local Policies vs. Shared Policies.


    
     

    

    

 
    [bookmark: pgfId-316569]For more information, see Basic Interface Settings on Cisco IOS Routers.

 
    [bookmark: pgfId-316571]Navigation Path

 
    [bookmark: pgfId-316573]Select a Cisco IOS router from the Device selector, then select Interfaces > Interfaces from the Policy selector.

 
    [bookmark: pgfId-316575]Related Topics

 
     
     		 [bookmark: pgfId-316580]Available Interface Types

 
     		 [bookmark: pgfId-316585]Deleting a Cisco IOS Router Interface

 
     		 [bookmark: pgfId-316590]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-316595]Filtering Tables

 
    

 
    [bookmark: pgfId-316597]Field Reference

 
    [bookmark: pgfId-316600] 

 
     
      
       
       [bookmark: pgfId-311922]Table 61-2 [bookmark: 132975]Router Interfaces Page 

 
       
      
        
        		
          
          [bookmark: pgfId-311928]Element
         
  
        		
          
          [bookmark: pgfId-311930]Description
         
  
       

 
        
        		[bookmark: pgfId-311936]Interface Type

  
        		[bookmark: pgfId-311938]The interface type. Subinterfaces are displayed indented beneath their parent interface.

  
       

 
        
        		[bookmark: pgfId-311944]Interface Name

  
        		[bookmark: pgfId-311946]The name of the interface.

  
       

 
        
        		[bookmark: pgfId-311952]Enabled

  
        		[bookmark: pgfId-311954]Indicates whether the interface is currently enabled (managed by Security Manager) or disabled (shutdown state).

  
       

 
        
        		[bookmark: pgfId-311960]IP Address

  
        		[bookmark: pgfId-311962]The IP address of interfaces defined with a static address.

  
       

 
        
        		[bookmark: pgfId-311968]IP Address Type

  
        		[bookmark: pgfId-311970]The type of IP address assigned to the interfaceâ��static, DHCP, PPPoE, or unnumbered. (IP address is defined by a selected interface role.)

  
       

 
        
        		[bookmark: pgfId-311976]Interface Role

  
        		[bookmark: pgfId-311978]The interface roles that are assigned to the selected interface.

  
       

 
        
        		[bookmark: pgfId-311984]Add button

  
        		[bookmark: pgfId-311989]Opens the Create Router Interface Dialog Box. From here you can create an interface on the selected router.

  
       

 
        
        		[bookmark: pgfId-311995]Edit button

  
        		[bookmark: pgfId-312000]Opens the Create Router Interface Dialog Box. From here you can edit the selected interface.

  
       

 
        
        		[bookmark: pgfId-312006]Delete button

  
        		[bookmark: pgfId-312008]Deletes the selected interfaces from the table. Ensure that the interface is not being used in any other policy before deleting it.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-316612][bookmark: 133032][bookmark: rtpage_cncpt_CreateRouterInterfaceDialogBox]Create Router Interface Dialog Box[bookmark: marker-316608][bookmark: marker-316610]

 
     [bookmark: pgfId-316614]Use the Create Router Interface dialog box to create and edit physical and virtual interfaces on the selected Cisco IOS router.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-316616]Tip Interface configuration is specific to the type of device. Many of the options on this page might be greyed out for specific device or interface types because they do not apply or they are not configurable.


     
      

     

     

 
     [bookmark: pgfId-316618]Navigation Path

 
     [bookmark: pgfId-316623]Go to the Router Interfaces Page, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-316625]Related Topics

 
      
      		 [bookmark: pgfId-316630]Basic Interface Settings on Cisco IOS Routers

 
      		 [bookmark: pgfId-316635]Deleting a Cisco IOS Router Interface

 
      		 [bookmark: pgfId-316640]Advanced Interface Settings Page

 
     

 
     [bookmark: pgfId-316642]Field Reference

 
     [bookmark: pgfId-316645] 

 
      
       
        
        [bookmark: pgfId-312021]Table 61-3 [bookmark: 133066]Create Router Interface Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-312027]Element
          
  
         		
           
           [bookmark: pgfId-312029]Description
          
  
        

 
         
         		[bookmark: pgfId-312035]Enabled

  
         		[bookmark: pgfId-312037]Whether the interface is enabled (no shutdown). If you deselect this option, the interface is created in the configuration but it is shut down.

  
        

 
         
         		[bookmark: pgfId-312043]Type

  
         		[bookmark: pgfId-312045]Specifies whether you are defining an interface or subinterface.

  
        

 
         
         		[bookmark: pgfId-312051]Name

  
         		[bookmark: pgfId-312053]Applies only to interfaces.

 [bookmark: pgfId-312058]The name of the interface. Enter a name manually, or click Select to display a dialog box for generating a name automatically. See Interface Auto Name Generator Dialog Box.

 [bookmark: pgfId-312060]Logical interfaces require a number after the name:

 
           
           		 [bookmark: pgfId-312062]The range for dialer interfaces is 0-799.

 
           		 [bookmark: pgfId-312064]The range for loopback interfaces is 0-2147483647.

 
           		 [bookmark: pgfId-312066]The range for BVI interfaces is 1-255.

 
           		 [bookmark: pgfId-312068]The only allowed value for null interfaces is 0.

 
          

  
        

 
         
         		[bookmark: pgfId-312074]Parent

  
         		[bookmark: pgfId-312076]Applies only to subinterfaces.

 [bookmark: pgfId-312078]The parent interface of the subinterface. Choose the parent interface from this list.

  
        

 
         
         		[bookmark: pgfId-312084]Subinterface ID

  
         		[bookmark: pgfId-312086]Applies only to subinterfaces.

 [bookmark: pgfId-312088]The ID number of the subinterface.

  
        

 
         
         		[bookmark: pgfId-312094]IP

  
         		[bookmark: pgfId-312096]The method of IP address assignment for the interface:

 
           
           		 [bookmark: pgfId-312098]Static IPâ��Defines a static IP address and subnet mask for the interface. Enter this information in the fields that appear below the option.

 
          

 [bookmark: pgfId-312103]Note You can define the mask using either dotted decimal (for example, 255.255.255.255) or CIDR notation (/32). See Contiguous and Discontiguous Network Masks for IPv4 Addresses.

 
           
           		 [bookmark: pgfId-312105]DHCPâ��The interface obtains its IP address dynamically from a DHCP server.

 
           		 [bookmark: pgfId-312107]PPPoEâ��The router automatically negotiates its own registered IP address from a central server (via PPP/IPCP). The following interface types support PPPoE:

 
          

 [bookmark: pgfId-312109] â�� Async

 [bookmark: pgfId-312111] â�� Serial

 [bookmark: pgfId-312113] â�� High-Speed Serial Interface (HSSI)

 [bookmark: pgfId-312115] â�� Dialer

 [bookmark: pgfId-312117] â�� BRI, PRI (ISDN)

 [bookmark: pgfId-312119] â�� Virtual template

 [bookmark: pgfId-312121] â�� Multilink

 
           
           		 [bookmark: pgfId-312123]Unnumberedâ��The interface obtains its IP address from a different interface on the device. Choose an interface from the Interface list. This option can be used with point-to-point interfaces only.

 
          

 [bookmark: pgfId-312125]Note Layer 2 interfaces do not support IP addresses. Deployment fails if you define an IP address on a Layer 2 interface.

  
        

 
         
         		[bookmark: pgfId-312131]Layer Type

  
         		[bookmark: pgfId-312133]The OSI layer at which the interface is defined:

 
           
           		 [bookmark: pgfId-312135]Unknownâ��The layer is unknown.

 
           		 [bookmark: pgfId-312137]Layer 2â��The data link layer, which contains the protocols that control the physical layer (Layer 1) and how data is framed before being transmitted on the medium. Layer 2 is used for bridging and switching. Layer 2 interfaces do not have IP addresses.

 
           		 [bookmark: pgfId-312139]Layer 3â��The network layer, which is primarily responsible for the routing of data in packets across logical internetwork paths. This routing is accomplished through the use of IP addresses.

 
          

  
        

 
         
         		[bookmark: pgfId-312145]Negotiation

  
         		[bookmark: pgfId-312147]Available on ASRs; applies to Fast Ethernet and Gigabit Ethernet interfaces only.

 [bookmark: pgfId-312149]Auto-negotiation detects the capabilities of remote devices and negotiates the best possible performance between the two devices. When Negotiation is enabled, the Duplex and Speed options are disabled.

  
        

 
         
         		[bookmark: pgfId-312155]Duplex

  
         		[bookmark: pgfId-312157]The interface transmission mode:

 
           
           		 [bookmark: pgfId-312159]Noneâ��The transmission mode is returned to its device-specific default setting.

 
           		 [bookmark: pgfId-312161]Fullâ��The interface transmits and receives at the same time (full duplex).

 
           		 [bookmark: pgfId-312163]Halfâ��The interface can transmit or receive, but not at the same time (half duplex). This is the default.

 
           		 [bookmark: pgfId-312165]Autoâ��The router automatically detects and sets the appropriate transmission mode, either full or half duplex. Not available on ASRs; use auto-negotiation instead.

 
          

 [bookmark: pgfId-312167]Note When using Auto mode, be sure that the port on the active network device to which you connect this interface is also set to automatically negotiate the transmission mode. Otherwise, select the appropriate fixed mode.

 [bookmark: pgfId-312169]Note You can configure a duplex value only if you set the Speed to a fixed speed, not Auto.

 [bookmark: pgfId-312171]Note This setting does not apply to serial, HSSI, ATM, PRI, DSL, tunnel, or loopback interfaces.

  
        

 
         
         		[bookmark: pgfId-312177]Speed

  
         		[bookmark: pgfId-312179]Applies only to Fast Ethernet and Gigabit Ethernet interfaces.

 [bookmark: pgfId-312181]The speed of the interface:

 
           
           		 [bookmark: pgfId-312183]Noneâ��The setting is not configurable on the device.

 
           		 [bookmark: pgfId-312185]10â��10 megabits per second (10Base-T networks).

 
           		 [bookmark: pgfId-312187]100â��100 megabits per second (100Base-T networks). This is the default for Fast Ethernet interfaces.

 
           		 [bookmark: pgfId-312189]1000â��1000 megabits per second (Gigabit Ethernet networks). This is the default for Gigabit Ethernet interfaces.

 
           		 [bookmark: pgfId-312191]Autoâ��The router automatically detects and sets appropriate interface speed. Not available on ASRs; use auto-negotiation.

 
          

 [bookmark: pgfId-312193]Note When using Auto mode, be sure that the port on the active network device to which you connect this interface is also set to automatically negotiate the transmission speed. Otherwise, select the appropriate fixed speed.

  
        

 
         
         		[bookmark: pgfId-312199]MTU

  
         		[bookmark: pgfId-312201]The maximum transmission unit, which refers to the maximum packet size, in bytes, that this interface can handle.

 [bookmark: pgfId-312203]Valid values for serial, Ethernet, and Fast Ethernet interfaces range from 64 to 17940 bytes.

 [bookmark: pgfId-312205]Valid values for Gigabit Ethernet interfaces range from 1500 to 9216 bytes.

  
        

 
         
         		[bookmark: pgfId-312211]Encapsulation

  
         		[bookmark: pgfId-312213]The type of encapsulation performed by the interface:

 
           
           		 [bookmark: pgfId-312215]Noneâ��No encapsulation.

 
           		 [bookmark: pgfId-312217]DOT1Qâ��VLAN encapsulation, as defined by the IEEE 802.1Q standard. Applies only to Ethernet subinterfaces.

 
           		 [bookmark: pgfId-312219]Frame Relayâ��IETF Frame Relay encapsulation. Applies only to serial interfaces (not serial subinterfaces).

 
          

 [bookmark: pgfId-312221]Note IETF Frame Relay encapsulation provides interoperability between a Cisco IOS router and equipment from other vendors. To configure Cisco Frame Relay encapsulation, use CLI commands or FlexConfigs.

  
        

 
         
         		[bookmark: pgfId-312227]VLAN ID

  
         		[bookmark: pgfId-312229]Applies only to subinterfaces with encapsulation type DOT1Q.

 [bookmark: pgfId-312231]The VLAN ID associated with this subinterface. The VLAN ID specifies where 802.1Q tagged packets are sent and received on this subinterface; without a VLAN ID, the subinterface cannot send or receive traffic. Valid values range from 1 to 4094.

 [bookmark: pgfId-312233]Note All VLAN IDs must be unique among all subinterfaces configured on the same physical interface.

 command using CLI commands or FlexConfigs. See Understanding FlexConfig Policies and Policy Objects. Configuring VLANs on the main interface increases the number of VLANs that can be configured on the router.  
        

 
         
         		[bookmark: pgfId-312244]Native VLAN

  
         		[bookmark: pgfId-312246]Applies only when the encapsulation type is DOT1Q and you are configuring a physical interface that is meant to serve as an 802.1Q trunk interface. Trunking is a way to carry traffic from several VLANs over a point-to-point link between two devices.

 [bookmark: pgfId-312248]When selected, the Native VLAN is associated with this interface, using the ID specified in the VLAN ID field. (If no VLAN ID is specified for the Native VLAN, the default is 1.) The native VLAN is the VLAN to which all untagged VLAN packets are logically assigned by default. This includes the management traffic associated with the VLAN. If no VLAN ID is defined, the default is 1.

 [bookmark: pgfId-312250]For example, if the VLAN ID of this interface is 1, all incoming untagged packets and packets with VLAN ID 1 are received on the main interface and not on a subinterface. Packets sent from the main interface are transmitted without an 802.1Q tag.

 [bookmark: pgfId-312252]When deselected, the Native VLAN is not associated with this interface.

 [bookmark: pgfId-312254]Note The Native VLAN cannot be configured on a subinterface of the trunk interface. Be sure to configure the same Native VLAN value at both ends of the link; otherwise, traffic may be lost or sent to the wrong VLAN.

  
        

 
         
         		[bookmark: pgfId-312260]DLCI

  
         		[bookmark: pgfId-312262]Applies only to serial subinterfaces with Frame Relay encapsulation.

 [bookmark: pgfId-312264]Enter the data-link connection identifier to associate with the subinterface. Valid values range from 16 to 1007.

 [bookmark: pgfId-312266]Note Security Manager configures serial subinterfaces as point-to-point not multipoint.

  
        

 
         
         		[bookmark: pgfId-312272]Description

  
         		[bookmark: pgfId-312274]Additional information about the interface (up to 1024 characters).

  
        

 
         
         		[bookmark: pgfId-312280]Roles

  
         		[bookmark: pgfId-312282]The interface roles assigned to this interface. A message is displayed if no roles have yet been assigned.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-316657][bookmark: 133258][bookmark: rtpage_cncpt_InterfaceAutoNameGeneratorDialogBox]Interface Auto Name Generator Dialog Box[bookmark: marker-316653][bookmark: marker-316655]

 
     [bookmark: pgfId-316659]Use the Interface Auto Name Generator dialog box to have Security Manager generate a name for the interface based on the interface type and its location in the router or switch.

 
     [bookmark: pgfId-316661]Navigation Path

 
     [bookmark: pgfId-316666]Go to the Create Router Interface Dialog Box, select Interface from the Type list, then click Select in the Name field.

 
     [bookmark: pgfId-316668]Field Reference

 
     [bookmark: pgfId-316671] 

 
      
       
        
        [bookmark: pgfId-312295]Table 61-4 [bookmark: 133279]Interface Auto Name Generator Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-312301]Element
          
  
         		
           
           [bookmark: pgfId-312303]Description
          
  
        

 
         
         		[bookmark: pgfId-312309]Type

  
         		[bookmark: pgfId-312314]The type of interface. Your selection from this list forms the first part of the generated name, as displayed in the Result field. For more information, see Available Interface Types.

  
        

 
         
         		[bookmark: pgfId-312320]Card

  
         		[bookmark: pgfId-312322]The card related to the interface.

 [bookmark: pgfId-312324]Note When defining a BVI interface, enter the number of the corresponding bridge group.

  
        

 
         
         		[bookmark: pgfId-312330]Slot

  
         		[bookmark: pgfId-312332]The slot related to the interface.

  
        

 
         
         		[bookmark: pgfId-312338]Port

  
         		[bookmark: pgfId-312340]The port related to the interface.

 [bookmark: pgfId-312342]Note The information you enter in these fields forms the remainder of the generated name, as displayed in the Result field.

  
        

 
         
         		[bookmark: pgfId-312348]Result

  
         		[bookmark: pgfId-312350]The name generated by Security Manager from the information you entered for the interface type and location. The name displayed in this field is read-only.

 [bookmark: pgfId-312352]Tip After closing this dialog box, you can edit the generated name in the Create Router Interface dialog box, if required.  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-316683][bookmark: 133320][bookmark: rtchap_proc_DefiningAdvancedInterfaceSettings]Advanced Interface Settings on Cisco IOS Routers[bookmark: marker-316677][bookmark: marker-316679][bookmark: marker-316681]

 
    [bookmark: pgfId-316685]In addition to the basic interface definitions that you can define on the Interfaces page, Security Manager provides a method for defining selected advanced settings on interfaces that support those settings.

 
    [bookmark: pgfId-316690]Unlike the basic interface settings defined on the Interface page, you can share an advanced settings policy with multiple devices. This provides a convenient method for configuring multiple devices with identical settings. See Working with Shared Policies in Device View or the Site-to-Site VPN Manager.

 
    [bookmark: pgfId-316692]You can define a variety of advanced settings on a selected interface, subinterface, or interface role, including:

 
     
     		 [bookmark: pgfId-316694]Cisco Discovery Protocol (CDP) settings.

 
     		 [bookmark: pgfId-316696]Internet Control Message Protocol (ICMP) settings.

 
     		 [bookmark: pgfId-316698]Directed broadcast settings.

 
     		 [bookmark: pgfId-316700]Load interval for determining the average load.

 
     		 [bookmark: pgfId-316702]Throughput delay for use by routing protocols.

 
     		 [bookmark: pgfId-316704]Configuring TCP maximum segment size.

 
     		 [bookmark: pgfId-316709]Helper addresses for forwarding UDP broadcasts. For more information on helper addresses, see Understanding Helper Addresses.

 
     		 [bookmark: pgfId-316711]Enabling Maintenance Operation Protocol (MOP).

 
     		 [bookmark: pgfId-316713]Enabling virtual fragmentation reassembly (VFR).

 
     		 [bookmark: pgfId-316715]Enabling proxy ARP.

 
     		 [bookmark: pgfId-316717]Enabling NBAR protocol discovery.

 
     		 [bookmark: pgfId-316719]Enabling and configuring unicast reverse path forwarding (RFP).

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-316724]Tip You can define these settings for multiple interfaces on a device at once by choosing an interface role instead of a specific interface. For example, if you have defined an All-Ethernets interface role, you can define identical advanced settings for every Ethernet interface on the device with a single definition. See Understanding Interface Role Objects.


    
     

    

    

 
    [bookmark: pgfId-316726]Before You Begin

 
     
     		 [bookmark: pgfId-316731]Define basic interface settings. See Basic Interface Settings on Cisco IOS Routers.

 
    

 
    
 
    [bookmark: pgfId-316735]Step 1 [bookmark: 133372]Do one of the following:

 
     
     		 [bookmark: pgfId-316737](Device view) Select  Interfaces > Settings > Advanced Settings from the Policy selector.

 
     		 [bookmark: pgfId-316739](Policy view) Select  Router Interfaces > Settings > Advanced Settings from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-316744]The Advanced Interface Settings page is displayed (see Advanced Interface Settings Page).

 
    [bookmark: pgfId-316746]Step 2 Do one of the following:

 
     
     		 [bookmark: pgfId-316748]Click the  Add button to add an interface or interface role to the table. In the Advanced Interface Settings dialog box, enter the name of the interface or interface role, or click  Select to select an existing role or to create a new role.

 
     		 [bookmark: pgfId-316750]Select an existing entry in the table and click the  Edit button to change its settings.

 
    

 
    [bookmark: pgfId-316757]Step 3 [bookmark: 133393]Configure the advanced settings required for the selected interface. For details about each setting, see Advanced Interface Settings Dialog Box.

 
    [bookmark: pgfId-316761]Step 4 [bookmark: 133396]Click OK to save your definitions. Your definitions are displayed in the Advanced Interface Settings table.

 
    [bookmark: pgfId-316763]


    
     

    
 
    

 
     
      [bookmark: pgfId-316773][bookmark: 133401][bookmark: rtchap_cncpt_UnderstandingHelperAddresses]Understanding Helper Addresses[bookmark: marker-316769][bookmark: marker-316771]

 
     [bookmark: pgfId-316775]Network hosts occasionally use User Datagram Protocol (UDP) broadcasts to determine address, configuration, and name information. This presents a problem if the host is on a network segment that does not include the required server, as by default, routers do not forward UDP broadcasts beyond their subnet. You can remedy this situation by configuring the interface to forward certain classes of broadcasts to a helper address.

 
     [bookmark: pgfId-316777]One common use of helper addresses is when the router acts as a relay agent for DHCP clients who need to contact a DHCP server located on a different subnet. The helper address can either represent a specific DHCP server or a network address for a segment containing multiple DHCP servers. You can also configure a helper address for each DHCP server.

 
     [bookmark: pgfId-316782]In Figure 61-1, hosts located on network 192.168.1.0 can use 10.44.23.7 as a helper address to forward UDP broadcasts to the other network, while hosts located on network 10.44.0.0 can use 192.168.1.19 as their helper address.

 
     [bookmark: pgfId-316786]Figure 61-1 [bookmark: 133413]Helper Addresses

 
     [bookmark: pgfId-316789] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-316794]Table 61-5 lists the default UDP services that can be forwarded to helper addresses.

 
     [bookmark: pgfId-316797] 

 
      
       
        
        [bookmark: pgfId-312365]Table 61-5 [bookmark: 133419]Default UDP Services Forwarded to Helper Addresses 

 
        
       
         
         		
           
           [bookmark: pgfId-312371]Service
          
  
         		
           
           [bookmark: pgfId-312373]Port
          
  
        

 
         
         		[bookmark: pgfId-312379]BOOTP/DHCP Client

  
         		[bookmark: pgfId-312381]68

  
        

 
         
         		[bookmark: pgfId-312387]BOOTP/DHCP Server

  
         		[bookmark: pgfId-312389]67

  
        

 
         
         		[bookmark: pgfId-312395]DNS

  
         		[bookmark: pgfId-312397]53

  
        

 
         
         		[bookmark: pgfId-312403]NetBIOS datagram service

  
         		[bookmark: pgfId-312405]138

  
        

 
         
         		[bookmark: pgfId-312411]NetBIOS name service

  
         		[bookmark: pgfId-312413]137

  
        

 
         
         		[bookmark: pgfId-312419]TACACS

  
         		[bookmark: pgfId-312421]49

  
        

 
         
         		[bookmark: pgfId-312427]TFTP

  
         		[bookmark: pgfId-312429]69

  
        

 
         
         		[bookmark: pgfId-312435]Time

  
         		[bookmark: pgfId-312437]37

  
        

 
       
      

 
     
 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-316802]Tip To forward additional UDP services, use the CLI or FlexConfigs to configure the ip forward-protocol command. Use the no form of this command to prevent the forwarding of any of the default services listed in Table 61-5.


     
      

     

     

 
     [bookmark: pgfId-316804]All of the following conditions must be met in order for a UDP or IP packet to use helper addresses:

 
      
      		 [bookmark: pgfId-316806]The MAC address of the received frame must be an all-ones broadcast address (ffff.ffff.ffff).

 
      		 [bookmark: pgfId-316808]The IP destination address must be one of the following: all-ones broadcast (255.255.255.255), subnet broadcast for the receiving interface, or major-net broadcast for the receiving interface if the no ip classless command is also configured.

 
      		 [bookmark: pgfId-316810]The IP time-to-live (TTL) value must be at least 2.

 
      		 [bookmark: pgfId-316812]The IP protocol must be UDP (17).

 
     

 
     [bookmark: pgfId-316814]Related Topics

 
      
      		 [bookmark: pgfId-316819]Advanced Interface Settings on Cisco IOS Routers

 
      		 [bookmark: pgfId-316824]Basic Interface Settings on Cisco IOS Routers

 
     

 
    
 
   
 
    
     [bookmark: pgfId-316836][bookmark: 133492][bookmark: rtpage_cncpt_AdvancedInterfaceSettingsPage]Advanced Interface Settings Page[bookmark: marker-316832][bookmark: marker-316834]

 
    [bookmark: pgfId-316841]Use the Advanced Interface Settings page to configure advanced interface definitions (physical and virtual) on a router. Examples of advanced settings include Cisco Discovery Protocol (CDP) settings, ICMP message settings, and virtual fragment reassembly settings. You can configure settings for specific interfaces or for interface roles. The columns in the table summarize the advanced settings for an entry and are explained in Advanced Interface Settings Dialog Box.

 
    [bookmark: pgfId-316843]To configure advanced settings:

 
     
     		 [bookmark: pgfId-316845]Click the  Add button to add an interface or interface role to the table, and fill in the Advanced Interface Settings dialog box.

 
     		 [bookmark: pgfId-316847]Select an entry and click the  Edit button to edit an existing entry.

 
     		 [bookmark: pgfId-316849]Select an entry and click the  Delete button to delete it.

 
    

 
    [bookmark: pgfId-316854]For more information, see Advanced Interface Settings on Cisco IOS Routers.

 
    [bookmark: pgfId-316856]Navigation Path

 
     
     		 [bookmark: pgfId-316858](Device view) Select  Interfaces > Settings > Advanced Settings from the Policy selector.

 
     		 [bookmark: pgfId-316860](Policy view) Select  Router Interfaces > Settings > Advanced Settings from the Policy Type selector. Right-click  Advanced Settings to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-316862]Related Topics

 
     
     		 [bookmark: pgfId-316867]Router Interfaces Page

 
     		 [bookmark: pgfId-316872]Available Interface Types

 
     		 [bookmark: pgfId-316877]Deleting a Cisco IOS Router Interface

 
     		 [bookmark: pgfId-316882]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-316887]Filtering Tables

 
    

 
     
      [bookmark: pgfId-316899][bookmark: 133546][bookmark: rtpage_cncpt_AdvancedInterfaceSettingsDialogBox-1]Advanced Interface Settings Dialog Box[bookmark: marker-316895][bookmark: marker-316897]

 
     [bookmark: pgfId-316901]Use the Advanced Interface Settings dialog box to define a variety of advanced settings on a selected interface as described in the table below.

 
     [bookmark: pgfId-316903]Navigation Path

 
     [bookmark: pgfId-316908]Go to the Advanced Interface Settings Page, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-316910]Related Topics

 
      
      		 [bookmark: pgfId-316915]Basic Interface Settings on Cisco IOS Routers

 
      		 [bookmark: pgfId-316920]Advanced Interface Settings on Cisco IOS Routers

 
      		 [bookmark: pgfId-316925]Deleting a Cisco IOS Router Interface

 
      		 [bookmark: pgfId-316930]Available Interface Types

 
     

 
     [bookmark: pgfId-316932]Field Reference

 
     [bookmark: pgfId-316935] 

 
      
       
        
        [bookmark: pgfId-312450]Table 61-6 [bookmark: 133582]Advanced Interface Settings Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-312456]Element
          
  
         		
           
           [bookmark: pgfId-312458]Description
          
  
        

 
         
         		[bookmark: pgfId-312464]Interface

  
         		[bookmark: pgfId-312466]The interface on which the advanced settings are defined. Enter the name of an interface or interface role, or click Select to select it. If the you want is not listed, click the Create button to create it.

 [bookmark: pgfId-312468]Note The only advanced settings supported on Layer 2 interfaces are Max. Bandwidth, Load Interval, and CDP.

  
        

 
         
         		[bookmark: pgfId-312474]Max Bandwidth

  
         		[bookmark: pgfId-312476]The bandwidth value to communicate to higher-level protocols in kilobits per second (kbps). The value you define in this field is an informational parameter only; it does not affect the physical interface.

  
        

 
         
         		[bookmark: pgfId-312482]Load Interval

  
         		[bookmark: pgfId-312484]The length of time, in seconds, used to calculate the average load on the interface. Valid values range from 30 to 600 seconds, in multiples of 30 seconds. The default is 300 seconds (5 minutes). Load interval is not supported on subinterfaces.

 [bookmark: pgfId-312486]Modify the default to shorten the length of time over which load averages are computed. You can do this if you want load computations to be more reactive to short bursts of traffic.

 [bookmark: pgfId-312488]Load data is gathered every 5 seconds. This data is used to compute load statistics, including input/output rate in bits and packets per second, load, and reliability. Load data is computed using a weighted-average calculation in which recent load data has more weight in the computation than older load data.

 [bookmark: pgfId-312490]Tip You can use this option to increase or decrease the likelihood of activating a backup interface; for example, a backup dial interface may be triggered by a sudden spike in the load on an active interface.  
        

 
         
         		[bookmark: pgfId-312498][bookmark: marker-312496] TCP Maximum Segment Size

  
         		[bookmark: pgfId-312500]The maximum segment size (MSS) of TCP SYN packets that pass through this interface. Valid values range from 500 to 1460 bytes. If you do not specify a value, the MSS is determined by the originating host.

 [bookmark: pgfId-312502]This option helps prevent TCP sessions from being dropped as they pass through the router. Use this option when the ICMP messages that perform auto-negotiation of TCP frame size are blocked (for example, by a firewall). We highly recommend using this option on the tunnel interfaces of DMVPN networks.

 [bookmark: pgfId-312504]For more information, see TCP MSS Adjustment at this URL:

 [bookmark: pgfId-312508]http://www.cisco.com/en/US/docs/ios/12_2t/12_2t4/feature/guide/ft_admss.html

 [bookmark: pgfId-312510]Note Typically, the optimum MSS is 1452 bytes. This value plus the 20-byte IP header, the 20-byte TCP header, and the 8-byte PPPoE header add up to a 1500-byte packet that matches the MTU size for the Ethernet link.

  
        

 
         
         		[bookmark: pgfId-312516]Helper Addresses

  
         		[bookmark: pgfId-312518]The helper addresses that are used to forward User Datagram Protocol (UDP) broadcasts that are received on this interface. Enter one or more addresses or the names of the network/host objects, or click Select to select an object from a list or to create a new object.

 [bookmark: pgfId-312523]By default, routers do not forward broadcasts outside of their subnet. Helper addresses provide a solution by enabling the router to forward certain types of UDP broadcasts as a unicast to an address on the destination subnet. For more information, see Understanding Helper Addresses.

  
        

 
         
         		[bookmark: pgfId-312531]Interface Throughput Delay[bookmark: marker-312529]

  
         		[bookmark: pgfId-312533]The expected delay for the interface in tens of microseconds (for example, 3000 translates to 30,000 microseconds). You can enter a value between 1 and 16777215, and the default varies by the type of interface.

 [bookmark: pgfId-312535]Higher-level protocols might use delay information to make operating decisions. For example, IGRP can use delay information to differentiate between a satellite link and a land link. This setting is for informational purposes only and does not affect the actual delay on the interface.

  
        

 
         
         		[bookmark: pgfId-312545]Cisco Discovery Protocol settings[bookmark: marker-312541][bookmark: marker-312543]

  
         		[bookmark: pgfId-312547]Settings related to the Cisco Discovery Protocol (CDP). CDP is a media- and protocol-independent device-discovery protocol that runs on all Cisco-manufactured equipment including routers, access servers, bridges, and switches. It is primarily used to obtain protocol addresses of neighboring devices and to discover the platform of those devices. The options are:

 
           
           		 [bookmark: pgfId-312549]Enable CDPâ��Whether to enable the Cisco Discovery Protocol (CDP) on this interface. You cannot enable CDP on ATM interfaces.

 
           		 [bookmark: pgfId-312551]Log CDP Messagesâ��On Ethernet interfaces, whether to log duplex mismatches for this interface.

 
          

  
        

 
         
         		 [bookmark: pgfId-312561][bookmark: marker-312557][bookmark: marker-312559]ICMP Messages Settings

  
        

 
         
         		[bookmark: pgfId-312569]Enable Redirect Messages

  
         		[bookmark: pgfId-312571]Whether to enable the sending of Internet Control Message Protocol (ICMP) redirect messages if the device is forced to resend a packet through the same interface on which it was received to another device on the same subnet. Redirect messages are sent when the device wants to instruct the originator of the packet to remove it from the route and substitute a different device that offers a more direct path to the destination.

  
        

 
         
         		[bookmark: pgfId-312577]Enable Unreachable Messages

  
         		[bookmark: pgfId-312579]Whether to enable the sending of ICMP unreachable messages. Unreachable messages are sent in two circumstances:

 
           
           		 [bookmark: pgfId-312581]If the interface receives a nonbroadcast packet destined for itself that uses an unknown protocol, the interface sends an ICMP unreachable message to the source.

 
           		 [bookmark: pgfId-312583]If the device receives a packet that it cannot deliver to its ultimate destination because it knows of no route to the destination address, it sends an ICMP host unreachable message to the originator of the packet.

 
          

 [bookmark: pgfId-312585]Note This is the only advanced setting supported by the null0 interface.

  
        

 
         
         		[bookmark: pgfId-312591]Enable Mask Reply Messages

  
         		[bookmark: pgfId-312593]Whether to enable the sending of ICMP mask reply messages. Mask reply messages are sent in response to mask request messages, which are sent when a device needs to know the subnet mask for a particular subnetwork.

  
        

 
         
         		 
           
           [bookmark: pgfId-312599]Additional Settings
          
  
        

 
         
         		[bookmark: pgfId-312611]Enable Maintenance Operation Protocol (MOP)[bookmark: marker-312607][bookmark: marker-312609]

  
         		[bookmark: pgfId-312613]Whether to enable MOP on the interface. You can use MOP for utility services such as uploading and downloading system software, remote testing, and problem diagnosis.

  
        

 
         
         		[bookmark: pgfId-312623][bookmark: marker-312619][bookmark: marker-312621]Enable Virtual Fragment Reassembly (VFR)

  
         		[bookmark: pgfId-312625]Whether to enable virtual fragmentation reassembly (VFR) on this interface. VFR is a feature that enables the Cisco IOS Firewall to create dynamic ACLs that can protect the network from various fragmentation attacks. For more information, see Virtual Fragmentation Reassembly at this URL:

 [bookmark: pgfId-312629]http://www.cisco.com/en/US/docs/ios/sec_data_plane/configuration/guide/sec_virt_frag_reassm_ps6441_TSD_Products_Configuration_Guide_Chapter.html

  
        

 
         
         		[bookmark: pgfId-312639][bookmark: marker-312635][bookmark: marker-312637]Enable Proxy ARP

  
         		[bookmark: pgfId-312641]Whether to enable proxy Address Resolution Protocol (ARP) on the interface. Proxy ARP, defined in RFC 1027, is the technique in which one host, usually a router, answers ARP requests intended for another machine, thereby accepting responsibility for routing packets to the real destination. Proxy ARP can help machines on a subnet reach remote subnets without configuring routing or a default gateway.

  
        

 
         
         		[bookmark: pgfId-312651][bookmark: marker-312647][bookmark: marker-312649] Enable NBAR Protocol Discovery

  
         		[bookmark: pgfId-312653]Whether to enable network-based application recognition (NBAR) on this interface to discover traffic and keep traffic statistics for all protocols known to NBAR. Protocol discovery provides a method to discover application protocols traversing an interface so that QoS policies can be developed and applied to them. For more information, go to:

 [bookmark: pgfId-312657]http://www.cisco.com/en/US/products/ps6616/products_qanda_item09186a00800a3ded.shtml

  
        

 
         
         		[bookmark: pgfId-312669][bookmark: marker-312663][bookmark: marker-312665][bookmark: marker-312667]Enable Directed Broadcasts

 [bookmark: pgfId-312671]ACL

  
         		[bookmark: pgfId-312673]Whether to have directed broadcast packets â��explodedâ�� as a link-layer broadcast when this interface is directly connected to the destination subnet. When deselected, directed broadcast packets that are intended for the subnet to which this interface is directly connected are dropped rather than being broadcast. This is the default.

 [bookmark: pgfId-312675]An IP directed broadcast is an IP packet whose destination address is a valid broadcast address on a different subnet from the node on which it originated. In such cases, the packet is forwarded as if it was a unicast packet until it reaches its destination subnet.

 [bookmark: pgfId-312677]This option affects only the final transmission of the directed broadcast on its destination subnet; it does not affect the transit unicast routing of IP directed broadcasts.

 [bookmark: pgfId-312679]If you enable directed broadcasts, you can apply an ACL to determine which directed broadcasts are permitted to be broadcast on the destination subnet. All other directed broadcasts destined for the subnet to which this interface is directly connected are dropped. Enter the name of a standard or extended ACL object, or click Select to select an object from a list or to create a new object.

 [bookmark: pgfId-312681]Tip Because directed broadcasts, and particularly ICMP directed broadcasts, have been abused by malicious persons, we recommend deselecting this option on interfaces where directed broadcasts are not needed. When you enable directed broadcasts, apply an ACL to restrict their use.  
        

 
         
         		 [bookmark: pgfId-312693][bookmark: marker-312687][bookmark: marker-312689][bookmark: marker-312691]Unicast Reverse Path Forwarding (RFP) Settings

  
        

 
         
         		[bookmark: pgfId-312701]Enable Unicast RFP

  
         		[bookmark: pgfId-312703]Whether to enable unicast reverse path forwarding (RFP) on the interface. When you enable Unicast RPF on an interface, the router examines all packets that are received on that interface. The router checks to make sure that the source address appears in the FIB, and takes action based on your unicast RFP settings. Use unicast RFP to mitigate problems caused by malformed or forged (spoofed) IP source addresses that pass through a router. Malformed or forged source addresses can indicate DoS attacks based on source IP address spoofing. For more information on unicast RFP, see the description of the ip verify unicast source reachable-via command in the Cisco IOS Interface and Hardware Component Command Reference.

 [bookmark: pgfId-312708]To enable unicast RFP, you must also globally enable Cisco Express Forwarding (CEF). For more information on CEF, see CEF Interface Settings on Cisco IOS Routers.

  
        

 
         
         		[bookmark: pgfId-312714]Mode

  
         		[bookmark: pgfId-312716]How strict to make unicast RFP:

 
           
           		 [bookmark: pgfId-312718]Loose Modeâ��The default. Examines incoming packets to determine whether the source address is in the Forwarding Information Base (FIB) and permits the packet if the source is reachable through any interface on the router.

 
          

 [bookmark: pgfId-312720]Use loose mode on interfaces where asymmetric paths allow packets from valid source networks (networks contained in the FIB). For example, routers that are in the core of an ISP network have no guarantee that the best forwarding path out of the router will be the path selected for packets returning to the router.

 
           
           		 [bookmark: pgfId-312722]Strict Modeâ��Examines incoming packets to determine whether the source address is in the FIB and permits the packet only if the source is reachable through the interface on which the packet was received.

 
          

 [bookmark: pgfId-312724]Use strict mode on interfaces where only one path allows packets from valid source networks (networks contained in the FIB). Also, use strict mode when a router has multiple paths to a given network as long as the valid networks are switched through the incoming interfaces. Packets for invalid networks are dropped. For example, routers at the edge of the network of an ISP are likely to have symmetrical reverse paths. Strict mode is also applicable in certain multihomed situations, provided that optional Border Gateway Protocol (BGP) attributes, such as weight and local preference, are used to achieve symmetric routing.

  
        

 
         
         		[bookmark: pgfId-312730]Allow Use Of Default Route for RFP Verification

  
         		[bookmark: pgfId-312732]Whether to permit Unicast RPF to successfully match on prefixes that are known through the default route when determining whether to pass packets. Normally, sources found in the FIB but only by way of the default route are dropped.

  
        

 
         
         		[bookmark: pgfId-312738]Allow Self Ping

  
         		[bookmark: pgfId-312740]Whether to allow the router to ping its own interfaces. By default, when you enable Unicast RPF, packets that are generated by the router and destined to the router are dropped, thereby making certain troubleshooting and management tasks difficult to accomplish.

 
           
           [image: ] 
          
 
          
 
          
           [bookmark: pgfId-312742]Caution Allowing self-ping opens a potential denial of service (DoS) hole.
            
            
 
           

          
  
        

 
         
         		[bookmark: pgfId-312748]ACL

 [bookmark: pgfId-312750](For Unicast RFP)

  
         		[bookmark: pgfId-312752]If you enable unicast RFP, you can apply an ACL to refine how packets are handled when a reverse path is not found. If you specify an ACL, when (and only when) a packet fails the Unicast RPF check, the ACL is checked to determine whether the packet should be dropped (using a deny statement in the ACL) or forwarded (using a permit statement in the ACL). Enter the name of a standard or extended ACL object, or click Select to select an object from a list or to create a new object.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-316949][bookmark: 133818][bookmark: rtchap_proc_IPSModuleInterfaceSettingsonCiscoIOSRouters]IPS Module Interface Settings on Cisco IOS Routers[bookmark: marker-316941][bookmark: marker-316943][bookmark: marker-316945][bookmark: marker-316947]

 
    [bookmark: pgfId-316951]On some routers, you can install IPS modules such as the Cisco Intrusion Prevention System Advanced Integration Module or Network Module. When installed and active, you must configure the IPS Module interface settings policy to define the following:

 
     
     		 [bookmark: pgfId-316953]The name of the interface between the module and the router.

 
     		 [bookmark: pgfId-316955]The failure mode of the module. If the module fails, you can configure it to allow all traffic or to deny all traffic.

 
     		 [bookmark: pgfId-316960]The router interfaces to monitor. You can name specific interfaces or use interface roles to cover more than one interface at a time. For example, if you have defined an All-Ethernets interface role, you can define identical monitoring settings for every Ethernet interface on the device with a single definition. See Understanding Interface Role Objects.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-316965]Tip After you have defined an IPS Module interface settings policy, you can share the policy and assign it to other devices. This provides a convenient method for configuring multiple devices with identical settings. See Working with Shared Policies in Device View or the Site-to-Site VPN Manager.


    
     

    

    

 
    [bookmark: pgfId-316967]Before You Begin

 
    [bookmark: pgfId-316972]Define basic interface settings. See Basic Interface Settings on Cisco IOS Routers.

 
    
 
    [bookmark: pgfId-316974]Step 1 Do one of the following:

 
     
     		 [bookmark: pgfId-316976](Device view) Select  Interfaces > Settings > IPS Module from the Policy selector.

 
     		 [bookmark: pgfId-316978](Policy view) Select  Router Interfaces > Settings > IPS Module from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-316983]The IPS Module Interface Settings page is displayed. See IPS Module Interface Settings Page for an explanation of the fields on this page.

 
    [bookmark: pgfId-316985]Step 2 In the IPS Module Interface Settings fields, enter the name of the IPS interface (such as IDS-Sensor1/0) or click Select to select it from a list. Also determine whether you want to allow all traffic if the module fails (fail open) or to deny all traffic (fail closed).

 
    [bookmark: pgfId-316990]Step 3 Identify the router interfaces that the module should monitor. Click the Add button below the IPS Module Service Module Monitoring Settings table to add interfaces to the list, or select an interface and click the Edit button to change the settings for an existing interface. Use the IPS Monitoring Information dialog box to define the interface name or role, monitoring mode, and access list (if any). For more information, see IPS Monitoring Information Dialog Box.

 
    [bookmark: pgfId-316992]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-317004][bookmark: 133869][bookmark: rtpage_cncpt_AIM-IPSPolicyPage]IPS Module Interface Settings Page[bookmark: marker-317000][bookmark: marker-317002]

 
    [bookmark: pgfId-317006]Use the IPS Module Interface Settings page to define the settings on the Cisco Intrusion Prevention System Advanced Integration Module or Network Module. The module must be running IPS 6.0 or later. You can define the fail mode for the IPS interface, and the interfaces that the module should monitor. Configure this policy only if the router hosts an IPS module.

 
     
     [image: ] 
    
 
    
 
    
     [bookmark: pgfId-317008]
     Caution Cisco IOS IPS and the Cisco IPS module cannot be used together. Cisco IOS IPS must be disabled when the IPS module is installed.
      
      
 
     

    
 
    [bookmark: pgfId-317010]Navigation Path

 
     
     		 [bookmark: pgfId-317012](Device view) Select  Interfaces > Settings > IPS Module from the Policy selector.

 
     		 [bookmark: pgfId-317014](Policy view) Select  Router Interfaces > Settings > IPS Module from the Policy Type selector. Create a new policy or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-317016]Related Topics

 
     
     		 [bookmark: pgfId-317021]IPS Module Interface Settings on Cisco IOS Routers

 
     		 [bookmark: pgfId-317026]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-317031]Filtering Tables

 
    

 
    [bookmark: pgfId-317033]Field Reference

 
    [bookmark: pgfId-317036] 

 
     
      
       
       [bookmark: pgfId-312765]Table 61-7 [bookmark: 133905]IPS Module Interface Settings Page 

 
       
      
        
        		
          
          [bookmark: pgfId-312771]Element
         
  
        		
          
          [bookmark: pgfId-312773]Description
         
  
       

 
        
        		[bookmark: pgfId-312779]Interface Name

  
        		[bookmark: pgfId-312781]The name of the IPS module interface. Enter the name or click Select to select the interface or interface role. If the object that you want is not listed, click the Create button to create it.

  
       

 
        
        		[bookmark: pgfId-312787]Fail Over Mode

  
        		[bookmark: pgfId-312789]How the module should handle traffic inspection during a module failure, either to fail open (passing all traffic without inspection) or fail closed (dropping all traffic). The default is fail open.

  
       

 
        
        		[bookmark: pgfId-312795]IPS Module Service Module Monitoring Settings table

  
        		[bookmark: pgfId-312797]The list of interfaces on the router that the IPS module should monitor.

 [bookmark: pgfId-312799]The table shows the name of the interface or interface role, whether monitoring is inline or promiscuous, and whether an ACL is used to filter traffic for inspection on the interface. Inline mode puts the IPS module directly into the traffic flow, allowing it to stop attacks by dropping malicious traffic before it reaches the intended target. In promiscuous mode, packets do not flow through the sensor; the sensor analyzes a copy of the monitored traffic rather than the actual forwarded packet. If the ACL is matched, the matched traffic is not inspected.

 
          
          		 [bookmark: pgfId-312804]To add an interface to the table, click the Add button and fill in the IPS Monitoring Information Dialog Box.

 
          		 [bookmark: pgfId-312806]To edit the settings for an interface, select it and click the Edit button.

 
          		 [bookmark: pgfId-312808]To delete an interface, select it and click the Delete button.

 
         

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-317048][bookmark: 133941][bookmark: rtpage_cncpt_IPSMonitoringInformationDialogBox]IPS Monitoring Information Dialog Box[bookmark: marker-317044][bookmark: marker-317046]

 
     [bookmark: pgfId-317050]Use the IPS Monitoring Information dialog box to add or edit the properties of interfaces to be monitored by the IPS module.

 
     [bookmark: pgfId-317052]Navigation Path

 
     [bookmark: pgfId-317057]Go to the IPS Module Interface Settings Page, then click the Add or Edit button beneath the IPS Module Service Module Monitoring Settings table.

 
     [bookmark: pgfId-317059]Related Topics

 
      
      		 [bookmark: pgfId-317064]IPS Module Interface Settings on Cisco IOS Routers

 
      		 [bookmark: pgfId-317069]Basic Interface Settings on Cisco IOS Routers

 
     

 
     [bookmark: pgfId-317071]Field Reference

 
     [bookmark: pgfId-317074] 

 
      
       
        
        [bookmark: pgfId-312821]Table 61-8 [bookmark: 133970]IPS Monitoring Information Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-312827]Element
          
  
         		
           
           [bookmark: pgfId-312829]Description
          
  
        

 
         
         		[bookmark: pgfId-312835]Interface Name

  
         		[bookmark: pgfId-312837]A name of the interface or interface role that the module should monitor. Enter the name or click Select to select the interface or interface role. If the object that you want is not listed, click the Create button to create it.

  
        

 
         
         		[bookmark: pgfId-312843]Monitoring Mode

  
         		[bookmark: pgfId-312845]How the interface should be monitored:

 
           
           		 [bookmark: pgfId-312847]Inline modeâ��The IPS module is directly in the traffic flow, allowing it to stop attacks by dropping malicious traffic before it reaches the intended target.

 
           		 [bookmark: pgfId-312849]Promiscuous modeâ��Packets do not flow through the sensor; the sensor analyzes a copy of the monitored traffic rather than the actual forwarded packet.

 
          

  
        

 
         
         		[bookmark: pgfId-312855]Access List

  
         		[bookmark: pgfId-312857]The name of the standard or extended access list policy object to use to filter traffic on this interface for inspection, if you want to apply one. A matched ACL causes traffic not to be inspected for that ACL. Click Select to select the ACL or to create a new one.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-317088][bookmark: 134005][bookmark: rtchap_proc_CEFInterfaceSettingsonCiscoIOSRouters]CEF Interface Settings on Cisco IOS Routers[bookmark: marker-317080][bookmark: marker-317082][bookmark: marker-317084][bookmark: marker-317086]

 
    [bookmark: pgfId-317090]Cisco Express Forwarding (CEF) is an advanced Layer 3 IP switching technology that optimizes network performance and scalability for all kinds of networks, from those that carry small amounts of traffic to those that carry large amounts of traffic in complex patterns, such as the Internet and networks characterized by intensive web-based applications or interactive sessions. CEF is enabled by default on most Cisco IOS routers.

 
    [bookmark: pgfId-317092]Typically, you do not need to configure a CEF policy unless you want to enable CEF accounting so that you can view statistics with the show ip cef command on the router. You would also configure the policy if you want to disable CEF, or to configure non-default CEF behavior on specific interfaces, for example, to have CEF load balance based on packets rather than source-destination packet streams.

 
    [bookmark: pgfId-317097]When configuring alternate CEF settings for interfaces, you can name specific interfaces or use interface roles to cover more than one interface at a time. For example, if you have defined an All-Ethernets interface role, you can define identical CEF settings for every Ethernet interface on the device with a single definition. See Understanding Interface Role Objects.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-317102]Tip After you have defined a CEF interface settings policy, you can share the policy and assign it to other devices. This provides a convenient method for configuring multiple devices with identical settings. See Working with Shared Policies in Device View or the Site-to-Site VPN Manager.


    
     

    

    

 
    [bookmark: pgfId-317104]Before You Begin

 
    [bookmark: pgfId-317109]Define basic interface settings. See Basic Interface Settings on Cisco IOS Routers.

 
    
 
    [bookmark: pgfId-317111]Step 1 Do one of the following:

 
     
     		 [bookmark: pgfId-317113](Device view) Select  Interfaces > Settings > CEF from the Policy selector.

 
     		 [bookmark: pgfId-317115](Policy view) Select  Router Interfaces > Settings > CEF from the Policy Type selector. Select an existing policy or create a new one.

 
    

 
    [bookmark: pgfId-317120]The CEF Interface Settings page is displayed. See CEF Interface Settings Page for an explanation of the fields on this page.

 
    [bookmark: pgfId-317122]Step 2 If you are enabling CEF, select the accounting options you desire.

 
    [bookmark: pgfId-317127]Step 3 If you want to configure non-default behavior for certain interfaces, add them to the CEF Interface Settings table. Click the Add button below the table to add interfaces to the list, or select an interface and click the Edit button to change the settings for an existing interface. For more information about the options, see CEF Interface Settings Dialog Box.

 
    [bookmark: pgfId-317129]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-317141][bookmark: 134052][bookmark: rtpage_cncpt_CEFPolicyPage]CEF Interface Settings Page[bookmark: marker-317137][bookmark: marker-317139]

 
    [bookmark: pgfId-317143]Use the CEF Interface Settings page to define the settings for Cisco Express Forwarding. CEF is an advanced Layer 3 IP switching technology that optimizes network performance and scalability for all kinds of networks, from those that carry small amounts of traffic to those that carry large amounts of traffic in complex patterns, such as the Internet and networks characterized by intensive web-based applications or interactive sessions. CEF is enabled by default on most Cisco IOS routers.

 
    [bookmark: pgfId-317145]Navigation Path

 
     
     		 [bookmark: pgfId-317147](Device view) Select  Interfaces > Settings > CEF from the Policy selector.

 
     		 [bookmark: pgfId-317149](Policy view) Select  Router Interfaces > Settings > CEF from the Policy Type selector. Create a new policy or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-317151]Related Topics

 
     
     		 [bookmark: pgfId-317156]CEF Interface Settings on Cisco IOS Routers

 
     		 [bookmark: pgfId-317161]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-317166]Filtering Tables

 
    

 
    [bookmark: pgfId-317168]Field Reference

 
    [bookmark: pgfId-317171] 

 
     
      
       
       [bookmark: pgfId-312870]Table 61-9 [bookmark: 134086]CEF Interface Settings Page 

 
       
      
        
        		
          
          [bookmark: pgfId-312876]Element
         
  
        		
          
          [bookmark: pgfId-312878]Description
         
  
       

 
        
        		[bookmark: pgfId-312884]Enable Cisco Express Forwarding

  
        		[bookmark: pgfId-312886]Whether to enable CEF globally on the device. The option is greyed out if you cannot disable CEF on the device. You can configure other settings on the page only if you enable CEF globally.

  
       

 
        
        		[bookmark: pgfId-312892]CEF Network Accounting

  
        		[bookmark: pgfId-312894]These options are for configuring CEF accounting globally. If you collect accounting statistics, you can view them using the show ip cef command on the router. You can select the following options to enable different types of accounting:

 
          
          		 [bookmark: pgfId-312896]Enable Accounting for Traffic Through Non-Recursive Prefixesâ��For network prefixes with directly connected next hops, non-recursive accounting enables express forwarding of the collection of packets through a prefix.

 
          		 [bookmark: pgfId-312898]Enable Per-Prefix Accountingâ��Accounting statistics based on the packetâ��s network prefix.

 
          		 [bookmark: pgfId-312900]Enable Prefix Length Accountingâ��Accounting statistics based on the network prefix length.

 
          		 [bookmark: pgfId-312902]Enable Load Balance Hash Accountingâ��When you use per-destination load balancing (the default), CEF uses a series of 16 hash buckets to distribute the available paths based on the source and destination addresses. Enabling load balance hash accounting provides per-hash-bucket counters.

 
         

  
       

 
        
        		[bookmark: pgfId-312908]CEF Interface Settings table

  
        		[bookmark: pgfId-312910]The interfaces on the router for which you are defining special CEF configurations. When you enable CEF globally, by default, all interfaces on the router enable CEF and use per-destination load balancing. Add interfaces to this table only if you want to configure different behavior for the interfaces.

 [bookmark: pgfId-312915]The table shows the name of the interface or interface role, whether CEF is enabled or disabled, and whether the interface is load balancing based on destination or on a per-packet basis. For a detailed explanation of the fields, see CEF Interface Settings Dialog Box.

 
          
          		 [bookmark: pgfId-312917]To add an interface to the table, click the Add button.

 
          		 [bookmark: pgfId-312919]To edit the settings for an interface, select it and click the Edit button.

 
          		 [bookmark: pgfId-312921]To delete an interface, select it and click the Delete button.

 
         

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-317183][bookmark: 134130][bookmark: rtpage_cncpt_CEFInterfaceSettingsDialogBox]CEF Interface Settings Dialog Box[bookmark: marker-317179][bookmark: marker-317181]

 
     [bookmark: pgfId-317185]Use the CEF Interface Settings dialog box to add or edit the CEF properties of interfaces when you want to configure something different than the global default.

 
     [bookmark: pgfId-317187]Navigation Path

 
     [bookmark: pgfId-317192]Go to the CEF Interface Settings Page, then click the Add or Edit button beneath the CEF Interface Settings table.

 
     [bookmark: pgfId-317194]Related Topics

 
      
      		 [bookmark: pgfId-317199]CEF Interface Settings on Cisco IOS Routers

 
      		 [bookmark: pgfId-317204]Basic Interface Settings on Cisco IOS Routers

 
     

 
     [bookmark: pgfId-317206]Field Reference

 
     [bookmark: pgfId-317209] 

 
      
       
        
        [bookmark: pgfId-312934]Table 61-10 [bookmark: 134158]CEF Interface Settings Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-312940]Element
          
  
         		
           
           [bookmark: pgfId-312942]Description
          
  
        

 
         
         		[bookmark: pgfId-312948]Interface Name

  
         		[bookmark: pgfId-312950]The name of the interface or interface role for which you are configuring CEF. Enter the name or click Select to select the interface or interface role. If the object that you want is not listed, click the Create button to create it.

  
        

 
         
         		[bookmark: pgfId-312956]Enable CEF on Interface

  
         		[bookmark: pgfId-312958]Whether to enable CEF on the interface. CEF is enabled by default.

  
        

 
         
         		[bookmark: pgfId-312964]Load Balancing

  
         		[bookmark: pgfId-312966]How the interface should balance traffic, either per-destination or per-packet.

 [bookmark: pgfId-312968]In per-destination load balancing, all packets for a given source-destination pair take the same path. In per-packet load balancing, packets for a given source-destination pair can take different equal-cost routes, and thus reach their destination out of order.

 [bookmark: pgfId-312970]The default is to balance the load based on the destination of the traffic.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-317221][bookmark: 134189][bookmark: rtchap_cncpt_DialerInterfacesonCiscoIOSRouters]Dialer Interfaces on Cisco IOS Routers[bookmark: marker-317215][bookmark: marker-317217][bookmark: marker-317219]

 
    [bookmark: pgfId-317226]Before you can configure a dial backup policy for a site-to-site VPN (see Configuring Dial Backup), you must configure a dialer interface policy on the appropriate Cisco IOS router. The dialer interface policy uses dialer pools to associate the dialer interface used by dial backup with a physical BRI interface on the router. Each dialer interface is associated with a single dialer pool, which can contain one or more physical interfaces. Multiple dialer interfaces can reference the same dialer pool.

 
    [bookmark: pgfId-317228]The following topics describe how to create dialer interfaces policies on Cisco IOS routers:

 
     
     		 [bookmark: pgfId-317233]Defining Dialer Profiles

 
     		 [bookmark: pgfId-317238]Defining BRI Interface Properties

 
    

 
     
      [bookmark: pgfId-317246][bookmark: 134211][bookmark: rtchap_proc_DefiningDialerProfiles]Defining Dialer Profiles[bookmark: marker-317244]

 
     [bookmark: pgfId-317248]When you configure a dialer profile, you must select the interface or interface role representing the dialer interface and specify the number to be dialed. You must also assign a pool ID, which you use to reference this dialer interface when configuring the physical dialer interface. Additionally, you can modify the default timeout settings for the line.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-317250]Note IP is the only protocol supported for dialer profiles by Security Manager.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-317252]Note Authentication parameters for the dialer profile are defined in the PPP policy.


     
      

     

     

 
     [bookmark: pgfId-317254]Before You Begin

 
     [bookmark: pgfId-317259]Define the virtual and physical dialer interfaces on the router. See Basic Interface Settings on Cisco IOS Routers.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-317264]Note In addition, you can optionally define interface roles for the virtual and physical dialer interfaces. See Defining Dialer Profiles.


     
      

     

     

 
     [bookmark: pgfId-317266]Related Topics

 
      
      		 [bookmark: pgfId-317271]Defining BRI Interface Properties

 
      		 [bookmark: pgfId-317276]Dialer Interfaces on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-317278]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-317280](Device view) Select  Interfaces > Settings > Dialer from the Policy selector.

 
      		 [bookmark: pgfId-317282](Policy view) Select  Router Interfaces > Settings > Dialer from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-317287]The Dialer page is displayed. See Table 61-11 for a description of the fields on this page.

 
     [bookmark: pgfId-317292]Step 2 Select a dialer profile from the upper table on the Dialer Interfaces page, then click Edit, or click Add to create a profile. The Dialer Profile dialog box appears. See Table 61-12 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-317297]Step 3 Enter the name of the interface or interface role that represents the virtual dialer interface, or click Select to select an interface role object or to create a new one. For more information, see Specifying Interfaces During Policy Definition.

 
     [bookmark: pgfId-317302]Step 4 Enter a name for the dialer profile. Having a name makes it easier for you to assign the correct dialer pool to the physical interface. See Defining BRI Interface Properties.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-317304]Tip We recommend that you define a name that is logically associated with the site to which the dialer interface serves as a backup. For example, if the dialer interface is serving as a backup connection to the London site, define the name London for the dialer profile.


     
      

     

     

 
     [bookmark: pgfId-317306]Step 5 Enter an ID number for the dialer pool to associate with this dialer interface. Each dialer interface is associated with a single pool. Multiple interfaces may, however, be associated with the same dialer pool.

 
     [bookmark: pgfId-317308]Step 6 Enter the number of the dialer group to assign to the dialer interface.

 
     [bookmark: pgfId-317310]Step 7 (Optional) In the Interesting Traffic ACL field, enter the name of the extended ACL object that defines which packets are permitted to initiate calls using this dialer profile, or click Select to select the object from a list or to create a new one. Use this option to limit the IP traffic that can make use of the dialer.

 
     [bookmark: pgfId-317312]Step 8 Enter the dialer string, which is the phone number of the remote side of the dialer interface connection.

 
     [bookmark: pgfId-317314]Step 9 (Optional) Modify the default timeout values (Idle Timeout and Fast Idle Timeout), if required.

 
     [bookmark: pgfId-317316]Step 10 Click OK to save your definitions locally on the client and close the dialog box. The dialer profile appears in the Dialer Profile table on the Dialer page.

 
     [bookmark: pgfId-317318]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-317326][bookmark: 134276][bookmark: rtchap_proc_DefiningBRIInterfaceProperties]Defining BRI Interface Properties[bookmark: marker-317324]

 
     [bookmark: pgfId-317328]You configure the properties of the physical BRI interfaces used for dialer interface policies by selecting the appropriate interface or interface role, defining the dialer pools to which the interface belongs, and defining the ISDN switch type. It is the dialer pool that connects the physical interface with the virtual dialer interface.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-317333]Note To define other types of physical dialer interfaces, such as ATM and Ethernet, use FlexConfigs. For more information, see Understanding FlexConfig Policies and Policy Objects.


     
      

     

     

 
     [bookmark: pgfId-317335]Before You Begin

 
     [bookmark: pgfId-317340]Define the virtual and physical dialer interfaces on the router. SeeBasic Interface Settings on Cisco IOS Routers.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-317345]Note In addition, you can optionally define interface roles for the virtual and physical dialer interfaces. See Creating Interface Role Objects.


     
      

     

     

 
     [bookmark: pgfId-317347]Related Topics

 
      
      		 [bookmark: pgfId-317352]Defining Dialer Profiles

 
      		 [bookmark: pgfId-317357]Dialer Interfaces on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-317359]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-317361](Device view) Select  Interfaces > Settings > Dialer from the Policy selector.

 
      		 [bookmark: pgfId-317363](Policy view) Select  Router Interfaces > Settings > Dialer from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-317368]The Dialer Interfaces page is displayed. See Table 61-11 for a description of the fields on this page.

 
     [bookmark: pgfId-317373]Step 2 Select a physical BRI interface from the Dialer Physical Interfaces table, then click Edit, or click Add to add an interface. The Dialer Physical Interface dialog box appears. See Table 61-13 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-317378]Step 3 Enter the name of the interface or interface role that represents the physical dialer interface, or click Select to select an interface role object from a list or to create a new one. For more information, see Specifying Interfaces During Policy Definition.

 
     [bookmark: pgfId-317380]Step 4 Enter the names of the dialer pools to associate with the physical interface, or click Select to display a selector. Separate multiple entries with commas.

 
     [bookmark: pgfId-317385]Step 5 Select the ISDN switch type used by the physical interface. Table 61-13 describes the available switch types.

 
     [bookmark: pgfId-317387]Step 6 (Optional) If you selected the Basic-DMS-100, Basic-NI, or Basic-5ess switch type, enter up to two service provider identifiers (SPIDs).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-317389]Note We recommend that you do not enter SPIDs for the Basic-5ess switch type, even though SPIDs are supported.


     
      

     

     

 
     [bookmark: pgfId-317391]Step 7 Click OK to save your definitions locally on the client and close the dialog box. The interface definition appears in the Dialer Physical Interfaces table on the Dialer Interface page.

 
     [bookmark: pgfId-317393]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-317405][bookmark: 134336][bookmark: rtpage_cncpt_DialerPolicyPage]Dialer Policy Page[bookmark: marker-317401][bookmark: marker-317403]

 
    [bookmark: pgfId-317407]Use the Dialer page to define the relationship between physical Basic Rate Interface (BRI) and virtual dialer interfaces. You use these dialer interfaces when you configure the dial backup feature for site-to-site VPNs.

 
    [bookmark: pgfId-317412]For more information, see Dialer Interfaces on Cisco IOS Routers.

 
    [bookmark: pgfId-317414]Navigation Path

 
     
     		 [bookmark: pgfId-317416](Device view) Select  Interfaces > Settings > Dialer from the Policy selector.

 
     		 [bookmark: pgfId-317418](Policy view) Select  Router Interfaces > Settings > Dialer from the Policy Type selector. Right-click  Dialer to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-317420]Related Topics

 
     
     		 [bookmark: pgfId-317425]Configuring Dial Backup

 
     		 [bookmark: pgfId-317430]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-317435]Filtering Tables

 
    

 
    [bookmark: pgfId-317437]Field Reference

 
    [bookmark: pgfId-317440] 

 
     
      
       
       [bookmark: pgfId-312983]Table 61-11 [bookmark: 134374]Dialer Page 

 
       
      
        
        		
          
          [bookmark: pgfId-312989]Element
         
  
        		
          
          [bookmark: pgfId-312991]Description
         
  
       

 
        
        		[bookmark: pgfId-312997]Dialer Profiles table

  
        		[bookmark: pgfId-312999]The dialer profiles that define the dialer pools. You must add profiles before you can add physical BRI interfaces. The table shows the name of the interface or interface role that the dialer interface uses, the profile name, pool, group, the ACL that defines which traffic can use this profile, the dial string, and idle times.

 
          
          		 [bookmark: pgfId-313004]To add a profile, click the  Add Row button and fill in the Dialer Profile Dialog Box.

 
          		 [bookmark: pgfId-313006]To edit a profile, select it and click the  Edit Row button.

 
          		 [bookmark: pgfId-313008]To delete a profile, select it and click the  Delete Row button.

 
         

  
       

 
        
        		[bookmark: pgfId-313014]Dialer Physical Interfaces (BRI) table

  
        		[bookmark: pgfId-313016]The physical interfaces that use the dialer profiles. The table shows the name of the interface or interface role, the dial pools, ISDN switch type, and first and second service provider identifiers (SPID) related to the interface.

 
          
          		 [bookmark: pgfId-313021]To add an interface, click the  Add Row button and fill in the Dialer Physical Interface Dialog Box.

 
          		 [bookmark: pgfId-313023]To edit an interface, select it and click the  Edit Row button.

 
          		 [bookmark: pgfId-313025]To delete an interface, select it and click the  Delete Row button.

 
         

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-317452][bookmark: 134416][bookmark: rtpage_cncpt_DialerProfileDialogBox]Dialer Profile Dialog Box[bookmark: marker-317448][bookmark: marker-317450]

 
     [bookmark: pgfId-317454]Use the Dialer Profile dialog box to add or edit dialer profiles.

 
     [bookmark: pgfId-317456]Navigation Path

 
     [bookmark: pgfId-317461]Go to the Dialer Policy Page, then click the Add or Edit button beneath the Dialer Profile table.

 
     [bookmark: pgfId-317463]Related Topics

 
      
      		 [bookmark: pgfId-317468]Dialer Physical Interface Dialog Box

 
      		 [bookmark: pgfId-317473]Defining Dialer Profiles

 
      		 [bookmark: pgfId-317478]Dialer Interfaces on Cisco IOS Routers

 
      		 [bookmark: pgfId-317483]Basic Interface Settings on Cisco IOS Routers

 
      		 [bookmark: pgfId-317488]Creating Interface Role Objects

 
     

 
     [bookmark: pgfId-317490]Field Reference

 
     [bookmark: pgfId-317493] 

 
      
       
        
        [bookmark: pgfId-313038]Table 61-12 [bookmark: 134454]Dialer Profile Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-313044]Element
          
  
         		
           
           [bookmark: pgfId-313046]Description
          
  
        

 
         
         		[bookmark: pgfId-313052]Name

  
         		[bookmark: pgfId-313054]A descriptive name for the dialer profile. This name enables you to assign the correct dialer pool to the physical interface. You can also use the profile name as a reference to the site to which this dialer interface serves as a backup.

  
        

 
         
         		[bookmark: pgfId-313060]Interface

  
         		[bookmark: pgfId-313062]The virtual dialer interface to associate with the dialer profile. Enter the name of an interface or interface role, or click Select to select it. If the object that you want is not listed, click the Create button to create it.

  
        

 
         
         		[bookmark: pgfId-313068]Pool ID

  
         		[bookmark: pgfId-313070]The dialer pool ID. Each pool can contain multiple physical interfaces and can be associated with multiple dialer interfaces. Each dialer interface, however, is associated with only one pool.

  
        

 
         
         		[bookmark: pgfId-313076]Group

  
         		[bookmark: pgfId-313078]The group ID, which identifies the dialer group that this dialer interface uses.

  
        

 
         
         		[bookmark: pgfId-313084]Interesting Traffic ACL

  
         		[bookmark: pgfId-313086]The extended, numbered ACL that defines which packets are permitted to initiate calls using this dialer profile. The valid ACL number range is 100 to 199.

 [bookmark: pgfId-313088]Enter the name of the ACL object, or click Select to select it. If the object that you want is not listed, click the Create button to create it.

  
        

 
         
         		[bookmark: pgfId-313094]Dialer String (Remote Phone Number)

  
         		[bookmark: pgfId-313096]The phone number of the destination that the dialer contacts.

  
        

 
         
         		[bookmark: pgfId-313102]Idle Timeout

  
         		[bookmark: pgfId-313104]The default amount of idle time before an uncontested line is disconnected. The default is 120 seconds.

  
        

 
         
         		[bookmark: pgfId-313110]Fast Idle Timeout

  
         		[bookmark: pgfId-313112]The default amount of idle time before a contested line is disconnected. The default is 20 seconds.

 [bookmark: pgfId-313114]Line contention occurs when a busy line is requested to send another packet to a different destination.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-317505][bookmark: 134511][bookmark: rtpage_cncpt_DialerPhysicalInterfaceDialogBox]Dialer Physical Interface Dialog Box[bookmark: marker-317501][bookmark: marker-317503]

 
     [bookmark: pgfId-317507]Use the Dialer Physical Interface dialog box to add or edit the properties that associate physical BRI interfaces with dialer interfaces.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-317512]Note Use FlexConfigs to define other types of physical dialer interfaces, such as ATM and Ethernet. For more information, see Understanding FlexConfig Policies and Policy Objects.


     
      

     

     

 
     [bookmark: pgfId-317514]Navigation Path

 
     [bookmark: pgfId-317519]Go to the Dialer Policy Page, then click the Add or Edit button beneath the Dialer Physical Interfaces table.

 
     [bookmark: pgfId-317521]Related Topics

 
      
      		 [bookmark: pgfId-317526]Dialer Profile Dialog Box

 
      		 [bookmark: pgfId-317531]Defining BRI Interface Properties

 
      		 [bookmark: pgfId-317536]Dialer Interfaces on Cisco IOS Routers

 
      		 [bookmark: pgfId-317541]Basic Interface Settings on Cisco IOS Routers

 
      		 [bookmark: pgfId-317546]Understanding Interface Role Objects

 
     

 
     [bookmark: pgfId-317548]Field Reference

 
     [bookmark: pgfId-317551] 

 
      
       
        
        [bookmark: pgfId-313127]Table 61-13 [bookmark: 134551]Dialer Physical Interface Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-313133]Element
          
  
         		
           
           [bookmark: pgfId-313135]Description
          
  
        

 
         
         		[bookmark: pgfId-313141]ISDN BRI

  
         		[bookmark: pgfId-313143]The physical BRI interface associated with the dialer interface. Enter the name of an interface or interface role object, or click Select to select it. If the object that you want is not listed, click the Create button to create it.

  
        

 
         
         		[bookmark: pgfId-313149]Pools

  
         		[bookmark: pgfId-313154]Associates dialer pools with a physical interface. Enter the names of one or more pools (as defined in the Dialer Profile Dialog Box), or click Select to display a selector. Use commas to separate multiple entries.

  
        

 
         
         		[bookmark: pgfId-313160]Switch Type

  
         		[bookmark: pgfId-313162]The ISDN switch type.

 [bookmark: pgfId-313164]Options for North America are:

 
           
           		 [bookmark: pgfId-313166]basic-5essâ��Lucent (AT&T) basic rate 5ESS switch

 
           		 [bookmark: pgfId-313168]basic-dms100â��Northern Telecom DMS-100 basic rate switch

 
           		 [bookmark: pgfId-313170]basic-niâ��National ISDN switches

 
          

 [bookmark: pgfId-313172]Options for Australia, Europe, and the UK are:

 
           
           		 [bookmark: pgfId-313174]basic-1tr6â��German 1TR6 ISDN switch

 
           		 [bookmark: pgfId-313176]basic-net3â��NET3 ISDN BRI for Norway NET3, Australia NET3, and New Zealand NET3 switch types; ETSI-compliant switch types for Euro-ISDN E-DSS1 signaling system

 
           		 [bookmark: pgfId-313178]vn3â��French VN3 and VN4 ISDN BRI switches

 
          

 [bookmark: pgfId-313180]Option for Japan is:

 
           
           		 [bookmark: pgfId-313182]nttâ��Japanese NTT ISDN switches

 
          

 [bookmark: pgfId-313184]Option for Voice/PBX system is:

 
           
           		 [bookmark: pgfId-313186]basic-qsigâ��PINX (PBX) switches with QSIG signaling per Q.931 ()

 
          

  
        

 
         
         		[bookmark: pgfId-313192]SPID1

  
         		[bookmark: pgfId-313194]Applies only when you select Basic-DMS-100, Basic-NI, or Basic-5ess as the switch type.

 [bookmark: pgfId-313196]The service provider identifier (SPID) for the ISDN service to which the interface subscribes. Some service providers in North America assign SPIDs to ISDN devices when you first subscribe to an ISDN service. If you are using a service provider that requires SPIDs, your ISDN device cannot place or receive calls until it sends a valid assigned SPID to the service provider when accessing the switch to initialize the connection.

 [bookmark: pgfId-313198]Valid SPIDs can contain up to 20 characters, including spaces and special characters.

 [bookmark: pgfId-313200]Note We recommend that you do not enter a SPID for interfaces using the AT&T 5ESS switch type, even though they are supported.

  
        

 
         
         		[bookmark: pgfId-313206]SPID2

  
         		[bookmark: pgfId-313208]Applies only when you select DMS-100 or NI as the switch type.

 [bookmark: pgfId-313210]The service provider identifier (SPID) for a second ISDN service to which the interface subscribes. Valid SPIDs can contain up to 20 alphanumeric characters (no spaces are permitted).

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-317563][bookmark: 134620][bookmark: rtchap_cncpt_ADSLonCiscoIOSRouters]ADSL on Cisco IOS Routers[bookmark: marker-317557][bookmark: marker-317559][bookmark: marker-317561]

 
    [bookmark: pgfId-317567][bookmark: marker-317565] Digital Subscriber Line (DSL) is a family of technologies that transports data over existing twisted-pair copper wire. DSL uses frequencies that are beyond the upper list used by POTS (plain old telephone service) to deliver broadband applications, such as multimedia and video, over the local loop (or last mile) that connects the telephone companyâ��s central office to customer sites.

 
    [bookmark: pgfId-317573]Asymmetric Digital Subscriber Line (ADSL) is a form of DSL where the data flow downstream to customer sites is much greater than the data flow upstream to the central office (CO). This asymmetric setup is well-suited for applications where users typically download far more information than they send, such as web surfing, video-on-demand, and remote LAN access. With ADSL, the connection speed is related to the distance between the customer site and the [bookmark: marker-317569][bookmark: marker-317571] digital subscriber line-access multiplexer (DSLAM) that aggregates the connections from multiple customer sites onto a high-speed line.

 
    [bookmark: pgfId-317575]ADSL downstream rates range from 1.5 to 9 Mbps, whereas upstream bandwidth ranges from 16 to 640 kbps. ADSL transmissions work at distances up to 18,000 feet (5,488 meters) over a single copper twisted pair. Newer versions of ADSL technology, such as ADSL2 and ADSL2+, offer even higher data rates for short distances, as well as power management and realtime performance monitoring.

 
    [bookmark: pgfId-317580]ATM is used in many ADSL implementations due to its small, fixed-length cell size, which makes it suitable for carrying time-critical traffic, such as voice and video, in conjunction with other traffic. You can use Security Manager to configure ATM over DSL on a Cisco IOS router. For more information about configuring ADSL policies in Security Manager, see Defining ADSL Settings.

 
    [bookmark: pgfId-317582]To configure ADSL in Security Manager, you must do the following:

 
    [bookmark: pgfId-317587] 1. Configure an ATM interface or subinterface. See Defining Basic Router Interface Settings.

 
    [bookmark: pgfId-317592] 2. Configure ADSL settings on the ATM interface or subinterface. See Defining ADSL Settings.

 
    [bookmark: pgfId-317597] 3. Configure PVCs on the ATM interface or subinterface. See Defining ATM PVCs.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-317599]Note If you perform discovery on the device, Security Manager populates the Interfaces policy with the ATM interface and subinterface and the ADSL policy with the ADSL settings for that interface. Any discovered PVCs are added to the PVC policy.


    
     

    

    

 
    [bookmark: pgfId-317601]Related Topics

 
     
     		 [bookmark: pgfId-317606]Supported ADSL Operating Modes

 
    

 
     
      [bookmark: pgfId-317614][bookmark: 134662][bookmark: rtchap_cncpt_SupportedADSLOperatingModes]Supported ADSL Operating Modes[bookmark: marker-317612]

 
     [bookmark: pgfId-317619]Table 61-14 describes the operating modes that are supported on each ADSL interface card that can be configured with Security Manager.

 
     [bookmark: pgfId-317622] 

 
      
       
        
        [bookmark: pgfId-313223]Table 61-14 [bookmark: 134670]ADSL Cards and Supported DSL Operating Modes 

 
        
       
         
         		
           
           [bookmark: pgfId-313229]ADSL Interface Card
          
  
         		
           
           [bookmark: pgfId-313231]Supported DSL Operating Modes
          
  
        

 
         
         		[bookmark: pgfId-313237]WIC-1ADSL

  
         		[bookmark: pgfId-313239]auto, ansi-dmt, itu-dmt, splitterless

  
        

 
         
         		[bookmark: pgfId-313245]WIC-1ADSL-I-DG

  
         		[bookmark: pgfId-313247]auto, etsi, itu-dmt

  
        

 
         
         		[bookmark: pgfId-313253]WIC-1ADSL-DG

  
         		[bookmark: pgfId-313255]auto, ansi-dmt, itu-dmt, splitterless

  
        

 
         
         		[bookmark: pgfId-313261]HWIC-1ADSL

  
         		[bookmark: pgfId-313263]auto, ansi-dmt, itu-dmt, adsl2, adsl2+

  
        

 
         
         		[bookmark: pgfId-313269]HWIC-1ADSLI

  
         		[bookmark: pgfId-313271]auto, etsi, itu-dmt, adsl2, adsl2+

  
        

 
         
         		[bookmark: pgfId-313277]HWIC-ADSL-B/ST

  
         		[bookmark: pgfId-313279]auto, ansi-dmt, itu-dmt, adsl2, adsl2+

  
        

 
         
         		[bookmark: pgfId-313285]HWIC-ADSLI-B/ST

  
         		[bookmark: pgfId-313287]auto, etsi, itu-dmt, adsl2, adsl2+

  
        

 
       
      

 
     
 
     [bookmark: pgfId-317627]Table 61-15 describes the operating modes that are supported on each ADSL device that can be configured with Security Manager.

 
     [bookmark: pgfId-317630] 

 
      
       
        
        [bookmark: pgfId-313300]Table 61-15 [bookmark: 134718]Fixed ADSL Devices and Supported DSL Operating Modes 

 
        
       
         
         		
           
           [bookmark: pgfId-313306]Device
          
  
         		
           
           [bookmark: pgfId-313308]Supported DSL Operating Modes
          
  
        

 
         
         		[bookmark: pgfId-313314]857 Integrated Services Router

  
         		[bookmark: pgfId-313316]auto, ansi-dmt, itu-dmt, adsl2, adsl2+

  
        

 
         
         		[bookmark: pgfId-313322]876 Integrated Services Router

  
         		[bookmark: pgfId-313324]auto, etsi, itu-dmt, adsl2, adsl2+

  
        

 
         
         		[bookmark: pgfId-313330]877 Integrated Services Router

  
         		[bookmark: pgfId-313332]auto, ansi-dmt, itu-dmt, adsl2, adsl2+

  
        

 
         
         		[bookmark: pgfId-313338]1801 Integrated Services Router

  
         		[bookmark: pgfId-313340]auto, ansi-dmt, itu-dmt, adsl2, adsl2+

  
        

 
         
         		[bookmark: pgfId-313346]1802 Integrated Services Router

  
         		[bookmark: pgfId-313348]auto, etsi, itu-dmt, adsl2, adsl2+

  
        

 
       
      

 
     
 
     [bookmark: pgfId-317632]Related Topics

 
      
      		 [bookmark: pgfId-317637]Defining ADSL Settings

 
      		 [bookmark: pgfId-317642]ADSL on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-317650][bookmark: 134763][bookmark: rtchap_proc_DefiningADSLSettings]Defining ADSL Settings[bookmark: marker-317648]

 
     [bookmark: pgfId-317654]When you configure an ADSL definition in Security Manager, you must select the ATM interface on which ADSL is being defined. In addition, we highly recommend that you specify the router type or the type of [bookmark: marker-317652] WIC (WAN interface card) installed in the router. The validity of DSL policy definitions is highly dependent on the hardware. By specifying the hardware used by this policy, you enable Security Manager to properly validate the values you define and avoid deployment failures.

 
     [bookmark: pgfId-317656]You can optionally specify the following parameters:

 
      
      		 [bookmark: pgfId-317658]The DSL operating mode.

 
      		 [bookmark: pgfId-317660]Whether to enable dynamic VC bandwidth adjustments when using Inverse Multiplexing over ATM (IMA).

 
      		 [bookmark: pgfId-317662]Whether certain interface cards should use a particular set of carrier tones.

 
     

 
     [bookmark: pgfId-317664]Modular Cisco IOS routers may contain multiple interface cards, each of which contains a single ATM interface. You may define only one ADSL definition per interface.

 
     [bookmark: pgfId-317666]Before You Begin

 
      
      		 [bookmark: pgfId-317671]Make sure that the device contains an ADSL ATM interface. See Basic Interface Settings on Cisco IOS Routers.

 
     

 
     [bookmark: pgfId-317673]Related Topics

 
      
      		 [bookmark: pgfId-317678]Supported ADSL Operating Modes

 
      		 [bookmark: pgfId-317683]ADSL on Cisco IOS Routers

 
      		 [bookmark: pgfId-317688]PVCs on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-317690]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-317692](Device view) Select  Interfaces > Settings > DSL > ADSL from the Policy selector.

 
      		 [bookmark: pgfId-317694](Policy view) Select  Router Interfaces > Settings > DSL > ADSL from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-317699]The ADSL page is displayed. See Table 61-16 for a description of the fields on this page.

 
     [bookmark: pgfId-317706]Step 2 [bookmark: 134810]Click the Add button beneath the table to display the ADSL Settings dialog box. See Table 61-17 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-317711]Step 3 In the ATM Interface field, enter the name of the ATM interface or interface role on which you want to define ADSL settings, or click Select to select an interface role or create a new one. For more information, see Specifying Interfaces During Policy Definition.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-317713]Note The interface that you select must be physically present on the device; otherwise, deployment fails.


     
      

     

     

 
     [bookmark: pgfId-317715]Step 4 (Optional) Select the interface card type installed on the router.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-317717]Note When discovering from a live device, the correct interface card type is already displayed. If you did not perform discovery on a live device, or if Security Manager cannot detect the type of interface card installed on the device, this field displays â��Unknownâ��.


     
      

     

     

 
     [bookmark: pgfId-317719]Step 5 (Optional) When using IMA groups, select the Allow bandwidth change on ATM PVCs check box to enable dynamic adjustments to VC bandwidth in response to changes in group bandwidth. If this check box is left deselected, you must make these adjustments manually.

 
     [bookmark: pgfId-317724]Step 6 (Optional) Specify the DSL operating mode for this ATM interface. See Table 61-14 for a list of the operating modes supported for each card type.

 
     [bookmark: pgfId-317726]Step 7 (Optional) Select the Use low tone set check box to have the interface card use carrier tones 29 through 48.

 
     [bookmark: pgfId-317730]Step 8 [bookmark: 134831]Click OK to save your definitions locally on the client and close the dialog box. Your definitions are displayed in the ADSL table.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-317732]Note To edit an ADSL definition, select it from the table, then click Edit. To remove an ADSL definition, select it, then click Delete.


     
      

     

     

 
     [bookmark: pgfId-317740]Step 9 Repeat Step 2 through Step 8 to define ADSL settings on additional ATM interfaces. Only one ADSL definition may be defined on an interface.

 
     [bookmark: pgfId-317742]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-317754][bookmark: 134845][bookmark: rtpage_cncpt_ADSLPolicyPage]ADSL Policy Page[bookmark: marker-317750][bookmark: marker-317752]

 
    [bookmark: pgfId-317759]Use the ADSL page to create, edit, and delete ADSL definitions on the ATM interfaces of the router. For more information, see Defining ADSL Settings.

 
    [bookmark: pgfId-317761]Navigation Path

 
     
     		 [bookmark: pgfId-317763](Device view) Select  Interfaces > Settings > DSL > ADSL from the Policy selector.

 
     		 [bookmark: pgfId-317765](Policy view) Select  Router Interfaces > Settings > DSL > ADSL from the Policy Type selector. Right-click  ADSL to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-317767]Related Topics

 
     
     		 [bookmark: pgfId-317772]PVC Policy Page

 
     		 [bookmark: pgfId-317777]SHDSL Policy Page

 
     		 [bookmark: pgfId-317782]ADSL on Cisco IOS Routers

 
     		 [bookmark: pgfId-317787]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-317792]Filtering Tables

 
    

 
    [bookmark: pgfId-317794]Field Reference

 
    [bookmark: pgfId-317797] 

 
     
      
       
       [bookmark: pgfId-313361]Table 61-16 [bookmark: 134888]ADSL Page 

 
       
      
        
        		
          
          [bookmark: pgfId-313367]Element
         
  
        		
          
          [bookmark: pgfId-313369]Description
         
  
       

 
        
        		[bookmark: pgfId-313375]ATM Interface

  
        		[bookmark: pgfId-313377]The ATM interface on which ADSL settings are defined.

  
       

 
        
        		[bookmark: pgfId-313383]Interface Card

  
        		[bookmark: pgfId-313385]The type of device or ADSL interface card on which the ATM interface resides.

  
       

 
        
        		[bookmark: pgfId-313391]Bandwidth Change

  
        		[bookmark: pgfId-313393]Indicates whether the router makes dynamic adjustments to VC bandwidth as overall bandwidth changes. (This is relevant only when IMA groups are configured on the ATM interface.)

  
       

 
        
        		[bookmark: pgfId-313399]DSL Operating Mode

  
        		[bookmark: pgfId-313401]The DSL operating mode for this interface.

  
       

 
        
        		[bookmark: pgfId-313407]Tone Low

  
        		[bookmark: pgfId-313409]Indicates whether the interface is using the low tone set (carrier tones 29 through 48).

  
       

 
        
        		[bookmark: pgfId-313415]Add button

  
        		[bookmark: pgfId-313420]Opens the ADSL Settings Dialog Box. From here you can define the ADSL settings for a selected ATM interface.

  
       

 
        
        		[bookmark: pgfId-313426]Edit button

  
        		[bookmark: pgfId-313431]Opens the ADSL Settings Dialog Box. From here you can edit the selected ADSL definition.

  
       

 
        
        		[bookmark: pgfId-313437]Delete button

  
        		[bookmark: pgfId-313439]Deletes the selected ADSL definition from the table.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-317809][bookmark: 134940][bookmark: rtpage_cncpt_ADSLSettingsDialogBox]ADSL Settings Dialog Box[bookmark: marker-317805][bookmark: marker-317807]

 
     [bookmark: pgfId-317811]Use the ADSL Settings dialog box to configure ADSL settings on a selected ATM interface.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-317813]Note When you configure ADSL settings, we highly recommend that you select the type of device or interface card on which the ATM interface is defined. ADSL settings are highly dependent on the hardware. Defining the hardware type in Security Manager enables proper validation of your configuration for a successful deployment to your devices.


     
      

     

     

 
     [bookmark: pgfId-317815]Navigation Path

 
     [bookmark: pgfId-317820]Go to the ADSL Policy Page, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-317822]Related Topics

 
      
      		 [bookmark: pgfId-317827]Defining ADSL Settings

 
      		 [bookmark: pgfId-317832]PVC Policy Page

 
     

 
     [bookmark: pgfId-317834]Field Reference

 
     [bookmark: pgfId-317837] 

 
      
       
        
        [bookmark: pgfId-313452]Table 61-17 [bookmark: 134970]ADSL Settings Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-313458]Element
          
  
         		
           
           [bookmark: pgfId-313460]Description
          
  
        

 
         
         		[bookmark: pgfId-313466]ATM Interface

  
         		[bookmark: pgfId-313468]The ATM interface on which ADSL settings are defined. Enter the name of an interface or interface role, or click Select to select it. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-313470]Note We recommend that you do not define an interface role that includes ATM interfaces from different interface cards. The different settings supported by each card type may cause deployment to fail.

 [bookmark: pgfId-313472]Note You can create only one ADSL definition per interface.

  
        

 
         
         		[bookmark: pgfId-313478]Interface Card

  
         		[bookmark: pgfId-313480]The device type or the type of interface card installed on the router:

 
           
           		 [bookmark: pgfId-313482][blank]â��The interface card type is not defined.

 
           		 [bookmark: pgfId-313484]WIC-1ADSLâ��A 1-port ADSL WAN interface card that provides ADSL over POTS (ordinary telephone lines).

 
           		 [bookmark: pgfId-313486]WIC-1ADSL-I-DGâ��A 1-port ADSL WAN interface card that provides ADSL over ISDN with Dying Gasp support. (With Dying Gasp, the router warns the DSLAM of imminent line drops when the router is about to lose power.)

 
           		 [bookmark: pgfId-313488]WIC-1ADSL-DGâ��A 1-port ADSL WAN interface card that provides ADSL over POTS with Dying Gasp support.

 
           		 [bookmark: pgfId-313490]HWIC-1ADSLâ��A 1-port high-speed ADSL WAN interface card that provides ADSL over POTS.

 
           		 [bookmark: pgfId-313492]HWIC-1ADSLIâ��A 1-port high-speed ADSL WAN interface card that provides ADSL over ISDN.

 
           		 [bookmark: pgfId-313494]HWIC-ADSL-B/STâ��A 2-port high-speed ADSL WAN interface card that provides ADSL over POTS with an ISDN BRI port for backup.

 
           		 [bookmark: pgfId-313496]HWIC-ADSLI-B/STâ��A 2-port high-speed ADSL WAN interface card that provides ADSL over ISDN with an ISDN BRI port for backup.

 
          

  
        

 
         
         		[bookmark: pgfId-313502]Interface Card (continued)

  
         		
           
           		 [bookmark: pgfId-313504]857 ADSLâ��Cisco 857 Integrated Service Router with an ADSL interface.

 
           		 [bookmark: pgfId-313506]876 ADSLâ��Cisco 876 Integrated Services Router with an ADSL interface.

 
           		 [bookmark: pgfId-313508]877 ADSLâ��Cisco 877 Integrated Services Router with an ADSL interface.

 
           		 [bookmark: pgfId-313510]1801 ADSLoPOTSâ��Cisco 1801 Integrated Services Router that provides ADSL over POTS.

 
           		 [bookmark: pgfId-313512]1802 ADSLoISDNâ��Cisco 1802 Integrated Services Router that provides ADSL over ISDN.

 
          

 [bookmark: pgfId-313514]Note When discovering from a live device, the correct interface card type will already be displayed. If you did not perform discovery on a live device, or if Security Manager cannot detect the type of interface card installed on the device, this field displays â��Unknownâ��.

  
        

 
         
         		[bookmark: pgfId-313520]Allow bandwidth change on ATM PVCs

  
         		[bookmark: pgfId-313524]When selected, the router makes dynamic adjustments to VC bandwidth in response to changes in the overall bandwidth of the [bookmark: marker-313522] Inverse Multiplexing over ATM (IMA) group defined on the ATM interface.

 [bookmark: pgfId-313526]When deselected, PVC bandwidth must be adjusted manually (using the CLI) whenever an individual physical link in the IMA group goes up or down.

  
        

 
         
         		[bookmark: pgfId-313532]DSL Operating Mode

  
         		[bookmark: pgfId-313534]The operating mode configured for this ADSL line:

 
           
           		 [bookmark: pgfId-313536]autoâ��Performs automatic negotiation with the DSLAM located at the central office (CO). This is the default.

 
           		 [bookmark: pgfId-313538]ansi-dmtâ��The line trains in ANSI T1.413 Issue 2 mode.

 
           		 [bookmark: pgfId-313540]itu-dmtâ��The line trains in G.992.1 mode.

 
           		 [bookmark: pgfId-313542]splitterlessâ��The line trains in G.992.2 (G.Lite) mode.

 
           		 [bookmark: pgfId-313544]etsiâ��The line trains in ETSI (European Telecommunications Standards Institute) mode.

 
           		 [bookmark: pgfId-313546]adsl2â��The line trains in G.992.3 (adsl2)mode.

 
           		 [bookmark: pgfId-313548]adsl2+â��The line trains in G.992.5 (adsl2+) mode.

 
          

 [bookmark: pgfId-313553]Note See Table 61-14 for a description of the operating modes that are supported by each card type.

  
        

 
         
         		[bookmark: pgfId-313559]Use low tone set

  
         		[bookmark: pgfId-313561]When selected, the interface card uses carrier tones 29 through 48.

 [bookmark: pgfId-313563]When deselected, the interface card uses carrier tones 33 through 56.

 [bookmark: pgfId-313565]Note Leave this option deselected when the interface card is operating in accordance with Deutsche Telekom specification U-R2.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-317849][bookmark: 135066][bookmark: rtchap_cncpt_SHDSLonCiscoIOSRouters]SHDSL on Cisco IOS Routers[bookmark: marker-317843][bookmark: marker-317845][bookmark: marker-317847]

 
    [bookmark: pgfId-317851]Digital Subscriber Line (DSL) is a family of technologies that transports data over existing twisted-pair copper wire. DSL uses frequencies that are beyond the upper list used by POTS (plain old telephone service) to deliver broadband applications, such as multimedia and video, over the local loop (or last mile) that connects the telephone companyâ��s central office to customer sites.

 
    [bookmark: pgfId-317853]Based on the International Telecommunications Union (ITU) G.991.2 global industry standard, symmetric high-speed digital subscriber line (SHDSL) delivers symmetrical data rates from 192 up to 2.3 Mbps on a single wire pair. It transports many types of signals, such as T1, E1, ISDN, ATM, and IP. In addition, the G.SHDSL signal has a greater distance reach from the central office than ADSL and proprietary SDSL connections.

 
    [bookmark: pgfId-317855]To configure SHDSL in Security Manager, do the following:

 
    [bookmark: pgfId-317860] 1. Configure the SHDSL controller. See Defining SHDSL Controllers.

 
    [bookmark: pgfId-317865] 2. Deploy the SHDSL policy. If ATM mode is activated, the router creates an ATM interface that corresponds to the controller upon deployment. See Working with Deployment and the Configuration Archive.

 
    [bookmark: pgfId-317870] 3. Rediscover the device to add the new ATM interface to Security Manager. See Discovering Policies on Devices Already in Security Manager.

 
    [bookmark: pgfId-317875] 4. (Optional) Create one or more subinterfaces on the ATM interface. See Defining Basic Router Interface Settings.

 
    [bookmark: pgfId-317880] 5. Configure PVCs on the ATM interface or subinterface. See Defining ATM PVCs.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-317882]Note If you perform discovery on the device, Security Manager populates the SHDSL policy with the definition of the controller and the Interfaces policy with the ATM interface and subinterface. Any discovered PVCs are added to the PVC policy.


    
     

    

    

 
    [bookmark: pgfId-317884]Related Topics

 
     
     		 [bookmark: pgfId-317889]PVCs on Cisco IOS Routers

 
    

 
     
      [bookmark: pgfId-317897][bookmark: 135105][bookmark: rtchap_proc_DefiningSHDSLControllers]Defining SHDSL Controllers[bookmark: marker-317895]

 
     [bookmark: pgfId-317899]When you configure an SHDSL controller in Security Manager, you must enter the name of the controller that is installed in the Cisco IOS router. The following settings are then applied automatically:

 
      
      		 [bookmark: pgfId-317901]ATM mode is enabled.

 
      		 [bookmark: pgfId-317903]The line termination is set to CPE (customer premises equipment).

 
      		 [bookmark: pgfId-317905]The line mode is set to Auto.

 
     

 
     [bookmark: pgfId-317907]You can optionally change the line termination to CO and specify the DSL mode and line mode. In addition, you can define signal-to-noise ratio margins to improve line stability.

 
     [bookmark: pgfId-317909]A Cisco IOS router may contain multiple SHDSL controllers. You may define only one SHDSL definition per controller.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-317914]Note When you deploy an SHDSL policy with ATM mode enabled, an ATM interface is created automatically on the router. Perform rediscovery to add the interface into Security Manager. You can then define PVCs on the ATM interface as required. See Defining ATM PVCs.


     
      

     

     

 
     [bookmark: pgfId-317916]Before You Begin

 
      
      		 [bookmark: pgfId-317918]Make sure that an SHDSL controller in installed on the device.

 
     

 
     [bookmark: pgfId-317920]Related Topics

 
      
      		 [bookmark: pgfId-317925]SHDSL on Cisco IOS Routers

 
      		 [bookmark: pgfId-317930]PVCs on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-317932]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-317934](Device view) Select  Interfaces > Settings > DSL > SHDSL from the Policy selector.

 
      		 [bookmark: pgfId-317936](Policy view) Select  Router Interfaces > Settings > DSL > SHDSL from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-317941]The SHDSL page is displayed. See Table 61-18 for a description of the fields on this page.

 
     [bookmark: pgfId-317945]Step 2 [bookmark: 135148]Click the Add button beneath the table to display the SHDSL dialog box.

 
     [bookmark: pgfId-317950]Step 3 Enter the name of the controller, or click Select to display the utility for generating the name. See Controller Auto Name Generator Dialog Box.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-317952]Note The controller that you select must be physically present on the device; otherwise, deployment fails.


     
      

     

     

 
     [bookmark: pgfId-317957]Step 4 Define the SHDSL controller as required. For more information, see Table 61-19.

 
     [bookmark: pgfId-317961]Step 5 [bookmark: 135159]Click OK to save your definitions locally on the client and close the dialog box. Your definitions are displayed in the SHDSL table.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-317963]Note To edit an SHDSL controller, select it from the table, then click Edit. To remove an SHDSL controller, select it, then click Delete.


     
      

     

     

 
     [bookmark: pgfId-317971]Step 6 Repeat Step 2 through Step 5 to define additional SHDSL controllers. Only one definition may be defined per controller.

 
     [bookmark: pgfId-317973]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-317985][bookmark: 135173][bookmark: rtpage_cncpt_SHDSLPolicyPage]SHDSL Policy Page[bookmark: marker-317981][bookmark: marker-317983]

 
    [bookmark: pgfId-317990]Use the SHDSL page to create, edit, and delete DSL controller definitions on the router. For more information, see Defining SHDSL Controllers.

 
    [bookmark: pgfId-317992]Navigation Path

 
     
     		 [bookmark: pgfId-317994](Device view) Select  Interfaces > Settings > DSL > SHDSL from the Policy selector.

 
     		 [bookmark: pgfId-317996](Policy view) Select  Router Interfaces > Settings > DSL > SHDSL from the Policy Type selector. Right-click  SHDSL to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-317998]Related Topics

 
     
     		 [bookmark: pgfId-318003]PVC Policy Page

 
     		 [bookmark: pgfId-318008]ADSL Policy Page

 
     		 [bookmark: pgfId-318013]SHDSL on Cisco IOS Routers

 
     		 [bookmark: pgfId-318018]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-318023]Filtering Tables

 
    

 
    [bookmark: pgfId-318025]Field Reference

 
    [bookmark: pgfId-318028] 

 
     
      
       
       [bookmark: pgfId-313578]Table 61-18 [bookmark: 135216]SHDSL Page 

 
       
      
        
        		
          
          [bookmark: pgfId-313584]Element
         
  
        		
          
          [bookmark: pgfId-313586]Description
         
  
       

 
        
        		[bookmark: pgfId-313592]Name

  
        		[bookmark: pgfId-313594]The name of the DSL controller.

  
       

 
        
        		[bookmark: pgfId-313600]Description

  
        		[bookmark: pgfId-313602]An optional description of the controller.

  
       

 
        
        		[bookmark: pgfId-313608]Shutdown

  
        		[bookmark: pgfId-313610]Indicates whether the DSL controller is in shutdown mode.

  
       

 
        
        		[bookmark: pgfId-313616]Configure ATM Mode

  
        		[bookmark: pgfId-313618]Indicates whether the DSL controller has been set into ATM mode.

  
       

 
        
        		[bookmark: pgfId-313624]Line Termination

  
        		[bookmark: pgfId-313626]The line termination set for the router (CPE or CO).

  
       

 
        
        		[bookmark: pgfId-313632]DSL Mode

  
        		[bookmark: pgfId-313634]The operating mode defined for the DSL controller.

  
       

 
        
        		[bookmark: pgfId-313640]Line Mode

  
        		[bookmark: pgfId-313642]The line mode defined for the DSL controller.

  
       

 
        
        		[bookmark: pgfId-313648]Line Rate

  
        		[bookmark: pgfId-313650]The line rate (in kbps) defined for the DSL controller.

 [bookmark: pgfId-313652]Note A value is displayed in this column only if the line mode is not set to Auto.

  
       

 
        
        		[bookmark: pgfId-313658]SNR Margin Current

  
        		[bookmark: pgfId-313660]The current signal-to-noise ratio on the controller.

  
       

 
        
        		[bookmark: pgfId-313666]SNR Margin Snext

  
        		[bookmark: pgfId-313668]The self near-end crosstalk (Snext) signal-to-noise ratio on the controller.

  
       

 
        
        		[bookmark: pgfId-313674]Add button

  
        		[bookmark: pgfId-313679]Opens the SHDSL Controller Dialog Box. From here you can define the settings for a DSL controller.

  
       

 
        
        		[bookmark: pgfId-313685]Edit button

  
        		[bookmark: pgfId-313690]Opens the SHDSL Controller Dialog Box. From here you can edit the selected DSL controller definition.

  
       

 
        
        		[bookmark: pgfId-313696]Delete button

  
        		[bookmark: pgfId-313698]Deletes the selected DSL controller definition from the table.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-318040][bookmark: 135294][bookmark: rtpage_cncpt_SHDSLControllerDialogBox]SHDSL Controller Dialog Box[bookmark: marker-318036][bookmark: marker-318038]

 
     [bookmark: pgfId-318042]Use the SHDSL Controller dialog box to configure SHDSL controllers.

 
     [bookmark: pgfId-318044]Navigation Path

 
     [bookmark: pgfId-318049]Go to the SHDSL Policy Page, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-318051]Related Topics

 
      
      		 [bookmark: pgfId-318056]Defining SHDSL Controllers

 
      		 [bookmark: pgfId-318061]PVC Policy Page

 
      		 [bookmark: pgfId-318066]Discovering Policies on Devices Already in Security Manager

 
     

 
     [bookmark: pgfId-318068]Field Reference

 
     [bookmark: pgfId-318071] 

 
      
       
        
        [bookmark: pgfId-313711]Table 61-19 [bookmark: 135326]SHDSL Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-313717]Element
          
  
         		
           
           [bookmark: pgfId-313719]Description
          
  
        

 
         
         		[bookmark: pgfId-313725]Name

  
         		[bookmark: pgfId-313730]The name of the controller. Enter a name manually, or click Select to display a dialog box for generating a name. See Controller Auto Name Generator Dialog Box.

  
        

 
         
         		[bookmark: pgfId-313736]Description

  
         		[bookmark: pgfId-313738]Additional information about the controller (up to 80 characters).

  
        

 
         
         		[bookmark: pgfId-313744]Shutdown

  
         		[bookmark: pgfId-313746]When selected, the DSL controller is in shutdown state. However, its definition is not deleted.

 [bookmark: pgfId-313748]When deselected, the DSL controller is enabled. This is the default.

  
        

 
         
         		[bookmark: pgfId-313754]Configure ATM mode

  
         		[bookmark: pgfId-313756]When selected, sets the controller into ATM mode and creates an ATM interface with the same ID as the controller. This is the default. You must enable ATM mode and then perform rediscovery to configure ATM or PVCs on the device.

 [bookmark: pgfId-313758]When deselected, ATM mode is disabled. No ATM interface is created on deployment.

 [bookmark: pgfId-313760]Note You cannot remove ATM mode from a controller after it has been saved in Security Manager.

  
        

 
         
         		[bookmark: pgfId-313766]Line Termination

  
         		[bookmark: pgfId-313768]The line termination that is set for the router:

 
           
           		 [bookmark: pgfId-313770]CPEâ��Customer premises equipment. This is the default.

 
           		 [bookmark: pgfId-313772]COâ��Central office.

 
          

  
        

 
         
         		[bookmark: pgfId-313778]DSL Mode

  
         		[bookmark: pgfId-313780]The DSL operating mode, including regional operating parameters, used by the controller:

 
           
           		 [bookmark: pgfId-313782][blank]â��The operating mode is not defined. (When deployed, the Annex A standard for North America is used.)

 
           		 [bookmark: pgfId-313784]Aâ��Supports Annex A of the G.991.2 standard for North America.

 
           		 [bookmark: pgfId-313786]A-Bâ��Supports Annex A or Annex B. Available only when the Line Term is set to CPE. The appropriate mode is selected when the line trains.

 
           		 [bookmark: pgfId-313788]A-B-ANFPâ��Supports Annex A or Annex B-ANFP. Available only when the Line Term is set to CPE. The appropriate mode is selected when the line trains.

 
           		 [bookmark: pgfId-313790]Bâ��Supports Annex B of the G.991.2 standard for Europe.

 
           		 [bookmark: pgfId-313792]B-ANFPâ��Supports Annex B-ANFP (Access Network Frequency Plan).

 
          

 [bookmark: pgfId-313794]Note The available DSL modes are dependent on the selected line termination.

  
        

 
         
         		 [bookmark: pgfId-313800]Line Mode settings

  
        

 
         
         		[bookmark: pgfId-313808]Line Mode

  
         		[bookmark: pgfId-313810]The line mode used by the controller:

 
           
           		 [bookmark: pgfId-313812]autoâ��The controller operates in the same mode as the other line termination (2-wire line 0, 2-wire line 1, or 4-wire enhanced). This is the default for CPE line termination.

 
           		 [bookmark: pgfId-313814]2-wireâ��The controller operates in two-wire mode. This is the default for CO line termination.

 
           		 [bookmark: pgfId-313816]4-wireâ��The controller operates in four-wire mode.

 
          

 [bookmark: pgfId-313818]Note You can select Auto only when you configure the controller as the CPE.

  
        

 
         
         		[bookmark: pgfId-313824]Line

  
         		[bookmark: pgfId-313826]Applies only when the Line Mode is defined as 2-wire.

 [bookmark: pgfId-313828]The pair of wires to use:

 
           
           		 [bookmark: pgfId-313830]line-zeroâ��RJ-11 pin 1 and pin 2. This is the default for CO line termination.

 
           		 [bookmark: pgfId-313832]line-oneâ��RJ-11 pin 3 and pin 4.

 
          

  
        

 
         
         		[bookmark: pgfId-313838]Exchange Handshake

  
         		[bookmark: pgfId-313840]Applies only when the Line Mode is defined as 4-wire.

 [bookmark: pgfId-313842]The type of handshake mode to use:

 
           
           		 [bookmark: pgfId-313844][blank]â��The handshake mode is not specified. (When deployed, the enhanced option is used.) This is the default.

 
           		 [bookmark: pgfId-313846]enhancedâ��Exchanges handshake status on both wire pairs.

 
           		 [bookmark: pgfId-313848]standardâ��Exchanges handshake status on the master wire pair only.

 
          

  
        

 
         
         		[bookmark: pgfId-313854]Line Rate

  
         		[bookmark: pgfId-313856]Does not apply when the Line Mode is defined as Auto.

 [bookmark: pgfId-313858]The DSL line rate (in kbps) available for the SHDSL port:

 
           
           		 [bookmark: pgfId-313860]autoâ��The controller selects the line rate. This is available only in 2-wire mode.

 
           		 [bookmark: pgfId-313862]Supported line rates:

 
          

 [bookmark: pgfId-313864] â�� For 2-wire mode: 192, 256, 320, 384, 448, 512, 576, 640, 704, 768, 832, 896, 960, 1024, 1088, 1152, 1216, 1280, 1344, 1408, 1472, 1536, 1600, 1664, 1728, 1792, 1856, 1920, 1984, 2048, 2112, 2176, 2240, and 2304.

 [bookmark: pgfId-313866] â�� For 4-wire mode: 384, 512, 640, 768, 896, 1024, 1152, 1280, 1408, 1536, 1664, 1792, 1920, 2048, 2176, 2304, 2432, 2560, 2688, 2816, 2944, 3072, 3200, 3328, 3456, 3584, 3712, 3840, 3968, 4096, 4224, 4352, 4480, and 4608.

 [bookmark: pgfId-313868]Note Third-party equipment may use a line rate that includes an additional SHDSL overhead of 8 kbps for 2-wire mode or 16 kbps for 4-wire mode.

  
        

 
         
         		 [bookmark: pgfId-313874]SNR Margin settings

  
        

 
         
         		[bookmark: pgfId-313882]Current

  
         		[bookmark: pgfId-313884]The current signal-to-noise (SNR) ratio on the controller, in decibels (dB). Valid values range from -10 to 10 dB.

 [bookmark: pgfId-313886]This option can create a more stable line by making the line train more than current noise margin plus SNR ratio threshold during training time. If any external noise is applied that is less than the set SNR margin, the line will be stable.

 to disable the current SNR.

  
        

 
         
         		[bookmark: pgfId-313894]Snext

  
         		[bookmark: pgfId-313900][bookmark: marker-313896][bookmark: marker-313898] The Self Near-End Crosstalk (SNEXT) signal-to-noise ratio on the controller, in decibels. Valid values range from -10 to 10 dB.

 [bookmark: pgfId-313902]This option can create a more stable line by making the line train more than SNEXT threshold during training time. If any external noise is applied that is less than the set SNEXT margin, the line will be stable.

 to disable the SNEXT SNR.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-318083][bookmark: 135473][bookmark: rtpage_cncpt_ControllerAutoNameGeneratorDialogBox]Controller Auto Name Generator Dialog Box[bookmark: marker-318079][bookmark: marker-318081]

 
     [bookmark: pgfId-318085]Use the Controller Auto Name Generator dialog box to have Security Manager generate a name for the DSL controller based on its location in the router.

 
     [bookmark: pgfId-318087]Navigation Path

 
     [bookmark: pgfId-318092]Go to the SHDSL Controller Dialog Box, then click Select in the Name field.

 
     [bookmark: pgfId-318094]Related Topics

 
      
      		 [bookmark: pgfId-318099]Defining SHDSL Controllers

 
      		 [bookmark: pgfId-318104]SHDSL Policy Page

 
      		 [bookmark: pgfId-318109]PVC Policy Page

 
     

 
     [bookmark: pgfId-318111]Field Reference

 
     [bookmark: pgfId-318114] 

 
      
       
        
        [bookmark: pgfId-313917]Table 61-20 [bookmark: 135505]Controller Auto Name Generator Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-313923]Element
          
  
         		
           
           [bookmark: pgfId-313925]Description
          
  
        

 
         
         		[bookmark: pgfId-313931]Type

  
         		[bookmark: pgfId-313933]The type of interface. This field displays the value DSL and is read-only.

  
        

 
         
         		[bookmark: pgfId-313939]Card

  
         		[bookmark: pgfId-313941]The card related to the controller.

  
        

 
         
         		[bookmark: pgfId-313947]Slot

  
         		[bookmark: pgfId-313949]The slot related to the controller.

  
        

 
         
         		[bookmark: pgfId-313955]Port

  
         		[bookmark: pgfId-313957]The port related to the controller.

 [bookmark: pgfId-313959]Note The information you enter in these fields forms the remainder of the generated name, as displayed in the Result field.

  
        

 
         
         		[bookmark: pgfId-313965]Result

  
         		[bookmark: pgfId-313967]The name generated by Security Manager from the information you entered for the controller location. The name displayed in this field is read-only.

 [bookmark: pgfId-313969]Tip After closing this dialog box, you can edit the generated name in the SHDSL dialog box, if required.  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-318126][bookmark: 135544][bookmark: rtchap_cncpt_PVCsonCiscoIOSRouters]PVCs on Cisco IOS Routers[bookmark: marker-318120][bookmark: marker-318122][bookmark: marker-318124]

 
    [bookmark: pgfId-318132][bookmark: marker-318128][bookmark: marker-318130] Asynchronous Transfer Mode (ATM) is an International Telecommunication Union (ITU-T) standard designed for the high-speed transfer of voice, video, and data through public and private networks using cell relay technology. A cell switching and multiplexing technology, ATM combines the benefits of circuit switching (constant transmission delay, guaranteed capacity) with those of packet switching (flexibility, efficiency for intermittent traffic). An ATM network is made up of one or more ATM switches and ATM endpoints, such as a Cisco IOS router.

 
    [bookmark: pgfId-318134]There are three general types of ATM services, permanent virtual connections (PVCs), switched virtual connections (SVCs), and connectionless service. PVCs allow direct and permanent connections between sites to provide a service that is similar to a leased line. Advantages of PVCs are the guaranteed availability of a connection and that no call setup procedures are required between switches. Each piece of equipment between the source and destination must be manually provisioned for the PVC.

 
    [bookmark: pgfId-318136]For more information about ATM PVCs, see:

 
     
     		 [bookmark: pgfId-318141]Understanding Virtual Paths and Virtual Channels

 
     		 [bookmark: pgfId-318146]Understanding ATM Service Classes

 
     		 [bookmark: pgfId-318151]Understanding ATM Management Protocols

 
    

 
    [bookmark: pgfId-318153]For more information about defining PVCs in Security Manager, see:

 
     
     		 [bookmark: pgfId-318158]Defining ATM PVCs

 
     		 [bookmark: pgfId-318163]Defining OAM Management on ATM PVCs

 
    

 
    [bookmark: pgfId-318165]Related Topics

 
     
     		 [bookmark: pgfId-318170]ADSL on Cisco IOS Routers

 
     		 [bookmark: pgfId-318175]SHDSL on Cisco IOS Routers

 
    

 
     
      [bookmark: pgfId-318183][bookmark: 135590][bookmark: rtchap_cncpt_UnderstandingVirtualPathsandVirtualChannels]Understanding Virtual Paths and Virtual Channels[bookmark: marker-318181]

 
     [bookmark: pgfId-318185]ATM networks are fundamentally connection oriented. This means that a virtual connection needs to be established across the ATM network before any data transfer. Two types of ATM connections exist:

 
      
      		 [bookmark: pgfId-318193][bookmark: marker-318187][bookmark: marker-318189][bookmark: marker-318191] Virtual path connections (VPCs), identified by a virtual path identifier (VPI).

 
      		 [bookmark: pgfId-318201][bookmark: marker-318195][bookmark: marker-318197][bookmark: marker-318199] Virtual channel connections (VCCs), identified by the combination of a VPI and a VCI (virtual channel identifier). PVCs are a type of VCC where a permanent connection is defined between two sites.

 
     

 
     [bookmark: pgfId-318206]As shown in Figure 61-2, a virtual path is a bundle of virtual channels, all of which are switched transparently across the ATM network on the basis of the common VPI. A VPC can be thought of as a bundle of VCCs with the same VPI value.

 
     [bookmark: pgfId-318210]Figure 61-2 [bookmark: 135620]ATM Virtual Path and Virtual Channel Connections

 
     [bookmark: pgfId-318213] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-318215]Every cell header contains a VPI field and a VCI field, which explicitly associate a cell with a given virtual channel on a physical link. It is important to remember the following attributes of VPIs and VCIs:

 
      
      		 [bookmark: pgfId-318217]VPIs and VCIs are not addresses, such as MAC addresses used in LAN switching.

 
      		 [bookmark: pgfId-318219]VPIs and VCIs are explicitly assigned at each segment of a connection and, as such, have only local significance across a particular link. They are remapped, as appropriate, at each switching point.

 
     

 
     [bookmark: pgfId-318221]Using the VPI/VCI identifier, the ATM layer can multiplex (interleave), demultiplex, and switch cells from multiple connections. Certain VPI/VCI identifiers are reserved for particular uses, such as the Integrated Local Management Interface (ILMI).

 
     [bookmark: pgfId-318223]Related Topics

 
      
      		 [bookmark: pgfId-318228]Understanding ATM Service Classes

 
      		 [bookmark: pgfId-318233]Understanding ATM Management Protocols

 
      		 [bookmark: pgfId-318238]Defining ATM PVCs

 
      		 [bookmark: pgfId-318243]PVCs on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-318251][bookmark: 135646][bookmark: rtchap_cncpt_UnderstandingATMServiceClasses]Understanding ATM Service Classes[bookmark: marker-318249]

 
     [bookmark: pgfId-318253]Version 4.0 of the Traffic Management Specification published by the ATM Forum defines five service classes that describe the user traffic transmitted on a network and the quality of service that a network needs to provide for that traffic. Security Manager supports the following ATM service classes:

 
      
      		 [bookmark: pgfId-318259][bookmark: marker-318255] Available Bit Rate (ABR) This is a service class where ATM switches make no guarantee of cell delivery, but do guarantee a minimum bit rate and that cell loss is kept as low as possible with the use of a feedback mechanism. The ABR service category is designed for VCs that carry file transfers and other bursty, non-real-time traffic that requires a minimum amount of bandwidth. This bandwidth is specified via a minimum cell rate that must be available while the VC is configured and active. For more details, see  Understanding the Available Bit Rate (ABR) Service Category for ATM VCs at:  http://www.cisco.com/en/US/tech/tk39/tk51/technologies_tech_note09186a00800fbc76.shtml .

 
      		 [bookmark: pgfId-318265][bookmark: marker-318261] Constant Bit Rate (CBR) This is a service class where cells are transmitted in a continuous bitstream to meet voice and video QoS needs. The CBR service class is designed for ATM virtual circuits (VCs) that need a static amount of bandwidth that is continuously available for the duration of the active connection. An ATM VC configured as CBR can send cells at peak cell rate (PCR) at any time and for any duration. It also can send cells at a rate less than the PCR or even emit no cells. The configuration on CBR may vary with different platforms. For more details, see  Understanding the CBR Service Category for ATM VCs at:  http://www.cisco.com/en/US/tech/tk39/tk51/technologies_tech_note09186a0080094e6a.shtml .

 
      		 [bookmark: pgfId-318271][bookmark: marker-318267] Unspecified Bit Rate (UBR) This is a service class where the network management makes no Quality of Service (QoS) commitment. It models the best-effort service that the Internet normally provides and is suitable for applications tolerant to delay that do not require real-time responses. Examples include email, fax transmission, file transfers, Telnet, LAN and remote office interconnections. For more details, see  Understanding the UBR Service Category for ATM Virtual Circuits at:  http://www.cisco.com/en/US/tech/tk39/tk51/technologies_tech_note09186a00800a4837.shtml .

 
      		 [bookmark: pgfId-318277] Unspecified Bit Rate (UBR+) [bookmark: marker-318273] Cisco provides a variant of the UBR service class called UBR+. The main advantage of the UBR+ service class is that it allows an ATM end-system to signal a minimum cell rate to an ATM switch in a connection request, and the ATM network attempts to maintain this minimum as an end-to-end guarantee. For more details, see  Understanding the UBR+ Service Category for ATM VCs at:  http://www.cisco.com/en/US/tech/tk39/tk51/technologies_tech_note09186a0080094b40.shtml .

 
      		 [bookmark: pgfId-318283][bookmark: marker-318279] Variable Bit Rate - Non-Real Time (VBR-nrt) This service class is used to transmit non-real-time applications that are bursty in nature. The traffic characteristics are defined in terms of the Peak Cell Rate (PCR), Sustained Cell Rate (SCR), and Minimum Burst Size (MBS). For more details, see  Understanding the VBR-nrt Service Category and Traffic Shaping for ATM VCs at:  http://www.cisco.com/en/US/tech/tk39/tk51/technologies_tech_note09186a0080102a42.shtml .

 
      		 [bookmark: pgfId-318289][bookmark: marker-318285] Variable Bit Rate - Real Time (VBR-rt) This service class is used to transmit real-time data that is sensitive to time delays, like compressed voice over IP and video conferencing. As with VBR-nrt, VBR-rt traffic is defined in terms of a PCR, SCR, and MBS. For more details, see  Understanding the Variable Bit Rate Real Time (VBR-rt) Service Category for ATM VCs at:  http://www.cisco.com/en/US/tech/tk39/tk51/technologies_tech_note09186a0080094cd0.shtml .

 
     

 
     [bookmark: pgfId-318291]You can use these service classes to define ATM quality of service (QoS) guarantees, such as traffic shaping. Traffic shaping is the use of queues to constrain data bursts, limit peak data rate, and smooth jitter so that traffic fits within the envelope defined by the traffic contract. ATM devices use traffic shaping to adhere to the terms of the traffic contract.

 
     [bookmark: pgfId-318293]Related Topics

 
      
      		 [bookmark: pgfId-318298]Understanding Virtual Paths and Virtual Channels

 
      		 [bookmark: pgfId-318303]Understanding ATM Management Protocols

 
      		 [bookmark: pgfId-318308]Defining ATM PVCs

 
      		 [bookmark: pgfId-318313]PVCs on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-318321][bookmark: 135713][bookmark: rtchap_cncpt_UnderstandingATMManagementProtocols]Understanding ATM Management Protocols[bookmark: marker-318319]

 
     [bookmark: pgfId-318323]ATM uses two different types of signaling for tracking the status of PVCs:

 
      
      		 [bookmark: pgfId-318328]Integrated Local Management Interface (ILMI). For more information, see Understanding ILMI.

 
      		 [bookmark: pgfId-318333]Flow 4 (F4) and Flow 5 (F5) Operation, Administration, and Maintenance (OAM) cells. For more information, see Understanding OAM.

 
     

 
     [bookmark: pgfId-318335]Security Manager can be used to enable and disable ILMI on specific PVCs and to configure F5 OAM functionality.

 
     [bookmark: pgfId-318337]Related Topics

 
      
      		 [bookmark: pgfId-318342]Understanding Virtual Paths and Virtual Channels

 
      		 [bookmark: pgfId-318347]Understanding ATM Service Classes

 
      		 [bookmark: pgfId-318352]Defining ATM PVCs

 
      		 [bookmark: pgfId-318357]Defining OAM Management on ATM PVCs

 
      		 [bookmark: pgfId-318362]PVCs on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-318372][bookmark: 135746][bookmark: rtchap_cncpt_UnderstandingILMI]Understanding ILMI[bookmark: marker-318368][bookmark: marker-318370]

 
     [bookmark: pgfId-318374]The Integrated Local Management Interface (ILMI) is a protocol defined by the ATM Forum for setting and capturing physical layer, ATM layer, virtual path, and virtual circuit parameters on ATM interfaces. ILMI facilitates network-wide autoconfiguration by enabling devices to determine the status of components at the other end of a physical link and to negotiate a common set of operational parameters to ensure interoperability. The ATM routing protocols, PNNI (Private Network to Network Interface) and IISP (Interim-Interswitch Signaling Protocol), use this information to discover and bring up a network of interconnected ATM switch routers.

 
     [bookmark: pgfId-318376]When two ATM interfaces run the ILMI protocol, they exchange ILMI packets across the physical connection. These packets consist of SNMP messages as large as 484 octets. ATM interfaces encapsulate these messages in an ATM adaptation layer 5 (AAL5) trailer, segment the packet into cells, and schedule the cells for transmission. ATM interfaces use the SNMP object IDs in network functions such as permanent virtual circuit (PVC) autodiscovery, which is particularly useful in digital subscriber line (DSL) applications.

 
     [bookmark: pgfId-318378]ILMI organizes managed objects into multiple information bases (MIBs), including one for link management. This MIB contains the following object groups for all ATM interfaces:

 
      
      		 [bookmark: pgfId-318380]Physical layerâ��ILMI 4.0 discontinues or "deprecates" earlier physical-layer ILMI values and specifies the use of the standard Interface MIB (RFC 1213).

 
      		 [bookmark: pgfId-318382]ATM layerâ��Indicates the number of available bits for VPI and VCI values in the ATM cell header, maximum number of virtual path connections (VPCs) and virtual channel connections (VCCs) allowed, number of configured PVCs, and so on.

 
      		 [bookmark: pgfId-318384]Virtual path connectionâ��Indicates the up or down status of a VPC and its Quality of Service (QoS) parameters.

 
      		 [bookmark: pgfId-318386]Virtual channel connectionâ��Indicates the up or down status of the VCC and its QoS parameters.

 
     

 
     [bookmark: pgfId-318388]Administrators may enable or disable ILMI at will, but we highly recommend you enable it. Without ILMI, you must manually configure many of the parameters otherwise managed by ILMI for the ATM devices to operate correctly. ILMI operates over a reserved PVC of VPI=X, VCI=16.

 
     [bookmark: pgfId-318390]Related Topics

 
      
      		 [bookmark: pgfId-318395]Understanding ATM Management Protocols

 
      		 [bookmark: pgfId-318400]PVCs on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-318408][bookmark: 135777][bookmark: rtchap_cncpt_UnderstandingOAM]Understanding OAM[bookmark: marker-318406]

 
     [bookmark: pgfId-318410]The Operation, Administration, and Maintenance (OAM) feature provides fault management and performance management for ATM and is based on the standard defined in ITU recommendation I.610. OAM detects network connectivity failures on a PVC and reacts by bringing down the PVC. Without OAM, a PVC would remain up after network connectivity is lost. In such a situation, routing table entries would continue to point to the PVC, resulting in lost packets.

 
     [bookmark: pgfId-318412]Security Manager enables the use of F5 OAM, which operates at the virtual circuit (VC) level. To detect a failure along the PVC path on an end-device, such as a Cisco IOS router, OAM uses the following cells:

 
      
      		 [bookmark: pgfId-318416][bookmark: marker-318414] Loopback cellsâ��At regular intervals, routers configured for OAM send loopback cells which must be looped in the network. This looping point can be the machine at the end of the PVC (end-to-end loopback cells) or a device on the path (segment loopback cells). A failure occurs when the loopback cell fails to return to its point of origin.

 
      		 [bookmark: pgfId-318420][bookmark: marker-318418] Continuity Check (CC) cellsâ��CC cells are sent regularly by routers configured for OAM to check the integrity of the link. CC cells can be sent either end-to-end or confined to a particular segment of the PVC. Activation and deactivation cells are used to initiate and suspend continuity checking. Any connectivity failures are reported in special SNMP notifications.

 
      		 [bookmark: pgfId-318424][bookmark: marker-318422] Alarm Indication Signal (AIS) cellsâ��In the event of a failure at the physical layer, AIS cells are sent to downstream devices to report a virtual connection failure at the ATM layer. The PVC moves to the down state after a defined number of AIS cells are received and does not come up again until a defined interval passes without additional AIS cells.

 
      		 [bookmark: pgfId-318428][bookmark: marker-318426] Remote Detection Indication (RDI) cellsâ��When AIS cells are sent to warn downstream devices of a connectivity failure, RDI cells are sent upstream in response as a control and feedback mechanism for the network.

 
     

 
     [bookmark: pgfId-318430]AIS/RDI cells are sent using the same VPI/VCI as the user cells on the affected PVC until the failure is resolved.

 
     [bookmark: pgfId-318432]Related Topics

 
      
      		 [bookmark: pgfId-318437]Understanding ATM Management Protocols

 
      		 [bookmark: pgfId-318442]PVCs on Cisco IOS Routers

 
      		 [bookmark: pgfId-318447]Defining OAM Management on ATM PVCs

 
     

 
    
 
     
      [bookmark: pgfId-318455][bookmark: 135817][bookmark: rtchap_proc_DefiningATMPVCs]Defining ATM PVCs[bookmark: marker-318453]

 
     [bookmark: pgfId-318457]You define an ATM permanent virtual circuit (PVC) by selecting an ATM interface and then defining the following settings:

 
      
      		 [bookmark: pgfId-318459]The PVC ID.

 
      		 [bookmark: pgfId-318461]The type of encapsulation to use.

 
      		 [bookmark: pgfId-318463]Whether ILMI management is enabled on this PVC.

 
      		 [bookmark: pgfId-318465]Whether Inverse ARP (InARP) is used to learn the IP addresses of the destination devices.

 
      		 [bookmark: pgfId-318467]Options related to PPP over Ethernet (PPPoE) and PPP over ATM (PPPoA).

 
      		 [bookmark: pgfId-318469]Quality-of-service settings, such as traffic shaping.

 
      		 [bookmark: pgfId-318471]Static IP address mappings in place of InARP.

 
     

 
     [bookmark: pgfId-318476]For information about defining F5 Operation, Administration, and Maintenance (OAM) management, such as loopbacks and continuity checks, on PVCs, see Defining OAM Management on ATM PVCs.

 
     [bookmark: pgfId-318478]Before You Begin

 
      
      		 [bookmark: pgfId-318486]When configuring ATM over DSL, make sure that you have configured either an ADSL policy (seeADSL on Cisco IOS Routers) or an SHDSL policy (SHDSL on Cisco IOS Routers).

 
      		 [bookmark: pgfId-318491]Make sure that the device contains an ATM interface and subinterface. (PVCs are typically configured on ATM subinterfaces.) See Basic Interface Settings on Cisco IOS Routers.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-318496]Note When configuring ATM for SHDSL, the ATM interface is created when you define the SHDSL controller and enable ATM mode. You must then rediscover the device to add the ATM interface to Security Manager. See Defining SHDSL Controllers.


     
      

     

     

 
     [bookmark: pgfId-318498]Related Topics

 
      
      		 [bookmark: pgfId-318503]Defining OAM Management on ATM PVCs

 
      		 [bookmark: pgfId-318508]Understanding Policing and Shaping Parameters

 
      		 [bookmark: pgfId-318513]PVCs on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-318515]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-318517](Device view) Select  Interfaces > Settings > PVC from the Policy selector.

 
      		 [bookmark: pgfId-318519](Policy view) Select  Router Interfaces > Settings > PVC from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-318524]The PVC page is displayed. See Table 61-21 for a description of the fields on this page.

 
     [bookmark: pgfId-318531]Step 2 [bookmark: 135876]Click the Add button beneath the table to display the PVC dialog box. See Table 61-22 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-318533]Step 3 In the Interface field, enter the name of the ATM interface, ATM subinterface, or interface role on which you want to define the PVC, or click Select to select an interface role or to create a new one.

 
     [bookmark: pgfId-318535]Step 4 Select the type of device or DSL WAN interface card that contains the ATM interface.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-318537]Note We highly recommend that you define this setting to ensure the proper validation of your PVC policy, as the settings in this policy are highly hardware-dependent.


     
      

     

     

 
     [bookmark: pgfId-318539]Step 5 On the Settings tab of the PVC dialog box, define the basic settings of the PVC:

 
     [bookmark: pgfId-318541] a. Enter the VPI/VCI identifier and an optional text handle. If you are defining the management PVC, select the Management PVC (ILMI) check box.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-318543]Note An error occurs if two users attempt to define PVCs with the same identifiers at the same time.


     
      

     

     

 
     [bookmark: pgfId-318545] b. Select the type of ATM encapsulation to use. If you select aal5autoppp or aal5ciscoppp, you must define the virtual template to use for PPPoA, or click Select to display a selector. If you select aal5mux as the encapsulation type, you must select the protocol that is carried by the PVC.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-318547]Note Do not select an encapsulation type when defining the management PVC.
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     [bookmark: pgfId-318549]Note If you modify the virtual template settings on an existing PVC, you must enter the shutdown command followed by the no shutdown command on the ATM subinterface to restart the interface. This causes the newly configured parameters to take effect.


     
      

     

     

 
     [bookmark: pgfId-318554] c. Select the Enable ILMI check box to enable the ILMI to manage this PVC. For more information, see Understanding ILMI.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-318556]Note You cannot configure the management PVC on a subinterface.


     
      

     

     

 
     [bookmark: pgfId-318558] d. Select the Inverse ARP check box to enable the PVC to dynamically learn the Layer 3 addresses that are required to forward traffic to those devices.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-318563]Note Alternatively, you can create static address mappings, as described in Step 7.


     
      

     

     

 
     [bookmark: pgfId-318565] e. In the PPPoE Max Sessions field, define the maximum number of PPPoE sessions allowed on the PVC.

 
     [bookmark: pgfId-318567] f. In the VPN Service Name field, define the static domain name to use for PPPoA sessions on the PVC.

 
     [bookmark: pgfId-318572]See Table 61-23for a description of the fields on the Settings tab.

 
     [bookmark: pgfId-318577]Step 6 (Optional) On the QoS tab of the PVC dialog box, define the type of ATM traffic shaping to perform on the traffic carried by this PVC. Traffic shaping regulates the flow of traffic carried by the PVC by queuing traffic that exceeds the defined bit rates. See Table 61-24 for a description of the fields on the QoS tab.

 
     [bookmark: pgfId-318581]Step 7 [bookmark: 135916](Optional) On the Protocol tab of the PVC dialog box, create static mappings for the IP addresses at the other end of the PVC:

 
     [bookmark: pgfId-318588] a. [bookmark: 135917]Click Add to display the Define Mapping dialog box. See Table 61-26 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-318590] b. Select IP Address, then enter the address or network/host object that you want to map, or click Select to select a network/host object from a list or to create a new one.

 
     [bookmark: pgfId-318594] c. [bookmark: 135924]Click OK. The static mapping is displayed on the Protocol tab.

 
     [bookmark: pgfId-318602] d. Repeat a. through c. to define additional static mappings.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-318604]Note You can also use the Protocol tab to change the type of InARP to use, broadcast or non-broadcast.


     
      

     

     

 
     [bookmark: pgfId-318609]Step 8 Click Advanced to configure OAM management on the PVC. See Defining OAM Management on ATM PVCs.

 
     [bookmark: pgfId-318613]Step 9 [bookmark: 135938]Click OK to save your definitions locally on the client and close the dialog box. Your definitions are displayed in the PVC table.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-318615]Note To edit a PVC, select it from the table, then click Edit. To remove a PVC, select it, then click Delete.


     
      

     

     

 
     [bookmark: pgfId-318623]Step 10 Repeat Step 2 through Step 9 to define additional PVCs.

 
     [bookmark: pgfId-318625]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-318633][bookmark: 135951][bookmark: rtchap_proc_DefiningOAMManagementonATMPVCs]Defining OAM Management on ATM PVCs[bookmark: marker-318631]

 
     [bookmark: pgfId-318635]Security Manager enables you to configure the following F5 (VC level) Operation, Administration, and Maintenance (OAM) cells for detecting PVC failures in a Cisco IOS router:

 
      
      		 [bookmark: pgfId-318637]Loopback cells

 
      		 [bookmark: pgfId-318639]Continuity Check (CC) cells

 
      		 [bookmark: pgfId-318641]Alarm Indication Signal (AIS) cells

 
      		 [bookmark: pgfId-318643]Remote Detection Indication (RDI) cells

 
     

 
     [bookmark: pgfId-318645]You can enable and disable each of these cell types and define settings that determine how each cell type affects the PVC when a failure is detected.

 
     [bookmark: pgfId-318647]Before You Begin

 
      
      		 [bookmark: pgfId-318649]Select the ATM interface on which the PVC is defined.

 
      		 [bookmark: pgfId-318654]Define the general settings and the QoS settings of the PVC. See Defining ATM PVCs.

 
     

 
     [bookmark: pgfId-318656]Related Topics

 
      
      		 [bookmark: pgfId-318661]Defining ATM PVCs

 
      		 [bookmark: pgfId-318666]PVCs on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-318671]Step 1 In the PVC dialog box, click Advanced to display the PVC Advanced Settings dialog box. See Table 61-27 for a description of the fields in this dialog box.

 
     [bookmark: pgfId-318673]Step 2 Enable OAM loopback cells on the selected PVC:

 
     [bookmark: pgfId-318678] a. Click the OAM-PVC tab. See Table 61-29 for a description of the fields on this tab.

 
     [bookmark: pgfId-318680] b. Select the Enable OAM Management check box.

 
     [bookmark: pgfId-318682] c. Define the frequency of loopback cell transmissions.

 
     [bookmark: pgfId-318686]Step 3 [bookmark: 136001](Optional) Enable segment CC cells on the PVC:

 
     [bookmark: pgfId-318688] a. Under Segment Continuity Check, select Configure Continuity Check.

 
     [bookmark: pgfId-318690] b. Choose whether the router should act as the sink, source, or both. This determines the direction in which CC cells are sent.

 
     [bookmark: pgfId-318692] c. Choose whether the PVC should remain up after segment or end-to-end failures are detected.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-318694]Note Select Deny Activation Requests to have the router reject CC activation requests received from peers.


     
      

     

     

 
     [bookmark: pgfId-318699]Step 4 (Optional) Enable end-to-end CC cells on the PVC, using the procedure described in Step 3 for segment CC cells.

 
     [bookmark: pgfId-318701]Step 5 (Optional) Configure additional loopback cell parameters:

 
     [bookmark: pgfId-318703] a. Click the OAM tab.

 
     [bookmark: pgfId-318708] b. Select the Enable OAM Retry check box, then define the down count, up count, and retry frequency. See Table 61-28 for a description of the available options.

 
     [bookmark: pgfId-318710]Step 6 (Optional) Configure additional CC cell parameters:

 
     [bookmark: pgfId-318717] a. [bookmark: 136027]Select the Enable check box for segment CC cells, then define the activation count, deactivation count, and retry frequency. These fields determine how many activation and deactivation requests are sent to peers and how often the router waits between each attempt. See Table 61-28 for a description of the available options.

 
     [bookmark: pgfId-318722] b. Repeat a. for end-to-end CC cells.

 
     [bookmark: pgfId-318724]Step 7 (Optional) Configure AIS/RDI cells on the PVC:

 
     [bookmark: pgfId-318726] a. On the OAM tab, select the Enable AIS-RDI Detection check box.

 
     [bookmark: pgfId-318728] b. Define how many AIS/RDI cells are required to move the PVC to the down state.

 
     [bookmark: pgfId-318730] c. Define how many seconds must elapse without receiving AIS/RDI cells before moving the PVC to the up state.

 
     [bookmark: pgfId-318732]Step 8 Click OK to close the dialog box and return to PVC dialog box.

 
     [bookmark: pgfId-318734]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-318746][bookmark: 136053][bookmark: rtpage_cncpt_PVCPolicyPage]PVC Policy Page[bookmark: marker-318742][bookmark: marker-318744]

 
    [bookmark: pgfId-318751]Use the PVC page to create, edit, and delete permanent virtual connections (PVCs) on the router. PVCs allow direct and permanent connections between sites to provide a service that is similar to a leased line. These PVCs can be used in ADSL, SHDSL, or pure ATM environments. For more information, see Defining ATM PVCs.

 
    [bookmark: pgfId-318753]Navigation Path

 
     
     		 [bookmark: pgfId-318755](Device view) Select  Interfaces > Settings > PVC from the Policy selector.

 
     		 [bookmark: pgfId-318757](Policy view) Select  Router Interfaces > Settings > PVC from the Policy Type selector. Right-click  PVC to create a policy, or select an existing policy from the Shared Policy selector.

 
    

 
    [bookmark: pgfId-318759]Related Topics

 
     
     		 [bookmark: pgfId-318764]ADSL Policy Page

 
     		 [bookmark: pgfId-318769]SHDSL Policy Page

 
     		 [bookmark: pgfId-318774]PVCs on Cisco IOS Routers

 
     		 [bookmark: pgfId-318779]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-318784]Filtering Tables

 
    

 
    [bookmark: pgfId-318786]Field Reference

 
    [bookmark: pgfId-318789] 

 
     
      
       
       [bookmark: pgfId-313982]Table 61-21 [bookmark: 136096]PVC Page 

 
       
      
        
        		
          
          [bookmark: pgfId-313988]Element
         
  
        		
          
          [bookmark: pgfId-313990]Description
         
  
       

 
        
        		[bookmark: pgfId-313996]ATM Interface

  
        		[bookmark: pgfId-313998]The ATM interface on which the PVC is defined.

  
       

 
        
        		[bookmark: pgfId-314004]Interface Card

  
        		[bookmark: pgfId-314006]The type of device or WAN interface card on which the ATM interface resides.

  
       

 
        
        		[bookmark: pgfId-314012]PVC ID

  
        		[bookmark: pgfId-314014]The Virtual Path Identifier (VPI) and Virtual Channel Identifier (VCI) of the PVC.

  
       

 
        
        		[bookmark: pgfId-314020]Settings

  
        		[bookmark: pgfId-314022]Additional settings configured for the PVC, including encapsulation, the number of PPPoE sessions, and the VPN service name.

  
       

 
        
        		[bookmark: pgfId-314028]QoS

  
        		[bookmark: pgfId-314030]Quality-of-service settings defined for the PVC, such as traffic shaping.

  
       

 
        
        		[bookmark: pgfId-314036]Protocol

  
        		[bookmark: pgfId-314038]The IP protocol mappings (static maps or Inverse ARP) configured for the PVC.

  
       

 
        
        		[bookmark: pgfId-314044]OAM

  
        		[bookmark: pgfId-314046]The F5 Operation, Administration, and Maintenance (OAM) loopback, continuity check, and AIS/RDI definitions configured for the PVC.

  
       

 
        
        		[bookmark: pgfId-314052]OAM-PVC

  
        		[bookmark: pgfId-314054]The OAM management cells that are configured for the PVC.

  
       

 
        
        		[bookmark: pgfId-314060]Add button

  
        		[bookmark: pgfId-314065]Opens the PVC Dialog Box. From here you can define a PVC.

  
       

 
        
        		[bookmark: pgfId-314071]Edit button

  
        		[bookmark: pgfId-314076]Opens the PVC Dialog Box. From here you can edit the selected PVC.

  
       

 
        
        		[bookmark: pgfId-314082]Delete button

  
        		[bookmark: pgfId-314084]Deletes the selected PVC from the table.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-318801][bookmark: 136163][bookmark: rtpage_cncpt_PVCDialogBox]PVC Dialog Box[bookmark: marker-318797][bookmark: marker-318799]

 
     [bookmark: pgfId-318803]Use the PVC dialog box to configure ATM permanent virtual circuits (PVCs).

 
     [bookmark: pgfId-318805]You can configure the following types of interface cards:

 
      
      		 [bookmark: pgfId-318807]Unknownâ��The interface card type is not defined.

 
      		 [bookmark: pgfId-318809]WIC-1ADSLâ��A 1-port ADSL WAN interface card that provides ADSL over POTS (ordinary telephone lines).

 
      		 [bookmark: pgfId-318811]WIC-1ADSL-I-DGâ��A 1-port ADSL WAN interface card that provides ADSL over ISDN with Dying Gasp support. (With Dying Gasp, the router warns the DSLAM of imminent line drops when the router is about to lose power.)

 
      		 [bookmark: pgfId-318813]WIC-1ADSL-DGâ��A 1-port ADSL WAN interface card that provides ADSL over POTS with Dying Gasp support.

 
      		 [bookmark: pgfId-318815]HWIC-1ADSLâ��A 1-port high-speed ADSL WAN interface card that provides ADSL over POTS.

 
      		 [bookmark: pgfId-318817]HWIC-1ADSLIâ��A 1-port high-speed ADSL WAN interface card that provides ADSL over ISDN.

 
      		 [bookmark: pgfId-318819]HWIC-ADSL-B/STâ��A 2-port high-speed ADSL WAN interface card that provides ADSL over POTS with an ISDN BRI port for backup.

 
      		 [bookmark: pgfId-318821]HWIC-ADSLI-B/STâ��A 2-port high-speed ADSL WAN interface card that provides ADSL over ISDN with an ISDN BRI port for backup.

 
      		 [bookmark: pgfId-318823]WIC-1-SHDSL-V2â��A 1-port multiline G.SHDSL WAN interface card with support for 2-wire mode and enhanced 4-wire mode.

 
      		 [bookmark: pgfId-318825]WIC-1-SHDSL-V3â��A 1-port multiline G.SHDSL WAN interface card with support for 2-wire mode and 4-wire mode (standard & enhanced).

 
      		 [bookmark: pgfId-318827]NM-1A-T3â��A 1-port ATM network module with a T3 link.

 
      		 [bookmark: pgfId-318829]NM-1A-OC3-POMâ��A 1-port ATM network module with an optical carrier level 3 (OC-3) link and three operating modes (multimode, single-mode intermediate reach (SMIR), and single-mode long-reach (SMLR)).

 
      		 [bookmark: pgfId-318831]NM-1A-E3â��A 1-port ATM network module with an E3 link.

 
      		 [bookmark: pgfId-318833]857 ADSLâ��Cisco 857 Integrated Service Router with an ADSL interface.

 
      		 [bookmark: pgfId-318835]876 ADSLâ��Cisco 876 Integrated Services Router with an ADSL interface.

 
      		 [bookmark: pgfId-318837]877 ADSLâ��Cisco 877 Integrated Services Router with an ADSL interface.

 
      		 [bookmark: pgfId-318839]878 888 G.SHDSLâ��Cisco 878 Integrated Services Router with a G.SHDSL interface.

 
      		 [bookmark: pgfId-318841]1801 ADSLoPOTSâ��Cisco 1801 Integrated Services Router that provides ADSL over POTS.

 
      		 [bookmark: pgfId-318843]1802 ADSLoISDNâ��Cisco 1802 Integrated Services Router that provides ADSL over ISDN.

 
      		 [bookmark: pgfId-318845]1803 G.SHDSLâ��Cisco 1803 Integrated Services Router that provides 4-wire G.SHDSL.

 
     

 
     [bookmark: pgfId-318847]Navigation Path

 
     [bookmark: pgfId-318852]Go to the PVC Policy Page, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-318854]Related Topics

 
      
      		 [bookmark: pgfId-318859]Defining ATM PVCs

 
     

 
     [bookmark: pgfId-318861]Field Reference

 
     [bookmark: pgfId-318864] 

 
      
       
        
        [bookmark: pgfId-314097]Table 61-22 [bookmark: 136231]PVC Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-314103]Element
          
  
         		
           
           [bookmark: pgfId-314105]Description
          
  
        

 
         
         		[bookmark: pgfId-314111]ATM Interface

  
         		[bookmark: pgfId-314113]The ATM interface on which the PVC is defined. Enter the name of an interface, subinterface, or interface role, or click Select to select it. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-314115]Note We strongly recommend not defining an interface role that includes ATM interfaces from different interface cards. The different settings supported by each card type may cause deployment to fail.

  
        

 
         
         		[bookmark: pgfId-314121]Interface Card

  
         		[bookmark: pgfId-314123]The type of WAN interface card installed on the router or the router type. Supported card types are listed above.

 [bookmark: pgfId-314125]Note To ensure proper policy validation, we highly recommend that you define a value in this field. When you discover a live device, the correct interface card type will already be displayed. If you did not perform discovery on a live device, or if Security Manager cannot detect the type of interface card installed on the device, this field displays â��Unknownâ��.

  
        

 
         
         		[bookmark: pgfId-314131]Settings tab

  
         		[bookmark: pgfId-314136]Defines basic PVC settings, such as the VPI/VCI and encapsulation. See PVC Dialog Boxâ��Settings Tab.

  
        

 
         
         		[bookmark: pgfId-314142]QoS tab

  
         		[bookmark: pgfId-314147]Defines ATM traffic shaping and other quality-of-service settings for the PVC. See PVC Dialog Boxâ��QoS Tab.

  
        

 
         
         		[bookmark: pgfId-314153]Protocol tab

  
         		[bookmark: pgfId-314158]Defines the IP protocol mappings configured for the PVC (static maps or Inverse ARP). See PVC Dialog Boxâ��Protocol Tab.

  
        

 
         
         		[bookmark: pgfId-314164]Advanced button

  
         		[bookmark: pgfId-314169]Defines F5 Operation, Administration, and Maintenance (OAM) settings for the PVC. See PVC Advanced Settings Dialog Boxâ��OAM Tab.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-318874][bookmark: 136279][bookmark: rtpage_cncpt_PVCDialogBoxSettingsTab]PVC Dialog Boxâ��Settings Tab[bookmark: marker-318872]

 
     [bookmark: pgfId-318876]Use the Settings tab of the PVC dialog box to configure the basic settings of the PVC, including:

 
      
      		 [bookmark: pgfId-318878]ID settings.

 
      		 [bookmark: pgfId-318880]Encapsulation settings.

 
      		 [bookmark: pgfId-318882]Whether ILMI and Inverse ARP are enabled.

 
      		 [bookmark: pgfId-318884]The maximum number of PPPoE sessions.

 
      		 [bookmark: pgfId-318886]The static domain (VPN service) name to use for PPPoA.

 
     

 
     [bookmark: pgfId-318888]Navigation Path

 
     [bookmark: pgfId-318893]Go to the PVC Dialog Box, then click the Settings tab.

 
     [bookmark: pgfId-318895]Related Topics

 
      
      		 [bookmark: pgfId-318900]PVC Dialog Boxâ��QoS Tab

 
      		 [bookmark: pgfId-318905]PVC Dialog Boxâ��Protocol Tab

 
      		 [bookmark: pgfId-318910]PVC Advanced Settings Dialog Box

 
      		 [bookmark: pgfId-318915]Defining ATM PVCs

 
     

 
     [bookmark: pgfId-318917]Field Reference

 
     [bookmark: pgfId-318920] 

 
      
       
        
        [bookmark: pgfId-314182]Table 61-23 [bookmark: 136320]PVC Dialog Boxâ��Settings Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-314188]Element
          
  
         		
           
           [bookmark: pgfId-314190]Description
          
  
        

 
         
         		 [bookmark: pgfId-314196]PVC ID settings

  
        

 
         
         		[bookmark: pgfId-314204]VPI

  
         		[bookmark: pgfId-314206]The virtual path identifier of the PVC. In conjunction with the VCI, identifies the next destination of a cell as it passes through a series of ATM switches on the way to its destination. Valid values for most platforms range from 0 to 255.

 [bookmark: pgfId-314208]For Cisco 2600 and 3600 Series routers using Inverse Multiplexing for ATM (IMA), valid values range from 0 to 15, 64 to 79, 128 to 143, and 192 to 207.

 [bookmark: pgfId-314210]Note VPI/VCI values must be unique for all the PVCs configured on a selected interface. VPI/VCI values are unique to a single link only and might change as cells traverse the ATM network.

  
        

 
         
         		[bookmark: pgfId-314216]VCI

  
         		[bookmark: pgfId-314218]The 16-bit virtual channel identifier of the PVC. In conjunction with the VPI, identifies the next destination of a cell as it passes through a series of ATM switches on the way to its destination. Valid values vary by platform. Typically, values up to 31 are reserved for special traffic (such as ILMI) and should not be used. 3 and 4 are invalid.

 [bookmark: pgfId-314220]Note VPI/VCI values must be unique for all the PVCs configured on a selected interface. VPI/VCI values are unique to a single link only and might change as cells traverse the ATM network.

  
        

 
         
         		[bookmark: pgfId-314226]Handle

  
         		[bookmark: pgfId-314228]An optional name to identify the PVC. The maximum length is 15 characters.

  
        

 
         
         		[bookmark: pgfId-314234]Management PVC (ILMI)

  
         		[bookmark: pgfId-314236]Does not apply when configuring the PVC on a subinterface.

 [bookmark: pgfId-314241]When selected, designates this PVC as the management PVC for this ATM interface by enabling communication with the Interim Local Management Interface (ILMI). ILMI is a protocol defined by the ATM Forum for setting and capturing physical layer, ATM layer, virtual path, and virtual circuit parameters on ATM interfaces. See Understanding ILMI.

 [bookmark: pgfId-314243]When deselected, this PVC does not act as the management PVC. This is the default.

 [bookmark: pgfId-314245]Note The VPI/VCI for the management PVC is typically set to 0/16.

  
        

 
         
         		 [bookmark: pgfId-314251]Encapsulation settings

  
        

 
         
         		[bookmark: pgfId-314259]Type

  
         		[bookmark: pgfId-314261]Does not apply when the Management PVC (ILMI) check box is enabled.

 [bookmark: pgfId-314263]The ATM adaptation layer (AAL) and encapsulation type to use on the PVC:

 
           
           		 [bookmark: pgfId-314265][blank]â��The encapsulation type is not defined. (When deployed, aal5snap is applied.)

 
           		 [bookmark: pgfId-314267]aal2â��For PVCs dedicated to AAL2 Voice over ATM. AAL2 is used for variable bit rate (VBR) traffic, which can be either realtime (VBR-RT) or non-realtime (VBR-NRT).

 
           		 [bookmark: pgfId-314269]aal5autopppâ��Enables the router to distinguish between incoming PPP over ATM (PPPoA) and PPP over Ethernet (PPPoE) sessions and create virtual access for both PPP types based on demand.

 
           		 [bookmark: pgfId-314271]aal5ciscopppâ��For the proprietary Cisco version of PPP over ATM.

 
           		 [bookmark: pgfId-314273]aal5muxâ��Enables you to dedicate the PVC to a single protocol, as defined in the Protocol field.

 
           		 [bookmark: pgfId-314275]aal5nlpidâ��Enables ATM interfaces to work with High-Speed Serial Interfaces (HSSI) that are using an ATM data service unit (ADSU) and running ATM-Data Exchange Interface (DXI).

 
           		 [bookmark: pgfId-314277]aal5snapâ��Supports Inverse ARP and incorporates the Logical Link Control/Subnetwork Access Protocol (LLC/SNAP) that precedes the protocol datagram. This allows multiple protocols to traverse the same PVC.

 
          

  
        

 
         
         		[bookmark: pgfId-314283]Virtual Template

  
         		[bookmark: pgfId-314285]The virtual template used for PPP over ATM on this PVC. Enter the name of a virtual template interface or interface role, or click Select to select it. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-314287]When a user dials in, the virtual template is used to configure a virtual access interface. When the user is done, the virtual access interface goes down and the resources are freed for other dial-in users.

 [bookmark: pgfId-314289]Note If you modify the virtual template settings on an existing PVC, you must enter the shutdown command followed by the no shutdown command on the ATM subinterface to restart the interface. This causes the newly configured parameters to take effect.

  
        

 
         
         		[bookmark: pgfId-314295]Protocol

  
         		[bookmark: pgfId-314297]Applies only when aal5mux is the defined encapsulation type.

 [bookmark: pgfId-314299]The protocol carried by the MUX-encapsulated PVC:

 
           
           		 [bookmark: pgfId-314301]frame-relayâ��Frame-Relay-ATM Network Interworking (FRF.5) on the Cisco MC3810.

 
           		 [bookmark: pgfId-314303]fr-atm-srvâ��Frame-Relay-ATM Service Interworking (FRF.8) on the Cisco MC3810.

 
           		 [bookmark: pgfId-314305]ipâ��IP protocol.

 
           		 [bookmark: pgfId-314307]pppâ��IETF-compliant PPP over ATM. You must specify a virtual template when using this protocol type.

 
           		 [bookmark: pgfId-314309]voiceâ��Voice over ATM.

 
          

  
        

 
         
         		 [bookmark: pgfId-314315]Additional settings

  
        

 
         
         		[bookmark: pgfId-314323]Enable ILMI

  
         		[bookmark: pgfId-314325]When selected, enables ILMI management on this PVC.

 [bookmark: pgfId-314327]When deselected, ILMI management on this PVC is disabled.

  
        

 
         
         		[bookmark: pgfId-314335][bookmark: marker-314333] Inverse ARP

  
         		[bookmark: pgfId-314337]When selected, the Inverse Address Resolution Protocol (Inverse ARP) is enabled on the PVC.

 [bookmark: pgfId-314339]When deselected, Inverse ARP is disabled. This is the default.

 [bookmark: pgfId-314341]Inverse ARP is used to learn the Layer 3 addresses at the remote ends of established connections. These addresses must be learned before the virtual circuit can be used.

 [bookmark: pgfId-314346]Note Use the Protocol tab to define static mappings of IP addresses instead of dynamically learning the addresses using Inverse ARP. See PVC Dialog Boxâ��Protocol Tab.

  
        

 
         
         		[bookmark: pgfId-314352]PPPoE Max Sessions

  
         		[bookmark: pgfId-314354]The maximum number of PPP over Ethernet sessions that are permitted on the PVC.

  
        

 
         
         		[bookmark: pgfId-314360]VPN Service Name

  
         		[bookmark: pgfId-314362]The static domain name to use on this PVC. The maximum length is 128 characters.

 [bookmark: pgfId-314364]Use this option when you want PPP over ATM (PPPoA) sessions in the PVC to be forwarded according to the domain name supplied, without starting PPP.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-318930][bookmark: 136445][bookmark: rtpage_cncpt_PVCDialogBoxQoSTab]PVC Dialog Boxâ��QoS Tab[bookmark: marker-318928]

 
     [bookmark: pgfId-318932]Use the QoS tab of the PVC dialog box to configure the ATM traffic shaping and other quality-of-service settings of the PVC, including:

 
      
      		 [bookmark: pgfId-318934]The limit on packets placed on transmission rings.

 
      		 [bookmark: pgfId-318936]The QoS service.

 
      		 [bookmark: pgfId-318938]Whether random detection is enabled.

 
     

 
     [bookmark: pgfId-318940]These settings regulate the flow of traffic over the PVC by queuing traffic that exceeds the defined allowable bit rates.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-318942]Note QoS values are highly hardware dependent. Please refer to your router documentation for additional details about the settings that can be configured on your device.


     
      

     

     

 
     [bookmark: pgfId-318944]Navigation Path

 
     [bookmark: pgfId-318949]Go to the PVC Dialog Box, then click the QoS tab.

 
     [bookmark: pgfId-318951]Related Topics

 
      
      		 [bookmark: pgfId-318956]PVC Dialog Boxâ��Settings Tab

 
      		 [bookmark: pgfId-318961]PVC Dialog Boxâ��Protocol Tab

 
      		 [bookmark: pgfId-318966]PVC Advanced Settings Dialog Box

 
      		 [bookmark: pgfId-318971]Defining ATM PVCs

 
      		 [bookmark: pgfId-318976]Quality of Service Policy Page

 
      		 [bookmark: pgfId-318981]Understanding Policing and Shaping Parameters

 
     

 
     [bookmark: pgfId-318983]Field Reference

 
     [bookmark: pgfId-318986] 

 
      
       
        
        [bookmark: pgfId-314377]Table 61-24 [bookmark: 136490]PVC Dialog Boxâ��QoS Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-314383]Element
          
  
         		
           
           [bookmark: pgfId-314385]Description
          
  
        

 
         
         		[bookmark: pgfId-314391]Tx Ring Limit

  
         		[bookmark: pgfId-314393]The maximum number of transmission packets that can be placed on a transmission ring on the WAN interface card (WIC) or interface.

 [bookmark: pgfId-314398]The range of valid values depends on the type of interface card selected in the Settings tab. See PVC Dialog Boxâ��Settings Tab.

  
        

 
         
         		 [bookmark: pgfId-314404]Traffic Shaping settings

  
        

 
         
         		[bookmark: pgfId-314412]Traffic Shaping

  
         		[bookmark: pgfId-314414]The type of service to define on the PVC:

 
           
           		 [bookmark: pgfId-314416][null]â��The bit rate is not defined.

 
           		 [bookmark: pgfId-314418]ABRâ��Available Bit Rate. A best-effort service suitable for applications that do not require guarantees against cell loss or delays.

 
           		 [bookmark: pgfId-314420]CBRâ��Constant Bit Rate service. Delay-sensitive data, such as voice or video, is sent at a fixed rate, providing a service similar to a leased line.

 
           		 [bookmark: pgfId-314422]UBRâ��Unspecified Bit Rate service. A best-effort service suitable for applications that are tolerant to delay and do not require realtime responses.

 
           		 [bookmark: pgfId-314424]UBR+â��Unspecified Bit Rate service. Unlike UBR, UBR+ attempts to maintain a guaranteed minimum rate.

 
           		 [bookmark: pgfId-314426]VBR-NRTâ��Variable Bit Rate - Non-Real Time service. A service suitable for non-realtime applications that are bursty in nature. VBR is more efficient than CBR and more reliable than UBR.

 
           		 [bookmark: pgfId-314428]VBR-RTâ��Variable Bit Rate - Real Time service. A service suitable for realtime applications that are bursty in nature.

 
          

 [bookmark: pgfId-314433]For more information about each service class, see Understanding ATM Service Classes.

  
        

 
         
         		[bookmark: pgfId-314439]ABR

  
         		[bookmark: pgfId-314441]The following fields are displayed when ABR is selected as the Bit Rate:

 
           
           		 [bookmark: pgfId-314443]PCRâ��The peak cell rate in kilobits per second (kbps). It specifies the maximum value of the ABR.

 
           		 [bookmark: pgfId-314445]MCRâ��The minimum cell rate in kilobits per second (kbps). It specifies the minimum value of the ABR.

 
          

 [bookmark: pgfId-314447]The ABR varies between the MCR and the PCR. It is dynamically controlled using congestion control mechanisms.

  
        

 
         
         		[bookmark: pgfId-314453]CBR

  
         		[bookmark: pgfId-314455]The following field is displayed when CBR is selected as the Bit Rate:

 
           
           		 [bookmark: pgfId-314457]Rateâ��The constant bit rate (also known as the average cell rate) for the PVC in kilobits per second (kbps). An ATM VC configured for CBR can send cells at this rate for as long as required.

 
          

  
        

 
         
         		[bookmark: pgfId-314463]UBR

  
         		[bookmark: pgfId-314465]The following field is displayed when UBR is selected as the Bit Rate:

 
           
           		 [bookmark: pgfId-314467]PCRâ��The peak cell rate for output in kilobits per second (kbps). Cells in excess of the PCR may be discarded.

 
          

  
        

 
         
         		[bookmark: pgfId-314473]UBR+

  
         		[bookmark: pgfId-314475]The following fields are displayed when UBR+ is selected as the Bit Rate:

 
           
           		 [bookmark: pgfId-314477]PCRâ��The peak cell rate for output in kilobits per second (kbps). Cells in excess of the PCR may be discarded.

 
           		 [bookmark: pgfId-314479]MCRâ��The minimum guaranteed cell rate for output in kilobits per second (kbps). Traffic is always allowed to be sent at this rate.

 
          

 [bookmark: pgfId-314481]Note UBR+ requires Cisco IOS Software Release 12.4(2)XA or later, or version 12.4(6)T or later.

  
        

 
         
         		[bookmark: pgfId-314487]VBR-NRT

  
         		[bookmark: pgfId-314489]The following fields are displayed when VBR-NRT is selected as the Bit Rate:

 
           
           		 [bookmark: pgfId-314491]PCRâ��The peak cell rate for output in kilobits per second (kbps). Cells in excess of the PCR may be discarded.

 
           		 [bookmark: pgfId-314493]SCRâ��The sustained cell rate for output in kilobits per second (kbps). This value, which must be lower than or equal to the PCR, represents the maximum rate at which cells can be transmitted without incurring data loss.

 
           		 [bookmark: pgfId-314495]MBSâ��The maximum burst cell size for output. This value represents the number of cells that can be transmitted above the SCR but below the PCR without penalty.

 
          

  
        

 
         
         		[bookmark: pgfId-314501]VBR-RT

  
         		[bookmark: pgfId-314503]The following fields are displayed when VBR-RT is selected as the Bit Rate:

 
           
           		 [bookmark: pgfId-314505]Peak Rateâ��The peak information rate for realtime traffic in kilobits per second (kbps).

 
           		 [bookmark: pgfId-314507]Average Rateâ��The average information rate for realtime traffic in kilobits per second (kbps). This value must be lower than or equal to the peak rate.

 
           		 [bookmark: pgfId-314509]Burstâ��The burst size for realtime traffic, in number of cells. Configure this value if the PVC carries bursty traffic.

 
          

 [bookmark: pgfId-314511]These values configure traffic shaping between realtime traffic (such as voice and video) and data traffic to ensure that the carrier does not discard realtime traffic, for example, voice calls.

  
        

 
         
         		 [bookmark: pgfId-314517]IP QoS settings

  
        

 
         
         		[bookmark: pgfId-314525]Random Detect

  
         		[bookmark: pgfId-314527]When selected, enables Weighted Random Early Detection (WRED) or VIP-distributed WRED (DWRED) on the PVC.

 [bookmark: pgfId-314529]When deselected, WRED and DWRED are disabled. This is the default.

 [bookmark: pgfId-314534]WRED is a queue management method that selectively drops packets as the interface becomes congested. See Tail Drop vs. WRED.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-318996][bookmark: 136609][bookmark: rtpage_cncpt_PVCDialogBoxProtocolTab]PVC Dialog Boxâ��Protocol Tab[bookmark: marker-318994]

 
     [bookmark: pgfId-318998]Use the Protocol tab of the PVC dialog box to add, edit, or delete the protocol mappings configured for the PVC. You may configured static mappings or Inverse ARP (broadcast or nonbroadcast) for each PVC, but not both.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-319000]Note IP is the only protocol supported by Security Manager for protocol mapping on ATM networks. You cannot define protocol mappings on the Management PVC (ILMI).


     
      

     

     

 
     [bookmark: pgfId-319002]Navigation Path

 
     [bookmark: pgfId-319007]Go to the PVC Dialog Box, then click the Protocol tab.

 
     [bookmark: pgfId-319009]Related Topics

 
      
      		 [bookmark: pgfId-319014]PVC Dialog Boxâ��Settings Tab

 
      		 [bookmark: pgfId-319019]PVC Dialog Boxâ��QoS Tab

 
      		 [bookmark: pgfId-319024]PVC Advanced Settings Dialog Box

 
      		 [bookmark: pgfId-319029]Defining ATM PVCs

 
     

 
     [bookmark: pgfId-319031]Field Reference

 
     [bookmark: pgfId-319034] 

 
      
       
        
        [bookmark: pgfId-314547]Table 61-25 [bookmark: 136640]PVC Dialog Boxâ��Protocol Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-314553]Element
          
  
         		
           
           [bookmark: pgfId-314555]Description
          
  
        

 
         
         		[bookmark: pgfId-314561]IP Protocol Mapping

  
         		[bookmark: pgfId-314563]Displays the IP protocol mappings configured for the PVC.

  
        

 
         
         		[bookmark: pgfId-314569]Add button

  
         		[bookmark: pgfId-314574]Opens the Define Mapping Dialog Box. From here you can define an IP protocol mapping.

  
        

 
         
         		[bookmark: pgfId-314580]Edit button

  
         		[bookmark: pgfId-314585]Opens the Define Mapping Dialog Box. From here you can edit the selected mapping.

  
        

 
         
         		[bookmark: pgfId-314591]Delete button

  
         		[bookmark: pgfId-314593]Deletes the selected mapping from the table.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-319046][bookmark: 136673][bookmark: rtpage_cncpt_DefineMappingDialogBox]Define Mapping Dialog Box[bookmark: marker-319042][bookmark: marker-319044]

 
     [bookmark: pgfId-319048]Use the Define Mapping dialog box to configure the IP protocol mappings to use on the ATM PVC. Mappings are required by the PVC to discover which IP address is reachable at the other end of a connection. Mappings can either be learned dynamically using Inverse ARP (InARP) or defined statically. Static mappings are best suited for simple networks that contain only a few nodes.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-319053]Note Inverse ARP is only supported for the aal5snap encapsulation type. See PVC Dialog Boxâ��Settings Tab.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-319055]Tip Use the CLI or FlexConfigs to configure mappings for protocols other than IP.


     
      

     

     

 
     [bookmark: pgfId-319057]Navigation Path

 
     [bookmark: pgfId-319062]Go to the PVC Dialog Boxâ��Protocol Tab, then click Add or Edit.

 
     [bookmark: pgfId-319064]Related Topics

 
      
      		 [bookmark: pgfId-319069]PVC Dialog Box

 
      		 [bookmark: pgfId-319074]Defining ATM PVCs

 
     

 
     [bookmark: pgfId-319076]Field Reference

 
     [bookmark: pgfId-319079] 

 
      
       
        
        [bookmark: pgfId-314606]Table 61-26 [bookmark: 136705]Define Mapping Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-314612]Element
          
  
         		
           
           [bookmark: pgfId-314614]Description
          
  
        

 
         
         		[bookmark: pgfId-314620]IP Options

  
         		[bookmark: pgfId-314622]The type of IP protocol mapping to use:

 
           
           		 [bookmark: pgfId-314624]IP Addressâ��Select this option when using static mapping. Enter the address or the name of a network/host object, or click  Select to select it. If the object that you want is not listed, click the  Create button to create it.

 
           		 [bookmark: pgfId-314626]InARPâ��Inverse ARP. Select this option when using dynamic mapping. This allows the PVC to resolve its own network addresses without configuring a static map. Dynamic mappings age out and are refreshed periodically every 15 minutes by default.

 
          

 [bookmark: pgfId-314631]Note InARP can be used only when aal5snap is the defined encapsulation type for the PVC. See PVC Dialog Boxâ��Settings Tab.

  
        

 
         
         		[bookmark: pgfId-314637]Broadcast Options

  
         		[bookmark: pgfId-314639]Indicates whether to use this map entry when sending IP broadcast packets (such as EIGRP updates):

 
           
           		 [bookmark: pgfId-314641]Broadcastâ��The map entry is used for broadcast packets.

 
           		 [bookmark: pgfId-314643]No Broadcastâ��The map entry is used only for unicast packets.

 
           		 [bookmark: pgfId-314645]Noneâ��Broadcast options are disabled.

 
          

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-319091][bookmark: 136743][bookmark: rtpage_cncpt_PVCAdvancedSettingsDialogBox]PVC Advanced Settings Dialog Box[bookmark: marker-319087][bookmark: marker-319089]

 
     [bookmark: pgfId-319093]Use the PVC Advanced Settings dialog box to configure F5 Operation, Administration, and Maintenance (OAM) functionality on an ATM PVC. OAM is used to detect connectivity failures at the ATM layer.

 
     [bookmark: pgfId-319098]For more information, see Defining OAM Management on ATM PVCs.

 
     [bookmark: pgfId-319100]Navigation Path

 
     [bookmark: pgfId-319105]Go to the PVC Dialog Box, then click Advanced.

 
     [bookmark: pgfId-319107]Related Topics

 
      
      		 [bookmark: pgfId-319112]PVC Policy Page

 
     

 
     [bookmark: pgfId-319114]Field Reference

 
     [bookmark: pgfId-319117] 

 
      
       
        
        [bookmark: pgfId-314658]Table 61-27 [bookmark: 136770]PVC Advanced Settings Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-314664]Element
          
  
         		
           
           [bookmark: pgfId-314666]Description
          
  
        

 
         
         		[bookmark: pgfId-314672]OAM tab

  
         		[bookmark: pgfId-314677]Defines loopback, connectivity check, and AIS/RDI settings. See PVC Advanced Settings Dialog Boxâ��OAM Tab.

  
        

 
         
         		[bookmark: pgfId-314683]OAM-PVC tab

  
         		[bookmark: pgfId-314688]Enables OAM loopbacks and connectivity checks on the PVC. See PVC Advanced Settings Dialog Boxâ��OAM-PVC Tab.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-319127][bookmark: 136792][bookmark: rtpage_cncpt_PVCAdvancedSettingsDialogBoxOAMTab]PVC Advanced Settings Dialog Boxâ��OAM Tab[bookmark: marker-319125]

 
     [bookmark: pgfId-319129]Use the OAM tab of the PVC Advanced Settings dialog box to define:

 
      
      		 [bookmark: pgfId-319131]The number of loopback cell responses that move the PVC to the down or up state.

 
      		 [bookmark: pgfId-319133]The number of alarm indication signal/remote defect indication (AIS/RDI) cells that move the PVC to the down or up state.

 
      		 [bookmark: pgfId-319135]The number and frequency of segment/end continuity check (CC) activation and deactivation requests that are sent on this PVC.

 
     

 
     [bookmark: pgfId-319140]For more information, see Defining OAM Management on ATM PVCs.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-319145]Note The settings defined in this tab are dependent on the settings defined in the OAM-PVC tab. See PVC Advanced Settings Dialog Boxâ��OAM-PVC Tab.


     
      

     

     

 
     [bookmark: pgfId-319147]Navigation Path

 
     [bookmark: pgfId-319152]Go to the PVC Advanced Settings Dialog Box, then click the OAM tab.

 
     [bookmark: pgfId-319154]Related Topics

 
      
      		 [bookmark: pgfId-319159]PVC Dialog Box

 
     

 
     [bookmark: pgfId-319161]Field Reference

 
     [bookmark: pgfId-319164] 

 
      
       
        
        [bookmark: pgfId-314701]Table 61-28 [bookmark: 136824]PVC Advanced Settings Dialog Boxâ��OAM Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-314707]Element
          
  
         		
           
           [bookmark: pgfId-314709]Description
          
  
        

 
         
         		 [bookmark: pgfId-314715]Retry settings

  
        

 
         
         		[bookmark: pgfId-314723]Enable OAM Retry

  
         		[bookmark: pgfId-314725]When selected, OAM management settings can be defined.

 [bookmark: pgfId-314727]When deselected, OAM management settings cannot be defined.

 [bookmark: pgfId-314729]Note If Enable OAM Management is deselected in the OAM-PVC tab, these settings are saved in the device configuration but are not applied.

  
        

 
         
         		[bookmark: pgfId-314735]Down Count

  
         		[bookmark: pgfId-314737]The number of consecutive, unreceived, end-to-end loopback cell responses that cause the PVC to move to the down state. The default is 3.

  
        

 
         
         		[bookmark: pgfId-314743]Up Count

  
         		[bookmark: pgfId-314745]The number of consecutive end-to-end loopback cell responses that must be received in order to move the PVC to the up state. The default is 5.

  
        

 
         
         		[bookmark: pgfId-314751]Retry Frequency

  
         		[bookmark: pgfId-314753]The interval between loopback cell verification transmissions in seconds. The default is 1 second.

 [bookmark: pgfId-314755]If a PVC is up and a loopback cell response is not received within the specified interval (as defined in the Frequency field of the PVC-OAM tab), loopback cells are transmitted at the frequency defined here to verify whether the PVC is down. If the number of consecutive cells that do not receive a response matches the defined down count, the PVC is moved to the down state.

  
        

 
         
         		 [bookmark: pgfId-314761]AIS-RDI settings

  
        

 
         
         		[bookmark: pgfId-314769]Enable AIS-RDI Detection

  
         		[bookmark: pgfId-314771]When selected, alarm indication signal (AIS) cells and remote defect indication (RDI) cells are used to report connectivity failures at the ATM layer of the PVC.

 [bookmark: pgfId-314773]When deselected, AIS/RDI cells are disabled.

 [bookmark: pgfId-314775]AIS cells notify downstream devices of the connectivity failure. The last ATM switch then generates RDI cells in the upstream direction towards the device that sent the original failure notification.

  
        

 
         
         		[bookmark: pgfId-314781]Down Count

  
         		[bookmark: pgfId-314783]The number of consecutive AIS/RDI cells that cause the PVC to go down. Valid values range from 1 to 60. The default is 1.

  
        

 
         
         		[bookmark: pgfId-314789]Up Count

  
         		[bookmark: pgfId-314791]The number of seconds after which a PVC is brought up if no AIS/RDI cells are received. Valid values range from 3 to 60 seconds. The default is 3.

  
        

 
         
         		 [bookmark: pgfId-314797]Segment Continuity Check settings

  
        

 
         
         		[bookmark: pgfId-314805]Enable Segment Continuity Check

  
         		[bookmark: pgfId-314807]When selected, OAM F5 continuity check (CC) activation and deactivation requests are sent to a device at the other end of a segment.

 [bookmark: pgfId-314809]When deselected, segment CC activation and deactivation requests are disabled.

 [bookmark: pgfId-314811]Note If Configure Continuity Check is deselected in the OAM-PVC tab, these settings are saved in the device configuration but are not applied.

  
        

 
         
         		[bookmark: pgfId-314817]Activation Count

  
         		[bookmark: pgfId-314819]The maximum number of times that the activation request is sent before the receipt of an acknowledgement. Valid values range from 3 to 600. The default is 3.

  
        

 
         
         		[bookmark: pgfId-314825]Deactivation Count

  
         		[bookmark: pgfId-314827]The maximum number of times that the deactivation request is sent before the receipt of an acknowledgement. Valid values range from 3 to 600. The default is 3.

  
        

 
         
         		[bookmark: pgfId-314833]Retry Frequency

  
         		[bookmark: pgfId-314835]The interval between activation/deactivation retries, in seconds. The default is 30 seconds.

  
        

 
         
         		 [bookmark: pgfId-314841]End-to-End Continuity Check settings

  
        

 
         
         		[bookmark: pgfId-314849]Enable End-to-End Continuity Check

  
         		[bookmark: pgfId-314851]When selected, OAM F5 continuity check (CC) activation and deactivation requests are sent to a device at the other end of the PVC.

 [bookmark: pgfId-314853]When deselected, segment CC activation and deactivation requests are disabled.

 [bookmark: pgfId-314855]Note If Configure Continuity Check is deselected in the OAM-PVC tab, these settings are saved in the device configuration but are not applied.

  
        

 
         
         		[bookmark: pgfId-314861]Activation Count

  
         		[bookmark: pgfId-314863]The maximum number of times that the activation request is sent before the receipt of an acknowledgement. Valid values range from 3 to 600. The default is 3.

  
        

 
         
         		[bookmark: pgfId-314869]Deactivation Count

  
         		[bookmark: pgfId-314871]The maximum number of times that the deactivation request is sent before the receipt of an acknowledgement. Valid values range from 3 to 600. The default is 3.

  
        

 
         
         		[bookmark: pgfId-314877]Retry Frequency

  
         		[bookmark: pgfId-314879]The interval between activation/deactivation retries, in seconds. The default is 30 seconds.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-319174][bookmark: 136935][bookmark: rtpage_cncpt_PVCAdvancedSettingsDialogBoxOAMPVCTab]PVC Advanced Settings Dialog Boxâ��OAM-PVC Tab[bookmark: marker-319172]

 
     [bookmark: pgfId-319176]Use the OAM-PVC tab of the PVC Advanced Settings dialog box to enable loopback cells and connectivity checks (CCs) on the PVC. These functions test the connectivity of the virtual connection.

 
     [bookmark: pgfId-319181]For more information, see Defining OAM Management on ATM PVCs.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-319186]Note Use the OAM tab to define additional settings related to the settings on this tab. See PVC Advanced Settings Dialog Boxâ��OAM Tab.


     
      

     

     

 
     [bookmark: pgfId-319188]Navigation Path

 
     [bookmark: pgfId-319193]Go to the PVC Advanced Settings Dialog Box, then click the OAM-PVC tab.

 
     [bookmark: pgfId-319195]Related Topics

 
      
      		 [bookmark: pgfId-319200]PVC Dialog Box

 
     

 
     [bookmark: pgfId-319202]Field Reference

 
     [bookmark: pgfId-319205] 

 
      
       
        
        [bookmark: pgfId-314892]Table 61-29 [bookmark: 136960]PVC Advanced Settings Dialog Boxâ��OAM-PVC Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-314898]Element
          
  
         		
           
           [bookmark: pgfId-314900]Description
          
  
        

 
         
         		 [bookmark: pgfId-314906]OAM settings

  
        

 
         
         		[bookmark: pgfId-314914]Enable OAM Management

  
         		[bookmark: pgfId-314916]When selected, OAM loopback cell generation and OAM management are enabled on the PVC.

 [bookmark: pgfId-314918]When deselected, OAM loopback cells and OAM management are disabled. However, continuity checks can still be performed.

  
        

 
         
         		[bookmark: pgfId-314924]Frequency

  
         		[bookmark: pgfId-314926]The interval between loopback cell transmissions. Valid values range from 0 to 600 seconds.

  
        

 
         
         		 [bookmark: pgfId-314932]Segment Continuity Check settings

  
        

 
         
         		[bookmark: pgfId-314940]Segment Continuity Check

  
         		[bookmark: pgfId-314942]The current configuration of OAM F5 continuity checks performed on PVC segments:

 
           
           		 [bookmark: pgfId-314944]Noneâ��Segment continuity checks (CC) are disabled.

 
           		 [bookmark: pgfId-314946]Deny Activation Requestsâ��The PVC rejects activation requests from peer devices, which prevents OAM F5 CC management from being activated on the PVC.

 
           		 [bookmark: pgfId-314948]Configure Continuity Checkâ��Segment CCs are enabled on the PVC. The router on which CC management is configured sends a CC activation request to the router at the other end of the segment, directing it to act as either a source or a sink.

 
          

 [bookmark: pgfId-314950]Segment CCs occur on a PVC segment between the router and a first-hop ATM switch.

  
        

 
         
         		[bookmark: pgfId-314956]Direction

  
         		[bookmark: pgfId-314958]Applies only when CC management is enabled.

 [bookmark: pgfId-314960]The direction in which CC cells are transmitted:

 
           
           		 [bookmark: pgfId-314962]bothâ��CC cells are transmitted in both directions.

 
           		 [bookmark: pgfId-314964]sinkâ��CC cells are transmitted toward the router that initiated the CC activation request.

 
           		 [bookmark: pgfId-314966]sourceâ��CC cells are transmitted away from the router that initiated the CC activation request.

 
          

  
        

 
         
         		[bookmark: pgfId-314972]Keep VC up after segment failure

  
         		[bookmark: pgfId-314974]When selected, the PVC is kept in the up state when CC cells detect connectivity failure.

 [bookmark: pgfId-314976]When deselected, the PVC is brought down when CC cells detect connectivity failure.

  
        

 
         
         		[bookmark: pgfId-314982]Keep VC up after end-to-end failure

  
         		[bookmark: pgfId-314984]When selected, specifies that if AIS/RDI cells are received, the PVC is not brought down because of end CC failure or loopback failure.

 [bookmark: pgfId-314986]When deselected, the PVC is brought down because of end CC failure or loopback failure.

  
        

 
         
         		 [bookmark: pgfId-314992]End-to-End Continuity Check settings

  
        

 
         
         		[bookmark: pgfId-315000]End-to-End Continuity Check

  
         		[bookmark: pgfId-315002]The current configuration of OAM F5 end-to-end continuity checks on the PVC:

 
           
           		 [bookmark: pgfId-315004]Noneâ��End-to-end continuity checks (CC) are disabled.

 
           		 [bookmark: pgfId-315006]Deny Activation Requestsâ��The PVC rejects activation requests from peer devices, which prevents OAM F5 CC management from being activated on the PVC.

 
           		 [bookmark: pgfId-315008]Configure Continuity Checkâ��End-to-end CCs are enabled on the PVC. The router on which CC management is configured sends a CC activation request to the router at the other end of the connection, directing it to act as either a source or a sink.

 
          

 [bookmark: pgfId-315010]End-to-end CC monitoring is performed on the entire PVC between two ATM end stations.

  
        

 
         
         		[bookmark: pgfId-315016]Direction

  
         		[bookmark: pgfId-315018]Applies only when CC management is enabled.

 [bookmark: pgfId-315020]The direction in which CC cells are transmitted:

 
           
           		 [bookmark: pgfId-315022]bothâ��CC cells are transmitted in both directions.

 
           		 [bookmark: pgfId-315024]sinkâ��CC cells are transmitted toward the router that initiated the CC activation request.

 
           		 [bookmark: pgfId-315026]sourceâ��CC cells are transmitted away from the router that initiated the CC activation request.

 
          

  
        

 
         
         		[bookmark: pgfId-315032]Keep VC up after end-to-end failure

  
         		[bookmark: pgfId-315034]When selected, the PVC is kept in the up state when CC cells detect connectivity failure.

 [bookmark: pgfId-315036]When deselected, the PVC is brought down when CC cells detect connectivity failure.

  
        

 
         
         		[bookmark: pgfId-315042]Keep VC up after segment failure

  
         		[bookmark: pgfId-315044]When selected, specifies that if AIS/RDI cells are received, the PVC is not brought down because of a segment CC failure.

 [bookmark: pgfId-315046]When deselected, the PVC is brought down because of a segment CC failure.

  
        

 
       
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-319217][bookmark: 137072][bookmark: rtchap_cncpt_PPPonCiscoIOSRouters]PPP on Cisco IOS Routers[bookmark: marker-319211][bookmark: marker-319213][bookmark: marker-319215]

 
    [bookmark: pgfId-319219]The Point-to-Point Protocol (PPP), as defined in RFC 1661, provides a method for transporting packets between two devices or hosts using physical or logical links. PPP is a Layer 2 data-link protocol that can work with multiple Layer 3 network-layer protocols, including IP, IPX, and AppleTalk.

 
    [bookmark: pgfId-319221]PPP is used in many common scenarios, such as:

 
     
     		 [bookmark: pgfId-319223]Connecting remote users to a central network over dial-in connections.

 
     		 [bookmark: pgfId-319225]Connecting the gateway of an enterprise network to an ISP for internet access.

 
     		 [bookmark: pgfId-319227]Connecting two LANs (for example, a central office and a branch office) to exchange data between them.

 
    

 
    [bookmark: pgfId-319229]PPP connectivity is established in stages:

 
    [bookmark: pgfId-319231] 1. First, a Link Control Protocol (LCP) establishes, configures, and tests the data-link connection.

 
    [bookmark: pgfId-319233] 2. (Optional) Authentication verifies the identity of the two parties.

 
    [bookmark: pgfId-319235] 3. A family of Network Control Protocols (NCPs) establishes and configures the necessary network-layer protocols.

 
    [bookmark: pgfId-319240]The PPP policy in Security Manager provides a method for configuring selected parameters that are negotiated between the two nodes during the LCP stage, including authentication (typically CHAP or PAP) and Multilink PPP (MLP). For more information about MLP, see Defining Multilink PPP Bundles.

 
    [bookmark: pgfId-319242]The following topics describe the tasks you perform to create PPP policies on Cisco IOS routers:

 
     
     		 [bookmark: pgfId-319247]Defining PPP Connections

 
     		 [bookmark: pgfId-319252]Defining Multilink PPP Bundles

 
    

 
     
      [bookmark: pgfId-319262][bookmark: 137111][bookmark: rtchap_cncpt_UnderstandingMultilinkPPPMLP]Understanding Multilink PPP (MLP)[bookmark: marker-319258][bookmark: marker-319260]

 
     [bookmark: pgfId-319264]MLP, as defined in RFC 1990, is a method for splitting, recombining, and sequencing datagrams across multiple logical data links. MLP was originally designed to exploit multiple bearer channels in ISDN, but it can be used whenever multiple PPP links connect two systems, including asynchronous links.

 
     [bookmark: pgfId-319266]MLP spreads inbound and outbound traffic across multiple physical WAN links (known collectively as a bundle) while providing the following benefits:

 
      
      		 [bookmark: pgfId-319268]Packet fragmentation and reassembly

 
      		 [bookmark: pgfId-319270]Proper sequencing

 
      		 [bookmark: pgfId-319272]Multivendor interoperability

 
      		 [bookmark: pgfId-319274]Load balancing

 
     

 
     [bookmark: pgfId-319279]As shown in Figure 61-3, traffic routed across an MLP link is fragmented, with the fragments being sent across the different physical links. At the remote end of the link, the fragments are reassembled and forwarded to the next hop toward their ultimate destination. By using multiple physical links, MLP provides a way to temporarily use the additional bandwidth afforded by these links.

 
     [bookmark: pgfId-319283]Figure 61-3 [bookmark: 137131]Multilink PPP

 
     [bookmark: pgfId-319286] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-319288]Every MLP bundle is controlled by a single interface, the bundle master, which is a virtual-access interface. This interface is created in the background when the bundle is first created. The physical interface becomes part of the bundle that is managed by the bundle master. Bundles are also used when you create a multilink group consisting of a multilink interface and its associated serial interfaces, which is a setup that is often found in static, leased-line environments.

 
     [bookmark: pgfId-319290]MLP uses an endpoint discriminator to identify the system transmitting a packet. By default, this discriminator is based on the hostname of the router, but it can also be based on other criteria, such as the IP address or MAC address of the interface, a telephone number, or a user-defined string. If the endpoint discriminator matches the discriminator of an existing link, the new link is added to the matching bundle. If no match exists, a new bundle is created. When authentication is used, a new bundle is established whenever there is a mismatch in either the discriminator or the authentication information exchanged between the two nodes.

 
     [bookmark: pgfId-319292]Related Topics

 
      
      		 [bookmark: pgfId-319297]Defining Multilink PPP Bundles

 
      		 [bookmark: pgfId-319302]PPP on Cisco IOS Routers

 
     

 
    
 
     
      [bookmark: pgfId-319310][bookmark: 137146][bookmark: rtchap_proc_DefiningPPPConnections]Defining PPP Connections[bookmark: marker-319308]

 
     [bookmark: pgfId-319312]When you define a PPP connection, the first step is to select the interface on which PPP should be enabled. You must select one of the following interface types:

 
      
      		 [bookmark: pgfId-319314]Async

 
      		 [bookmark: pgfId-319316]Group-Async

 
      		 [bookmark: pgfId-319318]Serial

 
      		 [bookmark: pgfId-319320]High-Speed Serial Interface (HSSI)

 
      		 [bookmark: pgfId-319322]Dialer

 
      		 [bookmark: pgfId-319324]BRI, PRI (ISDN)

 
      		 [bookmark: pgfId-319326]Virtual template

 
      		 [bookmark: pgfId-319328]Multilink

 
     

 
     [bookmark: pgfId-319330]You cannot define PPP connections on:

 
      
      		 [bookmark: pgfId-319332]Subinterfaces.

 
      		 [bookmark: pgfId-319334]Serial interfaces with Frame Relay encapsulation.

 
      		 [bookmark: pgfId-319336]Virtual template interfaces defined as Ethernet or tunnel types (serial is supported).

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-319341]Note You cannot configure PPP on serial interfaces that are configured for Frame Relay encapsulation. See Defining Basic Router Interface Settings.


     
      

     

     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-319346]Note Deployment might fail if you define PPP on a virtual template that is also used in an 802.1x policy. See Defining 802.1x Policies.


     
      

     

     

 
     [bookmark: pgfId-319348]You can select one or more authentication protocols and define when authentication should be performed.

 
     [bookmark: pgfId-319350]In addition, you can configure the authentication and authorization methods to use when performing AAA on a remote security server. You can either define a default method list to use for all PPP connections on the device or define a customized method list that applies to a specific connection.

 
     [bookmark: pgfId-319352]Before You Begin

 
      
      		 [bookmark: pgfId-319357]Make sure that the device contains an interface on which PPP can be configured. See Basic Interface Settings on Cisco IOS Routers.

 
     

 
     [bookmark: pgfId-319359]Related Topics

 
      
      		 [bookmark: pgfId-319364]Defining Multilink PPP Bundles

 
      		 [bookmark: pgfId-319369]PPP on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-319371]Step 1 Do one of the following:

 
      
      		 [bookmark: pgfId-319373](Device view) Select  Interfaces > Settings > PPP/MLP from the Policy selector.

 
      		 [bookmark: pgfId-319375](Policy view) Select  Router Interfaces > Settings > PPP/MLP from the Policy Type selector. Select an existing policy or create a new one.

 
     

 
     [bookmark: pgfId-319380]The PPP/MLP page is displayed. See Table 61-30 for a description of the fields on this page.

 
     [bookmark: pgfId-319384]Step 2 [bookmark: 137210]Click the Add button beneath the table to display the PPP dialog box.

 
     [bookmark: pgfId-319386]Step 3 In the Interface field, enter the name of the interface or interface role on which you want to define the PPP connection, or click Select to select an interface role from a list or to create a new one.

 
     [bookmark: pgfId-319388]Step 4 (Optional) On the PPP tab, define authentication for the PPP connection:

 
     [bookmark: pgfId-319390] a. Select one or more authentication protocols.

 
     [bookmark: pgfId-319392] b. Select one or more authentication options. These options determine when to perform authentication (callin, callout, and callback), whether to use one-time passwords, and whether to allow a mobile station in a PDSN configuration to receive Simple IP and Mobile IP services without using CHAP or PAP.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-319394]Note The Call Back option only enables authentication during callback. Use the CLI or FlexConfigs to configure the callback feature on the device.


     
      

     

     

 
     [bookmark: pgfId-319399] c. See PPP Dialog Boxâ��PPP Tab for a description of the fields on this tab.

 
     [bookmark: pgfId-319401]Step 5 (Optional) When using a remote AAA server to perform authentication, select Default List or Custom Method List in the Authenticate Using field, then define the methods to use in the Prioritized Method List field.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-319403]Note If you modify the default list, your changes affect all PPP connections on the devices that use this list. If you leave this field blank, authentication is performed using the local database on the device.


     
      

     

     

 
     [bookmark: pgfId-319405]Step 6 (Optional) When using a remote AAA server to perform authorization, select AAA Policy Default List or Custom Method List, then define the methods to use in the Prioritized Method List field.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-319410]Note If you choose AAA Policy Default List, the device uses the default authorization methods defined in the AAA policy. See Defining AAA Services.


     
      

     

     

 
     [bookmark: pgfId-319412]Step 7 (Optional) Define the username and password to send in response to PAP authentication requests.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-319414]Note If you entered the encrypted version of the password, select the Encrypted check box.


     
      

     

     

 
     [bookmark: pgfId-319416]Step 8 (Optional) Define a different hostname to send in all CHAP challenges and responses in place of the routerâ��s own hostname.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-319418]Note If you entered the encrypted version of the password, select the Encrypted check box.


     
      

     

     

 
     [bookmark: pgfId-319423]Step 9 (Optional) To enable Multilink PPP on this connection, click the MLP tab. See Defining Multilink PPP Bundles.

 
     [bookmark: pgfId-319427]Step 10 [bookmark: 137246]Click OK to save your definitions locally on the client and close the dialog box. Your definitions are displayed in the PPP table.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-319429]Note To edit a PPP connection, select it from the table, then click Edit. To remove a PPP connection, select it, then click Delete.


     
      

     

     

 
     [bookmark: pgfId-319437]Step 11 Repeat Step 2 to Step 10 to define PPP connections on additional interfaces. Only one PPP connection may be defined on an interface.

 
     [bookmark: pgfId-319439]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-319449][bookmark: 137259][bookmark: rtchap_proc_DefiningMultilinkPPPBundles]Defining Multilink PPP Bundles[bookmark: marker-319445][bookmark: marker-319447]

 
     [bookmark: pgfId-319453]You enable Multilink PPP (MLP) on the selected interface by selecting the check box at the top of the Multilink tab in the PPP dialog box. You can optionally enable [bookmark: marker-319451] Multiclass Multilink PPP (MCMP), which prevents delay-sensitive traffic from fragmentation, and interleaving, which enables packets to be interspersed among the fragments of larger packets. If you want to restrict a serial interface to a specific bundle, you can select the multilink interface that represents that bundle.

 
     [bookmark: pgfId-319455]In addition, you can optionally modify the following default settings:

 
      
      		 [bookmark: pgfId-319457]The maximum fragment delay.

 
      		 [bookmark: pgfId-319459]The endpoint discriminator that identifies the router when negotiating the use of MLP.

 
      		 [bookmark: pgfId-319461]The maximum receive reconstructed unit (MRRU) permitted by the router and its peers.

 
      		 [bookmark: pgfId-319463]The maximum queue depth for first-in, first-out (FIFO) and non-FIFO queues.

 
     

 
     [bookmark: pgfId-319465]Before You Begin

 
      
      		 [bookmark: pgfId-319467]Select the interface on which the PPP connection should be enabled.

 
     

 
     [bookmark: pgfId-319469]Related Topics

 
      
      		 [bookmark: pgfId-319474]Defining PPP Connections

 
      		 [bookmark: pgfId-319479]PPP on Cisco IOS Routers

 
     

 
     
 
     [bookmark: pgfId-319484]Step 1 In the PPP dialog box, click the MLP tab. See PPP Dialog Boxâ��MLP Tab for a description of the fields on this tab.

 
     [bookmark: pgfId-319486]Step 2 Select the Enable Multilink Protocol (MLP) check box.

 
     [bookmark: pgfId-319488]Step 3 (Optional) Configure one or more of the following options:

 
     [bookmark: pgfId-319490] a. Whether to enable the multiclass feature that prevents delay-sensitive traffic from being fragmented. This is achieved by placing delay-sensitive traffic in a separate class from regular traffic.

 
     [bookmark: pgfId-319492] b. Whether to enable the interleaving of packets among the fragments of larger packets on the MLP bundle.

 
     [bookmark: pgfId-319494] c. Whether to restrict the physical link to joining only a designated multilink-group (defined by selecting a multilink interface). If a peer at the other end of the link tries to join a different bundle, the connected is severed.

 
     [bookmark: pgfId-319496] d. Whether to modify the default amount of time required to transmit a fragment on the MLP bundle. The default is 30 milliseconds.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-319498]Note If you enable interleaving without defining a fragment delay, the default delay of 30 seconds is configured. This value does not appear in Security Manager or in the device configuration.


     
      

     

     

 
     [bookmark: pgfId-319500]Step 4 (Optional) Under Endpoint, modify the default endpoint discriminator used on the MLP bundle.

 
     [bookmark: pgfId-319505]The endpoint discriminator is used to identify the router on the MLP bundle. The default endpoint discriminator is either the globally configured hostname, or the PAP username or CHAP hostname (depending on the authentication protocol being used), if you configured those values on the PPP tab. See Defining PPP Connections.

 
     [bookmark: pgfId-319507]Step 5 (Optional) In the MRRU fields, modify the default maximum packet size that the router (local) or the peer (remote) is capable of receiving.

 
     [bookmark: pgfId-319509]Step 6 (Optional) Modify the default maximum size of link transmit queues when using FIFO and non-FIFO (QoS) queuing.

 
     [bookmark: pgfId-319511]Step 7 Click OK to close the dialog box. Your definitions are displayed on the PPP page.

 
     [bookmark: pgfId-319513]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-319525][bookmark: 137329][bookmark: rtpage_cncpt_PPPMLPPolicyPage]PPP/MLP Policy Page[bookmark: marker-319521][bookmark: marker-319523]

 
    [bookmark: pgfId-319530]Use the PPP/MLP page to create, edit, and delete PPP connections on the router. For more information, see Defining PPP Connections.

 
    [bookmark: pgfId-319532]Navigation Path

 
     
     		 [bookmark: pgfId-319534](Device view) Select  Interfaces > Settings > PPP/MLP from the Policy selector.

 
     		 [bookmark: pgfId-319536](Policy view) Select  Router Interfaces > Settings > PPP/MLP from the Policy Type selector. Right-click  PPP/MLP to create a policy, or select an existing policy from the Shared Policies selector.

 
    

 
    [bookmark: pgfId-319538]Related Topics

 
     
     		 [bookmark: pgfId-319543]PPP on Cisco IOS Routers

 
     		 [bookmark: pgfId-319548]Table Columns and Column Heading Features

 
     		 [bookmark: pgfId-319553]Filtering Tables

 
    

 
    [bookmark: pgfId-319555]Field Reference

 
    [bookmark: pgfId-319558] 

 
     
      
       
       [bookmark: pgfId-315059]Table 61-30 [bookmark: 137366]PPP/MLP Page 

 
       
      
        
        		
          
          [bookmark: pgfId-315065]Element
         
  
        		
          
          [bookmark: pgfId-315067]Description
         
  
       

 
        
        		[bookmark: pgfId-315073]Interface

  
        		[bookmark: pgfId-315075]The interface that is configured for PPP/MLP.

  
       

 
        
        		[bookmark: pgfId-315081]Authentication

  
        		[bookmark: pgfId-315083]The types of authentication used on the PPP connection.

  
       

 
        
        		[bookmark: pgfId-315089]Authorization

  
        		[bookmark: pgfId-315091]The method list used for AAA authorization on the PPP connection.

  
       

 
        
        		[bookmark: pgfId-315097]Multilink

  
        		[bookmark: pgfId-315099]Indicates whether Multilink PPP (MLP) is enabled on this PPP connection.

  
       

 
        
        		[bookmark: pgfId-315105]Endpoint

  
        		[bookmark: pgfId-315107]The type of default endpoint discriminator to use when negotiating the use of MLP with the peer.

  
       

 
        
        		[bookmark: pgfId-315113]Multiclass

  
        		[bookmark: pgfId-315115]Indicates whether the Multiclass Multilink PPP (MCMP) feature is enabled on this PPP connection.

  
       

 
        
        		[bookmark: pgfId-315121]Group

  
        		[bookmark: pgfId-315123]The number of the multilink-group interface to which the physical link is restricted.

  
       

 
        
        		[bookmark: pgfId-315129]Interleave

  
        		[bookmark: pgfId-315131]Indicates whether the PPP multilink interleave feature is enabled on this PPP connection.

  
       

 
        
        		[bookmark: pgfId-315137]Add button

  
        		[bookmark: pgfId-315142]Opens the PPP Dialog Box. From here you can define the authentication and multilink settings for the PPP connection.

  
       

 
        
        		[bookmark: pgfId-315148]Edit button

  
        		[bookmark: pgfId-315153]Opens the PPP Dialog Box. From here you can edit the selected PPP connection.

  
       

 
        
        		[bookmark: pgfId-315159]Delete button

  
        		[bookmark: pgfId-315161]Deletes the selected PPP connection from the table.

  
       

 
      
     

 
    
 
     
      [bookmark: pgfId-319570][bookmark: 137433][bookmark: rtpage_cncpt_PPPDialogBox]PPP Dialog Box[bookmark: marker-319566][bookmark: marker-319568]

 
     [bookmark: pgfId-319572]Use the PPP dialog box to configure PPP connections on the router. When you configure a PPP connection, you can define the type of authentication and authorization to perform and define multilink parameters.

 
     [bookmark: pgfId-319574]Navigation Path

 
     [bookmark: pgfId-319579]Go to the PPP/MLP Policy Page, then click the Add or Edit button beneath the table.

 
     [bookmark: pgfId-319581]Related Topics

 
      
      		 [bookmark: pgfId-319586]Defining PPP Connections

 
     

 
     [bookmark: pgfId-319588]Field Reference

 
     [bookmark: pgfId-319591] 

 
      
       
        
        [bookmark: pgfId-315174]Table 61-31 [bookmark: 137459]PPP Dialog Box 

 
        
       
         
         		
           
           [bookmark: pgfId-315180]Element
          
  
         		
           
           [bookmark: pgfId-315182]Description
          
  
        

 
         
         		[bookmark: pgfId-315188]Interface

  
         		[bookmark: pgfId-315190]The interface on which PPP encapsulation is enabled. Enter the name of an interface or interface role, or click Select to select it. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-315192]The following interface types support PPP:

 
           
           		 [bookmark: pgfId-315194]Async

 
           		 [bookmark: pgfId-315196]Group-Async

 
           		 [bookmark: pgfId-315198]Serial

 
           		 [bookmark: pgfId-315200]High-Speed Serial Interface (HSSI)

 
           		 [bookmark: pgfId-315202]Dialer

 
           		 [bookmark: pgfId-315204]BRI, PRI (ISDN)

 
           		 [bookmark: pgfId-315206]Virtual template

 
           		 [bookmark: pgfId-315208]Multilink

 
          

 [bookmark: pgfId-315210]You cannot define PPP on:

 
           
           		 [bookmark: pgfId-315212]Subinterfaces.

 
           		 [bookmark: pgfId-315214]Serial interfaces with Frame Relay encapsulation.

 
           		 [bookmark: pgfId-315216]Virtual template interfaces defined as Ethernet or tunnel types (serial is supported).

 
          

 [bookmark: pgfId-315218]Note You can define only one PPP connection per interface.

 [bookmark: pgfId-315223]Note Deployment might fail if you define PPP on a virtual template that is also used in an 802.1x policy. See 802.1x Policy Page.

  
        

 
         
         		[bookmark: pgfId-315229]PPP tab

  
         		[bookmark: pgfId-315234]Defines the type of authentication and authorization to perform on the PPP connection. See PPP Dialog Boxâ��PPP Tab.

  
        

 
         
         		[bookmark: pgfId-315240]MLP tab

  
         		[bookmark: pgfId-315245]Defines how to split and recombine sequential datagrams across multiple logical data links using Multilink PPP (MLP). See PPP Dialog Boxâ��MLP Tab.

 [bookmark: pgfId-315247]This tab is greyed out and cannot be opened for devices that do not support the configuration settings.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-319601][bookmark: 137518][bookmark: rtpage_cncpt_PPPDialogBoxPPPTab]PPP Dialog Boxâ��PPP Tab[bookmark: marker-319599]

 
     [bookmark: pgfId-319603]Use the PPP tab of the PPP dialog box to define the types of authentication and authorization to perform on the PPP connection.

 
     [bookmark: pgfId-319605]Navigation Path

 
     [bookmark: pgfId-319610]Go to the PPP Dialog Box, then click the PPP tab.

 
     [bookmark: pgfId-319612]Related Topics

 
      
      		 [bookmark: pgfId-319617]PPP Dialog Boxâ��MLP Tab

 
     

 
     [bookmark: pgfId-319619]Field Reference

 
     [bookmark: pgfId-319622] 

 
      
       
        
        [bookmark: pgfId-315260]Table 61-32 [bookmark: 137539]PPP Dialog Boxâ��PPP Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-315266]Element
          
  
         		
           
           [bookmark: pgfId-315268]Description
          
  
        

 
         
         		 [bookmark: pgfId-315274]Authentication settings

  
        

 
         
         		[bookmark: pgfId-315282]PPP Encapsulation

  
         		[bookmark: pgfId-315284]When selected, indicates that PPP encapsulation is enabled for the selected interface. This field is read-only.

  
        

 
         
         		[bookmark: pgfId-315290]Protocol

  
         		[bookmark: pgfId-315292]The authentication protocols to use:

 
           
           		 [bookmark: pgfId-315294]CHAPâ��Challenge-Handshake Authentication Protocol.

 
           		 [bookmark: pgfId-315296]PAPâ��Password Authentication Protocol.

 
           		 [bookmark: pgfId-315298]MS-CHAPâ��Version 1 of the Microsoft version of CHAP (RFC 2433).

 
           		 [bookmark: pgfId-315300]MS-CHAP-2â��Version 2 of the Microsoft version of CHAP (RFC 2759).

 
           		 [bookmark: pgfId-315302]EAPâ��Extensible Authentication Protocol.

 
          

 [bookmark: pgfId-315304]You may select one or more authentication protocols, as required.

  
        

 
         
         		[bookmark: pgfId-315310]Options

  
         		[bookmark: pgfId-315312]The authentication options to use:

 
           
           		 [bookmark: pgfId-315314]Call Inâ��When selected, authentication is performed on incoming calls.

 
           		 [bookmark: pgfId-315316]Call Outâ��When selected, authentication is performed on outgoing calls.

 
           		 [bookmark: pgfId-315318]Call Backâ��When selected, authentication is performed on callback.

 
           		 [bookmark: pgfId-315320]One Timeâ��When selected, one-time passwords are used for authentication. One-time passwords are considered highly secure since each one is used only once. When deselected, one-time passwords are not used.

 
          

 [bookmark: pgfId-315325]Note AAA authentication must be enabled in order to use one-time passwords. See AAA Policy Page. One-time passwords cannot be used with CHAP.

 
           
           		 [bookmark: pgfId-315327]Optionalâ��When selected, allows a mobile station in a Packet Data Serving Node (PDSN) configuration to receive Simple IP and Mobile IP services without using CHAP or PAP.

 
          

 [bookmark: pgfId-315329]When deselected, mobile stations must use CHAP or PAP to receive Simple IP and Mobile IP services.

  
        

 
         
         		[bookmark: pgfId-315335]Authenticate Using

  
         		[bookmark: pgfId-315337]AAA authentication settings for the PPP connection:

 
           
           		 [bookmark: pgfId-315339]PPP Default Listâ��Defines a default list of methods to be queried when authenticating a user for PPP. Enter the names of one or more AAA server group objects (up to four) in the Prioritized Method List field, or click  Select to select it. Use the up and down arrows in the object selector to define the order in which the selected server groups should be used. If the object that you want is not listed, click the  Create button to create it.

 
          

 [bookmark: pgfId-315341]The device tries initially to authenticate users using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-315343]Tip After you create the default list for one PPP connection, you can use it for other PPP connections on this device. 
           
           		 [bookmark: pgfId-315345]Prioritized Method Listâ��Defines a sequential list of methods to be queried when authenticating a user for this PPP connection only.

 
          

 [bookmark: pgfId-315347]Note Leave this field blank to perform authentication using the local database on the router.

  
        

 
         
         		 [bookmark: pgfId-315353]PAP Authentication settings

  
        

 
         
         		[bookmark: pgfId-315361]Username

  
         		[bookmark: pgfId-315363]The username to send in PAP authentication requests. The username is case sensitive.

  
        

 
         
         		[bookmark: pgfId-315369]Password

  
         		[bookmark: pgfId-315371]The password to send in PAP authentication requests. Enter the password again in the Confirm field. The password can contain 1 to 25 uppercase or lowercase alphanumeric characters. The password is case sensitive.

 [bookmark: pgfId-315373]The username and password are sent if the peer requests the router to authenticate itself using PAP.

  
        

 
         
         		[bookmark: pgfId-315379]Encrypted Password

  
         		[bookmark: pgfId-315381]When selected, this indicates that the password you entered is already encrypted.

 [bookmark: pgfId-315383]When deselected, this indicates that the password you entered is in clear text.

  
        

 
         
         		 [bookmark: pgfId-315389]CHAP Authentication settings

  
        

 
         
         		[bookmark: pgfId-315397]Hostname

  
         		[bookmark: pgfId-315399]By default, the router uses its hostname to identify itself to the peer. If required, you can enter a different hostname to use for all CHAP challenges and responses. For example, use this field to specify a common alias for all routers in a rotary group.

  
        

 
         
         		[bookmark: pgfId-315405]Secret

  
         		[bookmark: pgfId-315407]The secret used to compute the response value for any CHAP challenge from an unknown peer. Enter the secret again in the Confirm field.

  
        

 
         
         		[bookmark: pgfId-315413]Encrypted Secret

  
         		[bookmark: pgfId-315415]When selected, this indicates that the password you entered is already encrypted. When deselected, this indicates that the password you entered is in clear text.

  
        

 
         
         		 [bookmark: pgfId-315421]Authorization settings

  
        

 
         
         		[bookmark: pgfId-315429]Authorize Using

  
         		[bookmark: pgfId-315431]AAA authorization settings for the PPP connection:

 
           
           		 [bookmark: pgfId-315436]AAA Policy Default Listâ��Uses the default authorization method list that is defined in the deviceâ��s AAA policy. See AAA Policy Page.

 
           		 [bookmark: pgfId-315438]Prioritized Method Listâ��Defines a sequential list of methods to be queried when authorizing a user. Enter the names of one or more AAA server group objects (up to four), or click  Select to select it. Use the up and down arrows to define the order in which selected server groups should be used. If the object that you want is not listed, click the  Create button to create it.

 
          

 [bookmark: pgfId-315440]The device tries initially to authorize users using the first method in the list. If that method fails to respond, the device tries the next method, and so on, until a response is received.

 [bookmark: pgfId-315442]Note Leave this field blank to perform authorization using the local database on the router.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-319632][bookmark: 137669][bookmark: rtpage_cncpt_PPPDialogBoxMLPTab]PPP Dialog Boxâ��MLP Tab[bookmark: marker-319630]

 
     [bookmark: pgfId-319634]Use the MLP tab of the PPP dialog box to define Multilink PPP (MLP) parameters for the selected PPP connection.

 
     [bookmark: pgfId-319636]Navigation Path

 
     [bookmark: pgfId-319641]Go to the PPP Dialog Box, then click the MLP tab.

 
     [bookmark: pgfId-319643]Related Topics

 
      
      		 [bookmark: pgfId-319648]PPP Dialog Boxâ��PPP Tab

 
     

 
     [bookmark: pgfId-319650]Field Reference

 
     [bookmark: pgfId-319653] 

 
      
       
        
        [bookmark: pgfId-315455]Table 61-33 [bookmark: 137690]PPP Dialog Boxâ��MLP Tab 

 
        
       
         
         		
           
           [bookmark: pgfId-315461]Element
          
  
         		
           
           [bookmark: pgfId-315463]Description
          
  
        

 
         
         		[bookmark: pgfId-315469]Enable Multilink PPP (MLP)

  
         		[bookmark: pgfId-315471]When selected, MLP is enabled on this PPP connection.

 [bookmark: pgfId-315473]When deselected, MLP is disabled.

  
        

 
         
         		[bookmark: pgfId-315479]Allow Multiple Data Classes

  
         		[bookmark: pgfId-315481]When selected, enables multiple data classes on the MLP bundle. Delay-sensitive traffic is placed into Class 1, where it can be interleaved but never fragmented. Normal data traffic is placed into Class 0, which is subject to fragmentation just as regular multilink packets are.

 [bookmark: pgfId-315483]When deselected, all traffic is subject to fragmentation.

  
        

 
         
         		[bookmark: pgfId-315489]Enable Interleaving of Packets Among Fragments of Larger Packets

  
         		[bookmark: pgfId-315491]When selected, enables the interleaving of packets among the fragments of larger packets on the MLP bundle.

 [bookmark: pgfId-315493]Note If you enable interleaving without defining a fragment delay, the default delay of 30 seconds is configured. This value does not appear in Security Manager or in the device configuration.

 [bookmark: pgfId-315495]When deselected, interleaving is disabled.

 [bookmark: pgfId-315497]Note Serial interfaces do not support interleaving.

  
        

 
         
         		[bookmark: pgfId-315503]Multilink Group

  
         		[bookmark: pgfId-315505]Applies only to serial, Group-Async, and multilink interfaces.

 [bookmark: pgfId-315507]Restricts the physical link to the selected multilink-group interface. Enter the name of a multilink interface or interface role, or click Select to select it. If the object that you want is not listed, click the Create button to create it.

 [bookmark: pgfId-315509]This option is typically used in static leased-line environments, where the remote systems to which the deviceâ��s serial lines are connected are known in advance.

 [bookmark: pgfId-315511]In effect, this option dedicates a specific interfaces to a particular user, even when that user is not connected. If a peer at the other end of the link tries to join a different bundle, the connected is severed.

  
        

 
         
         		[bookmark: pgfId-315517]Maximum Fragment Delay

  
         		[bookmark: pgfId-315519]The maximum amount of time that should be required to transmit a fragment on the MLP bundle. Valid values range from 1 to 1000 milliseconds.

 [bookmark: pgfId-315521]Fragment size is determined by the defined fragment delay and the bandwidth of the links.

 [bookmark: pgfId-315523]Note Serial interfaces do not support this feature.

  
        

 
         
         		[bookmark: pgfId-315529]Endpoint Type

  
         		[bookmark: pgfId-315531]The identifier used by the router when transmitting packets on the MLP bundle:

 
           
           		 [bookmark: pgfId-315533][null]â��Negotiation is conducted without using an endpoint discriminator. (No CLI command is generated.)

 
           		 [bookmark: pgfId-315535]Hostnameâ��The hostname of the router. This option is useful when multiple routers are using the same username to authenticate but have different hostnames.

 
           		 [bookmark: pgfId-315537]IPâ��A defined IP address. Enter the address or the name of a network/host object, or click  Select to select it. If the object that you want is not listed, click the  Create button to create it.

 
           		 [bookmark: pgfId-315539]MACâ��The MAC address of a specific interface. Enter the name of the interface or interface role, or click  Select to select it. If the object that you want is not listed, click the  Create button to create it.

 
           		 [bookmark: pgfId-315541]Noneâ��Negotiation is conducted without using an endpoint discriminator. (The relevant CLI command is generated, but no endpoint discriminator is provided.) This option is useful when the router is connected to a malfunctioning peer that does not handle the endpoint discriminator properly.

 
           		 [bookmark: pgfId-315543]Phoneâ��An E.164-compliant telephone number. Enter the number in the field displayed.

 
           		 [bookmark: pgfId-315545]Stringâ��A character string. Enter the string in the field displayed.

 
          

 [bookmark: pgfId-315547]The default endpoint discriminator is either the globally configured hostname, or the PAP username or CHAP hostname (depending on the authentication protocol being used), if you have configured those values on the PPP tab.

  
        

 
         
         		[bookmark: pgfId-315555][bookmark: marker-315553] MRRU Local Peer

  
         		[bookmark: pgfId-315557]The maximum receive reconstructed unit (MRRU) value of the local peer. This value represents the maximum size packet that the local router is capable of receiving.

 [bookmark: pgfId-315559]Valid values range from 128 to 16384 bytes. The default is the maximum transmission unit (MTU) of the multilink group interface and 1524 bytes for all other interfaces.

  
        

 
         
         		[bookmark: pgfId-315565]MRRU Remote Peer

  
         		[bookmark: pgfId-315567]The maximum receive reconstructed unit (MRRU) value of the remote peer. This value represents the maximum size packet that the remote peer is capable of receiving.

 [bookmark: pgfId-315569]Valid values range from 128 to 16384 bytes. The default is 1524 bytes.

  
        

 
         
         		[bookmark: pgfId-315575]Maximum FIFO Queue Size

  
         		[bookmark: pgfId-315577]The maximum queue depth when the bundle uses first-in, first-out (FIFO) queuing. Valid values range from 2 to 255 packets. The default is 8.

  
        

 
         
         		[bookmark: pgfId-315583]Maximum QoS Queue Size

  
         		[bookmark: pgfId-315585]The maximum queue depth when the bundle uses non-FIFO queuing. Valid values range from 2 to 255 packets. The default is 2.
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     [bookmark: pgfId-67681][bookmark: 29510][bookmark: adman_cncpt_ManagingtheSecurityManagerServer]Managing the Security Manager Server[bookmark: marker-67677][bookmark: marker-67679]
      
      
 
     
 

 
    [bookmark: pgfId-67683]The following topics describe some system management tasks related to the general operation of the Security Manager product:

 
     
     		 [bookmark: pgfId-67688]Overview of Security Manager Server Management and Administration

 
     		 [bookmark: pgfId-67693]Managing a Cluster of Security Manager Servers

 
     		 [bookmark: pgfId-67698]Installing Security Manager License Files

 
     		 [bookmark: pgfId-67703]Certificate Trust Management

 
     		 [bookmark: pgfId-67708]Working with Audit Reports

 
     		 [bookmark: pgfId-67713]Taking Over Another User’s Work

 
     		 [bookmark: pgfId-67718]Changing Passwords for the Admin or Other Users

 
     		 [bookmark: pgfId-67723]Backing up and Restoring the Security Manager Database

 
     		 [bookmark: pgfId-67728]Generating Data for the Cisco Technical Assistance Center

 
    

 
   
 
    
     [bookmark: pgfId-67738][bookmark: 29547][bookmark: adman_cncpt_OverviewofSecurityManagerServerManagementandAdministration]Overview of Security Manager Server Management and Administration[bookmark: marker-67734][bookmark: marker-67736]

 
    [bookmark: pgfId-67740]As a software application, Cisco Security Manager runs on the framework provided by the CiscoWorks Common Services application. Many of the fundamental server control functions are provided by Common Services. For example, if you want to create a multiple-server setup for Security Manager, you must create that setup in Common Services. Common Services also provides the tools for creating and managing local user accounts, for backing up and restoring the database, for generating various reports on system functions, and for many other basic functions.

 
    [bookmark: pgfId-67742]To access the Common Services application, do any of the following:

 
     
     		 [bookmark: pgfId-67744]If you currently have the Security Manager client open, you can select  Tools > Security Manager Administration and select  Server Security from the table of contents. The Server Security page has buttons that link to and open specific pages in Common Services. You can click any button and then navigate to any desired page in Common Services.

 
     		 [bookmark: pgfId-67746]Using your web browser, link to the Security Manager server using the URL https:// servername , where  servername is the IP address or DNS name of the server. This URL opens the Security Manager home page. Click  Server Administration , or the  CiscoWorks link, to open Common Services.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-67754]Note [bookmark: marker-67748][bookmark: marker-67750][bookmark: marker-67752]A special consideration applies if you are using Internet Explorer 10.x in Windows Server 2012 (Standard or Datacenter)—64-bit, support for which is new in Version 4.7 of Cisco Security Manager. You need to be aware of this consideration when using the following navigation path: Windows Start > Cisco Security Manager Client > [log in] > Configuration Manager > Tools > Security Manager Administration... > Server Security. The Server Security page will open normally for you, but on that page you will be unable to use the buttons (e.g., Local User Setup) to cross-launch the Server Security Tools within Common Services. To work around this problem, decrease the security levels of your intranet settings in Internet Explorer 10.x.


    
     

    

    

 
    [bookmark: pgfId-67756]To learn more about the things you can do with Common Services, browse the Common Services online help.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-67758]Note The Software Center > Software Update feature in Common Services is not supported by Cisco Security Manager.


    
     

    

    

 
   
 
    
     [bookmark: pgfId-67770][bookmark: 29579][bookmark: adman_cncpt_ManagingaClusterofSecurityManagerServers]Managing a Cluster of Security Manager Servers[bookmark: marker-67764][bookmark: marker-67766][bookmark: marker-67768]

 
    [bookmark: pgfId-67772]A Security Manager server cluster is two or more Security Manager servers used to manage a network. Typically, you want to maintain some relationship between the servers. Although there is no systematic relationship between the servers in the cluster, there are some techniques that you can use to maintain a cluster-like relationship. The topics in this section explain how you can manage a group of Security Manager servers as a cluster.

 
    [bookmark: pgfId-67774]This section contains the following topics:

 
     
     		 [bookmark: pgfId-67779]Overview of Security Manager Server Cluster Management

 
     		 [bookmark: pgfId-67784]Exporting the Device Inventory

 
     		 [bookmark: pgfId-67789]Exporting Shared Policies

 
     		 [bookmark: pgfId-67794]Importing Policies or Devices

 
    

 
     
      [bookmark: pgfId-67806][bookmark: 29592][bookmark: adman_cncpt_OverviewofSecurityManagerServerCusterManagement]Overview of Security Manager Server Cluster Management[bookmark: marker-67800][bookmark: marker-67802][bookmark: marker-67804]

 
     [bookmark: pgfId-67808]You can manage a large number of devices with a single Security Manager server. There are, however, a variety of reasons for managing your network with more than one Security Manager server. For example:

 
      
      		 [bookmark: pgfId-67810]If you have a very large network with thousands of devices to manage, you might find performance to be unacceptable when trying to manage all devices from a single server.

 
      		 [bookmark: pgfId-67812]For geographic reasons, you might find it better to have servers that are closer to managed devices. For example, if you have major sites on different sides of the globe, having separate servers at each major site might simplify management and improve performance. For example, when deploying configurations to managed devices, a Security Manager server located in Bangalore should be able to deploy configurations to a device in Bangalore much faster than a Security Manager server located in San Francisco simply due to the much shorter physical network distance.

 
      		 [bookmark: pgfId-67814]You might want to segment device management based on the technology managed. For example, you might want to use one server to manage your site-to-site VPNs, another server to manage ASA firewall and remote access VPN policies, and a third server to manage IPS.

 
      		 [bookmark: pgfId-67816]Separate IT organizations might be managing different parts of your network. Although you can set up ACS to fine-tune access control to the device level, you might instead find it simpler to have distinct Security Manager servers for each IT organization.

 
     

 
     [bookmark: pgfId-67818]If you decide to install more than one Security Manager server, the main challenges are the following:

 
      
      		 [bookmark: pgfId-67823]Splitting a single server into two or more servers—You might currently have a single Security Manager server, and decide that you need multiple servers. For information on how to split a Security Manager server into two or more servers, see Splitting a Security Manager Server.

 
      		 [bookmark: pgfId-67825]Maintaining the same set of shared policies—If you use multiple servers to manage the same device types, you might want to ensure that the shared policies assigned to the devices are identical. For example, you might want to have the same set of mandatory and default access rules inherited by all ASA devices.

 
     

 
     [bookmark: pgfId-67830]There is no automatic process for maintaining the same set of shared policies among a cluster of servers. Instead, you must manually export them from your main server and import them into the remaining servers. For more information, see Synchronizing Shared Policies Among Security Manager Servers.

 
    
 
     
      [bookmark: pgfId-67842][bookmark: 29623][bookmark: adman_proc_SplittingaSecurityManagerServer]Splitting a Security Manager Server[bookmark: marker-67836][bookmark: marker-67838][bookmark: marker-67840]

 
     [bookmark: pgfId-67844]If you decide that you need to convert a single Security Manager server into two or more servers, you can split the server by moving subsets of the devices managed by the original server to the new servers. Keep in mind that you should manage a specific network device from a single Security Manager server, so delete the moved devices from the original server.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-67846]Tip Use the same release of Security Manager software on all servers.


     
      

     

     

 
     [bookmark: pgfId-67848]Related Topics

 
      
      		 [bookmark: pgfId-67853]Overview of Security Manager Server Cluster Management

 
      		 [bookmark: pgfId-67858]Synchronizing Shared Policies Among Security Manager Servers

 
      		 [bookmark: pgfId-67863]Exporting Shared Policies

 
     

 
     
 
     [bookmark: pgfId-67867]Step 1 Install the new Security Manager servers as described in the Installation Guide for Cisco Security Manager.

 
     [bookmark: pgfId-67872]Ensure that the server is functioning correctly, and also ensure that you install licenses with a device count that will be sufficient for the devices you will move to the server. Ensure that you use a professional license if you manage device types that require it. For information on installing licenses, see Installing Security Manager License Files.

 
     [bookmark: pgfId-67874]Step 2 On the original server, verify that the policies of the devices that you will move will allow access from the IP address of the new server. For example, consider access rules on ASAs and routers, and the Allowed Hosts policy on IPS devices.

 
     [bookmark: pgfId-67876]Step 3 On the original server, ensure that all configuration changes for the devices you are moving have been submitted and deployed. You will need to ask the staff to submit and deploy their changes, there is no simple way to determine this status within Security Manager.

 
     [bookmark: pgfId-67878]This step ensures that there are no pending uncommited changes. For information on deploying configurations, see the following topics based on workflow mode:

 
      
      		 [bookmark: pgfId-67883]Deploying Configurations in Non-Workflow Mode

 
      		 [bookmark: pgfId-67888]Deploying Configurations in Workflow Mode

 
     

 
     [bookmark: pgfId-67893]Step 4 Select File > Export > Devices to export the devices with their assigned policies and policy objects from the original Security Manager server. Be sure to select Export Devices, Policies, and Objects during the device export so that policy information is included. The file type must be dev. For more detailed information, see Exporting the Device Inventory from the Security Manager Client.

 
     [bookmark: pgfId-67895]Create separate export files containing unique devices for each new Security Manager server.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-67897]Tip At this point, do not make policy changes to the exported devices in the original server, and do not deploy configurations to those devices. If you find that you need to make changes to the devices from the original server before you complete the split, create a new export file.


     
      

     

     

 
     [bookmark: pgfId-67902]Step 5 On each of the new Security Manager servers, select File > Import to import the exported information to the new servers. For more detailed information, see Importing Policies or Devices.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-67904]Tip Device groups are not preserved during import. All devices are placed in the All group. You need to manually recreate the desired device group structure and add the devices to the appropriate groups.


     
      

     

     

 
     [bookmark: pgfId-67906]Step 6 Verify that each of the new Security Manager servers can manage the newly-imported devices. For example, you could do a deployment, even for unchanged devices, to ensure that the new server can successfully contact all devices and deploy configurations.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-67911]Tip As explained in Importing Policies or Devices, you must submit policies before the changes are available for configuring devices. Submit policies before doing a deployment.


     
      

     

     

 
     [bookmark: pgfId-67913]Step 7 If you were monitoring any of the moved devices using the original server (that is, with Event Viewer and optionally Report Manager), ensure that you update the relevant policies to have syslog messages sent to the new server and to allow contact from the new server. None of the event or report data from the original server is transferred to the new server.

 
     [bookmark: pgfId-67915]For information on configuring the devices to enable Security Manager monitoring, see the following topics:

 
      
      		 [bookmark: pgfId-67920]Configuring ASA and FWSM Devices for Event Management

 
      		 [bookmark: pgfId-67925]Configuring IPS Devices for Event Management

 
     

 
     [bookmark: pgfId-67930]Step 8 On the original Security Manager server, select File > Delete Devices to delete the moved devices from the original server. For information on deleting devices, see Deleting Devices from the Security Manager Inventory.

 
     [bookmark: pgfId-67932]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-67948][bookmark: 29702][bookmark: adman_proc_SynchronizingSharedPoliciesAmongSecurityManagerServers]Synchronizing Shared Policies Among Security Manager Servers[bookmark: marker-67938][bookmark: marker-67940][bookmark: marker-67942][bookmark: marker-67944][bookmark: marker-67946]

 
     [bookmark: pgfId-67950]When you have more than one Security Manager server, you can manually synchronize the shared policies among those servers. When you synchronize shared policies, the policy objects that are used by those shared policies are also synchronized.

 
     [bookmark: pgfId-67952]Tips

 
      
      		 [bookmark: pgfId-67954]There is no programmatic way to identify a single Security Manager server as the “master” server, the one that contains the official version of shared policies. You must decide which server to use as the master and have the discipline to edit shared policies on that server only.

 
      		 [bookmark: pgfId-67956]Use the same release of Security Manager software on all servers.

 
      		 [bookmark: pgfId-67961]You can also synchronize certain types of policy object among servers even if those objects are not used in shared policies. If you have network/host, service, or port list objects that you want to synchronize, you can use the command described in Importing and Exporting Policy Objects.

 
      		 [bookmark: pgfId-67963]When importing shared policies and policy objects, the imported information always replaces any existing shared policies or policy objects of the same name. Therefore, if you allow users to create their own shared policies and objects on a server where you will import policies and objects, it is critical that you develop a policy and object naming standard so that user policies and objects are not accidentally overwritten by newly imported policies and objects.

 
     

 
     [bookmark: pgfId-67965]Related Topics

 
      
      		 [bookmark: pgfId-67970]Overview of Security Manager Server Cluster Management

 
      		 [bookmark: pgfId-67975]Splitting a Security Manager Server

 
      		 [bookmark: pgfId-67980]Exporting the Device Inventory from the Security Manager Client

 
     

 
     
 
     [bookmark: pgfId-67982]Step 1 On the original server, ensure that all configuration changes for the shared policies and policy objects have been submitted. You will need to ask the staff to submit their changes and have them approved, there is no simple way to determine this status within Security Manager.

 
     [bookmark: pgfId-67984]When exporting shared policies, there is no need to ensure that new changes have been deployed to devices assigned to the policies. Device assignments and deployment status are not part of the exported information.

 
     [bookmark: pgfId-67986]Step 2 Select File > Export > Policies to export the shared policies and any policy objects used by the policies. The export process creates a file with the extension pol.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-67988]Tip You cannot pick and choose which policies to export. You can select policy types only. All shared policies of a selected type are exported.


     
      

     

     

 
     [bookmark: pgfId-67993]For more detailed information, see Exporting Shared Policies.

 
     [bookmark: pgfId-67998]Step 3 On each of the other Security Manager servers, select File > Import to import the exported shared policy information to the servers. For more detailed information, see Importing Policies or Devices.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-68003]Tip Any shared policies or objects that have the same name as imported ones are replaced. The import of a policy or object will fail if a user already has a lock on the policy or object. As explained in Importing Policies or Devices, you must submit policies before the changes are available for configuring devices.


     
      

     

     

 
     [bookmark: pgfId-68005]Step 4 If you do not want to import all of the shared policies, delete the ones you did not want to import on the other servers. This is a manual process.

 
     [bookmark: pgfId-68007]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-68019][bookmark: 29768][bookmark: ivman_cncpt_ExportingtheDeviceInventory]Exporting the Device Inventory[bookmark: marker-68013][bookmark: marker-68015][bookmark: marker-68017]

 
     [bookmark: pgfId-68021]Exporting the device inventory allows you to import the inventory into other network management applications, or to manipulate the output for your own reporting purposes. There are two unrelated methods to export the device inventory:

 
      
      		 [bookmark: pgfId-68026]Use the  File > Export > Devices command—Using this command, you can create either a simple comma-separated values (CSV) file, or a compressed .dev file that contains the devices along with their complete configuration policies. You can open the CSV file and view it in a spreadsheet or text editor program. The .dev file is suitable for importing into another Security Manager server only. For more information, see Exporting the Device Inventory from the Security Manager Client.

 
      		 [bookmark: pgfId-68031]Use the CSMgrDeviceExport Perl script—Using this Perl script, you can export the inventory without starting the Security Manager client. You can direct the output to the screen or to a comma-separated values (CSV) file. For more information, see Exporting the Device Inventory from the Command Line.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-68033]Note Only the five most recent versions of each device configuration are exported.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-68061][bookmark: 29792][bookmark: adman_proc_ExportingtheDeviceInventoryfromtheSecurityManagerClient]Exporting the Device Inventory from the Security Manager Client[bookmark: marker-68043][bookmark: marker-68045][bookmark: marker-68047][bookmark: marker-68049][bookmark: marker-68051][bookmark: marker-68053][bookmark: marker-68055][bookmark: marker-68057][bookmark: marker-68059]

 
     [bookmark: pgfId-68063]You can export the device inventory in a variety of formats. These are the main choices:

 
      
      		 [bookmark: pgfId-68065] Export as CSV (comma-separated values)—You can create a simple CSV file containing inventory information in the CSM (for use with Cisco Security Manager) format. You can open a CSV file in a spreadsheet application or text editor, and use the file with any application that supports the format, including other Security Manager servers. However, this format contains no policy information, so if you use it with another Security Manager server, you must discover policies while adding the devices.

 
     

 
     [bookmark: pgfId-68070] – For more information about the CSV formats, see Supported CSV Formats for Inventory Import/Export.

 
     [bookmark: pgfId-68075] – For information on how to import devices from a CSV file, see Adding Devices from an Inventory File.

 
      
      		 [bookmark: pgfId-68077] Export Devices, Policies, and Objects —Export the device inventory along with all device properties, policies, and policy objects used by the device. Exported information includes the following:

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-68079]Note Importing of *.pol or *.dev files is only supported on the same version of Cisco Security Manager as used when exporting those files. You cannot export from one version of Cisco Security Manager and import on a server running a different version.


     
      

     

     

 
     [bookmark: pgfId-68081] – All local and shared policies assigned to the devices, including all policy objects used in the policies and any device-level overrides for the objects. Shared policy assignments are maintained.

 
     [bookmark: pgfId-68083] – Device properties and inventory.

 
     [bookmark: pgfId-68085] – Configuration Archive data for the devices.

 
     [bookmark: pgfId-68087] – History snapshots for the devices.

 
     [bookmark: pgfId-68089] – Device certificates.

 
     [bookmark: pgfId-68091] – IPS device license and certificate information. Applied signatures are not exported (when importing the device, you must have the same signature package registered on the server). IPS update settings are not included; you will have to recreate them after import.

 
     [bookmark: pgfId-68093] – The VPN topologies in which the devices participate. However, a VPN topology is exported only if all devices that participate in the topology are included in the export. Extranet VPNs are always exported.

 
     [bookmark: pgfId-68095]Thus, the export file includes the complete policy configuration for the selected devices. The file created has the extension .dev and can be read only by another Security Manager server (the file contents are compressed and uninterpretable, which preserves the security of your policy information).

 
     [bookmark: pgfId-68100]For information on importing a .dev file into another Security Manager server, see Importing Policies or Devices.

 
     [bookmark: pgfId-68102]Export Size Limitations

 
     [bookmark: pgfId-68104]If your Security Manager database contains a large number of devices or a large number of policies or policy objects, you should limit the number of devices you export at one time to prevent errors. The following guidelines can be used to help estimate the number of devices you can successfully export at one time:

 
     [bookmark: pgfId-68106]Example 1: 1000+ devices in the database with approximately 1500+ polices per device and approximately 25,000 objects in the database:

 
      
      		 [bookmark: pgfId-68108]Maximum number of devices (devices only) to be exported at one time = 250

 
      		 [bookmark: pgfId-68110]Maximum number of devices (along with polices and objects) to be exported at one time = 100 to 150

 
     

 
     [bookmark: pgfId-68112]Example 2: Fewer than 1000 devices in the database with approximately 1500+ polices per device and approximately 10,000-15,000 objects in the database:

 
      
      		 [bookmark: pgfId-68114]Maximum number of devices (devices only) to be exported at one time = 250 to 300

 
      		 [bookmark: pgfId-68116]Maximum number of devices (along with polices and objects) to be exported at one time = 200

 
     

 
     [bookmark: pgfId-68118]Tips

 
      
      		 [bookmark: pgfId-68123]When you select the  Export Devices, Policies, and Objects option, you can export to the Security Manager server or to the local Security Manager client. When exporting a CSV file, you can only export to the Security Manager server. You can control the ability to export to or import from the local Security Manager client from  Tools > Security Manager Administration > Customize Desktop . For more information, see Customize Desktop Page.

 
      		 [bookmark: pgfId-68125]Exported devices are not deleted from the inventory. If you intend to manage the devices from a different Security Manager server, delete the devices after successfully importing them into the other server.

 
      		 [bookmark: pgfId-68127]If you select a device that uses an AUS or Configuration Engine to manage its configuration, you should also select the server in the list of devices to export. 

 
      		 [bookmark: pgfId-68129]You can export unmanaged devices.

 
      		 [bookmark: pgfId-68131]When exporting devices with their policies, only policies and policy objects that have been submitted and approved are included in the export file. Make sure that all desired submissions and approvals have occurred before exporting devices with policies and policy objects.

 
      		 [bookmark: pgfId-68133]No type of export file includes event and report data (that is, data that is available through Event Viewer or Report Manager). Thus, if you are exporting devices with the intention of moving them to another Security Manager server, the event and report data that was already collected for the device will not be available on the new server.

 
      		 [bookmark: pgfId-68135]No type of export file includes device group information. You will have to manually recreate device groups and assign devices to them after importing devices.

 
      		 [bookmark: pgfId-68137]When selecting security contexts or virtual sensors, be sure to select the host device as well. Also, if a device is part of a VPN, ensure that you select all devices in the VPN when exporting devices, policies, and policy objects.

 
      		 [bookmark: pgfId-68139]When selecting IPS or IOS IPS devices, make sure that you have already applied an IPS signature update to the device. Although you can export an IPS or IOS IPS device with the base sensor package (Sig0), you will not be able to import it. The import error will be “missing Sig0 package.”

 
      		 [bookmark: pgfId-68141]When you select the following types of device that are contained in another device, the hosting device is also automatically exported: any module in a Catalyst 6500/7600, an AIM or NME module in a router. You can separately export ASA devices and their IPS modules.

 
      		 [bookmark: pgfId-68143]You cannot export devices with their policies (.dev format) while an activity or configuration session is being approved. All approvals must be complete before you can export devices with policies. In Workflow mode with an approver, contact the approver and ask that the approval be completed in a timely manner. In non-Workflow mode, or Workflow mode without an approver, wait a few minutes before retrying the export, because approvals happen automatically when changes are submitted.

 
      		 [bookmark: pgfId-68145]While you are exporting devices with their policies (.dev format), policy changes cannot be approved. Once the export file has been created, and the command finishes, users can again approve policy changes. In non-Workflow mode, or Workflow mode without an approver, this means that submissions are not allowed during the export process.

 
      		 [bookmark: pgfId-68147]To export devices, policies, and policy objects, you must have Modify Policy and Modify Object privileges to the policy and object types, and Modify Device privileges. These privileges can be assigned for separate policies, objects, and devices when using ACS for authorization control. Having system administrator, network administrator, or security administrator privileges provide the required privileges.

 
     

 
     [bookmark: pgfId-68149]When exporting devices to CSV, you need Modify Devices privileges only.

 
     [bookmark: pgfId-68151]Related Topics

 
      
      		 [bookmark: pgfId-68156]Filtering Items in Selectors

 
      		 [bookmark: pgfId-68161]Selecting or Specifying a File or Directory in Security Manager

 
      		 [bookmark: pgfId-68166]Customize Desktop Page

 
     

 
     
 
     [bookmark: pgfId-68168]Step 1 In Device view, select File > Export > Devices to open the Export Inventory dialog box.

 
     [bookmark: pgfId-68170]Step 2 Select either Export as CSV or Export Devices, Policies, and Objects. These options are described above.

 
     [bookmark: pgfId-68172]Step 3 Select the devices that you want to include in the export file and click >> to add them to the Selected Devices list. You can select a folder to select all devices in the folder.

 
     [bookmark: pgfId-68174]The list from which you choose contains only those devices to which you have Modify Device permissions.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-68176]Note If your Security Manager database contains a large number of devices or a large number of policies or policy objects, you should limit the number of devices you export at one time to prevent errors. For more information, see Export Size Limitations above.


     
      

     

     

 
     [bookmark: pgfId-68178]Step 4 Click Browse to select the folder in which to create the export file and to enter a name for the file. For File Type, select the type of file that you want to create; this selection is critical when creating a CSV file, whereas there is a single option when creating a .dev file.

 
     [bookmark: pgfId-68180]Click Save to return to the Export Inventory dialog box. The Export Inventory To field is updated with the export file information.

 
     [bookmark: pgfId-68182]Step 5 Click OK to create the export file.

 
     [bookmark: pgfId-68184]A message indicates when the export completes and whether there were errors in the export. When you click OK, if there are problems during the export, a dialog box opens listing the messages. If there is a Details button in the dialog box, you can select a message and click Details to see the message in a more readable format.

 
     [bookmark: pgfId-68186]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-68200][bookmark: 29951][bookmark: adman_cncpt_SupportedCSVFormatsforInventoryImportExport]Supported CSV Formats for Inventory Import/Export[bookmark: marker-68192][bookmark: marker-68194][bookmark: marker-68196][bookmark: marker-68198]

 
     [bookmark: pgfId-1053953]When you export devices to a CSV (comma-separated values) file (by selecting File > Export > Devices and selecting Export as CSV), or import devices from a CSV file (by selecting File > New Device and then selecting Add Device from File in the New Device wizard), The following CSV file format is supported:

 
      
      		 [bookmark: pgfId-1053958] Cisco Security Manager —The Security Manager format, which is the DCR version 3.0 format with additional fields. If you are importing the inventory into another Security Manager server, selecting this format will allow you to import the inventory without discovering policies on the devices.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-68214]Note If the file does not specify os_type and os_version for a device, you must discover policies directly from the device when adding it.


     
      

     

     

 
     [bookmark: pgfId-68216]The additional fields, which appear at the end of each row, are:

 
     [bookmark: pgfId-68218] – os_type. The operating system type, which can be one of the following: PIX, ASA, IOS, FWSM, IPS. This field is required for all device types.

 
     [bookmark: pgfId-68223] – os_version. The target operating system version, which can be any of the version numbers listed in the New Device wizard when you select Add New Device. The acceptable version numbers differ depending on the device model, so if you are creating a CSV file by hand, look over this list carefully. For more information about adding devices using this method, see Adding Devices by Manual Definition. This field is required for all device types.

 
     [bookmark: pgfId-68225] – fw_os_mode. The mode in which a firewall device is running, which can be one of the following: TRANSPARENT, ROUTER, MIXED. This field is required for ASA, PIX, and FWSM devices.

 
     [bookmark: pgfId-68227] – fw_os_context. The context in which a firewall device is running, which can be one of the following: SINGLE, MULTI. This field is required for ASA, PIX, and FWSM devices.

 
     [bookmark: pgfId-68229] – anc_os_type. The ancillary operating system type for Cisco IOS-IPS devices. If present, it is IPS. This field is required for IOS IPS devices.

 
     [bookmark: pgfId-68231] – anc_os_version. The ancillary target operating system version, which is the IPS target operating system version. If present, it can be any of the supported IOS-IPS versions. This field is required for IOS IPS devices.

 
     [bookmark: pgfId-68233]You can use these CSV files with any program that supports the file format. You can also create a CSV file yourself and use the file to import inventory into Security Manager.

 
     [bookmark: pgfId-68235]Related Topics

 
      
      		 [bookmark: pgfId-68240]Exporting the Device Inventory from the Security Manager Client

 
      		 [bookmark: pgfId-68245]Importing Policies or Devices

 
      		 [bookmark: pgfId-68250]Adding Devices from an Inventory File

 
     

 
    
 
     
      [bookmark: pgfId-68260][bookmark: 30013][bookmark: ivman_cncpt_ExportingtheDeviceInventoryfromtheCommandLine]Exporting the Device Inventory from the Command Line[bookmark: marker-68256][bookmark: marker-68258]

 
     [bookmark: pgfId-68262]Security Manager includes a Perl script that you can use to export the device inventory without starting the Security Manager client. You can use this script to automate various offline reporting tasks that your organization might require. You can pipe the output to a comma-separated values (CSV) file or otherwise capture and manipulate the output.
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     [bookmark: pgfId-68264]Tip This command does not produce a file that you can use for importing devices or for adding devices “from file.” Although it exports inventory information, making it similar to the integrated export features, the usefulness of the command is limited to reporting purposes for organizations that have unique off-line reporting process requirements.


     
      

     

     

 
     [bookmark: pgfId-68266]The Perl command is located in $NMSROOT\bin, which is typically C:\Program Files\CSCSpx\bin. The syntax of the command is:

 
     [bookmark: pgfId-68268]perl [path]CSMgrDeviceExport.pl -u username [-p password] [-s {Dhdoirtg}] [-h] [> filename.csv]

 
     [bookmark: pgfId-68271]Syntax

 
      
       
       
         
         		[bookmark: pgfId-66677]perl [path] CSMgrDeviceExport.pl

  
         		[bookmark: pgfId-66679]The Perl script command. Include the path to the CSMgrDeviceExport.pl file if the path is not defined in the system path variable.

  
        

 
         
         		[bookmark: pgfId-66685]-u username

  
         		[bookmark: pgfId-66687]A Security Manager username. The data exported is limited by the permissions assigned to this user. The user must have View Device permissions.

  
        

 
         
         		[bookmark: pgfId-66693]-p password

  
         		[bookmark: pgfId-66695](Optional.) The user’s password. If you do not include the password on the command, you are prompted for it.

  
        

 
         
         		[bookmark: pgfId-66701]-s {Dhdoirtg}

  
         		[bookmark: pgfId-66703](Optional.) The fields you are selecting to include in the output. If you do not specify the -s option, all fields are included. You can specify one or more of the following:

 
           
           		 [bookmark: pgfId-66705]D—Display name.

 
           		 [bookmark: pgfId-66707]h—Host name.

 
           		 [bookmark: pgfId-66709]d—Domain name.

 
           		 [bookmark: pgfId-66711]o—Operating system (OS) type.

 
           		 [bookmark: pgfId-66713]I—Image name.

 
           		 [bookmark: pgfId-66715]r—Running OS version.

 
           		 [bookmark: pgfId-66717]t—Target OS version.

 
           		 [bookmark: pgfId-66719]g—Device groups.

 
          

  
        

 
         
         		
           
           [bookmark: pgfId-66725]-h
          
  
         		[bookmark: pgfId-66727](Optional.) Display the command line help. If you include this option, all other options are ignored.

  
        

 
         
         		[bookmark: pgfId-66733]> filename.csv

  
         		[bookmark: pgfId-66735](Optional.) Pipe the output to the specified file. If you do not specify a file, the output is displayed on the screen.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-68273]Output Format

 
     [bookmark: pgfId-68275]The output is in standard comma-separated values (CSV) format, which you can open in spreadsheet programs or process with your own scripts. The first line has column headings. The columns, left to right, are in the order of the fields described for the -s option above.

 
     [bookmark: pgfId-68277]If there is no value for a particular field, that field is blank in the output.

 
     [bookmark: pgfId-68279]The device group output field is enclosed in double-quotes and it can contain more than one group name. The group names include the path structure for the group. For example, the following output indicates the device is part of two groups, the East Coast group in the Department folder, and the NewGroup group in the New folder. Groups are separated by a semicolon.

 
     
      [bookmark: pgfId-68281]"/Department/East Coast; /New/NewGroup"
     

     
      [bookmark: pgfId-68283] 
     

     
      [bookmark: pgfId-68285] 
     

     [bookmark: pgfId-68287]Any error messages generated during the script are written to the output file.

 
    
 
     
      [bookmark: pgfId-68301][bookmark: 30119][bookmark: adman_proc_ExportingSharedPolicies]Exporting Shared Policies[bookmark: marker-68295][bookmark: marker-68297][bookmark: marker-68299]

 
     [bookmark: pgfId-68306]You can export shared policies and the policy objects that they use so that you can import them into another Security Manager server. This can help you maintain the same policies among a group of servers, as explained in Synchronizing Shared Policies Among Security Manager Servers.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-68308]Note Importing of *.pol or *.dev files is only supported on the same version of Cisco Security Manager as used when exporting those files. You cannot export from one version of Cisco Security Manager and import on a server running a different version.


     
      

     

     

 
     [bookmark: pgfId-68310]Tips

 
      
      		 [bookmark: pgfId-68315]You can export to the Security Manager server or to the local Security Manager client. You can control the ability to export to or import from the local Security Manager client from  Tools > Security Manager Administration > Customize Desktop . For more information, see Customize Desktop Page.

 
      		 [bookmark: pgfId-68317]Only shared policies and policy objects that have been submitted and approved are included in the export file. Make sure that all desired submissions and approvals have occurred before exporting policies.

 
      		 [bookmark: pgfId-68322]All policy objects referenced by shared policies are also exported. However, if a policy object is not referenced, it is not exported. There is a separate command you can use to export network/host, service, and port list objects directly; for information, see Importing and Exporting Policy Objects.

 
      		 [bookmark: pgfId-68324]You cannot export policies while an activity or configuration session is being approved. All approvals must be complete before you can export policies. In Workflow mode with an approver, contact the approver and ask that the approval be completed in a timely manner. In non-Workflow mode, or Workflow mode without an approver, wait a few minutes before retrying the export, because approvals happen automatically when changes are submitted.

 
      		 [bookmark: pgfId-68326]While you are exporting policies, policy changes cannot be approved. Once the export file has been created, and the command finishes, users can again approve policy changes. In non-Workflow mode, or Workflow mode without an approver, this means that submissions are not allowed during the export process.

 
      		 [bookmark: pgfId-68328]To export policies and their policy objects, you must have Modify Policy and Modify Object privileges to the policy and object types. These privileges can be assigned for separate policies, objects, and devices when using ACS for authorization control. Having system administrator, network administrator, or security administrator privileges provide the required privileges.

 
     

 
     [bookmark: pgfId-68330]Related Topics

 
      
      		 [bookmark: pgfId-68335]Overview of Security Manager Server Cluster Management

 
      		 [bookmark: pgfId-68340]Splitting a Security Manager Server

 
      		 [bookmark: pgfId-68345]Synchronizing Shared Policies Among Security Manager Servers

 
      		 [bookmark: pgfId-68350]Exporting the Device Inventory from the Security Manager Client

 
      		 [bookmark: pgfId-68355]Selecting or Specifying a File or Directory in Security Manager

 
      		 [bookmark: pgfId-68360]Customize Desktop Page

 
     

 
     
 
     [bookmark: pgfId-68362]Step 1 In Configuration Manager, select File > Export > Policies to open the Export Shared Policies dialog box.

 
     [bookmark: pgfId-68364]Before opening the dialog box, Security Manager evaluates and loads any shared policies that are defined.

 
     [bookmark: pgfId-68366]Step 2 Select the shared policies that you want to export, using any of the following methods:

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-68368]Tip You can use multiple methods to select policies. For example, you can select all shared policies modified since a certain date and also select all shared policies of a specific type to export those policies in the same file.


     
      

     

     

 
      
      		 [bookmark: pgfId-68370]To select all shared policies that have been modified since a certain date, enter that date in the Modified since field and click  Select >> next to the Modified since field. You can enter the date in  MMM DD YYYY format or you can click the Calendar to select the desired date.

 
      		 [bookmark: pgfId-68372]To select all shared policies, select the  All folder and click  Select >> under Browse All Shared Policies.

 
      		 [bookmark: pgfId-68374]To select all shared policies of a specific type, select the shared policy type and click  Select >> under Browse All Shared Policies. You can select a folder to move all types within the folder to the selected list.

 
      		 [bookmark: pgfId-68376]To specify specific shared policies to export, select the type of shared policies you want to export from the Browse All Shared Policies list, select the check boxes next to the shared policies of that type that you want to export, and then click  Select >> to move them to the Selected Policies list. If you do not select any specific shared policies, all policies of the selected type will be added to the Selected Policies list.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-68378]Note Only those policy types for which shared policies have been defined are listed.


     
      

     

     

 
     [bookmark: pgfId-68380]To remove any policies from the Selected Policies list, select them and then click the << Remove button. Use the Select All checkbox to specify that all entries in the Selected Policies list are to be removed.

 
     [bookmark: pgfId-68382]Step 3 Click Browse next to the Export Shared Policies To field to select the folder where the export file is to be created, and enter a name for the file. The file type is pre-selected as .pol; you cannot change the file type.

 
     [bookmark: pgfId-68384]Click OK to save the file name and location.

 
     [bookmark: pgfId-68386]Step 4 Click OK in the Export Shared Policies dialog box to begin the export. When the export is completed, you are told how many shared policies were exported and if there are warnings or errors, a dialog box opens listing the problems.

 
     [bookmark: pgfId-68391]You can now import the policies into other Security Manager servers as explained in Importing Policies or Devices.

 
     [bookmark: pgfId-68393]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-68415][bookmark: 30214][bookmark: adman_proc_ImportingPoliciesorDevices]Importing Policies or Devices[bookmark: marker-68403][bookmark: marker-68405][bookmark: marker-68407][bookmark: marker-68409][bookmark: marker-68411][bookmark: marker-68413]

 
     [bookmark: pgfId-68417]You can import a shared policy (.pol) or device inventory plus policies (.dev) file that was exported from another Security Manager server.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-68419]Note Importing of *.pol or *.dev files is only supported on the same version of Cisco Security Manager as used when exporting those files. You cannot export from one version of Cisco Security Manager and import on a server running a different version.


     
      

     

     

 
     [bookmark: pgfId-68421]Tips

 
      
      		 [bookmark: pgfId-68426]You can import from the Security Manager server or from the local Security Manager client. You can control the ability to export to or import from the local Security Manager client from  Tools > Security Manager Administration > Customize Desktop . For more information, see Customize Desktop Page.

 
      		 [bookmark: pgfId-68431]When importing devices, the server must have a sufficient Security Manager license to support the number and types of devices that you are importing. Ensure that you install a professional license before importing device types that require it. For information on installing licenses, see Installing Security Manager License Files.

 
      		 [bookmark: pgfId-68436]When importing policies, whether during device or shared policy import, only the policy types selected for management on the Security Manager Administration Policy Management page will be visible. However, all policies are imported. If you select a previously deselected policy type for management, those imported policies appear with their imported configurations. For more information about selective policy management, see Customizing Policy Management for Routers and Firewall Devices.

 
      		 [bookmark: pgfId-68438]When importing shared polices and policy objects, if a policy or object on the server has the same name as an imported one, it is replaced by the imported policy or object. If there are locks on the policy or object, the import for that policy or object will fail. The message will indicate that the failure was due to a locking problem. To avoid problems, ensure that all users have submitted and approved any changes to shared policies or policy objects before doing an import.

 
      		 [bookmark: pgfId-68440]When importing devices, any shared policies and policy objects assigned to the device are also imported, and these policies and objects replace existing policies and objects under the same conditions as used when importing shared policies.

 
      		 [bookmark: pgfId-68442]To import policies and their policy objects, you must have Modify Policy and Modify Object privileges to the policy and object types. When importing devices, you must also have Modify Device privileges. These privileges can be assigned for separate policies, objects, and devices when using ACS for authorization control. Having system administrator, network administrator, or security administrator privileges provide the required privileges.

 
      		 [bookmark: pgfId-68444]You can import a file only if it was exported from a server running the same release of Security Manager.

 
      		 [bookmark: pgfId-68446]You cannot import a device if the device is already in the inventory. Thus, you cannot update device policies from an import file. If you want to re-import a device, first delete it from the inventory.

 
      		 [bookmark: pgfId-68448]When importing devices that use AUS or Configuration Engine servers to manage configuration deployment, the servers must either be included in the import file or already defined in the Security Manager server, but not both. You will get duplicate display name errors if the import file includes an AUS or Configuration Engine already defined in the inventory. You will get an “invalid server selection” error if you try to import a device that has an AUS or Configuration Engine server assigned to it, but the server is not included in the import file or defined in the inventory.

 
      		 [bookmark: pgfId-68450]You can import unmanaged devices.

 
      		 [bookmark: pgfId-68455]When importing IPS devices, the server must have the same signature levels as the imported devices. For example, if you import two IPS devices, one running signature level 481 and the other 530, you must have both 481 and 530 installed on the server. You might need to download signature packages before importing IPS devices as described in Checking for IPS Updates and Downloading Them.

 
      		 [bookmark: pgfId-68460]This procedure explains how to import .pol or .dev files. If you want to import a device inventory from a CSV file, the procedure is explained in Adding Devices from an Inventory File. The procedures are not similar.

 
     

 
     [bookmark: pgfId-68462]Related Topics

 
      
      		 [bookmark: pgfId-68467]Overview of Security Manager Server Cluster Management

 
      		 [bookmark: pgfId-68472]Splitting a Security Manager Server

 
      		 [bookmark: pgfId-68477]Synchronizing Shared Policies Among Security Manager Servers

 
      		 [bookmark: pgfId-68482]Selecting or Specifying a File or Directory in Security Manager

 
      		 [bookmark: pgfId-68487]Customize Desktop Page

 
     

 
     
 
     [bookmark: pgfId-68489]Step 1 In Configuration Manager, select File > Import to open the Import dialog box.

 
     [bookmark: pgfId-68491]Step 2 Click Browse to select the file. Make sure that you select the desired file type (either .pol or .dev) from the Files of Type list on the Select a File dialog box.

 
     [bookmark: pgfId-68493]Click OK when you have selected the file.

 
     [bookmark: pgfId-68495]Step 3 Click OK in the Import dialog box.

 
     [bookmark: pgfId-68497]You are warned that imported policies or policy objects will replace same-named policies and objects. If you have the required authorization privileges (system administrator or Modify Admin), you have the option to deselect Display a warning on all shared policies and imported objects. When selected, the banner for shared policies and imported objects warns users that shared policies might have been created during import, and that specific objects were in fact created during import. This warning provides notice that if the user changes the policy or object, those changes might be overridden by a subsequent policy import. Select whether you want to display a warning and click Yes.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-68499]Tip If you decide later that you want to change whether the warning is displayed, you can modify the Display a warning on all shared policies and imported objects option on the Tools > Security Manager Administration > Policy Management page.


     
      

     

     

 
     [bookmark: pgfId-68501]The information is imported and you are informed of the results. If errors occur, nothing is imported and a dialog box opens that explains the errors. The most common errors include duplicate device display names when importing devices, or locks on shared policies or policy objects that have the same name as those being imported.

 
      
      		 [bookmark: pgfId-68503]To resolve the duplicate display name problem, you must delete the device from the inventory or rename it. You cannot selectively import devices, you must import all or none.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-68505]Note Not all duplicate device names might be listed. When using AUS or Configuration Engine to manage configuration deployment, imported AUS and Configuration names are evaluated before managed device names. Thus, you might see new duplicate display name errors after fixing the first set of errors.


     
      

     

     

 
      
      		 [bookmark: pgfId-68507]To resolve the locking problem, you must ensure that users submit their policy changes and have them approved. When importing devices, you might have to delete the imported devices before retrying the import.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-68509]Tip When importing devices, it might take some time for the devices to appear in the device list in Device view. Also, device groups are not preserved during import. All devices are placed in the All group. You need to manually recreate the desired device group structure and add the devices to the appropriate groups.


     
      

     

     

 
     [bookmark: pgfId-68511]Step 4 Because policy changes are performed under an activity or configuration session, the imported policies and policy objects are not yet committed to the Security Manager database. You must submit and approve the changes. Based on Workflow mode:

 
      
      		 [bookmark: pgfId-68513]Non-Workflow mode—Select  File > Submit .

 
      		 [bookmark: pgfId-68515]Workflow mode without an approver—Select  Activities > Approve Activity .

 
      		 [bookmark: pgfId-68517]Workflow mode with an approver—Select  Activities > Submit Activity . The activity must be approved before the changes are committed.

 
     

 
     [bookmark: pgfId-68522]If you are not happy with the import, you can discard the activity or configuration session. However, when importing devices, the devices are added outside an activity or configuration session. Therefore, if you discard the activity or configuration session, you discard the device policies and VPN topologies, but the devices remain in the inventory. You should also delete the devices as described in Deleting Devices from the Security Manager Inventory.

 
     [bookmark: pgfId-68524]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-68542][bookmark: 30337][bookmark: defapset_proc_InstallingSecurityManagerLicenseFiles]Installing Security Manager License Files [bookmark: marker-68532][bookmark: marker-68534][bookmark: marker-68536][bookmark: marker-68538][bookmark: marker-68540]

 
    [bookmark: pgfId-68544]The terms of your Security Manager software license determine many things, including the features that are available to you and the number of devices that you can manage. For licensing purposes, the device count includes any physical device, security context, virtual sensor, or Catalyst security services module that uses an IP address. Failover pairs count as one device. For PIX Firewalls, FWSM, and ASA devices that are configured in multiple-context mode (so that they host more than one security context), only the security contexts are counted as devices; the hosting device is not counted as a separate device.

 
    [bookmark: pgfId-68550]Three license types, Standard, Professional, and Upgrade, are available, in addition to a free 90-day evaluation period that is restricted to 50 devices. For complete information on the types of licenses available and the various supported upgrade paths, as well as information about the Cisco Software Application Support service agreement contracts that you can purchase, see the product bulletin for this version of Security Manager at http://www.cisco.com/en/US/products/ps6498/prod_bulletins_list.html. Also see the Installation Guide for Cisco Security Manager.

 
    [bookmark: pgfId-68552]License limits are imposed when you exceed the allotted time (in the case of the evaluation license), or the number of devices that your license allows you to manage. The evaluation license provides the same privileges as the Professional Edition license. It is important that you register Security Manager as soon as you can within the first 90 days, and for the number of devices that you need, to ensure uninterrupted use of the product. Each time you start the application you are reminded of how many days remain on your evaluation license, and you are prompted to upgrade during the evaluation period. At the end of the evaluation period, you are prevented from logging in until you upgrade your license.

 
    [bookmark: pgfId-68554]For non-evaluation licenses, if the database contains more devices than what is allowed by your configured licenses, you cannot log into the application using the Security Manager client. You are prompted to add a license during login, and login cannot complete until you add an appropriate license.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-68556]Tip The number of devices includes all discovered security contexts and virtual sensors, even if you have not submitted the activity that discovered them and they do not currently appear in the device selector. If it appears there are fewer devices in the inventory than your license allows, but you are getting device count error messages, submit all activities to determine the number of discovered devices. Delete those that you do not want to manage.


    
     

    

    

 
    [bookmark: pgfId-68558]Before You Begin

 
     
     		 [bookmark: pgfId-68560]Obtain the base or upgrade license and any additional licenses that you require. You must have a Cisco.com user ID, and you must register your copy of the software on Cisco.com. When registering, you must provide the Product Authorization Key (PAK) that is attached to the Software License Claim Certificate inside the shipped software package.

 
    

 
    [bookmark: pgfId-68564] – If you are a registered Cisco.com user, go to http://www.cisco.com/go/license.

 
    [bookmark: pgfId-68568] – If you are not a registered Cisco.com user, go to http://tools.cisco.com/RPF/register/register.do.

 
    [bookmark: pgfId-68570]After registration, the base software license is sent to the e-mail address that you provided during registration. In addition to receiving a PAK and license for Security Manager, you might receive one additional PAK for each incremental device count pack you purchased.

 
    [bookmark: pgfId-68572]Copy the license files to a folder on the Security Manager server or your local Security Manager client. If you are copying the license files to your Security Manager server, you must store your license files on a disk that is local to your Security Manager server; you cannot use a drive that is mapped to the server. Windows imposes this limitation, which serves to improve Security Manager performance and security.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-68577]Note To install a license file that is located on your local Security Manager client, you must have client-side file browsing enabled (see Customize Desktop Page).


    
     

    

    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-68579]Tip Do not place the license file in the etc/licenses/CSM folder in the product’s installation folder on the Security Manager server, or you will encounter an error when you try to add the license. Place the file in a folder outside the product folders.


    
     

    

    

 
     
     		 [bookmark: pgfId-68583]Common Services does not require a license file.[bookmark: marker-68581]

 
     		 [bookmark: pgfId-68587]Auto Update Server does not require a license file.[bookmark: marker-68585]

 
    

 
    
 
    [bookmark: pgfId-68589]Step 1 Select Tools > Security Manager Administration and select Licensing from the table of contents.

 
    [bookmark: pgfId-68594]Step 2 Click CSM if the tab is not active. For a description of the fields on this tab, see CSM Tab, Licensing Page.

 
    [bookmark: pgfId-68596]Step 3 Click Install a License to open the Install a License dialog box.

 
    [bookmark: pgfId-68598]The Install a License dialog box includes links to Cisco.com for obtaining licenses if you have not already done so. Click Browse to select a license file, and then click OK on the Install a License dialog box to install the license.

 
    [bookmark: pgfId-68600]Repeat the process until you have installed all of your licenses.

 
    [bookmark: pgfId-68602]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-68608][bookmark: 30408][bookmark: adman_cncpt_CertificateTrustManagement]Certificate Trust Management

 
    [bookmark: pgfId-68610]Cisco Security Manager downloads ASA images and IPS packages from Cisco.com over HTTPS, which uses certificates for establishing trust. Beginning with version 4.4, Security Manager has a certificate trust management feature. This feature helps you with improved handling of Cisco.com certificates for both types of downloads:

 
     
     		 [bookmark: pgfId-68615]ASA image downloads. For detailed documentation on certificate trust management for ASA image downloads, refer to Image Manager Page or navigate to Tools > Security Manager Administration... > Image Manager > Help.

 
     		 [bookmark: pgfId-68620]IPS package downloads. For detailed documentation on certificate trust management for IPS package downloads, refer to Edit Update Server Settings Dialog Box or navigate to Tools > Security Manager Administration... > IPS Updates > [Update Server group] > Edit Settings > Help.

 
    

 
    [bookmark: pgfId-68622]Certificate Trust Management Feature

 
    [bookmark: pgfId-68624]The certificate trust management feature in Security Manager has these characteristics:

 
     
     		 [bookmark: pgfId-68626]It behaves like a browser. It imparts trust to what you, as the user, consciously trust.

 
     		 [bookmark: pgfId-68628]It allows you to view the certificate and use your discretion in accepting it.

 
     		 [bookmark: pgfId-68630]It proactively validates a certificate to help you judge whether to accept or reject it. For example, it checks to see if a certificate is self-signed (not issued by a trusted Certificate Authority) and to see if it is expired, not yet valid, or revoked.

 
     		 [bookmark: pgfId-68632]After you accept a certificate, it stores that certificate on your Security Manager server.

 
     		 [bookmark: pgfId-68634]It provides transparency and control: You can retrieve and add a certificate, view a certificate, and remove a stored certificate.

 
     		 [bookmark: pgfId-68636]During communication with Cisco.com, it compares the live server certificate with the stored certificate and proceeds only upon a complete match. The complete certificate chain, not just the root certificate, is compared for a match. If there is a mismatch, the current operation is aborted until you view and accept the new certificate.

 
     		 [bookmark: pgfId-68638]It performs daily checks of your Security Manager server for certificate revocation and validity, and it removes any revoked or invalid certificates from your server. It does this by live contact with the CRL distribution points/URL present in the certificate. The default fixed schedule is for this daily check to be performed at 2:00 a.m.

 
    

 
    [bookmark: pgfId-68640]Download Requirements

 
    [bookmark: pgfId-68648]To download images from Cisco.com, you must retrieve, view, and accept both the latest image meta-data locator certificate and the latest certificate URL of the download site. The Security Manager interface has messages to assist you in key locations, and detailed documentation is available by referring to Image Manager Page and Edit Update Server Settings Dialog Box.

 
    [bookmark: pgfId-68650]Troubleshooting

 
    [bookmark: pgfId-68652]During daily checks for certificate revocation and validity, the CRL revocation list is not stored on your Security Manager server. For that reason, if connectivity is lost, the daily checks fail to detect any possible certificate revocations. This problem will be solved after connectivity is restored.

 
    [bookmark: pgfId-68654]If failure occurs while downloading ASA images or checking for IPS update packages, the most probable causes are the following:

 
     
     		 [bookmark: pgfId-68656]Site’s certificate is not found on your Security Manager server

 
     		 [bookmark: pgfId-68658]There is a mismatch between the certificate received from the site and the stored certificate

 
     		 [bookmark: pgfId-68660]The site’s certificate has expired

 
    

 
    [bookmark: pgfId-68662]In all of these three cases listed above, the operation is aborted, and a message gives the cause of the error and the URL of the failed site. To recover, navigate to the user interface of the certificate feature (Tools > Security Manager Administration... > Image Manager or Tools > Security Manager Administration... > IPS Updates > [Update Server group] > Edit Settings); then retrieve, view, and accept the new certificate from the site and re-try the download.

 
    [bookmark: pgfId-68664]If failure occurs while performing a check for IPS updates, verify that you have accepted both the certificate of the Cisco.com site used to obtain the meta-data information for IPS packages and the certificate of the actual download site of the IPS packages. Cisco recommends that you always configure email for notification of the job execution status. Then you can view the recommended actions in the email for recovering from the error. Copy the failed download URL from the email message to retrieve the certificate.

 
    [bookmark: pgfId-68666]Because certificates are stored, if you upgrade to Security Manager 4.4 from a previous version, all communication with Cisco.com will fail. To resolve this problem, you must retrieve the certificates from the image meta-data locator and the download site URL.

 
    [bookmark: pgfId-68668]If the stored certificate table in the user interface does not show the addition of a particular certificate, check to see if the daily checks for certificate revocation and validity have removed it because of revocation or expiration. You can do this by looking for the Certificate Revocation Check Task in the tomcat log; that log will enable you to determine the exact reason for the removal of the stored certificate.

 
   
 
    
     [bookmark: pgfId-68678][bookmark: 30457][bookmark: adman_cncpt_WorkingwithAuditReports]Working with Audit Reports[bookmark: marker-68674][bookmark: marker-68676]

 
    [bookmark: pgfId-68680]When state changes occur in Security Manager, an audit entry is created in the audit log, which you can view by selecting Manage > Audit Report. The following topics provide more detailed information about audit reports:

 
     
     		 [bookmark: pgfId-68685]Understanding Audit Reports

 
     		 [bookmark: pgfId-68690]Generating the Audit Report

 
     		 [bookmark: pgfId-68695]Purging Audit Log Entries

 
    

 
     
      [bookmark: pgfId-68705][bookmark: 30477][bookmark: adman_cncpt_UnderstandingAuditReports]Understanding Audit Reports[bookmark: marker-68701][bookmark: marker-68703]

 
     [bookmark: pgfId-68707]When state changes occur in Security Manager, an audit entry is created in the audit log, which you can view by selecting Manage > Audit Report.

 
     [bookmark: pgfId-68709]The state changes that generate an event and create an audit entry are:

 
      
      		 [bookmark: pgfId-68711]Changes to the runtime environment:

 
     

 
     [bookmark: pgfId-68713] – System changes, such as login attempts (successful or failed), logout, and scheduled backups.

 
     [bookmark: pgfId-68715] – Authorization issues, such as failed attempts and security breaches.

 
     [bookmark: pgfId-68717] – Map changes, such as saving, deleting, and changing background map views.

 
     [bookmark: pgfId-68719] – Administrative changes, such as changing workflow modes.

 
      
      		 [bookmark: pgfId-68721]Changes to the state of Security Manager objects:

 
     

 
     [bookmark: pgfId-68723] – Activity changes, such as creating, editing, submitting, or approving an activity.

 
     [bookmark: pgfId-68725] – Deployment changes, such as creating, editing, or submitting a deployment job.

 
      
      		 [bookmark: pgfId-68727]Changes to the state of managed devices:

 
     

 
     [bookmark: pgfId-68729] – Object changes, such as changes to policy objects.

 
     [bookmark: pgfId-68731] – Inventory changes, such as adding, deleting, or modifying devices in the inventory.

 
     [bookmark: pgfId-68733] – Policy changes, such as creating, restoring, modifying, or deleting policies.

 
     [bookmark: pgfId-68735] – VPN changes, such as creating, modifying, or deleting a VPN.

 
     [bookmark: pgfId-68737]When viewing the audit report, you can view subsets of entries by specifying search criteria to select only the desired records.

 
     [bookmark: pgfId-68739]Related Topics

 
      
      		 [bookmark: pgfId-68744]Generating the Audit Report

 
      		 [bookmark: pgfId-68749]Purging Audit Log Entries

 
     

 
    
 
     
      [bookmark: pgfId-68757][bookmark: 30529][bookmark: adman_proc_GeneratingtheAuditReport]Generating the Audit Report[bookmark: marker-68755]

 
     [bookmark: pgfId-68759]You can view the audit log to analyze the events that have occurred in the Security Manager System. This information can help you track changes that users have made to devices or to identify other system events of interest. The Audit Report window provides extensive search criteria to help you view the specific audit log entries that interest you.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-68764]Tip You can also view the audit logs through CiscoWorks Common Services. From the Common Services Server Administration page, select Server > Reports, and select Audit Log from the table of contents. Click Generate Report and you are presented with a list of logs, one for each day. Click the link for the desired log to open it. These logs are stored in the Program Files/CSCOpx/MDC/Logs/audit/ directory. For information about logging into Common Services, see Logging In to the Cisco Security Management Suite Server.


     
      

     

     

 
     [bookmark: pgfId-68766]Related Topics

 
      
      		 [bookmark: pgfId-68771]Understanding Audit Reports

 
     

 
     
 
     [bookmark: pgfId-68773]Step 1 Select Manage > Audit Report to open the Audit Report window.

 
     [bookmark: pgfId-68778]Step 2 To reduce the report to a specific set of records that relate to an area of interest, enter the appropriate search criteria in the left pane and click Search. For detailed information about the search fields, see Using the Audit Report Window.

 
     [bookmark: pgfId-68780]The following examples describe sample search criteria:

 
      
      		 [bookmark: pgfId-68782]To find out when the device router1 was removed from Security Manager management—Select  Devices > Delete from the  Search by action selector. In the  Search by all or part of the object name field, enter the display name of the device (router1).

 
      		 [bookmark: pgfId-68784]To find out if a failed login attempt occurred in the system—Select  System > Authorization > Login > Failed from the  Search by action selector.

 
     

 
     [bookmark: pgfId-68786]Step 3 To view the contents of an entry in the report, double click the entry. This action opens a dialog box where you can read the message related to the entry. You can scroll through the report in this dialog box by using the up and down arrow buttons.

 
     [bookmark: pgfId-68788]


     
      

     
 
     

 
    
 
     
      [bookmark: pgfId-68800][bookmark: 30570][bookmark: toolpage_cncpt_AuditReportPage]Using the Audit Report Window[bookmark: marker-68796][bookmark: marker-68798]

 
     [bookmark: pgfId-68802]Use the Audit Report window to view records of state changes in Security Manager.

 
     [bookmark: pgfId-68804]The Audit Report page contains two panes. Use the left pane to define the parameters for generating the audit report. The right pane displays the audit report using one row for each audit entry or message. The content of the audit report depends on the parameters you defined in the left pane. Therefore, all columns listed in the table might not be displayed in the generated audit report.

 
     [bookmark: pgfId-68806]Navigation Path

 
     [bookmark: pgfId-68808]Select Manage > Audit Report.

 
     [bookmark: pgfId-68810]Related Topics

 
      
      		 [bookmark: pgfId-68815]Understanding Audit Reports

 
      		 [bookmark: pgfId-68820]Generating the Audit Report

 
     

 
     [bookmark: pgfId-68822]Field Reference

 
     [bookmark: pgfId-68825] 

 
      
       
        
        [bookmark: pgfId-66748]Table 10-1 [bookmark: 30596]Audit Report Window 

 
        
       
         
         		
           
           [bookmark: pgfId-66754]Element
          
  
         		
           
           [bookmark: pgfId-66756]Description
          
  
        

 
         
         		 [bookmark: pgfId-66762]Search Criteria (Left Pane)

 [bookmark: pgfId-66764]The left side of the Audit Report window contains the search criteria for the report. The default report lists all state changes from yesterday and today, sorted with the most recent changes at the top.

  
        

 
         
         		[bookmark: pgfId-66772]Search by action

  
         		[bookmark: pgfId-66774]One or more sources of actions to include in the audit report. If you do not make a selection, the report is not filtered based on action. You can select All to include all action sources.

  
        

 
         
         		[bookmark: pgfId-66780]Search by date

  
         		[bookmark: pgfId-66782]The time period to include in the report. Actions that occur between the from and to dates are displayed. Click the calendar icon to select the dates.

 [bookmark: pgfId-66784]This filter’s default (reset position) is to include actions from yesterday to today.

  
        

 
         
         		[bookmark: pgfId-66790]Search for activity by state

  
         		[bookmark: pgfId-66792]This field works differently from the other search fields, and is primarily of use in Workflow mode. You can use this field to select one or more activities to include in the report. The activities are listed in the display box below the drop-down list. The drop-down list helps you find the activities on which you want to report.

 [bookmark: pgfId-66794]To use this search mechanism, select the activity state of the activities on which you want to report, and then select the activities. Use Ctrl+click to select multiple activities.

 [bookmark: pgfId-66796]Select No Activity to not filter by activity.

  
        

 
         
         		[bookmark: pgfId-66802]Search by message warning level

  
         		[bookmark: pgfId-66804]The message warning level. The report is limited to messages of the selected severity. Use Ctrl+click to select multiple levels.

  
        

 
         
         		[bookmark: pgfId-66810]Search by user name

  
         		[bookmark: pgfId-66812]The username of the person who performed the actions to include in the report. To see Security Manager system-generated actions, enter the username System.

  
        

 
         
         		[bookmark: pgfId-66818]Search by a phrase in the message body

  
         		[bookmark: pgfId-66820]A string of text that should occur in the message of the audit report entries. You can enter a maximum of 1025 characters.

 [bookmark: pgfId-66822]The message is not visible in the report table. To see the messages related to an entry, double-click the entry.

  
        

 
         
         		[bookmark: pgfId-66828]Search by all or part of the object name

  
         		[bookmark: pgfId-66830]A string of text that should occur in the name of the object for which the audit entries were generated. You can enter a maximum of 1025 characters.

  
        

 
         
         		[bookmark: pgfId-66836]Search button

  
         		[bookmark: pgfId-66838]Click this button to generate the report in the right pane.

  
        

 
         
         		[bookmark: pgfId-66844]Reset button

  
         		[bookmark: pgfId-66846]Click this button to reset the search criteria and delete any values or selections you made.

  
        

 
         
         		 [bookmark: pgfId-66852]Audit Report (Right Pane)

 [bookmark: pgfId-66854]The right side of the Audit Report window contains the audit report. Each row represents one audit entry. Double-click a row to open the Audit Message Details dialog box, where you can view a more readable layout of the information and to see the specific messages associated with the entry. You can scroll through the entries in the report from within the Audit Message Details dialog box.

  
        

 
         
         		[bookmark: pgfId-66862]Message Level

  
         		[bookmark: pgfId-66864]The message warning level: Information, Warning, Success, Failure and Internal System Error.

  
        

 
         
         		[bookmark: pgfId-66870]Date

  
         		[bookmark: pgfId-66872]The date and time the action occurred.

  
        

 
         
         		[bookmark: pgfId-66878]Source

  
         		[bookmark: pgfId-66880]The origin of the audit entry: Objects, License, Admin, Firewall, Policy Manager, Devices, Topology, VPN, Config Archive, Deployment, System, and Activity.

  
        

 
         
         		[bookmark: pgfId-66886]Action

  
         		[bookmark: pgfId-66888]The action performed: Add, Assign, Create, Delete, Open, Purge, Unassign, and Update.

  
        

 
         
         		[bookmark: pgfId-66894]Object

  
         		[bookmark: pgfId-66896]The identifier of the object of the action. For example, if the category is device, then the object identifier could be the device name or IP address. If the category is deployment, then the object identifier could be job name, job ID, and so on. There frequently is no specific object name.

  
        

 
         
         		[bookmark: pgfId-66902]User Name

  
         		[bookmark: pgfId-66904]The username of the person performing the action.

  
        

 
         
         		[bookmark: pgfId-66910]Activity

  
         		[bookmark: pgfId-66912]The name of the activity in which the action occurred, if any.

  
        

 
         
         		[bookmark: pgfId-66918]# of rows per page

  
         		[bookmark: pgfId-66920]The number of rows to display on each page.

  
        

 
         
         		[bookmark: pgfId-66926]< arrow

  
         		[bookmark: pgfId-66928]Click this button to return to the previous page of the audit report.

  
        

 
         
         		[bookmark: pgfId-66934]> arrow

  
         		[bookmark: pgfId-66936]Click this button to advance to the next page of the audit report.

  
        

 
       
      

 
     
 
    
 
     
      [bookmark: pgfId-68833][bookmark: 30718][bookmark: adman_cncpt_PurgingAuditLogEntries]Purging Audit Log Entries[bookmark: marker-68831]

 
     [bookmark: pgfId-68835]Security Manager automatically prunes the audit logs based on the age of the log entries. You do not need to actively manage the size of the log. However, you can change the defaults to increase or decrease the maximum size of the log and thus manage the overall size of the database.

 
     [bookmark: pgfId-68840]To change the default settings for audit logs, select Tools > Security Manager Administration and select Logs from the table of contents (see Logs Page). The size of the log is controlled by the maximum number of days an entry can be, and the overall maximum number of entries that can be in the log. These settings work together, and entries are pruned on a periodic basis to keep the log to the maximum number of entries with none that are older than the maximum number of days. If you reduce the maximum size of the log, click Purge Now to delete the excess entries before the regular pruning cycle.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-68842]Note The Purge Now button only removes audit report entries from the database. It does not remove the *.csv files from the <install_dir>\CSCOpx\MDC\log\audit folder. These *.csv files can be deleted directly.


     
      

     

     

 
     [bookmark: pgfId-68844]You can also control the size of the log by changing the severity level of events that are captured in the log. For example, if you capture only Severe events, the log will probably remain small. However, reducing the level of information might reduce the value of the log.

 
     [bookmark: pgfId-68846]Related Topics

 
      
      		 [bookmark: pgfId-68851]Understanding Audit Reports

 
      		 [bookmark: pgfId-68856]Generating the Audit Report

 
      		 [bookmark: pgfId-68861]Using the Audit Report Window

 
     

 
    
 
   
 
    
     [bookmark: pgfId-68871][bookmark: 30747][bookmark: defapset_proc_TakingOverAnotherUsersWork]Taking Over Another User’s Work[bookmark: marker-68867][bookmark: marker-68869]

 
    [bookmark: pgfId-68873]A user with administrative privileges can take over the work of another user in non-Workflow mode. Taking over another user’s work is useful when a user is working on devices and policies, causing the devices and policies to be locked, and another user needs access to the same devices and policies.

 
    
 
    [bookmark: pgfId-68878]Step 1 Select Tools > Security Manager Administration and select Take Over User Session from the table of contents to open the Take Over User Session page (see Take Over User Session Page).

 
    [bookmark: pgfId-68880]Step 2 Select the user session you want to take over.

 
    [bookmark: pgfId-68882]Step 3 Click Take over session. The changes made by the selected user are transferred to you. Any changes that have not already been committed are discarded.

 
    [bookmark: pgfId-68884]If the selected user is logged in at the time changes are taken over, the user receives a warning message, loses the changes in progress, and then is logged out.

 
    [bookmark: pgfId-68886]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-68898][bookmark: 30771][bookmark: adman_proc_ChangingtheAdminPassword]Changing Passwords for the Admin or Other Users [bookmark: marker-68892][bookmark: marker-68894][bookmark: marker-68896]

 
    [bookmark: pgfId-68900]The admin user is a pre-defined user that has access to all Security Manager functions. When you install the product, you configure a password for the admin user. If you forget the password, you can use the following procedure to change it. You can also use this procedure to reset the password for other user accounts.

 
    
 
    [bookmark: pgfId-68902]Step 1 Log into Windows on the Security Manager server and open a Windows command line window.

 
    [bookmark: pgfId-68904]Step 2 Stop the daemon manager services by using this command:

 
    [bookmark: pgfId-68906]net stop crmdmgtd

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-68908]Tip You can also stop and start the daemon manager using the Services control panel.


    
     

    

    

 
    [bookmark: pgfId-68910]Step 3 Run ResetPasswd.pl specifying admin as the user name. This example assumes you installed the product in the default directory; change the directory path if you used a different directory:

 
    [bookmark: pgfId-68912]C:\Program Files\CSCOpx\bin\perl ResetPasswd.pl admin

 
    [bookmark: pgfId-68914]You are prompted for a new password.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-68916]Tip If you want to change the password for a different user, replace admin with the desired user name.


    
     

    

    

 
    [bookmark: pgfId-68918]Step 4 Start the daemon manager services by using this command:

 
    [bookmark: pgfId-68920]net start crmdmgtd

 
    [bookmark: pgfId-68922]


    
     

    
 
    

 
   
 
    
     [bookmark: pgfId-68934][bookmark: 30804][bookmark: adman_cncpt_BackupandRestore]Backing up and Restoring the Security Manager Database [bookmark: marker-68928][bookmark: marker-68930][bookmark: marker-68932]

 
    [bookmark: pgfId-68936]You should regularly back up the Security Manager database in case you need to recover your work.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-68941]Tip The Security Manager database backup does not include the event data store used by the Event Manager service. If you want to back up event management data, see Archiving or Backing Up and Restoring the Event Data Store.


    
     

    

    

 
    [bookmark: pgfId-68943]The following topics describe how to back up and recover the Security Manager database:

 
     
     		 [bookmark: pgfId-68948]Backing Up the Server Database

 
     		 [bookmark: pgfId-68953]Restoring the Server Database

 
    

 
     
      [bookmark: pgfId-68965][bookmark: 30826][bookmark: adman_cncpt_BackingUptheServerDatabase]Backing Up the Server Database[bookmark: marker-68959][bookmark: marker-68961][bookmark: marker-68963]

 
     [bookmark: pgfId-68967]Security Manager uses CiscoWorks Common Services facilities to back up and restore its database. In the Security Manager client, select Tools > Backup to open the CiscoWorks Common Services Backup page for creating a backup schedule. You should regularly back up the database so that you can recover it if necessary.

 
     [bookmark: pgfId-68969]After completing a backup, Security Manager compresses it. If you configure an e-mail address on the CiscoWorks Common Services backup page, you will get notifications of the completion of the backup and compression processes. If you have problems with file compression, or if you do not want to compress the backups, you can turn off backup compression. Edit the backup.properties file in the %NMSROOT%\conf folder (typically C:\Program Files\CSCOpx\conf) and change the backup compression property to specify NO instead of YES, as follows: VMS_FILEBACKUP_COMPRESS=NO.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-68974]Tip The backup includes the configuration and reporting databases, but it does not include the event storage areas. You can exclude the reporting database by changing the SKIP_RPT_DB_BACKUP property value to YES in the backup.properties file. Even if you specify YES, the backup will include reports generated by report schedules. For information on backing up the event data store, see Archiving or Backing Up and Restoring the Event Data Store.


     
      

     

     

 
     [bookmark: pgfId-68976]While backing up and restoring data, both Common Services and Security Manager processes will be shut down and restarted. Because Security Manager can take several minutes to fully restart, users might be able to start their client before the restart is complete. If this happens, they might see the message “error loading page” in device policy windows.

 
     [bookmark: pgfId-68978]We strongly recommend you take a backup of your current system before restoring an older backup.

 
     [bookmark: pgfId-68980]You cannot restore a backup from an earlier version of Security Manager if that backup contains any pending data, which is data that has not been committed to the database. Before upgrading to a new version of Cisco Security Manager, we recommend that you commit or discard all uncommitted changes and then create a backup of your database. You can use the following instructions to help with committing or discarding pending data:

 
      
      		 [bookmark: pgfId-68982] In non-Workflow mode: 

 
     

 
     [bookmark: pgfId-68984] – To commit changes, select File > Submit.

 
     [bookmark: pgfId-68986] – To discard uncommitted changes, select File > Discard.

 
     [bookmark: pgfId-68988]If there are multiple users with pending data, the changes for those users must also be committed or discarded. If you need to commit or discard changes for another user, you can take over that user’s session. To take over a session, select Tools > Security Manager Administration > Take Over User Session, select the session, and click Take Over Session.

 
      
      		 [bookmark: pgfId-68990] In Workflow mode: 

 
     

 
     [bookmark: pgfId-68992] – To commit and approve changes, select Manage > Activities. From the Activity Manager window, select an activity and click Approve. If you are using an activity approver, click Submit and have the approver approve the activity.

 
     [bookmark: pgfId-68994] – To discard uncommitted changes, select Manage > Activities. From the Activity Manager window, select an activity and click Discard. Only an activity in the Edit or Edit Open state can be discarded.

 
     [bookmark: pgfId-68996]You can also back up the database from a Windows command prompt using the following command:

 
     [bookmark: pgfId-68998][path]perl [path]backup.pl backup_directory [log_filename [email=email_address [number_of_generations [compress]]]]

 
     [bookmark: pgfId-69001]Syntax

 
      
       
       
         
         		[bookmark: pgfId-66943][path]perl [path]backup.pl

  
         		[bookmark: pgfId-66945]The Perl script command. Include the path to the perl command and the backup.pl file if the path is not defined in the system path variable. The typical path for both is C:\Progra~1\CSCOpx\bin\.

  
        

 
         
         		[bookmark: pgfId-66951]backup_directory

  
         		[bookmark: pgfId-66953]The directory where you want to create the backup. For example, C:\Backups.

  
        

 
         
         		[bookmark: pgfId-66959]log_filename

  
         		[bookmark: pgfId-66961](Optional.) The log file for messages generated during backup. Include the path if you want it created somewhere other than the current directory. For example, C:\BackupLogs.

 [bookmark: pgfId-66963]If you do not specify a name, the log is %NMSROOT%\log\dbbackup.log.

  
        

 
         
         		[bookmark: pgfId-66969]email=email_address

  
         		[bookmark: pgfId-66971](Optional.) The email address where you want notifications sent. If you do not want to specify an email address, but you need to specify a subsequent parameter, enter email without the equal sign or address.

 [bookmark: pgfId-66976]You must configure SMTP settings in CiscoWorks Common Services to enable notifications. For more information, see Configuring an SMTP Server and Default Addresses for E-Mail Notifications.

  
        

 
         
         		[bookmark: pgfId-66982]number_of_generations

  
         		[bookmark: pgfId-66984](Optional.) The maximum number of backup generations to keep in the backup directory. When the maximum is reached, old backups are deleted. The default is 0, which does not limit the number of generations kept.

  
        

 
         
         		
           
           [bookmark: pgfId-66990]compress
          
  
         		[bookmark: pgfId-66992](Optional.) Whether you want the backup file to be compressed. If you do not enter this keyword, the backup is not compressed if VMS_FILEBACKUP_COMPRESS=NO is specified in the backup.properties file. Otherwise, the backup is still compressed. We recommend compressing backups.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-69003]Example

 
     [bookmark: pgfId-69005]The following command assumes that you are in the directory containing the perl and backup.pl commands. It creates a compressed backup and log file in the backups directory and sends notifications to admin@domain.com. Note that you must specify a backup generation to include the compress parameter; if you specify any parameter after the log file parameter, you must include values for all preceding parameters.

 
     
      [bookmark: pgfId-69007]perl backup.pl C:\backups C:\backups\backup.log email=admin@domain.com 0 compress
     

     
      [bookmark: pgfId-69009] 
     

     
      [bookmark: pgfId-69011] 
     

      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-69013]Tip If you stop a backup that is in progress, you need to delete the backup.LOCK file in the Security Manager installation directory (typically C:\Progra~1\CSCOpx) before you can perform another backup.


     
      

     

     

 
    
 
     
      [bookmark: pgfId-69025][bookmark: 30941][bookmark: adman_proc_RestoringtheServerDatabase]Restoring the Server Database[bookmark: marker-69019][bookmark: marker-69021][bookmark: marker-69023]

 
     [bookmark: pgfId-69027]You can restore your database by running a script from the command line. You have to shut down and restart CiscoWorks while restoring data. This procedure describes how you can restore the backed up database on your server. A single backup and restore facility exists to back up and restore all applications installed on a CiscoWorks server; you cannot back up or restore individual applications.

 
     [bookmark: pgfId-69029]If you install the applications on multiple servers, ensure that you recover the database backup that contains data appropriate for the installed applications.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-69033]Tip You can restore backups taken from previous releases of the application if the backup is from a version supported for direct local inline upgrade to this version of the application. For information on which versions are supported for upgrade, see the Installation Guide for Cisco Security Manager for this release of the product.


     
      

     

     

 
     
 
     [bookmark: pgfId-69035]Step 1 Stop all processes by entering the following at the command line:

 
     [bookmark: pgfId-69037]net stop crmdmgtd

 
     [bookmark: pgfId-69039]Step 2 Restore the database by entering:

 
     [bookmark: pgfId-69041]$NMSROOT\bin\perl $NMSROOT\bin\restorebackup.pl [-t temporary_directory] [-gen generationNumber] -d backup_directory[-h]

 
     [bookmark: pgfId-69043]where:

 
      
      		 [bookmark: pgfId-69045] $NMSROOT —The full pathname of the Common Services installation directory (the default is C:\Program Files\CSCOpx).

 
      		 [bookmark: pgfId-69047] -t  temporary_directory —(Optional) This is the directory or folder used by the restore program to store its temporary files. By default this directory is  $NMSROOT \tempBackupData.

 
      		 [bookmark: pgfId-69049] -gen  generationNumber —(Optional.) The backup generation number you want to recover. By default, it is the latest generation. If generations 1 through 5 exist, then 5 will be the latest.

 
      		 [bookmark: pgfId-69051] -d  backup_directory —The backup directory that contains the backup to restore.

 
      		 [bookmark: pgfId-69053] -h —(Optional) Provides help. When used with -d BackupDirectory, help shows the correct syntax along with available suites and generations.

 
     

 
     [bookmark: pgfId-69055]For example, to restore the most recent version from the c:\var\backup directory, enter the following command:

 
     [bookmark: pgfId-69057]C:\Progra~1\CSCOpx\bin\perl C:\Progra~1\CSCOpx\bin\restorebackup.pl -d C:\var\backup

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-69059]Tip If you are restoring a database that contains RME data, you might be asked if you want to collect inventory data. Collecting this data can take a long time. You might want to respond No and then configure RME to schedule an inventory. In RME, select Devices > Inventory.


     
      

     

     

 
     [bookmark: pgfId-69061]Step 3 Examine the log file, NMSROOT\log\restorebackup.log, to verify that the database was restored.

 
     [bookmark: pgfId-69063]Step 4 Restart the system by entering:

 
     [bookmark: pgfId-69065]net start crmdmgtd

 
     [bookmark: pgfId-69067]Step 5 If you restore a database that was backed up prior to installing a Security Manager service pack, you must reapply the service pack after restoring the database.

 
     [bookmark: pgfId-69069]


     
      

     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-69081][bookmark: 31021][bookmark: adman_cncpt_GeneratingDatafortheCiscoTechnicalAssistanceCenter]Generating Data for the Cisco Technical Assistance Center [bookmark: marker-69075][bookmark: marker-69077][bookmark: marker-69079]

 
    [bookmark: pgfId-69083]Cisco Technical Assistance Center (TAC) personnel might ask you to submit a variety of data to help them identify and resolve problems you might encounter when using the application. The following topics can help you generate the required information. However, you should perform these tasks only at the direction of the TAC, because the information is not always required to resolve a problem.

 
     
     		 [bookmark: pgfId-69088]Creating Diagnostics Files for the Cisco Technical Assistance Center

 
     		 [bookmark: pgfId-69093]Generating Deployment or Discovery Status Reports

 
     		 [bookmark: pgfId-69098]Generating a Partial Database Backup for the Cisco Technical Assistance Center

 
    

 
     
      [bookmark: pgfId-69114][bookmark: 31043][bookmark: adman_cncpt_SecurityManagerDiagnostics]Creating Diagnostics Files for the Cisco Technical Assistance Center [bookmark: marker-69104][bookmark: marker-69106][bookmark: marker-69108][bookmark: marker-69110][bookmark: marker-69112]

 
     [bookmark: pgfId-69116]Cisco Technical Assistance Center (TAC) personnel may ask you to submit system configuration information in the form of a diagnostics file when you submit a problem report. The diagnostics file assists them with diagnosing the problem. You do not need to submit a diagnostics file unless they ask you to.

 
     [bookmark: pgfId-69121]Before you create the diagnostics file, perform the actions that lead to the problem in your report. If necessary, you can control the level of detail in the diagnostics file by changing the settings on the Debug Options page (Tools > Security Manager Administration > Debug Options); see Debug Options Page.

 
     [bookmark: pgfId-69123]Beginning with Version 4.7, Cisco Security Manager supports diagnostics in a new, light variant; this "Light Diagnostics" variant collects only basic information; as a result, the diagnostics file is smaller, and its generation is faster. The existing "General Diagnostics" variant is the same in 4.7 as it was in 4.6 and earlier versions.

 
     [bookmark: pgfId-69125]General Diagnostics File

 
     [bookmark: pgfId-69127]The general diagnostics file (CSMDiagnostics.zip) contains the following files and information:

 
      
      		 [bookmark: pgfId-69129]Configuration files

 
      		 [bookmark: pgfId-69131]Apache configuration and log files

 
      		 [bookmark: pgfId-69133]Tomcat configuration and log files

 
      		 [bookmark: pgfId-69135]Installation, audit, and operation log files

 
      		 [bookmark: pgfId-69137]The CiscoWorks Common Services Registry subtree ([HKEY_LOCAL_MACHINE][SOFTWARE][Cisco][MDC])

 
      		 [bookmark: pgfId-69139]Windows System Event and Application Event log files

 
      		 [bookmark: pgfId-69141]Host environment information (operating system version and installed service packs, amount of RAM, disk space on all volumes, computer name, and virtual memory size)

 
     

 
     [bookmark: pgfId-69143]To create CSMDiagnostics.zip by using the GUI, follow this procedure:

 
     [bookmark: pgfId-69145] 1. Using the Security Manager client, select Tools > Security Manager Diagnostics... > General Diagnostics.... A dialog box is opened.

 
     [bookmark: pgfId-69147] 2. Click OK to start the file generation. The dialog box displays the progress.

 
     [bookmark: pgfId-69149] 3. When the file is generated, click Close.

 
     [bookmark: pgfId-69151]To create CSMDiagnostics.zip by using the CLI, follow this procedure:

 
     [bookmark: pgfId-69153] 1. Open a command line window on the Security Manager server.

 
     [bookmark: pgfId-69155] 2. Run the ~MDC\bin\CSMDiagnostics program.

 
     [bookmark: pgfId-69157] 3. CSMDiagnostics.zip is placed in the <installation_location>/MDC/etc folder, where <installation_location> is the drive and directory in which you installed CiscoWorks Common Services. The default value for <installation_location> is C:\Program Files (x86)\CSCOpx.

 
     [bookmark: pgfId-69159] 4. If you want to, you can specify a different folder where CSMDiagnostics.zip is placed. For example, you can specify CSMDiagnostics C:\Temp.

 
     [bookmark: pgfId-69161] 5. You should move or rename CSMDiagnostics.zip after you create it, because it will be overwritten the second time you generate it, with only one previous version (appended with "_old") being saved.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-69163]Note When creating CSMDiagnostics.zip by using the CLI, you must allow the command to complete before closing the window; if you do not, subsequent attempts to run CSMDiagnostics will not work properly. If you mistakenly close the window, delete the C:\Program Files\CSCOpx\MDC\etc\mdcsupporttemp folder before attempting to use the command again.


     
      

     

     

 
     [bookmark: pgfId-69165]Light Diagnostics File

 
     [bookmark: pgfId-69167]The light diagnostics file (CSMDiagnostics_light.zip) contains a subset of the general diagnostics file (CSMDiagnostics.zip), so it is smaller and generated faster.

 
     [bookmark: pgfId-69169]To create CSMDiagnostics_light.zip by using the GUI, follow this procedure:

 
     [bookmark: pgfId-69171] 1. Using the Security Manager client, select Tools > Security Manager Diagnostics... > Light Diagnostics.... A dialog box is opened.

 
     [bookmark: pgfId-69173] 2. Click OK to start the file generation. The dialog box displays the progress.

 
     [bookmark: pgfId-69175] 3. When the file is generated, click Close.

 
     [bookmark: pgfId-69177]To create CSMDiagnostics_light.zip by using the CLI, follow this procedure:

 
     [bookmark: pgfId-69179] 1. Open a command line window on the Security Manager Server.

 
     [bookmark: pgfId-69181] 2. Run the following command: <installation_location>\MDC\diagnostics\script>rundiag.bat, where <installation_location> is the drive and directory in which you installed CiscoWorks Common Services. The default value for <installation_location> is C:\Program Files (x86)\CSCOpx.

 
     [bookmark: pgfId-69183] 3. Be certain that you run the command with the following 3 parameters and in the order shown:

 
     [bookmark: pgfId-69185]3.1. Installation Folder—Folder where Security Manager server is installed. This must not be changed or modified. An error in the path leads to failure in the generation of the diagnostics file. Example: C:\PROGRA~2\CSCOpx\MDC

 
     [bookmark: pgfId-69187]3.2. Destination Folder—Folder where the diagnostics file will be placed after generation. You can specify any path and folder where you want the file to be saved. If you want the file to be saved in the default path, then you must specify the default path explicitly. If you do not specify the path, there will be an error in generation. Example: C:\PROGRA~2\Light_Diagnostics

 
     [bookmark: pgfId-69189]3.3. "LightDiagnostics" string without a space. The string alphabets are not case-sensitive, so you can use capital or lower-case letters, but you must not use a space in this string. If you neglect to specify this string, part of the general diagnostics (i.e., not light diagnostics) logs will automatically be collected in the destination folder.

 
     [bookmark: pgfId-69191] 4. Complete command screen example:

 
     [bookmark: pgfId-69193]C:\Program Files (x86)\CSCOpx\MDC\diagnostics\script>rundiag.bat C:\PROGRA~2\CSCOpx\MDC C:\PROGRA~2\Light_Diagnostics LightDiagnostics

 
    
 
     
      [bookmark: pgfId-69213][bookmark: 31146][bookmark: adman_proc_GeneratingDeploymentorDiscoveryStatusReports]Generating Deployment or Discovery Status Reports[bookmark: marker-69199][bookmark: marker-69201][bookmark: marker-69203][bookmark: marker-69205][bookmark: marker-69207][bookmark: marker-69209][bookmark: marker-69211]

 
     [bookmark: pgfId-69215]You can generate status reports for deployment and policy discovery jobs. If you have problems involving deployment or discovery, these reports can help the Cisco Technical Support (TAC) personnel resolve your problem. Although the reports are mainly intended for troubleshooting, you can also generate these reports for your own uses.

 
     [bookmark: pgfId-69217]The status reports are generated as Adobe Acrobat (PDF) files on your workstation (you are prompted to select the location to save the PDF file). The report includes a summary of the job and summaries for each device in the job. Deployment status reports also include the full and delta configurations and the transcript of communications between Security Manager and the device.

 
     [bookmark: pgfId-69219]You can generate deployment or discovery reports in the following ways:

 
      
      		 [bookmark: pgfId-69221] Deployment Status Reports 

 
     

 
     [bookmark: pgfId-69226] – When a deployment job finishes, either successfully or unsuccessfully, by clicking the Generate Report button on the Deployment Status dialog box. See Deployment Status Details Dialog Box.

 
     [bookmark: pgfId-69231] – For previously completed jobs, by selecting the job in the Deployment Manager and clicking the Generate Report button. See Deployment Manager Window.

 
      
      		 [bookmark: pgfId-69233] Discovery Status Reports 

 
     

 
     [bookmark: pgfId-69238] – During a discovery job, which might occur when adding devices or when rediscovering policies on devices already in the inventory, by clicking the Generate Report button on the Discovery Status dialog box. See Discovery Status Dialog Box.

 
     [bookmark: pgfId-69243] – For previously completed jobs, by selecting the job in the Policy Discovery Status dialog box and clicking the Generate Report button. See Policy Discovery Status Page.

 
    
 
     
      [bookmark: pgfId-69257][bookmark: 31198][bookmark: adman_cncpt_GeneratingaPartialDatabaseBackupfortheCiscoTechnicalAssistanceCenter]Generating a Partial Database Backup for the Cisco Technical Assistance Center[bookmark: marker-69249][bookmark: marker-69251][bookmark: marker-69253][bookmark: marker-69255]

 
      
      [image: ] 
     
 
     
 
     
      [bookmark: pgfId-69259]
      Caution This topic explains how to create a partial database backup. Partial backups are incomplete and you cannot use them as a replacement for full backups. Partial backups are strictly for use in troubleshooting and you should generate one only if instructed to do so by Cisco Technical Assistance (TAC) personnel.
       
       
 
      

     
 
     [bookmark: pgfId-69264]Partial database backups have the same characteristics as regular backups, but they contain a more limited set of data. When creating a partial backup, you are asked whether you want to include data from the Configuration Archive, and if you say yes, how many archive versions (per device) you want to include (regular backups include the entire Configuration Archive). For a description of regular backups, see Backing Up the Server Database.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-69269]Tip The partial backup will include or exclude the reporting database based on the settings in the backup.properties file as described in Backing Up the Server Database.


     
      

     

     

 
     [bookmark: pgfId-69271]While backing up and restoring data, both Common Services and Security Manager processes will be shut down and restarted. Because Security Manager can take several minutes to fully restart, users might be able to start their client before the restart is complete. If this happens, they might see the message “error loading page” in device policy windows. Note that if you try to restore a partial backup, the system will point out that it is a partial backup, and you will have to confirm that you want to restore a partial backup.

 
     [bookmark: pgfId-69273]To generate a partial backup, use the following command at a Windows command prompt on the Security Manager server.

 
     [bookmark: pgfId-69275][path]perl [path]partial_backup.pl backup_directory [log_filename [email=email_address [number_of_generations [compress]]]]

 
     [bookmark: pgfId-69278]Syntax

 
      
       
       
         
         		[bookmark: pgfId-66999][path]perl [path]partial_backup.pl

  
         		[bookmark: pgfId-67001]The Perl script command. Include the path to the perl command and the partial_backup.pl file if the path is not defined in the system path variable. The typical path for both is C:\Progra~1\CSCOpx\bin\.

  
        

 
         
         		[bookmark: pgfId-67007]backup_directory

  
         		[bookmark: pgfId-67009]The directory where you want to create the backup. For example, C:\Backups.

  
        

 
         
         		[bookmark: pgfId-67015]log_filename

  
         		[bookmark: pgfId-67017](Optional.) The log file for messages generated during backup. Include the path if you want it created somewhere other than the current directory. For example, C:\BackupLogs.

 [bookmark: pgfId-67019]If you do not specify a name, the log is %NMSROOT%\log\dbbackup.log.

  
        

 
         
         		[bookmark: pgfId-67025]email=email_address

  
         		[bookmark: pgfId-67027](Optional.) The email address where you want notifications sent. If you do not want to specify an email address, but you need to specify a subsequent parameter, enter email without the equal sign or address.

 [bookmark: pgfId-67032]You must configure SMTP settings in CiscoWorks Common Services to enable notifications. For more information, see Configuring an SMTP Server and Default Addresses for E-Mail Notifications.

  
        

 
         
         		[bookmark: pgfId-67038]number_of_generations

  
         		[bookmark: pgfId-67040](Optional.) The maximum number of backup generations to keep in the backup directory. When the maximum is reached, old backups are deleted. The default is 0, which does not limit the number of generations kept.

  
        

 
         
         		
           
           [bookmark: pgfId-67046]compress
          
  
         		[bookmark: pgfId-67048](Optional.) Whether you want the backup file to be compressed. If you do not enter this keyword, the backup is not compressed if VMS_FILEBACKUP_COMPRESS=NO is specified in the backup.properties file. Otherwise, the backup is still compressed. We recommend compressing backups.

  
        

 
       
      

 
     
 
     [bookmark: pgfId-69280]Example

 
     [bookmark: pgfId-69282]The following command assumes that you are in the directory containing the perl and partial_backup.pl commands. It creates a compressed partial backup and log file in the backups directory and sends notifications to admin@domain.com. Note that you must specify a backup generation to include the compress parameter; if you specify any parameter after the log file parameter, you must include values for all preceding parameters. Also note that you are asked whether you want to include the Configuration Archive, and if yes, how many archive versions to include in the backup. In this example, five archive versions per device are included in the backup.

 
     
      [bookmark: pgfId-69284]perl partial_backup.pl C:\backups C:\backups\pbackup.log email=admin@domain.com 0 compress
     

     
      [bookmark: pgfId-69286]Root: c:\backups
     

     
      [bookmark: pgfId-69288]Do you also want to take config-archive backup(Yes/No): Yes
     

     
      [bookmark: pgfId-69290]How many previous config-archive you want to restore: 5
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